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Documento de Oficialização da Demanda (DOD) nº 20 / 2018

Soluções de Tecnologia da Informação

1. Descrição da solução de Tecnologia da Informação:
Registro de Preço para aquisição de ativos de rede: switchs

gerenciáveis.

2. Necessidades, objetivos e justificativas:

No caso de Registro de Preços, apresentar justificativa ou enquadramento ao DECRETO Nº
7.892, DE 23 DE JANEIRO DE 2013

Art. 3º O Sistema de Registro de Preços poderá ser adotado nas seguintes hipóteses:
I - quando, pelas características do bem ou serviço, houver necessidade de
contratações frequentes;
II - quando for conveniente a aquisição de bens com previsão de entregas parceladas
ou contratação de serviços remunerados por unidade de medida ou em regime de
tarefa;
III - quando for conveniente a aquisição de bens ou a contratação de serviços para
atendimento a mais de um órgão ou entidade, ou a programas de governo; ou
IV - quando, pela natureza do objeto, não for possível definir previamente o
quantitativo a ser demandado pela Administração.

Muitos cartórios ainda não são dotados de ativos de rede gerenciáveis;
Equipamentosem uso e necessários estão fora de garantia ou obsoletos;
Neste sentido, se torna necessário prover tais equipes  de equipamentos com
desempenho adequado ao desenvolvimento de suas atividades;
A gerência de ativos de rede é boa prática relativa à segurança da informação.

O alinhamento com o PEI é identificado na visão do recursos de infraestrutura e
tecnologia em seus dois aspectos apontados:

1 – Garantir a infraestrutura física apropriadas às atividades administrativas e judiciais.

Alinhamento com os Objetivos Estratégicos da Estratégia Nacional de TIC do Poder
Judiciário nos seguintes aspectos:

1. Prover infraestrutura de TIC apropriada às atividades judiciais e administrativas.

Alinhamento com os Objetivos Estratégicos de TIC da Justiça Eleitoral de Alagoas –
2017/2022 nos seguintes aspectos:

1. Viabilizar serviços e soluções de TIC.

Os  itens  são objeto de liberação de suplementação orçamentária para o exercício
2018 e não estão previstos na Proposta Orçamentária 2018, Equipamentos de
Informática - Equipamentos de Processamento de Dados e, neste sentido, por se tratar
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de Registro de Preços, trata-se de antecipação de ações internas para agilizar a
aquisição no exercício 2019, conforme solicitado pela SAD.

A estratégia de Registro de Preços está amparada no Decreto nº 7.892/2013, art 3º,
incisos:

I - vez que os equipamentos podem ser objeto de diversas aquisições/fornecimentos
até que se supra progressivamente toda a demanda de substituição progressiva;

II - as entregas deve ser progressivas de forma que as equipes da STI, em número
limitado, possam implantar os equipamentos sem que os mesmo precisem ser
estocados por longos períodos apenas exaurindo seus prazos de garantia.

3. Lista de requisitos:

Serão detalhados  no Termo de Referência.

Registro de Preço de 50 (cinquenta) de 48 porta, com fornecimento mínimo de 05
(cinco) por ordem; e 40 (quarenta) de 24 portas, com fornecimento de mínimo de 04
(quatro) por ordem.

Equipamentos devem ser gerenciáveis de forma centralizada por meio de
compatibilidade com o software de Gerenciamento IMC, em uso neste Regional, de
forma a garantir o investimento legado e mitigar problemas relativos à curva de
aprendizado ou heteregoneidade que cause paralizações ou inoperâncias de
plataforma.

4. Benefícios esperados (demonstrativo de resultados a serem
alcançados):

Dotar o TRE/AL de ativos de rede gerenciáveis com desempenho
adequado, com confiabilidade e .
5. Integrante demandante para equipe de planejamento da
contratação:

Integrante demandante: Coordenador de Infraestrutura

Integrante técnico: Chefe da Seção de Suporte Operacional

6. Fonte do recurso orçamentário:
Orçamento de Material Permanente de TI, exercício 2018 e 2019.

7. Metas do planejamento estratégico a serem alcançadas:
Esta aquisição está alinhada com o planejamento estratégico de

TIC quanto à necessidade proeminente de manutenção do parque
computacional confiável, assim como destacado no Item 2.
8. Expectativa de entrega:

30 (trinta) dias a partir de eventual ordem de fornecimento.
Resolução CNJ nº 182/2013 (destaques para o demandante):
Art. 3º São atribuições do Integrante Demandante definir, sempre que
possível e necessário, os requisitos:
I – de negócio, que independem de características tecnológicas, bem
como os aspectos funcionais da Solução de Tecnologia da Informação e
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Comunicação, limitados àqueles indispensáveis ao atendimento das
necessidades reais do órgão;

A qualidade dos serviços informatizados depende, em boa parte,
da qualidade dos equipamentos utilizados neste serviço.
II – de capacitação, que definem a necessidade de treinamento,
número de participantes, carga horária, materiais didáticos, entre
outros pertinentes;

Não há necessidade de treinamento, já que os equipamentos
serão utilizados para atividades já executadas pelas equipes.
III – legais, que definem as normas com as quais a Solução de
Tecnologia da Informação e Comunicação deverá estar em
conformidade;

Não há, s.m.j., normas para a substituição pretendida além das
regulam o próprio procedimento licitatório.
IV – de manutenção, que independem de configuração tecnológica e
que definem a necessidade de serviços complementares, tais como de
manutenção preventiva, corretiva, adaptativa e evolutiva da solução;

Não se aplica.
V – temporais, que definem os prazos de entrega dos bens e/ou do
início e encerramento dos serviços a serem contratados;

O registro de preço deverá ser entregue preferencialmente até
novembro/2018.
VI – de segurança da informação, juntamente com o Integrante
Técnico; e

Serão definidos no Termo de Referência.
VII – sociais, ambientais e culturais, que definem requisitos que a
solução deverá atender para estar em conformidade com os costumes,
os idiomas e o meio ambiente, entre outros pertinentes.

Não há demanda desta natureza.
§ 1º O Integrante Demandante deverá apresentar justificativa quando
não for possível definir os requisitos exigidos neste artigo.

Suprido nos itens anteriores deste documento.
§ 2º Além dos requisitos exigidos nos incisos deste artigo, cabe ao
Integrante Demandante a coordenação dos trabalhos necessários para
a efetiva concretização da demanda de Solução de Tecnologia da
Informação e Comunicação.

Ciente.
Decreto nº 7.174/2010 (destaques para o demandante):
Art. 2º A aquisição de bens e serviços de tecnologia da informação e
automação deverá ser precedida da elaboração de planejamento da
contratação, incluindo projeto básico ou termo de referência contendo
as especificações do objeto a ser contratado, vedando-se as
especificações que:
I - direcionem ou favoreçam a contratação de um fornecedor
específico;
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Não há, s.m.j., direcionamento ou favorecimento.
II - não representem a real demanda de desempenho do órgão ou
entidade; e

O registro de preços pretende a aquisição dos equipamentos
para renovação do parque e é essencial para garantir a continuidade da
qualidade dos serviços prestados por este Regional.
III - não explicitem métodos objetivos de mensuração do desempenho
dos bens e serviços de informática e automação.
Parágrafo único. Compete ao Ministério do Planejamento, Orçamento e
Gestão expedir normas complementares sobre o processo de
contratação de bens e serviços de informática e automação.

A medição do desempenho dos equipamentos adquiridos poderá
ser aferida através da continuidade da prestação dos serviços atuais.
Art. 3º Além dos requisitos dispostos na legislação vigente, nas
aquisições de bens de informática e automação, o instrumento
convocatório deverá conter, obrigatoriamente:
I - as normas e especificações técnicas a serem consideradas na
licitação;

No entender desta unidade técnica a exigência será
suficientemente atendida no Termo de Referência.
II - as exigências, na fase de habilitação, de certificações emitidas por
instituições públicas ou privadas credenciadas pelo Instituto Nacional
de Metrologia, Normalização e Qualidade Industrial - Inmetro, que
atestem, conforme regulamentação específica, a adequação dos
seguintes requisitos:
a) segurança para o usuário e instalações;
b) compatibilidade eletromagnética; e
c) consumo de energia;

No entender desta unidade técnica a exigência não cabe à STI,
devendo ser supridas pelas linhas gerais do Edital no tocante à habilitação,
conforme o caso e não se aplicando no caso de software e licenciamentos,
dada sua natureza intelectual.
III - exigência contratual de comprovação da origem dos bens
importados oferecidos pelos licitantes e da quitação dos tributos de
importação a eles referentes, que deve ser apresentada no momento
da entrega do objeto, sob pena de rescisão contratual e multa; e

No entender desta unidade técnica a exigência não cabe à STI.
IV - as ferramentas de aferição de desempenho que serão utilizadas
pela administração para medir o desempenho dos bens ofertados,
quando for o caso.

No entender desta unidade técnica a exigência não se aplica,
pois os serviços em questão não buscam diretamente o incremento de
produtividade, apenas a manutenção de condição para desempenho das
atividades.

Maceió, 26 de setembro de 2018.
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Documento assinado eletronicamente por DANIEL MACÊDO DE CARVALHO SOUTO,
Coordenador, em 26/09/2018, às 10:18, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0441142 e o código CRC AABC3E4B.

0008478-63.2018.6.02.8000 0441142v6
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 8000 - Maceió - AL

 

DESPACHO

Maceió, 26 de setembro de 2018.
À STI
 
Senhor Secretário,
 
Solicito que Vossa Senhoria avalie o documento de

oficialização da demanda (doc. SEI nº 0441142)  e, se
possível, autorize o desenvolvimento das providências
administrativas subsequentes, a fim de assegurar a aquisição
dos software listados.

Nos termos da Resolução CNJ nº 182/2013,
indico o titular da Coordenadoria de Infraestrutura, como
integrante demandante, e o titular da Seção de Gerência de
Infraestrutura, como integrante técnico.

Outrossim, em observância ao art. 6º da Portaria
TRE/AL nº 66/2018, destaco de abertura do presente
procedimento não ocorreu até o dia 31 de julho de 2018, dado
que demandado verbalmente, na data de ontem, pelo Sr.
Secretário de Administração, em decorrência de liberação de
recursos por parte do TSE e como medida de antecipação de
despesas de próximo exercício.

Por fim, sugere-se a atualização do Plano de
Contratatações de Soluções de Tecnologia da Informação e
Comunição - Portaria TRE/AL nº 50/2018.

 
Respeitosamente,

Documento assinado eletronicamente por DANIEL MACÊDO DE CARVALHO SOUTO,
Coordenador, em 26/09/2018, às 10:25, conforme art. 1º, III, "b", da Lei 11.419/2006.
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A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0441152 e o código CRC BE90BA23.

0008478-63.2018.6.02.8000 0441152v1
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 26 de setembro de 2018.
Senhor Diretor-Geral,
 
Segue o documento de oficialização da demanda

apresentado pelo Senhor Coordenador de Infraestrutura, com
a finalidade de viabilizar a aquisição de ativos de rede.

 
Na hipótese de Vossa Senhoria concordar com o

teor do documento, solicito a remessa destes autos ao Senhor
Secretário de Administração para as providências
subsequentes.

 
Nos termos da Resolução CNJ nº 182/2013,

indico o Coordenador de Infraestrutura, como integrante
demandante, e o titular da Seção de Gerência de
Infraestrutura, como integrante técnico.

 
Respeitosamente,

Documento assinado eletronicamente por CARLOS HENRIQUE TAVARES MÉRO,
Secretário de Tecnologia da Informação, em 26/09/2018, às 15:10, conforme art. 1º,
III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0441427 e o código CRC 0709EBAD.

0008478-63.2018.6.02.8000 0441427v1
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 27 de setembro de 2018.
À Direção-Geral.
Assunto: Indicação. Comissão de Planejamento.

Contratação. Tecnologia da Informação.
 
Senhor Diretor,
 
Considerando a instrução ora consignada, em

especial as informações colhidas no Documento de
Oficialização de Demanda (SEI 0441142)), submeto a Vossa
Excelência a proposição de designação do Coordenador de
Infraestrutura, bem como do chefe da Seção de Suporte
Operacional, ambos vinculados à Secretaria de Tecnologia da
Informação, respectivamente, como integrantes da unidade
demandante e técnica, para composição da Comissão de
Planejamento da Contratação de Solução de Tecnologia da
Informação e Comunicação, objetivando o Registro de Preço
de ativos de rede: switchs gerenciáveis, nos termos da
Resolução CNJ nº 182/2013.

Em complemento, tendo em vista a tríade
relacionada à composição acima referida, peço vênia para
indicar, como representante administrativo, o servidor Iury
Araújo Souza, lotado na Seção de Patrimônio deste Tribunal.

Respeitosamente.

Documento assinado eletronicamente por JOSÉ RICARDO ARAÚJO E SILVA,
Secretário de Administração, em 27/09/2018, às 16:09, conforme art. 1º, III, "b", da
Lei 11.419/2006.
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A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0441914 e o código CRC 87E6CF43.

0008478-63.2018.6.02.8000 0441914v1
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

CONCLUSÃO

Maceió, 27 de setembro de 2018.
Senhor Presidente,
Tendo em vista o pronunciamento constante no doc. sob

nº 0441914 e o Documento Oficial de Demanda (0441142), nos
termos da Resolução CNJ nº 182/2013, submeto à superior
consideração de Vossa Excelência a indicação, para composição
da Comissão de Planejamento objetivando o Registro de Preço de
ativos de rede: switchs gerenciáveis, como membros representantes
das unidades demandante e técnica, respectivamente, o Coordenador
de Infraestrutura, bem como do chefe da Seção de Suporte
Operacional, ambos vinculados à Secretaria de Tecnologia da
Informação, e, para atuar como representante administrativo, o
servidor Iury Araújo Souza, lotado na Seção de Patrimônio deste
Tribunal.

Documento assinado eletronicamente por JOSÉ RICARDO ARAÚJO E SILVA, Diretor-
Geral em exercício, em 27/09/2018, às 17:50, conforme art. 1º, III, "b", da Lei
11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0442128 e o código CRC B1F65A7E.

0008478-63.2018.6.02.8000 0442128v1
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
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PROCESSO : 0008478-63.2018.6.02.8000
INTERESSADO : SECRETARIA DE TECNOLOGIA DA INFORMAÇÃO
ASSUNTO : Designação de Membros de Comissão de Planejamento.

 

Decisão nº 3678 / 2018 - TRE-AL/PRE/GPRES

 
De acordo com a sugestão do Sr. Diretor-Geral 0442128.
Isto posto, APROVO a composição da Comissão de

Planejamento para Registro de Preço de ativos de rede: switchs
gerenciáveis, conforme Documento de Oficialização da Demanda -
DOD (0441142), cujos membros representantes das
unidades demandante e técnica, serão, respectivamente,
o Coordenador de Infraestrutura e o chefe da Seção de Suporte
Operacional, ambos vinculados à Secretaria de Tecnologia da
Informação, e, como representante administrativo, o servidor Iury
Araújo Souza, lotado na Seção de Patrimônio deste Tribunal.

Remeta-se à Direção-Geral para elaboração da
competente portaria e ciência aos servidores, após à SAD, para
providências.

 
DES. JOSÉ CARLOS MALTA MARQUES

Presidente do TRE/AL
 
 
 

 
Desembargador JOSÉ CARLOS MALTA MARQUES

Presidente

 

Documento assinado eletronicamente por JOSÉ CARLOS MALTA MARQUES,
Presidente, em 03/10/2018, às 16:53, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0444311 e o código CRC BE1FDE1C.

0008478-63.2018.6.02.8000 0444311v3
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS

PORTARIA PRESIDÊNCIA Nº 412/2018 TRE-AL/PRE/DG/GDG

O PRESIDENTE DO TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS, no uso de suas
atribuições legais e regulamentares,

CONSIDERANDO o contido no Processo Administrativo TRE-AL nº 0008478-
63.2018.6.02.8000 ;

CONSIDERANDO a necessidade de padronização de procedimentos para as
contratações de Tecnologia da Informação e Comunicação (TIC), de maneira que haja
previsibilidade com relação ao planejamento, à execução e à gestão dos contratos
firmados pelos órgãos submetidos ao controle administrativo e financeiro do CNJ, nos
termos da Resolução CNJ nº 182/2013,

RESOLVE:

Art. 1º Constituir Comissão de Planejamento para Registro de Preço de ativos de rede:
switchs gerenciáveis, conforme Documento de Oficialização da Demanda - DOD, cujos
membros representantes das unidades demandante e técnica, serão, respectivamente,
o Coordenador de Infraestrutura e o chefe da Seção de Suporte Operacional, ambos
vinculados à Secretaria de Tecnologia da Informação, e, como representante
administrativo, o servidor Iury Araújo Souza, lotado na Seção de Patrimônio deste
Tribunal.

Art. 2º Esta Portaria entra em vigor na data de sua publicação.

JOSÉ CARLOS MALTA MARQUES

Desembargador Presidente

Maceió, 03 de outubro de 2018.

Documento assinado eletronicamente por JOSÉ CARLOS MALTA MARQUES,
Presidente, em 04/10/2018, às 16:07, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0445262 e o código CRC E6AEEDB1.

0008478-63.2018.6.02.8000 0445262v4

Publicador_DJE nº 20180199
Disponibilização: 04/10/2018
Publicação: 05/10/2018
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

CERTIDÃO

Certifico que a Portaria Presidência nº 412/2018 foi
publicada no Diário Eletrônico da Justiça Eleitoral em Alagoas
(DEJEAL) de nº 199, de 05/10/2018, à fl. 05.

Documento assinado eletronicamente por ÉRICA SANTOS BRAGA, Técnico Judiciário,
em 05/10/2018, às 16:51, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0446491 e o código CRC 83546AF6.

0008478-63.2018.6.02.8000 0446491v2
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 05 de outubro de 2018.
Publicada a Portaria Presidência nº 412/2018 no

Diário Eletrônico da Justiça Eleitoral de Alagoas - DEJEAL,
nos termos da Certidão 0446491, determino o
encaminhamento do presente procedimento à Secretaria de
Administração e STI para ciência aos interessados e
continuidade do feito.

Documento assinado eletronicamente por MAURÍCIO DE OMENA SOUZA, Diretor-
Geral, em 05/10/2018, às 18:37, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0446493 e o código CRC C572726A.

0008478-63.2018.6.02.8000 0446493v1
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 05 de outubro de 2018.
Aos Senhores Coordenador de Infraestrutura e

Chefe da Seção de Gerência de Infraestrutura para ciência do
teor da Portaria TRE-AL nº 412/2018.

 
Atenciosamente,

Documento assinado eletronicamente por CARLOS HENRIQUE TAVARES MÉRO,
Secretário de Tecnologia da Informação, em 05/10/2018, às 19:06, conforme art. 1º,
III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0446591 e o código CRC 8BA73F82.

0008478-63.2018.6.02.8000 0446591v1
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 06 de outubro de 2018.
À SEPAT, para ciência da Portaria Presidência 412

(0445262).

Documento assinado eletronicamente por JOSÉ RICARDO ARAÚJO E SILVA,
Secretário de Administração, em 06/10/2018, às 19:22, conforme art. 1º, III, "b", da
Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0446941 e o código CRC 0F5848E6.

0008478-63.2018.6.02.8000 0446941v1
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 8000 - Maceió - AL

 

Estudos Preliminares

1. Análise de Viabilidade da Contratação (Resolução CNJ nº 182/2013 –
Arts.12 e 14)
 
1.1. Contextualização
 

A contínua evolução na área de tecnologia da informação fornece
novas soluções que tornam mais eficientes os meios de comunicação de dados,
permitindo, desta maneira, a utilização de novos recursos como forma de
aumentar disponibilidade, segurança e performance de tais meios.

Neste sentido, surge a necessidade de fomentar Registro de
Preço para aquisição de ativos gerenciáveis de rede, como medida de
viabilização a melhoria da segurança, da performance e da confiabilidade dos
meios de comunicação que são utilizados pelos cartórios eleitorais e
escritórios remotos da Justiça Eleitoral em Alagoas.
2. 2. Definição e Especificação dos Requisitos da Demanda (Art. 14, I)
 
2.1. Especificações Técnicas

Especificações técnicas mínimas (Serão definidas em detalhes no
Termo de Referência)

Gerenciáveis de forma centralizada;
Modelos de 24 e 48 portas;
Gigabit;
Compatibilidade com o software de Gerenciamento IMC
Garantia mínima de 36 meses.

 
3. 3. Soluções Disponíveis no Mercado de TIC (Art. 14, I, a):

Trata-se de solução de ativos de rede, comercializada por
diversos revendedores. No entanto, serão aceitos apenas equipamentos
integralmente compatíveis com o software de Gerenciamento IMC em uso
neste Tribunal, como forma de garantir o investimo legado.
4. Contratações Públicas Similares (Art. 14, I, b):

Pregão Eletrônico nº 11/2017, Código UASG 158513
Pregão Eletrônico nº 23/2017 - CBMGO
Pregão Eletrônico nº 44/2017 - TRF5
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5. Outras Soluções Disponíveis (Art. 14, II, a):

Não se vislumbra solução alternativo, sendo os ativos em questão infraestrutura
necessária ao funcionamento desta Justiça Especializada.

6. Portal do Software Público Brasileiro (Art. 14, II, b):
Não se aplica.

7. Alternativa no Mercado de TIC (Art. 14, II, c):
Não se aplica, considerando-se cumulativamente o exposto no

Item 5 do presente documento.
8. Modelo Nacional de Interoperabilidade – MNI (Art. 14, II, d):

Não se aplica.
9. Infraestrutura de Chaves Públicas Brasileira – ICP-Brasil (Art. 14, II,
e):

Não se aplica.
10. Modelo de Requisitos Moreq-Jus (Art. 14, II, f):

Não se aplica.
11. Análise dos Custos Totais da Demanda (Art. 14, III):

Ainda não há, neste momento, dados sobre valores, por se tratar
de Registro de Preços, aguarda-se-á, como medida de celeridade, a coleta de
preços a ser executada por unidade competente.
12. Escolha e Justificativa da Solução (Art. 14, IV):

Efetivamente, trata-se de ampliação da confiabilidade e da
segurança da malha de comunicação de dados entre a Sede do TRE/AL e as
zonas eleirorais/escritórios remotos da Justiça Eleitoral em Alagoas. Desta
forma, optou-se pela expansão do uso de equipamentos gerenciáveis, que
suprem as necessidades da solução.

 
13. Descrição da Solução (Art. 14, IV, a):

Registro de Preço para aquisição de Ativos de Rede gerenciáveis
14. Alinhamento da Solução (Art. 14, IV, b):

Esta aquisição está alinhada com o planejamento estratégico de
TIC quanto à necessidade proeminente de manutenção dos meios de
comunicação de forma confiável.

Resolução TRE/AL nº 15.809/2017, Objetivo Estratégico (OE5);
Aprimorar a segurança da informação; vinculado ao Indicador 8: Índice de
Desempenho na Implantação dos Serviços de Segurança de TIC
15. Benefícios Esperados (Art. 14, IV, c):

Ampliar a segurança da comunicação e do acesso à Internet das zonas eleitorais
Acompanhamento e gerenciamento centralizado da comunicação das zonas
eleitorais.

16. Relação entre a Demanda Prevista e a Contratada (Art. 14, IV, d):
É pretendida a aquisiçao de forma paulatina como meio de

Estudos Preliminares COINF 0448409         SEI 0008478-63.2018.6.02.8000 / pg. 19



permitir a implantação sem perda de prazos de garantia dos equipamentos.
17. Adequação do Ambiente (Art. 14, V, a, b, c, d, e, f):

Não há necessidade de ajustes para a utilização dos
equipamentos.
18. Orçamento Estimado (Art. 14, II, g):

Neste momento, os dados disponíveis podem ser vistos no
Item 11. Análise dos Custos Totais da Demanda (Art. 14, III), serão confirmados
pela SC e empregar-se-á o Orçamento Ordinário de TI, exercício 2017 e 2018,
prazo de vigência da Ata de RP pretendida.
19. Sustentação do Contrato (Art.15)
19.1. Recursos Materiais e Humanos (Art. 15, I):

Não será necessária a disponibilização de recursos humanos e/ou
materiais adicionais para sustentação da solução adquirida, após sua
implantação.
19.2. Descontinuidade do Fornecimento (Art. 15, II):

Não se trata de um serviço de natureza contínua, logo não se
aplica.
19.3. Transição Contratual (Art. 15, III, a, b, c, d, e):

Não se trata de um serviço de natureza contínua, logo não se
aplica.
19.4. Estratégia de Independência Tecnológica (Art. 15, IV, a, b):

Não se aplica.
20. Estratégia para Contratação (Art.16)
 
20.1. Natureza do Objeto (Art. 16, I):

O objeto possui características comuns e usuais encontrados no
mercado de TIC e trata-se de contrato de fornecimento de equipamentos, não
consistindo de serviço continuado.
20.2. Parcelamento do Objeto (Art. 16, II):

Como se trata de RP é natural se pensar em parcelamento.
Todavia, cada demanda, ou seja, cada ordem de fornecimento derivada do RP
deverá ser realizada de maneira integral.

20.3. Adjudicação do Objeto (Art. 16, III):

É sugerida a adjudicação por item.

20.4. Modalidade e Tipo de Licitação (Art. 16, IV):

A aquisição pretendida deverá ser realizada por meio de licitação
do tipo Pregão Eletrônico, como é de praxe neste Regional, salvo
entendimento superior contrário.

A sugestão da equipe de planejamento, por se tratar de
fornecimento de equipamento, é pela contratação por licitação via pregão. Por
conta de possibilidade de contingenciamento orçamentário indicamos a
modalidade de registro de preços.
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O DECRETO Nº 7.174, DE 12 DE MAIO DE 2010 que regulamenta a contratação de
bens e serviços de informática e automação pela administração pública federal, direta
ou indireta, pelas fundações instituídas ou mantidas pelo Poder Público e pelas demais
organizações sob o controle direto ou indireto da União deve ser aplicado nesta
aquisição por se tratar de bem de informática.

A ressalva que a equipe aponta é em relação ao artigo 3º, item II que versa sobre a
necessidade de exigências, na fase de habilitação, de certificações emitidas por
instituições públicas ou privadas credenciadas pelo Instituto Nacional de Metrologia,
Normalização e Qualidade Industrial (Inmetro), que atestem, conforme regulamentação
específica, a adequação à segurança para o usuário e instalações, compatibilidade
eletromagnética e consumo de energia.

Tal exigência inviabiliza e restringe a competição deste certame, vez que a certificação
para este tipo de produto, segundo o próprio INMETRO, é voluntária, conforme Portaria
Inmetro n.º 170 de 10/04/2012.

(fonte:http://www.inmetro.gov.br/legislacao/rtac/pdf/RTAC001808.pdf).

20.5. Classificação e Indicação Orçamentária (Art. 16, V):

A classificação e fonte dos recursos financeiros será indicada
pela Coordenadoria de Orçamento e Finanças. 

Com base no Plano de Contratações STIC/2018, vislumbra-se
como indicação 4490.52.35 - EQUIPAMENTOS DE PROCESSAMENTO DE
DADOS.

20.6. Vigência da Prestação de Serviço (Art. 16, VI)

Será, na forma dos normativos vigentes, o tempo máximo do Registro de Preços.

20.7. Equipe de Apoio à Contratação (Art. 16, VII):

Na forma da Portaria TRE/AL 412/2018, doc. 0445262:

Integrante Demandante: Coordenador de Infraestrutura de TI

E-mail: coinf@tre-al.jus.br

 

Integrante Técnico: Chefe da Seção de Suporte Operacional, ora denominda Seção de
Gerência de Infraestrutura

E-mail: segi@tre-al.jus.br

 

Integrante Administrativo: servidor Iury Araújo Souza.

20.8. Equipe de Gestão da Contratação (Art. 16, VIII):

Gestor do Contrato: Indicação a cargo da Secretaria de
Administração;

Fiscal Técnico: Indicação a cargo da Secretaria de Tecnologia da
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Informação.

21. Análise de Riscos:

A análise em questão é mínima, portanto, não exaustiva e focada em aspectos
diretamente ligados ao procedimento nas suas etapas de aquisição e fornecimento.

A pretendida contratação sugere a ampliação de segurança e confiabilidade da
comunicação das zonas eleitorais. Neste sentido, caso não ocorra a contratação
também não serão implementadas as melhorias presentidas, tornando a malha de
comunicação mais vulnerável em certos aspectos.

 

Risco
1

Risco: Falta de recursos orçamentários para a aquisição da
solução ou parte dela

Probabilidade:  Id Dano Impacto

Média 2
Ausência de solução para planos
de ampliação da rede conectada de
forma segura

Paralisação
dos serviços

atrelados

 

Id Ação de Mitigação e Contingência Responsável

1
Utilização de recursos
destinados a outras
aquisições para contemplar
esta necessidade;

STI

 

Risco
2

Risco: Atraso na aquisição

Probabilidade:  Id Dano Impacto

Média 2
Ausência de solução para planos
de ampliação da rede conectada de
forma segura

Paralisação
dos serviços

atrelados
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Id Ação de Mitigação e Contingência Responsável

1 Solicitação de aceleração de
trâmites internos. STI

 

 

 

Risco
3

Risco: Atraso na entrega da solução

Probabilidade:  Id Dano Impacto

Média 2
Ausência de solução para planos
de ampliação da rede conectada de
forma segura

Paralisação
dos serviços

atrelados

 

Id Ação de Mitigação e Contingência Responsável

1 Notificar a contratada. Gestor do
contrato

 

Lista de Potenciais Fornecedores

Fornecedor 01:
Nome: G3 Solutions
Sítio: http://www.g3solutions.com.br/
Telefone: 81 3471-8600 / 81 8173-7134
E-mail: alexandre.barros@g3solutions.com.br
Contato: Alexandre Barros

Fornecedor 02:
Nome: SUPORTE INFORMÁTICA
Sítio: http://www.suporteinformatica.com
Telefone: 81 3202-9100 / 81 3244-9697 / 81 8178-6653
E-mail: andre.brasileiro@suporteinformatica.com
Contato: André Brasileiro
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Fornecedor 03:
Nome: TELTEC NETWORKS
Sítio: http://atasteltec.com.br
Telefone: 81 2122-3023

Fornecedor 04:
Nome: PISONTEC
Sítio: http://www.pisontec.com
E-mail: michel@pisontec.com

Fornecedor 05:
Nome: INFINIIT
Sítio: http://www.infiniit.com.br
E-mail: guilherme@infiniit.com.br

Fornecedor 06:
Nome: SWT
Sítio: http://www.swt.com.br/
Email: bsabino@swt.com.br
Telefone: 32213731

Fornecedor 07:
Nome: Plugnet
Sítio: http://www.plugnetshop.com.br/
Telefone: (81) 34267006
Email: max@plugnetshop.com.br

Fornecedor 08:
Nome: PCT Informática
Sítio: http://www.pctinformatica.com.br/
Telefone: (82) 3241-5300
Email: pct@pctinformatica.com.br

Fornecedor 09:
Nome: Usetech
Sítio: http://www.usetech.net
Telefone: (82) 3327-9436
Email: maxwell@usetech.net

Fornecedor 10:
Nome: Inovva
Sítio: http://www.grupoinovva.com.br
Telefone: (61) 3032-6602
Email: olivan@grupoinovva.com.br

Fornecedor 11:
Nome: Altasnet
Sítio: http://www.grupoinovva.com.br
Telefone: (31) 3449-4516
Email: arnaldo.paula@altasnet.com.br
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Obs.: a aguardar retorno oportuno, por parte da Seção de Compras, para registro de
novos potenciais fornecedores para uso em referência futura noutros procedimentos.

Maceió, 11 de outubro de 2018.

Documento assinado eletronicamente por DANIEL MACÊDO DE CARVALHO SOUTO,
Coordenador, em 11/10/2018, às 11:55, conforme art. 1º, III, "b", da Lei 11.419/2006.

Documento assinado eletronicamente por CRISTINO HERMANO DE BULHÕES, Chefe
de Seção, em 11/10/2018, às 20:03, conforme art. 1º, III, "b", da Lei 11.419/2006.

Documento assinado eletronicamente por IURY ARAÚJO SOUZA, Técnico Judiciário,
em 18/10/2018, às 17:50, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0448409 e o código CRC F84B57B6.

0008478-63.2018.6.02.8000 0448409v16
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 8000 - Maceió - AL

 

DESPACHO

Maceió, 16 de outubro de 2018.
À SEPAT
Ao servidor Iury Araújo Souza
 
Prezado,
 
Submento à apreciação os Estudos Preliminares,

doc. 0448409, disponibilizado em bloco de assinatura, em
decorrência da Portaria 412/2018, doc. 0445262.

 
Atenciosamente.

Documento assinado eletronicamente por DANIEL MACÊDO DE CARVALHO SOUTO,
Coordenador, em 16/10/2018, às 18:39, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0450358 e o código CRC 4D7AFF7C.

0008478-63.2018.6.02.8000 0450358v1
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 8000 - Maceió - AL

 

Termo de Referência - TIC nº 20 / 2018

Termo de Referência - Soluções de Tecnologia da Informação

QUADRO RESUMO 

01. Objeto Registro de Preço para aquisição de componentes de rede (Networking)

LOTE 01 - SOLUÇÃO PARTA REDE CABEADA

ITEM DESCRIÇÃO DOS PRODUTOS/SERVIÇOS QTD

ITEM
01

SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE
ACESSO PARA REDE CABEADA 01

ITEM
02

LICENCIAMENTO ADICIONAL PARA SISTEMA DE
GERENCIAMENTO HPE IMC 03

ITEM
03

LICENCIAMENTO ADICIONAL DO MÓDULO DE ANÁLISE
DE TRAFEGO DO SISTEMA DE GERENCIAMENTO HPE
IMC

02

ITEM
04

LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE
ANÁLISE DE PERFIL E CONTROLE DE ACESSO 02

ITEM
05

SWITCH DE DISTRIBUIÇÃO COM 16 PORTAS SFP+ E
SUPORTE A MÓDULOS DE EXPANSÃO 06

ITEM
06

MÓDULO COM 4 PORTAS SFP+ PARA SWITCH DE
DISTRIBUIÇÃO 16

ITEM
07

MÓDULO DE STACKING COM 4 PORTAS PARA SWITCH
DE DISTRIBUIÇÃO 06

ITEM
08

SWITCH DE ACESSO L3 COM 48 PORTAS GIGABIT E
4SFP+ 50

ITEM
09

SWITCH DE ACESSO L3 COM 24 PORTAS GIGABIT E
4SFP+ 40

ITEM
10

SWITCH DE ACESSO L2 COM 24 PORTAS GIGABIT E
4SFP 50

ITEM
11

SWITCH DE ACESSO L2 COM 48 PORTAS GIGABIT E
4SFP 40

ITEM
12 GBIC 10GB PARA ATÉ 300M 50

ITEM
13 CABO DAC 10 GBPS DE 1M 30

ITEM
14 CABO DAC 10 GBPS DE 3M 30

ITEM
15 GBIC 1GB PARA ATÉ 500M 10
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02. Quantidade

ITEM
16

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE
TECNOLOGIA PARA SWITCHS DE REDE 05

ITEM
17

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO 01

ITEM
18

TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE
SWITCHES 04

ITEM
19

TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE
DE ACESSO 04

LOTE 02 - SOLUÇÃO DE REDE WIRELESS

ITEM DESCRIÇÃO DOS PRODUTOS/SERVIÇOS QTD

ITEM
01

SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE
ACESSO PARA REDE WIRELESS 01

ITEM
02 SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS 01

ITEM
03

LICENÇAS ADICIONAIS PARA SOLUÇÃO DE
GERENCIAMENTO DE REDE WIRELESS 200

ITEM
04

LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE
ANÁLISE DE PERFIL E CONTROLE DE ACESSO 02

ITEM
05 CONTROLADORA WLAN 04

ITEM
06 LICENÇAS ADICIONAIS PARA CONTROLADORA WLAN 200

ITEM
07 PONTO DE ACESSO INTERNO TIPO 01 100

ITEM
08 PONTO DE ACESSO INTERNO TIPO 02 100

ITEM
09 INJETOR POE PARA PONTOS DE ACESSO TIPO 1 100

ITEM
10 INJETOR POE PARA PONTOS DE ACESSO TIPO 2 100

ITEM
11

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE
TECNOLOGIA PARA SOLUÇÃO DE GERENCIAMENTO 01

ITEM
12

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO 01

ITEM
13

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE
TECNOLOGIA PARA PONTOS DE ACESSO 05

ITEM
14

TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE
ARQUITETURA WLAN 04

ITEM
15

TREINAMENTO BÁSICO DA SOLUÇÃO DE
GERENCIAMENTO 04

Termo de Referência - TIC 20 (0450416)         SEI 0008478-63.2018.6.02.8000 / pg. 28



ITEM
16

TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE
DE ACESSO 04

03. Resumo da Especificação do
Objeto

Por se tratar de quantidade elevata de itens partencente a lotes específicos, o
detalhamento das especificações está consntante no DETALHAMENTO DO OBJETO (Art. 18, § 3º, III).

04. Valor Estimado Os custos totais projetados, por certo, serão objeto de levantamento por parte da Seção
de Compras, em momento porterior.

05. Justificativa

A dependência tecnológica para o adequado funcionamento de qualquer instituição é na prática, total;
A malha de comunicação de rede interna é primordial para  acesso aos sistemas e serviço informatizados e
desta maneira essencial;
Grande parte dos equipamentos de rede do Tribunal está defasado tecnologicamente,  fora de garantia ou na
iminência de término da mesma;
Permitir a qualificação da equipe da CONIF para o gerenciamento das soluções a serem adquiridas;
Maiores detalhes disponíveis no Item 2 do Documento de Oficialização da Demanda.

06. Prazo de Entrega
O prazo máximo para o fornecimento das licenças é de 90 (noventa) dias corridos após o recebimento da ordem
de fornecimento, nota de empenho ou documento equivalente. Não podendo ultrapassar, conforme o caso, o dia
15 de dezembro ou dia útil subsequente considerado cada exercício individualmente, em decorrência dos efeitos
da Emenda Constitucional nº 95/2016

07. Adjudicação
Por Lote.

Justificativa: Plena exigência de total compatibilidade e interoperabilidade entre em componentes do respectivo lote,
como também quanto à solução de gerenciamento em uso no TRE/AL.

08. Classificação Orçamentária (A cargo da COFIN).

09. Local de Entrega

Almoxarifado do Tribunal Regional Eleitoral de Alagoas

Av. Menino Marcelo, 7200D, Serraria

Maceió – AL CEP 57046-005 Tel.: (82) 3328-1947

Horário: De segunda-feira a quinta-feira das 13 às 19h e sexta-feira das 7h30min Às 13h30min.
10. Unidade Fiscalizadora SEGI/CIE/STI
11. Unidade Gestora SAD

12. Sanções Administrativas
Vide

Item 3.2 Forma de Execução e de Gestão do Contrato (Art. 18, § 3º, III, a)
Subitem Penalidades (Art. 18, § 3º, III, a, 11)

13. Prazo de Pagamento
Vide 

Item 3.2 Forma de Execução e de Gestão do Contrato (Art. 18, § 3º, III, a)
Subitem Forma de Pagamento (Art. 18, § 3º, III, a, 7)

14. Estratégia de Recebimento
Vide 

Item 3.2 Forma de Execução e de Gestão do Contrato (Art. 18, § 3º, III, a)
Subitem Recebimento do Objeto:

15. Modalidade e Tipo de
Licitação

Vide

2.11 Modalidade, Tipo de Licitação, Critérios de Habilitação e Atendimento aos Requisitos (Art. 18, § 3º, II, j, IV e V)

 

1. OBJETO (Art. 18, §3º,I):
 

Registro de Preço para aquisição de componentes de rede sem
fio e cabeada.

1.1 Definição (Art. 18, §3º, I)

Registro de Preço para aquisição de computadores  para
substituir equipamentos fora de garantia e/ou obsoletos.
2. FUNDAMENTAÇÃO DA CONTRATAÇÃO (Art. 18, § 3º, II)
 
2.1 Motivação (Art. 18, § 3º, II, a )

Os equipamentos tem por finalidade a substituição, por atualização tecnológica, de
equipamentos, ora em uso, com aproximadamente 04 (quatro) anos e já não mais
cobertos por garantia. Estes aspectos, a um só tempo, a se falar em TI, evidenciam a
necessidade de atualização e de demanda de salvaguarda, esculpida em garantia, da
efetividade e continuidade do mister da Secretaria.

 

A estratégia de Registro de Preços está amparada no Decreto nº 7.892/2013, art 3º,
incisos:

I - vez que os equipamentos podem ser objeto de diversas aquisições/fornecimentos
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até que se supra progressivamente toda a demanda de substituição progressiva;

II - as entregas deve ser progressivas de forma que as equipes da STI, em número
limitado, possam implantar os equipamentos sem que os mesmo precisem ser
estocados por longos períodos apenas exaurindo seus prazos de garantia.

2.2 Objetivos (Art. 18, § 3º, II, b)
A contratação visa, além de promover ações no sentido de

elaborar novo instrumento que mantenha um meio para disponibilizar os
computadores demandados e:

Garantir a infraestrutura física apropriadas às atividades
administrativas e judiciais.

Prover infraestrutura de TIC apropriada às atividades judiciais e
administrativas.
2.3 Benefícios (Art. 18, § 3º, II, c)

Reposição de equipamentos defasados e manutenção da capacidade produtiva
atualizada.

2.4 Alinhamento Estratégico (Art. 18, § 3º, II, d)

O alinhamento com o PEI é identificado na visão do recursos de infraestrutura e
tecnologia em seus dois aspectos apontados:

Garantir a infraestrutura física apropriadas às atividades administrativas e judiciais.

Alinhamento com os Objetivos Estratégicos da Estratégia Nacional de TIC do Poder
Judiciário nos seguintes aspectos:

Prover infraestrutura de TIC apropriada às atividades judiciais e administrativas.

Alinhamento com os Objetivos Estratégicos de TIC da Justiça Eleitoral de Alagoas –
2017/2022 nos seguintes aspectos:

Viabilizar serviços e soluções de TIC.

 

2.5 Referência aos Estudos Preliminares (Art. 18, § 3º, II, e)
Este Termo de Referência foi elaborado considerando o

Documento de Oficialização de Demanda (DOD) encaminhado pela Secretaria
de Tecnologia da Informação (STI) e os Estudos Preliminares constantes do
Processo SEI nº 0008478-63.2018.6.02.8000.
2.6 Relação entre a Demanda Prevista e a Contratada (Art. 18, §3º, II, f)

É pretendida a renovação do parque de equipamentos
componentes da infraestrutura de TIC.
2.7 Análise de Mercado de TIC (Art. 18, § 3º, II, g)

Verifica-se que os bens e serviços pretendidos poderão ser
fornecidos por diferentes empresas no mercado de TIC.

Considerando o Item 7 dos Estudos Preliminares, não se
vislumbrou alternativa que não o presente Registro de Preços.

 
2.8 Natureza do Objeto (Art. 18, § 3º, II, h)

Os bens e serviços a serem contratados possuem características
comuns e usuais encontradas atualmente no mercado de TIC, cujos padrões de
desempenho e de qualidade podem ser objetivamente definidos neste Termo
de Referência.

O objeto desta contratação tem como escopo a obtenção de
produto específico em período determinado, portanto não se caracteriza como
serviço de natureza continuada.
2.9 Parcelamento e Adjudicação do Objeto (Art. 18, § 3º, II, i)

Não haverá parcelamento, cada ordem de fornecimento derivado
do Registro de Preços deverá ser realizada de maneira integral.

Adjudicação será por lote.
2.10 Vigência

Será, na forma dos normativos vigentes, o tempo máximo do
Registro de Preços.

A vigência da ata será de 12 (doze) meses, contados a partir de
sua assinatura.

A utilização do sistema de Registro de Preços visa,
primordialmente, a redução de número de licitações para o mesmo objeto,
porquanto se concentra em um único procedimento a possibilidade de realizar
diversas aquisições recorrentes e necessárias, via ordens de fornecimento,
durante o lapso temporal de sua vigência, em face de os preços
permanecerem à disposição da Administração.
2.11 Modalidade, Tipo de Licitação, Critérios de Habilitação e
Atendimento aos Requisitos (Art. 18, § 3º, II, j, IV e V)

A aquisição pretendida deverá ser realizada por meio de licitação
do tipo Pregão Eletrônico, como é de praxe neste Regional, salvo
entendimento superior contrário.

A sugestão da equipe de planejamento, por se tratar de
fornecimento de equipamento, é pela contratação por licitação via pregão. Por
conta de possibilidade de contingenciamento orçamentário indicamos a
modalidade de registro de preços.
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O DECRETO Nº 7.174, DE 12 DE MAIO DE 2010 que regulamenta a contratação de
bens e serviços de informática e automação pela administração pública federal, direta
ou indireta, pelas fundações instituídas ou mantidas pelo Poder Público e pelas demais
organizações sob o controle direto ou indireto da União deve ser aplicado nesta
aquisição por se tratar de bem de informática.

A ressalva que a equipe aponta é em relação ao artigo 3º, item II que versa sobre a
necessidade de exigências, na fase de habilitação, de certificações emitidas por
instituições públicas ou privadas credenciadas pelo Instituto Nacional de Metrologia,
Normalização e Qualidade Industrial (Inmetro), que atestem, conforme regulamentação
específica, a adequação à segurança para o usuário e instalações, compatibilidade
eletromagnética e consumo de energia.

Tal exigência inviabiliza e restringe a competição deste certame, vez que a certificação
para este tipo de produto, segundo o próprio INMETRO, é voluntária, conforme Portaria
Inmetro n.º 170 de 10/04/2012.

(fonte:http://www.inmetro.gov.br/legislacao/rtac/pdf/RTAC001808.pdf).

pretendida deverá ser realizada por meio de licitação do tipo
Pregão Eletrônico, como é de praxe neste Regional, salvo entendimento
superior contrário.

A sugestão da equipe de planejamento, por se tratar de
fornecimento de equipamento, é pela contratação por licitação via pregão. Por
conta de possibilidade de contingenciamento orçamentário indicamos a
modalidade de registro de preços.

O DECRETO Nº 7.174, DE 12 DE MAIO DE 2010 que regulamenta a contratação de
bens e serviços de informática e automação pela administração pública federal, direta
ou indireta, pelas fundações instituídas ou mantidas pelo Poder Público e pelas demais
organizações sob o controle direto ou indireto da União deve ser aplicado nesta
aquisição por se tratar de bem de informática.

A ressalva que a equipe aponta é em relação ao artigo 3º, item II que versa sobre a
necessidade de exigências, na fase de habilitação, de certificações emitidas por
instituições públicas ou privadas credenciadas pelo Instituto Nacional de Metrologia,
Normalização e Qualidade Industrial (Inmetro), que atestem, conforme regulamentação
específica, a adequação à segurança para o usuário e instalações, compatibilidade
eletromagnética e consumo de energia.

Tal exigência inviabiliza e restringe a competição deste certame, vez que a certificação
para este tipo de produto, segundo o próprio INMETRO, é voluntária, conforme Portaria
Inmetro n.º 170 de 10/04/2012.

(fonte:http://www.inmetro.gov.br/legislacao/rtac/pdf/RTAC001808.pdf).

2.12 Adequação do Ambiente (Art. 18, § 3º, II, k)
Para utilização do objeto pretendido é necessário dispor de

infraestrutura física para sua instalação, situação essa já existente no âmbito
do TRE/AL, salvo o surgimento de demanda muito particular e além da
previsibilidade.
2.13 Conformidade Técnica e Legal (Art. 18, § 3º, II, l)

 
2.14 Obrigações do Contratante (Art. 18, § 3º, II, m)

1. Efetuar o pagamento à Contratada, após o recebimento definitivo;

2. Acompanhar e fiscalizar a execução do objeto da Ata de Registro de Preços e
do(s) contrato(s) dela decorrentes, por meio de servidor(es) designado(s),
de modo a garantir o fiel cumprimento do mesmo e da proposta;

3. Manter arquivo, junto ao processo administrativo ao qual está vinculado o presente termo, toda a documentação referente ao mesmo;

4. Proporcionar todas as facilidades indispensáveis à
boa execução das obrigações contratuais; e

5. Aplicar as sanções conforme previsto no contrato, assegurando à Contratada o contraditório e ampla defesa.

2.15 Obrigações da Contratada (Art. 18, § 3º, II, m)
As obrigações abaixo são aplicáveis ao objeto a ser contratado.

1. Fornecer o(s) equipamento(s) conforme especificações, quantidades, prazos e demais condições estabelecidas no Edital, na
Ata de Registro de Preços, na Ordem de Fornecimento, na Proposta e
no Contrato;

2. Fornecer a documentação necessária à instalação e
à operação dos produtos (manuais, termos de garantia,
etc.), completa, atualizada e em português do Brasil, caso exista, ou
em inglês;

3. Disponibilizar Central
de Atendimento para a abertura e fechamento de chamados técnicos, conforme períodos, horários e condições estabelecidas no Edital e
em seus Anexos;

4. Comunicar formal e imediatamente ao Gestor ou Responsável Técnico da
Administração sobre mudanças nos dados para contato com a Central
de Atendimento;

5. Prestar as informações e os esclarecimentos que venham a
ser solicitados pelo representante da
Administração, referentes a qualquer problema detectado ou
ao andamento de atividades da garantia;

6. Responder
por quaisquer prejuízos que seus profissionais causarem ao patrimônio da
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Administração ou a terceiros,
por ocasião da execução do objeto, procedendo imediatamente aos reparos ou
às indenizações cabíveis e assumindo o ônus decorrente;

7. Responsabilizar-se  integralmente pelo fornecimento dos equipamentos e
pela execução dos serviços de garantia técnica, primando pela qualidade,
desempenho, eficiência e produtividade na execução dos trabalhos,
dentro dos prazos estipulados e cujo descumprimento será considerado
infração passível de aplicação das penalidades previstas neste Termo de
Referência;

8.  Comunicar ao Gestor ou Responsável Técnico, formal
e imediatamente, todas as ocorrências anormais e/ou
que possam comprometer a execução do objeto;

9. Manter sigilo sobre todo e qualquer assunto de interesse da
Administração ou de terceiros de que tomar conhecimento em razão da
execução do objeto, respeitando todos os critérios estabelecidos,
aplicáveis aos dados, informações, regras de negócios, documentos, entre
outros pertinentes, sob pena de responsabilidade civil, penal e
administrativa;

10.  Cumprir e garantir que seus profissionais estejam cientes, aderentes e obedeçam rigorosamente às normas e
aos procedimentos estabelecidos na Política de Segurança da Informação
do TRE/AL;

11.  Responsabilizar-
se pela conservação dos ambientes onde desempenhe as atividades necessárias para prestar a garantia on-
site.

12. Prestar as informações e
os esclarecimentos que venham a ser solicitados pela Administração, referentes a qualquer problema detectado ou
ao andamento de atividades da garantia técnica

13. No caso de fornecimento/entrega, em final de exercício e posterior
ao dia 15 de dezembro ou dia útil imediatamente subsquente, fica
obrigado a aceitar, o cancelamento da ordem de fornecimento por
parte da Administração, em decorrência dos efeitos da Emenda
Constitucional nº 95/2016, sem a reversão de qualquer ônus à
Administração.

DETALHAMENTO DO OBJETO (Art. 18, § 3º, III)
3.1 Descrição do Objeto

CONDIÇÕES GERAIS
1. Todos os itens ofertados por lote, deverão ser do mesmo fabricante para garantir

total compatibilidade entre todos os componentes, sem a utilização de
ferramentas de terceiros ou modo de interoperabilidade na solução;

2. Para o  Lote 01: Todos os itens de software ofertados deverão possuir integração
total com o HPE Intelligent Managment Center (IMC) já existente na infraestrutura
da contratante, através de interface única de gerenciamento e/ou autenticação
centralizada;

3. Para o Lote 01: Os equipamentos fornecidos deverão ser gerenciados pelo HPE
IMC já existente na infraestrutura da contratante, com presença na matriz de
compatibilidade comprovada através de documentação oficial do fabricante;

4. Os equipamentos devem ser novos e estar em produção. Não serão aceitos
equipamentos descontinuados, recondicionados ou usados;

5. Os equipamentos devem ser entregues acondicionados adequadamente em suas
embalagens originais;

6. A(s) solução(ões) de gerenciamento/controle ofertada(s), deverá(ão) ser
baseada(s) em plataforma “On Premise”, ou seja, deverá ser executada
localmente, não sendo aceitas soluções híbridas ou em Cloud;

7. Cada lote deverá ser fornecido por uma única empresa, visando a garantia integral
de compatibilidade dos componentes ofertados;

8. As configurações e especificações aqui apresentadas são mínimas, sendo aceitos
equipamentos/softwares com características superiores, desde que compatíveis
com as exigidas;

9. Prazo de entrega para equipamentos: 60 (sessenta) dias contados a partir da
emissão da ordem de fornecimento ou documento equivalente;

10. Prazo de entrega para softwares: 30 (trinta) dias contados a partir da emissão da
ordem de fornecimento ou documento equivalente;

11. Os serviços de instalação, integração, garantia e suporte dos equipamentos e
softwares, deverão ser realizados diretamente pelo fabricante de acordo com as
exigências contidas no descritivo dos mesmos, estando essas aderentes aos
respectivos níveis de serviço necessários a cada um deles.

 
 
LOTE 01 – SOLUÇÃO DE REDE
CABEADA
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ITEM 01 – SOLUÇÃO DE ANÁLISE DE PERFIL E
CONTROLE DE ACESSO
LICENCIAMENTO

1. Licenciamento da SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE
ACESSO, contemplando o quantitativo mínimo de 1.000 (um mil) dispositivos,
usuários corporativos ou visitantes simultâneos, independente do perfil de
autenticação, seja por dispositivo ou usuário;

2. Caso a solução ofertada necessite de licenciamento específico para
credenciamento dos dispositivos, usuários (corporativos ou visitantes), deverá ser
fornecido o quantitativo solicitado para ambos, de forma que a solução realize a
análise de perfil e o controle de acesso dos 1.000 (um mil) dispositivos ou
usuários (corporativos ou visitantes) simultâneos.

 

MÓDULO DE ANÁLISE DE PERFIL DE DISPOSITIVO
Características Gerais Modulo de Análise de Perfil de Dispositivo

3. Deve implementar funcionalidade de classificação automática criando perfis de
dispositivos, de forma a descobrir, classificar e agrupar os dispositivos
conectados na rede;

4. Deve categorizar os dispositivos em pelo menos 3 níveis:

a. Por tipo de dispositivo (ex. Computador, Smartdevice, impressora, etc.);

b. Por sistema operacional (ex. Windows, Linux, MacOS, etc.);

c. Versão do sistema operacional (ex. Windows 7, Windows 2008 Server, etc.);

5. Deve ser capaz de gerar gráficos das categorias, separando os dispositivos
conforme suas características;

6. Deve suportar a coleta de informações, para classificação, usando no mínimo:

a. DHCP;

b. HTTP User-Agent;

c. MAC OUI;

d. ActiveSync plugin;

e. SNMP;

f. Subnet Scanner;

g. IF-MAP;

h. Cisco Device Sensor;

i. MDM;

j. TCP Fingerprinting.

7. Deve possuir dicionário de categorias de dispositivos pré-configurado e
mecanismo de atualização do mesmo;

8. Deve suportar a integração com, no mínimo, as seguintes soluções de MDM de
mercado AirWatch, MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, MaaS 360
devendo comprovar a compatibilidade em documentação oficial do fabricante;

9. Deve permitir priorização na ordem de criação dos perfis com no mínimo as
seguintes características:

a. Agente proprietário;

b. HTTP User-Agent;

c. SNMP;

d. DHCP;

e. MAC OUI.

10. A solução de análise de perfil de usuários deverá permitir consultas a sua base,
pela solução de controle de acesso para validação de dispositivos com base no
seu perfil.

 

MÓDULO DE CONTROLE DE ACESSO DE DISPOSITIVOS E
USUÁRIOS
Características Gerais

11. A Solução deverá dar suporte a no mínimo as seguintes bases de dados:

a. Microsoft Active Directory;
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b. Kerberos;

c. Diretórios LDAP;

d. Novell eDirectory;

e. OpenLDAP;

f. Sun Directory Server;

g. PostgreSQL;

h. Oracle 11g;

i. MariaDB;

j. MSSQL;

k. Servidores de Token;

l. Base de dados SQL interna;

m. Lista interna estática de hosts.

12. Deve suportar "Single Sign-on" (SSO) através de SAML v2.0;

13. Deve implementar gerenciamento e aplicação de políticas de autorização de
acesso de usuários com base em:

a. Atributos do usuário autenticado;

b. Hora do dia, dia da semana;

c. Tipo de dispositivo utilizado;

d. Localização do usuário;

e. Tipo de autenticação utilizada.

14. Deve permitir a visualização de todas informações relativas a cada transação e
autenticação em uma única tela, a solução deverá trazer no mínimo as seguintes
informações:

a. Data e Hora;

b. Mac Address do dispositivo;

c. Classificação do dispositivo;

d. Usuário;

e. Equipamento que requisitou a autenticação (origem);

f. Método de autenticação utilizado;

g. Fonte de autenticação utilizada para validação;

h. Perfil de acesso aplicado;

i. Atributos de entrada do protocolo utilizados na requisição (ex. RADIUS);

j. Informações de resposta da solução para o elemento de rede;

k. Alertas em caso de falha;

l. LOGS já filtrados para a requisição em análise.

15. Deve possuir Dashboard customizável, onde deve permitir a visualização de no
mínimo as seguintes informações:

a. a. Lista com últimos Alertas do sistema;

b. Gráfico com todas as requisições de autenticação dos últimos 7 dias,
incluindo RADIUS, TACACS+ e Autenticações Web;

c. Gráfico com o status das autenticações aceitas e rejeitadas nos últimos 7
dias;

d. Gráfico com a categorização dos dispositivos classificados pela solução,
divididos de acordo com as categorias de classificação;

e. Últimas falhas de autenticação;

f. Gráfico com as requisições de avaliação de postura dos dispositivos,
divididos em:

I. Saudáveis (dentro das políticas estabelecidas);

II. Não saudáveis (que estão fora das políticas estabelecidas);

a. a. Lista com as últimas autenticações;

b. Lista com as últimas autenticações com sucesso;

c. Utilização de CPU do sistema, no mínimo nos últimos 30 minutos;

16. Deve possuir base de regras e categorias de dispositivos pré-configurada e
mecanismo de atualização da mesma;

17. Deve suportar a integração com no mínimo as seguintes soluções de MDM de
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mercado AirWatch, MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, MaaS 360
devendo comprovar a compatibilidade em documentação oficial do fabricante;

18. Deve suportar autenticações via OAuth2, Facebook, Twitter, LinkdIn, Office365 e
Google Apps;

19. Deve possuir recursos integrados de AAA: RADIUS, TACACS+ e Kerberos;

20. Deve possuir suporte aos seguintes recursos:

a. RADIUS;

b. RADIUS CoA;

c. TACACS+;

d. Web authentication;

e. SAML v2.0;

f. EAP-FAST (EAP-MSCHAPv2, EAP-GTC, EAP-TLS);

g. PEAP (EAP-MSCHAPv2, EAP-GTC, EAP-TLS, EAP-PEAP-Public);

h. TTLS (EAP-MSCHAPv2, EAP-GTC, EAP- TLS, EAP-MD5, PAP, CHAP);

i. EAP-TLS;

j. PAP, CHAP, MSCHAPv1, MSCHAPv2, and EAP-MD5;

k. Windows machine authentication;

l. MAC address authentication (dispositivos sem suporte a 802.1X);

21. Deve suportar verificação de vulnerabilidade através de varredura de portas;

22. Deve suportar à aplicação de políticas em ambiente com múltiplos fornecedores
de Wireless, cabeado e VPN;

23. Deve possuir CA integrada, para geração de certificados para os dispositivos que
forem se autenticar na rede;

24. Deve suportar à integração com plataforma de terceiros usando HTTP/RESTful
API;

25. Deve permitir que a solução faça consultas em bases SQL, com o objetivo de
buscar informação a serem utilizadas durante o processo de autenticação dos
usuários;

26. Deve possuir suporte a administração através de IPv6;

27. Deve possuir ferramenta para gerenciar os processos de credenciamento,
autenticação, autorização e contabilização de usuários visitantes através de portal
web seguro;

28. Deve implementar a criação de grupos de autorizadores com privilégios distintos
de criação de credenciais temporárias e atribuição de permissões de acesso aos
clientes;

29. Deve permitir realizar a autenticação dos autorizadores em base externa do tipo
Microsoft Active Directory ou LDAP e atribuir o privilégio ao autorizador de acordo
com o seu perfil;

30. Deve implementar as funcionalidades de geração de lotes de credenciais
aleatórias, temporárias, pré-autorizadas;

31. Deve implementar a importação e exportação da relação de credenciais
temporárias através de arquivos txt ou csv;

32. Deve permitir a configuração do tempo de validade das credenciais, baseando-se
na criação da conta ou no primeiro login da conta;

33. Deve permitir que o visitante crie sua própria credencial temporária (autosserviço)
através de portal web, com ou sem a necessidade de um autorizador;

34. Deve permitir a customização do formulário de criação de credenciais, a ser
preenchido pelo autorizador ou pelo visitante em caso de autosserviço,
especificando quais informações cadastrais dos visitantes são obrigatórias ou
opcionais;

35. Deve permitir a customização do nível de segurança da senha temporária que
será gerada ao visitante, especificando a quantidade mínima de caracteres e o uso
de caracteres especiais e números para compor a senha;

36. Deve exigir que o usuário visitante aceite o “Termo de uso da rede” a cada login
ou apenas no primeiro login;

37. Deve permitir o envio das credenciais aos usuários registrados através de
mensagens SMS (Short Message Service), e-mail ou impressão local.

 

GARANTIA E SUPORTE

38. Garantia e suporte do fabricante para a solução de software ofertada pelo período
mínimo de 36 (sessenta) meses, incluindo a evolução para novas versões
devendo o atendimento ser na modalidade 24x7 (vinte quatro horas por dia, sete
dias da semana), com tempo de resposta máximo em 4 (quatro) horas;
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39. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução;

40. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
disponibilidade ainda de área para cadastro da solução de software ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;

41. A empresa fabricante da solução de software deverá dispor de um número
telefônico tipo 0800 para suporte técnico e abertura de chamados técnicos.

42. A comprovação da modalidade da garantia deverá ocorrer através de
documentação do fabricante de domínio público, não sendo aceita documentação
emitida pelo fornecedor ou centro de distribuição para fins de comprovação que
por ventura conflitem com catálogos, manuais, folders oficiais impressos ou da
internet (devendo constar o endereço URL para folders da web). Caso não seja
comprovada por um dos meios citados anteriormente, será possível a
comprovação através da apresentação de documentação expressa do fabricante
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso
de documentação expressa do fabricante deverá ser anexada a mesma a
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.

 

ITEM 02 – LICENCIAMENTO ADICIONAL PARA
SISTEMA DE GERENCIAMENTO HPE IMC
Características técnicas mínimas

1. Licenciamento para expansão do SISTEMA DE GERENCIAMENTO HPE IMC
existente na infraestrutura da contratante, contemplando o quantitativo adicional
mínimo de 50 (cinquenta) dispositivos simultâneos;

 

GARANTIA E SUPORTE

1. Garantia e suporte do fabricante para a solução de software ofertada pelo período
mínimo de 36 (sessenta) meses, incluindo a evolução para novas versões
devendo o atendimento ser na modalidade 24x7 (vinte quatro horas por dia, sete
dias da semana), com tempo de resposta máximo em 4 (quatro) horas.

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução.

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
disponibilidade ainda de área para cadastro da solução de software ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;

4. A empresa fabricante da solução de software deverá dispor de um número
telefônico tipo 0800 para suporte técnico e abertura de chamados técnicos.

5. A comprovação da modalidade da garantia deverá ocorrer através de
documentação do fabricante de domínio público, não sendo aceita documentação
emitida pelo fornecedor ou centro de distribuição para fins de comprovação que
por ventura conflitem com catálogos, manuais, folders oficiais impressos ou da
internet (devendo constar o endereço URL para folders da web). Caso não seja
comprovada por um dos meios citados anteriormente, será possível a
comprovação através da apresentação de documentação expressa do fabricante
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso
de documentação expressa do fabricante deverá ser anexada a mesma a
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.

 

ITEM 03 – LICENCIAMENTO ADICIONAL DO
MÓDULO DE ANÁLISE DE TRAFEGO DO SISTEMA DE
GERENCIAMENTO HPE IMC
Características técnicas mínimas

1. Licenciamento para expansão do MÓDULO DE ANÁLISE DE TRAFEGO DO
SISTEMA DE GERENCIAMENTO HPE IMC existente na infraestrutura da
contratante, contemplando o quantitativo adicional mínimo de 5 (cinco)
dispositivos simultâneos;

 

GARANTIA E SUPORTE

1. Garantia e suporte do fabricante para a solução de software ofertada pelo período
mínimo de 36 (sessenta) meses, incluindo a evolução para novas versões
devendo o atendimento ser na modalidade 24x7 (vinte quatro horas por dia, sete
dias da semana), com tempo de resposta máximo em 4 (quatro) horas.
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2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução.

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
disponibilidade ainda de área para cadastro da solução de software ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;

4. A empresa fabricante da solução de software deverá dispor de um número
telefônico tipo 0800 para suporte técnico e abertura de chamados técnicos.

5. A comprovação da modalidade da garantia deverá ocorrer através de
documentação do fabricante de domínio público, não sendo aceita documentação
emitida pelo fornecedor ou centro de distribuição para fins de comprovação que
por ventura conflitem com catálogos, manuais, folders oficiais impressos ou da
internet (devendo constar o endereço URL para folders da web). Caso não seja
comprovada por um dos meios citados anteriormente, será possível a
comprovação através da apresentação de documentação expressa do fabricante
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso
de documentação expressa do fabricante deverá ser anexada a mesma a
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.

 

ITEM 04 – LICENCIAMENTO ADICIONAL DA
SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE
ACESSO
Características técnicas mínimas

2. Licenciamento para expansão da SOLUÇÃO DE ANALISE DE PERFIL E
CONTROLE DE ACESSO, contemplando o quantitativo mínimo adicional de 500
(quinhentos) dispositivos, usuários corporativos ou visitantes simultâneos,
independente do perfil de autenticação, seja por dispositivo ou usuário;

 

GARANTIA E SUPORTE

1. Garantia e suporte do fabricante para a solução de software ofertada pelo período
mínimo de 36 (sessenta) meses, incluindo a evolução para novas versões
devendo o atendimento ser na modalidade 24x7 (vinte quatro horas por dia, sete
dias da semana), com tempo de resposta máximo em 4 (quatro) horas.

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução.

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
disponibilidade ainda de área para cadastro da solução de software ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;

4. A empresa fabricante da solução de software deverá dispor de um número
telefônico tipo 0800 para suporte técnico e abertura de chamados técnicos.

5. A comprovação da modalidade da garantia deverá ocorrer através de
documentação do fabricante de domínio público, não sendo aceita documentação
emitida pelo fornecedor ou centro de distribuição para fins de comprovação que
por ventura conflitem com catálogos, manuais, folders oficiais impressos ou da
internet (devendo constar o endereço URL para folders da web). Caso não seja
comprovada por um dos meios citados anteriormente, será possível a
comprovação através da apresentação de documentação expressa do fabricante
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso
de documentação expressa do fabricante deverá ser anexada a mesma a
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.

 

ITEM 05 – SWITCH DE DISTRIBUIÇÃO COM 16
PORTAS SFP+ E SUPORTE A MÓDULOS DE
EXPANSÃO
 

Características técnicas mínimas

1. Deve possuir no mínimo 16 portas 10 Gigabit Ethernet, 1000/10000 SFP+ fixas ao
equipamento

2. Deve suportar, através de módulos, o mínimo de 8 portas adicionais de 10 Gigabit
Ethernet SFP+ ou 2 portas de 40 Gigabit Ethernet QSFP+;

3. Deve suportar transceivers de 10GbE SFP+ e de 40GbE QSFP+ através da adição
ou substituição de módulos.
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4. Deve possuir, no mínimo, 2 módulos de expansão podendo ser utilizados para
uplinks ou dados de usuários;

5. Deve possuir, no mínimo, 2 módulos de fonte internas ao equipamento operando
em modo redundante;

6. Deve possuir porta dedicada de gerenciamento;

7. Deve possuir 1 interface RJ-45 ou serial para acesso console local;

8. Deve possuir latência de, no máximo, 2,8 μs a 1Gbps;

9. Deve possuir memória SDRAM de no mínimo 2 Gbytes;

10. Deve possuir buffer de pacotes de no mínimo 13.5 Mbytes;

11. Deve possuir capacidade de encaminhamento de no mínimo 285 Mpps;

12. Deve possuir capacidade de comutação de no mínimo 480 Gbps;

13. Deve possuir Certificado de Homologação na Anatel, de acordo com a Resolução
nº 242;

14. Deve possuir fonte de alimentação interna 110/220VAC;

Disponibilidade

15. Deve possuir capacidade de, no mínimo, 10 (dez) equipamentos membros da
mesma pilha;

16. Deve possuir fonte de alimentação interna redundante com características
idênticas a fonte principal;

17. Deve suportar empilhamento com banda agregada mínima de 320 Gbps sem uso
de portas de dados de usuário para este fim.

Switching

18. Deve implementar VLANs baseadas em MAC;

19. Deve suportar no mínimo 4094 VLAN IDs;

20. Deve implementar registro dinâmico de VLAN com MVRP;

21. Deve suportar protocolo OpenFlow 1.3;

22. Deve implementar Jumbo frames nas interfaces Gigabit Ethernet e 10-Gigabit
Ethernet

23. Deve implementar Jumbo frames com tamanho de até 9000 bytes;

24. Deve implementar Ethernet link aggregation;

25. Deve implementar IEEE 802.1ad QinQ;

26. Deve suportar agregação de link através de LACP com no mínimo 144 grupos
distribuídos através da pilha, com cada grupo permitindo até 8 portas;

27. Deve implementar IEEE 802.3x Flow Control;

28. Deve implementar STP BPDU Protection (BPDU Guard);

29. Deve implementar IEEE 802.1w Rapid Reconfiguration of Spanning Tree;

30. Deve implementar MSTP IEEE 802.1s com pelo menos 64 instâncias;

31. Deve implementar UDLD ou DLDP.

Roteamento

32. Deve implementar roteamento estático IPv4 e IPv6;

33. Deve implementar RIP, RIPv2 e RIPng;

34. Deve possuir no mínimo 512 interfaces de roteamento IP (VLAN Interface)

35. O equipamento ofertado deve implementar roteamento baseado em política (PBR)
para IPv4 e IPv6;

36. O equipamento ofertado deve possuir tabela de roteamento com no mínimo 10 mil
entradas IPv4 e 5 mil entradas IPv6;

37. Deve suportar no mínimo 256 rotas estáticas;

38. O equipamento ofertado deve permitir autenticação em servidores RADIUS e
TACACS+;

39. Deve suportar dual stack IPv4/IPv6;

40. Deve implementar Bidirectional Forwarding Detection (BFD), suportando redução
do tempo de convergência para OSPF e VRRP;

41. Deve implementar OSPF v2 e OSPF v3;

42. Deve implementar BGP.

QoS

43. Deve implementar 8 filas em cada porta;
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44. Deve implementar traffic shapping;

45. Deve implementar classificação de tráfego utilizando informações de camada 2, 3
e 4;

46. Deve implementar priorização do trafego em camada 4, baseado em número de
portas TCP/UDP.

Segurança

47. Deve implementar autenticação 802.1x de múltiplos usuários por porta,
simultaneamente.

48. Deve implementar segurança orientada por identidade e controle de acesso por
usuário através de ACLs que permitam ou negue o acesso do usuário aos
recursos de rede específicos, com base na identidade do usuário.

49. Atribuição VLAN automática, automaticamente atribui os usuários para a VLAN
apropriada, com base em suas identidades.

50. Deve implementar accounting RADIUS;

51. Deve implementar TACACS+;

52. Deve implementar proteção contra ataques de ARP;

53. Deve implementar proteção contra IP spoofing (IP source guard);

54. Deve implementar SNMP v1, v2 e v3;

55. Deve implementar detecção de ataques maliciosos e enviar um aviso quando uma
anomalia potencial, causada pelos ataques mal-intencionado, for detectado.

56. Deve suportar o isolamento de portas e VLANs, de forma que uma porta ou VLAN
isolada não possa enviar tráfego para outra porta isolada do mesmo switch;

57. Deve implementar segurança do gerenciamento do switch em métodos de acesso
CLI, GUI ou MIB, através de SSHv2, SSL e SNMPv3

58. Deve implementar autenticação baseado em porta ou endereço MAC;

59. Deve implementar autenticação utilizando navegadores web, possibilitando que
clientes que não possuem cliente 802.1x possam autenticar;

60. Deve suportar port-security.

Gerenciamento

61. Deve permitir instalação simplificada “Zero-touch provisioning” através de
processo baseado em DHCP com a solução de software de gerenciamento;

62. O equipamento ofertado deve permitir múltiplos arquivos de configuração;

63. Deve suportar espelhamento remoto;

64. Deve implementar Secure File Transfer Protocol;

65. Deve implementar LLDP;

66. Deve implementar LLDP-MEd;

67. Deve implementar SNTP v4;

68. O equipamento ofertado deve Implementar Sflow ou Netflow;

69. Deve implementar RFC 1213 MIB II;

70. Deve implementar RFC 2096 IP Forwarding Table MIB;

71. Deve implementar RFC 2571 SNMP Framework MIB;

72. Deve implementar RFC 2572 SNMP-MPD MIB;

73. Deve implementar RFC 2573 SNMP-Notification MIB;

74. Deve implementar RFC 2574 SNMP USM MIB;

75. Deve implementar RFC 2737 Entity MIB (Version 2);

76. Deve implementar RFC 3414 SNMP-User based-SM MIB;

77. Deve implementar RFC 3415 SNMP-View based-ACM MIB;

78. Deve implementar RFC 2668 802.3 MAU MIB;

79. Deve implementar RFC 3418 MIB for SNMPv3;

80. Deve ser fornecido com a versão de software mais completa e atual disponível
para o equipamento;

81. Deve ser fornecido com todas as licenças de software necessárias para o
funcionamento integral de todas as funcionalidades disponíveis para o
equipamento;

82. O equipamento ofertado deve possuir certificado de homologação na Anatel, de
acordo com a resolução n° 242;

Garantia e Suporte
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83. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-
site pelo período mínimo de 60 (sessenta) meses para reposição de peças, mão
de obra e atendimento. O prazo máximo para atendimento do chamado deve ser
de até o próximo dia útil após a sua abertura. Durante o período da garantia o
prazo máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis.

84. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução.

85. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
disponibilidade ainda de área para cadastro da solução de hardware ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;

86. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo
0800 para suporte técnico e abertura de chamados técnicos.

87. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e
solução exigidos para os equipamentos, deverá ser comprovada a existência da
assistência técnica local no domicílio da contratante e na modalidade on-site,
devendo essa ser realizada por meio de documentação oficial do fabricante dos
produtos e de domínio público, através de catálogos, folder impressos ou da
internet, devendo constar o endereço URL na mesma. Caso não seja comprovada
por um dos meios citados anteriormente, será possível a comprovação através da
apresentação de documentação expressa do fabricante dos equipamentos,
indicando a referida assistência técnica que será responsável pelo atendimento e
manutenção durante o período de garantia dos produtos ofertados. Em caso de
documentação expressa do fabricante a esta deverá ser anexada uma
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.

88. Todos os componentes instalados ou integrados dos equipamentos devem ser do
próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada.

 

ITEM 06 – MÓDULO COM 4 PORTAS SFP+ PARA
SWITCH DE DISTRIBUIÇÃO
 

Características técnicas mínimas

1. Módulo de expansão para switch de distribuição;

2. Suporte a no mínimo 4 (quatro) portas SFP+;

3. Deve ser compatível com GBICS 100M/1G/10G SFP+;

4. Deve possuir suporte a MACsec;

5. Compatibilidade integral com o item 05.

Garantia e Suporte

6. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de
peças, mão de obra e atendimento no local. O período da garantia o prazo
máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis;

7. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(part number), incorporado ao equipamento;

8.  Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do
próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada;

 

ITEM 07 – MÓDULO DE STACKING COM 4 PORTAS
PARA SWITCH DE DISTRIBUIÇÃO

Características técnicas mínimas

1. Módulo de expansão para switch de distribuição;

2. Suporte a no mínimo 4 (quatro) portas para stacking;

3. Deve prover no mínimo 320Gbps por módulo;

4. Deve acompanhar 1 (um) cabo de stacking compatível, com 1 (um) metro de
comprimento;
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5.  Compatibilidade integral com o item 05.

 

Garantia e Suporte

6. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de
peças, mão de obra e atendimento no local. O período da garantia o prazo
máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis;

7. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(part number), incorporado ao equipamento;

8. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do
próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada;

 

ITEM 08 – SWITCH DE ACESSO L3 COM 48 PORTAS
GIGABIT E 4 SFP+
 

Características gerais

1. Deve possuir 48 portas 10/100/1000;

2. Deve possuir 4 portas 1/10G SFP+;

3. Deve possuir capacidade de encaminhamento de, no mínimo, 110 Mpps;

4. Deve possuir capacidade de comutação de, no mínimo, 176 Gbps;

5. Deve implementar IEEE 802.3az para as portas 10/100/1000;

6. Deve possuir uma interface de console USB;

7. Deve suportar empilhamento de no mínimo 8 switches;

8. Deve suportar agregação de link através de LACP com no mínimo 20 grupos
distribuídos através da pilha, com cada grupo permitindo até 8 portas;

9. Deve suportar a agregação de links entre diferentes membros da pilha;

10. Deve possuir no mínimo 32.000 endereços MAC;

11. Deve possuir latência máxima de 4μs, considerando pacotes de 64 bytes;

12. Deve possuir buffers de, no mínimo, 12 MB;

13. Deve implementar funcionalidade que permita a detecção de links unidirecionais;

14. Deve implementar funcionalidade que permita a detecção de falhas de uplink;

15. Deve implementar no mínimo 2000 VLANs simultaneamente;

16. Deve implementar MVRP (Multiple VLAN Registration Protocol);

17. Deve implementar LLDP (IEEE 802.1ab);

18. Deve implementar LLDP-MED;

19. Deve implementar Q-in-Q (IEEE 802.1ad);

20. Deve implementar PVST+, RPVST+ ou protocolo compatível;

21. Deve implementar MSTP (IEEE 802.1s);

22. Deve implementar túneis VxLAN (VTEP).

 

Funcionalidades de Camada 3

23. Deve possuir tabela de roteamento com no mínimo 2.000 rotas IPv4 e 1.000 rotas
IPv6;

24. Deve implementar roteamento estático;

25. Deve implementar RIP v2, com suporte a autenticação MD5 (RIPv2);

26. Deve implementar RIPng;

27. Deve implementar OSPF;

28. Deve implementar OSPFv3;

29. Deve implementar Policy-based Routing;

30. Deve implementar VRRP;
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31. Deve implementar VRRPv3;

32. Deve implementar servidor DHCP;

33. Deve implementar DHCP snooping (IPv4 e IPv6);

34. Deve implementar DHCP relay (IPv4 e IPv6);

35. Deve implementar Gateway mDNS, com suporte a Apple Bonjour.

 

Multicast

36. Deve implementar PIM-SM;

37. Deve implementar PIM-DM;

38. Deve implementar MLD snooping;

39. Deve implementar IGMP v3.

 

Software Defined Networking

40. Deve implementar OpenFlow 1.3 ou superior;

41. Deve implementar a separação lógica do tráfego sem suporte a OpenFlow do
tráfego com suporte a OpenFlow através de instâncias. O tráfego OpenFlow não
pode influenciar o tráfego não openflow no equipamento;

42. Deve permitir configurar cada instância como modo ativo (pacotes referentes a
fluxos que o switch não conhece são enviados para a controladora) ou modo
passivo (pacotes que não se referem a um fluxo na tabela do switch não são
enviados para a controladora);

43. Deve implementar 16 instâncias de OpenFlow;

44. As instâncias de OpenFlow devem suportar a associação de múltiplas VLANs;

45. Cada instância OpenFlow configurada no equipamento deve suportar, pelo menos,
a configuração de 3 controladores SDN;

46. Deve permitir utilizar intervalo de portas TCP/UDP e flags de TCP como parâmetros
nas regras de OpenFlow;

47. Deve suportar no mínimo 16.000 regras openflow;

48. Deve possuir interface REST API;

49. Deve suportar configurações via JSON/REST API com, no mínimo, os seguintes
métodos: GET, POST, PUT e DELETE;

50. Deve suportar a criação de VLANs e ACLs no equipamento através de REST.

 

QoS

51. Deve implementar controle de broadcast;

52. Deve implementar rate limiting para pacotes ICMP;

53. Deve implementar rate limiting para tráfego broadcast e multicast;

54. Deve implementar rate limiting baseado em tráfego classificado por uma ACL;

55. Deve suportar espelhamento de portas;

56. Deve suportar espelhamento de tráfego para um switch remoto.

 

Segurança

57. Deve implementar controle de acesso baseado em perfis (Role Based Access
Control);

58. Deve implementar VLANs privadas, de forma que permita o isolamento de tráfego
de uma porta de acesso das demais portas de acesso de uma mesma VLAN,
permitindo acesso apenas para as portas de Uplink (porta promíscua);

59. Deve implementar 802.1x;

60. Deve implementar autenticação baseada em web;

61. Deve implementar autenticação baseada em endereço MAC;

62. Deve permitir a utilização simultânea de autenticação 802.1x e MAC em uma
mesma porta;

63. Deve implementar TACACS+. Não serão aceitas soluções similares;

64. Deverá suportar o download de políticas ou ACLsl a partir de um software de
Controle de Acesso à Rede (NAC), sem necessidade de pré-configuração das
regras no switch, permitindo a centralização das políticas;

65. Deve suportar integração com ferramenta de controle de acesso do mesmo
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fabricante que permita identificar automaticamente o tipo e sistema operacional
dos equipamentos que se conectam à rede (device profiling) sem a necessidade
de agentes instalados nos dispositivos;

66. Deve suportar integração com ferramenta de controle de acesso do mesmo
fabricante que permita verificar se a máquina está em conformidade com a política
de segurança antes de entrar na rede, verificando, no mínimo serviços os
serviços e antivírus das máquinas. Deve suportar os sistemas operacionais
Microsoft Windows, Mac OS e Linux.

 

Gerenciamento

67. Deve implementar NTP com autenticação MD5;

68. Deve implementar Time Domain Reflectometry (TDR) para testes de cabos UTP,
permitindo identificar falhas e verificar a distância do cabo;

69. Deve suportar duas imagens de software na flash;

70. Deve suportar múltiplos arquivos de configuração na flash;

71. Deve permitir o agendamento de tarefas, permitindo executar um comando em
um dia e horário específicos;

72. Deve suportar a autoconfiguração dos switches através de DHCP e software de
gerenciamento, sem necessidade de nenhuma intervenção no switch (com
configuração de fábrica);

73. Deve suportar gerenciamento através de plataforma de nuvem do mesmo
fabricante, com funcionalidades de gerenciamento de configuração, alertas e
notificações e gerenciamento de firmware, sem necessidade de instalação de
nenhum software ou dispositivo on-site;

74. Deve suportar IPSec para comunicação com o sistema de gerenciamento;

75. Deve implementar sFlow (IPv4 e IPv6);

76. Deve possuir interface web para configuração;

77. Deve implementar TR-69 (CPE WAN Management Protocol);

78. Deve suportar diagnóstico de transceivers ópticos;

79. Deve implementar Syslog sobre TLS;

80. Deve implementar Secure SFTP (SFTP);

81. Deve implementar SNMP v1/v2/v3;

82. Deve implementar funcionalidade que permita monitorar o SLA (Service Level
Agreement) de conexões IP. Deve suportar os seguintes testes: ICMP Echo, UDP-
Echo (em porta configurável) e TCP-Connect (em porta configurável) e Jitter UDP
para voz;

83. Deve implementar compatibilidade com o protocolo CDP para provisionamento de
telefones IP;

84. Deve implementar o isolamento de um Access Point rogue conectado ao switch,
quando este for detectado por solução de WLAN do mesmo fabricante;

85. Deve implementar a configuração automática de Access Point wireless do mesmo
fabricante quando conectado ao switch. Devem ser suportados os seguintes
parâmetros para a configuração automática: VLAN, CoS, largura de banda
máxima;

86. Deve suportar o encaminhamento de tráfego para controladora wireless do
mesmo fabricante para inspeção e controle de acesso.

 

Licenciamento

87. Deve ser fornecido com a versão de software mais completa disponível para o
equipamento;

88. Deve ser fornecido com todas as licenças de software necessárias para o
funcionamento integral de todas as funcionalidades disponíveis para o
equipamento.

 

Garantia e Suporte

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-
site pelo período mínimo de 60 (sessenta) meses para reposição de peças, mão
de obra e atendimento. O prazo máximo para atendimento do chamado deve ser
de até o próximo dia útil após a sua abertura. Durante o período da garantia o
prazo máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis.

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução.

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
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disponibilidade ainda de área para cadastro da solução de hardware ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo
0800 para suporte técnico e abertura de chamados técnicos.

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e
solução exigidos para os equipamentos, deverá ser comprovada a existência da
assistência técnica local no domicílio da contratante e na modalidade on-site,
devendo essa ser realizada por meio de documentação oficial do fabricante dos
produtos e de domínio público, através de catálogos, folder impressos ou da
internet, devendo constar o endereço URL na mesma. Caso não seja comprovada
por um dos meios citados anteriormente, será possível a comprovação através da
apresentação de documentação expressa do fabricante dos equipamentos,
indicando a referida assistência técnica que será responsável pelo atendimento e
manutenção durante o período de garantia dos produtos ofertados. Em caso de
documentação expressa do fabricante a esta deverá ser anexada uma
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do
próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada.

 

ITEM 09 – SWITCH DE ACESSO L3 COM 24 PORTAS
GIGABIT E 4 SFP+
 

Características gerais

1. Deve possuir 24 portas 10/100/1000;

2. Deve possuir 4 portas 1/10G SFP+;

3. Deve possuir capacidade de encaminhamento de, no mínimo, 95 Mpps;

4. Deve possuir capacidade de comutação de, no mínimo, 128 Gbps;

5. Deve implementar IEEE 802.3az para as portas 10/100/1000;

6. Deve possuir uma interface de console USB;

7. Deve suportar empilhamento de no mínimo 4 switches;

8. Deve suportar agregação de link através de LACP com no mínimo 20 grupos
distribuídos através da pilha, com cada grupo permitindo até 8 portas;

9. Deve suportar a agregação de links entre diferentes membros da pilha;

10. Deve possuir no mínimo 32.000 endereços MAC;

11. Deve possuir latência máxima de 4μs, considerando pacotes de 64 bytes;

12. Deve possuir buffers de, no mínimo, 12 MB;

13. Deve implementar funcionalidade que permita a detecção de links unidirecionais;

14. Deve implementar funcionalidade que permita a detecção de falhas de uplink;

15. Deve implementar no mínimo 2000 VLANs simultaneamente;

16. Deve implementar MVRP (Multiple VLAN Registration Protocol);

17. Deve implementar LLDP (IEEE 802.1ab);

18. Deve implementar LLDP-MED;

19. Deve implementar Q-in-Q (IEEE 802.1ad);

20. Deve implementar PVST+, RPVST+ ou protocolo compatível;

21. Deve implementar MSTP (IEEE 802.1s);

22. Deve implementar túneis VxLAN (VTEP);

 

Funcionalidades de Camada 3

23. Deve possuir tabela de roteamento com no mínimo 2.000 rotas IPv4 e 1.000 rotas
IPv6;

24. Deve implementar roteamento estático;

25. Deve implementar RIP v2, com suporte a autenticação MD5 (RIPv2);

26. Deve implementar RIPng;

27. Deve implementar OSPF;
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28. Deve implementar OSPFv3;

29. Deve implementar Policy-based Routing;

30. Deve implementar VRRP;

31. Deve implementar VRRPv3;

32. Deve implementar servidor DHCP;

33. Deve implementar DHCP snooping (IPv4 e IPv6);

34. Deve implementar DHCP relay (IPv4 e IPv6);

35. Deve implementar Gateway mDNS, com suporte a Apple Bonjour;

 

Multicast

36. Deve implementar PIM-SM;

37. Deve implementar PIM-DM;

38. Deve implementar MLD snooping;

39. Deve implementar IGMP v3;

 

Software Defined Networking

40. Deve implementar OpenFlow 1.3 ou superior;

41. Deve implementar a separação lógica do tráfego sem suporte a OpenFlow do
tráfego com suporte a OpenFlow através de instâncias. O tráfego OpenFlow não
pode influenciar o tráfego não openflow no equipamento.

42. Deve permitir configurar cada instância como modo ativo (pacotes referentes a
fluxos que o switch não conhece são enviados para a controladora) ou modo
passivo (pacotes que não se referem a um fluxo na tabela do switch não são
enviados para a controladora)

43. Deve implementar 16 instâncias de OpenFlow;

44. As instâncias de OpenFlow devem suportar a associação de múltiplas VLANs.

45. Cada instância OpenFlow configurada no equipamento deve suportar, pelo menos,
a configuração de 3 controladores SDN.

46. Deve permitir utilizar intervalo de portas TCP/UDP e flags de TCP como parâmetros
nas regras de OpenFlow;

47. Deve suportar no mínimo 16.000 regras openflow;

48. Deve possuir interface REST API;

49. Deve suportar configurações via JSON/REST API com, no mínimo, os seguintes
métodos: GET, POST, PUT e DELETE;

50. Deve suportar a criação de VLANs e ACLs no equipamento através de REST.

 

QoS

51. Deve implementar controle de broadcast;

52. Deve implementar rate limiting para pacotes ICMP;

53. Deve implementar rate limiting para tráfego broadcast e multicast;

54. Deve implementar rate limiting baseado em tráfego classificado por uma ACL;

55. Deve suportar espelhamento de portas;

56. Deve suportar espelhamento de tráfego para um switch remoto.

 

Segurança

57. Deve implementar controle de acesso baseado em perfis (Role Based Access
Control);

58. Deve implementar VLANs privadas, de forma que permita o isolamento de tráfego
de uma porta de acesso das demais portas de acesso de uma mesma VLAN,
permitindo acesso apenas para as portas de Uplink (porta promíscua);

59. Deve implementar 802.1x;

60. Deve implementar autenticação baseada em web;

61. Deve implementar autenticação baseada em endereço MAC;

62. Deve permitir a utilização simultânea de autenticação 802.1x e MAC em uma
mesma porta;

63. Deve implementar TACACS+. Não serão aceitas soluções similares;
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64. Deverá suportar o download de políticas ou ACLs a partir de um software de
Controle de Acesso à Rede (NAC), sem necessidade de pré-configuração das
regras no switch, permitindo a centralização das políticas;

65. Deve suportar integração com ferramenta de controle de acesso do mesmo
fabricante que permita identificar automaticamente o tipo e sistema operacional
dos equipamentos que se conectam à rede (device profiling) sem a necessidade
de agentes instalados nos dispositivos;

66. Deve suportar integração com ferramenta de controle de acesso do mesmo
fabricante que permita verificar se a máquina está em conformidade com a política
de segurança antes de entrar na rede, verificando, no mínimo serviços os
serviços e antivírus das máquinas. Deve suportar os sistemas operacionais
Microsoft Windows, Mac OS e Linux.

 

Gerenciamento

67. Deve implementar NTP com autenticação MD5;

68. Deve implementar Time Domain Reflectometry (TDR) para testes de cabos UTP,
permitindo identificar falhas e verificar a distância do cabo;

69. Deve suportar duas imagens de software na flash;

70. Deve suportar múltiplos arquivos de configuração na flash;

71. Deve permitir o agendamento de tarefas, permitindo executar um comando em
um dia e horário específicos;

72. Deve suportar a autoconfiguração dos switches através de DHCP e software de
gerenciamento, sem necessidade de nenhuma intervenção no switch (com
configuração de fábrica);

73. Deve suportar gerenciamento através de plataforma de nuvem do mesmo
fabricante, com funcionalidades de gerenciamento de configuração, alertas e
notificações e gerenciamento de firmware, sem necessidade de instalação de
nenhum software ou dispositivo on-site;

74. Deve suportar IPSec para comunicação com o sistema de gerenciamento;

75. Deve implementar sFlow (IPv4 e IPv6);

76. Deve possuir interface web para configuração;

77. Deve implementar TR-69 (CPE WAN Management Protocol);

78. Deve suportar diagnóstico de transceivers ópticos;

79. Deve implementar Syslog sobre TLS;

80. Deve implementar Secure SFTP (SFTP);

81. Deve implementar SNMP v1/v2/v3;

82. Deve implementar funcionalidade que permita monitorar o SLA (Service Level
Agreement) de conexões IP. Deve suportar os seguintes testes: ICMP Echo, UDP-
Echo (em porta configurável) e TCP-Connect (em porta configurável) e Jitter UDP
para voz;

83. Deve implementar compatibilidade com o protocolo CDP para provisionamento de
telefones IP;

84. Deve implementar o isolamento de um Access Point rogue conectado ao switch,
quando este for detectado por solução de WLAN do mesmo fabricante;

85. Deve implementar a configuração automática de Access Point wireless do mesmo
fabricante quando conectado ao switch. Devem ser suportados os seguintes
parâmetros para a configuração automática: VLAN, CoS, largura de banda
máxima;

86. Deve suportar o encaminhamento de tráfego para controladora wireless do
mesmo fabricante para inspeção e controle de acesso.

 

Licenciamento

87. Deve ser fornecido com a versão de software mais completa disponível para o
equipamento;

88. Deve ser fornecido com todas as licenças de software necessárias para o
funcionamento integral de todas as funcionalidades disponíveis para o
equipamento.

 

Garantia e Suporte

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-
site pelo período mínimo de 60 (sessenta) meses para reposição de peças, mão
de obra e atendimento. O prazo máximo para atendimento do chamado deve ser
de até o próximo dia útil após a sua abertura. Durante o período da garantia o
prazo máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis.

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
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deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução.

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
disponibilidade ainda de área para cadastro da solução de hardware ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo
0800 para suporte técnico e abertura de chamados técnicos.

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e
solução exigidos para os equipamentos, deverá ser comprovada a existência da
assistência técnica local no domicílio da contratante e na modalidade on-site,
devendo essa ser realizada por meio de documentação oficial do fabricante dos
produtos e de domínio público, através de catálogos, folder impressos ou da
internet, devendo constar o endereço URL na mesma. Caso não seja comprovada
por um dos meios citados anteriormente, será possível a comprovação através da
apresentação de documentação expressa do fabricante dos equipamentos,
indicando a referida assistência técnica que será responsável pelo atendimento e
manutenção durante o período de garantia dos produtos ofertados. Em caso de
documentação expressa do fabricante a esta deverá ser anexada uma
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do
próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada.

 

ITEM 10 – SWITCH DE ACESSO L2 COM 24 PORTAS
GIGABIT E 4 SFP
 

1. Deve possuir 24 portas 10/100/1000;

2. Deve possuir 4 portas 1G SFP;

3. Deve possuir capacidade de encaminhamento de, no mínimo, 40 Mpps;

4. Deve possuir capacidade de comutação de, no mínimo, 56 Gbps;

5. Deve implementar IEEE 802.3az para as portas 10/100/1000;

6. Deve possuir uma interface de console USB;

7. Deve suportar agregação com suporte a até 8 portas por grupo;

8. Deve possuir 16.000 endereços MAC;

9. Deve possuir latência máxima de 4 μs para links de 1000Mbps, considerando
pacotes de 64 bytes;

10. Deve implementar funcionalidade que permita a detecção de links unidirecionais;

11. Deve implementar virtual stacking permitindo o gerenciamento de, no mínimo, 16
switches com mesmo endereço IP;

12. Deve implementar 512 VLANs simultaneamente;

13. Deve implementar MVRP (Multiple VLAN Registration Protocol);

14. Deve implementar LLDP (IEEE 802.1ab);

15. Deve implementar LLDP-MED;

16. Deve implementar PVST+, RPVST+ ou protocolo compatível;

17. Deve implementar MSTP (IEEE 802.1s);

18. Deve implementar Gateway mDNS, com suporte a Apple Bonjour;

19. Deve implementar IEEE 802.1p permitindo a classificação de tráfego com até 8
filas de prioridade;

20. Deve permitir a priorização de tráfego por porta e VLAN;

21. Deve implementar controle de broadcast;

22. Deve implementar rate limiting para pacotes ICMP;

23. Deve implementar rate limiting para tráfego broadcast e multicast;

24. Deve suportar espelhamento de portas;

25. Deve implementar RADIUS authentication;

26. Deve implementar RADIUS accounting;

27. Deve implementar TACACS+;
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28. Deve implementar IEEE 802.1X com, no mínimo, 8 (oito) autenticações por porta;

29. Deve implementar SSHv2;

30. Deve implementar SSH para IPv6;

31. Deve implementar DHCP snooping;

32. Deve implementar user role localmente permitindo criar políticas de acesso de
segurança e QoS, por perfil de usuário e dispositivos;

33. Deve implementar autenticação baseada em web;

34. Deve implementar NTP com autenticação MD5;

35. Deve suportar duas imagens de software na flash;

36. Deve suportar múltiplos arquivos de configuração na flash;

37. Deve permitir o agendamento de tarefas, permitindo executar um comando ou
grupo de comandos em um dia e horário específicos;

38. Deve implementar sFlow (IPv4 e IPv6) ou Netflow;

39. Deve implementar RMON com os grupos statistics, history, alarms e events;

40. Deve possuir interface web para configuração;

41. Deve implementar TR-69 (CPE WAN Management Protocol);

42. Deve suportar a auto-configuração dos switches através de DHCP e software de
gerenciamento, sem necessidade de nenhuma intervenção no switch (com
configuração de fábrica);

43. Deve suportar Digital Optical Monitoring (DOM) para transceivers ópticos;

44. Deve implementar Syslog sobre TLS;

45. Deve implementar SFTP ou SCP;

46. Deve implementar SNMP v1/v2/v3

47. Deve permitir gerar notificação caso seja excedido o limite de MACs;

48. Deve implementar compatibilidade com o protocolo CDP para provisionamento de
telefones IP;

49. Deve implementar o isolamento de um Access Point rogue conectado ao switch,
quando este for detectado por solução de WLAN do mesmo fabricante;

50. Deve implementar a configuração automática de Access Point wireless do mesmo
fabricante quando conectado ao switch. Devem ser suportados os seguintes
parâmetros para a configuração automática: VLAN, CoS, largura de banda
máxima;

51. Deve ser fornecido com a versão de software mais completa disponível para o
equipamento;

52. Deve ser fornecido com todas as licenças de software necessárias para o
funcionamento integral de todas as funcionalidades disponíveis para o
equipamento;

 

Garantia e Suporte

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-
site pelo período mínimo de 60 (sessenta) meses para reposição de peças, mão
de obra e atendimento. O prazo máximo para atendimento do chamado deve ser
de até o próximo dia útil após a sua abertura. Durante o período da garantia o
prazo máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis.

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução.

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
disponibilidade ainda de área para cadastro da solução de hardware ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo
0800 para suporte técnico e abertura de chamados técnicos.

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e
solução exigidos para os equipamentos, deverá ser comprovada a existência da
assistência técnica local no domicílio da contratante e na modalidade on-site,
devendo essa ser realizada por meio de documentação oficial do fabricante dos
produtos e de domínio público, através de catálogos, folder impressos ou da
internet, devendo constar o endereço URL na mesma. Caso não seja comprovada
por um dos meios citados anteriormente, será possível a comprovação através da
apresentação de documentação expressa do fabricante dos equipamentos,
indicando a referida assistência técnica que será responsável pelo atendimento e
manutenção durante o período de garantia dos produtos ofertados. Em caso de
documentação expressa do fabricante a esta deverá ser anexada uma

Termo de Referência - TIC 20 (0450416)         SEI 0008478-63.2018.6.02.8000 / pg. 48



documentação expressa do fabricante a esta deverá ser anexada uma
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do
próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada.

 

 

ITEM 11 – SWITCH DE ACESSO L2 COM 48 PORTAS
GIGABIT E 4SFP
 

1. Deve possuir 48 portas 10/100/1000;

2. Deve possuir 4 portas 1G SFP;

3. Deve possuir capacidade de encaminhamento de, no mínimo, 77 Mpps;

4. Deve possuir capacidade de comutação de, no mínimo, 104 Gbps;

5. Deve implementar IEEE 802.3az para as portas 10/100/1000;

6. Deve possuir uma interface de console USB;

7. Deve suportar agregação com suporte a até 8 portas por grupo;

8. Deve possuir 16.000 endereços MAC;

9. Deve possuir latência máxima de 4 μs para links de 1000Mbps, considerando
pacotes de 64 bytes;

10. Deve implementar funcionalidade que permita a detecção de links unidirecionais;

11. Deve implementar virtual stacking permitindo o gerenciamento de, no mínimo, 16
switches com mesmo endereço IP;

12. Deve implementar 512 VLANs simultaneamente;

13. Deve implementar MVRP (Multiple VLAN Registration Protocol);

14. Deve implementar LLDP (IEEE 802.1ab);

15. Deve implementar LLDP-MED;

16. Deve implementar PVST+, RPVST+ ou protocolo compatível;

17. Deve implementar MSTP (IEEE 802.1s);

18. Deve implementar Gateway mDNS, com suporte a Apple Bonjour;

19. Deve implementar IEEE 802.1p permitindo a classificação de tráfego com até 8
filas de prioridade;

20. Deve permitir a priorização de tráfego por porta e VLAN;

21. Deve implementar controle de broadcast;

22. Deve implementar rate limiting para pacotes ICMP;

23. Deve implementar rate limiting para tráfego broadcast e multicast;

24. Deve suportar espelhamento de portas;

25. Deve implementar RADIUS authentication;

26. Deve implementar RADIUS accounting;

27. Deve implementar TACACS+;

28. Deve implementar IEEE 802.1X com, no mínimo, 8 (oito) autenticações por porta;

29. Deve implementar SSHv2;

30. Deve implementar SSH para IPv6;

31. Deve implementar DHCP snooping;

32. Deve implementar user role localmente permitindo criar políticas de acesso de
segurança e QoS, por perfil de usuário e dispositivos;

33. Deve implementar autenticação baseada em web;

34. Deve implementar NTP com autenticação MD5;

35. Deve suportar duas imagens de software na flash;

36. Deve suportar múltiplos arquivos de configuração na flash;

37. Deve permitir o agendamento de tarefas, permitindo executar um comando ou
grupo de comandos em um dia e horário específicos;

38. Deve implementar sFlow (IPv4 e IPv6) ou Netflow;
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39. Deve implementar RMON com os grupos statistics, history, alarms e events;

40. Deve possuir interface web para configuração;

41. Deve implementar TR-69 (CPE WAN Management Protocol);

42. Deve suportar a auto-configuração dos switches através de DHCP e software de
gerenciamento, sem necessidade de nenhuma intervenção no switch (com
configuração de fábrica);

43. Deve suportar Digital Optical Monitoring (DOM) para transceivers ópticos;

44. Deve implementar Syslog sobre TLS;

45. Deve implementar SFTP ou SCP;

46. Deve implementar SNMP v1/v2/v3

47. Deve permitir gerar notificação caso seja excedido o limite de MACs;

48. Deve implementar compatibilidade com o protocolo CDP para provisionamento de
telefones IP;

49. Deve implementar o isolamento de um Access Point rogue conectado ao switch,
quando este for detectado por solução de WLAN do mesmo fabricante;

50. Deve implementar a configuração automática de Access Point wireless do mesmo
fabricante quando conectado ao switch. Devem ser suportados os seguintes
parâmetros para a configuração automática: VLAN, CoS, largura de banda
máxima;

51. Deve ser fornecido com a versão de software mais completa disponível para o
equipamento;

52. Deve ser fornecido com todas as licenças de software necessárias para o
funcionamento integral de todas as funcionalidades disponíveis para o
equipamento.

 

Garantia e Suporte

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-
site pelo período mínimo de 60 (sessenta) meses para reposição de peças, mão
de obra e atendimento. O prazo máximo para atendimento do chamado deve ser
de até o próximo dia útil após a sua abertura. Durante o período da garantia o
prazo máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis.

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução.

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
disponibilidade ainda de área para cadastro da solução de hardware ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo
0800 para suporte técnico e abertura de chamados técnicos.

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e
solução exigidos para os equipamentos, deverá ser comprovada a existência da
assistência técnica local no domicílio da contratante e na modalidade on-site,
devendo essa ser realizada por meio de documentação oficial do fabricante dos
produtos e de domínio público, através de catálogos, folder impressos ou da
internet, devendo constar o endereço URL na mesma. Caso não seja comprovada
por um dos meios citados anteriormente, será possível a comprovação através da
apresentação de documentação expressa do fabricante dos equipamentos,
indicando a referida assistência técnica que será responsável pelo atendimento e
manutenção durante o período de garantia dos produtos ofertados. Em caso de
documentação expressa do fabricante a esta deverá ser anexada uma
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do
próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada.

 

ITEM 12 – GBIC 10GB PARA ATÉ 300M
 

Características técnicas mínimas

1. Deve ser do tipo SFP+ de 10GBASE-SR com conector LC;

2. Compatibilidade integral com os Itens 5, 6, 8 e 9.
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Garantia e Suporte

3. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de
peças, mão de obra e atendimento no local. O período da garantia o prazo
máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis;

4. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(part number), incorporado ao equipamento;

5. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do
próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada.

 

 

ITEM 13 – CABO DAC 10GB DE 1M
 

Características técnicas mínimas

1. Cabo metálico com conector tipo SFP+ para ligação de duas unidades de switch
em 10 Gbps;

2. Cabo com comprimento mínimo de 1 (um) metro;

3.  Compatibilidade integral com os itens 5, 6, 8 e 9.

 

Garantia e Suporte

4. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de
peças, mão de obra e atendimento no local. O período da garantia o prazo
máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis;

5. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(part number), incorporado ao equipamento;

6. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do
próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada.

 

ITEM 14 – CABO DAC 10GB DE 3M
 

Características técnicas mínimas

1. Cabo metálico com conector tipo SFP+ para ligação de duas unidades de switch
em 10 Gbps;

2. Cabo com comprimento mínimo de 3 (três) metros;

3. Compatibilidade integral com os itens 5, 6, 8 e 9.

 

Garantia e Suporte

4. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de
peças, mão de obra e atendimento no local. O período da garantia o prazo
máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis;

5. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(part number), incorporado ao equipamento;

6. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do
próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada.

 

ITEM 15 – GBIC 1GB PARA ATÉ 500M
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Características técnicas mínimas

1. Deve ser do tipo SFP de 1G BASE-SX com conector LC;

2. Compatibilidade integral com os Itens 5, 6, 8, 9, 10 e 11.

 

Garantia e Suporte

3. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de
peças, mão de obra e atendimento no local. O período da garantia o prazo
máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis;

4. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(part number), incorporado ao equipamento;

5. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do
próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada.

 

ITEM 16 – SERVIÇOS DE IMPLANTAÇÃO E
TRANSFERÊNCIA DE TECNOLOGIA PARA SWITCHS
DE REDE
 

Características Gerais

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das
14:00 às 18:00) presencialmente no TRE-AL ou remotamente conforme
necessidades da CONTRATANTE;

 

Implantação

2. Instalação e configuração de no mínimo 10 (dez) switchs de rede, contemplando:

3. Configuração básica de acesso a gerencia via rede;

4. Gerencia e monitoramento em MÓDULO DE GERENCIA DE REDE;

5. Configuração de autenticação de usuários em MÓDULO DE CONTROLE DE
ACESSO;

6. Configuração de no mínimo 10 (dez) VLANs;

7. Configuração de stacking de 2 (duas) pilhas com no máximo 4 (quatro) switchs;

8. Configuração de agregação de links em até 10 (dez) switchs com no máximo 4
(quatro) portas por dispositivo.

 

Transferência de Tecnologia

9. O treinamento deverá ser no realizado na modalidade workshop com tarefas
práticas hands-on, visando assim a melhor fixação dos temas abordados com
foco direto na explicação da tecnologia dos produtos ofertados como também
nas rotinas de configuração, gerenciamento, administração e operação dos
mesmos, devendo ter duração mínima de 24 (vinte e quatro) horas onde serão
abordados no mínimo os seguintes tópicos:

a. Configuração inicial e acesso a gerencia;

b. Configuração de VLANS;

c. Configuração de autenticação de usuários em MÓDULO DE CONTROLE DE
ACESSO;

d. Configuração de empilhamento de switchs;

e. Configuração de agregação de links;

f. Configuração de switchs para MÓDULO DE GERENCIA DE REDE;

g. Configuração de switchs para MÓDULO DE ANÁLISE DE TRÁFEGO.

 

ITEM 17 - SERVIÇOS DE IMPLANTAÇÃO E
TRANSFERÊNCIA DE TECNOLOGIA DO MÓDULO DE
CONTROLE DE ACESSO
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Características Gerais

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das
14:00 às 18:00) presencialmente no TRE-AL ou remotamente conforme
necessidades da CONTRATANTE;

 

Implantação

2. Instalação e configuração de 1 (uma) instância do serviço controle de acesso,
contemplando configurações básicas para acesso à rede, dimensionamento,
configuração de armazenamento;

3. Configuração de autenticação em Active Directory para usuários corporativos;

4. Configuração de autenticação de visitantes com portal de autosserviço para
criação de usuários;

5. Configuração de no mínimo 10 (dez) dispositivos de rede para autenticação na
solução.

 

Transferência de Tecnologia

6. O treinamento deverá ser no realizado na modalidade workshop com tarefas
práticas hands-on, visando assim a melhor fixação dos temas abordados com
foco direto na explicação da tecnologia da solução como também nas rotinas de
configuração, gerenciamento, administração e operação da mesma devendo ter
duração mínima de 24 (vinte e quatro) horas onde será abordado no mínimo os
seguintes tópicos:

a. Configuração de Active Directory como base de autenticação;

b. Configuração de autenticação de usuários corporativos;

c. Configuração de autenticação de usuários visitantes;

d. Configuração de portal de autosserviço;

e. Configuração de autenticação e autorização com RADIUS.

 

ITEM 18 – TREINAMENTO BÁSICO DE
ADMINISTRAÇÃO DE SWITCHES
 

Características Gerais

1. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do
fabricante no Treinamento Básico de Administração dos Switches para 01 (um)
profissional da contratante;

2. O voucher deverá ter validade de pelo menos 12 (doze) meses;

3. O treinamento deverá ser de acordo com o calendário de treinamento do
fabricante e ministrado em centro oficial de treinamento do mesmo ou
remotamente, utilizando tecnologia de ensino a distância;

4. Deverá ser ministrado por profissional devidamente credenciado junto ao
fabricante e apto a entregar o respectivo;

5. O treinamento deverá compreender a explicação da tecnologia da solução como
também das rotinas de configuração, gerenciamento, administração e operação
da mesma;

6. O treinamento deverá ter carga horária mínima de 24 (vinte e quatro) horas,
ministrado no período de 08:00 às 12:00 e das 14:00 às 18:00.

 

ITEM 19 – TREINAMENTO BÁSICO DA SOLUÇÃO DE
CONTROLE DE ACESSO
 

Características Gerais

1. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do
fabricante no Treinamento da Solução de Controle de Acesso  para 01 (um)
profissional da contratante;

2. O voucher deverá ter validade de pelo menos 12 (doze) meses;

3. O treinamento deverá ser de acordo com o calendário de treinamento do
fabricante e ministrado em centro oficial de treinamento do mesmo ou
remotamente, utilizando tecnologia de ensino a distância;

4. Deverá ser ministrado por profissional devidamente credenciado junto ao
fabricante e apto a entregar o respectivo;

5. O treinamento deverá compreender a explicação da tecnologia da solução como
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também das rotinas de configuração, gerenciamento, administração e operação
da mesma;

6. O treinamento deverá ter carga horária mínima de 40 (Quarenta) horas,
ministrado no período de 08:00 às 12:00 e das 14:00 às 18:00;

 

 
LOTE 02 – SOLUÇÃO DE REDE
WIRELESS
 

ITEM 01 – SOLUÇÃO DE ANÁLISE DE PERFIL E
CONTROLE DE ACESSO PARA SOLUÇÃO DE REDE
WIRELESS
LICENCIAMENTO

1. Licenciamento da SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE
ACESSO, contemplando o quantitativo mínimo de 1.000 (um mil) dispositivos,
usuários corporativos ou visitantes simultâneos, independente do perfil de
autenticação, seja por dispositivo ou usuário;

2. Caso a solução ofertada necessite de licenciamento específico para
credenciamento dos dispositivos, usuários (corporativos ou visitantes), deverá ser
fornecido o quantitativo solicitado para ambos, de forma que a solução realize a
análise de perfil e o controle de acesso dos 1.000 (um mil) dispositivos ou
usuários (corporativos ou visitantes) simultâneos.

 

MÓDULO DE ANÁLISE DE PERFIL DE DISPOSITIVO
Características Gerais Modulo de Análise de Perfil de Dispositivo

3. Deve implementar funcionalidade de classificação automática criando perfis de
dispositivos, de forma a descobrir, classificar e agrupar os dispositivos
conectados na rede;

4. Deve categorizar os dispositivos em pelo menos 3 níveis:

d. Por tipo de dispositivo (ex. Computador, Smartdevice, impressora, etc.);

e. Por sistema operacional (ex. Windows, Linux, MacOS, etc.);

f. Versão do sistema operacional (ex. Windows 7, Windows 2008 Server, etc.);

5. Deve ser capaz de gerar gráficos das categorias separando os dispositivos
conforme suas características;

6. Deve suportar a coleta de informações, para classificação, usando no mínimo:

k. DHCP;

l. HTTP User-Agent;

m. MAC OUI;

n. ActiveSync plugin;

o. SNMP;

p. Subnet Scanner;

q. IF-MAP;

r. Cisco Device Sensor;

s. MDM;

t. TCP Fingerprinting.

7. Deve possuir dicionário de categorias de dispositivos pré-configurado e
mecanismo de atualização do mesmo;

8. Deve suportar a integração com, no mínimo, as seguintes soluções de MDM de
mercado AirWatch, MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, MaaS 360
devendo comprovar a compatibilidade em documentação oficial do fabricante;

9. Deve permitir priorização na ordem de criação dos perfis com no mínimo as
seguintes características:

f. Agente proprietário;

g. HTTP User-Agent;

h. SNMP;

i. DHCP;
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j. MAC OUI.

10. A solução de análise de perfil de usuários deverá permitir consultas a sua base,
pela solução de controle de acesso para validação de dispositivos com base no
seu perfil.

 

MÓDULO DE CONTROLE DE ACESSO DE DISPOSITIVOS E
USUÁRIOS
Características Gerais

11. A Solução deverá dar suporte a no mínimo as seguintes bases de dados:

n. Microsoft Active Directory;

o. Kerberos;

p. Diretórios LDAP;

q. Novell eDirectory;

r. OpenLDAP;

s. Sun Directory Server;

t. PostgreSQL;

u. Oracle 11g;

v. MariaDB;

w. MSSQL;

x. Servidores de Token;

y. Base de dados SQL interna;

z. Lista interna estática de hosts.

12. Deve suportar "Single Sign-on" (SSO) através de SAML v2.0;

13. Deve implementar gerenciamento e aplicação de políticas de autorização de
acesso de usuários com base em:

f. Atributos do usuário autenticado;

g. Hora do dia, dia da semana;

h. Tipo de dispositivo utilizado;

i. Localização do usuário;

j. Tipo de autenticação utilizada.

14. Deve permitir a visualização de todas informações relativas a cada transação e
autenticação em uma única tela, a solução deverá trazer no mínimo as seguintes
informações:

m. Data e Hora;

n. Mac Address do dispositivo;

o. Classificação do dispositivo;

p. Usuário;

q. Equipamento que requisitou a autenticação (origem);

r. Método de autenticação utilizado;

s. Fonte de autenticação utilizada para validação;

t. Perfil de acesso aplicado;

u. Atributos de entrada do protocolo utilizados na requisição (ex. RADIUS);

v. Informações de resposta da solução para o elemento de rede;

w. Alertas em caso de falha;

x. LOGS já filtrados para a requisição em análise.

15. Deve possuir Dashboard customizável, onde deve permitir a visualização de no
mínimo as seguintes informações:

a. a. Lista com últimos Alertas do sistema;

b. Gráfico com todas as requisições de autenticação dos últimos 7 dias,
incluindo RADIUS, TACACS+ e Autenticações Web;

c. Gráfico com o status das autenticações aceitas e rejeitadas nos últimos 7
dias;

d. Gráfico com a categorização dos dispositivos classificados pela solução,
divididos de acordo com as categorias de classificação;
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e. Últimas falhas de autenticação;

f. Gráfico com as requisições de avaliação de postura dos dispositivos,
divididos em:

I. Saudáveis (dentro das políticas estabelecidas);

II. Não saudáveis (que estão fora das políticas estabelecidas);

a. a. Lista com as últimas autenticações;

b. Lista com as últimas autenticações com sucesso;

c. Utilização de CPU do sistema, no mínimo nos últimos 30 minutos;

16. Deve possuir base de regras e categorias de dispositivos pré-configurada e
mecanismo de atualização da mesma;

17. Deve suportar a integração com no mínimo as seguintes soluções de MDM de
mercado AirWatch, MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, MaaS 360
devendo comprovar a compatibilidade em documentação oficial do fabricante;

18. Deve suportar autenticações via OAuth2, Facebook, Twitter, LinkdIn, Office365 e
Google Apps;

19. Deve possuir recursos integrados de AAA: RADIUS, TACACS+ e Kerberos;

20. Deve possuir suporte aos seguintes recursos:

m. RADIUS;

n. RADIUS CoA;

o. TACACS+;

p. Web authentication;

q. SAML v2.0;

r. EAP-FAST (EAP-MSCHAPv2, EAP-GTC, EAP-TLS);

s. PEAP (EAP-MSCHAPv2, EAP-GTC, EAP-TLS, EAP-PEAP-Public);

t. TTLS (EAP-MSCHAPv2, EAP-GTC, EAP- TLS, EAP-MD5, PAP, CHAP);

u. EAP-TLS;

v. PAP, CHAP, MSCHAPv1, MSCHAPv2, and EAP-MD5;

w. Windows machine authentication;

x. MAC address authentication (dispositivos sem suporte a 802.1X);

21. Deve suportar verificação de vulnerabilidade através de varredura de portas;

22. Deve suportar à aplicação de políticas em ambiente com múltiplos fornecedores
de Wireless, cabeado e VPN;

23. Deve possuir CA integrada, para geração de certificados para os dispositivos que
forem se autenticar na rede;

24. Deve suportar à integração com plataforma de terceiros usando HTTP/RESTful
API;

25. Deve permitir que a solução faça consultas em bases SQL, com o objetivo de
buscar informação a serem utilizadas durante o processo de autenticação dos
usuários;

26. Deve possuir suporte a administração através de IPv6;

27. Deve possuir ferramenta para gerenciar os processos de credenciamento,
autenticação, autorização e contabilização de usuários visitantes através de portal
web seguro;

28. Deve implementar a criação de grupos de autorizadores com privilégios distintos
de criação de credenciais temporárias e atribuição de permissões de acesso aos
clientes;

29. Deve permitir realizar a autenticação dos autorizadores em base externa do tipo
Microsoft Active Directory ou LDAP e atribuir o privilégio ao autorizador de acordo
com o seu perfil;

30. Deve implementar as funcionalidades de geração de lotes de credenciais
aleatórias, temporárias, pré-autorizadas;

31. Deve implementar a importação e exportação da relação de credenciais
temporárias através de arquivos txt ou csv;

32. Deve permitir a configuração do tempo de validade das credenciais, baseando-se
na criação da conta ou no primeiro login da conta;

33. Deve permitir que o visitante crie sua própria credencial temporária (autosserviço)
através de portal web, com ou sem a necessidade de um autorizador;

34. Deve permitir a customização do formulário de criação de credenciais, a ser
preenchido pelo autorizador ou pelo visitante em caso de autosserviço,
especificando quais informações cadastrais dos visitantes são obrigatórias ou
opcionais;
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35. Deve permitir a customização do nível de segurança da senha temporária que
será gerada ao visitante, especificando a quantidade mínima de caracteres e o uso
de caracteres especiais e números para compor a senha;

36. Deve exigir que o usuário visitante aceite o “Termo de uso da rede” a cada login
ou apenas no primeiro login;

37. Deve permitir o envio das credenciais aos usuários registrados através de
mensagens SMS (Short Message Service), e-mail ou impressão local.

 

GARANTIA E SUPORTE

38. Garantia e suporte do fabricante para a solução de software ofertada pelo período
mínimo de 36 (sessenta) meses, incluindo a evolução para novas versões
devendo o atendimento ser na modalidade 24x7 (vinte quatro horas por dia, sete
dias da semana), com tempo de resposta máximo em 4 (quatro) horas.

39. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução.

40. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
disponibilidade ainda de área para cadastro da solução de software ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;

41. A empresa fabricante da solução de software deverá dispor de um número
telefônico tipo 0800 para suporte técnico e abertura de chamados técnicos.

42. A comprovação da modalidade da garantia deverá ocorrer através de
documentação do fabricante de domínio público, não sendo aceita documentação
emitida pelo fornecedor ou centro de distribuição para fins de comprovação que
por ventura conflitem com catálogos, manuais, folders oficiais impressos ou da
internet (devendo constar o endereço URL para folders da web). Caso não seja
comprovada por um dos meios citados anteriormente, será possível a
comprovação através da apresentação de documentação expressa do fabricante
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso
de documentação expressa do fabricante deverá ser anexada a mesma a
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.

 

 

ITEM 02 – SOLUÇÃO DE GERENCIAMENTO DE REDE
WIRELESS
LICENCIAMENTO

1. Deverá ser entregue o quantitativo mínimo de licenças para o gerenciamento
simultâneo de 50 (cinquenta) Pontos de acesso;

CARACTERÍSTICAS GERAIS

2. A solução de gerenciamento deverá administrar a configuração dos Pontos de
acesso de forma centralizada;

3. A solução de gerenciamento deverá possuir integração com o HPE IMC em
console única de gerenciamento;

4. A solução de gerenciamento de rede wireless deverá suportar, em arquitetura de
controladora distribuída, a capacidade de gerenciar no mínimo 120 (cento e vinte)
pontos de acesso por cluster e no mínimo um total de 20 (vinte) clusters;

5. A solução de gerenciamento, em arquitetura de controladora física ou virtual,
deverá suportar no mínimo 2400 pontos de acesso;

6. Deve ser obrigatoriamente do mesmo fabricante dos pontos de acesso e
controladores;

7. Permitir a configuração e gerenciamento através de browser padrão (http, https);

8. Permitir que os eventos sejam gravados remotamente utilizando Syslog;

9. Prover organização hierárquica de equipamentos, permitindo que um
equipamento receba as configurações lógicas e as replique a outros
equipamentos;

10. Possuir capacidade de projeto automatizado de redes sem fio nos padrões
802.11a, 802.11b e 802.11g, 802.11n e 802.11ac, segundo a geografia do prédio
(planta);

11. Considerar a área de cobertura e a banda por usuário desejada;

12. Possibilitar a importação de plantas baixas nos formatos dwg e jpg;

13. Permitir a visualização de alertas da rede em tempo real;

14. Permitir a visualização de eventuais áreas sem cobertura de RF (áreas de
sombra);
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15. Monitorar o desempenho da rede wireless, consolidando informações de rede tais
como:

a. Níveis de ruído;

b. Relação sinal-ruído;

c. Interferência;

d. Potência de sinal.

16. Possuir capacidade de listagem on-line da localização de usuário, endereço IP,
endereço MAC, nível de potência de recepção e dados de associação e de
autenticação 802.1x;

17. Deve possuir informação visual e gráfica, na planta baixa dos andares, para:

a. Visualização dos Pontos de acesso instalados, com estado de funcionamento;

b. Visualização do mapa de calor de RF (Heatmap);

c. Localização de ativos conectados à rede (equipamentos 802.11);

d. Localização de Pontos de acesso rogue.

18. Caso esta funcionalidade não esteja disponível no sistema de gerência, deve ser
fornecido software, do mesmo fabricante, para atender este item, contemplando
todos os dispositivos licenciados e com redundância 1+1;

19. Possuir capacidade de identificação e listagem dos rádios vizinhos e respectivos
SSID/BSSID que podem ser percebidos por cada Ponto de acesso;

20. Possuir capacidade de configuração gráfica completa do controlador WLAN seja
ela física, virtual ou distribuída e respectivos Pontos de acesso;

21. Possuir capacidade de geração de relatórios dos seguintes tipos:

a. Listagem de clientes Wireless;

b. Listagem de Pontos de acesso;

c. Informações de Configuração dos Controladores WLAN;

d. Utilização da rede;

e. Detalhes dos Pontos de acesso não autorizados (rogues) detectados.

22. Suportar SSH, HTTP/HTTPS, SSL, Telnet;

23. Possuir ferramentas de debug e log de eventos para depuração e gerenciamento
em primeiro nível;

24. Implementar os padrões abertos de gerência de rede SNMPv2c e SNMPv3,
incluindo a geração de traps;

25. Possuir suporte a MIB II, conforme RFC 1213;

26. Implementar a MIB privativa que forneça informações relativas ao funcionamento
do equipamento;

27. Possibilitar a obtenção da configuração do equipamento através do protocolo
SNMP;

28. Possibilitar a obtenção via SNMP de informações de capacidade e desempenho da
CPU, memória e portas;

29. Possibilitar a gerência e identificação individualizada de cada Ponto de acesso
remoto;

30. Permitir a administração centralizada dos Pontos de acesso sem a necessidade de
configurar os mesmos individualmente;

31. Possibilitar a identificação de paredes e divisórias com respectivos níveis de
atenuação por tipo (alvenaria, vidro, drywall e divisória);

32. Possibilitar a importação de plantas baixas nos formatos gráficos (CAD, dwg, jpg,
gif e png);

33. Deve disponibilizar em painel gráfico de controle informações referentes à:

a. Sistemas operacionais e tipos de dispositivos que estão se conectando a rede;

b. Informações sobre chamadas de voz, seus protocolos e qualidade das mesmas;

c. Informações sobre os tipos de aplicações mais utilizados;

d. Informações sobre usuários conectados.

34. Deve possuir informação sobre possíveis ameaças a rede detectadas pelos
sistemas gerenciados;

35. Deve possibilitar criação de regras de detecção de ameaças e correlacionar todos
os dispositivos gerenciados.
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ITEM 03 – LICENÇAS ADICIONAIS PARA SOLUÇÃO
DE GERENCIAMENTO DE REDE WIRELESS
Características técnicas mínimas

1. Licença para expansão da SOLUÇÃO DE GERENCIAMENTO DE REDE
WIRELESS, contemplando o quantitativo adicional mínimo de 1 (um) ponto de
acesso simultâneo;

2. Cada unidade deve ser fornecida com todas as licenças de software necessárias
para o funcionamento integral de todas as funcionalidades disponíveis para
SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS especificada nesse
edital.

 

GARANTIA E SUPORTE

1. Garantia e suporte do fabricante para a solução de software ofertada pelo período
mínimo de 36 (sessenta) meses, incluindo a evolução para novas versões
devendo o atendimento ser na modalidade 24x7 (vinte quatro horas por dia, sete
dias da semana), com tempo de resposta máximo em 4 (quatro) horas.

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução.

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
disponibilidade ainda de área para cadastro da solução de software ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;

4. A empresa fabricante da solução de software deverá dispor de um número
telefônico tipo 0800 para suporte técnico e abertura de chamados técnicos.

5. A comprovação da modalidade da garantia deverá ocorrer através de
documentação do fabricante de domínio público, não sendo aceita documentação
emitida pelo fornecedor ou centro de distribuição para fins de comprovação que
por ventura conflitem com catálogos, manuais, folders oficiais impressos ou da
internet (devendo constar o endereço URL para folders da web). Caso não seja
comprovada por um dos meios citados anteriormente, será possível a
comprovação através da apresentação de documentação expressa do fabricante
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso
de documentação expressa do fabricante deverá ser anexada a mesma a
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.

 

 
ITEM 04 – LICENCIAMENTO ADICIONAL DA
SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE
ACESSO
Características técnicas mínimas

3. Licenciamento para expansão da SOLUÇÃO DE ANALISE DE PERFIL E
CONTROLE DE ACESSO, contemplando o quantitativo mínimo adicional de 500
(quinhentos) dispositivos, usuários corporativos ou visitantes simultâneos,
independente do perfil de autenticação, seja por dispositivo ou usuário;

 

GARANTIA E SUPORTE

6. Garantia e suporte do fabricante para a solução de software ofertada pelo período
mínimo de 36 (sessenta) meses, incluindo a evolução para novas versões
devendo o atendimento ser na modalidade 24x7 (vinte quatro horas por dia, sete
dias da semana), com tempo de resposta máximo em 4 (quatro) horas.

7. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução.

8. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
disponibilidade ainda de área para cadastro da solução de software ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;

9. A empresa fabricante da solução de software deverá dispor de um número
telefônico tipo 0800 para suporte técnico e abertura de chamados técnicos.

10. A comprovação da modalidade da garantia deverá ocorrer através de
documentação do fabricante de domínio público, não sendo aceita documentação
emitida pelo fornecedor ou centro de distribuição para fins de comprovação que
por ventura conflitem com catálogos, manuais, folders oficiais impressos ou da
internet (devendo constar o endereço URL para folders da web). Caso não seja
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comprovada por um dos meios citados anteriormente, será possível a
comprovação através da apresentação de documentação expressa do fabricante
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso
de documentação expressa do fabricante deverá ser anexada a mesma a
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.

 
ITEM 05 – CONTROLADORA WLAN
Características gerais

1. Solução baseada em hardware ou software específico, do tipo appliance físico ou
virtual, do mesmo fabricante dos pontos de acesso e software de gerência;

2. Deve estar licenciado para controle de, no mínimo, 50 (cinquenta) pontos de
acesso, podendo ser expandido em no mínimo, 250 (duzentos e cinquenta)
pontos de acesso através de licenciamento adicional;

3. Permitir a conexão simultânea de, no mínimo, 4.000 clientes wireless;

4. Permitir a gravação de eventos por meio do protocolo syslog;

5. Acesso ao sistema através de cliente com browser padrão (http, https, Java);

6. Permitir operação em modo mesh;

7. Permitir o uso de múltiplos SSIDs simultaneamente;

8. Prover tempo de fast-roaming intra-switch inferior a 25 milissegundos;

9. Prover tempo de fast-roaming inter-switch em camada 2, inferior a 100
milissegundos;

10. Permitir conexão entre APs sem a necessidade de conexão cabeada,
implementando assim uma rede padrão mesh;

11. Deve suportar 802.11e com WMM, U-APSD e T-SPEC;

12. Gerenciar centralizadamente a autenticação de usuários;

13. Implementar protocolo de autenticação para controle do acesso administrativo a
solução com mecanismos de AAA;

14. Possuir base de dados de usuários interna para autenticação de usuários
convidados / temporários (acesso guest);

15. Permitir autenticação em no mínimo os seguintes sistemas de base de dados de
usuários Microsoft Active Directory, Cisco ACS server, FreeRadius, entre outros;

16. Realizar o provisionamento de usuários convidados (guests) através de interface
Web por meio de um usuário administrativo com permissões mínimas, exclusivas
para este fim;

17. Possuir suporte a autenticação IEEE 802.1X, com pelo menos os seguintes
métodos EAP: EAP-MD5, PEAP/EAP-GTC, PEAP/EAP-MSCHAPv2, EAP-TLS com
utilização de base de usuários interna ou servidor RADIUS externo;

18. Suportar as especificações:

a. RFC 2409;

b. RFC 2661;

c. RFC 2408;

d. RFC 3602;

e. RFC 3948;

f. RFC 2548;

g. RFC 2328;

h. RFC 2338;

i. RFC 1027;

j. IEEE 802.1w;

k. RFC 1519;

19. Deverá suportar os seguintes métodos EAP-PEAP, EAP-TLS e EAP-TTLS;

20. Possuir suporte a autenticação IEEE 802.1X, com o método PEAP/EAP-GTC, e
com utilização de base de usuários LDAP externa;

21. Permitir a seleção/uso de servidor Radius ou LDAP com base no SSID;

22. Suportar a autenticação de usuários conectados à rede cabeada através das
portas do controlador;

23. Possuir o recurso de EAP Offload para terminação do túnel EAP no próprio
controlador;
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24. Deve suportar utilização de Portal Captivo externo ao controlador;

25. Permitir a autenticação (através de endereço MAC, Portal Captivo ou IEEE 802.1X)
de usuários conectados à rede WLAN (wireless) ou usuários conectados às
portas cabeadas do controlador. Também deverá permitir a autenticação de
usuário e de máquina por meio de IEEE 802.1x;

26. Oferecer recurso de Portal Captivo (Captive Portal) com suporte a múltiplos
portais simultaneamente;

27. Implementar associação dinâmica de usuário a VLAN, com base nos parâmetros
da etapa de autenticação;

28. Implementar Qualidade de Serviço com a marcação de pacotes utilizando Diffserv
e suporte a 802.1p para QoS de rede;

29. Possibilitar roaming com integridade de sessão, dando suporte a aplicações em
tempo real, tais como, VoIP, VoWLAN, videoconferência, dentre outras;

30. Permitir portais captivos externos a controladora;

31. A controladora deve possuir funcionalidade de conexão Site to Site VPN utilizando
padrão Ipsec. Caso a solução fornecida não possua a funcionalidade, será aceita
solução de VPN adicional integrada;

32. Deve permitir o tunelamento do trafego de dados de usuários mesmo em redes
L3, não sendo necessário estender VLANs até o Ponto de Acesso, inclusive em
MANs e WANs;

33. Implementar segurança IEEE 802.11i;

34. Suportar a criptografia centralizada com os seguintes protocolos: AES-CCMP, TKIP
e WEP;

35. Suportar, no mínimo, 2000 VLANs;

36. Implementar o protocolo 802.1w (Rapid Spanning Tree);

37. Oferecer suporte a roteamento e switching de camadas L2 e L3;

38. Possuir o recurso de criação de Pools de VLAN para permitir a escalabilidade de
redes;

39. Possuir servidor DHCP embutido;

40. Suportar o protocolo VRRP para redundância de controladores;

41. Deve suportar redundância de controladores nos modos:

a. 1+1;

b. N+1;

c. Ativo-Ativo;

d. Ativo-Standby;

42. Oferecer os recursos de mobilidade entre VLANs para roaming de camada 2;

43. Oferecer os recursos de Proxy de endereços IP e Proxy DHCP para roaming entre
redes (L3)

44. Deve implementar northbound APIs para realização de integrações com aplicações
de terceiros para fins de monitoramento e visibilidade. Caso seja necessário, deve
ser ofertado licenças para ativação desse recurso;

45. Implementar tagging de VLANs através do protocolo 802.1Q;

46. Implementar o protocolo 802.1d para Spanning Tree (STP);

47. O controlador WLAN poderá estar diretamente e/ou remotamente conectado aos
APs por ele gerenciados, inclusive via roteamento nível 3 da camada OSI

48. Se um controlador WLAN falhar, os APs relacionados deverão se associar a um
controlador WLAN alternativo de forma automática, não permitindo que a rede
wireless se torne inoperante;

49. Realizar a descoberta automática dos APs na infraestrutura wireless;

50. Permitir o controle dos APs mediante a conexão através de topologia MESH (WiFi
Mesh);

51. A rede MESH deverá oferecer comportamento determinístico da topologia da rede
MESH;

52. A rede MESH deverá prover auto-redundância das camadas física (RF) e Layer 2
com comportamento determinístico;

53. Permitir a conexão de APs de maneira remota e segura;

54. Conectar APs através de redes públicas e/ou privadas com garantia de segurança
através de conexão criptografada;

55. Permitir a propagação de SSIDs de maneira segura para qualquer AP
legitimamente cadastrado na controladora, independentemente de onde este AP
esteja conectado;

56. Permitir a autenticação do AP remoto através de certificado digital ou de usuário e
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senha cadastrados em servidor AD e Radius;

57. Gerenciar o tráfego dos APs centralizadamente;

58. Administrar a configuração dos AP’s;

59. Deve permitir administrar centralizadamente todos os aspectos de segurança da
rede WLAN através de firewall integrado à solução de rede sem fio, caso a solução
ofertada não possua solução de firewall nativa na controladora WLAN deverá ser
ofertado firewall externo com capacidade para atender toda a solução;

60. Permitir o bloqueio de comunicação entre clientes wireless – L2 bridging;

61. Implementar filtros baseados em protocolos e em endereços MAC;

62. Implementar padrão IEEE 802.11h;

63. Realizar o controle de autorização baseado em perfis de acesso;

64. Permitir que seja configurado um perfil de acesso, com regras aplicadas de
firewall, para o qual será direcionado o usuário após sua autenticação;

65. Possuir o recurso de “blacklisting” contra ataques ao Firewall e à rede wireless,
evitando que um determinado cliente se associe à rede wireless caso viole políticas
definidas de Firewall ou execute algum ataque à rede WLAN de endereços MAC de
APs do sistema;

66. O Firewall deverá implementar os recursos de NAT (Network Address Translation)
tanto para destino quanto para origem;

67. Implementar listas de controle de acesso (ACLs);

68. Oferecer detecção e proteção integrada de ataques de negação de serviços TCP,
ICMP;

69. Permitir o espelhamento de sessão e logs detalhados por pacote a fim de
possibilitar análises forenses;

70. Permitir a aplicação de políticas de camada 4, de acordo com as características do
usuário. Por exemplo, um usuário que pertença ao grupo de gerentes
(cadastrado no Radius ou Active Directory) terá permissão de acesso ao
protocolo FTP no servidor de ERP;

71. Permitir derivação de políticas de acesso. Por exemplo, um usuário pode
pertencer a um grupo ao qual foram atribuídas políticas de acesso em camada 4,
porém, caso esteja utilizando um dispositivo de voz, o tráfego SIP passará a ter
prioridade através de aplicação de QoS;

72. Permitir a criação de políticas com base em horários e na localização do usuário.
Por exemplo: bloquear o tráfego do protocol FTP após às 18 horas.

73. O Firewall deverá ser integrado à rede WLAN de modo a permitir a desassociação
de usuários da rede sem fio WLAN com base na violação de políticas de tráfego.
Por exemplo: desassociar da rede WLAN e colocar em quarentena o Notebook
com endereço MAC XX:XX:XX se o usuário tentar fazer um telnet para o servidor
ABC;

74. Otimizar o desempenho e a cobertura da radiofrequência;

75. Ajustar automaticamente os canais de modo a otimizar a cobertura de rede e
mudar as condições de RF baseado em performance;

76. Detectar interferência e ajustar parâmetros de RF, evitando problemas de
cobertura e controle da propagação indesejada de RF;

77. Implementar varredura de RF contínua, programada ou sob demanda, com
identificação de APs ou clientes irregulares;

78. Deve implementar a tecnologia de “Channel load balancing”, permitindo que
clientes sejam automaticamente distribuídos entre Pontos de Acesso adjacentes
operando em canais distintos, com o objetivo de balancear a carga entre os
Pontos de Acesso;

79. Deve implementar a tecnologia de “Band Steering/Select”, permitindo que clientes
com suporte a faixa de frequência de 5GHz se conectem aos Pontos de Acesso
utilizando, preferencialmente, a faixa de 5GHz;

80. Implementar varredura de RF nas bandas 802.11a, 802.11b, 802.11g, 802.1n e
802.11ac para identificação de ataques e APs intrusos não autorizados (rogues);

81. Realizar a varredura no canal de operação do AP sem impacto na performance da
rede WLAN;

82. Permitir a varredura em todos os canais possíveis de RF para detecção e
contenção de ameaças na rede WLAN;

83. Deve fazer a varredura dos espectros de 2,4 GHz e 5 GHz para localização e
classificação de interferências não 802.11, analise de espectro, e evita-las
automaticamente;

84. O controlador deve possuir funcionalidade de analisador gráfico de espectro para
detecção de interferências nas faixas de frequência de 2.4 e 5 GHz, sejam elas
IEEE 802.11 ou não. Deve disponibilizar interface gráfica com, pelo menos,
gráficos de Fast Fourier Transform (FFT) e espectrograma; Caso a funcionalidade
não possa ser apresentada pelo controlador, deve ser fornecido um equipamento
ou software, do mesmo fabricante, que o faça;
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85. Utilizar os APs como ”sensores” de RF para fazer a monitoração do ambiente
Wireless;

86. Classificar automaticamente APs válidos, os que interferem e os não autorizados
(rogues);

87. Implementar mecanismos para detecção e contenção de APs não autorizados
(rogues);

88. Realizar a contenção automática dos APs Rogue, simultaneamente, através da
rede WLAN e da rede cabeada;

89. Realizar a identificação e contenção de redes “ad-hoc”;

90. Detectar e bloquear o bridging entre estações da rede WLAN;

91. Oferecer proteção contra ataques Denial Of Service (DOS) a APs e estações

92. Detectar e alertar os seguintes tipos de ataques na rede WLAN:

a. Impersonalização de AP válido;

b. Floods de Frames;

c. Fake Ap, Airjack;

d. Broadcasts de de-autenticação;

e. ASLEAP;

f. Ataques baseados em probes;

93. Possuir capacidade de gerar alarmes e executar contra-ataques se um ataque for
detectado;

94. Detectar áreas de sombra de cobertura e efetuar os devidos ajustes para sua
correção, automaticamente;

95. Ajustar, dinamicamente, o nível de potência e canal de rádio dos APs, de modo a
otimizar o tamanho da célula de RF, garantindo a performance e escalabilidade;

96. Permitir o controle de banda disponível (bandwith contracts) por usuário ou
através de perfis de usuários;

97. Possibilitar roaming com integridade de sessão, dando suporte a aplicações em
tempo real, tais como, VoIP, VoWLAN, videoconferência, dentre outras;

98. Deve possuir mecanismo de controle de admissão de chamadas nos pontos de
acesso (CAC);

99. Possuir mecanismo automático de QoS para protocolos de voz (SIP, SVP e SCCP)
utilizando inspeção automática de pacotes, sem a necessidade de fazer a
marcação prévia (tagging) de pacotes;

100. Deve possuir solução de identificação de aplicações através de técnicas de análise
de tráfego, provendo informações das aplicações mais utilizadas na interface
gráfica;

101. Permitir a criação de políticas de acesso baseadas nas aplicações, como por
exemplo, o acesso a “redes sociais” terá um controle de banda de 2Mpbs.

102. Apresentar informações gráficas referente a utilização de soluções de
comunicações unificadas (UC) sobre a infraestrutura WLAN, de formar a
apresentar informações referentes as chamadas realizadas e relações gráficas
entre o nível de sinal recebido pelo usuário e a qualidade da chamada.

103. Possuir a funcionalidade da utilização do protocolo Bonjour na infraestrutura,
permitindo que os serviços divulgados via mDNS sejam controlados, filtrados e
disponibilizados entre diferentes subnets, tornando assim possível a utilização em
redes com múltiplas subnets e um número grande de dispositivos.

104. Cada unidade deve ser fornecida com todas as licenças de software necessárias
para o funcionamento integral de todas as funcionalidades disponíveis.

Garantia e Suporte

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-
site pelo período mínimo de 60 (sessenta) meses para reposição de peças, mão
de obra e atendimento. O prazo máximo para atendimento do chamado deve ser
de até o próximo dia útil após a sua abertura. Durante o período da garantia o
prazo máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis.

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução.

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
disponibilidade ainda de área para cadastro da solução de hardware ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo
0800 para suporte técnico e abertura de chamados técnicos.

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e
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5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e
solução exigidos para os equipamentos, deverá ser comprovada a existência da
assistência técnica local no domicílio da contratante e na modalidade on-site,
devendo essa ser realizada por meio de documentação oficial do fabricante dos
produtos e de domínio público, através de catálogos, folder impressos ou da
internet, devendo constar o endereço URL na mesma. Caso não seja comprovada
por um dos meios citados anteriormente, será possível a comprovação através da
apresentação de documentação expressa do fabricante dos equipamentos,
indicando a referida assistência técnica que será responsável pelo atendimento e
manutenção durante o período de garantia dos produtos ofertados. Em caso de
documentação expressa do fabricante a esta deverá ser anexada uma
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do
próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada.

 

ITEM 06 – LICENÇAS ADICIONAIS PARA
CONTROLADORA WLAN
Características técnicas mínimas

3. Licença para expansão da CONTROLADORA WLAN, contemplando o
quantitativo adicional mínimo de 1 (um) ponto de acesso simultâneo;

4. Deve ser compatível com controladora WLAN especificada nesse edital;

5. Cada unidade deve ser fornecida com todas as licenças de software necessárias
para o funcionamento integral de todas as funcionalidades disponíveis para
CONTROLADORA WLAN especificada nesse edital.

 

GARANTIA E SUPORTE

6. Garantia e suporte do fabricante para a solução de software ofertada pelo período
mínimo de 36 (sessenta) meses, incluindo a evolução para novas versões
devendo o atendimento ser na modalidade 24x7 (vinte quatro horas por dia, sete
dias da semana), com tempo de resposta máximo em 4 (quatro) horas.

7. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução.

8. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
disponibilidade ainda de área para cadastro da solução de software ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;

9. A empresa fabricante da solução de software deverá dispor de um número
telefônico tipo 0800 para suporte técnico e abertura de chamados técnicos.

10. A comprovação da modalidade da garantia deverá ocorrer através de
documentação do fabricante de domínio público, não sendo aceita documentação
emitida pelo fornecedor ou centro de distribuição para fins de comprovação que
por ventura conflitem com catálogos, manuais, folders oficiais impressos ou da
internet (devendo constar o endereço URL para folders da web). Caso não seja
comprovada por um dos meios citados anteriormente, será possível a
comprovação através da apresentação de documentação expressa do fabricante
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso
de documentação expressa do fabricante deverá ser anexada a mesma a
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.

 

ITEM 07 – PONTO DE ACESSO INTERNO TIPO 01
Características gerais

1. Equipamento de Ponto de Acesso para rede local sem fio, configurável via
software, com funcionamento simultâneo nos padrões IEEE 802.11a/n/ac, 5GHz,
e IEEE 802.11b/g/n, 2.4GHz;

2. Todos os Pontos de acesso sem fio deverão ser novos e sem nenhum histórico
de utilização;

3. Os pontos de acesso deverão possuir certificado emitido pelo “WIFI Alliance”
comprovando no mínimo os seguintes padrões, protocolos e funcionalidades:

a. IEEE 802.11a;

b. IEEE 802.11b;

c. IEEE 802.11g;

Termo de Referência - TIC 20 (0450416)         SEI 0008478-63.2018.6.02.8000 / pg. 64



d. IEEE 802.11n;

e. IEEE 802.11d;

f. IEEE 802.11ac;

g. WPA® Enterprise/Personal;

h. WPA2® Enterprise/Personal;

i. EAP-TLS;

j. EAP-TTLS/MSCHAPv2;

k. PEAPv0/EAP-MSCHAPv2;

l. PEAPv1/EAP-GTC;

m. EAP-SIM;

n. EAP-FAST;

o. WMM® e WMM® Power Save;

p. Beamforming;

q. Short Guard Interval (SGI);

r. Packet Aggregation (A-MPDU);

s. Opportunistic Key Caching (OKC)

4. Deve operar simultaneamente em 2.4GHz e 5GHz (concurrent dual-band);

 

Performance

5. Deve suportar rádio dual, 5 GHz 802.11ac 2x2 MIMO e 2.4GHz 802.11n 2x2 MIMO

6. Deve suportar capacidade de 1300 Mbps de throughput ou superior;

7. Deve possuir rádio duplo configurável pelo software suportando 5 GHz e 2,4 GHz;

8. Deve possuir no mínimo dois spatial stream Single User (SU) MIMO para taxa de
dados sem fio de até 867 Mbps para dispositivos cliente individuais (VHT80) 2x2
em 5GHz;

9. Deve possuir no mínimo dois spatial stream Single User (SU) MIMO para uma taxa
de dados sem fio de até 400 Mbps para dispositivos clientes compatíveis (2x2
VHT40) em 5GHz;

10. Deve possuir suporte para até 255 dispositivos cliente associados por rádio e até
16 BSSIDs por rádio;

11. Deve suportar no mínimo as bandas de frequência:

a. 2,400 a 2,4835 GHz

b. 5.150 a 5.250 GHz

c. 5,25 a 5,350 GHz

d. 5,470 a 5,725 GHz

e. 5,725 a 5,850 GHz

12. Deve possuir suporte a seleção de frequência dinâmica (DFS) otimizando o uso do
espectro de RF disponível;

13. Deve suportar, no mínimo, as seguintes tecnologias de rádio:

a. 802.11b: espectro espalhável de sequência direta (DSSS)

b. 802.11a/g/n/ac: multiplexação por divisão de frequência ortogonal (OFDM)

14. Deve suportar, no mínimo, os seguintes tipos de modulação:

a. 802.11b: BPSK, QPSK, CCK

b. 802.11a/g/n/ac: BPSK, QPSK, 16-QAM, 64-QAM, 256-QAM

15. Deve possuir potência de transmissão configurável em incrementos de 0,5 dBm.

16. Deve respeitar os limites de potência de transmissão máxima (conduzida):

a. Faixa de 2,4 GHz: +18 dBm por corrente, agregado de +21 dBm (2x2)

b. Banda de 5 GHz: +18 dBm por corrente, agregado de +21 dBm (2x2)

17. Deve suportar Advanced Cellular Coexistence (ACC) minimizando a interferência
das redes celulares;

18. Deve suportar Maximum ratio combining (MRC) para melhorar o desempenho do
receptor;

19. Deve suportar Cyclic delay/shift diversity (CDD/CSD) para melhorar o desempenho
RF de downlink;

20. Deve suportar Short guard interval para canais de 20MHz, 40MHz e 80MHz;
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21. Deve suportar Space-time block coding (STBC) para aumentar o alcance e
melhorar a recepção;

22. Deve suportar Verificação de paridade de baixa densidade (LDPC) para correção
de erros de alta eficiência e aumento da taxa de transferência;

23. Deve suportar Transmit beam-forming (TxBF);

24. Deve possuir, no mínimo, as seguintes taxas de dados suportadas (Mbps):

a. 802.11b: 1, 2, 5.5, 11

b. 802, 11a / g: 6, 9, 12, 18, 24, 36, 48, 54

c. 802.11n (2.4GHz): 6.5 a 300 (MCS0 a MCS15)

d. 802.11ac: 6.5 a 867 (MCS0 a MCS9, NSS = 1 a 2 for VHT20/40/80

25. Deve possuir suporte a 802.11n de alto rendimento (HT): HT 20/40

26. Deve possuir suporte a 802.11ac de alta velocidade (VHT): VHT 20/40/80

27. Deve possuir suporte a agregação de pacotes 802.11n/ac: A-MPDU, A-MSDU

 

Gerenciamento

28. Deve implementar funcionamento de modo auto gerenciado, sem necessidade de
controladora WLAN para configuração de seus parâmetros de rede wireless,
gerenciamento das políticas de segurança, QoS e monitoramento de RF.

29. Deve obedecer à todas as características descritas mesmo neste modo de
funcionamento;

30. No modo de funcionamento auto gerenciado deve disponibilizar na interface
gráfica informações de usuários conectados, qualidade de sinal e trafego de
dados na rede;

31. O ponto de acesso deve permitir a conversão de modo auto gerenciado para
modo gerenciado por controlador WLAN através de interface gráfica, em browser
padrão (HTTPS), e permitir que todos os demais pontos de acesso pertencentes
ao mesmo cluster, também sejam convertidos automaticamente;

32. O ponto de acesso deverá suportar conexão direta ou remota com controlador
WLAN, inclusive via roteamento da camada de rede, baseado no modelo OSI;

33. Se um controlador WLAN falhar, os Pontos de Acesso relacionados deverão se
associar automaticamente a um controlador WLAN alternativo, não permitindo
que a rede wireless se torne inoperante;

34. Implementar mecanismo de funcionamento para trabalhar com controladores
WLAN em redundância;

35. Deve permitir que o ponto de acesso seja atualizado de forma centralizada pela
interface gráfica;

36. Permitir o armazenamento de sua configuração em memória não volátil, podendo,
numa queda e posterior restabelecimento da alimentação, voltar à operação
normalmente na mesma configuração anterior;

37. Deve possuir servidor DHCP interno configurável;

38. Possibilitar backup e restore da configuração através da interface gráfica;

39. Deve possuir Portal Captivo (Captive Portal) integrado para utilização em rede de
visitantes;

40. Deve possuir mecanismos para proteção contra Pontos de Acesso não
autorizados (Rogues);

41. Possuir capacidade de identificação e listagem dos rádios vizinhos e respectivos
SSID/BSSID;

42. Implementar associação dinâmica de usuários à VLANs com base nos parâmetros
da etapa de autenticação;

43. Deve possuir uma base de usuários interna que diferencie usuários visitantes de
funcionários, para ser usada em autenticação 802.1x ou portal captivo;

44. Permitir a autenticação para acesso dos usuários conectados nas redes WLAN
(Wireless) através:

a. MAC Address

b. 802.1x em base Local

c. Captive Portal

d. 802.1x em base externa RADIUS

e. 802.1x em base externa LDAP

45. Deve permitir a seleção/uso de servidor de autenticação específico com base no
SSID;

46. Implementar o protocolo de enlace CSMA/CA para acesso ao meio de transmissão;
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47. Possuir capacidade de selecionar automaticamente o canal de transmissão;

48. Permitir o ajuste dinâmico de nível de potência e canal de rádio de modo a otimizar
o tamanho da célula de RF;

49. Permitir habilitar e desabilitar a divulgação do SSID;

50. Implementar diferentes tipos de combinações encriptação/autenticação por SSID;

51. Implementar padrão WMM da Wi-Fi Alliance para priorização de tráfego,
suportando aplicações em tempo real, tais como, VoIP, vídeo, dentre outras;

52. Não deve haver no licenciamento restrições com relação ao número de
dispositivos conectados por ponto de acesso;

53. Implementar a pilha de protocolos TCP/IP com suporte a IPV4 e IPV6 (Bridging);

54. Implementar VLANs conforme padrão IEEE 802.1Q;

55. Possuir, no mínimo, uma interface IEEE 802.3 10/100/1000BaseT Ethernet, auto-
sensing, auto MDI/MDX;

56. Permitir a atualização remota do sistema operacional e arquivos de configuração
através da controladora WLAN

57. Implementar cliente DHCP, para configuração automática de rede;

58. Deve configurar-se automaticamente ao ser conectado na rede;

59. Possuir LED’s indicativos do estado de operação, da atividade do rádio e da
interface Ethernet;

60. Possuir estrutura que permita fixação do equipamento em teto e parede e
fornecer acessórios para que possa ser feita a fixação;

61. Deve ser acompanhado de todos os acessórios necessários para
operacionalização do equipamento, tais como: softwares, cabos de console,
cabos de energia elétrica, documentação técnica e manuais (podendo ser em CD-
ROM) que contenham informações suficientes para possibilitar a instalação,
configuração e operacionalização do equipamento;

62. Permitir o bloqueio da configuração do Ponto de Acesso via rede wireless;

63. Implementar varredura de RF nas bandas 802.11a, 802.11b, 802.11g, 802.11n,
para identificação de Pontos de Acesso intrusos não autorizados (rogues) e
interferências no canal habilitado ao ponto de acesso e nos demais canais
configurados na rede WLAN, sem impacto no seu desempenho;

64. Implementar IEEE 802.1x, com pelo menos os seguintes métodos EAP:

a. EAP- MD5

b. EAP-FAST

c. EAP-TLS

d. PEAP-GTC

e. PEAP-MSCHAPv2

65. Permitir a integração com RADIUS Server com suporte aos métodos EAP citados;

66. A comunicação entre todos os pontos de acesso sem fio e a controladora deverá
ser criptografada;

67. Suportar a autenticação com geração dinâmica de chaves criptográficas por
sessão e por usuário;

68. Implementar WPA com algoritmo de criptografia TKIP e MIC;

69. Implementar WPA2 com algoritmo de criptografia AES, 128/256 bits, IEEE 802.11i;

70. Deve possuir modo dedicado de funcionamento de análise de espectro das faixas
de frequência de 2.4 e 5 GHz identificando fontes de interferência nessas faixas;

71. Deve possibilitar analise de espectro nos canais em que estiver provendo acesso,
sem desconectar os usuários;

72. Deve disponibilizar informações gráficas de análise de espectro em conjunto com
o controlador WLAN;

73. O equipamento deverá possuir registro na ANATEL e deverá ser apresentado na
entrega do equipamento;

74. Deverá prover priorização de trafego de vídeo e voz através de parâmetros de
QoS (Quality os Service) com possibilidade de aplicar por SSID e dispositivo;

75. Possibilitar roaming na rede wireless;

76. Suportar a criação de uma rede de convidados autocontida com isolamento de
tráfego entre clientes e serviços locais;

77. Possuir recursos de seleção automática de canal de transmissão procurando por
canais onde haja menor interferência, tendo por objetivo melhorar a performance
da rede wireless;

78. Permitir a operação em estrutura Mesh viabilizando a comunicação direta entre
diferentes Pontos de Acesso sem Fio onde não seja possível estender a rede
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cabeada;

79. Operando em estrutura Mesh, a comunicação entre os dispositivos estrutura
deverão operar na frequência de 5Ghz.

80. Possuir mecanismo para a restauração das configurações originais de fábrica
fisicamente no equipamento (reset);

81. Suportar operação em humidade de 5% a 95% sem condensação;

82. Suportar operação em temperatura de até 40°C (quarenta graus centígrados);

83. Possuir um MTBF (Mean Time Between Failure - Período Médio entre Falhas) de, no
mínimo, 250.000 horas.

 

Garantia e Suporte

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-
site pelo período mínimo de 60 (sessenta) meses para reposição de peças, mão
de obra e atendimento. O prazo máximo para atendimento do chamado deve ser
de até o próximo dia útil após a sua abertura. Durante o período da garantia o
prazo máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis.

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução.

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
disponibilidade ainda de área para cadastro da solução de hardware ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo
0800 para suporte técnico e abertura de chamados técnicos.

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e
solução exigidos para os equipamentos, deverá ser comprovada a existência da
assistência técnica local no domicílio da contratante e na modalidade on-site,
devendo essa ser realizada por meio de documentação oficial do fabricante dos
produtos e de domínio público, através de catálogos, folder impressos ou da
internet, devendo constar o endereço URL na mesma. Caso não seja comprovada
por um dos meios citados anteriormente, será possível a comprovação através da
apresentação de documentação expressa do fabricante dos equipamentos,
indicando a referida assistência técnica que será responsável pelo atendimento e
manutenção durante o período de garantia dos produtos ofertados. Em caso de
documentação expressa do fabricante a esta deverá ser anexada uma
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do
próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada.

 

ITEM 08 – PONTO DE ACESSO INTERNO TIPO 02
Características gerais

1. Equipamento de Ponto de Acesso para rede local sem fio, configurável via
software, com funcionamento simultâneo nos padrões IEEE 802.11a/n/ac, 5GHz,
e IEEE 802.11b/g/n, 2.4GHz;

2. Todos os Pontos de acesso sem fio deverão ser novos e sem nenhum histórico
de utilização;

3. Os pontos de acesso deverão possuir certificado emitido pelo “WIFI Alliance”
comprovando no mínimo os seguintes padrões, protocolos e funcionalidades:

a. IEEE 802.11a;

b. IEEE 802.11b;

c. IEEE 802.11g;

d. IEEE 802.11n;

e. IEEE 802.11d;

f. IEEE 802.11ac;

g. WPA® Enterprise/Personal;

h. WPA2® Enterprise/Personal;

i. EAP-TLS;

j. EAP-TTLS/MSCHAPv2;

k. PEAPv0/EAP-MSCHAPv2;
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l. PEAPv1/EAP-GTC;

m. EAP-SIM;

n. EAP-FAST;

o. WMM® e WMM® Power Save;

p. Beamforming;

q. Short Guard Interval (SGI);

r. Packet Aggregation (A-MPDU);

s. Opportunistic Key Caching (OKC)

4. Deve operar simultaneamente em 2.4GHz e 5GHz (concurrent dual-band);

 

Performance

5. Deve suportar rádio dual, 5 GHz 802.11ac 4x4 MIMO e 2.4 GHz 802.11n 2x2
MIMO;

6. Deve possuir rádio duplo configurável pelo software, suportando 5 GHz e 2,4
GHz;

7. Deve possuir quatro spatial stream Single User (SU) MIMO para taxa de dados
sem fio de até 1,733 Mbps, em 5GHz;

8. Deve possuir três spatial stream Multi User (MU) MIMO para uma taxa de dados
sem fio de até 1,300 Mbps para dispositivos clientes compatíveis, em 5GHz;

9. Deve possuir suporte para até 255 dispositivos cliente associados por rádio e até
16 BSSIDs por rádio;

10. Deve suportar no mínimo as bandas de frequência:

a. 2,400 a 2,4835 GHz

b. 5.150 a 5.250 GHz

c. 5.250 a 5.350 GHz

d. 5,470 a 5,725 GHz

e. 5,725 a 5,850 GHz

11. Deve possuir suporte a seleção de frequência dinâmica (DFS) otimizando o uso do
espectro de RF disponível;

12. Deve suportar, no mínimo, as seguintes tecnologias de rádio:

a. 802.11b: espectro espalhável de sequência direta (DSSS);

b. 802.11a / g / n / ac: multiplexação por divisão de frequência ortogonal (OFDM);

13. Deve suportar, no mínimo, os seguintes tipos de modulação:

a. 802.11b: BPSK, QPSK, CCK;

b. 802.11a / g / n / ac: BPSK, QPSK, 16-QAM, 64-QAM, 256-QAM;

14. Deve possuir potência de transmissão configurável em incrementos de 0,5 dBm;

15. Deve respeitar os limites de potência de transmissão máxima (conduzida):

a. Faixa de 2,4 GHz: +18 dBm por corrente, agregado de +24 dBm (3x3);

b. Faixa de 5 GHz: +18 dBm por corrente, agregado de +24 dBm (4x4);

16. Deve suportar Advanced Cellular Coexistence (ACC) minimizando a interferência
das redes celulares;

17. Deve suportar Maximum Ratio Combining (MRC) para melhorar o desempenho do
receptor;

18. Deve suportar Cyclic delay/shift diversity (CDD/CSD) para melhorar o desempenho
RF de downlink;

19. Deve suportar Short guard interval para canais de 20-MHz, 40-MHz e 80-MHz;

20. Deve suportar Space-time block coding (STBC) para aumentar o alcance e
melhorar a recepção;

21. Deve suportar verificação de paridade de baixa densidade (LDPC) para correção
de erros de alta eficiência e aumento da taxa de transferência;

22. Deve suportar Transmit beam-forming (TxBF);

23. Deve possuir, no mínimo, as seguintes taxas de dados suportadas (Mbps):

a. 802.11b: 1, 2, 5.5, 11

b. 802.11a/g: 6, 9, 12, 18, 24, 36, 48, 54

c. 802.11n: 6.5 até 450 (MCS0 até MCS23)
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d. 802.11ac: 6.5 até 1,733 (MCS0 até MCS9, NSS = 1 até 4)

24. Deve possuir suporte a 802.11n de alto rendimento (HT): HT 20/40;

25. Deve possuir suporte a 802.11ac de alta velocidade (VHT): VHT 20/40/80;

26. Deve possuir suporte a agregação de pacotes 802.11n/ac: A-MPDU, A-MSDU;

 

Gerenciamento

27. Deve implementar funcionamento de modo auto gerenciado, sem necessidade de
controladora WLAN para configuração de seus parâmetros de rede wireless,
gerenciamento das políticas de segurança, QoS e monitoramento de RF.

28. Deve obedecer a todas as características descritas mesmo neste modo de
funcionamento;

29. No modo de funcionamento autogerenciado deve disponibilizar na interface
gráfica informações de usuários conectados, qualidade de sinal e trafego de
dados na rede;

30. O ponto de acesso deve permitir a conversão de modo auto gerenciado para
modo gerenciado por controlador WLAN através de interface gráfica, em browser
padrão (HTTPS), e permitir que todos os demais pontos de acesso pertencentes
ao mesmo cluster, também sejam convertidos automaticamente;

31. O ponto de acesso deverá suportar conexão direta ou remota com controlador
WLAN, inclusive via roteamento da camada de rede, baseado no modelo OSI;

32. Se um controlador WLAN falhar, os Pontos de Acesso relacionados deverão se
associar automaticamente a um controlador WLAN alternativo, não permitindo
que a rede wireless se torne inoperante;

33. Implementar mecanismo de funcionamento para trabalhar com controladores
WLAN em redundância;

34. Deve permitir que o ponto de acesso seja atualizado de forma centralizada pela
interface gráfica;

35. Permitir o armazenamento de sua configuração em memória não volátil, podendo,
numa queda e posterior restabelecimento da alimentação, voltar à operação
normalmente na mesma configuração anterior;

36. Deve possuir servidor DHCP interno configurável;

37. Possibilitar backup e restore da configuração através da interface gráfica;

38. Deve possuir Portal Captivo (Captive Portal) integrado para utilização em rede de
visitantes;

39. Deve possuir mecanismos para proteção contra Pontos de Acesso não
autorizados (Rogues);

40. Possuir capacidade de identificação e listagem dos rádios vizinhos e respectivos
SSID/BSSID;

41. Implementar associação dinâmica de usuários à VLANs com base nos parâmetros
da etapa de autenticação;

42. Deve possuir uma base de usuários interna que diferencie usuários visitantes de
funcionários, para ser usada em autenticação 802.1x ou portal captivo;

43. Permitir a autenticação para acesso dos usuários conectados nas redes WLAN
(Wireless) através:

a. MAC Address

b. 802.1x em base Local

c. Captive Portal

d. 802.1x em base externa RADIUS

e. 802.1x em base externa LDAP

44. Deve permitir a seleção/uso de servidor de autenticação específico com base no
SSID;

45. Implementar o protocolo de enlace CSMA/CA para acesso ao meio de transmissão;

46. Possuir capacidade de selecionar automaticamente o canal de transmissão;

47. Permitir o ajuste dinâmico de nível de potência e canal de rádio de modo a otimizar
o tamanho da célula de RF;

48. Permitir habilitar e desabilitar a divulgação do SSID;

49. Implementar diferentes tipos de combinações encriptação/autenticação por SSID;

50. Implementar padrão WMM da Wi-Fi Alliance para priorização de tráfego,
suportando aplicações em tempo real, tais como, VoIP, vídeo, dentre outras;

51. Não deve haver no licenciamento restrições com relação ao número de
dispositivos conectados por ponto de acesso;

52. Implementar a pilha de protocolos TCP/IP com suporte a IPV4 e IPV6 (Bridging);
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53. Implementar VLANs conforme padrão IEEE 802.1Q;

54. Possuir, no mínimo, uma interface IEEE 802.3 10/100/1000BaseT Ethernet, auto-
sensing, auto MDI/MDX;

55. Permitir a atualização remota do sistema operacional e arquivos de configuração
através da controladora WLAN

56. Implementar cliente DHCP, para configuração automática de rede;

57. Deve configurar-se automaticamente ao ser conectado na rede;

58. Possuir LED’s indicativos do estado de operação, da atividade do rádio e da
interface Ethernet;

59. Possuir estrutura que permita fixação do equipamento em teto e parede e
fornecer acessórios para que possa ser feita a fixação;

60. Deve ser acompanhado de todos os acessórios necessários para
operacionalização do equipamento, tais como: softwares, cabos de console,
cabos de energia elétrica, documentação técnica e manuais (podendo ser em CD-
ROM) que contenham informações suficientes para possibilitar a instalação,
configuração e operacionalização do equipamento;

61. Permitir o bloqueio da configuração do Ponto de Acesso via rede wireless;

62. Implementar varredura de RF nas bandas 802.11a, 802.11b, 802.11g, 802.11n,
para identificação de Pontos de Acesso intrusos não autorizados (rogues) e
interferências no canal habilitado ao ponto de acesso e nos demais canais
configurados na rede WLAN, sem impacto no seu desempenho;

63. Implementar IEEE 802.1x, com pelo menos os seguintes métodos EAP:

a. EAP- MD5

b. EAP-FAST

c. EAP-TLS

d. PEAP-GTC

e. PEAP-MSCHAPv2

64. Permitir a integração com RADIUS Server com suporte aos métodos EAP citados;

65. A comunicação entre todos os pontos de acesso sem fio e a controladora deverá
ser criptografada;

66. Suportar a autenticação com geração dinâmica de chaves criptográficas por
sessão e por usuário;

67. Implementar WPA com algoritmo de criptografia TKIP e MIC;

68. Implementar WPA2 com algoritmo de criptografia AES, 128/256 bits, IEEE 802.11i;

69. Deve possuir modo dedicado de funcionamento de análise de espectro das faixas
de frequência de 2.4 e 5 GHz identificando fontes de interferência nessas faixas;

70. Deve possibilitar analise de espectro nos canais em que estiver provendo acesso,
sem desconectar os usuários;

71. Deve disponibilizar informações gráficas de análise de espectro em conjunto com
o controlador WLAN;

72. O equipamento deverá possuir registro na ANATEL e deverá ser apresentado na
entrega do equipamento;

73. Deverá prover priorização de trafego de vídeo e voz através de parâmetros de
QoS (Quality os Service) com possibilidade de aplicar por SSID e dispositivo;

74. Possibilitar roaming na rede wireless;

75. Suportar a criação de uma rede de convidados autocontida com isolamento de
tráfego entre clientes e serviços locais;

76. Possuir recursos de seleção automática de canal de transmissão procurando por
canais onde haja menor interferência, tendo por objetivo melhorar a performance
da rede wireless;

77. Permitir a operação em estrutura Mesh viabilizando a comunicação direta entre
diferentes Pontos de Acesso sem Fio onde não seja possível estender a rede
cabeada;

78. Operando em estrutura Mesh, a comunicação entre os dispositivos estrutura
deverão operar na frequência de 5Ghz.

79. Possuir mecanismo para a restauração das configurações originais de fábrica
fisicamente no equipamento (reset);

80. Suportar operação em humidade de 5% a 95% sem condensação;

81. Suportar operação em temperatura de até 40°C (quarenta graus centígrados);

82. Possuir um MTBF (Mean Time Between Failure - Período Médio entre Falhas) de, no
mínimo, 250.000 horas.
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Garantia e Suporte

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-
site pelo período mínimo de 60 (sessenta) meses para reposição de peças, mão
de obra e atendimento. O prazo máximo para atendimento do chamado deve ser
de até o próximo dia útil após a sua abertura. Durante o período da garantia o
prazo máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis.

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução.

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
disponibilidade ainda de área para cadastro da solução de hardware ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo
0800 para suporte técnico e abertura de chamados técnicos.

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e
solução exigidos para os equipamentos, deverá ser comprovada a existência da
assistência técnica local no domicílio da contratante e na modalidade on-site,
devendo essa ser realizada por meio de documentação oficial do fabricante dos
produtos e de domínio público, através de catálogos, folder impressos ou da
internet, devendo constar o endereço URL na mesma. Caso não seja comprovada
por um dos meios citados anteriormente, será possível a comprovação através da
apresentação de documentação expressa do fabricante dos equipamentos,
indicando a referida assistência técnica que será responsável pelo atendimento e
manutenção durante o período de garantia dos produtos ofertados. Em caso de
documentação expressa do fabricante a esta deverá ser anexada uma
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.

6.  Todos os componentes instalados ou integrados dos equipamentos devem ser
do próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada.

 

ITEM 09 – INJETOR POE PARA PONTOS DE ACESSO
TIPO 1
Características técnicas mínimas

1. Deve ser do mesmo fabricante dos Pontos de acesso ou homologado e
certificado pelo mesmo para utilização em seus equipamentos;

2. Injetor PoE 802.3af 10/100/1000 Ethernet com 15.4W;

 

Garantia e Suporte

1. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de
peças, mão de obra e atendimento no local. O período da garantia o prazo
máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis;

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(part number), incorporado ao equipamento;

3. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do
próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada.

 

ITEM 10 – INJETOR POE PARA PONTOS DE ACESSO
TIPO 2
Características técnicas mínimas

1. Deve ser do mesmo fabricante dos Pontos de acesso ou homologado e
certificado pelo mesmo para utilização em seus equipamentos;

2. Injetor PoE+ 802.3at 10/100/1000 Ethernet com 30W;

 

Garantia e Suporte

1. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de
peças, mão de obra e atendimento no local. O período da garantia o prazo
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máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis;

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(part number), incorporado ao equipamento;

3. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do
próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada.

 

ITEM 11 – SERVIÇOS DE IMPLANTAÇÃO E
TRANSFERÊNCIA DE TECNOLOGIA PARA SOLUÇÃO
DE GERENCIAMENTO
Características Gerais

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das
14:00 às 18:00) presencialmente no TRE-AL ou remotamente conforme
necessidades da CONTRATANTE;

 

Implantação

2. Instalação e configuração de 1 (uma) instância do serviço de gerenciamento de
rede, contemplando:

a. Configurações básicas para acesso à rede, dimensionamento e configuração de
armazenamento;

b. Inclusão de no mínimo 10 (dez) pontos de acesso no monitoramento;

c. Criação de modelo de configuração (templates) de forma a possibilitar a replicação
de configuração entre equipamentos.

 

Transferência De Tecnologia

3. O treinamento deverá ser no realizado na modalidade workshop com tarefas
práticas hands-on, visando assim a melhor fixação dos temas abordados com
foco direto na explicação da tecnologia da solução como também nas rotinas de
configuração, gerenciamento, administração e operação da mesma;

 

4. O treinamento do MÓDULO DE GERENCIA DE REDE deverá ter duração mínima
de 24 (vinte e quatro) horas onde será abordado, no mínimo, os seguintes
tópicos:

a. Inserção, modificação e remoção de dispositivos de forma unitária e em lote;

b. Configuração de VLANs Globais e Locais em switchs gerenciados;

c. Configuração de ACLS Globais e Locais em switchs gerenciados;

d. Backup e restore de configuração de switchs gerenciados;

e. Monitoramento e alarmes default e customizados;

f. Customização do Dashboard com alertas, mapas de topologia e monitoramento
de dispositivos;

 

ITEM 12 - SERVIÇOS DE IMPLANTAÇÃO E
TRANSFERÊNCIA DE TECNOLOGIA DO MÓDULO DE
CONTROLE DE ACESSO
Características Gerais

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das
14:00 às 18:00) presencialmente no TRE-AL ou remotamente conforme
necessidades da CONTRATANTE;

 

Implantação

2. Instalação e configuração de 1 (uma) instancia do serviço controle de acesso,
contemplando:

a. Configurações básicas para acesso à rede, dimensionamento e configuração de
armazenamento;

b. Configuração de autenticação em Active Directory para usuários corporativos;

c. Configuração de autenticação de visitantes com portal de autosserviço para
criação de usuários;
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d. Configuração de no mínimo 5 (cinco) dispositivos de rede para autenticação na
solução.

 

Transferência de Tecnologia

3. O treinamento deverá ser no realizado na modalidade workshop com tarefas
práticas hands-on, visando assim a melhor fixação dos temas abordados com
foco direto na explicação da tecnologia da solução como também nas rotinas de
configuração, gerenciamento, administração e operação da mesma devendo ter
duração mínima de 24 (vinte e quatro) horas onde será abordado no mínimo os
seguintes tópicos:

a. Configuração de Active Directory como base de autenticação;

b. Configuração de autenticação de usuários corporativos;

c. Configuração de autenticação de usuários visitantes;

d. Configuração de portal de autosserviço;

e. Configuração de autenticação e autorização com protocolo RADIUS.

ITEM 13 – SERVIÇOS DE IMPLANTAÇÃO E
TRANSFERÊNCIA DE TECNOLOGIA PARA
CONTROLADORA WLAN E PONTOS DE ACESSO
 

Características Gerais

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das
14:00 às 18:00) presencialmente no TRE-AL ou remotamente conforme
necessidades da CONTRATANTE;

 

Implantação

2. Instalação e configuração de no mínimo 10 (dez) pontos de acesso,
contemplando:

a. Configuração básica de acesso a gerência via rede;

b. Configuração de gerência e monitoramento em MÓDULO DE GERENCIA DE
REDE;

c. Configuração da autenticação de usuários em MÓDULO DE CONTROLE DE
ACESSO

d. Configuração de pontos de acesso em controladora WLAN habilitando
gerenciamento centralizado;

 

Transferência de Tecnologia

3. O treinamento deverá ser no realizado na modalidade workshop com tarefas
práticas hands-on, visando assim a melhor fixação dos temas abordados com
foco direto na explicação da tecnologia dos produtos ofertados como também
nas rotinas de configuração, gerenciamento, administração e operação dos
mesmos devendo ter duração mínima de 16 (Dezesseis) horas onde será
abordado no mínimo os seguintes tópicos:

a. Configuração inicial e acesso a gerência;

b. Configuração de Clusters;

c. Configuração de autenticação de usuários em MÓDULO DE CONTROLE DE
ACESSO;

d. Criação de SSID com autenticação PSK;

e. Criação de SSID com autenticação enterprise em MÓDULO DE CONTROLE DE
ACESSO;

f. Configuração de pontos de acesso para MÓDULO DE GERENCIA DE REDE;

g. Configuração pontos de acesso para MÓDULO DE ANÁLISE DE TRÁFEGO;

 

ITEM 14 – TREINAMENTO BÁSICO DE
ADMINISTRAÇÃO DE ARQUITETURA WLAN
 

Características Gerais

7. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do
fabricante no Treinamento Básico De Administração De Arquitetura Wlan para 01
(um) profissional da contratante;

8. O voucher deverá ter validade de pelo menos 12 (doze) meses;
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9. O treinamento deverá ser de acordo com o calendário de treinamento do
fabricante e ministrado em centro oficial de treinamento do mesmo ou
remotamente, utilizando tecnologia de ensino a distância;

10. Deverá ser ministrado por profissional devidamente credenciado junto ao
fabricante e apto a entregar o respectivo;

11. O treinamento deverá compreender a explicação da tecnologia da solução como
também das rotinas de configuração, gerenciamento, administração e operação
da mesma;

12. O treinamento deverá ter carga horária mínima de 20 (vinte) horas, ministrado no
período de 08:00 às 12:00 e das 14:00 às 18:00.

 

ITEM 15 – TREINAMENTO BÁSICO DA SOLUÇÃO DE
GERENCIAMENTO
 

Características Gerais

1. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do
fabricante no Treinamento da Solução de Gerenciamento para 01 (um) profissional
da contratante;

2. O voucher deverá ter validade de pelo menos 12 (doze) meses;

3. O treinamento deverá ser de acordo com o calendário de treinamento do
fabricante e ministrado em centro oficial de treinamento do mesmo ou
remotamente, utilizando tecnologia de ensino a distância;

4. Deverá ser ministrado por profissional devidamente credenciado junto ao
fabricante e apto a entregar o respectivo;

5. O treinamento deverá compreender a explicação da tecnologia da solução como
também das rotinas de configuração, gerenciamento, administração e operação
da mesma;

6. O treinamento deverá ter carga horária mínima de 40 (Quarenta) horas,
ministrado no período de 08:00 às 12:00 e das 14:00 às 18:00.

 

ITEM 16 – TREINAMENTO BÁSICO DA SOLUÇÃO DE
CONTROLE DE ACESSO
 

Características Gerais

7. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do
fabricante no Treinamento da Solução de Controle de Acesso  para 01 (um)
profissional da contratante;

8. O voucher deverá ter validade de pelo menos 12 (doze) meses;

9. O treinamento deverá ser de acordo com o calendário de treinamento do
fabricante e ministrado em centro oficial de treinamento do mesmo ou
remotamente, utilizando tecnologia de ensino a distância;

10. Deverá ser ministrado por profissional devidamente credenciado junto ao
fabricante e apto a entregar o respectivo;

11. O treinamento deverá compreender a explicação da tecnologia da solução como
também das rotinas de configuração, gerenciamento, administração e operação
da mesma;

12. O treinamento deverá ter carga horária mínima de 40 (Quarenta) horas,
ministrado no período de 08:00 às 12:00 e das 14:00 às 18:00.

3.2 Forma de Execução e de Gestão do Contrato (Art. 18, § 3º, III, a)
A execução do objeto pressupõe a existência dos seguintes

papéis e responsabilidades (Art. 18, § 3º, III, a, 1):

1. Patrocinador da Contratação: é o titular da área demandante, responsável por
representar os interesses do órgão no contexto da Contratação, pela aprovação
da necessidade e, por fim, pela negociação das ações necessárias para que os
objetivos sejam alcançados;

2. Gestor do Contrato (art. 3º, IV, da Resolução TRE/AL nº 15.787/2017): servidor
designado para coordenar e comandar o processo da fiscalização da execução
contratual. Na forma do Art. 17 da mesma Resolução, o gestor do contrato
responsabiliza-se pela condução da gestão e fiscalização do contrato, nos termos
do Art. 67, da Lei nº 8.666/93.

3. Fiscal do Contrato (art. 3º, VI, da Resolução TRE/AL nº 15.787/2017): servidor
designado para auxiliar o gestor do contrato quanto à fiscalização do objeto do
contrato. Neste sentido, indicado pela respectiva autoridade competente para
fiscalizar o Contrato quanto aos aspectos técnicos da solução.

Dinâmica da Execução (Art. 18, § 3º, III, a, 2):

1. Os equipamentos deverão ser entregues no Almoxarifado do TRE/AL, nos
quantitativos indicados no pedido de fornecimento;
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2. A garantia dos equipamentos deve obedecer o detalhamento técnico feito e terá
seu tempo contado por cada fornecimento individualmente;

3. Entende-se como garantia aquela prestada pelo próprio fabricante ou por rede
credenciada pelo fabricante do(s) referido(s) equipamento(s);

4. O pagamento será realizado individualmente para cada nota fiscal apresentada,
após emissão do aceite definitivo pela unidade competente do TRE/AL;

5. Os equipamentos deverão ser novos, não recondicionados, de primeiro uso e não
deverão conter marcas, amassados, arranhões ou outros problemas e, ainda,
serem entregues em pleno estado de funcionamento;

6. Os equipamentos deverão atender rigorosamente a todas as especificações
técnicas contidas neste Termo de Referência e em seus Anexos;

7. Os equipamentos deverão vir acompanhados de todos os acessórios necessários
para o seu pleno estado de funcionamento, como cabos, drivers, mídias e outros,
os quais só serão recebidos juntamente com os respectivos equipamentos. Este
item se aplica tanto para a entrega dos equipamentos quanto para substituições
durante o período de garantia;

8. Ao TRE é reservado o direito de efetuar conexões dos equipamentos a outros,
bem como adicionar demais acessórios compatíveis tecnicamente, sem que isso
constitua motivo para a Contratada se desobrigar da garantia, desde que tal fato
não implique danos materiais ou técnicos aos equipamentos e acessórios,
hipótese que deverá ser devidamente comprovada;

9.  Ao TRE/AL é reservado o direito de efetuar diligência, a qualquer tempo, quanto
aos documentos exigidos neste Termo de Referência e em seus Anexos.

Recebimento do Objeto:

1. O Tribunal designará Comissão para realizar o recebimento provisório, que só será
emitido se os equipamentos estiverem de acordo com as especificações técnicas;

2. Após a entrega, os equipamentos serão submetidos à avaliação e homologação
pelos responsáveis técnicos do Tribunal;

3.  O exame para comprovação das características técnicas consistirá em avaliações
e testes não-destrutivos, por amostragem realizados em duas etapas:

a. Primeira: inspeção visual de todos os equipamentos entregues;
b. Segunda: testes funcionais de configuração e desempenho, em, no mínimo,

10% (dez por cento) e não menos do que 01 (um) dos equipamentos
recebidos. O Tribunal poderá, a seu critério, executar os testes nos demais
equipamentos, dentro de um critério de razoabilidade, podendo chegar
a 100% dos quantitativos, mas dentro de um prazo máximo de 30 (trinta)
dias corridos e contados de cada lote de equipamentos.

4. As especificações serão avaliadas também por meio de documentos técnicos que
acompanham os equipamentos, informações fornecidas pela Contratada e
disponível no sítio do fabricante.

5. A comissão do Tribunal deverá, após a comprovação do perfeito funcionamento
dos equipamentos e adequação às especificações técnicas, emitir e assinar o
Termo de Recebimento Definitivo.

Instrumentos Formais de Solicitação do(s) Bens e/ou
Serviço(s) (Art. 18, § 3º, III, a, 3):

1. A Ordem de Fornecimento será o instrumento formal de solicitação dos bens
pertencentes ao escopo desta contratação.

Forma de Pagamento (Art. 18, § 3º, III, a, 7)

1. O pagamento será efetuado mediante crédito em conta-corrente do Fornecedor,
por ordem bancária, no prazo disposto nos artigos 5º, § 3º, ou 40, XIV, “a”, da
Lei n. 8.666/93, conforme o caso, quando mantidas as mesmas condições iniciais
de habilitação e cumpridos os seguintes  requisitos:

a. Apresentação de nota fiscal de acordo com a legislação vigente à época da
emissão (nota fiscaleletrônica, se for o caso), acompanhada da
Certidão Negativa de Débito – CND, comprovando regularidade com o INSS;
do Certificado de Regularidade do FGTS – CRF, comprovando regularidade
com o FGTS; da Certidão Conjunta Negativa de Débitos Relativos a Tributos
Federais e à Dívida Ativa da União, expedida pela Secretaria da Receita
Federal; e da Certidão Negativa de Débitos Trabalhistas – CNDT, emitida pela
Justiça do Trabalho; e  da prova de regularidade para com as Fazendas
Estadual e Municipal do domicílio ou sede do Fornecedor; e

b. Inexistência de fato impeditivo para o qual tenha concorrido o Fornecedor.
2. Nenhum pagamento será efetuado à Contratada enquanto pendente de liquidação

qualquer obrigação. Esse fato não será gerador de direito a reajustamento de
preços ou a atualização monetária.

Direitos de Propriedade Intelectual (Art. 18, § 3º, III, a, 9):

1. Esse requisito não se aplica ao contexto desta contratação, uma vez que o objeto
se refere ao fornecimento de equipamentos, cujos direitos autorais do fabricante
são resguardados por legislação nacional e internacional.

Penalidades (Art. 18, § 3º, III, a, 11):

1. Com fundamento no artigo 7º da Lei nº 10.520/2002 e, subsidiariamente, nos
artigos 86 e 87 da Lei 8.666/1993, a Contratada ficará sujeita, assegurada prévia e
ampla defesa, às seguintes penalidades:

a. Advertência:
i. A Contratada será notificada formalmente em caso de descumprimento

de obrigação contratual e terá que apresentar as devidas justificativas
em um prazo de até 5 (cinco) dias úteis após o recebimento da
notificação; e

ii. Caso não haja manifestação dentro desse prazo ou se entenda serem
improcedentes as justificativas apresentadas, a Contratada será
advertida;

b. Multa de:
i. 0,5% por dia, sobre o valor constante da Ordem de Fornecimento, no

caso de atraso injustificado na entrega dos equipamentos, limitada a
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incidência a 20 (vinte) dias corridos;
1. No caso de atraso injustificado na entrega dos equipamentos por prazo superior

a 20 (vinte) dias corridos, com
a aceitação pela Administração, será aplicada a multa de
10% sobre o valor da Ordem de Fornecimento; e

2. No caso de atraso injustificado na entrega dos equipamentos por prazo superior
a 20 (vinte) dias corridos, com a
não aceitação pela Administração, será aplicada a penalidade 20%
sobre o valor da Ordem de Fornecimento, no caso de inexecução
total da obrigação, podendo haver, ainda, o cancelamento do
registro de preços do Fornecedor;

ii.  0,5% por dia, sobre o valor do equipamento,
no caso de atraso injustificado na solução do chamado de garantia, limitada a incidência 30
(trinta) dias corridos;

1. No caso de atraso injustificado na solução do chamado de garantia por prazo superior
a 30 (trinta) dias corridos, aplica-se adicionalmente, a multa de
1% sobre o valor da Ordem de Fornecimento; e

2. A multa por atraso relacionada ao item
anterior será auferida por Ordem de Fornecimento e aplicada somente uma única vez a
cada mês, independente da quantidade de equipamentos sem
solução.

iii. 10% sobre o valor constante da Ordem de Fornecimento, no caso de
inexecução parcial da obrigação assumida;

iv. 20% sobre o valor da Ordem de Fornecimento, no caso de inexecução
total da obrigação, podendo haver, ainda, o cancelamento do registro
de preços do Fornecedor;

v. 10% sobre o valor global estimado da Ata de Ata de Registro de Preços,
na hipótese de recusa em assinar a Ata ou o instrumento do contrato,
ou retirar a Ordem de Fornecimento.

c. Impedimento de licitar e contratar com a União e descredenciamento do
SICAF pelo prazo de até 5 (cinco) anos, sem prejuízo das demais penalidades
legais; e

d. Declaração de inidoneidade para licitar ou contratar com a Administração
Pública.

2. O cometimento reiterado de atrasos injustificados dos prazos previstos para
entrega/solução do chamado de garantia dos equipamentos poderá resultar no
cancelamento do registro de preços com a Contratada.

3. As sanções previstas nos itens "1.a", “1.c” e “1.d” do item 1 poderão ser
aplicadas, cumulativamente ou não, à pena de multa.

4. O valor da multa, aplicada após o regular processo administrativo, será
descontado de pagamentos eventualmente devidos à contratada ou cobrado
judicialmente;

5. Excepcionalmente, ad cautelam, a Administração poderá efetuar a retenção do
valor presumido da multa, antes da instauração do regular procedimento
administrativo.
.
 

4. Requisitos Técnicos (Art. 18, § 3º, IV)
 
Garantia mínima de 36  (trinta e seis) meses.
Estar comprovadamente ainda em produção.
Conformidade com o presente Termo de Referência.

5. Modelos (templates) propostos a serem utilizados na contratação
(Art. 18, § 3º, III, V)

Memorando nº ____ / 20__ - TRE-AL/_______________________

Maceió, ___ de ___________ de _____________.

Para: SGO-COFIN

Assunto: Autorização de Emissão de Nota de Empenho.

PA _________________________

Adesão à Ata de Registro de Preços ______________

Ordem de Fornecimento nº _____/_________.

 

Senhor Chefe

Encaminhamos estes autos para emissão de Nota de Empenho, em favor
da Empresa ________________. CNPJ: xx.xxx.xxx/xxxx-xx, conforme tabela
abaixo, tudo em conformidade com o disposto na Resolução TRE-AL nº 12.738/1996
(0216181).

Certidões: SICAF evennto: ______ / RECEITA ESTADUAL evento: ______ / SIMPLES
NACIONAL (se aderente) evento: __________

Item:
Descrição:
Quant. total
da ATA

Quant.
Recebida

Quant. desta
Ordem

Saldo no
Fornecedor

Valor
Unitário

Valor Total
(R$)
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*  Solicitamos utilizar a reserva de crédito do PE XXX/XXXX

 

 

Gestor da Ata - Portaria TRE/AL nº XX/XXXX

 

Moodelo a ser adotado em decorrência do comando inserto no Proc SEI nº 0005423-
07.2018.6.02.8000, evento 0442132: modelo de referência indicado: 0452895.

Maceió, 16 de outubro de 2018.

Documento assinado eletronicamente por DANIEL MACÊDO DE CARVALHO SOUTO,
Coordenador, em 30/01/2019, às 15:21, conforme art. 1º, III, "b", da Lei 11.419/2006.

Documento assinado eletronicamente por CRISTINO HERMANO DE BULHÕES,
Coordenador Substituto, em 30/01/2019, às 15:21, conforme art. 1º, III, "b", da Lei
11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0450416 e o código CRC 58E08991.

0008478-63.2018.6.02.8000 0450416v42
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 8000 - Maceió - AL

 

DESPACHO

Maceió, 30 de janeiro de 2019.
À STI
 
Sr. Secretário,
 
Segue Termo de Referência, doc. 0450416, a visar

registro de preços de ativos de rede, para os fins previstos na
Resolução TRE/AL nº 15.904/2018 (Regulamento da
Secretaria do TRE/AL), art. 111, VI e, conforme entendimento,
posterior encaminhamento e prosseguimento do feito.

 
Respeitosamente.

Documento assinado eletronicamente por DANIEL MACÊDO DE CARVALHO SOUTO,
Coordenador, em 30/01/2019, às 15:26, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0494245 e o código CRC 269F7794.

0008478-63.2018.6.02.8000 0494245v1
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 31 de janeiro de 2019.
Senhor Secretário de Administração,
 
Nos termos do § 1º do art. 13 da Resolução CNJ nº

182/2013, manifesto concordância com os estudos
preliminares e com o termo de referência elaborados
pela Equipe de Planejamento da Contratação.

 
Atenciosamente,

Documento assinado eletronicamente por CARLOS HENRIQUE TAVARES MÉRO,
Secretário de Tecnologia da Informação, em 31/01/2019, às 16:14, conforme art. 1º,
III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0494899 e o código CRC EC2FD695.

0008478-63.2018.6.02.8000 0494899v1
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 06 de fevereiro de 2019.
Ao Senhor Secretário de Tecnologia da Informação,
 
Permita-se suscitar um incidente na instrução do

presente feito: dado o expressivo número de demandas
abertas por essa Secretaria e considerando o atual cenário de
restrições orçamentárias, solicito que, se possível, seja
apresentada uma lista com as priorizações dessas inicitivas,
como forma de auxiliar nossas ações relativas a estimativas de
preços e de possíveis pedidos de créditos adicionais.

Atenciosamente.

Documento assinado eletronicamente por JOSÉ RICARDO ARAÚJO E SILVA,
Secretário de Administração, em 06/02/2019, às 12:47, conforme art. 1º, III, "b", da
Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0497215 e o código CRC 5F08E0E1.

0008478-63.2018.6.02.8000 0497215v1
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 07 de fevereiro de 2019.
Senhor Secretário de Administração,
 
Informo que há prioridade para todos os

documentos de oficialização da demanda que decorrem do
plano de contratações de STIC 2019, cujos recursos
orçamentários estão previstos e expressos (processo SEI
nº 0010717-40.2018.6.02.8000).

 
Atenciosamente,

Documento assinado eletronicamente por CARLOS HENRIQUE TAVARES MÉRO,
Secretário de Tecnologia da Informação, em 07/02/2019, às 14:11, conforme art. 1º,
III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0498072 e o código CRC F35E9B28.

0008478-63.2018.6.02.8000 0498072v1
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 07 de fevereiro de 2019.
Reporto-me aos Despachos SAD 0497215 e

STI 0498072, para remeter os presentes autos à COFIN, no
sentido de informar se o plano de aquisições de TI é
compatível com a última versão da proposta orçamentária
deste Tribunal.

Documento assinado eletronicamente por JOSÉ RICARDO ARAÚJO E SILVA,
Secretário de Administração, em 07/02/2019, às 14:24, conforme art. 1º, III, "b", da
Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0498092 e o código CRC 96C59E73.

0008478-63.2018.6.02.8000 0498092v1
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 08 de fevereiro de 2019.
À SAD (c/c p SGO p ciência),
 
Sr. Secretário,
 
1. Diante do despacho SAD (0498092), venho

informar :
a) O Plano de Contratação de Soluções de TI fora

instruído em 26/11/2018, através do processo SEI nº 0010717-
40.2018.6.02.8000, evento (0469065);

b) O valor de contratações previstos no referido
plano (0469075), monta em R$ 4.221.346,00 (quatro milhões,
duzentos e vinte e um mil trezentos e quarenta e seis reais),
valor esse bem superior a proposta orçamentária final, cujo
valor, previsto para STI, fora da ordem de R$ 2.204.531,90
(dois milhões, duzentos e quatro mil quinhentos e trinta e um
reais e noventa centavos). 

c) Registro, que, quando das tratativas para ajustes
da proposta Orçamentária a STI decidiu pelo corte linear das
ações ao invés de ajustar pontualmente as ações
orçamentárias, notadamente em virtude da exiguidade do
tempo para conclusão dos ajustes.

 
2. Pelo exposto, demonstro sinteticamente os itens

previstos no Plano de Contratação e o valor efetivamente
disposto na proposta orçamentária ajustada :

Despacho COFIN 0499140         SEI 0008478-63.2018.6.02.8000 / pg. 84



 
3. Como se percebe, é necessário um grande ajuste

do plano de contratação ao valor do orçamento final. A
priorização dos itens a serem efetivados é de suma
importância visto que alguns itens previstos , em decorrência
da redução do valor, não poderão ser adquiridos em menor
quantidade ou isoladamente.

 
4. Em que pese o dinamismo da execução

orçamentária, percebo que as ações de STI , colocadas em
segundo plano, em virtude de contingenciamentos
necessários, prejudica a execução orçamentária. Por esse
motivo, proponho que se estipule as prioridades e sejam
estartadas, previamente, as contratações necessárias,
evitando-se o remanejamento de recursos orçamentários ao
encerrar do exercício financeiro.

 
Atenciosamente.

 

 

Documento assinado eletronicamente por RUI CARLOS GALVÃO, Coordenador
Orçamentário e Financeiro, em 08/02/2019, às 15:38, conforme art. 1º, III, "b", da Lei
11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0499140 e o código CRC 9BEF14D5.
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 09 de fevereiro de 2019.
Ao Senhor Secretário de TIC,
 
Em face do Despacho COFIN 0499140, remeto o

feito a Vossa Senhoria, reportando-me à solicitação veiculada
em nosso Despacho 0497215.

Atenciosamente.

Documento assinado eletronicamente por JOSÉ RICARDO ARAÚJO E SILVA,
Secretário de Administração, em 09/02/2019, às 14:53, conforme art. 1º, III, "b", da
Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0499157 e o código CRC 8F1F9439.

0008478-63.2018.6.02.8000 0499157v1
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 22 de fevereiro de 2019.
Senhor Secretário de Administração,
 
Reforço a manifestação de que há prioridade para

todos os documentos de oficialização da demanda que
decorrem do plano de contratações de STIC 2019.

 
Por outro lado, solicito a continuidade de trâmite

dos procedimentos de aquisição, inclusive com a indicação do
integrante administrativo e posterior publicação de portaria.

 
Atenciosamente,

Documento assinado eletronicamente por CARLOS HENRIQUE TAVARES MÉRO,
Secretário de Tecnologia da Informação, em 22/02/2019, às 12:09, conforme art. 1º,
III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0506392 e o código CRC 8481B963.

0008478-63.2018.6.02.8000 0506392v1
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 27 de fevereiro de 2019.
À COINF
 
Senhor Coordenador,
 
Tendo em vista o Despacho STI 0506392, solicito que seja

informada a estimativa de aquisição, ainda no presnete exercício, dos
itens listados no TR de evento 0450416, para efeito de darmos
sequência à fase de cotação de preços e posterior reserva de crédito.

Atenciosamente.

Documento assinado eletronicamente por JOSÉ RICARDO ARAÚJO E SILVA,
Secretário de Administração, em 28/02/2019, às 13:42, conforme art. 1º, III, "b", da
Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0508792 e o código CRC 72E8FAB8.

0008478-63.2018.6.02.8000 0508792v1
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 20 de março de 2019.
À SAD
 
Sr. Secretário,
 
Em atenção ao Despacho GSAD 0505792, segue

abaixo  estimativa de aquisição, ainda no presnete exercício.
 
 

LOTE 01 - SOLUÇÃO PARTA REDE CABEADA

ITEM DESCRIÇÃO DOS PRODUTOS/SERVIÇOS QTD

ITEM
10

SWITCH DE ACESSO L2 COM 24 PORTAS GIGABIT E
4SFP

05

 

LOTE 02 - SOLUÇÃO DE REDE WIRELESS

ITEM DESCRIÇÃO DOS PRODUTOS/SERVIÇOS QTD

ITEM
01

SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE
ACESSO PARA REDE WIRELESS 01

ITEM
02 SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS 01
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ITEM
05 CONTROLADORA WLAN 02

ITEM
07 PONTO DE ACESSO INTERNO TIPO 01 15

ITEM
08 PONTO DE ACESSO INTERNO TIPO 02 15

ITEM
09 INJETOR POE PARA PONTOS DE ACESSO TIPO 1 15

ITEM
10 INJETOR POE PARA PONTOS DE ACESSO TIPO 2 15

ITEM
11

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE
TECNOLOGIA PARA SOLUÇÃO DE GERENCIAMENTO 01

ITEM
12

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO 01

ITEM
13

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE
TECNOLOGIA PARA PONTOS DE ACESSO 03

ITEM
14

TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE
ARQUITETURA WLAN 03

ITEM
15

TREINAMENTO BÁSICO DA SOLUÇÃO DE
GERENCIAMENTO 03

ITEM
16

TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE
DE ACESSO 03
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Respeitosamente.

Documento assinado eletronicamente por DANIEL MACÊDO DE CARVALHO SOUTO,
Coordenador, em 25/03/2019, às 14:48, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0517349 e o código CRC 04322C0F.

0008478-63.2018.6.02.8000 0517349v1
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 28 de março de 2019.

À COMAP/SEIC,

Sra. Coordenadora, Sr. Chefe

Encaminho o presente expediente para, em atendimento ao teor do art. 8º da
Resolução nº 15.787/2017, realização da estimativa de preços para aquisição do
material indicado.

Oportunamente, em que pese a informação constante no Despacho STI 0506392,
informo que já houve a indicação do integrante administrativo da equipe de
planejamento da contratação, tendo sido, inclusive, publicada a respectiva portaria,
conforme eventos 0445262 e 0446491.

Atenciosamente,

Documento assinado eletronicamente por JOSÉ RICARDO ARAÚJO E SILVA,
Secretário de Administração, em 28/03/2019, às 19:16, conforme art. 1º, III, "b", da
Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0520870 e o código CRC 2D19B4F8.

0008478-63.2018.6.02.8000 0520870v1
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 29 de março de 2019.

 

À SEIC
 
Senhor Chefe,
 
Diante do Despacho GSAD 0520870, encaminho os

presentes autos para que se proceda à pesquisa/cotação de preços,
em atendimento ao artigo 8º da Resolução TRE nº 15.787/2017, de
15/02/2017.

 
Atenciosamente.
 

Documento assinado eletronicamente por ANDRÉA CRISTINA DE LIMA BELCHIOR,
Coordenador, em 29/03/2019, às 11:33, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0521551 e o código CRC 8CFF0A7B.

0008478-63.2018.6.02.8000 0521551v1
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E-mail - 0522495

Data de Envio: 
  01/04/2019 18:03:52

De: 
  TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-al.jus.br>

Para (com cópia oculta):
    alexandre.barros@g3solutions.com.br
    andre.brasileiro@suporteinformatica.com
    michel@pisontec.com
    guilherme@infiniit.com.br
    bsabino@swt.com.br
    max@plugnetshop.com.br
    pct@pctinformatica.com.br
    maxwell@usetech.net
    olivan@grupoinovva.com.br
    arnaldo.paula@altasnet.com.br

Assunto: 
  Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL

Mensagem: 
  Prezado Senhor(a),

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem fio e cabeada,
mediante sistema de registro de preços, distribuídos em lote 01 e lote 02, conforme descrição do
produto/serviço, quantitativos e demais especificações constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL
seic@tre-al.jus.br
anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL
CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/77

Anexos:
    Termo_de_Referencia___TIC_0450416.html
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E-mail - 0522526

Data de Envio: 
  01/04/2019 18:20:57

De: 
  TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-al.jus.br>

Para (com cópia oculta):
    gpereira@supriservice.com.br
    comercial@supriservice.com.br
    willian@telc.com.br
    comercial@telc.com.br
    anderson.marques@hpe.com
    teltec@teltecnetworks.com.br
    horidan@plugnetshop.com.br
    vendas@newsupri.com.br
    lofredo@hpe.com
    ronaldo_araujo@hp.com
    max@usetech.net
    plugnet@plugnetshop.com.br
    breno@plugnetshop.com.br
    tatiane.santos2@hpe.com
    junior@newsupri.com.br
    gustavo.pavanelli@gpsit.com.br
    roselene.franca@hp.com

Assunto: 
  Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL

Mensagem: 
  Prezado Senhor(a),

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem fio e cabeada,
mediante sistema de registro de preços, distribuídos em lote 01 e lote 02, conforme descrição do
produto/serviço, quantitativos e demais especificações constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL
seic@tre-al.jus.br
anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL
CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/77

Anexos:
    Termo_de_Referencia___TIC_0450416.html

E-mail SEIC 0522526         SEI 0008478-63.2018.6.02.8000 / pg. 96



De: Jose A Muniz JUNIOR - NEWSUPRI <junior@newsupri.com.br> 

Para:
TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-
al.jus.br>

Data: 01/04/2019 06:21 PM

Assunto:
[seic] Resposta automática: Solicitação. Cotação. Aquisição de
componentes de rede sem fio e cabeada. TREAL

Estamos em novas e modernas instalações no Recife. Os telefones são os mesmos.
Favor atualize nosso novo endereço no Recife
Av. Agamenon Magalhães, 4779 – 4º Andar – Empresarial Isaac Newton
Boa Vista – Cep 50070-160 – Recife – PE

WorldClient https://webmail.tre-al.gov.br:3001/WorldClient.dll?Session=R31YH...
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E-mail - 0523417

Data de Envio: 
  02/04/2019 18:41:46

De: 
  TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-al.jus.br>

Para (com cópia oculta):
    felipe.vieira@ish.com.br
    newtechdistribuidora@gamil.com
    contato@7secure.com.br
    contato@ntsec.com.br
    info@smartwavenetworks.com.br
    flavio@smartwavenetworks.com.br
    manzi@wintronic.com.br

Assunto: 
  Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL

Mensagem: 
  Prezado Senhor(a),

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem fio e cabeada,
mediante sistema de registro de preços, distribuídos em lote 01 e lote 02, conforme descrição do
produto/serviço, quantitativos e demais especificações constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL
seic@tre-al.jus.br
anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL
CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/77

Anexos:
    Termo_de_Referencia___TIC_0450416.html
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E-mail - 0523772

Data de Envio: 
  03/04/2019 14:10:29

De: 
  TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-al.jus.br>

Para (com cópia oculta):
    guilherme@newsupri.com.br

Assunto: 
  Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL

Mensagem: 
  Prezado Guilherme,

Boa tarde,

Conforme contato telefônico há pouco com a funcionária Elisângela, encaminho pedido de cotação abaixo:

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem fio e cabeada,
mediante sistema de registro de preços, distribuídos em lote 01 e lote 02, conforme descrição do
produto/serviço, quantitativos e demais especificações constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL
seic@tre-al.jus.br
anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL
CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/7711

Anexos:
    Termo_de_Referencia___TIC_0450416.html
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De:
Guilherme Agranemam - NEWSUPRI

<guilherme@newsupri.com.br> 

Para:
TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-
al.jus.br>

Data: 03/04/2019 02:12 PM

Assunto:
[seic] Resposta automática: Solicitação. Cotação. Aquisição de
componentes de rede sem fio e cabeada. TREAL

Estamos em novas e modernas instalações no Recife. Os telefones são os mesmos.
Favor atualize nosso novo endereço
Av. Agamenon Magalhães, 4779 – 4º Andar – Empresarial Isaac Newton
Boa Vista – Cep 50070-160 – Recife – PE
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E-mail - 0523865

Data de Envio: 
  03/04/2019 15:03:39

De: 
  TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-al.jus.br>

Para:
    comercialvix@ish.com.br

Assunto: 
  Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL

Mensagem: 
  Prezado Senhor(a),

Boa tarde,

Mediante contato telefônico há pouco com a Senhora Gorete, ao qual informou que o Senhor Felipe Vieira
encontra-se em férias, reencaminho pedido de cotação abaixo, conforme orientação:

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem fio e cabeada,
mediante sistema de registro de preços, distribuídos em lote 01 e lote 02, conforme descrição do
produto/serviço, quantitativos e demais especificações constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL
seic@tre-al.jus.br
anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL
CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/7711

Anexos:
    Termo_de_Referencia___TIC_0450416.html
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E-mail - 0524848

Data de Envio: 
  04/04/2019 17:25:47

De: 
  TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-al.jus.br>

Para:
    comercial.vix@ish.com.br

Assunto: 
  Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL

Mensagem: 
  Prezada Hana,

Boa tarde,

Conforme telefônico há pouco encaminho pedido de cotação abaixo:

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem fio e cabeada,
mediante sistema de registro de preços, distribuídos em lote 01 e lote 02, conforme descrição do
produto/serviço, quantitativos e demais especificações constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL
seic@tre-al.jus.br
anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL
CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/7711

Anexos:
    Termo_de_Referencia___TIC_0450416.html
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E-mail - 0524885

Data de Envio: 
  04/04/2019 17:44:44

De: 
  TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-al.jus.br>

Para (com cópia oculta):
    newtechdistribuidora@gmail.com

Assunto: 
  Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL

Mensagem: 
  Prezado Diego,

Boa tarde,

Conforme contato telefônico há pouco encaminho pedido de cotação abaixo:

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem fio e cabeada,
mediante sistema de registro de preços, distribuídos em lote 01 e lote 02, conforme descrição do
produto/serviço, quantitativos e demais especificações constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL
seic@tre-al.jus.br
anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL
CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/7711

Anexos:
    Termo_de_Referencia___TIC_0450416.html
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De: Cristino Hermano de Bulhões <cristinobulhoes@tre-al.jus.br> 

Para: Ana Paula Gomes Silva <anasilva@tre-al.jus.br>

Data: 08/04/2019 04:41 PM

Assunto:
Empresas Adicionais para Cotação - Processo SEI nº
0008478-63.2018.6.02.8000

Ana Paula,

  A título de colaboração quanto à obtenção de orçamentos de componentes
de networking, Procedimento SEI nº 0008478-63.2018.6.02.8000, seguem
empresas adicionais para contato:

Empresa: Solo Network
Site: www.solonetwork.com.br
E-mail: comercial@solonetwork.com.br

Empresa: Solus Tecnologia
Site: www.solustecnologia.com.br
E-mail: comercial@solustecnologia.com.br

Empresa: Ingram Micro
Site: www.ingrammicro.com
E-mail: glauber.cordeiro@ingrammicro.com

Atenciosamente,

--
Cristino Hermano de Bulhões
TRE-AL/STI/CIE
Seção de Gerência de Infraestrutura
Telefones Fixos: (82) 2122-7753/2122-7751
Telefone Móvel: (82) 99114-9951
E-mail: cristinobulhoes@tre-al.jus.br

WorldClient https://webmail.tre-al.gov.br:3001/WorldClient.dll?Session=L4V6W...
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E-mail - 0526142

Data de Envio: 
  08/04/2019 17:03:45

De: 
  TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-al.jus.br>

Para (com cópia oculta):
    comercial@solonetwork.com.br
    comercial@solustecnologia.com.br
    glauber.cordeiro@ingrammicro.com

Assunto: 
  Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL

Mensagem: 
  Prezado Senhor(a),

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem fio e cabeada,
mediante sistema de registro de preços, distribuídos em lote 01 e lote 02, conforme descrição do
produto/serviço, quantitativos e demais especificações constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL
seic@tre-al.jus.br
anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL
CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/7711

Anexos:
    Termo_de_Referencia___TIC_0450416.html
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E-mail - 0526384

Data de Envio: 
  09/04/2019 09:57:31

De: 
  TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-al.jus.br>

Para (com cópia oculta):
    isaac@smartwavenetworks.com.br

Assunto: 
  Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL

Mensagem: 
  Prezado Isaac,

Bom dia,

Conforme contato telefônico há pouco com a empresa, através do funcionário Edilson, encaminho pedido
de cotação abaixo:

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem fio e cabeada,
mediante sistema de registro de preços, distribuídos em lote 01 e lote 02, conforme descrição do
produto/serviço, quantitativos e demais especificações constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL
seic@tre-al.jus.br
anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL
CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/7711

Anexos:
    Termo_de_Referencia___TIC_0450416.html
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E-mail - 0526386

Data de Envio: 
  09/04/2019 10:05:33

De: 
  TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-al.jus.br>

Para (com cópia oculta):
    governo@solonetwork.com.br

Assunto: 
  Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL

Mensagem: 
  Prezado Senhor(a),

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem fio e cabeada,
mediante sistema de registro de preços, distribuídos em lote 01 e lote 02, conforme descrição do
produto/serviço, quantitativos e demais especificações constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL
seic@tre-al.jus.br
anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL
CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/7711

Anexos:
    Termo_de_Referencia___TIC_0450416.html
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E-mail - 0526393

Data de Envio: 
  09/04/2019 10:14:38

De: 
  TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-al.jus.br>

Para:
    gilson.santos@solustecnologia.com.br

Assunto: 
  Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL

Mensagem: 
  Prezado Gilson,

Bom dia,

Conforme contato telefônico há pouco com a empresa, através do funcionário Marcos, encaminho pedido
de cotação abaixo:

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem fio e cabeada,
mediante sistema de registro de preços, distribuídos em lote 01 e lote 02, conforme descrição do
produto/serviço, quantitativos e demais especificações constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL
seic@tre-al.jus.br
anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL
CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/7711

Anexos:
    Termo_de_Referencia___TIC_0450416.html
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De: Mary Machado <mary@7secure.com.br> 

Para: seic@tre-al.jus.br

Data: 09/04/2019 10:10 AM

Assunto:
[seic] Solicitação. Cotação. Aquisição de componentes de rede sem
fio e cabeada. TREAL

Bom dia Ana Paula,

Estamos fazendo a cotação,possivelmente até sexta-feira teremos uma resposta.

Atenciosamente,

---------- Forwarded message ---------
De: TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-al.jus.br>
Date: ter, 2 de abr de 2019 às 18:42
Subject: Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL
To:

Prezado Senhor(a),

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem fio e cabeada, mediante 
sistema de registro de preços, distribuídos em lote 01 e lote 02, conforme descrição do produto/serviço,
quantitativos e demais especificações constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL
seic@tre-al.jus.br
anasilva@tre-al.jus.br
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Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL
CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/77

[2] Arquivo:
Termo_de_Referencia___TIC_0450416.html

Tamanho:
370k

Tipo de Conteúdo:
text/html
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De: Isaac Santos <isaac@smartwavenetworks.com.br> 

Para:
TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-
al.jus.br>

Data: 09/04/2019 10:37 AM

Assunto:
[seic] Solicitação. Cotação. Aquisição de componentes de rede sem
fio e cabeada. TREAL

Olá Ana Paula, bom dia e muito obrigado por compartilhar a TR comigo.
Tivemos acesso à esse documento na semana passada e nossa equipe de engenharia já está analisando as
exigências. Devemos ter um feedback deles ainda hoje.
Caso estejamos atendendo o termo, enviaremos a proposta de imediato. Caso contrário, enviaremos antes da
proposta nossas sugestões de alteração para que em sendo aceita, possamos cotar de imediato.
Atenciosamente,

Isaac Santos
Executivo de vendas
Smartwave Networks
+55(79)9.9124-0547
(Respondido através do meu Android)

Em ter, 9 de abr de 2019 09:57, TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-
al.jus.br> escreveu:

Prezado Isaac,

Bom dia,

Conforme contato telefônico há pouco com a empresa, através do funcionário Edilson, encaminho pedido de
cotação abaixo:

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem fio e cabeada, mediante 
sistema de registro de preços, distribuídos em lote 01 e lote 02, conforme descrição do produto/serviço,
quantitativos e demais especificações constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL
seic@tre-al.jus.br
anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL
CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/7711
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De: "MANZI - WINTRONIC" <manzi@wintronic.com.br> 

Para:
'TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES'
<seic@tre-al.jus.br>, "'undisclosed-
recipients:'"@bartf0012.email.locaweb.com.br

Data: 09/04/2019 10:45 AM

Assunto:
[seic] RES: Solicitação. Cotação. Aquisição de componentes de
rede sem fio e cabeada. TREAL

Bom dia Ana Paula.

A Wintronic não presta serviços de projetos ou instalação de redes e
portanto não consegue atender a totalidade dos itens dos grupos no TR.

Agradeço o contato e me coloco à disposição sempre que necessitarem.

Atenciosamente,

Alberto Manzi Jr.

Rua Turiassu, 390 • 16º andar
Conj. 162 • Perdizes • CEP 05005-000
São Paulo/SP • Brasil
Tel: 11 3873-3530
Cel/Whats: 11 99979-0912
Skype: alberto.manzi.jr

www.wintronic.com.br

-----Mensagem original-----
De: TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES [mailto:seic@tre-al.jus.br]
Enviada em: terça-feira, 2 de abril de 2019 18:42
Para: undisclosed-recipients:
Assunto: Solicitação. Cotação. Aquisição de componentes de rede sem fio e
cabeada. TREAL

Prezado Senhor(a),

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de
rede sem fio e cabeada, mediante  sistema de registro de preços,
distribuídos em lote 01 e lote 02, conforme descrição do produto/serviço,
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quantitativos e demais especificações constantes do termo de referência em
anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL seic@tre-al.jus.br
anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira:
07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL CNPJ
nº: 06.015.041/0001-38
Telefones: 82 2122-7712/77
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De: "Isaac Santos - SWN NE" <isaac@smartwavenetworks.com.br> 

Para: "'Ana Paula Gomes Silva'" <anasilva@tre-al.jus.br>

Data: 09/04/2019 09:45 PM

Assunto:
RES: [seic] Solicitação. Cotação. Aquisição de componentes de
rede sem fio e cabeada. TREAL

Ana Paula, conforme planilha excel anexada (TRE_Alagoas_08042019_rev0.xlsx) de fato existem alguns itens que
impossibilita a nossa par cipação e pedimos a gen leza da equipe de TI/TREAL na análise das nossas sugestões...
Lembro que nossa demanda não é para diminuir a capacidade exigida mas sim manter o nível técnico visualizado e
exigido.

Conforme é possível visualizar nos datasheets, nossa pretensão é entrar com equipamentos “ponta de linha” da
Aerohive (veja mais em www.aerohive.com) e além das exigências do documento estaremos entregando
adicionalmente (mesmo sem a exigencia no TR) os seguintes itens:

Garan a dos equipamentos na modalidade ‘Limited Life me’ ofertado pelo próprio fabricante
Garante a subs tuição dos equipamentos em mais 5 anos após ser descon nuado, em caso de falha.

Entrega de access point com tecnologia ‘ax’ para atendimento a todas as exigencias do ‘access point po 2’
Entrega adicional de solução NAC em atendimento à demanda de auten cação de usuários

Ficamos no aguardo do entendimento dos senhores sobre nossos requisitos e prontos para enviar nosso
orçamento assim que recebermos as respostas.
Atenciosamente,

Isaac Santos
Execu vo de Vendas - NE  
Celular: +55 79 9.9124-0547 TIM e Whatsapp
Telefone:+55 11 2609-6985
E-mail: isaac@smartwavenetworks.com.br
SmartWave Networks

De: Ana Paula Gomes Silva <anasilva@tre-al.jus.br>
Enviada em: terça-feira, 9 de abril de 2019 10:42
Para: Isaac Santos <isaac@smartwavenetworks.com.br>
Assunto: Re: [seic] Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL

Bom dia Isaac,

Aguardamos. Muito obrigada.

Atenciosamente.
Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL
seic@tre-al.jus.br
anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL
CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/7711

From: Isaac Santos <isaac@smartwavenetworks.com.br>

WorldClient https://webmail.tre-al.gov.br:3001/WorldClient.dll?Session=V4FE1I...

1 de 3 10/04/2019 15:05
E-mail Sugestões. SmartWave Networks. (0527637)         SEI 0008478-63.2018.6.02.8000 / pg. 115



To: TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-al.jus.br>
Date: Tue, 9 Apr 2019 10:37:43 -0300
Subject: [seic] Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL

Olá Ana Paula, bom dia e muito obrigado por compartilhar a TR comigo.
Tivemos acesso à esse documento na semana passada e nossa equipe de engenharia já está analisando as
exigências. Devemos ter um feedback deles ainda hoje.
Caso estejamos atendendo o termo, enviaremos a proposta de imediato. Caso contrário, enviaremos antes da
proposta nossas sugestões de alteração para que em sendo aceita, possamos cotar de imediato.
Atenciosamente,

Isaac Santos
Executivo de vendas
Smartwave Networks
+55(79)9.9124-0547
(Respondido através do meu Android)

Em ter, 9 de abr de 2019 09:57, TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-
al.jus.br> escreveu:

Prezado Isaac,

Bom dia,

Conforme contato telefônico há pouco com a empresa, através do funcionário Edilson, encaminho pedido de
cotação abaixo:

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem fio e cabeada, mediante 
sistema de registro de preços, distribuídos em lote 01 e lote 02, conforme descrição do produto/serviço,
quantitativos e demais especificações constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL
seic@tre-al.jus.br
anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL
CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/7711

[2] Arquivo:
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Enterprise Access Network Management Offering Intuitive Configuration Workflows,
Real-Time & Historical Monitoring, and Simplified Troubleshooting

HiveManager™  Local Cloud
D ATA  S H E E T
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HiveManager Local Cloud
DATASHEET

HiveManager™ Local Cloud
HiveManager Local Cloud is a robust and flexible network management system, built from the ground up to take 
full advantage of the SD-LAN and SD-WAN solution from Aerohive. Working in tandem with Aerohive’s cut-
ting-edge HiveOS, HiveManager Local Cloud leverages state-of-the-art virtualization technology. Benefit from 
unified, full-stack management of Wi-Fi, switching and routing, centralized monitoring and configuration, re-
al-time and historical reporting, simplified troubleshooting, integrated RF planner tools and much more.

Summary

HiveManager Local Cloud is an on-premises version of HiveMa-
nager, typically deployed in the customer’s private network. Built 
on the latest virtualization technology (including an Elasticsearch 
architecture), this Local Cloud can effectively manage thousands 
of network-connected devices (APs, switches & routers) in a sin-
gle instance.

The on-premises flexibility of Local Cloud enables organizations to 
manage their entire access network, centrally, within the confines 
and supervision of a local premises. With an extensible architec-

ture that benefits from resource-driven scalability, this virtualized 
solution supports environments of all sizes with a platform built for 
the future, not just today.

The included suite of open APIs empowers developers to create 
3rd party applications, bespoke user experiences and provide in-
tegration with existing systems including device onboarding, infra-
structure management and more.

Key Features of HiveManager Local Cloud

Auto-Provisioning: With zero-touch deployment, automatically apply 
a configuration policy, upgrade software and more.

Dashboard: Intuitive, visual dashboard with contextual filters for a 
comprehensive overview of network assets, application and data usage 
as well as user activity.

Application Visibility and Control: Visibility and control of applica-
tion usage on the network, for professional and recreational applica-
tions and network services.

Monitoring: Real-time and historical view of devices, clients, alarms 
and events with automated out-of-band alerting.

Simplified Deployment: Guided workflows for creating and deploying 
network policies, with optional advanced configuration.

Guest Access: Flexible onboarding and management options for visitor 
and BYOD devices including intuitive Captive Web Portals and PPSK.

Network Health: Real-time and historical view of client and device 
health with built-in remediation tools.

Deployment Scalability: Centrally manage up to 5,000 network con-
nected devices including access points, switches, and routers.

Troubleshooting: Help-desk optimized interface to triage historical 
and real-time client problems with actionable data to reduce escala-
tions and provide a better end-user experience.

Full-stack Management: Single pane-of-glass management and visi-
bility of wired and wireless devices.

Multi-tenancy: Allows MSPs and large corporations to efficiently man-
age multiple customers or subsidiary accounts from one master account 
with VHM switching or Hierarchical Management (HHM).

IoT Management: Securely connect IoT devices with AES encryption 
using Aerohive’s unique Private Pre-Shared Key (PPSK).

Open APIs: A full suite of REST APIs for monitoring, identity, and 
configuration.

Anexo Aerohive_Datasheet_HiveManager_Local_Cloud (0527639)         SEI 0008478-63.2018.6.02.8000 / pg. 119



3

Distributed Control

HiveManager is a Network Management System (NMS). It lever-
ages Aerohive’s unique distributed control architecture (built into 
HiveOS) and eliminates the needs for centralized network control-
lers. The control and data planes operate at the edge. With this 
out-of-band control plane, no control or data plane information 
traverses HiveManager. 

As a result, network devices can operate even if communication to 
HiveManager is interrupted. This approach is essential to mission crit-
ical environments and helps maintain optimal network performance.

Features
HIVEMANAGER LOCAL CLOUD

Aerohive’s unique distributed control architecture.

Intuitive Interface
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Product Specifications

Simplified Deployment

• Guided workflow for network policy deployment

• On-screen step-by-step guided configuration

• RF planner with map import and export

• Ability to swap simulated APs with real Aerohive APs on RF planner map

• Devices automatically connect to HiveManager for provisioning

• Devices auto-provision with network policy and firmware updates

 

Centralized Configuration

• Guest Access functionality

• Device templates for switches, routers and APs

• Aerohive device as RADIUS server or RADIUS proxy, and as DHCP server

• Centralized view of all configuraiton objects

• Ability to bulk edit device properties

• Ability to schedule firmware upgrade

• Command Line Interface (CLI) access to Aerohive devices

• Support for select Dell N-Series switches

• Active directory/LDAP

• IPv6 support

• Syslog and SNMP server configuration

• Auto-provisioning

• Configuration audit, backup, restore, import and export

• Support for Aerohive VPN gateway (VG-VA)

• Multi-tenant capability: supports multiple virtual organizations 

 

Centralized Policy Management

•  Device classification by location & time zone

•  Customer application definition

•  Client classification by location, OS type, MAC address

•  Multiple user profiles for each SSID

•  Time-based firewall and QoS policy

•  Application, network and MAC layer firewall policy rules

•  WIPS policy for rogue AP detection and mitigation

Security and Privacy

• Role-based access control

• Customer and network data is private and secure

• No customer data traverses Aerohive’s network

• SSO for HiveManager administrators via SAML and RADIUS

• Optional multi-factor authentication with Google Authenticator for administrators

Security and Privacy (Continued)

•  EU General Data Protection Regulation (GDPR): HiveManager supports features that 

can assist customers in responding to obligations resulting from GDPR, including:

•  Search for, download and delete personal data for specific users

•  Creation of reports to document the above actions

Dashboard

• Graphical widgets and status cards with drill-down capabilities

• Time-range slider on dashboard for historical view

• 360° views of Aerohive network policies, AP, client devices, users and apps

• Global search function by network policy, MAC address, serial number, user, 

hostname or application name

• 30-days of historic monitoring and reporting data

• Interactive Network Summary Report with easy sharing

• Savable contextual filters by location, SSID, policy, user, profile and client OS type

Troubleshooting

•  Client 360° behavioral analysis; real-time and historical network performance 

monitoring and optimization

• Help-desk optimized interface with problem summary and suggested remedy

• Dedicated Helpdesk user role

• Real-time troubleshooting with probe messages and stage filters

• Historical troubleshooting with automatic issue detection

• Mark issue resolved or escalate issue with email notification

• Built-in Command Line Interface (CLI) and remote SSH

• RADIUS test

• AP technical data download

• VLAN probe tool for simplified troubleshooting of the wired network

• Optional packet capture analysis with partner solution (CloudShark)

 
Monitor

• WIPS history report

• Drill-down capability from client list to client 360° view

• Device list with rich utilities for advanced configuration and investigation

• Real-time client list with SNR, RSSI, data usage and connection status

• Savable and reusable filters shared across dashboard and monitor

• Alarm and event lists with historical and real-time data

• PCI DSS 3.2 compliant reporting

• Rogue AP and rogue client monitoring

• Real-time data for connection clients and users

• Google Maps integration and navigation with floorplan upload capability

HIVEMANAGER LOCAL CLOUD
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Product Specifications (Continued)

Guest Access

• Onboarding and management of visitor and employee personal devices (BYOD)

•  Provides multiple onboarding workflows via customizable Captive Web Portal

• Private PSK (PPSK), 802.1X (RADIUS) and PSK authentication

• Supports 3rd party and customized CWPs including HTML upload for added 

deployment flexibility

Supported Languages

• English, German, Spanish, French, Italian, Japanese, Korean, Portuguese, Chinese

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hardware Requirements per Host

For up to 500 devices:

•  CPU: Xeon E3-1220 v5, 3.0GHz, 8MB cache

• 1 physical CPU

• 4 cores, 4 threads

• 24GB RAM

• Storage: 250GB (local storage, SSD preferred, does not support SAN).

For up to 5000* devices:

• CPU: Xeon E5-2620 v4, 2.1GHz, 20MB cache

• 1 physical CPU

• 8 cores, 16 threads

• 32GB RAM

• Storage: 250GB (local storage, SSD preferred, does not support SAN). 

 

* HiveManager Local Cloud supports up to 5,000 network devices, based on 

available hardware resources. HiveManager Local Cloud can be deployed on 

industry-standard hardware with sufficient compute and storage capacity. The 

above specifications are meant only as a guide.

•  HiveManager Local Cloud is available as an OVA file.

•  Please contact your Aerohive sales representative for guidance on hardware and 

software specifications.

HIVEMANAGER LOCAL CLOUD
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SKUs

SKU DESCRIPTION

AH-HMNG-SVA HiveManager Local Cloud (single instance) delivered via download.

AH-NGCS-SL-1YR/3YR/5YR HiveManager software subscription for 1 network device for 1, 3 or 5 years.

HiveManager Local Cloud - SKUs

HIVEMANAGER LOCAL CLOUD
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Security and Control for all Devices on the Access Network
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Key Features & Bene�ts

Supports all devices and users on the access network  
A3 secures standard wireless and wired corporate clients, BYOD, 
IoT and guest devices alike. It also supports the creation and 
administration of granular network access rights (e.g., by access 
to applications, time of day, location on the network) depending 
on the user’s role. 

Complete onboarding for guest and corporate devices
A3 includes a highly customizable captive web portal (CWP) that 
supports self-service onboarding for visitor devices, while a compre-
hensive management interface and automated device provisioning 
of 802.1X certi�cates enables onboarding of corporate devices.

Comprehensive authentication toolset
For authentication of corporate devices, A3 supports 802.1X 
certi�cates with its built-in RADIUS server. Where certi�cates 
are not practical, A3 provides alternative authentication methods 
like Private Shared Keys (PSK) or Social Login (e.g., for Guest 
authentication).

 
Network Access Control (NAC)
A3 provides complete functionality for Network Access Control 
that ensures authorized devices stay secure over time. Features 
include device scanning for security compliance, quarantining of 
non-compliant devices to prevent network access, and guided 
self-remediation to reduce IT helpdesk calls. 

Security for the Internet of Things (IoT)
Connected devices like thermostats and lighting systems in the IoT 
context present a unique set of challenges for IT security. A3 is 
equipped to onboard, secure and control “Things”, with the ability to 
automatically identify IOT, and then onboard them with appropriately 
de�ned network access rights.

Seamless integration with existing IT security infrastructure
Customers can directly integrate A3 with the market leading 
�rewalls, MDM and endpoint security systems, Intrusion Detec-

A3 provides a complete set of functionalities for device onboarding, guest management, automated device provisioning, device pro�ling 
and network access control. With its streamlined work�ows and intuitive user interface, A3 greatly reduces the operational complexity 
and cost typically associated with incumbent offerings. It can be deployed on all major vendors’ access networks. 

Aerohive A3 is an innovative solution for securing, managing and controlling all devices on your Access 
Network – from standard wireless and wired clients to IoT and BYOD.

Aerohive® A3™
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tion Systems (IDS) and Posture Assessment solutions they 
already have installed and continue to leverage their existing 
security investment.

 
Unparalleled deployment �exibility 
A3 supports on-premises deployments, based on a Virtual Appli-
ance (VA), with a choice of standard or clustered High-Availability 
con�gurations. A3 can be managed locally on-premises, or central-
ly from the cloud. The cloud management option for A3 leverages 
Aerohive's 3rd generation cloud platform that provides customers 
high performance and scalability for their A3 deployments.
 

Device �ngerprinting and pro�ling
A3 includes the largest available device �ngerprint database, that is 
constantly updated. Device �ngerprinting is the most comprehen-
sive method for identifying a device type (e.g. laptop vs. smart-
phone vs. HVAC sensor) automatically when a device requests 
network access. A3 then leverages this information to grant appro-
priate network access rights to each device based on its category. 
This includes IoT, which are otherwise very hard to identify and 
secure effectively, much less in an automated fashion.

Supports access networks from all leading vendors
Access networks typically include wired and wireless infrastruc-
ture components from multiple vendors. A3 supports WLAN equip-
ment and switches from Aerohive and other leading vendors, 
which provides customers added deployment functionality. 

Simpli�ed work�ows that reduce complexity
A3 was developed as one integrated product from the ground up. An 
intuitive UI guides users through the con�guration process, which 
results in a much more intuitive and simpli�ed work�ows compared 
to traditional solutions. The platform setup (new Virtual Appliances 
and clusters) is entirely UI based and takes only 5-8 minutes once 
basic con�guration information is entered. It completely removes 
the need for tedious, error-prone CLI con�guration. 
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AEROHIVE A3

Product Screenshots
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Intuitive graphical dashboard

Services overview and administration

Con�guration of external authentication sources

Extensive reporting capabilities
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AEROHIVE A3

Product Speci�cations

• Role-based Access Control (RBAC)
• Per User
• Per Switch
• Per VLAN
• Per Client
• Per Client Category
• Per Device Type
• Per Time
• Per Location

• Object based con�guration management 
• De�ne roles, domains, authentication sources, switches and WLANs,

and connection pro�les easily 

• Automated checkup and �x permissions tasks 

• Accounting based on several criteria 
• Node, switch groups, user, role, OS, source, realm, SSID, pro�le and domain
• Violations, failures, successes, registration type and state

• Customizable Captive Web Portal (CWP)

• Wireless ISP Roaming (WISPR), Eduroam and Hotspot 2.0

• Supports billable hotspots
• Billing and service tiers 
• Payment processing through Paypal, Mirapay, Authorize.net, Stripe

• Guest Access Self Registration
• With or without credentials
• Self- registration with Social login

• User device registration

• Employee sponsorship

• Email Validation

• SMS Validation

• Password-of-the-day

• “Device pro�le” or “device �ngerprint” based onboarding

• Aerohive Private Pre-Shared Key (2019)

• EAP Protocols
• EAP-FAST, PEAP, EAP-TTLS, EAP-TLS, PAP, CHAP, MSCHAPv1 and 2, EAP-MD5 

• 802.1X Support
• RADIUS to AD/LDAP server support for 802.1X authentication
• 802.1X (PEAP) or Certi�cate (TLS) BYOD automated onboarding
• User Authentication Portal (AD/LDAP)
• PKI with EAP EAP-TLS, EAP-TTLS, EAP-LEAP, EAP-PEAPv0,

EAP-PEAPv1, EAP-MSCHAPv2

• Authentication Types
• LDAP

• Microsoft Active Directory
• Novell eDirectory
• OpenLDAP
• Any LDAP-compliant servers

• RADIUS
• Cisco ACS
• RADIUS (FreeRADIUS, Radiator, etc.)
• Microsoft NPS
• Any RADIUS-compliant servers

• Local user �le (Apache htpasswd format)
• OAuth2

• Facebook
• Google
• GitHub
• LinkedIn
• Microsoft Live
• Twitter

• SAML
• Additional built-in SQL DB for User store for deployments without LDAP
• Aerohive Private Pre-Shared Key (2019)

• Provisioning agents
• Android
• Windows
• API for all Apple devices

Management Features

Guest, BYOD and IoT Management

Authentication

Secure Provisioning

4

Anexo Aerohive_Datasheet_A3 (0527640)         SEI 0008478-63.2018.6.02.8000 / pg. 127



AEROHIVE A3

Product Speci�cations

• Realtime security policy assessment (posture assessment) & noti�cation
for multiple OS

• Gradual Deployment
• Pre-registration
• Per location/switch/port deployments

• Automated Device Registration
• By network device
• By device �ngerprinting
• By MAC address vendor
• Integrates with 3rd party solutions to extend device registration capabilities

• Snort, Nessus, OpenVAS, Browser User-Agent and more
• VLAN isolation and quarantining (See supported switches below)

• Net�ow / IPFIX

• Bandwidth accounting

• Floating device support
• Switches and APs

• Functionality
• Pro�ling of devices/ IoT device recognition
• Group based policies for network devices
• Device visibility and identi�cation

• Device Fingerprinting
• World’s largest device �ngerprinting database 
• DHCP v4 & v6
• User Agent
• MAC address Patterns
• OUI
• TCP �ngerprints
• Behavioral analysis

A3 supports direct integration with these 3rd party IT security solutions: 

• Intrusion Detection (IDS): 
• OPSWAT Meta defender
• Snort
• Suricata
• Fortigate
• TrendMicro
 

• Vulnerability / Posture Assessment
• Nessus
• OpenVAS
• Windows Management Interface
• TNC Statement of Health protocol

• Endpoint Security
• OPSWAT Meta defender Agent
• Symantec SEPM
• Sentinel One

• Mobile Device Management (MDM)
• Mobile Iron
• JAMF
• AirWatch (Q1 2019)
• IBM MAAS 360 (Q1 2019)
• Microsoft inTune (Q1 2019)

• Firewalls
• Barracuda
• Checkpoint
• Cisco
• Fortinet
• Fortigate
• iBoss
• Juniper (Q1 2019)
• PaloAlto Networks
• Watchguard
• Sonicwall (Q1 2019)

• Microsoft PKI
• Simple Certi�cate Exchange Protocol (SCEP)
• Network Device Enrollment Service (NDES)

Network Access Control

Pro�ling

Integration Capability with Complementary Security Infrastructure

5
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AEROHIVE A3

Product Speci�cations

• Simpli�ed Deployment
• Out of band deployment
• Hybrid out of band

• High Availability
• Active/Active Clustering
• Supports deployments of millions of devices

• Supported deployment models:
• Virtual Appliance (VA) 
• Cloud-based management (monitoring Q3 2018, con�guration Q1 2019)
 

• Supports WLAN Infrastructure from the following vendors:
Aerohive, Aruba Networks, AnyFi, Avaya, BelAir, Brocade, Cisco, D-Link, Dell, 
Extreme Networks, Enterasys, Extracom, Hewlett-Packard, Huawei, Juniper, 
Meraki, Meru Networks, MicroTik, Mojo Networks, Motorola/Zebra, Ruckus 
Wireless, and Xirrus Networks

• Supports network switches from all leading vendors:
Aerohive, Alcatel-Lucent, Avaya, Brocade, Cisco, Dell, D-Link, HP, Huawei, 
Juniper, Linksys, Ubiquiti, and more

• VoIP support, also in heterogenous environments, for multiple switch vendors 
Avaya, Cisco, HP and more

Deployment Flexibility Hardware Requirements

• Virtual Appliance Support
• Deployed as VA
• VMWare ESXi 4.0 and above

• Minimum System requirements
• Intel or AMD CPU 3 GHz or better
• 16 GB of RAM or more
• 100 GB of disk space (RAID-1 recommended)
• 1 network card (2 recommended)

• High Performance Active Clustering
• Minimum recommended cluster is 3 hosts for HA, load balancing and failover
• Signi�cantly increases capacity and throughput
• Enables sharing of device licenses across different customer sites.

• Contact your Aerohive partner or representative for con�guration assistance

Professional Services

• Optional professional services are available through A3 Authorized Aerohive partners.

6
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Software license for A3 Virtual Appliance (VA). Required with A3 subscription.AH-A3-VA

High Availability software license for 2 additional VA for cluster con�guration; optional for all deployments.AH-A3-HA

AEROHIVE A3 - SKUs

SKU DESCRIPTION

1/3/5 Year subscription for up to 1,000 concurrent clients/endpoints. Includes support.AH-A3-1K-SL-1Y/3Y/5Y

1/3/5 Year subscription for up to 5,000 concurrent clients/endpoints. Includes support.AH-A3-5K-SL-1Y/3Y/5Y

1/3/5 Year subscription for up to 10,000 concurrent clients/endpoints. Includes support.AH-A3-10K-SL-1Y/3Y/5Y

1/3/5 Year subscription for up to 25,000 concurrent clients/endpoints. Includes support.AH-A3-25K-SL-1Y/3Y/5Y

1/3/5 Year subscription for up to 50,000 concurrent clients/endpoints. Includes support.AH-A3-50K-SL-1Y/3Y/5Y

1/3/5 Year subscription for up to 75,000 concurrent clients/endpoints. Includes support.AH-A3-75K-SL-1Y/3Y/5Y

1/3/5 Year subscription for 100,000 (and more) concurrent clients/endpoints. Includes support.AH-A3-100K-SL-1Y/3Y/5Y

©2018 Aerohive Networks. All Rights Reserved. 7

AEROHIVE A3

Product SKUs
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Aerohive's Secure, Adaptable, Software-De�ned 
LAN & WAN Network Operating System

HiveOS®
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Key Features

Software-De�ned Radios (SDR) & Machine Learning
Software-De�ned Radios (SDR) utilize machine learning algorithms to 
evaluate current and historical RF conditions and reduce radio 
contention by automatically disabling redundant 2.4GHz radios, or, on 
some APs, reprogramming the radios to operate in Dual 5GHz mode. 
This process dynamically optimizes network con�guration over time to 
deliver optimal performance and increased network capacity in 
ever-changing environments.

Application Visibility and Control (AVC)
Full context-based visibility and control of over 1200+ layer 7 applica-
tions, including the option to de�ne custom applications and network 
services. By using the granular controls built into HiveOS, administra-
tors can identify and prioritize applications important to speci�c users 
without having to create additional SSIDs or affect the entire network.

Increase Network Capacity with Airtime Management
Aerohive’s Dynamic Airtime Scheduling enables faster clients, like 
802.11ac devices, to get equal access to the airtime rather than allowing 
it to be monopolized by legacy or slow clients. In addition, Dynamic 
Airtime Scheduling can also track retries and manage upstream traf�c 
to protect the network from misbehaving clients or users. Overall, 
Dynamic Airtime Scheduling can increase network capacity by up to 
10x, by preventing slow or legacy clients dominating airtime.

Zero-Wait DFS
Dynamic Frequency Selection (DFS) is a mechanism that enables 
devices to coexist on the same 5GHz frequency space used by radar 
systems. Unfortunately, if an AP detects radar, it must vacate that 
channel immediately and scan an adjacent channel for radar. This 
scanning process can take several minutes to complete. Once the AP 
classi�es the new channel as available, only then will it switch over.  
Zero-Wait DFS speeds up the scanning process. The result – more 
ef�cient use of the 5GHz spectrum with minimum interruption and 
downtime, even when using DFS channels. 

Aerohive HiveOS is the network operating system that powers all Aerohive access points, based on a feature-rich Cooperative Control 
architecture. HiveOS enables Aerohive devices to organize into groups, or “hives”, which allows functionality like fast roaming, 
user-based access control and fully stateful application-aware �rewall policies, as well as additional security and RF networking 
features - all without the need for a centralized or dedicated controller. Cooperative Control and HiveOS leads the industry with 
reduced deployment and ownership costs while delivering higher performance, reliability and scalability than competing architectures.

HiveOS delivers reliable, high-performance Wi-Fi with integrated SLA governance, application-aware 
enterprise �rewall security, device management, containerization, granular QoS control, advanced spectrum 
intelligence, machine learning capabilities and much more.

HiveOS®
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SLA Compliance Monitoring and Response
The SLA compliance solution brings determinism and visibility to the 
wireless network by enabling IT administrators to establish, monitor, 
and deliver a reliable service to client devices. The SLA feature not only 
provides the ability to set a performance threshold for connected 
clients but includes auto-remediation capabilities to re-allocate airtime 
to clients that do not meet the established SLA.

Private Pre-Shared Key (PPSK)
Aerohive's 'Private' PSK technology provides easy on-boarding and 
unique network identity to devices, without security or complexity 
concerns. Due to compatibility issues with 802.1X, PPSK enables 
stronger security for IoT and Guests. Easily revoke access for a single 
device or individual, without affecting other users. Prevent key re-use 
with simultaneous connection limits and MAC-address binding. 
Thousands of keys can easily be managed and distributed via the cloud, 
mobile applications and self-registration.

Private Client Groups (PCG)
PPSK is further enhanced by Private Client Groups (PCG) which enable 
administrators to manage and control network services through 
virtualized containerization based on micro-location. Create mini-pri-
vate networks for each and every user based on their PPSK – perfect 
for hospitality and student accommodation.

Built-in Spectrum Analysis and Intelligence
Spectrum Analysis is a critical tool for detecting interference from 
non-Wi-Fi radio devices such as Bluetooth, microwave ovens and 
cordless phones. Aerohive includes Spectrum Analysis with advanced 
signature detection in many of our access points, with no additional 
hardware or licenses required. HiveOS uses spectrum analysis 
information to feed the Aerohive Channel Selection Protocol (ACSP) and 
boosts performance by avoiding interference from non-802.11 devices.
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SD-LAN Cooperative Control Protocols

Aerohive Channel Selection Protocol (ACSP)
Responsible for Radio Resource Management (RRM) with dynamic 
channel and power adjustment based on RF conditions. 
ACSP minimizes co-channel and adjacent channel interference to 
provide optimized performance. 

Aerohive Mobility Routing Protocol (AMRP)
Automatic neighbor discovery, negotiation of client state information 
between APs and dynamic backhaul-mesh in the event of a failure. AMRP 
enables fast/secure roaming while maintaining client session state.

Dynamic Network Extension Protocol (DNXP)
Dynamically establishes tunnels between APs in different subnets 
in order to provide seamless L3 roaming.

Identity-Based Network Extension Protocol (INXP)
Provides the ability to de�ne a static tunnel which can be used 
to pass client traf�c, based on identity. Typically used for 
guest-to-DMZ isolation.

Aerohive Network Extension Protocol (ANXP)
Responsible for Private Client Group (PCG) client tunneling between 
neighbor APs and an anchor AP. This enables a user retain access to 
their PCG network while roaming. 

Product Speci�cation

(The following speci�cation is based on current capabilities of HiveOS 8.2r1)

 Cooperative Control & RF Management
• Cooperative fast L2/L3 roaming
• Cooperative channel selection, with DFS support
• RRM achieved using ACSP
• Dynamic tunnel load balancing for L3 roaming
• Real-time display and analysis of received RF signals with signature-based 

detection of non-Wi-Fi devices
• Wireless client load balancing
• Wireless client band steering
• Transmit Beamforming (implicit and explicit) *
• MU-MIMO* 
• Cooperative transmit power level control
• 802.11h/Transmit Power Control (TPC) *
• Zero-Wait DFS support to dramatically reduce DFS scanning process time *
• Support for Software De�ned Radios (SDR) with dynamic learning & selection 

algorithm - Automatically or manually enable Dual 5GHz to increase 
performance & capacity *

SLA Compliance
• Client and AP Health – Monitor connection quality plus reporting and 

auto-remediation 
• Airtime Boost – Automatically increase airtime allocation to suitable clients to 

boost performance
• Load balancing – Direct clients to APs for improved connection quality and 

resource distribution

QoS, Voice & Roaming
• QoS for Voice, Video and Data at the Radio
• Stateful VoIP roaming and failover
• User pro�le-based queuing, scheduling and policing
• Application prioritization and control for over 1200+ layer 7 applications 

including custom applications
• QoS assignment per VLAN, user pro�le, service and MAC address
• Protocol decoding and dynamic port detection for SIP calls
• Full queuing support with 8 queues – strict and weighted round robin queuing 

mechanisms

QoS, Voice & Roaming (Continued)
• Per VLAN, per user pro�le, per user, per service rate limiting
• VoIP call admission control (CAC) with 802.11e traf�c speci�cation (TSPEC)
• 802.11r fast roaming support with 802.11k radio measurement and 802.11v 

roaming management
• Marking and Policing - WWM® (802.11e) for wireless, 802.1p and/or DiffServ
• Wi-Fi CERTIFIED™ WMM®
• Support for Spectralink SVP protocol
• Support for Lync, Skype and Skype for Business
• Hotspot 2.0 and PassPoint® Wi-Fi CERTIFIED™ *
• Voice Enterprise Wi-Fi CERTIFIED™ *

High Availability
• Full client session synchronization across APs
• AAA caching of credentials for remote of�ce survivability
• Dynamic mesh failover automatically changes access radio to backhaul radio 

in the event of a wire or switch failure
• Wireless virtual access console – troubleshoot the AP locally without 

physically connecting
• Track IP or Gateway automatically initiates failover or troubleshooting tools in 

the event of a failure

Mesh
• Flexible radio con�guration allows for simultaneous operation of mesh 

networking and client access 
• Ethernet bridging support across mesh connections for single device or 

workgroup
• Automatic neighbor detection and route determination
• Mesh traf�c encrypted with AES
• L2 routing rather than Spanning Tree used for greater performance and less 

overhead
• Self-healing enabled by dynamic path selection

Security
• Trusted Platform Module (TPM) – Hardware-based key storage and encryption
• Wireless privacy and authentication Wi-Fi CERTIFIED™ WPA/WPA2 Personal 

and Enterprise, 802.11i, 802.1X, PSK
• Private Client Groups (PCG) enable the creation of ‘private’ networks using 

PPSK micro-location and micro-segmentation

3* Available on select access points
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Product Speci�cation (Continued)

Security (Continued)
• Granular user pro�le-based management de�nes VLANs, QoS, mobility policies 

and security policies for each network user
• Dynamic pro�le assignment based on device attributes
• Encryption: AES-CCMP, TKIP and RC4 (WEP only)
• Time-of-day and day-of-week access control and SSID enablement
• On-board application-aware deep packet inspection (DPI) �rewall policy 

enforcement with session state sync with neighbors
• ALG support for SIP, DNS, TFTP and FTP
• Destination-based MAC �rewall support
• Up to 16 SSIDs per radio for network segmentation
• Tunneled guest networks for DMZ isolation
• Hive-wide client isolation
• WPA-TKIP vulnerability protection
• 802.11w management frame protection

Authentication
• 802.1X authentication for WPA and WPA2
• Private PSK (PPSK) authentication allows for unique pre-shared keys (PSK) for 

each user within a single SSID
• Up to 9999 local PPSKs per AP for AP230, AP250, AP245X, AP550, AP1130
• Up to 4096 local PPSKs per AP for AP122, AP122X, AP130, AP150W
• Self-registration portal for dynamic PPSK creation and assignment
• RADIUS client support with PEAP, EAP-TLS, TTLS, LEAP and EAP-FAST
• LDAP authentication to directory servers, including OpenLDAP, Novell 

eDirectory and Apple OpenDirectory
• Authentication to Microsoft® Active Directory™ with local credential caching. 

Also supports Global Catalog and multiple forests
• Multiple RADIUS server support (per AP SSID)
• RADIUS server with local database or proxy
• Standard Interchange Protocol, version 2 (SIP2) support for validation of users 

against a Library Information System (LIS)
• Support for Operator-Name RADIUS attribute
• MAC-based RADIUS authentication
• Dynamic Change of Authorization 
• (RFC3576)
• User pro�le assignment based on any RADIUS attribute
• Up to 255 associated clients per radio for: AP130, AP230, AP245X, AP250, 

AP550, AP1130
• Up to 100 associated clients per radio for: AP122, AP122X, AP150W

Wireless VPN
• Remote of�ce IPsec-based VPN solution
• Pro�le-based split tunneling with NAT support
• Supported across mesh
• RADIUS, DHCP, NTLM, LDAP and NTP can selectivity go to local or remote network
• Up to 127 GRE tunnels per AP
• Up to 128 L2 IPsec tunnels per AP (acting as L2 VPN server)
• Up to 1024 L2/L3 IPsec tunnels for VGVA

Captive Web Portal
• Built-in customizable captive web portal on APs
• Automatic multi-language support based on browser
• External captive web portal support, including Social Login, RADIUS authentica-

tion and walled garden con�guration allows for easy integration with 3rd party
• Microsoft® Active Directory™ authentication

Wireless IDS & IPS
• Built-in in-network rogue AP detection & mitigation
• Rogue client detection including ad-hoc clients
• Wireless compliance checking
• Sophisticated L2/L3 DoS protection with a wide range of L2/L3 attack signatures
• Port scan, IP spoo�ng and IP address sweep protection provides added 

security, particularly for quarantine and guest networks
• Wide array of security actions including logging, blocking, disassociation and 

banning to enable the network to automatically respond to threats

Management
• Centralized management via HiveManager
• Device Con�guration via CLI - Telnet, SSHv2 or console
• Virtual Console automatically sets up an SSID with CLI access allowing 

con�guration of new APs
• Monitoring via SNMP (v1, v2c, v3) and syslog

Location and Asset Tracking
• Built-in location tracking with topology and heat maps
• Partnership with AeroScout to act as sensor
• Partnership with Ekahau for location and asset tracking
• Integrated iBeacon con�guration

Services
• DHCP server and DHCP relay
• Client operating system detection by DHCP and HTTP User-Agent for 

policy assignment
• AP as a RADIUS server – up to 4 can be con�gured for redundancy. Optional 

RADIUS proxy for large deployments

IPv6-Ready
• Host-mode support for IPv6
• Interface IP address assignment via static con�guration �le entries or via 
SLAAC (RFC2462)
• DHCPv6 client for service auto con�guration (RFC3315) 
• DNS name resolution
• Multicast to unicast conversion
• IPv6 client address snooping and displaying
• Router Advertisement Guard
• DHCPv6 Shield
• RADIUS client for IPv6
• Support for Bonjour for IPv6 enabled clients
• Application Visibility and Control (AVC) (L7 inspection of IPv6 traf�c)
• QoS for IPv6 enabled clients
• Firewall policies for IPv6 traf�c
• Support for IPv6 devices to perform management functions through CLI or 

HiveManager
• Support for IPv6 versions of Ping, SSH, TFTP commands

©2018 Aerohive Networks. All Rights Reserved.
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802.11ac Dual-Radio 2x2:2 Access Point with Internal Antennas;
Designed for Density Environments
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With more users, more devices, more things, more applications, and 
strained infrastructure and budget, the AP130 is a powerful option to 
meet those challenges. AP130 combines powerful 802.11ac Wi-Fi tech-
nology, advanced security and device lifecycle management together into 
a cost-optimized solution that allows you to deploy high speed Wi-Fi into 
every office or classroom. 

The AP130 benefits from an AI-driven Wi-Fi architecture capable of 
self-organizing, self-learning, self-healing and self-optimizing in the most 
challenging environments. Cooperative Control eliminates single points of 
failure and bottlenecks, delivering bulletproof stability and unbridled per-
formance, perfectly complimenting the unrivalled capabilities of HiveOS 
- a stateful L2-L7 DPI firewall for context-based access security, advanced 
and customizable QoS for traffic optimization, intelligent meshing algo-
rithms, Private Pre-Shared Key (PPSK) and much more.

All Aerohive APs can be centrally managed using Aerohive’s out-of-band 
cloud network management system - HiveManager. HiveManager is an 
industry-leading and visionary approach to cloud-managed networking, 
built from the ground up to take full advantage of the SD-LAN and SD-
WAN solution from Aerohive. Working in tandem with Aerohive’s cut-
ting-edge HiveOS, HiveManager leverages state-of-the-art cloud technol-
ogy. Benefit from unified, full-stack management of Wi-Fi, switching and 
routing, centralized monitoring and configuration, real-time and historical 
reporting, simplified troubleshooting, integrated RF planner tools and 
much more.

HiveManager is available in two editions: Connect and Select. The Con-
nect solution is bundled with Aerohive access points and switches and 
is free for the lifetime of the device. Connect is the perfect solution for 
those looking to provide robust, yet enterprise-grade connectivity, without 
having to invest in the full suite of management features. The optional 
upgrade to Select unlocks a slew of advanced features and capabilities 
that enhance network management, security and visibility.

The AP130 provides high-performance aggregate data rates up to 1167Mbps in the 5 GHz band. It supports dual 
concurrent 2.4 GHz 802.11b/g/n and 5 GHz 802.11a/n/ac radios. Designed for high density environments, AP130 
is powerful enough to provide all the services needed for an enterprise network, and cost-effective enough to 
deploy for capacity networks. 
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Product Specifications
AEROHIVE AP130

Power Options

• Power Draw: Typical 9.05W, Max 11W

• 802.3af Power over Ethernet (PoE) capable

   Gigabit Ethernet port (RJ-45 power input pins:

   Wires 4,5,7,8 or 1,2,3,6)

• 802.3af Power over Ethernet injector

Physical

• LxWxH 147X147X42 mm (5.79x5.79x1.65in). (w/o mounting brackets)

• .51kg (1.13 lbs) (w/o mounting brackets)

Antennas

• 2x Integrated single band, 2.4-2.5 GHz 

   omnidirectional antennas

• 2x Integrated single band, 5.1-5.8 GHz 

   omnidirectional antennas

Mounting

• Desktop

• Wall Mount included as part of AP

• Built-in slot for Kensington type locks

• Ceiling Tile Recessed 15/16”, 3/8”, 9/16” sold as an accessory

• Ceiling Tile flush 3/8”, 9/16” sold as an accessory

• Suspend Mount sold as an accessory

• Plenum Mount sold as an accessory

• TPM chip for added security

Environmental

• Operating: 0 to 40 °C, Storage: -40 to 70 °C

• Humidity: 95%

Environmental Compliance

• UL2043

Radio Specifications

802.11a

• 5.150–5.850 GHz Operating Frequency

• Orthogonal Frequency Division Multiplexing (OFDM) Modulation

• Rates (Mbps): 54, 48, 36, 24, 18, 12, 9, 6 w/ auto fallback

802.11b

• 2.4–2.5 GHz Operating Frequency

• Direct-Sequence Spread-Spectrum (DSSS) Modulation

• Rates (Mbps): 11, 5.5, 2, 1 w/ auto fallback

802.11g

• 2.4–2.5 GHz Operating Frequency

• Orthogonal Frequency Division Multiplexing (OFDM) Modulation

• Rates (Mbps): 54, 48, 36, 24, 18, 12, 9, 6 w/ auto fallback

802.11n

• 2.4–2.5 GHz & 5.150–5.850 GHz Operating Frequency

• 802.11n Modulation

• Rates (Mbps): MCS0 - MCS15 (6.5MBps - 300Mbps)

• 2x2 Multiple-In, Multiple-Out (MIMO) Radio

• HT20 High-Throughput (HT) Support (for both 2.4 GHz and 5 GHz)

•  HT40 High-Throughput (HT) Support for 5 GHz

• A-MPDU and A-MSDU Frame Aggregation

802.11ac

• 5.150–5.850 GHz Operating Frequency

• 802.11ac Modulation (256-QAM)

• Rates (Mbps): MCS0–MCS9 (6.5Mbps – 867Mbps), NSS = 1-2.

• 2x2:2 Stream Multiple-In, Multiple-Out (MIMO) Radio

• VHT20/VHT40/VHT80 support

• TxBF ( Transmit Beamforming)

 
Interfaces

• Autosensing 10/100/1000 BASE-T Ethernet PoE

   (Power over Ethernet 802.3af) Port

Power Specifications

• IEEE 802.3af PoE Power
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Power and Sensitivity Tables
AEROHIVE AP130

Power - 2.4 GHz

Power - 5 GHz

Receive Sensitivity - 2.4 GHz

Receive Sensitivity - 5 GHz

CHANNEL DATA RATE SENSITIVITY

11b 1 - 11 Mbps -99, -91

11g
6 Mbps -95

54 Mbps -77

11n HT20
MCS0 - 12 -94, -81

MCS7, 15 -74

CHANNEL DATA RATE SENSITIVITY

11a
6 Mbps -94

54 Mbps -77

11n HT20
MCS0 - 12 -93, -81

MCS 7, 15 -73

11n HT40
MCS0, 8 -93, -90

MCS7, 15 -74, -71

11ac VHT20
MCS0 -93

MCS8 -69

11ac VHT40
MCS0 -90

MCS9 -64

11ac VHT80
MCS0 -87

MCS9 -61

CHANNEL DATA RATE POWER (DBM)

11b 1 - 11 Mbps 21

11g
6 Mbps 19

54 Mbps 16

11n HT20
MCS0 - 12 20

MCS7, 15 16

CHANNEL DATA RATE POWER (DBM)

11a
6 Mbps 19

54 Mbps 16

11n HT20
MCS0 - 12 19

MCS 7, 15 16

11n HT40
MCS0, 8 19

MCS7, 15 14

11ac VHT20
MCS0 19

MCS8 13

11ac VHT40
MCS0 19

MCS9 12

11ac VHT80
MCS0 19

MCS9 12
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Radiation Patterns – Azimuth & Elevation
AEROHIVE AP130

Azimuth - 2.4 GHz

Azimuth - 5 GHz

Elevation - 2.4 GHz

Elevation - 5 GHz
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SKUs
AEROHIVE AP130

AP130- SKUs

SKU DESCRIPTION

AH-AP-130-AC-XX AP130, indoor plenum rated, 2 radio 2x2:2 802.11a/b/g/n/ac, 1 10/100/1000 Ethernet port,  without power supply (Internal Antenna only). Includes HiveManager 
Connect & HiveCare Community. (Regulatory Domains available: FCC, CE, W (World))

AP130 - MISCELLANEOUS SKUs

©2018 Aerohive Networks. All Rights Reserved.

SKU DESCRIPTION

AH-ACC-INJ-30W-UK 30W PoE power injector with UK power cord for AP122,AP122X,AP130, AP200 series,AP550,AP630,AP650 and AP650X

AH-ACC-INJ-30W-US 30W PoE power injector with US power cord for AP122,AP122X,AP130, AP200 series,AP550,AP630,AP650 and AP650X

AH-ACC-PLENUM-KIT AP130,AP230, AP245X, AP250, AP550 Plenum Bracket Kit

AH-ACC-RBR-FT Rubber feet for  AP130/AP200 series/AP550

AH-ACC-SEC-BIT-3PK AP122,AP122X,AP130,AP230, AP245X, AP250, AP550 security screw bit (3pk) 

AH-ACC-SEC-KIT Security bracket, screws and security screw bit for AP122,AP122X, AP130, AP230, AP245x, AP250

AH-ACC-BKT-916-KIT AP122, AP122X, AP130, AP200 series/AP500 series 9/16” ceiling mount brackets for recessed and flush ceiling tiles

AH-ACC-BKT-AC-KIT AP122, AP122X, AP130, AP200 series/AP500 series 15/16” ceiling mount brackets for recessed and non-recessed ceiling tiles

AH-ACC-BKT-AC-WALL AP122, AP122X, AP130/AP230/AP245X/AP250,AP550 wall mounting and 15/16” ceiling mount bracket

AH-ACC-BKT-SILINT-KT AP122, AP122X, AP130,AP230/AP245X/AP250 ,AP550 Mounting bracket kit for Silhouette and Interlude ceiling types

AH-ACC-BKT-SU-KIT AP122,AP122X,AP130,AP230,AP245X, AP250, AP550 Suspend Bracket Kit

AH-ACC-BKT-WP-KIT Wall plate bracket kit for AP122, AP122X, AP130, AP230, AP245X, AP250,AP550 Includes the bracket and security screws

AH-ACC-INJ-20W-AU 20W PoE power injector with Australia/New Zealand power cord for AP100 series

AH-ACC-INJ-20W-EU 20W PoE power injector with EU power cord for AP100 series

AH-ACC-INJ-20W-UK 20W PoE power injector with UK power cord for AP100 series

AH-ACC-INJ-20W-US 20W PoE power injector with US power cord for AP100 series

AH-ACC-INJ-30W-AU 30W PoE power injector with Australia/New Zealand power cord for AP122,AP122X,AP130, AP200 series,AP550,AP630,AP650 and AP650X

AH-ACC-INJ-30W-EU 30W PoE power injector with EU power cord for AP122,AP122X,AP130, AP200 series,AP550,AP630,AP650 and AP650X

Anexo Aerohive_Datasheet_AP130 (0527646)         SEI 0008478-63.2018.6.02.8000 / pg. 140



D ATA  S H E E T

Enterprise-grade 4x4, 4-stream, 802.11ax Access Point with Integrated Antennas
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All Aerohive APs can be centrally managed using Aerohive’s out-of-band 
cloud network management system - HiveManager. HiveManager is an 
industry-leading and visionary approach to cloud-managed networking, 
built from the ground up to take full advantage of the SD-LAN and SD-
WAN solution from Aerohive. Working in tandem with Aerohive’s HiveOS, 
HiveManager leverages state-of-the-art cloud technology. Benefit from 
unified, full-stack management of Wi-Fi, switching and routing, central-
ized monitoring and configuration, real-time and historical reporting, sim-
plified troubleshooting, integrated RF planner tools and much more.

HiveManager is available in two editions: Connect and Select. The Con-
nect solution is bundled with Aerohive access points and switches and 
is free for the lifetime of the device. Connect is the perfect solution for 
those looking to provide robust, yet enterprise-grade connectivity, without 
having to invest in the full suite of management features. The optional up-
grade to Select unlocks a multitude of advanced features and capabilities 
that enhance network management, security and visibility.

Powered by HiveOS and the innovative distributed Cooperative Control 
architecture, AP650 brings the best of capacity and advanced high-effi-
ciency 802.11ax technology. In addition, the integrated BLE and ZigBee 
radios, plus a USB interface in the access point opens up a multitude 
of deployment use-cases in IoT and proximity/location-oriented services.

The AP650 benefits from an AI-driven Wi-Fi architecture capable of 
self-organizing, self-learning, self-healing and self-optimizing in the most 
challenging environments. Cooperative Control eliminates single points 
of failure and bottlenecks, delivering stability and unbridled performance, 
complimenting the capabilities of HiveOS - a stateful L2-L7 DPI firewall 
for context-based access security, advanced and customizable QoS for 
traffic optimization, intelligent meshing algorithms, Private Pre-Shared 
Key (PPSK) and much more.

The AP650 is designed for high performance environments – combining the latest in Wi-Fi standards (IEEE 
802.11ax technology), the latest in Ethernet standards (2.5 mGig), and Aerohive’s software-defined dual 5 GHz 
radios for indoor and industrial environments. AP650 has integrated BLE and USB connectivity for enhanced 
location-driven services and the ability to provide additional wireless access options for IoT and other devices.
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Product Specifications

Radio Specifications

Wireless Frequency Range

• USA: 2.400 ~ 2.483 GHz, 5.15 ~ 5.35 GHz, 5.47 ~ 5.725 GHz, 5.725 ~ 5.85 GHz

• Europe: 2.400 ~ 2.483 GHz, 5.15 ~ 5.35 GHz, 5.47 ~ 5.725 GHz

• Japan: 2.400 ~ 2.497 GHz, 5.15 ~ 5.35 GHz, 5.47 ~ 5.725 GHz

• China: 2.400 ~ 2.483 GHz, 5.725 ~5.85 GHz

Modes

• IEEE802.11a 5 GHz OFDM

• IEEE802.11b 2.4 GHz DSSS/CCK 

• IEEE802.11g 2.4 GHz OFDM 

 

Channel Support

802.11 b/g/n/ax

• US/Canada: 11 (1 ~ 11)

• Europe: 13 (1 ~ 13)

• Japan: 11b: 14 (1~13 or 14th), 11g: 13 (1 ~ 13)

• China: 13 (1 ~ 13)

 802.11 a/n/ac/ax

• US/Canada: 24 non-overlapping channels (36,40,44,48,52,56,60,64;100,104,108, 

112,116,120,124,128,132,136,140; 149,153,157,161,165)

• Europe: 19 non-overlapping channel (36,40,44,48,52,56,60,64;100,104,108,112, 

116,120,124,128,132,136,140)

• Japan: 19 non-overlapping channels (36,40,44,48,52,56,60,64;100,104,108,112, 

116,120,124,128,132,136,140)

• China: 5 non-overlapping channels (149,153,157,161,165) 

 

Modulation Technology
 
802.11 Legacy a/b/g

• DSSS (DBPSK, DQPSK, CCK) OFDM (BPSK, QPSK, 16-QAM, 64-QAM)

• DSSS (Direct Sequence Spread Spectrum) with DBPSK (Differential Binary Phase 

Shift Keying 1 Mbps), DQPSK (Differential Quaternary Phase Shift Keying 2 Mbps), 

and CCK (Complementary Code Keying 5.5 & 11 Mbps), and OFDM (Orthogonal 

Frequency Division Multiplexing with BPSK for 6, 9 Mbps.  QPSK for 12, 

18 Mbps,16QAM for 24, 36 Mbps, 64QAM for 48, 54 Mbps)

802.11n

• OFDM (BPSK, QPSK, 16-QAM, 64-QAM)

802.11ac

• OFDM (BPSK, QPSK, 16-QAM, 64-QAM, 256-QAM)

802.11ax

• OFDMA (1024-QAM)

Interfaces

• 1x 10/100/1000 Gigabit Ethernet

• 1x 2.5 mGig

• RJ-45 Console Port

Radios

• Dual Radio AP, 2.4 GHz/5GHz and 5GHz radios supporting dual band or dual 

5GHz operation

• 2.4 GHz/5 GHz, 802.11b/g/n/ax, 4x4

• 5 GHz, 802.11 a/n/ac/ax, 4x4

• 160 MHz, 1024-QAM supported

• 1x Bluetooth/Zigbee radio

Power Consumption

• DC Power: Typical 18.78 W; Max 20.65 W

• 802.3at PoE Power: Typical 15.72 W; Max 19.92 W

Environmental

• Operating Temperature:  0 to 40 °C

• Storage Temperature:  -40 to 70 °C

• Humidity:  10 to 95% 

Physical

• Dimensions:  225mm x 225mm x 37.5mm

• Weight: 2.6lb (1.18kg)

• Wall or ceiling mountable

• MTBF:  >500,000 Hours @ 25º C (estimate)

• RoHS:  -2 Compliant

• TPM chip for added security

Antenna

•  4x integrated dual band 2.4-2.5 GHz/5.1-5.8 GHz omnidirectional antennas 

•  4x integrated single band, 5.1-5.8 GHz omnidirectional antennas

•  1x internal Bluetooth/ZigBee antenna

Peak Antenna Gain:

• 2.4 GHz omnidirectional, gain 5.0 dBi

• 5 GHz omnidirectional, gain 6.0 dBi

• Bluetooth/ZigBee omnidirectional, gain 4.2 dBi

AEROHIVE  AP650

• IEEE802.11n 2.4 GHz/5 GHz OFDM 

• IEEE802.11ac OFDM 

• IEEE802.11ax OFDMA

• USB Interface

• 802.3az supported

• Redundant PoE Capable
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Power - 2.4 GHz

CHANNEL DATA RATE POWER (DBM)

11b 1,2,5.5,11 Mbps 18

11g

54 Mbps 15

48 Mbps 16

36 Mbps 17

6 Mbps 18

HE20

MCS0,1,2 18

MCS3 17

MCS4,5 16

MCS6,7 15

MCS8,9 14

MCS10,11 12

HE40

MCS0,1,2 18

MCS3 17

MCS4,5 16

MCS6,7 15

MCS8,9 14

MCS10,11 12

AEROHIVE AP650

Power and Receive Sensitivity Tables (2.4 GHz)

Receive Sensitivity - 2.4 GHz

CHANNEL DATA RATE SENSITIVITY

11b
1 Mbps -98

11 Mbps -90

11g
6 Mbps -96

54 Mbps -78

HE20
MCS0 -95

MCS11 -64

HE40
MCS0 -92

MCS11 -62

Anexo Aerohive_Datasheet_AP650 (0527647)         SEI 0008478-63.2018.6.02.8000 / pg. 144



5

AEROHIVE AP650

Power and Receive Sensitivity Tables (5 GHz)

Receive Sensitivity - 5 GHz

CHANNEL DATA RATE SENSITIVITY

11g
6 Mbps -86

54 Mbps -73

HE20
MCS0 -87

MCS11 -58

HE40
MCS0 -88

MCS11 -56

HE80
MCS0 -83

MCS11 -53

HE160
MCS0 -82

MCS11 -51

CHANNEL DATA RATE POWER (DBM)

11a

54 Mbps 17

48 Mbps 17

36 Mbps 18

6 Mbps 19

HE20

MCS0,1,2 19

MCS3,4 17

MCS5,6 16

MCS7,8 15

MCS9 14

MCS10 13

MCS11 12

HE40

MCS0,1,2 17

MCS3,4,5 16

MCS6,7,8 15

MCS9 14

MCS10 13

MCS11 12

HE80

MCS 0,1,2 17

MCS 3,4,5 16

MCS 6,7,8 15

MCS 9 14

MCS 10 13

MCS 11 12

HE160

MCS 0,1,2 17

MCS 3,4,5 16

MCS 6,7,8 15

MCS 9 14

MCS 10 13

MCS 11 12

Power - 5 GHz
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Azimuth - 2.4 GHz

Azimuth - 5 GHz

Elevation - 2.4 GHz

Elevation - 5 GHz

Radiation Patterns – Azimuth & Elevation
AEROHIVE AP650
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SKUs

©2018 Aerohive Networks. All Rights Reserved.

AEROHIVE AP650

AP650 - MISCELLANEOUS SKUs

SKU DESCRIPTION

AH-ACC-INJ-30W-UK 30W POE power injector with UK power cord for AP122,AP122X,AP130, AP200 series,AP550,AP630,AP650 and AP650X

AH-ACC-INJ-30W-US 30W POE power injector with US power cord for AP122,AP122X,AP130, AP200 series,AP550,AP630,AP650 and AP650X

AH-ACC-INJ-30W-AU 30W POE power injector with Australia/New Zealand power cord for AP122,AP122X,AP130, AP200 series,AP550,AP630,AP650 and AP650X

AH-ACC-INJ-30W-EU 30W POE power injector with EU power cord for AP122,AP122X,AP130, AP200 series,AP550,AP630,AP650 and AP650X

AH-ACC-BKT-AX-IL Armstrong mounting bracket for Interlude ceiling for the AP650, AP650X, or AP630

AH-ACC-BKT-AX-TB Replacement Prelude Bracket, T-Bar, Supported on AP630, AP650 and AP650X. Same as in-box accessory.

AH-ACC-BKT-AX-SL Mounting bracket for Silhouette ceiling, 1/4" or 1/8". Supported on AP630, AP650 and AP650X.

AH-ACC-BKT-AX-WL Bracket, Wall Mount, Supported on AP630, AP650 and AP650X.

AH-ACC-PW-30W-US 30W Power Supply for AP650/AP650X with US Power Plug

AH-ACC-PW-30W-UK 30W Power Supply for AP650/AP650X with UK Power Plug

AH-ACC-PW-30W-EU 30W Power Supply for AP650/AP650X with EU Power Plug

AH-ACC-PW-30W-AU 30W Power Supply for AP650/AP650X with Australia Power Plug

AH-ACC-PW-30W-JP 30W Power Supply for AP650/AP650X with Japan Power Plug

AH-ACC-PW-30W-KR 30W Power Supply for AP650/AP650X with Korea Power Plug

SKU DESCRIPTION

AH-AP-650-AX-XX AP650 Indoor plenum rated AP, dual 5 GHz radio 4x4:4 802.11ac/ax AP, 1x NBASE-T™ Ethernet port and 1x GE Ethernet port, with internal antennas. Includes 
HiveManager Connect and HiveCare Community. (Regulatory Domains available: FCC, CE, W (World), CAN (Canada))

AP650 - SKUs
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Documento Confidencial - Somente para uso interno
HM + A3  - QUANTIDADE:  XX unidades

ITEM AÇÃO OBSERVAÇÕES JUSTIFICATIVA / QUESTIONAMENTO

MÓDULO DE ANÁLISE DE PERFIL DE DISPOSITIVO
Características Gerais Modulo de Análise de Perfil de Dispositivo

4. Deve categorizar os dispositivos em pelo menos 3 níveis:

d. Por tipo de dispositivo (ex. Computador, Smartdevice, impressora, etc.);

e. Por sistema operacional (ex. Windows, Linux, MacOS, etc.);

f. Versão do sistema operacional (ex. Windows 7, Windows 2008 Server, etc.);

Alterar

k. DHCP;
l. HTTP User-Agent;
m. MAC OUI;
n. ActiveSync plugin;
o. SNMP;
p. Subnet Scanner;
q. IF-MAP;
r. Cisco Device Sensor;
s. MDM;
t. TCP Fingerprinting.

Alterar

f. Agente proprietário;
g. HTTP User-Agent;
h. SNMP;
i. DHCP;
j. MAC OUI.

MÓDULO DE CONTROLE DE ACESSO DE DISPOSITIVOS E USUÁRIOS
Características Gerais

11. A Solução deverá dar suporte a no mínimo as seguintes bases de dados: Alterar

n. Microsoft Active Directory;
o. Kerberos;
p. Diretórios LDAP;
q. Novell eDirectory;
r. OpenLDAP;
s. Sun Directory Server;
t. PostgreSQL;
u. Oracle 11g;
v. MariaDB;
w. MSSQL;
x. Servidores de Token;
y. Base de dados SQL interna;
z. Lista interna estática de hosts.
12. Deve suportar "Single Sign-on" (SSO) através de SAML v2.0;

f. Atributos do usuário autenticado;
g. Hora do dia, dia da semana;
h. Tipo de dispositivo utilizado;
i. Localização do usuário;
j. Tipo de autenticação utilizada.

m. Data e Hora;
n. Mac Address do dispositivo;
o. Classificação do dispositivo;
p. Usuário;
q. Equipamento que requisitou a autenticação (origem);
r. Método de autenticação utilizado;
s. Fonte de autenticação utilizada para validação;
t. Perfil de acesso aplicado;
u. Atributos de entrada do protocolo utilizados na requisição (ex. RADIUS);
v. Informações de resposta da solução para o elemento de rede;
w. Alertas em caso de falha
x. LOGS já filtrados para a requisição em análise

a. Lista com últimos Alertas do sistema;

Alterar

e. Últimas falhas de autenticação;

I. a. Saudáveis (dentro das políticas estabelecidas);
II. Não saudáveis (que estão fora das políticas estabelecidas);
a. Lista com as últimas autenticações;
b. Lista com as últimas autenticações com sucesso;
c. Utilização de CPU do sistema, no mínimo nos últimos 30 minutos;

ITEM 01 – SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 
PARA SOLUÇÃO DE REDE WIRELESS LICENCIAMENTO
1. Licenciamento da SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE 
ACESSO, contemplando o quantitativo mínimo de 1.000 (um mil) dispositivos, 
usuários corporativos ou visitantes simultâneos, independente do perfil de 
autenticação seja por dispositivo ou usuário;

2. Caso a solução ofertada necessite de licenciamento específico para 
credenciamento dos dispositivos, usuários (corporativos ou visitantes), deverá 
ser fornecido o quantitativo solicitado para ambos, de forma que a solução 
realize a análise de perfil e o controle de acesso dos 1.000 (um mil) 
dispositivos ou usuários (corporativos ou visitantes) simultâneos.

3. Deve implementar funcionalidade de classificação automática criando perfis 
de dispositivos, de forma a descobrir, classificar e agrupar os dispositivos 
conectados na rede;

5. Deve ser capaz de gerar gráficos das categorias separando os dispositivos 
conforme suas características;

6. Deve suportar a coleta de informações, para classificação, usando no 
mínimo:

6. Deve suportar a coleta de informações, para 
classificação, usando no mínimo 3 (três) dos métodos 

descritos abaixo:

7. Deve possuir dicionário de categorias de dispositivos pré-configurado e 
mecanismo de atualização do mesmo;

8. Deve suportar a integração com, no mínimo, as seguintes soluções de MDM 
de mercado AirWatch, MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, 
MaaS 360 devendo comprovar a compatibilidade em documentação oficial do 
fabricante; 

8. Deve suportar a integração com, no mínimo uma 
das seguintes soluções de MDM de mercado AirWatch, 

MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, 
MaaS 360 devendo comprovar a compatibilidade em 

documentação oficial do fabricante; 

9. Deve permitir priorização na ordem de criação dos perfis com no mínimo as 
seguintes características:

10. A solução de análise de perfil de usuários deverá permitir consultas a sua 
base, pela solução de controle de acesso para validação de dispositivos com 
base no seu perfil.

11. A Solução deverá dar suporte a no mínimo 3 (três) 
das seguintes bases de dados:

13.Deve implementar gerenciamento e aplicação de políticas de autorização 
de acesso de usuários com base em:

14. Deve permitir a visualização de todas informações relativas a cada 
transação e autenticação em uma única tela, a solução deverá trazer no 
mínimo as seguintes informações:

15. Deve possuir Dashboard customizável, onde deve permitir a 
visualização de no mínimo as seguintes informações:

b. Gráfico com todas as requisições de autenticação dos últimos 7 dias, 
incluindo RADIUS, TACACS+ e Autenticações Web;

b. Gráfico com todas as requisições de autenticação 
dos últimos 7 dias, incluindo RADIUS, Autenticações 

Web ou TACACS+;

c. Gráfico com o status das autenticações aceitas e rejeitadas nos últimos 7 
dias;
d. Gráfico com a categorização dos dispositivos classificados pela solução, 
divididos de acordo com as categorias de classificação;

f. Gráfico com as requisições de avaliação de postura dos dispositivos, 
divididos em:

16. Deve possuir base de regras e categorias de dispositivos pré-configurada e 
mecanismo de atualização da mesma;
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Alterar

19. Deve possuir recursos integrados de AAA: RADIUS, TACACS+ e Kerberos; Alterar

20. Deve possuir suporte aos seguintes recursos:
m. RADIUS;
n. RADIUS CoA;
o. TACACS+; Retirar
p. Web authentication;
q. SAML v2.0;
r. EAP-FAST (EAP-MSCHAPv2, EAP-GTC, EAP-TLS);
s. PEAP (EAP-MSCHAPv2, EAP-GTC, EAP-TLS, EAP-PEAP-Public);
t. TTLS (EAP-MSCHAPv2, EAP-GTC, EAP- TLS, EAP-MD5, PAP, CHAP);
u. EAP-TLS;

v. PAP, CHAP, MSCHAPv1, MSCHAPv2, and EAP-MD5; Alterar v. PAP, CHAP, MSCHAPv1 ou MSCHAPv2, and EAP-MD5;

w. Windows machine authentication;
x. MAC address authentication (dispositivos sem suporte a 802.1X);

26. Deve possuir suporte a administração através de IPv6;

GARANTIA E SUPORTE

17. Deve suportar a integração com no mínimo as seguintes soluções de MDM 
de mercado AirWatch, MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, 
MaaS 360 devendo comprovar a compatibilidade em documentação oficial do 
fabricante;

17. Deve suportar a integração com no mínimo uma 
das seguintes soluções de MDM de mercado AirWatch, 

MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, 
MaaS 360 devendo comprovar a compatibilidade em 

documentação oficial do fabricante.

18. Deve suportar autenticações via OAuth2, Facebook, Twitter, LinkdIn, 
Office365 e Google Apps;

19. Deve possuir recursos integrados de AAA: RADIUS, 
Kerberos ou TACACS+.

21. Deve suportar verificação de vulnerabilidade através de varredura de 
portas;
22. Deve suportar à aplicação de políticas em ambiente com múltiplos 
fornecedores de Wireless, cabeado e VPN;
23. Deve possuir CA integrada, para geração de certificados para os 
dispositivos que forem se autenticar na rede;
24. Deve suportar à integração com plataforma de terceiros usando 
HTTP/RESTful API;

25. Deve permitir que a solução faça consultas em bases SQL, com o objetivo 
de buscar informação a serem utilizadas durante o processo de autenticação 
dos usuários;

27. Deve possuir ferramenta para gerenciar os processos de credenciamento, 
autenticação, autorização e contabilização de usuários visitantes através de 
portal web seguro;

28. Deve implementar a criação de grupos de autorizadores com privilégios 
distintos de criação de credenciais temporárias e atribuição de permissões de 
acesso aos clientes;

29. Deve permitir realizar a autenticação dos autorizadores em base externa 
do tipo Microsoft Active Directory ou LDAP e atribuir o privilégio ao autorizador 
de acordo com o seu perfil;

30. Deve implementar as funcionalidades de geração de lotes de credenciais 
aleatórias, temporárias, pré-autorizadas;
31. Deve implementar a importação e exportação da relação de credenciais 
temporárias através de arquivos txt ou csv
32.Deve permitir a configuração do tempo de validade das credenciais, 
baseando-se na criação da conta ou no primeiro login da conta

33. Deve permitir que o visitante crie sua própria credencial temporária 
(autosserviço) através de portal web, com ou sem a necessidade de um 
autorizador;

34. Deve permitir a customização do formulário de criação de credenciais, a 
ser preenchido pelo autorizador ou pelo visitante em caso de autosserviço, 
especificando quais informações cadastrais dos visitantes são obrigatórias ou 
opcionais;

35. Deve permitir a customização do nível de segurança da senha temporária 
que será gerada ao visitante, especificando a quantidade mínima de 
caracteres e o uso de caracteres especiais e números para compor a senha;

36. Deve exigir que o usuário visitante aceite o “Termo de uso da rede” a cada 
login ou apenas no primeiro login;

37. Deve permitir o envio das credenciais aos usuários registrados através de 
mensagens SMS (Short Message Service), e-mail ou impressão local.

38. Garantia e suporte do fabricante para a solução de software ofertada pelo 
período mínimo de 36 (sessenta) meses, incluindo a evolução para novas 
versões devendo o atendimento ser na modalidade 24x7 (vinte quatro horas 
por dia, sete dias da semana), com tempo de resposta máximo em 4 (quatro) 
horas.
39. Caso a garantia padrão do fabricante seja menor que a exigida, a 
proponente deverá informar em sua proposta o código de serviço de garantia 
do fabricante (“part number”), incorporada à solução.

40. O fabricante deve possuir canais de comunicação e ferramentas adicionais 
para suporte técnico online como “chat” e “e-mail” em seu site da internet 
com disponibilidade ainda de área para cadastro da solução de software 
ofertada, possibilitando assim que a CONTRATANTE possa receber de forma 
proativa, durante todo período da garantia as notificações de atualizações e 
correções (“hotfix”) da solução;

41. A empresa fabricante da solução de software deverá dispor de um número 
telefônico tipo 0800 para suporte técnico e abertura de chamados técnicos.

42. A comprovação da modalidade da garantia deverá ocorrer através de 
documentação do fabricante de domínio público, não sendo aceita 
documentação emitida pelo fornecedor ou centro de distribuição para fins de 
comprovação que por ventura conflitem com catálogos, manuais, folders 
oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados 
anteriormente, será possível a comprovação através da apresentação de 
documentação expressa do fabricante dos softwares, indicando o período de 
garantia dos produtos ofertados. Em caso de documentação expressa do 
fabricante deverá ser anexada a mesma a procuração que comprove que a 
fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas.
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Documento Confidencial - Somente para uso interno
HM Local Cloud  - QUANTIDADE:  XX unidades

ITEM AÇÃO OBSERVAÇÕES JUSTIFICATIVA / QUESTIONAMENTO
ITEM 02 – SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS
LICENCIAMENTO

CARACTERÍSTICAS GERAIS

Retirar

Alterar

Alterar

8. Permitir que os eventos sejam gravados remotamente utilizando Syslog;

11. Considerar a área de cobertura e a banda por usuário desejada;

12. Possibilitar a importação de plantas baixas nos formatos dwg e jpg; Alterar

13. Permitir a visualização de alertas da rede em tempo real;

a. Níveis de ruído;
b. Relação sinal-ruído;
c. Interferência;
d. Potência de sinal.

b. Visualização do mapa de calor de RF (Heatmap);
c. Localização de ativos conectados à rede (equipamentos 802.11);
d. Localização de Pontos de acesso rogue.

21. Possuir capacidade de geração de relatórios dos seguintes tipos:
a. Listagem de clientes Wireless;
b. Listagem de Pontos de acesso;

c. Informações de Configuração dos Controladores WLAN; Alterar c. Informações de Configuração dos pontos de acesso;

d. Utilização da rede;
e. Detalhes dos Pontos de acesso não autorizados (rogues) detectados.
22. Suportar SSH, HTTP/HTTPS, SSL, Telnet; Alterar 22. Suportar SSH, SSL, Telnet ou HTTP/HTTPS;

25. Possuir suporte a MIB II, conforme RFC 1213;

Retirar

Retirar

Alterar

Alterar

33. Deve disponibilizar em painel gráfico de controle informações referentes à:

Alterar

Retirar

c. Informações sobre os tipos de aplicações mais utilizados;
d. Informações sobre usuários conectados.

1. Deverá ser entregue o quantitativo mínimo de licenças para o 
gerenciamento simultâneo de 50 (cinquenta) Pontos de acesso;

2. A solução de gerenciamento deverá administrar a configuração dos Pontos 
de acesso de forma centralizada;
3. A solução de gerenciamento deverá possuir integração com o HPE IMC em 
console única de gerenciamento;

4. A solução de gerenciamento de rede wireless deverá suportar, em 
arquitetura de controladora distribuída, a capacidade de gerenciar no mínimo 
120 (cento e vinte) pontos de acesso por cluster e no mínimo um total de 20 
(vinte) clusters;

4. A solução de gerenciamento de rede wireless poderá 
opcionalmente suportar, em arquitetura de 

controladora distribuída, a capacidade de gerenciar no 
mínimo 120 (cento e vinte) pontos de acesso por 

cluster e no mínimo um total de 20 (vinte) clusters;

5. A solução de gerenciamento, em arquitetura de controladora física ou 
virtual, deverá suportar no mínimo 2400 pontos de acesso;
6. Deve ser obrigatoriamente do mesmo fabricante dos pontos de acesso e 
controladores;

6. Deve ser obrigatoriamente do mesmo fabricante dos 
pontos de acesso;

7. Permitir a configuração e gerenciamento através de browser padrão (http, 
https);

9. Prover organização hierárquica de equipamentos, permitindo que um 
equipamento receba as configurações lógicas e as replique a outros 
equipamentos;

10. Possuir capacidade de projeto automatizado de redes sem fio nos padrões 
802.11a, 802.11b e 802.11g, 802.11n e 802.11ac, segundo a geografia do 
prédio (planta);

12. Possibilitar a importação de plantas baixas nos 
formatos dwg ou jpg;

14. Permitir a visualização de eventuais áreas sem cobertura de RF (áreas de 
sombra);
15. Monitorar o desempenho da rede wireless, consolidando informações de 
rede tais como:

16. Possuir capacidade de listagem on-line da localização de usuário, endereço 
IP, endereço MAC, nível de potência de recepção e dados de associação e de 
autenticação 802.1x;

17. Deve possuir informação visual e gráfica, na planta baixa dos andares, 
para:

a. Visualização dos Pontos de acesso instalados, com estado de 
funcionamento;

18. Caso esta funcionalidade não esteja disponível no sistema de gerência, 
deve ser fornecido software, do mesmo fabricante, para atender este item, 
contemplando todos os dispositivos licenciados e com redundância 1+1;

19. Possuir capacidade de identificação e listagem dos rádios vizinhos e 
respectivos SSID/BSSID que podem ser percebidos por cada Ponto de acesso;

20. Possuir capacidade de configuração gráfica completa do controlador WLAN 
seja ela física, virtual ou distribuída e respectivos Pontos de acesso;

23. Possuir ferramentas de debug e log de eventos para depuração e 
gerenciamento em primeiro nível;
24. Implementar os padrões abertos de gerência de rede SNMPv2c e SNMPv3, 
incluindo a geração de traps;

26. Implementar a MIB privativa que forneça informações relativas ao 
funcionamento do equipamento;
27. Possibilitar a obtenção da configuração do equipamento através do 
protocolo SNMP;

28. Possibilitar a obtenção via SNMP de informações de capacidade e 
desempenho da CPU, memória e portas;

28. Possibilitar a obtenção de informações de 
capacidade e desempenho da CPU, memória e portas;

29. Possibilitar a gerência e identificação individualizada de cada Ponto de 
acesso remoto;
30. Permitir a administração centralizada dos Pontos de acesso sem a 
necessidade de configurar os mesmos individualmente;
31. Possibilitar a identificação de paredes e divisórias com respectivos níveis 
de atenuação por tipo (alvenaria, vidro, drywall e divisória);

32. Possibilitar a importação de plantas baixas nos formatos gráficos (CAD, 
dwg, jpg, gif e png);

32. Possibilitar a importação de plantas baixas e pelo 
menos um dos formatos gráficos (CAD, dwg, jpg, gif e 

png);

a. Sistemas operacionais e tipos de dispositivos que estão se conectando a 
rede;

a. Sistemas operacionais ou tipos de dispositivos que 
estão se conectando a rede;

b. Informações sobre chamadas de voz, seus protocolos e qualidade das 
mesmas;

34. Deve possuir informação sobre possíveis ameaças a rede detectadas pelos 
sistemas gerenciados;
35. Deve possibilitar criação de regras de detecção de ameaças e 
correlacionar todos os dispositivos gerenciados.
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Documento Confidencial - Somente para uso interno
MODELO  - QUANTIDADE:  XX unidades

ITEM AÇÃO OBSERVAÇÕES JUSTIFICATIVA / QUESTIONAMENTO

Características técnicas mínimas

GERENCIAMENTO DE REDE WIRELESS especificada nesse edital.
GARANTIA E SUPORTE

ITEM 03 – LICENÇAS ADICIONAIS PARA SOLUÇÃO DE GERENCIAMENTO 
DE REDE WIRELESS

1. Licença para expansão da SOLUÇÃO DE GERENCIAMENTO DE REDE 
WIRELESS, contemplando o quantitativo adicional mínimo de 1 (um) ponto de 
acesso simultâneo;

2. Cada unidade deve ser fornecida com todas as licenças de software 
necessárias para o funcionamento integral de todas as funcionalidades 
disponíveis para SOLUÇÃO DE

1.Garantia e suporte do fabricante para a solução de software ofertada pelo 
período mínimo de 36 (sessenta) meses, incluindo a evolução para novas 
versões devendo o atendimento ser na modalidade 24x7 (vinte quatro horas 
por dia, sete dias da semana), com tempo de resposta máximo em 4 (quatro) 
horas.

2. Caso a garantia padrão do fabricante seja menor que a exigida, a 
proponente deverá informar em sua proposta o código de serviço de garantia 
do fabricante (“part number”), incorporada à solução.

3.O fabricante deve possuir canais de comunicação e ferramentas adicionais 
para suporte técnico online como “chat” e “e-mail” em seu site da internet 
com disponibilidade ainda de área para cadastro da solução de software 
ofertada, possibilitando assim que a CONTRATANTE possa receber de forma 
proativa, durante todo período da garantia as notificações de atualizações e 
correções (“hotfix”) da solução;

4.A empresa fabricante da solução de software deverá dispor de um número 
telefônico tipo 0800 para suporte técnico e abertura de chamados técnicos.

5.A comprovação da modalidade da garantia deverá ocorrer através de 
documentação do fabricante de domínio público, não sendo aceita 
documentação emitida pelo fornecedor ou centro de distribuição para fins de 
comprovação que por ventura conflitem com catálogos, manuais, folders 
oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados 
anteriormente, será possível a comprovação através da apresentação de 
documentação expressa do fabricante dos softwares, indicando o período de 
garantia dos produtos ofertados. Em caso de documentação expressa do 
fabricante deverá ser anexada a mesma a procuração que comprove que a 
fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas.
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Documento Confidencial - Somente para uso interno
MODELO  - QUANTIDADE:  XX unidades

ITEM AÇÃO OBSERVAÇÕES JUSTIFICATIVA / QUESTIONAMENTO

Características técnicas mínimas

GARANTIA E SUPORTE

ITEM 04 – LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE 
PERFIL E CONTROLE DE ACESSO

3.Licenciamento para expansão da SOLUÇÃO DE ANALISE DE PERFIL E 
CONTROLE DE ACESSO, contemplando o quantitativo mínimo adicional de 500 
(quinhentos) dispositivos, usuários corporativos ou visitantes simultâneos, 
independente do perfil de autenticação, seja por dispositivo ou usuário;

6.Garantia e suporte do fabricante para a solução de software ofertada pelo 
período mínimo de 36 (sessenta) meses, incluindo a evolução para novas 
versões devendo o atendimento ser na modalidade 24x7 (vinte quatro horas 
por dia, sete dias da semana), com tempo de resposta máximo em 4 (quatro) 
horas.
7.Caso a garantia padrão do fabricante seja menor que a exigida, a 
proponente deverá informar em sua proposta o código de serviço de garantia 
do fabricante (“part number”), incorporada à solução.

8.O fabricante deve possuir canais de comunicação e ferramentas adicionais 
para suporte técnico online como “chat” e “e-mail” em seu site da internet 
com disponibilidade ainda de área para cadastro da solução de software 
ofertada, possibilitando assim que a CONTRATANTE possa receber de forma 
proativa, durante todo período da garantia as notificações deatualizações e 
correções (“hotfix”) da solução;

9. A empresa fabricante da solução de software deverá dispor de um número 
telefônico tipo 0800 para suporte técnico e abertura de chamados técnicos.

10. A comprovação da modalidade da garantia deverá ocorrer através de 
documentação do fabricante de domínio público, não sendo aceita 
documentação emitida pelo fornecedor ou centro de distribuição para fins de 
comprovação que por ventura conflitem com catálogos, manuais, folders 
oficiais impressos ou da internet (devendo constar o endereço URL parafolders 
da web). Caso não seja comprovada por um dos meios citados anteriormente, 
será possível a comprovação através da apresentação de documentação 
expressa do fabricante dos softwares, indicando o período de garantia dos 
produtos ofertados. Em caso de documentação expressa do fabricante deverá 
ser anexada a mesma a procuração que comprove que a fabricante outorga 
ao procurador os poderes para firmar e declarar as exigências solicitadas.
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Documento Confidencial - Somente para uso interno
HM Local Cloud + APs - QUANTIDADE:  XX unidades

ITEM AÇÃO OBSERVAÇÕES JUSTIFICATIVA / QUESTIONAMENTO
ITEM 05 – CONTROLADORA WLAN
Características gerais

Alterar

3. Permitir a conexão simultânea de, no mínimo, 4.000 clientes wireless;

4. Permitir a gravação de eventos por meio do protocolo syslog;

5. Aesso ao sistema através de cliente com browser padrão (http, https, Java);

6. Permitir operação em modo mesh;
7. Permitir o uso de múltiplos SSIDs simultaneamente;
8. Prover tempo de fast-roaming intra-switch inferior a 25 milissegundos; Retirar

Retirar

11. Deve suportar 802.11e com WMM, U-APSD e T-SPEC;
12. Gerenciar centralizadamente a autenticação de usuários;

Alterar

Alterar

18 .Suportar as especificações: Retirar
a. RFC 2409; Retirar
b. RFC 2661; Retirar
c. RFC 2408; Retirar
d. RFC 3602; Retirar
e. RFC 3948; Retirar
f. RFC 2548; Retirar
g. RFC 2328; Retirar
h. RFC 2338; Retirar
i. RFC 1027; Retirar
j. IEEE 802.1w; Retirar
k. RFC 1519; Retirar
19. Deverá suportar os seguintes métodos EAP-PEAP, EAP-TLS e EAP-TTLS;

21. Permitir a seleção/uso de servidor Radius ou LDAP com base no SSID;

Retirar

Retirar

24. Deve suportar utilização de Portal Captivo externo ao controlador;

30. Permitir portais captivos externos a controladora;

Retirar

33. Implementar segurança IEEE 802.11i;

35. Suportar, no mínimo, 2000 VLANs;
36. Implementar o protocolo 802.1w (Rapid Spanning Tree); Retirar
37. Oferecer suporte a roteamento e switching de camadas L2 e L3; Retirar

39. Possuir servidor DHCP embutido; Retirar
40. Suportar o protocolo VRRP para redundância de controladores; Retirar
41. Deve suportar redundância de controladores nos modos: Retirar
a. 1+1; Retirar
b. N+1; Retirar
c. Ativo-Ativo; Retirar
d. Ativo-Standby; Retirar

Retirar

Retirar

45. Implementar tagging de VLANs através do protocolo 802.1Q;

46. Implementar o protocolo 802.1d para Spanning Tree (STP); Retirar

Alterar

49. Realizar a descoberta automática dos APs na infraestrutura wireless;

1. Solução baseada em hardware ou software específico, do tipo appliance 
físico ou virtual, do mesmo fabricante dos pontos de acesso e software de 
gerência;

1. Solução baseada em hardware ou software 
específico, do tipo appliance físico ou virtual, do 

mesmo fabricante dos pontos de acesso; 
Opcionalmente poderá ser baseada em arquitetura de 
controladora distribuida ou cooperativa onde os pontos 

de acesso atuam como controladores WLAN em 
redundância.

2. Deve estar licenciado para controle de, no mínimo, 50 (cinquenta) pontos 
de acesso, podendo ser expandido em no mínimo, 250 (duzentos e cinquenta) 
pontos de acesso através de licenciamento adicional;

9. Prover tempo de fast-roaming inter-switch em camada 2, inferior a 100 
milissegundos;
10. Permitir conexão entre APs sem a necessidade de conexão cabeada, 
implementando assim uma rede padrão mesh;

13. Implementar protocolo de autenticação para controle do acesso 
administrativo a solução com mecanismos de AAA;
14. Possuir base de dados de usuários interna para autenticação de usuários 
convidados / temporários (acesso guest);

15. Permitir autenticação em no mínimo os seguintes sistemas de base de 
dados de usuários Microsoft Active Directory, Cisco ACS server, FreeRadius, 
entre outros;

15. Permitir autenticação em no mínimo um dos 
seguintes sistemas de base de dados de usuários 

Microsoft Active Directory, Cisco ACS server, 
FreeRadius, entre outros;

16. Realizar o provisionamento de usuários convidados (guests) através de 
interface Web por meio de um usuário administrativo com permissões 
mínimas, exclusivas para este fim;

17. Possuir suporte a autenticação IEEE 802.1X, com pelo menos os seguintes 
métodos EAP: EAP-MD5, PEAP/EAP-GTC, PEAP/EAP-MSCHAPv2, EAP-TLS com 
utilização de base de usuários interna ou servidor RADIUS externo;

17. Possuir suporte a autenticação IEEE 802.1X, com 
pelo menos os seguintes métodos EAP: PEAP/EAP-GTC, 
PEAP/EAP-MSCHAPv2, EAP-TLS com utilização de base 

de usuários interna ou servidor RADIUS externo;

20. Possuir suporte a autenticação IEEE 802.1X, com o método PEAP/EAP-GTC, 
e com utilização de base de usuários LDAP externa;

22. Suportar a autenticação de usuários conectados à rede cabeada através 
das portas do controlador;
23. Possuir o recurso de EAP Offload para terminação do túnel EAP no próprio 
controlador;

25. Permitir a autenticação (através de endereço MAC, Portal Captivo ou IEEE 
802.1X) de usuários conectados à rede WLAN (wireless) ou usuários 
conectados às portas cabeadas do controlador. Também deverá permitir a 
autenticação de usuário e de máquina por meio de IEEE 802.1x;

26. Oferecer recurso de Portal Captivo (Captive Portal) com suporte a 
múltiplos portais simultaneamente;
27. Implementar associação dinâmica de usuário a VLAN, com base nos 
parâmetros da etapa de autenticação;
28. Implementar Qualidade de Serviço com a marcação de pacotes utilizando 
Diffserv e suporte a 802.1p para QoS de rede;
29. Possibilitar roaming com integridade de sessão, dando suporte a 
aplicações em tempo real, tais como, VoIP, VoWLAN, videoconferência, dentre 
outras;

31. A controladora deve possuir funcionalidade de conexão Site to Site VPN 
utilizando padrão Ipsec. Caso a solução fornecida não possua a funcionalidade, 
será aceita solução de VPN  adicional integrada;

32. Deve permitir o tunelamento do trafego de dados de usuários mesmo em 
redes L3, não sendo necessário estender VLANs até o Ponto de Acesso, 
inclusive em MANs e WANs;

34. Suportar a criptografia centralizada com os seguintes protocolos: AES-
CCMP, TKIP e WEP;

38. Possuir o recurso de criação de Pools de VLAN para permitir a 
escalabilidade de redes;

42. Oferecer os recursos de mobilidade entre VLANs para roaming de camada 
2;
43. Oferecer os recursos de Proxy de endereços IP e Proxy DHCP para roaming 
entre redes (L3)

44. Deve implementar northbound APIs para realização de integrações com 
aplicações de terceiros para fins de monitoramento e visibilidade. Caso seja 
necessário, deve ser ofertado licenças para ativação desse recurso;

47. O controlador WLAN poderá estar diretamente e/ou remotamente 
conectado aos APs por ele gerenciados, inclusive via roteamento nível 3 da 
camada OSI

48. Se um controlador WLAN falhar, os APs relacionados deverão se associar a 
um controlador WLAN alternativo de forma automática, não permitindo que a 
rede wireless se torne inoperante;

48. Se um controlador WLAN ou AP controlador falhar, 
os APs relacionados deverão se associar a uma 

unidade controladora WLAN alternativa de forma 
automática, não permitindo que a rede wireless se 

torne inoperante; 

Anexo TRE_Alagoas_08042019_rev0. (0527651)         SEI 0008478-63.2018.6.02.8000 / pg. 153



53. Permitir a conexão de APs de maneira remota e segura;

Retirar

57. Gerenciar o tráfego dos APs centralizadamente; Retirar
58. Administrar a configuração dos AP’s;

60. Permitir o bloqueio de comunicação entre clientes wireless – L2 bridging;

61. Implementar filtros baseados em protocolos e em endereços MAC;
62. Implementar padrão IEEE 802.11h;
63. Realizar o controle de autorização baseado em perfis de acesso;

Retirar

67. Implementar listas de controle de acesso (ACLs);

Retirar

Retirar

Retirar

Retirar

Retirar

74. Otimizar o desempenho e a cobertura da radiofrequência;

Alterar

89. Realizar a identificação e contenção de redes “ad-hoc”;
90. Detectar e bloquear o bridging entre estações da rede WLAN;

91. Oferecer proteção contra ataques Denial Of Service (DOS) a APs e estações

92. Detectar e alertar os seguintes tipos de ataques na rede WLAN:
a. Impersonalização de AP válido;
b. Floods de Frames;
c. Fake Ap, Airjack; Alterar c. Fake Ap;
d. Broadcasts de de-autenticação;
e. ASLEAP; Retirar
f. Ataques baseados em probes;

50. Permitir o controle dos APs mediante a conexão através de topologia 
MESH (WiFi Mesh);
51. A rede MESH deverá oferecer comportamento determinístico da topologia 
da rede MESH;
52. A rede MESH deverá prover auto-redundância das camadas física (RF) e 
Layer 2 com comportamento determinístico;

54. Conectar APs através de redes públicas e/ou privadas com garantia de 
segurança através de conexão criptografada;

55. Permitir a propagação de SSIDs de maneira segura para qualquer AP 
legitimamente cadastrado na controladora, independentemente de onde este 
AP esteja conectado;

56. Permitir a autenticação do AP remoto através de certificado digital ou de 
usuário e senha cadastrados em servidor AD e Radius;

59. Deve permitir administrar centralizadamente todos os aspectos de 
segurança da rede WLAN através de firewall integrado à solução de rede sem 
fio, caso a solução ofertada não possua solução de firewall nativa na 
controladora WLAN deverá ser ofertado firewall externo com capacidade para 
atender toda a solução;

64. Permitir que seja configurado um perfil de acesso, com regras aplicadas de 
firewall, para o qual será direcionado o usuário após sua autenticação;

65.Possuir o recurso de “blacklisting” contra ataques ao Firewall e à rede 
wireless, evitando que um determinado cliente se associe à rede wireless caso 
viole políticas definidas de Firewall ou execute algum ataque à rede WLAN de 
endereços MAC de APs do sistema;

66. O Firewall deverá implementar os recursos de NAT (Network Address 
Translation) tanto para destino quanto para origem;

68. Oferecer detecção e proteção integrada de ataques de negação de 
serviços TCP, ICMP;
69. Permitir o espelhamento de sessão e logs detalhados por pacote a fim de 
possibilitar análises forenses;

70. Permitir a aplicação de políticas de camada 4, de acordo com as 
características do usuário. Por exemplo, um usuário que pertença ao grupo de 
gerentes (cadastrado no Radius ou Active Directory) terá permissão de acesso 
ao protocolo FTP no servidor de ERP;

71. Permitir derivação de políticas de acesso. Por exemplo, um usuário pode 
pertencer a um grupo ao qual foram atribuídas políticas de acesso em camada 
4, porém, caso esteja utilizando um dispositivo de voz, o tráfego SIP passará a 
ter prioridade através de aplicação de QoS;

72. Permitir a criação de políticas com base em horários e na localização do 
usuário. Por exemplo: bloquear o tráfego do protocol FTP após às 18 horas.

73. O Firewall deverá ser integrado à rede WLAN de modo a permitir a 
desassociação de usuários da rede sem fio WLAN com base na violação de 
políticas de tráfego. Por exemplo: desassociar da rede WLAN e colocar em 
quarentena o Notebook com endereço MAC XX:XX:XX se o usuário tentar fazer 
um telnet para o servidor ABC;

75. Ajustar automaticamente os canais de modo a otimizar a cobertura de 
rede e mudar as condições de RF baseado em performance;
76. Detectar interferência e ajustar parâmetros de RF, evitando problemas de 
cobertura e controle da propagação indesejada de RF;
77. Implementar varredura de RF contínua, programada ou sob demanda, com 
identificação de APs ou clientes irregulares;

78. Deve implementar a tecnologia de “Channel load balancing”, permitindo 
que clientes sejam automaticamente distribuídos entre Pontos de Acesso 
adjacentes operando em canais distintos, com o objetivo de balancear a carga 
entre os Pontos de Acesso;

79. Deve implementar a tecnologia de “Band Steering/Select”, permitindo que 
clientes com suporte a faixa de frequência de 5GHz se conectem aos Pontos 
de Acesso utilizando, preferencialmente, a faixa de 5GHz;

80. Implementar varredura de RF nas bandas 802.11a, 802.11b, 802.11g, 
802.1n e 802.11ac para identificação de ataques e APs intrusos não 
autorizados (rogues);

81. Realizar a varredura no canal de operação do AP sem impacto na 
performance da rede WLAN;
82. Permitir a varredura em todos os canais possíveis de RF para detecção e 
contenção de ameaças na rede WLAN;

83. Deve fazer a varredura dos espectros de 2,4 GHz e 5 GHz para localização 
e classificação de interferências não 802.11, analise de espectro, e evita-las 
automaticamente;

O controlador deve possuir funcionalidade de analisador gráfico de espectro 
para detecção de interferências nas faixas de frequência de 2.4 e 5 GHz, 
sejam elas IEEE 802.11 ou não.

84. Deve disponibilizar interface gráfica com, pelo menos, gráficos de Fast 
Fourier Transform (FFT) e espectrograma; Caso a funcionalidade não possa ser 
apresentada pelo controlador, deve ser fornecido um equipamento ou 
software, do mesmo fabricante, que o faça;

85. Utilizar os APs como ”sensores” de RF para fazer a monitoração do 
ambiente Wireless;
86. Classificar automaticamente APs válidos, os que interferem e os não 
autorizados (rogues);
87. Implementar mecanismos para detecção e contenção de APs não 
autorizados (rogues);

88. Realizar a contenção automática dos APs Rogue, simultaneamente, 
através da rede WLAN e da rede cabeada;

88. Realizar a contenção automática dos APs Rogue, 
simultaneamente, através da rede WLAN ou da rede 

cabeada;

93. Possuir capacidade de gerar alarmes e executar contra-ataques se um 
ataque for detectado;
94. Detectar áreas de sombra de cobertura e efetuar os devidos ajustes para 
sua correção, automaticamente;

95. Ajustar, dinamicamente, o nível de potência e canal de rádio dos APs, de 
modo a otimizar o tamanho da célula de RF, garantindo a performance e 
escalabilidade;

96. Permitir o controle de banda disponível (bandwith contracts) por usuário 
ou através de perfis de usuários;
97. Possibilitar roaming com integridade de sessão, dando suporte a 
aplicações em tempo real, tais como, VoIP, VoWLAN, videoconferência, dentre 
outras;
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Retirar

Retirar

Garantia e Suporte

98. Deve possuir mecanismo de controle de admissão de chamadas nos 
pontos de acesso (CAC);

99. Possuir mecanismo automático de QoS para protocolos de voz (SIP, SVP e 
SCCP) utilizando inspeção automática de pacotes, sem a necessidade de fazer 
a marcação prévia (tagging) de pacotes;

100. Deve possuir solução de identificação de aplicações através de técnicas 
de análise de tráfego, provendo informações das aplicações mais utilizadas na 
interface gráfica;

101. Permitir a criação de políticas de acesso baseadas nas aplicações, como 
por exemplo, o acesso a “redes sociais” terá um controle de banda de 2Mpbs.

102. Apresentar informações gráficas referente a utilização de soluções de 
comunicações unificadas (UC) sobre a infraestrutura WLAN, de formar a 
apresentar informações referentes as chamadas realizadas e relações gráficas 
entre o nível de sinal recebido pelo usuário e a qualidade da chamada.

103. Possuir a funcionalidade da utilização do protocolo Bonjour na 
infraestrutura, permitindo que os serviços divulgados via mDNS sejam 
controlados, filtrados e disponibilizados entre diferentes subnets, tornando 
assim possível a utilização em redes com múltiplas subnets e um número 
grande de dispositivos.
104. Cada unidade deve ser fornecida com todas as licenças de software 
necessárias para o funcionamento integral de todas as funcionalidades 
disponíveis.

1. O equipamento ofertado deverá possuir garantia do fabricante na 
modalidade on-site pelo período mínimo de 60 (sessenta) meses para 
reposição de peças, mão de obra e atendimento. O prazo máximo para 
atendimento do chamado deve ser de até o próximo dia útil após a sua 
abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de 
até 07 (sete) dias úteis.

2. Caso a garantia padrão do fabricante seja menor que a exigida, a 
proponente deverá informar em sua proposta o código de serviço de garantia 
do fabricante (“part number”), incorporada à solução.

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais 
para suporte técnico online como “chat” e “e-mail” em seu site da internet 
com disponibilidade ainda de área para cadastro da solução de hardware 
ofertada, possibilitando assim que a CONTRATANTE possa receber de forma 
proativa, durante todo período da garantia as notificações de atualizações e 
correções (“hotfix”) da solução;

4. A empresa fabricante do equipamento deverá dispor de um número 
telefônico tipo 0800 para suporte técnico e abertura de chamados técnicos.

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento 
e solução exigidos para os equipamentos, deverá ser comprovada a existência 
da assistência técnica local no domicílio da contratante e na modalidade on-
site, devendo essa ser realizada por meio de documentação oficial do 
fabricante dos produtos e de domínio público, através de catálogos, folder 
impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a 
comprovação através da apresentação de documentação expressa do 
fabricante dos equipamentos, indicando a referida assistência técnica que 
será responsável pelo atendimento e manutenção durante o período de 
garantia dos produtos ofertados. Em caso de documentação expressa do 
fabricante a esta deverá ser anexada uma procuração que comprove que a 
fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas.

6. Todos os componentes instalados ou integrados dos equipamentos devem 
ser do próprio fabricante ou estar em conformidade com a política de garantia 
do mesmo, não sendo permitida a integração de itens de terceiros que 
possam acarretar em perda parcial da garantia ou não realização da 
manutenção técnica pelo próprio fabricante quando solicitada.
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Documento Confidencial - Somente para uso interno
MODELO  - QUANTIDADE:  XX unidades

ITEM AÇÃO OBSERVAÇÕES JUSTIFICATIVA / QUESTIONAMENTO
ITEM 06 – LICENÇAS ADICIONAIS PARA CONTROLADORA WLAN
Características técnicas mínimas

4. Deve ser compatível com controladora WLAN especificada nesse edital;

GARANTIA E SUPORTE

3. Licença para expansão da CONTROLADORA WLAN, contemplando o 
quantitativo adicional mínimo de 1 (um) ponto de acesso simultâneo;

5. Cada unidade deve ser fornecida com todas as licenças de software 
necessárias para o funcionamento integral de todas as funcionalidades 
disponíveis para CONTROLADORA WLAN especificada nesse edital.

6.Garantia e suporte do fabricante para a solução de software ofertada pelo 
período mínimo de 36 (sessenta) meses, incluindo a evolução para novas 
versões devendo o atendimento ser na modalidade 24x7 (vinte quatro horas 
por dia, sete dias da semana), com tempo de resposta máximo em 4 (quatro) 
horas.

7.Caso a garantia padrão do fabricante seja menor que a exigida, a 
proponente deverá informar em sua proposta o código de serviço de garantia 
do fabricante (“part number”), incorporada à solução.

8. O fabricante deve possuir canais de comunicação e ferramentas adicionais 
para suporte técnico online como “chat” e “e-mail” em seu site da internet 
com disponibilidade ainda de área para cadastro da solução de software 
ofertada, possibilitando assim que a CONTRATANTE possa receber de forma 
proativa, durante todo período da garantia as notificações de atualizações e 
correções (“hotfix”) da solução;

9. A empresa fabricante da solução de software deverá dispor de um número 
telefônico tipo 0800 para suporte técnico e abertura de chamados técnicos.

10. A comprovação da modalidade da garantia deverá ocorrer através de 
documentação do fabricante de domínio público, não sendo aceita 
documentação emitida pelo fornecedor ou centro de distribuição para fins de 
comprovação que por ventura conflitem com catálogos, manuais, folders 
oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados 
anteriormente, será possível a comprovação através da apresentação de 
documentação expressa do fabricante dos softwares, indicando o período de 
garantia dos produtos ofertados. Em caso de documentação expressa do 
fabricante deverá ser anexada a mesma a procuração que comprove que a 
fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas.
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Documento Confidencial - Somente para uso interno
AP130  - QUANTIDADE:  XX unidades

ITEM AÇÃO OBSERVAÇÕES JUSTIFICATIVA / QUESTIONAMENTO
ITEM 07 – PONTO DE ACESSO INTERNO TIPO 01
Características gerais

a. IEEE 802.11a;
b. IEEE 802.11b;
c. IEEE 802.11g;
d. IEEE 802.11n;
e. IEEE 802.11d;
f. IEEE 802.11ac;
g. WPA® Enterprise/Personal;
h. WPA2® Enterprise/Personal;
i. EAP-TLS;
j. EAP-TTLS/MSCHAPv2;
k. PEAPv0/EAP-MSCHAPv2;
l. PEAPv1/EAP-GTC;
m. EAP-SIM;
n. EAP-FAST;
o. WMM® e WMM® Power Save;
p. Beamforming;
q. Short Guard Interval (SGI);
r. Packet Aggregation (A-MPDU);
s. Opportunistic Key Caching (OKC) Retirar

4. Deve operar simultaneamente em 2.4GHz e 5GHz (concurrent dual-band);

Performance

6. Deve suportar capacidade de 1300 Mbps de throughput ou superior; Alterar

Retirar

Alterar

11. Deve suportar no mínimo as bandas de frequência:
a. 2,400 a 2,4835 GHz
b. 5.150 a 5.250 GHz
c. 5,25 a 5,350 GHz
d. 5,470 a 5,725 GHz
e. 5,725 a 5,850 GHz

13. Deve suportar, no mínimo, as seguintes tecnologias de rádio:
a. 802.11b: espectro espalhável de sequência direta (DSSS)
b. 802.11a/g/n/ac: multiplexação por divisão de frequência ortogonal (OFDM)
14. Deve suportar, no mínimo, os seguintes tipos de modulação:

Alterar

a. Faixa de 2,4 GHz: +18 dBm por corrente, agregado de +21 dBm (2x2) Alterar

b. Banda de 5 GHz: +18 dBm por corrente, agregado de +21 dBm (2x2) Alterar

Retirar

Alterar

Alterar 20. Deve suportar Short guard interval;

23. Deve suportar Transmit beam-forming (TxBF);

24. Deve possuir, no mínimo, as seguintes taxas de dados suportadas (Mbps):

a. 802.11b: 1, 2, 5.5, 11
b. 802, 11a / g: 6, 9, 12, 18, 24, 36, 48, 54
c. 802.11n (2.4GHz): 6.5 a 300 (MCS0 a MCS15)
d. 802.11ac: 6.5 a 867 (MCS0 a MCS9, NSS = 1 a 2 for VHT20/40/80
25. Deve possuir suporte a 802.11n de alto rendimento (HT): HT 20/40

26. Deve possuir suporte a 802.11ac de alta velocidade (VHT): VHT 20/40/80

Gerenciamento

Retirar

Retirar

Retirar

Retirar

Alterar

Alterar

37. Deve possuir servidor DHCP interno configurável;

38. Possibilitar backup e restore da configuração através da interface gráfica;

1. Equipamento de Ponto de Acesso para rede local sem fio, configurável via 
software, com funcionamento simultâneo nos padrões IEEE 802.11a/n/ac, 
5GHz, e IEEE 802.11b/g/n, 2.4GHz;

2. Todos os Pontos de acesso sem fio deverão ser novos e sem nenhum 
histórico de utilização;
3. Os pontos de acesso deverão possuir certificado emitido pelo “WIFI 
Alliance” comprovando no mínimo os seguintes padrões, protocolos e 
funcionalidades:

5. Deve suportar rádio dual, 5 GHz 802.11ac 2x2 MIMO e 2.4GHz 802.11n 2x2 
MIMO

6. Deve suportar capacidade de 1100 Mbps de 
throughput ou superior;

7. Deve possuir rádio duplo configurável pelo software suportando 5 GHz e 2,4 
GHz;

8. Deve possuir no mínimo dois spatial stream Single User (SU) MIMO para 
taxa de dados sem fio de até 867 Mbps para dispositivos cliente individuais 
(VHT80) 2x2 em 5GHz;

9. Deve possuir no mínimo dois spatial stream Single User (SU) MIMO para 
uma taxa de dados sem fio de até 400 Mbps para dispositivos clientes 
compatíveis (2x2 VHT40) em 5GHz;

9. Deve possuir no mínimo dois spatial stream Single 
User (SU) MIMO para uma taxa de dados sem fio de até 
300 Mbps para dispositivos clientes compatíveis (2x2 

VHT40) em 2,4GHz;

10. Deve possuir suporte para até 255 dispositivos cliente associados por 
rádio e até 16 BSSIDs por rádio;

12. Deve possuir suporte a seleção de frequência dinâmica (DFS) otimizando o 
uso do espectro de RF disponível;

a. 802.11b: BPSK, QPSK, CCK 802.11a/g/n/ac: b. BPSK, QPSK, 16-QAM, 64-
QAM, 256-QAM
15. Deve possuir potência de transmissão configurável em incrementos de 0,5 
dBm.

15. Deve possuir potência de transmissão configurável 
em incrementos de 1,0 dBm.

16. Deve respeitar os limites de potência de transmissão máxima (conduzida):

a. Faixa de 2,4 GHz: +18 dBm por corrente ou 
agregado de +21 dBm (2x2)

b. Banda de 5 GHz: +18 dBm por corrente ou agregado 
de +21 dBm (2x2)

17. Deve suportar Advanced Cellular Coexistence (ACC) minimizando a 
interferência das redes celulares;
18. Deve suportar Maximum ratio combining (MRC) para melhorar o 
desempenho do receptor;

19. Deve suportar Cyclic delay/shift diversity (CDD/CSD) para melhorar o 
desempenho RF de downlink;

19. Deve suportar Cyclic delay/shift diversity 
(CDD/CSD) ou beamforming para melhorar o 

desempenho RF de downlink;
20. Deve suportar Short guard interval para canais de 20MHz, 40MHz e 
80MHz;
21. Deve suportar Space-time block coding (STBC) para aumentar o alcance e 
melhorar a recepção;

22. Deve suportar Verificação de paridade de baixa densidade (LDPC) para 
correção de erros de alta eficiência e aumento da taxa de transferência;

27. Deve possuir suporte a agregação de pacotes 802.11n/ac: A-MPDU, A-
MSDU

28. Deve implementar funcionamento de modo auto gerenciado, sem 
necessidade de controladora WLAN para configuração de seus parâmetros de 
rede wireless, gerenciamento das políticas de segurança, QoS e 
monitoramento de RF.

29. Deve obedecer à todas as características descritas mesmo neste modo de 
funcionamento;

30. No modo de funcionamento auto gerenciado deve disponibilizar na 
interface gráfica informações de usuários conectados, qualidade de sinal e 
trafego de dados na rede;

31. O ponto de acesso deve permitir a conversão de modo auto gerenciado 
para modo gerenciado por controlador WLAN através de interface gráfica, em 
browser padrão (HTTPS), e permitir que todos os demais pontos de acesso 
pertencentes ao mesmo cluster, também sejam convertidos automaticamente;

32. O ponto de acesso deverá suportar conexão direta ou remota com 
controlador WLAN, inclusive via roteamento da camada de rede, baseado no 
modelo OSI;

33. Se um controlador WLAN falhar, os Pontos de Acesso relacionados deverão 
se associar automaticamente a um controlador WLAN alternativo, não 
permitindo que a rede wireless se torne inoperante;

33. Se um controlador WLAN falhar, os Pontos de 
Acesso relacionados deverão se associar 

automaticamente a um controlador WLAN alternativo, 
podendo ser em camada de virtualização, não 

permitindo que a rede wireless se torne inoperante;

34. Implementar mecanismo de funcionamento para trabalhar com 
controladores WLAN em redundância;

34. Implementar mecanismo de funcionamento para 
trabalhar em alta disponibilidade;

35. Deve permitir que o ponto de acesso seja atualizado de forma centralizada 
pela interface gráfica;

36. Permitir o armazenamento de sua configuração em memória não volátil, 
podendo, numa queda e posterior restabelecimento da alimentação, voltar à 
operação normalmente na mesma configuração anterior;

39. Deve possuir Portal Captivo (Captive Portal) integrado para utilização em 
rede de visitantes;
40. Deve possuir mecanismos para proteção contra Pontos de Acesso não 
autorizados (Rogues);
41. Possuir capacidade de identificação e listagem dos rádios vizinhos e 
respectivos SSID/BSSID;
42. Implementar associação dinâmica de usuários à VLANs com base nos 
parâmetros da etapa de autenticação;

43. Deve possuir uma base de usuários interna que diferencie usuários 
visitantes de funcionários, para ser usada em autenticação 802.1x ou portal 
captivo;
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a. MAC Address b. 802.1x em base Local
c. Captive Portal
d. 802.1x em base externa RADIUS
e. 802.1x em base externa LDAP

49. Permitir habilitar e desabilitar a divulgação do SSID;

54. Implementar VLANs conforme padrão IEEE 802.1Q;

57. Implementar cliente DHCP, para configuração automática de rede;
58. Deve configurar-se automaticamente ao ser conectado na rede;

Alterar

62. Permitir o bloqueio da configuração do Ponto de Acesso via rede wireless;

64. Implementar IEEE 802.1x, com pelo menos os seguintes métodos EAP:

a. EAP- MD5 Retirar
b. EAP-FAST
c. EAP-TLS
d. PEAP-GTC
e. PEAP-MSCHAPv2

68. Implementar WPA com algoritmo de criptografia TKIP e MIC;

75. Possibilitar roaming na rede wireless;

81. Suportar operação em humidade de 5% a 95% sem condensação;

Retirar

Garantia e Suporte

incorporada à solução.

44. Permitir a autenticação para acesso dos usuários conectados nas redes 
WLAN (Wireless) através:

45. Deve permitir a seleção/uso de servidor de autenticação específico com 
base no SSID;
46. Implementar o protocolo de enlace CSMA/CA para acesso ao meio de 
transmissão;
47. Possuir capacidade de selecionar automaticamente o canal de 
transmissão;
48. Permitir o ajuste dinâmico de nível de potência e canal de rádio de modo a 
otimizar o tamanho da célula de RF;

50. Implementar diferentes tipos de combinações encriptação/autenticação 
por SSID;

51. Implementar padrão WMM da Wi-Fi Alliance para priorização de tráfego, 
suportando aplicações em tempo real, tais como, VoIP, vídeo, dentre outras;

52. Não deve haver no licenciamento restrições com relação ao número de 
dispositivos conectados por ponto de acesso;
53. Implementar a pilha de protocolos TCP/IP com suporte a IPV4 e IPV6 
(Bridging);

55. Possuir, no mínimo, uma interface IEEE 802.3 10/100/1000BaseT Ethernet, 
auto- sensing, auto MDI/MDX;
56. Permitir a atualização remota do sistema operacional e arquivos de 
configuração através da controladora WLAN

59. Possuir LED’s indicativos do estado de operação, da atividade do rádio e 
da interface Ethernet;

59. Possuir LED’s ou LED indicativo do estado de 
operação do ponto de acesso;

60. Possuir estrutura que permita fixação do equipamento em teto e parede e 
fornecer acessórios para que possa ser feita a fixação;

61. Deve ser acompanhado de todos os acessórios necessários para 
operacionalização do equipamento, tais como: softwares, cabos de console, 
cabos de energia elétrica, documentação técnica e manuais (podendo ser em 
CD-ROM) que contenham informações suficientes para possibilitar a 
instalação, configuração e operacionalização do equipamento;

63. Implementar varredura de RF nas bandas 802.11a, 802.11b, 802.11g, 
802.11n, para identificação de Pontos de Acesso intrusos não autorizados 
(rogues) e interferências no canal habilitado ao ponto de acesso e nos demais 
canais configurados na rede WLAN, sem impacto no seu desempenho;

65. Permitir a integração com RADIUS Server com suporte aos métodos EAP 
citados;
66. A comunicação entre todos os pontos de acesso sem fio e a controladora 
deverá ser criptografada;
67. Suportar a autenticação com geração dinâmica de chaves criptográficas 
por sessão e por usuário;

69. Implementar WPA2 com algoritmo de criptografia AES, 128/256 bits, IEEE 
802.11i;

70. Deve possuir modo dedicado de funcionamento de análise de espectro das 
faixas de frequência de 2.4 e 5 GHz identificando fontes de interferência 
nessas faixas;

71. Deve possibilitar analise de espectro nos canais em que estiver provendo 
acesso, sem desconectar os usuários;
72. Deve disponibilizar informações gráficas de análise de espectro em 
conjunto com o controlador WLAN;
73. O equipamento deverá possuir registro na ANATEL e deverá ser 
apresentado na entrega do equipamento;
74. Deverá prover priorização de trafego de vídeo e voz através de 
parâmetros de QoS (Quality os Service) com possibilidade de aplicar por SSID 
e dispositivo;

76. Suportar a criação de uma rede de convidados autocontida com 
isolamento de tráfego entre clientes e serviços locais;

77. Possuir recursos de seleção automática de canal de transmissão 
procurando por canais onde haja menor interferência, tendo por objetivo 
melhorar a performance da rede wireless;

78. Permitir a operação em estrutura Mesh viabilizando a comunicação direta 
entre diferentes Pontos de Acesso sem Fio onde não seja possível estender a 
rede cabeada;

79. Operando em estrutura Mesh, a comunicação entre os dispositivos 
estrutura deverão operar na frequência de 5Ghz.
80. Possuir mecanismo para a restauração das configurações originais de 
fábrica fisicamente no equipamento (reset);

82. Suportar operação em temperatura de até 40°C (quarenta graus 
centígrados);
83. Possuir um MTBF (Mean Time Between Failure - Período Médio entre 
Falhas) de, no mínimo, 250.000 horas.

1. O equipamento ofertado deverá possuir garantia do fabricante na 
modalidade on-site pelo período mínimo de 60 (sessenta) meses para 
reposição de peças, mão de obra e

atendimento. O prazo máximo para atendimento do chamado deve ser de até 
o próximo dia útil após a sua abertura. Durante o período da garantia o prazo 
máximo para o reparo de equipamentos defeituosos a condição normal de 
funcionamento deverá ser de até 07 (sete) dias úteis.

2. Caso a garantia padrão do fabricante seja menor que a exigida, a 
proponente deverá informar em sua proposta o código de serviço de garantia 
do fabricante (“part number”),

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais 
para suporte técnico online como “chat” e “e-mail” em seu site da internet 
com disponibilidade ainda de área para cadastro da solução de hardware 
ofertada, possibilitando assim que a CONTRATANTE possa receber de forma 
proativa, durante todo período da garantia as notificações de atualizações e 
correções (“hotfix”) da solução;

4. A empresa fabricante do equipamento deverá dispor de um número 
telefônico tipo 0800 para suporte técnico e abertura de chamados técnicos.

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento 
e solução exigidos para os equipamentos, deverá ser comprovada a existência 
da assistência técnica local no domicílio da contratante e na modalidade on-
site, devendo essa ser realizada por meio de documentação oficial do 
fabricante dos produtos e de domínio público, através de catálogos, folder 
impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a 
comprovação através da apresentação de documentação expressa do 
fabricante dos equipamentos, indicando a referida assistência técnica que 
será responsável pelo atendimento e manutenção durante o período de 
garantia dos produtos ofertados. Em caso de documentação expressa do 
fabricante a esta deverá ser anexada uma procuração que comprove que a 
fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas.

6.Todos os componentes instalados ou integrados dos equipamentos devem 
ser do próprio fabricante ou estar em conformidade com a política de garantia 
do mesmo, não sendo permitida a integração de itens de terceiros que 
possam acarretar em perda parcial da garantia ou não realização da 
manutenção técnica pelo próprio fabricante quando solicitada.
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Documento Confidencial - Somente para uso interno
AP650 - QUANTIDADE:  XX unidades

ITEM AÇÃO OBSERVAÇÕES JUSTIFICATIVA / QUESTIONAMENTO
ITEM 08 – PONTO DE ACESSO INTERNO TIPO 02
Características gerais

a. IEEE 802.11a;
b. IEEE 802.11b;
c. IEEE 802.11g;
d. IEEE 802.11n;
e. IEEE 802.11d;
f. IEEE 802.11ac;
g. WPA® Enterprise/Personal;
h. WPA2® Enterprise/Personal;
i. EAP-TLS;
j. EAP-TTLS/MSCHAPv2;
k. PEAPv0/EAP-MSCHAPv2;
l. PEAPv1/EAP-GTC;
m. EAP-SIM;
n. EAP-FAST;
o. WMM® e WMM® Power Save;
p. Beamforming;
q. Short Guard Interval (SGI);
r. Packet Aggregation (A-MPDU);

s. Opportunistic Key Caching (OKC) Retirar

4. Deve operar simultaneamente em 2.4GHz e 5GHz (concurrent dual-band);

Performance

Retirar

10. Deve suportar no mínimo as bandas de frequência:
a. 2,400 a 2,4835 GHz
b. 5.150 a 5.250 GHz
c. 5.250 a 5.350 GHz
d. 5,470 a 5,725 GHz
e. 5,725 a 5,850 GHz

12. Deve suportar, no mínimo, as seguintes tecnologias de rádio:
a. 802.11b: espectro espalhável de sequência direta (DSSS);

13. Deve suportar, no mínimo, os seguintes tipos de modulação:
a. 802.11b: BPSK, QPSK, CCK;
b. 802.11a / g / n / ac: BPSK, QPSK, 16-QAM, 64-QAM, 256-QAM;

Alterar

15. Deve respeitar os limites de potência de transmissão máxima (conduzida):

a. Faixa de 2,4 GHz: +18 dBm por corrente, agregado de +24 dBm (3x3); Alterar

b. Faixa de 5 GHz: +18 dBm por corrente, agregado de +24 dBm (4x4); Alterar

Retirar

Alterar

Alterar 19. Deve suportar Short guard interval;

22. Deve suportar Transmit beam-forming (TxBF);

23. Deve possuir, no mínimo, as seguintes taxas de dados suportadas (Mbps):

a. 802.11b: 1, 2, 5.5, 11
b. 802.11a/g: 6, 9, 12, 18, 24, 36, 48, 54
c. 802.11n: 6.5 até 450 (MCS0 até MCS23)
d. 802.11ac: 6.5 até 1,733 (MCS0 até MCS9, NSS = 1 até 4)
24. 802.11n de alto rendimento (HT): HT 20/40;

25. Deve possuir suporte a 802.11ac de alta velocidade (VHT): VHT 20/40/80;

Gerenciamento

Retirar

Retirar

Retirar

Retirar

Alterar

Alterar

1. Equipamento de Ponto de Acesso para rede local sem fio, configurável via 
software, com funcionamento simultâneo nos padrões IEEE 802.11a/n/ac, 
5GHz, e IEEE 802.11b/g/n, 2.4GHz;

2. Todos os Pontos de acesso sem fio deverão ser novos e sem nenhum 
histórico de utilização;

3. Os pontos de acesso deverão possuir certificado emitido pelo “WIFI 
Alliance” comprovando no mínimo os seguintes padrões, protocolos e 
funcionalidades:

5. Deve suportar rádio dual, 5 GHz 802.11ac 4x4 MIMO e 2.4 GHz 802.11n 2x2 
MIMO;
6. Deve possuir rádio duplo configurável pelo software, suportando 5 GHz e 
2,4 GHz;
7. Deve possuir quatro spatial stream Single User (SU) MIMO para taxa de 
dados sem fio de até 1,733 Mbps, em 5GHz;

8. Deve possuir três spatial stream Multi User (MU) MIMO para uma taxa de 
dados sem fio de até 1,300 Mbps para dispositivos clientes compatíveis, em 
5GHz;

9. Deve possuir suporte para até 255 dispositivos cliente associados por rádio 
e até 16 BSSIDs por rádio;

11. Deve possuir suporte a seleção de frequência dinâmica (DFS) otimizando o 
uso do espectro de RF disponível;

b. 802.11a / g / n / ac: multiplexação por divisão de frequência ortogonal 
(OFDM);

14. Deve possuir potência de transmissão configurável em incrementos de 0,5 
dBm;

14. Deve possuir potência de transmissão configurável 
em incrementos de 1,0 dBm;

a. Faixa de 2,4 GHz: +18 dBm por corrente ou 
agregado de +24 dBm (3x3);

b. Faixa de 5 GHz: +18 dBm por corrente ou agregado 
de +24 dBm (4x4);

16. Deve suportar Advanced Cellular Coexistence (ACC) minimizando a 
interferência das redes celulares;
17. Deve suportar Maximum Ratio Combining (MRC) para melhorar o 
desempenho do receptor;

18. Deve suportar Cyclic delay/shift diversity (CDD/CSD) para melhorar o 
desempenho RF de downlink;

18. Deve suportar Cyclic delay/shift diversity 
(CDD/CSD) ou beamforming para melhorar o 

desempenho RF de downlink;
19. Deve suportar Short guard interval para canais de 20-MHz, 40-MHz e 80-
MHz;
20. Deve suportar Space-time block coding (STBC) para aumentar o alcance e 
melhorar a recepção;

21. Deve suportar verificação de paridade de baixa densidade (LDPC) para 
correção de erros de alta eficiência e aumento da taxa de transferência;

26. Deve possuir suporte a agregação de pacotes 802.11n/ac: A-MPDU, A-
MSDU;

27. Deve implementar funcionamento de modo auto gerenciado, sem 
necessidade de controladora WLAN para configuração de seus parâmetros de 
rede wireless, gerenciamento das políticas de segurança, QoS e 
monitoramento de RF.

28. Deve obedecer a todas as características descritas mesmo neste modo de 
funcionamento;

29. No modo de funcionamento autogerenciado deve disponibilizar na 
interface gráfica informações de usuários conectados, qualidade de sinal e 
trafego de dados na rede;

30. O ponto de acesso deve permitir a conversão de modo auto gerenciado 
para modo gerenciado por controlador WLAN através de interface gráfica, em 
browser padrão (HTTPS), e permitir que todos os demais pontos de acesso 
pertencentes ao mesmo cluster, também sejam convertidos automaticamente;

31. O ponto de acesso deverá suportar conexão direta ou remota com 
controlador WLAN, inclusive via roteamento da camada de rede, baseado no 
modelo OSI;

32. Se um controlador WLAN falhar, os Pontos de Acesso relacionados deverão 
se associar automaticamente a um controlador WLAN alternativo, não 
permitindo que a rede wireless se torne inoperante;

32. Se um controlador WLAN falhar, os Pontos de 
Acesso relacionados deverão se associar 

automaticamente a um controlador WLAN alternativo, 
podendo ser em camada de virtualização, não 

permitindo que a rede wireless se torne inoperante;

33. Implementar mecanismo de funcionamento para trabalhar com 
controladores WLAN em redundância;

33. Implementar mecanismo de funcionamento para 
trabalhar em alta disponibilidade;

34. Deve permitir que o ponto de acesso seja atualizado de forma centralizada 
pela interface gráfica;

35. Permitir o armazenamento de sua configuração em memória não volátil, 
podendo, numa queda e posterior restabelecimento da alimentação, voltar à 
operação normalmente na mesma configuração anterior;
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36. Deve possuir servidor DHCP interno configurável;

37. Possibilitar backup e restore da configuração através da interface gráfica;

a. MAC Address
b. 802.1x em base Local
c. Captive Portal
d. 802.1x em base externa RADIUS
e. 802.1x em base externa LDAP

48. Permitir habilitar e desabilitar a divulgação do SSID;

53. Implementar VLANs conforme padrão IEEE 802.1Q;

56. Implementar cliente DHCP, para configuração automática de rede;
57. Deve configurar-se automaticamente ao ser conectado na rede;

Alterar

61. Permitir o bloqueio da configuração do Ponto de Acesso via rede wireless;

63. Implementar IEEE 802.1x, com pelo menos os seguintes métodos EAP:

a. EAP- MD5 Retirar

b. EAP-FAST
c. EAP-TLS
d. PEAP-GTC
e. PEAP-MSCHAPv2

67. Implementar WPA com algoritmo de criptografia TKIP e MIC;

Em fase final de homologação

74. Possibilitar roaming na rede wireless;

80. Suportar operação em humidade de 5% a 95% sem condensação;

Retirar

Garantia e Suporte

38. Deve possuir Portal Captivo (Captive Portal) integrado para utilização em 
rede de visitantes;
39. Deve possuir mecanismos para proteção contra Pontos de Acesso não 
autorizados (Rogues);
40. Possuir capacidade de identificação e listagem dos rádios vizinhos e 
respectivos SSID/BSSID;
41. Implementar associação dinâmica de usuários à VLANs com base nos 
parâmetros da etapa de autenticação;
42. Deve possuir uma base de usuários interna que diferencie usuários 
visitantes de funcionários, para ser usada em autenticação 802.1x ou portal 
captivo;
43. Permitir a autenticação para acesso dos usuários conectados nas redes 
WLAN (Wireless) através:

44. Deve permitir a seleção/uso de servidor de autenticação específico com 
base no SSID;
45. Implementar o protocolo de enlace CSMA/CA para acesso ao meio de 
transmissão;
46. Possuir capacidade de selecionar automaticamente o canal de 
transmissão;
47. Permitir o ajuste dinâmico de nível de potência e canal de rádio de modo a 
otimizar o tamanho da célula de RF;

49. Implementar diferentes tipos de combinações encriptação/autenticação 
por SSID;

50. Implementar padrão WMM da Wi-Fi Alliance para priorização de tráfego, 
suportando aplicações em tempo real, tais como, VoIP, vídeo, dentre outras;

51. Não deve haver no licenciamento restrições com relação ao número de 
dispositivos conectados por ponto de acesso;
52. Implementar a pilha de protocolos TCP/IP com suporte a IPV4 e IPV6 
(Bridging);

54. Possuir, no mínimo, uma interface IEEE 802.3 10/100/1000BaseT Ethernet, 
auto- sensing, auto MDI/MDX;
55. Permitir a atualização remota do sistema operacional e arquivos de 
configuração através da controladora WLAN

58. Possuir LED’s indicativos do estado de operação, da atividade do rádio e 
da interface Ethernet;

58. Possuir LED’s ou LED indicativo do estado de 
operação do ponto de acesso;

59. Possuir estrutura que permita fixação do equipamento em teto e parede e 
fornecer acessórios para que possa ser feita a fixação;

60. Deve ser acompanhado de todos os acessórios necessários para 
operacionalização do equipamento, tais como: softwares, cabos de console, 
cabos de energia elétrica, documentação técnica e manuais (podendo ser em 
CD-ROM) que contenham informações suficientes para possibilitar a 
instalação, configuração e operacionalização do equipamento;

62. Implementar varredura de RF nas bandas 802.11a, 802.11b, 802.11g, 
802.11n, para identificação de Pontos de Acesso intrusos não autorizados 
(rogues) e interferências no canal habilitado ao ponto de acesso e nos demais 
canais configurados na rede WLAN, sem impacto no seu desempenho;

64. Permitir a integração com RADIUS Server com suporte aos métodos EAP 
citados;
65. A comunicação entre todos os pontos de acesso sem fio e a controladora 
deverá ser criptografada;
66. Suportar a autenticação com geração dinâmica de chaves criptográficas 
por sessão e por usuário;

68. Implementar WPA2 com algoritmo de criptografia AES, 128/256 bits, IEEE 
802.11i;

69. Deve possuir modo dedicado de funcionamento de análise de espectro das 
faixas de frequência de 2.4 e 5 GHz identificando fontes de interferência 
nessas faixas;

70. Deve possibilitar analise de espectro nos canais em que estiver provendo 
acesso, sem desconectar os usuários;
71. Deve disponibilizar informações gráficas de análise de espectro em 
conjunto com o controlador WLAN;
72. O equipamento deverá possuir registro na ANATEL e deverá ser 
apresentado na entrega do equipamento;

73. Deverá prover priorização de trafego de vídeo e voz através de 
parâmetros de QoS (Quality os Service) com possibilidade de aplicar por SSID 
e dispositivo;

75. Suportar a criação de uma rede de convidados autocontida com 
isolamento de tráfego entre clientes e serviços locais;

76. Possuir recursos de seleção automática de canal de transmissão 
procurando por canais onde haja menor interferência, tendo por objetivo 
melhorar a performance da rede wireless;

77. Permitir a operação em estrutura Mesh viabilizando a comunicação direta 
entre diferentes Pontos de Acesso sem Fio onde não seja possível estender a 
rede cabeada;

78. Operando em estrutura Mesh, a comunicação entre os dispositivos 
estrutura deverão operar na frequência de 5Ghz.
79. Possuir mecanismo para a restauração das configurações originais de 
fábrica fisicamente no equipamento (reset);

81. Suportar operação em temperatura de até 40°C (quarenta graus 
centígrados);
82. Possuir um MTBF (Mean Time Between Failure - Período Médio entre 
Falhas) de, no mínimo, 250.000 horas.

1. O equipamento ofertado deverá possuir garantia do fabricante na 
modalidade on-site pelo período mínimo de 60 (sessenta) meses para 
reposição de peças, mão de obra e atendimento. O prazo máximo para 
atendimento do chamado deve ser de até o próximo dia útil após a sua 
abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de 
até 07 (sete) dias úteis.

2. Caso a garantia padrão do fabricante seja menor que a exigida, a 
proponente deverá informar em sua proposta o código de serviço de garantia 
do fabricante (“part number”), incorporada à solução.

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais 
para suporte técnico online como “chat” e “e-mail” em seu site da internet 
com disponibilidade ainda de área para cadastro da solução de hardware 
ofertada, possibilitando assim que a CONTRATANTE possa receber de forma 
proativa, durante todo período da garantia as notificações de atualizações e 
correções (“hotfix”) da solução;

4. A empresa fabricante do equipamento deverá dispor de um número 
telefônico tipo 0800 para suporte técnico e abertura de chamados técnicos.
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5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento 
e solução exigidos para os equipamentos, deverá ser comprovada a existência 
da assistência técnica local no domicílio da contratante e na modalidade on-
site, devendo essa ser realizada por meio de documentação oficial do 
fabricante dos produtos e de domínio público, através de catálogos, folder 
impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a 
comprovação através da apresentação de documentação expressa do 
fabricante dos equipamentos, indicando a referida assistência técnica que 
será responsável pelo atendimento e manutenção durante o período de 
garantia dos produtos ofertados. Em caso de documentação expressa do 
fabricante a esta deverá ser anexada uma procuração que comprove que a 
fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas.

6. Todos os componentes instalados ou integrados dos equipamentos devem 
ser do próprio fabricante ou estar em conformidade com a política de garantia 
do mesmo, não sendo permitida a integração de itens de terceiros que 
possam acarretar em perda parcial da garantia ou não realização da 
manutenção técnica pelo próprio fabricante quando solicitada.
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Documento Confidencial - Somente para uso interno
MODELO  - QUANTIDADE:  XX unidades

ITEM ATENDE AÇÃO OBSERVAÇÕES
ITEM 09 – INJETOR POE PARA PONTOS DE ACESSO TIPO 1
Características técnicas mínimas

2. Injetor PoE 802.3af 10/100/1000 Ethernet com 15.4W;
Garantia e Suporte

1. Deve ser do mesmo fabricante dos Pontos de acesso ou homologado e 
certificado pelo mesmo para utilização em seus equipamentos;

1.O equipamento ofertado deverá possuir garantia do fabricante do 
equipamento na modalidade on-site pelo período mínimo de 12 (doze) meses 
para reposição de peças, mão de obra e atendimento no local. O período da 
garantia o prazo máximo para o reparo de equipamentos defeituosos a 
condição normal de funcionamento deverá ser de até 07 (sete) dias úteis;

2. Caso a garantia padrão do fabricante seja menor que a exigida, a 
proponente deverá informar em sua proposta o código de serviço de garantia 
do fabricante (part number), incorporado ao equipamento;

3. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do 
próprio fabricante ou estar em conformidade com a política de garantia do 
mesmo, não sendo permitida a integração de itens de terceiros que possam 
acarretar em perda parcial da garantia ou não realização da manutenção 
técnica pelo próprio fabricante quando solicitada.
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Documento Confidencial - Somente para uso interno
MODELO  - QUANTIDADE:  XX unidades

ITEM ATENDE AÇÃO OBSERVAÇÕES
ITEM 10 – INJETOR POE PARA PONTOS DE ACESSO TIPO 2
Características técnicas mínimas

2. Injetor PoE+ 802.3at 10/100/1000 Ethernet com 30W;
Garantia e Suporte

1. Deve ser do mesmo fabricante dos Pontos de acesso ou homologado e 
certificado pelo mesmo para utilização em seus equipamentos;

1.O equipamento ofertado deverá possuir garantia do fabricante do 
equipamento na modalidade on-site pelo período mínimo de 12 (doze) meses 
para reposição de peças, mão de obra e atendimento no local. O período da 
garantia o prazo máximo para o reparo de equipamentos defeituosos a 
condição normal de funcionamento deverá ser de até 07 (sete) dias úteis;

2.Caso a garantia padrão do fabricante seja menor que a exigida, a 
proponente deverá informar em sua proposta o código de serviço de garantia 
do fabricante (part number), incorporado ao equipamento;

3. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do 
próprio fabricante ou estar em conformidade com a política de garantia do 
mesmo, não sendo permitida a integração de itens de terceiros que possam 
acarretar em perda parcial da garantia ou não realização da manutenção 
técnica pelo próprio fabricante quando solicitada.
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Documento Confidencial - Somente para uso interno
MODELO  - QUANTIDADE:  XX unidades

ITEM ATENDE AÇÃO OBSERVAÇÕES

GERENCIAMENTO
Características Gerais

Implantação

b. Inclusão de no mínimo 10 (dez) pontos de acesso no monitoramento;

Transferência De Tecnologia

b. Configuração de VLANs Globais e Locais em switchs gerenciados;
c. Configuração de ACLS Globais e Locais em switchs gerenciados;
d. Backup e restore de configuração de switchs gerenciados;
e. Monitoramento e alarmes default e customizados;

ITEM 11 – SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA SOLUÇÃO DE

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e 
das 14:00 às 18:00) presencialmente no TRE-AL ou remotamente conforme 
necessidades da CONTRATANTE;

2. Instalação e configuração de 1 (uma) instância do serviço de gerenciamento 
de rede, contemplando:
a. Configurações básicas para acesso à rede, dimensionamento e configuração 
de armazenamento;

c. Criação de modelo de configuração (templates) de forma a possibilitar a 
replicação de configuração entre equipamentos.

3. O treinamento deverá ser no realizado na modalidade workshop com 
tarefas práticas hands-on, visando assim a melhor fixação dos temas 
abordados com foco direto na explicação

da tecnologia da solução como também nas rotinas de configuração, 
gerenciamento, administração e operação da mesma;

O treinamento do MÓDULO DE GERENCIA DE REDE deverá ter duração mínima 
de 24 (vinte e quatro) horas onde será 4. abordado, no mínimo, os seguintes 
tópicos:
a. Inserção, modificação e remoção de dispositivos de forma unitária e em 
lote;

f. Customização do Dashboard com alertas, mapas de topologia e 
monitoramento de dispositivos;
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Documento Confidencial - Somente para uso interno
MODELO  - QUANTIDADE:  XX unidades

ITEM ATENDE AÇÃO OBSERVAÇÕES

Características Gerais

Implantação

Transferência de Tecnologia

a. Configuração de Active Directory como base de autenticação;
b. Configuração de autenticação de usuários corporativos;
c. Configuração de autenticação de usuários visitantes;
d. Configuração de portal de autosserviço;
e. Configuração de autenticação e autorização com protocolo RADIUS.

ITEM 12 - SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e 
das 14:00 às 18:00) presencialmente no TRE-AL ou remotamente conforme 
necessidades da CONTRATANTE;

2. Instalação e configuração de 1 (uma) instancia do serviço controle de 
acesso, contemplando:
a. Configurações básicas para acesso à rede, dimensionamento e configuração 
de armazenamento;
b. Configuração de autenticação em Active Directory para usuários 
corporativos;
c. Configuração de autenticação de visitantes com portal de autosserviço para 
criação de usuários;
d. Configuração de no mínimo 5 (cinco) dispositivos de rede para autenticação 
na solução.

3.O treinamento deverá ser no realizado na modalidade workshop com tarefas 
práticas hands-on, visando assim a melhor fixação dos temas abordados com 
foco direto na explicação da tecnologia da solução como também nas rotinas 
de configuração, gerenciamento, administração e operação da mesma 
devendo ter duração mínima de 24 (vinte e quatro) horas onde será abordado 
no mínimo os seguintes tópicos:
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Documento Confidencial - Somente para uso interno
MODELO  - QUANTIDADE:  XX unidades

ITEM ATENDE AÇÃO OBSERVAÇÕES

Características Gerais

CONTRATANTE;
Implantação

a. Configuração básica de acesso a gerência via rede;

Transferência de Tecnologia

a. Configuração inicial e acesso a gerência;
b. Configuração de Clusters;

d. Criação de SSID com autenticação PSK;

f. Configuração de pontos de acesso para MÓDULO DE GERENCIA DE REDE;

g. Configuração pontos de acesso para MÓDULO DE ANÁLISE DE TRÁFEGO;

ITEM 13 – SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA CONTROLADORA WLAN E PONTOS DE ACESSO

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e 
das 14:00 às 18:00) presencialmente no TRE-AL ou remotamente conforme 
necessidades da CONTRATANTE;

2. Instalação e configuração de no mínimo 10 (dez) pontos de acesso, 
contemplando:

Configuração de gerência e monitoramento em MÓDULO b. DE GERENCIA DE 
REDE;
c. Configuração da autenticação de usuários em MÓDULO DE CONTROLE DE 
ACESSO
d. Configuração de pontos de acesso em controladora WLAN habilitando 
gerenciamento centralizado;

3. O treinamento deverá ser no realizado na modalidade workshop com 
tarefas práticas hands-on, visando assim a melhor fixação dos temas 
abordados com foco direto na explicação da tecnologia dos produtos ofertados 
como também nas rotinas de configuração, gerenciamento, administração e 
operação dos mesmos devendo ter duração mínima de 16 (Dezesseis) horas 
onde será abordado no mínimo os seguintes tópicos:

c. Configuração de autenticação de usuários em MÓDULO DE CONTROLE DE 
ACESSO;

e. Criação de SSID com autenticação enterprise em MÓDULO DE CONTROLE 
DE ACESSO;
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Documento Confidencial - Somente para uso interno
MODELO  - QUANTIDADE:  XX unidades

ITEM ATENDE AÇÃO OBSERVAÇÕES

Características Gerais

8. O voucher deverá ter validade de pelo menos 12 (doze) meses;

14 – TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE ARQUITETURA 
WLAN

7. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do 
fabricante no Treinamento Básico De Administração De Arquitetura Wlan para 
01 (um) profissional da contratante;

9. O treinamento deverá ser de acordo com o calendário de treinamento do 
fabricante e ministrado em centro oficial de treinamento do mesmo ou 
remotamente, utilizando tecnologia de ensino a distância;

10. Deverá ser ministrado por profissional devidamente credenciado junto ao 
fabricante e apto a entregar o respectivo;

11. O treinamento deverá compreender a explicação da tecnologia da solução 
como também das rotinas de configuração, gerenciamento, administração e 
operação da mesma;

12. O treinamento deverá ter carga horária mínima de 20 (vinte) horas, 
ministrado no período de 08:00 às 12:00 e das 14:00 às 18:00.
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Documento Confidencial - Somente para uso interno
MODELO  - QUANTIDADE:  XX unidades

ITEM ATENDE AÇÃO OBSERVAÇÕES
ITEM 15 – TREINAMENTO BÁSICO DA SOLUÇÃO DE GERENCIAMENTO

Características Gerais

2. O voucher deverá ter validade de pelo menos 12 (doze) meses;

1. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do 
fabricante no Treinamento da Solução de Gerenciamento para 01 (um) 
profissional da contratante;

3. O treinamento deverá ser de acordo com o calendário de treinamento do 
fabricante e ministrado em centro oficial de treinamento do mesmo ou 
remotamente, utilizando tecnologia de ensino a distância;

4. Deverá ser ministrado por profissional devidamente credenciado junto ao 
fabricante e apto a entregar o respectivo;

5. O treinamento deverá compreender a explicação da tecnologia da solução 
como também das rotinas de configuração, gerenciamento, administração e 
operação da mesma;

6. O treinamento deverá ter carga horária mínima de 40 (Quarenta) horas, 
ministrado no período de 08:00 às 12:00 e das 14:00 às 18:00.
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Documento Confidencial - Somente para uso interno
MODELO  - QUANTIDADE:  XX unidades

ITEM ATENDE AÇÃO OBSERVAÇÕES

Características Gerais

8. O voucher deverá ter validade de pelo menos 12 (doze) meses;

ITEM 16 – TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE 
ACESSO

7. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do 
fabricante no Treinamento da Solução de Controle de Acesso para 01 (um) 
profissional da contratante;

9. O treinamento deverá ser de acordo com o calendário de treinamento do 
fabricante e ministrado em centro oficial de treinamento do mesmo ou 
remotamente, utilizando tecnologia de ensino a distância;

10. Deverá ser ministrado por profissional devidamente credenciado junto ao 
fabricante e apto a entregar o respectivo;

11. O treinamento deverá compreender a explicação da tecnologia da solução 
como também das rotinas de configuração, gerenciamento, administração e 
operação da mesma;

12. O treinamento deverá ter carga horária mínima de 40 (Quarenta) horas, 
ministrado no período de 08:00 às 12:00 e das 14:00 às 18:00.
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 10 de abril de 2019.
À COINF
 
Recebemos da empresa SmartWave Networks e-mail onde sugere a
análise da unidade requisitante quanto a equipamentos e possíveis
modificações no termo de referência, eventos 0527637, 0527639,
0527640, 0527643, 0527646, 0527647 e 0527651.
 
Encaminhamos a esta Coordenadoria para conhecimento e
deliberação a respeito da demanda apontada.
 
Respeitosamente.

Documento assinado eletronicamente por ANA PAULA GOMES SILVA, Técnico
Judiciário, em 10/04/2019, às 17:33, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0527655 e o código CRC A3D3C0BD.

0008478-63.2018.6.02.8000 0527655v1
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 10 de abril de 2019.
À SEIC
 
Prezados,
 
Em atenção ao Despacho SEIC 0527655, entende

esta unidade técnica que o Termo de Referência, tal como
posto, busca atender demandas do interesse da
Administração, salvo, o que parece não demonstrado pelas
sugestões, doc. 0527637, a ocorrência de vício não
intencional.

 
Atenciosamente.

Documento assinado eletronicamente por DANIEL MACÊDO DE CARVALHO SOUTO,
Coordenador, em 10/04/2019, às 18:37, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0527764 e o código CRC F9E9A023.
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Status da mensagem: Mensagem foi respondida

De: Rafael Lehmkuhl <rafael.lehmkuhl@solonetwork.com.br> 

Para:
TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-
al.jus.br>

Data: 15/04/2019 11:41 AM

Assunto:
[seic] RES: Solicitação. Cotação. Aquisição de componentes de
rede sem fio e cabeada. TREAL

Bom dia,

Agradecemos seu contato. Infelizmente não estamos aptos a atender sua necessidade
neste momento.

Cordialmente.

Rafael Felix Hahn Lehmkuhl - Consultor Comercial
Av. Manoel Ribas, 4.109 | 82025-160 - Cascatinha - Curitiba PR
Tel (41) 3051-7519

-----Mensagem original-----
De: TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-al.jus.br>
Enviada em: terça-feira, 9 de abril de 2019 10:06
Assunto: Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada.
TREAL

Prezado Senhor(a),

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem
fio e cabeada, mediante  sistema de registro de preços, distribuídos em lote 01 e
lote 02, conforme descrição do produto/serviço, quantitativos e demais especificações
constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL seic@tre-al.jus.br anasilva@tre-
al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às
13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL CNPJ nº:
06.015.041/0001-38

WorldClient https://webmail.tre-al.gov.br:3001/WorldClient.dll?Session=FLTUT...
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Telefones: 82 2122-7712/7711
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E-mail - 0529999

Data de Envio: 
  16/04/2019 14:05:48

De: 
  TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-al.jus.br>

Para (com cópia oculta):
    alexandre.barros@g3solutions.com.br
    andre.brasileiro@suporteinformatica.com
    michel@pisontec.com
    guilherme@infiniit.com.br
    bsabino@swt.com.br
    max@plugnetshop.com.br
    pct@pctinformatica.com.br
    maxwell@usetech.net
    olivan@grupoinovva.com.br
    arnaldo.paula@altasnet.com.br

Assunto: 
  Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL

Mensagem: 
  Prezado Senhor(a),

Boa tarde,

Reiteramos pedido de cotação abaixo:

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem fio e cabeada,
mediante sistema de registro de preços, distribuídos em lote 01 e lote 02, conforme descrição do
produto/serviço, quantitativos e demais especificações constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL
seic@tre-al.jus.br
anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL
CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/7711

Anexos:
    Termo_de_Referencia___TIC_0450416.html
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E-mail - 0530016

Data de Envio: 
  16/04/2019 14:18:11

De: 
  TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-al.jus.br>

Para (com cópia oculta):
    gpereira@supriservice.com.br
    comercial@supriservice.com.br
    comercial@telc.com.br
    anderson.marques@hpe.com
    teltec@teltecnetworks.com.br
    vendas@newsupri.com.br
    lofredo@hpe.com
    ronaldo_araujo@hp.com
    max@usetech.net
    plugnet@plugnetshop.com.br
    breno@plugnetshop.com.br
    tatiane.santos2@hpe.com
    junior@newsupri.com.br
    gustavo.pavanelli@gpsit.com.br
    roselene.franca@hp.com
    comercial.vix@ish.com.br
    felipe.vieira@ish.com.br
    contato@7secure.com.br
    contato@ntsec.com.br
    newtechdistribuidora@gmail.com
    guilherme@newsupri.com.br
    gilson.santos@solustecnologia.com.br
    glauber.cordeiro@ingrammicro.com
    mary@7secure.com.br
    comercial@solustecnologia.com.br

Assunto: 
  Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL

Mensagem: 
  Prezado Senhor(a),

Boa tarde,

Reiteramos pedido de cotação abaixo:

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem fio e cabeada,
mediante sistema de registro de preços, distribuídos em lote 01 e lote 02, conforme descrição do
produto/serviço, quantitativos e demais especificações constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL
seic@tre-al.jus.br
anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL
CNPJ nº: 06.015.041/0001-38
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Telefones: 82 2122-7712/7711

Anexos:
    Termo_de_Referencia___TIC_0450416.html
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De: "Breno Tavares" <breno@plugnetshop.com.br> 

Para: seic@tre-al.jus.br

Data: 16/04/2019 02:18 PM

Assunto:
[seic] Alerta de ausência: Re: Solicitação. Cotação. Aquisição de
componentes de rede sem fio e cabeada. TREAL

Estarei ausente no período de 12/04 e 25/04, sem acesso aos e-mails e ao celular.

Retornarei o mais breve possível o seu contato.

Em caso de URGENCIA, favor enviar e-mail para: plugnet@plugnetshop.com.br

--
Plugnet Comércio e Representações Ltda
Breno José de Araújo Tavares
Diretor Comercial
81 98844.0834
81 3426.7006
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De:
"Leonardo Becker (Teltec Solutions)"

<leonardo@teltecsolutions.com.br> 

Para:
TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-
al.jus.br>

Data: 16/04/2019 02:26 PM

Assunto:
[seic] Solicitação.  Cotação.  Aquisição de componentes de rede
sem fio e cabeada. TREAL

Boa tarde.
Informo que não apresentaremos propostas pois esse item não faz parte do nosso
portfólio.
Att.

--
Leonardo Becker
Coordenador Comercial

Teltec Solutions
48 9.9167-2593 | 48 3031-3473

 <http://teltecsolutions.com.br/quem-somos/>

Em 16/04/2019 14:18, "TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES" <seic@tre-al.jus.br>
escreveu:

    Prezado Senhor(a),

    Boa tarde,

    Reiteramos pedido de cotação abaixo:

    O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede
sem fio e cabeada, mediante  sistema de registro de preços, distribuídos em lote 01 e
lote 02, conforme descrição do produto/serviço, quantitativos e demais especificações
constantes do termo de referência em anexo.

    Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

    Atenciosamente.

    Ana Paula Gomes Silva
    Seção de Instrução de Contratações (SEIC) - TRE/AL

seic@tre-al.jus.br
anasilva@tre-al.jus.br

    Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30
às 13:30h.
    Tribunal Regional Eleitoral de Alagoas - TRE/AL.
    Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL
    CNPJ nº: 06.015.041/0001-38
    Telefones: 82 2122-7712/7711
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Status da mensagem: Mensagem foi respondida

De: "Cordeiro, Glauber" <Glauber.Cordeiro@ingrammicro.com> 

Para:
TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-
al.jus.br>

Data: 16/04/2019 02:32 PM

Assunto:
[seic] Solicitação. Cotação. Aquisição de componentes de rede sem
fio e cabeada. TREAL

Prezados,

Informo que recebemos e estamos solicitando os valores junto ao Fabricante.
Obrigado.

Atenciosamente,

Glauber Caminha
Account Manager N/NE
Av. Dr. Chucri Zaidan, 1240 - 21º Andar - Golden Tower 
Morumbi Corporate - São Paulo - SP - CEP 04711-130
Celular +55 81 98125-3342
Geral +55 11 3508-2222
glauber.cordeiro@ingrammicro.com

cid:image001.png@01CFFCF7.BF918360

As informações contidas nesta mensagem e no(s) arquivo(s) anexo(s) são confidenciais e de propriedades da
Ingram Micro e de uso exclusivamente à(s) pessoa(s) e/ou instituição(ões) acima indicada(s) e podem conter
informações confidenciais e/ou privilegiadas. Se você não for o destinatário ou pessoa autorizada a recebê-la,
queira, por favor retorná-la ao remetente e em seguida apagá-la definitivamente. Qualquer uso, cópia ou
divulgação das informações nela contidas, na íntegra ou parcialmente, são proibidas e serão tratadas conforme
legislação vigente.

De: TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-al.jus.br>
Enviado: terça-feira, 16 de abril de 2019 14:18
Assunto: Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL

Prezado Senhor(a),

Boa tarde,

Reiteramos pedido de cotação abaixo:

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem fio e cabeada, mediante 
sistema de registro de preços, distribuídos em lote 01 e lote 02, conforme descrição do produto/serviço,
quantitativos e demais especificações constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.
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Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL
seic@tre-al.jus.br
anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL
CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/7711

As informações con das nesta mensagem e no(s) arquivo(s) anexo(s) são confidenciais e de propriedades da Ingram Micro e de
uso exclusivamente à(s) pessoa(s) e/ou ins tuição(ões) acima indicada(s) e podem conter informações confidenciais e/ou
privilegiadas. Se você não for o des natário ou pessoa autorizada a recebê-la, queira, por favor retorná-la ao remetente e em
seguida apagá-la definitvamente. Qualquer uso, cópia ou digulvação das informações nela con das, na íntegra ou parcialmente,
são proibidas e serão tratadas conforme legislação vigente.
[Ingram_2818e5de]
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E-mail - 0530140

Data de Envio: 
  16/04/2019 15:39:05

De: 
  TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-al.jus.br>

Para:
    hana.oliveira@ish.com.br

Assunto: 
  Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL

Mensagem: 
  Prezada Hana,

Boa tarde,

Conforme contato telefônico há pouco encaminho pedido de cotação abaixo:

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem fio e cabeada,
mediante sistema de registro de preços, distribuídos em lote 01 e lote 02, conforme descrição do
produto/serviço, quantitativos e demais especificações constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL
seic@tre-al.jus.br
anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL
CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/7711

Anexos:
    Termo_de_Referencia___TIC_0450416.html

E-mail SEIC 0530140         SEI 0008478-63.2018.6.02.8000 / pg. 182



De: Luiz Carlos Netto Silva <lsilva@supriservice.com.br> 

Para:
TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-
al.jus.br>

Data: 16/04/2019 04:22 PM

Assunto:
[seic] Solicitação. Cotação. Aquisição de componentes de rede sem
fio e cabeada. TREAL

Boa tarde Ana Paula,,

Agradecemos a oportunidade de apresentar nossas ofertas a este conceituado Tribunal, porém os produtos cotados
não fazem parte de nosso portfólio.

Ficamos a disposição para os esclarecimentos necessários e para novas cotações.

Aproveitamos a oportunidade para registrar nossos protestos de profundo respeito.  

Sds,

Luiz Carlos Netto Silva
Gerente Comercial

Logo 
Assinatura 

Tel: (27)3211-6600 - Cel: (27)98133-0001
Praça San Martin, 84, Sala 105
Praia do Canto – Vitória – ES - 29055-170
lsilva@supriservice.com.br
www.supriservice.com.br

Em ter, 16 de abr de 2019 às 14:18, TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-
al.jus.br> escreveu:

Prezado Senhor(a),

Boa tarde,

Reiteramos pedido de cotação abaixo:

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem fio e cabeada, mediante 
sistema de registro de preços, distribuídos em lote 01 e lote 02, conforme descrição do produto/serviço,
quantitativos e demais especificações constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL
seic@tre-al.jus.br
anasilva@tre-al.jus.br
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Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL
CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/7711

[2] Arquivo: image001.png Tamanho: 4k Tipo de Conteúdo: image/png
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Status da mensagem: Mensagem foi respondida

De: New Tech <newtechdistribuidora@gmail.com> 

Para: Ana Paula Gomes Silva <anasilva@tre-al.jus.br>

Data: 16/04/2019 04:43 PM

Assunto:
Re: [seic] Solicitação. Cotação. Aquisição de componentes de rede
sem fio e cabeada. TREAL

O projeto está dificultando a ampla concorrência uma vez que os itens estão agrupados o que dificilmente
empresas de médio é pequeno porte tem condições de participar, além disso a obrigatoriedade da empresa cotar o
produto e oferecer a instalação e serviços no mesmo grupo, o  que apenas empresas de grande porte é que
tenham engenheiros qualificados conseguem atender.

Caso seja possível fazer a licitação por item ajudaremos na cotação.

Atenciosamente, Diego Macedo

Em ter, 16 de abr de 2019 às 16:32, Ana Paula Gomes Silva <anasilva@tre-al.jus.br> escreveu:

Boa tarde Diego,

Recebido.

Podemos aguardar uma proposta da empresa? Obrigada.

Atenciosamente.
Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL
seic@tre-al.jus.br
anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL
CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/7711

From: New Tech <newtechdistribuidora@gmail.com>
To: TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-al.jus.br>
Date: Tue, 16 Apr 2019 14:49:40 -0300
Subject: [seic] Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL

Em anexo envio algumas atas de nosso grupo de empresas que estão disponíveis para adesão o que pode
dispensar alguns itens de realizar a licitação, realizando a contratação de uma das empresas por meio de
adesão.

Em anexo por exemplo temos a ata da UNIFEI que tem 50 pontos de acesso.

Atenciosamente, Diego Macedo

Em ter, 16 de abr de 2019 às 14:18, TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-
al.jus.br> escreveu:

Prezado Senhor(a),
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Boa tarde,

Reiteramos pedido de cotação abaixo:

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem fio e cabeada,
mediante  sistema de registro de preços, distribuídos em lote 01 e lote 02, conforme descrição do
produto/serviço, quantitativos e demais especificações constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL
seic@tre-al.jus.br
anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL
CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/7711
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De: Maxwell Pinto - Usetech <max@usetech.net> 

Para:
TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-
al.jus.br>

Data: 17/04/2019 08:41 AM

Assunto:
[seic] RES: Solicitação. Cotação. Aquisição de componentes de
rede sem fio e cabeada. TREAL

Bom dia Ana Paula, tudo bom?
Agradecemos o envio do pedido de cotação, mas infelizmente não poderemos enviar proposta para esse
oportunidade, pois não conseguimos encontrar boa parte dos produtos.
Qualquer dúvida estamos à disposição.

Atenciosamente,

-----Mensagem original-----
De: TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-al.jus.br>
Enviada em: terça-feira, 16 de abril de 2019 14:18
Assunto: Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL

Prezado Senhor(a),

Boa tarde,

Reiteramos pedido de cotação abaixo:

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem fio e cabeada, mediante 
sistema de registro de preços, distribuídos em lote 01 e lote 02, conforme descrição do produto/serviço,
quan ta vos e demais especificações constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL seic@tre-al.jus.br anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/7711
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De: "Ana Paula Gomes Silva" <anasilva@tre-al.jus.br> 

Para: "Hana Oliveira" <hana.oliveira@ish.com.br>

Data: 23/04/2019 02:45 PM

Assunto:
Solicitação. Cotação. Aquisição de componentes de rede sem fio e
cabeada. TREAL. Re: Envio de e-mail teste.

Prezada Hanã,

Boa tarde,

Conforme contato telefônico há pouco reencaminho pedido de cotação abaixo:

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem fio e cabeada, mediante
sistema  de  registro  de  preços,  distribuídos  em  lote  01  e  lote  02,  conforme  descrição  do  produto/serviço,
quantitativos e demais especificações constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

Atenciosamente.
Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL
seic@tre-al.jus.br
anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL
CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/7711

From: Hana Oliveira <hana.oliveira@ish.com.br>
To: "ANASILVA@TRE-AL.JUS.BR" <ANASILVA@TRE-AL.JUS.BR>
Date: Tue, 23 Apr 2019 17:35:31 +0000
Subject: Envio de e-mail teste

Atenciosamente,

Hanã Carreiro de Oliveira
Inside Sales
Tel.: +55 27 3334-8900 ramal 8996
Cel.: +55 27 99242-8029
Skype: hanacarreiro
www.ish.com.br
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Aviso de Confidencialidade: Esta comunicação deve ser lida apenas pelo seu des natário e não pode ser retransmi da sem autorização
formal. Caso seja recebida indevidamente, por favor destrua-a. Qualquer reprodução, alteração, distribuição e/ou publicação é
estritamente proibida.
No ce of Confiden ality: This document should only be read by those persons to whom it is addressed and can not be relayed without
formal permission. If you have received this e-mail message in error, please destroy it. Any form of reproduc on, modifica on, distribu on
and/or publica on of this e-mail message is strictly prohibited.

Aviso de Confidencialidade: Esta comunicação deve ser lida apenas pelo seu destinatário e não pode ser retransmitida sem autorização formal.
Caso seja recebida indevidamente, por favor destrua-a. Qualquer reprodução, alteração, distribuição e/ou publicação é estritamente proibida.

Notice of Confidentiality: This document should only be read by those persons to whom it is addressed and can not be relayed without formal
permission. If  you have received this e-mail  message in error,  please destroy it.  Any form of reproduction, modification, distribution and/or
publication of this e-mail message is strictly prohibited.

[2] Arquivo: TR. Aquisição. Componentes
de rede..pdf

Tamanho:
634k

Tipo de Conteúdo:
application/pdf
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E-mail - 0532220

Data de Envio: 
  24/04/2019 14:21:02

De: 
  TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-al.jus.br>

Para:
    felipe.vieira@ish.com.br

Assunto: 
  Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL

Mensagem: 
  Prezado Felipe,

Boa tarde,

Conforme contato telefônico há pouco reencaminho pedido de cotação referente a outro procedimento de
componentes de rede.

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem fio e cabeada,
mediante sistema de registro de preços, distribuídos em lote 01 e lote 02, conforme descrição do
produto/serviço, quantitativos e demais especificações constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL
seic@tre-al.jus.br
anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL
CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/7711

Anexos:
    Termo_de_Referencia___TIC_0450416.html

E-mail SEIC 0532220         SEI 0008478-63.2018.6.02.8000 / pg. 190



E-mail - 0532280

Data de Envio: 
  24/04/2019 15:09:51

De: 
  TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-al.jus.br>

Para:
    felipe.vieira@ish.com.br

Assunto: 
  Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL

Mensagem: 
  Prezado Felipe,

Boa tarde,

Segue arquivo em PDF.

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem fio e cabeada,
mediante sistema de registro de preços, distribuídos em lote 01 e lote 02, conforme descrição do
produto/serviço, quantitativos e demais especificações constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL
seic@tre-al.jus.br
anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL
CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/7711

Anexos:
    Termo de Referência. Componentes de rede..pdf
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Status da mensagem: Mensagem foi respondida

De: Felipe Moyses Vieira <felipe.vieira@ish.com.br> 

Para:
TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-
al.jus.br>

Data: 24/04/2019 02:23 PM

Assunto:
[seic] RES: Solicitação. Cotação. Extensão de garantia e suporte
solução Firewall SonicWall. TRE-AL

Ana Paula,

Me desculpe só te retornar agora, acabei não visualizando esse email.

Analisando o objeto de contratação, verificamos que a ISH não possui em seu portfólio
, a solução mencionada (SonicWall). Trabalhamos com outros fabricantes, dentre eles
Checkpoint, Fortinet e ForcePoint. Entendemos que o Tribunal já utiliza essa solução
atualmente e que pretende apenas renovar suas garantias, e portanto, não poderemos
apoiá-los.

Aproveito aqui para compartilhar uma ARP de Ativos de Rede, com soluções do
fabricante Aruba, que tem tido grande procura do mercado devido aos preços
extremamente competitivos.
Caso tenha interesse na ARP, estamos à disposição, seguem meus contatos abaixo.

Att:

Felipe Moyses Vieira
Executivo de Negócios ES
ISH Tecnologia S.A.
Tel.: +55 27 3334.8920 | Cel.: +55 27 98138.5788
www.ish.com.br

-----Mensagem original-----
De: TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-al.jus.br>
Enviada em: terça-feira, 23 de abril de 2019 17:46
Assunto: Solicitação. Cotação. Extensão de garantia e suporte solução Firewall
SonicWall. TRE-AL

Prezado Senhor(a),

O Tribunal Regional Eleitoral de Alagoas necessita contratar suporte/garantia para
equipamentos e softwares da solução Firewall SonicWall conforme detalhamento abaixo:

01. Objeto: Contratação de extensão de garantia e suporte para equipamentos e
softwares da solução Firewall SonicWall em uso neste Tribunal e nos cartórios
eleitorais;

02. Quantidade: 01 Conjunto;

03. Resumo da Especificação do Objeto: A extensão de garantia pretende dar
longevidade técnica à solução de segurança Sonicwall em uso, mantendo-a atualizada do
ponto de vista de software como também quanto a novas implementações e recursos.

* Todos os componentes elencados deverão ter sua garantia estendida em 24 meses
adicionais, incluindo o direito de uso de novas versões de softwares;

*  A proposta deverá apresentar valores INDIVIDUAIS E TOTAIS.
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DETALHAMENTO DO OBJETO (Art. 18, § 3º, III)

3.1 Descrição do Objeto:

 Extensão de Garantia/Suporte da Solução de Segurança SonicWall em uso neste Tribunal
por um período adicional de 24 meses;

Atualização de firmware, softwares e definições, por igual período;

A solução é composta por:

A- 02 Firewalls SonicWall NSA 6600 em HA;

B- 04 Firewalls SonicWall SOHO;

C- 01 SonicWall GMS com suporte para 60 dispositivos.

Deve incluir os seguintes componentes:

Descrição:
COMPREHENSIVE GATEWAY SECURITY SUITE BUNDLE FOR SONICWALL SOHO SERIES 2YR

Partnumber: 01-SSC-0689

Quantidade: 05

Descrição:
COMPREHENSIVE GATEWAY SECURITY SUITE FOR 6600 (2 YR)

Partnumber: 01-SSC-4211

Quantidade: 01

Descrição: SonicWALL GMS E-Class 24X7 Software Support for 10 Nodes (2 Years)

Partnumber: 01-SSC-6531

Quantidade: 01

Descrição: SonicWALL GMS E-Class 24X7 Software Support for 25 Nodes (2 Years)

Partnumber: 01-SSC-6535

Quantidade: 02

Descrição: SONICWALL GMS E-CLASS 24X7 SOFTWARE SUPPORT FOR 1 NODE (2 YEARS)

Partnumber: 01-SSC-7677

Quantidade: 01

Prazo de entrega de até 30 dias contados a partir da autorização de fornecimento;

A entrega deverá ser realizada por meio eletrônico para o e-mail: coinf@tre-
al.jus.br.

Solicitamos proposta de acordo com as especificações e demais detalhamentos presentes
no termo de referência em anexo.
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Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL seic@tre-al.jus.br anasilva@tre-
al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às
13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL CNPJ nº:
06.015.041/0001-38
Telefones: 82 2122-7712/7711

Aviso de Confidencialidade: Esta comunicação deve ser lida apenas pelo seu
destinatário e não pode ser retransmitida sem autorização formal. Caso seja recebida
indevidamente, por favor destrua-a. Qualquer reprodução, alteração, distribuição e/ou
publicação é estritamente proibida.

Notice of Confidentiality: This document should only be read by those persons to whom
it is addressed and can not be relayed without formal permission. If you have
received this e-mail message in error, please destroy it. Any form of reproduction,
modification, distribution and/or publication of this e-mail message is strictly
prohibited.

[2] Arquivo: Apresentação_ATA_IFES.PDF
Tamanho:
1354k

Tipo de Conteúdo:
application/pdf

[3] Arquivo: IFES_ARP 30.2018_ARP
Digitalizada.pdf

Tamanho:
1841k

Tipo de Conteúdo:
application/pdf

Download arquivo zip contendo todos os
anexos
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ARP – INSTITUTO FEDERAL DO ESPÍRITO 

SANTO

HPE ARUBA

SWITCHES – WIRELESS – GESTÃO - NAC 
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INFORMAÇÕES PRELIMINARES

Edital de Pregão Eletrônico – 20/2018

Processo Administrativo nº: 23158.000246/2018-21 

Ata de Registro de Preços

ÓRGÃO: 

INSTITUTO FEDERAL DO ESPÍRITO SANTO (REITORIA) – UG 158151

LOTE ÚNICO

OBJETO DO EDITAL: AQUISIÇÃO DE EQUIPAMENTOS DE REDE DE DADOS 

(SWITCHES, TRANSCEIVERS, CABOS DE EMPILHAMENTO, RACK, ETC) 

NECESSÁRIOS PARA A DISPONIBILIZAÇÃO DA INFRAESTRUTURA DE REDE
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Comutação (Switches – Core)

Desempenho e Capacidades

Características 5406R zl2 5412R zl2

Throughput (Gbps) 960 1920

Interfaces/Slots 6 Slots 12 Slots

Switch Fabric (Gbps) 1015 2030

Slots para expansão

Tipo 1 – 2 portas 40Gbps QSFP+         R$ 24.977,51

Tipo 2 – 8 portas 1/10G SFP+ R$ 14.029,60

Tipo 3 – 8 portas 1/10G BaseT R$ 14.029,60

Tipo 4 – 20 portas 1G PoE+ / 4 portas 1/10G SFP+ R$ 14.029,60

Investimento R$ 17.941,37 R$ 33.746,86
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Comutação (Switches – Acesso – Com e Sem PoE+)

Desempenho e Capacidades

Características 2540 24G 4SFP+ 2540 24G 4SFP+ PoE+ 2540 48G 4SFP+ 2540 48G 4SFP+ PoE+

Throughput (Gbps) 128 128 176 176

Interfaces BaseT 24 24 48 48

PoE Budget (Watts) - 370W - 370W

Interfaces SFP+ 4 4 4 4

Investimento R$     9.774,14 R$  12.561,27 R$     14.382,08 R$  17.941,37
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Comutação (Cabeamentos e Transceivers Óticos)

Desempenho e Capacidades

Características
Cabo DAC 40G

QSFP+
Cabo DAC 10G

SFP+
Cabo DAC 10G

SFP+
Transceiver 1G 

SFP Base-SX
Transceiver 10G 

SFP+ Base-SR

Velocidade 40Gbps 10Gbps 10Gbps 1Gbps 10Gbps

Conexão/Descrição

Cabo para 
empilhamento 
ou conexões 

QSFP+ (40Gbps)

Cabo para 
empilhamento ou 

conexões SFP+ 
(10Gbps)

Cabo para 
empilhamento ou 

conexões SFP+ 
(10Gbps)

Transceptor ótico 
para fibras

multimodo –
curta distância

Transceptor ótico 
para fibras

multimodo –
longa distância

Comprimento/Distância 3 metros 3 metros 7 metros Até 550m Até 300m

Investimento R$     2.275,85 R$  827,61 R$     1.108,46 R$  740,46 R$  2.064,87
Anexo Apresentação_ATA_IFES. ISH Tecnologia. (0533076)         SEI 0008478-63.2018.6.02.8000 / pg. 199



Rede Wireless (Access Points)

Desempenho e Capacidades

Características AP-325 AP-325 AP-365

Antenas 2x2:2 4x4:4 2x2:2

Max. Throughput 2.4Ghz 867Mbps 1.733Gbps 867Mbps

Max. Throughput 5.0Ghz 300Mbps 600Mbps 400Mbps

Max. Throughput Agregado 1.16Gbps 2.33Gbps 1.26Gbps

Interfaces 1x 1G BaseT 2x 1G BaseT (LAG) 1x 1G BaseT

Investimento R$       1.635,17 R$    5.590,28 R$    5.756,29 

AP-303 AP-325 AP-365
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Infraestrutura (Software Gerenciamento)

ITEM VALOR

Software de Gerenciamento AirWave (por equipamento –

switch, ponto de acesso...)

R$ 384,94

 Visibilidade de Rede

 Monitoramento Real-Time

 Troubleshoot Granular (Clarity)

• Associação

• Autenticação

• DHCP

• DNS

Tempo gasto e % de erros
 AppRF – QoS por categoria de aplicação

 Alertas pró-ativos

 Mapa térmico de cobertura WLAN Real-Time

 Relatórios pré-configurados e customizáveis

 Gerencia equipamentos terceiros (não-Aruba)
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Infraestrutura (Software Controle de Acesso)

ITEM VALOR

Controle de Acesso ClearPass (VM) R$ 12.102,20

Controle de Acesso ClearPass (500 endpoints) R$ 39.210,05

Controle de Acesso ClearPass (1000 endpoints) R$ 63.353,40

 Controle de níveis de acesso baseado em políticas

de CONTEXTO.

 Descoberta automática dos dispositivos da rede.

 Contrução do Mapa Topológico com tipos dos 

dispositivos (switches, câmeras IP, Access Points,...)

 Função GUEST embarcada (autosserviço ou 

sponsor autorizador)

 Redes 802.1x ou não-.1x

 Integração com TACACS+, RADIUS, Microsoft AD

 Controla acesso em equipamentos terceiros (não-

Aruba)
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 Treinamento realizado por profissional ISH especialista em Aruba, com vasta experiência em Treinamentos e repasses Hands-On.

Serviços

ITEM VALOR

TREINAMENTO – Rede LAN – 40 horas

(por aluno)

R$ 2.000,00

TREINAMENTO – Rede WLAN – 40 horas

(por aluno)

R$ 2.000,00

TREINAMENTO – Solução de Gerência (AirWave) – 40 horas

(por aluno)

R$ 2.000,00

TREINAMENTO – Controle de Acesso (ClearPass) – 40 horas

(por aluno)

R$ 2.000,00

CONSULTORIA – Especialista

(por hora)

R$ 304,00
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CONTATOS
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De: Max Pereira <max@plugnetshop.com.br> 

Para:
TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-
al.jus.br>,  anasilva@tre-al.jus.br

CC:

Breno Tavares <breno@plugnetshop.com.br>, Marcos Cesar
<marcos@plugnetshop.com.br>,  Marcos Magalhães
<mmagalha@plugnetshop.com.br>

Data: 24/04/2019 09:54 PM

Assunto:
Re: Solicitação. Cotação. Aquisição de componentes de rede sem
fio e cabeada. TREAL

Ao TRE-AL

Prezados conforme solicitado segue proposta de preços de acordo com o Termo de Referência encaminhado.

Desde já agradecemos pela oportunidade e nos colocamos a disposição para quaisquer esclarecimentos necessários sobre a

mesma.

Atenciosamente,

Max Sitcovsky

Plugnet Informática

Cel: (81) 9 9294-7207

E-mail: max@plugnetshop.com.br

Esta mensagem (incluindo qualquer anexo) e os arquivos nela contidos é confidencial e legalmente protegida, somente
podendo ser usada pelo indivíduo ou entidade a quem foi endereçada. Caso você a tenha recebido por engano, deverá
devolvê-la ao remetente e, posteriormente, apagá-la, pois, a disseminação, encaminhamento, uso, impressão ou cópia do
conteúdo desta mensagem são expressamente proibidos.

This message (including any attachments) contains confidential information intended for a specific individual and purpose, and
is protected by law. If you are not the intended recipient, you should delete this message. Any disclosure, copying, or distribution
of this message, or the taking of any action based on it, is strictly prohibited.

Em ter, 16 de abr de 2019 às 14:06, TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-
al.jus.br> escreveu:

Prezado Senhor(a),

Boa tarde,

Reiteramos pedido de cotação abaixo:

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem fio e cabeada, mediante 
sistema de registro de preços, distribuídos em lote 01 e lote 02, conforme descrição do produto/serviço,
quantitativos e demais especificações constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.
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Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL
seic@tre-al.jus.br

anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL
CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/7711

[2] Arquivo: Proposta_TRE-
AL_Termo_Referência_TIC_20_2018_24042019_v1.pdf

Tamanho:
358k

Tipo de
Conteúdo:
application/pdf
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PLUGNET COMÉRCIO E REPRESENTAÇÕES 

LTDA 

          
Insc. Estadual Nº. - 18.1.001.0241444-4  
C.N.P.J. Nº. - 02.213.325/0001-88  
www.plugnetshop.com.br 
plugnet@nlink.com.br 
 

 

MATRIZ – RECIFE / PE 

 

Rua General Abreu e Lima, 222, 
Rosarinho – 52041-060 
Fone/Fax: 81 3426.7006 
plugnet@plugnetshop.com.br 

 

FILIAL – JOÃO PESSOA / PB 

 

Av. Nossa Senhora dos 
Navegantes, 104 / 402 Tambaú 

Fone/Fax: 83 3226.1422 
plugnetpb@plugnetshop.com.br 

 

FILIAL – FORTALEZA / CE 

 

Av. Santos Dumont, 5335 
Sl. 817 Papicu – 60175-047 

Fone/Fax: 85 3044 0115 
plugnetce@plugnetshop.com.br 

 

 

 
Recife, 24 de abril de 2019. 

 
 
 
Ao 
TRE-AL 
Atenção: Sra. Ana Paula Gomes Silva 
Seção de Instrução de Contratações (SEIC) - TRE/AL  
@-mail: seic@tre-al.jus.br / anasilva@tre-al.jus.br 
Assunto: Proposta estimativa de preços 
 
 
 

Conforme solicitado, segue nossa proposta comercial para fornecimento de equipamentos de acordo com o 
Termo de Referência - TIC nº 20 / 2018 encaminhado por esse tribunal. 

 
 

LOTE 01 - SOLUÇÃO PARTA REDE CABEADA 

ITEM DESCRIÇÃO DOS PRODUTOS/SERVIÇOS QTD MARCA V. UNITARIO V. TOTAL 

01 
SOLUÇÃO DE ANÁLISE DE PERFIL E 
CONTROLE DE ACESSO PARA REDE 
CABEADA 

1 ARUBA R$ 104.180,00 R$ 104.180,00 

02 
LICENCIAMENTO ADICIONAL PARA 
SISTEMA DE GERENCIAMENTO HPE IMC 

3 ARUBA R$ 16.060,00 R$ 48.180,00 

03 
LICENCIAMENTO ADICIONAL DO MÓDULO 
DE ANÁLISE DE TRAFEGO DO SISTEMA DE 
GERENCIAMENTO HPE IMC 

2 ARUBA R$ 12.745,00 R$ 25.490,00 

04 
LICENCIAMENTO ADICIONAL DA SOLUÇÃO 
DE ANÁLISE DE PERFIL E CONTROLE DE 
ACESSO 

2 ARUBA R$ 54.160,00 R$ 108.320,00 

05 
SWITCH DE DISTRIBUIÇÃO COM 16 
PORTAS SFP+ E SUPORTE A MÓDULOS DE 
EXPANSÃO 

6 ARUBA R$ 49.117,00 R$ 294.702,00 

06 
MÓDULO COM 4 PORTAS SFP+ PARA 
SWITCH DE DISTRIBUIÇÃO 

16 ARUBA R$ 4.742,00 R$ 75.872,00 

07 
MÓDULO DE STACKING COM 4 PORTAS 
PARA SWITCH DE DISTRIBUIÇÃO 

6 ARUBA R$ 4.406,00 R$ 26.436,00 

08 
SWITCH DE ACESSO L3 COM 48 PORTAS 
GIGABIT E 4SFP+ 

50 ARUBA R$ 21.468,00 R$ 1.073.400,00 

09 
SWITCH DE ACESSO L3 COM 24 PORTAS 
GIGABIT E 4SFP+ 

40 ARUBA R$ 14.106,00 R$ 564.240,00 

10 
SWITCH DE ACESSO L2 COM 24 PORTAS 
GIGABIT E 4SFP 

50 ARUBA R$ 4.724,00 R$ 236.200,00 

11 
SWITCH DE ACESSO L2 COM 48 PORTAS 
GIGABIT E 4SFP 

40 ARUBA R$ 8.245,00 R$ 329.800,00 

12 GBIC 10GB PARA ATÉ 300M 50 ARUBA R$ 2.364,00 R$ 118.200,00 

13 CABO DAC 10 GBPS DE 1M 30 ARUBA R$ 600,00 R$ 18.000,00 
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www.plugnetshop.com.br 
plugnet@nlink.com.br 
 

 

MATRIZ – RECIFE / PE 

 

Rua General Abreu e Lima, 222, 
Rosarinho – 52041-060 
Fone/Fax: 81 3426.7006 
plugnet@plugnetshop.com.br 

 

FILIAL – JOÃO PESSOA / PB 

 

Av. Nossa Senhora dos 
Navegantes, 104 / 402 Tambaú 

Fone/Fax: 83 3226.1422 
plugnetpb@plugnetshop.com.br 
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Av. Santos Dumont, 5335 
Sl. 817 Papicu – 60175-047 

Fone/Fax: 85 3044 0115 
plugnetce@plugnetshop.com.br 

 

 

14 CABO DAC 10 GBPS DE 3M 30 ARUBA R$ 900,00 R$ 27.000,00 

15 GBIC 1GB PARA ATÉ 500M 10 ARUBA R$ 1.200,00 R$ 12.000,00 

16 
SERVIÇOS DE IMPLANTAÇÃO E 
TRANSFERÊNCIA DE TECNOLOGIA PARA 
SWITCHS DE REDE 

5 ARUBA R$ 20.000,00 R$ 100.000,00 

17 
SERVIÇOS DE IMPLANTAÇÃO E 
TRANSFERÊNCIA DE TECNOLOGIA DO 
MÓDULO DE CONTROLE DE ACESSO 

1 ARUBA R$ 60.000,00 R$ 60.000,00 

18 
TREINAMENTO BÁSICO DE 
ADMINISTRAÇÃO DE SWITCHES 

4 ARUBA R$ 28.000,00 R$ 112.000,00 

19 
TREINAMENTO BÁSICO DA SOLUÇÃO DE 
CONTROLE DE ACESSO 

4 ARUBA R$ 28.000,00 R$ 112.000,00 

LOTE 02 - SOLUÇÃO DE REDE WIRELESS 

ITEM DESCRIÇÃO DOS PRODUTOS/SERVIÇOS QTD MARCA V. UNITARIO V. TOTAL 

01 
SOLUÇÃO DE ANÁLISE DE PERFIL E 
CONTROLE DE ACESSO PARA REDE 
WIRELESS 

1 ARUBA R$ 104.180,00 R$ 104.180,00 

02 
SOLUÇÃO DE GERENCIAMENTO DE REDE 
WIRELESS 

1 ARUBA R$ 570,00 R$ 570,00 

03 
LICENÇAS ADICIONAIS PARA SOLUÇÃO DE 
GERENCIAMENTO DE REDE WIRELESS 

200 ARUBA R$ 570,00 R$ 114.000,00 

04 
LICENCIAMENTO ADICIONAL DA SOLUÇÃO 
DE ANÁLISE DE PERFIL E CONTROLE DE 
ACESSO 

2 ARUBA R$ 55.000,00 R$ 110.000,00 

05 CONTROLADORA WLAN 4 ARUBA R$ 70.000,00 R$ 280.000,00 

06 
LICENÇAS ADICIONAIS PARA 
CONTROLADORA WLAN 

200 ARUBA R$ 900,00 R$ 180.000,00 

07 PONTO DE ACESSO INTERNO TIPO 01 100 ARUBA R$ 5.350,00 R$ 535.000,00 

08 PONTO DE ACESSO INTERNO TIPO 02 100 ARUBA R$ 2.300,00 R$ 230.000,00 

09 
INJETOR POE PARA PONTOS DE ACESSO 
TIPO 1 

100 ARUBA R$ 700,00 R$ 70.000,00 

10 
INJETOR POE PARA PONTOS DE ACESSO 
TIPO 2 

100 ARUBA R$ 550,00 R$ 55.000,00 

11 
SERVIÇOS DE IMPLANTAÇÃO E 
TRANSFERÊNCIA DE TECNOLOGIA PARA 
SOLUÇÃO DE GERENCIAMENTO 

1 ARUBA R$ 25.000,00 R$ 25.000,00 

12 
SERVIÇOS DE IMPLANTAÇÃO E 
TRANSFERÊNCIA DE TECNOLOGIA DO 
MÓDULO DE CONTROLE DE ACESSO 

1 ARUBA R$ 60.000,00 R$ 60.000,00 

13 
SERVIÇOS DE IMPLANTAÇÃO E 
TRANSFERÊNCIA DE TECNOLOGIA PARA 
PONTOS DE ACESSO 

5 ARUBA R$ 20.000,00 R$ 100.000,00 

14 
TREINAMENTO BÁSICO DE 
ADMINISTRAÇÃO DE ARQUITETURA WLAN 

4 ARUBA R$ 20.300,00 R$ 81.200,00 

15 
TREINAMENTO BÁSICO DA SOLUÇÃO DE 
GERENCIAMENTO 

4 ARUBA R$ 20.300,00 R$ 81.200,00 

16 
TREINAMENTO BÁSICO DA SOLUÇÃO DE 
CONTROLE DE ACESSO 

4 ARUBA R$ 28.000,00 R$ 112.000,00 
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PLUGNET COMÉRCIO E REPRESENTAÇÕES 

LTDA 

          
Insc. Estadual Nº. - 18.1.001.0241444-4  
C.N.P.J. Nº. - 02.213.325/0001-88  
www.plugnetshop.com.br 
plugnet@nlink.com.br 
 

 

MATRIZ – RECIFE / PE 

 

Rua General Abreu e Lima, 222, 
Rosarinho – 52041-060 
Fone/Fax: 81 3426.7006 
plugnet@plugnetshop.com.br 

 

FILIAL – JOÃO PESSOA / PB 

 

Av. Nossa Senhora dos 
Navegantes, 104 / 402 Tambaú 

Fone/Fax: 83 3226.1422 
plugnetpb@plugnetshop.com.br 

 

FILIAL – FORTALEZA / CE 

 

Av. Santos Dumont, 5335 
Sl. 817 Papicu – 60175-047 

Fone/Fax: 85 3044 0115 
plugnetce@plugnetshop.com.br 

 

 

 

 
 
Condições Comerciais: 

 
VALIDADE DA PROPOSTA: 30 (trinta) dias. 

PRAZO DE ENTREGA: 90 (sessenta) dias após o pedido. 

FORMA DE PAGAMENTO: Contra entrega/Empenho. 

 
 
 
 
 

 
Atenciosamente, 

 
 

Plugnet Comércio e Representações Ltda. 
Breno José de Araujo Tavares 
(81) 3426-7006 
Diretor 
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E-mail - 0533111

Data de Envio: 
  25/04/2019 16:50:15

De: 
  TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-al.jus.br>

Para:
    mazzochi@approachtec.com.br

Assunto: 
  Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL

Mensagem: 
  Prezado Eduardo,

Boa tarde,

Conforme conversamos, no dia de hoje, em visita a este Tribunal, encaminho pedido de cotação abaixo:

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem fio e cabeada,
mediante sistema de registro de preços, distribuídos em lote 01 e lote 02, conforme descrição do
produto/serviço, quantitativos e demais especificações constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL
seic@tre-al.jus.br
anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL
CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/7711

Anexos:
    Termo de Referência. Componentes de rede..pdf
    Termo_de_Referencia___TIC_0450416.html
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E-mail - 0533598

Data de Envio: 
  26/04/2019 11:09:43

De: 
  TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-al.jus.br>

Para:
    contato@swt.com.br

Assunto: 
  Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL

Mensagem: 
  Prezado Fernando Freitas,

Bom dia,

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem fio e cabeada,
mediante sistema de registro de preços, distribuídos em lote 01 e lote 02, conforme descrição do
produto/serviço, quantitativos e demais especificações constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL
seic@tre-al.jus.br
anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL
CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/7711

Anexos:
    Termo de Referência. Componentes de rede..pdf
    Termo_de_Referencia___TIC_0450416.html
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De: Eduardo Mazzochi <mazzochi@approachtec.com.br> 

Para:
TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-
al.jus.br>

Data: 26/04/2019 06:36 PM

Assunto:
[seic] Solicitação.  Cotação.  Aquisição de componentes de rede
sem fio e cabeada. TREAL

Boa tarde Ana Paula

Iremos estudar o Termo de Referencia de renovação e enviaremos o mais breve possível

a proposta para voces.

Em 25/04/2019 16:50, "TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES" <seic@tre-al.jus.br>

escreveu:

    Prezado Eduardo,

    Boa tarde,

    Conforme conversamos, no dia de hoje, em visita a este Tribunal, encaminho pedido

de cotação abaixo:

    O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede

sem fio e cabeada, mediante  sistema de registro de preços, distribuídos em lote 01 e

lote 02, conforme descrição do produto/serviço, quantitativos e demais especificações

constantes do termo de referência em anexo.

    Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

    Atenciosamente.

    Ana Paula Gomes Silva

    Seção de Instrução de Contratações (SEIC) - TRE/AL

seic@tre-al.jus.br

anasilva@tre-al.jus.br

    Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30

às 13:30h.

    Tribunal Regional Eleitoral de Alagoas - TRE/AL.

    Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL

    CNPJ nº: 06.015.041/0001-38

    Telefones: 82 2122-7712/7711
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De: "Isaac Santos - SWN NE" <isaac@smartwavenetworks.com.br> 

Para: "'Ana Paula Gomes Silva'" <anasilva@tre-al.jus.br>

Data: 30/04/2019 03:52 PM

Assunto:
RES: RES: RES: [seic] Solicitação. Cotação. Aquisição de

componentes de rede sem fio e cabeada. TREAL

Ana Paula, es�ve em Alagoas na semana passada quando �ve a oportunidade de ser recebido no setor de TI de

vcs.

Jus�fiquei meu pedido de ajustes para o pessoal e eles me informaram que não �nham recebido o documento em

excel. Pediram ainda que editasse o mesmo e que reenviasse em “pdf”.

Segue assim o nosso pedido de ajustes ao TR de vcs.

Ficamos na expecta�va de ter nosso pedido aceito.

Atenciosamente,

Isaac Santos

Execu�vo de Vendas - NE  

Celular: +55 79 9.9124-0547 TIM e Whatsapp

Telefone:+55 11 2609-6985

E-mail: isaac@smartwavenetworks.com.br

SmartWave Networks

De: Ana Paula Gomes Silva <anasilva@tre-al.jus.br>

Enviada em: terça-feira, 16 de abril de 2019 14:39

Para: Isaac Santos - SWN NE <isaac@smartwavenetworks.com.br>

Assunto: Re: RES: RES: [seic] Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL

Isaac boa tarde,

Que bom. Espero que a empresa possa apresentar uma cotação. Obrigada.

Atenciosamente.

Ana Paula Gomes Silva

Seção de Instrução de Contratações (SEIC) - TRE/AL

seic@tre-al.jus.br

anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.

Tribunal Regional Eleitoral de Alagoas - TRE/AL.

Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL

CNPJ nº: 06.015.041/0001-38

Telefones: 82 2122-7712/7711

From: "Isaac Santos - SWN NE" <isaac@smartwavenetworks.com.br>
To: "'Ana Paula Gomes Silva'" <anasilva@tre-al.jus.br>
Date: Tue, 16 Apr 2019 14:20:47 -0300
Subject: RES: RES: [seic] Solicitação. Cotação. Aquisição   de componentes de rede sem fio e cabeada. TREAL

Ana Paula, desculpe a demora em lhe responder.
Estamos reanalisando o documento com maior profundidade. Qualquer dúvida voltamos a nos falar por aqui ok.
Atenciosamente,

Isaac Santos
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Executivo de Vendas - NE  
Celular: +55 79 9.9124-0547 TIM e Whatsapp
Telefone:+55 11 2609-6985
E-mail: isaac@smartwavenetworks.com.br
SmartWave Networks

De: Ana Paula Gomes Silva <anasilva@tre-al.jus.br>
Enviada em: quinta-feira, 11 de abril de 2019 14:22
Para: Isaac Santos - SWN NE <isaac@smartwavenetworks.com.br>
Assunto: Re: RES: [seic] Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL
Prioridade: Alta

Prezado Isaac,

Boa tarde,  

Encaminhei  seus  apontamentos  e  a  Coordenadoria  de  Infraestrutura  entende  que  o  termo  de  referência
elaborado pela unidade técnica atende as demandas de interesse da Administração; se posicionamento, neste
momento, pela manutenção do termo de referência nas condições atuais.

Muito obrigada.

Atenciosamente.

Ana Paula Gomes Silva

Seção de Instrução de Contratações (SEIC) - TRE/AL
seic@tre-al.jus.br

anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.

Tribunal Regional Eleitoral de Alagoas - TRE/AL.

Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL

CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/7711

From: "Isaac Santos - SWN NE" <isaac@smartwavenetworks.com.br>
To: "'Ana Paula Gomes Silva'" <anasilva@tre-al.jus.br>
Date: Tue, 9 Apr 2019 21:45:09 -0300
Subject: RES: [seic] Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL

Ana Paula, conforme planilha excel anexada (TRE_Alagoas_08042019_rev0.xlsx) de fato existem alguns itens
que impossibilita a nossa participação e pedimos a gentileza da equipe de TI/TREAL na análise das nossas
sugestões... Lembro que nossa demanda não é para diminuir a capacidade exigida mas sim manter o nível
técnico visualizado e exigido.

Conforme é possível visualizar nos datasheets, nossa pretensão é entrar com equipamentos “ponta de linha”
da Aerohive (veja mais em www.aerohive.com) e além das exigências do documento estaremos entregando
adicionalmente (mesmo sem a exigencia no TR) os seguintes itens:

Garantia dos equipamentos na modalidade ‘Limited Lifetime’ ofertado pelo próprio fabricante
·

·

Garante a substituição dos equipamentos em mais 5 anos após ser descontinuado, em caso de
falha.

Entrega de access point com tecnologia ‘ax’ para atendimento a todas as exigencias do ‘access point
tipo 2’
Entrega adicional de solução NAC em atendimento à demanda de autenticação de usuários

WorldClient https://webmail.tre-al.gov.br:3001/WorldClient.dll?Session=Z3N39R...

2 de 4 02/05/2019 13:51
E-mail Pedido Ajustes TR. SmartWave Networks. (0535070)         SEI 0008478-63.2018.6.02.8000 / pg. 219



Ficamos no aguardo do entendimento dos senhores sobre nossos requisitos e prontos para enviar nosso
orçamento assim que recebermos as respostas.
Atenciosamente,

Isaac Santos

Executivo de Vendas - NE  
Celular: +55 79 9.9124-0547 TIM e Whatsapp
Telefone:+55 11 2609-6985
E-mail: isaac@smartwavenetworks.com.br
SmartWave Networks

De: Ana Paula Gomes Silva <anasilva@tre-al.jus.br>
Enviada em: terça-feira, 9 de abril de 2019 10:42
Para: Isaac Santos <isaac@smartwavenetworks.com.br>
Assunto: Re: [seic] Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL

Bom dia Isaac,

Aguardamos. Muito obrigada.

Atenciosamente.

Ana Paula Gomes Silva

Seção de Instrução de Contratações (SEIC) - TRE/AL
seic@tre-al.jus.br

anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.

Tribunal Regional Eleitoral de Alagoas - TRE/AL.

Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL

CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/7711

From: Isaac Santos <isaac@smartwavenetworks.com.br>
To: TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-al.jus.br>
Date: Tue, 9 Apr 2019 10:37:43 -0300
Subject: [seic] Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL

Olá Ana Paula, bom dia e muito obrigado por compartilhar a TR comigo.
Tivemos acesso à esse documento na semana passada e nossa equipe de engenharia já está analisando as
exigências. Devemos ter um feedback deles ainda hoje.
Caso estejamos atendendo o termo, enviaremos a proposta de imediato. Caso contrário, enviaremos antes
da proposta nossas sugestões de alteração para que em sendo aceita, possamos cotar de imediato.
Atenciosamente,

Isaac Santos
Executivo de vendas
Smartwave Networks
+55(79)9.9124-0547
(Respondido através do meu Android)

Em ter, 9 de abr de 2019 09:57, TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-
al.jus.br> escreveu:

Prezado Isaac,

Bom dia,
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Conforme contato telefônico há pouco com a empresa, através do funcionário Edilson, encaminho pedido
de cotação abaixo:

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem fio e cabeada,
mediante  sistema de registro de preços, distribuídos em lote 01 e lote 02, conforme descrição do
produto/serviço, quantitativos e demais especificações constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL
seic@tre-al.jus.br

anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL
CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/7711

[2] Arquivo: Pedidos de Ajustes ao TR

SEI-TRE-AL-0450416 - Smartwave

Networks.pdf

Tamanho:

357k

Tipo de Conteúdo:

application/pdf
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HM + A3  - QUANTIDADE:  XX unidades

ITEM AÇÃO OBSERVAÇÕES JUSTIFICATIVA / QUESTIONAMENTO

ITEM 01 – SOLUÇÃO DE ANÁLISE DE PERFIL E 
CONTROLE DE ACESSO PARA SOLUÇÃO DE REDE 
WIRELESS LICENCIAMENTO
MÓDULO DE ANÁLISE DE PERFIL DE DISPOSITIVO
Características Gerais Modulo de Análise de Perfil de 
Dispositivo

6. Deve suportar a coleta de informações, para classificação, 
usando no mínimo:

Alterar
6. Deve suportar a coleta de informações, 

para classificação, usando no mínimo 3 (três) 
dos métodos descritos abaixo:

k. DHCP;
l. HTTP User-Agent;
m. MAC OUI;
n. ActiveSync plugin;
o. SNMP;
p. Subnet Scanner;
q. IF-MAP;
r. Cisco Device Sensor;
s. MDM;
t. TCP Fingerprinting.

8. Deve suportar a integração com, no mínimo, as seguintes 
soluções de MDM de mercado AirWatch, MobileIron, BES, 
JAMF, SOTI, XenMobile, SAP Afaria, MaaS 360 devendo 
comprovar a compatibilidade em documentação oficial do 
fabricante; 

Alterar

8. Deve suportar a integração com, no mínimo 
uma das seguintes soluções de MDM de 

mercado AirWatch, MobileIron, BES, JAMF, 
SOTI, XenMobile, SAP Afaria, MaaS 360 
devendo comprovar a compatibilidade em 

documentação oficial do fabricante; 

MÓDULO DE CONTROLE DE ACESSO DE DISPOSITIVOS 
E USUÁRIOS
Características Gerais

11. A Solução deverá dar suporte a no mínimo as seguintes 
bases de dados:

Alterar
11. A Solução deverá dar suporte a no mínimo 

3 (três) das seguintes bases de dados:

n. Microsoft Active Directory;
o. Kerberos;
p. Diretórios LDAP;
q. Novell eDirectory;
r. OpenLDAP;
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s. Sun Directory Server;
t. PostgreSQL;
u. Oracle 11g;
v. MariaDB;
w. MSSQL;
x. Servidores de Token;
y. Base de dados SQL interna;
z. Lista interna estática de hosts.
15. Deve possuir Dashboard customizável, onde deve 
permitir a visualização de no mínimo as seguintes 
informações:

b. Gráfico com todas as requisições de autenticação dos 
últimos 7 dias, incluindo RADIUS, TACACS+ e 
Autenticações Web;

Alterar
b. Gráfico com todas as requisições de 

autenticação dos últimos 7 dias, incluindo 
RADIUS, Autenticações Web ou TACACS+;

17. Deve suportar a integração com no mínimo as seguintes 
soluções de MDM de mercado AirWatch, MobileIron, BES, 
JAMF, SOTI, XenMobile, SAP Afaria, MaaS 360 devendo 
comprovar a compatibilidade em documentação oficial do 
fabricante;

Alterar

17. Deve suportar a integração com no 
mínimo uma das seguintes soluções de MDM 

de mercado AirWatch, MobileIron, BES, 
JAMF, SOTI, XenMobile, SAP Afaria, MaaS 

360 devendo comprovar a compatibilidade em 
documentação oficial do fabricante.

19. Deve possuir recursos integrados de AAA: RADIUS, 
TACACS+ e Kerberos;

Alterar
19. Deve possuir recursos integrados de AAA: 

RADIUS, Kerberos ou TACACS+.
20. Deve possuir suporte aos seguintes recursos:

o. TACACS+; Retirar

Entendemos que o TACACS+ é um 
método específico para controle de 

acesso administrativo da gerência e não 
para controle de acesso de dispositivos 

para ingressar na rede sem fio e se 
mostra não usual nos projetos de rede.

v. PAP, CHAP, MSCHAPv1, MSCHAPv2, and EAP-MD5; Alterar
v. PAP, CHAP, MSCHAPv1 ou MSCHAPv2, 

and EAP-MD5;

HM Local Cloud  - QUANTIDADE:  XX unidades

ITEM AÇÃO OBSERVAÇÕES JUSTIFICATIVA / QUESTIONAMENTO
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ITEM 02 – SOLUÇÃO DE GERENCIAMENTO DE REDE 
WIRELESS
LICENCIAMENTO
CARACTERÍSTICAS GERAIS

3. A solução de gerenciamento deverá possuir integração 
com o HPE IMC em console única de gerenciamento;

Retirar

Este item limita a participação a um único 
fabricante, impossibilitando que os 

principais fornecedores de soluções de 
rede sem fio possam participar.

12. Possibilitar a importação de plantas baixas nos formatos 
dwg e jpg;

Alterar
12. Possibilitar a importação de plantas baixas 

ao menos em dois dos seguintes formatos: 
dwg, pdf, jpg e pdf;

22. Suportar SSH, HTTP/HTTPS, SSL, Telnet; Alterar
22. Suportar SSH, SSL, Telnet ou 

HTTP/HTTPS;

32. Possibilitar a importação de plantas baixas nos formatos 
gráficos (CAD, dwg, jpg, gif e png);

Alterar
32. Possibilitar a importação de plantas baixas 

e pelo menos dois dos formatos gráficos 
(CAD, dwg, pdf, jpg, gif e png);

Entendemos que este item está em 
duplicidade com o item 12

33. Deve disponibilizar em painel gráfico de controle 
informações referentes à:

b. Informações sobre chamadas de voz, seus protocolos e 
qualidade das mesmas;

Retirar

Necessitaria de equipamento ou 
aplicação específica e não precisa estar 
relacionada a solução de rede sem fio, 

que é apenas uma extensão das 
funcionalidades existentes na rede fixa. 

HM Local Cloud + APs - QUANTIDADE:  XX unidades

ITEM AÇÃO OBSERVAÇÕES JUSTIFICATIVA / QUESTIONAMENTO

ITEM 05 – CONTROLADORA WLAN
Características gerais

1. Solução baseada em hardware ou software específico, do 
tipo appliance físico ou virtual, do mesmo fabricante dos 
pontos de acesso e software de gerência;

Alterar

1. Solução baseada em hardware ou software 
específico, do tipo appliance físico ou virtual, 
do mesmo fabricante dos pontos de acesso; 

Opcionalmente poderá ser baseada em 
arquitetura de controladora distribuida ou 

cooperativa onde os pontos de acesso atuam 
como controladores WLAN em redundância.

Anexo Pedido AjustesTR SEI-TRE-AL- Smartwave Networks. (0535071)         SEI 0008478-63.2018.6.02.8000 / pg. 224



8. Prover tempo de fast-roaming intra-switch inferior a 25 
milissegundos;

Retirar

Nossa arquitetura de controle não faz o 
fast roaming entre controladores. Ele é 
gerenciado diretamente entre os pontos 

de acesso.

9. Prover tempo de fast-roaming inter-switch em camada 2, 
inferior a 100 milissegundos;

Retirar

Nossa arquitetura de controle não faz o 
fast roaming entre controladores. Ele é 
gerenciado diretamente entre os pontos 

de acesso.

15. Permitir autenticação em no mínimo os seguintes 
sistemas de base de dados de usuários Microsoft Active 
Directory, Cisco ACS server, FreeRadius, entre outros;

Alterar

15. Permitir autenticação em no mínimo um 
dos seguintes sistemas de base de dados de 

usuários Microsoft Active Directory, Cisco 
ACS server, FreeRadius, entre outros;

17. Possuir suporte a autenticação IEEE 802.1X, com pelo 
menos os seguintes métodos EAP: EAP-MD5, PEAP/EAP-
GTC, PEAP/EAP-MSCHAPv2, EAP-TLS com utilização de 
base de usuários interna ou servidor RADIUS externo;

Alterar

17. Possuir suporte a autenticação IEEE 
802.1X, com pelo menos os seguintes 

métodos EAP: PEAP/EAP-GTC, PEAP/EAP-
MSCHAPv2, EAP-TLS com utilização de base 

de usuários interna ou servidor RADIUS 
externo;

18 .Suportar as especificações: Retirar

Informações sobre RFCs não estão 
descritas em documentação publica, não 
somente pela Aerohive mas também em 

grande parte dos fabricantes. 

a. RFC 2409; Retirar

Informações sobre RFCs não estão 
descritas em documentação publica, não 
somente pela Aerohive mas também em 

grande parte dos fabricantes. 

b. RFC 2661; Retirar

Informações sobre RFCs não estão 
descritas em documentação publica, não 
somente pela Aerohive mas também em 

grande parte dos fabricantes. 

c. RFC 2408; Retirar

Informações sobre RFCs não estão 
descritas em documentação publica, não 
somente pela Aerohive mas também em 

grande parte dos fabricantes. 
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d. RFC 3602; Retirar

Informações sobre RFCs não estão 
descritas em documentação publica, não 
somente pela Aerohive mas também em 

grande parte dos fabricantes. 

e. RFC 3948; Retirar

Informações sobre RFCs não estão 
descritas em documentação publica, não 
somente pela Aerohive mas também em 

grande parte dos fabricantes. 

f. RFC 2548; Retirar

Informações sobre RFCs não estão 
descritas em documentação publica, não 
somente pela Aerohive mas também em 

grande parte dos fabricantes. 

g. RFC 2328; Retirar

Informações sobre RFCs não estão 
descritas em documentação publica, não 
somente pela Aerohive mas também em 

grande parte dos fabricantes. 

h. RFC 2338; Retirar

Informações sobre RFCs não estão 
descritas em documentação publica, não 
somente pela Aerohive mas também em 

grande parte dos fabricantes. 

i. RFC 1027; Retirar

Informações sobre RFCs não estão 
descritas em documentação publica, não 
somente pela Aerohive mas também em 

grande parte dos fabricantes. 

j. IEEE 802.1w; Retirar
Entendemos que este padrão deveria 

estar implementado na rede fixa e não no 
gerenciamento da rede sem fio.

k. RFC 1519; Retirar

Informações sobre RFCs não estão 
descritas em documentação publica, não 
somente pela Aerohive mas também em 

grande parte dos fabricantes. 
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22. Suportar a autenticação de usuários conectados à rede 
cabeada através das portas do controlador;

Retirar
Limitaria a utilização para controladora 
física (ou seja, descarta a possibilidade 

da entrega de Virtual Appliance)

32. Deve permitir o tunelamento do trafego de dados de 
usuários mesmo em redes L3, não sendo necessário 
estender VLANs até o Ponto de Acesso, inclusive em MANs 
e WANs;

Retirar

Não se aplica em arquiteturas com 
controle cooperativo entre pontos de 

acesso, obrigando a utilização de 
arquitetura de controle centralizada. 

36. Implementar o protocolo 802.1w (Rapid Spanning Tree); Retirar
Entendemos que este padrão deveria 

estar implementado na rede fixa e não no 
gerenciamento da rede sem fio.

37. Oferecer suporte a roteamento e switching de camadas 
L2 e L3;

Retirar
Entendemos que este padrão deveria 

estar implementado na rede fixa e não no 
gerenciamento da rede sem fio.

39. Possuir servidor DHCP embutido; Retirar
Entendemos que este padrão deveria 

estar implementado na rede fixa e não no 
gerenciamento da rede sem fio.

40. Suportar o protocolo VRRP para redundância de 
controladores;

Retirar
Entendemos que este padrão deveria 

estar implementado na rede fixa e não no 
gerenciamento da rede sem fio.

41. Deve suportar redundância de controladores nos modos: Alterar
41. Para Controladora tipo appliance físico a 

solução deverá suportar redundância de 
controladores nos modos

43. Oferecer os recursos de Proxy de endereços IP e Proxy 
DHCP para roaming entre redes (L3)

Alterar
43. Oferecer os recursos para roaming entre 

redes (L3)

44. Deve implementar northbound APIs para realização de 
integrações com aplicações de terceiros para fins de 
monitoramento e visibilidade. Caso seja necessário, deve ser 
ofertado licenças para ativação desse recurso;

Alterar

44. Deve implementar SDN´s para realização 
de integrações com aplicações de terceiros 
para fins de monitoramento e visibilidade. 
Caso seja necessário, deve ser ofertado 

licenças para ativação desse recurso;

46. Implementar o protocolo 802.1d para Spanning Tree 
(STP);

Alterar
46. Para Controladora tipo appliance físico a 

solução deverá Implementar o protocolo 
802.1d para Spanning Tree (STP);

48. Se um controlador WLAN falhar, os APs relacionados 
deverão se associar a um controlador WLAN alternativo de 
forma automática, não permitindo que a rede wireless se 
torne inoperante;

Alterar

48. Se um controlador WLAN ou AP 
controlador falhar, os APs relacionados 

deverão se associar a uma unidade 
controladora WLAN alternativa de forma 
automática, não permitindo que a rede 

wireless se torne inoperante; 
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66. O Firewall deverá implementar os recursos de NAT 
(Network Address Translation) tanto para destino quanto 
para origem;

Retirar

Necessitaria de equipamento ou 
aplicação específica e não precisa estar 
relacionada a solução de rede sem fio, 

que é apenas uma extensão das 
funcionalidades existentes na rede fixa.

73. O Firewall deverá ser integrado à rede WLAN de modo a 
permitir a desassociação de usuários da rede sem fio WLAN 
com base na violação de políticas de tráfego. Por exemplo: 
desassociar da rede WLAN e colocar em quarentena o 
Notebook com endereço MAC XX:XX:XX se o usuário tentar 
fazer um telnet para o servidor ABC;

Alterar

73. A rede WLAN deverá se integrar ao 
Firewall  de modo a permitir a desassociação 
de usuários da rede sem fio WLAN com base 
na violação de políticas de tráfego. Por 
exemplo: desassociar da rede WLAN e 
colocar em quarentena o Notebook com 
endereço MAC XX:XX:XX se o usuário tentar 
fazer um telnet para o servidor ABC;

88. Realizar a contenção automática dos APs Rogue, 
simultaneamente, através da rede WLAN e da rede 
cabeada;

Alterar
88. Realizar a contenção automática dos APs 

Rogue, simultaneamente, através da rede 
WLAN e/ou da rede cabeada;

c. Fake Ap, Airjack; Alterar c. Fake Ap;

Não temos comprovação de Airjack em 
documentação pública. Os protocolos 

hoje são bem mais seguros e 
acreditamos devido à isso, os fabricantes 
em sua maioria (dentre eles a Aerohive) 

não publiquem nos seus documentos 
(públicos) sobre

e. ASLEAP; Retirar

Este ataque é feito para explorar uma 
falha na autenticação LEAP que é 

proprietária da CISCO. Os protocolos 
hoje são bem mais seguros e 

acreditamos devido à isso, os fabricantes 
em sua maioria (dentre eles a Aerohive) 

não publiquem nos seus documentos 
(públicos) sobre.

AP130  - QUANTIDADE:  XX unidades

ITEM AÇÃO OBSERVAÇÕES JUSTIFICATIVA / QUESTIONAMENTO

ITEM 07 – PONTO DE ACESSO INTERNO TIPO 01
Características gerais

Anexo Pedido AjustesTR SEI-TRE-AL- Smartwave Networks. (0535071)         SEI 0008478-63.2018.6.02.8000 / pg. 228



s. Opportunistic Key Caching (OKC) Retirar
Esta especificação de OKC no certificado 

Wi-Fi Alliance não é comum entre os 
fabricantes

6. Deve suportar capacidade de 1300 Mbps de throughput 
ou superior;

Alterar
6. Deve suportar capacidade de 1100 Mbps 

de throughput ou superior;

7. Deve possuir rádio duplo configurável pelo software 
suportando 5 GHz e 2,4 GHz;

Retirar

Esta capacidade de escolher a frequência 
de trabalho do rádio em 2,4 GHZ ou 5 

GHz é cumprida por poucos modelos de 
AP's, piorando a competitividade do 

processo.

9. Deve possuir no mínimo dois spatial stream Single User 
(SU) MIMO para uma taxa de dados sem fio de até 400 
Mbps para dispositivos clientes compatíveis (2x2 VHT40) em 
5GHz;

Alterar

9. Deve possuir no mínimo dois spatial stream 
Single User (SU) MIMO para uma taxa de 

dados sem fio de até 300 Mbps para 
dispositivos clientes compatíveis (2x2 VHT40) 

em 2,4GHz;
15. Deve possuir potência de transmissão configurável em 
incrementos de 0,5 dBm.

Alterar
15. Deve possuir potência de transmissão 
configurável em incrementos de 1,0 dBm.

17. Deve suportar Advanced Cellular Coexistence (ACC) 
minimizando a interferência das redes celulares;

Retirar
Esta funcionalidade ACC impede a ampla 

participação dos fabricantes.

19. Deve suportar Cyclic delay/shift diversity (CDD/CSD) 
para melhorar o desempenho RF de downlink;

Alterar
19. Deve suportar Cyclic delay/shift diversity 
(CDD/CSD) ou beamforming para melhorar o 

desempenho RF de downlink;
20. Deve suportar Short guard interval para canais de 
20MHz, 40MHz e 80MHz;

Alterar 20. Deve suportar Short guard interval;

Gerenciamento

31. O ponto de acesso deve permitir a conversão de modo 
auto gerenciado para modo gerenciado por controlador 
WLAN através de interface gráfica, em browser padrão 
(HTTPS), e permitir que todos os demais pontos de acesso 
pertencentes ao mesmo cluster, também sejam convertidos 
automaticamente;

Alterar

31. O ponto de acesso deve permitir a 
conversão de modo gerência nativa para 
modo gerenciado completa através de 
inserção de licenciamento em interface 
gráfica, em browser padrão (HTTPS), e 
permitir que todos os demais pontos de 
acesso também sejam convertidos para este 
modo;

59. Possuir LED’s indicativos do estado de operação, da 
atividade do rádio e da interface Ethernet;

Alterar
59. Possuir LED’s ou LED indicativo do 

estado de operação do ponto de acesso;

a. EAP- MD5 Retirar
Método não é seguro e sua utilização não 

é mais recomendada.

83. Possuir um MTBF (Mean Time Between Failure - Período 
Médio entre Falhas) de, no mínimo, 250.000 horas.

Retirar
Tipo de informação que não está 

disponível para todos os fabricantes e 
restringe a ampla participação.
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AP650 - QUANTIDADE:  XX unidades

ITEM AÇÃO OBSERVAÇÕES JUSTIFICATIVA / QUESTIONAMENTO

ITEM 08 – PONTO DE ACESSO INTERNO TIPO 02
Características gerais

s. Opportunistic Key Caching (OKC) Retirar
Esta especificação de OKC no certificado 

Wi-Fi Alliance não é comum entre os 
fabricantes

6. Deve possuir rádio duplo configurável pelo software, 
suportando 5 GHz e 2,4 GHz;

Retirar

Esta capacidade de escolher a frequência 
de trabalho do rádio em 2,4 GHZ ou 5 

GHz é cumprida por poucos modelos de 
AP's, piorando a competitividade do 

edital.
14. Deve possuir potência de transmissão configurável em 
incrementos de 0,5 dBm;

Alterar
14. Deve possuir potência de transmissão 
configurável em incrementos de 1,0 dBm;

16. Deve suportar Advanced Cellular Coexistence (ACC) 
minimizando a interferência das redes celulares;

Retirar
Esta funcionalidade ACC impede a ampla 

participação dos fabricantes.

18. Deve suportar Cyclic delay/shift diversity (CDD/CSD) 
para melhorar o desempenho RF de downlink;

Alterar
18. Deve suportar Cyclic delay/shift diversity 
(CDD/CSD) ou beamforming para melhorar o 

desempenho RF de downlink;
19. Deve suportar Short guard interval para canais de 20-
MHz, 40-MHz e 80-MHz;

Alterar 19. Deve suportar Short guard interval;

Gerenciamento

30. O ponto de acesso deve permitir a conversão de modo 
auto gerenciado para modo gerenciado por controlador 
WLAN através de interface gráfica, em browser padrão 
(HTTPS), e permitir que todos os demais pontos de acesso 
pertencentes ao mesmo cluster, também sejam convertidos 
automaticamente;

Alterar

30. O ponto de acesso deve permitir a 
conversão de modo gerência nativa para 
modo gerenciado completa através de 
inserção de licenciamento em interface 
gráfica, em browser padrão (HTTPS), e 
permitir que todos os demais pontos de 
acesso também sejam convertidos para este 
modo;

58. Possuir LED’s indicativos do estado de operação, da 
atividade do rádio e da interface Ethernet;

Alterar
58. Possuir LED’s ou LED indicativo do 

estado de operação do ponto de acesso;

a. EAP- MD5 Retirar
Método não é seguro e sua utilização não 

é mais recomendada.

82. Possuir um MTBF (Mean Time Between Failure - Período 
Médio entre Falhas) de, no mínimo, 250.000 horas.

Retirar
Tipo de informação que não está 

disponível para todos os fabricantes e 
restringe a ampla participação.
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 02 de maio de 2019.
À COINF
 
1- Juntamos ao procedimento novo arquivo em PDF encaminhado
pela empresa SmartWave Networks, que trata de pedido de ajustes
ao termo de referência; conforme relatado pelo Senhor Isaac Santos -
Executivo de Vendas - NE, ao qual informou que, em visita a essa
Unidade, foi orientado a enviar o arquivo para a devida análise e
manifestação, eventos 0535070 e 0535071.
 
2- Peço, ainda, a colaboração para a avaliação da Ata de Registro de
Preços ARP Nº 30/2018 - IFES, encaminhada pela empresa ISH
Tecnologia S/A, quanto à equivalência a itens correspondentes com o
termo de referência em questão e também em um eventual interesse
da Administração na adesão, eventos 0533075, 0533076 e 0533078.
 
Respeitosamente.

 

Documento assinado eletronicamente por ANA PAULA GOMES SILVA, Técnico
Judiciário, em 02/05/2019, às 14:41, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0535072 e o código CRC EBC65D0E.
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Status da mensagem: Mensagem foi respondida

De: Jose A Muniz JUNIOR - NEWSUPRI <junior@newsupri.com.br> 

Para:
TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-
al.jus.br>

Data: 03/05/2019 10:45 AM

Assunto:
[seic] RES: Solicitação. Cotação. Aquisição de componentes de
rede sem fio e cabeada. TREAL

Prezada Senhora

Segue anexo com nossa proposta de preços dos itens solicitados.

Atenciosamente,

NEWSUPRI

-----Mensagem original-----

De: TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-al.jus.br>

Enviada em: terça-feira, 16 de abril de 2019 14:18

Assunto: Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada.

TREAL

Prezado Senhor(a),

Boa tarde,

Reiteramos pedido de cotação abaixo:

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem

fio e cabeada, mediante  sistema de registro de preços, distribuídos em lote 01 e

lote 02, conforme descrição do produto/serviço, quantitativos e demais especificações

constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

Atenciosamente.

Ana Paula Gomes Silva

Seção de Instrução de Contratações (SEIC) - TRE/AL seic@tre-al.jus.br anasilva@tre-

al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às

13:30h.

Tribunal Regional Eleitoral de Alagoas - TRE/AL.

Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL CNPJ nº:

06.015.041/0001-38

Telefones: 82 2122-7712/7711

[2] Arquivo: Proposta Newsupri para
TRE-AL REDE.pdf

Tamanho:
383k

Tipo de Conteúdo:
application/pdf

WorldClient https://webmail.tre-al.gov.br:3001/WorldClient.dll?Session=ME2R...

1 de 2 03/05/2019 11:12
E-mail Proposta. NewSupri. (0535904)         SEI 0008478-63.2018.6.02.8000 / pg. 232



WorldClient https://webmail.tre-al.gov.br:3001/WorldClient.dll?Session=ME2R...

2 de 2 03/05/2019 11:12
E-mail Proposta. NewSupri. (0535904)         SEI 0008478-63.2018.6.02.8000 / pg. 233



 

 

 SUPRISERVI COM REPS E 

SERVIÇOS LTDA 
www.newsupri.com.br 

marketing@newsupri.com.br 

Central Recife – PE 
R. Gal. Góes Monteiro, 308 

Imbiribeira – 51170-560 
(81) 3-8500 / fax (81) 3472-8501 

Filial Aracajú – SE 
Av. Dep. Sílvio Teixeira, 1300 Conj. 122 

Grageru – 49025-010 
(79) 3217-1341 / Fax  3217-4274 

Filial Maceió – AL 
R. Dep. José Lages, 972 
Ponta Verde – 5705-330 

(82) 3327-7703 / Fax  3327-9406 

Filial João Pessoa - PB 
Av. Almirante Barroso, 637 – lj105 

– Centro - CEP 58013-120  
(81) 3366-8500 / fax (81) 3366-

8501 

 

José Muniz JUNIOR 

Div. Comercial 
 
(81) 3366-8500 

junior@newsupri.com.br 

 

Recife, 03 de maio de 2019 
 
Ao 
TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS 
Att.:  Ana Paula Gomes Silva 

Seção de Instrução de Contratações (SEIC) - TRE/ 
 
Ref.: Proposta Comercial Redes 
  
 
 
Prezada Senhora, 
      
É com imensa satisfação que apresentamos a seguir, conforme solicitação de V. Sas., nossa proposta comercial para 
fornecimento de nossos produtos para atender escopo da solicitação recebida através do seu e-mail de 16/04/2019.  
 
Esperando ter atingido as finalidades de sua consulta, colocamo-nos a sua inteira disposição para quaisquer 
esclarecimentos adicionais. 
 
 
Atenciosamente. 
 
 
 
José Alves Muniz Junior  
Divisão Comercial – NEWSUPRI 
E-mail: junior@newsupri.com.br   
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 SUPRISERVI COMÉRCIO, REPRESENTAÇÕES 
E SERVIÇOS LTDA 

 
 

www.newsupri.com.br 
marketing@newsupri.com.br Página 2 de 6 

 

 

Restrições de Uso e Divulgação da Proposta 

As informações (dados) que constam de todas as folhas deste documento / cotação constituem informações 
confidenciais da Newsupri- Supriservi Com. Representações e Serviços LTDA (doravante referenciada “Newsupri”). 
 
As informações fornecidas ao cliente não podem ser usadas ou divulgadas, sem a prévia autorização da NEWSUPRI, 
para propósitos que não sejam os de avaliação da proposta. 
 
As propostas da NEWSUPRI poderão ser submetidas via e-mail e mídia eletrônica para sua conveniência. Se o 
conteúdo diferenciar entre as cópias impressas e mídia eletrônica, somente o conteúdo da impressa será garantido 
pela NEWSUPRI. 
 
Informações sensíveis / confidenciais que poderão ser necessárias para conclusão do projeto podem ser amparadas 
por um contrato de não divulgação (NDA- non-disclosure agreement) entre as partes. 
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Planilha de Preços 

 
 

LOTE 01 - SOLUÇÃO PARTA REDE CABEADA 

ITEM DESCRIÇÃO DOS PRODUTOS/SERVIÇOS QTD 
PREÇO 

UNITÁRIO 
EM REAIS 

PREÇO 
TOTAL 

EM REAIS 

ITEM 01 
SOLUÇÃO DE ANÁLISE DE PERFIL E 
CONTROLE DE ACESSO PARA REDE 
CABEADA 

1 R$ 114.350,25 R$ 114.350,25 

ITEM 02 
LICENCIAMENTO ADICIONAL PARA 
SISTEMA DE GERENCIAMENTO HPE IMC 

3 R$ 17.767,50 R$ 53.302,50 

ITEM 03 
LICENCIAMENTO ADICIONAL DO 
MÓDULO DE ANÁLISE DE TRÁFEGO DO 
SISTEMA DE GERENCIAMENTO HPE IMC 

2 R$ 14.549,60 R$ 29.099,20 

ITEM 04 
LICENCIAMENTO ADICIONAL DA 
SOLUÇÃO DE ANÁLISE DE PERFIL E 
CONTROLE DE ACESSO 

2 R$ 54.519,80 R$ 109.039,60 

ITEM 05 
SWITCH DE DISTRIBUIÇÃO COM 16 
PORTAS SFP+ E SUPORTE A MÓDULOS 
DE EXPANSÃO 

6 R$ 54.340,00 R$ 326.040,00 

ITEM 06 
MÓDULO COM 4 PORTAS SFP+ PARA 
SWITCH DE DISTRIBUIÇÃO 

16 R$ 5.239,52 R$ 83.832,32 

ITEM 07 
MÓDULO DE STACKING COM 4 PORTAS 
PARA SWITCH DE DISTRIBUIÇÃO 

6 R$ 4.433,90 R$ 26.603,40 

ITEM 08 
SWITCH DE ACESSO L3 COM 48 PORTAS 
GIGABIT E 4SFP+ 

50 R$ 23.608,00 R$ 1.180.400,00 

ITEM 09 
SWITCH DE ACESSO L3 COM 24 PORTAS 
GIGABIT E 4SFP+ 

40 R$ 16.082,56 R$ 643.302,40 

ITEM 10 
SWITCH DE ACESSO L2 COM 24 PORTAS 
GIGABIT E 4SFP 

50 R$ 5.565,00 R$ 278.250,00 

ITEM 11 
SWITCH DE ACESSO L2 COM 48 PORTAS 
GIGABIT E 4SFP 

40 R$ 9.100,00 R$ 364.000,00 

ITEM 12 GBIC 10GB PARA ATÉ 300M 50 R$ 2.480,40 R$ 124.020,00 

ITEM 13 CABO DAC 10 GBPS DE 1M 30 R$ 608,40 R$ 18.252,00 

ITEM 14 CABO DAC 10 GBPS DE 3M 30 R$ 939,75 R$ 28.192,50 
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ITEM 15 GBIC 1GB PARA ATÉ 500M 10 R$ 1.324,96 R$ 13.249,60 

ITEM 16 
SERVIÇOS DE IMPLANTAÇÃO E 
TRANSFERÊNCIA DE TECNOLOGIA PARA 
SWITCHS DE REDE 

5 R$ 22.027,09 R$ 110.135,45 

ITEM 17 
SERVIÇOS DE IMPLANTAÇÃO E 
TRANSFERÊNCIA DE TECNOLOGIA DO 
MÓDULO DE CONTROLE DE ACESSO 

1 R$ 63.407,80 R$ 63.407,80 

ITEM 18 
TREINAMENTO BÁSICO DE 
ADMINISTRAÇÃO DE SWITCHES 

4 R$ 29.795,00 R$ 119.180,00 

ITEM 19 
TREINAMENTO BÁSICO DA SOLUÇÃO DE 
CONTROLE DE ACESSO 

4 R$ 30.680,00 R$ 122.720,00 

PREÇO TOTAL DA PROPOSTA EM REAIS R$ 3.807.377,02 

 
 

LOTE 02 - SOLUÇÃO DE REDE WIRELESS 

ITEM DESCRIÇÃO DOS PRODUTOS/SERVIÇOS QTD 
PREÇO 

UNITÁRIO 
EM REAIS 

PREÇO 
TOTAL 

EM REAIS 

ITEM 01 
SOLUÇÃO DE ANÁLISE DE PERFIL E 
CONTROLE DE ACESSO PARA REDE 
WIRELESS 

1 R$ 111.919,50 R$ 111.919,50 

ITEM 02 
SOLUÇÃO DE GERENCIAMENTO DE REDE 
WIRELESS 

1 R$ 642,60 R$ 642,60 

ITEM 03 
LICENÇAS ADICIONAIS PARA SOLUÇÃO 
DE GERENCIAMENTO DE REDE WIRELESS 

200 R$ 648,90 R$ 129.780,00 

ITEM 04 
LICENCIAMENTO ADICIONAL DA 
SOLUÇÃO DE ANÁLISE DE PERFIL E 
CONTROLE DE ACESSO 

2 R$ 59.607,60 R$ 119.215,20 

ITEM 05 CONTROLADORA WLAN 4 R$ 70.686,00 R$ 282.744,00 

ITEM 06 
LICENÇAS ADICIONAIS PARA 
CONTROLADORA WLAN 

200 R$ 948,60 R$ 189.720,00 

ITEM 07 PONTO DE ACESSO INTERNO TIPO 01 100 R$ 5.709,60 R$ 570.960,00 

ITEM 08 PONTO DE ACESSO INTERNO TIPO 02 100 R$ 2.504,80 R$ 250.480,00 

ITEM 09 
INJETOR POE PARA PONTOS DE ACESSO 
TIPO 1 

100 R$ 756,02 R$ 75.602,00 

ITEM 10 
INJETOR POE PARA PONTOS DE ACESSO 
TIPO 2 

100 R$ 621,18 R$ 62.118,00 
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ITEM 11 
SERVIÇOS DE IMPLANTAÇÃO E 
TRANSFERÊNCIA DE TECNOLOGIA PARA 
SOLUÇÃO DE GERENCIAMENTO 

1 R$ 25.589,20 R$ 25.589,20 

ITEM 12 
SERVIÇOS DE IMPLANTAÇÃO E 
TRANSFERÊNCIA DE TECNOLOGIA DO 
MÓDULO DE CONTROLE DE ACESSO 

1 R$ 64.632,50 R$ 64.632,50 

ITEM 13 
SERVIÇOS DE IMPLANTAÇÃO E 
TRANSFERÊNCIA DE TECNOLOGIA PARA 
PONTOS DE ACESSO 

5 R$ 22.428,00 R$ 112.140,00 

ITEM 14 
TREINAMENTO BÁSICO DE 
ADMINISTRAÇÃO DE ARQUITETURA 
WLAN 

4 R$ 22.627,50 R$ 90.510,00 

ITEM 15 
TREINAMENTO BÁSICO DA SOLUÇÃO DE 
GERENCIAMENTO 

4 R$ 22.196,50 R$ 88.786,00 

ITEM 16 
TREINAMENTO BÁSICO DA SOLUÇÃO DE 
CONTROLE DE ACESSO 

4 R$ 27.948,00 R$ 111.792,00 

PREÇO TOTAL DA PROPOSTA EM REAIS R$ 2.286.631,00 
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Condições Comerciais  

Preços 

- Os preços dos serviços apresentados nesta proposta estão expressos em Reais; 

Condições de Pagamento 

Em até 5 (cinco) dias após entrega, mediante emissão de NF. 

Tributos 

Os preços incluem todos os tributos incidentes. Quaisquer alterações que venham a ser impostas, por força 

de lei, nas alíquotas e/ou bases de cálculo até a data do faturamento serão integralmente repassadas ao 

cliente. 

Prazo de Entrega / Execução 

Em até 60 (sessenta) dias após recebimento de nota de empenho e contrato assinado.  

Validade da Proposta 

Validade até 60 (sessenta) dias após emissão 

Faturamento 

O Faturamento será realizado pela NS, com base nas informações dessa proposta. 

Dados Cadastrais da NEWSUPRI 

R.SOCIAL: SUPRISERVI COMÉRCIO, REPRESENTAÇÕES E SERVIÇOS LTDA. 

END.: Rua Gal. Goes Monteiro, 308 – Imbiribeira – Cep 51170-560 – Recife – PE 

Fone: (081) 3366-8500  Fax: (081) 3366-8501 E-mail: vendas@newsupri.com.br 

CNPJ: 12.707.105/0001-64 Insc.Estadual: 0201069-04 Insc.Municipal: 239.461-8 
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De: Felipe Moyses Vieira <felipe.vieira@ish.com.br> 

Para:
TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-
al.jus.br>

Data: 03/05/2019 02:29 PM

Assunto:
[seic] RES: Solicitação. Cotação. Aquisição de componentes de
rede sem fio e cabeada. TREAL

Prezada Ana Paula,

Analisamos o documento e fizemos uma comparação com os itens da nossa Ata de Rede
vigente. Pelo que vimos, a nossa Ata atende com ressalvas o lote 1 (Rede Cabeada); e
atende quase em sua totalidade o lote 2 (Rede Não Cabeada):

LOTE 1 - Infraestrutura de rede cabeada - Pontos críticos:

Item 2: TRE-AL pede IMC. Nossa Ata apresenta o AirWave tanto para a Rede Cabeada
quanto a Não Cabeada;
Itens 3 e 4: TRE-AL pede suporte com tempo de resposta de 4h. Nossa ata permite
responder por telefone em até 4 horas, mas 8x5 NBD para substituição;
Itens 8 e 9:  TRE-AL pede Switches L3. Nossa ata não possui Switches L3, mas possui
Switches Core chassi e módulos que podem atender aos requisitos;

LOTE 2 - Infraestrutura de rede não cabeada - Pontos críticos:

Item 2: TRE-AL pede IMC. Nossa Ata apresenta o AirWave tanto para a Rede Cabeada
quanto a Não Cabeada;
Itens 3 e 4: TRE-AL pede suporte com tempo de resposta de 4h. Nossa ata permite
responder por telefone em até 4 horas, mas 8x5 NBD para substituição;
Itens 9 e 10: TRE-AL  pede injetores PoE. A ata do IFES não possui injetores PoE, mas
apenas Switches já com portas PoE;

Nos colocamos à disposição do time técnico para fazermos uma conferência a fim de
esclarecer esses pontos e outros que também acharem necessários.
Atenciosamente,

Felipe Moyses Vieira
Executivo de Negócios ES
ISH Tecnologia S.A.
Tel.: +55 27 3334.8920 | Cel.: +55 27 98138.5788
www.ish.com.br

-----Mensagem original-----
De: TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-al.jus.br>
Enviada em: quarta-feira, 24 de abril de 2019 15:10
Para: Felipe Moyses Vieira <felipe.vieira@ish.com.br>
Assunto: Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada.
TREAL

Prezado Felipe,

Boa tarde,

Segue arquivo em PDF.

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem
fio e cabeada, mediante  sistema de registro de preços, distribuídos em lote 01 e

WorldClient https://webmail.tre-al.gov.br:3001/WorldClient.dll?Session=IE3ISS4...
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lote 02, conforme descrição do produto/serviço, quantitativos e demais especificações
constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL seic@tre-al.jus.br anasilva@tre-
al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às
13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL CNPJ nº:
06.015.041/0001-38
Telefones: 82 2122-7712/7711

Aviso de Confidencialidade: Esta comunicação deve ser lida apenas pelo seu
destinatário e não pode ser retransmitida sem autorização formal. Caso seja recebida
indevidamente, por favor destrua-a. Qualquer reprodução, alteração, distribuição e/ou
publicação é estritamente proibida.

Notice of Confidentiality: This document should only be read by those persons to whom
it is addressed and can not be relayed without formal permission. If you have
received this e-mail message in error, please destroy it. Any form of reproduction,
modification, distribution and/or publication of this e-mail message is strictly
prohibited.
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 06 de maio de 2019.
À COINF
 
Em complemento ao despacho SEIC 0535072, juntamos e-mail com
algumas considerações da empresa ISH Tecnologia S/A a respeito da
Ata Nº 38/2018-IFES (0536380).
 
Recebemos, ainda, proposta da empresa Plugnet Informática
(0533091) e NewSupri Comércio (0535906).
 
Respeitosamente.
 

Documento assinado eletronicamente por ANA PAULA GOMES SILVA, Técnico
Judiciário, em 06/05/2019, às 13:21, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0536382 e o código CRC 67F22864.

0008478-63.2018.6.02.8000 0536382v1
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De: Eduardo Mazzochi <mazzochi@approachtec.com.br> 

Para: Ana Paula Gomes Silva <anasilva@tre-al.jus.br>

Data: 08/05/2019 05:42 PM

Assunto:
Re: [seic] Solicitação.  Cotação.  Aquisição de componentes de rede sem fio e

cabeada. TREAL

Boa tarde Ana

Conforme conversamos quando es�ve ai, estou enviando para vossa analise proposta para adesão a ARP que temos atualmente

vigente.

Peço que envie a área responsável para verificar a viabilidade de efetuarem a compra por meio de adesão onde facilitaria bastante o

processo de voces.

Qualquer duvida por favor entre em contato.

De: Ana Paula Gomes Silva <anasilva@tre-al.jus.br>

Data: quinta-feira, 2 de maio de 2019 13:21

Para: Eduardo Mazzochi <mazzochi@approachtec.com.br>

Assunto: Re: [seic] Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL

Boa tarde Eduardo,

Aguardamos. Obrigada.

Atenciosamente.

Ana Paula Gomes Silva

Seção de Instrução de Contratações (SEIC) - TRE/AL

seic@tre-al.jus.br

anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.

Tribunal Regional Eleitoral de Alagoas - TRE/AL.

Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL

CNPJ nº: 06.015.041/0001-38

Telefones: 82 2122-7712/7711

From: Eduardo Mazzochi <mazzochi@approachtec.com.br>
To: TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-al.jus.br>
Date: Fri, 26 Apr 2019 21:36:28 +0000
Subject: [seic] Solicitação.  Cotação.  Aquisição de componentes de rede sem fio e cabeada. TREAL

Boa tarde Ana Paula
Iremos estudar o Termo de Referencia de renovação e enviaremos o mais breve
possível a proposta para voces.

Em 25/04/2019 16:50, "TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES" <seic@tre-
al.jus.br> escreveu:
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    Prezado Eduardo,

    Boa tarde,

    Conforme conversamos, no dia de hoje, em visita a este Tribunal, encaminho
pedido de cotação abaixo:

    O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de
rede sem fio e cabeada, mediante  sistema de registro de preços, distribuídos em
lote 01 e lote 02, conforme descrição do produto/serviço, quantitativos e demais
especificações constantes do termo de referência em anexo.

    Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

    Atenciosamente.

    Ana Paula Gomes Silva
    Seção de Instrução de Contratações (SEIC) - TRE/AL

seic@tre-al.jus.br

anasilva@tre-al.jus.br

    Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira:
07:30 às 13:30h.
    Tribunal Regional Eleitoral de Alagoas - TRE/AL.
    Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL
    CNPJ nº: 06.015.041/0001-38
    Telefones: 82 2122-7712/7711

[2] Arquivo: 2019-TRE-AL-SWITCHES-v1[1].pdf Tamanho: 596k Tipo de Conteúdo: application/pdf

[3] Arquivo: 2019-TRE-AL-WiFi-v1[1].pdf Tamanho: 592k Tipo de Conteúdo: application/pdf

Download arquivo zip contendo todos os anexos
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Projeto de Aquisição de Switches 

Cliente: TRE-AL 

8 de maio de 2019 

 
 
 
 
 
 
 

Eduardo Mazzochi 
Executivo de contas 

mazzochi@approachtec.com.br | 48 9 9621-7551 
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www.approachtec.com.br 

CNPJ: 24.376.542-0001/21 
Razão Social: Approach Tecnologia Ltda Av. Prefeito Osmar Cunha, 416 – Centro – Florianópolis – SC – CEP 88015-100 - Tel (48) 4009.2160 

 

1. Descrição do projeto 

 

O projeto proposto compreende o fornecimento de uma solução para rede LAN através da Ata de 

Registro de Preço 47/2018 da UFPI. 

 

2. Itens e valores 

 

 

3. Premissas e observações 

• Nenhuma. 

 

4. Condições comerciais 

• Prazo de entrega: Em até 60 (sessenta) dias após a confirmação do pedido. 

• Validade da proposta: 30 (trinta) dias. 

 

5. Confidencialidade 

As informações contidas nesta proposta são confidenciais e fornecidas para a finalidade exclusiva 

de apresentação técnica e comercial da Approach Tecnologia a pedido do cliente, e não deve, de 

forma alguma, ser utilizada para qualquer outra finalidade. 

 

Atenciosamente, 

Eduardo Mazzochi 
Executivo de contas 

mazzochi@approachtec.com.br | 48 9 9621-7551 

Item ARP Item Fabricante Modelo Descrição Un Qtd Valor Unit. Valor Total

1 1 HPE JH714AAE Expansão IMC Standard - 50 devices Un 3 15.890,00R$      47.670,00R$           

4 2 HPE JL430A Switch de distribuição 3810M 24 SFP+ Un 1 74.074,00R$      74.074,00R$           

8 3 HPE JG932A Switch de acesso 5130 24 portas - tipo 1 Un 10 17.650,00R$      176.500,00R$        

9 4 HPE JG943A Switch de acesso 5130 48 portas - tipo 1 Un 8 26.015,00R$      208.120,00R$        

12 6 HPE J9777A Switch de acesso 2530 24 portas - tipo 2 Un 20 4.515,20R$         90.304,00R$           

13 7 HPE J9775A Switch de acesso 2530 48 portas - tipo 2 Un 15 7.880,00R$         118.200,00R$        

14 8 HPE J9150D Transceiver 10 Gigabit SR SFP+ Multimodo Un 20 2.810,00R$         56.200,00R$           

16 9 HPE J4858D Transceiver 1 Gigabit SFP Multimodo Un 10 862,00R$              8.620,00R$              

18 10 HPE J9281D Cabo DAC 10 GbE SFP+ 1 metro Un 30 411,00R$              12.330,00R$           

19 11 HPE J9283D Cabo DAC 10 GbE SFP+ 3 metros Un 10 584,00R$              5.840,00R$              

878.198,00R$        Subtotal
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Projeto de Aquisição de Rede Wireless 

Cliente: TRE-AL 

8 de maio de 2019 

 
 
 
 
 
 
 

Eduardo Mazzochi 
Executivo de contas 

mazzochi@approachtec.com.br | 48 9 9621-7551 
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www.approachtec.com.br 

CNPJ: 24.376.542-0001/21 
Razão Social: Approach Tecnologia Ltda Av. Prefeito Osmar Cunha, 416 – Centro – Florianópolis – SC – CEP 88015-100 - Tel (48) 4009.2160 

 

1. Descrição do projeto 

 

O projeto proposto compreende o fornecimento de uma solução para rede wireless através da Ata 

de Registro de Preço 15/2018 da UNIFAP. 

 

2. Itens e valores 

 

 

 

3. Premissas e observações 

• Nenhuma. 

 

4. Condições comerciais 

• Prazo de entrega: Em até 60 (sessenta) dias após a confirmação do pedido. 

• Validade da proposta: 30 (trinta) dias. 

 

5. Confidencialidade 

As informações contidas nesta proposta são confidenciais e fornecidas para a finalidade exclusiva 

de apresentação técnica e comercial da Approach Tecnologia a pedido do cliente, e não deve, de 

forma alguma, ser utilizada para qualquer outra finalidade. 

 

Atenciosamente,  

Eduardo Mazzochi 
Executivo de contas 

mazzochi@approachtec.com.br | 48 9 9621-7551 

Item ARP Item Fabricante Modelo Descrição Un Qtd Valor Unit. Valor Total

1 1 HPE/Aruba AP-305 Ponto de acesso interno AP-305 - acompanha fonte AC e kit de montagem - garantia "lifetime" Un 200 3.386,00R$         677.200,00R$        

3 2 HPE/Aruba JW627A Injetor PoE 802.3AF Un 200 303,10R$              60.620,00R$           

4 3 HPE/Aruba JW751A Wireless LAN Controller  Aruba 7220 Un 2 204.000,00R$   408.000,00R$        

5 4 HPE/Aruba LIC-AP,LIC-RFP-LIC-PEF Conjunto de licenças de ponto de acesso para controladora Un 200 956,00R$              191.200,00R$        

6 5 HPE/Aruba JW546AAE Licença para software de gerenciamento centralizado - Aruba AirWave - 3 anos de suporte Un 202 442,00R$              89.284,00R$           

7 4 Approach Approach Serviço de instalação lógica e treinamento Un 1 31.000,00R$      31.000,00R$           

1.457.304,00R$    Subtotal
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 08 de maio de 2019.
À COINF
 
Em complemento ao despacho SEIC 0536382, juntamos ao
procedimento 02 (duas) Atas de Registro de Preços, as quais
recebemos, na tarde de hoje, encaminhadas pela empresa Approach
Tecnologia, ARP Nº 47/2018-UFPI e ARP Nº 15/2018-UNIFAP; e,
solicitamos, mais uma vez, o apoio dessa Unidade para análise e
verificação quanto a equivalência dos referidos itens, conforme
eventos 0538462, 0538465 e 0538466.
 
Respeitosamente.

Documento assinado eletronicamente por ANA PAULA GOMES SILVA, Técnico
Judiciário, em 08/05/2019, às 19:24, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0538467 e o código CRC 324D6ED9.

0008478-63.2018.6.02.8000 0538467v1
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 13 de maio de 2019.
À SEIC,
 
Em atenção ao Item 01 do Despacho SEIC 0535072,

considerando os itens abaixo, esta unidade técnica entende
por acatar alguns itens propostos, sem que haja com isso
prejuízo às pesquisas de preços até aqui executadas.

Quadro de pessoal da COINF/SEGI bastante reduzido
Plataforma de gerenciamento em uso atualmente para toda a infraestrutura de
rede, incluindo equipamentos cabeados e sem fio é o HPE IMC
Investimento já realizado na plataforma de gerenciamento
Abandonar o legado já investido em aquisições, treinamentos, conhecimento
adquirido, curva de aprendizado tanto no softwasre quanto em equipamentos e
plataforma administrativas, equipamentos, etc.

Neste sentido, remete-se no Termo de Referência
atualizado.

 
Atenciosamente.

Documento assinado eletronicamente por DANIEL MACÊDO DE CARVALHO SOUTO,
Coordenador, em 15/05/2019, às 13:37, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0540351 e o código CRC C5C61C5C.

0008478-63.2018.6.02.8000 0540351v1
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 15 de maio de 2019.
À SEIC
 
Sr. Chefe,
 
Quanto à análise da Ata nº 30/2018 - IFES, doc.

0536380, observa-se as seguintes similaridades:
 

Item da ARP 30/2018 do IFES (Grupo 01) - Ata da
empresa ISH

Termo de Referência Networking -
TRE/AL

Item 01 Lote 01 - Item 10

Item 03 Lote 01 - Item 08

Item 11 Lote 01 - Item 14

Item 14 Lote 01 - Item 15

Item 15 Lote 01 - Item 12

Item 16 Lote 02 - Item 07

Item 17 Lote 02 - Item 08

 
Atenciosamente.

Documento assinado eletronicamente por DANIEL MACÊDO DE CARVALHO SOUTO,
Coordenador, em 15/05/2019, às 10:24, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0541607 e o código CRC 265199EC.

0008478-63.2018.6.02.8000 0541607v1

  

Despacho COINF 0541607         SEI 0008478-63.2018.6.02.8000 / pg. 251



TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

Termo de Referência - TIC nº 24 / 2019

Termo de Referência - Soluções de Tecnologia da Informação

QUADRO RESUMO 

01. Objeto Registro de Preço para aquisição de componentes de rede (Networking)

LOTE 01 - SOLUÇÃO PARTA REDE CABEADA

ITEM DESCRIÇÃO DOS PRODUTOS/SERVIÇOS QTD

ITEM
01

SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE
ACESSO PARA REDE CABEADA 01

ITEM
02

LICENCIAMENTO ADICIONAL PARA SISTEMA DE
GERENCIAMENTO HPE IMC 03

ITEM
03

LICENCIAMENTO ADICIONAL DO MÓDULO DE ANÁLISE
DE TRAFEGO DO SISTEMA DE GERENCIAMENTO HPE
IMC

02

ITEM
04

LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE
ANÁLISE DE PERFIL E CONTROLE DE ACESSO 02

ITEM
05

SWITCH DE DISTRIBUIÇÃO COM 16 PORTAS SFP+ E
SUPORTE A MÓDULOS DE EXPANSÃO 06

ITEM
06

MÓDULO COM 4 PORTAS SFP+ PARA SWITCH DE
DISTRIBUIÇÃO 16

ITEM
07

MÓDULO DE STACKING COM 4 PORTAS PARA SWITCH
DE DISTRIBUIÇÃO 06

ITEM
08

SWITCH DE ACESSO L3 COM 48 PORTAS GIGABIT E
4SFP+ 50

ITEM
09

SWITCH DE ACESSO L3 COM 24 PORTAS GIGABIT E
4SFP+ 40

ITEM
10

SWITCH DE ACESSO L2 COM 24 PORTAS GIGABIT E
4SFP 50

ITEM
11

SWITCH DE ACESSO L2 COM 48 PORTAS GIGABIT E
4SFP 40

ITEM
12 GBIC 10GB PARA ATÉ 300M 50

ITEM
13 CABO DAC 10 GBPS DE 1M 30

ITEM
14 CABO DAC 10 GBPS DE 3M 30

ITEM
15 GBIC 1GB PARA ATÉ 500M 10
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02. Quantidade

ITEM
16

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE
TECNOLOGIA PARA SWITCHS DE REDE 05

ITEM
17

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO 01

ITEM
18

TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE
SWITCHES 04

ITEM
19

TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE
DE ACESSO 04

LOTE 02 - SOLUÇÃO DE REDE WIRELESS

ITEM DESCRIÇÃO DOS PRODUTOS/SERVIÇOS QTD

ITEM
01

SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE
ACESSO PARA REDE WIRELESS 01

ITEM
02 SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS 01

ITEM
03

LICENÇAS ADICIONAIS PARA SOLUÇÃO DE
GERENCIAMENTO DE REDE WIRELESS 200

ITEM
04

LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE
ANÁLISE DE PERFIL E CONTROLE DE ACESSO 02

ITEM
05 CONTROLADORA WLAN 04

ITEM
06 LICENÇAS ADICIONAIS PARA CONTROLADORA WLAN 200

ITEM
07 PONTO DE ACESSO INTERNO TIPO 01 100

ITEM
08 PONTO DE ACESSO INTERNO TIPO 02 100

ITEM
09 INJETOR POE PARA PONTOS DE ACESSO TIPO 1 100

ITEM
10 INJETOR POE PARA PONTOS DE ACESSO TIPO 2 100

ITEM
11

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE
TECNOLOGIA PARA SOLUÇÃO DE GERENCIAMENTO 01

ITEM
12

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO 01

ITEM
13

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE
TECNOLOGIA PARA PONTOS DE ACESSO 05

ITEM
14

TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE
ARQUITETURA WLAN 04

ITEM
15

TREINAMENTO BÁSICO DA SOLUÇÃO DE
GERENCIAMENTO 04
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ITEM
16

TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE
DE ACESSO 04

03. Resumo da Especificação do
Objeto

Por se tratar de quantidade elevata de itens partencente a lotes específicos, o
detalhamento das especificações está consntante no DETALHAMENTO DO OBJETO (Art. 18, § 3º, III).

04. Valor Estimado Os custos totais projetados, por certo, serão objeto de levantamento por parte da Seção
de Compras, em momento porterior.

05. Justificativa

A dependência tecnológica para o adequado funcionamento de qualquer instituição é na prática, total;
A malha de comunicação de rede interna é primordial para  acesso aos sistemas e serviço informatizados e
desta maneira essencial;
Grande parte dos equipamentos de rede do Tribunal está defasado tecnologicamente,  fora de garantia ou na
iminência de término da mesma;
Permitir a qualificação da equipe da CONIF para o gerenciamento das soluções a serem adquiridas;
Maiores detalhes disponíveis no Item 2 do Documento de Oficialização da Demanda.

06. Prazo de Entrega
O prazo máximo para o fornecimento das licenças é de 90 (noventa) dias corridos após o recebimento da ordem
de fornecimento, nota de empenho ou documento equivalente. Não podendo ultrapassar, conforme o caso, o dia
15 de dezembro ou dia útil subsequente considerado cada exercício individualmente, em decorrência dos efeitos
da Emenda Constitucional nº 95/2016

07. Adjudicação
Por Lote.

Justificativa: Plena exigência de total compatibilidade e interoperabilidade entre em componentes do respectivo lote,
como também quanto à solução de gerenciamento em uso no TRE/AL.

08. Classificação Orçamentária (A cargo da COFIN).

09. Local de Entrega

Almoxarifado do Tribunal Regional Eleitoral de Alagoas

Av. Menino Marcelo, 7200D, Serraria

Maceió – AL CEP 57046-005 Tel.: (82) 3328-1947

Horário: De segunda-feira a quinta-feira das 13 às 19h e sexta-feira das 7h30min Às 13h30min.
10. Unidade Fiscalizadora SEGI/CIE/STI
11. Unidade Gestora SAD

12. Sanções Administrativas
Vide

Item 3.2 Forma de Execução e de Gestão do Contrato (Art. 18, § 3º, III, a)
Subitem Penalidades (Art. 18, § 3º, III, a, 11)

13. Prazo de Pagamento
Vide 

Item 3.2 Forma de Execução e de Gestão do Contrato (Art. 18, § 3º, III, a)
Subitem Forma de Pagamento (Art. 18, § 3º, III, a, 7)

14. Estratégia de Recebimento
Vide 

Item 3.2 Forma de Execução e de Gestão do Contrato (Art. 18, § 3º, III, a)
Subitem Recebimento do Objeto:

15. Modalidade e Tipo de
Licitação

Vide

2.11 Modalidade, Tipo de Licitação, Critérios de Habilitação e Atendimento aos Requisitos (Art. 18, § 3º, II, j, IV e V)

 

1. OBJETO (Art. 18, §3º,I):
 

Registro de Preço para aquisição de componentes de rede sem
fio e cabeada.

1.1 Definição (Art. 18, §3º, I)

Registro de Preço para aquisição de computadores  para
substituir equipamentos fora de garantia e/ou obsoletos.
2. FUNDAMENTAÇÃO DA CONTRATAÇÃO (Art. 18, § 3º, II)
 
2.1 Motivação (Art. 18, § 3º, II, a )

Os equipamentos tem por finalidade a substituição, por atualização tecnológica, de
equipamentos, ora em uso, com aproximadamente 04 (quatro) anos e já não mais
cobertos por garantia. Estes aspectos, a um só tempo, a se falar em TI, evidenciam a
necessidade de atualização e de demanda de salvaguarda, esculpida em garantia, da
efetividade e continuidade do mister da Secretaria.

 

A estratégia de Registro de Preços está amparada no Decreto nº 7.892/2013, art 3º,
incisos:

I - vez que os equipamentos podem ser objeto de diversas aquisições/fornecimentos
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até que se supra progressivamente toda a demanda de substituição progressiva;

II - as entregas deve ser progressivas de forma que as equipes da STI, em número
limitado, possam implantar os equipamentos sem que os mesmo precisem ser
estocados por longos períodos apenas exaurindo seus prazos de garantia.

2.2 Objetivos (Art. 18, § 3º, II, b)
A contratação visa, além de promover ações no sentido de

elaborar novo instrumento que mantenha um meio para disponibilizar os
computadores demandados e:

Garantir a infraestrutura física apropriadas às atividades
administrativas e judiciais.

Prover infraestrutura de TIC apropriada às atividades judiciais e
administrativas.
2.3 Benefícios (Art. 18, § 3º, II, c)

Reposição de equipamentos defasados e manutenção da capacidade produtiva
atualizada.

2.4 Alinhamento Estratégico (Art. 18, § 3º, II, d)

O alinhamento com o PEI é identificado na visão do recursos de infraestrutura e
tecnologia em seus dois aspectos apontados:

Garantir a infraestrutura física apropriadas às atividades administrativas e judiciais.

Alinhamento com os Objetivos Estratégicos da Estratégia Nacional de TIC do Poder
Judiciário nos seguintes aspectos:

Prover infraestrutura de TIC apropriada às atividades judiciais e administrativas.

Alinhamento com os Objetivos Estratégicos de TIC da Justiça Eleitoral de Alagoas –
2017/2022 nos seguintes aspectos:

Viabilizar serviços e soluções de TIC.

 

2.5 Referência aos Estudos Preliminares (Art. 18, § 3º, II, e)
Este Termo de Referência foi elaborado considerando o

Documento de Oficialização de Demanda (DOD) encaminhado pela Secretaria
de Tecnologia da Informação (STI) e os Estudos Preliminares constantes do
Processo SEI nº 0008478-63.2018.6.02.8000.
2.6 Relação entre a Demanda Prevista e a Contratada (Art. 18, §3º, II, f)

É pretendida a renovação do parque de equipamentos
componentes da infraestrutura de TIC.
2.7 Análise de Mercado de TIC (Art. 18, § 3º, II, g)

Verifica-se que os bens e serviços pretendidos poderão ser
fornecidos por diferentes empresas no mercado de TIC.

Considerando o Item 7 dos Estudos Preliminares, não se
vislumbrou alternativa que não o presente Registro de Preços.

 
2.8 Natureza do Objeto (Art. 18, § 3º, II, h)

Os bens e serviços a serem contratados possuem características
comuns e usuais encontradas atualmente no mercado de TIC, cujos padrões de
desempenho e de qualidade podem ser objetivamente definidos neste Termo
de Referência.

O objeto desta contratação tem como escopo a obtenção de
produto específico em período determinado, portanto não se caracteriza como
serviço de natureza continuada.
2.9 Parcelamento e Adjudicação do Objeto (Art. 18, § 3º, II, i)

Não haverá parcelamento, cada ordem de fornecimento derivado
do Registro de Preços deverá ser realizada de maneira integral.

Adjudicação será por lote.
2.10 Vigência

Será, na forma dos normativos vigentes, o tempo máximo do
Registro de Preços.

A vigência da ata será de 12 (doze) meses, contados a partir de
sua assinatura.

A utilização do sistema de Registro de Preços visa,
primordialmente, a redução de número de licitações para o mesmo objeto,
porquanto se concentra em um único procedimento a possibilidade de realizar
diversas aquisições recorrentes e necessárias, via ordens de fornecimento,
durante o lapso temporal de sua vigência, em face de os preços
permanecerem à disposição da Administração.
2.11 Modalidade, Tipo de Licitação, Critérios de Habilitação e
Atendimento aos Requisitos (Art. 18, § 3º, II, j, IV e V)

A aquisição pretendida deverá ser realizada por meio de licitação
do tipo Pregão Eletrônico, como é de praxe neste Regional, salvo
entendimento superior contrário.

A sugestão da equipe de planejamento, por se tratar de
fornecimento de equipamento, é pela contratação por licitação via pregão. Por
conta de possibilidade de contingenciamento orçamentário indicamos a
modalidade de registro de preços.
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O DECRETO Nº 7.174, DE 12 DE MAIO DE 2010 que regulamenta a contratação de
bens e serviços de informática e automação pela administração pública federal, direta
ou indireta, pelas fundações instituídas ou mantidas pelo Poder Público e pelas demais
organizações sob o controle direto ou indireto da União deve ser aplicado nesta
aquisição por se tratar de bem de informática.

A ressalva que a equipe aponta é em relação ao artigo 3º, item II que versa sobre a
necessidade de exigências, na fase de habilitação, de certificações emitidas por
instituições públicas ou privadas credenciadas pelo Instituto Nacional de Metrologia,
Normalização e Qualidade Industrial (Inmetro), que atestem, conforme regulamentação
específica, a adequação à segurança para o usuário e instalações, compatibilidade
eletromagnética e consumo de energia.

Tal exigência inviabiliza e restringe a competição deste certame, vez que a certificação
para este tipo de produto, segundo o próprio INMETRO, é voluntária, conforme Portaria
Inmetro n.º 170 de 10/04/2012.

(fonte:http://www.inmetro.gov.br/legislacao/rtac/pdf/RTAC001808.pdf).

pretendida deverá ser realizada por meio de licitação do tipo
Pregão Eletrônico, como é de praxe neste Regional, salvo entendimento
superior contrário.

A sugestão da equipe de planejamento, por se tratar de
fornecimento de equipamento, é pela contratação por licitação via pregão. Por
conta de possibilidade de contingenciamento orçamentário indicamos a
modalidade de registro de preços.

O DECRETO Nº 7.174, DE 12 DE MAIO DE 2010 que regulamenta a contratação de
bens e serviços de informática e automação pela administração pública federal, direta
ou indireta, pelas fundações instituídas ou mantidas pelo Poder Público e pelas demais
organizações sob o controle direto ou indireto da União deve ser aplicado nesta
aquisição por se tratar de bem de informática.

A ressalva que a equipe aponta é em relação ao artigo 3º, item II que versa sobre a
necessidade de exigências, na fase de habilitação, de certificações emitidas por
instituições públicas ou privadas credenciadas pelo Instituto Nacional de Metrologia,
Normalização e Qualidade Industrial (Inmetro), que atestem, conforme regulamentação
específica, a adequação à segurança para o usuário e instalações, compatibilidade
eletromagnética e consumo de energia.

Tal exigência inviabiliza e restringe a competição deste certame, vez que a certificação
para este tipo de produto, segundo o próprio INMETRO, é voluntária, conforme Portaria
Inmetro n.º 170 de 10/04/2012.

(fonte:http://www.inmetro.gov.br/legislacao/rtac/pdf/RTAC001808.pdf).

2.12 Adequação do Ambiente (Art. 18, § 3º, II, k)
Para utilização do objeto pretendido é necessário dispor de

infraestrutura física para sua instalação, situação essa já existente no âmbito
do TRE/AL, salvo o surgimento de demanda muito particular e além da
previsibilidade.
2.13 Conformidade Técnica e Legal (Art. 18, § 3º, II, l)

 
2.14 Obrigações do Contratante (Art. 18, § 3º, II, m)

1. Efetuar o pagamento à Contratada, após o recebimento definitivo;

2. Acompanhar e fiscalizar a execução do objeto da Ata de Registro de Preços e
do(s) contrato(s) dela decorrentes, por meio de servidor(es) designado(s),
de modo a garantir o fiel cumprimento do mesmo e da proposta;

3. Manter arquivo, junto ao processo administrativo ao qual está vinculado o presente termo, toda a documentação referente ao mesmo;

4. Proporcionar todas as facilidades indispensáveis à
boa execução das obrigações contratuais; e

5. Aplicar as sanções conforme previsto no contrato, assegurando à Contratada o contraditório e ampla defesa.

2.15 Obrigações da Contratada (Art. 18, § 3º, II, m)
As obrigações abaixo são aplicáveis ao objeto a ser contratado.

1. Fornecer o(s) equipamento(s) conforme especificações, quantidades, prazos e demais condições estabelecidas no Edital, na
Ata de Registro de Preços, na Ordem de Fornecimento, na Proposta e
no Contrato;

2. Fornecer a documentação necessária à instalação e
à operação dos produtos (manuais, termos de garantia,
etc.), completa, atualizada e em português do Brasil, caso exista, ou
em inglês;

3. Disponibilizar Central
de Atendimento para a abertura e fechamento de chamados técnicos, conforme períodos, horários e condições estabelecidas no Edital e
em seus Anexos;

4. Comunicar formal e imediatamente ao Gestor ou Responsável Técnico da
Administração sobre mudanças nos dados para contato com a Central
de Atendimento;

5. Prestar as informações e os esclarecimentos que venham a
ser solicitados pelo representante da
Administração, referentes a qualquer problema detectado ou
ao andamento de atividades da garantia;

6. Responder
por quaisquer prejuízos que seus profissionais causarem ao patrimônio da
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Administração ou a terceiros,
por ocasião da execução do objeto, procedendo imediatamente aos reparos ou
às indenizações cabíveis e assumindo o ônus decorrente;

7. Responsabilizar-se  integralmente pelo fornecimento dos equipamentos e
pela execução dos serviços de garantia técnica, primando pela qualidade,
desempenho, eficiência e produtividade na execução dos trabalhos,
dentro dos prazos estipulados e cujo descumprimento será considerado
infração passível de aplicação das penalidades previstas neste Termo de
Referência;

8.  Comunicar ao Gestor ou Responsável Técnico, formal
e imediatamente, todas as ocorrências anormais e/ou
que possam comprometer a execução do objeto;

9. Manter sigilo sobre todo e qualquer assunto de interesse da
Administração ou de terceiros de que tomar conhecimento em razão da
execução do objeto, respeitando todos os critérios estabelecidos,
aplicáveis aos dados, informações, regras de negócios, documentos, entre
outros pertinentes, sob pena de responsabilidade civil, penal e
administrativa;

10.  Cumprir e garantir que seus profissionais estejam cientes, aderentes e obedeçam rigorosamente às normas e
aos procedimentos estabelecidos na Política de Segurança da Informação
do TRE/AL;

11.  Responsabilizar-
se pela conservação dos ambientes onde desempenhe as atividades necessárias para prestar a garantia on-
site.

12. Prestar as informações e
os esclarecimentos que venham a ser solicitados pela Administração, referentes a qualquer problema detectado ou
ao andamento de atividades da garantia técnica

13. No caso de fornecimento/entrega, em final de exercício e posterior
ao dia 15 de dezembro ou dia útil imediatamente subsquente, fica
obrigado a aceitar, o cancelamento da ordem de fornecimento por
parte da Administração, em decorrência dos efeitos da Emenda
Constitucional nº 95/2016, sem a reversão de qualquer ônus à
Administração.

DETALHAMENTO DO OBJETO (Art. 18, § 3º, III)
3.1 Descrição do Objeto

CONDIÇÕES GERAIS
1. Todos os itens ofertados por lote, deverão ser do mesmo fabricante para garantir

total compatibilidade entre todos os componentes, sem a utilização de
ferramentas de terceiros ou modo de interoperabilidade na solução;

2. Para o  Lote 01: Todos os itens de software ofertados deverão possuir integração
total com o HPE Intelligent Managment Center (IMC) já existente na infraestrutura
da contratante, através de interface única de gerenciamento e/ou autenticação
centralizada;

3. Para o Lote 01: Os equipamentos fornecidos deverão ser gerenciados pelo HPE
IMC já existente na infraestrutura da contratante, com presença na matriz de
compatibilidade comprovada através de documentação oficial do fabricante;

4. Os equipamentos devem ser novos e estar em produção. Não serão aceitos
equipamentos descontinuados, recondicionados ou usados;

5. Os equipamentos devem ser entregues acondicionados adequadamente em suas
embalagens originais;

6. A(s) solução(ões) de gerenciamento/controle ofertada(s), deverá(ão) ser
baseada(s) em plataforma “On Premise”, ou seja, deverá ser executada
localmente, não sendo aceitas soluções híbridas ou em Cloud;

7. Cada lote deverá ser fornecido por uma única empresa, visando a garantia integral
de compatibilidade dos componentes ofertados;

8. As configurações e especificações aqui apresentadas são mínimas, sendo aceitos
equipamentos/softwares com características superiores, desde que compatíveis
com as exigidas;

9. Prazo de entrega para equipamentos: 60 (sessenta) dias contados a partir da
emissão da ordem de fornecimento ou documento equivalente;

10. Prazo de entrega para softwares: 30 (trinta) dias contados a partir da emissão da
ordem de fornecimento ou documento equivalente;

11. Os serviços de instalação, integração, garantia e suporte dos equipamentos e
softwares, deverão ser realizados diretamente pelo fabricante de acordo com as
exigências contidas no descritivo dos mesmos, estando essas aderentes aos
respectivos níveis de serviço necessários a cada um deles.

 
 
LOTE 01 – SOLUÇÃO DE REDE
CABEADA
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ITEM 01 – SOLUÇÃO DE ANÁLISE DE PERFIL E
CONTROLE DE ACESSO
LICENCIAMENTO

1. Licenciamento da SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE
ACESSO, contemplando o quantitativo mínimo de 1.000 (um mil) dispositivos,
usuários corporativos ou visitantes simultâneos, independente do perfil de
autenticação, seja por dispositivo ou usuário;

2. Caso a solução ofertada necessite de licenciamento específico para
credenciamento dos dispositivos, usuários (corporativos ou visitantes), deverá ser
fornecido o quantitativo solicitado para ambos, de forma que a solução realize a
análise de perfil e o controle de acesso dos 1.000 (um mil) dispositivos ou
usuários (corporativos ou visitantes) simultâneos.

 

MÓDULO DE ANÁLISE DE PERFIL DE DISPOSITIVO
Características Gerais Modulo de Análise de Perfil de Dispositivo

3. Deve implementar funcionalidade de classificação automática criando perfis de
dispositivos, de forma a descobrir, classificar e agrupar os dispositivos
conectados na rede;

4. Deve categorizar os dispositivos em pelo menos 3 níveis:

a. Por tipo de dispositivo (ex. Computador, Smartdevice, impressora, etc.);

b. Por sistema operacional (ex. Windows, Linux, MacOS, etc.);

c. Versão do sistema operacional (ex. Windows 7, Windows 2008 Server, etc.);

5. Deve ser capaz de gerar gráficos das categorias, separando os dispositivos
conforme suas características;

6. Deve suportar a coleta de informações, para classificação, usando no mínimo:

a. DHCP;

b. HTTP User-Agent;

c. MAC OUI;

d. ActiveSync plugin;

e. SNMP;

f. Subnet Scanner;

g. IF-MAP;

h. Cisco Device Sensor;

i. MDM;

j. TCP Fingerprinting.

7. Deve possuir dicionário de categorias de dispositivos pré-configurado e
mecanismo de atualização do mesmo;

8. Deve suportar a integração com, no mínimo, as seguintes soluções de MDM de
mercado AirWatch, MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, MaaS 360
devendo comprovar a compatibilidade em documentação oficial do fabricante;

9. Deve permitir priorização na ordem de criação dos perfis com no mínimo as
seguintes características:

a. Agente proprietário;

b. HTTP User-Agent;

c. SNMP;

d. DHCP;

e. MAC OUI.

10. A solução de análise de perfil de usuários deverá permitir consultas a sua base,
pela solução de controle de acesso para validação de dispositivos com base no
seu perfil.

 

MÓDULO DE CONTROLE DE ACESSO DE DISPOSITIVOS E
USUÁRIOS
Características Gerais

11. A Solução deverá dar suporte a no mínimo as seguintes bases de dados:

a. Microsoft Active Directory;
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b. Kerberos;

c. Diretórios LDAP;

d. OpenLDAP;

e. PostgreSQL;

f. Oracle 11g;

g. MariaDB;

h. MSSQL;

i. Servidores de Token;

j. Base de dados SQL interna;

k. Lista interna estática de hosts.

12. Deve suportar "Single Sign-on" (SSO) através de SAML v2.0;

13. Deve implementar gerenciamento e aplicação de políticas de autorização de
acesso de usuários com base em:

a. Atributos do usuário autenticado;

b. Hora do dia, dia da semana;

c. Tipo de dispositivo utilizado;

d. Localização do usuário;

e. Tipo de autenticação utilizada.

14. Deve permitir a visualização de todas informações relativas a cada transação e
autenticação em uma única tela, a solução deverá trazer no mínimo as seguintes
informações:

a. Data e Hora;

b. Mac Address do dispositivo;

c. Classificação do dispositivo;

d. Usuário;

e. Equipamento que requisitou a autenticação (origem);

f. Método de autenticação utilizado;

g. Fonte de autenticação utilizada para validação;

h. Perfil de acesso aplicado;

i. Atributos de entrada do protocolo utilizados na requisição (ex. RADIUS);

j. Informações de resposta da solução para o elemento de rede;

k. Alertas em caso de falha;

l. LOGS já filtrados para a requisição em análise.

15. Deve possuir Dashboard customizável, onde deve permitir a visualização de no
mínimo as seguintes informações:

a. a. Lista com últimos Alertas do sistema;

b. Gráfico com todas as requisições de autenticação dos últimos 7 dias,
incluindo RADIUS, TACACS+ e Autenticações Web;

c. Gráfico com o status das autenticações aceitas e rejeitadas nos últimos 7
dias;

d. Gráfico com a categorização dos dispositivos classificados pela solução,
divididos de acordo com as categorias de classificação;

e. Últimas falhas de autenticação;

f. Gráfico com as requisições de avaliação de postura dos dispositivos,
divididos em:

I. Saudáveis (dentro das políticas estabelecidas);

II. Não saudáveis (que estão fora das políticas estabelecidas);

a. a. Lista com as últimas autenticações;

b. Lista com as últimas autenticações com sucesso;

c. Utilização de CPU do sistema, no mínimo nos últimos 30 minutos;

16. Deve possuir base de regras e categorias de dispositivos pré-configurada e
mecanismo de atualização da mesma;

17. Deve suportar a integração com no mínimo as seguintes soluções de MDM de
mercado AirWatch, MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, MaaS 360
devendo comprovar a compatibilidade em documentação oficial do fabricante;

18. Deve suportar autenticações via OAuth2, Facebook, Twitter, LinkdIn, Office365 e
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Google Apps;

19. Deve possuir recursos integrados de AAA: RADIUS, TACACS+ e Kerberos;

20. Deve possuir suporte aos seguintes recursos:

a. RADIUS;

b. RADIUS CoA;

c. TACACS+;

d. Web authentication;

e. SAML v2.0;

f. EAP-FAST (EAP-MSCHAPv2, EAP-GTC, EAP-TLS);

g. PEAP (EAP-MSCHAPv2, EAP-GTC, EAP-TLS, EAP-PEAP-Public);

h. TTLS (EAP-MSCHAPv2, EAP-GTC, EAP- TLS, EAP-MD5, PAP, CHAP);

i. EAP-TLS;

j. PAP, CHAP, MSCHAPv1, MSCHAPv2  e EAP-MD5;

k. Windows machine authentication;

l. MAC address authentication (dispositivos sem suporte a 802.1X);

21. Deve suportar verificação de vulnerabilidade através de varredura de portas;

22. Deve suportar à aplicação de políticas em ambiente com múltiplos fornecedores
de Wireless, cabeado e VPN;

23. Deve possuir CA integrada, para geração de certificados para os dispositivos que
forem se autenticar na rede;

24. Deve suportar à integração com plataforma de terceiros usando HTTP/RESTful
API;

25. Deve permitir que a solução faça consultas em bases SQL, com o objetivo de
buscar informação a serem utilizadas durante o processo de autenticação dos
usuários;

26. Deve possuir suporte a administração através de IPv6;

27. Deve possuir ferramenta para gerenciar os processos de credenciamento,
autenticação, autorização e contabilização de usuários visitantes através de portal
web seguro;

28. Deve implementar a criação de grupos de autorizadores com privilégios distintos
de criação de credenciais temporárias e atribuição de permissões de acesso aos
clientes;

29. Deve permitir realizar a autenticação dos autorizadores em base externa do tipo
Microsoft Active Directory ou LDAP e atribuir o privilégio ao autorizador de acordo
com o seu perfil;

30. Deve implementar as funcionalidades de geração de lotes de credenciais
aleatórias, temporárias, pré-autorizadas;

31. Deve implementar a importação e exportação da relação de credenciais
temporárias através de arquivos txt ou csv;

32. Deve permitir a configuração do tempo de validade das credenciais, baseando-se
na criação da conta ou no primeiro login da conta;

33. Deve permitir que o visitante crie sua própria credencial temporária (autosserviço)
através de portal web, com ou sem a necessidade de um autorizador;

34. Deve permitir a customização do formulário de criação de credenciais, a ser
preenchido pelo autorizador ou pelo visitante em caso de autosserviço,
especificando quais informações cadastrais dos visitantes são obrigatórias ou
opcionais;

35. Deve permitir a customização do nível de segurança da senha temporária que
será gerada ao visitante, especificando a quantidade mínima de caracteres e o uso
de caracteres especiais e números para compor a senha;

36. Deve exigir que o usuário visitante aceite o “Termo de uso da rede” a cada login
ou apenas no primeiro login;

37. Deve permitir o envio das credenciais aos usuários registrados através de
mensagens SMS (Short Message Service), e-mail ou impressão local.

 

GARANTIA E SUPORTE

38. Garantia e suporte do fabricante para a solução de software ofertada pelo período
mínimo de 36 (sessenta) meses, incluindo a evolução para novas versões
devendo o atendimento ser na modalidade 24x7 (vinte quatro horas por dia, sete
dias da semana), com tempo de resposta máximo em 4 (quatro) horas;

39. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução;
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40. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
disponibilidade ainda de área para cadastro da solução de software ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;

41. A empresa fabricante da solução de software deverá dispor de um número
telefônico tipo 0800 para suporte técnico e abertura de chamados técnicos.

42. A comprovação da modalidade da garantia deverá ocorrer através de
documentação do fabricante de domínio público, não sendo aceita documentação
emitida pelo fornecedor ou centro de distribuição para fins de comprovação que
por ventura conflitem com catálogos, manuais, folders oficiais impressos ou da
internet (devendo constar o endereço URL para folders da web). Caso não seja
comprovada por um dos meios citados anteriormente, será possível a
comprovação através da apresentação de documentação expressa do fabricante
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso
de documentação expressa do fabricante deverá ser anexada a mesma a
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.

 

ITEM 02 – LICENCIAMENTO ADICIONAL PARA
SISTEMA DE GERENCIAMENTO HPE IMC
Características técnicas mínimas

1. Licenciamento para expansão do SISTEMA DE GERENCIAMENTO HPE IMC
existente na infraestrutura da contratante, contemplando o quantitativo adicional
mínimo de 50 (cinquenta) dispositivos simultâneos;

 

GARANTIA E SUPORTE

1. Garantia e suporte do fabricante para a solução de software ofertada pelo período
mínimo de 36 (sessenta) meses, incluindo a evolução para novas versões
devendo o atendimento ser na modalidade 24x7 (vinte quatro horas por dia, sete
dias da semana), com tempo de resposta máximo em 4 (quatro) horas.

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução.

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
disponibilidade ainda de área para cadastro da solução de software ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;

4. A empresa fabricante da solução de software deverá dispor de um número
telefônico tipo 0800 para suporte técnico e abertura de chamados técnicos.

5. A comprovação da modalidade da garantia deverá ocorrer através de
documentação do fabricante de domínio público, não sendo aceita documentação
emitida pelo fornecedor ou centro de distribuição para fins de comprovação que
por ventura conflitem com catálogos, manuais, folders oficiais impressos ou da
internet (devendo constar o endereço URL para folders da web). Caso não seja
comprovada por um dos meios citados anteriormente, será possível a
comprovação através da apresentação de documentação expressa do fabricante
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso
de documentação expressa do fabricante deverá ser anexada a mesma a
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.

 

ITEM 03 – LICENCIAMENTO ADICIONAL DO
MÓDULO DE ANÁLISE DE TRAFEGO DO SISTEMA DE
GERENCIAMENTO HPE IMC
Características técnicas mínimas

1. Licenciamento para expansão do MÓDULO DE ANÁLISE DE TRAFEGO DO
SISTEMA DE GERENCIAMENTO HPE IMC existente na infraestrutura da
contratante, contemplando o quantitativo adicional mínimo de 5 (cinco)
dispositivos simultâneos;

 

GARANTIA E SUPORTE

1. Garantia e suporte do fabricante para a solução de software ofertada pelo período
mínimo de 36 (sessenta) meses, incluindo a evolução para novas versões
devendo o atendimento ser na modalidade 24x7 (vinte quatro horas por dia, sete
dias da semana), com tempo de resposta máximo em 4 (quatro) horas.

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução.
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3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
disponibilidade ainda de área para cadastro da solução de software ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;

4. A empresa fabricante da solução de software deverá dispor de um número
telefônico tipo 0800 para suporte técnico e abertura de chamados técnicos.

5. A comprovação da modalidade da garantia deverá ocorrer através de
documentação do fabricante de domínio público, não sendo aceita documentação
emitida pelo fornecedor ou centro de distribuição para fins de comprovação que
por ventura conflitem com catálogos, manuais, folders oficiais impressos ou da
internet (devendo constar o endereço URL para folders da web). Caso não seja
comprovada por um dos meios citados anteriormente, será possível a
comprovação através da apresentação de documentação expressa do fabricante
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso
de documentação expressa do fabricante deverá ser anexada a mesma a
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.

 

ITEM 04 – LICENCIAMENTO ADICIONAL DA
SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE
ACESSO
Características técnicas mínimas

2. Licenciamento para expansão da SOLUÇÃO DE ANALISE DE PERFIL E
CONTROLE DE ACESSO, contemplando o quantitativo mínimo adicional de 500
(quinhentos) dispositivos, usuários corporativos ou visitantes simultâneos,
independente do perfil de autenticação, seja por dispositivo ou usuário;

 

GARANTIA E SUPORTE

1. Garantia e suporte do fabricante para a solução de software ofertada pelo período
mínimo de 36 (sessenta) meses, incluindo a evolução para novas versões
devendo o atendimento ser na modalidade 24x7 (vinte quatro horas por dia, sete
dias da semana), com tempo de resposta máximo em 4 (quatro) horas.

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução.

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
disponibilidade ainda de área para cadastro da solução de software ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;

4. A empresa fabricante da solução de software deverá dispor de um número
telefônico tipo 0800 para suporte técnico e abertura de chamados técnicos.

5. A comprovação da modalidade da garantia deverá ocorrer através de
documentação do fabricante de domínio público, não sendo aceita documentação
emitida pelo fornecedor ou centro de distribuição para fins de comprovação que
por ventura conflitem com catálogos, manuais, folders oficiais impressos ou da
internet (devendo constar o endereço URL para folders da web). Caso não seja
comprovada por um dos meios citados anteriormente, será possível a
comprovação através da apresentação de documentação expressa do fabricante
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso
de documentação expressa do fabricante deverá ser anexada a mesma a
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.

 

ITEM 05 – SWITCH DE DISTRIBUIÇÃO COM 16
PORTAS SFP+ E SUPORTE A MÓDULOS DE
EXPANSÃO
 

Características técnicas mínimas

1. Deve possuir no mínimo 16 portas 10 Gigabit Ethernet, 1000/10000 SFP+ fixas ao
equipamento

2. Deve suportar, através de módulos, o mínimo de 8 portas adicionais de 10 Gigabit
Ethernet SFP+ ou 2 portas de 40 Gigabit Ethernet QSFP+;

3. Deve suportar transceivers de 10GbE SFP+ e de 40GbE QSFP+ através da adição
ou substituição de módulos.

4. Deve possuir, no mínimo, 2 módulos de expansão podendo ser utilizados para
uplinks ou dados de usuários;
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5. Deve possuir, no mínimo, 2 módulos de fonte internas ao equipamento operando
em modo redundante;

6. Deve possuir porta dedicada de gerenciamento;

7. Deve possuir 1 interface RJ-45 ou serial para acesso console local;

8. Deve possuir latência de, no máximo, 2,8 μs a 1Gbps;

9. Deve possuir memória SDRAM de no mínimo 2 Gbytes;

10. Deve possuir buffer de pacotes de no mínimo 13.5 Mbytes;

11. Deve possuir capacidade de encaminhamento de no mínimo 285 Mpps;

12. Deve possuir capacidade de comutação de no mínimo 480 Gbps;

13. Deve possuir Certificado de Homologação na Anatel, de acordo com a Resolução
nº 242;

14. Deve possuir fonte de alimentação interna 110/220VAC;

Disponibilidade

15. Deve possuir capacidade de, no mínimo, 10 (dez) equipamentos membros da
mesma pilha;

16. Deve possuir fonte de alimentação interna redundante com características
idênticas a fonte principal;

17. Deve suportar empilhamento com banda agregada mínima de 320 Gbps sem uso
de portas de dados de usuário para este fim.

Switching

18. Deve implementar VLANs baseadas em MAC;

19. Deve suportar no mínimo 4094 VLAN IDs;

20. Deve implementar registro dinâmico de VLAN com MVRP;

21. Deve suportar protocolo OpenFlow 1.3;

22. Deve implementar Jumbo frames nas interfaces Gigabit Ethernet e 10-Gigabit
Ethernet

23. Deve implementar Jumbo frames com tamanho de até 9000 bytes;

24. Deve implementar Ethernet link aggregation;

25. Deve implementar IEEE 802.1ad QinQ;

26. Deve suportar agregação de link através de LACP com no mínimo 144 grupos
distribuídos através da pilha, com cada grupo permitindo até 8 portas;

27. Deve implementar IEEE 802.3x Flow Control;

28. Deve implementar STP BPDU Protection (BPDU Guard);

29. Deve implementar IEEE 802.1w Rapid Reconfiguration of Spanning Tree;

30. Deve implementar MSTP IEEE 802.1s com pelo menos 64 instâncias;

31. Deve implementar UDLD ou DLDP.

Roteamento

32. Deve implementar roteamento estático IPv4 e IPv6;

33. Deve implementar RIP, RIPv2 e RIPng;

34. Deve possuir no mínimo 512 interfaces de roteamento IP (VLAN Interface)

35. O equipamento ofertado deve implementar roteamento baseado em política (PBR)
para IPv4 e IPv6;

36. O equipamento ofertado deve possuir tabela de roteamento com no mínimo 10 mil
entradas IPv4 e 5 mil entradas IPv6;

37. Deve suportar no mínimo 256 rotas estáticas;

38. O equipamento ofertado deve permitir autenticação em servidores RADIUS e
TACACS+;

39. Deve suportar dual stack IPv4/IPv6;

40. Deve implementar Bidirectional Forwarding Detection (BFD), suportando redução
do tempo de convergência para OSPF e VRRP;

41. Deve implementar OSPF v2 e OSPF v3;

42. Deve implementar BGP.

QoS

43. Deve implementar 8 filas em cada porta;

44. Deve implementar traffic shapping;

45. Deve implementar classificação de tráfego utilizando informações de camada 2, 3
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e 4;

46. Deve implementar priorização do trafego em camada 4, baseado em número de
portas TCP/UDP.

Segurança

47. Deve implementar autenticação 802.1x de múltiplos usuários por porta,
simultaneamente.

48. Deve implementar segurança orientada por identidade e controle de acesso por
usuário através de ACLs que permitam ou negue o acesso do usuário aos
recursos de rede específicos, com base na identidade do usuário.

49. Atribuição VLAN automática, automaticamente atribui os usuários para a VLAN
apropriada, com base em suas identidades.

50. Deve implementar accounting RADIUS;

51. Deve implementar TACACS+;

52. Deve implementar proteção contra ataques de ARP;

53. Deve implementar proteção contra IP spoofing (IP source guard);

54. Deve implementar SNMP v1, v2 e v3;

55. Deve implementar detecção de ataques maliciosos e enviar um aviso quando uma
anomalia potencial, causada pelos ataques mal-intencionado, for detectado.

56. Deve suportar o isolamento de portas e VLANs, de forma que uma porta ou VLAN
isolada não possa enviar tráfego para outra porta isolada do mesmo switch;

57. Deve implementar segurança do gerenciamento do switch em métodos de acesso
CLI, GUI ou MIB, através de SSHv2, SSL e SNMPv3

58. Deve implementar autenticação baseado em porta ou endereço MAC;

59. Deve implementar autenticação utilizando navegadores web, possibilitando que
clientes que não possuem cliente 802.1x possam autenticar;

60. Deve suportar port-security.

Gerenciamento

61. Deve permitir instalação simplificada “Zero-touch provisioning” através de
processo baseado em DHCP com a solução de software de gerenciamento;

62. O equipamento ofertado deve permitir múltiplos arquivos de configuração;

63. Deve suportar espelhamento remoto;

64. Deve implementar Secure File Transfer Protocol;

65. Deve implementar LLDP;

66. Deve implementar LLDP-MEd;

67. Deve implementar SNTP v4;

68. O equipamento ofertado deve Implementar Sflow ou Netflow;

69. Deve implementar RFC 1213 MIB II;

70. Deve implementar RFC 2096 IP Forwarding Table MIB;

71. Deve implementar RFC 2571 SNMP Framework MIB;

72. Deve implementar RFC 2572 SNMP-MPD MIB;

73. Deve implementar RFC 2573 SNMP-Notification MIB;

74. Deve implementar RFC 2574 SNMP USM MIB;

75. Deve implementar RFC 2737 Entity MIB (Version 2);

76. Deve implementar RFC 3414 SNMP-User based-SM MIB;

77. Deve implementar RFC 3415 SNMP-View based-ACM MIB;

78. Deve implementar RFC 2668 802.3 MAU MIB;

79. Deve implementar RFC 3418 MIB for SNMPv3;

80. Deve ser fornecido com a versão de software mais completa e atual disponível
para o equipamento;

81. Deve ser fornecido com todas as licenças de software necessárias para o
funcionamento integral de todas as funcionalidades disponíveis para o
equipamento;

82. O equipamento ofertado deve possuir certificado de homologação na Anatel, de
acordo com a resolução n° 242;

Garantia e Suporte

83. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-
site pelo período mínimo de 60 (sessenta) meses para reposição de peças, mão
de obra e atendimento. O prazo máximo para atendimento do chamado deve ser
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de até o próximo dia útil após a sua abertura. Durante o período da garantia o
prazo máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis.

84. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução.

85. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
disponibilidade ainda de área para cadastro da solução de hardware ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;

86. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo
0800 para suporte técnico e abertura de chamados técnicos.

87. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e
solução exigidos para os equipamentos, deverá ser comprovada a existência da
assistência técnica local no domicílio da contratante e na modalidade on-site,
devendo essa ser realizada por meio de documentação oficial do fabricante dos
produtos e de domínio público, através de catálogos, folder impressos ou da
internet, devendo constar o endereço URL na mesma. Caso não seja comprovada
por um dos meios citados anteriormente, será possível a comprovação através da
apresentação de documentação expressa do fabricante dos equipamentos,
indicando a referida assistência técnica que será responsável pelo atendimento e
manutenção durante o período de garantia dos produtos ofertados. Em caso de
documentação expressa do fabricante a esta deverá ser anexada uma
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.

88. Todos os componentes instalados ou integrados dos equipamentos devem ser do
próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada.

 

ITEM 06 – MÓDULO COM 4 PORTAS SFP+ PARA
SWITCH DE DISTRIBUIÇÃO
 

Características técnicas mínimas

1. Módulo de expansão para switch de distribuição;

2. Suporte a no mínimo 4 (quatro) portas SFP+;

3. Deve ser compatível com GBICS 100M/1G/10G SFP+;

4. Deve possuir suporte a MACsec;

5. Compatibilidade integral com o item 05.

Garantia e Suporte

6. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de
peças, mão de obra e atendimento no local. O período da garantia o prazo
máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis;

7. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(part number), incorporado ao equipamento;

8.  Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do
próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada;

 

ITEM 07 – MÓDULO DE STACKING COM 4 PORTAS
PARA SWITCH DE DISTRIBUIÇÃO

Características técnicas mínimas

1. Módulo de expansão para switch de distribuição;

2. Suporte a no mínimo 4 (quatro) portas para stacking;

3. Deve prover no mínimo 320Gbps por módulo;

4. Deve acompanhar 1 (um) cabo de stacking compatível, com 1 (um) metro de
comprimento;

5.  Compatibilidade integral com o item 05.
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Garantia e Suporte

6. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de
peças, mão de obra e atendimento no local. O período da garantia o prazo
máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis;

7. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(part number), incorporado ao equipamento;

8. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do
próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada;

 

ITEM 08 – SWITCH DE ACESSO L3 COM 48 PORTAS
GIGABIT E 4 SFP+
 

Características gerais

1. Deve possuir 48 portas 10/100/1000;

2. Deve possuir 4 portas 1/10G SFP+;

3. Deve possuir capacidade de encaminhamento de, no mínimo, 110 Mpps;

4. Deve possuir capacidade de comutação de, no mínimo, 176 Gbps;

5. Deve implementar IEEE 802.3az para as portas 10/100/1000;

6. Deve possuir uma interface de console USB;

7. Deve suportar empilhamento de no mínimo 8 switches;

8. Deve suportar agregação de link através de LACP com no mínimo 20 grupos
distribuídos através da pilha, com cada grupo permitindo até 8 portas;

9. Deve suportar a agregação de links entre diferentes membros da pilha;

10. Deve possuir no mínimo 32.000 endereços MAC;

11. Deve possuir latência máxima de 4μs, considerando pacotes de 64 bytes;

12. Deve possuir buffers de, no mínimo, 12 MB;

13. Deve implementar funcionalidade que permita a detecção de links unidirecionais;

14. Deve implementar funcionalidade que permita a detecção de falhas de uplink;

15. Deve implementar no mínimo 2000 VLANs simultaneamente;

16. Deve implementar MVRP (Multiple VLAN Registration Protocol);

17. Deve implementar LLDP (IEEE 802.1ab);

18. Deve implementar LLDP-MED;

19. Deve implementar Q-in-Q (IEEE 802.1ad);

20. Deve implementar PVST+, RPVST+ ou protocolo compatível;

21. Deve implementar MSTP (IEEE 802.1s);

22. Deve implementar túneis VxLAN (VTEP).

 

Funcionalidades de Camada 3

23. Deve possuir tabela de roteamento com no mínimo 2.000 rotas IPv4 e 1.000 rotas
IPv6;

24. Deve implementar roteamento estático;

25. Deve implementar RIP v2, com suporte a autenticação MD5 (RIPv2);

26. Deve implementar RIPng;

27. Deve implementar OSPF;

28. Deve implementar OSPFv3;

29. Deve implementar Policy-based Routing;

30. Deve implementar VRRP;

31. Deve implementar VRRPv3;

32. Deve implementar servidor DHCP;
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33. Deve implementar DHCP snooping (IPv4 e IPv6);

34. Deve implementar DHCP relay (IPv4 e IPv6);

35. Deve implementar Gateway mDNS, com suporte a Apple Bonjour.

 

Multicast

36. Deve implementar PIM-SM;

37. Deve implementar PIM-DM;

38. Deve implementar MLD snooping;

39. Deve implementar IGMP v3.

 

Software Defined Networking

40. Deve implementar OpenFlow 1.3 ou superior;

41. Deve implementar a separação lógica do tráfego sem suporte a OpenFlow do
tráfego com suporte a OpenFlow através de instâncias. O tráfego OpenFlow não
pode influenciar o tráfego não openflow no equipamento;

42. Deve permitir configurar cada instância como modo ativo (pacotes referentes a
fluxos que o switch não conhece são enviados para a controladora) ou modo
passivo (pacotes que não se referem a um fluxo na tabela do switch não são
enviados para a controladora);

43. Deve implementar 16 instâncias de OpenFlow;

44. As instâncias de OpenFlow devem suportar a associação de múltiplas VLANs;

45. Cada instância OpenFlow configurada no equipamento deve suportar, pelo menos,
a configuração de 3 controladores SDN;

46. Deve permitir utilizar intervalo de portas TCP/UDP e flags de TCP como parâmetros
nas regras de OpenFlow;

47. Deve suportar no mínimo 16.000 regras openflow;

48. Deve possuir interface REST API;

49. Deve suportar configurações via JSON/REST API com, no mínimo, os seguintes
métodos: GET, POST, PUT e DELETE;

50. Deve suportar a criação de VLANs e ACLs no equipamento através de REST.

 

QoS

51. Deve implementar controle de broadcast;

52. Deve implementar rate limiting para pacotes ICMP;

53. Deve implementar rate limiting para tráfego broadcast e multicast;

54. Deve implementar rate limiting baseado em tráfego classificado por uma ACL;

55. Deve suportar espelhamento de portas;

56. Deve suportar espelhamento de tráfego para um switch remoto.

 

Segurança

57. Deve implementar controle de acesso baseado em perfis (Role Based Access
Control);

58. Deve implementar VLANs privadas, de forma que permita o isolamento de tráfego
de uma porta de acesso das demais portas de acesso de uma mesma VLAN,
permitindo acesso apenas para as portas de Uplink (porta promíscua);

59. Deve implementar 802.1x;

60. Deve implementar autenticação baseada em web;

61. Deve implementar autenticação baseada em endereço MAC;

62. Deve permitir a utilização simultânea de autenticação 802.1x e MAC em uma
mesma porta;

63. Deve implementar TACACS+. Não serão aceitas soluções similares;

64. Deverá suportar o download de políticas ou ACLsl a partir de um software de
Controle de Acesso à Rede (NAC), sem necessidade de pré-configuração das
regras no switch, permitindo a centralização das políticas;

65. Deve suportar integração com ferramenta de controle de acesso do mesmo
fabricante que permita identificar automaticamente o tipo e sistema operacional
dos equipamentos que se conectam à rede (device profiling) sem a necessidade
de agentes instalados nos dispositivos;
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66. Deve suportar integração com ferramenta de controle de acesso do mesmo
fabricante que permita verificar se a máquina está em conformidade com a política
de segurança antes de entrar na rede, verificando, no mínimo serviços os
serviços e antivírus das máquinas. Deve suportar os sistemas operacionais
Microsoft Windows, Mac OS e Linux.

 

Gerenciamento

67. Deve implementar NTP com autenticação MD5;

68. Deve implementar Time Domain Reflectometry (TDR) para testes de cabos UTP,
permitindo identificar falhas e verificar a distância do cabo;

69. Deve suportar duas imagens de software na flash;

70. Deve suportar múltiplos arquivos de configuração na flash;

71. Deve permitir o agendamento de tarefas, permitindo executar um comando em
um dia e horário específicos;

72. Deve suportar a autoconfiguração dos switches através de DHCP e software de
gerenciamento, sem necessidade de nenhuma intervenção no switch (com
configuração de fábrica);

73. Deve suportar gerenciamento através de plataforma de nuvem do mesmo
fabricante, com funcionalidades de gerenciamento de configuração, alertas e
notificações e gerenciamento de firmware, sem necessidade de instalação de
nenhum software ou dispositivo on-site;

74. Deve suportar IPSec para comunicação com o sistema de gerenciamento;

75. Deve implementar sFlow (IPv4 e IPv6);

76. Deve possuir interface web para configuração;

77. Deve implementar TR-69 (CPE WAN Management Protocol);

78. Deve suportar diagnóstico de transceivers ópticos;

79. Deve implementar Syslog sobre TLS;

80. Deve implementar Secure SFTP (SFTP);

81. Deve implementar SNMP v1/v2/v3;

82. Deve implementar funcionalidade que permita monitorar o SLA (Service Level
Agreement) de conexões IP. Deve suportar os seguintes testes: ICMP Echo, UDP-
Echo (em porta configurável) e TCP-Connect (em porta configurável) e Jitter UDP
para voz;

83. Deve implementar compatibilidade com o protocolo CDP para provisionamento de
telefones IP;

84. Deve implementar o isolamento de um Access Point rogue conectado ao switch,
quando este for detectado por solução de WLAN do mesmo fabricante;

85. Deve implementar a configuração automática de Access Point wireless do mesmo
fabricante quando conectado ao switch. Devem ser suportados os seguintes
parâmetros para a configuração automática: VLAN, CoS, largura de banda
máxima;

86. Deve suportar o encaminhamento de tráfego para controladora wireless do
mesmo fabricante para inspeção e controle de acesso.

 

Licenciamento

87. Deve ser fornecido com a versão de software mais completa disponível para o
equipamento;

88. Deve ser fornecido com todas as licenças de software necessárias para o
funcionamento integral de todas as funcionalidades disponíveis para o
equipamento.

 

Garantia e Suporte

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-
site pelo período mínimo de 60 (sessenta) meses para reposição de peças, mão
de obra e atendimento. O prazo máximo para atendimento do chamado deve ser
de até o próximo dia útil após a sua abertura. Durante o período da garantia o
prazo máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis.

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução.

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
disponibilidade ainda de área para cadastro da solução de hardware ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;
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4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo
0800 para suporte técnico e abertura de chamados técnicos.

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e
solução exigidos para os equipamentos, deverá ser comprovada a existência da
assistência técnica local no domicílio da contratante e na modalidade on-site,
devendo essa ser realizada por meio de documentação oficial do fabricante dos
produtos e de domínio público, através de catálogos, folder impressos ou da
internet, devendo constar o endereço URL na mesma. Caso não seja comprovada
por um dos meios citados anteriormente, será possível a comprovação através da
apresentação de documentação expressa do fabricante dos equipamentos,
indicando a referida assistência técnica que será responsável pelo atendimento e
manutenção durante o período de garantia dos produtos ofertados. Em caso de
documentação expressa do fabricante a esta deverá ser anexada uma
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do
próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada.

 

ITEM 09 – SWITCH DE ACESSO L3 COM 24 PORTAS
GIGABIT E 4 SFP+
 

Características gerais

1. Deve possuir 24 portas 10/100/1000;

2. Deve possuir 4 portas 1/10G SFP+;

3. Deve possuir capacidade de encaminhamento de, no mínimo, 95 Mpps;

4. Deve possuir capacidade de comutação de, no mínimo, 128 Gbps;

5. Deve implementar IEEE 802.3az para as portas 10/100/1000;

6. Deve possuir uma interface de console USB;

7. Deve suportar empilhamento de no mínimo 4 switches;

8. Deve suportar agregação de link através de LACP com no mínimo 20 grupos
distribuídos através da pilha, com cada grupo permitindo até 8 portas;

9. Deve suportar a agregação de links entre diferentes membros da pilha;

10. Deve possuir no mínimo 32.000 endereços MAC;

11. Deve possuir latência máxima de 4μs, considerando pacotes de 64 bytes;

12. Deve possuir buffers de, no mínimo, 12 MB;

13. Deve implementar funcionalidade que permita a detecção de links unidirecionais;

14. Deve implementar funcionalidade que permita a detecção de falhas de uplink;

15. Deve implementar no mínimo 2000 VLANs simultaneamente;

16. Deve implementar MVRP (Multiple VLAN Registration Protocol);

17. Deve implementar LLDP (IEEE 802.1ab);

18. Deve implementar LLDP-MED;

19. Deve implementar Q-in-Q (IEEE 802.1ad);

20. Deve implementar PVST+, RPVST+ ou protocolo compatível;

21. Deve implementar MSTP (IEEE 802.1s);

22. Deve implementar túneis VxLAN (VTEP);

 

Funcionalidades de Camada 3

23. Deve possuir tabela de roteamento com no mínimo 2.000 rotas IPv4 e 1.000 rotas
IPv6;

24. Deve implementar roteamento estático;

25. Deve implementar RIP v2, com suporte a autenticação MD5 (RIPv2);

26. Deve implementar RIPng;

27. Deve implementar OSPF;

28. Deve implementar OSPFv3;

29. Deve implementar Policy-based Routing;
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30. Deve implementar VRRP;

31. Deve implementar VRRPv3;

32. Deve implementar servidor DHCP;

33. Deve implementar DHCP snooping (IPv4 e IPv6);

34. Deve implementar DHCP relay (IPv4 e IPv6);

35. Deve implementar Gateway mDNS, com suporte a Apple Bonjour;

 

Multicast

36. Deve implementar PIM-SM;

37. Deve implementar PIM-DM;

38. Deve implementar MLD snooping;

39. Deve implementar IGMP v3;

 

Software Defined Networking

40. Deve implementar OpenFlow 1.3 ou superior;

41. Deve implementar a separação lógica do tráfego sem suporte a OpenFlow do
tráfego com suporte a OpenFlow através de instâncias. O tráfego OpenFlow não
pode influenciar o tráfego não openflow no equipamento.

42. Deve permitir configurar cada instância como modo ativo (pacotes referentes a
fluxos que o switch não conhece são enviados para a controladora) ou modo
passivo (pacotes que não se referem a um fluxo na tabela do switch não são
enviados para a controladora)

43. Deve implementar 16 instâncias de OpenFlow;

44. As instâncias de OpenFlow devem suportar a associação de múltiplas VLANs.

45. Cada instância OpenFlow configurada no equipamento deve suportar, pelo menos,
a configuração de 3 controladores SDN.

46. Deve permitir utilizar intervalo de portas TCP/UDP e flags de TCP como parâmetros
nas regras de OpenFlow;

47. Deve suportar no mínimo 16.000 regras openflow;

48. Deve possuir interface REST API;

49. Deve suportar configurações via JSON/REST API com, no mínimo, os seguintes
métodos: GET, POST, PUT e DELETE;

50. Deve suportar a criação de VLANs e ACLs no equipamento através de REST.

 

QoS

51. Deve implementar controle de broadcast;

52. Deve implementar rate limiting para pacotes ICMP;

53. Deve implementar rate limiting para tráfego broadcast e multicast;

54. Deve implementar rate limiting baseado em tráfego classificado por uma ACL;

55. Deve suportar espelhamento de portas;

56. Deve suportar espelhamento de tráfego para um switch remoto.

 

Segurança

57. Deve implementar controle de acesso baseado em perfis (Role Based Access
Control);

58. Deve implementar VLANs privadas, de forma que permita o isolamento de tráfego
de uma porta de acesso das demais portas de acesso de uma mesma VLAN,
permitindo acesso apenas para as portas de Uplink (porta promíscua);

59. Deve implementar 802.1x;

60. Deve implementar autenticação baseada em web;

61. Deve implementar autenticação baseada em endereço MAC;

62. Deve permitir a utilização simultânea de autenticação 802.1x e MAC em uma
mesma porta;

63. Deve implementar TACACS+. Não serão aceitas soluções similares;

64. Deverá suportar o download de políticas ou ACLs a partir de um software de
Controle de Acesso à Rede (NAC), sem necessidade de pré-configuração das
regras no switch, permitindo a centralização das políticas;
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65. Deve suportar integração com ferramenta de controle de acesso do mesmo
fabricante que permita identificar automaticamente o tipo e sistema operacional
dos equipamentos que se conectam à rede (device profiling) sem a necessidade
de agentes instalados nos dispositivos;

66. Deve suportar integração com ferramenta de controle de acesso do mesmo
fabricante que permita verificar se a máquina está em conformidade com a política
de segurança antes de entrar na rede, verificando, no mínimo serviços os
serviços e antivírus das máquinas. Deve suportar os sistemas operacionais
Microsoft Windows, Mac OS e Linux.

 

Gerenciamento

67. Deve implementar NTP com autenticação MD5;

68. Deve implementar Time Domain Reflectometry (TDR) para testes de cabos UTP,
permitindo identificar falhas e verificar a distância do cabo;

69. Deve suportar duas imagens de software na flash;

70. Deve suportar múltiplos arquivos de configuração na flash;

71. Deve permitir o agendamento de tarefas, permitindo executar um comando em
um dia e horário específicos;

72. Deve suportar a autoconfiguração dos switches através de DHCP e software de
gerenciamento, sem necessidade de nenhuma intervenção no switch (com
configuração de fábrica);

73. Deve suportar gerenciamento através de plataforma de nuvem do mesmo
fabricante, com funcionalidades de gerenciamento de configuração, alertas e
notificações e gerenciamento de firmware, sem necessidade de instalação de
nenhum software ou dispositivo on-site;

74. Deve suportar IPSec para comunicação com o sistema de gerenciamento;

75. Deve implementar sFlow (IPv4 e IPv6);

76. Deve possuir interface web para configuração;

77. Deve implementar TR-69 (CPE WAN Management Protocol);

78. Deve suportar diagnóstico de transceivers ópticos;

79. Deve implementar Syslog sobre TLS;

80. Deve implementar Secure SFTP (SFTP);

81. Deve implementar SNMP v1/v2/v3;

82. Deve implementar funcionalidade que permita monitorar o SLA (Service Level
Agreement) de conexões IP. Deve suportar os seguintes testes: ICMP Echo, UDP-
Echo (em porta configurável) e TCP-Connect (em porta configurável) e Jitter UDP
para voz;

83. Deve implementar compatibilidade com o protocolo CDP para provisionamento de
telefones IP;

84. Deve implementar o isolamento de um Access Point rogue conectado ao switch,
quando este for detectado por solução de WLAN do mesmo fabricante;

85. Deve implementar a configuração automática de Access Point wireless do mesmo
fabricante quando conectado ao switch. Devem ser suportados os seguintes
parâmetros para a configuração automática: VLAN, CoS, largura de banda
máxima;

86. Deve suportar o encaminhamento de tráfego para controladora wireless do
mesmo fabricante para inspeção e controle de acesso.

 

Licenciamento

87. Deve ser fornecido com a versão de software mais completa disponível para o
equipamento;

88. Deve ser fornecido com todas as licenças de software necessárias para o
funcionamento integral de todas as funcionalidades disponíveis para o
equipamento.

 

Garantia e Suporte

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-
site pelo período mínimo de 60 (sessenta) meses para reposição de peças, mão
de obra e atendimento. O prazo máximo para atendimento do chamado deve ser
de até o próximo dia útil após a sua abertura. Durante o período da garantia o
prazo máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis.

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução.
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3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
disponibilidade ainda de área para cadastro da solução de hardware ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo
0800 para suporte técnico e abertura de chamados técnicos.

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e
solução exigidos para os equipamentos, deverá ser comprovada a existência da
assistência técnica local no domicílio da contratante e na modalidade on-site,
devendo essa ser realizada por meio de documentação oficial do fabricante dos
produtos e de domínio público, através de catálogos, folder impressos ou da
internet, devendo constar o endereço URL na mesma. Caso não seja comprovada
por um dos meios citados anteriormente, será possível a comprovação através da
apresentação de documentação expressa do fabricante dos equipamentos,
indicando a referida assistência técnica que será responsável pelo atendimento e
manutenção durante o período de garantia dos produtos ofertados. Em caso de
documentação expressa do fabricante a esta deverá ser anexada uma
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do
próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada.

 

ITEM 10 – SWITCH DE ACESSO L2 COM 24 PORTAS
GIGABIT E 4 SFP
 

1. Deve possuir 24 portas 10/100/1000;

2. Deve possuir 4 portas 1G SFP;

3. Deve possuir capacidade de encaminhamento de, no mínimo, 40 Mpps;

4. Deve possuir capacidade de comutação de, no mínimo, 56 Gbps;

5. Deve implementar IEEE 802.3az para as portas 10/100/1000;

6. Deve possuir uma interface de console USB;

7. Deve suportar agregação com suporte a até 8 portas por grupo;

8. Deve possuir 16.000 endereços MAC;

9. Deve possuir latência máxima de 4 μs para links de 1000Mbps, considerando
pacotes de 64 bytes;

10. Deve implementar funcionalidade que permita a detecção de links unidirecionais;

11. Deve implementar virtual stacking permitindo o gerenciamento de, no mínimo, 16
switches com mesmo endereço IP;

12. Deve implementar 512 VLANs simultaneamente;

13. Deve implementar MVRP (Multiple VLAN Registration Protocol);

14. Deve implementar LLDP (IEEE 802.1ab);

15. Deve implementar LLDP-MED;

16. Deve implementar PVST+, RPVST+ ou protocolo compatível;

17. Deve implementar MSTP (IEEE 802.1s);

18. Deve implementar Gateway mDNS, com suporte a Apple Bonjour;

19. Deve implementar IEEE 802.1p permitindo a classificação de tráfego com até 8
filas de prioridade;

20. Deve permitir a priorização de tráfego por porta e VLAN;

21. Deve implementar controle de broadcast;

22. Deve implementar rate limiting para pacotes ICMP;

23. Deve implementar rate limiting para tráfego broadcast e multicast;

24. Deve suportar espelhamento de portas;

25. Deve implementar RADIUS authentication;

26. Deve implementar RADIUS accounting;

27. Deve implementar TACACS+;

28. Deve implementar IEEE 802.1X com, no mínimo, 8 (oito) autenticações por porta;

29. Deve implementar SSHv2;
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30. Deve implementar SSH para IPv6;

31. Deve implementar DHCP snooping;

32. Deve implementar user role localmente permitindo criar políticas de acesso de
segurança e QoS, por perfil de usuário e dispositivos;

33. Deve implementar autenticação baseada em web;

34. Deve implementar NTP com autenticação MD5;

35. Deve suportar duas imagens de software na flash;

36. Deve suportar múltiplos arquivos de configuração na flash;

37. Deve permitir o agendamento de tarefas, permitindo executar um comando ou
grupo de comandos em um dia e horário específicos;

38. Deve implementar sFlow (IPv4 e IPv6) ou Netflow;

39. Deve implementar RMON com os grupos statistics, history, alarms e events;

40. Deve possuir interface web para configuração;

41. Deve implementar TR-69 (CPE WAN Management Protocol);

42. Deve suportar a auto-configuração dos switches através de DHCP e software de
gerenciamento, sem necessidade de nenhuma intervenção no switch (com
configuração de fábrica);

43. Deve suportar Digital Optical Monitoring (DOM) para transceivers ópticos;

44. Deve implementar Syslog sobre TLS;

45. Deve implementar SFTP ou SCP;

46. Deve implementar SNMP v1/v2/v3

47. Deve permitir gerar notificação caso seja excedido o limite de MACs;

48. Deve implementar compatibilidade com o protocolo CDP para provisionamento de
telefones IP;

49. Deve implementar o isolamento de um Access Point rogue conectado ao switch,
quando este for detectado por solução de WLAN do mesmo fabricante;

50. Deve implementar a configuração automática de Access Point wireless do mesmo
fabricante quando conectado ao switch. Devem ser suportados os seguintes
parâmetros para a configuração automática: VLAN, CoS, largura de banda
máxima;

51. Deve ser fornecido com a versão de software mais completa disponível para o
equipamento;

52. Deve ser fornecido com todas as licenças de software necessárias para o
funcionamento integral de todas as funcionalidades disponíveis para o
equipamento;

 

Garantia e Suporte

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-
site pelo período mínimo de 60 (sessenta) meses para reposição de peças, mão
de obra e atendimento. O prazo máximo para atendimento do chamado deve ser
de até o próximo dia útil após a sua abertura. Durante o período da garantia o
prazo máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis.

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução.

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
disponibilidade ainda de área para cadastro da solução de hardware ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo
0800 para suporte técnico e abertura de chamados técnicos.

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e
solução exigidos para os equipamentos, deverá ser comprovada a existência da
assistência técnica local no domicílio da contratante e na modalidade on-site,
devendo essa ser realizada por meio de documentação oficial do fabricante dos
produtos e de domínio público, através de catálogos, folder impressos ou da
internet, devendo constar o endereço URL na mesma. Caso não seja comprovada
por um dos meios citados anteriormente, será possível a comprovação através da
apresentação de documentação expressa do fabricante dos equipamentos,
indicando a referida assistência técnica que será responsável pelo atendimento e
manutenção durante o período de garantia dos produtos ofertados. Em caso de
documentação expressa do fabricante a esta deverá ser anexada uma
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.
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6. Todos os componentes instalados ou integrados dos equipamentos devem ser do
próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada.

 

 

ITEM 11 – SWITCH DE ACESSO L2 COM 48 PORTAS
GIGABIT E 4SFP
 

1. Deve possuir 48 portas 10/100/1000;

2. Deve possuir 4 portas 1G SFP;

3. Deve possuir capacidade de encaminhamento de, no mínimo, 77 Mpps;

4. Deve possuir capacidade de comutação de, no mínimo, 104 Gbps;

5. Deve implementar IEEE 802.3az para as portas 10/100/1000;

6. Deve possuir uma interface de console USB;

7. Deve suportar agregação com suporte a até 8 portas por grupo;

8. Deve possuir 16.000 endereços MAC;

9. Deve possuir latência máxima de 4 μs para links de 1000Mbps, considerando
pacotes de 64 bytes;

10. Deve implementar funcionalidade que permita a detecção de links unidirecionais;

11. Deve implementar virtual stacking permitindo o gerenciamento de, no mínimo, 16
switches com mesmo endereço IP;

12. Deve implementar 512 VLANs simultaneamente;

13. Deve implementar MVRP (Multiple VLAN Registration Protocol);

14. Deve implementar LLDP (IEEE 802.1ab);

15. Deve implementar LLDP-MED;

16. Deve implementar PVST+, RPVST+ ou protocolo compatível;

17. Deve implementar MSTP (IEEE 802.1s);

18. Deve implementar Gateway mDNS, com suporte a Apple Bonjour;

19. Deve implementar IEEE 802.1p permitindo a classificação de tráfego com até 8
filas de prioridade;

20. Deve permitir a priorização de tráfego por porta e VLAN;

21. Deve implementar controle de broadcast;

22. Deve implementar rate limiting para pacotes ICMP;

23. Deve implementar rate limiting para tráfego broadcast e multicast;

24. Deve suportar espelhamento de portas;

25. Deve implementar RADIUS authentication;

26. Deve implementar RADIUS accounting;

27. Deve implementar TACACS+;

28. Deve implementar IEEE 802.1X com, no mínimo, 8 (oito) autenticações por porta;

29. Deve implementar SSHv2;

30. Deve implementar SSH para IPv6;

31. Deve implementar DHCP snooping;

32. Deve implementar user role localmente permitindo criar políticas de acesso de
segurança e QoS, por perfil de usuário e dispositivos;

33. Deve implementar autenticação baseada em web;

34. Deve implementar NTP com autenticação MD5;

35. Deve suportar duas imagens de software na flash;

36. Deve suportar múltiplos arquivos de configuração na flash;

37. Deve permitir o agendamento de tarefas, permitindo executar um comando ou
grupo de comandos em um dia e horário específicos;

38. Deve implementar sFlow (IPv4 e IPv6) ou Netflow;

39. Deve implementar RMON com os grupos statistics, history, alarms e events;
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40. Deve possuir interface web para configuração;

41. Deve implementar TR-69 (CPE WAN Management Protocol);

42. Deve suportar a auto-configuração dos switches através de DHCP e software de
gerenciamento, sem necessidade de nenhuma intervenção no switch (com
configuração de fábrica);

43. Deve suportar Digital Optical Monitoring (DOM) para transceivers ópticos;

44. Deve implementar Syslog sobre TLS;

45. Deve implementar SFTP ou SCP;

46. Deve implementar SNMP v1/v2/v3

47. Deve permitir gerar notificação caso seja excedido o limite de MACs;

48. Deve implementar compatibilidade com o protocolo CDP para provisionamento de
telefones IP;

49. Deve implementar o isolamento de um Access Point rogue conectado ao switch,
quando este for detectado por solução de WLAN do mesmo fabricante;

50. Deve implementar a configuração automática de Access Point wireless do mesmo
fabricante quando conectado ao switch. Devem ser suportados os seguintes
parâmetros para a configuração automática: VLAN, CoS, largura de banda
máxima;

51. Deve ser fornecido com a versão de software mais completa disponível para o
equipamento;

52. Deve ser fornecido com todas as licenças de software necessárias para o
funcionamento integral de todas as funcionalidades disponíveis para o
equipamento.

 

Garantia e Suporte

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-
site pelo período mínimo de 60 (sessenta) meses para reposição de peças, mão
de obra e atendimento. O prazo máximo para atendimento do chamado deve ser
de até o próximo dia útil após a sua abertura. Durante o período da garantia o
prazo máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis.

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução.

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
disponibilidade ainda de área para cadastro da solução de hardware ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo
0800 para suporte técnico e abertura de chamados técnicos.

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e
solução exigidos para os equipamentos, deverá ser comprovada a existência da
assistência técnica local no domicílio da contratante e na modalidade on-site,
devendo essa ser realizada por meio de documentação oficial do fabricante dos
produtos e de domínio público, através de catálogos, folder impressos ou da
internet, devendo constar o endereço URL na mesma. Caso não seja comprovada
por um dos meios citados anteriormente, será possível a comprovação através da
apresentação de documentação expressa do fabricante dos equipamentos,
indicando a referida assistência técnica que será responsável pelo atendimento e
manutenção durante o período de garantia dos produtos ofertados. Em caso de
documentação expressa do fabricante a esta deverá ser anexada uma
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do
próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada.

 

ITEM 12 – GBIC 10GB PARA ATÉ 300M
 

Características técnicas mínimas

1. Deve ser do tipo SFP+ de 10GBASE-SR com conector LC;

2. Compatibilidade integral com os Itens 5, 6, 8 e 9.

 

Garantia e Suporte
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3. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de
peças, mão de obra e atendimento no local. O período da garantia o prazo
máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis;

4. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(part number), incorporado ao equipamento;

5. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do
próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada.

 

 

ITEM 13 – CABO DAC 10GB DE 1M
 

Características técnicas mínimas

1. Cabo metálico com conector tipo SFP+ para ligação de duas unidades de switch
em 10 Gbps;

2. Cabo com comprimento mínimo de 1 (um) metro;

3.  Compatibilidade integral com os itens 5, 6, 8 e 9.

 

Garantia e Suporte

4. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de
peças, mão de obra e atendimento no local. O período da garantia o prazo
máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis;

5. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(part number), incorporado ao equipamento;

6. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do
próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada.

 

ITEM 14 – CABO DAC 10GB DE 3M
 

Características técnicas mínimas

1. Cabo metálico com conector tipo SFP+ para ligação de duas unidades de switch
em 10 Gbps;

2. Cabo com comprimento mínimo de 3 (três) metros;

3. Compatibilidade integral com os itens 5, 6, 8 e 9.

 

Garantia e Suporte

4. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de
peças, mão de obra e atendimento no local. O período da garantia o prazo
máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis;

5. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(part number), incorporado ao equipamento;

6. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do
próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada.

 

ITEM 15 – GBIC 1GB PARA ATÉ 500M
 

Características técnicas mínimas
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1. Deve ser do tipo SFP de 1G BASE-SX com conector LC;

2. Compatibilidade integral com os Itens 5, 6, 8, 9, 10 e 11.

 

Garantia e Suporte

3. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de
peças, mão de obra e atendimento no local. O período da garantia o prazo
máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis;

4. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(part number), incorporado ao equipamento;

5. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do
próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada.

 

ITEM 16 – SERVIÇOS DE IMPLANTAÇÃO E
TRANSFERÊNCIA DE TECNOLOGIA PARA SWITCHS
DE REDE
 

Características Gerais

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das
14:00 às 18:00) presencialmente no TRE-AL ou remotamente conforme
necessidades da CONTRATANTE;

 

Implantação

2. Instalação e configuração de no mínimo 10 (dez) switchs de rede, contemplando:

3. Configuração básica de acesso a gerencia via rede;

4. Gerencia e monitoramento em MÓDULO DE GERENCIA DE REDE;

5. Configuração de autenticação de usuários em MÓDULO DE CONTROLE DE
ACESSO;

6. Configuração de no mínimo 10 (dez) VLANs;

7. Configuração de stacking de 2 (duas) pilhas com no máximo 4 (quatro) switchs;

8. Configuração de agregação de links em até 10 (dez) switchs com no máximo 4
(quatro) portas por dispositivo.

 

Transferência de Tecnologia

9. O treinamento deverá ser no realizado na modalidade workshop com tarefas
práticas hands-on, visando assim a melhor fixação dos temas abordados com
foco direto na explicação da tecnologia dos produtos ofertados como também
nas rotinas de configuração, gerenciamento, administração e operação dos
mesmos, devendo ter duração mínima de 24 (vinte e quatro) horas onde serão
abordados no mínimo os seguintes tópicos:

a. Configuração inicial e acesso a gerencia;

b. Configuração de VLANS;

c. Configuração de autenticação de usuários em MÓDULO DE CONTROLE DE
ACESSO;

d. Configuração de empilhamento de switchs;

e. Configuração de agregação de links;

f. Configuração de switchs para MÓDULO DE GERENCIA DE REDE;

g. Configuração de switchs para MÓDULO DE ANÁLISE DE TRÁFEGO.

 

ITEM 17 - SERVIÇOS DE IMPLANTAÇÃO E
TRANSFERÊNCIA DE TECNOLOGIA DO MÓDULO DE
CONTROLE DE ACESSO
 

Características Gerais
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1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das
14:00 às 18:00) presencialmente no TRE-AL ou remotamente conforme
necessidades da CONTRATANTE;

 

Implantação

2. Instalação e configuração de 1 (uma) instância do serviço controle de acesso,
contemplando configurações básicas para acesso à rede, dimensionamento,
configuração de armazenamento;

3. Configuração de autenticação em Active Directory para usuários corporativos;

4. Configuração de autenticação de visitantes com portal de autosserviço para
criação de usuários;

5. Configuração de no mínimo 10 (dez) dispositivos de rede para autenticação na
solução.

 

Transferência de Tecnologia

6. O treinamento deverá ser no realizado na modalidade workshop com tarefas
práticas hands-on, visando assim a melhor fixação dos temas abordados com
foco direto na explicação da tecnologia da solução como também nas rotinas de
configuração, gerenciamento, administração e operação da mesma devendo ter
duração mínima de 24 (vinte e quatro) horas onde será abordado no mínimo os
seguintes tópicos:

a. Configuração de Active Directory como base de autenticação;

b. Configuração de autenticação de usuários corporativos;

c. Configuração de autenticação de usuários visitantes;

d. Configuração de portal de autosserviço;

e. Configuração de autenticação e autorização com RADIUS.

 

ITEM 18 – TREINAMENTO BÁSICO DE
ADMINISTRAÇÃO DE SWITCHES
 

Características Gerais

1. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do
fabricante no Treinamento Básico de Administração dos Switches para 01 (um)
profissional da contratante;

2. O voucher deverá ter validade de pelo menos 12 (doze) meses;

3. O treinamento deverá ser de acordo com o calendário de treinamento do
fabricante e ministrado em centro oficial de treinamento do mesmo ou
remotamente, utilizando tecnologia de ensino a distância;

4. Deverá ser ministrado por profissional devidamente credenciado junto ao
fabricante e apto a entregar o respectivo;

5. O treinamento deverá compreender a explicação da tecnologia da solução como
também das rotinas de configuração, gerenciamento, administração e operação
da mesma;

6. O treinamento deverá ter carga horária mínima de 24 (vinte e quatro) horas,
ministrado no período de 08:00 às 12:00 e das 14:00 às 18:00.

 

ITEM 19 – TREINAMENTO BÁSICO DA SOLUÇÃO DE
CONTROLE DE ACESSO
 

Características Gerais

1. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do
fabricante no Treinamento da Solução de Controle de Acesso  para 01 (um)
profissional da contratante;

2. O voucher deverá ter validade de pelo menos 12 (doze) meses;

3. O treinamento deverá ser de acordo com o calendário de treinamento do
fabricante e ministrado em centro oficial de treinamento do mesmo ou
remotamente, utilizando tecnologia de ensino a distância;

4. Deverá ser ministrado por profissional devidamente credenciado junto ao
fabricante e apto a entregar o respectivo;

5. O treinamento deverá compreender a explicação da tecnologia da solução como
também das rotinas de configuração, gerenciamento, administração e operação
da mesma;
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6. O treinamento deverá ter carga horária mínima de 40 (Quarenta) horas,
ministrado no período de 08:00 às 12:00 e das 14:00 às 18:00;

 

 
LOTE 02 – SOLUÇÃO DE REDE
WIRELESS
 

ITEM 01 – SOLUÇÃO DE ANÁLISE DE PERFIL E
CONTROLE DE ACESSO PARA SOLUÇÃO DE REDE
WIRELESS
LICENCIAMENTO

1. Licenciamento da SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE
ACESSO, contemplando o quantitativo mínimo de 1.000 (um mil) dispositivos,
usuários corporativos ou visitantes simultâneos, independente do perfil de
autenticação, seja por dispositivo ou usuário;

2. Caso a solução ofertada necessite de licenciamento específico para
credenciamento dos dispositivos, usuários (corporativos ou visitantes), deverá ser
fornecido o quantitativo solicitado para ambos, de forma que a solução realize a
análise de perfil e o controle de acesso dos 1.000 (um mil) dispositivos ou
usuários (corporativos ou visitantes) simultâneos.

 

MÓDULO DE ANÁLISE DE PERFIL DE DISPOSITIVO
Características Gerais Modulo de Análise de Perfil de Dispositivo

3. Deve implementar funcionalidade de classificação automática criando perfis de
dispositivos, de forma a descobrir, classificar e agrupar os dispositivos
conectados na rede;

4. Deve categorizar os dispositivos em pelo menos 3 níveis:

d. Por tipo de dispositivo (ex. Computador, Smartdevice, impressora, etc.);

e. Por sistema operacional (ex. Windows, Linux, MacOS, etc.);

f. Versão do sistema operacional (ex. Windows 7, Windows 2008 Server, etc.);

5. Deve ser capaz de gerar gráficos das categorias separando os dispositivos
conforme suas características;

6. Deve suportar a coleta de informações, para classificação, usando no mínimo:

k. DHCP;

l. HTTP User-Agent;

m. MAC OUI;

n. ActiveSync plugin;

o. SNMP;

p. Subnet Scanner;

q. IF-MAP;

r. Cisco Device Sensor;

s. MDM;

t. TCP Fingerprinting.

7. Deve possuir dicionário de categorias de dispositivos pré-configurado e
mecanismo de atualização do mesmo;

8. Deve suportar a integração com, no mínimo, as seguintes soluções de MDM de
mercado AirWatch, MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, MaaS 360
devendo comprovar a compatibilidade em documentação oficial do fabricante;

9. Deve permitir priorização na ordem de criação dos perfis com no mínimo as
seguintes características:

f. Agente proprietário;

g. HTTP User-Agent;

h. SNMP;

i. DHCP;

j. MAC OUI.
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10. A solução de análise de perfil de usuários deverá permitir consultas a sua base,
pela solução de controle de acesso para validação de dispositivos com base no
seu perfil.

 

MÓDULO DE CONTROLE DE ACESSO DE DISPOSITIVOS E
USUÁRIOS
Características Gerais

11. A Solução deverá dar suporte a no mínimo as seguintes bases de dados:

n. Microsoft Active Directory;

o. Kerberos;

p. Diretórios LDAP;

q. OpenLDAP;

r. PostgreSQL;

s. Oracle 11g;

t. MariaDB;

u. MSSQL;

v. Servidores de Token;

w. Base de dados SQL interna;

x. Lista interna estática de hosts.

12. Deve suportar "Single Sign-on" (SSO) através de SAML v2.0;

13. Deve implementar gerenciamento e aplicação de políticas de autorização de
acesso de usuários com base em:

f. Atributos do usuário autenticado;

g. Hora do dia, dia da semana;

h. Tipo de dispositivo utilizado;

i. Localização do usuário;

j. Tipo de autenticação utilizada.

14. Deve permitir a visualização de todas informações relativas a cada transação e
autenticação em uma única tela, a solução deverá trazer no mínimo as seguintes
informações:

m. Data e Hora;

n. Mac Address do dispositivo;

o. Classificação do dispositivo;

p. Usuário;

q. Equipamento que requisitou a autenticação (origem);

r. Método de autenticação utilizado;

s. Fonte de autenticação utilizada para validação;

t. Perfil de acesso aplicado;

u. Atributos de entrada do protocolo utilizados na requisição (ex. RADIUS);

v. Informações de resposta da solução para o elemento de rede;

w. Alertas em caso de falha;

x. LOGS já filtrados para a requisição em análise.

15. Deve possuir Dashboard customizável, onde deve permitir a visualização de no
mínimo as seguintes informações:

a. a. Lista com últimos Alertas do sistema;

b. Gráfico com todas as requisições de autenticação dos últimos 7 dias,
incluindo RADIUS, TACACS+ e Autenticações Web;

c. Gráfico com o status das autenticações aceitas e rejeitadas nos últimos 7
dias;

d. Gráfico com a categorização dos dispositivos classificados pela solução,
divididos de acordo com as categorias de classificação;

e. Últimas falhas de autenticação;

f. Gráfico com as requisições de avaliação de postura dos dispositivos,
divididos em:

I. Saudáveis (dentro das políticas estabelecidas);
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II. Não saudáveis (que estão fora das políticas estabelecidas);

a. a. Lista com as últimas autenticações;

b. Lista com as últimas autenticações com sucesso;

c. Utilização de CPU do sistema, no mínimo nos últimos 30 minutos;

16. Deve possuir base de regras e categorias de dispositivos pré-configurada e
mecanismo de atualização da mesma;

17. Deve suportar a integração com no mínimo as seguintes soluções de MDM de
mercado AirWatch, MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, MaaS 360
devendo comprovar a compatibilidade em documentação oficial do fabricante;

18. Deve suportar autenticações via OAuth2, Facebook, Twitter, LinkdIn, Office365 e
Google Apps;

19. Deve possuir recursos integrados de AAA: RADIUS, TACACS+ e Kerberos;

20. Deve possuir suporte aos seguintes recursos:

m. RADIUS;

n. RADIUS CoA;

o. TACACS+;

p. Web authentication;

q. SAML v2.0;

r. EAP-FAST (EAP-MSCHAPv2, EAP-GTC, EAP-TLS);

s. PEAP (EAP-MSCHAPv2, EAP-GTC, EAP-TLS, EAP-PEAP-Public);

t. TTLS (EAP-MSCHAPv2, EAP-GTC, EAP- TLS, EAP-MD5, PAP, CHAP);

u. EAP-TLS;

v. PAP, CHAP, MSCHAPv1, MSCHAPv2, e EAP-MD5;

w. Windows machine authentication;

x. MAC address authentication (dispositivos sem suporte a 802.1X);

21. Deve suportar verificação de vulnerabilidade através de varredura de portas;

22. Deve suportar à aplicação de políticas em ambiente com múltiplos fornecedores
de Wireless, cabeado e VPN;

23. Deve possuir CA integrada, para geração de certificados para os dispositivos que
forem se autenticar na rede;

24. Deve suportar à integração com plataforma de terceiros usando HTTP/RESTful
API;

25. Deve permitir que a solução faça consultas em bases SQL, com o objetivo de
buscar informação a serem utilizadas durante o processo de autenticação dos
usuários;

26. Deve possuir suporte a administração através de IPv6;

27. Deve possuir ferramenta para gerenciar os processos de credenciamento,
autenticação, autorização e contabilização de usuários visitantes através de portal
web seguro;

28. Deve implementar a criação de grupos de autorizadores com privilégios distintos
de criação de credenciais temporárias e atribuição de permissões de acesso aos
clientes;

29. Deve permitir realizar a autenticação dos autorizadores em base externa do tipo
Microsoft Active Directory ou LDAP e atribuir o privilégio ao autorizador de acordo
com o seu perfil;

30. Deve implementar as funcionalidades de geração de lotes de credenciais
aleatórias, temporárias, pré-autorizadas;

31. Deve implementar a importação e exportação da relação de credenciais
temporárias através de arquivos txt ou csv;

32. Deve permitir a configuração do tempo de validade das credenciais, baseando-se
na criação da conta ou no primeiro login da conta;

33. Deve permitir que o visitante crie sua própria credencial temporária (autosserviço)
através de portal web, com ou sem a necessidade de um autorizador;

34. Deve permitir a customização do formulário de criação de credenciais, a ser
preenchido pelo autorizador ou pelo visitante em caso de autosserviço,
especificando quais informações cadastrais dos visitantes são obrigatórias ou
opcionais;

35. Deve permitir a customização do nível de segurança da senha temporária que
será gerada ao visitante, especificando a quantidade mínima de caracteres e o uso
de caracteres especiais e números para compor a senha;

36. Deve exigir que o usuário visitante aceite o “Termo de uso da rede” a cada login
ou apenas no primeiro login;
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37. Deve permitir o envio das credenciais aos usuários registrados através de
mensagens SMS (Short Message Service), e-mail ou impressão local.

 

GARANTIA E SUPORTE

38. Garantia e suporte do fabricante para a solução de software ofertada pelo período
mínimo de 36 (sessenta) meses, incluindo a evolução para novas versões
devendo o atendimento ser na modalidade 24x7 (vinte quatro horas por dia, sete
dias da semana), com tempo de resposta máximo em 4 (quatro) horas.

39. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução.

40. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
disponibilidade ainda de área para cadastro da solução de software ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;

41. A empresa fabricante da solução de software deverá dispor de um número
telefônico tipo 0800 para suporte técnico e abertura de chamados técnicos.

42. A comprovação da modalidade da garantia deverá ocorrer através de
documentação do fabricante de domínio público, não sendo aceita documentação
emitida pelo fornecedor ou centro de distribuição para fins de comprovação que
por ventura conflitem com catálogos, manuais, folders oficiais impressos ou da
internet (devendo constar o endereço URL para folders da web). Caso não seja
comprovada por um dos meios citados anteriormente, será possível a
comprovação através da apresentação de documentação expressa do fabricante
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso
de documentação expressa do fabricante deverá ser anexada a mesma a
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.

 

 

ITEM 02 – SOLUÇÃO DE GERENCIAMENTO DE REDE
WIRELESS
LICENCIAMENTO

1. Deverá ser entregue o quantitativo mínimo de licenças para o gerenciamento
simultâneo de 50 (cinquenta) Pontos de acesso;

CARACTERÍSTICAS GERAIS

2. A solução de gerenciamento deverá administrar a configuração dos Pontos de
acesso de forma centralizada;

3. A solução de gerenciamento deverá possuir integração com o HPE IMC em
console única de gerenciamento;

4. A solução de gerenciamento de rede wireless deverá suportar, em arquitetura de
controladora distribuída, a capacidade de gerenciar no mínimo 120 (cento e vinte)
pontos de acesso por cluster e no mínimo um total de 20 (vinte) clusters;

5. A solução de gerenciamento, em arquitetura de controladora física ou virtual,
deverá suportar no mínimo 2400 pontos de acesso;

6. Deve ser obrigatoriamente do mesmo fabricante dos pontos de acesso e
controladores;

7. Permitir a configuração e gerenciamento através de browser padrão (http, https);

8. Permitir que os eventos sejam gravados remotamente utilizando Syslog;

9. Prover organização hierárquica de equipamentos, permitindo que um
equipamento receba as configurações lógicas e as replique a outros
equipamentos;

10. Possuir capacidade de projeto automatizado de redes sem fio nos padrões
802.11a, 802.11b e 802.11g, 802.11n e 802.11ac, segundo a geografia do prédio
(planta);

11. Considerar a área de cobertura e a banda por usuário desejada;

12. Possibilitar a importação de plantas baixas nos formatos dwg e jpg;

13. Permitir a visualização de alertas da rede em tempo real;

14. Permitir a visualização de eventuais áreas sem cobertura de RF (áreas de
sombra);

15. Monitorar o desempenho da rede wireless, consolidando informações de rede tais
como:

a. Níveis de ruído;

b. Relação sinal-ruído;

Termo de Referência - TIC 24 (0541748)         SEI 0008478-63.2018.6.02.8000 / pg. 282



c. Interferência;

d. Potência de sinal.

16. Possuir capacidade de listagem on-line da localização de usuário, endereço IP,
endereço MAC, nível de potência de recepção e dados de associação e de
autenticação 802.1x;

17. Deve possuir informação visual e gráfica, na planta baixa dos andares, para:

a. Visualização dos Pontos de acesso instalados, com estado de funcionamento;

b. Visualização do mapa de calor de RF (Heatmap);

c. Localização de ativos conectados à rede (equipamentos 802.11);

d. Localização de Pontos de acesso rogue.

18. Caso esta funcionalidade não esteja disponível no sistema de gerência, deve ser
fornecido software, do mesmo fabricante, para atender este item, contemplando
todos os dispositivos licenciados e com redundância 1+1;

19. Possuir capacidade de identificação e listagem dos rádios vizinhos e respectivos
SSID/BSSID que podem ser percebidos por cada Ponto de acesso;

20. Possuir capacidade de configuração gráfica completa do controlador WLAN seja
ela física, virtual ou distribuída e respectivos Pontos de acesso;

21. Possuir capacidade de geração de relatórios dos seguintes tipos:

a. Listagem de clientes Wireless;

b. Listagem de Pontos de acesso;

c. Informações de Configuração dos Controladores WLAN;

d. Utilização da rede;

e. Detalhes dos Pontos de acesso não autorizados (rogues) detectados.

22. Suportar SSH, HTTP/HTTPS, SSL, Telnet;

23. Possuir ferramentas de debug e log de eventos para depuração e gerenciamento
em primeiro nível;

24. Implementar os padrões abertos de gerência de rede SNMPv2c e SNMPv3,
incluindo a geração de traps;

25. Possuir suporte a MIB II, conforme RFC 1213;

26. Implementar a MIB privativa que forneça informações relativas ao funcionamento
do equipamento;

27. Possibilitar a obtenção da configuração do equipamento através do protocolo
SNMP;

28. Possibilitar a obtenção via SNMP de informações de capacidade e desempenho da
CPU, memória e portas;

29. Possibilitar a gerência e identificação individualizada de cada Ponto de acesso
remoto;

30. Permitir a administração centralizada dos Pontos de acesso sem a necessidade de
configurar os mesmos individualmente;

31. Possibilitar a identificação de paredes e divisórias com respectivos níveis de
atenuação por tipo (alvenaria, vidro, drywall e divisória);

32. Possibilitar a importação de plantas baixas nos formatos gráficos (CAD, dwg, jpg,
gif e png);

33. Deve disponibilizar em painel gráfico de controle informações referentes à:

a. Sistemas operacionais e tipos de dispositivos que estão se conectando a rede;

b. Informações sobre os tipos de aplicações mais utilizados;

c. Informações sobre usuários conectados.

34. Deve possuir informação sobre possíveis ameaças a rede detectadas pelos
sistemas gerenciados;

35. Deve possibilitar criação de regras de detecção de ameaças e correlacionar todos
os dispositivos gerenciados.

 

 
ITEM 03 – LICENÇAS ADICIONAIS PARA SOLUÇÃO
DE GERENCIAMENTO DE REDE WIRELESS
Características técnicas mínimas

1. Licença para expansão da SOLUÇÃO DE GERENCIAMENTO DE REDE
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WIRELESS, contemplando o quantitativo adicional mínimo de 1 (um) ponto de
acesso simultâneo;

2. Cada unidade deve ser fornecida com todas as licenças de software necessárias
para o funcionamento integral de todas as funcionalidades disponíveis para
SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS especificada nesse
edital.

 

GARANTIA E SUPORTE

1. Garantia e suporte do fabricante para a solução de software ofertada pelo período
mínimo de 36 (sessenta) meses, incluindo a evolução para novas versões
devendo o atendimento ser na modalidade 24x7 (vinte quatro horas por dia, sete
dias da semana), com tempo de resposta máximo em 4 (quatro) horas.

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução.

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
disponibilidade ainda de área para cadastro da solução de software ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;

4. A empresa fabricante da solução de software deverá dispor de um número
telefônico tipo 0800 para suporte técnico e abertura de chamados técnicos.

5. A comprovação da modalidade da garantia deverá ocorrer através de
documentação do fabricante de domínio público, não sendo aceita documentação
emitida pelo fornecedor ou centro de distribuição para fins de comprovação que
por ventura conflitem com catálogos, manuais, folders oficiais impressos ou da
internet (devendo constar o endereço URL para folders da web). Caso não seja
comprovada por um dos meios citados anteriormente, será possível a
comprovação através da apresentação de documentação expressa do fabricante
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso
de documentação expressa do fabricante deverá ser anexada a mesma a
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.

 

 
ITEM 04 – LICENCIAMENTO ADICIONAL DA
SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE
ACESSO
Características técnicas mínimas

3. Licenciamento para expansão da SOLUÇÃO DE ANALISE DE PERFIL E
CONTROLE DE ACESSO, contemplando o quantitativo mínimo adicional de 500
(quinhentos) dispositivos, usuários corporativos ou visitantes simultâneos,
independente do perfil de autenticação, seja por dispositivo ou usuário;

 

GARANTIA E SUPORTE

6. Garantia e suporte do fabricante para a solução de software ofertada pelo período
mínimo de 36 (sessenta) meses, incluindo a evolução para novas versões
devendo o atendimento ser na modalidade 24x7 (vinte quatro horas por dia, sete
dias da semana), com tempo de resposta máximo em 4 (quatro) horas.

7. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução.

8. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
disponibilidade ainda de área para cadastro da solução de software ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;

9. A empresa fabricante da solução de software deverá dispor de um número
telefônico tipo 0800 para suporte técnico e abertura de chamados técnicos.

10. A comprovação da modalidade da garantia deverá ocorrer através de
documentação do fabricante de domínio público, não sendo aceita documentação
emitida pelo fornecedor ou centro de distribuição para fins de comprovação que
por ventura conflitem com catálogos, manuais, folders oficiais impressos ou da
internet (devendo constar o endereço URL para folders da web). Caso não seja
comprovada por um dos meios citados anteriormente, será possível a
comprovação através da apresentação de documentação expressa do fabricante
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso
de documentação expressa do fabricante deverá ser anexada a mesma a
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.
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ITEM 05 – CONTROLADORA WLAN
Características gerais

1. Solução baseada em hardware ou software específico, do tipo appliance físico ou
virtual, do mesmo fabricante dos pontos de acesso e software de gerência;

2. Deve estar licenciado para controle de, no mínimo, 50 (cinquenta) pontos de
acesso, podendo ser expandido em no mínimo, 250 (duzentos e cinquenta)
pontos de acesso através de licenciamento adicional;

3. Permitir a conexão simultânea de, no mínimo, 4.000 clientes wireless;

4. Permitir a gravação de eventos por meio do protocolo syslog;

5. Acesso ao sistema através de cliente com browser padrão (http, https, Java);

6. Permitir operação em modo mesh;

7. Permitir o uso de múltiplos SSIDs simultaneamente;

8. Prover tempo de fast-roaming intra-switch inferior a 25 milissegundos;

9. Prover tempo de fast-roaming inter-switch em camada 2, inferior a 100
milissegundos;

10. Permitir conexão entre APs sem a necessidade de conexão cabeada,
implementando assim uma rede padrão mesh;

11. Deve suportar 802.11e com WMM, U-APSD e T-SPEC;

12. Gerenciar centralizadamente a autenticação de usuários;

13. Implementar protocolo de autenticação para controle do acesso administrativo a
solução com mecanismos de AAA;

14. Possuir base de dados de usuários interna para autenticação de usuários
convidados / temporários (acesso guest);

15. Permitir autenticação em no mínimo os seguintes sistemas de base de dados de
usuários Microsoft Active Directory, Cisco ACS server, FreeRadius, entre outros;

16. Realizar o provisionamento de usuários convidados (guests) através de interface
Web por meio de um usuário administrativo com permissões mínimas, exclusivas
para este fim;

17. Possuir suporte a autenticação IEEE 802.1X, com pelo menos os seguintes
métodos EAP: EAP-MD5, PEAP/EAP-GTC, PEAP/EAP-MSCHAPv2, EAP-TLS com
utilização de base de usuários interna ou servidor RADIUS externo;

18. Suportar as especificações: IEEE 802.1x;

19. Deverá suportar os seguintes métodos EAP-PEAP, EAP-TLS e EAP-TTLS;

20. Possuir suporte a autenticação IEEE 802.1X, com o método PEAP/EAP-GTC, e
com utilização de base de usuários LDAP externa;

21. Permitir a seleção/uso de servidor Radius ou LDAP com base no SSID;

22. Suportar a autenticação de usuários conectados à rede cabeada através das
portas do controlador;

23. Possuir o recurso de EAP Offload para terminação do túnel EAP no próprio
controlador;

24. Deve suportar utilização de Portal Captivo externo ao controlador;

25. Permitir a autenticação (através de endereço MAC, Portal Captivo ou IEEE 802.1X)
de usuários conectados à rede WLAN (wireless) ou usuários conectados às
portas cabeadas do controlador. Também deverá permitir a autenticação de
usuário e de máquina por meio de IEEE 802.1x;

26. Oferecer recurso de Portal Captivo (Captive Portal) com suporte a múltiplos
portais simultaneamente;

27. Implementar associação dinâmica de usuário a VLAN, com base nos parâmetros
da etapa de autenticação;

28. Implementar Qualidade de Serviço com a marcação de pacotes utilizando Diffserv
e suporte a 802.1p para QoS de rede;

29. Possibilitar roaming com integridade de sessão, dando suporte a aplicações em
tempo real, tais como, VoIP, VoWLAN, videoconferência, dentre outras;

30. Permitir portais captivos externos a controladora;

31. A controladora deve possuir funcionalidade de conexão Site to Site VPN utilizando
padrão Ipsec. Caso a solução fornecida não possua a funcionalidade, será aceita
solução de VPN adicional integrada;

32. Deve permitir o tunelamento do trafego de dados de usuários mesmo em redes
L3, não sendo necessário estender VLANs até o Ponto de Acesso, inclusive em
MANs e WANs;
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33. Implementar segurança IEEE 802.11i;

34. Suportar a criptografia centralizada com os seguintes protocolos: AES-CCMP, TKIP
e WEP;

35. Suportar, no mínimo, 2000 VLANs;

36. Implementar o protocolo 802.1w (Rapid Spanning Tree);

37. Oferecer suporte a roteamento e switching de camadas L2 e L3;

38. Possuir o recurso de criação de Pools de VLAN para permitir a escalabilidade de
redes;

39. Possuir servidor DHCP embutido;

40. Suportar o protocolo VRRP para redundância de controladores;

41. Deve suportar redundância de controladores nos modos:

a. 1+1;

b. N+1;

c. Ativo-Ativo;

d. Ativo-Standby;

42. Oferecer os recursos de mobilidade entre VLANs para roaming de camada 2;

43. Oferecer os recursos de Proxy de endereços IP e Proxy DHCP para roaming entre
redes (L3)

44. Deve implementar northbound APIs para realização de integrações com aplicações
de terceiros para fins de monitoramento e visibilidade. Caso seja necessário, deve
ser ofertado licenças para ativação desse recurso;

45. Implementar tagging de VLANs através do protocolo 802.1Q;

46. Implementar o protocolo 802.1d para Spanning Tree (STP);

47. O controlador WLAN poderá estar diretamente e/ou remotamente conectado aos
APs por ele gerenciados, inclusive via roteamento nível 3 da camada OSI

48. Se um controlador WLAN ou AP controlador falhar, os APs relacionados deverão
se associar a um controlador WLAN alternativo de forma automática, não
permitindo que a rede wireless se torne inoperante;

49. Realizar a descoberta automática dos APs na infraestrutura wireless;

50. Permitir o controle dos APs mediante a conexão através de topologia MESH (WiFi
Mesh);

51. A rede MESH deverá oferecer comportamento determinístico da topologia da rede
MESH;

52. A rede MESH deverá prover auto-redundância das camadas física (RF) e Layer 2
com comportamento determinístico;

53. Permitir a conexão de APs de maneira remota e segura;

54. Conectar APs através de redes públicas e/ou privadas com garantia de segurança
através de conexão criptografada;

55. Permitir a propagação de SSIDs de maneira segura para qualquer AP
legitimamente cadastrado na controladora, independentemente de onde este AP
esteja conectado;

56. Permitir a autenticação do AP remoto através de certificado digital ou de usuário e
senha cadastrados em servidor AD e Radius;

57. Gerenciar o tráfego dos APs centralizadamente;

58. Administrar a configuração dos AP’s;

59. Deve permitir administrar centralizadamente todos os aspectos de segurança da
rede WLAN através de firewall integrado à solução de rede sem fio, caso a solução
ofertada não possua solução de firewall nativa na controladora WLAN deverá ser
ofertado firewall externo com capacidade para atender toda a solução;

60. Permitir o bloqueio de comunicação entre clientes wireless – L2 bridging;

61. Implementar filtros baseados em protocolos e em endereços MAC;

62. Implementar padrão IEEE 802.11h;

63. Realizar o controle de autorização baseado em perfis de acesso;

64. Permitir que seja configurado um perfil de acesso, com regras aplicadas de
firewall, para o qual será direcionado o usuário após sua autenticação;

65. Possuir o recurso de “blacklisting” contra ataques ao Firewall e à rede wireless,
evitando que um determinado cliente se associe à rede wireless caso viole políticas
definidas de Firewall ou execute algum ataque à rede WLAN de endereços MAC de
APs do sistema;

66. O Firewall deverá implementar os recursos de NAT (Network Address Translation)
tanto para destino quanto para origem;
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67. Implementar listas de controle de acesso (ACLs);

68. Oferecer detecção e proteção integrada de ataques de negação de serviços TCP,
ICMP;

69. Permitir o espelhamento de sessão e logs detalhados por pacote a fim de
possibilitar análises forenses;

70. Permitir a aplicação de políticas de camada 4, de acordo com as características do
usuário. Por exemplo, um usuário que pertença ao grupo de gerentes
(cadastrado no Radius ou Active Directory) terá permissão de acesso ao
protocolo FTP no servidor de ERP;

71. Permitir derivação de políticas de acesso. Por exemplo, um usuário pode
pertencer a um grupo ao qual foram atribuídas políticas de acesso em camada 4,
porém, caso esteja utilizando um dispositivo de voz, o tráfego SIP passará a ter
prioridade através de aplicação de QoS;

72. Permitir a criação de políticas com base em horários e na localização do usuário.
Por exemplo: bloquear o tráfego do protocol FTP após às 18 horas.

73. O Firewall deverá ser integrado à rede WLAN de modo a permitir a desassociação
de usuários da rede sem fio WLAN com base na violação de políticas de tráfego.
Por exemplo: desassociar da rede WLAN e colocar em quarentena o Notebook
com endereço MAC XX:XX:XX se o usuário tentar fazer um telnet para o servidor
ABC;

74. Otimizar o desempenho e a cobertura da radiofrequência;

75. Ajustar automaticamente os canais de modo a otimizar a cobertura de rede e
mudar as condições de RF baseado em performance;

76. Detectar interferência e ajustar parâmetros de RF, evitando problemas de
cobertura e controle da propagação indesejada de RF;

77. Implementar varredura de RF contínua, programada ou sob demanda, com
identificação de APs ou clientes irregulares;

78. Deve implementar a tecnologia de “Channel load balancing”, permitindo que
clientes sejam automaticamente distribuídos entre Pontos de Acesso adjacentes
operando em canais distintos, com o objetivo de balancear a carga entre os
Pontos de Acesso;

79. Deve implementar a tecnologia de “Band Steering/Select”, permitindo que clientes
com suporte a faixa de frequência de 5GHz se conectem aos Pontos de Acesso
utilizando, preferencialmente, a faixa de 5GHz;

80. Implementar varredura de RF nas bandas 802.11a, 802.11b, 802.11g, 802.1n e
802.11ac para identificação de ataques e APs intrusos não autorizados (rogues);

81. Realizar a varredura no canal de operação do AP sem impacto na performance da
rede WLAN;

82. Permitir a varredura em todos os canais possíveis de RF para detecção e
contenção de ameaças na rede WLAN;

83. Deve fazer a varredura dos espectros de 2,4 GHz e 5 GHz para localização e
classificação de interferências não 802.11, analise de espectro, e evita-las
automaticamente;

84. O controlador deve possuir funcionalidade de analisador gráfico de espectro para
detecção de interferências nas faixas de frequência de 2.4 e 5 GHz, sejam elas
IEEE 802.11 ou não. Deve disponibilizar interface gráfica com, pelo menos,
gráficos de Fast Fourier Transform (FFT) e espectrograma; Caso a funcionalidade
não possa ser apresentada pelo controlador, deve ser fornecido um equipamento
ou software, do mesmo fabricante, que o faça;

85. Utilizar os APs como ”sensores” de RF para fazer a monitoração do ambiente
Wireless;

86. Classificar automaticamente APs válidos, os que interferem e os não autorizados
(rogues);

87. Implementar mecanismos para detecção e contenção de APs não autorizados
(rogues);

88. Realizar a contenção automática dos APs Rogue, simultaneamente, através da
rede WLAN e/ou da rede cabeada;

89. Realizar a identificação e contenção de redes “ad-hoc”;

90. Detectar e bloquear o bridging entre estações da rede WLAN;

91. Oferecer proteção contra ataques Denial Of Service (DOS) a APs e estações

92. Detectar e alertar os seguintes tipos de ataques na rede WLAN:

a. Impersonalização de AP válido;

b. Floods de Frames;

c. Fake Ap, Airjack;

d. Broadcasts de de-autenticação;

e. Ataques baseados em probes;
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93. Possuir capacidade de gerar alarmes e executar contra-ataques se um ataque for
detectado;

94. Detectar áreas de sombra de cobertura e efetuar os devidos ajustes para sua
correção, automaticamente;

95. Ajustar, dinamicamente, o nível de potência e canal de rádio dos APs, de modo a
otimizar o tamanho da célula de RF, garantindo a performance e escalabilidade;

96. Permitir o controle de banda disponível (bandwith contracts) por usuário ou
através de perfis de usuários;

97. Possibilitar roaming com integridade de sessão, dando suporte a aplicações em
tempo real, tais como, VoIP, VoWLAN, videoconferência, dentre outras;

98. Deve possuir mecanismo de controle de admissão de chamadas nos pontos de
acesso (CAC);

99. Possuir mecanismo automático de QoS para protocolos de voz (SIP, SVP e SCCP)
utilizando inspeção automática de pacotes, sem a necessidade de fazer a
marcação prévia (tagging) de pacotes;

100. Deve possuir solução de identificação de aplicações através de técnicas de análise
de tráfego, provendo informações das aplicações mais utilizadas na interface
gráfica;

101. Permitir a criação de políticas de acesso baseadas nas aplicações, como por
exemplo, o acesso a “redes sociais” terá um controle de banda de 2Mpbs.

102. Apresentar informações gráficas referente a utilização de soluções de
comunicações unificadas (UC) sobre a infraestrutura WLAN, de formar a
apresentar informações referentes as chamadas realizadas e relações gráficas
entre o nível de sinal recebido pelo usuário e a qualidade da chamada.

103. Possuir a funcionalidade da utilização do protocolo Bonjour na infraestrutura,
permitindo que os serviços divulgados via mDNS sejam controlados, filtrados e
disponibilizados entre diferentes subnets, tornando assim possível a utilização em
redes com múltiplas subnets e um número grande de dispositivos.

104. Cada unidade deve ser fornecida com todas as licenças de software necessárias
para o funcionamento integral de todas as funcionalidades disponíveis.

Garantia e Suporte

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-
site pelo período mínimo de 60 (sessenta) meses para reposição de peças, mão
de obra e atendimento. O prazo máximo para atendimento do chamado deve ser
de até o próximo dia útil após a sua abertura. Durante o período da garantia o
prazo máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis.

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução.

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
disponibilidade ainda de área para cadastro da solução de hardware ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo
0800 para suporte técnico e abertura de chamados técnicos.

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e
solução exigidos para os equipamentos, deverá ser comprovada a existência da
assistência técnica local no domicílio da contratante e na modalidade on-site,
devendo essa ser realizada por meio de documentação oficial do fabricante dos
produtos e de domínio público, através de catálogos, folder impressos ou da
internet, devendo constar o endereço URL na mesma. Caso não seja comprovada
por um dos meios citados anteriormente, será possível a comprovação através da
apresentação de documentação expressa do fabricante dos equipamentos,
indicando a referida assistência técnica que será responsável pelo atendimento e
manutenção durante o período de garantia dos produtos ofertados. Em caso de
documentação expressa do fabricante a esta deverá ser anexada uma
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do
próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada.

 

ITEM 06 – LICENÇAS ADICIONAIS PARA
CONTROLADORA WLAN
Características técnicas mínimas

3. Licença para expansão da CONTROLADORA WLAN, contemplando o
quantitativo adicional mínimo de 1 (um) ponto de acesso simultâneo;
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4. Deve ser compatível com controladora WLAN especificada nesse edital;

5. Cada unidade deve ser fornecida com todas as licenças de software necessárias
para o funcionamento integral de todas as funcionalidades disponíveis para
CONTROLADORA WLAN especificada nesse edital.

 

GARANTIA E SUPORTE

6. Garantia e suporte do fabricante para a solução de software ofertada pelo período
mínimo de 36 (sessenta) meses, incluindo a evolução para novas versões
devendo o atendimento ser na modalidade 24x7 (vinte quatro horas por dia, sete
dias da semana), com tempo de resposta máximo em 4 (quatro) horas.

7. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução.

8. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
disponibilidade ainda de área para cadastro da solução de software ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;

9. A empresa fabricante da solução de software deverá dispor de um número
telefônico tipo 0800 para suporte técnico e abertura de chamados técnicos.

10. A comprovação da modalidade da garantia deverá ocorrer através de
documentação do fabricante de domínio público, não sendo aceita documentação
emitida pelo fornecedor ou centro de distribuição para fins de comprovação que
por ventura conflitem com catálogos, manuais, folders oficiais impressos ou da
internet (devendo constar o endereço URL para folders da web). Caso não seja
comprovada por um dos meios citados anteriormente, será possível a
comprovação através da apresentação de documentação expressa do fabricante
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso
de documentação expressa do fabricante deverá ser anexada a mesma a
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.

 

ITEM 07 – PONTO DE ACESSO INTERNO TIPO 01
Características gerais

1. Equipamento de Ponto de Acesso para rede local sem fio, configurável via
software, com funcionamento simultâneo nos padrões IEEE 802.11a/n/ac, 5GHz,
e IEEE 802.11b/g/n, 2.4GHz;

2. Todos os Pontos de acesso sem fio deverão ser novos e sem nenhum histórico
de utilização;

3. Os pontos de acesso deverão possuir certificado emitido pelo “WIFI Alliance”
comprovando no mínimo os seguintes padrões, protocolos e funcionalidades:

a. IEEE 802.11a;

b. IEEE 802.11b;

c. IEEE 802.11g;

d. IEEE 802.11n;

e. IEEE 802.11d;

f. IEEE 802.11ac;

g. WPA® Enterprise/Personal;

h. WPA2® Enterprise/Personal;

i. EAP-TLS;

j. EAP-TTLS/MSCHAPv2;

k. PEAPv0/EAP-MSCHAPv2;

l. PEAPv1/EAP-GTC;

m. EAP-SIM;

n. EAP-FAST;

o. WMM® e WMM® Power Save;

p. Beamforming;

q. Short Guard Interval (SGI);

r. Packet Aggregation (A-MPDU);

s. Opportunistic Key Caching (OKC)

4. Deve operar simultaneamente em 2.4GHz e 5GHz (concurrent dual-band);
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Performance

5. Deve suportar rádio dual, 5 GHz 802.11ac 2x2 MIMO e 2.4GHz 802.11n 2x2 MIMO

6. Deve suportar capacidade de 1300 Mbps de throughput ou superior;

7. Deve possuir rádio duplo configurável pelo software suportando 5 GHz e 2,4 GHz;

8. Deve possuir no mínimo dois spatial stream Single User (SU) MIMO para taxa de
dados sem fio de até 867 Mbps para dispositivos cliente individuais (VHT80) 2x2
em 5GHz;

9. Deve possuir no mínimo dois spatial stream Single User (SU) MIMO para uma taxa
de dados sem fio de até 400 Mbps para dispositivos clientes compatíveis (2x2
VHT40) em 5GHz;

10. Deve possuir suporte para até 255 dispositivos cliente associados por rádio e até
16 BSSIDs por rádio;

11. Deve suportar no mínimo as bandas de frequência:

a. 2,400 a 2,4835 GHz

b. 5.150 a 5.250 GHz

c. 5,25 a 5,350 GHz

d. 5,470 a 5,725 GHz

e. 5,725 a 5,850 GHz

12. Deve possuir suporte a seleção de frequência dinâmica (DFS) otimizando o uso do
espectro de RF disponível;

13. Deve suportar, no mínimo, as seguintes tecnologias de rádio:

a. 802.11b: espectro espalhável de sequência direta (DSSS)

b. 802.11a/g/n/ac: multiplexação por divisão de frequência ortogonal (OFDM)

14. Deve suportar, no mínimo, os seguintes tipos de modulação:

a. 802.11b: BPSK, QPSK, CCK

b. 802.11a/g/n/ac: BPSK, QPSK, 16-QAM, 64-QAM, 256-QAM

15. Deve possuir potência de transmissão configurável em incrementos entre 0,5
e 1,0 dBm.

16. Deve respeitar os limites de potência de transmissão máxima (conduzida):

a. Faixa de 2,4 GHz: +18 dBm por corrente, agregado de +21 dBm (2x2)

b. Banda de 5 GHz: +18 dBm por corrente, agregado de +21 dBm (2x2)

17. Deve suportar Advanced Cellular Coexistence (ACC) minimizando a interferência
das redes celulares;

18. Deve suportar Maximum ratio combining (MRC) para melhorar o desempenho do
receptor;

19. Deve suportar Cyclic delay/shift diversity (CDD/CSD) para melhorar o desempenho
RF de downlink;

20. Deve suportar Short guard interval para canais de 20MHz, 40MHz e 80MHz;

21. Deve suportar Space-time block coding (STBC) para aumentar o alcance e
melhorar a recepção;

22. Deve suportar Verificação de paridade de baixa densidade (LDPC) para correção
de erros de alta eficiência e aumento da taxa de transferência;

23. Deve suportar Transmit beam-forming (TxBF);

24. Deve possuir, no mínimo, as seguintes taxas de dados suportadas (Mbps):

a. 802.11b: 1, 2, 5.5, 11

b. 802, 11a / g: 6, 9, 12, 18, 24, 36, 48, 54

c. 802.11n (2.4GHz): 6.5 a 300 (MCS0 a MCS15)

d. 802.11ac: 6.5 a 867 (MCS0 a MCS9, NSS = 1 a 2 for VHT20/40/80

25. Deve possuir suporte a 802.11n de alto rendimento (HT): HT 20/40

26. Deve possuir suporte a 802.11ac de alta velocidade (VHT): VHT 20/40/80

27. Deve possuir suporte a agregação de pacotes 802.11n/ac: A-MPDU, A-MSDU

 

Gerenciamento

28. Deve implementar funcionamento de modo auto gerenciado, sem necessidade de
controladora WLAN para configuração de seus parâmetros de rede wireless,
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gerenciamento das políticas de segurança, QoS e monitoramento de RF.

29. Deve obedecer à todas as características descritas mesmo neste modo de
funcionamento;

30. No modo de funcionamento auto gerenciado deve disponibilizar na interface
gráfica informações de usuários conectados, qualidade de sinal e trafego de
dados na rede;

31. O ponto de acesso deve permitir a conversão de modo auto gerenciado para
modo gerenciado por controlador WLAN através de interface gráfica, em browser
padrão (HTTPS), e permitir que todos os demais pontos de acesso pertencentes
ao mesmo cluster, também sejam convertidos automaticamente;

32. O ponto de acesso deverá suportar conexão direta ou remota com controlador
WLAN, inclusive via roteamento da camada de rede, baseado no modelo OSI;

33. Se um controlador WLAN falhar, os Pontos de Acesso relacionados deverão se
associar automaticamente a um controlador WLAN alternativo, não permitindo
que a rede wireless se torne inoperante;

34. Implementar mecanismo de funcionamento para trabalhar com controladores
WLAN em redundância;

35. Deve permitir que o ponto de acesso seja atualizado de forma centralizada pela
interface gráfica;

36. Permitir o armazenamento de sua configuração em memória não volátil, podendo,
numa queda e posterior restabelecimento da alimentação, voltar à operação
normalmente na mesma configuração anterior;

37. Deve possuir servidor DHCP interno configurável;

38. Possibilitar backup e restore da configuração através da interface gráfica;

39. Deve possuir Portal Captivo (Captive Portal) integrado para utilização em rede de
visitantes;

40. Deve possuir mecanismos para proteção contra Pontos de Acesso não
autorizados (Rogues);

41. Possuir capacidade de identificação e listagem dos rádios vizinhos e respectivos
SSID/BSSID;

42. Implementar associação dinâmica de usuários à VLANs com base nos parâmetros
da etapa de autenticação;

43. Deve possuir uma base de usuários interna que diferencie usuários visitantes de
funcionários, para ser usada em autenticação 802.1x ou portal captivo;

44. Permitir a autenticação para acesso dos usuários conectados nas redes WLAN
(Wireless) através:

a. MAC Address

b. 802.1x em base Local

c. Captive Portal

d. 802.1x em base externa RADIUS

e. 802.1x em base externa LDAP

45. Deve permitir a seleção/uso de servidor de autenticação específico com base no
SSID;

46. Implementar o protocolo de enlace CSMA/CA para acesso ao meio de transmissão;

47. Possuir capacidade de selecionar automaticamente o canal de transmissão;

48. Permitir o ajuste dinâmico de nível de potência e canal de rádio de modo a otimizar
o tamanho da célula de RF;

49. Permitir habilitar e desabilitar a divulgação do SSID;

50. Implementar diferentes tipos de combinações encriptação/autenticação por SSID;

51. Implementar padrão WMM da Wi-Fi Alliance para priorização de tráfego,
suportando aplicações em tempo real, tais como, VoIP, vídeo, dentre outras;

52. Não deve haver no licenciamento restrições com relação ao número de
dispositivos conectados por ponto de acesso;

53. Implementar a pilha de protocolos TCP/IP com suporte a IPV4 e IPV6 (Bridging);

54. Implementar VLANs conforme padrão IEEE 802.1Q;

55. Possuir, no mínimo, uma interface IEEE 802.3 10/100/1000BaseT Ethernet, auto-
sensing, auto MDI/MDX;

56. Permitir a atualização remota do sistema operacional e arquivos de configuração
através da controladora WLAN

57. Implementar cliente DHCP, para configuração automática de rede;

58. Deve configurar-se automaticamente ao ser conectado na rede;

59. Possuir LED’s indicativos do estado de operação, da atividade do rádio e da

Termo de Referência - TIC 24 (0541748)         SEI 0008478-63.2018.6.02.8000 / pg. 291



interface Ethernet;

60. Possuir estrutura que permita fixação do equipamento em teto e parede e
fornecer acessórios para que possa ser feita a fixação;

61. Deve ser acompanhado de todos os acessórios necessários para
operacionalização do equipamento, tais como: softwares, cabos de console,
cabos de energia elétrica, documentação técnica e manuais (podendo ser em CD-
ROM) que contenham informações suficientes para possibilitar a instalação,
configuração e operacionalização do equipamento;

62. Permitir o bloqueio da configuração do Ponto de Acesso via rede wireless;

63. Implementar varredura de RF nas bandas 802.11a, 802.11b, 802.11g, 802.11n,
para identificação de Pontos de Acesso intrusos não autorizados (rogues) e
interferências no canal habilitado ao ponto de acesso e nos demais canais
configurados na rede WLAN, sem impacto no seu desempenho;

64. Implementar IEEE 802.1x, com pelo menos os seguintes métodos EAP:

a. EAP-FAST

b. EAP-TLS

c. PEAP-GTC

d. PEAP-MSCHAPv2

65. Permitir a integração com RADIUS Server com suporte aos métodos EAP citados;

66. A comunicação entre todos os pontos de acesso sem fio e a controladora deverá
ser criptografada;

67. Suportar a autenticação com geração dinâmica de chaves criptográficas por
sessão e por usuário;

68. Implementar WPA com algoritmo de criptografia TKIP e MIC;

69. Implementar WPA2 com algoritmo de criptografia AES, 128/256 bits, IEEE 802.11i;

70. Deve possuir modo dedicado de funcionamento de análise de espectro das faixas
de frequência de 2.4 e 5 GHz identificando fontes de interferência nessas faixas;

71. Deve possibilitar analise de espectro nos canais em que estiver provendo acesso,
sem desconectar os usuários;

72. Deve disponibilizar informações gráficas de análise de espectro em conjunto com
o controlador WLAN;

73. O equipamento deverá possuir registro na ANATEL e deverá ser apresentado na
entrega do equipamento;

74. Deverá prover priorização de trafego de vídeo e voz através de parâmetros de
QoS (Quality os Service) com possibilidade de aplicar por SSID e dispositivo;

75. Possibilitar roaming na rede wireless;

76. Suportar a criação de uma rede de convidados autocontida com isolamento de
tráfego entre clientes e serviços locais;

77. Possuir recursos de seleção automática de canal de transmissão procurando por
canais onde haja menor interferência, tendo por objetivo melhorar a performance
da rede wireless;

78. Permitir a operação em estrutura Mesh viabilizando a comunicação direta entre
diferentes Pontos de Acesso sem Fio onde não seja possível estender a rede
cabeada;

79. Operando em estrutura Mesh, a comunicação entre os dispositivos estrutura
deverão operar na frequência de 5Ghz.

80. Possuir mecanismo para a restauração das configurações originais de fábrica
fisicamente no equipamento (reset);

81. Suportar operação em humidade de 5% a 95% sem condensação;

82. Suportar operação em temperatura de até 40°C (quarenta graus centígrados);

83. Possuir um MTBF (Mean Time Between Failure - Período Médio entre Falhas) de, no
mínimo, 250.000 horas.

 

Garantia e Suporte

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-
site pelo período mínimo de 60 (sessenta) meses para reposição de peças, mão
de obra e atendimento. O prazo máximo para atendimento do chamado deve ser
de até o próximo dia útil após a sua abertura. Durante o período da garantia o
prazo máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis.

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução.

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
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disponibilidade ainda de área para cadastro da solução de hardware ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo
0800 para suporte técnico e abertura de chamados técnicos.

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e
solução exigidos para os equipamentos, deverá ser comprovada a existência da
assistência técnica local no domicílio da contratante e na modalidade on-site,
devendo essa ser realizada por meio de documentação oficial do fabricante dos
produtos e de domínio público, através de catálogos, folder impressos ou da
internet, devendo constar o endereço URL na mesma. Caso não seja comprovada
por um dos meios citados anteriormente, será possível a comprovação através da
apresentação de documentação expressa do fabricante dos equipamentos,
indicando a referida assistência técnica que será responsável pelo atendimento e
manutenção durante o período de garantia dos produtos ofertados. Em caso de
documentação expressa do fabricante a esta deverá ser anexada uma
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do
próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada.

 

ITEM 08 – PONTO DE ACESSO INTERNO TIPO 02
Características gerais

1. Equipamento de Ponto de Acesso para rede local sem fio, configurável via
software, com funcionamento simultâneo nos padrões IEEE 802.11a/n/ac, 5GHz,
e IEEE 802.11b/g/n, 2.4GHz;

2. Todos os Pontos de acesso sem fio deverão ser novos e sem nenhum histórico
de utilização;

3. Os pontos de acesso deverão possuir certificado emitido pelo “WIFI Alliance”
comprovando no mínimo os seguintes padrões, protocolos e funcionalidades:

a. IEEE 802.11a;

b. IEEE 802.11b;

c. IEEE 802.11g;

d. IEEE 802.11n;

e. IEEE 802.11d;

f. IEEE 802.11ac;

g. WPA® Enterprise/Personal;

h. WPA2® Enterprise/Personal;

i. EAP-TLS;

j. EAP-TTLS/MSCHAPv2;

k. PEAPv0/EAP-MSCHAPv2;

l. PEAPv1/EAP-GTC;

m. EAP-SIM;

n. EAP-FAST;

o. WMM® e WMM® Power Save;

p. Beamforming;

q. Short Guard Interval (SGI);

r. Packet Aggregation (A-MPDU);

s. Opportunistic Key Caching (OKC)

4. Deve operar simultaneamente em 2.4GHz e 5GHz (concurrent dual-band);

 

Performance

5. Deve suportar rádio dual, 5 GHz 802.11ac 4x4 MIMO e 2.4 GHz 802.11n 2x2
MIMO;

6. Deve possuir rádio duplo configurável pelo software, suportando 5 GHz e 2,4
GHz;

7. Deve possuir quatro spatial stream Single User (SU) MIMO para taxa de dados
sem fio de até 1,733 Mbps, em 5GHz;
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8. Deve possuir três spatial stream Multi User (MU) MIMO para uma taxa de dados
sem fio de até 1,300 Mbps para dispositivos clientes compatíveis, em 5GHz;

9. Deve possuir suporte para até 255 dispositivos cliente associados por rádio e até
16 BSSIDs por rádio;

10. Deve suportar no mínimo as bandas de frequência:

a. 2,400 a 2,4835 GHz

b. 5.150 a 5.250 GHz

c. 5.250 a 5.350 GHz

d. 5,470 a 5,725 GHz

e. 5,725 a 5,850 GHz

11. Deve possuir suporte a seleção de frequência dinâmica (DFS) otimizando o uso do
espectro de RF disponível;

12. Deve suportar, no mínimo, as seguintes tecnologias de rádio:

a. 802.11b: espectro espalhável de sequência direta (DSSS);

b. 802.11a / g / n / ac: multiplexação por divisão de frequência ortogonal (OFDM);

13. Deve suportar, no mínimo, os seguintes tipos de modulação:

a. 802.11b: BPSK, QPSK, CCK;

b. 802.11a / g / n / ac: BPSK, QPSK, 16-QAM, 64-QAM, 256-QAM;

14. Deve possuir potência de transmissão configurável em incrementos de 0,5 dBm;

15. Deve respeitar os limites de potência de transmissão máxima (conduzida):

a. Faixa de 2,4 GHz: +18 dBm por corrente, agregado de +24 dBm (3x3);

b. Faixa de 5 GHz: +18 dBm por corrente, agregado de +24 dBm (4x4);

16. Deve suportar Advanced Cellular Coexistence (ACC) minimizando a interferência
das redes celulares;

17. Deve suportar Maximum Ratio Combining (MRC) para melhorar o desempenho do
receptor;

18. Deve suportar Cyclic delay/shift diversity (CDD/CSD) para melhorar o desempenho
RF de downlink;

19. Deve suportar Short guard interval para canais de 20-MHz, 40-MHz e 80-MHz;

20. Deve suportar Space-time block coding (STBC) para aumentar o alcance e
melhorar a recepção;

21. Deve suportar verificação de paridade de baixa densidade (LDPC) para correção
de erros de alta eficiência e aumento da taxa de transferência;

22. Deve suportar Transmit beam-forming (TxBF);

23. Deve possuir, no mínimo, as seguintes taxas de dados suportadas (Mbps):

a. 802.11b: 1, 2, 5.5, 11

b. 802.11a/g: 6, 9, 12, 18, 24, 36, 48, 54

c. 802.11n: 6.5 até 450 (MCS0 até MCS23)

d. 802.11ac: 6.5 até 1,733 (MCS0 até MCS9, NSS = 1 até 4)

24. Deve possuir suporte a 802.11n de alto rendimento (HT): HT 20/40;

25. Deve possuir suporte a 802.11ac de alta velocidade (VHT): VHT 20/40/80;

26. Deve possuir suporte a agregação de pacotes 802.11n/ac: A-MPDU, A-MSDU;

 

Gerenciamento

27. Deve implementar funcionamento de modo auto gerenciado, sem necessidade de
controladora WLAN para configuração de seus parâmetros de rede wireless,
gerenciamento das políticas de segurança, QoS e monitoramento de RF.

28. Deve obedecer a todas as características descritas mesmo neste modo de
funcionamento;

29. No modo de funcionamento autogerenciado deve disponibilizar na interface
gráfica informações de usuários conectados, qualidade de sinal e trafego de
dados na rede;

30. O ponto de acesso deve permitir a conversão de modo auto gerenciado para
modo gerenciado por controlador WLAN através de interface gráfica, em browser
padrão (HTTPS), e permitir que todos os demais pontos de acesso pertencentes
ao mesmo cluster, também sejam convertidos automaticamente;

31. O ponto de acesso deverá suportar conexão direta ou remota com controlador
WLAN, inclusive via roteamento da camada de rede, baseado no modelo OSI;
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32. Se um controlador WLAN falhar, os Pontos de Acesso relacionados deverão se
associar automaticamente a um controlador WLAN alternativo, não permitindo
que a rede wireless se torne inoperante;

33. Implementar mecanismo de funcionamento para trabalhar com controladores
WLAN em redundância;

34. Deve permitir que o ponto de acesso seja atualizado de forma centralizada pela
interface gráfica;

35. Permitir o armazenamento de sua configuração em memória não volátil, podendo,
numa queda e posterior restabelecimento da alimentação, voltar à operação
normalmente na mesma configuração anterior;

36. Deve possuir servidor DHCP interno configurável;

37. Possibilitar backup e restore da configuração através da interface gráfica;

38. Deve possuir Portal Captivo (Captive Portal) integrado para utilização em rede de
visitantes;

39. Deve possuir mecanismos para proteção contra Pontos de Acesso não
autorizados (Rogues);

40. Possuir capacidade de identificação e listagem dos rádios vizinhos e respectivos
SSID/BSSID;

41. Implementar associação dinâmica de usuários à VLANs com base nos parâmetros
da etapa de autenticação;

42. Deve possuir uma base de usuários interna que diferencie usuários visitantes de
funcionários, para ser usada em autenticação 802.1x ou portal captivo;

43. Permitir a autenticação para acesso dos usuários conectados nas redes WLAN
(Wireless) através:

a. MAC Address

b. 802.1x em base Local

c. Captive Portal

d. 802.1x em base externa RADIUS

e. 802.1x em base externa LDAP

44. Deve permitir a seleção/uso de servidor de autenticação específico com base no
SSID;

45. Implementar o protocolo de enlace CSMA/CA para acesso ao meio de transmissão;

46. Possuir capacidade de selecionar automaticamente o canal de transmissão;

47. Permitir o ajuste dinâmico de nível de potência e canal de rádio de modo a otimizar
o tamanho da célula de RF;

48. Permitir habilitar e desabilitar a divulgação do SSID;

49. Implementar diferentes tipos de combinações encriptação/autenticação por SSID;

50. Implementar padrão WMM da Wi-Fi Alliance para priorização de tráfego,
suportando aplicações em tempo real, tais como, VoIP, vídeo, dentre outras;

51. Não deve haver no licenciamento restrições com relação ao número de
dispositivos conectados por ponto de acesso;

52. Implementar a pilha de protocolos TCP/IP com suporte a IPV4 e IPV6 (Bridging);

53. Implementar VLANs conforme padrão IEEE 802.1Q;

54. Possuir, no mínimo, uma interface IEEE 802.3 10/100/1000BaseT Ethernet, auto-
sensing, auto MDI/MDX;

55. Permitir a atualização remota do sistema operacional e arquivos de configuração
através da controladora WLAN

56. Implementar cliente DHCP, para configuração automática de rede;

57. Deve configurar-se automaticamente ao ser conectado na rede;

58. Possuir LED’s indicativos do estado de operação, da atividade do rádio e da
interface Ethernet;

59. Possuir estrutura que permita fixação do equipamento em teto e parede e
fornecer acessórios para que possa ser feita a fixação;

60. Deve ser acompanhado de todos os acessórios necessários para
operacionalização do equipamento, tais como: softwares, cabos de console,
cabos de energia elétrica, documentação técnica e manuais (podendo ser em CD-
ROM) que contenham informações suficientes para possibilitar a instalação,
configuração e operacionalização do equipamento;

61. Permitir o bloqueio da configuração do Ponto de Acesso via rede wireless;

62. Implementar varredura de RF nas bandas 802.11a, 802.11b, 802.11g, 802.11n,
para identificação de Pontos de Acesso intrusos não autorizados (rogues) e
interferências no canal habilitado ao ponto de acesso e nos demais canais
configurados na rede WLAN, sem impacto no seu desempenho;
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63. Implementar IEEE 802.1x, com pelo menos os seguintes métodos EAP:

a. EAP- MD5

b. EAP-FAST

c. EAP-TLS

d. PEAP-GTC

e. PEAP-MSCHAPv2

64. Permitir a integração com RADIUS Server com suporte aos métodos EAP citados;

65. A comunicação entre todos os pontos de acesso sem fio e a controladora deverá
ser criptografada;

66. Suportar a autenticação com geração dinâmica de chaves criptográficas por
sessão e por usuário;

67. Implementar WPA com algoritmo de criptografia TKIP e MIC;

68. Implementar WPA2 com algoritmo de criptografia AES, 128/256 bits, IEEE 802.11i;

69. Deve possuir modo dedicado de funcionamento de análise de espectro das faixas
de frequência de 2.4 e 5 GHz identificando fontes de interferência nessas faixas;

70. Deve possibilitar analise de espectro nos canais em que estiver provendo acesso,
sem desconectar os usuários;

71. Deve disponibilizar informações gráficas de análise de espectro em conjunto com
o controlador WLAN;

72. O equipamento deverá possuir registro na ANATEL e deverá ser apresentado na
entrega do equipamento;

73. Deverá prover priorização de trafego de vídeo e voz através de parâmetros de
QoS (Quality os Service) com possibilidade de aplicar por SSID e dispositivo;

74. Possibilitar roaming na rede wireless;

75. Suportar a criação de uma rede de convidados autocontida com isolamento de
tráfego entre clientes e serviços locais;

76. Possuir recursos de seleção automática de canal de transmissão procurando por
canais onde haja menor interferência, tendo por objetivo melhorar a performance
da rede wireless;

77. Permitir a operação em estrutura Mesh viabilizando a comunicação direta entre
diferentes Pontos de Acesso sem Fio onde não seja possível estender a rede
cabeada;

78. Operando em estrutura Mesh, a comunicação entre os dispositivos estrutura
deverão operar na frequência de 5Ghz.

79. Possuir mecanismo para a restauração das configurações originais de fábrica
fisicamente no equipamento (reset);

80. Suportar operação em humidade de 5% a 95% sem condensação;

81. Suportar operação em temperatura de até 40°C (quarenta graus centígrados);

82. Possuir um MTBF (Mean Time Between Failure - Período Médio entre Falhas) de, no
mínimo, 250.000 horas.

 

Garantia e Suporte

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-
site pelo período mínimo de 60 (sessenta) meses para reposição de peças, mão
de obra e atendimento. O prazo máximo para atendimento do chamado deve ser
de até o próximo dia útil após a sua abertura. Durante o período da garantia o
prazo máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis.

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(“part number”), incorporada à solução.

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para
suporte técnico online como “chat” e “e-mail” em seu site da internet com
disponibilidade ainda de área para cadastro da solução de hardware ofertada,
possibilitando assim que a CONTRATANTE possa receber de forma proativa,
durante todo período da garantia as notificações de atualizações e correções
(“hotfix”) da solução;

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo
0800 para suporte técnico e abertura de chamados técnicos.

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e
solução exigidos para os equipamentos, deverá ser comprovada a existência da
assistência técnica local no domicílio da contratante e na modalidade on-site,
devendo essa ser realizada por meio de documentação oficial do fabricante dos
produtos e de domínio público, através de catálogos, folder impressos ou da
internet, devendo constar o endereço URL na mesma. Caso não seja comprovada
por um dos meios citados anteriormente, será possível a comprovação através da
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apresentação de documentação expressa do fabricante dos equipamentos,
indicando a referida assistência técnica que será responsável pelo atendimento e
manutenção durante o período de garantia dos produtos ofertados. Em caso de
documentação expressa do fabricante a esta deverá ser anexada uma
procuração que comprove que a fabricante outorga ao procurador os poderes
para firmar e declarar as exigências solicitadas.

6.  Todos os componentes instalados ou integrados dos equipamentos devem ser
do próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada.

 

ITEM 09 – INJETOR POE PARA PONTOS DE ACESSO
TIPO 1
Características técnicas mínimas

1. Deve ser do mesmo fabricante dos Pontos de acesso ou homologado e
certificado pelo mesmo para utilização em seus equipamentos;

2. Injetor PoE 802.3af 10/100/1000 Ethernet com 15.4W;

 

Garantia e Suporte

1. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de
peças, mão de obra e atendimento no local. O período da garantia o prazo
máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis;

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(part number), incorporado ao equipamento;

3. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do
próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada.

 

ITEM 10 – INJETOR POE PARA PONTOS DE ACESSO
TIPO 2
Características técnicas mínimas

1. Deve ser do mesmo fabricante dos Pontos de acesso ou homologado e
certificado pelo mesmo para utilização em seus equipamentos;

2. Injetor PoE+ 802.3at 10/100/1000 Ethernet com 30W;

 

Garantia e Suporte

1. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de
peças, mão de obra e atendimento no local. O período da garantia o prazo
máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis;

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente
deverá informar em sua proposta o código de serviço de garantia do fabricante
(part number), incorporado ao equipamento;

3. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do
próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção técnica
pelo próprio fabricante quando solicitada.

 

ITEM 11 – SERVIÇOS DE IMPLANTAÇÃO E
TRANSFERÊNCIA DE TECNOLOGIA PARA SOLUÇÃO
DE GERENCIAMENTO
Características Gerais

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das
14:00 às 18:00) presencialmente no TRE-AL ou remotamente conforme
necessidades da CONTRATANTE;

 

Implantação
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2. Instalação e configuração de 1 (uma) instância do serviço de gerenciamento de
rede, contemplando:

a. Configurações básicas para acesso à rede, dimensionamento e configuração de
armazenamento;

b. Inclusão de no mínimo 10 (dez) pontos de acesso no monitoramento;

c. Criação de modelo de configuração (templates) de forma a possibilitar a replicação
de configuração entre equipamentos.

 

Transferência De Tecnologia

3. O treinamento deverá ser no realizado na modalidade workshop com tarefas
práticas hands-on, visando assim a melhor fixação dos temas abordados com
foco direto na explicação da tecnologia da solução como também nas rotinas de
configuração, gerenciamento, administração e operação da mesma;

 

4. O treinamento do MÓDULO DE GERENCIA DE REDE deverá ter duração mínima
de 24 (vinte e quatro) horas onde será abordado, no mínimo, os seguintes
tópicos:

a. Inserção, modificação e remoção de dispositivos de forma unitária e em lote;

b. Configuração de VLANs Globais e Locais em switchs gerenciados;

c. Configuração de ACLS Globais e Locais em switchs gerenciados;

d. Backup e restore de configuração de switchs gerenciados;

e. Monitoramento e alarmes default e customizados;

f. Customização do Dashboard com alertas, mapas de topologia e monitoramento
de dispositivos;

 

ITEM 12 - SERVIÇOS DE IMPLANTAÇÃO E
TRANSFERÊNCIA DE TECNOLOGIA DO MÓDULO DE
CONTROLE DE ACESSO
Características Gerais

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das
14:00 às 18:00) presencialmente no TRE-AL ou remotamente conforme
necessidades da CONTRATANTE;

 

Implantação

2. Instalação e configuração de 1 (uma) instancia do serviço controle de acesso,
contemplando:

a. Configurações básicas para acesso à rede, dimensionamento e configuração de
armazenamento;

b. Configuração de autenticação em Active Directory para usuários corporativos;

c. Configuração de autenticação de visitantes com portal de autosserviço para
criação de usuários;

d. Configuração de no mínimo 5 (cinco) dispositivos de rede para autenticação na
solução.

 

Transferência de Tecnologia

3. O treinamento deverá ser no realizado na modalidade workshop com tarefas
práticas hands-on, visando assim a melhor fixação dos temas abordados com
foco direto na explicação da tecnologia da solução como também nas rotinas de
configuração, gerenciamento, administração e operação da mesma devendo ter
duração mínima de 24 (vinte e quatro) horas onde será abordado no mínimo os
seguintes tópicos:

a. Configuração de Active Directory como base de autenticação;

b. Configuração de autenticação de usuários corporativos;

c. Configuração de autenticação de usuários visitantes;

d. Configuração de portal de autosserviço;

e. Configuração de autenticação e autorização com protocolo RADIUS.

ITEM 13 – SERVIÇOS DE IMPLANTAÇÃO E
TRANSFERÊNCIA DE TECNOLOGIA PARA
CONTROLADORA WLAN E PONTOS DE ACESSO
 

Termo de Referência - TIC 24 (0541748)         SEI 0008478-63.2018.6.02.8000 / pg. 298



Características Gerais

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das
14:00 às 18:00) presencialmente no TRE-AL ou remotamente conforme
necessidades da CONTRATANTE;

 

Implantação

2. Instalação e configuração de no mínimo 10 (dez) pontos de acesso,
contemplando:

a. Configuração básica de acesso a gerência via rede;

b. Configuração de gerência e monitoramento em MÓDULO DE GERENCIA DE
REDE;

c. Configuração da autenticação de usuários em MÓDULO DE CONTROLE DE
ACESSO

d. Configuração de pontos de acesso em controladora WLAN habilitando
gerenciamento centralizado;

 

Transferência de Tecnologia

3. O treinamento deverá ser no realizado na modalidade workshop com tarefas
práticas hands-on, visando assim a melhor fixação dos temas abordados com
foco direto na explicação da tecnologia dos produtos ofertados como também
nas rotinas de configuração, gerenciamento, administração e operação dos
mesmos devendo ter duração mínima de 16 (Dezesseis) horas onde será
abordado no mínimo os seguintes tópicos:

a. Configuração inicial e acesso a gerência;

b. Configuração de Clusters;

c. Configuração de autenticação de usuários em MÓDULO DE CONTROLE DE
ACESSO;

d. Criação de SSID com autenticação PSK;

e. Criação de SSID com autenticação enterprise em MÓDULO DE CONTROLE DE
ACESSO;

f. Configuração de pontos de acesso para MÓDULO DE GERENCIA DE REDE;

g. Configuração pontos de acesso para MÓDULO DE ANÁLISE DE TRÁFEGO;

 

ITEM 14 – TREINAMENTO BÁSICO DE
ADMINISTRAÇÃO DE ARQUITETURA WLAN
 

Características Gerais

7. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do
fabricante no Treinamento Básico De Administração De Arquitetura Wlan para 01
(um) profissional da contratante;

8. O voucher deverá ter validade de pelo menos 12 (doze) meses;

9. O treinamento deverá ser de acordo com o calendário de treinamento do
fabricante e ministrado em centro oficial de treinamento do mesmo ou
remotamente, utilizando tecnologia de ensino a distância;

10. Deverá ser ministrado por profissional devidamente credenciado junto ao
fabricante e apto a entregar o respectivo;

11. O treinamento deverá compreender a explicação da tecnologia da solução como
também das rotinas de configuração, gerenciamento, administração e operação
da mesma;

12. O treinamento deverá ter carga horária mínima de 20 (vinte) horas, ministrado no
período de 08:00 às 12:00 e das 14:00 às 18:00.

 

ITEM 15 – TREINAMENTO BÁSICO DA SOLUÇÃO DE
GERENCIAMENTO
 

Características Gerais

1. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do
fabricante no Treinamento da Solução de Gerenciamento para 01 (um) profissional
da contratante;

2. O voucher deverá ter validade de pelo menos 12 (doze) meses;

Termo de Referência - TIC 24 (0541748)         SEI 0008478-63.2018.6.02.8000 / pg. 299



3. O treinamento deverá ser de acordo com o calendário de treinamento do
fabricante e ministrado em centro oficial de treinamento do mesmo ou
remotamente, utilizando tecnologia de ensino a distância;

4. Deverá ser ministrado por profissional devidamente credenciado junto ao
fabricante e apto a entregar o respectivo;

5. O treinamento deverá compreender a explicação da tecnologia da solução como
também das rotinas de configuração, gerenciamento, administração e operação
da mesma;

6. O treinamento deverá ter carga horária mínima de 40 (Quarenta) horas,
ministrado no período de 08:00 às 12:00 e das 14:00 às 18:00.

 

ITEM 16 – TREINAMENTO BÁSICO DA SOLUÇÃO DE
CONTROLE DE ACESSO
 

Características Gerais

7. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do
fabricante no Treinamento da Solução de Controle de Acesso  para 01 (um)
profissional da contratante;

8. O voucher deverá ter validade de pelo menos 12 (doze) meses;

9. O treinamento deverá ser de acordo com o calendário de treinamento do
fabricante e ministrado em centro oficial de treinamento do mesmo ou
remotamente, utilizando tecnologia de ensino a distância;

10. Deverá ser ministrado por profissional devidamente credenciado junto ao
fabricante e apto a entregar o respectivo;

11. O treinamento deverá compreender a explicação da tecnologia da solução como
também das rotinas de configuração, gerenciamento, administração e operação
da mesma;

12. O treinamento deverá ter carga horária mínima de 40 (Quarenta) horas,
ministrado no período de 08:00 às 12:00 e das 14:00 às 18:00.

3.2 Forma de Execução e de Gestão do Contrato (Art. 18, § 3º, III, a)
A execução do objeto pressupõe a existência dos seguintes

papéis e responsabilidades (Art. 18, § 3º, III, a, 1):

1. Patrocinador da Contratação: é o titular da área demandante, responsável por
representar os interesses do órgão no contexto da Contratação, pela aprovação
da necessidade e, por fim, pela negociação das ações necessárias para que os
objetivos sejam alcançados;

2. Gestor do Contrato (art. 3º, IV, da Resolução TRE/AL nº 15.787/2017): servidor
designado para coordenar e comandar o processo da fiscalização da execução
contratual. Na forma do Art. 17 da mesma Resolução, o gestor do contrato
responsabiliza-se pela condução da gestão e fiscalização do contrato, nos termos
do Art. 67, da Lei nº 8.666/93.

3. Fiscal do Contrato (art. 3º, VI, da Resolução TRE/AL nº 15.787/2017): servidor
designado para auxiliar o gestor do contrato quanto à fiscalização do objeto do
contrato. Neste sentido, indicado pela respectiva autoridade competente para
fiscalizar o Contrato quanto aos aspectos técnicos da solução.

Dinâmica da Execução (Art. 18, § 3º, III, a, 2):

1. Os equipamentos deverão ser entregues no Almoxarifado do TRE/AL, nos
quantitativos indicados no pedido de fornecimento;

2. A garantia dos equipamentos deve obedecer o detalhamento técnico feito e terá
seu tempo contado por cada fornecimento individualmente;

3. Entende-se como garantia aquela prestada pelo próprio fabricante ou por rede
credenciada pelo fabricante do(s) referido(s) equipamento(s);

4. O pagamento será realizado individualmente para cada nota fiscal apresentada,
após emissão do aceite definitivo pela unidade competente do TRE/AL;

5. Os equipamentos deverão ser novos, não recondicionados, de primeiro uso e não
deverão conter marcas, amassados, arranhões ou outros problemas e, ainda,
serem entregues em pleno estado de funcionamento;

6. Os equipamentos deverão atender rigorosamente a todas as especificações
técnicas contidas neste Termo de Referência e em seus Anexos;

7. Os equipamentos deverão vir acompanhados de todos os acessórios necessários
para o seu pleno estado de funcionamento, como cabos, drivers, mídias e outros,
os quais só serão recebidos juntamente com os respectivos equipamentos. Este
item se aplica tanto para a entrega dos equipamentos quanto para substituições
durante o período de garantia;

8. Ao TRE é reservado o direito de efetuar conexões dos equipamentos a outros,
bem como adicionar demais acessórios compatíveis tecnicamente, sem que isso
constitua motivo para a Contratada se desobrigar da garantia, desde que tal fato
não implique danos materiais ou técnicos aos equipamentos e acessórios,
hipótese que deverá ser devidamente comprovada;

9.  Ao TRE/AL é reservado o direito de efetuar diligência, a qualquer tempo, quanto
aos documentos exigidos neste Termo de Referência e em seus Anexos.

Recebimento do Objeto:

1. O Tribunal designará Comissão para realizar o recebimento provisório, que só será
emitido se os equipamentos estiverem de acordo com as especificações técnicas;

2. Após a entrega, os equipamentos serão submetidos à avaliação e homologação
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pelos responsáveis técnicos do Tribunal;
3.  O exame para comprovação das características técnicas consistirá em avaliações

e testes não-destrutivos, por amostragem realizados em duas etapas:
a. Primeira: inspeção visual de todos os equipamentos entregues;
b. Segunda: testes funcionais de configuração e desempenho, em, no mínimo,

10% (dez por cento) e não menos do que 01 (um) dos equipamentos
recebidos. O Tribunal poderá, a seu critério, executar os testes nos demais
equipamentos, dentro de um critério de razoabilidade, podendo chegar
a 100% dos quantitativos, mas dentro de um prazo máximo de 30 (trinta)
dias corridos e contados de cada lote de equipamentos.

4. As especificações serão avaliadas também por meio de documentos técnicos que
acompanham os equipamentos, informações fornecidas pela Contratada e
disponível no sítio do fabricante.

5. A comissão do Tribunal deverá, após a comprovação do perfeito funcionamento
dos equipamentos e adequação às especificações técnicas, emitir e assinar o
Termo de Recebimento Definitivo.

Instrumentos Formais de Solicitação do(s) Bens e/ou
Serviço(s) (Art. 18, § 3º, III, a, 3):

1. A Ordem de Fornecimento será o instrumento formal de solicitação dos bens
pertencentes ao escopo desta contratação.

Forma de Pagamento (Art. 18, § 3º, III, a, 7)

1. O pagamento será efetuado mediante crédito em conta-corrente do Fornecedor,
por ordem bancária, no prazo disposto nos artigos 5º, § 3º, ou 40, XIV, “a”, da
Lei n. 8.666/93, conforme o caso, quando mantidas as mesmas condições iniciais
de habilitação e cumpridos os seguintes  requisitos:

a. Apresentação de nota fiscal de acordo com a legislação vigente à época da
emissão (nota fiscaleletrônica, se for o caso), acompanhada da
Certidão Negativa de Débito – CND, comprovando regularidade com o INSS;
do Certificado de Regularidade do FGTS – CRF, comprovando regularidade
com o FGTS; da Certidão Conjunta Negativa de Débitos Relativos a Tributos
Federais e à Dívida Ativa da União, expedida pela Secretaria da Receita
Federal; e da Certidão Negativa de Débitos Trabalhistas – CNDT, emitida pela
Justiça do Trabalho; e  da prova de regularidade para com as Fazendas
Estadual e Municipal do domicílio ou sede do Fornecedor; e

b. Inexistência de fato impeditivo para o qual tenha concorrido o Fornecedor.
2. Nenhum pagamento será efetuado à Contratada enquanto pendente de liquidação

qualquer obrigação. Esse fato não será gerador de direito a reajustamento de
preços ou a atualização monetária.

Direitos de Propriedade Intelectual (Art. 18, § 3º, III, a, 9):

1. Esse requisito não se aplica ao contexto desta contratação, uma vez que o objeto
se refere ao fornecimento de equipamentos, cujos direitos autorais do fabricante
são resguardados por legislação nacional e internacional.

Penalidades (Art. 18, § 3º, III, a, 11):

1. Com fundamento no artigo 7º da Lei nº 10.520/2002 e, subsidiariamente, nos
artigos 86 e 87 da Lei 8.666/1993, a Contratada ficará sujeita, assegurada prévia e
ampla defesa, às seguintes penalidades:

a. Advertência:
i. A Contratada será notificada formalmente em caso de descumprimento

de obrigação contratual e terá que apresentar as devidas justificativas
em um prazo de até 5 (cinco) dias úteis após o recebimento da
notificação; e

ii. Caso não haja manifestação dentro desse prazo ou se entenda serem
improcedentes as justificativas apresentadas, a Contratada será
advertida;

b. Multa de:
i. 0,5% por dia, sobre o valor constante da Ordem de Fornecimento, no

caso de atraso injustificado na entrega dos equipamentos, limitada a
incidência a 20 (vinte) dias corridos;

1. No caso de atraso injustificado na entrega dos equipamentos por prazo superior
a 20 (vinte) dias corridos, com
a aceitação pela Administração, será aplicada a multa de
10% sobre o valor da Ordem de Fornecimento; e

2. No caso de atraso injustificado na entrega dos equipamentos por prazo superior
a 20 (vinte) dias corridos, com a
não aceitação pela Administração, será aplicada a penalidade 20%
sobre o valor da Ordem de Fornecimento, no caso de inexecução
total da obrigação, podendo haver, ainda, o cancelamento do
registro de preços do Fornecedor;

ii.  0,5% por dia, sobre o valor do equipamento,
no caso de atraso injustificado na solução do chamado de garantia, limitada a incidência 30
(trinta) dias corridos;

1. No caso de atraso injustificado na solução do chamado de garantia por prazo superior
a 30 (trinta) dias corridos, aplica-se adicionalmente, a multa de
1% sobre o valor da Ordem de Fornecimento; e

2. A multa por atraso relacionada ao item
anterior será auferida por Ordem de Fornecimento e aplicada somente uma única vez a
cada mês, independente da quantidade de equipamentos sem
solução.

iii. 10% sobre o valor constante da Ordem de Fornecimento, no caso de
inexecução parcial da obrigação assumida;

iv. 20% sobre o valor da Ordem de Fornecimento, no caso de inexecução
total da obrigação, podendo haver, ainda, o cancelamento do registro
de preços do Fornecedor;

v. 10% sobre o valor global estimado da Ata de Ata de Registro de Preços,
na hipótese de recusa em assinar a Ata ou o instrumento do contrato,
ou retirar a Ordem de Fornecimento.
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c. Impedimento de licitar e contratar com a União e descredenciamento do
SICAF pelo prazo de até 5 (cinco) anos, sem prejuízo das demais penalidades
legais; e

d. Declaração de inidoneidade para licitar ou contratar com a Administração
Pública.

2. O cometimento reiterado de atrasos injustificados dos prazos previstos para
entrega/solução do chamado de garantia dos equipamentos poderá resultar no
cancelamento do registro de preços com a Contratada.

3. As sanções previstas nos itens "1.a", “1.c” e “1.d” do item 1 poderão ser
aplicadas, cumulativamente ou não, à pena de multa.

4. O valor da multa, aplicada após o regular processo administrativo, será
descontado de pagamentos eventualmente devidos à contratada ou cobrado
judicialmente;

5. Excepcionalmente, ad cautelam, a Administração poderá efetuar a retenção do
valor presumido da multa, antes da instauração do regular procedimento
administrativo.
.
 

4. Requisitos Técnicos (Art. 18, § 3º, IV)
 
Garantia mínima de 36  (trinta e seis) meses.
Estar comprovadamente ainda em produção.
Conformidade com o presente Termo de Referência.

5. Modelos (templates) propostos a serem utilizados na contratação
(Art. 18, § 3º, III, V)

Memorando nº ____ / 20__ - TRE-AL/_______________________

Maceió, ___ de ___________ de _____________.

Para: SGO-COFIN

Assunto: Autorização de Emissão de Nota de Empenho.

PA _________________________

Adesão à Ata de Registro de Preços ______________

Ordem de Fornecimento nº _____/_________.

 

Senhor Chefe

Encaminhamos estes autos para emissão de Nota de Empenho, em favor
da Empresa ________________. CNPJ: xx.xxx.xxx/xxxx-xx, conforme tabela
abaixo, tudo em conformidade com o disposto na Resolução TRE-AL nº 12.738/1996
(0216181).

Certidões: SICAF evennto: ______ / RECEITA ESTADUAL evento: ______ / SIMPLES
NACIONAL (se aderente) evento: __________

Item:
Descrição:
Quant. total
da ATA

Quant.
Recebida

Quant. desta
Ordem

Saldo no
Fornecedor

Valor
Unitário

Valor Total
(R$)

      

 

*  Solicitamos utilizar a reserva de crédito do PE XXX/XXXX

 

 

Gestor da Ata - Portaria TRE/AL nº XX/XXXX

 

Moodelo a ser adotado em decorrência do comando inserto no Proc SEI nº 0005423-
07.2018.6.02.8000, evento 0442132: modelo de referência indicado: 0452895.

Maceió, 15 de maio de 2019.

Documento assinado eletronicamente por DANIEL MACÊDO DE CARVALHO SOUTO,
Coordenador, em 15/05/2019, às 13:36, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0541748 e o código CRC 1BA26998.

0008478-63.2018.6.02.8000 0541748v6
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 15 de maio de 2019.
À SEIC
 
Sr. Chefe, 
 
Para pronunciamento quanto ao solicitado pelo

Despacho SEIC 0538467.
 

Atenciosamente.

Documento assinado eletronicamente por DANIEL MACÊDO DE CARVALHO SOUTO,
Coordenador, em 16/05/2019, às 13:57, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0541761 e o código CRC 19686D10.

0008478-63.2018.6.02.8000 0541761v1
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 15 de maio de 2019.
À SEIC
 
Sr. Chefe,
 
Quanto à análise da Ata nº 47/2018 da UFPI, doc.

0538465, observa-se as seguintes similaridades:
 

Item da ARP 47/2018 da UFPI - Ata da empresa Approach
Tecnologia

Termo de Referência Networking -
TRE/AL

Item 01 Lote 01 - Item 02

Item 04 Lote 01 - Item 05

Item 08 Lote 01 - Item 09

Item 09 Lote 01 - Item 08

Item 12 Lote 01 - Item 10

Item 14 Lote 01 - Item 12

Item 16 Lote 01 - Item 15

Item 18 Lote 01 - Item 18

Item 19 Lote 01 - Item 19

 
Quanto à análise da Ata nº 15/2018 da UNIFAP,

doc. 0538466, observa-se as seguintes similaridades:
 

Item da ARP 15/2018 da UNIFAP - Ata da empresa Approach
Tecnologia

Termo de Referência Networking -
TRE/AL

Item 01 Lote 02 - Item 08

Item 03
Lote 02 - Item 09
Lote 02 - Item 10
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Atenciosamente.

Documento assinado eletronicamente por CRISTINO HERMANO DE BULHÕES, Chefe
de Seção, em 15/05/2019, às 14:46, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0541826 e o código CRC E5B88402.

0008478-63.2018.6.02.8000 0541826v1
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De: Felipe Moyses Vieira <felipe.vieira@ish.com.br>
Para: TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-al.jus.br>
Data: 04/06/2019 04:24 PM
Assunto: [seic] RES: Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL

Prezada Ana Paula / Márcia,

Segue proposta que atende ao Lote II deste Termo de Referência.

Dúvidas, estamos à disposição.

Att:

Felipe Moyses Vieira
Executivo de Negócios ES
ISH Tecnologia S.A.
Tel.: +55 27 3334.8920 | Cel.: +55 27 98138.5788
www.ish.com.br

-----Mensagem original-----
De: TRE-AL/SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES <seic@tre-al.jus.br>
Enviada em: quarta-feira, 24 de abril de 2019 15:10
Para: Felipe Moyses Vieira <felipe.vieira@ish.com.br>
Assunto: Solicitação. Cotação. Aquisição de componentes de rede sem fio e cabeada. TREAL

Prezado Felipe,

Boa tarde,

Segue arquivo em PDF.

O Tribunal Regional Eleitoral de Alagoas pretende adquirir componentes de rede sem fio e cabeada,
mediante  sistema de registro de preços, distribuídos em lote 01 e lote 02, conforme descrição do
produto/serviço, quantitativos e demais especificações constantes do termo de referência em anexo.

Na impossibilidade de fornecer cotação, favor mencionar por e-mail.

Atenciosamente.

Ana Paula Gomes Silva
Seção de Instrução de Contratações (SEIC) - TRE/AL seic@tre-al.jus.br anasilva@tre-al.jus.br

Horário Expediente: Segunda-feira a Quinta-feira: 13h às 19h. Sexta-feira: 07:30 às 13:30h.
Tribunal Regional Eleitoral de Alagoas - TRE/AL.
Avenida Aristeu de Andrade, 377 - Farol. CEP 57.051-090 - Maceió - AL CNPJ nº: 06.015.041/0001-38
Telefones: 82 2122-7712/7711

Aviso de Confidencialidade: Esta comunicação deve ser lida apenas pelo seu destinatário e não pode
ser retransmitida sem autorização formal. Caso seja recebida indevidamente, por favor destrua-a.
Qualquer reprodução, alteração, distribuição e/ou publicação é estritamente proibida.

Notice of Confidentiality: This document should only be read by those persons to whom it is addressed
and can not be relayed without formal permission. If you have received this e-mail message in error,
please destroy it. Any form of reproduction, modification, distribution and/or publication of this
e-mail message is strictly prohibited.

Anexados:

Arquivo: P2019060400-TREAL-REDE-ARUBA.pdf Tamanho: 766k Tipo de Conteúdo: application/pdf

https://webmail.tre-al.gov.br:3001/WorldClient.dll?Session=VF82D...

1 of 1 05/06/2019 13:39
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PROPOSTA COMERCIAL 
Fornecimento de Ativos de Rede  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

ISH TECNOLOGIA S/A 
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Ao: 
TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS – TRE-AL 
 
Ref.: 
Proposta Comercial de acordo com .o Termo de Referencia TIC nº 20 / 2018, apresentado 
por este TRE-AL 
 
Empresa proponente: 
ISH TECNOLOGIA S/A. 
Matriz: Rua Judith Maria Tovar Varejão, 355 
Enseada do Suá – Vitória – ES - CEP 29050-360. 
CNPJ: 01.707.536/0001-04. 
Tel.: 55 27 3334 8900. 
Fax: 55 27 3334 8905. 
 
 
Prezada Seção de Instrução de Contratações (SEIC), 
 
 
A ISH Tecnologia, empresa especializada em soluções de datacenter, segurança, 
infraestrutura de tecnologia da informação, apresenta sua proposta técnica para prestação 
de serviços especializados de fornecimento de Soluçao de Infraestrutura, conforme 
especificado no Termo de Referencia – Lote II.  
 
As informações, requisitos e exigências apresentadas no pedido formal de proposta do 
CLIENTE foram cuidadosamente analisados pela ISH Tecnologia, de forma a obter-se o 
melhor entendimento possível das necessidades em questão visando à oferta de serviços de 
excelente qualidade e que atendam às expectativas e objetivos estratégicos do TRE-AL.  
 
Agradecemos esta oportunidade e nos colocamos a disposição para contribuir de forma 
plena com os objetivos e metas do TRE-AL. Da mesma maneira, estamos a disposição para 
sanar quaisquer dúvidas decorrentes desta, ou em relação aos demais serviços oferecidos 
em nossas áreas de atuação que também podem ser obtidas por meio de nosso endereço 
virtual http://www.ish.com.br. 
 

 
Atenciosamente, 

 
 

FELIPE MOYSES VIEIRA  
Executivo de Contas 
ISH Tecnologia S/A 

felipe.vieira@ish.com.br 
Tel: (27) 98138-5788 
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1. Identificação deste documento 

Número P2019060400_TRE-AL_REDE_ARUBA 

Titulo Fornecimento de Ativos de Rede – Aruba – Lote II 

Destinatário 

Ana Paula Gomes Silva 

Seção de Instrução de Contratações (SEIC) 

Tel.: 82 2122-7712/7711 

Partes 

TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS - TRE/AL. 

Designado, simplesmente, CLIENTE ou CONTRATANTE, se 
houver aceitação da proposta. 

A ISH TECNOLOGIA S/A 

Designado, simplesmente, PROPONENTE, ISH ou 
CONTRATADA, se houver aceitação da proposta. 

Responsáveis 
Técnicos 

Marcelo Araujo    
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2. A ISH Tecnologia 

Fundada em 1996, a ISH Tecnologia é uma empresa 100% brasileira que fornece 

soluções de Datacenter, Segurança da Informação e Infraestrutura de TI, atuando em 

todo o mercado nacional e na América Latina. A ISH conta com matriz, filiais e escritórios 

em Vitória/ES, São Paulo/SP, Brasília/DF, Belo Horizonte/MG e Rio de Janeiro/RJ. 

Na década de 90 a internet ainda não era bem a internet como a vemos hoje, foi neste 

período que Al Gore cunhou um termo que descreveria o que estava por vir, algo como 

“uma rede de comunicação global de alta velocidade, por onde passariam dados, voz, 

vídeo e outras formas de informações por todo o mundo”. Para essa visão de rede ele 

deu o nome de Information Superhighway ou Super Rodovia da Informação.  

O significado da sigla “ISH” vem dessa expressão, Information Superhighway, pois 

vivíamos nesse ambiente de tecnologia e já nessa época estávamos estruturando e 

implantando, ou seria “pavimentando”, arrojados projetos de infraestrutura e de 

segurança para essa “super rodovia”, inicialmente no Espírito Santo, depois em todos 

os estados brasileiros e América Latina. 

A ISH ampliou seus horizontes executando projetos em todas as unidades da federação 

e em vários países de América Latina, conquistando um amplo portfolio de clientes, dos 

mais diversos segmentos de negócios, desde empresas multinacionais, 

governamentais, bancos, indústria e comércio, firmando parcerias tecnológicas com 

empresas de renome, oferecendo sempre a melhor solução a seus clientes e a evolução 

profissional de seus colaboradores. 

 

2.1. Parcerias 

 
Figura 1 - Parceiros da ISH Tecnologia  
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3. Planilha de Valores 

 
A tabela abaixo corresponde à Planilha de Preços para o Lote 2, conforme Termo de 
Referencia TIC nº 20 / 2018, apresentado por este TRE-AL: 
 

Item Descrição Quant. 
Valor 

Unitário 
Valor Total 

1 
SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE 

ACESSO PARA REDE WIRELESS 
1 

 R$  
111.409,52  

 R$        
111.409,52  

2 SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS 1 
 R$    

29.335,39  
 R$          

29.335,39  

3 
LICENÇAS ADICIONAIS PARA SOLUÇÃO DE 

GERENCIAMENTO DE REDE WIRELESS 
200 

 R$          
497,21  

 R$          
99.442,00  

4 
LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE 

DE PERFIL E CONTROLE DE ACESSO 
2 

 R$    
99.673,86  

 R$        
199.347,72  

5 CONTROLADORA WLAN 4 
 R$      

9.331,44  
 R$          

37.325,76  

6 LICENÇAS ADICIONAIS PARA CONTROLADORA WLAN 200 
 R$                  

-    
 R$                        

-    

7 PONTO DE ACESSO INTERNO TIPO 01 100 
 R$      

3.076,79  
 R$        

307.679,10  

8 PONTO DE ACESSO INTERNO TIPO 02 100 
 R$      

7.791,37  
 R$        

779.137,00  

9 INJETOR POE PARA PONTOS DE ACESSO TIPO 1  100 
 R$          

500,00  
 R$          

50.000,00  

10 INJETOR POE PARA PONTOS DE ACESSO TIPO 2 100 
 R$      

1.500,00  
 R$        

150.000,00  

11 
SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA SOLUÇÃO DE GERENCIAMENTO 1 

 R$    
24.000,00  

 R$          
24.000,00  

12 
SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 

TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO 1 
 R$    

24.000,00  
 R$          

24.000,00  

13 
SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 

TECNOLOGIA PARA PONTOS DE ACESSO 
5 

 R$    
24.000,00  

 R$        
120.000,00  

14 
TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE 

ARQUITETURA WLAN 
4 

 R$    
20.000,00  

 R$          
80.000,00  

15 
TREINAMENTO BÁSICO DA SOLUÇÃO DE 

GERENCIAMENTO 
4 

 R$    
20.000,00  

 R$          
80.000,00  

16 
TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE 

DE 
ACESSO 

4 
 R$    

20.000,00  
 R$          

80.000,00  

          

        

 R$  

2.171.676,49 
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O valor Global da proposta para o Lote II é R$ 2.171.676,49 
  

• Declaramos que estamos de pleno acordo com todas as condições estabelecidas no 

Edital e seus Anexos, bem como aceitamos todas as obrigações e responsabilidades 

especificadas no Termo de Referência. 

 

• Declaramos que nos preços cotados estão incluídas todas as despesas que, direta 

ou indiretamente, fazem parte do presente objeto, tais como gastos da empresa com suporte 

técnico e administrativo, impostos, gastos com transportes, seguros ou quaisquer outros que 

possam incidir sobre os custos dos serviços, sem quaisquer acréscimos em virtude de 

expectativa inflacionária e deduzidos os descontos eventualmente concedidos. 

 

• As condições de pagamento são aquelas estabelecidas no ato convocatório do 

certame em epígrafe; 

 

• Esta proposta é válida por 60 (sessenta) dias, contados da data de sua apresentação. 
 
• Efetuaremos a entrega dos produtos em prazo não superior a 60 (sessenta) dias 
corridos e contados a partir do recebimento da Autorização de Fornecimento ou Instrumento 
de Contrato. 
 
 
 
 
Vitória, 04 de Junho de 2019. 
 
 
 
 
 
 
 
 
 
 
 

Felipe Moyses Vieira 
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 05 de junho de 2019.
À SEIC
 
Sr. Chefe,
 
Com relação ao despacho 0541826, retifico a

informação quanto à correlação dos Itens 18 e 19 da ARP da
UFPI, conforme tabela a seguir:

 

Item da ARP 47/2018 da UFPI - Ata da empresa Approach
Tecnologia

Termo de Referência Networking -
TRE/AL

Item 18 Lote 01 - Item 13

Item 19 Lote 01 - Item 14

 

 
Atenciosamente.

Documento assinado eletronicamente por CRISTINO HERMANO DE BULHÕES,
Analista Judiciário, em 05/06/2019, às 15:16, conforme art. 1º, III, "b", da Lei
11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0551840 e o código CRC 4ABF8431.

0008478-63.2018.6.02.8000 0551840v1
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Planilha1

Página 1

COMAP – COORDENADORIA DE MATERIAIS E PATRIMÔNIO

SEIC – SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES

AQUISIÇÃO DE COMPONENTES DE REDE (NETWORKING) – PA 0008478-63.2018

PREÇOS RECEBIDOS

ITEM QUANTIDADE DESCRIÇÃO DOS PRODUTOS/SERVIÇOS

1 1 R$ 104.180,00 R$ 114.350,25 R$ 104.180,00 R$ 104.180,00

2 3 R$ 16.060,00 R$ 17.767,50 R$ 15.890,00 R$ 15.890,00 R$ 47.670,00

3 2 R$ 12.745,00 R$ 14.549,60 R$ 12.745,00 R$ 25.490,00

4 2 R$ 54.160,00 R$ 54.519,80 R$ 54.160,00 R$ 108.320,00

5 6 R$ 49.117,00 R$ 54.340,00 R$ 74.074,00 R$ 49.117,00 R$ 294.702,00

6 16 MÓDULO COM 4 PORTAS SFP+ PARA SWITCH DE DISTRIBUIÇÃO R$ 4.742,00 R$ 5.239,52 R$ 4.742,00 R$ 75.872,00

7 6
R$ 4.406,00 R$ 4.433,90 R$ 4.406,00 R$ 26.436,00

8 50 SWITCH DE ACESSO L3 COM 48 PORTAS GIGABIT E 4SFP+ R$ 21.468,00 R$ 23.608,00 R$ 14.382,08 R$ 26.015,00 R$ 14.382,08 R$ 719.104,00

9 40 SWITCH DE ACESSO L3 COM 24 PORTAS GIGABIT E 4SFP+ R$ 14.106,00 R$ 16.082,56 R$ 17.650,00 R$ 14.106,00 R$ 564.240,00

10 50 SWITCH DE ACESSO L2 COM 24 PORTAS GIGABIT E 4SFP R$ 4.724,00 R$ 5.565,00 R$ 9.774,14 R$ 4.515,20 R$ 4.515,20 R$ 225.760,00

11 40 SWITCH DE ACESSO L2 COM 48 PORTAS GIGABIT E 4SFP R$ 8.245,00 R$ 9.100,00 R$ 8.245,00 R$ 329.800,00

12 50 GBIC 10GB PARA ATÉ 300M R$ 2.364,00 R$ 2.480,00 R$ 2.064,87 R$ 2.810,00 R$ 2.064,87 R$ 103.243,50

13 30 CABO DAC 10 GBPS DE 1M R$ 600,00 R$ 608,40 R$ 411,00 R$ 411,00 R$ 12.330,00

14 30 CABO DAC 10 GBPS DE 3M R$ 900,00 R$ 939,75 R$ 2.275,85 R$ 584,00 R$ 584,00 R$ 17.520,00

15 10 GBIC 1GB PARA ATÉ 500M R$ 1.200,00 R$ 1.324,96 R$ 740,46 R$ 862,00 R$ 740,46 R$ 7.404,60

16 5 R$ 20.000,00 R$ 22.027,09 R$ 20.000,00 R$ 100.000,00

17 1 R$ 60.000,00 R$ 63.407,80 R$ 60.000,00 R$ 60.000,00

  PROPOSTA  
  PLUGNET     
R$ (0533091)

PROPOSTA 
NEW SUPRI  

R$   
(0535906)

PROPOSTA 
ISH (0551756)

ARP IFES 
30/2018 ISH R$ 

    (0533078)

ARP UFPI 
47/2018 

APPROACH  
R$     

(0538465)

ARP UNIFAP 
15/2018 

APPROACH  
R$     

(0538466)

VALOR UNITÁRIO 
Menor Proposta R$

VALOR TOTAL A 
REGISTRAR R$

SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 
PARA REDE CABEADA

LICENCIAMENTO ADICIONAL PARA SISTEMA DE 
GERENCIAMENTO HPE IMC

LICENCIAMENTO ADICIONAL DO MÓDULO DE ANÁLISE DE 
TRAFEGO DO SISTEMA DE GERENCIAMENTO HPE IMC 

LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE 
PERFIL E CONTROLE DE ACESSO 

SWITCH DE DISTRIBUIÇÃO COM 16 PORTAS SFP+ E SUPORTE A 
MÓDULOS DE EXPANSÃO 

MÓDULO DE STACKING COM 4 PORTAS PARA SWITCH DE 
DISTRIBUIÇÃO 

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA SWITCHS DE REDE 

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO 
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18 4 TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE SWITCHES R$ 28.000,00 R$ 29.795,00 R$ 28.000,00 R$ 112.000,00

19 4 TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE ACESSO R$ 28.000,00 R$ 30.680,00 R$ 28.000,00 R$ 112.000,00

LOTE 02 – SOLUÇÃO DE REDE WIRELESS

ITEM QUANTIDADE DESCRIÇÃO DOS PRODUTOS/SERVIÇOS

1 1 R$ 104.180,00 R$ 111.919,50 R$ 111.409,52 R$ 104.180,00 R$ 104.180,00

2 1 SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS R$ 570,00 R$ 642,60 R$ 29.335,39 R$ 570,00 R$ 570,00

3 200 R$ 570,00 R$ 648,90 R$ 497,21 R$ 497,21 R$ 99.442,00

4 2 R$ 55.000,00 R$ 59.607,60 R$ 99.673,86 R$ 55.000,00 R$ 110.000,00

5 4 CONTROLADORA WLAN R$ 70.000,00 R$ 70.686,00 R$ 9.331,44 R$ 70.000,00 R$ 280.000,00

6 200 LICENÇAS ADICIONAIS PARA CONTROLADORA WLAN R$ 900,00 R$ 948,60 R$ 900,00 R$ 180.000,00

7 100 PONTO DE ACESSO INTERNO TIPO 01 R$ 5.350,00 R$ 5.709,60 R$ 3.076,79 R$ 1.635,17 R$ 3.076,79 R$ 307.679,00

8 100 PONTO DE ACESSO INTERNO TIPO 02 R$ 2.300,00 R$ 2.504,80 R$ 7.791,37 R$ 5.590,28 R$ 3.386,00 R$ 2.300,00 R$ 230.000,00

9 100 INJETOR POE PARA PONTOS DE ACESSO TIPO 1 R$ 700,00 R$ 756,02 R$ 500,00 R$ 500,00 R$ 50.000,00

10 100 INJETOR POE PARA PONTOS DE ACESSO TIPO 2 R$ 550,00 R$ 621,18 R$ 1.500,00 R$ 550,00 R$ 55.000,00

11 1 R$ 25.000,00 R$ 25.589,20 R$ 24.000,00 R$ 24.000,00 R$ 24.000,00

12 1 R$ 60.000,00 R$ 64.632,50 R$ 24.000,00 R$ 24.000,00 R$ 24.000,00

13 5 R$ 20.000,00 R$ 22.428,00 R$ 24.000,00 R$ 20.000,00 R$ 100.000,00

14 4 R$ 20.300,00 R$ 22.627,50 R$ 20.000,00 R$ 20.000,00 R$ 80.000,00

15 4 TREINAMENTO BÁSICO DA SOLUÇÃO DE GERENCIAMENTO R$ 20.300,00 R$ 22.196,50 R$ 20.000,00 R$ 20.000,00 R$ 80.000,00

16 4 TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE ACESSO R$ 28.000,00 R$ 27.948,00 R$ 20.000,00 R$ 20.000,00 R$ 80.000,00

TOTAL  R$ R$ 4.850.943,10
preços discrepantes
menores preços

  PROPOSTA  
  PLUGNET     
R$ (0533091)

PROPOSTA 
NEW SUPRI  

R$   
(0535906)

PROPOSTA 
ISH (0551756)

ARP IFES 
30/2018 ISH R$ 

    (0533078)

ARP UFPI 
47/2018 

APPROACH  
R$     

(0538465)

ARP UNIFAP 
15/2018 

APPROACH  
R$     

(0538466)

VALOR UNITÁRIO 
Menor Proposta R$

VALOR TOTAL A 
REGISTRAR R$

SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 
PARA REDE WIRELESS 

LICENÇAS ADICIONAIS PARA SOLUÇÃO DE GERENCIAMENTO DE 
REDE WIRELESS 

LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE 
PERFIL E CONTROLE DE ACESSO 

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA SOLUÇÃO DE GERENCIAMENTO 

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO 

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA PONTOS DE ACESSO 

TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE ARQUITETURA 
WLAN 
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 05 de junho de 2019.
À COINF,
Encaminhamos Planilha (0552027) preenchida com

os valores das propostas recebidas até o momento dos itens
constantes do TR para Registro de Preços de componentes de
rede - networking (0450416) das empresas Plugnet (0533091),
New Supri (0535906) e ISH (0551756), e ARPs das empresas
ISH (0536380) e Aproach (0538465 e 0538466), após
indicação de equivalência para alguns itens, para análise
desta Coordenadoria quanto à adequação das propostas e
possibilidade da estimativa pelos menores preços e, se for o
caso, indicação do quantitativo mínimo previsto para
aquisição no presente exercício.

Atenciosamente,

Documento assinado eletronicamente por MARIA MÁRCIA LEITE DE MELO, Analista
Judiciário, em 05/06/2019, às 17:03, conforme art. 1º, III, "b", da Lei 11.419/2006.

Documento assinado eletronicamente por ANTONIO MATIAS DE PINHEIRO JUNIOR,
Chefe de Seção, em 05/06/2019, às 17:03, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0552029 e o código CRC 1E7ECD9F.

0008478-63.2018.6.02.8000 0552029v1
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS

 

INFORMAÇÃO Nº 3789 - TRE-AL/PRE/DG/STI/COINF

 

                            À SEIC,
 
                         

  Sr. Chefe,
 
Informamos o que segue, em atenção ao Despacho

SEIC 0552029:
 

Os itens de propostas e ARPs constantes na planilha Preliminar de
Melhores Preços Recebibos, doc. 0552027, estão adequados quanto às
características técnicas do termo de referência;
Ademais, dada a complexidade técnica envolvida não vislumbramos
formas adicionais para estimativa de preços menres que não a solicitação
de cotação em empresas especializadas;
Expectativa estimada de quantitativos para aquisição no presente
exercício:

LOTE 01 - SOLUÇÃO PARTA REDE CABEADA

ITEM DESCRIÇÃO DOS PRODUTOS/SERVIÇOS QTD

ITEM
01

SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE
ACESSO PARA REDE CABEADA 0

ITEM
02

LICENCIAMENTO ADICIONAL PARA SISTEMA DE
GERENCIAMENTO HPE IMC 0

ITEM
03

LICENCIAMENTO ADICIONAL DO MÓDULO DE ANÁLISE
DE TRAFEGO DO SISTEMA DE GERENCIAMENTO HPE 0
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03 IMC

ITEM
04

LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE
ANÁLISE DE PERFIL E CONTROLE DE ACESSO 0

ITEM
05

SWITCH DE DISTRIBUIÇÃO COM 16 PORTAS SFP+ E
SUPORTE A MÓDULOS DE EXPANSÃO 0

ITEM
06

MÓDULO COM 4 PORTAS SFP+ PARA SWITCH DE
DISTRIBUIÇÃO 0

ITEM
07

MÓDULO DE STACKING COM 4 PORTAS PARA SWITCH
DE DISTRIBUIÇÃO 0

ITEM
08

SWITCH DE ACESSO L3 COM 48 PORTAS GIGABIT E
4SFP+ 0

ITEM
09

SWITCH DE ACESSO L3 COM 24 PORTAS GIGABIT E
4SFP+ 0

ITEM
10

SWITCH DE ACESSO L2 COM 24 PORTAS GIGABIT E
4SFP 06

ITEM
11

SWITCH DE ACESSO L2 COM 48 PORTAS GIGABIT E
4SFP 02

ITEM
12 GBIC 10GB PARA ATÉ 300M 0

ITEM
13 CABO DAC 10 GBPS DE 1M 0

ITEM
14 CABO DAC 10 GBPS DE 3M 0
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ITEM
15 GBIC 1GB PARA ATÉ 500M 0

ITEM
16

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE
TECNOLOGIA PARA SWITCHS DE REDE 0

ITEM
17

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO 0

ITEM
18

TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE
SWITCHES 0

ITEM
19

TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE
DE ACESSO 0

LOTE 02 - SOLUÇÃO DE REDE WIRELESS

ITEM DESCRIÇÃO DOS PRODUTOS/SERVIÇOS QTD

ITEM
01

SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE
ACESSO PARA REDE WIRELESS 0

ITEM
02 SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS 01

ITEM
03

LICENÇAS ADICIONAIS PARA SOLUÇÃO DE
GERENCIAMENTO DE REDE WIRELESS 0

ITEM
04

LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE
ANÁLISE DE PERFIL E CONTROLE DE ACESSO 0

ITEM
05 CONTROLADORA WLAN 02

ITEM LICENÇAS ADICIONAIS PARA CONTROLADORA WLAN 0
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06 LICENÇAS ADICIONAIS PARA CONTROLADORA WLAN 0

ITEM
07 PONTO DE ACESSO INTERNO TIPO 01 10

ITEM
08 PONTO DE ACESSO INTERNO TIPO 02 02

ITEM
09 INJETOR POE PARA PONTOS DE ACESSO TIPO 1 10

ITEM
10 INJETOR POE PARA PONTOS DE ACESSO TIPO 2 02

ITEM
11

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE
TECNOLOGIA PARA SOLUÇÃO DE GERENCIAMENTO 01

ITEM
12

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO 0

ITEM
13

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE
TECNOLOGIA PARA PONTOS DE ACESSO 0

ITEM
14

TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE
ARQUITETURA WLAN 0

ITEM
15

TREINAMENTO BÁSICO DA SOLUÇÃO DE
GERENCIAMENTO 0

ITEM
16

TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE
DE ACESSO 0
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Documento assinado eletronicamente por DANIEL MACÊDO DE CARVALHO SOUTO,
Coordenador, em 19/06/2019, às 16:36, conforme art. 1º, III, "b", da Lei 11.419/2006.

Documento assinado eletronicamente por CRISTINO HERMANO DE BULHÕES,
Analista Judiciário, em 19/06/2019, às 16:36, conforme art. 1º, III, "b", da Lei
11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0558080 e o código CRC FEB22EBC.

0008478-63.2018.6.02.8000 0558080v9
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COMAP – COORDENADORIA DE MATERIAIS E PATRIMÔNIO

SEIC – SEÇÃO DE INSTRUÇÃO DE CONTRATAÇÕES

AQUISIÇÃO DE COMPONENTES DE REDE (NETWORKING) – PA 0008478-63.2018

PREÇOS RECEBIDOS

DESCRIÇÃO DOS PRODUTOS/SERVIÇOS

1 1 R$ 104.180,00 R$ 114.350,25 R$ 104.180,00 R$ 0,00 R$ 104.180,00

2 3 R$ 16.060,00 R$ 17.767,50 R$ 15.890,00 R$ 15.890,00 R$ 0,00 R$ 47.670,00

3 2 R$ 12.745,00 R$ 14.549,60 R$ 12.745,00 R$ 0,00 R$ 25.490,00

4 2 R$ 54.160,00 R$ 54.519,80 R$ 54.160,00 R$ 0,00 R$ 108.320,00

5 6 R$ 49.117,00 R$ 54.340,00 R$ 74.074,00 R$ 49.117,00 R$ 0,00 R$ 294.702,00

6 16 MÓDULO COM 4 PORTAS SFP+ PARA SWITCH DE DISTRIBUIÇÃO R$ 4.742,00 R$ 5.239,52 R$ 4.742,00 R$ 0,00 R$ 75.872,00

7 6
R$ 4.406,00 R$ 4.433,90 R$ 4.406,00 R$ 0,00 R$ 26.436,00

8 50 SWITCH DE ACESSO L3 COM 48 PORTAS GIGABIT E 4SFP+ R$ 21.468,00 R$ 23.608,00 R$ 14.382,08 R$ 26.015,00 R$ 14.382,08 R$ 0,00 R$ 719.104,00

9 40 SWITCH DE ACESSO L3 COM 24 PORTAS GIGABIT E 4SFP+ R$ 14.106,00 R$ 16.082,56 R$ 17.650,00 R$ 14.106,00 R$ 0,00 R$ 564.240,00

10 50 6 SWITCH DE ACESSO L2 COM 24 PORTAS GIGABIT E 4SFP R$ 4.724,00 R$ 5.565,00 R$ 9.774,14 R$ 4.515,20 R$ 4.515,20 R$ 27.091,20 R$ 225.760,00

11 40 2 SWITCH DE ACESSO L2 COM 48 PORTAS GIGABIT E 4SFP R$ 8.245,00 R$ 9.100,00 R$ 8.245,00 R$ 16.490,00 R$ 329.800,00

12 50 GBIC 10GB PARA ATÉ 300M R$ 2.364,00 R$ 2.480,00 R$ 2.064,87 R$ 2.810,00 R$ 2.064,87 R$ 0,00 R$ 103.243,50

13 30 CABO DAC 10 GBPS DE 1M R$ 600,00 R$ 608,40 R$ 411,00 R$ 411,00 R$ 0,00 R$ 12.330,00

14 30 CABO DAC 10 GBPS DE 3M R$ 900,00 R$ 939,75 R$ 2.275,85 R$ 584,00 R$ 584,00 R$ 0,00 R$ 17.520,00

15 10 GBIC 1GB PARA ATÉ 500M R$ 1.200,00 R$ 1.324,96 R$ 740,46 R$ 862,00 R$ 740,46 R$ 0,00 R$ 7.404,60

16 5 R$ 20.000,00 R$ 22.027,09 R$ 20.000,00 R$ 0,00 R$ 100.000,00

17 1 R$ 60.000,00 R$ 63.407,80 R$ 60.000,00 R$ 0,00 R$ 60.000,00

18 4 TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE SWITCHES R$ 28.000,00 R$ 29.795,00 R$ 28.000,00 R$ 0,00 R$ 112.000,00

19 4 TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE ACESSO R$ 28.000,00 R$ 30.680,00 R$ 28.000,00 R$ 0,00 R$ 112.000,00

LOTE 02 – SOLUÇÃO DE REDE WIRELESS

IT
E
M

QUANTIDADE 
A REGISTRAR

PREVISÃO 
AQUISIÇÃO 

MÍNIMA 
EXERCÍCIO 

2019

  PROPOSTA  
  PLUGNET     
R$ (0533091)

PROPOSTA 
NEW SUPRI  

R$   
(0535906)

PROPOSTA 
ISH (0551756)

ARP IFES 
30/2018 ISH R$ 

    (0533078)

ARP UFPI 
47/2018 

APPROACH  
R$     

(0538465)

ARP UNIFAP 
15/2018 

APPROACH  
R$     

(0538466)

VALOR 
UNITÁRIO 

Menor 
Proposta R$

VALOR 
PREVISTO 

AQUISIÇÃO 
MÍNIMA 2019

VALOR TOTAL A 
REGISTRAR

SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 
PARA REDE CABEADA

LICENCIAMENTO ADICIONAL PARA SISTEMA DE 
GERENCIAMENTO HPE IMC

LICENCIAMENTO ADICIONAL DO MÓDULO DE ANÁLISE DE 
TRAFEGO DO SISTEMA DE GERENCIAMENTO HPE IMC 

LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE 
PERFIL E CONTROLE DE ACESSO 

SWITCH DE DISTRIBUIÇÃO COM 16 PORTAS SFP+ E SUPORTE A 
MÓDULOS DE EXPANSÃO 

MÓDULO DE STACKING COM 4 PORTAS PARA SWITCH DE 
DISTRIBUIÇÃO 

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA SWITCHS DE REDE 

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO 
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QUANTIDADE DESCRIÇÃO DOS PRODUTOS/SERVIÇOS

1 1 R$ 104.180,00 R$ 111.919,50 R$ 111.409,52 R$ 104.180,00 R$ 0,00 R$ 104.180,00

2 1 1 SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS R$ 570,00 R$ 642,60 R$ 29.335,39 R$ 570,00 R$ 570,00 R$ 570,00

3 200 R$ 570,00 R$ 648,90 R$ 497,21 R$ 497,21 R$ 0,00 R$ 99.442,00

4 2 R$ 55.000,00 R$ 59.607,60 R$ 99.673,86 R$ 55.000,00 R$ 0,00 R$ 110.000,00

5 4 2 CONTROLADORA WLAN R$ 70.000,00 R$ 70.686,00 R$ 9.331,44 R$ 70.000,00 R$ 140.000,00 R$ 280.000,00

6 200 LICENÇAS ADICIONAIS PARA CONTROLADORA WLAN R$ 900,00 R$ 948,60 R$ 900,00 R$ 0,00 R$ 180.000,00

7 100 10 PONTO DE ACESSO INTERNO TIPO 01 R$ 5.350,00 R$ 5.709,60 R$ 3.076,79 R$ 1.635,17 R$ 3.076,79 R$ 30.767,90 R$ 307.679,00

8 100 2 PONTO DE ACESSO INTERNO TIPO 02 R$ 2.300,00 R$ 2.504,80 R$ 7.791,37 R$ 5.590,28 R$ 3.386,00 R$ 2.300,00 R$ 4.600,00 R$ 230.000,00

9 100 10 INJETOR POE PARA PONTOS DE ACESSO TIPO 1 R$ 700,00 R$ 756,02 R$ 500,00 R$ 500,00 R$ 5.000,00 R$ 50.000,00

10 100 2 INJETOR POE PARA PONTOS DE ACESSO TIPO 2 R$ 550,00 R$ 621,18 R$ 1.500,00 R$ 550,00 R$ 1.100,00 R$ 55.000,00

11 1 1 R$ 25.000,00 R$ 25.589,20 R$ 24.000,00 R$ 24.000,00 R$ 24.000,00 R$ 24.000,00

12 1 R$ 60.000,00 R$ 64.632,50 R$ 24.000,00 R$ 24.000,00 R$ 0,00 R$ 24.000,00

13 5 R$ 20.000,00 R$ 22.428,00 R$ 24.000,00 R$ 20.000,00 R$ 0,00 R$ 100.000,00

14 4 R$ 20.300,00 R$ 22.627,50 R$ 20.000,00 R$ 20.000,00 R$ 0,00 R$ 80.000,00

15 4 TREINAMENTO BÁSICO DA SOLUÇÃO DE GERENCIAMENTO R$ 20.300,00 R$ 22.196,50 R$ 20.000,00 R$ 20.000,00 R$ 0,00 R$ 80.000,00

16 4 TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE ACESSO R$ 28.000,00 R$ 27.948,00 R$ 20.000,00 R$ 20.000,00 R$ 0,00 R$ 80.000,00

TOTAL  R$ R$ 249.619,10 R$ 4.850.943,10

IT
E
M

  PROPOSTA  
  PLUGNET     
R$ (0533091)

PROPOSTA 
NEW SUPRI  

R$   
(0535906)

PROPOSTA 
ISH (0551756)

ARP IFES 
30/2018 ISH R$ 

    (0533078)

ARP UFPI 
47/2018 

APPROACH  
R$     

(0538465)

ARP UNIFAP 
15/2018 

APPROACH  
R$     

(0538466)

VALOR 
UNITÁRIO 

Menor 
Proposta R$

VALOR 
PREVISTO 

AQUISIÇÃO 
MÍNIMA 2019

VALOR TOTAL A 
REGISTRAR 

SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 
PARA REDE WIRELESS 

LICENÇAS ADICIONAIS PARA SOLUÇÃO DE GERENCIAMENTO DE 
REDE WIRELESS 

LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE 
PERFIL E CONTROLE DE ACESSO 

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA SOLUÇÃO DE GERENCIAMENTO 

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO 

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA PONTOS DE ACESSO 

TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE ARQUITETURA 
WLAN 
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INFORMAÇÃO Nº 3875 - TRE-AL/PRE/DG/SAD/COMAP/SEIC

À COMAP,
Senhora Coordenadora Substituta,
Veio o procedimento a esta Seção de Instrução de

Contratações - SEIC para realização de pesquisa de preços
(Despachos GSAD 0520870 e COMAP 0521551), visando ao Registro
de Preços de equipamentos de Soluções de Tecnologia da Informação
- componentes de rede (Networking), conforme Termo de Referência
ajustado 0541748.

Foram consultadas diversas empresas do ramo, incluindo
as empresas indicadas pela unidade demandante como potenciais
fornecedoras dos equipamentos requeridos, conforme eventos
0522495, 0522526, 0523417, 0526142, seguidos de vários contatos
telefônicos e algumas promessas de envio de cotação, a exemplo das
empresas 7secure, Smartwave Networks, Ingram Micro; outras
empresas informaram não atenderem ao requerido, como reportado
pela Wintronic, SoloNetwork, Supriservice, New Tech e Usetech.

As empresas ISH Tecnologia e Approach Tecnologia
enviaram Atas de Registro de Preços vigentes para itens apontados
pela unidade técnica demandante como equivalentes a alguns itens
requeridos no TR, servindo, portanto, como base para a formação do
preço estimado para esses itens.

Apresentaram orçamentos para o fornecimento as
empresa Plugnet (0533091), NewSupri (0535906) e ISH Tecnologia
(0551756), conforme Planilha de Preços Recebidos (evento 0559828).

Portanto, tendo em vista as aquisições passadas de
equipamentos de mesma natureza, quanto aos resultados
normalmente obtidos nos procedimentos licitatórios, com preços
fechados abaixo dos valores médios estimados - vez que os preços
apresentados pelas empresas fornecedoras na fase de pesquisa são
preços de balcão, como são chamados, deixando, como vem
ocorrendo, a negociação para o momento do certame, entendemos
prudente sugerir, como estimativa de preços para a aquisição dos
equipamentos, salvo melhor entendimento, os menores preços
obtidos na pesquisa para cada item do Termo de Referência,
considerando-se, inclusive, manifestação da unidade técnica
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demandante constante na Informação COINF 3789 (0558080).
Diante do exposto, conforme disposições do Termo de

Referência - TIC 24 (0541748), pendente de aprovação, obtivemos o
total estimado para o regisgtro de preços dos equipamentos no valor
de R$ 4.850.943,10 (quatro milhões, oitocentos e cinquenta mil,
novecentos e quarenta e três reais e dez centavos), e, para atender
previsão estimada ajustada de aquisição no presente exercício aposta
na Informação COINF 3789 (0558080), encontramos o valor médio
estimado de R$ 249.619,10 (duzentos e quarenta e nove mil,
seiscentos e dezenove reais e dez centavos).

Assim, caso autorizada, sugerimos que a contratação seja
realizada por meio de licitação, pregão eletrônico, pelo sistema de
registro de preços, com base na Lei nº 10.520/2002, regulamentada
pelos Decretos nºs 3.555/200, 5.450/2005 e 7.892/2013.

Respeitosamente,
 
 
 
 
 

 

Documento assinado eletronicamente por MARIA MÁRCIA LEITE DE MELO, Analista
Judiciário, em 28/06/2019, às 13:34, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0560123 e o código CRC A979CF8C.

0008478-63.2018.6.02.8000 0560123v34
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DESPACHO

Maceió, 01 de julho de 2019.
À SAD,
para ciência da informação 3875 da SEIC

(SEI 0560123) e demais providências cabíveis, inclusive, se
for o caso, aprovação do Termo de Referência constante no
evento SEI nº 0541748. 

Respeitosamente,

Documento assinado eletronicamente por INGRID PEREIRA DE LIMA ARAÚJO,
Coordenador Substituto, em 01/07/2019, às 13:40, conforme art. 1º, III, "b", da Lei
11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0560647 e o código CRC C27D985F.

0008478-63.2018.6.02.8000 0560647v1
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DESPACHO

Maceió, 01 de julho de 2019.
Em face do expressivo valor estimado para a

aquisição, inclusive no que respeita ao quantitativo referente
ao presente exercício, de acordo com a Informação 3875, da
SEIC (0560123), solicito ao Sr. Secretário de TI que reavalie a
proposição de modo a compatibilizá-la, no que couber, ao
quadro de aquisições de que trata o Despacho COFIN
0499140, ao plano de aquisições de TI ajustado e ao atual
cenário orçamentário.

Cópia à COFIN, para ciência e pronunciamento
quanto à viailidade de aquisição dos itens indicados para o
presente exercício, estimados em R$ 249.619,10 (duzentos e
quarenta e nove mil, seiscentos e dezenove reais e dez
centavos), valor médio.

Documento assinado eletronicamente por JOSÉ RICARDO ARAÚJO E SILVA,
Secretário de Administração, em 01/07/2019, às 14:29, conforme art. 1º, III, "b", da
Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0560718 e o código CRC 3D8C9BFF.

0008478-63.2018.6.02.8000 0560718v1
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DESPACHO

Maceió, 01 de julho de 2019.
À SGO,
Para manifestação acerca do disposto no despacho

GSAD  (0560718).
Atenciosamente.
 

Documento assinado eletronicamente por RUI CARLOS GALVÃO, Coordenador
Orçamentário e Financeiro, em 01/07/2019, às 14:39, conforme art. 1º, III, "b", da Lei
11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0560739 e o código CRC 6053FC21.

0008478-63.2018.6.02.8000 0560739v1
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DESPACHO

Maceió, 03 de julho de 2019.
Maceió, 3 de julho de 2019

SEI n. 0000809-22.2019.6.02.8000
Informação n. 139/2019
 
À COFIN.
 
Senhor Coordenador,
 
1. Vieram os autos para, paralelo à análise da unidade demandante,
avaliarmos a possibilidade de atender a necessidade orçamentária de
aquisição de equipamentos, materiais de consumo e prestação de serviços,
constantes do Termo de Referência - TIC 20 (0450416), neste exercício, em
R$ 249.619,10 (duzentos e quarenta e nove mil, seiscentos e dezenove reais e
dez centavos), conforme estimativa SEIC (0560123).
 
2. Pois bem, somente após o retorno do Processo SEI 0004929-
11.2019.6.02.8000, que trata da identificação de eventuais sobras
orçamentárias, pelas unidades administrativas do TRE/AL, é que poderemos
nos manifestar sobre a existência de recursos que possam atender a
necessidade apontada nestes autos, sem olvidar da necessária identificação
clara dos ítens a serem adquiridos neste exercício, devidamente classificados
em bens permanentes, materiais de consumo e prestação de serviços.
 
3. Ressalto que resta apenas que às UAs SAPEV e SMR se manifestem no SEI
citado no item 2, sendo que as demais não informaram nenhuma
liberação de crédito, com exceção da EJE que autorizou um remanejamento
de R$ 30.000,00 do orçamento de capacitação de recursos humanos para
à CODES, o que não influencia em nada o objeto deste SEI.
 
4. Por oportuno, ainda no SEI citado no item 2 acima, o chefe da SGO incluiu na
presente data, por UA (evento 0562002), a relação de reservas de créditos
ativas dos saldos existentes nas diversas despesas agregadas. Tal iniciativa
visa facilitar a análise por parte das UAs, sendo na verdade o desmembramos
do Anexo 14 citado no referido SEI.
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Respeitosamente.
 
 

Documento assinado eletronicamente por AGNALDO QUINTELA DOS SANTOS,
Analista Judiciário, em 03/07/2019, às 15:52, conforme art. 1º, III, "b", da Lei
11.419/2006.

Documento assinado eletronicamente por ROGÉRIO ROCHA DA SILVA, Chefe de
Seção, em 03/07/2019, às 15:52, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0561985 e o código CRC AC55B924.

0008478-63.2018.6.02.8000 0561985v1
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DESPACHO

Maceió, 03 de julho de 2019.
À GSAD (c/c p SGO),
Sr. Secretário,
Encaminho, para ciência e providências , o

despacho SGO (0561985).
Particularmente, vejo como prejudicado o

atendimento ao respectivo pleito, pois a SMR provavelmente
não irá disponibilizar recursos, pois as reservas existentes
referem-se às obras da Sininbu.

Quanto à manifestação da  SAPEV, o valor total que
poderia ser disponibilizado monta em R$ 188.171,29 o que
além de pouco provável de ocorrer, ainda não seria suficiente
para o atendimento da demanda.

Portanto, caso imprescindível a aquisição, sugiro
que a Alta Administração evidencie a prioridade com
remanejamento das  das reservas existentes nas demais UA´s-
Unidades Administrativas.

Atenciosamente.

Documento assinado eletronicamente por RUI CARLOS GALVÃO, Coordenador
Orçamentário e Financeiro, em 03/07/2019, às 16:50, conforme art. 1º, III, "b", da Lei
11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0562169 e o código CRC EDF26A81.

0008478-63.2018.6.02.8000 0562169v1
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DESPACHO

Maceió, 05 de julho de 2019.
À STI
 
Em complemento ao nosso Despacho 0560718,

solicito à STI considerar, para efeito de avaliação, os
despachos 0561985 e 0562169. 

Documento assinado eletronicamente por JOSÉ RICARDO ARAÚJO E SILVA,
Secretário de Administração, em 05/07/2019, às 15:05, conforme art. 1º, III, "b", da
Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0563363 e o código CRC 919A1728.

0008478-63.2018.6.02.8000 0563363v1
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DESPACHO

Maceió, 08 de julho de 2019.
À SAD
 
Sr. Secretário,
 
Em atenção ao Despacho GSAD 0563363, informo

que nos autos do Proc SEI nº 0004929-11.2019.6.02.8000 esta
Secretaria de TI já se manifestou, inclusive com
assinalamento de eventuais remanejamentos internos de
recursos, na forma dos Despachos STI 0557568 e Despacho
COINF 0556981.

 
Atenciosamente.

Documento assinado eletronicamente por DANIEL MACÊDO DE CARVALHO SOUTO,
Secretário de Tecnologia da Informação Substituto, em 08/07/2019, às 13:50,
conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0563677 e o código CRC DDA1A648.

0008478-63.2018.6.02.8000 0563677v1
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DESPACHO

Maceió, 08 de julho de 2019.
Retorno os autos à COFIN, para que reavalie a

questão à luz das informações consignadas no Despacho
COINF 0556981, proferida nos autos de nº 0004929-
11.2019.6.02.8000.

Documento assinado eletronicamente por JOSÉ RICARDO ARAÚJO E SILVA,
Secretário de Administração, em 08/07/2019, às 13:57, conforme art. 1º, III, "b", da
Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0563688 e o código CRC 5EA14181.

0008478-63.2018.6.02.8000 0563688v1
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DESPACHO

Maceió, 08 de julho de 2019.
À SGO,
Diante do despacho GSAD (0563688), encaminho

os autos eletrônicos para reanálise do apontado no despacho
SGO (0561985), face a manifestação da STI no evento 
(0563677).

Atenciosamente.
 

Documento assinado eletronicamente por RUI CARLOS GALVÃO, Coordenador
Orçamentário e Financeiro, em 08/07/2019, às 14:29, conforme art. 1º, III, "b", da Lei
11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0563742 e o código CRC DE1F9576.

0008478-63.2018.6.02.8000 0563742v1
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DESPACHO

Maceió, 16 de julho de 2019.
Maceió, 18 de julho de 2019

SEI n. 0008478-63.2018.6.02.8000
Informação n. 156/2019
 
À COFIN.
 
Senhor Coordenador,
 
1. Retornam os autos a esta unidade para continuidade da análise, visando
a indicação de eventuais disponibilidades de recursos que possam atender a
presente demanda, no valor total estimado, para o  exercício, em
R$ 249.619,10 (duzentos e quarenta e nove mil, seiscentos e dezenove reais e
dez centavos), conforme estimativa SEIC (0560123).
 
2. Pois bem, no que pese a não identificação clara dos ítens a serem
adquiridos, devidamente classificados em bens permanentes, materiais de
consumo e prestação de serviços, conforme requerido no tópico 2 do
Despacho SGO 0561985, pela unidade requisitante, verificamos, após o retorno
do Processo SEI 0004929-11.2019.6.02.8000, a inexistência de sobra
orçamentária suficiente a suprir a demanda. Por oportuno, informo que
realizamos a atualização no SEI aqui citado dos saldos existentes nas reservas
de créditos de programação, estando os pré-empenhos destinados à STI
relacionados nos eventos 0566913 e 0566938.
 
3. Como a despesa pretendida está vinculada a uma futura ata de registro de
preços, não é necessário emitir reserva de crédito. Fizemos registro na
planilha de controle de atas de registros de preços (evento 0567808).
Contudo, a aquisição no presente exercício somente pode acontecer após
identificação de existência de crédito orçamentário, definida a natureza da
despesa pretendida (custeio, investimento e treinamento).
 
4. Por fim, não obstante a impossibilidade de indicar neste momento recursos
para o exercício de 2019, sugerimos a continuidade do presente procedimento,
desde que o Registro de Preços não estabeleça a obrigatoriedade de
aquisições no ano em curso, sendo oportuno condicionar a aquisição a
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existência de orçamento. Quanto ao próximo exercício, com relação a parte de
investimento, será necessário que este Tribunal em 2020
realize remanejamento de crédito, ou identifique sobra orçamentária, ou
solicite crédito adicional, tendo em vista que estamos em vias de antecipação
da despesa de investimento de TI programadas para 2020.
 
Respeitosamente,
 

Documento assinado eletronicamente por AGNALDO QUINTELA DOS SANTOS,
Analista Judiciário, em 18/07/2019, às 16:09, conforme art. 1º, III, "b", da Lei
11.419/2006.

Documento assinado eletronicamente por ROGÉRIO ROCHA DA SILVA, Chefe de
Seção, em 18/07/2019, às 16:09, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0567525 e o código CRC D0CEE49A.

0008478-63.2018.6.02.8000 0567525v1
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PE Emitido Pleitos Eleitorais Data do
N Processo Objeto UA 2020  Registro Obs

Custeio Investimento Custeio Investimento Custeio (PE Emitidos)

1 0007945-07.2018.6.02.8000

Registro de Preço para aquisição de solução 

viabilizadora de vídeo conferência entre o 

Corregedoria Nacional de Justiça, cartórios 

eleitorais de Alagoas e o próprio Tribunal 

Regional Eleitoral de Alagoas, conforme 

Provimento nº 75 da Corregedoria Nacional 

de Justiça.

SAD 129.670,10                 -                       -                      -                   07/02/2019 1

2 0002730-50.2018.6.02.8000
Registro de Preços - água mineral (ATA DE 

2018)
SEALMOX 13.320,00 243                                10.920,78 10.920,78        

Ata 15/2018 de 2018, 
saldo para 2019 de R$ 

2.297,70 .

3 0000602-23.2019.6.02.8000 Aquisição de Material de Expediente SEALMOX 6.926,20                     98                                  3.716,90 3.716,90          Ata 04(A e B)/2019

4 0008478-63.2018.6.02.8000
Equipamento de TI, material de consumo e 

realização de treinamento
STI 249.619,10

 Não foi emitido (ver 

evento 0567525) 
-                   

5 -                   
6 -                   
7 -                   
8 -                   
9 -                   

10 -                   
Totais 399.535,40                 14.637,68            -                      -                   -                     -                              14.637,68        

ATAS DE REGISTRO DE PREÇO 2019 - OBJETO E VALORES

SEÇÃO DE GESTÃO ORÇAMENTÁRIA

CORDENADORIA DE ORÇAMENTO E FINANÇAS

TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS

REGISTRO DE PREÇOS 2019-2020

Valor reservado

Valor da ATA Total

Orçamento Ordinário
2020

Orçamento Ordinário
2019

Totais 399.535,40                 14.637,68            -                      -                   -                     -                              14.637,68        

1. Não houve programação da despesa específica na LOA 2019.

Rogério Rocha da Silva
Seção de Gestão Orçamentária

Heberth Henrique Araújo Pinheiro
Seção de Gestão Orçamentária

A
nexo A
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DESPACHO

Maceió, 18 de julho de 2019.
À GSAD,
Com manifestação da SGO (0567525).
Atenciosamente.
 

Documento assinado eletronicamente por RUI CARLOS GALVÃO, Coordenador
Orçamentário e Financeiro, em 18/07/2019, às 17:22, conforme art. 1º, III, "b", da Lei
11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0569110 e o código CRC 37205FBC.

0008478-63.2018.6.02.8000 0569110v1
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DESPACHO

Maceió, 18 de julho de 2019.
Ao Senhor Secretário de TI, para ciência do

Despacho SGO 0567525, ao tempo em que solicito o apoio
dessa Unidade em esclarecer a questão suscitada no item 3 do
citado ato.

Documento assinado eletronicamente por JOSÉ RICARDO ARAÚJO E SILVA,
Secretário de Administração, em 18/07/2019, às 18:49, conforme art. 1º, III, "b", da
Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0569196 e o código CRC 9EBF7EAF.

0008478-63.2018.6.02.8000 0569196v1
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DESPACHO

Maceió, 19 de julho de 2019.
Senhor Secretário de Administração,
 
Nos termos da manifestação da SGO, solicito a

continuidade do presente procedimento, desde que o Registro
de Preços não estabeleça a obrigatoriedade de aquisições no
ano em curso.

 
Em relação ao item 3 (doc. nº 0567525) e mantida a

tramitação destes autos, solicito a indicação detalhada da
aplicação dos recursos relativos a custeio e aos investimentos
de TI neste exercício (processo; produto/serviço/registro de
preços; valor), antes de emitir a manifestação solicitada por
Vossa Senhoria.

 
Atenciosamente,

Documento assinado eletronicamente por CARLOS HENRIQUE TAVARES MÉRO,
Secretário de Tecnologia da Informação, em 19/07/2019, às 08:02, conforme art. 1º,
III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0569246 e o código CRC 4DB2E3F4.

0008478-63.2018.6.02.8000 0569246v1
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DESPACHO

Maceió, 24 de julho de 2019.

 

À STI
 
Senhor Secretário,
 
Em acréscimo ao Despacho GSAD 0569196, destacamos

que o pedido de esclarecimento de que trata o item 3 do Despacho
SGO 0567525, diz respeito à classificação da natureza da despesa a
ser incorrida com a aquisição dos itens constantes deste processo.

Para maior clareza, transcrevemos o citado trecho:
3. Como a despesa pretendida está vinculada a uma
futura ata de registro de preços, não é necessário
emitir reserva de crédito. Fizemos registro na
planilha de controle de atas de registros de preços
(evento 0567808). Contudo, a aquisição no presente
exercício somente pode acontecer após identificação
de existência de crédito orçamentário, definida a
natureza da despesa pretendida
(custeio, investimento e treinamento). Grifos não
constantes do original.

Esse ponto é tratado também no item 2:
2. Pois bem, no que pese a não identificação clara
dos ítens a serem adquiridos, devidamente
classificados em bens permanentes, materiais
de consumo e prestação de
serviços, conforme requerido no tópico 2 do
Despacho SGO 0561985, pela unidade requisitante,
verificamos, após o retorno do Processo SEI 0004929-
11.2019.6.02.8000, a inexistência de sobra
orçamentária suficiente a suprir a demanda. Por
oportuno, informo que realizamos a atualização no
SEI aqui citado dos saldos existentes nas reservas de
créditos de programação, estando os pré-empenhos
destinados à STI relacionados nos
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eventos 0566913 e 0566938.

Nesse sentido, pedimos a colaboração dessa Unidade em
prestar os esclarecimentos solitados pela SGO, para o
aperfeiçoamento da instrução processual, ou seja, definir a natureza
dos itens que integram o objeto da aquisição/contratação (item 1 do
Termo de Referência).

 
Atenciosamente.
 

Documento assinado eletronicamente por ANDRÉA CRISTINA DE LIMA BELCHIOR,
Secretário de Administração Substituto, em 24/07/2019, às 15:46, conforme art. 1º,
III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0571378 e o código CRC 181863B0.

0008478-63.2018.6.02.8000 0571378v1
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DESPACHO

Maceió, 24 de julho de 2019.
Senhora Secretária de Administração Substituta,
 
Informo que os bens ora tratados, em razão de sua

natureza, devem ter suas despesas classificadas como
investimento.

 
Atenciosamente,

Documento assinado eletronicamente por CARLOS HENRIQUE TAVARES MÉRO,
Secretário de Tecnologia da Informação, em 24/07/2019, às 17:07, conforme art. 1º,
III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0571487 e o código CRC 96593D92.

0008478-63.2018.6.02.8000 0571487v1
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DESPACHO

Maceió, 25 de julho de 2019.
 
 
Reporto-me ao item 4 do Despacho SGO 0567525, para

encaminhar o feito à SLC, para que seja elaborada a minuta do
edital, com a urgência que o caso requer, uma vez que se trata
de projeto prioritário para o exercício, cujas aquisições estarão
condicionadas, como bem assinalado pela SGO, às disponibilidades
orçamentárias do Órgão, definida a natureza da despesa pretendida
(custeio, investimento e treinamento). 

 

Documento assinado eletronicamente por ANDRÉA CRISTINA DE LIMA BELCHIOR,
Secretário de Administração Substituto, em 25/07/2019, às 11:29, conforme art. 1º,
III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0571819 e o código CRC 1646798D.

0008478-63.2018.6.02.8000 0571819v1
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DESPACHO

Maceió, 26 de julho de 2019.
À SAD, para autorização ou não de inclusão de

Intenção de Registro de Preços no Comprasnet.

Documento assinado eletronicamente por ANDRÉA DE ALBUQUERQUE CÉSAR,
Analista Judiciário, em 26/07/2019, às 08:58, conforme art. 1º, III, "b", da Lei
11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0572403 e o código CRC C9E990A7.

0008478-63.2018.6.02.8000 0572403v1
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DESPACHO

Maceió, 26 de julho de 2019.
 
 
À SLC
 
Senhora Chefe,
 
Dispenso a divulgação da Intenção de Registro de

Preços, conforme previsto no §1º da art. 4º do Decreto nº
7.892/2013, em razão da urgência na tramitação do  presente
procedimento, em que se pretende a antecipação de despesa 
a fim de viabilizar crédito para concluir obra/serviços na
antiga sede.

 
Atenciosamente.
 
 

Documento assinado eletronicamente por ANDRÉA CRISTINA DE LIMA BELCHIOR,
Secretário de Administração Substituto, em 29/07/2019, às 10:27, conforme art. 1º,
III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0572764 e o código CRC AE72BB44.

0008478-63.2018.6.02.8000 0572764v1
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PPRREEGGÃÃOO  EELLEETTRRÔÔNNIICCOO  NNºº  XXXX//22001199  
  

MMIINNUUTTAA  

 
PROCESSO Nº 0008478-63.2018.6.02.8000 
Tipo de Licitação: MENOR PREÇO POR LOTE   
Data: XX de XXXX de 2019 
HORÁRIO DE BRASÍLIA/DF 
Horário de Abertura: XX horas 
Local: www.comprasnet.gov.br 

 

 O Tribunal Regional Eleitoral de Alagoas – TRE/AL, por intermédio da Seção de Licitações e 
Contratos, torna público, para quem interessar possa, que realizará licitação na modalidade 
PREGÃO ELETRÔNICO, do tipo MENOR PREÇO POR LOTE, conforme descrito neste Edital e seus 
Anexos, objetivando o Registro de Preços de  componentes de rede (Networking), tudo de acordo 
com requisição promovida pela Secretaria de Tecnologia da Informação. 
 

 O certame será regido conjuntamente pela Lei nº 10.520, de 17/07/2002, pelo Decreto nº 
5.450, de 31/05/2005, pelo Decreto nº 8.538, de 06/10/2015 e subsidiariamente pela Lei nº 8.666, 
de 21/06/1993 e com suas posteriores alterações e demais normas pertinentes. Aplica-se ao 
presente torneio licitatório, ainda, a Lei Complementar nº 123, de 14/12/2006, o Decreto nº 
7.174/2010, o Decreto nº 8.184/2014, a Portaria nº 212, de 18/06/2001, da Presidência deste 
Tribunal, publicada na seção 1 do DOU, edição de 19/06/2001, por meio da qual se adota o SICAF – 
Sistema de Cadastramento Unificado de Fornecedores - nas licitações realizadas no âmbito da 
Secretaria deste Tribunal, bem como, no que couber pela Lei nº 8.078, de 11/09/1990 e demais 
exigências deste Edital e seus anexos. 
 
1 - DO OBJETO. 
 

1.1. O presente Pregão tem por objeto o Registro de Preços de componentes de rede 
(Networking), conforme especificações descritas nos Anexos I e I-A deste edital. 

 
2 – DAS CONDIÇÕES GERAIS. 
 
2.1. O prazo de vigência da Ata de Registro de Preços decorrente deste procedimento 
licitatório é de 12 (doze) meses, contado da publicação do referido ato. 
 
2.2. 2.2. A Ata de Registro de Preços não obriga à contratação de toda quantidade 
estimada no Registro, que poderá ocorrer de acordo com as necessidades do TRE/AL. 
 
2.3. A existência de preços registrados não obriga o Tribunal Regional Eleitoral a contratar, 
facultando-se a realização de licitação específica para a aquisição pretendida, assegurada 
preferência ao fornecedor registrado em igualdade de condições. 
 

2.3.1. O direito de preferência de que trata este item poderá ser exercido pelo beneficiário 
do registro quando o Tribunal Regional Eleitoral de Alagoas, após realizada a licitação 
específica, constatar que o preço obtido é igual ou maior que o registrado ou, após 
negociação, aquiescer o detentor da ata em baixar o preço registrado, igualando ou tornando-
o menor que o obtido em referida licitação. 
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3 - DOS PRAZOS DE ENTREGA E DA GARANTIA.  
 

3.1. O prazo máximo para a entrega dos equipamentos é de 60 (sessenta) dias contados a 
partir do recebimento da Ordem de Fornecimento ou documento equivalente. 

 

3.2. O prazo máximo para a entrega dos softwares é 30 (trinta) dias contados a partir do 
recebimento da Ordem de Fornecimento ou documento equivalente. 

 

3.3. Os serviços de instalação, integração, garantia e suporte dos equipamentos e softwares, 
deverão ser realizados diretamente pelo fabricante de acordo com as exigências contidas no 
descritivo dos mesmos, estando essas aderentes aos respectivos níveis de serviço necessários a 
cada um deles. 

 
3.4. Quanto aos itens 1, 2, 3, 4, 20, 22, 23 e 25,   a garantia e o suporte do fabricante para a 
solução de software deverá ser ofertado pelo período mínimo de 36 (trinta e seis) meses, incluindo 
a evolução para novas versões devendo o atendimento ser na modalidade 24x7 (vinte quatro horas 
por dia, sete dias da semana), com tempo de resposta máximo em 4 (quatro) horas. 
 

3.4.2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3.4.3.  O fabricante deve possuir canais de comunicação e ferramentas adicionais para 
suporte técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda 
de área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução. 

3.4.4.  A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

3.4.5. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante dos 
softwares, indicando o período de garantia dos produtos ofertados. Em caso de documentação 
expressa do fabricante deverá ser anexada a mesma a procuração que comprove que a 
fabricante outorga ao procurador os poderes para firmar e declarar as exigências solicitadas. 

3.5. Quanto aos itens 5, 8, 9, 10, 11, 24, 26 e 27, o equipamento ofertado deverá possuir 
garantia do fabricante na modalidade on-site pelo período mínimo de 60 (sessenta) meses para 
reposição de peças, mão de obra e atendimento. O prazo máximo para atendimento do chamado 
deve ser de até o próximo dia útil após a sua abertura. Durante o período da garantia o prazo 
máximo para o reparo de equipamentos defeituosos a condição normal de funcionamento deverá 
ser de até 07 (sete) dias úteis. 
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3.5.1. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3.5.2. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de área 
para cadastro da solução de hardware ofertada, possibilitando assim que a CONTRATANTE 
possa receber de forma proativa, durante todo período da garantia as notificações de 
atualizações e correções (“hotfix”) da solução; 

3.5.3. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 
para suporte técnico e abertura de chamados técnicos. 

3.5.4. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica local 
no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por meio de 
documentação oficial do fabricante dos produtos e de domínio público, através de catálogos, 
folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso não seja 
comprovada por um dos meios citados anteriormente, será possível a comprovação através da 
apresentação de documentação expressa do fabricante dos equipamentos, indicando a referida 
assistência técnica que será responsável pelo atendimento e manutenção durante o período de 
garantia dos produtos ofertados. Em caso de documentação expressa do fabricante a esta 
deverá ser anexada uma procuração que comprove que a fabricante outorga ao procurador os 
poderes para firmar e declarar as exigências solicitadas. 

3.5.5. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da garantia 
ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

3.6.   Quanto aos itens 6, 7, 12, 13, 14, 15, 28 e  29, O equipamento ofertado deverá possuir 
garantia do fabricante do equipamento na modalidade on-site pelo período mínimo de 12 (doze) 
meses para reposição de peças, mão de obra e atendimento no local. O período da garantia o prazo 
máximo para o reparo de equipamentos defeituosos a condição normal de funcionamento deverá 
ser de até 07 (sete) dias úteis. 

3.6.1. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento. 

3.6.2. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da garantia 
ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 
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4 - DA PARTICIPAÇÃO. 
 
4.1.   Poderão participar deste pregão os interessados do ramo pertinente ao objeto licitado, 
obrigatoriamente, previamente cadastradas no Sistema de Cadastro Unificado de Fornecedores – 
SICAF, habilitação parcial, que atendam à linha de fornecimento e a todas as demais exigências 
deste Edital e seus anexos. 
 
4.2. Para participação neste Pregão, o licitante deverá manifestar, em campo próprio do 
sistema eletrônico, que cumpre plenamente os requisitos de habilitação e que sua proposta está em 
conformidade com as exigências do instrumento convocatório. 
 

4.2.1. A declaração falsa relativa ao cumprimento dos requisitos de habilitação e proposta 
sujeitará o licitante às sanções previstas neste Edital. 

 
4.3. No ato de envio de suas propostas, as Microempresas ou Empresas de Pequeno Porte 
deverão declarar, em campo próprio do Sistema do Pregão Eletrônico, que atendem aos requisitos 
do art. 3º da Lei Complementar nº 123/2006 para fazer jus aos benefícios previstos no referido 
diploma legal. 
 
4.4. Não será admitida nesta licitação a participação de empresas: 
 

4.4.1. em processo de recuperação judicial ou em processo de falência, sob concurso de 
credores, em dissolução ou em liquidação; 
 
4.4.2. que estejam suspensas de participar de licitação realizada pelo Tribunal Regional 
Eleitoral de Alagoas e empresas que tenham sido declaradas inidôneas para licitar ou 
contratar com a Administração Pública, enquanto perdurarem os motivos da punição; 
 
4.4.3. que estejam reunidas em consórcio e sejam controladoras, coligadas ou subsidiárias 
entre si, qualquer que seja sua forma de constituição; 
 
4.4.4. estrangeiras que não funcionem no País; 
 
4.4.5.  que tenham em seu quadro societário cônjuge, companheiro ou parente em linha reta, 
colateral ou por afinidade até o terceiro grau, inclusive, dos magistrados ocupantes de cargos 
de direção ou no exercício de funções administrativas, assim como de servidores ocupantes de 
cargos de direção, chefia e assessoramento vinculados direta ou indiretamente às unidades 
situadas na linha hierárquica da área encarregada da licitação, de acordo com o disposto no 
art. 2º da Resolução nº 07/2005 do Conselho Nacional de Justiça (com a nova redação dada 
pelo art. 1º da Resolução 229/2016-CNJ). 

 
5 - DA REPRESENTAÇÃO E DO CREDENCIAMENTO. 
 
5.1. Os licitantes ou seus representantes legais deverão estar previamente credenciados no 
site www.comprasnet.gov.br (Art. 3º do Decreto nº 5.450/05). 
 
5.2. O credenciamento do licitante, bem assim a sua manutenção, no site acima informado, 
dependerá de registro atualizado no Sistema de Cadastramento Unificado de Fornecedores – SICAF - 
Habilitação Parcial, que também será requisito obrigatório para fins de habilitação. 
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5.3. O credenciamento do licitante dar-se-á pela utilização de login e senha, para acesso ao 
sistema eletrônico no site www.comprasnet.gov.br, opção pregão eletrônico, criados quando do 
credenciamento supracitado. 
 
5.4. O credenciamento junto ao provedor do sistema implica a responsabilidade legal do 
licitante e a presunção de sua capacidade técnica para realização das transações inerentes ao 
pregão na forma eletrônica (Art. 3º, § 6º, do Decreto nº 5.450/05). 
 
5.5. O uso da senha de acesso pelo licitante é de sua responsabilidade exclusiva, incluindo 
qualquer transação efetuada diretamente ou por seu representante, não cabendo ao provedor do 
sistema ou ao TRE/AL, promotor da licitação, responsabilidade por eventuais danos decorrentes de 
uso indevido da senha, ainda que por terceiros (Art. 3º, § 5º, do Decreto nº 5.450/05). 
 
6 - DO ENVIO DA PROPOSTA DE PREÇOS. 
 

6.1. O licitante será responsável por todas as transações que forem efetuadas em seu nome 
no sistema eletrônico, assumindo como firmes e verdadeiras suas propostas, assim como os lances 
inseridos durante a sessão pública. (inciso III, do art. 13, do Decreto nº 5.450/2005). 
 

6.2. Incumbirá ao licitante acompanhar as operações no sistema eletrônico durante o 
processo licitatório, responsabilizando-se pelo ônus decorrente da perda de negócios diante da 
inobservância de quaisquer mensagens emitidas pelo sistema ou de sua desconexão (inciso IV, do 
art. 13, do Decreto 5.450/2005). 
 

6.3. A participação no pregão dar-se-á por meio da digitação de login e senha privativas do 
licitante e subsequente encaminhamento da proposta com a descrição do serviço ofertado, em 
campo próprio, que poderá ser feito a partir da data da disponibilização do Edital no site do 
www.comprasnet.gov.br e até a data e hora marcadas para abertura deste pregão, exclusivamente 
por meio do sistema eletrônico. 
 

6.3.1. Até a abertura da sessão, os licitantes poderão retirar ou substituir a proposta 
anteriormente apresentada (§ 4º do art. 21 do Decreto nº 5.450/2005). 

 

6.4.  Os licitantes deverão apresentar suas propostas de preços, utilizando do campo 
"descrição detalhada do objeto", contendo o seguinte: 
 

a) prazo de validade, a contar da data da abertura da sessão pública, observado o 
disposto no item 6.7 do edital; 
b) descrição de cada item que compõe o lote ofertado, de acordo com o Anexo I-A deste 
edital. 

 

6.4.1. Caso o campo seja preenchido com especificações diversas daquelas 
constantes no edital, deverá haver o cuidado, por parte do licitante, para que a descrição 
complementar não contrarie as especificações constantes no edital, sob pena de 
desclassificação. 
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6.4.2. Serão irrelevantes quaisquer ofertas que não se enquadrem nas especificações 
exigidas, ou anexos não solicitados, considerando-se que pelo preço proposto o licitante 
obrigar-se-á ao fornecimento descrito neste edital. 

 
6.4.2.1.  Entretanto, se da proposta constar condições materiais mais vantajosas 
que as exigidas neste edital elas não serão consideradas para efeito de 
escalonamento de ofertas, mas vincularão o proponente na execução contratual. 

 
6.4.3. Não podem constar da “descrição detalhada do objeto” qualquer tipo de 
identificação da empresa, seja nome, endereço, CNPJ, logotipo, ou qualquer outro dado 
capaz de identificar o licitante. Esta identificação somente constará na proposta ajustada 
encaminhada nos termos do item 10.1. 

 
6.4.4. Em campo próprio deverão ser inseridos marca e modelo do produto ofertado. 

 

6.5. As declarações referidas no subitem 11.1 “c” deverão ser enviadas em campo próprio do 
sistema Comprasnet, no momento da elaboração e envio da proposta pelos fornecedores, as quais 
serão visualizadas pelo Pregoeiro na fase de Habilitação, quando também poderá ser solicitado, via 
chat, pelo Pregoeiro, a alteração ou reenvio das mesmas pelo(s) vencedor(es). 
 

6.6. Nos preços ofertados deverão estar inclusas todas as despesas necessárias à perfeita 
execução das prestações contratuais, tais como tributos, encargos legais, embalagens, frete etc. 
 

6.7. O prazo de validade das propostas será de, no mínimo, 60 (sessenta) dias, contados da 
data de abertura da sessão pública. As propostas que o omitirem ou indicarem prazo de validade 
inferior ao mínimo permitido serão entendidas como válidas pelo período de 60 (sessenta) dias. 
 

6.8. Em caso de divergências verificadas entre as descrições relativas aos objetos desta 
licitação (Anexo I-A) e as descrições constantes no Catálogo de Materiais do “SIASG”, prevalecerão, 
sempre, as descrições constantes neste edital. 
 

6.9. Não serão aceitas propostas alternativas nem submetidas a termo, condição ou encargo. 
 

6.10. Todos os custos decorrentes da elaboração e apresentação de propostas serão de 
responsabilidade exclusiva do licitante, incluindo as transações que forem efetuadas em seu nome no 
sistema eletrônico ou de eventual desconexão. O Tribunal Regional Eleitoral de Alagoas não será 
responsável, em nenhum caso, pelos custos de tais procedimentos. 
 

6.11. O simples envio da proposta será interpretado como concordância com os termos deste 
edital, com o estipulado na Lei nº 10.520, de 17 de julho de 2002, no Decreto nº 5.450, de 31 de 
maio de 2005, e subsidiariamente pela Lei nº 8.666, de 21 de junho de 1993 e suas alterações 
posteriores, salvo se a proposta contiver disposição que contrarie expressamente quaisquer dos 
itens deste edital. 
 
7 - DA SESSÃO PÚBLICA E DIVULGAÇÃO DAS PROPOSTAS. 
 

7.1. O pregoeiro iniciará a sessão pública na data e horário previstos neste edital, via sistema 
eletrônico, com a divulgação das propostas de preços recebidas, as quais deverão estar em perfeita 
consonância com as especificações detalhadas no presente edital. 
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7.2.  As propostas que não atenderem aos requisitos constantes no presente edital ou que 
apresentarem preços manifestamente inexequíveis serão previamente desclassificadas pelo 
pregoeiro. 
 

7.2.1. A desclassificação de proposta será sempre fundamentada e registrada no 
sistema, com acompanhamento em tempo real por todos os licitantes. 

 

7.3.  O sistema ordenará, automaticamente, as propostas classificadas, sendo que somente 
estas participarão da fase de lances. 
 
8 - DA FORMULAÇÃO DOS LANCES. 
 

8.1.  Após a classificação das propostas, o pregoeiro dará início à etapa competitiva, 
oportunidade em que os licitantes poderão encaminhar lances, exclusivamente por meio do sistema 
eletrônico, sendo estes imediatamente informados do seu recebimento e respectivo horário de 
registro e valor. 
 

8.1.1. Os lances deverão ser ofertados pelo valor unitário de cada item que compõe o lote 
ofertado, sendo que o sistema efetuará automaticamente o somatório para efeito de 
escalonamento dos lances. 

 

8.2. Os licitantes poderão oferecer lances sucessivos, observado o horário fixado e as regras 
de aceitação dos mesmos. 
 

8.3. O licitante somente poderá oferecer lance inferior ao último por ele ofertado e registrado 
pelo sistema. 
 

8.4.  Havendo mais de um lance de igual valor, prevalecerá aquele que for recebido e 
registrado primeiro pelo sistema. 
 

8.5. Durante a sessão pública, os licitantes serão informados, em tempo real, do valor do 
menor lance registrado, vedada a identificação do licitante.  
 

8.6.  No caso de desconexão do pregoeiro, no decorrer da etapa competitiva do pregão 
eletrônico, o sistema eletrônico poderá permanecer acessível aos licitantes para a recepção dos 
lances, retomando o pregoeiro, quando possível, a sua atuação no certame, sem prejuízo dos atos 
realizados. 
 

8.6.1.  Quando a desconexão do pregoeiro persistir por tempo superior a 10 (dez) minutos, a 
sessão do pregão eletrônico será suspensa e terá reinício somente após comunicação aos 
licitantes participantes, no endereço utilizado para divulgação desta licitação. 

 

8.7.   A etapa de lances será encerrada por decisão do pregoeiro, mediante 
encaminhamento, pelo sistema eletrônico, de aviso de fechamento iminente dos lances. Após o que 
transcorrerá período de tempo de até 30 (trinta) minutos, aleatoriamente determinado pelo sistema 
eletrônico, findo o qual será encerrada, automaticamente, a recepção de lances. 
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8.8.  Após o encerramento da etapa de lances da sessão pública, o pregoeiro poderá 
encaminhar, pelo sistema eletrônico, contraproposta ao licitante que tenha apresentado lance mais 
vantajoso, para que seja obtida melhor proposta, observado o critério de julgamento, não se 
admitindo negociar condições diferentes daquelas previstas neste Edital. 
 
9 - DO JULGAMENTO DAS PROPOSTAS DE PREÇOS. 
 

9.1.  O pregoeiro efetuará o julgamento das Propostas de Preços pelo critério do menor 
preço por lote, decidindo sobre a aceitação do preço obtido. 
 
9.2.  Como critério de aceitabilidade dos preços, serão admitidos como limites máximos os 
valores estimados pela Administração, ou seja, os preços de referência, disponíveis no Anexo I-A 
deste edital, que representam uma média das várias propostas coletadas no mercado e, de modo 
algum, vinculam a decisão do Pregoeiro, que está autorizado a negociar em busca de preços 
inferiores. 

 
9.2.1. O critério de aceitabilidade será aferido em relação ao valor de cada item e em relação 
ao valor total do lote ofertado. 
 

9.3.  Será considerado vencedor deste pregão o licitante que oferecer o menor preço e tiver 
atendido a todas as exigências editalícias. 
 

9.4.  Analisada a aceitabilidade do preço obtido, o pregoeiro divulgará o resultado de 
julgamento das Propostas de Preços. 

 

9.5.  Se a proposta ou o lance, de menor preço, não for aceitável, ou se o licitante 
desatender às exigências habilitatórias, o pregoeiro examinará a proposta ou o lance subsequente, 
verificando a sua aceitabilidade e procedendo à sua habilitação, na ordem de classificação, e assim 
sucessivamente, até a apuração de uma proposta ou lance que atenda ao edital. 
 

9.5.1.  Ocorrendo a situação a que se refere este item, o pregoeiro poderá negociar 
com o licitante para que seja obtido preço melhor. 

 
10 – DO ENCAMINHAMENTO DA PROPOSTA E DA DOCUMENTAÇÃO. 
 

10.1.  A proposta ajustada ao lance final do licitante vencedor e os documentos exigidos para 
habilitação que não estejam contemplados no SICAF, caso necessário, deverão ser remetidos, como 
anexo, pelo sistema Comprasnet, quando solicitado pelo Pregoeiro. Junto com a documentação 
deverá ser encaminhado, também pelo sistema, os dados do licitante vencedor: Razão Social, 
endereço, telefone/fax, número do CNPJ/MF, banco, agência, número da conta corrente e praça de 
pagamento, podendo ser utilizado para tanto o modelo de planilha para contratação sugerido no 
ANEXO II. 

 

10.2. A licitante também deverá encaminhar, quando solicitado pelo pregoeiro, via sistema, a 
Planilha de Composição de Custos por Item, no modelo do Anexo I-B. 

 
11 - DA HABILITAÇÃO. 
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11 .1. A habilitação do licitante vencedor será verificada mediante a apresentação/obtenção da 
seguinte documentação: 
 

a) Quanto à Qualificação Jurídica e Fiscal: Situação do licitante perante o Sistema de 
Cadastro Unificado de Fornecedores – SICAF – Habilitação Parcial, após a análise e 
julgamento das Propostas de Preços, a ser obtida por meio de extrato “on line” do site do 
Comprasnet. 
 

a1.) Caso conste no cadastro do SICAF algum documento habilitatório com data de 
validade expirada, o pregoeiro poderá consultar o documento do licitante nos sítios 
das entidades responsáveis pelo referido tributo ou abrirá o prazo de 02 (dois) dias 
úteis para que o licitante o encaminhe, via protocolo. 

 
b) Quanto à regularidade trabalhista, esta deverá ser comprovada através de Certidão 
Negativa de Débitos expedida pela Justiça do Trabalho, em conformidade com a Lei 
Federal nº 12.440, de 07 de julho de 2011. 
 
c) Declarações que deverão ser efetuadas em campo específico do sistema Comprasnet, 
no momento da elaboração e envio da proposta, conforme item 6.5. do edital: 
 

c.1) Declaração de inexistência de fatos supervenientes impeditivos à habilitação da 
empresa; 
c.2)  Declaração de que a empresa não emprega menor de dezoito anos em trabalho 
noturno, perigoso ou insalubre, não emprega menor de dezesseis anos, salvo na 
condição de aprendiz, a partir dos quatorze anos; 
c.3)   Declaração de elaboração Independente de Proposta. 

 
11.2. No momento em que forem verificados os documentos relativos à habilitação, o 
pregoeiro deverá verificar, também, a existência de registros impeditivos da contratação no 
Cadastro Nacional de Empresas Inidôneas e Suspensas da Controladoria Geral da União, disponível 
no Portal da Transparência (http://www.portaltransparencia.gov.br). 
 
11.3.  Havendo o registro de Ocorrências Impeditivas Indiretas de licitar, constatado em 
consulta ao SICAF, a empresa será convocada a apresentar, em 48 (quarenta e oito) horas, a contar 
da solicitação do pregoeiro no “chat”, esclarecimentos/documentos, comprovando sua idoneidade. 

 
11.3.1. Havendo necessidade de analisar minuciosamente os documentos exigidos, o 
Pregoeiro suspenderá a sessão, informando no “chat” a nova data e horário para a 
continuidade da mesma. 
 

11.4.  A comprovação da regularidade fiscal das licitantes, obrigatoriamente, Microempresas e 
Empresas de Pequeno Porte, será exigida para efeito de contratação, conforme estipula o art. 42 da 
LC nº 123/2006, observando o que dispõe o art. 4º, do Decreto nº 8.538/2015. 
 

11.4.1.         Na hipótese de haver alguma restrição relativa à regularidade fiscal quando da 
comprovação de que trata o item 11.4., será assegurado prazo de cinco dias úteis, prorrogável 
por igual período, para a regularização da documentação, a realização do pagamento ou 
parcelamento do débito e a emissão de eventuais certidões negativas ou positivas com efeito 
de certidão negativa. 
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11.4.2.   Para aplicação do disposto no subitem 11.4.1, o prazo para regularização fiscal será 
contado a partir da divulgação do resultado da fase de habilitação. 
 
11.4.3. A prorrogação do prazo previsto no subitem 11.4.1., poderá ser concedida, a 
critério da administração pública, quando requerida pelo licitante, mediante apresentação de 
justificativa. 
 
11.4.4. A abertura da fase recursal em relação ao resultado do certame ocorrerá após  os 
prazos de regularização fiscal de que tratam os subitens 11.4.1. e 11.4.3. 
 
11.4.5.           A não regularização da documentação no prazo previsto nos subitens 11.4.1. e 
11.4.3. implicará decadência do direito à contratação, sem prejuízo das sanções previstas no 
art. 87 da Lei nº 8.666, de 1993, sendo facultado à administração pública convocar os 
licitantes remanescentes, na ordem de classificação, ou revogar a licitação. 

 
11.5. Os licitantes que deixarem de apresentar quaisquer dos documentos exigidos para a 
habilitação na presente licitação, ou os apresentarem em desacordo com o estabelecido neste 
Edital ou com irregularidades, ressalvado o disposto na alínea a.1 do item 11.1. e no item 11.4.1, 
serão inabilitados, não se admitindo complementação posterior. 
 
11.6. Não serão aceitos protocolos de entrega ou solicitação de documento em substituição 
aos documentos requeridos no presente Edital. 
 
11.7. Os documentos relacionados neste Edital referir-se-ão sempre ao domicílio da empresa 
licitante cadastrada no SICAF. 
 
11.8. Para fins de habilitação, a verificação pelo TRE/AL nos sítios oficiais de órgãos e 
entidades emissores de certidões constitui meio legal de prova. 
 
12 – DO CRITÉRIO DE DESEMPATE. 
 
12.1. Será assegurado, como critério de desempate, preferência de contratação a 
Microempresas e Empresas de Pequeno Porte, conforme disposto no art. 44 da Lei Complementar nº 
123/2006. 
 

12.1.1. Entende-se por empate aquelas situações em que as propostas apresentadas pelas 
Microempresas e Empresas de Pequeno Porte sejam iguais ou até 5% (cinco por cento) 
superiores à proposta mais bem classificada. 
 
12.1.2. O subitem anterior somente será aplicado quando a melhor oferta inicial não tiver sido 
apresentada por microempresa ou empresa de pequeno porte. 
 
12.1.3. Para identificação da situação de empate, o Sistema de Pregão Eletrônico, após 
encerramento da fase de lances identificará, em coluna própria as Microempresas e Empresas 
de Pequeno Porte participantes, fazendo a comparação entre os valores da primeira colocada, 
caso esta não seja uma Microempresa ou Empresa de Pequeno Porte, e das demais 
Microempresas e Empresas de Pequeno Porte, na ordem de classificação. 

 
12.2. Após o encerramento de todos os itens, para cada item que teve uma empresa de médio 
ou grande porte como vencedora do melhor lance, o sistema selecionará todas as Microempresas e 
Empresas de Pequeno Porte cujo último lance enviado, para o item, seja até 5% (cinco por cento) 
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superior à oferta vencedora. Após este procedimento, o sistema enviará mensagem, via chat, 
informando quais os itens terão desempate no lance. 
 
12.3. Para efeito do disposto no item 12.1, ocorrendo o empate, proceder-se-á da seguinte 
forma: 
 

I – A Microempresa ou Empresa de Pequeno Porte mais bem classificada poderá apresentar 
proposta de preço inferior àquela considerada vencedora do certame, situação em que lhe 
será adjudicado o objeto licitado. Para viabilizar tal procedimento, o Sistema selecionará os 
itens com tais características, disponibilizando-os automaticamente nas telas do pregoeiro e 
fornecedor, encaminhado mensagem também automática, por meio do chat, convocando a 
Microempresa ou Empresa de Pequeno Porte que se encontra em segundo lugar, a fazer sua 
última oferta no prazo de 5 (cinco) minutos, sob pena de decair do direito concedido; 
 
II – Caso a Microempresa ou Empresa de Pequeno Porte classificada em segundo lugar desista 
ou não se manifeste no prazo estabelecido, o Sistema convocará as demais Microempresas ou 
Empresas de Pequeno Porte participantes na mesma condição, na ordem de classificação; 
 
III – Havendo êxito neste procedimento, o Sistema disponibilizará a nova classificação dos 
fornecedores para fins de aceitação. Não havendo êxito, ou não existindo Microempresa ou 
Empresa de Pequeno Porte participante, prevalecerá a classificação inicial; 
 
IV – Caso sejam identificadas propostas de Microempresas ou Empresas de Pequeno Porte 
empatadas em segundo lugar, ou seja, na faixa dos 5% (cinco por cento) da primeira colocada, 
e permanecendo o empate até o encerramento do item, o sistema fará um sorteio eletrônico 
entre tais fornecedores, definindo e convocando automaticamente a vencedora para o 
encaminhamento da oferta final do desempate; 
 
V – A negociação de preço junto ao fornecedor classificado em primeiro lugar, quando houver, 
será sempre após o procedimento de desempate de proposta e classificação final dos 
fornecedores participantes. 

 
12.4. Para todos os cálculos efetuados, serão levadas em consideração duas casas decimais, 
sendo desprezadas as demais.  
 
12.5. Se durante o desempate houver suspensão do pregão ou do item, o tempo será 
interrompido. Quando o pregão ou item for reaberto, o tempo será retomado de onde parou. 
 
13 – DO CRITÉRIO DE PREFERÊNCIA. 

13.1.  Este pregão submete-se às regras relativas ao direito de preferência estabelecidas no 
Decreto nº 7.174/2010. 
 
 
14 - DA IMPUGNAÇÃO E PEDIDOS DE ESCLARECIMENTOS. 
 
14.1. Até 02 (dois) dias úteis antes da data fixada para abertura da sessão pública, qualquer 
pessoa poderá impugnar o ato convocatório do presente pregão, enviando a peça impugnatória ao 
endereço eletrônico slc@tre-al.jus.br. 
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14.1.1. Caberá ao Pregoeiro, auxiliado pela seção responsável pela elaboração do edital, 
decidir sobre a impugnação no prazo de até 24h (vinte e quatro horas). 

 

14.1.2.  Acolhida a impugnação contra o ato convocatório, será definida e publicada nova data 
para realização do certame. 

 

14.2. Os pedidos de esclarecimentos referentes a este Edital deverão ser enviados à Seção de 
Licitações e Contratos, até três dias úteis anteriores à data fixada para a abertura da sessão 
pública, exclusivamente por meio eletrônico via Internet, para o endereço de e-mail: slc@tre-
al.jus.br, cujas respostas serão disponibilizadas nos avisos referentes a este Pregão, no site do 
TRE/AL: www.tre-al.jus.br e no site www.comprasnet.gov.br. 
 
15- DOS RECURSOS. 
 
15.1.  Existindo intenção de interpor recurso, o licitante deverá manifestá-la ao pregoeiro, 
exclusivamente por meio eletrônico, em formulário próprio, explicitando sucintamente suas razões, 
logo após a fase de habilitação. 
 
15.2.  O Pregoeiro informará, via chat, o tempo para a recepção, pelo sistema eletrônico, da 
intenção de recurso, abrindo em seguida este prazo e fechando ao término do tempo informado. 
 
15.3.  Caso tenha havido registro de intenção de manifestação de recurso, o Pregoeiro decidirá 
sobre sua admissibilidade. Sendo admissível a manifestação de recurso registrada, o sistema abrirá 
formulário próprio para o registro das razões do recurso, no prazo de 3 (três) dias, as quais poderão 
ser impugnadas pelos demais licitantes, desde logo intimados para, querendo, apresentar 
contrarrazões em igual prazo, exclusivamente por meio eletrônico, e após julgadas pelo Pregoeiro, 
submeterá a sua decisão à autoridade competente. 

 
15.4.  O acolhimento do recurso implica tão somente na invalidação daqueles atos que não 
sejam passíveis de aproveitamento. 
 
15.5.  A falta de manifestação eletrônica de intenção de recorrer, no prazo estipulado pelo 
Pregoeiro, importará a decadência do direito de recurso e a adjudicação do objeto pelo pregoeiro ao 
vencedor. 
 
16 - DA ADJUDICAÇÃO E HOMOLOGAÇÃO. 
 
16.1.  A adjudicação do objeto do presente certame será viabilizada pelo pregoeiro sempre que 
não houver recurso. 
 
16.2.  A homologação da licitação é de responsabilidade da autoridade competente e só poderá 
ser realizada depois da adjudicação do objeto ao proponente vencedor pelo pregoeiro, ou, quando 
houver recurso, pela própria autoridade competente. 
 
16.3.  Antes da adjudicação pelo pregoeiro, será feita consulta ao CADIN – Cadastro Informativo 
de Créditos não Quitados do Setor Público Federal, nos termos do Inciso III do Art. 6º da Lei nº 
10.522, de 19/07/2002. 
 
17 - DO REAJUSTE DO PREÇO. 
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17.1.  Os preços ofertados serão fixos e irreajustáveis. No entanto, os valores constantes da Ata 
de Registro de Preços admitem revisão na forma disciplinada no Decreto nº 7.892/2013. 
 
18 - DA HOMOLOGAÇÃO, DA ATA DE REGISTRO DE PREÇOS E DA CONTRATAÇÃO. 
 
18.1. A adjudicação do objeto do presente certame será viabilizada pelo pregoeiro sempre que 
não houver recurso. 
 

18.1.1. Antes da adjudicação pelo pregoeiro, será feita consulta ao CADIN – Cadastro 
Informativo de Créditos não Quitados do Setor Público Federal, nos termos do Inciso III do Art. 
6º da Lei 10.522, de 19/07/2002. 

 
18.2. A homologação da licitação é de responsabilidade da autoridade competente e só poderá 
ser realizada depois da adjudicação do objeto ao proponente vencedor pelo pregoeiro, ou, quando 
houver recurso, pela própria autoridade competente. 
 
18.3. Homologado o resultado da licitação, os fornecedores classificados, observado o disposto 
no art. 11 do Decreto nº 7.892/2013, serão convocados para assinar a ata de registro de preços, 
dentro do prazo e condições estabelecidos no subitem 18.3.1., podendo ser prorrogado uma vez, 
por igual período, quando solicitado pelo fornecedor e desde que ocorra motivo justificado aceito 
pela administração. 
 

18.3.1. O cadastro de reserva dos fornecedores classificados a que se refere o item anterior 
será elaborado desde que viabilizado pelo sistema Comprasnet, tal como previsto no art. 26 do 
decreto acima citado. 
 
18.3.2. O licitante vencedor deverá devolver a Ata de Registro de Preços assinada dentro do 
prazo de 05 (cinco) dias úteis, a contar do recebimento da convocação para assinatura do 
documento, em conformidade com o previsto no art. 64 da Lei n. 8.666/1993. 

 
18.4. É facultado à administração, quando o convocado não assinar a ata de registro de preços 
no prazo e condições estabelecidos, convocar os licitantes remanescentes, na ordem de 
classificação, para fazê-lo em igual prazo e nas mesmas condições propostas pelo primeiro 
classificado. 
 
18.5. A ata de registro de preços implicará compromisso de fornecimento nas condições 
estabelecidas, após cumpridos os requisitos de publicidade. 
 
18.6. A recusa injustificada de fornecedor classificado em assinar a ata, dentro do prazo 
estabelecido no subitem 18.3.2, ensejará a aplicação das penalidades aludidas no item 18.12 deste 
edital, bem como às do art. 28 do Decreto n. 5.450/2005. 
 
18.7. A contratação com os fornecedores registrados será formalizada pelo órgão interessado 
por intermédio de instrumento contratual, emissão de nota de empenho de despesa, autorização de 
compra ou outro instrumento hábil, conforme o art. 62 da Lei nº 8.666, de 1993. 
 
18.8. Após a devolução da Ata de Registro de Preços assinada, a licitante poderá receber a 
Nota de Empenho e a Autorização de Fornecimento, devendo confirmar o seu recebimento. 
 
18.9. A recusa na aceitação da nota de empenho e da Autorização de Fornecimento deverá ser 
expressa, escrita e justificada, o que será encaminhado para a autoridade competente que 
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procederá à análise dos motivos acostados pelo licitante, decidindo acerca da aceitabilidade ou não 
da justificativa. 
 
18.10. Caso a justificativa não seja encaminhada na forma descrita ou esta não seja aceita pela 
autoridade competente, o prazo para a entrega continuará fluindo normalmente, e em não sendo 
cumprido, sujeitará o licitante às penalidades cabíveis. 
 
18.11. Os contratos decorrentes do Sistema de Registro de Preços poderão ser alterados, 
observado o disposto no art. 65 da Lei nº 8.666, de 1993 e no art. 12, § 3º do Decreto nº 
7.892/2013. 
 
18.12. O registro do fornecedor será cancelado quando: 
 
a) descumprir as condições da Ata de Registro de Preços; 
 
b) não retirar a nota de empenho ou instrumento equivalente no prazo estabelecido pela 
Administração, sem justificativa aceitável; 
 
c) não aceitar reduzir o seu preço registrado, na hipótese deste se tornar superior àqueles 
praticados no mercado; ou 
 
d) sofrer sanção prevista nos incisos III ou IV do caput do art. 87 da Lei nº 8.666, de 1993, ou no art. 
7º da Lei nº 10.520, de 2002. 
 

18.12.1. O cancelamento de registros nas hipóteses previstas nas alíneas “a”, “b” e “d” 
do subitem 18.12. será formalizado por despacho do órgão gerenciador, assegurado o 
contraditório e a ampla defesa. 

 
18.12.2. O cancelamento do registro de preços poderá ocorrer por fato superveniente, 
decorrente de caso fortuito ou força maior, que prejudique o cumprimento da ata, 
devidamente comprovados e justificados: 

 
a) por razão de interesse público; ou 
 
b) a pedido do fornecedor. 

 
18.13. O licitante vencedor somente poderá subcontratar, em parte, o objeto desta licitação, se 
for conveniente para a Administração deste Tribunal, mediante prévia e escrita autorização desta, 
sob pena de sofrer as sanções contratuais e legais. 
 

18.13.1. O licitante vencedor não poderá transferir a terceiros nenhuma responsabilidade, em 
caso de subcontratação autorizada. 

 
18.14. O licitante vencedor obriga-se a manter, durante a vigência do Registro de Preços, em 
compatibilidade com as obrigações por ele assumidas, todas as condições de habilitação e 
qualificação exigidas na licitação, renovando as certidões e encaminhando-as ao Tribunal Regional 
Eleitoral de Alagoas, no prazo máximo de 48 (quarenta e oito) horas a partir da solicitação das 
mesmas. 
 
18.15. A Ata de Registro de Preços, durante sua vigência, poderá ser utilizada por qualquer 
órgão ou entidade da administração pública federal que não tenha participado do certame 
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licitatório, mediante anuência do órgão gerenciador, observadas, ainda, as demais regras impostas 
no art. 22 do Decreto n.º 7.892/2013. 
 
18.16. As aquisições ou contratações adicionais a que se refere o subitem 18.15 não poderão 
exceder, por órgão ou entidade, a cinquenta por cento dos quantitativos dos itens do instrumento 
convocatório e registrados na ata de registro de preços para o órgão gerenciador e órgãos 
participantes. 
 
18.17. O quantitativo decorrente das adesões à ata de registro de preços não poderá exceder, 
na totalidade, ao dobro do quantitativo de cada item registrado na ata de registro de preços para o 
órgão gerenciador e órgãos participantes, independente do número de órgãos não participantes que 
aderirem.  
 
19 – DO RECEBIMENTO DO OBJETO. 
 
19.1.  O objeto deverá ser entregue, no prazo máximo de 90 (noventa) dias corridos, contados do 
recebimento da Nota de Empenho ou Ordem de Fornecimento, por e-mail ou ofício, o que ocorrer 
primeiro, no horário de expediente normal, de segunda a sexta-feira, na Seção de Almoxarifado do 
Tribunal Regional Eleitoral de Alagoas, localizada na Avenida Menino Marcelo (antiga via expressa), 
nº 7.200 D – Serraria, Maceió/AL, CEP: 57046-005, sob agendamento através do telefone (82) 3328-
1947. 
 
19.2. O objeto será recebido: 

 
a) provisoriamente, para que seja feita a verificação da conformidade dos mesmos com 
as especificações. 
 

b) definitivamente, após avaliação e homologação pelos responsáveis técnicos do Tribunal, da 
seguinte forma: 

b.1) O exame para comprovação das características técnicas consistirá em avaliações e 
testes não-destrutivos, por amostragem realizados em duas etapas: 

a. Primeira: inspeção visual de todos os equipamentos entregues; 
b. Segunda: testes funcionais de configuração e desempenho, em, no mínimo, 10% (dez 

por cento) e não menos do que 01 (um) dos equipamentos recebidos. O Tribunal 
poderá, a seu critério, executar os testes nos demais equipamentos, dentro de 
um critério de razoabilidade, podendo chegar a 100% dos quantitativos, mas dentro de 
um prazo máximo de 30 (trinta) dias corridos e contados de cada lote de 
equipamentos. 

b.2) As especificações serão avaliadas também por meio de documentos técnicos que 
acompanham os equipamentos, informações fornecidas pela Contratada e disponível no 
sítio do fabricante; 

b.3) A comissão do Tribunal deverá, após a comprovação do perfeito funcionamento dos 
equipamentos e adequação às especificações técnicas, emitir e assinar o Termo de 
Recebimento Definitivo. 

19.3. O produto será rejeitado no caso de incompatibilidade com as especificações previstas 
na proposta ou quando inadequado à sua utilização. 
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19.4. O prazo para a Secretaria competente proceder às verificações, após o recebimento 
provisório, será de 05 (cinco) dias úteis, quando deverá se manifestar, aceitando ou recusando o 
item objeto do fornecimento. 
 
19.5. Os recebimentos provisório e definitivo se darão mediante formulário próprio. 
 
19.6. O recebimento definitivo não exime o fornecedor de responder pelos vícios aparentes e 
ocultos segundo as disposições deste termo e as normas de proteção ao consumidor. 
 
19.7. O objeto que estiver em desacordo com as especificações do edital terá seu recebimento 
recusado, devendo o fornecedor, dentro do prazo de 10 (dez) dias corridos, substituir o produto 
adequadamente, sujeitando-se à multa prevista na Seção 18. 
 
20 – DAS SANÇÕES ADMINISTRATIVAS. 
 
20.1.  Com fundamento no artigo 7º da Lei nº 10.520/2002 e, subsidiariamente, nos artigos 86 e 
87 da Lei 8.666/1993, a Contratada ficará sujeita, assegurada prévia e ampla defesa, às seguintes 
penalidades:  
 
a. Advertência:  
 

i. A Contratada será notificada formalmente em caso de descumprimento de obrigação 
contratual e terá que apresentar as devidas justificativas em um prazo de até 5 (cinco) dias úteis 
após o recebimento da notificação; e 

 
ii. Caso não haja manifestação dentro desse prazo ou se entenda serem improcedentes as 
justificativas apresentadas, a Contratada será advertida. 

 
b. Multa de: 

 
i. 0,5% (meio por cento) por dia, e por ocorrência, sobre o valor do objeto com atraso 
injustificado, limitada a incidência a 20 (vinte) dias corridos; 

- No caso de atraso injustificado na entrega do objeto por prazo superior a 20 
(vinte) dias corridos, com a aceitação pela Administração, será aplicada a multa de 10% sobre o 
valor da Ordem de Fornecimento; e 

-  No caso de atraso injustificado na prestação dos serviços por prazo superior a 20 (vinte) dias 
corridos, com a não aceitação pela Administração, será aplicada a penalidade 20% sobre o valor 
da Ordem de Fornecimento, no caso de inexecução total da obrigação, podendo haver, ainda, o 
cancelamento do registro de preços do Fornecedor. 

ii. 10% sobre o valor constante da Ordem de Fornecimento, no caso de inexecução parcial 
da obrigação assumida; 

iii. 20% (vinte por cento) sobre o valor adjudicado, em caso de inexecução total da obrigação 
assumida; 

iv. 10% sobre o valor global da Ata de Registro de Preços, na hipótese de recusa em assinar a Ata 
ou retirar a Ordem de Fornecimento; 

Minuta de edital de pregão (0574599)         SEI 0008478-63.2018.6.02.8000 / pg. 363



 
TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS 

SEÇÃO DE LICITAÇÕES E CONTRATOS 

 

17 
 

 

 

c. Impedimento de licitar e contratar com a União e descredenciamento do SICAF pelo prazo de até 
5 (cinco) anos, sem prejuízo das demais penalidades legais; e  
 
d. Declaração de inidoneidade para licitar ou contratar com a Administração Pública.  

 
20.2.    O cometimento reiterado de atrasos injustificados dos prazos previstos para 
entrega/solução do chamado de garantia dos equipamentos poderá resultar no cancelamento do 
instrumento de fornecimento com a Contratada. 
 
20.3.   As sanções previstas nos itens "20.1.a", “20.1.c” e “20.1.d” poderão ser aplicadas, 
cumulativamente ou não, à pena de multa.  
 
20.4.   O valor da multa, aplicada após o regular processo administrativo, será descontado de 
pagamentos eventualmente devidos à contratada ou cobrado judicialmente;  
 
20.5.   Excepcionalmente, ad cautelam, a Administração poderá efetuar a retenção do valor 
presumido da multa, antes da instauração do regular procedimento administrativo. 
 
20.6.   O valor da multa, apurado após regular procedimento administrativo, será descontado 
dos pagamentos eventualmente devidos pelo TRE/AL ou cobrado judicialmente. 
 
20.7.   Na aplicação das penalidades previstas nesta Seção a autoridade competente sempre 
se valerá dos princípios da proporcionalidade, da razoabilidade e da prevalência e indisponibilidade 
do interesse público, em decorrência de circunstâncias fundamentadas em fatos comprovados. 
 
20.8.   O licitante contratado, quando não puder cumprir os prazos estipulados para o 
fornecimento do material, total ou parcialmente, deverá apresentar justificativa por escrito, 
devidamente comprovada, e em documento contemporâneo à sua ocorrência, acompanhada de 
pedido de prorrogação, nos casos de ocorrência de fato superveniente, excepcional ou imprevisível, 
estranho à vontade das partes, que altere fundamentalmente as condições do contrato, ou que 
impeça a sua execução, por fato ou ato de terceiro reconhecido pela Administração.  
 
20.9.  Do ato que aplicar as penalidades caberá recurso na forma do art. 109 da Lei nº 
8.666/1993. 
 
20.10.  Se o licitante contratado não recolher o valor da multa que lhe for aplicada, dentro de 05 
(cinco) dias úteis a contar da data da intimação para o pagamento, a importância será descontada 
automaticamente, ou ajuizada a dívida, consoante o § 3º do art. 86 e § 1º do art. 87 da Lei nº 
8.666/1993, acrescida de juros moratórios de 0,5% (meio por cento) ao mês. 
 
20.11.  O TRE/AL promoverá o registro no SICAF de toda e qualquer penalidade imposta ao 
licitante contratado. 
 
20.12.  O período de atraso será contado em dias corridos. 
 
20.13. No caso de aplicação de penalidade em que a contratada tenha que pagar multa através 
de Guia de Recolhimento da União – GRU, e não o faça no devido prazo, o índice utilizado para 
atualização do valor será o IPCA. 
 
20.14. A data a ser utilizada como referência para a atualização do débito será a da publicação 
da decisão da aplicação da penalidade no Diário Eletrônico.  
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20.15.  Fica estabelecido que os casos omissos serão resolvidos entre as partes contratantes, 
respeitados o objeto da presente licitação, a legislação e demais normas reguladoras da matéria, 
em especial as Leis nos 8.666/1993 e  10.520/2002, aplicando-lhes, quando for o caso, 
supletivamente, os princípios da Teoria Geral dos Contratos e as disposições do Direito Privado. 
 
20.16.  Os atos administrativos de aplicação das sanções, com exceção de advertência, multa de 
mora e convencional, serão publicados resumidamente no Diário Oficial da União. 
 
21 - DO PAGAMENTO. 
 
21.1.  O pagamento será efetuado mediante ordem bancária de crédito em conta corrente, em 
até 10 (dez) dias, após o recebimento da Nota Fiscal respectiva, a qual deverá ser entregue 
somente após a prestação dos serviços, devendo a contratada atender os seguintes requisitos: 

a) Apresentação de nota fiscal de acordo com a legislação vigente à época da emissão (nota 
fiscaleletrônica, se for o caso), acompanhada do Certificado de Regularidade do FGTS – CRF, 
comprovando regularidade com o FGTS; da Certidão Conjunta Negativa de Débitos Relativos a 
Tributos Federais e à Dívida Ativa da União, que incluindo as referentes a contribuições 
previdenciárias, expedida pela Secretaria da Receita Federal; e da Certidão Negativa de 
Débitos Trabalhistas – CNDT, emitida pela Justiça do Trabalho; e da prova de regularidade para 
com as Fazendas Estadual do domicílio ou sede do Fornecedor; e 

b) Inexistência de fato impeditivo para o qual tenha concorrido o Fornecedor. 

21.2.  Eventuais penalidades poderão ser descontadas do pagamento. 
 
21.3.  Em nenhuma hipótese haverá antecipação de pagamento. 
 
21.4.  O TRE/AL, por ocasião de cada pagamento, fará as retenções e recolhimentos fiscais 
determinados pela legislação tributária. 
 
21.5.  Se a empresa for optante pelo SIMPLES, deverá anexar à nota fiscal documento que 
comprove tal opção, para que sobre o valor do pagamento não incidam as retenções de que trata o 
item anterior. 
 
21.6.  Havendo atraso no pagamento, o valor devido deverá ser acrescido de encargos 
moratórios, apurados desde a data do primeiro dia útil do atraso, até a data do efetivo pagamento, 
desde que o contratado não tenha concorrido para tanto, mediante a aplicação da seguinte 
fórmula: 
 
EM = I x N x VP, 
 
Onde: 
EM= Encargos Moratórios 
N= Número de dias entre a data prevista para o pagamento e a do efetivo pagamento; 
VP = Valor da parcela a ser paga; 
I= Índice de atualização financeira= 0,0001644, assim apurado: 
 
I = (TX/100)                  I= (6/100)           I = 0,0001644 
         365                             365 
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TX= Percentual de Taxa Anual= 6% 

21.7.  Nenhum pagamento será efetuado à Contratada enquanto pendente de liquidação 
qualquer obrigação. Esse fato não será gerador de direito a reajustamento de preços ou a 
atualização monetária. 

22 – DA DOTAÇÃO ORÇAMENTÁRIA. 
 
22.1.  As despesas decorrentes da execução do contrato correrão à conta dos recursos 
lançados na Proposta Orçamentária Anual deste Tribunal para o exercício 2019, alocados no 
Programa de Trabalho - PTRES nº 084621 (Julgamento de causas e gestão administrativas) - Natureza 
da Despesa nº 44.90.52 (Equipamentos e Material Permanente) e 33.90.39 (Outros Serviços de 
Terceiros - Pessoa Jurídica). 
 
22.2.  As despesas referentes aos exercícios subsequentes correrão à conta das dotações 
orçamentárias respectivas. 
 
23 - DAS OBRIGAÇÕES DO ÓRGÃO GERENCIADOR. 
 
23.1. São obrigações do Órgão Gerenciador: 
 

a) Gerenciar a presente Ata, indicando, sempre que solicitado, o nome do detentor da ata, o 
preço, e as especificações dos materiais registrados, observada a ordem de classificação 
indicada na licitação; 
 
b) Observar para que, durante a vigência da presente ata, sejam mantidas todas as condições 
de habilitação e qualificação exigidas na licitação, bem assim, a compatibilidade com as 
obrigações assumidas; 
 
c) Conduzir eventuais procedimentos administrativos de renegociação de preços registrados, 
para fins de adequação às novas condições de mercado, e de aplicação de penalidades; 
 
d) Acompanhar a evolução dos preços de mercado, com a finalidade de verificar sua 
compatibilidade com aqueles registrados na Ata; 
 
e) Acompanhar e fiscalizar o cumprimento das condições ajustadas na presente Ata; 
 
f) Aplicar, garantida a ampla defesa e o contraditório, as penalidades decorrentes do 
descumprimento do pactuado na ata de registro de preços ou do descumprimento das 
obrigações contratuais, em relação às suas próprias contratações; 
 
g) Consultar o detentor da ata registrada (observada a ordem de classificação) quanto ao 
interesse em fornecer o material a outro(s) órgão(s) da Administração Pública que externe(m) 
a intenção de utilizar a presente Ata, conforme subitem 18.15. 

 
23.2. São, ainda, obrigações do órgão gerenciador da ata, na condição de contratante: 

 

a) Efetuar o pagamento à Contratada, após o recebimento definitivo; 
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b) Acompanhar e fiscalizar a execução do objeto da Ata de Registro de Preços e 
do(s) contrato(s) dela decorrentes, por meio de servidor(es) designado(s), 
de modo a garantir o fiel cumprimento do mesmo e da proposta; 

c) Manter arquivo, junto ao processo administrativo ao qual está vinculado o presente termo,  
toda a documentação referente ao mesmo; 

d) Proporcionar todas as facilidades indispensáveis à boa execução das obrigações contratuais; 
e 

e) Aplicar as sanções conforme previsto no contrato, assegurando à Contratada o contraditório 
e ampla defesa. 

24 - DAS OBRIGAÇÕES DO DETENTOR DA ATA. 
 

24.1.  São obrigações do detentor da Ata: 
 

a) Providenciar a imediata correção de deficiências, falhas ou irregularidades constatadas pelo 
ÓRGÃO GERENCIADOR referentes às condições firmadas na presente Ata; 
 
b) Viabilizar o atendimento das condições firmadas a partir da data da publicação da presente 
Ata; 
 
c) Manter, durante o prazo de vigência da presente Ata, todas as condições de idoneidade 
exigidas na licitação, além de se sujeitar às demais disposições do Código de Proteção e 
Defesa do Consumidor (Lei n° 8.078/90) que sejam compatíveis com o regime de direito 
público; 
 
d) Informar, no prazo máximo de 05 (cinco) dias úteis, contados do recebimento da 
notificação, quanto à aceitação ou não do fornecimento de material a outro órgão da 
Administração Pública (não participante) que venha a manifestar o interesse de utilizar a 
presente Ata, conforme item 18.15. 

 
24.2. São ainda obrigações do detentor da Ata, na condição de contratado: 

 
a) Executar o contrato em estrita conformidade com as disposições e especificações do 
Edital e com os termos da proposta de preços; 

b) Fornecer os equipamentos conforme especificações, quantidades, prazos e demais 
condições estabelecidas no Edital, na Ata de Registro de Preços, na Ordem de 
Fornecimento e na Proposta de preços; 

c) Fornecer a documentação necessária à instalação e à operação dos produtos 
(manuais, termos de garantia, etc.), completa, atualizada e em português do Brasil, caso 
exista, ou em inglês; 

d) Disponibilizar Central de Atendimento para a abertura e fechamento de chamados 
técnicos, conforme períodos, horários e condições estabelecidas no Edital e em seus 
Anexos; 

e) Comunicar formal e imediatamente ao Gestor ou Responsável Técnico da 
Administração sobre mudanças nos dados para contato com a Central de Atendimento; 

f) Prestar as informações e os esclarecimentos que venham a ser solicitados pelo 
representante da Administração, referentes a qualquer problema detectado ou ao 
andamento de atividades da garantia; 
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g)  Responder por quaisquer prejuízos que seus profissionais causarem ao patrimônio da 
Administração ou a terceiros, por ocasião da execução do objeto, procedendo 
imediatamente aos reparos ou às indenizações cabíveis e assumindo o ônus decorrente; 

h) Responsabilizar-se integralmente pelo fornecimento dos equipamentos e pela 
execução dos serviços de garantia técnica, primando pela qualidade, desempenho, 
eficiência e produtividade na execução dos trabalhos, dentro dos prazos estipulados e 
cujo descumprimento será considerado infração passível de aplicação das penalidades 
previstas no Termo de Referência (Anexo I); 

i) Comunicar ao Gestor ou Responsável Técnico, formal e imediatamente, todas as 
ocorrências anormais e/ou que possam comprometer a execução do objeto; 
 
j) Manter sigilo sobre todo e qualquer assunto de interesse da Administração ou de 
terceiros de que tomar conhecimento em razão da execução do objeto, respeitando 
todos os critérios estabelecidos, aplicáveis aos dados, informações, regras de negócios, 
documentos, entre outros pertinentes, sob pena de responsabilidade civil, penal e 
administrativa; 

 
k) Cumprir e garantir que seus profissionais estejam cientes, aderentes e obedeçam 
rigorosamente às normas e aos procedimentos estabelecidos na Política de Segurança da 
Informação do TRE/AL; 

 
l) Responsabilizar-se pela conservação dos ambientes onde desempenhe as atividades 
necessárias para prestar a garantia on-site; 

 
m) Prestar as informações e os esclarecimentos que venham a ser solicitados pela 
Administração, referentes a qualquer problema detectado ou ao andamento de 
atividades da garantia técnica. 
 
n) Indicar endereço eletrônico (e-mail) para o recebimento de expedientes/notificações 
enviadas pelo TRE/AL, sendo considerados válidos todos os expedientes/notificações 
enviadas ao endereço eletrônico indicado; 
 
o) Manter durante a execução do contrato todas as condições que culminaram em sua 
habilitação, principalmente a regularidade fiscal e previdenciária, condições de 
idoneidade exigidas na licitação e outras previstas na legislação vigente e na aplicável à 
natureza dos serviços objeto da contratação; 
 
p) Aceitar o cancelamento da ordem de fornecimento por parte da Administração, no 
caso de fornecimento/entrega, em final de exercício e posterior ao dia 15 de dezembro 
ou dia útil imediatamente subsequente, em decorrência dos efeitos da Emenda 
Constitucional nº 95/2016, sem a reversão de qualquer ônus à Administração. 
 
q) Apresentar certidões de quitação junto à Receita Federal, Dívida Ativa da União, INSS, 
FGTS e Fazenda Municipal ou estar registrada junto ao SICAF em condição regular; 
 
r) Acatar outras determinações previstas na legislação aplicável à natureza do objeto 
deste contrato; 
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s) Cumprir com outras obrigações decorrentes da aplicação do Código de Proteção e 
Defesa do Consumidor (Lei nº 8.078/1990) que sejam compatíveis com o regime de 
Direito Público. 

 
 
25 - DA PUBLICIDADE. 
 
25.1. O preço registrado com indicação dos fornecedores será divulgado no Portal de Compras 
do Governo federal e ficará disponibilizado durante a vigência da ata de registro de preços, em 
conformidade com o disposto no art. 11, inciso II do Decreto n.º 7.892/2013 combinado com o art. 
15, 2º da Lei nº 8.666/93. 
 
25 – DA VEDAÇÃO DE AQUISIÇÃO SEPARADA DOS ITENS. 
 
25.1. É vedada a aquisição separada de itens para os quais, o fornecedor convocado para 
assinar a ata não tenha apresentado o menor preço entre todos os licitantes. 
 
26 - DISPOSIÇÕES GERAIS. 
 
26.1.  É assegurado ao TRE/AL, no interesse da Administração, revogar o certame, ou, no caso 
de vício insanável (ilegalidade), anulá-lo, no todo ou em parte, dando ciência aos participantes, na 
forma da legislação vigente. 
 
26.2.  As proponentes assumem todos os custos de preparação e apresentação de suas 
propostas e o TRE/AL não será, em nenhum caso, responsável por esses custos, 
independentemente da condução ou do resultado do processo licitatório. 
 
26.3.   As proponentes serão responsáveis pela fidelidade e legitimidade das informações e dos 
documentos apresentados em qualquer fase da licitação. 
 
26.4.  Não havendo expediente, ou ocorrendo qualquer fato superveniente que impeça a 
realização do certame na data marcada, a sessão será transferida para o primeiro dia útil 
subsequente, devendo o Pregoeiro informar sobre o adiamento no ambiente do Comprasnet, com 
antecedência mínima de 24 (vinte e quatro) horas. 
 
26.5.  Na contagem dos prazos estabelecidos neste Edital, excluir-se-á o dia do início e incluir-
se-á o do vencimento. Só se iniciam e vencem os prazos em dias de expediente no TRE/AL. 
 
26.6.  No julgamento da habilitação e das propostas, o pregoeiro poderá sanar erros ou falhas 
que não alterem a substância das propostas, dos documentos e sua validade jurídica, mediante 
despacho fundamentado, registrado em ata e acessível a todos, atribuindo-lhes validade e eficácia 
para fins de habilitação e classificação. 
 
26.7.  As normas que disciplinam este Pregão serão sempre interpretadas em favor da 
ampliação da disputa entre as empresas interessadas, sem comprometimento da segurança do 
futuro contrato. 
 
26.8.  Havendo divergência entre o edital e seus anexos, prevalecerá o determinado neste 
edital. 
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26.9.  O endereço para vistas e protocolo de documentos, é o seguinte: Avenida Aristeu de 
Andrade, nº 377, 6º andar - COMAP/Seção de Licitações e Contratos, bairro Farol, CEP: 57051-090, 
Maceió/AL, Fone: (82) 2122-7764/7765. 
 
26.10. Todos os horários estabelecidos neste Edital, no aviso e durante a sessão pública, 
observarão, para todos os efeitos, o horário de Brasília, Distrito Federal, inclusive para contagem de 
tempo e registro no sistema eletrônico e na documentação relativa ao certame. 
 
26.11. A homologação do resultado desta licitação não implicará direito à contratação. 
 
26.12. Aos casos omissos, aplicar-se-ão as demais disposições da Lei nº 10.520/2002, do 
Decreto nº 5.450/2005 e alterações e da Lei nº 8.666/1993. 
 
26.13. O Edital e seus anexos poderão ser lidos na sala da Seção de Licitações e Contratos, 
COMAP, no endereço especificado no item 26.9, no caso de ser retirado em Maceió/AL, ou ainda, 
nos sites www.tre-al.jus.br e www.comprasnet.gov.br, gratuitamente. 
 
26.14. Fazem parte integrante deste Edital os seguintes Anexos: 
 

ANEXO I – Termo de Referência; 
ANEXO I–A – Especificações dos lotes, itens, quantitativos a serem adquiridos e preços 
máximos admitidos; 
ANEXO I-B - Planilha de Composição de Custos por Item; 
ANEXO II – Planilha para preenchimento dos dados do Contrato (Sugestão); 
ANEXO III – Minuta da Ata de Registro de Preços. 

 
26.15. Fica eleito o Foro da Justiça Federal em Maceió - Seção Judiciária do Estado de Alagoas, 
para dirimir quaisquer dúvidas ou controvérsias oriundas desta licitação, que não puderem ser 
solucionadas administrativamente. 

 
 

Maceió/AL, XX de XXXX de 2019. 
 
 

Ingrid Pereira de Lima Araújo 
Chefe da Seção de Licitações e Contratos  
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ANEXO I 
 

TERMO DE REFERÊNCIA  
 

01. Objeto Registro de Preço para aquisição de componentes de rede (Networking) 

02. Quantidade 

LOTE 01 - SOLUÇÃO PARA REDE CABEADA 

ITEM DESCRIÇÃO DOS PRODUTOS/SERVIÇOS QTD 

ITEM 
01 

SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 
PARA REDE CABEADA 

01 

ITEM 
02 

LICENCIAMENTO ADICIONAL PARA SISTEMA DE 
GERENCIAMENTO HPE IMC 

03 

ITEM 
03 

LICENCIAMENTO ADICIONAL DO MÓDULO DE ANÁLISE DE 
TRAFEGO DO SISTEMA DE GERENCIAMENTO HPE IMC 

02 

ITEM 
04 

LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE 
PERFIL E CONTROLE DE ACESSO 

02 

ITEM 
05 

SWITCH DE DISTRIBUIÇÃO COM 16 PORTAS SFP+ E SUPORTE 
A MÓDULOS DE EXPANSÃO 

06 

ITEM 
06 

MÓDULO COM 4 PORTAS SFP+ PARA SWITCH DE 
DISTRIBUIÇÃO 

16 

ITEM 
07 

MÓDULO DE STACKING COM 4 PORTAS PARA SWITCH DE 
DISTRIBUIÇÃO 

06 

ITEM 
08 

SWITCH DE ACESSO L3 COM 48 PORTAS GIGABIT E 4SFP+ 50 
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ITEM 
09 

SWITCH DE ACESSO L3 COM 24 PORTAS GIGABIT E 4SFP+ 40 

ITEM 
10 

SWITCH DE ACESSO L2 COM 24 PORTAS GIGABIT E 4SFP 50 

ITEM 
11 

SWITCH DE ACESSO L2 COM 48 PORTAS GIGABIT E 4SFP 40 

ITEM 
12 

GBIC 10GB PARA ATÉ 300M 50 

ITEM 
13 

CABO DAC 10 GBPS DE 1M 30 

ITEM 
14 

CABO DAC 10 GBPS DE 3M 30 

ITEM 
15 

GBIC 1GB PARA ATÉ 500M 10 

ITEM 
16 

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA SWITCHS DE REDE 

05 

ITEM 
17 

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO 

01 

ITEM 
18 

TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE SWITCHES 04 

ITEM 
19 

TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE 
ACESSO 

04 

LOTE 02 - SOLUÇÃO DE REDE WIRELESS 

ITEM DESCRIÇÃO DOS PRODUTOS/SERVIÇOS QTD 

ITEM 
20 

SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 
PARA REDE WIRELESS 

01 

ITEM 
21 

SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS 01 

ITEM 
22 

LICENÇAS ADICIONAIS PARA SOLUÇÃO DE GERENCIAMENTO 
DE REDE WIRELESS 

200 

ITEM 
23 

LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE 
PERFIL E CONTROLE DE ACESSO 

02 

ITEM CONTROLADORA WLAN 04 
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24 

ITEM 
25 

LICENÇAS ADICIONAIS PARA CONTROLADORA WLAN 200 

ITEM 
26 

PONTO DE ACESSO INTERNO TIPO 01 100 

ITEM 
27 

PONTO DE ACESSO INTERNO TIPO 02 100 

ITEM 
28 

INJETOR POE PARA PONTOS DE ACESSO TIPO 1 100 

ITEM 
29 

INJETOR POE PARA PONTOS DE ACESSO TIPO 2 100 

ITEM 
30 

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA SOLUÇÃO DE GERENCIAMENTO 

01 

ITEM 
31 

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO 

01 

ITEM 
32 

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA PONTOS DE ACESSO 

05 

ITEM 
33 

TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE ARQUITETURA 
WLAN 

04 

ITEM 
34 

TREINAMENTO BÁSICO DA SOLUÇÃO DE GERENCIAMENTO 04 

ITEM 
35 

TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE 
ACESSO 

04 

 

03. Resumo da 
Especificação do 
Objeto 

Por se tratar de quantidade elevada de itens pertencentes a lotes específicos, 
o detalhamento das especificações está constante no DETALHAMENTO DO 
OBJETO (Art. 18, § 3º, III). 

04. Valor 
Estimado 

Os custos totais projetados, por certo, serão objeto de levantamento por 
parte da Seção de Compras, em momento posterior. 
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05. Justificativa 

 A dependência tecnológica para o adequado funcionamento de qualquer 
instituição é na prática, total; 

 A malha de comunicação de rede interna é primordial para  acesso aos 
sistemas e serviço informatizados e desta maneira essencial; 

 Grande parte dos equipamentos de rede do Tribunal está defasado 
tecnologicamente,  fora de garantia ou na iminência de término da 
mesma; 

 Permitir a qualificação da equipe da CONIF para o gerenciamento das 
soluções a serem adquiridas; 

 Maiores detalhes disponíveis no Item 2 do Documento de Oficialização 
da Demanda. 

06. Prazo de 
Entrega 

O prazo máximo para o fornecimento das licenças é de 90 (noventa) dias 
corridos após o recebimento da ordem de fornecimento, nota de empenho ou 
documento equivalente. Não podendo ultrapassar, conforme o caso, o dia 15 de 
dezembro ou dia útil subsequente considerado cada exercício individualmente, 
em decorrência dos efeitos da Emenda Constitucional nº 95/2016 

07. Adjudicação 

Por Lote. 

Justificativa: Plena exigência de total compatibilidade e interoperabilidade entre 
em componentes do respectivo lote, como também quanto à solução de 
gerenciamento em uso no TRE/AL. 

08. Classificação 
Orçamentária 

(A cargo da COFIN). 

09. Local de 
Entrega 

Almoxarifado do Tribunal Regional Eleitoral de Alagoas 

Av. Menino Marcelo, 7200D, Serraria 

Maceió – AL CEP 57046-005 Tel.: (82) 3328-1947 

Horário: De segunda-feira a quinta-feira das 13 às 19h e sexta-feira das 
7h30min Às 13h30min. 

10. Unidade 
Fiscalizadora 

SEGI/CIE/STI 

11. Unidade 
Gestora 

SAD 

12. Sanções 
Administrativas 

Vide 

Item 3.2 Forma de Execução e de Gestão do Contrato (Art. 18, § 3º, III, a) 
Subitem Penalidades (Art. 18, § 3º, III, a, 11) 

13. Prazo de 
Pagamento 

Vide  

Item 3.2 Forma de Execução e de Gestão do Contrato (Art. 18, § 3º, III, a) 
Subitem Forma de Pagamento (Art. 18, § 3º, III, a, 7) 

14. Estratégia de 
Recebimento 

Vide  

Item 3.2 Forma de Execução e de Gestão do Contrato (Art. 18, § 3º, III, a) 
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Subitem Recebimento do Objeto: 

15. Modalidade e 
Tipo de Licitação 

Vide 

2.11 Modalidade, Tipo de Licitação, Critérios de Habilitação e Atendimento aos 
Requisitos (Art. 18, § 3º, II, j, IV e V) 

  

1. OBJETO (Art. 18, §3º,I): 

  

Registro de Preço para aquisição de componentes de rede sem fio e cabeada. 

1.1 Definição (Art. 18, §3º, I) 

Registro de Preço para aquisição de computadores  para substituir equipamentos 
fora de garantia e/ou obsoletos. 

2. FUNDAMENTAÇÃO DA CONTRATAÇÃO (Art. 18, § 3º, II) 

  

2.1 Motivação (Art. 18, § 3º, II, a ) 

Os equipamentos tem por finalidade a substituição, por atualização tecnológica, de equipamentos, 
ora em uso, com aproximadamente 04 (quatro) anos e já não mais cobertos por garantia. Estes 
aspectos, a um só tempo, a se falar em TI, evidenciam a necessidade de atualização e de 
demanda de salvaguarda, esculpida em garantia, da efetividade e continuidade do mister da 
Secretaria. 

  

A estratégia de Registro de Preços está amparada no Decreto nº 7.892/2013, art 3º, incisos: 

I - vez que os equipamentos podem ser objeto de diversas aquisições/fornecimentos até que se 
supra progressivamente toda a demanda de substituição progressiva; 

II - as entregas deve ser progressivas de forma que as equipes da STI, em número limitado, 
possam implantar os equipamentos sem que os mesmo precisem ser estocados por longos 
períodos apenas exaurindo seus prazos de garantia. 

2.2 Objetivos (Art. 18, § 3º, II, b) 

A contratação visa, além de promover ações no sentido de elaborar novo 
instrumento que mantenha um meio para disponibilizar os computadores demandados e: 

Garantir a infraestrutura física apropriadas às atividades administrativas e 
judiciais. 

Prover infraestrutura de TIC apropriada às atividades judiciais e administrativas. 

2.3 Benefícios (Art. 18, § 3º, II, c) 

 Reposição de equipamentos defasados e manutenção da capacidade produtiva atualizada. 

2.4 Alinhamento Estratégico (Art. 18, § 3º, II, d) 
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O alinhamento com o PEI é identificado na visão do recursos de infraestrutura e tecnologia em 
seus dois aspectos apontados: 

 Garantir a infraestrutura física apropriadas às atividades administrativas e judiciais. 

Alinhamento com os Objetivos Estratégicos da Estratégia Nacional de TIC do Poder Judiciário nos 
seguintes aspectos: 

 Prover infraestrutura de TIC apropriada às atividades judiciais e administrativas. 

Alinhamento com os Objetivos Estratégicos de TIC da Justiça Eleitoral de Alagoas – 2017/2022 nos 
seguintes aspectos: 

 Viabilizar serviços e soluções de TIC. 

  

2.5 Referência aos Estudos Preliminares (Art. 18, § 3º, II, e) 

Este Termo de Referência foi elaborado considerando o Documento de 
Oficialização de Demanda (DOD) encaminhado pela Secretaria de Tecnologia da Informação (STI) 
e os Estudos Preliminares constantes do Processo SEI nº 0008478-63.2018.6.02.8000. 

2.6 Relação entre a Demanda Prevista e a Contratada (Art. 18, §3º, II, f) 

É pretendida a renovação do parque de equipamentos componentes da 
infraestrutura de TIC. 

2.7 Análise de Mercado de TIC (Art. 18, § 3º, II, g) 

Verifica-se que os bens e serviços pretendidos poderão ser fornecidos por 
diferentes empresas no mercado de TIC. 

Considerando o Item 7 dos Estudos Preliminares, não se vislumbrou alternativa 
que não o presente Registro de Preços. 

  

2.8 Natureza do Objeto (Art. 18, § 3º, II, h) 

Os bens e serviços a serem contratados possuem características comuns e usuais 
encontradas atualmente no mercado de TIC, cujos padrões de desempenho e de qualidade 
podem ser objetivamente definidos neste Termo de Referência. 

O objeto desta contratação tem como escopo a obtenção de produto específico 
em período determinado, portanto não se caracteriza como serviço de natureza continuada. 

2.9 Parcelamento e Adjudicação do Objeto (Art. 18, § 3º, II, i) 

Não haverá parcelamento, cada ordem de fornecimento derivado do Registro de 
Preços deverá ser realizada de maneira integral. 

Adjudicação será por lote. 

2.10 Vigência 

Será, na forma dos normativos vigentes, o tempo máximo do Registro de Preços. 

A vigência da ata será de 12 (doze) meses, contados a partir de sua assinatura. 
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A utilização do sistema de Registro de Preços visa, primordialmente, a redução de 
número de licitações para o mesmo objeto, porquanto se concentra em um único procedimento a 
possibilidade de realizar diversas aquisições recorrentes e necessárias, via ordens de 
fornecimento, durante o lapso temporal de sua vigência, em face de os preços permanecerem à 
disposição da Administração. 

2.11 Modalidade, Tipo de Licitação, Critérios de Habilitação e Atendimento aos Requisitos (Art. 18, § 
3º, II, j, IV e V) 

A aquisição pretendida deverá ser realizada por meio de licitação do tipo Pregão 
Eletrônico, como é de praxe neste Regional, salvo entendimento superior contrário. 

A sugestão da equipe de planejamento, por se tratar de fornecimento de 
equipamento, é pela contratação por licitação via pregão. Por conta de possibilidade de 
contingenciamento orçamentário indicamos a modalidade de registro de preços. 

O DECRETO Nº 7.174, DE 12 DE MAIO DE 2010 que regulamenta a contratação de bens e serviços 
de informática e automação pela administração pública federal, direta ou indireta, pelas fundações 
instituídas ou mantidas pelo Poder Público e pelas demais organizações sob o controle direto ou 
indireto da União deve ser aplicado nesta aquisição por se tratar de bem de informática. 

A ressalva que a equipe aponta é em relação ao artigo 3º, item II que versa sobre a necessidade 
de exigências, na fase de habilitação, de certificações emitidas por instituições públicas ou 
privadas credenciadas pelo Instituto Nacional de Metrologia, Normalização e Qualidade Industrial 
(Inmetro), que atestem, conforme regulamentação específica, a adequação à segurança para o 
usuário e instalações, compatibilidade eletromagnética e consumo de energia. 

Tal exigência inviabiliza e restringe a competição deste certame, vez que a certificação para este 
tipo de produto, segundo o próprio INMETRO, é voluntária, conforme Portaria Inmetro n.º 170 de 
10/04/2012. 

(fonte:http://www.inmetro.gov.br/legislacao/rtac/pdf/RTAC001808.pdf). 

A contratação pretendida deverá ser realizada por meio de licitação do tipo 
Pregão Eletrônico, como é de praxe neste Regional, salvo entendimento superior contrário. 

A sugestão da equipe de planejamento, por se tratar de fornecimento de 
equipamento, é pela contratação por licitação via pregão. Por conta de possibilidade de 
contingenciamento orçamentário indicamos a modalidade de registro de preços. 

2.12 Adequação do Ambiente (Art. 18, § 3º, II, k) 

Para utilização do objeto pretendido é necessário dispor de infraestrutura física 
para sua instalação, situação essa já existente no âmbito do TRE/AL, salvo o surgimento de 
demanda muito particular e além da previsibilidade. 

2.13 Conformidade Técnica e Legal (Art. 18, § 3º, II, l) 

  

2.14 Obrigações do Contratante (Art. 18, § 3º, II, m) 

1. Efetuar o pagamento à Contratada, após o recebimento definitivo; 
2. Acompanhar e fiscalizar a execução do objeto da Ata de Registro de Preços e 

do(s) contrato(s) dela decorrentes, por meio de servidor(es) designado(s), 
de modo a garantir o fiel cumprimento do mesmo e da proposta; 

3. Manter arquivo, junto ao processo administrativo ao qual está vinculado o presente termo, to
da a documentação referente ao mesmo; 
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4. Proporcionar todas as facilidades indispensáveis à boa execução das obrigações contratuais; 
e 

5. Aplicar as sanções conforme previsto no contrato, assegurando à Contratada o contraditório 
e a ampla defesa. 

2.15 Obrigações da Contratada (Art. 18, § 3º, II, m) 

As obrigações abaixo são aplicáveis ao objeto a ser contratado. 

1. Fornecer o(s) equipamento(s) conforme especificações, quantidades, prazos e demais
 condições estabelecidas no Edital, na Ata de Registro de Preços, 
na Ordem de Fornecimento, na Proposta e no Contrato; 

2. Fornecer a documentação necessária à instalação e 
à operação dos produtos (manuais, termos de garantia, etc.), completa, atualizada e 
em português do Brasil, caso exista, ou em inglês; 

3. Disponibilizar Central 
de Atendimento para a abertura e fechamento de chamados técnicos, conforme períodos, 
horários e condições estabelecidas no Edital e em seus Anexos; 

4. Comunicar formal e imediatamente ao Gestor ou Responsável Técnico da 
Administração sobre mudanças nos dados para contato com a Central de Atendimento; 

5. Prestar as informações e os esclarecimentos que venham a ser solicitados pelo 
representante da Administração, referentes a qualquer problema detectado ou 
ao andamento de atividades da garantia; 

6. Responder por quaisquer prejuízos que seus profissionais causarem ao patrimônio da 
Administração ou a terceiros, 
por ocasião da execução do objeto, procedendo imediatamente aos reparos ou 
às indenizações cabíveis e assumindo o ônus decorrente; 

7. Responsabilizar-se  integralmente pelo fornecimento dos equipamentos e pela 
execução dos serviços de garantia técnica, primando pela qualidade, desempenho, 
eficiência e produtividade na execução dos trabalhos, dentro dos prazos estipulados e cujo 
descumprimento será considerado infração passível de aplicação das penalidades 
previstas neste Termo de Referência; 

8.  Comunicar ao Gestor ou Responsável Técnico, formal 
e imediatamente, todas as ocorrências anormais e/ou 
que possam comprometer a execução do objeto; 

9. Manter sigilo sobre todo e qualquer assunto de interesse da Administração ou de 
terceiros de que tomar conhecimento em razão da execução do objeto, respeitando todos 
os critérios estabelecidos, aplicáveis aos dados, informações, regras de negócios, 
documentos, entre outros pertinentes, sob pena de responsabilidade civil, penal e 
administrativa; 

10.  Cumprir e garantir que seus profissionais estejam cientes, aderentes e obedeçam rig
orosamente às normas e 
aos procedimentos estabelecidos na Política de Segurança da Informação do TRE/AL; 

11.  Responsabilizar-
se pela conservação dos ambientes onde desempenhe as atividades necessárias para pres
tar a garantia on-site. 

Minuta de edital de pregão (0574599)         SEI 0008478-63.2018.6.02.8000 / pg. 378



 
TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS 

SEÇÃO DE LICITAÇÕES E CONTRATOS 

 

32 
 

 

 

12. Prestar as informações e 
os esclarecimentos que venham a ser solicitados pela Administração, referentes a qualque
r problema detectado ou ao andamento de atividades da garantia técnica 

13. No caso de fornecimento/entrega, em final de exercício e posterior ao dia 15 de 
dezembro ou dia útil imediatamente subsquente, fica obrigado a aceitar, o cancelamento da 
ordem de fornecimento por parte da Administração, em decorrência dos efeitos da Emenda 
Constitucional nº 95/2016, sem a reversão de qualquer ônus à Administração. 

DETALHAMENTO DO OBJETO (Art. 18, § 3º, III) 

3.1 Descrição do Objeto 

CONDIÇÕES GERAIS 

1. Todos os itens ofertados por lote, deverão ser do mesmo fabricante para garantir total 
compatibilidade entre todos os componentes, sem a utilização de ferramentas de terceiros 
ou modo de interoperabilidade na solução; 

2. Para o  Lote 01: Todos os itens de software ofertados deverão possuir integração total com o 
HPE Intelligent Managment Center (IMC) já existente na infraestrutura da contratante, 
através de interface única de gerenciamento e/ou autenticação centralizada; 

3. Para o Lote 01: Os equipamentos fornecidos deverão ser gerenciados pelo HPE IMC já 
existente na infraestrutura da contratante, com presença na matriz de compatibilidade 
comprovada através de documentação oficial do fabricante; 

4. Os equipamentos devem ser novos e estar em produção. Não serão aceitos equipamentos 
descontinuados, recondicionados ou usados; 

5. Os equipamentos devem ser entregues acondicionados adequadamente em suas 
embalagens originais; 

6. A(s) solução(ões) de gerenciamento/controle ofertada(s), deverá(ão) ser baseada(s) em 
plataforma “On Premise”, ou seja, deverá ser executada localmente, não sendo aceitas 
soluções híbridas ou em Cloud; 

7. Cada lote deverá ser fornecido por uma única empresa, visando a garantia integral de 
compatibilidade dos componentes ofertados; 

8. As configurações e especificações aqui apresentadas são mínimas, sendo aceitos 
equipamentos/softwares com características superiores, desde que compatíveis com as 
exigidas; 

9. Prazo de entrega para equipamentos: 60 (sessenta) dias contados a partir da emissão da 
ordem de fornecimento ou documento equivalente; 

10. Prazo de entrega para softwares: 30 (trinta) dias contados a partir da emissão da ordem de 
fornecimento ou documento equivalente; 

11. Os serviços de instalação, integração, garantia e suporte dos equipamentos e softwares, 
deverão ser realizados diretamente pelo fabricante de acordo com as exigências contidas no 
descritivo dos mesmos, estando essas aderentes aos respectivos níveis de serviço 
necessários a cada um deles. 

 LOTE 01 – SOLUÇÃO DE REDE CABEADA 
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ITEM 01 – SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO LICENCIAMENTO 

1. Licenciamento da SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO, contemplando o 
quantitativo mínimo de 1.000 (um mil) dispositivos, usuários corporativos ou visitantes 
simultâneos, independente do perfil de autenticação, seja por dispositivo ou usuário; 

2. Caso a solução ofertada necessite de licenciamento específico para credenciamento dos 
dispositivos, usuários (corporativos ou visitantes), deverá ser fornecido o quantitativo 
solicitado para ambos, de forma que a solução realize a análise de perfil e o controle de 
acesso dos 1.000 (um mil) dispositivos ou usuários (corporativos ou visitantes) simultâneos. 

  

MÓDULO DE ANÁLISE DE PERFIL DE DISPOSITIVO 

Características Gerais Modulo de Análise de Perfil de Dispositivo 

3. Deve implementar funcionalidade de classificação automática criando perfis de dispositivos, 
de forma a descobrir, classificar e agrupar os dispositivos conectados na rede; 

4. Deve categorizar os dispositivos em pelo menos 3 níveis: 

a. Por tipo de dispositivo (ex. Computador, Smartdevice, impressora, etc.); 
b. Por sistema operacional (ex. Windows, Linux, MacOS, etc.); 
c. Versão do sistema operacional (ex. Windows 7, Windows 2008 Server, etc.); 

5. Deve ser capaz de gerar gráficos das categorias, separando os dispositivos conforme suas 
características; 

6. Deve suportar a coleta de informações, para classificação, usando no mínimo: 

a. DHCP; 
b. HTTP User-Agent; 
c. MAC OUI; 
d. ActiveSync plugin; 
e. SNMP; 
f. Subnet Scanner; 
g. IF-MAP; 
h. Cisco Device Sensor; 
i. MDM; 
j. TCP Fingerprinting. 

7. Deve possuir dicionário de categorias de dispositivos pré-configurado e mecanismo de 
atualização do mesmo; 

8. Deve suportar a integração com, no mínimo, as seguintes soluções de MDM de mercado 
AirWatch, MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, MaaS 360 devendo comprovar 
a compatibilidade em documentação oficial do fabricante; 

9. Deve permitir priorização na ordem de criação dos perfis com no mínimo as seguintes 
características: 

a. Agente proprietário; 
b. HTTP User-Agent; 
c. SNMP; 
d. DHCP; 
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e. MAC OUI. 

10. A solução de análise de perfil de usuários deverá permitir consultas a sua base, pela solução 
de controle de acesso para validação de dispositivos com base no seu perfil. 

  

MÓDULO DE CONTROLE DE ACESSO DE DISPOSITIVOS E USUÁRIOS 

Características Gerais 

11. A Solução deverá dar suporte a no mínimo as seguintes bases de dados: 

a. Microsoft Active Directory; 
b. Kerberos; 
c. Diretórios LDAP; 
d. OpenLDAP; 
e. PostgreSQL; 
f. Oracle 11g; 
g. MariaDB; 
h. MSSQL; 
i. Servidores de Token; 
j. Base de dados SQL interna; 
k. Lista interna estática de hosts. 

12. Deve suportar "Single Sign-on" (SSO) através de SAML v2.0; 
13. Deve implementar gerenciamento e aplicação de políticas de autorização de acesso de 

usuários com base em: 

a. Atributos do usuário autenticado; 
b. Hora do dia, dia da semana; 
c. Tipo de dispositivo utilizado; 
d. Localização do usuário; 
e. Tipo de autenticação utilizada. 

14. Deve permitir a visualização de todas informações relativas a cada transação e autenticação 
em uma única tela, a solução deverá trazer no mínimo as seguintes informações: 

a. Data e Hora; 
b. Mac Address do dispositivo; 
c. Classificação do dispositivo; 
d. Usuário; 
e. Equipamento que requisitou a autenticação (origem); 
f. Método de autenticação utilizado; 
g. Fonte de autenticação utilizada para validação; 
h. Perfil de acesso aplicado; 
i. Atributos de entrada do protocolo utilizados na requisição (ex. RADIUS); 
j. Informações de resposta da solução para o elemento de rede; 
k. Alertas em caso de falha; 
l. LOGS já filtrados para a requisição em análise. 
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15. Deve possuir Dashboard customizável, onde deve permitir a visualização de no mínimo as 
seguintes informações: 

a.  
a. Lista com últimos Alertas do sistema; 
b. Gráfico com todas as requisições de autenticação dos últimos 7 dias, incluindo 

RADIUS, TACACS+ e Autenticações Web; 
c. Gráfico com o status das autenticações aceitas e rejeitadas nos últimos 7 dias; 
d. Gráfico com a categorização dos dispositivos classificados pela solução, divididos de 

acordo com as categorias de classificação; 
e. Últimas falhas de autenticação; 
f. Gráfico com as requisições de avaliação de postura dos dispositivos, divididos em: 

  
I. Saudáveis (dentro das políticas estabelecidas); 
II. Não saudáveis (que estão fora das políticas estabelecidas); 

a.  
a. Lista com as últimas autenticações; 
b. Lista com as últimas autenticações com sucesso; 
c. Utilização de CPU do sistema, no mínimo nos últimos 30 minutos; 

16. Deve possuir base de regras e categorias de dispositivos pré-configurada e mecanismo de 
atualização da mesma; 

17. Deve suportar a integração com no mínimo as seguintes soluções de MDM de mercado 
AirWatch, MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, MaaS 360 devendo comprovar 
a compatibilidade em documentação oficial do fabricante; 

18. Deve suportar autenticações via OAuth2, Facebook, Twitter, LinkdIn, Office365 e Google 
Apps; 

19. Deve possuir recursos integrados de AAA: RADIUS, TACACS+ e Kerberos; 
20. Deve possuir suporte aos seguintes recursos: 

a. RADIUS; 
b. RADIUS CoA; 
c. TACACS+; 
d. Web authentication; 
e. SAML v2.0; 
f. EAP-FAST (EAP-MSCHAPv2, EAP-GTC, EAP-TLS); 
g. PEAP (EAP-MSCHAPv2, EAP-GTC, EAP-TLS, EAP-PEAP-Public); 
h. TTLS (EAP-MSCHAPv2, EAP-GTC, EAP- TLS, EAP-MD5, PAP, CHAP); 
i. EAP-TLS; 
j. PAP, CHAP, MSCHAPv1, MSCHAPv2  e EAP-MD5; 
k. Windows machine authentication; 
l. MAC address authentication (dispositivos sem suporte a 802.1X); 

21. Deve suportar verificação de vulnerabilidade através de varredura de portas; 
22. Deve suportar à aplicação de políticas em ambiente com múltiplos fornecedores de Wireless, 

cabeado e VPN; 
23. Deve possuir CA integrada, para geração de certificados para os dispositivos que forem se 

autenticar na rede; 
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24. Deve suportar à integração com plataforma de terceiros usando HTTP/RESTful API; 
25. Deve permitir que a solução faça consultas em bases SQL, com o objetivo de buscar 

informação a serem utilizadas durante o processo de autenticação dos usuários; 
26. Deve possuir suporte a administração através de IPv6; 
27. Deve possuir ferramenta para gerenciar os processos de credenciamento, autenticação, 

autorização e contabilização de usuários visitantes através de portal web seguro; 
28. Deve implementar a criação de grupos de autorizadores com privilégios distintos de criação 

de credenciais temporárias e atribuição de permissões de acesso aos clientes; 
29. Deve permitir realizar a autenticação dos autorizadores em base externa do tipo Microsoft 

Active Directory ou LDAP e atribuir o privilégio ao autorizador de acordo com o seu perfil; 
30. Deve implementar as funcionalidades de geração de lotes de credenciais aleatórias, 

temporárias, pré-autorizadas; 
31. Deve implementar a importação e exportação da relação de credenciais temporárias através 

de arquivos txt ou csv; 
32. Deve permitir a configuração do tempo de validade das credenciais, baseando-se na criação 

da conta ou no primeiro login da conta; 
33. Deve permitir que o visitante crie sua própria credencial temporária (autosserviço) através 

de portal web, com ou sem a necessidade de um autorizador; 
34. Deve permitir a customização do formulário de criação de credenciais, a ser preenchido pelo 

autorizador ou pelo visitante em caso de autosserviço, especificando quais informações 
cadastrais dos visitantes são obrigatórias ou opcionais; 

35. Deve permitir a customização do nível de segurança da senha temporária que será gerada 
ao visitante, especificando a quantidade mínima de caracteres e o uso de caracteres 
especiais e números para compor a senha; 

36. Deve exigir que o usuário visitante aceite o “Termo de uso da rede” a cada login ou apenas 
no primeiro login; 

37. Deve permitir o envio das credenciais aos usuários registrados através de mensagens SMS 
(Short Message Service), e-mail ou impressão local. 

  

 GARANTIA E SUPORTE 

38. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas; 

39. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução; 

40. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

41. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

42. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
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possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

  

ITEM 02 – LICENCIAMENTO ADICIONAL PARA SISTEMA DE GERENCIAMENTO HPE IMC 

Características técnicas mínimas 

1. Licenciamento para expansão do SISTEMA DE GERENCIAMENTO HPE IMC existente na 
infraestrutura da contratante, contemplando o quantitativo adicional mínimo de 50 
(cinquenta) dispositivos simultâneos; 

  

GARANTIA E SUPORTE 

1. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

5. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

  

ITEM 03 – LICENCIAMENTO ADICIONAL DO MÓDULO DE ANÁLISE DE TRAFEGO DO SISTEMA DE 
GERENCIAMENTO HPE IMC 

Características técnicas mínimas 
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1. Licenciamento para expansão do MÓDULO DE ANÁLISE DE TRAFEGO DO SISTEMA DE 
GERENCIAMENTO HPE IMC existente na infraestrutura da contratante, contemplando o 
quantitativo adicional mínimo de 5 (cinco) dispositivos simultâneos; 

  

GARANTIA E SUPORTE 

1. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

5. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

  

ITEM 04 – LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 

Características técnicas mínimas 

2. Licenciamento para expansão da SOLUÇÃO DE ANALISE DE PERFIL E CONTROLE DE ACESSO, 
contemplando o quantitativo mínimo adicional de 500 (quinhentos) dispositivos, usuários 
corporativos ou visitantes simultâneos, independente do perfil de autenticação, seja por 
dispositivo ou usuário; 

  

GARANTIA E SUPORTE 

1. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 
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2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

5. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

  

ITEM 05 – SWITCH DE DISTRIBUIÇÃO COM 16 PORTAS SFP+ E SUPORTE A MÓDULOS DE EXPANSÃO 

  

Características técnicas mínimas 

1. Deve possuir no mínimo 16 portas 10 Gigabit Ethernet, 1000/10000 SFP+ fixas ao 
equipamento 

2. Deve suportar, através de módulos, o mínimo de 8 portas adicionais de 10 Gigabit Ethernet 
SFP+ ou 2 portas de 40 Gigabit Ethernet QSFP+; 

3. Deve suportar transceivers de 10GbE SFP+ e de 40GbE QSFP+ através da adição ou 
substituição de módulos. 

4. Deve possuir, no mínimo, 2 módulos de expansão podendo ser utilizados para uplinks ou 
dados de usuários; 

5. Deve possuir, no mínimo, 2 módulos de fonte internas ao equipamento operando em modo 
redundante; 

6. Deve possuir porta dedicada de gerenciamento; 
7. Deve possuir 1 interface RJ-45 ou serial para acesso console local; 
8. Deve possuir latência de, no máximo, 2,8 μs a 1Gbps; 
9. Deve possuir memória SDRAM de no mínimo 2 Gbytes; 
10. Deve possuir buffer de pacotes de no mínimo 13.5 Mbytes; 
11. Deve possuir capacidade de encaminhamento de no mínimo 285 Mpps; 
12. Deve possuir capacidade de comutação de no mínimo 480 Gbps; 
13. Deve possuir Certificado de Homologação na Anatel, de acordo com a Resolução nº 242; 
14. Deve possuir fonte de alimentação interna 110/220VAC; 

Disponibilidade 

15. Deve possuir capacidade de, no mínimo, 10 (dez) equipamentos membros da mesma pilha; 

Minuta de edital de pregão (0574599)         SEI 0008478-63.2018.6.02.8000 / pg. 386



 
TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS 

SEÇÃO DE LICITAÇÕES E CONTRATOS 

 

40 
 

 

 

16. Deve possuir fonte de alimentação interna redundante com características idênticas a fonte 
principal; 

17. Deve suportar empilhamento com banda agregada mínima de 320 Gbps sem uso de portas 
de dados de usuário para este fim. 

Switching 

18. Deve implementar VLANs baseadas em MAC; 
19. Deve suportar no mínimo 4094 VLAN IDs; 
20. Deve implementar registro dinâmico de VLAN com MVRP; 
21. Deve suportar protocolo OpenFlow 1.3; 
22. Deve implementar Jumbo frames nas interfaces Gigabit Ethernet e 10-Gigabit Ethernet 
23. Deve implementar Jumbo frames com tamanho de até 9000 bytes; 
24. Deve implementar Ethernet link aggregation; 
25. Deve implementar IEEE 802.1ad QinQ; 
26. Deve suportar agregação de link através de LACP com no mínimo 144 grupos distribuídos 

através da pilha, com cada grupo permitindo até 8 portas; 
27. Deve implementar IEEE 802.3x Flow Control; 
28. Deve implementar STP BPDU Protection (BPDU Guard); 
29. Deve implementar IEEE 802.1w Rapid Reconfiguration of Spanning Tree; 
30. Deve implementar MSTP IEEE 802.1s com pelo menos 64 instâncias; 
31. Deve implementar UDLD ou DLDP. 

Roteamento 

32. Deve implementar roteamento estático IPv4 e IPv6; 
33. Deve implementar RIP, RIPv2 e RIPng; 
34. Deve possuir no mínimo 512 interfaces de roteamento IP (VLAN Interface) 
35. O equipamento ofertado deve implementar roteamento baseado em política (PBR) para IPv4 

e IPv6; 
36. O equipamento ofertado deve possuir tabela de roteamento com no mínimo 10 mil entradas 

IPv4 e 5 mil entradas IPv6; 
37. Deve suportar no mínimo 256 rotas estáticas; 
38. O equipamento ofertado deve permitir autenticação em servidores RADIUS e TACACS+; 
39. Deve suportar dual stack IPv4/IPv6; 
40. Deve implementar Bidirectional Forwarding Detection (BFD), suportando redução do tempo 

de convergência para OSPF e VRRP; 
41. Deve implementar OSPF v2 e OSPF v3; 
42. Deve implementar BGP. 

QoS 

43. Deve implementar 8 filas em cada porta; 
44. Deve implementar traffic shapping; 
45. Deve implementar classificação de tráfego utilizando informações de camada 2, 3 e 4; 
46. Deve implementar priorização do trafego em camada 4, baseado em número de portas 

TCP/UDP. 

Segurança 
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47. Deve implementar autenticação 802.1x de múltiplos usuários por porta, simultaneamente. 
48. Deve implementar segurança orientada por identidade e controle de acesso por usuário 

através de ACLs que permitam ou negue o acesso do usuário aos recursos de rede 
específicos, com base na identidade do usuário. 

49. Atribuição VLAN automática, automaticamente atribui os usuários para a VLAN apropriada, 
com base em suas identidades. 

50. Deve implementar accounting RADIUS; 
51. Deve implementar TACACS+; 
52. Deve implementar proteção contra ataques de ARP; 
53. Deve implementar proteção contra IP spoofing (IP source guard); 
54. Deve implementar SNMP v1, v2 e v3; 
55. Deve implementar detecção de ataques maliciosos e enviar um aviso quando uma anomalia 

potencial, causada pelos ataques mal-intencionado, for detectado. 
56. Deve suportar o isolamento de portas e VLANs, de forma que uma porta ou VLAN isolada não 

possa enviar tráfego para outra porta isolada do mesmo switch; 
57. Deve implementar segurança do gerenciamento do switch em métodos de acesso CLI, GUI ou 

MIB, através de SSHv2, SSL e SNMPv3 
58. Deve implementar autenticação baseado em porta ou endereço MAC; 
59. Deve implementar autenticação utilizando navegadores web, possibilitando que clientes que 

não possuem cliente 802.1x possam autenticar; 
60. Deve suportar port-security. 

Gerenciamento 

61. Deve permitir instalação simplificada “Zero-touch provisioning” através de processo baseado 
em DHCP com a solução de software de gerenciamento; 

62. O equipamento ofertado deve permitir múltiplos arquivos de configuração; 
63. Deve suportar espelhamento remoto; 
64. Deve implementar Secure File Transfer Protocol; 
65. Deve implementar LLDP; 
66. Deve implementar LLDP-MEd; 
67. Deve implementar SNTP v4; 
68. O equipamento ofertado deve Implementar Sflow ou Netflow; 
69. Deve implementar RFC 1213 MIB II; 
70. Deve implementar RFC 2096 IP Forwarding Table MIB; 
71. Deve implementar RFC 2571 SNMP Framework MIB; 
72. Deve implementar RFC 2572 SNMP-MPD MIB; 
73. Deve implementar RFC 2573 SNMP-Notification MIB; 
74. Deve implementar RFC 2574 SNMP USM MIB; 
75. Deve implementar RFC 2737 Entity MIB (Version 2); 
76. Deve implementar RFC 3414 SNMP-User based-SM MIB; 
77. Deve implementar RFC 3415 SNMP-View based-ACM MIB; 
78. Deve implementar RFC 2668 802.3 MAU MIB; 
79. Deve implementar RFC 3418 MIB for SNMPv3; 
80. Deve ser fornecido com a versão de software mais completa e atual disponível para o 

equipamento; 
81. Deve ser fornecido com todas as licenças de software necessárias para o funcionamento 

integral de todas as funcionalidades disponíveis para o equipamento; 
82. O equipamento ofertado deve possuir certificado de homologação na Anatel, de acordo com 

a resolução n° 242; 

Minuta de edital de pregão (0574599)         SEI 0008478-63.2018.6.02.8000 / pg. 388



 
TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS 

SEÇÃO DE LICITAÇÕES E CONTRATOS 

 

42 
 

 

 

Garantia e Suporte 

83. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 

84. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

85. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

86. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

87. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos equipamentos, 
indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

88. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 06 – MÓDULO COM 4 PORTAS SFP+ PARA SWITCH DE DISTRIBUIÇÃO 

  

Características técnicas mínimas 

1. Módulo de expansão para switch de distribuição; 
2. Suporte a no mínimo 4 (quatro) portas SFP+; 
3. Deve ser compatível com GBICS 100M/1G/10G SFP+; 
4. Deve possuir suporte a MACsec; 
5. Compatibilidade integral com o item 05. 

Garantia e Suporte 
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6. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

7. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

8. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada; 

  

ITEM 07 – MÓDULO DE STACKING COM 4 PORTAS PARA SWITCH DE DISTRIBUIÇÃO 

 
Características técnicas mínimas 

1. Módulo de expansão para switch de distribuição; 
2. Suporte a no mínimo 4 (quatro) portas para stacking; 
3. Deve prover no mínimo 320Gbps por módulo; 
4. Deve acompanhar 1 (um) cabo de stacking compatível, com 1 (um) metro de comprimento; 
5. Compatibilidade integral com o item 05. 

  

Garantia e Suporte 

6. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

7. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

8. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada; 

  

ITEM 08 – SWITCH DE ACESSO L3 COM 48 PORTAS GIGABIT E 4 SFP+ 

  

Características gerais 

1. Deve possuir 48 portas 10/100/1000; 
2. Deve possuir 4 portas 1/10G SFP+; 

Minuta de edital de pregão (0574599)         SEI 0008478-63.2018.6.02.8000 / pg. 390



 
TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS 

SEÇÃO DE LICITAÇÕES E CONTRATOS 

 

44 
 

 

 

3. Deve possuir capacidade de encaminhamento de, no mínimo, 110 Mpps; 
4. Deve possuir capacidade de comutação de, no mínimo, 176 Gbps; 
5. Deve implementar IEEE 802.3az para as portas 10/100/1000; 
6. Deve possuir uma interface de console USB; 
7. Deve suportar empilhamento de no mínimo 8 switches; 
8. Deve suportar agregação de link através de LACP com no mínimo 20 grupos distribuídos 

através da pilha, com cada grupo permitindo até 8 portas; 
9. Deve suportar a agregação de links entre diferentes membros da pilha; 
10. Deve possuir no mínimo 32.000 endereços MAC; 
11. Deve possuir latência máxima de 4μs, considerando pacotes de 64 bytes; 
12. Deve possuir buffers de, no mínimo, 12 MB; 
13. Deve implementar funcionalidade que permita a detecção de links unidirecionais; 
14. Deve implementar funcionalidade que permita a detecção de falhas de uplink; 
15. Deve implementar no mínimo 2000 VLANs simultaneamente; 
16. Deve implementar MVRP (Multiple VLAN Registration Protocol); 
17. Deve implementar LLDP (IEEE 802.1ab); 
18. Deve implementar LLDP-MED; 
19. Deve implementar Q-in-Q (IEEE 802.1ad); 
20. Deve implementar PVST+, RPVST+ ou protocolo compatível; 
21. Deve implementar MSTP (IEEE 802.1s); 
22. Deve implementar túneis VxLAN (VTEP). 

  

Funcionalidades de Camada 3 

23. Deve possuir tabela de roteamento com no mínimo 2.000 rotas IPv4 e 1.000 rotas IPv6; 
24. Deve implementar roteamento estático; 
25. Deve implementar RIP v2, com suporte a autenticação MD5 (RIPv2); 
26. Deve implementar RIPng; 
27. Deve implementar OSPF; 
28. Deve implementar OSPFv3; 
29. Deve implementar Policy-based Routing; 
30. Deve implementar VRRP; 
31. Deve implementar VRRPv3; 
32. Deve implementar servidor DHCP; 
33. Deve implementar DHCP snooping (IPv4 e IPv6); 
34. Deve implementar DHCP relay (IPv4 e IPv6); 
35. Deve implementar Gateway mDNS, com suporte a Apple Bonjour. 

  

Multicast 

36. Deve implementar PIM-SM; 
37. Deve implementar PIM-DM; 
38. Deve implementar MLD snooping; 
39. Deve implementar IGMP v3. 

  

Software Defined Networking 
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40. Deve implementar OpenFlow 1.3 ou superior; 
41. Deve implementar a separação lógica do tráfego sem suporte a OpenFlow do tráfego com 

suporte a OpenFlow através de instâncias. O tráfego OpenFlow não pode influenciar o tráfego 
não openflow no equipamento; 

42. Deve permitir configurar cada instância como modo ativo (pacotes referentes a fluxos que o 
switch não conhece são enviados para a controladora) ou modo passivo (pacotes que não se 
referem a um fluxo na tabela do switch não são enviados para a controladora); 

43. Deve implementar 16 instâncias de OpenFlow; 
44. As instâncias de OpenFlow devem suportar a associação de múltiplas VLANs; 
45. Cada instância OpenFlow configurada no equipamento deve suportar, pelo menos, a 

configuração de 3 controladores SDN; 
46. Deve permitir utilizar intervalo de portas TCP/UDP e flags de TCP como parâmetros nas 

regras de OpenFlow; 
47. Deve suportar no mínimo 16.000 regras openflow; 
48. Deve possuir interface REST API; 
49. Deve suportar configurações via JSON/REST API com, no mínimo, os seguintes métodos: GET, 

POST, PUT e DELETE; 
50. Deve suportar a criação de VLANs e ACLs no equipamento através de REST. 

  

QoS 

51. Deve implementar controle de broadcast; 
52. Deve implementar rate limiting para pacotes ICMP; 
53. Deve implementar rate limiting para tráfego broadcast e multicast; 
54. Deve implementar rate limiting baseado em tráfego classificado por uma ACL; 
55. Deve suportar espelhamento de portas; 
56. Deve suportar espelhamento de tráfego para um switch remoto. 

  

Segurança 

57. Deve implementar controle de acesso baseado em perfis (Role Based Access Control); 
58. Deve implementar VLANs privadas, de forma que permita o isolamento de tráfego de uma 

porta de acesso das demais portas de acesso de uma mesma VLAN, permitindo acesso 
apenas para as portas de Uplink (porta promíscua); 

59. Deve implementar 802.1x; 
60. Deve implementar autenticação baseada em web; 
61. Deve implementar autenticação baseada em endereço MAC; 
62. Deve permitir a utilização simultânea de autenticação 802.1x e MAC em uma mesma porta; 
63. Deve implementar TACACS+. Não serão aceitas soluções similares; 
64. Deverá suportar o download de políticas ou ACLsl a partir de um software de Controle de 

Acesso à Rede (NAC), sem necessidade de pré-configuração das regras no switch, permitindo 
a centralização das políticas; 

65. Deve suportar integração com ferramenta de controle de acesso do mesmo fabricante que 
permita identificar automaticamente o tipo e sistema operacional dos equipamentos que se 
conectam à rede (device profiling) sem a necessidade de agentes instalados nos dispositivos; 

66. Deve suportar integração com ferramenta de controle de acesso do mesmo fabricante que 
permita verificar se a máquina está em conformidade com a política de segurança antes de 
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entrar na rede, verificando, no mínimo serviços os serviços e antivírus das máquinas. Deve 
suportar os sistemas operacionais Microsoft Windows, Mac OS e Linux. 

  

Gerenciamento 

67. Deve implementar NTP com autenticação MD5; 
68. Deve implementar Time Domain Reflectometry (TDR) para testes de cabos UTP, permitindo 

identificar falhas e verificar a distância do cabo; 
69. Deve suportar duas imagens de software na flash; 
70. Deve suportar múltiplos arquivos de configuração na flash; 
71. Deve permitir o agendamento de tarefas, permitindo executar um comando em um dia e 

horário específicos; 
72. Deve suportar a autoconfiguração dos switches através de DHCP e software de 

gerenciamento, sem necessidade de nenhuma intervenção no switch (com configuração de 
fábrica); 

73. Deve suportar gerenciamento através de plataforma de nuvem do mesmo fabricante, com 
funcionalidades de gerenciamento de configuração, alertas e notificações e gerenciamento 
de firmware, sem necessidade de instalação de nenhum software ou dispositivo on-site; 

74. Deve suportar IPSec para comunicação com o sistema de gerenciamento; 
75. Deve implementar sFlow (IPv4 e IPv6); 
76. Deve possuir interface web para configuração; 
77. Deve implementar TR-69 (CPE WAN Management Protocol); 
78. Deve suportar diagnóstico de transceivers ópticos; 
79. Deve implementar Syslog sobre TLS; 
80. Deve implementar Secure SFTP (SFTP); 
81. Deve implementar SNMP v1/v2/v3; 
82. Deve implementar funcionalidade que permita monitorar o SLA (Service Level Agreement) de 

conexões IP. Deve suportar os seguintes testes: ICMP Echo, UDP-Echo (em porta 
configurável) e TCP-Connect (em porta configurável) e Jitter UDP para voz; 

83. Deve implementar compatibilidade com o protocolo CDP para provisionamento de telefones 
IP; 

84. Deve implementar o isolamento de um Access Point rogue conectado ao switch, quando este 
for detectado por solução de WLAN do mesmo fabricante; 

85. Deve implementar a configuração automática de Access Point wireless do mesmo fabricante 
quando conectado ao switch. Devem ser suportados os seguintes parâmetros para a 
configuração automática: VLAN, CoS, largura de banda máxima; 

86. Deve suportar o encaminhamento de tráfego para controladora wireless do mesmo 
fabricante para inspeção e controle de acesso. 

  

Licenciamento 

87. Deve ser fornecido com a versão de software mais completa disponível para o equipamento; 
88. Deve ser fornecido com todas as licenças de software necessárias para o funcionamento 

integral de todas as funcionalidades disponíveis para o equipamento. 

  

Garantia e Suporte 
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1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos equipamentos, 
indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 09 – SWITCH DE ACESSO L3 COM 24 PORTAS GIGABIT E 4 SFP+ 

  

Características gerais 

1. Deve possuir 24 portas 10/100/1000; 
2. Deve possuir 4 portas 1/10G SFP+; 
3. Deve possuir capacidade de encaminhamento de, no mínimo, 95 Mpps; 
4. Deve possuir capacidade de comutação de, no mínimo, 128 Gbps; 
5. Deve implementar IEEE 802.3az para as portas 10/100/1000; 
6. Deve possuir uma interface de console USB; 
7. Deve suportar empilhamento de no mínimo 4 switches; 
8. Deve suportar agregação de link através de LACP com no mínimo 20 grupos distribuídos 

através da pilha, com cada grupo permitindo até 8 portas; 
9. Deve suportar a agregação de links entre diferentes membros da pilha; 
10. Deve possuir no mínimo 32.000 endereços MAC; 
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11. Deve possuir latência máxima de 4μs, considerando pacotes de 64 bytes; 
12. Deve possuir buffers de, no mínimo, 12 MB; 
13. Deve implementar funcionalidade que permita a detecção de links unidirecionais; 
14. Deve implementar funcionalidade que permita a detecção de falhas de uplink; 
15. Deve implementar no mínimo 2000 VLANs simultaneamente; 
16. Deve implementar MVRP (Multiple VLAN Registration Protocol); 
17. Deve implementar LLDP (IEEE 802.1ab); 
18. Deve implementar LLDP-MED; 
19. Deve implementar Q-in-Q (IEEE 802.1ad); 
20. Deve implementar PVST+, RPVST+ ou protocolo compatível; 
21. Deve implementar MSTP (IEEE 802.1s); 
22. Deve implementar túneis VxLAN (VTEP); 

  

Funcionalidades de Camada 3 

23. Deve possuir tabela de roteamento com no mínimo 2.000 rotas IPv4 e 1.000 rotas IPv6; 
24. Deve implementar roteamento estático; 
25. Deve implementar RIP v2, com suporte a autenticação MD5 (RIPv2); 
26. Deve implementar RIPng; 
27. Deve implementar OSPF; 
28. Deve implementar OSPFv3; 
29. Deve implementar Policy-based Routing; 
30. Deve implementar VRRP; 
31. Deve implementar VRRPv3; 
32. Deve implementar servidor DHCP; 
33. Deve implementar DHCP snooping (IPv4 e IPv6); 
34. Deve implementar DHCP relay (IPv4 e IPv6); 
35. Deve implementar Gateway mDNS, com suporte a Apple Bonjour; 

  

Multicast 

36. Deve implementar PIM-SM; 
37. Deve implementar PIM-DM; 
38. Deve implementar MLD snooping; 
39. Deve implementar IGMP v3; 

  

Software Defined Networking 

40. Deve implementar OpenFlow 1.3 ou superior; 
41. Deve implementar a separação lógica do tráfego sem suporte a OpenFlow do tráfego com 

suporte a OpenFlow através de instâncias. O tráfego OpenFlow não pode influenciar o tráfego 
não openflow no equipamento. 

42. Deve permitir configurar cada instância como modo ativo (pacotes referentes a fluxos que o 
switch não conhece são enviados para a controladora) ou modo passivo (pacotes que não se 
referem a um fluxo na tabela do switch não são enviados para a controladora) 

43. Deve implementar 16 instâncias de OpenFlow; 
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44. As instâncias de OpenFlow devem suportar a associação de múltiplas VLANs. 
45. Cada instância OpenFlow configurada no equipamento deve suportar, pelo menos, a 

configuração de 3 controladores SDN. 
46. Deve permitir utilizar intervalo de portas TCP/UDP e flags de TCP como parâmetros nas 

regras de OpenFlow; 
47. Deve suportar no mínimo 16.000 regras openflow; 
48. Deve possuir interface REST API; 
49. Deve suportar configurações via JSON/REST API com, no mínimo, os seguintes métodos: GET, 

POST, PUT e DELETE; 
50. Deve suportar a criação de VLANs e ACLs no equipamento através de REST. 

  

QoS 

51. Deve implementar controle de broadcast; 
52. Deve implementar rate limiting para pacotes ICMP; 
53. Deve implementar rate limiting para tráfego broadcast e multicast; 
54. Deve implementar rate limiting baseado em tráfego classificado por uma ACL; 
55. Deve suportar espelhamento de portas; 
56. Deve suportar espelhamento de tráfego para um switch remoto. 

  

Segurança 

57. Deve implementar controle de acesso baseado em perfis (Role Based Access Control); 
58. Deve implementar VLANs privadas, de forma que permita o isolamento de tráfego de uma 

porta de acesso das demais portas de acesso de uma mesma VLAN, permitindo acesso 
apenas para as portas de Uplink (porta promíscua); 

59. Deve implementar 802.1x; 
60. Deve implementar autenticação baseada em web; 
61. Deve implementar autenticação baseada em endereço MAC; 
62. Deve permitir a utilização simultânea de autenticação 802.1x e MAC em uma mesma porta; 
63. Deve implementar TACACS+. Não serão aceitas soluções similares; 
64. Deverá suportar o download de políticas ou ACLs a partir de um software de Controle de 

Acesso à Rede (NAC), sem necessidade de pré-configuração das regras no switch, permitindo 
a centralização das políticas; 

65. Deve suportar integração com ferramenta de controle de acesso do mesmo fabricante que 
permita identificar automaticamente o tipo e sistema operacional dos equipamentos que se 
conectam à rede (device profiling) sem a necessidade de agentes instalados nos dispositivos; 

66. Deve suportar integração com ferramenta de controle de acesso do mesmo fabricante que 
permita verificar se a máquina está em conformidade com a política de segurança antes de 
entrar na rede, verificando, no mínimo serviços os serviços e antivírus das máquinas. Deve 
suportar os sistemas operacionais Microsoft Windows, Mac OS e Linux. 

  

Gerenciamento 

67. Deve implementar NTP com autenticação MD5; 
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68. Deve implementar Time Domain Reflectometry (TDR) para testes de cabos UTP, permitindo 
identificar falhas e verificar a distância do cabo; 

69. Deve suportar duas imagens de software na flash; 
70. Deve suportar múltiplos arquivos de configuração na flash; 
71. Deve permitir o agendamento de tarefas, permitindo executar um comando em um dia e 

horário específicos; 
72. Deve suportar a autoconfiguração dos switches através de DHCP e software de 

gerenciamento, sem necessidade de nenhuma intervenção no switch (com configuração de 
fábrica); 

73. Deve suportar gerenciamento através de plataforma de nuvem do mesmo fabricante, com 
funcionalidades de gerenciamento de configuração, alertas e notificações e gerenciamento 
de firmware, sem necessidade de instalação de nenhum software ou dispositivo on-site; 

74. Deve suportar IPSec para comunicação com o sistema de gerenciamento; 
75. Deve implementar sFlow (IPv4 e IPv6); 
76. Deve possuir interface web para configuração; 
77. Deve implementar TR-69 (CPE WAN Management Protocol); 
78. Deve suportar diagnóstico de transceivers ópticos; 
79. Deve implementar Syslog sobre TLS; 
80. Deve implementar Secure SFTP (SFTP); 
81. Deve implementar SNMP v1/v2/v3; 
82. Deve implementar funcionalidade que permita monitorar o SLA (Service Level Agreement) de 

conexões IP. Deve suportar os seguintes testes: ICMP Echo, UDP-Echo (em porta 
configurável) e TCP-Connect (em porta configurável) e Jitter UDP para voz; 

83. Deve implementar compatibilidade com o protocolo CDP para provisionamento de telefones 
IP; 

84. Deve implementar o isolamento de um Access Point rogue conectado ao switch, quando este 
for detectado por solução de WLAN do mesmo fabricante; 

85. Deve implementar a configuração automática de Access Point wireless do mesmo fabricante 
quando conectado ao switch. Devem ser suportados os seguintes parâmetros para a 
configuração automática: VLAN, CoS, largura de banda máxima; 

86. Deve suportar o encaminhamento de tráfego para controladora wireless do mesmo 
fabricante para inspeção e controle de acesso. 

  

 Licenciamento 

87. Deve ser fornecido com a versão de software mais completa disponível para o equipamento; 
88. Deve ser fornecido com todas as licenças de software necessárias para o funcionamento 

integral de todas as funcionalidades disponíveis para o equipamento. 

  

Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 
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2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos equipamentos, 
indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 10 – SWITCH DE ACESSO L2 COM 24 PORTAS GIGABIT E 4 SFP 

  

1. Deve possuir 24 portas 10/100/1000; 
2. Deve possuir 4 portas 1G SFP; 
3. Deve possuir capacidade de encaminhamento de, no mínimo, 40 Mpps; 
4. Deve possuir capacidade de comutação de, no mínimo, 56 Gbps; 
5. Deve implementar IEEE 802.3az para as portas 10/100/1000; 
6. Deve possuir uma interface de console USB; 
7. Deve suportar agregação com suporte a até 8 portas por grupo; 
8. Deve possuir 16.000 endereços MAC; 
9. Deve possuir latência máxima de 4 μs para links de 1000Mbps, considerando pacotes de 64 

bytes; 
10. Deve implementar funcionalidade que permita a detecção de links unidirecionais; 
11. Deve implementar virtual stacking permitindo o gerenciamento de, no mínimo, 16 switches 

com mesmo endereço IP; 
12. Deve implementar 512 VLANs simultaneamente; 
13. Deve implementar MVRP (Multiple VLAN Registration Protocol); 
14. Deve implementar LLDP (IEEE 802.1ab); 
15. Deve implementar LLDP-MED; 
16. Deve implementar PVST+, RPVST+ ou protocolo compatível; 
17. Deve implementar MSTP (IEEE 802.1s); 
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18. Deve implementar Gateway mDNS, com suporte a Apple Bonjour; 
19. Deve implementar IEEE 802.1p permitindo a classificação de tráfego com até 8 filas de 

prioridade; 
20. Deve permitir a priorização de tráfego por porta e VLAN; 
21. Deve implementar controle de broadcast; 
22. Deve implementar rate limiting para pacotes ICMP; 
23. Deve implementar rate limiting para tráfego broadcast e multicast; 
24. Deve suportar espelhamento de portas; 
25. Deve implementar RADIUS authentication; 
26. Deve implementar RADIUS accounting; 
27. Deve implementar TACACS+; 
28. Deve implementar IEEE 802.1X com, no mínimo, 8 (oito) autenticações por porta; 
29. Deve implementar SSHv2; 
30. Deve implementar SSH para IPv6; 
31. Deve implementar DHCP snooping; 
32. Deve implementar user role localmente permitindo criar políticas de acesso de segurança e 

QoS, por perfil de usuário e dispositivos; 
33. Deve implementar autenticação baseada em web; 
34. Deve implementar NTP com autenticação MD5; 
35. Deve suportar duas imagens de software na flash; 
36. Deve suportar múltiplos arquivos de configuração na flash; 
37. Deve permitir o agendamento de tarefas, permitindo executar um comando ou grupo de 

comandos em um dia e horário específicos; 
38. Deve implementar sFlow (IPv4 e IPv6) ou Netflow; 
39. Deve implementar RMON com os grupos statistics, history, alarms e events; 
40. Deve possuir interface web para configuração; 
41. Deve implementar TR-69 (CPE WAN Management Protocol); 
42. Deve suportar a auto-configuração dos switches através de DHCP e software de 

gerenciamento, sem necessidade de nenhuma intervenção no switch (com configuração de 
fábrica); 

43. Deve suportar Digital Optical Monitoring (DOM) para transceivers ópticos; 
44. Deve implementar Syslog sobre TLS; 
45. Deve implementar SFTP ou SCP; 
46. Deve implementar SNMP v1/v2/v3 
47. Deve permitir gerar notificação caso seja excedido o limite de MACs; 
48. Deve implementar compatibilidade com o protocolo CDP para provisionamento de telefones 

IP; 
49. Deve implementar o isolamento de um Access Point rogue conectado ao switch, quando este 

for detectado por solução de WLAN do mesmo fabricante; 
50. Deve implementar a configuração automática de Access Point wireless do mesmo fabricante 

quando conectado ao switch. Devem ser suportados os seguintes parâmetros para a 
configuração automática: VLAN, CoS, largura de banda máxima; 

51. Deve ser fornecido com a versão de software mais completa disponível para o equipamento; 
52. Deve ser fornecido com todas as licenças de software necessárias para o funcionamento 

integral de todas as funcionalidades disponíveis para o equipamento; 

  

Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
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atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos equipamentos, 
indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

   

ITEM 11 – SWITCH DE ACESSO L2 COM 48 PORTAS GIGABIT E 4SFP 

  

1. Deve possuir 48 portas 10/100/1000; 
2. Deve possuir 4 portas 1G SFP; 
3. Deve possuir capacidade de encaminhamento de, no mínimo, 77 Mpps; 
4. Deve possuir capacidade de comutação de, no mínimo, 104 Gbps; 
5. Deve implementar IEEE 802.3az para as portas 10/100/1000; 
6. Deve possuir uma interface de console USB; 
7. Deve suportar agregação com suporte a até 8 portas por grupo; 
8. Deve possuir 16.000 endereços MAC; 
9. Deve possuir latência máxima de 4 μs para links de 1000Mbps, considerando pacotes de 64 

bytes; 
10. Deve implementar funcionalidade que permita a detecção de links unidirecionais; 
11. Deve implementar virtual stacking permitindo o gerenciamento de, no mínimo, 16 switches 

com mesmo endereço IP; 
12. Deve implementar 512 VLANs simultaneamente; 
13. Deve implementar MVRP (Multiple VLAN Registration Protocol); 
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14. Deve implementar LLDP (IEEE 802.1ab); 
15. Deve implementar LLDP-MED; 
16. Deve implementar PVST+, RPVST+ ou protocolo compatível; 
17. Deve implementar MSTP (IEEE 802.1s); 
18. Deve implementar Gateway mDNS, com suporte a Apple Bonjour; 
19. Deve implementar IEEE 802.1p permitindo a classificação de tráfego com até 8 filas de 

prioridade; 
20. Deve permitir a priorização de tráfego por porta e VLAN; 
21. Deve implementar controle de broadcast; 
22. Deve implementar rate limiting para pacotes ICMP; 
23. Deve implementar rate limiting para tráfego broadcast e multicast; 
24. Deve suportar espelhamento de portas; 
25. Deve implementar RADIUS authentication; 
26. Deve implementar RADIUS accounting; 
27. Deve implementar TACACS+; 
28. Deve implementar IEEE 802.1X com, no mínimo, 8 (oito) autenticações por porta; 
29. Deve implementar SSHv2; 
30. Deve implementar SSH para IPv6; 
31. Deve implementar DHCP snooping; 
32. Deve implementar user role localmente permitindo criar políticas de acesso de segurança e 

QoS, por perfil de usuário e dispositivos; 
33. Deve implementar autenticação baseada em web; 
34. Deve implementar NTP com autenticação MD5; 
35. Deve suportar duas imagens de software na flash; 
36. Deve suportar múltiplos arquivos de configuração na flash; 
37. Deve permitir o agendamento de tarefas, permitindo executar um comando ou grupo de 

comandos em um dia e horário específicos; 
38. Deve implementar sFlow (IPv4 e IPv6) ou Netflow; 
39. Deve implementar RMON com os grupos statistics, history, alarms e events; 
40. Deve possuir interface web para configuração; 
41. Deve implementar TR-69 (CPE WAN Management Protocol); 
42. Deve suportar a auto-configuração dos switches através de DHCP e software de 

gerenciamento, sem necessidade de nenhuma intervenção no switch (com configuração de 
fábrica); 

43. Deve suportar Digital Optical Monitoring (DOM) para transceivers ópticos; 
44. Deve implementar Syslog sobre TLS; 
45. Deve implementar SFTP ou SCP; 
46. Deve implementar SNMP v1/v2/v3 
47. Deve permitir gerar notificação caso seja excedido o limite de MACs; 
48. Deve implementar compatibilidade com o protocolo CDP para provisionamento de telefones 

IP; 
49. Deve implementar o isolamento de um Access Point rogue conectado ao switch, quando este 

for detectado por solução de WLAN do mesmo fabricante; 
50. Deve implementar a configuração automática de Access Point wireless do mesmo fabricante 

quando conectado ao switch. Devem ser suportados os seguintes parâmetros para a 
configuração automática: VLAN, CoS, largura de banda máxima; 

51. Deve ser fornecido com a versão de software mais completa disponível para o equipamento; 
52. Deve ser fornecido com todas as licenças de software necessárias para o funcionamento 

integral de todas as funcionalidades disponíveis para o equipamento. 
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Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos equipamentos, 
indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 12 – GBIC 10GB PARA ATÉ 300M 

  

Características técnicas mínimas 

1. Deve ser do tipo SFP+ de 10GBASE-SR com conector LC; 
2. Compatibilidade integral com os Itens 5, 6, 8 e 9. 

  

Garantia e Suporte 

3. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
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de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

4. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

5. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

  

ITEM 13 – CABO DAC 10GB DE 1M 

  

Características técnicas mínimas 

1. Cabo metálico com conector tipo SFP+ para ligação de duas unidades de switch em 10 Gbps; 
2. Cabo com comprimento mínimo de 1 (um) metro; 
3. Compatibilidade integral com os itens 5, 6, 8 e 9. 

  

Garantia e Suporte 

4. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

5. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

6. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 14 – CABO DAC 10GB DE 3M 

  

Características técnicas mínimas 

1. Cabo metálico com conector tipo SFP+ para ligação de duas unidades de switch em 10 Gbps; 
2. Cabo com comprimento mínimo de 3 (três) metros; 
3. Compatibilidade integral com os itens 5, 6, 8 e 9. 
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Garantia e Suporte 

4. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

5. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

6. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 15 – GBIC 1GB PARA ATÉ 500M 

  

Características técnicas mínimas 

1. Deve ser do tipo SFP de 1G BASE-SX com conector LC; 
2. Compatibilidade integral com os Itens 5, 6, 8, 9, 10 e 11. 

  

Garantia e Suporte 

3. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

4. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

5. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 16 – SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE TECNOLOGIA PARA SWITCHS DE REDE 

  

Características Gerais 
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1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das 14:00 às 18:00) 
presencialmente no TRE-AL ou remotamente conforme necessidades da CONTRATANTE; 

  

Implantação 

2. Instalação e configuração de no mínimo 10 (dez) switchs de rede, contemplando: 
3. Configuração básica de acesso a gerencia via rede; 
4. Gerencia e monitoramento em MÓDULO DE GERENCIA DE REDE; 
5. Configuração de autenticação de usuários em MÓDULO DE CONTROLE DE ACESSO; 
6. Configuração de no mínimo 10 (dez) VLANs; 
7. Configuração de stacking de 2 (duas) pilhas com no máximo 4 (quatro) switchs; 
8. Configuração de agregação de links em até 10 (dez) switchs com no máximo 4 (quatro) 

portas por dispositivo. 

  

Transferência de Tecnologia 

9. O treinamento deverá ser no realizado na modalidade workshop com tarefas práticas hands-
on, visando assim a melhor fixação dos temas abordados com foco direto na explicação da 
tecnologia dos produtos ofertados como também nas rotinas de configuração, 
gerenciamento, administração e operação dos mesmos, devendo ter duração mínima de 24 
(vinte e quatro) horas onde serão abordados no mínimo os seguintes tópicos: 

a. Configuração inicial e acesso a gerencia; 
b. Configuração de VLANS; 
c. Configuração de autenticação de usuários em MÓDULO DE CONTROLE DE ACESSO; 
d. Configuração de empilhamento de switchs; 
e. Configuração de agregação de links; 
f. Configuração de switchs para MÓDULO DE GERENCIA DE REDE; 
g. Configuração de switchs para MÓDULO DE ANÁLISE DE TRÁFEGO. 

  

ITEM 17 - SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE TECNOLOGIA DO MÓDULO DE 
CONTROLE DE ACESSO 

  

Características Gerais 

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das 14:00 às 18:00) 
presencialmente no TRE-AL ou remotamente conforme necessidades da CONTRATANTE; 

  

Implantação 

2. Instalação e configuração de 1 (uma) instância do serviço controle de acesso, contemplando 
configurações básicas para acesso à rede, dimensionamento, configuração de 
armazenamento; 
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3. Configuração de autenticação em Active Directory para usuários corporativos; 
4. Configuração de autenticação de visitantes com portal de autosserviço para criação de 

usuários; 
5. Configuração de no mínimo 10 (dez) dispositivos de rede para autenticação na solução. 

  

Transferência de Tecnologia 

6. O treinamento deverá ser no realizado na modalidade workshop com tarefas práticas hands-
on, visando assim a melhor fixação dos temas abordados com foco direto na explicação da 
tecnologia da solução como também nas rotinas de configuração, gerenciamento, 
administração e operação da mesma devendo ter duração mínima de 24 (vinte e quatro) 
horas onde será abordado no mínimo os seguintes tópicos: 

a. Configuração de Active Directory como base de autenticação; 
b. Configuração de autenticação de usuários corporativos; 
c. Configuração de autenticação de usuários visitantes; 
d. Configuração de portal de autosserviço; 
e. Configuração de autenticação e autorização com RADIUS. 

  

ITEM 18 – TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE SWITCHES 

  

Características Gerais 

1. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do fabricante no 
Treinamento Básico de Administração dos Switches para 01 (um) profissional da contratante; 

2. O voucher deverá ter validade de pelo menos 12 (doze) meses; 
3. O treinamento deverá ser de acordo com o calendário de treinamento do fabricante e 

ministrado em centro oficial de treinamento do mesmo ou remotamente, utilizando 
tecnologia de ensino a distância; 

4. Deverá ser ministrado por profissional devidamente credenciado junto ao fabricante e apto a 
entregar o respectivo; 

5. O treinamento deverá compreender a explicação da tecnologia da solução como também das 
rotinas de configuração, gerenciamento, administração e operação da mesma; 

6. O treinamento deverá ter carga horária mínima de 24 (vinte e quatro) horas, ministrado no 
período de 08:00 às 12:00 e das 14:00 às 18:00. 

  

ITEM 19 – TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE ACESSO 

  

Características Gerais 

1. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do fabricante no 
Treinamento da Solução de Controle de Acesso para 01 (um) profissional da contratante; 

2. O voucher deverá ter validade de pelo menos 12 (doze) meses; 
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3. O treinamento deverá ser de acordo com o calendário de treinamento do fabricante e 
ministrado em centro oficial de treinamento do mesmo ou remotamente, utilizando 
tecnologia de ensino a distância; 

4. Deverá ser ministrado por profissional devidamente credenciado junto ao fabricante e apto a 
entregar o respectivo; 

5. O treinamento deverá compreender a explicação da tecnologia da solução como também das 
rotinas de configuração, gerenciamento, administração e operação da mesma; 

6. O treinamento deverá ter carga horária mínima de 40 (Quarenta) horas, ministrado no 
período de 08:00 às 12:00 e das 14:00 às 18:00; 

  

  

LOTE 02 – SOLUÇÃO DE REDE WIRELESS 

 
  

ITEM 20 – SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO PARA SOLUÇÃO DE REDE 
WIRELESS 

LICENCIAMENTO 

1. Licenciamento da SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO, contemplando o 
quantitativo mínimo de 1.000 (um mil) dispositivos, usuários corporativos ou visitantes 
simultâneos, independente do perfil de autenticação, seja por dispositivo ou usuário; 

2. Caso a solução ofertada necessite de licenciamento específico para credenciamento dos 
dispositivos, usuários (corporativos ou visitantes), deverá ser fornecido o quantitativo 
solicitado para ambos, de forma que a solução realize a análise de perfil e o controle de 
acesso dos 1.000 (um mil) dispositivos ou usuários (corporativos ou visitantes) simultâneos. 

  

MÓDULO DE ANÁLISE DE PERFIL DE DISPOSITIVO 

Características Gerais Modulo de Análise de Perfil de Dispositivo 

3. Deve implementar funcionalidade de classificação automática criando perfis de dispositivos, 
de forma a descobrir, classificar e agrupar os dispositivos conectados na rede; 

4. Deve categorizar os dispositivos em pelo menos 3 níveis: 

d. Por tipo de dispositivo (ex. Computador, Smartdevice, impressora, etc.); 
e. Por sistema operacional (ex. Windows, Linux, MacOS, etc.); 
f. Versão do sistema operacional (ex. Windows 7, Windows 2008 Server, etc.); 

5. Deve ser capaz de gerar gráficos das categorias separando os dispositivos conforme suas 
características; 

6. Deve suportar a coleta de informações, para classificação, usando no mínimo: 

k. DHCP; 
l. HTTP User-Agent; 
m. MAC OUI; 
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n. ActiveSync plugin; 
o. SNMP; 
p. Subnet Scanner; 
q. IF-MAP; 
r. Cisco Device Sensor; 
s. MDM; 
t. TCP Fingerprinting. 

7. Deve possuir dicionário de categorias de dispositivos pré-configurado e mecanismo de 
atualização do mesmo; 

8. Deve suportar a integração com, no mínimo, as seguintes soluções de MDM de mercado 
AirWatch, MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, MaaS 360 devendo comprovar 
a compatibilidade em documentação oficial do fabricante; 

9. Deve permitir priorização na ordem de criação dos perfis com no mínimo as seguintes 
características: 

f. Agente proprietário; 
g. HTTP User-Agent; 
h. SNMP; 
i. DHCP; 
j. MAC OUI. 

10. A solução de análise de perfil de usuários deverá permitir consultas a sua base, pela solução 
de controle de acesso para validação de dispositivos com base no seu perfil. 

  

MÓDULO DE CONTROLE DE ACESSO DE DISPOSITIVOS E USUÁRIOS 

Características Gerais 

11. A Solução deverá dar suporte a no mínimo as seguintes bases de dados: 

n. Microsoft Active Directory; 
o. Kerberos; 
p. Diretórios LDAP; 
q. OpenLDAP; 
r. PostgreSQL; 
s. Oracle 11g; 
t. MariaDB; 
u. MSSQL; 
v. Servidores de Token; 
w. Base de dados SQL interna; 
x. Lista interna estática de hosts. 

12. Deve suportar "Single Sign-on" (SSO) através de SAML v2.0; 
13. Deve implementar gerenciamento e aplicação de políticas de autorização de acesso de 

usuários com base em: 

f. Atributos do usuário autenticado; 
g. Hora do dia, dia da semana; 
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h. Tipo de dispositivo utilizado; 
i. Localização do usuário; 
j. Tipo de autenticação utilizada. 

14. Deve permitir a visualização de todas informações relativas a cada transação e autenticação 
em uma única tela, a solução deverá trazer no mínimo as seguintes informações: 

m. Data e Hora; 
n. Mac Address do dispositivo; 
o. Classificação do dispositivo; 
p. Usuário; 
q. Equipamento que requisitou a autenticação (origem); 
r. Método de autenticação utilizado; 
s. Fonte de autenticação utilizada para validação; 
t. Perfil de acesso aplicado; 
u. Atributos de entrada do protocolo utilizados na requisição (ex. RADIUS); 
v. Informações de resposta da solução para o elemento de rede; 
w. Alertas em caso de falha; 
x. LOGS já filtrados para a requisição em análise. 

15. Deve possuir Dashboard customizável, onde deve permitir a visualização de no mínimo as 
seguintes informações: 

a.  
a. Lista com últimos Alertas do sistema; 
b. Gráfico com todas as requisições de autenticação dos últimos 7 dias, incluindo 

RADIUS, TACACS+ e Autenticações Web; 
c. Gráfico com o status das autenticações aceitas e rejeitadas nos últimos 7 dias; 
d. Gráfico com a categorização dos dispositivos classificados pela solução, divididos de 

acordo com as categorias de classificação; 
e. Últimas falhas de autenticação; 
f. Gráfico com as requisições de avaliação de postura dos dispositivos, divididos em: 

  
I. Saudáveis (dentro das políticas estabelecidas); 
II. Não saudáveis (que estão fora das políticas estabelecidas); 

a.  
a. Lista com as últimas autenticações; 
b. Lista com as últimas autenticações com sucesso; 
c. Utilização de CPU do sistema, no mínimo nos últimos 30 minutos; 

16. Deve possuir base de regras e categorias de dispositivos pré-configurada e mecanismo de 
atualização da mesma; 

17. Deve suportar a integração com no mínimo as seguintes soluções de MDM de mercado 
AirWatch, MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, MaaS 360 devendo comprovar 
a compatibilidade em documentação oficial do fabricante; 

18. Deve suportar autenticações via OAuth2, Facebook, Twitter, LinkdIn, Office365 e Google 
Apps; 

19. Deve possuir recursos integrados de AAA: RADIUS, TACACS+ e Kerberos; 
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20. Deve possuir suporte aos seguintes recursos: 

m. RADIUS; 
n. RADIUS CoA; 
o. TACACS+; 
p. Web authentication; 
q. SAML v2.0; 
r. EAP-FAST (EAP-MSCHAPv2, EAP-GTC, EAP-TLS); 
s. PEAP (EAP-MSCHAPv2, EAP-GTC, EAP-TLS, EAP-PEAP-Public); 
t. TTLS (EAP-MSCHAPv2, EAP-GTC, EAP- TLS, EAP-MD5, PAP, CHAP); 
u. EAP-TLS; 
v. PAP, CHAP, MSCHAPv1, MSCHAPv2, e EAP-MD5; 
w. Windows machine authentication; 
x. MAC address authentication (dispositivos sem suporte a 802.1X); 

21. Deve suportar verificação de vulnerabilidade através de varredura de portas; 
22. Deve suportar à aplicação de políticas em ambiente com múltiplos fornecedores de Wireless, 

cabeado e VPN; 
23. Deve possuir CA integrada, para geração de certificados para os dispositivos que forem se 

autenticar na rede; 
24. Deve suportar à integração com plataforma de terceiros usando HTTP/RESTful API; 
25. Deve permitir que a solução faça consultas em bases SQL, com o objetivo de buscar 

informação a serem utilizadas durante o processo de autenticação dos usuários; 
26. Deve possuir suporte a administração através de IPv6; 
27. Deve possuir ferramenta para gerenciar os processos de credenciamento, autenticação, 

autorização e contabilização de usuários visitantes através de portal web seguro; 
28. Deve implementar a criação de grupos de autorizadores com privilégios distintos de criação 

de credenciais temporárias e atribuição de permissões de acesso aos clientes; 
29. Deve permitir realizar a autenticação dos autorizadores em base externa do tipo Microsoft 

Active Directory ou LDAP e atribuir o privilégio ao autorizador de acordo com o seu perfil; 
30. Deve implementar as funcionalidades de geração de lotes de credenciais aleatórias, 

temporárias, pré-autorizadas; 
31. Deve implementar a importação e exportação da relação de credenciais temporárias através 

de arquivos txt ou csv; 
32. Deve permitir a configuração do tempo de validade das credenciais, baseando-se na criação 

da conta ou no primeiro login da conta; 
33. Deve permitir que o visitante crie sua própria credencial temporária (autosserviço) através 

de portal web, com ou sem a necessidade de um autorizador; 
34. Deve permitir a customização do formulário de criação de credenciais, a ser preenchido pelo 

autorizador ou pelo visitante em caso de autosserviço, especificando quais informações 
cadastrais dos visitantes são obrigatórias ou opcionais; 

35. Deve permitir a customização do nível de segurança da senha temporária que será gerada 
ao visitante, especificando a quantidade mínima de caracteres e o uso de caracteres 
especiais e números para compor a senha; 

36. Deve exigir que o usuário visitante aceite o “Termo de uso da rede” a cada login ou apenas 
no primeiro login; 

37. Deve permitir o envio das credenciais aos usuários registrados através de mensagens SMS 
(Short Message Service), e-mail ou impressão local. 

  

GARANTIA E SUPORTE 
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38. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 

39. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

40. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

41. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

42. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

  

  

ITEM 21 – SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS 

LICENCIAMENTO 

1. Deverá ser entregue o quantitativo mínimo de licenças para o gerenciamento simultâneo de 
50 (cinquenta) Pontos de acesso; 

CARACTERÍSTICAS GERAIS 

2. A solução de gerenciamento deverá administrar a configuração dos Pontos de acesso de 
forma centralizada; 

3. A solução de gerenciamento deverá possuir integração com o HPE IMC em console única de 
gerenciamento; 

4. A solução de gerenciamento de rede wireless deverá suportar, em arquitetura de 
controladora distribuída, a capacidade de gerenciar no mínimo 120 (cento e vinte) pontos de 
acesso por cluster e no mínimo um total de 20 (vinte) clusters; 

5. A solução de gerenciamento, em arquitetura de controladora física ou virtual, deverá 
suportar no mínimo 2400 pontos de acesso; 

6. Deve ser obrigatoriamente do mesmo fabricante dos pontos de acesso e controladores; 
7. Permitir a configuração e gerenciamento através de browser padrão (http, https); 
8. Permitir que os eventos sejam gravados remotamente utilizando Syslog; 
9. Prover organização hierárquica de equipamentos, permitindo que um equipamento receba as 

configurações lógicas e as replique a outros equipamentos; 
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10. Possuir capacidade de projeto automatizado de redes sem fio nos padrões 802.11a, 802.11b 
e 802.11g, 802.11n e 802.11ac, segundo a geografia do prédio (planta); 

11. Considerar a área de cobertura e a banda por usuário desejada; 
12. Possibilitar a importação de plantas baixas nos formatos dwg e jpg; 
13. Permitir a visualização de alertas da rede em tempo real; 
14. Permitir a visualização de eventuais áreas sem cobertura de RF (áreas de sombra); 
15. Monitorar o desempenho da rede wireless, consolidando informações de rede tais como: 

a. Níveis de ruído; 
b. Relação sinal-ruído; 
c. Interferência; 
d. Potência de sinal. 

16. Possuir capacidade de listagem on-line da localização de usuário, endereço IP, endereço 
MAC, nível de potência de recepção e dados de associação e de autenticação 802.1x; 

17. Deve possuir informação visual e gráfica, na planta baixa dos andares, para: 

a. Visualização dos Pontos de acesso instalados, com estado de funcionamento; 
b. Visualização do mapa de calor de RF (Heatmap); 
c. Localização de ativos conectados à rede (equipamentos 802.11); 
d. Localização de Pontos de acesso rogue. 

18. Caso esta funcionalidade não esteja disponível no sistema de gerência, deve ser fornecido 
software, do mesmo fabricante, para atender este item, contemplando todos os dispositivos 
licenciados e com redundância 1+1; 

19. Possuir capacidade de identificação e listagem dos rádios vizinhos e respectivos SSID/BSSID 
que podem ser percebidos por cada Ponto de acesso; 

20. Possuir capacidade de configuração gráfica completa do controlador WLAN seja ela física, 
virtual ou distribuída e respectivos Pontos de acesso; 

21. Possuir capacidade de geração de relatórios dos seguintes tipos: 

a. Listagem de clientes Wireless; 
b. Listagem de Pontos de acesso; 
c. Informações de Configuração dos Controladores WLAN; 
d. Utilização da rede; 
e. Detalhes dos Pontos de acesso não autorizados (rogues) detectados. 

22. Suportar SSH, HTTP/HTTPS, SSL, Telnet; 
23. Possuir ferramentas de debug e log de eventos para depuração e gerenciamento em 

primeiro nível; 
24. Implementar os padrões abertos de gerência de rede SNMPv2c e SNMPv3, incluindo a 

geração de traps; 
25. Possuir suporte a MIB II, conforme RFC 1213; 
26. Implementar a MIB privativa que forneça informações relativas ao funcionamento do 

equipamento; 
27. Possibilitar a obtenção da configuração do equipamento através do protocolo SNMP; 
28. Possibilitar a obtenção via SNMP de informações de capacidade e desempenho da CPU, 

memória e portas; 
29. Possibilitar a gerência e identificação individualizada de cada Ponto de acesso remoto; 
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30. Permitir a administração centralizada dos Pontos de acesso sem a necessidade de configurar 
os mesmos individualmente; 

31. Possibilitar a identificação de paredes e divisórias com respectivos níveis de atenuação por 
tipo (alvenaria, vidro, drywall e divisória); 

32. Possibilitar a importação de plantas baixas nos formatos gráficos (CAD, dwg, jpg, gif e png); 
33. Deve disponibilizar em painel gráfico de controle informações referentes à: 

a. Sistemas operacionais e tipos de dispositivos que estão se conectando a rede; 
b. Informações sobre os tipos de aplicações mais utilizados; 
c. Informações sobre usuários conectados. 

34. Deve possuir informação sobre possíveis ameaças a rede detectadas pelos sistemas 
gerenciados; 

35. Deve possibilitar criação de regras de detecção de ameaças e correlacionar todos os 
dispositivos gerenciados. 

  

 
ITEM 22 – LICENÇAS ADICIONAIS PARA SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS 

Características técnicas mínimas 

1. Licença para expansão da SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS, contemplando 
o quantitativo adicional mínimo de 1 (um) ponto de acesso simultâneo; 

2. Cada unidade deve ser fornecida com todas as licenças de software necessárias para o 
funcionamento integral de todas as funcionalidades disponíveis para SOLUÇÃO DE 
GERENCIAMENTO DE REDE WIRELESS especificada nesse edital. 

  

GARANTIA E SUPORTE 

1. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

5. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
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possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

  

  

ITEM 23 – LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 

Características técnicas mínimas 

3. Licenciamento para expansão da SOLUÇÃO DE ANALISE DE PERFIL E CONTROLE DE ACESSO, 
contemplando o quantitativo mínimo adicional de 500 (quinhentos) dispositivos, usuários 
corporativos ou visitantes simultâneos, independente do perfil de autenticação, seja por 
dispositivo ou usuário; 

  

GARANTIA E SUPORTE 

6. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 

7. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

8. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

9. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

10. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 
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ITEM 24 – CONTROLADORA WLAN 

Características gerais 

1. Solução baseada em hardware ou software específico, do tipo appliance físico ou virtual, do 
mesmo fabricante dos pontos de acesso e software de gerência; 

2. Deve estar licenciado para controle de, no mínimo, 50 (cinquenta) pontos de acesso, 
podendo ser expandido em no mínimo, 250 (duzentos e cinquenta) pontos de acesso através 
de licenciamento adicional; 

3. Permitir a conexão simultânea de, no mínimo, 4.000 clientes wireless; 
4. Permitir a gravação de eventos por meio do protocolo syslog; 
5. Acesso ao sistema através de cliente com browser padrão (http, https, Java); 
6. Permitir operação em modo mesh; 
7. Permitir o uso de múltiplos SSIDs simultaneamente; 
8. Prover tempo de fast-roaming intra-switch inferior a 25 milissegundos; 
9. Prover tempo de fast-roaming inter-switch em camada 2, inferior a 100 milissegundos; 
10. Permitir conexão entre APs sem a necessidade de conexão cabeada, implementando assim 

uma rede padrão mesh; 
11. Deve suportar 802.11e com WMM, U-APSD e T-SPEC; 
12. Gerenciar centralizadamente a autenticação de usuários; 
13. Implementar protocolo de autenticação para controle do acesso administrativo a solução 

com mecanismos de AAA; 
14. Possuir base de dados de usuários interna para autenticação de usuários convidados / 

temporários (acesso guest); 
15. Permitir autenticação em no mínimo os seguintes sistemas de base de dados de usuários 

Microsoft Active Directory, Cisco ACS server, FreeRadius, entre outros; 
16. Realizar o provisionamento de usuários convidados (guests) através de interface Web por 

meio de um usuário administrativo com permissões mínimas, exclusivas para este fim; 
17. Possuir suporte a autenticação IEEE 802.1X, com pelo menos os seguintes métodos EAP: EAP-

MD5, PEAP/EAP-GTC, PEAP/EAP-MSCHAPv2, EAP-TLS com utilização de base de usuários 
interna ou servidor RADIUS externo; 

18. Suportar as especificações: IEEE 802.1x; 
19. Deverá suportar os seguintes métodos EAP-PEAP, EAP-TLS e EAP-TTLS; 
20. Possuir suporte a autenticação IEEE 802.1X, com o método PEAP/EAP-GTC, e com utilização 

de base de usuários LDAP externa; 
21. Permitir a seleção/uso de servidor Radius ou LDAP com base no SSID; 
22. Suportar a autenticação de usuários conectados à rede cabeada através das portas do 

controlador; 
23. Possuir o recurso de EAP Offload para terminação do túnel EAP no próprio controlador; 
24. Deve suportar utilização de Portal Captivo externo ao controlador; 
25. Permitir a autenticação (através de endereço MAC, Portal Captivo ou IEEE 802.1X) de 

usuários conectados à rede WLAN (wireless) ou usuários conectados às portas cabeadas do 
controlador. Também deverá permitir a autenticação de usuário e de máquina por meio de 
IEEE 802.1x; 

26. Oferecer recurso de Portal Captivo (Captive Portal) com suporte a múltiplos portais 
simultaneamente; 

27. Implementar associação dinâmica de usuário a VLAN, com base nos parâmetros da etapa de 
autenticação; 
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28. Implementar Qualidade de Serviço com a marcação de pacotes utilizando Diffserv e suporte 
a 802.1p para QoS de rede; 

29. Possibilitar roaming com integridade de sessão, dando suporte a aplicações em tempo real, 
tais como, VoIP, VoWLAN, videoconferência, dentre outras; 

30. Permitir portais captivos externos a controladora; 
31. A controladora deve possuir funcionalidade de conexão Site to Site VPN utilizando padrão 

Ipsec. Caso a solução fornecida não possua a funcionalidade, será aceita solução de VPN 
adicional integrada; 

32. Deve permitir o tunelamento do trafego de dados de usuários mesmo em redes L3, não 
sendo necessário estender VLANs até o Ponto de Acesso, inclusive em MANs e WANs; 

33. Implementar segurança IEEE 802.11i; 
34. Suportar a criptografia centralizada com os seguintes protocolos: AES-CCMP, TKIP e WEP; 
35. Suportar, no mínimo, 2000 VLANs; 
36. Implementar o protocolo 802.1w (Rapid Spanning Tree); 
37. Oferecer suporte a roteamento e switching de camadas L2 e L3; 
38. Possuir o recurso de criação de Pools de VLAN para permitir a escalabilidade de redes; 
39. Possuir servidor DHCP embutido; 
40. Suportar o protocolo VRRP para redundância de controladores; 
41. Deve suportar redundância de controladores nos modos: 

a. 1+1; 
b. N+1; 
c. Ativo-Ativo; 
d. Ativo-Standby; 

42. Oferecer os recursos de mobilidade entre VLANs para roaming de camada 2; 
43. Oferecer os recursos de Proxy de endereços IP e Proxy DHCP para roaming entre redes (L3) 
44. Deve implementar northbound APIs para realização de integrações com aplicações de 

terceiros para fins de monitoramento e visibilidade. Caso seja necessário, deve ser ofertado 
licenças para ativação desse recurso; 

45. Implementar tagging de VLANs através do protocolo 802.1Q; 
46. Implementar o protocolo 802.1d para Spanning Tree (STP); 
47. O controlador WLAN poderá estar diretamente e/ou remotamente conectado aos APs por ele 

gerenciados, inclusive via roteamento nível 3 da camada OSI 
48. Se um controlador WLAN ou AP controlador falhar, os APs relacionados deverão se associar a 

um controlador WLAN alternativo de forma automática, não permitindo que a rede wireless 
se torne inoperante; 

49. Realizar a descoberta automática dos APs na infraestrutura wireless; 
50. Permitir o controle dos APs mediante a conexão através de topologia MESH (WiFi Mesh); 
51. A rede MESH deverá oferecer comportamento determinístico da topologia da rede MESH; 
52. A rede MESH deverá prover auto-redundância das camadas física (RF) e Layer 2 com 

comportamento determinístico; 
53. Permitir a conexão de APs de maneira remota e segura; 
54. Conectar APs através de redes públicas e/ou privadas com garantia de segurança através de 

conexão criptografada; 
55. Permitir a propagação de SSIDs de maneira segura para qualquer AP legitimamente 

cadastrado na controladora, independentemente de onde este AP esteja conectado; 
56. Permitir a autenticação do AP remoto através de certificado digital ou de usuário e senha 

cadastrados em servidor AD e Radius; 
57. Gerenciar o tráfego dos APs centralizadamente; 
58. Administrar a configuração dos AP’s; 
59. Deve permitir administrar centralizadamente todos os aspectos de segurança da rede WLAN 

através de firewall integrado à solução de rede sem fio, caso a solução ofertada não possua 
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solução de firewall nativa na controladora WLAN deverá ser ofertado firewall externo com 
capacidade para atender toda a solução; 

60. Permitir o bloqueio de comunicação entre clientes wireless – L2 bridging; 
61. Implementar filtros baseados em protocolos e em endereços MAC; 
62. Implementar padrão IEEE 802.11h; 
63. Realizar o controle de autorização baseado em perfis de acesso; 
64. Permitir que seja configurado um perfil de acesso, com regras aplicadas de firewall, para o 

qual será direcionado o usuário após sua autenticação; 
65. Possuir o recurso de “blacklisting” contra ataques ao Firewall e à rede wireless, evitando que 

um determinado cliente se associe à rede wireless caso viole políticas definidas de Firewall 
ou execute algum ataque à rede WLAN de endereços MAC de APs do sistema; 

66. O Firewall deverá implementar os recursos de NAT (Network Address Translation) tanto para 
destino quanto para origem; 

67. Implementar listas de controle de acesso (ACLs); 
68. Oferecer detecção e proteção integrada de ataques de negação de serviços TCP, ICMP; 
69. Permitir o espelhamento de sessão e logs detalhados por pacote a fim de possibilitar análises 

forenses; 
70. Permitir a aplicação de políticas de camada 4, de acordo com as características do usuário. 

Por exemplo, um usuário que pertença ao grupo de gerentes (cadastrado no Radius ou Active 
Directory) terá permissão de acesso ao protocolo FTP no servidor de ERP; 

71. Permitir derivação de políticas de acesso. Por exemplo, um usuário pode pertencer a um 
grupo ao qual foram atribuídas políticas de acesso em camada 4, porém, caso esteja 
utilizando um dispositivo de voz, o tráfego SIP passará a ter prioridade através de aplicação 
de QoS; 

72. Permitir a criação de políticas com base em horários e na localização do usuário. Por 
exemplo: bloquear o tráfego do protocol FTP após às 18 horas. 

73. O Firewall deverá ser integrado à rede WLAN de modo a permitir a desassociação de usuários 
da rede sem fio WLAN com base na violação de políticas de tráfego. Por exemplo: 
desassociar da rede WLAN e colocar em quarentena o Notebook com endereço MAC 
XX:XX:XX se o usuário tentar fazer um telnet para o servidor ABC; 

74. Otimizar o desempenho e a cobertura da radiofrequência; 
75. Ajustar automaticamente os canais de modo a otimizar a cobertura de rede e mudar as 

condições de RF baseado em performance; 
76. Detectar interferência e ajustar parâmetros de RF, evitando problemas de cobertura e 

controle da propagação indesejada de RF; 
77. Implementar varredura de RF contínua, programada ou sob demanda, com identificação de 

APs ou clientes irregulares; 
78. Deve implementar a tecnologia de “Channel load balancing”, permitindo que clientes sejam 

automaticamente distribuídos entre Pontos de Acesso adjacentes operando em canais 
distintos, com o objetivo de balancear a carga entre os Pontos de Acesso; 

79. Deve implementar a tecnologia de “Band Steering/Select”, permitindo que clientes com 
suporte a faixa de frequência de 5GHz se conectem aos Pontos de Acesso utilizando, 
preferencialmente, a faixa de 5GHz; 

80. Implementar varredura de RF nas bandas 802.11a, 802.11b, 802.11g, 802.1n e 802.11ac 
para identificação de ataques e APs intrusos não autorizados (rogues); 

81. Realizar a varredura no canal de operação do AP sem impacto na performance da rede 
WLAN; 

82. Permitir a varredura em todos os canais possíveis de RF para detecção e contenção de 
ameaças na rede WLAN; 

83. Deve fazer a varredura dos espectros de 2,4 GHz e 5 GHz para localização e classificação de 
interferências não 802.11, analise de espectro, e evita-las automaticamente; 
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84. O controlador deve possuir funcionalidade de analisador gráfico de espectro para detecção 
de interferências nas faixas de frequência de 2.4 e 5 GHz, sejam elas IEEE 802.11 ou não. 
Deve disponibilizar interface gráfica com, pelo menos, gráficos de Fast Fourier Transform 
(FFT) e espectrograma; Caso a funcionalidade não possa ser apresentada pelo controlador, 
deve ser fornecido um equipamento ou software, do mesmo fabricante, que o faça; 

85. Utilizar os APs como ”sensores” de RF para fazer a monitoração do ambiente Wireless; 
86. Classificar automaticamente APs válidos, os que interferem e os não autorizados (rogues); 
87. Implementar mecanismos para detecção e contenção de APs não autorizados (rogues); 
88. Realizar a contenção automática dos APs Rogue, simultaneamente, através da rede WLAN 

e/ou da rede cabeada; 
89. Realizar a identificação e contenção de redes “ad-hoc”; 
90. Detectar e bloquear o bridging entre estações da rede WLAN; 
91. Oferecer proteção contra ataques Denial Of Service (DOS) a APs e estações 
92. Detectar e alertar os seguintes tipos de ataques na rede WLAN: 

a. Impersonalização de AP válido; 
b. Floods de Frames; 
c. Fake Ap, Airjack; 
d. Broadcasts de de-autenticação; 
e. Ataques baseados em probes; 

93. Possuir capacidade de gerar alarmes e executar contra-ataques se um ataque for detectado; 
94. Detectar áreas de sombra de cobertura e efetuar os devidos ajustes para sua correção, 

automaticamente; 
95. Ajustar, dinamicamente, o nível de potência e canal de rádio dos APs, de modo a otimizar o 

tamanho da célula de RF, garantindo a performance e escalabilidade; 
96. Permitir o controle de banda disponível (bandwith contracts) por usuário ou através de perfis 

de usuários; 
97. Possibilitar roaming com integridade de sessão, dando suporte a aplicações em tempo real, 

tais como, VoIP, VoWLAN, videoconferência, dentre outras; 
98. Deve possuir mecanismo de controle de admissão de chamadas nos pontos de acesso (CAC); 
99. Possuir mecanismo automático de QoS para protocolos de voz (SIP, SVP e SCCP) utilizando 

inspeção automática de pacotes, sem a necessidade de fazer a marcação prévia (tagging) de 
pacotes; 

100. Deve possuir solução de identificação de aplicações através de técnicas de análise de 
tráfego, provendo informações das aplicações mais utilizadas na interface gráfica; 

101. Permitir a criação de políticas de acesso baseadas nas aplicações, como por exemplo, 
o acesso a “redes sociais” terá um controle de banda de 2Mpbs. 

102. Apresentar informações gráficas referente a utilização de soluções de comunicações 
unificadas (UC) sobre a infraestrutura WLAN, de formar a apresentar informações referentes 
as chamadas realizadas e relações gráficas entre o nível de sinal recebido pelo usuário e a 
qualidade da chamada. 

103. Possuir a funcionalidade da utilização do protocolo Bonjour na infraestrutura, 
permitindo que os serviços divulgados via mDNS sejam controlados, filtrados e 
disponibilizados entre diferentes subnets, tornando assim possível a utilização em redes com 
múltiplas subnets e um número grande de dispositivos. 

104. Cada unidade deve ser fornecida com todas as licenças de software necessárias para o 
funcionamento integral de todas as funcionalidades disponíveis. 

Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
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atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos equipamentos, 
indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

 
  

ITEM 25 – LICENÇAS ADICIONAIS PARA CONTROLADORA WLAN 

Características técnicas mínimas 

3. Licença para expansão da CONTROLADORA WLAN, contemplando o quantitativo adicional 
mínimo de 1 (um) ponto de acesso simultâneo; 

4. Deve ser compatível com controladora WLAN especificada nesse edital; 
5. Cada unidade deve ser fornecida com todas as licenças de software necessárias para o 

funcionamento integral de todas as funcionalidades disponíveis para CONTROLADORA 
WLANespecificada nesse edital. 

  

GARANTIA E SUPORTE 

6. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
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modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 

7. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

8. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

9. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

10. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

 
  

ITEM 26 – PONTO DE ACESSO INTERNO TIPO 01 

Características gerais 

1. Equipamento de Ponto de Acesso para rede local sem fio, configurável via software, com 
funcionamento simultâneo nos padrões IEEE 802.11a/n/ac, 5GHz, e IEEE 802.11b/g/n, 
2.4GHz; 

2. Todos os Pontos de acesso sem fio deverão ser novos e sem nenhum histórico de utilização; 
3. Os pontos de acesso deverão possuir certificado emitido pelo “WIFI Alliance” comprovando 

no mínimo os seguintes padrões, protocolos e funcionalidades: 

a. IEEE 802.11a; 
b. IEEE 802.11b; 
c. IEEE 802.11g; 
d. IEEE 802.11n; 
e. IEEE 802.11d; 
f. IEEE 802.11ac; 
g. WPA® Enterprise/Personal; 
h. WPA2® Enterprise/Personal; 
i. EAP-TLS; 
j. EAP-TTLS/MSCHAPv2; 
k. PEAPv0/EAP-MSCHAPv2; 
l. PEAPv1/EAP-GTC; 
m. EAP-SIM; 
n. EAP-FAST; 
o. WMM® e WMM® Power Save; 
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p. Beamforming; 
q. Short Guard Interval (SGI); 
r. Packet Aggregation (A-MPDU); 
s. Opportunistic Key Caching (OKC) 

4. Deve operar simultaneamente em 2.4GHz e 5GHz (concurrent dual-band); 

  

Performance 

5. Deve suportar rádio dual, 5 GHz 802.11ac 2x2 MIMO e 2.4GHz 802.11n 2x2 MIMO 
6. Deve suportar capacidade de 1300 Mbps de throughput ou superior; 
7. Deve possuir rádio duplo configurável pelo software suportando 5 GHz e 2,4 GHz; 
8. Deve possuir no mínimo dois spatial stream Single User (SU) MIMO para taxa de dados sem 

fio de até 867 Mbps para dispositivos cliente individuais (VHT80) 2x2 em 5GHz; 
9. Deve possuir no mínimo dois spatial stream Single User (SU) MIMO para uma taxa de dados 

sem fio de até 400 Mbps para dispositivos clientes compatíveis (2x2 VHT40) em 5GHz; 
10. Deve possuir suporte para até 255 dispositivos cliente associados por rádio e até 16 BSSIDs 

por rádio; 
11. Deve suportar no mínimo as bandas de frequência: 

a. 2,400 a 2,4835 GHz 
b. 5.150 a 5.250 GHz 
c. 5,25 a 5,350 GHz 
d. 5,470 a 5,725 GHz 
e. 5,725 a 5,850 GHz 

12. Deve possuir suporte a seleção de frequência dinâmica (DFS) otimizando o uso do espectro 
de RF disponível; 

13. Deve suportar, no mínimo, as seguintes tecnologias de rádio: 

a. 802.11b: espectro espalhável de sequência direta (DSSS) 
b. 802.11a/g/n/ac: multiplexação por divisão de frequência ortogonal (OFDM) 

14. Deve suportar, no mínimo, os seguintes tipos de modulação: 

a. 802.11b: BPSK, QPSK, CCK 
b. 802.11a/g/n/ac: BPSK, QPSK, 16-QAM, 64-QAM, 256-QAM 

15. Deve possuir potência de transmissão configurável em incrementos entre 0,5 e 1,0 dBm. 
16. Deve respeitar os limites de potência de transmissão máxima (conduzida): 

a. Faixa de 2,4 GHz: +18 dBm por corrente, agregado de +21 dBm (2x2) 
b. Banda de 5 GHz: +18 dBm por corrente, agregado de +21 dBm (2x2) 

17. Deve suportar Advanced Cellular Coexistence (ACC) minimizando a interferência das redes 
celulares; 

18. Deve suportar Maximum ratio combining (MRC) para melhorar o desempenho do receptor; 
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19. Deve suportar Cyclic delay/shift diversity (CDD/CSD) para melhorar o desempenho RF de 
downlink; 

20. Deve suportar Short guard interval para canais de 20MHz, 40MHz e 80MHz; 
21. Deve suportar Space-time block coding (STBC) para aumentar o alcance e melhorar a 

recepção; 
22. Deve suportar Verificação de paridade de baixa densidade (LDPC) para correção de erros de 

alta eficiência e aumento da taxa de transferência; 
23. Deve suportar Transmit beam-forming (TxBF); 
24. Deve possuir, no mínimo, as seguintes taxas de dados suportadas (Mbps): 

a. 802.11b: 1, 2, 5.5, 11 
b. 802, 11a / g: 6, 9, 12, 18, 24, 36, 48, 54 
c. 802.11n (2.4GHz): 6.5 a 300 (MCS0 a MCS15) 
d. 802.11ac: 6.5 a 867 (MCS0 a MCS9, NSS = 1 a 2 for VHT20/40/80 

25. Deve possuir suporte a 802.11n de alto rendimento (HT): HT 20/40 
26. Deve possuir suporte a 802.11ac de alta velocidade (VHT): VHT 20/40/80 
27. Deve possuir suporte a agregação de pacotes 802.11n/ac: A-MPDU, A-MSDU 

  

    Gerenciamento 

28. Deve implementar funcionamento de modo auto gerenciado, sem necessidade de 
controladora WLAN para configuração de seus parâmetros de rede wireless, gerenciamento 
das políticas de segurança, QoS e monitoramento de RF. 

29. Deve obedecer à todas as características descritas mesmo neste modo de funcionamento; 
30. No modo de funcionamento auto gerenciado deve disponibilizar na interface gráfica 

informações de usuários conectados, qualidade de sinal e trafego de dados na rede; 
31. O ponto de acesso deve permitir a conversão de modo auto gerenciado para modo 

gerenciado por controlador WLAN através de interface gráfica, em browser padrão (HTTPS), e 
permitir que todos os demais pontos de acesso pertencentes ao mesmo cluster, também 
sejam convertidos automaticamente; 

32. O ponto de acesso deverá suportar conexão direta ou remota com controlador WLAN, 
inclusive via roteamento da camada de rede, baseado no modelo OSI; 

33. Se um controlador WLAN falhar, os Pontos de Acesso relacionados deverão se associar 
automaticamente a um controlador WLAN alternativo, não permitindo que a rede wireless se 
torne inoperante; 

34. Implementar mecanismo de funcionamento para trabalhar com controladores WLAN em 
redundância; 

35. Deve permitir que o ponto de acesso seja atualizado de forma centralizada pela interface 
gráfica; 

36. Permitir o armazenamento de sua configuração em memória não volátil, podendo, numa 
queda e posterior restabelecimento da alimentação, voltar à operação normalmente na 
mesma configuração anterior; 

37. Deve possuir servidor DHCP interno configurável; 
38. Possibilitar backup e restore da configuração através da interface gráfica; 
39. Deve possuir Portal Captivo (Captive Portal) integrado para utilização em rede de visitantes; 
40. Deve possuir mecanismos para proteção contra Pontos de Acesso não autorizados (Rogues); 
41. Possuir capacidade de identificação e listagem dos rádios vizinhos e respectivos SSID/BSSID; 
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42. Implementar associação dinâmica de usuários à VLANs com base nos parâmetros da etapa 
de autenticação; 

43. Deve possuir uma base de usuários interna que diferencie usuários visitantes de 
funcionários, para ser usada em autenticação 802.1x ou portal captivo; 

44. Permitir a autenticação para acesso dos usuários conectados nas redes WLAN (Wireless) 
através: 

a. MAC Address 
b. 802.1x em base Local 
c. Captive Portal 
d. 802.1x em base externa RADIUS 
e. 802.1x em base externa LDAP 

45. Deve permitir a seleção/uso de servidor de autenticação específico com base no SSID; 
46. Implementar o protocolo de enlace CSMA/CA para acesso ao meio de transmissão; 
47. Possuir capacidade de selecionar automaticamente o canal de transmissão; 
48. Permitir o ajuste dinâmico de nível de potência e canal de rádio de modo a otimizar o 

tamanho da célula de RF; 
49. Permitir habilitar e desabilitar a divulgação do SSID; 
50. Implementar diferentes tipos de combinações encriptação/autenticação por SSID; 
51. Implementar padrão WMM da Wi-Fi Alliance para priorização de tráfego, suportando 

aplicações em tempo real, tais como, VoIP, vídeo, dentre outras; 
52. Não deve haver no licenciamento restrições com relação ao número de dispositivos 

conectados por ponto de acesso; 
53. Implementar a pilha de protocolos TCP/IP com suporte a IPV4 e IPV6 (Bridging); 
54. Implementar VLANs conforme padrão IEEE 802.1Q; 
55. Possuir, no mínimo, uma interface IEEE 802.3 10/100/1000BaseT Ethernet, auto- sensing, 

auto MDI/MDX; 
56. Permitir a atualização remota do sistema operacional e arquivos de configuração através da 

controladora WLAN 
57. Implementar cliente DHCP, para configuração automática de rede; 
58. Deve configurar-se automaticamente ao ser conectado na rede; 
59. Possuir LED’s indicativos do estado de operação, da atividade do rádio e da interface 

Ethernet; 
60. Possuir estrutura que permita fixação do equipamento em teto e parede e fornecer 

acessórios para que possa ser feita a fixação; 
61. Deve ser acompanhado de todos os acessórios necessários para operacionalização do 

equipamento, tais como: softwares, cabos de console, cabos de energia elétrica, 
documentação técnica e manuais (podendo ser em CD-ROM) que contenham informações 
suficientes para possibilitar a instalação, configuração e operacionalização do equipamento; 

62. Permitir o bloqueio da configuração do Ponto de Acesso via rede wireless; 
63. Implementar varredura de RF nas bandas 802.11a, 802.11b, 802.11g, 802.11n, para 

identificação de Pontos de Acesso intrusos não autorizados (rogues) e interferências no canal 
habilitado ao ponto de acesso e nos demais canais configurados na rede WLAN, sem impacto 
no seu desempenho; 

64. Implementar IEEE 802.1x, com pelo menos os seguintes métodos EAP: 

a. EAP-FAST 
b. EAP-TLS 
c. PEAP-GTC 
d. PEAP-MSCHAPv2 
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65. Permitir a integração com RADIUS Server com suporte aos métodos EAP citados; 
66. A comunicação entre todos os pontos de acesso sem fio e a controladora deverá ser 

criptografada; 
67. Suportar a autenticação com geração dinâmica de chaves criptográficas por sessão e por 

usuário; 
68. Implementar WPA com algoritmo de criptografia TKIP e MIC; 
69. Implementar WPA2 com algoritmo de criptografia AES, 128/256 bits, IEEE 802.11i; 
70. Deve possuir modo dedicado de funcionamento de análise de espectro das faixas de 

frequência de 2.4 e 5 GHz identificando fontes de interferência nessas faixas; 
71. Deve possibilitar analise de espectro nos canais em que estiver provendo acesso, sem 

desconectar os usuários; 
72. Deve disponibilizar informações gráficas de análise de espectro em conjunto com o 

controlador WLAN; 
73. O equipamento deverá possuir registro na ANATEL e deverá ser apresentado na entrega do 

equipamento; 
74. Deverá prover priorização de trafego de vídeo e voz através de parâmetros de QoS (Quality 

os Service) com possibilidade de aplicar por SSID e dispositivo; 
75. Possibilitar roaming na rede wireless; 
76. Suportar a criação de uma rede de convidados autocontida com isolamento de tráfego entre 

clientes e serviços locais; 
77. Possuir recursos de seleção automática de canal de transmissão procurando por canais onde 

haja menor interferência, tendo por objetivo melhorar a performance da rede wireless; 
78. Permitir a operação em estrutura Mesh viabilizando a comunicação direta entre diferentes 

Pontos de Acesso sem Fio onde não seja possível estender a rede cabeada; 
79. Operando em estrutura Mesh, a comunicação entre os dispositivos estrutura deverão operar 

na frequência de 5Ghz. 
80. Possuir mecanismo para a restauração das configurações originais de fábrica fisicamente no 

equipamento (reset); 
81. Suportar operação em humidade de 5% a 95% sem condensação; 
82. Suportar operação em temperatura de até 40°C (quarenta graus centígrados); 
83. Possuir um MTBF (Mean Time Between Failure - Período Médio entre Falhas) de, no mínimo, 

250.000 horas. 

  

Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 
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4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos equipamentos, 
indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 27 – PONTO DE ACESSO INTERNO TIPO 02 

Características gerais 

1. Equipamento de Ponto de Acesso para rede local sem fio, configurável via software, com 
funcionamento simultâneo nos padrões IEEE 802.11a/n/ac, 5GHz, e IEEE 802.11b/g/n, 
2.4GHz; 

2. Todos os Pontos de acesso sem fio deverão ser novos e sem nenhum histórico de utilização; 
3. Os pontos de acesso deverão possuir certificado emitido pelo “WIFI Alliance” comprovando 

no mínimo os seguintes padrões, protocolos e funcionalidades: 

a. IEEE 802.11a; 
b. IEEE 802.11b; 
c. IEEE 802.11g; 
d. IEEE 802.11n; 
e. IEEE 802.11d; 
f. IEEE 802.11ac; 
g. WPA® Enterprise/Personal; 
h. WPA2® Enterprise/Personal; 
i. EAP-TLS; 
j. EAP-TTLS/MSCHAPv2; 
k. PEAPv0/EAP-MSCHAPv2; 
l. PEAPv1/EAP-GTC; 
m. EAP-SIM; 
n. EAP-FAST; 
o. WMM® e WMM® Power Save; 
p. Beamforming; 
q. Short Guard Interval (SGI); 
r. Packet Aggregation (A-MPDU); 
s. Opportunistic Key Caching (OKC) 

Minuta de edital de pregão (0574599)         SEI 0008478-63.2018.6.02.8000 / pg. 425



 
TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS 

SEÇÃO DE LICITAÇÕES E CONTRATOS 

 

79 
 

 

 

4. Deve operar simultaneamente em 2.4GHz e 5GHz (concurrent dual-band); 

  

Performance 

5. Deve suportar rádio dual, 5 GHz 802.11ac 4x4 MIMO e 2.4 GHz 802.11n 2x2 MIMO; 
6. Deve possuir rádio duplo configurável pelo software, suportando 5 GHz e 2,4 GHz; 
7. Deve possuir quatro spatial stream Single User (SU) MIMO para taxa de dados sem fio de até 

1,733 Mbps, em 5GHz; 
8. Deve possuir três spatial stream Multi User (MU) MIMO para uma taxa de dados sem fio de 

até 1,300 Mbps para dispositivos clientes compatíveis, em 5GHz; 
9. Deve possuir suporte para até 255 dispositivos cliente associados por rádio e até 16 BSSIDs 

por rádio; 
10. Deve suportar no mínimo as bandas de frequência: 

a. 2,400 a 2,4835 GHz 
b. 5.150 a 5.250 GHz 
c. 5.250 a 5.350 GHz 
d. 5,470 a 5,725 GHz 
e. 5,725 a 5,850 GHz 

11. Deve possuir suporte a seleção de frequência dinâmica (DFS) otimizando o uso do espectro 
de RF disponível; 

12. Deve suportar, no mínimo, as seguintes tecnologias de rádio: 

a. 802.11b: espectro espalhável de sequência direta (DSSS); 
b. 802.11a / g / n / ac: multiplexação por divisão de frequência ortogonal (OFDM); 

13. Deve suportar, no mínimo, os seguintes tipos de modulação: 

a. 802.11b: BPSK, QPSK, CCK; 
b. 802.11a / g / n / ac: BPSK, QPSK, 16-QAM, 64-QAM, 256-QAM; 

14. Deve possuir potência de transmissão configurável em incrementos de 0,5 dBm; 
15. Deve respeitar os limites de potência de transmissão máxima (conduzida): 

a. Faixa de 2,4 GHz: +18 dBm por corrente, agregado de +24 dBm (3x3); 
b. Faixa de 5 GHz: +18 dBm por corrente, agregado de +24 dBm (4x4); 

16. Deve suportar Advanced Cellular Coexistence (ACC) minimizando a interferência das redes 
celulares; 

17. Deve suportar Maximum Ratio Combining (MRC) para melhorar o desempenho do receptor; 
18. Deve suportar Cyclic delay/shift diversity (CDD/CSD) para melhorar o desempenho RF de 

downlink; 
19. Deve suportar Short guard interval para canais de 20-MHz, 40-MHz e 80-MHz; 
20. Deve suportar Space-time block coding (STBC) para aumentar o alcance e melhorar a 

recepção; 
21. Deve suportar verificação de paridade de baixa densidade (LDPC) para correção de erros de 

alta eficiência e aumento da taxa de transferência; 
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22. Deve suportar Transmit beam-forming (TxBF); 
23. Deve possuir, no mínimo, as seguintes taxas de dados suportadas (Mbps): 

a. 802.11b: 1, 2, 5.5, 11 
b. 802.11a/g: 6, 9, 12, 18, 24, 36, 48, 54 
c. 802.11n: 6.5 até 450 (MCS0 até MCS23) 
d. 802.11ac: 6.5 até 1,733 (MCS0 até MCS9, NSS = 1 até 4) 

24. Deve possuir suporte a 802.11n de alto rendimento (HT): HT 20/40; 
25. Deve possuir suporte a 802.11ac de alta velocidade (VHT): VHT 20/40/80; 
26. Deve possuir suporte a agregação de pacotes 802.11n/ac: A-MPDU, A-MSDU; 

  

   Gerenciamento 

27. Deve implementar funcionamento de modo auto gerenciado, sem necessidade de 
controladora WLAN para configuração de seus parâmetros de rede wireless, gerenciamento 
das políticas de segurança, QoS e monitoramento de RF. 

28. Deve obedecer a todas as características descritas mesmo neste modo de funcionamento; 
29. No modo de funcionamento autogerenciado deve disponibilizar na interface gráfica 

informações de usuários conectados, qualidade de sinal e trafego de dados na rede; 
30. O ponto de acesso deve permitir a conversão de modo auto gerenciado para modo 

gerenciado por controlador WLAN através de interface gráfica, em browser padrão (HTTPS), e 
permitir que todos os demais pontos de acesso pertencentes ao mesmo cluster, também 
sejam convertidos automaticamente; 

31. O ponto de acesso deverá suportar conexão direta ou remota com controlador WLAN, 
inclusive via roteamento da camada de rede, baseado no modelo OSI; 

32. Se um controlador WLAN falhar, os Pontos de Acesso relacionados deverão se associar 
automaticamente a um controlador WLAN alternativo, não permitindo que a rede wireless se 
torne inoperante; 

33. Implementar mecanismo de funcionamento para trabalhar com controladores WLAN em 
redundância; 

34. Deve permitir que o ponto de acesso seja atualizado de forma centralizada pela interface 
gráfica; 

35. Permitir o armazenamento de sua configuração em memória não volátil, podendo, numa 
queda e posterior restabelecimento da alimentação, voltar à operação normalmente na 
mesma configuração anterior; 

36. Deve possuir servidor DHCP interno configurável; 
37. Possibilitar backup e restore da configuração através da interface gráfica; 
38. Deve possuir Portal Captivo (Captive Portal) integrado para utilização em rede de visitantes; 
39. Deve possuir mecanismos para proteção contra Pontos de Acesso não autorizados (Rogues); 
40. Possuir capacidade de identificação e listagem dos rádios vizinhos e respectivos SSID/BSSID; 
41. Implementar associação dinâmica de usuários à VLANs com base nos parâmetros da etapa 

de autenticação; 
42. Deve possuir uma base de usuários interna que diferencie usuários visitantes de 

funcionários, para ser usada em autenticação 802.1x ou portal captivo; 
43. Permitir a autenticação para acesso dos usuários conectados nas redes WLAN (Wireless) 

através: 

a. MAC Address 
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b. 802.1x em base Local 
c. Captive Portal 
d. 802.1x em base externa RADIUS 
e. 802.1x em base externa LDAP 

44. Deve permitir a seleção/uso de servidor de autenticação específico com base no SSID; 
45. Implementar o protocolo de enlace CSMA/CA para acesso ao meio de transmissão; 
46. Possuir capacidade de selecionar automaticamente o canal de transmissão; 
47. Permitir o ajuste dinâmico de nível de potência e canal de rádio de modo a otimizar o 

tamanho da célula de RF; 
48. Permitir habilitar e desabilitar a divulgação do SSID; 
49. Implementar diferentes tipos de combinações encriptação/autenticação por SSID; 
50. Implementar padrão WMM da Wi-Fi Alliance para priorização de tráfego, suportando 

aplicações em tempo real, tais como, VoIP, vídeo, dentre outras; 
51. Não deve haver no licenciamento restrições com relação ao número de dispositivos 

conectados por ponto de acesso; 
52. Implementar a pilha de protocolos TCP/IP com suporte a IPV4 e IPV6 (Bridging); 
53. Implementar VLANs conforme padrão IEEE 802.1Q; 
54. Possuir, no mínimo, uma interface IEEE 802.3 10/100/1000BaseT Ethernet, auto- sensing, 

auto MDI/MDX; 
55. Permitir a atualização remota do sistema operacional e arquivos de configuração através da 

controladora WLAN 
56. Implementar cliente DHCP, para configuração automática de rede; 
57. Deve configurar-se automaticamente ao ser conectado na rede; 
58. Possuir LED’s indicativos do estado de operação, da atividade do rádio e da interface 

Ethernet; 
59. Possuir estrutura que permita fixação do equipamento em teto e parede e fornecer 

acessórios para que possa ser feita a fixação; 
60. Deve ser acompanhado de todos os acessórios necessários para operacionalização do 

equipamento, tais como: softwares, cabos de console, cabos de energia elétrica, 
documentação técnica e manuais (podendo ser em CD-ROM) que contenham informações 
suficientes para possibilitar a instalação, configuração e operacionalização do equipamento; 

61. Permitir o bloqueio da configuração do Ponto de Acesso via rede wireless; 
62. Implementar varredura de RF nas bandas 802.11a, 802.11b, 802.11g, 802.11n, para 

identificação de Pontos de Acesso intrusos não autorizados (rogues) e interferências no canal 
habilitado ao ponto de acesso e nos demais canais configurados na rede WLAN, sem impacto 
no seu desempenho; 

63. Implementar IEEE 802.1x, com pelo menos os seguintes métodos EAP: 

a. EAP- MD5 
b. EAP-FAST 
c. EAP-TLS 
d. PEAP-GTC 
e. PEAP-MSCHAPv2 

64. Permitir a integração com RADIUS Server com suporte aos métodos EAP citados; 
65. A comunicação entre todos os pontos de acesso sem fio e a controladora deverá ser 

criptografada; 
66. Suportar a autenticação com geração dinâmica de chaves criptográficas por sessão e por 

usuário; 
67. Implementar WPA com algoritmo de criptografia TKIP e MIC; 
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68. Implementar WPA2 com algoritmo de criptografia AES, 128/256 bits, IEEE 802.11i; 
69. Deve possuir modo dedicado de funcionamento de análise de espectro das faixas de 

frequência de 2.4 e 5 GHz identificando fontes de interferência nessas faixas; 
70. Deve possibilitar analise de espectro nos canais em que estiver provendo acesso, sem 

desconectar os usuários; 
71. Deve disponibilizar informações gráficas de análise de espectro em conjunto com o 

controlador WLAN; 
72. O equipamento deverá possuir registro na ANATEL e deverá ser apresentado na entrega do 

equipamento; 
73. Deverá prover priorização de trafego de vídeo e voz através de parâmetros de QoS (Quality 

os Service) com possibilidade de aplicar por SSID e dispositivo; 
74. Possibilitar roaming na rede wireless; 
75. Suportar a criação de uma rede de convidados autocontida com isolamento de tráfego entre 

clientes e serviços locais; 
76. Possuir recursos de seleção automática de canal de transmissão procurando por canais onde 

haja menor interferência, tendo por objetivo melhorar a performance da rede wireless; 
77. Permitir a operação em estrutura Mesh viabilizando a comunicação direta entre diferentes 

Pontos de Acesso sem Fio onde não seja possível estender a rede cabeada; 
78. Operando em estrutura Mesh, a comunicação entre os dispositivos estrutura deverão operar 

na frequência de 5Ghz. 
79. Possuir mecanismo para a restauração das configurações originais de fábrica fisicamente no 

equipamento (reset); 
80. Suportar operação em humidade de 5% a 95% sem condensação; 
81. Suportar operação em temperatura de até 40°C (quarenta graus centígrados); 
82. Possuir um MTBF (Mean Time Between Failure - Período Médio entre Falhas) de, no mínimo, 

250.000 horas. 

  

Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
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não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos equipamentos, 
indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 28 – INJETOR POE PARA PONTOS DE ACESSO TIPO 1 

Características técnicas mínimas 

1. Deve ser do mesmo fabricante dos Pontos de acesso ou homologado e certificado pelo 
mesmo para utilização em seus equipamentos; 

2. Injetor PoE 802.3af 10/100/1000 Ethernet com 15.4W; 

  

Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

3. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 29 – INJETOR POE PARA PONTOS DE ACESSO TIPO 2 

Características técnicas mínimas 

1. Deve ser do mesmo fabricante dos Pontos de acesso ou homologado e certificado pelo 
mesmo para utilização em seus equipamentos; 

2. Injetor PoE+ 802.3at 10/100/1000 Ethernet com 30W; 

  

Garantia e Suporte 
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1. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

3. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 30 – SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE TECNOLOGIA PARA SOLUÇÃO DE 
GERENCIAMENTO 

Características Gerais 

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das 14:00 às 18:00) 
presencialmente no TRE-AL ou remotamente conforme necessidades da CONTRATANTE; 

  

Implantação 

2. Instalação e configuração de 1 (uma) instância do serviço de gerenciamento de rede, 
contemplando: 

a. Configurações básicas para acesso à rede, dimensionamento e configuração de 
armazenamento; 

b. Inclusão de no mínimo 10 (dez) pontos de acesso no monitoramento; 
c. Criação de modelo de configuração (templates) de forma a possibilitar a replicação de 

configuração entre equipamentos. 

  

Transferência De Tecnologia 

3. O treinamento deverá ser no realizado na modalidade workshop com tarefas práticas hands-
on, visando assim a melhor fixação dos temas abordados com foco direto na explicação da 
tecnologia da solução como também nas rotinas de configuração, gerenciamento, 
administração e operação da mesma; 

  

4. O treinamento do MÓDULO DE GERENCIA DE REDE deverá ter duração mínima de 24 (vinte e 
quatro) horas onde será abordado, no mínimo, os seguintes tópicos: 

a. Inserção, modificação e remoção de dispositivos de forma unitária e em lote; 
b. Configuração de VLANs Globais e Locais em switchs gerenciados; 
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c. Configuração de ACLS Globais e Locais em switchs gerenciados; 
d. Backup e restore de configuração de switchs gerenciados; 
e. Monitoramento e alarmes default e customizados; 
f. Customização do Dashboard com alertas, mapas de topologia e monitoramento de 

dispositivos; 

  

ITEM 31- SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE TECNOLOGIA DO MÓDULO DE CONTROLE 
DE ACESSO 

Características Gerais 

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das 14:00 às 18:00) 
presencialmente no TRE-AL ou remotamente conforme necessidades da CONTRATANTE; 

  

Implantação 

2. Instalação e configuração de 1 (uma) instancia do serviço controle de acesso, contemplando: 

a. Configurações básicas para acesso à rede, dimensionamento e configuração de 
armazenamento; 

b. Configuração de autenticação em Active Directory para usuários corporativos; 
c. Configuração de autenticação de visitantes com portal de autosserviço para criação de 

usuários; 
d. Configuração de no mínimo 5 (cinco) dispositivos de rede para autenticação na solução. 

  

Transferência de Tecnologia 

3. O treinamento deverá ser no realizado na modalidade workshop com tarefas práticas hands-
on, visando assim a melhor fixação dos temas abordados com foco direto na explicação da 
tecnologia da solução como também nas rotinas de configuração, gerenciamento, 
administração e operação da mesma devendo ter duração mínima de 24 (vinte e quatro) 
horas onde será abordado no mínimo os seguintes tópicos: 

a. Configuração de Active Directory como base de autenticação; 
b. Configuração de autenticação de usuários corporativos; 
c. Configuração de autenticação de usuários visitantes; 
d. Configuração de portal de autosserviço; 
e. Configuração de autenticação e autorização com protocolo RADIUS. 

ITEM 32– SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE TECNOLOGIA PARA CONTROLADORA 
WLAN E PONTOS DE ACESSO 

  

Características Gerais 
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1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das 14:00 às 18:00) 
presencialmente no TRE-AL ou remotamente conforme necessidades da CONTRATANTE; 

  

Implantação 

2. Instalação e configuração de no mínimo 10 (dez) pontos de acesso, contemplando: 

a. Configuração básica de acesso a gerência via rede; 
b. Configuração de gerência e monitoramento em MÓDULO DE GERENCIA DE REDE; 
c. Configuração da autenticação de usuários em MÓDULO DE CONTROLE DE ACESSO 
d. Configuração de pontos de acesso em controladora WLAN habilitando gerenciamento 

centralizado; 

  

Transferência de Tecnologia 

3. O treinamento deverá ser no realizado na modalidade workshop com tarefas práticas hands-
on, visando assim a melhor fixação dos temas abordados com foco direto na explicação da 
tecnologia dos produtos ofertados como também nas rotinas de configuração, 
gerenciamento, administração e operação dos mesmos devendo ter duração mínima de 16 
(Dezesseis) horas onde será abordado no mínimo os seguintes tópicos: 

a. Configuração inicial e acesso a gerência; 
b. Configuração de Clusters; 
c. Configuração de autenticação de usuários em MÓDULO DE CONTROLE DE ACESSO; 
d. Criação de SSID com autenticação PSK; 
e. Criação de SSID com autenticação enterprise em MÓDULO DE CONTROLE DE ACESSO; 
f. Configuração de pontos de acesso para MÓDULO DE GERENCIA DE REDE; 
g. Configuração pontos de acesso para MÓDULO DE ANÁLISE DE TRÁFEGO; 

  

ITEM 33 – TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE ARQUITETURA WLAN 

  

Características Gerais 

7. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do fabricante no 
Treinamento Básico De Administração De Arquitetura Wlan para 01 (um) profissional da 
contratante; 

8. O voucher deverá ter validade de pelo menos 12 (doze) meses; 
9. O treinamento deverá ser de acordo com o calendário de treinamento do fabricante e 

ministrado em centro oficial de treinamento do mesmo ou remotamente, utilizando 
tecnologia de ensino a distância; 

10. Deverá ser ministrado por profissional devidamente credenciado junto ao fabricante e apto a 
entregar o respectivo; 

11. O treinamento deverá compreender a explicação da tecnologia da solução como também das 
rotinas de configuração, gerenciamento, administração e operação da mesma; 
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12. O treinamento deverá ter carga horária mínima de 20 (vinte) horas, ministrado no período de 
08:00 às 12:00 e das 14:00 às 18:00. 

  

ITEM 34 – TREINAMENTO BÁSICO DA SOLUÇÃO DE GERENCIAMENTO 

  

Características Gerais 

1. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do fabricante no 
Treinamento da Solução de Gerenciamento para 01 (um) profissional da contratante; 

2. O voucher deverá ter validade de pelo menos 12 (doze) meses; 
3. O treinamento deverá ser de acordo com o calendário de treinamento do fabricante e 

ministrado em centro oficial de treinamento do mesmo ou remotamente, utilizando 
tecnologia de ensino a distância; 

4. Deverá ser ministrado por profissional devidamente credenciado junto ao fabricante e apto a 
entregar o respectivo; 

5. O treinamento deverá compreender a explicação da tecnologia da solução como também das 
rotinas de configuração, gerenciamento, administração e operação da mesma; 

6. O treinamento deverá ter carga horária mínima de 40 (Quarenta) horas, ministrado no 
período de 08:00 às 12:00 e das 14:00 às 18:00. 

  

ITEM 35 – TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE ACESSO 

  

Características Gerais 

7. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do fabricante no 
Treinamento da Solução de Controle de Acesso para 01 (um) profissional da contratante; 

8. O voucher deverá ter validade de pelo menos 12 (doze) meses; 
9. O treinamento deverá ser de acordo com o calendário de treinamento do fabricante e 

ministrado em centro oficial de treinamento do mesmo ou remotamente, utilizando 
tecnologia de ensino a distância; 

10. Deverá ser ministrado por profissional devidamente credenciado junto ao fabricante e apto a 
entregar o respectivo; 

11. O treinamento deverá compreender a explicação da tecnologia da solução como também das 
rotinas de configuração, gerenciamento, administração e operação da mesma; 

12. O treinamento deverá ter carga horária mínima de 40 (Quarenta) horas, ministrado no 
período de 08:00 às 12:00 e das 14:00 às 18:00. 

3.2 Forma de Execução e de Gestão do Contrato (Art. 18, § 3º, III, a) 

A execução do objeto pressupõe a existência dos seguintes papéis e 
responsabilidades (Art. 18, § 3º, III, a, 1): 

1. Patrocinador da Contratação: é o titular da área demandante, responsável por representar os 
interesses do órgão no contexto da Contratação, pela aprovação da necessidade e, por fim, 
pela negociação das ações necessárias para que os objetivos sejam alcançados; 
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2. Gestor do Contrato (art. 3º, IV, da Resolução TRE/AL nº 15.787/2017): servidor designado 
para coordenar e comandar o processo da fiscalização da execução contratual. Na forma do 
Art. 17 da mesma Resolução, o gestor do contrato responsabiliza-se pela condução da gestão 
e fiscalização do contrato, nos termos do Art. 67, da Lei nº 8.666/93. 

3. Fiscal do Contrato (art. 3º, VI, da Resolução TRE/AL nº 15.787/2017): servidor designado para 
auxiliar o gestor do contrato quanto à fiscalização do objeto do contrato. Neste sentido, 
indicado pela respectiva autoridade competente para fiscalizar o Contrato quanto aos 
aspectos técnicos da solução. 

Dinâmica da Execução (Art. 18, § 3º, III, a, 2): 

1. Os equipamentos deverão ser entregues no Almoxarifado do TRE/AL, nos quantitativos 
indicados no pedido de fornecimento; 

2. A garantia dos equipamentos deve obedecer o detalhamento técnico feito e terá seu tempo 
contado por cada fornecimento individualmente; 

3. Entende-se como garantia aquela prestada pelo próprio fabricante ou por rede 
credenciada pelo fabricante do(s) referido(s) equipamento(s); 

4. O pagamento será realizado individualmente para cada nota fiscal apresentada, 
após emissão do aceite definitivo pela unidade competente do TRE/AL; 

5. Os equipamentos deverão ser novos, não recondicionados, de primeiro uso e não deverão 
conter marcas, amassados, arranhões ou outros problemas e, ainda, serem entregues em 
pleno estado de funcionamento; 

6. Os equipamentos deverão atender rigorosamente a todas as especificações técnicas contidas 
neste Termo de Referência e em seus Anexos; 

7. Os equipamentos deverão vir acompanhados de todos os acessórios necessários para o seu 
pleno estado de funcionamento, como cabos, drivers, mídias e outros, os quais só serão 
recebidos juntamente com os respectivos equipamentos. Este item se aplica tanto para a 
entrega dos equipamentos quanto para substituições durante o período de garantia; 

8. Ao TRE é reservado o direito de efetuar conexões dos equipamentos a outros, bem como 
adicionar demais acessórios compatíveis tecnicamente, sem que isso constitua motivo para a 
Contratada se desobrigar da garantia, desde que tal fato não implique danos materiais 
ou técnicos aos equipamentos e acessórios, hipótese que deverá ser devidamente 
comprovada; 

9.  Ao TRE/AL é reservado o direito de efetuar diligência, a qualquer tempo, quanto aos 
documentos exigidos neste Termo de Referência e em seus Anexos. 

Recebimento do Objeto: 

1. O Tribunal designará Comissão para realizar o recebimento provisório, que só será emitido se 
os equipamentos estiverem de acordo com as especificações técnicas; 

2. Após a entrega, os equipamentos serão submetidos à avaliação e homologação pelos 
responsáveis técnicos do Tribunal; 

3.  O exame para comprovação das características técnicas consistirá em avaliações e testes 
não-destrutivos, por amostragem realizados em duas etapas: 

a. Primeira: inspeção visual de todos os equipamentos entregues; 
b. Segunda: testes funcionais de configuração e desempenho, em, no mínimo, 10% (dez 

por cento) e não menos do que 01 (um) dos equipamentos recebidos. O Tribunal 
poderá, a seu critério, executar os testes nos demais equipamentos, dentro de 
um critério de razoabilidade, podendo chegar a 100% dos quantitativos, mas dentro 
de um prazo máximo de 30 (trinta) dias corridos e contados de cada lote de 
equipamentos. 
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4. As especificações serão avaliadas também por meio de documentos técnicos que 
acompanham os equipamentos, informações fornecidas pela Contratada e disponível no 
sítio do fabricante. 

5. A comissão do Tribunal deverá, após a comprovação do perfeito funcionamento dos 
equipamentos e adequação às especificações técnicas, emitir e assinar o Termo de 
Recebimento Definitivo. 

Instrumentos Formais de Solicitação do(s) Bens e/ou Serviço(s) (Art. 18, § 3º, III, a, 
3): 

1. A Ordem de Fornecimento será o instrumento formal de solicitação dos bens pertencentes ao 
escopo desta contratação. 

Forma de Pagamento (Art. 18, § 3º, III, a, 7) 

1. O pagamento será efetuado mediante crédito em conta-corrente do Fornecedor, por ordem 
bancária, no prazo disposto nos artigos 5º, § 3º, ou 40, XIV, “a”, da Lei n. 8.666/93, conforme 
o caso, quando mantidas as mesmas condições iniciais de habilitação e cumpridos os 
seguintes  requisitos: 

a. Apresentação de nota fiscal de acordo com a legislação vigente à época da emissão 
(nota fiscaleletrônica, se for o caso), acompanhada da Certidão Negativa de Débito – 
CND, comprovando regularidade com o INSS; do Certificado de Regularidade do FGTS 
– CRF, comprovando regularidade com o FGTS; da Certidão Conjunta Negativa de 
Débitos Relativos a Tributos Federais e à Dívida Ativa da União, expedida pela 
Secretaria da Receita Federal; e da Certidão Negativa de Débitos Trabalhistas – CNDT, 
emitida pela Justiça do Trabalho; e  da prova de regularidade para com as Fazendas 
Estadual e Municipal do domicílio ou sede do Fornecedor; e 

b. Inexistência de fato impeditivo para o qual tenha concorrido o Fornecedor. 
2. Nenhum pagamento será efetuado à Contratada enquanto pendente de liquidação qualquer 

obrigação. Esse fato não será gerador de direito a reajustamento de preços ou a atualização 
monetária. 

Direitos de Propriedade Intelectual (Art. 18, § 3º, III, a, 9): 

1. Esse requisito não se aplica ao contexto desta contratação, uma vez que o objeto se refere 
ao fornecimento de equipamentos, cujos direitos autorais do fabricante são resguardados 
por legislação nacional e internacional. 

Penalidades (Art. 18, § 3º, III, a, 11): 

1. Com fundamento no artigo 7º da Lei nº 10.520/2002 e, subsidiariamente, nos artigos 86 e 87 
da Lei 8.666/1993, a Contratada ficará sujeita, assegurada prévia e ampla defesa, 
às seguintes penalidades: 

a. Advertência: 
i. A Contratada será notificada formalmente em caso de descumprimento de 

obrigação contratual e terá que apresentar as devidas justificativas em um 
prazo de até 5 (cinco) dias úteis após o recebimento da 
notificação; e 

ii. Caso não haja manifestação dentro desse prazo ou se entenda serem 
improcedentes as justificativas apresentadas, a Contratada será advertida; 
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b. Multa de: 

i. 0,5% por dia, sobre o valor constante da Ordem de Fornecimento, no caso de 
atraso injustificado na entrega dos equipamentos, limitada a incidência a 20 
(vinte) dias corridos; 

1. No caso de atraso injustificado na entrega dos equipamentos por prazo s
uperior a 20 (vinte) dias corridos, com 
a aceitação pela Administração, será aplicada a multa de 10% sobre o 
valor da Ordem de Fornecimento; e 

2. No caso de atraso injustificado na entrega dos equipamentos por prazo s
uperior a 20 (vinte) dias corridos, com a 
não aceitação pela Administração, será aplicada a penalidade 20% sobre 
o valor da Ordem de Fornecimento, no caso de inexecução total da 
obrigação, podendo haver, ainda, o cancelamento do registro de preços 
do Fornecedor; 

ii.  0,5% por dia, sobre o valor do equipamento, 
no caso de atraso injustificado na solução do chamado de garantia, limitada a i
ncidência 30 (trinta) dias corridos; 

1. No caso de atraso injustificado na solução do chamado de garantia por p
razo superior a 30 (trinta) dias corridos, aplica-se adicionalmente, 
a multa de 1% sobre o valor da Ordem de Fornecimento; e 

2. A multa por atraso relacionada ao item 
anterior será auferida por Ordem de Fornecimento e aplicada somente u
ma única vez a cada mês, independente da quantidade 
de equipamentos sem solução. 

iii. 10% sobre o valor constante da Ordem de Fornecimento, no caso de 
inexecução parcial da obrigação assumida; 

iv. 20% sobre o valor da Ordem de Fornecimento, no caso de inexecução total da 
obrigação, podendo haver, ainda, o cancelamento do registro de preços do 
Fornecedor; 

v. 10% sobre o valor global estimado da Ata de Ata de Registro de Preços, na 
hipótese de recusa em assinar a Ata ou o instrumento do contrato, ou retirar a 
Ordem de Fornecimento. 

c. Impedimento de licitar e contratar com a União e descredenciamento do SICAF pelo 
prazo de até 5 (cinco) anos, sem prejuízo das demais penalidades legais; e 

d. Declaração de inidoneidade para licitar ou contratar com a Administração Pública. 
2. O cometimento reiterado de atrasos injustificados dos prazos previstos para entrega/solução 

do chamado de garantia dos equipamentos poderá resultar no cancelamento do registro 
de preços com a Contratada. 

3. As sanções previstas nos itens "1.a", “1.c” e “1.d” do item 1 poderão ser aplicadas, 
cumulativamente ou não, à pena de multa. 

4. O valor da multa, aplicada após o regular processo administrativo, será descontado de 
pagamentos eventualmente devidos à contratada ou cobrado judicialmente; 

5. Excepcionalmente, ad cautelam, a Administração poderá efetuar a retenção do valor 
presumido da multa, antes da instauração do regular procedimento administrativo. 
. 
  

4. Requisitos Técnicos (Art. 18, § 3º, IV) 
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Garantia mínima de 36  (trinta e seis) meses. 

Estar comprovadamente ainda em produção. 

Conformidade com o presente Termo de Referência. 

5. Modelos (templates) propostos a serem utilizados na contratação (Art. 18, § 3º, III, V) 

Memorando nº ____ / 20__ - TRE-AL/_______________________ 

Maceió, ___ de ___________ de _____________. 

Para: SGO-COFIN 

Assunto: Autorização de Emissão de Nota de Empenho. 

PA _________________________ 

Adesão à Ata de Registro de Preços ______________ 

Ordem de Fornecimento nº _____/_________. 

 
  

Senhor Chefe 

Encaminhamos estes autos para emissão de Nota de Empenho, em favor da Empresa ________________. CNPJ: 
xx.xxx.xxx/xxxx-xx, conforme tabela abaixo, tudo em conformidade com o disposto na Resolução TRE-AL nº 
12.738/1996 (0216181). 

Certidões: SICAF evennto: ______ / RECEITA ESTADUAL evento: ______ / SIMPLES NACIONAL (se aderente) 
evento: __________ 

Item: 

Descrição: 

Quant. total da 
ATA 

Quant. 
Recebida 

Quant. desta 
Ordem 

Saldo no 
Fornecedor 

Valor 
Unitário 

Valor Total 
(R$) 

            

  

*  Solicitamos utilizar a reserva de crédito do PE XXX/XXXX 

  

  

Gestor da Ata - Portaria TRE/AL nº XX/XXXX 

  

Moodelo a ser adotado em decorrência do comando inserto no Proc SEI nº 0005423-07.2018.6.02.8000, 
evento 0442132: modelo de referência indicado: 0452895. 

Maceió, 15 de maio de 2019. 

 
DANIEL MACÊDO DE CARVALHO SOUTO 

 Coordenador 
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ANEXO I-A 
 

ESPECIFICAÇÕES DOS LOTES, ITENS, QUANTITATIVOS A SEREM 
ADQUIRIDOS E PREÇOS MÁXIMOS ADMITIDOS 

 

Lote 1 Item Qtd Descrição Valor 
Unitário 

Valor Total 

 

01 

1 1 SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 
PARA REDE CABEADA 

R$ 104.180,00 R$ 104.180,00 

2 3 LICENCIAMENTO ADICIONAL PARA SISTEMA DE 
GERENCIAMENTO HPE IMC 

R$ 15.890,00 R$ 47.670,00 

3 2 LICENCIAMENTO ADICIONAL DO MÓDULO DE ANÁLISE DE 
TRAFEGO DO SISTEMA DE GERENCIAMENTO HPE IMC 

R$ 12.745,00 R$ 25.490,00 

4 2 LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE 
PERFIL E CONTROLE DE ACESSO 

R$ 54.160,00 R$ 108.320,00 

5 6 SWITCH DE DISTRIBUIÇÃO COM 16 PORTAS SFP+ E 
SUPORTE A MÓDULOS DE EXPANSÃO 

R$ 49.117,00 R$ 294.702,00 

6 16 MÓDULO COM 4 PORTAS SFP+ PARA SWITCH DE 
DISTRIBUIÇÃO 

R$ 4.742,00 R$ 75.872,00 

7 6 MÓDULO DE STACKING COM 4 PORTAS PARA SWITCH DE 
DISTRIBUIÇÃO 

R$ 4.406,00 R$ 26.436,00 

8 50 SWITCH DE ACESSO L3 COM 48 PORTAS GIGABIT E 4SFP+ R$ 14.382,08 R$ 719.104,00 

9 40 SWITCH DE ACESSO L3 COM 24 PORTAS GIGABIT E 4SFP+ R$ 14.106,00 R$ 564.240,00 

10 50 SWITCH DE ACESSO L2 COM 24 PORTAS GIGABIT E 4SFP R$ 4.515,00 R$ 225.760,00 

11 40 SWITCH DE ACESSO L2 COM 48 PORTAS GIGABIT E 4SFP
    

R$ 8.245,00 R$ 329.800,00 

12 50 GBIC 10GB PARA ATÉ 300M R$ 2.064,87 R$ 103.243,50 

13 30 CABO DAC 10 GBPS DE 1M  R$ 411,00 R$ 12.330,00 

14 30 CABO DAC 10 GBPS DE 3M R$ 584,00 R$ 17.520,00 

15 10 GBIC 1GB PARA ATÉ 500M R$ 740,46 R$ 7.404,60 

16 5 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA SWITCHS DE REDE 

R$ 20.000,00 R$ 100.000,00 

17 1 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO
  

R$ 60.000,00 R$ 60.000,00 

18 4 TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE SWITCHES R$ 28.000,00 R$ 112.000,00 

19 4 TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE 
ACESSO 

R$ 28.000,00 R$ 112.000,00 

02 

20 1 SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 
PARA REDE WIRELESS 

R$ 104.180,00 R$ 104.180,00 

21 1 SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS R$ 570,00 R$ 570,00 

22 200 LICENÇAS ADICIONAIS PARA SOLUÇÃO DE GERENCIAMENTO 
DE REDE WIRELESS 

R$ 497,21 R$ 99.442,00 

23 2 LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE 
PERFIL E CONTROLE DE ACESSO 

R$ 55.000,00 R$ 110.000,00 

24 4 CONTROLADORA WLAN R$ 70.000,00 R$ 280.000,00 

25 200 LICENÇAS ADICIONAIS PARA CONTROLADORA WLAN
    

R$ 900,00 R$ 180.000,00 

26 100 PONTO DE ACESSO INTERNO TIPO 01 R$ 3.076,79 R$ 307.679,00 

27 100 PONTO DE ACESSO INTERNO TIPO 02 R$ 2.300,00 R$ 230.000,00 

28 100 INJETOR POE PARA PONTOS DE ACESSO TIPO 1 R$ 500,00 R$ 50.000,00 

29 100 INJETOR POE PARA PONTOS DE ACESSO TIPO 2 R$ 550,00 R$ 55.000,00 

30 1 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA SOLUÇÃO DE GERENCIAMENTO 

R$ 24.000,00 R$ 24.000,00 

31 1 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO 

R$ 24.000,00 R$ 24.000,00 
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32 5 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA PONTOS DE ACESSO 

R$ 20.000,00 R$ 100.000,00 

33 4 TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE 
ARQUITETURA WLAN 

R$ 20.000,00 R$ 80.000,00 

34 4 TREINAMENTO BÁSICO DA SOLUÇÃO DE GERENCIAMENTO R$ 20.000,00 R$ 80.000,00 

35 4 TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE 
ACESSO    

R$ 20.000,00 R$ 80.000,00 
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        ANEXO I-B 
 

       PLANILHA DE COMPOSIÇÃO DE CUSTOS POR ITEM 

 

Lote 1 Item Qtd Descrição Valor 
Unitário 

Valor 
Total 

 

01 

1 1 SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 
PARA REDE CABEADA 

  

2 3 LICENCIAMENTO ADICIONAL PARA SISTEMA DE 
GERENCIAMENTO HPE IMC 

  

3 2 LICENCIAMENTO ADICIONAL DO MÓDULO DE ANÁLISE DE 
TRAFEGO DO SISTEMA DE GERENCIAMENTO HPE IMC 

  

4 2 LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE 
PERFIL E CONTROLE DE ACESSO 

  

5 6 SWITCH DE DISTRIBUIÇÃO COM 16 PORTAS SFP+ E SUPORTE A 
MÓDULOS DE EXPANSÃO 

  

6 16 MÓDULO COM 4 PORTAS SFP+ PARA SWITCH DE 
DISTRIBUIÇÃO 

  

7 6 MÓDULO DE STACKING COM 4 PORTAS PARA SWITCH DE 
DISTRIBUIÇÃO 

  

8 50 SWITCH DE ACESSO L3 COM 48 PORTAS GIGABIT E 4SFP+   

9 40 SWITCH DE ACESSO L3 COM 24 PORTAS GIGABIT E 4SFP+   

10 50 SWITCH DE ACESSO L2 COM 24 PORTAS GIGABIT E 4SFP   

11 40 SWITCH DE ACESSO L2 COM 48 PORTAS GIGABIT E 4SFP 
   

  

12 50 GBIC 10GB PARA ATÉ 300M   

13 30 CABO DAC 10 GBPS DE 1M    

14 30 CABO DAC 10 GBPS DE 3M   

15 10 GBIC 1GB PARA ATÉ 500M   

16 5 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA SWITCHS DE REDE 

  

17 1 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO  

  

18 4 TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE SWITCHES   

19 4 TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE ACESSO   

02 

20 1 SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 
PARA REDE WIRELESS 

  

21 1 SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS   

22 200 LICENÇAS ADICIONAIS PARA SOLUÇÃO DE GERENCIAMENTO DE 
REDE WIRELESS 

  

23 2 LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE 
PERFIL E CONTROLE DE ACESSO 

  

24 4 CONTROLADORA WLAN   

25 200  LICENÇAS ADICIONAIS PARA 
CONTROLADORA WLAN    

  

26 100 PONTO DE ACESSO INTERNO TIPO 01   

27 100 PONTO DE ACESSO INTERNO TIPO 02   

28 100 INJETOR POE PARA PONTOS DE ACESSO TIPO 1   

29 100 INJETOR POE PARA PONTOS DE ACESSO TIPO 2   

30 1 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA SOLUÇÃO DE GERENCIAMENTO 

  

31 1 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO 

  

32 5 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA PONTOS DE ACESSO 

  

33 4 TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE ARQUITETURA 
WLAN 

  

34 4 TREINAMENTO BÁSICO DA SOLUÇÃO DE GERENCIAMENTO   

35 4 TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE ACESSO
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                                                 ANEXO II 
 

PREGÃO ELETRÔNICO Nº XX/2019 
  

PPLLAANNIILLHHAA  DDEE  DDAADDOOSS  PPAARRAA  CCOONNTTRRAATTAAÇÇÃÃOO 
 
Dados da Empresa: 
Razão Social  
CNPJ  
Endereço  
CEP  
Fones:  
Fax  
E-mail  
Site internet  

 
Dados do Representante da Empresa: 
Nome  
Cargo  
Nacionalidade  
Estado civil  
Profissão  
Endereço  
CEP  
Fone  
Fax  
E-mail  
Cart. Identidade  
Orgão Expedidor  
CPF  
 
Dados Bancários da Empresa 
Banco  
Agência  

Conta  
 
Dados do Contato com a Empresa: 
Nome  
Cargo  
Endereço  
CEP  
Fone  
Fax  
E-mail  
 
Empresa optante pelo SIMPLES?  (   ) Sim  (   ) Não 
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ANEXO III 
ATA DE REGISTRO DE PREÇOS n.º XX/2019  

 

Processo nº 0008478-63.2018.6.02.8000 
Pregão Eletrônico para Registro de Preços nº XX/2019 

 
MINUTA  

 
Aos ---- dias do mês ----------- de 2019, O TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS, 
Órgão do Poder Judiciário, em nome da União – Pessoa Jurídica de Direito Público Interno, 
inscrito no CNPJ nº 06.015.041/0001-38, sediado na Avenida Aristeu de Andrade, nº 377 – 
Farol, CEP: 57051-090, nesta, neste ato representado por seu Vice-Presidente no exercício 
da Presidência, Desembargador Otávio Leão Praxedes, brasileiro, casado, Magistrado, 
portador da Carteira de Identidade nº 215.430 SSP/AL, inscrito no CPF sob o nº 
087.912.284-68, residente e domiciliado nesta Cidade, resolve registrar os preços ofertados 
pela empresa ................................., (INFORMAR SE É MICROEMPRESA OU EMPRESA DE 
PEQUENO PORTE) CNPJ …....................., sediada em …..................., representada 
por..........................................., para eventual fornecimento dos materiais abaixo 
relacionados, conforme condições descritas nos  Anexos I e I-A do Pregão Eletrônico nº 
XX/2019, nos termos da Lei nº 8.666, de 21 de junho de 1993, da Lei nº 10.520, de 17 de 
julho de 2002, do Decreto nº 5.450, de 31 de maio de 2005, do Decreto nº 7.892, de 23 de 
janeiro de 2013, e demais normas legais aplicáveis. 

 
1 – DO OBJETO. 
 
1.1. A presente ata tem por objeto o registro de preços do(s) item(ns) abaixo, 
na forma do Edital de Pregão Eletrônico nº XX/2019: 

 

LOTE ITEM DESCRIÇÃO MARCA UNID. 
QUANT. 
TOTAL 

REGISTRADA 

VALOR 
UNITÁRIO 

(R$) 

VALOR 
TOTAL 
(R$) 

 

       

 
1.2. Relação dos licitantes que aceitaram cotar seus bens em valor igual ao do vencedor 
do certame para formação de cadastro de reserva, caso haja cancelamento do registro do 
fornecedor, conforme previsto no subitem 18.3 do edital do PE nº XX/2019: 
 

Nome da empresa CNPJ Preços Quantitativos 
    
    

 
2 – DO PRAZO DE VIGÊNCIA. 
 
2.1. O prazo de vigência do presente Registro de Preços é de 12 (doze) 
meses, contado da publicação do extrato desta ata. 
 
3 – DOS PRAZOS DE ENTREGA E DA GARANTIA.  

 

3.1. O prazo máximo para a entrega dos equipamentos é de 60 (sessenta) 
dias contados a partir do recebimento da Ordem de Fornecimento ou documento 
equivalente. 
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3.2. O prazo máximo para a entrega dos softwares é 30 (trinta) dias contados 
a partir do recebimento da Ordem de Fornecimento ou documento equivalente. 

 

3.3. Os serviços de instalação, integração, garantia e suporte dos 
equipamentos e softwares, deverão ser realizados diretamente pelo fabricante de acordo 
com as exigências contidas no descritivo dos mesmos, estando essas aderentes aos 
respectivos níveis de serviço necessários a cada um deles. 

 
3.4. Quanto aos itens 1, 2, 3, 4, 20, 22, 23 e 25,   a garantia e o suporte do 
fabricante para a solução de software deverá ser ofertado pelo período mínimo de 36 (trinta 
e seis) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 

 
3.4.1. Caso a garantia padrão do fabricante seja menor que a exigida, a 
proponente deverá informar em sua proposta o código de serviço de garantia do 
fabricante (“part number”), incorporada à solução. 

3.4.2.  O fabricante deve possuir canais de comunicação e ferramentas adicionais 
para suporte técnico online como “chat” e “e-mail” em seu site da internet com 
disponibilidade ainda de área para cadastro da solução de software ofertada, 
possibilitando assim que a CONTRATANTE possa receber de forma proativa, durante 
todo período da garantia as notificações de atualizações e correções (“hotfix”) da 
solução. 

3.4.3.  A empresa fabricante da solução de software deverá dispor de um número 
telefônico tipo 0800 para suporte técnico e abertura de chamados técnicos. 

3.4.4. A comprovação da modalidade da garantia deverá ocorrer através de 
documentação do fabricante de domínio público, não sendo aceita documentação 
emitida pelo fornecedor ou centro de distribuição para fins de comprovação que por 
ventura conflitem com catálogos, manuais, folders oficiais impressos ou da internet 
(devendo constar o endereço URL para folders da web). Caso não seja comprovada por 
um dos meios citados anteriormente, será possível a comprovação através da 
apresentação de documentação expressa do fabricante dos softwares, indicando o 
período de garantia dos produtos ofertados. Em caso de documentação expressa do 
fabricante deverá ser anexada a mesma a procuração que comprove que a fabricante 
outorga ao procurador os poderes para firmar e declarar as exigências solicitadas. 

3.5. Quanto aos itens 5, 8, 9, 10, 11, 24, 26 e 27, o equipamento ofertado 
deverá possuir garantia do fabricante na modalidade on-site pelo período mínimo de 60 
(sessenta) meses para reposição de peças, mão de obra e atendimento. O prazo máximo 
para atendimento do chamado deve ser de até o próximo dia útil após a sua abertura. 
Durante o período da garantia o prazo máximo para o reparo de equipamentos defeituosos 
a condição normal de funcionamento deverá ser de até 07 (sete) dias úteis. 

3.5.1. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente 
deverá informar em sua proposta o código de serviço de garantia do fabricante (“part 
number”), incorporada à solução. 

3.5.2. O fabricante deve possuir canais de comunicação e ferramentas adicionais para 
suporte técnico online como “chat” e “e-mail” em seu site da internet com 

Minuta de edital de pregão (0574599)         SEI 0008478-63.2018.6.02.8000 / pg. 444



 
TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS 

SEÇÃO DE LICITAÇÕES E CONTRATOS 

 

98 
 

 

 

disponibilidade ainda de área para cadastro da solução de hardware ofertada, 
possibilitando assim que a CONTRATANTE possa receber de forma proativa, durante 
todo período da garantia as notificações de atualizações e correções (“hotfix”) da 
solução; 

3.5.3. A empresa fabricante do equipamento deverá dispor de um número telefônico 
tipo 0800 para suporte técnico e abertura de chamados técnicos. 

3.5.4. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e 
solução exigidos para os equipamentos, deverá ser comprovada a existência da 
assistência técnica local no domicílio da contratante e na modalidade on-site, devendo 
essa ser realizada por meio de documentação oficial do fabricante dos produtos e de 
domínio público, através de catálogos, folder impressos ou da internet, devendo 
constar o endereço URL na mesma. Caso não seja comprovada por um dos meios 
citados anteriormente, será possível a comprovação através da apresentação de 
documentação expressa do fabricante dos equipamentos, indicando a referida 
assistência técnica que será responsável pelo atendimento e manutenção durante o 
período de garantia dos produtos ofertados. Em caso de documentação expressa do 
fabricante a esta deverá ser anexada uma procuração que comprove que a fabricante 
outorga ao procurador os poderes para firmar e declarar as exigências solicitadas. 

3.5.5. Todos os componentes instalados ou integrados dos equipamentos devem ser 
do próprio fabricante ou estar em conformidade com a política de garantia do mesmo, 
não sendo permitida a integração de itens de terceiros que possam acarretar em 
perda parcial da garantia ou não realização da manutenção técnica pelo próprio 
fabricante quando solicitada. 

3.6.   Quanto aos itens 6, 7, 12, 13, 14, 15, 28 e  29, O equipamento ofertado 
deverá possuir garantia do fabricante do equipamento na modalidade on-site pelo período 
mínimo de 12 (doze) meses para reposição de peças, mão de obra e atendimento no local. 
O período da garantia o prazo máximo para o reparo de equipamentos defeituosos a 
condição normal de funcionamento deverá ser de até 07 (sete) dias úteis. 

3.6.1. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente 
deverá informar em sua proposta o código de serviço de garantia do fabricante (part 
number), incorporado ao equipamento. 

3.6.2. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do 
próprio fabricante ou estar em conformidade com a política de garantia do mesmo, 
não sendo permitida a integração de itens de terceiros que possam acarretar em 
perda parcial da garantia ou não realização da manutenção técnica pelo próprio 
fabricante quando solicitada. 

 
4. DAS OBRIGAÇÕES DO ÓRGÃO GERENCIADOR. 
 
4.1. São obrigações do Órgão Gerenciador: 
 

a) Gerenciar a presente Ata, indicando, sempre que solicitado, o nome do 
detentor da ata, o preço, e as especificações dos materiais registrados, 
observada a ordem de classificação indicada na licitação; 
b) Observar para que, durante a vigência da presente ata, sejam mantidas 
todas as condições de habilitação e qualificação exigidas na licitação, bem 
assim, a compatibilidade com as obrigações assumidas; 
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c) Conduzir eventuais renegociações dos preços registrados, para fins de 
adequação às novas condições de mercado; 
d) Realizar, periodicamente, pesquisa de mercado para comprovação da 
vantajosidade dos preços registrados na Ata; 
e) Acompanhar e fiscalizar o cumprimento das condições ajustadas na 
presente Ata; 
f) Aplicar, garantida a ampla defesa e o contraditório, as penalidades 
decorrentes do descumprimento do pactuado na ata de registro de preços ou 
do descumprimento das obrigações contratuais, em relação às suas próprias 
contratações; 
g) Consultar o detentor da ata registrada (observada a ordem de classificação) 
quanto ao interesse em fornecer o material a outro(s) órgão(s) da 
Administração Pública que externe(m) a intenção de utilizar a presente Ata. 

 
4.2. São ainda obrigações do órgão gerenciador da ata, na condição de 
contratante: 

a) Efetuar o pagamento à Contratada, após o recebimento definitivo; 
b) Acompanhar e fiscalizar a execução do objeto da Ata 
de Registro de Preços e do(s) contrato(s) dela decorrentes, 
por meio de servidor(es) designado(s), 
de modo a garantir o fiel cumprimento do mesmo e da proposta; 
c) Manter arquivo, junto ao processo administrativo ao qual está vinculado 
o presente termo,  toda a documentação referente ao mesmo; 
d) Proporcionar todas as facilidades indispensáveis à 
boa execução das obrigações contratuais; e 
e) Aplicar as sanções conforme previsto no contrato, assegurando à Contrata
da o contraditório e ampla defesa. 

5. DAS OBRIGAÇÕES DO DETENTOR DA ATA 
 
5.1. São obrigações do detentor da Ata: 
 

a) Providenciar a imediata correção de deficiências, falhas ou irregularidades 
constatadas pelo ÓRGÃO GERENCIADOR referentes às condições firmadas na 
presente Ata; 
b) Viabilizar o atendimento das condições firmadas a partir da data da 
publicação da presente Ata; 
c) Manter, durante o prazo de vigência da presente Ata, todas as condições de 
idoneidade exigidas na licitação, além de sujeitar-se às demais disposições do 
Código de Proteção e Defesa do Consumidor (Lei n° 8.078/90) que sejam 
compatíveis com o regime de direito público; 
d) Informar, no prazo máximo de 05 (cinco) dias úteis, contados do 
recebimento da notificação, quanto à aceitação ou não do fornecimento de 
material a outro órgão da Administração Pública (não participante) que venha 
a manifestar o interesse de utilizar a presente Ata. 
 

5.2. São, ainda, obrigações do detentor da Ata, na condição de contratado: 
 

a) Executar o contrato em estrita conformidade com as disposições e 
especificações do Edital e com os termos da proposta de preços; 

b) Fornecer os equipamentos conforme especificações, quantidades, 
prazos e demais condições estabelecidas no Edital, na Ata de Registro de 
Preços, na Ordem de Fornecimento e na Proposta de preços; 
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c) Fornecer a documentação necessária à instalação e à operação dos 
produtos (manuais, termos de garantia, etc.), completa, atualizada e em 
português do Brasil, caso exista, ou em inglês; 

d) Disponibilizar Central de Atendimento para a abertura e fechamento 
de chamados técnicos, conforme períodos, horários e condições 
estabelecidas no Edital e em seus Anexos; 

e) Comunicar formal e imediatamente ao Gestor ou Responsável Técnico 
da Administração sobre mudanças nos dados para contato com a Central 
de Atendimento; 

f) Prestar as informações e os esclarecimentos que venham a ser 
solicitados pelo representante da Administração, referentes a qualquer 
problema detectado ou ao andamento de atividades da garantia; 

g)  Responder por quaisquer prejuízos que seus profissionais causarem 
ao patrimônio da Administração ou a terceiros, por ocasião da execução 
do objeto, procedendo imediatamente aos reparos ou às indenizações 
cabíveis e assumindo o ônus decorrente; 

h) Responsabilizar-se integralmente pelo fornecimento dos equipamentos 
e pela execução dos serviços de garantia técnica, primando pela 
qualidade, desempenho, eficiência e produtividade na execução dos 
trabalhos, dentro dos prazos estipulados e cujo descumprimento será 
considerado infração passível de aplicação das penalidades previstas no 
Termo de Referência (Anexo I); 

i) Comunicar ao Gestor ou Responsável Técnico, formal e 
imediatamente, todas as ocorrências anormais e/ou que possam 
comprometer a execução do objeto; 
 
j) Manter sigilo sobre todo e qualquer assunto de interesse da 
Administração ou de terceiros de que tomar conhecimento em razão da 
execução do objeto, respeitando todos os critérios estabelecidos, 
aplicáveis aos dados, informações, regras de negócios, documentos, 
entre outros pertinentes, sob pena de responsabilidade civil, penal e 
administrativa; 

 
k) Cumprir e garantir que seus profissionais estejam cientes, aderentes e 
obedeçam rigorosamente às normas e aos procedimentos estabelecidos 
na Política de Segurança da Informação do TRE/AL; 

 
l) Responsabilizar-se pela conservação dos ambientes onde desempenhe 
as atividades necessárias para prestar a garantia on-site; 

 
m) Prestar as informações e os esclarecimentos que venham a ser 
solicitados pela Administração, referentes a qualquer problema 
detectado ou ao andamento de atividades da garantia técnica. 
 
n) Indicar endereço eletrônico (e-mail) para o recebimento de 
expedientes/notificações enviadas pelo TRE/AL, sendo considerados 
válidos todos os expedientes/notificações enviadas ao endereço 
eletrônico indicado; 
 
o) Manter durante a execução do contrato todas as condições que 
culminaram em sua habilitação, principalmente a regularidade fiscal e 
previdenciária, condições de idoneidade exigidas na licitação e outras 
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previstas na legislação vigente e na aplicável à natureza dos serviços 
objeto da contratação; 
 
p) Aceitar o cancelamento da ordem de fornecimento por parte da 
Administração, no caso de fornecimento/entrega, em final de exercício 
e posterior ao dia 15 de dezembro ou dia útil imediatamente 
subsequente, em decorrência dos efeitos da Emenda Constitucional nº 
95/2016, sem a reversão de qualquer ônus à Administração. 
 
q) Apresentar certidões de quitação junto à Receita Federal, Dívida Ativa 
da União, INSS, FGTS e Fazenda Municipal ou estar registrada junto ao 
SICAF em condição regular; 
 
r) Acatar outras determinações previstas na legislação aplicável à 
natureza do objeto deste contrato; 
 
s) Cumprir com outras obrigações decorrentes da aplicação do Código 
de Proteção e Defesa do Consumidor (Lei nº 8.078/1990) que sejam 
compatíveis com o regime de Direito Público. 

 
6 - DO PAGAMENTO. 
 
6.1. O pagamento será efetuado mediante ordem bancária de crédito em 
conta corrente, em até 10 (dez) dias, após o recebimento da Nota Fiscal respectiva, a qual 
deverá ser entregue somente após a prestação dos serviços, devendo a contratada atender 
os seguintes requisitos: 

a) Apresentação de nota fiscal de acordo com a legislação vigente à época da 
emissão (nota fiscaleletrônica, se for o caso), acompanhada do Certificado 
de Regularidade do FGTS – CRF, comprovando regularidade com o FGTS; da 
Certidão Conjunta Negativa de Débitos Relativos a Tributos Federais e à Dívida 
Ativa da União, que incluindo as referentes a contribuições previdenciárias, 
expedida pela Secretaria da Receita Federal; e da Certidão Negativa de 
Débitos Trabalhistas – CNDT, emitida pela Justiça do Trabalho; e da prova de 
regularidade para com as Fazendas Estadual do domicílio ou sede do 
Fornecedor; e 

b) Inexistência de fato impeditivo para o qual tenha concorrido o Fornecedor. 

6.2.  Eventuais penalidades poderão ser descontadas do pagamento. 
 
6.3.  Em nenhuma hipótese haverá antecipação de pagamento. 
 
6.4.  O TRE/AL, por ocasião de cada pagamento, fará as retenções e 
recolhimentos fiscais determinados pela legislação tributária. 
 
6.5.  Se a empresa for optante pelo SIMPLES, deverá anexar à nota fiscal 
documento que comprove tal opção, para que sobre o valor do pagamento não incidam as 
retenções de que trata o item anterior. 
 
6.6.  Havendo atraso no pagamento, o valor devido deverá ser acrescido de 
encargos moratórios, apurados desde a data do primeiro dia útil do atraso, até a data do 
efetivo pagamento, desde que o contratado não tenha concorrido para tanto, mediante a 
aplicação da seguinte fórmula: 
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EM = I x N x VP, 
 
Onde: 
EM= Encargos Moratórios 
N= Número de dias entre a data prevista para o pagamento e a do efetivo pagamento; 
VP = Valor da parcela a ser paga; 
I= Índice de atualização financeira= 0,0001644, assim apurado: 
 
I = (TX/100)                  I= (6/100)           I = 0,0001644 
         365                             365 
TX= Percentual de Taxa Anual= 6% 

6.7.  Nenhum pagamento será efetuado à Contratada enquanto pendente de 
liquidação qualquer obrigação. Esse fato não será gerador de direito a reajustamento de 
preços ou a atualização monetária. 

7 – DO RECEBIMENTO DO OBJETO. 
 
7.1. O objeto deverá ser entregue, no prazo máximo de 90 (noventa) dias corridos, 
contados do recebimento da Nota de Empenho ou Ordem de Fornecimento, por e-mail ou 
ofício, o que ocorrer primeiro, no horário de expediente normal, de segunda a sexta-feira, 
na Seção de Almoxarifado do Tribunal Regional Eleitoral de Alagoas, localizada na Avenida 
Menino Marcelo (antiga via expressa), nº 7.200 D – Serraria, Maceió/AL, CEP: 57046-005, 
sob agendamento através do telefone (82) 3328-1947. 
 
7.2. O objeto será recebido: 
 

a) provisoriamente, para que seja feita a verificação da conformidade dos mesmos 
com as especificações. 

 
b) definitivamente, após avaliação e homologação pelos responsáveis técnicos 
do Tribunal, da seguinte forma: 

b.1) O exame para comprovação das características técnicas consistirá em 
avaliações e testes não-destrutivos, por amostragem realizados em duas 
etapas: 

a. Primeira: inspeção visual de todos os equipamentos entregues; 
b. Segunda: testes funcionais de configuração e desempenho, em, no 

mínimo, 10% (dez por cento) e não menos do que 01 (um) dos 
equipamentos recebidos. O Tribunal poderá, a seu critério, executar 
os testes nos demais equipamentos, dentro de um critério de 
razoabilidade, podendo chegar a 100% dos quantitativos, mas dentro 
de um prazo máximo de 30 (trinta) dias corridos e contados de cada 
lote de equipamentos. 

b.2) As especificações serão avaliadas também por meio de documentos 
técnicos que acompanham os equipamentos, informações fornecidas pela 
Contratada e disponível no sítio do fabricante; 

b.3) A comissão do Tribunal deverá, após a comprovação do perfeito 
funcionamento dos equipamentos e adequação às especificações técnicas, 
emitir e assinar o Termo de Recebimento Definitivo. 
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7.3. O produto será rejeitado no caso de incompatibilidade com as 
especificações previstas na proposta ou quando inadequado à sua utilização. 
 
7.4. O prazo para a Secretaria competente proceder às verificações, após o 
recebimento provisório, será de 05 (cinco) dias úteis, quando deverá se manifestar, 
aceitando ou recusando o item objeto do fornecimento. 
 
7.5. Os recebimentos provisório e definitivo se darão mediante formulário 
próprio. 
 
7.6. O recebimento definitivo não exime o fornecedor de responder pelos 
vícios aparentes e ocultos segundo as disposições deste termo e as normas de proteção ao 
consumidor. 
 
7.7. O objeto que estiver em desacordo com as especificações do edital terá seu 
recebimento recusado, devendo o fornecedor, dentro do prazo de 10 (dez) dias corridos, 
substituir o produto adequadamente, sujeitando-se à multa prevista na Seção 8. 
 
8 - DAS SANÇÕES ADMINISTRATIVAS. 
 
8.1. Com fundamento no artigo 7º da Lei nº 10.520/2002 e, subsidiariamente, 
nos artigos 86 e 87 da Lei 8.666/1993, a Contratada ficará sujeita, assegurada prévia e 
ampla defesa, às seguintes penalidades:  

 
a. Advertência:  
 

i. A Contratada será notificada formalmente em caso de descumprimento de 
obrigação contratual e terá que apresentar as devidas justificativas em um prazo 
de até 5 (cinco) dias úteis após o recebimento da notificação; e 

 
ii. Caso não haja manifestação dentro desse prazo ou se entenda serem 
improcedentes as justificativas apresentadas, a Contratada será advertida. 

 
b. Multa de: 

 
i. 0,5% (meio por cento) por dia, e por ocorrência, sobre o valor do 

objeto com atraso injustificado, limitada a incidência a 20 (vinte) 
dias corridos; 

- No caso de atraso injustificado na entrega do objeto por prazo superior a 20 
(vinte) dias corridos, com 
a aceitação pela Administração, será aplicada a multa de 10% sobre o valor 
da Ordem de Fornecimento; e 

-  No caso de atraso injustificado na prestação dos serviços por prazo superior a 
20 (vinte) dias corridos, com a não aceitação pela Administração, será aplicada a 
penalidade 20% sobre o valor da Ordem de Fornecimento, no caso de inexecução 
total da obrigação, podendo haver, ainda, o cancelamento do registro de preços 
do Fornecedor. 

ii. 10% sobre o valor constante da Ordem de Fornecimento, no caso de inexecução 
parcial da obrigação assumida; 
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iii. 20% (vinte por cento) sobre o valor adjudicado, em caso de inexecução total da 
obrigação assumida; 

iv. 10% sobre o valor global da Ata de Registro de Preços, na hipótese de recusa em 
assinar a Ata ou retirar a Ordem de Fornecimento; 

c. Impedimento de licitar e contratar com a União e descredenciamento do SICAF 
pelo prazo de até 5 (cinco) anos, sem prejuízo das demais penalidades legais; e  
 
d. Declaração de inidoneidade para licitar ou contratar com a Administração 
Pública.  

 
8.2.    O cometimento reiterado de atrasos injustificados dos prazos previstos para 
entrega/solução do chamado de garantia dos equipamentos poderá resultar no 
cancelamento do instrumento de fornecimento com a Contratada. 
 
8.3.   As sanções previstas nos itens "18.1.a", “18.1.c” e “18.1.d” poderão ser 
aplicadas, cumulativamente ou não, à pena de multa.  
 
8.4.   O valor da multa, aplicada após o regular processo administrativo, será 
descontado de pagamentos eventualmente devidos à contratada ou cobrado judicialmente;  
 
8.5.   Excepcionalmente, ad cautelam, a Administração poderá efetuar a retenção 
do valor presumido da multa, antes da instauração do regular procedimento administrativo. 
 
8.6.   O valor da multa, apurado após regular procedimento administrativo, será 
descontado dos pagamentos eventualmente devidos pelo TRE/AL ou cobrado judicialmente. 
 
8.7.   Na aplicação das penalidades previstas nesta Seção a autoridade 
competente sempre se valerá dos princípios da proporcionalidade, da razoabilidade e da 
prevalência e indisponibilidade do interesse público, em decorrência de circunstâncias 
fundamentadas em fatos comprovados. 
 
8.8.   O licitante contratado, quando não puder cumprir os prazos 
estipulados para o fornecimento do material, total ou parcialmente, deverá apresentar 
justificativa por escrito, devidamente comprovada, e em documento contemporâneo à sua 
ocorrência, acompanhada de pedido de prorrogação, nos casos de ocorrência de fato 
superveniente, excepcional ou imprevisível, estranho à vontade das partes, que altere 
fundamentalmente as condições do contrato, ou que impeça a sua execução, por fato ou 
ato de terceiro reconhecido pela Administração.  
 
8.9.  Do ato que aplicar as penalidades caberá recurso na forma do art. 109 da Lei 
nº 8.666/1993. 
 
8.10.  Se o licitante contratado não recolher o valor da multa que lhe for aplicada, 
dentro de 05 (cinco) dias úteis a contar da data da intimação para o pagamento, a 
importância será descontada automaticamente, ou ajuizada a dívida, consoante o § 3º do 
art. 86 e § 1º do art. 87 da Lei nº 8.666/1993, acrescida de juros moratórios de 0,5% (meio 
por cento) ao mês. 
 
8.11.  O TRE/AL promoverá o registro no SICAF de toda e qualquer penalidade 
imposta ao licitante contratado. 
 
8.12.  O período de atraso será contado em dias corridos. 
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8.13. No caso de aplicação de penalidade em que a contratada tenha que 
pagar multa através de Guia de Recolhimento da União – GRU, e não o faça no devido 
prazo, o índice utilizado para atualização do valor será o IPCA. 
 
8.14. A data a ser utilizada como referência para a atualização do débito será a 
da publicação da decisão da aplicação da penalidade no Diário Eletrônico.  
 
8.15.  Fica estabelecido que os casos omissos serão resolvidos entre as partes 
contratantes, respeitados o objeto da presente licitação, a legislação e demais normas 
reguladoras da matéria, em especial as Leis nos 8.666/1993 e  10.520/2002, aplicando-lhes, 
quando for o caso, supletivamente, os princípios da Teoria Geral dos Contratos e as 
disposições do Direito Privado. 

 
18.16.  Os atos administrativos de aplicação das sanções, com exceção de 
advertência, multa de mora e convencional, serão publicados resumidamente no Diário 
Oficial da União. 

9 – DA VEDAÇÃO DE ACRÉSCIMO NOS QUANTITATIVOS REGISTRADOS 

9.1.     É vedado efetuar acréscimos nos quantitativos fixados na presente  ata de 
registro de preços, inclusive o acréscimo de que trata o § 1º do art. 65 da Lei nº 8.666, de 
1993, de acordo com o disposto no § 1º, art. 12 do Decreto nº 7.892/2013. 
 
10  - DA PUBLICAÇÃO 
 
10.1.       O extrato da presente ata será publicado no Diário Oficial da União. 
 
11 – DO FORO 
 
11.1.  Fica eleito o foro da Seção Judiciária da Justiça Federal da Capital do 
Estado de Alagoas, para dirimir as questões originadas deste contrato, com exclusão de 
qualquer outro, por mais privilegiado que seja. 
 

E por estarem justos e contratados, foi lavrado o presente instrumento, em 02 (duas) vias 
de igual teor e forma, que, após lido e achado conforme, segue assinado pelas partes. 

Maceió, XX de XXXX de 2019. 
 
Pelo TRE/AL: 
 

Desembargador Otávio Leão Praxedes 
Vice-Presidente, no exercício da Presidência 

 
Pela Empresa: 
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INFORMAÇÃO Nº 4565 - TRE-AL/PRE/DG/SAD/COMAP/SLC

  Sr. Secretário,

 

Vieram os autos para elaboração de minuta de edital visando ao Registro de
Preços de material/serviço de informática.
 
Salientamos que a minuta foi elaborada sem conferir às Microempresas e
Empresas de Pequeno Porte, exclusividade na participação do certame, em
virtude do valor estimado da contratação.
 
Informo, ainda, que foi dispensada a divulgação de Intenção de Registro de
Preços no Comprasnet em virtude de determinação da Srª Secretária de
Administração substituta (Despacho GSAD 0572764).
 
Ressaltamos, ainda, que foi divulgado no edital o preço orçado pela
administração, como já foi devidamente fundamentado em outros
procedimentos que seguiram a mesma sorte que este, ancorado no
entendimento do TCU, exarado Acórdão 2.166/2014 – Plenário:
 
“(...) Na modalidade pregão, o orçamento estimado não constitui elemento
obrigatório do edital, devendo, contudo, estar inserido no processo relativo ao
certame. Todavia, sempre que o preço de referência for utilizado como critério
de aceitabilidade da proposta, a sua divulgação no edital é obrigatória, nos
termos do art. 40, inciso X da Lei 8666/93.”
 
Diante do exposto, encaminhamos os autos para que, havendo concordância
com os termos da minuta apresentada, seja dado encaminhamento dos autos
em seus ulteriores termos.
 

Documento assinado eletronicamente por ANDRÉA DE ALBUQUERQUE CÉSAR,
Analista Judiciário, em 31/07/2019, às 15:37, conforme art. 1º, III, "b", da Lei
11.419/2006.

Documento assinado eletronicamente por INGRID PEREIRA DE LIMA ARAÚJO,
Técnico Judiciário, em 31/07/2019, às 15:38, conforme art. 1º, III, "b", da Lei
11.419/2006.
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A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 31 de julho de 2019.
 
 
À AJ-DG.
 
Senhor Assessor,
 
Em harmonia com o disposto no artigo 4º, inciso X, da

Resolução TRE/AL nº 15.787/2017, encaminho os autos a Vossa
Senhoria para análise da minuta do edital de licitação, conforme
evento SEI 0574599.

Para isso, ratifico os termos da minuta elaborada pela
Seção de Licitações e Contratos, inclusive quanto a não
exclusividade de participação para microempresas e empresas de
pequeno porte na competição, em virtude do valor estimado do
objeto.

Por fim, em consonância com o novo entendimento do
Tribunal de Contas da União, destaco que na mencionada minuta
consta a divulgação dos preços médios estimados para contratação.

 
Atenciosamente.

 

Documento assinado eletronicamente por ANDRÉA CRISTINA DE LIMA BELCHIOR,
Secretário de Administração Substituto, em 31/07/2019, às 16:38, conforme art. 1º,
III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0574668 e o código CRC BDC31803.
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PROCESSO : 0008478-63.2018.6.02.8000
INTERESSADO : SECRETARIA DE TECNOLOGIA DA INFORMAÇÃO
ASSUNTO : REGISTRO DE PREÇOS DE COMPONENTES DE REDE (NETWORKING),

 

Parecer nº 1555 / 2019 - TRE-AL/PRE/DG/AJ-DG

1. DO OBJETO
 

Tratam os autos de registro de preços para
eventual aquisição de componentes de rede (networking),
mediante registro de preços, conforme termo de
referência 0541748, tudo de acordo com requisição
promovida pela Secretaria de Tecnologia da Informação, com
a justificativa de que grande parte dos equipamentos de rede
deste Tribunal está defasado tecnologicamente, fora de
garantia ou na iminência de seu término.

  
2. DO PROCEDIMENTO

 

Constam dos autos os seguintes documentos: 
- Documento de Oficialização da Demanda (DOD) nº

20/ 2019 (0441142), nos termos da Resolução CNJ nº
182/2013;

- Portaria 412/2019, que nomeou a  Comissão de
Planejamento (0445262);

- Estudos Preliminares (0448409), nos termos da
Resolução CNJ nº 182/2013;

- Termo de Referência (0541748);
- Aprovação da primeira versão do TR pelo

Secretário de Tecnologia da Informação (0494899);
- Pesquisa de preços realizada pela SEIC (0560123);
- Informação da SGO/COFIN sobre as limitações de

Crédito (0567525) para aquisição neste exercício;
- Despacho da STI, solicitando a continuidade do

presente procedimento, desde que o Registro de Preços não
estabeleça a obrigatoriedade de aquisições no ano em
curso(0569246);

-Despacho SAD sobre a dispensa da divulgação
da Intenção de Registro de Preços, conforme previsto no §1º
da art. 4º do Decreto nº 7.892/2013, em razão da urgência na
tramitação do  presente procedimento, em que se pretende a
antecipação de despesa  a fim de viabilizar crédito para
concluir obra/serviços na antiga sede (0572764);

-Minuta de edital de licitação na modalidade
PREGÃO ELETRÔNICO, do tipo MENOR PREÇO POR LOTE
(0574599), elaborada pela SLC, objetivando o Registro de
Preços de componentes de rede (Networking).

Eis o resumo dos fatos contidos nos autos.
Ressalvadas as nuanças técnicas e financeiras, passamos a
opinar quanto aos aspectos jurídicos nos termos que seguem.

 
3. DO AGRUPAMENTO DOS ITENS POR LOTES
 

 Anote-se que o termo de referência apresenta
justificativa para agrupamento dos itens em lotes (vide item 7
do TR). 
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Gize-se ainda que a minuta ora analisada, em seu
item 25 do edital e item 9 da Ata de Registro de Preços,
observou as cautelas e limites impostos pela jurisprudência
do TCU, para a utilização de lotes em sede de registro de
preços,  trazendo disposições relativas à vedação de 
aquisição separada de itens para os quais o fornecedor
convocado para assinar a ata não tenha apresentado o menor
preço.

 
4. DO REGISTRO DE PREÇOS
 

Os presentes autos tratam da utilização do Sistema
de Registro de Preços, na forma prevista pelo art. 15 da Lei nº
8.666/93 e regulamentada pelo Decreto nº 7.892/2013, com
alterações feitas pelo Decreto nº 9.488/2018.

Com efeito, como se conclui das informações
constantes nestes autos, a aquisição em tela pode se
enquadrar na hipótese contida no inciso II do art. 3º do citado
Decreto nº 7.892/13, ou seja, pelas suas características, pode
ser conveniente a previsão de entregas parceladas, tal como
previsto no  termo de referência (0574599).

Frise-se que referido decreto, em seu art. 7º, 
possibilita a utilização da modalidade pregão para a licitação
que objetiva o registro de preços.

Tendo em mente as disposições constantes no
Decreto acima relacionado, vê-se que os instrumentos ora
trazidos à análise conformam-se, in totum, ao Sistema de
Registro de Preços, inclusive no que se refere ao prazo de
validade da ata (art. 12) e aos elementos necessários do edital
(art. 9º).

 
5. DA PESQUISA DE PREÇOS

 

Acerca da pesquisa de preços realizada pela SEIC,
parece de relevo transcrever a Informação nº 3.875
(0560123);

 
"Veio o procedimento a esta Seção de
Instrução de Contratações - SEIC para
realização de pesquisa de preços
(Despachos GSAD 0520870 e
COMAP 0521551), visando ao Registro de
Preços de equipamentos de Soluções de
Tecnologia da Informação - componentes
de rede (Networking), conforme Termo de
Referência ajustado 0541748.
Foram consultadas diversas empresas do
ramo, incluindo as empresas indicadas
pela unidade demandante como potenciais
fornecedoras dos equipamentos
requeridos, conforme
eventos 0522495, 0522526, 0523417, 0526142,
seguidos de vários contatos telefônicos e
algumas promessas de envio de cotação, a
exemplo das empresas 7secure,
Smartwave Networks, Ingram Micro;
outras empresas informaram não
atenderem ao requerido, como reportado
pela Wintronic, SoloNetwork,
Supriservice, New Tech e Usetech.
As empresas ISH Tecnologia e Approach
Tecnologia enviaram Atas de Registro de
Preços vigentes para itens apontados pela
unidade técnica demandante como
equivalentes a alguns itens requeridos no
TR, servindo, portanto, como base para a
formação do preço estimado para esses
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itens.
Apresentaram orçamentos para o
fornecimento as empresa Plugnet
(0533091), NewSupri (0535906) e ISH
Tecnologia (0551756), conforme Planilha
de Preços Recebidos (evento 0559828).
Portanto, tendo em vista as aquisições
passadas de equipamentos de mesma
natureza, quanto aos resultados
normalmente obtidos nos procedimentos
licitatórios, com preços fechados abaixo
dos valores médios estimados - vez que os
preços apresentados pelas empresas
fornecedoras na fase de pesquisa são
preços de balcão, como são chamados,
deixando, como vem ocorrendo, a
negociação para o momento do certame,
entendemos prudente sugerir, como
estimativa de preços para a aquisição dos
equipamentos, salvo melhor
entendimento, os menores preços obtidos
na pesquisa para cada item do Termo de
Referência, considerando-se, inclusive,
manifestação da unidade técnica
demandante constante na Informação
COINF 3789 (0558080).
Diante do exposto, conforme disposições
do Termo de Referência - TIC 24
(0541748), pendente de aprovação,
obtivemos o total estimado para o
regisgtro de preços dos equipamentos no
valor de R$ 4.850.943,10 (quatro
milhões, oitocentos e cinquenta mil,
novecentos e quarenta e três reais e dez
centavos), e, para atender previsão
estimada ajustada de aquisição no
presente exercício aposta na Informação
COINF 3789 (0558080), encontramos o
valor médio estimado de R$ 249.619,10
(duzentos e quarenta e nove mil,
seiscentos e dezenove reais e dez
centavos).
Assim, caso autorizada, sugerimos que a
contratação seja realizada por meio de
licitação, pregão eletrônico, pelo sistema
de registro de preços, com base na Lei nº
10.520/2002, regulamentada pelos
Decretos nºs 3.555/200, 5.450/2005 e
7.892/2013."
(Grifos não constam do original)

  
Como visto, houve certa dificuldade na obtenção

dos preços médios dos serviços e equipamentos de
informática.

Com efeito, não se trata de tema de fácil deslinde.
Cite-se, por oportuno, substancioso texto elaborado
pela  Editora Zênite, contratada pela Justiça Eleitoral para a
prestação de serviços de consultoria em licitações e
contratos.

Não obstante tratar de serviços de manutenção
predial, os entraves e dificuldades são comuns aos serviços de
TI, como se verá adiante:

 
"QUESTÃO
"Pretende-se realizar licitação para a
contratação de serviços de manutenção
predial no âmbito do Poder Judiciário
Estadual. Após intensa pesquisa
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de preços houve retorno de apenas três
empresas entre as vinte que foram
consultadas para cotação. As respostas
exibiam valores díspares, retirando a
confiabilidade do critério de média
aritmética. Desta forma, questionamos a
aplicabilidade ao caso da Instrução
Normativa nº 05 da SLTI do MPOG, a
qual não alcança esta Administração
Judiciária, em face de seu art. 1º, § único.
Em caso positivo, indagamos a
possibilidade de empregar o disposto no
art. 2º,§2º da referida Instrução, com
utilização do menor preço obtido (preço
mínimo) como critério de balizamento da
estimativa."
ORIENTAÇÃO ZÊNITE
As dúvidas da Administração envolvem o
procedimento a ser adotado para fins de
estimativa do valor da licitação que será
deflagrada para a contratação
de serviços de manutenção predial no
âmbito do Poder Judiciário Estadual,
tendo em vista a dificuldade enfrentada
na obtenção, junto a fornecedores, de
orçamentos que refletissem com
segurança a média de preços praticada.
De início, válido recordar que a
conformidade dos preços contratados com
aqueles praticados no mercado constitui
um dos fatores de legitimidade das
contratações públicas. Isso porque, entre
os princípios que informam o agir da
Administração, destaca-se o da
economicidade, por força do qual as
necessidades públicas devem ser
satisfeitas com o melhor aproveitamento
de recursos públicos possível.
Nesse passo, a delineação adequada do
valor estimado da contratação ganha
relevância, exigindo da Administração
cautela no levantamento das informações
pertinentes na etapa de
planejamento. Sem a
adequada cotação de preços, a
Administração (i)não tem como aferir a
modalidade licitatória adequada e,
inclusive, a possibilidade de eventual
contratação direta; (ii) não consegue
avaliar a efetiva disponibilidade
financeira para a execução do contrato;
e (iii) não detém fundamentos para a
fixação de critérios objetivos para o
julgamento e aceitabilidade das ofertas,
ficando sujeita à contratação de propostas
desvantajosas por serem excessivas ou
potencialmente prejudiciais por serem
inexequíveis.
Com o intuito de vincular a Administração
à contratação de propostas que reflitam
as condições praticadas no segmento, a
Lei de Licitações impõe o dever de a
Administração contratar preço em
conformidade com a realidade
de mercado, conforme se depreende
dos seguintes dispositivos: art. 15, III, §
6º; art. 24, VIII, X, XX, XXIII; art. 26,
parágrafo único, III; art. 43, IV; art. 44, §
3º; art. 48, II.
Não obstante imponha o dever de
observância dos preços de mercado, a Lei
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de Licitações não estabelece o
procedimento a ser adotado para
promover esse levantamento.
Diante disso, mostra-se oportuna a
adoção, como parâmetro, da Instrução
Normativa nº 05/2014 da Secretaria de
Logística e Tecnologia da Informação do
Ministério do Planejamento, Orçamento e
Gestão, que reflete as boas práticas
indicadas pela doutrina e pelos órgãos de
controle ao dispor "sobre o procedimento
administrativo para a realização
de pesquisa de preços para a aquisição de
bens e contratação de serviços em geral"
(art. 1º).
(...)
 
Dito isso, passa-se à análise do disposto
no art. 2º da IN nº 05/2014, abaixo
transcrito:
"Art. 2º A pesquisa de preços será
realizada mediante a utilização de um dos
seguintes parâmetros:
I - Portal de Compras Governamentais -
www.comprasgovernamentais.gov.br;
II - pesquisa publicada em mídia
especializada, sítios eletrônicos
especializados ou de domínio amplo,
desde que contenha a data e hora de
acesso;
III - contratações similares de outros
entes públicos, em execução ou
concluídos nos 180 (cento e oitenta) dias
anteriores à data da pesquisa de preços;
ou
IV - pesquisa com os fornecedores.
§ 1º No caso do inciso I será admitida
a pesquisa de um único preço.
§ 2º No âmbito de cada parâmetro, o
resultado da pesquisa de preços será
a média ou o menor dos preços obtidos.
§ 3º A utilização de outro método para a
obtenção do resultado
da pesquisa de preços, que não o disposto
no § 2º, deverá ser devidamente
justificada pela autoridade competente.
§ 4º No caso do inciso IV, somente serão
admitidos os preços cujas datas não se
diferenciem em mais de 180 (cento e
oitenta) dias.
§ 5º Excepcionalmente, mediante
justificativa da autoridade competente,
será admitida a pesquisa com menos
de três preços ou fornecedores.
§ 6º Para a obtenção do resultado
da pesquisa de preços, não poderão ser
considerados os preços inexequíveis ou
os excessivamente elevados, conforme
critérios fundamentados e descritos no
processo administrativo." (Destacamos.)
Ao indicar as formas
de pesquisa de preços, a IN teve como
objetivo estabelecer métodos que
conferissem maior grau de segurança e
controle em torno da obtenção de
resultados atuais, capazes de refletir
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efetivamente valores praticados no
segmento.
E é justamente pela notoriedade da
problemática envolta
na pesquisa de preços realizada
exclusivamente junto a
potenciais fornecedores que a citada
IN indica outras formas de obter a
estimativa de preços e exige, como
regra, a obtenção de pelo
menos três orçamentos distintos.  Essa
regra é excepcionada quando
a pesquisa é feita no Portal de
Compras Governamentais ou quando,
justificadamente, não for possível
obter três orçamentos.
Essa também é a
orientação do Tribunal de Contas da
União, que registrou o seguinte
Enunciado no Informativo de
Licitações e Contratos n. 63:
"Enunciado: No caso de
impossibilidade de obtenção
de preços referenciais, via sistemas
oficiais, para a estimativa dos custos
em processos licitatórios, deve ser
realizada pesquisa contendo o
mínimo de três cotações de
empresas/fornecedores distintos,
fazendo constar do respectivo
processo a documentação
comprobatória pertinente aos
levantamentos e estudos que
fundamentaram o preço
estimado, devendo ser devidamente
justificadas as situações em que não
for possível atingir o número mínimo
de cotações." (Acórdão n.º
1266/2011-Plenário, TC-
002.573/2011-3, rel. Min. Ubiratan
Aguiar, 18.05.2011 - destacamos.)
Ademais, válido pontuar  que o TCU, no
Acórdão nº 1.445/2015 – Plenário, deu
ciência ao órgão jurisdicionado de que:
"9.3.2. para fim de orçamentação nas
licitações de bens e serviços, devem ser
priorizados os parâmetros previstos nos
incisos I e III do art. 2º da IN SLTI/MPOG
5/2014, quais sejam, ‘Portal de Compras
Governamentais’ e ‘contratações
similares de outros entes públicos’, em
detrimento dos parâmetros contidos nos
incisos II e IV daquele mesmo art. 2º, isto
é, ‘pesquisa publicada em mídia
especializada, sítios eletrônicos
especializados ou de domínio amplo’ e
‘pesquisa com os fornecedores’, cuja
adoção deve ser vista como prática
subsidiária, suplementar;" (Destacamos.)
Em vista do cenário envolto na obtenção
de orçamentos junto aos potenciais
fornecedores, entende-se que a primeira
providência a ser adotada pela
Administração refere-se à ampliação
das fontes de pesquisa para fins de
definição dos critérios de julgamento que
serão estabelecidos no edital da licitação
futura.
Para tanto, é recomendável que a
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Para tanto, é recomendável que a
Administração promova diligências com
vistas a avaliar se os preços obtidos junto
aos fornecedores na etapa de
planejamento correspondem aos valores
praticados em contratações similares
registradas no Portal de Compras
Governamentais, ou em mídia/sítios
eletrônicos especializados, ou em
contratações similares de outros entes
públicos.
A partir disso, a Administração terá
condições de determinar se os
orçamentos encaminhados pelos
fornecedores refletem valores pertinentes
com aqueles praticados no mercado ou
não, e, assim, definir o parâmetro para
estimar o valor da futura licitação (o
menor valor obtido ou a média entre
todos os preços).
A decisão pela consideração do menor
valor pesquisado ou pela média de todos
os preços conhecidos deve ser motivada,
considerando que depende de análise
crítica da Administração em torno da sua
realidade orçamentária, bem como do
próprio mercado em que estão inseridos
os objetos pretendidos.
Essa motivação se aplica
independentemente de a Administração
ter sido bem sucedida na ampliação das
fontes de pesquisa. Tendo ou não uma
variedade de fontes a respeito dos valores
praticados no mercado, a estimativa do
valor da licitação a partir do menor preço
ou da média dos preços obtidos requer
justificativa pertinente.
Sendo assim, é preciso avaliar se a área
técnica detém condições de justificar a
exequibilidade do menor valor pesquisado
e a inadequação dos
demais preços obtidos.
Somente se houver elementos capazes de
aferir a regularidade do parâmetro eleito
é que a Administração terá condições de
motivar a estimativa de preços da futura
licitação com base apenas no menor valor
pesquisado.
Essa análise é de suma importância, na
medida em que não é adequada a
delineação dos critérios de aceitabilidade
das propostas com base em valores que
escapam à margem de variação usual
dos preços do mercado. Tanto é assim
que o TCU já havia manifestado
entendimento similar à regra indicada no
§ 6º do art. 2º da IN nº 05/2014:
"Em processo de fiscalização de
contratação realizada por meio de
dispensa, foi identificada irregularidade
na fase de planejamento consistente na
realização de pesquisa de preço baseada
apenas em contrato semelhante firmado
com outra entidade do mesmo setor e no
valor apresentado pela futura contratada.
Analisando o caso, o TCU enfatizou a
relevância da fase de planejamento como
forma de assegurar a economicidade na
contratação, manifestando-se quanto
à pesquisa de preços nos seguintes
termos: '6. Para a estimativa do preço a
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ser contratado, é necessário consultar as
fontes de pesquisa que sejam capazes de
representar o mercado. A propósito, o
Voto que conduziu o Acórdão 2.170/2007
- TCU - Plenário, citado no relatório de
auditoria, indica exemplos de fontes
de pesquisa de preço, in verbis: 'Esse
conjunto de preços ao qual me referi
como 'cesta de preços aceitáveis' pode ser
oriundo, por exemplo, de pesquisas junto
a fornecedores, valores adjudicados em
licitações de órgãos públicos – inclusos
aqueles constantes no Comprasnet –,
valores registrados em atas de SRP, entre
outras fontes disponíveis tanto para os
gestores como para os órgãos de controle
– a exemplo de compras/contratações
realizadas por corporações privadas em
condições idênticas ou semelhantes
àquelas da Administração Pública –, desde
que, com relação a qualquer das fontes
utilizadas, sejam expurgados os valores
que, manifestamente, não representem a
realidade do mercado'.' (TCU, Acórdão nº
868/2013, Plenário, Rel. Min. Marcos
Bemquerer, DOU de
22.04.2013.)"3 (Destacamos.)
Veja-se que a escolha do critério
balizador dos preços na futura
licitação exige motivação pautada na
prática de mercado. Por essa razão,
importante identificar se há um padrão de
repetição e variação dos valores e
verificar quais orçamentos escapam a
esse padrão (seja para mais, seja para
menos), de modo a justificar a sua
desconsideração para fins de estimativa
de preços na licitação.
Se escolhido o menor preço, é
indispensável que a área técnica
apresente as justificativas que indicam a
sua exequibilidade em face do encargo a
ser licitado.
A não adoção de cautelas nesse sentido
pode conduzir à realização de certame
que, por não ter valor de referência
condizente com aquele praticado
no mercado, poderá restar frustrado ou
fracassado.
A respeito do tema, citam-se as seguintes
manifestações do TCU:
Acórdão nº 2.170/2007 – Plenário
"REPRESENTAÇÃO. PEDIDO DE
REEXAME. PREGÃO
ELETRÔNICO. SERVIÇOS DE INFORMÁTICA.
REVOGAÇÃO DE MEDIDA CAUTELAR.
PROVIMENTO PARCIAL.
1. A aferição de preços nas aquisições
e contratações de produtos
e serviços de tecnologia da
informação, no âmbito da
Administração Pública federal, na
fase de estimativa de preços, no
momento de adjudicação do objeto do
certame licitatório, na contratação e
alterações posteriores, deve se
basear em valores aceitáveis, que se
encontrem dentro da faixa
usualmente praticada

Parecer 1555 (0574780)         SEI 0008478-63.2018.6.02.8000 / pg. 464



pelo mercado em determinada época,
obtida por meio depesquisa a partir
de fontes diversas, como orçamentos
de fornecedores, valores adjudicados
em licitações de órgãos públicos -
inclusos aqueles constantes no
Comprasnet -, valores registrados em
atas de Sistema de Registro
de Preços, entre outras, a exemplo de
compras/contratações realizadas por
corporações privadas em condições
idênticas ou semelhantes àquelas da
Administração Pública.
2. Preço aceitável, a ser considerado
na faixa de preços referida no item
precedente, é aquele que não
representa claro viés em relação ao
contexto do mercado, ou seja, abaixo
do limite inferior ou acima do maior
valor constante da faixa identificada
para o produto ou serviço."
(Destacamos.)
Acórdão nº 1861/2008- 1ª Câmara
"[RELATÓRIO]
Observa-se ainda que não houve
qualquer pesquisa a preços efetivamente
praticados no âmbito da Administração
Pública. Para a formação de preços na
fase interna de um processo licitatório,
deve-se dar preferência a valores
efetivamente praticados
no mercado, prioritariamente
pela pesquisa em preços praticados pela
Administração Pública em processos
licitatórios de ampla competição, como,
por exemplo, pregões e registro
de preços, conforme dispositivo da Lei nº
8.666/1993'.
[...]
45. Dessa forma, permanece o
entendimento de que o orçamento de
referência de preço não está respaldado
por uma pesquisa de preços adequada e
suficiente, uma vez que todas as cotações
solicitadas se limitaram a empresas
representantes de um mesmo fabricante
[...], sendo este mais um indicativo do
direcionamento do certame e da restrição
ao caráter competitivo. Além disso,
conforme mencionado supra, não
há pesquisa em contratos firmados no
âmbito da Administração Pública, como
preconiza o inciso IV do art. 43 da Lei nº
8.666/1993.
[...]
[ACÓRDÃO]
9.2. determinar à Coordenação-Geral de
Recursos Logísticos do Ministério do
Planejamento, Orçamento e Gestão -
CGLOG/MP que:
[...]
9.2.3. quando da elaboração do
orçamento-base da licitação, realize
ampla pesquisa de mercado para a
formação dos preços orçados, utilizando-
se de fontes oficiais ou de orçamentos
emitidos por, no mínimo,
três fornecedores, quando houver, a qual
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deverá necessariamente estar
documentada no processo licitatório,
previamente à publicação do edital, de
forma a atender aos princípios da
impessoalidade, da publicidade e da
vinculação ao instrumento convocatório;"
(Destacamos.)
CONCLUSÕES
(...)
- Antes de adotar qualquer decisão em
torno do valor a ser definido, recomenda-
se à Administração ampliar
as fontes de pesquisa no que tange à
contratação pretendida, avaliando-se, por
exemplo, os valores praticados em
contratos com outras entidades ou órgãos
da Administração Pública, a fim de
confirmar a
regularidade dos preços obtidos junto aos
três fornecedores.
- Independentemente de conseguir
ampliar as fontes de pesquisa, a
Administração deve ter cautela na
definição do valor estimado. A
decisão pela adoção como parâmetro
do menor valor ou da média dos
valores pesquisados dependerá de
análise crítica em torno da sua
realidade orçamentária, bem como do
próprio mercado em que estão
inseridos os objetos pretendidos.
- A motivação exaustiva a respeito da
questão afasta questionamentos
quanto à adoção de valor que não
corresponde à realidade
de mercado e que, por isso, pode
representar restrição indevida à
competição, resultar em certame
fracassado ou deserto, ou, por outro
lado, em contratação
desvantajosa/antieconômica.
Salvo melhor juízo, essa é a orientação da
Zênite, de caráter opinativo e orientativo,
elaborada de acordo com os subsídios
fornecidos pela Consulente."

 
Concluindo o presente item, e ciente das

dificuldades enfrentadas pela SEIC em casos que tais, tem
esta AJ-DG por importante serem ponderadas as diretrizes
acima expostas pela consultoria da Editora Zênite, 
 parecendo de bom alvitre seja auscultada a ACAGE, 
considerando, inclusive, que o procedimento, após a eventual
adjudicação do objeto do certame pelo pregoeiro, deverá
seguir àquela Assessoria, em razão da matéria, na forma do
regulamento.  

 

6. DA LEGISLAÇÃO APLICÁVEL
 
Ao procedimento licitatório na modalidade pregão,

na forma eletrônica, aplicam-se as normas contidas na Lei nº
10.520/02 e no Decreto nº 5.450/05, bem como,
subsidiariamente, as prescrições insertas na Lei nº 8.666/93,
com alterações.

O pregão, segundo a disciplina do art. 1º da
antedita Lei nº 10.520/02, bem como o § 1º do art. 2º do
Decreto nº 5.450/05, destina-se à aquisição de bens e serviços
comuns, ou seja, aqueles cujos padrões de desempenho e
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qualidade possam ser objetivamente definidos pelo edital, por
meio de especificações usuais no mercado.

  Posteriormente, o art. 9º do Decreto nº
7.174/2010 veio aclarar ainda mais a situação, senão vejamos:

“Art. 9º  Para a contratação de bens e
serviços de informática e automação,
deverão ser adotados os tipos de licitação
“menor preço” ou “técnica e preço”,
conforme disciplinado neste Decreto,
ressalvadas as hipóteses de dispensa ou
inexigibilidade previstas na legislação.

§ 1o A licitação do tipo menor preço será
exclusiva para a aquisição de bens e
serviços de informática e automação
considerados comuns, na forma do
parágrafo único do art. 1º da Lei nº
10.520, de 2002, e deverá ser realizada na
modalidade de pregão, preferencialmente
na forma eletrônica, conforme determina
o art. 4odo Decreto no 5.450, de 31 de
maio de 2005.

§2o Será considerado comum o bem ou
serviço cuja especificação estabelecer
padrão objetivo de desempenho e
qualidade e for capaz de ser atendida por
vários fornecedores, ainda que existam
outras soluções disponíveis no mercado.”

 
Dessa forma, sendo os serviços em

foco  catalogados como serviços comuns,  tem-se que os
objetos da presente licitação podem ser adquiridos via pregão,
tudo conforme consta nos itens 20.1 e 20.4, do documento
"Estudos Preliminares" (0411475), registrando-se, ainda, que
todos os atos da fase interna ou preparatória, previstos no art.
3º da Lei n.º 10.520/02 c/c o art. 9º do Decreto n.º 5.450/05,
foram devidamente observados.

Frise-se, ainda, que o presente procedimento
contém todos os elementos necessários, segundo as
prescrições do art. 30 do Decreto nº 5.450/05, quais sejam, a
justificativa da contratação, o termo de referência, a planilha
de custo e a minuta do edital, sendo que esta não traz
cláusula restritiva ou impertinente para a execução do objeto
contratual, obedecendo, destarte, ao art. 37, inc. XXI, da
Constituição Federal e ao art. 14, do antedito Decreto,
pendente, ainda, a autorização de abertura da licitação.

Nota-se, ainda, que as exigências quanto à
habilitação são autorizadas em lei e compatíveis com o
contrato a ser executado, conforme preceituam os arts. 27 a
31 da Lei de Licitações e o art. 14 do Decreto nº 5.450/05; que
é objetivo o critério de julgamento adotado, conforme
disciplinam os arts. 44 e 45 da mesma Lei; havendo regular
previsão das fases do procedimento licitatório,
homenageando-se o art. 43 da referida Lei e que os anexos do
edital estão de acordo com as exigências legais (art. 40, § 2º,
Lei nº 8.666/93).

Da mesma forma, encontram-se dentro das
prescrições legais e regulamentares as referências
à  participação exclusivas de microempresas e empresas de
pequeno porte.  

Igualmente,  a minuta da ata de registro de preços
encontra-se de acordo com os preceitos regulamentares
vigentes, inclusive no que concerne aos novos limites de
adesão previstos pelo Decreto nº 9.488/2018.

 
7. DA LISTA DE VERIFICAÇÃO

 
 Em face do que determina a PORTARIA
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PRESIDÊNCIA Nº 226/2018, que regulamentou a
obrigatoriedade do uso de listas de verificação dos
procedimentos de contratações de bens e serviços no âmbito
do Tribunal Regional Eleitoral de Alagoas. Segue a lista de
verificação contida no Anexo II - Atos administrativos e
documentos necessários à instrução da fase interna do
procedimento licitatório na modalidade pregão, no formato
eletrônico, prévios às contratações de bens e serviços de
tecnologia da informação

 

ItemQuestionário
Sim
Não
N/A

Evento

FORMALIDADES PRELIMINARES

1
O processo administrativo foi devidamente autuado?

Ref. art. 38, caput, da Lei nº 8.666/93
SIM  

2

A demanda por bens e/ou serviços de TI está em harmonia com o
Planejamento Estratégico Institucional (PEI) ou com o Planejamento
Estratégico de Tecnologia da Informação e Comunicação (PETIC) do
TRE/AL, alinhados com o Planejamento Estratégico do Poder
Judiciário?

Ref. caput do art. 6º, da Resolução nº 182/2013

SIM 0441142

3

A unidade demandante da contratação para os fins do disposto
no caput do art. 7º e o seu § 1º, ambos da Resolução nº 182/2013,
apresentou no 1º trimestre do ano que antecede a contratação os
elementos suficientes para subsidiar a proposta orçamentária e até
o dia 30 de novembro do mesmo ano o Plano de Contratações de
Soluções de Tecnologia da Informação e Comunicação, na forma do
Manual de Contratações de TI do TRE/AL - Etapas do Planejamento
da Contratação?

Resolução nº 182/2013:
Art. 7º O Plano de Contratações de STIC do órgão deverá ser
elaborado no exercício anterior ao ano de sua execução,
pela Área de Tecnologia da Informação e Comunicação, em
harmonia com o seu Plano Diretor de Tecnologia da Informação e
Comunicação (PDTIC), de modo a incluir todas as contratações
necessárias ao alcance dos objetivos estabelecidos nos
planejamentos do órgão e de TIC.
§ 1º O Plano de Contratações de STIC deverá ser submetido até
o dia 30 (trinta) de novembro de cada ano à autoridade
competente do órgão que deliberará sobre as ações e os
investimentos em Tecnologia da Informação e Comunicação a
serem realizados.

SIM 0441142

4
Consta dos autos Estudos Preliminares e Projeto Básico ou Termo
de Referência?

Ref. art. 8 da Resolução nº 182/2013
SIM

0448409

0541748

5
Se a contratação for de mão de obra terceirizada, a Equipe de
Planejamento da Contratação elaborou Plano de Trabalho, nos
termos do art. 9º da Resolução nº 182/2013, antes de fazer o
Termo de Referência?

N/A  

6

A unidade demandante e a Equipe de Planejamento da Contratação
estão cientes de que não poderão ser objeto de contratação de
STIC:

     (1) mais de uma solução de TI em um único contrato; e

     (2) gestão de processos de Tecnologia da Informação e
Comunicação, incluindo segurança da informação

SIM  

7

Na hipótese de a contratação se destinar à aquisição de serviço de
Suporte Técnico aos processos de planejamento e avaliação da
qualidade da Solução STIC, o responsável indicado para
supervisionar o contrato é servidor deste TRE?

Ref. § 1º do art. 10 da Resolução CNJ nº 182/2013.

 N/A  

8

A unidade demandante e a Equipe de Planejamento da Contratação
estão cientes de que a empresa contratada para prover a STIC não
poderá ser a mesma que avalia, mensura ou fiscaliza o objeto daSIM  
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8 contratação?

Ref. Parágrafo segundo do art. 10, da Resolução CNJ nº 182/2013

SIM  

9 Foram observadas as vedações constantes do art. 11 da Resolução
CNJ nº 182/2013? SIM  

10 Os Estudos Preliminares contemplam as etapas previstas no § 1º do
art. 12 da Resolução CNJ nº 182/2013? SIM  

11
Consta dos autos o Documento de Oficialização da Demanda,
contemplando os elementos enunciados no § 5º do art. 12 da
Resolução CNJ nº 182/2013?

SIM  

12 Foi instituída equipe de planejamento da contratação, na forma dos
§§ 5º, 6º e 7º do art. 12 Resolução CNJ nº 182/2013? SIM 0445262

13 Houve a indicação do Gestor do Contrato, Fiscal do Contrato ou
Equipe de Gestão? SIM

0541748

(item 11 -
SAD)

14
A equipe de planejamento foi quem elaborou e assinou os Estudos
Preliminares e o TR ou PB?

Ref. § 1º do art. 13 da Resolução CNJ nº 182/2013
SIM  

15
O titular da área demandante aprovou os termos da contratação?

Ref. § 1º do art. 13 da Resolução CNJ nº 182/2013
SIM 0494899

16
A autoridade competente autorizou o prosseguimento da
contratação pretendida?

Ref. § 1º do art. 13 da Resolução CNJ nº 182/2013
SIM 0442128

17

A Equipe de Planejamento da Contratação produziu justificativa para
a não elaboração da documentação exigida em cada uma das etapas
dos Estudos Preliminares da STIC (análise de viabilidade da
contratação, sustentação do contrato, estratégia para a contratação
e análise de risco)?

Ref. § 3º, do art. 13, da Resolução nº 182/2013

N/A  

18 O documento viabilidade da contratação contém os elementos
mínimos estabelecidos no art. 14, da Resolução CNJ nº 182/2013? SIM 0448409

19 O documento sustentação do contrato contém os elementos
mínimos estabelecidos no art. 15, da Resolução CNJ nº 182/2013? SIM 0448409

20 O documento estratégia para a contratação contém os elementos
mínimos estabelecidos no art. 16, da Resolução CNJ nº 182/2013? SIM 0448409

21 O documento análise de riscos contém os elementos mínimos
estabelecidos no art. 17, da Resolução CNJ nº 182/2013? SIM 0448409

22 A Equipe de Planejamento da Contratação elaborou o Termo de
Referência em consonância com os Estudos Preliminares da STIC? SIM 0541748

23
A Equipe de Planejamento da Contratação observou o constante nos
§§ 1º, 2º e 3º, do art. 18, da Resolução nº 182/2013, na elaboração
do TR?

SIM 0541748

24 O Termo de Referência contém ainda os elementos mínimos
estabelecidos na Resolução CNJ nº 182/2013? SIM 0541748

25 O titular da área demandante aprovou os Estudos Preliminares e o
Termo de Referência da Contratação? SIM

0494899 

(apenas a
primeira
versão)

PESQUISA DE PREÇOS  

26
Antes da pesquisa de preços, consta a aprovação motivada do
Termo de Referência pela autoridade competente?

Ref. art. 9º, II, § 1º do Decreto nº 5.450/2005
NÃO  
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27

Foi realizada a pesquisa de preços praticados pelo mercado do
ramo do objeto da licitação?

Ref. art. 3º, III, da Lei nº 10.520/02, art. 9º, § 2º, do Decreto nº
5.450/2005, arts. 15, III e 43, IV da Lei nº 8.666/1993, art. 22,
IN/SLTI 04/2014 e IN/SLTI 05/2014.

SIM 0560123

28

Tratando-se de serviço, existe orçamento detalhado em planilhas
que expresse a composição de todos os seus custos unitários
baseado em pesquisa de preços praticados no mercado do ramo
do objeto da contratação (art. 7º, § 2º, II da Lei 8.666/1993 e art.
15, XII, “a”, da IN/SLTI 02/2008), assim como a respectiva
pesquisa de preços realizada (art. 43, IV da Lei nº 8.666/93, art.
15, XII, “b”, IN/SLTI 02/2008 e IN/SLTI 05/2014)?
Ref. Acórdão 2471/2008 – Plenário - TCU

N/A
 

 

29
Quando da utilização de método de pesquisa diverso do disposto
no § 2º do art. 2º da IN/SLTI 05/2014, foi tal situação justificada?

Ref. art. 2º, § 3º da IN/SLTI 05/2014
N/A A

esclarecer

30
No caso de pesquisa com menos de 3 preços/fornecedores, foi
apresentada justificativa?

Ref. art. 2º, § 5º da IN/SLTI 05/2014
SIM  

31
A Seção de Compras avaliou a estimativa de preços e atestou a
compatibilidade do preço cotado com aquele praticado no mercado
ou encaminhou a pesquisa para manifestação da unidade
demandante, conforme o caso?

SIM 0560123

32
A minuta do edital contém previsão de participação exclusiva de
microempresas, empresas de pequeno porte e sociedade
cooperativa, em face do valor estimado para o item da
contratação?

NÃO  

33
Consta dos autos justificativa para o afastamento da exclusividade
prevista para microempresas e empresas de pequeno porte e
Sociedade Cooperativa?

SIM 0574600

34
A minuta do edital contém previsão de direito de preferência e de
saneamento às entidades preferenciais (MEI, ME, EPP e Sociedade
Cooperativa), limitado, no caso de empate, às propostas
superiores em até 5% do menor preço cotado?

SIM 0574599

35

A minuta do edital contém previsão de cota reservada às entidades
preferenciais (MEI, ME, EPP e Sociedade Cooperativa), observada a
divisibilidade dos bens a serem adquiridos e o limite máximo de
25%, relativamente ao objeto da contratação?

Ref. LC n. 123/2006, art. 48, inciso III

NÃO  

36
A minuta do edital contém disciplina para a hipótese de
desenquadramento da situação de entidade preferencial em razão
do valor da contratação (caso previsto o tratamento favorecido e
diferenciado)?

NÃO  

37
Os autos do processo administrativo estão instruídos com
justificativas adequadas e razoáveis para todas as exigências que
tenham potencial para reduzir o universo de fornecedores
interessados em participar da licitação?

SIM 0541748

38
A minuta do edital contempla anexos com orçamento detalhado
em planilhas que expressem a composição de todos os custos
unitários afetos aos bens/serviços que serão adquiridos?

NÃO  

 

39

A minuta do edital contém anexos
com planilhas que refletem todos
os direitos trabalhistas previstos
em legislação especial (inclusive em
Acordos e em Convenções
Coletivas de Trabalho).

N/A  
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40

A minuta do edital contém
definição da forma de
apresentação de lances, dos
critérios de julgamento,
classificação e aceitação das
propostas?

SIM 0574599

41
As exigências de habilitação
jurídica contidas na minuta do
edital estão de acordo com a
legislação?

SIM  

42
As exigências relativas à
regularidade fiscal e trabalhista
contidas na minuta do edital estão
de acordo com a legislação?

SIM  

43
A forma de divulgação de licitação
está de acordo com o valor a ser
contratado?

SIM  

44
A minuta do edital contempla a
avaliação quanto aos critérios de
habilitação econômico-financeira?

NÃO  

45
A minuta de edital contém critério
objetivo para avaliar a
exequibilidade das propostas?

NÃO  

46
A minuta de edital se abstém de
definir de forma genérica
penalidades aplicáveis na fase de
julgamento da licitação?

SIM  

47
A minuta do contrato estabelece
prazo razoável (não exíguo) para
início da prestação de serviços?

SIM  

48
A minuta do contrato/ata contém
descrição dos prazos e modo para
fornecimento de bens e/ou
prestação dos serviços?

SIM  0574599

49
A minuta do contrato/ata contém
descrição das obrigações
atribuídas ao TRE-AL e à
fornecedora?

SIM (edital)

50
A minuta do contrato/ata contém
obrigação à fornecedora de
manter as condições de habilitação
durante a execução do contrato?

SIM (edital)
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51
A minuta do contrato/ata contém descrição das sanções
administrativas aplicáveis às fornecedoras que incorrerem em
inadimplemento?

SIM (edital)

52
A minuta do contrato/ata contém norma estabelecendo, para
a fornecedora, a obrigação de prestar garantia de execução
do contrato? (A decisão compete à autoridade que ordenar a
despesa).

NÃO  

53 A minuta do contrato estabelece, quando for o caso, a
segregação entre o recebimento provisório e o definitivo? SIM (edital)

54 A minuta do contrato contém requisitos de qualidade que
viabilizem a vinculação da remuneração com os resultados? NÃO  

55 A minuta do contrato/ata contém cláusula com previsão de
reajuste e/ou repactuação de preços? SIM 0574599

56
A minuta do contrato/ata contém norma estabelecendo, para
a fornecedora, a obrigação de devolver valores eventualmente
recebidos em excesso?

NÃO  
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OUTROS ATOS INSTRUTÓRIOS  

57
A SLC/COMAP verificou os dispositivos legais que dispõem
sobre a margem de preferência?

Ref. Decretos nºs 7546/ 2011 e 8538/2015
SIM 0574600

58

A SLC/COMAP, em face do valor estimado do objeto, verificou
a possibilidade de a licitação ser exclusiva para
Microempresas, Empresas de Pequeno Porte e Sociedades
Cooperativas?

Ref. art. 48, I, da LC nº 123/06, art. 6º do Decreto nº
8.538/15 e art. 34 da Lei nº 11.488/07

N/A

  

59
A SLC verificou a incidência das exceções previstas no art. 10
do Decreto nº 8.538/15, devidamente justificada, a afastar a
exclusividade?

N/A  

60
Consta dos autos a análise e aprovação da minuta de edital e
seus anexos pela assessoria jurídica?

Ref. art. 38, parágrafo único, da Lei nº 8.666/93
 Em curso

61

Consta a autorização da autoridade competente para a
abertura da fase externa da licitação?

Ref. art. 38, caput, da Lei nº 8.666/93 e arts. 8º, III e 30, V,
do Decreto 5.450/05

 Próxima
fase

62
Consta a publicação do aviso de edital?

Ref. art. 4º, I e II, da Lei nº 10.520/02 e art. 17 do Decreto nº
5.450/05

 Próxima
fase

63
Consta a designação do pregoeiro e equipe de apoio?

Ref. art. 3º, IV, §§1º e 2º da Lei nº 10.520/02, arts. 9º, VI, 10,
11, 12 e 30, VI, do Decreto nº 5.450/05

 Próxima
fase

64
Em se tratando de licitação destinada à formação de atas de
registro de preço, houve divulgação, mediante publicação no
DOU, da intenção de registro de preços? Caso negativo,
existe justificativa?

NÃO 0572764

RECURSOS ORÇAMENTÁRIOS  

65

Os autos do processo contêm documento indicativo da
existência de recursos orçamentários para suportar a
despesa?

Ref. art. 30, IV, do Decreto nº 5.450/05 e arts. 7º, § 2º, III, 14
e 38, caput, da Lei nº 8.666/93.

NÃO

0567525

Parcial

(Registro de
preços)

66
Fora das hipóteses de registro de preços, os autos do
processo contêm documento com estimativa do impacto
orçamentário financeiro da despesa? Ref. art. 16, I, da Lei
Complementar nº 101/2000

N/A  

67
Os autos do processo contêm declaração do ordenador da
despesa?

Ref. art. 16, II, da Lei Complementar nº 101/2000
N/A  

 

8. CONCLUSÃO

Para que o procedimento flua com regularidade,
faz-se mister juntar-se aos autos os elementos referentes aos
itens 25 e 26 da tabela de verificação acima. 

Outrossim, após a análise da minuta apresentada,
verificamos a necessidade de algumas alterações, a saber:

a) inserir no preâmbulo a menção ao
Decreto nº 9.488/2018, que alterou o
Decreto nº 7.892/2013;
b) na minuta do edital, ponderar acerca
da necessidade de exigência de
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qualificação econômico-financeira;
c) considerando a natureza do objeto a
ser licitado, incluir a exigência da
regularidade perante a Fazenda
Municipal, além da Estadual já exigida
no item 21.1 "a" do edital;
d) considerando a natureza do objeto a
ser licitado, incluir a exigência da
regularidade perante a Fazenda Estadual,
além da Municipal já exigida nos itens
24.2 "q" do edital e 5,2 "q" da ARP; 
e) verificar a aparente contradição entre
os itens 19.1 do edital e 7.1 da ARP com
os demais itens que tratam de prazo de
entrega: 

19.1 do edital
"19.1. O objeto deverá ser entregue,
no prazo máximo de 90 (noventa)
dias corridos, contados do
recebimento da Nota de Empenho ou
Ordem de Fornecimento..." 
6 do Termo de Referência 
"O prazo máximo para o
fornecimento das licenças é de 90
(noventa) dias corridos após o
recebimento da ordem de
fornecimento...";
7.1 da ARP  
"O objeto deverá ser entregue, no
prazo máximo de 90 (noventa) dias
corridos, contados do recebimento da
Nota de Empenho ou Ordem de
Fornecimento..." 
 
Edital
"3.1. O prazo máximo para a entrega
dos equipamentos é de 60
(sessenta) dias contados a partir do
recebimento da Ordem de
Fornecimento ou documento
equivalente.
3.2. O prazo máximo para a entrega
dos softwares é 30 (trinta) dias
contados a partir do recebimento da
Ordem de Fornecimento ou
documento equivalente."
 
Termo de Referência:
"9. Prazo de entrega para
equipamentos: 60 (sessenta) dias
contados a partir da emissão da
ordem de fornecimento ou
documento equivalente;
10.Prazo de entrega para
softwares: 30 (trinta) dias contados
a partir da emissão da ordem de
fornecimento ou documento
equivalente;"
 
ARP 
"3.1. O prazo máximo para a entrega
dos equipamentos é de 60
(sessenta) dias contados a partir do
recebimento da Ordem de
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Fornecimento ou documento
equivalente.
3.2. O prazo máximo para a entrega
dos softwares é 30 (trinta) dias
contados a partir do recebimento da
Ordem de Fornecimento ou
documento equivalente."
 

À SAD, para aperfeiçoamento da instrução e à
ACAGE, tendo em vista o que consta no item 5 acima,

Documento assinado eletronicamente por CLÁUDIA MARIA TEIXEIRA MOREIRA
RAMALHO, Assessora Jurídica Substituta, em 02/08/2019, às 10:30, conforme art. 1º,
III, "b", da Lei 11.419/2006.

Documento assinado eletronicamente por MARCEL GAMELEIRA DE ALBUQUERQUE,
Assessor Jurídico, em 02/08/2019, às 10:30, conforme art. 1º, III, "b", da Lei
11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0574780 e o código CRC DA792950.

0008478-63.2018.6.02.8000 0574780v41
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 05 de agosto de 2019.
À STI.
Para observância do primeiro parágrafo da

conclusão do PARECER 1555 (0574780).
À SLC, em paralelo, para realizar as alterações

indicadas no Parecer acima citado.
Atenciosamente,

Documento assinado eletronicamente por ANDRÉA CRISTINA DE LIMA BELCHIOR,
Secretário de Administração Substituto, em 05/08/2019, às 21:34, conforme art. 1º,
III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0576607 e o código CRC AA50D553.

0008478-63.2018.6.02.8000 0576607v1
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 06 de agosto de 2019.
À SAD
 
Sr. Secretário,
 
Em atenção ao Despacho GSAD 0576607, para os

fins previstos na Resolução TRE/AL nº 15.904/2018
(Regulamento da Secretaria do TRE/AL), art. 111, VI, aprovo
as alterações promovidas nos projetos básicos e nos termos
de referência desenvolvidos no âmbito desta Secretaria,
evento 0541748.

Desta forma, smj, supri-se o apontado no primeiro
parágrafo da conclusão do PARECER 1555 (0574780).

 
Atenciosamente.

 

Documento assinado eletronicamente por DANIEL MACÊDO DE CARVALHO SOUTO,
Secretário de Tecnologia da Informação Substituto, em 06/08/2019, às 14:23,
conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0577195 e o código CRC AACEDCDE.

0008478-63.2018.6.02.8000 0577195v1
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS 

SEÇÃO DE LICITAÇÕES E CONTRATOS 

 

1 
 

 

 

PPRREEGGÃÃOO  EELLEETTRRÔÔNNIICCOO  NNºº  XXXX//22001199  
  

MMIINNUUTTAA  

 
PROCESSO Nº 0008478-63.2018.6.02.8000 
Tipo de Licitação: MENOR PREÇO POR LOTE   
Data: XX de XXXX de 2019 
HORÁRIO DE BRASÍLIA/DF 
Horário de Abertura: XX horas 
Local: www.comprasnet.gov.br 

 

 O Tribunal Regional Eleitoral de Alagoas – TRE/AL, por intermédio da Seção de Licitações e 
Contratos, torna público, para quem interessar possa, que realizará licitação na modalidade 
PREGÃO ELETRÔNICO, do tipo MENOR PREÇO POR LOTE, conforme descrito neste Edital e seus 
Anexos, objetivando o Registro de Preços de  componentes de rede (Networking), tudo de acordo 
com requisição promovida pela Secretaria de Tecnologia da Informação. 
 

 O certame será regido conjuntamente pela Lei nº 10.520, de 17/07/2002, pelo Decreto nº 
5.450, de 31/05/2005, pelo Decreto nº 8.538, de 06/10/2015 e subsidiariamente pela Lei nº 8.666, 
de 21/06/1993 e com suas posteriores alterações e demais normas pertinentes. Aplica-se ao 
presente torneio licitatório, ainda, a Lei Complementar nº 123, de 14/12/2006, o Decreto nº 
7.174/2010, o Decreto nº 7.892/2013 atualizado pelo Decreto nº 9.488/2018,  o Decreto nº 
8.184/2014, a Portaria nº 212, de 18/06/2001, da Presidência deste Tribunal, publicada na seção 1 
do DOU, edição de 19/06/2001, por meio da qual se adota o SICAF – Sistema de Cadastramento 
Unificado de Fornecedores - nas licitações realizadas no âmbito da Secretaria deste Tribunal, bem 
como, no que couber pela Lei nº 8.078, de 11/09/1990 e demais exigências deste Edital e seus 
anexos. 
 
1 - DO OBJETO. 
 

1.1. O presente Pregão tem por objeto o Registro de Preços de componentes de rede 
(Networking), conforme especificações descritas nos Anexos I e I-A deste edital. 

 
2 – DAS CONDIÇÕES GERAIS. 
 
2.1. O prazo de vigência da Ata de Registro de Preços decorrente deste procedimento 
licitatório é de 12 (doze) meses, contado da publicação do referido ato. 
 
2.2. 2.2. A Ata de Registro de Preços não obriga à contratação de toda quantidade 
estimada no Registro, que poderá ocorrer de acordo com as necessidades do TRE/AL. 
 
2.3. A existência de preços registrados não obriga o Tribunal Regional Eleitoral a contratar, 
facultando-se a realização de licitação específica para a aquisição pretendida, assegurada 
preferência ao fornecedor registrado em igualdade de condições. 
 

2.3.1. O direito de preferência de que trata este item poderá ser exercido pelo beneficiário 
do registro quando o Tribunal Regional Eleitoral de Alagoas, após realizada a licitação 
específica, constatar que o preço obtido é igual ou maior que o registrado ou, após 
negociação, aquiescer o detentor da ata em baixar o preço registrado, igualando ou tornando-
o menor que o obtido em referida licitação. 
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS 

SEÇÃO DE LICITAÇÕES E CONTRATOS 

 

2 
 

 

 

 
3 - DOS PRAZOS DE ENTREGA E DA GARANTIA.  
 

3.1. O prazo máximo para a entrega dos equipamentos é de 60 (sessenta) dias contados a 
partir do recebimento da Ordem de Fornecimento ou documento equivalente. 

 

3.2. O prazo máximo para a entrega dos softwares é 30 (trinta) dias contados a partir do 
recebimento da Ordem de Fornecimento ou documento equivalente. 

 

3.3. Os serviços de instalação, integração, garantia e suporte dos equipamentos e softwares, 
deverão ser realizados diretamente pelo fabricante de acordo com as exigências contidas no 
descritivo dos mesmos, estando essas aderentes aos respectivos níveis de serviço necessários a 
cada um deles. 

 
3.4. Quanto aos itens 1, 2, 3, 4, 20, 22, 23 e 25,   a garantia e o suporte do fabricante para a 
solução de software deverá ser ofertado pelo período mínimo de 36 (trinta e seis) meses, incluindo 
a evolução para novas versões devendo o atendimento ser na modalidade 24x7 (vinte quatro horas 
por dia, sete dias da semana), com tempo de resposta máximo em 4 (quatro) horas. 
 

3.4.2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3.4.3.  O fabricante deve possuir canais de comunicação e ferramentas adicionais para 
suporte técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda 
de área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução. 

3.4.4.  A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

3.4.5. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante dos 
softwares, indicando o período de garantia dos produtos ofertados. Em caso de documentação 
expressa do fabricante deverá ser anexada a mesma a procuração que comprove que a 
fabricante outorga ao procurador os poderes para firmar e declarar as exigências solicitadas. 

3.5. Quanto aos itens 5, 8, 9, 10, 11, 24, 26 e 27, o equipamento ofertado deverá possuir 
garantia do fabricante na modalidade on-site pelo período mínimo de 60 (sessenta) meses para 
reposição de peças, mão de obra e atendimento. O prazo máximo para atendimento do chamado 
deve ser de até o próximo dia útil após a sua abertura. Durante o período da garantia o prazo 
máximo para o reparo de equipamentos defeituosos a condição normal de funcionamento deverá 
ser de até 07 (sete) dias úteis. 
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3.5.1. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3.5.2. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de área 
para cadastro da solução de hardware ofertada, possibilitando assim que a CONTRATANTE 
possa receber de forma proativa, durante todo período da garantia as notificações de 
atualizações e correções (“hotfix”) da solução; 

3.5.3. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 
para suporte técnico e abertura de chamados técnicos. 

3.5.4. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica local 
no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por meio de 
documentação oficial do fabricante dos produtos e de domínio público, através de catálogos, 
folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso não seja 
comprovada por um dos meios citados anteriormente, será possível a comprovação através da 
apresentação de documentação expressa do fabricante dos equipamentos, indicando a referida 
assistência técnica que será responsável pelo atendimento e manutenção durante o período de 
garantia dos produtos ofertados. Em caso de documentação expressa do fabricante a esta 
deverá ser anexada uma procuração que comprove que a fabricante outorga ao procurador os 
poderes para firmar e declarar as exigências solicitadas. 

3.5.5. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da garantia 
ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

3.6.   Quanto aos itens 6, 7, 12, 13, 14, 15, 28 e  29, O equipamento ofertado deverá possuir 
garantia do fabricante do equipamento na modalidade on-site pelo período mínimo de 12 (doze) 
meses para reposição de peças, mão de obra e atendimento no local. O período da garantia o prazo 
máximo para o reparo de equipamentos defeituosos a condição normal de funcionamento deverá 
ser de até 07 (sete) dias úteis. 

3.6.1. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento. 

3.6.2. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da garantia 
ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 
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4 - DA PARTICIPAÇÃO. 
 
4.1.   Poderão participar deste pregão os interessados do ramo pertinente ao objeto licitado, 
obrigatoriamente, previamente cadastradas no Sistema de Cadastro Unificado de Fornecedores – 
SICAF, habilitação parcial, que atendam à linha de fornecimento e a todas as demais exigências 
deste Edital e seus anexos. 
 
4.2. Para participação neste Pregão, o licitante deverá manifestar, em campo próprio do 
sistema eletrônico, que cumpre plenamente os requisitos de habilitação e que sua proposta está em 
conformidade com as exigências do instrumento convocatório. 
 

4.2.1. A declaração falsa relativa ao cumprimento dos requisitos de habilitação e proposta 
sujeitará o licitante às sanções previstas neste Edital. 

 
4.3. No ato de envio de suas propostas, as Microempresas ou Empresas de Pequeno Porte 
deverão declarar, em campo próprio do Sistema do Pregão Eletrônico, que atendem aos requisitos 
do art. 3º da Lei Complementar nº 123/2006 para fazer jus aos benefícios previstos no referido 
diploma legal. 
 
4.4. Não será admitida nesta licitação a participação de empresas: 
 

4.4.1. em processo de recuperação judicial ou em processo de falência, sob concurso de 
credores, em dissolução ou em liquidação; 
 
4.4.2. que estejam suspensas de participar de licitação realizada pelo Tribunal Regional 
Eleitoral de Alagoas e empresas que tenham sido declaradas inidôneas para licitar ou 
contratar com a Administração Pública, enquanto perdurarem os motivos da punição; 
 
4.4.3. que estejam reunidas em consórcio e sejam controladoras, coligadas ou subsidiárias 
entre si, qualquer que seja sua forma de constituição; 
 
4.4.4. estrangeiras que não funcionem no País; 
 
4.4.5.  que tenham em seu quadro societário cônjuge, companheiro ou parente em linha reta, 
colateral ou por afinidade até o terceiro grau, inclusive, dos magistrados ocupantes de cargos 
de direção ou no exercício de funções administrativas, assim como de servidores ocupantes de 
cargos de direção, chefia e assessoramento vinculados direta ou indiretamente às unidades 
situadas na linha hierárquica da área encarregada da licitação, de acordo com o disposto no 
art. 2º da Resolução nº 07/2005 do Conselho Nacional de Justiça (com a nova redação dada 
pelo art. 1º da Resolução 229/2016-CNJ). 

 
5 - DA REPRESENTAÇÃO E DO CREDENCIAMENTO. 
 
5.1. Os licitantes ou seus representantes legais deverão estar previamente credenciados no 
site www.comprasnet.gov.br (Art. 3º do Decreto nº 5.450/05). 
 
5.2. O credenciamento do licitante, bem assim a sua manutenção, no site acima informado, 
dependerá de registro atualizado no Sistema de Cadastramento Unificado de Fornecedores – SICAF - 
Habilitação Parcial, que também será requisito obrigatório para fins de habilitação. 
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5.3. O credenciamento do licitante dar-se-á pela utilização de login e senha, para acesso ao 
sistema eletrônico no site www.comprasnet.gov.br, opção pregão eletrônico, criados quando do 
credenciamento supracitado. 
 
5.4. O credenciamento junto ao provedor do sistema implica a responsabilidade legal do 
licitante e a presunção de sua capacidade técnica para realização das transações inerentes ao 
pregão na forma eletrônica (Art. 3º, § 6º, do Decreto nº 5.450/05). 
 
5.5. O uso da senha de acesso pelo licitante é de sua responsabilidade exclusiva, incluindo 
qualquer transação efetuada diretamente ou por seu representante, não cabendo ao provedor do 
sistema ou ao TRE/AL, promotor da licitação, responsabilidade por eventuais danos decorrentes de 
uso indevido da senha, ainda que por terceiros (Art. 3º, § 5º, do Decreto nº 5.450/05). 
 
6 - DO ENVIO DA PROPOSTA DE PREÇOS. 
 

6.1. O licitante será responsável por todas as transações que forem efetuadas em seu nome 
no sistema eletrônico, assumindo como firmes e verdadeiras suas propostas, assim como os lances 
inseridos durante a sessão pública. (inciso III, do art. 13, do Decreto nº 5.450/2005). 
 

6.2. Incumbirá ao licitante acompanhar as operações no sistema eletrônico durante o 
processo licitatório, responsabilizando-se pelo ônus decorrente da perda de negócios diante da 
inobservância de quaisquer mensagens emitidas pelo sistema ou de sua desconexão (inciso IV, do 
art. 13, do Decreto 5.450/2005). 
 

6.3. A participação no pregão dar-se-á por meio da digitação de login e senha privativas do 
licitante e subsequente encaminhamento da proposta com a descrição do serviço ofertado, em 
campo próprio, que poderá ser feito a partir da data da disponibilização do Edital no site do 
www.comprasnet.gov.br e até a data e hora marcadas para abertura deste pregão, exclusivamente 
por meio do sistema eletrônico. 
 

6.3.1. Até a abertura da sessão, os licitantes poderão retirar ou substituir a proposta 
anteriormente apresentada (§ 4º do art. 21 do Decreto nº 5.450/2005). 

 

6.4.  Os licitantes deverão apresentar suas propostas de preços, utilizando do campo 
"descrição detalhada do objeto", contendo o seguinte: 
 

a) prazo de validade, a contar da data da abertura da sessão pública, observado o 
disposto no item 6.7 do edital; 
b) descrição de cada item que compõe o lote ofertado, de acordo com o Anexo I-A deste 
edital. 

 

6.4.1. Caso o campo seja preenchido com especificações diversas daquelas 
constantes no edital, deverá haver o cuidado, por parte do licitante, para que a descrição 
complementar não contrarie as especificações constantes no edital, sob pena de 
desclassificação. 
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6.4.2. Serão irrelevantes quaisquer ofertas que não se enquadrem nas especificações 
exigidas, ou anexos não solicitados, considerando-se que pelo preço proposto o licitante 
obrigar-se-á ao fornecimento descrito neste edital. 

 
6.4.2.1.  Entretanto, se da proposta constar condições materiais mais vantajosas 
que as exigidas neste edital elas não serão consideradas para efeito de 
escalonamento de ofertas, mas vincularão o proponente na execução contratual. 

 
6.4.3. Não podem constar da “descrição detalhada do objeto” qualquer tipo de 
identificação da empresa, seja nome, endereço, CNPJ, logotipo, ou qualquer outro dado 
capaz de identificar o licitante. Esta identificação somente constará na proposta ajustada 
encaminhada nos termos do item 10.1. 

 
6.4.4. Em campo próprio deverão ser inseridos marca e modelo do produto ofertado. 

 

6.5. As declarações referidas no subitem 11.1 “c” deverão ser enviadas em campo próprio do 
sistema Comprasnet, no momento da elaboração e envio da proposta pelos fornecedores, as quais 
serão visualizadas pelo Pregoeiro na fase de Habilitação, quando também poderá ser solicitado, via 
chat, pelo Pregoeiro, a alteração ou reenvio das mesmas pelo(s) vencedor(es). 
 

6.6. Nos preços ofertados deverão estar inclusas todas as despesas necessárias à perfeita 
execução das prestações contratuais, tais como tributos, encargos legais, embalagens, frete etc. 
 

6.7. O prazo de validade das propostas será de, no mínimo, 60 (sessenta) dias, contados da 
data de abertura da sessão pública. As propostas que o omitirem ou indicarem prazo de validade 
inferior ao mínimo permitido serão entendidas como válidas pelo período de 60 (sessenta) dias. 
 

6.8. Em caso de divergências verificadas entre as descrições relativas aos objetos desta 
licitação (Anexo I-A) e as descrições constantes no Catálogo de Materiais do “SIASG”, prevalecerão, 
sempre, as descrições constantes neste edital. 
 

6.9. Não serão aceitas propostas alternativas nem submetidas a termo, condição ou encargo. 
 

6.10. Todos os custos decorrentes da elaboração e apresentação de propostas serão de 
responsabilidade exclusiva do licitante, incluindo as transações que forem efetuadas em seu nome no 
sistema eletrônico ou de eventual desconexão. O Tribunal Regional Eleitoral de Alagoas não será 
responsável, em nenhum caso, pelos custos de tais procedimentos. 
 

6.11. O simples envio da proposta será interpretado como concordância com os termos deste 
edital, com o estipulado na Lei nº 10.520, de 17 de julho de 2002, no Decreto nº 5.450, de 31 de 
maio de 2005, e subsidiariamente pela Lei nº 8.666, de 21 de junho de 1993 e suas alterações 
posteriores, salvo se a proposta contiver disposição que contrarie expressamente quaisquer dos 
itens deste edital. 
 
7 - DA SESSÃO PÚBLICA E DIVULGAÇÃO DAS PROPOSTAS. 
 

7.1. O pregoeiro iniciará a sessão pública na data e horário previstos neste edital, via sistema 
eletrônico, com a divulgação das propostas de preços recebidas, as quais deverão estar em perfeita 
consonância com as especificações detalhadas no presente edital. 
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7.2.  As propostas que não atenderem aos requisitos constantes no presente edital ou que 
apresentarem preços manifestamente inexequíveis serão previamente desclassificadas pelo 
pregoeiro. 
 

7.2.1. A desclassificação de proposta será sempre fundamentada e registrada no 
sistema, com acompanhamento em tempo real por todos os licitantes. 

 

7.3.  O sistema ordenará, automaticamente, as propostas classificadas, sendo que somente 
estas participarão da fase de lances. 
 
8 - DA FORMULAÇÃO DOS LANCES. 
 

8.1.  Após a classificação das propostas, o pregoeiro dará início à etapa competitiva, 
oportunidade em que os licitantes poderão encaminhar lances, exclusivamente por meio do sistema 
eletrônico, sendo estes imediatamente informados do seu recebimento e respectivo horário de 
registro e valor. 
 

8.1.1. Os lances deverão ser ofertados pelo valor unitário de cada item que compõe o lote 
ofertado, sendo que o sistema efetuará automaticamente o somatório para efeito de 
escalonamento dos lances. 

 

8.2. Os licitantes poderão oferecer lances sucessivos, observado o horário fixado e as regras 
de aceitação dos mesmos. 
 

8.3. O licitante somente poderá oferecer lance inferior ao último por ele ofertado e registrado 
pelo sistema. 
 

8.4.  Havendo mais de um lance de igual valor, prevalecerá aquele que for recebido e 
registrado primeiro pelo sistema. 
 

8.5. Durante a sessão pública, os licitantes serão informados, em tempo real, do valor do 
menor lance registrado, vedada a identificação do licitante.  
 

8.6.  No caso de desconexão do pregoeiro, no decorrer da etapa competitiva do pregão 
eletrônico, o sistema eletrônico poderá permanecer acessível aos licitantes para a recepção dos 
lances, retomando o pregoeiro, quando possível, a sua atuação no certame, sem prejuízo dos atos 
realizados. 
 

8.6.1.  Quando a desconexão do pregoeiro persistir por tempo superior a 10 (dez) minutos, a 
sessão do pregão eletrônico será suspensa e terá reinício somente após comunicação aos 
licitantes participantes, no endereço utilizado para divulgação desta licitação. 

 

8.7.   A etapa de lances será encerrada por decisão do pregoeiro, mediante 
encaminhamento, pelo sistema eletrônico, de aviso de fechamento iminente dos lances. Após o que 
transcorrerá período de tempo de até 30 (trinta) minutos, aleatoriamente determinado pelo sistema 
eletrônico, findo o qual será encerrada, automaticamente, a recepção de lances. 

 

Minuta de edita (0578992)         SEI 0008478-63.2018.6.02.8000 / pg. 483



 
TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS 

SEÇÃO DE LICITAÇÕES E CONTRATOS 

 

8 
 

 

 

8.8.  Após o encerramento da etapa de lances da sessão pública, o pregoeiro poderá 
encaminhar, pelo sistema eletrônico, contraproposta ao licitante que tenha apresentado lance mais 
vantajoso, para que seja obtida melhor proposta, observado o critério de julgamento, não se 
admitindo negociar condições diferentes daquelas previstas neste Edital. 
 
9 - DO JULGAMENTO DAS PROPOSTAS DE PREÇOS. 
 

9.1.  O pregoeiro efetuará o julgamento das Propostas de Preços pelo critério do menor 
preço por lote, decidindo sobre a aceitação do preço obtido. 
 
9.2.  Como critério de aceitabilidade dos preços, serão admitidos como limites máximos os 
valores estimados pela Administração, ou seja, os preços de referência, disponíveis no Anexo I-A 
deste edital, que representam uma média das várias propostas coletadas no mercado e, de modo 
algum, vinculam a decisão do Pregoeiro, que está autorizado a negociar em busca de preços 
inferiores. 

 
9.2.1. O critério de aceitabilidade será aferido em relação ao valor de cada item e em relação 
ao valor total do lote ofertado. 
 

9.3.  Será considerado vencedor deste pregão o licitante que oferecer o menor preço e tiver 
atendido a todas as exigências editalícias. 
 

9.4.  Analisada a aceitabilidade do preço obtido, o pregoeiro divulgará o resultado de 
julgamento das Propostas de Preços. 

 

9.5.  Se a proposta ou o lance, de menor preço, não for aceitável, ou se o licitante 
desatender às exigências habilitatórias, o pregoeiro examinará a proposta ou o lance subsequente, 
verificando a sua aceitabilidade e procedendo à sua habilitação, na ordem de classificação, e assim 
sucessivamente, até a apuração de uma proposta ou lance que atenda ao edital. 
 

9.5.1.  Ocorrendo a situação a que se refere este item, o pregoeiro poderá negociar 
com o licitante para que seja obtido preço melhor. 

 
10 – DO ENCAMINHAMENTO DA PROPOSTA E DA DOCUMENTAÇÃO. 
 

10.1.  A proposta ajustada ao lance final do licitante vencedor e os documentos exigidos para 
habilitação que não estejam contemplados no SICAF, caso necessário, deverão ser remetidos, como 
anexo, pelo sistema Comprasnet, quando solicitado pelo Pregoeiro. Junto com a documentação 
deverá ser encaminhado, também pelo sistema, os dados do licitante vencedor: Razão Social, 
endereço, telefone/fax, número do CNPJ/MF, banco, agência, número da conta corrente e praça de 
pagamento, podendo ser utilizado para tanto o modelo de planilha para contratação sugerido no 
ANEXO II. 

 

10.2. A licitante também deverá encaminhar, quando solicitado pelo pregoeiro, via sistema, a 
Planilha de Composição de Custos por Item, no modelo do Anexo I-B. 

 
11 - DA HABILITAÇÃO. 
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11 .1. A habilitação do licitante vencedor será verificada mediante a apresentação/obtenção da 
seguinte documentação: 
 

a) Quanto à Qualificação Jurídica e Fiscal: Situação do licitante perante o Sistema de 
Cadastro Unificado de Fornecedores – SICAF – Habilitação Parcial, após a análise e 
julgamento das Propostas de Preços, a ser obtida por meio de extrato “on line” do site do 
Comprasnet. 
 

a1.) Caso conste no cadastro do SICAF algum documento habilitatório com data de 
validade expirada, o pregoeiro poderá consultar o documento do licitante nos sítios 
das entidades responsáveis pelo referido tributo ou abrirá o prazo de 02 (dois) dias 
úteis para que o licitante o encaminhe, via protocolo. 

 
b) Quanto à regularidade trabalhista, esta deverá ser comprovada através de Certidão 
Negativa de Débitos expedida pela Justiça do Trabalho, em conformidade com a Lei 
Federal nº 12.440, de 07 de julho de 2011. 
 
c) Declarações que deverão ser efetuadas em campo específico do sistema Comprasnet, 
no momento da elaboração e envio da proposta, conforme item 6.5. do edital: 
 

c.1) Declaração de inexistência de fatos supervenientes impeditivos à habilitação da 
empresa; 
c.2)  Declaração de que a empresa não emprega menor de dezoito anos em trabalho 
noturno, perigoso ou insalubre, não emprega menor de dezesseis anos, salvo na 
condição de aprendiz, a partir dos quatorze anos; 
c.3)   Declaração de elaboração Independente de Proposta. 

 
11.2. No momento em que forem verificados os documentos relativos à habilitação, o 
pregoeiro deverá verificar, também, a existência de registros impeditivos da contratação no 
Cadastro Nacional de Empresas Inidôneas e Suspensas da Controladoria Geral da União, disponível 
no Portal da Transparência (http://www.portaltransparencia.gov.br). 
 
11.3.  Havendo o registro de Ocorrências Impeditivas Indiretas de licitar, constatado em 
consulta ao SICAF, a empresa será convocada a apresentar, em 48 (quarenta e oito) horas, a contar 
da solicitação do pregoeiro no “chat”, esclarecimentos/documentos, comprovando sua idoneidade. 

 
11.3.1. Havendo necessidade de analisar minuciosamente os documentos exigidos, o 
Pregoeiro suspenderá a sessão, informando no “chat” a nova data e horário para a 
continuidade da mesma. 
 

11.4.  A comprovação da regularidade fiscal das licitantes, obrigatoriamente, Microempresas e 
Empresas de Pequeno Porte, será exigida para efeito de contratação, conforme estipula o art. 42 da 
LC nº 123/2006, observando o que dispõe o art. 4º, do Decreto nº 8.538/2015. 
 

11.4.1.         Na hipótese de haver alguma restrição relativa à regularidade fiscal quando da 
comprovação de que trata o item 11.4., será assegurado prazo de cinco dias úteis, prorrogável 
por igual período, para a regularização da documentação, a realização do pagamento ou 
parcelamento do débito e a emissão de eventuais certidões negativas ou positivas com efeito 
de certidão negativa. 
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11.4.2.   Para aplicação do disposto no subitem 11.4.1, o prazo para regularização fiscal será 
contado a partir da divulgação do resultado da fase de habilitação. 
 
11.4.3. A prorrogação do prazo previsto no subitem 11.4.1., poderá ser concedida, a 
critério da administração pública, quando requerida pelo licitante, mediante apresentação de 
justificativa. 
 
11.4.4. A abertura da fase recursal em relação ao resultado do certame ocorrerá após  os 
prazos de regularização fiscal de que tratam os subitens 11.4.1. e 11.4.3. 
 
11.4.5.           A não regularização da documentação no prazo previsto nos subitens 11.4.1. e 
11.4.3. implicará decadência do direito à contratação, sem prejuízo das sanções previstas no 
art. 87 da Lei nº 8.666, de 1993, sendo facultado à administração pública convocar os 
licitantes remanescentes, na ordem de classificação, ou revogar a licitação. 

 
11.5. Os licitantes que deixarem de apresentar quaisquer dos documentos exigidos para a 
habilitação na presente licitação, ou os apresentarem em desacordo com o estabelecido neste 
Edital ou com irregularidades, ressalvado o disposto na alínea a.1 do item 11.1. e no item 11.4.1, 
serão inabilitados, não se admitindo complementação posterior. 
 
11.6. Não serão aceitos protocolos de entrega ou solicitação de documento em substituição 
aos documentos requeridos no presente Edital. 
 
11.7. Os documentos relacionados neste Edital referir-se-ão sempre ao domicílio da empresa 
licitante cadastrada no SICAF. 
 
11.8. Para fins de habilitação, a verificação pelo TRE/AL nos sítios oficiais de órgãos e 
entidades emissores de certidões constitui meio legal de prova. 
 
12 – DO CRITÉRIO DE DESEMPATE. 
 
12.1. Será assegurado, como critério de desempate, preferência de contratação a 
Microempresas e Empresas de Pequeno Porte, conforme disposto no art. 44 da Lei Complementar nº 
123/2006. 
 

12.1.1. Entende-se por empate aquelas situações em que as propostas apresentadas pelas 
Microempresas e Empresas de Pequeno Porte sejam iguais ou até 5% (cinco por cento) 
superiores à proposta mais bem classificada. 
 
12.1.2. O subitem anterior somente será aplicado quando a melhor oferta inicial não tiver sido 
apresentada por microempresa ou empresa de pequeno porte. 
 
12.1.3. Para identificação da situação de empate, o Sistema de Pregão Eletrônico, após 
encerramento da fase de lances identificará, em coluna própria as Microempresas e Empresas 
de Pequeno Porte participantes, fazendo a comparação entre os valores da primeira colocada, 
caso esta não seja uma Microempresa ou Empresa de Pequeno Porte, e das demais 
Microempresas e Empresas de Pequeno Porte, na ordem de classificação. 

 
12.2. Após o encerramento de todos os itens, para cada item que teve uma empresa de médio 
ou grande porte como vencedora do melhor lance, o sistema selecionará todas as Microempresas e 
Empresas de Pequeno Porte cujo último lance enviado, para o item, seja até 5% (cinco por cento) 
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superior à oferta vencedora. Após este procedimento, o sistema enviará mensagem, via chat, 
informando quais os itens terão desempate no lance. 
 
12.3. Para efeito do disposto no item 12.1, ocorrendo o empate, proceder-se-á da seguinte 
forma: 
 

I – A Microempresa ou Empresa de Pequeno Porte mais bem classificada poderá apresentar 
proposta de preço inferior àquela considerada vencedora do certame, situação em que lhe 
será adjudicado o objeto licitado. Para viabilizar tal procedimento, o Sistema selecionará os 
itens com tais características, disponibilizando-os automaticamente nas telas do pregoeiro e 
fornecedor, encaminhado mensagem também automática, por meio do chat, convocando a 
Microempresa ou Empresa de Pequeno Porte que se encontra em segundo lugar, a fazer sua 
última oferta no prazo de 5 (cinco) minutos, sob pena de decair do direito concedido; 
 
II – Caso a Microempresa ou Empresa de Pequeno Porte classificada em segundo lugar desista 
ou não se manifeste no prazo estabelecido, o Sistema convocará as demais Microempresas ou 
Empresas de Pequeno Porte participantes na mesma condição, na ordem de classificação; 
 
III – Havendo êxito neste procedimento, o Sistema disponibilizará a nova classificação dos 
fornecedores para fins de aceitação. Não havendo êxito, ou não existindo Microempresa ou 
Empresa de Pequeno Porte participante, prevalecerá a classificação inicial; 
 
IV – Caso sejam identificadas propostas de Microempresas ou Empresas de Pequeno Porte 
empatadas em segundo lugar, ou seja, na faixa dos 5% (cinco por cento) da primeira colocada, 
e permanecendo o empate até o encerramento do item, o sistema fará um sorteio eletrônico 
entre tais fornecedores, definindo e convocando automaticamente a vencedora para o 
encaminhamento da oferta final do desempate; 
 
V – A negociação de preço junto ao fornecedor classificado em primeiro lugar, quando houver, 
será sempre após o procedimento de desempate de proposta e classificação final dos 
fornecedores participantes. 

 
12.4. Para todos os cálculos efetuados, serão levadas em consideração duas casas decimais, 
sendo desprezadas as demais.  
 
12.5. Se durante o desempate houver suspensão do pregão ou do item, o tempo será 
interrompido. Quando o pregão ou item for reaberto, o tempo será retomado de onde parou. 
 
13 – DO CRITÉRIO DE PREFERÊNCIA. 

13.1.  Este pregão submete-se às regras relativas ao direito de preferência estabelecidas no 
Decreto nº 7.174/2010. 
 
 
14 - DA IMPUGNAÇÃO E PEDIDOS DE ESCLARECIMENTOS. 
 
14.1. Até 02 (dois) dias úteis antes da data fixada para abertura da sessão pública, qualquer 
pessoa poderá impugnar o ato convocatório do presente pregão, enviando a peça impugnatória ao 
endereço eletrônico slc@tre-al.jus.br. 
 

Minuta de edita (0578992)         SEI 0008478-63.2018.6.02.8000 / pg. 487

mailto:slc@tre-al.jus.br


 
TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS 

SEÇÃO DE LICITAÇÕES E CONTRATOS 

 

12 
 

 

 

14.1.1. Caberá ao Pregoeiro, auxiliado pela seção responsável pela elaboração do edital, 
decidir sobre a impugnação no prazo de até 24h (vinte e quatro horas). 

 

14.1.2.  Acolhida a impugnação contra o ato convocatório, será definida e publicada nova data 
para realização do certame. 

 

14.2. Os pedidos de esclarecimentos referentes a este Edital deverão ser enviados à Seção de 
Licitações e Contratos, até três dias úteis anteriores à data fixada para a abertura da sessão 
pública, exclusivamente por meio eletrônico via Internet, para o endereço de e-mail: slc@tre-
al.jus.br, cujas respostas serão disponibilizadas nos avisos referentes a este Pregão, no site do 
TRE/AL: www.tre-al.jus.br e no site www.comprasnet.gov.br. 
 
15- DOS RECURSOS. 
 
15.1.  Existindo intenção de interpor recurso, o licitante deverá manifestá-la ao pregoeiro, 
exclusivamente por meio eletrônico, em formulário próprio, explicitando sucintamente suas razões, 
logo após a fase de habilitação. 
 
15.2.  O Pregoeiro informará, via chat, o tempo para a recepção, pelo sistema eletrônico, da 
intenção de recurso, abrindo em seguida este prazo e fechando ao término do tempo informado. 
 
15.3.  Caso tenha havido registro de intenção de manifestação de recurso, o Pregoeiro decidirá 
sobre sua admissibilidade. Sendo admissível a manifestação de recurso registrada, o sistema abrirá 
formulário próprio para o registro das razões do recurso, no prazo de 3 (três) dias, as quais poderão 
ser impugnadas pelos demais licitantes, desde logo intimados para, querendo, apresentar 
contrarrazões em igual prazo, exclusivamente por meio eletrônico, e após julgadas pelo Pregoeiro, 
submeterá a sua decisão à autoridade competente. 

 
15.4.  O acolhimento do recurso implica tão somente na invalidação daqueles atos que não 
sejam passíveis de aproveitamento. 
 
15.5.  A falta de manifestação eletrônica de intenção de recorrer, no prazo estipulado pelo 
Pregoeiro, importará a decadência do direito de recurso e a adjudicação do objeto pelo pregoeiro ao 
vencedor. 
 
16 - DA ADJUDICAÇÃO E HOMOLOGAÇÃO. 
 
16.1.  A adjudicação do objeto do presente certame será viabilizada pelo pregoeiro sempre que 
não houver recurso. 
 
16.2.  A homologação da licitação é de responsabilidade da autoridade competente e só poderá 
ser realizada depois da adjudicação do objeto ao proponente vencedor pelo pregoeiro, ou, quando 
houver recurso, pela própria autoridade competente. 
 
16.3.  Antes da adjudicação pelo pregoeiro, será feita consulta ao CADIN – Cadastro Informativo 
de Créditos não Quitados do Setor Público Federal, nos termos do Inciso III do Art. 6º da Lei nº 
10.522, de 19/07/2002. 
 
17 - DO REAJUSTE DO PREÇO. 
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17.1.  Os preços ofertados serão fixos e irreajustáveis. No entanto, os valores constantes da Ata 
de Registro de Preços admitem revisão na forma disciplinada no Decreto nº 7.892/2013. 
 
18 - DA HOMOLOGAÇÃO, DA ATA DE REGISTRO DE PREÇOS E DA CONTRATAÇÃO. 
 
18.1. A adjudicação do objeto do presente certame será viabilizada pelo pregoeiro sempre que 
não houver recurso. 
 

18.1.1. Antes da adjudicação pelo pregoeiro, será feita consulta ao CADIN – Cadastro 
Informativo de Créditos não Quitados do Setor Público Federal, nos termos do Inciso III do Art. 
6º da Lei 10.522, de 19/07/2002. 

 
18.2. A homologação da licitação é de responsabilidade da autoridade competente e só poderá 
ser realizada depois da adjudicação do objeto ao proponente vencedor pelo pregoeiro, ou, quando 
houver recurso, pela própria autoridade competente. 
 
18.3. Homologado o resultado da licitação, os fornecedores classificados, observado o disposto 
no art. 11 do Decreto nº 7.892/2013, serão convocados para assinar a ata de registro de preços, 
dentro do prazo e condições estabelecidos no subitem 18.3.1., podendo ser prorrogado uma vez, 
por igual período, quando solicitado pelo fornecedor e desde que ocorra motivo justificado aceito 
pela administração. 
 

18.3.1. O cadastro de reserva dos fornecedores classificados a que se refere o item anterior 
será elaborado desde que viabilizado pelo sistema Comprasnet, tal como previsto no art. 26 do 
decreto acima citado. 
 
18.3.2. O licitante vencedor deverá devolver a Ata de Registro de Preços assinada dentro do 
prazo de 05 (cinco) dias úteis, a contar do recebimento da convocação para assinatura do 
documento, em conformidade com o previsto no art. 64 da Lei n. 8.666/1993. 

 
18.4. É facultado à administração, quando o convocado não assinar a ata de registro de preços 
no prazo e condições estabelecidos, convocar os licitantes remanescentes, na ordem de 
classificação, para fazê-lo em igual prazo e nas mesmas condições propostas pelo primeiro 
classificado. 
 
18.5. A ata de registro de preços implicará compromisso de fornecimento nas condições 
estabelecidas, após cumpridos os requisitos de publicidade. 
 
18.6. A recusa injustificada de fornecedor classificado em assinar a ata, dentro do prazo 
estabelecido no subitem 18.3.2, ensejará a aplicação das penalidades aludidas no item 18.12 deste 
edital, bem como às do art. 28 do Decreto n. 5.450/2005. 
 
18.7. A contratação com os fornecedores registrados será formalizada pelo órgão interessado 
por intermédio de instrumento contratual, emissão de nota de empenho de despesa, autorização de 
compra ou outro instrumento hábil, conforme o art. 62 da Lei nº 8.666, de 1993. 
 
18.8. Após a devolução da Ata de Registro de Preços assinada, a licitante poderá receber a 
Nota de Empenho e a Autorização de Fornecimento, devendo confirmar o seu recebimento. 
 
18.9. A recusa na aceitação da nota de empenho e da Autorização de Fornecimento deverá ser 
expressa, escrita e justificada, o que será encaminhado para a autoridade competente que 
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procederá à análise dos motivos acostados pelo licitante, decidindo acerca da aceitabilidade ou não 
da justificativa. 
 
18.10. Caso a justificativa não seja encaminhada na forma descrita ou esta não seja aceita pela 
autoridade competente, o prazo para a entrega continuará fluindo normalmente, e em não sendo 
cumprido, sujeitará o licitante às penalidades cabíveis. 
 
18.11. Os contratos decorrentes do Sistema de Registro de Preços poderão ser alterados, 
observado o disposto no art. 65 da Lei nº 8.666, de 1993 e no art. 12, § 3º do Decreto nº 
7.892/2013. 
 
18.12. O registro do fornecedor será cancelado quando: 
 
a) descumprir as condições da Ata de Registro de Preços; 
 
b) não retirar a nota de empenho ou instrumento equivalente no prazo estabelecido pela 
Administração, sem justificativa aceitável; 
 
c) não aceitar reduzir o seu preço registrado, na hipótese deste se tornar superior àqueles 
praticados no mercado; ou 
 
d) sofrer sanção prevista nos incisos III ou IV do caput do art. 87 da Lei nº 8.666, de 1993, ou no art. 
7º da Lei nº 10.520, de 2002. 
 

18.12.1. O cancelamento de registros nas hipóteses previstas nas alíneas “a”, “b” e “d” 
do subitem 18.12. será formalizado por despacho do órgão gerenciador, assegurado o 
contraditório e a ampla defesa. 

 
18.12.2. O cancelamento do registro de preços poderá ocorrer por fato superveniente, 
decorrente de caso fortuito ou força maior, que prejudique o cumprimento da ata, 
devidamente comprovados e justificados: 

 
a) por razão de interesse público; ou 
 
b) a pedido do fornecedor. 

 
18.13. O licitante vencedor somente poderá subcontratar, em parte, o objeto desta licitação, se 
for conveniente para a Administração deste Tribunal, mediante prévia e escrita autorização desta, 
sob pena de sofrer as sanções contratuais e legais. 
 

18.13.1. O licitante vencedor não poderá transferir a terceiros nenhuma responsabilidade, em 
caso de subcontratação autorizada. 

 
18.14. O licitante vencedor obriga-se a manter, durante a vigência do Registro de Preços, em 
compatibilidade com as obrigações por ele assumidas, todas as condições de habilitação e 
qualificação exigidas na licitação, renovando as certidões e encaminhando-as ao Tribunal Regional 
Eleitoral de Alagoas, no prazo máximo de 48 (quarenta e oito) horas a partir da solicitação das 
mesmas. 
 
18.15. A Ata de Registro de Preços, durante sua vigência, poderá ser utilizada por qualquer 
órgão ou entidade da administração pública federal que não tenha participado do certame 
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licitatório, mediante anuência do órgão gerenciador, observadas, ainda, as demais regras impostas 
no art. 22 do Decreto n.º 7.892/2013. 
 
18.16. As aquisições ou contratações adicionais a que se refere o subitem 18.15 não poderão 
exceder, por órgão ou entidade, a cinquenta por cento dos quantitativos dos itens do instrumento 
convocatório e registrados na ata de registro de preços para o órgão gerenciador e órgãos 
participantes. 
 
18.17. O quantitativo decorrente das adesões à ata de registro de preços não poderá exceder, 
na totalidade, ao dobro do quantitativo de cada item registrado na ata de registro de preços para o 
órgão gerenciador e órgãos participantes, independente do número de órgãos não participantes que 
aderirem.  
 
19 – DO RECEBIMENTO DO OBJETO. 
 
19.1.  O objeto deverá ser entregue, no prazo previsto no item 3 deste edital, por e-mail ou ofício, 
o que ocorrer primeiro, no horário de expediente normal, de segunda a sexta-feira, na Seção de 
Almoxarifado do Tribunal Regional Eleitoral de Alagoas, localizada na Avenida Menino Marcelo 
(antiga via expressa), nº 7.200 D – Serraria, Maceió/AL, CEP: 57046-005, sob agendamento através 
do telefone (82) 3328-1947. 
 
19.2. O objeto será recebido: 

 
a) provisoriamente, para que seja feita a verificação da conformidade dos mesmos com 
as especificações. 
 

b) definitivamente, após avaliação e homologação pelos responsáveis técnicos do Tribunal, da 
seguinte forma: 

b.1) O exame para comprovação das características técnicas consistirá em avaliações e 
testes não-destrutivos, por amostragem realizados em duas etapas: 

a. Primeira: inspeção visual de todos os equipamentos entregues; 
b. Segunda: testes funcionais de configuração e desempenho, em, no mínimo, 10% (dez 

por cento) e não menos do que 01 (um) dos equipamentos recebidos. O Tribunal 
poderá, a seu critério, executar os testes nos demais equipamentos, dentro de 
um critério de razoabilidade, podendo chegar a 100% dos quantitativos, mas dentro de 
um prazo máximo de 30 (trinta) dias corridos e contados de cada lote de 
equipamentos. 

b.2) As especificações serão avaliadas também por meio de documentos técnicos que 
acompanham os equipamentos, informações fornecidas pela Contratada e disponível no 
sítio do fabricante; 

b.3) A comissão do Tribunal deverá, após a comprovação do perfeito funcionamento dos 
equipamentos e adequação às especificações técnicas, emitir e assinar o Termo de 
Recebimento Definitivo. 

19.3. O produto será rejeitado no caso de incompatibilidade com as especificações previstas 
na proposta ou quando inadequado à sua utilização. 
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19.4. O prazo para a Secretaria competente proceder às verificações, após o recebimento 
provisório, será de 05 (cinco) dias úteis, quando deverá se manifestar, aceitando ou recusando o 
item objeto do fornecimento. 
 
19.5. Os recebimentos provisório e definitivo se darão mediante formulário próprio. 
 
19.6. O recebimento definitivo não exime o fornecedor de responder pelos vícios aparentes e 
ocultos segundo as disposições deste termo e as normas de proteção ao consumidor. 
 
19.7. O objeto que estiver em desacordo com as especificações do edital terá seu recebimento 
recusado, devendo o fornecedor, dentro do prazo de 10 (dez) dias corridos, substituir o produto 
adequadamente, sujeitando-se à multa prevista na Seção 18. 
 
20 – DAS SANÇÕES ADMINISTRATIVAS. 
 
20.1.  Com fundamento no artigo 7º da Lei nº 10.520/2002 e, subsidiariamente, nos artigos 86 e 
87 da Lei 8.666/1993, a Contratada ficará sujeita, assegurada prévia e ampla defesa, às seguintes 
penalidades:  
 
a. Advertência:  
 

i. A Contratada será notificada formalmente em caso de descumprimento de obrigação 
contratual e terá que apresentar as devidas justificativas em um prazo de até 5 (cinco) dias úteis 
após o recebimento da notificação; e 

 
ii. Caso não haja manifestação dentro desse prazo ou se entenda serem improcedentes as 
justificativas apresentadas, a Contratada será advertida. 

 
b. Multa de: 

 
i. 0,5% (meio por cento) por dia, e por ocorrência, sobre o valor do objeto com atraso 
injustificado, limitada a incidência a 20 (vinte) dias corridos; 

- No caso de atraso injustificado na entrega do objeto por prazo superior a 20 
(vinte) dias corridos, com a aceitação pela Administração, será aplicada a multa de 10% sobre o 
valor da Ordem de Fornecimento; e 

-  No caso de atraso injustificado na prestação dos serviços por prazo superior a 20 (vinte) dias 
corridos, com a não aceitação pela Administração, será aplicada a penalidade 20% sobre o valor 
da Ordem de Fornecimento, no caso de inexecução total da obrigação, podendo haver, ainda, o 
cancelamento do registro de preços do Fornecedor. 

ii. 10% sobre o valor constante da Ordem de Fornecimento, no caso de inexecução parcial 
da obrigação assumida; 

iii. 20% (vinte por cento) sobre o valor adjudicado, em caso de inexecução total da obrigação 
assumida; 

iv. 10% sobre o valor global da Ata de Registro de Preços, na hipótese de recusa em assinar a Ata 
ou retirar a Ordem de Fornecimento; 
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c. Impedimento de licitar e contratar com a União e descredenciamento do SICAF pelo prazo de até 
5 (cinco) anos, sem prejuízo das demais penalidades legais; e  
 
d. Declaração de inidoneidade para licitar ou contratar com a Administração Pública.  

 
20.2.    O cometimento reiterado de atrasos injustificados dos prazos previstos para 
entrega/solução do chamado de garantia dos equipamentos poderá resultar no cancelamento do 
instrumento de fornecimento com a Contratada. 
 
20.3.   As sanções previstas nos itens "20.1.a", “20.1.c” e “20.1.d” poderão ser aplicadas, 
cumulativamente ou não, à pena de multa.  
 
20.4.   O valor da multa, aplicada após o regular processo administrativo, será descontado de 
pagamentos eventualmente devidos à contratada ou cobrado judicialmente;  
 
20.5.   Excepcionalmente, ad cautelam, a Administração poderá efetuar a retenção do valor 
presumido da multa, antes da instauração do regular procedimento administrativo. 
 
20.6.   O valor da multa, apurado após regular procedimento administrativo, será descontado 
dos pagamentos eventualmente devidos pelo TRE/AL ou cobrado judicialmente. 
 
20.7.   Na aplicação das penalidades previstas nesta Seção a autoridade competente sempre 
se valerá dos princípios da proporcionalidade, da razoabilidade e da prevalência e indisponibilidade 
do interesse público, em decorrência de circunstâncias fundamentadas em fatos comprovados. 
 
20.8.   O licitante contratado, quando não puder cumprir os prazos estipulados para o 
fornecimento do material, total ou parcialmente, deverá apresentar justificativa por escrito, 
devidamente comprovada, e em documento contemporâneo à sua ocorrência, acompanhada de 
pedido de prorrogação, nos casos de ocorrência de fato superveniente, excepcional ou imprevisível, 
estranho à vontade das partes, que altere fundamentalmente as condições do contrato, ou que 
impeça a sua execução, por fato ou ato de terceiro reconhecido pela Administração.  
 
20.9.  Do ato que aplicar as penalidades caberá recurso na forma do art. 109 da Lei nº 
8.666/1993. 
 
20.10.  Se o licitante contratado não recolher o valor da multa que lhe for aplicada, dentro de 05 
(cinco) dias úteis a contar da data da intimação para o pagamento, a importância será descontada 
automaticamente, ou ajuizada a dívida, consoante o § 3º do art. 86 e § 1º do art. 87 da Lei nº 
8.666/1993, acrescida de juros moratórios de 0,5% (meio por cento) ao mês. 
 
20.11.  O TRE/AL promoverá o registro no SICAF de toda e qualquer penalidade imposta ao 
licitante contratado. 
 
20.12.  O período de atraso será contado em dias corridos. 
 
20.13. No caso de aplicação de penalidade em que a contratada tenha que pagar multa através 
de Guia de Recolhimento da União – GRU, e não o faça no devido prazo, o índice utilizado para 
atualização do valor será o IPCA. 
 
20.14. A data a ser utilizada como referência para a atualização do débito será a da publicação 
da decisão da aplicação da penalidade no Diário Eletrônico.  
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20.15.  Fica estabelecido que os casos omissos serão resolvidos entre as partes contratantes, 
respeitados o objeto da presente licitação, a legislação e demais normas reguladoras da matéria, 
em especial as Leis nos 8.666/1993 e  10.520/2002, aplicando-lhes, quando for o caso, 
supletivamente, os princípios da Teoria Geral dos Contratos e as disposições do Direito Privado. 
 
20.16.  Os atos administrativos de aplicação das sanções, com exceção de advertência, multa de 
mora e convencional, serão publicados resumidamente no Diário Oficial da União. 
 
21 - DO PAGAMENTO. 
 
21.1.  O pagamento será efetuado mediante ordem bancária de crédito em conta corrente, em 
até 10 (dez) dias, após o recebimento da Nota Fiscal respectiva, a qual deverá ser entregue 
somente após a prestação dos serviços, devendo a contratada atender os seguintes requisitos: 

a) Apresentação de nota fiscal de acordo com a legislação vigente à época da emissão (nota 
fiscaleletrônica, se for o caso), acompanhada do Certificado de Regularidade do FGTS – CRF, 
comprovando regularidade com o FGTS; da Certidão Conjunta Negativa de Débitos Relativos a 
Tributos Federais e à Dívida Ativa da União, que incluindo as referentes a contribuições 
previdenciárias, expedida pela Secretaria da Receita Federal; e da Certidão Negativa de 
Débitos Trabalhistas – CNDT, emitida pela Justiça do Trabalho; e da prova de regularidade para 
com as Fazendas Estadual e Municipal do domicílio ou sede do Fornecedor; e 

b) Inexistência de fato impeditivo para o qual tenha concorrido o Fornecedor. 

21.2.  Eventuais penalidades poderão ser descontadas do pagamento. 
 
21.3.  Em nenhuma hipótese haverá antecipação de pagamento. 
 
21.4.  O TRE/AL, por ocasião de cada pagamento, fará as retenções e recolhimentos fiscais 
determinados pela legislação tributária. 
 
21.5.  Se a empresa for optante pelo SIMPLES, deverá anexar à nota fiscal documento que 
comprove tal opção, para que sobre o valor do pagamento não incidam as retenções de que trata o 
item anterior. 
 
21.6.  Havendo atraso no pagamento, o valor devido deverá ser acrescido de encargos 
moratórios, apurados desde a data do primeiro dia útil do atraso, até a data do efetivo pagamento, 
desde que o contratado não tenha concorrido para tanto, mediante a aplicação da seguinte 
fórmula: 
 
EM = I x N x VP, 
 
Onde: 
EM= Encargos Moratórios 
N= Número de dias entre a data prevista para o pagamento e a do efetivo pagamento; 
VP = Valor da parcela a ser paga; 
I= Índice de atualização financeira= 0,0001644, assim apurado: 
 
I = (TX/100)                  I= (6/100)           I = 0,0001644 
         365                             365 
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TX= Percentual de Taxa Anual= 6% 

21.7.  Nenhum pagamento será efetuado à Contratada enquanto pendente de liquidação 
qualquer obrigação. Esse fato não será gerador de direito a reajustamento de preços ou a 
atualização monetária. 

22 – DA DOTAÇÃO ORÇAMENTÁRIA. 
 
22.1.  As despesas decorrentes da execução do contrato correrão à conta dos recursos 
lançados na Proposta Orçamentária Anual deste Tribunal para o exercício 2019, alocados no 
Programa de Trabalho - PTRES nº 084621 (Julgamento de causas e gestão administrativas) - Natureza 
da Despesa nº 44.90.52 (Equipamentos e Material Permanente) e 33.90.39 (Outros Serviços de 
Terceiros - Pessoa Jurídica). 
 
22.2.  As despesas referentes aos exercícios subsequentes correrão à conta das dotações 
orçamentárias respectivas. 
 
23 - DAS OBRIGAÇÕES DO ÓRGÃO GERENCIADOR. 
 
23.1. São obrigações do Órgão Gerenciador: 
 

a) Gerenciar a presente Ata, indicando, sempre que solicitado, o nome do detentor da ata, o 
preço, e as especificações dos materiais registrados, observada a ordem de classificação 
indicada na licitação; 
 
b) Observar para que, durante a vigência da presente ata, sejam mantidas todas as condições 
de habilitação e qualificação exigidas na licitação, bem assim, a compatibilidade com as 
obrigações assumidas; 
 
c) Conduzir eventuais procedimentos administrativos de renegociação de preços registrados, 
para fins de adequação às novas condições de mercado, e de aplicação de penalidades; 
 
d) Acompanhar a evolução dos preços de mercado, com a finalidade de verificar sua 
compatibilidade com aqueles registrados na Ata; 
 
e) Acompanhar e fiscalizar o cumprimento das condições ajustadas na presente Ata; 
 
f) Aplicar, garantida a ampla defesa e o contraditório, as penalidades decorrentes do 
descumprimento do pactuado na ata de registro de preços ou do descumprimento das 
obrigações contratuais, em relação às suas próprias contratações; 
 
g) Consultar o detentor da ata registrada (observada a ordem de classificação) quanto ao 
interesse em fornecer o material a outro(s) órgão(s) da Administração Pública que externe(m) 
a intenção de utilizar a presente Ata, conforme subitem 18.15. 

 
23.2. São, ainda, obrigações do órgão gerenciador da ata, na condição de contratante: 

 

a) Efetuar o pagamento à Contratada, após o recebimento definitivo; 
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b) Acompanhar e fiscalizar a execução do objeto da Ata de Registro de Preços e 
do(s) contrato(s) dela decorrentes, por meio de servidor(es) designado(s), 
de modo a garantir o fiel cumprimento do mesmo e da proposta; 

c) Manter arquivo, junto ao processo administrativo ao qual está vinculado o presente termo,  
toda a documentação referente ao mesmo; 

d) Proporcionar todas as facilidades indispensáveis à boa execução das obrigações contratuais; 
e 

e) Aplicar as sanções conforme previsto no contrato, assegurando à Contratada o contraditório 
e ampla defesa. 

24 - DAS OBRIGAÇÕES DO DETENTOR DA ATA. 
 

24.1.  São obrigações do detentor da Ata: 
 

a) Providenciar a imediata correção de deficiências, falhas ou irregularidades constatadas pelo 
ÓRGÃO GERENCIADOR referentes às condições firmadas na presente Ata; 
 
b) Viabilizar o atendimento das condições firmadas a partir da data da publicação da presente 
Ata; 
 
c) Manter, durante o prazo de vigência da presente Ata, todas as condições de idoneidade 
exigidas na licitação, além de se sujeitar às demais disposições do Código de Proteção e 
Defesa do Consumidor (Lei n° 8.078/90) que sejam compatíveis com o regime de direito 
público; 
 
d) Informar, no prazo máximo de 05 (cinco) dias úteis, contados do recebimento da 
notificação, quanto à aceitação ou não do fornecimento de material a outro órgão da 
Administração Pública (não participante) que venha a manifestar o interesse de utilizar a 
presente Ata, conforme item 18.15. 

 
24.2. São ainda obrigações do detentor da Ata, na condição de contratado: 

 
a) Executar o contrato em estrita conformidade com as disposições e especificações do 
Edital e com os termos da proposta de preços; 

b) Fornecer os equipamentos conforme especificações, quantidades, prazos e demais 
condições estabelecidas no Edital, na Ata de Registro de Preços, na Ordem de 
Fornecimento e na Proposta de preços; 

c) Fornecer a documentação necessária à instalação e à operação dos produtos 
(manuais, termos de garantia, etc.), completa, atualizada e em português do Brasil, caso 
exista, ou em inglês; 

d) Disponibilizar Central de Atendimento para a abertura e fechamento de chamados 
técnicos, conforme períodos, horários e condições estabelecidas no Edital e em seus 
Anexos; 

e) Comunicar formal e imediatamente ao Gestor ou Responsável Técnico da 
Administração sobre mudanças nos dados para contato com a Central de Atendimento; 

f) Prestar as informações e os esclarecimentos que venham a ser solicitados pelo 
representante da Administração, referentes a qualquer problema detectado ou ao 
andamento de atividades da garantia; 
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g)  Responder por quaisquer prejuízos que seus profissionais causarem ao patrimônio da 
Administração ou a terceiros, por ocasião da execução do objeto, procedendo 
imediatamente aos reparos ou às indenizações cabíveis e assumindo o ônus decorrente; 

h) Responsabilizar-se integralmente pelo fornecimento dos equipamentos e pela 
execução dos serviços de garantia técnica, primando pela qualidade, desempenho, 
eficiência e produtividade na execução dos trabalhos, dentro dos prazos estipulados e 
cujo descumprimento será considerado infração passível de aplicação das penalidades 
previstas no Termo de Referência (Anexo I); 

i) Comunicar ao Gestor ou Responsável Técnico, formal e imediatamente, todas as 
ocorrências anormais e/ou que possam comprometer a execução do objeto; 
 
j) Manter sigilo sobre todo e qualquer assunto de interesse da Administração ou de 
terceiros de que tomar conhecimento em razão da execução do objeto, respeitando 
todos os critérios estabelecidos, aplicáveis aos dados, informações, regras de negócios, 
documentos, entre outros pertinentes, sob pena de responsabilidade civil, penal e 
administrativa; 

 
k) Cumprir e garantir que seus profissionais estejam cientes, aderentes e obedeçam 
rigorosamente às normas e aos procedimentos estabelecidos na Política de Segurança da 
Informação do TRE/AL; 

 
l) Responsabilizar-se pela conservação dos ambientes onde desempenhe as atividades 
necessárias para prestar a garantia on-site; 

 
m) Prestar as informações e os esclarecimentos que venham a ser solicitados pela 
Administração, referentes a qualquer problema detectado ou ao andamento de 
atividades da garantia técnica. 
 
n) Indicar endereço eletrônico (e-mail) para o recebimento de expedientes/notificações 
enviadas pelo TRE/AL, sendo considerados válidos todos os expedientes/notificações 
enviadas ao endereço eletrônico indicado; 
 
o) Manter durante a execução do contrato todas as condições que culminaram em sua 
habilitação, principalmente a regularidade fiscal e previdenciária, condições de 
idoneidade exigidas na licitação e outras previstas na legislação vigente e na aplicável à 
natureza dos serviços objeto da contratação; 
 
p) Aceitar o cancelamento da ordem de fornecimento por parte da Administração, no 
caso de fornecimento/entrega, em final de exercício e posterior ao dia 15 de dezembro 
ou dia útil imediatamente subsequente, em decorrência dos efeitos da Emenda 
Constitucional nº 95/2016, sem a reversão de qualquer ônus à Administração. 
 
q) Apresentar certidões de quitação junto à Receita Federal, Dívida Ativa da União, INSS, 
FGTS, Fazenda Estadual e Fazenda  Municipal ou estar registrada junto ao SICAF em 
condição regular; 
 
r) Acatar outras determinações previstas na legislação aplicável à natureza do objeto 
deste contrato; 
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s) Cumprir com outras obrigações decorrentes da aplicação do Código de Proteção e 
Defesa do Consumidor (Lei nº 8.078/1990) que sejam compatíveis com o regime de 
Direito Público. 

 
 
25 - DA PUBLICIDADE. 
 
25.1. O preço registrado com indicação dos fornecedores será divulgado no Portal de Compras 
do Governo federal e ficará disponibilizado durante a vigência da ata de registro de preços, em 
conformidade com o disposto no art. 11, inciso II do Decreto n.º 7.892/2013 combinado com o art. 
15, 2º da Lei nº 8.666/93. 
 
25 – DA VEDAÇÃO DE AQUISIÇÃO SEPARADA DOS ITENS. 
 
25.1. É vedada a aquisição separada de itens para os quais, o fornecedor convocado para 
assinar a ata não tenha apresentado o menor preço entre todos os licitantes. 
 
26 - DISPOSIÇÕES GERAIS. 
 
26.1.  É assegurado ao TRE/AL, no interesse da Administração, revogar o certame, ou, no caso 
de vício insanável (ilegalidade), anulá-lo, no todo ou em parte, dando ciência aos participantes, na 
forma da legislação vigente. 
 
26.2.  As proponentes assumem todos os custos de preparação e apresentação de suas 
propostas e o TRE/AL não será, em nenhum caso, responsável por esses custos, 
independentemente da condução ou do resultado do processo licitatório. 
 
26.3.   As proponentes serão responsáveis pela fidelidade e legitimidade das informações e dos 
documentos apresentados em qualquer fase da licitação. 
 
26.4.  Não havendo expediente, ou ocorrendo qualquer fato superveniente que impeça a 
realização do certame na data marcada, a sessão será transferida para o primeiro dia útil 
subsequente, devendo o Pregoeiro informar sobre o adiamento no ambiente do Comprasnet, com 
antecedência mínima de 24 (vinte e quatro) horas. 
 
26.5.  Na contagem dos prazos estabelecidos neste Edital, excluir-se-á o dia do início e incluir-
se-á o do vencimento. Só se iniciam e vencem os prazos em dias de expediente no TRE/AL. 
 
26.6.  No julgamento da habilitação e das propostas, o pregoeiro poderá sanar erros ou falhas 
que não alterem a substância das propostas, dos documentos e sua validade jurídica, mediante 
despacho fundamentado, registrado em ata e acessível a todos, atribuindo-lhes validade e eficácia 
para fins de habilitação e classificação. 
 
26.7.  As normas que disciplinam este Pregão serão sempre interpretadas em favor da 
ampliação da disputa entre as empresas interessadas, sem comprometimento da segurança do 
futuro contrato. 
 
26.8.  Havendo divergência entre o edital e seus anexos, prevalecerá o determinado neste 
edital. 
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26.9.  O endereço para vistas e protocolo de documentos, é o seguinte: Avenida Aristeu de 
Andrade, nº 377, 6º andar - COMAP/Seção de Licitações e Contratos, bairro Farol, CEP: 57051-090, 
Maceió/AL, Fone: (82) 2122-7764/7765. 
 
26.10. Todos os horários estabelecidos neste Edital, no aviso e durante a sessão pública, 
observarão, para todos os efeitos, o horário de Brasília, Distrito Federal, inclusive para contagem de 
tempo e registro no sistema eletrônico e na documentação relativa ao certame. 
 
26.11. A homologação do resultado desta licitação não implicará direito à contratação. 
 
26.12. Aos casos omissos, aplicar-se-ão as demais disposições da Lei nº 10.520/2002, do 
Decreto nº 5.450/2005 e alterações e da Lei nº 8.666/1993. 
 
26.13. O Edital e seus anexos poderão ser lidos na sala da Seção de Licitações e Contratos, 
COMAP, no endereço especificado no item 26.9, no caso de ser retirado em Maceió/AL, ou ainda, 
nos sites www.tre-al.jus.br e www.comprasnet.gov.br, gratuitamente. 
 
26.14. Fazem parte integrante deste Edital os seguintes Anexos: 
 

ANEXO I – Termo de Referência; 
ANEXO I–A – Especificações dos lotes, itens, quantitativos a serem adquiridos e preços 
máximos admitidos; 
ANEXO I-B - Planilha de Composição de Custos por Item; 
ANEXO II – Planilha para preenchimento dos dados do Contrato (Sugestão); 
ANEXO III – Minuta da Ata de Registro de Preços. 

 
26.15. Fica eleito o Foro da Justiça Federal em Maceió - Seção Judiciária do Estado de Alagoas, 
para dirimir quaisquer dúvidas ou controvérsias oriundas desta licitação, que não puderem ser 
solucionadas administrativamente. 

 
 

Maceió/AL, XX de XXXX de 2019. 
 
 

Ingrid Pereira de Lima Araújo 
Chefe da Seção de Licitações e Contratos  
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ANEXO I 
 

TERMO DE REFERÊNCIA  
 

01. Objeto Registro de Preço para aquisição de componentes de rede (Networking) 

02. Quantidade 

LOTE 01 - SOLUÇÃO PARA REDE CABEADA 

ITEM DESCRIÇÃO DOS PRODUTOS/SERVIÇOS QTD 

ITEM 
01 

SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 
PARA REDE CABEADA 

01 

ITEM 
02 

LICENCIAMENTO ADICIONAL PARA SISTEMA DE 
GERENCIAMENTO HPE IMC 

03 

ITEM 
03 

LICENCIAMENTO ADICIONAL DO MÓDULO DE ANÁLISE DE 
TRAFEGO DO SISTEMA DE GERENCIAMENTO HPE IMC 

02 

ITEM 
04 

LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE 
PERFIL E CONTROLE DE ACESSO 

02 

ITEM 
05 

SWITCH DE DISTRIBUIÇÃO COM 16 PORTAS SFP+ E SUPORTE 
A MÓDULOS DE EXPANSÃO 

06 

ITEM 
06 

MÓDULO COM 4 PORTAS SFP+ PARA SWITCH DE 
DISTRIBUIÇÃO 

16 

ITEM 
07 

MÓDULO DE STACKING COM 4 PORTAS PARA SWITCH DE 
DISTRIBUIÇÃO 

06 

ITEM 
08 

SWITCH DE ACESSO L3 COM 48 PORTAS GIGABIT E 4SFP+ 50 

ITEM 
09 

SWITCH DE ACESSO L3 COM 24 PORTAS GIGABIT E 4SFP+ 40 

ITEM 
10 

SWITCH DE ACESSO L2 COM 24 PORTAS GIGABIT E 4SFP 50 

ITEM 
11 

SWITCH DE ACESSO L2 COM 48 PORTAS GIGABIT E 4SFP 40 

ITEM 
12 

GBIC 10GB PARA ATÉ 300M 50 

ITEM 
13 

CABO DAC 10 GBPS DE 1M 30 
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ITEM 
14 

CABO DAC 10 GBPS DE 3M 30 

ITEM 
15 

GBIC 1GB PARA ATÉ 500M 10 

ITEM 
16 

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA SWITCHS DE REDE 

05 

ITEM 
17 

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO 

01 

ITEM 
18 

TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE SWITCHES 04 

ITEM 
19 

TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE 
ACESSO 

04 

LOTE 02 - SOLUÇÃO DE REDE WIRELESS 

ITEM DESCRIÇÃO DOS PRODUTOS/SERVIÇOS QTD 

ITEM 
20 

SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 
PARA REDE WIRELESS 

01 

ITEM 
21 

SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS 01 

ITEM 
22 

LICENÇAS ADICIONAIS PARA SOLUÇÃO DE GERENCIAMENTO 
DE REDE WIRELESS 

200 

ITEM 
23 

LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE 
PERFIL E CONTROLE DE ACESSO 

02 

ITEM 
24 

CONTROLADORA WLAN 04 

ITEM 
25 

LICENÇAS ADICIONAIS PARA CONTROLADORA WLAN 200 

ITEM 
26 

PONTO DE ACESSO INTERNO TIPO 01 100 

ITEM 
27 

PONTO DE ACESSO INTERNO TIPO 02 100 

ITEM 
28 

INJETOR POE PARA PONTOS DE ACESSO TIPO 1 100 

ITEM INJETOR POE PARA PONTOS DE ACESSO TIPO 2 100 
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29 

ITEM 
30 

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA SOLUÇÃO DE GERENCIAMENTO 

01 

ITEM 
31 

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO 

01 

ITEM 
32 

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA PONTOS DE ACESSO 

05 

ITEM 
33 

TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE ARQUITETURA 
WLAN 

04 

ITEM 
34 

TREINAMENTO BÁSICO DA SOLUÇÃO DE GERENCIAMENTO 04 

ITEM 
35 

TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE 
ACESSO 

04 

 

03. Resumo da 
Especificação do 
Objeto 

Por se tratar de quantidade elevada de itens pertencentes a lotes específicos, 
o detalhamento das especificações está constante no DETALHAMENTO DO 
OBJETO (Art. 18, § 3º, III). 

04. Valor 
Estimado 

Os custos totais projetados, por certo, serão objeto de levantamento por 
parte da Seção de Compras, em momento posterior. 

05. Justificativa 

 A dependência tecnológica para o adequado funcionamento de qualquer 
instituição é na prática, total; 

 A malha de comunicação de rede interna é primordial para  acesso aos 
sistemas e serviço informatizados e desta maneira essencial; 

 Grande parte dos equipamentos de rede do Tribunal está defasado 
tecnologicamente,  fora de garantia ou na iminência de término da 
mesma; 

 Permitir a qualificação da equipe da CONIF para o gerenciamento das 
soluções a serem adquiridas; 

 Maiores detalhes disponíveis no Item 2 do Documento de Oficialização 
da Demanda. 

06. Prazo de 
Entrega 

Conforme  item 3 do edital. 

07. Adjudicação 

Por Lote. 

Justificativa: Plena exigência de total compatibilidade e interoperabilidade entre 
em componentes do respectivo lote, como também quanto à solução de 
gerenciamento em uso no TRE/AL. 

08. Classificação 
Orçamentária 

(A cargo da COFIN). 
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09. Local de 
Entrega 

Almoxarifado do Tribunal Regional Eleitoral de Alagoas 

Av. Menino Marcelo, 7200D, Serraria 

Maceió – AL CEP 57046-005 Tel.: (82) 3328-1947 

Horário: De segunda-feira a quinta-feira das 13 às 19h e sexta-feira das 
7h30min Às 13h30min. 

10. Unidade 
Fiscalizadora 

SEGI/CIE/STI 

11. Unidade 
Gestora 

SAD 

12. Sanções 
Administrativas 

Vide 

Item 3.2 Forma de Execução e de Gestão do Contrato (Art. 18, § 3º, III, a) 
Subitem Penalidades (Art. 18, § 3º, III, a, 11) 

13. Prazo de 
Pagamento 

Vide  

Item 3.2 Forma de Execução e de Gestão do Contrato (Art. 18, § 3º, III, a) 
Subitem Forma de Pagamento (Art. 18, § 3º, III, a, 7) 

14. Estratégia de 
Recebimento 

Vide  

Item 3.2 Forma de Execução e de Gestão do Contrato (Art. 18, § 3º, III, a) 
Subitem Recebimento do Objeto: 

15. Modalidade e 
Tipo de Licitação 

Vide 

2.11 Modalidade, Tipo de Licitação, Critérios de Habilitação e Atendimento aos 
Requisitos (Art. 18, § 3º, II, j, IV e V) 

  

1. OBJETO (Art. 18, §3º,I): 

  

Registro de Preço para aquisição de componentes de rede sem fio e cabeada. 

1.1 Definição (Art. 18, §3º, I) 

Registro de Preço para aquisição de computadores  para substituir equipamentos 
fora de garantia e/ou obsoletos. 

2. FUNDAMENTAÇÃO DA CONTRATAÇÃO (Art. 18, § 3º, II) 

  

2.1 Motivação (Art. 18, § 3º, II, a ) 

Os equipamentos tem por finalidade a substituição, por atualização tecnológica, de equipamentos, 
ora em uso, com aproximadamente 04 (quatro) anos e já não mais cobertos por garantia. Estes 
aspectos, a um só tempo, a se falar em TI, evidenciam a necessidade de atualização e de 
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demanda de salvaguarda, esculpida em garantia, da efetividade e continuidade do mister da 
Secretaria. 

  

A estratégia de Registro de Preços está amparada no Decreto nº 7.892/2013, art 3º, incisos: 

I - vez que os equipamentos podem ser objeto de diversas aquisições/fornecimentos até que se 
supra progressivamente toda a demanda de substituição progressiva; 

II - as entregas deve ser progressivas de forma que as equipes da STI, em número limitado, 
possam implantar os equipamentos sem que os mesmo precisem ser estocados por longos 
períodos apenas exaurindo seus prazos de garantia. 

2.2 Objetivos (Art. 18, § 3º, II, b) 

A contratação visa, além de promover ações no sentido de elaborar novo 
instrumento que mantenha um meio para disponibilizar os computadores demandados e: 

Garantir a infraestrutura física apropriadas às atividades administrativas e 
judiciais. 

Prover infraestrutura de TIC apropriada às atividades judiciais e administrativas. 

2.3 Benefícios (Art. 18, § 3º, II, c) 

 Reposição de equipamentos defasados e manutenção da capacidade produtiva atualizada. 

2.4 Alinhamento Estratégico (Art. 18, § 3º, II, d) 

O alinhamento com o PEI é identificado na visão do recursos de infraestrutura e tecnologia em 
seus dois aspectos apontados: 

 Garantir a infraestrutura física apropriadas às atividades administrativas e judiciais. 

Alinhamento com os Objetivos Estratégicos da Estratégia Nacional de TIC do Poder Judiciário nos 
seguintes aspectos: 

 Prover infraestrutura de TIC apropriada às atividades judiciais e administrativas. 

Alinhamento com os Objetivos Estratégicos de TIC da Justiça Eleitoral de Alagoas – 2017/2022 nos 
seguintes aspectos: 

 Viabilizar serviços e soluções de TIC. 

  

2.5 Referência aos Estudos Preliminares (Art. 18, § 3º, II, e) 

Este Termo de Referência foi elaborado considerando o Documento de 
Oficialização de Demanda (DOD) encaminhado pela Secretaria de Tecnologia da Informação (STI) 
e os Estudos Preliminares constantes do Processo SEI nº 0008478-63.2018.6.02.8000. 

2.6 Relação entre a Demanda Prevista e a Contratada (Art. 18, §3º, II, f) 

É pretendida a renovação do parque de equipamentos componentes da 
infraestrutura de TIC. 
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2.7 Análise de Mercado de TIC (Art. 18, § 3º, II, g) 

Verifica-se que os bens e serviços pretendidos poderão ser fornecidos por 
diferentes empresas no mercado de TIC. 

Considerando o Item 7 dos Estudos Preliminares, não se vislumbrou alternativa 
que não o presente Registro de Preços. 

  

2.8 Natureza do Objeto (Art. 18, § 3º, II, h) 

Os bens e serviços a serem contratados possuem características comuns e usuais 
encontradas atualmente no mercado de TIC, cujos padrões de desempenho e de qualidade 
podem ser objetivamente definidos neste Termo de Referência. 

O objeto desta contratação tem como escopo a obtenção de produto específico 
em período determinado, portanto não se caracteriza como serviço de natureza continuada. 

2.9 Parcelamento e Adjudicação do Objeto (Art. 18, § 3º, II, i) 

Não haverá parcelamento, cada ordem de fornecimento derivado do Registro de 
Preços deverá ser realizada de maneira integral. 

Adjudicação será por lote. 

2.10 Vigência 

Será, na forma dos normativos vigentes, o tempo máximo do Registro de Preços. 

A vigência da ata será de 12 (doze) meses, contados a partir de sua assinatura. 

A utilização do sistema de Registro de Preços visa, primordialmente, a redução de 
número de licitações para o mesmo objeto, porquanto se concentra em um único procedimento a 
possibilidade de realizar diversas aquisições recorrentes e necessárias, via ordens de 
fornecimento, durante o lapso temporal de sua vigência, em face de os preços permanecerem à 
disposição da Administração. 

2.11 Modalidade, Tipo de Licitação, Critérios de Habilitação e Atendimento aos Requisitos (Art. 18, § 
3º, II, j, IV e V) 

A aquisição pretendida deverá ser realizada por meio de licitação do tipo Pregão 
Eletrônico, como é de praxe neste Regional, salvo entendimento superior contrário. 

A sugestão da equipe de planejamento, por se tratar de fornecimento de 
equipamento, é pela contratação por licitação via pregão. Por conta de possibilidade de 
contingenciamento orçamentário indicamos a modalidade de registro de preços. 

O DECRETO Nº 7.174, DE 12 DE MAIO DE 2010 que regulamenta a contratação de bens e serviços 
de informática e automação pela administração pública federal, direta ou indireta, pelas fundações 
instituídas ou mantidas pelo Poder Público e pelas demais organizações sob o controle direto ou 
indireto da União deve ser aplicado nesta aquisição por se tratar de bem de informática. 

A ressalva que a equipe aponta é em relação ao artigo 3º, item II que versa sobre a necessidade 
de exigências, na fase de habilitação, de certificações emitidas por instituições públicas ou 
privadas credenciadas pelo Instituto Nacional de Metrologia, Normalização e Qualidade Industrial 
(Inmetro), que atestem, conforme regulamentação específica, a adequação à segurança para o 
usuário e instalações, compatibilidade eletromagnética e consumo de energia. 
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Tal exigência inviabiliza e restringe a competição deste certame, vez que a certificação para este 
tipo de produto, segundo o próprio INMETRO, é voluntária, conforme Portaria Inmetro n.º 170 de 
10/04/2012. 

(fonte:http://www.inmetro.gov.br/legislacao/rtac/pdf/RTAC001808.pdf). 

A contratação pretendida deverá ser realizada por meio de licitação do tipo 
Pregão Eletrônico, como é de praxe neste Regional, salvo entendimento superior contrário. 

A sugestão da equipe de planejamento, por se tratar de fornecimento de 
equipamento, é pela contratação por licitação via pregão. Por conta de possibilidade de 
contingenciamento orçamentário indicamos a modalidade de registro de preços. 

2.12 Adequação do Ambiente (Art. 18, § 3º, II, k) 

Para utilização do objeto pretendido é necessário dispor de infraestrutura física 
para sua instalação, situação essa já existente no âmbito do TRE/AL, salvo o surgimento de 
demanda muito particular e além da previsibilidade. 

2.13 Conformidade Técnica e Legal (Art. 18, § 3º, II, l) 

  

2.14 Obrigações do Contratante (Art. 18, § 3º, II, m) 

1. Efetuar o pagamento à Contratada, após o recebimento definitivo; 
2. Acompanhar e fiscalizar a execução do objeto da Ata de Registro de Preços e 

do(s) contrato(s) dela decorrentes, por meio de servidor(es) designado(s), 
de modo a garantir o fiel cumprimento do mesmo e da proposta; 

3. Manter arquivo, junto ao processo administrativo ao qual está vinculado o presente termo, to
da a documentação referente ao mesmo; 

4. Proporcionar todas as facilidades indispensáveis à boa execução das obrigações contratuais; 
e 

5. Aplicar as sanções conforme previsto no contrato, assegurando à Contratada o contraditório 
e a ampla defesa. 

2.15 Obrigações da Contratada (Art. 18, § 3º, II, m) 

As obrigações abaixo são aplicáveis ao objeto a ser contratado. 

1. Fornecer o(s) equipamento(s) conforme especificações, quantidades, prazos e demais
 condições estabelecidas no Edital, na Ata de Registro de Preços, 
na Ordem de Fornecimento, na Proposta e no Contrato; 

2. Fornecer a documentação necessária à instalação e 
à operação dos produtos (manuais, termos de garantia, etc.), completa, atualizada e 
em português do Brasil, caso exista, ou em inglês; 

3. Disponibilizar Central 
de Atendimento para a abertura e fechamento de chamados técnicos, conforme períodos, 
horários e condições estabelecidas no Edital e em seus Anexos; 

4. Comunicar formal e imediatamente ao Gestor ou Responsável Técnico da 
Administração sobre mudanças nos dados para contato com a Central de Atendimento; 

5. Prestar as informações e os esclarecimentos que venham a ser solicitados pelo 
representante da Administração, referentes a qualquer problema detectado ou 
ao andamento de atividades da garantia; 
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6. Responder por quaisquer prejuízos que seus profissionais causarem ao patrimônio da 
Administração ou a terceiros, 
por ocasião da execução do objeto, procedendo imediatamente aos reparos ou 
às indenizações cabíveis e assumindo o ônus decorrente; 

7. Responsabilizar-se  integralmente pelo fornecimento dos equipamentos e pela 
execução dos serviços de garantia técnica, primando pela qualidade, desempenho, 
eficiência e produtividade na execução dos trabalhos, dentro dos prazos estipulados e cujo 
descumprimento será considerado infração passível de aplicação das penalidades 
previstas neste Termo de Referência; 

8.  Comunicar ao Gestor ou Responsável Técnico, formal 
e imediatamente, todas as ocorrências anormais e/ou 
que possam comprometer a execução do objeto; 

9. Manter sigilo sobre todo e qualquer assunto de interesse da Administração ou de 
terceiros de que tomar conhecimento em razão da execução do objeto, respeitando todos 
os critérios estabelecidos, aplicáveis aos dados, informações, regras de negócios, 
documentos, entre outros pertinentes, sob pena de responsabilidade civil, penal e 
administrativa; 

10.  Cumprir e garantir que seus profissionais estejam cientes, aderentes e obedeçam rig
orosamente às normas e 
aos procedimentos estabelecidos na Política de Segurança da Informação do TRE/AL; 

11.  Responsabilizar-
se pela conservação dos ambientes onde desempenhe as atividades necessárias para pres
tar a garantia on-site. 

12. Prestar as informações e 
os esclarecimentos que venham a ser solicitados pela Administração, referentes a qualque
r problema detectado ou ao andamento de atividades da garantia técnica 

13. No caso de fornecimento/entrega, em final de exercício e posterior ao dia 15 de 
dezembro ou dia útil imediatamente subsquente, fica obrigado a aceitar, o cancelamento da 
ordem de fornecimento por parte da Administração, em decorrência dos efeitos da Emenda 
Constitucional nº 95/2016, sem a reversão de qualquer ônus à Administração. 

DETALHAMENTO DO OBJETO (Art. 18, § 3º, III) 

3.1 Descrição do Objeto 

CONDIÇÕES GERAIS 

1. Todos os itens ofertados por lote, deverão ser do mesmo fabricante para garantir total 
compatibilidade entre todos os componentes, sem a utilização de ferramentas de terceiros 
ou modo de interoperabilidade na solução; 

2. Para o  Lote 01: Todos os itens de software ofertados deverão possuir integração total com o 
HPE Intelligent Managment Center (IMC) já existente na infraestrutura da contratante, 
através de interface única de gerenciamento e/ou autenticação centralizada; 

3. Para o Lote 01: Os equipamentos fornecidos deverão ser gerenciados pelo HPE IMC já 
existente na infraestrutura da contratante, com presença na matriz de compatibilidade 
comprovada através de documentação oficial do fabricante; 

4. Os equipamentos devem ser novos e estar em produção. Não serão aceitos equipamentos 
descontinuados, recondicionados ou usados; 
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5. Os equipamentos devem ser entregues acondicionados adequadamente em suas 
embalagens originais; 

6. A(s) solução(ões) de gerenciamento/controle ofertada(s), deverá(ão) ser baseada(s) em 
plataforma “On Premise”, ou seja, deverá ser executada localmente, não sendo aceitas 
soluções híbridas ou em Cloud; 

7. Cada lote deverá ser fornecido por uma única empresa, visando a garantia integral de 
compatibilidade dos componentes ofertados; 

8. As configurações e especificações aqui apresentadas são mínimas, sendo aceitos 
equipamentos/softwares com características superiores, desde que compatíveis com as 
exigidas; 

9. Prazo de entrega para equipamentos: 60 (sessenta) dias contados a partir da emissão da 
ordem de fornecimento ou documento equivalente; 

10. Prazo de entrega para softwares: 30 (trinta) dias contados a partir da emissão da ordem de 
fornecimento ou documento equivalente; 

11. Os serviços de instalação, integração, garantia e suporte dos equipamentos e softwares, 
deverão ser realizados diretamente pelo fabricante de acordo com as exigências contidas no 
descritivo dos mesmos, estando essas aderentes aos respectivos níveis de serviço 
necessários a cada um deles. 

 LOTE 01 – SOLUÇÃO DE REDE CABEADA 

  

ITEM 01 – SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO LICENCIAMENTO 

1. Licenciamento da SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO, contemplando o 
quantitativo mínimo de 1.000 (um mil) dispositivos, usuários corporativos ou visitantes 
simultâneos, independente do perfil de autenticação, seja por dispositivo ou usuário; 

2. Caso a solução ofertada necessite de licenciamento específico para credenciamento dos 
dispositivos, usuários (corporativos ou visitantes), deverá ser fornecido o quantitativo 
solicitado para ambos, de forma que a solução realize a análise de perfil e o controle de 
acesso dos 1.000 (um mil) dispositivos ou usuários (corporativos ou visitantes) simultâneos. 

  

MÓDULO DE ANÁLISE DE PERFIL DE DISPOSITIVO 

Características Gerais Modulo de Análise de Perfil de Dispositivo 

3. Deve implementar funcionalidade de classificação automática criando perfis de dispositivos, 
de forma a descobrir, classificar e agrupar os dispositivos conectados na rede; 

4. Deve categorizar os dispositivos em pelo menos 3 níveis: 

a. Por tipo de dispositivo (ex. Computador, Smartdevice, impressora, etc.); 
b. Por sistema operacional (ex. Windows, Linux, MacOS, etc.); 
c. Versão do sistema operacional (ex. Windows 7, Windows 2008 Server, etc.); 

5. Deve ser capaz de gerar gráficos das categorias, separando os dispositivos conforme suas 
características; 

6. Deve suportar a coleta de informações, para classificação, usando no mínimo: 

a. DHCP; 
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b. HTTP User-Agent; 
c. MAC OUI; 
d. ActiveSync plugin; 
e. SNMP; 
f. Subnet Scanner; 
g. IF-MAP; 
h. Cisco Device Sensor; 
i. MDM; 
j. TCP Fingerprinting. 

7. Deve possuir dicionário de categorias de dispositivos pré-configurado e mecanismo de 
atualização do mesmo; 

8. Deve suportar a integração com, no mínimo, as seguintes soluções de MDM de mercado 
AirWatch, MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, MaaS 360 devendo comprovar 
a compatibilidade em documentação oficial do fabricante; 

9. Deve permitir priorização na ordem de criação dos perfis com no mínimo as seguintes 
características: 

a. Agente proprietário; 
b. HTTP User-Agent; 
c. SNMP; 
d. DHCP; 
e. MAC OUI. 

10. A solução de análise de perfil de usuários deverá permitir consultas a sua base, pela solução 
de controle de acesso para validação de dispositivos com base no seu perfil. 

  

MÓDULO DE CONTROLE DE ACESSO DE DISPOSITIVOS E USUÁRIOS 

Características Gerais 

11. A Solução deverá dar suporte a no mínimo as seguintes bases de dados: 

a. Microsoft Active Directory; 
b. Kerberos; 
c. Diretórios LDAP; 
d. OpenLDAP; 
e. PostgreSQL; 
f. Oracle 11g; 
g. MariaDB; 
h. MSSQL; 
i. Servidores de Token; 
j. Base de dados SQL interna; 
k. Lista interna estática de hosts. 

12. Deve suportar "Single Sign-on" (SSO) através de SAML v2.0; 
13. Deve implementar gerenciamento e aplicação de políticas de autorização de acesso de 

usuários com base em: 
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a. Atributos do usuário autenticado; 
b. Hora do dia, dia da semana; 
c. Tipo de dispositivo utilizado; 
d. Localização do usuário; 
e. Tipo de autenticação utilizada. 

14. Deve permitir a visualização de todas informações relativas a cada transação e autenticação 
em uma única tela, a solução deverá trazer no mínimo as seguintes informações: 

a. Data e Hora; 
b. Mac Address do dispositivo; 
c. Classificação do dispositivo; 
d. Usuário; 
e. Equipamento que requisitou a autenticação (origem); 
f. Método de autenticação utilizado; 
g. Fonte de autenticação utilizada para validação; 
h. Perfil de acesso aplicado; 
i. Atributos de entrada do protocolo utilizados na requisição (ex. RADIUS); 
j. Informações de resposta da solução para o elemento de rede; 
k. Alertas em caso de falha; 
l. LOGS já filtrados para a requisição em análise. 

15. Deve possuir Dashboard customizável, onde deve permitir a visualização de no mínimo as 
seguintes informações: 

a.  
a. Lista com últimos Alertas do sistema; 
b. Gráfico com todas as requisições de autenticação dos últimos 7 dias, incluindo 

RADIUS, TACACS+ e Autenticações Web; 
c. Gráfico com o status das autenticações aceitas e rejeitadas nos últimos 7 dias; 
d. Gráfico com a categorização dos dispositivos classificados pela solução, divididos de 

acordo com as categorias de classificação; 
e. Últimas falhas de autenticação; 
f. Gráfico com as requisições de avaliação de postura dos dispositivos, divididos em: 

  
I. Saudáveis (dentro das políticas estabelecidas); 
II. Não saudáveis (que estão fora das políticas estabelecidas); 

a.  
a. Lista com as últimas autenticações; 
b. Lista com as últimas autenticações com sucesso; 
c. Utilização de CPU do sistema, no mínimo nos últimos 30 minutos; 

16. Deve possuir base de regras e categorias de dispositivos pré-configurada e mecanismo de 
atualização da mesma; 

17. Deve suportar a integração com no mínimo as seguintes soluções de MDM de mercado 
AirWatch, MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, MaaS 360 devendo comprovar 
a compatibilidade em documentação oficial do fabricante; 
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18. Deve suportar autenticações via OAuth2, Facebook, Twitter, LinkdIn, Office365 e Google 
Apps; 

19. Deve possuir recursos integrados de AAA: RADIUS, TACACS+ e Kerberos; 
20. Deve possuir suporte aos seguintes recursos: 

a. RADIUS; 
b. RADIUS CoA; 
c. TACACS+; 
d. Web authentication; 
e. SAML v2.0; 
f. EAP-FAST (EAP-MSCHAPv2, EAP-GTC, EAP-TLS); 
g. PEAP (EAP-MSCHAPv2, EAP-GTC, EAP-TLS, EAP-PEAP-Public); 
h. TTLS (EAP-MSCHAPv2, EAP-GTC, EAP- TLS, EAP-MD5, PAP, CHAP); 
i. EAP-TLS; 
j. PAP, CHAP, MSCHAPv1, MSCHAPv2  e EAP-MD5; 
k. Windows machine authentication; 
l. MAC address authentication (dispositivos sem suporte a 802.1X); 

21. Deve suportar verificação de vulnerabilidade através de varredura de portas; 
22. Deve suportar à aplicação de políticas em ambiente com múltiplos fornecedores de Wireless, 

cabeado e VPN; 
23. Deve possuir CA integrada, para geração de certificados para os dispositivos que forem se 

autenticar na rede; 
24. Deve suportar à integração com plataforma de terceiros usando HTTP/RESTful API; 
25. Deve permitir que a solução faça consultas em bases SQL, com o objetivo de buscar 

informação a serem utilizadas durante o processo de autenticação dos usuários; 
26. Deve possuir suporte a administração através de IPv6; 
27. Deve possuir ferramenta para gerenciar os processos de credenciamento, autenticação, 

autorização e contabilização de usuários visitantes através de portal web seguro; 
28. Deve implementar a criação de grupos de autorizadores com privilégios distintos de criação 

de credenciais temporárias e atribuição de permissões de acesso aos clientes; 
29. Deve permitir realizar a autenticação dos autorizadores em base externa do tipo Microsoft 

Active Directory ou LDAP e atribuir o privilégio ao autorizador de acordo com o seu perfil; 
30. Deve implementar as funcionalidades de geração de lotes de credenciais aleatórias, 

temporárias, pré-autorizadas; 
31. Deve implementar a importação e exportação da relação de credenciais temporárias através 

de arquivos txt ou csv; 
32. Deve permitir a configuração do tempo de validade das credenciais, baseando-se na criação 

da conta ou no primeiro login da conta; 
33. Deve permitir que o visitante crie sua própria credencial temporária (autosserviço) através 

de portal web, com ou sem a necessidade de um autorizador; 
34. Deve permitir a customização do formulário de criação de credenciais, a ser preenchido pelo 

autorizador ou pelo visitante em caso de autosserviço, especificando quais informações 
cadastrais dos visitantes são obrigatórias ou opcionais; 

35. Deve permitir a customização do nível de segurança da senha temporária que será gerada 
ao visitante, especificando a quantidade mínima de caracteres e o uso de caracteres 
especiais e números para compor a senha; 

36. Deve exigir que o usuário visitante aceite o “Termo de uso da rede” a cada login ou apenas 
no primeiro login; 

37. Deve permitir o envio das credenciais aos usuários registrados através de mensagens SMS 
(Short Message Service), e-mail ou impressão local. 

Minuta de edita (0578992)         SEI 0008478-63.2018.6.02.8000 / pg. 511



 
TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS 

SEÇÃO DE LICITAÇÕES E CONTRATOS 

 

36 
 

 

 

  

 GARANTIA E SUPORTE 

38. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas; 

39. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução; 

40. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

41. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

42. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

  

ITEM 02 – LICENCIAMENTO ADICIONAL PARA SISTEMA DE GERENCIAMENTO HPE IMC 

Características técnicas mínimas 

1. Licenciamento para expansão do SISTEMA DE GERENCIAMENTO HPE IMC existente na 
infraestrutura da contratante, contemplando o quantitativo adicional mínimo de 50 
(cinquenta) dispositivos simultâneos; 

  

GARANTIA E SUPORTE 

1. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
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área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

5. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

  

ITEM 03 – LICENCIAMENTO ADICIONAL DO MÓDULO DE ANÁLISE DE TRAFEGO DO SISTEMA DE 
GERENCIAMENTO HPE IMC 

Características técnicas mínimas 

1. Licenciamento para expansão do MÓDULO DE ANÁLISE DE TRAFEGO DO SISTEMA DE 
GERENCIAMENTO HPE IMC existente na infraestrutura da contratante, contemplando o 
quantitativo adicional mínimo de 5 (cinco) dispositivos simultâneos; 

  

GARANTIA E SUPORTE 

1. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

5. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
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documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

  

ITEM 04 – LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 

Características técnicas mínimas 

2. Licenciamento para expansão da SOLUÇÃO DE ANALISE DE PERFIL E CONTROLE DE ACESSO, 
contemplando o quantitativo mínimo adicional de 500 (quinhentos) dispositivos, usuários 
corporativos ou visitantes simultâneos, independente do perfil de autenticação, seja por 
dispositivo ou usuário; 

  

GARANTIA E SUPORTE 

1. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

5. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

  

ITEM 05 – SWITCH DE DISTRIBUIÇÃO COM 16 PORTAS SFP+ E SUPORTE A MÓDULOS DE EXPANSÃO 

  

Características técnicas mínimas 
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1. Deve possuir no mínimo 16 portas 10 Gigabit Ethernet, 1000/10000 SFP+ fixas ao 
equipamento 

2. Deve suportar, através de módulos, o mínimo de 8 portas adicionais de 10 Gigabit Ethernet 
SFP+ ou 2 portas de 40 Gigabit Ethernet QSFP+; 

3. Deve suportar transceivers de 10GbE SFP+ e de 40GbE QSFP+ através da adição ou 
substituição de módulos. 

4. Deve possuir, no mínimo, 2 módulos de expansão podendo ser utilizados para uplinks ou 
dados de usuários; 

5. Deve possuir, no mínimo, 2 módulos de fonte internas ao equipamento operando em modo 
redundante; 

6. Deve possuir porta dedicada de gerenciamento; 
7. Deve possuir 1 interface RJ-45 ou serial para acesso console local; 
8. Deve possuir latência de, no máximo, 2,8 μs a 1Gbps; 
9. Deve possuir memória SDRAM de no mínimo 2 Gbytes; 
10. Deve possuir buffer de pacotes de no mínimo 13.5 Mbytes; 
11. Deve possuir capacidade de encaminhamento de no mínimo 285 Mpps; 
12. Deve possuir capacidade de comutação de no mínimo 480 Gbps; 
13. Deve possuir Certificado de Homologação na Anatel, de acordo com a Resolução nº 242; 
14. Deve possuir fonte de alimentação interna 110/220VAC; 

Disponibilidade 

15. Deve possuir capacidade de, no mínimo, 10 (dez) equipamentos membros da mesma pilha; 
16. Deve possuir fonte de alimentação interna redundante com características idênticas a fonte 

principal; 
17. Deve suportar empilhamento com banda agregada mínima de 320 Gbps sem uso de portas 

de dados de usuário para este fim. 

Switching 

18. Deve implementar VLANs baseadas em MAC; 
19. Deve suportar no mínimo 4094 VLAN IDs; 
20. Deve implementar registro dinâmico de VLAN com MVRP; 
21. Deve suportar protocolo OpenFlow 1.3; 
22. Deve implementar Jumbo frames nas interfaces Gigabit Ethernet e 10-Gigabit Ethernet 
23. Deve implementar Jumbo frames com tamanho de até 9000 bytes; 
24. Deve implementar Ethernet link aggregation; 
25. Deve implementar IEEE 802.1ad QinQ; 
26. Deve suportar agregação de link através de LACP com no mínimo 144 grupos distribuídos 

através da pilha, com cada grupo permitindo até 8 portas; 
27. Deve implementar IEEE 802.3x Flow Control; 
28. Deve implementar STP BPDU Protection (BPDU Guard); 
29. Deve implementar IEEE 802.1w Rapid Reconfiguration of Spanning Tree; 
30. Deve implementar MSTP IEEE 802.1s com pelo menos 64 instâncias; 
31. Deve implementar UDLD ou DLDP. 

Roteamento 

32. Deve implementar roteamento estático IPv4 e IPv6; 
33. Deve implementar RIP, RIPv2 e RIPng; 
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34. Deve possuir no mínimo 512 interfaces de roteamento IP (VLAN Interface) 
35. O equipamento ofertado deve implementar roteamento baseado em política (PBR) para IPv4 

e IPv6; 
36. O equipamento ofertado deve possuir tabela de roteamento com no mínimo 10 mil entradas 

IPv4 e 5 mil entradas IPv6; 
37. Deve suportar no mínimo 256 rotas estáticas; 
38. O equipamento ofertado deve permitir autenticação em servidores RADIUS e TACACS+; 
39. Deve suportar dual stack IPv4/IPv6; 
40. Deve implementar Bidirectional Forwarding Detection (BFD), suportando redução do tempo 

de convergência para OSPF e VRRP; 
41. Deve implementar OSPF v2 e OSPF v3; 
42. Deve implementar BGP. 

QoS 

43. Deve implementar 8 filas em cada porta; 
44. Deve implementar traffic shapping; 
45. Deve implementar classificação de tráfego utilizando informações de camada 2, 3 e 4; 
46. Deve implementar priorização do trafego em camada 4, baseado em número de portas 

TCP/UDP. 

Segurança 

47. Deve implementar autenticação 802.1x de múltiplos usuários por porta, simultaneamente. 
48. Deve implementar segurança orientada por identidade e controle de acesso por usuário 

através de ACLs que permitam ou negue o acesso do usuário aos recursos de rede 
específicos, com base na identidade do usuário. 

49. Atribuição VLAN automática, automaticamente atribui os usuários para a VLAN apropriada, 
com base em suas identidades. 

50. Deve implementar accounting RADIUS; 
51. Deve implementar TACACS+; 
52. Deve implementar proteção contra ataques de ARP; 
53. Deve implementar proteção contra IP spoofing (IP source guard); 
54. Deve implementar SNMP v1, v2 e v3; 
55. Deve implementar detecção de ataques maliciosos e enviar um aviso quando uma anomalia 

potencial, causada pelos ataques mal-intencionado, for detectado. 
56. Deve suportar o isolamento de portas e VLANs, de forma que uma porta ou VLAN isolada não 

possa enviar tráfego para outra porta isolada do mesmo switch; 
57. Deve implementar segurança do gerenciamento do switch em métodos de acesso CLI, GUI ou 

MIB, através de SSHv2, SSL e SNMPv3 
58. Deve implementar autenticação baseado em porta ou endereço MAC; 
59. Deve implementar autenticação utilizando navegadores web, possibilitando que clientes que 

não possuem cliente 802.1x possam autenticar; 
60. Deve suportar port-security. 

Gerenciamento 

61. Deve permitir instalação simplificada “Zero-touch provisioning” através de processo baseado 
em DHCP com a solução de software de gerenciamento; 

62. O equipamento ofertado deve permitir múltiplos arquivos de configuração; 
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63. Deve suportar espelhamento remoto; 
64. Deve implementar Secure File Transfer Protocol; 
65. Deve implementar LLDP; 
66. Deve implementar LLDP-MEd; 
67. Deve implementar SNTP v4; 
68. O equipamento ofertado deve Implementar Sflow ou Netflow; 
69. Deve implementar RFC 1213 MIB II; 
70. Deve implementar RFC 2096 IP Forwarding Table MIB; 
71. Deve implementar RFC 2571 SNMP Framework MIB; 
72. Deve implementar RFC 2572 SNMP-MPD MIB; 
73. Deve implementar RFC 2573 SNMP-Notification MIB; 
74. Deve implementar RFC 2574 SNMP USM MIB; 
75. Deve implementar RFC 2737 Entity MIB (Version 2); 
76. Deve implementar RFC 3414 SNMP-User based-SM MIB; 
77. Deve implementar RFC 3415 SNMP-View based-ACM MIB; 
78. Deve implementar RFC 2668 802.3 MAU MIB; 
79. Deve implementar RFC 3418 MIB for SNMPv3; 
80. Deve ser fornecido com a versão de software mais completa e atual disponível para o 

equipamento; 
81. Deve ser fornecido com todas as licenças de software necessárias para o funcionamento 

integral de todas as funcionalidades disponíveis para o equipamento; 
82. O equipamento ofertado deve possuir certificado de homologação na Anatel, de acordo com 

a resolução n° 242; 

Garantia e Suporte 

83. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 

84. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

85. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

86. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

87. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos equipamentos, 
indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
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documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

88. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 06 – MÓDULO COM 4 PORTAS SFP+ PARA SWITCH DE DISTRIBUIÇÃO 

  

Características técnicas mínimas 

1. Módulo de expansão para switch de distribuição; 
2. Suporte a no mínimo 4 (quatro) portas SFP+; 
3. Deve ser compatível com GBICS 100M/1G/10G SFP+; 
4. Deve possuir suporte a MACsec; 
5. Compatibilidade integral com o item 05. 

Garantia e Suporte 

6. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

7. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

8. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada; 

  

ITEM 07 – MÓDULO DE STACKING COM 4 PORTAS PARA SWITCH DE DISTRIBUIÇÃO 

 
Características técnicas mínimas 

1. Módulo de expansão para switch de distribuição; 
2. Suporte a no mínimo 4 (quatro) portas para stacking; 
3. Deve prover no mínimo 320Gbps por módulo; 
4. Deve acompanhar 1 (um) cabo de stacking compatível, com 1 (um) metro de comprimento; 
5. Compatibilidade integral com o item 05. 

  

Garantia e Suporte 
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6. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

7. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

8. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada; 

  

ITEM 08 – SWITCH DE ACESSO L3 COM 48 PORTAS GIGABIT E 4 SFP+ 

  

Características gerais 

1. Deve possuir 48 portas 10/100/1000; 
2. Deve possuir 4 portas 1/10G SFP+; 
3. Deve possuir capacidade de encaminhamento de, no mínimo, 110 Mpps; 
4. Deve possuir capacidade de comutação de, no mínimo, 176 Gbps; 
5. Deve implementar IEEE 802.3az para as portas 10/100/1000; 
6. Deve possuir uma interface de console USB; 
7. Deve suportar empilhamento de no mínimo 8 switches; 
8. Deve suportar agregação de link através de LACP com no mínimo 20 grupos distribuídos 

através da pilha, com cada grupo permitindo até 8 portas; 
9. Deve suportar a agregação de links entre diferentes membros da pilha; 
10. Deve possuir no mínimo 32.000 endereços MAC; 
11. Deve possuir latência máxima de 4μs, considerando pacotes de 64 bytes; 
12. Deve possuir buffers de, no mínimo, 12 MB; 
13. Deve implementar funcionalidade que permita a detecção de links unidirecionais; 
14. Deve implementar funcionalidade que permita a detecção de falhas de uplink; 
15. Deve implementar no mínimo 2000 VLANs simultaneamente; 
16. Deve implementar MVRP (Multiple VLAN Registration Protocol); 
17. Deve implementar LLDP (IEEE 802.1ab); 
18. Deve implementar LLDP-MED; 
19. Deve implementar Q-in-Q (IEEE 802.1ad); 
20. Deve implementar PVST+, RPVST+ ou protocolo compatível; 
21. Deve implementar MSTP (IEEE 802.1s); 
22. Deve implementar túneis VxLAN (VTEP). 

  

Funcionalidades de Camada 3 

23. Deve possuir tabela de roteamento com no mínimo 2.000 rotas IPv4 e 1.000 rotas IPv6; 
24. Deve implementar roteamento estático; 
25. Deve implementar RIP v2, com suporte a autenticação MD5 (RIPv2); 
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26. Deve implementar RIPng; 
27. Deve implementar OSPF; 
28. Deve implementar OSPFv3; 
29. Deve implementar Policy-based Routing; 
30. Deve implementar VRRP; 
31. Deve implementar VRRPv3; 
32. Deve implementar servidor DHCP; 
33. Deve implementar DHCP snooping (IPv4 e IPv6); 
34. Deve implementar DHCP relay (IPv4 e IPv6); 
35. Deve implementar Gateway mDNS, com suporte a Apple Bonjour. 

  

Multicast 

36. Deve implementar PIM-SM; 
37. Deve implementar PIM-DM; 
38. Deve implementar MLD snooping; 
39. Deve implementar IGMP v3. 

  

Software Defined Networking 

40. Deve implementar OpenFlow 1.3 ou superior; 
41. Deve implementar a separação lógica do tráfego sem suporte a OpenFlow do tráfego com 

suporte a OpenFlow através de instâncias. O tráfego OpenFlow não pode influenciar o tráfego 
não openflow no equipamento; 

42. Deve permitir configurar cada instância como modo ativo (pacotes referentes a fluxos que o 
switch não conhece são enviados para a controladora) ou modo passivo (pacotes que não se 
referem a um fluxo na tabela do switch não são enviados para a controladora); 

43. Deve implementar 16 instâncias de OpenFlow; 
44. As instâncias de OpenFlow devem suportar a associação de múltiplas VLANs; 
45. Cada instância OpenFlow configurada no equipamento deve suportar, pelo menos, a 

configuração de 3 controladores SDN; 
46. Deve permitir utilizar intervalo de portas TCP/UDP e flags de TCP como parâmetros nas 

regras de OpenFlow; 
47. Deve suportar no mínimo 16.000 regras openflow; 
48. Deve possuir interface REST API; 
49. Deve suportar configurações via JSON/REST API com, no mínimo, os seguintes métodos: GET, 

POST, PUT e DELETE; 
50. Deve suportar a criação de VLANs e ACLs no equipamento através de REST. 

  

QoS 

51. Deve implementar controle de broadcast; 
52. Deve implementar rate limiting para pacotes ICMP; 
53. Deve implementar rate limiting para tráfego broadcast e multicast; 
54. Deve implementar rate limiting baseado em tráfego classificado por uma ACL; 
55. Deve suportar espelhamento de portas; 
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56. Deve suportar espelhamento de tráfego para um switch remoto. 

  

Segurança 

57. Deve implementar controle de acesso baseado em perfis (Role Based Access Control); 
58. Deve implementar VLANs privadas, de forma que permita o isolamento de tráfego de uma 

porta de acesso das demais portas de acesso de uma mesma VLAN, permitindo acesso 
apenas para as portas de Uplink (porta promíscua); 

59. Deve implementar 802.1x; 
60. Deve implementar autenticação baseada em web; 
61. Deve implementar autenticação baseada em endereço MAC; 
62. Deve permitir a utilização simultânea de autenticação 802.1x e MAC em uma mesma porta; 
63. Deve implementar TACACS+. Não serão aceitas soluções similares; 
64. Deverá suportar o download de políticas ou ACLsl a partir de um software de Controle de 

Acesso à Rede (NAC), sem necessidade de pré-configuração das regras no switch, permitindo 
a centralização das políticas; 

65. Deve suportar integração com ferramenta de controle de acesso do mesmo fabricante que 
permita identificar automaticamente o tipo e sistema operacional dos equipamentos que se 
conectam à rede (device profiling) sem a necessidade de agentes instalados nos dispositivos; 

66. Deve suportar integração com ferramenta de controle de acesso do mesmo fabricante que 
permita verificar se a máquina está em conformidade com a política de segurança antes de 
entrar na rede, verificando, no mínimo serviços os serviços e antivírus das máquinas. Deve 
suportar os sistemas operacionais Microsoft Windows, Mac OS e Linux. 

  

Gerenciamento 

67. Deve implementar NTP com autenticação MD5; 
68. Deve implementar Time Domain Reflectometry (TDR) para testes de cabos UTP, permitindo 

identificar falhas e verificar a distância do cabo; 
69. Deve suportar duas imagens de software na flash; 
70. Deve suportar múltiplos arquivos de configuração na flash; 
71. Deve permitir o agendamento de tarefas, permitindo executar um comando em um dia e 

horário específicos; 
72. Deve suportar a autoconfiguração dos switches através de DHCP e software de 

gerenciamento, sem necessidade de nenhuma intervenção no switch (com configuração de 
fábrica); 

73. Deve suportar gerenciamento através de plataforma de nuvem do mesmo fabricante, com 
funcionalidades de gerenciamento de configuração, alertas e notificações e gerenciamento 
de firmware, sem necessidade de instalação de nenhum software ou dispositivo on-site; 

74. Deve suportar IPSec para comunicação com o sistema de gerenciamento; 
75. Deve implementar sFlow (IPv4 e IPv6); 
76. Deve possuir interface web para configuração; 
77. Deve implementar TR-69 (CPE WAN Management Protocol); 
78. Deve suportar diagnóstico de transceivers ópticos; 
79. Deve implementar Syslog sobre TLS; 
80. Deve implementar Secure SFTP (SFTP); 
81. Deve implementar SNMP v1/v2/v3; 
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82. Deve implementar funcionalidade que permita monitorar o SLA (Service Level Agreement) de 
conexões IP. Deve suportar os seguintes testes: ICMP Echo, UDP-Echo (em porta 
configurável) e TCP-Connect (em porta configurável) e Jitter UDP para voz; 

83. Deve implementar compatibilidade com o protocolo CDP para provisionamento de telefones 
IP; 

84. Deve implementar o isolamento de um Access Point rogue conectado ao switch, quando este 
for detectado por solução de WLAN do mesmo fabricante; 

85. Deve implementar a configuração automática de Access Point wireless do mesmo fabricante 
quando conectado ao switch. Devem ser suportados os seguintes parâmetros para a 
configuração automática: VLAN, CoS, largura de banda máxima; 

86. Deve suportar o encaminhamento de tráfego para controladora wireless do mesmo 
fabricante para inspeção e controle de acesso. 

  

Licenciamento 

87. Deve ser fornecido com a versão de software mais completa disponível para o equipamento; 
88. Deve ser fornecido com todas as licenças de software necessárias para o funcionamento 

integral de todas as funcionalidades disponíveis para o equipamento. 

  

Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos equipamentos, 
indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
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comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 09 – SWITCH DE ACESSO L3 COM 24 PORTAS GIGABIT E 4 SFP+ 

  

Características gerais 

1. Deve possuir 24 portas 10/100/1000; 
2. Deve possuir 4 portas 1/10G SFP+; 
3. Deve possuir capacidade de encaminhamento de, no mínimo, 95 Mpps; 
4. Deve possuir capacidade de comutação de, no mínimo, 128 Gbps; 
5. Deve implementar IEEE 802.3az para as portas 10/100/1000; 
6. Deve possuir uma interface de console USB; 
7. Deve suportar empilhamento de no mínimo 4 switches; 
8. Deve suportar agregação de link através de LACP com no mínimo 20 grupos distribuídos 

através da pilha, com cada grupo permitindo até 8 portas; 
9. Deve suportar a agregação de links entre diferentes membros da pilha; 
10. Deve possuir no mínimo 32.000 endereços MAC; 
11. Deve possuir latência máxima de 4μs, considerando pacotes de 64 bytes; 
12. Deve possuir buffers de, no mínimo, 12 MB; 
13. Deve implementar funcionalidade que permita a detecção de links unidirecionais; 
14. Deve implementar funcionalidade que permita a detecção de falhas de uplink; 
15. Deve implementar no mínimo 2000 VLANs simultaneamente; 
16. Deve implementar MVRP (Multiple VLAN Registration Protocol); 
17. Deve implementar LLDP (IEEE 802.1ab); 
18. Deve implementar LLDP-MED; 
19. Deve implementar Q-in-Q (IEEE 802.1ad); 
20. Deve implementar PVST+, RPVST+ ou protocolo compatível; 
21. Deve implementar MSTP (IEEE 802.1s); 
22. Deve implementar túneis VxLAN (VTEP); 

  

Funcionalidades de Camada 3 

23. Deve possuir tabela de roteamento com no mínimo 2.000 rotas IPv4 e 1.000 rotas IPv6; 
24. Deve implementar roteamento estático; 
25. Deve implementar RIP v2, com suporte a autenticação MD5 (RIPv2); 
26. Deve implementar RIPng; 
27. Deve implementar OSPF; 
28. Deve implementar OSPFv3; 
29. Deve implementar Policy-based Routing; 
30. Deve implementar VRRP; 
31. Deve implementar VRRPv3; 
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32. Deve implementar servidor DHCP; 
33. Deve implementar DHCP snooping (IPv4 e IPv6); 
34. Deve implementar DHCP relay (IPv4 e IPv6); 
35. Deve implementar Gateway mDNS, com suporte a Apple Bonjour; 

  

Multicast 

36. Deve implementar PIM-SM; 
37. Deve implementar PIM-DM; 
38. Deve implementar MLD snooping; 
39. Deve implementar IGMP v3; 

  

Software Defined Networking 

40. Deve implementar OpenFlow 1.3 ou superior; 
41. Deve implementar a separação lógica do tráfego sem suporte a OpenFlow do tráfego com 

suporte a OpenFlow através de instâncias. O tráfego OpenFlow não pode influenciar o tráfego 
não openflow no equipamento. 

42. Deve permitir configurar cada instância como modo ativo (pacotes referentes a fluxos que o 
switch não conhece são enviados para a controladora) ou modo passivo (pacotes que não se 
referem a um fluxo na tabela do switch não são enviados para a controladora) 

43. Deve implementar 16 instâncias de OpenFlow; 
44. As instâncias de OpenFlow devem suportar a associação de múltiplas VLANs. 
45. Cada instância OpenFlow configurada no equipamento deve suportar, pelo menos, a 

configuração de 3 controladores SDN. 
46. Deve permitir utilizar intervalo de portas TCP/UDP e flags de TCP como parâmetros nas 

regras de OpenFlow; 
47. Deve suportar no mínimo 16.000 regras openflow; 
48. Deve possuir interface REST API; 
49. Deve suportar configurações via JSON/REST API com, no mínimo, os seguintes métodos: GET, 

POST, PUT e DELETE; 
50. Deve suportar a criação de VLANs e ACLs no equipamento através de REST. 

  

QoS 

51. Deve implementar controle de broadcast; 
52. Deve implementar rate limiting para pacotes ICMP; 
53. Deve implementar rate limiting para tráfego broadcast e multicast; 
54. Deve implementar rate limiting baseado em tráfego classificado por uma ACL; 
55. Deve suportar espelhamento de portas; 
56. Deve suportar espelhamento de tráfego para um switch remoto. 

  

Segurança 

57. Deve implementar controle de acesso baseado em perfis (Role Based Access Control); 
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58. Deve implementar VLANs privadas, de forma que permita o isolamento de tráfego de uma 
porta de acesso das demais portas de acesso de uma mesma VLAN, permitindo acesso 
apenas para as portas de Uplink (porta promíscua); 

59. Deve implementar 802.1x; 
60. Deve implementar autenticação baseada em web; 
61. Deve implementar autenticação baseada em endereço MAC; 
62. Deve permitir a utilização simultânea de autenticação 802.1x e MAC em uma mesma porta; 
63. Deve implementar TACACS+. Não serão aceitas soluções similares; 
64. Deverá suportar o download de políticas ou ACLs a partir de um software de Controle de 

Acesso à Rede (NAC), sem necessidade de pré-configuração das regras no switch, permitindo 
a centralização das políticas; 

65. Deve suportar integração com ferramenta de controle de acesso do mesmo fabricante que 
permita identificar automaticamente o tipo e sistema operacional dos equipamentos que se 
conectam à rede (device profiling) sem a necessidade de agentes instalados nos dispositivos; 

66. Deve suportar integração com ferramenta de controle de acesso do mesmo fabricante que 
permita verificar se a máquina está em conformidade com a política de segurança antes de 
entrar na rede, verificando, no mínimo serviços os serviços e antivírus das máquinas. Deve 
suportar os sistemas operacionais Microsoft Windows, Mac OS e Linux. 

  

Gerenciamento 

67. Deve implementar NTP com autenticação MD5; 
68. Deve implementar Time Domain Reflectometry (TDR) para testes de cabos UTP, permitindo 

identificar falhas e verificar a distância do cabo; 
69. Deve suportar duas imagens de software na flash; 
70. Deve suportar múltiplos arquivos de configuração na flash; 
71. Deve permitir o agendamento de tarefas, permitindo executar um comando em um dia e 

horário específicos; 
72. Deve suportar a autoconfiguração dos switches através de DHCP e software de 

gerenciamento, sem necessidade de nenhuma intervenção no switch (com configuração de 
fábrica); 

73. Deve suportar gerenciamento através de plataforma de nuvem do mesmo fabricante, com 
funcionalidades de gerenciamento de configuração, alertas e notificações e gerenciamento 
de firmware, sem necessidade de instalação de nenhum software ou dispositivo on-site; 

74. Deve suportar IPSec para comunicação com o sistema de gerenciamento; 
75. Deve implementar sFlow (IPv4 e IPv6); 
76. Deve possuir interface web para configuração; 
77. Deve implementar TR-69 (CPE WAN Management Protocol); 
78. Deve suportar diagnóstico de transceivers ópticos; 
79. Deve implementar Syslog sobre TLS; 
80. Deve implementar Secure SFTP (SFTP); 
81. Deve implementar SNMP v1/v2/v3; 
82. Deve implementar funcionalidade que permita monitorar o SLA (Service Level Agreement) de 

conexões IP. Deve suportar os seguintes testes: ICMP Echo, UDP-Echo (em porta 
configurável) e TCP-Connect (em porta configurável) e Jitter UDP para voz; 

83. Deve implementar compatibilidade com o protocolo CDP para provisionamento de telefones 
IP; 

84. Deve implementar o isolamento de um Access Point rogue conectado ao switch, quando este 
for detectado por solução de WLAN do mesmo fabricante; 
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85. Deve implementar a configuração automática de Access Point wireless do mesmo fabricante 
quando conectado ao switch. Devem ser suportados os seguintes parâmetros para a 
configuração automática: VLAN, CoS, largura de banda máxima; 

86. Deve suportar o encaminhamento de tráfego para controladora wireless do mesmo 
fabricante para inspeção e controle de acesso. 

  

 Licenciamento 

87. Deve ser fornecido com a versão de software mais completa disponível para o equipamento; 
88. Deve ser fornecido com todas as licenças de software necessárias para o funcionamento 

integral de todas as funcionalidades disponíveis para o equipamento. 

  

Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos equipamentos, 
indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 
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ITEM 10 – SWITCH DE ACESSO L2 COM 24 PORTAS GIGABIT E 4 SFP 

  

1. Deve possuir 24 portas 10/100/1000; 
2. Deve possuir 4 portas 1G SFP; 
3. Deve possuir capacidade de encaminhamento de, no mínimo, 40 Mpps; 
4. Deve possuir capacidade de comutação de, no mínimo, 56 Gbps; 
5. Deve implementar IEEE 802.3az para as portas 10/100/1000; 
6. Deve possuir uma interface de console USB; 
7. Deve suportar agregação com suporte a até 8 portas por grupo; 
8. Deve possuir 16.000 endereços MAC; 
9. Deve possuir latência máxima de 4 μs para links de 1000Mbps, considerando pacotes de 64 

bytes; 
10. Deve implementar funcionalidade que permita a detecção de links unidirecionais; 
11. Deve implementar virtual stacking permitindo o gerenciamento de, no mínimo, 16 switches 

com mesmo endereço IP; 
12. Deve implementar 512 VLANs simultaneamente; 
13. Deve implementar MVRP (Multiple VLAN Registration Protocol); 
14. Deve implementar LLDP (IEEE 802.1ab); 
15. Deve implementar LLDP-MED; 
16. Deve implementar PVST+, RPVST+ ou protocolo compatível; 
17. Deve implementar MSTP (IEEE 802.1s); 
18. Deve implementar Gateway mDNS, com suporte a Apple Bonjour; 
19. Deve implementar IEEE 802.1p permitindo a classificação de tráfego com até 8 filas de 

prioridade; 
20. Deve permitir a priorização de tráfego por porta e VLAN; 
21. Deve implementar controle de broadcast; 
22. Deve implementar rate limiting para pacotes ICMP; 
23. Deve implementar rate limiting para tráfego broadcast e multicast; 
24. Deve suportar espelhamento de portas; 
25. Deve implementar RADIUS authentication; 
26. Deve implementar RADIUS accounting; 
27. Deve implementar TACACS+; 
28. Deve implementar IEEE 802.1X com, no mínimo, 8 (oito) autenticações por porta; 
29. Deve implementar SSHv2; 
30. Deve implementar SSH para IPv6; 
31. Deve implementar DHCP snooping; 
32. Deve implementar user role localmente permitindo criar políticas de acesso de segurança e 

QoS, por perfil de usuário e dispositivos; 
33. Deve implementar autenticação baseada em web; 
34. Deve implementar NTP com autenticação MD5; 
35. Deve suportar duas imagens de software na flash; 
36. Deve suportar múltiplos arquivos de configuração na flash; 
37. Deve permitir o agendamento de tarefas, permitindo executar um comando ou grupo de 

comandos em um dia e horário específicos; 
38. Deve implementar sFlow (IPv4 e IPv6) ou Netflow; 
39. Deve implementar RMON com os grupos statistics, history, alarms e events; 
40. Deve possuir interface web para configuração; 
41. Deve implementar TR-69 (CPE WAN Management Protocol); 
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42. Deve suportar a auto-configuração dos switches através de DHCP e software de 
gerenciamento, sem necessidade de nenhuma intervenção no switch (com configuração de 
fábrica); 

43. Deve suportar Digital Optical Monitoring (DOM) para transceivers ópticos; 
44. Deve implementar Syslog sobre TLS; 
45. Deve implementar SFTP ou SCP; 
46. Deve implementar SNMP v1/v2/v3 
47. Deve permitir gerar notificação caso seja excedido o limite de MACs; 
48. Deve implementar compatibilidade com o protocolo CDP para provisionamento de telefones 

IP; 
49. Deve implementar o isolamento de um Access Point rogue conectado ao switch, quando este 

for detectado por solução de WLAN do mesmo fabricante; 
50. Deve implementar a configuração automática de Access Point wireless do mesmo fabricante 

quando conectado ao switch. Devem ser suportados os seguintes parâmetros para a 
configuração automática: VLAN, CoS, largura de banda máxima; 

51. Deve ser fornecido com a versão de software mais completa disponível para o equipamento; 
52. Deve ser fornecido com todas as licenças de software necessárias para o funcionamento 

integral de todas as funcionalidades disponíveis para o equipamento; 

  

Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos equipamentos, 
indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 
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6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

   

ITEM 11 – SWITCH DE ACESSO L2 COM 48 PORTAS GIGABIT E 4SFP 

  

1. Deve possuir 48 portas 10/100/1000; 
2. Deve possuir 4 portas 1G SFP; 
3. Deve possuir capacidade de encaminhamento de, no mínimo, 77 Mpps; 
4. Deve possuir capacidade de comutação de, no mínimo, 104 Gbps; 
5. Deve implementar IEEE 802.3az para as portas 10/100/1000; 
6. Deve possuir uma interface de console USB; 
7. Deve suportar agregação com suporte a até 8 portas por grupo; 
8. Deve possuir 16.000 endereços MAC; 
9. Deve possuir latência máxima de 4 μs para links de 1000Mbps, considerando pacotes de 64 

bytes; 
10. Deve implementar funcionalidade que permita a detecção de links unidirecionais; 
11. Deve implementar virtual stacking permitindo o gerenciamento de, no mínimo, 16 switches 

com mesmo endereço IP; 
12. Deve implementar 512 VLANs simultaneamente; 
13. Deve implementar MVRP (Multiple VLAN Registration Protocol); 
14. Deve implementar LLDP (IEEE 802.1ab); 
15. Deve implementar LLDP-MED; 
16. Deve implementar PVST+, RPVST+ ou protocolo compatível; 
17. Deve implementar MSTP (IEEE 802.1s); 
18. Deve implementar Gateway mDNS, com suporte a Apple Bonjour; 
19. Deve implementar IEEE 802.1p permitindo a classificação de tráfego com até 8 filas de 

prioridade; 
20. Deve permitir a priorização de tráfego por porta e VLAN; 
21. Deve implementar controle de broadcast; 
22. Deve implementar rate limiting para pacotes ICMP; 
23. Deve implementar rate limiting para tráfego broadcast e multicast; 
24. Deve suportar espelhamento de portas; 
25. Deve implementar RADIUS authentication; 
26. Deve implementar RADIUS accounting; 
27. Deve implementar TACACS+; 
28. Deve implementar IEEE 802.1X com, no mínimo, 8 (oito) autenticações por porta; 
29. Deve implementar SSHv2; 
30. Deve implementar SSH para IPv6; 
31. Deve implementar DHCP snooping; 
32. Deve implementar user role localmente permitindo criar políticas de acesso de segurança e 

QoS, por perfil de usuário e dispositivos; 
33. Deve implementar autenticação baseada em web; 
34. Deve implementar NTP com autenticação MD5; 
35. Deve suportar duas imagens de software na flash; 
36. Deve suportar múltiplos arquivos de configuração na flash; 
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37. Deve permitir o agendamento de tarefas, permitindo executar um comando ou grupo de 
comandos em um dia e horário específicos; 

38. Deve implementar sFlow (IPv4 e IPv6) ou Netflow; 
39. Deve implementar RMON com os grupos statistics, history, alarms e events; 
40. Deve possuir interface web para configuração; 
41. Deve implementar TR-69 (CPE WAN Management Protocol); 
42. Deve suportar a auto-configuração dos switches através de DHCP e software de 

gerenciamento, sem necessidade de nenhuma intervenção no switch (com configuração de 
fábrica); 

43. Deve suportar Digital Optical Monitoring (DOM) para transceivers ópticos; 
44. Deve implementar Syslog sobre TLS; 
45. Deve implementar SFTP ou SCP; 
46. Deve implementar SNMP v1/v2/v3 
47. Deve permitir gerar notificação caso seja excedido o limite de MACs; 
48. Deve implementar compatibilidade com o protocolo CDP para provisionamento de telefones 

IP; 
49. Deve implementar o isolamento de um Access Point rogue conectado ao switch, quando este 

for detectado por solução de WLAN do mesmo fabricante; 
50. Deve implementar a configuração automática de Access Point wireless do mesmo fabricante 

quando conectado ao switch. Devem ser suportados os seguintes parâmetros para a 
configuração automática: VLAN, CoS, largura de banda máxima; 

51. Deve ser fornecido com a versão de software mais completa disponível para o equipamento; 
52. Deve ser fornecido com todas as licenças de software necessárias para o funcionamento 

integral de todas as funcionalidades disponíveis para o equipamento. 

  

Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos equipamentos, 
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indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 12 – GBIC 10GB PARA ATÉ 300M 

  

Características técnicas mínimas 

1. Deve ser do tipo SFP+ de 10GBASE-SR com conector LC; 
2. Compatibilidade integral com os Itens 5, 6, 8 e 9. 

  

Garantia e Suporte 

3. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

4. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

5. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

  

ITEM 13 – CABO DAC 10GB DE 1M 

  

Características técnicas mínimas 

1. Cabo metálico com conector tipo SFP+ para ligação de duas unidades de switch em 10 Gbps; 
2. Cabo com comprimento mínimo de 1 (um) metro; 
3. Compatibilidade integral com os itens 5, 6, 8 e 9. 

  

Garantia e Suporte 
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4. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

5. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

6. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 14 – CABO DAC 10GB DE 3M 

  

Características técnicas mínimas 

1. Cabo metálico com conector tipo SFP+ para ligação de duas unidades de switch em 10 Gbps; 
2. Cabo com comprimento mínimo de 3 (três) metros; 
3. Compatibilidade integral com os itens 5, 6, 8 e 9. 

  

Garantia e Suporte 

4. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

5. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

6. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 15 – GBIC 1GB PARA ATÉ 500M 

  

Características técnicas mínimas 

1. Deve ser do tipo SFP de 1G BASE-SX com conector LC; 
2. Compatibilidade integral com os Itens 5, 6, 8, 9, 10 e 11. 
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Garantia e Suporte 

3. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

4. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

5. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 16 – SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE TECNOLOGIA PARA SWITCHS DE REDE 

  

Características Gerais 

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das 14:00 às 18:00) 
presencialmente no TRE-AL ou remotamente conforme necessidades da CONTRATANTE; 

  

Implantação 

2. Instalação e configuração de no mínimo 10 (dez) switchs de rede, contemplando: 
3. Configuração básica de acesso a gerencia via rede; 
4. Gerencia e monitoramento em MÓDULO DE GERENCIA DE REDE; 
5. Configuração de autenticação de usuários em MÓDULO DE CONTROLE DE ACESSO; 
6. Configuração de no mínimo 10 (dez) VLANs; 
7. Configuração de stacking de 2 (duas) pilhas com no máximo 4 (quatro) switchs; 
8. Configuração de agregação de links em até 10 (dez) switchs com no máximo 4 (quatro) 

portas por dispositivo. 

  

Transferência de Tecnologia 

9. O treinamento deverá ser no realizado na modalidade workshop com tarefas práticas hands-
on, visando assim a melhor fixação dos temas abordados com foco direto na explicação da 
tecnologia dos produtos ofertados como também nas rotinas de configuração, 
gerenciamento, administração e operação dos mesmos, devendo ter duração mínima de 24 
(vinte e quatro) horas onde serão abordados no mínimo os seguintes tópicos: 

a. Configuração inicial e acesso a gerencia; 
b. Configuração de VLANS; 
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c. Configuração de autenticação de usuários em MÓDULO DE CONTROLE DE ACESSO; 
d. Configuração de empilhamento de switchs; 
e. Configuração de agregação de links; 
f. Configuração de switchs para MÓDULO DE GERENCIA DE REDE; 
g. Configuração de switchs para MÓDULO DE ANÁLISE DE TRÁFEGO. 

  

ITEM 17 - SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE TECNOLOGIA DO MÓDULO DE 
CONTROLE DE ACESSO 

  

Características Gerais 

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das 14:00 às 18:00) 
presencialmente no TRE-AL ou remotamente conforme necessidades da CONTRATANTE; 

  

Implantação 

2. Instalação e configuração de 1 (uma) instância do serviço controle de acesso, contemplando 
configurações básicas para acesso à rede, dimensionamento, configuração de 
armazenamento; 

3. Configuração de autenticação em Active Directory para usuários corporativos; 
4. Configuração de autenticação de visitantes com portal de autosserviço para criação de 

usuários; 
5. Configuração de no mínimo 10 (dez) dispositivos de rede para autenticação na solução. 

  

Transferência de Tecnologia 

6. O treinamento deverá ser no realizado na modalidade workshop com tarefas práticas hands-
on, visando assim a melhor fixação dos temas abordados com foco direto na explicação da 
tecnologia da solução como também nas rotinas de configuração, gerenciamento, 
administração e operação da mesma devendo ter duração mínima de 24 (vinte e quatro) 
horas onde será abordado no mínimo os seguintes tópicos: 

a. Configuração de Active Directory como base de autenticação; 
b. Configuração de autenticação de usuários corporativos; 
c. Configuração de autenticação de usuários visitantes; 
d. Configuração de portal de autosserviço; 
e. Configuração de autenticação e autorização com RADIUS. 

  

ITEM 18 – TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE SWITCHES 

  

Características Gerais 
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1. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do fabricante no 
Treinamento Básico de Administração dos Switches para 01 (um) profissional da contratante; 

2. O voucher deverá ter validade de pelo menos 12 (doze) meses; 
3. O treinamento deverá ser de acordo com o calendário de treinamento do fabricante e 

ministrado em centro oficial de treinamento do mesmo ou remotamente, utilizando 
tecnologia de ensino a distância; 

4. Deverá ser ministrado por profissional devidamente credenciado junto ao fabricante e apto a 
entregar o respectivo; 

5. O treinamento deverá compreender a explicação da tecnologia da solução como também das 
rotinas de configuração, gerenciamento, administração e operação da mesma; 

6. O treinamento deverá ter carga horária mínima de 24 (vinte e quatro) horas, ministrado no 
período de 08:00 às 12:00 e das 14:00 às 18:00. 

  

ITEM 19 – TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE ACESSO 

  

Características Gerais 

1. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do fabricante no 
Treinamento da Solução de Controle de Acesso para 01 (um) profissional da contratante; 

2. O voucher deverá ter validade de pelo menos 12 (doze) meses; 
3. O treinamento deverá ser de acordo com o calendário de treinamento do fabricante e 

ministrado em centro oficial de treinamento do mesmo ou remotamente, utilizando 
tecnologia de ensino a distância; 

4. Deverá ser ministrado por profissional devidamente credenciado junto ao fabricante e apto a 
entregar o respectivo; 

5. O treinamento deverá compreender a explicação da tecnologia da solução como também das 
rotinas de configuração, gerenciamento, administração e operação da mesma; 

6. O treinamento deverá ter carga horária mínima de 40 (Quarenta) horas, ministrado no 
período de 08:00 às 12:00 e das 14:00 às 18:00; 

  

  

LOTE 02 – SOLUÇÃO DE REDE WIRELESS 

 
  

ITEM 20 – SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO PARA SOLUÇÃO DE REDE 
WIRELESS 

LICENCIAMENTO 

1. Licenciamento da SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO, contemplando o 
quantitativo mínimo de 1.000 (um mil) dispositivos, usuários corporativos ou visitantes 
simultâneos, independente do perfil de autenticação, seja por dispositivo ou usuário; 

2. Caso a solução ofertada necessite de licenciamento específico para credenciamento dos 
dispositivos, usuários (corporativos ou visitantes), deverá ser fornecido o quantitativo 
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solicitado para ambos, de forma que a solução realize a análise de perfil e o controle de 
acesso dos 1.000 (um mil) dispositivos ou usuários (corporativos ou visitantes) simultâneos. 

  

MÓDULO DE ANÁLISE DE PERFIL DE DISPOSITIVO 

Características Gerais Modulo de Análise de Perfil de Dispositivo 

3. Deve implementar funcionalidade de classificação automática criando perfis de dispositivos, 
de forma a descobrir, classificar e agrupar os dispositivos conectados na rede; 

4. Deve categorizar os dispositivos em pelo menos 3 níveis: 

d. Por tipo de dispositivo (ex. Computador, Smartdevice, impressora, etc.); 
e. Por sistema operacional (ex. Windows, Linux, MacOS, etc.); 
f. Versão do sistema operacional (ex. Windows 7, Windows 2008 Server, etc.); 

5. Deve ser capaz de gerar gráficos das categorias separando os dispositivos conforme suas 
características; 

6. Deve suportar a coleta de informações, para classificação, usando no mínimo: 

k. DHCP; 
l. HTTP User-Agent; 
m. MAC OUI; 
n. ActiveSync plugin; 
o. SNMP; 
p. Subnet Scanner; 
q. IF-MAP; 
r. Cisco Device Sensor; 
s. MDM; 
t. TCP Fingerprinting. 

7. Deve possuir dicionário de categorias de dispositivos pré-configurado e mecanismo de 
atualização do mesmo; 

8. Deve suportar a integração com, no mínimo, as seguintes soluções de MDM de mercado 
AirWatch, MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, MaaS 360 devendo comprovar 
a compatibilidade em documentação oficial do fabricante; 

9. Deve permitir priorização na ordem de criação dos perfis com no mínimo as seguintes 
características: 

f. Agente proprietário; 
g. HTTP User-Agent; 
h. SNMP; 
i. DHCP; 
j. MAC OUI. 

10. A solução de análise de perfil de usuários deverá permitir consultas a sua base, pela solução 
de controle de acesso para validação de dispositivos com base no seu perfil. 
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MÓDULO DE CONTROLE DE ACESSO DE DISPOSITIVOS E USUÁRIOS 

Características Gerais 

11. A Solução deverá dar suporte a no mínimo as seguintes bases de dados: 

n. Microsoft Active Directory; 
o. Kerberos; 
p. Diretórios LDAP; 
q. OpenLDAP; 
r. PostgreSQL; 
s. Oracle 11g; 
t. MariaDB; 
u. MSSQL; 
v. Servidores de Token; 
w. Base de dados SQL interna; 
x. Lista interna estática de hosts. 

12. Deve suportar "Single Sign-on" (SSO) através de SAML v2.0; 
13. Deve implementar gerenciamento e aplicação de políticas de autorização de acesso de 

usuários com base em: 

f. Atributos do usuário autenticado; 
g. Hora do dia, dia da semana; 
h. Tipo de dispositivo utilizado; 
i. Localização do usuário; 
j. Tipo de autenticação utilizada. 

14. Deve permitir a visualização de todas informações relativas a cada transação e autenticação 
em uma única tela, a solução deverá trazer no mínimo as seguintes informações: 

m. Data e Hora; 
n. Mac Address do dispositivo; 
o. Classificação do dispositivo; 
p. Usuário; 
q. Equipamento que requisitou a autenticação (origem); 
r. Método de autenticação utilizado; 
s. Fonte de autenticação utilizada para validação; 
t. Perfil de acesso aplicado; 
u. Atributos de entrada do protocolo utilizados na requisição (ex. RADIUS); 
v. Informações de resposta da solução para o elemento de rede; 
w. Alertas em caso de falha; 
x. LOGS já filtrados para a requisição em análise. 

15. Deve possuir Dashboard customizável, onde deve permitir a visualização de no mínimo as 
seguintes informações: 

a.  
a. Lista com últimos Alertas do sistema; 
b. Gráfico com todas as requisições de autenticação dos últimos 7 dias, incluindo 

RADIUS, TACACS+ e Autenticações Web; 
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c. Gráfico com o status das autenticações aceitas e rejeitadas nos últimos 7 dias; 
d. Gráfico com a categorização dos dispositivos classificados pela solução, divididos de 

acordo com as categorias de classificação; 
e. Últimas falhas de autenticação; 
f. Gráfico com as requisições de avaliação de postura dos dispositivos, divididos em: 

  
I. Saudáveis (dentro das políticas estabelecidas); 
II. Não saudáveis (que estão fora das políticas estabelecidas); 

a.  
a. Lista com as últimas autenticações; 
b. Lista com as últimas autenticações com sucesso; 
c. Utilização de CPU do sistema, no mínimo nos últimos 30 minutos; 

16. Deve possuir base de regras e categorias de dispositivos pré-configurada e mecanismo de 
atualização da mesma; 

17. Deve suportar a integração com no mínimo as seguintes soluções de MDM de mercado 
AirWatch, MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, MaaS 360 devendo comprovar 
a compatibilidade em documentação oficial do fabricante; 

18. Deve suportar autenticações via OAuth2, Facebook, Twitter, LinkdIn, Office365 e Google 
Apps; 

19. Deve possuir recursos integrados de AAA: RADIUS, TACACS+ e Kerberos; 
20. Deve possuir suporte aos seguintes recursos: 

m. RADIUS; 
n. RADIUS CoA; 
o. TACACS+; 
p. Web authentication; 
q. SAML v2.0; 
r. EAP-FAST (EAP-MSCHAPv2, EAP-GTC, EAP-TLS); 
s. PEAP (EAP-MSCHAPv2, EAP-GTC, EAP-TLS, EAP-PEAP-Public); 
t. TTLS (EAP-MSCHAPv2, EAP-GTC, EAP- TLS, EAP-MD5, PAP, CHAP); 
u. EAP-TLS; 
v. PAP, CHAP, MSCHAPv1, MSCHAPv2, e EAP-MD5; 
w. Windows machine authentication; 
x. MAC address authentication (dispositivos sem suporte a 802.1X); 

21. Deve suportar verificação de vulnerabilidade através de varredura de portas; 
22. Deve suportar à aplicação de políticas em ambiente com múltiplos fornecedores de Wireless, 

cabeado e VPN; 
23. Deve possuir CA integrada, para geração de certificados para os dispositivos que forem se 

autenticar na rede; 
24. Deve suportar à integração com plataforma de terceiros usando HTTP/RESTful API; 
25. Deve permitir que a solução faça consultas em bases SQL, com o objetivo de buscar 

informação a serem utilizadas durante o processo de autenticação dos usuários; 
26. Deve possuir suporte a administração através de IPv6; 
27. Deve possuir ferramenta para gerenciar os processos de credenciamento, autenticação, 

autorização e contabilização de usuários visitantes através de portal web seguro; 
28. Deve implementar a criação de grupos de autorizadores com privilégios distintos de criação 

de credenciais temporárias e atribuição de permissões de acesso aos clientes; 

Minuta de edita (0578992)         SEI 0008478-63.2018.6.02.8000 / pg. 538



 
TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS 

SEÇÃO DE LICITAÇÕES E CONTRATOS 

 

63 
 

 

 

29. Deve permitir realizar a autenticação dos autorizadores em base externa do tipo Microsoft 
Active Directory ou LDAP e atribuir o privilégio ao autorizador de acordo com o seu perfil; 

30. Deve implementar as funcionalidades de geração de lotes de credenciais aleatórias, 
temporárias, pré-autorizadas; 

31. Deve implementar a importação e exportação da relação de credenciais temporárias através 
de arquivos txt ou csv; 

32. Deve permitir a configuração do tempo de validade das credenciais, baseando-se na criação 
da conta ou no primeiro login da conta; 

33. Deve permitir que o visitante crie sua própria credencial temporária (autosserviço) através 
de portal web, com ou sem a necessidade de um autorizador; 

34. Deve permitir a customização do formulário de criação de credenciais, a ser preenchido pelo 
autorizador ou pelo visitante em caso de autosserviço, especificando quais informações 
cadastrais dos visitantes são obrigatórias ou opcionais; 

35. Deve permitir a customização do nível de segurança da senha temporária que será gerada 
ao visitante, especificando a quantidade mínima de caracteres e o uso de caracteres 
especiais e números para compor a senha; 

36. Deve exigir que o usuário visitante aceite o “Termo de uso da rede” a cada login ou apenas 
no primeiro login; 

37. Deve permitir o envio das credenciais aos usuários registrados através de mensagens SMS 
(Short Message Service), e-mail ou impressão local. 

  

GARANTIA E SUPORTE 

38. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 

39. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

40. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

41. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

42. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 
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ITEM 21 – SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS 

LICENCIAMENTO 

1. Deverá ser entregue o quantitativo mínimo de licenças para o gerenciamento simultâneo de 
50 (cinquenta) Pontos de acesso; 

CARACTERÍSTICAS GERAIS 

2. A solução de gerenciamento deverá administrar a configuração dos Pontos de acesso de 
forma centralizada; 

3. A solução de gerenciamento deverá possuir integração com o HPE IMC em console única de 
gerenciamento; 

4. A solução de gerenciamento de rede wireless deverá suportar, em arquitetura de 
controladora distribuída, a capacidade de gerenciar no mínimo 120 (cento e vinte) pontos de 
acesso por cluster e no mínimo um total de 20 (vinte) clusters; 

5. A solução de gerenciamento, em arquitetura de controladora física ou virtual, deverá 
suportar no mínimo 2400 pontos de acesso; 

6. Deve ser obrigatoriamente do mesmo fabricante dos pontos de acesso e controladores; 
7. Permitir a configuração e gerenciamento através de browser padrão (http, https); 
8. Permitir que os eventos sejam gravados remotamente utilizando Syslog; 
9. Prover organização hierárquica de equipamentos, permitindo que um equipamento receba as 

configurações lógicas e as replique a outros equipamentos; 
10. Possuir capacidade de projeto automatizado de redes sem fio nos padrões 802.11a, 802.11b 

e 802.11g, 802.11n e 802.11ac, segundo a geografia do prédio (planta); 
11. Considerar a área de cobertura e a banda por usuário desejada; 
12. Possibilitar a importação de plantas baixas nos formatos dwg e jpg; 
13. Permitir a visualização de alertas da rede em tempo real; 
14. Permitir a visualização de eventuais áreas sem cobertura de RF (áreas de sombra); 
15. Monitorar o desempenho da rede wireless, consolidando informações de rede tais como: 

a. Níveis de ruído; 
b. Relação sinal-ruído; 
c. Interferência; 
d. Potência de sinal. 

16. Possuir capacidade de listagem on-line da localização de usuário, endereço IP, endereço 
MAC, nível de potência de recepção e dados de associação e de autenticação 802.1x; 

17. Deve possuir informação visual e gráfica, na planta baixa dos andares, para: 

a. Visualização dos Pontos de acesso instalados, com estado de funcionamento; 
b. Visualização do mapa de calor de RF (Heatmap); 
c. Localização de ativos conectados à rede (equipamentos 802.11); 
d. Localização de Pontos de acesso rogue. 

18. Caso esta funcionalidade não esteja disponível no sistema de gerência, deve ser fornecido 
software, do mesmo fabricante, para atender este item, contemplando todos os dispositivos 
licenciados e com redundância 1+1; 
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19. Possuir capacidade de identificação e listagem dos rádios vizinhos e respectivos SSID/BSSID 
que podem ser percebidos por cada Ponto de acesso; 

20. Possuir capacidade de configuração gráfica completa do controlador WLAN seja ela física, 
virtual ou distribuída e respectivos Pontos de acesso; 

21. Possuir capacidade de geração de relatórios dos seguintes tipos: 

a. Listagem de clientes Wireless; 
b. Listagem de Pontos de acesso; 
c. Informações de Configuração dos Controladores WLAN; 
d. Utilização da rede; 
e. Detalhes dos Pontos de acesso não autorizados (rogues) detectados. 

22. Suportar SSH, HTTP/HTTPS, SSL, Telnet; 
23. Possuir ferramentas de debug e log de eventos para depuração e gerenciamento em 

primeiro nível; 
24. Implementar os padrões abertos de gerência de rede SNMPv2c e SNMPv3, incluindo a 

geração de traps; 
25. Possuir suporte a MIB II, conforme RFC 1213; 
26. Implementar a MIB privativa que forneça informações relativas ao funcionamento do 

equipamento; 
27. Possibilitar a obtenção da configuração do equipamento através do protocolo SNMP; 
28. Possibilitar a obtenção via SNMP de informações de capacidade e desempenho da CPU, 

memória e portas; 
29. Possibilitar a gerência e identificação individualizada de cada Ponto de acesso remoto; 
30. Permitir a administração centralizada dos Pontos de acesso sem a necessidade de configurar 

os mesmos individualmente; 
31. Possibilitar a identificação de paredes e divisórias com respectivos níveis de atenuação por 

tipo (alvenaria, vidro, drywall e divisória); 
32. Possibilitar a importação de plantas baixas nos formatos gráficos (CAD, dwg, jpg, gif e png); 
33. Deve disponibilizar em painel gráfico de controle informações referentes à: 

a. Sistemas operacionais e tipos de dispositivos que estão se conectando a rede; 
b. Informações sobre os tipos de aplicações mais utilizados; 
c. Informações sobre usuários conectados. 

34. Deve possuir informação sobre possíveis ameaças a rede detectadas pelos sistemas 
gerenciados; 

35. Deve possibilitar criação de regras de detecção de ameaças e correlacionar todos os 
dispositivos gerenciados. 

  

 
ITEM 22 – LICENÇAS ADICIONAIS PARA SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS 

Características técnicas mínimas 

1. Licença para expansão da SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS, contemplando 
o quantitativo adicional mínimo de 1 (um) ponto de acesso simultâneo; 

Minuta de edita (0578992)         SEI 0008478-63.2018.6.02.8000 / pg. 541



 
TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS 

SEÇÃO DE LICITAÇÕES E CONTRATOS 

 

66 
 

 

 

2. Cada unidade deve ser fornecida com todas as licenças de software necessárias para o 
funcionamento integral de todas as funcionalidades disponíveis para SOLUÇÃO DE 
GERENCIAMENTO DE REDE WIRELESS especificada nesse edital. 

  

GARANTIA E SUPORTE 

1. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

5. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

  

  

ITEM 23 – LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 

Características técnicas mínimas 

3. Licenciamento para expansão da SOLUÇÃO DE ANALISE DE PERFIL E CONTROLE DE ACESSO, 
contemplando o quantitativo mínimo adicional de 500 (quinhentos) dispositivos, usuários 
corporativos ou visitantes simultâneos, independente do perfil de autenticação, seja por 
dispositivo ou usuário; 

  

GARANTIA E SUPORTE 

6. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
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modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 

7. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

8. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

9. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

10. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

 
  

ITEM 24 – CONTROLADORA WLAN 

Características gerais 

1. Solução baseada em hardware ou software específico, do tipo appliance físico ou virtual, do 
mesmo fabricante dos pontos de acesso e software de gerência; 

2. Deve estar licenciado para controle de, no mínimo, 50 (cinquenta) pontos de acesso, 
podendo ser expandido em no mínimo, 250 (duzentos e cinquenta) pontos de acesso através 
de licenciamento adicional; 

3. Permitir a conexão simultânea de, no mínimo, 4.000 clientes wireless; 
4. Permitir a gravação de eventos por meio do protocolo syslog; 
5. Acesso ao sistema através de cliente com browser padrão (http, https, Java); 
6. Permitir operação em modo mesh; 
7. Permitir o uso de múltiplos SSIDs simultaneamente; 
8. Prover tempo de fast-roaming intra-switch inferior a 25 milissegundos; 
9. Prover tempo de fast-roaming inter-switch em camada 2, inferior a 100 milissegundos; 
10. Permitir conexão entre APs sem a necessidade de conexão cabeada, implementando assim 

uma rede padrão mesh; 
11. Deve suportar 802.11e com WMM, U-APSD e T-SPEC; 
12. Gerenciar centralizadamente a autenticação de usuários; 
13. Implementar protocolo de autenticação para controle do acesso administrativo a solução 

com mecanismos de AAA; 
14. Possuir base de dados de usuários interna para autenticação de usuários convidados / 

temporários (acesso guest); 
15. Permitir autenticação em no mínimo os seguintes sistemas de base de dados de usuários 

Microsoft Active Directory, Cisco ACS server, FreeRadius, entre outros; 
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16. Realizar o provisionamento de usuários convidados (guests) através de interface Web por 
meio de um usuário administrativo com permissões mínimas, exclusivas para este fim; 

17. Possuir suporte a autenticação IEEE 802.1X, com pelo menos os seguintes métodos EAP: EAP-
MD5, PEAP/EAP-GTC, PEAP/EAP-MSCHAPv2, EAP-TLS com utilização de base de usuários 
interna ou servidor RADIUS externo; 

18. Suportar as especificações: IEEE 802.1x; 
19. Deverá suportar os seguintes métodos EAP-PEAP, EAP-TLS e EAP-TTLS; 
20. Possuir suporte a autenticação IEEE 802.1X, com o método PEAP/EAP-GTC, e com utilização 

de base de usuários LDAP externa; 
21. Permitir a seleção/uso de servidor Radius ou LDAP com base no SSID; 
22. Suportar a autenticação de usuários conectados à rede cabeada através das portas do 

controlador; 
23. Possuir o recurso de EAP Offload para terminação do túnel EAP no próprio controlador; 
24. Deve suportar utilização de Portal Captivo externo ao controlador; 
25. Permitir a autenticação (através de endereço MAC, Portal Captivo ou IEEE 802.1X) de 

usuários conectados à rede WLAN (wireless) ou usuários conectados às portas cabeadas do 
controlador. Também deverá permitir a autenticação de usuário e de máquina por meio de 
IEEE 802.1x; 

26. Oferecer recurso de Portal Captivo (Captive Portal) com suporte a múltiplos portais 
simultaneamente; 

27. Implementar associação dinâmica de usuário a VLAN, com base nos parâmetros da etapa de 
autenticação; 

28. Implementar Qualidade de Serviço com a marcação de pacotes utilizando Diffserv e suporte 
a 802.1p para QoS de rede; 

29. Possibilitar roaming com integridade de sessão, dando suporte a aplicações em tempo real, 
tais como, VoIP, VoWLAN, videoconferência, dentre outras; 

30. Permitir portais captivos externos a controladora; 
31. A controladora deve possuir funcionalidade de conexão Site to Site VPN utilizando padrão 

Ipsec. Caso a solução fornecida não possua a funcionalidade, será aceita solução de VPN 
adicional integrada; 

32. Deve permitir o tunelamento do trafego de dados de usuários mesmo em redes L3, não 
sendo necessário estender VLANs até o Ponto de Acesso, inclusive em MANs e WANs; 

33. Implementar segurança IEEE 802.11i; 
34. Suportar a criptografia centralizada com os seguintes protocolos: AES-CCMP, TKIP e WEP; 
35. Suportar, no mínimo, 2000 VLANs; 
36. Implementar o protocolo 802.1w (Rapid Spanning Tree); 
37. Oferecer suporte a roteamento e switching de camadas L2 e L3; 
38. Possuir o recurso de criação de Pools de VLAN para permitir a escalabilidade de redes; 
39. Possuir servidor DHCP embutido; 
40. Suportar o protocolo VRRP para redundância de controladores; 
41. Deve suportar redundância de controladores nos modos: 

a. 1+1; 
b. N+1; 
c. Ativo-Ativo; 
d. Ativo-Standby; 

42. Oferecer os recursos de mobilidade entre VLANs para roaming de camada 2; 
43. Oferecer os recursos de Proxy de endereços IP e Proxy DHCP para roaming entre redes (L3) 
44. Deve implementar northbound APIs para realização de integrações com aplicações de 

terceiros para fins de monitoramento e visibilidade. Caso seja necessário, deve ser ofertado 
licenças para ativação desse recurso; 

45. Implementar tagging de VLANs através do protocolo 802.1Q; 
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46. Implementar o protocolo 802.1d para Spanning Tree (STP); 
47. O controlador WLAN poderá estar diretamente e/ou remotamente conectado aos APs por ele 

gerenciados, inclusive via roteamento nível 3 da camada OSI 
48. Se um controlador WLAN ou AP controlador falhar, os APs relacionados deverão se associar a 

um controlador WLAN alternativo de forma automática, não permitindo que a rede wireless 
se torne inoperante; 

49. Realizar a descoberta automática dos APs na infraestrutura wireless; 
50. Permitir o controle dos APs mediante a conexão através de topologia MESH (WiFi Mesh); 
51. A rede MESH deverá oferecer comportamento determinístico da topologia da rede MESH; 
52. A rede MESH deverá prover auto-redundância das camadas física (RF) e Layer 2 com 

comportamento determinístico; 
53. Permitir a conexão de APs de maneira remota e segura; 
54. Conectar APs através de redes públicas e/ou privadas com garantia de segurança através de 

conexão criptografada; 
55. Permitir a propagação de SSIDs de maneira segura para qualquer AP legitimamente 

cadastrado na controladora, independentemente de onde este AP esteja conectado; 
56. Permitir a autenticação do AP remoto através de certificado digital ou de usuário e senha 

cadastrados em servidor AD e Radius; 
57. Gerenciar o tráfego dos APs centralizadamente; 
58. Administrar a configuração dos AP’s; 
59. Deve permitir administrar centralizadamente todos os aspectos de segurança da rede WLAN 

através de firewall integrado à solução de rede sem fio, caso a solução ofertada não possua 
solução de firewall nativa na controladora WLAN deverá ser ofertado firewall externo com 
capacidade para atender toda a solução; 

60. Permitir o bloqueio de comunicação entre clientes wireless – L2 bridging; 
61. Implementar filtros baseados em protocolos e em endereços MAC; 
62. Implementar padrão IEEE 802.11h; 
63. Realizar o controle de autorização baseado em perfis de acesso; 
64. Permitir que seja configurado um perfil de acesso, com regras aplicadas de firewall, para o 

qual será direcionado o usuário após sua autenticação; 
65. Possuir o recurso de “blacklisting” contra ataques ao Firewall e à rede wireless, evitando que 

um determinado cliente se associe à rede wireless caso viole políticas definidas de Firewall 
ou execute algum ataque à rede WLAN de endereços MAC de APs do sistema; 

66. O Firewall deverá implementar os recursos de NAT (Network Address Translation) tanto para 
destino quanto para origem; 

67. Implementar listas de controle de acesso (ACLs); 
68. Oferecer detecção e proteção integrada de ataques de negação de serviços TCP, ICMP; 
69. Permitir o espelhamento de sessão e logs detalhados por pacote a fim de possibilitar análises 

forenses; 
70. Permitir a aplicação de políticas de camada 4, de acordo com as características do usuário. 

Por exemplo, um usuário que pertença ao grupo de gerentes (cadastrado no Radius ou Active 
Directory) terá permissão de acesso ao protocolo FTP no servidor de ERP; 

71. Permitir derivação de políticas de acesso. Por exemplo, um usuário pode pertencer a um 
grupo ao qual foram atribuídas políticas de acesso em camada 4, porém, caso esteja 
utilizando um dispositivo de voz, o tráfego SIP passará a ter prioridade através de aplicação 
de QoS; 

72. Permitir a criação de políticas com base em horários e na localização do usuário. Por 
exemplo: bloquear o tráfego do protocol FTP após às 18 horas. 

73. O Firewall deverá ser integrado à rede WLAN de modo a permitir a desassociação de usuários 
da rede sem fio WLAN com base na violação de políticas de tráfego. Por exemplo: 
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desassociar da rede WLAN e colocar em quarentena o Notebook com endereço MAC 
XX:XX:XX se o usuário tentar fazer um telnet para o servidor ABC; 

74. Otimizar o desempenho e a cobertura da radiofrequência; 
75. Ajustar automaticamente os canais de modo a otimizar a cobertura de rede e mudar as 

condições de RF baseado em performance; 
76. Detectar interferência e ajustar parâmetros de RF, evitando problemas de cobertura e 

controle da propagação indesejada de RF; 
77. Implementar varredura de RF contínua, programada ou sob demanda, com identificação de 

APs ou clientes irregulares; 
78. Deve implementar a tecnologia de “Channel load balancing”, permitindo que clientes sejam 

automaticamente distribuídos entre Pontos de Acesso adjacentes operando em canais 
distintos, com o objetivo de balancear a carga entre os Pontos de Acesso; 

79. Deve implementar a tecnologia de “Band Steering/Select”, permitindo que clientes com 
suporte a faixa de frequência de 5GHz se conectem aos Pontos de Acesso utilizando, 
preferencialmente, a faixa de 5GHz; 

80. Implementar varredura de RF nas bandas 802.11a, 802.11b, 802.11g, 802.1n e 802.11ac 
para identificação de ataques e APs intrusos não autorizados (rogues); 

81. Realizar a varredura no canal de operação do AP sem impacto na performance da rede 
WLAN; 

82. Permitir a varredura em todos os canais possíveis de RF para detecção e contenção de 
ameaças na rede WLAN; 

83. Deve fazer a varredura dos espectros de 2,4 GHz e 5 GHz para localização e classificação de 
interferências não 802.11, analise de espectro, e evita-las automaticamente; 

84. O controlador deve possuir funcionalidade de analisador gráfico de espectro para detecção 
de interferências nas faixas de frequência de 2.4 e 5 GHz, sejam elas IEEE 802.11 ou não. 
Deve disponibilizar interface gráfica com, pelo menos, gráficos de Fast Fourier Transform 
(FFT) e espectrograma; Caso a funcionalidade não possa ser apresentada pelo controlador, 
deve ser fornecido um equipamento ou software, do mesmo fabricante, que o faça; 

85. Utilizar os APs como ”sensores” de RF para fazer a monitoração do ambiente Wireless; 
86. Classificar automaticamente APs válidos, os que interferem e os não autorizados (rogues); 
87. Implementar mecanismos para detecção e contenção de APs não autorizados (rogues); 
88. Realizar a contenção automática dos APs Rogue, simultaneamente, através da rede WLAN 

e/ou da rede cabeada; 
89. Realizar a identificação e contenção de redes “ad-hoc”; 
90. Detectar e bloquear o bridging entre estações da rede WLAN; 
91. Oferecer proteção contra ataques Denial Of Service (DOS) a APs e estações 
92. Detectar e alertar os seguintes tipos de ataques na rede WLAN: 

a. Impersonalização de AP válido; 
b. Floods de Frames; 
c. Fake Ap, Airjack; 
d. Broadcasts de de-autenticação; 
e. Ataques baseados em probes; 

93. Possuir capacidade de gerar alarmes e executar contra-ataques se um ataque for detectado; 
94. Detectar áreas de sombra de cobertura e efetuar os devidos ajustes para sua correção, 

automaticamente; 
95. Ajustar, dinamicamente, o nível de potência e canal de rádio dos APs, de modo a otimizar o 

tamanho da célula de RF, garantindo a performance e escalabilidade; 
96. Permitir o controle de banda disponível (bandwith contracts) por usuário ou através de perfis 

de usuários; 
97. Possibilitar roaming com integridade de sessão, dando suporte a aplicações em tempo real, 

tais como, VoIP, VoWLAN, videoconferência, dentre outras; 
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98. Deve possuir mecanismo de controle de admissão de chamadas nos pontos de acesso (CAC); 
99. Possuir mecanismo automático de QoS para protocolos de voz (SIP, SVP e SCCP) utilizando 

inspeção automática de pacotes, sem a necessidade de fazer a marcação prévia (tagging) de 
pacotes; 

100. Deve possuir solução de identificação de aplicações através de técnicas de análise de 
tráfego, provendo informações das aplicações mais utilizadas na interface gráfica; 

101. Permitir a criação de políticas de acesso baseadas nas aplicações, como por exemplo, 
o acesso a “redes sociais” terá um controle de banda de 2Mpbs. 

102. Apresentar informações gráficas referente a utilização de soluções de comunicações 
unificadas (UC) sobre a infraestrutura WLAN, de formar a apresentar informações referentes 
as chamadas realizadas e relações gráficas entre o nível de sinal recebido pelo usuário e a 
qualidade da chamada. 

103. Possuir a funcionalidade da utilização do protocolo Bonjour na infraestrutura, 
permitindo que os serviços divulgados via mDNS sejam controlados, filtrados e 
disponibilizados entre diferentes subnets, tornando assim possível a utilização em redes com 
múltiplas subnets e um número grande de dispositivos. 

104. Cada unidade deve ser fornecida com todas as licenças de software necessárias para o 
funcionamento integral de todas as funcionalidades disponíveis. 

Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos equipamentos, 
indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
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permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

 
  

ITEM 25 – LICENÇAS ADICIONAIS PARA CONTROLADORA WLAN 

Características técnicas mínimas 

3. Licença para expansão da CONTROLADORA WLAN, contemplando o quantitativo adicional 
mínimo de 1 (um) ponto de acesso simultâneo; 

4. Deve ser compatível com controladora WLAN especificada nesse edital; 
5. Cada unidade deve ser fornecida com todas as licenças de software necessárias para o 

funcionamento integral de todas as funcionalidades disponíveis para CONTROLADORA 
WLANespecificada nesse edital. 

  

GARANTIA E SUPORTE 

6. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 

7. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

8. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

9. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

10. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

 
  

ITEM 26 – PONTO DE ACESSO INTERNO TIPO 01 

Características gerais 
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1. Equipamento de Ponto de Acesso para rede local sem fio, configurável via software, com 
funcionamento simultâneo nos padrões IEEE 802.11a/n/ac, 5GHz, e IEEE 802.11b/g/n, 
2.4GHz; 

2. Todos os Pontos de acesso sem fio deverão ser novos e sem nenhum histórico de utilização; 
3. Os pontos de acesso deverão possuir certificado emitido pelo “WIFI Alliance” comprovando 

no mínimo os seguintes padrões, protocolos e funcionalidades: 

a. IEEE 802.11a; 
b. IEEE 802.11b; 
c. IEEE 802.11g; 
d. IEEE 802.11n; 
e. IEEE 802.11d; 
f. IEEE 802.11ac; 
g. WPA® Enterprise/Personal; 
h. WPA2® Enterprise/Personal; 
i. EAP-TLS; 
j. EAP-TTLS/MSCHAPv2; 
k. PEAPv0/EAP-MSCHAPv2; 
l. PEAPv1/EAP-GTC; 
m. EAP-SIM; 
n. EAP-FAST; 
o. WMM® e WMM® Power Save; 
p. Beamforming; 
q. Short Guard Interval (SGI); 
r. Packet Aggregation (A-MPDU); 
s. Opportunistic Key Caching (OKC) 

4. Deve operar simultaneamente em 2.4GHz e 5GHz (concurrent dual-band); 

  

Performance 

5. Deve suportar rádio dual, 5 GHz 802.11ac 2x2 MIMO e 2.4GHz 802.11n 2x2 MIMO 
6. Deve suportar capacidade de 1300 Mbps de throughput ou superior; 
7. Deve possuir rádio duplo configurável pelo software suportando 5 GHz e 2,4 GHz; 
8. Deve possuir no mínimo dois spatial stream Single User (SU) MIMO para taxa de dados sem 

fio de até 867 Mbps para dispositivos cliente individuais (VHT80) 2x2 em 5GHz; 
9. Deve possuir no mínimo dois spatial stream Single User (SU) MIMO para uma taxa de dados 

sem fio de até 400 Mbps para dispositivos clientes compatíveis (2x2 VHT40) em 5GHz; 
10. Deve possuir suporte para até 255 dispositivos cliente associados por rádio e até 16 BSSIDs 

por rádio; 
11. Deve suportar no mínimo as bandas de frequência: 

a. 2,400 a 2,4835 GHz 
b. 5.150 a 5.250 GHz 
c. 5,25 a 5,350 GHz 
d. 5,470 a 5,725 GHz 
e. 5,725 a 5,850 GHz 
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12. Deve possuir suporte a seleção de frequência dinâmica (DFS) otimizando o uso do espectro 
de RF disponível; 

13. Deve suportar, no mínimo, as seguintes tecnologias de rádio: 

a. 802.11b: espectro espalhável de sequência direta (DSSS) 
b. 802.11a/g/n/ac: multiplexação por divisão de frequência ortogonal (OFDM) 

14. Deve suportar, no mínimo, os seguintes tipos de modulação: 

a. 802.11b: BPSK, QPSK, CCK 
b. 802.11a/g/n/ac: BPSK, QPSK, 16-QAM, 64-QAM, 256-QAM 

15. Deve possuir potência de transmissão configurável em incrementos entre 0,5 e 1,0 dBm. 
16. Deve respeitar os limites de potência de transmissão máxima (conduzida): 

a. Faixa de 2,4 GHz: +18 dBm por corrente, agregado de +21 dBm (2x2) 
b. Banda de 5 GHz: +18 dBm por corrente, agregado de +21 dBm (2x2) 

17. Deve suportar Advanced Cellular Coexistence (ACC) minimizando a interferência das redes 
celulares; 

18. Deve suportar Maximum ratio combining (MRC) para melhorar o desempenho do receptor; 
19. Deve suportar Cyclic delay/shift diversity (CDD/CSD) para melhorar o desempenho RF de 

downlink; 
20. Deve suportar Short guard interval para canais de 20MHz, 40MHz e 80MHz; 
21. Deve suportar Space-time block coding (STBC) para aumentar o alcance e melhorar a 

recepção; 
22. Deve suportar Verificação de paridade de baixa densidade (LDPC) para correção de erros de 

alta eficiência e aumento da taxa de transferência; 
23. Deve suportar Transmit beam-forming (TxBF); 
24. Deve possuir, no mínimo, as seguintes taxas de dados suportadas (Mbps): 

a. 802.11b: 1, 2, 5.5, 11 
b. 802, 11a / g: 6, 9, 12, 18, 24, 36, 48, 54 
c. 802.11n (2.4GHz): 6.5 a 300 (MCS0 a MCS15) 
d. 802.11ac: 6.5 a 867 (MCS0 a MCS9, NSS = 1 a 2 for VHT20/40/80 

25. Deve possuir suporte a 802.11n de alto rendimento (HT): HT 20/40 
26. Deve possuir suporte a 802.11ac de alta velocidade (VHT): VHT 20/40/80 
27. Deve possuir suporte a agregação de pacotes 802.11n/ac: A-MPDU, A-MSDU 

  

    Gerenciamento 

28. Deve implementar funcionamento de modo auto gerenciado, sem necessidade de 
controladora WLAN para configuração de seus parâmetros de rede wireless, gerenciamento 
das políticas de segurança, QoS e monitoramento de RF. 

29. Deve obedecer à todas as características descritas mesmo neste modo de funcionamento; 
30. No modo de funcionamento auto gerenciado deve disponibilizar na interface gráfica 

informações de usuários conectados, qualidade de sinal e trafego de dados na rede; 
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31. O ponto de acesso deve permitir a conversão de modo auto gerenciado para modo 
gerenciado por controlador WLAN através de interface gráfica, em browser padrão (HTTPS), e 
permitir que todos os demais pontos de acesso pertencentes ao mesmo cluster, também 
sejam convertidos automaticamente; 

32. O ponto de acesso deverá suportar conexão direta ou remota com controlador WLAN, 
inclusive via roteamento da camada de rede, baseado no modelo OSI; 

33. Se um controlador WLAN falhar, os Pontos de Acesso relacionados deverão se associar 
automaticamente a um controlador WLAN alternativo, não permitindo que a rede wireless se 
torne inoperante; 

34. Implementar mecanismo de funcionamento para trabalhar com controladores WLAN em 
redundância; 

35. Deve permitir que o ponto de acesso seja atualizado de forma centralizada pela interface 
gráfica; 

36. Permitir o armazenamento de sua configuração em memória não volátil, podendo, numa 
queda e posterior restabelecimento da alimentação, voltar à operação normalmente na 
mesma configuração anterior; 

37. Deve possuir servidor DHCP interno configurável; 
38. Possibilitar backup e restore da configuração através da interface gráfica; 
39. Deve possuir Portal Captivo (Captive Portal) integrado para utilização em rede de visitantes; 
40. Deve possuir mecanismos para proteção contra Pontos de Acesso não autorizados (Rogues); 
41. Possuir capacidade de identificação e listagem dos rádios vizinhos e respectivos SSID/BSSID; 
42. Implementar associação dinâmica de usuários à VLANs com base nos parâmetros da etapa 

de autenticação; 
43. Deve possuir uma base de usuários interna que diferencie usuários visitantes de 

funcionários, para ser usada em autenticação 802.1x ou portal captivo; 
44. Permitir a autenticação para acesso dos usuários conectados nas redes WLAN (Wireless) 

através: 

a. MAC Address 
b. 802.1x em base Local 
c. Captive Portal 
d. 802.1x em base externa RADIUS 
e. 802.1x em base externa LDAP 

45. Deve permitir a seleção/uso de servidor de autenticação específico com base no SSID; 
46. Implementar o protocolo de enlace CSMA/CA para acesso ao meio de transmissão; 
47. Possuir capacidade de selecionar automaticamente o canal de transmissão; 
48. Permitir o ajuste dinâmico de nível de potência e canal de rádio de modo a otimizar o 

tamanho da célula de RF; 
49. Permitir habilitar e desabilitar a divulgação do SSID; 
50. Implementar diferentes tipos de combinações encriptação/autenticação por SSID; 
51. Implementar padrão WMM da Wi-Fi Alliance para priorização de tráfego, suportando 

aplicações em tempo real, tais como, VoIP, vídeo, dentre outras; 
52. Não deve haver no licenciamento restrições com relação ao número de dispositivos 

conectados por ponto de acesso; 
53. Implementar a pilha de protocolos TCP/IP com suporte a IPV4 e IPV6 (Bridging); 
54. Implementar VLANs conforme padrão IEEE 802.1Q; 
55. Possuir, no mínimo, uma interface IEEE 802.3 10/100/1000BaseT Ethernet, auto- sensing, 

auto MDI/MDX; 
56. Permitir a atualização remota do sistema operacional e arquivos de configuração através da 

controladora WLAN 
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57. Implementar cliente DHCP, para configuração automática de rede; 
58. Deve configurar-se automaticamente ao ser conectado na rede; 
59. Possuir LED’s indicativos do estado de operação, da atividade do rádio e da interface 

Ethernet; 
60. Possuir estrutura que permita fixação do equipamento em teto e parede e fornecer 

acessórios para que possa ser feita a fixação; 
61. Deve ser acompanhado de todos os acessórios necessários para operacionalização do 

equipamento, tais como: softwares, cabos de console, cabos de energia elétrica, 
documentação técnica e manuais (podendo ser em CD-ROM) que contenham informações 
suficientes para possibilitar a instalação, configuração e operacionalização do equipamento; 

62. Permitir o bloqueio da configuração do Ponto de Acesso via rede wireless; 
63. Implementar varredura de RF nas bandas 802.11a, 802.11b, 802.11g, 802.11n, para 

identificação de Pontos de Acesso intrusos não autorizados (rogues) e interferências no canal 
habilitado ao ponto de acesso e nos demais canais configurados na rede WLAN, sem impacto 
no seu desempenho; 

64. Implementar IEEE 802.1x, com pelo menos os seguintes métodos EAP: 

a. EAP-FAST 
b. EAP-TLS 
c. PEAP-GTC 
d. PEAP-MSCHAPv2 

65. Permitir a integração com RADIUS Server com suporte aos métodos EAP citados; 
66. A comunicação entre todos os pontos de acesso sem fio e a controladora deverá ser 

criptografada; 
67. Suportar a autenticação com geração dinâmica de chaves criptográficas por sessão e por 

usuário; 
68. Implementar WPA com algoritmo de criptografia TKIP e MIC; 
69. Implementar WPA2 com algoritmo de criptografia AES, 128/256 bits, IEEE 802.11i; 
70. Deve possuir modo dedicado de funcionamento de análise de espectro das faixas de 

frequência de 2.4 e 5 GHz identificando fontes de interferência nessas faixas; 
71. Deve possibilitar analise de espectro nos canais em que estiver provendo acesso, sem 

desconectar os usuários; 
72. Deve disponibilizar informações gráficas de análise de espectro em conjunto com o 

controlador WLAN; 
73. O equipamento deverá possuir registro na ANATEL e deverá ser apresentado na entrega do 

equipamento; 
74. Deverá prover priorização de trafego de vídeo e voz através de parâmetros de QoS (Quality 

os Service) com possibilidade de aplicar por SSID e dispositivo; 
75. Possibilitar roaming na rede wireless; 
76. Suportar a criação de uma rede de convidados autocontida com isolamento de tráfego entre 

clientes e serviços locais; 
77. Possuir recursos de seleção automática de canal de transmissão procurando por canais onde 

haja menor interferência, tendo por objetivo melhorar a performance da rede wireless; 
78. Permitir a operação em estrutura Mesh viabilizando a comunicação direta entre diferentes 

Pontos de Acesso sem Fio onde não seja possível estender a rede cabeada; 
79. Operando em estrutura Mesh, a comunicação entre os dispositivos estrutura deverão operar 

na frequência de 5Ghz. 
80. Possuir mecanismo para a restauração das configurações originais de fábrica fisicamente no 

equipamento (reset); 
81. Suportar operação em humidade de 5% a 95% sem condensação; 
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82. Suportar operação em temperatura de até 40°C (quarenta graus centígrados); 
83. Possuir um MTBF (Mean Time Between Failure - Período Médio entre Falhas) de, no mínimo, 

250.000 horas. 

  

Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos equipamentos, 
indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 27 – PONTO DE ACESSO INTERNO TIPO 02 

Características gerais 

1. Equipamento de Ponto de Acesso para rede local sem fio, configurável via software, com 
funcionamento simultâneo nos padrões IEEE 802.11a/n/ac, 5GHz, e IEEE 802.11b/g/n, 
2.4GHz; 

2. Todos os Pontos de acesso sem fio deverão ser novos e sem nenhum histórico de utilização; 

Minuta de edita (0578992)         SEI 0008478-63.2018.6.02.8000 / pg. 553



 
TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS 

SEÇÃO DE LICITAÇÕES E CONTRATOS 

 

78 
 

 

 

3. Os pontos de acesso deverão possuir certificado emitido pelo “WIFI Alliance” comprovando 
no mínimo os seguintes padrões, protocolos e funcionalidades: 

a. IEEE 802.11a; 
b. IEEE 802.11b; 
c. IEEE 802.11g; 
d. IEEE 802.11n; 
e. IEEE 802.11d; 
f. IEEE 802.11ac; 
g. WPA® Enterprise/Personal; 
h. WPA2® Enterprise/Personal; 
i. EAP-TLS; 
j. EAP-TTLS/MSCHAPv2; 
k. PEAPv0/EAP-MSCHAPv2; 
l. PEAPv1/EAP-GTC; 
m. EAP-SIM; 
n. EAP-FAST; 
o. WMM® e WMM® Power Save; 
p. Beamforming; 
q. Short Guard Interval (SGI); 
r. Packet Aggregation (A-MPDU); 
s. Opportunistic Key Caching (OKC) 

4. Deve operar simultaneamente em 2.4GHz e 5GHz (concurrent dual-band); 

  

Performance 

5. Deve suportar rádio dual, 5 GHz 802.11ac 4x4 MIMO e 2.4 GHz 802.11n 2x2 MIMO; 
6. Deve possuir rádio duplo configurável pelo software, suportando 5 GHz e 2,4 GHz; 
7. Deve possuir quatro spatial stream Single User (SU) MIMO para taxa de dados sem fio de até 

1,733 Mbps, em 5GHz; 
8. Deve possuir três spatial stream Multi User (MU) MIMO para uma taxa de dados sem fio de 

até 1,300 Mbps para dispositivos clientes compatíveis, em 5GHz; 
9. Deve possuir suporte para até 255 dispositivos cliente associados por rádio e até 16 BSSIDs 

por rádio; 
10. Deve suportar no mínimo as bandas de frequência: 

a. 2,400 a 2,4835 GHz 
b. 5.150 a 5.250 GHz 
c. 5.250 a 5.350 GHz 
d. 5,470 a 5,725 GHz 
e. 5,725 a 5,850 GHz 

11. Deve possuir suporte a seleção de frequência dinâmica (DFS) otimizando o uso do espectro 
de RF disponível; 

12. Deve suportar, no mínimo, as seguintes tecnologias de rádio: 

a. 802.11b: espectro espalhável de sequência direta (DSSS); 
b. 802.11a / g / n / ac: multiplexação por divisão de frequência ortogonal (OFDM); 
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13. Deve suportar, no mínimo, os seguintes tipos de modulação: 

a. 802.11b: BPSK, QPSK, CCK; 
b. 802.11a / g / n / ac: BPSK, QPSK, 16-QAM, 64-QAM, 256-QAM; 

14. Deve possuir potência de transmissão configurável em incrementos de 0,5 dBm; 
15. Deve respeitar os limites de potência de transmissão máxima (conduzida): 

a. Faixa de 2,4 GHz: +18 dBm por corrente, agregado de +24 dBm (3x3); 
b. Faixa de 5 GHz: +18 dBm por corrente, agregado de +24 dBm (4x4); 

16. Deve suportar Advanced Cellular Coexistence (ACC) minimizando a interferência das redes 
celulares; 

17. Deve suportar Maximum Ratio Combining (MRC) para melhorar o desempenho do receptor; 
18. Deve suportar Cyclic delay/shift diversity (CDD/CSD) para melhorar o desempenho RF de 

downlink; 
19. Deve suportar Short guard interval para canais de 20-MHz, 40-MHz e 80-MHz; 
20. Deve suportar Space-time block coding (STBC) para aumentar o alcance e melhorar a 

recepção; 
21. Deve suportar verificação de paridade de baixa densidade (LDPC) para correção de erros de 

alta eficiência e aumento da taxa de transferência; 
22. Deve suportar Transmit beam-forming (TxBF); 
23. Deve possuir, no mínimo, as seguintes taxas de dados suportadas (Mbps): 

a. 802.11b: 1, 2, 5.5, 11 
b. 802.11a/g: 6, 9, 12, 18, 24, 36, 48, 54 
c. 802.11n: 6.5 até 450 (MCS0 até MCS23) 
d. 802.11ac: 6.5 até 1,733 (MCS0 até MCS9, NSS = 1 até 4) 

24. Deve possuir suporte a 802.11n de alto rendimento (HT): HT 20/40; 
25. Deve possuir suporte a 802.11ac de alta velocidade (VHT): VHT 20/40/80; 
26. Deve possuir suporte a agregação de pacotes 802.11n/ac: A-MPDU, A-MSDU; 

  

   Gerenciamento 

27. Deve implementar funcionamento de modo auto gerenciado, sem necessidade de 
controladora WLAN para configuração de seus parâmetros de rede wireless, gerenciamento 
das políticas de segurança, QoS e monitoramento de RF. 

28. Deve obedecer a todas as características descritas mesmo neste modo de funcionamento; 
29. No modo de funcionamento autogerenciado deve disponibilizar na interface gráfica 

informações de usuários conectados, qualidade de sinal e trafego de dados na rede; 
30. O ponto de acesso deve permitir a conversão de modo auto gerenciado para modo 

gerenciado por controlador WLAN através de interface gráfica, em browser padrão (HTTPS), e 
permitir que todos os demais pontos de acesso pertencentes ao mesmo cluster, também 
sejam convertidos automaticamente; 

31. O ponto de acesso deverá suportar conexão direta ou remota com controlador WLAN, 
inclusive via roteamento da camada de rede, baseado no modelo OSI; 
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32. Se um controlador WLAN falhar, os Pontos de Acesso relacionados deverão se associar 
automaticamente a um controlador WLAN alternativo, não permitindo que a rede wireless se 
torne inoperante; 

33. Implementar mecanismo de funcionamento para trabalhar com controladores WLAN em 
redundância; 

34. Deve permitir que o ponto de acesso seja atualizado de forma centralizada pela interface 
gráfica; 

35. Permitir o armazenamento de sua configuração em memória não volátil, podendo, numa 
queda e posterior restabelecimento da alimentação, voltar à operação normalmente na 
mesma configuração anterior; 

36. Deve possuir servidor DHCP interno configurável; 
37. Possibilitar backup e restore da configuração através da interface gráfica; 
38. Deve possuir Portal Captivo (Captive Portal) integrado para utilização em rede de visitantes; 
39. Deve possuir mecanismos para proteção contra Pontos de Acesso não autorizados (Rogues); 
40. Possuir capacidade de identificação e listagem dos rádios vizinhos e respectivos SSID/BSSID; 
41. Implementar associação dinâmica de usuários à VLANs com base nos parâmetros da etapa 

de autenticação; 
42. Deve possuir uma base de usuários interna que diferencie usuários visitantes de 

funcionários, para ser usada em autenticação 802.1x ou portal captivo; 
43. Permitir a autenticação para acesso dos usuários conectados nas redes WLAN (Wireless) 

através: 

a. MAC Address 
b. 802.1x em base Local 
c. Captive Portal 
d. 802.1x em base externa RADIUS 
e. 802.1x em base externa LDAP 

44. Deve permitir a seleção/uso de servidor de autenticação específico com base no SSID; 
45. Implementar o protocolo de enlace CSMA/CA para acesso ao meio de transmissão; 
46. Possuir capacidade de selecionar automaticamente o canal de transmissão; 
47. Permitir o ajuste dinâmico de nível de potência e canal de rádio de modo a otimizar o 

tamanho da célula de RF; 
48. Permitir habilitar e desabilitar a divulgação do SSID; 
49. Implementar diferentes tipos de combinações encriptação/autenticação por SSID; 
50. Implementar padrão WMM da Wi-Fi Alliance para priorização de tráfego, suportando 

aplicações em tempo real, tais como, VoIP, vídeo, dentre outras; 
51. Não deve haver no licenciamento restrições com relação ao número de dispositivos 

conectados por ponto de acesso; 
52. Implementar a pilha de protocolos TCP/IP com suporte a IPV4 e IPV6 (Bridging); 
53. Implementar VLANs conforme padrão IEEE 802.1Q; 
54. Possuir, no mínimo, uma interface IEEE 802.3 10/100/1000BaseT Ethernet, auto- sensing, 

auto MDI/MDX; 
55. Permitir a atualização remota do sistema operacional e arquivos de configuração através da 

controladora WLAN 
56. Implementar cliente DHCP, para configuração automática de rede; 
57. Deve configurar-se automaticamente ao ser conectado na rede; 
58. Possuir LED’s indicativos do estado de operação, da atividade do rádio e da interface 

Ethernet; 
59. Possuir estrutura que permita fixação do equipamento em teto e parede e fornecer 

acessórios para que possa ser feita a fixação; 
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60. Deve ser acompanhado de todos os acessórios necessários para operacionalização do 
equipamento, tais como: softwares, cabos de console, cabos de energia elétrica, 
documentação técnica e manuais (podendo ser em CD-ROM) que contenham informações 
suficientes para possibilitar a instalação, configuração e operacionalização do equipamento; 

61. Permitir o bloqueio da configuração do Ponto de Acesso via rede wireless; 
62. Implementar varredura de RF nas bandas 802.11a, 802.11b, 802.11g, 802.11n, para 

identificação de Pontos de Acesso intrusos não autorizados (rogues) e interferências no canal 
habilitado ao ponto de acesso e nos demais canais configurados na rede WLAN, sem impacto 
no seu desempenho; 

63. Implementar IEEE 802.1x, com pelo menos os seguintes métodos EAP: 

a. EAP- MD5 
b. EAP-FAST 
c. EAP-TLS 
d. PEAP-GTC 
e. PEAP-MSCHAPv2 

64. Permitir a integração com RADIUS Server com suporte aos métodos EAP citados; 
65. A comunicação entre todos os pontos de acesso sem fio e a controladora deverá ser 

criptografada; 
66. Suportar a autenticação com geração dinâmica de chaves criptográficas por sessão e por 

usuário; 
67. Implementar WPA com algoritmo de criptografia TKIP e MIC; 
68. Implementar WPA2 com algoritmo de criptografia AES, 128/256 bits, IEEE 802.11i; 
69. Deve possuir modo dedicado de funcionamento de análise de espectro das faixas de 

frequência de 2.4 e 5 GHz identificando fontes de interferência nessas faixas; 
70. Deve possibilitar analise de espectro nos canais em que estiver provendo acesso, sem 

desconectar os usuários; 
71. Deve disponibilizar informações gráficas de análise de espectro em conjunto com o 

controlador WLAN; 
72. O equipamento deverá possuir registro na ANATEL e deverá ser apresentado na entrega do 

equipamento; 
73. Deverá prover priorização de trafego de vídeo e voz através de parâmetros de QoS (Quality 

os Service) com possibilidade de aplicar por SSID e dispositivo; 
74. Possibilitar roaming na rede wireless; 
75. Suportar a criação de uma rede de convidados autocontida com isolamento de tráfego entre 

clientes e serviços locais; 
76. Possuir recursos de seleção automática de canal de transmissão procurando por canais onde 

haja menor interferência, tendo por objetivo melhorar a performance da rede wireless; 
77. Permitir a operação em estrutura Mesh viabilizando a comunicação direta entre diferentes 

Pontos de Acesso sem Fio onde não seja possível estender a rede cabeada; 
78. Operando em estrutura Mesh, a comunicação entre os dispositivos estrutura deverão operar 

na frequência de 5Ghz. 
79. Possuir mecanismo para a restauração das configurações originais de fábrica fisicamente no 

equipamento (reset); 
80. Suportar operação em humidade de 5% a 95% sem condensação; 
81. Suportar operação em temperatura de até 40°C (quarenta graus centígrados); 
82. Possuir um MTBF (Mean Time Between Failure - Período Médio entre Falhas) de, no mínimo, 

250.000 horas. 
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Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos equipamentos, 
indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 28 – INJETOR POE PARA PONTOS DE ACESSO TIPO 1 

Características técnicas mínimas 

1. Deve ser do mesmo fabricante dos Pontos de acesso ou homologado e certificado pelo 
mesmo para utilização em seus equipamentos; 

2. Injetor PoE 802.3af 10/100/1000 Ethernet com 15.4W; 

  

Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
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equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

3. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 29 – INJETOR POE PARA PONTOS DE ACESSO TIPO 2 

Características técnicas mínimas 

1. Deve ser do mesmo fabricante dos Pontos de acesso ou homologado e certificado pelo 
mesmo para utilização em seus equipamentos; 

2. Injetor PoE+ 802.3at 10/100/1000 Ethernet com 30W; 

  

Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

3. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 30 – SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE TECNOLOGIA PARA SOLUÇÃO DE 
GERENCIAMENTO 

Características Gerais 

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das 14:00 às 18:00) 
presencialmente no TRE-AL ou remotamente conforme necessidades da CONTRATANTE; 

  

Implantação 

2. Instalação e configuração de 1 (uma) instância do serviço de gerenciamento de rede, 
contemplando: 
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a. Configurações básicas para acesso à rede, dimensionamento e configuração de 
armazenamento; 

b. Inclusão de no mínimo 10 (dez) pontos de acesso no monitoramento; 
c. Criação de modelo de configuração (templates) de forma a possibilitar a replicação de 

configuração entre equipamentos. 

  

Transferência De Tecnologia 

3. O treinamento deverá ser no realizado na modalidade workshop com tarefas práticas hands-
on, visando assim a melhor fixação dos temas abordados com foco direto na explicação da 
tecnologia da solução como também nas rotinas de configuração, gerenciamento, 
administração e operação da mesma; 

  

4. O treinamento do MÓDULO DE GERENCIA DE REDE deverá ter duração mínima de 24 (vinte e 
quatro) horas onde será abordado, no mínimo, os seguintes tópicos: 

a. Inserção, modificação e remoção de dispositivos de forma unitária e em lote; 
b. Configuração de VLANs Globais e Locais em switchs gerenciados; 
c. Configuração de ACLS Globais e Locais em switchs gerenciados; 
d. Backup e restore de configuração de switchs gerenciados; 
e. Monitoramento e alarmes default e customizados; 
f. Customização do Dashboard com alertas, mapas de topologia e monitoramento de 

dispositivos; 

  

ITEM 31- SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE TECNOLOGIA DO MÓDULO DE CONTROLE 
DE ACESSO 

Características Gerais 

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das 14:00 às 18:00) 
presencialmente no TRE-AL ou remotamente conforme necessidades da CONTRATANTE; 

  

Implantação 

2. Instalação e configuração de 1 (uma) instancia do serviço controle de acesso, contemplando: 

a. Configurações básicas para acesso à rede, dimensionamento e configuração de 
armazenamento; 

b. Configuração de autenticação em Active Directory para usuários corporativos; 
c. Configuração de autenticação de visitantes com portal de autosserviço para criação de 

usuários; 
d. Configuração de no mínimo 5 (cinco) dispositivos de rede para autenticação na solução. 

  

Minuta de edita (0578992)         SEI 0008478-63.2018.6.02.8000 / pg. 560



 
TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS 

SEÇÃO DE LICITAÇÕES E CONTRATOS 

 

85 
 

 

 

Transferência de Tecnologia 

3. O treinamento deverá ser no realizado na modalidade workshop com tarefas práticas hands-
on, visando assim a melhor fixação dos temas abordados com foco direto na explicação da 
tecnologia da solução como também nas rotinas de configuração, gerenciamento, 
administração e operação da mesma devendo ter duração mínima de 24 (vinte e quatro) 
horas onde será abordado no mínimo os seguintes tópicos: 

a. Configuração de Active Directory como base de autenticação; 
b. Configuração de autenticação de usuários corporativos; 
c. Configuração de autenticação de usuários visitantes; 
d. Configuração de portal de autosserviço; 
e. Configuração de autenticação e autorização com protocolo RADIUS. 

ITEM 32– SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE TECNOLOGIA PARA CONTROLADORA 
WLAN E PONTOS DE ACESSO 

  

Características Gerais 

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das 14:00 às 18:00) 
presencialmente no TRE-AL ou remotamente conforme necessidades da CONTRATANTE; 

  

Implantação 

2. Instalação e configuração de no mínimo 10 (dez) pontos de acesso, contemplando: 

a. Configuração básica de acesso a gerência via rede; 
b. Configuração de gerência e monitoramento em MÓDULO DE GERENCIA DE REDE; 
c. Configuração da autenticação de usuários em MÓDULO DE CONTROLE DE ACESSO 
d. Configuração de pontos de acesso em controladora WLAN habilitando gerenciamento 

centralizado; 

  

Transferência de Tecnologia 

3. O treinamento deverá ser no realizado na modalidade workshop com tarefas práticas hands-
on, visando assim a melhor fixação dos temas abordados com foco direto na explicação da 
tecnologia dos produtos ofertados como também nas rotinas de configuração, 
gerenciamento, administração e operação dos mesmos devendo ter duração mínima de 16 
(Dezesseis) horas onde será abordado no mínimo os seguintes tópicos: 

a. Configuração inicial e acesso a gerência; 
b. Configuração de Clusters; 
c. Configuração de autenticação de usuários em MÓDULO DE CONTROLE DE ACESSO; 
d. Criação de SSID com autenticação PSK; 
e. Criação de SSID com autenticação enterprise em MÓDULO DE CONTROLE DE ACESSO; 
f. Configuração de pontos de acesso para MÓDULO DE GERENCIA DE REDE; 
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g. Configuração pontos de acesso para MÓDULO DE ANÁLISE DE TRÁFEGO; 

  

ITEM 33 – TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE ARQUITETURA WLAN 

  

Características Gerais 

7. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do fabricante no 
Treinamento Básico De Administração De Arquitetura Wlan para 01 (um) profissional da 
contratante; 

8. O voucher deverá ter validade de pelo menos 12 (doze) meses; 
9. O treinamento deverá ser de acordo com o calendário de treinamento do fabricante e 

ministrado em centro oficial de treinamento do mesmo ou remotamente, utilizando 
tecnologia de ensino a distância; 

10. Deverá ser ministrado por profissional devidamente credenciado junto ao fabricante e apto a 
entregar o respectivo; 

11. O treinamento deverá compreender a explicação da tecnologia da solução como também das 
rotinas de configuração, gerenciamento, administração e operação da mesma; 

12. O treinamento deverá ter carga horária mínima de 20 (vinte) horas, ministrado no período de 
08:00 às 12:00 e das 14:00 às 18:00. 

  

ITEM 34 – TREINAMENTO BÁSICO DA SOLUÇÃO DE GERENCIAMENTO 

  

Características Gerais 

1. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do fabricante no 
Treinamento da Solução de Gerenciamento para 01 (um) profissional da contratante; 

2. O voucher deverá ter validade de pelo menos 12 (doze) meses; 
3. O treinamento deverá ser de acordo com o calendário de treinamento do fabricante e 

ministrado em centro oficial de treinamento do mesmo ou remotamente, utilizando 
tecnologia de ensino a distância; 

4. Deverá ser ministrado por profissional devidamente credenciado junto ao fabricante e apto a 
entregar o respectivo; 

5. O treinamento deverá compreender a explicação da tecnologia da solução como também das 
rotinas de configuração, gerenciamento, administração e operação da mesma; 

6. O treinamento deverá ter carga horária mínima de 40 (Quarenta) horas, ministrado no 
período de 08:00 às 12:00 e das 14:00 às 18:00. 

  

ITEM 35 – TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE ACESSO 

  

Características Gerais 
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7. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do fabricante no 
Treinamento da Solução de Controle de Acesso para 01 (um) profissional da contratante; 

8. O voucher deverá ter validade de pelo menos 12 (doze) meses; 
9. O treinamento deverá ser de acordo com o calendário de treinamento do fabricante e 

ministrado em centro oficial de treinamento do mesmo ou remotamente, utilizando 
tecnologia de ensino a distância; 

10. Deverá ser ministrado por profissional devidamente credenciado junto ao fabricante e apto a 
entregar o respectivo; 

11. O treinamento deverá compreender a explicação da tecnologia da solução como também das 
rotinas de configuração, gerenciamento, administração e operação da mesma; 

12. O treinamento deverá ter carga horária mínima de 40 (Quarenta) horas, ministrado no 
período de 08:00 às 12:00 e das 14:00 às 18:00. 

3.2 Forma de Execução e de Gestão do Contrato (Art. 18, § 3º, III, a) 

A execução do objeto pressupõe a existência dos seguintes papéis e 
responsabilidades (Art. 18, § 3º, III, a, 1): 

1. Patrocinador da Contratação: é o titular da área demandante, responsável por representar os 
interesses do órgão no contexto da Contratação, pela aprovação da necessidade e, por fim, 
pela negociação das ações necessárias para que os objetivos sejam alcançados; 

2. Gestor do Contrato (art. 3º, IV, da Resolução TRE/AL nº 15.787/2017): servidor designado 
para coordenar e comandar o processo da fiscalização da execução contratual. Na forma do 
Art. 17 da mesma Resolução, o gestor do contrato responsabiliza-se pela condução da gestão 
e fiscalização do contrato, nos termos do Art. 67, da Lei nº 8.666/93. 

3. Fiscal do Contrato (art. 3º, VI, da Resolução TRE/AL nº 15.787/2017): servidor designado para 
auxiliar o gestor do contrato quanto à fiscalização do objeto do contrato. Neste sentido, 
indicado pela respectiva autoridade competente para fiscalizar o Contrato quanto aos 
aspectos técnicos da solução. 

Dinâmica da Execução (Art. 18, § 3º, III, a, 2): 

1. Os equipamentos deverão ser entregues no Almoxarifado do TRE/AL, nos quantitativos 
indicados no pedido de fornecimento; 

2. A garantia dos equipamentos deve obedecer o detalhamento técnico feito e terá seu tempo 
contado por cada fornecimento individualmente; 

3. Entende-se como garantia aquela prestada pelo próprio fabricante ou por rede 
credenciada pelo fabricante do(s) referido(s) equipamento(s); 

4. O pagamento será realizado individualmente para cada nota fiscal apresentada, 
após emissão do aceite definitivo pela unidade competente do TRE/AL; 

5. Os equipamentos deverão ser novos, não recondicionados, de primeiro uso e não deverão 
conter marcas, amassados, arranhões ou outros problemas e, ainda, serem entregues em 
pleno estado de funcionamento; 

6. Os equipamentos deverão atender rigorosamente a todas as especificações técnicas contidas 
neste Termo de Referência e em seus Anexos; 

7. Os equipamentos deverão vir acompanhados de todos os acessórios necessários para o seu 
pleno estado de funcionamento, como cabos, drivers, mídias e outros, os quais só serão 
recebidos juntamente com os respectivos equipamentos. Este item se aplica tanto para a 
entrega dos equipamentos quanto para substituições durante o período de garantia; 

8. Ao TRE é reservado o direito de efetuar conexões dos equipamentos a outros, bem como 
adicionar demais acessórios compatíveis tecnicamente, sem que isso constitua motivo para a 
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Contratada se desobrigar da garantia, desde que tal fato não implique danos materiais 
ou técnicos aos equipamentos e acessórios, hipótese que deverá ser devidamente 
comprovada; 

9.  Ao TRE/AL é reservado o direito de efetuar diligência, a qualquer tempo, quanto aos 
documentos exigidos neste Termo de Referência e em seus Anexos. 

Recebimento do Objeto: 

1. O Tribunal designará Comissão para realizar o recebimento provisório, que só será emitido se 
os equipamentos estiverem de acordo com as especificações técnicas; 

2. Após a entrega, os equipamentos serão submetidos à avaliação e homologação pelos 
responsáveis técnicos do Tribunal; 

3.  O exame para comprovação das características técnicas consistirá em avaliações e testes 
não-destrutivos, por amostragem realizados em duas etapas: 

a. Primeira: inspeção visual de todos os equipamentos entregues; 
b. Segunda: testes funcionais de configuração e desempenho, em, no mínimo, 10% (dez 

por cento) e não menos do que 01 (um) dos equipamentos recebidos. O Tribunal 
poderá, a seu critério, executar os testes nos demais equipamentos, dentro de 
um critério de razoabilidade, podendo chegar a 100% dos quantitativos, mas dentro 
de um prazo máximo de 30 (trinta) dias corridos e contados de cada lote de 
equipamentos. 

4. As especificações serão avaliadas também por meio de documentos técnicos que 
acompanham os equipamentos, informações fornecidas pela Contratada e disponível no 
sítio do fabricante. 

5. A comissão do Tribunal deverá, após a comprovação do perfeito funcionamento dos 
equipamentos e adequação às especificações técnicas, emitir e assinar o Termo de 
Recebimento Definitivo. 

Instrumentos Formais de Solicitação do(s) Bens e/ou Serviço(s) (Art. 18, § 3º, III, a, 
3): 

1. A Ordem de Fornecimento será o instrumento formal de solicitação dos bens pertencentes ao 
escopo desta contratação. 

Forma de Pagamento (Art. 18, § 3º, III, a, 7) 

1. O pagamento será efetuado mediante crédito em conta-corrente do Fornecedor, por ordem 
bancária, no prazo disposto nos artigos 5º, § 3º, ou 40, XIV, “a”, da Lei n. 8.666/93, conforme 
o caso, quando mantidas as mesmas condições iniciais de habilitação e cumpridos os 
seguintes  requisitos: 

a. Apresentação de nota fiscal de acordo com a legislação vigente à época da emissão 
(nota fiscaleletrônica, se for o caso), acompanhada da Certidão Negativa de Débito – 
CND, comprovando regularidade com o INSS; do Certificado de Regularidade do FGTS 
– CRF, comprovando regularidade com o FGTS; da Certidão Conjunta Negativa de 
Débitos Relativos a Tributos Federais e à Dívida Ativa da União, expedida pela 
Secretaria da Receita Federal; e da Certidão Negativa de Débitos Trabalhistas – CNDT, 
emitida pela Justiça do Trabalho; e  da prova de regularidade para com as Fazendas 
Estadual e Municipal do domicílio ou sede do Fornecedor; e 

b. Inexistência de fato impeditivo para o qual tenha concorrido o Fornecedor. 
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2. Nenhum pagamento será efetuado à Contratada enquanto pendente de liquidação qualquer 
obrigação. Esse fato não será gerador de direito a reajustamento de preços ou a atualização 
monetária. 

Direitos de Propriedade Intelectual (Art. 18, § 3º, III, a, 9): 

1. Esse requisito não se aplica ao contexto desta contratação, uma vez que o objeto se refere 
ao fornecimento de equipamentos, cujos direitos autorais do fabricante são resguardados 
por legislação nacional e internacional. 

Penalidades (Art. 18, § 3º, III, a, 11): 

1. Com fundamento no artigo 7º da Lei nº 10.520/2002 e, subsidiariamente, nos artigos 86 e 87 
da Lei 8.666/1993, a Contratada ficará sujeita, assegurada prévia e ampla defesa, 
às seguintes penalidades: 

a. Advertência: 
i. A Contratada será notificada formalmente em caso de descumprimento de 

obrigação contratual e terá que apresentar as devidas justificativas em um 
prazo de até 5 (cinco) dias úteis após o recebimento da 
notificação; e 

ii. Caso não haja manifestação dentro desse prazo ou se entenda serem 
improcedentes as justificativas apresentadas, a Contratada será advertida; 

b. Multa de: 

i. 0,5% por dia, sobre o valor constante da Ordem de Fornecimento, no caso de 
atraso injustificado na entrega dos equipamentos, limitada a incidência a 20 
(vinte) dias corridos; 

1. No caso de atraso injustificado na entrega dos equipamentos por prazo s
uperior a 20 (vinte) dias corridos, com 
a aceitação pela Administração, será aplicada a multa de 10% sobre o 
valor da Ordem de Fornecimento; e 

2. No caso de atraso injustificado na entrega dos equipamentos por prazo s
uperior a 20 (vinte) dias corridos, com a 
não aceitação pela Administração, será aplicada a penalidade 20% sobre 
o valor da Ordem de Fornecimento, no caso de inexecução total da 
obrigação, podendo haver, ainda, o cancelamento do registro de preços 
do Fornecedor; 

ii.  0,5% por dia, sobre o valor do equipamento, 
no caso de atraso injustificado na solução do chamado de garantia, limitada a i
ncidência 30 (trinta) dias corridos; 

1. No caso de atraso injustificado na solução do chamado de garantia por p
razo superior a 30 (trinta) dias corridos, aplica-se adicionalmente, 
a multa de 1% sobre o valor da Ordem de Fornecimento; e 

2. A multa por atraso relacionada ao item 
anterior será auferida por Ordem de Fornecimento e aplicada somente u
ma única vez a cada mês, independente da quantidade 
de equipamentos sem solução. 

iii. 10% sobre o valor constante da Ordem de Fornecimento, no caso de 
inexecução parcial da obrigação assumida; 
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iv. 20% sobre o valor da Ordem de Fornecimento, no caso de inexecução total da 
obrigação, podendo haver, ainda, o cancelamento do registro de preços do 
Fornecedor; 

v. 10% sobre o valor global estimado da Ata de Ata de Registro de Preços, na 
hipótese de recusa em assinar a Ata ou o instrumento do contrato, ou retirar a 
Ordem de Fornecimento. 

c. Impedimento de licitar e contratar com a União e descredenciamento do SICAF pelo 
prazo de até 5 (cinco) anos, sem prejuízo das demais penalidades legais; e 

d. Declaração de inidoneidade para licitar ou contratar com a Administração Pública. 
2. O cometimento reiterado de atrasos injustificados dos prazos previstos para entrega/solução 

do chamado de garantia dos equipamentos poderá resultar no cancelamento do registro 
de preços com a Contratada. 

3. As sanções previstas nos itens "1.a", “1.c” e “1.d” do item 1 poderão ser aplicadas, 
cumulativamente ou não, à pena de multa. 

4. O valor da multa, aplicada após o regular processo administrativo, será descontado de 
pagamentos eventualmente devidos à contratada ou cobrado judicialmente; 

5. Excepcionalmente, ad cautelam, a Administração poderá efetuar a retenção do valor 
presumido da multa, antes da instauração do regular procedimento administrativo. 
. 
  

4. Requisitos Técnicos (Art. 18, § 3º, IV) 

  

Garantia mínima de 36  (trinta e seis) meses. 

Estar comprovadamente ainda em produção. 

Conformidade com o presente Termo de Referência. 

5. Modelos (templates) propostos a serem utilizados na contratação (Art. 18, § 3º, III, V) 

Memorando nº ____ / 20__ - TRE-AL/_______________________ 

Maceió, ___ de ___________ de _____________. 

Para: SGO-COFIN 

Assunto: Autorização de Emissão de Nota de Empenho. 

PA _________________________ 

Adesão à Ata de Registro de Preços ______________ 

Ordem de Fornecimento nº _____/_________. 

 
  

Senhor Chefe 

Encaminhamos estes autos para emissão de Nota de Empenho, em favor da Empresa ________________. CNPJ: 
xx.xxx.xxx/xxxx-xx, conforme tabela abaixo, tudo em conformidade com o disposto na Resolução TRE-AL nº 
12.738/1996 (0216181). 

Certidões: SICAF evennto: ______ / RECEITA ESTADUAL evento: ______ / SIMPLES NACIONAL (se aderente) 
evento: __________ 

Item: 
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Descrição: 

Quant. total da 
ATA 

Quant. 
Recebida 

Quant. desta 
Ordem 

Saldo no 
Fornecedor 

Valor 
Unitário 

Valor Total 
(R$) 

            

  

*  Solicitamos utilizar a reserva de crédito do PE XXX/XXXX 

  

  

Gestor da Ata - Portaria TRE/AL nº XX/XXXX 

  

Moodelo a ser adotado em decorrência do comando inserto no Proc SEI nº 0005423-07.2018.6.02.8000, 
evento 0442132: modelo de referência indicado: 0452895. 

Maceió, 15 de maio de 2019. 

 
DANIEL MACÊDO DE CARVALHO SOUTO 

 Coordenador 
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ANEXO I-A 
 

ESPECIFICAÇÕES DOS LOTES, ITENS, QUANTITATIVOS A SEREM 
ADQUIRIDOS E PREÇOS MÁXIMOS ADMITIDOS 

 

Lote 1 Item Qtd Descrição Valor 
Unitário 

Valor Total 

 

01 

1 1 SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 
PARA REDE CABEADA 

R$ 104.180,00 R$ 104.180,00 

2 3 LICENCIAMENTO ADICIONAL PARA SISTEMA DE 
GERENCIAMENTO HPE IMC 

R$ 15.890,00 R$ 47.670,00 

3 2 LICENCIAMENTO ADICIONAL DO MÓDULO DE ANÁLISE DE 
TRAFEGO DO SISTEMA DE GERENCIAMENTO HPE IMC 

R$ 12.745,00 R$ 25.490,00 

4 2 LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE 
PERFIL E CONTROLE DE ACESSO 

R$ 54.160,00 R$ 108.320,00 

5 6 SWITCH DE DISTRIBUIÇÃO COM 16 PORTAS SFP+ E 
SUPORTE A MÓDULOS DE EXPANSÃO 

R$ 49.117,00 R$ 294.702,00 

6 16 MÓDULO COM 4 PORTAS SFP+ PARA SWITCH DE 
DISTRIBUIÇÃO 

R$ 4.742,00 R$ 75.872,00 

7 6 MÓDULO DE STACKING COM 4 PORTAS PARA SWITCH DE 
DISTRIBUIÇÃO 

R$ 4.406,00 R$ 26.436,00 

8 50 SWITCH DE ACESSO L3 COM 48 PORTAS GIGABIT E 4SFP+ R$ 14.382,08 R$ 719.104,00 

9 40 SWITCH DE ACESSO L3 COM 24 PORTAS GIGABIT E 4SFP+ R$ 14.106,00 R$ 564.240,00 

10 50 SWITCH DE ACESSO L2 COM 24 PORTAS GIGABIT E 4SFP R$ 4.515,00 R$ 225.760,00 

11 40 SWITCH DE ACESSO L2 COM 48 PORTAS GIGABIT E 4SFP
    

R$ 8.245,00 R$ 329.800,00 

12 50 GBIC 10GB PARA ATÉ 300M R$ 2.064,87 R$ 103.243,50 

13 30 CABO DAC 10 GBPS DE 1M  R$ 411,00 R$ 12.330,00 

14 30 CABO DAC 10 GBPS DE 3M R$ 584,00 R$ 17.520,00 

15 10 GBIC 1GB PARA ATÉ 500M R$ 740,46 R$ 7.404,60 

16 5 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA SWITCHS DE REDE 

R$ 20.000,00 R$ 100.000,00 

17 1 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO
  

R$ 60.000,00 R$ 60.000,00 

18 4 TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE SWITCHES R$ 28.000,00 R$ 112.000,00 

19 4 TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE 
ACESSO 

R$ 28.000,00 R$ 112.000,00 

02 

20 1 SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 
PARA REDE WIRELESS 

R$ 104.180,00 R$ 104.180,00 

21 1 SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS R$ 570,00 R$ 570,00 

22 200 LICENÇAS ADICIONAIS PARA SOLUÇÃO DE GERENCIAMENTO 
DE REDE WIRELESS 

R$ 497,21 R$ 99.442,00 

23 2 LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE 
PERFIL E CONTROLE DE ACESSO 

R$ 55.000,00 R$ 110.000,00 

24 4 CONTROLADORA WLAN R$ 70.000,00 R$ 280.000,00 

25 200 LICENÇAS ADICIONAIS PARA CONTROLADORA WLAN
    

R$ 900,00 R$ 180.000,00 

26 100 PONTO DE ACESSO INTERNO TIPO 01 R$ 3.076,79 R$ 307.679,00 

27 100 PONTO DE ACESSO INTERNO TIPO 02 R$ 2.300,00 R$ 230.000,00 

28 100 INJETOR POE PARA PONTOS DE ACESSO TIPO 1 R$ 500,00 R$ 50.000,00 

29 100 INJETOR POE PARA PONTOS DE ACESSO TIPO 2 R$ 550,00 R$ 55.000,00 

30 1 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA SOLUÇÃO DE GERENCIAMENTO 

R$ 24.000,00 R$ 24.000,00 

31 1 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO 

R$ 24.000,00 R$ 24.000,00 
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32 5 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA PONTOS DE ACESSO 

R$ 20.000,00 R$ 100.000,00 

33 4 TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE 
ARQUITETURA WLAN 

R$ 20.000,00 R$ 80.000,00 

34 4 TREINAMENTO BÁSICO DA SOLUÇÃO DE GERENCIAMENTO R$ 20.000,00 R$ 80.000,00 

35 4 TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE 
ACESSO    

R$ 20.000,00 R$ 80.000,00 
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        ANEXO I-B 
 

       PLANILHA DE COMPOSIÇÃO DE CUSTOS POR ITEM 

 

Lote 1 Item Qtd Descrição Valor 
Unitário 

Valor 
Total 

 

01 

1 1 SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 
PARA REDE CABEADA 

  

2 3 LICENCIAMENTO ADICIONAL PARA SISTEMA DE 
GERENCIAMENTO HPE IMC 

  

3 2 LICENCIAMENTO ADICIONAL DO MÓDULO DE ANÁLISE DE 
TRAFEGO DO SISTEMA DE GERENCIAMENTO HPE IMC 

  

4 2 LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE 
PERFIL E CONTROLE DE ACESSO 

  

5 6 SWITCH DE DISTRIBUIÇÃO COM 16 PORTAS SFP+ E SUPORTE A 
MÓDULOS DE EXPANSÃO 

  

6 16 MÓDULO COM 4 PORTAS SFP+ PARA SWITCH DE 
DISTRIBUIÇÃO 

  

7 6 MÓDULO DE STACKING COM 4 PORTAS PARA SWITCH DE 
DISTRIBUIÇÃO 

  

8 50 SWITCH DE ACESSO L3 COM 48 PORTAS GIGABIT E 4SFP+   

9 40 SWITCH DE ACESSO L3 COM 24 PORTAS GIGABIT E 4SFP+   

10 50 SWITCH DE ACESSO L2 COM 24 PORTAS GIGABIT E 4SFP   

11 40 SWITCH DE ACESSO L2 COM 48 PORTAS GIGABIT E 4SFP 
   

  

12 50 GBIC 10GB PARA ATÉ 300M   

13 30 CABO DAC 10 GBPS DE 1M    

14 30 CABO DAC 10 GBPS DE 3M   

15 10 GBIC 1GB PARA ATÉ 500M   

16 5 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA SWITCHS DE REDE 

  

17 1 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO  

  

18 4 TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE SWITCHES   

19 4 TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE ACESSO   

02 

20 1 SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 
PARA REDE WIRELESS 

  

21 1 SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS   

22 200 LICENÇAS ADICIONAIS PARA SOLUÇÃO DE GERENCIAMENTO DE 
REDE WIRELESS 

  

23 2 LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE 
PERFIL E CONTROLE DE ACESSO 

  

24 4 CONTROLADORA WLAN   

25 200  LICENÇAS ADICIONAIS PARA 
CONTROLADORA WLAN    

  

26 100 PONTO DE ACESSO INTERNO TIPO 01   

27 100 PONTO DE ACESSO INTERNO TIPO 02   

28 100 INJETOR POE PARA PONTOS DE ACESSO TIPO 1   

29 100 INJETOR POE PARA PONTOS DE ACESSO TIPO 2   

30 1 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA SOLUÇÃO DE GERENCIAMENTO 

  

31 1 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO 

  

32 5 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA PONTOS DE ACESSO 

  

33 4 TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE ARQUITETURA 
WLAN 

  

34 4 TREINAMENTO BÁSICO DA SOLUÇÃO DE GERENCIAMENTO   

35 4 TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE ACESSO
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                                                 ANEXO II 
 

PREGÃO ELETRÔNICO Nº XX/2019 
  

PPLLAANNIILLHHAA  DDEE  DDAADDOOSS  PPAARRAA  CCOONNTTRRAATTAAÇÇÃÃOO 
 
Dados da Empresa: 
Razão Social  
CNPJ  
Endereço  
CEP  
Fones:  
Fax  
E-mail  
Site internet  

 
Dados do Representante da Empresa: 
Nome  
Cargo  
Nacionalidade  
Estado civil  
Profissão  
Endereço  
CEP  
Fone  
Fax  
E-mail  
Cart. Identidade  
Orgão Expedidor  
CPF  
 
Dados Bancários da Empresa 
Banco  
Agência  

Conta  
 
Dados do Contato com a Empresa: 
Nome  
Cargo  
Endereço  
CEP  
Fone  
Fax  
E-mail  
 
Empresa optante pelo SIMPLES?  (   ) Sim  (   ) Não 
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ANEXO III 
ATA DE REGISTRO DE PREÇOS n.º XX/2019  

 

Processo nº 0008478-63.2018.6.02.8000 
Pregão Eletrônico para Registro de Preços nº XX/2019 

 
MINUTA  

 
Aos ---- dias do mês ----------- de 2019, O TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS, 
Órgão do Poder Judiciário, em nome da União – Pessoa Jurídica de Direito Público Interno, 
inscrito no CNPJ nº 06.015.041/0001-38, sediado na Avenida Aristeu de Andrade, nº 377 – 
Farol, CEP: 57051-090, nesta, neste ato representado por seu Vice-Presidente no exercício 
da Presidência, Desembargador Otávio Leão Praxedes, brasileiro, casado, Magistrado, 
portador da Carteira de Identidade nº 215.430 SSP/AL, inscrito no CPF sob o nº 
087.912.284-68, residente e domiciliado nesta Cidade, resolve registrar os preços ofertados 
pela empresa ................................., (INFORMAR SE É MICROEMPRESA OU EMPRESA DE 
PEQUENO PORTE) CNPJ …....................., sediada em …..................., representada 
por..........................................., para eventual fornecimento dos materiais abaixo 
relacionados, conforme condições descritas nos  Anexos I e I-A do Pregão Eletrônico nº 
XX/2019, nos termos da Lei nº 8.666, de 21 de junho de 1993, da Lei nº 10.520, de 17 de 
julho de 2002, do Decreto nº 5.450, de 31 de maio de 2005, do Decreto nº 7.892, de 23 de 
janeiro de 2013, e demais normas legais aplicáveis. 

 
1 – DO OBJETO. 
 
1.1. A presente ata tem por objeto o registro de preços do(s) item(ns) abaixo, 
na forma do Edital de Pregão Eletrônico nº XX/2019: 

 

LOTE ITEM DESCRIÇÃO MARCA UNID. 
QUANT. 
TOTAL 

REGISTRADA 

VALOR 
UNITÁRIO 

(R$) 

VALOR 
TOTAL 
(R$) 

 

       

 
1.2. Relação dos licitantes que aceitaram cotar seus bens em valor igual ao do vencedor 
do certame para formação de cadastro de reserva, caso haja cancelamento do registro do 
fornecedor, conforme previsto no subitem 18.3 do edital do PE nº XX/2019: 
 

Nome da empresa CNPJ Preços Quantitativos 
    
    

 
2 – DO PRAZO DE VIGÊNCIA. 
 
2.1. O prazo de vigência do presente Registro de Preços é de 12 (doze) 
meses, contado da publicação do extrato desta ata. 
 
3 – DOS PRAZOS DE ENTREGA E DA GARANTIA.  

 

3.1. O prazo máximo para a entrega dos equipamentos é de 60 (sessenta) 
dias contados a partir do recebimento da Ordem de Fornecimento ou documento 
equivalente. 
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3.2. O prazo máximo para a entrega dos softwares é 30 (trinta) dias contados 
a partir do recebimento da Ordem de Fornecimento ou documento equivalente. 

 

3.3. Os serviços de instalação, integração, garantia e suporte dos 
equipamentos e softwares, deverão ser realizados diretamente pelo fabricante de acordo 
com as exigências contidas no descritivo dos mesmos, estando essas aderentes aos 
respectivos níveis de serviço necessários a cada um deles. 

 
3.4. Quanto aos itens 1, 2, 3, 4, 20, 22, 23 e 25,   a garantia e o suporte do 
fabricante para a solução de software deverá ser ofertado pelo período mínimo de 36 (trinta 
e seis) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 

 
3.4.1. Caso a garantia padrão do fabricante seja menor que a exigida, a 
proponente deverá informar em sua proposta o código de serviço de garantia do 
fabricante (“part number”), incorporada à solução. 

3.4.2.  O fabricante deve possuir canais de comunicação e ferramentas adicionais 
para suporte técnico online como “chat” e “e-mail” em seu site da internet com 
disponibilidade ainda de área para cadastro da solução de software ofertada, 
possibilitando assim que a CONTRATANTE possa receber de forma proativa, durante 
todo período da garantia as notificações de atualizações e correções (“hotfix”) da 
solução. 

3.4.3.  A empresa fabricante da solução de software deverá dispor de um número 
telefônico tipo 0800 para suporte técnico e abertura de chamados técnicos. 

3.4.4. A comprovação da modalidade da garantia deverá ocorrer através de 
documentação do fabricante de domínio público, não sendo aceita documentação 
emitida pelo fornecedor ou centro de distribuição para fins de comprovação que por 
ventura conflitem com catálogos, manuais, folders oficiais impressos ou da internet 
(devendo constar o endereço URL para folders da web). Caso não seja comprovada por 
um dos meios citados anteriormente, será possível a comprovação através da 
apresentação de documentação expressa do fabricante dos softwares, indicando o 
período de garantia dos produtos ofertados. Em caso de documentação expressa do 
fabricante deverá ser anexada a mesma a procuração que comprove que a fabricante 
outorga ao procurador os poderes para firmar e declarar as exigências solicitadas. 

3.5. Quanto aos itens 5, 8, 9, 10, 11, 24, 26 e 27, o equipamento ofertado 
deverá possuir garantia do fabricante na modalidade on-site pelo período mínimo de 60 
(sessenta) meses para reposição de peças, mão de obra e atendimento. O prazo máximo 
para atendimento do chamado deve ser de até o próximo dia útil após a sua abertura. 
Durante o período da garantia o prazo máximo para o reparo de equipamentos defeituosos 
a condição normal de funcionamento deverá ser de até 07 (sete) dias úteis. 

3.5.1. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente 
deverá informar em sua proposta o código de serviço de garantia do fabricante (“part 
number”), incorporada à solução. 

3.5.2. O fabricante deve possuir canais de comunicação e ferramentas adicionais para 
suporte técnico online como “chat” e “e-mail” em seu site da internet com 
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disponibilidade ainda de área para cadastro da solução de hardware ofertada, 
possibilitando assim que a CONTRATANTE possa receber de forma proativa, durante 
todo período da garantia as notificações de atualizações e correções (“hotfix”) da 
solução; 

3.5.3. A empresa fabricante do equipamento deverá dispor de um número telefônico 
tipo 0800 para suporte técnico e abertura de chamados técnicos. 

3.5.4. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e 
solução exigidos para os equipamentos, deverá ser comprovada a existência da 
assistência técnica local no domicílio da contratante e na modalidade on-site, devendo 
essa ser realizada por meio de documentação oficial do fabricante dos produtos e de 
domínio público, através de catálogos, folder impressos ou da internet, devendo 
constar o endereço URL na mesma. Caso não seja comprovada por um dos meios 
citados anteriormente, será possível a comprovação através da apresentação de 
documentação expressa do fabricante dos equipamentos, indicando a referida 
assistência técnica que será responsável pelo atendimento e manutenção durante o 
período de garantia dos produtos ofertados. Em caso de documentação expressa do 
fabricante a esta deverá ser anexada uma procuração que comprove que a fabricante 
outorga ao procurador os poderes para firmar e declarar as exigências solicitadas. 

3.5.5. Todos os componentes instalados ou integrados dos equipamentos devem ser 
do próprio fabricante ou estar em conformidade com a política de garantia do mesmo, 
não sendo permitida a integração de itens de terceiros que possam acarretar em 
perda parcial da garantia ou não realização da manutenção técnica pelo próprio 
fabricante quando solicitada. 

3.6.   Quanto aos itens 6, 7, 12, 13, 14, 15, 28 e  29, O equipamento ofertado 
deverá possuir garantia do fabricante do equipamento na modalidade on-site pelo período 
mínimo de 12 (doze) meses para reposição de peças, mão de obra e atendimento no local. 
O período da garantia o prazo máximo para o reparo de equipamentos defeituosos a 
condição normal de funcionamento deverá ser de até 07 (sete) dias úteis. 

3.6.1. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente 
deverá informar em sua proposta o código de serviço de garantia do fabricante (part 
number), incorporado ao equipamento. 

3.6.2. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do 
próprio fabricante ou estar em conformidade com a política de garantia do mesmo, 
não sendo permitida a integração de itens de terceiros que possam acarretar em 
perda parcial da garantia ou não realização da manutenção técnica pelo próprio 
fabricante quando solicitada. 

 
4. DAS OBRIGAÇÕES DO ÓRGÃO GERENCIADOR. 
 
4.1. São obrigações do Órgão Gerenciador: 
 

a) Gerenciar a presente Ata, indicando, sempre que solicitado, o nome do 
detentor da ata, o preço, e as especificações dos materiais registrados, 
observada a ordem de classificação indicada na licitação; 
b) Observar para que, durante a vigência da presente ata, sejam mantidas 
todas as condições de habilitação e qualificação exigidas na licitação, bem 
assim, a compatibilidade com as obrigações assumidas; 
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c) Conduzir eventuais renegociações dos preços registrados, para fins de 
adequação às novas condições de mercado; 
d) Realizar, periodicamente, pesquisa de mercado para comprovação da 
vantajosidade dos preços registrados na Ata; 
e) Acompanhar e fiscalizar o cumprimento das condições ajustadas na 
presente Ata; 
f) Aplicar, garantida a ampla defesa e o contraditório, as penalidades 
decorrentes do descumprimento do pactuado na ata de registro de preços ou 
do descumprimento das obrigações contratuais, em relação às suas próprias 
contratações; 
g) Consultar o detentor da ata registrada (observada a ordem de classificação) 
quanto ao interesse em fornecer o material a outro(s) órgão(s) da 
Administração Pública que externe(m) a intenção de utilizar a presente Ata. 

 
4.2. São ainda obrigações do órgão gerenciador da ata, na condição de 
contratante: 

a) Efetuar o pagamento à Contratada, após o recebimento definitivo; 
b) Acompanhar e fiscalizar a execução do objeto da Ata 
de Registro de Preços e do(s) contrato(s) dela decorrentes, 
por meio de servidor(es) designado(s), 
de modo a garantir o fiel cumprimento do mesmo e da proposta; 
c) Manter arquivo, junto ao processo administrativo ao qual está vinculado 
o presente termo,  toda a documentação referente ao mesmo; 
d) Proporcionar todas as facilidades indispensáveis à 
boa execução das obrigações contratuais; e 
e) Aplicar as sanções conforme previsto no contrato, assegurando à Contrata
da o contraditório e ampla defesa. 

5. DAS OBRIGAÇÕES DO DETENTOR DA ATA 
 
5.1. São obrigações do detentor da Ata: 
 

a) Providenciar a imediata correção de deficiências, falhas ou irregularidades 
constatadas pelo ÓRGÃO GERENCIADOR referentes às condições firmadas na 
presente Ata; 
b) Viabilizar o atendimento das condições firmadas a partir da data da 
publicação da presente Ata; 
c) Manter, durante o prazo de vigência da presente Ata, todas as condições de 
idoneidade exigidas na licitação, além de sujeitar-se às demais disposições do 
Código de Proteção e Defesa do Consumidor (Lei n° 8.078/90) que sejam 
compatíveis com o regime de direito público; 
d) Informar, no prazo máximo de 05 (cinco) dias úteis, contados do 
recebimento da notificação, quanto à aceitação ou não do fornecimento de 
material a outro órgão da Administração Pública (não participante) que venha 
a manifestar o interesse de utilizar a presente Ata. 
 

5.2. São, ainda, obrigações do detentor da Ata, na condição de contratado: 
 

a) Executar o contrato em estrita conformidade com as disposições e 
especificações do Edital e com os termos da proposta de preços; 

b) Fornecer os equipamentos conforme especificações, quantidades, 
prazos e demais condições estabelecidas no Edital, na Ata de Registro de 
Preços, na Ordem de Fornecimento e na Proposta de preços; 
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c) Fornecer a documentação necessária à instalação e à operação dos 
produtos (manuais, termos de garantia, etc.), completa, atualizada e em 
português do Brasil, caso exista, ou em inglês; 

d) Disponibilizar Central de Atendimento para a abertura e fechamento 
de chamados técnicos, conforme períodos, horários e condições 
estabelecidas no Edital e em seus Anexos; 

e) Comunicar formal e imediatamente ao Gestor ou Responsável Técnico 
da Administração sobre mudanças nos dados para contato com a Central 
de Atendimento; 

f) Prestar as informações e os esclarecimentos que venham a ser 
solicitados pelo representante da Administração, referentes a qualquer 
problema detectado ou ao andamento de atividades da garantia; 

g)  Responder por quaisquer prejuízos que seus profissionais causarem 
ao patrimônio da Administração ou a terceiros, por ocasião da execução 
do objeto, procedendo imediatamente aos reparos ou às indenizações 
cabíveis e assumindo o ônus decorrente; 

h) Responsabilizar-se integralmente pelo fornecimento dos equipamentos 
e pela execução dos serviços de garantia técnica, primando pela 
qualidade, desempenho, eficiência e produtividade na execução dos 
trabalhos, dentro dos prazos estipulados e cujo descumprimento será 
considerado infração passível de aplicação das penalidades previstas no 
Termo de Referência (Anexo I); 

i) Comunicar ao Gestor ou Responsável Técnico, formal e 
imediatamente, todas as ocorrências anormais e/ou que possam 
comprometer a execução do objeto; 
 
j) Manter sigilo sobre todo e qualquer assunto de interesse da 
Administração ou de terceiros de que tomar conhecimento em razão da 
execução do objeto, respeitando todos os critérios estabelecidos, 
aplicáveis aos dados, informações, regras de negócios, documentos, 
entre outros pertinentes, sob pena de responsabilidade civil, penal e 
administrativa; 

 
k) Cumprir e garantir que seus profissionais estejam cientes, aderentes e 
obedeçam rigorosamente às normas e aos procedimentos estabelecidos 
na Política de Segurança da Informação do TRE/AL; 

 
l) Responsabilizar-se pela conservação dos ambientes onde desempenhe 
as atividades necessárias para prestar a garantia on-site; 

 
m) Prestar as informações e os esclarecimentos que venham a ser 
solicitados pela Administração, referentes a qualquer problema 
detectado ou ao andamento de atividades da garantia técnica. 
 
n) Indicar endereço eletrônico (e-mail) para o recebimento de 
expedientes/notificações enviadas pelo TRE/AL, sendo considerados 
válidos todos os expedientes/notificações enviadas ao endereço 
eletrônico indicado; 
 
o) Manter durante a execução do contrato todas as condições que 
culminaram em sua habilitação, principalmente a regularidade fiscal e 
previdenciária, condições de idoneidade exigidas na licitação e outras 
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previstas na legislação vigente e na aplicável à natureza dos serviços 
objeto da contratação; 
 
p) Aceitar o cancelamento da ordem de fornecimento por parte da 
Administração, no caso de fornecimento/entrega, em final de exercício 
e posterior ao dia 15 de dezembro ou dia útil imediatamente 
subsequente, em decorrência dos efeitos da Emenda Constitucional nº 
95/2016, sem a reversão de qualquer ônus à Administração. 
 
q) Apresentar certidões de quitação junto à Receita Federal, Dívida Ativa 
da União, INSS, FGTS, Fazenda Estadual  e Fazenda Municipal ou estar 
registrada junto ao SICAF em condição regular; 
 
r) Acatar outras determinações previstas na legislação aplicável à 
natureza do objeto deste contrato; 
 
s) Cumprir com outras obrigações decorrentes da aplicação do Código 
de Proteção e Defesa do Consumidor (Lei nº 8.078/1990) que sejam 
compatíveis com o regime de Direito Público. 

 
6 - DO PAGAMENTO. 
 
6.1. O pagamento será efetuado mediante ordem bancária de crédito em 
conta corrente, em até 10 (dez) dias, após o recebimento da Nota Fiscal respectiva, a qual 
deverá ser entregue somente após a prestação dos serviços, devendo a contratada atender 
os seguintes requisitos: 

a) Apresentação de nota fiscal de acordo com a legislação vigente à época da 
emissão (nota fiscaleletrônica, se for o caso), acompanhada do Certificado 
de Regularidade do FGTS – CRF, comprovando regularidade com o FGTS; da 
Certidão Conjunta Negativa de Débitos Relativos a Tributos Federais e à Dívida 
Ativa da União, que incluindo as referentes a contribuições previdenciárias, 
expedida pela Secretaria da Receita Federal; e da Certidão Negativa de 
Débitos Trabalhistas – CNDT, emitida pela Justiça do Trabalho; e da prova de 
regularidade para com as Fazendas Estadual do domicílio ou sede do 
Fornecedor; e 

b) Inexistência de fato impeditivo para o qual tenha concorrido o Fornecedor. 

6.2.  Eventuais penalidades poderão ser descontadas do pagamento. 
 
6.3.  Em nenhuma hipótese haverá antecipação de pagamento. 
 
6.4.  O TRE/AL, por ocasião de cada pagamento, fará as retenções e 
recolhimentos fiscais determinados pela legislação tributária. 
 
6.5.  Se a empresa for optante pelo SIMPLES, deverá anexar à nota fiscal 
documento que comprove tal opção, para que sobre o valor do pagamento não incidam as 
retenções de que trata o item anterior. 
 
6.6.  Havendo atraso no pagamento, o valor devido deverá ser acrescido de 
encargos moratórios, apurados desde a data do primeiro dia útil do atraso, até a data do 
efetivo pagamento, desde que o contratado não tenha concorrido para tanto, mediante a 
aplicação da seguinte fórmula: 
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EM = I x N x VP, 
 
Onde: 
EM= Encargos Moratórios 
N= Número de dias entre a data prevista para o pagamento e a do efetivo pagamento; 
VP = Valor da parcela a ser paga; 
I= Índice de atualização financeira= 0,0001644, assim apurado: 
 
I = (TX/100)                  I= (6/100)           I = 0,0001644 
         365                             365 
TX= Percentual de Taxa Anual= 6% 

6.7.  Nenhum pagamento será efetuado à Contratada enquanto pendente de 
liquidação qualquer obrigação. Esse fato não será gerador de direito a reajustamento de 
preços ou a atualização monetária. 

7 – DO RECEBIMENTO DO OBJETO. 
 
7.1. O objeto deverá ser entregue, no prazo previsto no item 3 desta Ata, contados do 
recebimento da Nota de Empenho ou Ordem de Fornecimento, por e-mail ou ofício, o que 
ocorrer primeiro, no horário de expediente normal, de segunda a sexta-feira, na Seção de 
Almoxarifado do Tribunal Regional Eleitoral de Alagoas, localizada na Avenida Menino 
Marcelo (antiga via expressa), nº 7.200 D – Serraria, Maceió/AL, CEP: 57046-005, sob 
agendamento através do telefone (82) 3328-1947. 
 
7.2. O objeto será recebido: 
 

a) provisoriamente, para que seja feita a verificação da conformidade dos mesmos 
com as especificações. 

 
b) definitivamente, após avaliação e homologação pelos responsáveis técnicos 
do Tribunal, da seguinte forma: 

b.1) O exame para comprovação das características técnicas consistirá em 
avaliações e testes não-destrutivos, por amostragem realizados em duas 
etapas: 

a. Primeira: inspeção visual de todos os equipamentos entregues; 
b. Segunda: testes funcionais de configuração e desempenho, em, no 

mínimo, 10% (dez por cento) e não menos do que 01 (um) dos 
equipamentos recebidos. O Tribunal poderá, a seu critério, executar 
os testes nos demais equipamentos, dentro de um critério de 
razoabilidade, podendo chegar a 100% dos quantitativos, mas dentro 
de um prazo máximo de 30 (trinta) dias corridos e contados de cada 
lote de equipamentos. 

b.2) As especificações serão avaliadas também por meio de documentos 
técnicos que acompanham os equipamentos, informações fornecidas pela 
Contratada e disponível no sítio do fabricante; 

b.3) A comissão do Tribunal deverá, após a comprovação do perfeito 
funcionamento dos equipamentos e adequação às especificações técnicas, 
emitir e assinar o Termo de Recebimento Definitivo. 
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7.3. O produto será rejeitado no caso de incompatibilidade com as 
especificações previstas na proposta ou quando inadequado à sua utilização. 
 
7.4. O prazo para a Secretaria competente proceder às verificações, após o 
recebimento provisório, será de 05 (cinco) dias úteis, quando deverá se manifestar, 
aceitando ou recusando o item objeto do fornecimento. 
 
7.5. Os recebimentos provisório e definitivo se darão mediante formulário 
próprio. 
 
7.6. O recebimento definitivo não exime o fornecedor de responder pelos 
vícios aparentes e ocultos segundo as disposições deste termo e as normas de proteção ao 
consumidor. 
 
7.7. O objeto que estiver em desacordo com as especificações do edital terá seu 
recebimento recusado, devendo o fornecedor, dentro do prazo de 10 (dez) dias corridos, 
substituir o produto adequadamente, sujeitando-se à multa prevista na Seção 8. 
 
8 - DAS SANÇÕES ADMINISTRATIVAS. 
 
8.1. Com fundamento no artigo 7º da Lei nº 10.520/2002 e, subsidiariamente, 
nos artigos 86 e 87 da Lei 8.666/1993, a Contratada ficará sujeita, assegurada prévia e 
ampla defesa, às seguintes penalidades:  

 
a. Advertência:  
 

i. A Contratada será notificada formalmente em caso de descumprimento de 
obrigação contratual e terá que apresentar as devidas justificativas em um prazo 
de até 5 (cinco) dias úteis após o recebimento da notificação; e 

 
ii. Caso não haja manifestação dentro desse prazo ou se entenda serem 
improcedentes as justificativas apresentadas, a Contratada será advertida. 

 
b. Multa de: 

 
i. 0,5% (meio por cento) por dia, e por ocorrência, sobre o valor do 

objeto com atraso injustificado, limitada a incidência a 20 (vinte) 
dias corridos; 

- No caso de atraso injustificado na entrega do objeto por prazo superior a 20 
(vinte) dias corridos, com 
a aceitação pela Administração, será aplicada a multa de 10% sobre o valor 
da Ordem de Fornecimento; e 

-  No caso de atraso injustificado na prestação dos serviços por prazo superior a 
20 (vinte) dias corridos, com a não aceitação pela Administração, será aplicada a 
penalidade 20% sobre o valor da Ordem de Fornecimento, no caso de inexecução 
total da obrigação, podendo haver, ainda, o cancelamento do registro de preços 
do Fornecedor. 

ii. 10% sobre o valor constante da Ordem de Fornecimento, no caso de inexecução 
parcial da obrigação assumida; 
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iii. 20% (vinte por cento) sobre o valor adjudicado, em caso de inexecução total da 
obrigação assumida; 

iv. 10% sobre o valor global da Ata de Registro de Preços, na hipótese de recusa em 
assinar a Ata ou retirar a Ordem de Fornecimento; 

c. Impedimento de licitar e contratar com a União e descredenciamento do SICAF 
pelo prazo de até 5 (cinco) anos, sem prejuízo das demais penalidades legais; e  
 
d. Declaração de inidoneidade para licitar ou contratar com a Administração 
Pública.  

 
8.2.    O cometimento reiterado de atrasos injustificados dos prazos previstos para 
entrega/solução do chamado de garantia dos equipamentos poderá resultar no 
cancelamento do instrumento de fornecimento com a Contratada. 
 
8.3.   As sanções previstas nos itens "18.1.a", “18.1.c” e “18.1.d” poderão ser 
aplicadas, cumulativamente ou não, à pena de multa.  
 
8.4.   O valor da multa, aplicada após o regular processo administrativo, será 
descontado de pagamentos eventualmente devidos à contratada ou cobrado judicialmente;  
 
8.5.   Excepcionalmente, ad cautelam, a Administração poderá efetuar a retenção 
do valor presumido da multa, antes da instauração do regular procedimento administrativo. 
 
8.6.   O valor da multa, apurado após regular procedimento administrativo, será 
descontado dos pagamentos eventualmente devidos pelo TRE/AL ou cobrado judicialmente. 
 
8.7.   Na aplicação das penalidades previstas nesta Seção a autoridade 
competente sempre se valerá dos princípios da proporcionalidade, da razoabilidade e da 
prevalência e indisponibilidade do interesse público, em decorrência de circunstâncias 
fundamentadas em fatos comprovados. 
 
8.8.   O licitante contratado, quando não puder cumprir os prazos 
estipulados para o fornecimento do material, total ou parcialmente, deverá apresentar 
justificativa por escrito, devidamente comprovada, e em documento contemporâneo à sua 
ocorrência, acompanhada de pedido de prorrogação, nos casos de ocorrência de fato 
superveniente, excepcional ou imprevisível, estranho à vontade das partes, que altere 
fundamentalmente as condições do contrato, ou que impeça a sua execução, por fato ou 
ato de terceiro reconhecido pela Administração.  
 
8.9.  Do ato que aplicar as penalidades caberá recurso na forma do art. 109 da Lei 
nº 8.666/1993. 
 
8.10.  Se o licitante contratado não recolher o valor da multa que lhe for aplicada, 
dentro de 05 (cinco) dias úteis a contar da data da intimação para o pagamento, a 
importância será descontada automaticamente, ou ajuizada a dívida, consoante o § 3º do 
art. 86 e § 1º do art. 87 da Lei nº 8.666/1993, acrescida de juros moratórios de 0,5% (meio 
por cento) ao mês. 
 
8.11.  O TRE/AL promoverá o registro no SICAF de toda e qualquer penalidade 
imposta ao licitante contratado. 
 
8.12.  O período de atraso será contado em dias corridos. 
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8.13. No caso de aplicação de penalidade em que a contratada tenha que 
pagar multa através de Guia de Recolhimento da União – GRU, e não o faça no devido 
prazo, o índice utilizado para atualização do valor será o IPCA. 
 
8.14. A data a ser utilizada como referência para a atualização do débito será a 
da publicação da decisão da aplicação da penalidade no Diário Eletrônico.  
 
8.15.  Fica estabelecido que os casos omissos serão resolvidos entre as partes 
contratantes, respeitados o objeto da presente licitação, a legislação e demais normas 
reguladoras da matéria, em especial as Leis nos 8.666/1993 e  10.520/2002, aplicando-lhes, 
quando for o caso, supletivamente, os princípios da Teoria Geral dos Contratos e as 
disposições do Direito Privado. 

 
18.16.  Os atos administrativos de aplicação das sanções, com exceção de 
advertência, multa de mora e convencional, serão publicados resumidamente no Diário 
Oficial da União. 

9 – DA VEDAÇÃO DE ACRÉSCIMO NOS QUANTITATIVOS REGISTRADOS 

9.1.     É vedado efetuar acréscimos nos quantitativos fixados na presente  ata de 
registro de preços, inclusive o acréscimo de que trata o § 1º do art. 65 da Lei nº 8.666, de 
1993, de acordo com o disposto no § 1º, art. 12 do Decreto nº 7.892/2013. 
 
10  - DA PUBLICAÇÃO 
 
10.1.       O extrato da presente ata será publicado no Diário Oficial da União. 
 
11 – DO FORO 
 
11.1.  Fica eleito o foro da Seção Judiciária da Justiça Federal da Capital do 
Estado de Alagoas, para dirimir as questões originadas deste contrato, com exclusão de 
qualquer outro, por mais privilegiado que seja. 
 

E por estarem justos e contratados, foi lavrado o presente instrumento, em 02 (duas) vias 
de igual teor e forma, que, após lido e achado conforme, segue assinado pelas partes. 

Maceió, XX de XXXX de 2019. 
 
Pelo TRE/AL: 
 

Desembargador Otávio Leão Praxedes 
Vice-Presidente, no exercício da Presidência 

 
Pela Empresa: 
 

 

Minuta de edita (0578992)         SEI 0008478-63.2018.6.02.8000 / pg. 581

http://www.planalto.gov.br/ccivil_03/LEIS/L8666cons.htm#art65§1
http://www.planalto.gov.br/ccivil_03/LEIS/L8666cons.htm#art65§1


TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 09 de agosto de 2019.
À SAD, 
com minuta alterada do edital, conforme solicitado

pela AJ-DG.
Solicito manifestação quanto à conveniência de

inclusão de qualificação econômino-financeira, conforme
solicitado pela AJ-DG, em caso positivo indicar seus termos.

Ressalto que  o servidor Cristino do COINF
informou que o prazo de entrega  correto é o constante no
item 3 do edital.

Respeitosamente,
 

Documento assinado eletronicamente por INGRID PEREIRA DE LIMA ARAÚJO,
Técnico Judiciário, em 09/08/2019, às 12:38, conforme art. 1º, III, "b", da Lei
11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0578995 e o código CRC A667EBDB.
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PROCESSO : 0008478-63.2018.6.02.8000
INTERESSADO : SECRETARIA DE TECNOLOGIA DA INFORMAÇÃO
ASSUNTO : COMPONENTES DE REDE (NETWORKING). COTAÇÃO DE PREÇOS. MENOR PREÇO ORÇADO. CONSULTA.

 

Parecer nº 1648 / 2019 - TRE-AL/PRE/ACAGE

Senhora Assessora-Chefe, 
 
Trata-se de provocação promovida pela Assessoria

Jurídica da Diretoria Geral em seu Parecer n.º 1555/2019
(0574780), face sugestão suscitada em Informação n.º 3875
(0560123) pela Seção de Instrução de Contratações - SEIC
acerca da adoção, como estimativa de preços para a aquisição
dos equipamentos objeto destes autos, dos menores preços
obtidos na pesquisa realizada por aquele Setor, conforme
podemos observar em trecho a seguir transcrito: 

 
Veio o procedimento a esta Seção de Instrução
de Contratações - SEIC para realização de
pesquisa de preços (Despachos
GSAD 0520870 e COMAP 0521551), visando
ao Registro de Preços de equipamentos de
Soluções de Tecnologia da Informação -
componentes de rede (Networking), conforme
Termo de Referência ajustado 0541748.
Foram consultadas diversas empresas do
ramo, incluindo as empresas indicadas pela
unidade demandante como potenciais
fornecedoras dos equipamentos requeridos,
conforme
eventos 0522495, 0522526, 0523417, 0526142,
seguidos de vários contatos telefônicos e
algumas promessas de envio de cotação, a
exemplo das empresas 7secure, Smartwave
Networks, Ingram Micro; outras empresas
informaram não atenderem ao requerido, como
reportado pela Wintronic, SoloNetwork,
Supriservice, New Tech e Usetech.
As empresas ISH Tecnologia e Approach
Tecnologia enviaram Atas de Registro de
Preços vigentes para itens apontados pela
unidade técnica demandante como
equivalentes a alguns itens requeridos no TR,
servindo, portanto, como base para a formação
do preço estimado para esses itens.
Apresentaram orçamentos para o
fornecimento as empresa Plugnet (0533091),
NewSupri (0535906) e ISH Tecnologia
(0551756), conforme Planilha de Preços
Recebidos (evento 0559828).
Portanto, tendo em vista as aquisições
passadas de equipamentos de mesma
natureza, quanto aos resultados normalmente
obtidos nos procedimentos licitatórios, com
preços fechados abaixo dos valores médios
estimados - vez que os preços apresentados
pelas empresas fornecedoras na fase de
pesquisa são preços de balcão, como são
chamados, deixando, como vem ocorrendo, a
negociação para o momento do certame,
entendemos prudente sugerir, como
estimativa de preços para a aquisição dos
equipamentos, salvo melhor entendimento, os
menores preços obtidos na pesquisa para cada
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item do Termo de Referência, considerando-se,
inclusive, manifestação da unidade técnica
demandante constante na Informação COINF
3789 (0558080).

 
  Debruçado acerca da presente consulta, a

Assessoria Jurídica, por meio do antedito documento
(0574780), trouxe orientação fornecida pela Editora Zênite,
empresa contratada pela Justiça Eleitoral para a prestação de
serviços de consultoria em licitações e contratos, ao qual
reproduzimos a conclusão acerca de caso análogo por ela
analisado:

 
"Pretende-se realizar licitação para a
contratação de serviços de manutenção
predial no âmbito do Poder Judiciário
Estadual. Após intensa pesquisa
de preços houve retorno de apenas três
empresas entre as vinte que foram
consultadas para cotação. As respostas
exibiam valores díspares, retirando a
confiabilidade do critério de média aritmética.
Desta forma, questionamos a aplicabilidade ao
caso da Instrução Normativa nº 05 da SLTI do
MPOG, a qual não alcança esta Administração
Judiciária, em face de seu art. 1º, § único. Em
caso positivo, indagamos a possibilidade de
empregar o disposto no art. 2º,§2º da referida
Instrução, com utilização do menor preço
obtido (preço mínimo) como critério de
balizamento da estimativa."
ORIENTAÇÃO ZÊNITE
As dúvidas da Administração envolvem o
procedimento a ser adotado para fins de
estimativa do valor da licitação que será
deflagrada para a contratação de serviços de
manutenção predial no âmbito do Poder
Judiciário Estadual, tendo em vista a
dificuldade enfrentada na obtenção, junto a
fornecedores, de orçamentos que refletissem
com segurança a média de preços praticada.
De início, válido recordar que a conformidade
dos preços contratados com aqueles
praticados no mercado constitui um dos
fatores de legitimidade das contratações
públicas. Isso porque, entre os princípios que
informam o agir da Administração, destaca-se
o da economicidade, por força do qual as
necessidades públicas devem ser satisfeitas
com o melhor aproveitamento de recursos
públicos possível.
Nesse passo, a delineação adequada do valor
estimado da contratação ganha relevância,
exigindo da Administração cautela no
levantamento das informações pertinentes na
etapa de planejamento. Sem a
adequada cotação de preços, a
Administração (i)não tem como aferir a
modalidade licitatória adequada e, inclusive, a
possibilidade de eventual contratação
direta; (ii) não consegue avaliar a efetiva
disponibilidade financeira para a execução do
contrato; e (iii) não detém fundamentos para a
fixação de critérios objetivos para o
julgamento e aceitabilidade das ofertas,
ficando sujeita à contratação de propostas
desvantajosas por serem excessivas ou
potencialmente prejudiciais por serem
inexequíveis.
Com o intuito de vincular a Administração à
contratação de propostas que reflitam as
condições praticadas no segmento, a Lei de
Licitações impõe o dever de a Administração
contratar preço em conformidade com a
realidade de mercado, conforme se depreende
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dos seguintes dispositivos: art. 15, III, § 6º;
art. 24, VIII, X, XX, XXIII; art. 26, parágrafo
único, III; art. 43, IV; art. 44, § 3º; art. 48, II.
Não obstante imponha o dever de observância
dos preços de mercado, a Lei de Licitações
não estabelece o procedimento a ser adotado
para promover esse levantamento.
Diante disso, mostra-se oportuna a
adoção, como parâmetro, da Instrução
Normativa nº 05/2014 da Secretaria de
Logística e Tecnologia da Informação do
Ministério do Planejamento, Orçamento e
Gestão, que reflete as boas práticas indicadas
pela doutrina e pelos órgãos de controle ao
dispor "sobre o procedimento administrativo
para a realização de pesquisa de preços para a
aquisição de bens e contratação
de serviços em geral" (art. 1º).
(...)
Dito isso, passa-se à análise do disposto no art.
2º da IN nº 05/2014, abaixo transcrito:
"Art. 2º A pesquisa de preços será realizada
mediante a utilização de um dos seguintes
parâmetros:
I - Portal de Compras Governamentais -
www.comprasgovernamentais.gov.br;
II - pesquisa publicada em mídia especializada,
sítios eletrônicos especializados ou de domínio
amplo, desde que contenha a data e hora de
acesso;
III - contratações similares de outros entes
públicos, em execução ou concluídos nos 180
(cento e oitenta) dias anteriores à data
da pesquisa de preços; ou
IV - pesquisa com os fornecedores.
§ 1º No caso do inciso I será admitida
a pesquisa de um único preço.
§ 2º No âmbito de cada parâmetro, o resultado
da pesquisa de preços será a média ou
o menor dos preços obtidos.
§ 3º A utilização de outro método para a
obtenção do resultado da pesquisa de preços,
que não o disposto no § 2º, deverá ser
devidamente justificada pela autoridade
competente.
§ 4º No caso do inciso IV, somente serão
admitidos os preços cujas datas não se
diferenciem em mais de 180 (cento e oitenta)
dias.
§ 5º Excepcionalmente, mediante justificativa
da autoridade competente, será admitida
a pesquisa com menos
de três preços ou fornecedores.
§ 6º Para a obtenção do resultado
da pesquisa de preços, não poderão ser
considerados os preços inexequíveis ou os
excessivamente elevados, conforme critérios
fundamentados e descritos no processo
administrativo." (Destacamos.)
Ao indicar as formas de pesquisa de preços, a
IN teve como objetivo estabelecer métodos
que conferissem maior grau de segurança e
controle em torno da obtenção de resultados
atuais, capazes de refletir efetivamente
valores praticados no segmento.
E é justamente pela notoriedade da
problemática envolta
na pesquisa de preços realizada
exclusivamente junto a
potenciais fornecedores que a citada IN
indica outras formas de obter a
estimativa de preços e exige, como regra,
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a obtenção de pelo
menos três orçamentos distintos.  Essa
regra é excepcionada quando
a pesquisa é feita no Portal de Compras
Governamentais ou quando,
justificadamente, não for possível obter
três orçamentos.
Essa também é a orientação do Tribunal
de Contas da União, que registrou o
seguinte Enunciado no Informativo de
Licitações e Contratos n. 63:
"Enunciado: No caso de impossibilidade
de obtenção de preços referenciais, via
sistemas oficiais, para a estimativa dos
custos em processos licitatórios, deve ser
realizada pesquisa contendo o mínimo
de três cotações de
empresas/fornecedores distintos, fazendo
constar do respectivo processo a
documentação comprobatória pertinente
aos levantamentos e estudos que
fundamentaram o preço
estimado, devendo ser devidamente
justificadas as situações em que não for
possível atingir o número mínimo de
cotações." (Acórdão n.º 1266/2011-
Plenário, TC-002.573/2011-3, rel. Min.
Ubiratan Aguiar, 18.05.2011 -
destacamos.)
Ademais, válido pontuar  que o TCU, no
Acórdão nº 1.445/2015 – Plenário, deu ciência
ao órgão jurisdicionado de que:
"9.3.2. para fim de orçamentação nas
licitações de bens e serviços, devem ser
priorizados os parâmetros previstos nos
incisos I e III do art. 2º da IN SLTI/MPOG
5/2014, quais sejam, ‘Portal de Compras
Governamentais’ e ‘contratações similares de
outros entes públicos’, em detrimento dos
parâmetros contidos nos incisos II e IV
daquele mesmo art. 2º, isto é,
‘pesquisa publicada em mídia especializada,
sítios eletrônicos especializados ou de domínio
amplo’ e ‘pesquisa com os fornecedores’, cuja
adoção deve ser vista como prática
subsidiária, suplementar;" (Destacamos.)
Em vista do cenário envolto na obtenção de
orçamentos junto aos potenciais fornecedores,
entende-se que a primeira providência a ser
adotada pela Administração refere-se à
ampliação das fontes de pesquisa para fins de
definição dos critérios de julgamento que
serão estabelecidos no edital da licitação
futura.
Para tanto, é recomendável que a
Administração promova diligências com vistas
a avaliar se os preços obtidos junto aos
fornecedores na etapa de planejamento
correspondem aos valores praticados em
contratações similares registradas no Portal
de Compras Governamentais, ou em
mídia/sítios eletrônicos especializados, ou em
contratações similares de outros entes
públicos.
A partir disso, a Administração terá condições
de determinar se os orçamentos encaminhados
pelos fornecedores refletem valores
pertinentes com aqueles praticados no
mercado ou não, e, assim, definir o parâmetro
para estimar o valor da futura licitação (o
menor valor obtido ou a média entre todos
os preços).
A decisão pela consideração do menor valor
pesquisado ou pela média de todos
os preços conhecidos deve ser motivada,
considerando que depende de análise crítica
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da Administração em torno da sua realidade
orçamentária, bem como do
próprio mercado em que estão inseridos os
objetos pretendidos.
Essa motivação se aplica independentemente
de a Administração ter sido bem sucedida na
ampliação das fontes de pesquisa. Tendo ou
não uma variedade de fontes a respeito dos
valores praticados no mercado, a estimativa do
valor da licitação a partir do menor preço ou
da média dos preços obtidos requer
justificativa pertinente.
Sendo assim, é preciso avaliar se a área
técnica detém condições de justificar a
exequibilidade do menor valor pesquisado e a
inadequação dos demais preços obtidos.
Somente se houver elementos capazes de
aferir a regularidade do parâmetro eleito é que
a Administração terá condições de motivar a
estimativa de preços da futura licitação com
base apenas no menor valor pesquisado.
Essa análise é de suma importância, na
medida em que não é adequada a delineação
dos critérios de aceitabilidade das propostas
com base em valores que escapam à margem
de variação usual
dos preços do mercado. Tanto é assim que o
TCU já havia manifestado entendimento
similar à regra indicada no § 6º do art. 2º da
IN nº 05/2014:
"Em processo de fiscalização de contratação
realizada por meio de dispensa, foi identificada
irregularidade na fase de planejamento
consistente na realização de pesquisa de preço
baseada apenas em contrato semelhante
firmado com outra entidade do mesmo setor e
no valor apresentado pela futura contratada.
Analisando o caso, o TCU enfatizou a
relevância da fase de planejamento como
forma de assegurar a economicidade na
contratação, manifestando-se quanto
à pesquisa de preços nos seguintes termos: '6.
Para a estimativa do preço a ser contratado,
é necessário consultar as fontes
de pesquisa que sejam capazes de representar
o mercado. A propósito, o Voto que conduziu o
Acórdão 2.170/2007 - TCU - Plenário, citado no
relatório de auditoria, indica exemplos de
fontes de pesquisa de preço, in verbis: 'Esse
conjunto de preços ao qual me referi como
'cesta de preços aceitáveis' pode ser oriundo,
por exemplo, de pesquisas junto
a fornecedores, valores adjudicados em
licitações de órgãos públicos – inclusos
aqueles constantes no Comprasnet –, valores
registrados em atas de SRP, entre outras
fontes disponíveis tanto para os gestores como
para os órgãos de controle – a exemplo de
compras/contratações realizadas por
corporações privadas em condições idênticas
ou semelhantes àquelas da Administração
Pública –, desde que, com relação a qualquer
das fontes utilizadas, sejam expurgados os
valores que, manifestamente, não representem
a realidade do mercado'.' (TCU, Acórdão nº
868/2013, Plenário, Rel. Min. Marcos
Bemquerer, DOU de
22.04.2013.)"3 (Destacamos.)
Veja-se que a escolha do critério
balizador dos preços na futura licitação
exige motivação pautada na prática
de mercado. Por essa razão, importante
identificar se há um padrão de repetição e
variação dos valores e verificar quais
orçamentos escapam a esse padrão (seja para
mais, seja para menos), de modo a justificar a
sua desconsideração para fins de estimativa
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de preços na licitação.
Se escolhido o menor preço, é indispensável
que a área técnica apresente
as justificativas que indicam a sua
exequibilidade em face do encargo a ser
licitado.
A não adoção de cautelas nesse sentido pode
conduzir à realização de certame que, por não
ter valor de referência condizente com aquele
praticado no mercado, poderá restar frustrado
ou fracassado.
A respeito do tema, citam-se as seguintes
manifestações do TCU:
Acórdão nº 2.170/2007 – Plenário
"REPRESENTAÇÃO. PEDIDO DE
REEXAME. PREGÃO
ELETRÔNICO. SERVIÇOS DE INFORMÁTICA.
REVOGAÇÃO DE MEDIDA CAUTELAR.
PROVIMENTO PARCIAL.
1. A aferição de preços nas aquisições e
contratações de produtos e serviços de
tecnologia da informação, no âmbito da
Administração Pública federal, na fase de
estimativa de preços, no momento de
adjudicação do objeto do certame
licitatório, na contratação e alterações
posteriores, deve se basear em valores
aceitáveis, que se encontrem dentro da
faixa usualmente praticada
pelo mercado em determinada época,
obtida por meio depesquisa a partir de
fontes diversas, como orçamentos
de fornecedores, valores adjudicados em
licitações de órgãos públicos - inclusos
aqueles constantes no Comprasnet -,
valores registrados em atas de Sistema de
Registro de Preços, entre outras, a
exemplo de compras/contratações
realizadas por corporações privadas em
condições idênticas ou semelhantes
àquelas da Administração Pública.
2. Preço aceitável, a ser considerado na
faixa de preços referida no item
precedente, é aquele que não representa
claro viés em relação ao contexto
do mercado, ou seja, abaixo do limite
inferior ou acima do maior valor
constante da faixa identificada para o
produto ou serviço." (Destacamos.)
Acórdão nº 1861/2008- 1ª Câmara
"[RELATÓRIO]
Observa-se ainda que não houve
qualquer pesquisa a preços efetivamente
praticados no âmbito da Administração
Pública. Para a formação de preços na fase
interna de um processo licitatório, deve-se dar
preferência a valores efetivamente praticados
no mercado, prioritariamente
pela pesquisa em preços praticados pela
Administração Pública em processos
licitatórios de ampla competição, como, por
exemplo, pregões e registro de preços,
conforme dispositivo da Lei nº 8.666/1993'.
[...]
45. Dessa forma, permanece o entendimento
de que o orçamento de referência de preço não
está respaldado por
uma pesquisa de preços adequada e suficiente,
uma vez que todas as cotações solicitadas se
limitaram a empresas representantes de um
mesmo fabricante [...], sendo este mais um
indicativo do direcionamento do certame e da
restrição ao caráter competitivo. Além disso,
conforme mencionado supra, não
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há pesquisa em contratos firmados no âmbito
da Administração Pública, como preconiza o
inciso IV do art. 43 da Lei nº 8.666/1993.
[...]
[ACÓRDÃO]
9.2. determinar à Coordenação-Geral de
Recursos Logísticos do Ministério do
Planejamento, Orçamento e Gestão -
CGLOG/MP que:
[...]
9.2.3. quando da elaboração do orçamento-
base da licitação, realize
ampla pesquisa de mercado para a formação
dos preços orçados, utilizando-se de fontes
oficiais ou de orçamentos emitidos por, no
mínimo, três fornecedores, quando houver, a
qual deverá necessariamente estar
documentada no processo licitatório,
previamente à publicação do edital, de forma a
atender aos princípios da impessoalidade, da
publicidade e da vinculação ao instrumento
convocatório;" (Destacamos.)
CONCLUSÕES
(...)
- Antes de adotar qualquer decisão em torno
do valor a ser definido, recomenda-se à
Administração ampliar
as fontes de pesquisa no que tange à
contratação pretendida, avaliando-se, por
exemplo, os valores praticados em contratos
com outras entidades ou órgãos da
Administração Pública, a fim de confirmar a
regularidade dos preços obtidos junto aos três
fornecedores.
- Independentemente de conseguir
ampliar as fontes de pesquisa, a
Administração deve ter cautela na
definição do valor estimado. A decisão
pela adoção como parâmetro do menor
valor ou da média dos valores
pesquisados dependerá de análise crítica
em torno da sua realidade orçamentária,
bem como do próprio mercado em que
estão inseridos os objetos pretendidos.
- A motivação exaustiva a respeito da
questão afasta questionamentos quanto à
adoção de valor que não corresponde à
realidade de mercado e que, por isso,
pode representar restrição indevida à
competição, resultar em certame
fracassado ou deserto, ou, por outro
lado, em contratação
desvantajosa/antieconômica.
Salvo melhor juízo, essa é a orientação da
Zênite, de caráter opinativo e orientativo,
elaborada de acordo com os subsídios
fornecidos pela Consulente."
 
 

Preliminarmente, cumpre citar, para que se
recomende constante consulta pelas unidades responsáveis
pela aquisição de bens e serviços neste Tribunal, a Ordem de
Serviço TRE/AL n.º 02, de 1º de fevereiro de 2010, norma que
regulamenta os procedimentos e critérios referentes à
estimativas de preços no âmbito desta Regional.      

 
Contudo, para o melhor deslinde da situação,

cumpre transcrever na íntegra o art. 2º da Instrução
Normativa nº 3, de 20 de abril de 2017 05/2014, da Secretaria
de Logística e Tecnologia da Informação do Ministério do
Planejamento, Orçamento e Gestão, que veio a substituir a
Instrução Normativa anterior de n.º 05/2014, passando assim
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a disciplinar sobre os procedimentos administrativos para a
realização de pesquisa de preços para a aquisição de bens e
contratação de serviços em geral:

 

"Art. 2º  A pesquisa de preços será realizada
mediante a utilização dos seguintes
parâmetros:
I - Painel de Preços, disponível no endereço
eletrônico
http://paineldeprecos.planejamento.gov.br;
II - contratações similares de outros entes
públicos, em execução ou concluídos nos 180
(cento e oitenta) dias anteriores à data da
pesquisa de preços; 
III - pesquisa publicada em mídia
especializada, sítios eletrônicos especializados
ou de domínio amplo, desde que contenha a
data e hora de acesso; ou
IV - pesquisa com os fornecedores, desde que
as datas das pesquisas não se diferenciem em
mais de 180 (cento e oitenta) dias. 
§1º  Os parâmetros previstos nos incisos deste
artigo poderão ser utilizados de forma
combinada ou não, devendo ser priorizados os
previstos nos incisos I e II e demonstrada no
processo administrativo a metodologia
utilizada para obtenção do preço de referência.
§2º  Serão utilizadas, como metodologia
para obtenção do preço de referência
para a contratação, a média, a mediana
ou o menor dos valores obtidos na
pesquisa de preços, desde que o cálculo
incida sobre um conjunto de três ou mais
preços, oriundos de um ou mais dos
parâmetros adotados neste artigo,
desconsiderados os valores inexequíveis e
os excessivamente elevados.
§3º  Poderão ser utilizados outros
critérios ou metodologias, desde que
devidamente justificados pela autoridade
competente.
§4º  Os preços coletados devem ser
analisados de forma crítica, em especial,
quando houver grande variação entre os
valores apresentados.
§5º  Para desconsideração dos preços
inexequíveis ou excessivamente elevados,
deverão ser adotados critérios
fundamentados e descritos no processo
administrativo.
§6º  Excepcionalmente, mediante
justificativa da autoridade competente,
será admitida a pesquisa com menos de
três preços ou fornecedores." (NR)
(Grifo nosso)

 
Ademais, certo da dificuldade dos problemas

advindos acerca do planejamento das contratações de bens e
serviços voltados para a área de Tecnologia da Informação, o
Tribunal de Contas da União (TCU) lançou o "Guia de boas
práticas em contratação de soluções de tecnologia da
informação", ao qual transcrevemos abaixo trecho desse
compêndio que trata sobre cotação de preços, constante no
Item "6.3.9 - Estimativas dos preços", Subitens "C. O que
fazer" e "D. Considerações":

 
(...)
C. O que fazer:
1) A estimativa de preços deverá levar em
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conta todo o período de vigência do contrato a
ser firmado, dividida por ano, consideradas as
prorrogações previstas para a contratação.
2) O valor estimado da solução deve refletir
seu preço de mercado. Ao analisar o mercado
com vistas à obtenção de dados sobre preços,
pode-se utilizar, entre outras, as seguintes
fontes de informação:
a) preços vigentes em outros órgãos (e.g. em
licitações, inclusive de registro de preço) (Lei
8.666/1993, art. 15, inciso V);
b) consultas diretas aos fornecedores (RFP –
Request for Proposal), que deve incluir as
informações definidas até então no termo de
referência ou no projeto básico, pois essas
informações afetam a percepção de risco das
empresas, que por sua vez influencia os preços
oferecidos. Por exemplo, ao solicitar cotação
de preço às empresas, o órgão deve informar
os requisitos, os modelos de execução do
objeto e de gestão do contrato, incluindo as
sanções previstas;
c) consulta ou audiência pública, no caso de
contratações de maior materialidade e
complexidade;
d) consultas em portais de fornecedores na
web e em sistemas de busca de preços na
internet, lembrando que os preços informados
normalmente são unitários, ou seja, referem-se
à contratação de um único produto, de modo
que não consideram o efeito de escala que
existe em uma contratação de muitas
unidades;
e) bancos de dados da APF (e.g. Comprasnet,
Siasg);
f) cadastros de preços mantidos por entidades
de pesquisa;
g) preços obtidos em contratações
semelhantes do setor privado (Lei 8.666/1993,
art. 15, inciso III);
h) uso do portal do órgão para publicar o
planejamento da licitação na web e receber
estimativas de preço.
3) Ao efetuar a análise de mercado com vistas
a estimar o preço, a equipe de planejamento
deve estar aberta a modificar os requisitos,
pois o mercado pode oferecer produtos e
serviços com características não consideradas
originalmente ou que sejam variações de
requisitos já estabelecidos.
4) Incluir os memoriais de cálculo das
estimativas dos preços unitários e do preço
total (global) nos autos do processo de
contratação.
5) Considerar somente preços recentes (e.g.
dos últimos noventa dias), pois os preços
podem variar em função de diversos fatores
(e.g. variação cambial para cima ou para baixo,
escassez ou sobra do produto no mercado).
 
D. Considerações:
1) A estimativa de preço está na raiz de
problemas como o sobrepreço e o ato
antieconômico, que compõem irregularidades
graves que podem afetar a gestão dos recursos
dos órgãos, bem como levar à
responsabilização de servidores participantes
dos processos de contratação e de gestão
contratual. Portanto, deve ser feita com o
maior cuidado possível.
2) Vale destacar os itens 32 e 33 do voto do
Ministro-Relator do Acórdão 2.170/2007-TCU-
Plenário com relação aos conceitos de “preço
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Plenário com relação aos conceitos de “preço
aceitável” e “cesta de preços”:
(...)
3) Há uma crença bastante disseminada entre
os gestores públicos de que basta haver três
propostas de fornecedores para que uma
estimativa de preço seja considerada válida.
Como a estimativa de preço é elemento
fundamental para se realizar análises de
sobrepreço, a equipe de planejamento da
contratação, em apoio à área administrativa,
deve buscar o maior número de preços
possível. Como exposto anteriormente no
trecho do acórdão citado, não se deve limitar o
levantamento de preço a três preços
informados por fornecedores, a menos que seja
devidamente justificado. Adicionalmente, não
se deve apenas buscar preços junto a
fornecedores, como exposto a seguir.
4) Os fornecedores não revelam em suas
propostas, antes da licitação, os preços que de
fato irão propor durante o certame, pois não
têm estímulo para isso. Por isso sabe-se, de
antemão, que os preços levantados de
propostas comerciais preliminares são maiores
que os praticados nas condições de
concorrência. Pode ser caro preparar uma
proposta comercial de boa qualidade
(detalhada e confiável), pois exige a análise de
diversos elementos do planejamento da
contratação (e.g. requisitos, itens pontuáveis,
quantidades a contratar, modelos de execução
do objeto e de gestão do contrato), assim os
fornecedores provavelmente não gastarão
tempo e dinheiro com propostas comerciais
prévias à licitação, pois isso não lhes trará
qualquer vantagem na licitação. Pelo
contrário, pois quanto maior a estimativa de
preço feita pelo órgão, menor a probabilidade
do preço final contratado ser questionado.
Essa é também uma razão para se ter muita
cautela ao justificar a razoabilidade de preços
em dispensas de licitação com base apenas em
propostas comerciais.
5) Como os preços expostos em
propostas de preço obtidas junto a
fornecedores, antes da licitação,
normalmente incluem folgas, a equipe de
planejamento da contratação deve avaliar
a aplicação de um deflator, isto é, um
percentual de diminuição do valor
dessas propostas. Essa recomendação é
especialmente importante quando a
estimativa de preço feita pela equipe de
planejamento somente se basear em
propostas de preço de fornecedores, isto
é, não utilizar preços obtidos em
licitações realizadas por outros órgãos ou
preços obtidos em outras das fontes
citadas neste item.
6) A equipe de planejamento deve
documentar seus métodos, técnicas e
decisões nos processos de contratação.
Há diversos aspectos a considerar:
a) quantidades de itens a contratar (e.g.
quanto maior a quantidade contratada,
menor é o preço esperado, em função de
economias de escala);
b) fontes de preços a serem pesquisadas;
c) tratamento a ser dado aos preços
coletados: como, por exemplo, cálculo da
média aritmética ou adoção do valor
mínimo encontrado, bem como expurgo
dos valores considerados esdrúxulos,
sejam eles os maiores ou os menores
obtidos;
d) identificação de preço inexequível.
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7) Muitas vezes o desvio padrão do
conjunto de preços obtidos em propostas
comerciais é bastante elevado, reduzindo
em muito o significado da média
aritmética para embasar a tomada de
decisão.
8) A Comunidade de Tecnologia da Informação
Aplicada ao Controle (TIControle) elaborou a
Orientação Técnica - TIControle 1/2010, sobre
estimativa de preço, disponível no portal da
comunidade na internet (http://www.
ticontrole.gov.br), na qual são expostas
algumas considerações e orientações para
estimar preços.
9) Vale lembrar também que o preço de uma
solução contratada por outro órgão com itens,
critérios obrigatórios e opcionais diferentes
não serve diretamente como base para uma
estimativa de preço, sendo necessário fazer
ajustes para poder aproveitá-lo (e.g. descontar
ou acrescentar valores). Neste ponto pode-se
ressaltar a importância da padronização de
produtos no mercado público, pois quanto
mais padronizado for um produto ou serviço,
mais comparáveis se tornam os preços obtidos
nas contratações (Lei 8.666/1993, art. 11 135).
A SLTI oferece padrões de alguns produtos no
endereço
http://www.governoeletronico.gov.br/sisp-
conteudo/especificacoes-tic, de acordo com
Portaria - SLTI 2/2010, art. 1º.
10) Quanto mais informações as interessadas e
as licitantes possuem, menor é o risco
mapeado por elas com relação à contratação,
e, desse modo, podem oferecer preços
menores, pois os riscos normalmente se
traduzem em custos adicionais. A equipe de
planejamento da contratação deve tornar
disponível às empresas consultadas todos os
elementos do termo de referência ou do
projeto básico, de modo que as empresas
interessadas informem preços com base em
todas as condições estabelecidas (e.g.
requisitos, cumprimento de normas do órgão,
sanções previstas e obrigação de entrega de
relatórios mensais para acompanhamento e
pagamento dos serviços);
11) Muitos órgãos comparam a estimativa
da licitação com o preço final obtido. Se
a diferença é grande, argumentam que
houve uma determinada economia
quantificada em termos percentuais.
Entretanto, se a estimativa tiver sido
elaborada de forma precária, a economia
pode ser ilusória, pois se utiliza como
parâmetro de comparação um número
obtido de forma vaga, que pode ser
distante dos menores preços praticados
no mercado, e confronta-se com o preço
final obtido, que pode ter sido alcançado
antes do melhor lance ter sido proposto,
por exemplo, devido a manobras como
“coelho” ou “mergulho”.
Essa manobra consiste em interromper a
fase de lances do pregão
prematuramente, da seguinte forma:
1) durante a fase de lances, alguma
licitante em conluio com outra apresenta
um lance bem abaixo das demais, de
forma que as outras licitantes parem de
dar lances;
2) após obtida a ordem de classificação, a
empresa que deu o menor lance é
desclassificada por algum motivo (e.g.
não apresenta documentação correta);
3) a segunda colocada, que estava em

Parecer 1648 (0580729)         SEI 0008478-63.2018.6.02.8000 / pg. 593



conluio com a empresa que realizou o
“mergulho”, é chamada para negociar
com o órgão, mas com um preço bem
acima da primeira colocada e
provavelmente acima do melhor lance
que poderia ter sido dado se a manobra,
que é uma fraude, não tivesse sido
executada.
(Grifo nosso)

   
Conforme citado no antedito guia, vale fazer

constar fragmento do voto do Ministro-Relator do Acórdão
2.170/2007-TCU-Plenário com relação aos conceitos de “preço
aceitável” e “cesta de preços”:

 
31. Não obstante tais considerações, concordo
com o ACE da Serur quando afirma que “o
paradigma, seja para aferição de
sobrepreço de um produto ou para
definir sua adequação aos valores de
mercado, não é o ‘preço de adjudicação’
de um determinado pregão” (fl. 78 -
Anexo 5), mas, sim, o valor que se
encontra dentro de uma faixa de preços
praticada pelos fornecedores desse
mesmo produto, o que “pressupõe um
valor mínimo e um valor máximo de
mercado para cada produto” (fl. 76 - Anexo
5). O sobrepreço ficaria caracterizado, nesses
termos, se o valor adjudicado ultrapassasse o
máximo da faixa de preços aceitáveis
praticada para o produto a ser adquirido pela
Administração.

32. Esclareço que preço aceitável é aquele
que não representa claro viés em relação
ao contexto do mercado, ou seja, abaixo
do limite inferior ou acima do maior valor
constante da faixa identificada para o
produto (ou serviço). Tal consideração
leva à conclusão de que as estimativas de
preços prévias às licitações, os valores a
serem aceitos pelos gestores antes da
adjudicação dos objetos dos certames
licitatórios, bem como na contratação e
posteriores alterações, por meio de
aditivos, e mesmo os parâmetros
utilizados pelos órgãos de controle para
caracterizar sobrepreço ou
superfaturamento em contratações da
área de TI devem estar baseados em uma
“cesta de preços aceitáveis”. A velocidade
das mudanças tecnológicas do setor exige esse
cuidado especial.

33. Esse conjunto de preços ao qual me
referi como “cesta de preços aceitáveis”
pode ser oriundo, por exemplo, de
pesquisas junto a fornecedores, valores
adjudicados em licitações de órgãos
públicos - inclusos aqueles constantes no
Comprasnet -, valores registrados em
atas de SRP, entre outras fontes
disponíveis tanto para os gestores como
para os órgãos de controle - a exemplo de
compras/contratações realizadas por
corporações privadas em condições
idênticas ou semelhantes àquelas
da Administração Pública -, desde que,
com relação a qualquer das fontes
utilizadas, sejam expurgados os valores
que, manifestamente, não representem a
realidade do mercado.
(Grifo nosso)
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Trazemos ainda a Orientação Técnica n.º 01/2010
que relaciona as boas práticas para a estimatica de preços na
contratação de bens e serviços de Tecnologia da Informação,
documento formulado pela Comunidade TIControle, grupo
integrado pelos gestores da área de tecnologia da informação
ao qual o Tribunal Superior Eleitoral faz parte por meio do
Acordo de Cooperação Técnica consignado em 12 de março de
2008:

 
A Comunidade TIControle, representada pelos
gestores da área de TI dos órgãos signatários
do Acordo de Cooperação Técnica firmado em
12 de março de 2008, considera boas práticas
para a estimativa de preços na contratação de
bens e serviços de TI o que se segue:
 
1. O método de estimativa de bens e serviços
de TI deve considerar as características do
respectivo mercado.
1.1. Em mercados altamente competitivos, a
estimativa poderá adotar, por padrão, a média
dos preços apurados em pesquisa com o maior
número de fornecedores que for possível
consultar em função do prazo disponível e do
valor da contratação.
1.2. Em mercados pouco competitivos,
deve ser adotado o menor preço entre os
preços coletados com o maior número
possível de fornecedores que for razoável
consultar em função do prazo disponível
e do valor da contratação. Não poderão
ser considerados os preços inexeqüíveis
ou excessivamente elevados, conforme
critérios fundamentados e descritos no
processo administrativo.
1.3. Outras fontes de informação também
podem ser utilizadas, tais como contratos
formalizados por outros entes públicos, em
execução ou recentemente concluídos com
sucesso; pesquisas publicadas na mídia
especializada e listas de preços registrados em
decorrência de licitação de objeto compatível.
1.4. A Administração solicitará formalmente
estimativas de preço aos potenciais licitantes
e lhes fornecerá as informações de que
dispuser e que pretenda incluir no edital a ser
publicado (o mais semelhante possível ao
edital). Não devem ser divulgados, entretanto,
os limites de aceitabilidade de preços, bem
como toda informação que deva ser
considerada sigilosa em decorrência da
política de segurança da informação do ente
público. Essa medida é importante
para aumentar as chances de que as propostas
comerciais efetivamente reflitam as
características do objeto a ser contratado,
para que sejam comparáveis e resultantes de
análise de risco por parte dos potenciais
licitantes. O prazo de resposta à consulta de
preços deve ser de 5 (cinco) dias úteis, a
contar da data de recebimento da
mensagem. No caso de objetos de maior
complexidade, o prazo deverá ser dilatado pelo
tempo julgado razoável para a participação do
maior número de potenciais licitantes.
1.5. Deve-se buscar o maior número
possível de propostas, mesmo que já se
tenha atingido o número mínimo de três,
de modo a formar uma estimativa
confiável do preço de mercado.
1 . 6 . A utilização de menos de três
cotações de preços é possível diante da
inexistência de opções nas fontes
descritas no item 1.3. Quando as empresas
consultadas, para apresentação de cotação,
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consultadas, para apresentação de cotação,
não se manifestarem no prazo que lhes for
comunicado na solicitação formal (ofício, fax,
mensagem de correio eletrônico, etc.) - prazo
este que deve ser compatível com o esforço
exigido para a tarefa de cotação -, a solicitação
deverá ser reiterada, com novo prazo de
5(cinco) dias úteis. A falta de manifestação
formal da empresa, nos prazos concedidos,
será considerado desinteresse de sua parte na
apresentação da cotação e na licitação,
podendo se utilizado como subsídio para
analisar eventuais questionamentos,
impugnações mandados de segurança
interpostos pela empresa, nos termos do art.
40 da Lei n.º 8.078/1990. Assim, toda pesquisa
deve ser documentada e apensada no processo
de contratação de bens e serviços de TI. O
acesso da empresa que não apresentou
resposta à consulta de preços, porém, jamais
poderá ser dificultado ou impedido.
1.7. É razoável admitir que são comparáveis
propostas cujas datas não se diferenciem em
mais de noventa dias, ressalvadas as situações
que envolvam bens ou serviços cotados em
moeda estrangeira ou cenários adversos, como
os de forte instabilidade econômica.
1.8. A validade das propostas comerciais
não é atributo significativo, exceto nos
casos de contratações diretas, vez que
tais propostas não vinculam os licitantes.
É prudente, porém, que a estimativa de
preço constante em edital resulte de
dados coletados nos últimos noventa
dias, de modo a refletir mais
adequadamente a situação conjuntural
do mercado.
1.9. Nos autos deve ser incluído o
memorial que documenta atividade de
estimativa de preço, que deve conter a
documentação comprobatória, como
ofícios enviados aos fornecedores e
respectivas propostas de preço por eles
entregues.
 
2. O processo de estimativa de preço em
licitação presta-se, principalmente, aos
seguintes propósitos:
a. indicar o preço estimado para adequação
orçamentária;
b. indicar o preço máximo aceitável do objeto e
dos seus itens constitutivos, individualmente,
para suportar a análise de aceitabilidade de
preços a ser procedida pela área
administrativa e para evitar o conhecido "jogo
de planilha";
c. indicar o limite mínimo de preço, abaixo do
qual o preço será considerado inexequível; ou
d. dar suporte à análise formal de
economicidade da contratação.
Por essas razões:
2.1. A estimativa de preços não vincula a
licitação, podendo ser adquirido o objeto
por preço inferior ou superior à
estimativa, desde que respeitados os
limites máximos e mínimos, de
aceitabilidade de preços definidos nos
autos (que não são publicados no edital).
Se o resultado da licitação indicar preço
superior ao estimado, a área de TI do
órgão contratante analisará os motivos
da divergência e, mediante justificativa e
demonstração, poderá ratificar que o
preço do certame é compatível com os
preços praticados correntemente no
mercado, naquele momento, ou poderá
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recomendar o cancelamento da licitação
para realização de nova pesquisa de
mercado.
2 . 2 . A estimativa de preço deve ser
razoável e a menor possível com vistas à
observação dos princípios de
economicidade e eficiência, sempre
visando que a Administração Pública
contrate bem ou serviço que atenda às
suas necessidades.
2.3. Preços registrados podem ser utilizados
como preço estimativo, nos termos da Lei,
quando inferiores à média de preços
encontrada em pesquisa de mercado. A
atribuição de inexequibilidade a preço
registrado é decisão administrativa que
demanda justificativa formal, nos termos da
Lei, lembrando que nada impede que os
licitantes ofertem preços acima do valor
estimado nas licitações por pregão eletrônico
ou nas licitações tradicionais.
2.4. Sempre que necessário e possível, e
desde que devidamente justificado
em documento específico, devem-se
aplicar deflatores aos preços
apresentados pelos fornecedores.
Estimativas infladas ajudam a justificar
preço final elevado. Adicionalmente, a
competição, por si só, pode não
conseguir fazer com que o menor preço
aflore durante a licitação. Se não for
licitação por pregão, o uso de deflator se
torna ainda mais importante.
2.5. Não podem ser aplicados quaisquer
índices inflatores aos preços.
 
3. Devem ser considerados como fonte de
cotação os seguintes canais:
3.1. Comprasnet;
3.2. Registros de preços, na esfera
federal;
3.3. Consultas a empresas ou pesquisas
publicadas na mídia especializada; ou
3.4. Os órgãos membros da TIControle;
 
4. Também serão admitidos os preços
formados mediante pesquisa em sítios na
Internet de empresas de comércio eletrônico
(Submarino, Extra, Americanas, etc.) ou de
fornecedores via Internet (DeU, Itautec,
Positivo etc.). Todavia, não podem ser
admitidas cotações obtidas em sítios de leilão
ou de intermediação de vendas (Mercado
Livre, Ebay etc.). Vale lembrar que cotação em
sítio da Internet muitas vezes não considera o
efeito de escala de uma contratação, pois se
refere ao preço unitário do produto ou serviço.
Neste caso, deve-se avaliar a aplicação de
deflator ao preço obtido.
5. Para efeito de estimativa de preços não será
exigido que a empresa esteja previamente
cadastrada no Sicaf.
(Grifo nosso)
 

Segundo podemos presenciar no estudo das normas
e orientações trazidas neste documento, na impossibilidade de
se adotar a prática de obtenção de um conjunto favorável de
cotações de preços, a legislação permite sim ao Administrador
adotar estimativa de preços da futura licitação com base
apenas no menor valor pesquisado, desde que precedida da
justificativa pertinente baseada principalmente pela análise da
unidade técnica quanto à existência de elementos capazes de
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aferir a regularidade do parâmetro eleito, tendentes a aferir
um orçamento que venha a refletir o mais fielmente possível
com os praticados pelo mercado, evitando-se assim a
existência de 'sobrepreço" ou mesmo de preços inexequíveis.

 
Desta feita, tomando em consideração a sugestão

ora proposta pela SEIC em sua Informação n.º 3875 (0560123)
quanto à aplicação, em futuro procedimento licitatório, dos
menores valores obtidos em pesquisa de preços por ela
realizada como estimativas de preços para cada um dos itens
constantes no Termo de Referência, motivada principalmente
pela ocorrência de negociações durante o transcorrer do
certame que venham a reduzir o preço anteriormente orçado,
parece-nos razoáveis sua adoção, recomendando assim o
retorno destes autos à Secretaria de Administração para
conhecimento e providências.

 
 

Wilton Daniel Felix de Lima
Assistente I - ACAGE

 
De acordo.
À Secretaria de Administração.
 

Raquel Helena Paixão Tavares
Assessora-Chefe

ACAGE

Documento assinado eletronicamente por WILTON DANIEL FELIX DE LIMA, Técnico
Judiciário, em 15/08/2019, às 13:56, conforme art. 1º, III, "b", da Lei 11.419/2006.

Documento assinado eletronicamente por RAQUEL HELENA PAIXÃO TAVARES,
Assessor-Chefe, em 15/08/2019, às 13:57, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0580729 e o código CRC 25C4275E.
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 15 de agosto de 2019.
À SLC
(cópia à COINF e à AJ-DG)
 
Senhora Chefe,
 
Em resposta ao questionamento de Vossa Senhoria

(doc. 0578995), solicito averiguar se, em aquisições
anteriores de objeto semelhante ou da mesma natureza, houve
inclusão do requisito de habilitação econômico-financeira,
posto que, considerando o avançado da instrução, não
encontramos, ao menos nos autos, justificativa para inclusão
da exigência além do possível valor da aquisição em si, o que
pode ter motivado a recomendação da AJ-DG. Sem embargo, a
Unidade poderá lançar no edital a exigência prevista no inciso
II do art. 31 da Lei nº 8.666/93, em consonância com a
condição prevista no subitem 4.4.1 da minuta do edital.

De todo modo, considerando que a exigência diz
respeito às condições econômicas do fornecedor com vistas à
capacidade de cumprimento de  suas obrigações, solicito
apoio da Unidade demandante em informar se há registro de
problemas na entrega de objeto semelhante ou no
cumprimento de obrigações dessa natureza em aquisições
anteriores realizadas pelo Tribunal. A Unidade poderá avaliar,
se assim entender, a conveniência de que seja adotada
algumas das garantias previstas no § 1º do art. 56 da Lei nº
8.666/93. Nesse caso, remeto à Assessoria Jurídica o
questionamento de se poder adotar tal exigência em aquisição
a ser formalizada no regime de registro de preços,
considerando as peculiaridades do caso, em que não se tem,
per se, o contrato, mas o compromisso de contratação.
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Atenciosamente.

Documento assinado eletronicamente por JOSÉ RICARDO ARAÚJO E SILVA,
Secretário de Administração, em 15/08/2019, às 11:06, conforme art. 1º, III, "b", da
Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0581221 e o código CRC AE2C7A91.
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS 

SEÇÃO DE LICITAÇÕES E CONTRATOS 

 

1 
 

 

 

PPRREEGGÃÃOO  EELLEETTRRÔÔNNIICCOO  NNºº  XXXX//22001199  
  

MMIINNUUTTAA  

 
PROCESSO Nº 0008478-63.2018.6.02.8000 
Tipo de Licitação: MENOR PREÇO POR LOTE   
Data: XX de XXXX de 2019 
HORÁRIO DE BRASÍLIA/DF 
Horário de Abertura: XX horas 
Local: www.comprasnet.gov.br 

 

 O Tribunal Regional Eleitoral de Alagoas – TRE/AL, por intermédio da Seção de Licitações e 
Contratos, torna público, para quem interessar possa, que realizará licitação na modalidade 
PREGÃO ELETRÔNICO, do tipo MENOR PREÇO POR LOTE, conforme descrito neste Edital e seus 
Anexos, objetivando o Registro de Preços de  componentes de rede (Networking), tudo de acordo 
com requisição promovida pela Secretaria de Tecnologia da Informação. 
 

 O certame será regido conjuntamente pela Lei nº 10.520, de 17/07/2002, pelo Decreto nº 
5.450, de 31/05/2005, pelo Decreto nº 8.538, de 06/10/2015 e subsidiariamente pela Lei nº 8.666, 
de 21/06/1993 e com suas posteriores alterações e demais normas pertinentes. Aplica-se ao 
presente torneio licitatório, ainda, a Lei Complementar nº 123, de 14/12/2006, o Decreto nº 
7.174/2010, o Decreto nº 7.892/2013 atualizado pelo Decreto nº 9.488/2018, o Decreto nº 
8.184/2014, a Portaria nº 212, de 18/06/2001, da Presidência deste Tribunal, publicada na seção 1 
do DOU, edição de 19/06/2001, por meio da qual se adota o SICAF – Sistema de Cadastramento 
Unificado de Fornecedores - nas licitações realizadas no âmbito da Secretaria deste Tribunal, bem 
como, no que couber pela Lei nº 8.078, de 11/09/1990 e demais exigências deste Edital e seus 
anexos. 
 
1 - DO OBJETO. 
 

1.1. O presente Pregão tem por objeto o Registro de Preços de componentes de rede 
(Networking), conforme especificações descritas nos Anexos I e I-A deste edital. 

 
2 – DAS CONDIÇÕES GERAIS. 
 
2.1. O prazo de vigência da Ata de Registro de Preços decorrente deste procedimento 
licitatório é de 12 (doze) meses, contado da publicação do referido ato. 
 
2.2. 2.2. A Ata de Registro de Preços não obriga à contratação de toda quantidade 
estimada no Registro, que poderá ocorrer de acordo com as necessidades do TRE/AL. 
 
2.3. A existência de preços registrados não obriga o Tribunal Regional Eleitoral a contratar, 
facultando-se a realização de licitação específica para a aquisição pretendida, assegurada 
preferência ao fornecedor registrado em igualdade de condições. 
 

2.3.1. O direito de preferência de que trata este item poderá ser exercido pelo beneficiário 
do registro quando o Tribunal Regional Eleitoral de Alagoas, após realizada a licitação 
específica, constatar que o preço obtido é igual ou maior que o registrado ou, após 
negociação, aquiescer o detentor da ata em baixar o preço registrado, igualando ou tornando-
o menor que o obtido em referida licitação. 
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS 

SEÇÃO DE LICITAÇÕES E CONTRATOS 

 

2 
 

 

 

 
3 - DOS PRAZOS DE ENTREGA E DA GARANTIA.  
 

3.1. O prazo máximo para a entrega dos equipamentos é de 60 (sessenta) dias contados a 
partir do recebimento da Ordem de Fornecimento ou documento equivalente. 

 

3.2. O prazo máximo para a entrega dos softwares é 30 (trinta) dias contados a partir do 
recebimento da Ordem de Fornecimento ou documento equivalente. 

 

3.3. Os serviços de instalação, integração, garantia e suporte dos equipamentos e softwares, 
deverão ser realizados diretamente pelo fabricante de acordo com as exigências contidas no 
descritivo dos mesmos, estando essas aderentes aos respectivos níveis de serviço necessários a 
cada um deles. 

 
3.4. Quanto aos itens 1, 2, 3, 4, 20, 22, 23 e 25,   a garantia e o suporte do fabricante para a 
solução de software deverá ser ofertado pelo período mínimo de 36 (trinta e seis) meses, incluindo 
a evolução para novas versões devendo o atendimento ser na modalidade 24x7 (vinte quatro horas 
por dia, sete dias da semana), com tempo de resposta máximo em 4 (quatro) horas. 
 

3.4.2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3.4.3.  O fabricante deve possuir canais de comunicação e ferramentas adicionais para 
suporte técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda 
de área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução. 

3.4.4.  A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

3.4.5. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante dos 
softwares, indicando o período de garantia dos produtos ofertados. Em caso de documentação 
expressa do fabricante deverá ser anexada a mesma a procuração que comprove que a 
fabricante outorga ao procurador os poderes para firmar e declarar as exigências solicitadas. 

3.5. Quanto aos itens 5, 8, 9, 10, 11, 24, 26 e 27, o equipamento ofertado deverá possuir 
garantia do fabricante na modalidade on-site pelo período mínimo de 60 (sessenta) meses para 
reposição de peças, mão de obra e atendimento. O prazo máximo para atendimento do chamado 
deve ser de até o próximo dia útil após a sua abertura. Durante o período da garantia o prazo 
máximo para o reparo de equipamentos defeituosos a condição normal de funcionamento deverá 
ser de até 07 (sete) dias úteis. 
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3.5.1. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3.5.2. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de área 
para cadastro da solução de hardware ofertada, possibilitando assim que a CONTRATANTE 
possa receber de forma proativa, durante todo período da garantia as notificações de 
atualizações e correções (“hotfix”) da solução; 

3.5.3. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 
para suporte técnico e abertura de chamados técnicos. 

3.5.4. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica local 
no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por meio de 
documentação oficial do fabricante dos produtos e de domínio público, através de catálogos, 
folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso não seja 
comprovada por um dos meios citados anteriormente, será possível a comprovação através da 
apresentação de documentação expressa do fabricante dos equipamentos, indicando a referida 
assistência técnica que será responsável pelo atendimento e manutenção durante o período de 
garantia dos produtos ofertados. Em caso de documentação expressa do fabricante a esta 
deverá ser anexada uma procuração que comprove que a fabricante outorga ao procurador os 
poderes para firmar e declarar as exigências solicitadas. 

3.5.5. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da garantia 
ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

3.6.   Quanto aos itens 6, 7, 12, 13, 14, 15, 28 e  29, O equipamento ofertado deverá possuir 
garantia do fabricante do equipamento na modalidade on-site pelo período mínimo de 12 (doze) 
meses para reposição de peças, mão de obra e atendimento no local. O período da garantia o prazo 
máximo para o reparo de equipamentos defeituosos a condição normal de funcionamento deverá 
ser de até 07 (sete) dias úteis. 

3.6.1. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento. 

3.6.2. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da garantia 
ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 
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4 - DA PARTICIPAÇÃO. 
 
4.1.   Poderão participar deste pregão os interessados do ramo pertinente ao objeto licitado, 
obrigatoriamente, previamente cadastradas no Sistema de Cadastro Unificado de Fornecedores – 
SICAF, habilitação parcial, que atendam à linha de fornecimento e a todas as demais exigências 
deste Edital e seus anexos. 
 
4.2. Para participação neste Pregão, o licitante deverá manifestar, em campo próprio do 
sistema eletrônico, que cumpre plenamente os requisitos de habilitação e que sua proposta está em 
conformidade com as exigências do instrumento convocatório. 
 

4.2.1. A declaração falsa relativa ao cumprimento dos requisitos de habilitação e proposta 
sujeitará o licitante às sanções previstas neste Edital. 

 
4.3. No ato de envio de suas propostas, as Microempresas ou Empresas de Pequeno Porte 
deverão declarar, em campo próprio do Sistema do Pregão Eletrônico, que atendem aos requisitos 
do art. 3º da Lei Complementar nº 123/2006 para fazer jus aos benefícios previstos no referido 
diploma legal. 
 
4.4. Não será admitida nesta licitação a participação de empresas: 
 

4.4.1. em processo de recuperação judicial ou em processo de falência, sob concurso de 
credores, em dissolução ou em liquidação; 
 
4.4.2. que estejam suspensas de participar de licitação realizada pelo Tribunal Regional 
Eleitoral de Alagoas e empresas que tenham sido declaradas inidôneas para licitar ou 
contratar com a Administração Pública, enquanto perdurarem os motivos da punição; 
 
4.4.3. que estejam reunidas em consórcio e sejam controladoras, coligadas ou subsidiárias 
entre si, qualquer que seja sua forma de constituição; 
 
4.4.4. estrangeiras que não funcionem no País; 
 
4.4.5.  que tenham em seu quadro societário cônjuge, companheiro ou parente em linha reta, 
colateral ou por afinidade até o terceiro grau, inclusive, dos magistrados ocupantes de cargos 
de direção ou no exercício de funções administrativas, assim como de servidores ocupantes de 
cargos de direção, chefia e assessoramento vinculados direta ou indiretamente às unidades 
situadas na linha hierárquica da área encarregada da licitação, de acordo com o disposto no 
art. 2º da Resolução nº 07/2005 do Conselho Nacional de Justiça (com a nova redação dada 
pelo art. 1º da Resolução 229/2016-CNJ). 

 
5 - DA REPRESENTAÇÃO E DO CREDENCIAMENTO. 
 
5.1. Os licitantes ou seus representantes legais deverão estar previamente credenciados no 
site www.comprasnet.gov.br (Art. 3º do Decreto nº 5.450/05). 
 
5.2. O credenciamento do licitante, bem assim a sua manutenção, no site acima informado, 
dependerá de registro atualizado no Sistema de Cadastramento Unificado de Fornecedores – SICAF - 
Habilitação Parcial, que também será requisito obrigatório para fins de habilitação. 
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5.3. O credenciamento do licitante dar-se-á pela utilização de login e senha, para acesso ao 
sistema eletrônico no site www.comprasnet.gov.br, opção pregão eletrônico, criados quando do 
credenciamento supracitado. 
 
5.4. O credenciamento junto ao provedor do sistema implica a responsabilidade legal do 
licitante e a presunção de sua capacidade técnica para realização das transações inerentes ao 
pregão na forma eletrônica (Art. 3º, § 6º, do Decreto nº 5.450/05). 
 
5.5. O uso da senha de acesso pelo licitante é de sua responsabilidade exclusiva, incluindo 
qualquer transação efetuada diretamente ou por seu representante, não cabendo ao provedor do 
sistema ou ao TRE/AL, promotor da licitação, responsabilidade por eventuais danos decorrentes de 
uso indevido da senha, ainda que por terceiros (Art. 3º, § 5º, do Decreto nº 5.450/05). 
 
6 - DO ENVIO DA PROPOSTA DE PREÇOS. 
 

6.1. O licitante será responsável por todas as transações que forem efetuadas em seu nome 
no sistema eletrônico, assumindo como firmes e verdadeiras suas propostas, assim como os lances 
inseridos durante a sessão pública. (inciso III, do art. 13, do Decreto nº 5.450/2005). 
 

6.2. Incumbirá ao licitante acompanhar as operações no sistema eletrônico durante o 
processo licitatório, responsabilizando-se pelo ônus decorrente da perda de negócios diante da 
inobservância de quaisquer mensagens emitidas pelo sistema ou de sua desconexão (inciso IV, do 
art. 13, do Decreto 5.450/2005). 
 

6.3. A participação no pregão dar-se-á por meio da digitação de login e senha privativas do 
licitante e subsequente encaminhamento da proposta com a descrição do serviço ofertado, em 
campo próprio, que poderá ser feito a partir da data da disponibilização do Edital no site do 
www.comprasnet.gov.br e até a data e hora marcadas para abertura deste pregão, exclusivamente 
por meio do sistema eletrônico. 
 

6.3.1. Até a abertura da sessão, os licitantes poderão retirar ou substituir a proposta 
anteriormente apresentada (§ 4º do art. 21 do Decreto nº 5.450/2005). 

 

6.4.  Os licitantes deverão apresentar suas propostas de preços, utilizando do campo 
"descrição detalhada do objeto", contendo o seguinte: 
 

a) prazo de validade, a contar da data da abertura da sessão pública, observado o 
disposto no item 6.7 do edital; 
b) descrição de cada item que compõe o lote ofertado, de acordo com o Anexo I-A deste 
edital. 

 

6.4.1. Caso o campo seja preenchido com especificações diversas daquelas 
constantes no edital, deverá haver o cuidado, por parte do licitante, para que a descrição 
complementar não contrarie as especificações constantes no edital, sob pena de 
desclassificação. 
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6.4.2. Serão irrelevantes quaisquer ofertas que não se enquadrem nas especificações 
exigidas, ou anexos não solicitados, considerando-se que pelo preço proposto o licitante 
obrigar-se-á ao fornecimento descrito neste edital. 

 
6.4.2.1.  Entretanto, se da proposta constar condições materiais mais vantajosas 
que as exigidas neste edital elas não serão consideradas para efeito de 
escalonamento de ofertas, mas vincularão o proponente na execução contratual. 

 
6.4.3. Não podem constar da “descrição detalhada do objeto” qualquer tipo de 
identificação da empresa, seja nome, endereço, CNPJ, logotipo, ou qualquer outro dado 
capaz de identificar o licitante. Esta identificação somente constará na proposta ajustada 
encaminhada nos termos do item 10.1. 

 
6.4.4. Em campo próprio deverão ser inseridos marca e modelo do produto ofertado. 

 

6.5. As declarações referidas no subitem 11.1 “c” deverão ser enviadas em campo próprio do 
sistema Comprasnet, no momento da elaboração e envio da proposta pelos fornecedores, as quais 
serão visualizadas pelo Pregoeiro na fase de Habilitação, quando também poderá ser solicitado, via 
chat, pelo Pregoeiro, a alteração ou reenvio das mesmas pelo(s) vencedor(es). 
 

6.6. Nos preços ofertados deverão estar inclusas todas as despesas necessárias à perfeita 
execução das prestações contratuais, tais como tributos, encargos legais, embalagens, frete etc. 
 

6.7. O prazo de validade das propostas será de, no mínimo, 60 (sessenta) dias, contados da 
data de abertura da sessão pública. As propostas que o omitirem ou indicarem prazo de validade 
inferior ao mínimo permitido serão entendidas como válidas pelo período de 60 (sessenta) dias. 
 

6.8. Em caso de divergências verificadas entre as descrições relativas aos objetos desta 
licitação (Anexo I-A) e as descrições constantes no Catálogo de Materiais do “SIASG”, prevalecerão, 
sempre, as descrições constantes neste edital. 
 

6.9. Não serão aceitas propostas alternativas nem submetidas a termo, condição ou encargo. 
 

6.10. Todos os custos decorrentes da elaboração e apresentação de propostas serão de 
responsabilidade exclusiva do licitante, incluindo as transações que forem efetuadas em seu nome no 
sistema eletrônico ou de eventual desconexão. O Tribunal Regional Eleitoral de Alagoas não será 
responsável, em nenhum caso, pelos custos de tais procedimentos. 
 

6.11. O simples envio da proposta será interpretado como concordância com os termos deste 
edital, com o estipulado na Lei nº 10.520, de 17 de julho de 2002, no Decreto nº 5.450, de 31 de 
maio de 2005, e subsidiariamente pela Lei nº 8.666, de 21 de junho de 1993 e suas alterações 
posteriores, salvo se a proposta contiver disposição que contrarie expressamente quaisquer dos 
itens deste edital. 
 
7 - DA SESSÃO PÚBLICA E DIVULGAÇÃO DAS PROPOSTAS. 
 

7.1. O pregoeiro iniciará a sessão pública na data e horário previstos neste edital, via sistema 
eletrônico, com a divulgação das propostas de preços recebidas, as quais deverão estar em perfeita 
consonância com as especificações detalhadas no presente edital. 
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7.2.  As propostas que não atenderem aos requisitos constantes no presente edital ou que 
apresentarem preços manifestamente inexequíveis serão previamente desclassificadas pelo 
pregoeiro. 
 

7.2.1. A desclassificação de proposta será sempre fundamentada e registrada no 
sistema, com acompanhamento em tempo real por todos os licitantes. 

 

7.3.  O sistema ordenará, automaticamente, as propostas classificadas, sendo que somente 
estas participarão da fase de lances. 
 
8 - DA FORMULAÇÃO DOS LANCES. 
 

8.1.  Após a classificação das propostas, o pregoeiro dará início à etapa competitiva, 
oportunidade em que os licitantes poderão encaminhar lances, exclusivamente por meio do sistema 
eletrônico, sendo estes imediatamente informados do seu recebimento e respectivo horário de 
registro e valor. 
 

8.1.1. Os lances deverão ser ofertados pelo valor unitário de cada item que compõe o lote 
ofertado, sendo que o sistema efetuará automaticamente o somatório para efeito de 
escalonamento dos lances. 

 

8.2. Os licitantes poderão oferecer lances sucessivos, observado o horário fixado e as regras 
de aceitação dos mesmos. 
 

8.3. O licitante somente poderá oferecer lance inferior ao último por ele ofertado e registrado 
pelo sistema. 
 

8.4.  Havendo mais de um lance de igual valor, prevalecerá aquele que for recebido e 
registrado primeiro pelo sistema. 
 

8.5. Durante a sessão pública, os licitantes serão informados, em tempo real, do valor do 
menor lance registrado, vedada a identificação do licitante.  
 

8.6.  No caso de desconexão do pregoeiro, no decorrer da etapa competitiva do pregão 
eletrônico, o sistema eletrônico poderá permanecer acessível aos licitantes para a recepção dos 
lances, retomando o pregoeiro, quando possível, a sua atuação no certame, sem prejuízo dos atos 
realizados. 
 

8.6.1.  Quando a desconexão do pregoeiro persistir por tempo superior a 10 (dez) minutos, a 
sessão do pregão eletrônico será suspensa e terá reinício somente após comunicação aos 
licitantes participantes, no endereço utilizado para divulgação desta licitação. 

 

8.7.   A etapa de lances será encerrada por decisão do pregoeiro, mediante 
encaminhamento, pelo sistema eletrônico, de aviso de fechamento iminente dos lances. Após o que 
transcorrerá período de tempo de até 30 (trinta) minutos, aleatoriamente determinado pelo sistema 
eletrônico, findo o qual será encerrada, automaticamente, a recepção de lances. 
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8.8.  Após o encerramento da etapa de lances da sessão pública, o pregoeiro poderá 
encaminhar, pelo sistema eletrônico, contraproposta ao licitante que tenha apresentado lance mais 
vantajoso, para que seja obtida melhor proposta, observado o critério de julgamento, não se 
admitindo negociar condições diferentes daquelas previstas neste Edital. 
 
9 - DO JULGAMENTO DAS PROPOSTAS DE PREÇOS. 
 

9.1.  O pregoeiro efetuará o julgamento das Propostas de Preços pelo critério do menor 
preço por lote, decidindo sobre a aceitação do preço obtido. 
 
9.2.  Como critério de aceitabilidade dos preços, serão admitidos como limites máximos os 
valores estimados pela Administração, ou seja, os preços de referência, disponíveis no Anexo I-A 
deste edital, que representam uma média das várias propostas coletadas no mercado e, de modo 
algum, vinculam a decisão do Pregoeiro, que está autorizado a negociar em busca de preços 
inferiores. 

 
9.2.1. O critério de aceitabilidade será aferido em relação ao valor de cada item e em relação 
ao valor total do lote ofertado. 
 

9.3.  Será considerado vencedor deste pregão o licitante que oferecer o menor preço e tiver 
atendido a todas as exigências editalícias. 
 

9.4.  Analisada a aceitabilidade do preço obtido, o pregoeiro divulgará o resultado de 
julgamento das Propostas de Preços. 

 

9.5.  Se a proposta ou o lance, de menor preço, não for aceitável, ou se o licitante 
desatender às exigências habilitatórias, o pregoeiro examinará a proposta ou o lance subsequente, 
verificando a sua aceitabilidade e procedendo à sua habilitação, na ordem de classificação, e assim 
sucessivamente, até a apuração de uma proposta ou lance que atenda ao edital. 
 

9.5.1.  Ocorrendo a situação a que se refere este item, o pregoeiro poderá negociar 
com o licitante para que seja obtido preço melhor. 

 
10 – DO ENCAMINHAMENTO DA PROPOSTA E DA DOCUMENTAÇÃO. 
 

10.1.  A proposta ajustada ao lance final do licitante vencedor e os documentos exigidos para 
habilitação que não estejam contemplados no SICAF, caso necessário, deverão ser remetidos, como 
anexo, pelo sistema Comprasnet, quando solicitado pelo Pregoeiro. Junto com a documentação 
deverá ser encaminhado, também pelo sistema, os dados do licitante vencedor: Razão Social, 
endereço, telefone/fax, número do CNPJ/MF, banco, agência, número da conta corrente e praça de 
pagamento, podendo ser utilizado para tanto o modelo de planilha para contratação sugerido no 
ANEXO II. 

 

10.2. A licitante também deverá encaminhar, quando solicitado pelo pregoeiro, via sistema, a 
Planilha de Composição de Custos por Item, no modelo do Anexo I-B. 

 
11 - DA HABILITAÇÃO. 
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11 .1. A habilitação do licitante vencedor será verificada mediante a apresentação/obtenção da 
seguinte documentação: 
 

a) Quanto à Qualificação Jurídica e Fiscal: Situação do licitante perante o Sistema de 
Cadastro Unificado de Fornecedores – SICAF – Habilitação Parcial, após a análise e 
julgamento das Propostas de Preços, a ser obtida por meio de extrato “on line” do site do 
Comprasnet. 
 

a1.) Caso conste no cadastro do SICAF algum documento habilitatório com data de 
validade expirada, o pregoeiro poderá consultar o documento do licitante nos sítios 
das entidades responsáveis pelo referido tributo ou abrirá o prazo de 02 (dois) dias 
úteis para que o licitante o encaminhe, via protocolo. 

 
b) Quanto à regularidade trabalhista, esta deverá ser comprovada através de Certidão 
Negativa de Débitos expedida pela Justiça do Trabalho, em conformidade com a Lei 
Federal nº 12.440, de 07 de julho de 2011. 
 
c) Declarações que deverão ser efetuadas em campo específico do sistema Comprasnet, 
no momento da elaboração e envio da proposta, conforme item 6.5. do edital: 
 

c.1) Declaração de inexistência de fatos supervenientes impeditivos à habilitação da 
empresa; 
c.2)  Declaração de que a empresa não emprega menor de dezoito anos em trabalho 
noturno, perigoso ou insalubre, não emprega menor de dezesseis anos, salvo na 
condição de aprendiz, a partir dos quatorze anos; 
c.3)   Declaração de elaboração Independente de Proposta. 

 
e) Quanto à qualificação econômico-financeira: 

 
e.1) Certidão negativa de falência ou concordata expedida pelo distribuidor da sede 
da pessoa jurídica há menos de 90 (noventa) dias da data de abertura do certame.  

 
11.2. No momento em que forem verificados os documentos relativos à habilitação, o 
pregoeiro deverá verificar, também, a existência de registros impeditivos da contratação no 
Cadastro Nacional de Empresas Inidôneas e Suspensas da Controladoria Geral da União, disponível 
no Portal da Transparência (http://www.portaltransparencia.gov.br). 
 
11.3.  Havendo o registro de Ocorrências Impeditivas Indiretas de licitar, constatado em 
consulta ao SICAF, a empresa será convocada a apresentar, em 48 (quarenta e oito) horas, a contar 
da solicitação do pregoeiro no “chat”, esclarecimentos/documentos, comprovando sua idoneidade. 

 
11.3.1. Havendo necessidade de analisar minuciosamente os documentos exigidos, o 
Pregoeiro suspenderá a sessão, informando no “chat” a nova data e horário para a 
continuidade da mesma. 
 

11.4.  A comprovação da regularidade fiscal das licitantes, obrigatoriamente, Microempresas e 
Empresas de Pequeno Porte, será exigida para efeito de contratação, conforme estipula o art. 42 da 
LC nº 123/2006, observando o que dispõe o art. 4º, do Decreto nº 8.538/2015. 
 

11.4.1.         Na hipótese de haver alguma restrição relativa à regularidade fiscal quando da 
comprovação de que trata o item 11.4., será assegurado prazo de cinco dias úteis, prorrogável 
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por igual período, para a regularização da documentação, a realização do pagamento ou 
parcelamento do débito e a emissão de eventuais certidões negativas ou positivas com efeito 
de certidão negativa. 
 
11.4.2.   Para aplicação do disposto no subitem 11.4.1, o prazo para regularização fiscal será 
contado a partir da divulgação do resultado da fase de habilitação. 
 
11.4.3. A prorrogação do prazo previsto no subitem 11.4.1., poderá ser concedida, a 
critério da administração pública, quando requerida pelo licitante, mediante apresentação de 
justificativa. 
 
11.4.4. A abertura da fase recursal em relação ao resultado do certame ocorrerá após  os 
prazos de regularização fiscal de que tratam os subitens 11.4.1. e 11.4.3. 
 
11.4.5.           A não regularização da documentação no prazo previsto nos subitens 11.4.1. e 
11.4.3. implicará decadência do direito à contratação, sem prejuízo das sanções previstas no 
art. 87 da Lei nº 8.666, de 1993, sendo facultado à administração pública convocar os 
licitantes remanescentes, na ordem de classificação, ou revogar a licitação. 

 
11.5. Os licitantes que deixarem de apresentar quaisquer dos documentos exigidos para a 
habilitação na presente licitação, ou os apresentarem em desacordo com o estabelecido neste 
Edital ou com irregularidades, ressalvado o disposto na alínea a.1 do item 11.1. e no item 11.4.1, 
serão inabilitados, não se admitindo complementação posterior. 
 
11.6. Não serão aceitos protocolos de entrega ou solicitação de documento em substituição 
aos documentos requeridos no presente Edital. 
 
11.7. Os documentos relacionados neste Edital referir-se-ão sempre ao domicílio da empresa 
licitante cadastrada no SICAF. 
 
11.8. Para fins de habilitação, a verificação pelo TRE/AL nos sítios oficiais de órgãos e 
entidades emissores de certidões constitui meio legal de prova. 
 
12 – DO CRITÉRIO DE DESEMPATE. 
 
12.1. Será assegurado, como critério de desempate, preferência de contratação a 
Microempresas e Empresas de Pequeno Porte, conforme disposto no art. 44 da Lei Complementar nº 
123/2006. 
 

12.1.1. Entende-se por empate aquelas situações em que as propostas apresentadas pelas 
Microempresas e Empresas de Pequeno Porte sejam iguais ou até 5% (cinco por cento) 
superiores à proposta mais bem classificada. 
 
12.1.2. O subitem anterior somente será aplicado quando a melhor oferta inicial não tiver sido 
apresentada por microempresa ou empresa de pequeno porte. 
 
12.1.3. Para identificação da situação de empate, o Sistema de Pregão Eletrônico, após 
encerramento da fase de lances identificará, em coluna própria as Microempresas e Empresas 
de Pequeno Porte participantes, fazendo a comparação entre os valores da primeira colocada, 
caso esta não seja uma Microempresa ou Empresa de Pequeno Porte, e das demais 
Microempresas e Empresas de Pequeno Porte, na ordem de classificação. 
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12.2. Após o encerramento de todos os itens, para cada item que teve uma empresa de médio 
ou grande porte como vencedora do melhor lance, o sistema selecionará todas as Microempresas e 
Empresas de Pequeno Porte cujo último lance enviado, para o item, seja até 5% (cinco por cento) 
superior à oferta vencedora. Após este procedimento, o sistema enviará mensagem, via chat, 
informando quais os itens terão desempate no lance. 
 
12.3. Para efeito do disposto no item 12.1, ocorrendo o empate, proceder-se-á da seguinte 
forma: 
 

I – A Microempresa ou Empresa de Pequeno Porte mais bem classificada poderá apresentar 
proposta de preço inferior àquela considerada vencedora do certame, situação em que lhe 
será adjudicado o objeto licitado. Para viabilizar tal procedimento, o Sistema selecionará os 
itens com tais características, disponibilizando-os automaticamente nas telas do pregoeiro e 
fornecedor, encaminhado mensagem também automática, por meio do chat, convocando a 
Microempresa ou Empresa de Pequeno Porte que se encontra em segundo lugar, a fazer sua 
última oferta no prazo de 5 (cinco) minutos, sob pena de decair do direito concedido; 
 
II – Caso a Microempresa ou Empresa de Pequeno Porte classificada em segundo lugar desista 
ou não se manifeste no prazo estabelecido, o Sistema convocará as demais Microempresas ou 
Empresas de Pequeno Porte participantes na mesma condição, na ordem de classificação; 
 
III – Havendo êxito neste procedimento, o Sistema disponibilizará a nova classificação dos 
fornecedores para fins de aceitação. Não havendo êxito, ou não existindo Microempresa ou 
Empresa de Pequeno Porte participante, prevalecerá a classificação inicial; 
 
IV – Caso sejam identificadas propostas de Microempresas ou Empresas de Pequeno Porte 
empatadas em segundo lugar, ou seja, na faixa dos 5% (cinco por cento) da primeira colocada, 
e permanecendo o empate até o encerramento do item, o sistema fará um sorteio eletrônico 
entre tais fornecedores, definindo e convocando automaticamente a vencedora para o 
encaminhamento da oferta final do desempate; 
 
V – A negociação de preço junto ao fornecedor classificado em primeiro lugar, quando houver, 
será sempre após o procedimento de desempate de proposta e classificação final dos 
fornecedores participantes. 

 
12.4. Para todos os cálculos efetuados, serão levadas em consideração duas casas decimais, 
sendo desprezadas as demais.  
 
12.5. Se durante o desempate houver suspensão do pregão ou do item, o tempo será 
interrompido. Quando o pregão ou item for reaberto, o tempo será retomado de onde parou. 
 
13 – DO CRITÉRIO DE PREFERÊNCIA. 

13.1.  Este pregão submete-se às regras relativas ao direito de preferência estabelecidas no 
Decreto nº 7.174/2010. 
 
 
14 - DA IMPUGNAÇÃO E PEDIDOS DE ESCLARECIMENTOS. 
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14.1. Até 02 (dois) dias úteis antes da data fixada para abertura da sessão pública, qualquer 
pessoa poderá impugnar o ato convocatório do presente pregão, enviando a peça impugnatória ao 
endereço eletrônico slc@tre-al.jus.br. 
 

14.1.1. Caberá ao Pregoeiro, auxiliado pela seção responsável pela elaboração do edital, 
decidir sobre a impugnação no prazo de até 24h (vinte e quatro horas). 

 

14.1.2.  Acolhida a impugnação contra o ato convocatório, será definida e publicada nova data 
para realização do certame. 

 

14.2. Os pedidos de esclarecimentos referentes a este Edital deverão ser enviados à Seção de 
Licitações e Contratos, até três dias úteis anteriores à data fixada para a abertura da sessão 
pública, exclusivamente por meio eletrônico via Internet, para o endereço de e-mail: slc@tre-
al.jus.br, cujas respostas serão disponibilizadas nos avisos referentes a este Pregão, no site do 
TRE/AL: www.tre-al.jus.br e no site www.comprasnet.gov.br. 
 
15- DOS RECURSOS. 
 
15.1.  Existindo intenção de interpor recurso, o licitante deverá manifestá-la ao pregoeiro, 
exclusivamente por meio eletrônico, em formulário próprio, explicitando sucintamente suas razões, 
logo após a fase de habilitação. 
 
15.2.  O Pregoeiro informará, via chat, o tempo para a recepção, pelo sistema eletrônico, da 
intenção de recurso, abrindo em seguida este prazo e fechando ao término do tempo informado. 
 
15.3.  Caso tenha havido registro de intenção de manifestação de recurso, o Pregoeiro decidirá 
sobre sua admissibilidade. Sendo admissível a manifestação de recurso registrada, o sistema abrirá 
formulário próprio para o registro das razões do recurso, no prazo de 3 (três) dias, as quais poderão 
ser impugnadas pelos demais licitantes, desde logo intimados para, querendo, apresentar 
contrarrazões em igual prazo, exclusivamente por meio eletrônico, e após julgadas pelo Pregoeiro, 
submeterá a sua decisão à autoridade competente. 

 
15.4.  O acolhimento do recurso implica tão somente na invalidação daqueles atos que não 
sejam passíveis de aproveitamento. 
 
15.5.  A falta de manifestação eletrônica de intenção de recorrer, no prazo estipulado pelo 
Pregoeiro, importará a decadência do direito de recurso e a adjudicação do objeto pelo pregoeiro ao 
vencedor. 
 
16 - DA ADJUDICAÇÃO E HOMOLOGAÇÃO. 
 
16.1.  A adjudicação do objeto do presente certame será viabilizada pelo pregoeiro sempre que 
não houver recurso. 
 
16.2.  A homologação da licitação é de responsabilidade da autoridade competente e só poderá 
ser realizada depois da adjudicação do objeto ao proponente vencedor pelo pregoeiro, ou, quando 
houver recurso, pela própria autoridade competente. 
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16.3.  Antes da adjudicação pelo pregoeiro, será feita consulta ao CADIN – Cadastro Informativo 
de Créditos não Quitados do Setor Público Federal, nos termos do Inciso III do Art. 6º da Lei nº 
10.522, de 19/07/2002. 
 
17 - DO REAJUSTE DO PREÇO. 
 
17.1.  Os preços ofertados serão fixos e irreajustáveis. No entanto, os valores constantes da Ata 
de Registro de Preços admitem revisão na forma disciplinada no Decreto nº 7.892/2013. 
 
18 - DA HOMOLOGAÇÃO, DA ATA DE REGISTRO DE PREÇOS E DA CONTRATAÇÃO. 
 
18.1. A adjudicação do objeto do presente certame será viabilizada pelo pregoeiro sempre que 
não houver recurso. 
 

18.1.1. Antes da adjudicação pelo pregoeiro, será feita consulta ao CADIN – Cadastro 
Informativo de Créditos não Quitados do Setor Público Federal, nos termos do Inciso III do Art. 
6º da Lei 10.522, de 19/07/2002. 

 
18.2. A homologação da licitação é de responsabilidade da autoridade competente e só poderá 
ser realizada depois da adjudicação do objeto ao proponente vencedor pelo pregoeiro, ou, quando 
houver recurso, pela própria autoridade competente. 
 
18.3. Homologado o resultado da licitação, os fornecedores classificados, observado o disposto 
no art. 11 do Decreto nº 7.892/2013, serão convocados para assinar a ata de registro de preços, 
dentro do prazo e condições estabelecidos no subitem 18.3.1., podendo ser prorrogado uma vez, 
por igual período, quando solicitado pelo fornecedor e desde que ocorra motivo justificado aceito 
pela administração. 
 

18.3.1. O cadastro de reserva dos fornecedores classificados a que se refere o item anterior 
será elaborado desde que viabilizado pelo sistema Comprasnet, tal como previsto no art. 26 do 
decreto acima citado. 
 
18.3.2. O licitante vencedor deverá devolver a Ata de Registro de Preços assinada dentro do 
prazo de 05 (cinco) dias úteis, a contar do recebimento da convocação para assinatura do 
documento, em conformidade com o previsto no art. 64 da Lei n. 8.666/1993. 

 
18.4. É facultado à administração, quando o convocado não assinar a ata de registro de preços 
no prazo e condições estabelecidos, convocar os licitantes remanescentes, na ordem de 
classificação, para fazê-lo em igual prazo e nas mesmas condições propostas pelo primeiro 
classificado. 
 
18.5. A ata de registro de preços implicará compromisso de fornecimento nas condições 
estabelecidas, após cumpridos os requisitos de publicidade. 
 
18.6. A recusa injustificada de fornecedor classificado em assinar a ata, dentro do prazo 
estabelecido no subitem 18.3.2, ensejará a aplicação das penalidades aludidas no item 18.12 deste 
edital, bem como às do art. 28 do Decreto n. 5.450/2005. 
 
18.7. A contratação com os fornecedores registrados será formalizada pelo órgão interessado 
por intermédio de instrumento contratual, emissão de nota de empenho de despesa, autorização de 
compra ou outro instrumento hábil, conforme o art. 62 da Lei nº 8.666, de 1993. 
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18.8. Após a devolução da Ata de Registro de Preços assinada, a licitante poderá receber a 
Nota de Empenho e a Autorização de Fornecimento, devendo confirmar o seu recebimento. 
 
18.9. A recusa na aceitação da nota de empenho e da Autorização de Fornecimento deverá ser 
expressa, escrita e justificada, o que será encaminhado para a autoridade competente que 
procederá à análise dos motivos acostados pelo licitante, decidindo acerca da aceitabilidade ou não 
da justificativa. 
 
18.10. Caso a justificativa não seja encaminhada na forma descrita ou esta não seja aceita pela 
autoridade competente, o prazo para a entrega continuará fluindo normalmente, e em não sendo 
cumprido, sujeitará o licitante às penalidades cabíveis. 
 
18.11. Os contratos decorrentes do Sistema de Registro de Preços poderão ser alterados, 
observado o disposto no art. 65 da Lei nº 8.666, de 1993 e no art. 12, § 3º do Decreto nº 
7.892/2013. 
 
18.12. O registro do fornecedor será cancelado quando: 
 
a) descumprir as condições da Ata de Registro de Preços; 
 
b) não retirar a nota de empenho ou instrumento equivalente no prazo estabelecido pela 
Administração, sem justificativa aceitável; 
 
c) não aceitar reduzir o seu preço registrado, na hipótese deste se tornar superior àqueles 
praticados no mercado; ou 
 
d) sofrer sanção prevista nos incisos III ou IV do caput do art. 87 da Lei nº 8.666, de 1993, ou no art. 
7º da Lei nº 10.520, de 2002. 
 

18.12.1. O cancelamento de registros nas hipóteses previstas nas alíneas “a”, “b” e “d” 
do subitem 18.12. será formalizado por despacho do órgão gerenciador, assegurado o 
contraditório e a ampla defesa. 

 
18.12.2. O cancelamento do registro de preços poderá ocorrer por fato superveniente, 
decorrente de caso fortuito ou força maior, que prejudique o cumprimento da ata, 
devidamente comprovados e justificados: 

 
a) por razão de interesse público; ou 
 
b) a pedido do fornecedor. 

 
18.13. O licitante vencedor somente poderá subcontratar, em parte, o objeto desta licitação, se 
for conveniente para a Administração deste Tribunal, mediante prévia e escrita autorização desta, 
sob pena de sofrer as sanções contratuais e legais. 
 

18.13.1. O licitante vencedor não poderá transferir a terceiros nenhuma responsabilidade, em 
caso de subcontratação autorizada. 

 
18.14. O licitante vencedor obriga-se a manter, durante a vigência do Registro de Preços, em 
compatibilidade com as obrigações por ele assumidas, todas as condições de habilitação e 
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qualificação exigidas na licitação, renovando as certidões e encaminhando-as ao Tribunal Regional 
Eleitoral de Alagoas, no prazo máximo de 48 (quarenta e oito) horas a partir da solicitação das 
mesmas. 
 
18.15. A Ata de Registro de Preços, durante sua vigência, poderá ser utilizada por qualquer 
órgão ou entidade da administração pública federal que não tenha participado do certame 
licitatório, mediante anuência do órgão gerenciador, observadas, ainda, as demais regras impostas 
no art. 22 do Decreto n.º 7.892/2013. 
 
18.16. As aquisições ou contratações adicionais a que se refere o subitem 18.15 não poderão 
exceder, por órgão ou entidade, a cinquenta por cento dos quantitativos dos itens do instrumento 
convocatório e registrados na ata de registro de preços para o órgão gerenciador e órgãos 
participantes. 
 
18.17. O quantitativo decorrente das adesões à ata de registro de preços não poderá exceder, 
na totalidade, ao dobro do quantitativo de cada item registrado na ata de registro de preços para o 
órgão gerenciador e órgãos participantes, independente do número de órgãos não participantes que 
aderirem.  
 
19 – DO RECEBIMENTO DO OBJETO. 
 
19.1.  O objeto deverá ser entregue, no prazo previsto no item 3 deste edital, por e-mail ou ofício, 
o que ocorrer primeiro, no horário de expediente normal, de segunda a sexta-feira, na Seção de 
Almoxarifado do Tribunal Regional Eleitoral de Alagoas, localizada na Avenida Menino Marcelo 
(antiga via expressa), nº 7.200 D – Serraria, Maceió/AL, CEP: 57046-005, sob agendamento através 
do telefone (82) 3328-1947. 
 
19.2. O objeto será recebido: 

 
a) provisoriamente, para que seja feita a verificação da conformidade dos mesmos com 
as especificações. 
 

b) definitivamente, após avaliação e homologação pelos responsáveis técnicos do Tribunal, da 
seguinte forma: 

b.1) O exame para comprovação das características técnicas consistirá em avaliações e 
testes não-destrutivos, por amostragem realizados em duas etapas: 

a. Primeira: inspeção visual de todos os equipamentos entregues; 
b. Segunda: testes funcionais de configuração e desempenho, em, no mínimo, 10% (dez 

por cento) e não menos do que 01 (um) dos equipamentos recebidos. O Tribunal 
poderá, a seu critério, executar os testes nos demais equipamentos, dentro de 
um critério de razoabilidade, podendo chegar a 100% dos quantitativos, mas dentro de 
um prazo máximo de 30 (trinta) dias corridos e contados de cada lote de 
equipamentos. 

b.2) As especificações serão avaliadas também por meio de documentos técnicos que 
acompanham os equipamentos, informações fornecidas pela Contratada e disponível no 
sítio do fabricante; 
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b.3) A comissão do Tribunal deverá, após a comprovação do perfeito funcionamento dos 
equipamentos e adequação às especificações técnicas, emitir e assinar o Termo de 
Recebimento Definitivo. 

19.3. O produto será rejeitado no caso de incompatibilidade com as especificações previstas 
na proposta ou quando inadequado à sua utilização. 
 
19.4. O prazo para a Secretaria competente proceder às verificações, após o recebimento 
provisório, será de 05 (cinco) dias úteis, quando deverá se manifestar, aceitando ou recusando o 
item objeto do fornecimento. 
 
19.5. Os recebimentos provisório e definitivo se darão mediante formulário próprio. 
 
19.6. O recebimento definitivo não exime o fornecedor de responder pelos vícios aparentes e 
ocultos segundo as disposições deste termo e as normas de proteção ao consumidor. 
 
19.7. O objeto que estiver em desacordo com as especificações do edital terá seu recebimento 
recusado, devendo o fornecedor, dentro do prazo de 10 (dez) dias corridos, substituir o produto 
adequadamente, sujeitando-se à multa prevista na Seção 18. 
 
20 – DAS SANÇÕES ADMINISTRATIVAS. 
 
20.1.  Com fundamento no artigo 7º da Lei nº 10.520/2002 e, subsidiariamente, nos artigos 86 e 
87 da Lei 8.666/1993, a Contratada ficará sujeita, assegurada prévia e ampla defesa, às seguintes 
penalidades:  
 
a. Advertência:  
 

i. A Contratada será notificada formalmente em caso de descumprimento de obrigação 
contratual e terá que apresentar as devidas justificativas em um prazo de até 5 (cinco) dias úteis 
após o recebimento da notificação; e 

 
ii. Caso não haja manifestação dentro desse prazo ou se entenda serem improcedentes as 
justificativas apresentadas, a Contratada será advertida. 

 
b. Multa de: 

 
i. 0,5% (meio por cento) por dia, e por ocorrência, sobre o valor do objeto com atraso 
injustificado, limitada a incidência a 20 (vinte) dias corridos; 

- No caso de atraso injustificado na entrega do objeto por prazo superior a 20 
(vinte) dias corridos, com a aceitação pela Administração, será aplicada a multa de 10% sobre o 
valor da Ordem de Fornecimento; e 

-  No caso de atraso injustificado na prestação dos serviços por prazo superior a 20 (vinte) dias 
corridos, com a não aceitação pela Administração, será aplicada a penalidade 20% sobre o valor 
da Ordem de Fornecimento, no caso de inexecução total da obrigação, podendo haver, ainda, o 
cancelamento do registro de preços do Fornecedor. 

ii. 10% sobre o valor constante da Ordem de Fornecimento, no caso de inexecução parcial 
da obrigação assumida; 
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iii. 20% (vinte por cento) sobre o valor adjudicado, em caso de inexecução total da obrigação 
assumida; 

iv. 10% sobre o valor global da Ata de Registro de Preços, na hipótese de recusa em assinar a Ata 
ou retirar a Ordem de Fornecimento; 

c. Impedimento de licitar e contratar com a União e descredenciamento do SICAF pelo prazo de até 
5 (cinco) anos, sem prejuízo das demais penalidades legais; e  
 
d. Declaração de inidoneidade para licitar ou contratar com a Administração Pública.  

 
20.2.    O cometimento reiterado de atrasos injustificados dos prazos previstos para 
entrega/solução do chamado de garantia dos equipamentos poderá resultar no cancelamento do 
instrumento de fornecimento com a Contratada. 
 
20.3.   As sanções previstas nos itens "20.1.a", “20.1.c” e “20.1.d” poderão ser aplicadas, 
cumulativamente ou não, à pena de multa.  
 
20.4.   O valor da multa, aplicada após o regular processo administrativo, será descontado de 
pagamentos eventualmente devidos à contratada ou cobrado judicialmente;  
 
20.5.   Excepcionalmente, ad cautelam, a Administração poderá efetuar a retenção do valor 
presumido da multa, antes da instauração do regular procedimento administrativo. 
 
20.6.   O valor da multa, apurado após regular procedimento administrativo, será descontado 
dos pagamentos eventualmente devidos pelo TRE/AL ou cobrado judicialmente. 
 
20.7.   Na aplicação das penalidades previstas nesta Seção a autoridade competente sempre 
se valerá dos princípios da proporcionalidade, da razoabilidade e da prevalência e indisponibilidade 
do interesse público, em decorrência de circunstâncias fundamentadas em fatos comprovados. 
 
20.8.   O licitante contratado, quando não puder cumprir os prazos estipulados para o 
fornecimento do material, total ou parcialmente, deverá apresentar justificativa por escrito, 
devidamente comprovada, e em documento contemporâneo à sua ocorrência, acompanhada de 
pedido de prorrogação, nos casos de ocorrência de fato superveniente, excepcional ou imprevisível, 
estranho à vontade das partes, que altere fundamentalmente as condições do contrato, ou que 
impeça a sua execução, por fato ou ato de terceiro reconhecido pela Administração.  
 
20.9.  Do ato que aplicar as penalidades caberá recurso na forma do art. 109 da Lei nº 
8.666/1993. 
 
20.10.  Se o licitante contratado não recolher o valor da multa que lhe for aplicada, dentro de 05 
(cinco) dias úteis a contar da data da intimação para o pagamento, a importância será descontada 
automaticamente, ou ajuizada a dívida, consoante o § 3º do art. 86 e § 1º do art. 87 da Lei nº 
8.666/1993, acrescida de juros moratórios de 0,5% (meio por cento) ao mês. 
 
20.11.  O TRE/AL promoverá o registro no SICAF de toda e qualquer penalidade imposta ao 
licitante contratado. 
 
20.12.  O período de atraso será contado em dias corridos. 
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20.13. No caso de aplicação de penalidade em que a contratada tenha que pagar multa através 
de Guia de Recolhimento da União – GRU, e não o faça no devido prazo, o índice utilizado para 
atualização do valor será o IPCA. 
 
20.14. A data a ser utilizada como referência para a atualização do débito será a da publicação 
da decisão da aplicação da penalidade no Diário Eletrônico.  
 
20.15.  Fica estabelecido que os casos omissos serão resolvidos entre as partes contratantes, 
respeitados o objeto da presente licitação, a legislação e demais normas reguladoras da matéria, 
em especial as Leis nos 8.666/1993 e  10.520/2002, aplicando-lhes, quando for o caso, 
supletivamente, os princípios da Teoria Geral dos Contratos e as disposições do Direito Privado. 
 
20.16.  Os atos administrativos de aplicação das sanções, com exceção de advertência, multa de 
mora e convencional, serão publicados resumidamente no Diário Oficial da União. 
 
21 - DO PAGAMENTO. 
 
21.1.  O pagamento será efetuado mediante ordem bancária de crédito em conta corrente, em 
até 10 (dez) dias, após o recebimento da Nota Fiscal respectiva, a qual deverá ser entregue 
somente após a prestação dos serviços, devendo a contratada atender os seguintes requisitos: 

a) Apresentação de nota fiscal de acordo com a legislação vigente à época da emissão (nota 
fiscaleletrônica, se for o caso), acompanhada do Certificado de Regularidade do FGTS – CRF, 
comprovando regularidade com o FGTS; da Certidão Conjunta Negativa de Débitos Relativos a 
Tributos Federais e à Dívida Ativa da União, que incluindo as referentes a contribuições 
previdenciárias, expedida pela Secretaria da Receita Federal; e da Certidão Negativa de 
Débitos Trabalhistas – CNDT, emitida pela Justiça do Trabalho; e da prova de regularidade para 
com as Fazendas Estadual e Municipal do domicílio ou sede do Fornecedor; e 

b) Inexistência de fato impeditivo para o qual tenha concorrido o Fornecedor. 

21.2.  Eventuais penalidades poderão ser descontadas do pagamento. 
 
21.3.  Em nenhuma hipótese haverá antecipação de pagamento. 
 
21.4.  O TRE/AL, por ocasião de cada pagamento, fará as retenções e recolhimentos fiscais 
determinados pela legislação tributária. 
 
21.5.  Se a empresa for optante pelo SIMPLES, deverá anexar à nota fiscal documento que 
comprove tal opção, para que sobre o valor do pagamento não incidam as retenções de que trata o 
item anterior. 
 
21.6.  Havendo atraso no pagamento, o valor devido deverá ser acrescido de encargos 
moratórios, apurados desde a data do primeiro dia útil do atraso, até a data do efetivo pagamento, 
desde que o contratado não tenha concorrido para tanto, mediante a aplicação da seguinte 
fórmula: 
 
EM = I x N x VP, 
 
Onde: 
EM= Encargos Moratórios 
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N= Número de dias entre a data prevista para o pagamento e a do efetivo pagamento; 
VP = Valor da parcela a ser paga; 
I= Índice de atualização financeira= 0,0001644, assim apurado: 
 
I = (TX/100)                  I= (6/100)           I = 0,0001644 
         365                             365 
TX= Percentual de Taxa Anual= 6% 

21.7.  Nenhum pagamento será efetuado à Contratada enquanto pendente de liquidação 
qualquer obrigação. Esse fato não será gerador de direito a reajustamento de preços ou a 
atualização monetária. 

22 – DA DOTAÇÃO ORÇAMENTÁRIA. 
 
22.1.  As despesas decorrentes da execução do contrato correrão à conta dos recursos 
lançados na Proposta Orçamentária Anual deste Tribunal para o exercício 2019, alocados no 
Programa de Trabalho - PTRES nº 084621 (Julgamento de causas e gestão administrativas) - Natureza 
da Despesa nº 44.90.52 (Equipamentos e Material Permanente) e 33.90.39 (Outros Serviços de 
Terceiros - Pessoa Jurídica). 
 
22.2.  As despesas referentes aos exercícios subsequentes correrão à conta das dotações 
orçamentárias respectivas. 
 
23 - DAS OBRIGAÇÕES DO ÓRGÃO GERENCIADOR. 
 
23.1. São obrigações do Órgão Gerenciador: 
 

a) Gerenciar a presente Ata, indicando, sempre que solicitado, o nome do detentor da ata, o 
preço, e as especificações dos materiais registrados, observada a ordem de classificação 
indicada na licitação; 
 
b) Observar para que, durante a vigência da presente ata, sejam mantidas todas as condições 
de habilitação e qualificação exigidas na licitação, bem assim, a compatibilidade com as 
obrigações assumidas; 
 
c) Conduzir eventuais procedimentos administrativos de renegociação de preços registrados, 
para fins de adequação às novas condições de mercado, e de aplicação de penalidades; 
 
d) Acompanhar a evolução dos preços de mercado, com a finalidade de verificar sua 
compatibilidade com aqueles registrados na Ata; 
 
e) Acompanhar e fiscalizar o cumprimento das condições ajustadas na presente Ata; 
 
f) Aplicar, garantida a ampla defesa e o contraditório, as penalidades decorrentes do 
descumprimento do pactuado na ata de registro de preços ou do descumprimento das 
obrigações contratuais, em relação às suas próprias contratações; 
 
g) Consultar o detentor da ata registrada (observada a ordem de classificação) quanto ao 
interesse em fornecer o material a outro(s) órgão(s) da Administração Pública que externe(m) 
a intenção de utilizar a presente Ata, conforme subitem 18.15. 
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23.2. São, ainda, obrigações do órgão gerenciador da ata, na condição de contratante: 

 

a) Efetuar o pagamento à Contratada, após o recebimento definitivo; 
b) Acompanhar e fiscalizar a execução do objeto da Ata de Registro de Preços e 

do(s) contrato(s) dela decorrentes, por meio de servidor(es) designado(s), 
de modo a garantir o fiel cumprimento do mesmo e da proposta; 

c) Manter arquivo, junto ao processo administrativo ao qual está vinculado o presente termo,  
toda a documentação referente ao mesmo; 

d) Proporcionar todas as facilidades indispensáveis à boa execução das obrigações contratuais; 
e 

e) Aplicar as sanções conforme previsto no contrato, assegurando à Contratada o contraditório 
e ampla defesa. 

24 - DAS OBRIGAÇÕES DO DETENTOR DA ATA. 
 

24.1.  São obrigações do detentor da Ata: 
 

a) Providenciar a imediata correção de deficiências, falhas ou irregularidades constatadas pelo 
ÓRGÃO GERENCIADOR referentes às condições firmadas na presente Ata; 
 
b) Viabilizar o atendimento das condições firmadas a partir da data da publicação da presente 
Ata; 
 
c) Manter, durante o prazo de vigência da presente Ata, todas as condições de idoneidade 
exigidas na licitação, além de se sujeitar às demais disposições do Código de Proteção e 
Defesa do Consumidor (Lei n° 8.078/90) que sejam compatíveis com o regime de direito 
público; 
 
d) Informar, no prazo máximo de 05 (cinco) dias úteis, contados do recebimento da 
notificação, quanto à aceitação ou não do fornecimento de material a outro órgão da 
Administração Pública (não participante) que venha a manifestar o interesse de utilizar a 
presente Ata, conforme item 18.15. 

 
24.2. São ainda obrigações do detentor da Ata, na condição de contratado: 

 
a) Executar o contrato em estrita conformidade com as disposições e especificações do 
Edital e com os termos da proposta de preços; 

b) Fornecer os equipamentos conforme especificações, quantidades, prazos e demais 
condições estabelecidas no Edital, na Ata de Registro de Preços, na Ordem de 
Fornecimento e na Proposta de preços; 

c) Fornecer a documentação necessária à instalação e à operação dos produtos 
(manuais, termos de garantia, etc.), completa, atualizada e em português do Brasil, caso 
exista, ou em inglês; 

d) Disponibilizar Central de Atendimento para a abertura e fechamento de chamados 
técnicos, conforme períodos, horários e condições estabelecidas no Edital e em seus 
Anexos; 
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e) Comunicar formal e imediatamente ao Gestor ou Responsável Técnico da 
Administração sobre mudanças nos dados para contato com a Central de Atendimento; 

f) Prestar as informações e os esclarecimentos que venham a ser solicitados pelo 
representante da Administração, referentes a qualquer problema detectado ou ao 
andamento de atividades da garantia; 

g)  Responder por quaisquer prejuízos que seus profissionais causarem ao patrimônio da 
Administração ou a terceiros, por ocasião da execução do objeto, procedendo 
imediatamente aos reparos ou às indenizações cabíveis e assumindo o ônus decorrente; 

h) Responsabilizar-se integralmente pelo fornecimento dos equipamentos e pela 
execução dos serviços de garantia técnica, primando pela qualidade, desempenho, 
eficiência e produtividade na execução dos trabalhos, dentro dos prazos estipulados e 
cujo descumprimento será considerado infração passível de aplicação das penalidades 
previstas no Termo de Referência (Anexo I); 

i) Comunicar ao Gestor ou Responsável Técnico, formal e imediatamente, todas as 
ocorrências anormais e/ou que possam comprometer a execução do objeto; 
 
j) Manter sigilo sobre todo e qualquer assunto de interesse da Administração ou de 
terceiros de que tomar conhecimento em razão da execução do objeto, respeitando 
todos os critérios estabelecidos, aplicáveis aos dados, informações, regras de negócios, 
documentos, entre outros pertinentes, sob pena de responsabilidade civil, penal e 
administrativa; 

 
k) Cumprir e garantir que seus profissionais estejam cientes, aderentes e obedeçam 
rigorosamente às normas e aos procedimentos estabelecidos na Política de Segurança da 
Informação do TRE/AL; 

 
l) Responsabilizar-se pela conservação dos ambientes onde desempenhe as atividades 
necessárias para prestar a garantia on-site; 

 
m) Prestar as informações e os esclarecimentos que venham a ser solicitados pela 
Administração, referentes a qualquer problema detectado ou ao andamento de 
atividades da garantia técnica. 
 
n) Indicar endereço eletrônico (e-mail) para o recebimento de expedientes/notificações 
enviadas pelo TRE/AL, sendo considerados válidos todos os expedientes/notificações 
enviadas ao endereço eletrônico indicado; 
 
o) Manter durante a execução do contrato todas as condições que culminaram em sua 
habilitação, principalmente a regularidade fiscal e previdenciária, condições de 
idoneidade exigidas na licitação e outras previstas na legislação vigente e na aplicável à 
natureza dos serviços objeto da contratação; 
 
p) Aceitar o cancelamento da ordem de fornecimento por parte da Administração, no 
caso de fornecimento/entrega, em final de exercício e posterior ao dia 15 de dezembro 
ou dia útil imediatamente subsequente, em decorrência dos efeitos da Emenda 
Constitucional nº 95/2016, sem a reversão de qualquer ônus à Administração. 
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q) Apresentar certidões de quitação junto à Receita Federal, Dívida Ativa da União, INSS, 
FGTS, Fazenda Estadual e Fazenda  Municipal ou estar registrada junto ao SICAF em 
condição regular; 
 
r) Acatar outras determinações previstas na legislação aplicável à natureza do objeto 
deste contrato; 
 
s) Cumprir com outras obrigações decorrentes da aplicação do Código de Proteção e 
Defesa do Consumidor (Lei nº 8.078/1990) que sejam compatíveis com o regime de 
Direito Público. 

 
 
25 - DA PUBLICIDADE. 
 
25.1. O preço registrado com indicação dos fornecedores será divulgado no Portal de Compras 
do Governo federal e ficará disponibilizado durante a vigência da ata de registro de preços, em 
conformidade com o disposto no art. 11, inciso II do Decreto n.º 7.892/2013 combinado com o art. 
15, 2º da Lei nº 8.666/93. 
 
25 – DA VEDAÇÃO DE AQUISIÇÃO SEPARADA DOS ITENS. 
 
25.1. É vedada a aquisição separada de itens para os quais, o fornecedor convocado para 
assinar a ata não tenha apresentado o menor preço entre todos os licitantes. 
 
26 - DISPOSIÇÕES GERAIS. 
 
26.1.  É assegurado ao TRE/AL, no interesse da Administração, revogar o certame, ou, no caso 
de vício insanável (ilegalidade), anulá-lo, no todo ou em parte, dando ciência aos participantes, na 
forma da legislação vigente. 
 
26.2.  As proponentes assumem todos os custos de preparação e apresentação de suas 
propostas e o TRE/AL não será, em nenhum caso, responsável por esses custos, 
independentemente da condução ou do resultado do processo licitatório. 
 
26.3.   As proponentes serão responsáveis pela fidelidade e legitimidade das informações e dos 
documentos apresentados em qualquer fase da licitação. 
 
26.4.  Não havendo expediente, ou ocorrendo qualquer fato superveniente que impeça a 
realização do certame na data marcada, a sessão será transferida para o primeiro dia útil 
subsequente, devendo o Pregoeiro informar sobre o adiamento no ambiente do Comprasnet, com 
antecedência mínima de 24 (vinte e quatro) horas. 
 
26.5.  Na contagem dos prazos estabelecidos neste Edital, excluir-se-á o dia do início e incluir-
se-á o do vencimento. Só se iniciam e vencem os prazos em dias de expediente no TRE/AL. 
 
26.6.  No julgamento da habilitação e das propostas, o pregoeiro poderá sanar erros ou falhas 
que não alterem a substância das propostas, dos documentos e sua validade jurídica, mediante 
despacho fundamentado, registrado em ata e acessível a todos, atribuindo-lhes validade e eficácia 
para fins de habilitação e classificação. 
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26.7.  As normas que disciplinam este Pregão serão sempre interpretadas em favor da 
ampliação da disputa entre as empresas interessadas, sem comprometimento da segurança do 
futuro contrato. 
 
26.8.  Havendo divergência entre o edital e seus anexos, prevalecerá o determinado neste 
edital. 
 
26.9.  O endereço para vistas e protocolo de documentos, é o seguinte: Avenida Aristeu de 
Andrade, nº 377, 6º andar - COMAP/Seção de Licitações e Contratos, bairro Farol, CEP: 57051-090, 
Maceió/AL, Fone: (82) 2122-7764/7765. 
 
26.10. Todos os horários estabelecidos neste Edital, no aviso e durante a sessão pública, 
observarão, para todos os efeitos, o horário de Brasília, Distrito Federal, inclusive para contagem de 
tempo e registro no sistema eletrônico e na documentação relativa ao certame. 
 
26.11. A homologação do resultado desta licitação não implicará direito à contratação. 
 
26.12. Aos casos omissos, aplicar-se-ão as demais disposições da Lei nº 10.520/2002, do 
Decreto nº 5.450/2005 e alterações e da Lei nº 8.666/1993. 
 
26.13. O Edital e seus anexos poderão ser lidos na sala da Seção de Licitações e Contratos, 
COMAP, no endereço especificado no item 26.9, no caso de ser retirado em Maceió/AL, ou ainda, 
nos sites www.tre-al.jus.br e www.comprasnet.gov.br, gratuitamente. 
 
26.14. Fazem parte integrante deste Edital os seguintes Anexos: 
 

ANEXO I – Termo de Referência; 
ANEXO I–A – Especificações dos lotes, itens, quantitativos a serem adquiridos e preços 
máximos admitidos; 
ANEXO I-B - Planilha de Composição de Custos por Item; 
ANEXO II – Planilha para preenchimento dos dados do Contrato (Sugestão); 
ANEXO III – Minuta da Ata de Registro de Preços. 

 
26.15. Fica eleito o Foro da Justiça Federal em Maceió - Seção Judiciária do Estado de Alagoas, 
para dirimir quaisquer dúvidas ou controvérsias oriundas desta licitação, que não puderem ser 
solucionadas administrativamente. 

 
 

Maceió/AL, XX de XXXX de 2019. 
 
 

Ingrid Pereira de Lima Araújo 
Chefe da Seção de Licitações e Contratos  
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ANEXO I 
 

TERMO DE REFERÊNCIA  
 

01. Objeto Registro de Preço para aquisição de componentes de rede (Networking) 

02. Quantidade 

LOTE 01 - SOLUÇÃO PARA REDE CABEADA 

ITEM DESCRIÇÃO DOS PRODUTOS/SERVIÇOS QTD 

ITEM 
01 

SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 
PARA REDE CABEADA 

01 

ITEM 
02 

LICENCIAMENTO ADICIONAL PARA SISTEMA DE 
GERENCIAMENTO HPE IMC 

03 

ITEM 
03 

LICENCIAMENTO ADICIONAL DO MÓDULO DE ANÁLISE DE 
TRAFEGO DO SISTEMA DE GERENCIAMENTO HPE IMC 

02 

ITEM 
04 

LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE 
PERFIL E CONTROLE DE ACESSO 

02 

ITEM 
05 

SWITCH DE DISTRIBUIÇÃO COM 16 PORTAS SFP+ E SUPORTE 
A MÓDULOS DE EXPANSÃO 

06 

ITEM 
06 

MÓDULO COM 4 PORTAS SFP+ PARA SWITCH DE 
DISTRIBUIÇÃO 

16 

ITEM 
07 

MÓDULO DE STACKING COM 4 PORTAS PARA SWITCH DE 
DISTRIBUIÇÃO 

06 

ITEM 
08 

SWITCH DE ACESSO L3 COM 48 PORTAS GIGABIT E 4SFP+ 50 

ITEM 
09 

SWITCH DE ACESSO L3 COM 24 PORTAS GIGABIT E 4SFP+ 40 

ITEM 
10 

SWITCH DE ACESSO L2 COM 24 PORTAS GIGABIT E 4SFP 50 
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ITEM 
11 

SWITCH DE ACESSO L2 COM 48 PORTAS GIGABIT E 4SFP 40 

ITEM 
12 

GBIC 10GB PARA ATÉ 300M 50 

ITEM 
13 

CABO DAC 10 GBPS DE 1M 30 

ITEM 
14 

CABO DAC 10 GBPS DE 3M 30 

ITEM 
15 

GBIC 1GB PARA ATÉ 500M 10 

ITEM 
16 

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA SWITCHS DE REDE 

05 

ITEM 
17 

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO 

01 

ITEM 
18 

TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE SWITCHES 04 

ITEM 
19 

TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE 
ACESSO 

04 

LOTE 02 - SOLUÇÃO DE REDE WIRELESS 

ITEM DESCRIÇÃO DOS PRODUTOS/SERVIÇOS QTD 

ITEM 
20 

SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 
PARA REDE WIRELESS 

01 

ITEM 
21 

SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS 01 

ITEM 
22 

LICENÇAS ADICIONAIS PARA SOLUÇÃO DE GERENCIAMENTO 
DE REDE WIRELESS 

200 

ITEM 
23 

LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE 
PERFIL E CONTROLE DE ACESSO 

02 

ITEM 
24 

CONTROLADORA WLAN 04 

ITEM 
25 

LICENÇAS ADICIONAIS PARA CONTROLADORA WLAN 200 

ITEM PONTO DE ACESSO INTERNO TIPO 01 100 
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26 

ITEM 
27 

PONTO DE ACESSO INTERNO TIPO 02 100 

ITEM 
28 

INJETOR POE PARA PONTOS DE ACESSO TIPO 1 100 

ITEM 
29 

INJETOR POE PARA PONTOS DE ACESSO TIPO 2 100 

ITEM 
30 

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA SOLUÇÃO DE GERENCIAMENTO 

01 

ITEM 
31 

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO 

01 

ITEM 
32 

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA PONTOS DE ACESSO 

05 

ITEM 
33 

TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE ARQUITETURA 
WLAN 

04 

ITEM 
34 

TREINAMENTO BÁSICO DA SOLUÇÃO DE GERENCIAMENTO 04 

ITEM 
35 

TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE 
ACESSO 

04 

 

03. Resumo da 
Especificação do 
Objeto 

Por se tratar de quantidade elevada de itens pertencentes a lotes específicos, 
o detalhamento das especificações está constante no DETALHAMENTO DO 
OBJETO (Art. 18, § 3º, III). 

04. Valor 
Estimado 

Os custos totais projetados, por certo, serão objeto de levantamento por 
parte da Seção de Compras, em momento posterior. 

05. Justificativa 

 A dependência tecnológica para o adequado funcionamento de qualquer 
instituição é na prática, total; 

 A malha de comunicação de rede interna é primordial para  acesso aos 
sistemas e serviço informatizados e desta maneira essencial; 

 Grande parte dos equipamentos de rede do Tribunal está defasado 
tecnologicamente,  fora de garantia ou na iminência de término da 
mesma; 

 Permitir a qualificação da equipe da CONIF para o gerenciamento das 
soluções a serem adquiridas; 

 Maiores detalhes disponíveis no Item 2 do Documento de Oficialização 
da Demanda. 

06. Prazo de 
Entrega 

Conforme item 3 do edital. 
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07. Adjudicação 

Por Lote. 

Justificativa: Plena exigência de total compatibilidade e interoperabilidade entre 
em componentes do respectivo lote, como também quanto à solução de 
gerenciamento em uso no TRE/AL. 

08. Classificação 
Orçamentária 

(A cargo da COFIN). 

09. Local de 
Entrega 

Almoxarifado do Tribunal Regional Eleitoral de Alagoas 

Av. Menino Marcelo, 7200D, Serraria 

Maceió – AL CEP 57046-005 Tel.: (82) 3328-1947 

Horário: De segunda-feira a quinta-feira das 13 às 19h e sexta-feira das 
7h30min Às 13h30min. 

10. Unidade 
Fiscalizadora 

SEGI/CIE/STI 

11. Unidade 
Gestora 

SAD 

12. Sanções 
Administrativas 

Vide 

Item 3.2 Forma de Execução e de Gestão do Contrato (Art. 18, § 3º, III, a) 
Subitem Penalidades (Art. 18, § 3º, III, a, 11) 

13. Prazo de 
Pagamento 

Vide  

Item 3.2 Forma de Execução e de Gestão do Contrato (Art. 18, § 3º, III, a) 
Subitem Forma de Pagamento (Art. 18, § 3º, III, a, 7) 

14. Estratégia de 
Recebimento 

Vide  

Item 3.2 Forma de Execução e de Gestão do Contrato (Art. 18, § 3º, III, a) 
Subitem Recebimento do Objeto: 

15. Modalidade e 
Tipo de Licitação 

Vide 

2.11 Modalidade, Tipo de Licitação, Critérios de Habilitação e Atendimento aos 
Requisitos (Art. 18, § 3º, II, j, IV e V) 

  

1. OBJETO (Art. 18, §3º,I): 

  

Registro de Preço para aquisição de componentes de rede sem fio e cabeada. 

1.1 Definição (Art. 18, §3º, I) 

Registro de Preço para aquisição de computadores  para substituir equipamentos 
fora de garantia e/ou obsoletos. 
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2. FUNDAMENTAÇÃO DA CONTRATAÇÃO (Art. 18, § 3º, II) 

  

2.1 Motivação (Art. 18, § 3º, II, a ) 

Os equipamentos tem por finalidade a substituição, por atualização tecnológica, de equipamentos, 
ora em uso, com aproximadamente 04 (quatro) anos e já não mais cobertos por garantia. Estes 
aspectos, a um só tempo, a se falar em TI, evidenciam a necessidade de atualização e de 
demanda de salvaguarda, esculpida em garantia, da efetividade e continuidade do mister da 
Secretaria. 

  

A estratégia de Registro de Preços está amparada no Decreto nº 7.892/2013, art 3º, incisos: 

I - vez que os equipamentos podem ser objeto de diversas aquisições/fornecimentos até que se 
supra progressivamente toda a demanda de substituição progressiva; 

II - as entregas deve ser progressivas de forma que as equipes da STI, em número limitado, 
possam implantar os equipamentos sem que os mesmo precisem ser estocados por longos 
períodos apenas exaurindo seus prazos de garantia. 

2.2 Objetivos (Art. 18, § 3º, II, b) 

A contratação visa, além de promover ações no sentido de elaborar novo 
instrumento que mantenha um meio para disponibilizar os computadores demandados e: 

Garantir a infraestrutura física apropriadas às atividades administrativas e 
judiciais. 

Prover infraestrutura de TIC apropriada às atividades judiciais e administrativas. 

2.3 Benefícios (Art. 18, § 3º, II, c) 

 Reposição de equipamentos defasados e manutenção da capacidade produtiva atualizada. 

2.4 Alinhamento Estratégico (Art. 18, § 3º, II, d) 

O alinhamento com o PEI é identificado na visão do recursos de infraestrutura e tecnologia em 
seus dois aspectos apontados: 

 Garantir a infraestrutura física apropriadas às atividades administrativas e judiciais. 

Alinhamento com os Objetivos Estratégicos da Estratégia Nacional de TIC do Poder Judiciário nos 
seguintes aspectos: 

 Prover infraestrutura de TIC apropriada às atividades judiciais e administrativas. 

Alinhamento com os Objetivos Estratégicos de TIC da Justiça Eleitoral de Alagoas – 2017/2022 nos 
seguintes aspectos: 

 Viabilizar serviços e soluções de TIC. 

  

2.5 Referência aos Estudos Preliminares (Art. 18, § 3º, II, e) 
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Este Termo de Referência foi elaborado considerando o Documento de 
Oficialização de Demanda (DOD) encaminhado pela Secretaria de Tecnologia da Informação (STI) 
e os Estudos Preliminares constantes do Processo SEI nº 0008478-63.2018.6.02.8000. 

2.6 Relação entre a Demanda Prevista e a Contratada (Art. 18, §3º, II, f) 

É pretendida a renovação do parque de equipamentos componentes da 
infraestrutura de TIC. 

2.7 Análise de Mercado de TIC (Art. 18, § 3º, II, g) 

Verifica-se que os bens e serviços pretendidos poderão ser fornecidos por 
diferentes empresas no mercado de TIC. 

Considerando o Item 7 dos Estudos Preliminares, não se vislumbrou alternativa 
que não o presente Registro de Preços. 

  

2.8 Natureza do Objeto (Art. 18, § 3º, II, h) 

Os bens e serviços a serem contratados possuem características comuns e usuais 
encontradas atualmente no mercado de TIC, cujos padrões de desempenho e de qualidade 
podem ser objetivamente definidos neste Termo de Referência. 

O objeto desta contratação tem como escopo a obtenção de produto específico 
em período determinado, portanto não se caracteriza como serviço de natureza continuada. 

2.9 Parcelamento e Adjudicação do Objeto (Art. 18, § 3º, II, i) 

Não haverá parcelamento, cada ordem de fornecimento derivado do Registro de 
Preços deverá ser realizada de maneira integral. 

Adjudicação será por lote. 

2.10 Vigência 

Será, na forma dos normativos vigentes, o tempo máximo do Registro de Preços. 

A vigência da ata será de 12 (doze) meses, contados a partir de sua assinatura. 

A utilização do sistema de Registro de Preços visa, primordialmente, a redução de 
número de licitações para o mesmo objeto, porquanto se concentra em um único procedimento a 
possibilidade de realizar diversas aquisições recorrentes e necessárias, via ordens de 
fornecimento, durante o lapso temporal de sua vigência, em face de os preços permanecerem à 
disposição da Administração. 

2.11 Modalidade, Tipo de Licitação, Critérios de Habilitação e Atendimento aos Requisitos (Art. 18, § 
3º, II, j, IV e V) 

A aquisição pretendida deverá ser realizada por meio de licitação do tipo Pregão 
Eletrônico, como é de praxe neste Regional, salvo entendimento superior contrário. 

A sugestão da equipe de planejamento, por se tratar de fornecimento de 
equipamento, é pela contratação por licitação via pregão. Por conta de possibilidade de 
contingenciamento orçamentário indicamos a modalidade de registro de preços. 

O DECRETO Nº 7.174, DE 12 DE MAIO DE 2010 que regulamenta a contratação de bens e serviços 
de informática e automação pela administração pública federal, direta ou indireta, pelas fundações 
instituídas ou mantidas pelo Poder Público e pelas demais organizações sob o controle direto ou 
indireto da União deve ser aplicado nesta aquisição por se tratar de bem de informática. 
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A ressalva que a equipe aponta é em relação ao artigo 3º, item II que versa sobre a necessidade 
de exigências, na fase de habilitação, de certificações emitidas por instituições públicas ou 
privadas credenciadas pelo Instituto Nacional de Metrologia, Normalização e Qualidade Industrial 
(Inmetro), que atestem, conforme regulamentação específica, a adequação à segurança para o 
usuário e instalações, compatibilidade eletromagnética e consumo de energia. 

Tal exigência inviabiliza e restringe a competição deste certame, vez que a certificação para este 
tipo de produto, segundo o próprio INMETRO, é voluntária, conforme Portaria Inmetro n.º 170 de 
10/04/2012. 

(fonte:http://www.inmetro.gov.br/legislacao/rtac/pdf/RTAC001808.pdf). 

A contratação pretendida deverá ser realizada por meio de licitação do tipo 
Pregão Eletrônico, como é de praxe neste Regional, salvo entendimento superior contrário. 

A sugestão da equipe de planejamento, por se tratar de fornecimento de 
equipamento, é pela contratação por licitação via pregão. Por conta de possibilidade de 
contingenciamento orçamentário indicamos a modalidade de registro de preços. 

2.12 Adequação do Ambiente (Art. 18, § 3º, II, k) 

Para utilização do objeto pretendido é necessário dispor de infraestrutura física 
para sua instalação, situação essa já existente no âmbito do TRE/AL, salvo o surgimento de 
demanda muito particular e além da previsibilidade. 

2.13 Conformidade Técnica e Legal (Art. 18, § 3º, II, l) 

  

2.14 Obrigações do Contratante (Art. 18, § 3º, II, m) 

1. Efetuar o pagamento à Contratada, após o recebimento definitivo; 
2. Acompanhar e fiscalizar a execução do objeto da Ata de Registro de Preços e 

do(s) contrato(s) dela decorrentes, por meio de servidor(es) designado(s), 
de modo a garantir o fiel cumprimento do mesmo e da proposta; 

3. Manter arquivo, junto ao processo administrativo ao qual está vinculado o presente termo, to
da a documentação referente ao mesmo; 

4. Proporcionar todas as facilidades indispensáveis à boa execução das obrigações contratuais; 
e 

5. Aplicar as sanções conforme previsto no contrato, assegurando à Contratada o contraditório 
e a ampla defesa. 

2.15 Obrigações da Contratada (Art. 18, § 3º, II, m) 

As obrigações abaixo são aplicáveis ao objeto a ser contratado. 

1. Fornecer o(s) equipamento(s) conforme especificações, quantidades, prazos e demais
 condições estabelecidas no Edital, na Ata de Registro de Preços, 
na Ordem de Fornecimento, na Proposta e no Contrato; 

2. Fornecer a documentação necessária à instalação e 
à operação dos produtos (manuais, termos de garantia, etc.), completa, atualizada e 
em português do Brasil, caso exista, ou em inglês; 

3. Disponibilizar Central 
de Atendimento para a abertura e fechamento de chamados técnicos, conforme períodos, 
horários e condições estabelecidas no Edital e em seus Anexos; 
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4. Comunicar formal e imediatamente ao Gestor ou Responsável Técnico da 
Administração sobre mudanças nos dados para contato com a Central de Atendimento; 

5. Prestar as informações e os esclarecimentos que venham a ser solicitados pelo 
representante da Administração, referentes a qualquer problema detectado ou 
ao andamento de atividades da garantia; 

6. Responder por quaisquer prejuízos que seus profissionais causarem ao patrimônio da 
Administração ou a terceiros, 
por ocasião da execução do objeto, procedendo imediatamente aos reparos ou 
às indenizações cabíveis e assumindo o ônus decorrente; 

7. Responsabilizar-se  integralmente pelo fornecimento dos equipamentos e pela 
execução dos serviços de garantia técnica, primando pela qualidade, desempenho, 
eficiência e produtividade na execução dos trabalhos, dentro dos prazos estipulados e cujo 
descumprimento será considerado infração passível de aplicação das penalidades 
previstas neste Termo de Referência; 

8.  Comunicar ao Gestor ou Responsável Técnico, formal 
e imediatamente, todas as ocorrências anormais e/ou 
que possam comprometer a execução do objeto; 

9. Manter sigilo sobre todo e qualquer assunto de interesse da Administração ou de 
terceiros de que tomar conhecimento em razão da execução do objeto, respeitando todos 
os critérios estabelecidos, aplicáveis aos dados, informações, regras de negócios, 
documentos, entre outros pertinentes, sob pena de responsabilidade civil, penal e 
administrativa; 

10.  Cumprir e garantir que seus profissionais estejam cientes, aderentes e obedeçam rig
orosamente às normas e 
aos procedimentos estabelecidos na Política de Segurança da Informação do TRE/AL; 

11.  Responsabilizar-
se pela conservação dos ambientes onde desempenhe as atividades necessárias para pres
tar a garantia on-site. 

12. Prestar as informações e 
os esclarecimentos que venham a ser solicitados pela Administração, referentes a qualque
r problema detectado ou ao andamento de atividades da garantia técnica 

13. No caso de fornecimento/entrega, em final de exercício e posterior ao dia 15 de 
dezembro ou dia útil imediatamente subsquente, fica obrigado a aceitar, o cancelamento da 
ordem de fornecimento por parte da Administração, em decorrência dos efeitos da Emenda 
Constitucional nº 95/2016, sem a reversão de qualquer ônus à Administração. 

DETALHAMENTO DO OBJETO (Art. 18, § 3º, III) 

3.1 Descrição do Objeto 

CONDIÇÕES GERAIS 

1. Todos os itens ofertados por lote, deverão ser do mesmo fabricante para garantir total 
compatibilidade entre todos os componentes, sem a utilização de ferramentas de terceiros 
ou modo de interoperabilidade na solução; 

2. Para o  Lote 01: Todos os itens de software ofertados deverão possuir integração total com o 
HPE Intelligent Managment Center (IMC) já existente na infraestrutura da contratante, 
através de interface única de gerenciamento e/ou autenticação centralizada; 
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3. Para o Lote 01: Os equipamentos fornecidos deverão ser gerenciados pelo HPE IMC já 
existente na infraestrutura da contratante, com presença na matriz de compatibilidade 
comprovada através de documentação oficial do fabricante; 

4. Os equipamentos devem ser novos e estar em produção. Não serão aceitos equipamentos 
descontinuados, recondicionados ou usados; 

5. Os equipamentos devem ser entregues acondicionados adequadamente em suas 
embalagens originais; 

6. A(s) solução(ões) de gerenciamento/controle ofertada(s), deverá(ão) ser baseada(s) em 
plataforma “On Premise”, ou seja, deverá ser executada localmente, não sendo aceitas 
soluções híbridas ou em Cloud; 

7. Cada lote deverá ser fornecido por uma única empresa, visando a garantia integral de 
compatibilidade dos componentes ofertados; 

8. As configurações e especificações aqui apresentadas são mínimas, sendo aceitos 
equipamentos/softwares com características superiores, desde que compatíveis com as 
exigidas; 

9. Prazo de entrega para equipamentos: 60 (sessenta) dias contados a partir da emissão da 
ordem de fornecimento ou documento equivalente; 

10. Prazo de entrega para softwares: 30 (trinta) dias contados a partir da emissão da ordem de 
fornecimento ou documento equivalente; 

11. Os serviços de instalação, integração, garantia e suporte dos equipamentos e softwares, 
deverão ser realizados diretamente pelo fabricante de acordo com as exigências contidas no 
descritivo dos mesmos, estando essas aderentes aos respectivos níveis de serviço 
necessários a cada um deles. 

 LOTE 01 – SOLUÇÃO DE REDE CABEADA 

  

ITEM 01 – SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO LICENCIAMENTO 

1. Licenciamento da SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO, contemplando o 
quantitativo mínimo de 1.000 (um mil) dispositivos, usuários corporativos ou visitantes 
simultâneos, independente do perfil de autenticação, seja por dispositivo ou usuário; 

2. Caso a solução ofertada necessite de licenciamento específico para credenciamento dos 
dispositivos, usuários (corporativos ou visitantes), deverá ser fornecido o quantitativo 
solicitado para ambos, de forma que a solução realize a análise de perfil e o controle de 
acesso dos 1.000 (um mil) dispositivos ou usuários (corporativos ou visitantes) simultâneos. 

  

MÓDULO DE ANÁLISE DE PERFIL DE DISPOSITIVO 

Características Gerais Modulo de Análise de Perfil de Dispositivo 

3. Deve implementar funcionalidade de classificação automática criando perfis de dispositivos, 
de forma a descobrir, classificar e agrupar os dispositivos conectados na rede; 

4. Deve categorizar os dispositivos em pelo menos 3 níveis: 

a. Por tipo de dispositivo (ex. Computador, Smartdevice, impressora, etc.); 
b. Por sistema operacional (ex. Windows, Linux, MacOS, etc.); 
c. Versão do sistema operacional (ex. Windows 7, Windows 2008 Server, etc.); 
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5. Deve ser capaz de gerar gráficos das categorias, separando os dispositivos conforme suas 
características; 

6. Deve suportar a coleta de informações, para classificação, usando no mínimo: 

a. DHCP; 
b. HTTP User-Agent; 
c. MAC OUI; 
d. ActiveSync plugin; 
e. SNMP; 
f. Subnet Scanner; 
g. IF-MAP; 
h. Cisco Device Sensor; 
i. MDM; 
j. TCP Fingerprinting. 

7. Deve possuir dicionário de categorias de dispositivos pré-configurado e mecanismo de 
atualização do mesmo; 

8. Deve suportar a integração com, no mínimo, as seguintes soluções de MDM de mercado 
AirWatch, MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, MaaS 360 devendo comprovar 
a compatibilidade em documentação oficial do fabricante; 

9. Deve permitir priorização na ordem de criação dos perfis com no mínimo as seguintes 
características: 

a. Agente proprietário; 
b. HTTP User-Agent; 
c. SNMP; 
d. DHCP; 
e. MAC OUI. 

10. A solução de análise de perfil de usuários deverá permitir consultas a sua base, pela solução 
de controle de acesso para validação de dispositivos com base no seu perfil. 

  

MÓDULO DE CONTROLE DE ACESSO DE DISPOSITIVOS E USUÁRIOS 

Características Gerais 

11. A Solução deverá dar suporte a no mínimo as seguintes bases de dados: 

a. Microsoft Active Directory; 
b. Kerberos; 
c. Diretórios LDAP; 
d. OpenLDAP; 
e. PostgreSQL; 
f. Oracle 11g; 
g. MariaDB; 
h. MSSQL; 
i. Servidores de Token; 
j. Base de dados SQL interna; 
k. Lista interna estática de hosts. 
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12. Deve suportar "Single Sign-on" (SSO) através de SAML v2.0; 
13. Deve implementar gerenciamento e aplicação de políticas de autorização de acesso de 

usuários com base em: 

a. Atributos do usuário autenticado; 
b. Hora do dia, dia da semana; 
c. Tipo de dispositivo utilizado; 
d. Localização do usuário; 
e. Tipo de autenticação utilizada. 

14. Deve permitir a visualização de todas informações relativas a cada transação e autenticação 
em uma única tela, a solução deverá trazer no mínimo as seguintes informações: 

a. Data e Hora; 
b. Mac Address do dispositivo; 
c. Classificação do dispositivo; 
d. Usuário; 
e. Equipamento que requisitou a autenticação (origem); 
f. Método de autenticação utilizado; 
g. Fonte de autenticação utilizada para validação; 
h. Perfil de acesso aplicado; 
i. Atributos de entrada do protocolo utilizados na requisição (ex. RADIUS); 
j. Informações de resposta da solução para o elemento de rede; 
k. Alertas em caso de falha; 
l. LOGS já filtrados para a requisição em análise. 

15. Deve possuir Dashboard customizável, onde deve permitir a visualização de no mínimo as 
seguintes informações: 

a.  
a. Lista com últimos Alertas do sistema; 
b. Gráfico com todas as requisições de autenticação dos últimos 7 dias, incluindo 

RADIUS, TACACS+ e Autenticações Web; 
c. Gráfico com o status das autenticações aceitas e rejeitadas nos últimos 7 dias; 
d. Gráfico com a categorização dos dispositivos classificados pela solução, divididos de 

acordo com as categorias de classificação; 
e. Últimas falhas de autenticação; 
f. Gráfico com as requisições de avaliação de postura dos dispositivos, divididos em: 

  
I. Saudáveis (dentro das políticas estabelecidas); 
II. Não saudáveis (que estão fora das políticas estabelecidas); 

a.  
a. Lista com as últimas autenticações; 
b. Lista com as últimas autenticações com sucesso; 
c. Utilização de CPU do sistema, no mínimo nos últimos 30 minutos; 

16. Deve possuir base de regras e categorias de dispositivos pré-configurada e mecanismo de 
atualização da mesma; 
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17. Deve suportar a integração com no mínimo as seguintes soluções de MDM de mercado 
AirWatch, MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, MaaS 360 devendo comprovar 
a compatibilidade em documentação oficial do fabricante; 

18. Deve suportar autenticações via OAuth2, Facebook, Twitter, LinkdIn, Office365 e Google 
Apps; 

19. Deve possuir recursos integrados de AAA: RADIUS, TACACS+ e Kerberos; 
20. Deve possuir suporte aos seguintes recursos: 

a. RADIUS; 
b. RADIUS CoA; 
c. TACACS+; 
d. Web authentication; 
e. SAML v2.0; 
f. EAP-FAST (EAP-MSCHAPv2, EAP-GTC, EAP-TLS); 
g. PEAP (EAP-MSCHAPv2, EAP-GTC, EAP-TLS, EAP-PEAP-Public); 
h. TTLS (EAP-MSCHAPv2, EAP-GTC, EAP- TLS, EAP-MD5, PAP, CHAP); 
i. EAP-TLS; 
j. PAP, CHAP, MSCHAPv1, MSCHAPv2  e EAP-MD5; 
k. Windows machine authentication; 
l. MAC address authentication (dispositivos sem suporte a 802.1X); 

21. Deve suportar verificação de vulnerabilidade através de varredura de portas; 
22. Deve suportar à aplicação de políticas em ambiente com múltiplos fornecedores de Wireless, 

cabeado e VPN; 
23. Deve possuir CA integrada, para geração de certificados para os dispositivos que forem se 

autenticar na rede; 
24. Deve suportar à integração com plataforma de terceiros usando HTTP/RESTful API; 
25. Deve permitir que a solução faça consultas em bases SQL, com o objetivo de buscar 

informação a serem utilizadas durante o processo de autenticação dos usuários; 
26. Deve possuir suporte a administração através de IPv6; 
27. Deve possuir ferramenta para gerenciar os processos de credenciamento, autenticação, 

autorização e contabilização de usuários visitantes através de portal web seguro; 
28. Deve implementar a criação de grupos de autorizadores com privilégios distintos de criação 

de credenciais temporárias e atribuição de permissões de acesso aos clientes; 
29. Deve permitir realizar a autenticação dos autorizadores em base externa do tipo Microsoft 

Active Directory ou LDAP e atribuir o privilégio ao autorizador de acordo com o seu perfil; 
30. Deve implementar as funcionalidades de geração de lotes de credenciais aleatórias, 

temporárias, pré-autorizadas; 
31. Deve implementar a importação e exportação da relação de credenciais temporárias através 

de arquivos txt ou csv; 
32. Deve permitir a configuração do tempo de validade das credenciais, baseando-se na criação 

da conta ou no primeiro login da conta; 
33. Deve permitir que o visitante crie sua própria credencial temporária (autosserviço) através 

de portal web, com ou sem a necessidade de um autorizador; 
34. Deve permitir a customização do formulário de criação de credenciais, a ser preenchido pelo 

autorizador ou pelo visitante em caso de autosserviço, especificando quais informações 
cadastrais dos visitantes são obrigatórias ou opcionais; 

35. Deve permitir a customização do nível de segurança da senha temporária que será gerada 
ao visitante, especificando a quantidade mínima de caracteres e o uso de caracteres 
especiais e números para compor a senha; 
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36. Deve exigir que o usuário visitante aceite o “Termo de uso da rede” a cada login ou apenas 
no primeiro login; 

37. Deve permitir o envio das credenciais aos usuários registrados através de mensagens SMS 
(Short Message Service), e-mail ou impressão local. 

  

 GARANTIA E SUPORTE 

38. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas; 

39. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução; 

40. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

41. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

42. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

  

ITEM 02 – LICENCIAMENTO ADICIONAL PARA SISTEMA DE GERENCIAMENTO HPE IMC 

Características técnicas mínimas 

1. Licenciamento para expansão do SISTEMA DE GERENCIAMENTO HPE IMC existente na 
infraestrutura da contratante, contemplando o quantitativo adicional mínimo de 50 
(cinquenta) dispositivos simultâneos; 

  

GARANTIA E SUPORTE 

1. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 
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2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

5. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

  

ITEM 03 – LICENCIAMENTO ADICIONAL DO MÓDULO DE ANÁLISE DE TRAFEGO DO SISTEMA DE 
GERENCIAMENTO HPE IMC 

Características técnicas mínimas 

1. Licenciamento para expansão do MÓDULO DE ANÁLISE DE TRAFEGO DO SISTEMA DE 
GERENCIAMENTO HPE IMC existente na infraestrutura da contratante, contemplando o 
quantitativo adicional mínimo de 5 (cinco) dispositivos simultâneos; 

  

GARANTIA E SUPORTE 

1. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

5. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
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centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

  

ITEM 04 – LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 

Características técnicas mínimas 

2. Licenciamento para expansão da SOLUÇÃO DE ANALISE DE PERFIL E CONTROLE DE ACESSO, 
contemplando o quantitativo mínimo adicional de 500 (quinhentos) dispositivos, usuários 
corporativos ou visitantes simultâneos, independente do perfil de autenticação, seja por 
dispositivo ou usuário; 

  

GARANTIA E SUPORTE 

1. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

5. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 
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ITEM 05 – SWITCH DE DISTRIBUIÇÃO COM 16 PORTAS SFP+ E SUPORTE A MÓDULOS DE EXPANSÃO 

  

Características técnicas mínimas 

1. Deve possuir no mínimo 16 portas 10 Gigabit Ethernet, 1000/10000 SFP+ fixas ao 
equipamento 

2. Deve suportar, através de módulos, o mínimo de 8 portas adicionais de 10 Gigabit Ethernet 
SFP+ ou 2 portas de 40 Gigabit Ethernet QSFP+; 

3. Deve suportar transceivers de 10GbE SFP+ e de 40GbE QSFP+ através da adição ou 
substituição de módulos. 

4. Deve possuir, no mínimo, 2 módulos de expansão podendo ser utilizados para uplinks ou 
dados de usuários; 

5. Deve possuir, no mínimo, 2 módulos de fonte internas ao equipamento operando em modo 
redundante; 

6. Deve possuir porta dedicada de gerenciamento; 
7. Deve possuir 1 interface RJ-45 ou serial para acesso console local; 
8. Deve possuir latência de, no máximo, 2,8 μs a 1Gbps; 
9. Deve possuir memória SDRAM de no mínimo 2 Gbytes; 
10. Deve possuir buffer de pacotes de no mínimo 13.5 Mbytes; 
11. Deve possuir capacidade de encaminhamento de no mínimo 285 Mpps; 
12. Deve possuir capacidade de comutação de no mínimo 480 Gbps; 
13. Deve possuir Certificado de Homologação na Anatel, de acordo com a Resolução nº 242; 
14. Deve possuir fonte de alimentação interna 110/220VAC; 

Disponibilidade 

15. Deve possuir capacidade de, no mínimo, 10 (dez) equipamentos membros da mesma pilha; 
16. Deve possuir fonte de alimentação interna redundante com características idênticas a fonte 

principal; 
17. Deve suportar empilhamento com banda agregada mínima de 320 Gbps sem uso de portas 

de dados de usuário para este fim. 

Switching 

18. Deve implementar VLANs baseadas em MAC; 
19. Deve suportar no mínimo 4094 VLAN IDs; 
20. Deve implementar registro dinâmico de VLAN com MVRP; 
21. Deve suportar protocolo OpenFlow 1.3; 
22. Deve implementar Jumbo frames nas interfaces Gigabit Ethernet e 10-Gigabit Ethernet 
23. Deve implementar Jumbo frames com tamanho de até 9000 bytes; 
24. Deve implementar Ethernet link aggregation; 
25. Deve implementar IEEE 802.1ad QinQ; 
26. Deve suportar agregação de link através de LACP com no mínimo 144 grupos distribuídos 

através da pilha, com cada grupo permitindo até 8 portas; 
27. Deve implementar IEEE 802.3x Flow Control; 
28. Deve implementar STP BPDU Protection (BPDU Guard); 
29. Deve implementar IEEE 802.1w Rapid Reconfiguration of Spanning Tree; 
30. Deve implementar MSTP IEEE 802.1s com pelo menos 64 instâncias; 
31. Deve implementar UDLD ou DLDP. 
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Roteamento 

32. Deve implementar roteamento estático IPv4 e IPv6; 
33. Deve implementar RIP, RIPv2 e RIPng; 
34. Deve possuir no mínimo 512 interfaces de roteamento IP (VLAN Interface) 
35. O equipamento ofertado deve implementar roteamento baseado em política (PBR) para IPv4 

e IPv6; 
36. O equipamento ofertado deve possuir tabela de roteamento com no mínimo 10 mil entradas 

IPv4 e 5 mil entradas IPv6; 
37. Deve suportar no mínimo 256 rotas estáticas; 
38. O equipamento ofertado deve permitir autenticação em servidores RADIUS e TACACS+; 
39. Deve suportar dual stack IPv4/IPv6; 
40. Deve implementar Bidirectional Forwarding Detection (BFD), suportando redução do tempo 

de convergência para OSPF e VRRP; 
41. Deve implementar OSPF v2 e OSPF v3; 
42. Deve implementar BGP. 

QoS 

43. Deve implementar 8 filas em cada porta; 
44. Deve implementar traffic shapping; 
45. Deve implementar classificação de tráfego utilizando informações de camada 2, 3 e 4; 
46. Deve implementar priorização do trafego em camada 4, baseado em número de portas 

TCP/UDP. 

Segurança 

47. Deve implementar autenticação 802.1x de múltiplos usuários por porta, simultaneamente. 
48. Deve implementar segurança orientada por identidade e controle de acesso por usuário 

através de ACLs que permitam ou negue o acesso do usuário aos recursos de rede 
específicos, com base na identidade do usuário. 

49. Atribuição VLAN automática, automaticamente atribui os usuários para a VLAN apropriada, 
com base em suas identidades. 

50. Deve implementar accounting RADIUS; 
51. Deve implementar TACACS+; 
52. Deve implementar proteção contra ataques de ARP; 
53. Deve implementar proteção contra IP spoofing (IP source guard); 
54. Deve implementar SNMP v1, v2 e v3; 
55. Deve implementar detecção de ataques maliciosos e enviar um aviso quando uma anomalia 

potencial, causada pelos ataques mal-intencionado, for detectado. 
56. Deve suportar o isolamento de portas e VLANs, de forma que uma porta ou VLAN isolada não 

possa enviar tráfego para outra porta isolada do mesmo switch; 
57. Deve implementar segurança do gerenciamento do switch em métodos de acesso CLI, GUI ou 

MIB, através de SSHv2, SSL e SNMPv3 
58. Deve implementar autenticação baseado em porta ou endereço MAC; 
59. Deve implementar autenticação utilizando navegadores web, possibilitando que clientes que 

não possuem cliente 802.1x possam autenticar; 
60. Deve suportar port-security. 

Gerenciamento 
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61. Deve permitir instalação simplificada “Zero-touch provisioning” através de processo baseado 
em DHCP com a solução de software de gerenciamento; 

62. O equipamento ofertado deve permitir múltiplos arquivos de configuração; 
63. Deve suportar espelhamento remoto; 
64. Deve implementar Secure File Transfer Protocol; 
65. Deve implementar LLDP; 
66. Deve implementar LLDP-MEd; 
67. Deve implementar SNTP v4; 
68. O equipamento ofertado deve Implementar Sflow ou Netflow; 
69. Deve implementar RFC 1213 MIB II; 
70. Deve implementar RFC 2096 IP Forwarding Table MIB; 
71. Deve implementar RFC 2571 SNMP Framework MIB; 
72. Deve implementar RFC 2572 SNMP-MPD MIB; 
73. Deve implementar RFC 2573 SNMP-Notification MIB; 
74. Deve implementar RFC 2574 SNMP USM MIB; 
75. Deve implementar RFC 2737 Entity MIB (Version 2); 
76. Deve implementar RFC 3414 SNMP-User based-SM MIB; 
77. Deve implementar RFC 3415 SNMP-View based-ACM MIB; 
78. Deve implementar RFC 2668 802.3 MAU MIB; 
79. Deve implementar RFC 3418 MIB for SNMPv3; 
80. Deve ser fornecido com a versão de software mais completa e atual disponível para o 

equipamento; 
81. Deve ser fornecido com todas as licenças de software necessárias para o funcionamento 

integral de todas as funcionalidades disponíveis para o equipamento; 
82. O equipamento ofertado deve possuir certificado de homologação na Anatel, de acordo com 

a resolução n° 242; 

Garantia e Suporte 

83. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 

84. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

85. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

86. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

87. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
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através da apresentação de documentação expressa do fabricante dos equipamentos, 
indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

88. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 06 – MÓDULO COM 4 PORTAS SFP+ PARA SWITCH DE DISTRIBUIÇÃO 

  

Características técnicas mínimas 

1. Módulo de expansão para switch de distribuição; 
2. Suporte a no mínimo 4 (quatro) portas SFP+; 
3. Deve ser compatível com GBICS 100M/1G/10G SFP+; 
4. Deve possuir suporte a MACsec; 
5. Compatibilidade integral com o item 05. 

Garantia e Suporte 

6. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

7. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

8. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada; 

  

ITEM 07 – MÓDULO DE STACKING COM 4 PORTAS PARA SWITCH DE DISTRIBUIÇÃO 

 
Características técnicas mínimas 

1. Módulo de expansão para switch de distribuição; 
2. Suporte a no mínimo 4 (quatro) portas para stacking; 
3. Deve prover no mínimo 320Gbps por módulo; 
4. Deve acompanhar 1 (um) cabo de stacking compatível, com 1 (um) metro de comprimento; 
5. Compatibilidade integral com o item 05. 
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Garantia e Suporte 

6. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

7. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

8. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada; 

  

ITEM 08 – SWITCH DE ACESSO L3 COM 48 PORTAS GIGABIT E 4 SFP+ 

  

Características gerais 

1. Deve possuir 48 portas 10/100/1000; 
2. Deve possuir 4 portas 1/10G SFP+; 
3. Deve possuir capacidade de encaminhamento de, no mínimo, 110 Mpps; 
4. Deve possuir capacidade de comutação de, no mínimo, 176 Gbps; 
5. Deve implementar IEEE 802.3az para as portas 10/100/1000; 
6. Deve possuir uma interface de console USB; 
7. Deve suportar empilhamento de no mínimo 8 switches; 
8. Deve suportar agregação de link através de LACP com no mínimo 20 grupos distribuídos 

através da pilha, com cada grupo permitindo até 8 portas; 
9. Deve suportar a agregação de links entre diferentes membros da pilha; 
10. Deve possuir no mínimo 32.000 endereços MAC; 
11. Deve possuir latência máxima de 4μs, considerando pacotes de 64 bytes; 
12. Deve possuir buffers de, no mínimo, 12 MB; 
13. Deve implementar funcionalidade que permita a detecção de links unidirecionais; 
14. Deve implementar funcionalidade que permita a detecção de falhas de uplink; 
15. Deve implementar no mínimo 2000 VLANs simultaneamente; 
16. Deve implementar MVRP (Multiple VLAN Registration Protocol); 
17. Deve implementar LLDP (IEEE 802.1ab); 
18. Deve implementar LLDP-MED; 
19. Deve implementar Q-in-Q (IEEE 802.1ad); 
20. Deve implementar PVST+, RPVST+ ou protocolo compatível; 
21. Deve implementar MSTP (IEEE 802.1s); 
22. Deve implementar túneis VxLAN (VTEP). 

  

Funcionalidades de Camada 3 

Minuta de edital (complementada) (0581377)         SEI 0008478-63.2018.6.02.8000 / pg. 643



 
TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS 

SEÇÃO DE LICITAÇÕES E CONTRATOS 

 

44 
 

 

 

23. Deve possuir tabela de roteamento com no mínimo 2.000 rotas IPv4 e 1.000 rotas IPv6; 
24. Deve implementar roteamento estático; 
25. Deve implementar RIP v2, com suporte a autenticação MD5 (RIPv2); 
26. Deve implementar RIPng; 
27. Deve implementar OSPF; 
28. Deve implementar OSPFv3; 
29. Deve implementar Policy-based Routing; 
30. Deve implementar VRRP; 
31. Deve implementar VRRPv3; 
32. Deve implementar servidor DHCP; 
33. Deve implementar DHCP snooping (IPv4 e IPv6); 
34. Deve implementar DHCP relay (IPv4 e IPv6); 
35. Deve implementar Gateway mDNS, com suporte a Apple Bonjour. 

  

Multicast 

36. Deve implementar PIM-SM; 
37. Deve implementar PIM-DM; 
38. Deve implementar MLD snooping; 
39. Deve implementar IGMP v3. 

  

Software Defined Networking 

40. Deve implementar OpenFlow 1.3 ou superior; 
41. Deve implementar a separação lógica do tráfego sem suporte a OpenFlow do tráfego com 

suporte a OpenFlow através de instâncias. O tráfego OpenFlow não pode influenciar o tráfego 
não openflow no equipamento; 

42. Deve permitir configurar cada instância como modo ativo (pacotes referentes a fluxos que o 
switch não conhece são enviados para a controladora) ou modo passivo (pacotes que não se 
referem a um fluxo na tabela do switch não são enviados para a controladora); 

43. Deve implementar 16 instâncias de OpenFlow; 
44. As instâncias de OpenFlow devem suportar a associação de múltiplas VLANs; 
45. Cada instância OpenFlow configurada no equipamento deve suportar, pelo menos, a 

configuração de 3 controladores SDN; 
46. Deve permitir utilizar intervalo de portas TCP/UDP e flags de TCP como parâmetros nas 

regras de OpenFlow; 
47. Deve suportar no mínimo 16.000 regras openflow; 
48. Deve possuir interface REST API; 
49. Deve suportar configurações via JSON/REST API com, no mínimo, os seguintes métodos: GET, 

POST, PUT e DELETE; 
50. Deve suportar a criação de VLANs e ACLs no equipamento através de REST. 

  

QoS 

51. Deve implementar controle de broadcast; 
52. Deve implementar rate limiting para pacotes ICMP; 
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53. Deve implementar rate limiting para tráfego broadcast e multicast; 
54. Deve implementar rate limiting baseado em tráfego classificado por uma ACL; 
55. Deve suportar espelhamento de portas; 
56. Deve suportar espelhamento de tráfego para um switch remoto. 

  

Segurança 

57. Deve implementar controle de acesso baseado em perfis (Role Based Access Control); 
58. Deve implementar VLANs privadas, de forma que permita o isolamento de tráfego de uma 

porta de acesso das demais portas de acesso de uma mesma VLAN, permitindo acesso 
apenas para as portas de Uplink (porta promíscua); 

59. Deve implementar 802.1x; 
60. Deve implementar autenticação baseada em web; 
61. Deve implementar autenticação baseada em endereço MAC; 
62. Deve permitir a utilização simultânea de autenticação 802.1x e MAC em uma mesma porta; 
63. Deve implementar TACACS+. Não serão aceitas soluções similares; 
64. Deverá suportar o download de políticas ou ACLsl a partir de um software de Controle de 

Acesso à Rede (NAC), sem necessidade de pré-configuração das regras no switch, permitindo 
a centralização das políticas; 

65. Deve suportar integração com ferramenta de controle de acesso do mesmo fabricante que 
permita identificar automaticamente o tipo e sistema operacional dos equipamentos que se 
conectam à rede (device profiling) sem a necessidade de agentes instalados nos dispositivos; 

66. Deve suportar integração com ferramenta de controle de acesso do mesmo fabricante que 
permita verificar se a máquina está em conformidade com a política de segurança antes de 
entrar na rede, verificando, no mínimo serviços os serviços e antivírus das máquinas. Deve 
suportar os sistemas operacionais Microsoft Windows, Mac OS e Linux. 

  

Gerenciamento 

67. Deve implementar NTP com autenticação MD5; 
68. Deve implementar Time Domain Reflectometry (TDR) para testes de cabos UTP, permitindo 

identificar falhas e verificar a distância do cabo; 
69. Deve suportar duas imagens de software na flash; 
70. Deve suportar múltiplos arquivos de configuração na flash; 
71. Deve permitir o agendamento de tarefas, permitindo executar um comando em um dia e 

horário específicos; 
72. Deve suportar a autoconfiguração dos switches através de DHCP e software de 

gerenciamento, sem necessidade de nenhuma intervenção no switch (com configuração de 
fábrica); 

73. Deve suportar gerenciamento através de plataforma de nuvem do mesmo fabricante, com 
funcionalidades de gerenciamento de configuração, alertas e notificações e gerenciamento 
de firmware, sem necessidade de instalação de nenhum software ou dispositivo on-site; 

74. Deve suportar IPSec para comunicação com o sistema de gerenciamento; 
75. Deve implementar sFlow (IPv4 e IPv6); 
76. Deve possuir interface web para configuração; 
77. Deve implementar TR-69 (CPE WAN Management Protocol); 
78. Deve suportar diagnóstico de transceivers ópticos; 
79. Deve implementar Syslog sobre TLS; 
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80. Deve implementar Secure SFTP (SFTP); 
81. Deve implementar SNMP v1/v2/v3; 
82. Deve implementar funcionalidade que permita monitorar o SLA (Service Level Agreement) de 

conexões IP. Deve suportar os seguintes testes: ICMP Echo, UDP-Echo (em porta 
configurável) e TCP-Connect (em porta configurável) e Jitter UDP para voz; 

83. Deve implementar compatibilidade com o protocolo CDP para provisionamento de telefones 
IP; 

84. Deve implementar o isolamento de um Access Point rogue conectado ao switch, quando este 
for detectado por solução de WLAN do mesmo fabricante; 

85. Deve implementar a configuração automática de Access Point wireless do mesmo fabricante 
quando conectado ao switch. Devem ser suportados os seguintes parâmetros para a 
configuração automática: VLAN, CoS, largura de banda máxima; 

86. Deve suportar o encaminhamento de tráfego para controladora wireless do mesmo 
fabricante para inspeção e controle de acesso. 

  

Licenciamento 

87. Deve ser fornecido com a versão de software mais completa disponível para o equipamento; 
88. Deve ser fornecido com todas as licenças de software necessárias para o funcionamento 

integral de todas as funcionalidades disponíveis para o equipamento. 

  

Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos equipamentos, 
indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
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documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 09 – SWITCH DE ACESSO L3 COM 24 PORTAS GIGABIT E 4 SFP+ 

  

Características gerais 

1. Deve possuir 24 portas 10/100/1000; 
2. Deve possuir 4 portas 1/10G SFP+; 
3. Deve possuir capacidade de encaminhamento de, no mínimo, 95 Mpps; 
4. Deve possuir capacidade de comutação de, no mínimo, 128 Gbps; 
5. Deve implementar IEEE 802.3az para as portas 10/100/1000; 
6. Deve possuir uma interface de console USB; 
7. Deve suportar empilhamento de no mínimo 4 switches; 
8. Deve suportar agregação de link através de LACP com no mínimo 20 grupos distribuídos 

através da pilha, com cada grupo permitindo até 8 portas; 
9. Deve suportar a agregação de links entre diferentes membros da pilha; 
10. Deve possuir no mínimo 32.000 endereços MAC; 
11. Deve possuir latência máxima de 4μs, considerando pacotes de 64 bytes; 
12. Deve possuir buffers de, no mínimo, 12 MB; 
13. Deve implementar funcionalidade que permita a detecção de links unidirecionais; 
14. Deve implementar funcionalidade que permita a detecção de falhas de uplink; 
15. Deve implementar no mínimo 2000 VLANs simultaneamente; 
16. Deve implementar MVRP (Multiple VLAN Registration Protocol); 
17. Deve implementar LLDP (IEEE 802.1ab); 
18. Deve implementar LLDP-MED; 
19. Deve implementar Q-in-Q (IEEE 802.1ad); 
20. Deve implementar PVST+, RPVST+ ou protocolo compatível; 
21. Deve implementar MSTP (IEEE 802.1s); 
22. Deve implementar túneis VxLAN (VTEP); 

  

Funcionalidades de Camada 3 

23. Deve possuir tabela de roteamento com no mínimo 2.000 rotas IPv4 e 1.000 rotas IPv6; 
24. Deve implementar roteamento estático; 
25. Deve implementar RIP v2, com suporte a autenticação MD5 (RIPv2); 
26. Deve implementar RIPng; 
27. Deve implementar OSPF; 
28. Deve implementar OSPFv3; 
29. Deve implementar Policy-based Routing; 
30. Deve implementar VRRP; 
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31. Deve implementar VRRPv3; 
32. Deve implementar servidor DHCP; 
33. Deve implementar DHCP snooping (IPv4 e IPv6); 
34. Deve implementar DHCP relay (IPv4 e IPv6); 
35. Deve implementar Gateway mDNS, com suporte a Apple Bonjour; 

  

Multicast 

36. Deve implementar PIM-SM; 
37. Deve implementar PIM-DM; 
38. Deve implementar MLD snooping; 
39. Deve implementar IGMP v3; 

  

Software Defined Networking 

40. Deve implementar OpenFlow 1.3 ou superior; 
41. Deve implementar a separação lógica do tráfego sem suporte a OpenFlow do tráfego com 

suporte a OpenFlow através de instâncias. O tráfego OpenFlow não pode influenciar o tráfego 
não openflow no equipamento. 

42. Deve permitir configurar cada instância como modo ativo (pacotes referentes a fluxos que o 
switch não conhece são enviados para a controladora) ou modo passivo (pacotes que não se 
referem a um fluxo na tabela do switch não são enviados para a controladora) 

43. Deve implementar 16 instâncias de OpenFlow; 
44. As instâncias de OpenFlow devem suportar a associação de múltiplas VLANs. 
45. Cada instância OpenFlow configurada no equipamento deve suportar, pelo menos, a 

configuração de 3 controladores SDN. 
46. Deve permitir utilizar intervalo de portas TCP/UDP e flags de TCP como parâmetros nas 

regras de OpenFlow; 
47. Deve suportar no mínimo 16.000 regras openflow; 
48. Deve possuir interface REST API; 
49. Deve suportar configurações via JSON/REST API com, no mínimo, os seguintes métodos: GET, 

POST, PUT e DELETE; 
50. Deve suportar a criação de VLANs e ACLs no equipamento através de REST. 

  

QoS 

51. Deve implementar controle de broadcast; 
52. Deve implementar rate limiting para pacotes ICMP; 
53. Deve implementar rate limiting para tráfego broadcast e multicast; 
54. Deve implementar rate limiting baseado em tráfego classificado por uma ACL; 
55. Deve suportar espelhamento de portas; 
56. Deve suportar espelhamento de tráfego para um switch remoto. 

  

Segurança 
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57. Deve implementar controle de acesso baseado em perfis (Role Based Access Control); 
58. Deve implementar VLANs privadas, de forma que permita o isolamento de tráfego de uma 

porta de acesso das demais portas de acesso de uma mesma VLAN, permitindo acesso 
apenas para as portas de Uplink (porta promíscua); 

59. Deve implementar 802.1x; 
60. Deve implementar autenticação baseada em web; 
61. Deve implementar autenticação baseada em endereço MAC; 
62. Deve permitir a utilização simultânea de autenticação 802.1x e MAC em uma mesma porta; 
63. Deve implementar TACACS+. Não serão aceitas soluções similares; 
64. Deverá suportar o download de políticas ou ACLs a partir de um software de Controle de 

Acesso à Rede (NAC), sem necessidade de pré-configuração das regras no switch, permitindo 
a centralização das políticas; 

65. Deve suportar integração com ferramenta de controle de acesso do mesmo fabricante que 
permita identificar automaticamente o tipo e sistema operacional dos equipamentos que se 
conectam à rede (device profiling) sem a necessidade de agentes instalados nos dispositivos; 

66. Deve suportar integração com ferramenta de controle de acesso do mesmo fabricante que 
permita verificar se a máquina está em conformidade com a política de segurança antes de 
entrar na rede, verificando, no mínimo serviços os serviços e antivírus das máquinas. Deve 
suportar os sistemas operacionais Microsoft Windows, Mac OS e Linux. 

  

Gerenciamento 

67. Deve implementar NTP com autenticação MD5; 
68. Deve implementar Time Domain Reflectometry (TDR) para testes de cabos UTP, permitindo 

identificar falhas e verificar a distância do cabo; 
69. Deve suportar duas imagens de software na flash; 
70. Deve suportar múltiplos arquivos de configuração na flash; 
71. Deve permitir o agendamento de tarefas, permitindo executar um comando em um dia e 

horário específicos; 
72. Deve suportar a autoconfiguração dos switches através de DHCP e software de 

gerenciamento, sem necessidade de nenhuma intervenção no switch (com configuração de 
fábrica); 

73. Deve suportar gerenciamento através de plataforma de nuvem do mesmo fabricante, com 
funcionalidades de gerenciamento de configuração, alertas e notificações e gerenciamento 
de firmware, sem necessidade de instalação de nenhum software ou dispositivo on-site; 

74. Deve suportar IPSec para comunicação com o sistema de gerenciamento; 
75. Deve implementar sFlow (IPv4 e IPv6); 
76. Deve possuir interface web para configuração; 
77. Deve implementar TR-69 (CPE WAN Management Protocol); 
78. Deve suportar diagnóstico de transceivers ópticos; 
79. Deve implementar Syslog sobre TLS; 
80. Deve implementar Secure SFTP (SFTP); 
81. Deve implementar SNMP v1/v2/v3; 
82. Deve implementar funcionalidade que permita monitorar o SLA (Service Level Agreement) de 

conexões IP. Deve suportar os seguintes testes: ICMP Echo, UDP-Echo (em porta 
configurável) e TCP-Connect (em porta configurável) e Jitter UDP para voz; 

83. Deve implementar compatibilidade com o protocolo CDP para provisionamento de telefones 
IP; 

84. Deve implementar o isolamento de um Access Point rogue conectado ao switch, quando este 
for detectado por solução de WLAN do mesmo fabricante; 
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85. Deve implementar a configuração automática de Access Point wireless do mesmo fabricante 
quando conectado ao switch. Devem ser suportados os seguintes parâmetros para a 
configuração automática: VLAN, CoS, largura de banda máxima; 

86. Deve suportar o encaminhamento de tráfego para controladora wireless do mesmo 
fabricante para inspeção e controle de acesso. 

  

 Licenciamento 

87. Deve ser fornecido com a versão de software mais completa disponível para o equipamento; 
88. Deve ser fornecido com todas as licenças de software necessárias para o funcionamento 

integral de todas as funcionalidades disponíveis para o equipamento. 

  

Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos equipamentos, 
indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 
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ITEM 10 – SWITCH DE ACESSO L2 COM 24 PORTAS GIGABIT E 4 SFP 

  

1. Deve possuir 24 portas 10/100/1000; 
2. Deve possuir 4 portas 1G SFP; 
3. Deve possuir capacidade de encaminhamento de, no mínimo, 40 Mpps; 
4. Deve possuir capacidade de comutação de, no mínimo, 56 Gbps; 
5. Deve implementar IEEE 802.3az para as portas 10/100/1000; 
6. Deve possuir uma interface de console USB; 
7. Deve suportar agregação com suporte a até 8 portas por grupo; 
8. Deve possuir 16.000 endereços MAC; 
9. Deve possuir latência máxima de 4 μs para links de 1000Mbps, considerando pacotes de 64 

bytes; 
10. Deve implementar funcionalidade que permita a detecção de links unidirecionais; 
11. Deve implementar virtual stacking permitindo o gerenciamento de, no mínimo, 16 switches 

com mesmo endereço IP; 
12. Deve implementar 512 VLANs simultaneamente; 
13. Deve implementar MVRP (Multiple VLAN Registration Protocol); 
14. Deve implementar LLDP (IEEE 802.1ab); 
15. Deve implementar LLDP-MED; 
16. Deve implementar PVST+, RPVST+ ou protocolo compatível; 
17. Deve implementar MSTP (IEEE 802.1s); 
18. Deve implementar Gateway mDNS, com suporte a Apple Bonjour; 
19. Deve implementar IEEE 802.1p permitindo a classificação de tráfego com até 8 filas de 

prioridade; 
20. Deve permitir a priorização de tráfego por porta e VLAN; 
21. Deve implementar controle de broadcast; 
22. Deve implementar rate limiting para pacotes ICMP; 
23. Deve implementar rate limiting para tráfego broadcast e multicast; 
24. Deve suportar espelhamento de portas; 
25. Deve implementar RADIUS authentication; 
26. Deve implementar RADIUS accounting; 
27. Deve implementar TACACS+; 
28. Deve implementar IEEE 802.1X com, no mínimo, 8 (oito) autenticações por porta; 
29. Deve implementar SSHv2; 
30. Deve implementar SSH para IPv6; 
31. Deve implementar DHCP snooping; 
32. Deve implementar user role localmente permitindo criar políticas de acesso de segurança e 

QoS, por perfil de usuário e dispositivos; 
33. Deve implementar autenticação baseada em web; 
34. Deve implementar NTP com autenticação MD5; 
35. Deve suportar duas imagens de software na flash; 
36. Deve suportar múltiplos arquivos de configuração na flash; 
37. Deve permitir o agendamento de tarefas, permitindo executar um comando ou grupo de 

comandos em um dia e horário específicos; 
38. Deve implementar sFlow (IPv4 e IPv6) ou Netflow; 
39. Deve implementar RMON com os grupos statistics, history, alarms e events; 
40. Deve possuir interface web para configuração; 
41. Deve implementar TR-69 (CPE WAN Management Protocol); 
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42. Deve suportar a auto-configuração dos switches através de DHCP e software de 
gerenciamento, sem necessidade de nenhuma intervenção no switch (com configuração de 
fábrica); 

43. Deve suportar Digital Optical Monitoring (DOM) para transceivers ópticos; 
44. Deve implementar Syslog sobre TLS; 
45. Deve implementar SFTP ou SCP; 
46. Deve implementar SNMP v1/v2/v3 
47. Deve permitir gerar notificação caso seja excedido o limite de MACs; 
48. Deve implementar compatibilidade com o protocolo CDP para provisionamento de telefones 

IP; 
49. Deve implementar o isolamento de um Access Point rogue conectado ao switch, quando este 

for detectado por solução de WLAN do mesmo fabricante; 
50. Deve implementar a configuração automática de Access Point wireless do mesmo fabricante 

quando conectado ao switch. Devem ser suportados os seguintes parâmetros para a 
configuração automática: VLAN, CoS, largura de banda máxima; 

51. Deve ser fornecido com a versão de software mais completa disponível para o equipamento; 
52. Deve ser fornecido com todas as licenças de software necessárias para o funcionamento 

integral de todas as funcionalidades disponíveis para o equipamento; 

  

Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos equipamentos, 
indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 
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6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

   

ITEM 11 – SWITCH DE ACESSO L2 COM 48 PORTAS GIGABIT E 4SFP 

  

1. Deve possuir 48 portas 10/100/1000; 
2. Deve possuir 4 portas 1G SFP; 
3. Deve possuir capacidade de encaminhamento de, no mínimo, 77 Mpps; 
4. Deve possuir capacidade de comutação de, no mínimo, 104 Gbps; 
5. Deve implementar IEEE 802.3az para as portas 10/100/1000; 
6. Deve possuir uma interface de console USB; 
7. Deve suportar agregação com suporte a até 8 portas por grupo; 
8. Deve possuir 16.000 endereços MAC; 
9. Deve possuir latência máxima de 4 μs para links de 1000Mbps, considerando pacotes de 64 

bytes; 
10. Deve implementar funcionalidade que permita a detecção de links unidirecionais; 
11. Deve implementar virtual stacking permitindo o gerenciamento de, no mínimo, 16 switches 

com mesmo endereço IP; 
12. Deve implementar 512 VLANs simultaneamente; 
13. Deve implementar MVRP (Multiple VLAN Registration Protocol); 
14. Deve implementar LLDP (IEEE 802.1ab); 
15. Deve implementar LLDP-MED; 
16. Deve implementar PVST+, RPVST+ ou protocolo compatível; 
17. Deve implementar MSTP (IEEE 802.1s); 
18. Deve implementar Gateway mDNS, com suporte a Apple Bonjour; 
19. Deve implementar IEEE 802.1p permitindo a classificação de tráfego com até 8 filas de 

prioridade; 
20. Deve permitir a priorização de tráfego por porta e VLAN; 
21. Deve implementar controle de broadcast; 
22. Deve implementar rate limiting para pacotes ICMP; 
23. Deve implementar rate limiting para tráfego broadcast e multicast; 
24. Deve suportar espelhamento de portas; 
25. Deve implementar RADIUS authentication; 
26. Deve implementar RADIUS accounting; 
27. Deve implementar TACACS+; 
28. Deve implementar IEEE 802.1X com, no mínimo, 8 (oito) autenticações por porta; 
29. Deve implementar SSHv2; 
30. Deve implementar SSH para IPv6; 
31. Deve implementar DHCP snooping; 
32. Deve implementar user role localmente permitindo criar políticas de acesso de segurança e 

QoS, por perfil de usuário e dispositivos; 
33. Deve implementar autenticação baseada em web; 
34. Deve implementar NTP com autenticação MD5; 
35. Deve suportar duas imagens de software na flash; 
36. Deve suportar múltiplos arquivos de configuração na flash; 
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37. Deve permitir o agendamento de tarefas, permitindo executar um comando ou grupo de 
comandos em um dia e horário específicos; 

38. Deve implementar sFlow (IPv4 e IPv6) ou Netflow; 
39. Deve implementar RMON com os grupos statistics, history, alarms e events; 
40. Deve possuir interface web para configuração; 
41. Deve implementar TR-69 (CPE WAN Management Protocol); 
42. Deve suportar a auto-configuração dos switches através de DHCP e software de 

gerenciamento, sem necessidade de nenhuma intervenção no switch (com configuração de 
fábrica); 

43. Deve suportar Digital Optical Monitoring (DOM) para transceivers ópticos; 
44. Deve implementar Syslog sobre TLS; 
45. Deve implementar SFTP ou SCP; 
46. Deve implementar SNMP v1/v2/v3 
47. Deve permitir gerar notificação caso seja excedido o limite de MACs; 
48. Deve implementar compatibilidade com o protocolo CDP para provisionamento de telefones 

IP; 
49. Deve implementar o isolamento de um Access Point rogue conectado ao switch, quando este 

for detectado por solução de WLAN do mesmo fabricante; 
50. Deve implementar a configuração automática de Access Point wireless do mesmo fabricante 

quando conectado ao switch. Devem ser suportados os seguintes parâmetros para a 
configuração automática: VLAN, CoS, largura de banda máxima; 

51. Deve ser fornecido com a versão de software mais completa disponível para o equipamento; 
52. Deve ser fornecido com todas as licenças de software necessárias para o funcionamento 

integral de todas as funcionalidades disponíveis para o equipamento. 

  

Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos equipamentos, 
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indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 12 – GBIC 10GB PARA ATÉ 300M 

  

Características técnicas mínimas 

1. Deve ser do tipo SFP+ de 10GBASE-SR com conector LC; 
2. Compatibilidade integral com os Itens 5, 6, 8 e 9. 

  

Garantia e Suporte 

3. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

4. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

5. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

  

ITEM 13 – CABO DAC 10GB DE 1M 

  

Características técnicas mínimas 

1. Cabo metálico com conector tipo SFP+ para ligação de duas unidades de switch em 10 Gbps; 
2. Cabo com comprimento mínimo de 1 (um) metro; 
3. Compatibilidade integral com os itens 5, 6, 8 e 9. 

  

Garantia e Suporte 

Minuta de edital (complementada) (0581377)         SEI 0008478-63.2018.6.02.8000 / pg. 655



 
TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS 

SEÇÃO DE LICITAÇÕES E CONTRATOS 

 

56 
 

 

 

4. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

5. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

6. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 14 – CABO DAC 10GB DE 3M 

  

Características técnicas mínimas 

1. Cabo metálico com conector tipo SFP+ para ligação de duas unidades de switch em 10 Gbps; 
2. Cabo com comprimento mínimo de 3 (três) metros; 
3. Compatibilidade integral com os itens 5, 6, 8 e 9. 

  

Garantia e Suporte 

4. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

5. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

6. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 15 – GBIC 1GB PARA ATÉ 500M 

  

Características técnicas mínimas 

1. Deve ser do tipo SFP de 1G BASE-SX com conector LC; 
2. Compatibilidade integral com os Itens 5, 6, 8, 9, 10 e 11. 
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Garantia e Suporte 

3. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

4. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

5. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 16 – SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE TECNOLOGIA PARA SWITCHS DE REDE 

  

Características Gerais 

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das 14:00 às 18:00) 
presencialmente no TRE-AL ou remotamente conforme necessidades da CONTRATANTE; 

  

Implantação 

2. Instalação e configuração de no mínimo 10 (dez) switchs de rede, contemplando: 
3. Configuração básica de acesso a gerencia via rede; 
4. Gerencia e monitoramento em MÓDULO DE GERENCIA DE REDE; 
5. Configuração de autenticação de usuários em MÓDULO DE CONTROLE DE ACESSO; 
6. Configuração de no mínimo 10 (dez) VLANs; 
7. Configuração de stacking de 2 (duas) pilhas com no máximo 4 (quatro) switchs; 
8. Configuração de agregação de links em até 10 (dez) switchs com no máximo 4 (quatro) 

portas por dispositivo. 

  

Transferência de Tecnologia 

9. O treinamento deverá ser no realizado na modalidade workshop com tarefas práticas hands-
on, visando assim a melhor fixação dos temas abordados com foco direto na explicação da 
tecnologia dos produtos ofertados como também nas rotinas de configuração, 
gerenciamento, administração e operação dos mesmos, devendo ter duração mínima de 24 
(vinte e quatro) horas onde serão abordados no mínimo os seguintes tópicos: 

a. Configuração inicial e acesso a gerencia; 
b. Configuração de VLANS; 
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c. Configuração de autenticação de usuários em MÓDULO DE CONTROLE DE ACESSO; 
d. Configuração de empilhamento de switchs; 
e. Configuração de agregação de links; 
f. Configuração de switchs para MÓDULO DE GERENCIA DE REDE; 
g. Configuração de switchs para MÓDULO DE ANÁLISE DE TRÁFEGO. 

  

ITEM 17 - SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE TECNOLOGIA DO MÓDULO DE 
CONTROLE DE ACESSO 

  

Características Gerais 

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das 14:00 às 18:00) 
presencialmente no TRE-AL ou remotamente conforme necessidades da CONTRATANTE; 

  

Implantação 

2. Instalação e configuração de 1 (uma) instância do serviço controle de acesso, contemplando 
configurações básicas para acesso à rede, dimensionamento, configuração de 
armazenamento; 

3. Configuração de autenticação em Active Directory para usuários corporativos; 
4. Configuração de autenticação de visitantes com portal de autosserviço para criação de 

usuários; 
5. Configuração de no mínimo 10 (dez) dispositivos de rede para autenticação na solução. 

  

Transferência de Tecnologia 

6. O treinamento deverá ser no realizado na modalidade workshop com tarefas práticas hands-
on, visando assim a melhor fixação dos temas abordados com foco direto na explicação da 
tecnologia da solução como também nas rotinas de configuração, gerenciamento, 
administração e operação da mesma devendo ter duração mínima de 24 (vinte e quatro) 
horas onde será abordado no mínimo os seguintes tópicos: 

a. Configuração de Active Directory como base de autenticação; 
b. Configuração de autenticação de usuários corporativos; 
c. Configuração de autenticação de usuários visitantes; 
d. Configuração de portal de autosserviço; 
e. Configuração de autenticação e autorização com RADIUS. 

  

ITEM 18 – TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE SWITCHES 

  

Características Gerais 
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1. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do fabricante no 
Treinamento Básico de Administração dos Switches para 01 (um) profissional da contratante; 

2. O voucher deverá ter validade de pelo menos 12 (doze) meses; 
3. O treinamento deverá ser de acordo com o calendário de treinamento do fabricante e 

ministrado em centro oficial de treinamento do mesmo ou remotamente, utilizando 
tecnologia de ensino a distância; 

4. Deverá ser ministrado por profissional devidamente credenciado junto ao fabricante e apto a 
entregar o respectivo; 

5. O treinamento deverá compreender a explicação da tecnologia da solução como também das 
rotinas de configuração, gerenciamento, administração e operação da mesma; 

6. O treinamento deverá ter carga horária mínima de 24 (vinte e quatro) horas, ministrado no 
período de 08:00 às 12:00 e das 14:00 às 18:00. 

  

ITEM 19 – TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE ACESSO 

  

Características Gerais 

1. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do fabricante no 
Treinamento da Solução de Controle de Acesso para 01 (um) profissional da contratante; 

2. O voucher deverá ter validade de pelo menos 12 (doze) meses; 
3. O treinamento deverá ser de acordo com o calendário de treinamento do fabricante e 

ministrado em centro oficial de treinamento do mesmo ou remotamente, utilizando 
tecnologia de ensino a distância; 

4. Deverá ser ministrado por profissional devidamente credenciado junto ao fabricante e apto a 
entregar o respectivo; 

5. O treinamento deverá compreender a explicação da tecnologia da solução como também das 
rotinas de configuração, gerenciamento, administração e operação da mesma; 

6. O treinamento deverá ter carga horária mínima de 40 (Quarenta) horas, ministrado no 
período de 08:00 às 12:00 e das 14:00 às 18:00; 

  

  

LOTE 02 – SOLUÇÃO DE REDE WIRELESS 

 
  

ITEM 20 – SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO PARA SOLUÇÃO DE REDE 
WIRELESS 

LICENCIAMENTO 

1. Licenciamento da SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO, contemplando o 
quantitativo mínimo de 1.000 (um mil) dispositivos, usuários corporativos ou visitantes 
simultâneos, independente do perfil de autenticação, seja por dispositivo ou usuário; 

2. Caso a solução ofertada necessite de licenciamento específico para credenciamento dos 
dispositivos, usuários (corporativos ou visitantes), deverá ser fornecido o quantitativo 
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solicitado para ambos, de forma que a solução realize a análise de perfil e o controle de 
acesso dos 1.000 (um mil) dispositivos ou usuários (corporativos ou visitantes) simultâneos. 

  

MÓDULO DE ANÁLISE DE PERFIL DE DISPOSITIVO 

Características Gerais Modulo de Análise de Perfil de Dispositivo 

3. Deve implementar funcionalidade de classificação automática criando perfis de dispositivos, 
de forma a descobrir, classificar e agrupar os dispositivos conectados na rede; 

4. Deve categorizar os dispositivos em pelo menos 3 níveis: 

d. Por tipo de dispositivo (ex. Computador, Smartdevice, impressora, etc.); 
e. Por sistema operacional (ex. Windows, Linux, MacOS, etc.); 
f. Versão do sistema operacional (ex. Windows 7, Windows 2008 Server, etc.); 

5. Deve ser capaz de gerar gráficos das categorias separando os dispositivos conforme suas 
características; 

6. Deve suportar a coleta de informações, para classificação, usando no mínimo: 

k. DHCP; 
l. HTTP User-Agent; 
m. MAC OUI; 
n. ActiveSync plugin; 
o. SNMP; 
p. Subnet Scanner; 
q. IF-MAP; 
r. Cisco Device Sensor; 
s. MDM; 
t. TCP Fingerprinting. 

7. Deve possuir dicionário de categorias de dispositivos pré-configurado e mecanismo de 
atualização do mesmo; 

8. Deve suportar a integração com, no mínimo, as seguintes soluções de MDM de mercado 
AirWatch, MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, MaaS 360 devendo comprovar 
a compatibilidade em documentação oficial do fabricante; 

9. Deve permitir priorização na ordem de criação dos perfis com no mínimo as seguintes 
características: 

f. Agente proprietário; 
g. HTTP User-Agent; 
h. SNMP; 
i. DHCP; 
j. MAC OUI. 

10. A solução de análise de perfil de usuários deverá permitir consultas a sua base, pela solução 
de controle de acesso para validação de dispositivos com base no seu perfil. 
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MÓDULO DE CONTROLE DE ACESSO DE DISPOSITIVOS E USUÁRIOS 

Características Gerais 

11. A Solução deverá dar suporte a no mínimo as seguintes bases de dados: 

n. Microsoft Active Directory; 
o. Kerberos; 
p. Diretórios LDAP; 
q. OpenLDAP; 
r. PostgreSQL; 
s. Oracle 11g; 
t. MariaDB; 
u. MSSQL; 
v. Servidores de Token; 
w. Base de dados SQL interna; 
x. Lista interna estática de hosts. 

12. Deve suportar "Single Sign-on" (SSO) através de SAML v2.0; 
13. Deve implementar gerenciamento e aplicação de políticas de autorização de acesso de 

usuários com base em: 

f. Atributos do usuário autenticado; 
g. Hora do dia, dia da semana; 
h. Tipo de dispositivo utilizado; 
i. Localização do usuário; 
j. Tipo de autenticação utilizada. 

14. Deve permitir a visualização de todas informações relativas a cada transação e autenticação 
em uma única tela, a solução deverá trazer no mínimo as seguintes informações: 

m. Data e Hora; 
n. Mac Address do dispositivo; 
o. Classificação do dispositivo; 
p. Usuário; 
q. Equipamento que requisitou a autenticação (origem); 
r. Método de autenticação utilizado; 
s. Fonte de autenticação utilizada para validação; 
t. Perfil de acesso aplicado; 
u. Atributos de entrada do protocolo utilizados na requisição (ex. RADIUS); 
v. Informações de resposta da solução para o elemento de rede; 
w. Alertas em caso de falha; 
x. LOGS já filtrados para a requisição em análise. 

15. Deve possuir Dashboard customizável, onde deve permitir a visualização de no mínimo as 
seguintes informações: 

a.  
a. Lista com últimos Alertas do sistema; 
b. Gráfico com todas as requisições de autenticação dos últimos 7 dias, incluindo 

RADIUS, TACACS+ e Autenticações Web; 
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c. Gráfico com o status das autenticações aceitas e rejeitadas nos últimos 7 dias; 
d. Gráfico com a categorização dos dispositivos classificados pela solução, divididos de 

acordo com as categorias de classificação; 
e. Últimas falhas de autenticação; 
f. Gráfico com as requisições de avaliação de postura dos dispositivos, divididos em: 

  
I. Saudáveis (dentro das políticas estabelecidas); 
II. Não saudáveis (que estão fora das políticas estabelecidas); 

a.  
a. Lista com as últimas autenticações; 
b. Lista com as últimas autenticações com sucesso; 
c. Utilização de CPU do sistema, no mínimo nos últimos 30 minutos; 

16. Deve possuir base de regras e categorias de dispositivos pré-configurada e mecanismo de 
atualização da mesma; 

17. Deve suportar a integração com no mínimo as seguintes soluções de MDM de mercado 
AirWatch, MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, MaaS 360 devendo comprovar 
a compatibilidade em documentação oficial do fabricante; 

18. Deve suportar autenticações via OAuth2, Facebook, Twitter, LinkdIn, Office365 e Google 
Apps; 

19. Deve possuir recursos integrados de AAA: RADIUS, TACACS+ e Kerberos; 
20. Deve possuir suporte aos seguintes recursos: 

m. RADIUS; 
n. RADIUS CoA; 
o. TACACS+; 
p. Web authentication; 
q. SAML v2.0; 
r. EAP-FAST (EAP-MSCHAPv2, EAP-GTC, EAP-TLS); 
s. PEAP (EAP-MSCHAPv2, EAP-GTC, EAP-TLS, EAP-PEAP-Public); 
t. TTLS (EAP-MSCHAPv2, EAP-GTC, EAP- TLS, EAP-MD5, PAP, CHAP); 
u. EAP-TLS; 
v. PAP, CHAP, MSCHAPv1, MSCHAPv2, e EAP-MD5; 
w. Windows machine authentication; 
x. MAC address authentication (dispositivos sem suporte a 802.1X); 

21. Deve suportar verificação de vulnerabilidade através de varredura de portas; 
22. Deve suportar à aplicação de políticas em ambiente com múltiplos fornecedores de Wireless, 

cabeado e VPN; 
23. Deve possuir CA integrada, para geração de certificados para os dispositivos que forem se 

autenticar na rede; 
24. Deve suportar à integração com plataforma de terceiros usando HTTP/RESTful API; 
25. Deve permitir que a solução faça consultas em bases SQL, com o objetivo de buscar 

informação a serem utilizadas durante o processo de autenticação dos usuários; 
26. Deve possuir suporte a administração através de IPv6; 
27. Deve possuir ferramenta para gerenciar os processos de credenciamento, autenticação, 

autorização e contabilização de usuários visitantes através de portal web seguro; 
28. Deve implementar a criação de grupos de autorizadores com privilégios distintos de criação 

de credenciais temporárias e atribuição de permissões de acesso aos clientes; 
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29. Deve permitir realizar a autenticação dos autorizadores em base externa do tipo Microsoft 
Active Directory ou LDAP e atribuir o privilégio ao autorizador de acordo com o seu perfil; 

30. Deve implementar as funcionalidades de geração de lotes de credenciais aleatórias, 
temporárias, pré-autorizadas; 

31. Deve implementar a importação e exportação da relação de credenciais temporárias através 
de arquivos txt ou csv; 

32. Deve permitir a configuração do tempo de validade das credenciais, baseando-se na criação 
da conta ou no primeiro login da conta; 

33. Deve permitir que o visitante crie sua própria credencial temporária (autosserviço) através 
de portal web, com ou sem a necessidade de um autorizador; 

34. Deve permitir a customização do formulário de criação de credenciais, a ser preenchido pelo 
autorizador ou pelo visitante em caso de autosserviço, especificando quais informações 
cadastrais dos visitantes são obrigatórias ou opcionais; 

35. Deve permitir a customização do nível de segurança da senha temporária que será gerada 
ao visitante, especificando a quantidade mínima de caracteres e o uso de caracteres 
especiais e números para compor a senha; 

36. Deve exigir que o usuário visitante aceite o “Termo de uso da rede” a cada login ou apenas 
no primeiro login; 

37. Deve permitir o envio das credenciais aos usuários registrados através de mensagens SMS 
(Short Message Service), e-mail ou impressão local. 

  

GARANTIA E SUPORTE 

38. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 

39. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

40. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

41. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

42. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 
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ITEM 21 – SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS 

LICENCIAMENTO 

1. Deverá ser entregue o quantitativo mínimo de licenças para o gerenciamento simultâneo de 
50 (cinquenta) Pontos de acesso; 

CARACTERÍSTICAS GERAIS 

2. A solução de gerenciamento deverá administrar a configuração dos Pontos de acesso de 
forma centralizada; 

3. A solução de gerenciamento deverá possuir integração com o HPE IMC em console única de 
gerenciamento; 

4. A solução de gerenciamento de rede wireless deverá suportar, em arquitetura de 
controladora distribuída, a capacidade de gerenciar no mínimo 120 (cento e vinte) pontos de 
acesso por cluster e no mínimo um total de 20 (vinte) clusters; 

5. A solução de gerenciamento, em arquitetura de controladora física ou virtual, deverá 
suportar no mínimo 2400 pontos de acesso; 

6. Deve ser obrigatoriamente do mesmo fabricante dos pontos de acesso e controladores; 
7. Permitir a configuração e gerenciamento através de browser padrão (http, https); 
8. Permitir que os eventos sejam gravados remotamente utilizando Syslog; 
9. Prover organização hierárquica de equipamentos, permitindo que um equipamento receba as 

configurações lógicas e as replique a outros equipamentos; 
10. Possuir capacidade de projeto automatizado de redes sem fio nos padrões 802.11a, 802.11b 

e 802.11g, 802.11n e 802.11ac, segundo a geografia do prédio (planta); 
11. Considerar a área de cobertura e a banda por usuário desejada; 
12. Possibilitar a importação de plantas baixas nos formatos dwg e jpg; 
13. Permitir a visualização de alertas da rede em tempo real; 
14. Permitir a visualização de eventuais áreas sem cobertura de RF (áreas de sombra); 
15. Monitorar o desempenho da rede wireless, consolidando informações de rede tais como: 

a. Níveis de ruído; 
b. Relação sinal-ruído; 
c. Interferência; 
d. Potência de sinal. 

16. Possuir capacidade de listagem on-line da localização de usuário, endereço IP, endereço 
MAC, nível de potência de recepção e dados de associação e de autenticação 802.1x; 

17. Deve possuir informação visual e gráfica, na planta baixa dos andares, para: 

a. Visualização dos Pontos de acesso instalados, com estado de funcionamento; 
b. Visualização do mapa de calor de RF (Heatmap); 
c. Localização de ativos conectados à rede (equipamentos 802.11); 
d. Localização de Pontos de acesso rogue. 

18. Caso esta funcionalidade não esteja disponível no sistema de gerência, deve ser fornecido 
software, do mesmo fabricante, para atender este item, contemplando todos os dispositivos 
licenciados e com redundância 1+1; 
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19. Possuir capacidade de identificação e listagem dos rádios vizinhos e respectivos SSID/BSSID 
que podem ser percebidos por cada Ponto de acesso; 

20. Possuir capacidade de configuração gráfica completa do controlador WLAN seja ela física, 
virtual ou distribuída e respectivos Pontos de acesso; 

21. Possuir capacidade de geração de relatórios dos seguintes tipos: 

a. Listagem de clientes Wireless; 
b. Listagem de Pontos de acesso; 
c. Informações de Configuração dos Controladores WLAN; 
d. Utilização da rede; 
e. Detalhes dos Pontos de acesso não autorizados (rogues) detectados. 

22. Suportar SSH, HTTP/HTTPS, SSL, Telnet; 
23. Possuir ferramentas de debug e log de eventos para depuração e gerenciamento em 

primeiro nível; 
24. Implementar os padrões abertos de gerência de rede SNMPv2c e SNMPv3, incluindo a 

geração de traps; 
25. Possuir suporte a MIB II, conforme RFC 1213; 
26. Implementar a MIB privativa que forneça informações relativas ao funcionamento do 

equipamento; 
27. Possibilitar a obtenção da configuração do equipamento através do protocolo SNMP; 
28. Possibilitar a obtenção via SNMP de informações de capacidade e desempenho da CPU, 

memória e portas; 
29. Possibilitar a gerência e identificação individualizada de cada Ponto de acesso remoto; 
30. Permitir a administração centralizada dos Pontos de acesso sem a necessidade de configurar 

os mesmos individualmente; 
31. Possibilitar a identificação de paredes e divisórias com respectivos níveis de atenuação por 

tipo (alvenaria, vidro, drywall e divisória); 
32. Possibilitar a importação de plantas baixas nos formatos gráficos (CAD, dwg, jpg, gif e png); 
33. Deve disponibilizar em painel gráfico de controle informações referentes à: 

a. Sistemas operacionais e tipos de dispositivos que estão se conectando a rede; 
b. Informações sobre os tipos de aplicações mais utilizados; 
c. Informações sobre usuários conectados. 

34. Deve possuir informação sobre possíveis ameaças a rede detectadas pelos sistemas 
gerenciados; 

35. Deve possibilitar criação de regras de detecção de ameaças e correlacionar todos os 
dispositivos gerenciados. 

  

 
ITEM 22 – LICENÇAS ADICIONAIS PARA SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS 

Características técnicas mínimas 

1. Licença para expansão da SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS, contemplando 
o quantitativo adicional mínimo de 1 (um) ponto de acesso simultâneo; 
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2. Cada unidade deve ser fornecida com todas as licenças de software necessárias para o 
funcionamento integral de todas as funcionalidades disponíveis para SOLUÇÃO DE 
GERENCIAMENTO DE REDE WIRELESS especificada nesse edital. 

  

GARANTIA E SUPORTE 

1. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

5. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

  

  

ITEM 23 – LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 

Características técnicas mínimas 

3. Licenciamento para expansão da SOLUÇÃO DE ANALISE DE PERFIL E CONTROLE DE ACESSO, 
contemplando o quantitativo mínimo adicional de 500 (quinhentos) dispositivos, usuários 
corporativos ou visitantes simultâneos, independente do perfil de autenticação, seja por 
dispositivo ou usuário; 

  

GARANTIA E SUPORTE 

6. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
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modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 

7. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

8. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

9. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

10. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

 
  

ITEM 24 – CONTROLADORA WLAN 

Características gerais 

1. Solução baseada em hardware ou software específico, do tipo appliance físico ou virtual, do 
mesmo fabricante dos pontos de acesso e software de gerência; 

2. Deve estar licenciado para controle de, no mínimo, 50 (cinquenta) pontos de acesso, 
podendo ser expandido em no mínimo, 250 (duzentos e cinquenta) pontos de acesso através 
de licenciamento adicional; 

3. Permitir a conexão simultânea de, no mínimo, 4.000 clientes wireless; 
4. Permitir a gravação de eventos por meio do protocolo syslog; 
5. Acesso ao sistema através de cliente com browser padrão (http, https, Java); 
6. Permitir operação em modo mesh; 
7. Permitir o uso de múltiplos SSIDs simultaneamente; 
8. Prover tempo de fast-roaming intra-switch inferior a 25 milissegundos; 
9. Prover tempo de fast-roaming inter-switch em camada 2, inferior a 100 milissegundos; 
10. Permitir conexão entre APs sem a necessidade de conexão cabeada, implementando assim 

uma rede padrão mesh; 
11. Deve suportar 802.11e com WMM, U-APSD e T-SPEC; 
12. Gerenciar centralizadamente a autenticação de usuários; 
13. Implementar protocolo de autenticação para controle do acesso administrativo a solução 

com mecanismos de AAA; 
14. Possuir base de dados de usuários interna para autenticação de usuários convidados / 

temporários (acesso guest); 
15. Permitir autenticação em no mínimo os seguintes sistemas de base de dados de usuários 

Microsoft Active Directory, Cisco ACS server, FreeRadius, entre outros; 
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16. Realizar o provisionamento de usuários convidados (guests) através de interface Web por 
meio de um usuário administrativo com permissões mínimas, exclusivas para este fim; 

17. Possuir suporte a autenticação IEEE 802.1X, com pelo menos os seguintes métodos EAP: EAP-
MD5, PEAP/EAP-GTC, PEAP/EAP-MSCHAPv2, EAP-TLS com utilização de base de usuários 
interna ou servidor RADIUS externo; 

18. Suportar as especificações: IEEE 802.1x; 
19. Deverá suportar os seguintes métodos EAP-PEAP, EAP-TLS e EAP-TTLS; 
20. Possuir suporte a autenticação IEEE 802.1X, com o método PEAP/EAP-GTC, e com utilização 

de base de usuários LDAP externa; 
21. Permitir a seleção/uso de servidor Radius ou LDAP com base no SSID; 
22. Suportar a autenticação de usuários conectados à rede cabeada através das portas do 

controlador; 
23. Possuir o recurso de EAP Offload para terminação do túnel EAP no próprio controlador; 
24. Deve suportar utilização de Portal Captivo externo ao controlador; 
25. Permitir a autenticação (através de endereço MAC, Portal Captivo ou IEEE 802.1X) de 

usuários conectados à rede WLAN (wireless) ou usuários conectados às portas cabeadas do 
controlador. Também deverá permitir a autenticação de usuário e de máquina por meio de 
IEEE 802.1x; 

26. Oferecer recurso de Portal Captivo (Captive Portal) com suporte a múltiplos portais 
simultaneamente; 

27. Implementar associação dinâmica de usuário a VLAN, com base nos parâmetros da etapa de 
autenticação; 

28. Implementar Qualidade de Serviço com a marcação de pacotes utilizando Diffserv e suporte 
a 802.1p para QoS de rede; 

29. Possibilitar roaming com integridade de sessão, dando suporte a aplicações em tempo real, 
tais como, VoIP, VoWLAN, videoconferência, dentre outras; 

30. Permitir portais captivos externos a controladora; 
31. A controladora deve possuir funcionalidade de conexão Site to Site VPN utilizando padrão 

Ipsec. Caso a solução fornecida não possua a funcionalidade, será aceita solução de VPN 
adicional integrada; 

32. Deve permitir o tunelamento do trafego de dados de usuários mesmo em redes L3, não 
sendo necessário estender VLANs até o Ponto de Acesso, inclusive em MANs e WANs; 

33. Implementar segurança IEEE 802.11i; 
34. Suportar a criptografia centralizada com os seguintes protocolos: AES-CCMP, TKIP e WEP; 
35. Suportar, no mínimo, 2000 VLANs; 
36. Implementar o protocolo 802.1w (Rapid Spanning Tree); 
37. Oferecer suporte a roteamento e switching de camadas L2 e L3; 
38. Possuir o recurso de criação de Pools de VLAN para permitir a escalabilidade de redes; 
39. Possuir servidor DHCP embutido; 
40. Suportar o protocolo VRRP para redundância de controladores; 
41. Deve suportar redundância de controladores nos modos: 

a. 1+1; 
b. N+1; 
c. Ativo-Ativo; 
d. Ativo-Standby; 

42. Oferecer os recursos de mobilidade entre VLANs para roaming de camada 2; 
43. Oferecer os recursos de Proxy de endereços IP e Proxy DHCP para roaming entre redes (L3) 
44. Deve implementar northbound APIs para realização de integrações com aplicações de 

terceiros para fins de monitoramento e visibilidade. Caso seja necessário, deve ser ofertado 
licenças para ativação desse recurso; 

45. Implementar tagging de VLANs através do protocolo 802.1Q; 
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46. Implementar o protocolo 802.1d para Spanning Tree (STP); 
47. O controlador WLAN poderá estar diretamente e/ou remotamente conectado aos APs por ele 

gerenciados, inclusive via roteamento nível 3 da camada OSI 
48. Se um controlador WLAN ou AP controlador falhar, os APs relacionados deverão se associar a 

um controlador WLAN alternativo de forma automática, não permitindo que a rede wireless 
se torne inoperante; 

49. Realizar a descoberta automática dos APs na infraestrutura wireless; 
50. Permitir o controle dos APs mediante a conexão através de topologia MESH (WiFi Mesh); 
51. A rede MESH deverá oferecer comportamento determinístico da topologia da rede MESH; 
52. A rede MESH deverá prover auto-redundância das camadas física (RF) e Layer 2 com 

comportamento determinístico; 
53. Permitir a conexão de APs de maneira remota e segura; 
54. Conectar APs através de redes públicas e/ou privadas com garantia de segurança através de 

conexão criptografada; 
55. Permitir a propagação de SSIDs de maneira segura para qualquer AP legitimamente 

cadastrado na controladora, independentemente de onde este AP esteja conectado; 
56. Permitir a autenticação do AP remoto através de certificado digital ou de usuário e senha 

cadastrados em servidor AD e Radius; 
57. Gerenciar o tráfego dos APs centralizadamente; 
58. Administrar a configuração dos AP’s; 
59. Deve permitir administrar centralizadamente todos os aspectos de segurança da rede WLAN 

através de firewall integrado à solução de rede sem fio, caso a solução ofertada não possua 
solução de firewall nativa na controladora WLAN deverá ser ofertado firewall externo com 
capacidade para atender toda a solução; 

60. Permitir o bloqueio de comunicação entre clientes wireless – L2 bridging; 
61. Implementar filtros baseados em protocolos e em endereços MAC; 
62. Implementar padrão IEEE 802.11h; 
63. Realizar o controle de autorização baseado em perfis de acesso; 
64. Permitir que seja configurado um perfil de acesso, com regras aplicadas de firewall, para o 

qual será direcionado o usuário após sua autenticação; 
65. Possuir o recurso de “blacklisting” contra ataques ao Firewall e à rede wireless, evitando que 

um determinado cliente se associe à rede wireless caso viole políticas definidas de Firewall 
ou execute algum ataque à rede WLAN de endereços MAC de APs do sistema; 

66. O Firewall deverá implementar os recursos de NAT (Network Address Translation) tanto para 
destino quanto para origem; 

67. Implementar listas de controle de acesso (ACLs); 
68. Oferecer detecção e proteção integrada de ataques de negação de serviços TCP, ICMP; 
69. Permitir o espelhamento de sessão e logs detalhados por pacote a fim de possibilitar análises 

forenses; 
70. Permitir a aplicação de políticas de camada 4, de acordo com as características do usuário. 

Por exemplo, um usuário que pertença ao grupo de gerentes (cadastrado no Radius ou Active 
Directory) terá permissão de acesso ao protocolo FTP no servidor de ERP; 

71. Permitir derivação de políticas de acesso. Por exemplo, um usuário pode pertencer a um 
grupo ao qual foram atribuídas políticas de acesso em camada 4, porém, caso esteja 
utilizando um dispositivo de voz, o tráfego SIP passará a ter prioridade através de aplicação 
de QoS; 

72. Permitir a criação de políticas com base em horários e na localização do usuário. Por 
exemplo: bloquear o tráfego do protocol FTP após às 18 horas. 

73. O Firewall deverá ser integrado à rede WLAN de modo a permitir a desassociação de usuários 
da rede sem fio WLAN com base na violação de políticas de tráfego. Por exemplo: 

Minuta de edital (complementada) (0581377)         SEI 0008478-63.2018.6.02.8000 / pg. 669



 
TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS 

SEÇÃO DE LICITAÇÕES E CONTRATOS 

 

70 
 

 

 

desassociar da rede WLAN e colocar em quarentena o Notebook com endereço MAC 
XX:XX:XX se o usuário tentar fazer um telnet para o servidor ABC; 

74. Otimizar o desempenho e a cobertura da radiofrequência; 
75. Ajustar automaticamente os canais de modo a otimizar a cobertura de rede e mudar as 

condições de RF baseado em performance; 
76. Detectar interferência e ajustar parâmetros de RF, evitando problemas de cobertura e 

controle da propagação indesejada de RF; 
77. Implementar varredura de RF contínua, programada ou sob demanda, com identificação de 

APs ou clientes irregulares; 
78. Deve implementar a tecnologia de “Channel load balancing”, permitindo que clientes sejam 

automaticamente distribuídos entre Pontos de Acesso adjacentes operando em canais 
distintos, com o objetivo de balancear a carga entre os Pontos de Acesso; 

79. Deve implementar a tecnologia de “Band Steering/Select”, permitindo que clientes com 
suporte a faixa de frequência de 5GHz se conectem aos Pontos de Acesso utilizando, 
preferencialmente, a faixa de 5GHz; 

80. Implementar varredura de RF nas bandas 802.11a, 802.11b, 802.11g, 802.1n e 802.11ac 
para identificação de ataques e APs intrusos não autorizados (rogues); 

81. Realizar a varredura no canal de operação do AP sem impacto na performance da rede 
WLAN; 

82. Permitir a varredura em todos os canais possíveis de RF para detecção e contenção de 
ameaças na rede WLAN; 

83. Deve fazer a varredura dos espectros de 2,4 GHz e 5 GHz para localização e classificação de 
interferências não 802.11, analise de espectro, e evita-las automaticamente; 

84. O controlador deve possuir funcionalidade de analisador gráfico de espectro para detecção 
de interferências nas faixas de frequência de 2.4 e 5 GHz, sejam elas IEEE 802.11 ou não. 
Deve disponibilizar interface gráfica com, pelo menos, gráficos de Fast Fourier Transform 
(FFT) e espectrograma; Caso a funcionalidade não possa ser apresentada pelo controlador, 
deve ser fornecido um equipamento ou software, do mesmo fabricante, que o faça; 

85. Utilizar os APs como ”sensores” de RF para fazer a monitoração do ambiente Wireless; 
86. Classificar automaticamente APs válidos, os que interferem e os não autorizados (rogues); 
87. Implementar mecanismos para detecção e contenção de APs não autorizados (rogues); 
88. Realizar a contenção automática dos APs Rogue, simultaneamente, através da rede WLAN 

e/ou da rede cabeada; 
89. Realizar a identificação e contenção de redes “ad-hoc”; 
90. Detectar e bloquear o bridging entre estações da rede WLAN; 
91. Oferecer proteção contra ataques Denial Of Service (DOS) a APs e estações 
92. Detectar e alertar os seguintes tipos de ataques na rede WLAN: 

a. Impersonalização de AP válido; 
b. Floods de Frames; 
c. Fake Ap, Airjack; 
d. Broadcasts de de-autenticação; 
e. Ataques baseados em probes; 

93. Possuir capacidade de gerar alarmes e executar contra-ataques se um ataque for detectado; 
94. Detectar áreas de sombra de cobertura e efetuar os devidos ajustes para sua correção, 

automaticamente; 
95. Ajustar, dinamicamente, o nível de potência e canal de rádio dos APs, de modo a otimizar o 

tamanho da célula de RF, garantindo a performance e escalabilidade; 
96. Permitir o controle de banda disponível (bandwith contracts) por usuário ou através de perfis 

de usuários; 
97. Possibilitar roaming com integridade de sessão, dando suporte a aplicações em tempo real, 

tais como, VoIP, VoWLAN, videoconferência, dentre outras; 
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98. Deve possuir mecanismo de controle de admissão de chamadas nos pontos de acesso (CAC); 
99. Possuir mecanismo automático de QoS para protocolos de voz (SIP, SVP e SCCP) utilizando 

inspeção automática de pacotes, sem a necessidade de fazer a marcação prévia (tagging) de 
pacotes; 

100. Deve possuir solução de identificação de aplicações através de técnicas de análise de 
tráfego, provendo informações das aplicações mais utilizadas na interface gráfica; 

101. Permitir a criação de políticas de acesso baseadas nas aplicações, como por exemplo, 
o acesso a “redes sociais” terá um controle de banda de 2Mpbs. 

102. Apresentar informações gráficas referente a utilização de soluções de comunicações 
unificadas (UC) sobre a infraestrutura WLAN, de formar a apresentar informações referentes 
as chamadas realizadas e relações gráficas entre o nível de sinal recebido pelo usuário e a 
qualidade da chamada. 

103. Possuir a funcionalidade da utilização do protocolo Bonjour na infraestrutura, 
permitindo que os serviços divulgados via mDNS sejam controlados, filtrados e 
disponibilizados entre diferentes subnets, tornando assim possível a utilização em redes com 
múltiplas subnets e um número grande de dispositivos. 

104. Cada unidade deve ser fornecida com todas as licenças de software necessárias para o 
funcionamento integral de todas as funcionalidades disponíveis. 

Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos equipamentos, 
indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
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permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

 
  

ITEM 25 – LICENÇAS ADICIONAIS PARA CONTROLADORA WLAN 

Características técnicas mínimas 

3. Licença para expansão da CONTROLADORA WLAN, contemplando o quantitativo adicional 
mínimo de 1 (um) ponto de acesso simultâneo; 

4. Deve ser compatível com controladora WLAN especificada nesse edital; 
5. Cada unidade deve ser fornecida com todas as licenças de software necessárias para o 

funcionamento integral de todas as funcionalidades disponíveis para CONTROLADORA 
WLANespecificada nesse edital. 

  

GARANTIA E SUPORTE 

6. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 

7. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

8. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

9. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

10. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

 
  

ITEM 26 – PONTO DE ACESSO INTERNO TIPO 01 

Características gerais 
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1. Equipamento de Ponto de Acesso para rede local sem fio, configurável via software, com 
funcionamento simultâneo nos padrões IEEE 802.11a/n/ac, 5GHz, e IEEE 802.11b/g/n, 
2.4GHz; 

2. Todos os Pontos de acesso sem fio deverão ser novos e sem nenhum histórico de utilização; 
3. Os pontos de acesso deverão possuir certificado emitido pelo “WIFI Alliance” comprovando 

no mínimo os seguintes padrões, protocolos e funcionalidades: 

a. IEEE 802.11a; 
b. IEEE 802.11b; 
c. IEEE 802.11g; 
d. IEEE 802.11n; 
e. IEEE 802.11d; 
f. IEEE 802.11ac; 
g. WPA® Enterprise/Personal; 
h. WPA2® Enterprise/Personal; 
i. EAP-TLS; 
j. EAP-TTLS/MSCHAPv2; 
k. PEAPv0/EAP-MSCHAPv2; 
l. PEAPv1/EAP-GTC; 
m. EAP-SIM; 
n. EAP-FAST; 
o. WMM® e WMM® Power Save; 
p. Beamforming; 
q. Short Guard Interval (SGI); 
r. Packet Aggregation (A-MPDU); 
s. Opportunistic Key Caching (OKC) 

4. Deve operar simultaneamente em 2.4GHz e 5GHz (concurrent dual-band); 

  

Performance 

5. Deve suportar rádio dual, 5 GHz 802.11ac 2x2 MIMO e 2.4GHz 802.11n 2x2 MIMO 
6. Deve suportar capacidade de 1300 Mbps de throughput ou superior; 
7. Deve possuir rádio duplo configurável pelo software suportando 5 GHz e 2,4 GHz; 
8. Deve possuir no mínimo dois spatial stream Single User (SU) MIMO para taxa de dados sem 

fio de até 867 Mbps para dispositivos cliente individuais (VHT80) 2x2 em 5GHz; 
9. Deve possuir no mínimo dois spatial stream Single User (SU) MIMO para uma taxa de dados 

sem fio de até 400 Mbps para dispositivos clientes compatíveis (2x2 VHT40) em 5GHz; 
10. Deve possuir suporte para até 255 dispositivos cliente associados por rádio e até 16 BSSIDs 

por rádio; 
11. Deve suportar no mínimo as bandas de frequência: 

a. 2,400 a 2,4835 GHz 
b. 5.150 a 5.250 GHz 
c. 5,25 a 5,350 GHz 
d. 5,470 a 5,725 GHz 
e. 5,725 a 5,850 GHz 
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12. Deve possuir suporte a seleção de frequência dinâmica (DFS) otimizando o uso do espectro 
de RF disponível; 

13. Deve suportar, no mínimo, as seguintes tecnologias de rádio: 

a. 802.11b: espectro espalhável de sequência direta (DSSS) 
b. 802.11a/g/n/ac: multiplexação por divisão de frequência ortogonal (OFDM) 

14. Deve suportar, no mínimo, os seguintes tipos de modulação: 

a. 802.11b: BPSK, QPSK, CCK 
b. 802.11a/g/n/ac: BPSK, QPSK, 16-QAM, 64-QAM, 256-QAM 

15. Deve possuir potência de transmissão configurável em incrementos entre 0,5 e 1,0 dBm. 
16. Deve respeitar os limites de potência de transmissão máxima (conduzida): 

a. Faixa de 2,4 GHz: +18 dBm por corrente, agregado de +21 dBm (2x2) 
b. Banda de 5 GHz: +18 dBm por corrente, agregado de +21 dBm (2x2) 

17. Deve suportar Advanced Cellular Coexistence (ACC) minimizando a interferência das redes 
celulares; 

18. Deve suportar Maximum ratio combining (MRC) para melhorar o desempenho do receptor; 
19. Deve suportar Cyclic delay/shift diversity (CDD/CSD) para melhorar o desempenho RF de 

downlink; 
20. Deve suportar Short guard interval para canais de 20MHz, 40MHz e 80MHz; 
21. Deve suportar Space-time block coding (STBC) para aumentar o alcance e melhorar a 

recepção; 
22. Deve suportar Verificação de paridade de baixa densidade (LDPC) para correção de erros de 

alta eficiência e aumento da taxa de transferência; 
23. Deve suportar Transmit beam-forming (TxBF); 
24. Deve possuir, no mínimo, as seguintes taxas de dados suportadas (Mbps): 

a. 802.11b: 1, 2, 5.5, 11 
b. 802, 11a / g: 6, 9, 12, 18, 24, 36, 48, 54 
c. 802.11n (2.4GHz): 6.5 a 300 (MCS0 a MCS15) 
d. 802.11ac: 6.5 a 867 (MCS0 a MCS9, NSS = 1 a 2 for VHT20/40/80 

25. Deve possuir suporte a 802.11n de alto rendimento (HT): HT 20/40 
26. Deve possuir suporte a 802.11ac de alta velocidade (VHT): VHT 20/40/80 
27. Deve possuir suporte a agregação de pacotes 802.11n/ac: A-MPDU, A-MSDU 

  

    Gerenciamento 

28. Deve implementar funcionamento de modo auto gerenciado, sem necessidade de 
controladora WLAN para configuração de seus parâmetros de rede wireless, gerenciamento 
das políticas de segurança, QoS e monitoramento de RF. 

29. Deve obedecer à todas as características descritas mesmo neste modo de funcionamento; 
30. No modo de funcionamento auto gerenciado deve disponibilizar na interface gráfica 

informações de usuários conectados, qualidade de sinal e trafego de dados na rede; 
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31. O ponto de acesso deve permitir a conversão de modo auto gerenciado para modo 
gerenciado por controlador WLAN através de interface gráfica, em browser padrão (HTTPS), e 
permitir que todos os demais pontos de acesso pertencentes ao mesmo cluster, também 
sejam convertidos automaticamente; 

32. O ponto de acesso deverá suportar conexão direta ou remota com controlador WLAN, 
inclusive via roteamento da camada de rede, baseado no modelo OSI; 

33. Se um controlador WLAN falhar, os Pontos de Acesso relacionados deverão se associar 
automaticamente a um controlador WLAN alternativo, não permitindo que a rede wireless se 
torne inoperante; 

34. Implementar mecanismo de funcionamento para trabalhar com controladores WLAN em 
redundância; 

35. Deve permitir que o ponto de acesso seja atualizado de forma centralizada pela interface 
gráfica; 

36. Permitir o armazenamento de sua configuração em memória não volátil, podendo, numa 
queda e posterior restabelecimento da alimentação, voltar à operação normalmente na 
mesma configuração anterior; 

37. Deve possuir servidor DHCP interno configurável; 
38. Possibilitar backup e restore da configuração através da interface gráfica; 
39. Deve possuir Portal Captivo (Captive Portal) integrado para utilização em rede de visitantes; 
40. Deve possuir mecanismos para proteção contra Pontos de Acesso não autorizados (Rogues); 
41. Possuir capacidade de identificação e listagem dos rádios vizinhos e respectivos SSID/BSSID; 
42. Implementar associação dinâmica de usuários à VLANs com base nos parâmetros da etapa 

de autenticação; 
43. Deve possuir uma base de usuários interna que diferencie usuários visitantes de 

funcionários, para ser usada em autenticação 802.1x ou portal captivo; 
44. Permitir a autenticação para acesso dos usuários conectados nas redes WLAN (Wireless) 

através: 

a. MAC Address 
b. 802.1x em base Local 
c. Captive Portal 
d. 802.1x em base externa RADIUS 
e. 802.1x em base externa LDAP 

45. Deve permitir a seleção/uso de servidor de autenticação específico com base no SSID; 
46. Implementar o protocolo de enlace CSMA/CA para acesso ao meio de transmissão; 
47. Possuir capacidade de selecionar automaticamente o canal de transmissão; 
48. Permitir o ajuste dinâmico de nível de potência e canal de rádio de modo a otimizar o 

tamanho da célula de RF; 
49. Permitir habilitar e desabilitar a divulgação do SSID; 
50. Implementar diferentes tipos de combinações encriptação/autenticação por SSID; 
51. Implementar padrão WMM da Wi-Fi Alliance para priorização de tráfego, suportando 

aplicações em tempo real, tais como, VoIP, vídeo, dentre outras; 
52. Não deve haver no licenciamento restrições com relação ao número de dispositivos 

conectados por ponto de acesso; 
53. Implementar a pilha de protocolos TCP/IP com suporte a IPV4 e IPV6 (Bridging); 
54. Implementar VLANs conforme padrão IEEE 802.1Q; 
55. Possuir, no mínimo, uma interface IEEE 802.3 10/100/1000BaseT Ethernet, auto- sensing, 

auto MDI/MDX; 
56. Permitir a atualização remota do sistema operacional e arquivos de configuração através da 

controladora WLAN 
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57. Implementar cliente DHCP, para configuração automática de rede; 
58. Deve configurar-se automaticamente ao ser conectado na rede; 
59. Possuir LED’s indicativos do estado de operação, da atividade do rádio e da interface 

Ethernet; 
60. Possuir estrutura que permita fixação do equipamento em teto e parede e fornecer 

acessórios para que possa ser feita a fixação; 
61. Deve ser acompanhado de todos os acessórios necessários para operacionalização do 

equipamento, tais como: softwares, cabos de console, cabos de energia elétrica, 
documentação técnica e manuais (podendo ser em CD-ROM) que contenham informações 
suficientes para possibilitar a instalação, configuração e operacionalização do equipamento; 

62. Permitir o bloqueio da configuração do Ponto de Acesso via rede wireless; 
63. Implementar varredura de RF nas bandas 802.11a, 802.11b, 802.11g, 802.11n, para 

identificação de Pontos de Acesso intrusos não autorizados (rogues) e interferências no canal 
habilitado ao ponto de acesso e nos demais canais configurados na rede WLAN, sem impacto 
no seu desempenho; 

64. Implementar IEEE 802.1x, com pelo menos os seguintes métodos EAP: 

a. EAP-FAST 
b. EAP-TLS 
c. PEAP-GTC 
d. PEAP-MSCHAPv2 

65. Permitir a integração com RADIUS Server com suporte aos métodos EAP citados; 
66. A comunicação entre todos os pontos de acesso sem fio e a controladora deverá ser 

criptografada; 
67. Suportar a autenticação com geração dinâmica de chaves criptográficas por sessão e por 

usuário; 
68. Implementar WPA com algoritmo de criptografia TKIP e MIC; 
69. Implementar WPA2 com algoritmo de criptografia AES, 128/256 bits, IEEE 802.11i; 
70. Deve possuir modo dedicado de funcionamento de análise de espectro das faixas de 

frequência de 2.4 e 5 GHz identificando fontes de interferência nessas faixas; 
71. Deve possibilitar analise de espectro nos canais em que estiver provendo acesso, sem 

desconectar os usuários; 
72. Deve disponibilizar informações gráficas de análise de espectro em conjunto com o 

controlador WLAN; 
73. O equipamento deverá possuir registro na ANATEL e deverá ser apresentado na entrega do 

equipamento; 
74. Deverá prover priorização de trafego de vídeo e voz através de parâmetros de QoS (Quality 

os Service) com possibilidade de aplicar por SSID e dispositivo; 
75. Possibilitar roaming na rede wireless; 
76. Suportar a criação de uma rede de convidados autocontida com isolamento de tráfego entre 

clientes e serviços locais; 
77. Possuir recursos de seleção automática de canal de transmissão procurando por canais onde 

haja menor interferência, tendo por objetivo melhorar a performance da rede wireless; 
78. Permitir a operação em estrutura Mesh viabilizando a comunicação direta entre diferentes 

Pontos de Acesso sem Fio onde não seja possível estender a rede cabeada; 
79. Operando em estrutura Mesh, a comunicação entre os dispositivos estrutura deverão operar 

na frequência de 5Ghz. 
80. Possuir mecanismo para a restauração das configurações originais de fábrica fisicamente no 

equipamento (reset); 
81. Suportar operação em humidade de 5% a 95% sem condensação; 
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82. Suportar operação em temperatura de até 40°C (quarenta graus centígrados); 
83. Possuir um MTBF (Mean Time Between Failure - Período Médio entre Falhas) de, no mínimo, 

250.000 horas. 

  

Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos equipamentos, 
indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 27 – PONTO DE ACESSO INTERNO TIPO 02 

Características gerais 

1. Equipamento de Ponto de Acesso para rede local sem fio, configurável via software, com 
funcionamento simultâneo nos padrões IEEE 802.11a/n/ac, 5GHz, e IEEE 802.11b/g/n, 
2.4GHz; 

2. Todos os Pontos de acesso sem fio deverão ser novos e sem nenhum histórico de utilização; 
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3. Os pontos de acesso deverão possuir certificado emitido pelo “WIFI Alliance” comprovando 
no mínimo os seguintes padrões, protocolos e funcionalidades: 

a. IEEE 802.11a; 
b. IEEE 802.11b; 
c. IEEE 802.11g; 
d. IEEE 802.11n; 
e. IEEE 802.11d; 
f. IEEE 802.11ac; 
g. WPA® Enterprise/Personal; 
h. WPA2® Enterprise/Personal; 
i. EAP-TLS; 
j. EAP-TTLS/MSCHAPv2; 
k. PEAPv0/EAP-MSCHAPv2; 
l. PEAPv1/EAP-GTC; 
m. EAP-SIM; 
n. EAP-FAST; 
o. WMM® e WMM® Power Save; 
p. Beamforming; 
q. Short Guard Interval (SGI); 
r. Packet Aggregation (A-MPDU); 
s. Opportunistic Key Caching (OKC) 

4. Deve operar simultaneamente em 2.4GHz e 5GHz (concurrent dual-band); 

  

Performance 

5. Deve suportar rádio dual, 5 GHz 802.11ac 4x4 MIMO e 2.4 GHz 802.11n 2x2 MIMO; 
6. Deve possuir rádio duplo configurável pelo software, suportando 5 GHz e 2,4 GHz; 
7. Deve possuir quatro spatial stream Single User (SU) MIMO para taxa de dados sem fio de até 

1,733 Mbps, em 5GHz; 
8. Deve possuir três spatial stream Multi User (MU) MIMO para uma taxa de dados sem fio de 

até 1,300 Mbps para dispositivos clientes compatíveis, em 5GHz; 
9. Deve possuir suporte para até 255 dispositivos cliente associados por rádio e até 16 BSSIDs 

por rádio; 
10. Deve suportar no mínimo as bandas de frequência: 

a. 2,400 a 2,4835 GHz 
b. 5.150 a 5.250 GHz 
c. 5.250 a 5.350 GHz 
d. 5,470 a 5,725 GHz 
e. 5,725 a 5,850 GHz 

11. Deve possuir suporte a seleção de frequência dinâmica (DFS) otimizando o uso do espectro 
de RF disponível; 

12. Deve suportar, no mínimo, as seguintes tecnologias de rádio: 

a. 802.11b: espectro espalhável de sequência direta (DSSS); 
b. 802.11a / g / n / ac: multiplexação por divisão de frequência ortogonal (OFDM); 
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13. Deve suportar, no mínimo, os seguintes tipos de modulação: 

a. 802.11b: BPSK, QPSK, CCK; 
b. 802.11a / g / n / ac: BPSK, QPSK, 16-QAM, 64-QAM, 256-QAM; 

14. Deve possuir potência de transmissão configurável em incrementos de 0,5 dBm; 
15. Deve respeitar os limites de potência de transmissão máxima (conduzida): 

a. Faixa de 2,4 GHz: +18 dBm por corrente, agregado de +24 dBm (3x3); 
b. Faixa de 5 GHz: +18 dBm por corrente, agregado de +24 dBm (4x4); 

16. Deve suportar Advanced Cellular Coexistence (ACC) minimizando a interferência das redes 
celulares; 

17. Deve suportar Maximum Ratio Combining (MRC) para melhorar o desempenho do receptor; 
18. Deve suportar Cyclic delay/shift diversity (CDD/CSD) para melhorar o desempenho RF de 

downlink; 
19. Deve suportar Short guard interval para canais de 20-MHz, 40-MHz e 80-MHz; 
20. Deve suportar Space-time block coding (STBC) para aumentar o alcance e melhorar a 

recepção; 
21. Deve suportar verificação de paridade de baixa densidade (LDPC) para correção de erros de 

alta eficiência e aumento da taxa de transferência; 
22. Deve suportar Transmit beam-forming (TxBF); 
23. Deve possuir, no mínimo, as seguintes taxas de dados suportadas (Mbps): 

a. 802.11b: 1, 2, 5.5, 11 
b. 802.11a/g: 6, 9, 12, 18, 24, 36, 48, 54 
c. 802.11n: 6.5 até 450 (MCS0 até MCS23) 
d. 802.11ac: 6.5 até 1,733 (MCS0 até MCS9, NSS = 1 até 4) 

24. Deve possuir suporte a 802.11n de alto rendimento (HT): HT 20/40; 
25. Deve possuir suporte a 802.11ac de alta velocidade (VHT): VHT 20/40/80; 
26. Deve possuir suporte a agregação de pacotes 802.11n/ac: A-MPDU, A-MSDU; 

  

   Gerenciamento 

27. Deve implementar funcionamento de modo auto gerenciado, sem necessidade de 
controladora WLAN para configuração de seus parâmetros de rede wireless, gerenciamento 
das políticas de segurança, QoS e monitoramento de RF. 

28. Deve obedecer a todas as características descritas mesmo neste modo de funcionamento; 
29. No modo de funcionamento autogerenciado deve disponibilizar na interface gráfica 

informações de usuários conectados, qualidade de sinal e trafego de dados na rede; 
30. O ponto de acesso deve permitir a conversão de modo auto gerenciado para modo 

gerenciado por controlador WLAN através de interface gráfica, em browser padrão (HTTPS), e 
permitir que todos os demais pontos de acesso pertencentes ao mesmo cluster, também 
sejam convertidos automaticamente; 

31. O ponto de acesso deverá suportar conexão direta ou remota com controlador WLAN, 
inclusive via roteamento da camada de rede, baseado no modelo OSI; 
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32. Se um controlador WLAN falhar, os Pontos de Acesso relacionados deverão se associar 
automaticamente a um controlador WLAN alternativo, não permitindo que a rede wireless se 
torne inoperante; 

33. Implementar mecanismo de funcionamento para trabalhar com controladores WLAN em 
redundância; 

34. Deve permitir que o ponto de acesso seja atualizado de forma centralizada pela interface 
gráfica; 

35. Permitir o armazenamento de sua configuração em memória não volátil, podendo, numa 
queda e posterior restabelecimento da alimentação, voltar à operação normalmente na 
mesma configuração anterior; 

36. Deve possuir servidor DHCP interno configurável; 
37. Possibilitar backup e restore da configuração através da interface gráfica; 
38. Deve possuir Portal Captivo (Captive Portal) integrado para utilização em rede de visitantes; 
39. Deve possuir mecanismos para proteção contra Pontos de Acesso não autorizados (Rogues); 
40. Possuir capacidade de identificação e listagem dos rádios vizinhos e respectivos SSID/BSSID; 
41. Implementar associação dinâmica de usuários à VLANs com base nos parâmetros da etapa 

de autenticação; 
42. Deve possuir uma base de usuários interna que diferencie usuários visitantes de 

funcionários, para ser usada em autenticação 802.1x ou portal captivo; 
43. Permitir a autenticação para acesso dos usuários conectados nas redes WLAN (Wireless) 

através: 

a. MAC Address 
b. 802.1x em base Local 
c. Captive Portal 
d. 802.1x em base externa RADIUS 
e. 802.1x em base externa LDAP 

44. Deve permitir a seleção/uso de servidor de autenticação específico com base no SSID; 
45. Implementar o protocolo de enlace CSMA/CA para acesso ao meio de transmissão; 
46. Possuir capacidade de selecionar automaticamente o canal de transmissão; 
47. Permitir o ajuste dinâmico de nível de potência e canal de rádio de modo a otimizar o 

tamanho da célula de RF; 
48. Permitir habilitar e desabilitar a divulgação do SSID; 
49. Implementar diferentes tipos de combinações encriptação/autenticação por SSID; 
50. Implementar padrão WMM da Wi-Fi Alliance para priorização de tráfego, suportando 

aplicações em tempo real, tais como, VoIP, vídeo, dentre outras; 
51. Não deve haver no licenciamento restrições com relação ao número de dispositivos 

conectados por ponto de acesso; 
52. Implementar a pilha de protocolos TCP/IP com suporte a IPV4 e IPV6 (Bridging); 
53. Implementar VLANs conforme padrão IEEE 802.1Q; 
54. Possuir, no mínimo, uma interface IEEE 802.3 10/100/1000BaseT Ethernet, auto- sensing, 

auto MDI/MDX; 
55. Permitir a atualização remota do sistema operacional e arquivos de configuração através da 

controladora WLAN 
56. Implementar cliente DHCP, para configuração automática de rede; 
57. Deve configurar-se automaticamente ao ser conectado na rede; 
58. Possuir LED’s indicativos do estado de operação, da atividade do rádio e da interface 

Ethernet; 
59. Possuir estrutura que permita fixação do equipamento em teto e parede e fornecer 

acessórios para que possa ser feita a fixação; 
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60. Deve ser acompanhado de todos os acessórios necessários para operacionalização do 
equipamento, tais como: softwares, cabos de console, cabos de energia elétrica, 
documentação técnica e manuais (podendo ser em CD-ROM) que contenham informações 
suficientes para possibilitar a instalação, configuração e operacionalização do equipamento; 

61. Permitir o bloqueio da configuração do Ponto de Acesso via rede wireless; 
62. Implementar varredura de RF nas bandas 802.11a, 802.11b, 802.11g, 802.11n, para 

identificação de Pontos de Acesso intrusos não autorizados (rogues) e interferências no canal 
habilitado ao ponto de acesso e nos demais canais configurados na rede WLAN, sem impacto 
no seu desempenho; 

63. Implementar IEEE 802.1x, com pelo menos os seguintes métodos EAP: 

a. EAP- MD5 
b. EAP-FAST 
c. EAP-TLS 
d. PEAP-GTC 
e. PEAP-MSCHAPv2 

64. Permitir a integração com RADIUS Server com suporte aos métodos EAP citados; 
65. A comunicação entre todos os pontos de acesso sem fio e a controladora deverá ser 

criptografada; 
66. Suportar a autenticação com geração dinâmica de chaves criptográficas por sessão e por 

usuário; 
67. Implementar WPA com algoritmo de criptografia TKIP e MIC; 
68. Implementar WPA2 com algoritmo de criptografia AES, 128/256 bits, IEEE 802.11i; 
69. Deve possuir modo dedicado de funcionamento de análise de espectro das faixas de 

frequência de 2.4 e 5 GHz identificando fontes de interferência nessas faixas; 
70. Deve possibilitar analise de espectro nos canais em que estiver provendo acesso, sem 

desconectar os usuários; 
71. Deve disponibilizar informações gráficas de análise de espectro em conjunto com o 

controlador WLAN; 
72. O equipamento deverá possuir registro na ANATEL e deverá ser apresentado na entrega do 

equipamento; 
73. Deverá prover priorização de trafego de vídeo e voz através de parâmetros de QoS (Quality 

os Service) com possibilidade de aplicar por SSID e dispositivo; 
74. Possibilitar roaming na rede wireless; 
75. Suportar a criação de uma rede de convidados autocontida com isolamento de tráfego entre 

clientes e serviços locais; 
76. Possuir recursos de seleção automática de canal de transmissão procurando por canais onde 

haja menor interferência, tendo por objetivo melhorar a performance da rede wireless; 
77. Permitir a operação em estrutura Mesh viabilizando a comunicação direta entre diferentes 

Pontos de Acesso sem Fio onde não seja possível estender a rede cabeada; 
78. Operando em estrutura Mesh, a comunicação entre os dispositivos estrutura deverão operar 

na frequência de 5Ghz. 
79. Possuir mecanismo para a restauração das configurações originais de fábrica fisicamente no 

equipamento (reset); 
80. Suportar operação em humidade de 5% a 95% sem condensação; 
81. Suportar operação em temperatura de até 40°C (quarenta graus centígrados); 
82. Possuir um MTBF (Mean Time Between Failure - Período Médio entre Falhas) de, no mínimo, 

250.000 horas. 
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Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos equipamentos, 
indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 28 – INJETOR POE PARA PONTOS DE ACESSO TIPO 1 

Características técnicas mínimas 

1. Deve ser do mesmo fabricante dos Pontos de acesso ou homologado e certificado pelo 
mesmo para utilização em seus equipamentos; 

2. Injetor PoE 802.3af 10/100/1000 Ethernet com 15.4W; 

  

Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
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equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

3. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 29 – INJETOR POE PARA PONTOS DE ACESSO TIPO 2 

Características técnicas mínimas 

1. Deve ser do mesmo fabricante dos Pontos de acesso ou homologado e certificado pelo 
mesmo para utilização em seus equipamentos; 

2. Injetor PoE+ 802.3at 10/100/1000 Ethernet com 30W; 

  

Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

3. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 30 – SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE TECNOLOGIA PARA SOLUÇÃO DE 
GERENCIAMENTO 

Características Gerais 

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das 14:00 às 18:00) 
presencialmente no TRE-AL ou remotamente conforme necessidades da CONTRATANTE; 

  

Implantação 

2. Instalação e configuração de 1 (uma) instância do serviço de gerenciamento de rede, 
contemplando: 
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a. Configurações básicas para acesso à rede, dimensionamento e configuração de 
armazenamento; 

b. Inclusão de no mínimo 10 (dez) pontos de acesso no monitoramento; 
c. Criação de modelo de configuração (templates) de forma a possibilitar a replicação de 

configuração entre equipamentos. 

  

Transferência De Tecnologia 

3. O treinamento deverá ser no realizado na modalidade workshop com tarefas práticas hands-
on, visando assim a melhor fixação dos temas abordados com foco direto na explicação da 
tecnologia da solução como também nas rotinas de configuração, gerenciamento, 
administração e operação da mesma; 

  

4. O treinamento do MÓDULO DE GERENCIA DE REDE deverá ter duração mínima de 24 (vinte e 
quatro) horas onde será abordado, no mínimo, os seguintes tópicos: 

a. Inserção, modificação e remoção de dispositivos de forma unitária e em lote; 
b. Configuração de VLANs Globais e Locais em switchs gerenciados; 
c. Configuração de ACLS Globais e Locais em switchs gerenciados; 
d. Backup e restore de configuração de switchs gerenciados; 
e. Monitoramento e alarmes default e customizados; 
f. Customização do Dashboard com alertas, mapas de topologia e monitoramento de 

dispositivos; 

  

ITEM 31- SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE TECNOLOGIA DO MÓDULO DE CONTROLE 
DE ACESSO 

Características Gerais 

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das 14:00 às 18:00) 
presencialmente no TRE-AL ou remotamente conforme necessidades da CONTRATANTE; 

  

Implantação 

2. Instalação e configuração de 1 (uma) instancia do serviço controle de acesso, contemplando: 

a. Configurações básicas para acesso à rede, dimensionamento e configuração de 
armazenamento; 

b. Configuração de autenticação em Active Directory para usuários corporativos; 
c. Configuração de autenticação de visitantes com portal de autosserviço para criação de 

usuários; 
d. Configuração de no mínimo 5 (cinco) dispositivos de rede para autenticação na solução. 
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Transferência de Tecnologia 

3. O treinamento deverá ser no realizado na modalidade workshop com tarefas práticas hands-
on, visando assim a melhor fixação dos temas abordados com foco direto na explicação da 
tecnologia da solução como também nas rotinas de configuração, gerenciamento, 
administração e operação da mesma devendo ter duração mínima de 24 (vinte e quatro) 
horas onde será abordado no mínimo os seguintes tópicos: 

a. Configuração de Active Directory como base de autenticação; 
b. Configuração de autenticação de usuários corporativos; 
c. Configuração de autenticação de usuários visitantes; 
d. Configuração de portal de autosserviço; 
e. Configuração de autenticação e autorização com protocolo RADIUS. 

ITEM 32– SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE TECNOLOGIA PARA CONTROLADORA 
WLAN E PONTOS DE ACESSO 

  

Características Gerais 

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das 14:00 às 18:00) 
presencialmente no TRE-AL ou remotamente conforme necessidades da CONTRATANTE; 

  

Implantação 

2. Instalação e configuração de no mínimo 10 (dez) pontos de acesso, contemplando: 

a. Configuração básica de acesso a gerência via rede; 
b. Configuração de gerência e monitoramento em MÓDULO DE GERENCIA DE REDE; 
c. Configuração da autenticação de usuários em MÓDULO DE CONTROLE DE ACESSO 
d. Configuração de pontos de acesso em controladora WLAN habilitando gerenciamento 

centralizado; 

  

Transferência de Tecnologia 

3. O treinamento deverá ser no realizado na modalidade workshop com tarefas práticas hands-
on, visando assim a melhor fixação dos temas abordados com foco direto na explicação da 
tecnologia dos produtos ofertados como também nas rotinas de configuração, 
gerenciamento, administração e operação dos mesmos devendo ter duração mínima de 16 
(Dezesseis) horas onde será abordado no mínimo os seguintes tópicos: 

a. Configuração inicial e acesso a gerência; 
b. Configuração de Clusters; 
c. Configuração de autenticação de usuários em MÓDULO DE CONTROLE DE ACESSO; 
d. Criação de SSID com autenticação PSK; 
e. Criação de SSID com autenticação enterprise em MÓDULO DE CONTROLE DE ACESSO; 
f. Configuração de pontos de acesso para MÓDULO DE GERENCIA DE REDE; 
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g. Configuração pontos de acesso para MÓDULO DE ANÁLISE DE TRÁFEGO; 

  

ITEM 33 – TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE ARQUITETURA WLAN 

  

Características Gerais 

7. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do fabricante no 
Treinamento Básico De Administração De Arquitetura Wlan para 01 (um) profissional da 
contratante; 

8. O voucher deverá ter validade de pelo menos 12 (doze) meses; 
9. O treinamento deverá ser de acordo com o calendário de treinamento do fabricante e 

ministrado em centro oficial de treinamento do mesmo ou remotamente, utilizando 
tecnologia de ensino a distância; 

10. Deverá ser ministrado por profissional devidamente credenciado junto ao fabricante e apto a 
entregar o respectivo; 

11. O treinamento deverá compreender a explicação da tecnologia da solução como também das 
rotinas de configuração, gerenciamento, administração e operação da mesma; 

12. O treinamento deverá ter carga horária mínima de 20 (vinte) horas, ministrado no período de 
08:00 às 12:00 e das 14:00 às 18:00. 

  

ITEM 34 – TREINAMENTO BÁSICO DA SOLUÇÃO DE GERENCIAMENTO 

  

Características Gerais 

1. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do fabricante no 
Treinamento da Solução de Gerenciamento para 01 (um) profissional da contratante; 

2. O voucher deverá ter validade de pelo menos 12 (doze) meses; 
3. O treinamento deverá ser de acordo com o calendário de treinamento do fabricante e 

ministrado em centro oficial de treinamento do mesmo ou remotamente, utilizando 
tecnologia de ensino a distância; 

4. Deverá ser ministrado por profissional devidamente credenciado junto ao fabricante e apto a 
entregar o respectivo; 

5. O treinamento deverá compreender a explicação da tecnologia da solução como também das 
rotinas de configuração, gerenciamento, administração e operação da mesma; 

6. O treinamento deverá ter carga horária mínima de 40 (Quarenta) horas, ministrado no 
período de 08:00 às 12:00 e das 14:00 às 18:00. 

  

ITEM 35 – TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE ACESSO 

  

Características Gerais 
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7. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do fabricante no 
Treinamento da Solução de Controle de Acesso para 01 (um) profissional da contratante; 

8. O voucher deverá ter validade de pelo menos 12 (doze) meses; 
9. O treinamento deverá ser de acordo com o calendário de treinamento do fabricante e 

ministrado em centro oficial de treinamento do mesmo ou remotamente, utilizando 
tecnologia de ensino a distância; 

10. Deverá ser ministrado por profissional devidamente credenciado junto ao fabricante e apto a 
entregar o respectivo; 

11. O treinamento deverá compreender a explicação da tecnologia da solução como também das 
rotinas de configuração, gerenciamento, administração e operação da mesma; 

12. O treinamento deverá ter carga horária mínima de 40 (Quarenta) horas, ministrado no 
período de 08:00 às 12:00 e das 14:00 às 18:00. 

3.2 Forma de Execução e de Gestão do Contrato (Art. 18, § 3º, III, a) 

A execução do objeto pressupõe a existência dos seguintes papéis e 
responsabilidades (Art. 18, § 3º, III, a, 1): 

1. Patrocinador da Contratação: é o titular da área demandante, responsável por representar os 
interesses do órgão no contexto da Contratação, pela aprovação da necessidade e, por fim, 
pela negociação das ações necessárias para que os objetivos sejam alcançados; 

2. Gestor do Contrato (art. 3º, IV, da Resolução TRE/AL nº 15.787/2017): servidor designado 
para coordenar e comandar o processo da fiscalização da execução contratual. Na forma do 
Art. 17 da mesma Resolução, o gestor do contrato responsabiliza-se pela condução da gestão 
e fiscalização do contrato, nos termos do Art. 67, da Lei nº 8.666/93. 

3. Fiscal do Contrato (art. 3º, VI, da Resolução TRE/AL nº 15.787/2017): servidor designado para 
auxiliar o gestor do contrato quanto à fiscalização do objeto do contrato. Neste sentido, 
indicado pela respectiva autoridade competente para fiscalizar o Contrato quanto aos 
aspectos técnicos da solução. 

Dinâmica da Execução (Art. 18, § 3º, III, a, 2): 

1. Os equipamentos deverão ser entregues no Almoxarifado do TRE/AL, nos quantitativos 
indicados no pedido de fornecimento; 

2. A garantia dos equipamentos deve obedecer o detalhamento técnico feito e terá seu tempo 
contado por cada fornecimento individualmente; 

3. Entende-se como garantia aquela prestada pelo próprio fabricante ou por rede 
credenciada pelo fabricante do(s) referido(s) equipamento(s); 

4. O pagamento será realizado individualmente para cada nota fiscal apresentada, 
após emissão do aceite definitivo pela unidade competente do TRE/AL; 

5. Os equipamentos deverão ser novos, não recondicionados, de primeiro uso e não deverão 
conter marcas, amassados, arranhões ou outros problemas e, ainda, serem entregues em 
pleno estado de funcionamento; 

6. Os equipamentos deverão atender rigorosamente a todas as especificações técnicas contidas 
neste Termo de Referência e em seus Anexos; 

7. Os equipamentos deverão vir acompanhados de todos os acessórios necessários para o seu 
pleno estado de funcionamento, como cabos, drivers, mídias e outros, os quais só serão 
recebidos juntamente com os respectivos equipamentos. Este item se aplica tanto para a 
entrega dos equipamentos quanto para substituições durante o período de garantia; 

8. Ao TRE é reservado o direito de efetuar conexões dos equipamentos a outros, bem como 
adicionar demais acessórios compatíveis tecnicamente, sem que isso constitua motivo para a 
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Contratada se desobrigar da garantia, desde que tal fato não implique danos materiais 
ou técnicos aos equipamentos e acessórios, hipótese que deverá ser devidamente 
comprovada; 

9.  Ao TRE/AL é reservado o direito de efetuar diligência, a qualquer tempo, quanto aos 
documentos exigidos neste Termo de Referência e em seus Anexos. 

Recebimento do Objeto: 

1. O Tribunal designará Comissão para realizar o recebimento provisório, que só será emitido se 
os equipamentos estiverem de acordo com as especificações técnicas; 

2. Após a entrega, os equipamentos serão submetidos à avaliação e homologação pelos 
responsáveis técnicos do Tribunal; 

3.  O exame para comprovação das características técnicas consistirá em avaliações e testes 
não-destrutivos, por amostragem realizados em duas etapas: 

a. Primeira: inspeção visual de todos os equipamentos entregues; 
b. Segunda: testes funcionais de configuração e desempenho, em, no mínimo, 10% (dez 

por cento) e não menos do que 01 (um) dos equipamentos recebidos. O Tribunal 
poderá, a seu critério, executar os testes nos demais equipamentos, dentro de 
um critério de razoabilidade, podendo chegar a 100% dos quantitativos, mas dentro 
de um prazo máximo de 30 (trinta) dias corridos e contados de cada lote de 
equipamentos. 

4. As especificações serão avaliadas também por meio de documentos técnicos que 
acompanham os equipamentos, informações fornecidas pela Contratada e disponível no 
sítio do fabricante. 

5. A comissão do Tribunal deverá, após a comprovação do perfeito funcionamento dos 
equipamentos e adequação às especificações técnicas, emitir e assinar o Termo de 
Recebimento Definitivo. 

Instrumentos Formais de Solicitação do(s) Bens e/ou Serviço(s) (Art. 18, § 3º, III, a, 
3): 

1. A Ordem de Fornecimento será o instrumento formal de solicitação dos bens pertencentes ao 
escopo desta contratação. 

Forma de Pagamento (Art. 18, § 3º, III, a, 7) 

1. O pagamento será efetuado mediante crédito em conta-corrente do Fornecedor, por ordem 
bancária, no prazo disposto nos artigos 5º, § 3º, ou 40, XIV, “a”, da Lei n. 8.666/93, conforme 
o caso, quando mantidas as mesmas condições iniciais de habilitação e cumpridos os 
seguintes  requisitos: 

a. Apresentação de nota fiscal de acordo com a legislação vigente à época da emissão 
(nota fiscaleletrônica, se for o caso), acompanhada da Certidão Negativa de Débito – 
CND, comprovando regularidade com o INSS; do Certificado de Regularidade do FGTS 
– CRF, comprovando regularidade com o FGTS; da Certidão Conjunta Negativa de 
Débitos Relativos a Tributos Federais e à Dívida Ativa da União, expedida pela 
Secretaria da Receita Federal; e da Certidão Negativa de Débitos Trabalhistas – CNDT, 
emitida pela Justiça do Trabalho; e  da prova de regularidade para com as Fazendas 
Estadual e Municipal do domicílio ou sede do Fornecedor; e 

b. Inexistência de fato impeditivo para o qual tenha concorrido o Fornecedor. 
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2. Nenhum pagamento será efetuado à Contratada enquanto pendente de liquidação qualquer 
obrigação. Esse fato não será gerador de direito a reajustamento de preços ou a atualização 
monetária. 

Direitos de Propriedade Intelectual (Art. 18, § 3º, III, a, 9): 

1. Esse requisito não se aplica ao contexto desta contratação, uma vez que o objeto se refere 
ao fornecimento de equipamentos, cujos direitos autorais do fabricante são resguardados 
por legislação nacional e internacional. 

Penalidades (Art. 18, § 3º, III, a, 11): 

1. Com fundamento no artigo 7º da Lei nº 10.520/2002 e, subsidiariamente, nos artigos 86 e 87 
da Lei 8.666/1993, a Contratada ficará sujeita, assegurada prévia e ampla defesa, 
às seguintes penalidades: 

a. Advertência: 
i. A Contratada será notificada formalmente em caso de descumprimento de 

obrigação contratual e terá que apresentar as devidas justificativas em um 
prazo de até 5 (cinco) dias úteis após o recebimento da 
notificação; e 

ii. Caso não haja manifestação dentro desse prazo ou se entenda serem 
improcedentes as justificativas apresentadas, a Contratada será advertida; 

b. Multa de: 

i. 0,5% por dia, sobre o valor constante da Ordem de Fornecimento, no caso de 
atraso injustificado na entrega dos equipamentos, limitada a incidência a 20 
(vinte) dias corridos; 

1. No caso de atraso injustificado na entrega dos equipamentos por prazo s
uperior a 20 (vinte) dias corridos, com 
a aceitação pela Administração, será aplicada a multa de 10% sobre o 
valor da Ordem de Fornecimento; e 

2. No caso de atraso injustificado na entrega dos equipamentos por prazo s
uperior a 20 (vinte) dias corridos, com a 
não aceitação pela Administração, será aplicada a penalidade 20% sobre 
o valor da Ordem de Fornecimento, no caso de inexecução total da 
obrigação, podendo haver, ainda, o cancelamento do registro de preços 
do Fornecedor; 

ii.  0,5% por dia, sobre o valor do equipamento, 
no caso de atraso injustificado na solução do chamado de garantia, limitada a i
ncidência 30 (trinta) dias corridos; 

1. No caso de atraso injustificado na solução do chamado de garantia por p
razo superior a 30 (trinta) dias corridos, aplica-se adicionalmente, 
a multa de 1% sobre o valor da Ordem de Fornecimento; e 

2. A multa por atraso relacionada ao item 
anterior será auferida por Ordem de Fornecimento e aplicada somente u
ma única vez a cada mês, independente da quantidade 
de equipamentos sem solução. 

iii. 10% sobre o valor constante da Ordem de Fornecimento, no caso de 
inexecução parcial da obrigação assumida; 
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iv. 20% sobre o valor da Ordem de Fornecimento, no caso de inexecução total da 
obrigação, podendo haver, ainda, o cancelamento do registro de preços do 
Fornecedor; 

v. 10% sobre o valor global estimado da Ata de Ata de Registro de Preços, na 
hipótese de recusa em assinar a Ata ou o instrumento do contrato, ou retirar a 
Ordem de Fornecimento. 

c. Impedimento de licitar e contratar com a União e descredenciamento do SICAF pelo 
prazo de até 5 (cinco) anos, sem prejuízo das demais penalidades legais; e 

d. Declaração de inidoneidade para licitar ou contratar com a Administração Pública. 
2. O cometimento reiterado de atrasos injustificados dos prazos previstos para entrega/solução 

do chamado de garantia dos equipamentos poderá resultar no cancelamento do registro 
de preços com a Contratada. 

3. As sanções previstas nos itens "1.a", “1.c” e “1.d” do item 1 poderão ser aplicadas, 
cumulativamente ou não, à pena de multa. 

4. O valor da multa, aplicada após o regular processo administrativo, será descontado de 
pagamentos eventualmente devidos à contratada ou cobrado judicialmente; 

5. Excepcionalmente, ad cautelam, a Administração poderá efetuar a retenção do valor 
presumido da multa, antes da instauração do regular procedimento administrativo. 
. 
  

4. Requisitos Técnicos (Art. 18, § 3º, IV) 

  

Garantia mínima de 36  (trinta e seis) meses. 

Estar comprovadamente ainda em produção. 

Conformidade com o presente Termo de Referência. 

5. Modelos (templates) propostos a serem utilizados na contratação (Art. 18, § 3º, III, V) 

Memorando nº ____ / 20__ - TRE-AL/_______________________ 

Maceió, ___ de ___________ de _____________. 

Para: SGO-COFIN 

Assunto: Autorização de Emissão de Nota de Empenho. 

PA _________________________ 

Adesão à Ata de Registro de Preços ______________ 

Ordem de Fornecimento nº _____/_________. 

 
  

Senhor Chefe 

Encaminhamos estes autos para emissão de Nota de Empenho, em favor da Empresa ________________. CNPJ: 
xx.xxx.xxx/xxxx-xx, conforme tabela abaixo, tudo em conformidade com o disposto na Resolução TRE-AL nº 
12.738/1996 (0216181). 

Certidões: SICAF evennto: ______ / RECEITA ESTADUAL evento: ______ / SIMPLES NACIONAL (se aderente) 
evento: __________ 

Item: 
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Descrição: 

Quant. total da 
ATA 

Quant. 
Recebida 

Quant. desta 
Ordem 

Saldo no 
Fornecedor 

Valor 
Unitário 

Valor Total 
(R$) 

            

  

*  Solicitamos utilizar a reserva de crédito do PE XXX/XXXX 

  

  

Gestor da Ata - Portaria TRE/AL nº XX/XXXX 

  

Moodelo a ser adotado em decorrência do comando inserto no Proc SEI nº 0005423-07.2018.6.02.8000, 
evento 0442132: modelo de referência indicado: 0452895. 

Maceió, 15 de maio de 2019. 

 
DANIEL MACÊDO DE CARVALHO SOUTO 

 Coordenador 
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ANEXO I-A 
 

ESPECIFICAÇÕES DOS LOTES, ITENS, QUANTITATIVOS A SEREM 
ADQUIRIDOS E PREÇOS MÁXIMOS ADMITIDOS 

 

Lote 1 Item Qtd Descrição Valor 
Unitário 

Valor Total 

 

01 

1 1 SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 
PARA REDE CABEADA 

R$ 104.180,00 R$ 104.180,00 

2 3 LICENCIAMENTO ADICIONAL PARA SISTEMA DE 
GERENCIAMENTO HPE IMC 

R$ 15.890,00 R$ 47.670,00 

3 2 LICENCIAMENTO ADICIONAL DO MÓDULO DE ANÁLISE DE 
TRAFEGO DO SISTEMA DE GERENCIAMENTO HPE IMC 

R$ 12.745,00 R$ 25.490,00 

4 2 LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE 
PERFIL E CONTROLE DE ACESSO 

R$ 54.160,00 R$ 108.320,00 

5 6 SWITCH DE DISTRIBUIÇÃO COM 16 PORTAS SFP+ E 
SUPORTE A MÓDULOS DE EXPANSÃO 

R$ 49.117,00 R$ 294.702,00 

6 16 MÓDULO COM 4 PORTAS SFP+ PARA SWITCH DE 
DISTRIBUIÇÃO 

R$ 4.742,00 R$ 75.872,00 

7 6 MÓDULO DE STACKING COM 4 PORTAS PARA SWITCH DE 
DISTRIBUIÇÃO 

R$ 4.406,00 R$ 26.436,00 

8 50 SWITCH DE ACESSO L3 COM 48 PORTAS GIGABIT E 4SFP+ R$ 14.382,08 R$ 719.104,00 

9 40 SWITCH DE ACESSO L3 COM 24 PORTAS GIGABIT E 4SFP+ R$ 14.106,00 R$ 564.240,00 

10 50 SWITCH DE ACESSO L2 COM 24 PORTAS GIGABIT E 4SFP R$ 4.515,00 R$ 225.760,00 

11 40 SWITCH DE ACESSO L2 COM 48 PORTAS GIGABIT E 4SFP
    

R$ 8.245,00 R$ 329.800,00 

12 50 GBIC 10GB PARA ATÉ 300M R$ 2.064,87 R$ 103.243,50 

13 30 CABO DAC 10 GBPS DE 1M  R$ 411,00 R$ 12.330,00 

14 30 CABO DAC 10 GBPS DE 3M R$ 584,00 R$ 17.520,00 

15 10 GBIC 1GB PARA ATÉ 500M R$ 740,46 R$ 7.404,60 

16 5 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA SWITCHS DE REDE 

R$ 20.000,00 R$ 100.000,00 

17 1 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO
  

R$ 60.000,00 R$ 60.000,00 

18 4 TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE SWITCHES R$ 28.000,00 R$ 112.000,00 

19 4 TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE 
ACESSO 

R$ 28.000,00 R$ 112.000,00 

02 

20 1 SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 
PARA REDE WIRELESS 

R$ 104.180,00 R$ 104.180,00 

21 1 SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS R$ 570,00 R$ 570,00 

22 200 LICENÇAS ADICIONAIS PARA SOLUÇÃO DE GERENCIAMENTO 
DE REDE WIRELESS 

R$ 497,21 R$ 99.442,00 

23 2 LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE 
PERFIL E CONTROLE DE ACESSO 

R$ 55.000,00 R$ 110.000,00 

24 4 CONTROLADORA WLAN R$ 70.000,00 R$ 280.000,00 

25 200 LICENÇAS ADICIONAIS PARA CONTROLADORA WLAN
    

R$ 900,00 R$ 180.000,00 

26 100 PONTO DE ACESSO INTERNO TIPO 01 R$ 3.076,79 R$ 307.679,00 

27 100 PONTO DE ACESSO INTERNO TIPO 02 R$ 2.300,00 R$ 230.000,00 

28 100 INJETOR POE PARA PONTOS DE ACESSO TIPO 1 R$ 500,00 R$ 50.000,00 

29 100 INJETOR POE PARA PONTOS DE ACESSO TIPO 2 R$ 550,00 R$ 55.000,00 

30 1 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA SOLUÇÃO DE GERENCIAMENTO 

R$ 24.000,00 R$ 24.000,00 

31 1 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO 

R$ 24.000,00 R$ 24.000,00 
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32 5 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA PONTOS DE ACESSO 

R$ 20.000,00 R$ 100.000,00 

33 4 TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE 
ARQUITETURA WLAN 

R$ 20.000,00 R$ 80.000,00 

34 4 TREINAMENTO BÁSICO DA SOLUÇÃO DE GERENCIAMENTO R$ 20.000,00 R$ 80.000,00 

35 4 TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE 
ACESSO    

R$ 20.000,00 R$ 80.000,00 
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        ANEXO I-B 
 

       PLANILHA DE COMPOSIÇÃO DE CUSTOS POR ITEM 

 

Lote 1 Item Qtd Descrição Valor 
Unitário 

Valor 
Total 

 

01 

1 1 SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 
PARA REDE CABEADA 

  

2 3 LICENCIAMENTO ADICIONAL PARA SISTEMA DE 
GERENCIAMENTO HPE IMC 

  

3 2 LICENCIAMENTO ADICIONAL DO MÓDULO DE ANÁLISE DE 
TRAFEGO DO SISTEMA DE GERENCIAMENTO HPE IMC 

  

4 2 LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE 
PERFIL E CONTROLE DE ACESSO 

  

5 6 SWITCH DE DISTRIBUIÇÃO COM 16 PORTAS SFP+ E SUPORTE A 
MÓDULOS DE EXPANSÃO 

  

6 16 MÓDULO COM 4 PORTAS SFP+ PARA SWITCH DE 
DISTRIBUIÇÃO 

  

7 6 MÓDULO DE STACKING COM 4 PORTAS PARA SWITCH DE 
DISTRIBUIÇÃO 

  

8 50 SWITCH DE ACESSO L3 COM 48 PORTAS GIGABIT E 4SFP+   

9 40 SWITCH DE ACESSO L3 COM 24 PORTAS GIGABIT E 4SFP+   

10 50 SWITCH DE ACESSO L2 COM 24 PORTAS GIGABIT E 4SFP   

11 40 SWITCH DE ACESSO L2 COM 48 PORTAS GIGABIT E 4SFP 
   

  

12 50 GBIC 10GB PARA ATÉ 300M   

13 30 CABO DAC 10 GBPS DE 1M    

14 30 CABO DAC 10 GBPS DE 3M   

15 10 GBIC 1GB PARA ATÉ 500M   

16 5 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA SWITCHS DE REDE 

  

17 1 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO  

  

18 4 TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE SWITCHES   

19 4 TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE ACESSO   

02 

20 1 SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 
PARA REDE WIRELESS 

  

21 1 SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS   

22 200 LICENÇAS ADICIONAIS PARA SOLUÇÃO DE GERENCIAMENTO DE 
REDE WIRELESS 

  

23 2 LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE 
PERFIL E CONTROLE DE ACESSO 

  

24 4 CONTROLADORA WLAN   

25 200  LICENÇAS ADICIONAIS PARA 
CONTROLADORA WLAN    

  

26 100 PONTO DE ACESSO INTERNO TIPO 01   

27 100 PONTO DE ACESSO INTERNO TIPO 02   

28 100 INJETOR POE PARA PONTOS DE ACESSO TIPO 1   

29 100 INJETOR POE PARA PONTOS DE ACESSO TIPO 2   

30 1 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA SOLUÇÃO DE GERENCIAMENTO 

  

31 1 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO 

  

32 5 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA PONTOS DE ACESSO 

  

33 4 TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE ARQUITETURA 
WLAN 

  

34 4 TREINAMENTO BÁSICO DA SOLUÇÃO DE GERENCIAMENTO   

35 4 TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE ACESSO
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                                                 ANEXO II 
 

PREGÃO ELETRÔNICO Nº XX/2019 
  

PPLLAANNIILLHHAA  DDEE  DDAADDOOSS  PPAARRAA  CCOONNTTRRAATTAAÇÇÃÃOO 
 
Dados da Empresa: 
Razão Social  
CNPJ  
Endereço  
CEP  
Fones:  
Fax  
E-mail  
Site internet  

 
Dados do Representante da Empresa: 
Nome  
Cargo  
Nacionalidade  
Estado civil  
Profissão  
Endereço  
CEP  
Fone  
Fax  
E-mail  
Cart. Identidade  
Orgão Expedidor  
CPF  
 
Dados Bancários da Empresa 
Banco  
Agência  

Conta  
 
Dados do Contato com a Empresa: 
Nome  
Cargo  
Endereço  
CEP  
Fone  
Fax  
E-mail  
 
Empresa optante pelo SIMPLES?  (   ) Sim  (   ) Não 
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ANEXO III 
ATA DE REGISTRO DE PREÇOS n.º XX/2019  

 

Processo nº 0008478-63.2018.6.02.8000 
Pregão Eletrônico para Registro de Preços nº XX/2019 

 
MINUTA  

 
Aos ---- dias do mês ----------- de 2019, O TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS, 
Órgão do Poder Judiciário, em nome da União – Pessoa Jurídica de Direito Público Interno, 
inscrito no CNPJ nº 06.015.041/0001-38, sediado na Avenida Aristeu de Andrade, nº 377 – 
Farol, CEP: 57051-090, nesta, neste ato representado por seu Vice-Presidente no exercício 
da Presidência, Desembargador Otávio Leão Praxedes, brasileiro, casado, Magistrado, 
portador da Carteira de Identidade nº 215.430 SSP/AL, inscrito no CPF sob o nº 
087.912.284-68, residente e domiciliado nesta Cidade, resolve registrar os preços ofertados 
pela empresa ................................., (INFORMAR SE É MICROEMPRESA OU EMPRESA DE 
PEQUENO PORTE) CNPJ …....................., sediada em …..................., representada 
por..........................................., para eventual fornecimento dos materiais abaixo 
relacionados, conforme condições descritas nos  Anexos I e I-A do Pregão Eletrônico nº 
XX/2019, nos termos da Lei nº 8.666, de 21 de junho de 1993, da Lei nº 10.520, de 17 de 
julho de 2002, do Decreto nº 5.450, de 31 de maio de 2005, do Decreto nº 7.892, de 23 de 
janeiro de 2013, e demais normas legais aplicáveis. 

 
1 – DO OBJETO. 
 
1.1. A presente ata tem por objeto o registro de preços do(s) item(ns) abaixo, 
na forma do Edital de Pregão Eletrônico nº XX/2019: 

 

LOTE ITEM DESCRIÇÃO MARCA UNID. 
QUANT. 
TOTAL 

REGISTRADA 

VALOR 
UNITÁRIO 

(R$) 

VALOR 
TOTAL 
(R$) 

 

       

 
1.2. Relação dos licitantes que aceitaram cotar seus bens em valor igual ao do vencedor 
do certame para formação de cadastro de reserva, caso haja cancelamento do registro do 
fornecedor, conforme previsto no subitem 18.3 do edital do PE nº XX/2019: 
 

Nome da empresa CNPJ Preços Quantitativos 
    
    

 
2 – DO PRAZO DE VIGÊNCIA. 
 
2.1. O prazo de vigência do presente Registro de Preços é de 12 (doze) 
meses, contado da publicação do extrato desta ata. 
 
3 – DOS PRAZOS DE ENTREGA E DA GARANTIA.  

 

3.1. O prazo máximo para a entrega dos equipamentos é de 60 (sessenta) 
dias contados a partir do recebimento da Ordem de Fornecimento ou documento 
equivalente. 
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3.2. O prazo máximo para a entrega dos softwares é 30 (trinta) dias contados 
a partir do recebimento da Ordem de Fornecimento ou documento equivalente. 

 

3.3. Os serviços de instalação, integração, garantia e suporte dos 
equipamentos e softwares, deverão ser realizados diretamente pelo fabricante de acordo 
com as exigências contidas no descritivo dos mesmos, estando essas aderentes aos 
respectivos níveis de serviço necessários a cada um deles. 

 
3.4. Quanto aos itens 1, 2, 3, 4, 20, 22, 23 e 25,   a garantia e o suporte do 
fabricante para a solução de software deverá ser ofertado pelo período mínimo de 36 (trinta 
e seis) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 

 
3.4.1. Caso a garantia padrão do fabricante seja menor que a exigida, a 
proponente deverá informar em sua proposta o código de serviço de garantia do 
fabricante (“part number”), incorporada à solução. 

3.4.2.  O fabricante deve possuir canais de comunicação e ferramentas adicionais 
para suporte técnico online como “chat” e “e-mail” em seu site da internet com 
disponibilidade ainda de área para cadastro da solução de software ofertada, 
possibilitando assim que a CONTRATANTE possa receber de forma proativa, durante 
todo período da garantia as notificações de atualizações e correções (“hotfix”) da 
solução. 

3.4.3.  A empresa fabricante da solução de software deverá dispor de um número 
telefônico tipo 0800 para suporte técnico e abertura de chamados técnicos. 

3.4.4. A comprovação da modalidade da garantia deverá ocorrer através de 
documentação do fabricante de domínio público, não sendo aceita documentação 
emitida pelo fornecedor ou centro de distribuição para fins de comprovação que por 
ventura conflitem com catálogos, manuais, folders oficiais impressos ou da internet 
(devendo constar o endereço URL para folders da web). Caso não seja comprovada por 
um dos meios citados anteriormente, será possível a comprovação através da 
apresentação de documentação expressa do fabricante dos softwares, indicando o 
período de garantia dos produtos ofertados. Em caso de documentação expressa do 
fabricante deverá ser anexada a mesma a procuração que comprove que a fabricante 
outorga ao procurador os poderes para firmar e declarar as exigências solicitadas. 

3.5. Quanto aos itens 5, 8, 9, 10, 11, 24, 26 e 27, o equipamento ofertado 
deverá possuir garantia do fabricante na modalidade on-site pelo período mínimo de 60 
(sessenta) meses para reposição de peças, mão de obra e atendimento. O prazo máximo 
para atendimento do chamado deve ser de até o próximo dia útil após a sua abertura. 
Durante o período da garantia o prazo máximo para o reparo de equipamentos defeituosos 
a condição normal de funcionamento deverá ser de até 07 (sete) dias úteis. 

3.5.1. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente 
deverá informar em sua proposta o código de serviço de garantia do fabricante (“part 
number”), incorporada à solução. 

3.5.2. O fabricante deve possuir canais de comunicação e ferramentas adicionais para 
suporte técnico online como “chat” e “e-mail” em seu site da internet com 
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disponibilidade ainda de área para cadastro da solução de hardware ofertada, 
possibilitando assim que a CONTRATANTE possa receber de forma proativa, durante 
todo período da garantia as notificações de atualizações e correções (“hotfix”) da 
solução; 

3.5.3. A empresa fabricante do equipamento deverá dispor de um número telefônico 
tipo 0800 para suporte técnico e abertura de chamados técnicos. 

3.5.4. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e 
solução exigidos para os equipamentos, deverá ser comprovada a existência da 
assistência técnica local no domicílio da contratante e na modalidade on-site, devendo 
essa ser realizada por meio de documentação oficial do fabricante dos produtos e de 
domínio público, através de catálogos, folder impressos ou da internet, devendo 
constar o endereço URL na mesma. Caso não seja comprovada por um dos meios 
citados anteriormente, será possível a comprovação através da apresentação de 
documentação expressa do fabricante dos equipamentos, indicando a referida 
assistência técnica que será responsável pelo atendimento e manutenção durante o 
período de garantia dos produtos ofertados. Em caso de documentação expressa do 
fabricante a esta deverá ser anexada uma procuração que comprove que a fabricante 
outorga ao procurador os poderes para firmar e declarar as exigências solicitadas. 

3.5.5. Todos os componentes instalados ou integrados dos equipamentos devem ser 
do próprio fabricante ou estar em conformidade com a política de garantia do mesmo, 
não sendo permitida a integração de itens de terceiros que possam acarretar em 
perda parcial da garantia ou não realização da manutenção técnica pelo próprio 
fabricante quando solicitada. 

3.6.   Quanto aos itens 6, 7, 12, 13, 14, 15, 28 e  29, O equipamento ofertado 
deverá possuir garantia do fabricante do equipamento na modalidade on-site pelo período 
mínimo de 12 (doze) meses para reposição de peças, mão de obra e atendimento no local. 
O período da garantia o prazo máximo para o reparo de equipamentos defeituosos a 
condição normal de funcionamento deverá ser de até 07 (sete) dias úteis. 

3.6.1. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente 
deverá informar em sua proposta o código de serviço de garantia do fabricante (part 
number), incorporado ao equipamento. 

3.6.2. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do 
próprio fabricante ou estar em conformidade com a política de garantia do mesmo, 
não sendo permitida a integração de itens de terceiros que possam acarretar em 
perda parcial da garantia ou não realização da manutenção técnica pelo próprio 
fabricante quando solicitada. 

 
4. DAS OBRIGAÇÕES DO ÓRGÃO GERENCIADOR. 
 
4.1. São obrigações do Órgão Gerenciador: 
 

a) Gerenciar a presente Ata, indicando, sempre que solicitado, o nome do 
detentor da ata, o preço, e as especificações dos materiais registrados, 
observada a ordem de classificação indicada na licitação; 
b) Observar para que, durante a vigência da presente ata, sejam mantidas 
todas as condições de habilitação e qualificação exigidas na licitação, bem 
assim, a compatibilidade com as obrigações assumidas; 
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c) Conduzir eventuais renegociações dos preços registrados, para fins de 
adequação às novas condições de mercado; 
d) Realizar, periodicamente, pesquisa de mercado para comprovação da 
vantajosidade dos preços registrados na Ata; 
e) Acompanhar e fiscalizar o cumprimento das condições ajustadas na 
presente Ata; 
f) Aplicar, garantida a ampla defesa e o contraditório, as penalidades 
decorrentes do descumprimento do pactuado na ata de registro de preços ou 
do descumprimento das obrigações contratuais, em relação às suas próprias 
contratações; 
g) Consultar o detentor da ata registrada (observada a ordem de classificação) 
quanto ao interesse em fornecer o material a outro(s) órgão(s) da 
Administração Pública que externe(m) a intenção de utilizar a presente Ata. 

 
4.2. São ainda obrigações do órgão gerenciador da ata, na condição de 
contratante: 

a) Efetuar o pagamento à Contratada, após o recebimento definitivo; 
b) Acompanhar e fiscalizar a execução do objeto da Ata 
de Registro de Preços e do(s) contrato(s) dela decorrentes, 
por meio de servidor(es) designado(s), 
de modo a garantir o fiel cumprimento do mesmo e da proposta; 
c) Manter arquivo, junto ao processo administrativo ao qual está vinculado 
o presente termo,  toda a documentação referente ao mesmo; 
d) Proporcionar todas as facilidades indispensáveis à 
boa execução das obrigações contratuais; e 
e) Aplicar as sanções conforme previsto no contrato, assegurando à Contrata
da o contraditório e ampla defesa. 

5. DAS OBRIGAÇÕES DO DETENTOR DA ATA 
 
5.1. São obrigações do detentor da Ata: 
 

a) Providenciar a imediata correção de deficiências, falhas ou irregularidades 
constatadas pelo ÓRGÃO GERENCIADOR referentes às condições firmadas na 
presente Ata; 
b) Viabilizar o atendimento das condições firmadas a partir da data da 
publicação da presente Ata; 
c) Manter, durante o prazo de vigência da presente Ata, todas as condições de 
idoneidade exigidas na licitação, além de sujeitar-se às demais disposições do 
Código de Proteção e Defesa do Consumidor (Lei n° 8.078/90) que sejam 
compatíveis com o regime de direito público; 
d) Informar, no prazo máximo de 05 (cinco) dias úteis, contados do 
recebimento da notificação, quanto à aceitação ou não do fornecimento de 
material a outro órgão da Administração Pública (não participante) que venha 
a manifestar o interesse de utilizar a presente Ata. 
 

5.2. São, ainda, obrigações do detentor da Ata, na condição de contratado: 
 

a) Executar o contrato em estrita conformidade com as disposições e 
especificações do Edital e com os termos da proposta de preços; 

b) Fornecer os equipamentos conforme especificações, quantidades, 
prazos e demais condições estabelecidas no Edital, na Ata de Registro de 
Preços, na Ordem de Fornecimento e na Proposta de preços; 
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c) Fornecer a documentação necessária à instalação e à operação dos 
produtos (manuais, termos de garantia, etc.), completa, atualizada e em 
português do Brasil, caso exista, ou em inglês; 

d) Disponibilizar Central de Atendimento para a abertura e fechamento 
de chamados técnicos, conforme períodos, horários e condições 
estabelecidas no Edital e em seus Anexos; 

e) Comunicar formal e imediatamente ao Gestor ou Responsável Técnico 
da Administração sobre mudanças nos dados para contato com a Central 
de Atendimento; 

f) Prestar as informações e os esclarecimentos que venham a ser 
solicitados pelo representante da Administração, referentes a qualquer 
problema detectado ou ao andamento de atividades da garantia; 

g)  Responder por quaisquer prejuízos que seus profissionais causarem 
ao patrimônio da Administração ou a terceiros, por ocasião da execução 
do objeto, procedendo imediatamente aos reparos ou às indenizações 
cabíveis e assumindo o ônus decorrente; 

h) Responsabilizar-se integralmente pelo fornecimento dos equipamentos 
e pela execução dos serviços de garantia técnica, primando pela 
qualidade, desempenho, eficiência e produtividade na execução dos 
trabalhos, dentro dos prazos estipulados e cujo descumprimento será 
considerado infração passível de aplicação das penalidades previstas no 
Termo de Referência (Anexo I); 

i) Comunicar ao Gestor ou Responsável Técnico, formal e 
imediatamente, todas as ocorrências anormais e/ou que possam 
comprometer a execução do objeto; 
 
j) Manter sigilo sobre todo e qualquer assunto de interesse da 
Administração ou de terceiros de que tomar conhecimento em razão da 
execução do objeto, respeitando todos os critérios estabelecidos, 
aplicáveis aos dados, informações, regras de negócios, documentos, 
entre outros pertinentes, sob pena de responsabilidade civil, penal e 
administrativa; 

 
k) Cumprir e garantir que seus profissionais estejam cientes, aderentes e 
obedeçam rigorosamente às normas e aos procedimentos estabelecidos 
na Política de Segurança da Informação do TRE/AL; 

 
l) Responsabilizar-se pela conservação dos ambientes onde desempenhe 
as atividades necessárias para prestar a garantia on-site; 

 
m) Prestar as informações e os esclarecimentos que venham a ser 
solicitados pela Administração, referentes a qualquer problema 
detectado ou ao andamento de atividades da garantia técnica. 
 
n) Indicar endereço eletrônico (e-mail) para o recebimento de 
expedientes/notificações enviadas pelo TRE/AL, sendo considerados 
válidos todos os expedientes/notificações enviadas ao endereço 
eletrônico indicado; 
 
o) Manter durante a execução do contrato todas as condições que 
culminaram em sua habilitação, principalmente a regularidade fiscal e 
previdenciária, condições de idoneidade exigidas na licitação e outras 
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previstas na legislação vigente e na aplicável à natureza dos serviços 
objeto da contratação; 
 
p) Aceitar o cancelamento da ordem de fornecimento por parte da 
Administração, no caso de fornecimento/entrega, em final de exercício 
e posterior ao dia 15 de dezembro ou dia útil imediatamente 
subsequente, em decorrência dos efeitos da Emenda Constitucional nº 
95/2016, sem a reversão de qualquer ônus à Administração. 
 
q) Apresentar certidões de quitação junto à Receita Federal, Dívida Ativa 
da União, INSS, FGTS, Fazenda Estadual  e Fazenda Municipal ou estar 
registrada junto ao SICAF em condição regular; 
 
r) Acatar outras determinações previstas na legislação aplicável à 
natureza do objeto deste contrato; 
 
s) Cumprir com outras obrigações decorrentes da aplicação do Código 
de Proteção e Defesa do Consumidor (Lei nº 8.078/1990) que sejam 
compatíveis com o regime de Direito Público. 

 
6 - DO PAGAMENTO. 
 
6.1. O pagamento será efetuado mediante ordem bancária de crédito em 
conta corrente, em até 10 (dez) dias, após o recebimento da Nota Fiscal respectiva, a qual 
deverá ser entregue somente após a prestação dos serviços, devendo a contratada atender 
os seguintes requisitos: 

a) Apresentação de nota fiscal de acordo com a legislação vigente à época da 
emissão (nota fiscaleletrônica, se for o caso), acompanhada do Certificado 
de Regularidade do FGTS – CRF, comprovando regularidade com o FGTS; da 
Certidão Conjunta Negativa de Débitos Relativos a Tributos Federais e à Dívida 
Ativa da União, que incluindo as referentes a contribuições previdenciárias, 
expedida pela Secretaria da Receita Federal; e da Certidão Negativa de 
Débitos Trabalhistas – CNDT, emitida pela Justiça do Trabalho; e da prova de 
regularidade para com as Fazendas Estadual do domicílio ou sede do 
Fornecedor; e 

b) Inexistência de fato impeditivo para o qual tenha concorrido o Fornecedor. 

6.2.  Eventuais penalidades poderão ser descontadas do pagamento. 
 
6.3.  Em nenhuma hipótese haverá antecipação de pagamento. 
 
6.4.  O TRE/AL, por ocasião de cada pagamento, fará as retenções e 
recolhimentos fiscais determinados pela legislação tributária. 
 
6.5.  Se a empresa for optante pelo SIMPLES, deverá anexar à nota fiscal 
documento que comprove tal opção, para que sobre o valor do pagamento não incidam as 
retenções de que trata o item anterior. 
 
6.6.  Havendo atraso no pagamento, o valor devido deverá ser acrescido de 
encargos moratórios, apurados desde a data do primeiro dia útil do atraso, até a data do 
efetivo pagamento, desde que o contratado não tenha concorrido para tanto, mediante a 
aplicação da seguinte fórmula: 
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EM = I x N x VP, 
 
Onde: 
EM= Encargos Moratórios 
N= Número de dias entre a data prevista para o pagamento e a do efetivo pagamento; 
VP = Valor da parcela a ser paga; 
I= Índice de atualização financeira= 0,0001644, assim apurado: 
 
I = (TX/100)                  I= (6/100)           I = 0,0001644 
         365                             365 
TX= Percentual de Taxa Anual= 6% 

6.7.  Nenhum pagamento será efetuado à Contratada enquanto pendente de 
liquidação qualquer obrigação. Esse fato não será gerador de direito a reajustamento de 
preços ou a atualização monetária. 

7 – DO RECEBIMENTO DO OBJETO. 
 
7.1. O objeto deverá ser entregue, no prazo previsto no item 3 desta Ata, contados do 
recebimento da Nota de Empenho ou Ordem de Fornecimento, por e-mail ou ofício, o que 
ocorrer primeiro, no horário de expediente normal, de segunda a sexta-feira, na Seção de 
Almoxarifado do Tribunal Regional Eleitoral de Alagoas, localizada na Avenida Menino 
Marcelo (antiga via expressa), nº 7.200 D – Serraria, Maceió/AL, CEP: 57046-005, sob 
agendamento através do telefone (82) 3328-1947. 
 
7.2. O objeto será recebido: 
 

a) provisoriamente, para que seja feita a verificação da conformidade dos mesmos 
com as especificações. 

 
b) definitivamente, após avaliação e homologação pelos responsáveis técnicos 
do Tribunal, da seguinte forma: 

b.1) O exame para comprovação das características técnicas consistirá em 
avaliações e testes não-destrutivos, por amostragem realizados em duas 
etapas: 

a. Primeira: inspeção visual de todos os equipamentos entregues; 
b. Segunda: testes funcionais de configuração e desempenho, em, no 

mínimo, 10% (dez por cento) e não menos do que 01 (um) dos 
equipamentos recebidos. O Tribunal poderá, a seu critério, executar 
os testes nos demais equipamentos, dentro de um critério de 
razoabilidade, podendo chegar a 100% dos quantitativos, mas dentro 
de um prazo máximo de 30 (trinta) dias corridos e contados de cada 
lote de equipamentos. 

b.2) As especificações serão avaliadas também por meio de documentos 
técnicos que acompanham os equipamentos, informações fornecidas pela 
Contratada e disponível no sítio do fabricante; 

b.3) A comissão do Tribunal deverá, após a comprovação do perfeito 
funcionamento dos equipamentos e adequação às especificações técnicas, 
emitir e assinar o Termo de Recebimento Definitivo. 
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7.3. O produto será rejeitado no caso de incompatibilidade com as 
especificações previstas na proposta ou quando inadequado à sua utilização. 
 
7.4. O prazo para a Secretaria competente proceder às verificações, após o 
recebimento provisório, será de 05 (cinco) dias úteis, quando deverá se manifestar, 
aceitando ou recusando o item objeto do fornecimento. 
 
7.5. Os recebimentos provisório e definitivo se darão mediante formulário 
próprio. 
 
7.6. O recebimento definitivo não exime o fornecedor de responder pelos 
vícios aparentes e ocultos segundo as disposições deste termo e as normas de proteção ao 
consumidor. 
 
7.7. O objeto que estiver em desacordo com as especificações do edital terá seu 
recebimento recusado, devendo o fornecedor, dentro do prazo de 10 (dez) dias corridos, 
substituir o produto adequadamente, sujeitando-se à multa prevista na Seção 8. 
 
8 - DAS SANÇÕES ADMINISTRATIVAS. 
 
8.1. Com fundamento no artigo 7º da Lei nº 10.520/2002 e, subsidiariamente, 
nos artigos 86 e 87 da Lei 8.666/1993, a Contratada ficará sujeita, assegurada prévia e 
ampla defesa, às seguintes penalidades:  

 
a. Advertência:  
 

i. A Contratada será notificada formalmente em caso de descumprimento de 
obrigação contratual e terá que apresentar as devidas justificativas em um prazo 
de até 5 (cinco) dias úteis após o recebimento da notificação; e 

 
ii. Caso não haja manifestação dentro desse prazo ou se entenda serem 
improcedentes as justificativas apresentadas, a Contratada será advertida. 

 
b. Multa de: 

 
i. 0,5% (meio por cento) por dia, e por ocorrência, sobre o valor do 

objeto com atraso injustificado, limitada a incidência a 20 (vinte) 
dias corridos; 

- No caso de atraso injustificado na entrega do objeto por prazo superior a 20 
(vinte) dias corridos, com 
a aceitação pela Administração, será aplicada a multa de 10% sobre o valor 
da Ordem de Fornecimento; e 

-  No caso de atraso injustificado na prestação dos serviços por prazo superior a 
20 (vinte) dias corridos, com a não aceitação pela Administração, será aplicada a 
penalidade 20% sobre o valor da Ordem de Fornecimento, no caso de inexecução 
total da obrigação, podendo haver, ainda, o cancelamento do registro de preços 
do Fornecedor. 

ii. 10% sobre o valor constante da Ordem de Fornecimento, no caso de inexecução 
parcial da obrigação assumida; 
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iii. 20% (vinte por cento) sobre o valor adjudicado, em caso de inexecução total da 
obrigação assumida; 

iv. 10% sobre o valor global da Ata de Registro de Preços, na hipótese de recusa em 
assinar a Ata ou retirar a Ordem de Fornecimento; 

c. Impedimento de licitar e contratar com a União e descredenciamento do SICAF 
pelo prazo de até 5 (cinco) anos, sem prejuízo das demais penalidades legais; e  
 
d. Declaração de inidoneidade para licitar ou contratar com a Administração 
Pública.  

 
8.2.    O cometimento reiterado de atrasos injustificados dos prazos previstos para 
entrega/solução do chamado de garantia dos equipamentos poderá resultar no 
cancelamento do instrumento de fornecimento com a Contratada. 
 
8.3.   As sanções previstas nos itens "18.1.a", “18.1.c” e “18.1.d” poderão ser 
aplicadas, cumulativamente ou não, à pena de multa.  
 
8.4.   O valor da multa, aplicada após o regular processo administrativo, será 
descontado de pagamentos eventualmente devidos à contratada ou cobrado judicialmente;  
 
8.5.   Excepcionalmente, ad cautelam, a Administração poderá efetuar a retenção 
do valor presumido da multa, antes da instauração do regular procedimento administrativo. 
 
8.6.   O valor da multa, apurado após regular procedimento administrativo, será 
descontado dos pagamentos eventualmente devidos pelo TRE/AL ou cobrado judicialmente. 
 
8.7.   Na aplicação das penalidades previstas nesta Seção a autoridade 
competente sempre se valerá dos princípios da proporcionalidade, da razoabilidade e da 
prevalência e indisponibilidade do interesse público, em decorrência de circunstâncias 
fundamentadas em fatos comprovados. 
 
8.8.   O licitante contratado, quando não puder cumprir os prazos 
estipulados para o fornecimento do material, total ou parcialmente, deverá apresentar 
justificativa por escrito, devidamente comprovada, e em documento contemporâneo à sua 
ocorrência, acompanhada de pedido de prorrogação, nos casos de ocorrência de fato 
superveniente, excepcional ou imprevisível, estranho à vontade das partes, que altere 
fundamentalmente as condições do contrato, ou que impeça a sua execução, por fato ou 
ato de terceiro reconhecido pela Administração.  
 
8.9.  Do ato que aplicar as penalidades caberá recurso na forma do art. 109 da Lei 
nº 8.666/1993. 
 
8.10.  Se o licitante contratado não recolher o valor da multa que lhe for aplicada, 
dentro de 05 (cinco) dias úteis a contar da data da intimação para o pagamento, a 
importância será descontada automaticamente, ou ajuizada a dívida, consoante o § 3º do 
art. 86 e § 1º do art. 87 da Lei nº 8.666/1993, acrescida de juros moratórios de 0,5% (meio 
por cento) ao mês. 
 
8.11.  O TRE/AL promoverá o registro no SICAF de toda e qualquer penalidade 
imposta ao licitante contratado. 
 
8.12.  O período de atraso será contado em dias corridos. 
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8.13. No caso de aplicação de penalidade em que a contratada tenha que 
pagar multa através de Guia de Recolhimento da União – GRU, e não o faça no devido 
prazo, o índice utilizado para atualização do valor será o IPCA. 
 
8.14. A data a ser utilizada como referência para a atualização do débito será a 
da publicação da decisão da aplicação da penalidade no Diário Eletrônico.  
 
8.15.  Fica estabelecido que os casos omissos serão resolvidos entre as partes 
contratantes, respeitados o objeto da presente licitação, a legislação e demais normas 
reguladoras da matéria, em especial as Leis nos 8.666/1993 e  10.520/2002, aplicando-lhes, 
quando for o caso, supletivamente, os princípios da Teoria Geral dos Contratos e as 
disposições do Direito Privado. 

 
18.16.  Os atos administrativos de aplicação das sanções, com exceção de 
advertência, multa de mora e convencional, serão publicados resumidamente no Diário 
Oficial da União. 

9 – DA VEDAÇÃO DE ACRÉSCIMO NOS QUANTITATIVOS REGISTRADOS 

9.1.     É vedado efetuar acréscimos nos quantitativos fixados na presente  ata de 
registro de preços, inclusive o acréscimo de que trata o § 1º do art. 65 da Lei nº 8.666, de 
1993, de acordo com o disposto no § 1º, art. 12 do Decreto nº 7.892/2013. 
 
10  - DA PUBLICAÇÃO 
 
10.1.       O extrato da presente ata será publicado no Diário Oficial da União. 
 
11 – DO FORO 
 
11.1.  Fica eleito o foro da Seção Judiciária da Justiça Federal da Capital do 
Estado de Alagoas, para dirimir as questões originadas deste contrato, com exclusão de 
qualquer outro, por mais privilegiado que seja. 
 

E por estarem justos e contratados, foi lavrado o presente instrumento, em 02 (duas) vias 
de igual teor e forma, que, após lido e achado conforme, segue assinado pelas partes. 

Maceió, XX de XXXX de 2019. 
 
Pelo TRE/AL: 
 

Desembargador Otávio Leão Praxedes 
Vice-Presidente, no exercício da Presidência 

 
Pela Empresa: 
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DESPACHO

Maceió, 15 de agosto de 2019.
À SAD,
Sr. Secretário,
Em atenção ao Despacho GSAD (0581221),

verifiquei que em aquisições anteriores de objeto semelhante
ou da mesma natureza, não houve inclusão do requisito de
habilitação econômico-financeira. Assim, procedi à
complementação da minuta incluindo a exigência prevista no
inciso II do art. 31 da Lei nº 8.666/93, conforme determinado
por Vossa Senhoria.

Documento assinado eletronicamente por ANDRÉA DE ALBUQUERQUE CÉSAR, Chefe
de Seção Substituto, em 15/08/2019, às 13:47, conforme art. 1º, III, "b", da Lei
11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0581379 e o código CRC C86A770E.
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DESPACHO

Maceió, 15 de agosto de 2019.
Ciente da informação veiculada no Despacho

SLC 0581379, devolvo os autos à análise da Assessoria
Jurídica, reportando-me ao nosso Despacho 0581221.

Documento assinado eletronicamente por JOSÉ RICARDO ARAÚJO E SILVA,
Secretário de Administração, em 15/08/2019, às 14:30, conforme art. 1º, III, "b", da
Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0581443 e o código CRC 48C4EE62.
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DESPACHO

Maceió, 15 de agosto de 2019.
À SAD
 
Sr. Secretário,
 
Em atenção ao Despacho GSAD 0581221, ratifico o

que já informado pelo Despacho SLC 0581379 no sentido de
que  não houve inclusão do requisito de habilitação
econômico-financeira noutros processo assemelhados.

Outrossim, acrescento que esta unidade técnica
entende que a Administração está suficientemente acautelada,
vez que o objeto é Registro de Preços, do qual as obrigações e
conformidades tem necessariamente de ser conferidas, após a
entrega dos itens e antes de qualquer pagamento.

 
Atenciosamente. 

Documento assinado eletronicamente por DANIEL MACÊDO DE CARVALHO SOUTO,
Secretário de Tecnologia da Informação Substituto, em 15/08/2019, às 14:32,
conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0581444 e o código CRC 539A5898.

0008478-63.2018.6.02.8000 0581444v1
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DESPACHO

Maceió, 15 de agosto de 2019.
Devolvo os autos à SEIC/COMAP e à COINF,

para possível revisão conjunta da estimativa de preços,
considerando os parâmetros assinalados pela ACAGE, no
minudente Parecer 1648 (0580729), do qual destaco o
seguinte excerto:

Segundo podemos presenciar no estudo das
normas e orientações trazidas neste
documento, na impossibilidade de se
adotar a prática de obtenção de um
conjunto favorável de cotações de preços,
a legislação permite sim ao
Administrador adotar estimativa
de preços da futura licitação com base
apenas no menor valor pesquisado, desde
que precedida da justificativa pertinente
baseada principalmente pela análise da
unidade técnica quanto à existência de
elementos capazes de aferir a
regularidade do parâmetro eleito,
tendentes a aferir um orçamento que
venha a refletir o mais fielmente possível
com os praticados pelo mercado, evitando-
se assim a existência de 'sobrepreço" ou
mesmo de preços inexequíveis.
Desta feita, tomando em consideração a
sugestão ora proposta pela SEIC em sua
Informação n.º 3875 (0560123) quanto à
aplicação, em futuro procedimento licitatório,
dos menores valores obtidos em pesquisa de
preços por ela realizada como estimativas de
preços para cada um dos itens constantes no
Termo de Referência, motivada principalmente
pela ocorrência de negociações durante o
transcorrer do certame que venham a reduzir
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transcorrer do certame que venham a reduzir
o preço anteriormente orçado, parece-nos
razoáveis sua adoção, recomendando assim o
retorno destes autos à Secretaria de
Administração para conhecimento e
providências. (grifos não constantes do
original).
 

Na hipótese de revisão da estimativa, o feito deverá
seguir à SLC, para necessários ajustes na minuta, com cópia à
SGO/COFIN, para ciência.

Solicito que seja dada a necessária celeridade na
análise dos autos, posto integrar os projetos prioritários da
Gestão para o presente exercício.

Documento assinado eletronicamente por JOSÉ RICARDO ARAÚJO E SILVA,
Secretário de Administração, em 15/08/2019, às 16:45, conforme art. 1º, III, "b", da
Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0581624 e o código CRC 33AFB0A4.

0008478-63.2018.6.02.8000 0581624v1
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DESPACHO

Maceió, 15 de agosto de 2019.
À SAD
 
Sr. Secretário,
 
Em atenção ao Despacho GSAD 0581624, registro

por oportuno que esta unidade, na medida de que lhe foi
possível, buscou auxiliar a SEIC.

De asseverar que na forma da Informação 3875,
evento 0560123, já houve manifestação anterior, desta
unidade técnica de TI, por meio da Informação COINF 3789,
evento 0558080.

Desta forma, não se vislumbra com que outros
elementos pode esta unidade de TI colaborar adicionamente  e
que levem à revisão de estimativa.

 
Respeitosamente.

 

Documento assinado eletronicamente por DANIEL MACÊDO DE CARVALHO SOUTO,
Coordenador, em 15/08/2019, às 17:24, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0581648 e o código CRC BE5AD92C.

0008478-63.2018.6.02.8000 0581648v1
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DESPACHO

Maceió, 15 de agosto de 2019.
À SAD,
 
Tendo em vista o encaminhamento contido no

evento 0581624.
 
Atenciosamente,

Documento assinado eletronicamente por MARCEL GAMELEIRA DE ALBUQUERQUE,
Assessor Jurídico, em 15/08/2019, às 17:08, conforme art. 1º, III, "b", da Lei
11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0581664 e o código CRC C0DD4697.

0008478-63.2018.6.02.8000 0581664v1
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DESPACHO

Maceió, 15 de agosto de 2019.
A AJ-DG,
 
Senhor Assessor,
 
Em análise ao Despacho GSAD, evento 0581624, e

considerando os termos do Parecer ACAGE-1648 (0580729), do
Despacho COINF 0581648 e nossa sugestão contida na Informação
SEIC-3875 (0560123), cremos, salvo melhor juízo, não haver no
momento nada a acrescentar por parte desta Seção.

Respeitosamente,

Documento assinado eletronicamente por ANTONIO MATIAS DE PINHEIRO JUNIOR,
Chefe de Seção, em 15/08/2019, às 18:18, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0581714 e o código CRC 31D4200E.

0008478-63.2018.6.02.8000 0581714v1
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PROCESSO : 0008478-63.2018.6.02.8000
INTERESSADO : SECRETARIA DE TECNOLOGIA DA INFORMAÇÃO

ASSUNTO : REGISTRO DE PREÇOS DE COMPONENTES DE REDE (NETWORKING)

 

Parecer nº 1663 / 2019 - TRE-AL/PRE/DG/AJ-DG

 

Senhor Diretor-Geral, 
 
 
Tratam os autos de registro de preços para

eventual aquisição de componentes de rede (networking),
mediante registro de preços, conforme termo de
referência 0541748, tudo de acordo com requisição
promovida pela Secretaria de Tecnologia da Informação, com
a justificativa de que grande parte dos equipamentos de rede
deste Tribunal está defasado tecnologicamente, fora de
garantia ou na iminência de seu término.

  A análise da regularidade do procedimento foi
iniciada quando da emissão do Parecer 1555 (0574780),
ocasião em que esta Assessoria Jurídica recomendou
algumas  alterações na minuta do edital e outras providências,
que foram prontamente atendidas com a juntada da nova
minuta (0581377) pela SLC e pela manifestação da STI
(0577195). Quanto à qualificação econômico-financeira, a
inclusão da exigência prevista no inciso II do art. 31 da Lei nº
8.666/93 (inserida no item 11.1 "e.1" da minuta) satisfaz o que
foi anteriormente solicitado (0574780). 

A ACAGE, por sua vez, manifestou-se por meio do
Parecer 1648 (0580729), quanto ao item 5 apontado no
Parecer desta Assessoria Jurídica, no sentido da adoção dos
menores valores obtidos em pesquisa de preços realizada pela
SEIC para cada um dos itens constantes no Termo de
Referência, como parâmetros máximos a serem
aceitos em futuros procedimentos
licitatórios, fundamentando-se principalmente na ocorrência
de negociações durante o transcorrer do certame que venham
a reduzir o preço anteriormente orçado.

Em sua resposta, a SEIC informou: "Em análise ao
Despacho GSAD, evento 0581624, e considerando os termos
do Parecer ACAGE-1648 (0580729), do Despacho
COINF 0581648 e nossa sugestão contida na Informação
SEIC-3875 (0560123), cremos, salvo melhor juízo, não haver
no momento nada a acrescentar por parte desta Seção."

 Dessa forma,  nos termos do parágrafo único, do
Art. 38, da Lei nº 8.666/93, e em complemento ao antedito
parecer, esta Assessoria Jurídica aprova, em face de sua
regularidade jurídica,  a minuta de edital  (0581377) que
visa à realização de licitação, na modalidade PREGÃO, em sua
forma ELETRÔNICA, do tipo MENOR PREÇO POR LOTE,
objetivando o Registro de Preços de componentes de rede
(Networking).

  
À consideração superior.

Documento assinado eletronicamente por MARCEL GAMELEIRA DE ALBUQUERQUE,
Assessor Jurídico, em 15/08/2019, às 18:47, conforme art. 1º, III, "b", da Lei
11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
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al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0581752 e o código CRC AF18AA77.

0008478-63.2018.6.02.8000 0581752v6
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CONCLUSÃO

Maceió, 15 de agosto de 2019.
Senhor Presidente,
Tendo em vista a conclusão dos atos preliminares

essenciais à deflagração do procedimento licitatório pretendido
nestes autos, com a justificativa da contratação, o termo de
referência, a planilha de custo e a minuta do edital, submeto à
superior consideração de Vossa Excelência, sugerindo, com fulcro no
art. 1º da Lei nº 10.520/02 e Decreto nº 5.450/05, a abertura da fase
externa do presente certame, na modalidade pregão, na forma
eletrônica, do tipo menor preço por lote, objetivando ao registro de
preços de componentes de rede (Networking), nos termos da
minuta 0581377, aprovada pela Assessoria Jurídica desta Diretoria-
Geral, por meio do Parecer 1663 (0581752).

Documento assinado eletronicamente por FILIPE LÔBO GOMES, Diretor-Geral, em
15/08/2019, às 19:10, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0581776 e o código CRC C4AF3028.

0008478-63.2018.6.02.8000 0581776v1
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PROCESSO : 0008478-63.2018.6.02.8000
INTERESSADO : SECRETARIA DE TECNOLOGIA DA INFORMAÇÃO
ASSUNTO : Autorização. Abertura. Fase externa. Pregão eletrônico.

 

Decisão nº 2432 / 2019 - TRE-AL/PRE/GPRES

De acordo com a sugestão ofertada pelo Senhor Diretor-
Geral, inserta no evento SEI 0581776.

AUTORIZO a abertura da fase externa do certame
licitatório, na modalidade Pregão, na forma eletrônica, do tipo menor
preço por lote, objetivando o registro de preços para eventual
aquisição de componentes de rede (networking), de acordo com
requisição promovida pela Secretaria de Tecnologia da Informação. 

À SAD para a divulgação do competente instrumento
convocatório, nos termos da minuta constante no evento
SEI 0581377, aprovada pela Assessoria Jurídica da Diretoria-Geral,
por meio dos Pareceres de nº 1555 (0574780) e nº 1663 (0581752) e
demais medidas cabíveis.

 
Desembargador PEDRO AUGUSTO MENDONÇA DE ARAÚJO

Presidente
Documento assinado eletronicamente por PEDRO AUGUSTO MENDONÇA DE
ARAÚJO, Presidente, em 16/08/2019, às 11:50, conforme art. 1º, III, "b", da Lei
11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0581825 e o código CRC EE247857.

0008478-63.2018.6.02.8000 0581825v2
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DESPACHO

Maceió, 20 de agosto de 2019.
À SLC,
 
Senhora Chefe,
 
Diante da Decisão 0581825, encaminho os

presentes autos para que sejam tomadas as providências
necessárias ao seu cumprimento.

 
Atenciosamente.

Documento assinado eletronicamente por JOSÉ RICARDO ARAÚJO E SILVA,
Secretário de Administração, em 20/08/2019, às 22:22, conforme art. 1º, III, "b", da
Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0583377 e o código CRC 885FD8A8.

0008478-63.2018.6.02.8000 0583377v1
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DESPACHO

Maceió, 21 de agosto de 2019.
À SEIC, para indicação dos números dos catmats

dos itens da futura licitação.

Documento assinado eletronicamente por ANDRÉA DE ALBUQUERQUE CÉSAR,
Analista Judiciário, em 21/08/2019, às 14:52, conforme art. 1º, III, "b", da Lei
11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0584101 e o código CRC 893B7BFC.

0008478-63.2018.6.02.8000 0584101v1

  

Despacho SLC 0584101         SEI 0008478-63.2018.6.02.8000 / pg. 719



TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 21 de agosto de 2019.
Senhora Chefe,
 
Diante das dificuldades, já verbalmente informadas,

sugerimos: 
CATMATs para todos os itens, 458073 e em

segunda opção 457229.
 
Atenciosamente.

Documento assinado eletronicamente por ANTONIO MATIAS DE PINHEIRO JUNIOR,
Chefe de Seção, em 21/08/2019, às 16:03, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0584174 e o código CRC 1EB1CA6B.

0008478-63.2018.6.02.8000 0584174v1
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PPRREEGGÃÃOO  EELLEETTRRÔÔNNIICCOO  NNºº  3399//22001199  
  
PROCESSO Nº 0008478-63.2018.6.02.8000 
Tipo de Licitação: MENOR PREÇO POR LOTE   
Data: 09 de setembro de 2019 
HORÁRIO DE BRASÍLIA/DF 
Horário de Abertura: 14 horas 
Local: www.comprasnet.gov.br 

 

 O Tribunal Regional Eleitoral de Alagoas – TRE/AL, por intermédio da Seção de Licitações e 
Contratos, torna público, para quem interessar possa, que realizará licitação na modalidade 
PREGÃO ELETRÔNICO, do tipo MENOR PREÇO POR LOTE, conforme descrito neste Edital e seus 
Anexos, objetivando o Registro de Preços de  componentes de rede (Networking), tudo de acordo 
com requisição promovida pela Secretaria de Tecnologia da Informação. 
 

 O certame será regido conjuntamente pela Lei nº 10.520, de 17/07/2002, pelo Decreto nº 
5.450, de 31/05/2005, pelo Decreto nº 8.538, de 06/10/2015 e subsidiariamente pela Lei nº 8.666, 
de 21/06/1993 e com suas posteriores alterações e demais normas pertinentes. Aplica-se ao 
presente torneio licitatório, ainda, a Lei Complementar nº 123, de 14/12/2006, o Decreto nº 
7.174/2010, o Decreto nº 7.892/2013 atualizado pelo Decreto nº 9.488/2018, o Decreto nº 
8.184/2014, a Portaria nº 212, de 18/06/2001, da Presidência deste Tribunal, publicada na seção 1 
do DOU, edição de 19/06/2001, por meio da qual se adota o SICAF – Sistema de Cadastramento 
Unificado de Fornecedores - nas licitações realizadas no âmbito da Secretaria deste Tribunal, bem 
como, no que couber pela Lei nº 8.078, de 11/09/1990 e demais exigências deste Edital e seus 
anexos. 
 
1 - DO OBJETO. 
 

1.1. O presente Pregão tem por objeto o Registro de Preços de componentes de rede 
(Networking), conforme especificações descritas nos Anexos I e I-A deste edital. 

 
2 – DAS CONDIÇÕES GERAIS. 
 
2.1. O prazo de vigência da Ata de Registro de Preços decorrente deste procedimento 
licitatório é de 12 (doze) meses, contado da publicação do referido ato. 
 
2.2. 2.2. A Ata de Registro de Preços não obriga à contratação de toda quantidade 
estimada no Registro, que poderá ocorrer de acordo com as necessidades do TRE/AL. 
 
2.3. A existência de preços registrados não obriga o Tribunal Regional Eleitoral a contratar, 
facultando-se a realização de licitação específica para a aquisição pretendida, assegurada 
preferência ao fornecedor registrado em igualdade de condições. 
 

2.3.1. O direito de preferência de que trata este item poderá ser exercido pelo beneficiário 
do registro quando o Tribunal Regional Eleitoral de Alagoas, após realizada a licitação 
específica, constatar que o preço obtido é igual ou maior que o registrado ou, após 
negociação, aquiescer o detentor da ata em baixar o preço registrado, igualando ou tornando-
o menor que o obtido em referida licitação. 

 
3 - DOS PRAZOS DE ENTREGA E DA GARANTIA.  
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2 
 

 

 

 

3.1. O prazo máximo para a entrega dos equipamentos é de 60 (sessenta) dias contados a 
partir do recebimento da Ordem de Fornecimento ou documento equivalente. 

 

3.2. O prazo máximo para a entrega dos softwares é 30 (trinta) dias contados a partir do 
recebimento da Ordem de Fornecimento ou documento equivalente. 

 

3.3. Os serviços de instalação, integração, garantia e suporte dos equipamentos e softwares, 
deverão ser realizados diretamente pelo fabricante de acordo com as exigências contidas no 
descritivo dos mesmos, estando essas aderentes aos respectivos níveis de serviço necessários a 
cada um deles. 

 
3.4. Quanto aos itens 1, 2, 3, 4, 20, 22, 23 e 25,   a garantia e o suporte do fabricante para a 
solução de software deverá ser ofertado pelo período mínimo de 36 (trinta e seis) meses, incluindo 
a evolução para novas versões devendo o atendimento ser na modalidade 24x7 (vinte quatro horas 
por dia, sete dias da semana), com tempo de resposta máximo em 4 (quatro) horas. 
 

3.4.2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3.4.3.  O fabricante deve possuir canais de comunicação e ferramentas adicionais para 
suporte técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda 
de área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução. 

3.4.4.  A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

3.4.5. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante dos 
softwares, indicando o período de garantia dos produtos ofertados. Em caso de documentação 
expressa do fabricante deverá ser anexada a mesma a procuração que comprove que a 
fabricante outorga ao procurador os poderes para firmar e declarar as exigências solicitadas. 

3.5. Quanto aos itens 5, 8, 9, 10, 11, 24, 26 e 27, o equipamento ofertado deverá possuir 
garantia do fabricante na modalidade on-site pelo período mínimo de 60 (sessenta) meses para 
reposição de peças, mão de obra e atendimento. O prazo máximo para atendimento do chamado 
deve ser de até o próximo dia útil após a sua abertura. Durante o período da garantia o prazo 
máximo para o reparo de equipamentos defeituosos a condição normal de funcionamento deverá 
ser de até 07 (sete) dias úteis. 
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3.5.1. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3.5.2. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de área 
para cadastro da solução de hardware ofertada, possibilitando assim que a CONTRATANTE 
possa receber de forma proativa, durante todo período da garantia as notificações de 
atualizações e correções (“hotfix”) da solução; 

3.5.3. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 
para suporte técnico e abertura de chamados técnicos. 

3.5.4. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica local 
no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por meio de 
documentação oficial do fabricante dos produtos e de domínio público, através de catálogos, 
folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso não seja 
comprovada por um dos meios citados anteriormente, será possível a comprovação através da 
apresentação de documentação expressa do fabricante dos equipamentos, indicando a referida 
assistência técnica que será responsável pelo atendimento e manutenção durante o período de 
garantia dos produtos ofertados. Em caso de documentação expressa do fabricante a esta 
deverá ser anexada uma procuração que comprove que a fabricante outorga ao procurador os 
poderes para firmar e declarar as exigências solicitadas. 

3.5.5. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da garantia 
ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

3.6.   Quanto aos itens 6, 7, 12, 13, 14, 15, 28 e  29, O equipamento ofertado deverá possuir 
garantia do fabricante do equipamento na modalidade on-site pelo período mínimo de 12 (doze) 
meses para reposição de peças, mão de obra e atendimento no local. O período da garantia o prazo 
máximo para o reparo de equipamentos defeituosos a condição normal de funcionamento deverá 
ser de até 07 (sete) dias úteis. 

3.6.1. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento. 

3.6.2. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da garantia 
ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 
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4 - DA PARTICIPAÇÃO. 
 
4.1.   Poderão participar deste pregão os interessados do ramo pertinente ao objeto licitado, 
obrigatoriamente, previamente cadastradas no Sistema de Cadastro Unificado de Fornecedores – 
SICAF, habilitação parcial, que atendam à linha de fornecimento e a todas as demais exigências 
deste Edital e seus anexos. 
 
4.2. Para participação neste Pregão, o licitante deverá manifestar, em campo próprio do 
sistema eletrônico, que cumpre plenamente os requisitos de habilitação e que sua proposta está em 
conformidade com as exigências do instrumento convocatório. 
 

4.2.1. A declaração falsa relativa ao cumprimento dos requisitos de habilitação e proposta 
sujeitará o licitante às sanções previstas neste Edital. 

 
4.3. No ato de envio de suas propostas, as Microempresas ou Empresas de Pequeno Porte 
deverão declarar, em campo próprio do Sistema do Pregão Eletrônico, que atendem aos requisitos 
do art. 3º da Lei Complementar nº 123/2006 para fazer jus aos benefícios previstos no referido 
diploma legal. 
 
4.4. Não será admitida nesta licitação a participação de empresas: 
 

4.4.1. em processo de recuperação judicial ou em processo de falência, sob concurso de 
credores, em dissolução ou em liquidação; 
 
4.4.2. que estejam suspensas de participar de licitação realizada pelo Tribunal Regional 
Eleitoral de Alagoas e empresas que tenham sido declaradas inidôneas para licitar ou 
contratar com a Administração Pública, enquanto perdurarem os motivos da punição; 
 
4.4.3. que estejam reunidas em consórcio e sejam controladoras, coligadas ou subsidiárias 
entre si, qualquer que seja sua forma de constituição; 
 
4.4.4. estrangeiras que não funcionem no País; 
 
4.4.5.  que tenham em seu quadro societário cônjuge, companheiro ou parente em linha reta, 
colateral ou por afinidade até o terceiro grau, inclusive, dos magistrados ocupantes de cargos 
de direção ou no exercício de funções administrativas, assim como de servidores ocupantes de 
cargos de direção, chefia e assessoramento vinculados direta ou indiretamente às unidades 
situadas na linha hierárquica da área encarregada da licitação, de acordo com o disposto no 
art. 2º da Resolução nº 07/2005 do Conselho Nacional de Justiça (com a nova redação dada 
pelo art. 1º da Resolução 229/2016-CNJ). 

 
5 - DA REPRESENTAÇÃO E DO CREDENCIAMENTO. 
 
5.1. Os licitantes ou seus representantes legais deverão estar previamente credenciados no 
site www.comprasnet.gov.br (Art. 3º do Decreto nº 5.450/05). 
 
5.2. O credenciamento do licitante, bem assim a sua manutenção, no site acima informado, 
dependerá de registro atualizado no Sistema de Cadastramento Unificado de Fornecedores – SICAF - 
Habilitação Parcial, que também será requisito obrigatório para fins de habilitação. 
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5.3. O credenciamento do licitante dar-se-á pela utilização de login e senha, para acesso ao 
sistema eletrônico no site www.comprasnet.gov.br, opção pregão eletrônico, criados quando do 
credenciamento supracitado. 
 
5.4. O credenciamento junto ao provedor do sistema implica a responsabilidade legal do 
licitante e a presunção de sua capacidade técnica para realização das transações inerentes ao 
pregão na forma eletrônica (Art. 3º, § 6º, do Decreto nº 5.450/05). 
 
5.5. O uso da senha de acesso pelo licitante é de sua responsabilidade exclusiva, incluindo 
qualquer transação efetuada diretamente ou por seu representante, não cabendo ao provedor do 
sistema ou ao TRE/AL, promotor da licitação, responsabilidade por eventuais danos decorrentes de 
uso indevido da senha, ainda que por terceiros (Art. 3º, § 5º, do Decreto nº 5.450/05). 
 
6 - DO ENVIO DA PROPOSTA DE PREÇOS. 
 

6.1. O licitante será responsável por todas as transações que forem efetuadas em seu nome 
no sistema eletrônico, assumindo como firmes e verdadeiras suas propostas, assim como os lances 
inseridos durante a sessão pública. (inciso III, do art. 13, do Decreto nº 5.450/2005). 
 

6.2. Incumbirá ao licitante acompanhar as operações no sistema eletrônico durante o 
processo licitatório, responsabilizando-se pelo ônus decorrente da perda de negócios diante da 
inobservância de quaisquer mensagens emitidas pelo sistema ou de sua desconexão (inciso IV, do 
art. 13, do Decreto 5.450/2005). 
 

6.3. A participação no pregão dar-se-á por meio da digitação de login e senha privativas do 
licitante e subsequente encaminhamento da proposta com a descrição do serviço ofertado, em 
campo próprio, que poderá ser feito a partir da data da disponibilização do Edital no site do 
www.comprasnet.gov.br e até a data e hora marcadas para abertura deste pregão, exclusivamente 
por meio do sistema eletrônico. 
 

6.3.1. Até a abertura da sessão, os licitantes poderão retirar ou substituir a proposta 
anteriormente apresentada (§ 4º do art. 21 do Decreto nº 5.450/2005). 

 

6.4.  Os licitantes deverão apresentar suas propostas de preços, utilizando do campo 
"descrição detalhada do objeto", contendo o seguinte: 
 

a) prazo de validade, a contar da data da abertura da sessão pública, observado o 
disposto no item 6.7 do edital; 
b) descrição de cada item que compõe o lote ofertado, de acordo com o Anexo I-A deste 
edital. 

 

6.4.1. Caso o campo seja preenchido com especificações diversas daquelas 
constantes no edital, deverá haver o cuidado, por parte do licitante, para que a descrição 
complementar não contrarie as especificações constantes no edital, sob pena de 
desclassificação. 
 

6.4.2. Serão irrelevantes quaisquer ofertas que não se enquadrem nas especificações 
exigidas, ou anexos não solicitados, considerando-se que pelo preço proposto o licitante 
obrigar-se-á ao fornecimento descrito neste edital. 
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6.4.2.1.  Entretanto, se da proposta constar condições materiais mais vantajosas 
que as exigidas neste edital elas não serão consideradas para efeito de 
escalonamento de ofertas, mas vincularão o proponente na execução contratual. 

 
6.4.3. Não podem constar da “descrição detalhada do objeto” qualquer tipo de 
identificação da empresa, seja nome, endereço, CNPJ, logotipo, ou qualquer outro dado 
capaz de identificar o licitante. Esta identificação somente constará na proposta ajustada 
encaminhada nos termos do item 10.1. 

 
6.4.4. Em campo próprio deverão ser inseridos marca e modelo do produto ofertado. 

 

6.5. As declarações referidas no subitem 11.1 “c” deverão ser enviadas em campo próprio do 
sistema Comprasnet, no momento da elaboração e envio da proposta pelos fornecedores, as quais 
serão visualizadas pelo Pregoeiro na fase de Habilitação, quando também poderá ser solicitado, via 
chat, pelo Pregoeiro, a alteração ou reenvio das mesmas pelo(s) vencedor(es). 
 

6.6. Nos preços ofertados deverão estar inclusas todas as despesas necessárias à perfeita 
execução das prestações contratuais, tais como tributos, encargos legais, embalagens, frete etc. 
 

6.7. O prazo de validade das propostas será de, no mínimo, 60 (sessenta) dias, contados da 
data de abertura da sessão pública. As propostas que o omitirem ou indicarem prazo de validade 
inferior ao mínimo permitido serão entendidas como válidas pelo período de 60 (sessenta) dias. 
 

6.8. Em caso de divergências verificadas entre as descrições relativas aos objetos desta 
licitação (Anexo I-A) e as descrições constantes no Catálogo de Materiais do “SIASG”, prevalecerão, 
sempre, as descrições constantes neste edital. 
 

6.9. Não serão aceitas propostas alternativas nem submetidas a termo, condição ou encargo. 
 

6.10. Todos os custos decorrentes da elaboração e apresentação de propostas serão de 
responsabilidade exclusiva do licitante, incluindo as transações que forem efetuadas em seu nome no 
sistema eletrônico ou de eventual desconexão. O Tribunal Regional Eleitoral de Alagoas não será 
responsável, em nenhum caso, pelos custos de tais procedimentos. 
 

6.11. O simples envio da proposta será interpretado como concordância com os termos deste 
edital, com o estipulado na Lei nº 10.520, de 17 de julho de 2002, no Decreto nº 5.450, de 31 de 
maio de 2005, e subsidiariamente pela Lei nº 8.666, de 21 de junho de 1993 e suas alterações 
posteriores, salvo se a proposta contiver disposição que contrarie expressamente quaisquer dos 
itens deste edital. 
 
7 - DA SESSÃO PÚBLICA E DIVULGAÇÃO DAS PROPOSTAS. 
 

7.1. O pregoeiro iniciará a sessão pública na data e horário previstos neste edital, via sistema 
eletrônico, com a divulgação das propostas de preços recebidas, as quais deverão estar em perfeita 
consonância com as especificações detalhadas no presente edital. 
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7.2.  As propostas que não atenderem aos requisitos constantes no presente edital ou que 
apresentarem preços manifestamente inexequíveis serão previamente desclassificadas pelo 
pregoeiro. 
 

7.2.1. A desclassificação de proposta será sempre fundamentada e registrada no 
sistema, com acompanhamento em tempo real por todos os licitantes. 

 

7.3.  O sistema ordenará, automaticamente, as propostas classificadas, sendo que somente 
estas participarão da fase de lances. 
 
8 - DA FORMULAÇÃO DOS LANCES. 
 

8.1.  Após a classificação das propostas, o pregoeiro dará início à etapa competitiva, 
oportunidade em que os licitantes poderão encaminhar lances, exclusivamente por meio do sistema 
eletrônico, sendo estes imediatamente informados do seu recebimento e respectivo horário de 
registro e valor. 
 

8.1.1. Os lances deverão ser ofertados pelo valor unitário de cada item que compõe o lote 
ofertado, sendo que o sistema efetuará automaticamente o somatório para efeito de 
escalonamento dos lances. 

 

8.2. Os licitantes poderão oferecer lances sucessivos, observado o horário fixado e as regras 
de aceitação dos mesmos. 
 

8.3. O licitante somente poderá oferecer lance inferior ao último por ele ofertado e registrado 
pelo sistema. 
 

8.4.  Havendo mais de um lance de igual valor, prevalecerá aquele que for recebido e 
registrado primeiro pelo sistema. 
 

8.5. Durante a sessão pública, os licitantes serão informados, em tempo real, do valor do 
menor lance registrado, vedada a identificação do licitante.  
 

8.6.  No caso de desconexão do pregoeiro, no decorrer da etapa competitiva do pregão 
eletrônico, o sistema eletrônico poderá permanecer acessível aos licitantes para a recepção dos 
lances, retomando o pregoeiro, quando possível, a sua atuação no certame, sem prejuízo dos atos 
realizados. 
 

8.6.1.  Quando a desconexão do pregoeiro persistir por tempo superior a 10 (dez) minutos, a 
sessão do pregão eletrônico será suspensa e terá reinício somente após comunicação aos 
licitantes participantes, no endereço utilizado para divulgação desta licitação. 

 

8.7.   A etapa de lances será encerrada por decisão do pregoeiro, mediante 
encaminhamento, pelo sistema eletrônico, de aviso de fechamento iminente dos lances. Após o que 
transcorrerá período de tempo de até 30 (trinta) minutos, aleatoriamente determinado pelo sistema 
eletrônico, findo o qual será encerrada, automaticamente, a recepção de lances. 
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8.8.  Após o encerramento da etapa de lances da sessão pública, o pregoeiro poderá 
encaminhar, pelo sistema eletrônico, contraproposta ao licitante que tenha apresentado lance mais 
vantajoso, para que seja obtida melhor proposta, observado o critério de julgamento, não se 
admitindo negociar condições diferentes daquelas previstas neste Edital. 
 
9 - DO JULGAMENTO DAS PROPOSTAS DE PREÇOS. 
 

9.1.  O pregoeiro efetuará o julgamento das Propostas de Preços pelo critério do menor 
preço por lote, decidindo sobre a aceitação do preço obtido. 
 
9.2.  Como critério de aceitabilidade dos preços, serão admitidos como limites máximos os 
valores estimados pela Administração, ou seja, os preços de referência, disponíveis no Anexo I-A 
deste edital, que representam uma média das várias propostas coletadas no mercado e, de modo 
algum, vinculam a decisão do Pregoeiro, que está autorizado a negociar em busca de preços 
inferiores. 

 
9.2.1. O critério de aceitabilidade será aferido em relação ao valor de cada item e em relação 
ao valor total do lote ofertado. 
 

9.3.  Será considerado vencedor deste pregão o licitante que oferecer o menor preço e tiver 
atendido a todas as exigências editalícias. 
 

9.4.  Analisada a aceitabilidade do preço obtido, o pregoeiro divulgará o resultado de 
julgamento das Propostas de Preços. 

 

9.5.  Se a proposta ou o lance, de menor preço, não for aceitável, ou se o licitante 
desatender às exigências habilitatórias, o pregoeiro examinará a proposta ou o lance subsequente, 
verificando a sua aceitabilidade e procedendo à sua habilitação, na ordem de classificação, e assim 
sucessivamente, até a apuração de uma proposta ou lance que atenda ao edital. 
 

9.5.1.  Ocorrendo a situação a que se refere este item, o pregoeiro poderá negociar 
com o licitante para que seja obtido preço melhor. 

 
10 – DO ENCAMINHAMENTO DA PROPOSTA E DA DOCUMENTAÇÃO. 
 

10.1.  A proposta ajustada ao lance final do licitante vencedor e os documentos exigidos para 
habilitação que não estejam contemplados no SICAF, caso necessário, deverão ser remetidos, como 
anexo, pelo sistema Comprasnet, quando solicitado pelo Pregoeiro. Junto com a documentação 
deverá ser encaminhado, também pelo sistema, os dados do licitante vencedor: Razão Social, 
endereço, telefone/fax, número do CNPJ/MF, banco, agência, número da conta corrente e praça de 
pagamento, podendo ser utilizado para tanto o modelo de planilha para contratação sugerido no 
ANEXO II. 

 

10.2. A licitante também deverá encaminhar, quando solicitado pelo pregoeiro, via sistema, a 
Planilha de Composição de Custos por Item, no modelo do Anexo I-B. 

 
11 - DA HABILITAÇÃO. 
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11 .1. A habilitação do licitante vencedor será verificada mediante a apresentação/obtenção da 
seguinte documentação: 
 

a) Quanto à Qualificação Jurídica e Fiscal: Situação do licitante perante o Sistema de 
Cadastro Unificado de Fornecedores – SICAF – Habilitação Parcial, após a análise e 
julgamento das Propostas de Preços, a ser obtida por meio de extrato “on line” do site do 
Comprasnet. 
 

a1.) Caso conste no cadastro do SICAF algum documento habilitatório com data de 
validade expirada, o pregoeiro poderá consultar o documento do licitante nos sítios 
das entidades responsáveis pelo referido tributo ou abrirá o prazo de 02 (dois) dias 
úteis para que o licitante o encaminhe, via protocolo. 

 
b) Quanto à regularidade trabalhista, esta deverá ser comprovada através de Certidão 
Negativa de Débitos expedida pela Justiça do Trabalho, em conformidade com a Lei 
Federal nº 12.440, de 07 de julho de 2011. 
 
c) Declarações que deverão ser efetuadas em campo específico do sistema Comprasnet, 
no momento da elaboração e envio da proposta, conforme item 6.5. do edital: 
 

c.1) Declaração de inexistência de fatos supervenientes impeditivos à habilitação da 
empresa; 
c.2)  Declaração de que a empresa não emprega menor de dezoito anos em trabalho 
noturno, perigoso ou insalubre, não emprega menor de dezesseis anos, salvo na 
condição de aprendiz, a partir dos quatorze anos; 
c.3)   Declaração de elaboração Independente de Proposta. 

 
e) Quanto à qualificação econômico-financeira: 

 
e.1) Certidão negativa de falência ou concordata expedida pelo distribuidor da sede 
da pessoa jurídica há menos de 90 (noventa) dias da data de abertura do certame.  

 
11.2. No momento em que forem verificados os documentos relativos à habilitação, o 
pregoeiro deverá verificar, também, a existência de registros impeditivos da contratação no 
Cadastro Nacional de Empresas Inidôneas e Suspensas da Controladoria Geral da União, disponível 
no Portal da Transparência (http://www.portaltransparencia.gov.br). 
 
11.3.  Havendo o registro de Ocorrências Impeditivas Indiretas de licitar, constatado em 
consulta ao SICAF, a empresa será convocada a apresentar, em 48 (quarenta e oito) horas, a contar 
da solicitação do pregoeiro no “chat”, esclarecimentos/documentos, comprovando sua idoneidade. 

 
11.3.1. Havendo necessidade de analisar minuciosamente os documentos exigidos, o 
Pregoeiro suspenderá a sessão, informando no “chat” a nova data e horário para a 
continuidade da mesma. 
 

11.4.  A comprovação da regularidade fiscal das licitantes, obrigatoriamente, Microempresas e 
Empresas de Pequeno Porte, será exigida para efeito de contratação, conforme estipula o art. 42 da 
LC nº 123/2006, observando o que dispõe o art. 4º, do Decreto nº 8.538/2015. 
 

11.4.1.         Na hipótese de haver alguma restrição relativa à regularidade fiscal quando da 
comprovação de que trata o item 11.4., será assegurado prazo de cinco dias úteis, prorrogável 
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por igual período, para a regularização da documentação, a realização do pagamento ou 
parcelamento do débito e a emissão de eventuais certidões negativas ou positivas com efeito 
de certidão negativa. 
 
11.4.2.   Para aplicação do disposto no subitem 11.4.1, o prazo para regularização fiscal será 
contado a partir da divulgação do resultado da fase de habilitação. 
 
11.4.3. A prorrogação do prazo previsto no subitem 11.4.1., poderá ser concedida, a 
critério da administração pública, quando requerida pelo licitante, mediante apresentação de 
justificativa. 
 
11.4.4. A abertura da fase recursal em relação ao resultado do certame ocorrerá após  os 
prazos de regularização fiscal de que tratam os subitens 11.4.1. e 11.4.3. 
 
11.4.5.           A não regularização da documentação no prazo previsto nos subitens 11.4.1. e 
11.4.3. implicará decadência do direito à contratação, sem prejuízo das sanções previstas no 
art. 87 da Lei nº 8.666, de 1993, sendo facultado à administração pública convocar os 
licitantes remanescentes, na ordem de classificação, ou revogar a licitação. 

 
11.5. Os licitantes que deixarem de apresentar quaisquer dos documentos exigidos para a 
habilitação na presente licitação, ou os apresentarem em desacordo com o estabelecido neste 
Edital ou com irregularidades, ressalvado o disposto na alínea a.1 do item 11.1. e no item 11.4.1, 
serão inabilitados, não se admitindo complementação posterior. 
 
11.6. Não serão aceitos protocolos de entrega ou solicitação de documento em substituição 
aos documentos requeridos no presente Edital. 
 
11.7. Os documentos relacionados neste Edital referir-se-ão sempre ao domicílio da empresa 
licitante cadastrada no SICAF. 
 
11.8. Para fins de habilitação, a verificação pelo TRE/AL nos sítios oficiais de órgãos e 
entidades emissores de certidões constitui meio legal de prova. 
 
12 – DO CRITÉRIO DE DESEMPATE. 
 
12.1. Será assegurado, como critério de desempate, preferência de contratação a 
Microempresas e Empresas de Pequeno Porte, conforme disposto no art. 44 da Lei Complementar nº 
123/2006. 
 

12.1.1. Entende-se por empate aquelas situações em que as propostas apresentadas pelas 
Microempresas e Empresas de Pequeno Porte sejam iguais ou até 5% (cinco por cento) 
superiores à proposta mais bem classificada. 
 
12.1.2. O subitem anterior somente será aplicado quando a melhor oferta inicial não tiver sido 
apresentada por microempresa ou empresa de pequeno porte. 
 
12.1.3. Para identificação da situação de empate, o Sistema de Pregão Eletrônico, após 
encerramento da fase de lances identificará, em coluna própria as Microempresas e Empresas 
de Pequeno Porte participantes, fazendo a comparação entre os valores da primeira colocada, 
caso esta não seja uma Microempresa ou Empresa de Pequeno Porte, e das demais 
Microempresas e Empresas de Pequeno Porte, na ordem de classificação. 
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12.2. Após o encerramento de todos os itens, para cada item que teve uma empresa de médio 
ou grande porte como vencedora do melhor lance, o sistema selecionará todas as Microempresas e 
Empresas de Pequeno Porte cujo último lance enviado, para o item, seja até 5% (cinco por cento) 
superior à oferta vencedora. Após este procedimento, o sistema enviará mensagem, via chat, 
informando quais os itens terão desempate no lance. 
 
12.3. Para efeito do disposto no item 12.1, ocorrendo o empate, proceder-se-á da seguinte 
forma: 
 

I – A Microempresa ou Empresa de Pequeno Porte mais bem classificada poderá apresentar 
proposta de preço inferior àquela considerada vencedora do certame, situação em que lhe 
será adjudicado o objeto licitado. Para viabilizar tal procedimento, o Sistema selecionará os 
itens com tais características, disponibilizando-os automaticamente nas telas do pregoeiro e 
fornecedor, encaminhado mensagem também automática, por meio do chat, convocando a 
Microempresa ou Empresa de Pequeno Porte que se encontra em segundo lugar, a fazer sua 
última oferta no prazo de 5 (cinco) minutos, sob pena de decair do direito concedido; 
 
II – Caso a Microempresa ou Empresa de Pequeno Porte classificada em segundo lugar desista 
ou não se manifeste no prazo estabelecido, o Sistema convocará as demais Microempresas ou 
Empresas de Pequeno Porte participantes na mesma condição, na ordem de classificação; 
 
III – Havendo êxito neste procedimento, o Sistema disponibilizará a nova classificação dos 
fornecedores para fins de aceitação. Não havendo êxito, ou não existindo Microempresa ou 
Empresa de Pequeno Porte participante, prevalecerá a classificação inicial; 
 
IV – Caso sejam identificadas propostas de Microempresas ou Empresas de Pequeno Porte 
empatadas em segundo lugar, ou seja, na faixa dos 5% (cinco por cento) da primeira colocada, 
e permanecendo o empate até o encerramento do item, o sistema fará um sorteio eletrônico 
entre tais fornecedores, definindo e convocando automaticamente a vencedora para o 
encaminhamento da oferta final do desempate; 
 
V – A negociação de preço junto ao fornecedor classificado em primeiro lugar, quando houver, 
será sempre após o procedimento de desempate de proposta e classificação final dos 
fornecedores participantes. 

 
12.4. Para todos os cálculos efetuados, serão levadas em consideração duas casas decimais, 
sendo desprezadas as demais.  
 
12.5. Se durante o desempate houver suspensão do pregão ou do item, o tempo será 
interrompido. Quando o pregão ou item for reaberto, o tempo será retomado de onde parou. 
 
13 – DO CRITÉRIO DE PREFERÊNCIA. 

13.1.  Este pregão submete-se às regras relativas ao direito de preferência estabelecidas no 
Decreto nº 7.174/2010. 
 
 
14 - DA IMPUGNAÇÃO E PEDIDOS DE ESCLARECIMENTOS. 
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14.1. Até 02 (dois) dias úteis antes da data fixada para abertura da sessão pública, qualquer 
pessoa poderá impugnar o ato convocatório do presente pregão, enviando a peça impugnatória ao 
endereço eletrônico slc@tre-al.jus.br. 
 

14.1.1. Caberá ao Pregoeiro, auxiliado pela seção responsável pela elaboração do edital, 
decidir sobre a impugnação no prazo de até 24h (vinte e quatro horas). 

 

14.1.2.  Acolhida a impugnação contra o ato convocatório, será definida e publicada nova data 
para realização do certame. 

 

14.2. Os pedidos de esclarecimentos referentes a este Edital deverão ser enviados à Seção de 
Licitações e Contratos, até três dias úteis anteriores à data fixada para a abertura da sessão 
pública, exclusivamente por meio eletrônico via Internet, para o endereço de e-mail: slc@tre-
al.jus.br, cujas respostas serão disponibilizadas nos avisos referentes a este Pregão, no site do 
TRE/AL: www.tre-al.jus.br e no site www.comprasnet.gov.br. 
 
15- DOS RECURSOS. 
 
15.1.  Existindo intenção de interpor recurso, o licitante deverá manifestá-la ao pregoeiro, 
exclusivamente por meio eletrônico, em formulário próprio, explicitando sucintamente suas razões, 
logo após a fase de habilitação. 
 
15.2.  O Pregoeiro informará, via chat, o tempo para a recepção, pelo sistema eletrônico, da 
intenção de recurso, abrindo em seguida este prazo e fechando ao término do tempo informado. 
 
15.3.  Caso tenha havido registro de intenção de manifestação de recurso, o Pregoeiro decidirá 
sobre sua admissibilidade. Sendo admissível a manifestação de recurso registrada, o sistema abrirá 
formulário próprio para o registro das razões do recurso, no prazo de 3 (três) dias, as quais poderão 
ser impugnadas pelos demais licitantes, desde logo intimados para, querendo, apresentar 
contrarrazões em igual prazo, exclusivamente por meio eletrônico, e após julgadas pelo Pregoeiro, 
submeterá a sua decisão à autoridade competente. 

 
15.4.  O acolhimento do recurso implica tão somente na invalidação daqueles atos que não 
sejam passíveis de aproveitamento. 
 
15.5.  A falta de manifestação eletrônica de intenção de recorrer, no prazo estipulado pelo 
Pregoeiro, importará a decadência do direito de recurso e a adjudicação do objeto pelo pregoeiro ao 
vencedor. 
 
16 - DA ADJUDICAÇÃO E HOMOLOGAÇÃO. 
 
16.1.  A adjudicação do objeto do presente certame será viabilizada pelo pregoeiro sempre que 
não houver recurso. 
 
16.2.  A homologação da licitação é de responsabilidade da autoridade competente e só poderá 
ser realizada depois da adjudicação do objeto ao proponente vencedor pelo pregoeiro, ou, quando 
houver recurso, pela própria autoridade competente. 
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16.3.  Antes da adjudicação pelo pregoeiro, será feita consulta ao CADIN – Cadastro Informativo 
de Créditos não Quitados do Setor Público Federal, nos termos do Inciso III do Art. 6º da Lei nº 
10.522, de 19/07/2002. 
 
17 - DO REAJUSTE DO PREÇO. 
 
17.1.  Os preços ofertados serão fixos e irreajustáveis. No entanto, os valores constantes da Ata 
de Registro de Preços admitem revisão na forma disciplinada no Decreto nº 7.892/2013. 
 
18 - DA HOMOLOGAÇÃO, DA ATA DE REGISTRO DE PREÇOS E DA CONTRATAÇÃO. 
 
18.1. A adjudicação do objeto do presente certame será viabilizada pelo pregoeiro sempre que 
não houver recurso. 
 

18.1.1. Antes da adjudicação pelo pregoeiro, será feita consulta ao CADIN – Cadastro 
Informativo de Créditos não Quitados do Setor Público Federal, nos termos do Inciso III do Art. 
6º da Lei 10.522, de 19/07/2002. 

 
18.2. A homologação da licitação é de responsabilidade da autoridade competente e só poderá 
ser realizada depois da adjudicação do objeto ao proponente vencedor pelo pregoeiro, ou, quando 
houver recurso, pela própria autoridade competente. 
 
18.3. Homologado o resultado da licitação, os fornecedores classificados, observado o disposto 
no art. 11 do Decreto nº 7.892/2013, serão convocados para assinar a ata de registro de preços, 
dentro do prazo e condições estabelecidos no subitem 18.3.1., podendo ser prorrogado uma vez, 
por igual período, quando solicitado pelo fornecedor e desde que ocorra motivo justificado aceito 
pela administração. 
 

18.3.1. O cadastro de reserva dos fornecedores classificados a que se refere o item anterior 
será elaborado desde que viabilizado pelo sistema Comprasnet, tal como previsto no art. 26 do 
decreto acima citado. 
 
18.3.2. O licitante vencedor deverá devolver a Ata de Registro de Preços assinada dentro do 
prazo de 05 (cinco) dias úteis, a contar do recebimento da convocação para assinatura do 
documento, em conformidade com o previsto no art. 64 da Lei n. 8.666/1993. 

 
18.4. É facultado à administração, quando o convocado não assinar a ata de registro de preços 
no prazo e condições estabelecidos, convocar os licitantes remanescentes, na ordem de 
classificação, para fazê-lo em igual prazo e nas mesmas condições propostas pelo primeiro 
classificado. 
 
18.5. A ata de registro de preços implicará compromisso de fornecimento nas condições 
estabelecidas, após cumpridos os requisitos de publicidade. 
 
18.6. A recusa injustificada de fornecedor classificado em assinar a ata, dentro do prazo 
estabelecido no subitem 18.3.2, ensejará a aplicação das penalidades aludidas no item 18.12 deste 
edital, bem como às do art. 28 do Decreto n. 5.450/2005. 
 
18.7. A contratação com os fornecedores registrados será formalizada pelo órgão interessado 
por intermédio de instrumento contratual, emissão de nota de empenho de despesa, autorização de 
compra ou outro instrumento hábil, conforme o art. 62 da Lei nº 8.666, de 1993. 
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18.8. Após a devolução da Ata de Registro de Preços assinada, a licitante poderá receber a 
Nota de Empenho e a Autorização de Fornecimento, devendo confirmar o seu recebimento. 
 
18.9. A recusa na aceitação da nota de empenho e da Autorização de Fornecimento deverá ser 
expressa, escrita e justificada, o que será encaminhado para a autoridade competente que 
procederá à análise dos motivos acostados pelo licitante, decidindo acerca da aceitabilidade ou não 
da justificativa. 
 
18.10. Caso a justificativa não seja encaminhada na forma descrita ou esta não seja aceita pela 
autoridade competente, o prazo para a entrega continuará fluindo normalmente, e em não sendo 
cumprido, sujeitará o licitante às penalidades cabíveis. 
 
18.11. Os contratos decorrentes do Sistema de Registro de Preços poderão ser alterados, 
observado o disposto no art. 65 da Lei nº 8.666, de 1993 e no art. 12, § 3º do Decreto nº 
7.892/2013. 
 
18.12. O registro do fornecedor será cancelado quando: 
 
a) descumprir as condições da Ata de Registro de Preços; 
 
b) não retirar a nota de empenho ou instrumento equivalente no prazo estabelecido pela 
Administração, sem justificativa aceitável; 
 
c) não aceitar reduzir o seu preço registrado, na hipótese deste se tornar superior àqueles 
praticados no mercado; ou 
 
d) sofrer sanção prevista nos incisos III ou IV do caput do art. 87 da Lei nº 8.666, de 1993, ou no art. 
7º da Lei nº 10.520, de 2002. 
 

18.12.1. O cancelamento de registros nas hipóteses previstas nas alíneas “a”, “b” e “d” 
do subitem 18.12. será formalizado por despacho do órgão gerenciador, assegurado o 
contraditório e a ampla defesa. 

 
18.12.2. O cancelamento do registro de preços poderá ocorrer por fato superveniente, 
decorrente de caso fortuito ou força maior, que prejudique o cumprimento da ata, 
devidamente comprovados e justificados: 

 
a) por razão de interesse público; ou 
 
b) a pedido do fornecedor. 

 
18.13. O licitante vencedor somente poderá subcontratar, em parte, o objeto desta licitação, se 
for conveniente para a Administração deste Tribunal, mediante prévia e escrita autorização desta, 
sob pena de sofrer as sanções contratuais e legais. 
 

18.13.1. O licitante vencedor não poderá transferir a terceiros nenhuma responsabilidade, em 
caso de subcontratação autorizada. 

 
18.14. O licitante vencedor obriga-se a manter, durante a vigência do Registro de Preços, em 
compatibilidade com as obrigações por ele assumidas, todas as condições de habilitação e 
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qualificação exigidas na licitação, renovando as certidões e encaminhando-as ao Tribunal Regional 
Eleitoral de Alagoas, no prazo máximo de 48 (quarenta e oito) horas a partir da solicitação das 
mesmas. 
 
18.15. A Ata de Registro de Preços, durante sua vigência, poderá ser utilizada por qualquer 
órgão ou entidade da administração pública federal que não tenha participado do certame 
licitatório, mediante anuência do órgão gerenciador, observadas, ainda, as demais regras impostas 
no art. 22 do Decreto n.º 7.892/2013. 
 
18.16. As aquisições ou contratações adicionais a que se refere o subitem 18.15 não poderão 
exceder, por órgão ou entidade, a cinquenta por cento dos quantitativos dos itens do instrumento 
convocatório e registrados na ata de registro de preços para o órgão gerenciador e órgãos 
participantes. 
 
18.17. O quantitativo decorrente das adesões à ata de registro de preços não poderá exceder, 
na totalidade, ao dobro do quantitativo de cada item registrado na ata de registro de preços para o 
órgão gerenciador e órgãos participantes, independente do número de órgãos não participantes que 
aderirem.  
 
19 – DO RECEBIMENTO DO OBJETO. 
 
19.1.  O objeto deverá ser entregue, no prazo previsto no item 3 deste edital, por e-mail ou ofício, 
o que ocorrer primeiro, no horário de expediente normal, de segunda a sexta-feira, na Seção de 
Almoxarifado do Tribunal Regional Eleitoral de Alagoas, localizada na Avenida Menino Marcelo 
(antiga via expressa), nº 7.200 D – Serraria, Maceió/AL, CEP: 57046-005, sob agendamento através 
do telefone (82) 3328-1947. 
 
19.2. O objeto será recebido: 

 
a) provisoriamente, para que seja feita a verificação da conformidade dos mesmos com 
as especificações. 
 

b) definitivamente, após avaliação e homologação pelos responsáveis técnicos do Tribunal, da 
seguinte forma: 

b.1) O exame para comprovação das características técnicas consistirá em avaliações e 
testes não-destrutivos, por amostragem realizados em duas etapas: 

a. Primeira: inspeção visual de todos os equipamentos entregues; 
b. Segunda: testes funcionais de configuração e desempenho, em, no mínimo, 10% (dez 

por cento) e não menos do que 01 (um) dos equipamentos recebidos. O Tribunal 
poderá, a seu critério, executar os testes nos demais equipamentos, dentro de 
um critério de razoabilidade, podendo chegar a 100% dos quantitativos, mas dentro de 
um prazo máximo de 30 (trinta) dias corridos e contados de cada lote de 
equipamentos. 

b.2) As especificações serão avaliadas também por meio de documentos técnicos que 
acompanham os equipamentos, informações fornecidas pela Contratada e disponível no 
sítio do fabricante; 
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b.3) A comissão do Tribunal deverá, após a comprovação do perfeito funcionamento dos 
equipamentos e adequação às especificações técnicas, emitir e assinar o Termo de 
Recebimento Definitivo. 

19.3. O produto será rejeitado no caso de incompatibilidade com as especificações previstas 
na proposta ou quando inadequado à sua utilização. 
 
19.4. O prazo para a Secretaria competente proceder às verificações, após o recebimento 
provisório, será de 05 (cinco) dias úteis, quando deverá se manifestar, aceitando ou recusando o 
item objeto do fornecimento. 
 
19.5. Os recebimentos provisório e definitivo se darão mediante formulário próprio. 
 
19.6. O recebimento definitivo não exime o fornecedor de responder pelos vícios aparentes e 
ocultos segundo as disposições deste termo e as normas de proteção ao consumidor. 
 
19.7. O objeto que estiver em desacordo com as especificações do edital terá seu recebimento 
recusado, devendo o fornecedor, dentro do prazo de 10 (dez) dias corridos, substituir o produto 
adequadamente, sujeitando-se à multa prevista na Seção 18. 
 
20 – DAS SANÇÕES ADMINISTRATIVAS. 
 
20.1.  Com fundamento no artigo 7º da Lei nº 10.520/2002 e, subsidiariamente, nos artigos 86 e 
87 da Lei 8.666/1993, a Contratada ficará sujeita, assegurada prévia e ampla defesa, às seguintes 
penalidades:  
 
a. Advertência:  
 

i. A Contratada será notificada formalmente em caso de descumprimento de obrigação 
contratual e terá que apresentar as devidas justificativas em um prazo de até 5 (cinco) dias úteis 
após o recebimento da notificação; e 

 
ii. Caso não haja manifestação dentro desse prazo ou se entenda serem improcedentes as 
justificativas apresentadas, a Contratada será advertida. 

 
b. Multa de: 

 
i. 0,5% (meio por cento) por dia, e por ocorrência, sobre o valor do objeto com atraso 
injustificado, limitada a incidência a 20 (vinte) dias corridos; 

- No caso de atraso injustificado na entrega do objeto por prazo superior a 20 
(vinte) dias corridos, com a aceitação pela Administração, será aplicada a multa de 10% sobre o 
valor da Ordem de Fornecimento; e 

-  No caso de atraso injustificado na prestação dos serviços por prazo superior a 20 (vinte) dias 
corridos, com a não aceitação pela Administração, será aplicada a penalidade 20% sobre o valor 
da Ordem de Fornecimento, no caso de inexecução total da obrigação, podendo haver, ainda, o 
cancelamento do registro de preços do Fornecedor. 

ii. 10% sobre o valor constante da Ordem de Fornecimento, no caso de inexecução parcial 
da obrigação assumida; 
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iii. 20% (vinte por cento) sobre o valor adjudicado, em caso de inexecução total da obrigação 
assumida; 

iv. 10% sobre o valor global da Ata de Registro de Preços, na hipótese de recusa em assinar a Ata 
ou retirar a Ordem de Fornecimento; 

c. Impedimento de licitar e contratar com a União e descredenciamento do SICAF pelo prazo de até 
5 (cinco) anos, sem prejuízo das demais penalidades legais; e  
 
d. Declaração de inidoneidade para licitar ou contratar com a Administração Pública.  

 
20.2.    O cometimento reiterado de atrasos injustificados dos prazos previstos para 
entrega/solução do chamado de garantia dos equipamentos poderá resultar no cancelamento do 
instrumento de fornecimento com a Contratada. 
 
20.3.   As sanções previstas nos itens "20.1.a", “20.1.c” e “20.1.d” poderão ser aplicadas, 
cumulativamente ou não, à pena de multa.  
 
20.4.   O valor da multa, aplicada após o regular processo administrativo, será descontado de 
pagamentos eventualmente devidos à contratada ou cobrado judicialmente;  
 
20.5.   Excepcionalmente, ad cautelam, a Administração poderá efetuar a retenção do valor 
presumido da multa, antes da instauração do regular procedimento administrativo. 
 
20.6.   O valor da multa, apurado após regular procedimento administrativo, será descontado 
dos pagamentos eventualmente devidos pelo TRE/AL ou cobrado judicialmente. 
 
20.7.   Na aplicação das penalidades previstas nesta Seção a autoridade competente sempre 
se valerá dos princípios da proporcionalidade, da razoabilidade e da prevalência e indisponibilidade 
do interesse público, em decorrência de circunstâncias fundamentadas em fatos comprovados. 
 
20.8.   O licitante contratado, quando não puder cumprir os prazos estipulados para o 
fornecimento do material, total ou parcialmente, deverá apresentar justificativa por escrito, 
devidamente comprovada, e em documento contemporâneo à sua ocorrência, acompanhada de 
pedido de prorrogação, nos casos de ocorrência de fato superveniente, excepcional ou imprevisível, 
estranho à vontade das partes, que altere fundamentalmente as condições do contrato, ou que 
impeça a sua execução, por fato ou ato de terceiro reconhecido pela Administração.  
 
20.9.  Do ato que aplicar as penalidades caberá recurso na forma do art. 109 da Lei nº 
8.666/1993. 
 
20.10.  Se o licitante contratado não recolher o valor da multa que lhe for aplicada, dentro de 05 
(cinco) dias úteis a contar da data da intimação para o pagamento, a importância será descontada 
automaticamente, ou ajuizada a dívida, consoante o § 3º do art. 86 e § 1º do art. 87 da Lei nº 
8.666/1993, acrescida de juros moratórios de 0,5% (meio por cento) ao mês. 
 
20.11.  O TRE/AL promoverá o registro no SICAF de toda e qualquer penalidade imposta ao 
licitante contratado. 
 
20.12.  O período de atraso será contado em dias corridos. 
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20.13. No caso de aplicação de penalidade em que a contratada tenha que pagar multa através 
de Guia de Recolhimento da União – GRU, e não o faça no devido prazo, o índice utilizado para 
atualização do valor será o IPCA. 
 
20.14. A data a ser utilizada como referência para a atualização do débito será a da publicação 
da decisão da aplicação da penalidade no Diário Eletrônico.  
 
20.15.  Fica estabelecido que os casos omissos serão resolvidos entre as partes contratantes, 
respeitados o objeto da presente licitação, a legislação e demais normas reguladoras da matéria, 
em especial as Leis nos 8.666/1993 e  10.520/2002, aplicando-lhes, quando for o caso, 
supletivamente, os princípios da Teoria Geral dos Contratos e as disposições do Direito Privado. 
 
20.16.  Os atos administrativos de aplicação das sanções, com exceção de advertência, multa de 
mora e convencional, serão publicados resumidamente no Diário Oficial da União. 
 
21 - DO PAGAMENTO. 
 
21.1.  O pagamento será efetuado mediante ordem bancária de crédito em conta corrente, em 
até 10 (dez) dias, após o recebimento da Nota Fiscal respectiva, a qual deverá ser entregue 
somente após a prestação dos serviços, devendo a contratada atender os seguintes requisitos: 

a) Apresentação de nota fiscal de acordo com a legislação vigente à época da emissão (nota 
fiscaleletrônica, se for o caso), acompanhada do Certificado de Regularidade do FGTS – CRF, 
comprovando regularidade com o FGTS; da Certidão Conjunta Negativa de Débitos Relativos a 
Tributos Federais e à Dívida Ativa da União, que incluindo as referentes a contribuições 
previdenciárias, expedida pela Secretaria da Receita Federal; e da Certidão Negativa de 
Débitos Trabalhistas – CNDT, emitida pela Justiça do Trabalho; e da prova de regularidade para 
com as Fazendas Estadual e Municipal do domicílio ou sede do Fornecedor; e 

b) Inexistência de fato impeditivo para o qual tenha concorrido o Fornecedor. 

21.2.  Eventuais penalidades poderão ser descontadas do pagamento. 
 
21.3.  Em nenhuma hipótese haverá antecipação de pagamento. 
 
21.4.  O TRE/AL, por ocasião de cada pagamento, fará as retenções e recolhimentos fiscais 
determinados pela legislação tributária. 
 
21.5.  Se a empresa for optante pelo SIMPLES, deverá anexar à nota fiscal documento que 
comprove tal opção, para que sobre o valor do pagamento não incidam as retenções de que trata o 
item anterior. 
 
21.6.  Havendo atraso no pagamento, o valor devido deverá ser acrescido de encargos 
moratórios, apurados desde a data do primeiro dia útil do atraso, até a data do efetivo pagamento, 
desde que o contratado não tenha concorrido para tanto, mediante a aplicação da seguinte 
fórmula: 
 
EM = I x N x VP, 
 
Onde: 
EM= Encargos Moratórios 

Edital do PE nº 39/2019 (0584653)         SEI 0008478-63.2018.6.02.8000 / pg. 738



 
TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS 

SEÇÃO DE LICITAÇÕES E CONTRATOS 

 

19 
 

 

 

N= Número de dias entre a data prevista para o pagamento e a do efetivo pagamento; 
VP = Valor da parcela a ser paga; 
I= Índice de atualização financeira= 0,0001644, assim apurado: 
 
I = (TX/100)                  I= (6/100)           I = 0,0001644 
         365                             365 
TX= Percentual de Taxa Anual= 6% 

21.7.  Nenhum pagamento será efetuado à Contratada enquanto pendente de liquidação 
qualquer obrigação. Esse fato não será gerador de direito a reajustamento de preços ou a 
atualização monetária. 

22 – DA DOTAÇÃO ORÇAMENTÁRIA. 
 
22.1.  As despesas decorrentes da execução do contrato correrão à conta dos recursos 
lançados na Proposta Orçamentária Anual deste Tribunal para o exercício 2019, alocados no 
Programa de Trabalho - PTRES nº 084621 (Julgamento de causas e gestão administrativas) - Natureza 
da Despesa nº 44.90.52 (Equipamentos e Material Permanente) e 33.90.39 (Outros Serviços de 
Terceiros - Pessoa Jurídica). 
 
22.2.  As despesas referentes aos exercícios subsequentes correrão à conta das dotações 
orçamentárias respectivas. 
 
23 - DAS OBRIGAÇÕES DO ÓRGÃO GERENCIADOR. 
 
23.1. São obrigações do Órgão Gerenciador: 
 

a) Gerenciar a presente Ata, indicando, sempre que solicitado, o nome do detentor da ata, o 
preço, e as especificações dos materiais registrados, observada a ordem de classificação 
indicada na licitação; 
 
b) Observar para que, durante a vigência da presente ata, sejam mantidas todas as condições 
de habilitação e qualificação exigidas na licitação, bem assim, a compatibilidade com as 
obrigações assumidas; 
 
c) Conduzir eventuais procedimentos administrativos de renegociação de preços registrados, 
para fins de adequação às novas condições de mercado, e de aplicação de penalidades; 
 
d) Acompanhar a evolução dos preços de mercado, com a finalidade de verificar sua 
compatibilidade com aqueles registrados na Ata; 
 
e) Acompanhar e fiscalizar o cumprimento das condições ajustadas na presente Ata; 
 
f) Aplicar, garantida a ampla defesa e o contraditório, as penalidades decorrentes do 
descumprimento do pactuado na ata de registro de preços ou do descumprimento das 
obrigações contratuais, em relação às suas próprias contratações; 
 
g) Consultar o detentor da ata registrada (observada a ordem de classificação) quanto ao 
interesse em fornecer o material a outro(s) órgão(s) da Administração Pública que externe(m) 
a intenção de utilizar a presente Ata, conforme subitem 18.15. 
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23.2. São, ainda, obrigações do órgão gerenciador da ata, na condição de contratante: 

 

a) Efetuar o pagamento à Contratada, após o recebimento definitivo; 
b) Acompanhar e fiscalizar a execução do objeto da Ata de Registro de Preços e 

do(s) contrato(s) dela decorrentes, por meio de servidor(es) designado(s), 
de modo a garantir o fiel cumprimento do mesmo e da proposta; 

c) Manter arquivo, junto ao processo administrativo ao qual está vinculado o presente termo,  
toda a documentação referente ao mesmo; 

d) Proporcionar todas as facilidades indispensáveis à boa execução das obrigações contratuais; 
e 

e) Aplicar as sanções conforme previsto no contrato, assegurando à Contratada o contraditório 
e ampla defesa. 

24 - DAS OBRIGAÇÕES DO DETENTOR DA ATA. 
 

24.1.  São obrigações do detentor da Ata: 
 

a) Providenciar a imediata correção de deficiências, falhas ou irregularidades constatadas pelo 
ÓRGÃO GERENCIADOR referentes às condições firmadas na presente Ata; 
 
b) Viabilizar o atendimento das condições firmadas a partir da data da publicação da presente 
Ata; 
 
c) Manter, durante o prazo de vigência da presente Ata, todas as condições de idoneidade 
exigidas na licitação, além de se sujeitar às demais disposições do Código de Proteção e 
Defesa do Consumidor (Lei n° 8.078/90) que sejam compatíveis com o regime de direito 
público; 
 
d) Informar, no prazo máximo de 05 (cinco) dias úteis, contados do recebimento da 
notificação, quanto à aceitação ou não do fornecimento de material a outro órgão da 
Administração Pública (não participante) que venha a manifestar o interesse de utilizar a 
presente Ata, conforme item 18.15. 

 
24.2. São ainda obrigações do detentor da Ata, na condição de contratado: 

 
a) Executar o contrato em estrita conformidade com as disposições e especificações do 
Edital e com os termos da proposta de preços; 

b) Fornecer os equipamentos conforme especificações, quantidades, prazos e demais 
condições estabelecidas no Edital, na Ata de Registro de Preços, na Ordem de 
Fornecimento e na Proposta de preços; 

c) Fornecer a documentação necessária à instalação e à operação dos produtos 
(manuais, termos de garantia, etc.), completa, atualizada e em português do Brasil, caso 
exista, ou em inglês; 

d) Disponibilizar Central de Atendimento para a abertura e fechamento de chamados 
técnicos, conforme períodos, horários e condições estabelecidas no Edital e em seus 
Anexos; 
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e) Comunicar formal e imediatamente ao Gestor ou Responsável Técnico da 
Administração sobre mudanças nos dados para contato com a Central de Atendimento; 

f) Prestar as informações e os esclarecimentos que venham a ser solicitados pelo 
representante da Administração, referentes a qualquer problema detectado ou ao 
andamento de atividades da garantia; 

g)  Responder por quaisquer prejuízos que seus profissionais causarem ao patrimônio da 
Administração ou a terceiros, por ocasião da execução do objeto, procedendo 
imediatamente aos reparos ou às indenizações cabíveis e assumindo o ônus decorrente; 

h) Responsabilizar-se integralmente pelo fornecimento dos equipamentos e pela 
execução dos serviços de garantia técnica, primando pela qualidade, desempenho, 
eficiência e produtividade na execução dos trabalhos, dentro dos prazos estipulados e 
cujo descumprimento será considerado infração passível de aplicação das penalidades 
previstas no Termo de Referência (Anexo I); 

i) Comunicar ao Gestor ou Responsável Técnico, formal e imediatamente, todas as 
ocorrências anormais e/ou que possam comprometer a execução do objeto; 
 
j) Manter sigilo sobre todo e qualquer assunto de interesse da Administração ou de 
terceiros de que tomar conhecimento em razão da execução do objeto, respeitando 
todos os critérios estabelecidos, aplicáveis aos dados, informações, regras de negócios, 
documentos, entre outros pertinentes, sob pena de responsabilidade civil, penal e 
administrativa; 

 
k) Cumprir e garantir que seus profissionais estejam cientes, aderentes e obedeçam 
rigorosamente às normas e aos procedimentos estabelecidos na Política de Segurança da 
Informação do TRE/AL; 

 
l) Responsabilizar-se pela conservação dos ambientes onde desempenhe as atividades 
necessárias para prestar a garantia on-site; 

 
m) Prestar as informações e os esclarecimentos que venham a ser solicitados pela 
Administração, referentes a qualquer problema detectado ou ao andamento de 
atividades da garantia técnica. 
 
n) Indicar endereço eletrônico (e-mail) para o recebimento de expedientes/notificações 
enviadas pelo TRE/AL, sendo considerados válidos todos os expedientes/notificações 
enviadas ao endereço eletrônico indicado; 
 
o) Manter durante a execução do contrato todas as condições que culminaram em sua 
habilitação, principalmente a regularidade fiscal e previdenciária, condições de 
idoneidade exigidas na licitação e outras previstas na legislação vigente e na aplicável à 
natureza dos serviços objeto da contratação; 
 
p) Aceitar o cancelamento da ordem de fornecimento por parte da Administração, no 
caso de fornecimento/entrega, em final de exercício e posterior ao dia 15 de dezembro 
ou dia útil imediatamente subsequente, em decorrência dos efeitos da Emenda 
Constitucional nº 95/2016, sem a reversão de qualquer ônus à Administração. 
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q) Apresentar certidões de quitação junto à Receita Federal, Dívida Ativa da União, INSS, 
FGTS, Fazenda Estadual e Fazenda  Municipal ou estar registrada junto ao SICAF em 
condição regular; 
 
r) Acatar outras determinações previstas na legislação aplicável à natureza do objeto 
deste contrato; 
 
s) Cumprir com outras obrigações decorrentes da aplicação do Código de Proteção e 
Defesa do Consumidor (Lei nº 8.078/1990) que sejam compatíveis com o regime de 
Direito Público. 

 
 
25 - DA PUBLICIDADE. 
 
25.1. O preço registrado com indicação dos fornecedores será divulgado no Portal de Compras 
do Governo federal e ficará disponibilizado durante a vigência da ata de registro de preços, em 
conformidade com o disposto no art. 11, inciso II do Decreto n.º 7.892/2013 combinado com o art. 
15, 2º da Lei nº 8.666/93. 
 
25 – DA VEDAÇÃO DE AQUISIÇÃO SEPARADA DOS ITENS. 
 
25.1. É vedada a aquisição separada de itens para os quais, o fornecedor convocado para 
assinar a ata não tenha apresentado o menor preço entre todos os licitantes. 
 
26 - DISPOSIÇÕES GERAIS. 
 
26.1.  É assegurado ao TRE/AL, no interesse da Administração, revogar o certame, ou, no caso 
de vício insanável (ilegalidade), anulá-lo, no todo ou em parte, dando ciência aos participantes, na 
forma da legislação vigente. 
 
26.2.  As proponentes assumem todos os custos de preparação e apresentação de suas 
propostas e o TRE/AL não será, em nenhum caso, responsável por esses custos, 
independentemente da condução ou do resultado do processo licitatório. 
 
26.3.   As proponentes serão responsáveis pela fidelidade e legitimidade das informações e dos 
documentos apresentados em qualquer fase da licitação. 
 
26.4.  Não havendo expediente, ou ocorrendo qualquer fato superveniente que impeça a 
realização do certame na data marcada, a sessão será transferida para o primeiro dia útil 
subsequente, devendo o Pregoeiro informar sobre o adiamento no ambiente do Comprasnet, com 
antecedência mínima de 24 (vinte e quatro) horas. 
 
26.5.  Na contagem dos prazos estabelecidos neste Edital, excluir-se-á o dia do início e incluir-
se-á o do vencimento. Só se iniciam e vencem os prazos em dias de expediente no TRE/AL. 
 
26.6.  No julgamento da habilitação e das propostas, o pregoeiro poderá sanar erros ou falhas 
que não alterem a substância das propostas, dos documentos e sua validade jurídica, mediante 
despacho fundamentado, registrado em ata e acessível a todos, atribuindo-lhes validade e eficácia 
para fins de habilitação e classificação. 
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26.7.  As normas que disciplinam este Pregão serão sempre interpretadas em favor da 
ampliação da disputa entre as empresas interessadas, sem comprometimento da segurança do 
futuro contrato. 
 
26.8.  Havendo divergência entre o edital e seus anexos, prevalecerá o determinado neste 
edital. 
 
26.9.  O endereço para vistas e protocolo de documentos, é o seguinte: Avenida Aristeu de 
Andrade, nº 377, 6º andar - COMAP/Seção de Licitações e Contratos, bairro Farol, CEP: 57051-090, 
Maceió/AL, Fone: (82) 2122-7764/7765. 
 
26.10. Todos os horários estabelecidos neste Edital, no aviso e durante a sessão pública, 
observarão, para todos os efeitos, o horário de Brasília, Distrito Federal, inclusive para contagem de 
tempo e registro no sistema eletrônico e na documentação relativa ao certame. 
 
26.11. A homologação do resultado desta licitação não implicará direito à contratação. 
 
26.12. Aos casos omissos, aplicar-se-ão as demais disposições da Lei nº 10.520/2002, do 
Decreto nº 5.450/2005 e alterações e da Lei nº 8.666/1993. 
 
26.13. O Edital e seus anexos poderão ser lidos na sala da Seção de Licitações e Contratos, 
COMAP, no endereço especificado no item 26.9, no caso de ser retirado em Maceió/AL, ou ainda, 
nos sites www.tre-al.jus.br e www.comprasnet.gov.br, gratuitamente. 
 
26.14. Fazem parte integrante deste Edital os seguintes Anexos: 
 

ANEXO I – Termo de Referência; 
ANEXO I–A – Especificações dos lotes, itens, quantitativos a serem adquiridos e preços 
máximos admitidos; 
ANEXO I-B - Planilha de Composição de Custos por Item; 
ANEXO II – Planilha para preenchimento dos dados do Contrato (Sugestão); 
ANEXO III – Minuta da Ata de Registro de Preços. 

 
26.15. Fica eleito o Foro da Justiça Federal em Maceió - Seção Judiciária do Estado de Alagoas, 
para dirimir quaisquer dúvidas ou controvérsias oriundas desta licitação, que não puderem ser 
solucionadas administrativamente. 

 
 

Maceió/AL, 21 de agosto de 2019. 
 
 

Ingrid Pereira de Lima Araújo 
Chefe da Seção de Licitações e Contratos  
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ANEXO I 
 

TERMO DE REFERÊNCIA  
 

01. Objeto Registro de Preço para aquisição de componentes de rede (Networking) 

02. Quantidade 

LOTE 01 - SOLUÇÃO PARA REDE CABEADA 

ITEM DESCRIÇÃO DOS PRODUTOS/SERVIÇOS QTD 

ITEM 
01 

SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 
PARA REDE CABEADA 

01 

ITEM 
02 

LICENCIAMENTO ADICIONAL PARA SISTEMA DE 
GERENCIAMENTO HPE IMC 

03 

ITEM 
03 

LICENCIAMENTO ADICIONAL DO MÓDULO DE ANÁLISE DE 
TRAFEGO DO SISTEMA DE GERENCIAMENTO HPE IMC 

02 

ITEM 
04 

LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE 
PERFIL E CONTROLE DE ACESSO 

02 

ITEM 
05 

SWITCH DE DISTRIBUIÇÃO COM 16 PORTAS SFP+ E SUPORTE 
A MÓDULOS DE EXPANSÃO 

06 

ITEM 
06 

MÓDULO COM 4 PORTAS SFP+ PARA SWITCH DE 
DISTRIBUIÇÃO 

16 

ITEM 
07 

MÓDULO DE STACKING COM 4 PORTAS PARA SWITCH DE 
DISTRIBUIÇÃO 

06 

ITEM 
08 

SWITCH DE ACESSO L3 COM 48 PORTAS GIGABIT E 4SFP+ 50 

ITEM 
09 

SWITCH DE ACESSO L3 COM 24 PORTAS GIGABIT E 4SFP+ 40 

ITEM 
10 

SWITCH DE ACESSO L2 COM 24 PORTAS GIGABIT E 4SFP 50 

ITEM 
11 

SWITCH DE ACESSO L2 COM 48 PORTAS GIGABIT E 4SFP 40 

ITEM 
12 

GBIC 10GB PARA ATÉ 300M 50 

ITEM 
13 

CABO DAC 10 GBPS DE 1M 30 

ITEM 
14 

CABO DAC 10 GBPS DE 3M 30 

Edital do PE nº 39/2019 (0584653)         SEI 0008478-63.2018.6.02.8000 / pg. 744



 
TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS 

SEÇÃO DE LICITAÇÕES E CONTRATOS 

 

25 
 

 

 

ITEM 
15 

GBIC 1GB PARA ATÉ 500M 10 

ITEM 
16 

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA SWITCHS DE REDE 

05 

ITEM 
17 

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO 

01 

ITEM 
18 

TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE SWITCHES 04 

ITEM 
19 

TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE 
ACESSO 

04 

LOTE 02 - SOLUÇÃO DE REDE WIRELESS 

ITEM DESCRIÇÃO DOS PRODUTOS/SERVIÇOS QTD 

ITEM 
20 

SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 
PARA REDE WIRELESS 

01 

ITEM 
21 

SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS 01 

ITEM 
22 

LICENÇAS ADICIONAIS PARA SOLUÇÃO DE GERENCIAMENTO 
DE REDE WIRELESS 

200 

ITEM 
23 

LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE 
PERFIL E CONTROLE DE ACESSO 

02 

ITEM 
24 

CONTROLADORA WLAN 04 

ITEM 
25 

LICENÇAS ADICIONAIS PARA CONTROLADORA WLAN 200 

ITEM 
26 

PONTO DE ACESSO INTERNO TIPO 01 100 

ITEM 
27 

PONTO DE ACESSO INTERNO TIPO 02 100 

ITEM 
28 

INJETOR POE PARA PONTOS DE ACESSO TIPO 1 100 

ITEM 
29 

INJETOR POE PARA PONTOS DE ACESSO TIPO 2 100 

ITEM SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 01 
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30 TECNOLOGIA PARA SOLUÇÃO DE GERENCIAMENTO 

ITEM 
31 

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO 

01 

ITEM 
32 

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA PONTOS DE ACESSO 

05 

ITEM 
33 

TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE ARQUITETURA 
WLAN 

04 

ITEM 
34 

TREINAMENTO BÁSICO DA SOLUÇÃO DE GERENCIAMENTO 04 

ITEM 
35 

TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE 
ACESSO 

04 

 

03. Resumo da 
Especificação do 
Objeto 

Por se tratar de quantidade elevada de itens pertencentes a lotes específicos, 
o detalhamento das especificações está constante no DETALHAMENTO DO 
OBJETO (Art. 18, § 3º, III). 

04. Valor 
Estimado 

Os custos totais projetados, por certo, serão objeto de levantamento por 
parte da Seção de Compras, em momento posterior. 

05. Justificativa 

 A dependência tecnológica para o adequado funcionamento de qualquer 
instituição é na prática, total; 

 A malha de comunicação de rede interna é primordial para  acesso aos 
sistemas e serviço informatizados e desta maneira essencial; 

 Grande parte dos equipamentos de rede do Tribunal está defasado 
tecnologicamente,  fora de garantia ou na iminência de término da 
mesma; 

 Permitir a qualificação da equipe da CONIF para o gerenciamento das 
soluções a serem adquiridas; 

 Maiores detalhes disponíveis no Item 2 do Documento de Oficialização 
da Demanda. 

06. Prazo de 
Entrega 

Conforme item 3 do edital. 

07. Adjudicação 

Por Lote. 

Justificativa: Plena exigência de total compatibilidade e interoperabilidade entre 
em componentes do respectivo lote, como também quanto à solução de 
gerenciamento em uso no TRE/AL. 

08. Classificação 
Orçamentária 

(A cargo da COFIN). 

09. Local de 
Entrega 

Almoxarifado do Tribunal Regional Eleitoral de Alagoas 
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Av. Menino Marcelo, 7200D, Serraria 

Maceió – AL CEP 57046-005 Tel.: (82) 3328-1947 

Horário: De segunda-feira a quinta-feira das 13 às 19h e sexta-feira das 
7h30min Às 13h30min. 

10. Unidade 
Fiscalizadora 

SEGI/CIE/STI 

11. Unidade 
Gestora 

SAD 

12. Sanções 
Administrativas 

Vide 

Item 3.2 Forma de Execução e de Gestão do Contrato (Art. 18, § 3º, III, a) 
Subitem Penalidades (Art. 18, § 3º, III, a, 11) 

13. Prazo de 
Pagamento 

Vide  

Item 3.2 Forma de Execução e de Gestão do Contrato (Art. 18, § 3º, III, a) 
Subitem Forma de Pagamento (Art. 18, § 3º, III, a, 7) 

14. Estratégia de 
Recebimento 

Vide  

Item 3.2 Forma de Execução e de Gestão do Contrato (Art. 18, § 3º, III, a) 
Subitem Recebimento do Objeto: 

15. Modalidade e 
Tipo de Licitação 

Vide 

2.11 Modalidade, Tipo de Licitação, Critérios de Habilitação e Atendimento aos 
Requisitos (Art. 18, § 3º, II, j, IV e V) 

  

1. OBJETO (Art. 18, §3º,I): 

  

Registro de Preço para aquisição de componentes de rede sem fio e cabeada. 

1.1 Definição (Art. 18, §3º, I) 

Registro de Preço para aquisição de computadores  para substituir equipamentos 
fora de garantia e/ou obsoletos. 

2. FUNDAMENTAÇÃO DA CONTRATAÇÃO (Art. 18, § 3º, II) 

  

2.1 Motivação (Art. 18, § 3º, II, a ) 

Os equipamentos tem por finalidade a substituição, por atualização tecnológica, de equipamentos, 
ora em uso, com aproximadamente 04 (quatro) anos e já não mais cobertos por garantia. Estes 
aspectos, a um só tempo, a se falar em TI, evidenciam a necessidade de atualização e de 
demanda de salvaguarda, esculpida em garantia, da efetividade e continuidade do mister da 
Secretaria. 
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A estratégia de Registro de Preços está amparada no Decreto nº 7.892/2013, art 3º, incisos: 

I - vez que os equipamentos podem ser objeto de diversas aquisições/fornecimentos até que se 
supra progressivamente toda a demanda de substituição progressiva; 

II - as entregas deve ser progressivas de forma que as equipes da STI, em número limitado, 
possam implantar os equipamentos sem que os mesmo precisem ser estocados por longos 
períodos apenas exaurindo seus prazos de garantia. 

2.2 Objetivos (Art. 18, § 3º, II, b) 

A contratação visa, além de promover ações no sentido de elaborar novo 
instrumento que mantenha um meio para disponibilizar os computadores demandados e: 

Garantir a infraestrutura física apropriadas às atividades administrativas e 
judiciais. 

Prover infraestrutura de TIC apropriada às atividades judiciais e administrativas. 

2.3 Benefícios (Art. 18, § 3º, II, c) 

 Reposição de equipamentos defasados e manutenção da capacidade produtiva atualizada. 

2.4 Alinhamento Estratégico (Art. 18, § 3º, II, d) 

O alinhamento com o PEI é identificado na visão do recursos de infraestrutura e tecnologia em 
seus dois aspectos apontados: 

 Garantir a infraestrutura física apropriadas às atividades administrativas e judiciais. 

Alinhamento com os Objetivos Estratégicos da Estratégia Nacional de TIC do Poder Judiciário nos 
seguintes aspectos: 

 Prover infraestrutura de TIC apropriada às atividades judiciais e administrativas. 

Alinhamento com os Objetivos Estratégicos de TIC da Justiça Eleitoral de Alagoas – 2017/2022 nos 
seguintes aspectos: 

 Viabilizar serviços e soluções de TIC. 

  

2.5 Referência aos Estudos Preliminares (Art. 18, § 3º, II, e) 

Este Termo de Referência foi elaborado considerando o Documento de 
Oficialização de Demanda (DOD) encaminhado pela Secretaria de Tecnologia da Informação (STI) 
e os Estudos Preliminares constantes do Processo SEI nº 0008478-63.2018.6.02.8000. 

2.6 Relação entre a Demanda Prevista e a Contratada (Art. 18, §3º, II, f) 

É pretendida a renovação do parque de equipamentos componentes da 
infraestrutura de TIC. 

2.7 Análise de Mercado de TIC (Art. 18, § 3º, II, g) 
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Verifica-se que os bens e serviços pretendidos poderão ser fornecidos por 
diferentes empresas no mercado de TIC. 

Considerando o Item 7 dos Estudos Preliminares, não se vislumbrou alternativa 
que não o presente Registro de Preços. 

  

2.8 Natureza do Objeto (Art. 18, § 3º, II, h) 

Os bens e serviços a serem contratados possuem características comuns e usuais 
encontradas atualmente no mercado de TIC, cujos padrões de desempenho e de qualidade 
podem ser objetivamente definidos neste Termo de Referência. 

O objeto desta contratação tem como escopo a obtenção de produto específico 
em período determinado, portanto não se caracteriza como serviço de natureza continuada. 

2.9 Parcelamento e Adjudicação do Objeto (Art. 18, § 3º, II, i) 

Não haverá parcelamento, cada ordem de fornecimento derivado do Registro de 
Preços deverá ser realizada de maneira integral. 

Adjudicação será por lote. 

2.10 Vigência 

Será, na forma dos normativos vigentes, o tempo máximo do Registro de Preços. 

A vigência da ata será de 12 (doze) meses, contados a partir de sua assinatura. 

A utilização do sistema de Registro de Preços visa, primordialmente, a redução de 
número de licitações para o mesmo objeto, porquanto se concentra em um único procedimento a 
possibilidade de realizar diversas aquisições recorrentes e necessárias, via ordens de 
fornecimento, durante o lapso temporal de sua vigência, em face de os preços permanecerem à 
disposição da Administração. 

2.11 Modalidade, Tipo de Licitação, Critérios de Habilitação e Atendimento aos Requisitos (Art. 18, § 
3º, II, j, IV e V) 

A aquisição pretendida deverá ser realizada por meio de licitação do tipo Pregão 
Eletrônico, como é de praxe neste Regional, salvo entendimento superior contrário. 

A sugestão da equipe de planejamento, por se tratar de fornecimento de 
equipamento, é pela contratação por licitação via pregão. Por conta de possibilidade de 
contingenciamento orçamentário indicamos a modalidade de registro de preços. 

O DECRETO Nº 7.174, DE 12 DE MAIO DE 2010 que regulamenta a contratação de bens e serviços 
de informática e automação pela administração pública federal, direta ou indireta, pelas fundações 
instituídas ou mantidas pelo Poder Público e pelas demais organizações sob o controle direto ou 
indireto da União deve ser aplicado nesta aquisição por se tratar de bem de informática. 

A ressalva que a equipe aponta é em relação ao artigo 3º, item II que versa sobre a necessidade 
de exigências, na fase de habilitação, de certificações emitidas por instituições públicas ou 
privadas credenciadas pelo Instituto Nacional de Metrologia, Normalização e Qualidade Industrial 
(Inmetro), que atestem, conforme regulamentação específica, a adequação à segurança para o 
usuário e instalações, compatibilidade eletromagnética e consumo de energia. 

Tal exigência inviabiliza e restringe a competição deste certame, vez que a certificação para este 
tipo de produto, segundo o próprio INMETRO, é voluntária, conforme Portaria Inmetro n.º 170 de 
10/04/2012. 
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(fonte:http://www.inmetro.gov.br/legislacao/rtac/pdf/RTAC001808.pdf). 

A contratação pretendida deverá ser realizada por meio de licitação do tipo 
Pregão Eletrônico, como é de praxe neste Regional, salvo entendimento superior contrário. 

A sugestão da equipe de planejamento, por se tratar de fornecimento de 
equipamento, é pela contratação por licitação via pregão. Por conta de possibilidade de 
contingenciamento orçamentário indicamos a modalidade de registro de preços. 

2.12 Adequação do Ambiente (Art. 18, § 3º, II, k) 

Para utilização do objeto pretendido é necessário dispor de infraestrutura física 
para sua instalação, situação essa já existente no âmbito do TRE/AL, salvo o surgimento de 
demanda muito particular e além da previsibilidade. 

2.13 Conformidade Técnica e Legal (Art. 18, § 3º, II, l) 

  

2.14 Obrigações do Contratante (Art. 18, § 3º, II, m) 

1. Efetuar o pagamento à Contratada, após o recebimento definitivo; 
2. Acompanhar e fiscalizar a execução do objeto da Ata de Registro de Preços e 

do(s) contrato(s) dela decorrentes, por meio de servidor(es) designado(s), 
de modo a garantir o fiel cumprimento do mesmo e da proposta; 

3. Manter arquivo, junto ao processo administrativo ao qual está vinculado o presente termo, to
da a documentação referente ao mesmo; 

4. Proporcionar todas as facilidades indispensáveis à boa execução das obrigações contratuais; 
e 

5. Aplicar as sanções conforme previsto no contrato, assegurando à Contratada o contraditório 
e a ampla defesa. 

2.15 Obrigações da Contratada (Art. 18, § 3º, II, m) 

As obrigações abaixo são aplicáveis ao objeto a ser contratado. 

1. Fornecer o(s) equipamento(s) conforme especificações, quantidades, prazos e demais
 condições estabelecidas no Edital, na Ata de Registro de Preços, 
na Ordem de Fornecimento, na Proposta e no Contrato; 

2. Fornecer a documentação necessária à instalação e 
à operação dos produtos (manuais, termos de garantia, etc.), completa, atualizada e 
em português do Brasil, caso exista, ou em inglês; 

3. Disponibilizar Central 
de Atendimento para a abertura e fechamento de chamados técnicos, conforme períodos, 
horários e condições estabelecidas no Edital e em seus Anexos; 

4. Comunicar formal e imediatamente ao Gestor ou Responsável Técnico da 
Administração sobre mudanças nos dados para contato com a Central de Atendimento; 

5. Prestar as informações e os esclarecimentos que venham a ser solicitados pelo 
representante da Administração, referentes a qualquer problema detectado ou 
ao andamento de atividades da garantia; 

6. Responder por quaisquer prejuízos que seus profissionais causarem ao patrimônio da 
Administração ou a terceiros, 
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por ocasião da execução do objeto, procedendo imediatamente aos reparos ou 
às indenizações cabíveis e assumindo o ônus decorrente; 

7. Responsabilizar-se  integralmente pelo fornecimento dos equipamentos e pela 
execução dos serviços de garantia técnica, primando pela qualidade, desempenho, 
eficiência e produtividade na execução dos trabalhos, dentro dos prazos estipulados e cujo 
descumprimento será considerado infração passível de aplicação das penalidades 
previstas neste Termo de Referência; 

8.  Comunicar ao Gestor ou Responsável Técnico, formal 
e imediatamente, todas as ocorrências anormais e/ou 
que possam comprometer a execução do objeto; 

9. Manter sigilo sobre todo e qualquer assunto de interesse da Administração ou de 
terceiros de que tomar conhecimento em razão da execução do objeto, respeitando todos 
os critérios estabelecidos, aplicáveis aos dados, informações, regras de negócios, 
documentos, entre outros pertinentes, sob pena de responsabilidade civil, penal e 
administrativa; 

10.  Cumprir e garantir que seus profissionais estejam cientes, aderentes e obedeçam rig
orosamente às normas e 
aos procedimentos estabelecidos na Política de Segurança da Informação do TRE/AL; 

11.  Responsabilizar-
se pela conservação dos ambientes onde desempenhe as atividades necessárias para pres
tar a garantia on-site. 

12. Prestar as informações e 
os esclarecimentos que venham a ser solicitados pela Administração, referentes a qualque
r problema detectado ou ao andamento de atividades da garantia técnica 

13. No caso de fornecimento/entrega, em final de exercício e posterior ao dia 15 de 
dezembro ou dia útil imediatamente subsquente, fica obrigado a aceitar, o cancelamento da 
ordem de fornecimento por parte da Administração, em decorrência dos efeitos da Emenda 
Constitucional nº 95/2016, sem a reversão de qualquer ônus à Administração. 

 

DETALHAMENTO DO OBJETO (Art. 18, § 3º, III) 

3.1 Descrição do Objeto 

CONDIÇÕES GERAIS 

1. Todos os itens ofertados por lote, deverão ser do mesmo fabricante para garantir total 
compatibilidade entre todos os componentes, sem a utilização de ferramentas de terceiros 
ou modo de interoperabilidade na solução; 

2. Para o  Lote 01: Todos os itens de software ofertados deverão possuir integração total com o 
HPE Intelligent Managment Center (IMC) já existente na infraestrutura da contratante, 
através de interface única de gerenciamento e/ou autenticação centralizada; 

3. Para o Lote 01: Os equipamentos fornecidos deverão ser gerenciados pelo HPE IMC já 
existente na infraestrutura da contratante, com presença na matriz de compatibilidade 
comprovada através de documentação oficial do fabricante; 

4. Os equipamentos devem ser novos e estar em produção. Não serão aceitos equipamentos 
descontinuados, recondicionados ou usados; 
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5. Os equipamentos devem ser entregues acondicionados adequadamente em suas 
embalagens originais; 

6. A(s) solução(ões) de gerenciamento/controle ofertada(s), deverá(ão) ser baseada(s) em 
plataforma “On Premise”, ou seja, deverá ser executada localmente, não sendo aceitas 
soluções híbridas ou em Cloud; 

7. Cada lote deverá ser fornecido por uma única empresa, visando a garantia integral de 
compatibilidade dos componentes ofertados; 

8. As configurações e especificações aqui apresentadas são mínimas, sendo aceitos 
equipamentos/softwares com características superiores, desde que compatíveis com as 
exigidas; 

9. Prazo de entrega para equipamentos: 60 (sessenta) dias contados a partir da emissão da 
ordem de fornecimento ou documento equivalente; 

10. Prazo de entrega para softwares: 30 (trinta) dias contados a partir da emissão da ordem de 
fornecimento ou documento equivalente; 

11. Os serviços de instalação, integração, garantia e suporte dos equipamentos e softwares, 
deverão ser realizados diretamente pelo fabricante de acordo com as exigências contidas no 
descritivo dos mesmos, estando essas aderentes aos respectivos níveis de serviço 
necessários a cada um deles. 

 LOTE 01 – SOLUÇÃO DE REDE CABEADA 

  

ITEM 01 – SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO LICENCIAMENTO 

1. Licenciamento da SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO, contemplando o 
quantitativo mínimo de 1.000 (um mil) dispositivos, usuários corporativos ou visitantes 
simultâneos, independente do perfil de autenticação, seja por dispositivo ou usuário; 

2. Caso a solução ofertada necessite de licenciamento específico para credenciamento dos 
dispositivos, usuários (corporativos ou visitantes), deverá ser fornecido o quantitativo 
solicitado para ambos, de forma que a solução realize a análise de perfil e o controle de 
acesso dos 1.000 (um mil) dispositivos ou usuários (corporativos ou visitantes) simultâneos. 

  

MÓDULO DE ANÁLISE DE PERFIL DE DISPOSITIVO 

Características Gerais Modulo de Análise de Perfil de Dispositivo 

3. Deve implementar funcionalidade de classificação automática criando perfis de dispositivos, 
de forma a descobrir, classificar e agrupar os dispositivos conectados na rede; 

4. Deve categorizar os dispositivos em pelo menos 3 níveis: 

a. Por tipo de dispositivo (ex. Computador, Smartdevice, impressora, etc.); 
b. Por sistema operacional (ex. Windows, Linux, MacOS, etc.); 
c. Versão do sistema operacional (ex. Windows 7, Windows 2008 Server, etc.); 

5. Deve ser capaz de gerar gráficos das categorias, separando os dispositivos conforme suas 
características; 

6. Deve suportar a coleta de informações, para classificação, usando no mínimo: 

a. DHCP; 
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b. HTTP User-Agent; 
c. MAC OUI; 
d. ActiveSync plugin; 
e. SNMP; 
f. Subnet Scanner; 
g. IF-MAP; 
h. Cisco Device Sensor; 
i. MDM; 
j. TCP Fingerprinting. 

7. Deve possuir dicionário de categorias de dispositivos pré-configurado e mecanismo de 
atualização do mesmo; 

8. Deve suportar a integração com, no mínimo, as seguintes soluções de MDM de mercado 
AirWatch, MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, MaaS 360 devendo comprovar 
a compatibilidade em documentação oficial do fabricante; 

9. Deve permitir priorização na ordem de criação dos perfis com no mínimo as seguintes 
características: 

a. Agente proprietário; 
b. HTTP User-Agent; 
c. SNMP; 
d. DHCP; 
e. MAC OUI. 

10. A solução de análise de perfil de usuários deverá permitir consultas a sua base, pela solução 
de controle de acesso para validação de dispositivos com base no seu perfil. 

  

MÓDULO DE CONTROLE DE ACESSO DE DISPOSITIVOS E USUÁRIOS 

Características Gerais 

11. A Solução deverá dar suporte a no mínimo as seguintes bases de dados: 

a. Microsoft Active Directory; 
b. Kerberos; 
c. Diretórios LDAP; 
d. OpenLDAP; 
e. PostgreSQL; 
f. Oracle 11g; 
g. MariaDB; 
h. MSSQL; 
i. Servidores de Token; 
j. Base de dados SQL interna; 
k. Lista interna estática de hosts. 

12. Deve suportar "Single Sign-on" (SSO) através de SAML v2.0; 
13. Deve implementar gerenciamento e aplicação de políticas de autorização de acesso de 

usuários com base em: 
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a. Atributos do usuário autenticado; 
b. Hora do dia, dia da semana; 
c. Tipo de dispositivo utilizado; 
d. Localização do usuário; 
e. Tipo de autenticação utilizada. 

14. Deve permitir a visualização de todas informações relativas a cada transação e autenticação 
em uma única tela, a solução deverá trazer no mínimo as seguintes informações: 

a. Data e Hora; 
b. Mac Address do dispositivo; 
c. Classificação do dispositivo; 
d. Usuário; 
e. Equipamento que requisitou a autenticação (origem); 
f. Método de autenticação utilizado; 
g. Fonte de autenticação utilizada para validação; 
h. Perfil de acesso aplicado; 
i. Atributos de entrada do protocolo utilizados na requisição (ex. RADIUS); 
j. Informações de resposta da solução para o elemento de rede; 
k. Alertas em caso de falha; 
l. LOGS já filtrados para a requisição em análise. 

15. Deve possuir Dashboard customizável, onde deve permitir a visualização de no mínimo as 
seguintes informações: 

a.  
a. Lista com últimos Alertas do sistema; 
b. Gráfico com todas as requisições de autenticação dos últimos 7 dias, incluindo 

RADIUS, TACACS+ e Autenticações Web; 
c. Gráfico com o status das autenticações aceitas e rejeitadas nos últimos 7 dias; 
d. Gráfico com a categorização dos dispositivos classificados pela solução, divididos de 

acordo com as categorias de classificação; 
e. Últimas falhas de autenticação; 
f. Gráfico com as requisições de avaliação de postura dos dispositivos, divididos em: 

  
I. Saudáveis (dentro das políticas estabelecidas); 
II. Não saudáveis (que estão fora das políticas estabelecidas); 

a.  
a. Lista com as últimas autenticações; 
b. Lista com as últimas autenticações com sucesso; 
c. Utilização de CPU do sistema, no mínimo nos últimos 30 minutos; 

16. Deve possuir base de regras e categorias de dispositivos pré-configurada e mecanismo de 
atualização da mesma; 

17. Deve suportar a integração com no mínimo as seguintes soluções de MDM de mercado 
AirWatch, MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, MaaS 360 devendo comprovar 
a compatibilidade em documentação oficial do fabricante; 
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18. Deve suportar autenticações via OAuth2, Facebook, Twitter, LinkdIn, Office365 e Google 
Apps; 

19. Deve possuir recursos integrados de AAA: RADIUS, TACACS+ e Kerberos; 
20. Deve possuir suporte aos seguintes recursos: 

a. RADIUS; 
b. RADIUS CoA; 
c. TACACS+; 
d. Web authentication; 
e. SAML v2.0; 
f. EAP-FAST (EAP-MSCHAPv2, EAP-GTC, EAP-TLS); 
g. PEAP (EAP-MSCHAPv2, EAP-GTC, EAP-TLS, EAP-PEAP-Public); 
h. TTLS (EAP-MSCHAPv2, EAP-GTC, EAP- TLS, EAP-MD5, PAP, CHAP); 
i. EAP-TLS; 
j. PAP, CHAP, MSCHAPv1, MSCHAPv2  e EAP-MD5; 
k. Windows machine authentication; 
l. MAC address authentication (dispositivos sem suporte a 802.1X); 

21. Deve suportar verificação de vulnerabilidade através de varredura de portas; 
22. Deve suportar à aplicação de políticas em ambiente com múltiplos fornecedores de Wireless, 

cabeado e VPN; 
23. Deve possuir CA integrada, para geração de certificados para os dispositivos que forem se 

autenticar na rede; 
24. Deve suportar à integração com plataforma de terceiros usando HTTP/RESTful API; 
25. Deve permitir que a solução faça consultas em bases SQL, com o objetivo de buscar 

informação a serem utilizadas durante o processo de autenticação dos usuários; 
26. Deve possuir suporte a administração através de IPv6; 
27. Deve possuir ferramenta para gerenciar os processos de credenciamento, autenticação, 

autorização e contabilização de usuários visitantes através de portal web seguro; 
28. Deve implementar a criação de grupos de autorizadores com privilégios distintos de criação 

de credenciais temporárias e atribuição de permissões de acesso aos clientes; 
29. Deve permitir realizar a autenticação dos autorizadores em base externa do tipo Microsoft 

Active Directory ou LDAP e atribuir o privilégio ao autorizador de acordo com o seu perfil; 
30. Deve implementar as funcionalidades de geração de lotes de credenciais aleatórias, 

temporárias, pré-autorizadas; 
31. Deve implementar a importação e exportação da relação de credenciais temporárias através 

de arquivos txt ou csv; 
32. Deve permitir a configuração do tempo de validade das credenciais, baseando-se na criação 

da conta ou no primeiro login da conta; 
33. Deve permitir que o visitante crie sua própria credencial temporária (autosserviço) através 

de portal web, com ou sem a necessidade de um autorizador; 
34. Deve permitir a customização do formulário de criação de credenciais, a ser preenchido pelo 

autorizador ou pelo visitante em caso de autosserviço, especificando quais informações 
cadastrais dos visitantes são obrigatórias ou opcionais; 

35. Deve permitir a customização do nível de segurança da senha temporária que será gerada 
ao visitante, especificando a quantidade mínima de caracteres e o uso de caracteres 
especiais e números para compor a senha; 

36. Deve exigir que o usuário visitante aceite o “Termo de uso da rede” a cada login ou apenas 
no primeiro login; 

37. Deve permitir o envio das credenciais aos usuários registrados através de mensagens SMS 
(Short Message Service), e-mail ou impressão local. 
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 GARANTIA E SUPORTE 

38. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas; 

39. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução; 

40. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

41. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

42. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

  

ITEM 02 – LICENCIAMENTO ADICIONAL PARA SISTEMA DE GERENCIAMENTO HPE IMC 

Características técnicas mínimas 

1. Licenciamento para expansão do SISTEMA DE GERENCIAMENTO HPE IMC existente na 
infraestrutura da contratante, contemplando o quantitativo adicional mínimo de 50 
(cinquenta) dispositivos simultâneos; 

  

GARANTIA E SUPORTE 

1. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
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área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

5. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

  

ITEM 03 – LICENCIAMENTO ADICIONAL DO MÓDULO DE ANÁLISE DE TRAFEGO DO SISTEMA DE 
GERENCIAMENTO HPE IMC 

Características técnicas mínimas 

1. Licenciamento para expansão do MÓDULO DE ANÁLISE DE TRAFEGO DO SISTEMA DE 
GERENCIAMENTO HPE IMC existente na infraestrutura da contratante, contemplando o 
quantitativo adicional mínimo de 5 (cinco) dispositivos simultâneos; 

  

GARANTIA E SUPORTE 

1. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

5. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
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documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

  

ITEM 04 – LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 

Características técnicas mínimas 

2. Licenciamento para expansão da SOLUÇÃO DE ANALISE DE PERFIL E CONTROLE DE ACESSO, 
contemplando o quantitativo mínimo adicional de 500 (quinhentos) dispositivos, usuários 
corporativos ou visitantes simultâneos, independente do perfil de autenticação, seja por 
dispositivo ou usuário; 

  

GARANTIA E SUPORTE 

1. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

5. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

  

ITEM 05 – SWITCH DE DISTRIBUIÇÃO COM 16 PORTAS SFP+ E SUPORTE A MÓDULOS DE EXPANSÃO 

  

Características técnicas mínimas 
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1. Deve possuir no mínimo 16 portas 10 Gigabit Ethernet, 1000/10000 SFP+ fixas ao 
equipamento 

2. Deve suportar, através de módulos, o mínimo de 8 portas adicionais de 10 Gigabit Ethernet 
SFP+ ou 2 portas de 40 Gigabit Ethernet QSFP+; 

3. Deve suportar transceivers de 10GbE SFP+ e de 40GbE QSFP+ através da adição ou 
substituição de módulos. 

4. Deve possuir, no mínimo, 2 módulos de expansão podendo ser utilizados para uplinks ou 
dados de usuários; 

5. Deve possuir, no mínimo, 2 módulos de fonte internas ao equipamento operando em modo 
redundante; 

6. Deve possuir porta dedicada de gerenciamento; 
7. Deve possuir 1 interface RJ-45 ou serial para acesso console local; 
8. Deve possuir latência de, no máximo, 2,8 μs a 1Gbps; 
9. Deve possuir memória SDRAM de no mínimo 2 Gbytes; 
10. Deve possuir buffer de pacotes de no mínimo 13.5 Mbytes; 
11. Deve possuir capacidade de encaminhamento de no mínimo 285 Mpps; 
12. Deve possuir capacidade de comutação de no mínimo 480 Gbps; 
13. Deve possuir Certificado de Homologação na Anatel, de acordo com a Resolução nº 242; 
14. Deve possuir fonte de alimentação interna 110/220VAC; 

Disponibilidade 

15. Deve possuir capacidade de, no mínimo, 10 (dez) equipamentos membros da mesma pilha; 
16. Deve possuir fonte de alimentação interna redundante com características idênticas a fonte 

principal; 
17. Deve suportar empilhamento com banda agregada mínima de 320 Gbps sem uso de portas 

de dados de usuário para este fim. 

Switching 

18. Deve implementar VLANs baseadas em MAC; 
19. Deve suportar no mínimo 4094 VLAN IDs; 
20. Deve implementar registro dinâmico de VLAN com MVRP; 
21. Deve suportar protocolo OpenFlow 1.3; 
22. Deve implementar Jumbo frames nas interfaces Gigabit Ethernet e 10-Gigabit Ethernet 
23. Deve implementar Jumbo frames com tamanho de até 9000 bytes; 
24. Deve implementar Ethernet link aggregation; 
25. Deve implementar IEEE 802.1ad QinQ; 
26. Deve suportar agregação de link através de LACP com no mínimo 144 grupos distribuídos 

através da pilha, com cada grupo permitindo até 8 portas; 
27. Deve implementar IEEE 802.3x Flow Control; 
28. Deve implementar STP BPDU Protection (BPDU Guard); 
29. Deve implementar IEEE 802.1w Rapid Reconfiguration of Spanning Tree; 
30. Deve implementar MSTP IEEE 802.1s com pelo menos 64 instâncias; 
31. Deve implementar UDLD ou DLDP. 

Roteamento 

32. Deve implementar roteamento estático IPv4 e IPv6; 
33. Deve implementar RIP, RIPv2 e RIPng; 
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34. Deve possuir no mínimo 512 interfaces de roteamento IP (VLAN Interface) 
35. O equipamento ofertado deve implementar roteamento baseado em política (PBR) para IPv4 

e IPv6; 
36. O equipamento ofertado deve possuir tabela de roteamento com no mínimo 10 mil entradas 

IPv4 e 5 mil entradas IPv6; 
37. Deve suportar no mínimo 256 rotas estáticas; 
38. O equipamento ofertado deve permitir autenticação em servidores RADIUS e TACACS+; 
39. Deve suportar dual stack IPv4/IPv6; 
40. Deve implementar Bidirectional Forwarding Detection (BFD), suportando redução do tempo 

de convergência para OSPF e VRRP; 
41. Deve implementar OSPF v2 e OSPF v3; 
42. Deve implementar BGP. 

QoS 

43. Deve implementar 8 filas em cada porta; 
44. Deve implementar traffic shapping; 
45. Deve implementar classificação de tráfego utilizando informações de camada 2, 3 e 4; 
46. Deve implementar priorização do trafego em camada 4, baseado em número de portas 

TCP/UDP. 

Segurança 

47. Deve implementar autenticação 802.1x de múltiplos usuários por porta, simultaneamente. 
48. Deve implementar segurança orientada por identidade e controle de acesso por usuário 

através de ACLs que permitam ou negue o acesso do usuário aos recursos de rede 
específicos, com base na identidade do usuário. 

49. Atribuição VLAN automática, automaticamente atribui os usuários para a VLAN apropriada, 
com base em suas identidades. 

50. Deve implementar accounting RADIUS; 
51. Deve implementar TACACS+; 
52. Deve implementar proteção contra ataques de ARP; 
53. Deve implementar proteção contra IP spoofing (IP source guard); 
54. Deve implementar SNMP v1, v2 e v3; 
55. Deve implementar detecção de ataques maliciosos e enviar um aviso quando uma anomalia 

potencial, causada pelos ataques mal-intencionado, for detectado. 
56. Deve suportar o isolamento de portas e VLANs, de forma que uma porta ou VLAN isolada não 

possa enviar tráfego para outra porta isolada do mesmo switch; 
57. Deve implementar segurança do gerenciamento do switch em métodos de acesso CLI, GUI ou 

MIB, através de SSHv2, SSL e SNMPv3 
58. Deve implementar autenticação baseado em porta ou endereço MAC; 
59. Deve implementar autenticação utilizando navegadores web, possibilitando que clientes que 

não possuem cliente 802.1x possam autenticar; 
60. Deve suportar port-security. 

Gerenciamento 

61. Deve permitir instalação simplificada “Zero-touch provisioning” através de processo baseado 
em DHCP com a solução de software de gerenciamento; 

62. O equipamento ofertado deve permitir múltiplos arquivos de configuração; 
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63. Deve suportar espelhamento remoto; 
64. Deve implementar Secure File Transfer Protocol; 
65. Deve implementar LLDP; 
66. Deve implementar LLDP-MEd; 
67. Deve implementar SNTP v4; 
68. O equipamento ofertado deve Implementar Sflow ou Netflow; 
69. Deve implementar RFC 1213 MIB II; 
70. Deve implementar RFC 2096 IP Forwarding Table MIB; 
71. Deve implementar RFC 2571 SNMP Framework MIB; 
72. Deve implementar RFC 2572 SNMP-MPD MIB; 
73. Deve implementar RFC 2573 SNMP-Notification MIB; 
74. Deve implementar RFC 2574 SNMP USM MIB; 
75. Deve implementar RFC 2737 Entity MIB (Version 2); 
76. Deve implementar RFC 3414 SNMP-User based-SM MIB; 
77. Deve implementar RFC 3415 SNMP-View based-ACM MIB; 
78. Deve implementar RFC 2668 802.3 MAU MIB; 
79. Deve implementar RFC 3418 MIB for SNMPv3; 
80. Deve ser fornecido com a versão de software mais completa e atual disponível para o 

equipamento; 
81. Deve ser fornecido com todas as licenças de software necessárias para o funcionamento 

integral de todas as funcionalidades disponíveis para o equipamento; 
82. O equipamento ofertado deve possuir certificado de homologação na Anatel, de acordo com 

a resolução n° 242; 

Garantia e Suporte 

83. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 

84. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

85. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

86. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

87. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos equipamentos, 
indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
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documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

88. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 06 – MÓDULO COM 4 PORTAS SFP+ PARA SWITCH DE DISTRIBUIÇÃO 

  

Características técnicas mínimas 

1. Módulo de expansão para switch de distribuição; 
2. Suporte a no mínimo 4 (quatro) portas SFP+; 
3. Deve ser compatível com GBICS 100M/1G/10G SFP+; 
4. Deve possuir suporte a MACsec; 
5. Compatibilidade integral com o item 05. 

Garantia e Suporte 

6. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

7. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

8. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada; 

  

ITEM 07 – MÓDULO DE STACKING COM 4 PORTAS PARA SWITCH DE DISTRIBUIÇÃO 

 
Características técnicas mínimas 

1. Módulo de expansão para switch de distribuição; 
2. Suporte a no mínimo 4 (quatro) portas para stacking; 
3. Deve prover no mínimo 320Gbps por módulo; 
4. Deve acompanhar 1 (um) cabo de stacking compatível, com 1 (um) metro de comprimento; 
5. Compatibilidade integral com o item 05. 

  

Garantia e Suporte 
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6. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

7. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

8. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada; 

  

ITEM 08 – SWITCH DE ACESSO L3 COM 48 PORTAS GIGABIT E 4 SFP+ 

  

Características gerais 

1. Deve possuir 48 portas 10/100/1000; 
2. Deve possuir 4 portas 1/10G SFP+; 
3. Deve possuir capacidade de encaminhamento de, no mínimo, 110 Mpps; 
4. Deve possuir capacidade de comutação de, no mínimo, 176 Gbps; 
5. Deve implementar IEEE 802.3az para as portas 10/100/1000; 
6. Deve possuir uma interface de console USB; 
7. Deve suportar empilhamento de no mínimo 8 switches; 
8. Deve suportar agregação de link através de LACP com no mínimo 20 grupos distribuídos 

através da pilha, com cada grupo permitindo até 8 portas; 
9. Deve suportar a agregação de links entre diferentes membros da pilha; 
10. Deve possuir no mínimo 32.000 endereços MAC; 
11. Deve possuir latência máxima de 4μs, considerando pacotes de 64 bytes; 
12. Deve possuir buffers de, no mínimo, 12 MB; 
13. Deve implementar funcionalidade que permita a detecção de links unidirecionais; 
14. Deve implementar funcionalidade que permita a detecção de falhas de uplink; 
15. Deve implementar no mínimo 2000 VLANs simultaneamente; 
16. Deve implementar MVRP (Multiple VLAN Registration Protocol); 
17. Deve implementar LLDP (IEEE 802.1ab); 
18. Deve implementar LLDP-MED; 
19. Deve implementar Q-in-Q (IEEE 802.1ad); 
20. Deve implementar PVST+, RPVST+ ou protocolo compatível; 
21. Deve implementar MSTP (IEEE 802.1s); 
22. Deve implementar túneis VxLAN (VTEP). 

  

Funcionalidades de Camada 3 

23. Deve possuir tabela de roteamento com no mínimo 2.000 rotas IPv4 e 1.000 rotas IPv6; 
24. Deve implementar roteamento estático; 
25. Deve implementar RIP v2, com suporte a autenticação MD5 (RIPv2); 
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26. Deve implementar RIPng; 
27. Deve implementar OSPF; 
28. Deve implementar OSPFv3; 
29. Deve implementar Policy-based Routing; 
30. Deve implementar VRRP; 
31. Deve implementar VRRPv3; 
32. Deve implementar servidor DHCP; 
33. Deve implementar DHCP snooping (IPv4 e IPv6); 
34. Deve implementar DHCP relay (IPv4 e IPv6); 
35. Deve implementar Gateway mDNS, com suporte a Apple Bonjour. 

  

Multicast 

36. Deve implementar PIM-SM; 
37. Deve implementar PIM-DM; 
38. Deve implementar MLD snooping; 
39. Deve implementar IGMP v3. 

  

Software Defined Networking 

40. Deve implementar OpenFlow 1.3 ou superior; 
41. Deve implementar a separação lógica do tráfego sem suporte a OpenFlow do tráfego com 

suporte a OpenFlow através de instâncias. O tráfego OpenFlow não pode influenciar o tráfego 
não openflow no equipamento; 

42. Deve permitir configurar cada instância como modo ativo (pacotes referentes a fluxos que o 
switch não conhece são enviados para a controladora) ou modo passivo (pacotes que não se 
referem a um fluxo na tabela do switch não são enviados para a controladora); 

43. Deve implementar 16 instâncias de OpenFlow; 
44. As instâncias de OpenFlow devem suportar a associação de múltiplas VLANs; 
45. Cada instância OpenFlow configurada no equipamento deve suportar, pelo menos, a 

configuração de 3 controladores SDN; 
46. Deve permitir utilizar intervalo de portas TCP/UDP e flags de TCP como parâmetros nas 

regras de OpenFlow; 
47. Deve suportar no mínimo 16.000 regras openflow; 
48. Deve possuir interface REST API; 
49. Deve suportar configurações via JSON/REST API com, no mínimo, os seguintes métodos: GET, 

POST, PUT e DELETE; 
50. Deve suportar a criação de VLANs e ACLs no equipamento através de REST. 

  

QoS 

51. Deve implementar controle de broadcast; 
52. Deve implementar rate limiting para pacotes ICMP; 
53. Deve implementar rate limiting para tráfego broadcast e multicast; 
54. Deve implementar rate limiting baseado em tráfego classificado por uma ACL; 
55. Deve suportar espelhamento de portas; 
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56. Deve suportar espelhamento de tráfego para um switch remoto. 

  

Segurança 

57. Deve implementar controle de acesso baseado em perfis (Role Based Access Control); 
58. Deve implementar VLANs privadas, de forma que permita o isolamento de tráfego de uma 

porta de acesso das demais portas de acesso de uma mesma VLAN, permitindo acesso 
apenas para as portas de Uplink (porta promíscua); 

59. Deve implementar 802.1x; 
60. Deve implementar autenticação baseada em web; 
61. Deve implementar autenticação baseada em endereço MAC; 
62. Deve permitir a utilização simultânea de autenticação 802.1x e MAC em uma mesma porta; 
63. Deve implementar TACACS+. Não serão aceitas soluções similares; 
64. Deverá suportar o download de políticas ou ACLsl a partir de um software de Controle de 

Acesso à Rede (NAC), sem necessidade de pré-configuração das regras no switch, permitindo 
a centralização das políticas; 

65. Deve suportar integração com ferramenta de controle de acesso do mesmo fabricante que 
permita identificar automaticamente o tipo e sistema operacional dos equipamentos que se 
conectam à rede (device profiling) sem a necessidade de agentes instalados nos dispositivos; 

66. Deve suportar integração com ferramenta de controle de acesso do mesmo fabricante que 
permita verificar se a máquina está em conformidade com a política de segurança antes de 
entrar na rede, verificando, no mínimo serviços os serviços e antivírus das máquinas. Deve 
suportar os sistemas operacionais Microsoft Windows, Mac OS e Linux. 

  

Gerenciamento 

67. Deve implementar NTP com autenticação MD5; 
68. Deve implementar Time Domain Reflectometry (TDR) para testes de cabos UTP, permitindo 

identificar falhas e verificar a distância do cabo; 
69. Deve suportar duas imagens de software na flash; 
70. Deve suportar múltiplos arquivos de configuração na flash; 
71. Deve permitir o agendamento de tarefas, permitindo executar um comando em um dia e 

horário específicos; 
72. Deve suportar a autoconfiguração dos switches através de DHCP e software de 

gerenciamento, sem necessidade de nenhuma intervenção no switch (com configuração de 
fábrica); 

73. Deve suportar gerenciamento através de plataforma de nuvem do mesmo fabricante, com 
funcionalidades de gerenciamento de configuração, alertas e notificações e gerenciamento 
de firmware, sem necessidade de instalação de nenhum software ou dispositivo on-site; 

74. Deve suportar IPSec para comunicação com o sistema de gerenciamento; 
75. Deve implementar sFlow (IPv4 e IPv6); 
76. Deve possuir interface web para configuração; 
77. Deve implementar TR-69 (CPE WAN Management Protocol); 
78. Deve suportar diagnóstico de transceivers ópticos; 
79. Deve implementar Syslog sobre TLS; 
80. Deve implementar Secure SFTP (SFTP); 
81. Deve implementar SNMP v1/v2/v3; 
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82. Deve implementar funcionalidade que permita monitorar o SLA (Service Level Agreement) de 
conexões IP. Deve suportar os seguintes testes: ICMP Echo, UDP-Echo (em porta 
configurável) e TCP-Connect (em porta configurável) e Jitter UDP para voz; 

83. Deve implementar compatibilidade com o protocolo CDP para provisionamento de telefones 
IP; 

84. Deve implementar o isolamento de um Access Point rogue conectado ao switch, quando este 
for detectado por solução de WLAN do mesmo fabricante; 

85. Deve implementar a configuração automática de Access Point wireless do mesmo fabricante 
quando conectado ao switch. Devem ser suportados os seguintes parâmetros para a 
configuração automática: VLAN, CoS, largura de banda máxima; 

86. Deve suportar o encaminhamento de tráfego para controladora wireless do mesmo 
fabricante para inspeção e controle de acesso. 

  

Licenciamento 

87. Deve ser fornecido com a versão de software mais completa disponível para o equipamento; 
88. Deve ser fornecido com todas as licenças de software necessárias para o funcionamento 

integral de todas as funcionalidades disponíveis para o equipamento. 

  

Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos equipamentos, 
indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
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comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 09 – SWITCH DE ACESSO L3 COM 24 PORTAS GIGABIT E 4 SFP+ 

  

Características gerais 

1. Deve possuir 24 portas 10/100/1000; 
2. Deve possuir 4 portas 1/10G SFP+; 
3. Deve possuir capacidade de encaminhamento de, no mínimo, 95 Mpps; 
4. Deve possuir capacidade de comutação de, no mínimo, 128 Gbps; 
5. Deve implementar IEEE 802.3az para as portas 10/100/1000; 
6. Deve possuir uma interface de console USB; 
7. Deve suportar empilhamento de no mínimo 4 switches; 
8. Deve suportar agregação de link através de LACP com no mínimo 20 grupos distribuídos 

através da pilha, com cada grupo permitindo até 8 portas; 
9. Deve suportar a agregação de links entre diferentes membros da pilha; 
10. Deve possuir no mínimo 32.000 endereços MAC; 
11. Deve possuir latência máxima de 4μs, considerando pacotes de 64 bytes; 
12. Deve possuir buffers de, no mínimo, 12 MB; 
13. Deve implementar funcionalidade que permita a detecção de links unidirecionais; 
14. Deve implementar funcionalidade que permita a detecção de falhas de uplink; 
15. Deve implementar no mínimo 2000 VLANs simultaneamente; 
16. Deve implementar MVRP (Multiple VLAN Registration Protocol); 
17. Deve implementar LLDP (IEEE 802.1ab); 
18. Deve implementar LLDP-MED; 
19. Deve implementar Q-in-Q (IEEE 802.1ad); 
20. Deve implementar PVST+, RPVST+ ou protocolo compatível; 
21. Deve implementar MSTP (IEEE 802.1s); 
22. Deve implementar túneis VxLAN (VTEP); 

  

Funcionalidades de Camada 3 

23. Deve possuir tabela de roteamento com no mínimo 2.000 rotas IPv4 e 1.000 rotas IPv6; 
24. Deve implementar roteamento estático; 
25. Deve implementar RIP v2, com suporte a autenticação MD5 (RIPv2); 
26. Deve implementar RIPng; 
27. Deve implementar OSPF; 
28. Deve implementar OSPFv3; 
29. Deve implementar Policy-based Routing; 
30. Deve implementar VRRP; 
31. Deve implementar VRRPv3; 
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32. Deve implementar servidor DHCP; 
33. Deve implementar DHCP snooping (IPv4 e IPv6); 
34. Deve implementar DHCP relay (IPv4 e IPv6); 
35. Deve implementar Gateway mDNS, com suporte a Apple Bonjour; 

  

Multicast 

36. Deve implementar PIM-SM; 
37. Deve implementar PIM-DM; 
38. Deve implementar MLD snooping; 
39. Deve implementar IGMP v3; 

  

Software Defined Networking 

40. Deve implementar OpenFlow 1.3 ou superior; 
41. Deve implementar a separação lógica do tráfego sem suporte a OpenFlow do tráfego com 

suporte a OpenFlow através de instâncias. O tráfego OpenFlow não pode influenciar o tráfego 
não openflow no equipamento. 

42. Deve permitir configurar cada instância como modo ativo (pacotes referentes a fluxos que o 
switch não conhece são enviados para a controladora) ou modo passivo (pacotes que não se 
referem a um fluxo na tabela do switch não são enviados para a controladora) 

43. Deve implementar 16 instâncias de OpenFlow; 
44. As instâncias de OpenFlow devem suportar a associação de múltiplas VLANs. 
45. Cada instância OpenFlow configurada no equipamento deve suportar, pelo menos, a 

configuração de 3 controladores SDN. 
46. Deve permitir utilizar intervalo de portas TCP/UDP e flags de TCP como parâmetros nas 

regras de OpenFlow; 
47. Deve suportar no mínimo 16.000 regras openflow; 
48. Deve possuir interface REST API; 
49. Deve suportar configurações via JSON/REST API com, no mínimo, os seguintes métodos: GET, 

POST, PUT e DELETE; 
50. Deve suportar a criação de VLANs e ACLs no equipamento através de REST. 

  

QoS 

51. Deve implementar controle de broadcast; 
52. Deve implementar rate limiting para pacotes ICMP; 
53. Deve implementar rate limiting para tráfego broadcast e multicast; 
54. Deve implementar rate limiting baseado em tráfego classificado por uma ACL; 
55. Deve suportar espelhamento de portas; 
56. Deve suportar espelhamento de tráfego para um switch remoto. 

  

Segurança 

57. Deve implementar controle de acesso baseado em perfis (Role Based Access Control); 
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58. Deve implementar VLANs privadas, de forma que permita o isolamento de tráfego de uma 
porta de acesso das demais portas de acesso de uma mesma VLAN, permitindo acesso 
apenas para as portas de Uplink (porta promíscua); 

59. Deve implementar 802.1x; 
60. Deve implementar autenticação baseada em web; 
61. Deve implementar autenticação baseada em endereço MAC; 
62. Deve permitir a utilização simultânea de autenticação 802.1x e MAC em uma mesma porta; 
63. Deve implementar TACACS+. Não serão aceitas soluções similares; 
64. Deverá suportar o download de políticas ou ACLs a partir de um software de Controle de 

Acesso à Rede (NAC), sem necessidade de pré-configuração das regras no switch, permitindo 
a centralização das políticas; 

65. Deve suportar integração com ferramenta de controle de acesso do mesmo fabricante que 
permita identificar automaticamente o tipo e sistema operacional dos equipamentos que se 
conectam à rede (device profiling) sem a necessidade de agentes instalados nos dispositivos; 

66. Deve suportar integração com ferramenta de controle de acesso do mesmo fabricante que 
permita verificar se a máquina está em conformidade com a política de segurança antes de 
entrar na rede, verificando, no mínimo serviços os serviços e antivírus das máquinas. Deve 
suportar os sistemas operacionais Microsoft Windows, Mac OS e Linux. 

  

Gerenciamento 

67. Deve implementar NTP com autenticação MD5; 
68. Deve implementar Time Domain Reflectometry (TDR) para testes de cabos UTP, permitindo 

identificar falhas e verificar a distância do cabo; 
69. Deve suportar duas imagens de software na flash; 
70. Deve suportar múltiplos arquivos de configuração na flash; 
71. Deve permitir o agendamento de tarefas, permitindo executar um comando em um dia e 

horário específicos; 
72. Deve suportar a autoconfiguração dos switches através de DHCP e software de 

gerenciamento, sem necessidade de nenhuma intervenção no switch (com configuração de 
fábrica); 

73. Deve suportar gerenciamento através de plataforma de nuvem do mesmo fabricante, com 
funcionalidades de gerenciamento de configuração, alertas e notificações e gerenciamento 
de firmware, sem necessidade de instalação de nenhum software ou dispositivo on-site; 

74. Deve suportar IPSec para comunicação com o sistema de gerenciamento; 
75. Deve implementar sFlow (IPv4 e IPv6); 
76. Deve possuir interface web para configuração; 
77. Deve implementar TR-69 (CPE WAN Management Protocol); 
78. Deve suportar diagnóstico de transceivers ópticos; 
79. Deve implementar Syslog sobre TLS; 
80. Deve implementar Secure SFTP (SFTP); 
81. Deve implementar SNMP v1/v2/v3; 
82. Deve implementar funcionalidade que permita monitorar o SLA (Service Level Agreement) de 

conexões IP. Deve suportar os seguintes testes: ICMP Echo, UDP-Echo (em porta 
configurável) e TCP-Connect (em porta configurável) e Jitter UDP para voz; 

83. Deve implementar compatibilidade com o protocolo CDP para provisionamento de telefones 
IP; 

84. Deve implementar o isolamento de um Access Point rogue conectado ao switch, quando este 
for detectado por solução de WLAN do mesmo fabricante; 
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85. Deve implementar a configuração automática de Access Point wireless do mesmo fabricante 
quando conectado ao switch. Devem ser suportados os seguintes parâmetros para a 
configuração automática: VLAN, CoS, largura de banda máxima; 

86. Deve suportar o encaminhamento de tráfego para controladora wireless do mesmo 
fabricante para inspeção e controle de acesso. 

  

 Licenciamento 

87. Deve ser fornecido com a versão de software mais completa disponível para o equipamento; 
88. Deve ser fornecido com todas as licenças de software necessárias para o funcionamento 

integral de todas as funcionalidades disponíveis para o equipamento. 

  

Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos equipamentos, 
indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

Edital do PE nº 39/2019 (0584653)         SEI 0008478-63.2018.6.02.8000 / pg. 770



 
TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS 

SEÇÃO DE LICITAÇÕES E CONTRATOS 

 

51 
 

 

 

ITEM 10 – SWITCH DE ACESSO L2 COM 24 PORTAS GIGABIT E 4 SFP 

  

1. Deve possuir 24 portas 10/100/1000; 
2. Deve possuir 4 portas 1G SFP; 
3. Deve possuir capacidade de encaminhamento de, no mínimo, 40 Mpps; 
4. Deve possuir capacidade de comutação de, no mínimo, 56 Gbps; 
5. Deve implementar IEEE 802.3az para as portas 10/100/1000; 
6. Deve possuir uma interface de console USB; 
7. Deve suportar agregação com suporte a até 8 portas por grupo; 
8. Deve possuir 16.000 endereços MAC; 
9. Deve possuir latência máxima de 4 μs para links de 1000Mbps, considerando pacotes de 64 

bytes; 
10. Deve implementar funcionalidade que permita a detecção de links unidirecionais; 
11. Deve implementar virtual stacking permitindo o gerenciamento de, no mínimo, 16 switches 

com mesmo endereço IP; 
12. Deve implementar 512 VLANs simultaneamente; 
13. Deve implementar MVRP (Multiple VLAN Registration Protocol); 
14. Deve implementar LLDP (IEEE 802.1ab); 
15. Deve implementar LLDP-MED; 
16. Deve implementar PVST+, RPVST+ ou protocolo compatível; 
17. Deve implementar MSTP (IEEE 802.1s); 
18. Deve implementar Gateway mDNS, com suporte a Apple Bonjour; 
19. Deve implementar IEEE 802.1p permitindo a classificação de tráfego com até 8 filas de 

prioridade; 
20. Deve permitir a priorização de tráfego por porta e VLAN; 
21. Deve implementar controle de broadcast; 
22. Deve implementar rate limiting para pacotes ICMP; 
23. Deve implementar rate limiting para tráfego broadcast e multicast; 
24. Deve suportar espelhamento de portas; 
25. Deve implementar RADIUS authentication; 
26. Deve implementar RADIUS accounting; 
27. Deve implementar TACACS+; 
28. Deve implementar IEEE 802.1X com, no mínimo, 8 (oito) autenticações por porta; 
29. Deve implementar SSHv2; 
30. Deve implementar SSH para IPv6; 
31. Deve implementar DHCP snooping; 
32. Deve implementar user role localmente permitindo criar políticas de acesso de segurança e 

QoS, por perfil de usuário e dispositivos; 
33. Deve implementar autenticação baseada em web; 
34. Deve implementar NTP com autenticação MD5; 
35. Deve suportar duas imagens de software na flash; 
36. Deve suportar múltiplos arquivos de configuração na flash; 
37. Deve permitir o agendamento de tarefas, permitindo executar um comando ou grupo de 

comandos em um dia e horário específicos; 
38. Deve implementar sFlow (IPv4 e IPv6) ou Netflow; 
39. Deve implementar RMON com os grupos statistics, history, alarms e events; 
40. Deve possuir interface web para configuração; 
41. Deve implementar TR-69 (CPE WAN Management Protocol); 
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42. Deve suportar a auto-configuração dos switches através de DHCP e software de 
gerenciamento, sem necessidade de nenhuma intervenção no switch (com configuração de 
fábrica); 

43. Deve suportar Digital Optical Monitoring (DOM) para transceivers ópticos; 
44. Deve implementar Syslog sobre TLS; 
45. Deve implementar SFTP ou SCP; 
46. Deve implementar SNMP v1/v2/v3 
47. Deve permitir gerar notificação caso seja excedido o limite de MACs; 
48. Deve implementar compatibilidade com o protocolo CDP para provisionamento de telefones 

IP; 
49. Deve implementar o isolamento de um Access Point rogue conectado ao switch, quando este 

for detectado por solução de WLAN do mesmo fabricante; 
50. Deve implementar a configuração automática de Access Point wireless do mesmo fabricante 

quando conectado ao switch. Devem ser suportados os seguintes parâmetros para a 
configuração automática: VLAN, CoS, largura de banda máxima; 

51. Deve ser fornecido com a versão de software mais completa disponível para o equipamento; 
52. Deve ser fornecido com todas as licenças de software necessárias para o funcionamento 

integral de todas as funcionalidades disponíveis para o equipamento; 

  

Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos equipamentos, 
indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 
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6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

   

ITEM 11 – SWITCH DE ACESSO L2 COM 48 PORTAS GIGABIT E 4SFP 

  

1. Deve possuir 48 portas 10/100/1000; 
2. Deve possuir 4 portas 1G SFP; 
3. Deve possuir capacidade de encaminhamento de, no mínimo, 77 Mpps; 
4. Deve possuir capacidade de comutação de, no mínimo, 104 Gbps; 
5. Deve implementar IEEE 802.3az para as portas 10/100/1000; 
6. Deve possuir uma interface de console USB; 
7. Deve suportar agregação com suporte a até 8 portas por grupo; 
8. Deve possuir 16.000 endereços MAC; 
9. Deve possuir latência máxima de 4 μs para links de 1000Mbps, considerando pacotes de 64 

bytes; 
10. Deve implementar funcionalidade que permita a detecção de links unidirecionais; 
11. Deve implementar virtual stacking permitindo o gerenciamento de, no mínimo, 16 switches 

com mesmo endereço IP; 
12. Deve implementar 512 VLANs simultaneamente; 
13. Deve implementar MVRP (Multiple VLAN Registration Protocol); 
14. Deve implementar LLDP (IEEE 802.1ab); 
15. Deve implementar LLDP-MED; 
16. Deve implementar PVST+, RPVST+ ou protocolo compatível; 
17. Deve implementar MSTP (IEEE 802.1s); 
18. Deve implementar Gateway mDNS, com suporte a Apple Bonjour; 
19. Deve implementar IEEE 802.1p permitindo a classificação de tráfego com até 8 filas de 

prioridade; 
20. Deve permitir a priorização de tráfego por porta e VLAN; 
21. Deve implementar controle de broadcast; 
22. Deve implementar rate limiting para pacotes ICMP; 
23. Deve implementar rate limiting para tráfego broadcast e multicast; 
24. Deve suportar espelhamento de portas; 
25. Deve implementar RADIUS authentication; 
26. Deve implementar RADIUS accounting; 
27. Deve implementar TACACS+; 
28. Deve implementar IEEE 802.1X com, no mínimo, 8 (oito) autenticações por porta; 
29. Deve implementar SSHv2; 
30. Deve implementar SSH para IPv6; 
31. Deve implementar DHCP snooping; 
32. Deve implementar user role localmente permitindo criar políticas de acesso de segurança e 

QoS, por perfil de usuário e dispositivos; 
33. Deve implementar autenticação baseada em web; 
34. Deve implementar NTP com autenticação MD5; 
35. Deve suportar duas imagens de software na flash; 
36. Deve suportar múltiplos arquivos de configuração na flash; 
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37. Deve permitir o agendamento de tarefas, permitindo executar um comando ou grupo de 
comandos em um dia e horário específicos; 

38. Deve implementar sFlow (IPv4 e IPv6) ou Netflow; 
39. Deve implementar RMON com os grupos statistics, history, alarms e events; 
40. Deve possuir interface web para configuração; 
41. Deve implementar TR-69 (CPE WAN Management Protocol); 
42. Deve suportar a auto-configuração dos switches através de DHCP e software de 

gerenciamento, sem necessidade de nenhuma intervenção no switch (com configuração de 
fábrica); 

43. Deve suportar Digital Optical Monitoring (DOM) para transceivers ópticos; 
44. Deve implementar Syslog sobre TLS; 
45. Deve implementar SFTP ou SCP; 
46. Deve implementar SNMP v1/v2/v3 
47. Deve permitir gerar notificação caso seja excedido o limite de MACs; 
48. Deve implementar compatibilidade com o protocolo CDP para provisionamento de telefones 

IP; 
49. Deve implementar o isolamento de um Access Point rogue conectado ao switch, quando este 

for detectado por solução de WLAN do mesmo fabricante; 
50. Deve implementar a configuração automática de Access Point wireless do mesmo fabricante 

quando conectado ao switch. Devem ser suportados os seguintes parâmetros para a 
configuração automática: VLAN, CoS, largura de banda máxima; 

51. Deve ser fornecido com a versão de software mais completa disponível para o equipamento; 
52. Deve ser fornecido com todas as licenças de software necessárias para o funcionamento 

integral de todas as funcionalidades disponíveis para o equipamento. 

  

Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos equipamentos, 
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indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 12 – GBIC 10GB PARA ATÉ 300M 

  

Características técnicas mínimas 

1. Deve ser do tipo SFP+ de 10GBASE-SR com conector LC; 
2. Compatibilidade integral com os Itens 5, 6, 8 e 9. 

  

Garantia e Suporte 

3. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

4. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

5. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

  

ITEM 13 – CABO DAC 10GB DE 1M 

  

Características técnicas mínimas 

1. Cabo metálico com conector tipo SFP+ para ligação de duas unidades de switch em 10 Gbps; 
2. Cabo com comprimento mínimo de 1 (um) metro; 
3. Compatibilidade integral com os itens 5, 6, 8 e 9. 

  

Garantia e Suporte 
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4. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

5. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

6. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 14 – CABO DAC 10GB DE 3M 

  

Características técnicas mínimas 

1. Cabo metálico com conector tipo SFP+ para ligação de duas unidades de switch em 10 Gbps; 
2. Cabo com comprimento mínimo de 3 (três) metros; 
3. Compatibilidade integral com os itens 5, 6, 8 e 9. 

  

Garantia e Suporte 

4. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

5. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

6. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 15 – GBIC 1GB PARA ATÉ 500M 

  

Características técnicas mínimas 

1. Deve ser do tipo SFP de 1G BASE-SX com conector LC; 
2. Compatibilidade integral com os Itens 5, 6, 8, 9, 10 e 11. 
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Garantia e Suporte 

3. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

4. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

5. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 16 – SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE TECNOLOGIA PARA SWITCHS DE REDE 

  

Características Gerais 

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das 14:00 às 18:00) 
presencialmente no TRE-AL ou remotamente conforme necessidades da CONTRATANTE; 

  

Implantação 

2. Instalação e configuração de no mínimo 10 (dez) switchs de rede, contemplando: 
3. Configuração básica de acesso a gerencia via rede; 
4. Gerencia e monitoramento em MÓDULO DE GERENCIA DE REDE; 
5. Configuração de autenticação de usuários em MÓDULO DE CONTROLE DE ACESSO; 
6. Configuração de no mínimo 10 (dez) VLANs; 
7. Configuração de stacking de 2 (duas) pilhas com no máximo 4 (quatro) switchs; 
8. Configuração de agregação de links em até 10 (dez) switchs com no máximo 4 (quatro) 

portas por dispositivo. 

  

Transferência de Tecnologia 

9. O treinamento deverá ser no realizado na modalidade workshop com tarefas práticas hands-
on, visando assim a melhor fixação dos temas abordados com foco direto na explicação da 
tecnologia dos produtos ofertados como também nas rotinas de configuração, 
gerenciamento, administração e operação dos mesmos, devendo ter duração mínima de 24 
(vinte e quatro) horas onde serão abordados no mínimo os seguintes tópicos: 

a. Configuração inicial e acesso a gerencia; 
b. Configuração de VLANS; 
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c. Configuração de autenticação de usuários em MÓDULO DE CONTROLE DE ACESSO; 
d. Configuração de empilhamento de switchs; 
e. Configuração de agregação de links; 
f. Configuração de switchs para MÓDULO DE GERENCIA DE REDE; 
g. Configuração de switchs para MÓDULO DE ANÁLISE DE TRÁFEGO. 

  

ITEM 17 - SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE TECNOLOGIA DO MÓDULO DE 
CONTROLE DE ACESSO 

  

Características Gerais 

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das 14:00 às 18:00) 
presencialmente no TRE-AL ou remotamente conforme necessidades da CONTRATANTE; 

  

Implantação 

2. Instalação e configuração de 1 (uma) instância do serviço controle de acesso, contemplando 
configurações básicas para acesso à rede, dimensionamento, configuração de 
armazenamento; 

3. Configuração de autenticação em Active Directory para usuários corporativos; 
4. Configuração de autenticação de visitantes com portal de autosserviço para criação de 

usuários; 
5. Configuração de no mínimo 10 (dez) dispositivos de rede para autenticação na solução. 

  

Transferência de Tecnologia 

6. O treinamento deverá ser no realizado na modalidade workshop com tarefas práticas hands-
on, visando assim a melhor fixação dos temas abordados com foco direto na explicação da 
tecnologia da solução como também nas rotinas de configuração, gerenciamento, 
administração e operação da mesma devendo ter duração mínima de 24 (vinte e quatro) 
horas onde será abordado no mínimo os seguintes tópicos: 

a. Configuração de Active Directory como base de autenticação; 
b. Configuração de autenticação de usuários corporativos; 
c. Configuração de autenticação de usuários visitantes; 
d. Configuração de portal de autosserviço; 
e. Configuração de autenticação e autorização com RADIUS. 

  

ITEM 18 – TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE SWITCHES 

  

Características Gerais 
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1. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do fabricante no 
Treinamento Básico de Administração dos Switches para 01 (um) profissional da contratante; 

2. O voucher deverá ter validade de pelo menos 12 (doze) meses; 
3. O treinamento deverá ser de acordo com o calendário de treinamento do fabricante e 

ministrado em centro oficial de treinamento do mesmo ou remotamente, utilizando 
tecnologia de ensino a distância; 

4. Deverá ser ministrado por profissional devidamente credenciado junto ao fabricante e apto a 
entregar o respectivo; 

5. O treinamento deverá compreender a explicação da tecnologia da solução como também das 
rotinas de configuração, gerenciamento, administração e operação da mesma; 

6. O treinamento deverá ter carga horária mínima de 24 (vinte e quatro) horas, ministrado no 
período de 08:00 às 12:00 e das 14:00 às 18:00. 

  

ITEM 19 – TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE ACESSO 

  

Características Gerais 

1. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do fabricante no 
Treinamento da Solução de Controle de Acesso para 01 (um) profissional da contratante; 

2. O voucher deverá ter validade de pelo menos 12 (doze) meses; 
3. O treinamento deverá ser de acordo com o calendário de treinamento do fabricante e 

ministrado em centro oficial de treinamento do mesmo ou remotamente, utilizando 
tecnologia de ensino a distância; 

4. Deverá ser ministrado por profissional devidamente credenciado junto ao fabricante e apto a 
entregar o respectivo; 

5. O treinamento deverá compreender a explicação da tecnologia da solução como também das 
rotinas de configuração, gerenciamento, administração e operação da mesma; 

6. O treinamento deverá ter carga horária mínima de 40 (Quarenta) horas, ministrado no 
período de 08:00 às 12:00 e das 14:00 às 18:00; 

  

  

LOTE 02 – SOLUÇÃO DE REDE WIRELESS 

 
  

ITEM 20 – SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO PARA SOLUÇÃO DE REDE 
WIRELESS 

LICENCIAMENTO 

1. Licenciamento da SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO, contemplando o 
quantitativo mínimo de 1.000 (um mil) dispositivos, usuários corporativos ou visitantes 
simultâneos, independente do perfil de autenticação, seja por dispositivo ou usuário; 

2. Caso a solução ofertada necessite de licenciamento específico para credenciamento dos 
dispositivos, usuários (corporativos ou visitantes), deverá ser fornecido o quantitativo 
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solicitado para ambos, de forma que a solução realize a análise de perfil e o controle de 
acesso dos 1.000 (um mil) dispositivos ou usuários (corporativos ou visitantes) simultâneos. 

  

MÓDULO DE ANÁLISE DE PERFIL DE DISPOSITIVO 

Características Gerais Modulo de Análise de Perfil de Dispositivo 

3. Deve implementar funcionalidade de classificação automática criando perfis de dispositivos, 
de forma a descobrir, classificar e agrupar os dispositivos conectados na rede; 

4. Deve categorizar os dispositivos em pelo menos 3 níveis: 

d. Por tipo de dispositivo (ex. Computador, Smartdevice, impressora, etc.); 
e. Por sistema operacional (ex. Windows, Linux, MacOS, etc.); 
f. Versão do sistema operacional (ex. Windows 7, Windows 2008 Server, etc.); 

5. Deve ser capaz de gerar gráficos das categorias separando os dispositivos conforme suas 
características; 

6. Deve suportar a coleta de informações, para classificação, usando no mínimo: 

k. DHCP; 
l. HTTP User-Agent; 
m. MAC OUI; 
n. ActiveSync plugin; 
o. SNMP; 
p. Subnet Scanner; 
q. IF-MAP; 
r. Cisco Device Sensor; 
s. MDM; 
t. TCP Fingerprinting. 

7. Deve possuir dicionário de categorias de dispositivos pré-configurado e mecanismo de 
atualização do mesmo; 

8. Deve suportar a integração com, no mínimo, as seguintes soluções de MDM de mercado 
AirWatch, MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, MaaS 360 devendo comprovar 
a compatibilidade em documentação oficial do fabricante; 

9. Deve permitir priorização na ordem de criação dos perfis com no mínimo as seguintes 
características: 

f. Agente proprietário; 
g. HTTP User-Agent; 
h. SNMP; 
i. DHCP; 
j. MAC OUI. 

10. A solução de análise de perfil de usuários deverá permitir consultas a sua base, pela solução 
de controle de acesso para validação de dispositivos com base no seu perfil. 
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MÓDULO DE CONTROLE DE ACESSO DE DISPOSITIVOS E USUÁRIOS 

Características Gerais 

11. A Solução deverá dar suporte a no mínimo as seguintes bases de dados: 

n. Microsoft Active Directory; 
o. Kerberos; 
p. Diretórios LDAP; 
q. OpenLDAP; 
r. PostgreSQL; 
s. Oracle 11g; 
t. MariaDB; 
u. MSSQL; 
v. Servidores de Token; 
w. Base de dados SQL interna; 
x. Lista interna estática de hosts. 

12. Deve suportar "Single Sign-on" (SSO) através de SAML v2.0; 
13. Deve implementar gerenciamento e aplicação de políticas de autorização de acesso de 

usuários com base em: 

f. Atributos do usuário autenticado; 
g. Hora do dia, dia da semana; 
h. Tipo de dispositivo utilizado; 
i. Localização do usuário; 
j. Tipo de autenticação utilizada. 

14. Deve permitir a visualização de todas informações relativas a cada transação e autenticação 
em uma única tela, a solução deverá trazer no mínimo as seguintes informações: 

m. Data e Hora; 
n. Mac Address do dispositivo; 
o. Classificação do dispositivo; 
p. Usuário; 
q. Equipamento que requisitou a autenticação (origem); 
r. Método de autenticação utilizado; 
s. Fonte de autenticação utilizada para validação; 
t. Perfil de acesso aplicado; 
u. Atributos de entrada do protocolo utilizados na requisição (ex. RADIUS); 
v. Informações de resposta da solução para o elemento de rede; 
w. Alertas em caso de falha; 
x. LOGS já filtrados para a requisição em análise. 

15. Deve possuir Dashboard customizável, onde deve permitir a visualização de no mínimo as 
seguintes informações: 

a.  
a. Lista com últimos Alertas do sistema; 
b. Gráfico com todas as requisições de autenticação dos últimos 7 dias, incluindo 

RADIUS, TACACS+ e Autenticações Web; 
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c. Gráfico com o status das autenticações aceitas e rejeitadas nos últimos 7 dias; 
d. Gráfico com a categorização dos dispositivos classificados pela solução, divididos de 

acordo com as categorias de classificação; 
e. Últimas falhas de autenticação; 
f. Gráfico com as requisições de avaliação de postura dos dispositivos, divididos em: 

  
I. Saudáveis (dentro das políticas estabelecidas); 
II. Não saudáveis (que estão fora das políticas estabelecidas); 

a.  
a. Lista com as últimas autenticações; 
b. Lista com as últimas autenticações com sucesso; 
c. Utilização de CPU do sistema, no mínimo nos últimos 30 minutos; 

16. Deve possuir base de regras e categorias de dispositivos pré-configurada e mecanismo de 
atualização da mesma; 

17. Deve suportar a integração com no mínimo as seguintes soluções de MDM de mercado 
AirWatch, MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, MaaS 360 devendo comprovar 
a compatibilidade em documentação oficial do fabricante; 

18. Deve suportar autenticações via OAuth2, Facebook, Twitter, LinkdIn, Office365 e Google 
Apps; 

19. Deve possuir recursos integrados de AAA: RADIUS, TACACS+ e Kerberos; 
20. Deve possuir suporte aos seguintes recursos: 

m. RADIUS; 
n. RADIUS CoA; 
o. TACACS+; 
p. Web authentication; 
q. SAML v2.0; 
r. EAP-FAST (EAP-MSCHAPv2, EAP-GTC, EAP-TLS); 
s. PEAP (EAP-MSCHAPv2, EAP-GTC, EAP-TLS, EAP-PEAP-Public); 
t. TTLS (EAP-MSCHAPv2, EAP-GTC, EAP- TLS, EAP-MD5, PAP, CHAP); 
u. EAP-TLS; 
v. PAP, CHAP, MSCHAPv1, MSCHAPv2, e EAP-MD5; 
w. Windows machine authentication; 
x. MAC address authentication (dispositivos sem suporte a 802.1X); 

21. Deve suportar verificação de vulnerabilidade através de varredura de portas; 
22. Deve suportar à aplicação de políticas em ambiente com múltiplos fornecedores de Wireless, 

cabeado e VPN; 
23. Deve possuir CA integrada, para geração de certificados para os dispositivos que forem se 

autenticar na rede; 
24. Deve suportar à integração com plataforma de terceiros usando HTTP/RESTful API; 
25. Deve permitir que a solução faça consultas em bases SQL, com o objetivo de buscar 

informação a serem utilizadas durante o processo de autenticação dos usuários; 
26. Deve possuir suporte a administração através de IPv6; 
27. Deve possuir ferramenta para gerenciar os processos de credenciamento, autenticação, 

autorização e contabilização de usuários visitantes através de portal web seguro; 
28. Deve implementar a criação de grupos de autorizadores com privilégios distintos de criação 

de credenciais temporárias e atribuição de permissões de acesso aos clientes; 
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29. Deve permitir realizar a autenticação dos autorizadores em base externa do tipo Microsoft 
Active Directory ou LDAP e atribuir o privilégio ao autorizador de acordo com o seu perfil; 

30. Deve implementar as funcionalidades de geração de lotes de credenciais aleatórias, 
temporárias, pré-autorizadas; 

31. Deve implementar a importação e exportação da relação de credenciais temporárias através 
de arquivos txt ou csv; 

32. Deve permitir a configuração do tempo de validade das credenciais, baseando-se na criação 
da conta ou no primeiro login da conta; 

33. Deve permitir que o visitante crie sua própria credencial temporária (autosserviço) através 
de portal web, com ou sem a necessidade de um autorizador; 

34. Deve permitir a customização do formulário de criação de credenciais, a ser preenchido pelo 
autorizador ou pelo visitante em caso de autosserviço, especificando quais informações 
cadastrais dos visitantes são obrigatórias ou opcionais; 

35. Deve permitir a customização do nível de segurança da senha temporária que será gerada 
ao visitante, especificando a quantidade mínima de caracteres e o uso de caracteres 
especiais e números para compor a senha; 

36. Deve exigir que o usuário visitante aceite o “Termo de uso da rede” a cada login ou apenas 
no primeiro login; 

37. Deve permitir o envio das credenciais aos usuários registrados através de mensagens SMS 
(Short Message Service), e-mail ou impressão local. 

  

GARANTIA E SUPORTE 

38. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 

39. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

40. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

41. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

42. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 
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ITEM 21 – SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS 

LICENCIAMENTO 

1. Deverá ser entregue o quantitativo mínimo de licenças para o gerenciamento simultâneo de 
50 (cinquenta) Pontos de acesso; 

CARACTERÍSTICAS GERAIS 

2. A solução de gerenciamento deverá administrar a configuração dos Pontos de acesso de 
forma centralizada; 

3. A solução de gerenciamento deverá possuir integração com o HPE IMC em console única de 
gerenciamento; 

4. A solução de gerenciamento de rede wireless deverá suportar, em arquitetura de 
controladora distribuída, a capacidade de gerenciar no mínimo 120 (cento e vinte) pontos de 
acesso por cluster e no mínimo um total de 20 (vinte) clusters; 

5. A solução de gerenciamento, em arquitetura de controladora física ou virtual, deverá 
suportar no mínimo 2400 pontos de acesso; 

6. Deve ser obrigatoriamente do mesmo fabricante dos pontos de acesso e controladores; 
7. Permitir a configuração e gerenciamento através de browser padrão (http, https); 
8. Permitir que os eventos sejam gravados remotamente utilizando Syslog; 
9. Prover organização hierárquica de equipamentos, permitindo que um equipamento receba as 

configurações lógicas e as replique a outros equipamentos; 
10. Possuir capacidade de projeto automatizado de redes sem fio nos padrões 802.11a, 802.11b 

e 802.11g, 802.11n e 802.11ac, segundo a geografia do prédio (planta); 
11. Considerar a área de cobertura e a banda por usuário desejada; 
12. Possibilitar a importação de plantas baixas nos formatos dwg e jpg; 
13. Permitir a visualização de alertas da rede em tempo real; 
14. Permitir a visualização de eventuais áreas sem cobertura de RF (áreas de sombra); 
15. Monitorar o desempenho da rede wireless, consolidando informações de rede tais como: 

a. Níveis de ruído; 
b. Relação sinal-ruído; 
c. Interferência; 
d. Potência de sinal. 

16. Possuir capacidade de listagem on-line da localização de usuário, endereço IP, endereço 
MAC, nível de potência de recepção e dados de associação e de autenticação 802.1x; 

17. Deve possuir informação visual e gráfica, na planta baixa dos andares, para: 

a. Visualização dos Pontos de acesso instalados, com estado de funcionamento; 
b. Visualização do mapa de calor de RF (Heatmap); 
c. Localização de ativos conectados à rede (equipamentos 802.11); 
d. Localização de Pontos de acesso rogue. 

18. Caso esta funcionalidade não esteja disponível no sistema de gerência, deve ser fornecido 
software, do mesmo fabricante, para atender este item, contemplando todos os dispositivos 
licenciados e com redundância 1+1; 
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19. Possuir capacidade de identificação e listagem dos rádios vizinhos e respectivos SSID/BSSID 
que podem ser percebidos por cada Ponto de acesso; 

20. Possuir capacidade de configuração gráfica completa do controlador WLAN seja ela física, 
virtual ou distribuída e respectivos Pontos de acesso; 

21. Possuir capacidade de geração de relatórios dos seguintes tipos: 

a. Listagem de clientes Wireless; 
b. Listagem de Pontos de acesso; 
c. Informações de Configuração dos Controladores WLAN; 
d. Utilização da rede; 
e. Detalhes dos Pontos de acesso não autorizados (rogues) detectados. 

22. Suportar SSH, HTTP/HTTPS, SSL, Telnet; 
23. Possuir ferramentas de debug e log de eventos para depuração e gerenciamento em 

primeiro nível; 
24. Implementar os padrões abertos de gerência de rede SNMPv2c e SNMPv3, incluindo a 

geração de traps; 
25. Possuir suporte a MIB II, conforme RFC 1213; 
26. Implementar a MIB privativa que forneça informações relativas ao funcionamento do 

equipamento; 
27. Possibilitar a obtenção da configuração do equipamento através do protocolo SNMP; 
28. Possibilitar a obtenção via SNMP de informações de capacidade e desempenho da CPU, 

memória e portas; 
29. Possibilitar a gerência e identificação individualizada de cada Ponto de acesso remoto; 
30. Permitir a administração centralizada dos Pontos de acesso sem a necessidade de configurar 

os mesmos individualmente; 
31. Possibilitar a identificação de paredes e divisórias com respectivos níveis de atenuação por 

tipo (alvenaria, vidro, drywall e divisória); 
32. Possibilitar a importação de plantas baixas nos formatos gráficos (CAD, dwg, jpg, gif e png); 
33. Deve disponibilizar em painel gráfico de controle informações referentes à: 

a. Sistemas operacionais e tipos de dispositivos que estão se conectando a rede; 
b. Informações sobre os tipos de aplicações mais utilizados; 
c. Informações sobre usuários conectados. 

34. Deve possuir informação sobre possíveis ameaças a rede detectadas pelos sistemas 
gerenciados; 

35. Deve possibilitar criação de regras de detecção de ameaças e correlacionar todos os 
dispositivos gerenciados. 

  

 
ITEM 22 – LICENÇAS ADICIONAIS PARA SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS 

Características técnicas mínimas 

1. Licença para expansão da SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS, contemplando 
o quantitativo adicional mínimo de 1 (um) ponto de acesso simultâneo; 
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2. Cada unidade deve ser fornecida com todas as licenças de software necessárias para o 
funcionamento integral de todas as funcionalidades disponíveis para SOLUÇÃO DE 
GERENCIAMENTO DE REDE WIRELESS especificada nesse edital. 

  

GARANTIA E SUPORTE 

1. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

5. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

  

  

ITEM 23 – LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 

Características técnicas mínimas 

3. Licenciamento para expansão da SOLUÇÃO DE ANALISE DE PERFIL E CONTROLE DE ACESSO, 
contemplando o quantitativo mínimo adicional de 500 (quinhentos) dispositivos, usuários 
corporativos ou visitantes simultâneos, independente do perfil de autenticação, seja por 
dispositivo ou usuário; 

  

GARANTIA E SUPORTE 

6. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
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modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 

7. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

8. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

9. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

10. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

 
  

ITEM 24 – CONTROLADORA WLAN 

Características gerais 

1. Solução baseada em hardware ou software específico, do tipo appliance físico ou virtual, do 
mesmo fabricante dos pontos de acesso e software de gerência; 

2. Deve estar licenciado para controle de, no mínimo, 50 (cinquenta) pontos de acesso, 
podendo ser expandido em no mínimo, 250 (duzentos e cinquenta) pontos de acesso através 
de licenciamento adicional; 

3. Permitir a conexão simultânea de, no mínimo, 4.000 clientes wireless; 
4. Permitir a gravação de eventos por meio do protocolo syslog; 
5. Acesso ao sistema através de cliente com browser padrão (http, https, Java); 
6. Permitir operação em modo mesh; 
7. Permitir o uso de múltiplos SSIDs simultaneamente; 
8. Prover tempo de fast-roaming intra-switch inferior a 25 milissegundos; 
9. Prover tempo de fast-roaming inter-switch em camada 2, inferior a 100 milissegundos; 
10. Permitir conexão entre APs sem a necessidade de conexão cabeada, implementando assim 

uma rede padrão mesh; 
11. Deve suportar 802.11e com WMM, U-APSD e T-SPEC; 
12. Gerenciar centralizadamente a autenticação de usuários; 
13. Implementar protocolo de autenticação para controle do acesso administrativo a solução 

com mecanismos de AAA; 
14. Possuir base de dados de usuários interna para autenticação de usuários convidados / 

temporários (acesso guest); 
15. Permitir autenticação em no mínimo os seguintes sistemas de base de dados de usuários 

Microsoft Active Directory, Cisco ACS server, FreeRadius, entre outros; 
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16. Realizar o provisionamento de usuários convidados (guests) através de interface Web por 
meio de um usuário administrativo com permissões mínimas, exclusivas para este fim; 

17. Possuir suporte a autenticação IEEE 802.1X, com pelo menos os seguintes métodos EAP: EAP-
MD5, PEAP/EAP-GTC, PEAP/EAP-MSCHAPv2, EAP-TLS com utilização de base de usuários 
interna ou servidor RADIUS externo; 

18. Suportar as especificações: IEEE 802.1x; 
19. Deverá suportar os seguintes métodos EAP-PEAP, EAP-TLS e EAP-TTLS; 
20. Possuir suporte a autenticação IEEE 802.1X, com o método PEAP/EAP-GTC, e com utilização 

de base de usuários LDAP externa; 
21. Permitir a seleção/uso de servidor Radius ou LDAP com base no SSID; 
22. Suportar a autenticação de usuários conectados à rede cabeada através das portas do 

controlador; 
23. Possuir o recurso de EAP Offload para terminação do túnel EAP no próprio controlador; 
24. Deve suportar utilização de Portal Captivo externo ao controlador; 
25. Permitir a autenticação (através de endereço MAC, Portal Captivo ou IEEE 802.1X) de 

usuários conectados à rede WLAN (wireless) ou usuários conectados às portas cabeadas do 
controlador. Também deverá permitir a autenticação de usuário e de máquina por meio de 
IEEE 802.1x; 

26. Oferecer recurso de Portal Captivo (Captive Portal) com suporte a múltiplos portais 
simultaneamente; 

27. Implementar associação dinâmica de usuário a VLAN, com base nos parâmetros da etapa de 
autenticação; 

28. Implementar Qualidade de Serviço com a marcação de pacotes utilizando Diffserv e suporte 
a 802.1p para QoS de rede; 

29. Possibilitar roaming com integridade de sessão, dando suporte a aplicações em tempo real, 
tais como, VoIP, VoWLAN, videoconferência, dentre outras; 

30. Permitir portais captivos externos a controladora; 
31. A controladora deve possuir funcionalidade de conexão Site to Site VPN utilizando padrão 

Ipsec. Caso a solução fornecida não possua a funcionalidade, será aceita solução de VPN 
adicional integrada; 

32. Deve permitir o tunelamento do trafego de dados de usuários mesmo em redes L3, não 
sendo necessário estender VLANs até o Ponto de Acesso, inclusive em MANs e WANs; 

33. Implementar segurança IEEE 802.11i; 
34. Suportar a criptografia centralizada com os seguintes protocolos: AES-CCMP, TKIP e WEP; 
35. Suportar, no mínimo, 2000 VLANs; 
36. Implementar o protocolo 802.1w (Rapid Spanning Tree); 
37. Oferecer suporte a roteamento e switching de camadas L2 e L3; 
38. Possuir o recurso de criação de Pools de VLAN para permitir a escalabilidade de redes; 
39. Possuir servidor DHCP embutido; 
40. Suportar o protocolo VRRP para redundância de controladores; 
41. Deve suportar redundância de controladores nos modos: 

a. 1+1; 
b. N+1; 
c. Ativo-Ativo; 
d. Ativo-Standby; 

42. Oferecer os recursos de mobilidade entre VLANs para roaming de camada 2; 
43. Oferecer os recursos de Proxy de endereços IP e Proxy DHCP para roaming entre redes (L3) 
44. Deve implementar northbound APIs para realização de integrações com aplicações de 

terceiros para fins de monitoramento e visibilidade. Caso seja necessário, deve ser ofertado 
licenças para ativação desse recurso; 

45. Implementar tagging de VLANs através do protocolo 802.1Q; 
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46. Implementar o protocolo 802.1d para Spanning Tree (STP); 
47. O controlador WLAN poderá estar diretamente e/ou remotamente conectado aos APs por ele 

gerenciados, inclusive via roteamento nível 3 da camada OSI 
48. Se um controlador WLAN ou AP controlador falhar, os APs relacionados deverão se associar a 

um controlador WLAN alternativo de forma automática, não permitindo que a rede wireless 
se torne inoperante; 

49. Realizar a descoberta automática dos APs na infraestrutura wireless; 
50. Permitir o controle dos APs mediante a conexão através de topologia MESH (WiFi Mesh); 
51. A rede MESH deverá oferecer comportamento determinístico da topologia da rede MESH; 
52. A rede MESH deverá prover auto-redundância das camadas física (RF) e Layer 2 com 

comportamento determinístico; 
53. Permitir a conexão de APs de maneira remota e segura; 
54. Conectar APs através de redes públicas e/ou privadas com garantia de segurança através de 

conexão criptografada; 
55. Permitir a propagação de SSIDs de maneira segura para qualquer AP legitimamente 

cadastrado na controladora, independentemente de onde este AP esteja conectado; 
56. Permitir a autenticação do AP remoto através de certificado digital ou de usuário e senha 

cadastrados em servidor AD e Radius; 
57. Gerenciar o tráfego dos APs centralizadamente; 
58. Administrar a configuração dos AP’s; 
59. Deve permitir administrar centralizadamente todos os aspectos de segurança da rede WLAN 

através de firewall integrado à solução de rede sem fio, caso a solução ofertada não possua 
solução de firewall nativa na controladora WLAN deverá ser ofertado firewall externo com 
capacidade para atender toda a solução; 

60. Permitir o bloqueio de comunicação entre clientes wireless – L2 bridging; 
61. Implementar filtros baseados em protocolos e em endereços MAC; 
62. Implementar padrão IEEE 802.11h; 
63. Realizar o controle de autorização baseado em perfis de acesso; 
64. Permitir que seja configurado um perfil de acesso, com regras aplicadas de firewall, para o 

qual será direcionado o usuário após sua autenticação; 
65. Possuir o recurso de “blacklisting” contra ataques ao Firewall e à rede wireless, evitando que 

um determinado cliente se associe à rede wireless caso viole políticas definidas de Firewall 
ou execute algum ataque à rede WLAN de endereços MAC de APs do sistema; 

66. O Firewall deverá implementar os recursos de NAT (Network Address Translation) tanto para 
destino quanto para origem; 

67. Implementar listas de controle de acesso (ACLs); 
68. Oferecer detecção e proteção integrada de ataques de negação de serviços TCP, ICMP; 
69. Permitir o espelhamento de sessão e logs detalhados por pacote a fim de possibilitar análises 

forenses; 
70. Permitir a aplicação de políticas de camada 4, de acordo com as características do usuário. 

Por exemplo, um usuário que pertença ao grupo de gerentes (cadastrado no Radius ou Active 
Directory) terá permissão de acesso ao protocolo FTP no servidor de ERP; 

71. Permitir derivação de políticas de acesso. Por exemplo, um usuário pode pertencer a um 
grupo ao qual foram atribuídas políticas de acesso em camada 4, porém, caso esteja 
utilizando um dispositivo de voz, o tráfego SIP passará a ter prioridade através de aplicação 
de QoS; 

72. Permitir a criação de políticas com base em horários e na localização do usuário. Por 
exemplo: bloquear o tráfego do protocol FTP após às 18 horas. 

73. O Firewall deverá ser integrado à rede WLAN de modo a permitir a desassociação de usuários 
da rede sem fio WLAN com base na violação de políticas de tráfego. Por exemplo: 
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desassociar da rede WLAN e colocar em quarentena o Notebook com endereço MAC 
XX:XX:XX se o usuário tentar fazer um telnet para o servidor ABC; 

74. Otimizar o desempenho e a cobertura da radiofrequência; 
75. Ajustar automaticamente os canais de modo a otimizar a cobertura de rede e mudar as 

condições de RF baseado em performance; 
76. Detectar interferência e ajustar parâmetros de RF, evitando problemas de cobertura e 

controle da propagação indesejada de RF; 
77. Implementar varredura de RF contínua, programada ou sob demanda, com identificação de 

APs ou clientes irregulares; 
78. Deve implementar a tecnologia de “Channel load balancing”, permitindo que clientes sejam 

automaticamente distribuídos entre Pontos de Acesso adjacentes operando em canais 
distintos, com o objetivo de balancear a carga entre os Pontos de Acesso; 

79. Deve implementar a tecnologia de “Band Steering/Select”, permitindo que clientes com 
suporte a faixa de frequência de 5GHz se conectem aos Pontos de Acesso utilizando, 
preferencialmente, a faixa de 5GHz; 

80. Implementar varredura de RF nas bandas 802.11a, 802.11b, 802.11g, 802.1n e 802.11ac 
para identificação de ataques e APs intrusos não autorizados (rogues); 

81. Realizar a varredura no canal de operação do AP sem impacto na performance da rede 
WLAN; 

82. Permitir a varredura em todos os canais possíveis de RF para detecção e contenção de 
ameaças na rede WLAN; 

83. Deve fazer a varredura dos espectros de 2,4 GHz e 5 GHz para localização e classificação de 
interferências não 802.11, analise de espectro, e evita-las automaticamente; 

84. O controlador deve possuir funcionalidade de analisador gráfico de espectro para detecção 
de interferências nas faixas de frequência de 2.4 e 5 GHz, sejam elas IEEE 802.11 ou não. 
Deve disponibilizar interface gráfica com, pelo menos, gráficos de Fast Fourier Transform 
(FFT) e espectrograma; Caso a funcionalidade não possa ser apresentada pelo controlador, 
deve ser fornecido um equipamento ou software, do mesmo fabricante, que o faça; 

85. Utilizar os APs como ”sensores” de RF para fazer a monitoração do ambiente Wireless; 
86. Classificar automaticamente APs válidos, os que interferem e os não autorizados (rogues); 
87. Implementar mecanismos para detecção e contenção de APs não autorizados (rogues); 
88. Realizar a contenção automática dos APs Rogue, simultaneamente, através da rede WLAN 

e/ou da rede cabeada; 
89. Realizar a identificação e contenção de redes “ad-hoc”; 
90. Detectar e bloquear o bridging entre estações da rede WLAN; 
91. Oferecer proteção contra ataques Denial Of Service (DOS) a APs e estações 
92. Detectar e alertar os seguintes tipos de ataques na rede WLAN: 

a. Impersonalização de AP válido; 
b. Floods de Frames; 
c. Fake Ap, Airjack; 
d. Broadcasts de de-autenticação; 
e. Ataques baseados em probes; 

93. Possuir capacidade de gerar alarmes e executar contra-ataques se um ataque for detectado; 
94. Detectar áreas de sombra de cobertura e efetuar os devidos ajustes para sua correção, 

automaticamente; 
95. Ajustar, dinamicamente, o nível de potência e canal de rádio dos APs, de modo a otimizar o 

tamanho da célula de RF, garantindo a performance e escalabilidade; 
96. Permitir o controle de banda disponível (bandwith contracts) por usuário ou através de perfis 

de usuários; 
97. Possibilitar roaming com integridade de sessão, dando suporte a aplicações em tempo real, 

tais como, VoIP, VoWLAN, videoconferência, dentre outras; 
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98. Deve possuir mecanismo de controle de admissão de chamadas nos pontos de acesso (CAC); 
99. Possuir mecanismo automático de QoS para protocolos de voz (SIP, SVP e SCCP) utilizando 

inspeção automática de pacotes, sem a necessidade de fazer a marcação prévia (tagging) de 
pacotes; 

100. Deve possuir solução de identificação de aplicações através de técnicas de análise de 
tráfego, provendo informações das aplicações mais utilizadas na interface gráfica; 

101. Permitir a criação de políticas de acesso baseadas nas aplicações, como por exemplo, 
o acesso a “redes sociais” terá um controle de banda de 2Mpbs. 

102. Apresentar informações gráficas referente a utilização de soluções de comunicações 
unificadas (UC) sobre a infraestrutura WLAN, de formar a apresentar informações referentes 
as chamadas realizadas e relações gráficas entre o nível de sinal recebido pelo usuário e a 
qualidade da chamada. 

103. Possuir a funcionalidade da utilização do protocolo Bonjour na infraestrutura, 
permitindo que os serviços divulgados via mDNS sejam controlados, filtrados e 
disponibilizados entre diferentes subnets, tornando assim possível a utilização em redes com 
múltiplas subnets e um número grande de dispositivos. 

104. Cada unidade deve ser fornecida com todas as licenças de software necessárias para o 
funcionamento integral de todas as funcionalidades disponíveis. 

Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos equipamentos, 
indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
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permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

 
  

ITEM 25 – LICENÇAS ADICIONAIS PARA CONTROLADORA WLAN 

Características técnicas mínimas 

3. Licença para expansão da CONTROLADORA WLAN, contemplando o quantitativo adicional 
mínimo de 1 (um) ponto de acesso simultâneo; 

4. Deve ser compatível com controladora WLAN especificada nesse edital; 
5. Cada unidade deve ser fornecida com todas as licenças de software necessárias para o 

funcionamento integral de todas as funcionalidades disponíveis para CONTROLADORA 
WLANespecificada nesse edital. 

  

GARANTIA E SUPORTE 

6. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 

7. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

8. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de software ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

9. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 

10. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou 
centro de distribuição para fins de comprovação que por ventura conflitem com catálogos, 
manuais, folders oficiais impressos ou da internet (devendo constar o endereço URL para 
folders da web). Caso não seja comprovada por um dos meios citados anteriormente, será 
possível a comprovação através da apresentação de documentação expressa do fabricante 
dos softwares, indicando o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante deverá ser anexada a mesma a procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

 
  

ITEM 26 – PONTO DE ACESSO INTERNO TIPO 01 

Características gerais 
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1. Equipamento de Ponto de Acesso para rede local sem fio, configurável via software, com 
funcionamento simultâneo nos padrões IEEE 802.11a/n/ac, 5GHz, e IEEE 802.11b/g/n, 
2.4GHz; 

2. Todos os Pontos de acesso sem fio deverão ser novos e sem nenhum histórico de utilização; 
3. Os pontos de acesso deverão possuir certificado emitido pelo “WIFI Alliance” comprovando 

no mínimo os seguintes padrões, protocolos e funcionalidades: 

a. IEEE 802.11a; 
b. IEEE 802.11b; 
c. IEEE 802.11g; 
d. IEEE 802.11n; 
e. IEEE 802.11d; 
f. IEEE 802.11ac; 
g. WPA® Enterprise/Personal; 
h. WPA2® Enterprise/Personal; 
i. EAP-TLS; 
j. EAP-TTLS/MSCHAPv2; 
k. PEAPv0/EAP-MSCHAPv2; 
l. PEAPv1/EAP-GTC; 
m. EAP-SIM; 
n. EAP-FAST; 
o. WMM® e WMM® Power Save; 
p. Beamforming; 
q. Short Guard Interval (SGI); 
r. Packet Aggregation (A-MPDU); 
s. Opportunistic Key Caching (OKC) 

4. Deve operar simultaneamente em 2.4GHz e 5GHz (concurrent dual-band); 

  

Performance 

5. Deve suportar rádio dual, 5 GHz 802.11ac 2x2 MIMO e 2.4GHz 802.11n 2x2 MIMO 
6. Deve suportar capacidade de 1300 Mbps de throughput ou superior; 
7. Deve possuir rádio duplo configurável pelo software suportando 5 GHz e 2,4 GHz; 
8. Deve possuir no mínimo dois spatial stream Single User (SU) MIMO para taxa de dados sem 

fio de até 867 Mbps para dispositivos cliente individuais (VHT80) 2x2 em 5GHz; 
9. Deve possuir no mínimo dois spatial stream Single User (SU) MIMO para uma taxa de dados 

sem fio de até 400 Mbps para dispositivos clientes compatíveis (2x2 VHT40) em 5GHz; 
10. Deve possuir suporte para até 255 dispositivos cliente associados por rádio e até 16 BSSIDs 

por rádio; 
11. Deve suportar no mínimo as bandas de frequência: 

a. 2,400 a 2,4835 GHz 
b. 5.150 a 5.250 GHz 
c. 5,25 a 5,350 GHz 
d. 5,470 a 5,725 GHz 
e. 5,725 a 5,850 GHz 
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12. Deve possuir suporte a seleção de frequência dinâmica (DFS) otimizando o uso do espectro 
de RF disponível; 

13. Deve suportar, no mínimo, as seguintes tecnologias de rádio: 

a. 802.11b: espectro espalhável de sequência direta (DSSS) 
b. 802.11a/g/n/ac: multiplexação por divisão de frequência ortogonal (OFDM) 

14. Deve suportar, no mínimo, os seguintes tipos de modulação: 

a. 802.11b: BPSK, QPSK, CCK 
b. 802.11a/g/n/ac: BPSK, QPSK, 16-QAM, 64-QAM, 256-QAM 

15. Deve possuir potência de transmissão configurável em incrementos entre 0,5 e 1,0 dBm. 
16. Deve respeitar os limites de potência de transmissão máxima (conduzida): 

a. Faixa de 2,4 GHz: +18 dBm por corrente, agregado de +21 dBm (2x2) 
b. Banda de 5 GHz: +18 dBm por corrente, agregado de +21 dBm (2x2) 

17. Deve suportar Advanced Cellular Coexistence (ACC) minimizando a interferência das redes 
celulares; 

18. Deve suportar Maximum ratio combining (MRC) para melhorar o desempenho do receptor; 
19. Deve suportar Cyclic delay/shift diversity (CDD/CSD) para melhorar o desempenho RF de 

downlink; 
20. Deve suportar Short guard interval para canais de 20MHz, 40MHz e 80MHz; 
21. Deve suportar Space-time block coding (STBC) para aumentar o alcance e melhorar a 

recepção; 
22. Deve suportar Verificação de paridade de baixa densidade (LDPC) para correção de erros de 

alta eficiência e aumento da taxa de transferência; 
23. Deve suportar Transmit beam-forming (TxBF); 
24. Deve possuir, no mínimo, as seguintes taxas de dados suportadas (Mbps): 

a. 802.11b: 1, 2, 5.5, 11 
b. 802, 11a / g: 6, 9, 12, 18, 24, 36, 48, 54 
c. 802.11n (2.4GHz): 6.5 a 300 (MCS0 a MCS15) 
d. 802.11ac: 6.5 a 867 (MCS0 a MCS9, NSS = 1 a 2 for VHT20/40/80 

25. Deve possuir suporte a 802.11n de alto rendimento (HT): HT 20/40 
26. Deve possuir suporte a 802.11ac de alta velocidade (VHT): VHT 20/40/80 
27. Deve possuir suporte a agregação de pacotes 802.11n/ac: A-MPDU, A-MSDU 

  

    Gerenciamento 

28. Deve implementar funcionamento de modo auto gerenciado, sem necessidade de 
controladora WLAN para configuração de seus parâmetros de rede wireless, gerenciamento 
das políticas de segurança, QoS e monitoramento de RF. 

29. Deve obedecer à todas as características descritas mesmo neste modo de funcionamento; 
30. No modo de funcionamento auto gerenciado deve disponibilizar na interface gráfica 

informações de usuários conectados, qualidade de sinal e trafego de dados na rede; 
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31. O ponto de acesso deve permitir a conversão de modo auto gerenciado para modo 
gerenciado por controlador WLAN através de interface gráfica, em browser padrão (HTTPS), e 
permitir que todos os demais pontos de acesso pertencentes ao mesmo cluster, também 
sejam convertidos automaticamente; 

32. O ponto de acesso deverá suportar conexão direta ou remota com controlador WLAN, 
inclusive via roteamento da camada de rede, baseado no modelo OSI; 

33. Se um controlador WLAN falhar, os Pontos de Acesso relacionados deverão se associar 
automaticamente a um controlador WLAN alternativo, não permitindo que a rede wireless se 
torne inoperante; 

34. Implementar mecanismo de funcionamento para trabalhar com controladores WLAN em 
redundância; 

35. Deve permitir que o ponto de acesso seja atualizado de forma centralizada pela interface 
gráfica; 

36. Permitir o armazenamento de sua configuração em memória não volátil, podendo, numa 
queda e posterior restabelecimento da alimentação, voltar à operação normalmente na 
mesma configuração anterior; 

37. Deve possuir servidor DHCP interno configurável; 
38. Possibilitar backup e restore da configuração através da interface gráfica; 
39. Deve possuir Portal Captivo (Captive Portal) integrado para utilização em rede de visitantes; 
40. Deve possuir mecanismos para proteção contra Pontos de Acesso não autorizados (Rogues); 
41. Possuir capacidade de identificação e listagem dos rádios vizinhos e respectivos SSID/BSSID; 
42. Implementar associação dinâmica de usuários à VLANs com base nos parâmetros da etapa 

de autenticação; 
43. Deve possuir uma base de usuários interna que diferencie usuários visitantes de 

funcionários, para ser usada em autenticação 802.1x ou portal captivo; 
44. Permitir a autenticação para acesso dos usuários conectados nas redes WLAN (Wireless) 

através: 

a. MAC Address 
b. 802.1x em base Local 
c. Captive Portal 
d. 802.1x em base externa RADIUS 
e. 802.1x em base externa LDAP 

45. Deve permitir a seleção/uso de servidor de autenticação específico com base no SSID; 
46. Implementar o protocolo de enlace CSMA/CA para acesso ao meio de transmissão; 
47. Possuir capacidade de selecionar automaticamente o canal de transmissão; 
48. Permitir o ajuste dinâmico de nível de potência e canal de rádio de modo a otimizar o 

tamanho da célula de RF; 
49. Permitir habilitar e desabilitar a divulgação do SSID; 
50. Implementar diferentes tipos de combinações encriptação/autenticação por SSID; 
51. Implementar padrão WMM da Wi-Fi Alliance para priorização de tráfego, suportando 

aplicações em tempo real, tais como, VoIP, vídeo, dentre outras; 
52. Não deve haver no licenciamento restrições com relação ao número de dispositivos 

conectados por ponto de acesso; 
53. Implementar a pilha de protocolos TCP/IP com suporte a IPV4 e IPV6 (Bridging); 
54. Implementar VLANs conforme padrão IEEE 802.1Q; 
55. Possuir, no mínimo, uma interface IEEE 802.3 10/100/1000BaseT Ethernet, auto- sensing, 

auto MDI/MDX; 
56. Permitir a atualização remota do sistema operacional e arquivos de configuração através da 

controladora WLAN 
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57. Implementar cliente DHCP, para configuração automática de rede; 
58. Deve configurar-se automaticamente ao ser conectado na rede; 
59. Possuir LED’s indicativos do estado de operação, da atividade do rádio e da interface 

Ethernet; 
60. Possuir estrutura que permita fixação do equipamento em teto e parede e fornecer 

acessórios para que possa ser feita a fixação; 
61. Deve ser acompanhado de todos os acessórios necessários para operacionalização do 

equipamento, tais como: softwares, cabos de console, cabos de energia elétrica, 
documentação técnica e manuais (podendo ser em CD-ROM) que contenham informações 
suficientes para possibilitar a instalação, configuração e operacionalização do equipamento; 

62. Permitir o bloqueio da configuração do Ponto de Acesso via rede wireless; 
63. Implementar varredura de RF nas bandas 802.11a, 802.11b, 802.11g, 802.11n, para 

identificação de Pontos de Acesso intrusos não autorizados (rogues) e interferências no canal 
habilitado ao ponto de acesso e nos demais canais configurados na rede WLAN, sem impacto 
no seu desempenho; 

64. Implementar IEEE 802.1x, com pelo menos os seguintes métodos EAP: 

a. EAP-FAST 
b. EAP-TLS 
c. PEAP-GTC 
d. PEAP-MSCHAPv2 

65. Permitir a integração com RADIUS Server com suporte aos métodos EAP citados; 
66. A comunicação entre todos os pontos de acesso sem fio e a controladora deverá ser 

criptografada; 
67. Suportar a autenticação com geração dinâmica de chaves criptográficas por sessão e por 

usuário; 
68. Implementar WPA com algoritmo de criptografia TKIP e MIC; 
69. Implementar WPA2 com algoritmo de criptografia AES, 128/256 bits, IEEE 802.11i; 
70. Deve possuir modo dedicado de funcionamento de análise de espectro das faixas de 

frequência de 2.4 e 5 GHz identificando fontes de interferência nessas faixas; 
71. Deve possibilitar analise de espectro nos canais em que estiver provendo acesso, sem 

desconectar os usuários; 
72. Deve disponibilizar informações gráficas de análise de espectro em conjunto com o 

controlador WLAN; 
73. O equipamento deverá possuir registro na ANATEL e deverá ser apresentado na entrega do 

equipamento; 
74. Deverá prover priorização de trafego de vídeo e voz através de parâmetros de QoS (Quality 

os Service) com possibilidade de aplicar por SSID e dispositivo; 
75. Possibilitar roaming na rede wireless; 
76. Suportar a criação de uma rede de convidados autocontida com isolamento de tráfego entre 

clientes e serviços locais; 
77. Possuir recursos de seleção automática de canal de transmissão procurando por canais onde 

haja menor interferência, tendo por objetivo melhorar a performance da rede wireless; 
78. Permitir a operação em estrutura Mesh viabilizando a comunicação direta entre diferentes 

Pontos de Acesso sem Fio onde não seja possível estender a rede cabeada; 
79. Operando em estrutura Mesh, a comunicação entre os dispositivos estrutura deverão operar 

na frequência de 5Ghz. 
80. Possuir mecanismo para a restauração das configurações originais de fábrica fisicamente no 

equipamento (reset); 
81. Suportar operação em humidade de 5% a 95% sem condensação; 
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82. Suportar operação em temperatura de até 40°C (quarenta graus centígrados); 
83. Possuir um MTBF (Mean Time Between Failure - Período Médio entre Falhas) de, no mínimo, 

250.000 horas. 

  

Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos equipamentos, 
indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 27 – PONTO DE ACESSO INTERNO TIPO 02 

Características gerais 

1. Equipamento de Ponto de Acesso para rede local sem fio, configurável via software, com 
funcionamento simultâneo nos padrões IEEE 802.11a/n/ac, 5GHz, e IEEE 802.11b/g/n, 
2.4GHz; 

2. Todos os Pontos de acesso sem fio deverão ser novos e sem nenhum histórico de utilização; 
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3. Os pontos de acesso deverão possuir certificado emitido pelo “WIFI Alliance” comprovando 
no mínimo os seguintes padrões, protocolos e funcionalidades: 

a. IEEE 802.11a; 
b. IEEE 802.11b; 
c. IEEE 802.11g; 
d. IEEE 802.11n; 
e. IEEE 802.11d; 
f. IEEE 802.11ac; 
g. WPA® Enterprise/Personal; 
h. WPA2® Enterprise/Personal; 
i. EAP-TLS; 
j. EAP-TTLS/MSCHAPv2; 
k. PEAPv0/EAP-MSCHAPv2; 
l. PEAPv1/EAP-GTC; 
m. EAP-SIM; 
n. EAP-FAST; 
o. WMM® e WMM® Power Save; 
p. Beamforming; 
q. Short Guard Interval (SGI); 
r. Packet Aggregation (A-MPDU); 
s. Opportunistic Key Caching (OKC) 

4. Deve operar simultaneamente em 2.4GHz e 5GHz (concurrent dual-band); 

  

Performance 

5. Deve suportar rádio dual, 5 GHz 802.11ac 4x4 MIMO e 2.4 GHz 802.11n 2x2 MIMO; 
6. Deve possuir rádio duplo configurável pelo software, suportando 5 GHz e 2,4 GHz; 
7. Deve possuir quatro spatial stream Single User (SU) MIMO para taxa de dados sem fio de até 

1,733 Mbps, em 5GHz; 
8. Deve possuir três spatial stream Multi User (MU) MIMO para uma taxa de dados sem fio de 

até 1,300 Mbps para dispositivos clientes compatíveis, em 5GHz; 
9. Deve possuir suporte para até 255 dispositivos cliente associados por rádio e até 16 BSSIDs 

por rádio; 
10. Deve suportar no mínimo as bandas de frequência: 

a. 2,400 a 2,4835 GHz 
b. 5.150 a 5.250 GHz 
c. 5.250 a 5.350 GHz 
d. 5,470 a 5,725 GHz 
e. 5,725 a 5,850 GHz 

11. Deve possuir suporte a seleção de frequência dinâmica (DFS) otimizando o uso do espectro 
de RF disponível; 

12. Deve suportar, no mínimo, as seguintes tecnologias de rádio: 

a. 802.11b: espectro espalhável de sequência direta (DSSS); 
b. 802.11a / g / n / ac: multiplexação por divisão de frequência ortogonal (OFDM); 
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13. Deve suportar, no mínimo, os seguintes tipos de modulação: 

a. 802.11b: BPSK, QPSK, CCK; 
b. 802.11a / g / n / ac: BPSK, QPSK, 16-QAM, 64-QAM, 256-QAM; 

14. Deve possuir potência de transmissão configurável em incrementos de 0,5 dBm; 
15. Deve respeitar os limites de potência de transmissão máxima (conduzida): 

a. Faixa de 2,4 GHz: +18 dBm por corrente, agregado de +24 dBm (3x3); 
b. Faixa de 5 GHz: +18 dBm por corrente, agregado de +24 dBm (4x4); 

16. Deve suportar Advanced Cellular Coexistence (ACC) minimizando a interferência das redes 
celulares; 

17. Deve suportar Maximum Ratio Combining (MRC) para melhorar o desempenho do receptor; 
18. Deve suportar Cyclic delay/shift diversity (CDD/CSD) para melhorar o desempenho RF de 

downlink; 
19. Deve suportar Short guard interval para canais de 20-MHz, 40-MHz e 80-MHz; 
20. Deve suportar Space-time block coding (STBC) para aumentar o alcance e melhorar a 

recepção; 
21. Deve suportar verificação de paridade de baixa densidade (LDPC) para correção de erros de 

alta eficiência e aumento da taxa de transferência; 
22. Deve suportar Transmit beam-forming (TxBF); 
23. Deve possuir, no mínimo, as seguintes taxas de dados suportadas (Mbps): 

a. 802.11b: 1, 2, 5.5, 11 
b. 802.11a/g: 6, 9, 12, 18, 24, 36, 48, 54 
c. 802.11n: 6.5 até 450 (MCS0 até MCS23) 
d. 802.11ac: 6.5 até 1,733 (MCS0 até MCS9, NSS = 1 até 4) 

24. Deve possuir suporte a 802.11n de alto rendimento (HT): HT 20/40; 
25. Deve possuir suporte a 802.11ac de alta velocidade (VHT): VHT 20/40/80; 
26. Deve possuir suporte a agregação de pacotes 802.11n/ac: A-MPDU, A-MSDU; 

  

   Gerenciamento 

27. Deve implementar funcionamento de modo auto gerenciado, sem necessidade de 
controladora WLAN para configuração de seus parâmetros de rede wireless, gerenciamento 
das políticas de segurança, QoS e monitoramento de RF. 

28. Deve obedecer a todas as características descritas mesmo neste modo de funcionamento; 
29. No modo de funcionamento autogerenciado deve disponibilizar na interface gráfica 

informações de usuários conectados, qualidade de sinal e trafego de dados na rede; 
30. O ponto de acesso deve permitir a conversão de modo auto gerenciado para modo 

gerenciado por controlador WLAN através de interface gráfica, em browser padrão (HTTPS), e 
permitir que todos os demais pontos de acesso pertencentes ao mesmo cluster, também 
sejam convertidos automaticamente; 

31. O ponto de acesso deverá suportar conexão direta ou remota com controlador WLAN, 
inclusive via roteamento da camada de rede, baseado no modelo OSI; 
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32. Se um controlador WLAN falhar, os Pontos de Acesso relacionados deverão se associar 
automaticamente a um controlador WLAN alternativo, não permitindo que a rede wireless se 
torne inoperante; 

33. Implementar mecanismo de funcionamento para trabalhar com controladores WLAN em 
redundância; 

34. Deve permitir que o ponto de acesso seja atualizado de forma centralizada pela interface 
gráfica; 

35. Permitir o armazenamento de sua configuração em memória não volátil, podendo, numa 
queda e posterior restabelecimento da alimentação, voltar à operação normalmente na 
mesma configuração anterior; 

36. Deve possuir servidor DHCP interno configurável; 
37. Possibilitar backup e restore da configuração através da interface gráfica; 
38. Deve possuir Portal Captivo (Captive Portal) integrado para utilização em rede de visitantes; 
39. Deve possuir mecanismos para proteção contra Pontos de Acesso não autorizados (Rogues); 
40. Possuir capacidade de identificação e listagem dos rádios vizinhos e respectivos SSID/BSSID; 
41. Implementar associação dinâmica de usuários à VLANs com base nos parâmetros da etapa 

de autenticação; 
42. Deve possuir uma base de usuários interna que diferencie usuários visitantes de 

funcionários, para ser usada em autenticação 802.1x ou portal captivo; 
43. Permitir a autenticação para acesso dos usuários conectados nas redes WLAN (Wireless) 

através: 

a. MAC Address 
b. 802.1x em base Local 
c. Captive Portal 
d. 802.1x em base externa RADIUS 
e. 802.1x em base externa LDAP 

44. Deve permitir a seleção/uso de servidor de autenticação específico com base no SSID; 
45. Implementar o protocolo de enlace CSMA/CA para acesso ao meio de transmissão; 
46. Possuir capacidade de selecionar automaticamente o canal de transmissão; 
47. Permitir o ajuste dinâmico de nível de potência e canal de rádio de modo a otimizar o 

tamanho da célula de RF; 
48. Permitir habilitar e desabilitar a divulgação do SSID; 
49. Implementar diferentes tipos de combinações encriptação/autenticação por SSID; 
50. Implementar padrão WMM da Wi-Fi Alliance para priorização de tráfego, suportando 

aplicações em tempo real, tais como, VoIP, vídeo, dentre outras; 
51. Não deve haver no licenciamento restrições com relação ao número de dispositivos 

conectados por ponto de acesso; 
52. Implementar a pilha de protocolos TCP/IP com suporte a IPV4 e IPV6 (Bridging); 
53. Implementar VLANs conforme padrão IEEE 802.1Q; 
54. Possuir, no mínimo, uma interface IEEE 802.3 10/100/1000BaseT Ethernet, auto- sensing, 

auto MDI/MDX; 
55. Permitir a atualização remota do sistema operacional e arquivos de configuração através da 

controladora WLAN 
56. Implementar cliente DHCP, para configuração automática de rede; 
57. Deve configurar-se automaticamente ao ser conectado na rede; 
58. Possuir LED’s indicativos do estado de operação, da atividade do rádio e da interface 

Ethernet; 
59. Possuir estrutura que permita fixação do equipamento em teto e parede e fornecer 

acessórios para que possa ser feita a fixação; 
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60. Deve ser acompanhado de todos os acessórios necessários para operacionalização do 
equipamento, tais como: softwares, cabos de console, cabos de energia elétrica, 
documentação técnica e manuais (podendo ser em CD-ROM) que contenham informações 
suficientes para possibilitar a instalação, configuração e operacionalização do equipamento; 

61. Permitir o bloqueio da configuração do Ponto de Acesso via rede wireless; 
62. Implementar varredura de RF nas bandas 802.11a, 802.11b, 802.11g, 802.11n, para 

identificação de Pontos de Acesso intrusos não autorizados (rogues) e interferências no canal 
habilitado ao ponto de acesso e nos demais canais configurados na rede WLAN, sem impacto 
no seu desempenho; 

63. Implementar IEEE 802.1x, com pelo menos os seguintes métodos EAP: 

a. EAP- MD5 
b. EAP-FAST 
c. EAP-TLS 
d. PEAP-GTC 
e. PEAP-MSCHAPv2 

64. Permitir a integração com RADIUS Server com suporte aos métodos EAP citados; 
65. A comunicação entre todos os pontos de acesso sem fio e a controladora deverá ser 

criptografada; 
66. Suportar a autenticação com geração dinâmica de chaves criptográficas por sessão e por 

usuário; 
67. Implementar WPA com algoritmo de criptografia TKIP e MIC; 
68. Implementar WPA2 com algoritmo de criptografia AES, 128/256 bits, IEEE 802.11i; 
69. Deve possuir modo dedicado de funcionamento de análise de espectro das faixas de 

frequência de 2.4 e 5 GHz identificando fontes de interferência nessas faixas; 
70. Deve possibilitar analise de espectro nos canais em que estiver provendo acesso, sem 

desconectar os usuários; 
71. Deve disponibilizar informações gráficas de análise de espectro em conjunto com o 

controlador WLAN; 
72. O equipamento deverá possuir registro na ANATEL e deverá ser apresentado na entrega do 

equipamento; 
73. Deverá prover priorização de trafego de vídeo e voz através de parâmetros de QoS (Quality 

os Service) com possibilidade de aplicar por SSID e dispositivo; 
74. Possibilitar roaming na rede wireless; 
75. Suportar a criação de uma rede de convidados autocontida com isolamento de tráfego entre 

clientes e serviços locais; 
76. Possuir recursos de seleção automática de canal de transmissão procurando por canais onde 

haja menor interferência, tendo por objetivo melhorar a performance da rede wireless; 
77. Permitir a operação em estrutura Mesh viabilizando a comunicação direta entre diferentes 

Pontos de Acesso sem Fio onde não seja possível estender a rede cabeada; 
78. Operando em estrutura Mesh, a comunicação entre os dispositivos estrutura deverão operar 

na frequência de 5Ghz. 
79. Possuir mecanismo para a restauração das configurações originais de fábrica fisicamente no 

equipamento (reset); 
80. Suportar operação em humidade de 5% a 95% sem condensação; 
81. Suportar operação em temperatura de até 40°C (quarenta graus centígrados); 
82. Possuir um MTBF (Mean Time Between Failure - Período Médio entre Falhas) de, no mínimo, 

250.000 horas. 
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Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e 
atendimento. O prazo máximo para atendimento do chamado deve ser de até o próximo dia 
útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
área para cadastro da solução de hardware ofertada, possibilitando assim que a 
CONTRATANTE possa receber de forma proativa, durante todo período da garantia as 
notificações de atualizações e correções (“hotfix”) da solução; 

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 
exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica 
local no domicílio da contratante e na modalidade on-site, devendo essa ser realizada por 
meio de documentação oficial do fabricante dos produtos e de domínio público, através de 
catálogos, folder impressos ou da internet, devendo constar o endereço URL na mesma. Caso 
não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos equipamentos, 
indicando a referida assistência técnica que será responsável pelo atendimento e 
manutenção durante o período de garantia dos produtos ofertados. Em caso de 
documentação expressa do fabricante a esta deverá ser anexada uma procuração que 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as 
exigências solicitadas. 

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 
permitida a integração de itens de terceiros que possam acarretar em perda parcial da 
garantia ou não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 28 – INJETOR POE PARA PONTOS DE ACESSO TIPO 1 

Características técnicas mínimas 

1. Deve ser do mesmo fabricante dos Pontos de acesso ou homologado e certificado pelo 
mesmo para utilização em seus equipamentos; 

2. Injetor PoE 802.3af 10/100/1000 Ethernet com 15.4W; 

  

Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
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equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

3. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 29 – INJETOR POE PARA PONTOS DE ACESSO TIPO 2 

Características técnicas mínimas 

1. Deve ser do mesmo fabricante dos Pontos de acesso ou homologado e certificado pelo 
mesmo para utilização em seus equipamentos; 

2. Injetor PoE+ 802.3at 10/100/1000 Ethernet com 30W; 

  

Garantia e Suporte 

1. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão 
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) 
dias úteis; 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (part number), 
incorporado ao equipamento; 

3. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada. 

  

ITEM 30 – SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE TECNOLOGIA PARA SOLUÇÃO DE 
GERENCIAMENTO 

Características Gerais 

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das 14:00 às 18:00) 
presencialmente no TRE-AL ou remotamente conforme necessidades da CONTRATANTE; 

  

Implantação 

2. Instalação e configuração de 1 (uma) instância do serviço de gerenciamento de rede, 
contemplando: 
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a. Configurações básicas para acesso à rede, dimensionamento e configuração de 
armazenamento; 

b. Inclusão de no mínimo 10 (dez) pontos de acesso no monitoramento; 
c. Criação de modelo de configuração (templates) de forma a possibilitar a replicação de 

configuração entre equipamentos. 

  

Transferência De Tecnologia 

3. O treinamento deverá ser no realizado na modalidade workshop com tarefas práticas hands-
on, visando assim a melhor fixação dos temas abordados com foco direto na explicação da 
tecnologia da solução como também nas rotinas de configuração, gerenciamento, 
administração e operação da mesma; 

  

4. O treinamento do MÓDULO DE GERENCIA DE REDE deverá ter duração mínima de 24 (vinte e 
quatro) horas onde será abordado, no mínimo, os seguintes tópicos: 

a. Inserção, modificação e remoção de dispositivos de forma unitária e em lote; 
b. Configuração de VLANs Globais e Locais em switchs gerenciados; 
c. Configuração de ACLS Globais e Locais em switchs gerenciados; 
d. Backup e restore de configuração de switchs gerenciados; 
e. Monitoramento e alarmes default e customizados; 
f. Customização do Dashboard com alertas, mapas de topologia e monitoramento de 

dispositivos; 

  

ITEM 31- SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE TECNOLOGIA DO MÓDULO DE CONTROLE 
DE ACESSO 

Características Gerais 

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das 14:00 às 18:00) 
presencialmente no TRE-AL ou remotamente conforme necessidades da CONTRATANTE; 

  

Implantação 

2. Instalação e configuração de 1 (uma) instancia do serviço controle de acesso, contemplando: 

a. Configurações básicas para acesso à rede, dimensionamento e configuração de 
armazenamento; 

b. Configuração de autenticação em Active Directory para usuários corporativos; 
c. Configuração de autenticação de visitantes com portal de autosserviço para criação de 

usuários; 
d. Configuração de no mínimo 5 (cinco) dispositivos de rede para autenticação na solução. 
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Transferência de Tecnologia 

3. O treinamento deverá ser no realizado na modalidade workshop com tarefas práticas hands-
on, visando assim a melhor fixação dos temas abordados com foco direto na explicação da 
tecnologia da solução como também nas rotinas de configuração, gerenciamento, 
administração e operação da mesma devendo ter duração mínima de 24 (vinte e quatro) 
horas onde será abordado no mínimo os seguintes tópicos: 

a. Configuração de Active Directory como base de autenticação; 
b. Configuração de autenticação de usuários corporativos; 
c. Configuração de autenticação de usuários visitantes; 
d. Configuração de portal de autosserviço; 
e. Configuração de autenticação e autorização com protocolo RADIUS. 

ITEM 32– SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE TECNOLOGIA PARA CONTROLADORA 
WLAN E PONTOS DE ACESSO 

  

Características Gerais 

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das 14:00 às 18:00) 
presencialmente no TRE-AL ou remotamente conforme necessidades da CONTRATANTE; 

  

Implantação 

2. Instalação e configuração de no mínimo 10 (dez) pontos de acesso, contemplando: 

a. Configuração básica de acesso a gerência via rede; 
b. Configuração de gerência e monitoramento em MÓDULO DE GERENCIA DE REDE; 
c. Configuração da autenticação de usuários em MÓDULO DE CONTROLE DE ACESSO 
d. Configuração de pontos de acesso em controladora WLAN habilitando gerenciamento 

centralizado; 

  

Transferência de Tecnologia 

3. O treinamento deverá ser no realizado na modalidade workshop com tarefas práticas hands-
on, visando assim a melhor fixação dos temas abordados com foco direto na explicação da 
tecnologia dos produtos ofertados como também nas rotinas de configuração, 
gerenciamento, administração e operação dos mesmos devendo ter duração mínima de 16 
(Dezesseis) horas onde será abordado no mínimo os seguintes tópicos: 

a. Configuração inicial e acesso a gerência; 
b. Configuração de Clusters; 
c. Configuração de autenticação de usuários em MÓDULO DE CONTROLE DE ACESSO; 
d. Criação de SSID com autenticação PSK; 
e. Criação de SSID com autenticação enterprise em MÓDULO DE CONTROLE DE ACESSO; 
f. Configuração de pontos de acesso para MÓDULO DE GERENCIA DE REDE; 
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g. Configuração pontos de acesso para MÓDULO DE ANÁLISE DE TRÁFEGO; 

  

ITEM 33 – TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE ARQUITETURA WLAN 

  

Características Gerais 

7. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do fabricante no 
Treinamento Básico De Administração De Arquitetura Wlan para 01 (um) profissional da 
contratante; 

8. O voucher deverá ter validade de pelo menos 12 (doze) meses; 
9. O treinamento deverá ser de acordo com o calendário de treinamento do fabricante e 

ministrado em centro oficial de treinamento do mesmo ou remotamente, utilizando 
tecnologia de ensino a distância; 

10. Deverá ser ministrado por profissional devidamente credenciado junto ao fabricante e apto a 
entregar o respectivo; 

11. O treinamento deverá compreender a explicação da tecnologia da solução como também das 
rotinas de configuração, gerenciamento, administração e operação da mesma; 

12. O treinamento deverá ter carga horária mínima de 20 (vinte) horas, ministrado no período de 
08:00 às 12:00 e das 14:00 às 18:00. 

  

ITEM 34 – TREINAMENTO BÁSICO DA SOLUÇÃO DE GERENCIAMENTO 

  

Características Gerais 

1. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do fabricante no 
Treinamento da Solução de Gerenciamento para 01 (um) profissional da contratante; 

2. O voucher deverá ter validade de pelo menos 12 (doze) meses; 
3. O treinamento deverá ser de acordo com o calendário de treinamento do fabricante e 

ministrado em centro oficial de treinamento do mesmo ou remotamente, utilizando 
tecnologia de ensino a distância; 

4. Deverá ser ministrado por profissional devidamente credenciado junto ao fabricante e apto a 
entregar o respectivo; 

5. O treinamento deverá compreender a explicação da tecnologia da solução como também das 
rotinas de configuração, gerenciamento, administração e operação da mesma; 

6. O treinamento deverá ter carga horária mínima de 40 (Quarenta) horas, ministrado no 
período de 08:00 às 12:00 e das 14:00 às 18:00. 

  

ITEM 35 – TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE ACESSO 

  

Características Gerais 
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7. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do fabricante no 
Treinamento da Solução de Controle de Acesso para 01 (um) profissional da contratante; 

8. O voucher deverá ter validade de pelo menos 12 (doze) meses; 
9. O treinamento deverá ser de acordo com o calendário de treinamento do fabricante e 

ministrado em centro oficial de treinamento do mesmo ou remotamente, utilizando 
tecnologia de ensino a distância; 

10. Deverá ser ministrado por profissional devidamente credenciado junto ao fabricante e apto a 
entregar o respectivo; 

11. O treinamento deverá compreender a explicação da tecnologia da solução como também das 
rotinas de configuração, gerenciamento, administração e operação da mesma; 

12. O treinamento deverá ter carga horária mínima de 40 (Quarenta) horas, ministrado no 
período de 08:00 às 12:00 e das 14:00 às 18:00. 

3.2 Forma de Execução e de Gestão do Contrato (Art. 18, § 3º, III, a) 

A execução do objeto pressupõe a existência dos seguintes papéis e 
responsabilidades (Art. 18, § 3º, III, a, 1): 

1. Patrocinador da Contratação: é o titular da área demandante, responsável por representar os 
interesses do órgão no contexto da Contratação, pela aprovação da necessidade e, por fim, 
pela negociação das ações necessárias para que os objetivos sejam alcançados; 

2. Gestor do Contrato (art. 3º, IV, da Resolução TRE/AL nº 15.787/2017): servidor designado 
para coordenar e comandar o processo da fiscalização da execução contratual. Na forma do 
Art. 17 da mesma Resolução, o gestor do contrato responsabiliza-se pela condução da gestão 
e fiscalização do contrato, nos termos do Art. 67, da Lei nº 8.666/93. 

3. Fiscal do Contrato (art. 3º, VI, da Resolução TRE/AL nº 15.787/2017): servidor designado para 
auxiliar o gestor do contrato quanto à fiscalização do objeto do contrato. Neste sentido, 
indicado pela respectiva autoridade competente para fiscalizar o Contrato quanto aos 
aspectos técnicos da solução. 

Dinâmica da Execução (Art. 18, § 3º, III, a, 2): 

1. Os equipamentos deverão ser entregues no Almoxarifado do TRE/AL, nos quantitativos 
indicados no pedido de fornecimento; 

2. A garantia dos equipamentos deve obedecer o detalhamento técnico feito e terá seu tempo 
contado por cada fornecimento individualmente; 

3. Entende-se como garantia aquela prestada pelo próprio fabricante ou por rede 
credenciada pelo fabricante do(s) referido(s) equipamento(s); 

4. O pagamento será realizado individualmente para cada nota fiscal apresentada, 
após emissão do aceite definitivo pela unidade competente do TRE/AL; 

5. Os equipamentos deverão ser novos, não recondicionados, de primeiro uso e não deverão 
conter marcas, amassados, arranhões ou outros problemas e, ainda, serem entregues em 
pleno estado de funcionamento; 

6. Os equipamentos deverão atender rigorosamente a todas as especificações técnicas contidas 
neste Termo de Referência e em seus Anexos; 

7. Os equipamentos deverão vir acompanhados de todos os acessórios necessários para o seu 
pleno estado de funcionamento, como cabos, drivers, mídias e outros, os quais só serão 
recebidos juntamente com os respectivos equipamentos. Este item se aplica tanto para a 
entrega dos equipamentos quanto para substituições durante o período de garantia; 

8. Ao TRE é reservado o direito de efetuar conexões dos equipamentos a outros, bem como 
adicionar demais acessórios compatíveis tecnicamente, sem que isso constitua motivo para a 
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Contratada se desobrigar da garantia, desde que tal fato não implique danos materiais 
ou técnicos aos equipamentos e acessórios, hipótese que deverá ser devidamente 
comprovada; 

9.  Ao TRE/AL é reservado o direito de efetuar diligência, a qualquer tempo, quanto aos 
documentos exigidos neste Termo de Referência e em seus Anexos. 

Recebimento do Objeto: 

1. O Tribunal designará Comissão para realizar o recebimento provisório, que só será emitido se 
os equipamentos estiverem de acordo com as especificações técnicas; 

2. Após a entrega, os equipamentos serão submetidos à avaliação e homologação pelos 
responsáveis técnicos do Tribunal; 

3.  O exame para comprovação das características técnicas consistirá em avaliações e testes 
não-destrutivos, por amostragem realizados em duas etapas: 

a. Primeira: inspeção visual de todos os equipamentos entregues; 
b. Segunda: testes funcionais de configuração e desempenho, em, no mínimo, 10% (dez 

por cento) e não menos do que 01 (um) dos equipamentos recebidos. O Tribunal 
poderá, a seu critério, executar os testes nos demais equipamentos, dentro de 
um critério de razoabilidade, podendo chegar a 100% dos quantitativos, mas dentro 
de um prazo máximo de 30 (trinta) dias corridos e contados de cada lote de 
equipamentos. 

4. As especificações serão avaliadas também por meio de documentos técnicos que 
acompanham os equipamentos, informações fornecidas pela Contratada e disponível no 
sítio do fabricante. 

5. A comissão do Tribunal deverá, após a comprovação do perfeito funcionamento dos 
equipamentos e adequação às especificações técnicas, emitir e assinar o Termo de 
Recebimento Definitivo. 

Instrumentos Formais de Solicitação do(s) Bens e/ou Serviço(s) (Art. 18, § 3º, III, a, 
3): 

1. A Ordem de Fornecimento será o instrumento formal de solicitação dos bens pertencentes ao 
escopo desta contratação. 

Forma de Pagamento (Art. 18, § 3º, III, a, 7) 

1. O pagamento será efetuado mediante crédito em conta-corrente do Fornecedor, por ordem 
bancária, no prazo disposto nos artigos 5º, § 3º, ou 40, XIV, “a”, da Lei n. 8.666/93, conforme 
o caso, quando mantidas as mesmas condições iniciais de habilitação e cumpridos os 
seguintes  requisitos: 

a. Apresentação de nota fiscal de acordo com a legislação vigente à época da emissão 
(nota fiscaleletrônica, se for o caso), acompanhada da Certidão Negativa de Débito – 
CND, comprovando regularidade com o INSS; do Certificado de Regularidade do FGTS 
– CRF, comprovando regularidade com o FGTS; da Certidão Conjunta Negativa de 
Débitos Relativos a Tributos Federais e à Dívida Ativa da União, expedida pela 
Secretaria da Receita Federal; e da Certidão Negativa de Débitos Trabalhistas – CNDT, 
emitida pela Justiça do Trabalho; e  da prova de regularidade para com as Fazendas 
Estadual e Municipal do domicílio ou sede do Fornecedor; e 

b. Inexistência de fato impeditivo para o qual tenha concorrido o Fornecedor. 
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2. Nenhum pagamento será efetuado à Contratada enquanto pendente de liquidação qualquer 
obrigação. Esse fato não será gerador de direito a reajustamento de preços ou a atualização 
monetária. 

Direitos de Propriedade Intelectual (Art. 18, § 3º, III, a, 9): 

1. Esse requisito não se aplica ao contexto desta contratação, uma vez que o objeto se refere 
ao fornecimento de equipamentos, cujos direitos autorais do fabricante são resguardados 
por legislação nacional e internacional. 

Penalidades (Art. 18, § 3º, III, a, 11): 

1. Com fundamento no artigo 7º da Lei nº 10.520/2002 e, subsidiariamente, nos artigos 86 e 87 
da Lei 8.666/1993, a Contratada ficará sujeita, assegurada prévia e ampla defesa, 
às seguintes penalidades: 

a. Advertência: 
i. A Contratada será notificada formalmente em caso de descumprimento de 

obrigação contratual e terá que apresentar as devidas justificativas em um 
prazo de até 5 (cinco) dias úteis após o recebimento da 
notificação; e 

ii. Caso não haja manifestação dentro desse prazo ou se entenda serem 
improcedentes as justificativas apresentadas, a Contratada será advertida; 

b. Multa de: 

i. 0,5% por dia, sobre o valor constante da Ordem de Fornecimento, no caso de 
atraso injustificado na entrega dos equipamentos, limitada a incidência a 20 
(vinte) dias corridos; 

1. No caso de atraso injustificado na entrega dos equipamentos por prazo s
uperior a 20 (vinte) dias corridos, com 
a aceitação pela Administração, será aplicada a multa de 10% sobre o 
valor da Ordem de Fornecimento; e 

2. No caso de atraso injustificado na entrega dos equipamentos por prazo s
uperior a 20 (vinte) dias corridos, com a 
não aceitação pela Administração, será aplicada a penalidade 20% sobre 
o valor da Ordem de Fornecimento, no caso de inexecução total da 
obrigação, podendo haver, ainda, o cancelamento do registro de preços 
do Fornecedor; 

ii.  0,5% por dia, sobre o valor do equipamento, 
no caso de atraso injustificado na solução do chamado de garantia, limitada a i
ncidência 30 (trinta) dias corridos; 

1. No caso de atraso injustificado na solução do chamado de garantia por p
razo superior a 30 (trinta) dias corridos, aplica-se adicionalmente, 
a multa de 1% sobre o valor da Ordem de Fornecimento; e 

2. A multa por atraso relacionada ao item 
anterior será auferida por Ordem de Fornecimento e aplicada somente u
ma única vez a cada mês, independente da quantidade 
de equipamentos sem solução. 

iii. 10% sobre o valor constante da Ordem de Fornecimento, no caso de 
inexecução parcial da obrigação assumida; 
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iv. 20% sobre o valor da Ordem de Fornecimento, no caso de inexecução total da 
obrigação, podendo haver, ainda, o cancelamento do registro de preços do 
Fornecedor; 

v. 10% sobre o valor global estimado da Ata de Ata de Registro de Preços, na 
hipótese de recusa em assinar a Ata ou o instrumento do contrato, ou retirar a 
Ordem de Fornecimento. 

c. Impedimento de licitar e contratar com a União e descredenciamento do SICAF pelo 
prazo de até 5 (cinco) anos, sem prejuízo das demais penalidades legais; e 

d. Declaração de inidoneidade para licitar ou contratar com a Administração Pública. 
2. O cometimento reiterado de atrasos injustificados dos prazos previstos para entrega/solução 

do chamado de garantia dos equipamentos poderá resultar no cancelamento do registro 
de preços com a Contratada. 

3. As sanções previstas nos itens "1.a", “1.c” e “1.d” do item 1 poderão ser aplicadas, 
cumulativamente ou não, à pena de multa. 

4. O valor da multa, aplicada após o regular processo administrativo, será descontado de 
pagamentos eventualmente devidos à contratada ou cobrado judicialmente; 

5. Excepcionalmente, ad cautelam, a Administração poderá efetuar a retenção do valor 
presumido da multa, antes da instauração do regular procedimento administrativo. 
. 
  

4. Requisitos Técnicos (Art. 18, § 3º, IV) 

  

Garantia mínima de 36  (trinta e seis) meses. 

Estar comprovadamente ainda em produção. 

Conformidade com o presente Termo de Referência. 

5. Modelos (templates) propostos a serem utilizados na contratação (Art. 18, § 3º, III, V) 

Memorando nº ____ / 20__ - TRE-AL/_______________________ 

Maceió, ___ de ___________ de _____________. 

Para: SGO-COFIN 

Assunto: Autorização de Emissão de Nota de Empenho. 

PA _________________________ 

Adesão à Ata de Registro de Preços ______________ 

Ordem de Fornecimento nº _____/_________. 

 
  

Senhor Chefe 

Encaminhamos estes autos para emissão de Nota de Empenho, em favor da Empresa ________________. CNPJ: 
xx.xxx.xxx/xxxx-xx, conforme tabela abaixo, tudo em conformidade com o disposto na Resolução TRE-AL nº 
12.738/1996 (0216181). 

Certidões: SICAF evennto: ______ / RECEITA ESTADUAL evento: ______ / SIMPLES NACIONAL (se aderente) 
evento: __________ 

Item: 
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Descrição: 

Quant. total da 
ATA 

Quant. 
Recebida 

Quant. desta 
Ordem 

Saldo no 
Fornecedor 

Valor 
Unitário 

Valor Total 
(R$) 

            

  

*  Solicitamos utilizar a reserva de crédito do PE XXX/XXXX 

  

  

Gestor da Ata - Portaria TRE/AL nº XX/XXXX 

  

Moodelo a ser adotado em decorrência do comando inserto no Proc SEI nº 0005423-07.2018.6.02.8000, 
evento 0442132: modelo de referência indicado: 0452895. 

Maceió, 15 de maio de 2019. 

 
DANIEL MACÊDO DE CARVALHO SOUTO 

 Coordenador 
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       ANEXO I-A 
 

ESPECIFICAÇÕES DOS LOTES, ITENS, QUANTITATIVOS A SEREM 
ADQUIRIDOS E PREÇOS MÁXIMOS ADMITIDOS 

 

Lote  Item Qtd Descrição Valor 
Unitário 

Valor Total 

 

01 

1 1 SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 
PARA REDE CABEADA 

R$ 104.180,00 R$ 104.180,00 

2 3 LICENCIAMENTO ADICIONAL PARA SISTEMA DE 
GERENCIAMENTO HPE IMC 

R$ 15.890,00 R$ 47.670,00 

3 2 LICENCIAMENTO ADICIONAL DO MÓDULO DE ANÁLISE DE 
TRAFEGO DO SISTEMA DE GERENCIAMENTO HPE IMC 

R$ 12.745,00 R$ 25.490,00 

4 2 LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE 
PERFIL E CONTROLE DE ACESSO 

R$ 54.160,00 R$ 108.320,00 

5 6 SWITCH DE DISTRIBUIÇÃO COM 16 PORTAS SFP+ E 
SUPORTE A MÓDULOS DE EXPANSÃO 

R$ 49.117,00 R$ 294.702,00 

6 16 MÓDULO COM 4 PORTAS SFP+ PARA SWITCH DE 
DISTRIBUIÇÃO 

R$ 4.742,00 R$ 75.872,00 

7 6 MÓDULO DE STACKING COM 4 PORTAS PARA SWITCH DE 
DISTRIBUIÇÃO 

R$ 4.406,00 R$ 26.436,00 

8 50 SWITCH DE ACESSO L3 COM 48 PORTAS GIGABIT E 4SFP+ R$ 14.382,08 R$ 719.104,00 

9 40 SWITCH DE ACESSO L3 COM 24 PORTAS GIGABIT E 4SFP+ R$ 14.106,00 R$ 564.240,00 

10 50 SWITCH DE ACESSO L2 COM 24 PORTAS GIGABIT E 4SFP R$ 4.515,00 R$ 225.760,00 

11 40 SWITCH DE ACESSO L2 COM 48 PORTAS GIGABIT E 4SFP
    

R$ 8.245,00 R$ 329.800,00 

12 50 GBIC 10GB PARA ATÉ 300M R$ 2.064,87 R$ 103.243,50 

13 30 CABO DAC 10 GBPS DE 1M  R$ 411,00 R$ 12.330,00 

14 30 CABO DAC 10 GBPS DE 3M R$ 584,00 R$ 17.520,00 

15 10 GBIC 1GB PARA ATÉ 500M R$ 740,46 R$ 7.404,60 

16 5 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA SWITCHS DE REDE 

R$ 20.000,00 R$ 100.000,00 

17 1 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO
  

R$ 60.000,00 R$ 60.000,00 

18 4 TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE SWITCHES R$ 28.000,00 R$ 112.000,00 

19 4 TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE 
ACESSO 

R$ 28.000,00 R$ 112.000,00 

02 

20 1 SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 
PARA REDE WIRELESS 

R$ 104.180,00 R$ 104.180,00 

21 1 SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS R$ 570,00 R$ 570,00 

22 200 LICENÇAS ADICIONAIS PARA SOLUÇÃO DE GERENCIAMENTO 
DE REDE WIRELESS 

R$ 497,21 R$ 99.442,00 

23 2 LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE 
PERFIL E CONTROLE DE ACESSO 

R$ 55.000,00 R$ 110.000,00 

24 4 CONTROLADORA WLAN R$ 70.000,00 R$ 280.000,00 

25 200 LICENÇAS ADICIONAIS PARA CONTROLADORA WLAN
    

R$ 900,00 R$ 180.000,00 

26 100 PONTO DE ACESSO INTERNO TIPO 01 R$ 3.076,79 R$ 307.679,00 

27 100 PONTO DE ACESSO INTERNO TIPO 02 R$ 2.300,00 R$ 230.000,00 

28 100 INJETOR POE PARA PONTOS DE ACESSO TIPO 1 R$ 500,00 R$ 50.000,00 

29 100 INJETOR POE PARA PONTOS DE ACESSO TIPO 2 R$ 550,00 R$ 55.000,00 

30 1 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA SOLUÇÃO DE GERENCIAMENTO 

R$ 24.000,00 R$ 24.000,00 

31 1 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO 

R$ 24.000,00 R$ 24.000,00 
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32 5 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA PONTOS DE ACESSO 

R$ 20.000,00 R$ 100.000,00 

33 4 TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE 
ARQUITETURA WLAN 

R$ 20.000,00 R$ 80.000,00 

34 4 TREINAMENTO BÁSICO DA SOLUÇÃO DE GERENCIAMENTO R$ 20.000,00 R$ 80.000,00 

35 4 TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE 
ACESSO    

R$ 20.000,00 R$ 80.000,00 
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        ANEXO I-B 
 

       PLANILHA DE COMPOSIÇÃO DE CUSTOS POR ITEM 

 

Lote 1 Item Qtd Descrição Valor 
Unitário 

Valor 
Total 

 

01 

1 1 SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 
PARA REDE CABEADA 

  

2 3 LICENCIAMENTO ADICIONAL PARA SISTEMA DE 
GERENCIAMENTO HPE IMC 

  

3 2 LICENCIAMENTO ADICIONAL DO MÓDULO DE ANÁLISE DE 
TRAFEGO DO SISTEMA DE GERENCIAMENTO HPE IMC 

  

4 2 LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE 
PERFIL E CONTROLE DE ACESSO 

  

5 6 SWITCH DE DISTRIBUIÇÃO COM 16 PORTAS SFP+ E SUPORTE A 
MÓDULOS DE EXPANSÃO 

  

6 16 MÓDULO COM 4 PORTAS SFP+ PARA SWITCH DE 
DISTRIBUIÇÃO 

  

7 6 MÓDULO DE STACKING COM 4 PORTAS PARA SWITCH DE 
DISTRIBUIÇÃO 

  

8 50 SWITCH DE ACESSO L3 COM 48 PORTAS GIGABIT E 4SFP+   

9 40 SWITCH DE ACESSO L3 COM 24 PORTAS GIGABIT E 4SFP+   

10 50 SWITCH DE ACESSO L2 COM 24 PORTAS GIGABIT E 4SFP   

11 40 SWITCH DE ACESSO L2 COM 48 PORTAS GIGABIT E 4SFP 
   

  

12 50 GBIC 10GB PARA ATÉ 300M   

13 30 CABO DAC 10 GBPS DE 1M    

14 30 CABO DAC 10 GBPS DE 3M   

15 10 GBIC 1GB PARA ATÉ 500M   

16 5 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA SWITCHS DE REDE 

  

17 1 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO  

  

18 4 TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE SWITCHES   

19 4 TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE ACESSO   

02 

20 1 SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 
PARA REDE WIRELESS 

  

21 1 SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS   

22 200 LICENÇAS ADICIONAIS PARA SOLUÇÃO DE GERENCIAMENTO DE 
REDE WIRELESS 

  

23 2 LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE 
PERFIL E CONTROLE DE ACESSO 

  

24 4 CONTROLADORA WLAN   

25 200  LICENÇAS ADICIONAIS PARA 
CONTROLADORA WLAN    

  

26 100 PONTO DE ACESSO INTERNO TIPO 01   

27 100 PONTO DE ACESSO INTERNO TIPO 02   

28 100 INJETOR POE PARA PONTOS DE ACESSO TIPO 1   

29 100 INJETOR POE PARA PONTOS DE ACESSO TIPO 2   

30 1 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA SOLUÇÃO DE GERENCIAMENTO 

  

31 1 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA DO MÓDULO DE CONTROLE DE ACESSO 

  

32 5 SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE 
TECNOLOGIA PARA PONTOS DE ACESSO 

  

33 4 TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE ARQUITETURA 
WLAN 

  

34 4 TREINAMENTO BÁSICO DA SOLUÇÃO DE GERENCIAMENTO   

35 4 TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE ACESSO
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                                                 ANEXO II 
 

PREGÃO ELETRÔNICO Nº 39/2019 
  

PPLLAANNIILLHHAA  DDEE  DDAADDOOSS  PPAARRAA  CCOONNTTRRAATTAAÇÇÃÃOO 
 
Dados da Empresa: 
Razão Social  
CNPJ  
Endereço  
CEP  
Fones:  
Fax  
E-mail  
Site internet  

 
Dados do Representante da Empresa: 
Nome  
Cargo  
Nacionalidade  
Estado civil  
Profissão  
Endereço  
CEP  
Fone  
Fax  
E-mail  
Cart. Identidade  
Orgão Expedidor  
CPF  
 
Dados Bancários da Empresa 
Banco  
Agência  

Conta  
 
Dados do Contato com a Empresa: 
Nome  
Cargo  
Endereço  
CEP  
Fone  
Fax  
E-mail  
 
Empresa optante pelo SIMPLES?  (   ) Sim  (   ) Não 
 
 
 

Edital do PE nº 39/2019 (0584653)         SEI 0008478-63.2018.6.02.8000 / pg. 815



 
TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS 

SEÇÃO DE LICITAÇÕES E CONTRATOS 

 

96 
 

 

 

ANEXO III 
ATA DE REGISTRO DE PREÇOS n.º XX/2019  

 

Processo nº 0008478-63.2018.6.02.8000 
Pregão Eletrônico para Registro de Preços nº 39/2019 

 
MINUTA  

 
Aos ---- dias do mês ----------- de 2019, O TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS, 
Órgão do Poder Judiciário, em nome da União – Pessoa Jurídica de Direito Público Interno, 
inscrito no CNPJ nº 06.015.041/0001-38, sediado na Avenida Aristeu de Andrade, nº 377 – 
Farol, CEP: 57051-090, nesta, neste ato representado por seu Vice-Presidente no exercício 
da Presidência, Desembargador Otávio Leão Praxedes, brasileiro, casado, Magistrado, 
portador da Carteira de Identidade nº 215.430 SSP/AL, inscrito no CPF sob o nº 
087.912.284-68, residente e domiciliado nesta Cidade, resolve registrar os preços ofertados 
pela empresa ................................., (INFORMAR SE É MICROEMPRESA OU EMPRESA DE 
PEQUENO PORTE) CNPJ …....................., sediada em …..................., representada 
por..........................................., para eventual fornecimento dos materiais abaixo 
relacionados, conforme condições descritas nos  Anexos I e I-A do Pregão Eletrônico nº 
39/2019, nos termos da Lei nº 8.666, de 21 de junho de 1993, da Lei nº 10.520, de 17 de 
julho de 2002, do Decreto nº 5.450, de 31 de maio de 2005, do Decreto nº 7.892, de 23 de 
janeiro de 2013, e demais normas legais aplicáveis. 

 
1 – DO OBJETO. 
 
1.1. A presente ata tem por objeto o registro de preços do(s) item(ns) abaixo, 
na forma do Edital de Pregão Eletrônico nº 39/2019: 

 

LOTE ITEM DESCRIÇÃO MARCA UNID. 
QUANT. 
TOTAL 

REGISTRADA 

VALOR 
UNITÁRIO 

(R$) 

VALOR 
TOTAL 
(R$) 

 

       

 
1.2. Relação dos licitantes que aceitaram cotar seus bens em valor igual ao do vencedor 
do certame para formação de cadastro de reserva, caso haja cancelamento do registro do 
fornecedor, conforme previsto no subitem 18.3 do edital do PE nº 39/2019: 
 

Nome da empresa CNPJ Preços Quantitativos 
    
    

 
2 – DO PRAZO DE VIGÊNCIA. 
 
2.1. O prazo de vigência do presente Registro de Preços é de 12 (doze) 
meses, contado da publicação do extrato desta ata. 
 
3 – DOS PRAZOS DE ENTREGA E DA GARANTIA.  

 

3.1. O prazo máximo para a entrega dos equipamentos é de 60 (sessenta) 
dias contados a partir do recebimento da Ordem de Fornecimento ou documento 
equivalente. 
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3.2. O prazo máximo para a entrega dos softwares é 30 (trinta) dias contados 
a partir do recebimento da Ordem de Fornecimento ou documento equivalente. 

 

3.3. Os serviços de instalação, integração, garantia e suporte dos 
equipamentos e softwares, deverão ser realizados diretamente pelo fabricante de acordo 
com as exigências contidas no descritivo dos mesmos, estando essas aderentes aos 
respectivos níveis de serviço necessários a cada um deles. 

 
3.4. Quanto aos itens 1, 2, 3, 4, 20, 22, 23 e 25, a garantia e o suporte do 
fabricante para a solução de software deverá ser ofertado pelo período mínimo de 36 (trinta 
e seis) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 

 
3.4.1. Caso a garantia padrão do fabricante seja menor que a exigida, a 
proponente deverá informar em sua proposta o código de serviço de garantia do 
fabricante (“part number”), incorporada à solução. 

3.4.2.  O fabricante deve possuir canais de comunicação e ferramentas adicionais 
para suporte técnico online como “chat” e “e-mail” em seu site da internet com 
disponibilidade ainda de área para cadastro da solução de software ofertada, 
possibilitando assim que a CONTRATANTE possa receber de forma proativa, durante 
todo período da garantia as notificações de atualizações e correções (“hotfix”) da 
solução. 

3.4.3.  A empresa fabricante da solução de software deverá dispor de um número 
telefônico tipo 0800 para suporte técnico e abertura de chamados técnicos. 

3.4.4. A comprovação da modalidade da garantia deverá ocorrer através de 
documentação do fabricante de domínio público, não sendo aceita documentação 
emitida pelo fornecedor ou centro de distribuição para fins de comprovação que por 
ventura conflitem com catálogos, manuais, folders oficiais impressos ou da internet 
(devendo constar o endereço URL para folders da web). Caso não seja comprovada por 
um dos meios citados anteriormente, será possível a comprovação através da 
apresentação de documentação expressa do fabricante dos softwares, indicando o 
período de garantia dos produtos ofertados. Em caso de documentação expressa do 
fabricante deverá ser anexada a mesma a procuração que comprove que a fabricante 
outorga ao procurador os poderes para firmar e declarar as exigências solicitadas. 

3.5. Quanto aos itens 5, 8, 9, 10, 11, 24, 26 e 27, o equipamento ofertado 
deverá possuir garantia do fabricante na modalidade on-site pelo período mínimo de 60 
(sessenta) meses para reposição de peças, mão de obra e atendimento. O prazo máximo 
para atendimento do chamado deve ser de até o próximo dia útil após a sua abertura. 
Durante o período da garantia o prazo máximo para o reparo de equipamentos defeituosos 
a condição normal de funcionamento deverá ser de até 07 (sete) dias úteis. 

3.5.1. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente 
deverá informar em sua proposta o código de serviço de garantia do fabricante (“part 
number”), incorporada à solução. 

3.5.2. O fabricante deve possuir canais de comunicação e ferramentas adicionais para 
suporte técnico online como “chat” e “e-mail” em seu site da internet com 
disponibilidade ainda de área para cadastro da solução de hardware ofertada, 
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possibilitando assim que a CONTRATANTE possa receber de forma proativa, durante 
todo período da garantia as notificações de atualizações e correções (“hotfix”) da 
solução; 

3.5.3. A empresa fabricante do equipamento deverá dispor de um número telefônico 
tipo 0800 para suporte técnico e abertura de chamados técnicos. 

3.5.4. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e 
solução exigidos para os equipamentos, deverá ser comprovada a existência da 
assistência técnica local no domicílio da contratante e na modalidade on-site, devendo 
essa ser realizada por meio de documentação oficial do fabricante dos produtos e de 
domínio público, através de catálogos, folder impressos ou da internet, devendo 
constar o endereço URL na mesma. Caso não seja comprovada por um dos meios 
citados anteriormente, será possível a comprovação através da apresentação de 
documentação expressa do fabricante dos equipamentos, indicando a referida 
assistência técnica que será responsável pelo atendimento e manutenção durante o 
período de garantia dos produtos ofertados. Em caso de documentação expressa do 
fabricante a esta deverá ser anexada uma procuração que comprove que a fabricante 
outorga ao procurador os poderes para firmar e declarar as exigências solicitadas. 

3.5.5. Todos os componentes instalados ou integrados dos equipamentos devem ser 
do próprio fabricante ou estar em conformidade com a política de garantia do mesmo, 
não sendo permitida a integração de itens de terceiros que possam acarretar em 
perda parcial da garantia ou não realização da manutenção técnica pelo próprio 
fabricante quando solicitada. 

3.6.   Quanto aos itens 6, 7, 12, 13, 14, 15, 28 e  29, O equipamento ofertado 
deverá possuir garantia do fabricante do equipamento na modalidade on-site pelo período 
mínimo de 12 (doze) meses para reposição de peças, mão de obra e atendimento no local. 
O período da garantia o prazo máximo para o reparo de equipamentos defeituosos a 
condição normal de funcionamento deverá ser de até 07 (sete) dias úteis. 

3.6.1. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente 
deverá informar em sua proposta o código de serviço de garantia do fabricante (part 
number), incorporado ao equipamento. 

3.6.2. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do 
próprio fabricante ou estar em conformidade com a política de garantia do mesmo, 
não sendo permitida a integração de itens de terceiros que possam acarretar em 
perda parcial da garantia ou não realização da manutenção técnica pelo próprio 
fabricante quando solicitada. 

 
4. DAS OBRIGAÇÕES DO ÓRGÃO GERENCIADOR. 
 
4.1. São obrigações do Órgão Gerenciador: 
 

a) Gerenciar a presente Ata, indicando, sempre que solicitado, o nome do 
detentor da ata, o preço, e as especificações dos materiais registrados, 
observada a ordem de classificação indicada na licitação; 
b) Observar para que, durante a vigência da presente ata, sejam mantidas 
todas as condições de habilitação e qualificação exigidas na licitação, bem 
assim, a compatibilidade com as obrigações assumidas; 
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c) Conduzir eventuais renegociações dos preços registrados, para fins de 
adequação às novas condições de mercado; 
d) Realizar, periodicamente, pesquisa de mercado para comprovação da 
vantajosidade dos preços registrados na Ata; 
e) Acompanhar e fiscalizar o cumprimento das condições ajustadas na 
presente Ata; 
f) Aplicar, garantida a ampla defesa e o contraditório, as penalidades 
decorrentes do descumprimento do pactuado na ata de registro de preços ou 
do descumprimento das obrigações contratuais, em relação às suas próprias 
contratações; 
g) Consultar o detentor da ata registrada (observada a ordem de classificação) 
quanto ao interesse em fornecer o material a outro(s) órgão(s) da 
Administração Pública que externe(m) a intenção de utilizar a presente Ata. 

 
4.2. São ainda obrigações do órgão gerenciador da ata, na condição de 
contratante: 

a) Efetuar o pagamento à Contratada, após o recebimento definitivo; 
b) Acompanhar e fiscalizar a execução do objeto da Ata 
de Registro de Preços e do(s) contrato(s) dela decorrentes, 
por meio de servidor(es) designado(s), 
de modo a garantir o fiel cumprimento do mesmo e da proposta; 
c) Manter arquivo, junto ao processo administrativo ao qual está vinculado 
o presente termo,  toda a documentação referente ao mesmo; 
d) Proporcionar todas as facilidades indispensáveis à 
boa execução das obrigações contratuais; e 
e) Aplicar as sanções conforme previsto no contrato, assegurando à Contrata
da o contraditório e ampla defesa. 

5. DAS OBRIGAÇÕES DO DETENTOR DA ATA 
 
5.1. São obrigações do detentor da Ata: 
 

a) Providenciar a imediata correção de deficiências, falhas ou irregularidades 
constatadas pelo ÓRGÃO GERENCIADOR referentes às condições firmadas na 
presente Ata; 
b) Viabilizar o atendimento das condições firmadas a partir da data da 
publicação da presente Ata; 
c) Manter, durante o prazo de vigência da presente Ata, todas as condições de 
idoneidade exigidas na licitação, além de sujeitar-se às demais disposições do 
Código de Proteção e Defesa do Consumidor (Lei n° 8.078/90) que sejam 
compatíveis com o regime de direito público; 
d) Informar, no prazo máximo de 05 (cinco) dias úteis, contados do 
recebimento da notificação, quanto à aceitação ou não do fornecimento de 
material a outro órgão da Administração Pública (não participante) que venha 
a manifestar o interesse de utilizar a presente Ata. 
 

5.2. São, ainda, obrigações do detentor da Ata, na condição de contratado: 
 

a) Executar o contrato em estrita conformidade com as disposições e 
especificações do Edital e com os termos da proposta de preços; 

b) Fornecer os equipamentos conforme especificações, quantidades, 
prazos e demais condições estabelecidas no Edital, na Ata de Registro de 
Preços, na Ordem de Fornecimento e na Proposta de preços; 
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c) Fornecer a documentação necessária à instalação e à operação dos 
produtos (manuais, termos de garantia, etc.), completa, atualizada e em 
português do Brasil, caso exista, ou em inglês; 

d) Disponibilizar Central de Atendimento para a abertura e fechamento 
de chamados técnicos, conforme períodos, horários e condições 
estabelecidas no Edital e em seus Anexos; 

e) Comunicar formal e imediatamente ao Gestor ou Responsável Técnico 
da Administração sobre mudanças nos dados para contato com a Central 
de Atendimento; 

f) Prestar as informações e os esclarecimentos que venham a ser 
solicitados pelo representante da Administração, referentes a qualquer 
problema detectado ou ao andamento de atividades da garantia; 

g)  Responder por quaisquer prejuízos que seus profissionais causarem 
ao patrimônio da Administração ou a terceiros, por ocasião da execução 
do objeto, procedendo imediatamente aos reparos ou às indenizações 
cabíveis e assumindo o ônus decorrente; 

h) Responsabilizar-se integralmente pelo fornecimento dos equipamentos 
e pela execução dos serviços de garantia técnica, primando pela 
qualidade, desempenho, eficiência e produtividade na execução dos 
trabalhos, dentro dos prazos estipulados e cujo descumprimento será 
considerado infração passível de aplicação das penalidades previstas no 
Termo de Referência (Anexo I); 

i) Comunicar ao Gestor ou Responsável Técnico, formal e 
imediatamente, todas as ocorrências anormais e/ou que possam 
comprometer a execução do objeto; 
 
j) Manter sigilo sobre todo e qualquer assunto de interesse da 
Administração ou de terceiros de que tomar conhecimento em razão da 
execução do objeto, respeitando todos os critérios estabelecidos, 
aplicáveis aos dados, informações, regras de negócios, documentos, 
entre outros pertinentes, sob pena de responsabilidade civil, penal e 
administrativa; 

 
k) Cumprir e garantir que seus profissionais estejam cientes, aderentes e 
obedeçam rigorosamente às normas e aos procedimentos estabelecidos 
na Política de Segurança da Informação do TRE/AL; 

 
l) Responsabilizar-se pela conservação dos ambientes onde desempenhe 
as atividades necessárias para prestar a garantia on-site; 

 
m) Prestar as informações e os esclarecimentos que venham a ser 
solicitados pela Administração, referentes a qualquer problema 
detectado ou ao andamento de atividades da garantia técnica. 
 
n) Indicar endereço eletrônico (e-mail) para o recebimento de 
expedientes/notificações enviadas pelo TRE/AL, sendo considerados 
válidos todos os expedientes/notificações enviadas ao endereço 
eletrônico indicado; 
 
o) Manter durante a execução do contrato todas as condições que 
culminaram em sua habilitação, principalmente a regularidade fiscal e 
previdenciária, condições de idoneidade exigidas na licitação e outras 
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previstas na legislação vigente e na aplicável à natureza dos serviços 
objeto da contratação; 
 
p) Aceitar o cancelamento da ordem de fornecimento por parte da 
Administração, no caso de fornecimento/entrega, em final de exercício 
e posterior ao dia 15 de dezembro ou dia útil imediatamente 
subsequente, em decorrência dos efeitos da Emenda Constitucional nº 
95/2016, sem a reversão de qualquer ônus à Administração. 
 
q) Apresentar certidões de quitação junto à Receita Federal, Dívida Ativa 
da União, INSS, FGTS, Fazenda Estadual  e Fazenda Municipal ou estar 
registrada junto ao SICAF em condição regular; 
 
r) Acatar outras determinações previstas na legislação aplicável à 
natureza do objeto deste contrato; 
 
s) Cumprir com outras obrigações decorrentes da aplicação do Código 
de Proteção e Defesa do Consumidor (Lei nº 8.078/1990) que sejam 
compatíveis com o regime de Direito Público. 

 
6 - DO PAGAMENTO. 
 
6.1. O pagamento será efetuado mediante ordem bancária de crédito em 
conta corrente, em até 10 (dez) dias, após o recebimento da Nota Fiscal respectiva, a qual 
deverá ser entregue somente após a prestação dos serviços, devendo a contratada atender 
os seguintes requisitos: 

a) Apresentação de nota fiscal de acordo com a legislação vigente à época da 
emissão (nota fiscaleletrônica, se for o caso), acompanhada do Certificado 
de Regularidade do FGTS – CRF, comprovando regularidade com o FGTS; da 
Certidão Conjunta Negativa de Débitos Relativos a Tributos Federais e à Dívida 
Ativa da União, que incluindo as referentes a contribuições previdenciárias, 
expedida pela Secretaria da Receita Federal; e da Certidão Negativa de 
Débitos Trabalhistas – CNDT, emitida pela Justiça do Trabalho; e da prova de 
regularidade para com as Fazendas Estadual e Municipal do domicílio ou 
sede do Fornecedor; e 

b) Inexistência de fato impeditivo para o qual tenha concorrido o Fornecedor. 

6.2.  Eventuais penalidades poderão ser descontadas do pagamento. 
 
6.3.  Em nenhuma hipótese haverá antecipação de pagamento. 
 
6.4.  O TRE/AL, por ocasião de cada pagamento, fará as retenções e 
recolhimentos fiscais determinados pela legislação tributária. 
 
6.5.  Se a empresa for optante pelo SIMPLES, deverá anexar à nota fiscal 
documento que comprove tal opção, para que sobre o valor do pagamento não incidam as 
retenções de que trata o item anterior. 
 
6.6.  Havendo atraso no pagamento, o valor devido deverá ser acrescido de 
encargos moratórios, apurados desde a data do primeiro dia útil do atraso, até a data do 
efetivo pagamento, desde que o contratado não tenha concorrido para tanto, mediante a 
aplicação da seguinte fórmula: 
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EM = I x N x VP, 
 
Onde: 
EM= Encargos Moratórios 
N= Número de dias entre a data prevista para o pagamento e a do efetivo pagamento; 
VP = Valor da parcela a ser paga; 
I= Índice de atualização financeira= 0,0001644, assim apurado: 
 
I = (TX/100)                  I= (6/100)           I = 0,0001644 
         365                             365 
TX= Percentual de Taxa Anual= 6% 

6.7.  Nenhum pagamento será efetuado à Contratada enquanto pendente de 
liquidação qualquer obrigação. Esse fato não será gerador de direito a reajustamento de 
preços ou a atualização monetária. 

7 – DO RECEBIMENTO DO OBJETO. 
 
7.1. O objeto deverá ser entregue, no prazo previsto no item 3 desta Ata, contados do 
recebimento da Nota de Empenho ou Ordem de Fornecimento, por e-mail ou ofício, o que 
ocorrer primeiro, no horário de expediente normal, de segunda a sexta-feira, na Seção de 
Almoxarifado do Tribunal Regional Eleitoral de Alagoas, localizada na Avenida Menino 
Marcelo (antiga via expressa), nº 7.200 D – Serraria, Maceió/AL, CEP: 57046-005, sob 
agendamento através do telefone (82) 3328-1947. 
 
7.2. O objeto será recebido: 
 

a) provisoriamente, para que seja feita a verificação da conformidade dos mesmos 
com as especificações. 

 
b) definitivamente, após avaliação e homologação pelos responsáveis técnicos 
do Tribunal, da seguinte forma: 

b.1) O exame para comprovação das características técnicas consistirá em 
avaliações e testes não-destrutivos, por amostragem realizados em duas 
etapas: 

a. Primeira: inspeção visual de todos os equipamentos entregues; 
b. Segunda: testes funcionais de configuração e desempenho, em, no 

mínimo, 10% (dez por cento) e não menos do que 01 (um) dos 
equipamentos recebidos. O Tribunal poderá, a seu critério, executar 
os testes nos demais equipamentos, dentro de um critério de 
razoabilidade, podendo chegar a 100% dos quantitativos, mas dentro 
de um prazo máximo de 30 (trinta) dias corridos e contados de cada 
lote de equipamentos. 

b.2) As especificações serão avaliadas também por meio de documentos 
técnicos que acompanham os equipamentos, informações fornecidas pela 
Contratada e disponível no sítio do fabricante; 

b.3) A comissão do Tribunal deverá, após a comprovação do perfeito 
funcionamento dos equipamentos e adequação às especificações técnicas, 
emitir e assinar o Termo de Recebimento Definitivo. 
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7.3. O produto será rejeitado no caso de incompatibilidade com as 
especificações previstas na proposta ou quando inadequado à sua utilização. 
 
7.4. O prazo para a Secretaria competente proceder às verificações, após o 
recebimento provisório, será de 05 (cinco) dias úteis, quando deverá se manifestar, 
aceitando ou recusando o item objeto do fornecimento. 
 
7.5. Os recebimentos provisório e definitivo se darão mediante formulário 
próprio. 
 
7.6. O recebimento definitivo não exime o fornecedor de responder pelos 
vícios aparentes e ocultos segundo as disposições deste termo e as normas de proteção ao 
consumidor. 
 
7.7. O objeto que estiver em desacordo com as especificações do edital terá seu 
recebimento recusado, devendo o fornecedor, dentro do prazo de 10 (dez) dias corridos, 
substituir o produto adequadamente, sujeitando-se à multa prevista na Seção 8. 
 
8 - DAS SANÇÕES ADMINISTRATIVAS. 
 
8.1. Com fundamento no artigo 7º da Lei nº 10.520/2002 e, subsidiariamente, 
nos artigos 86 e 87 da Lei 8.666/1993, a Contratada ficará sujeita, assegurada prévia e 
ampla defesa, às seguintes penalidades:  

 
a. Advertência:  
 

i. A Contratada será notificada formalmente em caso de descumprimento de 
obrigação contratual e terá que apresentar as devidas justificativas em um prazo 
de até 5 (cinco) dias úteis após o recebimento da notificação; e 

 
ii. Caso não haja manifestação dentro desse prazo ou se entenda serem 
improcedentes as justificativas apresentadas, a Contratada será advertida. 

 
b. Multa de: 

 
i. 0,5% (meio por cento) por dia, e por ocorrência, sobre o valor do 

objeto com atraso injustificado, limitada a incidência a 20 (vinte) 
dias corridos; 

- No caso de atraso injustificado na entrega do objeto por prazo superior a 20 
(vinte) dias corridos, com 
a aceitação pela Administração, será aplicada a multa de 10% sobre o valor 
da Ordem de Fornecimento; e 

-  No caso de atraso injustificado na prestação dos serviços por prazo superior a 
20 (vinte) dias corridos, com a não aceitação pela Administração, será aplicada a 
penalidade 20% sobre o valor da Ordem de Fornecimento, no caso de inexecução 
total da obrigação, podendo haver, ainda, o cancelamento do registro de preços 
do Fornecedor. 

ii. 10% sobre o valor constante da Ordem de Fornecimento, no caso de inexecução 
parcial da obrigação assumida; 
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iii. 20% (vinte por cento) sobre o valor adjudicado, em caso de inexecução total da 
obrigação assumida; 

iv. 10% sobre o valor global da Ata de Registro de Preços, na hipótese de recusa em 
assinar a Ata ou retirar a Ordem de Fornecimento; 

c. Impedimento de licitar e contratar com a União e descredenciamento do SICAF 
pelo prazo de até 5 (cinco) anos, sem prejuízo das demais penalidades legais; e  
 
d. Declaração de inidoneidade para licitar ou contratar com a Administração 
Pública.  

 
8.2.    O cometimento reiterado de atrasos injustificados dos prazos previstos para 
entrega/solução do chamado de garantia dos equipamentos poderá resultar no 
cancelamento do instrumento de fornecimento com a Contratada. 
 
8.3.   As sanções previstas nos itens "18.1.a", “18.1.c” e “18.1.d” poderão ser 
aplicadas, cumulativamente ou não, à pena de multa.  
 
8.4.   O valor da multa, aplicada após o regular processo administrativo, será 
descontado de pagamentos eventualmente devidos à contratada ou cobrado judicialmente;  
 
8.5.   Excepcionalmente, ad cautelam, a Administração poderá efetuar a retenção 
do valor presumido da multa, antes da instauração do regular procedimento administrativo. 
 
8.6.   O valor da multa, apurado após regular procedimento administrativo, será 
descontado dos pagamentos eventualmente devidos pelo TRE/AL ou cobrado judicialmente. 
 
8.7.   Na aplicação das penalidades previstas nesta Seção a autoridade 
competente sempre se valerá dos princípios da proporcionalidade, da razoabilidade e da 
prevalência e indisponibilidade do interesse público, em decorrência de circunstâncias 
fundamentadas em fatos comprovados. 
 
8.8.   O licitante contratado, quando não puder cumprir os prazos 
estipulados para o fornecimento do material, total ou parcialmente, deverá apresentar 
justificativa por escrito, devidamente comprovada, e em documento contemporâneo à sua 
ocorrência, acompanhada de pedido de prorrogação, nos casos de ocorrência de fato 
superveniente, excepcional ou imprevisível, estranho à vontade das partes, que altere 
fundamentalmente as condições do contrato, ou que impeça a sua execução, por fato ou 
ato de terceiro reconhecido pela Administração.  
 
8.9.  Do ato que aplicar as penalidades caberá recurso na forma do art. 109 da Lei 
nº 8.666/1993. 
 
8.10.  Se o licitante contratado não recolher o valor da multa que lhe for aplicada, 
dentro de 05 (cinco) dias úteis a contar da data da intimação para o pagamento, a 
importância será descontada automaticamente, ou ajuizada a dívida, consoante o § 3º do 
art. 86 e § 1º do art. 87 da Lei nº 8.666/1993, acrescida de juros moratórios de 0,5% (meio 
por cento) ao mês. 
 
8.11.  O TRE/AL promoverá o registro no SICAF de toda e qualquer penalidade 
imposta ao licitante contratado. 
 
8.12.  O período de atraso será contado em dias corridos. 
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8.13. No caso de aplicação de penalidade em que a contratada tenha que 
pagar multa através de Guia de Recolhimento da União – GRU, e não o faça no devido 
prazo, o índice utilizado para atualização do valor será o IPCA. 
 
8.14. A data a ser utilizada como referência para a atualização do débito será a 
da publicação da decisão da aplicação da penalidade no Diário Eletrônico.  
 
8.15.  Fica estabelecido que os casos omissos serão resolvidos entre as partes 
contratantes, respeitados o objeto da presente licitação, a legislação e demais normas 
reguladoras da matéria, em especial as Leis nos 8.666/1993 e  10.520/2002, aplicando-lhes, 
quando for o caso, supletivamente, os princípios da Teoria Geral dos Contratos e as 
disposições do Direito Privado. 

 
18.16.  Os atos administrativos de aplicação das sanções, com exceção de 
advertência, multa de mora e convencional, serão publicados resumidamente no Diário 
Oficial da União. 

9 – DA VEDAÇÃO DE ACRÉSCIMO NOS QUANTITATIVOS REGISTRADOS 

9.1.     É vedado efetuar acréscimos nos quantitativos fixados na presente  ata de 
registro de preços, inclusive o acréscimo de que trata o § 1º do art. 65 da Lei nº 8.666, de 
1993, de acordo com o disposto no § 1º, art. 12 do Decreto nº 7.892/2013. 
 
10  - DA PUBLICAÇÃO 
 
10.1.       O extrato da presente ata será publicado no Diário Oficial da União. 
 
11 – DO FORO 
 
11.1.  Fica eleito o foro da Seção Judiciária da Justiça Federal da Capital do Estado de 
Alagoas, para dirimir as questões originadas deste contrato, com exclusão de qualquer 
outro, por mais privilegiado que seja. 

E por estarem justos e contratados, foi lavrado o presente instrumento, em 02 (duas) vias 
de igual teor e forma, que, após lido e achado conforme, segue assinado pelas partes. 

Maceió, XX de XXXX de 2019. 
 
Pelo TRE/AL: 

 
Desembargador Otávio Leão Praxedes 

Vice-Presidente, no exercício da Presidência 
 

Pela Empresa: 
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EDITAL Nº 43 - TRE-AL/PRE/DG/SAD/COMAP/SLC

PREGÃO ELETRÔNICO Nº 39/2019

 

PROCESSO Nº 0008478-63.2018.6.02.8000
Tipo de Licitação: MENOR PREÇO POR LOTE 

Data: 09 de setembro de 2019
HORÁRIO DE BRASÍLIA/DF

Horário de Abertura: 14 horas
Local: www.comprasnet.gov.br

 
                   O Tribunal Regional Eleitoral de Alagoas – TRE/AL, por
intermédio da Seção de Licitações e Contratos, torna público, para quem
interessar possa, que realizará licitação na modalidade PREGÃO
ELETRÔNICO, do tipo MENOR PREÇO POR LOTE, conforme descrito neste
Edital e seus Anexos, objetivando o Registro de Preços de  componentes
de rede (Networking), tudo de acordo com requisição promovida pela
Secretaria de Tecnologia da Informação.
 
                   O certame será regido conjuntamente pela Lei nº 10.520, de
17/07/2002, pelo Decreto nº 5.450, de 31/05/2005, pelo Decreto nº 8.538, de
06/10/2015 e subsidiariamente pela Lei nº 8.666, de 21/06/1993 e com suas
posteriores alterações e demais normas pertinentes. Aplica-se ao presente
torneio licitatório, ainda, a Lei Complementar nº 123, de 14/12/2006, o Decreto
nº 7.174/2010, o Decreto nº 7.892/2013 atualizado pelo Decreto nº 9.488/2018,
o Decreto nº 8.184/2014, a Portaria nº 212, de 18/06/2001, da Presidência deste
Tribunal, publicada na seção 1 do DOU, edição de 19/06/2001, por meio da qual
se adota o SICAF – Sistema de Cadastramento Unificado de Fornecedores - nas
licitações realizadas no âmbito da Secretaria deste Tribunal, bem como, no
que couber pela Lei nº 8.078, de 11/09/1990 e demais exigências deste Edital e
seus anexos.
 
1 - DO OBJETO.
 
1.1.           O presente Pregão tem por objeto o Registro de Preços de
componentes de rede (Networking), conforme especificações descritas nos
Anexos I e I-A deste edital.
 
2 – DAS CONDIÇÕES GERAIS.
 
2.1.         O prazo de vigência da Ata de Registro de Preços decorrente deste
procedimento licitatório é de 12 (doze) meses, contado da publicação do
referido ato.
 
2.2.           2.2.         A Ata de Registro de Preços não obriga à contratação de
toda quantidade estimada no Registro, que poderá ocorrer de acordo com as
necessidades do TRE/AL.
 
2.3.            A existência de preços registrados não obriga o Tribunal Regional
Eleitoral a contratar, facultando-se a realização de licitação específica para a
aquisição pretendida, assegurada preferência ao fornecedor registrado em
igualdade de condições.
 
2.3.1.  O direito de preferência de que trata este item poderá ser exercido
pelo beneficiário do registro quando o Tribunal Regional Eleitoral de Alagoas,
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após realizada a licitação específica, constatar que o preço obtido é igual ou
maior que o registrado ou, após negociação, aquiescer o detentor da ata em
baixar o preço registrado, igualando ou tornando-o menor que o obtido em
referida licitação.
 
3 - DOS PRAZOS DE ENTREGA E DA GARANTIA.
 
3 .1 .         O prazo máximo para a entrega dos equipamentos é de 60
(sessenta) dias contados a partir do recebimento da Ordem de Fornecimento
ou documento equivalente.
 
3.2.         O prazo máximo para a entrega dos softwares é 30 (trinta) dias
contados a partir do recebimento da Ordem de Fornecimento ou documento
equivalente.
 
3.3.           Os serviços de instalação, integração, garantia e suporte dos
equipamentos e softwares, deverão ser realizados diretamente pelo fabricante
de acordo com as exigências contidas no descritivo dos mesmos, estando
essas aderentes aos respectivos níveis de serviço necessários a cada um
deles.
 
3.4.         Quanto aos itens 1, 2, 3, 4, 20, 22, 23 e 25,   a garantia e o
suporte do fabricante para a solução de software deverá ser ofertado pelo
período mínimo de 36 (trinta e seis) meses, incluindo a evolução para novas
versões devendo o atendimento ser na modalidade 24x7 (vinte quatro horas
por dia, sete dias da semana), com tempo de resposta máximo em 4 (quatro)
horas.
 
3.4.2. Caso a garantia padrão do fabricante seja menor que a exigida, a
proponente deverá informar em sua proposta o código de serviço de garantia
do fabricante (“part number”), incorporada à solução.
3.4.3.    O fabricante deve possuir canais de comunicação e ferramentas
adicionais para suporte técnico online como “chat” e “e-mail” em seu site da
internet com disponibilidade ainda de área para cadastro da solução de
software ofertada, possibilitando assim que a CONTRATANTE possa receber
de forma proativa, durante todo período da garantia as notificações de
atualizações e correções (“hotfix”) da solução.
3.4.4.  A empresa fabricante da solução de software deverá dispor de um
número telefônico tipo 0800 para suporte técnico e abertura de chamados
técnicos.
3.4.5. A comprovação da modalidade da garantia deverá ocorrer através de
documentação do fabricante de domínio público, não sendo aceita
documentação emitida pelo fornecedor ou centro de distribuição para fins de
comprovação que por ventura conflitem com catálogos, manuais, folders
oficiais impressos ou da internet (devendo constar o endereço URL para
folders da web). Caso não seja comprovada por um dos meios citados
anteriormente, será possível a comprovação através da apresentação de
documentação expressa do fabricante dos softwares, indicando o período de
garantia dos produtos ofertados. Em caso de documentação expressa do
fabricante deverá ser anexada a mesma a procuração que comprove que a
fabricante outorga ao procurador os poderes para firmar e declarar as
exigências solicitadas.
3.5.            Quanto aos itens 5, 8, 9, 10, 11, 24, 26 e 27, o equipamento
ofertado deverá possuir garantia do fabricante na modalidade on-site pelo
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra
e atendimento. O prazo máximo para atendimento do chamado deve ser de até
o próximo dia útil após a sua abertura. Durante o período da garantia o prazo
máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis.
3.5.1. Caso a garantia padrão do fabricante seja menor que a exigida, a
proponente deverá informar em sua proposta o código de serviço de garantia
do fabricante (“part number”), incorporada à solução.
3.5.2. O fabricante deve possuir canais de comunicação e ferramentas
adicionais para suporte técnico online como “chat” e “e-mail” em seu site da
internet com disponibilidade ainda de área para cadastro da solução de
hardware ofertada, possibilitando assim que a CONTRATANTE possa receber
de forma proativa, durante todo período da garantia as notificações de
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atualizações e correções (“hotfix”) da solução;
3.5.3. A empresa fabricante do equipamento deverá dispor de um número
telefônico tipo 0800 para suporte técnico e abertura de chamados técnicos.
3.5.4. Para efeito de comprovação da garantia, suporte, dos níveis de
atendimento e solução exigidos para os equipamentos, deverá ser comprovada
a existência da assistência técnica local no domicílio da contratante e na
modalidade on-site, devendo essa ser realizada por meio de documentação
oficial do fabricante dos produtos e de domínio público, através de catálogos,
folder impressos ou da internet, devendo constar o endereço URL na mesma.
Caso não seja comprovada por um dos meios citados anteriormente, será
possível a comprovação através da apresentação de documentação expressa
do fabricante dos equipamentos, indicando a referida assistência técnica que
será responsável pelo atendimento e manutenção durante o período de
garantia dos produtos ofertados. Em caso de documentação expressa do
fabricante a esta deverá ser anexada uma procuração que comprove que a
fabricante outorga ao procurador os poderes para firmar e declarar as
exigências solicitadas.
3.5.5. Todos os componentes instalados ou integrados dos equipamentos
devem ser do próprio fabricante ou estar em conformidade com a política de
garantia do mesmo, não sendo permitida a integração de itens de terceiros
que possam acarretar em perda parcial da garantia ou não realização da
manutenção técnica pelo próprio fabricante quando solicitada.
3.6.          Quanto aos itens 6, 7, 12, 13, 14, 15, 28 e  29, O equipamento
ofertado deverá possuir garantia do fabricante do equipamento na
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de
peças, mão de obra e atendimento no local. O período da garantia o prazo
máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis.
3.6.1. Caso a garantia padrão do fabricante seja menor que a exigida, a
proponente deverá informar em sua proposta o código de serviço de garantia
do fabricante (part number), incorporado ao equipamento.
3.6.2. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser
do próprio fabricante ou estar em conformidade com a política de garantia do
mesmo, não sendo permitida a integração de itens de terceiros que possam
acarretar em perda parcial da garantia ou não realização da manutenção
técnica pelo próprio fabricante quando solicitada.
 
 
4 - DA PARTICIPAÇÃO.
 
4.1.            Poderão participar deste pregão os interessados do ramo
pertinente ao objeto licitado, obrigatoriamente, previamente cadastradas no
Sistema de Cadastro Unificado de Fornecedores – SICAF, habilitação parcial,
que atendam à linha de fornecimento e a todas as demais exigências deste
Edital e seus anexos.
 
4.2.            Para participação neste Pregão, o licitante deverá manifestar, em
campo próprio do sistema eletrônico, que cumpre plenamente os requisitos de
habilitação e que sua proposta está em conformidade com as exigências do
instrumento convocatório.
 
4.2.1.  A declaração falsa relativa ao cumprimento dos requisitos de
habilitação e proposta sujeitará o licitante às sanções previstas neste Edital.
 
4.3.         No ato de envio de suas propostas, as Microempresas ou Empresas
de Pequeno Porte deverão declarar, em campo próprio do Sistema do Pregão
Eletrônico, que atendem aos requisitos do art. 3º da Lei Complementar nº
123/2006 para fazer jus aos benefícios previstos no referido diploma legal.
 
4.4.            Não será admitida nesta licitação a participação de empresas:
 
4.4.1.  em processo de recuperação judicial ou em processo de falência, sob
concurso de credores, em dissolução ou em liquidação;
 
4.4.2.  que estejam suspensas de participar de licitação realizada pelo
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Tribunal Regional Eleitoral de Alagoas e empresas que tenham sido
declaradas inidôneas para licitar ou contratar com a Administração Pública,
enquanto perdurarem os motivos da punição;
 
4.4.3.  que estejam reunidas em consórcio e sejam controladoras, coligadas ou
subsidiárias entre si, qualquer que seja sua forma de constituição;
 
4.4.4.  estrangeiras que não funcionem no País;
 
4.4.5.  que tenham em seu quadro societário cônjuge, companheiro ou
parente em linha reta, colateral ou por afinidade até o terceiro grau, inclusive,
dos magistrados ocupantes de cargos de direção ou no exercício de funções
administrativas, assim como de servidores ocupantes de cargos de direção,
chefia e assessoramento vinculados direta ou indiretamente às unidades
situadas na linha hierárquica da área encarregada da licitação, de acordo com
o disposto no art. 2º da Resolução nº 07/2005 do Conselho Nacional de Justiça
(com a nova redação dada pelo art. 1º da Resolução 229/2016-CNJ).
 
5 - DA REPRESENTAÇÃO E DO CREDENCIAMENTO.
 
5 . 1 .         Os licitantes ou seus representantes legais deverão estar
previamente credenciados no site www.comprasnet.gov.br (Art. 3º do Decreto
nº 5.450/05).
 
5.2.         O credenciamento do licitante, bem assim a sua manutenção, no site
acima informado, dependerá de registro atualizado no Sistema de
Cadastramento Unificado de Fornecedores – SICAF - Habilitação Parcial, que
também será requisito obrigatório para fins de habilitação.
 
5.3.         O credenciamento do licitante dar-se-á pela utilização de login e
senha, para acesso ao sistema eletrônico no site www.comprasnet.gov.br,
opção pregão eletrônico, criados quando do credenciamento supracitado.
 
5 . 4 .         O credenciamento junto ao provedor do sistema implica a
responsabilidade legal do licitante e a presunção de sua capacidade técnica
para realização das transações inerentes ao pregão na forma eletrônica (Art.
3º, § 6º, do Decreto nº 5.450/05).
 
5.5.         O uso da senha de acesso pelo licitante é de sua responsabilidade
exclusiva, incluindo qualquer transação efetuada diretamente ou por seu
representante, não cabendo ao provedor do sistema ou ao TRE/AL, promotor
da licitação, responsabilidade por eventuais danos decorrentes de uso
indevido da senha, ainda que por terceiros (Art. 3º, § 5º, do Decreto nº
5.450/05).
 
6 - DO ENVIO DA PROPOSTA DE PREÇOS.
 
6.1.           O licitante será responsável por todas as transações que forem
efetuadas em seu nome no sistema eletrônico, assumindo como firmes e
verdadeiras suas propostas, assim como os lances inseridos durante a sessão
pública. (inciso III, do art. 13, do Decreto nº 5.450/2005).
 
6.2.           Incumbirá ao licitante acompanhar as operações no sistema
eletrônico durante o processo licitatório, responsabilizando-se pelo ônus
decorrente da perda de negócios diante da inobservância de quaisquer
mensagens emitidas pelo sistema ou de sua desconexão (inciso IV, do art. 13,
do Decreto 5.450/2005).
 
6.3.         A participação no pregão dar-se-á por meio da digitação de login e
senha privativas do licitante e subsequente encaminhamento da proposta com
a descrição do serviço ofertado, em campo próprio, que poderá ser feito a
partir da data da disponibilização do Edital no site do www.comprasnet.gov.br
e até a data e hora marcadas para abertura deste pregão, exclusivamente por
meio do sistema eletrônico.
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6.3.1.  Até a abertura da sessão, os licitantes poderão retirar ou substituir a
proposta anteriormente apresentada (§ 4º do art. 21 do Decreto nº
5.450/2005).
 
6.4.         Os licitantes deverão apresentar suas propostas de preços,
utilizando do campo "descrição detalhada do objeto", contendo o seguinte:
 
a) prazo de validade, a contar da data da abertura da sessão pública,
observado o disposto no item 6.7 do edital;
b) descrição de cada item que compõe o lote ofertado, de acordo com o Anexo
I-A deste edital.
 
6.4.1.    Caso o campo seja preenchido com especificações diversas daquelas
constantes no edital, deverá haver o cuidado, por parte do licitante, para que
a descrição complementar não contrarie as especificações constantes no
edital, sob pena de desclassificação.
 
6.4.2.    Serão irrelevantes quaisquer ofertas que não se enquadrem nas
especificações exigidas, ou anexos não solicitados, considerando-se que pelo
preço proposto o licitante obrigar-se-á ao fornecimento descrito neste edital.
 
6.4.2.1. Entretanto, se da proposta constar condições materiais mais
vantajosas que as exigidas neste edital elas não serão consideradas para
efeito de escalonamento de ofertas, mas vincularão o proponente na execução
contratual.
 
6.4.3.    Não podem constar da “descrição detalhada do objeto”
qualquer tipo de identificação da empresa, seja nome, endereço, CNPJ,
logotipo, ou qualquer outro dado capaz de identificar o licitante. Esta
identificação somente constará na proposta ajustada encaminhada nos
termos do item 10.1.
 
6.4.4.    Em campo próprio deverão ser inseridos marca e modelo do
produto ofertado.
 
6.5.         As declarações referidas no subitem 11.1 “c” deverão ser enviadas
em campo próprio do sistema Comprasnet, no momento da elaboração e envio
da proposta pelos fornecedores, as quais serão visualizadas pelo Pregoeiro na
fase de Habilitação, quando também poderá ser solicitado, via chat, pelo
Pregoeiro, a alteração ou reenvio das mesmas pelo(s) vencedor(es).
 
6.6.         Nos preços ofertados deverão estar inclusas todas as despesas
necessárias à perfeita execução das prestações contratuais, tais como
tributos, encargos legais, embalagens, frete etc.
 
6.7.           O prazo de validade das propostas será de, no mínimo, 60
(sessenta) dias, contados da data de abertura da sessão pública. As
propostas que o omitirem ou indicarem prazo de validade inferior ao
mínimo permitido serão entendidas como válidas pelo período de 60
(sessenta) dias.
 
6.8.         Em caso de divergências verificadas entre as descrições
relativas aos objetos desta licitação (Anexo I-A) e as descrições
constantes no Catálogo de Materiais do “SIASG”, prevalecerão, sempre,
as descrições constantes neste edital.
 
6.9.           Não serão aceitas propostas alternativas nem submetidas a termo,
condição ou encargo.
 
6.10.       Todos os custos decorrentes da elaboração e apresentação de
propostas serão de responsabilidade exclusiva do licitante, incluindo as
transações que forem efetuadas em seu nome no sistema eletrônico ou de
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eventual desconexão. O Tribunal Regional Eleitoral de Alagoas não será
responsável, em nenhum caso, pelos custos de tais procedimentos.
 
6.11.       O simples envio da proposta será interpretado como concordância
com os termos deste edital, com o estipulado na Lei nº 10.520, de 17 de julho
de 2002, no Decreto nº 5.450, de 31 de maio de 2005, e subsidiariamente pela
Lei nº 8.666, de 21 de junho de 1993 e suas alterações posteriores, salvo se a
proposta contiver disposição que contrarie expressamente quaisquer dos
itens deste edital.
 
7 - DA SESSÃO PÚBLICA E DIVULGAÇÃO DAS PROPOSTAS.
 
7.1.         O pregoeiro iniciará a sessão pública na data e horário previstos
neste edital, via sistema eletrônico, com a divulgação das propostas de preços
recebidas, as quais deverão estar em perfeita consonância com as
especificações detalhadas no presente edital.
 
7.2.           As propostas que não atenderem aos requisitos constantes no
presente edital ou que apresentarem preços manifestamente inexequíveis
serão previamente desclassificadas pelo pregoeiro.
 
7.2.1.     A desclassificação de proposta será sempre fundamentada e
registrada no sistema, com acompanhamento em tempo real por todos os
licitantes.
 
7.3.           O sistema ordenará, automaticamente, as propostas classificadas,
sendo que somente estas participarão da fase de lances.
 
8 - DA FORMULAÇÃO DOS LANCES.
 
8.1.         Após a classificação das propostas, o pregoeiro dará início à etapa
competitiva, oportunidade em que os licitantes poderão encaminhar lances,
exclusivamente por meio do sistema eletrônico, sendo estes imediatamente
informados do seu recebimento e respectivo horário de registro e valor.
 
8.1.1. Os lances deverão ser ofertados pelo valor unitário de cada item
que compõe o lote ofertado, sendo que o sistema efetuará
automaticamente o somatório para efeito de escalonamento dos
lances.
 
8.2.           Os licitantes poderão oferecer lances sucessivos, observado o
horário fixado e as regras de aceitação dos mesmos.
 
8.3.           O licitante somente poderá oferecer lance inferior ao último por ele
ofertado e registrado pelo sistema.
 
8.4.           Havendo mais de um lance de igual valor, prevalecerá aquele que
for recebido e registrado primeiro pelo sistema.
 
8.5.           Durante a sessão pública, os licitantes serão informados, em tempo
real, do valor do menor lance registrado, vedada a identificação do licitante.
 
8.6.           No caso de desconexão do pregoeiro, no decorrer da etapa
competitiva do pregão eletrônico, o sistema eletrônico poderá permanecer
acessível aos licitantes para a recepção dos lances, retomando o pregoeiro,
quando possível, a sua atuação no certame, sem prejuízo dos atos realizados.
 
8.6.1. Quando a desconexão do pregoeiro persistir por tempo superior a 10
(dez) minutos, a sessão do pregão eletrônico será suspensa e terá reinício
somente após comunicação aos licitantes participantes, no endereço utilizado
para divulgação desta licitação.
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8.7.                A etapa de lances será encerrada por decisão do pregoeiro,
mediante encaminhamento, pelo sistema eletrônico, de aviso de fechamento
iminente dos lances. Após o que transcorrerá período de tempo de até 30
(trinta) minutos, aleatoriamente determinado pelo sistema eletrônico, findo o
qual será encerrada, automaticamente, a recepção de lances.
 
8.8.             Após o encerramento da etapa de lances da sessão pública, o
pregoeiro poderá encaminhar, pelo sistema eletrônico, contraproposta ao
licitante que tenha apresentado lance mais vantajoso, para que seja obtida
melhor proposta, observado o critério de julgamento, não se admitindo
negociar condições diferentes daquelas previstas neste Edital.
 
9 - DO JULGAMENTO DAS PROPOSTAS DE PREÇOS.
 
9.1.             O pregoeiro efetuará o julgamento das Propostas de Preços pelo
critério do menor preço por lote, decidindo sobre a aceitação do preço
obtido.
 
9.2.                Como critério de aceitabilidade dos preços, serão admitidos como
limites máximos os valores estimados pela Administração, ou seja, os preços
de referência, disponíveis no Anexo I-A deste edital, que representam uma
média das várias propostas coletadas no mercado e, de modo algum, vinculam
a decisão do Pregoeiro, que está autorizado a negociar em busca de preços
inferiores.
 
9.2.1. O critério de aceitabilidade será aferido em relação ao valor de cada
item e em relação ao valor total do lote ofertado.
 
9.3.             Será considerado vencedor deste pregão o licitante que oferecer
o menor preço e tiver atendido a todas as exigências editalícias.
 
9.4.             Analisada a aceitabilidade do preço obtido, o pregoeiro divulgará
o resultado de julgamento das Propostas de Preços.
 
9.5.             Se a proposta ou o lance, de menor preço, não for aceitável, ou
se o licitante desatender às exigências habilitatórias, o pregoeiro examinará a
proposta ou o lance subsequente, verificando a sua aceitabilidade e
procedendo à sua habilitação, na ordem de classificação, e assim
sucessivamente, até a apuração de uma proposta ou lance que atenda ao
edital.
 
9.5.1.          Ocorrendo a situação a que se refere este item, o pregoeiro poderá
negociar com o licitante para que seja obtido preço melhor.
 
10 – DO ENCAMINHAMENTO DA PROPOSTA E DA DOCUMENTAÇÃO.
 
10.1.       A proposta ajustada ao lance final do licitante vencedor e os
documentos exigidos para habilitação que não estejam contemplados no
SICAF, caso necessário, deverão ser remetidos, como anexo, pelo sistema
Comprasnet, quando solicitado pelo Pregoeiro. Junto com a documentação
deverá ser encaminhado, também pelo sistema, os dados do licitante
vencedor: Razão Social, endereço, telefone/fax, número do CNPJ/MF, banco,
agência, número da conta corrente e praça de pagamento, podendo ser
utilizado para tanto o modelo de planilha para contratação sugerido no
ANEXO II.
 
10.2.         A licitante também deverá encaminhar, quando solicitado pelo
pregoeiro, via sistema, a Planilha de Composição de Custos por Item, no
modelo do Anexo I-B.
 
11 - DA HABILITAÇÃO.
 
11 .1.      A habilitação do licitante vencedor será verificada mediante a
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apresentação/obtenção da seguinte documentação:
 
a) Quanto à Qualificação Jurídica e Fiscal: Situação do licitante perante o
Sistema de Cadastro Unificado de Fornecedores – SICAF – Habilitação Parcial,
após a análise e julgamento das Propostas de Preços, a ser obtida por meio de
extrato “on line” do site do Comprasnet.
 
a1.) Caso conste no cadastro do SICAF algum documento habilitatório com
data de validade expirada, o pregoeiro poderá consultar o documento do
licitante nos sítios das entidades responsáveis pelo referido tributo ou abrirá
o prazo de 02 (dois) dias úteis para que o licitante o encaminhe, via
protocolo.
 
b) Quanto à regularidade trabalhista, esta deverá ser comprovada através de
Certidão Negativa de Débitos expedida pela Justiça do Trabalho, em
conformidade com a Lei Federal nº 12.440, de 07 de julho de 2011.
 
c) Declarações que deverão ser efetuadas em campo específico do sistema
Comprasnet, no momento da elaboração e envio da proposta, conforme item
6.5. do edital:
 
c .1 ) Declaração de inexistência de fatos supervenientes impeditivos à
habilitação da empresa;
c.2)  Declaração de que a empresa não emprega menor de dezoito anos em
trabalho noturno, perigoso ou insalubre, não emprega menor de dezesseis
anos, salvo na condição de aprendiz, a partir dos quatorze anos;
c.3)   Declaração de elaboração Independente de Proposta.
 
e) Quanto à qualificação econômico-financeira:
 
e.1) Certidão negativa de falência ou concordata expedida pelo distribuidor
da sede da pessoa jurídica há menos de 90 (noventa) dias da data de abertura
do certame.
 
11.2.       No momento em que forem verificados os documentos relativos à
habilitação, o pregoeiro deverá verificar, também, a existência de registros
impeditivos da contratação no Cadastro Nacional de Empresas Inidôneas e
Suspensas da Controladoria Geral da União, disponível no Portal da
Transparência (http://www.portaltransparencia.gov.br).
 
11.3.        Havendo o registro de Ocorrências Impeditivas Indiretas de licitar,
constatado em consulta ao SICAF, a empresa será convocada a apresentar, em
48 (quarenta e oito) horas, a contar da solicitação do pregoeiro no “chat”,
esclarecimentos/documentos, comprovando sua idoneidade.
 
11.3.1. Havendo necessidade de analisar minuciosamente os documentos
exigidos, o Pregoeiro suspenderá a sessão, informando no “chat” a nova data
e horário para a continuidade da mesma.
 
1 1 . 4 .       A comprovação da regularidade fiscal das licitantes,
obrigatoriamente, Microempresas e Empresas de Pequeno Porte, será exigida
para efeito de contratação, conforme estipula o art. 42 da LC nº 123/2006,
observando o que dispõe o art. 4º, do Decreto nº 8.538/2015.
 
11.4.1.         Na hipótese de haver alguma restrição relativa à regularidade
fiscal quando da comprovação de que trata o item 11.4., será assegurado
prazo de cinco dias úteis, prorrogável por igual período, para a regularização
da documentação, a realização do pagamento ou parcelamento do débito e a
emissão de eventuais certidões negativas ou positivas com efeito de certidão
negativa.
 
11.4.2.   Para aplicação do disposto no subitem 11.4.1, o prazo para
regularização fiscal será contado a partir da divulgação do resultado da fase
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de habilitação.
 
11.4.3.          A prorrogação do prazo previsto no subitem 11.4.1., poderá ser
concedida, a critério da administração pública, quando requerida pelo
licitante, mediante apresentação de justificativa.
 
11.4.4.            A abertura da fase recursal em relação ao resultado do certame
ocorrerá após  os prazos de regularização fiscal de que tratam os subitens
11.4.1. e 11.4.3.
 
11.4.5.                     A não regularização da documentação no prazo previsto
nos subitens 11.4.1. e 11.4.3. implicará decadência do direito à contratação,
sem prejuízo das sanções previstas no art. 87 da Lei nº 8.666, de 1993, sendo
facultado à administração pública convocar os licitantes remanescentes, na
ordem de classificação, ou revogar a licitação.
 
1 1 .5 .       Os licitantes que deixarem de apresentar quaisquer dos
documentos exigidos para a habilitação na presente licitação, ou os
apresentarem em desacordo com o estabelecido neste Edital ou com
irregularidades, ressalvado o disposto na alínea a.1 do item 11.1. e no item
11.4.1, serão inabilitados, não se admitindo complementação posterior.
 
11.6 .       Não serão aceitos protocolos de entrega ou solicitação de
documento em substituição aos documentos requeridos no presente Edital.
 
11.7.       Os documentos relacionados neste Edital referir-se-ão sempre ao
domicílio da empresa licitante cadastrada no SICAF.
 
11.8.       Para fins de habilitação, a verificação pelo TRE/AL nos sítios oficiais
de órgãos e entidades emissores de certidões constitui meio legal de prova.
 
12 – DO CRITÉRIO DE DESEMPATE.
 
12.1.         Será assegurado, como critério de desempate, preferência de
contratação a Microempresas e Empresas de Pequeno Porte, conforme
disposto no art. 44 da Lei Complementar nº 123/2006.
 
12.1.1.          Entende-se por empate aquelas situações em que as propostas
apresentadas pelas Microempresas e Empresas de Pequeno Porte sejam
iguais ou até 5% (cinco por cento) superiores à proposta mais bem
classificada.
 
12.1.2.          O subitem anterior somente será aplicado quando a melhor
oferta inicial não tiver sido apresentada por microempresa ou empresa de
pequeno porte.
 
12.1.3.          Para identificação da situação de empate, o Sistema de Pregão
Eletrônico, após encerramento da fase de lances identificará, em coluna
própria as Microempresas e Empresas de Pequeno Porte participantes,
fazendo a comparação entre os valores da primeira colocada, caso esta não
seja uma Microempresa ou Empresa de Pequeno Porte, e das demais
Microempresas e Empresas de Pequeno Porte, na ordem de classificação.
 
12.2.       Após o encerramento de todos os itens, para cada item que teve
uma empresa de médio ou grande porte como vencedora do melhor lance, o
sistema selecionará todas as Microempresas e Empresas de Pequeno Porte
cujo último lance enviado, para o item, seja até 5% (cinco por cento) superior à
oferta vencedora. Após este procedimento, o sistema enviará mensagem, via
chat, informando quais os itens terão desempate no lance.
 
12.3.       Para efeito do disposto no item 12.1, ocorrendo o empate, proceder-
se-á da seguinte forma:
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I – A Microempresa ou Empresa de Pequeno Porte mais bem classificada
poderá apresentar proposta de preço inferior àquela considerada vencedora
do certame, situação em que lhe será adjudicado o objeto licitado. Para
viabilizar tal procedimento, o Sistema selecionará os itens com tais
características, disponibilizando-os automaticamente nas telas do pregoeiro e
fornecedor, encaminhado mensagem também automática, por meio do chat,
convocando a Microempresa ou Empresa de Pequeno Porte que se encontra
em segundo lugar, a fazer sua última oferta no prazo de 5 (cinco) minutos, sob
pena de decair do direito concedido;
 
II – Caso a Microempresa ou Empresa de Pequeno Porte classificada em
segundo lugar desista ou não se manifeste no prazo estabelecido, o Sistema
convocará as demais Microempresas ou Empresas de Pequeno Porte
participantes na mesma condição, na ordem de classificação;
 
III – Havendo êxito neste procedimento, o Sistema disponibilizará a nova
classificação dos fornecedores para fins de aceitação. Não havendo êxito, ou
não existindo Microempresa ou Empresa de Pequeno Porte participante,
prevalecerá a classificação inicial;
 
IV – Caso sejam identificadas propostas de Microempresas ou Empresas de
Pequeno Porte empatadas em segundo lugar, ou seja, na faixa dos 5% (cinco
por cento) da primeira colocada, e permanecendo o empate até o
encerramento do item, o sistema fará um sorteio eletrônico entre tais
fornecedores, definindo e convocando automaticamente a vencedora para o
encaminhamento da oferta final do desempate;
 
V – A negociação de preço junto ao fornecedor classificado em primeiro lugar,
quando houver, será sempre após o procedimento de desempate de proposta
e classificação final dos fornecedores participantes.
 
12.4.       Para todos os cálculos efetuados, serão levadas em consideração
duas casas decimais, sendo desprezadas as demais.
 
12.5.       Se durante o desempate houver suspensão do pregão ou do item, o
tempo será interrompido. Quando o pregão ou item for reaberto, o tempo será
retomado de onde parou.
 
13 – DO CRITÉRIO DE PREFERÊNCIA.
13.1.         Este pregão submete-se às regras relativas ao direito de
preferência estabelecidas no Decreto nº 7.174/2010.
 
 
14 - DA IMPUGNAÇÃO E PEDIDOS DE ESCLARECIMENTOS.
 
14.1.       Até 02 (dois) dias úteis antes da data fixada para abertura da sessão
pública, qualquer pessoa poderá impugnar o ato convocatório do presente
pregão, enviando a peça impugnatória ao endereço eletrônico slc@tre-
al.jus.br.
 
14.1.1. Caberá ao Pregoeiro, auxiliado pela seção responsável pela elaboração
do edital, decidir sobre a impugnação no prazo de até 24h (vinte e quatro
horas).
 
14.1.2.          Acolhida a impugnação contra o ato convocatório, será definida
e publicada nova data para realização do certame.
 
14.2.       Os pedidos de esclarecimentos referentes a este Edital deverão ser
enviados à Seção de Licitações e Contratos, até três dias úteis anteriores à
data fixada para a abertura da sessão pública, exclusivamente por meio
eletrônico via Internet, para o endereço de e-mail: slc@tre-al.jus.br, cujas
respostas serão disponibilizadas nos avisos referentes a este Pregão, no site
do TRE/AL: www.tre-al.jus.br e no site www.comprasnet.gov.br.
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15- DOS RECURSOS.
 
15.1.           Existindo intenção de interpor recurso, o licitante deverá
manifestá-la ao pregoeiro, exclusivamente por meio eletrônico, em formulário
próprio, explicitando sucintamente suas razões, logo após a fase de
habilitação.
 
15.2.           O Pregoeiro informará, via chat, o tempo para a recepção, pelo
sistema eletrônico, da intenção de recurso, abrindo em seguida este prazo e
fechando ao término do tempo informado.
 
15.3.           Caso tenha havido registro de intenção de manifestação de
recurso, o Pregoeiro decidirá sobre sua admissibilidade. Sendo admissível a
manifestação de recurso registrada, o sistema abrirá formulário próprio para
o registro das razões do recurso, no prazo de 3 (três) dias, as quais poderão
ser impugnadas pelos demais licitantes, desde logo intimados para, querendo,
apresentar contrarrazões em igual prazo, exclusivamente por meio eletrônico,
e após julgadas pelo Pregoeiro, submeterá a sua decisão à autoridade
competente.
 
15.4.           O acolhimento do recurso implica tão somente na invalidação
daqueles atos que não sejam passíveis de aproveitamento.
 
15.5.           A falta de manifestação eletrônica de intenção de recorrer, no
prazo estipulado pelo Pregoeiro, importará a decadência do direito de recurso
e a adjudicação do objeto pelo pregoeiro ao vencedor.
 
16 - DA ADJUDICAÇÃO E HOMOLOGAÇÃO.
 
16.1.           A adjudicação do objeto do presente certame será viabilizada pelo
pregoeiro sempre que não houver recurso.
 
16.2.           A homologação da licitação é de responsabilidade da autoridade
competente e só poderá ser realizada depois da adjudicação do objeto ao
proponente vencedor pelo pregoeiro, ou, quando houver recurso, pela própria
autoridade competente.
 
16.3.           Antes da adjudicação pelo pregoeiro, será feita consulta ao
CADIN – Cadastro Informativo de Créditos não Quitados do Setor Público
Federal, nos termos do Inciso III do Art. 6º da Lei nº 10.522, de 19/07/2002.
 
17 - DO REAJUSTE DO PREÇO.
 
17.1.           Os preços ofertados serão fixos e irreajustáveis. No entanto, os
valores constantes da Ata de Registro de Preços admitem revisão na forma
disciplinada no Decreto nº 7.892/2013.
 
18 - DA HOMOLOGAÇÃO, DA ATA DE REGISTRO DE PREÇOS E DA
CONTRATAÇÃO.
 
18.1.       A adjudicação do objeto do presente certame será viabilizada pelo
pregoeiro sempre que não houver recurso.
 
18.1.1.          Antes da adjudicação pelo pregoeiro, será feita consulta ao
CADIN – Cadastro Informativo de Créditos não Quitados do Setor Público
Federal, nos termos do Inciso III do Art. 6º da Lei 10.522, de 19/07/2002.
 
18.2.       A homologação da licitação é de responsabilidade da autoridade
competente e só poderá ser realizada depois da adjudicação do objeto ao
proponente vencedor pelo pregoeiro, ou, quando houver recurso, pela própria
autoridade competente.
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18.3.         Homologado o resultado da licitação, os fornecedores classificados,
observado o disposto no art. 11 do Decreto nº 7.892/2013, serão convocados
para assinar a ata de registro de preços, dentro do prazo e condições
estabelecidos no subitem 18.3.1., podendo ser prorrogado uma vez, por igual
período, quando solicitado pelo fornecedor e desde que ocorra motivo
justificado aceito pela administração.
 
18.3.1.            O cadastro de reserva dos fornecedores classificados a que se
refere o item anterior será elaborado desde que viabilizado pelo sistema
Comprasnet, tal como previsto no art. 26 do decreto acima citado.
 
18.3.2.          O licitante vencedor deverá devolver a Ata de Registro de
Preços assinada dentro do prazo de 05 (cinco) dias úteis, a contar do
recebimento da convocação para assinatura do documento, em conformidade
com o previsto no art. 64 da Lei n. 8.666/1993.
 
18.4.       É facultado à administração, quando o convocado não assinar a ata
de registro de preços no prazo e condições estabelecidos, convocar os
licitantes remanescentes, na ordem de classificação, para fazê-lo em igual
prazo e nas mesmas condições propostas pelo primeiro classificado.
 
18.5.       A ata de registro de preços implicará compromisso de fornecimento
nas condições estabelecidas, após cumpridos os requisitos de publicidade.
 
18.6.       A recusa injustificada de fornecedor classificado em assinar a ata,
dentro do prazo estabelecido no subitem 18.3.2, ensejará a aplicação das
penalidades aludidas no item 18.12 deste edital, bem como às do art. 28 do
Decreto n. 5.450/2005.
 
18.7.       A contratação com os fornecedores registrados será formalizada
pelo órgão interessado por intermédio de instrumento contratual, emissão de
nota de empenho de despesa, autorização de compra ou outro instrumento
hábil, conforme o art. 62 da Lei nº 8.666, de 1993.
 
18.8.       Após a devolução da Ata de Registro de Preços assinada, a licitante
poderá receber a Nota de Empenho e a Autorização de Fornecimento, devendo
confirmar o seu recebimento.
 
18.9.       A recusa na aceitação da nota de empenho e da Autorização de
Fornecimento deverá ser expressa, escrita e justificada, o que será
encaminhado para a autoridade competente que procederá à análise dos
motivos acostados pelo licitante, decidindo acerca da aceitabilidade ou não da
justificativa.
 
18.10.       Caso a justificativa não seja encaminhada na forma descrita ou esta
não seja aceita pela autoridade competente, o prazo para a entrega
continuará fluindo normalmente, e em não sendo cumprido, sujeitará o
licitante às penalidades cabíveis.
 
18.11.     Os contratos decorrentes do Sistema de Registro de Preços poderão
ser alterados, observado o disposto no art. 65 da Lei nº 8.666, de 1993 e no
art. 12, § 3º do Decreto nº 7.892/2013.
 
18.12.     O registro do fornecedor será cancelado quando:
 
a) descumprir as condições da Ata de Registro de Preços;
 
b) não retirar a nota de empenho ou instrumento equivalente no prazo
estabelecido pela Administração, sem justificativa aceitável;
 
c) não aceitar reduzir o seu preço registrado, na hipótese deste se tornar
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superior àqueles praticados no mercado; ou
 
d) sofrer sanção prevista nos incisos III ou IV do caput do art. 87 da Lei nº
8.666, de 1993, ou no art. 7º da Lei nº 10.520, de 2002.
 
18.12.1.        O cancelamento de registros nas hipóteses previstas nas alíneas
“a”, “b” e “d” do subitem 18.12. será formalizado por despacho do órgão
gerenciador, assegurado o contraditório e a ampla defesa.
 
18.12.2.        O cancelamento do registro de preços poderá ocorrer por fato
superveniente, decorrente de caso fortuito ou força maior, que prejudique o
cumprimento da ata, devidamente comprovados e justificados:
 
a) por razão de interesse público; ou
 
b) a pedido do fornecedor.
 
18.13.     O licitante vencedor somente poderá subcontratar, em parte, o
objeto desta licitação, se for conveniente para a Administração deste Tribunal,
mediante prévia e escrita autorização desta, sob pena de sofrer as sanções
contratuais e legais.
 
18.13.1.  O licitante vencedor não poderá transferir a terceiros nenhuma
responsabilidade, em caso de subcontratação autorizada.
 
18.14.       O licitante vencedor obriga-se a manter, durante a vigência do
Registro de Preços, em compatibilidade com as obrigações por ele assumidas,
todas as condições de habilitação e qualificação exigidas na licitação,
renovando as certidões e encaminhando-as ao Tribunal Regional Eleitoral de
Alagoas, no prazo máximo de 48 (quarenta e oito) horas a partir da solicitação
das mesmas.
 
18.15.     A Ata de Registro de Preços, durante sua vigência, poderá ser
utilizada por qualquer órgão ou entidade da administração pública federal que
não tenha participado do certame licitatório, mediante anuência do órgão
gerenciador, observadas, ainda, as demais regras impostas no art. 22 do
Decreto n.º 7.892/2013.
 
18.16.     As aquisições ou contratações adicionais a que se refere o subitem
18.15 não poderão exceder, por órgão ou entidade, a cinquenta por cento
dos quantitativos dos itens do instrumento convocatório e registrados na
ata de registro de preços para o órgão gerenciador e órgãos participantes.
 
18.17.     O quantitativo decorrente das adesões à ata de registro de preços
não poderá exceder, na totalidade, ao dobro do quantitativo de cada item
registrado na ata de registro de preços para o órgão gerenciador e
órgãos participantes, independente do número de órgãos não participantes
que aderirem.
 
19 – DO RECEBIMENTO DO OBJETO.
 
19.1. O objeto deverá ser entregue, no prazo previsto no item 3 deste edital,
por e-mail ou ofício, o que ocorrer primeiro, no horário de expediente normal,
de segunda a sexta-feira, na Seção de Almoxarifado do Tribunal Regional
Eleitoral de Alagoas, localizada na Avenida Menino Marcelo (antiga via
expressa), nº 7.200 D – Serraria, Maceió/AL, CEP: 57046-005, sob agendamento
através do telefone (82) 3328-1947.
 
19.2.   O objeto será recebido:
 
a) provisoriamente, para que seja feita a verificação da conformidade dos
mesmos com as especificações.
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b) definitivamente, após avaliação e homologação pelos responsáveis técnicos
do Tribunal, da seguinte forma:
b.1) O exame para comprovação das características técnicas consistirá em
avaliações e testes não-destrutivos, por amostragem realizados em duas
etapas:

1. Primeira: inspeção visual de todos os equipamentos entregues;
2. Segunda: testes funcionais de configuração e desempenho, em, no

mínimo, 10% (dez por cento) e não menos do que 01 (um) dos
equipamentos recebidos. O Tribunal poderá, a seu critério, executar
os testes nos demais equipamentos, dentro de um critério de
razoabilidade, podendo chegar a 100% dos quantitativos, mas dentro de
um prazo máximo de 30 (trinta) dias corridos e contados de cada lote de
equipamentos.

b.2) As especificações serão avaliadas também por meio de documentos
técnicos que acompanham os equipamentos, informações fornecidas pela
Contratada e disponível no sítio do fabricante;
b.3) A comissão do Tribunal deverá, após a comprovação do perfeito
funcionamento dos equipamentos e adequação às especificações técnicas,
emitir e assinar o Termo de Recebimento Definitivo.
19.3.         O produto será rejeitado no caso de incompatibilidade com as
especificações previstas na proposta ou quando inadequado à sua utilização.
 
19.4.         O prazo para a Secretaria competente proceder às verificações,
após o recebimento provisório, será de 05 (cinco) dias úteis, quando deverá se
manifestar, aceitando ou recusando o item objeto do fornecimento.
 
19.5.         Os recebimentos provisório e definitivo se darão mediante
formulário próprio.
 
19.6.         O recebimento definitivo não exime o fornecedor de responder pelos
vícios aparentes e ocultos segundo as disposições deste termo e as normas de
proteção ao consumidor.
 
19.7. O objeto que estiver em desacordo com as especificações do edital terá
seu recebimento recusado, devendo o fornecedor, dentro do prazo de 10 (dez)
dias corridos, substituir o produto adequadamente, sujeitando-se à multa
prevista na Seção 18.
 
20 – DAS SANÇÕES ADMINISTRATIVAS.
 
20.1.        Com fundamento no artigo 7º da Lei nº 10.520/2002 e,
subsidiariamente, nos artigos 86 e 87 da Lei 8.666/1993, a Contratada ficará
sujeita, assegurada prévia e ampla defesa, às seguintes penalidades:
 
a. Advertência:
 
i. A Contratada será notificada formalmente em caso de descumprimento de
obrigação contratual e terá que apresentar as devidas justificativas em um
prazo de até 5 (cinco) dias úteis após o recebimento da notificação; e
 
ii. Caso não haja manifestação dentro desse prazo ou se entenda serem
improcedentes as justificativas apresentadas, a Contratada será advertida.
 
b. Multa de:
 

1. 0,5% (meio por cento) por dia, e por ocorrência, sobre o valor do objeto
com atraso injustificado, limitada a incidência a 20 (vinte) dias corridos;

- No caso de atraso injustificado na entrega do objeto por prazo superior a 20
(vinte) dias corridos, com
a aceitação pela Administração, será aplicada a multa de 10% sobre o valor
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da Ordem de Fornecimento; e
-  No caso de atraso injustificado na prestação dos serviços por prazo superior
a 20 (vinte) dias corridos, com a não aceitação pela Administração, será
aplicada a penalidade 20% sobre o valor da Ordem de Fornecimento, no caso
de inexecução total da obrigação, podendo haver, ainda, o cancelamento do
registro de preços do Fornecedor.
ii. 10% sobre o valor constante da Ordem de Fornecimento, no caso de
inexecução parcial da obrigação assumida;
iii. 20% (vinte por cento) sobre o valor adjudicado, em caso de inexecução total
da obrigação assumida;
iv. 10% sobre o valor global da Ata de Registro de Preços, na hipótese de
recusa em assinar a Ata ou retirar a Ordem de Fornecimento;
c. Impedimento de licitar e contratar com a União e descredenciamento do
SICAF pelo prazo de até 5 (cinco) anos, sem prejuízo das demais penalidades
legais; e
 
d. Declaração de inidoneidade para licitar ou contratar com a Administração
Pública.
 
20.2.                          O cometimento reiterado de atrasos injustificados dos
prazos previstos para entrega/solução do chamado de garantia dos
equipamentos poderá resultar no cancelamento do instrumento de
fornecimento com a Contratada.
 
20.3.              As sanções previstas nos itens "20.1.a", “20.1.c” e “20.1.d”
poderão ser aplicadas, cumulativamente ou não, à pena de multa.
 
20.4.              O valor da multa, aplicada após o regular processo
administrativo, será descontado de pagamentos eventualmente devidos à
contratada ou cobrado judicialmente;
 
20.5.              Excepcionalmente, ad cautelam, a Administração poderá efetuar
a retenção do valor presumido da multa, antes da instauração do regular
procedimento administrativo.
 
20.6.             O valor da multa, apurado após regular procedimento
administrativo, será descontado dos pagamentos eventualmente devidos pelo
TRE/AL ou cobrado judicialmente.
 
20.7.                         Na aplicação das penalidades previstas nesta Seção a
autoridade competente sempre se valerá dos princípios da proporcionalidade,
da razoabilidade e da prevalência e indisponibilidade do interesse público, em
decorrência de circunstâncias fundamentadas em fatos comprovados.
 
20.8.                         O licitante contratado, quando não puder cumprir os
prazos estipulados para o fornecimento do material, total ou parcialmente,
deverá apresentar justificativa por escrito, devidamente comprovada, e em
documento contemporâneo à sua ocorrência, acompanhada de pedido de
prorrogação, nos casos de ocorrência de fato superveniente, excepcional ou
imprevisível, estranho à vontade das partes, que altere fundamentalmente as
condições do contrato, ou que impeça a sua execução, por fato ou ato de
terceiro reconhecido pela Administração.
 
20.9.      Do ato que aplicar as penalidades caberá recurso na forma do art.
109 da Lei nº 8.666/1993.
 
20.10.     Se o licitante contratado não recolher o valor da multa que lhe for
aplicada, dentro de 05 (cinco) dias úteis a contar da data da intimação para o
pagamento, a importância será descontada automaticamente, ou ajuizada a
dívida, consoante o § 3º do art. 86 e § 1º do art. 87 da Lei nº 8.666/1993,
acrescida de juros moratórios de 0,5% (meio por cento) ao mês.
 
20.11.     O TRE/AL promoverá o registro no SICAF de toda e qualquer
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penalidade imposta ao licitante contratado.
 
20.12.     O período de atraso será contado em dias corridos.
 
20.13.       No caso de aplicação de penalidade em que a contratada tenha que
pagar multa através de Guia de Recolhimento da União – GRU, e não o faça no
devido prazo, o índice utilizado para atualização do valor será o IPCA.
 
20.14.       A data a ser utilizada como referência para a atualização do débito
será a da publicação da decisão da aplicação da penalidade no Diário
Eletrônico.   
 
20.15.     Fica estabelecido que os casos omissos serão resolvidos entre as
partes contratantes, respeitados o objeto da presente licitação, a legislação e
demais normas reguladoras da matéria, em especial as Leis nos 8.666/1993 e 
10.520/2002, aplicando-lhes, quando for o caso, supletivamente, os princípios
da Teoria Geral dos Contratos e as disposições do Direito Privado.
 
20.16.     Os atos administrativos de aplicação das sanções, com exceção de
advertência, multa de mora e convencional, serão publicados resumidamente
no Diário Oficial da União.
 
21 - DO PAGAMENTO.
 
21.1.             O pagamento será efetuado mediante ordem bancária de crédito
em conta corrente, em até 10 (dez) dias, após o recebimento da Nota Fiscal
respectiva, a qual deverá ser entregue somente após a prestação dos serviços,
devendo a contratada atender os seguintes requisitos:
a) Apresentação de nota fiscal de acordo com a legislação vigente à época da
emissão (nota fiscaleletrônica, se for o caso), acompanhada do Certificado
de Regularidade do FGTS – CRF, comprovando regularidade com o FGTS; da
Certidão Conjunta Negativa de Débitos Relativos a Tributos Federais e à
Dívida Ativa da União, que incluindo as referentes a contribuições
previdenciárias, expedida pela Secretaria da Receita Federal; e da Certidão
Negativa de Débitos Trabalhistas – CNDT, emitida pela Justiça do Trabalho;
e da prova de regularidade para com as Fazendas Estadual e Municipal do
domicílio ou sede do Fornecedor; e
b) Inexistência de fato impeditivo para o qual tenha concorrido o Fornecedor.
21.2.             Eventuais penalidades poderão ser descontadas do pagamento.
 
21.3.           Em nenhuma hipótese haverá antecipação de pagamento.
 
21.4.           O TRE/AL, por ocasião de cada pagamento, fará as retenções e
recolhimentos fiscais determinados pela legislação tributária.
 
21.5.      Se a empresa for optante pelo SIMPLES, deverá anexar à nota fiscal
documento que comprove tal opção, para que sobre o valor do pagamento não
incidam as retenções de que trata o item anterior.
 
21.6.           Havendo atraso no pagamento, o valor devido deverá ser
acrescido de encargos moratórios, apurados desde a data do primeiro dia útil
do atraso, até a data do efetivo pagamento, desde que o contratado não tenha
concorrido para tanto, mediante a aplicação da seguinte fórmula:
 
EM = I x N x VP,
 
Onde:
EM= Encargos Moratórios
N= Número de dias entre a data prevista para o pagamento e a do efetivo
pagamento;
VP = Valor da parcela a ser paga;
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I= Índice de atualização financeira= 0,0001644, assim apurado:
 
I = (TX/100)                  I= (6/100)           I = 0,0001644
         365                             365
TX= Percentual de Taxa Anual= 6%
21.7.         Nenhum pagamento será efetuado à Contratada enquanto
pendente de liquidação qualquer obrigação. Esse fato não será gerador de
direito a reajustamento de preços ou a atualização monetária.
22 – DA DOTAÇÃO ORÇAMENTÁRIA.
 
22.1.              As despesas decorrentes da execução do contrato correrão à
conta dos recursos lançados na Proposta Orçamentária Anual deste Tribunal
para o exercício 2019, alocados no Programa de Trabalho - PTRES nº 084621
(Julgamento de causas e gestão administrativas) - Natureza da
Despesa nº 44.90.52 (Equipamentos e Material Permanente) e 33.90.39
(Outros Serviços de Terceiros - Pessoa Jurídica).
 
22.2.        As despesas referentes aos exercícios subsequentes correrão à
conta das dotações orçamentárias respectivas.
 
23 - DAS OBRIGAÇÕES DO ÓRGÃO GERENCIADOR.
 
23.1.         São obrigações do Órgão Gerenciador:
 
a) Gerenciar a presente Ata, indicando, sempre que solicitado, o nome do
detentor da ata, o preço, e as especificações dos materiais registrados,
observada a ordem de classificação indicada na licitação;
 
b) Observar para que, durante a vigência da presente ata, sejam mantidas
todas as condições de habilitação e qualificação exigidas na licitação, bem
assim, a compatibilidade com as obrigações assumidas;
 
c) Conduzir eventuais procedimentos administrativos de renegociação de
preços registrados, para fins de adequação às novas condições de mercado, e
de aplicação de penalidades;
 
d) Acompanhar a evolução dos preços de mercado, com a finalidade de
verificar sua compatibilidade com aqueles registrados na Ata;
 
e) Acompanhar e fiscalizar o cumprimento das condições ajustadas na
presente Ata;
 
f) Aplicar, garantida a ampla defesa e o contraditório, as penalidades
decorrentes do descumprimento do pactuado na ata de registro de preços ou
do descumprimento das obrigações contratuais, em relação às suas próprias
contratações;
 
g) Consultar o detentor da ata registrada (observada a ordem de
classificação) quanto ao interesse em fornecer o material a outro(s) órgão(s)
da Administração Pública que externe(m) a intenção de utilizar a presente Ata,
conforme subitem 18.15.
 
23.2.       São, ainda, obrigações do órgão gerenciador da ata, na condição de
contratante:
 

1. Efetuar o pagamento à Contratada, após o recebimento definitivo;
2. Acompanhar e fiscalizar a execução do objeto da Ata

de Registro de Preços e do(s) contrato(s) dela decorrentes,
por meio de servidor(es) designado(s),
de modo a garantir o fiel cumprimento do mesmo e da proposta;
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3. Manter arquivo, junto ao processo administrativo ao qual está vinculado o presente termo, 
toda a documentação referente ao mesmo;

4. Proporcionar todas as facilidades indispensáveis à
boa execução das obrigações contratuais; e

5. Aplicar as sanções conforme previsto no contrato, assegurando à Contratada o contraditório e ampla defesa.

24 - DAS OBRIGAÇÕES DO DETENTOR DA ATA.
 
24.1.       São obrigações do detentor da Ata:
 
a) Providenciar a imediata correção de deficiências, falhas ou irregularidades
constatadas pelo ÓRGÃO GERENCIADOR referentes às condições firmadas na
presente Ata;
 
b) Viabilizar o atendimento das condições firmadas a partir da data da
publicação da presente Ata;
 
c) Manter, durante o prazo de vigência da presente Ata, todas as condições de
idoneidade exigidas na licitação, além de se sujeitar às demais disposições do
Código de Proteção e Defesa do Consumidor (Lei n° 8.078/90) que sejam
compatíveis com o regime de direito público;
 
d) Informar, no prazo máximo de 05 (cinco) dias úteis, contados do
recebimento da notificação, quanto à aceitação ou não do fornecimento de
material a outro órgão da Administração Pública (não participante) que venha
a manifestar o interesse de utilizar a presente Ata, conforme item 18.15.
 
24.2 .       São ainda obrigações do detentor da Ata, na condição de
contratado:
 
a) Executar o contrato em estrita conformidade com as disposições e
especificações do Edital e com os termos da proposta de preços;
b) Fornecer os equipamentos conforme especificações, quantidades, prazos e
demais condições estabelecidas no Edital, na Ata de Registro de Preços, na
Ordem de Fornecimento e na Proposta de preços;

3. Fornecer a documentação necessária à instalação e à operação dos
produtos (manuais, termos de garantia, etc.), completa, atualizada e em
português do Brasil, caso exista, ou em inglês;

4. Disponibilizar Central de Atendimento para a abertura e fechamento de
chamados técnicos, conforme períodos, horários e condições
estabelecidas no Edital e em seus Anexos;

5. Comunicar formal e imediatamente ao Gestor ou Responsável Técnico da
Administração sobre mudanças nos dados para contato com a Central de
Atendimento;

6. Prestar as informações e os esclarecimentos que venham a ser solicitados
pelo representante da Administração, referentes a qualquer problema
detectado ou ao andamento de atividades da garantia;

7.  Responder por quaisquer prejuízos que seus profissionais causarem ao
patrimônio da Administração ou a terceiros, por ocasião da execução do
objeto, procedendo imediatamente aos reparos ou às indenizações
cabíveis e assumindo o ônus decorrente;

8. Responsabilizar-se integralmente pelo fornecimento dos equipamentos e
pela execução dos serviços de garantia técnica, primando pela qualidade,
desempenho, eficiência e produtividade na execução dos trabalhos,
dentro dos prazos estipulados e cujo descumprimento será considerado
infração passível de aplicação das penalidades previstas no Termo de
Referência (Anexo I);

9. Comunicar ao Gestor ou Responsável Técnico, formal e imediatamente,
todas as ocorrências anormais e/ou que possam comprometer a execução
do objeto;

 

10. Manter sigilo sobre todo e qualquer assunto de interesse da
Administração ou de terceiros de que tomar conhecimento em razão da
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execução do objeto, respeitando todos os critérios estabelecidos,
aplicáveis aos dados, informações, regras de negócios, documentos, entre
outros pertinentes, sob pena de responsabilidade civil, penal e
administrativa;

 
k) Cumprir e garantir que seus profissionais estejam cientes, aderentes e
obedeçam rigorosamente às normas e aos procedimentos estabelecidos na
Política de Segurança da Informação do TRE/AL;
 
l) Responsabilizar-se pela conservação dos ambientes onde desempenhe as
atividades necessárias para prestar a garantia on-site;
 
m) Prestar as informações e os esclarecimentos que venham a ser solicitados
pela Administração, referentes a qualquer problema detectado ou ao
andamento de atividades da garantia técnica.
 
n) Indicar endereço eletrônico (e-mail) para o recebimento de
expedientes/notificações enviadas pelo TRE/AL, sendo considerados válidos
todos os expedientes/notificações enviadas ao endereço eletrônico indicado;
 
o)  Manter durante a execução do contrato todas as condições que
culminaram em sua habilitação, principalmente a regularidade fiscal e
previdenciária, condições de idoneidade exigidas na licitação e outras
previstas na legislação vigente e na aplicável à natureza dos serviços objeto da
contratação;
 
p)  Aceitar o cancelamento da ordem de fornecimento por parte da
Administração, no caso de fornecimento/entrega, em final de exercício
e posterior ao dia 15 de dezembro ou dia útil imediatamente subsequente, em
decorrência dos efeitos da Emenda Constitucional nº 95/2016, sem a reversão
de qualquer ônus à Administração.
 
q) Apresentar certidões de quitação junto à Receita Federal, Dívida Ativa da
União, INSS, FGTS, Fazenda Estadual e Fazenda  Municipal ou estar registrada
junto ao SICAF em condição regular;
 
r)   Acatar outras determinações previstas na legislação aplicável à natureza
do objeto deste contrato;
 
s)   Cumprir com outras obrigações decorrentes da aplicação do Código de
Proteção e Defesa do Consumidor (Lei nº 8.078/1990) que sejam compatíveis
com o regime de Direito Público.
 
 
25 - DA PUBLICIDADE.
 
25.1.         O preço registrado com indicação dos fornecedores será divulgado
no Portal de Compras do Governo federal e ficará disponibilizado durante a
vigência da ata de registro de preços, em conformidade com o disposto no art.
11, inciso II do Decreto n.º 7.892/2013 combinado com o art. 15, 2º da Lei nº
8.666/93.
 
25 – DA VEDAÇÃO DE AQUISIÇÃO SEPARADA DOS ITENS.
 
25.1.      É vedada a aquisição separada de itens para os quais, o fornecedor
convocado para assinar a ata não tenha apresentado o menor preço entre
todos os licitantes.
 
26 - DISPOSIÇÕES GERAIS.
 
26.1.           É assegurado ao TRE/AL, no interesse da Administração, revogar
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o certame, ou, no caso de vício insanável (ilegalidade), anulá-lo, no todo ou em
parte, dando ciência aos participantes, na forma da legislação vigente.
 
26.2.           As proponentes assumem todos os custos de preparação e
apresentação de suas propostas e o TRE/AL não será, em nenhum caso,
responsável por esses custos, independentemente da condução ou do
resultado do processo licitatório.
 
26.3.         As proponentes serão responsáveis pela fidelidade e legitimidade
das informações e dos documentos apresentados em qualquer fase da
licitação.
 
2 6 . 4 .           Não havendo expediente, ou ocorrendo qualquer fato
superveniente que impeça a realização do certame na data marcada, a sessão
será transferida para o primeiro dia útil subsequente, devendo o Pregoeiro
informar sobre o adiamento no ambiente do Comprasnet, com antecedência
mínima de 24 (vinte e quatro) horas.
 
26.5.           Na contagem dos prazos estabelecidos neste Edital, excluir-se-á o
dia do início e incluir-se-á o do vencimento. Só se iniciam e vencem os prazos
em dias de expediente no TRE/AL.
 
26.6.           No julgamento da habilitação e das propostas, o pregoeiro poderá
sanar erros ou falhas que não alterem a substância das propostas, dos
documentos e sua validade jurídica, mediante despacho fundamentado,
registrado em ata e acessível a todos, atribuindo-lhes validade e eficácia para
fins de habilitação e classificação.
 
2 6 .7 .           As normas que disciplinam este Pregão serão sempre
interpretadas em favor da ampliação da disputa entre as empresas
interessadas, sem comprometimento da segurança do futuro contrato.
 
26.8.          Havendo divergência entre o edital e seus anexos, prevalecerá o
determinado neste edital.
 
26.9.          O endereço para vistas e protocolo de documentos, é o seguinte:
Avenida Aristeu de Andrade, nº 377, 6º andar - COMAP/Seção de Licitações e
Contratos, bairro Farol, CEP: 57051-090, Maceió/AL, Fone: (82) 2122-7764/7765.
 
26.10.    Todos os horários estabelecidos neste Edital, no aviso e durante a
sessão pública, observarão, para todos os efeitos, o horário de Brasília,
Distrito Federal, inclusive para contagem de tempo e registro no sistema
eletrônico e na documentação relativa ao certame.
 
26.11.    A homologação do resultado desta licitação não implicará direito à
contratação.
 
26.12.    Aos casos omissos, aplicar-se-ão as demais disposições da Lei nº
10.520/2002, do Decreto nº 5.450/2005 e alterações e da Lei nº 8.666/1993.
 
26.13.    O Edital e seus anexos poderão ser lidos na sala da Seção de
Licitações e Contratos, COMAP, no endereço especificado no item 26.9, no
caso de ser retirado em Maceió/AL, ou ainda, nos sites www.tre-al.jus.br e
www.comprasnet.gov.br, gratuitamente.
 
26.14.    Fazem parte integrante deste Edital os seguintes Anexos:
 
ANEXO I – Termo de Referência;
ANEXO I–A – Especificações dos lotes, itens, quantitativos a serem adquiridos
e preços máximos admitidos;
ANEXO I-B - Planilha de Composição de Custos por Item;
ANEXO II – Planilha para preenchimento dos dados do Contrato (Sugestão);
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ANEXO III – Minuta da Ata de Registro de Preços.
 
26.15.    Fica eleito o Foro da Justiça Federal em Maceió - Seção Judiciária do
Estado de Alagoas, para dirimir quaisquer dúvidas ou controvérsias oriundas
desta licitação, que não puderem ser solucionadas administrativamente.

 
Maceió/AL, 21 de agosto de 2019.

 
 

Ingrid Pereira de Lima Araújo
Chefe da Seção de Licitações e Contratos

 

 

 

 

Em 22 de agosto de 2019.

Documento assinado eletronicamente por INGRID PEREIRA DE LIMA ARAÚJO,
Técnico Judiciário, em 23/08/2019, às 12:47, conforme art. 1º, III, "b", da Lei
11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0584655 e o código CRC 5ECB8D44.

0008478-63.2018.6.02.8000 0584655v2
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DIRETORIA-GERAL DA SECRETARIA
SECRETARIA DE ADMINISTRAÇÃO

AVISO DE PENALIDADE

O TRF 1ª Região resolve aplicar à JSCOND SERVIÇOS E COMÉRCIO LTDA., CNPJ
25.187.379/0001-11, a penalidade de impedimento de licitar e contratar com a União, com
base no art. 7º da Lei nº 10.520/2002, pelo período de 6 meses, a contar desta publicação.
A penalidade é resultado da apuração de irregularidades ocorridas na execução da
obrigação decorrente da Nota de Empenho n. 2017NE800875, mediante Processo
Administrativo nº 0011082-89.2018.4.01.800.

MARIA CRISTINA TURNES
Diretora da Secretaria de Administração

TRIBUNAL REGIONAL FEDERAL DA 2ª REGIÃO
RESULTADO DE JULGAMENTO

PREGÃO Nº 18/2019

Processo nº TRF2-EOF-2018/00230. Objeto: Registro de Preços visando à contratação de
empresa especializada na prestação de serviços técnicos especializados em
desenvolvimento, manutenção evolutiva e corretiva, e sustentação de sistemas
corporativos. O Senhor Pregoeiro decidiu declaraR VENCEDORA do objeto do pregão em
epígrafe a empresa MINDTEK INTELIGÊNCIA E TECNOLOGIA LTDA.

FRANCISCO LUÍS DUARTE
Pregoeiro

(SIDEC - 22/08/2019)

RESULTADO DE JULGAMENTO
PREGÃO Nº 34/2019

Processo nº TRF2-EOF-2019/00136. Objeto: Contratação de empresa especializada para
prestação de serviço Telefônico Fixo Comutado (STFC) de longa distância, nas modalidades
longa distância nacional e internacional, LDN e LDI, para aparelhos fixos e móveis. O
Senhor Pregoeiro decidiu ADJUDICAR o objeto do pregão em epígrafe à empresa TELEMAR
NORTE LESTE S.A.

FRANCISCO LUÍS DUARTE
Pregoeiro

(SIDEC - 22/08/2019)
S EC R E T A R I A - G E R A L

EXTRATO DE NOTA DE EMPENHO

Nota de empenho: 2019NE000783, emitida em 20/08/2019. Contratante: TRF- 2ªRG.
Contratada: SEGINFO COMÉRCIO & SERVIÇOS EMPRESARIAIS EIRELI. Objeto: aquisição de
pen drive (Ata n.º 054/2019). Modalidade de Licitação: Lei nº 10.520/02 c/c Decretos
5.450/05 e 7.892/13. Crédito Orçamentário: Programa de Trabalho: 02061056942576013.
Elemento de despesa: 339030. Valor total do empenho: R$ 14.220,00 (quatorze mil,
duzentos e vinte reais). Proc. nº TRF2-EOF-2019/00143.02

TRIBUNAL REGIONAL FEDERAL DA 3ª REGIÃO
EXTRATO DE CESSÃO DE USO

Processo n.º 0014576-10.2015.4.03.8000 Espécie: Termo de Cessão de Uso n.º
02.001.10.2019. Partícipes: Caixa Econômica Federal, CNPJ n.º 00.360.305/001-04 e o
Tribunal Regional Federal da 3.ª Região - TRF3, CNPJ n.° 59.949.362/0001-76. Objeto:
Cessão de Uso, a título gratuito, de imóveis locados pela Caixa-Cedente, consistentes nos
conjuntos localizados no Edifício Funcef Center, situados na Avenida Paulista n.°
1904/1912, em São Paulo, Capital, assim descritos: 11.° andar, Conjunto 111, composto
pelos salões 111, 113 e 115; Conjunto 112, composto pelos salões 112, 114 e 116 e  8
vagas de garagem, situadas nos subsolos do referido edifício. Fundamento Legal: Lei n.°
8666/1993. Data da Assinatura: 12/07/2019. Vigência: 60 (sessenta) meses, a contar da
data da assinatura. Valor: Não haverá transferência de recursos financeiros entre os
partícipes. Signatários: pelo TRF3: Marisol Ávila Ribeiro (Diretora-Geral, em exercício) e
pela CEF: Cesar Luiz Pucinelli (Gerente Filial de Logística).

TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
AVISO DE HOMOLOGAÇÃO

PREGÃO ELETRÔNICO Nº 32/2019

Processo Administrativo SEI nº 0005085-96.2019.6.02.8000. O Desembargador
Pedro Augusto Mendonça de Araújo, Presidente do TRE/AL, homologou, em 15/08/2019, o
resultado do Pregão Eletrônico nº 32/2019, cujo objeto é a aquisição de material
permanente - pedestais, que foi adjudicado à empresa BELT COMPANY DO BRASIL
MARKETING LTDA, CNPJ nº 01.281.553/0001-22, vencedora quanto aos itens 01 e 02 pelo
valor total de R$7.182,50. Fundamento legal: art. 4º, XXII, da Lei nº 10.520/02 e Decreto
nº 5.450/05.

Maceió-AL, 22 de agosto de 2019.
INGRID PEREIRA DE LIMA ARAÚJO

Chefe da Seção de Licitações e Contratos
SECRETARIA DE ADMINISTRAÇÃO

COORDENADORIA DE MATERIAL E PATRIMÔNIO
AVISO DE LICITAÇÃO

PREGÃO ELETRÔNICO Nº 39/2019 - UASG 70011

Nº Processo: 0008478-63.2018. Objeto: Registro de Preços de componentes de rede
(Networking).. Total de Itens Licitados: 35. Edital: 23/08/2019 das 08h00 às 17h00.
Endereço: Avenida Aristeu de Andrade, Nº 377, Farol - Maceió/AL ou
www.comprasgovernamentais.gov.br/edital/70011-5-00039-2019. Entrega das Propostas:
a partir de 23/08/2019 às 08h00 no site www.comprasnet.gov.br. Abertura das
Propostas: 09/09/2019 às 14h00 no site www.comprasnet.gov.br.

INGRID PEREIRA DE LIMA ARAUJO
Chefe da Seção de Licitações e Contratos

(SIASGnet - 22/08/2019) 70011-00001-2019NE000032

TRIBUNAL REGIONAL ELEITORAL DO AMAPÁ
EXTRATO DE INEXIGIBILIDADE DE LICITAÇÃO

P.A. nº 0001340-81.2019.6.03.8000. Termo de Inexigibilidade nº 36/2019. Contratante:
Tribunal Regional Eleitoral do Amapá. Favorecido: Instituto Gestão Pública Eireli (IGP
Brasil). CNPJ: 25.100.085/0001-00. Objeto: Participação de servidores em curso in
company. Fundamento Legal: art. 25, II, c/c art. 13, VI, da Lei nº 8.666/93. VALOR: R$
18.000,00 (dezoito mil reais). Assinatura de ratificação em 22/08/2019 pelo Contratante,
Des. Rommel Araújo de Oliveira, Presidente do TRE/AP.

TRIBUNAL REGIONAL ELEITORAL DO AMAZONAS
EXTRATO DE CONTRATO

Processo: 3942/2017 - PAD/TRE/AM. Espécie: Termo de Contrato n. 16/2019. Objeto:
Prestação de serviços de apoio técnico operacional para as atividades de gestão de
Governança, na forma de serviços continuados, executados sob demanda e sem dedicação
exclusiva de mão de obra, mensurados em Unidade de Serviço Governamental - USG,
conforme condições, quantidade e exigências estabelecidas no Edital e seus anexos -
Ministério da Saúde, o qual o TRE-AM configura como partícipe. Modalidade de Licitação:
Pregão Eletrônico SRP 44/2018. CONTRATANTE: TRIBUNAL REGIONAL ELEITORAL DO
AMAZONAS. CONTRATADA: CENTRAL IT TECNOLOGIA DA INFORMAÇÃO LTDA. CNPJ:
07.171.299/0001-96. Fundamentação Legal: Lei n. 10.520/2002, Lei n. 8.666/1993, Decreto
n. 7.892/2013 e Decreto n. 2.271/1997. Dotação Orçamentária: Programa de Trabalho
02.122.0570.20GP.0013, 02.061.0570.4269.0001 Elemento de Despesas: 3390.39. Prazo de
Vigência: 12 (doze) meses a contar de 06/08/2019. Preço: Valor total de R$ 287.000,00
(duzentos e oitenta e sete mil reais). Data da Assinatura: 06/08/2019. Assinam: Desdor.
JOÃO DE JESUS ABDALA SIMÕES, pelo Contratante, o Sr. CARLOS ALBERTO FREITAS, pela
Contratada.

SECRETARIA DO TRIBUNAL
SECRETARIA DE ADMINISTRAÇÃO, ORÇAMENTO E FINANÇAS

EXTRATO DE TERMO ADITIVO

Processo: (PAD) 4682/2018-TRE/AM. Espécie: Primeiro Termo Aditivo ao Contrato n.
25/2018, Locação de imóvel para abrigar o Cartório Eleitoral da 17ª ZE - Humaitá/AM.
LOCATÁRIO: TRIBUNAL REGIONAL ELEITORAL DO AMAZONAS. LOCADOR: CARLOS SÉRGIO
DA SILVA GUIMARÃES. Fundamentação Legal: Lei n. 8.666/93 e alterações posteriores, em
especial no Art. 62, § 3º, inciso I, e o Art. 3º da Lei n. 8.245/91. Do Objeto: alteração do
caput da Cláusula Terceira (Do Prazo de Vigência) e da Cláusula Quarta (Do Preço). Preço:
mensal de R$ 3.116,54 (três mil, cento e dezesseis reais e cinquenta e quatro centavos), a
partir de 27/09/2019. Vigência: de 27/09/2019 a 26/09/2020. Assinam: Desdor JOÃO DE
JESUS ABDALA SIMÕES, pelo Locatário, o Sr. CARLOS SÉRGIO DA SILVA GUIMARÃES, pelo
Locador.

EXTRATO DE TERMO ADITIVO

Processo: (PAD) 6974/2018 TRE-AM Espécie: Primeiro Termo Aditivo ao Contrato n.
24/2018, prestação de serviços de fretamento de aeronaves tipo helicóptero - táxi aéreo.
CONTRATADA: EMAR TÁXI AÉREO LTDA. CONTRATANTE: TRIBUNAL REGIONAL ELEITORAL
DO AMAZONAS. Fundamentação Legal: Lei n. 8.666/93, e alterações posteriores, em
especial o seu Art. 57, II. Do Objeto: alterar o caput da CLÁUSULA QUATORZE (DA
VIGÊNCIA). Vigência: 12 (doze) meses, ou seja, de 19/09/2019 até 18/09/2020. Data da
Assinatura: 16/08/2019. Assinam: Desdor. JOÃO DE JESUS ABDALA SIMÕES, pelo
Contratante, Sra. RENATA DE OLIVEIRA MENDONÇA, pela Contratada.

AVISO DE CREDENCIAMENTO

Processo PAD: 8527/2019/TRE-AM. Espécie: Credenciamento de Associações
e/ou Cooperativas de Catadores de Materiais Recicláveis, para a coleta de resíduos sólidos
recicláveis descartados por unidades do TRE/AM, em Manaus/AM. Data para recebimento
dos documentos de credenciamento e habilitação: 7 (sete) dias úteis, contados a partir da
presente data (data da publicação deste aviso e publicação do edital no D.O.U.). Local e
horário da entrega dos documentos: protocolo do Tribunal Regional Eleitoral do Amazonas,
localizado na Avenida André Araújo, n. 200, térreo, Bairro Aleixo, em Manaus/AM, das 08h
às 14h. Informações: (92) 3632-4435. Os interessados poderão retirar o edital pela
Internet, no endereço: http://www.tre-am.jus.br/o-tre/conheca-o-tre-am/sustentabilidade-
arquivos/edital-001-2019-coleta-seletiva

DESEMBARGADOR JOÃO DE JESUS ABDALA SIMÕES
Presidente do Tre-Am

TRIBUNAL REGIONAL ELEITORAL DA BAHIA
EXTRATO DE COOPERAÇÃO TÉCNICA Nº 1/2019

TERMO DE PARCERIA E COOPERAÇÃO TÉCNICA, firmado entre a 49ª Zona Eleitoral e o
Município de Jandaíra/BA: PAD Nº 10208/2019. OBJETO: Cooperação entre os partícipes
visando à disponibilização de pessoal do quadro de servidores do Município de Jandaíra,
para a prestação dos serviços de atualização do cadastro eleitoral mediante incorporação
de dados biométricos, nos serviços extraordinários de revisão. FUNDAMENTO LEGAL: Leis
7.444/1985 e 9.454/1997 e as Resoluções TSE nº 21.538/2003 e 23.440/2015. VIGÊNCIA:
Período de 01 (um) ano a partir da assinatura do termo. ASSINATURA: 11.07.2019.
SIGNATÁRIOS: Bel. César Augusto Carvalho de Figueiredo, pela 49ªZE, e Adilson Aires Leite
de Ávila Júnior pelo Município de Jandaíra.

TRIBUNAL REGIONAL ELEITORAL DO CEARÁ
EXTRATO DE APOSTILAMENTO

Espécie: 5º Termo de Apostilamento ao Contrato N.º 324/2018 celebrado com a empresa
REALIZA SERVIÇOS ESPECIALIZADOS EIRELI. Objeto: Repactuar o Contrato de prestação de
serviços n.º 324/2018, concernente à categoria de Supervisor de Informática, motivado por
solicitação da empresa, em razão do Dissídio Coletivo dos Trabalhadores em
Processamento de Dados, Serviços de Informática e Similares do Estado do Ceará,
registrado por meio de Acórdão nº DC-0080578-03.2015.5.07.000 do Tribunal Regional do
Trabalho da 7a. Região, em 23 de julho de 2019; Repactuar os valores das horas extras;
Repactuar os valores das diárias; Incluir o aumento do vale-transporte, a partir de 26 de
janeiro de 2019. Fundamento: art. 40, XI, da Lei n.º 8.666/93 e o art. 12 do Decreto n.º
9.507/2018, c/c Cláusula 5.3 do Contrato n.º 324/2018 e na autorização do Diretor-Geral,
contida no Processo PAD N.º 13.865/2019. Assina: pelo TRE/CE, Hugo Pereira Filho, Diretor-
Geral. Data: 22/08/2019. HUGO PEREIRA FILHO
DIRETOR-GERAL

EXTRATO DE APOSTILAMENTO

Espécie: 1º Termo de Apostilamento ao Contrato N.º 8/2019 celebrado com a empresa
INOVA TECNOLOGIA EM SERVIÇOS LTDA. Objeto: Repactuar o Contrato de prestação de
serviços n.º 8/2019, concernente à categoria de Recepcionista, motivado por solicitação da
empresa, em razão da celebração da Convenção Coletiva de Trabalho 2019/2019 entre o
Sindicato das Empresas de Asseio e Conservação do Estado do Ceará e o Sindicato dos
Empregados em Empresas de Asseio e Conservação; Repactuar os valores das horas extras;
O Contrato passa a ter os valores mensais, conforme anexo a este termo: Os valores das
horas extras serão repactuados para: Recepcionista, Hora extra com 75% de adicional, R$
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Toquem fogo na Amazônia

Já deixei claro em outros artigos que não faço desta 
coluna plataforma de defesa ou de acusação políticas 
o que, no entanto, não me deixa fora de tecer alguns 

comentários pertinentes e não parecer alienado ou alheio 
aos problemas que aconteçam em nosso país. 
   Sabemos da existência de ONGs na Amazônia, sabe-
mos de seus trabalhos assim como temos ciência de que 
existem boas e ruins e todas elas sendo beneficiadas com 
dinheiro do estado há muitos anos. Suas presenças são 
importantes no contexto de defesa de nossa floresta e o 
que devemos é tentar separa o joio do trigo e “dar a Cesar 
o que é de Cesar”. 

   O fato é que a degradação, o desmatamento, 
a ocupação indevida, tudo isto acontece há dé-
cadas naquela região, assim como as queimada 
principalmente em épocas de seca como a de 
agora. Nem por isso essas incêndios podem ser 
taxados de criminosos e muito menos apontando-
se o dedo para as ONGs sem provas legais de 
que sejam elas as responsáveis com o objetivo de 
se locupletarem com mais benesses do servi-
ço público federal. Mas o presidente Bolsonaro 
irresponsavelmente apontou o dedo, declarou 
em alto e bom som o que não pode provar e que 
jamais poderia sair da boca de um presidente da 
república sem que estivesse calcado e baseado 
em provas concretas advindas de um inquérito 
absolutamente legal. 
      Este tipo de coisas é que tiram a credibilidade 
do Brasil no exterior, que desanimam investido-
res, que fazem com que a imagem chamuscada 
ateie fogo nas pretensões do desenvolvimento. 

   É preciso falar na hora certa e é 
necessário calar no momento em que o 
silêncio for promissor. Mas, por favor, não 
toquem outro tipo de fogo na Amazônia. 
Apaguem o físico com a maior presteza e 
esqueçam o fogo que abala projetos e as 
melhores intenções. 

ALERTA DO DIA:
• Mais um bairro de Maceió na mira dos 
afundamentos: Bom Pastor. Casas racha-
das, pisos mergulhando na terra e por aí 
vai. Pode?

• E aí, gente, nada contra a Braskem, 
mas numa hora dessas ela solicita auto-
rização para pra explorar sal-gema em 
áreas da zona norte da cidade?

• Aquilo que era no meu tempo uma 

doencinha que toda a criança tinha, 
o sarampo, agora sai matando pelo 
Brasil a dentro. Sarampo, catapora, 
caxumba e outras menos votadas 
eram quase que obrigatórias na infân-
cia do meu tempo.

• Tema de encontro entre Rodrigo 
Cunha e o Ministro da Cidadania, 
Osmar Terra: medidas que possam 
tirar da situação de desolação adoles-
centes que deixaram a escola por não 
se sentirem estimulados e não têm 
espaço no mercado de trabalho. Os 
chamados “nem-nem”.

PARE PRA PENSAR
Não se compare com ninguém. 
Compare os outros a você e veja onde 
melhorar.  

Bebedouro: 80 casas 
são condenadas em 
encosta no bairro
Moradores dizem que não houve aviso de equipes do município; 
para a prefeitura, obra é necessária e famílias serão indenizadas

Casas foram marcadas com X; vereador diz que obra de contenção deveria ter sido iniciada há um mês

LUCAS FRANÇA
REPÓRTER

Moradores do bairro de 
Bebedouro em Maceió 
dizem que não foram 

informados de forma direta 
sobre a condenação de 80 ca-
sas que ficam próximas a uma 
encosta na Rua Marquês de 
Abrantes que dá acesso à Chã 
da Jaqueira. Segundo o repre-
sentante do bairro e o vereador 
Francisco Sales, era para ter 
sido iniciada há um mês uma 
obra de contenção da encosta.

“O Governo Federal desti-
nou R$ 2,5 milhões para iniciar 
uma obra nas encostas. Isso de-
veria ter sido feito há mais de 

um mês. No entanto, sem avi-
sar nada aos moradores, equi-
pes da prefeitura foram ao local 
e marcaram com um X as casas 
que devem ser condenadas. Fi-
zeram isto sem fazer uma reu-
nião prévia com as famílias, fa-
lar sobre indenização ou ajuda 
em aluguel social. Simplesmen-
te disseram que o pessoal tem 
que sair do local”, denuncia o 
vereador.

O líder comunitário de Be-
bedouro, Augusto Cícero, rea-
firma a denúncia do vereador e 
acrescenta que o poder público 
atualmente está fazendo o que 
quer sem ouvir a população.

“Simplesmente marcou as 
casas. 60 na principal e 20 ca-
sas na parte de cima da Mar-

EDILSON OMENA

grand

missa

fisio

TIC

quês de Abrantes. A questão é 
que foi marcada as casas para, 
segundo a Prefeitura, realizar 
contenção de encostas. Sendo 
que em nenhum  momento mo-
radores das casas demarcadas 
foram procurados pela Prefei-
tura. E nem foi falado em inde-
nização para eles’’, disse o líder 
comunitário. “Foi igual fizeram 
com o PAM de Bebedouro, sim-
plesmente organizaram uma 
reunião na calada da noite e 
resolveram tirar daqui, mes-
mo sabendo das necessidades. 
Aqui, tem local que poderia 
ter ficado o PAM, pois não é o 
bairro todo que está na área de 
risco. E agora, vão tirar os mo-
radores sem nenhuma ajuda. 
Depois chega as reclamações e 

as reivindicações porque eles 
mesmo causam isso”, finaliza.

A Prefeitura de Maceió ex-
plica que equipes da Defesa 
Civil e da Secretaria Municipal 
de Infraestrutura (Seminfra) 
estiveram na Rua Marquês de 
Abrantes, em Bebedouro, para 
acompanhar a empresa respon-
sável pela obra de contenção de 
encostas. “A obra é fundamen-
tal para evitar novos desliza-
mentos de terra, como os que 
ocorreram em 2017, e garan-
tir a segurança dos moradores 
da região. As casas que foram 

marcadas vão receber a visita 
de equipes da Prefeitura, que 
vão identificar se as famílias já 
estão inseridas no programa de 
Habitação do Município e orien-
tá-las sobre os procedimentos 
que serão adotados. Os recursos 
para a obra já foram aprovados, 
mas ainda não foram liberados 
pelo governo federal”.

Os moradores das proxi-
midades da encosta disseram 
que ficaram surpresos com a 
marcação, por não terem sido 
avisados dessa visita. “É fato 
que o local é perigoso. Já hou-

ve deslizamento, mas a gente 
mora aqui há bastante tempo 
e não temos para onde ir. Eles 
simplesmente vieram e falaram 
que as casas estão condenadas”, 
disse o polidor de automóveis 
Ivan Emílio Bezerra. Quem 
também criticou a maneira que 
foi feito o aviso foi o lustrador 
de móveis, Noé Francisco. “Eles 
falaram que vão indenizar to-
dos, mas nunca feito uma visita 
para pegar nossos dados, ava-
liar o imóvel nem nada disso. 
Só se fizerem antes da obra ini-
ciar”.
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DESPACHO

Maceió, 23 de agosto de 2019.
À CPREG, após publicação do Aviso de Licitação no

DOU, no periódico Tribuna Independente, bem como no
Portal da Transparência, para realização do certame.

Documento assinado eletronicamente por ANDRÉA DE ALBUQUERQUE CÉSAR,
Analista Judiciário, em 23/08/2019, às 12:38, conforme art. 1º, III, "b", da Lei
11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0585582 e o código CRC A13F8498.
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De: "Ingrid Brêda de Gusmão Pereira" <ingridpereira@tre-al.jus.br>
Para: "Weber Bezerra Cavalcanti" <webercavalcanti@tre-al.jus.br>, "João Hermínio de Barros Neto"
<joaobarros@tre-al.jus.br>, "pregoeiro Mailing List" <pregoeiro@tre-al.jus.br>
Data: 04/09/2019 04:19 PM
Assunto: Fwd: [slc] PE-39/2019 - TRE- AL | SOLICITAÇÃO DE ESCLARECIMENTOS {01}

 
 
 
 

From: "Silva, Neiva" <Neiva.Silva@ingrammicro.com>
To: Ingrid Breda de Gusmão Pereira <ingridpereira@tre-al.jus.br>
Cc: "Cordeiro, Glauber" <Glauber.Cordeiro@ingrammicro.com>, "Souza, Sidney"
<Sidney.Souza@ingrammicro.com>
Date: Wed, 4 Sep 2019 18:56:45 +0000
Subject: [slc] PE-39/2019 - TRE- AL | SOLICITAÇÃO DE ESCLARECIMENTOS {01}
 
Ao
TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
PREGÃO ELETRÔNICO Nº 39/2019
 
OBJETO: Registro de Preços de componentes de rede (Networking), conforme especificações descritas nos Anexos I
e I-A deste edital.

 
A Ingram Micro Brasil Ltda., sediada Av. Piracema, 1.341, Galpões 3 e 4, parte - Cep 06460-030 – Bairro:
Tamboré – Barueri – SP, CNPJ: 01.771.935/0008-00, pessoa jurídica de direito privado, devidamente
qualificada a par�cipar do procedimento licitatório acima referenciado, por intermédio de seu
representante legal, tempes�va e respeitosamente, vem perante a essa denotada Comissão de Licitação,
solicitar os seguintes esclarecimentos:
 
 
 

Questão 1)
O objeto do presente edital é o Registro de Preços de componentes de rede (Networking) conforme especificações
descritas nos Anexos I e I-A, solução composta por Hardware, So�ware, serviços, instalação, treinamento, garan�a e
suporte técnico. É praxe no mercado de TI, principalmente no caso de soluções, compostas de serviços complexos,
a u�lização de mão de obra terceirizada para a execução de soluções deste �po, sendo o próprio fabricante ou
mesmo a u�lização de empresas locais, parceiros devidamente credenciadas pelo mesmo, o que inclusive permite
uma oferta mais vantajosa para a administração pública, para a execução de tais serviços. No entanto, ra�ficamos
que a Contratada con�nua mantendo a total responsabilidade pela execução da solução e, responderá técnica e
juridicamente pelo cumprimento do contrato. Entendemos que neste caso estaríamos atendendo ao referido no
edital. Nosso entendimento está correto?
 
Questão 2)
É previsto no instrumento convocatório que os equipamentos sejam entregues em até 60 dias contados do
recebimento da Ordem de Fornecimento e/ou documento equivalente, é nosso entendimento que para execução
do escopo de serviços de instalação, configuração e hands-on, será concedido um prazo de 15 dias a contar da
entrega dos equipamentos. Está correto nosso entendimento?
 
Questão 3)
Em análise ao Termo de Referência, é requisitado:

“8. Ao TRE é reservado o direito de efetuar conexões dos equipamentos a outros, bem como adicionar
demais acessórios compa�veis tecnicamente, sem que isso cons�tua mo�vo para a  Contratada se
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desobrigar da garan�a, desde que tal fato não implique danos materiais ou técnicos aos equipamentos e
acessórios, hipótese que deverá ser devidamente comprovada;“

Entendemos que, as conexões que o TRE irá realizar, serão conexões lógicas de protocolos abertos, com
compa�bilidade total entre fabricantes. No que tange os componentes de hardware, como transceivers, cabos e
outros, será considerado a matriz de compa�bilidade dos equipamentos ofertados pelo fabricante. Está correto
nosso entendimento?
 
Questão 4)
É disposto no item:

“21.1. O pagamento será efetuado mediante ordem bancária de crédito em conta corrente, em até 10
(dez) dias, após o recebimento da Nota Fiscal respec�va...”

Tendo em vista que, o objeto deste certame trata-se da entrega de equipamentos e execução serviços, o que conota
a existência de 2 marcos de recebimentos precedentes ao recebimento defini�vo e afim de evitar novos custos
financeiros as licitantes, além dos que já estão previstos na execução do objeto, obje�vando a entrega de uma
proposta mais compe��va por parte dos proponentes, entendemos que, o pagamento do objeto licitado ocorrerá
da seguinte forma:
 
-Itens de Hardware – em até 10 (dez) dias após o aceite defini�vo que será dado em até 05 dias corridos do aceite
provisório emi�do no momento da entrega do equipamento juntamente com
a Nota Fiscal.
-Serviços de Instalação e Treinamento – até 10 (dez) dias após a realização dos serviços e aceite defini�vo dos
mesmos que será dado em até 05 dias corridos.
Está correto nosso entendimento? 
 
Questão 5)
Entendemos que no quadro Anexo I-A com as especificações e quan�ta�vos que serão adquiridos para o lote 1 –
itens 18 e 19 serão de fato para 4 profissionais e não para apenas 1 como está na descrição das caracterís�cas
gerais dos mesmos itens. está correto nosso entendimento?
 
Questão 6)
De acordo com as exigências con�das no edital na página 3, requisito [...3. DOS PRAZOS DE ENTREGA E DA
GARANTIA...], subitens 3.5 e 3.6 que tratam da garan�a do fabricante, atendimento e prazo de reparo para os
equipamentos.
Grifo nosso:

...[ 3.5. Quanto aos itens 5, 8, 9, 10, 11, 24, 26 e 27, o equipamento ofertado deverá possuir
garan�a do fabricante na modalidade on-site pelo período mínimo de 60 (sessenta) meses para reposição
de peças, mão de obra e atendimento. O prazo máximo para atendimento do chamado deve ser de até o
próximo dia ú�l após a sua abertura. Durante o período da garan�a o prazo máximo para o reparo de
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) dias úteis.]...
 ...[ 3.6. Quanto aos itens 6, 7, 12, 13, 14, 15, 28 e 29, O equipamento ofertado deverá possuir garan�a do
fabricante do equipamento na modalidade on-site pelo período mínimo de 12 (doze) meses para reposição
de peças, mão de obra e atendimento no local. O período da garan�a o prazo máximo para o reparo de
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) dias úteis.]...

 Entendemos que ofertando equipamentos com garan�a do fabricante na modalidade de Envio no Próximo Dia Ú�l
(Next Business Day Shipment) que é mais abrangente que as exigências dos itens 3.5 e 3.6 do edital, por já
contemplar a remessa de equipamentos, peças e partes para troca ou reposição dos respe�vos itens defeituosos no
prazo máximo de próximo dia ú�l, bem como, atendendo ainda ao requisito de prazo máximo para o reparo de
equipamentos defeituosos a condição normal de funcionamento em até 07 (sete) dias úteis, que estaremos
atendendo as exigências con�das no edital. Está correto nosso entendimento ?
Questão 7)
De acordo com as exigências con�das no edital, no “Anexo I”, páginas 31 e 32, requisito [...3.1 Descrição do
Objeto...], subitem 8, que trata das configurações e especificações mínimas, informando ainda que serão aceitos
equipamentos/so�wares com caracterís�cas superiores, desde que compa�veis com as exigidas.
Grifo nosso:
 

...[ 8.    As configurações e especificações aqui apresentadas são mínimas, sendo aceitos
equipamentos/so�wares com caracterís�cas superiores, desde que compa�veis com as exigidas;]...
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Assim diante do extenso e complexo descri�vo das exigências técnicas mínimas dos itens de equipamentos e
so�wares do edital, corroborando ainda com o “Anexo I”, páginas 31 e 32, requisito [...3.1 Descrição do Objeto...],
subitem 8. Solicitamos que seja informado qual o procedimento que deverá ser adotado para a comprovação de
todos os itens e subitens exigidos nas caracterís�cas técnicas mínimas ?
 
 
No Aguardo do pronunciamento desta douta comissão.
 
A�,
 
Neiva	Maria	da	Silva
Gestora	de	Editais
Bidding	Manager
Av.	Piracema,	1341	–	Galpões	3	e	4
Tamboré,	Barueri	–	SP	-	06460-030
NOVO	TELEFONE
Direto	+55	11	2078-4764	–	Ramal	interno	84764
Celular	+55	11	99677-1348
Geral	+55	11	2078-4200
neiva.silva@ingrammicro.com

As informações contidas nesta mensagem e no(s) arquivo(s) anexo(s) são confidenciais e de propriedades da Ingram
Micro e de uso exclusivamente à(s) pessoa(s) e/ou instituição(ões) acima indicada(s) e podem conter informações
confidenciais e/ou privilegiadas. Se você não for o destinatário ou pessoa autorizada a recebê-la, queira, por favor
retorná-la ao remetente e em seguida apagá-la definitivamente. Qualquer uso, cópia ou divulgação das informações
nela contidas, na íntegra ou parcialmente, são proibidas e serão tratadas conforme legislação vigente.
 

As informações con�das nesta mensagem e no(s) arquivo(s) anexo(s) são confidenciais e de propriedades da Ingram Micro e de
uso exclusivamente à(s) pessoa(s) e/ou ins�tuição(ões) acima indicada(s) e podem conter informações confidenciais e/ou
privilegiadas. Se você não for o des�natário ou pessoa autorizada a recebê-la, queira, por favor retorná-la ao remetente e em
seguida apagá-la definitvamente. Qualquer uso, cópia ou digulvação das informações nela con�das, na íntegra ou parcialmente,
são proibidas e serão tratadas conforme legislação vigente.
[Ingram_2818e5de]
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Ao 
TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS 
PREGÃO ELETRÔNICO Nº 39/2019 
 

OBJETO: Registro de Preços de componentes de rede (Networking), conforme especificações descritas nos 
Anexos I e I-A deste edital. 

 

A Ingram Micro Brasil Ltda., sediada Av. Piracema, 1.341, Galpões 3 e 4, parte - Cep 06460-
030 – Bairro: Tamboré – Barueri – SP, CNPJ: 01.771.935/0008-00, pessoa jurídica de direito 
privado, devidamente qualificada a participar do procedimento licitatório acima referenciado, 
por intermédio de seu representante legal, tempestiva e respeitosamente, vem perante a essa 
denotada Comissão de Licitação, solicitar os seguintes esclarecimentos: 

 
 
 

Questão 1) 

O objeto do presente edital é o Registro de Preços de componentes de rede (Networking) conforme 

especificações descritas nos Anexos I e I-A, solução composta por Hardware, Software, serviços, instalação, 

treinamento, garantia e suporte técnico. É praxe no mercado de TI, principalmente no caso de soluções, 

compostas de serviços complexos, a utilização de mão de obra terceirizada para a execução de soluções 

deste tipo, sendo o próprio fabricante ou mesmo a utilização de empresas locais, parceiros devidamente 

credenciadas pelo mesmo, o que inclusive permite uma oferta mais vantajosa para a administração pública, 

para a execução de tais serviços. No entanto, ratificamos que a Contratada continua mantendo a total 

responsabilidade pela execução da solução e, responderá técnica e juridicamente pelo cumprimento do 

contrato. Entendemos que neste caso estaríamos atendendo ao referido no edital. Nosso entendimento 

está correto?  

 

Questão 2) 

É previsto no instrumento convocatório que os equipamentos sejam entregues em até 60 dias contados do 

recebimento da Ordem de Fornecimento e/ou documento equivalente, é nosso entendimento que para 

execução do escopo de serviços de instalação, configuração e hands-on, será concedido um prazo de 15 

dias a contar da entrega dos equipamentos. Está correto nosso entendimento? 

 

Questão 3) 

Em análise ao Termo de Referência, é requisitado: 

“8. Ao TRE é reservado o direito de efetuar conexões dos equipamentos a outros, bem como 

adicionar demais acessórios compatíveis tecnicamente, sem que isso constitua motivo para 

a  Contratada se desobrigar da garantia, desde que tal fato não implique danos materiais ou 

técnicos aos equipamentos e acessórios, hipótese que deverá ser devidamente comprovada;“ 
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Entendemos que, as conexões que o TRE irá realizar, serão conexões lógicas de protocolos abertos, com 

compatibilidade total entre fabricantes. No que tange os componentes de hardware, como transceivers, 

cabos e outros, será considerado a matriz de compatibilidade dos equipamentos ofertados pelo fabricante. 

Está correto nosso entendimento? 

 

Questão 4) 

É disposto no item: 

“21.1. O pagamento será efetuado mediante ordem bancária de crédito em conta corrente, 

em até 10 (dez) dias, após o recebimento da Nota Fiscal respectiva...” 

Tendo em vista que, o objeto deste certame trata-se da entrega de equipamentos e execução serviços, o 

que conota a existência de 2 marcos de recebimentos precedentes ao recebimento definitivo e afim de 

evitar novos custos financeiros as licitantes, além dos que já estão previstos na execução do objeto, 

objetivando a entrega de uma proposta mais competitiva por parte dos proponentes, entendemos que, o 

pagamento do objeto licitado ocorrerá da seguinte forma: 

 

-Itens de Hardware – em até 10 (dez) dias após o aceite definitivo que será dado em até 05 dias corridos do 

aceite provisório emitido no momento da entrega do equipamento juntamente com  

a Nota Fiscal. 

-Serviços de Instalação e Treinamento – até 10 (dez) dias após a realização dos serviços e aceite definitivo 

dos mesmos que será dado em até 05 dias corridos.  

Está correto nosso entendimento?   

 

Questão 5) 

Entendemos que no quadro Anexo I-A com as especificações e quantitativos que serão adquiridos para o 

lote 1 – itens 18 e 19 serão de fato para 4 profissionais e não para apenas 1 como está na descrição das 

características gerais dos mesmos itens. está correto nosso entendimento? 

 

Questão 6) 
De acordo com as exigências contidas no edital na página 3, requisito [...3. DOS PRAZOS DE ENTREGA E DA 
GARANTIA...], subitens 3.5 e 3.6 que tratam da garantia do fabricante, atendimento e prazo de reparo para 
os equipamentos. 
Grifo nosso: 

...[ 3.5. Quanto aos itens 5, 8, 9, 10, 11, 24, 26 e 27, o equipamento ofertado deverá possuir 
garantia do fabricante na modalidade on-site pelo período mínimo de 60 (sessenta) meses para 
reposição de peças, mão de obra e atendimento. O prazo máximo para atendimento do chamado 
deve ser de até o próximo dia útil após a sua abertura. Durante o período da garantia o prazo 
máximo para o reparo de equipamentos defeituosos a condição normal de funcionamento deverá 
ser de até 07 (sete) dias úteis.]... 
  

...[ 3.6. Quanto aos itens 6, 7, 12, 13, 14, 15, 28 e 29, O equipamento ofertado deverá possuir 
garantia do fabricante do equipamento na modalidade on-site pelo período mínimo de 12 (doze) 
meses para reposição de peças, mão de obra e atendimento no local. O período da garantia o prazo 
máximo para o reparo de equipamentos defeituosos a condição normal de funcionamento deverá 
ser de até 07 (sete) dias úteis.]...  

Entendemos que ofertando equipamentos com garantia do fabricante na modalidade de Envio no Próximo 
Dia Útil (Next Business Day Shipment) que é mais abrangente que as exigências dos itens 3.5 e 3.6 do edital, 
por já contemplar a remessa de equipamentos, peças e partes para troca ou reposição dos respetivos itens 
defeituosos no prazo máximo de próximo dia útil, bem como, atendendo ainda ao requisito de prazo 
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máximo para o reparo de equipamentos defeituosos a condição normal de funcionamento em até 07 (sete) 
dias úteis, que estaremos atendendo as exigências contidas no edital. Está correto nosso entendimento ? 
  
Questão 7) 
De acordo com as exigências contidas no edital, no “Anexo I”, páginas 31 e 32, requisito [...3.1 Descrição do 
Objeto...], subitem 8, que trata das configurações e especificações mínimas, informando ainda que serão 
aceitos equipamentos/softwares com características superiores, desde que compatíveis com as exigidas. 
Grifo nosso: 

  
...[ 8.    As configurações e especificações aqui apresentadas são mínimas, sendo aceitos 

equipamentos/softwares com características superiores, desde que compatíveis com as exigidas;]... 
  
Assim diante do extenso e complexo descritivo das exigências técnicas mínimas dos itens de equipamentos 
e softwares do edital, corroborando ainda com o “Anexo I”, páginas 31 e 32, requisito [...3.1 Descrição do 
Objeto...], subitem 8. Solicitamos que seja informado qual o procedimento que deverá ser adotado para a 
comprovação de todos os itens e subitens exigidos nas características técnicas mínimas ? 
 

 
No Aguardo do pronunciamento desta douta comissão.  
 
 
Barueri/SP, 04 de setembro de 2019. 
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Avenida Aristeu de Andrade nº 377 - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 04 de setembro de 2019.
Senhor Coordenador,
A Empresa Ingram Micro Brasil Ltda., solicita os

devidos esclarecimentos,  referentes ao Edital do Pregão
Eletrônico n.º 39/2019, conforme eventos 0590017 e 0590019.

Respeitosamente.

Documento assinado eletronicamente por JOÃO HERMÍNIO DE BARROS NETO,
Pregoeiro, em 04/09/2019, às 17:59, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0590022 e o código CRC FECA0E1E.

0008478-63.2018.6.02.8000 0590022v1
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DESPACHO

Maceió, 05 de setembro de 2019.
Ao Pregoeiro
 
Sr. Pregoeiro,
 
Em atenção ao Despacho PREG 0590022, informo

quanto à:
 
Questão 1)
Resposta: É possível a utilização de mão de obra

terceirizada para a execução de soluções deste tipo ciente o
contratado da necessidade de apresentação de compravação
de mão de obra qualificada, ciente de que qualquer dano ou
anulação de garantia por parte do fabricante incidirá na
responsabilização do contratado.

 
Questão 2)
Resposta: Para os itens que preveem instalação,

deve o licitante estar ciente de que o pagamento só ocorrerá
após o fornecimento, instalação e aferição técnica de
funcionamento/funcionalidade. Para os demais há de se
observar as regras gerais para o Recimento do Objeto parte
integrante do Termo de Referência. No caso de
inadimplemento de obrigação fica o licitante/contratado
sujeito às penalidade previstas.

 
Questão 3)
Resposta: Correto o entendimento.
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Questão 4)
Resposta: Não é quesito técnico de TI.
 
Questão 5)
Resposta: A leitura deve ser conjunta, ou seja, os

vouchers são individuais, mas o total dos vouchers são 04
(quatro) por item.

 
Questão 6)
Resposta: Correto o entendimento, salientando-se a

necessidade de observar os períodos mínimos de cobertura 60
(sessenta) ou 12 (doze) meses, conforme o caso.

 
Questão 7)
Resposta: A comprovação se dará pela verificação

de part numbers, ficha técnica, catálogo, url do fabricante,
conforme apresente o licitante em sua proposta, ou seja, é
dever do licitante comprovar o alegado em sua proposta para
que possa a Administração aferir.

 
 

Atenciosamente.

 
 
 

Documento assinado eletronicamente por DANIEL MACÊDO DE CARVALHO SOUTO,
Coordenador, em 05/09/2019, às 15:49, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0590455 e o código CRC D5D806E3.

0008478-63.2018.6.02.8000 0590455v1
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Esclarecimento 05/09/2019 16:56:01
 
OBJETO: Registro de Preços de componentes de rede (Networking), conforme especificações descritas nos Anexos I e I-A
deste edital. A Ingram Micro Brasil Ltda., sediada Av. Piracema, 1.341, Galpões 3 e 4, parte - Cep 06460- 030 – Bairro:
Tamboré – Barueri – SP, CNPJ: 01.771.935/0008-00, pessoa jurídica de direito privado, devidamente qualificada a participar
do procedimento licitatório acima referenciado, por intermédio de seu representante legal, tempestiva e respeitosamente,
vem perante a essa denotada Comissão de Licitação, solicitar os seguintes esclarecimentos: Questão 1) O objeto do
presente edital é o Registro de Preços de componentes de rede (Networking) conforme especificações descritas nos Anexos
I e I-A, solução composta por Hardware, Software, serviços, instalação, treinamento, garantia e suporte técnico. É praxe no
mercado de TI, principalmente no caso de soluções, compostas de serviços complexos, a utilização de mão de obra
terceirizada para a execução de soluções deste tipo, sendo o próprio fabricante ou mesmo a utilização de empresas locais,
parceiros devidamente credenciadas pelo mesmo, o que inclusive permite uma oferta mais vantajosa para a administração
pública, para a execução de tais serviços. No entanto, ratificamos que a Contratada continua mantendo a total
responsabilidade pela execução da solução e, responderá técnica e juridicamente pelo cumprimento do contrato.
Entendemos que neste caso estaríamos atendendo ao referido no edital. Nosso entendimento está correto? Questão 2) É
previsto no instrumento convocatório que os equipamentos sejam entregues em até 60 dias contados do recebimento da
Ordem de Fornecimento e/ou documento equivalente, é nosso entendimento que para execução do escopo de serviços de
instalação, configuração e hands-on, será concedido um prazo de 15 dias a contar da entrega dos equipamentos. Está
correto nosso entendimento? Questão 3) Em análise ao Termo de Referência, é requisitado: “8. Ao TRE é reservado o direito
de efetuar conexões dos equipamentos a outros, bem como adicionar demais acessórios compatíveis tecnicamente, sem que
isso constitua motivo para a Contratada se desobrigar da garantia, desde que tal fato não implique danos materiais ou
técnicos aos equipamentos e acessórios, hipótese que deverá ser devidamente comprovada;“ Entendemos que, as conexões
que o TRE irá realizar, serão conexões lógicas de protocolos abertos, com compatibilidade total entre fabricantes. No que
tange os componentes de hardware, como transceivers, cabos e outros, será considerado a matriz de compatibilidade dos
equipamentos ofertados pelo fabricante. Está correto nosso entendimento? Questão 4) É disposto no item: “21.1. O
pagamento será efetuado mediante ordem bancária de crédito em conta corrente, em até 10 (dez) dias, após o recebimento
da Nota Fiscal respectiva...” Tendo em vista que, o objeto deste certame trata-se da entrega de equipamentos e execução
serviços, o que conota a existência de 2 marcos de recebimentos precedentes ao recebimento definitivo e afim de evitar
novos custos financeiros as licitantes, além dos que já estão previstos na execução do objeto, objetivando a entrega de uma
proposta mais competitiva por parte dos proponentes, entendemos que, o pagamento do objeto licitado ocorrerá da
seguinte forma: -Itens de Hardware – em até 10 (dez) dias após o aceite definitivo que será dado em até 05 dias corridos
do aceite provisório emitido no momento da entrega do equipamento juntamente com a Nota Fiscal. -Serviços de Instalação
e Treinamento – até 10 (dez) dias após a realização dos serviços e aceite definitivo dos mesmos que será dado em até 05
dias corridos. Está correto nosso entendimento? Questão 5) Entendemos que no quadro Anexo I-A com as especificações e
quantitativos que serão adquiridos para o lote 1 – itens 18 e 19 serão de fato para 4 profissionais e não para apenas 1 como
está na descrição das características gerais dos mesmos itens. está correto nosso entendimento? Questão 6) De acordo com
as exigências contidas no edital na página 3, requisito [...3. DOS PRAZOS DE ENTREGA E DA GARANTIA...], subitens 3.5 e
3.6 que tratam da garantia do fabricante, atendimento e prazo de reparo para os equipamentos. Grifo nosso: ...[ 3.5.
Quanto aos itens 5, 8, 9, 10, 11, 24, 26 e 27, o equipamento ofertado deverá possuir garantia do fabricante na modalidade
on-site pelo período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e atendimento. O prazo máximo
para atendimento do chamado deve ser de até o próximo dia útil após a sua abertura. Durante o período da garantia o
prazo máximo para o reparo de equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete)
dias úteis.]... ...[ 3.6. Quanto aos itens 6, 7, 12, 13, 14, 15, 28 e 29, O equipamento ofertado deverá possuir garantia do
fabricante do equipamento na modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão
de obra e atendimento no local. O período da garantia o prazo máximo para o reparo de equipamentos defeituosos a
condição normal de funcionamento deverá ser de até 07 (sete) dias úteis.]... Entendemos que ofertando equipamentos com
garantia do fabricante na modalidade de Envio no Próximo Dia Útil (Next Business Day Shipment) que é mais abrangente
que as exigências dos itens 3.5 e 3.6 do edital, por já contemplar a remessa de equipamentos, peças e partes para troca ou
reposição dos respetivos itens defeituosos no prazo máximo de próximo dia útil, bem como, atendendo ainda ao requisito de
prazo máximo para o reparo de equipamentos defeituosos a condição normal de funcionamento em até 07 (sete) dias úteis,
que estaremos atendendo as exigências contidas no edital. Está correto nosso entendimento ? Questão 7) De acordo com as
exigências contidas no edital, no “Anexo I”, páginas 31 e 32, requisito [...3.1 Descrição do Objeto...], subitem 8, que trata
das configurações e especificações mínimas, informando ainda que serão aceitos equipamentos/softwares com
características superiores, desde que compatíveis com as exigidas. Grifo nosso: ...[ 8. As configurações e especificações
aqui apresentadas são mínimas, sendo aceitos equipamentos/softwares com características superiores, desde que
compatíveis com as exigidas;]... Assim diante do extenso e complexo descritivo das exigências técnicas mínimas dos itens
de equipamentos e softwares do edital, corroborando ainda com o “Anexo I”, páginas 31 e 32, requisito [...3.1 Descrição do
Objeto...], subitem 8. Solicitamos que seja informado qual o procedimento que deverá ser adotado para a comprovação de
todos os itens e subitens exigidos nas características técnicas mínimas ? No Aguardo do pronunciamento desta douta
comissão. Barueri/SP, 04 de setembro de 2019

Fechar
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Resposta 05/09/2019 16:56:01
 
Sr. Pregoeiro, Em atenção ao Despacho PREG 0590022, informo quanto à: Questão 1) Resposta: É possível a utilização de
mão de obra terceirizada para a execução de soluções deste tipo ciente o contratado da necessidade de apresentação de
compravação de mão de obra qualificada, ciente de que qualquer dano ou anulação de garantia por parte do fabricante
incidirá na responsabilização do contratado. Questão 2) Resposta: Para os itens que preveem instalação, deve o licitante
estar ciente de que o pagamento só ocorrerá após o fornecimento, instalação e aferição técnica de
funcionamento/funcionalidade. Para os demais há de se observar as regras gerais para o Recimento do Objeto parte
integrante do Termo de Referência. No caso de inadimplemento de obrigação fica o licitante/contratado sujeito às
penalidade previstas. Questão 3) Resposta: Correto o entendimento. Questão 4) Resposta: Não é quesito técnico de TI.
Questão 5) Resposta: A leitura deve ser conjunta, ou seja, os vouchers são individuais, mas o total dos vouchers são 04
(quatro) por item. Questão 6) Resposta: Correto o entendimento, salientando-se a necessidade de observar os períodos
mínimos de cobertura 60 (sessenta) ou 12 (doze) meses, conforme o caso. Questão 7) Resposta: A comprovação se dará
pela verificação de part numbers, ficha técnica, catálogo, url do fabricante, conforme apresente o licitante em sua proposta,
ou seja, é dever do licitante comprovar o alegado em sua proposta para que possa a Administração aferir.

Fechar
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 05 de setembro de 2019.

Senhora Chefe da Seção de Licitações e Contratos,

Comunica-se que houve publicação referente ao Pregão 39/2019 no sistema
ComprasNet, solicitando-se que haja a publicidade ordinariamente promovida em casos
tais:

"Esclarecimento 05/09/2019 16:56:01

O Pregoeiro recebeu o seguinte Pedido de Esclarecimento: “OBJETO: Registro de
Preços de componentes de rede (Networking), conforme especificações descritas nos
Anexos I e I-A deste edital. A Ingram Micro Brasil Ltda., sediada Av. Piracema, 1.341,
Galpões 3 e 4, parte - Cep 06460- 030 – Bairro: Tamboré – Barueri – SP, CNPJ:
01.771.935/0008-00, pessoa jurídica de direito privado, devidamente qualificada a
participar do procedimento licitatório acima referenciado, por intermédio de seu
representante legal, tempestiva e respeitosamente, vem perante a essa denotada
Comissão de Licitação, solicitar os seguintes esclarecimentos: Questão 1) O objeto do
presente edital é o Registro de Preços de componentes de rede (Networking) conforme
especificações descritas nos Anexos I e I-A, solução composta por Hardware,
Software, serviços, instalação, treinamento, garantia e suporte técnico. É praxe no
mercado de TI, principalmente no caso de soluções, compostas de serviços
complexos, a utilização de mão de obra terceirizada para a execução de soluções deste
tipo, sendo o próprio fabricante ou mesmo a utilização de empresas locais, parceiros
devidamente credenciadas pelo mesmo, o que inclusive permite uma oferta mais
vantajosa para a administração pública, para a execução de tais serviços. No entanto,
ratificamos que a Contratada continua mantendo a total responsabilidade pela
execução da solução e, responderá técnica e juridicamente pelo cumprimento do
contrato. Entendemos que neste caso estaríamos atendendo ao referido no edital.
Nosso entendimento está correto? Questão 2) É previsto no instrumento convocatório
que os equipamentos sejam entregues em até 60 dias contados do recebimento da
Ordem de Fornecimento e/ou documento equivalente, é nosso entendimento que para
execução do escopo de serviços de instalação, configuração e hands-on, será
concedido um prazo de 15 dias a contar da entrega dos equipamentos. Está correto
nosso entendimento? Questão 3) Em análise ao Termo de Referência, é requisitado: “8.
Ao TRE é reservado o direito de efetuar conexões dos equipamentos a outros, bem
como adicionar demais acessórios compatíveis tecnicamente, sem que isso constitua
motivo para a Contratada se desobrigar da garantia, desde que tal fato não implique
danos materiais ou técnicos aos equipamentos e acessórios, hipótese que deverá ser
devidamente comprovada;“ Entendemos que, as conexões que o TRE irá realizar, serão
conexões lógicas de protocolos abertos, com compatibilidade total entre fabricantes.
No que tange os componentes de hardware, como transceivers, cabos e outros, será
considerado a matriz de compatibilidade dos equipamentos ofertados pelo fabricante.
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considerado a matriz de compatibilidade dos equipamentos ofertados pelo fabricante.
Está correto nosso entendimento? Questão 4) É disposto no item: “21.1. O pagamento
será efetuado mediante ordem bancária de crédito em conta corrente, em até 10 (dez)
dias, após o recebimento da Nota Fiscal respectiva...” Tendo em vista que, o objeto
deste certame trata-se da entrega de equipamentos e execução serviços, o que conota
a existência de 2 marcos de recebimentos precedentes ao recebimento definitivo e afim
de evitar novos custos financeiros as licitantes, além dos que já estão previstos na
execução do objeto, objetivando a entrega de uma proposta mais competitiva por parte
dos proponentes, entendemos que, o pagamento do objeto licitado ocorrerá da
seguinte forma: -Itens de Hardware – em até 10 (dez) dias após o aceite definitivo que
será dado em até 05 dias corridos do aceite provisório emitido no momento da entrega
do equipamento juntamente com a Nota Fiscal. -Serviços de Instalação e Treinamento –
até 10 (dez) dias após a realização dos serviços e aceite definitivo dos mesmos que
será dado em até 05 dias corridos. Está correto nosso entendimento? Questão 5)
Entendemos que no quadro Anexo I-A com as especificações e quantitativos que serão
adquiridos para o lote 1 – itens 18 e 19 serão de fato para 4 profissionais e não para
apenas 1 como está na descrição das características gerais dos mesmos itens. está
correto nosso entendimento? Questão 6) De acordo com as exigências contidas no
edital na página 3, requisito [...3. DOS PRAZOS DE ENTREGA E DA GARANTIA...],
subitens 3.5 e 3.6 que tratam da garantia do fabricante, atendimento e prazo de reparo
para os equipamentos. Grifo nosso: ...[ 3.5. Quanto aos itens 5, 8, 9, 10, 11, 24, 26 e
27, o equipamento ofertado deverá possuir garantia do fabricante na modalidade on-
site pelo período mínimo de 60 (sessenta) meses para reposição de peças, mão de
obra e atendimento. O prazo máximo para atendimento do chamado deve ser de até o
próximo dia útil após a sua abertura. Durante o período da garantia o prazo máximo
para o reparo de equipamentos defeituosos a condição normal de funcionamento
deverá ser de até 07 (sete) dias úteis.]... ...[ 3.6. Quanto aos itens 6, 7, 12, 13, 14, 15,
28 e 29, O equipamento ofertado deverá possuir garantia do fabricante do
equipamento na modalidade on-site pelo período mínimo de 12 (doze) meses para
reposição de peças, mão de obra e atendimento no local. O período da garantia o prazo
máximo para o reparo de equipamentos defeituosos a condição normal de
funcionamento deverá ser de até 07 (sete) dias úteis.]... Entendemos que ofertando
equipamentos com garantia do fabricante na modalidade de Envio no Próximo Dia Útil
(Next Business Day Shipment) que é mais abrangente que as exigências dos itens 3.5 e
3.6 do edital, por já contemplar a remessa de equipamentos, peças e partes para troca
ou reposição dos respetivos itens defeituosos no prazo máximo de próximo dia útil,
bem como, atendendo ainda ao requisito de prazo máximo para o reparo de
equipamentos defeituosos a condição normal de funcionamento em até 07 (sete) dias
úteis, que estaremos atendendo as exigências contidas no edital. Está correto nosso
entendimento ? Questão 7) De acordo com as exigências contidas no edital, no “Anexo
I”, páginas 31 e 32, requisito [...3.1 Descrição do Objeto...], subitem 8, que trata das
configurações e especificações mínimas, informando ainda que serão aceitos
equipamentos/softwares com características superiores, desde que compatíveis com
as exigidas. Grifo nosso: ...[ 8. As configurações e especificações aqui apresentadas
são mínimas, sendo aceitos equipamentos/softwares com características superiores,
desde que compatíveis com as exigidas;]... Assim diante do extenso e complexo
descritivo das exigências técnicas mínimas dos itens de equipamentos e softwares do
edital, corroborando ainda com o “Anexo I”, páginas 31 e 32, requisito [...3.1 Descrição
do Objeto...], subitem 8. Solicitamos que seja informado qual o procedimento que
deverá ser adotado para a comprovação de todos os itens e subitens exigidos nas
características técnicas mínimas ? No Aguardo do pronunciamento desta douta
comissão. Barueri/SP, 04 de setembro de 2019".
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"Resposta 05/09/2019 16:56:01

Instada a manifestar-se, a Unidade Requisitante registrou: “Sr. Pregoeiro, Em atenção
ao Despacho PREG 0590022, informo quanto à: Questão 1) Resposta: É possível a
utilização de mão de obra terceirizada para a execução de soluções deste tipo ciente o
contratado da necessidade de apresentação de compravação de mão de obra
qualificada, ciente de que qualquer dano ou anulação de garantia por parte do
fabricante incidirá na responsabilização do contratado. Questão 2) Resposta: Para os
itens que preveem instalação, deve o licitante estar ciente de que o pagamento só
ocorrerá após o fornecimento, instalação e aferição técnica de
funcionamento/funcionalidade. Para os demais há de se observar as regras gerais para
o Recimento do Objeto parte integrante do Termo de Referência. No caso de
inadimplemento de obrigação fica o licitante/contratado sujeito às penalidade previstas.
Questão 3) Resposta: Correto o entendimento. Questão 4) Resposta: Não é quesito
técnico de TI. Questão 5) Resposta: A leitura deve ser conjunta, ou seja, os vouchers
são individuais, mas o total dos vouchers são 04 (quatro) por item. Questão 6)
Resposta: Correto o entendimento, salientando-se a necessidade de observar os
períodos mínimos de cobertura 60 (sessenta) ou 12 (doze) meses, conforme o caso.
Questão 7) Resposta: A comprovação se dará pela verificação de part numbers, ficha
técnica, catálogo, url do fabricante, conforme apresente o licitante em sua proposta, ou
seja, é dever do licitante comprovar o alegado em sua proposta para que possa a
Administração aferir."

 

Respeitosamente.

 

João Hermínio de Barros Neto

Pregoeiro

82-2122-7706

Documento assinado eletronicamente por JOÃO HERMÍNIO DE BARROS NETO,
Pregoeiro, em 05/09/2019, às 17:03, conforme art. 1º, III, "b", da Lei 11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0590693 e o código CRC C57CEDD6.

0008478-63.2018.6.02.8000 0590693v1
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TRIBUNAL REGIONAL ELEITORAL DE ALAGOAS
Avenida Aristeu de Andrade nº 377 - Bairro Farol - CEP 57051-090 - Maceió - AL

 

DESPACHO

Maceió, 06 de setembro de 2019.
À PREG,
após publicação no portal.
Atenciosamente,

Documento assinado eletronicamente por INGRID PEREIRA DE LIMA ARAÚJO,
Técnico Judiciário, em 06/09/2019, às 09:43, conforme art. 1º, III, "b", da Lei
11.419/2006.

A autenticidade do documento pode ser conferida no site http://sei.tre-
al.jus.br/sei/controlador_externo.php?
acao=documento_conferir&id_orgao_acesso_externo=0 informando o código verificador
0591047 e o código CRC 3E91F177.

0008478-63.2018.6.02.8000 0591047v1
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PLUGNET COMÉRCIO E 

REPRESENTAÇÕES LTDA        

Insc. Estadual Nº. - 024144495 
C.N.P.J. Nº. - 02.213.325/0001-88 
www.plugnetshop.com.br 
 

 

MATRIZ – RECIFE / PE 

Rua General Abreu e Lima, Nº 222 
Rosarinho – 52.041-040  
Fone/Fax: 81 3426.7006 
plugnet@plugnetshop.com.br 

 

FILIAL – BELÉM / PA 

Av. Romulo Maiorana, nº 700 – 
Sala 1709 – Marco – Belém/PA – 

CEP: 66.093-672  
plugnetpa@plugnetshop.com.br 

 

FILIAL – JOÃO PESSOA / PB 

Av. Nossa Senhora dos 
 Navegantes, 104 / 402 Tambaú 

Fone/Fax: 83 3226.1422 
plugnetpb@plugnetshop.com.br 

 

 

 

    

 

 

 
 

Recife, 09 de Setembro de 2019. 
 
 
Ao 

Tribunal Regional Eleitoral de Alagoas 

Pregão Eletrônico Nº 039/2019 

Processo nº 0008478-63.2018.6.02.8000 
 
 

DECLARAÇÃO DE ATENDIMENTO AOS REQUISITOS DE HABILITAÇÃO 
 
 
 
A PLUGNET Comércio e Representações LTDA, inscrita no CNPJ Nº 02.213.325/0001-88, por intermédio de seu 

representante legal infra-assinado, DECLARA, para efeito do cumprimento ao estabelecido no Inciso VII do 

artigo 4º da Lei Federal n.º 10.520/2002, de 17.07.2002, e no Inciso VI do artigo 15 da Lei Estadual n.º 

12.340/2003, de 27.01.2003, sob as penalidades cabíveis, que cumpre plenamente os requisitos de habilitação 

exigidos no referido Edital. 

 
 
 
 
 
 
Atenciosamente, 
 
 
Plugnet Comércio e Representações Ltda 
Breno José de Araujo Tavares 
(81) 3426-7006 
Diretor 
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PLUGNET COMÉRCIO E 

REPRESENTAÇÕES LTDA        

Insc. Estadual Nº. - 024144495 
C.N.P.J. Nº. - 02.213.325/0001-88 
www.plugnetshop.com.br 
 

 

MATRIZ – RECIFE / PE 

Rua General Abreu e Lima, Nº 222 
Rosarinho – 52.041-040  
Fone/Fax: 81 3426.7006 
plugnet@plugnetshop.com.br 

 

FILIAL – BELÉM / PA 

Av. Romulo Maiorana, nº 700 – 
Sala 1709 – Marco – Belém/PA – 

CEP: 66.093-672  
plugnetpa@plugnetshop.com.br 

 

FILIAL – JOÃO PESSOA / PB 

Av. Nossa Senhora dos 
 Navegantes, 104 / 402 Tambaú 

Fone/Fax: 83 3226.1422 
plugnetpb@plugnetshop.com.br 

 

 

 

    

 

 

 
 

Recife, 09 de Setembro de 2019. 
 
Ao 

Tribunal Regional Eleitoral de Alagoas 

Pregão Eletrônico Nº 039/2019 

Processo nº 0008478-63.2018.6.02.8000 
 
 
 
 

DECLARAÇÃO DE INEXISTÊNCIA DE PARENTESCO 
 
 
 
A PLUGNET Comércio e Representações LTDA, inscrita no CNPJ Nº 02.213.325/0001-88, por intermédio de seu 

representante legal infra-assinado, Cientes que ao se realizar declaração falsa, incorre-se no crime de falsidade 

ideológica, previsto no artigo 299 do Código  Penal  Brasileiro,  declaramos  que  não  há  sócios,  gerentes,  

diretores  ou  responsáveis  técnicos  na  empresa Plugnet Comércio e Representações Ltda, CNPJ: 

02.213.325/0001-88, que sejam:  

 

a) membros ou servidores do Tribunal Regional Eleitoral de Alagoas, efetivos, comissionados, cedidos ou 

colocados à disposição da Tribunal Regional Eleitoral de Alagoas; 

 

b) cônjuge, companheiro ou parente em linha reta, colateral ou por afinidade, até o terceiro grau, inclusive, de 

membro ou servidor do Tribunal Regional Eleitoral de Alagoas, este último quando ocupante de cargo de 

direção, chefia e assessoramento, servidor cedido ou colocado à disposição do Tribunal Regional Eleitoral de 

Alagoas. 

 
 
Atenciosamente, 
 
 
Plugnet Comércio e Representações Ltda 
Breno José de Araujo Tavares 
CPF: 376.381.144-34 
(81) 3426-7006 
Diretor 
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PLUGNET COMÉRCIO E 

REPRESENTAÇÕES LTDA        

Insc. Estadual Nº. - 024144495 
C.N.P.J. Nº. - 02.213.325/0001-88 
www.plugnetshop.com.br 
 

 

MATRIZ – RECIFE / PE 

Rua General Abreu e Lima, Nº 222 
Rosarinho – 52.041-040  
Fone/Fax: 81 3426.7006 
plugnet@plugnetshop.com.br 

 

FILIAL – BELÉM / PA 

Av. Romulo Maiorana, nº 700 – 
Sala 1709 – Marco – Belém/PA – 

CEP: 66.093-672  
plugnetpa@plugnetshop.com.br 

 

FILIAL – JOÃO PESSOA / PB 

Av. Nossa Senhora dos 
 Navegantes, 104 / 402 Tambaú 

Fone/Fax: 83 3226.1422 
plugnetpb@plugnetshop.com.br 

 

 

 

    

 

 

 
Recife, 09 de Setembro de 2019. 

 
 
Ao 

Tribunal Regional Eleitoral de Alagoas 

Pregão Eletrônico Nº 039/2019 

Processo nº 0008478-63.2018.6.02.8000 
 
 
 

DECLARAÇÃO DE INEXISTÊNCIA DE TRABALHADOR MENOR 

 
 
 
 
 
 A Plugnet Comércio e Representações LTDA, inscrita no Ministério da Fazenda sob o CNPJ 02.213.325/0001-

88, por intermédio de seu representante legal abaixo assinado, DECLARA, para fins do disposto no inciso V do 

art.27 da Lei nº 8.666 de 21 de junho de 1993, acrescido pela Lei nº 9.854, de 27 de outubro de 1999, que, não 

emprega menor de dezoito anos em trabalho noturno, perigoso ou insalubre, não emprega menor de 

dezesseis anos e não emprega menor a partir de quatorze anos na condição de aprendiz. 

  
 
 Por ser verdade, firmamos a presente declaração para que produza seus efeitos de direito. 
 
 
 
 
 
Atenciosamente, 
 
 
Plugnet Comércio e Representações Ltda 
Breno José de Araujo Tavares 
(81) 3426-7006 
Diretor 
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PLUGNET COMÉRCIO E 

REPRESENTAÇÕES LTDA        

Insc. Estadual Nº. - 024144495 
C.N.P.J. Nº. - 02.213.325/0001-88 
www.plugnetshop.com.br 
 

 

MATRIZ – RECIFE / PE 

Rua General Abreu e Lima, Nº 222 
Rosarinho – 52.041-040  
Fone/Fax: 81 3426.7006 
plugnet@plugnetshop.com.br 

 

FILIAL – BELÉM / PA 

Av. Romulo Maiorana, nº 700 – 
Sala 1709 – Marco – Belém/PA – 

CEP: 66.093-672  
plugnetpa@plugnetshop.com.br 

 

FILIAL – JOÃO PESSOA / PB 

Av. Nossa Senhora dos 
 Navegantes, 104 / 402 Tambaú 

Fone/Fax: 83 3226.1422 
plugnetpb@plugnetshop.com.br 

 

 

 

    

 

 

 
Recife, 09 de Setembro de 2019. 

 
 
Ao 

Tribunal Regional Eleitoral de Alagoas 

Pregão Eletrônico Nº 039/2019 

Processo nº 0008478-63.2018.6.02.8000 
 
 
 

DECLARAÇÃO DE INEXISTÊNCIA DE FATOS IMPEDITIVOS 
 
 
 
 
 
 
 
 

PLUGNET COMÉRCIO E REPRESENTAÇÕES LTDA, CNPJ nº 02.213.325/0001-88, sediada na Av. 

Santos Dumont, 599 – Rosarinho - Recife-PE, CEP 52.050-050, declara, sob as penalidades da Lei, que até a 

presente data inexistem fatos impeditivos para sua habilitação no presente processo licitatório, ciente da 

obrigatoriedade de declarar ocorrência posteriores. 

 
 
 
 
 
Atenciosamente, 
 
 
Plugnet Comércio e Representações Ltda 
Breno José de Araujo Tavares 
(81) 3426-7006 
Diretor 
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PLUGNET COMÉRCIO E 

REPRESENTAÇÕES LTDA        

Insc. Estadual Nº. - 024144495 
C.N.P.J. Nº. - 02.213.325/0001-88 
www.plugnetshop.com.br 
 

 

MATRIZ – RECIFE / PE 

Rua General Abreu e Lima, Nº 222 
Rosarinho – 52.041-040  
Fone/Fax: 81 3426.7006 
plugnet@plugnetshop.com.br 

 

FILIAL – BELÉM / PA 

Av. Romulo Maiorana, nº 700 – 
Sala 1709 – Marco – Belém/PA – 

CEP: 66.093-672  
plugnetpa@plugnetshop.com.br 

 

FILIAL – JOÃO PESSOA / PB 

Av. Nossa Senhora dos 
 Navegantes, 104 / 402 Tambaú 

Fone/Fax: 83 3226.1422 
plugnetpb@plugnetshop.com.br 

 

 

 

    

 

 

 
Recife, 09 de Setembro de 2019. 

 
 
Ao 

Tribunal Regional Eleitoral de Alagoas 

Pregão Eletrônico Nº 039/2019 

Processo nº 0008478-63.2018.6.02.8000 
 
 

DECLARAÇÃO 
 
 
 
 PLUGNET COMÉRCIO E REPRESENTAÇÕES LTDA, inscrita no CNPJ Nº 02.213.325/0001-88, por intermédio de 

seu representante legal infra-assinado, DECLARA que: 

 

 

• Estão inclusos nos preços ofertados todas as despesas diretas e indiretas, inclusive os tributos, taxas, 

conforme discriminado no Anexo I – Termo de Referência, encargos sociais, trabalhistas e previdenciários, 

frete, seguro, etiquetagem, mão-de-obra, e quaisquer outros serviços de despesas, que incidam sobre a 

execução do objeto.  

 

 
Atenciosamente, 
 
 
Plugnet Comércio e Representações Ltda 
Breno José de Araujo Tavares 
(81) 3426-7006 
Diretor 
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Recife, 09 de Setembro de 2019. 
Ao 

Tribunal Regional Eleitoral de Alagoas 

Pregão Eletrônico Nº 039/2019 

Processo nº 0008478-63.2018.6.02.8000 
 

DECLARAÇÃO 
 
   PLUGNET COMÉRCIO E REPRESENTAÇÕES LTDA, inscrita no CNPJ Nº 02.213.325/0001-88, por 

intermédio de seu representante legal, Breno José de Araújo Tavares, portador da carteira de identidade nº 

1862424 SSP/RN, inscrito no Ministério da fazenda sob o nº 376.381.144-34, como representante 

devidamente constituído da e PLUGNET COMÉRCIO E REPRESENTAÇÕES LTDA doravante denominado 

PLUGNET INFORMÁTICA, declara, sob as penas da lei, em especial o art. 299 do Código Penal Brasileiro, que: 

(a) a proposta apresentada para participar da Edital Pregão Eletrônico nº 039/2019, foi elaborada de maneira 

independente PLUGNET INFORMÁTICA, e o conteúdo da proposta não foi, no todo ou em parte, direta ou 

indiretamente, informado, discutido ou recebido de qualquer outro participante potencial ou de fato da Edital 

Pregão Eletrônico nº 039/2019, por qualquer meio ou por qualquer pessoa; 

(b) a intenção de apresentar a proposta elaborada para participar do Edital Pregão Eletrônico nº 039/2019 não 

foi informada, discutida ou recebida de qualquer outro participante potencial ou de fato do Edital Pregão 

Eletrônico nº 39/2019, por qualquer meio ou por qualquer pessoa; 

(c) que não tentou, por qualquer meio ou por qualquer pessoa, influir na decisão de qualquer outro 

participante potencial ou de fato do Edital Pregão Eletrônico nº 39/2019 quanto a participar ou não da referida 

licitação; 

(d) que o conteúdo da proposta apresentada para participar do Edital Pregão Eletrônico nº 39/2019 não será, 

no todo ou em parte, direta ou indiretamente, comunicado ou discutido com qualquer outro participante 

potencial ou de fato da Edital Pregão Eletrônico nº 39/2019 antes da adjudicação do objeto da referida 

licitação; 
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(e) que o conteúdo da proposta apresentada para participar da Edital Pregão Eletrônico nº 39/2019 não foi, no 

todo ou em parte, direta ou indiretamente, informado, discutido ou recebido de qualquer integrante de Edital 

Pregão Eletrônico nº 39/2019, antes da abertura oficial das propostas; e  

(f) que está plenamente ciente do teor e da extensão desta declaração e que detém plenos poderes e 

informações para firmá-la. 

 

Atenciosamente, 

 

 

Plugnet Comércio e Representações Ltda 

Breno José de Araujo Tavares 

(81) 3426-7006 

Diretor 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Proposta EMPRESA PLUGNET (0592496)         SEI 0008478-63.2018.6.02.8000 / pg. 881



                                                       ‘                 

 
PLUGNET COMÉRCIO E 

REPRESENTAÇÕES LTDA        

Insc. Estadual Nº. - 024144495 
C.N.P.J. Nº. - 02.213.325/0001-88 
www.plugnetshop.com.br 
 

 

MATRIZ – RECIFE / PE 

Rua General Abreu e Lima, Nº 222 
Rosarinho – 52.041-040  
Fone/Fax: 81 3426.7006 
plugnet@plugnetshop.com.br 

 

FILIAL – BELÉM / PA 

Av. Romulo Maiorana, nº 700 – 
Sala 1709 – Marco – Belém/PA – 

CEP: 66.093-672  
plugnetpa@plugnetshop.com.br 

 

FILIAL – JOÃO PESSOA / PB 

Av. Nossa Senhora dos 
 Navegantes, 104 / 402 Tambaú 

Fone/Fax: 83 3226.1422 
plugnetpb@plugnetshop.com.br 

 

 

 

    

 

 

 
 

Recife, 09 de Setembro de 2019. 
 
 
Ao 

Tribunal Regional Eleitoral de Alagoas 

Pregão Eletrônico Nº 039/2019 

Processo nº 0008478-63.2018.6.02.8000 
 
 

 
 
 

Prezados Senhores, 

 

A Plugnet Comércio e Representações LTDA, inscrita no CNPJ Nº 02.213.325/0001-88, inscrição estadual nº 

18.1.001.0241444-4, estabelecida na Rua General Abreu e Lima, 222 - Rosarinho, Recife/PE, está honrada em 

responder sua solicitação. Estamos encaminhando para apreciação nossa Proposta. 

 

Concordamos e atendemos a todos os requisitos solicitados no Pregão Eletrônico N.º 39/2019, para o 

FORNECIMENTO de equipamentos de informática, conforme proposta apresentada e nos colocamos à 

disposição para quaisquer esclarecimentos que se fizerem necessários. 

 

 
 
Atenciosamente, 
 
 
Plugnet Comércio e Representações Ltda 
Breno José de Araujo Tavares 
(81) 3426-7006 
Diretor 
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Recife, 09 de Setembro de 2019. 
 
 

Ao 

Tribunal Regional Eleitoral de Alagoas 

Pregão Eletrônico Nº 039/2019 

Processo nº 0008478-63.2018.6.02.8000 
  

PROPOSTA COMERCIAL  
 

Lote 1 
   

Item Qtd Descrição Valor Unitário Valor Total 

1 1 
SOLUÇÃO DE ANÁLISE DE PERFIL E 
CONTROLE DE ACESSO PARA REDE CABEADA R$ 101.500,00 R$ 101.500,00 

2 3 
LICENCIAMENTO ADICIONAL PARA
 SISTEMA DE GERENCIAMENTO 
HPE IMC R$ 15.802,00 R$ 47.406,00 

3 2 
LICENCIAMENTO ADICIONAL DO MÓDULO DE 
ANÁLISE DE TRAFEGO DO SISTEMA DE 
GERENCIAMENTO HPE IMC R$ 11.900,00 R$ 23.800,00 

4 2 
LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE 
ANÁLISE DE PERFIL E CONTROLE DE ACESSO R$ 50.750,00 R$ 101.500,00 

5 6 
SWITCH DE DISTRIBUIÇÃO COM 16 PORTAS 
SFP+ E SUPORTE A MÓDULOS DE EXPANSÃO R$ 48.175,00 R$ 289.050,00 

6 16 
MÓDULO COM 4 PORTAS SFP+ PARA SWITCH 
DE DISTRIBUIÇÃO R$ 4.405,00 R$ 70.480,00 

7 6 
MÓDULO DE STACKING COM 4 PORTAS PARA 
SWITCH DE DISTRIBUIÇÃO R$ 4.235,00 R$ 25.410,00 

8 50 
SWITCH DE ACESSO L3 COM 48 PORTAS 
GIGABIT E 4SFP+ R$ 14.300,00 R$ 715.000,00 

9 40 
SWITCH DE ACESSO L3 COM 24 PORTAS 
GIGABIT E 4SFP+ R$ 11.980,00 R$ 479.200,00 

10 50 
SWITCH DE ACESSO L2 COM 24 PORTAS 
GIGABIT E 4SFP R$ 3.707,00 R$ 185.350,00 

11 40 
SWITCH DE ACESSO L2 COM 48 PORTAS 
GIGABIT E 4SFP R$ 6.470,00 R$ 258.800,00 

12 50 GBIC 10GB PARA ATÉ 300M R$ 2.000,00 R$ 100.000,00 

13 30 CABO DAC 10 GBPS DE 1M R$ 360,00 R$ 10.800,00 

14 30 CABO DAC 10 GBPS DE 3M R$ 500,00 R$ 15.000,00 

15 10 GBIC 1GB PARA ATÉ 500M R$ 665,00 R$ 6.650,00 

16 5 
SERVIÇOS DE IMPLANTAÇÃO E 
TRANSFERÊNCIA DE TECNOLOGIA PARA 
SWITCHS DE REDE R$ 12.600,00 R$ 63.000,00 

17 1 
SERVIÇOS DE IMPLANTAÇÃO E 
TRANSFERÊNCIA DE TECNOLOGIA DO 
MÓDULO DE CONTROLE DE ACESSO R$ 22.800,00 R$ 22.800,00 

18 4 
TREINAMENTO BÁSICO DE ADMINISTRAÇÃO 
DE SWITCHES R$ 9.000,00 R$ 36.000,00 

19 4 
TREINAMENTO BÁSICO DA SOLUÇÃO DE 
CONTROLE DE ACESSO R$ 16.200,00 R$ 64.800,00 

VALOR GLOBAL LOTE 1 
R$ 

2.616.546,00 
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Lote 2 

Item Qtd Descrição 
Valor Unitário 
R$ 

Valor Total R$ 

20 1 
SOLUÇÃO DE ANÁLISE DE PERFIL E 
CONTROLE DE ACESSO PARA REDE 
WIRELESS R$ 101.500,00 

R$ 101.500,00 

21 1 
SOLUÇÃO DE GERENCIAMENTO DE REDE 
WIRELESS R$ 570,00 

R$ 570,00 

22 200 
LICENÇAS ADICIONAIS PARA SOLUÇÃO DE 
GERENCIAMENTO DE REDE WIRELESS R$ 451,00 

R$ 90.200,00 

23 2 
LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE 
ANÁLISE DE PERFIL E CONTROLE DE ACESSO R$ 50.750,00 

R$ 101.500,00 

24 4 CONTROLADORA WLAN R$ 69.900,00 R$ 279.600,00 

25 200 
LICENÇAS ADICIONAIS PARA CONTROLADORA 
WLAN R$ 880,00 

R$ 176.000,00 

26 100 PONTO DE ACESSO INTERNO TIPO 01 R$ 1.800,00 R$ 180.000,00 

27 100 PONTO DE ACESSO INTERNO TIPO 02 R$ 2.300,00 R$ 230.000,00 

28 100 
INJETOR POE PARA PONTOS DE ACESSO TIPO 
1 R$ 428,00 

R$ 42.800,00 

29 100 
INJETOR POE PARA PONTOS DE ACESSO TIPO 
2 R$ 526,00 

R$ 52.600,00 

30 1 
SERVIÇOS DE IMPLANTAÇÃO E 
TRANSFERÊNCIA DE TECNOLOGIA PARA 
SOLUÇÃO DE GERENCIAMENTO R$ 18.000,00 

R$ 18.000,00 

31 1 
SERVIÇOS DE IMPLANTAÇÃO E 
TRANSFERÊNCIA DE TECNOLOGIA DO 
MÓDULO DE CONTROLE DE ACESSO R$ 22.800,00 

R$ 22.800,00 

32 5 
SERVIÇOS DE IMPLANTAÇÃO E 
TRANSFERÊNCIA DE TECNOLOGIA PARA 
PONTOS DE ACESSO R$ 12.600,00 

R$ 63.000,00 

33 4 
TREINAMENTO BÁSICO DE ADMINISTRAÇÃO 
DE ARQUITETURA WLAN R$ 9.000,00 

R$ 36.000,00 

34 4 
TREINAMENTO BÁSICO DA SOLUÇÃO DE 
GERENCIAMENTO R$ 9.000,00 

R$ 36.000,00 

35 4 
TREINAMENTO BÁSICO DA SOLUÇÃO DE 
CONTROLE DE ACESSO R$ 16.200,00 

R$ 64.800,00 

VALOR GLOBAL LOTE 2 
R$ 

1.495.370,00 
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LOTE 01 – SOLUÇÃO DE REDE CABEADA 
 
 
ITEM 01 – SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO LICENCIAMENTO 
 
1. Licenciamento da SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO, contemplando o 
quantitativo mínimo de 1.000 (um mil) dispositivos, usuários corporativos ou visitantes simultâneos, 
independente do perfil de autenticação, seja por dispositivo ou usuário; 
2. Caso a solução ofertada necessite de licenciamento específico para credenciamento dos 
dispositivos, usuários (corporativos ou visitantes), deverá ser fornecido o quantitativo solicitado 
para ambos, de forma que a solução realize a análise de perfil e o controle de acesso dos 1.000 (um 
mil) dispositivos ou usuários (corporativos ou visitantes) simultâneos. 
 
 
MÓDULO DE ANÁLISE DE PERFIL DE DISPOSITIVO 
Características Gerais Modulo de Análise de Perfil de Dispositivo 
 
3. Deve implementar funcionalidade de classificação automática criando perfis de dispositivos, de 
forma a descobrir, classificar e agrupar os dispositivos conectados na rede; 
4. Deve categorizar os dispositivos em pelo menos 3 níveis: 
 
a. Por tipo de dispositivo (ex. Computador, Smartdevice, impressora, etc.); 
b. Por sistema operacional (ex. Windows, Linux, MacOS, etc.); 
c. Versão do sistema operacional (ex. Windows 7, Windows 2008 Server, etc.); 
 
5. Deve ser capaz de gerar gráficos das categorias, separando os dispositivos conforme suas 
características; 
6. Deve suportar a coleta de informações, para classificação, usando no mínimo: 
 
a. DHCP; 
  
 
b. HTTP User-Agent; 
c. MAC OUI; 
d. ActiveSync plugin; 
e. SNMP; 
f. Subnet Scanner; 
g. IF-MAP; 
h. Cisco Device Sensor; 
i. MDM; 
j. TCP Fingerprinting. 
 
7. Deve possuir dicionário de categorias de dispositivos pré-configurado e mecanismo de 
atualização do mesmo; 
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8. Deve suportar a integração com, no mínimo, as seguintes soluções de MDM de mercado 
AirWatch, MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, MaaS 360 devendo comprovar a 
compatibilidade em documentação oficial do fabricante; 
9. Deve permitir priorização na ordem de criação dos perfis com no mínimo as seguintes 
características: 
 
a. Agente proprietário; 
b. HTTP User-Agent; 
c. SNMP; 
d. DHCP; 
e. MAC OUI. 
 
10. A solução de análise de perfil de usuários deverá permitir consultas a sua base, pela solução de 
controle de acesso para validação de dispositivos com base no seu perfil. 
 
 
MÓDULO DE CONTROLE DE ACESSO DE DISPOSITIVOS E USUÁRIOS 
Características Gerais 
 
11. A Solução deverá dar suporte a no mínimo as seguintes bases de dados: 
 
a. Microsoft Active Directory; 
b. Kerberos; 
c. Diretórios LDAP; 
d. OpenLDAP; 
e. PostgreSQL; 
f. Oracle 11g; 
g. MariaDB; 
h. MSSQL; 
i. Servidores de Token; 
j. Base de dados SQL interna; 
k. Lista interna estática de hosts. 
 
12. Deve suportar "Single Sign-on" (SSO) através de SAML v2.0; 
13. Deve implementar gerenciamento e aplicação de políticas de autorização de acesso de 
usuários com base em: 
  
 
a. Atributos do usuário autenticado; 
b. Hora do dia, dia da semana; 
c. Tipo de dispositivo utilizado; 
d. Localização do usuário; 
e. Tipo de autenticação utilizada. 
 
14. Deve permitir a visualização de todas informações relativas a cada transação e autenticação 
em uma única tela, a solução deverá trazer no mínimo as seguintes informações: 
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a. Data e Hora; 
b. Mac Address do dispositivo; 
c. Classificação do dispositivo; 
d. Usuário; 
e. Equipamento que requisitou a autenticação (origem); 
f. Método de autenticação utilizado; 
g. Fonte de autenticação utilizada para validação; 
h. Perfil de acesso aplicado; 
i. Atributos de entrada do protocolo utilizados na requisição (ex. RADIUS); 
j. Informações de resposta da solução para o elemento de rede; 
k. Alertas em caso de falha; 
l. LOGS já filtrados para a requisição em análise. 
 
15. Deve possuir Dashboard customizável, onde deve permitir a visualização de no mínimo as 
seguintes informações: 
 
a. 
a. Lista com últimos Alertas do sistema; 
b. Gráfico com todas as requisições de autenticação dos últimos 7 dias, incluindo RADIUS, 
TACACS+ e Autenticações Web; 
c. Gráfico com o status das autenticações aceitas e rejeitadas nos últimos 7 dias; 
d. Gráfico com a categorização dos dispositivos classificados pela solução, divididos de acordo 
com as categorias de classificação; 
e. Últimas falhas de autenticação; 
f. Gráfico com as requisições de avaliação de postura dos dispositivos, divididos em: 
 
• 
I. Saudáveis (dentro das políticas estabelecidas); 
II. Não saudáveis (que estão fora das políticas estabelecidas); 
 
a. 
a. Lista com as últimas autenticações; 
b. Lista com as últimas autenticações com sucesso; 
c. Utilização de CPU do sistema, no mínimo nos últimos 30 minutos; 
 
16. Deve possuir base de regras e categorias de dispositivos pré-configurada e mecanismo de 
atualização da mesma; 
17. Deve suportar a integração com no mínimo as seguintes soluções de MDM de mercado 
AirWatch, MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, MaaS 360 devendo comprovar a 
compatibilidade em documentação oficial do fabricante; 
  
 
18. Deve suportar autenticações via OAuth2, Facebook, Twitter, LinkdIn, Office365 e Google Apps; 
19. Deve possuir recursos integrados de AAA: RADIUS, TACACS+ e Kerberos; 
20. Deve possuir suporte aos seguintes recursos: 
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a. RADIUS; 
b. RADIUS CoA; 
c. TACACS+; 
d. Web authentication; 
e. SAML v2.0; 
f. EAP-FAST (EAP-MSCHAPv2, EAP-GTC, EAP-TLS); 
g. PEAP (EAP-MSCHAPv2, EAP-GTC, EAP-TLS, EAP-PEAP-Public); 
h. TTLS (EAP-MSCHAPv2, EAP-GTC, EAP- TLS, EAP-MD5, PAP, CHAP); 
i. EAP-TLS; 
j. PAP, CHAP, MSCHAPv1, MSCHAPv2 e EAP-MD5; 
k. Windows machine authentication; 
l. MAC address authentication (dispositivos sem suporte a 802.1X); 
 
21. Deve suportar verificação de vulnerabilidade através de varredura de portas; 
22. Deve suportar à aplicação de políticas em ambiente com múltiplos fornecedores de Wireless, 
cabeado e VPN; 
23. Deve possuir CA integrada, para geração de certificados para os dispositivos que forem se 
autenticar na rede; 
24. Deve suportar à integração com plataforma de terceiros usando HTTP/RESTful API; 
25. Deve permitir que a solução faça consultas em bases SQL, com o objetivo de buscar 
informação a serem utilizadas durante o processo de autenticação dos usuários; 
26. Deve possuir suporte a administração através de IPv6; 
27. Deve possuir ferramenta para gerenciar os processos de credenciamento, autenticação, 
autorização e contabilização de usuários visitantes através de portal web seguro; 
28. Deve implementar a criação de grupos de autorizadores com privilégios distintos de criação de 
credenciais temporárias e atribuição de permissões de acesso aos clientes; 
29. Deve permitir realizar a autenticação dos autorizadores em base externa do tipo Microsoft 
Active Directory ou LDAP e atribuir o privilégio ao autorizador de acordo com o seu perfil; 
30. Deve implementar as funcionalidades de geração de lotes de credenciais aleatórias, 
temporárias, pré-autorizadas; 
31. Deve implementar a importação e exportação da relação de credenciais temporárias através 
de arquivos txt ou csv; 
32. Deve permitir a configuração do tempo de validade das credenciais, baseando-se na criação da 
conta ou no primeiro login da conta; 
33. Deve permitir que o visitante crie sua própria credencial temporária (autosserviço) através de 
portal web, com ou sem a necessidade de um autorizador; 
34. Deve permitir a customização do formulário de criação de credenciais, a ser preenchido pelo 
autorizador ou pelo visitante em caso de autosserviço, especificando quais informações cadastrais 
dos visitantes são obrigatórias ou opcionais; 
35. Deve permitir a customização do nível de segurança da senha temporária que será gerada ao 
visitante, especificando a quantidade mínima de caracteres e o uso de caracteres especiais e 
números para compor a senha; 
36. Deve exigir que o usuário visitante aceite o “Termo de uso da rede” a cada login ou apenas no 
primeiro login; 
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37. Deve permitir o envio das credenciais aos usuários registrados através de mensagens SMS 
(Short Message Service), e-mail ou impressão local. 
  
 
 
GARANTIA E SUPORTE 
 
38. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas; 
39. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá informar 
em sua proposta o código de serviço de garantia do fabricante (“part number”), incorporada à 
solução; 
40. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte técnico 
online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de área para 
cadastro da solução de software ofertada, possibilitando assim que a CONTRATANTE possa receber 
de forma proativa, durante todo período da garantia as notificações de atualizações e correções 
(“hotfix”) da solução; 
41. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 0800 
para suporte técnico e abertura de chamados técnicos. 
42. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou centro 
de distribuição para fins de comprovação que por ventura conflitem com catálogos, manuais, 
folders oficiais impressos ou da internet (devendo constar o endereço URL para folders da web). 
Caso não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos softwares, indicando o 
período de garantia dos produtos ofertados. Em caso de documentação expressa do fabricante 
deverá ser anexada a mesma a procuração que comprove que a fabricante outorga ao procurador 
os poderes para firmar e declarar as exigências solicitadas. 
 
 
ITEM 02 – LICENCIAMENTO ADICIONAL PARA SISTEMA DE GERENCIAMENTO HPE IMC 
Características técnicas mínimas 
 
1. Licenciamento para expansão do SISTEMA DE GERENCIAMENTO HPE IMC existente na 
infraestrutura da contratante, contemplando o quantitativo adicional mínimo de 50 (cinquenta) 
dispositivos simultâneos; 
 
 
GARANTIA E SUPORTE 
 
1. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 
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2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá informar 
em sua proposta o código de serviço de garantia do fabricante (“part number”), incorporada à 
solução. 
3. O fabricante deve possuir canais de comunicação e ferramentas adicionais  para  suporte  
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de 
  
 
área para cadastro da solução de software ofertada, possibilitando assim que a CONTRATANTE 
possa receber de forma proativa, durante todo período da garantia as notificações de atualizações e 
correções (“hotfix”) da solução; 
4. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 
5. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou centro 
de distribuição para fins de comprovação que por ventura conflitem com catálogos, manuais, 
folders oficiais impressos ou da internet (devendo constar o endereço URL para folders da web). 
Caso não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos softwares, indicando o 
período de garantia dos produtos ofertados. Em caso de documentação expressa do fabricante 
deverá ser anexada a mesma a procuração que comprove que a fabricante outorga ao procurador 
os poderes para firmar e declarar as exigências solicitadas. 
 
 
ITEM 03 – LICENCIAMENTO ADICIONAL DO MÓDULO DE ANÁLISE DE TRAFEGO DO SISTEMA DE 
GERENCIAMENTO HPE IMC 
Características técnicas mínimas 
 
1. Licenciamento para expansão do MÓDULO DE ANÁLISE DE TRAFEGO DO SISTEMA DE 
GERENCIAMENTO HPE IMC existente na infraestrutura da contratante, contemplando o 
quantitativo adicional mínimo de 5 (cinco) dispositivos simultâneos; 
 
 
GARANTIA E SUPORTE 
 
1. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 
2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá informar 
em sua proposta o código de serviço de garantia do fabricante (“part number”), incorporada à 
solução. 
3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de área 
para cadastro da solução de software ofertada, possibilitando assim que a CONTRATANTE possa 
receber de forma proativa, durante todo período da garantia as notificações de atualizações e 
correções (“hotfix”) da solução; 
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4. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 
5. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou centro 
de distribuição para fins de comprovação que por ventura conflitem com catálogos, manuais, 
folders oficiais impressos ou da internet (devendo constar o endereço URL para folders da web). 
Caso não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
através da apresentação de documentação expressa do fabricante dos softwares, indicando o 
período de garantia dos produtos ofertados. Em caso de 
  
 
documentação expressa do fabricante deverá ser anexada a mesma a procuração que comprove 
que a fabricante outorga ao procurador os poderes para firmar e declarar as exigências solicitadas. 
 
 
ITEM 04 – LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE 
ACESSO 
Características técnicas mínimas 
 
2. Licenciamento para expansão da SOLUÇÃO DE ANALISE DE PERFIL E CONTROLE DE ACESSO, 
contemplando o quantitativo mínimo adicional de 500 (quinhentos) dispositivos, usuários 
corporativos ou visitantes simultâneos, independente do perfil de autenticação, seja por dispositivo 
ou usuário; 
 
 
GARANTIA E SUPORTE 
 
1. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo de 
36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 
modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta 
máximo em 4 (quatro) horas. 
2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá informar 
em sua proposta o código de serviço de garantia do fabricante (“part number”), incorporada à 
solução. 
3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de área 
para cadastro da solução de software ofertada, possibilitando assim que a CONTRATANTE possa 
receber de forma proativa, durante todo período da garantia as notificações de atualizações e 
correções (“hotfix”) da solução; 
4. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 
0800 para suporte técnico e abertura de chamados técnicos. 
5. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 
fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou centro 
de distribuição para fins de comprovação que por ventura conflitem com catálogos, manuais, 
folders oficiais impressos ou da internet (devendo constar o endereço URL para folders da web). 
Caso não seja comprovada por um dos meios citados anteriormente, será possível a comprovação 
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através da apresentação de documentação expressa do fabricante dos softwares, indicando o 
período de garantia dos produtos ofertados. Em caso de documentação expressa do fabricante 
deverá ser anexada a mesma a procuração que comprove que a fabricante outorga ao procurador 
os poderes para firmar e declarar as exigências solicitadas. 
 
 
ITEM 05 – SWITCH DE DISTRIBUIÇÃO COM 16 PORTAS SFP+ E SUPORTE A MÓDULOS DE EXPANSÃO 
 
Características técnicas mínimas 
  
 
1. Deve possuir no mínimo 16 portas 10 Gigabit Ethernet, 1000/10000 SFP+ fixas ao equipamento 
2. Deve suportar, através de módulos, o mínimo de 8 portas adicionais de 10 Gigabit Ethernet 
SFP+ ou 2 portas de 40 Gigabit Ethernet QSFP+; 
3. Deve suportar transceivers de 10GbE SFP+ e de 40GbE QSFP+ através da adição ou substituição 
de módulos. 
4. Deve possuir, no mínimo, 2 módulos de expansão podendo ser utilizados para uplinks ou 
dados de usuários; 
5. Deve possuir, no mínimo, 2 módulos de fonte internas ao equipamento operando em modo 
redundante; 
6. Deve possuir porta dedicada de gerenciamento; 
7. Deve possuir 1 interface RJ-45 ou serial para acesso console local; 
8. Deve possuir latência de, no máximo, 2,8 μs a 1Gbps; 
9. Deve possuir memória SDRAM de no mínimo 2 Gbytes; 
10. Deve possuir buffer de pacotes de no mínimo 13.5 Mbytes; 
11. Deve possuir capacidade de encaminhamento de no mínimo 285 Mpps; 
12. Deve possuir capacidade de comutação de no mínimo 480 Gbps; 
13. Deve possuir Certificado de Homologação na Anatel, de acordo com a Resolução nº 242; 
14. Deve possuir fonte de alimentação interna 110/220VAC; Disponibilidade 
15. Deve possuir capacidade de, no mínimo, 10 (dez) equipamentos membros da mesma pilha; 
16. Deve possuir fonte de alimentação interna redundante com características idênticas a fonte 
principal; 
17. Deve suportar empilhamento com banda agregada mínima de 320 Gbps sem uso de portas de 
dados de usuário para este fim. 
 
Switching 
 
18. Deve implementar VLANs baseadas em MAC; 
19. Deve suportar no mínimo 4094 VLAN IDs; 
20. Deve implementar registro dinâmico de VLAN com MVRP; 
21. Deve suportar protocolo OpenFlow 1.3; 
22. Deve implementar Jumbo frames nas interfaces Gigabit Ethernet e 10-Gigabit Ethernet 
23. Deve implementar Jumbo frames com tamanho de até 9000 bytes; 
24. Deve implementar Ethernet link aggregation; 
25. Deve implementar IEEE 802.1ad QinQ; 
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26. Deve suportar agregação de link através de LACP com no mínimo 144 grupos distribuídos 
através da pilha, com cada grupo permitindo até 8 portas; 
27. Deve implementar IEEE 802.3x Flow Control; 
28. Deve implementar STP BPDU Protection (BPDU Guard); 
29. Deve implementar IEEE 802.1w Rapid Reconfiguration of Spanning Tree; 
30. Deve implementar MSTP IEEE 802.1s com pelo menos 64 instâncias; 
31. Deve implementar UDLD ou DLDP. Roteamento 
32. Deve implementar roteamento estático IPv4 e IPv6; 
33. Deve implementar RIP, RIPv2 e RIPng; 
  
 
34. Deve possuir no mínimo 512 interfaces de roteamento IP (VLAN Interface) 
35. O equipamento ofertado deve implementar roteamento baseado em política (PBR) para IPv4 e 
IPv6; 
36. O equipamento ofertado deve possuir tabela de roteamento com no mínimo 10 mil entradas 
IPv4 e 5 mil entradas IPv6; 
37. Deve suportar no mínimo 256 rotas estáticas; 
38. O equipamento ofertado deve permitir autenticação em servidores RADIUS e TACACS+; 
39. Deve suportar dual stack IPv4/IPv6; 
40. Deve implementar Bidirectional Forwarding Detection (BFD), suportando redução do tempo de 
convergência para OSPF e VRRP; 
41. Deve implementar OSPF v2 e OSPF v3; 
42. Deve implementar BGP. QoS 
43. Deve implementar 8 filas em cada porta; 
44. Deve implementar traffic shapping; 
45. Deve implementar classificação de tráfego utilizando informações de camada 2, 3 e 4; 
46. Deve implementar priorização do trafego em camada 4, baseado em número de portas 
TCP/UDP. 
 
Segurança 
 
47. Deve implementar autenticação 802.1x de múltiplos usuários por porta, simultaneamente. 
48. Deve implementar segurança orientada por identidade e controle de acesso por usuário 
através de ACLs que permitam ou negue o acesso do usuário aos recursos de rede específicos, com 
base na identidade do usuário. 
49. Atribuição VLAN automática, automaticamente atribui os usuários para a VLAN apropriada, 
com base em suas identidades. 
50. Deve implementar accounting RADIUS; 
51. Deve implementar TACACS+; 
52. Deve implementar proteção contra ataques de ARP; 
53. Deve implementar proteção contra IP spoofing (IP source guard); 
54. Deve implementar SNMP v1, v2 e v3; 
55. Deve implementar detecção de ataques maliciosos e enviar um aviso quando uma anomalia 
potencial, causada pelos ataques mal-intencionado, for detectado. 
56. Deve suportar o isolamento de portas e VLANs, de forma que uma porta ou VLAN isolada não 
possa enviar tráfego para outra porta isolada do mesmo switch; 
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57. Deve implementar segurança do gerenciamento do switch em métodos de acesso CLI, GUI ou 
MIB, através de SSHv2, SSL e SNMPv3 
58. Deve implementar autenticação baseado em porta ou endereço MAC; 
59. Deve implementar autenticação utilizando navegadores web, possibilitando que clientes que 
não possuem cliente 802.1x possam autenticar; 
60. Deve suportar port-security. 
 
Gerenciamento 
 
61. Deve permitir instalação simplificada “Zero-touch provisioning” através de processo baseado 
em DHCP com a solução de software de gerenciamento; 
62. O equipamento ofertado deve permitir múltiplos arquivos de configuração; 
  
 
63. Deve suportar espelhamento remoto; 
64. Deve implementar Secure File Transfer Protocol; 
65. Deve implementar LLDP; 
66. Deve implementar LLDP-MEd; 
67. Deve implementar SNTP v4; 
68. O equipamento ofertado deve Implementar Sflow ou Netflow; 
69. Deve implementar RFC 1213 MIB II; 
70. Deve implementar RFC 2096 IP Forwarding Table MIB; 
71. Deve implementar RFC 2571 SNMP Framework MIB; 
72. Deve implementar RFC 2572 SNMP-MPD MIB; 
73. Deve implementar RFC 2573 SNMP-Notification MIB; 
74. Deve implementar RFC 2574 SNMP USM MIB; 
75. Deve implementar RFC 2737 Entity MIB (Version 2); 
76. Deve implementar RFC 3414 SNMP-User based-SM MIB; 
77. Deve implementar RFC 3415 SNMP-View based-ACM MIB; 
78. Deve implementar RFC 2668 802.3 MAU MIB; 
79. Deve implementar RFC 3418 MIB for SNMPv3; 
80. Deve ser fornecido com a versão de software mais completa e atual disponível para o 
equipamento; 
81. Deve ser fornecido com todas as licenças de software necessárias para o funcionamento 
integral de todas as funcionalidades disponíveis para o equipamento; 
82. O equipamento ofertado deve possuir certificado de homologação na Anatel, de acordo com a 
resolução n° 242; 
 
Garantia e Suporte 
 
83. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e atendimento. O 
prazo máximo para atendimento do chamado deve ser de até o próximo dia útil após a sua 
abertura. Durante o período da garantia o prazo máximo para o reparo de equipamentos 
defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) dias úteis. 
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84. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá informar 
em sua proposta o código de serviço de garantia do fabricante (“part number”), incorporada à 
solução. 
85. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte técnico 
online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de área para 
cadastro da solução de hardware ofertada, possibilitando assim que a CONTRATANTE possa receber 
de forma proativa, durante todo período da garantia as notificações de atualizações e correções 
(“hotfix”) da solução; 
86. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 
87. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução exigidos 
para os equipamentos, deverá ser comprovada a existência da assistência técnica local no domicílio 
da contratante e na modalidade on-site, devendo essa ser realizada por meio de documentação 
oficial do fabricante dos produtos e de domínio público, através de catálogos, folder impressos ou 
da internet, devendo constar o endereço URL na mesma. Caso não seja comprovada por um dos 
meios citados anteriormente, será possível a comprovação através da apresentação de 
documentação expressa do fabricante dos equipamentos, indicando a referida assistência técnica 
que será responsável pelo atendimento e manutenção durante o período de garantia dos produtos 
ofertados. Em caso de 
  
 
documentação expressa do fabricante a esta deverá ser anexada uma procuração que comprove 
que a fabricante outorga ao procurador os poderes para firmar e declarar as exigências solicitadas. 
88. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada. 
 
 
ITEM 06 – MÓDULO COM 4 PORTAS SFP+ PARA SWITCH DE DISTRIBUIÇÃO 
 
Características técnicas mínimas 
 
1. Módulo de expansão para switch de distribuição; 
2. Suporte a no mínimo 4 (quatro) portas SFP+; 
3. Deve ser compatível com GBICS 100M/1G/10G SFP+; 
4. Deve possuir suporte a MACsec; 
5. Compatibilidade integral com o item 05. 
 
Garantia e Suporte 
 
6. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão de obra 
e atendimento no local. O período da garantia o prazo máximo para o reparo de equipamentos 
defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) dias úteis; 
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7. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá informar 
em sua proposta o código de serviço de garantia do fabricante (part number), incorporado ao 
equipamento; 
8. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a integração 
de itens de terceiros que possam acarretar em perda parcial da garantia ou não realização da 
manutenção técnica pelo próprio fabricante quando solicitada; 
 
 
ITEM 07 – MÓDULO DE STACKING COM 4 PORTAS PARA SWITCH DE DISTRIBUIÇÃO 
 
Características técnicas mínimas 
 
1. Módulo de expansão para switch de distribuição; 
2. Suporte a no mínimo 4 (quatro) portas para stacking; 
3. Deve prover no mínimo 320Gbps por módulo; 
4. Deve acompanhar 1 (um) cabo de stacking compatível, com 1 (um) metro de comprimento; 
5. Compatibilidade integral com o item 05. 
 
 
Garantia e Suporte 
  
 
6. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão de obra 
e atendimento no local. O período da garantia o prazo máximo para o reparo de equipamentos 
defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) dias úteis; 
7. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá informar 
em sua proposta o código de serviço de garantia do fabricante (part number), incorporado ao 
equipamento; 
8. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a integração 
de itens de terceiros que possam acarretar em perda parcial da garantia ou não realização da 
manutenção técnica pelo próprio fabricante quando solicitada; 
 
 
ITEM 08 – SWITCH DE ACESSO L3 COM 48 PORTAS GIGABIT E 4 SFP+ 
 
Características gerais 
 
1. Deve possuir 48 portas 10/100/1000; 
2. Deve possuir 4 portas 1/10G SFP+; 
3. Deve possuir capacidade de encaminhamento de, no mínimo, 110 Mpps; 
4. Deve possuir capacidade de comutação de, no mínimo, 176 Gbps; 
5. Deve implementar IEEE 802.3az para as portas 10/100/1000; 
6. Deve possuir uma interface de console USB; 
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7. Deve suportar empilhamento de no mínimo 8 switches; 
8. Deve suportar agregação de link através de LACP com no mínimo 20 grupos distribuídos 
através da pilha, com cada grupo permitindo até 8 portas; 
9. Deve suportar a agregação de links entre diferentes membros da pilha; 
10. Deve possuir no mínimo 32.000 endereços MAC; 
11. Deve possuir latência máxima de 4μs, considerando pacotes de 64 bytes; 
12. Deve possuir buffers de, no mínimo, 12 MB; 
13. Deve implementar funcionalidade que permita a detecção de links unidirecionais; 
14. Deve implementar funcionalidade que permita a detecção de falhas de uplink; 
15. Deve implementar no mínimo 2000 VLANs simultaneamente; 
16. Deve implementar MVRP (Multiple VLAN Registration Protocol); 
17. Deve implementar LLDP (IEEE 802.1ab); 
18. Deve implementar LLDP-MED; 
19. Deve implementar Q-in-Q (IEEE 802.1ad); 
20. Deve implementar PVST+, RPVST+ ou protocolo compatível; 
21. Deve implementar MSTP (IEEE 802.1s); 
22. Deve implementar túneis VxLAN (VTEP). 
 
 
Funcionalidades de Camada 3 
 
23. Deve possuir tabela de roteamento com no mínimo 2.000 rotas IPv4 e 1.000 rotas IPv6; 
24. Deve implementar roteamento estático; 
25. Deve implementar RIP v2, com suporte a autenticação MD5 (RIPv2); 
  
 
26. Deve implementar RIPng; 
27. Deve implementar OSPF; 
28. Deve implementar OSPFv3; 
29. Deve implementar Policy-based Routing; 
30. Deve implementar VRRP; 
31. Deve implementar VRRPv3; 
32. Deve implementar servidor DHCP; 
33. Deve implementar DHCP snooping (IPv4 e IPv6); 
34. Deve implementar DHCP relay (IPv4 e IPv6); 
35. Deve implementar Gateway mDNS, com suporte a Apple Bonjour. 
 
 
Multicast 
 
36. Deve implementar PIM-SM; 
37. Deve implementar PIM-DM; 
38. Deve implementar MLD snooping; 
39. Deve implementar IGMP v3. 
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Software Defined Networking 
 
40. Deve implementar OpenFlow 1.3 ou superior; 
41. Deve implementar a separação lógica do tráfego sem suporte a OpenFlow do tráfego com 
suporte a OpenFlow através de instâncias. O tráfego OpenFlow não pode influenciar o tráfego não 
openflow no equipamento; 
42. Deve permitir configurar cada instância como modo ativo (pacotes referentes a fluxos que o 
switch não conhece são enviados para a controladora) ou modo passivo (pacotes que não se 
referem a um fluxo na tabela do switch não são enviados para a controladora); 
43. Deve implementar 16 instâncias de OpenFlow; 
44. As instâncias de OpenFlow devem suportar a associação de múltiplas VLANs; 
45. Cada instância OpenFlow configurada no equipamento deve suportar, pelo menos, a 
configuração de 3 controladores SDN; 
46. Deve permitir utilizar intervalo de portas TCP/UDP e flags de TCP como parâmetros nas regras 
de OpenFlow; 
47. Deve suportar no mínimo 16.000 regras openflow; 
48. Deve possuir interface REST API; 
49. Deve suportar configurações via JSON/REST API com, no mínimo, os seguintes métodos: GET, 
POST, PUT e DELETE; 
50. Deve suportar a criação de VLANs e ACLs no equipamento através de REST. 
 
 
QoS 
 
51. Deve implementar controle de broadcast; 
52. Deve implementar rate limiting para pacotes ICMP; 
53. Deve implementar rate limiting para tráfego broadcast e multicast; 
54. Deve implementar rate limiting baseado em tráfego classificado por uma ACL; 
55. Deve suportar espelhamento de portas; 
  
 
56. Deve suportar espelhamento de tráfego para um switch remoto. 
 
 
Segurança 
 
57. Deve implementar controle de acesso baseado em perfis (Role Based Access Control); 
58. Deve implementar VLANs privadas, de forma que permita o isolamento de tráfego de uma 
porta de acesso das demais portas de acesso de uma mesma VLAN, permitindo acesso apenas para 
as portas de Uplink (porta promíscua); 
59. Deve implementar 802.1x; 
60. Deve implementar autenticação baseada em web; 
61. Deve implementar autenticação baseada em endereço MAC; 
62. Deve permitir a utilização simultânea de autenticação 802.1x e MAC em uma mesma porta; 
63. Deve implementar TACACS+. Não serão aceitas soluções similares; 
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64. Deverá suportar o download de políticas ou ACLsl a partir de um software de Controle de 
Acesso à Rede (NAC), sem necessidade de pré-configuração das regras no switch, permitindo a 
centralização das políticas; 
65. Deve suportar integração com ferramenta de controle de acesso do mesmo fabricante que 
permita identificar automaticamente o tipo e sistema operacional dos equipamentos que se 
conectam à rede (device profiling) sem a necessidade de agentes instalados nos dispositivos; 
66. Deve suportar integração com ferramenta de controle de acesso do mesmo fabricante que 
permita verificar se a máquina está em conformidade com a política de segurança antes de entrar 
na rede, verificando, no mínimo serviços os serviços e antivírus das máquinas. Deve suportar os 
sistemas operacionais Microsoft Windows, Mac OS e Linux. 
 
 
Gerenciamento 
 
67. Deve implementar NTP com autenticação MD5; 
68. Deve implementar Time Domain Reflectometry (TDR) para testes de cabos UTP, permitindo 
identificar falhas e verificar a distância do cabo; 
69. Deve suportar duas imagens de software na flash; 
70. Deve suportar múltiplos arquivos de configuração na flash; 
71. Deve permitir o agendamento de tarefas, permitindo executar um comando em um dia e 
horário específicos; 
72. Deve suportar a autoconfiguração dos switches através de DHCP e software de gerenciamento, 
sem necessidade de nenhuma intervenção no switch (com configuração de fábrica); 
73. Deve suportar gerenciamento através de plataforma de nuvem do mesmo fabricante, com 
funcionalidades de gerenciamento de configuração, alertas e notificações e gerenciamento de 
firmware, sem necessidade de instalação de nenhum software ou dispositivo on-site; 
74. Deve suportar IPSec para comunicação com o sistema de gerenciamento; 
75. Deve implementar sFlow (IPv4 e IPv6); 
76. Deve possuir interface web para configuração; 
77. Deve implementar TR-69 (CPE WAN Management Protocol); 
78. Deve suportar diagnóstico de transceivers ópticos; 
79. Deve implementar Syslog sobre TLS; 
80. Deve implementar Secure SFTP (SFTP); 
81. Deve implementar SNMP v1/v2/v3; 
  
 
82. Deve implementar funcionalidade que permita monitorar o SLA (Service Level Agreement) de 
conexões IP. Deve suportar os seguintes testes: ICMP Echo, UDP-Echo (em porta configurável) e 
TCP-Connect (em porta configurável) e Jitter UDP para voz; 
83. Deve implementar compatibilidade com o protocolo CDP para provisionamento de telefones 
IP; 
84. Deve implementar o isolamento de um Access Point rogue conectado ao switch, quando este 
for detectado por solução de WLAN do mesmo fabricante; 
85. Deve implementar a configuração automática de Access Point wireless do mesmo fabricante 
quando conectado ao switch. Devem ser suportados os seguintes parâmetros para a configuração 
automática: VLAN, CoS, largura de banda máxima; 
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86. Deve suportar o encaminhamento de tráfego para controladora wireless do mesmo fabricante 
para inspeção e controle de acesso. 
 
 
Licenciamento 
 
87. Deve ser fornecido com a versão de software mais completa disponível para o equipamento; 
88. Deve ser fornecido com todas as licenças de software necessárias para o funcionamento 
integral de todas as funcionalidades disponíveis para o equipamento. 
 
 
Garantia e Suporte 
 
1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e atendimento. O 
prazo máximo para atendimento do chamado deve ser de até o próximo dia útil após a sua 
abertura. Durante o período da garantia o prazo máximo para o reparo de equipamentos 
defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) dias úteis. 
2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 
3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de área 
para cadastro da solução de hardware ofertada, possibilitando assim que a CONTRATANTE possa 
receber de forma proativa, durante todo período da garantia as notificações de atualizações e 
correções (“hotfix”) da solução; 
4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 
5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução exigidos 
para os equipamentos, deverá ser comprovada a existência da assistência técnica local no domicílio 
da contratante e na modalidade on-site, devendo essa ser realizada por meio de documentação 
oficial do fabricante dos produtos e de domínio público, através de catálogos, folder impressos ou 
da internet, devendo constar o endereço URL na mesma. Caso não seja comprovada por um dos 
meios citados anteriormente, será possível a comprovação através da apresentação de 
documentação expressa do fabricante dos equipamentos, indicando a referida assistência técnica 
que será responsável pelo atendimento e manutenção durante o período de garantia dos produtos 
ofertados. Em caso de documentação expressa do fabricante a esta deverá ser anexada uma 
procuração que 
  
 
comprove que a fabricante outorga ao procurador os poderes para firmar e declarar as exigências 
solicitadas. 
6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada. 
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ITEM 09 – SWITCH DE ACESSO L3 COM 24 PORTAS GIGABIT E 4 SFP+ 
 
Características gerais 
 
1. Deve possuir 24 portas 10/100/1000; 
2. Deve possuir 4 portas 1/10G SFP+; 
3. Deve possuir capacidade de encaminhamento de, no mínimo, 95 Mpps; 
4. Deve possuir capacidade de comutação de, no mínimo, 128 Gbps; 
5. Deve implementar IEEE 802.3az para as portas 10/100/1000; 
6. Deve possuir uma interface de console USB; 
7. Deve suportar empilhamento de no mínimo 4 switches; 
8. Deve suportar agregação de link através de LACP com no mínimo 20 grupos distribuídos 
através da pilha, com cada grupo permitindo até 8 portas; 
9. Deve suportar a agregação de links entre diferentes membros da pilha; 
10. Deve possuir no mínimo 32.000 endereços MAC; 
11. Deve possuir latência máxima de 4μs, considerando pacotes de 64 bytes; 
12. Deve possuir buffers de, no mínimo, 12 MB; 
13. Deve implementar funcionalidade que permita a detecção de links unidirecionais; 
14. Deve implementar funcionalidade que permita a detecção de falhas de uplink; 
15. Deve implementar no mínimo 2000 VLANs simultaneamente; 
16. Deve implementar MVRP (Multiple VLAN Registration Protocol); 
17. Deve implementar LLDP (IEEE 802.1ab); 
18. Deve implementar LLDP-MED; 
19. Deve implementar Q-in-Q (IEEE 802.1ad); 
20. Deve implementar PVST+, RPVST+ ou protocolo compatível; 
21. Deve implementar MSTP (IEEE 802.1s); 
22. Deve implementar túneis VxLAN (VTEP); 
 
 
Funcionalidades de Camada 3 
 
23. Deve possuir tabela de roteamento com no mínimo 2.000 rotas IPv4 e 1.000 rotas IPv6; 
24. Deve implementar roteamento estático; 
25. Deve implementar RIP v2, com suporte a autenticação MD5 (RIPv2); 
26. Deve implementar RIPng; 
27. Deve implementar OSPF; 
28. Deve implementar OSPFv3; 
29. Deve implementar Policy-based Routing; 
30. Deve implementar VRRP; 
31. Deve implementar VRRPv3; 
  
 
32. Deve implementar servidor DHCP; 
33. Deve implementar DHCP snooping (IPv4 e IPv6); 
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34. Deve implementar DHCP relay (IPv4 e IPv6); 
35. Deve implementar Gateway mDNS, com suporte a Apple Bonjour; 
 
 
Multicast 
 
36. Deve implementar PIM-SM; 
37. Deve implementar PIM-DM; 
38. Deve implementar MLD snooping; 
39. Deve implementar IGMP v3; 
 
 
Software Defined Networking 
 
40. Deve implementar OpenFlow 1.3 ou superior; 
41. Deve implementar a separação lógica do tráfego sem suporte a OpenFlow do tráfego com 
suporte a OpenFlow através de instâncias. O tráfego OpenFlow não pode influenciar o tráfego não 
openflow no equipamento. 
42. Deve permitir configurar cada instância como modo ativo (pacotes referentes a fluxos que o 
switch não conhece são enviados para a controladora) ou modo passivo (pacotes que não se 
referem a um fluxo na tabela do switch não são enviados para a controladora) 
43. Deve implementar 16 instâncias de OpenFlow; 
44. As instâncias de OpenFlow devem suportar a associação de múltiplas VLANs. 
45. Cada instância OpenFlow configurada no equipamento deve suportar, pelo menos, a 
configuração de 3 controladores SDN. 
46. Deve permitir utilizar intervalo de portas TCP/UDP e flags de TCP como parâmetros nas regras 
de OpenFlow; 
47. Deve suportar no mínimo 16.000 regras openflow; 
48. Deve possuir interface REST API; 
49. Deve suportar configurações via JSON/REST API com, no mínimo, os seguintes métodos: GET, 
POST, PUT e DELETE; 
50. Deve suportar a criação de VLANs e ACLs no equipamento através de REST. 
 
 
QoS 
 
51. Deve implementar controle de broadcast; 
52. Deve implementar rate limiting para pacotes ICMP; 
53. Deve implementar rate limiting para tráfego broadcast e multicast; 
54. Deve implementar rate limiting baseado em tráfego classificado por uma ACL; 
55. Deve suportar espelhamento de portas; 
56. Deve suportar espelhamento de tráfego para um switch remoto. 
 
 
Segurança 
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57. Deve implementar controle de acesso baseado em perfis (Role Based Access Control); 
  
 
58. Deve implementar VLANs privadas, de forma que permita o isolamento de tráfego de uma 
porta de acesso das demais portas de acesso de uma mesma VLAN, permitindo acesso apenas para 
as portas de Uplink (porta promíscua); 
59. Deve implementar 802.1x; 
60. Deve implementar autenticação baseada em web; 
61. Deve implementar autenticação baseada em endereço MAC; 
62. Deve permitir a utilização simultânea de autenticação 802.1x e MAC em uma mesma porta; 
63. Deve implementar TACACS+. Não serão aceitas soluções similares; 
64. Deverá suportar o download de políticas ou ACLs a partir de um software de Controle de 
Acesso à Rede (NAC), sem necessidade de pré-configuração das regras no switch, permitindo a 
centralização das políticas; 
65. Deve suportar integração com ferramenta de controle de acesso do mesmo fabricante que 
permita identificar automaticamente o tipo e sistema operacional dos equipamentos que se 
conectam à rede (device profiling) sem a necessidade de agentes instalados nos dispositivos; 
66. Deve suportar integração com ferramenta de controle de acesso do mesmo fabricante que 
permita verificar se a máquina está em conformidade com a política de segurança antes de entrar 
na rede, verificando, no mínimo serviços os serviços e antivírus das máquinas. Deve suportar os 
sistemas operacionais Microsoft Windows, Mac OS e Linux. 
 
 
Gerenciamento 
 
67. Deve implementar NTP com autenticação MD5; 
68. Deve implementar Time Domain Reflectometry (TDR) para testes de cabos UTP, permitindo 
identificar falhas e verificar a distância do cabo; 
69. Deve suportar duas imagens de software na flash; 
70. Deve suportar múltiplos arquivos de configuração na flash; 
71. Deve permitir o agendamento de tarefas, permitindo executar um comando em um dia e 
horário específicos; 
72. Deve suportar a autoconfiguração dos switches através de DHCP e software de gerenciamento, 
sem necessidade de nenhuma intervenção no switch (com configuração de fábrica); 
73. Deve suportar gerenciamento através de plataforma de nuvem do mesmo fabricante, com 
funcionalidades de gerenciamento de configuração, alertas e notificações e gerenciamento de 
firmware, sem necessidade de instalação de nenhum software ou dispositivo on-site; 
74. Deve suportar IPSec para comunicação com o sistema de gerenciamento; 
75. Deve implementar sFlow (IPv4 e IPv6); 
76. Deve possuir interface web para configuração; 
77. Deve implementar TR-69 (CPE WAN Management Protocol); 
78. Deve suportar diagnóstico de transceivers ópticos; 
79. Deve implementar Syslog sobre TLS; 
80. Deve implementar Secure SFTP (SFTP); 
81. Deve implementar SNMP v1/v2/v3; 
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82. Deve implementar funcionalidade que permita monitorar o SLA (Service Level Agreement) de 
conexões IP. Deve suportar os seguintes testes: ICMP Echo, UDP-Echo (em porta configurável) e 
TCP-Connect (em porta configurável) e Jitter UDP para voz; 
83. Deve implementar compatibilidade com o protocolo CDP para provisionamento de telefones 
IP; 
84. Deve implementar o isolamento de um Access Point rogue conectado ao switch, quando este 
for detectado por solução de WLAN do mesmo fabricante; 
  
 
85. Deve implementar a configuração automática de Access Point wireless do mesmo fabricante 
quando conectado ao switch. Devem ser suportados os seguintes parâmetros para a configuração 
automática: VLAN, CoS, largura de banda máxima; 
86. Deve suportar o encaminhamento de tráfego para controladora wireless do mesmo fabricante 
para inspeção e controle de acesso. 
 
 
Licenciamento 
 
87. Deve ser fornecido com a versão de software mais completa disponível para o equipamento; 
88. Deve ser fornecido com todas as licenças de software necessárias para o funcionamento 
integral de todas as funcionalidades disponíveis para o equipamento. 
 
 
Garantia e Suporte 
 
1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e atendimento. O 
prazo máximo para atendimento do chamado deve ser de até o próximo dia útil após a sua 
abertura. Durante o período da garantia o prazo máximo para o reparo de equipamentos 
defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) dias úteis. 
2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 
3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de área 
para cadastro da solução de hardware ofertada, possibilitando assim que a CONTRATANTE possa 
receber de forma proativa, durante todo período da garantia as notificações de atualizações e 
correções (“hotfix”) da solução; 
4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 
5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução exigidos 
para os equipamentos, deverá ser comprovada a existência da assistência técnica local no domicílio 
da contratante e na modalidade on-site, devendo essa ser realizada por meio de documentação 
oficial do fabricante dos produtos e de domínio público, através de catálogos, folder impressos ou 
da internet, devendo constar o endereço URL na mesma. Caso não seja comprovada por um dos 
meios citados anteriormente, será possível a comprovação através da apresentação de 
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documentação expressa do fabricante dos equipamentos, indicando a referida assistência técnica 
que será responsável pelo atendimento e manutenção durante o período de garantia dos produtos 
ofertados. Em caso de documentação expressa do fabricante a esta deverá ser anexada uma 
procuração que comprove que a fabricante outorga ao procurador os poderes para firmar e 
declarar as exigências solicitadas. 
6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada. 
  
 
ITEM 10 – SWITCH DE ACESSO L2 COM 24 PORTAS GIGABIT E 4 SFP 
 
 
1. Deve possuir 24 portas 10/100/1000; 
2. Deve possuir 4 portas 1G SFP; 
3. Deve possuir capacidade de encaminhamento de, no mínimo, 40 Mpps; 
4. Deve possuir capacidade de comutação de, no mínimo, 56 Gbps; 
5. Deve implementar IEEE 802.3az para as portas 10/100/1000; 
6. Deve possuir uma interface de console USB; 
7. Deve suportar agregação com suporte a até 8 portas por grupo; 
8. Deve possuir 16.000 endereços MAC; 
9. Deve possuir latência máxima de 4 μs para links de 1000Mbps, considerando pacotes de 64 
bytes; 
10. Deve implementar funcionalidade que permita a detecção de links unidirecionais; 
11. Deve implementar virtual stacking permitindo o gerenciamento de, no mínimo, 16 switches 
com mesmo endereço IP; 
12. Deve implementar 512 VLANs simultaneamente; 
13. Deve implementar MVRP (Multiple VLAN Registration Protocol); 
14. Deve implementar LLDP (IEEE 802.1ab); 
15. Deve implementar LLDP-MED; 
16. Deve implementar PVST+, RPVST+ ou protocolo compatível; 
17. Deve implementar MSTP (IEEE 802.1s); 
18. Deve implementar Gateway mDNS, com suporte a Apple Bonjour; 
19. Deve implementar IEEE 802.1p permitindo a classificação de tráfego com até 8 filas de 
prioridade; 
20. Deve permitir a priorização de tráfego por porta e VLAN; 
21. Deve implementar controle de broadcast; 
22. Deve implementar rate limiting para pacotes ICMP; 
23. Deve implementar rate limiting para tráfego broadcast e multicast; 
24. Deve suportar espelhamento de portas; 
25. Deve implementar RADIUS authentication; 
26. Deve implementar RADIUS accounting; 
27. Deve implementar TACACS+; 
28. Deve implementar IEEE 802.1X com, no mínimo, 8 (oito) autenticações por porta; 
29. Deve implementar SSHv2; 
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30. Deve implementar SSH para IPv6; 
31. Deve implementar DHCP snooping; 
32. Deve implementar user role localmente permitindo criar políticas de acesso de segurança e 
QoS, por perfil de usuário e dispositivos; 
33. Deve implementar autenticação baseada em web; 
34. Deve implementar NTP com autenticação MD5; 
35. Deve suportar duas imagens de software na flash; 
36. Deve suportar múltiplos arquivos de configuração na flash; 
37. Deve permitir o agendamento de tarefas, permitindo executar um comando ou grupo de 
comandos em um dia e horário específicos; 
38. Deve implementar sFlow (IPv4 e IPv6) ou Netflow; 
39. Deve implementar RMON com os grupos statistics, history, alarms e events; 
40. Deve possuir interface web para configuração; 
41. Deve implementar TR-69 (CPE WAN Management Protocol); 
  
 
42. Deve suportar a auto-configuração dos switches através de DHCP e software de 
gerenciamento, sem necessidade de nenhuma intervenção no switch (com configuração de 
fábrica); 
43. Deve suportar Digital Optical Monitoring (DOM) para transceivers ópticos; 
44. Deve implementar Syslog sobre TLS; 
45. Deve implementar SFTP ou SCP; 
46. Deve implementar SNMP v1/v2/v3 
47. Deve permitir gerar notificação caso seja excedido o limite de MACs; 
48. Deve implementar compatibilidade com o protocolo CDP para provisionamento de telefones 
IP; 
49. Deve implementar o isolamento de um Access Point rogue conectado ao switch, quando este 
for detectado por solução de WLAN do mesmo fabricante; 
50. Deve implementar a configuração automática de Access Point wireless do mesmo fabricante 
quando conectado ao switch. Devem ser suportados os seguintes parâmetros para a configuração 
automática: VLAN, CoS, largura de banda máxima; 
51. Deve ser fornecido com a versão de software mais completa disponível para o equipamento; 
52. Deve ser fornecido com todas as licenças de software necessárias para o funcionamento 
integral de todas as funcionalidades disponíveis para o equipamento; 
 
 
Garantia e Suporte 
 
1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e atendimento. O 
prazo máximo para atendimento do chamado deve ser de até o próximo dia útil após a sua 
abertura. Durante o período da garantia o prazo máximo para o reparo de equipamentos 
defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) dias úteis. 
2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá informar 
em sua proposta o código de serviço de garantia do fabricante (“part number”), incorporada à 
solução. 
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3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de área 
para cadastro da solução de hardware ofertada, possibilitando assim que a CONTRATANTE possa 
receber de forma proativa, durante todo período da garantia as notificações de atualizações e 
correções (“hotfix”) da solução; 
4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 
5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução exigidos 
para os equipamentos, deverá ser comprovada a existência da assistência técnica local no domicílio 
da contratante e na modalidade on-site, devendo essa ser realizada por meio de documentação 
oficial do fabricante dos produtos e de domínio público, através de catálogos, folder impressos ou 
da internet, devendo constar o endereço URL na mesma. Caso não seja comprovada por um dos 
meios citados anteriormente, será possível a comprovação através da apresentação de 
documentação expressa do fabricante dos equipamentos, indicando a referida assistência técnica 
que será responsável pelo atendimento e manutenção durante o período de garantia dos produtos 
ofertados. Em caso de documentação expressa do fabricante a esta deverá ser anexada uma 
procuração que comprove que a fabricante outorga ao procurador os poderes para firmar e 
declarar as exigências solicitadas. 
  
 
6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada. 
 
 
ITEM 11 – SWITCH DE ACESSO L2 COM 48 PORTAS GIGABIT E 4SFP 
 
 
1. Deve possuir 48 portas 10/100/1000; 
2. Deve possuir 4 portas 1G SFP; 
3. Deve possuir capacidade de encaminhamento de, no mínimo, 77 Mpps; 
4. Deve possuir capacidade de comutação de, no mínimo, 104 Gbps; 
5. Deve implementar IEEE 802.3az para as portas 10/100/1000; 
6. Deve possuir uma interface de console USB; 
7. Deve suportar agregação com suporte a até 8 portas por grupo; 
8. Deve possuir 16.000 endereços MAC; 
9. Deve possuir latência máxima de 4 μs para links de 1000Mbps, considerando pacotes de 64 
bytes; 
10. Deve implementar funcionalidade que permita a detecção de links unidirecionais; 
11. Deve implementar virtual stacking permitindo o gerenciamento de, no mínimo, 16 switches 
com mesmo endereço IP; 
12. Deve implementar 512 VLANs simultaneamente; 
13. Deve implementar MVRP (Multiple VLAN Registration Protocol); 
14. Deve implementar LLDP (IEEE 802.1ab); 
15. Deve implementar LLDP-MED; 
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16. Deve implementar PVST+, RPVST+ ou protocolo compatível; 
17. Deve implementar MSTP (IEEE 802.1s); 
18. Deve implementar Gateway mDNS, com suporte a Apple Bonjour; 
19. Deve implementar IEEE 802.1p permitindo a classificação de tráfego com até 8 filas de 
prioridade; 
20. Deve permitir a priorização de tráfego por porta e VLAN; 
21. Deve implementar controle de broadcast; 
22. Deve implementar rate limiting para pacotes ICMP; 
23. Deve implementar rate limiting para tráfego broadcast e multicast; 
24. Deve suportar espelhamento de portas; 
25. Deve implementar RADIUS authentication; 
26. Deve implementar RADIUS accounting; 
27. Deve implementar TACACS+; 
28. Deve implementar IEEE 802.1X com, no mínimo, 8 (oito) autenticações por porta; 
29. Deve implementar SSHv2; 
30. Deve implementar SSH para IPv6; 
31. Deve implementar DHCP snooping; 
32. Deve implementar user role localmente permitindo criar políticas de acesso de segurança e 
QoS, por perfil de usuário e dispositivos; 
33. Deve implementar autenticação baseada em web; 
34. Deve implementar NTP com autenticação MD5; 
35. Deve suportar duas imagens de software na flash; 
36. Deve suportar múltiplos arquivos de configuração na flash; 
  
 
37. Deve permitir o agendamento de tarefas, permitindo executar um comando ou grupo de 
comandos em um dia e horário específicos; 
38. Deve implementar sFlow (IPv4 e IPv6) ou Netflow; 
39. Deve implementar RMON com os grupos statistics, history, alarms e events; 
40. Deve possuir interface web para configuração; 
41. Deve implementar TR-69 (CPE WAN Management Protocol); 
42. Deve suportar a auto-configuração dos switches através de DHCP e software de 
gerenciamento, sem necessidade de nenhuma intervenção no switch (com configuração de 
fábrica); 
43. Deve suportar Digital Optical Monitoring (DOM) para transceivers ópticos; 
44. Deve implementar Syslog sobre TLS; 
45. Deve implementar SFTP ou SCP; 
46. Deve implementar SNMP v1/v2/v3 
47. Deve permitir gerar notificação caso seja excedido o limite de MACs; 
48. Deve implementar compatibilidade com o protocolo CDP para provisionamento de telefones 
IP; 
49. Deve implementar o isolamento de um Access Point rogue conectado ao switch, quando este 
for detectado por solução de WLAN do mesmo fabricante; 
50. Deve implementar a configuração automática de Access Point wireless do mesmo fabricante 
quando conectado ao switch. Devem ser suportados os seguintes parâmetros para a configuração 
automática: VLAN, CoS, largura de banda máxima; 
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51. Deve ser fornecido com a versão de software mais completa disponível para o equipamento; 
52. Deve ser fornecido com todas as licenças de software necessárias para o funcionamento 
integral de todas as funcionalidades disponíveis para o equipamento. 
 
 
Garantia e Suporte 
 
1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 
período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e atendimento. O 
prazo máximo para atendimento do chamado deve ser de até o próximo dia útil após a sua 
abertura. Durante o período da garantia o prazo máximo para o reparo de equipamentos 
defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) dias úteis. 
2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 
informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 
incorporada à solução. 
3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 
técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de área 
para cadastro da solução de hardware ofertada, possibilitando assim que a CONTRATANTE possa 
receber de forma proativa, durante todo período da garantia as notificações de atualizações e 
correções (“hotfix”) da solução; 
4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 para 
suporte técnico e abertura de chamados técnicos. 
5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução exigidos 
para os equipamentos, deverá ser comprovada a existência da assistência técnica local no domicílio 
da contratante e na modalidade on-site, devendo essa ser realizada por meio de documentação 
oficial do fabricante dos produtos e de domínio público, através de catálogos, folder impressos ou 
da internet, devendo constar o endereço URL na mesma. Caso não seja comprovada por um dos 
meios citados anteriormente, será possível a comprovação através da apresentação de 
documentação expressa do fabricante dos equipamentos, 
  
 
indicando a referida assistência técnica que será responsável pelo atendimento e manutenção 
durante o período de garantia dos produtos ofertados. Em caso de documentação expressa do 
fabricante a esta deverá ser anexada uma procuração que comprove que a fabricante outorga ao 
procurador os poderes para firmar e declarar as exigências solicitadas. 
6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 
fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 
integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não 
realização da manutenção técnica pelo próprio fabricante quando solicitada. 
 
 
ITEM 12 – GBIC 10GB PARA ATÉ 300M 
 
Características técnicas mínimas 
 
1. Deve ser do tipo SFP+ de 10GBASE-SR com conector LC; 
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2. Compatibilidade integral com os Itens 5, 6, 8 e 9. 
 
 
Garantia e Suporte 
 
3. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão de obra 
e atendimento no local. O período da garantia o prazo máximo para o reparo de equipamentos 
defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) dias úteis; 
4. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá informar 
em sua proposta o código de serviço de garantia do fabricante (part number), incorporado ao 
equipamento; 
5. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a integração 
de itens de terceiros que possam acarretar em perda parcial da garantia ou não realização da 
manutenção técnica pelo próprio fabricante quando solicitada. 
 
 
 
 
ITEM 13 – CABO DAC 10GB DE 1M 
 
Características técnicas mínimas 
 
1. Cabo metálico com conector tipo SFP+ para ligação de duas unidades de switch em 10 Gbps; 
2. Cabo com comprimento mínimo de 1 (um) metro; 
3. Compatibilidade integral com os itens 5, 6, 8 e 9. 
 
 
Garantia e Suporte 
  
 
4. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão de obra 
e atendimento no local. O período da garantia o prazo máximo para o reparo de equipamentos 
defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) dias úteis; 
5. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá informar 
em sua proposta o código de serviço de garantia do fabricante (part number), incorporado ao 
equipamento; 
6. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a integração 
de itens de terceiros que possam acarretar em perda parcial da garantia ou não realização da 
manutenção técnica pelo próprio fabricante quando solicitada. 
 
 
ITEM 14 – CABO DAC 10GB DE 3M 

Proposta EMPRESA PLUGNET (0592496)         SEI 0008478-63.2018.6.02.8000 / pg. 910



                                                       ‘                 

 
PLUGNET COMÉRCIO E 

REPRESENTAÇÕES LTDA        

Insc. Estadual Nº. - 024144495 
C.N.P.J. Nº. - 02.213.325/0001-88 
www.plugnetshop.com.br 
 

 

MATRIZ – RECIFE / PE 

Rua General Abreu e Lima, Nº 222 
Rosarinho – 52.041-040  
Fone/Fax: 81 3426.7006 
plugnet@plugnetshop.com.br 

 

FILIAL – BELÉM / PA 

Av. Romulo Maiorana, nº 700 – 
Sala 1709 – Marco – Belém/PA – 

CEP: 66.093-672  
plugnetpa@plugnetshop.com.br 

 

FILIAL – JOÃO PESSOA / PB 

Av. Nossa Senhora dos 
 Navegantes, 104 / 402 Tambaú 

Fone/Fax: 83 3226.1422 
plugnetpb@plugnetshop.com.br 

 

 

 

    

 

 
Características técnicas mínimas 
 
1. Cabo metálico com conector tipo SFP+ para ligação de duas unidades de switch em 10 Gbps; 
2. Cabo com comprimento mínimo de 3 (três) metros; 
3. Compatibilidade integral com os itens 5, 6, 8 e 9. 
 
 
Garantia e Suporte 
 
4. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão de obra 
e atendimento no local. O período da garantia o prazo máximo para o reparo de equipamentos 
defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) dias úteis; 
5. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá informar 
em sua proposta o código de serviço de garantia do fabricante (part number), incorporado ao 
equipamento; 
6. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a integração 
de itens de terceiros que possam acarretar em perda parcial da garantia ou não realização da 
manutenção técnica pelo próprio fabricante quando solicitada. 
 
 
ITEM 15 – GBIC 1GB PARA ATÉ 500M 
 
Características técnicas mínimas 
 
1. Deve ser do tipo SFP de 1G BASE-SX com conector LC; 
2. Compatibilidade integral com os Itens 5, 6, 8, 9, 10 e 11. 
  
 
 
Garantia e Suporte 
 
3. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 
modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão de obra 
e atendimento no local. O período da garantia o prazo máximo para o reparo de equipamentos 
defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) dias úteis; 
4. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá informar 
em sua proposta o código de serviço de garantia do fabricante (part number), incorporado ao 
equipamento; 
5. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante 
ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a integração 
de itens de terceiros que possam acarretar em perda parcial da garantia ou não realização da 
manutenção técnica pelo próprio fabricante quando solicitada. 
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ITEM 16 – SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE TECNOLOGIA PARA SWITCHS DE 
REDE 
 
Características Gerais 
 
1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das 14:00 às 18:00) 
presencialmente no TRE-AL ou remotamente conforme necessidades da CONTRATANTE; 
 
 
Implantação 
 
2. Instalação e configuração de no mínimo 10 (dez) switchs de rede, contemplando: 
3. Configuração básica de acesso a gerencia via rede; 
4. Gerencia e monitoramento em MÓDULO DE GERENCIA DE REDE; 
5. Configuração de autenticação de usuários em MÓDULO DE CONTROLE DE ACESSO; 
6. Configuração de no mínimo 10 (dez) VLANs; 
7. Configuração de stacking de 2 (duas) pilhas com no máximo 4 (quatro) switchs; 
8. Configuração de agregação de links em até 10 (dez) switchs com no máximo 4 (quatro) portas 
por dispositivo. 
 
 
Transferência de Tecnologia 
 
9. O treinamento deverá ser no realizado na modalidade workshop com tarefas práticas hands- 
on, visando assim a melhor fixação dos temas abordados com foco direto na explicação da 
tecnologia dos produtos ofertados como também nas rotinas de configuração, gerenciamento, 
administração e operação dos mesmos, devendo ter duração mínima de 24 (vinte e quatro) horas 
onde serão abordados no mínimo os seguintes tópicos: 
 
a. Configuração inicial e acesso a gerencia; 
b. Configuração de VLANS; 
  
 
c. Configuração de autenticação de usuários em MÓDULO DE CONTROLE DE ACESSO; 
d. Configuração de empilhamento de switchs; 
e. Configuração de agregação de links; 
f. Configuração de switchs para MÓDULO DE GERENCIA DE REDE; 
g. Configuração de switchs para MÓDULO DE ANÁLISE DE TRÁFEGO. 
 
 
ITEM 17 - SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE TECNOLOGIA DO MÓDULO  DE 
CONTROLE DE ACESSO 
 
Características Gerais 
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1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das 14:00 às 18:00) 
presencialmente no TRE-AL ou remotamente conforme necessidades da CONTRATANTE; 
 
 
Implantação 
 
2. Instalação e configuração de 1 (uma) instância do serviço controle de acesso, contemplando 
configurações básicas para acesso à rede, dimensionamento, configuração de armazenamento; 
3. Configuração de autenticação em Active Directory para usuários corporativos; 
4. Configuração de autenticação de visitantes com portal de autosserviço para criação de 
usuários; 
5. Configuração de no mínimo 10 (dez) dispositivos de rede para autenticação na solução. 
 
 
Transferência de Tecnologia 
 
6. O treinamento deverá ser no realizado na modalidade workshop com tarefas práticas hands- 
on, visando assim a melhor fixação dos temas abordados com foco direto na explicação da 
tecnologia da solução como também nas rotinas de configuração, gerenciamento, administração e 
operação da mesma devendo ter duração mínima de 24 (vinte e quatro) horas onde será abordado 
no mínimo os seguintes tópicos: 
 
a. Configuração de Active Directory como base de autenticação; 
b. Configuração de autenticação de usuários corporativos; 
c. Configuração de autenticação de usuários visitantes; 
d. Configuração de portal de autosserviço; 
e. Configuração de autenticação e autorização com RADIUS. 
 
 
ITEM 18 – TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE SWITCHES 
 
Características Gerais 
  
 
1. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do fabricante no 
Treinamento Básico de Administração dos Switches para 01 (um) profissional da contratante; 
2. O voucher deverá ter validade de pelo menos 12 (doze) meses; 
3. O treinamento deverá ser de acordo com o calendário de treinamento do fabricante e 
ministrado em centro oficial de treinamento do mesmo ou remotamente, utilizando tecnologia de 
ensino a distância; 
4. Deverá ser ministrado por profissional devidamente credenciado junto ao fabricante e apto a 
entregar o respectivo; 
5. O treinamento deverá compreender a explicação da tecnologia da solução como também das 
rotinas de configuração, gerenciamento, administração e operação da mesma; 
6. O treinamento deverá ter carga horária mínima de 24 (vinte e quatro) horas, ministrado no 
período de 08:00 às 12:00 e das 14:00 às 18:00. 
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ITEM 19 – TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE ACESSO 
 
Características Gerais 
 
1. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do fabricante no 
Treinamento da Solução de Controle de Acesso para 01 (um) profissional da contratante; 
2. O voucher deverá ter validade de pelo menos 12 (doze) meses; 
3. O treinamento deverá ser de acordo com o calendário de treinamento do fabricante e 
ministrado em centro oficial de treinamento do mesmo ou remotamente, utilizando tecnologia de 
ensino a distância; 
4. Deverá ser ministrado por profissional devidamente credenciado junto ao fabricante e apto a 
entregar o respectivo; 
5. O treinamento deverá compreender a explicação da tecnologia da solução como também das 
rotinas de configuração, gerenciamento, administração e operação da mesma; 
6. O treinamento deverá ter carga horária mínima de 40 (Quarenta) horas, ministrado no período 
de 08:00 às 12:00 e das 14:00 às 18:00; 
 

 
 

LOTE 02 – SOLUÇÃO DE REDE WIRELESS 

 

 

ITEM 20 – SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO PARA SOLUÇÃO DE REDE 

WIRELESS 

LICENCIAMENTO 

 

1. Licenciamento da SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO, contemplando 

o quantitativo mínimo de 1.000 (um mil) dispositivos, usuários corporativos ou visitantes 

simultâneos, independente do perfil de autenticação, seja por dispositivo ou usuário; 

2. Caso a solução ofertada necessite de licenciamento específico para credenciamento dos 

dispositivos, usuários (corporativos ou visitantes), deverá ser fornecido o quantitativo 

 

solicitado para ambos, de forma que a solução realize a análise de perfil e o controle de acesso dos 

1.000 (um mil) dispositivos ou usuários (corporativos ou visitantes) simultâneos. 

 

MÓDULO DE ANÁLISE DE PERFIL DE DISPOSITIVO 

Características Gerais Modulo de Análise de Perfil de Dispositivo 
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3. Deve implementar funcionalidade de classificação automática criando perfis de dispositivos, 

de forma a descobrir, classificar e agrupar os dispositivos conectados na rede; 

4. Deve categorizar os dispositivos em pelo menos 3 níveis: 

 

d. Por tipo de dispositivo (ex. Computador, Smartdevice, impressora, etc.); 

e. Por sistema operacional (ex. Windows, Linux, MacOS, etc.); 

f. Versão do sistema operacional (ex. Windows 7, Windows 2008 Server, etc.); 

 

5. Deve ser capaz de gerar gráficos das categorias separando os dispositivos conforme suas 

características; 

6. Deve suportar a coleta de informações, para classificação, usando no mínimo: 

k. DHCP; 

l. HTTP User-Agent; 

m. MAC OUI; 

n. ActiveSync plugin; 

o. SNMP; 

p. Subnet Scanner; 

q. IF-MAP; 

r. Cisco Device Sensor; 

s.MDM; 

t. TCP Fingerprinting. 

 

7. Deve possuir dicionário de categorias de dispositivos pré-configurado e mecanismo de 

atualização do mesmo; 

8. Deve suportar a integração com, no mínimo, as seguintes soluções de MDM de mercado 

AirWatch, MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, MaaS 360 devendo comprovar a 

compatibilidade em documentação oficial do fabricante; 

9. Deve permitir priorização na ordem de criação dos perfis com no mínimo as seguintes 

características: 
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f. Agente proprietário; 

g. HTTP User-Agent; 

h. SNMP; 

i. DHCP; 

j. MAC OUI. 

 

10. A solução de análise de perfil de usuários deverá permitir consultas a sua base, pela solução de 

controle de acesso para validação de dispositivos com base no seu perfil. 

 

MÓDULO DE CONTROLE DE ACESSO DE DISPOSITIVOS E USUÁRIOS 

Características Gerais 

 

11. A Solução deverá dar suporte a no mínimo as seguintes bases de dados: 

 

n. Microsoft Active Directory; 

o. Kerberos; 

p. Diretórios LDAP; 

q. OpenLDAP; 

r. PostgreSQL; 

s.Oracle 11g; 

t. MariaDB; 

u. MSSQL; 

v. Servidores de Token; 

w. Base de dados SQL interna; 

x. Lista interna estática de hosts. 

 

12. Deve suportar "Single Sign-on" (SSO) através de SAML v2.0; 

13. Deve implementar gerenciamento e aplicação de políticas de autorização de acesso de 

usuários com base em: 
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f. Atributos do usuário autenticado; 

g. Hora do dia, dia da semana; 

h. Tipo de dispositivo utilizado; 

i. Localização do usuário; 

j. Tipo de autenticação utilizada. 

 

14. Deve permitir a visualização de todas informações relativas a cada transação e autenticação 

em uma única tela, a solução deverá trazer no mínimo as seguintes informações: 

 

m. Data e Hora; 

n. Mac Address do dispositivo; 

o. Classificação do dispositivo; 

p. Usuário; 

q. Equipamento que requisitou a autenticação (origem); 

r. Método de autenticação utilizado; 

s.Fonte de autenticação utilizada para validação; 

t. Perfil de acesso aplicado; 

u. Atributos de entrada do protocolo utilizados na requisição (ex. RADIUS); 

v. Informações de resposta da solução para o elemento de rede; 

w. Alertas em caso de falha; 

x. LOGS já filtrados para a requisição em análise. 

 

15. Deve possuir Dashboard customizável, onde deve permitir a visualização de no mínimo as 

seguintes informações: 

 

a. 

a. Lista com últimos Alertas do sistema; 

b. Gráfico com todas as requisições de autenticação dos últimos 7 dias, incluindo RADIUS, 

TACACS+ e Autenticações Web; 
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c. Gráfico com o status das autenticações aceitas e rejeitadas nos últimos 7 dias; 

d. Gráfico com a categorização dos dispositivos classificados pela solução, divididos de acordo 

com as categorias de classificação; 

e. Últimas falhas de autenticação; 

f. Gráfico com as requisições de avaliação de postura dos dispositivos, divididos em: 

 

• 

I. Saudáveis (dentro das políticas estabelecidas); 

II. Não saudáveis (que estão fora das políticas estabelecidas); 

 

a. 

a. Lista com as últimas autenticações; 

b. Lista com as últimas autenticações com sucesso; 

c. Utilização de CPU do sistema, no mínimo nos últimos 30 minutos; 

 

16. Deve possuir base de regras e categorias de dispositivos pré-configurada e mecanismo de 

atualização da mesma; 

17. Deve suportar a integração com no mínimo as seguintes soluções de MDM de mercado 

AirWatch, MobileIron, BES, JAMF, SOTI, XenMobile, SAP Afaria, MaaS 360 devendo comprovar a 

compatibilidade em documentação oficial do fabricante; 

18. Deve suportar autenticações via OAuth2, Facebook, Twitter, LinkdIn, Office365 e Google 

Apps; 

19. Deve possuir recursos integrados de AAA: RADIUS, TACACS+ e Kerberos; 

20. Deve possuir suporte aos seguintes recursos: 

 

m. RADIUS; 

n. RADIUS CoA; 

o. TACACS+; 

p. Web authentication; 

q. SAML v2.0; 
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r. EAP-FAST (EAP-MSCHAPv2, EAP-GTC, EAP-TLS); 

s.PEAP (EAP-MSCHAPv2, EAP-GTC, EAP-TLS, EAP-PEAP-Public); 

t. TTLS (EAP-MSCHAPv2, EAP-GTC, EAP- TLS, EAP-MD5, PAP, CHAP); 

u. EAP-TLS; 

v. PAP, CHAP, MSCHAPv1, MSCHAPv2, e EAP-MD5; 

w. Windows machine authentication; 

x. MAC address authentication (dispositivos sem suporte a 802.1X); 

 

21. Deve suportar verificação de vulnerabilidade através de varredura de portas; 

22. Deve suportar à aplicação de políticas em ambiente com múltiplos fornecedores de 

Wireless, cabeado e VPN; 

23. Deve possuir CA integrada, para geração de certificados para os dispositivos que forem se 

autenticar na rede; 

24. Deve suportar à integração com plataforma de terceiros usando HTTP/RESTful API; 

25. Deve permitir que a solução faça consultas em bases SQL, com o objetivo de buscar 

informação a serem utilizadas durante o processo de autenticação dos usuários; 

26. Deve possuir suporte a administração através de IPv6; 

27. Deve possuir ferramenta para gerenciar os processos de credenciamento, autenticação, 

autorização e contabilização de usuários visitantes através de portal web seguro; 

28. Deve implementar a criação de grupos de autorizadores com privilégios distintos de criação 

de credenciais temporárias e atribuição de permissões de acesso aos clientes; 

29. Deve permitir realizar a autenticação dos autorizadores em base externa do tipo Microsoft 

Active Directory ou LDAP e atribuir o privilégio ao autorizador de acordo com o seu perfil; 

30. Deve implementar as funcionalidades de geração de lotes de credenciais aleatórias, 

temporárias, pré-autorizadas; 

31. Deve implementar a importação e exportação da relação de credenciais temporárias 

através de arquivos txt ou csv; 

32. Deve permitir a configuração do tempo de validade das credenciais, baseando-se na criação 

da conta ou no primeiro login da conta; 

33. Deve permitir que o visitante crie sua própria credencial temporária (autosserviço) através 

de portal web, com ou sem a necessidade de um autorizador; 
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34. Deve permitir a customização do formulário de criação de credenciais, a ser preenchido 

pelo autorizador ou pelo visitante em caso de autosserviço, especificando quais informações 

cadastrais dos visitantes são obrigatórias ou opcionais; 

35. Deve permitir a customização do nível de segurança da senha temporária que será gerada 

ao visitante, especificando a quantidade mínima de caracteres e o uso de caracteres especiais e 

números para compor a senha; 

36. Deve exigir que o usuário visitante aceite o “Termo de uso da rede” a cada login ou apenas 

no primeiro login; 

37. Deve permitir o envio das credenciais aos usuários registrados através de mensagens SMS 

(Short Message Service), e-mail ou impressão local. 

 

 

GARANTIA E SUPORTE 

 

38. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo 

de 36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 

modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta máximo 

em 4 (quatro) horas. 

39. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 

informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 

incorporada à solução. 

40. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte técnico 

online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de área para 

cadastro da solução de software ofertada, possibilitando assim que a CONTRATANTE possa receber 

de forma proativa, durante todo período da garantia as notificações de atualizações e correções 

(“hotfix”) da solução; 

41. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 0800 

para suporte técnico e abertura de chamados técnicos. 

42. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 

fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou centro 

de distribuição para fins de comprovação que por ventura conflitem com catálogos, manuais, folders 

oficiais impressos ou da internet (devendo constar o endereço URL para folders da web). Caso não 

seja comprovada por um dos meios citados anteriormente, será possível a comprovação através da 

apresentação de documentação expressa do fabricante dos softwares, indicando o período de 

garantia dos produtos ofertados. Em caso de documentação expressa do fabricante deverá ser 
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anexada a mesma a procuração que comprove que a fabricante outorga ao procurador os poderes 

para firmar e declarar as exigências solicitadas. 

 

 

ITEM 21 – SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS LICENCIAMENTO 

1. Deverá ser entregue o quantitativo mínimo de licenças para o gerenciamento simultâneo de 

50 (cinquenta) Pontos de acesso; 

 

CARACTERÍSTICAS GERAIS 

 

2. A solução de gerenciamento deverá administrar a configuração dos Pontos de acesso de 

forma centralizada; 

3. A solução de gerenciamento deverá possuir integração com o HPE IMC em console única de 

gerenciamento; 

4. A solução de gerenciamento de rede wireless deverá suportar, em arquitetura de 

controladora distribuída, a capacidade de gerenciar no mínimo 120 (cento e vinte) pontos de acesso 

por cluster e no mínimo um total de 20 (vinte) clusters; 

5. A solução de gerenciamento, em arquitetura de controladora física ou virtual, deverá 

suportar no mínimo 2400 pontos de acesso; 

6. Deve ser obrigatoriamente do mesmo fabricante dos pontos de acesso e controladores; 

7. Permitir a configuração e gerenciamento através de browser padrão (http, https); 

8. Permitir que os eventos sejam gravados remotamente utilizando Syslog; 

9. Prover organização hierárquica de equipamentos, permitindo que um equipamento receba 

as configurações lógicas e as replique a outros equipamentos; 

10. Possuir capacidade de projeto automatizado de redes sem fio nos padrões 802.11a, 802.11b 

e 802.11g, 802.11n e 802.11ac, segundo a geografia do prédio (planta); 

11. Considerar a área de cobertura e a banda por usuário desejada; 

12. Possibilitar a importação de plantas baixas nos formatos dwg e jpg; 

13. Permitir a visualização de alertas da rede em tempo real; 

14. Permitir a visualização de eventuais áreas sem cobertura de RF (áreas de sombra); 

15. Monitorar o desempenho da rede wireless, consolidando informações de rede tais como: 
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a. Níveis de ruído; 

b. Relação sinal-ruído; 

c. Interferência; 

d. Potência de sinal. 

 

16. Possuir capacidade de listagem on-line da localização de usuário, endereço IP, endereço 

MAC, nível de potência de recepção e dados de associação e de autenticação 802.1x; 

17. Deve possuir informação visual e gráfica, na planta baixa dos andares, para: 

 

a. Visualização dos Pontos de acesso instalados, com estado de funcionamento; 

b. Visualização do mapa de calor de RF (Heatmap); 

c. Localização de ativos conectados à rede (equipamentos 802.11); 

d. Localização de Pontos de acesso rogue. 

 

18. Caso esta funcionalidade não esteja disponível no sistema de gerência, deve ser fornecido 

software, do mesmo fabricante, para atender este item, contemplando todos os dispositivos 

licenciados e com redundância 1+1; 

19. Possuir capacidade de identificação e listagem dos rádios vizinhos e respectivos SSID/BSSID 

que podem ser percebidos por cada Ponto de acesso; 

20. Possuir capacidade de configuração gráfica completa do controlador WLAN seja ela física, 

virtual ou distribuída e respectivos Pontos de acesso; 

21. Possuir capacidade de geração de relatórios dos seguintes tipos: 

 

a. Listagem de clientes Wireless; 

b. Listagem de Pontos de acesso; 

c. Informações de Configuração dos Controladores WLAN; 

d. Utilização da rede; 

e. Detalhes dos Pontos de acesso não autorizados (rogues) detectados. 

 

22. Suportar SSH, HTTP/HTTPS, SSL, Telnet; 
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23. Possuir ferramentas de debug e log de eventos para depuração e gerenciamento em 

primeiro nível; 

24. Implementar os padrões abertos de gerência de rede SNMPv2c e SNMPv3, incluindo a 

geração de traps; 

25. Possuir suporte a MIB II, conforme RFC 1213; 

26. Implementar a MIB privativa que forneça informações relativas ao funcionamento do 

equipamento; 

27. Possibilitar a obtenção da configuração do equipamento através do protocolo SNMP; 

28. Possibilitar a obtenção via SNMP de informações de capacidade e desempenho da CPU, 

memória e portas; 

29. Possibilitar a gerência e identificação individualizada de cada Ponto de acesso remoto; 

30. Permitir a administração centralizada dos Pontos de acesso sem a necessidade de 

configurar os mesmos individualmente; 

31. Possibilitar a identificação de paredes e divisórias com respectivos níveis de atenuação por 

tipo (alvenaria, vidro, drywall e divisória); 

32. Possibilitar a importação de plantas baixas nos formatos gráficos (CAD, dwg, jpg, gif e png); 

33. Deve disponibilizar em painel gráfico de controle informações referentes à: 

 

a. Sistemas operacionais e tipos de dispositivos que estão se conectando a rede; 

b. Informações sobre os tipos de aplicações mais utilizados; 

c. Informações sobre usuários conectados. 

 

34. Deve possuir informação sobre possíveis ameaças a rede detectadas pelos sistemas 

gerenciados; 

35. Deve possibilitar criação de regras de detecção de ameaças e correlacionar todos os 

dispositivos gerenciados. 

 

ITEM 22 – LICENÇAS ADICIONAIS PARA SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS 

Características técnicas mínimas 

 

1. Licença para expansão da SOLUÇÃO DE GERENCIAMENTO DE REDE WIRELESS, 

contemplando o quantitativo adicional mínimo de 1 (um) ponto de acesso simultâneo; 
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2. Cada unidade deve ser fornecida com todas as licenças de software necessárias para o 

funcionamento integral de todas as funcionalidades disponíveis para SOLUÇÃO DE GERENCIAMENTO 

DE REDE WIRELESS especificada nesse edital. 

 

GARANTIA E SUPORTE 

 

1. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo 

de 36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 

modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta máximo 

em 4 (quatro) horas. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 

informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 

incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 

técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de área para 

cadastro da solução de software ofertada, possibilitando assim que a CONTRATANTE possa receber 

de forma proativa, durante todo período da garantia as notificações de atualizações e correções 

(“hotfix”) da solução; 

4. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 

0800 para suporte técnico e abertura de chamados técnicos. 

5. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 

fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou centro 

de distribuição para fins de comprovação que por ventura conflitem com catálogos, manuais, folders 

oficiais impressos ou da internet (devendo constar o endereço URL para folders da web). Caso não 

seja comprovada por um dos meios citados anteriormente, será possível a comprovação através da 

apresentação de documentação expressa do fabricante dos softwares, indicando o período de 

garantia dos produtos ofertados. Em caso de documentação expressa do fabricante deverá ser 

anexada a mesma a procuração que comprove que a fabricante outorga ao procurador os poderes 

para firmar e declarar as exigências solicitadas. 

 

 

ITEM 23 – LICENCIAMENTO ADICIONAL DA SOLUÇÃO DE ANÁLISE DE PERFIL E CONTROLE DE ACESSO 

Características técnicas mínimas 
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3. Licenciamento para expansão da SOLUÇÃO DE ANALISE DE PERFIL E CONTROLE DE ACESSO, 

contemplando o quantitativo mínimo adicional de 500 (quinhentos) dispositivos, usuários 

corporativos ou visitantes simultâneos, independente do perfil de autenticação, seja por dispositivo 

ou usuário; 

 

GARANTIA E SUPORTE 

 

6. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo 

de 36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 

  

 

modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta máximo 

em 4 (quatro) horas. 

7. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 

informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 

incorporada à solução. 

8. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 

técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de área para 

cadastro da solução de software ofertada, possibilitando assim que a CONTRATANTE possa receber 

de forma proativa, durante todo período da garantia as notificações de atualizações e correções 

(“hotfix”) da solução; 

9. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 

0800 para suporte técnico e abertura de chamados técnicos. 

10. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 

fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou centro 

de distribuição para fins de comprovação que por ventura conflitem com catálogos, manuais, folders 

oficiais impressos ou da internet (devendo constar o endereço URL para folders da web). Caso não 

seja comprovada por um dos meios citados anteriormente, será possível a comprovação através da 

apresentação de documentação expressa do fabricante dos softwares, indicando o período de 

garantia dos produtos ofertados. Em caso de documentação expressa do fabricante deverá ser 

anexada a mesma a procuração que comprove que a fabricante outorga ao procurador os poderes 

para firmar e declarar as exigências solicitadas. 

 

 

ITEM 24 – CONTROLADORA WLAN 
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Características gerais 

 

1. Solução baseada em hardware ou software específico, do tipo appliance físico ou virtual, do 

mesmo fabricante dos pontos de acesso e software de gerência; 

2. Deve estar licenciado para controle de, no mínimo, 50 (cinquenta) pontos de acesso, 

podendo ser expandido em no mínimo, 250 (duzentos e cinquenta) pontos de acesso através de 

licenciamento adicional; 

3. Permitir a conexão simultânea de, no mínimo, 4.000 clientes wireless; 

4. Permitir a gravação de eventos por meio do protocolo syslog; 

5. Acesso ao sistema através de cliente com browser padrão (http, https, Java); 

6. Permitir operação em modo mesh; 

7. Permitir o uso de múltiplos SSIDs simultaneamente; 

8. Prover tempo de fast-roaming intra-switch inferior a 25 milissegundos; 

9. Prover tempo de fast-roaming inter-switch em camada 2, inferior a 100 milissegundos; 

10. Permitir conexão entre APs sem a necessidade de conexão cabeada, implementando assim 

uma rede padrão mesh; 

11. Deve suportar 802.11e com WMM, U-APSD e T-SPEC; 

12. Gerenciar centralizadamente a autenticação de usuários; 

13. Implementar protocolo de autenticação para controle do acesso administrativo a solução 

com mecanismos de AAA; 

14. Possuir base de dados de usuários interna para autenticação de usuários convidados / 

temporários (acesso guest); 

15. Permitir autenticação em no mínimo os seguintes sistemas de base de dados de usuários 

Microsoft Active Directory, Cisco ACS server, FreeRadius, entre outros; 

16. Realizar o provisionamento de usuários convidados (guests) através de interface Web por 

meio de um usuário administrativo com permissões mínimas, exclusivas para este fim; 

17. Possuir suporte a autenticação IEEE 802.1X, com pelo menos os seguintes métodos EAP: 

EAP- MD5, PEAP/EAP-GTC, PEAP/EAP-MSCHAPv2, EAP-TLS com utilização de base de usuários  

interna ou servidor RADIUS externo; 

18. Suportar as especificações: IEEE 802.1x; 

19. Deverá suportar os seguintes métodos EAP-PEAP, EAP-TLS e EAP-TTLS; 
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20. Possuir suporte a autenticação IEEE 802.1X, com o método PEAP/EAP-GTC, e com utilização 

de base de usuários LDAP externa; 

21. Permitir a seleção/uso de servidor Radius ou LDAP com base no SSID; 

22. Suportar a autenticação de usuários conectados à rede cabeada através das portas do 

controlador; 

23. Possuir o recurso de EAP Offload para terminação do túnel EAP no próprio controlador; 

24. Deve suportar utilização de Portal Captivo externo ao controlador; 

25. Permitir a autenticação (através de endereço MAC, Portal Captivo ou IEEE 802.1X) de 

usuários conectados à rede WLAN (wireless) ou usuários conectados às portas cabeadas do 

controlador. Também deverá permitir a autenticação de usuário e de máquina por meio de IEEE 

802.1x; 

26. Oferecer recurso de Portal Captivo (Captive Portal) com suporte a múltiplos portais 

simultaneamente; 

27. Implementar associação dinâmica de usuário a VLAN, com base nos parâmetros da etapa de 

autenticação; 

28. Implementar Qualidade de Serviço com a marcação de pacotes utilizando Diffserv e suporte 

a 802.1p para QoS de rede; 

29. Possibilitar roaming com integridade de sessão, dando suporte a aplicações em tempo real, 

tais como, VoIP, VoWLAN, videoconferência, dentre outras; 

30. Permitir portais captivos externos a controladora; 

31. A controladora deve possuir funcionalidade de conexão Site to Site VPN utilizando padrão 

Ipsec. Caso a solução fornecida não possua a funcionalidade, será aceita solução de VPN adicional 

integrada; 

32. Deve permitir o tunelamento do trafego de dados de usuários mesmo em redes L3, não 

sendo necessário estender VLANs até o Ponto de Acesso, inclusive em MANs e WANs; 

33. Implementar segurança IEEE 802.11i; 

34. Suportar a criptografia centralizada com os seguintes protocolos: AES-CCMP, TKIP e WEP; 

35. Suportar, no mínimo, 2000 VLANs; 

36. Implementar o protocolo 802.1w (Rapid Spanning Tree); 

37. Oferecer suporte a roteamento e switching de camadas L2 e L3; 

38. Possuir o recurso de criação de Pools de VLAN para permitir a escalabilidade de redes; 

39. Possuir servidor DHCP embutido; 

40. Suportar o protocolo VRRP para redundância de controladores; 
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41. Deve suportar redundância de controladores nos modos: a. 1+1; 

b. N+1; 

c. Ativo-Ativo; 

d. Ativo-Standby; 

42. Oferecer os recursos de mobilidade entre VLANs para roaming de camada 2; 

43. Oferecer os recursos de Proxy de endereços IP e Proxy DHCP para roaming entre redes (L3) 

44. Deve implementar northbound APIs para realização de integrações com aplicações de 

terceiros para fins de monitoramento e visibilidade. Caso seja necessário, deve ser ofertado licenças 

para ativação desse recurso; 

45. Implementar tagging de VLANs através do protocolo 802.1Q; 

46. Implementar o protocolo 802.1d para Spanning Tree (STP); 

47. O controlador WLAN poderá estar diretamente e/ou remotamente conectado aos APs por ele 

gerenciados, inclusive via roteamento nível 3 da camada OSI 

48. Se um controlador WLAN ou AP controlador falhar, os APs relacionados deverão se associar 

a um controlador WLAN alternativo de forma automática, não permitindo que a rede wireless se 

torne inoperante; 

49. Realizar a descoberta automática dos APs na infraestrutura wireless; 

50. Permitir o controle dos APs mediante a conexão através de topologia MESH (WiFi Mesh); 

51. A rede MESH deverá oferecer comportamento determinístico da topologia da rede MESH; 

52. A rede MESH deverá prover auto-redundância das camadas física (RF) e Layer 2 com 

comportamento determinístico; 

53. Permitir a conexão de APs de maneira remota e segura; 

54. Conectar APs através de redes públicas e/ou privadas com garantia de segurança através de 

conexão criptografada; 

55. Permitir a propagação de SSIDs de maneira segura para qualquer AP legitimamente 

cadastrado na controladora, independentemente de onde este AP esteja conectado; 

56. Permitir a autenticação do AP remoto através de certificado digital ou de usuário e senha 

cadastrados em servidor AD e Radius; 

57. Gerenciar o tráfego dos APs centralizadamente; 

58. Administrar a configuração dos AP’s; 

59. Deve permitir administrar centralizadamente todos os aspectos de segurança da rede 

WLAN através de firewall integrado à solução de rede sem fio, caso a solução ofertada não possua 
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solução de firewall nativa na controladora WLAN deverá ser ofertado firewall externo com 

capacidade para atender toda a solução; 

60. Permitir o bloqueio de comunicação entre clientes wireless – L2 bridging; 

61. Implementar filtros baseados em protocolos e em endereços MAC; 

62. Implementar padrão IEEE 802.11h; 

63. Realizar o controle de autorização baseado em perfis de acesso; 

64. Permitir que seja configurado um perfil de acesso, com regras aplicadas de firewall, para o 

qual será direcionado o usuário após sua autenticação; 

65. Possuir o recurso de “blacklisting” contra ataques ao Firewall e à rede wireless, evitando 

que um determinado cliente se associe à rede wireless caso viole políticas definidas de Firewall ou 

execute algum ataque à rede WLAN de endereços MAC de APs do sistema; 

66. O Firewall deverá implementar os recursos de NAT (Network Address Translation) tanto para 

destino quanto para origem; 

67. Implementar listas de controle de acesso (ACLs); 

68. Oferecer detecção e proteção integrada de ataques de negação de serviços TCP, ICMP; 

69. Permitir o espelhamento de sessão e logs detalhados por pacote a fim de possibilitar 

análises forenses; 

70. Permitir a aplicação de políticas de camada 4, de acordo com as características do usuário. 

Por exemplo, um usuário que pertença ao grupo de gerentes (cadastrado no Radius ou Active 

Directory) terá permissão de acesso ao protocolo FTP no servidor de ERP; 

71. Permitir derivação de políticas de acesso. Por exemplo, um usuário pode pertencer a um 

grupo ao qual foram atribuídas políticas de acesso em camada 4, porém, caso esteja utilizando um 

dispositivo de voz, o tráfego SIP passará a ter prioridade através de aplicação de QoS; 

72. Permitir a criação de políticas com base em horários e na localização do usuário. Por 

exemplo: bloquear o tráfego do protocol FTP após às 18 horas. 

73. O Firewall deverá ser integrado à rede WLAN de modo a permitir a desassociação de usuários da 

rede sem fio WLAN com base na violação de políticas de tráfego. Por exemplo: 

desassociar da rede WLAN e colocar em quarentena o Notebook com endereço MAC XX:XX:XX se o 

usuário tentar fazer um telnet para o servidor ABC; 

74. Otimizar o desempenho e a cobertura da radiofrequência; 

75. Ajustar automaticamente os canais de modo a otimizar a cobertura de rede e mudar as 

condições de RF baseado em performance; 
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76. Detectar interferência e ajustar parâmetros de RF, evitando problemas de cobertura e 

controle da propagação indesejada de RF; 

77. Implementar varredura de RF contínua, programada ou sob demanda, com identificação de 

APs ou clientes irregulares; 

78. Deve implementar a tecnologia de “Channel load balancing”, permitindo que clientes sejam 

automaticamente distribuídos entre Pontos de Acesso adjacentes operando em canais distintos, com 

o objetivo de balancear a carga entre os Pontos de Acesso; 

79. Deve implementar a tecnologia de “Band Steering/Select”, permitindo que clientes com 

suporte a faixa de frequência de 5GHz se conectem aos Pontos de Acesso utilizando, 

preferencialmente, a faixa de 5GHz; 

80. Implementar varredura de RF nas bandas 802.11a, 802.11b, 802.11g, 802.1n e 802.11ac 

para identificação de ataques e APs intrusos não autorizados (rogues); 

81. Realizar a varredura no canal de operação do AP sem impacto na performance da rede 

WLAN; 

82. Permitir a varredura em todos os canais possíveis de RF para detecção e contenção de 

ameaças na rede WLAN; 

83. Deve fazer a varredura dos espectros de 2,4 GHz e 5 GHz para localização e classificação de 

interferências não 802.11, analise de espectro, e evita-las automaticamente; 

84. O controlador deve possuir funcionalidade de analisador gráfico de espectro para detecção de 

interferências nas faixas de frequência de 2.4 e 5 GHz, sejam elas IEEE 802.11 ou não. Deve 

disponibilizar interface gráfica com, pelo menos, gráficos de Fast Fourier Transform (FFT) e 

espectrograma; Caso a funcionalidade não possa ser apresentada pelo controlador, deve ser 

fornecido um equipamento ou software, do mesmo fabricante, que o faça; 

85. Utilizar os APs como ”sensores” de RF para fazer a monitoração do ambiente Wireless; 

86. Classificar automaticamente APs válidos, os que interferem e os não autorizados (rogues); 

87. Implementar mecanismos para detecção e contenção de APs não autorizados (rogues); 

88. Realizar a contenção automática dos APs Rogue, simultaneamente, através da rede WLAN 

e/ou da rede cabeada; 

89. Realizar a identificação e contenção de redes “ad-hoc”; 

90. Detectar e bloquear o bridging entre estações da rede WLAN; 

91. Oferecer proteção contra ataques Denial Of Service (DOS) a APs e estações 

92. Detectar e alertar os seguintes tipos de ataques na rede WLAN: 

a. Impersonalização de AP válido; 

Proposta EMPRESA PLUGNET (0592496)         SEI 0008478-63.2018.6.02.8000 / pg. 930



                                                       ‘                 

 
PLUGNET COMÉRCIO E 

REPRESENTAÇÕES LTDA        

Insc. Estadual Nº. - 024144495 
C.N.P.J. Nº. - 02.213.325/0001-88 
www.plugnetshop.com.br 
 

 

MATRIZ – RECIFE / PE 

Rua General Abreu e Lima, Nº 222 
Rosarinho – 52.041-040  
Fone/Fax: 81 3426.7006 
plugnet@plugnetshop.com.br 

 

FILIAL – BELÉM / PA 

Av. Romulo Maiorana, nº 700 – 
Sala 1709 – Marco – Belém/PA – 

CEP: 66.093-672  
plugnetpa@plugnetshop.com.br 

 

FILIAL – JOÃO PESSOA / PB 

Av. Nossa Senhora dos 
 Navegantes, 104 / 402 Tambaú 

Fone/Fax: 83 3226.1422 
plugnetpb@plugnetshop.com.br 

 

 

 

    

 

b. Floods de Frames; 

c. Fake Ap, Airjack; 

d. Broadcasts de de-autenticação; 

e. Ataques baseados em probes; 

93. Possuir capacidade de gerar alarmes e executar contra-ataques se um ataque for detectado; 

94. Detectar áreas de sombra de cobertura e efetuar os devidos ajustes para sua correção, 

automaticamente; 

95. Ajustar, dinamicamente, o nível de potência e canal de rádio dos APs, de modo a otimizar o 

tamanho da célula de RF, garantindo a performance e escalabilidade; 

96. Permitir o controle de banda disponível (bandwith contracts) por usuário ou através de 

perfis de usuários; 

97. Possibilitar roaming com integridade de sessão, dando suporte a aplicações em tempo real, 

tais como, VoIP, VoWLAN, videoconferência, dentre outras; 

98. Deve possuir mecanismo de controle de admissão de chamadas nos pontos de acesso 

(CAC); 

99. Possuir mecanismo automático de QoS para protocolos de voz (SIP, SVP e SCCP) utilizando 

inspeção automática de pacotes, sem a necessidade de fazer a marcação prévia (tagging) de pacotes; 

100. Deve possuir solução de identificação de aplicações através de técnicas de análise de 

tráfego, provendo informações das aplicações mais utilizadas na interface gráfica; 

101. Permitir a criação de políticas de acesso baseadas nas aplicações, como por exemplo, o 

acesso a “redes sociais” terá um controle de banda de 2Mpbs. 

102. Apresentar informações gráficas referente a utilização de soluções de comunicações 

unificadas (UC) sobre a infraestrutura WLAN, de formar a apresentar informações referentes as 

chamadas realizadas e relações gráficas entre o nível de sinal recebido pelo usuário e a qualidade da 

chamada. 

103. Possuir a funcionalidade da utilização do protocolo Bonjour na infraestrutura, permitindo 

que os serviços divulgados via mDNS sejam controlados, filtrados e disponibilizados entre diferentes 

subnets, tornando assim possível a utilização em redes com múltiplas subnets e um número grande 

de dispositivos. 

104. Cada unidade deve ser fornecida com todas as licenças de software necessárias para o 

funcionamento integral de todas as funcionalidades disponíveis. 

 

Garantia e Suporte 
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1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 

período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e atendimento. O 

prazo máximo para atendimento do chamado deve ser de até o próximo dia útil após a sua abertura. 

Durante o período da garantia o prazo máximo para o reparo de equipamentos defeituosos a 

condição normal de funcionamento deverá ser de até 07 (sete) dias úteis. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 

informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 

incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 

técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de área para 

cadastro da solução de hardware ofertada, possibilitando assim que a CONTRATANTE possa receber 

de forma proativa, durante todo período da garantia as notificações de atualizações e correções 

(“hotfix”) da solução; 

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 

para suporte técnico e abertura de chamados técnicos. 

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 

exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica local no 

domicílio da contratante e na modalidade on-site, devendo essa ser realizada por meio de 

documentação oficial do fabricante dos produtos e de domínio público, através de catálogos, folder 

impressos ou da internet, devendo constar o endereço URL na mesma. Caso não seja comprovada 

por um dos meios citados anteriormente, será possível a comprovação através da apresentação de 

documentação expressa do fabricante dos equipamentos, indicando a referida assistência técnica 

que será responsável pelo atendimento e manutenção durante o período de garantia dos produtos 

ofertados. Em caso de documentação expressa do fabricante a esta deverá ser anexada uma 

procuração que comprove que a fabricante outorga ao procurador os poderes para firmar e declarar 

as exigências solicitadas. 

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 

fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo 

permitida a integração de itens de terceiros que possam acarretar em perda parcial da garantia ou 

não realização da manutenção técnica pelo próprio fabricante quando solicitada. 

 

 

ITEM 25 – LICENÇAS ADICIONAIS PARA CONTROLADORA WLAN 

Características técnicas mínimas 
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3. Licença para expansão da CONTROLADORA WLAN, contemplando o quantitativo adicional 

mínimo de 1 (um) ponto de acesso simultâneo; 

4. Deve ser compatível com controladora WLAN especificada nesse edital; 

5. Cada unidade deve ser fornecida com todas as licenças de software necessárias para o 

funcionamento integral de todas as funcionalidades disponíveis para CONTROLADORA 

WLANespecificada nesse edital. 

 

GARANTIA E SUPORTE 

 

6. Garantia e suporte do fabricante para a solução de software ofertada pelo período mínimo 

de 36 (sessenta) meses, incluindo a evolução para novas versões devendo o atendimento ser na 

modalidade 24x7 (vinte quatro horas por dia, sete dias da semana), com tempo de resposta máximo 

em 4 (quatro) horas. 

7. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 

informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 

incorporada à solução. 

8. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 

técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de área para 

cadastro da solução de software ofertada, possibilitando assim que a CONTRATANTE possa receber 

de forma proativa, durante todo período da garantia as notificações de atualizações e correções 

(“hotfix”) da solução; 

9. A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 

0800 para suporte técnico e abertura de chamados técnicos. 

10. A comprovação da modalidade da garantia deverá ocorrer através de documentação do 

fabricante de domínio público, não sendo aceita documentação emitida pelo fornecedor ou centro 

de distribuição para fins de comprovação que por ventura conflitem com catálogos, manuais, folders 

oficiais impressos ou da internet (devendo constar o endereço URL para folders da web). Caso não 

seja comprovada por um dos meios citados anteriormente, será possível a comprovação através da 

apresentação de documentação expressa do fabricante dos softwares, indicando o período de 

garantia dos produtos ofertados. Em caso de documentação expressa do fabricante deverá ser 

anexada a mesma a procuração que comprove que a fabricante outorga ao procurador os poderes 

para firmar e declarar as exigências solicitadas. 
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ITEM 26 – PONTO DE ACESSO INTERNO TIPO 01 

Características gerais 

  

 

1. Equipamento de Ponto de Acesso para rede local sem fio, configurável via software, com 

funcionamento simultâneo nos padrões IEEE 802.11a/n/ac, 5GHz, e IEEE 802.11b/g/n, 2.4GHz; 

2. Todos os Pontos de acesso sem fio deverão ser novos e sem nenhum histórico de utilização; 

3. Os pontos de acesso deverão possuir certificado emitido pelo “WIFI Alliance” comprovando 

no mínimo os seguintes padrões, protocolos e funcionalidades: 

 

a. IEEE 802.11a; 

b. IEEE 802.11b; 

c. IEEE 802.11g; 

d. IEEE 802.11n; 

e. IEEE 802.11d; 

f. IEEE 802.11ac; 

g. WPA® Enterprise/Personal; 

h. WPA2® Enterprise/Personal; 

i. EAP-TLS; 

j. EAP-TTLS/MSCHAPv2; 

k. PEAPv0/EAP-MSCHAPv2; 

l. PEAPv1/EAP-GTC; 

m. EAP-SIM; 

n. EAP-FAST; 

o. WMM® e WMM® Power Save; 

p. Beamforming; 

q. Short Guard Interval (SGI); 

r. Packet Aggregation (A-MPDU); 

s.Opportunistic Key Caching (OKC) 
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4. Deve operar simultaneamente em 2.4GHz e 5GHz (concurrent dual-band); 

 

 

Performance 

 

5. Deve suportar rádio dual, 5 GHz 802.11ac 2x2 MIMO e 2.4GHz 802.11n 2x2 MIMO 

6. Deve suportar capacidade de 1300 Mbps de throughput ou superior; 

7. Deve possuir rádio duplo configurável pelo software suportando 5 GHz e 2,4 GHz; 

8. Deve possuir no mínimo dois spatial stream Single User (SU) MIMO para taxa de dados sem 

fio de até 867 Mbps para dispositivos cliente individuais (VHT80) 2x2 em 5GHz; 

9. Deve possuir no mínimo dois spatial stream Single User (SU) MIMO para uma taxa de dados 

sem fio de até 400 Mbps para dispositivos clientes compatíveis (2x2 VHT40) em 5GHz; 

10. Deve possuir suporte para até 255 dispositivos cliente associados por rádio e até 16 BSSIDs 

por rádio; 

11. Deve suportar no mínimo as bandas de frequência: 

 

a. 2,400 a 2,4835 GHz 

b. 5.150 a 5.250 GHz 

c. 5,25 a 5,350 GHz 

d.  5,470 a 5,725 GHz 

e.  5,725 a 5,850 GHz 

  

 

12. Deve possuir suporte a seleção de frequência dinâmica (DFS) otimizando o uso do espectro 

de RF disponível; 

13. Deve suportar, no mínimo, as seguintes tecnologias de rádio: 

 

a. 802.11b: espectro espalhável de sequência direta (DSSS) 

b. 802.11a/g/n/ac: multiplexação por divisão de frequência ortogonal (OFDM) 
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14. Deve suportar, no mínimo, os seguintes tipos de modulação: 

 

a. 802.11b: BPSK, QPSK, CCK 

b. 802.11a/g/n/ac: BPSK, QPSK, 16-QAM, 64-QAM, 256-QAM 

 

15. Deve possuir potência de transmissão configurável em incrementos entre 0,5 e 1,0 dBm. 

16. Deve respeitar os limites de potência de transmissão máxima (conduzida): 

 

a. Faixa de 2,4 GHz: +18 dBm por corrente, agregado de +21 dBm (2x2) 

b. Banda de 5 GHz: +18 dBm por corrente, agregado de +21 dBm (2x2) 

 

17. Deve suportar Advanced Cellular Coexistence (ACC) minimizando a interferência das redes 

celulares; 

18. Deve suportar Maximum ratio combining (MRC) para melhorar o desempenho do receptor; 

19. Deve suportar Cyclic delay/shift diversity (CDD/CSD) para melhorar o desempenho RF de 

downlink; 

20. Deve suportar Short guard interval para canais de 20MHz, 40MHz e 80MHz; 

21. Deve suportar Space-time block coding (STBC) para aumentar o alcance e melhorar a 

recepção; 

22. Deve suportar Verificação de paridade de baixa densidade (LDPC) para correção de erros de 

alta eficiência e aumento da taxa de transferência; 

23. Deve suportar Transmit beam-forming (TxBF); 

24. Deve possuir, no mínimo, as seguintes taxas de dados suportadas (Mbps): 

 

a. 802.11b: 1, 2, 5.5, 11 

b. 802, 11a / g: 6, 9, 12, 18, 24, 36, 48, 54 

c. 802.11n (2.4GHz): 6.5 a 300 (MCS0 a MCS15) 

d. 802.11ac: 6.5 a 867 (MCS0 a MCS9, NSS = 1 a 2 for VHT20/40/80 

 

25. Deve possuir suporte a 802.11n de alto rendimento (HT): HT 20/40 
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26. Deve possuir suporte a 802.11ac de alta velocidade (VHT): VHT 20/40/80 

27. Deve possuir suporte a agregação de pacotes 802.11n/ac: A-MPDU, A-MSDU 

 

 

Gerenciamento 

 

28. Deve implementar funcionamento de modo auto gerenciado, sem necessidade de 

controladora WLAN para configuração de seus parâmetros de rede wireless, gerenciamento das 

políticas de segurança, QoS e monitoramento de RF. 

29. Deve obedecer à todas as características descritas mesmo neste modo de funcionamento; 

30. No modo de funcionamento auto gerenciado deve disponibilizar na interface gráfica 

informações de usuários conectados, qualidade de sinal e trafego de dados na rede; 

  

 

31. O ponto de acesso deve permitir a conversão de modo auto gerenciado para modo gerenciado 

por controlador WLAN através de interface gráfica, em browser padrão (HTTPS), e permitir que todos 

os demais pontos de acesso pertencentes ao mesmo cluster, também sejam convertidos 

automaticamente; 

32. O ponto de acesso deverá suportar conexão direta ou remota com controlador WLAN, inclusive 

via roteamento da camada de rede, baseado no modelo OSI; 

33. Se um controlador WLAN falhar, os Pontos de Acesso relacionados deverão se associar 

automaticamente a um controlador WLAN alternativo, não permitindo que a rede wireless se torne 

inoperante; 

34. Implementar mecanismo de funcionamento para trabalhar com controladores WLAN em 

redundância; 

35. Deve permitir que o ponto de acesso seja atualizado de forma centralizada pela interface 

gráfica; 

36. Permitir o armazenamento de sua configuração em memória não volátil, podendo, numa 

queda e posterior restabelecimento da alimentação, voltar à operação normalmente na mesma 

configuração anterior; 

37. Deve possuir servidor DHCP interno configurável; 

38. Possibilitar backup e restore da configuração através da interface gráfica; 

39. Deve possuir Portal Captivo (Captive Portal) integrado para utilização em rede de visitantes; 

Proposta EMPRESA PLUGNET (0592496)         SEI 0008478-63.2018.6.02.8000 / pg. 937



                                                       ‘                 

 
PLUGNET COMÉRCIO E 

REPRESENTAÇÕES LTDA        

Insc. Estadual Nº. - 024144495 
C.N.P.J. Nº. - 02.213.325/0001-88 
www.plugnetshop.com.br 
 

 

MATRIZ – RECIFE / PE 

Rua General Abreu e Lima, Nº 222 
Rosarinho – 52.041-040  
Fone/Fax: 81 3426.7006 
plugnet@plugnetshop.com.br 

 

FILIAL – BELÉM / PA 

Av. Romulo Maiorana, nº 700 – 
Sala 1709 – Marco – Belém/PA – 

CEP: 66.093-672  
plugnetpa@plugnetshop.com.br 

 

FILIAL – JOÃO PESSOA / PB 

Av. Nossa Senhora dos 
 Navegantes, 104 / 402 Tambaú 

Fone/Fax: 83 3226.1422 
plugnetpb@plugnetshop.com.br 

 

 

 

    

 

40. Deve possuir mecanismos para proteção contra Pontos de Acesso não autorizados (Rogues); 

41. Possuir capacidade de identificação e listagem dos rádios vizinhos e respectivos SSID/BSSID; 

42. Implementar associação dinâmica de usuários à VLANs com base nos parâmetros da etapa 

de autenticação; 

43. Deve possuir uma base de usuários interna que diferencie usuários visitantes de 

funcionários, para ser usada em autenticação 802.1x ou portal captivo; 

44. Permitir a autenticação para acesso dos usuários conectados nas redes WLAN (Wireless) 

através: 

 

a. MAC Address 

b. 802.1x em base Local 

c. Captive Portal 

d. 802.1x em base externa RADIUS 

e. 802.1x em base externa LDAP 

 

45. Deve permitir a seleção/uso de servidor de autenticação específico com base no SSID; 

46. Implementar o protocolo de enlace CSMA/CA para acesso ao meio de transmissão; 

47. Possuir capacidade de selecionar automaticamente o canal de transmissão; 

48. Permitir o ajuste dinâmico de nível de potência e canal de rádio de modo a otimizar o 

tamanho da célula de RF; 

49. Permitir habilitar e desabilitar a divulgação do SSID; 

50. Implementar diferentes tipos de combinações encriptação/autenticação por SSID; 

51. Implementar padrão WMM da Wi-Fi Alliance para priorização de tráfego, suportando 

aplicações em tempo real, tais como, VoIP, vídeo, dentre outras; 

52. Não deve haver no licenciamento restrições com relação ao número de dispositivos 

conectados por ponto de acesso; 

53. Implementar a pilha de protocolos TCP/IP com suporte a IPV4 e IPV6 (Bridging); 

54. Implementar VLANs conforme padrão IEEE 802.1Q; 

55. Possuir, no mínimo, uma interface IEEE 802.3 10/100/1000BaseT Ethernet, auto- sensing, 

auto MDI/MDX; 
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56. Permitir a atualização remota do sistema operacional e arquivos de configuração através da 

controladora WLAN 

  

 

57. Implementar cliente DHCP, para configuração automática de rede; 

58. Deve configurar-se automaticamente ao ser conectado na rede; 

59. Possuir LED’s indicativos do estado de operação, da atividade do rádio e da interface 

Ethernet; 

60. Possuir estrutura que permita fixação do equipamento em teto e parede e fornecer 

acessórios para que possa ser feita a fixação; 

61. Deve ser acompanhado de todos os acessórios necessários para operacionalização do 

equipamento, tais como: softwares, cabos de console, cabos de energia elétrica, documentação 

técnica e manuais (podendo ser em CD-ROM) que contenham informações suficientes para 

possibilitar a instalação, configuração e operacionalização do equipamento; 

62. Permitir o bloqueio da configuração do Ponto de Acesso via rede wireless; 

63. Implementar varredura de RF nas bandas 802.11a, 802.11b, 802.11g, 802.11n, para 

identificação de Pontos de Acesso intrusos não autorizados (rogues) e interferências no canal 

habilitado ao ponto de acesso e nos demais canais configurados na rede WLAN, sem impacto no seu 

desempenho; 

64. Implementar IEEE 802.1x, com pelo menos os seguintes métodos EAP: 

 

a. EAP-FAST 

b. EAP-TLS 

c. PEAP-GTC 

d. PEAP-MSCHAPv2 

 

65. Permitir a integração com RADIUS Server com suporte aos métodos EAP citados; 

66. A comunicação entre todos os pontos de acesso sem fio e a controladora deverá ser 

criptografada; 

67. Suportar a autenticação com geração dinâmica de chaves criptográficas por sessão e por 

usuário; 

68. Implementar WPA com algoritmo de criptografia TKIP e MIC; 
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69. Implementar WPA2 com algoritmo de criptografia AES, 128/256 bits, IEEE 802.11i; 

70. Deve possuir modo dedicado de funcionamento de análise de espectro das faixas de 

frequência de 2.4 e 5 GHz identificando fontes de interferência nessas faixas; 

71. Deve possibilitar analise de espectro nos canais em que estiver provendo acesso, sem 

desconectar os usuários; 

72. Deve disponibilizar informações gráficas de análise de espectro em conjunto com o 

controlador WLAN; 

73. O equipamento deverá possuir registro na ANATEL e deverá ser apresentado na entrega do 

equipamento; 

74. Deverá prover priorização de trafego de vídeo e voz através de parâmetros de QoS (Quality 

os Service) com possibilidade de aplicar por SSID e dispositivo; 

75. Possibilitar roaming na rede wireless; 

76. Suportar a criação de uma rede de convidados autocontida com isolamento de tráfego 

entre clientes e serviços locais; 

77. Possuir recursos de seleção automática de canal de transmissão procurando por canais 

onde haja menor interferência, tendo por objetivo melhorar a performance da rede wireless; 

78. Permitir a operação em estrutura Mesh viabilizando a comunicação direta entre diferentes 

Pontos de Acesso sem Fio onde não seja possível estender a rede cabeada; 

79. Operando em estrutura Mesh, a comunicação entre os dispositivos estrutura deverão 

operar na frequência de 5Ghz. 

80. Possuir mecanismo para a restauração das configurações originais de fábrica fisicamente no 

equipamento (reset); 

81. Suportar operação em humidade de 5% a 95% sem condensação; 

  

 

82. Suportar operação em temperatura de até 40°C (quarenta graus centígrados); 

83. Possuir um MTBF (Mean Time Between Failure - Período Médio entre Falhas) de, no 

mínimo, 

250.000 horas. 

 

 

Garantia e Suporte 
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1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 

período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e atendimento. O 

prazo máximo para atendimento do chamado deve ser de até o próximo dia útil após a sua abertura. 

Durante o período da garantia o prazo máximo para o reparo de equipamentos defeituosos a 

condição normal de funcionamento deverá ser de até 07 (sete) dias úteis. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 

informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 

incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 

técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de área para 

cadastro da solução de hardware ofertada, possibilitando assim que a CONTRATANTE possa receber 

de forma proativa, durante todo período da garantia as notificações de atualizações e correções 

(“hotfix”) da solução; 

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 

para suporte técnico e abertura de chamados técnicos. 

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 

exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica local no 

domicílio da contratante e na modalidade on-site, devendo essa ser realizada por meio de 

documentação oficial do fabricante dos produtos e de domínio público, através de catálogos, folder 

impressos ou da internet, devendo constar o endereço URL na mesma. Caso não seja comprovada 

por um dos meios citados anteriormente, será possível a comprovação através da apresentação de 

documentação expressa do fabricante dos equipamentos, indicando a referida assistência técnica 

que será responsável pelo atendimento e manutenção durante o período de garantia dos produtos 

ofertados. Em caso de documentação expressa do fabricante a esta deverá ser anexada uma 

procuração que comprove que a fabricante outorga ao procurador os poderes para firmar e declarar 

as exigências solicitadas. 

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 

fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 

integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não realização 

da manutenção técnica pelo próprio fabricante quando solicitada. 

 

 

ITEM 27 – PONTO DE ACESSO INTERNO TIPO 02 

Características gerais 
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1. Equipamento de Ponto de Acesso para rede local sem fio, configurável via software, com 

funcionamento simultâneo nos padrões IEEE 802.11a/n/ac, 5GHz, e IEEE 802.11b/g/n, 2.4GHz; 

2. Todos os Pontos de acesso sem fio deverão ser novos e sem nenhum histórico de utilização; 

  

 

3. Os pontos de acesso deverão possuir certificado emitido pelo “WIFI Alliance” comprovando 

no mínimo os seguintes padrões, protocolos e funcionalidades: 

 

a. IEEE 802.11a; 

b. IEEE 802.11b; 

c. IEEE 802.11g; 

d. IEEE 802.11n; 

e. IEEE 802.11d; 

f. IEEE 802.11ac; 

g. WPA® Enterprise/Personal; 

h. WPA2® Enterprise/Personal; 

i. EAP-TLS; 

j. EAP-TTLS/MSCHAPv2; 

k. PEAPv0/EAP-MSCHAPv2; 

l. PEAPv1/EAP-GTC; 

m. EAP-SIM; 

n. EAP-FAST; 

o. WMM® e WMM® Power Save; 

p. Beamforming; 

q. Short Guard Interval (SGI); 

r. Packet Aggregation (A-MPDU); 

s.Opportunistic Key Caching (OKC) 

 

4. Deve operar simultaneamente em 2.4GHz e 5GHz (concurrent dual-band); 

 

Proposta EMPRESA PLUGNET (0592496)         SEI 0008478-63.2018.6.02.8000 / pg. 942



                                                       ‘                 

 
PLUGNET COMÉRCIO E 

REPRESENTAÇÕES LTDA        

Insc. Estadual Nº. - 024144495 
C.N.P.J. Nº. - 02.213.325/0001-88 
www.plugnetshop.com.br 
 

 

MATRIZ – RECIFE / PE 

Rua General Abreu e Lima, Nº 222 
Rosarinho – 52.041-040  
Fone/Fax: 81 3426.7006 
plugnet@plugnetshop.com.br 

 

FILIAL – BELÉM / PA 

Av. Romulo Maiorana, nº 700 – 
Sala 1709 – Marco – Belém/PA – 

CEP: 66.093-672  
plugnetpa@plugnetshop.com.br 

 

FILIAL – JOÃO PESSOA / PB 

Av. Nossa Senhora dos 
 Navegantes, 104 / 402 Tambaú 

Fone/Fax: 83 3226.1422 
plugnetpb@plugnetshop.com.br 

 

 

 

    

 

 

Performance 

 

5. Deve suportar rádio dual, 5 GHz 802.11ac 4x4 MIMO e 2.4 GHz 802.11n 2x2 MIMO; 

6. Deve possuir rádio duplo configurável pelo software, suportando 5 GHz e 2,4 GHz; 

7. Deve possuir quatro spatial stream Single User (SU) MIMO para taxa de dados sem fio de 

até 1,733 Mbps, em 5GHz; 

8. Deve possuir três spatial stream Multi User (MU) MIMO para uma taxa de dados sem fio de 

até 1,300 Mbps para dispositivos clientes compatíveis, em 5GHz; 

9. Deve possuir suporte para até 255 dispositivos cliente associados por rádio e até 16 BSSIDs 

por rádio; 

10. Deve suportar no mínimo as bandas de frequência: 

 

a. 2,400 a 2,4835 GHz 

b.  5.150 a 5.250 GHz 

c.  5.250 a 5.350 GHz 

d.  5,470 a 5,725 GHz 

e.  5,725 a 5,850 GHz 

 

11. Deve possuir suporte a seleção de frequência dinâmica (DFS) otimizando o uso do espectro 

de RF disponível; 

12. Deve suportar, no mínimo, as seguintes tecnologias de rádio: 

 

a. 802.11b: espectro espalhável de sequência direta (DSSS); 

b. 802.11a / g / n / ac: multiplexação por divisão de frequência ortogonal (OFDM); 

  

 

13. Deve suportar, no mínimo, os seguintes tipos de modulação: 

 

a. 802.11b: BPSK, QPSK, CCK; 
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b. 802.11a / g / n / ac: BPSK, QPSK, 16-QAM, 64-QAM, 256-QAM; 

 

14. Deve possuir potência de transmissão configurável em incrementos de 0,5 dBm; 

15. Deve respeitar os limites de potência de transmissão máxima (conduzida): 

 

a. Faixa de 2,4 GHz: +18 dBm por corrente, agregado de +24 dBm (3x3); 

b. Faixa de 5 GHz: +18 dBm por corrente, agregado de +24 dBm (4x4); 

 

16. Deve suportar Advanced Cellular Coexistence (ACC) minimizando a interferência das redes 

celulares; 

17. Deve suportar Maximum Ratio Combining (MRC) para melhorar o desempenho do receptor; 

18. Deve suportar Cyclic delay/shift diversity (CDD/CSD) para melhorar o desempenho RF de 

downlink; 

19. Deve suportar Short guard interval para canais de 20-MHz, 40-MHz e 80-MHz; 

20. Deve suportar Space-time block coding (STBC) para aumentar o alcance e melhorar a 

recepção; 

21. Deve suportar verificação de paridade de baixa densidade (LDPC) para correção de erros de 

alta eficiência e aumento da taxa de transferência; 

22. Deve suportar Transmit beam-forming (TxBF); 

23. Deve possuir, no mínimo, as seguintes taxas de dados suportadas (Mbps): 

 

a. 802.11b: 1, 2, 5.5, 11 

b. 802.11a/g: 6, 9, 12, 18, 24, 36, 48, 54 

c. 802.11n: 6.5 até 450 (MCS0 até MCS23) 

d. 802.11ac: 6.5 até 1,733 (MCS0 até MCS9, NSS = 1 até 4) 

 

24. Deve possuir suporte a 802.11n de alto rendimento (HT): HT 20/40; 

25. Deve possuir suporte a 802.11ac de alta velocidade (VHT): VHT 20/40/80; 

26. Deve possuir suporte a agregação de pacotes 802.11n/ac: A-MPDU, A-MSDU; 
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Gerenciamento 

 

27. Deve implementar funcionamento de modo auto gerenciado, sem necessidade de 

controladora WLAN para configuração de seus parâmetros de rede wireless, gerenciamento das 

políticas de segurança, QoS e monitoramento de RF. 

28. Deve obedecer a todas as características descritas mesmo neste modo de funcionamento; 

29. No modo de funcionamento autogerenciado deve disponibilizar na interface gráfica 

informações de usuários conectados, qualidade de sinal e trafego de dados na rede; 

30. O ponto de acesso deve permitir a conversão de modo auto gerenciado para modo gerenciado 

por controlador WLAN através de interface gráfica, em browser padrão (HTTPS), e permitir que todos 

os demais pontos de acesso pertencentes ao mesmo cluster, também sejam convertidos 

automaticamente; 

31. O ponto de acesso deverá suportar conexão direta ou remota com controlador WLAN, inclusive 

via roteamento da camada de rede, baseado no modelo OSI; 

  

 

32. Se um controlador WLAN falhar, os Pontos de Acesso relacionados deverão se associar 

automaticamente a um controlador WLAN alternativo, não permitindo que a rede wireless se torne 

inoperante; 

33. Implementar mecanismo de funcionamento para trabalhar com controladores WLAN em 

redundância; 

34. Deve permitir que o ponto de acesso seja atualizado de forma centralizada pela interface 

gráfica; 

35. Permitir o armazenamento de sua configuração em memória não volátil, podendo, numa 

queda e posterior restabelecimento da alimentação, voltar à operação normalmente na mesma 

configuração anterior; 

36. Deve possuir servidor DHCP interno configurável; 

37. Possibilitar backup e restore da configuração através da interface gráfica; 

38. Deve possuir Portal Captivo (Captive Portal) integrado para utilização em rede de visitantes; 

39. Deve possuir mecanismos para proteção contra Pontos de Acesso não autorizados (Rogues); 

40. Possuir capacidade de identificação e listagem dos rádios vizinhos e respectivos SSID/BSSID; 
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41. Implementar associação dinâmica de usuários à VLANs com base nos parâmetros da etapa 

de autenticação; 

42. Deve possuir uma base de usuários interna que diferencie usuários visitantes de 

funcionários, para ser usada em autenticação 802.1x ou portal captivo; 

43. Permitir a autenticação para acesso dos usuários conectados nas redes WLAN (Wireless) 

através: 

 

a. MAC Address 

b. 802.1x em base Local 

c. Captive Portal 

d. 802.1x em base externa RADIUS 

e. 802.1x em base externa LDAP 

 

44. Deve permitir a seleção/uso de servidor de autenticação específico com base no SSID; 

45. Implementar o protocolo de enlace CSMA/CA para acesso ao meio de transmissão; 

46. Possuir capacidade de selecionar automaticamente o canal de transmissão; 

47. Permitir o ajuste dinâmico de nível de potência e canal de rádio de modo a otimizar o 

tamanho da célula de RF; 

48. Permitir habilitar e desabilitar a divulgação do SSID; 

49. Implementar diferentes tipos de combinações encriptação/autenticação por SSID; 

50. Implementar padrão WMM da Wi-Fi Alliance para priorização de tráfego, suportando 

aplicações em tempo real, tais como, VoIP, vídeo, dentre outras; 

51. Não deve haver no licenciamento restrições com relação ao número de dispositivos 

conectados por ponto de acesso; 

52. Implementar a pilha de protocolos TCP/IP com suporte a IPV4 e IPV6 (Bridging); 

53. Implementar VLANs conforme padrão IEEE 802.1Q; 

54. Possuir, no mínimo, uma interface IEEE 802.3 10/100/1000BaseT Ethernet, auto- sensing, 

auto MDI/MDX; 

55. Permitir a atualização remota do sistema operacional e arquivos de configuração através da 

controladora WLAN 

56. Implementar cliente DHCP, para configuração automática de rede; 
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57. Deve configurar-se automaticamente ao ser conectado na rede; 

58. Possuir LED’s indicativos do estado de operação, da atividade do rádio e da interface 

Ethernet; 

59. Possuir estrutura que permita fixação do equipamento em teto e parede e fornecer 

acessórios para que possa ser feita a fixação; 

  

 

60. Deve ser acompanhado de todos os acessórios necessários para operacionalização do 

equipamento, tais como: softwares, cabos de console, cabos de energia elétrica, documentação 

técnica e manuais (podendo ser em CD-ROM) que contenham informações suficientes para 

possibilitar a instalação, configuração e operacionalização do equipamento; 

61. Permitir o bloqueio da configuração do Ponto de Acesso via rede wireless; 

62. Implementar varredura de RF nas bandas 802.11a, 802.11b, 802.11g, 802.11n, para 

identificação de Pontos de Acesso intrusos não autorizados (rogues) e interferências no canal 

habilitado ao ponto de acesso e nos demais canais configurados na rede WLAN, sem impacto no seu 

desempenho; 

63. Implementar IEEE 802.1x, com pelo menos os seguintes métodos EAP: 

 

a. EAP- MD5 

b. EAP-FAST 

c. EAP-TLS 

d. PEAP-GTC 

e. PEAP-MSCHAPv2 

 

64. Permitir a integração com RADIUS Server com suporte aos métodos EAP citados; 

65. A comunicação entre todos os pontos de acesso sem fio e a controladora deverá ser 

criptografada; 

66. Suportar a autenticação com geração dinâmica de chaves criptográficas por sessão e por 

usuário; 

67. Implementar WPA com algoritmo de criptografia TKIP e MIC; 

68. Implementar WPA2 com algoritmo de criptografia AES, 128/256 bits, IEEE 802.11i; 
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69. Deve possuir modo dedicado de funcionamento de análise de espectro das faixas de 

frequência de 2.4 e 5 GHz identificando fontes de interferência nessas faixas; 

70. Deve possibilitar analise de espectro nos canais em que estiver provendo acesso, sem 

desconectar os usuários; 

71. Deve disponibilizar informações gráficas de análise de espectro em conjunto com o 

controlador WLAN; 

72. O equipamento deverá possuir registro na ANATEL e deverá ser apresentado na entrega do 

equipamento; 

73. Deverá prover priorização de trafego de vídeo e voz através de parâmetros de QoS (Quality 

os Service) com possibilidade de aplicar por SSID e dispositivo; 

74. Possibilitar roaming na rede wireless; 

75. Suportar a criação de uma rede de convidados autocontida com isolamento de tráfego 

entre clientes e serviços locais; 

76. Possuir recursos de seleção automática de canal de transmissão procurando por canais 

onde haja menor interferência, tendo por objetivo melhorar a performance da rede wireless; 

77. Permitir a operação em estrutura Mesh viabilizando a comunicação direta entre diferentes 

Pontos de Acesso sem Fio onde não seja possível estender a rede cabeada; 

78. Operando em estrutura Mesh, a comunicação entre os dispositivos estrutura deverão 

operar na frequência de 5Ghz. 

79. Possuir mecanismo para a restauração das configurações originais de fábrica fisicamente no 

equipamento (reset); 

80. Suportar operação em humidade de 5% a 95% sem condensação; 

81. Suportar operação em temperatura de até 40°C (quarenta graus centígrados); 

82. Possuir um MTBF (Mean Time Between Failure - Período Médio entre Falhas) de, no 

mínimo, 

250.000 horas. 

  

 

Garantia e Suporte 

 

1. O equipamento ofertado deverá possuir garantia do fabricante na modalidade on-site pelo 

período mínimo de 60 (sessenta) meses para reposição de peças, mão de obra e atendimento. O 

prazo máximo para atendimento do chamado deve ser de até o próximo dia útil após a sua abertura. 
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Durante o período da garantia o prazo máximo para o reparo de equipamentos defeituosos a 

condição normal de funcionamento deverá ser de até 07 (sete) dias úteis. 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 

informar em sua proposta o código de serviço de garantia do fabricante (“part number”), 

incorporada à solução. 

3. O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte 

técnico online como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de área para 

cadastro da solução de hardware ofertada, possibilitando assim que a CONTRATANTE possa receber 

de forma proativa, durante todo período da garantia as notificações de atualizações e correções 

(“hotfix”) da solução; 

4. A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 

para suporte técnico e abertura de chamados técnicos. 

5. Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução 

exigidos para os equipamentos, deverá ser comprovada a existência da assistência técnica local no 

domicílio da contratante e na modalidade on-site, devendo essa ser realizada por meio de 

documentação oficial do fabricante dos produtos e de domínio público, através de catálogos, folder 

impressos ou da internet, devendo constar o endereço URL na mesma. Caso não seja comprovada 

por um dos meios citados anteriormente, será possível a comprovação através da apresentação de 

documentação expressa do fabricante dos equipamentos, indicando a referida assistência técnica 

que será responsável pelo atendimento e manutenção durante o período de garantia dos produtos 

ofertados. Em caso de documentação expressa do fabricante a esta deverá ser anexada uma 

procuração que comprove que a fabricante outorga ao procurador os poderes para firmar e declarar 

as exigências solicitadas. 

6. Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio 

fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 

integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não realização 

da manutenção técnica pelo próprio fabricante quando solicitada. 

 

 

ITEM 28 – INJETOR POE PARA PONTOS DE ACESSO TIPO 1 

Características técnicas mínimas 

 

1. Deve ser do mesmo fabricante dos Pontos de acesso ou homologado e certificado pelo 

mesmo para utilização em seus equipamentos; 

2. Injetor PoE 802.3af 10/100/1000 Ethernet com 15.4W; 
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Garantia e Suporte 

 

1. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 

modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão de obra e 

atendimento no local. O período da garantia o prazo máximo para o reparo de 

  

 

equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) dias 

úteis; 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 

informar em sua proposta o código de serviço de garantia do fabricante (part number), incorporado 

ao equipamento; 

3. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio 

fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 

integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não realização 

da manutenção técnica pelo próprio fabricante quando solicitada. 

 

 

ITEM 29 – INJETOR POE PARA PONTOS DE ACESSO TIPO 2 

Características técnicas mínimas 

 

1. Deve ser do mesmo fabricante dos Pontos de acesso ou homologado e certificado pelo 

mesmo para utilização em seus equipamentos; 

2. Injetor PoE+ 802.3at 10/100/1000 Ethernet com 30W; 

 

 

Garantia e Suporte 

 

1. O equipamento ofertado deverá possuir garantia do fabricante do equipamento na 

modalidade on-site pelo período mínimo de 12 (doze) meses para reposição de peças, mão de obra e 
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atendimento no local. O período da garantia o prazo máximo para o reparo de equipamentos 

defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) dias úteis; 

2. Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá 

informar em sua proposta o código de serviço de garantia do fabricante (part number), incorporado 

ao equipamento; 

3. Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio 

fabricante ou estar em conformidade com a política de garantia do mesmo, não sendo permitida a 

integração de itens de terceiros que possam acarretar em perda parcial da garantia ou não realização 

da manutenção técnica pelo próprio fabricante quando solicitada. 

 

 

ITEM 30 – SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE TECNOLOGIA PARA SOLUÇÃO DE 

GERENCIAMENTO 

Características Gerais 

 

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das 14:00 às 18:00) 

presencialmente no TRE-AL ou remotamente conforme necessidades da CONTRATANTE; 

 

Implantação 

 

2. Instalação e configuração de 1 (uma) instância do serviço de gerenciamento de rede, 

contemplando: 

  

a. Configurações básicas para acesso à rede, dimensionamento e configuração de 

armazenamento; 

b. Inclusão de no mínimo 10 (dez) pontos de acesso no monitoramento; 

c. Criação de modelo de configuração (templates) de forma a possibilitar a replicação de 

configuração entre equipamentos. 

 

Transferência De Tecnologia 

 

3. O treinamento deverá ser no realizado na modalidade workshop com tarefas práticas 

hands- on, visando assim a melhor fixação dos temas abordados com foco direto na explicação da 
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tecnologia da solução como também nas rotinas de configuração, gerenciamento, administração e 

operação da mesma; 

 

4. O treinamento do MÓDULO DE GERENCIA DE REDE deverá ter duração mínima de 24 (vinte 

e quatro) horas onde será abordado, no mínimo, os seguintes tópicos: 

 

a. Inserção, modificação e remoção de dispositivos de forma unitária e em lote; 

b. Configuração de VLANs Globais e Locais em switchs gerenciados; 

c. Configuração de ACLS Globais e Locais em switchs gerenciados; 

d. Backup e restore de configuração de switchs gerenciados; 

e. Monitoramento e alarmes default e customizados; 

f. Customização do Dashboard com alertas, mapas de topologia e monitoramento de dispositivos; 

 

 

ITEM 31- SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE TECNOLOGIA DO MÓDULO DE 

CONTROLE DE ACESSO 

Características Gerais 

 

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das 14:00 às 18:00) 

presencialmente no TRE-AL ou remotamente conforme necessidades da CONTRATANTE; 

 

 

Implantação 

 

2. Instalação e configuração de 1 (uma) instancia do serviço controle de acesso, 

contemplando: 

 

a. Configurações básicas para acesso à rede, dimensionamento e configuração de 

armazenamento; 

b. Configuração de autenticação em Active Directory para usuários corporativos; 
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c. Configuração de autenticação de visitantes com portal de autosserviço para criação de 

usuários; 

d. Configuração de no mínimo 5 (cinco) dispositivos de rede para autenticação na solução. 

  

 

Transferência de Tecnologia 

 

3. O treinamento deverá ser no realizado na modalidade workshop com tarefas práticas 

hands- on, visando assim a melhor fixação dos temas abordados com foco direto na explicação da 

tecnologia da solução como também nas rotinas de configuração, gerenciamento, administração e 

operação da mesma devendo ter duração mínima de 24 (vinte e quatro) horas onde será abordado 

no mínimo os seguintes tópicos: 

 

a. Configuração de Active Directory como base de autenticação; 

b. Configuração de autenticação de usuários corporativos; 

c. Configuração de autenticação de usuários visitantes; 

d. Configuração de portal de autosserviço; 

e. Configuração de autenticação e autorização com protocolo RADIUS. 

 

ITEM 32– SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE TECNOLOGIA PARA CONTROLADORA 

WLAN E PONTOS DE ACESSO 

 

Características Gerais 

 

1. Os serviços serão realizados em horário de expediente (08:00 às 12:00 e das 14:00 às 18:00) 

presencialmente no TRE-AL ou remotamente conforme necessidades da CONTRATANTE; 

 

 

Implantação 

 

2. Instalação e configuração de no mínimo 10 (dez) pontos de acesso, contemplando: 
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a. Configuração básica de acesso a gerência via rede; 

b. Configuração de gerência e monitoramento em MÓDULO DE GERENCIA DE REDE; 

c. Configuração da autenticação de usuários em MÓDULO DE CONTROLE DE ACESSO 

d. Configuração de pontos de acesso em controladora WLAN habilitando gerenciamento 

centralizado; 

 

 

Transferência de Tecnologia 

 

3. O treinamento deverá ser no realizado na modalidade workshop com tarefas práticas 

hands- on, visando assim a melhor fixação dos temas abordados com foco direto na explicação da 

tecnologia dos produtos ofertados como também nas rotinas de configuração, gerenciamento, 

administração e operação dos mesmos devendo ter duração mínima de 16 (Dezesseis) horas onde 

será abordado no mínimo os seguintes tópicos: 

 

a. Configuração inicial e acesso a gerência; 

b. Configuração de Clusters; 

c. Configuração de autenticação de usuários em MÓDULO DE CONTROLE DE ACESSO; 

d. Criação de SSID com autenticação PSK; 

e. Criação de SSID com autenticação enterprise em MÓDULO DE CONTROLE DE ACESSO; 

f. Configuração de pontos de acesso para MÓDULO DE GERENCIA DE REDE; 

  

 

g. Configuração pontos de acesso para MÓDULO DE ANÁLISE DE TRÁFEGO; 

 

 

ITEM 33 – TREINAMENTO BÁSICO DE ADMINISTRAÇÃO DE ARQUITETURA WLAN 

 

Características Gerais 
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7. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do fabricante no 

Treinamento Básico De Administração De Arquitetura Wlan para 01 (um) profissional da contratante; 

8. O voucher deverá ter validade de pelo menos 12 (doze) meses; 

9. O treinamento deverá ser de acordo com o calendário de treinamento do fabricante e 

ministrado em centro oficial de treinamento do mesmo ou remotamente, utilizando tecnologia de 

ensino a distância; 

10. Deverá ser ministrado por profissional devidamente credenciado junto ao fabricante e apto 

a entregar o respectivo; 

11. O treinamento deverá compreender a explicação da tecnologia da solução como também das 

rotinas de configuração, gerenciamento, administração e operação da mesma; 

12. O treinamento deverá ter carga horária mínima de 20 (vinte) horas, ministrado no período de 

08:00 às 12:00 e das 14:00 às 18:00. 

 

 

ITEM 34 – TREINAMENTO BÁSICO DA SOLUÇÃO DE GERENCIAMENTO 

 

Características Gerais 

 

1. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do fabricante no 

Treinamento da Solução de Gerenciamento para 01 (um) profissional da contratante; 

2. O voucher deverá ter validade de pelo menos 12 (doze) meses; 

3. O treinamento deverá ser de acordo com o calendário de treinamento do fabricante e 

ministrado em centro oficial de treinamento do mesmo ou remotamente, utilizando tecnologia de 

ensino a distância; 

4. Deverá ser ministrado por profissional devidamente credenciado junto ao fabricante e apto 

a entregar o respectivo; 

5. O treinamento deverá compreender a explicação da tecnologia da solução como também 

das rotinas de configuração, gerenciamento, administração e operação da mesma; 

6. O treinamento deverá ter carga horária mínima de 40 (Quarenta) horas, ministrado no 

período de 08:00 às 12:00 e das 14:00 às 18:00. 

 

 

ITEM 35 – TREINAMENTO BÁSICO DA SOLUÇÃO DE CONTROLE DE ACESSO 
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Características Gerais 

  

 

7. O fornecimento desse item deverá contemplar 01 (um) voucher oficial do fabricante no 

Treinamento da Solução de Controle de Acesso para 01 (um) profissional da contratante; 

8. O voucher deverá ter validade de pelo menos 12 (doze) meses; 

9. O treinamento deverá ser de acordo com o calendário de treinamento do fabricante e 

ministrado em centro oficial de treinamento do mesmo ou remotamente, utilizando tecnologia de 

ensino a distância; 

10. Deverá ser ministrado por profissional devidamente credenciado junto ao fabricante e apto 

a entregar o respectivo; 

11. O treinamento deverá compreender a explicação da tecnologia da solução como também das 

rotinas de configuração, gerenciamento, administração e operação da mesma; 

12. O treinamento deverá ter carga horária mínima de 40 (Quarenta) horas, ministrado no período 

de 08:00 às 12:00 e das 14:00 às 18:00. 

PRAZO DE VALIDADE DA PROPOSTA: 60 (sessenta) dias, contados da data de abertura da sessão pública, 

conforme item 6.7, do edital em referência. 

 

PRAZOS DE ENTREGA:  

 

Conforme item 3.1 – O prazo máximo para entrega dos equipamentos é de 60 (sessenta) dias contados a partir 

do recebimento da Ordem de Fornecimento ou documento equivalente. 

Conforme item 3.2 – O prazo máximo para entrega dos softwares é de 30 (trinta) dias contados a partir do 

recebimento da Ordem de Fornecimento ou documento equivalente. 

 

SERVIÇOS DE INSTALAÇÃO, INTEGRAÇÃO, GARANTIA E SUPORTE 

Serão realizados diretamente pelo fabricante de acordo com as exigências contidas no descritivo dos mesmos, 

estando essas aderentes aos respectivos níveis de serviço necessários a cada uma deles. 
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Quanto aos itens do Lotes 01 e 02 – 1, 2, 3, 4, 20, 21, 22, 23 e 25, a garantia e o suporte do fabricante 
para a solução de software deverá ser ofertado pelo período de 36 (trinta e seis) meses, incluindo a 
evolução para novas versões sendo o atendimento na modalidade 24x7 (vinte quatro horas por dia, sete 
dias da semana), com tempo de resposta máximo em 4 (quatro) horas. 

 

Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá informar em sua 
proposta o código de serviço de garantia do fabricante (“part number”), incorporada à solução. 

 

O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte técnico online 

como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de área para cadastro da 
solução de software ofertada, possibilitando assim que a CONTRATANTE possa receber de forma 
proativa, durante todo período da garantia as notificações de atualizações e correções (“hotfix”) da 
solução. 

 

A empresa fabricante da solução de software deverá dispor de um número telefônico tipo 0800 55 64 05 
para suporte técnico e abertura de chamados técnicos. 

 

A comprovação da modalidade da garantia deverá ocorrer através de documentação do fabricante de 
domínio público, não sendo aceita documentação emitida pelo fornecedor ou centro de distribuição para 
fins de comprovação que por ventura conflitem com catálogos, manuais, folders oficiais impressos ou da 
internet (devendo constar o endereço URL para folders da web). Caso não seja comprovada por um dos 
meios citados anteriormente, será possível a comprovação através da apresentação de documentação 
expressa do fabricante dos softwares, indicando o período de garantia dos produtos ofertados. Em caso 
de documentação expressa do fabricante deverá ser anexada a mesma a procuração que comprove que a 
fabricante outorga ao procurador os poderes para firmar e declarar as exigências solicitadas. 

 
Quanto aos itens dos Lotes 01 e 02: 5, 8, 9, 10, 11, 24, 26 e 27, o equipamento ofertado deverá possuir 
garantia do fabricante na modalidade on-site pelo período mínimo de 60 (sessenta) meses para reposição 
de peças, mão de obra e atendimento. O prazo máximo para atendimento do chamado deve ser de até o 
próximo dia útil após a sua abertura. Durante o período da garantia o prazo máximo para o reparo de 
equipamentos defeituosos a condição normal de funcionamento deverá ser de até 07 (sete) dias úteis. 

Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá informar em sua 
proposta o código de serviço de garantia do fabricante (“part number”), incorporada à solução. 

 

O fabricante deve possuir canais de comunicação e ferramentas adicionais para suporte técnico online 
como “chat” e “e-mail” em seu site da internet com disponibilidade ainda de área para cadastro da solução 
de hardware ofertada, possibilitando assim que a CONTRATANTE possa receber de forma proativa, 
durante todo período da garantia as notificações de atualizações e correções (“hotfix”) da solução; 

 

A empresa fabricante do equipamento deverá dispor de um número telefônico tipo 0800 55 64 05  para 
suporte técnico e abertura de chamados técnicos. 

 

Para efeito de comprovação da garantia, suporte, dos níveis de atendimento e solução exigidos para os 
equipamentos, deverá ser comprovada a existência da assistência técnica local no domicílio da 
contratante e na modalidade on-site, devendo essa ser realizada por meio de documentação oficial do 
fabricante dos produtos e de domínio público, através de catálogos, folder impressos ou da internet, 
devendo constar o endereço URL na mesma https://www.hpe.com/br/pt/home.html. Caso não seja 
comprovada por um dos meios citados anteriormente, será possível a comprovação através da 
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apresentação de documentação expressa do fabricante dos equipamentos, indicando a referida 
assistência técnica que será responsável pelo atendimento e manutenção durante o período de garantia 
dos produtos ofertados. Em caso de documentação expressa do fabricante a esta deverá ser anexada 
uma procuração que comprove que a fabricante outorga ao procurador os poderes para firmar e declarar 
as exigências solicitadas. 

 

Todos os componentes instalados ou integrados dos equipamentos devem ser do próprio fabricante ou 
estar em conformidade com a política de garantia do mesmo, não sendo permitida a integração de itens 
de terceiros que possam acarretar em perda parcial da garantia ou não realização da manutenção técnica 
pelo próprio fabricante quando solicitada. 

 

Quanto aos itens dos Lotes 01 e 02 06, 07, 12, 13, 14, 15, 28 e 29, O equipamento ofertado deverá 
possuir garantia do fabricante do equipamento na modalidade on-site pelo período mínimo de 12 (doze) 
meses para reposição de peças, mão de obra e atendimento no local. O período da garantia o prazo 
máximo para o reparo de equipamentos defeituosos a condição normal de funcionamento deverá ser de 
até 07 (sete) dias úteis. 

 

Caso a garantia padrão do fabricante seja menor que a exigida, a proponente deverá informar em sua 
proposta o código de serviço de garantia do fabricante (part number), incorporado ao equipamento. 

 

Por questões de compatibilidade, gerencia, suporte e garantia, deve ser do próprio fabricante ou estar em 
conformidade com a política de garantia do mesmo, não sendo permitida a integração de itens de terceiros 
que possam acarretar em perda parcial da garantia ou não realização da manutenção técnica pelo próprio 
fabricante quando solicitada. 
 

FORMA DE PAGAMENTO: Conforme item 21 do Edital. 

 

LOCAL DE ENTREGA:  

De  segunda  a  sexta-feira,  na  Seção  de  Almoxarifado  do Tribunal  Regional  Eleitoral  de  Alagoas,  

localizada  na  Avenida  Menino  Marcelo (antiga  via  expressa),  nº  7.200D  –  Serraria,  Maceió/AL,  CEP:  

57046-005,  sob agendamento através do telefone (82) 3328-1947; 

A. Horário: De segunda-feira a quinta-feira das 13 às 19 e sexta-feira das 7h30min às 13h30min. 

 

Procedência: Importado, adquirido no mercado nacional, através da Hewlett-Packard Enterprise do Brasil e 

seus Distribuidores credenciados no Brasil. 

 

ASSISTÊNCIA TÉCNICA AUTORIZADA:  

Será prestada através da Assistência Técnica Autorizada HPE: 

SUPRISERVI COMERCIO REPRESENTAÇÕES LTDA 

Rua Deputado José Lages, 972 – Térreo, SL 07 – Ponta Verde – Maceió/AL 

Proposta EMPRESA PLUGNET (0592496)         SEI 0008478-63.2018.6.02.8000 / pg. 958



                                                       ‘                 

 
PLUGNET COMÉRCIO E 

REPRESENTAÇÕES LTDA        

Insc. Estadual Nº. - 024144495 
C.N.P.J. Nº. - 02.213.325/0001-88 
www.plugnetshop.com.br 
 

 

MATRIZ – RECIFE / PE 

Rua General Abreu e Lima, Nº 222 
Rosarinho – 52.041-040  
Fone/Fax: 81 3426.7006 
plugnet@plugnetshop.com.br 

 

FILIAL – BELÉM / PA 

Av. Romulo Maiorana, nº 700 – 
Sala 1709 – Marco – Belém/PA – 

CEP: 66.093-672  
plugnetpa@plugnetshop.com.br 

 

FILIAL – JOÃO PESSOA / PB 

Av. Nossa Senhora dos 
 Navegantes, 104 / 402 Tambaú 

Fone/Fax: 83 3226.1422 
plugnetpb@plugnetshop.com.br 

 

 

 

    

 

 

CEP: 57.035-330 

CNPJ: 12.707.105/0001-64 

 

CHAMADOS VIA 0800 HPE -  0800 55 64 05   

 

IMPOSTOS, FRETES, TAXAS, SEGUROS E DEMAIS ENCARGOS: Incluso no preço dos equipamentos. 

 
Alíquota do ICMS no Estado de Pernambuco: 18% 
 
Dados da empresa: 
Razão Social: Plugnet Comércio e Representações LTDA 
Inscrição Estadual: Nº. - 024144495 
CNPJ Nº.: 02.213.325/0001-88  
Endereço: Rua General Abreu e Lima, 222 Rosarinho, Recife-PE. CEP: 52050-050. 
Fone/Fax: 81 3426.7006  
 
 
 
Dados Bancários: 
Banco: Banco do Brasil S.A. – 001 
Agência: Casa Forte – 1509-1 (Recife – PE) 
Conta Corrente: 9.075-1 
 
 
Dados do responsável para assinatura do contrato: 
Nome : Breno José de Araújo Tavares 
Estado Civil: Casado 
Profissão : Empresário 
RG: 1.862.424 – SSP/RN 
CPF: 376.381.144-34 
Endereço : Rua Jorge de Albuquerque, 31, Apto. 1201, Casa Forte, Recife/PE, CEP: 52.061-100 
 
 
 
Atenciosamente, 
 
 
Plugnet Comércio e Representações Ltda 
Breno José de Araujo Tavares 
(81) 3426-7006 
Diretor 
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Aruba ClearPass Policy Manager Platform
The most advanced Secure NAC platform available
 

 

Product overview
 
Aruba's ClearPass Policy Manager, part of the Aruba 360 Secure Fabric, provides role- and device-based
secure network access control for IoT, BYOD, Corporate devices, the employees, contractors and guests
across any multivendor wired, wireless and VPN infrastructure that use them.
 
With a built-in context-based policy engine, RADIUS, TACACS+, non-RADIUS enforcement using
OnConnect, device profiling, posture assessment, onboarding, and guest access options, ClearPass is
unrivaled as a foundation for network security for organizations of any size.
 
For comprehensive integrated security coverage and response using firewalls, EMM/MDM and other
existing solutions, ClearPass supports the Aruba 360 Security Exchange Program. This allows for
automated threat detection and response workflows that integrate with third-party security vendors and IT
systems previously requiring manual IT intervention.
 
In addition, ClearPass supports secure self-service capabilities making it easier for end users trying to
access the network. Users can securely configure their own devices for enterprise use or Internet access.
Aruba wireless customers in particular can take advantage of the enhanced security of their AirGroup
environment as well as ClearPass Auto Sign-On. This enables a user's network authentication to pass
automatically to their enterprise mobile apps so they can get right to work.
 
The result is detailed visibility of all wired and wireless devices connecting to the enterprise, increased
control through simplified and automated authentication or authorization of devices, and faster, better
incident analysis and response through the integration of Aruba IntroSpect UEBA and third-party partner
ecosystems.  This is achieved with a comprehensive and scalable policy management platform that goes
beyond traditional AAA solutions to deliver extensive enforcement capabilities for IT-owned and bring-your-
own-device (BYOD) security requirements.

Key Features
Role-based network access enforcement for multi-vendor Wireless, wired and VPN networks.
Virtual and hardware appliances that can be deployed in a cluster to increase scalability and
redundancy.
Intuitive policy configuration templates and visibility troubleshooting tools.
Supports multiple authentication/authorization sources (AD, LDAP, SQL dB).
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Self-service device onboarding with built-in certificate authority (CA) for BYOD
Guest access with extensive customization, branding and sponsor-based approvals.
Supports NAC and EMM/MDM integration for mobile device assessments.
Comprehensive integration with the Aruba 360 Security Exchange Program.
Single sign-on (SSO) support works with Ping, Okta and other identity management tools to improve
user experience to SAML 2.0-based applications.
Advanced reporting and granular alerts
Active and passive device fingerprinting
Support for popular virtualizations platforms such as VMware vSphere Hypervisor (ESXi), Microsoft
Hyper-V, CentOS KVM & Amazon EC2.

The ClearPass Difference
ClearPass is the only policy platform that centrally enforces all aspects of enterprise-grade access security for any industry.
Granular policy enforcement is based on a user's role, device type and role, authentication method, EMM/MDM attributes,
device health, traffic patterns, location, and time-of-day.

ClearPass offers extensive multi-vendor wireless, wired and VPN infrastructure support which enables IT to easily rollout
secure mobility policies across any environment.

Deployment scalability supports tens of thousands of devices and authentications which surpasses the
capabilities offered by legacy AAA solutions. Options exist for small to large organizations, from centralized
to distributed environments.

Advanced Policy Management
Enforcement and visibility for wired and wireless
With ClearPass, organizations can deploy wired or wireless using standards-based 802.1X enforcement for
secure authentication. ClearPass also supports MAC address authentication for IoT and headless devices
that may lack support for 802.1X. For wired environments where RADIUS based authentication cannot be
deployed, OnConnect, offers an alternative using SNMP based enforcement.
Authentication methods can be used to concurrently support a variety of use-cases. It also includes support
for multi-factor authentication based on log-in times, posture checks, and other context such as new user,
new device, and more.
Attributes from multiple identity stores such as Microsoft Active Directory, LDAP-compliant directory, ODBC-
compliant SQL database, token servers and internal databases across domains can be used within a single
policy for fine- grained control.
Contextual data from these profiled devices allows for IT to define what devices can access either the wired,
VPN, or wireless network. Device profile changes are dynamically used to modify authorization privileges.
For example, if a Windows laptop appears as a printer, ClearPass policies can automatically revoke or deny
access.
 
Secure device configuration
ClearPass Onboard provides automated provisioning of any Windows, macOS, iOS, Android, Chromebook,
and Ubuntu devices via a user driven self-guided portal. Network details, security settings and unique
device identity certificates are automatically configured on authorized devices. Cloud identity services like
Microsoft Azure Active Directory, Google G Suite and Okta can also be leveraged as identity providers with
Onboard for secure certificate enrollment.
 
Device health checks
ClearPass OnGuard leverages persistent and dissolvable agents to perform advanced endpoint posture
assessments over wireless, wired and VPN connections. OnGuard's health-check capabilities ensure
compliance and network safeguards before devices connect.
 
Customizable Visitor Management
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ClearPass Guest simplifies visitor workflow processes to enable employees, receptionists, and other non-IT
staff to create temporary guest accounts for secure wireless and wired access.  Highly customizable, mobile
friendly portals provide easy-to-use login processes that include self-registration, sponsor approval, and
bulk credential creation support any visitor needs ### enterprise, retail, education, large public venue. 
Credentials can be delivered by SMS, email, printed badges, or input directly through cloud identity
providers such as Facebook or Twitter.
Built in support for commercial oriented guest Wi-Fi hotspots with credit card billing and 3rd party
advertising driven workflows make it simple to integrate into a wide variety of environments.

Aruba 360 Security Exchange Program
Integrate with security and workflow systems
Support for the Aruba 360 Security Exchange Program is an integrated component of ClearPass. Using
features like REST-based APIs, RADIUS Accounting Proxy, and Syslog ingestion help facilitate workflows
with EMM/MDM, SIEM, firewalls, help-desk systems and more. Context is shared between each component
for end-to-end policy enforcement and visibility.
The ClearPass Ingress Event Engine provides 3rd party systems the means to share information in real-
time using Syslog. This enables ClearPass to respond to changing threats for users and devices after they
have authenticated to the network. By utilizing an open dictionary approach, anyone can write a parsing
ruleset without the need for costly add-ons or locked in 3rd party ecosystems.

Advanced Reporting and Alerting
ClearPass Insight provides advanced reporting capabilities via customizable reports. Information about
authentication trends, profiled devices, guest data, on-boarded devices, and endpoint health can also be
viewed in an easy to use dashboard. Insight also has support for granular alerts and a watchlist to monitor
specific authentication failures.

Specifications
Appliances
ClearPass is available as hardware or as a virtual appliance.
Virtual appliances are supported on VMware vSphere Hypervisor (ESXi), Microsoft Hyper-V, CentOS KVM
& Amazon EC2.

VMware ESXi 5.5 up to 6.5 Update 1
Microsoft Hyper-V 2012/2016 R2 and Windows 2012/2016 R2 Enterprise
KVM on CentOS 6.6, 6.7 and 6.8
Amazon EC2

 
Platform

Deployment templates for any network type, identity store and endpoint
802.1X, MAC authentication and captive portal support
ClearPass OnConnect for SNMP-based enforcement on wired switches
Advanced reporting, analytics and troubleshooting tools
Interactive policy simulation and monitor mode utilities
Multiple device registration portals - Guest, Aruba AirGroup, BYOD, and un-managed devices
Admin/operator access security via CAC and TLS certificates

 
Framework and protocol support

RADIUS, RADIUS CoA, TACACS+, web authentication, SAML v2.0
EAP-FAST (EAP-MSCHAPv2, EAP-GTC, EAP-TLS)
PEAP (EAP-MSCHAPv2, EAP-GTC, EAP-TLS, EAP-PEAP-Public, EAP-PWD)
TTLS (EAP-MSCHAPv2, EAP-GTC, EAP- TLS, EAP-MD5, PAP, CHAP)
EAP-TLS
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PAP, CHAP, MSCHAPv1 and 2, EAP-MD5
OAuth2
Windows machine authentication
SMB v2/v3
Online Certificate Status Protocol (OCSP)
SNMP generic MIB, SNMP private MIB
Common Event Format (CEF), Log Event Extended Format (LEEF)

 
Supported identity stores

Microsoft Active Directory
RADIUS
Any LDAP compliant directory
MySQL, Microsoft SQL, PostGRES and Oracle 11g ODBC-compliant SQL server
Token servers
Built-in SQL store, static hosts list
Kerberos
Microsoft Azure Active Directory
Google G Suite

 
RFC standards

2246, 2248, 2407, 2408, 2409, 2548, 2759, 2865, 2866, 2869, 2882, 3079, 3576, 3579, 3580, 3748,
3779, 4017, 4137, 4301, 4302, 4303, 4308, 4346, 4514, 4518, 4809, 4849, 4851, 4945, 5216, 5246,
5280, 5281, 5282, 5755, 5759, 6818, 6960, 7030, 7296, 7321, 7468, 7815, 8032, 8247

 
Internet drafts

Protected EAP Versions 0 and 1, Microsoft CHAP extensions, dynamic provisioning using EAP-FAST,
TACACS+, draft-ietf-curdle-pkix-00 EdDSA, Ed25519, Ed448, Curve25519 and Curve448 for X.509,
draft-nourse-scep-23 (Simple Certificate Enrollment Protocol)

 
Profiling methods

Active: Nmap, WMI, SSH, SNMP
Passive: MAC OUI, DHCP, TCP, Netflow v5/v10, IPFIX, sFLOW, 'SPAN' Port, HTTP User-Agent, IF-
MAP
Integrated & 3rd Party: Onboard, OnGuard, ArubaOS, EMM/MDM, Rapid7, Cisco device sensor

 
IPv6 Support

Web and CLI based management
IPv6 addressed authentication & authorization servers
IPv6 accounting proxy
IPv6 addressed endpoint context servers
Syslog, DNS, NTP, IPsec IPv6 targets
IPv6 Virtual IP for high availability
HTTP Proxy
Ingress Event Engine Syslog sources

 
Information assurance validations

FIPS 140-2 - Certificate #2577
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Ordering Guidance
Please refer to the ClearPass Scaling & Ordering Guide for detailed information on appropriate sizing and
required licensing to deploy ClearPass. This can be found on the Aruba support website in the ClearPass
documentation section.
   

Ordering Information
   
Description Part Number
   
Hardware Appliances  
Aruba ClearPass C1000 S-1200 R4 HW-Based Appliance JZ508A
Aruba ClearPass C2000 DL20 Gen9 HW-Based Appliance JZ509A
Aruba ClearPass C3000 DL360 Gen9 HW-Based Appliance JZ510A
   
Virtual Appliances  
Aruba ClearPass Cx000V VM-Based Appliance E-LTU JZ399AAE
   
Power Supplies  
Aruba ClearPass DL20 Spare Power Supply JX923A
Aruba ClearPass-Airwave DL360 500W Spare Power Supply JX922A
   
Software Licenses*  
ClearPass Access- 802.1X, MAC-Auth, Guest, TACACS+, OnConnect, Endpoint Profiling & ClearPass
Exchange
(Licensed per maximum number of endpoints concurrently connected per day)
   
ClearPass OnBoard - Network details, security settings and unique device identity certificates
(Licensed per maximum number of users with active certificates)
   
ClearPass OnGuard - Endpoint device health
(Licensed per number of endpoints using OnGuard per day)
   
   
Warranty  
1 year parts** Hardware
90 days** Software
   
*Software licenses are available in the following increments: 100, 500, 1,000, 2,500, 5,000, and 10,000
** Extended with support contract  
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C1000 Appliance
(JZ508A)

C2000 Appliance
(JZ509A)

C3000 Appliance
(JZ510A)

 

Hardware Model Unicom S-1200 R4 HPE DL20 Gen 9 HPE DL360 Gen 9

CPU
(1) Eight Core 2.4GHz Atom

C2758

(1) Xeon 3.5Ghz E3-
1240v5 with Four Cores

(8 Threads)

(2) Xeon 2.4GHz E5-
2620_V3 with Six Cores

(12 Threads)

Memory 8 GB 16 GB 64 GB

Hard drive storage
(1) SATA (7.3K RPM)

1TB hard drive

(2) SATA (7.2K RPM) 1TB
hard drives, RAID-1

controller

(6) SAS (10K RPM)
600GB Hot-Plug hard

drives, RAID-10
controller

Out of Band
Management

N/A HPE Integrated Lights-Out
(iLO) Standard

HPE Integrated Lights-
Out (iLO) Advanced

Serial Port Yes (RJ-45) Yes (Virtual Serial via iLO) Yes (DB-9)

Performance & Scale
Please refer to the

ClearPass  Scaling &
Ordering Guide

Please refer to the
ClearPass  Scaling &

Ordering Guide

Please refer to the
ClearPass  Scaling &

Ordering Guide

Form Factor

Dimensions (WxHxD) 17.2"? x 1.7"? x 11.3"? 17.11"? x 1.70"? x 15.05"? 17.1"? x 1.7"? x 27.5"?

Weight (Max Config) 8.5 Lbs Up to 19.18 Lbs Up to 33.3 Lbs

Power

Power supply 200 watts max
HPE 900W AC 240VDC

Power Input FIO Module*

HPE 500W Flex Slot
Platinum Hot Plug Power

Supply

Power redundancy N/A Optional Optional

AC input voltage 100/240 VAC auto-selecting 100/240 VAC auto-selecting 100/240 VAC auto-selecting
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AC input frequency 50/60 Hz auto-selecting 50/60 Hz auto-selecting 50/60 Hz auto-selecting

Environmental

Operating temperature
5º C to 35º C

(41º F to 95º F)
10º C to 35º C
(50º F to 95º F)

10º C to 35º C
(50º F to 95º F)

Operating vibration 0.25 G at 5 Hz to 200 Hz for 15
minutes

Random vibration at 0.000075
G²/Hz, 10Hz to 300Hz, (0.15

G's nominal)

Random vibration at 0.000075
G²/Hz, 10Hz to 300Hz, (0.15

G's nominal)

Operating shock 1 shock pulse of 20 G for up to
2.5 ms 2 G's 2 G's

Operating altitude -16 m to 3,048 m
(-50 ft to 10,000 ft)

3,050 m (10,000 ft) 3,050 m (10,000 ft)

 
*The HPE 900W Redundant Power Supply supports100VAC to 240VAC and also supports 240VDC..
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Date Version History Action Description of Change
18-Dec-2017 From Version 3 to 4 Changed Minor edit on Configuration section
04-Dec-2017 From Version 2 to 3 Added SKUs added: JZ508A, JZ509A,

JZ510A, JZ399AAE, JX923A
Changed All document sections updated

07-Nov-2016 From Version 1 to 2 Added SKUs added: JW771A, JW772A
01-Nov-2016 Version 1 Created Document creation.

     

Sign up for updates

 

 
  © Copyright 2017 Hewlett Packard Enterprise Development LP. The

information contained herein is subject to change without notice. The only
warranties for Hewlett Packard Enterprise products and services are set forth
in the express warranty statements accompanying such products and
services. Nothing herein should be construed as constituting an additional
warranty. Hewlett Packard Enterprise shall not be liable for technical or
editorial errors or omissions contained herein.

To learn more, visit: http://www.hpe.com/networking
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Aruba ClearPass Guest Software
A ClearPass Policy Manager Application
 

 

Product overview
 
ClearPass Guest is a scalable, easy-to-use visitor management solution that delivers secure automated guest access
workflows for visitors, contractors, partners, shoppers and fans on wireless and wired networks using any type of mobile
device.

Self-registration and sponsor involved options ensure credentials and pre-authorized access privileges are enforced for
short-term and long-term guests, without putting a heavy burden on IT, receptionists and staff.

Once registered, credentials can be delivered via SMS text, email, or printed badges. Accounts can be set to expire
automatically after a specified number of hours or days.

Designed for organizations of all sizes, Aruba's ClearPass Guest solution offers the security and automation to support
hundreds or thousands of guests, while also reducing the threats that come with unauthorized guest access and possible
risks.

The ClearPass Advantages

ClearPass Guest operates on the ClearPass Policy Manager platform, which offers a core set of authentication,
authorization, accounting, profiling of devices, reporting and policy enforcement capabilities. This ensures that the platforms
scalability, redundancy, management and reporting features can be leveraged for guest and any employee-based policy
enforcement needs.

Features and Benefits
 
Key Features

Self-registration - highly customizable guest portal provides easy-to-use login process that also deters
unwanted users from requesting access
Customizable branding - logos, visual imagery and optional advertisements provide an opportunity to
extend company messaging, and promote mobile apps and offers
Automated credential delivery - registration process can deliver SMS text, email or printed credentials
depending on security requirements
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Mobile device awareness - captive portal is automatically sized for smart phones, tablets and laptops
Industry leading scalability - enterprise and high capacity guest modes provide options for any type of
organization
Secure guest access - industry's only login and traffic encryption option for public networks
Social logins - functionality that enables retailers and public venues to gather valuable demographics
about guests that opt-in to guest Wi-Fi using Facebook, Twitter or other credentials
Third-party integration - customizable workflows using rest-based API's for delivering streamlined
registration and payment system integration for hospitality and healthcare
Hotspot management - built-in support for commercial oriented guest Wi-Fi hotspots with support for
credit card billing

Enterprise-grade security for guest networks
Aruba's PEAP-Public is the industry's only secure enterprise-grade encryption method for public guest
access. Unique authentication method ensures that all guest connections and traffic are encrypted. 
Role-based policy enforcement
Guest access privileges can be customized to enforce bandwidth limits, access to specific resources and
length of connections. MAC caching can be also be used for a set period of time to ensure that guests are
not repeatedly asked to enter login and passwords each time they re-connect to the guest network. 
High-capacity guest support
An optional high-capacity guest (HCG) mode provides the scalability needed for any airport, conference
center, or other large venue where guests normally visit for shorter periods than when visiting an enterprise.
Capacity of the Policy Manager appliance is doubled in HCG mode.

Advanced Guest Features 
Highly customizable guest portals
Customizable login pages provide the ability to display the latest corporate branding, messaging and
promotional offers. The ability to display separate captive portals where multiple departments, stores or
divisions exist is also supported. Data entry field customization allows for capturing additional information
about guests, support for rotating background images and a variety of built-in remediation pages allow full
portal customization for a variety of business uses.
Acceptance of Use acknowledgement is also supported. 
Social logins
Built-in support for functionality that enables retailers and public venues to gather valuable demographics
about guests that opt-in to guest Wi-Fi using Facebook, Twitter and other social media credentials.
Advertising services
Built-in advertisement module and support for external services enables marketing organizations to easily
promote special offers, multimedia content and mobile applications each time a guest registers for
credentials. 
Third-party ClearPass Exchange Integration
Automate the generation of guest credentials by integrating ClearPass Guest with leading property
management, patient management and other third-party systems such as: Micros OPERA PMS, Protel
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1.

a.

b.

2.

3.

PMS, Silverbyte Optima PMS, Agilysis Visual One PMS, and more.

Ordering Guidance 
ClearPass Guest can be purchased through subscription licensing for 1, 3, or 5 year periods or via
perpetual licenses. Optional enterprise licensing enables organizations to selectively choose ClearPass
Guest, Onboard or OnGuard based on their immediate licensing needs.
 Ordering ClearPass Guest involves the following three steps: 

Determine the number of unique visitor devices that will be supported on a daily basis.
Choose the appropriate ClearPass Policy Manager hardware or virtual appliance to accommodate the
total number from above.

In standard mode, you must have adequate Policy Manager Capacity to support an accumulative
number of devices over a 7 day period.
In HCG mode, both Guest license and the Policy Manager's capacity are refreshed on a daily
basis.

Additional Policy Manager Appliances can be added to a cluster to support growth and redundancy
requirements.
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Ordering Information
   
Description Part Number
Guest Perpetual Part Numbers  
Aruba ClearPass Guest 100 Endpoint License E-LTU JW586AAE
Aruba ClearPass Guest 500 Endpoint License E-LTU JW587AAE
Aruba ClearPass Guest 1K Endpoint License E-LTU JW588AAE
Aruba ClearPass Guest 2500 Endpoint License E-LTU JW589AAE
Aruba ClearPass Guest 5K Endpoint License E-LTU JW590AAE
Aruba ClearPass Guest 10K Endpoint License E-LTU JW591AAE
Aruba ClearPass Guest 25K Endpoint License E-LTU JW592AAE
Aruba ClearPass Guest 50K Endpoint License E-LTU JW593AAE
Aruba ClearPass Guest 100K Endpoint License E-LTU JW594AAE
   
Enterprise Perpetual Part Number  
Aruba ClearPass Enterprise 100 Endpoint License E-LTU JW595AAE
Aruba ClearPass Enterprise 100K Endpoint License E-LTU JW603AAE
Aruba ClearPass Enterprise 10K Endpoint License E-LTU JW600AAE
Aruba ClearPass Enterprise 1K Endpoint License E-LTU JW597AAE
Aruba ClearPass Enterprise 2500 Endpoint License E-LTU JW598AAE
Aruba ClearPass Enterprise 25K Endpoint License E-LTU JW601AAE
Aruba ClearPass Enterprise 500 Endpoint License E-LTU JW596AAE
Aruba ClearPass Enterprise 50K Endpoint License E-LTU JW602AAE
Aruba ClearPass Enterprise 5K Endpoint License E-LTU JW599AAE
   
Guest Subscription Part Numbers  
Aruba ClearPass Guest 100 Endpoint Licenses 1-Year Subscription E-STU JW392AAE
Aruba ClearPass Guest 100K Endpoint Licenses 1-Year Subscription E-STU JW400AAE
Aruba ClearPass Guest 10K Endpoint Licenses 1-Year Subscription E-STU JW397AAE
Aruba ClearPass Guest 1K Endpoint Licenses 1-Year Subscription E-STU JW394AAE
Aruba ClearPass Guest 2500 Endpoint Licenses 1-Year Subscription E-STU JW395AAE
Aruba ClearPass Guest 25K Endpoint Licenses 1-Year Subscription E-STU JW398AAE
Aruba ClearPass Guest 500 Endpoint Licenses 1-Year Subscription E-STU JW393AAE
Aruba ClearPass Guest 50K Endpoint Licenses 1-Year Subscription E-STU JW399AAE
Aruba ClearPass Guest 5K Endpoint Licenses 1-Year Subscription E-STU JW396AAE
Aruba ClearPass Guest 100 Endpoint Licenses 3-Year Subscription E-STU JW401AAE
Aruba ClearPass Guest 100K Endpoint Licenses 3-Year Subscription E-STU JW409AAE
Aruba ClearPass Guest 10K Endpoint Licenses 3-Year Subscription E-STU JW406AAE
Aruba ClearPass Guest 1K Endpoint Licenses 3-Year Subscription E-STU JW403AAE
Aruba ClearPass Guest 2500 Endpoint Licenses 3-Year Subscription E-STU JW404AAE
Aruba ClearPass Guest 25K Endpoint Licenses 3-Year Subscription E-STU JW407AAE
Aruba ClearPass Guest 500 Endpoint Licenses 3-Year Subscription E-STU JW402AAE
Aruba ClearPass Guest 50K Endpoint Licenses 3-Year Subscription E-STU JW408AAE
Aruba ClearPass Guest 5K Endpoint Licenses 3-Year Subscription E-STU JW405AAE
Aruba ClearPass Guest 100 Endpoint Licenses 5-Year Subscription E-STU JW410AAE
Aruba ClearPass Guest 100K Endpoint Licenses 5-Year Subscription E-STU JW418AAE
Aruba ClearPass Guest 10K Endpoint Licenses 5-Year Subscription E-STU JW415AAE
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Aruba ClearPass Guest 1K Endpoint Licenses 5-Year Subscription E-STU JW412AAE
Aruba ClearPass Guest 2500 Endpoint Licenses 5-Year Subscription E-STU JW413AAE
Aruba ClearPass Guest 25K Endpoint Licenses 5-Year Subscription E-STU JW416AAE
Aruba ClearPass Guest 500 Endpoint Licenses 5-Year Subscription E-STU JW411AAE
Aruba ClearPass Guest 50K Endpoint Licenses 5-Year Subscription E-STU JW417AAE
Aruba ClearPass Guest 5K Endpoint Licenses 5-Year Subscription E-STU JW414AAE
   
Enterprise Subscription Part Numbers  
Aruba ClearPass Enterprise 100 Endpoint Licenses 1-Year Subscription E-STU JW338AAE
Aruba ClearPass Enterprise 100K Endpoint Licenses 1-Year Subscription E-STU JW346AAE
Aruba ClearPass Enterprise 10K Endpoint Licenses 1-Year Subscription E-STU JW343AAE
Aruba ClearPass Enterprise 1K Endpoint Licenses 1-Year Subscription E-STU JW340AAE
Aruba ClearPass Enterprise 2500 Endpoint Licenses 1-Year Subscription E-STU JW341AAE
Aruba ClearPass Enterprise 25K Endpoint Licenses 1-Year Subscription E-STU JW344AAE
Aruba ClearPass Enterprise 500 Endpoint Licenses 1-Year Subscription E-STU JW339AAE
Aruba ClearPass Enterprise 50K Endpoint Licenses 1-Year Subscription E-STU JW345AAE
Aruba ClearPass Enterprise 5K Endpoint Licenses 1-Year Subscription E-STU JW342AAE
Aruba ClearPass Enterprise 100 Endpoint Licenses 3-Year Subscription E-STU JW347AAE
Aruba ClearPass Enterprise 100K Endpoint Licenses 3-Year Subscription E-STU JW355AAE
Aruba ClearPass Enterprise 10K Endpoint Licenses 3-Year Subscription E-STU JW352AAE
Aruba ClearPass Enterprise 1K Endpoint Licenses 3-Year Subscription E-STU JW349AAE
Aruba ClearPass Enterprise 2500 Endpoint Licenses 3-Year Subscription E-STU JW350AAE
Aruba ClearPass Enterprise 25K Endpoint Licenses 3-Year Subscription E-STU JW353AAE
Aruba ClearPass Enterprise 500 Endpoint Licenses 3-Year Subscription E-STU JW348AAE
Aruba ClearPass Enterprise 50K Endpoint Licenses 3-Year Subscription E-STU JW354AAE
Aruba ClearPass Enterprise 5K Endpoint Licenses 3-Year Subscription E-STU JW351AAE
Aruba ClearPass Enterprise 100 Endpoint Licenses 5-Year Subscription E-STU JW356AAE
Aruba ClearPass Enterprise 100K Endpoint Licenses 5-Year Subscription E-STU JW364AAE
Aruba ClearPass Enterprise 10K Endpoint Licenses 5-Year Subscription E-STU JW361AAE
Aruba ClearPass Enterprise 1K Endpoint Licenses 5-Year Subscription E-STU JW358AAE
Aruba ClearPass Enterprise 2500 Endpoint Licenses 5-Year Subscription E-STU JW359AAE
Aruba ClearPass Enterprise 25K Endpoint Licenses 5-Year Subscription E-STU JW362AAE
Aruba ClearPass Enterprise 500 Endpoint Licenses 5-Year Subscription E-STU JW357AAE
Aruba ClearPass Enterprise 50K Endpoint Licenses 5-Year Subscription E-STU JW363AAE
Aruba ClearPass Enterprise 5K Endpoint Licenses 5-Year Subscription E-STU JW360AAE
   
Customization Service  
User portal customization service AMG-SKIN-PS
   
Warranty  
90 days** Software
   
* Subscription and enterprise licenses can be purchased in 1-, 3- and 5-year increments for 100, 500, 1,000,
2,500, 5,000, 10,000, 25,000, 50,000, and 100,000 endpoints
** Extended with support contract  
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Date Version History Action Description of Change
16-Oct-2017 Form Version 1 to 2 Changed Aruba information updated
01-Nov-2016 Version 1 Created Document creation.
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Aruba ClearPass OnBoard Software
A ClearPass Policy Manager Application
 

Product overview
Automated mobile device provisioning and configuration for secure BYOD

ClearPass Onboard automatically configures and provisions mobile devices - Windows desktop, macOS, iOS, Android,
Chromebook, and Ubuntu - enabling them to securely connect to enterprise networks in support of BYOD initiatives.
IT can automatically give employees, contractors and partners permission to self-configure their personal devices. The
ClearPass Onboard portal dynamically detects a device's operating system and guides the user through the appropriate
steps.
This provides an incredibly simple way to configure wireless, wired and VPN settings, apply unique per device certificates
and profiles and ensure that users can securely connect their devices to 802.1X- enabled networks with minimal IT
interaction.
ClearPass Onboard also increases the amount of usable context for troubleshooting, user- and device-based policies and
compliance reporting per each device.
The result is a streamlined workflow that allows IT helpdesk personnel to efficiently automate multiple processes that are
required to successfully carry out BYOD initiatives while offloading IT and improving the user experience.

Key Features
 

Enables users to self-register and securely onboard multiple devices
Supports Windows, macOS, iOS, Android, Chromebook and Ubuntu operating systems
Sponsor-based onboarding allows for custom workflows
Active Directory and cloud identity credential authentication supported
Automates the configuration of network settings for wired and wireless endpoints
Unique provisioning and revocation of device- specific credentials and certificates
Contains built-in certificate authority specifically for BYOD
Uses profiling to identify device type, manufacturer and model
Provides BYOD visibility and centralized policy management capabilities

 

The ClearPass Advantage
 
With the industry's most advanced auto-provisioning features, onboarding thousands of devices is amazingly simple via
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integrated policy management, customizable user-facing portal and built-in certificate authority (CA).

Automated policy management
With ClearPass, IT can use context collected during onboarding to enforce device type and ownership-based network
access policies. Centrally-defined policies also limit the types of devices that can be on-boarded and define which user
groups can onboard devices..

Built-in certificate authority simplifies administration for BYO devices
 
Flexible workflow options
The onboard configuration process can be managed via IT-enabled and sponsor required workflows. User
authentication can prompt for active directory or cloud identity credentials. 
Customized device provisioning
A centrally managed administrator portal allows IT to configure device certificates and trust details, network
access, VPN, and health check settings and authentication protocols for wireless and wired networks.
The IT staff can also define the number of devices that can be on-boarded per user and how long their
certificates are valid.

Advanced Onboarding Capabilities
 
Built-in certificate authority for BYOD
The distribution of published device credentials through ClearPass Onboard’s built-in CA safeguards
organizations that want to adopt BYOD initiative’s without requiring the implementation of an external CA.
ClearPass Onboard issued certificates are unique as they also include specific user and device context.
The Onboard CA provides the option to utilize certificate management without the need to make changes to
an internal public key infrastructure (PKI) or active directory (AD).
ClearPass also supports the distribution of Onboard generated certificates requested by third-party
applications - EMM/MDM using SCEP and EST (RFC 7030) proto
 
Revocation of unique certificates
Easy-to-use search and menu-driven capabilities ensure the rapid revocation and deletion of certificates for
specific mobile devices if a user leaves a organization or the mobile device is lost or stolen.
Online Certificate Status Protocol (OCSP) supported.
 

QuickSpecs Aruba ClearPass OnBoard Software

Overview

DA - 15699   Worldwide QuickSpecs — Version 5 — 12/18/2017 Page  2

Anexo 03 ITEM 01 (0592506)         SEI 0008478-63.2018.6.02.8000 / pg. 975



1.
2.

Details of unique credentials for OnBoarded BYOD endpoints

Ordering Guidance
 
ClearPass Onboard can be ordered via perpetual license or subscription that includes ArubaCare for the
length of the subscription.
Ordering ClearPass Onboard involves the following steps:

Determine the number of unique users you will provision within your environment.
Select the total number of OnBoard licenses.  

Additional Onboard capacity can be purchased at any time to meet growth demands.  ClearPass Onboard is
licensed on a per user basis.
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Ordering Information*
   
Description Part Number
Perpetual Licenses  
Aruba ClearPass Onboard 100 User Licenses E-LTU JZ436AAE
Aruba ClearPass Onboard 500 User Licenses E-LTU JZ437AAE
Aruba ClearPass Onboard 1K User Licenses E-LTU JZ438AAE
Aruba ClearPass Onboard 2500 User Licenses E-LTU JZ439AAE
Aruba ClearPass Onboard 5K User Licenses E-LTU JZ440AAE
Aruba ClearPass Onboard 10K User Licenses E-LTU JZ441AAE
   
Perpetual Licenses Warranty  
90 days** Software
   
Subscription Licenses (1 Year)  
Aruba ClearPass Onboard 100 User Licenses 1-Year Subscription E-STU JZ445AAE
Aruba ClearPass Onboard 500 User Licenses 1-Year Subscription E-STU JZ446AAE
Aruba ClearPass Onboard 1K User Licenses 1-Year Subscription E-STU JZ447AAE
Aruba ClearPass Onboard 2500 User Licenses 1-Year Subscription E-STU JZ448AAE
Aruba ClearPass Onboard 5K User Licenses 1-Year Subscription E-STU JZ449AAE
Aruba ClearPass Onboard 10K User Licenses 1-Year Subscription E-STU JZ450AAE
Aruba ClearPass Onboard 100 User Licenses 3-Year Subscription E-STU JZ454AAE
Aruba ClearPass Onboard 500 User Licenses 3-Year Subscription E-STU JZ455AAE
Aruba ClearPass Onboard 1K User Licenses 3-Year Subscription E-STU JZ456AAE
Aruba ClearPass Onboard 2500 User Licenses 3-Year Subscription E-STU JZ457AAE
Aruba ClearPass Onboard 5K User Licenses 3-Year Subscription E-STU JZ458AAE
Aruba ClearPass Onboard 10K User Licenses 3-Year Subscription E-STU JZ459AAE
Aruba ClearPass Onboard 100 User Licenses 5-Year Subscription E-STU JZ463AAE
Aruba ClearPass Onboard 500 User Licenses 5-Year Subscription E-STU JZ464AAE
Aruba ClearPass Onboard 1K User Licenses 5-Year Subscription E-STU JZ465AAE
Aruba ClearPass Onboard 2500 User Licenses 5-Year Subscription E-STU JZ466AAE
Aruba ClearPass Onboard 5K User Licenses 5-Year Subscription E-STU JZ467AAE
Aruba ClearPass Onboard 10K User Licenses 5-Year Subscription E-STU JZ468AAE
   
* Subscription and enterprise licenses can be purchased in 1-, 3- or 5-year increments for 100, 500, 1,000,
2,500, 5,000, and 10,000 endpoints
** Extended with support contract  
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Date Version History Action Description of Change
18-Dec-2017 From Version 3 to 4 Changed Product overview, Advanced

Onboarding Capabilities, Ordering
Guidance and Ordering
Information updated

04-Dec-2017 Form Version 2 to 3 Added SKUs added: JZ436AAE,
JZ437AAE, JZ438AAE,
JZ439AAE, JZ440AAE,
JZ441AAE, JZ445AAE,
JZ446AAE, JZ447AAE,
JZ448AAE, JZ449AAE,
JZ450AAE, JZ454AAE,
JZ455AAE, JZ456AAE,
JZ457AAE, JZ458AAE,
JZ459AAE, JZ463AAE,
JZ464AAE, JZ465AAE,
JZ466AAE, JZ467AAE,
JZ468AAE

Changed All document sections updated
16-Oct-2017 Form Version 1 to 2 Changed Aruba information updated
01-Nov-2016 Version 1 Created Document creation.
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Aruba ClearPass Universal Profiler Software
Identify everything connected to wired and wireless networks
 

Product overview
 
As every connected device today is a potential attack point, knowing what is on your network is the first step
to securing your data. It's no longer acceptable to estimate the total number of devices on your network and
whether they are IT-managed laptops, unmanaged smartphones or IoT devices. And given that the number
of IoT devices is expected to grow into the billions, knowing what's on the network has become IT's biggest
challenge. 
IoT devices may be deployed by IT, facilities, or even brought in from home by employees, so
understanding what they are and how they're being used is critical. In fact, as hackers figure out how to
exploit vulnerabilities, knowing what should be on a network and what is not allowed is needed for both
internal and external compliance, regardless of the industry.  
The Aruba ClearPass Universal Profiler is designed to automatically give you that granular visibility into all
connected devices, even controllers and switches. A customizable dashboard lets you see categories and
families of devices and individual attributes for everything connected. No agents or initial investment in a
network access control (NAC) or policy management solution is needed. 
And, as security requirements change, it's easy to migrate from pure profiling to a comprehensive policy and
enforcement solution, when needed. This is something that the competition can't offer.

Key Benefits
Automatically find all managed, unmanaged and IoT  devices
Monitor any wired or wireless multi-vendor network
Uses active and passive profiling methods - DHCP, SNMP,  and  more
See what devices come and go from the network
Built-in profi  update feed for new or unknown devices
Low cost entry point lets you scale to any size network
Easily start with profiling and move to policy enforcement, when  needed

Features and Benefits
 
Real-Time Discovery And Fingerprinting
The ClearPass Universal Profiler automatically identifies all devices on your network by leveraging DHCP, SNMP, and other
methods on both wired and wireless, with minimal set-up—even in multi-vendor environments. In addition to an initial
discovery, Universal Profiler identifies any new devices and the attributes that change on existing devices, too.

It's never been easier to gather information about device categories, manufacturers, connection methods,
OS types and version numbers, and IP addresses. You now have the visibility needed for security and
network performance optimization that allows your business to thrive while delivering a secure and reliable
user experience.
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Granular device discovery, categorization and visibility

Visibility From One Central Location
The ClearPass Universal Profiler also delivers an intuitive web-based interface that is simple to administer,
shows device totals and devices per category, host names, device vendor information, and if the devices
are online or off. Visual graphs make it easy to track what's on the network and allows you to drill down to
see device specific attributes. All from your office or while on the road. 
A filtering option easily lets you find the one device that may require extra attention - maybe it shouldn't be
on the network, or is exhibiting suspect security behavior. Or perhaps you want to find out a little more about
a new IoT device that is connected to a wired port in a remote office. No more hunting for devices across
multiple tools.

Profiling Is Your Security Launch Point
Just as vulnerability scans are critical to identifying security gaps within servers and other resources,
identifying all IP-enabled devices is critical from a security standpoint, and for audit and compliance
requirements. What you do with the profiling information is what makes the difference. Device visibility is
easily applied to adjust policies on existing firewalls, SIEM, UBA, and other solutions.
 
For more comprehensive controls, a simple migration path from Aruba ClearPass Universal Profiler to the
Aruba ClearPass Policy Manager ensures that automated policy enforcement is easily implemented for real-
time access security. Managed, unmanaged and IoT devices are allowed onto a network based on
category, OS version, ownership, or other attributes.

Key Features
Identify all IP-enabled devices: laptops, smartphones, switches, controllers, routers
Easily view per device attributes:

- Type - printer, HVAC sensor, laptop, IV Pump, and more

- Model name

- MAC address

- IP address

- NIC vendor

- Operating system type and version number
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- Associated switch port

- VLAN

Web-based dashboard: Dynamic visibility, reporting and tiered admin access
Simple to read device totals: Categories, family, and specific vendor names
Continuous insight: See all devices connecting and profiled over time
Compilation of device connectivity: View information like IP subnet, wired/wireless
Simple administration: Easily monitor the heath metrics of all profiler nodes
Vendor-agnostic: Built to work in multi-vendor wired and wireless networks
No agents required: Leverages DHCP, SNMP and other methods

 

Ordering Guidance
The ClearPass Universal Profiler will be available via subscription licenses that include support. For
simplicity, there will be a single part number that covers licensing for 100 devices. For example, for
deployments that contain 2,060 devices, the guidance is to order 21 instances of the part number below.
This allows the ClearPass Universal Profiler software to run on a virtual appliance.

System Requirements
The ClearPass Universal Profiler will only be available in a virtual appliance format. VMware ESX is the
supported platform. Based on the number of devices discovered within an environment, there are three
sizing recommendations for a virtual appliance (specifications provided upon request):

Up to 2,000 devices
Up to 20,000 devices
Up to 100,000 devices
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Ordering Information
   
Description Part Number
Aruba ClearPass Universal Profiler 100 Endpoint Licenses 1yr Subscription E-
STU

JY914AAE

Aruba ClearPass Universal Profiler 100 Endpoint Licenses 3yr Subscription E-
STU

JY981AAE

   
   
For more information on Aruba's Universal Profiler, visit
http://www.arubanetworks.com/products/security/network-access-control/clearpass-universal-
profiler/.
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Date Version History Action Description of Change
06-Feb-2016 Version 1 Created Document creation.
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Copyright Information

©Copyright 2017 Hewlett Packard Enterprise Development LP.

Open Source Code

This product includes code licensed under theGNU General Public License, the GNU Lesser General Public
License, and/or certain other open source licenses. A completemachine-readable copy of the source code
corresponding to such code is available upon request. This offer is valid to anyone in receipt of this information
and shall expire three years following the date of the final distribution of this product version by Hewlett-
Packard Enterprise Company. To obtain such source code, send a check ormoney order in the amount of US
$10.00 to:

Hewlett-Packard Enterprise Company
Attn: General Counsel
3000 Hanover Street
Palo Alto, CA 94304
USA

Installing or Upgrading to 6.7 on a Virtual Appliance| Tech Note | 2
Anexo 05 ITEM 01 (0592511)         SEI 0008478-63.2018.6.02.8000 / pg. 985



Installing or Upgrading to 6.7 on a Virtual Appliance| Tech
Note

Contents | 3

Contents

About This Tech Note 5
Related Documents 5

Use of Cookies 5

Contacting Support 5

VMware vSphere Hypervisor (ESXi) Installations 7
VMware vSphere Hypervisor Installation Process Overview 7

Recommended VMware vSphere Hypervisor Server Specifications 7

Supported VMware vSphere Hypervisor (ESXi) Versions 8

CLABV (Evaluation OVF) 8

C1000V (500 Virtual ApplianceOVF) 8

C2000V (5K Virtual ApplianceOVF) 9

C3000V (25K Virtual ApplianceOVF) 9

Installing ClearPass on an ESXi Virtual Appliance 9

Deploy the ClearPass Image on a VMware ESXi Server 9

Add aHard Disk to the ESXi Virtual Appliance 13

PowerOn and Configure the ESXi Virtual Appliance 15

After Upgrading ClearPass to 6.7.0 on ESXi Servers 17

Morphing ESXi to a HigherModel Virtual Appliance 17

Manually Upgrading an ESXi Installation 19

Hyper-V Installations 23
Hyper-V Installation Process Overview 23

Recommended Hyper-V Server Specifications 24

Supported Hyper-V Versions 24

CLABV (Evaluation VHDX) 25

C1000V (500 Virtual Appliance VHDX) 25

C2000V (5K Virtual Appliance VHDX) 25

C3000V (25K Virtual Appliance VHDX) 25

Installing ClearPass on aHyper-V Virtual Appliance 25

Import the Virtual Appliance 26

Add aHard Disk to theHyper-V Virtual Appliance 28

PowerOn and Configure theHyper-V Virtual Appliance 32

After Upgrading ClearPass to 6.7.0 on Hyper-V Servers 34

Morphing a Hyper-V Version 35

Anexo 05 ITEM 01 (0592511)         SEI 0008478-63.2018.6.02.8000 / pg. 986



4 | Contents Installing or Upgrading to 6.7 on a Virtual Appliance| Tech Note

Troubleshooting Hyper-V 41

Configuring SPAN for Hyper-V 41

Process Overview for Enabling and Configuring SPAN 41

Creating a Virtual Switch 41

Attaching a ClearPass SPAN Virtual Interface to the Virtual Switch 42

EnablingMicrosoft NDIS Capture Extensions for the Virtual Switch 44

Setting theMirroringMode on the External Port 45

Setting the Local SPAN in a Cisco Switch 46

Additional References, SPAN Configuration 46

LowNetwork Performance on Hyper-V Due to NIC Cards 46

Example 1: Increase in RADIUS Timeout Packets 47

Example 2: Increase in RADIUS End-to-End Processing 47

Example 3: Ping Test 47

KVM Installations 49

Anexo 05 ITEM 01 (0592511)         SEI 0008478-63.2018.6.02.8000 / pg. 987



Installing or Upgrading to 6.7 on a Virtual Appliance| Tech Note About This Tech Note | 5

Chapter 1
About This Tech Note

This Tech Note describes the procedures for installing and upgrading ClearPass 6.7 on a virtual appliance.
Information is provided for ESXi®, Hyper-V™, and KVM installations.

This Tech Note contains the following chapters:

l "VMware vSphere Hypervisor (ESXi) Installations" on page 7

l "Hyper-V Installations" on page 23

l "KVM Installations" on page 49

Related Documents
The following documents are part of the complete documentation set for the ClearPass 6.7 platform:

l ClearPass Policy Manager 6.7 User Guide

l ClearPass Guest 6.7 User Guide

l ClearPass Policy Manager 6.7 Getting Started Guide

l ClearPass 6.7 Deployment Guide

l Tech Note: Upgrading to ClearPass 6.7

Use of Cookies
Cookies are small text files that are placed on a user’s computer by Web sites the user visits. They arewidely
used in order to makeWeb sites work, or work more efficiently, as well as to provide information to the owners
of a site. Session cookies are temporary cookies that last only for the duration of one user session.

When a user registers or logs in via an Aruba captive portal, Aruba uses session cookies solely to remember
between clicks who a guest or operator is. Aruba uses this information in away that does not identify any user-
specific information, and does not make any attempt to find out the identities of those using its ClearPass
products. Aruba does not associate any data gathered by the cookie with any personally identifiable
information (PII) from any source. Aruba uses session cookies only during the user’s active session and does
not store any permanent cookies on a user’s computer. Session cookies are deleted when the user closes his or
herWeb browser.

Contacting Support

Main Site arubanetworks.com

Support Site support.arubanetworks.com

Airheads Social Forums and
Knowledge Base

community.arubanetworks.com

North American Telephone 1-800-943-4526 (Toll Free)
1-408-754-1200
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International Telephones arubanetworks.com/support-services/contact-support/

Software Licensing Site hpe.com/networking/support

End-of-Life Information arubanetworks.com/support-services/end-of-life/

Security Incident
Response Team

Site: arubanetworks.com/support-services/security-bulletins
Email: sirt@arubanetworks.com
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Chapter 2
VMware vSphere Hypervisor (ESXi) Installations

This chapter describes how to install or upgrade ClearPass on a VMware vSphere Hypervisor (ESXi) virtual
appliance.

This chapter includes:

l "VMware vSphere Hypervisor Installation Process Overview" on page 7

l "Recommended VMware vSphere Hypervisor Server Specifications" on page 7

l "Installing ClearPass on an ESXi Virtual Appliance" on page 9

l "After Upgrading ClearPass to 6.7.0 on ESXi Servers" on page 17

l "Morphing ESXi to a HigherModel Virtual Appliance " on page 17

l "Manually Upgrading an ESXi Installation" on page 19

VMware vSphere Hypervisor Installation Process Overview
The process of installing ClearPass on a VMware vSphere Hypervisor (ESXi) virtual appliance (VA) is done in four
stages:

1. ClearPass 6.7 VMware software packages are distributed as Zip files. Download the software image from
theDownload Software > ClearPass > Policy Manager > Current Release > ESXi folder on the
Support site and unzip it to a folder on your server to extract the files.

2. Follow the steps in theOVF wizard to deploy theOVF files, but do not power on yet.

3. Add a new hard disk, based on the requirements for your type of VA. See "Recommended VMware vSphere
Hypervisor Server Specifications" on page 7 formore information.

4. Power on and configure the VA.

Instructions for these procedures are provided in "Installing ClearPass on an ESXi Virtual Appliance" on page 9.

If you are upgrading ClearPass from 6.5.7 or 6.6.x to 6.7.0 on an ESXi server, and only if theMAC address of
Network adapter1 is higher than that of Network adapter2, additional steps are required after the
upgrade. See "After Upgrading ClearPass to 6.7.0 on ESXi Servers" on page 17 for details.

Review the release notes for the current release before you upgrade ClearPass.

Cloning a virtual appliance to facilitate a ClearPass deployment is not recommended or supported.

Recommended VMware vSphere Hypervisor Server Specifications
Please carefully review all virtual appliance (VA) requirements, including functional IOP ratings, and verify that
your systemmeets these requirements. These recommendations supersede earlier requirements that were
published for ClearPass 6.x installations.

Virtual appliance requirements are adjusted to align with the shipping ClearPass hardware appliance
specifications. If you do not have the VA resources to support a full workload, then you should consider
ordering a ClearPass hardware appliance.
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Be sure that your systemmeets the recommended specifications required for the ClearPass virtual appliance.
The ClearPass VMware ships with a 30 GB hard disk volume. Thismust be supplemented with additional
storage/hard disk through VMware settings by adding a new hard disk. The additional space required depends
on the ClearPass virtual appliance version.

To ensure scalability, dedicate or reserve the processing andmemory to the ClearPass VA instance. Youmust
also ensure that the disk subsystem canmaintain the IOP’s throughput as detailed below. Most virtualized
environments use a shared disk subsystem assuming that each application will have bursts of I/Owithout a
sustained high I/O throughput. ClearPass requires a continuous sustained high data I/O rate.

If you do not add a new hard disk to the VA before it is powered on, it will continue to restart with kernel panics.

An ESXi version can bemorphed to a larger version by using themorph-vm command. Formore information,
see "Morphing ESXi to a HigherModel Virtual Appliance " on page 17 of this Tech Note, and theCommand
Line Interface > System Commands > system morph-vm section in the ClearPass Policy Manager 6.7
User Guide.

Starting with the 6.7.0 release, the names of the ClearPass appliance types have changed:

l CP-SW-EVAL is now CLABV

l CP-VA-500 is now C1000V

l CP-VA-5K is now C2000V

l CP-VA-25K is now C3000V

The CLABV appliance image is for training, configuration testing, and demonstrations. The C1000V, C2000V,
and C3000V appliance images should be used for performance and scale testing or to mimic a production
environment.

Supported VMware vSphere Hypervisor (ESXi) Versions
The following VMware vSphere Hypervisor versions are supported. VMware Player is not supported.

l VMware vSphere Hypervisor (ESXi) 5.5, 6.0, or 6.5

CLABV (Evaluation OVF)
l 2 reserved virtual CPUs

l 6 GB RAM

l 80 GB disk space required

C1000V (500 Virtual Appliance OVF)
l 8 reserved virtual CPUs

n Underlying CPU is recommended to have a PassMark® of 3000 or higher

l 8 GB RAM

l 1000 GB disk space required

l 2 Gigabit virtual switched ports

l Functional IOP rating for a 40-60 read/write profile for 4K random read/write = 75
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C2000V (5K Virtual Appliance OVF)
l 8 reserved virtual CPUs

n Underlying CPU is recommended to have a PassMark® of 9600 or higher

l 8 GB RAM

l 1000 GB disk space required

l 2 Gigabit virtual switched ports

l Functional IOP rating for a 40-60 read/write profile for 4K random read/write = 105

C3000V (25K Virtual Appliance OVF)
l 24 reserved virtual CPUs

n Underlying CPUs are recommended to have a PassMark® of 9900 or higher

l 64 GB RAM

l 1800 GB disk space required

l 2 Gigabit virtual switched ports

l Functional IOP rating for a 40-60 read/write profile for 4K random read/write = 350

Installing ClearPass on an ESXi Virtual Appliance
After you download and unzip the ClearPass 6.7 VMware ESXi software package Zip files, follow the
instructions in this section to deploy the ClearPass files, add a new hard disk, and power on and configure the
VA:

l "Deploy the ClearPass Image on a VMware ESXi Server" on page 9

l "Add aHard Disk to the ESXi Virtual Appliance" on page 13

l "PowerOn and Configure the ESXi Virtual Appliance" on page 15

Deploy the ClearPass Image on a VMware ESXi Server

The illustrations in this section use a CLABV virtual appliance as an example. Refer to "Recommended VMware
vSphere Hypervisor Server Specifications" on page 7 for the appropriate requirements for your appliance.

1. Start the VMware vSphereWeb client and connect to your ESXi server. Select File > Deploy OVF template.
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Figure 1 Deploy OVF Template Wizard

2. Select theOVF and vmdk file from the folder where the ClearPass Zip file was extracted. TheDeploy OVF
wizard opens with theOVF Template Details page displayed. (OVF, or Open Virtualization Format, is a
standard for distributing virtual appliances or software to virtual machines)

Figure 2 Deploy OVF Template Wizard, Select Template Folder

Figure 3 Deploy OVF Template Wizard, Select Template File
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3. Select the ESXi host under vCenter where it needs to be deployed.

Figure 4 Deploy OVF Template Wizard, Select Name and Location

Figure 5 Deploy OVF Template Wizard, Select a Resource

4. ClickNext.

5. On the End User License Agreement page, review the information, click Accept, and then clickNext.

Figure 6 Deploy OVF Template Wizard, Review Agreement
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6. Select Storage and clickNext.

7. On theDisk Format page, leave the default option of Thick Provision Lazy Zeroed, and then clickNext.

Figure 7 Deploy OVF Template Wizard, Select Storage

Figure 8 Deploy OVF Template Wizard, Review Details

8. Assign virtual switches to themanagement and data port respectively.

Figure 9 Deploy OVF Template Wizard, Select Networks
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9. Click on Finish after reviewing the configuration.

Figure 10 Deploy OVF Template Wizard, Ready to Complete

You will need to reconfigure the VA settings by adding a hard disk before you power on.

Add a Hard Disk to the ESXi Virtual Appliance

For disk size requirements for the different ClearPass models, see "Recommended VMware vSphere Hypervisor
Server Specifications" on page 7.

1. On the vSphereWeb client, navigate to the deployed virtual appliance, right-click on it, and select Edit
Settings.

Figure 11 vSphere Web Client, Edit Settings
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2. ClickNew Hard Disk to add another hard disk. This example shows adding an HDD SCSI(0:1) for 300 GB.
Youmust make sure the newHDD added is pointing to SCSI(0:1).

Figure 12 Virtual Machine Properties, Add Hard Disk

Figure 13 Add Hardware Wizard, New Hard Disk Size
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3. Review the system requirements and finish the deployment.

Figure 14 Add Hardware Wizard, Disk Review

4. Ensure that the hard disk node ID is set yo SCSI(0:1) and the disk type setting is Thick Provision Lazy
Zeroed, then click Finish.

Power On and Configure the ESXi Virtual Appliance
1. Power on the ESXi virtual appliance. You should see the following in the vSphereWeb client:

Figure 15 “Enter appliance type to continue”

2. Enter the list number for the appropriate appliance type (do not enter the appliancemodel itself). Options
include:

n 1) CLABV—This is the Evaluation RAWDisk Image.

n 2) C1000V—This is the 500 Virtual Appliance RAWDisk Image.

n 3) C2000V—This is the 5K Virtual Appliance RAWDisk Image.

n 4) C3000V—This is the 25K Virtual Appliance RAWDisk Image.

So, for example, to install a CLABV, you would enter the number 1.
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Figure 16 Number Entered to Indicate Appliance Option

3. The system requirements are displayed for the appliancemodel you entered, along with your current
system configuration. Compare these to make sure your systemmeets the new system requirements. For
more information, see "Recommended VMware vSphere Hypervisor Server Specifications" on page 7.

Figure 17 System Requirements Comparison, and “Enter ‘y’ or ‘Y’ to proceed”

4. When you have verified that your systemmeets the new requirements, press y. The ClearPass 6.7.0 setup
and installation begins. You should see the following information, and ClearPass will reboot at least once.
After that reboot the ClearPass VA is configured, and will power on and boot up within a couple of minutes.
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Thewhole process fromDeploying theOVF image to the final startup screen should take between 30 and
40 minutes.

5. Continue to wait for some time. Once theNetwork Configuration Wizard appears, assign network details
to ClearPass. Once this is completed, ClearPass should be accessible online.

After Upgrading ClearPass to 6.7.0 on ESXi Servers
If you are upgrading ClearPass from 6.5.x or 6.6.x to 6.7.0 on a VMware ESXi server, and only if theMAC
address of Network adapter1 is higher than that of Network adapter2, additional steps are required after
the upgrade.

After upgrading, follow the steps below in order for ClearPass to have network connectivity:

1. After you upgrade to 6.7.0, log in to the console as appadmin and use the CLI command <system
shutdown> to shut down the ClearPassserver. This stepmust be done only through the console.

2. After the command is executed, wait for the virtual appliance to shut down completely.

3. Edit the ClearPass virtual appliance settings in the vSphereWeb client and remove the two Ethernet
adapters that are namedNetwork adapter1 andNetwork adapter2.

4. Add two new network adapters with the namesNetwork adapter1 andNetwork adapter2 and of type
Ethernet Adapter. Network adapter1 should be themanagement port connected to SwitchManagement,
and Network adapter2 should be the data port connected to SwitchData.

5. Save the new settings and start the ClearPass virtual appliance.

6. Log in to the ClearPass console using the appadmin account, and then run the following CLI command to
refresh the network settings:

system refresh-network

7. After the refresh command is executed, reboot the ClearPass virtual appliance to establish network
connectivity.

Morphing ESXi to a Higher Model Virtual Appliance
The illustrations in this section use the example of morphing a C1000V virtual appliance to a C3000V. Adjust your
own configuration as needed.

Perform the following steps whenmorphing an ESXi virtual appliance to a highermodel virtual appliance:

1. Power off the ClearPass VMware instance.

2. In VMware, open the ClearPass Virtual Machine Properties.

3. Add a new hard disk to the virtual appliance. TheVirtual Device Node should be SCSI(0:2).

Review the VMware disk requirements first. These are described in "Recommended VMware vSphere
Hypervisor Server Specifications" on page 7.

Never remove SCSI 0:0

Installing or Upgrading to 6.7 on a Virtual Appliance| Tech Note VMware vSphere Hypervisor (ESXi) Installations | 17
Anexo 05 ITEM 01 (0592511)         SEI 0008478-63.2018.6.02.8000 / pg. 1000



18 | VMware vSphere Hypervisor (ESXi) Installations Installing or Upgrading to 6.7 on a Virtual Appliance| Tech Note

Figure 18 Add Hardware, New HDD

Figure 19 New Hard Disk in Devices List

4. Power on the VM after adding the newHDD.
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5. In the examplewe’re using, the information shows that you are now in a C1000V virtual appliance and
about to morph to a C3000V.

Figure 20 “Press “y” or “Y” to proceed” (A)

6. Review allocated system requirements with required system configuration and enter Y to proceed

Figure 21 “Press “y” or “Y” to proceed” (B)

7. The system requirements are displayed for the appliancemodel you entered, along with your current
system configuration. Compare these to make sure your systemmeets the new system requirements. For
more information, see "Recommended VMware vSphere Hypervisor Server Specifications" on page 7.

8. When you have verified that your systemmeets the new requirements, press y. The ClearPass 6.7.0 setup
and installation begins.

Manually Upgrading an ESXi Installation
This section describes how to perform amanual upgrade of a VMware ESXi virtual appliance. This procedure is
recommended only if you experience problemswhen taking snapshots of a virtual appliance on an ESXi version
5.x or 6.x.

By default, ClearPass 6.7 comeswith VMware Tools version 9.4.10.37835 installed in it. If you are going to
perform amanual VMware Tools upgrade, youmust first verify that a version of ClearPass is already installed.
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Tomanually upgrade a VMware installation:

1. Power on the virtual appliance and verify that ClearPass is installed on it. In the vSphereWeb client, right-
click on the VA instance and select Guest > Install/Upgrade VMware Tools.

Figure 22 Select the Virtual Machine Instance

2. Select Automatic Tools Upgrade. This option ensures that the VA instance is upgraded to the highest
supported stable version for the respective version of ESXi server it is hosted on.

Figure 23 Automatic Tool Upgrade Option

3. ClickOK.
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4. The console displays amessage that the VMware Tools upgrade has been initiated and is in progress. The
process takes approximately fiveminutes to complete.

Do not make any configuration changes to either ClearPass or the vSphere Web client while the upgrade is in
progress.
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Chapter 3
Hyper-V Installations

This chapter describes how to install ClearPass on aMicrosoft Hyper-V virtual appliance.

This chapter includes:

l "Hyper-V Installation Process Overview" on page 23

l "Recommended Hyper-V Server Specifications" on page 24

l "Installing ClearPass on aHyper-V Virtual Appliance" on page 25

l "After Upgrading ClearPass to 6.7.0 on Hyper-V Servers" on page 34

l "Morphing a Hyper-V Version" on page 35

l "Troubleshooting Hyper-V" on page 41

Hyper-V Installation Process Overview
The process of installing ClearPass on aMicrosoft Hyper-V virtual appliance (VA) is done in four stages:

1. ClearPass 6.7 Hyper-V software packages are distributed as Zip files. Download the software image from
theDownload Software > ClearPass > Policy Manager > Current Release > Hyper-V folder on the
Support site and unzip it to a folder on your server to extract the files.

2. Import the virtual appliance and choose the import type.

3. Add the hard disk and configure the format, type, and size, based on the requirement for your VA. See
"Recommended Hyper-V Server Specifications" on page 24 formore information.

4. Power on and configure the VA.

Instructions for these procedures are provided in "Installing ClearPass on aHyper-V Virtual Appliance" on page
25.

If you are upgrading ClearPass from 6.5.x or 6.6.x to 6.7.0 on aHyper-V server, additional steps are required
after the upgrade. See "After Upgrading ClearPass to 6.7.0 on Hyper-V Servers" on page 34 for details.

Review the release notes for the current release before you upgrade ClearPass.

Cloning a virtual appliance to facilitate a ClearPass deployment is not recommended or supported.

Do not use the Cluster Upgrade Tool to upgrade ClearPass clusters from 6.5.7 or 6.6.x to 6.7.0 on a Hyper-V server.
Doing so will cause the appliance to lose network connectivity after the upgrade and will require manual intervention
from the administrator to regain connectivity.

Ensure that you bring up fresh ClearPass 6.7.0 installs with the network adapter type "Network adapter" instead of
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the legacy option.

Recommended Hyper-V Server Specifications
Please carefully review all virtual appliance (VA) requirements, including functional IOP ratings, and verify that
your systemmeets these requirements. These recommendations supersede earlier requirements that were
published for ClearPass 6.x installations.

Virtual appliance recommendations are adjusted to align with the requirements for ClearPass hardware
appliances. If you do not have the VA resources to support a full workload, then you should consider ordering
the ClearPass hardware appliance.

Be sure that your systemmeets the recommended specifications required for the ClearPass virtual appliance.
The ClearPass virtual appliance ships with a 30 GB hard disk volume. Thismust be supplemented with
additional storage/hard disk through Hyper-V settings by adding a new hard disk. The additional space
required depends on the ClearPass virtual appliance version.

To ensure scalability, dedicate or reserve the processing andmemory to the ClearPass virtual appliance
instance. Youmust also ensure that the disk subsystem canmaintain the IOP’s throughput as detailed below.
Most virtualized environments use a shared disk subsystem assuming that each application will have bursts of
I/Owithout a sustained high I/O throughput. ClearPass requires a continuous sustained high data I/O rate.

If you do not add a new hard disk to the virtual appliance before it is powered on, it will continue to restart with kernel
panics.

AHyper-V version can bemorphed to a larger version by using themorph-vm command. Formore
information, see "Morphing a Hyper-V Version" on page 35 of this Tech Note, and theCommand Line
Interface > System Commands > system morph-vm section in the ClearPass Policy Manager 6.7 User
Guide.

Starting with the 6.7.0 release, the names of the ClearPass appliance types have changed:

l CP-SW-EVAL is now CLABV

l CP-VA-500 is now C1000V

l CP-VA-5K is now C2000V

l CP-VA-25K is now C3000V

The CLABV appliance image is for training, configuration testing, and demonstrations. The C1000V, C2000V,
and C3000V appliance images should be used for performance and scale testing or to mimic a production
environment.

Supported Hyper-V Versions
The followingMicrosoft Hyper-V versions are supported:

l Microsoft Hyper-V Server 2012 R2

l Microsoft Hyper-V Server 2016

l Windows Server 2012 R2 with Hyper-V

l Windows Server 2016 with Hyper-V
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CLABV (Evaluation VHDX)
l 2 reserved virtual CPUs

l 6 GB RAM

l 80 GB disk space required

C1000V (500 Virtual Appliance VHDX)
l 8 reserved virtual CPUs

n Underlying CPU is recommended to have a PassMark® of 3000 or higher

l 8 GB RAM

l 1000 GB disk space required

l 2 Gigabit virtual switched ports

l Functional IOP rating for a 40-60 read/write profile for 4K random read/write = 75

C2000V (5K Virtual Appliance VHDX)
l 8 reserved virtual CPUs

n Underlying is recommended to have a PassMark® of 9600 or higher

l 8 GB RAM

l 1000 GB disk required

l 2 Gigabit virtual switched ports

l Functional IOP rating for a 40-60 read/write profile for 4K random read/write = 105

C3000V (25K Virtual Appliance VHDX)
l 24 reserved virtual CPUs

n Underlying CPUs are recommended to have a PassMark® of 9900 or higher

l 64 GB RAM

l 1800 GB disk required

l 2 Gigabit virtual switched ports

l Functional IOP rating for a 40-60 read/write profile for 4K random read/write = 350

Installing ClearPass on a Hyper-V Virtual Appliance
After you download and unzip the ClearPass 6.7 Hyper-V software package Zip files, follow the instructions in
this section to deploy the ClearPass files, add a new hard disk, and power on and configure the virtual
appliance:

l "Import the Virtual Appliance " on page 26

l "Add aHard Disk to theHyper-V Virtual Appliance" on page 28

l "PowerOn and Configure theHyper-V Virtual Appliance" on page 32

The illustrations in this section use a CLABV appliance.
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Import the Virtual Appliance
1. Download and unzip theHyper-V package from theDownload Software > ClearPass > Policy Manager

> Current Release > Hyper-V folder on the Support site .

2. FromHyper-V Manager, right-click to select theHyper-V server and select the Import Virtual Machine
option. The Import Virtual Machine window opens.

3. In the Locate Folder step, browse to the folder you unzipped in step 1, and then clickNext.

Figure 24 Import Virtual Machine Window, Locate Folder

4. In the Select Virtual Machine step, select the vhdx file, verify the summary, and clickNext.

5. In theChoose Import Type step, select Copy the virtual machine to create a Unique ID.

Figure 25 Import Virtual Machine Window, Choose Import Type
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6. Select the location where your HDD needs to be stored and finish the deployment.

Figure 26 Import Virtual Machine Window, Choose Storage Folders

7. Assign network adapters to Management and Data port respectively. Make sure they are of type “Network
adapter” and not “Legacy network adapter”.

Figure 27 Import Virtual Machine Window, Completing Import Wizard

8. After it is imported, select the VA, right click, and choose properties. The Settings configuration window
opens, where you will add the hard disk.
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Add a Hard Disk to the Hyper-V Virtual Appliance
1. Select the SCSI Controller option. To install ClearPass, we need to add another disk partition to this

deployed VM. Right click on the VM to edit settings and add a new hard drive.

Figure 28 Hyper-V Settings, Add New Hard Drive

Figure 29 Hyper-V Settings, Select Devices for VM
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Figure 30 Hyper-V Settings, SCSI Controller Option

2. Choose the type of HDD and select Dynamic expanding and clickNext to specify the size.

Figure 31 Hyper-V Settings, Choose Disk Type
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3. Add a hard drive and verify the following values:

l Controller = SCSI Controller

l Location = 1

Figure 32 Hyper-V Settings, Adding Hard Drive and Verifying Values

Disk size required:

n CLABV (evaluation = 80 GB

n C1000V (500) = 1000 GB

n C2000V (5K) = 1000 GB

n C3000V (25K) = 1800 GB

Using a CLABV as an example, the following images show the name and location, disk configuration, and
summary steps. Formore information about the correct requirements for your virtual appliance version,
see "Recommended Hyper-V Server Specifications" on page 24.
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Figure 33 Hyper-V Settings, Choose Storage Folder

Figure 34 New Virtual Hard Disk Wizard, Summary

4. Click Apply in themain window, and then clickOK.
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Power On and Configure the Hyper-V Virtual Appliance
1. Power on theHyper-V virtual appliance. You should see the following:

Figure 35 “Enter appliance type to continue”

2. Enter the list number for the appropriate appliance type (do not enter the appliancemodel itself). Options
include:

n 1) CLABV—This is the Evaluation RAWDisk Image.

n 2) C1000V—This is the 500 Virtual Appliance RAWDisk Image.

n 3) C2000V—This is the 5K Virtual Appliance RAWDisk Image.

n 4) C3000V—This is the 25K Virtual Appliance RAWDisk Image.

So, for example, to install a CLABV, you would enter the number 1.

3. The system requirements are displayed for the appliancemodel you entered, along with your current
system configuration. Compare these to make sure your systemmeets the new system requirements. For
more information, see "Recommended Hyper-V Server Specifications" on page 24. When you have verified
that your systemmeets the new requirements, press y. The ClearPass 6.7.0 setup and installation begins.
You should see the following information, and ClearPass will reboot at least once.
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Figure 36 “Enter ‘y’ or ‘Y’ to proceed”

Figure 37 Initializing Disk

After that reboot the ClearPass VA is configured, and will power on and boot up within a couple of minutes. The
whole process fromDeploying the VHDX image to the final startup screen should take between 30 and 40
minutes.
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4. After the ClearPass VA launches correctly, you should see the following banner:

Figure 38 Banner

When you see the banner, you can log in by following the instructions in the ClearPass Policy Manager 6.7
Getting Started Guide.

After Upgrading ClearPass to 6.7.0 on Hyper-V Servers
If you are upgrading ClearPass from 6.5.x or 6.6.x to 6.7.0 on aHyper-V server, additional steps are required
after the upgrade.

ClearPass 6.5.x and 6.6.x Hyper-V images were shipped with network adapters of type “Legacy Network
Adapter”. CentOS version 7 does not support the Legacy Network Adapter type, therefore ClearPass 6.7.0
Hyper-V images do not support the Legacy Network Adapter type. After upgrading fromClearPass 6.5.x or
6.6.x to 6.7.0, youmust follow the steps below in order for ClearPass to have network connectivity:

1. After you upgrade to 6.7.0, log in to the console as appadmin, and use the CLI command <system
shutdown> to shut down the ClearPass server. This stepmust be done only through the console.

2. After the command is executed, wait for the virtual appliance to shut down completely.

3. Edit the ClearPass virtual appliance settings in theHyper-V manager and remove all three network adapters
(these are namedNIC0,NIC1, andNetwork Adapter).

4. Add two new network adapters with names of typeNetwork Adapter.

5. Edit the network adapters. Make the first one themanagement port connected to SwitchManagement, and
make the second one the data port connected to SwitchData.

6. Save the new settings and start the ClearPass virtual appliance.

7. Log in to the ClearPass console using the appadmin account, and then run the following CLI command to
refresh the network settings:

system refresh-network

8. After the refresh command is executed, reboot the ClearPass virtual appliance to establish network
connectivity.

Do not use the Cluster Upgrade Tool to upgrade ClearPass clusters from 6.5.x or 6.6.x to 6.7.0 on a Hyper-V server.
Doing so will cause the appliance to lose network connectivity after the upgrade and will require manual intervention
from the administrator to regain connectivity.
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Morphing a Hyper-V Version
The illustrations in this section use the example of morphing a C1000V virtual appliance to a C3000V. Adjust your
own configuration as needed.

AHyper-V virtual appliance can bemorphed to a higher-value virtual appliance by using themorph-vm
command as follows:

1. Power off the virtual appliance.

2. Open Settings andmake the followingmodifications:

a. Modify theRAM and CPU to match the recommended system requirements for the larger VA (see
"Recommended Hyper-V Server Specifications" on page 24).

Figure 39 Hardware, RAM Settings
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Figure 40 Hardware, CPU Settings

b. Add an additional disk with the recommended disk size for the larger VA:

(1) Select SCSI(0:2) Controller.
(2) Select theHard Drive option and then click Add.
(3) In the next screen, specify the following values:

Controller = SCSI(0:2) Controller 1
Location = 2

(4) In theMedia section, clickNew.

Anexo 05 ITEM 01 (0592511)         SEI 0008478-63.2018.6.02.8000 / pg. 1019



Figure 41 Hardware, Controller Settings

(5) Add a new VHDX hard disk of Fixed size, and size equivalent to the requirements for the larger
VA disk size.
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Figure 42 Choose Disk Type and Size

(6) Specify the name and location.

Figure 43 Specify Name and Location

(7) Configure the disk size and click Finish.
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Figure 44 Configure Disk Size

3. After adding the hard disk, power on the original VA and, using SSH, log in to it as appadmin.

4. Run the command ‘system morph-vm <C3000V> and follow the prompts.

Figure 45 System Morph-VM Command

5. The existing hardware version and the new hardware version are displayed, along with awarning that you
cannot revert to the existing version after themorphing process is started. When you are ready to proceed,
press y.
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Figure 46 Version Comparison and Warning

6. The system requirements are displayed for the appliancemodel you entered, along with your current
system configuration. Compare these to make sure your systemmeets the new system requirements. For
more information, see "Recommended Hyper-V Server Specifications" on page 24.

Figure 47

Anexo 05 ITEM 01 (0592511)         SEI 0008478-63.2018.6.02.8000 / pg. 1023



When you have verified that your systemmeets the new requirements, press y. The ClearPass 6.7.0 setup and
installation begins.

Troubleshooting Hyper-V
This section includes the following information:

l "Configuring SPAN for Hyper-V" on page 41

l "LowNetwork Performance on Hyper-V Due to NIC Cards" on page 46

Configuring SPAN for Hyper-V
This section describes how to enable and configure SPAN for Hyper-V.

The default behavior of Hyper-V Manager allows port mirroring between VA instances on the sameHyper-V
server. It does not allow users to configure promiscuousmode for a virtual interface on a specific VA instance
in order to receive external traffic.

Process Overview for Enabling and Configuring SPAN

Make sure no ClearPass VA instance is running while you perform the following steps.

1. Create a virtual switch.

2. Attach a ClearPass SPAN virtual interface to the virtual switch.

3. EnableMicrosoft NDIS capture extensions for the virtual switch.

4. Set themirroringmode on the external port.

5. Set the local SPAN in a Cisco switch.

Make sure SPAN is enabled only on the data port and not the management port. Also, before you begin the SPAN
configuration on the data port, make sure the data port is not configured with an IP address.

Creating a Virtual Switch
1. Open theVirtual Switch Manager.

2. In theVirtual Switches list, highlight New virtual network switch and then select External as the
dedicated spanned network adapter type. Click Create Virtual Switch.

Figure 48 Virtual Switch Manager, New Virtual Network Switch
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3. For the switch you just created, select External Network as theConnection type, and select theAllow
management operating system to share this network adapter option.

Figure 49 Virtual Switch Manager, Connection Type

Attaching a ClearPass SPAN Virtual Interface to the Virtual Switch
The steps to attach the ClearPass SPAN virtual interface can be performed either fromWindows PowerShell or
fromHyper-V Manager.

Using PowerShell:

1. Add a new network adapter, selecting the newly added SPAN virtual switch. Use the command:

ADD-VMNetworkAdapter -VMName VK-C1000V-LongRunning-650 -Name Monitor -

SwitchName vSwitch_Span

2. Enable port mirroring for the selected interface as the span destination. Use the command:

Get-VMNetworkAdapter -VMName VK-C1000V-LongRunning-650 | ? Name -eq Monitor |

Set-VMNetworkAdapter -PortMirroring Destination

Where:

VK-C1000V-LongRunning-650 = CPPM VA name

vSwitch_Span = Newly added SPAN virtual switch name

Monitor = Newly added adapter name
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(The newly added adapter hardware namewill be “Monitor” when adding using the above commands, and
“Network Adapter” when added using Hyper-V Manager.)

Using Hyper-V Manager:

1. Add a new network adapter. In theHardware list, highlight Network Adapter.

2. In theVirtual Switch field, select vSwitch_Span.

Figure 50 Hyper-V Manager, Virtual Switch

3. In theHardware list, expandNetwork Adapter and select Advanced Features.
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4. In the Port Mirroring area, select Destination as theMirroring mode for the new virtual interface.

Figure 51 Hyper-V Manager, Mirroring Mode

Enabling Microsoft NDIS Capture Extensions for the Virtual Switch
To enableMicrosoft NDIS Capture Extensions for the newly added virtual switch:

1. Open theVirtual Switch Manager on theHyper-V host.

2. In theVirtual Switches list, expand the virtual switch name vSwitch_Span and highlight Extensions.
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3. In the Switch Extensions field, selectMicrosoft NDIS Capture.

Figure 52 Virtual Switch Manager, Microsoft NDIS Capture

4. Click OK.

Setting the Mirroring Mode on the External Port
The final part of the procedure is to set themirroringmode on the external port of the new virtual switch to be
the source.

TheHyper-V virtual switch (vSwitch_Span) must be configured so that any traffic that comes to the external
source port is forwarded to the virtual network adapter that you configured as the destination.

l The following PowerShell commands can be used to set the external virtual switch port to sourcemirror
mode:

$ExtPortFeature=Get-VMSystemSwitchExtensionPortFeature -FeatureName "Ethernet

Switch Port Security Settings"

$ExtPortFeature.SettingData.MonitorMode=2

Add-VMSwitchExtensionPortFeature -ExternalPort -SwitchName vSwitch_Span -

VMSwitchExtensionFeature $ExtPortFeature

Where:

vSwitch_Span = Newly added SPAN virtual switch name.

MonitorMode=2 = Source

MonitorMode=1 = Destination

MonitorMode=0 = None

l The following PowerShell command verifies themonitoringmode status:

Get-VMSwitchExtensionPortFeature -FeatureName "Ethernet Switch Port Security

Settings" -SwitchName vSwitch_Span -ExternalPort | select -ExpandProperty

SettingData
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Where:

vSwitch_Span = Newly added SPAN virtual switch name

Setting the Local SPAN in a Cisco Switch
The following commands can be used to set the local span on a Cisco switch where you plan to test SPAN:

l To add the Source:

monitor session 1 source interface gigabitEthernet 1/0/1 both

l To add theDestination:

monitor session 1 destination interface gigabitEthernet 1/0/11

Additional References, SPAN Configuration
The following references provide additional information about Hyper-V and SPAN:

l http://charbelnemnom.com/2015/01/how-to-deploy-websense-in-stand-alone-mode-on-a-hyper-v-virtual-
machine-hyperv-websense/

l http://www.cloudbase.it/hyper-v-promiscuous-mode/

Low Network Performance on Hyper-V Due to NIC Cards
In lab conditions, we noticed that the network latency increases and throughput decreases due to certain
features in theNIC not working as expected. This affects network throughput to any OS installed on aHyper-V
server.

In ClearPass, we have noticed the following symptomswhen the server is handling authentications:

l Drastic increase in network latency to external servers

l Increase in RADIUS timeout packets

l Increase in RADIUS end-to-end processing of authentication requests

If you notice these symptomswith your ClearPass server running on Hyper-V, please consult with theNIC
vendor about compatibility issues with theMicrosoft Hyper-V platform, or update to the latest driver version
whichmight resolve network throughput problems.

In our test setups, we have found that disabling the Virtual MachineQueue feature on a Broadcom5720 QP
1Gb Network Daughter Card decreased network latency times; however, this was not truewith all Broadcom
NICs.

AMicrosoft Knowledgebase article detailing the effects of Virtual MachineQueue on BroadcomNICs is
available at http://support.microsoft.com/en-us/kb/2902166.

The following examples show some sample observations on a ClearPass virtual appliance installed on aHyper-V
server where the Virtual MachineQueue featurewas enabled on theNIC card.
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Example 1: Increase in RADIUS Timeout Packets

Figure 53 System Monitor, RADIUS Timeout Packets Count

Example 2: Increase in RADIUS End-to-End Processing

Figure 54 System Monitor, Time for Full RADIUS Request Processing and Total RADIUS Request Count

Example 3: Ping Test
You can see the network latency increase through a ping test from any VA on theHyper-V server. In Clearpass,
you can perform the ping test as follows:

1. Using SSH, log in to ClearPass with the username appadmin and your password.

2. Run the command network ping <ip address>. The IP address should be a server external to the
Hyper-V server.
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The image below shows results of a network ping test to an external server from a ClearPass VA on Hyper-V.
Please note that the times shownmay vary based on your network:

Figure 55 Example Results of Network Ping Test to an External Server from a ClearPass VA on Hyper-V

The image below shows results of a network ping test to an external server from a ClearPass VA after disabling
the Virtual MachineQueue feature on a Broadcom5709c NIC:

Figure 56 Example Results of Network Ping Test to an External Server After Disabling Virtual Machine Queue
Feature
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Chapter 4
KVM Installations

Virtual appliance customers who use KVM hypervisors are advised to not apply the ClearPass 6.7.0 upgrade at
this time. Our tests have shown a negative performance impact when 6.7.0 is installed on a KVM virtual
appliance. To prevent this happening to our customers, at the time of this releasewe have not posted the
virtual appliance image for KVMwith the other 6.7.0 images. Because ClearPass upgrade patches are the same
for all platforms, KVM customers are not recommended to apply the 6.7.0 upgrade patch until further notice.
We areworking to resolve the issue in a future patch release. Wewill then repost the KVM virtual appliance
image and let users knowwe again recommend upgrading to 6.7.0 on KVM hypervisors.
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Copyright Information
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Chapter 1
About ClearPass Policy Manager

This chapter provides an overview of the ClearPass 6.7 Policy Manager Access Management System.

This chapter includes the following information:

n ClearPass Access Management System Overview

n Initial Login and Activation of the ClearPass Platform License

n Using the Policy Manager Dashboard

n Accessing Configuration Information

n Importing and Exporting Information

ClearPass Access Management System Overview
With ClearPass, IT can centrally manage network policies, automatically configure devices and distribute
security certificates, admit guest users, assess device health, and even share information with third-party
solutions—through a single pane of glass, on any network and without changing the current infrastructure.

The ClearPass Policy Manager™ Access Management System provides a window into your network and covers
all your access security requirements from a single platform. You get complete views of mobile devices and
users and have total control over what they can access.

About Policies, Profiles, and Services
In ClearPassPolicy Manager, a policy provides the rules that tells ClearPass when to execute profiles. Profiles
are actions that are taken by ClearPass; for example assigning a certain role to a user or enabling command
authorization for different types of users on a switch. The actions specified in a policy are the profiles to be
activated when specific conditions or rules are met.

Then a policy is associated with a service—a service ties all the elements together: authentication sources,
authorization sources, role-mapping, and enforcement policies.

Role-Based and Device-Based Access
The ClearPass Policy Manager platform provides role-based and device-based network access control for
employees, contractors, and guests across any wired, wireless, and VPN infrastructure.

ClearPass works with any multivendor network and can be extended to business and IT systems that are
already in place.

Self-Service Capabilities
ClearPass delivers a wide range of unique self-service capabilities. Users can securely onboard their own devices
for enterprise use or register AirPlay, AirPrint, Digital Living Network Alliance (DLNA), and Universal Plug and
Play (UPnP) devices that are enabled for sharing, sponsor guest Wi-Fi access, and even set up sharing for Apple
TV and Google Chromecast.

Leveraging Contextual Data
The power of ClearPass comes from integrating ultra-scalable AAA (authentication, authorization, and
accounting) with policy management, guest network access, device onboarding, and device health checks with
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a complete understanding of context.

From this single ClearPass policy and AAA platform, contextual data is leveraged across the network to ensure
that users and devices are granted the appropriate access privileges.

ClearPass leverages a user’s role, device, location, application use, and time of day to execute custom security
policies, accelerate device deployments, and streamline network operations across wired networks, wireless
networks, and VPNs.

Third-Party Security and IT Systems
ClearPass can be extended to third-party security and IT systems using REST-based APIs to automate work
flows that previously required manual IT intervention. ClearPass integrates with mobile device management to
leverage device inventory and posture information, which enables well-informed policy decisions.

Advanced Policy Management
ClearPass advanced policy management support includes:

n Employee access
ClearPass offers user and device authentication based on 802.1X, non-802.1X, and Web Portal access
methods. To strengthen security in any environment, you can concurrently use multiple authentication
protocols, such as PEAP, EAP-FAST, EAP-TLS, EAP-TTLS, and EAP-PEAP-Public.

For fine-grained control, you can use attributes from multiple identity stores, such as Microsoft Active
Directory, LDAP-compliant directory, Open Database Connectivity (ODBC)-compliant SQL database, token
servers, and internal databases across domains within a single policy.

Additionally, you can add posture assessments and remediation to existing policies at any time.

n Device profiling
ClearPass provides a profiling service that discovers and classifies all endpoints, regardless of device type.
You can obtain a variety of contextual data(such as MAC OUIs, DHCP fingerprinting, and other identity-
centric device data) and use this data within policies.

Stored profiling data identifies device profile changes and dynamically modifies authorization privileges. For
example, if a printer appears as a Windows laptop, ClearPass Policy Manager can automatically deny access.

n Access for unmanaged endpoints
Unmanaged non-802.1X devices (such as printers, IP phones, and IP cameras) can be identified as known or
unknown upon connecting to the network. The identity of these devices is based on the presence of their
MAC address in an external or internal database.

n Secure configuration of personal devices
ClearPass Onboard fully automates the provisioning of any Windows, macOS, iOS, Android, ChromeOS, and
Ubuntu devices via a built-in enrollment workflow. Valid users are redirected to a template-based interface
to configure required SSIDs and 802.1X settings, and download unique device credentials.

Additional capabilities include the ability for IT to revoke and delete credentials for lost or stolen devices,
and the ability to configure mobile email settings for Exchange ActiveSync and VPN clients on some device
types.

n Customizable visitor management
ClearPass Guest simplifies work flow processes so that receptionists, employees, and other non-IT staff can
create temporary guest accounts for secure Wi-Fi and wired network access. Self-registration allows guests
to create their credentials.
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n Device health checks
ClearPass OnGuard, as well as separate OnGuard persistent or dissolvable agents, performs advanced
endpoint posture assessments. Traditional NAC (Network Admission Control) health-check capabilities
ensure compliance and network safeguards before devices connect.

You can use information about endpoint integrity (such as status of anti-virus, anti-spyware, firewall, and
peer-to-peer applications) to enhance authorization policies. Automatic remediation services are also
available for non-compliant devices.

Getting Started
If you are new to ClearPass Policy Manager, refer to the following sections:

n For a general description of ClearPass Policy Manager features, refer to the following topics in this section,
ClearPass Access Management System Overview and Key Features.

n For a description of how to use the Dashboard, see Using the Policy Manager Dashboard.

n For a list of common configuration tasks and pointers to information about how to perform each task, refer
to Accessing Configuration Information.

n If you are planning a new ClearPass Policy Manager deployment, refer to the ClearPass Deployment Guide.
The ClearPass Deployment Guide is organized in a way that presents the recommended sequence in which
ClearPass deployment should take place, and makes the major deployment tasks easy to implement.

Key Features
ClearPass's key features are as follows:

n Comprehensive identity-based policy engine

n Posture agents for Windows, Macintosh OS X, and Linux operating systems

n Built-in AAA services: RADIUS, TACACS+, and Kerberos

n Web, 802.1X, and non-802.1X authentication and authorization

n Reporting, analytics, and troubleshooting tools

n External captive portal redirect to multivendor equipment

n Interactive policy simulation and monitor mode utilities

n Deployment templates for any network type, identity store, and endpoint

n Role-based network access enforcement for multivendor Wi-Fi, wired, and VPN networks

n Virtual and hardware appliances that can be deployed in a cluster to increase scalability and redundancy.

n Support for popular virtualizations platforms such as VMware vSphere Hypervisor (ESXi), Microsoft Hyper-
V, CentOS KVM, and Amazon AWS (EC2).

n Intuitive policy configuration templates and visibility troubleshooting tools.

n Supports multiple authentication/authorization sources—AD, LDAP, and SQL dB.

n Self-service device onboarding with built-in certificate authority (CA)

n Guest access with extensive customization, branding and sponsor-based approvals.

n Supports NAC and EMM/MDM integration for mobile device assessments.

n Comprehensive integration with the Aruba 360 Security Exchange Program.

n SAML 2.0 Identity Provider allowing seamless single sign-on (SSO) to cloud or on-premise applications

n SAML 2.0 Service Provider allowing seamless and secure access to ClearPass components using
federated/unified identity

n Advanced reporting and granular alerts.

n Active and passive device fingerprinting
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n High performance, scalability, High Availability, and load balancing

n A Web-based user interface that simplifies policy configuration and troubleshooting

n Network Access Control (NAC), Network Access Protection (NAP) posture and health checks, and Mobile
Device Management (MDM) integration for mobile device posture checks

n Social and Cloud Identity Network and Cloud Application SSO via OAuth2 OAuth 2.0

n Facebook, Twitter, LinkedIn, Azure Active Directory and Office 365 Office365, Google G Suite Google Apps,
and so on

n Device and User certificate enrollment via Simple Certificate Enrollment Protocol (SCEP), Enrollment over
Secure Transport (EST) and REST API-based workflows

n Advanced reporting of all user authentications and failures

n Enterprise Reporting, Monitoring, and Alerting

n HTTP/RESTful APIs for integration with third-party systems, Internet security, and MDM

n Device profiling and self-service onboarding

n Guest access with extensive branding and customization and sponsor-based approvals

n IPv6 administration support

System Specifications and Requirements

Framework and Protocol Support
n RADIUS, RADIUS CoA, TACACS+, Web authentication, and SAML v2.0

n EAP-FAST (EAP-MSCHAPv2, EAP-GTC, EAP-TLS)

n PEAP (EAP-MSCHAPv2, EAP-GTC, EAP-TLS, EAP-PEAP-Public)

n EAP-TTLS (EAP-MSCHAPv2, EAP-GTC, EAP- TLS, EAP-MD5, PAP, CHAP)

n EAP-TLS

n PAP, CHAP, MSCHAPv1, MSCHAPv2, and EAP-MD5

n Wireless and wired 802.1X and VPN

n OAuth 2.0

n Microsoft Network Access Protection (NAP) and Network Access Control (NAC)

n Active Directory machine authentication

n Online Certificate Status Protocol (OCSP)

n SNMP generic MIB, SNMP private MIB

n Common Event Format (CEF), Log Event Extended Format (LEEF)

n Simple Certificate Enrollment Protocol (SCEP)

n Enrollment over Secure Transport (EST)

Supported Identity Stores
n Microsoft Active Directory

n Kerberos

n Any LDAP-compliant directory

n Microsoft SQL, PostgreSQL, MariaDB, and Oracle 11g ODBC-compliant SQL server

n Built-in SQL store

n Built-in static-hosts list

n Token servers

n Built-in SQL store, static hosts list
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n Microsoft Azure Active Directory (via SAML and OAuth 2.0)

n Google G Suite (via SAML and OAuth 2.0)

n Any SAML 2.0-compliant identity provider

Supported Browsers

The supported browsers for ClearPass are:

n Mozilla Firefox on Windows 7, Windows 8.x, Windows 10, and macOS

n Google Chrome for macOS and Windows

n Apple Safari 9.x and later on macOS

n Mobile Safari 5.x on iOS

n Microsoft Edge on Windows 10

n Microsoft Internet Explorer 10 and later on Windows 7 and Windows 8.x. When accessing ClearPass Insight
with Internet Explorer (IE), IE 11 or above is required.

Special Characters Supported in Passwords

The special characters that are supported in passwords for all ClearPass modules (Policy Manager, ClearPass
Guest, ClearPass Onboard, ClearPass OnGuard and ClearPass Insight) are described in the following table:

Special
Character

Description

+ Plus sign

, Comma

- Hyphen

. Period

; Semicolon

= Equal sign

? Question mark

_ Underscore

Table 1: Supported Characters for
ClearPass Modules

Initial Login and Activation of the ClearPass Platform License
This section contains the following information:

n Specifying the ClearPass Platform License Key Upon Initial Login

n Logging in to the ClearPass Server

n Customizing the Landing Page Layout

n ClearPass Menu
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Specifying the ClearPass Platform License Key Upon Initial Login
Upon initial login to a Policy Manager 6.7.x server and later, you are prompted to enter the ClearPass Platform
License Key. The Policy Manager licenses on each cluster node are converted to ClearPass Platform Licenses.
The ClearPass Platform License provides a platform activation code that is installed on all the nodes in a
ClearPass cluster.

The ClearPass Platform License is the base-level license. Each ClearPass server has one ClearPass Platform
License for the physical hardware. Virtual devices have a ClearPass Platform License as well on a per-expected
device level.

For details about managing ClearPass licenses, see License Management.

You cannot have more than one ClearPass Platform license installed on a ClearPass node.

To specify the ClearPass Platform License Key upon initial login:

1. Navigate to the ClearPass Policy Manager Publisher node:

https://x.x.x.x/tips/

where x.x.x.x is the IP address of the management interface defined for the server.

2. Log in to the ClearPass 6.7.x or later server. The ClearPass Policy Manager End-User Software License
Agreement dialog appears.

The Select Application field is preset to ClearPass Platform.

Figure 1 Entering the ClearPass Platform License Key

3. Enter the ClearPass Platform License Key.

4. Click the check box for I agree to the above terms and conditions. The Add License button is now
enabled.

5. Click Add License. The Admin Login screen appears with a message indicating that you have 90 days to
activate the product and a link to activate the product.
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Figure 2 Activating the ClearPass Node

6. To activate the ClearPass Platform License on this appliance, click the Activate Now link. The Activate
License dialog opens:

Figure 3 Activating the ClearPass Platform License

7. If the ClearPass server is connected to the Internet, click the Activate Now button. The message, "Product
has been successfully activated" appears, and the Admin Login dialog is displayed.

Figure 4 Activation Successful: Admin Login Available
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Logging in to the ClearPass Server
The password you use upon initial login depends on the following scenarios:

n If you installed a ClearPass version before 6.7, set the cluster password. If a system is upgraded from
ClearPass 6.x.x to 6.7, eTIPS123 is the default password.

n If your ClearPass installation is a fresh 6.7 installation, eTIPS123 is not supported as the default password.
You must enter the password that was set up during the installation process.

n If a ClearPass 6.7 OVF (Open Virtualization Format Virtual Machine) is deployed, you are prompted for the
default password (eTIPS123) to initiate bootstrapping. After assigning all network parameters, hostname,
etc. to the ClearPass server, you are prompted for a new password during the bootstrapping process.

1. Log in to the ClearPass server with the following credentials:

l Username: admin

l Password: Enter the ClearPass cluster password.

2. Click Log In. The ClearPass Policy Manager Landing Page opens.

Figure 5 ClearPass Policy Manager Landing Page

Customizing the Landing Page Layout
To customize the Landing Page layout to display the information you most want to see (refer to Using the
Policy Manager Dashboard), drag and drop from the list of the Widget elements on Dashboard to one of the
available Dashboard slots in the right pane.

ClearPass Menu
The ClearPass Menu is available on the upper-right corner of every page in the ClearPass user interface.
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Figure 6 ClearPass Menu

From the ClearPass Menu, you can:

n Navigate to any of the ClearPass modules: Guest, Insight, Policy Manager, and Onboard.

n Bring up online Help for the current page of the ClearPass user interface.

n Access the Contact Support information.

n Log out

Using the Policy Manager Dashboard
The Policy Manager Dashboard organizes and presents the key information about the status and performance
of the current ClearPass server or cluster, as well as a set of Quick Links to the most commonly used functions,
such as configuring policies, and viewing the Access Tracker.

The Dashboard information is illustrated in interactive bar chart, graph, and table formats. To customize the
Dashboard layout to display the information you most want to see (as described in Table 1), drag and drop
from the list of the Widget elements on the left pane to one of the available Dashboard slots in the right pane.

To view the table with latest system level events, drag and drop
the Alerts widget to the Dashboard. Clicking on a row drills down
to the Event Viewer.

To view the graph that displays all requests (such as RADIUS,
TACACS+, and WebAuth requests )processed by Policy Manager
over the past week, drag and drop the All Requests widget.
Clicking on each bar in the graph drills down to the Access
Tracker page and shows the requests for the selected day.

To view the links to the Aruba Insight, Guest, and Onboard
applications that are integrated with Policy Manager, drag and
drop the Applications widget to the Dashboard.

Table 1: Dashboard Widget Summary
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To view a graph of the failed and successful requests over the
past week, drag and drop the Authentication Status to the
Dashboard. This graph includes RADIUS, WebAuth, and
TACACS+ requests. The default data filters Failed Requests
and Successful Requests are used to plot this graph.
Clicking on each circle on the line graph drills down to the
Access Tracker page that shows the failed and successful
requests for the day specified.

To view the status of all nodes in a cluster, drag and drop the
Cluster Status widget to the Dashboard. The following fields
are shown for each node:
n Status: Shows the overall health status of the cluster. Green

indicates healthy status. Red indicates connectivity problems
or high CPU or high memory utilization. The status also
shows red when a node is out-of-sync with the rest of the
cluster.

n Host Name: Specifies the name of the host and IP address
of the node.

n Zone: The configured cluster zone.
n Server Role: Indicates whether the cluster node is a

publisher or subscriber.
n Last Replication: Date of the last replication.
n Status: Indicates the status of the cluster node.

To view the chart that shows the graph of all profiled devices
categorized into the following categories:
n Access Points
n Computer
n Conflict

Indicates a conflict occurred in the categorization of the
device.

n Datacenter Appliance
n Game Console
n Monitoring Devices
n Network Boot Agents
n Physical Security
n Printer
n Router
n Server
n Smart Device
n Switch
n Unknown

Indicates devices that are not included in the Profiler
database.

n VOIP phone

To view the device family of a particular device category, drag
and drop the Device Category widget to the Dashboard, then
select the device category from the drop down menu. For
example, selecting Computer would show that the device family
is Windows.

To view a display that shows the number of smart devices,
computers, and unmanaged devices, as well as the total
number of devices defined by the Endpoint Profiler for this
ClearPass server, drag and drop the Endpoint Profiler
Summary widget to the Dashboard.
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To view the table with the latest failed authentications, drag and
drop the Failed Authentications widget to the Dashboard.
Clicking on a row drills down to the Access Tracker page and
shows failed requests sorted by timestamp, with the latest
request displayed on the top.

To view the graph of the healthy and unhealthy requests over
the past week, drag and drop the Health Status widget.
n Healthy requests are the requests to which the health state

was deemed to be healthy based on the posture data sent
from the client.

n Unhealthy requests are the requests to which the health state
was deemed to be quarantined (posture data received but
health status is not compliant) or unknown (no posture data
received).
This includes RADIUS and WebAuth requests. The default
data filters Health Requests and Unhealthy Requests are
used to plot this graph.

n Clicking on each circle on the line graph drills down to the
Access Tracker page that shows the healthy and unhealthy
requests for the last week.

To view the table with the latest authentications, drag and drop
the Latest Authentications widget to the Dashboard. Clicking
on a row in the table drills down to the Access Tracker page that
shows requests sorted by timestamp with the latest request
displayed on the top.

To view the table that displays the Available Count and Used
Count of the application licenses installed on the current
ClearPass server, drag and drop the License Usage widget to
the Dashboard.
n From the Select Application drop-down, select the

Application License of interest.

To view the charts that show the endpoints discovered, drag and
drop the MDM Discovery Summary widget to the Dashboard.
n The endpoints are displayed in separate charts based on the

endpoint's operating system.
n Clicking a chart drills down to the Configuration > Identity

> Endpoints page. The results depends on the operating
system selected.
For example, if you click the Android devices chart, you can
view the list of only Android devices in the Endpoints page.

To view a display that shows the number of Linux, Mac, and
Windows OnGuard clients, as well as the total number of
OnGuard clients for this ClearPass server, drag and drop the
OnGuard Clients Summary to the Dashboard.

ClearPass 6.7 Policy Manager | User Guide About ClearPass Policy Manager | 22
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1054



23 | About ClearPass Policy Manager ClearPass 6.7 Policy Manager |  User Guide

To view the links to the following configuration tasks, drag and
drop the Quick Links widget to the Dashboard:
n Start Configuring Policies
n Manage Services
n Access Tracker
n Analysis and Trending
n Network Devices
n Server Manager
n ClearPass Guest
n ClearPass Onboard
n ClearPass Insight
n ClearPass Extensions

To view the trend of total request processing time, drag and
drop the Request Processing Time widget to the Dashboard.

To view the bar chart with each bar representing a categorized
Policy Manager service request, drag and drop the Service
Categorization widget to the Dashboard.
n Clicking on a bar drills down to the Access Tracker that

shows the requests that were categorized into a specific
service.

To view a table with the latest successful authentications, drag
and drop the Successful Authentications widget to the
Dashboard.
n Clicking on a row in the table drills down to the Access

Tracker page that shows successful requests sorted by
timestamp, with the latest request displayed on the top.

To view the CPU usage for the last 30 minutes, drag and drop
the System CPU Utilization widget to the Dashboard.
n The widget displays the CPU utilization time in minutes and

percentage for System, User, and IO Wait time, indicated by
color.

n CPU utilization is presented in five-minute increments.

To view the Percentage Used statistics for the following
components, drag and drop the System Summary widget to
Dashboard:
n Main Memory
n Swap Memory
n Disk
n Swap Disk

Accessing Configuration Information
This section contains the following information:

n Introduction

n Service Templates & Wizards

n Services

n Authentication and Authorization
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n Identity

n Posture

n Enforcement

n Network

n Policy Simulation

n Profile and Network Scan

n Accessing Configuration Information

Introduction
This section provides pointers to information on how to configure the primary configuration tasks in ClearPass
Policy Manager. You can access all these configuration tasks via the ClearPass Configuration menu.To access
the ClearPass Configuration menu, select Configuration. The ClearPass Configuration menu opens (see
Figure 7):

Figure 7 ClearPass Policy Manager Configuration Menu

Service Templates & Wizards
The ClearPass Policy Manager Service Templates & Wizards page provides the ability to create templates for
services that will allows you to define baseline policies and require specific data when you create services.

For more information, see Configuring Services Using Service Templates & Wizards.

Services
The Services page provides options to add, modify, and remove a service. For more information, refer to the
following sections:

n Services Flow and Creation Methods on page 1

n Modifying and Managing Services
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n Using Templates to Create ClearPass Services

n Configuring Other Policy Manager Services

This page also shows the current list and order of services that ClearPass Policy Manager keeps track of during
authentication and authorization.

Authentication and Authorization
The Authentication page provides options to configure the following components:

n Adding and Modifying Authentication Methods on page 163

n Adding and Configuring Authentication Sources on page 186

n Modifying Authentication Methods or Sources for an Existing Service on page 222

Identity
The Identity page provides options on the settings required to configure ClearPass Policy Manager Identity
settings. For more information, refer to the following sections:

n Configuring Single Sign-On on page 224

n Managing Local Users on page 226

n Adding and Modifying Endpoints on page 233

n Managing Static Host Lists

n Adding and Modifying Roles

n Adding and Modifying Role-Mapping Policies

Posture
The Posture page provides options to configure posture policies and audit servers. For more information,
refer to the following sections:

n Posture Architecture and Flow

n Creating a New Posture Policy

n Configuring Audit Servers on page 347

Enforcement
The Enforcement page provides options to configure the Enforcement Profiles globally and to reference in an
enforcement policy that is associated with a service.

For more information, refer to the following sections:

n Configuring Enforcement Profiles

n Configuring Enforcement Policies

Network
The Network page provides options to configure the Network Access Device (NAD) that sends network access
requests to Policy Manager using the supported RADIUS, TACACS+, or SNMP protocol. The NAD in this context
is usually a mobility controller or a switch.

For more information, refer to the following sections :

n Adding a Network Device

n Adding and Modifying Device Groups

n Adding and Modifying Proxy Targets
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n Configuring the Ingress Event Source

Policy Simulation
The Policy Simulation page provides options to configure the Policy Simulation utility that applies a set of
request parameters as input against a given policy component.

n For more information, refer to Configuring Policy Simulation.

Profile and Network Scan
The Profile and Network Scan page provides options to configure the following elements:

n Subnet scans: See Scheduling Network Scans and Subnet Scans.

n Network scans: See Scheduling Network Scans and Subnet Scans.

n SNMP Configuration: See SNMP Credentials Configuration.

n SSH Configuration: See SSH Credentials Configuration.

n WMI Configuration: See WMI Credentials Configuration.

Importing and Exporting Information
This section contains the following information:

n Importing Information Into ClearPass

n Exporting Information From ClearPass

The option to import information into or export information from a ClearPass server is available from every
top-level page in the ClearPass Policy Manager user interface. The Add, Import, and Export All options are
displayed in the top-right corner of the configuration and administration pages:

Importing Information Into ClearPass
ClearPassPolicy Manager allows you to import configuration and administration-related information. This
information is stored as an XML file, which can be password protected. For information about the tags and
attributes in the XML file, refer to Appendix B, "Using the ClearPass Configuration API" in the ClearPass
Deployment Guide.

To import information into the current ClearPass server:

1. Click the Import link. The Import from file dialog opens.
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Figure 8 Import From File Dialog

2. Click Browse.

3. Browse to the file you want to import.

l Be sure to select an XML file that is in the correct format.

See Appendix B, "Using the ClearPass Configuration API" in the ClearPass Deployment Guide for more information
about the format and contents of XML files.

4. Enter secret for the file (if any): If you entered a secret key to encrypt the exported file, enter the same
secret key to import the device back into this ClearPass server.

5. Click Import.

Exporting Information From ClearPass
ClearPassPolicy Manager allows you to export configuration and administration-related information from the
current ClearPass server to an XML file. You can set this file to be password protected (see Table 1 for details).

To export multiple items, select the check boxes in the rows of the specific items that you want to export.

To export information from the current ClearPass server:

1. Click the Export All link at the top-right corner of the configuration page.

The Export to File dialog opens.

Figure 9 Export to File Dialog

2. Specify the export parameters based on Table 1.

Specify the Export to file parameters as described in Table 1:
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Parameter Action/Description

Export file with password
protection

To export the file with password protection, choose Yes.

Secret Key/ Verify Secret You can choose to encrypt the exported data with a key. This protects data such
as shared secret from being visible in the exported file. To import it back, you
specify the same key with which you exported
Enter the secret key. Then reenter the secret key.

Table 1: Export to File Dialog Parameters

3. Click Export.

An export dialog named for the selected ClearPass function opens:

Figure 10 Export XML File to Zip File Dialog

4. Specify to open the zip file or save the XML file to your system.

5. Click OK to proceed.

Export Considerations
The XML file generated from an export operation has a specific layout that is unique for each function in the
ClearPass user interface. If you import an XML file with an incorrect layout (usually because it's from the wrong
function), it will be rejected. Aruba recommends that you note the message displayed when the XML operation
is incorrect and what the issue is—typically either because it's from the wrong export file or because it was
modified incorrectly before being imported.
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Chapter 2
Services

This chapter describes the following topics:

n Viewing the List of Services

n Configuring Services Using Service Templates & Wizards

n Configuring Other Policy Manager Services

n Modifying and Managing Services

The Policy Manager policy model groups policy components that serve a specific type of request into the
Services page.

Viewing the List of Services
The Services page shows the current list and order of services that ClearPass Policy Manager follows during
authentication and authorization. You can use the configured default service types or you can add additional
services. To view the list of services on the current ClearPass server, navigate to Configuration > Services to
display the Services page:

Figure 11 Services Page

Services included in square brackets "[ ]" indicate default services.

To view a service's details, select the service of interest. As shown in Figure 12, the Edit Services page opens to
the Summary page, which provides the detailed information about the selected service's configuration.
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Figure 12 Viewing Details for an Individual Service

For information about additional common service tasks, see also Modifying and Managing Services.

Configuring Services Using Service Templates & Wizards
ClearPass Policy Manager Service templates provide a way to step through the service-creation process for the
most common use cases, allowing you to easily create services and configure their specific components, such
as role-mapping policies, enforcement policies, and associated network devices. Other service types can be
configured manually, or using the service wizards.

Using Templates to Create ClearPass Services
You can use templates to create services for common use cases for by defining baseline policies and required
data:

1. Navigate to the Configuration > Service Templates & Wizards page. The Service Templates
& Wizards page opens.
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Figure 13 Service Templates & Wizards Page (Partial View)

2. Select the desired service template.The configuration dialog for the selected service template opens, as
shown in the following example:

Figure 14 Auto Sign-On Service Template

3. Fill in the various fields that are presented in the templates—Policy Manager then creates the configuration
elements that are needed for that particular service.
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List of Provided Service Templates
Refer to the following descriptions of the ClearPass service templates for configuration details:

n 802.1X Wired, 802.1X Wireless, and Aruba 802.1X Wireless Service Template

n Aruba Auto Sign-On Service Template

n Aruba VPN Access with Posture Checks Service Template

n Certificate/Two-Factor Authentication for ClearPass Application Login Service Template

n ClearPass Admin Access Service Template

n ClearPass Admin SSO Login (SAML SP Service) Service Template

n Cloud Identity/Social Media Authentication Service Template

n ClearPass Identity Provider (SAML IdP Service) Service Template

n Device MAC Authentication Service Template

n Eduroam Service Template

n Encrypted Wireless Access via 802.1X Public PEAP Method Service Template

n Guest Access Service Template

n Guest Access Web Login Service Template

n Guest Authentication with MAC Caching Service Template

n OAuth2 API User Access Service Template

n Onboard Service Template

Using Wizards to Create ClearPass Services
Although Policy Manager includes templates to define services for the most common use cases, you can
manually configure services for any of the other supported service types using service Wizards, or by manually
creating your services on the Configuration > Services > Add page.

For more information on wizards and the procedures to manually define these other service types, see
Configuring Other Policy Manager Services.

802.1X Wired, 802.1X Wireless, and Aruba 802.1X Wireless Service Template

ClearPass Policy Manager includes the following 802.1X service templates. All three of these 802.1X service
templates are configured using identical parameters.

n The 802.1X Wired service template is designed for wired end-hosts connecting through an Ethernet LAN
using IEEE 802.1X authentication. The 802.1X Wired service template allows configuration of both
identity-based and posture-based policies.

n The 802.1X Wireless template is for wireless end-hosts connecting through an 802.11 wireless access
device or controller using IEEE 802.1X authentication. The 802.1X Wireless template allows configuring
both identity-based and posture-based policies.

n The Aruba 802.1X Wireless template is designed for wireless end-hosts connecting through an Aruba
802.11 wireless access device or controller using IEEE 802.1X authentication (service rules customized for
Aruba WLAN controllers).

Adding a Service to an 802.1X Template
To access the 802.1X Wired and Wireless service templates:

1. Navigate to Configuration > Service Templates & Wizards.
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2. From the Service Templates & Wizards page, select the desired 802.1X Wired or Wireless service
template. The desired 802.1X Wired or Wireless service template page opens to the General tab.

Figure 15 Service Templates > 802.1X Wired Service Template

3. Specify a unique Name Prefix (applies only to the selected template) in the General tab.

4. Update the required fields in the Authentication and Enforcement Details sections.

5. Click Add Service. An entry for the new set of configuration is created under the Services, Roles, Role
Mapping, Enforcement Policies and Profiles menus.

Not all the Policy Manager service templates include the same sections as the 802.1X service templates. It is
recommended to customize the respective templates when you add a new service.

Once you add a new service to the service template, the service denoted by the Name Prefix appears in
the Select Prefix drop-down. Selecting a prefix from the drop-down populates the existing configuration
for the service.

6. Specify the parameters in the 802.1X Wired, 802.1X Wireless, and Aruba 802.1X Wireless service templates
as described in the following table:

Parameter Action/Description

General

Select Prefix Select a prefix from the existing list of prefixes.
This populates the preconfigured information in the Authentication and Enforcement
Details sections. The Name Prefix field is not editable.

Name Prefix Enter a prefix that is appended to services using this template.
Use this to identify the services that use this template.

Authentication

Select Authentication
Source

Select any available authentication source from the drop-down list.
When you select an existing authentication source, the "Create an Active Directory
Authentication Source" section is removed. The information required for the
Authentication and Enforcement Details tabs is automatically populated.

Create an Active Directory Authentication Source

Active Directory Name To create a new Active Directory authentication source, enter the name of the Active
Directory. This field is mandatory.

Description Enter a description that helps you to identify the characteristics of this template.
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Parameter Action/Description

This field is mandatory.

Server Enter the hostname or the IP address of the Active Directory server. This field is
mandatory.

Port Enter the TCP port where the server is listening for a connection.
This field is mandatory.

Identity Enter the Distinguished Name (DN) of the administrator account. This field is mandatory.

Password Enter the account password. This field is mandatory.

NetBIOS Enter the server Active Directory domain name. This field is mandatory.

Base DN Enter the Distinguished Name (DN) of the node in your directory tree from which to start
searching for records. This field is mandatory.

Enforcement Details

Attribute Name The attributes defined in the Authentication Source are listed here.
Configure an optional enforcement policy based on the following attributes:
n Account Expires
n Department
n Email
n Name
n Phone
n UserDN
n Company
n member of
For example, you can configure an enforcement policy for a contractor specifying that "If
Name equals <contractor_name>, then assign the [Contractor] Role."

Attribute Value Enter the active directory attribute value for the selected name in the Attribute Name
field.

VLAN ID Enter the standard RADIUS-IETF VLAN ID.

Default VLAN/Role You can specify a default VLAN or role for instances in which the VLAN or role is not
specified.

Wired Network Settings

Select Switch Select any switch from the drop-down list.

Device Name When you select a switch from the drop-down list, ClearPass automatically populates the
name of the device.

IP Address When you select a switch from the drop-down list, ClearPass automatically populates the
IP address of the device.

Vendor Name When you select a switch from the drop-down list, ClearPass automatically populates the
manufacturer of the wired controller.

RADIUS Shared Secret When you select a switch from the drop-down list, ClearPass automatically populates the
shared secret that is configured on the controller and inside Policy Manager to send and
receive RADIUS requests.
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Enable RADIUS CoA When you select a switch from the drop-down list, ClearPass automatically populates
enables RADIUS-initiated Change of Authorization (CoA) on the network device.

RADIUS CoA Port Specifies the default port 3799 when RADIUS CoA is enabled.
Change this value only if you defined a custom port on the network device.

Wireless Network Settings

Wireless Controller
Name

Enter the name of the wireless controller.

Controller IP Address Enter the IP address of the wireless controller.

Vendor Name Select the manufacturer of the wireless controller.

RADIUS Shared Secret Enter the shared secret that is configured on the controller and Policy Manager to send
and receive RADIUS requests.

Enable RADIUS CoA Select to enable RADIUS initiated CoA on the network device.

RADIUS CoA Port Specifies the default port 3799 if RADIUS CoA is enabled.
Change this value only if you defined a custom port on the network device.

Posture Settings

Enable Posture Checks Select the check box to perform health checks post-authentication. This enables the Host
Operating System and Quarantine Message fields.

Host Operating System Select the operating system: Windows, Linux, or macOS.

Quarantine Message Specify the quarantine message that will appear on the client.

Deleting a Service
To delete a service:

1. Select the appropriate service from the Select Prefix drop-down.

2. Click Delete.

All the configured entries under the Services, Authentication Source, Roles, Role Mapping,
Enforcement Policies and Profiles menu are deleted if these entities were created from the service
template.

When you edit or delete the entities of a service, a message is displayed at the top of the entity page stating that the
selected entity was created through the service template. Do not delete entities used in service configurations that
were not created using the service template.

Aruba Auto Sign-On Service Template
The Aruba Auto Sign-On service template allows you to access the SAML-based single sign-on-enabled
applications (such as Policy Manager, Guest, Onboard, and ClearPass Insight) using a network authenticated
(802.1X) identity through controllers.

To access the Auto Sign-On Service service template:

1. Navigate to Configuration > Service Templates & Wizards.
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2. From the Service Templates & Wizards page, select Aruba Auto Sign-On Service. The Service
Templates - Auto Sign-On Service page opens to the General tab.

Figure 16 Auto Sign-On Service Template

3. Specify the Auto Sign-On service template parameters as described in the following table:

Parameter Action/Description

General

Name Prefix Enter a prefix that you want to append to services using this template.
Use this to identify services that use this service template.

Authentication

Select Authentication
Source

Select an authentication source from the list.
The information provided in the Authentication, Enforcement Details, and SP details
tabs are auto-populated.

Active Directory Name Enter the hostname or the IP address of the Active Directory server.
This field is mandatory.

Description Enter a description that helps you to identify the characteristics of this template.
This field is mandatory.

Server Enter the hostname or the IP address of the Active Directory server. This field is
mandatory.

Port Enter the TCP port where the server is listening for a connection.
This value defaults to 389. This field is mandatory.

Identity Enter the Distinguished Name (DN) of the administrator account. This field is mandatory.

Password Enter the account password. This field is mandatory.

NETBios Enter the server Active Directory domain name. This field is mandatory.

Base DN Enter the Base DN of the administrator account. This field is mandatory.

Enforcement Details

Create new
Enforcement Policy

Configure an optional enforcement policy based on the following attributes:
n Department
n Email
n Name

Table 1: Aruba Auto Sign-On Service Template Parameters
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n Phone
n UserDN
n company
n memberOf
n Title

SP Details

SP URL Enter the Service Provider (SP) URL.

Attribute Name Enter attribute names and assign values to those names.
These name/value pairs are included in SAML responses.

Attribute Value

Aruba VPN Access with Posture Checks Service Template
The Aruba VPN Access with Posture Checks service template authenticates Aruba VPN clients connecting
remotely to corporate networks. Differentiated access is based on the result of posture checks.

This template does the following:

n Configures an Active Directory authentication source.

n Joins this node to the Active Directory domain.

n Creates an enforcement policy for Active Directory-based attributes.

n Creates a Network Access Device (NAD).

To access the Aruba VPN Access with Posture Checks service template:

1. Navigate to Configuration > Service Templates & Wizards.

2. From the Service Templates & Wizards page, select Aruba VPN Access with Posture Checks. The Service
Templates -Aruba VPN Access with Posture Checks page opens to the General tab.
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Figure 17 Aruba VPN Access with Posture Checks Service Template

Specify the Aruba VPN Access with Posture Checks service template parameters as described in the
following table:

Parameter Action/Description

General

Select Prefix Select a prefix from the existing list of prefixes.
This populates the preconfigured information in the Authentication Aruba
Wireless Controller for VPN Settings and Aruba User Roles for different
access privileges sections. The Name Prefix field is not editable.

Name Prefix Enter a prefix that you want to append to services using this template. Use this to
identify services that use templates.

Authentication

Select Authentication Source Select an authentication source from the list.
The information provided in the Authentication, Aruba Wireless Controller for
VPN Settings, and Aruba User Roles for different access privileges sections
are auto-populated.

Active Directory Name Enter the Active Directory name.

Description Enter a description that helps you to identify the characteristics of this template.

Server Enter the host name or the IP address of the Active Directory server.

Identity Enter the Distinguished Name (DN) of the administrator account.

NetBIOS Enter the server Active Directory domain name.

Base DN Enter the Distinguished Name (DN) of the node in your directory tree from which to
start searching for records.

Password Enter the account password.

Port Enter the TCP port where the server is listening for a connection.

Aruba Wireless Controller for VPN Access

Select Wireless Controller Select a wireless controller from the drop-down list.

Wireless controller name Enter the name given to the wireless controller.

Table 1: Aruba VPN Access with Posture Checks Service Template Parameters
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Controller IP Address Enter the wireless controller's IP address.

Vendor Name Select the manufacturer of the wireless controller.

RADIUS Shared Secret Enter the shared secret that is configured on the controller and inside Policy
Manager to send and receive RADIUS requests.

Enable RADIUS CoA Select this option to enable RADIUS initiated CoA on the network device.

RADIUS CoA Port Specifies the default port 3799 if RADIUS CoA is enabled.
NOTE: Change this value only if you defined a custom port on the network device.

Aruba User Roles for different access privileges - Create a new Enforcement Policy

Initial Role (before posture
checks)

Enter the initial role of the client before posture checks are performed.

Quarantined Role (failed
posture checks)

Enter the role of clients that fail posture checks.

Healthy Role (passed
posture checks)

Enter the role of the client after a posture check is passed and deemed healthy.

Certificate/Two-Factor Authentication for ClearPass Application Login Service
Template
This service template allows administrators and operators to log in to ClearPass using a smart card and TLS
(Transport Layer Security) certificates. To log in using a smart card and TLS certificates, ensure that the services
are configured using the Certificate/Two-Factor Authentication for ClearPass Application Login service
template.

Adding a Service to the Template
To access the Certificate/Two-Factor Authentication Service service template:

1. Navigate to Configuration > Service Templates & Wizards.

2. From the Service Templates & Wizards page, select Certificate/Two-Factor Authentication Service.
The Service Templates - Certificate/Two-Factor Authentication Service page opens to the General
tab.

Figure 18 Certificate/Two-Factor Authentication Service Template
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Specify the Certificate/Two-Factor Authentication for ClearPass Application Login service template
parameters as described in the following table:

Parameter Action/Description

General

Select Prefix 1. Select a prefix from the existing list of prefixes.
This field populates the pre-configured information in the Authentication,
SP details, and Enforcement Details sections. The Name Prefix field is not
editable.

Name Prefix 2. Enter a prefix that you want to append to services using this template.
Use this to identify services that use templates.

Service Rule

Application 3. Select the application for which SAML-based Single Sign-On (SSO) should be
enabled from the following options: Policy Manager, Guest, Insight, and Onboard.

Authentication

Select Authentication
Source

4. Select an authentication source from the list.
The information provided in the Authentication, Enforcement Details, and
SP details tabs are auto-populated.

Active Directory Name 5. Enter the hostname or the IP address of the Active Directory server.
This field is mandatory.

Description 6. Enter a description that helps you to identify the characteristics of this template.
This field is mandatory.

Server 7. Enter the hostname or the IP address of the Active Directory server.
This field is mandatory.

Port 8. Enter the TCP port where the server is listening for a connection.
The default value is value defaults to 389. This field is mandatory.

Identity 9. Enter the DN of the administrator account. This field is mandatory.

Password 10. Enter the account password. This field is mandatory.

NETBIOS 11. Enter the server Active Directory domain name. This field is mandatory.

Base DN 12. Enter the Distinguished Name (DN) of the administrator account. This field is
mandatory.

IdP Details

Page Name 13. Select the Web Login pages from the drop-down list.
For more information, see the next section, Creating a New Web Login Page.

Enforcement Details

Table 1: ClearPass Certificate/Two-Factor Authentication Service Template Parameters

Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1073



Parameter Action/Description

Certificate Attribute -
Super Admin Condition

14. Select the certificate attribute from the drop-down list.
15. Enter the value in the Super Admin Condition field that matches the Certificate
Attribute value to provide the super administrator access.

Certificate Attribute -
Read Only Admin
Condition

16. Select the certificate attribute from the drop-down list.
17. Enter the value in the Read Only Admin Condition field that matches the
Certificate Attribute value to provide the Read-Only administrator access.

Certificate Attribute -
Help Desk Admin
Condition

18. Select the certificate attribute from the drop-down list.
19. Enter the value in the Help Desk Admin Condition field that matches the
Certificate Attribute value to provide the help desk administrator access.

Creating a New Web Login Page
To create a new Web Login page:

1. Click the Add New Guest Web Login page link. This opens the ClearPass Guest application in which you
can create a new Guest Web Login page.

2. To log in using a smart card and TLS certificates, navigate to ClearPass Guest > Configuration > Pages >
Web Logins.

3. In the Vendor Settings field, select Single Sign On -SAML Identity Provider.

a. When you select Optional - Request a client certificate from the user, but allow none from the
Client Certificate field, the user needs to provide a certificate, username, and password.

b. When you select Required - Require a client certificate from the user from the Client Certificate
field, the user needs to provide only certificates for authentication.

This enables the Authentication field with the following options:

l Certificate only - No username or password required: Requires only certificate authentication.

l Credentials - Also require a username and password: Requires the username and password.

ClearPass Admin Access Service Template
This template is designed for services that authenticate users against Active Directory. Use Active Directory
attributes to determine appropriate privilege levels for ClearPass Policy Manager admin access.

To access the ClearPass Admin Access service template:

1. Navigate to Configuration > Service Templates & Wizards.

2. From the Service Templates & Wizards page, select ClearPass Admin Access. The Service Templates
- ClearPass Admin Access page opens to the General tab.

Figure 19 ClearPass Admin Access Service Template
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Specify the ClearPass Admin Access service template parameters as described in the following table:

Parameter Action/Description

General

Select Prefix Select a prefix from the existing list of prefixes.
This populates the preconfigured information in the Authentication and Role Mapping
sections. The Name Prefix field is not editable.

Name Prefix Enter a prefix that you want to append to services using this template. Use this to identify
services that use templates.

Authentication: Create an Active Directory Authentication Source

Select Authentication
Source

Select an authentication source from the list.
The information updated in the Authentication and Role Mapping tabs are auto-
populated.

Active Directory
Name

Enter the hostname or the IP address of the Active Directory server. This field is
mandatory.

Description Enter a description that helps to identify the characteristics of this template. This field is
mandatory.

Server Enter the hostname or the IP address of the Active Directory server. This field is
mandatory.

Port Enter the TCP port where the server is listening for a connection. This field is mandatory.

Identity Enter the Distinguished Name (DN) of the administrator account. This field is mandatory.

Password Enter the account password. This field is mandatory.

NetBIOS Enter the server Active Directory domain name. This field is mandatory.

Base DN Enter the DN of the administrator account. This field is mandatory.

Role Mapping

Attribute Name Select the Active Directory attribute.

Super Admin
Condition

Defines the various privilege levels.

Read Only Admin
Condition

Help Desk Condition

Table 1: ClearPass Admin Access Service Template Parameters

ClearPass Admin SSO Login (SAML SP Service) Service Template
This application service template allows Security Asserting Markup Language (SAML)-based Single Sign-On (SSO)
authenticated users to access Policy Manager, Guest, Insight, and Operator pages.

To access the ClearPass Admin SSO Login service template:

1. Navigate to Configuration > Service Templates & Wizards.

2. From the Service Templates & Wizards page, select ClearPass Admin SSO Login.
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The Service Templates - ClearPass Admin SSO Login page opens to the General tab.

Figure 20 ClearPass Admin SSO Login (SAML SP Service) Service Template

Specify the ClearPass Admin SSO Login service template parameters as described in the following table:

Parameter Action/Description

General

Select Prefix Select a prefix from the existing list of prefixes.
This populates the preconfigured information in the Service Rule tab. The Name Prefix field is not
editable.

Name Prefix Enter a prefix that you want to append to services using this template.
Use this to identify services that use templates.

Service Rule

Application Select the application that single-sign-on-authenticated administrative users can access.

Table 1: ClearPass Admin SSO Login Service Template Parameters\

ClearPass Identity Provider (SAML IdP Service) Service Template
This template is designed for services that act as an Identity Provider (IdP). This Identity Provider feature allows
the Layer-2 device, RADIUS server, and SAML Identity Provider to work together and deliver application-based
single sign-on using network authentication information.

To access the ClearPass Identity Provider (SAML IdP Service) service template:

1. Navigate to Configuration > Service Templates & Wizards.

2. From the Service Templates & Wizards page, select ClearPass Identity Provider (SAML IdP Service).
The Service Templates - ClearPass Identity Provider (SAML IdP Service) page opens to the General
tab.

Figure 21 ClearPass Identity Provider (SAML IdP Service)
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Specify the ClearPass Identity Provider (SAML IdP Service) service template parameters:

Parameter Action/Description

General

Select Prefix Select a prefix from the existing list of prefixes.
This populates the pre-configured information in the Authentication and SP Details
sections. The Name Prefix field is not editable.

Name Prefix Enter a prefix that you want to append to services using this template. Use this to identify
services that use templates.

Authentication

Select
Authentication
Source

Select an authentication source from the list, the information updated in the Authentication
and SP Details tabs are auto-populated.

Active Directory
Name

Enter the hostname or the IP address of the Active Directory server. This field is mandatory.

Description Enter a description that helps you to identify the characteristics of this template. This field is
mandatory.

Server Enter the hostname or the IP address of the Active Directory server. This field is mandatory.

Identity Enter the Distinguished Name (DN) of the administrator account. This field is mandatory.

NetBIOS Enter the Active Directory server domain name. This field is mandatory.

Base DN Enter the Distinguished Name (DN) of the administrator account. This field is mandatory.

Password Enter the account password. This field is mandatory.

Port Enter the TCP port where the server is listening for a connection. This field is mandatory.

SP Details

SP URL Enter the Service Provider (SP) URL.

Attribute Name Enter the name of the attributes and assign values to those names. These name/value pairs
are included in SAML responses.

Attribute Value

Table 1: ClearPass Identity Provider (SAML IdP Service) Service Template Parameters

Cloud Identity/Social Media Authentication Service Template
You can use this service template to authenticate guest users who log in to the network via captive portal with
their social media accounts. Guests must reauthenticate after their session ends. You can limit the network
access for guest devices that do not have a user directly associated with them for a specific duration in days or
by a bandwidth limit.

To access the Cloud Identity/Social Media Authentication service template:

1. Navigate to Configuration > Service Templates & Wizards.

2. From the Service Templates & Wizards page, select Cloud Identity/Social Media Authentication.
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The Service Templates - Cloud Identity/Social Media Authentication page opens to the General
tab.

Figure 22 Cloud Identity/Social Media Authentication Service Template

3. Specify the parameters in the Service Templates - Cloud Identity/Social Media Authentication
service template as described in the following table:

Parameter Description

General

Name Prefix Enter a prefix that you want to append to services using this template. Use this to
identify services that use this service templates.

Wireless Network Settings

Select Wireless Controller From the drop-down, select the IP address of the wireless controller.

Wireless Controller Name When you select the Wireless Controller, ClearPass automatically populates this
field..

Controller IP Address When you select the Wireless Controller, ClearPass automatically populates this
field...

Vendor Name When you select the Wireless Controller, ClearPass automatically populates this field.

RADIUS Shared Secret When you select the Wireless Controller, ClearPass automatically populates the
shared secret that is configured on the controller and in Policy Manager to send and
receive RADIUS requests.

Enable RADIUS CoA When you select the wireless controller, ClearPass automatically enables RADIUS-
initiated CoA (Change of Authorization) on the network device.

RADIUS CoA Port Specifies the default port 3799 when RADIUS CoA is enabled.
NOTE: Change this value only if you defined a custom port on the network device.

Guest Access Restrictions

Social Login Provider Select the social media network provider(s): Google, Facebook, LinkedIn, and Twitter.

Days allowed for access Deselect the days of the week that the guest users are not allowed network access.
By default, all seven days of the week are enabled for guest access.

Maximum bandwidth
allowed per user

Specify the maximum amount of data in Megabytes a user is allowed per day. A value
of 0 (zero) means no limit is set (the default).

Table 1: Cloud Identity/Social Media Authentication Service Template Parameters
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4. Click Add Service.
You return to the Service page where the new service created by the service template has been added and
enabled. A message like the following is also displayed:

l Added 6 Enforcement Profile(s)

l Added 1 Enforcement Policies

l Added 1 service(s)

Device MAC Authentication Service Template
This template is designed for authenticating guest devices based on their MAC address. You can limit the
network access for guest devices that do not have user directly associated with them for a specific duration in
days or by the bandwidth limit.

To access the Device MAC Authentication service template:

1. Navigate to Configuration > Service Templates & Wizards.

2. From the Service Templates & Wizards page, select Device MAC Authentication.

The Service Templates - Device MAC Authentication page opens to the General tab.

Figure 23 Device MAC Authentication Service Template

Specify the parameters in the Device MAC Authentication service template as described in the following
table:

Parameter Action/Description

General

Select Prefix Select a prefix from the existing list of prefixes. This populates the preconfigured information in
the Authentication and SP Details sections. The Name Prefix field is not editable.

Name Prefix Enter a prefix that you want to append to services using this template. Use this to identify
services that use templates.

Network Settings

Select Device Select a preconfigured device from the drop-down list. To create a new device, leave this field
blank and enter the remaining fields.

Device Name The name of the device is populated automatically based on the device selected from the
Select Device field. If you create a new device, enter the name of the device.

Table 1: Device MAC Authentication Template Parameters
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IP Address The IP address of the device is populated automatically based on the device selected from the
Select Device field. If you create a new device, enter the name of the device.

Vendor Name The name of the manufacturer of the device is populated automatically based on the device
selected from the Select Device field. If you create a new device, enter the name of the
manufacturer of the device.

RADIUS Shared
Secret

Enter the shared secret that is configured on the controllerand in Policy Manager to send and
receive RADIUS requests.

Enable RADIUS
CoA

Select to enable RADIUS initiated Change of Authorization (CoA) on the network device.

RADIUS CoA Port Specifies the default port 3799 if RADIUS CoA is enabled. Change this value only if you defined
a custom port on the network device.

Device Access Restrictions

Days allowed for
access

Select the days on which network access is allowed.

Maximum
bandwidth
allowed per
device

Enter a number to set an upper limit for the amount of data in megabytes to which a device is
allowed per day. A value of 0 (zero), the default, means no limit is set.

Eduroam Service Template
This template is designed for the following scenarios:

n Local campus users connecting to eduroam from the local wireless network.

n Roaming users from an eduroam campus connecting to their campus network.

n Roaming users connecting from a local campus or other campuses that are part of the eduroam federation.

To access the Eduroam service template:

1. Navigate to Configuration > Service Templates & Wizards.

2. From the Service Templates & Wizards page, select Eduroam.

The Service Templates - Eduroam page opens to the General tab.
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Figure 24 Eduroam Service Template

Specify the parameters used in the Eduroam service template as described in the following table:

Parameter Action/Description

General

Select Prefix Select a prefix from the existing list of prefixes.
This populates the pre-configured information in the Authentication, Service Rule,
Wireless, andFederation Level Radius Server (FLR) tabs. The Name Prefix field
is not editable.

Name Prefix Enter a prefix that you want to append to services using this template.
Use this to identify services that use templates.

Service Rule

Enter domain details Enter the domain name of the network.
For example, @edunet.ucla.com. This field is mandatory.

Select Vendor Select the vendor of the network device. This field is mandatory.

Authentication

Select Active Directory Select an authentication source from the list, the information updated in the
Authentication, Wireless, and Federation Level Radius Server (FLR) tabs are
auto-populated.

Active Directory Name Enter the hostname or the IP address of the Active Directory server. This field is
mandatory.

Description Enter a description that helps you identify the characteristics of this template. This
field is mandatory.

Server Enter the host name or the IP address of the Active Directory server. This field is
mandatory.

Identity Enter the Distinguished Name (DN) of the administrator account. This field is
mandatory.

NetBIOS Enter the server Active Directory domain name. This field is mandatory.

Base DN Enter the Distinguished Name (DN) of the administrator account. This field is
mandatory.

Password Enter the account password. This field is mandatory.

Table 1: Eduroam Service Template Parameters
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Parameter Action/Description

Port Enter the TCP port where the server is listening for a connection. This field is
mandatory.

Wireless Network Settings

Select wireless controller Select a wireless controller from the drop-down list.

Wireless controller name Enter the name given to the wireless controller.

Controller IP Address Enter the IP address of the wireless controller.

Vendor Name Select the manufacturer of the wireless controller.

RADIUS Shared Secret Enter the shared secret that is configured on the controllerand inside Policy Manager
to send and receive RADIUS requests.

Enable RADIUS CoA Select to enable RADIUS initiated CoA on the network device.

RADIUS CoA Port Specifies the default port 3799 if RADIUS CoA is enabled. Change this value only if
you defined a custom port on the network device.

Federation Level RADIUS Server (FLR)

Host Name Enter the host name of the federation RADIUS server.

IP Address Enter the IP address of the federation RADIUS server.

Vendor Name Select the manufacturer of the wireless controller.

RADIUS Shared Secret Enter the shared secret that is configured on the controllerand inside Policy Manager
to send and receive RADIUS requests.

Enable RADIUS CoA Select to enable RADIUS initiated CoA on the network device.

RADIUS CoA Port Specifies the default port 3799 if RADIUS CoA is enabled.
NOTE: Change this value only if you defined a custom port on the network device.

RADIUS Authentication Port Enter the port number for the RADIUS Authentication Port.

RADIUS Accounting Port Enter the port number for the RADIUS Accounting Port.

Encrypted Wireless Access via 802.1X Public PEAP Method Service Template
This template is designed for providing encrypted wireless access to users using fixed 802.1X PEAP credentials.
It configures an EAP PEAP Public type authentication method and creates an enforcement policy for network
access.

To access the Encrypted Wireless Access via 802.1X Public PEAP Method service template:

1. Navigate to Configuration > Service Templates & Wizards.

2. From the Service Templates & Wizards page, select Encrypted Wireless Access via 802.1X Public
PEAP Method.
The Service Templates - Encrypted Wireless Access via 802.1X Public PEAP Method page opens to
the General tab.
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Figure 25 Encrypted Wireless Access via 802.1X Public PEAP Method Service Template

Specify the parameters used in the Encrypted Wireless Access via 802.1X Public PEAP method service
template s described in the following table:

Parameter Action/Description

General

Name Prefix Enter a prefix that you want to append to services using this template. You can use this to
identify services that use templates.

Wireless Network Settings

Select wireless
controller

Select a wireless controller from the drop-down list.

Wireless controller
name

Enter the name given to the wireless controller.

Controller
IP Address

Enter the IP address of the wireless controller.

Vendor Name Select the manufacturer of the wireless controller.

RADIUS Shared
Secret

Enter the shared secret that is configured on the controllerand inside Policy Manager to send
and receive RADIUS requests.

Enable RADIUS CoA Select to enable RADIUS initiated CoA on the network device.

RADIUS CoA Port Specifies the default port 3799 if RADIUS CoA is enabled.
NOTE: Change this value only if you defined a custom port on the network device.

Authentication Method

Public Username Enter the public username for the EAP PEAP Public type authentication method.

Public Password Enter the password for the EAP PEAP Public type authentication method.

Access Restrictions

Days allowed for
access

Select the days on which network access is allowed.

Table 1: Encrypted Wireless Access via 802.1X Public PEAP Method Service Template Parameters

Guest Access Service Template
This template is designed for authenticating guest users who log in using captive portal. Guests must
reauthenticate after session expiry. Guest access can be restricted based on day of the week, bandwidth limit,
and number of unique devices used by the guest user.
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To access the Guest Access service template:

1. Navigate to Configuration > Service Templates & Wizards.

2. From the Service Templates & Wizards page, select Guest Access. The Service Templates - Guest
Access page opens to the General tab.

Figure 26 Guest Access Service Template

Specify the parameters used in the Guest Access service template as described in the following table:

Parameter Action/Description

General

Select Prefix Select any one prefix from the existing list of prefixes.
This populates the pre-configured information in the Wireless Network Settings and
Guest Access Restrictions sections. The Name Prefix field is not editable.

Name Prefix Enter a prefix that you want to append to services using this template. Use this to identify
services that use templates.

Wireless Network Settings

Wireless SSID for
Guest access

Enter the SSID value here.

Select wireless
controller

Select the wireless controller from the drop-down list if you already configured.

Wireless controller
name

Enter the name of the wireless controller.

Controller
IP Address

Enter the wireless controller's IP address.

Vendor Name Select the manufacturer of the wireless controller.

RADIUS Shared
Secret

Enter the shared secret that is configured on the controller and inside Policy Manager to
send and receive RADIUS requests.

Enable RADIUS CoA Select to enable RADIUS initiated CoA on the network device.

RADIUS CoA Port Specifies the default port 3799 if RADIUS CoA is enabled.
NOTE: Change this value only if you defined a custom port on the network device.

Posture Settings

Table 1: Guest Access Service Template Parameters
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Parameter Action/Description

Enable Posture
Checks

Select the check box to perform health checks post authentication.
This enables the Host Operating System and Quarantine Message fields.

Host Operating
System

Select the operating system: Windows, Linux, or macOS.

Quarantine
Message

Specify the quarantine message that will appear on the client.

Initial Role/ VLAN Enter the initial role of the client before posture checks are performed.

Quarantine
Role/VLAN

Enter the role of clients that fail posture checks.

Guest Access Restrictions

Days allowed for
access

Select the days of the week that guest users are allowed network access.

Maximum
bandwidth allowed
per user

Enter a number to set an upper limit for the amount of data in Megabytes (MB) to which a
user is allowed per day.
A value of 0 (zero), the default, means no limit is set.

Guest Access Web Login Service Template
This service performs an authentication check for guests logging in using the Guest Portal. To use this service:

1. First create a Guest Web Login page that sets the Pre-Auth Check option to AppAuth - Check using
Aruba Application Authentication (for details, see Authentication in Guest Web Login Using OnGuard
Native Dissolvable Agent).

2. Navigate to Configuration > Start Here. The list of ClearPass Service Templates opens.

3. Select Guest Access - Web Login. The Guest Access Web Login service template opens:

Figure 27 Guest Access-Web Login Service Template

4. Specify the Guest Access - Web Login service template parameters as described in the following table:
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Parameter Action/Description

General

Select Prefix From the drop-down, select Guest Web Login.
This prefix is appended to services that use this template.

Name Prefix The prefix you selected is automatically populated into this field.

Service Rule

Page name From the Page name drop-down, select the name of the appropriate Guest Web Login page.

Add New Guest
Web Login page

To launch a new Web session to add a new Guest Web Login page, click this link.

Guest Access Restrictions

Enable days
allowed for guest
access

Select the days of the week that guest users are allowed network access.
NOTE: All seven days of the week are enabled by default.

Table 1: Guest Web Login Service Template Parameters

5. Click Add Service.

Guest Authentication with MAC Caching Service Template
This template is designed for authenticating guest accounts based on the cached MAC addresses used during
authentication. Users first log in via the Captive Portal and their MAC addresses are cached. Subsequent logins
will use MAC authentication and bypass the Captive Portal.

A guest can belong to a specific role such as Contractor, Guest, or Employee, and each role can have a different
lifetime for the cached MAC address. Network access can be restricted based on day of the week, bandwidth
limit, or number of unique devices used by the user. The cache lifetime of the MAC address can vary according
to the user's role (Guest, Employee, or Contractor) and after that the user will have to reauthenticate via the
Captive Portal. Optionally, posture checks can be enabled to validate the client device for antivirus or firewall
status. These results will determine the enforcement for the device.

To configure the Guest Authentication with MAC Caching service template:

1. Navigate to the Configuration > Service Templates & Wizards page. The Service Templates
& Wizards page opens.

2. Scroll down to and select the Guest Authentication with MAC Caching service template:
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Figure 28 Guest Authentication with MAC Caching Service Template

3. Specify the Guest Authentication with MAC Caching service template parameters as described in the
following table:

Parameter Action/Description

General

Select Prefix Select a prefix from the existing list of prefixes.
This populates the preconfigured information in the Wireless Network Settings,
MAC Caching Settings, and Access restrictions tabs. The Name Prefix field is not
editable.

Name Prefix Enter a prefix that you want to append to services using this template. Use this to identify
services that use templates.

Wireless Network Settings

Wireless SSID Enter the SSID name of your network.

Select Wireless
Controller

Select the wireless controller from the drop-down list if you already configured the
controller for ClearPass.

Wireless Controller
Name

Enter the name of the wireless controller.

Controller IP Address Enter the wireless controller's IP address.

Vendor Name Select the manufacturer of the wireless controller.

RADIUS Shared Secret Enter the shared secret that is configured on the controller and in Policy Manager to send
and receive RADIUS requests.

Enable RADIUS CoA Select this check box to enable RADIUS initiated CoA (Change of Authorization) on the
network device.

RADIUS CoA Port Specifies the default port 3799 if RADIUS CoA is enabled.
NOTE: Change this value only if you defined a custom port on the network device.

MAC Caching Settings

Table 1: Guest Authentication with MAC Caching Service Template Parameters
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Parameter Action/Description

Cache Duration for
Employee

From the Account Expiry Time drop-down, select the MAC caching duration for
employees:
n One Day
n One Week
n One Month
n Six Months
NOTE: When this duration expires, users must reauthenticate via the captive portal.
NOTE: You must specify the cache duration for at least one role.

Cache Duration for
Guest

From the Account Expiry Time drop-down, select the MAC caching duration for guests:
n One Day
n One Week
n One Month
n Six Months

Cache Duration for
Contractor

From the Account Expiry Time drop-down, select the MAC caching duration for
contractors:
n One Day
n One Week
n One Month
n Six Months

Posture Settings

Enable Posture Checks Select the Enable Posture Checks check box to perform health checks post
authentication. This enables the Host Operating System and Quarantine Message
fields.

Host Operating System Select the operating system(s): Windows, Linux, or macOS.

Quarantine Message Specify the quarantine message that will appear on the client.

Initial Role/VLAN Enter the initial role of the client before posture checks are performed.

Quarantine Role/VLAN Enter the role of clients that fail posture checks.

Access Restrictions

Enforcement Type Select one of the following enforcement types:
n Aruba Role Enforcement
n VLAN Enforcement
n Filter ID-Based Enforcement
NOTE: Enforcement Type applies to the Captive Portal Access, Employee Access,
Guest Access, and Contractor Access fields.
NOTE: At least one of Employee, Guest, or Contractor Access must be specified.

Captive Portal Access Used for unauthenticated users and after the MAC caching has expired.
n If you selected Aruba Role Enforcement as the Enforcement Type, enter the Aruba

Role Name.
n If you selected VLAN Enforcement as the Enforcement Type, enter the VLAN ID.
n If you selected Filter ID-Based Enforcement as the Enforcement Type, enter the

Filter ID.

Days allowed for
access

Select the days of the week that guest users are allowed network access.
By default, all seven days of the week are enabled.
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Parameter Action/Description

Maximum number of
devices allowed per
user

Enter the maximum number of devices that users can connect to the network.

Maximum bandwidth
allowed per user

Enter a number to set an upper limit for the amount of data in megabytes to which a user
is allowed per day. A value of 0 (zero), the default, means no limit is set.

Employee Access n If you selected Aruba Role Enforcement as the Enforcement Type, enter the Aruba
Role Name.

n If you selected VLAN Enforcement as the Enforcement Type, enter the VLAN ID.
n If you selected Filter ID-Based Enforcement as the Enforcement Type, enter the

Filter ID.

Guest Access n If you selected Aruba Role Enforcement as the Enforcement Type, enter the Aruba
Role Name.

n If you selected VLAN Enforcement as the Enforcement Type, enter the VLAN ID.
n If you selected Filter ID-Based Enforcement as the Enforcement Type, enter the

Filter ID.

Contractor Access n If you selected Aruba Role Enforcement as the Enforcement Type, enter the Aruba
Role Name.

n If you selected VLAN Enforcement as the Enforcement Type, enter the VLAN ID.
n If you selected Filter ID-Based Enforcement as the Enforcement Type, enter the

Filter ID.

Guest Social Media Authentication Service Template
This template is designed for authenticating guest users logging in through the captive portal with their social
media accounts, such as Google, Facebook, LinkedIn, and Twitter. Guests must reauthenticate after the session
ends.

To access the Guest Social Media Authentication service template:

1. Navigate to Configuration > Service Templates & Wizards.

2. From the Service Templates & Wizards page, select Guest Social Media Authentication. The Service
Templates - Guest Social Media Authentication page opens to the General tab.
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Figure 29 Guest Social Media Authentication Service Template

Specify the Guest Social Media Authentication service template parameters as described in the following
table:

Parameter Description

General

Select Prefix Select a prefix from the existing list of prefixes.
This populates the preconfigured information in the Wireless Network Settings,
MAC Caching Settings, and Guest Access restrictions tabs. The Name Prefix field is not
editable.

Name Prefix Enter a prefix that you want to append to services using this template. Use this to identify
services that use templates.

Wireless Network Settings

Wireless
Controller Name

Enter the name of the wireless controller.

Controller
IP Address

Enter the wireless controller's IP address.

Vendor Name Select the manufacturer of the wireless controller.

RADIUS Shared
Secret

Enter the shared secret that is configured on the controller and inside Policy Manager to send
and receive RADIUS requests.

Enable
RADIUS CoA

Select to enable RADIUS initiated CoA (Change of Authorization) on the network device.

RADIUS CoA Port Specifies the default port 3799 if RADIUS CoA is enabled.
NOTE: Change this value only if you defined a custom port on the network device.

Guest Access Restrictions

Social Login Pro-
vider

Select the social media network options: Google, Facebook, LinkedIn, and Twitter.

Days allowed for
access

Select the days of the week that the guest users are allowed network access.
By default, all seven days of the week are enabled.

Maximum
bandwidth allowed
per user

Specify the maximum amount of data in Megabytes a user is allowed per day. A value of 0
(zero) means no limit is set (the default).

Table 1: Guest Social Media Service Template Parameters
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OAuth2 API User Access Service Template
This template is designed for configurations that supports ClearPass Policy Manager authenticating API clients
with the username and OAuth2 grant-type password.

n The OAuth2 API User Access service template uses the Guest Operator Logins as the default
enforcement policy.

n The Local User Repository and Admin User Repository repositories are used as the default
authentication sources.

To access the OAuth2 API User Access service template:

1. Navigate to Configuration > Service Templates & Wizards.

2. From the Service Templates & Wizards page, select OAuth2 API User Access. The Service Templates
- OAuth2 API User Access page opens to the General tab.

Figure 30 OAuth2 API User Access Service Template

Specify the OAuth2 API User Access service template parameter as described in the following table:

Parameter Description

Name Prefix Enter a prefix that is appended to services using this template.
You can use this prefix to identify the services that use templates.

Table 1: OAuth2 API User Access Service Template Parameter

Onboard Service Template
This service creates an Onboard Pre-Authentication service to check the user's credentials before starting the
device provisioning process. This service template also creates an authorization service that checks whether a
user's device can be provisioned using Onboard. To authenticate users prior to device provisioning with
Onboard, as well as after device provisioning is completed, use an Aruba 802.1X Wireless service .

You cannot view the Onboard service template if High Capacity Guest mode is enabled in the cluster.

To access the Onboard service template:

1. Navigate to Configuration > Service Templates & Wizards.

2. From the Service Templates & Wizards page, select Onboard. The Service Templates - Onboard page
opens to the General tab.
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Figure 31 Onboard Pre-Authorization Service Template

The following table describes the Onboard Authorization service template parameters:

Parameter Description

General

Select Prefix Select a prefix from the existing list of prefixes or enter the name of a new prefix.
This populates the preconfigured information in the Wireless Network Settings, Device
Access Restrictions, and Provisioning Wireless Network Settings sections. The
Name Prefix field is not editable.

Name Prefix Enter a prefix that you want to append to services using this template. Use this to identify
services that use templates.

Wireless Network Settings

Wireless Controller
Name

Enter the name of the wireless controller.

Controller IP Address Enter the wireless controller's IP address.

Vendor Name Select the manufacturer of the wireless controller.

RADIUS Shared Secret Enter the shared secret that is configured on the controller and inside Policy Manager to
send and receive RADIUS requests.

Enable RADIUS CoA Select to enable RADIUS initiated CoA (Change of Authorization) on the network device.

RADIUS CoA Port Specifies the default port 3799 if RADIUS CoA is enabled.
NOTE: Change this value only if you defined a custom port on the network device.

Device Access Restrictions

Days allowed for
access

Select the days of the week that guest users are allowed network access.

Provisioning Wireless Network Settings

Wireless SSID for
Onboard Provisioning

Enter the SSID of your network.

Add New Onboard Net-
work Settings

Click the Add New Onboard Network Settings link to launch the Web UI to modify the
Onboard network settings.

Table 1: Onboard Authorization Service Template Parameters
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Configuring Other Policy Manager Services
Although Policy Manager provides service templates for the most common use cases, you can manually
configure services for all of the other supported service types. These Policy Manager services can be defined
using the service wizards by selecting the full Wizard link on the Configuration > Service Templates &
Wizards page, or by navigating to Configuration > Services and clicking the Add option.

For a list of services that can be defined using templates, see Configuring Service Templates

Click any of the links below for details on defining that service type:

n Aruba 802.1X Wireless Service

n 802.1X Wired Service

n 802.1X Wired—Identity Only Service

n 802.1X Wireless—Identity Only Service

n Cisco Web Authentication Proxy Service

n MAC Authentication Service

n RADIUS Authorization Service

n RADIUS Enforcement (Generic) Service

n RADIUS Proxy Service

n Aruba Application Authentication Service

n Aruba Application Authorization Service

n ClearPass OnConnect Enforcement Service

n Event-Based Enforcement Service

n TACACS+ Enforcement Service

n Web-Based Authentication Service

n Web-based Health Check Only Service

n Web-Based Open Network Access Service

Aruba 802.1X Wireless Service
Configure this service for wireless hosts that are connecting through an Aruba 802.1X wireless access device or
controller using IEEE 802.1X authentication. Service rules are customized for a typical Aruba Controller
deployment. The Aruba 802.1X service includes a rule that specifies that an Aruba ESSID exists.

If you want to administer the same set of policies for wired and wireless access, you can combine the service rule to
define one single service.
The other option is to keep two services for wired and wireless access, but reuse the policy components
(authentication methods, authentication source, authorization source, role mapping policies, posture policies, and
enforcement policies) in both services.

Service Configuration

The Service tab provides basic configuration parameters for the service. The Service Rules section defines a
set of criteria that supplicants must match to trigger the service. Some service templates have one or more
rules predefined. You can click on a service rule to modify any of its options.

To create a RADIUS Enforcement (Generic) service:

1. Navigate to Configuration > Services, then click the Add link.The Add Services dialog opens.
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2. From the Type drop-down, select 802.1X Wireless.The 802.1X Wireless service configuration dialog
opens:

Figure 32 Aruba 802.1X Wireless Service > Service Dialog

3. Specify the Service tab parameters as described in the following table:

Parameter Action/Description

Type Select a service from the drop-down list that defines what type of service can be
configured.

Name Enter the name of the service.

Description Provide additional information that helps to identify the service.

Monitor Mode Select this check box to monitor network access activity without enforcement.

More Options Check these boxes to access the additional configuration tabs:
n Authorization: See Authorization Configuration on page 64
n Posture Compliance: See Posture Configuration
n Audit End-hosts: See Audit Configuration on page 68
n Profile Endpoints: See Profile Endpoints Configuration on page 69
n Accounting Proxy: See Accounting Proxy Configuration on page 70

Service Rule

Matches Select the match condition for this service:
n Matches ANY
n Matches ALL of the following conditions

Type Select Click to add to select the service rule type.

Table 1: Add Aruba 802.1X Wireless Service > Service Tab Parameters
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Parameter Action/Description

Name Select the name of the service rule from the drop-down list.

Operator Select an appropriate operator from the list of operators for the data type of the
attribute.

Value Enter the value or select the value from the drop-down list. The value list depends
on the Type and Operator selected.

4. Click a service rule to modify its options.

Authentication Configuration

The Authentication tab contains options for configuring authentication methods and authentication
sources. The following figure displays the Authentication dialog:

Figure 33 Add Aruba 802.1X Wireless Service > Authentication Dialog

1. Specify the Authentication tab parameters as described in the following table:
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Parameter Action/Description

Authentication
Methods

Select authentication methods using the Select to Add field. The authentication methods
available for this service depend on the 802.1X supplicants and the type of authentication
methods you choose to deploy.
Policy Manager automatically selects the appropriate method for authentication, when a user
attempts to connect. The common types, which are automatically selected include the following
examples:
n EAP PEAP
n EAP FAST
n EAP TLS
n EAP TTLS
n EAP MSCHAPV2
The EAP-MD5 authentication type is not supported if you use ClearPass Policy Manager in FIPS
mode.
The order of authentication is significant, when a client tries to perform an 802.1X authentication.
Policy Manager proposes the first authentication method configured. However, the client can
accept the authentication method proposed by Policy Manager and continue authentication or
send a Negative-Acknowledgment (NAK) and propose a different authentication method. If the
newly proposed authentication method is also configured, then the authentication proceeds,
otherwise authentication fails.
If most of the clients in the network use a specific authentication method, that authentication
method should be configured first in the list. This would reduce the number of RADIUS packets
exchanged.
For more information, see the following:
n Adding and Modifying Authentication Methods on page 163
n Adding and Configuring Authentication Sources on page 186.

Authentication
Sources

Specify the authentication sources using the Select to Add field.
This can be one or more instances of the following list of authentication sources:
n AD_avenda313 [Active Directory]
n Admin User Repository
n Blacklist User Repository
n Endpoints Repository
n Guest Device Repository
n Guest User Repository
n http_3702
n HTTP_Auth_Source
n Insight Repository
n Local User Repository
n Onboard Devices Repository
n Social Login Repository
n Time Source
NOTE: When you attempt to specify more than 23 Services authentication sources, the following
error message is displayed: No. of Authentication Sources cannot exceed 23.

Strip
Username
Rules

Select the check box to preprocess the username (to remove prefixes and suffixes) before
authenticating and authorizing against the authentication source.

Service
Certificate

Select the Service Certificate.

Table 2: Add Aruba 802.1X Wireless Service > Authentication Parameters

Authorization Configuration
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Use the Authorization tab to select the authorization sources for this service. The Authorization tab is not
displayed by default. To access this tab, select the More Options > Authorization check box. ClearPass
fetches role-mapping attributes from the authorization sources associated with the service, regardless of which
authentication source was used to authenticate the user.

For a given service, role-mapping attributes are fetched from the following authorization sources:

n Authorization sources associated with the authentication source

n Authorization sources associated with the service

The following figure displays the Authorization dialog:

Figure 34 Add Aruba 802.1X Wireless Service > Authorization Dialog

2. Specify the Authorization parameters as described in the following table:

Table 1: Add Aruba 802.1X Wireless Service > Authorization Parameters

Parameter Action/Description

Authentication Source Displays the authorization sources from which role mapping attributes are fetched for
each authentication source.

Attributes Fetched From Displays the source of attributes.

Additional authorization
sources from which to
fetch role-mapping
attributes

Specify the authorization sources using the Select to Add field.
This can be one or more instances of the following list of authorization sources:
n Admin User Repository
n avenda313 [Active Directory]
n Blacklist User Repository
n Endpoints Repository
n Guest Device Repository
n Guest User Repository
n Insight Repository
n Local User Repository
n Onboard Devices Repository
n Social Login Repository
n Time Source
NOTE: When you attempt to specify more than 23 Services authorization sources, the
following error message is displayed:
No. of Authorization Sources cannot exceed 23
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Roles Configuration
Use the Roles tab to associate a role-mapping policy with this service. The following figure displays the Aruba
802.1X Wireless Service > Roles dialog:

Figure 35 Add Aruba 802.1X Wireless Service > Roles Dialog

Specify the Roles parameters as described in the following table:

Parameter Action/Description

Role Mapping Policy Select a role mapping policy from the drop-down list.
Policy Manager ships a number of preconfigured roles.
NOTE: A service can be configured without a role-mapping policy, but only one
role-mapping policy can be configured for each service.

Role Mapping Policy Details

Description Provide additional information about the selected role-mapping policy.

Default Role Specify the role to which Policy Manager defaults when the role-mapping policy
does not produce a match.

Rules Evaluation Algorithm Shows the first matched rule.

Table 3: Add Aruba 802.1X Wireless Service > Roles Tab Parameters

For information on configuring role-mapping policies, see Configuring a Role and Role-Mapping Policy on page
247.

Posture Configuration
The Posture tab is not enabled by default. To enable posture checking for this service:

1. Select the More Options > Posture Compliance check box. You can enable the posture checking for this
kind of service, if you deploy any of the following:

l ClearPass Policy Manager in a Microsoft Network Access Protection (NAP)

l Cisco Network Admission Control (NAC) Framework environment

l Aruba hosted captive portal that performs posture checks through a dissolvable agent

The Posture tab cannot be enabled when High Capacity Guest mode is enabled in the ClearPass cluster.

The following figure displays the Posture dialog:
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Figure 36 Add Aruba 802.1X Wireless Service > Posture Dialog

2. Specify the Wireless Service Posture parameters as described in Table 4:

Parameter Action/Description

Posture Policies

Posture Policies Select the posture policy from the Select to Add drop-down list.
If you do not have any preconfigured posture policies, click Add New Posture
Policy to create a new posture policy.
NOTE: Only NAP agent-type posture policies are applicable for this service.

Default Posture Token Select the default posture token from the drop-down list.

Remediate End-Hosts To perform remediation action, when a client is quarantined, select the Enable
auto-remediation of non-compliant end-hosts check box.

Remediation URL To perform the remediation, enter the web link of a server resource.

Table 4: Add Aruba 802.1X Wireless Service > Posture Parameters

For more information on configuring posture polices, see Configuring Posture Policy Agents and Hosts on page
257.

Enforcement Configuration
Use this tab to select an enforcement policy for a service. The following figure displays the Enforcement
dialog:

Figure 37 Aruba 802.1X Wireless Service > Enforcement Dialog

1. Specify the Enforcement parameters as described in the following table:
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Parameter Action/Description

Use Cached Results Select this check box to use cached roles and posture attributes from previous
sessions.

Enforcement Policy Select the preconfigured enforcement policy from the drop-down list. This is
mandatory.
If you do not have any preconfigured enforcement policies, click Add New
Enforcement Policy to create a new enforcement policy.

Enforcement Policy Details

Description Displays additional information about the selected enforcement policy.

Default Profile Displays a default profile applied by ClearPass Policy Manager.

Rules Evaluation Algorithm Shows the first matched rule.

Table 5: Aruba 802.1X Wireless Service > Enforcement Parameters

For related information, see Configuring Enforcement Policies.

Audit Configuration
Use the Audit tab to enable the Audit checking for this service.

1. To enable the Audit tab, select the Audit End-hosts check box from the More Options field on the
Service tab. The Audit dialog opens.

Figure 38 Add Aruba 8021X Wireless Service > Audit Dialog

2. Specify the Audit End-Hosts parameters as described in the following table:
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Parameter Action/Description

Audit Server Select the audit server from the following options:
n Nessus Server: Interfaces with Policy Manager primarily to perform

vulnerability scanning.
n Nmap Audit: Performs specific Nmap audit functions.

l To view the Policy Manager Entity Details dialog with the
summary of audit server details, click the View Details button.

l To view the Summary tab with audit server details, click the
Modify button.

Audit Trigger Conditions Select an audit trigger condition:
n Always: Always perform an audit.
n When posture is not available: Perform audit only when posture

credentials are not available in the request.
n For MAC Authentication Request: If you select this option, Policy Manager

presents the following three additional settings:
l For known end-hosts only: Select this option when you want to

reject unknown end-hosts and to audit known clients. Known end-
hosts are defined as clients that are found in the authentication
source(s) associated with this service.

l For unknown end-hosts only: Select this option when the known
end-hosts are assumed to be healthy, but you want to establish the
identity of unknown end-hosts and assign roles. Unknown end-hosts
are end-hosts that are not found in any of the authentication sources
associated with this service.

l For all end-hosts: For both known and unknown end-hosts.

Action After Audit Specify the audit that can be performed only after the MAC authentication
request is completed and the client has acquired an IP address through DHCP.
Once the audit results are available, Policy Manager reapplies policies on the
network device in one of the following ways:
n No Action: The audit does not apply policies on the network device after

completing this audit.
n Do SNMP bounce: This option bounces the switch port or forces an 802.1X

reauthentication (both done using SNMP).
Bouncing the port triggers a new 802.1X or MAC authentication request by
the client. If the audit server already has the posture token and attributes
associated with this client in its cache, it returns the token and the attributes
to ClearPass.

n Trigger RADIUS CoA action: This option sends a RADIUS CoA command
from ClearPass to the network device.

Table 6: Add Aruba 802.1X Wireless Service > Audit End-Hosts Parameters

Profile Endpoints Configuration
The Profiler tab is not displayed by default. To access this tab, select the More Options > Profile Endpoints
check box. The Add Profile Endpoints dialog opens:

Figure 39 Add Aruba 802.1X Wireless Service > Profile Endpoints Dialog
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1. Specify the Profile Endpoints parameters as described in the following table:

Parameter Action/Description

Endpoint Classification Select one or more endpoint classification items from the drop-down
list.

RADIUS CoA Action Select the RADIUS CoA action from the drop-down list.
n To view the Policy Manager Entity Details page with the

summary of enforcement profile details, click the View Details
button.

n To view the Summary tab with profile details, click the Modify
button.

n To create a new RADIUS CoA action, click the Add New RADIUS
CoA Action link.

Table 7: Add Aruba 802.1X Wireless Service > Profile Endpoints Parameters

Accounting Proxy Configuration
Use the Accounting Proxy tab to broadcast the RADIUS accounting packets to all the proxy targets. You can
configure the proxy targets to which RADIUS server should be forwarded and the attributes to be added in the
accounting. This enables the external security solutions to use the RADIUS account event to detect when a user
connects and disconnects to the server.

1. To enable the Accounting Proxy tab, select the More Options > Accounting Proxy check box.

The following figure displays the Add Accounting Proxy dialog:

Figure 40 Add 802.1X Wireless > Accounting Proxy Dialog

2. Specify the Accounting Proxy parameters as described in the following table:

Parameter Action/Description

Accounting Proxy Targets Specify the proxy targets to which the RADIUS server should be forwarded and
the attributes to be added in the accounting.
Select the accounting proxy target from the Select to Add drop-down list.

Add New Accounting Proxy
Target

Click this link to add a new accounting proxy target.

RADIUS attributes to be added for Accounting Proxy

Type Select the RADIUS attribute type from the drop-down list:
n Radius:IETF
n Radius:Cisco

Table 8: Add Aruba 802.1X Wireless Service > Accounting Proxy Tab Parameters
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Parameter Action/Description

n Radius:Hewlett-Packard-Enterprise
n Radius:Alcatel-Lucent-Enterprise
n Radius:Microsof
n Radius:Avenda
n Radius:Aruba

Name Select the name of the RADIUS attribute from the drop-down list.

Value Select the value from the Value drop-down list.
The values displayed here depend on the RADIUS attribute Type selected.

Summary Information
The Summary page presents the summary of parameters defined when you created a new service.

802.1X Wired Service
Configure this service for clients connecting through an Ethernet LAN with authentication using IEEE 802.1X.
Except for the NAS-Port-Type service rule value (which is Ethernet for an 802.1X Wired service and Wireless
802.11 for an 802.1X Wireless service), configuration for the rest of the tabs is similar to the Aruba 802.1X
Wireless service. For more information, see Aruba 802.1X Wireless Service on page 61.

The following figure displays the Add 802.1X Wired Service page:

Figure 41 Add 802.1X Wired Service Dialog

802.1X Wired—Identity Only Service
Configure this service for clients connecting through an Ethernet LAN with authentication using IEEE 802.1X.
Configuration for the 802.1X Wired—Identity Only service is same as the 802.1X Wired service, except that
Posture and Audit policies are not configurable when you use this template. For more information, see 802.1X
Wired Service on page 71.

The following figure displays the 802.1X Wired—Identity Only Service dialog:
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Figure 42 802.1X Wired—Identity Only Service

802.1X Wireless—Identity Only Service
Configuration for this type of service is the same as the Aruba 802.1X Wireless Service, except that Posture
and Audit policies are not configurable when you use this template. For more information, see 802.1X Wireless
Service on page 1.

The following figure displays the Configuration > Services > Add 802.1X Wireless—Identity Only Service
dialog:

Figure 43 802.1X Wireless—Identity Only Service Dialog

Cisco Web Authentication Proxy Service
This service is a web-based authentication service for guests or agent-less hosts. The Cisco switch hosts a
captive portal and the portal web page that collects username and password information. Subsequently, the
switch sends a RADIUS request in the form of a Password Authentication Protocol (PAP) authentication
request to Policy Manager. By default, this service uses the PAP authentication method. You can click on the
Authorization and Audit End-hosts options to enable additional tabs.

To create a Cisco Web Authentication Proxy service:

1. Navigate to Configuration > Services, then select the Add link. The Add Services page opens.

2. From the Type drop down, select Cisco Web Authentication Proxy.The Cisco Web Authentication
Proxy service configuration dialog opens:
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Figure 44 CiscoWeb Authentication Proxy Service

Configuring the Cisco Web Authentication Proxy service is similar to configuring the Aruba 802.1X
Wireless service except that the Posture Compliance and Profile Endpoints options are not available. For more
information on configuration, see Aruba 802.1X Wireless Service.

MAC Authentication Service
The MAC-based authentication service is used for clients without an 802.1X supplicant or a posture agent (such
as printers, other embedded devices, and computers owned by guests or contractors). The network access
device sends a MAC authentication request to Policy Manager. Policy Manager can look up the client in a white
list or a black list, authenticate, and authorize the client against an external authentication or authorization
source, and optionally perform an audit on the client.

You cannot configure posture for this type of service.
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The following figure displays the MAC Authentication service configuration dialog.

Figure 45 MAC Authentication Service Configuration Dialog

Configuration for the rest of the tabs is similar to the Aruba 802.1X Wireless service configuration. For
details on this service's configuration, see Aruba 802.1X Wireless Service on page 61.

RADIUS Authorization Service
Configure the RADIUS Authorization service type for services that perform authorization using RADIUS.
When you select this service, the Authorization tab is enabled. The following figure displays the
RADIUS Authorization service configuration dialog:

Figure 46 RADIUS Authorization Service Configuration Dialog

Configuration for this service is the same as the RADIUS Enforcement (Generic) service, except that you do
not configure authentication or posture with this service type. Refer to RADIUS Enforcement (Generic) Service
on page 75 for more information.
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RADIUS Enforcement (Generic) Service
Configure the RADIUS Enforcement (Generic) service for any kind of RADIUS request. There are no default
rules associated with this service type. You can add rules to handle any type of standard or vendor-specific
RADIUS attributes (that is, any attribute that is loaded through the prepackaged vendor-specific or standard
RADIUS dictionaries, or through other dictionaries imported into Policy Manager). For related information, see
Configuring Enforcement Policies.

Service Configuration

To create a RADIUS Enforcement (Generic) service:

1. Navigate to Configuration > Services, then click the Add link.The Add Services dialog opens.

2. From the Type drop-down, select RADIUS Enforcement (Generic).The RADIUS Enforcement (Generic)
service configuration dialog opens:

Figure 47 Add RADIUS Enforcement (Generic) Service Configuration Dialog

3. Specify the Service tab parameters as described in the following table.

Parameter Action/Description

Type Select a service from the drop-down list that defines what type of service can be
configured.

Name Enter the name of the service.

Description Provide additional information that helps to identify the service.

Monitor Mode Select this check box to monitor network access activity without enforcement.

More Options Check these boxes to access the additional configuration tabs:
n Authorization
n Posture Compliance
n Audit End-hosts
n Profile Endpoints
n Accounting Proxy

Table 1: Aruba RADIUS Enforcement (Generic) Service > Service Tab Parameters
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Parameter Action/Description

Service Rule

Matches Select the match condition for this service:
n Matches ANY
n Matches ALL of the following conditions

Type Select Click to add to select the service rule type.

Name Select the name of the service rule from the drop-down list.

Operator Select an appropriate operator from the list of operators for the data type of the
attribute.

Value Enter the value or select the value from the drop-down list. The value list depends
on the Type and Operator selected.

Parameter Action/Description

Type Select a service from the drop-down list that defines what type of service can be
configured.

Name Enter the name of the service.

Description Provide additional information that helps to identify the service.

Monitor Mode Select this check box to monitor network access activity without enforcement.

More Options Check these boxes to access the additional configuration tabs:
n Authorization
n Posture Compliance
n Audit End-hosts
n Profile Endpoints
n Accounting Proxy

Service Rule

Matches Select the match condition for this service:
n Matches ANY
n Matches ALL of the following conditions

Type Select Click to add to select the service rule type.

Name Select the name of the service rule from the drop-down list.

Operator Select an appropriate operator from the list of operators for the data type of the
attribute.

Value Enter the value or select the value from the drop-down list. The value list depends
on the Type and Operator selected.

Table 2: Aruba RADIUS Enforcement (Generic) Service > Service Tab Parameters

ClearPass 6.7 Policy Manager | User Guide Services | 76
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1108



77 | Services ClearPass 6.7 Policy Manager |  User Guide

4. Click Next.

Authentication Configuration

The Authentication tab contains options for configuring authentication methods and authentication
sources. The following figure displays the Authentication dialog:

Figure 48 Add Aruba RADIUS Enforcement (Generic) Service > Authentication Dialog
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Parameter Action/Description

Authentication
Methods

Select authentication methods using the Select to Add field. The authentication methods
available for this service depend on the 802.1X supplicants and the type of authentication
methods you choose to deploy.
Policy Manager automatically selects the appropriate method for authentication, when a user
attempts to connect. The common types, which are automatically selected include the following
examples:
n EAP PEAP
n EAP FAST
n EAP TLS
n EAP TTLS
n EAP MSCHAPV2
The order of authentication is significant, when a client tries to perform an 802.1X authentication.
Policy Manager proposes the first authentication method configured. However, the client can
accept the authentication method proposed by Policy Manager and continue authentication or
send a Negative-Acknowledgment (NAK) and propose a different authentication method. If the
newly proposed authentication method is also configured, then the authentication proceeds,
otherwise authentication fails.
If most of the clients in the network use a specific authentication method, that authentication
method should be configured first in the list. This would reduce the number of RADIUS packets
exchanged.
For more information, see the following:
n Adding and Modifying Authentication Methods on page 163
n Adding and Configuring Authentication Sources on page 186.

Authentication
Sources

Specify the authentication sources using the Select to Add field.
This can be one or more instances of the following list of authentication sources:
n AD_avenda313 [Active Directory]
n Admin User Repository
n Blacklist User Repository
n Endpoints Repository
n Guest Device Repository
n Guest User Repository
n http_3702
n HTTP_Auth_Source
n Insight Repository
n Local User Repository
n Onboard Devices Repository
n Social Login Repository
n Time Source
NOTE: When you attempt to specify more than 23 Services authentication sources, the following
error message is displayed: No. of Authentication Sources cannot exceed 23.

Strip
Username
Rules

Select the check box to preprocess the username (to remove prefixes and suffixes) before
authenticating and authorizing against the authentication source.

Service
Certificate

Select the Service Certificate.
Once you select the Service Certificate, click the View Certificate Details link to view
information about the certificate.

Table 3: Add Aruba RADIUS Enforcement (Generic) Service > Authentication Parameters

5. Click Next.

Roles Configuration
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Use the Roles tab to associate a role-mapping policy with this service.

The following figure displays the Aruba RADIUS Enforcement (Generic)> Roles dialog:

Figure 49 Add Aruba RADIUS Enforcement (Generic) Service > Roles Dialog

1. Specify the Roles parameters as described in the following table:

Parameter Action/Description

Role Mapping Policy Select a role mapping policy from the drop-down list.
Policy Manager ships a number of preconfigured roles.
NOTE: A service can be configured without a role-mapping policy, but only one
role-mapping policy can be configured for each service.
For information on configuring role-mapping policies, see Configuring a Role
and Role-Mapping Policy on page 247.

Role Mapping Policy Details

Description Provide additional information about the selected role-mapping policy.

Default Role Specify the role to which Policy Manager defaults when the role-mapping policy
does not produce a match.

Rules Evaluation Algorithm Shows the first matched rule.

Table 4: Add Aruba 802.1X Wireless Service > Roles Tab Parameters

2. Click Next.

Enforcement Configuration

Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1111



Use this tab to select an enforcement policy for a service. The following figure displays the Enforcement
dialog:

Figure 50 Aruba RADIUS Enforcement (Generic) Service > Enforcement Dialog

1. Specify the Enforcement parameters as described in the following table:

Parameter Action/Description

Use Cached Results Select this check box to use cached roles and posture attributes from previous
sessions.

Enforcement Policy Select the preconfigured enforcement policy from the drop-down list. This is
mandatory.
If you do not have any preconfigured enforcement policies, click Add New
Enforcement Policy to create a new enforcement policy.

Enforcement Policy Details

Description Displays additional information about the selected enforcement policy.

Default Profile Displays a default profile applied by ClearPassPolicy Manager.

Rules Evaluation Algorithm Shows the first matched rule.

Table 5: Aruba RADIUS Enforcement (Generic) > Enforcement Parameters

2. Click Save. You return to the Services page. The following message is displayed: Service "RADIUS
Enforcement service" has been added.

RADIUS Proxy Service
Configure the RADIUS Proxy service for any kind of RADIUS request that needs to be proxied to another
RADIUS server (that is, a proxy target). There are no default rules associated with this service type. You can add
rules to handle any type of standard or vendor-specific RADIUS attributes. Typically, proxying is based on the
realm or the domain of the user who is trying to access the network.

Configuration of this service is the same as the RADIUS Enforcement (Generic) service except that you do
not configure Authentication or Posture policies with this service type. However, you need to configure proxy
targets (the servers to which requests are proxied). Requests can be dispatched to the proxy targets randomly,
and are load balanced.

In Failover mode, requests can be dispatched to the first proxy target in the ordered list of targets and
subsequently to the other proxy targets if the prior requests failed. When you select the Enable proxy for
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accounting requests, accounting requests are also sent to the proxy targets. The following figure displays
the RADIUS Proxy service configuration dialog:

Figure 51 RADIUS Proxy Service Configuration Dialog

For configuration details, see RADIUS Enforcement (Generic) Service on page 75.

Aruba Application Authentication Service
This type of service provides authentication and authorization to users of ClearPass Guest and ClearPass
Insight. You can send Generic Application Enforcement Profile to these or other generic applications for
authenticating and authorizing the users. The following figure displays the Aruba Application
Authentication service configuration dialog:

Figure 52 Aruba Application Authentication Configuration Dialog

Configuring the Aruba Application Authentication service is similar to configuring the Aruba 802.1X
Wireless service except that the Posture Compliance, Audit End-hosts, and Profile Endpoints options are not
available. For configuration details, see Aruba 802.1X Wireless Service.

Aruba Application Authorization Service
This type of service provides authorization for users of Aruba applications: ClearPass Guest and ClearPass
Insight. You can send Generic Application Enforcement Profile to these or other generic applications for
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authorizing the users. The following figure displays the Aruba Application Authorization service
configuration dialog:

Figure 53 Aruba Application Authorization Configuration Dialog

Configuring the Aruba Application Authorization service is similar to configuring the Aruba 802.1X Wireless
service except that the Posture Compliance, Audit End-hosts, and Profile Endpoints options are not available. For
configuration details, see Aruba 802.1X Wireless Service on page 61.

ClearPass OnConnect Enforcement Service
This section provides the following information:

n Configuring the Service

n Configure an Enforcement Policy

ClearPass OnConnect Enforcement is an enforcement model that allows you to use non-802.1X methods
for device scans, VLAN placement, and so on. ClearPass OnConnect Enforcement allows enforcement in non-
802.1X environments without the need for an agent, such as OnGuard, on the endpoint. For related
information, see:

n Enabling ClearPass OnConnect Enforcement on a Network Device

n System Page

When ClearPass OnConnect Enforcement is enabled, ClearPass performs the following actions:

n Detects when a new endpoint connects to the network.

n Scans the endpoint to identify the logged-in user and other device-specific information.

n Triggers a Web-based authentication (WebAuth) for the device.

n Performs SNMP-based enforcement to change the network access profile for the device.

Configuring the Service

To add an OnConnect Enforcement service:

1. Navigate to Configuration > Services.The Services page opens.

2. To add the service, click Add.The Add Services dialog opens.

3. From the Type drop-down list, select ClearPass OnConnect Enforcement (see Figure 54).
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Figure 54 Specifying ClearPass OnConnect Enforcement

4. Enter the name or label of the OnConnect Enforcement service.

5. Enter the values for any other parameters, including service rules, required for this service.

For a description of all the parameters in the Service page, see Adding Services on page 1.

Configure an Enforcement Policy

After you create the ClearPass OnConnect Enforcement service, you must associate the service with an
enforcement policy. WMI (Windows Management Instrumentation) configuration is used to retrieve the
Loggedin User information.

Whenever a domain-joined Windows client connects to an OnConnect-enabled port with the domain user
logged in, Authorization attributes for this user are fetched from authorization sources to determine the role of
the user; this information is then used in configuring policy enforcement. For details on configuring WMI
credentials, see WMI Credentials Configuration.

To associate a ClearPass OnConnect Enforcement service with an enforcement policy:

1. When finished with the parameter settings on the Add Services > Service page, click Next.The Services >
Enforcement page opens.

2. From the Services > Add > Enforcement page, you can either select an existing enforcement policy or
create a new one.

Figure 55 Selecting the ClearPass OnConnect Enforcement Policy
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3. From the Enforcement Policy drop-down list, select the appropriate OnConnect Enforcement policy.If you
have not configured an OnConnect-type Enforcement policy, click Add New Enforcement Policy to create
a new enforcement policy to associate with this OnConnect service.

4. Specify the values for the remaining parameters as described in Table 1, then click Save.

Parameter Action/Description

Use Cached Results Select this check box to use cached roles and posture attributes from previous
sessions.

Enforcement Policy From the drop-down list, select the preconfigured enforcement policy. This is a
mandatory step.

Enforcement Policy Details

Description Displays additional information about the selected enforcement policy.

Default Profile Displays a default profile applied by .

Rules Evaluation Algorithm Shows first matched rule and return the role or select all matched rules and
return a set of roles.

Table 1: Service Enforcement Page Parameters

Event-Based Enforcement Service
The Event-Based Enforcement service manages enforcement actions in response to threat-event
processing. When there is a suspicious user, this user could represent a common DOS attack or some other
threat. When a threat is detected, ClearPass performs enforcement operations as configured; for example,
executing a change of authorization ( COA ) to disconnect a suspicious user from the network.To add an event-
based enforcement service:

1. Navigate to Configuration > Services. The Services page appears. The Services page provides options
to add, modify, and remove a service.

2. To add the service, click Add. The Add Services dialog appears.

3. From the Type drop-down list, select Event-based Enforcement (see Figure 56).

Figure 56 Specifying Event -Based Enforcement

4. Enter the name or label of the event-based enforcement service.

5. Enter the values for any other parameters, including service rules, required for this service.
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Associating the Service with an Enforcement Policy
After you create the event-based enforcement service, you must associate the service with an enforcement
policy. You can do this from the Services > Add > Enforcement page.

1. When finished with the parameter settings on the Add Services > Service page, click Next.The Services >
Enforcement page appears.

2. From the Services > Add > Enforcement page, you can either select an existing enforcement policy or
create a new one.

Figure 57 Selecting the Ingress Events Enforcement Policy

3. From the Enforcement Policy drop-down list, select the appropriate Event Enforcement policy.

4. If you have not configured Event-type Enforcement policies, click Add New Enforcement Policy to create
a new enforcement policy.

5. Specify the values for the remaining parameters as described in Table 1, then click Save.

Parameter Description

Use Cached Results 1. Select this check box to use cached roles and posture attributes from
previous sessions.

Enforcement Policy 2. From the drop-down list, select the preconfigured enforcement policy.
This is mandatory.

Enforcement Policy Details

Description Displays additional information about the selected enforcement policy.

Default Profile Displays a default profile applied by .

Rules Evaluation Algorithm Shows first matched rule and return the role or select all matched rules and
return a set of roles.

Table 1: Service Enforcement Page Parameters

TACACS+ Enforcement Service

Configure the TACACS+ Enforcement service for any kind of TACACS+ request. TACACS+ users can be
authenticated against any of the supported authentication source types:

n Local DB

n SQL DB

n Active Directory

Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1117



n LDAP Directory

n Token Servers with a RADIUS interface

Similarly, you can specify service-level authorization sources from the Authorization tab. You can associate a
role-mapping policy with this service via the Roles tab.

The result of evaluating a TACACS+ enforcement policy is one or more TACACS+ enforcement profiles. For
more information on TACACS+ enforcement profiles, see TACACS+ Based Enforcement Profile.

Configuring a TACACS+ Emforcement Service

To create a TACACS+ Enforcement service:

1. Navigate to Configuration > Services, then select the Add link. The Add Services page opens.

2. From the Type drop down, select TACACS+ Enforcement. The TACACS+ Enforcement service
configuration dialog opens:

Figure 58 Adding a New TACACS+ Enforcement Service

3. Specify the Service tab parameters as described in the following table:

Parameter Action/Description

Type From the drop-down list, select TACACS+ Enforcement.

Name Enter the name of the service.

Description Provide additional information that helps to identify the service.

Monitor Mode The Monitor Mode option is disabled for an enforcement policy.

More Options The Authorization tab is not enabled by default.
To bring up the Authorization configuration tab, check the Authorization check
box.

Service Rule

Table 1: Add TACACS+ Enforcement > Service Tab Parameters
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Parameter Action/Description

Type Select one of the following service rule types:
n Authentication
n Connection
n Date
n Device
n Host
n Endpoint

Name Select the name of the service rule from the drop-down list.

Operator Select an appropriate operator from the list of operators for the data type of the
attribute.
For example, you can select from BELONGS_TO, NOT_BELONGS_TO, CONTAINS, or
EQUALS.

Value Select the value from the drop-down list. The value list depends on the operator
selected.

Configuring a TACACS+ Multi-Factor Authentication Service

ClearPass provides a way to differentiate between a TACACS+ login authentication and a TACACS+ enable
authentication.

To do so, in Service and Policy rule configuration, you can use the Authentication type
TacacsAuthenService parameter. This parameter accepts three values: None, Login, or Enable.

Note that an Enforcement policy can also use the Authentication: TacacsAuthenService attribute in the
Rules Editor > Conditions section of the policy configuration.

Creating a TACACS+ Multi-Factor Authentication Service

To apply the TacacsAuthenService parameter in a TACACS+ Enforcement service:

1. Navigate to Configuration > Services, then select the Add link.

The TACACS+ Enforcement service configuration dialog opens:

Figure 59 Configuring a TACACS+Multi-Factor Authentication Service

2. Specify the TACACS+ Enforcement Service parameters as described in the following table:
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Parameter Action/Description

Type From the drop-down list, select TACACS+ Enforcement.

Name Enter the name of the service.

Description Provide additional information that helps to identify the service.

Monitor Mode The Monitor Mode option is disabled for an enforcement policy.

More Options The Authorization tab is not enabled by default.
To bring up the Authorization configuration tab, check the Authorization check
box.

Service Rule

Type Select Click to add, then select the Authentication type.

Name Select TacacsAuthenService.

Operator Select EQUALS.

Value Select one of the following values:
n AUTHEN_SVC_NONE: Choose this option when the user does not require

authentication.
n AUTHEN_SVC_LOGIN: Choose this option when the user is authenticating in

Login mode.
n AUTHEN_SVC_ENABLE: Choose this option when the user is authenticating in

Privileged mode.

Table 2: TACACS+ Enforcement > Service Tab Parameters

Web-Based Authentication Service
Configure a web-based authentication service for guests or agentless hosts that connect through the ClearPass
Portal. The user is redirected to the ClearPass captive portal by the network device or by a DNS server that is
set up to redirect traffic on a subnet to a specific URL.

The web page collects the user name and password, and also optionally collects health information on the
following operating systems (see the Attribute Name OSType in Table 1 for details):

n Linux

n macOS

n Windows 10

n Windows 8

n Windows 7

n Windows Vista

n Windows XP

n Windows Server 2008

n Windows Server 2008 R2

n Windows Server 2003

n Windows Server 2003 R2
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An internal service rule—Connection:Protocol EQUALS WebAuth—categorizes requests into this type of
service. You can add additional rules if needed.

In addition, you can select a Web-based Authentication service based on the operating system name. You can
specify or exclude specific OS versions (for details, see the next section, Selecting a Web-Based Authentication
Service by the OS Name).

For service configuration details, see Adding and Removing Services on page 1.

Configuring a Web-Based Authentication Service

To configure a web-based authentication service:

1. Navigate to Configuration > Services.

The Services page opens.

2. Select the Add link.

The Add Services page opens.

3. From the Type drop-down list, select Web-Based Authentication.

The following service configuration dialog opens:

Figure 60 Web-Based Authentication Service Configuration Dialog

The Audit End-hosts and Profile Endpoints options are not available for a Web-based Authentication service.

Selecting a Web-Based Authentication Service by the OS Name

The Service Rule > Host:OSName attribute allows you to select a Web-based Authentication service based
on the OS name. You can specify or exclude specific OS versions.

To select a web-based authentication service by the OS name and version:

1. From the Service tab > Service Rule area, select Click to add.
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Figure 61 Host OS Name Specified in the Web-Based Authentication Service

2. Specify the Host OS Architecture attribute as follows:

l Type=Host
l Name=OSArch
l Operator=EQUALS
l Value=i386 or x86_64

3. Specify the Host OS Type attribute as follows:

l Type=Host
l Name=OSType
l Operator=EQUALS
l Value=Windows 10

4. Specify the Host OS Name attribute as follows:

l Type=Host
l Name=OSName
l Operator=EQUALS
l Value=Microsoft Windows 10

Example Showing How to Differentiate Between Windows 8 and Windows 8.1

l Type=Host
l Name=OSName
l Operator=CONTAINS
l Value=Microsoft Windows 8.1

Service Rule > Web-Based Authentication Host Attributes

The following table describes the list of other attributes that can be used to create services based on the client's
information.
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Attribute Name

Host AgentType Specifies the type of OnGuard Agent. This attribute provides a way to
define a separate service for each OnGuard Agent Type. The
supported values are:
n OnGuardAgent: OnGuard Agent
n : OnGuardAgentService: OnGuard Agent running as a service
n NativeWebAgent: Native Dissolvable Agent
n JavaWebAgent: Java Dissolvable Agent

Agent Version OnGuard Agent version. This attribute can be used to create a service
based on the OnGuard Agent version.

CheckType Specifies the type of check OnGuard Agent is performing based on the
Mode setting in the OnGuard Settings page (for details, see OnGuard
Settings and Agent Library Updates).
For Authenticate with health checks, the value of this attribute is
Authentication, Health. The supported values are:
n Authentication: OnGuard Agent is performing authentication; that

is, the request contains credentials.
n Health: OnGuard Agent is performing health checks; that is, the

request contains Posture information.
n None

FQDN Indicates the Fully Qualified Domain Name of the client.

HealthCheckLevel Indicates the level of health checks performed by OnGuard Agent; that
is, whether the user is logged in at the time of health check or not.
This attribute can be used to see the health check level when OnGuard
Agent is running as Service or BothServiceAndUser.
n System: The user is not logged in when health checks are being

run.
n User: The user is logged in when health checks are being run.

Installed SHAs Specifies the SHAs installed on the client.

InterfaceType Specifies the type of Network Interface. This attribute can be used to
define different services based on Network Interface type. The
supported values are:
n Wired
n Wireless
n VPN

Name This is the host name of the client (without the domain name).

OSArch Specifies whether the client is running a 32-bit or 64-bit OS. The
supported values are:
n i386: 32-bit OS
n x86_64: 64-bit OS

OSName Indicates the full Operating System name. This attribute can be used
to create services for a specific OS.
For example, you can use this attribute to differentiate between
Windows 8 and Windows 8.1

Table 1: Service Rule >Web-Based Authentication Host Attributes
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Attribute Name

OSNameVersion Provides the Windows OS name and the build version. This attribute
can be used to create different Posture policies for different Windows
10 versions such as 2015 LTSB or 2016 LTSB.

OSType Specifies the Operating System type. The supported values are:
n Linux
n macOS
n Windows XP
n Windows 7
n Windows 8
n Window 10
n Windows Server 2003
n Windows Server 2003 R2
n Windows Server 2008
n Windows Server 2008 R2

SDKType Specifies the SDK type.
For example, you can specify that the SDK type equals V4. For related
information, see Upgrading From OnGuard Plugin Version 1.0 to 2.0.

SDKVersion Specifies the SDK version.

ServerCertificateCheck This attribute's value shows the status of the ClearPass Server
Certificate Check performed by OnGuard agent while sending a
WebAuth request to the ClearPass server.This attribute can also be
used in a Service Classification.
The value of this attribute can be one of the following:
n Passed: OnGuard Agent successfully verified the ClearPass Server

Certificate.
n Failed: OnGuard Agent failed to verify the ClearPass Server

Certificate.

UserAgent The value of this attribute contains both Agent Type and Agent
Version. For example, OnGuard 6.6.5.89660.

Attribute Name

Host AgentType Specifies the type of OnGuard Agent. This attribute provides a way to
define a separate service for each OnGuard Agent Type. The
supported values are:
n OnGuardAgent: OnGuard Agent
n OnGuardAgentService: OnGuard Agent running as a service
n NativeWebAgent: Native Dissolvable Agent
n JavaWebAgent: Java Dissolvable Agent

Agent Version OnGuard Agent version. This attribute can be used to create a service
based on the OnGuard Agent version.

CheckType Specifies the type of check OnGuard Agent is performing based on the
Mode setting in the OnGuard Settings page (for details, see OnGuard
Settings and Agent Library Updates).
For Authenticate with health checks, the value of this attribute is
Authentication, Health. The supported values are:
n Authentication: OnGuard Agent is performing authentication; that

is, the request contains credentials.

Table 2: Service Rule >Web-Based Authentication Host Attributes
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Attribute Name

n Health: OnGuard Agent is performing health checks; that is, the
request contains Posture information.

n None

FQDN Indicates the Fully Qualified Domain Name of the client.

HealthCheckLevel Indicates the level of health checks performed by OnGuard Agent; that
is, whether the user is logged in at the time of health check or not.
This attribute can be used to see the health check level when OnGuard
Agent is running as Service or BothServiceAndUser.
n System: The user is not logged in when health checks are being

run.
n User: The user is logged in when health checks are being run.

Installed SHAs Specifies the SHAs installed on the client.

InterfaceType Specifies the type of Network Interface. This attribute can be used to
define different services based on Network Interface type. The
supported values are:
n Wired
n Wireless
n VPN

Name This is the host name of the client (without the domain name).

OSArch Specifies whether the client is running a 32-bit or 64-bit OS. The
supported values are:
n i386: 32-bit OS
n x86_64: 64-bit OS

OSName Indicates the full Operating System name. This attribute can be used
to create services for a specific OS.
For example, you can use this attribute to differentiate between
Windows 8 and Windows 8.1

OSNameVersion Provides the Windows OS name and the build version. This attribute
can be used to create different Posture policies for different Windows
10 versions such as 2015 LTSB or 2016 LTSB.

OSType Specifies the Operating System type. The supported values are:
n Linux
n macOS
n Windows XP
n Windows 7
n Windows 8
n Window 10
n Windows Server 2003
n Windows Server 2003 R2
n Windows Server 2008
n Windows Server 2008 R2

SDKType Specifies the SDK type.
For example, you can specify that the SDK type equals V4. For related
information, see Upgrading From OnGuard Plugin Version 1.0 to 2.0.
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Attribute Name

SDKVersion Specifies the SDK version.

ServerCertificateCheck This attribute's value shows the status of the ClearPass Server
Certificate Check performed by OnGuard agent while sending a
WebAuth request to the ClearPass server.This attribute can also be
used in a Service Classification.
The value of this attribute can be one of the following:
n Passed: OnGuard Agent successfully verified the ClearPass Server

Certificate.
n Failed: OnGuard Agent failed to verify the ClearPass Server

Certificate.

UserAgent The value of this attribute contains both Agent Type and Agent
Version. For example, OnGuard 6.6.5.89660.

Web-based Health Check Only Service
This type of service is the same as the Web-based Authentication service except that there is no
authentication performed; only health check are performed.

n The internal service rule Connection:Protocol EQUALS WebAuth categorizes requests into this type of
service.

n The external service rule Host:CheckType EQUALS Health is automatically added when you select this
type of service.

For more information, see Web-Based Authentication Service on page 88.

Creating the Service
To create a Web-based Health Check Only service:

1. Navigate to Configuration > Services, then select the Add link.The Web-Based Health Check Only
service configuration dialog opens:

Figure 62 Web-Based Health Check Only Service Configuration Dialog

2. Specify the Service tab parameters as described in the following table:
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Parameter Action/Description

Type From the drop-down list, select Web-based Health Check Only.

Name Enter the name of the service.

Description Provide additional information that helps to identify the service.

Monitor Mode Select the check box to monitor network access activity without enforcement.

More Options Check these boxes to access the additional configuration tabs:
n Authorization
n Posture Compliance

Service Rule

Type Select one of the following service rule types:
n Authentication
n Connection
n Date
n Device
n Host
n Endpoint

Name Select the name of the service rule from the drop-down list.

Operator Select an appropriate operator from the list of operators for the data type of the
attribute.
For example, you can select from BELONGS_TO, NOT_BELONGS_TO, CONTAINS, or
EQUALS.

Value Select the value from the drop-down list. The value list depends on the operator
selected.

Table 1: Add Web-based Health Check Only Service > Service Tab Parameters

Service Rule > Web-Based Authentication Host Attributes
The following table describes the list of other attributes that can be used to create host services based on the
client's information.
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Attribute Name Description

AgentType Specifies the type of OnGuard Agent. This attribute provides a way to define a
separate service for each OnGuard Agent Type. The supported values are:
n OnGuardAgent: OnGuard Agent
n OnGuardAgentService: OnGuard Agent running as a service
n NativeWebAgent: Native Dissolvable Agent
n JavaWebAgent: Java Dissolvable Agent

Agent Version OnGuard Agent version. This attribute can be used to create a service based on
the OnGuard Agent version.

CheckType Specifies the type of check OnGuard Agent is performing based on the Mode
setting in the OnGuard Settings page (for details, see OnGuard Settings and
Agent Library Updates).
For Authenticate with health checks, the value of this attribute is
Authentication, Health. The supported values are:
n Authentication: OnGuard Agent is performing authentication; that is, the

request contains credentials.
n Health: OnGuard Agent is performing health checks; that is, the request

contains Posture information.
n None

FQDN Indicates the Fully Qualified Domain Name of the client.

HealthCheckLevel Indicates the level of health checks performed by OnGuard Agent; that is,
whether the user is logged in at the time of health check or not.
This attribute can be used to see the health check level when OnGuard Agent is
running as Service or BothServiceAndUser.
n System: The user is not logged in when health checks are being run.
n User: The user is logged in when health checks are being run.

Installed SHAs Specifies the SHAs installed on the client.

InterfaceType Specifies the type of Network Interface. This attribute can be used to define
different services based on Network Interface type. The supported values are:
n Wired
n Wireless
n VPN

Name This is the host name of the client (without the domain name).

OSArch Specifies whether the client is running a 32-bit or 64-bit OS. The supported
values are:
n i386: 32-bit OS
n x86_64: 64-bit OS

OSName Indicates the full Operating System name. This attribute can be used to create
services for a specific OS.
For example, you can use this attribute to differentiate between Windows 8 and
Windows 8.1

OSNameVersion Provides the Windows OS name and the build version. This attribute can be
used to create different Posture policies for different Windows 10 versions such
as 2015 LTSB or 2016 LTSB.

OSType Specifies the Operating System type. The supported values are:

Table 2: Service Rule >Web-Based Health Check Only Host Attributes
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Attribute Name Description

n Linux
n macOS
n Windows XP
n Windows 7
n Windows 8
n Window 10
n Windows Server 2003
n Windows Server 2003 R2
n Windows Server 2008
n Windows Server 2008 R2

SDKType Specifies the SDK type.
For example, you can specify that the SDK type equals V4. For related
information, see Upgrading From OnGuard Plugin Version 1.0 to 2.0.

SDKVersion Specifies the SDK version.

ServerCertificateCheck This attribute's value shows the status of the ClearPass Server Certificate
Check performed by OnGuard agent while sending a WebAuth request to the
ClearPass server.This attribute can also be used in a Service Classification.
The value of this attribute can be one of the following:
n Passed: OnGuard Agent successfully verified the ClearPass Server

Certificate.
n Failed: OnGuard Agent failed to verify the ClearPass Server Certificate.

UserAgent The value of this attribute contains both the Agent Type and Agent Version.
For example, OnGuard 6.6.7.89660.

Web-Based Open Network Access Service
Configuration for this service is the same as Web-based Authentication service, except that a health check is
not performed on the endpoints. A Terms of Service page (as configured on the ClearPass Guest Portal page) is
presented to the user. Network access is granted when you click Submit Action.

The Posture option is not available for the Web-Based Authentication service. For more information, see
Web-Based Authentication Service on page 88. The following figure displays the Web-based Open Network
service page configuration dialog:
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Figure 63 Web-based Open Network Access Service Configuration Dialog

For configuration details, see Aruba 802.1X Wireless Service on page 61.

Modifying and Managing Services
Following the procedures described in this section to modify and manage your services.

Modifying an Existing Service
You can use service types as configured, or you can edit their settings. To modify an existing service:

1. Navigate to the Configuration >  Services page.

2. Select the service you wish to modify. The Services > [service_name] dialog opens.

3. Edit the service parameters, then click Save to save your settings. For complete information on the settings
supported by each service type, seeConfiguring Services Using Service Templates & Wizards and Configuring
Other Policy Manager Services .

Creating a Service by Copying an Existing Service
You can perform a service-copy operation only on a Publisher node.To create a service template by making a
copying an existing service:

1. From the Services page, select the check box by a service.

2. Click Copy. You receive the following message: Service Copy_of_<service_name> has been added.

Removing a Non-Default Service
To remove a non-default service:

1. From the Services page, select the check box for the non-default service you want to remove.

2. Click Delete. You receive the prompt: Are you sure you want to delete this service?

3. To cancel the delete operation, click No. To delete the selected service, click Yes.
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Restarting ClearPass Services

The Audit Viewer (Monitoring > Audit Viewer) tracks NTP configuration changes.

To restart ClearPass services:

1. Navigate to Administration > Server Manager > Server Configuration.

2. Select the ClearPass Publisher node.

3. From the Server Configuration page, select the Services Control tab.

4. From the Action column, click Start for each service that needs to be restarted. Once the service is
restarted, the Start button is changed to Stop.

Figure 64 Restarting Stopped Services

Reordering Services
ClearPass Policy Manager evaluates requests against the service rules of each service that is configured, in the
order in which these services are defined.

n The service associated with the first matching service rule is associated with the request.

n To change the order in which service rules are processed, you can change the order of services.

To change the order of the services:

1. Navigate to the Configuration > Services page. The Services page opens.

Figure 65 Services Page Reorder Button

2. Click the Reorder button (located on the lower-right portion of the page). The Reorder Services page
opens.

3. Click the service you want to move to another position in the order (see Figure 66). In this example, we will
move Guest Operator Logins at the 5th position to the 2nd position.
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Figure 66 Selecting the Service to Be Reordered

4. Select the position where you want to move the service (see ).

Figure 67 Selecting the Destination Order Position

5. Click the selected destination position (see Figure 68). The service is now moved to its new position in the
services order.

Figure 68 Service Moved to New Order Position

6. Click Save.You return to the Services page, which shows the service in its new order and displays the
message: Services have been reordered successfully.
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Chapter 3
Live Monitoring

Live Monitoring

The Live Monitoring features in Policy Manager provide access to live monitoring of components and other
functions. ClearPass Policy Manager includes the following Live Monitoring features:

n Live Monitoring: Access Tracker on page 102

n Live Monitoring: Accounting on page 117

n Live Monitoring: Analysis and Trending on page 137

n Live Monitoring: OnGuard Activity

n Live Monitoring: System Monitor on page 138

Additional Monitoring Functions

The following additional monitoring features are provided:

n Audit Viewer on page 148

n Event Viewer on page 151

n Data Filters on page 154

n Restoring Blacklisted Users to the Network on page 158

Live Monitoring: Access Tracker
This section provides the following information:

n About the Access Tracker

n Customizing the Access Tracker

n Viewing Access Tracker Session Details

About the Access Tracker
The Access Tracker provides a real-time display of per-session access activity on the selected server or
domain. To view this page, navigate to Monitoring > Live Monitoring > Access Tracker.

Figure 69 Access Tracker Page

You can adjust and resize the column widths for the columns on the Access Tracker page. Use your mouse to grab
the column separator to the left of the column title, then move the column left or right to change the column width.
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Table 1 describes the information provided on the Access Tracker page:

Column Description

Server Displays the IP address of the current ClearPass server.

Source Displays the authentication source for the session. For example, TACACS or web
authentication (WEBAUTH).

Username Displays the username or MAC address of the host.

Service Displays the name of the service.

Login Status Displays the status of the request, such as Accept, Reject, or Timeout.

Request Timestamp Displays the date and time when the status was last updated.

Table 1: Access Tracker Page Columns

Customizing the Access Tracker
To customize the Access Tracker parameters:

1. From the Access Tracker page, click the Edit button (in the upper-right corner of the page). The
EditAccess Tracker page opens.

Figure 70 Edit Access Tracker Page

2. Modify the Edit Access Tracker page parameters as described in the following table, then click Save:
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Parameter Action/Description

Select Server/
Domain

From the drop-down, select the server or domain on the Access Tracker page.
To display transactions from all nodes in the Policy Manager cluster, select the default
option.

Select Filter Select a filter category to filter the displayed data.
For a description of available filters, see Data Filters on page 154.

Modify Filter
To modify the current data filter, click the icon. For more information, see Data Filters on
page 154.

Add Filter
To add a data filter, click the icon. For more information, see Data Filters on page
154.

Select Date Range To select the start of the range of dates for which the Access Tracker table displays data,
click the Last drop-down list. Available options are one to six days, or one week.

Select Date To select a date, click the icon.

 Show Latest To set the date in the before field to the current date, click Show Latest.

Select Columns This section displays the following two fields:
n Available Columns: Displays the data column available to be displayed in an Access

Tracker table.
n Selected Columns: Displays the data columns currently selected for display.
To move a column name from one field to another, select the column name and click the left
or right arrows. To change the order in which the columns are displayed, click a column
name in the Selected Columns field, then click the Up or Down buttons.

Table 1: Edit Access Tracker Page Parameters

Viewing Access Tracker Session Details
The following section describes session details for RADIUS, WebAuth and TACACS+ sessions

View RADIUS Session Information
To view details about a selected RADIUS session, navigate to the Monitoring > Live Monitoring > Access
Tracker page.
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Figure 71 Access Tracker Page

Click a RADIUS session in the Access Tracker table. The Session Details for the selected RADIUS transaction
are displayed. The information in this page varies, depending upon the session selected.

Change Status Button

When you click the Change Status button, the Request Details > Access Control Capabilities dialog
opens:

Figure 72 Access Control Capabilities

Specify the access control capabilities as described in the following table.
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Parameter Action/Description

Select Access Control Type Select one of the following Access Control Types to view or change any of the
supported access control types.
n Agent: This control is available for a session where the endpoint has the

OnGuard Agent installed. The following actions are allowed:
l Bouncing
l Sending Messages
l Tagging the status of the endpoint as Disabled or Known.

n SNMP: This control is available for any session for which Policy Manager has
the switch and port-level information associated with the MAC address of the
endpoint. Policy Manager uses SNMP to bounce the switch port with which the
endpoint is associated. For this type of control, SNMP read and write
community strings must be configured for the network device. You must
configure Policy Manager as an SNMP trap receiver to receive link up and link
down traps. For more information, see SNMP Trap Receivers.

n RADIUS CoA: This control is available for any session where access was
previously controlled by a RADIUS transaction. The network device must be
RADIUS CoA-capable and RADIUS CoA-enabled when you configure the
network device in Policy Manager (see Adding a Network Device). The actions
available depend on the type of device. The Disconnect or Terminate Section
action is supported by all devices. Some devices support setting a session
timeout, changing the VLAN for the session, and applying an ACL.

n Server Action: This control is available by default for any session. Select the
server action from the Server Action drop-down list.

RADIUS CoA Type Select one of the following RADIUS CoA (Change of Authorization)l types:
n Cisco - Terminate Session
n Cisco - Disable Host-Port
n Cisco - BounceHost-Port
n Cisco - Reauthenticate-Session
n CPATS CoA Enforcement Profile

Table 1: Access Control Capabilities

RADIUS > Summary Tab
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The Summary page shows the high-level information for the transaction.

Figure 73 Access Tracker > RADIUS Request Details > Summary Page

RADIUS > Input Tab

The Input tab shows protocol-specific attributes that Policy Manager received in a transaction request,
including authentication and posture details (if available). The Input tab also shows computed attributes that
Policy Manager derived from the request attributes:

n RADIUS Request

n Computed Attributes

n Endpoint Attributes

All of these attributes can be used in role -mapping rules. To view the Input tab, select a RADIUS session in the
Access Tracker page, then select the Input tab.
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Figure 74 Access Tracker > RADIUS Request Details > Input Page

RADIUS > Output Tab

The RADIUS Request Details > Output tab shows the attributes that were sent to the network device
(switch or controller) and the posture-capable endpoint (for example, MAC devices). You can view the posture
response and posture evaluation with accurate results. For example, you can view details such as missing
registry keys and the reasons for a failed registry key check.

To view the Request Details > Output page:

1. Navigate to the Monitoring > Live Monitoring > Access Tracker page.

2. Click any RADIUS session in the Access Tracker page.

3. Select the Output tab. The RADIUS Request Details > Output page opens:

Figure 75 Access Tracker > RADIUS Request Details > Output Page

Access Tracker shows an alert if more than two anti-malware products are installed on a client.

RADIUS > Accounting Tab
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The RADIUS Request Details > Accounting tab shows the account session details, as well as the following
information:

n Network Details

n Utilization information

n Authentication Session Details

To view the RADIUS Request Details > Accounting page:

1. Navigate to the Monitoring > Live Monitoring > Access Tracker page.

2. Click any RADIUS session in the Access Tracker page.

3. Select the Accounting tab. The Request Details > Accounting page opens:

Figure 76 Access Tracker > RADIUS Request Details > Accounting Tab

View WebAuth Session Information
WebAuth (Web Authentication) is a single sign-on (SSO) authentication system for web pages and web
applications. The first time a user attempts to access a web page protected by WebAuth, they are sent to a
central login server and prompted to authenticate. Users are typically asked for a username and password,
although other authentication methods are possible.

Once the user has logged in, the weblogin server sends their encrypted identity back to the original web page
they were trying to access. Their identity is also stored in a cookie set by the weblogin server and they will not
need to authenticate again until their credentials expire, even if they visit multiple protected web sites.To view
details about a selected WebAuth session:

1. Navigate to the Monitoring > Live Monitoring > Access Tracker page. The Access Tracker page
opens.

2. Click a WebAuth session in the Access Tracker table.

WebAuth > Summary Tab
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The Request Details page for the selected WebAuth (Web Authentication) transaction opens to the
Summary page. The information in this page varies, depending upon the type of session selected.

Figure 77 Access Tracker >WebAuth Request Details > Summary Page

The WebAuth Request Details > Summary page displays the basic WebAuth session information (login
status, date and time, end-host identifier, and so on), as well as providing a section that summarizes the service
being applied and details about the policies and profiles in use.

WebAuth Input Tab

The Input tab shows protocol-specific attributes that Policy Manager received in a transaction request,
including authentication and posture details (if available). The Input tab also shows computed attributes that
Policy Manager derived from the request attributes. All of these attributes can be used in role -mapping rules.

1. To view the Input tab, click a WebAuth session in the Access Tracker page, then select the Input tab.
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Figure 78 Access Tracker >WebAuth Request Details > Input Page

WebAuth > Output Tab

The WebAuth Request Details > Output tab shows the attributes that were sent to the network device
(switch or controller) and the posture-capable endpoint (for example, MAC devices). You can view the posture
response and posture evaluation with accurate results. For example, you can view details such as missing
registry keys and the reasons for a failed registry key check. The Output page also provides the RADIUS
response summary.

To view the WebAuth Request Details > Output page:

1. Navigate to the Monitoring > Live Monitoring > Access Tracker page.

2. Click any WebAuth session in the Access Tracker page.

3. Select the Output tab.

The WebAuth Request Details > Output page opens:
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Figure 79 Access Tracker >WebAuth Request Details > Output Page

View TACACS+ Session Information
TACACS+ is a security application that provides centralized validation of users attempting to gain access to a
router or network access server. The goal of TACACS+ is to provide a methodology for managing multiple
network access points from a single management service.

TACACS+ services are maintained in a database on a TACACS+ daemon running, typically, on a UNIX or
Windows NT workstation. You must have access to and must configure a TACACS+ server before the
configured TACACS+ features on your network access server are available.

To view details about a selected TACACS+ session, navigate to the Monitoring > Live Monitoring > Access
Tracker page, then click a TACACS+ session in the Access Tracker table.

Figure 80 Access Tracker Page with TACACS+ Session

TACACS+ > Summary Tab

The Session Details for the selected TACACS+ transaction opens to the Summary page.
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Figure 81 Access Tracker > TACACS Session Details > Summary Page

Table 2 describes the parameters in the TACACS+ Session Details Summary page.

Field Action/Description

Session ID Displays the automatically-generated session ID for the selected TACACS+ session.

Username Indicates the name of the admin user.

Time Indicates the time that the TACACAS+ session was initiated.

Status Indicates the authentication status of the selected TACACS+ session.

Authorizations Indicates the number of authentication authorizations that have taken place for this
session.

Export To export the TACACS+ summary information, click Export. For details, see Importing and
Exporting Information.

Show Logs When you click Show Logs, the Request log details for session: <session_number> are
displayed.

Table 2: TACACS Session Details > Summary Page Parameters

TACACS+ > Request Tab
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The TACACS+ Request page provides the essential information regarding the TACACS+ authentication
request.

Figure 82 Access Tracker > TACACS Session Details > Request Page

Table 3 describes the parameters in the TACACS+ Session Details Request page.

Field Action/Description

Username Indicates the name of the admin user.

Session ID Displays the automatically-generated session ID for the selected TACACS+ session.

Time Indicates the time that the TACACS+ session was initiated.

Status Indicates the authorization status of the selected TACACS+ session. The possible values
are:
n AUTHEN_STATUS_PASS
n AUTHEN_STATUS_FAIL
n AUTHEN_STATUS_GETDATA
n AUTHEN_STATUS_GETUSER
n AUTHEN_STATUS_GETPASS
n AUTHEN_STATUS_RESTART
n AUTHEN_STATUS_ERROR
n AUTHEN_STATUS_FOLLOW

Request Type Indicates the type of authentication request. There are three supported request types:
n TACACS Authentication
n TACACS Authorization
n TACACS Accounting

Message This is a message to be displayed to the user.

Client IP This is the IP address of the device (for example, the ArubaOS switch)the remote IP device
is attempting to log into.

Remote IP This is the source IP address of the user device (for example, a laptop) attempting to log
into the client device.

Table 3: TACACS Session Details > Request Page Parameters
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TACACS+ > Policies Tab

The TACACS+ > Policies page provides the details regarding the Policy Manager role mapping policies used,
authentication sources, and enforcement policies used (if available).

Figure 83 Access Tracker > TACACS Session Details > Policies Page

Field Action/Description

Service Name Indicates the name of the ClearPass service through which the user is authenticated.

Authentication
Source

Specifies the authentication source used bythe client. For more information, see Adding
and Configuring Authentication Sources.

Role Indicates the Policy Manager role assigned to the client. For more information, see Adding
and Modifying Roles.

Profiles Indicates the Enforcement Profile configured for this service. For more information, see
Configuring Enforcement Profiles.

Table 4: TACACS Session Details > Policies Used Page Parameters

TACACS+ > Alerts Tab

The TACACS+ > Alerts page shows information about a session that has an error.

Figure 84 Access Tracker > TACACS+ Session Details > Alerts Page
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Field Action/Description

Authentication Request Messages

Error Category Indicates the error category.

Error Code Dispays the error code.

Alerts for This Request

Alert source Indicates the source for this alert; in this case, the TACACS+ server.

Alert message Displays the alert message.

Table 5: TACACS Session Details > AlertsPage Parameters

Network Details

The Network Details section of the Access Request > Request Details > Accounting page includes a list
of the IPv6 addresses from the Framed-IPv6-Address vendor-specific attributes.

Figure 85 Accounting > Network Details Section

Framed IPv6 Data Available Via Export

Framed-IPv6-Address information is also available when you click Export from the Access Tracker Request
Details page. TheDashboard_Details.zip file contains theDashboard_Details.txt file. In the the Network
Details section of theDashboard_Details.txt file, entries for Framed IPv6 Address are provided:
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Figure 86 Framed IPv6 Address Information in Access Tracker Exported File

Live Monitoring: Accounting
This section provides the following information:

n Modifying the Accounting Page Parameters

n RADIUS Accounting Details > Summary Tab

n RADIUS Accounting Record Details > Auth Sessions Tab

n RADIUS Accounting Record Details > Utilization Tab

n RADIUS Accounting Record Details > Details Tab

n TACACS+ Accounting Record Details > Request Tab

n TACACS+ Accounting Record Details > Auth Sessions Tab

n TACACS+ Accounting Record Details > Details Tab

The Accounting page provides a dynamic report that describes session access, as reported by the network
access device by means of RADIUS or TACACS+ accounting records. To bring up the Accounting page,
navigate to Monitoring > Live Monitoring > Accounting.
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Figure 87 Live Monitoring > Accounting Page

The following table describes the Accounting parameters:

Parameter Description

Server Specifies the IP address of the host name.

Protocol Specifies the protocol used.

User Displays the user name.

Access Device Displays the IP address of the device.

Start Time Displays the date and time.

Table 1: Accounting Page Parameters

You can click any row in the Accounting page to drill down and display the corresponding Accounting
Record Details page for the selected session. For details, see RADIUS Accounting Details > Summary
Tab on page 119 and TACACS+ Accounting Record Details > Auth Sessions Tab on page 126.

Modifying the Accounting Page Parameters
You can filter or modify the information displayed in this table by creating a filter, or selecting a different
server, domain, or time range. To filter the data currently displayed in the Accounting page:

1. Navigate to the Monitoring > Live Monitoring > Accounting page.

2. Click Edit. The Edit Accounting Page dialog opens.
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Figure 88 Edit Accounting Page Dialog

3. Specify the Edit Accounting Page parameters as described in Table 2:

Parameter Action/Description

Select Server/ Domain Select the ClearPass server for the dashboard data to be displayed.

Select Filter To constrain the data display, select a filter from the drop-down list.
You can select one of the following filters:
n Protocol
n User
n Access Device

Modify
To modify a data filter, click the Modify Data Filter icon (as shown in Figure 88).

Add
To create a new data filter, click the icon.

Select Date Range Select the number of days prior to the configured date for which the accounting data
to be displayed. You can specify the number from one day to a week.

Show Latest To view the latest information, set the date to Today.

Select Columns n To move data between Available Columns and Selected Columns, click the right
or left arrows.

n To rearrange columns, click the Up or Down buttons.

Table 2: Edit Accounting Page Parameters

RADIUS Accounting Details > Summary Tab
To drill down and display the corresponding Accounting Record Details page for the session, click any row in
the Accounting page. The Accounting Record Details > Summary tab shows a summary view of the
transaction including session IDs, timestamp, and network details such as the framed IPv6 addresses for the
RADIUS protocol. The following figure displays the RADIUS Accounting Record Details > Summary page:
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Figure 89 RADIUS Accounting Record Details Summary Page

The following table describes the configuration parameters on the RADIUS Accounting Record Details >
Summary page:

Parameter Description

Session ID Specifies the Policy Manager session identifier.
You can correlate this record with a record in Access Tracker.

Account Session ID Specifies a unique ID for this accounting record.

Start Timestamp
End Timestamp

Shows the start time and end time of the session.

Status Shows the current connection status of the session.

Username Username associated with this record.

Termination Cause Specifies the reason for termination of this session.

Service Type Shows the value of the standard RADIUS attribute service type.

Network Details

NAS IP Address Shows the IP address of the network device.

Table 1: RADIUS Accounting Record Details Summary Tab Parameters
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Parameter Description

NAS Port Type Shows the access methods. For example, Ethernet, or 802.11 Wireless.

Calling Station ID Specifies the MAC address of the client that is supported by Policy Manager.
NOTE: Policy Manager supports Calling Station ID MAC addresses in the following
formats:
n XXXX-XXXX-XXXX
n aa:bb:cc:dd:ee:ff
n aa-bb-cc-dd-ee-ff
n aaaa.bbbb.cccc
n aabbccddeeff
n aaaa-bbbb-cccc

Called Station ID Shows the MAC address of the network device.

Framed IP Address Shows the IP address of the client (if available).

Framed IPv6 Address Displays a list of the IPv6 addresses from the Framed-IPv6-Address vendor-specific
attributes.

Account Auth Specifies the type of authentication; for example, RADIUS authentication.

RADIUS Accounting Record Details > Auth Sessions Tab
This section describes the parameters of the Accounting Record Details > Auth Sessions tab for the
RADIUS protocol. The following figure displays the the Accounting Record Details > Auth Sessions page:

Figure 90 RADIUS Accounting Record Details > Auth Sessions Page
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The following table describes the RADIUS Accounting Record Details >Auth Sessions parameters:

Parameter Description

Number of
Authentication
Sessions

Specifies the total number of authentications (always 1) and authorizations in this session.

Authentication Sessions Details

Session ID Displays the Policy Manager session ID.

Type Specifies the type of authentication: Initial authentication or reauthentication.

Time Stamp Specifies the time when the event occurred.

Table 1: RADIUS Accounting Record Details Auth Sessions Tab Parameters

RADIUS Accounting Record Details > Utilization Tab
This section describes the parameters of the Accounting Record Details > Utilization tab for the RADIUS
protocol. The following figure displays the RADIUS Accounting Record Details > Utilization page:

Figure 91 RADIUS Accounting Record Details > Utilization Page
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The following table describes the configuration parameters on the RADIUS Accounting Record Details -
Utilization tab:

Parameter Description

Active Time Displays the duration of the session that was active.

Account Delay
Time

Displays how many seconds the network device has been trying to send this record for
(subtract from record time stamp to determine the time this record was actually generated by
the device).

Account Input
Octets

Specifies the quantity of octets sent to and received from the device port during the session.

Account Output
Octets

Account Input
Packets

Specifies the packets sent and received from the device port during the session.

Account Output
Packets

Table 1: RADIUS Accounting Record Details > Utilization Tab Parameters

RADIUS Accounting Record Details > Details Tab
This section describes the parameters of the Accounting Record Details > Details tab for the RADIUS
protocol. The following figure displays the example of the RADIUS Accounting Record Details > Details
page:
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Figure 92 RADIUS Accounting > Details Page

The following table summarizes the configuration information provided on the RADIUS Accounting Record
Details > Details page:

Parameter Description

Accounting
Packet Details

Shows the details of RADIUS attributes sent and received from the network device during an
initial authentication and subsequent reauthentications. Each section in the Details page
corresponds to a session in Policy Manager.

Table 1: RADIUS Accounting Record > Details Page Summary
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TACACS+ Accounting Record Details > Request Tab
When you navigate to the Monitoring > Live Monitoring > Accounting page and select a TACACS+
Accounting record, the Accounting Record Details page opens to the Request page.

The following figure displays the TACACS+ Accounting Record Details > Request page:

Figure 93 TACACS+ Accounting Record Details > Request Page

The following table describes the configuration parameters on the TACACS+ Accounting Record > Request
page:

Parameter Description

Session ID Specifies the Session ID, which is a unique ID associated with a request.

User Session ID Specifies a session ID that correlates authentication, authorization, and
accounting records.

Start and End Timestamp Shows the start and end times of the session.

Username Shows the username associated with this record.

Client IP Shows the IP address and tty (text terminal) of the device interface.

Remote IP Shows the IP address from which the Administrator is logged in.

Flags Shows the identifier corresponding to starting, stopping, or updating the
accounting record.

Privilege Level Specifies the privilege level of the Administrator.
The range is from 1 (lowest) to 15 (highest).

Table 1: TACACS+ Accounting Record Request Page Parameters
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Parameter Description

Authentication Method Identifies the authentication method used for network access.

Authentication Type Identifies the authentication type used for network access.

Authentication Service Identifies the authentication service used for network access.

TACACS+ Accounting Record Details > Auth Sessions Tab
This section describes the parameters of the Accounting Record Details > Auth Sessions tab for the
TACACS+ protocol.

You can click any row in the Accounting page to display the corresponding Accounting Record Details page
for the session.

1. Navigate to the Monitoring > Live Monitoring > Accounting page.

2. Select a TACACS+ Accounting record. The Accounting Record Details page opens.

3. To view the Authentication Sessions details, click the Auth Sessions tab.The following figure displays the
TACACS+ Accounting Record Details > Auth Sessions page:

Figure 94 TACACS+ Accounting Record Details > Auth Sessions Page

The following table summarizes the information available on the TACACS+ Accounting Record Details >
Auth Sessions page:
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Parameter Description

Number of
Authentication
Sessions

Specifies the total number of authentications (always 1) and authorizations in this session.

Authentication
Sessions Details

Denotes whether the request is an authentication or authorization request, and the time
at which the request was sent for each request ID.

Table 1: TACACS+ Accounting Record Details > Authentication Sessions Page Parameters

TACACS+ Accounting Record Details > Details Tab
This section describes the parameters of the Accounting Record Details > Details page for the TACACS+
protocol.

You can click any row in the Accounting page to display the corresponding Accounting Record Details page
for the session.

1. Navigate to the Monitoring > Live Monitoring > Accounting page.

2. Select a TACACS+ Accounting record.

The Accounting Record Details page opens.

3. To view the sessions details, click the Details tab.

The following figure displays the TACACS+ Accounting Record Details > Details page:

Figure 95 TACACS+ Accounting Record Details > Details Page

The following table summarizes the configuration parameters provided on the TACACS+ Accounting
Record > Details tab:
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Parameter Description

Accounting
Packet
Details

Shows command typed (cmd), privilege level of the administrator executing the command (priv-
lvl) and service (shell) for each authorization request, as well as the start time, task ID, and the
time zone.

Table 1: TACACS+ Accounting Record > Details Page Parameters

Live Monitoring: OnGuard Activity
This section provides the following information:

n About OnGuard Activity

n Viewing Authentication Records

n Broadcasting Notifications to OnGuard Agents

n Sending a Message to Selected Endpoints

n Bouncing a Client Using SNMP

n Bouncing an Agent Not Using SNMP

n Bouncing the Network Interface After Waking Up From Sleep Mode

About OnGuard Activity
The OnGuard Activity page shows the real-time status of all endpoints that have ClearPass OnGuard
persistent agent. This page also presents configuration tools to bounce an endpoint, restart a session, and
send unicast or broadcast messages to all endpoints running the OnGuard agent.

To access the OnGuard Activity page:

1. Navigate to Monitoring > Live Monitoring > OnGuard Activity.The OnGuard Activity page opens:

Figure 96 OnGuard Activity Page

The following table describes the action buttons on the OnGuard Activity page:
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Parameter Action/Description

Send Message Click Send Message to send a message to the selected endpoints. For details,
see Sending a Message to Selected Endpoints.

Send Notification Click Send Notification to apply the Bounce or Restart Session notification
options to one or more endpoints that you selected in the OnGuard Activity
list. For details, see Broadcasting Notifications to OnGuard Agents.

Table 1: OnGuard Activity Parameters

Viewing Authentication Records
From the OnGuard Activity page, you can view the authentication records for the online devices that are
listed.To view the authentication records for a device that is online, click the View button on the pertinent row.
The Endpoint Authentication Details page opens.

Figure 97 Viewing an Endpoint's Authentication Records

Broadcasting Notifications to OnGuard Agents
This option allows administrators to send bounce or restart notifications to every connected OnGuard Agent. A
custom message can be included with the notifications.

To send bounce or restart notifications to selected OnGuard Agents:

1. Navigate to Monitoring > Live Monitoring > OnGuard Activity.The OnGuard Activity page opens.
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Figure 98 OnGuard Activity Page

2. Select the endpoint(s) to which you want to broadcast notifications.

In order for a message or notification to be sent, the endpoint status must be Online (green check icon).

3. Click the Broadcast Notification link. The Broadcast Notification to Agents dialog opens.

Figure 99 Broadcast Notification to Agents > Bounce Action Dialog

4. Specify the Broadcast Notification to Agents parameters as described in the following table:
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Parameter Action/Description

Display Message
(Optional)

Enter the text of the message you want to send to the selected OnGuard
Agents.

Web link for more details
(optional)

Optionally, enter a URL to be included with the message specified for
Display Message.

Action Select one of the following actions:
n Bounce: Select this option to have the OnGuard Agent bounce the

network interface.
n Restart Session: Select this option to have the OnGuard Agent restart

the session in order to perform authentication and health checks.

Endpoint Status When you select Bounce, you must specify one of the following options:
n No change in status: No change is made to the status of the endpoint.

The existing status of Known, Unknown, or Disabled continues to be
applied. Access control is granted or denied based on the existing
status of an endpoint.

n Allow network access: Allow network access by white-listing this
endpoint. Clicking Allow network access sets the status of the
endpoint as Known.

NOTE: You must configure Enforcement Policy Rules to allow access to
the endpoints with the status Known.
n Block network access: Block network access by blacklisting this

endpoint. Clicking Block network access sets the status of the
endpoint to Disabled.

NOTE: You must configure Enforcement Policy Rules to allow access to
the endpoints with the status Disabled.

Table 1: Send Notification to Agents Parameters

5. Click Send Notification. The notification, along with the specified Endpoint Status, is sent to the selected
endpoints.

Sending a Message to Selected Endpoints
To send a message to selected endpoints:

1. Navigate to Navigate to Monitoring > Live Monitoring > OnGuard Activity. The OnGuard Activity
page opens.

2. Select one or more devices listed on the OnGuard Activity page.

3. Click the Send Message button. The Send Notification to Agents dialog opens.

Figure 100 Sending a Message to OnGuard Agents
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4. Specify the Send Notification to Agents parameters as described in the following table:

Parameter Action/Description

Display Message Enter the text of the message you want to send to the selected OnGuard
Agents.

Web link for more details
(optional)

Optionally, enter a URL to be included with the text specified for Display
Message.

Table 1: Send Notification to Agents Parameters

5. Click Send. The message is sent to the selected devices.

Bouncing a Client Using SNMP
The Bounce Client (using SNMP) dialog is used to initiate a bounce operation using SNMP with wired
Ethernet switches.

Endpoint bounce only works with endpoints that run the OnGuard persistent agent.

Requirements
To successfully bounce a client using SNMP, the following conditions are required:

n The network device must be added to Policy Manager and SNMP read and write parameters must be
configured.

l For information about adding a network device to ClearPass Policy Manager, see Adding a Network
Device.

l For details about configuring SNMP settings, see SNMP Read Settings Parameters on page 428 and
SNMP Write Settings Parameters.

n SNMP traps (link up and/or MAC notification) must be enabled on the switch port (see ClearPass SNMP
Traps and OIDs and SNMP Trap Details).

n The DHCP snooper service on a ClearPass server must receive DHCP packets from the endpoint to specify
the IP address of the endpoint to bounce.

l For information about configuring the DhcpSnooper service, see ClearPass Network Services Options.

l For information about configuring the IP helper address, see DHCP Collector.

Bouncing a Client
To bounce a client using SNMP:

1. Navigate to Monitoring > Live Monitoring > OnGuard Activity. The OnGuard Activity page opens.
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Figure 101 OnGuard Activity Page

2. Click the Bounce Client (using SNMP) link. The Bounce Client (using SNMP) dialog opens.

Figure 102 Bouncing a Client Using SNMP

3. Enter the client IP address or MAC address of the client to be bounced, then click Go.The rest of the fields in
the Bounce Client (Using SNMP) dialog are automatically populated (Host MAC, Host IP, etc.) and the Send
Notification button is enabled.

4. Click Go, then click Send Notification. The OnGuard Agent bounces the network interface of the specified
client device.

Bouncing an Agent Not Using SNMP
This section describes how to initiate a bounce on an endpoint's managed interface.

Endpoint bounce works only with endpoints that run the OnGuard persistent agent.

Initiating a bounce on the managed interface on the endpoint results in creating tags for the specified endpoint
in the Endpoints page (navigate to Configuration > Identity > Endpoints).

One or more of the following tags are created:

n Disabled by

Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1165



n Disabled Reason

n Enabled by

n Enabled Reason

n Info URL

To bounce an agent:

1. Navigate to Monitoring > Live Monitoring > OnGuard Activity. The OnGuard Activity page opens.

2. Click a device listed on the OnGuard Activity page. The Agent and Endpoint Details page opens.

Figure 103 Agent and Endpoint Details

The following table describes the configuration parameters on the Agent and Endpoint Details page:

Parameter Description

Host MAC Displays the MAC address of the user.

Description Optional description of the endpoint.

Status Displays the status of the endpoint.

Added by Displays the server name.

MAC Vendor Vendor name and OS of the endpoint device.

OnGuard Details

User Displays the MAC address of the host.

Host IP Displays the IP address of the host.

Status Shows the status of the agent as either Online or Offline.

Agent Type Specifies the agent as an OnGuard agent.

Host OS Displays the operating system that runs on the endpoint.

Registered Policy Manager
Server

Displays the name and IP address of the Policy Manager server.

Registered at Displays the date and time at which the Policy Manager installation was
registered.

Table 1: Agent and Endpoint Details Parameters
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Parameter Description

Last Unregistered at Displays the date and time at which the Policy Manager installation was last
unregistered.

Last Seen Health Status Displays the health status of the endpoint. For example, QUARANTINED or
HEALTHY.

Unhealthy Health Classes Displays the health classes that are unhealthy.

3. Click Send Notification.The Send Notification to Agents dialog opens.

Figure 104 Sending Notification to OnGuard Agents

The following table describes the configuration parameters on the Send Notification to Agents dialog:

Parameter Action/Description

Display Message
(Optional)

An optional message to display on the endpoint using the OnGuard interface.

Web link for more
details (Optional)

An optional clickable URL that is displayed along with the Display Message.

Action Select one of the following actions:
n Bounce: Select this option to have the OnGuard Agent bounce the network interface.
n Restart Session: Select this option to have the OnGuard Agent restart the session in

order to perform authentication and health checks.

Endpoint Status When you select Bounce, you must specify one of the following options:
n No change in status: No change is made to the status of the endpoint. The existing

status of Known, Unknown, or Disabled continues to be applied. Access control is
granted or denied based on the existing status of an endpoint.

Table 2: Send Notification to Agents Parameters
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Parameter Action/Description

n Allow network access: Allow network access by white-listing this endpoint. Clicking
Allow network access sets the status of the endpoint to Known.

NOTE: You must configure Enforcement Policy Rules to allow access to the endpoints
with the status Known. For details, see Configuring Enforcement Policies.
n Block network access: Block network access by blacklisting this endpoint. Clicking

Block network access sets the status of the endpoint to Disabled.
NOTE: You must configure Enforcement Policy Rules to allow access to the endpoints
with the status Disabled.

4. To proceed, click Send Notification.The notification is sent to the selected device.

Posture Info
The Agent and Endpoint Details page includes the Posture Info tab. This page provides posture
information for the selected device in the following categories:

n Posture Request

n Posture Response

n Posture Evaluation Results

n Application Response

Figure 105 Agent and Endpoint Details > Posture Information
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Bouncing the Network Interface After Waking Up From Sleep Mode

ClearPass OnGuard Agent for Windows
ClearPass OnGuard Agent for Windows can bounce the network interface after waking up from sleep mode,
using the value of the new DisableBounceAfterWakeup registry key at the following location:

HKLM\Software\Aruba Networks\ClearPassOnGuard

This registry key is not automatically added to OnGuard during installation—administrators must add it
manually:

n If the value of DisableBounceAfterWakeup = 0, or if the key is not present, OnGuard will bounce the
network interface after waking up from sleep mode.

n If the value of DisableBounceAfterWakeup = 1, OnGuard will not bounce the network interface after
waking up from sleep mode.

The type for DisableBounceAfterWakeup should be REG_DWORD.

ClearPass OnGuard Agent for macOS
ClearPass OnGuard Agent for macOS can bounce the network interface after waking up from sleep mode by
checking the presence of the following file:

/Library/Application Support/ClearPassOnGuard/.disableBounceAfterWakeup

This file is not automatically created during installation—administrators must add it manually:

n If the file .disableBounceAfterWakeup is not present, OnGuard will bounce the network interface after
waking up from sleep mode.

n If the file .disableBounceAfterWakeup is present, OnGuard will not bounce the network interface after
waking up from sleep mode.

Live Monitoring: Analysis and Trending
The Analysis and Trending page displays requests for the subset of components included in the selected
filters over a selected time period: one month, two weeks, one week, one day, 12 hours, 6 hours, 3 hours, or
one hour. The data can be aggregated by minute, hour, day, or week. The list at the end of this section shows
the per-filter count for the aggregated data.

Each bar corresponding to each filter in the bar graph is clickable. Clicking a bar drills down into the Access
Tracker (see Live Monitoring: Access Tracker) that shows session data for the specific time-slice and for the
specific requests. To access this page, navigate to Monitoring > Live Monitoring > Analysis and Trending.
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Figure 106 Analysis and Trending

Use the following components in the user interface to customize and filter the Analysis and Trending page:

Component Action/Description

Select Server Select a ClearPass node from the cluster.

Update Now! Click to update the display with the latest available data.

Customize This! Click to customize the display by adding filters. You can add a maximum of four
filters.

Toggle Chart Type Click to toggle the chart display between line and bar type.

Add New Data Filter Click to add a data filter in the global filter list. For more information on adding filters,
refer to Data Filters on page 154.

Live Monitoring: System Monitor
The System Monitor page has four tabs. Each tab provides one or more charts or graphs that give real-time
information about various components.

Auto refresh ensures that the System Monitor page is updated for every two minutes. You can see the last updated
time in the Last updated at field in the System Monitor page.

n System Monitor Page

n Process Monitor Page

n Network Monitor Page
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n ClearPass Monitor Page

System Monitor Page
The System Monitor page displays charts and graphs that display information about CPU load, CPU usage,
memory usage, and disk usage for the selected ClearPass server.

To access the System Monitor page for the selected ClearPass server:

1. Navigate to Monitoring > Live Monitoring > System Monitor.

2. From the Select Server drop-down, select the desired ClearPass server.

Figure 107 System Monitor Page

Widget Description

CPU Usage Percentage of CPU usage for the following: System, User, I/O Wait, and Idle time.

CPU Load Percentage of CPU load averages in increments of 1, 5, and 15 minutes.

Memory Usage Percentage of free and total memory in Gigabytes.

Swap Memory Usage Percentage of free and total swap memory in Gigabytes.

Disk - Usage Percentage of used and free disk space.

Disk - Swap Usage Percentage of used and total swap space.

Table 1: System Monitor Page Report Widgets

Process Monitor Page
The Process Monitor page displays CPU Usage and Main Memory Usage for a selected process or service.

To access the Process Monitor page, navigate to Monitoring > Live Monitoring > System Monitor >
Process Monitor.
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Figure 108 System Monitoring: Process Monitor Page

Click the Select Process drop down list and select a process To view CPU Usage and Main Memory usage for the
selected process or service.

System Monitor Process List

The following processes can be monitored on the Monitoring > Live Monitoring > System Monitor page

n Admin UI service

n AirGroup notification service

n Apache web server

n Async DB write service

n Async network services

n ClearPass IPsec service

n DB change notification server

n DB replication service

n Domain service

n Extensions service

n Ingress logger service

n Ingress logrepo service

n Micros Fidelio FIAS

n Multi-master cache

n Policy server

n Radius server

n Stats aggregation service

n Stats collection service

n System auxiliary services

n System monitor service

n Tacacs server

n Virtual IP service
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Network Monitor Page
The Network Monitor page displays information about the selected network traffic type. To view network
activity, navigate to Monitoring > Live Monitoring > System Monitor > Network tab, click the Select
menu, and select the desired traffic type.

Figure 109 Network Monitor Page

Network Monitor Traffic List

The Network Monitor page displays network activity (in bytes) for the following traffic types:

n OnGuard

n Database

n Web Traffic

n RADIUS

n TACACS

n SSH

n NTP

ClearPass Monitor Page
The ClearPass Monitoring page displays performance monitoring counters and timers for the last 30 minutes
of activity on several key ClearPass components.

To access the ClearPass Monitor page:

1. Navigate to Monitoring > Live Monitoring > System Monitor > ClearPass tab.

2. Click the Select drop-down.

3. Select the desired ClearPass performance monitoring counter.
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Figure 110 System Monitoring: ClearPass Monitor Page

ClearPass Component List

You can view statistics for the following ClearPass components on this page.

n Service Categorization

n Authentication (RADIUS, TACACS, or WebAuth)

n Authorization

n Role Mapping

n Posture Evaluation

n Audit Scan

n Enforcement

n End-to-End Request Processing (RADIUS, TACACS, or WebAuth)

n Advanced

Monitoring Endpoint Profiler and Network Scan
This section provides the following information:

n Monitoring Endpoint Profiler

n Monitoring Network Scans and Subnet Scans

n Monitoring Discovered Devices

Monitoring Endpoint Profiler

Viewing Discovered Endpoints
To view the discovered endpoints that are connected to the network:

1. Navigate to Monitoring > Profile and Network Scan > Network Scan.The Network Scan page opens.

2. Click Endpoint Profiler.The Endpoint Profiler page opens.
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Figure 111 Endpoint Profiler Page: Viewing the Discovered Endpoints Information

3. Specify the Device Category, Device Family, and Device Name settings that you wish to view.The list of
endpoints that are presented is based on the Device Category, Device Family, and Device Name items
that you select.

4. To see graphs that show information about distribution and update frequency for devices and computers,
click Change View.

Viewing Details About a Specific Endpoint
To view details about a specific endpoint:

1. Click a device in the device table at the bottom of the page. The View Endpoint page opens:

Figure 112 Endpoint Profiler Details

2. To return to the Endpoint Profiler page, select the Cancel button.
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Monitoring Network Scans and Subnet Scans
This section provides the following information:

n Viewing Network Scan and Subnet Scan Status

n Updating the Data on Network Scans and Subnet Scans

Viewing Network Scan and Subnet Scan Status
After you have scheduled and run network scans and subnet scans, you can view the status of all scans run by
the current ClearPass server.

ClearPass retains the scan status information for the last ten network scans and subnet scans that were run.

To view network scan and subnet scan status:

1. Navigate to Monitoring > Profile and Network Scan> Network Scan.The Monitoring > Network
Scan page opens.

Figure 113 Viewing Network and Subnet Scan Status

Parameter Action/Description

Total Devices
Discovered

This section provides the total number of devices and endpoints discovered so far. This
does not display the devices discovered by the selected network or subnet scan.

Filter You can filter for the following:
n Zone
n Type
n Seed Device/IP Subnet(s)
n Start Time
n End Time
n Endpoints
n Devices
n Status

Table 1: Network Scan Status Page Parameters

Updating the Data on Network Scans and Subnet Scans
When Auto-Refresh is enabled (it is enabled by default), ClearPass fetches fresh data every few seconds to
ensure that the network scan and subnet scan status is always current. Every Auto-Refresh operation
accesses the database and reads the data. When there is no network scan occurring, you can disable Auto-
Refresh as there is no need to access the database so frequently in that case.

To enable or disable Auto Refresh:
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1. Navigate to Monitoring > Profile and Network Scan > Network Scan. When Auto-Refresh is enabled,
the button in front of the Auto Refresh link is green.

Figure 114 Network Scan> Auto Refresh

2. To disable Auto-Refresh, click the green button, which then turns red to indicate that the Auto Refresh is
disabled.

Figure 115 Auto Refresh Disabled

3. To reenable Auto Refresh, click the red button in front of the Auto Refresh link. The button turns green
and Auto Refresh is now reenabled.

Monitoring Discovered Devices
This section provides the following information:

n Importing Network Devices

n Viewing Details on a Discovered Device

To access the Discovered Devices page:

1. Navigate to Monitoring > Profile and Network Scan> Discovered Devices.

The Discovered Devices page opens.
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Figure 116 Discovered Devices Page

Importing Network Devices
The devices that you import are added to the set of network devices known to ClearPass.

You can import devices from the Publisher node only.

To import and add discovered devices to the set of ClearPass Network Devices:

1. From the list of discovered devices, select a device you wish to import (as shown in Figure 116).

You can select all of the discovered devices at once by clicking the Name check box.

2. Click the Import button.

The Network Device Details dialog opens.

Figure 117 Importing a Network Device

3. Enter the appropriate information in the Network Device Details dialog as described in Table 1.
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Field Action/Description

RADIUS Shared Secret If using RADIUS, enter the RADIUS Shared Secret for the selected discovered device.

TACACS+ Shared Secret If using TACACS+, enter the TACACS+ Shared Secret for the selected discovered
device.

Override Vendor Optionally, to override the discovered vendor type, select this check box.

Vendor This field is displayed when you select Override Vendor.
From the Vendor drop-down, select the name of the vendor type to override the
discovered vendor type.

Enable RADIUS CoA Select this check box to enable RADIUS CoA (Change of Authorization).

RADIUS CoA Port The default RADIUS CoA port is 3799.
To change the RADIUS CoA port number, enter the new port number.

Table 1: Specifying Network Device Details for Importing Devices

4. Click Import.

The selected network device has been added to ClearPass. To see the network device listed, navigate to
Configuration > Network > Devices.

Figure 118 Network Device Added to ClearPass

Viewing Details on a Discovered Device
To view detailed information about a discovered network devices, including a list of its neighbors in the
network:

1. Navigate to Monitoring > Profile and Network Scan> Discovered Devices.

The Discovered Devices page opens.

2. Click the name of the device of interest.

The Network Device Details page opens.
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Figure 119 Viewing Details fora Discovered Device

3. When finished, click Close.

Audit Viewer

This section provides the following information:

n Introduction

n Add Events

n Modify Events

n Remove Events

Introduction
The Audit Viewer page provides a dynamic report on actions, device name, category of Policy Manager
component, user, and timestamp. To access the Audit Viewer, navigate to Monitoring > Audit Viewer.
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Figure 120 Audit Viewer Page

To display detailed information about the selected event, click any row in the audit viewer. The Audit Row
Details page opens (see Figure 121). The content in the Audit Row Details page varies, depending upon type
of event you select.

Add Events
To display additional details that are specific to the new policy component, click a row with the Add action type
to display the Audit Row Details page.

Figure 121 Audit Row Details for Add Event
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For example, if a TACACS enforcement profile is added, the Audit Row Details page displays detailed
information about that profile. If a policy is created, the Audit Row Details page displays information about
the policy.

Modify Events
To display additional details information about the change, including the previous values, the latest, updated
values, and the differences between the two, click a row with the Modify action type.

Figure 122 shows the Audit Row Details page for a Modify Event.

Figure 122 Audit Row Details for Modify Event

When you view a modify event, the Audit Row Details window contains the following three tabs:

Parameter Description

Old Data Displays a summary of details about the original data values.
n The Profile section shows a summary of the profile values.
n The Attributes section shows data about the original attributes and values.

New Data Displays a summary of details about the new data values.
n The Profile section shows a summary of the profile values.
n The Attributes section shows data about the original attributes and values.

Inline Difference Displays information about what changed. The information is color-coded to indicate the
following types of changes:
n Modified
n Added
n Deleted
n Moved up
n Moved down

Table 1: Audit Row Details > Modify Event Page
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Remove Events
To display details about attributes that were removed, click a row with the Remove action type.

Event Viewer
This section provides the following information:

n About the Event Viewer

n Unsupported Admin Access Attempts Logged to the Event Viewer

n Creating an Event Viewer Report Using Default Values

n Creating an Event Viewer Report Using Custom Values

n Viewing Report Details

About the Event Viewer
The Event Viewer page provides reports about system-level events. All attempted upgrade, patch, and hotfix
installations are logged in the Event Viewer, including failed system installation attempts.

n Session idle time-out values for Admin WebUI session time-out and CLI session time-out events generate
Event Viewer messages with a description that includes the client IP address and session ID when necessary.

n Export and import operations for all modules are captured in the Event Viewer. Any configuration items
that can be imported or exported, such as services, enforcement profiles, endpoints, devices, and so on are
logged.

Unsupported Admin Access Attempts Logged to the Event Viewer
If an attempt is made to access the ClearPassPolicy Manager administration command-line interface (CLI)  with
unsupported SSH protocol versions, or unsupported encryption or cryptographic hash algorithms, ClearPass
logs those alerts in the Event Viewer. This feature requires the Ingress Event Engine option and services to
be enabled (for details, see Enabling Ingress Events Processing).

If an attempt is made to access ClearPassPolicy Manager administration WebUI with unsupported SSL protocol
versions, or unsupported ciphers, ClearPass logs those alerts in the Event Viewer. This feature requires the
Ingress Event Engine option and services to be enabled for the ClearPass server (for details, see Enabling
Ingress Events Processing).

To access the Event Viewer:

1. Navigate to Monitoring > Event Viewer. The Event Viewer page opens.
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Figure 123 Event Viewer Page

The following table describes the Event Viewer parameters:

Parameter Description

Source Displays the source of the event. For example, Policy Manager UI or ClearPassFirmware
Update Checker.

Level Displays the level of the event from the following options:
n INFO
n WARN
n ERROR

Category Displays the category of the event. For example, Logged in, System, or AV/AS Updates.

Action Displays the status of the event action. For example, Success, Failed, Unknown, and None.

Timestamp Displays the date and time when the event occurred.

Table 1: Event Viewer Page Parameters

Creating an Event Viewer Report Using Default Values
1. In the Filter field, select Source as the filter parameter.

2. Click Go. ClearPass returns all event records.

Creating an Event Viewer Report Using Custom Values
To create an Event Viewer report using custom values:

1. Click the icon. A new filter is added. You can add up to four filters.

Figure 124 Adding an Event Viewer Filter
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2. In the Filter field, select the element on which you wish to filter:

n Source

n Level

n Category

n Action

n Description

3. Specify equals or contains.

4. In the text field, enter the type of event for which you are searching.

5. (Optional) Create up to three additional filters if needed.

6. (Optional) Change the Show records value as desired.

7. Click Go. The following figure displays the Event Viewer report with custom values:

Figure 125 Event Viewer Report with Customized Filter

Viewing Report Details
To display the System Event Details page, click a row in the Event Viewer page.

Figure 126 System Event Details Page

Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1185



The following table describes the System Event Details parameters:

Parameter Description

Source Displays the source of the event. For example, Admin UI, RADIUS, and SnmpService.

Level Displays the level of the event from the following options:
n INFO
n WARN
n ERROR

Category Displays the category of the event. For example, Import, Export, Request, Authentication,
and System.

Action Displays the action of the events. For example, Success, Failed, Unknown, and None.

Timestamp Displays the date and time when the event occurred.

Description Displays additional information about the event, including User, Role, Entity, Client
IP Address, summary of the event, and when pertinent, the session inactive expiry time.

Table 2: System Event Details Page Parameters

Data Filters
This section provides the following information:

n About Data Filters

n Adding a Data Filter

About Data Filters
The Data Filters page provides a way to limit the number of rows of data shown by defining custom criteria or
rules in the following components in Policy Manager:

n Live Monitoring: Access Tracker on page 102

n Syslog Export Filters on page 602

n Live Monitoring: Analysis and Trending on page 137

n Live Monitoring: Accounting on page 117

Preconfigured Data Filters
Policy Manager is preconfigured with the following data filters:

Data Filter Description

RADIUS Requests Shows all RADIUS requests.

TACACS Requests Shows all TACACS requests.

WebAuth Requests Shows all Web Authentication requests (requests originated from the Guest Portal).

Table 1: Access Tracker Edit Page Parameters
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Data Filter Description

Event Requests Displays all event-based records.

Failed Requests Shows all authentication requests that were rejected or faile

Successful Requests Shows all authentication requests that were successful.

Unhealthy Requests Shows all requests that were not deemed healthy by Policy Manager.

Healthy Requests Shows all requests that were deemed healthy by Policy Manager.

Guest Access Requests Shows all requests—RADIUS or Web Authentication—where the user was assigned
the built-in role Guest.

ClearPass Application
Requests

Shows all Application session log requests.

All Requests Shows all requests (without any rows filtered).

Accessing the Data Filters Page
To access the Data Filters page:

1. Navigate to Monitoring > Data Filters.

The Data Filters page opens.

Figure 127 Data Filters Page

Adding a Data Filter
To add a data filter:

1. Click the Add link in the top-right corner of the page.

The Add Data Filters page opens to the Filter tab.

Figure 128 shows the Filter dialog when you choose Select Attributes.
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Figure 128 Add Data Filter > Filter Tab > Select Attributes

Figure 129 shows the Filter dialog when you choose Specify Custom SQL.

Figure 129 Add Data Filter > Filter Tab > Specify Custom SQL

2. Specify the Add Data Filters parameters as described in the following table.

Parameter Action/Description

Name Enter a name for the data filter.

Description Optionally,enter a description of this data filter (recommended).

Configuration Type Choose one of the following configuration types:
n Select Attributes
n Specify Custom SQL

Table 2: Add Data Filters Page > Filter Tab Parameters

ClearPass 6.7 Policy Manager | User Guide Live Monitoring | 156
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1188



157 | Live Monitoring ClearPass 6.7 Policy Manager |  User Guide

Parameter Action/Description

Select Attributes This option is selected by default. When you specify Select Attributes, the
Rules tab appears.
Use the Rules tab to configure rules for this filter.

Specify Custom SQL When you choose Specify Custom SQL, a default SQL template is
displayed.
In the text entry field, enter the attributes for the type, attribute name, and
attribute value.
NOTE: Aruba does not recommend that you enable this option without first
consulting Support (navigate to Administration > Support > Contact
Support).

Rules Tab
The Rules tab displays when you choose the Select Attributes configuration type on the Filter dialog.

Figure 130 Add Data Filter > Rules Dialog

Table 3 describes the Add Filter > Rules tab parameters:

Parameter Action/Description

Rule Evaluation
Algorithm

Select ANY match is a logical OR operation of all the rules. Select ALL matches is a logical
AND operation of all the rules.

Add Rule Add a rule to the filter.

Edit Rule Edit an existing rule.

Remove Rule When you select an existing rule and click Remove Rule, the selected Rule is deleted
immediately (no confirmation prompt appears).

Table 3: Add Filter > Rules Tab

When you click Add Rule or Edit Rule, the Dashboard Filter Rules Editor dialog opens.

Figure 131 Dashboard Filters > Rules Editor
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Table 4 describes the Dashboard Filters > Rules Editor parameters:

Parameter Action/Description

Matches Specify the match conditions:
n ANY matches one of the configured conditions.
n ALL specifies to match all of the configured conditions.

Type Select the type of data filter.
n Common: Attributes common to RADIUS, TACACS, and WebAuth requests and responses.
n RADIUS: Attributes associated with RADIUS authentication, accounting requests, and responses.
n TACACS: Attributes associated with TACACS authentication, accounting, policy requests, and

responses.
n Web Authentication Policy: Policy Manager policy objects assigned after the evaluation of

policies associated with Web Authentication requests. For example, Auth Method, Auth Source,
and Enforcement Profiles.

Name Select the name of the attribute from the Name drop-down list.
The Name list varies according to which Type you selected.

Operator Select any subset of string data type operators from the following list:
n EQUALS
n NOT_EQUALS
n LESS_THAN
n LESS_THAN_OR_EQUALS
n GREATER_THAN
n GREATER_THAN_OR_EQUALS
n CONTAINS
n NOT_CONTAINS
n EXISTS
n NOT_EXISTS

Value The value of the attribute.

Table 4: Dashboard Filters > Rules Editor Configuration Parameters

Restoring Blacklisted Users to the Network
The Blacklisted Users page lists the MAC address and user name of all blacklisted users, the authentication
source for that user, and indicates whether the bandwidth limit or session duration limits were exceeded by
each blacklisted user.After a user entry is removed from the blacklisted users list, the user is eligible to access
the network.

To access the Blacklisted Users page:

1. Navigate to Monitoring > Blacklisted Users.

2. To delete a user from this blacklist, select the user row and click Delete. The deleted Blacklisted user is now
eligible to access the network.
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Figure 132 Blacklisted Users Page
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Chapter 4
Authentication Methods and

Sources

This section provides the following information:

n Supported Authentication Methods on page 160

n Default Authentication Sources on page 161

n Adding and Modifying Authentication Methods on page 163

n Adding and Configuring Authentication Sources on page 186

n Modifying Authentication Methods or Sources for an Existing Service on page 222

Supported Authentication Methods
As a first step in the service-based processing, Policy Manager uses an authentication method to authenticate
the user or device against an authentication source.

After the user or device is authenticated, Policy Manager fetches attributes for role-mapping policies from the
authorization sources associated with this authentication source. For a general overview of Policy Manager
authentication and authorization, see Authentication and Authorization Architecture and Flow.

ClearPass Policy Manager supports the following authentication methods:

Tunneled EAP Authentication Methods
The tunneled EAP authentication methods are:

n EAP Protected EAP (EAP-PEAP)

n EAP Flexible Authentication Secure Tunnel (EAP-FAST)

n EAP Transport Layer Security (EAP-TLS)

n EAP Tunneled TLS (EAP-TTLS)

Non-Tunneled Authentication Methods
The non-tunneled authentication methods are:

n EAP Message Digest 5 (EAP-MD5)

n EAP Microsoft Challenge Handshake Authentication Protocol version 2 (EAP- MSCHAPv2)

n EAP Generic Token Card (EAP-GTC)

n Challenge Handshake Authentication Protocol (CHAP)

n Password Authentication Protocol (PAP)

n Microsoft CHAP version 1 and 2

n MAC authentication method (MAC-AUTH)

n Authorize authentication
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Default Authentication Sources
The following table describes the predefined ClearPass authentication sources that are part of the ClearPass
local SQL database. These local authentication sources appear in brackets in the cannot be copied or deleted.

Authentication
Source Name Description

[Admin User
Repository]

Users are authenticated against this Policy Manager admin user database.

[Blacklist User
Repository]

Blacklist database with users who have exceeded bandwidth or session related limits.

[Endpoints Repository] Authenticate endpoints against the local Policy Manager database. This database
supports the following filter categories:
n Authentication
n Status
n Profile
n Fingerprint
n MAC caching

[Guest Device
Repository]

Authenticate guest devices against the local Policy Manager database. This database
supports the following filter categories:
n Authentication
n Device Role ID

[Guest User Repository] Authenticate guest users against the local Policy Manager database. This database
supports the following filter categories:
n Authentication
n Authorization

[Insight Repository] Insight database with session information for users and devices. This database supports
the following filter categories:
n WebAuth check
n MAC caching
n Successful login count since midnight
n Active sessions
n Online status
n Daily duration
n Weekly duration
n Monthly duration

[Local User Repository] Authenticate users against the Policy Manager local user database.

[Onboard Devices
Repository]

Authenticate Onboard devices against the local Policy Manager database.

[Social Login
Repository]

Authenticate users against Policy Manager social login database.
n Authentication
n Social alias

[Time Source] Authorization source for implementing various time functions

Table 1: Local Authentication Sources

Authentication and Authorization Architecture and Flow
This section includes the following information:

n Authentication Method
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n Authentication Source

n Authorization Source

n Authentication and Authorization Flow of Control

Policy Manager divides the architecture of authentication and authorization into the following three
components:

n Authentication method

n Authentication source

n Authorization source

Authentication Method

Policy Manager initiates the authentication handshake by sending available methods in a priority order until
the client accepts a method or until the client rejects the last method with the following possible outcomes:

n Successful negotiation returns a method, which is used to authenticate the client against the authentication
source.

n Where no method is specified (for example, for unmanageable devices), Policy Manager passes the request
to the next configured policy component for this service.

n Policy Manager rejects the connection.

An authentication method is configurable only for some service types. For more information, see Configuring Other
Policy Manager Services on page 61. All 802.1X wired and wireless services have an associated authentication
method.

Authentication Source

In Policy Manager, an authentication source is the identity store (Active Directory, LDAP directory, SQL DB,
token server, etc.) against which users and devices are authenticated.

Policy Manager first tests whether the connecting entity (the device or user) is present in the ordered list of
configured authentication sources.

Policy Manager looks for the device or user by executing the first filter associated with the authentication
source. After the device or user is found, Policy Managerthen authenticates this entity against this
authentication source. The flow is as follows:

n On successful authentication, Policy Manager moves on to the next stage of policy evaluation, which
collects role mapping attributes from the authorization sources.

n Where no authentication source is specified (for example, for unmanageable devices), Policy Manager
passes the request to the next configured policy component for this service.

n If Policy Manager does not find the connecting entity in any of the configured authentication sources, it
rejects the request.

Authorization Source

After Policy Manager successfully authenticates the user or device against an authentication source, it retrieves
role-mapping attributes from each of the authorization sources configured for that authentication source.

It also, optionally, can retrieve attributes from authorization sources configured for the service.
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Authentication and Authorization Flow of Control
The flow of control for authentication takes the following components in sequence:

Figure 133 Authentication and Authorization Flow of Control

Adding and Modifying Authentication Methods
This section provides the following information:

n Adding a New Authentication Method

n Modifying an Existing Authentication Method

Adding a New Authentication Method
To add a new authentication method:

1. Navigate to Configuration > Authentication > Methods.

The Authentication Methods page opens.
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Figure 134 Authentication Methods Page

2. Click Add.

The Add Authentication Method page opens.

Figure 135 Add Authentication Method Page

3. Enter the name and description of the new authentication method.

4. From the Type drop-down, select the authentication type of authentication type.

5. Configure the Authentication Method of interest as described in the following sections:

l Authorize Authentication Method on page 165

l CHAP Authentication Method on page 166

l EAP-FAST Authentication Method on page 167
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l EAP-GTC Authentication Method on page 172

l EAP-MSCHAPv2 on page 173

l EAP-PEAP on page 174

l EAP-PEAP-Public on page 176

l EAP-PWD on page 179

l EAP-TLS on page 180

l EAP-TTLS on page 181

l MAC-AUTH Authentication Method on page 183

l MSCHAP on page 184

l PAP on page 185

Modifying an Existing Authentication Method
To modify an existing authentication method:

1. Navigate to Configuration > Authentication > Methods. The Authentication Methods page opens.

2. Click the authentication method of interest. The Edit Authentication Method page opens.

3. Modify the selected authentication method as necessary, then click Save.

Figure 136 Edit Authentication Method Page for EAP-FAST

Authorize Authentication Method
This is an authorization-only method that you can add with a custom name.

To add the Authorize authentication method:

1. Navigate to Configuration > Authentication > Methods. The Authentication Methods page opens.

2. Click Add. The Add Authentication Method configuration dialog opens:
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Figure 137 Add Authorize Authentication Method Configuration Dialog

3. Specify the Authorize Authentication Method parameters as described in the following table:

Table 2: Authorize Authentication Method Parameters

Parameter Action/Description

Name Specify the label of the authentication method.

Description Provide additional information that helps to identify the authentication method.

Type Select authentication method type Authorize.

4. Click Save.

CHAP Authentication Method
Policy Manager includes the Challenge-Handshake Authentication Protocol (CHAP) authentication
method. You can create one or more instances of the CHAP authentication method by assigning a customized
name to each one. This method can also be associated to a service as an authentication method.

To add the CHAP authentication method:

1. Navigate to Configuration > Authentication > Methods. The Authentication Methods page opens.

2. Click Add. The Add Authentication Method configuration dialog opens:

Figure 138 Adding CHAP Authentication Method

3. Specify the CHAP authentication method parameters as described in the following table:
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Parameter Description

Name Specify the name of the CHAP authentication method.

Description Provide the additional information that helps to identify the authentication method.

Type Select CHAP.

Table 1: CHAP Authentication Method Parameters

4. Click Save.

EAP-FAST Authentication Method
EAP-FAST (Flexible Authentication through Secure Tunneling) is an authentication method that encrypts EAP
transactions within a TLS (Transport Layer Security) tunnel. Use the General, Inner Methods, PACs and PAC
Provisioning tabs to configure EAP-Fast authentication.

General Tab

To add the EAP-FAST authentication method to ClearPass:

1. Navigate to Configuration > Authentication > Methods. The Authentication Methods page opens.

2. Select the Add link. The Add Authentication Method dialog opens to the General tab.

Figure 139 Adding the EAP-FAST Authentication Method

3. Configure the EAP-FAST authentication service as described in Table 1 then click Save.
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Parameter Action/Description

Name Specify the name of the authentication method.

Description Provide the additional information that helps to identify the authentication method.

Type Select EAP-FAST.

Session
Resumption

Caches EAP-FAST sessions on Policy Manager for reuse if the user/end-host reconnects to
the ClearPass server within the session-timeout interval. By default, this option is enabled.

Session Timeout Caches EAP-FAST sessions on Policy Manager for reuse if the user/end-host reconnects to
Policy Manager within the session-timeout interval.
Specify the Session Timeout in the number of hours.
n The default is 6 hours.
n If the Session Timeout value is set to 0, the cached sessions are not purged.

End-Host
Authentication

Specify one of the following end-host authentication methods:
n Using PACS (Protected Access Credentials)
n Using Client Certificate
NOTE: The PACs and PAC Provisioning tabs are available only when you select Using PACs.

Certificate
Comparison

Specify one of the following Certificate Comparison actions:
n Do not compare
n Compare Distinguished Name (DN)
n Compare Common Name (CN)
n Compare Subject Altername Subject Name (SAN)
n Compare CN or SAN
n Compare Binary

Table 1: Specifying the EAP-FAST > General Parameters

Parameter Action/Description

Name Specify the name of the authentication method.

Description Provide the additional information that helps to identify the authentication method.

Type Select EAP-FAST.

Session
Resumption

Caches EAP-FAST sessions on Policy Manager for reuse if the user/end-host reconnects to
the ClearPass server within the session-timeout interval. By default, this option is enabled.

Table 2: Specifying the EAP-FAST > General Parameters
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Parameter Action/Description

Session Timeout Caches EAP-FAST sessions on Policy Manager for reuse if the user/end-host reconnects to
Policy Manager within the session-timeout interval.
Specify the Session Timeout in the number of hours.
n The default is 6 hours.
n If the Session Timeout value is set to 0, the cached sessions are not purged.

End-Host
Authentication

Specify one of the following end-host authentication methods:
n Using PACS (Protected Access Credentials)
n Using Client Certificate
NOTE: The PACs and PAC Provisioning tabs are available only when you select Using PACs.

Certificate
Comparison

Specify one of the following Certificate Comparison actions:
n Do not compare
n Compare Distinguished Name (DN)
n Compare Common Name (CN)
n Compare Subject Altername Subject Name (SAN)
n Compare CN or SAN
n Compare Binary

Inner Methods Tab

The following figure displays the EAP-FAST > Inner Methods dialog:

Figure 140 EAP-FAST Authentication Method > Inner Methods Dialog

\\\

In FIPS mode, the EAP-MD5 authentication method is not supported.
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Parameter Action/Description

Specify inner authentication
methods in the preferred
order

Select a method from the drop-down list:
n Aruba EAP GTC
n EAP GTC
n EAP MD5
n EAP MSCHAPV2 (Default)
n EAP PWD
n EAP TLS with OSCP Enabled
n EAP TLS
Functions available in this tab include:
n To append an inner method to the displayed list, select from the Select a

method drop-down list. The list can contain multiple inner methods, which
Policy Manager sends in priority order until negotiation succeeds.

n To remove an inner method from the displayed list, select the method and click
Remove.

n To set an inner method as the default inner method (the method tried first),
select a method and click Default.

Table 3: EAP-FAST > Inner Methods Tab Parameters

PACs (Protected Access Credential) Tab

The PACs dialog enables or disables Protected Access Credential (PAC) types. The following figure displays the
EAP-FAST > PACs dialog:

Figure 141 EAP_FAST PACs Dialog

1. Specify the Expiration Time (number of hours, days, weeks, months, or years) for each of the
Protected Access Credentials:

a. Tunnel PAC Expire Time

b. Machine PAC Expire Time

c. Authorization PAC Expire Time

d. Posture PAC Expire Time

2. Select the PAC Provisioning tab.

PAC Provisioning Tab

The PAC Provisioning dialog controls anonymous and authenticated modes. The following figure displays the
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EAP-FAST PAC > Provisioning dialog:

Figure 142 EAP_FAST PAC Provisioning Dialog

1. Configure the PAC Provisioning parameters as described in Table 4.

2. When finished, click Save.

Parameter Action/Description Considerations

In-Band PAC Provisioning

Allow anonymous
mode

When in anonymous mode, phase 0 of
EAP_FAST provisioning establishes an
outer tunnel without end-host/Policy
Manager authentication.
NOTE: This mode is not as secure as
the authenticated mode.
After an outer tunnel is established, the
end-host and Policy Manager perform
mutual authentication using MSCHAPv2,
then Policy Manager provisions the end-
host with an appropriate PAC (tunnel or
machine).

Authenticated mode is more secure than
anonymous provisioning mode. After the
server is authenticated, the phase 0 tunnel is
established. The end-host and Policy
Manager perform mutual authentication and
provision on the end-host with an
appropriate PAC (tunnel or machine):
n If both anonymous and authenticated

provisioning modes are enabled and the
end-host sends a cipher suite that
supports server authentication, Policy
Manager picks the authenticated
provisioning mode.

n If the appropriate cipher suite is
supported by the end-host, Policy
Manager performs anonymous
provisioning.

Allow authenticated
mode

Enable to allow authenticated mode
provisioning.
When Allow authenticated mode is in
phase 0, Policy Manager establishes the
outer tunnel inside a server-
authenticated tunnel. The end-host
authenticates the server by validating
the Policy Manager certificate.

Table 4: EAP_FAST PAC Provisioning Parameters
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Parameter Action/Description Considerations

Accept end-host after
authenticated
provisioning

After the authenticated provisioning
mode is complete and the end-host is
provisioned with a PAC, Policy Manager
rejects the end-host authentication.
The end-host subsequently re-
authenticates using the newly
provisioned PAC.
When this field is enabled, Policy
Manager accepts the end-host
authentication in the provisioning mode
itself. The end-host does not have to re-
authenticate.

None.

Required end-host
certificate for
provisioning

In authenticated provisioning mode, the
end-host authenticates the server by
validating the server certificate, which
results in a protected outer tunnel.
The end-host is authenticated by the
server inside this tunnel. When this field
is enabled, the server can require the
end-host to send a certificate inside the
tunnel for the purpose of authenticating
the end-host.

None.

EAP-GTC Authentication Method
EAP-GTC (Generic Token Card) enables the exchange of clear-text authentication credentials across the
network. EAP-GTC carries a text challenge from the authentication server and a reply generated by a security
token.

To modify the EAP-GTC authentication method:

1. Navigate to Configuration > Authentication > Methods. The Authentication Methods page opens.

2. From the list of Authentication Methods, select EAP GTC. The Edit Authentication Method dialog for
EAP-GTC opens.

Figure 143 Edit EAP-GTC Authentication Method
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3. Specify the EAP-GTC General parameters as described in the following table, then click Save.

Parameter Action/Description

Name If necessary, specify the name of the authentication method.

Description Optionally, provide the additional information that helps to identify the authentication method.

Type EAP-GTC is preselected.

Method Details

Challenge Optionally, specify a password.

Table 1: EAP-GTC Authentication Method Parameters

EAP-MSCHAPv2
MS-CHAPv2 is an authentication protocol that Microsoft introduced with NT4.0 SP4 and Windows 98. The
inner authentication protocol is Microsoft's CHAP (Challenge Handshake Authentication Protocol), meaning it
allows authentication to databases that support the MS-CHAPv2 format, including Microsoft NT and Microsoft
Active Directory.

To add the EAP-MSCHAPv2 authentication method to ClearPass:

1. Navigate to Configuration > Authentication > Methods. The Authentication Methods page opens.

2. Select the Add link. The Add Authentication Method dialog opens:

Figure 144 Adding the EAP-MSCHAPv2 Authentication Method

3. Specify the EAP-MSCHAPv2 parameters as described in the table below, then click Save.

Parameter Description

Name Specify the name of the authentication method.

Description Optionally, provide the additional information that helps to identify the authentication method.

Type Select EAP-MSCHAPv2.

Table 1: EAP-MSCHAPv2 Parameters
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EAP-PEAP
EAP-Protected Extensible Authentication Protocol (EAP-PEAP) is a protocol that creates an encrypted (and more
secure) channel before the password-based authentication occurs.

PEAP is an 802.1X authentication method that uses server-side public key certificate to establish a secure
tunnel in which the client authenticates with server. The PEAP authentication creates an encrypted SSL/TLS
tunnel between client and authentication server. The exchange of information is encrypted and stored in the
tunnel ensuring that the user credentials are kept secure.

Use the General and Inner Methods tabs to configure EAP-Peap authentication.

General Tab

To add the EAP-PEAP authentication method to ClearPass:

1. Navigate to Configuration > Authentication > Methods. The Authentication Methods page opens.

2. Select the Add link. The Add Authentication Method dialog opens:

Figure 145 EAP-PEAP - General Tab

3. Specify the EAP-PEAP > General parameters as described in the following table, then click Save.

Parameter Action/Description

Name Specify the name of the authentication method.

Description Optionally, provide the additional information that helps to identify the authentication
method.

Type Select EAP-PEAP.

Method Details

Table 1: EAP-PEAP > General Parameters
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Parameter Action/Description

Session Resumption Check the Session Resumption check box if you intend to enable Fast Reconnect.

Session Timeout Caches EAP-PEAP sessions on the ClearPass server for reuse if the user/client
reconnects to the ClearPass server within the session timeout interval. If session timeout
value is set to 0, the cached sessions are not purged.

Fast Reconnect Enable this check box to allow fast reconnect.
When Fast Reconnect is enabled, the inner method that takes place inside the server
authenticated outer tunnel is also bypassed. This makes the process of reauthentication
faster. For Fast Reconnect to work, session resumption must be enabled.

Microsoft NAP
Support

Check this check box to enable Network Access Protection (NAP) on this ClearPass
server.

Cryptobinding Cryptobinding protects tunnel methods against man-in-the-middle attacks. Cryptographic
binding focuses on protecting the server rather than the peer.
Specify one of the following cryptobinding options:
n None (the default)
n Optional
n Required

Inner Methods Tab

The tunneled method is frequently referred to as the "inner method." The Inner Methods tab controls the
inner methods for the EAP-PEAP authentication method.

Figure 146 EAP-PEAP > Inner Methods Tab

In FIPS mode, the EAP-MD5 authentication method is not supported.
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Specify the EAP-PEAP Inner Methods parameters as described in the following table:

Parameter Description

Specify inner authentication
methods in the preferred
order

To append an inner method to the displayed list, select it from the Select a
method drop-down list. The list can contain multiple inner methods, which
ClearPass sends in priority order until negotiation succeeds.
Select any method available in the current context from the drop-down list. Inner
methods available include:
n Aruba EAP-GTC
n EAP-GTC
n EAP-MD5
n EAP-MSCHAPv2
n EAP-PWD
n EAP-TLS with OSCP enabled
n EAP-TLS

Default To set an inner method as the default (the method tried first), select it and click
Default.

Remove To remove an inner method from the displayed list, select the method and click
Remove.

Table 2: EAP-PEAP Inner Methods Tab Parameters

EAP-PEAP-Public
The EAP-PEAP-Public method is used for authenticating and providing a secured wireless guest access to the
endpoints. To provide a secured wireless guest access, the Wi-Fi Protected Access (WPA) is provided for publicly
known username and password. This ensures that every device gets a unique wireless session key that is used
to encrypt the traffic and provide secured wireless access without intruding the privacy of others though the
same username and password is shared to all devices.

Use the General and Inner Methods tabs to configure EAP-Peap authentication.

General
The General tab labels the authentication method and defines session details. To add the EAP-PEAP
authentication method to ClearPass:

1. Navigate to Configuration > Authentication > Methods. The Authentication Methods page opens.

2. Select the Add link. The Add Authentication Method dialog opens to the General tab.

3. In the Type field, select EAP-PEAP.
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The following figure is an example of the EAP-PEAP-Public - General tab:

Figure 147 EAP-PEAP-Public - General Tab

The following table describes the EAP-PEAP-Public - General parameters:

Parameter Description

Name Specify the name of the authentication method.

Description Provide the additional information that helps to identify the authentication method.

Type Specify the type of authentication. In this context, select EAP-PEAP-Public.

Session
Resumption

Caches EAP-PEAP-Public sessions on Policy Manager for reuse if the user/client reconnects to
Policy Manager within the session timeout interval. By default, this option is enabled.

Session
Timeout

Caches EAP-PEAP-Public sessions on Policy Manager for reuse if the user/client reconnects to
Policy Manager within the session timeout interval in hours. If session timeout value is set to 0, the
cached sessions are not purged. The default session timeout is 6 hours.

Table 1: EAP-PEAP-Public - General Tab Parameters
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Parameter Description

Fast
Reconnect

Enable this check box to allow fast reconnect. When fast reconnect is enabled, the inner method
that happens inside the server authenticated outer tunnel is also bypassed. This makes the process
of re-authentication faster. For the fast reconnect to work, session resumption must be enabled.

Public
Username

Enter the Guest username. In this context, enter 'public'.

Public
Password

Enter the Guest password. In this context, enter 'public'.

Inner Methods
The Inner Methods tab controls the inner methods for the EAP-PEAP-Public authentication method. The
following figure is an example of the EAP-PEAP-Public - Inner Methods tab:

Figure 148 EAP-PEAP-Public - Inner Methods Tab

The EAP-MD5 authentication method is not supported if you use ClearPass Policy Manager in the FIPS
(Administration > Server Manager > Server Configuration > FIPS tab) mode.
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Parameter Description

Specify inner authentication
methods in the preferred
order

Select the inner authentication method available from the drop-down list. In this
context, only the EAP-MSCHAPv2 method is available. The following functions are
available in this tab:
n To append an inner method to the displayed list, select it from the drop-down

list. The list can contain multiple inner methods, which Policy Manager sends in
priority order until negotiation succeeds.

n To remove an inner method from the displayed list, select the method and click
Remove.

n To set an inner method as the default (the method tried first), select it and click
Default.

Table 2: EAP-PEAP-Public Inner Methods Tab Parameters

EAP-PWD
EAP-PWD (Password) is an EAP authentication method that uses a shared password for authentication. EAP-
PWD addresses the problem of password-based authenticated key exchange using a possibly weak password
for authentication to derive an authenticated and cryptographically strong shared secret.

To add the EAP-PWD authentication method:

1. Navigate to Configuration > Authentication > Methods. The Authentication Methods page opens.

2. Select the Add link. The Add Authentication Method dialog opens:

Figure 149 EAP-PWD Authentication Method Configuration Dialog

3. Specify the EAP-PWD parameters as described in the following table, then click Save.
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Parameter Description

Name Enter the name of the authentication method.

Description Provide the additional information that helps to identify the authentication method.

Type Select EAP-PWD.

Method Details

Group Select the group from the drop-down list.
Each party to the exchange derives ephemeral keys with respect to a particular set of domain
parameters that is a group.
A group can be based on Finite Field Cryptography (FFC) or Elliptic Curve Cryptography (ECC).

Server ID Specify the string that identifies the ClearPass server to the peer.

Table 1: EAP-PWD Parameters

EAP-TLS
EAP-Transport Layer Security (EAP-TLS) requires an exchange of proof of identities through public key
cryptography (such as digital certificates). EAP-TLS secures this exchange with an encrypted TLS tunnel, which
helps to resist dictionary or other attacks.

To add the EAP-TLS authentication method:

1. Navigate to Configuration > Authentication > Methods. The Authentication Methods page opens.

2. Click Add. The Add Authentication Method dialog opens.

Figure 150 EAP-TLS Authentication Method Dialog
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3. Specify the Add Authentication Method parameters as described in the following table, then click Save.

Parameter Action/Description

Name Specify the name of the authentication method.

Description Provide the additional information that helps to identify the authentication method
(recommended).

Method Details

Type Select EAP_TLS.

Session Resumption Enable this option to cache EAP-TLS sessions on the ClearPass server for reuse if the
user or client reconnects to the ClearPass server within the session timeout interval.
This option is enabled by default.

Session Timeout Specify the duration in hours for the cached EAP-TLS sessions to be retained. The
default is 6 hours.

Authorization Required This parameter is enabled by default. Specify whether to perform an authorization
check.

Certificate Comparison Specify the type of certificate comparison (identity matching) upon presenting Policy
Manager with a client certificate:
n To skip the certificate comparison, choose Do not compare.
n To compare specific attributes, choose Compare Common Name (CN),

Compare Subject Alternate Name (SAN), or Compare CN or SAN.
n To perform a binary comparison of the stored (in the client record in Active

Directory or another LDAP-compliant directory) and presented certificates,
choose Compare Binary.

Verify Certificate using
OCSP

n If the certificate is to be verified by the Online Certificate Status Protocol (OCSP),
select Optional or Required.

n To not verify the certificate, select None.
n If an OCSP server is not accessible to perform certificate validation, you can skip

the OCSP check and proceed with the CRL validation result by selecting Required
(CRL fallback).

Override OCSP URL from
the Client

Select this option to use a different URL for OCSP.
After this option is enabled, you can enter a new URL in the OCSP URL field.

OCSP URL If the Override OCSP URL from the Client field is enabled, enter the replacement
URL.

Table 1: EAP_TLS Authentication Method Parameters

EAP-TTLS
EAP-Tunneled Transport Layer Security (EAP-TTLS) is designed to provide authentication that is similar to EAP-
TLS, but each user does not require a certificate be issued. The certificates are issued only to authentication
servers.

Use the General and Inner Methods tabs to configure The EAP-TTLS authentication method

General Tab
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The General tab labels the method and defines session details.

1. Navigate to Configuration > Authentication > Methods. The Authentication Methods page opens.

2. Select the Add link. The Add Authentication Method dialog opens:

Figure 151 EAP-TTLS - General Tab

3. Specify the EAP-TTLS parameters as described in the table below, then click Save.

Parameter Description

Name Specify the name of the authentication method.

Description Provide the additional information that helps to identify the authentication method.

Type Select the type of authentication. In this context, select EAP-TTLS.
NOTE: The EAP-MD5 authentication type is not supported if you use ClearPass Policy Manager in
the FIPS (Administration > Server Manager > Server Configuration > FIPS tab) mode.

Method Details

Session
Resumption

Caches EAP-TTLS sessions on Policy Manager for reuse if the user/client reconnects to Policy
Manager within the session timeout interval.

Session
Timeout

Specify the duration in hours for the EAP-TTLS sessions to be cached.

Table 1: EAP-TTLS - General Tab Parameters

Inner Methods Tab
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The Inner Methods tab controls the inner methods for the EAP-TTLS method. The following figure is an
example of the EAP-TTLS - Inner Methods tab:

Figure 152 EAP_TTLS - Inner Methods Tab

The following table describes the EAP-TTLS - Inner Methods parameters:

Parameter Description

Specify inner authentication
methods in the preferred
order

Select any method available in the current context from the drop-down list.
n To append an inner method to the displayed list, select it from the drop-down

list. The list can contain multiple inner methods, which Policy Manager sends in
priority order until negotiation succeeds.

n To remove an inner method from the displayed list, select the method and click
Remove.

n To set an inner method as the default (the method that tried first), select it and
click Default.

NOTE: The EAP-MD5 authentication type is not supported if you use ClearPass
Policy Manager in the FIPS (Administration > Server Manager > Server
Configuration > FIPS tab) mode.

Table 2: EAP-TTLS - Inner Methods Tab Parameters

MAC-AUTH Authentication Method
The MAC_AUTH authentication type must be used exclusively in a MAC-based authentication service.

When the MAC_AUTH method is selected, Policy Manager makes internal checks to verify that the request is a
MAC_Authentication request and not a spoofed request. In tunneled EAP methods, authentication and
posture credential exchanges occur inside a protected outer tunnel.

The MAC-AUTH method contains the General dialog that labels the authentication method and defines
session details. To add the MAC-AUTH authentication method to ClearPass:

1. Navigate to Configuration > Authentication > Methods. The Authentication Methods page opens.

2. Select the Add link. The Add Authentication Method dialog opens to the General tab.

Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1215



3. In the Type field, select MAC-AUTH.

The following figure is an example of the MAC-AUTH > General dialog:

Figure 153 Adding MAC-AUTH Authentication Method

The following table describes the MAC-Auth parameters:

Parameter Action/Description

General

Name Specify the name of the authentication method.

Description Provide the additional information that helps to identify the authentication method (recommended).

Type Select the MAC-AUTH type of authentication.

Method Details

Allow
Unknown
End-Hosts

Select this check box to enable further policy processing of MAC authentication requests of
unknown clients.
If this is not enabled, Policy Manager automatically rejects a request whose MAC address is not in a
configured authentication source. This setting is enabled, for example, when you want Policy
Manager to trigger an audit for an unknown client. By selecting this check box and enabling audit
(see Configuring Audit Servers on page 347), you can trigger an audit of an unknown client.

Table 1: MAC-Auth Parameters

MSCHAP
The MS-CHAP authentication method authenticates remote Windows-based workstations, integrating the
functionality to which LAN-based users are accustomed with the hashing algorithms used on Windows
networks. MS-CHAP uses a challenge-response mechanism to authenticate connections without sending any
passwords. The MSCHAP method contains the General tab that labels the authentication method and defines
session details.

To add the MSCHAP authentication method to ClearPass:

1. Navigate to Configuration > Authentication > Methods. The Authentication Methods page opens.

2. Select the Add link. The Add Authentication Method dialog opens to the General tab.

3. In the Type field, select MSCHAP.
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The following figure is an example of the MSCHAP - General tab:

Figure 154 MSCHAP - General Tab

The following table describes the MSCHAP - General parameters:

Parameter Description

Name Specify the name of the authentication method.

Description Provide the additional information that helps to identify the authentication method.

Type Select the type of authentication. In this context, select MSCHAP.

Table 1: MSCHAP - General Tab Parameters

PAP
The Password Authentication Protocol (PAP) is an authentication protocol in which the user name and
password are sent to the remote access server in unencrypted form.

The Add Authentication Method dialog identifies the authentication method—in this example, PAP—and
defines the method details.

To add the PAP authentication method to ClearPass:

1. Navigate to Configuration > Authentication > Methods. The Authentication Methods page opens.

2. Select the Add link. The Add Authentication Method dialog opens to the General tab.

3. In the Type field, select PAP.
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displays the Add Authentication Method > PAP dialog.

Figure 155 Adding the PAP Authentication Method

Table 1 describes the PAP parameters:

Parameter Action/Description

Name Specify the name of the authentication method.

Description Provide the additional information that helps to identify the authentication method.

Type Select PAP as the Type of authentication.

Method Details

Enable Aruba-
SSO

Enable or disable Aruba-SSO (Single Sign-On) by specifying True or False. The default is
False.

Table 1: PAP Authentication Method Parameters

Adding and Configuring Authentication Sources

An authentication source is the identity store (Active Directory, LDAP directory, etc.) against which users and
devices are authenticated.

To configure an authentication source:

1. Navigate to Configuration > Authentication > Sources. The Authentication Sources page opens.
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Figure 156 Authentication Sources Page

2. Click the Add link. The Add Authentication Sources page opens. Different tabs and fields appear,
depending on the authentication source selected.

Figure 157 Add Authentication Source Page

Refer to the following sections to configure these authentication sources:

n Generic LDAP and Active Directory

n Generic SQL DB

n HTTP

n Kerberos

n Okta

n RADIUS/Radsec Server

n Adding a Static Host List as an Authentication Source

n Token Server

Generic LDAP and Active Directory
Policy Manager can perform NTLM/MSCHAPv2, PAP/GTC, and certificate-based authentications against
Microsoft Active Directory and against any LDAP-compliant directory (for example, Novell eDirectory,
OpenLDAP, or Sun Directory Server).
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The LDAP and Active Directory-based server configurations are similar. You can retrieve role-mapping
attributes by using filters. For configuration details, see Adding and Modifying Role-Mapping Policies on page
251.

Configure Generic LDAP and Active Directory authentication sources
Use the following tabs to configure new Generic LDAP and Active Directory authentication sources:

General Configuration

To add a new Generic LDAP or Active Directory authentication source:

1. Navigate to Configuration > Authentication > Sources. The Authentication Sources page opens.

2. Click Add. The Add Authentication Sources dialog opens. In this example, Type is set to Active
Directory.

Figure 158 Active Directory or Generic LDAP Configuration Dialog

3. Specify the Generic Active Directory or LDAP > General parameters as described in the following
table.

Parameter Action/Description

Name Enter the name of the authentication source.

Description Provide the additional information that helps to identify the authentication source (recommended).

Type Select Active Directory or Generic LDAP.

Table 1: Active Directory or Generic LDAP Authentication Source> General Parameters
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Parameter Action/Description

Use for
Authorization

Enable this check box to instruct Policy Manager to fetch role-mapping attributes (or authorization
attributes) from this authentication source. If a user or device successfully authenticates against
this authentication source, then Policy Manager also fetches role-mapping attributes from the
same source if the Use for Authorization field is enabled. This check box is checked (enabled) by
default.

Authorization
Sources

Specify additional sources from which role-mapping attributes are to be fetched.
1. Select a previously configured authentication source from the drop-down list.
2. To add the authentication source to the list of authorization sources, click Add.

n To remove the authentication source from the list, click Remove.
If Policy Manager authenticates the user or device from this authentication source, then also
fetches role-mapping attributes from these additional authorization sources.
NOTE: You can specify additional authorization sources at the service level. Policy Manager
fetches role-mapping attributes regardless of which authentication source the user or device was
authenticated against.

Server
Timeout

The Policy Manager server will automatically time out if the Active Directory or LDAP
authentication source fails to send a response to an authorization query after 10 seconds. To
specify a different duration for the timeout, enter the preferred timeout value in the Server
Timeout field.

1. Specify the duration in number of seconds that Policy Manager waits before considering this
server unreachable.

If multiple backup servers are available, this value indicates the duration in number of seconds
that Policy Manager waits before attempting to fail over from the primary to backup servers in the
order in which they were configured.

Cache
Timeout

Specify the duration in number of seconds for which the attributes are cached.
Policy Manager caches attributes fetched for an authenticating entity.

Backup
Servers
Priority

n To add a backup server, click Add Backup.
When the Backup 1 tab appears, you can specify connection details for a backup server.

n To remove a backup server, select the server name and click Remove.
n To change the server priority of the backup servers, select a server, then select Move Up or

Move Down.
This is the order in which Policy Manager attempts to connect to the backup servers if the
primary server is unreachable.

NOTE: ClearPass logs an alert message in the Event Viewer if the primary Active Directory/LDAP
server of an authentication source for RADIUS and TACACS+ authentication fails over to a
designated backup server.

2. Click Next to continue to the Primary tab.

Primary Server Configuration
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The Primary tab defines the settings for the primary server. The following figure is an example of the Generic
Active Directory > Primary tab:

Figure 159 Generic LDAP or Active Directory > Primary Tab

Specify the Active Directory or Generic LDAP > Primary parameters as described in the following table:

Parameter Action/Description

Hostname Specify the hostname or the IPv4/IPv6 address of the LDAP or Active Directory
server.

Connection Security n For a default nonsecure connection (usually port 389), select None.
n For a secure connection that is negotiated over the standard LDAP port, select

StartTLS. This is the preferred way to connect to an LDAP directory securely.
n To choose the legacy way of securely connecting to an LDAP directory, select

LDAP over SSL or AD over SSL. You must use port 636 for this type of
connection.

NOTE: In a production environment, security is a concern because whenClearPass
binds to an LDAP server, it submits the username and password for that account
over the network under clear text unless you protect it using Connection Security and
set the port to 636.
NOTE: To ensure successful authentication, be sure to add the CA certificate of the
LDAP server to the Certificate Trust List.

Port Specify the TCP port at which the LDAP or Active Directory server is listening for
connections.
The default TCP port for LDAP connections is 389 and the default port for LDAP over
SSL is 636.

Verify Server Certificate Select this check box to verify the server certificate as part of authentication.

Bind DN Specify the DN (Distinguised Name) of the administrator account. Policy Manager
uses this account to access all other records in the directory.
NOTE: For Active Directory, the bind DN can also be in the administrator@domain
format (for example, administrator@acme.com).

Table 2: Active Directory or Generic LDAP > Primary Parameters

ClearPass 6.7 Policy Manager | User Guide Authentication Methods and Sources | 190
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1222



191 | Authentication Methods and Sources ClearPass 6.7 Policy Manager |  User Guide

Parameter Action/Description

Bind Password Specify the password for the administrator DN entered in the Bind DN field.

NetBIOS Domain Name Specify the Active Directory domain name for this server. Policy Manager prepends
this name to the user ID to authenticate users found in this Active Directory.
NOTE: This setting is available only for Active Directory.

Base DN Enter the DN (Distinguished Name) of the node in your directory tree from which to
start searching for records.

1. After entering the values for the fields described above, click Search Base DN
to browse the directory hierarchy.
The LDAP browser opens.
2. Navigate to the DN that you want to use as the base DN.
3. To select a node as a base DN, click the preferred node in the tree structure
that is displayed.
Note that the base DN is displayed at the top of the LDAP browser.

NOTE: This is also a method to test the connectivity to your LDAP or AD directory. If
the values entered for the primary server attributes are correct, you can browse the
directory hierarchy by clicking Search Base DN.

Search Scope Select the scope of the search you want to perform, starting at the base DN.
n Base Object Search allows you to search at the level specified by the base DN.
n One Level Search allows you to search up to one level lesser to the immediate

children of the base DN.
n Subtree Search allows you to search the entire subtree under the base DN

(including at the base DN level).

LDAP Referrals Enable this check box to automatically follow referrals returned by your directory
server in search results. Refer to your directory documentation for more information
on referrals.

Bind User Enable this check box to authenticate users by performing a bind operation on the
directory using the credentials (user name and password) obtained during
authentication.
For clients to be authenticated by using the LDAP bind method, Policy Manager must
receive the password in clear text.

User Certificate Enter the name of the attribute in the user record from which the user certificate can
be retrieved.

Always use NetBIOS name Check this option to always use the NetBIOS name instead of the domain part in the
username for authentication.
NOTE: This field is available only if you select Active Directory as an authentication
source.

Table 2: Active Directory or Generic LDAP > Primary Parameters

4. Click Next to continue to the Attributes tab.

Attributes Configuration

The Attributes tab defines the Active Directory or LDAP Directory query filters and the attributes to be
fetched by using those filters. The following figures are the examples of the Active Directory > Attributes
tab and the Generic LDAP Directory > Attributes tabs:
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Figure 160 Active Directory Attributes Dialog

Figure 161 Generic LDAP Directory > Attributes Dialog

The Attributes tab displays the following information for the filters applied to the Generic LDAP Directory or
Active Directory authentication source

Parameter Action/Description

Filter Name Name of the filter.

Attribute Name Name of the LDAP or Active Directory attributes defined for this filter.

Alias Name Alias name for each attribute name selected for the filter.

Enable As Indicates whether this value to be used directly as a role or attribute in an enforcement policy.
This bypasses the step to assign a role in Policy Manager through a role-mapping policy.

Table 3: Active Directory or Generic LDAP Attributes tab Parameters

The following table describes the default filters for the Active Directory/Generic LDAP directories.

You can select any filters in the Attributes tab to modify the parameters of that filter. For details, see Modifying
Default Filters

ClearPass 6.7 Policy Manager | User Guide Authentication Methods and Sources | 192
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1224



193 | Authentication Methods and Sources ClearPass 6.7 Policy Manager |  User Guide

Directory Default Filters

Active
Directory

n Authentication: The query searches in the objectClass of the type user. This query finds both
user and machine accounts in Active Directory:
(&(objectClass=user)(sAMAccountName=%{Authentication:Username}))
After a request arrives, Policy Manager populates %{Authentication:Username} with the
authenticating user or machine. This filter is also configured to fetch the following attributes
based on this filter query:

l dn (alias of UserDN): This is an internal attribute that is populated with the user or
machine record’s DN.

l department
l title
l company
l memberOf: In Active Directory, this attribute is populated with the groups that the user

or machine belongs to. This attribute can have multiple values.
l telephoneNumber
l mail
l displayName
l accountExpires

n Group: This is a filter used for retrieving the name of the groups a user or machine belongs to.
(distinguishedName=%{memberOf})
This query fetches all group records, where the distinguished name is the value returned by
the memberOf attribute. The values for the memberOf attribute are fetched by the first filter
(authentication) described above. The attribute fetched with this filter query is cn, which is the
name of the group.

n Machine: This query fetches the machine record in Active Directory.
(&(objectClass=computer)(sAMAccountName=%{Host:Name}$))

%{Host:Name} is populated by Policy Manager with the name of the connecting host if
available. dNSHostName,operatingSystem, and operatingSystemServicePack attributes are
fetched with this filter query.

n Onboard Device Owner: This is the filter for retrieving the name of the owner the onboard
device belongs to. This query finds the user in the Active Directory
(&(sAMAccountName=%{Onboard:Owner})(objectClass=user))
%{Onboard:Owner} is populated by Policy Manager with the name of the onboarded user.

n Onboard Device Owner Group: This filter is used for retrieving the name of the group the
onboarded device owner belongs to.
(distinguishedName=%{Onboard memberOf})
This query fetches all group records where the DN is the value returned by the Onboard
memberOf attribute. The attribute fetched with this filter query is cn, which is the name of the
Onboard group.

Generic LDAP
Directory

n Authentication: This is the filter used for authentication:
(&(objectClass=*)(uid=%{Authentication:Username}))

When a request arrives, Policy Manager populates %{Authentication:Username} with the
authenticating user or machine. This filter is also set up to fetch the following attributes based
on this filter query:

dn (aliased to UserDN): This is an internal attribute that is populated with the user record’s
DN.

n Group: This is the filter used for retrieving the name of the groups to which a user belongs.
(&(objectClass=groupOfNames)(member=%{UserDn}))

This query fetches all group records (of objectClass groupOfNames), where the member field
contains the DN of the user record (UserDN, which is populated after the authentication filter
query is executed. The attribute fetched with this filter query is cn, which is the name of the
group (this is aliased to a more readable name: groupName)).

Table 4: Active Directory/Generic LDAP Default Filters
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Directory Default Filters

Add More
Filters

Click this button to open the Authentication Sources > Add page to open the Configure Filter
page. From this page, you can define a filter query and the related attributes to be fetched. For
more information, see Generic LDAP and Active Directory

Configuration Summary
Use the Summary tab to see a summarized view of the parameters configured in the General, Primary, and
Attributes tab.

Adding and Managing Generic LDAP and Active Directory Filters

Policy Manager is preconfigured with filters and selected attributes for Active Directory and generic LDAP
directory. Create new filters only if you need Policy Manager to fetch role-mapping attributes from a new type
of record.The Filter tab provides an LDAP browser interface to define the filter search query. You can fetch
different types of records by specifying multiple filters that use different dynamic session attributes. For
example, Policy Manager can fetch the user record associated with %{Authentication:Username} and a
machine record associated with %{RADIUS:IETF:Calling-Station-ID} for a given request.

To view or configure filters, navigate to the Configuration > Authentication > Sources > Add page, and
define an LDAP or Active Directory authentication source according to the procedures described in the
previous steps. The Attributes tab on the Configuration > Authentication > Sources > Add page includes
the Add More Filters button, which opens the Configure Filters dialog. The four tabs on the Configure Filter
page allow you to browse the nodes in the Active Directory or LDAP directory, and create and manage filters

Browse Tab Settings

By default, The Configure Filter page opens on the Browse tab, which allows you to browse the nodes in the
Active Directory or LDAP directory, starting at the base DN. This is presented in the read-only mode. Selecting a
leaf node (a node that has no children) displays the attributes associated with that node.

Figure 162 Configure Filter > Browse configuration dialog for Active Directory or Generic LDAP authentication
sources:
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Specify the Active Directory or Generic LDAP Configure Configure Filter > Browse tab parameter as
described in the following table:

Navigation Action/Description

Find Node To find the node, enter the DN, then click the Go button.

Table 5: Configure Filter > Browse Actions for Active Directory or Generic LDAP Authentication Sources

Filters Tab Settings
Use this tab to view existing filters, or create new ones

Viewing Existing Filters

The following figure is an example of the Configure Filter > Filter configuration dialog for Active Directory or
Generic LDAP authentication sources:

Figure 163 Configure Filter > Filter configuration dialog for Active Directory or Generic LDAP Authentication
Sources
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The following table describes the Configure Filter > Filter tab parameters:

Parameter Action/Description

Find Node To find a node, enter the DN, then click the Go button.

Select the attributes for
filter

This table has Name and Value columns. You can enter the attribute name in the
following ways:
n By selecting a node, inspecting the attributes, and then manually entering the

attribute name by clicking on Click to add... in the table row.
n By selecting an attribute on the right-hand side of the LDAP browser. The attribute

name and value are automatically populated in the table.
The attribute value can be a value that is automatically populated by selecting an
attribute from the browser, or it can be manually populated. To aid in populating the
value with dynamic session attribute values, a drop-down with the commonly used
namespace and attribute names is presented.

Table 6: Configure Filter > Filter parameters for Active Directory or Generic LDAP Authentication Sources

Creating Filters

The goal of filter creation is to help Policy Manager find a user or device connecting to the network in LDAP or
Active Directory.

To create a filter:

1. From the Filter tab, click on a node that you want to extract user or device information from.

For example, browse the Users container in Active Directory and select the node for a user (Alice, for
example). On the right-hand side, you can view the attributes associated with that user.

2. Select the attributes that help Policy Manager identify the user or device. For example, in Active Directory,
an attribute called sAMAccountName stores the user ID.

The attributes that you select are automatically populated in the Filter table displayed below the browser
section with their values.

In this example, if you select sAMAccountName, the row in the Filter table shows this attribute with a
value of Alice (assuming you picked Alice’s record as a sample user node).

After Step 2, you can have values for a specific record (in this example, Alice’s record).

3. Change the value to a dynamic session attribute that helps Policy Manager associate a session with a
specific record in LDAP/Active Directory. For example, if you selected the sAMAccountName attribute in
Active Directory, click the Value field and select %{Authentication:Username}.
When Policy Manager processes an authentication request, %{Authentication:Username} is populated
with the user ID of the user connecting to the network.

4. Add more attributes from the selected node and continue with Step 2.

Attributes Tab Settings
The Attributes tab defines the attributes to be fetched from the Active Directory or LDAP directory. You can
also enable each attribute as a role, which means the value fetched for this attribute can be used directly in
enforcement policies. For more information, see Configuring Enforcement Policies.
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The following figure displays the Active Directory or Generic LDAP Configure Filter > Attributes tab:

Figure 164 Configure Filter > Attributes Configuration Dialog for Active Directory or Generic LDAP
Authentication Sources

Specify the Active Directory/LDAP Configure Filter Page > Attributes tab parameters as described in the
following table:

Parameter Action/Description

Enter values
for
parameters

Policy Manager parses the filter query (created in the Filter tab and shown at the top of the
Attributes tab) and prompts to enter the values for all dynamic session parameters in the query.
For example, if you have %{Authentication:Username} in the filter query, you are prompted to
enter the value for it. You can enter wildcard character (*) here to match all entries.
NOTE: If there are thousands of entries in the directory, entering the wildcard character (*) can
take a while to fetch all matching entries.

Execute 1. After entering the values for all dynamic parameters, click Execute to execute the filter
query.
You can see all entries that match the filter query.
2. Click one of the entries (nodes) to view the list of attributes for that node.
3. Click the attribute names that you want to use as role-mapping attributes.

Name Specify the name of the attribute.

Alias Name Specify the alternative name for the attribute. By default, this is the same as the attribute name.

Enable As Click this check box to enable this attribute value to be used directly as a role in an enforcement
policy. This bypasses the step of assigning a role in Policy Manager through a role-mapping policy.

Table 7: Configure Filter > Attributes Settings for Active Directory or Generic LDAP Authentication Sources

Configuration Tab Settings
The Configuration tab shows the filter and attributes configured in the Filter and Attributes tabs
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respectively. From this tab, you can also manually edit the filter query and the attributes to be fetched.

Figure 165 Configure Filter > Configuration Dialog for Active Directory or Generic LDAP Authentication Sources

Modifying Default Filters
When you add a new authentication source of type Active Directory or LDAP, a few default filters and
attributes are populated. To modify these predefined filters:

1. Select a filter on the Authentication > Sources > Attributes dialog. The Configure Filter page for the
specified filter opens.

A minimum of one filter must be specified for the LDAP and Active Directory authentication source. This filter is used
by Policy Manager to search for the user or device record. If not specified, authentication requests are rejected.

Figure 166 Modifying Default filters for Active Directory or Generic LDAP authentication sources:
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The attributes that are defined for the authentication source display as attributes in role-mapping policy
Rules Editor under the authorization source namespace.

2. From the Configure Filter > Configuration dialog, select the attribute you wish to modify.

3. Change the attribute operator values as needed, then click Save.

The operator values that display are based on the Data Type specified here.

For example, if you modify the Active Directory department to be an integer rather than a string, then the
list of operator values populate with values that are specific to integers.

Generic SQL DB
Configure the primary and backup servers, session details, filter query, and role-mapping attributes to fetch the
Generic SQL authentication sources. ClearPass Policy Manager can perform MSCHAPv2 and PAP/GTC
authentication against any Open Database Connectivity (ODBC)-compliant SQL database such as Microsoft
SQL Server, Oracle, or PostgrSQL. You can specify a stored procedure to query the relevant tables and retrieve
role-mapping attributes by using filters.

The MySQL database is supported in ClearPass 6.7 and later. The plugin/connector used to connect to MySQL
database is MariaDB.

General Tab
1. Navigate to the Configuration > Authentication > Sources, then click Add. The General tab labels the

authentication source and defines session details, authorization sources, and backup server details.

Figure 167 Add Generic SQL DB > General Tab

2. Specify the Add General SQL DB > General parameters as described in the following table.
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Parameter Action/Description

Name Specify the name of the authentication source.

Description Provide the additional information that helps to identify the authentication source.

Type Select Generic SQL DB.

Use for
Authorization

Enable this option to request Policy Manager to fetch role-mapping attributes (or authorization
attributes) from this authentication source.
If a user or device successfully authenticates against this authentication source, then Policy
Manager also fetches role-mapping attributes from the same source if the Use for Authorization
field is enabled. This check box is enabled by default.

Authorization
Sources

Specify additional sources from which role-mapping attributes are to be fetched.
1. Select a previously configured authentication source from the drop-down list.
2. To add the authentication source to the list of authorization sources, click Add.

n To remove the authentication source from the list, click Remove.
If Policy Manager authenticates the user or device from this authentication source, then also
fetches role-mapping attributes from these additional authorization sources.
NOTE: You can specify additional authorization sources at the service level. Policy Manager
fetches role-mapping attributes regardless of which authentication source the user or device was
authenticated against.
NOTE:

Backup
Servers

To add a backup server, click Add Backup.
From the Backup 1 tab, you can specify connection details for a backup server (same fields as for
primary server that are specified below).
To remove a backup server, select the server name and click Remove.
Select Move Up or Move Down to change the server priority of the backup servers. This is the
order in which Policy Manager attempts to connect to the backup servers.

Cache
Timeout

Policy Manager caches attributes fetched for an authenticating entity. This parameter controls the
time period for which the attributes are cached.

Table 1: Add Generic SQL DB > General Parameters

Primary Tab

The Primary tab defines the settings for the primary server.

Figure 168 Add Generic SQL DB > Primary Tab
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Specify the Generic SQL DB > Primary parameters as described in the following table:
Table 3: Generic SQL DB > Primary Tab Parameters

Parameter Action/Description

Server
Name

Enter the Fully Qualified Domain Name (FQDN) or the IPv4/IPv6 address of the database server.

Port
(Optional)

Specify a port value to override the default port.

Database
Name

Enter the name of the database from which records can be retrieved.

Login
Username

Enter the name of the user used to log into the database. This account must have read access to all
the attributes that need to be retrieved by the specified filters.

Password Enter the password for the user account entered in the Login Username field.

Timeout Enter the duration in seconds that Policy Manager waits before attempting to fail over from primary
to backup servers (in the order in which they are configured).

ODBC
Driver

Select the ODBC (Open Database Connectivity) driver to connect to the database:
n PostgreSQL
n Oracle 11g
n MariaDB
n MSSQL
If you connect to a Microsoft SQL server using Integrated Authentication, the login username in the
authentication source, formatted as either domain/username or UPN (User Principal Name), the
following characters are supported:
n Backslash ( \ )
n At-sign (@)
n Hyphen
n Underscore

Password
Type

Specify how the user password is stored in the database:
n Cleartext : Stored as clear, unencrypted text.
n NT Hash: Stored with an NT hash using MD4.
n LM Hash : Stored with a LAN Manager Hash using DES.
n SHA: Stored with a Secure Hash Algorighm (SHA) hash.
n SHA256: Stored with an SHA-256 hash function.
n MD5

Attributes Tab

The Attributes tab defines the SQL DB query filters and the attributes to be fetched by using those filters.
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Figure 169 Generic SQL DB > Attributes Tab

Viewing Existing Filters

The following table describes the Generic SQL DB > Attributes (Filter List) parameters:
Table 4: Generic SQL DB > Attributes Tab (Filter List) Parameters

Parameter Action/Description

Filter Name Specifies the name of the filter.

Attribute
Name

Specifies the name of the SQL DB attributes defined for this filter.

Alias Name Specifies an alias name for each attribute name selected for the filter.

Enabled As Indicates whether the filter is enabled as a role or attribute type. This can also be blank.

Add More
Filters

Click this button to open the Configure Filter page.
Use this page to define a filter query and the related attributes to be fetched from the SQL DB
store. Figure 170 displays the Generic SQL DB > Configure Filter page.

Adding More Filters

To add more filter queries and their related attributes:

1. Click Add More Filters. The Configure Filter page opens:

Figure 170 Generic SQL DB > Configure Filter Page
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2. Select Click to add. A new row opens.

3. Specify the Name of the filter, Alias Name, Data Type, and optionally, Enabled As attributes.

4. Repeat to add additional filters, then click Save.

5. Specify the Add Generic SQL DB > Configure Filter parameters as described in the following table:

Table 5: Add Generic SQL DB > Configure Filter Page Parameters

Parameter Action/Description

Filter Name Enter the name of the filter.

Filter Query Specify an SQL query to fetch the attributes from the user or device record in DB.

Name Specify the name of the attribute.

Alias Name Specify the name for the attribute. By default, this is the same as the attribute name.

Data Type Specify the data type for this attribute such as String, Integer, or Boolean.

Enabled As Specify whether this value to be used directly as a role or attribute in an enforcement policy. This
bypasses the step of having to assign a role in Policy Manager through a role-mapping policy.

Summary Tab

Use the Summary tab to view the Generic SQL DB authentication source configuration.

HTTP
The HTTP authentication source relies on the GET method to retrieve information. The client submits a request,
and then the server returns a response. All request parameters are included in the URL. For example, URL:
https//hostname/webservice/…/%{Auth:Username}?param1=%{…}&param2=value2. HTTP relies on the
assumption that the connection between the client and server is secure and can be trusted.

To configure an authentication source for an HTTP service:

1. Navigate to Configuration > Authentication > Sources. The Authentication Sources page opens.

2. Click the Add link. The Add Authentication Sources page opens.

3. Configure primary and backup servers, session details, filter query, and role mapping attributes to fetch
HTTP authentication sources.

General Tab
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The General tab labels the authentication source and defines session details, authorization sources, and
backup server details.

Figure 171 HTTP > General Tab

Specify the HTTP > General tab parameters as described in the following table:

Parameter Action/Description

Name Specify the name of the authentication source.

Description Provide the additional information that helps to identify the authentication source.

Type Select the type of source. In this context, select HTTP.

Table 1: HTTP > General Tab Parameters
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Parameter Action/Description

Use for
Authorization

Enable this option to request Policy Manager to fetch role-mapping attributes (or authorization
attributes) from this authentication source. If a user or device successfully authenticates against
this authentication source, then Policy Manager also fetches role-mapping attributes from the
same source if the Use for Authorization field is enabled. This check box is enabled by default.

Authorization
Sources

Specify additional sources from which to fetch role-mapping attributes. Select a previously
configured authentication source from the drop-down list and click Add to add it to the list of
authorization sources. Click Remove to remove the selected additional resource from the list.
If Policy Manager authenticates the user or device from this authentication source, then also
fetches role-mapping attributes from these additional authorization sources. The default
authorization sources are as follows:
n [Blacklist User Repository] [Local]
n [Endpoints Repository] [Local]
n [Guest Device Repository] [Local]
n [Guest User Repository] [Local]
n [Insight Repository] [Local]
n [Local User Repository] [Local]
n [Multi-Master Cache Repository] [HTTP]

This authorization source of type HTTP fetches the store numbers list attribute stored in the
Multi-Master Cache against the local host.

n [Onboard Devices Repository] [Local]
n [Social Login Repository] [Local]
n [Time Source] [Local]
NOTE: You can specify additional authorization sources at the service level. Policy Manager
fetches role-mapping attributes irrespective of which authentication source the user or device was
authenticated against.

Backup
Servers

To add a backup server, click Add Backup.
From the Backup 1 tab, you can specify connection details for a backup server.
To remove a backup server, select the server name and click Remove.
Select Move Up or Move Down to change the server priority of the backup servers. This is the
order in which Policy Manager attempts to connect to the backup servers.

Primary Tab

The Primary tab defines the settings for the primary server.

Figure 172 HTTP > Primary Tab
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Specify the HTTP > Primary tab parameters as described in the following table:
Table 6: HTTP > Primary Tab Parameters

Parameter Action/Description

Base URL Enter the base URL (host name) or IP address of the HTTP server.
For example, http://<hostname> or <fully-qualified domain name>:xxxx, where xxxx is the port to
access the HTTP server.

Login
Username

Enter the name of the user used to log into the database.
This account must have read access to all the attributes that need to be retrieved by the specified
filters.

Password Enter the password for the user account entered in the Login Username field.

Attributes Tab

The Attributes tab defines the HTTP query filters and the attributes to be fetched by using those filters.

Figure 173 HTTP > Attributes Tab

Specify the HTTP > Attributes tab parameters as described in the following table:
Table 7: HTTP > Attributes tab (Filter List) Parameters

Parameter Action/Description

Filter Name Displays the name of the filter.

Attribute Name Specifies the name of the SQL DB attributes defined for this filter.

Alias Name Specifies the name of an alias name for each attribute name selected for the filter.

Enabled As Indicates whether an attribute is enabled as a role.

Add More Filters Opens the Configure Filter page. For more information, see Add More Filters on page 207.
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Add More Filters

The Configure Filter page defines a filter query and the related attributes to be fetched from the SQL DB
store.

Figure 174 HTTP Filter Configure Page

Specify the HTTP Configure > Filter parameters as described in the following table:
Table 8: HTTP Configure Filter Page Parameters

Parameter Action/Description

Filter Name Enter the name of the selected filter.

Filter Query Specify the HTTP path (without the server name) to fetch the attributes from the HTTP server.
For example, if the full path name to the filter is http server URL = http://<hostname or
fqdn>:xxxx/abc/def/xyz, where you enter /abc/def/xyz.

Name Specify the name of the attribute.

Alias Name Specifies the alias name for the attribute. By default, this is the same as the attribute name.

Data Type Specifies the data type for this attribute such as String, Integer, and Boolean.

Enabled As Specify whether the value to be used directly as a role or attribute in an enforcement policy. This
bypasses the step of assigning a role in Policy Manager through a role-mapping policy.

Summary Tab

You can use the Summary tab to view configured parameters.

Kerberos
Policy Manager can perform standard PAP/GTC or tunneled PAP/GTC (for example, EAP-PEAP[EAP-GTC])
authentication against any Kerberos 5-compliant server, such as the Microsoft Active Directory server. It is
mandatory to pair this source type with an authorization source (identity store) containing user records.

To configure an authentication source for a Kerboros service:

1. Navigate to Configuration > Authentication > Sources. The Authentication Sources page opens.
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2. Click the Add link. The Add Authentication Sources page opens.

General Tab

The General tab labels the authentication source and defines session details, authorization sources, and
backup server details. The following figure displays the Kerberos > General tab:

Figure 175 Kerberos > General Tab

The following table describes the Kerberos > General parameters:

Parameter Description

Name Specify the name of the authentication source.

Description Provide the additional information that helps to identify the authentication source.

Type From the Type drop-down, select Kerberos.

Table 1: Kerberos > General Tab Parameters
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Parameter Description

Use for Authorization Leave disabled in this context.

Authorization Sources Specify one or more authorization sources from which role-mapping attributes are to be
fetched.

1. Select an authentication source from the drop-down list .
2. Click Add to add it to the list of authorization sources.
Click Remove to remove the selected authentication source from the list.

NOTE: You can specify additional authorization sources at the service level. Policy
Manager fetches role-mapping attributes irrespective of which authentication source the
user or device was authenticated against.

Backup Servers 1. To add a backup Kerberos server, click Add Backup.
2. From the Backup 1 tab, you can specify connection details for a backup server
(same fields applicable for primary server specified below).

n To remove a backup server, select the server name and click Remove.
n Select Move Up or Move Down to change the server priority of the backup servers.

This is the order in which Policy Manager attempts to connect to the backup servers.

Primary Tab

The Primary tab defines the settings for the primary server. The following figure displays the Kerberos >
Primary tab:

Figure 176 Kerberos > Primary Tab
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The following table describes the Kerberos > Primary parameters:
Table 9: Kerberos > Primary Tab Parameters

Parameter Description

Hostname Specify the name of the host or the IP address of the Kerberos server.

Port Specify the port at which the token server listens for kerberos connections. The default
port is 88.

Realm Specify the Kerberos domain.

Service Principal Name Enter the identity of the service principal as configured in the Kerberos server.

Service Principal
Password

Enter the password for the service principal.

Summary Tab

Use the Summary tab to view the authentication source configuration.

Okta
You can use Okta as an authentication source only for servers of the type Aruba Application Authentication.

To configure an authentication source for an Okta service:

1. Navigate to Configuration > Authentication > Sources. The Authentication Sources page opens.

2. Click the Add link.

The Add Authentication Sources page opens.

General Tab
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The General tab labels the authentication source and defines session details, authorization sources, and
backup server details.

Figure 177 Okta > General Tab

3. Specify the Okta > General parameters as described in the following table:

Parameter Description

Name Specify the name of the authentication source.

Description Provide the additional information that helps to identify the authentication source.

Type Select Okta.

Use for
Authorization

Enable this check box to request Policy Manager to fetch role mapping attributes (or
authorization attributes) from this authentication source.
If a user or device successfully authenticates against this authentication source, then Policy
Manager also fetches role-mapping attributes from the same source if the Use for
Authorization field is enabled. This check box is enabled by default.

Authorization
Sources

Specify additional sources from which role-mapping attributes are to be fetched.
1. Select a previously configured authentication source from the drop-down list.
2. To add the authentication source to the list of authorization sources, click Add.

n To remove the authentication source from the list, click Remove.
If Policy Manager authenticates the user or device from this authentication source, then also
fetches role-mapping attributes from these additional authorization sources.
NOTE: You can specify additional authorization sources at the service level. Policy Manager
fetches role-mapping attributes regard

Table 1: Okta > General Tab Parameters
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Parameter Description

Server Timeout Specify the duration in number of seconds that Policy Manager waits before considering this
server unreachable.
If multiple backup servers are available, this value indicates the duration in number of seconds
that Policy Manager waits before attempting to fail over from the primary to the backup
servers in the order in which they are configured.

Cache Timeout Policy Manager caches attributes fetched for an authenticating entity. This parameter controls
the duration in number of seconds for which the attributes are cached.

Backup Servers
Priority

1. To add a backup server, click Add Backup.
2. From the Backup 1 tab, you can specify connection details for a backup server (same
fields as for primary server that are specified below).

n To remove a backup server, select the server name and click Remove.
n Select Move Up or Move Down to change the server priority of the backup servers. This is

the order in which Policy Manager attempts to connect to the backup servers.

Primary Tab

The Primary tab defines the settings for the primary server.

Figure 178 Okta > Primary Tab

Specify the Okta > Primary parameters as described in the following table:
Table 10: Okta > Primary Tab Parameters

Parameter Description

Connection Details

URL Enter the address of the Okta server.

Authorization Token Enter the authorization token provided by Okta support.

Attributes Tab
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The Attributes tab defines the Okta query filters and the attributes to be fetched by using those filters. The
following figure displays the Okta > Attributes tab:

Figure 179 Okta > Attributes Tab

Specify the Okta > Attributes parameters as described in the following table:
Table 11: Okta - Attributes Tab Parameters

Parameter Description

Filter Name Displays the name of the filter.
You can configure only Group for Okta.

Attribute Name Specifies the name of the LDAP/AD attributes defined for this filter.

Alias Name Specifies the alias name for each attribute name selected for the filter.

Enable As Specifies whether value to be used directly as a role or an attribute in an enforcement policy.
This bypasses the step of assigning a role in Policy Manager through a role-mapping policy.

Add More Filters Click this button to open the Configure Filter page.

Adding Filters

To add a filter:

1. Click the Add More Filters button.

The Configure Filter page opens. This page defines a filter query and the related attributes to be fetched
from the SQL DB store.
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Figure 180 Okta > Configure Filter Page

Specify the Okta Configure Filter parameters as described in the following table:
Table 12: Okta Configure Filter Page

Parameter Description

Filter Name Enter the name of the filter.

Filter Query Specifies an SQL query to fetch attributes from the user or device record in DB.

Name Displays the name of the attribute.

Alias Name Specifies an alias name for the attribute. By default, this is the same as the attribute name.

Data Type Specifies the data type for this attribute such as String, Integer, and Boolean.

Enabled As Specify whether this value is to be used directly as a role or an attribute in an enforcement policy.
This bypasses the step of having to assign a role in Policy Manager through a role-mapping policy.

Summary Tab

Use the Summary tab to view the Okta authentication source configuration.

RADIUS/Radsec Server
You can use the RADIUS/RadSec Server as an authentication source to allow ClearPass to query a third-party
RADIUS/RadSec Server for authentication.

To configure an authentication source for a RADIUS service:

1. Navigate to Configuration > Authentication > Sources. The Authentication Sources page opens.

2. Click the Add link.

The Add Authentication Sources page opens.

General Tab
The General tab labels the authentication source and defines session details, authorization sources, and
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backup server details.

Figure 181 RADIUS/RadSec Server > General Tab

3. Specify the RADIUS/RadSEc Server > General parameters as described in the following table:

Parameter Action/Description

Name Specify the name of the authentication source.

Description Provide the additional information that helps to identify the authentication source.

Type From the Type drop-down, select RADIUS/RadSec Server.

Use for
Authorization

Enable this check box to request Policy Manager to fetch role-mapping attributes (or
authorization attributes) from this authentication source.
If a user or device successfully authenticates against this authentication source, Policy
Manager also fetches role-mapping attributes from the same source if the Use for
Authorization field is enabled. This check box is enabled by default.

Table 1: RADIUS/RadSec Server > General Tab Parameters
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Parameter Action/Description

Authorization
Sources

Specify additional sources from which role-mapping attributes are to be fetched.
1. Select a previously configured authentication source from the drop-down list.
2. To add the authentication source to the list of authorization sources, click Add.

n To remove the authentication source from the list, click Remove.
If Policy Manager authenticates the user or device from this authentication source, then also
fetches role-mapping attributes from these additional authorization sources.
NOTE: You can specify additional authorization sources at the service level. Policy Manager
fetches role-mapping attributes regardless of which authentication source the user or
device was authenticated against.

Server Timeout Specify the duration in number of seconds that Policy Manager waits before considering this
server unreachable.
If multiple backup servers are available, this value indicates the duration in number of
seconds that Policy Manager waits before attempting to fail over from the primary to the
backup servers in the order in which they are configured.

Backup Servers
Priority

1. To add a backup server, click Add Backup.
2. From the Backup 1 tab, you can specify connection details for a backup server (same
fields as for primary server that are specified below).

n To remove a backup server, select the server name and click Remove.
n Select Move Up or Move Down to change the server priority of the backup servers. This

is the order in which Policy Manager attempts to connect to the backup servers.

Primary Tab
The Primary tab defines the settings for the primary server.

Figure 182 RADIUS/RAdSec Server > Primary Tab

3. Specify the Radius/RadSec Server > Primary parameters as described in the following table:

Table 13: RADIUS/RadSec Server > Primary Tab Parameters

Parameter Action/Description

Connection Details

Server Names Enter the name of the RADIUS server.

Port The default port number is 1812. You may enter a different port number if required.

Secret Enter the secret key for authentication.

Attributes Tab
The Attributes tab defines the Okta query filters and the attributes to be fetched by using those filters.
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Figure 183 RADIUS/RadSec Server > Attributes Tab

4. Specify the RADIUS/RadSec Server > Attributes parameters as described in the following table:

Table 14: RADIUS/RadSec Server > Attributes Tab Parameters

Parameter Description

RADIUS Pre-
Proxy attributes

The following attributes that can be set prior to the proxy authentication:
n Type: Select a type from the drop-down.
n Name: Select a name from the drop-down.
n Value: Enter a value in the text box.

RADIUS Post-
Proxy attributes

The attributes for the post-proxy authentication are identical except that these can be set after
the proxy authentication.
n Type: Select a type from the drop-down.
n Name: Select a name from the drop-down.
n Value: Enter a value in the text box.
Save the changes by clicking the Save icon that appears at the end of the row.

Summary Tab

Use the Summary tab to view the RADIUS Server authentication source configuration.

Adding a Static Host List as an Authentication Source

You can configure primary and backup servers, session details, and the list of static hosts for Static Host List
authentication sources. A static host list often functions, in the context of the service, as a white list or a black
list. Therefore, static host lists are configured independently at the global level. A static host list comprises a
named list of MAC addresses or IP addresses, which can be invoked in the following ways:

n In service and role-mapping rules as a component.

n For non-responsive services on the network (for example, printers or scanners), as an authentication
source.

Only static host lists of type MAC Address are available as authentication sources. For more information about static
host lists, see Managing Static Host Lists.
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To add a static host list as an authentication source:

1. Navigate to Configuration > Authentication > Sources. The Authentication Sources page opens.

Figure 184 Authentication Sources Page

2. Click the Add link. The Add Authentication Sources dialog opens.

Figure 185 Specifying a Static Host List as Authentication Source

3. Enter the name and description of the static host list.

4. In the Type field, select Static Host List. In this context, the Use for Authorization and Authorization
Sources fields are not configurable.

5. Click Next. The Static Hosts Lists dialog opens.

6. From the Static Host Lists tab, select a static host list from the drop-down list. The selected static host list
is added to the MAC Address Host Lists (see Figure 186).
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Figure 186 Existing Static Host List Added

Only static host lists of type MAC Address Host Lists or MAC Address Regular Expression can be configured as
authentication sources.

a. To remove the selected static host list, click Remove.

b. To view the contents of the selected static host list, click View Details.

c. To modify the selected static host list, click Modify.

7. Click Save.

Token Server
Policy Manager can perform GTC authentication against any token server than can authenticate users by acting
as a RADIUS server (for example, RSA SecurID Token Server) and can authenticate users against a token server
and fetch role mapping attributes from any other configured authorization source.

Pair this source type with an authorization source (identity store) containing user records. When using a token
server as an authentication source, use the administrative interface to optionally configure a separate
authorization server. Policy Manager can also use the RADIUS attributes returned from a token server to create
role mapping policies. For more information, see Namespaces on page 980.

You configure primary and backup servers, session details, and the filter query and role mapping attributes to
fetch for token server authentication sources.

To configure an authentication source for a Token server:

1. Navigate to Configuration > Authentication > Sources. The Authentication Sources page opens.

2. Click the Add link. The Add Authentication Sources page opens.

General Tab
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The General tab labels the authentication source and defines session details, authorization sources, and
backup server details. The following figure displays the Token Server > General tab:

Figure 187 Token Server > General Tab

Specify the Token Server > General parameters as described in the following table:

Parameter Action/Description

Name Specify the label of the authentication source.

Description Provide the additional information that helps to identify the authentication source.

Type Select the type of authentication. In this context, select Token Server.

Use for
Authorization

Enable this check box to instruct Policy Manager to fetch role mapping attributes (or authorization
attributes) from this authentication source. If a user or device successfully authenticates against
this authentication source, then Policy Manager also fetches role mapping attributes from the
same source if the Use for Authorization field is enabled. This check box is enabled by default

Table 1: Token Server > General Tab Parameters
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Parameter Action/Description

Authorization
Sources

Specify additional sources from which to fetch role mapping attributes. Select a previously
configured authentication source from the drop-down list, and click Add to add it to the list of
authorization sources. Click Remove to remove it from the list.
If Policy Manager authenticates the user or device from this authentication source, then it also
fetches role mapping attributes from these additional authorization sources.
NOTE: You can specify additional authorization sources at the service level. Policy Manager
fetches role mapping attributes irrespective of which authentication source the user or device
was authenticated against.

Server
Timeout

Specify the duration in seconds that Policy Manager waits before attempting to fail over from
primary to backup servers (in the order in which they are configured).

Backup
Servers
Priority

To add a backup server, click Add Backup. From the Backup 1 tab, you can specify connection
details for a backup server (same fields as for primary server that are specified below).
To remove a backup server, select the server name and click Remove. Select Move Up or Move
Down to change the server priority of the backup servers. This is the order in which Policy
Manager attempts to connect to the backup servers.

Primary Tab

The Primary tab defines the settings for the primary server.

Figure 188 Token Server > Primary Tab

Specify the Token Server > Primary parameters as described in the following table:
Table 15: Token Server > Primary Tab Parameters

Parameter Action/Description

Server
Name

Specify the host name or the IP address of the token server,

Port Specify the UDP port at which the token server listens for RADIUS connections. The default port is
1812.

Secret Specify the RADIUS shared secret to connect to the token server.

Attributes Tab

The Attributes tab defines the RADIUS attributes to be fetched from the token server. These attributes can be
used in role-mapping policies. Policy Manager loads all RADIUS vendor dictionaries in the Type drop-down list
with attributes.
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Figure 189 Token Server > Attributes Tab

For more information, see Configuring a Role and Role-Mapping Policy on page 247.

Specify the Token Server > Attribute parameters as described in the following table:

Table 16: Token Server > Attribute Tab Parameters

Parameter Action/Description

Type Select the type of authentication source from the drop-down list.

Name Specifies the name of the token server attributes.

Enabled as
Role

Specifies whether value is to be used directly as a role or as an attribute in an enforcement policy.
This bypasses the step of assigning a role in Policy Manager through a role-mapping policy.

Summary Tab

Use the Summary tab to see a summarized view of the parameters configured in the General, Primary, and
Attributes tab.

Modifying Authentication Methods or Sources for an Existing
Service
To add or modify the authentication methods or sources for an existing service:

1. Navigate to the Configuration > Services page.

2. Select the service you want to modify. The Edit Service dialog for the selected service opens.

3. Select the Authentication tab. The Edit Services > Authentication dialog opens:
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Figure 190 Modifying Authentication Methods and Sources for a Selected Service

4. Specify the Authentication methods and sources for the selected service as described in the following table.
You can open an authentication method or source from the Configuration > Authentication >
Methods page or the Configuration > Authentication > Sources page.

Component Configuration Steps

Authentication Methods n Select a method, then select Move Up, Move Down, or Remove.
n Select View Details to view the details of the selected method.
n Select Modify to modify the selected authentication method. This displays

a dialog with the edit pagefor the select authentication method. To add a
previously configured authentication method, select from the Select to
Add drop-down list. To configure a new method, click the Add new
Authentication Method link. For more information about authentication
methods, see Adding and Modifying Authentication Methods on page 163.

NOTE: An authentication method is only configurable for some service types.
For more information, refer to Configuring Other Policy Manager Services on
page 61.

Authentication Sources n Select a source, then Move Up, Move Down, or Remove.
n Select View Details to view the details of the selected authentication

source.
n Select Modify to modify the selected authentication source. This displays

the Authentication Source Configuration wizard for the selected
authentication source.

n To add a previously configured authentication source, select from the
Select to Add drop-down list.

n To configure a new authentication source, click the Add new
Authentication Source link. For more information about authentication
sources, see Adding and Configuring Authentication Sources on page 186.

Strip Username Rules Select the Enable to specify a comma-separated list of rules to strip
usernames check box to preprocess the username and to remove prefixes
and suffixes before authenticating it to the authentication source.

Service Certificate If there is a Service Certificate to associate with this service, select it from the
drop-down list.

Table 1: Authentication Method or Source Configuration for a Service
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Chapter 5
Configuring Identity Settings

The Policy Manager database supports storage of user records when a particular class of users is not present in
a central user repository (for example, when there is neither an Active Directory nor any other database).

To authenticate local users from a particular service, include Local User Repository among the authentication
sources.

This chapter provides information on the following topics:

n Configuring Single Sign-On

n Managing Local Users

n Adding and Modifying Endpoints

n Managing Static Host Lists

n Configuring a Role and Role-Mapping Policy

Configuring Single Sign-On
The Single Sign-On (SSO) settings on the Single Sign-On page allows ClearPass users that have signed in to
ClearPass Policy Manager to access the Onboard, Guest, and Insight applications and Policy Manager
administration settings without reauthenticating. ClearPass provides single sign-on support using the Security
Assertion Markup Language (SAML). This feature also provides differentiated single sign-on access for Guest
web logins and Guest Operator logins .

SAML Service Provider (SP) Configuration
To configure single sign-on service provider settings:

1. Navigate to Configuration > Identity > Single Sign-On. The Single Sign-On > SAML SP Configuration
dialog opens.
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Figure 191 Configuring Single Sign-On > SAML Service Provider Parameters

2. In the Identity Provider (IdP) URL field, enter the URL used to access the IdP.

3. Select the application(s) you want users to access with single sign-on.

n If you select only the Guest Operator Login, SSO will be enabled for Operator logins only, and Web
logins will use standard non-SSO authentication.

n If you select only the Guest Web Login option, SSO will be enabled for Web logins only, and Operator
logins will use standard non-SSO authentication.

n If you select both the Guest Operator Login and the Guest Web Login options, Operator logins and
Web logins will both use SSO authentication.

4. Create trusted relationships between a Service Provider and Identity Provider clicking the Select
Certificate drop-down list and selecting the Identity Provider (IdP) certificate to use for single sign-on.
When you select a certificate, the page displays the following information about the certificate:

n Subject DN

n Issuer DN

n Issue Date/Time

n Expiry Date/Time

n Validity Status

n Signature Algorithm

n Public Key Format

n Serial Number

n Enabled

This field only displays certificates that are enabled in the certificate trust list. If you do not specify the Identity
Provider Certificate, ClearPass displays the message Identity Provider (IdP) Certificate is mandatory. For more
information, see also Certificate Trust List on page 712.

5. In the ClearPass Service Provider (SP) Metadata field, click Download to download and view an XML
file containing metadata for the Service ProviderURI  (Uniform Resource Identifier). The Metadata URI
field displays the URI for the Service Provider metadata resource.
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To complete this task, you must next define your SAML Identity Provider (IdP) Configuration

SAML Identity Provider (IdP) Configuration
To configure single sign-on identity provider settings:

1. Navigate to Configuration > Identity > Single Sign-On.

2. Select the SAML IdP Configuration tab.

Figure 192 Configuring Single Sign-On > Identity Provider Parameters

3. In the IdP Portal Name field, enter the name of the identity provider portal. To download and view an XML
file containing metadata for the Identity Provider URI (Uniform Resource Identifier), click Download. the
IdP Metadata URI field displays the URI (Uniform Resource Identifier) for the selected IdP metadata
resource.

4. If you upload metadata for SAML service providers, ClearPass can upload the SP metadata for validation
during the single-sign on process.

a. Click Add SP Metadata. The Upload SP Metadata dialog opens.

b. In the Name field, enter the name of the service provider.

c. In the Metadata field, browse for the service provider metadata file, then click Upload.

Managing Local Users
This section provides the following information:

n Adding a Local User

n Modifying a Local User Account

n Importing and Exporting Local Users

n Setting a Password Policy for Local Users

n Disabling Local User Accounts

ClearPass Policy Manager lists all local users in the Local Users page. You can also add, import, export, set
password policies, and configure the conditions for disabling accounts for the local users using the links
provided at the top-right corner of the Local Users page.

Adding a Local User
To add a local user in the Local Users table:

1. Navigate to Configuration > Identity > Local Users.The Local Users page opens.
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Figure 193 Local Users Page

2. Click the Add link at the top-right corner the page. The Add Local User page opens (see Figure 194).

Figure 194 Adding a Local User

3. Specify the Add Local User parameters as described in the following table, then click Add:

Parameter Action/Description

User ID Specify the local user's user ID.

Name Enter the local user's name.

Password/ Verify Password Specify a password for the local user, then verify the password.

Enable User You must enable this check box to enable the local user account. Otherwise, the
local user account is disabled.

Change Password Enable this check box to allow the user to change the password at the next TACACS+
login (after authenticating with the old password).
Once the password is changed successfully, this option is automatically disabled.
NOTE: The option to change the password on the next login is applicable for
network device administration logins using TACACS+ only.

Table 1: Adding a Local User Parameters
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Parameter Action/Description

Role Select a static role to be assigned to the user from the Role drop-down list.

Attributes

To add attributes for the local users, click Click to add...
A new row is created with a drop-down list in the Attribute column. This field is
optional. The list of local user attributes are:
n Department
n Designation
n Email
n Phone
n Sponsor
n Title

1. To add a custom attribute in the Attribute column, select an attribute from
the drop-down list or enter any string.

NOTE: If you add a new custom attribute, it is available for selection in the Attribute
drop-down list for all local users.

2. In the Value column, enter a value for the attribute specified in the
corresponding row.

NOTE: All attributes entered for a local user are available in the role-mapping rules
editor under the LocalUser namespace.
When you click Add, you return to the Local User page where the following
message is displayed:
User <username> added successfully

Modifying a Local User Account
To modify a local user account:

1. Navigate to the Configuration > Identity > Local Users page.

2. Click the User ID row that you want to edit. The Edit Local User window opens.

Figure 195 Modifying a Local User

3. Modify any values as necessary in the Edit Local User dialog.

4. Click Save.
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Importing and Exporting Local Users
You can import or export the admin user accounts by using the Import and Export All links at the top-right
corner of the Local Users page. ( For more information, see Importing and Exporting Information.) After
selecting one or more user accounts from the list, you can also export specific user accounts by clicking the
Export button .

The passwords of the local user accounts are not stored in clear text when exported to an XML file.

Setting a Password Policy for Local Users
To set password policies for the local users:

1. Navigate to the Configuration > Identity > Local Users page.

2. Click the Account Settings link. The Account Settings page opens.

Figure 196 Account Settings > Password Policy Settings Dialog

3. Specify the Password Policy parameters as described in Table 2, then click Save.
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Parameter Action/Description

Minimum Length Specify the minimum length required for the password.

Complexity Select the complexity setting from the Complexity drop-down list. The
complexity settings can be one of the following:
n No password complexity requirement
n At least one uppercase and one lowercase letter
n At least one digit
n At lease one letter and one digit
n At least one of each: uppercase letter, lowercase letter, digit
n At least one symbol
n At least one of each: uppercase letter, lowercase letter, digit, and symbol

Disallowed Characters Specify the characters not to be allowed in the password.
NOTE: Password characters validation takes effect for users created or
modified after changes are saved.

Disallowed Words (CSV) Specify the words not to be allowed in the password. Separate the disallowed
words with commas.

Additional Checks Select any additional checks, if required. The options are:
n May not contain User ID or its characters in reversed order.
n May not contain a repeated character four or more times consecutively.

Expiry Days Set the password expiration time for local users. The allowed range is 0 to
500 days. The default value is 0.
NOTE: If the value is set to 0, the password never expires. For any other
value, local users are forced to reset the expired password when they log in.
ClearPass alerts users five days before the password expires.

History Specify the number of previous passwords for this user to be compared
against. This option prevents users from setting a password that was used
recently. Valid options are from 1 to 99.

Reminder Configure the reminder message.Setting this option displays a reminder
after n days to change the password. The valid options are from 1 to 365.
When set, this option only displays a reminder; it does not prompt for a new
password. The message to be displayed can be set accordingly.
NOTE: The Reminder parameter is applicable for TACACS+ authentication
only. The other settings are applied to all users.

Table 2: Password Policy Parameters
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Parameter Action/Description

Minimum Length Specify the minimum length required for the password.

Complexity Select the complexity setting from the Complexity drop-down list. The
complexity settings can be one of the following:
n No password complexity requirement
n At least one uppercase and one lowercase letter
n At least one digit
n At lease one letter and one digit
n At least one of each: uppercase letter, lowercase letter, digit
n At least one symbol
n At least one of each: uppercase letter, lowercase letter, digit, and symbol

Disallowed Characters Specify the characters not to be allowed in the password.
NOTE: Password characters validation takes effect for users created or
modified after changes are saved.

Disallowed Words (CSV) Specify the words not to be allowed in the password. Separate the disallowed
words with commas.

Additional Checks Select any additional checks, if required. The options are:
n May not contain User ID or its characters in reversed order.
n May not contain a repeated character four or more times consecutively.

Expiry Days Set the password expiration time for local users.
The allowed range is 0 to 500 days. The default value is 0.
NOTE: If the value is set to 0, the password never expires. For any other
value, local users are forced to reset the expired password when they log in.
ClearPass alerts users five days before the password expires.

History Specify the number of previous passwords for this user to be compared
against. This option prevents users from setting a password that was used
recently. Valid options are from 1 to 99.

Reminder Configure the reminder message.Setting this option displays a reminder
after n days to change the password. The valid options are from 1 to 365.
When set, this option only displays a reminder; it does not prompt for a new
password. The message to be displayed can be set accordingly.
NOTE: The Reminder parameter is applicable for TACACS+ authentication
only. The other settings are applied to all users.

Table 3: Password Policy Parameters

Disabling Local User Accounts
Disabling a local user account can happen in two ways:

n When a local user tries to log in with an invalid password for a configured number of times defined by the
Failed attempts count parameter, the local user account is locked.

If the mechanism for logging in to ClearPassPolicy Manager is Certificate + Password, the local user is allowed to
enter the password even if the certificate is invalid.
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n When the local user tries to log in with an invalid user certificate for a configured number of times defined
by the Failed attempts count parameter, the local user account is disabled.

A local user’s failed login attempts are counted only when the Password_Mismatch, Password_Not_Available, and
User_Authentication_Failed error messages occur.

To reset the Failed attempts count and enable a disabled local user account, click the Reset button (see
Table 4). For Local users whose accounts are locked due to account settings validations, and whose accounts
are enabled again after being locked out, entries are logged in both the Audit Viewer (see Audit Viewer) and the
Event Viewer (see Event Viewer).

The Disable Account check occurs every day at midnight, except for the Failed attempts count. Other local
user configuration settings are applied to all local users.

To specify the conditions for disabling local user accounts:

1. Navigate to Configuration > Identity > Local Users.

2. Click the Account Settings link. The Account Settings page opens.

3. Select the Disable Accounts tab. The Disable Accounts dialog opens.

Figure 197 Disable Accounts Dialog

4. Specify the Disable Accounts parameters as described in Table 4, then click Save.

Parameter Action/Description

Days Exceed Specify the number of days before the account is disabled.
The range is from 1 to 100 days.

Date Exceeds Specify the date when local users are disabled when the current date exceeds the
configured date. The configured date can either be the current system date or a
future date. Entering a date prior to the current date is not supported.

Password not changed for Specify the number of days allowed before the password must be changed
The range is from 1 to 365 days.

Table 4: Disable Accounts Parameters

ClearPass 6.7 Policy Manager | User Guide Configuring Identity Settings | 232
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1264



233 | Configuring Identity Settings ClearPass 6.7 Policy Manager |  User Guide

Parameter Action/Description

Failed attempts count Specify the number of failed log-in attempts are allowed before the account is
disabled.The range is from 1 to 100 attempts.

Reset failed attempts count To reset the failed attempts count to zero and reenable those local users who
were disabled after exceeding the failed attempts count, click Reset.

Adding and Modifying Endpoints
This section provides the following information:

n Viewing the List of Authentication Endpoints

n Viewing Endpoint Authentication Details

n Performing Bulk Updates of Endpoint Attributes

n Performing Bulk Deletions of Endpoint Attributes

n Triggering Actions to Be Performed on Endpoints

n Updating Device Fingerprints From a Hosted Portal

n Manually Adding an Endpoint

n Modifying an Endpoint

For related information, see:

n Configuring Endpoint Context Server Actions

n Adding Vendor-Specific Endpoint Context Servers

Viewing the List of Authentication Endpoints
ClearPass Policy Manager automatically lists all the endpoints that are authenticated in the Configuration >
Identity > Endpoints page.

Figure 198 Endpoints Page
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Parameter Action/Description

Filters You can choose to select ALL matches or ANY matches.
Then you can specify from one to three device filters to refine the endpoint information you
wish to view.

MAC Address Displays the MAC address of the endpoint.

Hostname Specifies the host name of the endpoint.

Device Category Indicates the category of the profiled device. For example, Access Points, Computer, Smart
Device, VoIP phone, and so on.

Device OS Family Specifies the operating system that the device runs on. For example, when the category is
Computer, ClearPass shows a Device OS Family of Windows, Linux, or macOS.

Status Displays the status of the endpoint:
n Unknown
n Known client
n Unknown client
n Disabled client

Profiled Indicates whether the device has been added to the ClearPass Profile.

Table 1: Endpoint Page Parameters

Viewing Endpoint Authentication Details
To view the authentication details of an endpoint:

1. From the Configuration > Identity > Endpoints page, select an endpoint by the clicking the
corresponding check box.

The Authentication Records button is now enabled.

2. Click the Authentication Records button.

The Endpoint Authentication Details page opens.

Figure 199 Endpoint Authentication Details
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Performing Bulk Updates of Endpoint Attributes
You can perform bulk updates of endpoint attributes, either for a single endpoint or for multiple endpoints
simultaneously.

To perform bulk updates of endpoint attributes:

1. From the Configuration > Identity > Endpoints page, select one or more endpoints by the clicking the
corresponding check boxes.

The Bulk Update button is now enabled.

In network discovery, when endpoints do not have a MAC address, ClearPass creates MAC addresses for them that
include the prefix xa.

2. Click the Bulk Update button.

The Bulk Update Attributes dialog opens.

Figure 200 Configuring Bulk Update Attributes

3. To select an attribute you want to update, select Click to add, select the attribute from the Attribute list,
and then specify its Value.

4. Repeat the selection process for all the attributes you want to update, then click Update.

The multiple attributes that were configured will be updated on all the selected endpoints at once.

Performing Bulk Deletions of Endpoint Attributes
ClearPass supports bulk deletion of endpoint attributes.

To use this feature:

1. Navigate to Configuration > Identity > Endpoints.

The Endpoints page opens.
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Figure 201 Endpoints Page and Bulk Delete Button

2. Select the check box(es) of one or more endpoints in the list from which you wish to delete multiple
attributes.

3. Click the Bulk Delete button.

The Bulk Delete Attributes dialog is displayed.

Figure 202 Endpoints: Bulk Delete Attributes Dialog

4. To select the endpoint attributes to be deleted, select the Click to add link.

Figure 203 Selecting Endpoint Attributes for Bulk Deletion

5. From the Attribute drop-down, select the attributes (one attribute per line) that you wish to delete from
the specified endpoints, then click Delete.
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Triggering Actions to Be Performed on Endpoints
You can trigger endpoint actions for a single endpoint or for multiple endpoints simultaneously.

To trigger actions that are to be performed on selected endpoints:

1. From the Configuration > Identity > Endpoints page, select one or more endpoints from the Endpoints
page by clicking the corresponding check boxes.

The Trigger Server Action button is now enabled.

2. Click the Trigger Server Action button.

The Trigger Server Action page opens:

Figure 204 Endpoints Trigger Server Action Page

3. Specify the Trigger Server Action page parameters as described in the following table, then click Start
Action:

Parameter Action/Description

Server Action Select the server action from the drop-down list. The available server actions are as follows:
n Check Point Login - AD User
n Check Point Logout - Guest User
n Fortinet Login
n Fortinet Logout
n Handle AirGroup Time Sharing
n Infoblox Login
n On Demand Endpoint Scan

Context Server Enter a valid context server name. You can enter an IP address or a domain name.

Server Type Indicates the server type specified when the server was configured.

Action
Description

Describes the action that will take place on the endpoint; for example, "Inform Check Point that
user logged in."

Table 2: Trigger Server Action Page Parameters

Updating Device Fingerprints From a Hosted Portal
You can update device fingerprints for a single endpoint or for multiple endpoints simultaneously. If you
configure custom fingerprints, the custom fingerprint always takes precedence over the dynamically pushed
system fingerprint.

To update device fingerprints from a hosted portal:

Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1269



1. From the Configuration > Identity > Endpoints page, select one or more endpoints by clicking the
corresponding check boxes.

The Update Fingerprint button is now enabled.

2. Click the Update Fingerprint button.

Override Fingerprint Option
The Update Device Fingerprint page opens. By default, the Update Type is set to Override fingerprint
(see Figure 205).

Figure 205 Update Device Fingerprint Page: Override Fingerprint

When a new fingerprint override rule is defined, an entry is added to the Audit Viewer.

Add Fingerprint Rule Option
Figure 206 shows the Update Device Fingerprint page when you set the Update Type to Add fingerprint
rule.

ClearPass 6.7 Policy Manager | User Guide Configuring Identity Settings | 238
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1270



239 | Configuring Identity Settings ClearPass 6.7 Policy Manager |  User Guide

Figure 206 Update Device Fingerprint Page: Add Fingerprint Rule

3. Specify the Update Device Fingerprint page parameters as described in the following table, then click
Save:

Parameter Action/Description

Update Type Select one of the following update types:
n Override fingerprint: Update the device profile details (device category, device OS family, and

device name) for the selected endpoint.
n Add fingerprint rule: Update the device profile with a new fingerprint rule. This information is

displayed at the bottom of the Update Device Fingerprint page, as shown in Figure 206.

Specify Device Profile Details

Device
Category

Select the category the profiled device belongs to.

Device OS
Family

Select the operating system configured on the device.

Device
Name

Enter the name of the device. You can select the name of the device from the list.

Table 3: Update Device Fingerprint Parameters

When a new fingerprint rule is defined, an entry is added to the Audit Viewer.

Manually Adding an Endpoint
To manually add an endpoint:

1. From the Configuration > Identity > Endpoints page, click Add.

The Add Endpoint page opens.
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Figure 207 Add Endpoint Page

2. Specify the Add Endpoint page parameters as described in the following table, then click Save:

Parameter Action/Description

MAC
Address

Specify the MAC address of the endpoint.

Description Enter a description that provides additional information about the endpoin (recommended).

Status Specify the client status as:
n Known client
n Unknown client
n Disabled client

l You can use the Known client and Unknown client status in role-mapping rules by
specifying the Authentication:MacAuth attribute.

l You can use the Disabled client status to block access to a specific endpoint. This status
is automatically set when an endpoint is blocked from the Endpoint Profiler.

Attributes Add custom attributes for this endpoint.
Select the Click to add... row to add custom attributes.
You can enter any name in the attribute field. All attributes are of String datatype.
The Value field can also be populated with any string.
Each time you enter a new custom attribute, it is available for selection in the Attribute drop-down
list for all endpoints. All attributes entered for an endpoint are available in the role-mapping Rules
Editor.

Table 4: Add Endpoint Page Parameters

Support for Empty Values for Optional Endpoint Attributes

ClearPass supports empty values for optional endpoint attributes when they are added through the user
interface, an XML import, or the API:

n When empty optional attributes are added to an endpoint through the user interface at Configuration >
Identity > Endpoints, all attribute data types are supported except Boolean, Day, List, and TimeOfDay.

n When empty optional attributes are added through an XML import or through the API, all data types are
supported.

n Empty attributes are not valid if the Is Mandatory attribute is set to true.
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n The EXISTS operator will not work in rule conditions for an attribute of the integer data type if the attribute
has empty values. It does, however, work for all other data types.

n If the value of an optional endpoint attribute is set to -For-Delete- in the import file, the attribute is marked
for delete.

Modifying an Endpoint
n Modifying an Endpoint

n Configuring the Attributes for the Selected Endpoint

n Endpoint Fingerprint Details Page

To modify an endpoint:

1. From the Configuration > Identity > Endpoints page, click the endpoint of interest from the list of
endpoints.

The Edit Endpoint page opens.

Modifying an Endpoint

Figure 208 Edit Endpoint Page

2. Specify the Edit Endpoint page parameters as described in the following table, then click Save:
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Parameter Action/Description

MAC Address Displays the MAC address of the endpoint.

Description Enter a description that provides additional information about the endpoint
(recommended).

Status Indicate the status of the selected endpoint as:
n Known client
n Unknown client
n Disabled client

l You can use the Known client and Unknown client status in role-mapping rules
by applying the Authentication:MacAuth attribute.

l You can use the Disabled client status to block access to a specific endpoint.
This status is automatically set when an endpoint is blocked from the Endpoint
Profiler.

MAC Vendor Displays the MAC OUI (Organizationally Unique Identifier) information for all endpoints
even when no other profiling information is available for an endpoint.

Added by Displays the name of the ClearPass server that added the endpoint.

Online Status Displays the online status of the endpoint:
n Online
n Offline

Connection Type Indicates the connection type; for example, Wireless.
If the connection type is not known, the connection type is displayed as Unknown.

Switch IP Indicates the switch IP address.

Switch Port Indicates the port on the switch.

IP Address Displays the IP address that is associated with the endpoint.

Static IP Indicates whether the IP address of the endpoint is a static IP address (True or False).

Hostname Displays the host name or the IP address of the endpoint.

Device Category Select the device category that the endpoint belongs to from the drop-down list.

Device OS Family Specify the operating system that the endpoint runs on.

Device Name Select the name of the device from the drop-down list.

Added At Displays the date and time at which the endpoint was added.

Updated At Displays the date and time at which the endpoint was updated.

Last Profiled At Displays the date and time at which the endpoint was added to the ClearPass Profile.

Table 5: Edit Endpoint Page Parameters
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Configuring the Attributes for the Selected Endpoint
To configure the endpoint attributes for the selected endpoint:

1. From the Edit Endpoint page, select the Attributes tab.

Figure 209 Adding Endpoint Attributes

2. To add attributes for the selected endpoint, select Click to add...
A new row is created with a drop-down list in the Attribute column.

3. To add an attribute to the endpoint, select one or more attributes from the drop-down list, then click Save.

About the Airwatch Group ID and Group Name Endpoint Attributes

The LocationGroupName and LocationGroupID attributes are fetched from an Airwatch server. These
attributes are mapped to the corresponding GroupName and GroupID Endpoint attributes.

Figure 210 Airwatch GroupID and GroupName Endpoint Attributes

About the Airwatch Compliance Attribute

The Compliance attribute is fetched from an Airwatch server and made available in the Endpoint attributes
list. The values for the Compliance attribute are:

n NotAvailable
n NonCompliant
n Compliant
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Viewing the Endpoint Fingerprint Details
The information displayed in the Edit Endpoint > Fingerprints page varies depending on what type of device
is selected and whether an Nmap-based network discovery scan has been run (see Configuring SNMP, SSH, and
WMI Credentials).

As shown in Figure 211, the Endpoint Fingerprints Details page shows the active and inactive Windows
services and processes for the selected Windows endpoint.

Figure 211 Endpoint Fingerprint Details Page

Managing Static Host Lists

This section provides the following information:

n About Static Host Lists

n Adding a Static Host List

n Editing a Static Host List

n Importing and Exporting Static Host Lists

About Static Host Lists
You can configure primary and backup servers, session details, and the list of static hosts for Static Host List
authentication sources.

A static host list often functions, in the context of the service, as a white list or a black list. Therefore, static host
lists are configured independently at the global level. A static host list comprises a named list of MAC addresses
or IP addresses, which can be invoked in the following ways:

n In service and role-mapping rules as a component.

n For non-responsive services on the network (for example, printers or scanners), as an authentication
source. For more information, see Managing Static Host Lists and Adding a Static Host List as an
Authentication Source.

Only static host lists of type MAC address are available as authentication sources.

Internal Relational Database
An internal relational database stores the ClearPass Policy Manager configuration data as well as locally
configured user and device accounts.

The following predefined authentication sources represent the databases used to store local users, guest users,
and registered devices respectively:

n [Local User Repository]

ClearPass 6.7 Policy Manager | User Guide Configuring Identity Settings | 244
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1276



245 | Configuring Identity Settings ClearPass 6.7 Policy Manager |  User Guide

n [Guest User Repository]
n [Guest Device Repository]

While regular users reside in an authentication source such as Active Directory (or in other LDAP-compliant
stores), you can configure the temporary users, including guest users, in the Policy Manager local repositories.

Role Statically Assigned
For a user account created in a local database, the role is statically assigned to that account. This means you do
not need to specify a role-mapping policy for user accounts in the local database. However, if new custom
attributes are assigned to a user account (local or guest) in the local database, these can be used in role-
mapping policies.

Preconfigured Filter
The local user database is preconfigured with a filter to retrieve the password and the expiry time for the
account. Policy Manager can perform MSCHAPv2 and PAP/GTC authentication against the local database.

Adding a Static Host List
To add a static host list to ClearPass:

1. Navigate to the Configuration > Identity > Static Host Lists page.

The Static Hosts Lists page opens.

Figure 212 Static Host Lists Page

2. Click Add.

The Add Static Host List dialog opens.
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Figure 213 Adding a Static Host List

3. For the Host Format of List:

a. Enter the IP or MAC address of the device.

b. Enter a description of the device.

c. Click Save Host.

The device is added to the Host Entries.

d. Click Save.

e. Repeat these steps for each entry in the static host list.

4. Specify the parameters to add a static host list as described in Table 1, then click Save.

Parameter Action/Description

Name Enter the name of the static host list.

Description Enter the description that provides additional information about the static host list.

Host Format Select a format for expression of the address:
n Subnet
n Regular Expression
n List. For the List Host Format type, you can add a description for each IP address

in the static host list (for examples, see Figure 214 below).

Host Type Select a host type:
n IP Address
n MAC Address

Subnet Enter the subnet address.

Table 1: Add Static Host List Parameters
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The new static host list is now available to be added as an authentication source. For details, see Adding a
Static Host List as an Authentication Source.

Editing a Static Host List
To edit a static host list:

1. Navigate to the Configuration > Identity > Static Host Lists page .

The Static Hosts Lists page opens.

2. Click on the name of the static hosts list you want to edit.

The Edit Static Host List dialog opens.

Figure 214 Edit Static Host List Dialog

3. Make any required changes, then click Save.

Importing and Exporting Static Host Lists
You can import static host lists into ClearPass or export them to a file.

1. Navigate to the Configuration > Identity > Static Host Lists page .

The Static Hosts Lists page opens.

2. Click on the name of the static hosts list you want to import or export.

3. To import a static host list into ClearPass, click the Import link.

4. To export a static host list to a file, click the Export All link.

For further details, see Importing and Exporting Information.

Configuring a Role and Role-Mapping Policy
This section includes the following information:

n Preconfigured Roles

n Adding and Modifying Roles on page 249

Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1279



n Adding and Modifying Role-Mapping Policies on page 251

After authenticating a request, a Policy Manager service invokes its role-mapping policy, resulting in assignment
of a role(s) to the client. This role becomes the identity component of enforcement policy decisions.

A service can be configured without a role-mapping policy, but only one role-mapping policy can be configured for
each service.

Preconfigured Roles
Policy Manager provides the following preconfigured roles:

n [AirGroup v1]: Role for an AirGroup protocol version 1 request.

n [AirGroup v2]: Role for an AirGroup protocol version 2 request.

n [Aruba TACACS read-only Admin]: Default role for read-only\ access to Aruba device.

n [Aruba TACACS root Admin]: Default role for root access to Aruba device.

n [BYOD Operator]: Operators with this profile can view and manage their own provisioned devices.

n [Contractor]: Default role for a contractor

n [Device Registration]: Operators with this profile can self-provision their devices for MAC authentication and
AirGroup sharing.

n [Employee]: Default role for an employee.

n [Guest]: Default role for guest access.

n [MAC Caching]: Default role applied during MAC caching.

n [Onboard Android]: Role for an Android device being provisioned.

n [Onboard Chromebook]: Role for a ChromeOS device being provisioned.

n [Onboard iOS]: Role for an iOS device being provisioned.

n [Onboard Linux]: Role for a Linux device being provisioned.

n [Onboard macOS]: Role for a macOS device being provisioned.

n [Onboard Windows]: Role for a Windows device being provisioned.

n [Other]: Default role for another user or device

n [TACACS API Admin]: API administrator role for Policy Manager admin

n [TACACS Help Desk]: Policy Manager Admin role, limited to views of the Monitoring screens

n [TACACS Network Admin]: Policy Manager Admin role, limited to Configuration and Monitoring screens

n [TACACS Read-only Admin]: Read-only administrator role for Policy Manager Admin

n [TACACS Receptionist]: Policy Manager Guest provisioning role

n [TACACS Super Admin]: Policy Manager Admin role with unlimited access to all user interface screens

Identity Roles Architecture and Workflow
Roles can range in complexity from a simple user group (for example, Finance, Engineering, or Human
Resources) to a combination of a user group with some dynamic constraints (for example, “Night Shift Worker,”
an employee in the Engineering department who logs in through the network device between 8:00 p.m. and
5:00 a.m on weekdays). It can also apply to a list of users.

A Role-Mapping Policy reduces client (user or device) identity or attributes associated with the request to Role
(s) for Enforcement Policy evaluation. The roles ultimately determine differentiated access.

For more information, see Configuring a Role and Role-Mapping Policy.

Figure 215 illustrates the role-mapping process and workflow.
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Figure 215 Role-Mapping Process

A role can be:

n Authenticated through predefined single sign-on rules.

n Associated directly with a user in the Policy Manager local user database.

n Authenticated based on predefined allowed endpoints.

n Associated directly with a static host list, again through role mapping.

n Discovered by Policy Manager through role mapping.

Roles are typically discovered by Policy Manager by retrieving attributes from the authentication source.

Filter rules associated with the authentication source tell Policy Manager where to retrieve these attributes.

n Assigned automatically when retrieving attributes from the authentication source. Any attribute in the
authentication source can be mapped directly to a role.

Adding and Modifying Roles
Roles exist independently of an individual service and can be accessed globally through the role-mapping policy
of any service.

Policy Manager lists all available roles in the Roles page.

Roles available on this page include roles that are created automatically when an administrator creates a new
operator profile in ClearPass Guest. The new role is created with the same name as the operator profile.

If an administrator later wants to rename the role, the role is not replaced—instead, the first role is kept
unchanged and another role is created with the new name.

Adding a Role
To add a role:

1. Navigate to Configuration > Identity > Roles.

The Roles page opens.
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Figure 216 Roles Page

You can also configure a role from within a role-mapping policy (click the Add New Role link).

2. Click Add.

The Add New Role page opens.

Figure 217 Add New Role Page

3. Define the Add New Role parameters as described in the following table, then click Save.

Parameter Action/Description

Name Enter the name of the role.

Description Optionally, enter the description that provides additional information about the new role
(recommended).

Table 1: Add New Role Page Parameters

Modifying a Role

To modify a role:

1. Navigate to Configuration > Identity > Roles.

The Roles page opens.

2. Click the role Name that you wish to modify.

The Edit Role page appears.
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Figure 218 Edit Role Page

3. Edit the Name and Description as needed, then click Save.

Adding and Modifying Role-Mapping Policies

Adding a Role-Mapping Policy

To add a role-mapping policy:

1. Navigate to the Configuration > Identity > Role Mappings page. The Role Mappings page opens:

Figure 219 Role Mappings Page

2. Click Add. The Add Role-Mappings page opens to the Policy tab. The Policy tab labels the method and
defines the default role. The default role is the role to which Policy Manager defaults if the role-mapping
policy does not produce a match for a given request.

Figure 220 Role Mappings > Policy Tab

3. Specify the Role Mappings > Policy parameters as described in the following table:
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Parameter Action/Description

Policy Name Enter the name of the role-mapping policy.

Description Enter the description that provides additional information about the role mapping policy.

Default Role Select the role to which Policy Manager will default when the role-mapping policy does not produce
a match.

View Details To view the details of the default role, click View Details.

Modify To modify the default role, click Modify.

Add New
Role

To add a new role, click Add New Role.

Table 1: Role Mappings > Policy Parameters

Adding Mapping Rules

The Mapping Rules tab selects the evaluation algorithm to add, edit, remove, and reorder rules (see Figure
221).

Figure 221 Role Mapping >Mapping Rules Page

To add a mapping rule:

1. Click Add Rule. The Rules Editor page opens.

Figure 222 Rules Editor Page

2. Specify the Role Mappings Page > Rules Editor page parameters as described in the following table.
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Parameter Action/Description

Type The Rules Editor appears throughout the Policy Manager interface. It exposes different
namespace dictionaries, depending on context. (Refer to Namespaces on page 980.)
In the role mapping context, Policy Manager allows attributes from following namespaces:
n Application
n Application:ClearPass
n Application:SSO
n Authentication
n Authorization
n Authorization:<authorization_source_instance>: Policy Manager shows each instance of the

authorization source for which attributes have been configured to be fetched (see Adding
and Configuring Authentication Sources on page 186). Only those attributes that have been
configured to be fetched are shown in the attributes drop-down list.

n Certificate
n Connection
n Date
n Device
n Endpoint
n GuestUser
n Host
n LocalUser
n Onboard
n TACACS
n RADIUS: All enabled RADIUS vendor dictionaries.

Name Displays the drop-down list of attributes present in the selected namespace.

Operator Displays the drop-down list of context-appropriate (with respect to the attribute data type)
operators. For more information about operators, seeOperators.

Value Depending on attribute data type, this may be a free-form (one or many line) edit box, a drop-
down list, or a time/date widget.

Table 2: Rules Editor Page Parameters

The operator values that display for each type and name are based on the data type specified for the authentication
source (from the Configuration > Authentication > Sources page). If, for example, you modify the UserDN Data
type on the authentication sources page to be an integer rather than a string, then the list of operator values here
will populate with values that are specific to integers.

Modifying a Role-Mapping Policy

After you save your role-mapping configuration, it is displayed in the Mapping Rules list.

To modify a role-mapping policy:

1. Select the rule you wish to modify.

2. Then you can move the rule up or down in the list, edit the rule, or remove the rule.

3. Click Save.
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Chapter 6
Posture Policies and Audit Servers

This chapter provides the following information:

n Posture Architecture and Flow

n Creating a New Posture Policy

n Configuring Posture Policy Agents and Hosts

n Configuring Posture Policy Plug-ins

n Configuring Posture Policy Rules

n Configuring Posture for Services

n Configuring Audit Servers

Posture Architecture and Flow

Policy Manager supports two types of posture checking: posture policies and audit servers.

Posture Policy
Policy Manager supports four pre-configured posture plug-ins for Windows, one plug-in for Linux®, and one
plug-in for macOS®, against which administrators can configure rules that test for specific attributes of client
health and correlate the results to return application posture tokens for processing by enforcement policies.

A service can be configured without any posture policy.

Audit Servers
Audit servers provide posture checking for unmanageable devices, such as devices lacking adequate posture
agents or supplicants. In the case of such clients, the audit server’s post-audit rules map clients to roles.

Policy Manager supports two types of audit servers:

n NMAP audit server: Primarily used to derive roles from post-audit rules.

n NESSUS audit server: Primarily used for vulnerability scans (and, optionally, post-audit rules).

Figure 223 Posture Evaluation Process
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Assessing Client Consistency
ClearPass Policy Manager uses posture evaluation to assess client consistency with enterprise endpoint health
policies, specifically with respect to:

n Operating system version/type

n Registry keys/services present (or absent)

n Antivirus or firewall configuration

n Patch level of software components

n Peer-to-Peer (P2P) application checks

n Services to be running or not running

n Processes to be running or not running

Application Token
Each configured health check returns an application token representing health:

n Healthy. Client is compliant: there are no restrictions on network access.

n Checkup. Client is compliant; however, there is an update available. This can be used to proactively
remediate to healthy state.

n Transient. Client evaluation is in progress; typically associated with auditing a client. The network access
granted is interim.
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n Quarantine. Client is out of compliance; restrict network access so the client only has access to the
remediation servers.

n Infected. Client is infected and is a threat to other systems in the network; network access should be
denied or severely restricted.

n Unknown. The posture token of the client is unknown.

System Token
Upon completion of all configured posture checks, Policy Manager evaluates all application tokens and
calculates a system token, equivalent to the most restrictive rating for all returned application tokens. The
system token provides the health posture component for input to the enforcement policy.

Creating a New Posture Policy

ClearPass Policy Manager evaluates the health of the clients that request access using posture policies and an
audit server. All these methods return Posture Tokens (for example, Healthy and Quarantine) for use by Policy
Manager as input into an enforcement policy. You can associate one or more posture methods with a single
service. ClearPass forwards all or part of the posture data received from the client to a posture server. Nmap
(Network Mapper) or Nessus audit servers provide posture checking for unmanageable devices, such as
devices lacking adequate posture agents or supplicants. For more information on audit servers, see
Configuring Audit Servers on page 347.

From the Posture Policies page, you can create a new policy or edit an existing policy.

To create a new Posture Policy:

1. Navigate to Configuration > Posture > Posture Policies. The Posture Policies page displays a list of all
existing posture policies and the plugin version (2.0).

Figure 224 Posture Policies Page

2. Click the Add link. The Posture Policies Add page opens.
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Figure 225 Posture Policies Add Page

3. Configure the information in the Policy page as described in Configuring Posture Policy Agents and Hosts
on page 257.

l For information on configuring the Posture policy plug-ins, see Configuring Posture Policy Plug-ins on
page 261.

l For information on configuring Posture Policy Rules, see Configuring Posture Policy Rules on page 344.

Configuring Posture Policy Agents and Hosts

Adding a New Posture Policy
To configure posture policy agents and hosts:

1. Navigate to Configuration > Posture > Posture Policies. The Posture Policies page displays a list of all
existing posture policies.

Figure 226 Posture Policies Page

2. Click the Add link. The Add Posture Policies page opens.
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Figure 227 Add Posture Policies Page

3. Use the Posture Policies > Policy dialog to configure the policy name and description, select a posture
agent and host operating system, and specify role restrictions.

4. Specify the Add Posture Policy parameters as described in the following table:

Parameter Action/Description

Policy Name Enter the name assigned to the policy by the ClearPass Policy Manager
administrator.

Description Specify the description that provides additional information about the posture
policy.

Posture Agent Select the posture agent type.
For detailed information on these agents, see Configure NAP Agent Posture Plug-ins
and Configure OnGuard Agent Posture Plug-ins.

Host Operating System Specify whether the host is using a Windows, Linux, or macOS operating system.

Restrict by Roles Apply the posture policy to the selected roles.
To restrict the posture policy by roles:

1. From the Policy tab, click the Select or type role names drop-down. The list
of available roles opens.
2. Select the roles you wish to restrict access by, then click Add. The selected
roles are added to the Restrict by Roles field. For example, users with access
to research data might have a posture policy that does not permit the mounting
of USB storage devices. Or users with access to employee or customer personal
or health data might have a policy that requires full disk encryption.

Table 1: Add Posture Policy Parameters
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Configure NAP Agent Posture Plug-ins
When you select NAP Agent as the Posture agent, you can configure the posture plug-ins as described in
Table 2:

Plug-in Description/Health Checks Windows Support

Windows System
Health Validator

The Windows System Health Validator
permits or denies client computers to
connect to your network. The Windows
System Health Validator also restricts
client access to computers that have a
service pack less than service pack x.

n Windows 10: Yes
n Windows 8: Yes
n Windows 7: Yes
n Windows Vista: Yes
n Windows XP Svc Pack 3: Yes
n Windows Server 2008, 2008R2: Yes
n Windows Server 2012, 2012R2: Yes

Windows Security
Health Validator

The Windows Security Health Validator
permits or denies client computers
access to your network, subject to checks
of the client's system:
n Firewall
n Virus Protection
n Automatic Updates
n Security Updates
NOTE: If you configure the Windows
Security Health Validator posture plug-in
for Windows XP, spyware protection is
disabled.

n Windows 10: Yes
n Windows 8: Yes
n Windows 7: Yes
n Windows Vista: Yes
n Windows XP Svc Pack 3: Yes
n Windows Server 2008, 2008R2: No
n Windows Server 2012, 2012R2: No

Table 2: NAP Agent: Windows OS Posture Plug-ins Support

Configure OnGuard Agent Posture Plug-ins
Select OnGuard Agent(Persistent or Dissolvable) as the Posture Agent for use in the following scenarios:

n An environment that does not support 802.1X-based authentication. For example, some legacy Microsoft
Windows operating systems or legacy network devices.

n An environment configured with an operating system that provides support for 802.1X natively, but does
not have a built-in health agent. MacOS is an example of this type of environment.

When you select the Posture Agent: OnGuard Agent (Persistent or Dissolvable), you can configure the
post\ure plug-ins for:

n Windows (see Table 3)

n MacOS (see Table 4)

n Linux (see Table 5)
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Plug-in Description/Health Checks Windows Support

ClearPassWindows
Universal System
Health Validator

The configurable health checks for this
validator are:
n Services
n Processes
n Registry Keys
n AntiVirus
n Patch Management
n Windows HotFixes
n USB Devices
n Virtual Machines
n Network Connections
n Disk Encryption
n Installed Applications
n File Check

n Windows 10: Yes
n Windows 8: Yes
n Windows 7: Yes
n Windows Vista: Yes
n Windows 2003: Yes
n Windows XP Svc Pack 3: Yes
n Windows Server 2008, 2008R2: Yes
NOTE: Configuration for Windows Server
2008 applies also to Windows Server 2008R2.
n Windows Server 2012, 2012R2: Yes
NOTE: Configuration for Windows Server
2012 applies also to Windows Server 2012R2.
n Windows Server 2016: Yes

Windows System
Health Validator

The Windows System Health Validator
allows you to configure client computers
that can connect to your network, and
clients that are restricted from your
network. Access is determined by a
check of the service pack level. You can
determine the service pack level.

n Windows 10: Yes
n Windows 8: Yes
n Windows 7: Yes
n Windows Vista: Yes
n Windows 2003: Yes
n Windows XP Svc Pack 3: Yes
n Windows Server 2008, 2008R2: Yes
n Windows Server 2012, 2012R2: Yes
n Windows Server 2016: Yes

Windows Security
Health Validator

The configurable health checks for this
validator allow you to enable health
checks that permit or deny client
computers access to your network,
subject to checks of the client's system:
n Firewall
n Virus Protection,
n Automatic Updates
n Security Updates

n Windows 10: Yes
n Windows 8: Yes
n Windows 7: Yes
n Windows Vista: Yes
n Windows 2003: No
n Windows XP Svc Pack 3: Yes
n Windows Server 2008, 2008R2: No
n Windows Server 2012, 2012R2: No

Table 3: OnGuard Agent Validator Posture Plug-in Windows OS Support

Plug-in Name Health Checks

ClearPass macOS Universal System
Health Validator

The configurable health checks for this health validator are:
l Services
l Processes
l AntiVirus
l Firewall
l Patch Management
l Peer-to-Peer
l USB Devices
l Virtual Machines
l Network Connections
l Disk Encryption
l Installed Applications
l File Check

Table 4: OnGuard Agent (Persistent or Dissolvable) Posture Plug-ins for macOS
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Plug-in Name Health Check

ClearPass Linux Universal System
Health Validator

The configurable health check for this health validator is: Services.

Table 5: OnGuard Agent (Persistent or Dissolvable) Posture Plug-in for Linux

Configuring Posture Policy Plug-ins
The Posture Plugins dialog of the Posture Policies page allows you to configure plug-ins for the posture
policy. The plug-ins available on this tab vary, depending upon whether the policy is using a Network Access
Protection (NAP) agent or the OnGuard Agent (Persistent or Dissolvable) plug-in.

To configure posture policy plug-ins:

1. Navigate to Configuration > Posture > Posture Policies.

The Posture Policies page opens.

Figure 228 Posture Policies Page

2. Click Add.

The Add Posture Policies page opens.

Figure 229 Adding a Posture Policy

3. In the Policy tab, specify the following:

l Policy Name

l Description

l Posture Agent

l Host Operating System

4. Select the Posture Plugins tab .

The Add Posture Plugins page opens.
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Figure 230 Add Posture Plugins Page

You can configure the following posture plug-ins in the Posture Policies page:

l ClearPass Windows Universal System Health Validator > OnGuard Agent

l Windows System Health Validator: NAP Agent

l Windows System Health Validator: OnGuard Agent

l Windows Security Health Validator: NAP Agent

5. Select the check box of the plug-in you wish to configure.

6. To view the configuration page for the selected plug-in, click Configure.

Configuring OnGuard Agent Plugins
If you select the OnGuard Agent option in the Policy tab of the Posture Policies page, the Posture Plugins
tab allows you to configure different plugin types for hosts running Windows, Linux, and macOS operating
systems. Refer to the following topics for details on each plugin type:

n Windows:

l ClearPass Windows Universal System Health Validator > OnGuard Agent on page 262

l Windows System Health Validator: OnGuard Agent on page 303

l Windows Security Health Validator: OnGuard Agent on page 304

n Linux: ClearPass Linux Universal System Health Validator Plugin on page 305

n macOS: ClearPass macOS Universal System Health Validator: OnGuard Agent on page 311

The following figure displays the Posture Policies > Posture Plugins tab:

Figure 231 Configuring the OnGuard Agent Plugin for macOS

ClearPass Windows Universal System Health Validator > OnGuard Agent
To configure the ClearPass Windows Universal Health System Health Validator (OnGuard Agent):

1. Navigate to Configuration > Posture > Posture Policies, then click Add.

The Add Posture Policies dialog opens.
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Figure 232 Adding a Posture Policy

a. Enter the name and a description of the posture policy.

b. Posture Agent: Choose OnGuard Agent (Persistent or Dissolvable).
c. Host Operating System: Windows is selected by default.

d. Plugin Version: OnGuard plugin version 2.0 (V4 SDK) is set by default.

2. Click Next.

The Posture Plugins dialog opens.

Figure 233 Selecting the Windows Posture Plugin

3. In the Posture Plugins page, click the check box for ClearPass Windows Universal System Health
Validator.

4. Click Configure.

The ClearPass Windows Universal System Health Validator page opens.

5. Select the desired version of Windows.

6. To enable checks for the selected version, click the Enable checks for Windows Server check box.
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Figure 234 ClearPass Windows Universal System Health Validator Page

The following list of health checks for the selected version of Windows opens (see Figure 234):

l Services on page 264

l Processes on page 269

l Registry Keys on page 272

l Antivirus Health Check on page 275

l Firewall on page 280

l Peer To Peer on page 282

l Patch Management on page 283

l Windows Hotfixes on page 287

l USB Devices on page 292

l Virtual Machines on page 292

l Network Connections on page 293

l Disk Encryption on page 295

l Installed Applications on page 296

l File Check on page 300

7. When finished, click Save.

You return to the Posture Policies > Posture Plugins page, where the Status column for the ClearPass
Windows Universal System Health Validator now shows Configured.

Services

The Services feature allows network admins to determine how the overall health status of the Services health
class is determined—whether by using an AND condition (for example, Group1 AND Group2) or an OR condition
(for example, Group1 OR Group2).

Regarding services, for example, admins can run checks such as Service1 AND Service2 OR Service3 AND Service4.
You can also use the Services page to verify the group of services to be present or absent and specify the
service groups and services to run on a client.
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To define Windows Service Groups, specify the evaluation rules, and add or remove specific Windows services
on the endpoint:

1. Navigate to Configuration > Posture > Posture Policies, then click Add.

2. From the Add Posture Policies page, select the Posture Plugins tab.

3. Select the ClearPass Windows Universal System Health Validator, then click Configure.

4. Select the Windows operating system, then check the Enable checks for Windows_OS.

5. Select Services.

The Services health class configuration page opens:

Figure 235 displays an example of the ClearPass Widows Universal System Health Validator >
Services configuration page and highlights examples of the evaluation rule for groups and the evaluation
rule for services:

Figure 235 Specifying Service Groups to Run

6. Specify the ClearPass Widows Universal System Health Validator > Services configuration
parameters as described in the following table:

Parameter Action/Description

Auto Remediation Enable to allow auto-remediation for service checks. Enabling this option automatically
stops or starts services based on the entries in Service to Run and Services to Stop
configuration.
Auto-remediation for the Services health class is enabled by default.

User Notification When enabled, a remediation message that includes the groups of services to be
present or absent is displayed to the end user.

Table 1: Services Configuration Parameters
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Defining the Service Group to Be Present

You can configure the name of the service group and specify the evaluation rule for the service group.

1. To configure the Service Groups for Services to Run, click Add.
The Add Service Group to Be Present dialog opens.

Figure 236 Specifying the Service Group Evaluation Rule

2. Specify the Add Service Group to Be Present parameters as described in the following table:

Parameter Action/Description

Enter the Service Group
Name

1. Enter the name of the Service Group.

Service Group Evaluation
Rule

2. Select the appropriate Service Group Evaluation Rule:
n Pass All: Select this evaluation rule if you want the Services health class to be

deemed as healthy only if all the configured service groups are present.
Pass All is the equivalent of an AND condition.

n Pass Any One: Select this evaluation rule if you want the Services Check health
class to be deemed as healthy even if any one of the configured service groups are
present.
Pass Any One is the equivalent of an OR condition.

Table 2: Add Service Group to Be Present Parameters

Specifying the Services to Be Present

To specify the services to be present:

1. Click the Services to Be Present > Add button.

The Add Services to Run dialog opens.
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Figure 237 Specifying the Services to Run

2. Select one or more of the desired services from the Available Services list.

3. To move the desired services to the Services to Run box, click >>, then click Save.

4. You can also add a service to the list of available services. To do so, enter the service name in the Insert text
box, then click Insert.

Defining the Service Group to Be Absent

You can configure the name of the service group and specify the evaluation rule for the service group.

1. To configure the Service Groups for Services to Be Absent, click Add.
The Add Service Group to Be Absent dialog opens.

Figure 238 Add Services to Be Absent Dialog

2. Specify the Service Groups to Be Absent parameters as described in the following table:
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Parameter Action/Description

Enter the Service Group
Name

1. Enter the name of the Service Group.

Service Group Evaluation
Rule

2. Select the appropriate Service Group Evaluation Rule:
n Pass All: Select this evaluation rule if you want all service groups to be stopped.

Pass All is the equivalent of an AND condition.
n Pass Any One: Select this evaluation rule if you want any one of the service groups

to be stopped.
Pass Any One is the equivalent of an OR condition.

Table 3: Add Service Group to Be Absent Parameters

3. Click Add.

The Add Services to Stop dialog opens.

Figure 239 Specifying the Services to Stop

4. Select one or more of the desired services from the Available Services list.

5. To move the desired services to the Services to Stop box, select the desired services, then click >>.

a. To remove services from the Services to Stop box, select the services to be removed, then click <<.

6. When finished configuring the services to stop, click Save.

Figure 240 shows an example of services configured for Windows Server 2003.
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Figure 240 Example of Services Configured

Processes

The Processes page provides a set of parameters to specify which processes to be explicitly present or absent
on the system.

To configure Processes:

1. Navigate to Configuration > Posture > Posture Policies, then click Add.

2. From the Add Posture Policies page, select the Posture Plugins tab.

3. Select the ClearPass Windows Universal System Health Validator, then click Configure.

4. Select the Windows operating system, then check the Enable checks for Windows_OS.

5. Select Processes.

The Processes health class configuration page opens:

Figure 241 Processes Configuration Page

6. Specify the Processes configuration parameters as described in the following table:
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Parameter Action/Description

Auto Remediation Enable to allow auto-remediation for processes.

User Notification Enable to allow user notifications in the event of process policy violations.

Table 1: Processes Page Parameters

Processes to be Present Parameters

1. In the Processes to be Present section, click Add.
The Add Processes to be Present page opens.

Figure 242 Add Processes to be Present Page

2. Specify the Processes to be Present parameters as described in the following table, then click Save:

Parameter Action/Description

Process Location Choose from the following locations:
l System Drive
l Systemroot
l Program Files
l HOMEDRIVE
l HOMEPATH
l None

Enter the Process name Specify the path name containing the process executable name.

Enter the Display name Enter a user-friendly name for the process. This is displayed in end-user facing
messages.

Table 2: Processes to be Present Page Parameters

After you save the Processes parameters, the information appears in the Processes to be Present
section.

Processes to be Absent Parameters

1. In the Processes to be Absent section, click Add.
The Add Processes to be Absent page opens.

Figure 243 shows the configuration parameters for when you select Process Name and when you select
MD5 Sum.
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Figure 243 Process to be Absent Pages: Process Name and MD5 Sum

2. Specify the Processes to be Absent parameters as described in the following table, then click Save:

Parameter Action/Description

Check Type Select the type of process check to perform. The agent can look for the following:
l Process Name: The agent looks for all processes that matches with the given

name.
For example, if notepad.exe is specified, the agent kills all processes whose
name matches, regardless of the location from which these processes were
started.

l MD5 Sum: This specifies one or more (comma-separated) MD5 checksums
of the process executable file.
For example, if there are multiple versions of the process executable, you can
specify the MD5 sums of all versions here.
The agent enumerates all running processes on the system, computes the
MD5 sum of the process executable file, and matches this with the specified
list. One or more of the matching processes are then terminated.

Enter the
Display
name

Enter a user-friendly name for the process. This display name is displayed in end-user
facing messages.

Table 3: Processes to be Absent Page Parameters

You return to the Processes Configuration page, which now shows the values for the processes that were
configured:
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Figure 244 Processes Configured

Registry Keys

The Registry Keys page allows you to specify which registry keys are to be explicitly present or absent. To
define the registry keys:

1. Navigate to Configuration > Posture > Posture Policies, then click Add.

2. From the Add Posture Policies page, select the Posture Plugins tab.

3. Select the ClearPass Windows Universal System Health Validator, then click Configure.

4. Select the Windows operating system, then check the Enable checks for Windows_OS.

5. Select Registry Keys. The Registry Keys health class configuration page opens:

Figure 245 Registry Keys Page (Overview)

6. Specify the Registry Keys page parameters as described in the following table:
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Parameter Action/Description

Auto
Remediation

Enable auto remediation for registry checks.
Use this page to automatically add or remove registry keys based on the entries in Registry
keys to be present and Registry keys to be absent fields.

User
Notification

Enable user notifications for registry check policy violations.

Monitor Mode Enable this to set the health status of the Registry Keys health class healthy.
This allows administrators to collect information related to missing registry keys without marking
the clients as unhealthy even if some registry keys are missing.

Registry keys
to be present

To specify a registry key to be added to the Registry keys to be present list, click Add.
If the specified registry key is not present, the remediation message that is added in the
Registry Keys Page (Detail) window is displayed on OnGuard Agent.

Registry keys
to be absent

To add a registry key to the Registry keys to be absent list, click Add.
If the specified registry key is not absent, the remediation message that is added in the Registry
Keys Page (Detail) window is displayed on OnGuard Agent.

Table 1: Registry Keys Page Parameters

7. To configure the Registry key to Be Present, click Add. The Edit Registry Key to Be Present dialog
opens.

Figure 246 Edit Registry Keys to Be Present Parameters

8. Specify the Registry Key to be Present parameters as described in Table 2, then click Save.
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Parameter Action/Description

Select the Registry
Hive

Specify the registry hive from the following options:
n HKEY_CLASSES_ROOT
n HKEY_CURRENT_USER
n HKEY_LOCAL_MACHINE
n HKEY_USERS
n HKEY_CURRENT_CONFIG

Enter the Registry
key

Specify the registry key using the examples given in the GUI.

Enter the Registry
value name

Specify the name of the registry value.

Select the Registry
value data type

Specify the registry value data types. The data type can be any of the following:
n Multi String
n String
n DWORD
n QWORD
n Expandable String

Enter the Registry
value data

Specify the registry value.

Enter Regex
pattern for
Registry value

Enter the Regular Expression (Regex) pattern for the Registry value.
A regular expression is a pattern that the regular expression engine attempts to match in
input text. A pattern consists of one or more character literals, operators, or constructs.
NOTE: Perl regular expressions are supported.

Enter Remediation
Message

Specify the custom remediation message to be displayed to end users if the registry check
fails.

Table 2: Registry Keys Page (Detail)

As shown in Figure 247, after you save the registry configuration settings, the remediation message and
Regular Expression pattern appears in the Registry page.

Figure 247 Registry Keys Added
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Antivirus Health Check

On the Antivirus page, you can turn on an antivirus application.

To configure the Windows antivirus health class:

1. Navigate to Configuration > Posture > Posture Policies, then click Add.

The Add Posture Policies page opens to the Policy tab.

Figure 248 Creating an Antivirus Posture Policy for Windows

2. From the Add Posture Policies page, select the Posture Plugins tab.

3. Select the ClearPass Windows Universal System Health Validator.

Figure 249 Configuring the ClearPass Windows Universal System Health Validator

4. Click Configure.

The configuration page opens. The list of supported Windows operating systems is displayed.

5. Select the pertinent Windows operating system.

When you select one of the Windows operating systems, the list of health checks for the selected OS is
displayed.

6. Check the Enable checks for Windows OS.
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Figure 250 Health Checks Available for the Selected Windows OS

7. From the list of health checks, select AntiVirus.

The antivirus health class configuration page opens.

8. To configure the antivirus application information, click the An antivirus application is on check box.

When enabled, the antivirus detail page opens.
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Figure 251 Enabling an Antivirus Application

9. To specify product and version-check information, click Add.
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Figure 252 Antivirus Health Check Configuration Dialog

10.Specify the antivirus health class parameters as described in the following table:

Parameter Action/Description

An antivirus-application is on Click An antivirus-application is on to enable testing of health
data for configured antivirus application(s).

Auto Remediation Check the Auto Remediation check box to enable auto
remediation of antivirus status. This option is enabled by default.

User Notification Check the User Notification check box to enable user notification
of policy violation of antivirus status. This option is enabled by
default.

Display Update URL Check the Display Update URL check box to show the origination
URL of the update. This option is disabled by default.

Product-specific checks To configure for product-specific checks, leave the check box
checked (the default setting).
To allow any antivirus product, uncheck the check box.
All of these checks may not be available for some products. Where
checks are not available, they are shown in disabled state.

Select the antivirus product Select an antivirus product from the drop-down list.

Table 1: AntiVirus Health Class Parameters
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Parameter Action/Description

Product version check Select one of the following options:
n No Check
n Is Latest
n At Least: When you select At Least, the Version is at Least

field appears. Enter the At Least version you require for the
antivirus product version.

n In Last N Updates: Requires registration with ClearPass Portal.

Data file version check Select one of the following options:
n No Check
n Is Latest: Requires registration with ClearPass portal.
n At Least: You can specify the least version that you require for

the data file. Enter the least version in the Version is At Least
field. When you select At Least, the Data file version format
option appears.

n In Last N Updates: Requires registration with ClearPass Portal.

Data file version format This field allows admins to specify the data file version format when
the At Least check is selected for Data File Version check.
The configured format is used to compare the configured data file
version value with value received from the client. This field should
be configured when the Data file version value contains a date.
The following format specifiers are supported:
n mm: Month
n dd: Day of the month
n yy or yyyy: Year
n a: Alphabetic
n n: Numeric
NOTE: Characters other than alphabetic and numeric characters
are considered as separators and are not compared.
For example:
n Data file version: 10/14/2018 rev. 10

Specify this data file version format: mm/dd/yyyy aaa. n
n Data file version: 2018.10.08

Specify this data file version format: yyyy.mm.dd
n Data file version: 20181014194001

Specify this data file version format: yyyymmddn
n Data file version: 2018-10-12_04

Specify this data file version format: yyyy-mm-dd_n
NOTE: For antivirus products that do not include a date in the Data
file version check value, this field can be left blank. In such cases,
ClearPass compares the value of the configured data file version
with the value received from the client, character-by-character.

Data file has been updated in Enter the number, then specify the interval in hours, days, weeks, or
months.

Table 1: AntiVirus Health Class Parameters
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Parameter Action/Description

Last scan has been done before Enter the number, then specify the interval in hours, days, weeks, or
months.

Real-time Protection Status
Check

n No Check: ClearPass does not use the Real-time Protection
status value for health evaluation. This means that the client is
treated as healthy irrespective of the value of its Real-time
Protection status.

n On: Marked as healthy only if the value of Real-time Protection
status is On.

Adaptive Threat Protection When McAfee Endpoint Security is selected as the antivirus
product, the Adaptive Threat Protection option is made available.
Status checks for Adaptive Threat Protection are not enabled by
default.
n To enable checking the status of McAfee Endpoint Security

Adaptive Threat Protection, select the On button.
Auto-remediation action to enable Adaptive Threat Protection is
not supported.

n If McAfee Endpoint Security Adaptive Threat Protection is
disabled, OnGuard will mark the client as Unhealthy .

Table 1: AntiVirus Health Class Parameters

11.Click Save.

After you save your antivirus configuration, it is listed on the Antivirus page.

Figure 253 Antivirus Check Configured

Firewall

In the Firewall page, you can specify that a Firewall application must be on and specify information about the
Firewall application.

Figure 254 Firewall Page (Overview Before)

In the Firewall page, click A Firewall Application is On to configure the Firewall application information.
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Figure 255 Firewall Page (Detail 1)

When enabled, the Firewall detail page appears.

Figure 256 Firewall Page (Detail 2)

When you save your Firewall configuration, it appears in the Firewall page list.

Figure 257 Firewall Page (Overview After)

The following table describes the Firewall parameters:

Parameter Description

A Firewall Application is
On

Check the Firewall Application is On check box to enable testing of health data for
configured firewall application(s).

Auto Remediation Check the Auto Remediation check box to enable auto remediation of firewall status.

User Notification Check the User Notification check box to enable user notification of policy violation of
firewall status.

Uncheck to allow any
product

To specify Firewall product-specific checks, leave this parameter as is.
To specify whether any firewall application (any vendor) is running on the end host,
uncheck the Uncheck to allow any product check box.

Table 1: Firewall Page Parameters
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Parameter Description

Add To configure firewall application attributes for testing against health data, click Add.

Trashcan icon To remove configured firewall application attributes from the list, click the trashcan
icon in that row.

Product/Version Configure the specific settings for which to test against health data. All of these checks
may not be available for some products. Where checks are not available, they are
shown in disabled state on the UI.
n Select the firewall product - Select a vendor from the list
n Product version is at least - Enter the version of the product.

Peer To Peer

The Peer To Peer page provides a set of widgets for specifying specific peer to peer applications or networks
to be explicitly stopped. When you select a peer to peer network, all applications that make use of that network
are stopped.

The following figure displays the Peer To Peer health class configuration page:

Figure 258 Peer to Peer Page

The following table describes the Peer to Peer parameters:

Parameter Description

Auto
Remediation

Enable to allow auto remediation for service checks (Automatically stop peer-to-peer
applications based on the entries in Applications to stop configuration).

User
Notification

Enable to allow user notifications for peer to peer application/network check policy violations.

By Application /
By Network

Select the appropriate radio button to select individual peer-to-peer applications or a group of
applications that use specific peer-to-peer networks.

Available
Applications

This scrolling list contains a list of applications or networks that you can select and move to the
Applications to stop panel.
n Click the >> to add the applications or networks to the Applications to stop pane.
n Click the << to remove the applications or networks from the Applications to stop pane.

Table 1: Peer to Peer Page
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Patch Management

The Patch Management page provides a way to specify that a patch management application must be on.
You can also specify information about the patch management application, configure the Product Evaluation
Rule, and configure patch management application checks.

To configure patch-management application(s):

1. Navigate to Configuration > Posture > Posture Policies, then click Add.

The Add Posture Policies dialog opens.

2. Select the Posture Plugins tab.

3. Click the check box for ClearPass Windows Universal System Health Validator.

4. Click Configure.

The ClearPass Windows Universal System Health Validator page opens.

5. Select the desired version of Windows.

6. From the selected version of Windows list, select Patch Management.

7. To enable checks for the selected version, click the Enable checks for Windows Server check box.

8. Click the A patch management application is on check box.

The Patch Management configuration dialog opens.

Figure 259 ClearPass Windows Universal System Health Validator: Patch Management

9. Specify the Patch Management parameters as described in the following table.
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Parameter Action/Description

A patch management
application is on

To enable testing of health data for configured Antivirus application(s), check the A
patch management application is on check box.
The Patch Management configuration dialog opens

Remediation Checks

Auto Remediation To enable auto-remediation of patch management status, check the Auto
Remediation check box .

User Notification To enable user notification of policy violation of patch management status, check the
User Notification check box.

Product Evaluation Rule

Product Evaluation Rule Select the appropriate Product Evaluation Rule:
n Pass All: Select this product evaluation rule if you want the Patch Management

health class to be deemed as healthy only if all the configured patch management
products are present.
Pass All is the equivalent of an AND condition.

n Pass Any One: Select this product evaluation rule if you want the Patch
Management health class to be deemed as healthy if any one of the configured
patch management products are present. Pass Any One is the equivalent of an
OR condition. Pass Any One is the default.

Table 1: Patch Management Parameters

10.To configure patch management application checks, click Add.

The Patch Management Health Checks configuration page opens:

Figure 260 Configuration Page for the Patch Management Application

11.Specify these parameters as described in the following table:

All checks might not be available for some products. Where checks are not available, they are shown in a disabled
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state.

Parameter Action/Description

Product-specific checks To check whether any patch management application (any vendor) is running
on the end host, clear the Uncheck to allow any product check box.

Select Patch Management
Product

Select a patch management product vendor.
This option is enabled only if the Product-specific checks check box is
checked.

Product version is at least Enter the minimally recommended product version number.
This option is enabled only if the Product-specific checks check box is
checked.

Status Check Type Specify the Status Check Type to check whether the Patch Agent is enabled.
The ClearPass Policy Manager server compares the Patch Agent Status sent
by OnGuard Agent with the configured value. If the Patch Agent Status value is
different from configured value, the client is treated as unhealthy.
If Auto-remediation is enabled, OnGuard Agent changes the Patch Agent
Status on the client to the configured value. Select any of the following options:

l No Check: ClearPass Policy Manager server ignores the Patch
Agent Status value. This means it will not check the status of the
Patch Agent application on the client.

l Enabled: Patch Agent is turned on and it automatically updates the
client.

l Disabled: Patch Agent is disabled and it will not check for missing
patches and update the client.

l Notify Before Download: Patch Agent is turned on and it notifies
the user before downloading updates.

l Notify Before Install: Patch Agent is turned on and it notifies the
user before installing updates.

NOTE: The values specific to the selected patch management product are
displayed in the Status Check Type field.
For example, all five values are displayed for Microsoft Windows Automatic
Update. For Microsoft System Center Configuration Manager (SCCM), only No
Check, Disabled, and Notify Before Install are displayed.

Table 2: Patch Management Parameters
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Parameter Action/Description

Install Level Check Type This option is only enabled if the Product-specific checks check box is
checked. For Microsoft SCCM, selecting All will return the full list of all missing
patches.

l No Check: ClearPass Policy Manager server ignores the Patch
Agent Status value. This means it will not check the status of the
Patch Agent application on the client.

l All: Checks for all missing patches and searches for all available
patches.

NOTE: If you select the Microsoft Windows Update Agent from the Select
Patch Management product list and you select an option from the Install
Level Check Type list, the results are as follows:

l All: Returns the full list of missing patches.
l No Check: Disables the Grace Period and Scan Interval fields.

Grace Period Configure the time period for which OnGuard Agent should ignore missing
patches.
You can specify the grace period in hours, days, weeks, or months.
For example, if the Grace Period is set to 3 days, clients will be treated as
healthy for three days even if some patches are missing. After three days,
OnGuard Agent will treat clients as unhealthy if the patches are still missing.
You can enable Auto-remediation to install the missing patches and to treat
them as healthy.
If you selected No Check from the Install Level Check Type field, Grace
Period is disabled.

Scan Interval Specify the Scan Interval by specifying the number of hours, days, weeks, or
months.
If you selected No Check from the Install Level Check Type field, Scan
Interval is disabled.

12.Click Save.

When you save your patch management configuration, the configuration information is displayed on the
Patch Management page:
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Figure 261 Patch Management Configuration Summary

Windows Hotfixes

There are two Hotfixes evaluation rules that can be applied:

n The Windows Hotfixes Groups to be Present Evaluation Rule specifies how to evaluate the health
among multiple Hotfixes groups (see Table 1 for details).

For example, if the status of Group1 is [Hotfix1] AND [Hotfix 2], and the status of Group2 is [Hotfix3] OR
[Hotfix4], the overall health status of the two groups is calculated as follows:

l Pass All: ( [Hotfix1] AND [Hotfix2] ) AND ( [Hotfix3] OR [Hotfix4] )

l Pass Any: ( [Hotfix1] AND [Hotfix2] ) OR ( [Hotfix3] OR [Hotfix4] )

n The Windows Hotfixes Group Evaluation Rule specifies how to evaluate the health for a specific
Hotfixes group (see Table 2 for details).

To define Windows Hotfixes Groups, specify the evaluation rules for multiple groups or a single group, and add
or remove specific Windows hotfixes on the endpoint:

1. Navigate to Configuration > Posture > Posture Policies, then click Add.

2. From the Add Posture Policies page, select the Posture Plugins tab.

3. Select the ClearPass Windows Universal System Health Validator, then click Configure.

4. Select the Windows operating system, then check the Enable checks for Windows_OS.

5. Select Windows Hotfixes.

The Windows Hotfixes health class configuration page opens:
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Figure 262 Windows Hotfixes Page

6. Specify the Windows Hotfixes parameters as described in the following table:

Parameter Action/Description

Auto Remediation Enable to allow auto-remediation for hotfix checks. Enabling this automatically
triggers updates of the specified hotfixes.
Auto-remediation for the Windows Hotfixes health class is enabled by default.

User Notification Enable to allow user notifications to check for hotfix policy violations.

Monitor Mode Click to enable Monitor Mode.

Windows Hotfixes Groups to be
Present Evaluation Rule

This evaluation rule specifies whether all groups should be healthy or any one
group should be healthy.
For example, if there are two Hotfixes Groups:
n Pass All: Select this evaluation rule to calculate the two group's health

status as Group1 AND Group2.
n Pass Any One: Select this evaluation rule to calculate the two group's

health status as Group1 OR Group2.

Table 1: Windows Hotfixes Page Parameters

Configuring Windows Hotfixes Groups to Be Present

To configure the Windows Hotfixes Groups to be present:

1. From the Windows Hotfixes health class configuration page (see Figure 262), click Add.

The following Hotfixes dialog opens:
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Figure 263 Defining the Hotfix Group

2. Specify the Hotfixes Group parameters as described in the following table:

Parameter Action/Description

Enter the Windows
Hotfixes Group Name

Enter the name of the Hotfixes Group.

Windows Hotfixes Group
Evaluation Rule

This evaluation rule specifies how to evaluate the health of a specific Hotfixes Group.
Select the appropriate Hotfix Group Evaluation Rule:
n Pass All: Select this evaluation rule if you want all hotfixes groups to be present.

Pass All is the equivalent of an AND condition.
n Pass Any One: Select this evaluation rule if you want any one of the hotfixes

groups to be present.
Pass Any One is the equivalent of an OR condition.

Hotfixes to be Present To add hotfixes to the Hotfixes Group, click Add.
The dialog shown in Figure 264 opens.

Table 2: Specifying Hotfixes Group to Be Present Parameters
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Figure 264 Specifying the Hotfixes to Be Present

3. From the first list, specify the criticality of the hotfixes:

n Critical

n Important

n Moderate

n Low

n Unspecified

As shown in Figure 264, the list of hotfixes for the selected criticality are displayed.

4. Select one or more of the desired hotfixes from the Available Hotfixes list.

As shown in Figure 264, when you select a Hotfix from the list of available hotfixes, information about that
hotfix is displayed.

5. To move hotfixes to the Hotfixes to be present box, select the desired hotfixes, then click >>.

The selected hotfixes are moved to the Hotfixes to be present box.
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Figure 265 Windows Hotfixes Added

6. To remove a hotfix from the Hotfixes to be present list, select the hotfix to be removed.

The Edit Hotfixes to be Present dialog opens.

Figure 266 Removing Hotfixes from the Hotfixes to Be Present List

7. From the Hotfixes to be present list, select the hotfix(es) you wish to remove and click <<.

The selected hotfix is removed from the Hotfixes to be present list.

8. When finished, click Save.

You return to the Windows Hotfixes dialog, where the Hotfixes to be Present > Hotfix KBID
(Knowledge Base Article ID) list displays the updated list.

9. Click Save.

The Windows Hotfixes page displays a summary of the Hotfixes Group configuration:
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Figure 267 Summary of Hotfixes Groups Configuration

USB Devices

The USB Devices page provides configuration to control USB mass storage devices attached to an endpoint.

Figure 268 USB Devices

The following table describes the USB Devices parameters:

Parameter Description

Auto Remediation Enable to allow auto remediation for USB mass storage devices attached to the
endpoint (Automatically stop or eject the drive).

User Notification Enable to allow user notifications for USB devices policy violations.

Remediation Action for USB
Mass Storage Devices

n No Action - Take no action; do not eject or disable the attached devices.
n Remove USB Mass Storage Devices - Eject the attached devices.
n Remove USB Mass Storage Devices - Stop the attached devices.

Table 1: USB Devices

Virtual Machines

The Virtual Machines page provides configuration to Virtual Machines utilized by your network.
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Figure 269 Virtual Machines

The following table describes the Virtual Machines parameters:

Parameter Description

Auto Remediation Enable to allow auto remediation for virtual machines connected to
the endpoint.

User Notification Enable to allow user notifications for virtual machine policy violations.

Allow access to clients running on Virtual
Machine

Enable to allow clients that running a VM to be accessed and
validated.

Allow access to clients hosting Virtual
Machine

Enable to allow clients that hosting a VM to be accessed and
validated.

Remediation Action for clients hosting
Virtual Machines

n No Action - Take no action; do not stop or pause virtual machines.
n Stop all Virtual Machines running on Host - Stop the VM clients

that are running on Host.
n Pause all Virtual Machines running on Host - Pause the VM clients

that are running on Host.

Table 1: Virtual Machines

Network Connections

The Network Connections page provides configuration to control network connections based on connection
type.

To configure Network Connections:

1. From the ClearPass Windows Universal System Health Validator page, enable checks for the selected version
of Windows.

2. Select Network Connections.

3. Enable the Network Connection Check is on check box.

The Network Connections configuration page appears.
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Figure 270 Network Connections Configuration Page

4. Select the Check for Network Connection Types check box.

5. To specify the type of connection that you want to include, click Configure.

The Network Connection Types configuration page appears.

Figure 271 Network Connection Types Configuration Page

6. Specify the Network Connection Types configuration parameters as described in the following table:

Parameter Action/Description

Allowed Network Connections
Type

1. Select one of the following options:
l Allow Only One Network Connection
l Allow One Network Connection with VPN
l Allow Multiple Network Connections

Network Connection Types 2. To add or remove Others, Wired, and Wireless network connection
types, click >> or <<.

Remediation Action for 3. Specify one of the following
l No Action: Take no action. Do not eject or disable the attached

Table 1: Network Connection Type Configuration Parameters
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Parameter Action/Description

Network Connection Types Not
Allowed

devices.
l Disable Network Connections
l Disconnect Network Connections

4. Click Save.

This returns you to the Network Connections configuration page. The following table describes the
remaining fields on this page:

Parameter Action/Description

Auto Remediation 1. Enable to allow auto-remediation for network connections.

User Notification 2. Enable to allow user notifications in the event of network connection policy
violations.

Remediation Action for
Bridge Network
Connection

3. If Allow Bridge Network Connection is disabled, then specify whether to take
no action when a bridge network connection exists or to disable all bridge network
connections.

Remediation Action for
Internet Connection
Sharing

4. If Allow Internet Connection Sharing is disabled, then specify whether to take
no action when Internet connection sharing exists or to disable Internet connection
sharing.

Remediation Action for
Adhoc/Hosted Wireless
Networks

5. If Allow Adhoc/Hosted Wireless Networks is disabled, then specify whether to
take no action when an adhoc wireless network exists or to disable all
adhoc/hosted wireless networks.

Table 2: Network Connections Configuration Parameters

Disk Encryption

Disk encryption is a technology that protects information by converting it into unreadable code that cannot be
deciphered easily by unauthorized people. Disk encryption uses disk encryption software or hardware to
encrypt every bit of data that goes on a disk or disk volume. Disk encryption prevents unauthorized access to
data storage.

To configure disk encryption for Windows:

1. Navigate to Configuration > Posture > Posture Policies.

The Posture Policies page opens.

2. Click the Add link.

The Posture Policies > Add page opens.

3. Specify the following:

a. Policy Name/Description: Enter the name and a description of the posture policy.

b. Posture Agent: Select OnGuard Agent.
c. Host Operating System: Leave the setting as Windows(the default).

d. Plugin Version: OnGuard Plugin version 2.0 (V4 SDK) is set by default.

4. Click Next.

The Posture Plugins dialog opens.

5. Select the check box for the ClearPass Universal System Health Validator, then click the Configure button.
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6. From the ClearPass Universal System Health Validator page, enable checks for the selected version of
Windows.

7. Select Disk Encryption.

8. Enable the A disk encryption application is on check box to provide the options to specify the
remediation checks, auto remediation, and user notification.

TheDisk Encryption page opens:

Figure 272 Disk Encryption Configuration Page

9. Specify the Disk Encryption parameters as described in the following table:

Parameter Description

User Notification Enable to allow user notifications for disk encryption policy violations.

Product-specific checks If you wish to select a specific disk encryption product, do not change the
default setting.
To allow any encryption product to check disk encryption, select the
Uncheck to allow any product check box.
The Select Disk Encryption product and Product Version is at least
fields are disabled after you uncheck theUncheck to allow any product
check box.

Select Disk Encryption
product

Select a specific disk encryption product.

Product Version is at least Search for the production version of the selected product.

Locations to Check Select location to check. The options are:
n None
n System Root Drive
n All Drives
n Specific Locations

Table 1: Disk Encryption Parameters

10.Click Save.

Installed Applications

The Installed Applications category groups classes that represent software-related objects. Access to these
objects is supported by the Windows Installer. Examples of objects in this category are installed products, file
specifications, and registration actions.
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In the Installed Applications Configuration page (see Figure 274), you can turn on the installed applications
check and specify information about which installed applications you want to monitor.

To configure the installed applications for Windows:

1. Navigate to Configuration > Posture > Posture Policies, then click Add.

The Add Posture Policies dialog opens.

a. Enter the name and a description of the posture policy.

b. Posture Agent: Choose OnGuard Agent (Persistent or Dissolvable).
c. Host Operating System: Windows is selected by default.

d. Plugin Version: OnGuard plugin version 2.0 (V4 SDK) is set by default.

2. Click Next.

The Posture Plugins dialog opens.

Figure 273 Selecting the Windows Posture Plugin

3. In the Posture Plugins page, click the check box for ClearPass Windows Universal System Health
Validator.

4. Click Configure.

The ClearPass Windows Universal System Health Validator page opens.

5. From the ClearPass Windows Universal System Health Validator page, enable checks for the selected version
of Windows.

6. Select Installed Applications.

7. To provide the options to specify the remediation checks, auto remediation, or user notification, enable the
Installed Application Check is on check box . The Installed Applicationspage opens:
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Figure 274 Installed Applications for Windows Configuration Page

8. Specify the Installed Applications Configuration page parameters as described in the following table:

Parameter Action/Description

Remediation checks Auto-Remediation for the Installed Applications health class is not
supported.

User Notification Enable sending a remediation message with a list of applications to install
or uninstall to the user.

Monitor Mode Enable Monitor Mode to treat all the installed applications as always
healthy.

Applications Allowed (Mandatory) Specify installed applications to be monitored on a mandatory basis.
NOTE: Enter the application names as they are shown in Add/Remove
Programs.

Applications Allowed (Optional) Specify installed applications to be monitored on an optional basis.
NOTE: Enter the application names as they are shown in Add/Remove
Programs.

Allow only Mandatory and Optional
Applications

Specify that only the mandatory and optional applications are monitored.
NOTE: All applications that are not either mandatory or optional must be
removed or uninstalled.

Table 1: Installed Applications for Windows Configuration Page Parameters
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Enabling Regular Expressions for a Windows Application

To enable regular expressions for an application:

1. From the ClearPass Windows Universal System Health Validator > Configure page (seeClearPass
Windows Universal System Health Validator ), then select the desired version of Windows.

2. Select Installed Applications.

3. Click (enable) the Installed Applications Check is on check box. The Installed Applications dialog
opens (see Figure 274).

4. From the desired Applications Allowed category, click Add.

The Add Mandatory Applications dialog for the selected Applications Allowed category opens.

Figure 275 Enabling Regular Expression

5. Configure the Add Mandatory Applications parameters as described in Table 2.

Parameter Action/Description

Enter the Application
Name

Enter the name of the application.

Enable Regular
Expression

Check (enable) this check box to enable the use of regular expressions in the
Application Name.
When this field is enabled, ClearPass treats the Application Name as a regular
expression when comparing application names.

Remediation Message Optionally, enter the remediation message that will be displayed to the user in the event
of an error.
NOTE: Remediation messages can include reasons for remediation, links to helpful
URLs, and help desk contact information.

Table 2: Mandatory Applications Parameters

6. Click Save.

You return to the Installed Applications dialog, where Regular Expression
Enabled is set to true for the specified application (see Figure 276).
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Figure 276 Regular Expression Enabled

File Check

Use the File Check page to verify the group of files to present or absent. In the File Check page, you can turn
on the file check and specify information about which the files you want to check.

The following figure displays the File Check Health Class configuration page:

Figure 277 Windows File Check Health Class Configuration

The following table describes the File Check Configuration parameters:

Parameter Action/Description

Remediation checks Auto-remediation for the File Check health class is not supported.

User Notification 1. When enabled, a remediation message that includes the groups of files to be
present or absent is displayed to the end user.

Monitor Mode 2. To treat all the file check health classes as always healthy, enable Monitor
Mode.

Table 1: File Check Configuration Parameters
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Parameter Action/Description

File Groups to be Present 3. To add the files to be present in the File Check health class, click Add.

File Groups to be Absent 4. To add the files to be absent in the File Check health class, click Add.

Defining the File Group to Be Present

1. To open the File Group to be Present > Add page, click Add:

You can configure the name of the file group and specify the evaluation rule for the file group.

The following figure displays the File Group to Be Present > Add dialog:

The following table describes the File Group to be Present > Add parameters:

Parameter Action/Description

Enter the File Group
Name

1. Enter the name of the file group.

File Group Evaluation Rule 2. Select the appropriate File Group Evaluation Rule:
n Pass All: Select this evaluation rule if you want the File Check health class to be

deemed as 'healthy' only if all the configured file groups are present.
n Pass Any One: Select this evaluation rule if you want the File Check health class

to be deemed as 'healthy' even if any one of the configured file groups are present.

Table 2: File Group to be Present - Add Parameters

3. To configure the name of the file group and the evaluation rule for the file group, from File Groups to be
Present, click Add.

The following figure displays the File to Be Present > Add page:
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Figure 278 File to be Present > Add Dialog

The following table describes the File to be Present > Add parameters:

Parameter Action/Description

File Location 1. Select any location of the file from the drop-down list:
l SystemDrive
l Systemroot
l ProgramFiles
l ProgramFiles (x86)
l HOMEDRIVE
l HOMEPATH
l None

Enter the File Path 2. Enter the file path as described in the examples from the user interface.

Enter the File Name 3. Enter the name of the file.

Enter the MD5 Sum Optionally, specify one or more (comma separated) MD5 checksums of the process
executable file.

Remediation Message 4. Specify the custom remediation message to be displayed to end users if File
check fails.

Table 3: File to be Present > Add Parameters

5. When finished, click Save.

The parameters configured in the File to be Present > Add dialog are reflected in the File Groups to be
Present page as illustrated in the following figure:
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Figure 279 File Group to be Present Parameters Displayed

Windows System Health Validator: OnGuard Agent
This Windows System Health Validator checks for current Windows Service Packs. The OnGuard Agent also
supports Windows Server 2016, as well legacy Windows operating systems such as Windows Server 2003 and
Windows Server 2012.

Use the check boxes to enable support of specific operating systems and to restrict access based on the Service
Pack level.

To configure the Windows System Health Validator:

1. Navigate to Configuration > Posture > Posture Policies.

2. Click Add.

The Add Posture Policies dialog opens.

Figure 280 Adding a Posture Policy

3. Specify the following:

a. Policy Name: Enter the name and a description of the posture policy.

b. Posture Agent: Choose OnGuard Agent (Persistent or Dissolvable).
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c. Host Operating System: Windows is selected by default.

d. Plugin Version: OnGuard plugin version 2.0 (V4 SDK) is set by default.

4. Click Next.

5. From the Posture Plugins tab, select Windows System Health Validator, then click the Configure
button.

The Windows System Health Validator page opens:

Figure 281 OnGuard Agent: Windows System Health Validator

6. To enable support of specific operating systems, click the corresponding check box.

7. Enter the minimum Service Pack level required on the client computer to connect to your network.

8. Click Save.

You return to the Posture Policies > Posture Plugins page, where the Status column for the Windows
System Health Validator now shows Configured.

Windows Security Health Validator: OnGuard Agent
The Windows Security Health Validator checks for the presence of specific types of security applications. You
can use the options to restrict access based on the absence of the selected security application types.

To configure the Windows Security Health Validator:

1. Navigate to Configuration > Posture > Posture Policies.

2. Click Add.

The Add Posture Policies dialog appears. Specify the following:

a. Policy Name: Enter the name of the posture policy.

b. Posture Agent: Onguard Agent
c. Host Operating System: Windows

3. Click Next.

4. From the Posture Plugins tab, select Windows Security Health Validator, then click the Configure
button.
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The following screen appears:

Figure 282 Onguard Agent: Windows Security Health Validator Page

5. To enable support of specific operating systems, click the corresponding check box.

6. Enter the minimum Service Pack level required on the client computer to connect to your network.

7. Click Save.

ClearPass Linux Universal System Health Validator Plugin
The OnGuard Dissolvable Agent version of the ClearPass Linux Universal System Health Validator plug-
in supports the following health classes:

n Antivirus Health Check on page 307

n Services Health Check on page 310

To configure the ClearPass Linux Universal System Health Validator plugin:

1. Navigate to Configuration > Posture > Posture Policies.

2. Click Add.

The AddPosture Policies dialog opens.
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Figure 283 Adding a Universal System Health Validator for a Linux Posture Policy

3. Specify the following:

a. Policy Name/Description: Enter the name and a description of the posture policy.

b. Posture Agent: Select OnGuard Agent.
c. Host Operating System: Select Linux.

d. Plugin Version: OnGuard Plugin version 2.0 (V4 SDK) is set by default.

4. Click Next. The Posture Plugins dialog opens.

Figure 284 Selecting the ClearPass Linux Universal System Health Validator

5. Select the ClearPass Linux Universal System Health Validator, then click Configure to configure
antivirus settings and service types. The Linux posture plugin configuration dialog opens.

6. From the left pane, select the appropriate Linux OS:

l CentOS

l Fedora

l Red Hat Enterprise Linux

l SUSE Linux Enterprise

l Ubuntu
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Figure 285 Configuring the ClearPass Linux Universal System Health Validator

7. To provide the options to specify the remediation checks, auto remediation, or user notification, enable the
Enable checks for Linux_OS check box .

Antivirus Health Check

Use the Antivirus page to activate an antivirus application.

1. From the left pane, select AntiVirus.

2. To configure the antivirus application, click An antivirus-application is on .

The antivirus health class configuration page opens:

Figure 286 Antivirus Health Class Configuration Page

3. Specify the antivirus health class parameters as described in the following table:
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Parameter Description

Remediation checks Enable to allow auto-remediation for the antivirus health class.

User Notification Enable to allow user notifications in the event of process policy violations. .

Antivirus Shows the name of the antivirus configured.

Prd Version Shows the version of the antivirus.

Eng Version Shows the Engine version of the antivirus.

Dat Version Shows the version of the data file.

Table 1: Antivirus Health Class Configuration Parameters

4. To configure the antivirus product-specific checks, click Add. The antivirus product configuration dialog
opens:

Figure 287 Antivirus Product Configuration Dialog

5. Specify the antivirus product configuration parameters as described in the following table:

Parameter Description

Product-specific checks Select this check box if you want to configure a specific antivirus product. If you want to
allow any antivirus product, do not enable this field.

Select the Antivirus
product

Select the antivirus from the drop-down list.

Product version check Select one of the following options to check the product version:

Table 2: Linux Antivirus Product Configuration Parameters
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Parameter Description

n No Check
n Is Latest
n At Least. When you select At Least, the Version is at Least field appears. Enter

the At Least version you require for the antivirus product version.
n In Last N Updates.

Data file version check Select one of the following options to check the data file version:
n No Check
n Is Latest
n At Least: You can specify the least version that you require for the data file. Enter

the least version in the Version is At Least field. When you select At Least, the Data
file version format option appears.

n In Last N Updates.

Data file version format This field allows admins to specify the data file version format when the At Least
check is selected for Data File Version check.
The configured format is used to compare the configured data file version value with
value received from the client. This field should be configured when the Data file
version value contains a date.
The following format specifiers are supported:
n mm: Month
n dd: Day of the month
n yy or yyyy: Year
n a: Alphabetic
n n: Numeric
NOTE: Characters other than alphabetic and numeric characters are considered as
separators and are not compared.
For example:
n Data file version: 10/14/2018 rev. 10

Specify this data file version format: mm/dd/yyyy aaa. n
n Data file version: 2018.10.08

Specify this data file version format: yyyy.mm.dd
n Data file version: 20181014194001

Specify this data file version format: yyyymmddn
n Data file version: 2018-10-12_04

Specify this data file version format: yyyy-mm-dd_n
NOTE: For antivirus products that do not include a date in the Data file version
check value, this field can be left blank. In such cases, ClearPass compares the value
of the configured data file version with the value received from the client, character by
character.

6. Click Save.

After you save your antivirus health check configuration, it is listed on the Antivirus page.
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Services Health Check

The Services page provides a set of widgets for specifying services to run or stop.

1. Select Services. The Services configuration page opens:

Figure 288 Services Configuration Page

2. Specify the Services page parameters as described in the following table:

Parameter Description

Auto
Remediation

Enable to allow auto remediation for service checks (Automatically stop or start services based on
the entries in Service to run and Services to stop configuration).

User
Notification

Enable to allow user notifications for service check policy violations.

Available
Services

This scrolling list contains a list of services that you can select and move to the Services to run or
Services to stop panels (using their associated widgets). This list varies depending on OS types.
n To add the service(s) to the Services to run pane, select the service(s) in the Available

Services pane, then click >> arrows.
n To add the service(s) to the Services to stop pane, select the service(s) in the Available

Services pane, then click >> arrows.
n To move services from the Services to run or Services to stop panes, select the appropriate

services, then click the corresponding << arrows.

Insert To add a service to the list of available services, enter its name in the text box adjacent to this
button, then click Insert.

Delete To remove a service from the list of available services, select it and click Delete.

Table 3: Services Page

3. Click Save.

ClearPass 6.7 Policy Manager | User Guide Posture Policies and Audit Servers | 310
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1342



311 | Posture Policies and Audit Servers ClearPass 6.7 Policy Manager |  User Guide

After you save your Services health check configuration, it is listed on the Services page.

ClearPass macOS Universal System Health Validator: OnGuard Agent
To configure the ClearPass Universal System Health Validator for macOS:

1. Navigate to Configuration > Posture > Posture Policies, then click Add.

The Add Posture Policies dialog opens.

Figure 289 Adding a Universal System Health Validator for a macOS Posture Policy

2. Specify the following:

a. Policy Name/Description: Enter the name and a description of the posture policy.

b. Posture Agent: Select OnGuard Agent.
c. Host Operating System: Select macOS.
d. Plugin Version: OnGuard Plugin version 2.0 (V4 SDK) is set by default.

3. Click Next.

The Posture Plugins dialog opens.

Figure 290 Selecting the macOS Universal System Health Validator Posture Plug-in

4. In the Posture Plugins page, click the check box for ClearPass macOS Universal System Health
Validator.

5. Click Configure.

The ClearPass macOS Universal System Health Validator configuration page is displayed.

6. To enable checks for mac OS, select the Enable checks for macOS check box.

The following configuration page opens:
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Figure 291 Configuration Page: macOS Universal System Health Validator

Configuring macOS Health Checks
For details on configuring health checks for macOS, refer to the set of health check configuration pages
described in the following sections:

l Services on page 312

l Processes on page 314

l Antivirus on page 317

l Firewall on page 321

l Patch Management on page 323

l USB Devices on page 328

l Virtual Machine on page 329

l Network Connections on page 330

l Disk Encryption on page 332

l Installed Applications on page 335

l File Check

Services

From the Services page, you can configure which services to run and which services to stop.

To add or remove specific services on the endpoint:

1. Navigate to Configuration > Posture > Posture Policies, then click Add.

The AddPosture Policies dialog opens.
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Figure 292 Adding a Universal System Health Validator for a macOS Posture Policy

2. Specify the following:

a. Policy Name/Description: Enter the name and a description of the posture policy.

b. Posture Agent: Select OnGuard Agent.
c. Host Operating System: Select macOS.
d. Plugin Version: OnGuard Plugin version 2.0 (V4 SDK) is set by default.

3. Click Next.

The Posture Plugins dialog opens.

4. Select the ClearPass macOS Universal System Health Validator, then click Configure.

5. To provide the options to specify the remediation checks, auto remediation, or user notification, enable the
Enable checks for macOS check box .

6. Select Services.

The Services health class configuration page opens:

Figure 293 Services Health Class Configuration Page

7. Specify the ClearPass macOS Universal System Health Validator > Services configuration
parameters as described in the following table:
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Parameter Action/Description

Auto Remediation Enable to allow auto-remediation for service checks. Enabling this option automatically
stops or starts services based on the entries in Service to Run and Services to Stop
configuration.
Auto-remediation for the Services health class is enabled by default.

User Notification When enabled, a remediation message that includes the groups of services to be
present or absent is displayed to the end user.

Table 1: Services Configuration Parameters

Specifying the Services to Run

To specify the services to run:

1. Select one or more of the desired services from the Available Services list.

2. To move the desired services to the Services to Run box, click >>, then click Save.

3. You can also add a service to the list of available services. To do so, enter the service name in the Insert text
box, then click Insert.

Specifying the Services to Stop

To specify the services to stop:

1. Select one or more of the desired services from the Available Services list.

2. To move the desired services to the Services to Stop box, click >>, then click Save.

3. You can also add a service to the list of available services. To do so, enter the service name in the Insert text
box, then click Insert.

Processes

The Processes page provides a set of parameters to specify which processes to be explicitly present or absent
on the system.

To view and configure processes:

1. Navigate to Configuration > Posture > Posture Policies, then click Add.

The AddPosture Policies dialog opens.

Figure 294 Adding a Universal System Health Validator for a macOS Posture Policy

2. Specify the following:

a. Policy Name/Description: Enter the name and a description of the posture policy.

b. Posture Agent: Select OnGuard Agent.
c. Host Operating System: Select macOS.
d. Plugin Version: OnGuard Plugin version 2.0 (V4 SDK) is set by default.
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3. Click Next.

The Posture Plugins dialog opens.

4. Select the ClearPass macOS Universal System Health Validator, then click Configure.

5. To provide the options to specify the remediation checks, auto remediation, or user notification, enable the
Enable checks for macOS check box .

6. Select Processes.

The Processes health class configuration page opens:

Figure 295 Processes Page for macOS

7. Specify the Processes configuration parameters as described in the following table:

Parameter Action/Description

Auto Remediation Enable to allow auto-remediation for processes.

User Notification Enable to allow user notifications in the event of process policy violations.

Table 1: Processes Page Parameters

Processes to be Present Parameters

1. In the Processes to be Present section, click Add.
The Add Processes to be Present page opens.

2. To open the page with options to configure the name, location, and display name of the processes, click
Add.

The Process to be Present > Add page opens:
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Figure 296 Processes to be Present > Add Page

3. Specify the Processes to be Present parameters as described in the following table, then click Save:

Parameter Action/Description

Process Location Choose from the following locations:
n Applications
n UserBin
n UserLocalBin
n UserSBin
n None

Enter the Process name Specify the path name containing the process executable name.

Enter the Display name Enter a user-friendly name for the process. This is displayed in end-user facing
messages.

Table 2: Processes to be Present Page Parameters

After you save the Processes parameters, the information appears in the Processes to be Present
section.

Processes to Be Absent Parameters

1. In the Processes to be Absent section, click Add.
The Add Processes to be Absent page opens.

Figure 297 shows the configuration parameters for when you select Process Name and when you select
MD5 Sum.
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Figure 297 Process to Be Absent Pages: Process Name and MD5 Sum

2. Specify the Processes to be Absent parameters as described in the following table, then click Save:

Parameter Action/Description

Check Type Select the type of process check to perform. The agent can look for the following:
l Process Name: The agent looks for all processes that matches with the given

name.
For example, if notepad.exe is specified, the agent kills all processes whose
name matches, regardless of the location from which these processes were
started.

l MD5 Sum: This specifies one or more (comma-separated) MD5 checksums
of the process executable file.
For example, if there are multiple versions of the process executable, you can
specify the MD5 sums of all versions here.
The agent enumerates all running processes on the system, computes the
MD5 sum of the process executable file, and matches this with the specified
list. One or more of the matching processes are then terminated.

Enter the
Display
name

Enter a user-friendly name for the process. This display name is displayed in end-user
facing messages.

Table 3: Processes to Be Absent Page Parameters

You return to the Processes Configuration page, which now shows the values for the processes that were
configured.

Antivirus

On the Antivirus page, you can activate an antivirus application.
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To configure the macOS antivirus health class:

1. Navigate to Configuration > Posture > Posture Policies, then click Add.

The AddPosture Policies dialog opens.

Figure 298 Configuring the Universal System Health Validator for a macOS Posture Policy

2. Specify the following:

a. Policy Name/Description: Enter the name and a description of the posture policy.

b. Posture Agent: Select OnGuard Agent.
c. Host Operating System: Select macOS.
d. Plugin Version: OnGuard Plugin version 2.0 (V4 SDK) is set by default.

3. Click Next. The Posture Plugins configuration dialog opens.

Figure 299 Enabling the ClearPass macOS Universal Health Validator

4. Select the ClearPass macOS Universal System Health Validator, then click Configure.

5. To provide the options to specify the remediation checks, auto remediation, or user notification, enable the
Enable checks for macOS check box .

6. Select Antivirus.

The antivirus health class configuration page opens:

ClearPass 6.7 Policy Manager | User Guide Posture Policies and Audit Servers | 318
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1350



319 | Posture Policies and Audit Servers ClearPass 6.7 Policy Manager |  User Guide

Figure 300 macOS Antivirus Health Check Page

7. Configure the initial antivirus parameters as described in the following table:

Parameter Action/Description

An antivirus-application is on To enable testing of health data for configured antivirus application
(s), click An antivirus-application is on.

Auto Remediation To enable auto remediation of antivirus status, check the Auto
Remediation check box. This option is enabled by default.

User Notification To enable user notification of policy violation of antivirus status,
enable User Notification. This option is enabled by default.

Display Update URL To show the origination URL of the update, check (enable) the
Display Update URL check box . This option is disabled by default.

Table 1: Initial Antivirus Health Class Parameters

8. To specify product and version check information in the antivirus configuration page, click Add.
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Figure 301 Configuring a macOS Antivirus Health Check

9. Specify the antivirus health class parameters as described in the following table:

Parameter Action/Description

Product-specific checks To configure for product-specific checks, leave the check box
checked (the default setting).
To allow any antivirus product, uncheck the check box.
All of these checks may not be available for some products. Where
checks are not available, they are shown in the disabled state.

Select the antivirus product Select an antivirus product from the drop-down list.

Product version check Select one of the following options:
n No Check
n Is Latest: Requires registration with ClearPass portal.
n At Least: When you select At Least, the Version is at Least

field appears. Enter the At Least version you require for the
antivirus product version.

n In Last N Updates: Requires registration with ClearPass Portal.

Data file version check Select one of the following options:
n No Check
n Is Latest: Requires registration with ClearPass portal.
n At Least: You can specify the least version that you require for

the data file. Enter the least version in the Version is At Least
field. When you select At Least, the Data file version format

Table 2: Add Antivirus Health Class Parameters
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Parameter Action/Description

option appears.
n In Last N Updates: Requires registration with ClearPass Portal.

Data file version format This field allows admins to specify the data file version format when
the At Least check is selected for Data File Version check.
The configured format is used to compare the configured data file
version value with value received from the client. This field should
be configured when the Data file version value contains a date.
The following format specifiers are supported:
n mm: Month
n dd: Day of the month
n yy or yyyy: Year
n a: Alphabetic
n n: Numeric
NOTE: Characters other than alphabetic and numeric characters
are considered as separators and are not compared.
For example:
n Data file version: 10/14/2018 rev. 10

Specify this data file version format: mm/dd/yyyy aaa. n
n Data file version: 2018.10.08

Specify this data file version format: yyyy.mm.dd
n Data file version: 20181014194001

Specify this data file version format: yyyymmddn
n Data file version: 2018-10-12_04

Specify this data file version format: yyyy-mm-dd_n
NOTE: For antivirus products that do not include a date in the Data
file version check value, this field can be left blank. In such cases,
ClearPass compares the value of the configured data file version
with the value received from the client, character by character.

Data file has been updated in Enter the number, then specify the interval in hours, days, weeks, or
months.

Last scan has been done before Enter the number, then specify the interval in hours, days, weeks, or
months.

Real-time Protection Status
Check

n No Check: ClearPass does not use the Real-time Protection
status value for health evaluation. This means that the client is
treated as healthy irrespective of the value of its Real-time
Protection status.

n On: Marked as healthy only if the value of Real-time Protection
status is On.

Table 2: Add Antivirus Health Class Parameters

10.Click Save.

When you save your antivirus configuration, it appears in the Antivirus page list.

Firewall

In the Firewall page, you can specify that a Firewall application must be on and specify information about the
Firewall application.

To view and configure processes:

1. Navigate to Configuration > Posture > Posture Policies, then click Add.

The AddPosture Policies dialog opens.
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Figure 302 Adding a Universal System Health Validator for a macOS Posture Policy

2. Specify the following:

a. Policy Name/Description: Enter the name and a description of the posture policy.

b. Posture Agent: Select OnGuard Agent.
c. Host Operating System: Select macOS.
d. Plugin Version: OnGuard Plugin version 2.0 (V4 SDK) is set by default.

3. Click Next.

The Posture Plugins dialog opens.

4. Select the ClearPass macOS Universal System Health Validator, then click Configure.

5. To provide the options to specify the remediation checks, auto remediation, or user notification, enable the
Enable checks for macOS check box .

6. Select Firewall.
The Firewall health class configuration page opens:

7. To configure the firewall application information, click A Firewall Application is On.

The Firewall page opens:

Figure 303 MacOS Firewall Page

8. Specify the initial Firewall parameters as described in the following table:

Parameter Description

A Firewall Application is
On

Check the Firewall Application is On check box to enable testing of health data for
configured firewall application(s).

Auto Remediation Check the Auto Remediation check box to enable auto remediation of firewall status.

User Notification Check the User Notification check box to enable user notification of policy violation of
firewall status.

Table 1: Firewall Page Parameters
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Parameter Description

Product -specific checks To specify Firewall product-specific checks, leave this parameter as is.
To specify whether any firewall application (any vendor) is running on the end host,
uncheck the Uncheck to allow any product check box.

9. To configure different configuration elements specific to the firewall product that you select, from the
Firewall page, click Add .

The Add macOS Firewall page opens.

Figure 304 MacOS Firewall > Add Page

10.Specify the parameters as described in the following table:

Parameter Description

Select the firewall
product

From the drop-down list, select the firewall product.

Product Version is at
least

Optionally, specify the Product Version is at least. Check for the version of the latest
product release.

Table 2: Firewall Page Parameters

11., Click Save.

When you save the firewall configuration, it appears in the Firewall page list.

Patch Management

The Patch Management page provides a way to specify that a patch management application must be on.
You can also specify information about the patch management application, configure the Product Evaluation
Rule, and configure patch management application checks.

To configure patch-management application(s):

1. Navigate to Configuration > Posture > Posture Policies, then click Add.

The Add Posture Policies dialog opens.
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Figure 305 Adding a Universal System Health Validator for a macOS Posture Policy

2. Specify the following:

a. Policy Name/Description: Enter the name and a description of the posture policy.

b. Posture Agent: Select OnGuard Agent.
c. Host Operating System: Select macOS.
d. Plugin Version: OnGuard Plugin version 2.0 (V4 SDK) is set by default.

3. Click Next.

The Posture Plugins dialog opens.

4. Select the ClearPass macOS Universal System Health Validator, then click Configure.

5. To provide the options to specify the remediation checks, auto remediation, or user notification, enable the
Enable checks for macOS check box .

6. Select Patch Management.

The Patch Management health class configuration page opens:

The initial Patch Management configuration dialog opens.

Figure 306 MacOS Patch Management Page

7. Specify the initial Patch Management parameters as described in the following table.

Parameter Action/Description

A patch management
application is on

To enable testing of health data for configured Antivirus application(s), check the A
patch management application is on check box.
The Patch Management configuration dialog opens

Remediation Checks

Auto Remediation To enable auto-remediation of patch management status, check the Auto
Remediation check box .

Table 1: Patch Management Parameters
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Parameter Action/Description

User Notification To enable user notification of policy violation of patch management status, check the
User Notification check box.

Product Evaluation Rule

Product Evaluation Rule Select the appropriate Product Evaluation Rule:
n Pass All: Select this product evaluation rule if you want the Patch Management

health class to be deemed as healthy only if all the configured patch management
products are present.
Pass All is the equivalent of an AND condition.

n Pass Any One: Select this product evaluation rule if you want the Patch
Management health class to be deemed as healthy if any one of the configured
patch management products are present. Pass Any One is the equivalent of an
OR condition. Pass Any One is the default.

8. To configure the options for the specific patch management product, click Add.

The Patch Management > Add page opens:

Figure 307 Patch Management > Add Page

9. Specify the Patch Management parameters as described in the following table:

Parameter Action/Description

Product-specific checks To configure product-specific checks, leave this option as is.
To check whether any patch management application (any vendor) is running on the
end host, clear the Uncheck to allow any product check box.

Select Patch Management
Product

Select a patch management product vendor.
This option is enabled only if the Product-specific checks check box is checked.

Product version is at least Enter the minimally recommended product version number.
This option is enabled only if the Product-specific checks check box is checked.

Table 2: Patch Management Parameters
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Parameter Action/Description

Status Check Type Specify the Status Check Type to check whether the Patch Agent is enabled.
The ClearPass Policy Manager server compares the Patch Agent Status sent by
OnGuard Agent with the configured value. If the Patch Agent Status value is different
from configured value, the client is treated as unhealthy.
If Auto-remediation is enabled, OnGuard Agent changes the Patch Agent Status on
the client to the configured value. Select any of the following options:

l No Check: ClearPass Policy Manager server ignores the Patch Agent
Status value. This means it will not check the status of the Patch Agent
application on the client.

l Enabled: Patch Agent is turned on and it automatically updates the client.
l Disabled: Patch Agent is disabled and it will not check for missing patches

and update the client.
l Notify Before Download: Patch Agent is turned on and it notifies the user

before downloading updates.
l Notify Before Install: Patch Agent is turned on and it notifies the user

before installing updates.
NOTE: The values specific to the selected patch management product are displayed
in the Status Check Type field.
For example, all five values are displayed for Microsoft Windows Automatic Update.
For Microsoft System Center Configuration Manager (SCCM), only No
Check,Disabled, and Notify Before Install are displayed.

Install Level Check Type This option is only enabled if the Product-specific checks check box is checked. For
Microsoft SCCM, selecting All will return the full list of all missing patches.

l No Check:ClearPass Policy Manager server ignores the Patch Agent Status
value. This means it will not check the status of the Patch Agent application
on the client.

l All: Checks for all missing patches and searches for all available patches.
NOTE: If you select the Microsoft Windows Update Agent from the Select Patch
Management product list and you select an option from the Install Level Check
Type list, the results are as follows:

l All: Returns the full list of missing patches.
l No Check: Disables the Grace Period and Scan Interval fields.

Grace Period Configure the time period for which OnGuard Agent should ignore missing patches.
You can specify the grace period in hours, days, weeks, or months.
For example, if the Grace Period is set to 3 days, clients will be treated as healthy for
three days even if some patches are missing. After three days, OnGuard Agent will
treat clients as unhealthy if the patches are still missing. You can enable Auto-
remediation to install the missing patches and to treat them as healthy.
If you selected No Check from the Install Level Check Type field, Grace Period is
disabled.

Scan Interval Specify the Scan Interval by specifying the number of hours, days, weeks, or months.
If you selected No Check from the Install Level Check Type field, Scan Interval is
disabled.

10.Click Save.

When you save the patch management configuration, the configuration information is displayed on the
Patch Management page:

Peer To Peer

From the Peer To Peer page, you can view and add peer-to-peer applications.

To view and configure processes:

1. Navigate to Configuration > Posture > Posture Policies, then click Add.

The AddPosture Policies dialog opens.
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Figure 308 Adding a Universal System Health Validator for a macOS Posture Policy

2. Specify the following:

a. Policy Name/Description: Enter the name and a description of the posture policy.

b. Posture Agent: Select OnGuard Agent.
c. Host Operating System: Select macOS.
d. Plugin Version: OnGuard Plugin version 2.0 (V4 SDK) is set by default.

3. Click Next.

The Posture Plugins dialog opens.

4. Select the ClearPass macOS Universal System Health Validator, then click Configure.

5. To provide the options to specify the remediation checks, auto remediation, or user notification, enable the
Enable checks for macOS check box .

6. Select Peer to Peer.

7. To provide configuration options to specify peer-to-peer applications or networks that need to be explicitly
stopped, click A Peer to Peer application is on.

The Peer to Peer health class configuration page opens:

Figure 309 Peer To Peer Page

8. Specify the Peer to Peer parameters as described in the following table:
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Parameter Description

Auto Remediation Enable to allow auto remediation for service checks (Automatically stop peer-to-peer
applications based on the entries in Applications to stop configuration).

User Notification Enable to allow user notifications for peer-to-peer application/network check policy
violations.

By Application
By Network

Select the appropriate radio button to select individual peer-to-peer applications or a group
of applications that use specific peer-to-peer networks.
When you select a peer-to-peer network, all applications that make use of that network are
stopped.

Available
Applications

This scrolling list contains a list of applications or networks that you can select and move to
the Applications to stop pane.
n Select the applications or networks in the Available Applications pane, then click the >>

to add the applications or networks to the Applications to stop pane.

Applications to
Stop

n Select the applications or networks in the Applications to stop pane, then click the << to
move the applications or networks to the Available Applications pane.

Table 1: Peer-to Peer-Page Parameters

9. Click Save.

USB Devices

The USB Devices page provides configuration to control USB mass storage devices attached to an endpoint.

Use this page to configure the Auto Remediation and User Notification parameters. You can also configure
the options to take remediation action for USB mass storage devices or to remove USB mass storage devices
from the Remediation Action for USB Mass Storage Devices drop-down.

The following figure displays the USB Devices page:

Figure 310 USB Devices Page
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The following table describes the USB Devices parameters:

Parameter Description

Auto Remediation Enable to allow auto remediation for USB mass storage devices attached to the
endpoint (automatically stop or eject the drive).

User Notification Enable to allow user notifications for USB devices policy violations.

Remediation Action for USB
Mass Storage Devices

n No Action - Take no action; do not eject or disable the attached devices.
n Remove USB Mass Storage Devices - Eject the attached devices.
n Remove USB Mass Storage Devices - Stop the attached devices.

Table 1: MacOS USB Devices Parameters

Virtual Machine

The Virtual Machines page provides configuration options to virtual machines utilized by the network.

1. Select the Virtual Machine Detection is on option to enable the Auto Remediation and User
Notification options.

The macOS Virtual Machine page opens:

Figure 311 Virtual Machine Page

The following table describes the Virtual Machines parameters:

Parameter Description

Auto Remediation Enable to allow auto remediation for virtual machines connected to
the endpoint.

User Notification Enable to allow user notifications for virtual machine policy violations.

Allow access to clients running on Virtual
Machine

Enable to allow clients that running a VM to be accessed and
validated.

Table 1: Virtual Machines
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Parameter Description

Allow access to clients hosting Virtual
Machine

Enable to allow clients that hosting a VM to be accessed and validated.

Remediation Action for clients hosting
Virtual Machines

n No Action: Take no action; do not stop or pause virtual machines.
n Stop all virtual machines running on Host: Stop the VM clients that

are running on the host.
n Pause all virtual machines running on Host: Pause the VM clients

that are running on the host.

2. Click Save.

Network Connections

The Network Connections page provides configuration options to control network connections based on
connection type.

To configure Network Connections:

1. From the ClearPass macOS Universal System Health Validator page, enable checks for macOS.

2. Select Network Connections.

3. Enable the Network Connection Check is on check box to provide the options to specify the
remediation checks or user notification.

The Network connections page opens:

Figure 312 Network Connections Page

4. Select the Check for Network Connection Types check box.

5. To specify type of network connection, click Configure.

The Network Connection Types configuration page opens.
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Figure 313 Network Connections Configuration Page

6. Specify the Network Connection Types configuration parameters as described in the following table:

Parameter Action/Description

Allowed Network Connections
Type

Select one of the following options:
n Allow Only One Network Connection
n Allow One Network Connection with VPN
n Allow Multiple Network Connections

Network Connection Types To add or remove Others, Wired, and Wireless network connection types, click
>> or <<.

Remediation Action for
Network Connection Types Not
Allowed

Specify one of the following
n No Action: Take no action. Do not eject or disable the attached devices.
n Disable Network Connections
n Disconnect Network Connections

Click Save.

Table 1: Network Connection Type Configuration Parameters

7. Click Save.

This returns you to the Network Connections configuration page. The following table describes the
Network Connections configuration parameters on this page:
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Parameter Action/Description

Auto Remediation Enable this option to allow auto-remediation for network connections.

User Notification Enable this option to allow user notifications in the event of network connection policy
violations.

Remediation Action for
Bridge Network
Connection

If Allow Bridge Network Connection is disabled, then specify whether to take no
action when a bridge network connection exists or to disable all bridge network
connections.

Remediation Action for
Internet Connection
Sharing

If Allow Internet Connection Sharing is disabled, then specify whether to take no
action when Internet connection sharing exists or to disable Internet connection
sharing.

Remediation Action for
Adhoc/Hosted Wireless
Networks

If Allow Adhoc/Hosted Wireless Networks is disabled, then specify whether to take
no action when an adhoc wireless network exists or to disable all adhoc/hosted
wireless networks.

Table 2: Network Connections Configuration Parameters

Disk Encryption

Disk encryption is a technology that protects information by converting it into unreadable code that cannot be
deciphered easily by unauthorized people. Disk encryption uses disk encryption software or hardware to
encrypt every bit of data that goes on a disk or disk volume. Disk encryption prevents unauthorized access to
data storage.

To configure disk encryption for macOS:

1. Navigate to Configuration > Posture > Posture Policies.

The Posture Policies page opens.

2. Click the Add link.

The Posture Policies > Add page opens.

Figure 314 Configuring Disk Encryption for a macOS Posture Policy

3. Specify the following:

a. Policy Name/Description: Enter the name and a description of the posture policy.

b. Posture Agent: Select OnGuard Agent.
c. Host Operating System: Select macOS.

d. Plugin Version: OnGuard Plugin version 2.0 (V4 SDK) is set by default.

4. Click Next.
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The Posture Plugins dialog opens.

5. Select the check box for the ClearPass macOS Universal System Health Validator, then click the Configure
button.

6. From the ClearPass macOS Universal System Health Validator page, enable checks for macOS.

7. From the list of macOS health checks, select Disk Encryption.

8. To provide the options to specify the remediation checks, auto remediation, or user notification, enable the
A disk encryption application is on check box .

The Disk Encryption page opens:

Figure 315 MacOS Disk Encryption Page

9. To configure the product specific encryption checks, click Add.

The Disk Encryption Add page opens.
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Figure 316 Disk Encryption Add Page

10.Specify the macOS Disk Encryption health check parameters as described in the following table:

Parameter Action/Description

User Notification Enable to allow user notifications for disk encryption policy violations.

Product-specific checks If you wish to select a specific disk encryption product, do not change the
default setting.
To allow any encryption product to check disk encryption, select the
Uncheck to allow any product check box.
The Select Disk Encryption product and Product Version is at least fields are
disabled after you uncheck theUncheck to allow any product check
box.

Select Disk Encryption
product

Select a specific disk encryption product.

Product Version is at least Search for the production version of the selected product.

Locations to Check Select the locations to check disk encryption. The options are:
n None
n System Root Drive
n All Drives
n Specific Locations

Locations to Exclude Specify locations that should be excluded from disk encryption checks.
During posture evaluation, ClearPass does not check the encryption state
of the drives specified in Locations to Exclude. Locations to Exclude is
optional and is shown only when Locations to Check is set to All Drives.
This field accepts a list of locations separated by a new line.
NOTE: On macOS, the ClearPass OnGuard Agent automatically excludes
the Recovery and Virtual Memory (VM) partitions from disk encryption
checks.

Table 1: MacOS Disk Encryption Health Check Parameters

ClearPass 6.7 Policy Manager | User Guide Posture Policies and Audit Servers | 334
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1366



335 | Posture Policies and Audit Servers ClearPass 6.7 Policy Manager |  User Guide

11.Click Save.

Installed Applications

The Installed Applications category groups classes that represent software-related objects.

From the Installed Applications page, you can specify information about which installed applications you
want to monitor.

To configure the installed applications for macOS:

1. Navigate to Configuration > Posture > Posture Policies, then click Add.

The AddPosture Policies dialog opens.

Figure 317 Adding a Universal System Health Validator for a macOS Posture Policy

2. Specify the following:

a. Policy Name/Description: Enter the name and a description of the posture policy.

b. Posture Agent: Select OnGuard Agent.
c. Host Operating System: Select macOS.
d. Plugin Version: OnGuard Plugin version 2.0 (V4 SDK) is set by default.

3. Click Next.

The Posture Plugins dialog opens.

4. Select the ClearPass macOS Universal System Health Validator, then click Configure.

5. To provide the options to specify the remediation checks, auto remediation, or user notification, enable the
Enable checks for macOS check box .

6. Select Installed Applications.

7. To provide the options to specify the remediation checks, auto remediation, or user notification, enable the
Installed Application Check is on check box .

The Installed Applications health check configuration page opens:
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Figure 318 Installed Applications Page for macOS

8. Specify the Installed Applications for macOS Configuration page parameters as described in the
following table:

Parameter Action/Description

Remediation checks Auto-Remediation for the Installed Applications health class is not
supported.

User Notification Enable sending a remediation message with a list of applications to install
or uninstall to the user.

Monitor Mode Enable Monitor Mode to treat all the installed applications as always
healthy.

Applications Allowed (Mandatory) Specify installed applications to be monitored on a mandatory basis.
NOTE: Enter the application names as they are shown in Add/Remove
Programs.

Applications Allowed (Optional) Specify installed applications to be monitored on an optional basis.
NOTE: Enter the application name as they are shown in Add/Remove
Programs.

Allow only Mandatory and Optional
Applications

Specify that only the mandatory and optional applications are monitored.
NOTE: All applications that are not either mandatory or optional must be
removed or uninstalled.

Table 1: Installed Applications for macOS Configuration Page Parameters

9. Click Save.

Enabling Regular Expressions for a macOS Application

To enable regular expressions for an application:

1. From the ClearPass macOS Universal System Health Validator > Configure page (see ClearPass
macOS Universal System Health Validator: OnGuard Agent), select Installed Applications.

2. Click (enable) the Installed Applications Check is on check box.
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The Installed Applications dialog appears (see Figure 318 above).

3. From the Applications Allowed (Mandatory) category, click Add.

The Add Mandatory Applications dialog appears (see Figure 319).

Figure 319 Enabling Regular Expression

4. Configure the Add Mandatory Applications parameters as described in Table 2.

Parameter Action/Description

Enter the Application
Name

Enter the name of the application.

Enable Regular
Expression

Check (enable) this check box to enable the use of regular expressions in the Application
Name.
When this field is enabled, ClearPass treats the Application Name as regular expression
when comparing application names.

Remediation Message Optionally, enter the remediation message that will be displayed to the user in the event
of an error.
NOTE: Remedition messages can include reasons for remediation, links to helpful URLs
and helpdesk contact information.

Table 2: Add Mandatory Applications Parameters

5. Click Save.

You return to the Installed Applications dialog, where Regular Expression
Enabled is set to true for the specified application.

File Check

From the File Check page, you can turn on the file check feature and specify information about which the files
you want to check.

Use the File Check page to verify the group of files to be present or absent.

To configure macOS File Check:

1. Navigate to Configuration > Posture > Posture Policies, then click Add.

The AddPosture Policies dialog opens.
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Figure 320 Adding a Universal System Health Validator for a macOS Posture Policy

2. Specify the following:

a. Policy Name/Description: Enter the name and a description of the posture policy.

b. Posture Agent: Select OnGuard Agent.
c. Host Operating System: Select macOS.
d. Plugin Version: OnGuard Plugin version 2.0 (V4 SDK) is set by default.

3. Click Next.

The Posture Plugins dialog opens.

4. Select the ClearPass macOS Universal System Health Validator, then click Configure.

5. To provide the options to specify the remediation checks, auto remediation, or user notification, enable the
Enable checks for macOS check box .

6. Select File Check.

The File Check health class configuration page opens:

The following figure is an example of the File Check health class configuration dialog:

Figure 321 MacOS File Check Health Class Configuration

7. Specify the File Check Configuration parameters as described in the following table:
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Parameter Action/Description

Remediation checks Auto-remediation for the File Check health class is not supported.

User Notification When enabled, a remediation message that includes the groups of files to be present
or absent is displayed to the end user.

Monitor Mode To treat all the file check health classes as always healthy, enable Monitor Mode.

File Groups to be Present To add the files to be present in the File Check health class, click Add.

File Groups to be Absent To add the files to be absent in the File Check health class, click Add.

Table 1: File Check Configuration Parameters

8. To open the File Group to be Present > Add page, click Add:

You can configure the name of the file group and specify the evaluation rule for the file group.

The File Group to Be Present > Add dialog opens:

Figure 322 MacOS File Group to Be Present > Add Dialog

Specify the File Group to Be Present > Add parameters as described in the following table:

Parameter Action/Description

Enter the File Group
Name

Enter the name of the file group.

File Group Evaluation Rule Select the appropriate File Group Evaluation Rule:
n Pass All: Select this evaluation rule if you want the File Check health class to be

deemed as 'healthy' only if all the configured file groups are present.
n Pass Any One: Select this evaluation rule if you want the File Check health class

to be deemed as 'healthy' even if any one of the configured file groups are present.

Table 2: File Group to Be Present > Add Parameters

9. To configure the name of the file group and the evaluation rule for the file group, from File Groups to be
Present, click Add.

The File to Be Present > Add page opens:
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Figure 323 File to be Present > Add Dialog

10.Specify the File to Be Present > Add parameters as described in the following table:

Parameter Action/Description

File Location Select any location of the file from the drop-down list:
n Applications
n UserBin
n UserLocalBin
n UserSBin
n None

Enter the File Path Enter the file path as described in the examples provided.

Enter the File Name Enter the name of the file.

Enter the MD5 Sum Optionally, you can specify one or more (comma-separated) MD5 checksums of the
process executable file.

Remediation Message Specify the custom remediation message to be displayed to end users if File check
fails.

Table 3: File to Be Present > Add Parameters

11.When finished, click Save.

The parameters configured in the File to Be Present > Add dialog are reflected in the File Groups to be
Present dialog.

Configuring NAP Agent Plugins
If your posture policy is using a NAP agent, the Posture Plugins tab allows you to configure the following
plug-in types:

n Windows System Health Validator: NAP Agent on page 341

n Windows Security Health Validator: NAP Agent on page 342

ClearPass 6.7 Policy Manager | User Guide Posture Policies and Audit Servers | 340
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1372



341 | Posture Policies and Audit Servers ClearPass 6.7 Policy Manager |  User Guide

The following figure displays the NAP Agent - Posture Plugins tab:

Figure 324 NAP Agent - Posture Plugins Options

Windows System Health Validator: NAP Agent
The Windows System Health Validator NAP (Network Access Protection) Agent checks for the level of Windows
Service Packs.

To configure the minimum service pack level required, perform the following steps:

1. Navigate to Configuration > Posture > Posture Policies.

The Posture Policies page appears.

2. Click Add.

The Add Posture Policies > Policy dialog opens.

Figure 325 Adding a Windows NAP Agent Posture Policy

3. Specify the following:

a. Policy Name/Description: Enter the name and description of the posture policy.

b. Posture Agent: Select NAP Agent.
c. Host Operating System: Select Windows.

4. Click Next.

The Posture Policies > Posture Plugins page opens.
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Figure 326 Posture Plugins for Windows Health Validators

5. From the Posture Plugins tab, select Windows System Health Validator, then click the Configure
button.

The Windows System Health Validator page appears:

Figure 327 Onguard NAP Agent: Windows System Health Validator

6. To enable support of specific Windows operating systems, click the corresponding check boxes.

7. Enable the Restrict clients... check box and specify the minimum Service Pack level required on the client
computer to connect to your network.

8. Click Save.

You return to the Posture Plugins page where the status of the plug-in is now set to Configured.

Windows Security Health Validator: NAP Agent
The Windows Security Health Validator: NAP (Network Access Protection) Agent checks for the presence of
specific types of security applications. You can use the check boxes to restrict access based on the absence of
the selected security application types.

To configure the minimum service pack level required, perform the following steps:

1. Navigate to Configuration > Posture > Posture Policies.

The Posture Policies page appears.

2. Click Add.

The Add Posture Policies dialog appears.
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Figure 328 Adding Windows Security Health Validator: NAP Agent Posture Policy

3. Specify the following:

a. Policy Name: Enter the name of the posture policy.

b. Posture Agent: Select NAP Agent.

c. Host Operating System: Select Windows.

4. Click Next.

The Posture Policies > Posture Plugins page appears.

Figure 329 Selecting Posture Plugins for Windows Security Health Validator: NAP Agent

5. From the Posture Plugins page, select Windows Security Health Validator, then click Configure.

The Windows System Health Validator page appears:.

6. Click the Enable checks for Windows 10 check box.

The Windows Security Health Validator configuration page appears as shown in Figure 330.
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Figure 330 Windows Security Health Validator

7. To enable support of specific operating systems, click the corresponding check boxes.

8. Click Save.

You return to the Posture Plugins page where the status of the Windows Security Health Validator plug-in
is now Configured.

Configuring Posture Policy Rules
Once you have defined the posture hosts, agents, and plug-ins, you must configure the rules for the posture
policy.

To configure posture policy rules:

1. Navigate to Configuration > Posture > Posture Policies, then click the Add link.

The Add Posture Policies dialog opens.

2. Click the Rules tab.

The Posture Policy Rules Editor opens.

3. Click Add Rule.

The Rules Editor opens.
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Figure 331 Posture Policy Rules Tab and Rules Editor

4. Specify the Rules Editor configuration parameters as described in the following table:

Parameter Action/Description

Select Plugin
Checks

Click select one of the following plugin check types for System Health Validators.:
n Passes all System Health Validators checks
n Passes one or more System Health Validators checks
n Fails all System Health Validators checks
n Fails one or more System Health Validators checks

Select Plugins Select the plug-in to which the plug-in checks should apply.

Posture Token Select one of the following posture tokens:
n HEALTHY (0). This is the default.
n CHECKUP (10)
n TRANSITION (15)
n QUARANTINE (20)
n INFECTED (30)
n UNKNOWN (100)

Table 1: Posture Policy Rules Editor Parameters

Configuring Posture for Services
Policy Manager can forward all or part of the posture data received from the client to a posture server. The
posture server evaluates the posture data and returns application posture tokens. Policy Manager supports
the Microsoft NPS Server for Microsoft NAP integration. To configure the posture for a service, navigate to the
Add Service (Configuration > Services > Add) page. The Posture tab is not enabled by default. To enable
posture checking for this service, select the Posture Compliance check box from the More Options field on
the Service tab.

You can enable the posture checking for this kind of service, if you deploy any of the following:

n Policy Manager in a Microsoft Network Access Protection (NAP)

n Cisco Network Admission Control (NAC) Framework environment

n Aruba hosted captive portal that performs posture checks through a dissolvable agent
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The following figure displays an example on how to configure a posture at the service level:

The Posture Compliance check box must be selected on the Service tab in order for posture to be enabled.

Figure 332 Posture Features at the Service Level

You can configure the following components of a posture:

Configurable
Component How to Configure

Sequence of Posture
Policies

Select a policy, then select Move Up, Move Down, Remove, or View Details.
n To add a previously configured policy, select from the Select drop-down

list, then click Add.
n To configure a new policy, click the Add link at the top-right corner of the

Configuration > Posture Policies page. For more information, see
Creating a New Posture Policy.

n To edit the selected posture policy, click Modify.

Default Posture
Token

The default posture token is UNKNOWN (100). You can select the default
posture token from the drop-down list.

Remediation End-
Hosts

Select this check box to enable auto-remediation action on non-compliant
endpoints.

Table 1: Posture Features at the Service Level
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Configurable
Component How to Configure

Remediation URL This URL defines where to send additional remediation information to
endpoints.

Sequence of Posture
Servers

Select a posture server, then select Move Up, Move Down, Remove, or View
Details.
n To add a previously configured posture server, select from the Select drop-

down list, then click Add.
n To configure a new posture server, click Add link at the top-right corner of

the Configuration > Posture Policies page. For more information, see
Adding and Modifying Posture Servers.

n To edit the selected posture server, click Modify. For more information,
see Adding and Modifying Posture Servers.

Enable auto-
remediation of non-
compliant end-hosts

Select the Enable auto-remediation of non-compliant end-hosts check box
to enable the specified remediation server to enable auto-remediation.
Remediation server is optional. A popup appears on the client box with the URL
of the remediation server.

Configuring Audit Servers
The ClearPass Policy Manager server contains default Nessus (v2.X through v6.x) and Nmap (Network
Mapping) servers. For enterprises with existing audit server infrastructure, or with external audit servers, Policy
Manager supports these servers externally.

For more information, see:

n Audit Service Flow Control

n Default Audit Servers

n Custom Audit Servers

n Post-Audit Rules

Audit Service Flow Control
Audit servers evaluate posture, role, or both for unmanaged or unmanageable clients. One example is clients
that lack an adequate posture agent or an 802.1X supplicant. For example, printers, PDAs, or guest users might
not be able to send posture credentials or identify themselves.

A Policy Manager Service can trigger an audit by sending a client ID to a pre-configured audit server, and the
server returns attributes for role mapping and posture evaluation.

Audit servers are configured at a global level. Only one audit server can be associated with a service. The flow-
of-control of the audit process is shown in the figure below.

Figure 333 Flow of Policy Manager Auditing Control
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Default Audit Servers
When you configure an audit as part of a Policy Manager service, you can select the default Nessus (Nessus
Server) or the Nmap Audit configuration.

Adding Auditing to a Service
To configure an audit server for a new service:

1. Navigate to Configuration > Services.

The Services page opens.

2. Select the Add link in the top-right corner.

The Add Services dialog opens.

3. To display the Audit tab, select the More Options > Audit End-Hosts check box.

4. In the Add Services dialog, select the Audit tab.

The Add Services > Audit dialog opens.
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Figure 334 Add Services > Audit Dialog

5. Complete the fields in the Add Services > Audit tab as described in Table 1, then click Save.
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Parameter Action/Description

Audit
Server

Select a server profile from the list:
n Nessus Server: Performs vulnerability scanning and returns a Healthy/Quarantine

result.
n Nmap Audit: Performs network port scans. The health evaluation always returns a

Healthy result. The port scan gathers attributes that allow determination of role(s)
through post-audit rules.

You can click the View Details button to view the Policy Manager Entity Details
dialog with the summary of audit server details.
To view the Summary tab with audit server details, click the Modify button.
For Policy Manager to trigger an audit on an end-host, it needs to get the IP address of
the end-host. The IP address of the end-host is not available at the time of initial
authentication for 802.1X and MAC authentication requests. Policy Manager's DHCP
snooping service examines the DHCP request and response packets to derive the IP
address of the end-host.
For this to work, you need to use this service, Policy Manager must be configured as a
DHCP “IP Helper” on your router/switch in addition to your main DHCP server. Refer to
your switch documentation for “IP Helper” configuration.

To audit devices that have a static IP address assigned, it is recommended that you
create a static binding between the MAC address and IP address of the endpoint in your
DHCP server. Refer to your DHCP server documentation for configuring static bindings.
NOTE: Policy Manager does not issue the IP address; it only examines the DHCP traffic
to derive the IP address of the end-host.

Audit
Trigger
Conditions

Select from the following audit trigger conditions:
n Always: Always perform an audit.
n When posture is not available: Perform audit only when posture credentials are

not available in the request.
n For MAC Authentication Request: If you select this option, then Policy Manager

presents the following three additional settings:
l For known end-hosts only: Select this option when you want to reject

unknown end-hosts and to audit known clients. Known end-hosts are defined
as clients that are found in the authentication source(s) associated with this
service.

l For unknown end-hosts only: Select this option when known end-hosts are
assumed to be healthy, but you want to establish the identity of unknown end-
hosts and assign roles. Unknown end-hosts are end-hosts that are not found
in any of the authentication sources associated with this service.

l For all end-hosts: For both known and unknown end-hosts.

Action after
audit

Select an Action after audit.
Performing an audit on a client is an asynchronous task, which means the audit can be
performed only after the MAC authentication request is completed and the client has
acquired an IP address through DHCP. Once the audit results are available, there
should be a way for Policy Manager to re-apply policies on the network device. This can
be accomplished in one of the following ways:
n No Action: The audit will not apply policies on the network device after this audit.
n Do SNMP bounce: This option will bounce the switch port or force an 802.1X

reauthentication (both done using SNMP). Bouncing the port triggers a new
802.1X/MAC authentication request by the client.
If the audit server already has the posture token and attributes associated with this
client in its cache, it returns the token and the attributes to Policy Manager.

n Trigger RADIUS CoA action: This option sends a RADIUS CoA command to the
network device.

Table 1: Add Services > Audit Dialog Parameters

Modifying Default Audit Servers
To reconfigure default Policy Manager audit servers:
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1. Navigate to Configuration > Posture > Audit Servers.

Figure 335 Audit Servers Page

2. Select an audit server from the list of available servers.

The Edit Audit Servers page opens.

3. Modify the profile, plugins, and/or preferences.

n In the Audit tab, you can modify the In-Progress Posture Status and Default Posture Status.

n If you selected a Nessus Server, the Primary Server and Backup Server tabs allow you to specify a
scan profile. In addition, when you add a new scan profile, you can select plugins and preferences for the
profile. Refer to Nessus Scan Profiles on page 355 for more information.

The default Policy Manager Nessus audit server ships with approximately 1,000 of the most commonly
used Nessus plugins.

Rules Tab

In the Rules tab, you can create post-audit rules for determining roles based on identity attributes discovered
by the audit. For more information on creating post-audit rules, see Post-Audit Rules on page 360.

Custom Audit Servers
This section provides the following information:

n Adding a Nessus Audit Server on page 351

n Required Configuration Updates for External Nessus Servers

n Adding an Nmap Audit Server on page 358

For enterprises with existing audit server infrastructure or preferring custom audit servers, Policy Manager
supports Nessus (v2.x through v6.x) and Nmap scans using the NMAP plug-in on external Nessus servers.

Adding a Nessus Audit Server
ClearPass uses the Nessus audit server interface primarily to perform vulnerability scanning. It returns a result
of Healthy orQuarantine.

To add a Nessus audit server:

Audit Tab

1. Navigate to Configuration > Posture > Audit Servers, then click the Add link.

The Add Audit Servers dialog opens to the Audit tab.
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Figure 336 Add Nessus Audit Server > Audit Tab

2. Specify the Nessus Audit Server > Audit tab parameters as described in Table 1.

Parameter Action/Description

Name Specify the name of the audit server.

Description Optionally (and recommended), enter the description that provides
additional information about the audit server.

Type Specify the type of audit server: Nessus.

In-Progress Posture
Status

Specify the posture status during audit:
n Healthy (0)
n Checkup (10)
n Transition (15). This is the default setting.
n Quarantine (20)
n Infected (30)
n Unknown (100)

Default Posture Status Specify the posture status if evaluation does not return a condition or
action match. The default setting is UNKNOWN.

Table 1: Add Nessus Audit Server > Audit Tab Parameters

Primary Server and Backup Server Tabs

The Primary Server and Backup Server tabs specify connection information for the Nessus audit server.
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Figure 337 Add Nessus Audit Server > Primary and Backup Server Tabs

1. Specify the Nessus Audit Server > Primary Server tab and Backup Server tab parameters as described
in Table 2.

Parameter Action/Description

Backup On the Backup Server dialog:
For the backup server to be invoked on primary server failover, check the
Enable to use backup when primary does not respond check box.

Nessus Server Name Enter the name of the Nessus server

Nessus Server Port Specify the Nessus Server port. The default is 1241.

Username Enter the username for the primary and backup Nessus server

Password Enter the password for the primary and backup Nessus servers.

Scan Profile You can accept the default scan profile or select Add > Edit Scan Profile
to create other profiles and add them to the scan profile list. For details,
refer to Nessus Scan Profiles on page 355.

In-Progress Timeout Specify the duration (in seconds) before polling for Nmap results. The
default is 30 seconds.

Table 2: Add Nessus Audit Server > Primary and Backup Server Tabs Parameters

2. Configure the audit server Rules.

The Rules tab specifies rules for post-audit evaluation of the request to assign a role. For more information,
refer to Post-Audit Rules on page 360.
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Modifying a Nessus Audit Server

To modify an existing Nessus audit server:

1. Navigate to Configuration > Posture > Audit Server.

The Audit Servers dialog opens.

Figure 338 Selecting a Nessus Audit Server

2. Select the Nessus audit server you wish to modify.

The Edit Nessus Server dialog opens to the Summary tab, which displays the configuration settings for
the selected Nessus server.

Figure 339 Edit Nessus Server > Summary Page

3. Make any necessary configuration changes, then click Save.
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Required Configuration Updates for External Nessus Servers

To properly support Nessus server configuration on ClearPass servers, you must make the following
configuration settings on the external Nessus server:

1. On the external Nessus server, set the value for the disable_ntp parameter to no.

For example, on a CENTOS/RHEL server running Nessus, you would enter the following command:
centos# /opt/nessus/sbin/nessuscli fix --set disable_ntp=no

2. Restart the Nessus service.

For example:
centos# service nessusd restart

3. If the external Nessus server has Transport Layer Security (TLS) enabled, add the Nessus CA Certificate to
the ClearPass Certificate Trust List (see Certificate Trust List).

You can download the Nessus CA certificate from:
https://<nessus_server_name>:8834/getcert

Nessus Scan Profiles

A scan profile contains a set of scripts (plugins) that perform specific audit functions.

To add or edit scan p[rofiles:

1. Navigate to Configuration > Posture > Audit Servers.

2. Select the Primary Server tab.

3. From the Primary Server tab, click the Add/Edit Scan Profile link.

The Nessus Scan Profile Configuration page opens.

Figure 340 Nessus Scan Profile Configuration Page

4. You can refresh the plugins list (after uploading plugins into Policy Manager, or after refreshing the plugins
on your external Nessus server) by clicking Refresh Plugins List.

The Nessus Scan Profile Configuration page provides three views for scan profile configuration:

a. The Profile tab identifies the profile and provides a mechanism for selection of plugins:

From the Filter plugins by family drop-down list, select a family to display all available member plugins in the
list below. You may also enter the name of a plugin in Filter plugins by ID or name text box.

Select one or more plugins by enabling their corresponding check boxes (at left). Policy Manager will remember
selections as you select other plugins from other plugin families.
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When finished, click the Selected Plugins tab.

Figure 341 Nessus Scan Profile Configuration > Profile Tab

b. The Selected Plugins tab displays all selected plugins, plus any dependencies.

5. To display a synopsis of any listed plugin, click on its row.

Figure 342 Nessus Scan Profile Configuration Profile Tab > Plugin Synopsis
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Of special interest is the section of the synopsis entitled Risks. To delete any listed plugin, click on its corresponding
trashcan icon. To change the vulnerability level of any listed plugin, click on the link to change the level to one of
HOLE, WARN, or INFO. This action tells Policy Manager the vulnerability level that is considered to be assigned
QUARANTINE status.

Figure 343 Nessus Scan Profile Configuration > Selected Plugins Tab

Figure 344 Nessus Scan Profile Configuration Selected Plugins Tab > Vulnerability Level

For each selected plugin, the Preferences tab contains a list of fields that require entries.

In many cases, these fields will be pre-populated. In other cases, you must provide information required for the
operation of the plugin.

By way of example of how plugins use this information, consider a plugin that must access a particular service,
in order to determine some aspect of the client’s status; in such cases, login information might be among the
preference fields.

Figure 345 Nessus Scan Profile Configuration > Preferences Tab
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After saving the profile, plugin, and preference information for your new (or modified) plugin, you can go to the
Primary/Backup Servers tabs and select it from the Scan Profile drop-down list.

Adding an Nmap Audit Server

Policy Manager uses the Nmap audit server interface exclusively for network port scans.

n The Health evaluation always returns a status of Healthy.

n The port scan gathers attributes that allow determination of role(s) through post-audit rules.

To create an Nmap (Network Mapping) audit server:

1. Navigate to the Configuration > Posture > Audit Servers page, then click Add.

2. From the Audit tab, select the NMAP radio button in the Type field.

Audit Tab

You can use the Audit tab to identify the server and define configuration details.

Figure 346 NMAP Audit Server > Audit Tab

Specify the parameters configured in the Audit tab as described in the following table:

Table 17: Audit Tab Parameters

Parameter Action/Description

Name Enter the name of the NMAP audit server.

Description Optionally (and recommended), enter the description of the Nmap audit server.

Type Select NMAP.

In-Progress
Posture Status

Specify the posture status during audit:
n Healthy (0)
n Checkup (10)
n Transition (15). This is the default setting.
n Quarantine (20)
n Infected (30)
n Unknown (100)

Default Posture
Status

Select the posture status if evaluation does not return a condition/action match.
The default setting is UNKNOWN .
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NMAP Options Tab

You can use the NMAP Options tab to specify the type of scan configuration.

Figure 347 Nmap Server > NMAP Options Tab

Table 18: NMAP Options Tab

Parameter Action/Description

TCP Scan Specify the type of TCP (Transmission Control Protocol) scan:
n TCP SYN scan
n TCP Connect scan
n TCP Null Scan
n TCP FIN scan
n TCP Xmas scan
n TCP ACK scan
n TCP Window scan
n TCP Maimon scan
Refer to Nmap documentation for more information on the TCP scan options.
Nmap option: scanflags.

UDP Scan To enable UDP (User Datagram Protocol) scanning, check the UDP Scan check
box.
Nmap option: sU.

Service Scan Enable this scan to identify all the services and their versions running on your
target application's server.
To enable Service scanning, check the Service Scan check box
Nmap option: sV.

Detect Host
Operating System

To enable host OS detection, check the Detect Host Operating System check
box.
NMAP option: A.
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Parameter Action/Description

Port Range Specify the range of ports to scan. Specify the range with a hyphen. For example,
to scan ports 25 to 50, you would enter 25-50.
NMAP option: p.

Host Timeout Specify the time in seconds for the target host to timeout.
Nmap option: host-timeout

In-Progress
Timeout

Specify the duration (in seconds) before polling for Nmap results.

Rules Tab

The Rules tab specifies rules for post-audit evaluation of the request to assign a role. For details, refer to Post-
Audit Rules on page 360.

Figure 348 Configuring Audit Server Rules

Post-Audit Rules
The Audit Servers > Rules dialog specifies rules for post-audit evaluation of the request to assign a role.

Figure 349 All Audit Server Configurations > Rules Dialog
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Parameter Action/Description

Rules Evaluation
Algorithm

Select first matched rule and return the role or Select all matched rules and
return a set of roles.

Add Rule When you add a rule, the Rules Editor opens. See below for details.

Move Up/Down Reorder the rules as necessary.

Edit Rule Opens the selected rule in Edit mode.

Remove Rule Removes the selected rule.

Table 1: All Audit Server Configurations > Rules Dialog Parameters

Figure 350 All Audit Server Configurations > Rules Editor

Parameter Description

Conditions The Conditions list includes five dictionaries:
n Audit-Status
n Device-Type
n Output-Msgs
n MAC-Vendor
n Network-Apps
n Open-Ports
n OS-Info
For more information, refer to Namespaces.

Actions The Actions list includes the names of the roles configured in Policy Manager.

Save To commit a Condition/Action pairing, click Save.

Table 2: All Audit Server Configurations > Rules Editor Parameters
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Chapter 7
Configuring Enforcement Profiles

and Policies

This chapter describes the following topics:

n Configuring Enforcement Profiles on page 362

n Configuring Enforcement Policies on page 418

n Configuring Deep-Nested Active Directory Queries

ClearPass Policy Manager controls network access by sending a set of access-control attributes to the Network
Access Device (NAD) from which the network-access request originates.

ClearPass Policy Manager sends these attributes by evaluating an enforcement policy associated with the
service.

Each enforcement policy is a rule or set of rules for matching conditions (role, posture, and time) to actions,
which are specified in enforcement profiles.

Configuring Enforcement Profiles
n Adding an Enforcement Profile

n Modifying an Existing Enforcement Profile

You can configure Policy Manager enforcement profiles globally, but they must be referenced to an
enforcement policy that is associated with a service.

For information about configuring specific enforcement profiles, see:

n Agent Enforcement Profile

n Agent Script Enforcement Profile

n Aruba Downloadable Role Enforcement Profile

n Aruba RADIUS Enforcement Profile

n Cisco Downloadable ACL Enforcement Profile

n Cisco Web Authentication Enforcement Profile

n ClearPass Entity Update Enforcement Profile

n CLI-Based Enforcement Profile

n Filter ID Based Enforcement Profile

n Generic Application Enforcement Profile

n HTTP Based Enforcement Profile on page 401

n RADIUS Based Enforcement Profile

n RADIUS Change of Authorization (CoA) Profile

n Session Restrictions Enforcement Profile

n SNMP-Based Enforcement Profile

n TACACS+ Based Enforcement Profile

n VLAN Enforcement Profile

Adding an Enforcement Profile
To add an enforcement profile:

1. Navigate to Configuration > Enforcement > Profiles.
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The Enforcement Profiles page opens:

Figure 351 Enforcement Profiles Page

2. Click the Add link.

The Add Enforcement Profile dialog opens.

Figure 352 Add Enforcement Profile Dialog

The following table describes the default set of enforcement profiles included with Policy Manager:

Enforcement Profile Type Description

[Aerohive - Terminate
Session]

RADIUS_CoA System-defined profile to disconnect user (Aerohive)

[AirGroup Personal
Device]

RADIUS System-defined profile for an AirGroup personal device
request

[AirGroup Response] RADIUS System-defined profile for any AirGroup request

Table 1: Default Enforcement Profiles
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Enforcement Profile Type Description

[AirGroup Shared Device] RADIUS System-defined profile for an AirGroup shared device
request

[Allow Access Profile] RADIUS System-defined profile to allow network access

[Allow Application Access
Profile]

Application System-defined profile to allow access to an application

ArubaOS Switching -
Bounce Switch Port

RADIUS_CoA System-defined profile to bounce the switch port on
ArubaOS Switching products.

ArubaOS Switching -
Terminate Session

RADIUS_CoA System-defined profile to disconnect the user on
ArubaOS Switching, HP ProCurve, and HP UWW (Unified
Wired-WLAN) products.

ArubaOS Wireless -
Bounce Switch Port

RADIUS_CoA System-defined profile to bounce the switch port on
ArubaOS Mobility Controllers, Multi-Port APs, and
Mobility Access Switches.

[ArubaOS Wireless -
TACACS Read-Only
Access]

TACACS System-defined profile for TACACS read-only access on
ArubaOS Mobility Controllers, Aruba Instant APs, and
Mobility Access Switches.

[ArubaOS Wireless -
TACACS root Access]

TACACS System-defined profile for TACACS root access on
ArubaOS Mobility Controllers, Aruba Instant APs, and
Mobility Access Switches.

[Aruba Wireless -
Terminate Session]

RADIUS_CoA System-defined profile to disconnect the user on
ArubaOS Mobility Controllers, Aruba Instant APs, and
Mobility Access Switches.

[Cisco - Bounce-Host-Port] RADIUS_CoA System-defined profile to bounce the host port (Cisco)

[Cisco - Disable Host-Port] RADIUS_CoA System-defined profile to disable the host port (Cisco)

[Cisco - Reauthenticate-
Session]

RADIUS_CoA System-defined profile to re-authenticate session (Cisco)

[Cisco - Terminate-
Session]

RADIUS_CoA System-defined profile to disconnect a user (Cisco)

[Deny Access Profile] RADIUS System-defined profile to deny network access

[Deny Application Access
Profile]

Application System-defined profile to deny access to an application

[Drop Access Profile] RADIUS System-defined profile to drop the request

[H3C - Bounce Switch Port] RADIUS_CoA System-defined profile to bounce the switch port on H3C
products (including HPE FlexNetwork/Comware)

[H3C - Disable Switch Port] RADIUS_CoA System-defined profile to disable the switch port on H3C
products (including HPE FlexNetwork/Comware)

[H3C - Terminate Session] RADIUS_CoA System-defined profile to disconnect the user on H3C
products (including HPE FlexNetwork/Comware)
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Enforcement Profile Type Description

[Handle AirGroup Time
Sharing]

HTTP System-defined profile to send time-based sharing policy
to the AirGroup notification service

[Juniper Terminate
Session]

RADIUS_CoA System-defined profile to disconnect a user (Juniper)

[Motorola - Terminate
Session]

RADIUS_CoA System-defined profile to disconnect a user (Motorola)

[Operator Login - Admin
Users]

Application Enforcement profile for Guest admin logins

[Operator Login - Local
Users]

Application Enforcement profile for Guest operator logins

[TACACS API Admin] TACACS API admin access for ClearPass Policy Manager Admin

[TACACS Deny Profile] TACACS System-defined profile to deny network access

[TACACS Help Desk] TACACS Help desk access for ClearPass Policy Manager Admin

[TACACS Network Admin] TACACS Network admin access for ClearPass Policy Manager
Admin

[TACACS Read-only
Admin]

TACACS Read-only admin access for ClearPassPolicy Manager
Admin

[TACACS Receptionist] TACACS Receptionist access for ClearPassPolicy Manager Admin

[TACACS Super Admin] TACACS Super admin access for ClearPass Policy Manager
Admin

[Trapeze - Terminate
Session]

RADIUS_CoA System-defined profile to disconnect a user (Trapeze)

[Update Endpoint Known] Post-
Authentication

System-defined profile to change an Endpoint's status to
Known

Modifying an Existing Enforcement Profile
To modify an existing enforcement profile:

1. Navigate to the Configuration > Enforcement > Profiles page.

2. Click the name of the profile in the Enforcement Profile list that you wish to modify.

The Edit Enforcement Profile dialog for the selected profile opens. The parameters vary according to
which profile is selected.

3. Make the necessary changes in the Profile and Attributes dialogs, then click Save.

Agent Enforcement Profile
To configure profile and attribute parameters for an Agent Enforcement profile:

1. Navigate to Configuration > Enforcement > Profiles.

The Enforcement Profiles page opens.

2. Click Add.

Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1397



The Add Enforcement Profiles > Profile tab opens.

3. From the Template drop-down, select Agent Enforcement.

The Agent Enforcement > Profile dialog opens.

Figure 353 Agent Enforcement > Profile Tab

4. Specify the Add Agent Enforcement > Profile parameters as described in the following table:

Parameter Action/Description

Template Select Agent Enforcement from the drop-down list.

Name Enter the name of the enforcement profile.

Description Optionally, enter a description of the enforcement profile (recommended).

Type This field is populated automatically with type Agent.

Action By default, this field is disabled. It is enabled only when RADIUS type is selected.

Device Group
List

Select a device group from the drop-down list. The list displays all configured device groups.
All configured device groups are listed in the Configuration > Network > Device Groups
page. After you add one or more device groups, you can select a group and take one of the
following actions:
n To delete the selected Device Group List entry, click Remove.
n To see the device group parameters, click View Details.
n To change the parameters of the selected device group, click Modify.

Add New
Device Group

To add a new device group, click the Add New Device Group link. For more information, see
Adding and Modifying Device Groups.

Table 1: Add Agent Enforcement > Profile Parameters
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Configuring Agent Enforcement Attributes
Use the Attributes tab to configure the attribute name and attribute value for each attribute you add.

Figure 354 Agent Enforcement > Attributes Dialog

Specify the Agent Enforcement > Attributes parameters as described in the following table:

Attribute Name Action/Description

Bounce Client To bounce the network interface, set the value to True.

Message Enter the message that needs to be notified on the endpoint.

Session Timeout (in
seconds)

Configure the agent session timeout interval to periodically evaluate the endpoint's
health.
OnGuard Agent performs health checks after the specified session timeout interval and
updates the health status of the endpoint in Policy Cache.
You can specify the session timeout interval from 60 to 600 seconds. The default value
is 0.
NOTE: Setting the lower value for the session timeout interval results in numerous
authentication requests in the Access Tracker page.

Health Check interval
(in hours)

Specify the health-check interval value in hours for different Agent Enforcement Profiles
for different users. The allowed range is 0 to 1000 hours.
NOTE: The value of the Policy result cache timeout parameter (see Administration
> Server Manager > Server Configuration > Cluster-Wide Parameters > General tab)
must be greater than the highest value of all the Health Check Interval (in hours)
values.
Note the following information:
n You can set the Health Check Interval if OnGuard mode is set to Health only.
n This parameter is valid only for wired and wireless interface types.
n This parameter is not applicable for the OnGuard Dissolvable Agent, VPN, and Other

interface types.

Enable to hide Retry
button

To hide the Retry button in the OnGuard Agent, set the value to True.

Enable to hide Logout
button

To hide the Logout button in the OnGuard Agent, set the value to True.

Enable to hide Logout
option

To hide all Quit options in the OnGuard Agent, set the value to True.

Bounce Delay (in
seconds)

When Bounce Delay is configured, the network interface is bounced after the specified
delay.

Table 2: Agent Enforcement > Attributes Tab Parameters
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Attribute Name Action/Description

Show Custom UI for
Custom Scripts

Click the check box to set this attribute to True and enable the OnGuard Agent
Remediation User Interface for Custom Scripts (for related information, refer to the
Custom User Interface parameter in Creating OnGuard Custom Web Pages).

SDK Type Allows you to specify the V4 OnGuard Detection SDK (for related information, see
Upgrading From OnGuard Plugin Version 1.0 to 2.0).

Enable to auto update
OnGuard Agent Library

When this option is enabled and a new version of OnGuard Agent Library is available on
the ClearPass server, ClearPass OnGuard Agent automatically downloads and installs
the new version of OnGuard Agent Library from the ClearPass server. OnGuard
modules, including detection libraries for client programs (V4 SDK), can be upgraded
without having to upgrade your ClearPass or OnGuard installations (for more
information, see OnGuard Agent Library Updates).

Summary Information
The Summary tab summarizes the parameters configured in the Profile and Attribute tabs.

Figure 355 Agent Enforcement > Summary Tab

Agent Script Enforcement Profile
This section provides the following information:

n Introduction

n Configuring the Agent Script Enforcement Profile

n Configuring Agent Script Enforcement Attributes

n Viewing the Configuration Summary

Introduction
Agent Script Enforcement profiles allow execution of custom scripts on endpoint devices as part of agent
enforcement. All the details of custom script configuration, such as the path of the custom script, the
command to be executed, execution level, and so on, are configured in the Agent Script Enforcement profile.

You can select multiple Agent Script Enforcement Profiles in a rule in an enforcement profile. OnGuard Agent
executes them one after another.

The Agent Script Enforcement profile is currently supported only with the OnGuard Agent for Windows.

OnGuard Agent applies the Agent Script Enforcement profile (that is, it executes a custom script) after first
applying Agent Enforcement profiles (that is, after Agent Bounce is executed, if configured).
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While applying an Agent Script Enforcement profile, OnGuard Agent does not check to see if a script is already
running. It is possible for OnGuard Agent to launch the script multiple times if a previously launched script is
still running. This can occur if OnGuard Agent performs multiple health checks (either manually triggered or
caused by a change in health status). The script exits after performing its task.

Mandatory Agent Script Attributes

The following attributes are mandatory when configuring Agent Script Enforcement:

n Path of the Script

n Command to Execute

n Execution Level

Optional Agent Script Attributes

The following attributes are optional when configuring Agent Script Enforcement:

n SHA256 Checksum

n Wait Time (Seconds) Before Executing Script

n Pass Health Evaluation Results to Script

n Success Message

n Failure Message

n Progress Message

n Description

n Download URL

n Script Execution Timeout (Seconds)

Configuring the Agent Script Enforcement Profile
To configure an Agent Script Enforcement profile:

1. Navigate to Configuration > Enforcement > Profiles.

The Enforcement Profiles page opens.

2. Click the Add link. The Add Enforcement Profiles dialog opens to the Profile tab.

Figure 356 Agent Script Enforcement > Profile Dialog

3. Specify the Add Agent Script Enforcement > Profile parameters as described in the following table:
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Parameter Action/Description

Template Select the Agent Script Enforcement template.

Name Enter the name of the enforcement profile.

Description Optionally, enter a description of the enforcement profile (recommended).

Type This field is populated automatically with type Agent.

Action This parameter is disabled because it is not applicable to the Agent Script Enforcement Profile.

Device Group
List

This parameter is disabled because it is not applicable to the Agent Script Enforcement Profile.

Add new Device
Group

This parameter is disabled because it is not applicable to the Agent Script Enforcement Profile.

Table 1: Add Agent Script Enforcement > Profile Parameters

Configuring Agent Script Enforcement Attributes
Use the Attributes tab to configure the attribute name and attribute value for each attribute you add. The
following figure displays the Agent Script Enforcement > Attributes dialog:

Figure 357 Agent Script Enforcement > Attributes Dialog

1. Specify the Agent Script Enforcement > Attributes parameters as described in the following table:
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Attribute Action/Description

Path of the Script Complete the path of the script/program, including the filename. This attribute checks
for the existence of a file on an endpoint device and also verifies the SHA256
Checksum.

Command to Execute Specify the complete command that OnGuard Agent should execute. You can use the
command to launch scripts or pass command line arguments.
For example, to launch VBScript (InstallHotfixes.vbs) and pass All as an argument, you
would enter the following:
cscript /nologo C:\Test\InstallHotfixes.vbs All
If it is not required to pass arguments, set the value of this attribute to the same value
specified for Path of the Script.

SHA256 Checksum Specify the SHA256 checksum of the script or program. This attribute accepts comma-
separated multiple SHA256 checksums to allow execution of different versions of same
script or program.

Execution Level The attribute values are: User and System.
n To launch the script/program as the current logged-on user, select User.
n To launch the script/program as the system user with admin rights, select System.

Wait Time (Seconds)
Before Executing Script

Specify the time (in seconds) after which OnGuard Agent should launch the
script/program.
When Wait Time Before Executing Script is configured, the OnGuard Agent does not
process events such as Interface Up/Interface Down and health changes during the wait
time.

Pass Health Evaluation
Results to Script

Check the check box (which sets the value to true) to enable OnGuard Agent to pass
health evaluation results to the script/program as an argument. The default is false.
n When the Pass Health Evaluation Results to Script attribute is set to true,

OnGuard Agent passes health evaluation results to the script in a URL Encoded JSON
format.

n URL Encode replaces double quotes, spaces, and Unicode characters with their
ASCII value in %XX format. For example, spaces are replaced by %20 and double
quotes are replaced by %22.

Success Message Enter the message to be shown to the end user when the script or program is launched
successfully.

Failure Message Enter the message to be shown to the end user when execution of the script or program
fails.

Progress Message This message will be shown on the OnGuard Progress Page (see OnGuard Settings and
Agent Library Updates) while OnGuard Agent is executing the custom script and states
what action is being performed.

Table 2: Agent Script Enforcement > Attributes Parameters

Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1403



Attribute Action/Description

Description Provides a description of the custom user interface window or script.

Download URL If the script or program configured in the Path of the Script attribute is not present on
the client machine, enter the URL of the remote server from which OnGuard Agent can
download the script or program.
n OnGuard Agent supports downloading scripts only from HTTP and HTTPS URLs.
n For HTTPS URLs, OnGuard skips server certificate verification.
NOTE: OnGuard Agent does not support downloading files from URLs that require
credentials.

Script Execution Timeout
(Seconds)

Specify the Script Execution Timeout attribute value in the number of seconds. The
value must be an integer between 60 and 3600.
When this attribute is configured, OnGuard Agent waits for the specified time for the
custom script to finish execution. If the custom script does not finish execution within
the specified time, OnGuard Agent returns failure for that script.

When this attribute is not configured, OnGuard Agent uses varying timeout values,
depending upon whether or not custom remediation is enabled.
n When Custom Remediation is enabled: the default value is 20 minutes.
n When Custom Remediation is not enabled: 1 minute.

2. Click Save.

Viewing the Configuration Summary
The Summary page summarizes the parameters configured in the Profile and Attribute tabs.

The following figure displays the Agent Script Enforcement > Summary page:

Figure 358 Agent Script Enforcement > Summary Dialog

Aruba Downloadable Role Enforcement Profile
n Profile Configuration on page 373

n Role Configuration Mode: Standard on page 374

n Role Configuration Mode: Advanced

n Adding a Stateless Access Control List

n Adding a Session Access Control List

n Adding an Ethernet/MAC Access Control List

n Role Configuration Mode: Advanced

n Summary Information on page 388
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Profile Configuration
Use the Profile tab to configure the template, type of the profile, and the device group list, as well as specifying
the Role Configuration Mode—Standard or Advanced.

n Standard mode: User-provided options to configure individual components of a role (for example, Policer
Profile, Stateless ACL configuration, etc.). The user role is generated based on components added to the
configuration.

n Advanced mode: You can enter the entire role configuration as a text under a single attribute.

Events are logged in the Audit Viewer for create, update, and delete operations in the Captive Portal, Policy,
and Class configurations. Events are also logged for generated user roles and import/export operations in
enforcement profiles.

To configure the Aruba Downloadable Role Enforcement Profile:

1. Navigate to Configuration > Enforcement > Profiles.

The Enforcement Profiles page opens.

2. Click the Add link.

The Add Enforcement Profile page opens.

3. From the Template drop-down, select Aruba Downloadable Role Enforcement.

Figure 359 Aruba Downloadable Role Enforcement > Profile Page (Standard Mode)

4. Specify the Aruba Downloadable Role Enforcement > Profile parameters as described in the following
table:

Parameter Action/Description

Template Select the Aruba Downloadable Role Enforcement template.

Name Enter the name of the enforcement profile.

Description Enter a description of the enforcement profile.

Type This field is automatically populated with: RADIUS.

Action Click Accept, Reject, or Drop to define the action taken on the request. The default
action is Accept.

Table 1: Aruba Downloadable Role Enforcement > Profile Parameters
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Parameter Action/Description

Device Group List Select a device group from the drop-down list. The list displays all configured device
groups. All configured device groups are listed in the Configuration > Network >
Device Groups page. After adding one or more device group(s), you can select a
group and perform one of the following actions:
n To delete the selected Device Group List entry, click Remove.
n To see the device group parameters, click View Details.
n To change the parameters of the selected device group, click Modify.

Add New Device Group To add a new device group, click the Add New Device Group link. For more
information, see Adding and Modifying Device Groups.

Role Configuration Mode Select one of the following modes:
n Standard (the default)
n Advanced

Product Specify one of the following products:
n ArubaOS-Switch
n Mobility Access Switch (MAS)
n Mobility Controller

Role Configuration Mode: Standard
When Role Configuration is set to Standard (the default), the Role Configuration tab appears. In Standard
mode, the Role Configuration tab includes only the options that are appropriate for the selected product.

Role Configuration Page: Aruba-OS Switch

The fields on the Role Configuration tab vary according to which product you specify. The example below
displays the Role Configuration page when you specify the Aruba-OS Switch product. This page provides
support for class configuration for the ArubaOS-Switch, and the Role Configuration tab includes a Manage
Classes link.

Figure 360 Role Configuration Page: ArubaOS-Switch
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The following table describes the Role Configuration parameters when the Product parameter is set to
Aruba-OS Switch:

Parameter Action/Description

Captive Portal Profile Select the captive portal profile from the drop-down list if already configured.
Click the Add Captive Portal Profile link to add a new captive portal profile. For
more information, see Captive Portal Profile on page 381.

Policy Select the Enforcement Policy from the drop-down list if already configured.
Click the Add Policy link to add a new policy. See Policy Configuration Page: Aruba-
OS Switch > Rule Configuration for more information.

Secondary Role Type Specify one of the following secondary role types:
n None
n Static: When selected, the Controller Static Role field appears.
n Dynamic: When selected, the Controller Downloadable Role field appears.

VLAN Specify one of the following VLAN identifiers:
n None
n ID: When selected, the VLAN ID Tagged <number> field appears. Enter the VLAN

ID number.
n Name: When selected, the VLAN Name field appears. Enter the VLAN name.

VLAN Tagged Specify one of the following VLAN Tagged identifiers:
n None
n ID: When selected, the VLAN ID Tagged <number> field appears. Enter the VLAN

ID Tagged number.
n Name: When selected, the VLAN Name Tagged field appears. Enter the VLAN

tagged name..

Re-Authentication Period Specify the ArubaOS switch re-authentication period in seconds.

Class Configuration Select the Manage Class link to add, edit, or delete Class definitions.

User Role Configuration Select the Summary tab to view the generated User Role configuration.

Table 2: Role Configuration Page: ArubaOS-Switch Parameters

Policy Configuration Page: Aruba-OS Switch > Rule Configuration

When you select the Add Policy link, the following configuration dialog opens:
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Figure 361 Policy Configuration Page

Enter the appropriate values for each of the fields in the Policy Configuration > Rule Configuration dialog,
then click Save Rule.

Parameter Action/Description

Number Enter a number.

Class For the packet match, select one of the following:
n Ignore
n Match

Class Name Specify the appropriate class name from the drop-down.

Action Select the desired action from the drop-down list.

IP DSCP <0-63> Enter a number from 0 to 63 to indicate the IP DSCP.

IP Precedence <0-7> Specify the IP precedence by entering a number from 0 to 7.

Priority Enter a number from 0 to 7 to indicate Priority.

Rate Limit kpbs Specify the rate limit in KB per second.

Table 3: Policy Configuration Page: ArubaOS-Switch Parameters

Role Configuration Page: Aruba-OS Switch > Class Configuration

You can create and configure traffic classes and you can map the enforcement policy to the traffic classes.

When you select the Manage Classes link, the following configuration dialog opens:

ClearPass 6.7 Policy Manager | User Guide Configuring Enforcement Profiles and Policies | 376
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1408



377 | Configuring Enforcement Profiles and Policies ClearPass 6.7 Policy Manager |  User Guide

Figure 362 ArubaOS Switch Class Configuration Dialog

Specify the ArubaOS Switch Class Configuration parameters as described in the following table.

Parameter Action/Description

Select Class Name Select the class name from the drop-down list if already configured.

Name Enter the Class name.

Traffic Specify one of the following traffic types:
n IPv4
n IPv6
n MAC

Table 4: Class Configuration Page: ArubaOS-Switch Parameters

When you click the Rule Configuration tab, the following dialog opens:

Figure 363 ArubaOS Switch Class Configuration > Rule Configuration Dialog
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Specify the Rule Configuration parameters as described in the following table:

Parameter Action/Description

Number Enter a number.

Packet Match For the packet match, select one of the following:
n Ignore
n Match

Protocol Specify the appropriate traffic protocol from the drop-down.

Source Select one of the following sources:
n Any
n Host
n IP Subnet. When you select IP Subnet, you are prompted for the Source Value

(the IP subnet address).

Source Port Select one of the following options:
n Equal to Port
n Greater than Port
n Less than Port
n Except Port
n Port Range <1-65535>

Source Port Value Specify the source port value.

Destination Select one of the following destinations:
n Any
n Host
n IP Subnet. When you select IP Subnet, you are prompted for the Source Value

(the IP subnet address).

Destination Port Select one of the following options:
n Equal to Port
n Greater than Port
n Less than Port
n Except Port
n Port Range <1-65535>

Destination Port Value Specify the destination port value.

IP DSCP Specify the differentiated services code point (DSCP).

VLAN ID Specify the VLAN ID

IP Precedence Specify the IP precedence:
n Routine
n Priority
n Immediate
n Flash
n Flash Override
n Critical

Table 5: Rule Configuration Page: ArubaOS-Switch Parameters
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Parameter Action/Description

n Internet
n Network

IP Type of Service Specify one of the following for the type of service:
n Normal
n Max Reliability
n Max Throughput
n Minimum Delay

TCP Packets Bit Sets Select one of the following:
n Established
n Fin: The FIN flag indicates the end of data transmission to finish a TCP

connection.
n Rst: Sets the Reset flag.
n Syn: The SYN flag synchronizes sequence numbers to initiate a TCP connection.

Role Configuration Page: Mobility Access Switch

Many of the fields require you to select a link to launch a new page where you set role configuration profiles
and related parameters.

Figure 364 Role Configuration Page > Product: Mobility Access Switch
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The following table describes the Role Configuration parameters when the Product parameter is set to
Mobility Access Switch:

Parameters Action/Configuration

Captive Portal Profile Select the captive portal profile from the drop-down list if already configured.
Click the Add Captive Portal Profile link to add a new captive portal profile. For
more information, see Captive Portal Profile on page 381.

Policer Profile Select the policer profile from the drop-down list if already configured. Click Add
Policer Profile link to add a new policer profile. For more information, see Policer
Profile on page 381.

QoS Profile Select the QoS profile from the drop-down list if already configured. Click Add QoS
Profile link to add a new QoS profile. For more information, see QoS Profile on page
381.

VoIP Profile Select the VoIP profile from the drop-down list if already configured. Click Add VoIP
Profile link to add a new VoIP profile. For more information, see VoIP Profile on page
382.

Reauthentication Interval
Time (0-4096)

Enter the number of minutes between reauthentication intervals. You can select the
range between 0 to 4096 minutes.

VLAN To Be Assigned (1-
4904)

Enter a number between 1 and 4094 that defines when the VLAN is to be assigned.

NetService Configuration Select the Manage NetServices link to add, edit, and delete the NetService
definitions. For more information, see NetService Configuration.

NetDestination
Configuration

Select the Manage NetDestinations link to add, edit, and delete the
NetDestinations definitions. For more information, see NetDestination
Configuration.

Time Range
Configuration

Select the Manage Time Ranges link to add, edit, and delete time range definitions.
For more information, see Time Range Configuration.

NAT Pool Configuration Select the Manage NAT Pool link to add, edit and delete NAT Pool definitions. For
morfe information, see NAT Pool Configuration.

ACL Type Select from the following ACL types:
n Ethertype
n MAC
n Session
n Stateless

ACL Name Click the name of the ACL type.
n To move the ACL Name to the ACL field, click Add.
n To modify the order of the names in the ACL list, click Move Up, Move Down.
n To delete an ACL from the list, click Remove.

User Role Configuration Check the Summary tab for the generated role configuration.

Table 6: Role Configuration Parameters > Product: Mobility Access Switch
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Captive Portal Profile

To define the Captive Portal Profile:

1. Click the Add Captive Portal Profile link.

The Add Captive Portal Profile dialog opens:

Figure 365 Add Captive Portal Configuration Profile

2. Enter a name of the profile and configure the required attributes.

Policer Profile

To define a Policer Profile:

1. Click the Add Policer Profile link.

The Add Policer Profile dialog opens:

Figure 366 Add Policer Configuration Profile

2. Enter a name of the profile and configure the required attributes.

QoS Profile

To define a QoS Profile:

1. Click the Add QoS Profile link.

The Add QoS Profile opens:
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Figure 367 Add QoS Profle Configuration Profile

2. Enter a name of the profile and configure the required attributes.

VoIP Profile

To define a VoIP Profile:

1. Click the Add VoIP Profile link.

The Add VoIP Profile dialog opens:

Figure 368 Add VoIP Configuration Profile

2. Enter a name for the profile and configure the required attributes.

NetService Configuration

To define a NetService Configuration profile:

1. Click the Manage NetServices link.

The NetService dialog opens:
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Figure 369 NetService Configuration Profile

2. Enter a name for the profile and configure the required attributes.

NetDestination Configuration

To define a NetDestination Configuration profile:

1. Click the Manage NetDestinations link.

The NetDestinations dialog opens:

Figure 370 Net Destinations Configuration Profile

2. Enter a name for the profile and configure the required attributes.

Time Range Configuration

To define a Time Range Configuration profile:

1. Click the Manage Time Ranges link.

The Time Range Configuration dialog opens:
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Figure 371 Time Range Configuration Profile

2. Enter a name for the profile and configure the required attributes.

NAT Pool Configuration

To define a NAT (Network Address Translation) Pool Configuration profile:

1. Click the Manage NAT Pool Configuration link.

The NAT Pool Configuration dialog opens:

Figure 372 NAT Pool Configuration Profile

2. Enter a name for the profile and configure the required attributes.

Adding a Stateless Access Control List

To add a Stateless Access Control List:

1. Click the Add Stateless Access Control List link.

The Stateless Access Control List Configuration dialog opens:
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Figure 373 Stateless Access Control List Configuration Profile

2. Enter a name for the Stateless ACL.

3. On the General tab, click the Add Rule link.

The Rule Configuration dialog opens.

4. Enter the required attributes in the Rule Configuration dialog.

5. Click Save Rule.

Adding a Session Access Control List

To add a Session Access Control List:

1. Click the Add Session Access Control List link.

The Session Access Control List Configuration dialog opens.

2. Enter a name for the Session ACL.

3. On the General tab, click the Add Rule link.

The Rule Configuration dialog opens.

Figure 374 Session Access Control List Rule Configuration Profile

You can view different fields depending on the Action type you choose. For example, if you select the dual-
nat action type, you can view the Dual NAT Pool field additionally to specify the action.

4. Enter the required attributes in the Rule Configuration dialog.
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5. Click Save Rule.

Adding an Ethernet/MAC Access Control List

To add an Ethernet/MAC Access Control List:

1. Click the Add Ethernet/MAC Access Control List link.

The Session Access Control List Configuration dialog opens.

The ACL Type is set to Ethertype.

Figure 375 Ethernet/MAC Access Control List Configuration Profile

2. Enter a name for the Ethernet/MAC Access Control List.

3. Enter the required attributes in the Rules section of the page and click Reset, then click Save Rule.

4. When finished, click Save.

Role Configuration Mode: Advanced
When you set Role Configuration Mode to Advanced, the Enforcement Profile page displays the Attributes
tab (see Figure 376 below).

In Advanced mode, the Aruba Downloadable Role Enforcement profile provides two dictionaries and two
attributes. The supported dictionaries and their associated attributes are:

n Dictionary: Aruba
Attribute: Aruba-CPPM-Role
The Aruba-CPPM-Role attribute supports Mobility Access Switches.

n Dictionary: Hewlett-Packard Enterprise
l Attribute: HPE-CPPM-Role

The HPE-CPPM-Role attribute supports ArubaOS Switches.

l Attribute: HPE-CPPM-Secondary-Role
This attribute adds support for a downloadable secondary role that can be used with Per User Tunneled
Node (PUTN). When the attribute is added to the enforcement profile, ClearPass can send the controller
role for the ArubaOS switch.

You can use only one of the Advanced mode dictionaries at any given time; these dictionaries can't both be used at
the same time.
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Configuring the Advanced Attributes

To configure the Aruba Downloadable Role Enforcement > Advanced attributes:

1. Navigate to Configuration > Enforcement > Profiles > Add.
2. Select Aruba Downloadable Role Enforcement from the Template drop-down list.

The following fields appear:

a. Role Configuration Mode: Select Advanced.

b. Product: Select ArubaOS-Switch.

Figure 376 Downloadable Role Enforcement > Profile Tab (Advanced Mode)

3. Next, select the Attributes tab.

Figure 377 Configuring HPE-CPPM-Role Attribute

The Radius:Hewlett-Packard Enterprise> HPE-CPPM-Role attribute is selected by default.

4. To specify the Hewlett-Packard Enterprise dictionary and attribute:

a. Type: Hewlett-Packard Enterprise

b. Name: Select HPE-CPPM-Role (27) or HPE-CPPM-Secondary-Role (28).

In Advanced mode, a validation check is not available for downloadable role names that are greater than 64
characters. This is due to a limitation on the switch. Thus, if a downloadable role name configured on the ClearPass
server exceeds 64 characters, the enforcement profile may fail on the switch.

c. Value: Enter the appropriate ArubaOS switch commands.

5. Click Save.
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Summary Information
For a profile in Standard Role Configuration Mode, the Summary tab summarizes the parameters configured
in the Profile and Role Configuration tabs.

For a profile in Advanced Role Configuration Mode, the Summary tab summarizes the parameters configured
in the Profile and Attribute tabs.

Aruba RADIUS Enforcement Profile
This section describes the following Aruba RADIUS Enforcement profile features:

n Profile Configuration on page 388

n Attributes Configuration on page 389

n Summary Information on page 390

Profile Configuration
Use the Profile tab to configure the template, type of the profile, and device group list. The following figure
displays the Aruba RADIUS Enforcement > Profile tab:

Figure 378 Aruba RADIUS Enforcement > Profile Tab

The following table describes the Aruba RADIUS Enforcement > Profile tab parameters:

Parameter Action/Description

Template Select Aruba RADIUS Enforcement.

Name Enter the name of the profile.
The name is displayed on the Configuration > Enforcement > Profiles page.

Description Enter a description that provides additional information about the profile. This description is
displayed in on the Configuration > Enforcement > Profiles page.

Type This field is populated automatically.

Table 1: Aruba RADIUS Enforcement > Profile Parameters
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Parameter Action/Description

Action Click Accept, Reject, or Drop to define the action taken on the request.

Device Group
List

Select a device group from the drop-down list. The list displays all configured device groups. All
configured device groups are listed in the Configuration > Network > Device Groups page.
After adding one or more device group(s), you can select a group and take one of the following
actions:
n To delete the selected Device Group List entry, click Remove.
n To see the device group parameters, click View Details.
n To change the parameters of the selected device group, click Modify.

Add New
Device Group

Click this link to add a new device group, For more information, see Adding and Modifying
Device Groups.

Attributes Configuration
Use the Attribute tab to configure the attribute type, name, and value for the enforcement profile. The
following figure displays the Aruba RADIUS Enforcement > Attributes tab:

Figure 379 Aruba RADIUS Enforcement > Attributes Dialog

The following table describes the Aruba RADIUS Enforcement > Attributes parameters:

Attribute Action/Description

Type Select one of the following attribute types:
n Radius:Aruba
n Radius:IETF
n Radius:Cisco
n Radius: Hewlett-Packared-Enterprise
n Radius: Lucent-Alcatel-Enterprise
n Radius:Microsoft
n Radius:Avenda
For more information, see RADIUS Namespaces on page 989.

Name Select the appropriate Name attribute.
The options provided for the Name attribute depend on the Type attribute selected.

Value Specify the appropriate Value attribute.
The options provided for the Value attribute depend on the Type and Name attributes
selected.

Table 2: Aruba RADIUS Enforcement > Attributes Parameters
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Summary Information
The Summary tab summarizes the parameters configured in the Profile and Attributes tab.

Figure 380 Aruba RADIUS Enforcement > Summary Tab

Cisco Downloadable ACL Enforcement Profile
Use this page to configure the Cisco Downloadable ACL Enforcement profile.

Profile Configuration
Use the Profile tab to configure the Cisco Downloadable ACL Enforcement profile.

The following figure displays the Cisco Downloadable ACL Enforcement > Profile dialog:

Figure 381 Cisco Downloadable ACL Enforcement > Profile Dialog

Specify the Cisco Downloadable ACL Enforcement > Profile parameters as described in the following table:

Parameter Action/Description

Template Select the Cisco Downloadable ACL Enforcement template.

Name Enter the name of the profile.

The name is displayed in the Name column on the Configuration > Enforcement >
Profiles page.

Description Enter a description of the profile.
The description is displayed in the Description column on the Configuration > Enforcement >
Profiles page.

Type The field is populated automatically with Type: RADIUS.

Table 1: Cisco Downloadable ACL Enforcement > Profile Parameters
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Parameter Action/Description

Action To define the action to take on the request, click Accept, Reject, or Drop.

Device Group
List

Select a Device Group from the drop-down list. The list displays all configured device groups.
All configured device groups are listed in the Configuration > Network > Device Groups
page. After adding one or more device group(s), you can select a group and take one of the
following actions:
n To delete the selected Device Group List entry, click Remove.
n To see the device group parameters, click View Details.
n To change the parameters of the selected device group, click Modify.

Add New
Device Group

To add a new a device group, click the Add New Device Group link. For more information, see
Adding and Modifying Device Groups.

Attributes Configuration
Use the Attribute tab to configure the attribute type, name, and value for the enforcement profile.

The following figure displays the Cisco Downloadable ACL Enforcement > Attributes dialog:

Figure 382 Cisco Downloadable ACL Enforcement > Attributes Dialog

Specify the Cisco Downloadable ACL Enforcement > Attributes parameters as described in the following
table:

Parameter Action/Description

Type Select one of the following attribute types:
l Radius:IETF
l Radius:Cisco
l Radius: Hewlett-Packard-Enterprise
l Radius:Microsoft
l Radius: Alcatel-Lucent-Enterprise
l Radius:Avenda
l Radius:Aruba

For more information, see RADIUS Namespaces on page 989.

Name The options displayed for the Name attribute depend on the Type attribute that was selected.

Value The options displayed for the Value attribute depend on the Type and Name attributes that
were selected.

Table 2: Cisco Downloadable ACL Enforcement > Attributes Parameters

Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1423



Summary Information
The Summary tab summarizes the parameters configured in the Cisco Downloadable ACL Enforcement
profile.

Figure 383 Cisco Downloadable ACL Enforcement > Summary Tab

Cisco Web Authentication Enforcement Profile
Use this page to configure profile and attribute parameters for the Cisco Web Authentication Enforcement
profile.

Profile Configuration
Use the Profile tab to configure the template, type of the profile, and device group list.

Figure 384 CiscoWeb Authentication Enforcement > Profile Tab

Specify the Cisco Web Authentication Enforcement > Profile tab parameters as described in the following
table:

Parameter Action/Description

Template Select the Cisco Web Authentication Enforcement template.

Name Enter the name of the profile.

Description Enter a description that provides additional information about the profile (recommended).

Type This field is populated automatically.

Table 1: CiscoWeb Authentication Enforcement > Profile Tab Parameters
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Parameter Action/Description

Action Click Accept, Reject, or Drop to define the action taken on the request.

Device Group
List

Select a device group from the drop-down list. The list displays all configured device groups. All
configured device groups are listed in the Configuration > Network > Device Groups page.
After adding one or more device group(s), you can select a group and take one of the following
actions:
n To delete the selected Device Group List entry, click Remove.
n To see the device group parameters, click View Details.
n To change the parameters of the selected device group, click Modify.

Add new Device
Group

Click this link to add a new device group, For more information, see Adding and Modifying
Device Groups.

Attributes Configuration
Use the Attributes tab to configure the attribute name and attribute value. The following figure displays the
Cisco Web Authentication Enforcement > Profile tab:

Figure 385 CiscoWeb Authentication Enforcement > Attributes Tab

The following table describes the Cisco Web Authentication Enforcement > Attributes parameters:

Parameter Description

Type Select one of the following attribute types:
n Radius:Aruba
n Radius:IETF
n Radius:Cisco
n Radius: Hewlett-Packared-Enterprise
n Radius: Lucent-Alcatel-Enterprise
n Radius:Microsoft
n Radius:Avenda
For more information, see RADIUS Namespaces.

Name The options displayed for the Name attribute depend on the Type attribute that was selected.

Value The options displayed for the Value attribute depend on the Type and Name attributes that
were selected.

Table 2: CiscoWeb Authentication Enforcement > Attributes Parameters
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Summary Information
The Summary tab summarizes the parameters configured in the Profile and Attribute tabs.

Figure 386 CiscoWeb Authentication Enforcement > Summary Tab

ClearPass Entity Update Enforcement Profile
Use this page to configure profile and attribute parameters for the ClearPass Entity Update Enforcement
profile.

Profile Configuration
Use the Profile tab to configure the template, type of the profile, and device group list.

Figure 387 ClearPass Entity Update Enforcement > Profile Tab

Specify the ClearPass Entity Update Enforcement > Profile parameters as described in the following table:

Parameter Acvtion/Description

Template Select the template from the drop-down list. In this context, select ClearPass Entity Update
Enforcement.

Name Enter the name of the profile. The name is displayed in the Name column on the Configuration
> Enforcement > Profiles page.

Description Enter a description that provides additional information about the profile. This description is
displayed in the Description column on the Configuration > Enforcement > Profiles page.

Type This field is populated automatically.

Table 1: ClearPass Entity Update Enforcement > Profile Parameters
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Parameter Acvtion/Description

Action Click Accept, Reject, or Drop to define the action taken on the request.

Device Group
List

Select a device group from the drop-down list. The list displays all configured device groups. All
configured device groups are listed in the Configuration > Network > Device Groups page.
After adding one or more device group(s), you can select a group and take one of the following
actions:
n To delete the selected Device Group List entry, click Remove.
n To see the device group parameters, click View Details.
n To change the parameters of the selected device group, click Modify.

Add new Device
Group

Click this link to add a new device group, For more information, see Adding and Modifying
Device Groups.

Attributes Configuration
Use the Attribute tab to configure the attribute type, name, and value for the enforcement profile. The
following figure displays the ClearPass Entity Update Enforcement > Attributes tab:

Figure 388 ClearPass Entity Update Enforcement Attributes tab

Specify the ClearPass Entity Update Enforcement > Attributes parameters as described in the following
table:

Attribute Description

Type Select one of the following attribute types:
n Endpoint
n Expire-Time-Update
n GuestUser
n Status-Update

Name The options displayed for the Name attribute depend on the Type attribute that was selected.

Value The options displayed for the Value attribute depend on the Type and Name attributes that
were selected.

Table 2: ClearPass Entity Update Enforcement > Attributes Parameters
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Summary Information
The Summary tab summarizes the parameters configured in the Profile and Attributes tab.

Figure 389 ClearPass Entity Update Enforcement > Summary Tab

CLI-Based Enforcement Profile
Use this page to configure profile and attribute parameters for the CLI-Based Enforcement profile. The CLI-
Based Enforcement profile contains the following tabs:

n Profile Configuration on page 396

n Attributes Configuration on page 397

n Summary Information on page 397

Profile Configuration
Use the Profile tab to configure the template, type of the profile, and device group list. The following figure
displays the CLI-Based Enforcement > Profile tab:

Figure 390 CLI-Based Enforcement > Profile Tab

Specify the CLI-Based Enforcement > Profile tab parameters as described in the following table:

Parameter Action/Description

Template Select the CLI Based Enforcement template.

Name Enter the name of the profile.

Description Enter a description that provides additional information about the profile.

Type This field is populated automatically.

Table 1: CLI Based Enforcement > Profile Parameters
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Parameter Action/Description

Action Click Accept, Reject, or Drop to define the action taken on the request.

Device Group
List

Select a device group from the drop-down list. The list displays all configured device groups. All
configured device groups are listed in the Device Groups ( Configuration > Network >
Device Groups) page.
After adding one or more device group(s), you can select a group and take one of the following
actions:
n Click Remove to delete the selected Device Group List entry.
n Click View Details to see the device group parameters.
n Click Modify to change the parameters of the selected device group.

Add New
Device Group

Click this link to add a new device group, For more information, see Adding and Modifying
Device Groups.

Attributes Configuration
Use the Attribute tab to configure the attribute type, name, and value for the enforcement profile.

Figure 391 CLI Based Enforcement > Attributes Tab

Specify the CLI Based Enforcement > Attributes parameters as described in the following table:

Attribute Action/Parameter

Attribute Name Select Command or Target Device.

Attribute Value Specify the appropriate Attribute Value.
The options provided for the Attribute Value depend on the selected Attribute Name.

Table 2: CLI Based Enforcement > Attributes Parameters

Summary Information
The Summary tab summarizes the parameters configured in the Profile and Attributes tab. The following
figure displays the CLI-Based Enforcement > Summary tab:

Figure 392 CLI-Based Enforcement > Summary Tab
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Filter ID Based Enforcement Profile
This section provides the following information:

n Profile Configuration on page 398

n Attributes Configuration on page 399

Use this page to configure profile and attribute parameters for the Filter ID based enforcement profile. The
Filter ID Based Enforcement profile contains the following tabs:

Profile Configuration
The following figure displays the Filter ID Based Enforcement > Profile dialog:

Figure 393 Filter ID Based Enforcement Profile Dialog

Specify the Filter ID Based Enforcement Profile parameters as described in the following table:
Table 19: Filter ID Based Enforcement > Profile Parameters

Parameter Action/Description

Template Select the Filter ID Based Enforcement template.

Name Enter the name of the profile. The name is displayed in the Name column on the Configuration
> Enforcement > Profiles page.

Description Enter a description of the profile. The Description is displayed in the Description column on the
Configuration > Enforcement > Profiles page.

Type RADIUS. The field is populated automatically.

Action Enabled. Click Accept, Reject, or Drop to define the action taken on the request.

Device Group
List

Select a Device Group from the drop-down list. The list displays all configured Device Groups.
All configured device groups are listed in the Device Groups page: Configuration > Network
> Device Groups. After you add one or more device group(s), you can select a group and take
one of the following actions:
n To delete the selected Device Group List entry, click Remove.
n To see the device group parameters, click View Details.
n To change the parameters of the selected device group, click Modify.

Add New
Device Group

To add a new a device group, click the Add New Device Group link and see Adding and
Modifying Device Groups.
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Attributes Configuration
The following figure displays the Filter ID Based Enforcement Profile > Attributes dialog:

Figure 394 Filter ID Based Enforcement Profile > Attributes Dialog

Specify the Filter ID Based Enforcement > Attributes parameters as described in the following table:

Parameter Description

Type Select one of the following attribute types:

n Radius:Aruba
n Radius:IETF
n Radius:Cisco
n Radius: Hewlett-Packared-Enterprise
n Radius: Lucent-Alcatel-Enterprise
n Radius:Microsoft
n Radius:Avenda

For more information, see RADIUS Namespaces.

Name Select the desired Name attribute.
The options displayed for the Name attribute depend on the attribute that was selected.

Value Specify the appropriate Value.
The options displayed for the Value attribute depend on the Type attribute and Name attribute
that were selected.

Table 1: Filter ID Based Enforcement Profile > Attributes Tab Parameters

Generic Application Enforcement Profile
Use this page to configure profile and attribute parameters for the Generic Application Enforcement
profile. The Generic Application Enforcement profile contains the following tabs:

n Profile Configuration on page 399

n Attributes Configuration on page 400

n Summary Information on page 401

Profile Configuration
Use the Profile tab to configure the template, type of the profile, and device group list. The following figure
displays the Generic Application Enforcement > Profile tab:

Figure 395 Generic Application Enforcement > Profile Tab
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Specify the Generic Application Enforcement > Profile parameters as described in the following table:

Parameter Action/Description

Template Select the template from the drop-down list. In this context, select Generic Application
Enforcement.

Name Enter the name of the profile. The name is displayed in the Name column on the Configuration
> Enforcement > Profiles page.

Description Enter a description that provides additional information about the profile. This description is
displayed in the Description column on the Configuration > Enforcement > Profiles page.

Type This field is populated automatically.

Action Click Accept, Reject, or Drop to define the action taken on the request.

Device Group
List

Select a device group from the drop-down list. The list displays all configured device groups. All
configured device groups are listed in the Device Groups ( Configuration > Network >
Device Groups) page.
After adding one or more device group(s), you can select a group and take one of the following
actions:
n To delete the selected Device Group List entry, click Remove.
n To see the device group parameters, click View Details.
n To change the parameters of the selected device group, click Modify.

Add New
Device Group

Click this link to add a new device group, For more information, see Adding and Modifying
Device Groups.

Table 1: Generic Application Enforcement > Profile Tab Parameters

Attributes Configuration
Use the Attribute tab to configure the attribute type, name, and value for the enforcement profile. The
following figure displays the Generic Application Enforcement > Attributes tab:

Figure 396 Generic Application Enforcement > Attributes Tab

Specify the Generic Application Enforcement > Attributes parameters as described in the following table:
Table 20: Generic Application Enforcement > Attributes Parameters

Parameter Action/Description

Attribute Name Select an attribute name from the drop-down list. The list has multiple names.

Attribute Value Displays the options for the Attribute Value depend on the selected Attribute Name.
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Summary Information
The Summary tab summarizes the parameters configured in the Profile and Attributes tab.

Figure 397 Generic Application Enforcement > Summary Tab

HTTP Based Enforcement Profile
Use this page to configure the HTTP based Enforcement Profile.

Profile Configuration
The following figure displays the HTTP Based Enforcement > Profile dialog:

Figure 398 HTTP Based Enforcement Profile Dialog

Specify the HTTP Based Enforcement > Profile parameters as described in the following table:

Parameter Action/Description

Template Select the HTTP Based Enforcement template.

Name Enter the name of the profile.
The name is displayed in the Name column on the Configuration >
Enforcement > Profiles page.

Description Enter a description of the profile.
The description is displayed in the Description column on the
Configuration > Enforcement > Profiles page.

Type This field is populated automatically with HTTP.

Table 1: HTTP Based Enforcement Profile Parameters
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Parameter Action/Description

Action Disabled.

Device Group
List

Select a Device Group from the drop-down list.
The list displays all configured Device Groups. All configured device groups
are listed in the Configuration > Network > Device Groups.page. After
you add one or more device group(s), you can select a group and take one of
the following actions:
n To delete the selected Device Group List entry, click Remove.
n To see the device group parameters, click View Details.
n To change the parameters of the selected device group, click Modify.

Add New
Device Group

To add a new a device group, click the Add New Device Group link and see
Adding and Modifying Device Groups.

Attributes Configuration

Figure 399 HTTP Based Enforcement Attributes Dialog

Parameter Action/Description

Attribute Name Select the attribute name: Target Server or Action.

Attribute Value Specify the appropriate value.
The options displayed for the Attribute Value depend on the Attribute
Name that was selected.

Table 2: HTTP Based Enforcement Attributes Parameters

RADIUS Based Enforcement Profile

Use this page to configure profile and attribute parameters for the RADIUS based enforcement profiles.

Profile Configuration
The following figure displays the RADIUS Based Enforcement Profile tab:

Figure 400 RADIUS Based Enforcement > Profile Tab
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Specify the RADIUS Based Enforcement Profile parameters as described in the following table:

Parameter Action/Description

Template Select the RADIUS Based Enforcement template.

Name Enter the name of the profile.

Description Enter a description of the profile.

Type RADIUS. This field is populated automatically.

Action Enabled. Click Accept, Reject, or Drop.

Device Group
List

Select a Device Group from the drop-down list.
All configured device groups are listed in the Configuration > Network > Device Groups
page. After you add one or more device group(s), you can select a group and take one of the
following actions:
n To delete the selected Device Group List entry, click Remove.
n To see the device group parameters, click View Details.
n To change the parameters of the selected device group, click Modify.

Add New
Device Group

To add a new a device group, click the Add New Device Group link and see
Adding and Modifying Device Groups

Table 1: RADIUS Based Enforcement Profile Parameters

Attributes Tab
The following figure displays the RADIUS Based Enforcement > Attributes dialog:

Figure 401 RADIUS Based Enforcement Attributes Dialog
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Specify the RADIUS Based Enforcement > Attributes parameters as described in the following table:
Table 21: RADIUS Based Enforcement > Attributes Parameters

Parameter Description

Type Select one of the following attribute types:
n Radius:Aruba
n Radius:IETF
n Radius:Cisco
n Radius: Hewlett-Packared-Enterprise
n Radius: Lucent-Alcatel-Enterprise
n Radius:Microsoft
n Radius:Avenda
For more information, see RADIUS Namespaces.

Name The options displayed for the Name attribute depend on the Type attribute that was selected.

Value The options displayed for the Value attribute depend on the Type and Name attributes that
were selected.

RADIUS Change of Authorization (CoA) Profile
Use this page to configure the RADIUS Change of Authorization (CoA) enforcement profile.

Profile Configuration
The following figure displays the RADIUS Change of Authorization (CoA) > Profile tab:

Figure 402 RADIUS Change of Authorization (CoA) > Profile Tab

Specify the RADIUS Change of Authorization (CoA) > Profile tab parameters as described in the following
table:

Parameter Action/Description

Template Select the RADIUS Change of Authorization (CoA) template.

Name Enter the name of this enforcement profile.

Type RADIUS_CoA is automatically populated.

Table 1: RADIUS Change of Authorization (CoA) Profile Parameters
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Parameter Action/Description

Action Disabled.

Device Group
List

Optionally, select a Device Group from the drop-down list.
All configured device groups are listed on the Device Groups page: Configuration > Network
> Device Groups. After you add one or more device group(s), you can select a group and take
one of the following actions:
n To delete the selected Device Group List entry, click Remove.
n To see the device group parameters, click View Details.
n To change the parameters of the selected device group, click Modify.

Add New
Device Group

To add a new a device group, click the Add New Device Group link and see Adding and
Modifying Device Groups.

Attributes Configuration
The following figure displays the RADIUS Change of Authorization (CoA) > Attributes tab:

Figure 403 RADIUS Change of Authorization (CoA) > Attributes Dialog

The following table describes the RADIUS Change of Authorization (CoA) > Attributes parameters:

Parameter Action/Description

Select RADIUS CoA
Template

Select one of the following RADIUS CoA templates:
n Aruba - Change-User-Role
n Aruba - Change-VPN-User-Role
n Cisco - Bounce-Host-Port
n Cisco-Disable-Host-Port
n Cisco - Reauthenticate-Session
n Hewlett-Packard-Enterprise - Change-VLAN
n Hewlett-Packard-Enterprise - Generic-CoA
n Hewlett-Packard-Enterprise - Port-Bounce-Host-HP
n IETF- Generic-CoA-IETF
n IETF - Terminate-Session-IETF

Type Select one of the following attribute types:
l Radius:IETF
l Radius:Cisco
l Radius: Hewlett-Packared-Enterprise
l Radius: Alcatel-Lucent-Enterprise
l Radius:Microsoft
l Radius:Avenda
l Radius:Aruba

Name The options displayed for the Name attribute depend on the Template and Type
attributes that were selected.

Table 2: RADIUS Change of Authorization (CoA) Attributes Parameters
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Parameter Action/Description

Value The content for the Value attribute depends on the Template, Type, and Name
attributes that were selected.

Session Notification Enforcement Profile
Use this page to configure the Session Notification Enforcement profile.

You can send notification of a change in IP address to any external context server (such as a firewall) by
configuring that server as a generic HTTP server and adding the appropriate generic HTTP context server
actions.

The content of the payload to be posted by Policy Manager to the external server is based on the REST API
defined by the external server.

Profile Configuration
The following figure displays the Session Notification Enforcement > Profile tab:

Figure 404 Session Notification Enforcement > Profile Configuration Dialog

The following table describes the Session Notification Enforcement > Profile parameters:

Parameter Action/Description

Template Select Session Notification Enforcement.

Name Enter the name of the profile.

Description Enter a description of the profile (recommended).

Type The field is populated automatically with: Post_Authentication.

Action Disabled.

Device Group
List

Select a device group from the drop-down list.
All configured device groups are listed in the Device Groups Configuration > Network >
Device Groups page.

Add New
Device Group

To add a new a device group, click the Add New Device Group link. See Adding and Modifying
Device Groupsfor more information.

Table 1: Session Notification Enforcement Profile Tab Parameters
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Attributes Configuration
The following figure displays the Session Notification Enforcement > Attributes dialog:

Figure 405 Session Notification Enforcement > Attributes Configuration Dialog

Specify the Session Notification Enforcement > Attributes parameters as described in the following table:
Table 22: Session Notification Enforcement > Attributes Parameters

Parameter Action/Description

Type Select one of the following Type attributes:

n Session-Check
n Session-Notify
Palo Alto integration is extended to Guest MAC Caching use cases. Configure the Session-
Check attributes as follows:
n Session-Check::Username = %{Endpoint:Username}
NOTE: Post authentication sends the Guest username instead of the MAC address in the user
ID updates.
n Session-Notify: The Name options are:

l Login Action
l Logout Action
l Server IP
l Server Type

Server Type options:
l Generic HTTP
l Palo Alto Networks Panorama
l Palo Alto Networks Firewall

Server IP options: a choice of IP address/hostnames for the corresponding type of server as
Value. The Target Server attribute must be specified before you can use the Server IP
option.
Once the server IP address is selected, you can select Login Action or Logout Action. The
list of actions defined for the selected server will be shown as available choices for Value.

This enforcement type should be used both for Palo Alto devices and any Generic HTTP servers.

Name The options displayed for the Name attribute depend on the Type attribute that was selected.

Value The options displayed for the Value attribute depend on the Type and Name attributes that
were selected.
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Summary Information
This Summary tab summarizes the parameters configured for Session Notification Enforcement.

Figure 406 Session Notification Enforcement > Summary Tab

Session Restrictions Enforcement Profile
ClearPass uses Keep-Alive messages to issue Disconnect Messages for a Session Restrictions Enforcement
Profile if OnGuard Agent is disconnected (see below, Examples of Session-Check Enforcement Profile
Configurations). For related information, see OnGuard Global Agent Settings.

n Enforcement Profile Configuration

n Attributes Configuration

n Examples of Bandwidth-Check Enforcement Profile Configurations

n Examples of Session-Check Enforcement Profile Configurations

Enforcement Profile Configuration
To configure Profile and Attributes parameters for a Session Restrictions Enforcement profile:

1. Navigate to Configuration > Enforcement > Profiles.

The Enforcement Profiles page opens.

2. Click Add.

The Add Enforcement Profiles > Profile tab opens.

3. From the Template drop-down, select Session Restrictions Enforcement.

The Add Session Restrictions Enforcement > Profile dialog opens:

Figure 407 Add Session Restrictions Enforcement > Profile Tab

4. Specify the Session Restrictions Enforcement > Profile parameters as described in the following table:
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Parameter Action/Description

Template Select Session Restrictions Enforcement.

Name Enter the name of the enforcement profile.

Description Optionally, enter a description of the enforcement profile (recommended).

Type Post_Authentication.
The Type field is populated automatically when you select the Session Restrictions
Enforcement template.

Action By default, this field is disabled. It is enabled only when RADIUS type is selected.

Device Group
List

Select a device group from the drop-down list. The list displays all configured device groups.
All configured device groups are listed in the Configuration > Network > Device Groups
page. After you add one or more device groups, select a group and take one of the following
actions:
n To delete the selected device group list entry, click Remove.
n To see the device group parameters, click View Details.
n To change the parameters of the selected device group, click Modify.

Add New
Device Group

To add a new a device group, click the Add New Device Group link. For more information, see
Adding and Modifying Device Groups.

Table 1: Session Restrictions Enforcement Profile Parameters

Attributes Configuration
The following figure displays the Session Restrictions Enforcement > Attributes tab:

Figure 408 Session Restrictions Enforcement Profile > Attributes Dialog

1. Specify the Session Restrictions Enforcement > Attributes parameters as described in Table 2:
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Parameter Description

Type Select from the following attribute types:
n Bandwidth-Check
n Expiry-Check
n Post-Auth-Check
n Session-Check

Table 2: Session Restrictions Enforcement Attributes Parameters
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Parameter Description

Name The options displayed for the Name attribute depend on the Type attribute that was
selected.

Type: Bandwidth-Check
n Allowed-Limit: Defines the total bandwidth limit to be allowed per user or

endpoint.
n Check-Type: Defines the period/interval for bandwidth-based checks. Applicable

only with Allowed-Limit.
n Limit-Units: Defines the metric for bandwidth-based checks (KB, MB, GB, TB).

Applicable only with Allowed-Limit.
n Start-Date: Defines the start date for bandwidth-based checks. Applicable only

with Allowed-Limit.
n Start-Time: Defines the start time for bandwidth-based checks. Applicable only

with Allowed-Limit.
n Stop-Date: Defines the stop date for bandwidth-based checks. Applicable only with

Allowed-Limit.
n Stop-Time: Defines the stop time for bandwidth-based checks. Applicable only

with Allowed-Limit.
For configuration examples, see the next section, Examples of Bandwidth-Check
Enforcement Profile Configurations.

Type: Expiry-Check
n Expiry-Action

Type: Post-Auth-Check
n Action

Type: Session-Check
n Active-Session-Count: Defines the number of active sessions to be allowed per

user or endpoint.
n Agent-Connection: Set the value to Down to have ClearPass check to see if the

OnGuard Agent is down.
n Allowed-Duration: Defines the total session duration to be allowed per user or

endpoint.
n Check-Type: Defines the period or interval for duration-based checks. Applicable

only with Allowed-Duration.
n Duration-Units: Defines the metric for duration-based checks. Applicable only

with Allowed-Duration.
n Start-Date: Defines the start date for duration-based checks. Applicable only with

Allowed-Duration.
n Start-Time: Defines the start time for duration-based checks. Applicable only with

Allowed-Duration.
n Stop-Date: Defines the stop date for duration-based checks. Applicable only with

Allowed-Duration.
n Stop-Time: Defines the stop time for duration-based checks. Applicable only with

Allowed Duration.
n Username: Defines the username for which session restrictions are enabled.

Used when the client MAC address is to be defined as a username.
For configuration examples, see the section below, Examples of Session-Check
Enforcement Profile Configurations.

Value The options displayed for the Value attribute depend on the Type and Name
attributes that were selected.
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Examples of Bandwidth-Check Enforcement Profile Configurations
The following are typical examples of Session Restriction > Bandwidth-Check enforcement profile
configurations:

1. Allowed-Limit: Users/Endpoints will be disconnected after exceeding the 50 MB daily limit:

l Bandwidth-Check > Allowed-Limit = 50

l Bandwidth-Check > Limit-Units = MB

l Bandwidth-Check > Check-Type = Daily

l Post-Auth-Check > Action = Disconnect

2. Allowed-Limit: Users/Endpoints will be disconnected after exceeding 1 GB total bandwidth consumption.
Also, users are allowed access to the network only during the defined period (between 9:00 a.m. and 6:00
p.m.).

l Bandwidth-Check > Allowed-Limit = 1

l Bandwidth-Check > Limit-Units = GB

l Bandwidth-Check > Check-Type = Total

l Bandwidth-Check > Start-Time = 09:00:00

l Bandwidth-Check > Stop-Time = 18:00:00

l Post-Auth-Check > Action = Disconnect

Examples of Session-Check Enforcement Profile Configurations
The following are typical examples of Session Restriction > Session-Check enforcement profile
configurations:

1. Active Session Count: The Users/Endpoints active session count is set to 5. Users/Endpoints connecting
after the session count reaches 5 are disconnected:

l Session-Check > Active-Session-Count = 5

l Post-Auth-Check > Action = Disconnect

2. Agent-Connection: You can disconnect a session if OnGuard Agent is down:

l Session-Check > Agent-Connection = Down

l Post-Auth-Check > Action = Disconnect

3. Session Duration: The User/Endpoint is allowed access for 60 minutes daily. Users/Endpoints that exceed
this session duration limit are disconnected:

l Session-Check > Allowed-Duration = 60

l Session-Check > Duration-Units = Minutes

l Session-Check > Check-Type = Daily

l Post-Auth-Check > Action = Disconnect

4. Session Duration: The User/Endpoint is allowed access to the network daily for three hours in a specified
time period (between 9:00 a.m. and 5:00 p.m.)

l Session-Check > Allowed-Duration = 3

l Session-Check >Duration-Units = Hours

l Session-Check > Check-Type = Daily

l Session-Check > Start-Time = 09:00:00

l Session-Check Stop-Time = 17:00:00

l Post-Auth-Check > Action = Disconnect
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SNMP-Based Enforcement Profile
Use this page to configure the SNMP-Based Enforcement profile.

Profile Configuration
The following figure displays the SNMP Based Enforcement > Profile dialog:

Figure 409 SNMP Based Enforcement > Profile Dialog

Specify the SNMP Based Enforcement > Profile parameters as described in the following table:

Parameter Description

Template Select the SNMP Based Enforcement template.

Name Enter the name of the profile.
The name is displayed in the Name column on the Configuration > Enforcement > Profiles
page.

Description Enter a description of the profile (recommended).
The description is displayed in the Description column on the Configuration > Enforcement
> Profiles page.

Type SNMP. This field is populated automatically when you select the SNMP Based Enforcement
template.

Action Disabled.

Device Group
List

Select a Device Group from the drop-down list.
All configured device groups are listed in the Configuration > Network > Device Groups
page. After you add one or more device group(s), you can select a group and take one of the
following actions:
n To delete the selected Device Group List entry, click Remove.
n To see the device group parameters, click View Details.
n To change the parameters of the selected device group, click Modify.

Add New
Device Group

To add a new a device group, click the Add New Device Group link. See Adding and Modifying
Device Groups.

Table 1: SNMP Based Enforcement > Profile Tab Parameters

Attributes Configuration
The following figure displays the SNMP Based Enforcement > Attributes dialog:

Figure 410 SNMP Based Enforcement > Attributes Dialog
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Specify the SNMP Based Enforcement > Attributes parameters as described in the following table:

Parameter Action/Description

Attribute Name Select one of the following attributes:

n VLAN ID
n Session Timeout (in seconds)
n Reset Connection (after the settings are applied)

Attribute Value The options displayed for the Attribute Value depends on the Attribute Name that was
selected.

Table 2: SNMP Based Enforcement Attributes Parameters

TACACS+ Based Enforcement Profile
Use this page to configure the TACACS+ Based Enforcement profile.

Profile Configuration
To create a TACACS+ Based Enforcement profile:

1. navigate to Configuration > Enforcement > Profiles.

2. From the Enforcement Profiles page, click Add.

The Add Enforcement Profiles dialog opens.

Figure 411 Add TACACS+ Based Enforcement Profile Dialog

Specify the Add TACACS+ Based Enforcement Profile > Profile tab parameters as described in the following
table:

Parameter Action/Description

Template Select the TACACS+ Based Enforcement template.

Name Enter the name of the profile.
The name is displayed in the Name column on the Configuration > Enforcement > Profiles
page.

Description Enter a description of the profile (recommended).
The description is displayed in the Description column on the Configuration > Enforcement
> Profiles page.

Type TACACS. The field is populated automatically.

Table 1: TACACS+ Based Enforcement > Profile Parameters
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Parameter Action/Description

Action Disabled.

Device Group
List

Select a Device Group from the drop-down list.
All configured device groups are listed in the Configuration > Network > Device Groups
page. After you add one or more device group(s), you can select a group and take one of the
following actions:
n To delete the selected Device Group List entry, click Remove.
n To see the device group parameters, click View Details.
n To change the parameters of the selected device group, click Modify.

Add New
Device Group

To add a new a device group, click the Add New Device Group link. See Adding and Modifying
Device Groups.

Services Configuration
The following figure displays the TACACS+ Based Enforcement > Services dialog:

Figure 412 TACACS+ Based Enforcement > Services Dialog

Specify the TACACS+ Based Enforcement Profile > Service parameters as described in the following table:

Parameter Action/Description

Privilege Level Select a level between 0 and 15, with 0 being the minimum privilege level and 15
being the highest.

Selected Services Select one or more of the following services:
n Shell
n PIX Shell
n PPP:IP
n PPP:IPX
n PPP:LCP
n ARAP
n cpass:HTTP
n Wireless-WCS:HTTP
n CiscoWLC:Common
n Aruba:Common
n AMP:https
n NCS:HHHP

Export All TACACS+ Services
Dictionaries

Click this link to download the TACACS+ Services dictionary to the local
computer.

Authorize Attribute Status Select one of the following options:

Table 2: TACACS+ Based Enforcement > Services Parameters
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Parameter Action/Description

n ADD
n REPLACE

Custom Services To add new TACACS+ services / attributes or upload the modified XML
dictionary, click the Update TACACS+ Services Dictionary link.

Service Attributes

Type Select one of the following Service Attribute types:
n PPP:IP
n Shell
n cpass:HTTP

Name The options displayed for the Name attribute depend on the Type attribute that
was selected.

Value The options displayed for the Value attribute depend on the Type and Name
attributes that were selected.

VLAN Enforcement Profile

To configure profile and attribute parameters for a VLAN Enforcement profile:

1. Navigate to Configuration > Enforcement > Profiles.

The Enforcement Profiles page opens.

2. Click Add.

The Add Enforcement Profiles > Profile tab opens.

3. From the Template drop-down, select Agent Enforcement.

The VLAN Enforcement > Profile dialog opens.

Figure 413 VLAN Enforcement > Profile Configuration Dialog

4. Specify the VLAN Enforcement > Profile parameters as described in the following table:
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Parameter Action/Description

Template Select VLAN Enforcement from the drop-down list.

Name Enter the name of the enforcement profile.

Description Enter a description of theenforcement profile.

Type RADIUS. The field is populated automatically.

Action To define the action taken on the request, click Accept, Reject, or Drop.

Device Group List Select a Device Group from the drop-down list.
All configured device groups are listed in the Configuration > Network > Device
Groups page. After you add one or more device group(s), you can select a group and take
one of the following actions:
n To delete the selected Device Group List entry, click Remove.
n To see the device group parameters, click View Details.
n To change the parameters of the selected device group, click Modify.

Add New Device
Group

To add a new a device group, click the Add New Device Group link and see Adding and
Modifying Device Groups.

Table 1: VLAN Enforcement > Profile Parameters

Attributes Configuration
The following figure displays the VLAN Enforcement > Attributes dialog:

Figure 414 VLAN Enforcement Attributes Dialog

Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1449



Specify the RADIUS Based Enforcement > Attributes parameters as described in the following table:

Parameter Action/Description

Type Select one of the following attribute types:

n Radius:Aruba
n Radius:IETF
n Radius:Cisco
n Radius: Hewlett-Packared-Enterprise
n Radius: Alcatel-Lucent-Enterprise
n Radius:Microsoft
n Radius:Avenda

For more information, see RADIUS Namespaces

Name The options displayed for the Name attribute depend on the Type attribute that was selected.

Value The options displayed for the Value attribute depend on the Type and Name attributes that
were selected.

Table 2: VLAN Enforcement Attributes Tab Parameters

Configuring Enforcement Policies
n Adding an Enforcement Policy

n Binding SNMP Enforcement for Ingress Events

Adding an Enforcement Policy
Only one enforcement policy can be associated with each service. Enforcement policies can be added in one of
two ways:

n From the Configuration > Services page as part of the flow of the Add Service wizard.

n From Configuration > Enforcement > Enforcement Policies.

The Enforcement Policies page opens:

Figure 415 Enforcement Policies Page

1. To add a new enforcement policy from the Enforcement Policies page, navigate to Configuration >
Enforcement > Enforcement Policies.
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2. Click Add.

The Add Enforcement Policy page opens to the Enforcement tab:

Figure 416 Add Enforcement Policy > Enforcement Tab

3. Specify the Add Enforcement Policy > Enforcement parameters as described in the following table:

Parameter Action/Description

Name Enter the name of this enforcement policy.

Description Enter a useful description of this enforcement policy (recommended).

Enforcement Type Select one of the following enforcement types:
n RADIUS
n TACACS+
n WebAuth (SNMP/CLI)/CoA
n Application
n Event
Based on this selection, the Default Profile drop-down lists the associated enforcement
profiles.
NOTE: Web-based Authentication or WebAuth (HTTPS) is the mechanism used by
authentications performed via a browser, and authentications performed via ClearPass
OnGuard.
Both SNMP- and CLI-(SSH/Telnet) based enforcement profiles can be sent to the network
device based on the type of device and the use case.

Default Profile An enforcement policy applies conditions (roles, health, and time attributes) against
specific values associated with those attributes to determine the enforcement profile. If
none of the rules matches, Policy Manager applies the default profile.
To add a new profile, click Add New Enforcement Profile.

Table 1: Add Enforcement Policy > Enforcement Tab Parameters

4. In the Rules tab, click New Rule to display the Rules Editor:
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Figure 417 Add Enforcement Policy > Rules Editor

5. Specify the Add Enforcement Policy > Rules tab parameters as described in the following table:

Field Action/Description

Add Rule Click this button to bring up the Rules Editor.

Move
Up/Down

To reorder the rules in the enforcement policy, select an enforcement policy rule, then click Move
Up or Move Down.

Remove
Rule

To delete a rule, select the rule, then click Remove Rule.

Table 2: Add Enforcement Policy: Rules Editor

Field Description

Conditions/Enforcement
Profiles

Select conditions for this rule. For each condition, select a matching action
(enforcement profile).
NOTE: A condition in an enforcement policy rule can contain attributes from the
following namespaces: Tips:Role, Tips:Posture, and Date.
NOTE: The value field for the Tips:Role attribute can be a role defined in Policy
Manager, or a role fetched from the authorization source.
You can enter role names fetched from the authorization source free-form in the Value
field. To commit the rule, click Save.

Enforcement Profiles If the rule conditions match, attributes from the selected enforcement profiles are sent
to the Network Access Device. If a rule matches and there are multiple enforcement
profiles, the enforcement profile disambiguation rules apply. Refer to Configuring
Enforcement Profiles on page 362 for a list of the default profiles.

Table 3: Add Enforcement Policy: Rules Editor

Binding SNMP Enforcement for Ingress Events
SNMP enforcement profiles can be bound to an event-based enforcement policy, which enables ClearPass to
trigger SNMP enforcement based on an Ingress event.

This section demonstrates how ClearPass allows the binding of an SNMP-based enforcement profile to an
event-based enforcement policy.
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Figure 418 SNMP-Based Enforcement Profile

The configuration shown in Figure 419 demonstrates the binding of an SNMP-based enforcement to an event-
based enforcement policy.

Figure 419 Binding an SNMP-Based Enforcement to an Event-Based Enforcement Policy

Configuring Deep-Nested Active Directory Queries
This section describes the method for configuring ClearPass deep-nested Active Directory queries. This
configuration prevents failed authentications due to lengthy look-up times.

n Configuring the Active Directory Authentication Source

n Using the LDAP Browser to Select the Group Information

n Configuring the Enforcement Policy for Deep-Nested AD Queries

Configuring the Active Directory Authentication Source
The first task in this procedure is to create an Active Directory authentication source and configure a new filter
that will then be used in the enforcement policy.

To add a new Active Directory authentication source:

1. Navigate to Configuration > Authentication > Sources.
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The Authentication Sources page opens.

2. Click Add.

The Add Authentication Sources dialog opens.

3. For Type, select Active Directory.

For details on configuration for an Active Directory authentication source, refer to Generic LDAP and Active
Directory.

4. From the Attributes tab, click Add More Filters.

The Configure Filter dialog opens.

Figure 420 Configuring a New Filter for the Authentication Source

5. Specify the Authentication Source > Configure Filter parameters as described in the following table:

Parameter Action/Description

Filter Name Enter the name of this authentication source filter.

Filter Query Enter the following filter query:
(&(objectClass=user) (sAMAccountName=%{Authentication:Username}))

Name Enter the following name:
tokenGroups

Attributes

Alias Name Enter the following Alias Name:
Nested Groups
NOTE: Take note of this Alias Name as you will use it when configuring the Rule for the
enforcement policy later in this section (see Configuring the Enforcement Policy for Deep-
Nested AD Queries).

Data Type From the drop-down, select String.

Table 1: Authentication Source > Configure Filter Parameters

6. Click Save.
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Using the LDAP Browser to Select the Group Information
Use the LDAP Browse page to select the Group Name. Then copy the corresponding objectSid value. The
objectSid value will be used for the Rule Configuration in the enforcement policy (as described in the next
section).

To select the group information:

1. From the Configure Filter configuration dialog, select the Browse tab.

The Browse tab shows an LDAP browser from which you can browse the nodes in the Active Directory (or
LDAP) directory, starting at the base DN. This is presented in read-only mode.

Figure 421 Selecting the Group Name and objectSid Value from the Browse Dialog

2. From the panel on the left select the Group Name (for example, CN=Administration).

3. Then, from the panel on the right, locate and copy the corresponding objectSid value.

4. Click Close.

Configuring the Enforcement Policy for Deep-Nested AD Queries
For details on configuring enforcement policies, see Configuring Enforcement Policies.

To configure the enforcement policy for deep-nested queries:

1. Navigate to Configuration > Enforcement > Policies.

The Enforcement Policies page opens.

2. Click the Add link.

The Add Enforcement Policies page opens.
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Figure 422 Enforcement Policy

3. Specify the Enforcement tab parameters as described in the following table:

Parameter Action/Description

Name Enter the name of this enforcement policy.

Description Enter a description of this enforcement policy

Enforcement Type Select RADIUS.

Default Profile From the drop-down, select any appropriate enforcement profile.

Table 2: Add Enforcement Policy > Enforcement Tab Parameters

4. Click Next (or click the Rules tab).

The Rules Editor opens.

Figure 423 Configuring the Enforcement Policy Rule

5. Select conditions for this rule. For each condition, select a matching action (enforcement profile).

6. Specify the Rules Editor conditions as described in the following table:
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Parameter Action/Description

Type Select the Active Directory used for authentication.

Name Enter the Alias Name specified for the authentication source (see Configuring the Active
Directory Authentication Source).

Operator Select the appropriate operator.

Value Specify the objectSid value copied from the LDAP browser (see Using the LDAP Browser
to Select the Group Information).

Profile Name From the drop-down, select the appropriate profile name.

Table 3: Configuring the Nested Group Rule

7. Click Save.

You return to the Add Enforcement Policies > Rules page.

Figure 424 Enforcement Policy Rule Configured

8. Click Save.

If the rule conditions match, attributes from the selected enforcement profiles are sent to the Network
Access Device. If a rule matches and there are multiple enforcement profiles, the enforcement profile
disambiguation rules apply. Refer to Configuring Enforcement Profiles on page 362 for a list of the default
profiles.
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Adding and Modifying Network
Devices
A Network Access Device (NAD) must belong to the
global list of devices in the Policy Manager database in

order to connect to Policy Manager using any of the supported protocols.

The Policy Manager Network Devices page displays the device name, IP address or subnet address, and a
brief description of each configured device.

1. To view this page, navigate to Configuration > Network > Devices.

The Network Devices page opens:

Figure 425 Network Devices Page

2. Go to the following sections for Network Access Device configuration information:

n Adding a Network Device

n Modifying a Network Device

n Adding and Modifying Proxy Targets

n Adding and Modifying Device Groups

n Configuring the Ingress Event Source

Adding a Network Device
This section describes how to configure a new network device:

n Device Parameters

n SNMP Read Settings Parameters

n SNMP Write Settings Parameters

n CLI Settings Parameters

n Enabling ClearPass OnConnect Enforcement on a Network Device

n Querying and Selecting Port Names for OnConnect Enforcement

n Attributes Parameters

n Modifying a Network Device

To add a network device:

1. Navigate to the Configuration > Network > Devices page.

The Network Devices page opens.
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Figure 426 Network Devices Page

2. Click the Add link. The Add Device page opens.

Device Parameters

Figure 427 Add Device > Device Dialog

3. Enter the Add Device > Device parameters as described in Table 1:

Parameter Action/Description

Name Enter the name of the device.

IP Address or Subnet Specify the IPv4 address or the subnet of the device.
You can use a hyphen to indicate the range of device IP addresses following the
format a.b.c.d-e. For example, 192.168.1.1-20.

Description Enter a description that provides additional information to identify the device.

RADIUS Shared
Secret

Enter the RADIUS shared secret.

Table 1: Add Device > Device Parameters
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Parameter Action/Description

TACACS+ Shared
Secret

Enter the TACACS+ shared secret.

Vendor Name Specify the name of the vendor to load the dictionary associated with this vendor for
this device.
This field is optional.
NOTE: RADIUS:IETF, the dictionary containing the standard set of RADIUS attributes,
is always loaded. When you specify a vendor here, the RADIUS dictionary associated
with this vendor is automatically enabled.

Enable RADIUS CoA To configure the UDP port on the device to send CoA (Change of Authorization)
actions, enable RADIUS CoA for this device.
RADIUS CoA Port: The default value is 3799.

Enable RadSec To enable RadSec, click the Enable Radsec check box.
When RadSec is enabled, the RADIUS shared secret is populated with a default shared
secret with the string “radsec.”
NOTE: It is important that the controller is configured with the same shared secret.

SNMP Read Settings Parameters
Use the SNMP Read Settings tab to define values that allow ClearPass Policy Manager to read information
from the device using SNMPv1, SNMPv2, or SNMPv3.

Large or geographically-spread cluster deployments typically do not require each ClearPass node to probe all SNMP
configured devices. By default, a ClearPass node in a cluster only reads network device information for devices
configured to send traps to that node.

1. From the Add Device page, select the SNMP Read Settings tab.

The SNMP Read Settings dialog opens:

Figure 428 Add Device > SNMP Read Settings Dialog

2. Enter the SNMP Read Settings parameters as described in Table 2:
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Parameter Action/Description

Allow SNMP
Read

Toggle to enable or disable SNMP Read operations.

Policy
Manager
Zone

You can assign Network Access Devices to a zone, allowing the SNMP service to poll or query
only the NADs that are in its zone.
n From the Policy Manager Zone drop-down, select the zone assigned to the network device

that is being added.
OnConnect Enforcement is triggered when a trap from a NAD is received by a ClearPass node. If
the zone assigned to a ClearPass node is not same as the zone configured here, then OnConnect
Enforcement is not triggered on that ClearPass node.
NOTE: This setting can be empty or null.

SNMP Read
Setting

Specify one of the following SNMP Read Settings:
l SNMP v1 with community strings
l SNMP v2 with community strings
l SNMP v3 with no Authentication
l SNMP v3 with Authentication using MD5 and no Privacy
l SNMP v3 with Authentication using MD5 and with Privacy
l SNMP v3 with Authentication using SHA and no Privacy
l SNMP v3 with Authentication using SHA and with Privacy

NOTE: The MD5 authentication type is not supported when you use ClearPass Policy Manager in
FIPS mode.

Community
String

Enter the community string for sending the traps.
NOTE: Available in SNMP v2 only.

Verify Reenter the community string for sending the traps.

Force Read Enable Force Read to ensure that all ClearPass Policy Manager nodes in the cluster read SNMP
information from this device regardless of the trap configuration on the device.
This option is useful when demonstrating a static IP-based device profiling because this does not
require any trap configuration on the network device.
NOTE: Available in SNMP v1 and SNMP v2 only.

Read ARP
Table Info

Enable the Read ARP table on this device check box on a Layer-3 device if you intend to use
the ARP table on this device to discover endpoints in the network.
NOTE: When this option is selected, all ARP entries read during periodic Network Access Device
reads are added to ClearPass endpoints. SNMP, WMI, NMAP, and SSH scans are not used in this
process.

Username Specify the Admin user name to use for SNMP read operations.
NOTE: Available in SNMP v3 only.

Table 2: Add Device > SNMP Read Settings Parameters
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Parameter Action/Description

Authentication
Key

Specify the SNMP v3 with authentication option (SHA or MD5).
NOTE: The EAP-MD5 authentication type is not supported if you run ClearPass Policy Manager in
FIPS mode.
NOTE: Authentication Key is available in SNMP v3 only.

Privacy Key Specify the SNMP v3 with privacy option.
NOTE: Available in SNMP v3 only.

Privacy
Protocol

Choose one of the available privacy protocols:
l DES-CBC
l AES-128

NOTE: This option is available in SNMP v3 with Privacy only. Privacy allows for encryption of SNMP
v3 messages to ensure confidentiality of data.

SNMP Write Settings Parameters
Use the SNMP Write Settings tab to define values that allow ClearPass Policy Manager to write to (manage)
the device using SNMPv1, SNMPv2, or SNMPv3.

1. From the Add Device page, select the SNMP Write Settings tab.

The SNMP Write Settings dialog opens:

Figure 429 Add Device > SNMP Write Settings Dialog

2. Enter the SNMP Write Settings parameters as described in Table 3.

Parameter Action/Description

Allow SNMP
Write

Toggle to enable or disable SNMP write.

Default VLAN Specify the VLAN port setting after the SNMP-enforced session expires.

SNMP Write
Setting

Specify the SNMP Write setting for the device. You can set any of the following options:
l SNMP v1 with community strings
l SNMP v2 with community strings
l SNMP v3 with no Authentication
l SNMP v3 with Authentication using MD5 and no Privacy
l SNMP v3 with Authentication using MD5 and with Privacy

Table 3: Add Device > SNMP Write Settings Parameters
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Parameter Action/Description

l SNMP v3 with Authentication using SHA and no Privacy
l SNMP v3 with Authentication using SHA and with Privacy

NOTE: The MD5 authentication type is not supported if you use ClearPass Policy Manager in
FIPS mode.

Community
String

Enter the community string for sending the traps.

Verify Reenter the community string for sending the traps.

CLI Settings Parameters
Use the CLI Settings tab to enable or disable the CLI, and define user names, passwords, and port settings for
accessing the CLI.

1. From the Add Device page, select the CLI Settings tab.

The CLI Settings dialog opens:

Figure 430 Add Device > CLI Settings Dialog

2. Enter the CLI Settings parameters as described in Table 4:

Parameter Action/Description

Allow CLI Access Toggle to enable or disable CLI access.

Access Type Select SSH or Telnet.
Policy Manager uses the selected access method to log into the device CLI.

Port Specify the SSH or Telnet TCP port number.

Table 4: Add Device > CLI Parameters
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Parameter Action/Description

Username Enter the username to log into the CLI.

Password Enter the password to log into the CLI.

Username Prompt Regex Specify the regular expression for the username prompt.
Policy Manager looks for this pattern to recognize the Telnet username prompt.

Password Prompt Regex Specify the regular expression for the password prompt.
Policy Manager looks for this pattern to recognize the Telnet password prompt.

Command Prompt Regex Specify the regular expression for the command line prompt.
Policy Manager looks for this pattern to recognize the Telnet command-line prompt.

Enable Prompt Regex Specify the regular expression for the command line in the enable prompt.
Policy Manager looks for this pattern to recognize the Telnet command-line prompt.

Enable Password Enter then reenter the credentials for the Enable password in the CLI.

Enabling ClearPass OnConnect Enforcement on a Network Device
OnConnect Enforcement is an enforcement model that allows you to use non-802.1X methods for device
scans, VLAN placement, and so on. OnConnect Enforcement allows enforcement in non-802.1X environments
without the need for an agent (such as OnGuard) on the endpoint.

When this feature is enabled, ClearPass performs the following actions:

n Detects when a new endpoint connects to the network.

n Scans the endpoint to identify the logged-in user and other device-specific information.

n Triggers a Web-based authentication (WebAuth) for the device.

n Performs SNMP-based enforcement to change the network access profile for the device.

To enable ClearPass OnConnect Enforcement on a network device:

1. From the Add Device page, select the OnConnect Enforcement tab.

The OnConnect Enforcement dialog opens:
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Figure 431 Add Device > OnConnect Enforcement Dialog

2. Enter the OnConnect Enforcement parameters as described in Table 5.

Parameter Action/Description

Enable Select this check box to enable ClearPass OnConnect on the network access device being added.

Port Names Specify the names and descriptions of the ports to be enabled for OnConnect Enforcement (see the
next section for details). You can do so in two ways:
n Click Query Ports.
n You can also enter port names manually as a comma-separated list.
Only the ports added in the Port Names field will have OnConnect Enforcement enabled.
For example, if you add the port names Fa1/0/3,Fa1/0/5, when clients connect to any of these ports
on the specified network device, OnConnect Enforcement is triggered on that network device.
NOTE: An empty string will enable OnConnect on all ports. ClearPass will attempt to determine the
uplink or upstream trunk ports; however, it is recommended to explicitly remove those ports.

Query Ports To display the list of ports on the current server, click Query Ports.

Add to Port
Names

Once the list of ports are displayed, select the desired ports from the displayed list, then click Add
to Port Names.
The selected ports are added to the Port Names field.

Table 5: Add Device > OnConnect Enforcement Parameters

Querying and Selecting Port Names for OnConnect Enforcement
To query and select port names for a network access device for OnConnect Enforcement:

1. From the Configuration > Network > Devices page, select the network device.

2. From the Edit Device Details page, select the SNMP Read Settings tab (see Table 2 above).

3. In the Allow SNMP Read parameter, select the Enable Policy Manager to perform SNMP read
operations check box.

4. Select the OnConnect Enforcement tab.
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5. Click the Query Ports button.

The list of ports are displayed, as shown in Figure 432.

Figure 432 Querying Ports

6. Select the ports to use, then click Add to Port Names.

The selected port names are added to the Port Names list. Only the ports added in the Port Names field
will have OnConnect Enforcement enabled.

7. Click Save.
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Attributes Parameters
To add custom attributes for this device:

1. From the Add Device page, select the Attributes tab.

The Attributes dialog opens:

Figure 433 Adding Custom Device Attributes

2. From the Attribute field, click Click to add....
By default, the following custom attributes appear in the Attribute drop down:

l Controller ID

l Device Type

l Device Vendor

l Location

l OS Version

l sysContact

l sysLocation

l sysName

3. Select one of the default attributes or enter a new attribute.

You can enter any name in the Attribute field. All attributes are of string datatype.

4. Specify the attribute's value.

You can populate the Value field with any string.

5. Repeat this procedure as necessary.

6. When finished adding custom attributes, click Add.

All attributes entered for a device are available in the role-mapping Rules Editor under the Device
namespace.

Modifying a Network Device
To modify a ClearPass network device:

1. Navigate to the Configuration > Network > Devices page.

The Network Devices page opens.
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Figure 434 Network Devices Page

2. Select the network device you want to modify.

The Edit Device Details dialog opens.

Figure 435 Modifying a Network Device

3. Modify any device settings as necessary.

For details about all of the Network Device tabs and parameters, refer to the previous section, Adding a
Network Device.

If you disable RadSec, the shared secret is removed; you will have to reenter the original shared secret.

4. Click Save.

Adding and Modifying Device Groups
Policy Manager groups devices into Device Groups, which function as a component in service and role-
mapping rules. Device groups can also be associated with enforcement profiles; Policy Manager sends the
attributes associated with these profiles only if the request originated from a device belong to the device
groups.

Administrators configure device groups at the global level. Device groups can contain the members of the IP
address of a specified subnet, regular expression-based variation, or devices that are previously configured in
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the Policy Manager database.

Policy Manager lists all configured device groups in the Device Groups page (Configuration > Network >
Device Groups) .

Adding a Device Group
To add a device group:

1. Navigate to Configuration > Network > Device Groups .

The Network Device Groups page opens:

Figure 436 Device Groups Page

2. Click Add.

3. Complete the fields in the Add New Device Group page as described in the following figure:
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Figure 437 Add New Device Group Page

4. Specify the Add New Device Group page parameters as described in the following table:

Parameter Action/Description

Name Enter the name of the device group.

Description Optionally, enter the description that provides additional information
about the device group.

Format Select the format: Subnet, Regular Expression, or List.

Table 1: Add New Device Group Page
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Parameter Action/Description

Subnet Enter a subnet consisting of network address and the network suffix
(CIDR notation). For example, 192.168.5.0/24.

Regular
Expression

Specify a regular expression that represents all IPv4 addresses
matching that expression. For example, ^192(.[0-9]*){3}$.

List:
Available/Selected
Devices

Use the widgets to move device identifiers between Available and
Selected.
To filter the list based on the text in the associated text box, click Filter.

5. Click Save.

Adding and Modifying Proxy Targets
A proxy server is a dedicated computer or a software system running on a computer that acts as an
intermediary between an endpoint device, such as a computer, and another server from which a user or client
is requesting a service. The proxy server can exist in the same machine as a firewall server or it canbe on a
separate server, which forwards requests through the firewall.

In ClearPass Policy Manager, a proxy target represents a RADIUS server (Policy Manager or a third party) that is
the target of a proxied RADIUS request.

For example, when a branch office employee visits a main office and logs into the network, Policy Manager
assigns the request to the first service in priority order that contains a service rule for RADIUS proxy services
and appends the domain to the username.

Proxy targets are configured at a global level. They can be used in configuring RADIUS proxy services. For more
information, refer to Configuring Other Policy Manager Services on page 61.

Adding a Proxy Target
To add a proxy target:

1. Navigate to Configuration > Network > Proxy Targets.

The Proxy Targets page opens. Policy Manager lists all configured proxy servers in the Proxy Targets
page.

2. Click Add.

The Add Proxy Target dialog opens.

Figure 438 Add Proxy Target Dialog
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3. Specify the Add Proxy Target parameters as described in the following table, then click Save:

Parameter Action/Description

Name Enter the name of the proxy target.

Description Enter the description that provides additional information about the proxy target.

Hostname/Shared
Secret

Specify the RADIUS hostname.

Shared Secret
Verify Shared Secret

Enter the shared secret, then verify it.
NOTE: Use the same shared secret that you entered on the proxy target (refer to your
RADIUS server configuration).

RADIUS
Authentication Port

Enter the UDP port to send the RADIUS request. The default value for this port is 1812.

RADIUS Accounting
Port

Enter the UDP port to send the RADIUS accounting request. The default value for this port
is 1813.

Table 1: Add Proxy Target Parameters

Configuring the Ingress Event Source
An event source is a device that sends Syslog events to ClearPass.

Any events sent that are not from configured event sources are ignored.

To configure an Event Source:

1. Navigate to Configuration > Network > Event Sources.

The Event Sources page opens.

2. To add the Event Source for the desired vendor, click Add.

The Add Event Source dialog opens.

Figure 439 Adding an Event Source

3. Populate the Add Event Source parameters as described in Table 1.
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Parameter Action/Description

Name Enter the name or the IP address of the device that will send Syslog events to ClearPass.

Description Optionally, enter a description of this Event Source.

IP Address Enter the IP address of the device that will send Syslog events to ClearPass.

Type From the drop-down, select Syslog.

Vendor From the drop-down, select the event source Vendor:
n Aruba Introspect
n Check Point
n Infoblox
n Juniper Networks
n Palo Alto Networks

Enable Select this check box to enable the device as an Event Source.

Table 1: Configuring the Add Event Source Parameters

4. When finished, click Add.

The Event Sources page now displays the new Event Sources (see Figure 440).

Figure 440 Event Sources Page

Note that the IP address displayed in Figure 440 is the IP address and host name of the Juniper SRX
gateway that sends Syslog events to ClearPass.
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Chapter 9
Network Scan and Profile Settings

This chapter provides the following information:

n Configuring SNMP, SSH, and WMI Credentials

n Scheduling Network Scans and Subnet Scans

Configuring SNMP, SSH, and WMI Credentials
This section provides the following information:

n About Network Scan

n SNMP Credentials Configuration

n SSH Credentials Configuration

n WMI Credentials Configuration

About Network Scan
Network Scan uses a configured seed network device (typically a switch, router, or controller) to discover
endpoints and network devices. You can schedule network scans and subnet scans (see Scheduling Network
Scans and Subnet Scans).

The following information is read from the seed device:

n SNMP information

An SNMP description is necessary for discovering and profiling the network devices. For more information,
see SNMP Credentials Configuration.

n SSH credentials

For Linux server or network device discovery, specify SSH configuration credentials. For more information,
see SSH Credentials Configuration.

n WMI credentials

For Windows device discovery, specify WMI (Windows Management Instrumentation) credentials. For more
information, see WMI Credentials Configuration.

n Connected endpoints

Information about endpoints connected to the network device (typically MAC addresses of endpoints
connected to switch ports). These are added as discovered endpoints. For more information, see
Configuring SNMP, SSH, and WMI Credentials.

n ARP table

ClearPass supports Address Resolution Protocol (ARP) probes for network discovery scans. When the Read
ARP Table Info option is enabled, the scan also probes all available ARP entries. The ARP table provides
information about MAC address > IP associations for endpoints that were recently seen by this device.
These endpoints are probed further in an attempt to profile those devices. For more information, see SNMP
Read Settings Parameters.

n Neighbor network devices

Other network devices connected to the seed device as determined by neighbor discovery protocols such as
Cisco Discovery Protocol (CDP) and Link Layer Discovery Protocol (LLDP) (if enabled in your network).
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Each of the discovered neighbor network devices are further queried as seed devices; this is repeated for
multiple levels in your network up to a specified scan depth. For more information, see Monitoring
Discovered Devices).

n Services and processes running on an Endpoint

During the subnet scan, Network Discovery and the OnConnect domain-joined Windows client will be
queried to retrieve all the services and processes running on the endpoint. This information will be
displayed in the ClearPass Insight Endpoint reports.

Network Scan High-Level Tasks
Configuring Network Scan consists of these major tasks:

1. Add the configurations (SNMP, SSH, or WMI) needed to query all the devices in the target network.

You must configure SNMP, SSH, and WMI credentials for the devices that you want to discover as part of
the network scan. These credentials are used during a network scan or a subnet scan to profile Linux servers
and machines (SSH credentials), Windows servers and machines (WMI credentials), and network devices
(SNMP).

2. Schedule a network scan or subnet scan (see Scheduling Network Scans and Subnet Scans).

3. Import the discovered network devices into ClearPass (see Importing Network Devices).

4. Review the set of discovered devices and view the connected endpoints and neighbors (see Viewing Details
on a Discovered Device).

SNMP Credentials Configuration
For querying hosts discovered by a subnet scan, specify SNMP configuration. An SNMP-based scan sends an
SNMP request to retrieve the network device information.

To add the SNMP configuration for a network scan or subnet scan:

1. Navigate to Configuration > Profile and Network Scan > Profile Settings.

The Profile Settings > SNMP Configuration page opens.

Figure 441 SNMP Configuration Page

2. Click the Add SNMP Configuration link.

The SNMP Configuration dialog opens.
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Figure 442 Adding an SNMP Configuration

3. Specify the SNMP Configuration parameters as described in Table 1.

Field Action/Description

IP Subnets/ IP
Addresses

Enter either one or more IP subnets or one or more IP addresses.
For multiple entries, separate multiple IP addresses with commas.
When you schedule the network scan, ClearPass will use the SNMP configuration to fetch the
network device information for discovered devices.

SNMP Version From the drop-down, select the appropriate SNMP version:
n SNMP v1 with community strings
n SNMP v2 with community strings
n SNMP v3 with no Authentication
n SNMP v3 with Authentication using MD5 and no privacy
n SNMP v3 with Authentication using MD5 with privacy
n SNMP v3 with Authentication using SHA and no privacy
n SNMP v3 with Authentication using SHA with privacy

Description Optionally, enter a description of this SNMP configuration (recommended).

Community
String

Enter the community string, then reenter the community string in the Verify field.

Table 1: SNMP Configuration Parameters

4. When finished, click Save Entry.

5. Repeat these steps to add additional SNMP credentials per subnet.

6. When finished, click Save.

You return to the SNMP Configuration tab, where the new SNMP configuration information has been
added, and the following message is displayed:

SNMP configuration added successfully

SSH Credentials Configuration
For Linux servers or network device discovery, specify SSH (Secure Shell) configuration credentials. When SSH
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is found for an IP address or subnet, Network Scan looks for any Linux server or machine associated with that
IP address or subnet.

You can configure multiple user names and passwords. These credentials are organized in the order in which
they were created.

To configure SSH credentials for a network scan or subnet scan:

The SSH configuration can be for a single IP address or a subnet. These credentials are used when an SSH scan is
initiated.

1. Navigate to Configuration > Profile and Network Scan > Profile Settings.

The Profile Settings page opens.

2. Select the SSH Configuration tab.

Figure 443 SSH Configuration Tab

3. Click Add Configuration.

The SSH Configuration page opens.

Figure 444 SSH Configuration Page

4. Specify the parameters in the SSH Configuration dialog as described in the following table, then click Save
Entry.
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Field Action/Description

IP Subnets/ IP
Addresses

Enter either one or more IP subnets or one or more IP addresses. For multiple entries,
separate multiple IP addresses with commas.

Username Enter the username for the device or subnet specified.

Password Enter the password for the device or subnet specified.

Enable
Password

Enter the Enable password, then reenter the password in the Enable Password Verify field.

Description Optionally, enter a description of this SNMP configuration (recommended).

Table 2: SSH Configuration Parameters

5. Repeat this procedure for additional entries if needed.

6. When finished, click Save.

You return to the Profile Settings page, where you can see that the SSH configuration has been added
successfully (see Figure 445).

Figure 445 SSH Configuration Added Successfully

WMI Credentials Configuration
For Windows device discovery, specify WMI (Windows Management Instrumentation) configuration
credentials. WMI configuration is necessary to discover Windows systems and device fingerprint details.

WMI a key part of the Windows operating system. It's used to gather system statistics, monitor system health,
and manage system components. To work properly, WMI relies on the WMI service. This service must be
running and properly configured for your environment.

For WMI, the login format for username is usually domain\username. Whatever domain you provide, it will
be prepended to the username before logging into that machine.

Suppose you have provided an IP subnet address:

n ClearPass first checks to see if WMI is configured for that subnet/IP address.

n If WMI is configured, ClearPass checks to see if port 135 is open.

n If port 135 is open, ClearPass attempts the WMI login with those credentials.

If you provide just one IP address, the WMI login is performed for that particular IP address only.

To configure WMI credentials for a network scan or subnet scan:

1. Navigate to Configuration > Profile and Network Scan > Profile Settings.

The Profile Settings page opens.

2. Select the WMI Configuration tab.
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Figure 446 WMI Configuration Tab

3. Click Add Configuration.

The WMI Configuration page opens.

Figure 447 WMI Configuration Page

4. Specify the WMI Configuration parameters as described in Table 3, then click Save Entry.

Field Action/Description

IP Subnets/ IP
Addresses

Enter either one or more IP subnets or one or more IP addresses. For multiple entries,
separate multiple IP addresses with commas.
NOTE: The WMI configuration can be for a single IP address or a subnet. These credentials are
used when a WMI scan is scheduled.

Domain Enter the name of the Windows domain for logging into the device(s) that you are scanning.

Username Enter the username for the device or subnet specified.

Password Enter the password for the device or subnet specified.

Description Optionally, enter a description of this SNMP configuration (recommended).

Table 3: WMI Configuration Parameters

5. Repeat this procedure for additional entries if needed.

6. When finished, click Save.

You return to the Profile Settings page, where you can see that the WMI configuration has been added
successfully (see Figure 448).
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Figure 448 WMI Configuration Added Successfully

Scheduling Network Scans and Subnet Scans
This section provides the following information:

n Network Scan High-Level Tasks

n Scheduling a Network Scan

n Scheduling a Subnet Scan

n Viewing Details About a Subnet Scan

n Configuring Nmap-Based Endpoint Port Scans

Network Scan High-Level Tasks
Configuring Network Scan operations consist of these major tasks:

1. Add the configurations (SNMP, SSH, or WMI) needed to query all the devices in the target network (for
details, see Configuring SNMP, SSH, and WMI Credentials).

You must configure SNMP, SSH, and WMI credentials for the devices that you want to discover as part of
the network scan. These credentials are used during a network scan or a subnet scan to profile Linux servers
and machines (SSH credentials), Windows servers and machines (WMI credentials), and network devices
(SNMP).

2. Schedule a network scan or a subnet scan (as described in this section).

3. After running a network scan, import the discovered network devices into ClearPass (see Monitoring
Discovered Devices).

4. Review the set of discovered devices and view the connected endpoints and neighbors (see Monitoring
Discovered Devices).

Scheduling a Network Scan
Seed devices are the initial IP addresses provided by the network administrator to start the network scan.
When you initiate a network scan and specify the seed devices, network discovery uses SNMP to:

n Find any other devices connected to the seed devices.

n Profile the connected devices.

n ClearPass uses that information to detect more devices in the network. The network discovery scan will
proceed to the network depth specified by the Scan Depth parameter (described in Table 1 below).

n You can go to those devices and see their neighbor devices.

Running a network scan on seed devices is a time- and resource-consuming operation. Depending on the number of
devices associated with the seed device, a complete scan can take more than an hour.
It is recommended that the network scan should be done outside of normal business hours or performed on a
ClearPass node that is not servicing core authentications.
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To schedule a network scan:

1. Navigate to Configuration > Profile and Network Scan > Network Scan.

The Network Scan page opens.

Figure 449 Network Scan Page

2. Click the Start Scan link.

The Schedule Scan dialog opens.

Figure 450 Scheduling a Network Scan

3. Specify the Schedule Scan parameters as described in Table 1.
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Field Action/Description

Scan Type Select Network Scan.
NOTE: For scan operations to be operable, the Master Server in Zone parameter
must be configured. The master ClearPass server in a zone distributes the load among
other ClearPass nodes in the zone. For details, see Master Server in Zone.

Zone Specify the ClearPass Zone (for more information, see Managing Policy Manager
Zones).
If a Zone is not configured, accept the default zone.
NOTE: The primary master server in the zone forwards the scan request to the other
ClearPass nodes in the zone, depending on the seed device. Each scan configuration
added is distributed by the master to a different node in the zone. If one scan
configuration has multiple seed devices, all the seed devices are forwarded to one
node.

Seed Devices Enter the IP addresses of one or more seed devices from which the network scan
should proceed.
Separate multiple device IP addresses with commas.

Frequency of Scan Specify the frequency of the network scan:
n On Demand

This option runs the network scan once, either immediately if no start time is
specified, or at the time specified by the Start Time of Scan parameter.

n Hourly
n Daily
n Weekly

Scan Depth Specify the Scan Depth by selecting the desired number from 1 to 5.
The Scan Depth numbers indicate the levels of the network you want to scan. The
default is Scan Depth3.
The seed devices are, by default, at Scan Depth1. Starting from the seed device, the
next device level is Scan Depth 2, and so on, until the scan reaches the scan depth
specified here.

Probe ARP entries The ARP (Address Resolution Protocol) table provides information about MAC address
and IP address associations for endpoints that were discovered by this ClearPass
server.
The ARP entries for the specified network(s) are read irrespective of whether this
check box is enabled.
When this option is enabled, ClearPass uses the ARP entries to discover network
access devices (NADs), then proceeds to perform a network scan to the configured
scan depth.

Table 1: Schedule Network Scan Parameters

4. Click Save.

You return to the Network Scan page, which now indicates the following:

l ClearPass Policy Manager Zone specified for the scan

l Type of scan: Network
l IP address(es) of the seed device(s) or subnet(s)

l Details such as scan depth and whether ARP probe is enabled or not

l Schedule specified for the network scan

If a Start Time and End Time for the network scan was configured, that information is displayed.

If the scan was set for On Demand, the Schedule field displaysOn Demand.

l The Status of the network scan operation, which shows initially as Running," and finally, "Completed."
The green status indicator indicates that the scan operation was successful.
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l To restart a completed scan, click the green Status button.

Figure 451 Seed Device Successfully Scanned

Scheduling a Subnet Scan
To schedule a subnet scan:

1. Navigate to Configuration > Profile and Network Scan > Network Scan.

The Network Scan page opens.

2. Click the Start Scan link.

The Schedule Scan dialog opens.

Figure 452 Scheduling a Subnet Scan

3. Specify the Subnet Scan parameters as described in the following table:

Field Action/Description

Scan Type Select Subnet Scan.
n You can schedule multiple subnet scans per zone.
n To monitor subnet scan progress, navigate to Monitoring > Profiler and

Discovery > Network Scan.
NOTE: For scan operations to be operable, Zone Master must be configured. The Zone
Master distributes the load among other nodes in the zone.

Zone Specify the ClearPass Zone.
If a Zone is not configured, accept the default.

IP Subnets Enter the IP addresses of one or more IP subnets from which the subnet scan should
proceed. Separate multiple IP subnets with commas.

Table 2: Schedule Subnet Scan Parameters
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Field Action/Description

Frequency of Scan Specify the frequency of the scan:
n On Demand

This option runs the subnet scan once, either immediately if no start time is
specified, or at the time specified by the Start Time of Scan parameter.

n Hourly
n Daily
n Weekly

Start Time of Scan Select the time for the subnet scan to start.

4. Click Save.

You return to the Network Scan page, which now indicates the following:

l ClearPass Policy Manager Zone specified for the scan

l Type of scan: Subnet
l IP subnet(s) specified for the subnet scan

l Schedule specified for the subnet scan

If a Start Time and End Time for the subnet scan was configured, that information is displayed.

If the scan was set for On Demand, the Schedule field displays Runs only once On Demand starts at
<time specified>.

l The Status of the network scan operation, which shows initially as Running," and finally, "Completed."
The green status indicator indicates that the subnet scan has been scheduled.

Figure 453 Information Displayed for Scheduled Scans

Viewing Details About a Subnet Scan
Additional information is available for the scheduled subnet scans.

To view the details about a subnet scan:

1. Navigate to Monitoring > Profile and Network Scan > Network Scan.

The Monitoring > Network Scan page opens.
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Figure 454 Monitoring: Network Scan Page

2. Click anywhere on the line for the subnet scan of interest.

The Subnet Scan Results page opens.

Figure 455 Subnet Scan Results Page

The Subnet Scan Results page provides the following information regarding the selected subnet scan:

Field Description

Zone Specifies the ClearPass Policy Manager Zone in which the subnet resides.

Start Time Indicates the date and time when the subnet scan started.

End Time Indicates the date and time when the subnet scan was completed.

Active Hosts Indicates the number of active hosts in the subnet.
An active host is a network device that is up in the network.

Table 3: Subnet Scan Results: Information Provided
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Field Description

Failed Hosts Indicates the number of failed hosts in the subnet.
A failed host is a host that is not up in the network.

Status Displays the status of the subnet scan. The possible status states are:
n Failed
n Running
n Completed

Scan Errors Displays any errors that occurred during the subnet scan.

Configuring Nmap-Based Endpoint Port Scans
The network scan feature supports running an Nmap (Network Mapper)-based scan on a host to detect open
ports and also to fingerprint the services running behind those ports. This information is used in the device
profile.

To configure endpoint port scans using Nmap:

1. Enable Nmap-based endpoint port scans.

a. Navigate to Administration > Server Manager > Server Configuration > Cluster-Wide
Parameters.

The Cluster-Wide Parameters page opens.

b. Select the Profiler tab.

Figure 456 Cluster-Wide Parameters > Profiler Dialog

c. Set the Enable Endpoint Port Scans using Nmap parameter to TRUE, then click Save.

For more information, see Profiler Parameters.

Setting this value to TRUE enables active scan of the host for open ports. This can be resource intensive. Also, the
Profiler Scan Ports value is ignored when Nmap scan is enabled.

2. Schedule a network scan configuring a seed device with Probe ARP entries enabled (see Scheduling a
Network Scan).

3. When the network scan is completed, select an endpoint (see Adding and Modifying Endpoints).
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a. Navigate to Configuration > Identity > Endpoints.

b. From the Endpoints page, click the endpoint of interest.

The Edit Endpoint page opens.

Figure 457 Edit Endpoint Page

4. To view the list of host services and the list of open ports returned by the network scan for the selected
host or endpoint, select the Fingerprints tab (see Figure 458).

Figure 458 Endpoint Fingerprint Details with Nmap Scan Data Included
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Chapter 10
Configuring Policy Simulation

After creating policies, use the Policy Simulation

feature to evaluate those policies before deployment. The Policy Simulation feature applies a set of request
parameters as input against a given policy component and displays the outcome.

To configure a policy simulation:

1. Navigate to Configuration > Policy Simulation.

The Policy Simulation page opens.

Figure 459 Policy Simulation Page

This chapter describes the following types of policy simulations:

n Active Directory Authentication Simulation

n Application Authentication Simulation

n Audit Simulation

n Chained Simulation

n Enforcement Policy Simulation

n RADIUS Authentication Simulation

n Role Mapping Simulation

n Service Categorization Simulation

Active Directory Authentication Simulation
This section provides the following information:

n Adding an Active Directory Simulation

n Viewing the Simulation Results

This simulation tests authentication against an Active Directory domain or trusted domain to verify that the
ClearPass Policy Manager domain membership is valid.

The Attributes tab is not available for this simulation type.

Adding an Active Directory Simulation
To add an Active Directory simulation for the authentication test:

1. Navigate to the Configuration > Policy Simulation > Add page.

The Add Policy Simulation dialog opens.
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Figure 460 Active Directory Authentication > Simulation Tab

2. Specify the Active Directory Authentication > Simulation tab parameters as described in the following
table:

Parameter Action/Description

Name Enter the name of the simulation

Description Provide a description of this simulation.

Type Active Directory Authentication is specified by default.

Simulation Details

Active Directory Domain Select the Active Directory domain to which the node is joined.

Username Enter the username to log in to the domain.

Password Enter the password to log in to the domain.

Table 1: Active Directory Authentication Simulation Tab Parameters

Viewing the Simulation Results
The Results tab for the Active Directory Authentication simulation displays a summary of the
Authentication test and provides a status message.

The following figure displays the Active Directory Authentication > Results tab:

Figure 461 Active Directory Authentication Results Tab
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Parameter Description

Summary Displays the results of the Active Directory Authentication simulation.

Status Displays the status message.

Table 2: Active Directory Authentication Results Tab Parameters

Application Authentication Simulation
This simulation tests authentication requests generated from ClearPass Guest. The following figure displays
the Application Authentication policy simulation settings available on the Configuration > Policy
Simulation > Add page:

Simulation Tab
Figure 462 Application Authentication - Simulation Tab

Parameter Description

CPPM IP Address/FQDN Enter the IP Address or FQDN of the domain(s) to which the node is joined.

Username Enter the username.

Password Enter the password.

Table 1: Application Authentication Simulation Tab Parameters

Attributes Tab

Enter the attributes of the policy component to be tested. The following figure displays the Application
Authentication - Attributes tab:

Figure 463 Application Authentication - Attributes Tab
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Table 23: Application Authentication - Attributes Tab Parameters

Attribute Parameter

Type Select Application or select Application:ClearPass. See Application Namespace

Name The options displayed for the Name Attribute depend on the Type Attribute that was
selected.

Value The options displayed for the Value Attribute depend on the Type Attribute and Name
Attribute that were selected.

Results tab

The Results tab of the Application Authentication simulation displays the outcome of the Authentication
Result and the Application Authentication Output Attributes. The following figure displays the
Application Authentication Results tab:

Figure 464 Application Authentication Results Tab

Parameter Description

Summary Displays the results of the Active Directory Authentication simulation.

Application Authentication
Output Attributes

Displays the output attributes, such as Super Administrator.

Table 2: Application Authentication Results Tab Parameters

Audit Simulation
This simulation allows you to specify an audit against a Nessus Server or Nmap Server with its IP address.

The Attributes tab is not available for this simulation type.

Audit simulations can take more than 30 minutes. An AuditinProgress status message is displayed until the audit is
completed.
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The following figure displays the Audit Simulation tab:

Figure 465 Audit Simulation - Simulation Tab

The following table describes the Audit Simulation - Simulation tab parameters:

Parameter Description

Audit Server Select [Nessus Server] or [Nmap Audit].

Audit Host IP Address Enter the host IP address of the audit host.

Table 1: Audit Simulation Tab Parameters

Results Tab
The following figure displays the Audit Simulation - Results tab:

Figure 466 Audit Simulation Results Tab

The following table describes the Audit Simulation - Results tab parameters:

Parameter Description

Summary Displays information about the Audit Status, Temporary Status, and Audit Timeout.

Audit Output Attributes Displays the Audit-Status such as AUDIT_INPROGRESS.

Table 2: Audit Results Tab Parameters
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Chained Simulation
Given the service name, authentication source, user name, and an optional date and time, the chained
simulation combines the results of role mapping, posture validation and enforcement policy simulations and
displays the corresponding results.

Simulation Tab
The following figure displays the Chained Simulation Simulation tab:

Figure 467 Chained Simulation Tab

The following table describes the Chained Simulation - Results tab parameters:

Parameters Description

Service Select from:
n [Policy Manager Admin Network Login Service]
n [AirGroup Authorization Service]
n [Aruba Device Access Service]
n [Guest Operator Logins]
n Guest Access
n Guest Access With MAC Caching

Authentication
Source

Default Value = [Local User Repository] if you select: 

n [Policy Manager Admin Network Login Service]
n [Aruba Device Access Service]

Default Value = [Guest Device Repository] if you select:
n [AirGroup Authorization Service]
n Guest Access
n Guest Access With MAC Caching

Values = [Guest Device Repository] or [Local User Repository] if you select [Guest Operator
Logins]

Username Enter the username.

Test Date and
Time

Click the calendar icon to select a start date and time for simulation test. For more inform-
ation, see Date Namespaces

Table 1: Chained Simulation Tab Parameters

Attributes Tab

Enter the attributes of the policy component to be tested.
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Figure 468 Chained Simulation Attributes Tab

The following table describes the Chained Simulation Attributes - Results tab parameters:
Table 24: Chained Simulation Attributes tab Parameters

Attribute Parameter

Type Select the type of attributes from the drop-down list.

Host See Host Namespaces

Authentication See Authentication Namespaces

Connection See Connection Namespaces

Application See Application Namespace

Certificate See Certificate Namespaces on page 985

n Radius:IETF
n Radius:Cisco
n Radius:Microsoft
n Radius:Avenda
n Radius:Aruba
n Trend:AV
n Cisco: HIPS
n Cisco:HOST
n Cisco:PA
n NAI:AV
n Symantec:AV

See RADIUS Namespaces

Name The options displayed for the Name attribute depend on the Type
attribute that was selected.

Value The options displayed for the Value attribute depend on the Type and
Name attributes that were selected.

ClearPass 6.7 Policy Manager | User Guide Configuring Policy Simulation | 462
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1494



463 | Configuring Policy Simulation ClearPass 6.7 Policy Manager |  User Guide

Results Tab
The following figure displays the Chained Simulation - Results tab:

Figure 469 Chained Simulation Results Tab

Parameter Description

Summary Provides the following information about the chained simulation:

n Status
n Roles
n System Posture Status
n Enforcement Profiles

Table 2: Chained Simulation Results Tab Parameters

Enforcement Policy Simulation
Given the service name (and the associated enforcement policy), a role or a set of roles, the system posture
status, and an optional date and time, the enforcement policy simulation evaluates the rules in the
enforcement policy and displays the resulting enforcement profiles and their contents.

Authentication Source and User Name inputs are used to derive dynamic values in the enforcement profile
that are retrieved from the authorization source. These inputs are optional. Dynamic roles are attributes that
are enabled as a role retrieved from the authorization source. For an example of enabling attributes as a role,
see Generic LDAP and Active Directory on page 187.

To configure an enforcement policy simulation:

1. Navigate to Configuration > Policy Simulation.

The Policy Simulation page opens.

2. Click the Add link.

The Add Policy Simulation page opens to the Simulation tab.
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Figure 470 Enforcement Policy Simulation Tab

3. Specify the Policy Simulation tab parameters as described in the following table:

Parameter Action/Description

Name Enter the name of this policy simulation

Description Enter a description of this policy simulation

Type From the Type drop-down, select Enforcement Policy.

Service From the Service drop-down, select the appropriate service.

Enforcement Policy Depending on which service you selected, the value for the Enforcement Policy will
be filled automatically.

Authentication Source Value = [Local User Repository] if you select:
n [Policy Manager Admin Network Login Service]
n [Aruba Device Access Service]
Value = [Guest Device Repository] if you select:
n [AirGroup Authorization Service]
n Guest Access
n Guest Access With MAC Caching
Values = [Local User Repository] or [Guest Device Repository] if you select Guest
Operator Logins

Username Enter the user name.

Table 1: Enforcement Policy Simulation Tab Parameters
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Parameter Action/Description

Roles From the Roles drop-down, select the appropriate role.

Dynamic Roles To add a role:
1. Enter the name of a dynamic role in the Add Role field.
2. Click the Add Role button to populate the Dynamic Roles list.

To remove a role, highlight the dynamic role of choice, then click Remove Role.

System Posture Status Select from:

n HEALTHY (0)
n CHECKUP (10)
n TRANSITION (15)
n QUARANTINE (20)
n INFECTED (30)
n UNKNOWN (100)

Test Date and Time Click the calendar icon to select the start date and time for the simulation test. For
more information, see Date Namespaces

Attributes Tab
Enter the attributes of the policy component to be tested.

Attribute Description

Type Select the type of attribute from the drop-down list.
n Host (for more information, see Host Namespaces).
n Authentication (for more information, see Authentication Namespaces).
n Connection (for more information, see Connection Namespaces).
n Application (for more information, seeApplication Namespace).
n Radius:IETF
n Radius:Cisco
n Radius:Hewlett-Packard-Enterprise
n Radius:Microsoft
n Radius:Alcatel-Lucent-Enterprise
n Radius:F5
n Radius:Avenda
n Radius:Freeswitch
n Radius:Aruba

For more information, see RADIUS Namespaces.

Name The options displayed for the Name attribute depend on the Type attribute that was
selected.

Value The options displayed for the Value attribute depend on the Type and Name
attributes that were selected.

Table 2: Enforcement Policy Attributes Tab Parameters

Results Tab
The following figure displays the Policy Simulation > Results tab:
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Figure 471 Policy Simulation Results Tab

Parameter Description

Deny Access Displays the output of the Deny Access test.
n False: Device/network access is permitted.
n True: Device/network access is denied.

Enforcement Profile Displays the name of the Enforcement Profile that is applied to this policy.

Table 3: Enforcement Policy Results Tab Parameters

RADIUS Authentication Simulation

This section provides the following information:

n Adding a RADIUS Authentication Simulation

n Setting the Attributes to Be Tested

n Viewing the Simulation Results

Dictionaries in the RADIUS namespace come prepackaged with the ClearPass Policy Manager. The
administration interface does provide a way to add dictionaries into the system (see RADIUS Dictionary on
page 716 for more information).

The RADIUS namespace uses the notation RADIUS:Vendor, where Vendor is the name of the company that has
defined attributes in the dictionary. The same vendor can have multiple dictionaries, in which case the "Vendor"
portion includes a suffix or some other unique string by the name of the device to differentiate the
dictionaries.

Adding a RADIUS Authentication Simulation

To add the RADIUS authentication server for the authentication test:

1. Navigate to the Configuration > Policy Simulation > Add page.

The Add Policy Simulation dialog opens.

2. Enter the Name of the simulation.

3. From the Type drop-down list, select RADIUS Authentication.

Figure 472 displays the RADIUS Authentication Simulation Details dialog, with the Server parameter
set to Remote.
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Figure 472 RADIUS Authentication Simulation Details Dialog

4. Enter the values for each of the RADIUS Simulation parameters as described in Table 1.

Parameter Action/Description

Server 1. Specify Local or Remote.

CPPM IP Address or
FQDN

This field is displayed only if Remote Server is selected.
2. Enter the IP address or the fully qualified domain name (FQDN) of the remote
ClearPass Policy Manager server.

Shared Secret Displayed only if Remote Server is selected.
3. Enter the shared secret between the target ClearPass server and this node.
You must add the node as a Network Device on the target ClearPass server. (For
details, see Adding a Network Device).

NAS IP Address (optional) 4. To populate the NAS-IP-Address attribute in a RADIUS request, enter the IP
address of the network device.

NAS Type 5. Select the type of network device to simulate in terms of RADIUS attributes in
the request. The NAS types are:

l Aruba Wireless Controller
l Aruba Wired Switch
l Cisco Wireless Controller
l Generic

Authentication outer
method

6. Specify one of the following authentication outer methods:
n PAP
n CHAP
n MSCHAPv2
n PEAP: Authentication inner method: enabled.

Select one of the following PEAP Authentication inner methods:
l EAP-MSCHAPv2
l EAP-GTC
l EAP-TLS

n TTLS: Authentication inner method field: enabled.
Select one of the following TTLS Authentication inner methods:

l PAP

Table 1: RADIUS Simulation Tab Parameters
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Parameter Action/Description

l CHAP
l MSCHAPv2
l EAP-MSCHAPv2
l EAP-GTC
l EAP-TLS

n TLS

Client MAC Address
(optional)

7. Enter the client MAC address of the network device to populate the NAS-IP
address attribute in the RADIUS request.

Username 8. Enter the user name.

CA Certificate (optional) This is the optional Root CA certificate needed to verify the RADIUS server's
certificate.

9. Click Browse and navigate to the optional Root CA certificate. Click Open, then
click Upload.

Client Certificate PKCS12
(PFX)*

This is the client certificate that is used for TLS in PKCS12 (Public-Key Cryptography
Standards).
Formats: .pfx or .p12

10. Click Browse and navigate to the Client Certificate PKCS12. Click Open, then
click Upload.

Passphrase for PFX file* 11. Enter the pass phrase for the selected PFX file.

* These fields are displayed only if you select TTLS or PEAP as the authentication outer method and you select
EAP-TLS as the authentication inner method.

12. Click Save, or click Next to proceed to the Attributes tab.

Setting the Attributes to Be Tested

The attributes that you can set depend on the NAS Type selected on the Policy Simulation page (see Figure 472).

To set the attributes to be tested:

1. From the Attributes tab, click Click to add.

The Add Policy Simulation Attributes dialog opens.

2. From the Type drop-down, select the attribute Type.
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Figure 473 Specifying Policy Simulation Attributes

3. Select the attribute Name.

4. Select the attribute Value.

5. Repeat these steps for each additional attribute you wish to add.

6. Click Save, or click Next to proceed to the Results tab.

NAS Type: Aruba Wireless Controller

Figure 474 Aruba Wireless Controller Type - Attributes

Attribute Parameter

Line 1:

n Type = Radius:IETF
n Name = NAS-Port-Type
n Value = Wireless-802.11 (19)

Line 2:

n Type = Radius:IETF
n Name = Service-Type
n Value = Login-User (1)

Line 3:

n Type = Radius:Aruba
n Name = Aruba-Essid-Name
n Value = SSID

Table 2: Aruba Wireless Controller Required - Attribute Settings
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NAS Type: Aruba Wired Switch Controller

Figure 475 NAS Type: Aruba Wired Switch Controller Attributes Tab

Attribute

Line 1:

n Type = Radius:IETF
n Name = NAS-Port-Type
n Value = Ethernet (15)

Line 2:

n Type = Radius:IETF
n Name = Service-Type
n Value = Login-User (1)

Table 3: NAS Type: Aruba Wired Switch Controller—Required Attribute Settings

NAS Type: Cisco Wireless Switch

Figure 476 NAS Type: CiscoWireless Switch Attributes

Attribute

Line 1:

n Type = Radius:IETF
n Name = NAS-Port-Type
n Value = 802.11(19)

Line 2:

n Type = Radius:IETF
n Name = Service-Type
n Value = Framed-User(2)

Table 4: NAS Type: CiscoWireless Switch Required Attribute Settings

Viewing the Simulation Results

The following figure displays the Policy Simulation RADIUS - Results dialog:
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Figure 477 Results Tab

Parameter Description

Summary Displays a summary of the simulation.

Authentication Result Displays the outcome of the Authentication test.

Details Click this link to open a dialog that provides details about the Authentication
test. You can take the following actions:

n Click the Summary, Input, or Output tabs.
n Click the Change Status, Show Logs, Export, or Close buttons.

Status Message(s) Displays the status messages resulting from the test.

Table 5: RADIUS Authentication Results Tab Parameters

Role Mapping Simulation

The role mapping simulation tests Role-Mapping policy rules to determine which roles will be output, given the
service name (and associated role mapping policy), the authentication source and the user name.

You can also use role mapping simulation to test whether the specified authentication source is reachable.

Simulation Tab

The following figure displays the Role Mapping Simulation tab:
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Figure 478 Role Mapping Simulation Tab

Parameter Description

Service Select from:
n [Policy Manager Admin Network Login Service]
n [AirGroup Authorization Service]
n [Aruba Device Access Service]
n [Guest Operator Logins]
n Guest Access
n Guest Access With MAC Caching

Role Mapping Policy Field is disabled if you select:

n [Policy Manager Admin Network Login Service]
n [Aruba Device Access Service]
n [Guest Operator Logins]
n Field is auto-filled with [AirGroup Version Match] if you select [AirGroup

Authorization Service]
n Field is autofilled with [Guest Roles] if you select Guest Access
n Field is autofilled with Guest MAC Authentication Role Mapping if you select

Guest Access With MAC Caching

Authentication Source Value = [Local User Repository] if you select: 

n [Policy Manager Admin Network Login Service]
n [Aruba Device Access Service]

Value = [Guest Device Repository] if you select:
n [AirGroup Authorization Service]
n Guest Access
n Guest Access With MAC Caching

Values = [Guest Device Repository] or [Local User Repository] if you select [Guest
Operator Logins]

Username Enter the user name.

Test Date and Time Click calendar icon to select start date and time for simulation test. For more
information, see Date Namespaces

Table 1: Role Mapping Simulation Tab Parameters

Attributes Tab

Enter the attributes of the policy component to be tested. The following figure displays the Role Mapping
Simulation Attributes tab:
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Figure 479 Role Mapping Simulation Attributes Tab

The following table describes the Role Mapping Simulation Attributes tab parameters:

Attribute Parameter

Type Select the type of attributes from the drop-down list.

Host See Host Namespaces

Authentication See Authentication Namespaces

Connection See Connection Namespaces

Application See Application Namespace

Certificate See Certificate Namespaces on page 985

n Radius:IETF
n Radius:Cisco
n Radius:Microsoft
n Radius:Avenda
n Radius:Aruba

See RADIUS Namespaces

Name The options displayed for the Name attribute depend on the Type
attribute that was selected.

Value The options displayed for the Value attribute depend on the Type and
Name attributes that were selected.

Table 2: Role Mapping Simulation Attributes Tab Parameters

Results Tab

The following figure displays the Role Mapping Simulation - Results tab:

Figure 480 Results Tab

The following table describes the Role Mapping Simulation - Results tab parameters:

Parameter Description

Summary Displays the results of the simulation.

Table 3: Role Mapping Results Tab Parameters
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Service Categorization Simulation

A service categorization simulation allows you to specify a set of attributes in the RADIUS or Connection
namespace and test which configured service the request will be categorized into. The request attributes that
you specify represent the attributes sent in the simulated request.

Simulation Tab
The following figure displays the Service Categorization Simulation - Simulation tab:

Figure 481 Service Categorization Simulation Tab

Parameter Type Namespace Details

Test Date and Time Click calendar widget and select:
n Test start date
n Test start time

Table 1: Service Categorization Simulation Tab Parameter s

Attributes Tab
Enter the attributes of the policy component to be tested. The following figure displays the Service
Categorization Simulation - Attributes tab:

Figure 482 Service Categorization Attributes Tab

Attribute Parameter

Type Select the type of attributes from the drop-down list.

Host See Host Namespaces

Authentication See Authentication Namespaces

Connection See Connection Namespaces

Application See Application Namespace

Table 2: Service Categorization Simulation Attributes Tab Parameters
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Attribute Parameter

n Radius:IETF
n Radius:Cisco
n Radius:Microsoft
n Radius:Aruba

See RADIUS Namespaces

Name The options displayed for the Name attribute depend on the Type attribute
that was selected.

Value The options displayed for the Value attribute depend on the Type and Name
attributes that were selected.

Results Tab
The following figure displays the Service Categorization - Results tab:

Figure 483 Results Tab

The following table describes the Service Categorization Simulation Results tab parameters:

Parameter Description

Summary Gives the name of the service.

Table 3: Service Configuration Results Tab Parameters

Import and Export Simulations
Navigate to Configuration > Policy Simulation and select the Import link. The following figure shows an
example of the Import from file page.

Figure 484 Import Simulations
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Parameter Description

Select file Browse to select name of simulations to import.

Enter secret for the file (if any) If the file was exported with a secret key for encryption, enter the same key here.

Table 1: Import from file page Parameters

Export Simulations
Click the Export All link to export all simulations. The browser displays the Save As dialog box in which you
can enter the name of the XML file to export all simulations. The following image shows an example of the
Export page to file page.

Figure 485 Export Simulations

To export a specific simulation, click Export. In the Save As dialog box, enter the name of the XML file to
contain the export data.

Parameter Description

Export file with password protection Select Yes to export the file with password protection.

Secret Key Enter the secret key in this field.

Verify Secret Enter the same secret key to confirm and complete export.

Table 2: Export Simulations
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Chapter 11
ClearPass Profiler

This chapter contains the following information:

n ClearPass Device Profiler Overview

n About the Device Profile

n Endpoint Information Collectors

ClearPass Device Profiler Overview
This section contains the following information:

n About the ClearPass Device Profiler

n Enabling Endpoint Classification

n Viewing Live Endpoint Information for a Specific Device

n Configuring CoA for an Endpoint-Connected Device

n ClearPass Device Profiler Overview

n Fingerprint Dictionaries

About the ClearPass Device Profiler
The ClearPass Device Profiler is a ClearPass Policy Manager module that automatically classifies endpoints
using attributes obtained from software components called Collectors.

ClearPass Device Profiler associates an endpoint with a specific user or location and offers an efficient and
accurate way to differentiate access by endpoint type (for example, a laptop or tablet).

Device profiling allows you to gather device type and operating system information by inspecting packets that
are sent by these devices in the network. For example, you can identify that a device is a smart device, a laptop,
a printer, or IP phone.

You can use this information to implement Bring Your Own Device (BYOD) flows during enforcement, assigning
the appropriate privileges and access to users based on their device type and the identity of the user.

Enabling Endpoint Classification
To enable endpoint classification, you must configure the Master Server in Zone parameter by specifying
the Primary master server and Secondary master server (for more information, see Master Server in
Zone). If you don't specify the primary master server in the zone, ClearPass will automatically select the node in
the zone with the lowest UUID (universally unique identifier).

When you enable the ClearPass server for endpoint classification, this associates each endpoint with a specific
user or location and secures access for other devices.

Viewing Live Endpoint Information for a Specific Device
The ClearPass Live Monitoring feature allows you to view endpoint information in graphic format for the device
category, device family, and device name items you selected. You can also examine the endpoint details and
attributes about a specific device .

To access the Endpoint Profiler Live Monitoring information:
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1. Navigate to Monitoring > Profile and Network Scan > Endpoint Profiler.

The Endpoint Profiler opens.

Figure 486 Endpoint Profiler

2. To view endpoint details about a specific device, click a device in the table below the graphs.

3. To return to the Endpoint Profiler page, click Cancel.
For more information, see:

l Monitoring Endpoint Profiler

The Cluster Status Dashboard widget shows basic distribution of device types. For more information, see:

l Using the Policy Manager Dashboard

Configuring CoA for an Endpoint-Connected Device
After profiling an endpoint, use the Profiler page to configure Change of Authorization (CoA) on the network
device to which an endpoint is connected.

The Profiler tab is not displayed by default. To access the Profiler tab:

1. Navigate to Configuration > Services, then click Add.

2. Enter the name of the service.

3. From the More Options field on the Service tab, enable the Profile Endpoints check box.

The Profiler tab is added to the Services tabs:
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Figure 487 Adding the Profiler Page

4. Select the Profiler tab.

The Profiler page opens.

Figure 488 Profiler Page

5. You can select a set of categories and a CoA profile to be applied when the profile matches one of the
selected categories.

CoA is triggered using the selected CoA profile. You can use any option from Endpoint Classification to
invoke CoA on a change of any one of the fields (category, family, and name).

6. Specify the Profiler page parameters as described in Table 25:

Table 25: Profiler Page Parameters

Parameter Action/Description

Endpoint Classification Select one or more endpoint classification items from the drop-down list.
You can select a new action, or remove a current action.

RADIUS CoA Action Select the RADIUS CoA action from the drop-down list.
n To view the Policy Manager Entity Details page with the summary of

enforcement profile details, click View Details.
n To view the Summary tab with profile details, click Modify.

Add new RADIUS CoA
Action

To create a new RADIUS CoA action, click the Add New RADIUS CoA Action link.

7. When finished, click Save.
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Fingerprint Dictionaries
ClearPass Policy Manager uses a set of dictionaries and rules to perform device fingerprinting.

Because these dictionaries can change frequently, ClearPass Policy Manager provides a way to automatically
update fingerprints from a hosted portal. The device fingerprints are updated from the ArubaClearPass Update
Portal (for more information, see ClearPass Portal).

To view the contents of the fingerprints dictionary:

1. Navigate to Administration > Dictionaries > Fingerprints.

The Device Fingerprints page opens. This page lists all the device fingerprints recognized by the Device
Profiler module.

Figure 489 Device Fingerprints Page

2. To view the device fingerprint dictionary attributes, select the device fingerprint of interest.

The attributes for the selected Device Fingerprint Dictionary are displayed:

Figure 490 Device Fingerprint Dictionary Attributes Page

3. To exit, click Close.
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About the Device Profile
The Device Profiler module produces aDevice Profile, which is a hierarchical model consisting of three elements
that are derived by the endpoint attributes—DeviceCategory, DeviceFamily, and DeviceName.
Table 26: Elements of a Device Profile

Endpoint
Attributes Description

DeviceCategory Denotes the type of the device, for example, Computer, Smart Device, Printer, or
Access Point.

DeviceFamily Classifies devices based on the type of operating system or vendor. For example,
when the category is Computer, ClearPass Policy Manager shows a device family
of Windows, Linux, or Mac OS X.

DeviceName Denotes the name of the device. Devices in a family are organized based on
characteristics such as their operating system version. For example, in a
DeviceFamily of Windows, ClearPass Policy Manager shows a DeviceName of
Windows 8.1 or Windows Server 2012.

This hierarchical model provides a structured view of all endpoints accessing the network. In addition to these,
a Device Profile also collects and stores the following:

n IP address

n Host name

n Device vendor (via MAC OUI)

n Timestamp indicates when the device was first discovered and last seen

Endpoint Information Collectors
Collectors are the network elements that provide data in order to profile endpoints. This section provides the
following information:

n DHCP Collector

n NetFlow Collector

n SFlow Collector

n ClearPass Onboard Collector

n HTTP User-Agent Strings Collector

n MAC OUI Collector

n ActiveSync Plug-in Collector

n ClearPass OnGuard Agent

n Subnet Scan Collector

DHCP Collector
Dynamic Host Configuration Protocol (DHCP) attributes such as option 55 (parameter request list), option 60
(vendor class), and the options list from the Discover and Request packets can uniquely fingerprint most
devices that use the DHCP mechanism to acquire an IP address on the network.

You can configure switches and controllers to forward DHCP Discover, Request, and Inform packets to
ClearPass. These DHCP packets are decoded by ClearPass Policy Manager to arrive at the appropriate device
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category, OS family, and device name. In addition to fingerprints, DHCP also provides the host name and IP
address.

Sending DHCP Traffic to the ClearPass Server
To configure your Aruba controller and Cisco switch to send DHCP traffic to the ClearPass server, enter the
following CLI commands:

interface <vlan_name>
ip address <ip_addr> <netmask>
ip helper-address <dhcp_server_IO>
ip helper-address <clearpass_IP> end
end

You can configure multiple ip helper-address statements to send DHCP packets to servers other than the
DHCP server.

NetFlow Collector
NetFlow provides the ability to collect IP network traffic as it enters or exits an interface. By analyzing the data
provided by NetFlow, a network administrator can determine things such as the source and destination of
traffic, class of service, and the causes of congestion.

The ClearPass Policy Manager NetFlow Collector provides the ability to identify the open ports of a device
connected to a network by analyzing the received NetFlow packets.

Supported versions are NetFlow v5 through v9 and IPFIX (Internet Protocol Flow Information eXport).

SFlow Collector
sFlow is a general purpose network-traffic measurement system technology. sFlow is embedded in network
devices and provides continuous statistics on any protocol so that all traffic throughout a network can be
accurately characterized and monitored.

The main difference between NetFlow and sFlow is that NetFlow is restricted to IP only, whereas sFlow has the
ability sample all traffic (that is, it is network-layer independent).

The sFlow Collector has the following characteristics:

n In ClearPass Policy Manager, Sflow listens to UDP port 6343.

UDP port 6343 must be opened to the firewall. The switch/sFLow source should be configured to send sFlow packets
to ClearPass UDP port 6343.

n Sflow identifies the destination IP/Port from the flow that reaches the ClearPass server and determines
whether there is already an IP or MAC address.

n When Sflow finds the corresponding IP/MAC binding, the destination IP/Port is sent to Profiler for further
processing in batches of 10 and in one-minute intervals. IP/MAC pairs that are not found do not receive
further processing.

n sFlow Collector caches the open port information for a device and only the updated the port information is
sent to the Profiler (as a merge request).

ClearPass Onboard Collector
ClearPass Onboard collects authentic device information from all devices during the onboarding process.
Onboard then posts this information to the ClearPass Profile.

Because the information collected is definitive, ClearPass Profile can directly classify these devices into their
appropriate category, OS family, and name without having to rely on any other fingerprinting information.
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HTTP User-Agent Strings Collector
In some cases, DHCP fingerprinting alone cannot fully classify a device. A common example is the Apple family
of smart devices; for example, DHCP fingerprints cannot distinguish between an iPad and an iPhone.

In these scenarios, user-agent strings sent by browsers in the HTTP protocol are useful to further refine
classification results.

User-agent strings are collected from the following:

n ClearPass Guest

n ClearPass Onboard

n Aruba controller through an IF-MAP (Interface for Metadata Access Points) interface

MAC OUI Collector
The MAC OUI (Organization Unique Identifier) is expressed in the first 24 bits of a MAC address for a network-
connected device. Thus, the MAC OUI indicates the specific vendor for that device. The MAC OUI is acquired
through various authentication mechanisms, such as 802.1X and MAC address authentication.

The MAC OUI can be useful to more accurately classify endpoints. An example is Android™ devices where
DHCP fingerprints can only classify a device as generic Android, but it cannot provide more details regarding
the vendor.

Combining this information with MAC OUI, the ClearPass Profiler can classify a device as HTC™ Android,
Samsung™ Android, or Motorola® Droid, etc.

The MAC OUI is also useful to profile devices such as printers that might be configured with static IP addresses.

ActiveSync Plug-in Collector
You can install the ActiveSync plug-in provided by Aruba on Microsoft Exchange servers.

When a device communicates with an Exchange server using the Active Sync protocol, the device provides
attributes such as device-type and user-agent.

These attributes are collected by the ActiveSync plug-in and sent to the ClearPass Profiler. Profiler uses
dictionaries to derive profiles from these attributes.

ClearPass OnGuard Agent
The ClearPass OnGuard agent performs advanced endpoint posture assessment. This agent collects and sends
operating system details from endpoints during authentication.

The Policy Manager Profiler uses the OnGuard OSType attribute to derive a profile (for more information, refer
to Web-Based Authentication Service).

SNMP Collector
Endpoint information obtained by reading the Simple Network Management Protocol (SNMP) MIBs of network
devices is used to discover and profile static IP devices in the network. For related information, see Scheduling
Network Scans and Subnet Scans.
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MIB Description

SysDescr A textual description of the entity used both for profiling switches, controllers, and routers
configured in ClearPass, and for profiling printers and other static IP devices discovered
through SNMP or subnet scans (RFC1213).

cdpCacheTable Provides the cached information obtained via receiving Cisco Discovery Protocol (CDP)
messages from CDP-capable devices. This is used to discover neighbor devices
connected to the switch or controller configured in ClearPass.

lldpRemTable This table contains one or more rows per physical network connection known to this
agent read from LLDP (Link Layer Discovery Protocol)-capable devices. This is used to
discover and profile neighbor devices connected to the switch or controller configured in
ClearPass.

ARPtable Address Resolution Protocol (ARP) information is read from the network devices. This is
used as a means to discover endpoints in the network.

Table 1: SNMP MIBs Used by the SNMP Collector

Setting SNMP Community Attributes
The SNMP-based mechanism is capable of profiling devices only if they respond to SNMP, or if the device
advertises its capability via LLDP (Link Layer Discovery Protocol). When performing SNMP reads for a device,
ClearPass uses SNMP Read credentials configured in the network devices, or defaults to using SNMPv2 with
"public" community strings specified.

To specify SNMPv2 with community strings:

1. Navigate to Configuration > Network > Devices.

2. From the Network Devices page, select the appropriate device.

The Edit Device Details dialog opens.

3. Select the SNMP Read Settings tab.

Figure 491 Specifying SNMP v2 with Community Strings

4. Specify the SNMP Read Settings parameters as described in the following table, then click Save.
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Parameter Action/Description

Allow SNMP Read If not already enabled, enable the Allow SNMP Read check box.
The SNMP Read Settings parameter fields are now enabled for configuration.

Policy Manager Zone Select the Policy Manager Zone. If no Policy Manager Zone is configured, select
default.

SNMP Read Setting Select SNMPv2 with community strings.

Community String Enter the Community String value, then reenter the string to verify it.

Force Read Enable the Force Read check box to ensure that all ClearPass nodes in the
cluster will read the SNMP information from this device, regardless of the trap
configuration on the device.
NOTE: This option is especially useful when demonstrating static IP-based device
profiling because the Force Read option does not require any trap configuration
on the network device.

Read ARP Table Info If this is a Layer-3 device, and you want to use the ARP table on this device as a
way to discover endpoints in the network, enable the Read ARP Table Info check
box.
NOTE: Static IP endpoints discovered in this way are further probed via SNMP to
profile the device.

Table 2: SNMP Read Settings Parameters

Configuring the Device Info Poll Interval
Network devices configured with SNMP Read enabled are polled periodically for updates based on the time
interval configured in the Device Info Poll Interval.

To set the Device Info Poll Interval:

1. Navigate to Administration > Server Manager > Server Configuration.

2. Select the ClearPass server of interest.

The Server Configuration page opens.

3. Select the Service Parameters tab.

4. From the Select Service drop-down, select ClearPass network services.

The ClearPass network services page opens.
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Figure 492 Specifying the Device Info Poll Interval

5. In the minutes field, enter the Device Info Poll Interval, then click Save.

Subnet Scan Collector
A network or subnet scan discovers the IP addresses of devices in the network.

The devices discovered in this way are further probed using SNMP to fingerprint and assign a profile to the
device. Network subnets to be scanned are configured per Policy Manager Zone.

This is particularly useful in deployments that are geographically distributed. In such deployments, it is
recommended that you complete the following tasks:

1. Assign the ClearPass Policy Manager nodes in a cluster to multiple zones depending on the geographical
area served by that node.

To set up Policy Manager Zones, navigate to Administration > Server Manager > Server Configuration
> Manage Policy Manager Zones.

2. Then enable the profile for a minimum of one node per zone.

For more information, see Managing Policy Manager Zones on page 567.

3. Configure the SNMP, SSH, and WMI credentials required to query for network devices, Linux devices, and
Windows devices respectively (for details, see Configuring SNMP, SSH, and WMI Credentials).

4. Schedule a network scan or subnet scan (for details, see Scheduling Network Scans and Subnet Scans).
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Chapter 12
Administration

You can access all ClearPass administrative activities, including server configuration, log management,
certificate and dictionary maintenance, portal definitions, and administrator user account maintenance from
the following Administration sections:

ClearPass Portal
n ClearPass Portal on page 489

Users and Privileges
n Managing Admin Users on page 491

n Managing Admin Privileges on page 495

Server Manager
n Server Configuration Operations on page 504

n ClearPass Cluster Configuration Options

n Log Configuration on page 579

n Downloading Local Shared Folders on page 583

n License Management on page 583

External Servers
n SNMP Trap Receivers on page 596

n Syslog Targets on page 601

n Syslog Export Filters on page 602

n Messaging Setup on page 614

n Endpoint Context Servers on page 616

n Adding Vendor-Specific Endpoint Context Servers

n File Backup Servers on page 691

Certificates
n Certificate Store on page 693

n Creating and Installing a Self-Signed Server Certificate

n Creating a Certificate Signing Request

n Importing a Server Certificate

n Exporting a Server Certificate

n Service Certificates

n Associating a RADIUS Service Certificate with a Service

n Certificate Trust List on page 712

n Certificate Revocation Lists on page 714
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Dictionaries
n RADIUS Dictionary on page 716

n RADIUS CoA Templates

n TACACS+ Services Dictionary on page 720

n Device Fingerprints Dictionary on page 721

n Dictionary Attributes on page 725

n Applications Dictionaries on page 995

n Configuring Endpoint Context Server Actions on page 730

Agents and Software Updates
n Software Updates

n OnGuard Settings and Agent Library Updates on page 739

n Onguard Agent Installers

n Creating OnGuard Custom Web Pages

n OnGuard Global Agent Settings

n Upgrading From OnGuard Plugin Version 1.0 to 2.0

Cluster Update and Upgrade
n Updating Clusters on page 780

n Upgrading Clusters on page 1

Ingress Events Processing
n Configuring Processing for Ingress Events

Insight Report Tool
n ClearPass Insight Reports

Support Services
n Contacting Support on page 772

n Remote Assistance on page 774

n Accessing ClearPass Documentation on page 777

n Accessing the OnGuard Support Charts

ClearPass Portal
To customize the ClearPass Portal content for your enterprise:
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1. Navigate to the Administration > ClearPass Portal page. The ClearPass Portal page opens:

Figure 493 ClearPass Portal

2. Specify the ClearPass Portal parameters as described in the following table, then click Save:

Parameter Action/Description

Select Option Select the page that the user first sees after logging in to ClearPass:
n Default Landing Page
n Application Login Page:
n Guest Portal

Page Title Click and enter the text to appear as the page title in the default landing page.

Logo Image Click and browse to select an image for the banner in the default landing page.

Top section Click and enter the text to appear as the header in the default landing page.

Bottom section Click and enter the text to appear as the footer in the default landing page.

Copyright Click and enter the copyright text to appear in the default landing page.

Table 1: ClearPass Portal Parameters

Both the HTTP and HTTPS protocols are supported for ClearPass Portal redirection.
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Managing Admin Users
This section describes the following topics:

n About Admin Users

n Changing the Administration Password

n Adding an Admin User

n Importing and Exporting Admin Users

n Setting Password Policy for Admin Users

n Disabling Admin User Accounts

About Admin Users
ClearPass provides three types of admin users by default:

n Super Admin: Allowed read/write access to all configuration elements.

n API Admin: Allowed API access to all configuration elements.

n readonly: Allowed read-only access to all configuration elements.

In addition, ClearPass allows you to add the following types of admin users:

n Aruba User Role Download: This admin role provides access to only download user roles.

n Help Desk: Allows the Help Desk to log in to troubleshoot problems reported by end users.

n Network Administrator: Allowed to configure all ClearPass policies.

n Receptionist: Allowed to access the main monitoring screens.

Select any of the links below to view more information about these procedures.

Changing the Administration Password
After activating the ClearPass appliance, the recommended next task is to change the administration password
for the newly-activated ClearPass server.

To change the administration password:

1. Navigate to Administration > Users and Privileges > Admin Users.The Admin Users page opens.

Figure 494 Admin Users Page

In this page, you can view the administrator details such as user ID, user name, and privilege level, as well as
whether the admin user type is enabled or disabled. You can also change the admin password, and add,
import, export, set password policies for the admin users, and disable admin user accounts by using the
links provided at the top-right corner of this page.

2. Select the Admin user you want to modify.The Edit Admin User dialog opens.
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Figure 495 Changing the Administration User Password

3. Change the administration password, then click Save.

Adding an Admin User
To add a new admin user:

1. Navigate to Administration > Users and Privileges > Admin Users.

2. Click the Add link. The Add Admin User dialog opens.

Figure 496 Adding an Admin User

3. Specify the Add Admin User parameters as described in the following table, then click Save:

Parameter Action/Description

User ID Specify a user ID for this administrator.

Name Specify the name for the admin user.

Password/ Verify Password Specify a password for the local user, then verify the password.

Table 1: Adding an Admin User Parameters
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Parameter Action/Description

Enable User You must enable this check box to enable the admin user account (is is enabled by
default). Otherwise, the admin user account is disabled.

Privilege Level From the drop-down list, select one of the following admin user privilege levels:
n API Administrator
n Aruba User Role Download
n Help Desk
n Network Administrator
n Read-only Administrator
n Receptionist
n Super Administrator

Importing and Exporting Admin Users
You can import or export the admin user accounts by using the Import and Export All links at the top-right
corner of the Admin Users page. You can also export specific admin user accounts by using the Export
button that appears after selecting one or more admin user accounts from the list. For more information, refer
to Importing and Exporting Information.

The passwords of the admin user accounts are not stored in clear text when exported to an XML file.

Setting Password Policy for Admin Users
To set password policies for the administrators:

1. Navigate to Administration > Users and Privileges > Admin Users.

2. Click the Account Settings link at the top-right corner of the Admin Users page. The Password Policy
Settings dialog opens.

Figure 497 Setting Admin Users Password Policy

3. Specify the Password Policy parameters as described in Table 2, then click Save:
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Parameter Action/Description

Minimum Length Specify the minimum length required for the password.

Complexity Select the complexity setting from the Complexity drop-down list. The complexity
settings can be one of the following:
n No password complexity requirement
n At least one uppercase and one lowercase letter
n At least one digit
n At lease one letter and one digit
n At least one of each: uppercase letter, lowercase letter, digit
n At least one symbol
n At least one of each: uppercase letter, lowercase letter, digit, and symbol

Disallowed Characters Specify the characters not to be allowed in the password.

Disallowed Words (CSV) Specify the words not to be allowed in the password

Additional Checks Select any additional checks, if required. The options are:
n May not contain User ID or its characters in reversed order.
n May not contain repeated character four or more times consecutively.

Expiry Days Set the password expiry time for the local users.
The allowed range is 0 to 500 days. The default value is 0.
NOTE: If the value is set to 0, the password never expires. For any other value, local
users are forced to reset the expired password when they log in. ClearPass alerts
users five days before the password expires.

Table 2: Password Policy Parameters

Password Policy settings are effective only for the users created or modified after the changes are saved.

Disabling Admin User Accounts
The Disable Account check occurs every day at midnight. The Admin user account can be disabled in two
ways:

n When the Admin user tries to log in with an invalid password for a configured number of times defined by
the Failed attempts count parameter, the Admin user account is locked.

If the mechanism for logging in to ClearPassPolicy Manager is Certificate + Password, the Admin user is allowed to
enter the password even if the certificate is invalid.

n When the Admin user tries to log in with an invalid user certificate for a configured number of times defined
by the Failed attempts count parameter, the Admin user account is disabled.

n To reset the Failed attempts count and enable a disabled Admin user account, click the Reset button
(see Table 3).

n For Admin users whose accounts are locked due to account settings validations, and whose accounts are
enabled again after being locked out, entries are logged in both the Audit Viewer (see Audit Viewer) and the
Event Viewer (see Event Viewer).
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To specify the conditions for disabling admin user accounts:

1. Navigate to Administration > Users and Privileges > Admin Users.

2. Click the Account Settings link at the top-right corner of the Admin Users page. The Account Settings
page opens.

3. Select the Disable Accounts tab.The Disable Accounts dialog opens.

Figure 498 Disable Accounts Dialog

4. Specify the Disable Accounts parameters as described in Table 3, then click Save.

Parameter Action/Description

Failed attempts count Specify the number of failed log-in attempts are allowed before the account is
disabled.
The range is from 1 to 100 attempts.

Reset failed attempts count To reset the failed attempts count to zero and reenable those admin users who
were disabled after exceeding the failed attempts count, click Reset.

Table 3: Admin Users > Disable Accounts Parameters

Managing Admin Privileges
ClearPass Policy Manager ships with the following default administrator admin privileges XML files:

Parameter Description

API Administrator An API administrator is only allowed API access to read/write all configuration
elements.

Aruba User Role Download Privilege level used for Aruba User Role Download API operations.

Help Desk The Help Desk person logs in to troubleshoot problems reported by end users.

Help Desk - ASE The Help Desk person logs in to troubleshoot problems reported by end users.

Network Administrator Allowed to configure all the policies in the ClearPass system.

Privileged_user Allowed to add NADs, NAD groups, and edit endpoints along with monitoring
operations.

Read-only Administrator This administrator is allowed to only read all configuration elements.

Table 1: Default Admin Privileges
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Parameter Description

Receptionist The receptionist is allowed access to the main monitoring screens.

STS-Operations STS-Operations 7x24 team

Super Administrator This administrator is allowed read/write access to all configuration elements.

Each of these default admin privileges define the admin privileges for Policy Manager and ClearPass Insight.
The default set of admin privileges cannot be modified.

You can export one or more default files and modify the file to create a customized administrator privileges
file. Customized administrator privileges are defined in an XML file with a specific format and then imported
into ClearPass Policy Manager on the Admin Privileges page.

Defining Custom Admin Privileges
When a different set of admin privileges is needed (for example, if you require different admin privileges for
the Report module than the admin privileges defined for the other Insight modules), you must create a new
admin privileges administrator.

To define custom admin privileges for ClearPass and Insight:

1. Navigate to the Administration > Users and Privileges > Admin Privileges page.

The Admin Privileges page opens:

Figure 499 Admin Privileges Page

2. Click the Add link.

The Add Admin Privileges dialog opens.
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Figure 500 Add Admin Privileges Page: Basic Information Tab

3. Specify the parameters in the Basic Information tab as described in Table 27.

Table 27: Add Admin Privileges Parameters: Basic Information Tab

Parameter Action/Description

Name Enter the name of the Admin Privileges administrator.

Description Provide a description of this new admin privileges administrator.

Access Type Select one of the following Access Types:
n Give full access to the Admin
n Give UI access to the Admin
n Give API access to the Admin

Allow Passwords Select this check box if you want to allow password access.

Configuring Policy Manager Admin Privileges
To configure the Policy Manager admin privileges:

1. Select the Policy Manager tab.

The following dialog opens:
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Figure 501 Specifying Policy Manager Admin Privileges

2. Specify the admin privileges for each of the ClearPassPolicy Manager components, then click Save.

Configuring Insight Admin Privileges
To configure the Insight admin privileges:

1. Select the Insight tab.

The following dialog opens:

Figure 502 Specifying Insight Admin Privileges

2. Specify the admin privileges for each of the Insight modules, then click Save.

Creating Custom Administrator Privileges
To create a custom admin privilege XML file, you must use a plain text or XML editor.

Do not use word processing applications such as Microsoft Word, which introduce tags and corrupt the XML file.
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To create a custom administrator privilege:

1. Create an XML file that defines a privilege.

2. Store the new file.

3. Navigate to Administration > Users and Privileges > Admin Privileges.

4. Click Import Admin Privileges.

5. Import the administrator privilege file you created in step 1.

After you complete steps 1 through 5, the new administrator privileges document is displayed on the Admin
Privileges page.

Administrator Privilege XML File Structure
Admin privilege files are XML files with a specific structure. It must have a header at the beginning of the file in
the following format:
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>

The root tag is TipsContents. It is a container for the data in the XML file which must be in the following
format:
<TipsContents xmlns="http://www.avendasys.com/tipsapiDefs/1.0">
⋮

</TipsContents>

An optional TipsHeader tag can follow the TipsContents tag. The actual admin privileges information is
defined with the AdminPrivilege and AdminTask tags. You can use one AdminPrivilege tag for each
admin privilege you want to define. The AdminPrivilege tag contains the following two attributes:

n name

n description

You can have one or more AdminTask tags inside the AdminPrivilege tag. Each AdminTask tag defines a
lace within the ClearPass Policy Manager application that a user with that privilege can view or change. The
AdminTask tag contains one taskid attribute and a single AdminTaskAction tag. The AdminTaskAction
tag contains an attribute, type which can take a value, RO (read only) or RW (read/write).

The following sample gives the basic structure of an admin privilege file:
<AdminPrivileges>
<AdminPrivilege name="" description="">
<AdminTask taskid="">
<AdminTaskAction type=""/>

</AdminTask>
<AdminTask taskid="">
<AdminTaskAction type=""/>

</AdminTask>
</AdminPrivilege>

</AdminPrivileges>

Administrator Privileges and Task IDs
Every element in the ClearPass Policy Manager user interface has a task ID associated with it.

The users have access to the elements based on the permissions set for each task or element. By default, any
permission provided for a task is applicable for all its sub-tasks.

For example, if you give RW (read-write) permissions for the task, Enforcements (con.en), it is automatically
applied to its subtasks, Policies (con.en.epo) and Profiles (con.en.epr). Hence, you need not explicitly define the
same permission for those subtasks.
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The following table provides the tasks and subtasks of ClearPass Policy Manager and their associated task IDs:

Area (ClearPass Policy Manager Menu) Task ID

Dashboard dnd

Monitoring mon

n Live Monitoring mon.li

l Access Tracker mon.li.ad

l Accounting mon.li.ac

l Onguard Activity mon.li.ag

l Analysis and Trending mon.li.sp

l Endpoint Profiles mon.li.ep

l System Monitor mon.li.sy

n Audit Viewer mon.av

n Blacklisted Users mon.bl

n Event Viewer mon.ev

n Data Filters mon.df

Configuration con

n Start Here (Services Wizard) con.sh

n Services con.se

n Service Templates con.st

n Authentication con.au

l Methods con.au.am

l Sources con.au.as

n Identity con.id

l Single Sign-On con.id.sso

l Local Users con.id.lu

l Endpoints con.id.ep

l Static Host Lists con.id.sh

l Roles con.id.rs

l Role Mappings con.id.rm

Table 1: Administrator Privileges and Task IDs
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Area (ClearPass Policy Manager Menu) Task ID

n Posture con.pv

l Posture Policies con.pv.in

l Posture Servers con.pv.ex

l Audit Servers con.pv.au

n Enforcements con.en

l Policies con.en.epo

l Profiles con.en.epr

n Network con.nw

l Devices con.nw.nd

l Device Groups con.nw.ng

l Proxy Targets con.nw.pr

Policy Simulation con.ps

Profile Settings con.prs

Administration adm

n User and Privileges adm.us

l ClearPass Portal adm.po.cp

l Admin Users adm.us.au

l Admin Privileges adm.us.ap

n Server Manager adm.mg

l Server Configuration adm.mg.sc

l Log Configuration adm.mg.ls

l Local Shared Folders adm.mg.sf

l Licensing adm.mg.li

n External Servers adm.xs

l SNMP Trap Receivers adm.xs.st

l Syslog Targets adm.xs.es

l Syslog Export Filters adm.xs.sx

l Messaging Setup adm.xs.me
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Area (ClearPass Policy Manager Menu) Task ID

l Endpoint Context Servers adm.xs.cs

l Context Server Actions adm.di.csa

n Certificates adm.cm

l Server Certificate adm.cm.mc

l Trust List adm.cm.ctl

l Revocation List adm.cm.crl

n Dictionaries adm.di

l RADIUS adm.di.rd

l Posture adm.di.pd

l TACACS+ Services adm.di.td

l Fingerprints adm.di.df

l Attributes adm.di.at

l Applications adm.di.ad

n Agents and Software Updates adm.po

l Onguard Settings adm.po.aas

l Software Updates adm.po.es

n Support adm.su

l Contact Support adm.su.cs

l Remote Assistance adm.su.ra

l Documentation adm.su.doc

Sample Administrator Privilege XML File
This section provides sample XML files with different admin privileges for various user interface elements:

n Read Only (R) Privileges to All Sections

n Read/Write Access

n Read/Write Permissions

Read Only (R) Privileges to All Sections
The following sample provides Read Only (R) privileges to all the sections (dnd, con, mon, adm):
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<TipsContents xmlns="http://www.avendasys.com/tipsapiDefs/1.0">
<TipsHeader exportTime="Thu Jul 26 17:57:50 IST 2016" version="6.6"/>
<AdminPrivileges>
<AdminPrivilege name="Read-only Administrator" description="A read-only administrator is

only allowed to read all configuration elements">
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<AdminTask taskid="con"> //Refers to Configuration
<AdminTaskAction type="R"/>

</AdminTask>
<AdminTask taskid="dnd"> //Refers to DashBoard
<AdminTaskAction type="R"/>

</AdminTask>
<AdminTask taskid="mon"> //Refers to Monitoring
<AdminTaskAction type="R"/>

</AdminTask>
<AdminTask taskid="adm"> //Refers to Administration
<AdminTaskAction type="R"/>

</AdminTask>
</AdminPrivilege>

</AdminPrivileges>
</TipsContents>

Read/Write Access
The following sample provides Read/Write access only to Guest, Local and Endpoint Repository:
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<TipsContents xmlns="http://www.avendasys.com/tipsapiDefs/1.0">
<TipsHeader exportTime="Thu Jul 26 17:57:50 IST 2016" version="6.6"/>
<AdminPrivileges>
<AdminPrivilege name="Read/Write Access to Guest, Local and Endpoint Repository"

description="A read-only administrator is only allowed to read all configuration elements">
<AdminTask taskid="con.id.lu"> //Refers to Local Users Section
<AdminTaskAction type="RW"/>

</AdminTask>
<AdminTask taskid="con.id.gu"> //Refers to Guest Users Section
<AdminTaskAction type="RW"/>

</AdminTask>
<AdminTask taskid="con.id.ep"> //Refers to Endpoints Section
<AdminTaskAction type="RW"/>

</AdminTask>
</AdminPrivilege>

</AdminPrivileges>
</TipsContents>

Read/Write Permissions
The following sample provides Read/Write permissions to DashBoard/ Monitoring and ReadOnly permissions
to Server Configuration:
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<TipsContents xmlns="http://www.avendasys.com/tipsapiDefs/1.0">
<TipsHeader exportTime="Thu Jul 26 17:57:50 IST 2016" version="6.6"/>
<AdminPrivileges>
<AdminPrivilege name="Limited access permission" description="A read-only administrator is

only allowed to read all configuration elements">
<AdminTask taskid="dnd"> //Refers to DashBoard
<AdminTaskAction type="RW"/>

</AdminTask>
<AdminTask taskid="mon"> //Refers to Monitoring
<AdminTaskAction type="RW"/>

</AdminTask>
<AdminTask taskid="adm.mg.sc"> //Refers to Server Configuration
<AdminTaskAction type="R"/>

</AdminTask>
</AdminPrivilege>

</AdminPrivileges>
</TipsContents>
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Server Manager
This section provides the following information:

n Server Configuration Operations

n Log Configuration

n Downloading Local Shared Folders

n License Management

Server Configuration Operations
You can perform numerous server configuration tasks by navigating to Administration > Server Manager >
Server Configuration.

Figure 503 Server Configuration Page

This section describes the following server configuration tasks:

n Configuring the ClearPass Policy Manager Server on page 504

n Cluster-Wide Parameters on page 551

n Synchronizing the Cluster Date and Time with the NTP Server on page 564

n Changing the Cluster-Wide Password on page 567

n Managing Policy Manager Zones on page 567

n Configuring NetEvents Targets on page 570

n Configuring Virtual IP Settings on page 571

n Clearing Machine Authentication Cache on page 571

n Making a Subscriber Node on page 573

n Collecting Logs on page 574

n Backing Up the Policy Manager Database on page 576

n Restoring Policy Manager Configuration Data on page 576

n Performing a System Cleanup

n Shutting Down or Rebooting the Server on page 579

Configuring the ClearPass Policy Manager Server
This section provides the following information:
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n ClearPass Server Configuration Tabs

n Cluster Configuration Options

n Configuring the ClearPass Policy Manager Server

To modify the configuration settings of a ClearPass server:

1. Navigate to the Administration > Server Manager > Server Configuration page.

The Server Configuration page opens:

Figure 504 Server Configuration Page

2. Click the ClearPass server name of interest.

The Server Configuration page for the selected server opens:

Figure 505 Server Configuration Page for the Selected Server
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ClearPass Server Configuration Tabs
For details on viewing or modifying ClearPass server configuration settings, refer to the following sections: 

n System Page on page 508

n Services Control Page on page 518

n Service Parameters Page on page 518

n System Monitoring Page on page 535

n Network Page on page 536

n FIPS Page on page 549

Cluster Configuration Options
For details on the cluster configuration options, see ClearPass Cluster Configuration Options.

n Changing the Cluster Password

n Promoting a ClearPass Subscriber Node to Publisher

n Joining a ClearPass Server Back to the Cluster

For more information, see Server Configuration Operations on page 504.

Changing the Cluster Password
Use the Change Cluster Password link to synchronize the password of the selected node with cluster.
Synchronizing the cluster password will change the appadmin password for all the nodes in the cluster.

The following figure displays the Change Cluster Password dialog:

Figure 506 Change Cluster Password Dialog

Promoting a ClearPass Subscriber Node to Publisher
Use the Promote To Publisher link to promote the selected node as a Publisher node. You can enable this
node as a Publisher node using any other active node that is part of the same cluster.

All application licenses will be deactivated; you need to contact Aruba Support to reactivate these licenses. The
following figure displays the Promote to Publisher window:
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Figure 507 Promote Node to Publisher

Joining a ClearPass Server Back to the Cluster
Use the Join server back to cluster link to join a ClearPass server back to the cluster.

You can use this option only for a server that is in the Cluster Sync > Disabled state.

Only users with Admin access can join a ClearPass node back to a cluster.

To join a server back to the cluster:

1. Select a Subscriber node that is in Disabled state.

The Server Configuration > System tab opens.

Figure 508 Server Configuration > Join Server Back to Cluster Link

2. Click the Join server back to cluster link.

A warning message appears with a prompt to promote the node to Publisher. This option can only be
triggered from a node that is currently active in the cluster. The following message displays the warning
message:
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Figure 509 Join Server Back to Cluster Confirmation Dialog

3. Click Yes.

A progress indicator shows the progress of the operation.

The following figure displays the Join server back to cluster progress indicator:

Figure 510 Join Server Back to Cluster Progress Window

4. For a failed Publisher node, the following message will be displayed in the Dashboard page:

Figure 511 Publisher Warning Message

System Page
n Management Port Configuration

n Data/External Port Configuration

n DNS Settings Configuration

n Join AD Domain Configuration

n Adding a Password Server

To configure the Server Configuration > System page parameters:

1. Navigate to Administration > Server Manager > Server Configuration.

2. Select the ClearPass server of interest.
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The Server Configuration page opens onto the System page (see Figure 512).

Figure 512 Server Configuration > System Page

3. Specify the Server Configuration > System page parameters as described in the following table, then
click Save:

Parameter Action/Description

Hostname Specify the host name of the Policy Manager server.
NOTE: You do not need to enter the fully qualified domain name in this field.

FQDN Enter the Fully-Qualified Domain Name (FQDN) of the Policy Manager server.

Policy Manager Zone To specify a Policy Manager zone, select a previously configured zone from the
drop-down list, then click the Manage Policy Manager Zones link.
If you need to add a Policy Manager zone, click the Manage Policy Manager
Zones link. For more information on adding zones, see Adding Policy Manager
Zones.

Enable Performance
Monitoring Display

To enable the ClearPass Policy Manager server to perform performance
monitoring, select the Enable this server for performance monitoring display
check box.

Insight Setting To enable the Insight reporting tool on this node, select the Enable Insight check
box.
NOTE:
n When you enable this check box for Insight on a node in a cluster, the [Insight

Repository] configuration is updated automatically to point to the management
IP address of that ClearPass server.

n When this check box is enabled for other servers in the cluster, they are added
as backups for the same authentication source.

n The order of the primary and backup servers in the [Insight Repository] is the
same order in which the user enables Insight on the server.

Enable as Insight Master To specify the current server in the cluster as an Insight Master, select this check
box.
NOTE: This option is available only when Insight Setting > Enable Insight is
enabled.

Enable Ingress Events
Processing

Check this check box to enable ingress events processing on this server.
For more information, see Enabling Ingress Events Processing.

Master Server in Zone Use this option to specify the current ClearPass server as the Primary or
Secondary master ClearPass server within a Policy Manager zone.
NOTE: If no Primary master server for a zone is configured, the ClearPass server

Table 1: Server Configuration > System Page Parameters
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Parameter Action/Description

with the lowest UUID is designated as the Primary master server.
To do so, select Primary master or Secondary master from the drop-down list.
n The Primary master ClearPass server in the zone distributes the scan requests

to all the nodes in the zone, depending on the number of seed devices
(Network Discovery) or the number of networks/subnets (for Subnet Scans)
configured.

NOTE: If the Primary master server goes down, the Secondary master server
assumes the role of the Primary master server.
n Each scan configuration that is added is distributed by the Master ClearPass

server to a different node in the zone.
n If one scan configuration has multiple seed devices (Network Discovery), scan

requests are distributed to other nodes in the zone based on the number of
ARP entries received from the seed devices.

n If one scan configuration has multiple subnets configured (Subnet Scan), scan
requests are distributed to other nodes in the zone.

Span Port If necessary, select a port for DHCP spanning.
On selecting a port, the Enable TCP/ARP Fingerprinting check box appears.
This field is optional.

Management Port To configure the Management Port parameters, click Configure. The Configure
Management Port dialog opens. For details, see Management Port Configuration.

Data/External Port To configure the Data/External port, click Configure.
For details, see Data/External Port Configuration.

DNS Settings To configure the DNS settings, click Configure.
For details, see DNS Settings Configuration.

AD Domains Displays a list of the joined Active Directory domains.
To join an active directory domain, click Join Domain.
For details on joining an AD domain, see Join AD Domain Configuration on page 1.

Management Port Configuration
To configure the ClearPass server's Management port:

1. From the Administration > Server Manager > Server Configuration > System > Management Port
section, click Configure.

The Configure Management Port dialog opens.
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Figure 513 Configure Management Port Dialog (IPv4)

2. Specify the Configure Management Port parameters for IPv4 as described in the following table:

Parameter Action/Description

Select IP Version Select IPv4 .

IP Address Specify the IPv4 address that is used to access the ClearPass Policy Manager server's
management port.

Subnet Mask Specify the management interface subnet mask for an IPv4 address.

Default Gateway Specify the default gateway for the management interface.
A default gateway serves as an access point or IP router that a networked device uses to
send information to a device in another network or the Internet.

Table 2: Configure Management Port Parameters (IPv4)

Parameter Action/Description

Select IP Version Select IPv4 .

IP Address Specify the IPv4 address that is used to access the ClearPass Policy Manager server's
management port.

Subnet Mask Specify the management interface subnet mask for an IPv4 address.

Default Gateway Specify the default gateway for the management interface.
A default gateway serves as an access point or IP router that a networked device uses to
send information to a device in another network or the Internet.

Table 3: Configure Management Port Parameters (IPv4)

3. Click Update.
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Figure 514 Configure Management Port Dialog (IPv6)

4. Specify the Configure Management Port parameters for IPv6 as described in the following table:

Parameter Action/Description

Select IP Version Select IPv6.

IPv6 Address/Mask Specify the IPv6 address that is used to access the ClearPass Policy Manager server's
management port.
To configure the IPv6 address, specify the IPv6address with prefix length: <
ipv6address\prefixlength >
NOTE: IPv6 addresses don't require a netmask as they use Classless Inter-Domain
Routing (CIDR).

IPv6 Default Gateway Specify the default gateway for the management interface.
A default gateway serves as an access point or IP router that a networked device uses
to send information to a device in another network or the Internet.

Table 4: Configure Management Port Parameters (IPv6)

Data/External Port Configuration
To configure the ClearPass server's Data/External port:

1. From the Server Configuration > System > Data/External Port section, click Configure.

The Configure Data/External Port dialog opens.

Figure 515 Configure Data/External Port Dialog (IPv4)

2. Specify the Configure Data/External Port parameters for IPv4 as described in the following table:
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Parameter Action/Description

Select IP Version Select IPv4 .

IP Address Specify the IPv4 address of the ClearPass server's data interface.

Subnet Mask Specify the management interface subnet mask for an IPv4 address.

Default Gateway Specify the IPv4 address of the default gateway for the data interface.

Table 5: Configure Data/External Port Parameters (IPv4)

3. Click Update.

Figure 516 Configure Data/External Port Dialog (IPv6)

4. Specify the Configure Data/External Port parameters for IPv6 as described in the following table:

Parameter Action/Description

Select IP Version Select IPv6.

IPv6 Address/Mask Specify the IPv6 address that is used to access the ClearPass Policy Manager server's
data port.
To configure the IPv6 address, specify the IPv6address with prefix length: <
ipv6address\prefixlength >
NOTE: IPv6 addresses don't require a netmask as they use Classless Inter-Domain
Routing (CIDR).

IPv6 Default Gateway Specify the default gateway for the data/external interface.
A default gateway serves as an access point or IP router that a networked device uses
to send information to a device in another network or the Internet.

Table 6: Configure Data/External Port Parameters (IPv6)

DNS Settings Configuration

To configure the ClearPass server's DNS (Domain Name System) settings:

1. From the Server Configuration page > System tab > DNS Settings, click Configure.

The Configure DNS Setting dialog opens.
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Figure 517 Configure DNS Settings Dialog

2. Specify the Configure DNS Settings parameters as described in the following table:

Parameter Action/Description

Primary Specify the primary DNS server for name look-up. You can specify an IPv4 or IPv6
address.
NOTE: A DNS server can be primary for one domain and secondary for another. Only
one DNS server should be configured as primary for a domain, but you can have any
number of secondary DNS servers.

Secondary Specify one or more secondary DNS servers for name look-up. You can specify an IPv4
or IPv6 address.

Tertiary Optionally, in the rare event of both the primary and secondary DNS servers going down,
you can configure a tertiary DNS server. You can specify an IPv4 or IPv6 address.
NOTE: The recommended practice is to configure the primary and secondary DNS
servers on separate machines, on separate Internet connections, and in separate
geographic locations.

DNS Caching If enabled, ClearPass Policy Manager will cache DNS entries from the DNS server for the
Time to live (TTL) value for each entry, reducing the number of queries to the DNS
server. This feature is disabled by default.

Table 7: Configure DNS Setttings Parameters

3. Click Update.

Join AD Domain Configuration
You can join ClearPass Policy Manager to an Active Directory (AD) domain to authenticate users and computers
that are members of an Active Directory domain. If you join ClearPass to an Active Directory domain, it creates
an account for the ClearPass node in the Active Directory database.

Users can then authenticate into the network using 802.1X and EAP methods, such as PEAP-MSCHAPv2, with
their own their own Active Directory credentials.

If you need to authenticate users belonging to multiple Active Directory forests or domains in your network,
and there is no trust relationship between these entities, then you must join ClearPass to each of these
untrusted forests or domains.

ClearPass is not required to join multiple domains belonging to the same Active Directory forest because a one-way
trust relationship exists between those domains. In this case, ClearPass can join the root domain.

ClearPass 6.7 Policy Manager | User Guide Administration | 514
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1546



515 | Administration ClearPass 6.7 Policy Manager |  User Guide

ClearPass can join or leave an Active Directory domain by using the following two buttons in the Server
Configuration page > System tab:

n Join Domain: Click Join Domain to join this ClearPass appliance to an Active Directory domain. Password
servers can be configured after Policy Manager is successfully joined. For more information on adding a
password server, see Add Password Server.

n Leave Domain: If the server is already part of multiple Active Directory domains, click Leave Domain to
disassociate this ClearPass appliance from an Active Directory domain.

For most use cases, if you have multiple nodes in the cluster, you must join each node to the same Active Directory
domain.

To join the selected ClearPass server to an Active Directory domain:

1. From the Server Configuration page > System tab > AD Domains, click Join AD Domain.

The Join AD Domain dialog opens:

Figure 518 Join AD Domain Dialog

2. Specify the Join AD Domain parameters as described in the following table.

Parameter Action/Description

Domain
Controller

Enter the Fully Qualified Domain Name (FQDN) of the domain controller, then press Tab.
The following message is displayed: Trying to determine the NetBIOS name...
ClearPass searches for the NetBIOS name for the domain.

NetBIOS name
(optional)

Enter the NetBIOS name of the domain.
Enter this value only if this is different from your regular Active Directory domain name. If this is
different from your domain name (usually a shorter name), enter that name here. Contact your
Active Directory administrator about the NetBIOS name.
NOTE: If you enter an incorrect value for the NetBIOS name, you see a warning message in the
user interface. If you see this warning message, leave the domain by clicking on the Leave
Domain button (which replaces the Join Domain button once you join the domain). After
leaving the domain, join again with the correct NetBIOS name.

Domain
Controller
name conflict

Specify the action to take in the event of a domain controller name conflict.

Table 8: Join AD Domain Parameters
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Parameter Action/Description

In some deployments (especially if there are multiple domain controllers, or if the domain name
has been wrongly entered in the last step), the domain controller FQDN returned by the DNS
query can be different from what was entered. In this case, you can:
n Use specified Domain Controller: Continue to use the domain controller name that you

entered.
n Use Domain Controller returned by DNS query: Use the domain controller name

returned by the DNS query.
n Fail on conflict: Abort the Join Domain operation.

Use default
domain admin
user

Check this box to use the Administrator user name to join the domain.
NOTE: In a production environment, it is likely that an Administrative username that has
permissions to join machines to the domain would be used for the default domain admin user.
In that case, 1) disable (that is, uncheck) the Use default domain admin user
[Administrator] check box and 2) enter the Admin username and password in the fields
provided.

Username Enter the user ID of the domain administrator account.
NOTE: This field is disabled if the Use default domain admin user check box is selected.

Password Enter the password for the user account that will join ClearPass with the domain (for related
information, see Table 9, which displays the characters that are allowed and not allowed for the
Active Directory username and password).

Field Characters Allowed Not Allowed

Username ~ ! @ # $ % ^ * _ - + = { } , . \ ' " ? / ` & ( )

Password ! @ # $ % ^ & * ( ) _ - + = { } < , > . ? / ~ ` [ ] \ | ; : ' "

Table 9: Active Directory Username and Password Characters Allowed and
Not Allowed

3. Click Save.

The Join AD Domain status screen opens. The screen displays the message “Adding host to AD domain,”
and the screen displays status during the joining process.

When the joining process completes successfully, you see the message “Added host to the domain.”

4. Click Close.

You return to the Server Configuration page, and it now shows that the ClearPass server is joined to the
domain.

Now that the ClearPass Policy Manager server has joined the domain, the server can authenticate users with
Active Directory.

After an Active Directory Domain is added, the domain controller can be set up as a password server (as
described in the next section).

Adding a Password Server
After ClearPass successfully joins an Active Directory domain, you can configure a restricted list of domain
controllers to be used for MSCHAP authentication. If this is not configured, then all available domain
controllers obtained from DNS will be included.
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When an Active Directory password server is updated in the domain server configuration, the RADIUS service is
automatically restarted.

To add an Active Directory password server:

1. Navigate to Administration > Server Manager > Server Configuration, then select the ClearPass server
of interest.

2. In the AD Domains section of the System page, click the Add Password Server icon: . 
This icon appears only after ClearPass joins at least one Active Directory domain (see Figure 519).

Figure 519 Add Active Directory Password Server Icon

The Configure AD Password Servers dialog opens.

Figure 520 Active Directory Password Server Added

3. Specify the following:

l Domain controller

l NetBIOS name

l Password server(s)

You can specify Active Directory password servers with a hostname or an IP address. Use a new line for
each entry.

4. To complete adding the Active Directory password servers, click Save.
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Services Control Page
From the Services Control page, you can:

n View the status of all the services: Running or Stopped.

n Stop or start Policy Manager services, including any Active Directory domains that the server joins.

To access the Services Control page:

1. Navigate to Administration > Server Manager > Server Configuration.

From the Server Configuration page, select the desired ClearPass server.

2. Click the Services Control tab.

The Services Control page opens.

Figure 521 Services Control Page

3. To start a stopped service, click the Start button; to stop a running service, click the Stop button.

Service Parameters Page
Navigate to the Administration > Server Manager > Server Configuration > Service Parameters page
to change system parameters of the services listed below.

This section describes the following topics:

n Async Network Services Options on page 519

n ClearPass IPsec Service

n ClearPass Network Services Options on page 521

n ClearPass System Services Options on page 524

n Ingress Logger Service Ports

n Policy Server Options on page 527

n RADIUS Server Options

n Stats Collection Service Options on page 532
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n System Monitor Service Options on page 533

n TACACS Server Options on page 534

The following figure displays the Service Parameters page:

Figure 522 Service Parameters Page

Async Network Services Options

To configure the parameters for the Async network service:

1. Navigate to the Administration > Server Manager > Server Configuration.

2. Select the ClearPass server.

3. From the Server Configuration page, select the Service Parameters tab.

The Service Parameters > Async network services dialog opens by default:

Figure 523 Configuring Async Network Services

4. Specify the Service Parameters > Async Network Services parameters as described in Table 1
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Parameter Action/Description

Ingress Event

Batch Processing Interval Specify the Batch Processing Interval for ingress event processing.
The default interval is 30 seconds. The range of values is 10 to 300 seconds.
NOTE: For changes to the Batch Processing Interval to take effect, you must
restart the Async Network service.

Command Control

CoA Delay Set the CoA Delay value (in seconds).
The default value is 2, and the allowed values are from 0 to 15 seconds.

Enable SNMP Bounce Action Set the Enable SNMP Bounce Action value.
The default value is FALSE.

Post Auth

Number of request processing
threads

Set the number of request processing threads.
The default value is 20 threads, and the range of values is between 20 and 100.

Lazy handler polling frequency Set the Lazy handler polling frequency (in minutes).
The default value is 5 minutes, and the allowed values are from 1 to 10
minutes.
NOTE: If the value of the polling interval is less than three minutes, a warning
message is displayed that advises that setting the Lazy-handler polling
frequency to lower than 3 minutes can cause performance-related issues.

Eager handler polling frequency Set the Eager handler polling frequency (in seconds).
The default value is 30 seconds, and the allowed values are from 10 to 300
seconds.
Eager handler polling is employed when an attribute requires the freshest
possible value.

Connection Timeout Set the connection timeout in seconds. The default value is 10, and the range is
from 1 to 3600 (one hour).

Palo Alto User Identification
Timeout

Specify the Palo Alto endpoint context server user identification timeout in
minutes. The default value is 45; the range is from 1 to 3600.

Table 1: Service Parameters > Async Network Services Parameters

ClearPass IPsec Service

When a network device requests an IPsec connection between the device and a ClearPass server, ClearPass
uses the Online Certificate Status Protocol (OCSP) URI (uniform resource identifier) to contact a third-party
server that checks to see if the certificate sent by the requesting device is valid.

If the certificate is confirmed as valid, an IPsec connection between the ClearPass server and the requesting
network device is established.

To configure the ClearPass IPsec service:

1. Navigate to Administration > Server Manager > Server Configuration, then select the ClearPass
server.

2. Select the Service Parameters tab.

3. From the Select Service drop-down, select ClearPass IPsec service.
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The following dialog opens:

Figure 524 Configuring a ClearPass IPsec Service

4. Specify the Service Parameters > ClearPass IPsec Service parameters as described in Table 1, then click Save.

Parameter Action/Description

OCSP URI In the Parameter Value field, specify the HTTP or HTTPS URI (uniform resource
identifier) for the Online Certificate Status Protocol (OCSP).
OCSP enables the ClearPass server to determine the revocation state of a
certificate presented by a peer—for example a network device requesting an IPsec
connection to the ClearPass server.
NOTE: When you enter the OCSP URI, ClearPass checks that 1) the URI is in the
proper format (it must start with HTTP or HTTPS and be syntactically correct), and
2) ClearPass checks to see if the specified OCSP server IP address or host name is
reachable from the ClearPass node. A descriptive error message will be displayed
in the event of an incorrect OCSP URI.

Strict CRL Policy You can enable or disable a strict Certificate Revocation List (CRL) policy. This
parameter is disabled by default.
n To enable Strict CRL Policy, select Yes from the Parameter Value drop-down.
When this option is enabled, a fresh Certificate Revocation List must be available in
order for a peer connection to succeed.
Whenever Strict CRL Policy is modified, existing IPsec tunnels that use Public Key
Authentication are brought down and then brought up again.

Table 1: Service Parameters > ClearPass IPsec Service Parameters

ClearPass Network Services Options

The ClearPass Network Services parameters aggregate service parameters from the following services:

n SNMP Service

n Certificate Authentication Service

n Web Authentication Service

n Posture Service

n DHCP Snooper Service

To configure the parameters for ClearPass Network Services:

1. Navigate to the Administration > Server Manager > Server Configuration, then select the ClearPass
server.

2. From the Server Configuration page, select the Service Parameters tab.

3. From the Select Service drop-down, select ClearPass network services.

The Service Parameters > ClearPass network services dialog opens:
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Figure 525 Service Parameters > ClearPass Network Services

4. Specify the ClearPass Network Services parameters as described in the following table:

Service Parameters Action/Description

SnmpService

SNMP Timeout Specify the seconds to wait for an SNMP response from the network device.

SNMP Retries Specify the number of retries for SNMP requests.

LinkUp Timeout Specify the seconds to wait before processing link-up traps.
If a MAC notification trap arrives in this time, the SNMP service does not try to poll
the switch for MAC addresses behind a port for link-up processing.

IP Address Cache Timeout Specify the duration in seconds for which MAC-to-IP lookup response is cached.

Uplink Port Detection
Threshold

Specify the limit for the number of MAC addresses found behind a port after which
the port is considered an uplink port and not considered for SNMP lookup and
enforcement.
The default value is 5, with a range from 0 to 20.

Table 1: Service Parameters > ClearPass Network Services
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Service Parameters Action/Description

SNMP v2c Trap
Community

Specify the community string that must be checked in all incoming SNMP v2 traps.

SNMP v3 Trap Username Specify the SNMP v3 Username to be used for all incoming traps.

SNMP v3 Trap
Authentication Protocol

Specify the SNMP v3 Authentication protocol for traps.
The options are: MD5, SHA, or empty (to disable authentication).
NOTE: The EAP-MD5 authentication type is not supported in FIPS mode.

SNMP v3 Trap Privacy
Protocol

Specify the SNMP v3 Privacy protocol for traps.
The options are: DES_CBC, AES_128, or empty (to disable privacy).
NOTE: The DES_CBC privacy protocol is not supported in FIPS mode.

SNMP v3 Trap
Authentication Key

Specify the SNMP v3 authentication key and privacy key for incoming traps.

SNMP v3 Trap Privacy Key

Device Info Poll Interval Specify the time (in minutes) between polling for device information.

Certificate Auth

OCSP Check Specify one of the following options for initiating an Online Certificate Status Protocol
(OCSP) check:
n None (the default setting)
n Optional
n Required

WebAuthService

Max time to determine
network device where
client is connected

Specifies the maximum time to wait for Policy Manager to determine the network
device to which the client is connected.
In some usage scenarios where the web authentication request does not originate
from the network device, Policy Manager has to determine the network device to
which the client is connected through an out-of-band SNMP mechanism. The network
device deduction process can take some time.

PostureService

Audit Thread Pool Size Specify the number of threads to use for connections to audit servers.

Audit Result Cache
Timeout

Specify the time (in seconds) for which audit result entries are cached by Policy
Manager.

Audit Host Ping Timeout Specify the number of seconds for which Policy Manager pings an end-host before
giving up and deeming the host to be unreachable.
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DhcpSnooper

MAC to IP Request Hold
time

Specify the number of seconds to wait before responding to a query to get an IP
address corresponding to a MAC address.
Any DHCP message received in this time period refreshes the MAC address-to-IP
address binding.
Typically, an audit service requests a MAC-to-IP mapping as soon the RADIUS
request is received, but the client may take some more time to receive the IP
address through DHCP. This wait period takes into account the latest DHCP IP
address that the client received.

DHCP Request Probation
Time

Specify the number of seconds to wait before considering the MAC-to-IP binding
received in a DHCP REQUEST message as final.
This wait handles cases where a client receives a DHCPNAK for a DHCPREQUEST
and receives a new IP address after going through the DHCPDISCOVER process
again.

5. Click Save.

ClearPass System Services Options

You can use the ClearPass System Services parameters for PHP (Hypertext Preprocessor) configuration and for
HTTP traffic flowing through a proxy server.

ClearPass Policy Manager relies on an HTTP connection for the ClearPass Update Portal to download the latest
information for system services.

To configure ClearPass System Services:

1. Navigate to the Administration > Server Manager > Server Configuration, then select the ClearPass
server.

2. From the Server Configuration page, select the Service Parameters tab.

3. From the Select Service drop-down, select ClearPass system services.

The following dialog opens:
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Figure 526 ClearPass System Services Parameters

4. Specify the Service Parameters > ClearPass System Services parameters as described in the following
table.

Service Parameter Action/Description

PHP System Configuration

Memory Limit Specify the maximum memory that can be used by the PHP (Hypertext Preprocessor)
applications.

Form POST Size Specify the maximum HTTP POST content size that can be sent to the PHP application.

File Upload Size Specify the maximum file size that can be uploaded into the PHP application.

Input Time Specify the time limit after which the ClearPass server will detect no activity from the
user and will take some action.

Socket Timeout Specify the maximum time for any socket connections.

Enable zlib output
compression

Specify the setting to compress the output files.

Table 1: Service Parameters > ClearPass System Services
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Include PHP header in
web server response

Specify the setting to include PHP header in the HTTP responses.

TCP Keep Alive Configuration

Keep Alive Time Specify a value in seconds from 10 to 86400.

Keep Alive Interval Specify a value in seconds from 1 to 3600.

Keep Alive Probes Specify a value from 1 to 100 for the number of probes.

Database Configurations

Maximum connections Specify a number between 300 and 2000 for a maximum number of allowed
connections.

Extensions

Extensions Network
Address

You can use the Extensions Network Address parameter to configure the adapter
interface and change the subnet used for the Extension.
Specify the bridge IP address used for internal networking with local extensions.
n Default : 172.17.0.1/16
n Format : IPv4_ADDR/PREFIX_LEN
n Validation: A valid, non-routable IPv4 address must be supplied. The IPv4 address

must match 10.0.0.0/8, 192.168.0.0/16, or 172.16.0.0/12.
n Prefix Length: A valid prefix length must be supplied: >= 16 and <= 29

HTTP Proxy

Proxy Server Specify the hostname or IP address of the proxy server.
NOTE: ClearPass Policy Manager supports IPv6 HTTP-proxy addresses for sending
data to third-party context servers.

Port Specify the port at which the proxy server listens for HTTP traffic.

Username Specify the user name to authenticate with the proxy server.

Password Specify the password to authenticate with the proxy server.

Web Server Configuration

Timeout Specify a server timeout value in seconds from 1 to 60.

Keep Alive To enable or disable keep-alive for the web server, select TRUE or FALSE.

Request Wait Specify the request wait time in seconds from 1 to 60. The default value is 4 seconds.

Enable Host Header
check

Specify whether to enable the host header check.
The default value is TRUE.
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Service Parameter Action/Description

n When you set this value to TRUE, the Host Header Restriction check is enabled
and only the allowed or whitelisted host headers are allowed.

n When you set this value to FALSE, irrespective of Host Headers in the http packet,
ClearPass Policy Manager redirects to https://<ClearPass-server>/tips.

WhiteList Host Names When the Enable Host Header check value is set to TRUE, the web access is allowed
for Whitelist Host Names, hostnames, IP addresses, and VIP addresses in ClearPass
Policy Manager. The comma separated whitelist host names are allowed to support
multiple hostnames.
When the Enable Host Header check value is set to TRUE and the WhiteList Host
Names field is blank, the web access is allowed only for hostnames, IP addresses, and
VIP addresses in ClearPass Policy Manager.

Maximum Clients Specify a value from 10 to 20000 for the maximum number of clients allowed.

Maximum Requests Specify a number between 0 and 3000 for the maximum number of requests allowed.
The default value is 500.

5. Click Save.

Ingress Logger Service Ports

When Ingress Event Processing is enabled and configured on ClearPass (see Enabling Ingress Events
Processing), logging of ingress events occurs automatically. By default, the ClearPass server listens for Ingress
Events on TCP port 514 and UDP port 514. If necessary, you can change these Syslog Ingress Logger ports.

To change the Syslog Ingress Logger ports:

1. Navigate to Administration > Server Manager > Server Configuration, then select the ClearPass
server.

2. Select the Service Parameters tab.

3. From the Select Service drop-down, select Ingress Logger Service.

The following dialog opens:

Figure 527 Ingress Logger Service Dialog

4. To change the Ingress Logger TCP Port, enter the new port number in the Parameter Value field.

5. To change the Ingress Logger UDP Port, enter the new port number.

6. Click Save.

Policy Server Options

To configure the Policy Server service:

1. Navigate to the Administration > Server Manager > Server Configuration, then select the ClearPass
server.

2. From the Server Configuration page, select the Service Parameters tab.
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3. From the Select Service drop-down, select Policy server.

The following dialog opens:

Figure 528 Policy Server Service Parameters

4. Specify the Service Parameters > Policy Server parameters as described in the following table.

Service Parameter Action/Description

Machine Authentication
Cache Timeout

Specify the time (in hours) for which machine authentication entries are cached by
ClearPass Policy Manager.
The default is 24 hours.

LDAP Primary Retry
Interval

After a primary LDAP server is down, the ClearPass server connects to one of the
backup servers.
Specify how long the ClearPass server waits (in seconds) before it tries to connect
to the primary server again.

Audit SPT Default Timeout Specify the time (in seconds) for which an Audit success or error response is
cached in the Policy server.

Additional time before
session deletion from
multi-master cache

Specify the number of seconds the Policy server will wait before deleting the multi-
master entry.
The default value is 0.
This parameter handles roaming scenarios where an Accounting-Start occurs
without an authentication request. If the value for this parameter is 0, the Policy
server deletes the multi-master entry when an Accounting-Stop is received.
The RADIUS server updates the multi-master entry with attribute values from the
accounting request. These can be used in the Change of Authorization (CoA). In a
roaming scenario, this NAS information update from the accounting request helps
ClearPass send the CoA to the correct NAS.

Number of request
processing threads

Specify the maximum number of threads used to process requests.

HTTP Thread Pool Size Specify the number of threads allotted for the HTTP thread pool.

Authentication Thread
Pool Size

Specify the number of threads to use for LDAP/Active Directory and SQL
connections.

Table 1: Service Parameters > Policy Server Service

RADIUS Server Options

To configure the RADIUS server service:

1. Navigate to the Administration > Server Manager > Server Configuration, then select the ClearPass
server.
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2. From the Server Configuration page, select the Service Parameters tab.

3. From the Select Service drop-down, select Radius server.

The following dialog opens:

Figure 529 RADIUS Server Parameters Dialog

Specify the Service Parameters > RADIUS server parameters as described in the following table:

Service Parameter Action/Description

EAP-FAST

Master Key Expire Time Specify the lifetime of a generated EAP-FAST master key.

Master Key Grace Time Specify the grace period for an EAP-FAST master key after its lifetime expires.
The default is 3 weeks.
If a client presents a PAC (Protected Access Credential) that is encrypted using
the master key in this period after its TTL (Time-to-Live), it is accepted and a new
PAC encrypted with the latest master key is provisioned on the client.

PACs are valid across cluster If PACs (Protected Access Credentials) generated by this server are valid across
the cluster, set to TRUE (the default setting).
If not, select FALSE.

Proxy

Maximum Response Delay If the target server has not responded, specify the time delay before retrying a
proxy request. The default is 5 seconds.

Maximum Reactivation Time Specify the time to elapse before retrying a dead proxy server.

Table 1: Service Parameters > RADIUS Server Service
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Maximum Retry Counts If the target server doesn't respond, specify the maximum number of times to
retry a proxy request.

Accounting

Log Accounting Interim-
Update Packets

To store the Interim-Update packets in session logs, select TRUE. FALSE is the
default setting.

Thread Pool

Maximum Number of
Threads

Specify the maximum number of threads in the RADIUS server thread pool to
process requests.

Number of Initial Threads Specify the initial number of threads in the RADIUS server thread pool to
process requests.

Active Directory Errors

Window Size Enter a duration during which Active Directory errors are accumulated for
possible action. The default is 5 minutes.

Number of Errors Enter a number to specify the number of Active Directory errors that can occur
within the defined Window Size and have the self-healing Recovery Action taken.
The default is 150.

Recovery Action Select one of the following recovery actions from the drop-down list:
n None: To not initiate a self-recovery action. This is the default.
n Exit: To restart the RADIUS server. (The monitoring daemon restarts it.)
n Restart Domain Service: To restart the Domain service.

Security

Reject Packet Delay Specify the delay time before sending an actual RADIUS Access-Reject message
after the server decides to reject the request.

Maximum Attributes Specify the maximum number of RADIUS attributes allowed in a request. The
default is 200.

Process Server-Status
Request

n TRUE: Send replies to Status-Server RADIUS packets.
n FALSE: Do not send replies to Status-Server RADIUS packets. This is the

default setting.

Main

Authentication Port Specify the ports on which the RADIUS server listens for authentication
requests. Default values are ports 1645 and 1812.
NOTE: You can configure the Authentication Port to different values if desired.

Accounting Port Specify the ports on which the RADIUS server listens for accounting requests.
The default values are 1646 and 1813.
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Service Parameter Action/Description

NOTE: You can configure the Accounting Port to different values if desired.

Maximum Request Time Specify the maximum time (in seconds) allowed for processing a request after
which it is considered timed out. The default is 30 seconds.

Cleanup Time Specify the time to cache the response sent to a RADIUS request after sending
it.
The range is from 2 to 10 seconds. The default is 5 seconds.
If the RADIUS server gets a duplicate request for which the response is already
sent, and the duplicate request arrives within this time period, the cached
response is resent.

Local DB Authentication
Source Connection Count

Specify the maximum number of Local DB connections opened.

AD/LDAP Authentication
Source Connection Count

Specify the maximum number of Active Directory and LDAP (Lightweight
Directory Access Protocol) connections opened.
The range is from 5 to 300. The default is 64.

SQL DB Authentication
Source Connection Count

Specify the maximum number of SQL DB.

Kerberos Authentication
Source Connection Count

Specify the maximum number of Kerberos connections opened.

EAP-TLS Fragment Size Specify the maximum allowed size (in bytes) for the EAP-TLS fragment.

Use Inner Identity in Access-
Accept Reply

To use the inner identity in the Access-Accept replies, select TRUE. The default
setting is FALSE.

Reject if OCSP response does
not have Nonce

To reject an OCSP response without a nonce, select TRUE. Else, select FALSE.

Include Nonce in OCSP
request

Specify one of the following:
n TRUE: Select if the OCSP (Online Certificate Status Protocol) request should

include the nonce. This is the default value.
n FALSE: To avoid the EAP-TLS authentication failure, select if the OCSP server

does not support the nonce.

Enable signing for OCSP
Request

To enable signing for OCSP request, select TRUE.
This determines whether ClearPass should sign an OCSP request with a
RADIUS/EAP server certificate. The default value is FALSE.

Check the validity of all
certificates in the chain
against CRLs

To check the validity of all certificates in the chain against Certificate Revocation
Lists (CRLs), select TRUE. Else, select FALSE.

ECDH Curve Select one of the following ECDH curve (Elliptic Curve Diffie-Helman) options
from the drop-down list:
n X9.62/SECG curve over a 256-bit prime field
n NIST/SECG curve over a 384-bit prime field
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Disable TLS 1.2 To disable Transport Layer Security 1.2 (TLS 1.2), select TRUE.
FALSE is the default setting—TLS 1.2 is enabled by default.

Check the validity of
intermediary certificates in
the chain using OCSP

To check the validity of intermediary certificates in the chain using OCSP (Online
Certificate Status Protocol), select TRUE.
The default setting is FALSE.

Maximum Number of AD
Authentication Processes

To specify the maximum number of Active Directory authentication processes,
enter a number between 1 and 5.
The default is 1.

Verify OCSP Signing Purpose Specify one of the following:
n When the value for this parameter is set to TRUE, EAP-TLS authentication will

fail unless the OCSP signing certificate also has the OCSP signing purpose
set.

n If this parameter is left at the default setting of FALSE, the OCSP signing
certificate does not need to have the OCSP signing purpose set.

Disable CPPM Machine
account password expiry in
AD

Specify one of the following:
n When the value for this parameter is set to TRUE, it disables the Samba

machine account password timeout setting so that a change to the machine
account password will not be made.

n If this parameter is left at the default setting of FALSE, the Samba machine
account password timeout setting remains in effect.

Skip netevents for IPv6
Accounting Packets

This option is recommended in a dual-stack (IPv4/IPv6) environment when
ClearPass is configured to send updates to endpoint servers.
Use this option to disable accounting netevents if an IPv6 address is present in
the accounting packet.

When you enable this option (that is, set to TRUE), ClearPass does not send
client IPv6 updates to endpoint servers. The default setting is FALSE.

TLS Session Cache Limit Specify the number of TLS sessions to cache before purging the cache (used in
TLS based 802.1X EAP Methods).
The range is from 1,000 to 100,000. The default is 10,000.

Stats Collection Service Options

To configure the Statistics Collection service:

1. Navigate to the Administration > Server Manager > Server Configuration, then select the ClearPass
server.

2. From the Server Configuration page, select the Service Parameters tab.

3. From the Select Service drop-down, select Stats collection service.

The following dialog opens:
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Figure 530 Statistics Collection Service Dialog

4. Specify the Service Parameters tab > Stats Collection Service parameter as described in the following
table:

Service
Parameter Action/Description

Enable Stats
Collection

Enable or disable statistics collection and aggregation.
The Statistics Collection Service is enabled by default (TRUE).
If this is not enabled, statistics collection and aggregation services will not run on the node.
In addition, if statistics collection and aggregation is not enabled, the following error message
is displayed if the administrator attempts to start these services:
Failed to start Stats collection service - Ignoring service start request as Stats
Collection option is disabled on the node
NOTE: Enabling or disabling this parameter requires a restart of the cpass-statsd-server and
the cpass-carbon-server.

Table 1: Service Parameters > Statistics Collection Service

System Monitor Service Options

To configure the System Monitor service:

1. Navigate to the Administration > Server Manager > Server Configuration, then select the ClearPass
server.

2. From the Server Configuration page, select the Service Parameters tab.

3. From the Select Service drop-down, select System monitor service.

The following dialog opens:

Figure 531 System Monitor Service Dialog

4. Specify the Service Parameters > System Monitor Service parameters as described in the following
table:
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Free Disk Space
Threshold

This parameter monitors the available disk space on the current ClearPass server
node.
Specify the Free Disk Space Threshold (the default is 30%).
If the available disk free space falls below the specified threshold, the ClearPass
server sends SNMP traps to the configured trap servers.

1 Min CPU load average
Threshold

These parameters monitor the CPU load average of the system, specifying thresholds
for 1-minute, 5-minute, and 15-minute averages, respectively.
If any of these loads exceed the associated maximum value, the ClearPass server
sends traps to the configured trap servers.5 Min CPU load average

Threshold

15 Min CPU load average
Threshold

Table 1: Services Parameters > System Monitor Service Parameters

5. Click Save.

TACACS Server Options

To configure the TACACS Server service:

1. Navigate to the Administration > Server Manager > Server Configuration, then select the ClearPass
server.

2. From the Server Configuration page, select the Service Parameters tab.

3. From the Select Service drop-down, select Tacacs server.

The following dialog opens:

Figure 532 Service Parameters > TACACS+ Server Dialog

4. Specify the Service Parameters > TACACS server parameters as described in the following table:
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Service Parameter Action/Description

TACACS+ Profiles Cache
Timeout

Specify the time (in seconds) for which TACACS+ profile result entries are
cached by ClearPass Policy Manager.
The default is 86400 seconds (24 hours).

TACACS+ HTTP Thread
Pool Size

Specify the maximum number of simultaneous requests the server can
handle.
The default value is 100.
The range is from 5 to 500.
When the server has reached the limit or request threads, it defers
processing new requests until the number of active requests drops below
the specified amount. Increasing this value reduces HTTP response
latency times.

TACACS+ Authentication
Timeout

Specify the timeout value for the TACACS+ server.
The default value is 30 seconds.
The range is from 1 to 300 seconds.
This parameter specifies the timeout between the TACACS+ server (the
ClearPass server) and the Authentication server (such as Active
Directory, Token server, or any other authentication method).
If the Authentication server does not reply back to ClearPass (TACACS+
server) within the configured TACACS+ Authentication Timeout, then the
TACACS+ server (ClearPass) will timeout.

Table 1: Service Parameters > TACACS Server

5. Click Save.

System Monitoring Page
By configuring the System Monitoring parameters, you can ensure that the external Management
Information Base (MIB) browsers can browse the system-level MIB objects exposed by the ClearPass Policy
Manager appliance. The options in this page vary based on the SNMP version that you select.

To configure the System Monitoring parameters:

1. Navigate to the Administration > Server Manager > Server Configuration page.

2. Select the ClearPass server of interest.

3. Select the System Monitoring tab.

The System Monitoring configuration dialog opens:

Figure 533 System Monitoring Configuration Dialog

4. Specify the System Monitoring configuration parameters as described in the following table:
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System Location Specify the location of the ClearPass Policy Manager appliance.

System Contact Specify the contact information of the ClearPass Policy Manager appliance.

Engine ID A unique identifier for the SNMP v3 agent. The engine ID is used with a hashing function
to generate keys for authentication and encryption of SNMP v3 messages.
The default value for the Engine ID is 6620000004030662.
The Engine ID is automatically generated when you enable the stand-alone SNMP agent.

SNMP Configuration

Version Specify the SNMP version from the options V1, V2C, or V3.
The SNMP parameters on this page vary based on the SNMP version selected.

Community String V1 and V2C: Enter and reenter the community string for sending traps. This is applicable
only for SNMP V1 and V2C versions.

Username V3 only: Specify the user name to use for SNMP v3 communication.

Security Level V3 only: Select any of the following options:
n NOAUTH_NOPRIV (No authentication or privacy): When you select this security level,

only the SHA authentication protocol is available.
n AUTH_NOPRIV (Authentication but no privacy): When you select this security level,

the MD5 and SHA authentication protocols are available.
n AUTH _PRIV (Authenticate and keep the communication private): When you select

this security level, the MD5 and SHA authentication protocols are available.

Authentication
Protocol

V3 only: Select the authentication protocol from MD5 or SHA.
These protocols vary depending on the security level that you selected in the Security
Level field.
NOTE: The MD5 authentication protocol is not supported in FIPS mode.

Authentication key V3 only: Enter and reenter the authentication key. This field is available only if you
selected V3 as the SNMP version in the Version field.

Privacy Protocol V3 only: Select the privacy protocol from DES or AES.

Privacy Key V3 only: Enter the privacy key.

Table 1: System Monitoring Parameters

Network Page
This section provides the following information:

n Defining Application Access Control Restrictions

n Adding an SSH Public Key

n Creating GRE Tunnels

n Creating IPsec Tunnels

n Creating VLANs

To configure the Server Configuration > Network parameters:

1. Navigate to Administration > Server Manager > Server Configuration.
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2. Select the ClearPass server of interest.

3. Select the Network tab.

The Server Configuration > Network page opens:

Figure 534 Server Configuration > Network Page

Defining Application Access Control Restrictions
Use this function to define specific network resources and allow or deny them access to specific applications.
You can create multiple definitions.

To configure network application access control restrictions:

1. Navigate to the Administration > Server Manager > Server Configuration.

2. Select the ClearPass server of interest.

3. From the Server Configuration page, select the Network tab.

The Server Configuration > Network page opens.

4. From the Application Access Control option, click Restrict Access.

The Restrict Access dialog opens.
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Figure 535 Restrict Access Configuration Dialog

5. Specify the Restrict Access parameters as described in the following table, then click Create:

Parameter Action/Description

Resource
Name

Select the application for which you want to allow or deny access:
n OnGuard
n ClearPass API
n CLI
NOTE: Restricting CLI access restricts SSH access to the appadmin user. The console access is still
available through the appadmin user account.
n Policy Manager
n Graphite
n Guest Operator
n Insight

Access Select one of the access control options:
n Allow: Allows access to the selected application.

When you configure the Access option as Allow, with a specific set of IP addresses or subnets,
this set becomes the white list. This means there is an implicit Deny Access statement for all
other IP addresses or subnets in the network.

n Deny: Denies access to the selected application.
When you configure the Access option as Deny, with a specific set of IP addresses or subnets,
then every other IP address and subnet in the network has access except those specified here.
This means there is an implicit Allow Access statement for all other IP addresses or subnets in
the network.

Network Enter one or more host names, IP addresses, or IP subnets (CIDR) per line.
The devices defined by what you enter here will be either specifically allowed or specifically denied
access to the application you select.

Table 1: Restrict Access Parameters

ClearPass 6.7 Policy Manager | User Guide Administration | 538
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1570



539 | Administration ClearPass 6.7 Policy Manager |  User Guide

Adding an SSH Public Key
ClearPass supports public key-based SSH logins. This includes public key management and the ability to enable
public key authentication in ClearPass on a node-by-node basis.

When you add the SSH public key to the clients, ClearPass allows passwordless SSH public key-based
authentication to the appadmin ClearPass console.

SSH public key-based authentication will continue to work even when the cluster password or the appadmin
password have been changed.

To add an SSH public key:

1. Navigate to Administration > Server Manager > Server Configuration.

The Server Configuration page opens.

2. Select the ClearPass server for which passwordless SSH is needed.

The Server Configuration dialog for the selected server opens.

3. Select the Network tab.

The Server Configuration >Network page opens.

4. From the SSH Public Keys option, click Add Public Key.

The Add Public Key configuration page opens.

Figure 536 Adding a Public Key

5. In the SSH Public Key page, copy and paste the SSH public key of the client, then click Save.

If the SSH public key is regenerated on the client, passwordless public key-based SSH authentication will cease to
work. The existing entry for that client must be deleted. Then copy and paste the new SSH public key.

6. From the Server Configuration page, click Save.

The SSH operation to the ClearPass server using a public key is now active, and you can perform
passwordless SSH to the ClearPass server appadmin console.

Creating GRE Tunnels

You can use the Generic Routing Encapsulation (GRE) protocol to create a virtual point-to-point link over a
standard IP network or the Internet.

To create a GRE tunnel:

1. Navigate to the Administration > Server Manager > Server Configuration.

2. Select the ClearPass server of interest.

3. From the Server Configuration page, select the Network tab.

The Server Configuration > Network page opens.
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4. From the GRE Tunnels option, click Create Tunnel.
The Create Tunnel dialog opens:

Figure 537 Creating a GRE Tunnel

5. Specify the Create Tunnel parameters as described in the following table, then click Create:

Parameter Action/Description

Display Name Specify the name for the tunnel interface.
This name is used to identify the tunnel in the list of network interfaces.

Local Inner IP Enter the local IP address of the tunnel network interface.

Remote Outer IP Enter the IP address of the remote tunnel endpoint.

Remote Inner IP Enter the remote IP address of the tunnel network interface.
Enter a value to automatically create a route to this address through the tunnel.

Local Outer IP
(Optional)

Optionally, enter the local IP address of the tunnel endpoint.

Table 2: Create Tunnel Parameters

Creating IPsec Tunnels

ClearPass provides the option to configure rules that can determine which IPsec traffic to tunnel, which traffic
to drop, and which traffic to encrypt or bypass (see Figure 539).

Thus, ClearPass supports adding traffic selectors based on port number and protocol (TCP/UDP) with rule
options Bypass, Encrypt, and Drop (see Table 5).

To create an IPsec tunnel:

1. Navigate to the Administration > Server Manager > Server Configuration.

2. Select the ClearPass server of interest.

3. From the Server Configuration page, select the Network tab.

The Server Manager > Configuration > Network page opens.

4. Click Create IPsec Tunnel.
The Create IPsec Tunnel dialog opens to the General tab.
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Figure 538 Creating an IPsec Tunnel Dialog

5. Specify the Create IPsec Tunnel parameters as described in the following table, then click Create:

Parameter Action/Description

Local Interface Specify the local Management interface.
n IPv6 addresses are available in the drop-down list and can be specified as the

remote IP address.
n The local interface and remote IP address must either both be IPv4, or both be

IPv6.
NOTE: The IP addresses for the local and remote fields cannot be local link
addresses starting with fe80.

Remote IP Address Specify the IP address of the remote host. The remote IP address can be either IPv4
or IPv6.

IPsec Mode Select one of the following IPsec modes:
n Tunnel
n Transport

IKE Version Select the version of the Internet Key Exchange (IKE) protocol from the options: 1 or
2.

IKE Phase 1 Mode This parameter is enabled when you select IKE Version 1.
IKE Phase 1 Mode is set by default to Main.

PRF The PRF (pseudorandom function) parameter is enabled when you select IKE
Version 2.
Select one of the following PRF options:

l PRF-HMAC-SHA1

Table 3: Create IPSec Tunnel Parameters
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l PRF-HMAC-SHA256
l PRF-HMAC-SHA384
l PRF-HMAC-MD5
l Pre-Shared Key

Encryption Algorithm Select one of the following encryption algorithms:
l AES128
l AES256

Hash Algorithm Select one of the following hash algorithms:
l HMAC SHA
l HMAC-SHA256
l HMAC-SHA384
l HMAC-MD5

Diffie Hellman Group Select one of the following Diffie Hellman groups:
l Group 5
l Group 14
l Group 19
l Group 20

Authentication Type Select one of the following authentication types:
l Pre-Shared Key
l Certificate

IKE Shared Secret

Verify IKE Shared Secret

Enter the IKE Shared Secret, then verify the IKE secret key.
The IKE Shared Secret can be up 128 characters in length.
NOTE: This option appears only when the Authentication Type is set to Pre-Shared
Key.

IKE Lifetime Specify the number of minutes for the lifetime of the IKE. The default is 180
minutes.
The valid range for IKE Lifetime is from 5 to 1440 minutes.

Lifetime Specify the lifetime of the IPsec tunnel in minutes. The default is 60 minutes.
The valid range for Lifetime is from 5 to 1440 minutes.

Peer Certificate Subject DN When the authentication type is set to Certificate, you can configure the Peer
Subject Certificate DN (Distinguished Name) field, which ensures that the IPsec
connection will be successfully established only for peers that have certificates that
match the peer certificate subject DN.
NOTE: Configuring Peer Certificate Subject DN is optional. If it is configured,
the Distinguished Name should match with the peer certificate DN in order to
complete the authentication.

Enabled To enable the IPsec tunnel, click the Enabled check box.
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Parameter Action/Description

Local Interface Specify the local Management interface.
n IPv6 addresses are available in the drop-down list and can be specified as the

remote IP address.
n The local interface and remote IP address must either both be IPv4, or both be

IPv6.
NOTE: The IP addresses for the local and remote fields cannot be local link
addresses starting with fe80.

Remote IP Address Specify the IP address of the remote host. The remote IP address can be either IPv4
or IPv6.

IPsec Mode Select one of the following IPsec modes:
n Tunnel
n Transport

IKE Version Select the version of the Internet Key Exchange (IKE) protocol from the options: 1 or
2.

IKE Phase 1 Mode This parameter is enabled when you select IKE Version 1.
IKE Phase 1 Mode is set by default to Main.

PRF The PRF (pseudorandom function) parameter is enabled when you select IKE
Version 2.
Select one of the following PRF options:

l PRF-HMAC-SHA1
l PRF-HMAC-SHA256
l PRF-HMAC-SHA384
l PRF-HMAC-MD5
l Pre-Shared Key

Encryption Algorithm Select one of the following encryption algorithms:
l AES128
l AES256

Hash Algorithm Select one of the following hash algorithms:
l HMAC SHA
l HMAC-SHA256
l HMAC-SHA384
l HMAC-MD5

Diffie Hellman Group Select one of the following Diffie Hellman groups:
l Group 5
l Group 14
l Group 19
l Group 20

Authentication Type Select one of the following authentication types:
l Pre-Shared Key
l Certificate

IKE Shared Secret Enter the IKE Shared Secret, then verify the IKE secret key.
The IKE Shared Secret can be up 128 characters in length.

Table 4: Create IPSec Tunnel Parameters
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Verify IKE Shared Secret NOTE: This option appears only when the Authentication Type is set to Pre-Shared
Key.

IKE Lifetime Specify the number of minutes for the lifetime of the IKE. The default is 180
minutes.
The valid range for IKE Lifetime is from 5 to 1440 minutes.

Lifetime Specify the lifetime of the IPsec tunnel in minutes. The default is 60 minutes.
The valid range for Lifetime is from 5 to 1440 minutes.

Peer Certificate Subject DN When the authentication type is set to Certificate, you can configure the Peer
Subject Certificate DN (Distinguished Name) field, which ensures that the IPsec
connection will be successfully established only for peers that have certificates that
match the peer certificate subject DN.
NOTE: Configuring Peer Certificate Subject DN is optional. If it is configured,
the Distinguished Name should match with the peer certificate DN in order to
complete the authentication.

Enabled To enable the IPsec tunnel, click the Enabled check box.

Traffic Selectors

A traffic selector (also known as a proxy ID in IKEv1) is an agreement between IKE peers to permit traffic
through a tunnel if the traffic matches a specified pair of local and remote addresses. Only traffic that
conforms to a traffic selector is permitted through the associated IPsec security association (SA).

Traffic selectors are retained after a system restart, a service restart of network services, and a service restart of
the IPsec service.

To configure the traffic selectors for this IPsec tunnel:

1. From the Create IPsec Tunnel dialog, select the Traffic Selectors tab.

The Traffic Selectors dialog opens.
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Figure 539 Create IPsec Tunnel > Traffic Selectors Dialog

2. Specify the Traffic Selectors parameters as described in the following table, then click Create.

Parameter Action/Description

Encrypt Rules Displays the IPsec tunnel encryption rules configured for this IPsec tunnel.

Bypass Rules Displays the IPsec tunnel bypass rules configured for this IPsec tunnel.

Drop Rules Displays the IPsec tunnel drop rules configured for this IPsec tunnel.

Type Select one of the following traffic selector types:
l Bypass
l Encrypt
l Drop

Protocol Select one of the following protocols:
l Any
l TCP
l UDP

Port From the Port drop-down list, select the port.

Reset To reset the configuration settings to the defaults, click Reset.

Save Rule To save the current Rule configuration, click Save Rule.

Table 5: Create IPSec Tunnel > Traffic Selectors Parameters
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Encrypt Rules Displays the IPsec tunnel encryption rules configured for this IPsec tunnel.

Bypass Rules Displays the IPsec tunnel bypass rules configured for this IPsec tunnel.

Drop Rules Displays the IPsec tunnel drop rules configured for this IPsec tunnel.

Type Select one of the following traffic selector types:
l Bypass
l Encrypt
l Drop

Protocol Select one of the following protocols:
l Any
l TCP
l UDP

Port From the Port drop-down list, select the port.

Reset To reset the configuration settings to the defaults, click Reset.

Save Rule To save the current Rule configuration, click Save Rule.

Table 6: Create IPSec Tunnel > Traffic Selectors Parameters

Checking IPsec Tunnel Status

To check the status of an IPsec tunnel:

1. Navigate to the Server Manager > Configuration > Network page.

The IPsec Tunnels section displays the configuration summary for each configured IPsec tunnel, along
with an Action button to provide each IPsec tunnel's current status.

Figure 540 IPsec Tunnel Summary and Action Button to See Tunnel Status

2. To see the current status for an IPsec tunnel, click the Action button (see Figure 540).

The IPsec Tunnel Status window for the selected tunnel opens:
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Figure 541 IPsec Tunnel Status

l Bring Up
If the tunnel is down, Bring Up brings up the IPsec tunnel. If you select Bring Up when the tunnel is up,
ClearPass creates a new tunnel.

l Bring Down
If the tunnel is up, Bring Down tears down the IPsec tunnel.

If you select Bring Down when the tunnel is down (for example, when the tunnel is still negotiating),
ClearPass stops the tunnel from forming.

Understanding the IPsec Tunnel Status Information

A way to quickly decipher the IPsec tunnel status information is as follows:

n If the tunnel status shows ESTABLISHED, only IKE Phase 1 is complete.

n If the tunnel status shows INSTALLED, Rekeying, IKE Phase 2 is complete.

Example 1

If tunnel status shows as shown in Figure 542, Phase 1 is complete but Phase 2 is failing. Look at the Audit
Viewer events (Monitoring > Audit Viewer) to find the root cause.

Figure 542 IPsec Tunnel Status: Only IKE Phase 1 Complete

Example 2

When the tunnel status displays the information as shown in Figure 543, Phase 2 is also complete.
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Figure 543 IPsec Tunnel Status: IKE Phase 1 and Phase 2 Complete

Creating VLANs

To create VLAN interfaces:

1. Navigate to the Administration > Server Manager > Server Configuration.

2. Select the ClearPass server of interest.

3. From the Server Configuration page, select the Network tab.

The Server Configuration > Network page opens.

4. From the VLANS option, click Create VLAN.
The Create VLAN dialog opens:

Figure 544 Creating a VLAN

5. Specify the Create VLAN parameters as described in the following table, then click Create:

Parameter Action/Description

Physical
Interface

Enter the physical port on which to create the VLAN interface.
This is the interface through which the VLAN traffic will be routed.
NOTE: Make sure your network supports tagged 802.1Q packets on the selected
physical interface.

VLAN Name Enter the name for the VLAN interface.
This name is used to identify the VLAN in the list of network interfaces.

VLAN ID Specify the 802.1Q VLAN identifier. Enter a value between 1 and 4094.
The VLAN ID cannot be changed after the VLAN interface has been created.

Table 7: Server Configuration > Create VLAN Parameters
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Parameter Action/Description

NOTE: VLAN ID 1 is often reserved for use by network management components.
Avoid using this VLAN ID unless you know it will not conflict with a VLAN already defined
in your network.

IP Address Enter the IP address of the VLAN.

Netmask Enter the netmask for the VLAN.

FIPS Page
This section provides information on using ClearPass Policy Manager in Federal Information Processing
Standards (FIPS) 140-2 approved mode.

The U. S. Government developed FIPS 140-2 to define procedures, architectures, cryptographic algorithms,
and other security techniques for use in government applications and networks that use cryptography.

When running in FIPS Approved mode, ClearPass Policy Manager utilizes a FIPS 140-2 validated cryptographic
module. Support is not available for non-approved authentication methods such as EAP-MD5 and MD5 digest
algorithms.

For details on the Validated FIPS 140-1 and FIPS 140-2 Cryptographic Modules, see:

http://csrc.nist.gov/groups/STM/cmvp/documents/140-1/140val-all.htm#2577

Enabling FIPS Mode Using CLI

1. You can enable FIPS mode in ClearPass during installation using the CLI or post-installation using the Web
UI.

The following figure displays the prompt to enable FIPS mode using the CLI:

Figure 545 Enabling FIPS Mode

2. After enabling FIPS mode using the CLI commands, you can verify whether FIPS mode is enabled or not in
the Configuration Summary page.
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Figure 546 FIPS Mode > Configuration Summary

Enabling FIPS Mode in the ClearPass User Interface

Alternatively, you can enable or disable the FIPS mode in the ClearPass user interface:

1. Navigate to Administration > Server Manager > Server Configuration, then select the server of
interest.

The Server Configuration dialog for the selected server opens.

2. Select the FIPS tab.

Figure 547 Server Configuration > FIPS Tab

Important Points to Remember

Note the following important points, when you enable FIPS mode in the ClearPass Policy Manager user
interface:

n The database is reset when you enable the FIPS mode in ClearPass Policy Manager.

Ensure that you backed up your database before enabling FIPS mode.

n Configuration backup file from the ClearPass Policy Manager in non-FIPS mode cannot be restored on
ClearPass Policy Manager in FIPS mode. However, configuration backup file from the ClearPass Policy
Manager in FIPS mode can be restored on the ClearPass Policy Manager in non-FIPS mode.

n The server will be removed from the cluster if FIPS mode is enabled.

ClearPass 6.7 Policy Manager | User Guide Administration | 550
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1582



551 | Administration ClearPass 6.7 Policy Manager |  User Guide

n All nodes in a cluster must be either in FIPS or non-FIPS mode. The ClearPass Policy Manager nodes in FIPS
mode cannot be connected to the cluster whose nodes are in the non-FIPS mode.

n The legacy authentication method such as EAP-MD5 and MD5 digest algorithm are not supported in FIPS
mode. You cannot import the certificates that are created with the MD5 authentication type to the
Certificates Trust List (Administration > Certificates > Certificate Trust List) page.

n The server reboots when you enable FIPS mode. You need to log in again to the Administration interface.

You can view the status of FIPS mode in the status bar. The following figure displays the Status bar with the
status of FIPS mode:

Figure 548 FIPS Status

You can also view the status of the FIPS mode using the CLI commands. For more information, see Show
Commands on page 914.

ClearPass Cluster Configuration Options
This section describes the cluster configuration options that are available from the Administration > Server
Manager > Server Configuration page.

n Cluster-Wide Parameters

n Synchronizing the Cluster Date and Time with the NTP Server

n Changing the Cluster-Wide Password

n Managing Policy Manager Zones

n Configuring NetEvents Targets

n Clearing Machine Authentication Cache

n Configuring Virtual IP Settings

n Making a Subscriber Node

Cluster-Wide Parameters
This section describes the following Cluster-Wide Parameters features:

n General Parameters

n Cleanup Intervals Parameters

n Notifications Parameters

n Standby Publisher Parameters
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n Virtual IP Parameter

n Common Criteria Mode Parameter

n Database Parameters

n Profiler Parameters

n TACACS Parameters

General Parameters
You can configure the parameters that apply to all the nodes in a ClearPass cluster by configuring the Cluster-
Wide Parameters.

To configure the Cluster-Wide parameters:

1. Navigate to the Administration > Server Manager > Server Configuration page.

2. Select the Cluster-Wide Parameters link.

The Cluster-Wide Parameters page opens to the General page:

Figure 549 Cluster-Wide Parameters > General Page
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3. Configure the Cluster-Wide Parameters > General parameters as described in the following table, then
click Save.

Parameter Action/Description

Policy result cache timeout Specify the duration allowed in minutes to store the role mapping and posture
results derived by the policy engine during a policy evaluation.
A value of 0 disables caching.
This result can then be used in subsequent evaluation of policies associated
with a service, if the Use cached Roles and Posture attributes from
previous sessions option is turned on for the service.
NOTE: The value of the Policy result cache timeout field must be greater
than the highest value set in the Health Check Interval (in hours) fields.
For example, if you have created the profiles Student-Enforcement-Profile and
Staff-Enforcement-Profile with health check interval configured, then the value
of the Policy result cache timeout field must be greater than the highest
value of the Health Check Quiet Period (in hours) value configured among
the following profiles:
n Global Agent Settings
n Student-Enforcement-Profile
n Staff-Enforcement-Profile

Free disk space threshold value Specify the percentage below which disk usage warnings are issued in the
Monitoring > Event Viewer page.
For example, a value of 30% indicates that a warning is issued only when the
available disk space is 30% or lower.
An error message similar to the following may appear in the System Event
Details dialog:
System is running with low disk space. Aggressive cleanup will be initiated when
the available disk space falls below 80%. Current available disk space = 75%

Free memory threshold value Specify the percentage below which RAM usage warnings are issued in the
ClearPass Event Viewer.
For example, a value of 30 indicates that a warning is issued only when the
available RAM is 30% or lower.

Endpoint Context Servers polling
interval

Enter the interval in minutes between polling of endpoint context servers.
The default interval is 60 minutes.

Syslog Export Interval This parameter provides the ability to configure the Syslog messaging batch
interval. The default value is 120 seconds. The supported interval value is
between 30 seconds to 120 seconds.
NOTE: The interval specified for this parameter is applied to all appliances in a
cluster and to all the Syslog Export Filters that are in the enabled state. For
related information, see Syslog Export Filters.

Automatically check for available
Software Updates

Specify whether to enable automatic checking for available software updates.
The default it TRUE. For related information, see Software Updates.

Automatically download Posture
Signature and Windows Hotfixes
Updates

Specify whether to automatically download and install Posture Signature and
Windows Hotfixes Updates. The default is FALSE. For related information, see
Software Updates.

Automatically download
Endpoint Profile Fingerprints

Specify whether to automatically download Endpoint Profile Fingerprints. The
default is FALSE. For related information, see Software Updates.

Table 1: Cluster-Wide Parameters > General Page Parameters
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Login Banner Text Customize the banner text that appears on the ClearPass login screen and CLI
access window.

Allow Concurrent Admin Login n When this field is set to TRUE (which is the default setting), an Admin user
can log in to the same ClearPass server concurrently from either the same
device or a different device.

n When this field is set to FALSE, and an Admin user logs into a ClearPass
server from one device, and then later logs into the same ClearPass server
from either the same device or a different device, the Admin user is logged
out of all previous sessions on that ClearPass server. When this occurs, the
following message is displayed:
You have been logged out of previous active session(s)

Admin Session Idle Timeout Specify the maximum idle time permitted for admin users, beyond which the
session times out.
The default value is 30 minutes. The allowed range is 5 to 1440 minutes (24
hours).

CLI Session Idle Timeout Specify the maximum idle time permitted for CLI users, beyond which the
session times out.
The default value is 360 minutes. The allowed range is 5 to 1440 minutes (24
hours).
When this parameter is changed, the changes take effect when the client
opens a new CLI session. Any active CLI sessions will continue to use the old
timeout setting—the sessions have to be disconnected and reconnected for
the updated timeout value to take effect.

Console Session Idle Timeout Specify the Console Session Idle Timeout duration in minutes. The default
value is 360 minutes.
The Console Idle Session Timeout does not begin counting down until the
admin user exits the admin session, or when the admin session has timed out.
If the user is still logged in to the admin session, the Console Session Idle
Timeout is not enforced. To impose an automatic logout from the ClearPass
server for an admin user connected to the console, you must set the idle
timeout for the Admin Session Idle Timeout as well as the Console Session
Idle Timeout.
The Console Session Idle Timeout:
n Must have a valid integer value (for example, a setting of 10.5 wouldn't be

valid).
n The range of valid values is from 5 to 1,440 minutes (24 hours).
n The Audit Viewer captures the details about changes in Console Session

Idle Timeout.

Disable TLSv1.0 support To disable Transport Layer Security (TLS) v1.0 support, select one of
n Admin
n Network
n All
NOTE: Operations in Common Criteriarequire that this value be set to ALL..

Disable TLSv1.1 support To disable Transport Layer Security (TLS) v1.1 support, select one of the
following options:
n None
n Admin
n Network
n All
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Parameter Action/Description

NOTE: Operations in Common Criteria require that this value be set to ALL.

Content Security Policy (CSP) When enabled, Content Security Policy (CSP) has significant impact on the way
browsers renders pages (e.g., inline JavaScript is disabled by default and must
be explicitly allowed in the Content Security Policy). CSP prevents a wide range
of attacks, including cross-site scripting and other cross-site injections.

Performance Monitor Rendering
Port

Specify the port for performance monitor rendering.
The default value is 80.

ICMPv6 Filters n When the ICMPv6 Filters parameter is set to Disable (the default),
ClearPass responds to all ICMPv6 (Internet Control Message Protocol)
traffic.

n When this parameter is set to Enable, the following restrictions are
applicable:

l ClearPass does not respond to ICMPv6 traffic sent to an anycast or
multicast address.

l ClearPass does not transmit to ICMPv6 type-3 (Destination
Unreachable) messages.

Multi Master Cache Durability For the Multi-Master Cache to survive abrupt shutdowns, set this to Normal or
Full. The default value is OFF.
NOTE: Enabling this feature might result in some performance degradation.

Post-Auth v2 When Post-Auth v2 is enabled, it improves ClearPass performance and
scaling for post-authentication events when interoperating with third-party
systems.
To enable Post-Auth v2:

1. Set the Post-Auth v2 setting to Enabled.
When you either enable or disable Post-Auth v2, you must also manually
restart the Async Network service:
2. Navigate to Administration > Server Manager > Server
Configuration and select the appropriate ClearPass server.
3. Select the Services Control tab.
4. On the Async Network Services row, click Stop, then click Start.

The following Post-Auth v2 restrictions apply:
n Post-Auth v2 does not support ClearPass Proxy.
n IPv6 IP addressing is note supported.
n When defining a context server action, the following HTTP methods are

supported: PATCH, DELETE, POST, GET, and PUT.
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Cleanup Intervals Parameters
The following figure displays the Cluster-Wide Parameters > Cleanup Intervals dialog:

Figure 550 Cluster-Wide Parameters > Cleanup Intervals Dialog

1. Specify the Cluster-Wide Parameters > Cleanup Intervals parameters as described in the following
table:

Parameter Action/Description

Cleanup interval for
Session log details in the
database

Specify the duration in number of days to keep the following data in the Policy
Manager database:
n Session logs (found on the Monitoring > Live Monitoring > Access Tracker

page)
n Event logs (found on the Monitoring > Event Viewer page)
n Machine authentication cache
The default value is 7 days.

Cleanup interval for
information stored on the
disk

Specify the duration in number of days to keep log files that are written to the disk.
The default value is 7 days.

Old Audit Records cleanup
interval

Specify the cleanup interval in number of days that ClearPass uses to determine
when to start deleting old audit records from the Audit Viewer page. The default
value is 7 days.

Known endpoints cleanup
interval

Specify the duration in number of days that ClearPass uses to determine when to
start deleting known or disabled entries from the Endpoint repository.
Known entries are deleted based on the last Added At value for each Endpoint. For
example, if this value is 7, then known Endpoints that do not have the Added At
value within the last 7 days are deleted.
The default value is 0 days. This indicates that no cleanup interval is specified.

Unknown endpoints
cleanup interval

Specify the duration in number of days that ClearPass uses to determine when to
start deleting unknown entries from the Endpoint repository.
Unknown entries are deleted based on the last Updated At value for each Endpoint.
For example, if this value is 7, then unknown endpoints that do not have the
Updated At value within the last 7 days (stale endpoints) are deleted.

Table 2: Cluster-Wide Parameters > Cleanup Intervals Parameters
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Parameter Action/Description

The default value is 0 days. This indicates that no cleanup interval is specified.

Expired guest accounts
cleanup interval

Specify the cleanup interval for expired guest accounts.
This indicates the number of days after expiry that the cleanup occurs.
A value of 0 specifies no expired guest accounts cleanup interval. The default value
is 365 days.

Profiled Unknown
endpoints cleanup interval

Specify the cleanup interval in number of days that ClearPass uses to determine
when to start deleting profiled unknown entries from the Endpoint repository.
Profiled unknown entries are deleted based on their last Updated At value for each
endpoint.
For example, if this value is 7, then the Profiled Unknown Endpoints that do not have
an Updated At value within the last 7 days are deleted.
The default value is 0.

Profiled Known endpoints
cleanup option

Specify whether to enable the option to clean up profiled known endpoints.
The default value is FALSE.

Static IP endpoints cleanup
option

Specify whether to enable the option to clean up static IP endpoints.
The default option is FALSE.

Notifications Parameters
The following figure displays the Cluster-Wide Parameters > Notifications dialog:

Figure 551 Cluster-Wide Parameters > Notifications Dialog
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1. Specify the Cluster-Wide Parameters > Notifications parameters as described in the following table:

Parameter Action/Description

System Alert Level Specify the alert notifications that are generated for system events logged at this level
or higher.
n INFO: Alerts that provide Information, Warnings, and Error messages are

generated.
n WARN: Alerts that provide Warnings and Error messages are generated.
n ERROR: Alerts that provide Error messages only are generated.
n The default value is WARN.

Alert Notification
Timeout

Specify the timeout in hours that determines how often alert messages are generated
and distributed.
If you select Disabled, alert generation is disabled. The default value is 2 hours.

Alert Notification -
eMail Address

Enter a comma-separated list of email addresses to which alert messages are sent.

Alert Notification - SMS
Address

Enter a comma-separated list of phone numbers to which alert messages are sent.

Table 3: Cluster-Wide Parameters > Notifications Parameters

Standby Publisher Parameters

The Standby Publisher is the Publisher node in the cluster that is configured to come up in the event that the
Publisher node goes down.

The following figure displays the Cluster-Wide Parameters > Standby Publisher dialog:

Figure 552 Cluster-Wide Parameters > Standby Publisher Dialog
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1. Specify the Cluster-Wide Parameters > Standby Publisher parameters as described in the following
table:

Parameter Action/Description

Enable Publisher
Failover

To authorize a node in a cluster on the system to act as a publisher if the primary
publisher fails, select TRUE. The default value is FALSE.
NOTE: The standby publisher value should be set to false before starting a cluster update
to avoid false failover triggers.

Designated Standby
Publisher

Select the server in the cluster to act as the standby publisher.
The default value is 0.
NOTE: If the Standby Publisher is on a different subnet from the Publisher, then ensure
that a reliable connection between the two subnets is available to avoid unwanted network
segmentation and potential data loss from a false failover.

Failover Wait Time Specify the time (in minutes) for which the secondary node must wait before it acquires a
virtual IP address after the primary node fails.
The default failover wait time is 10 minutes.
This prevents the secondary node from taking over when the primary node is temporarily
unavailable during a restart.

Table 4: Cluster-Wide Parameters > Standby Publisher Parameters

Virtual IP Parameter
The following figure displays the Cluster-Wide Parameters > Virtual IP dialog:

Figure 553 Cluster-Wide Parameters > Virtual IP Dialog

1. Specify the Cluster-Wide Parameters > Virtual IP parameter as described in the following table:

Parameter Action/Description

Failover
Wait Time

Enter the number of seconds for the secondary node to wait after primary node failure before it
acquires the virtual IP address.
The default fail-over wait time is 10 seconds, in order for the secondary node to take over and
respond quickly to authentication access requests.

Table 5: Cluster-Wide Parameters > Virtual IP Configuration Parameter

You can define a virtual IP address with a primary server only (that is, without a secondary server) if required. This
can be used to add an additional IP address to the ClearPass Policy Manager server without introducing redundancy.
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Common Criteria Mode Parameter
The Mode tab in the Cluster-Wide Parameters page allows you to enable or disable Common Criteria
Mode.

Figure 554 Cluster-Wide Parameters Page > Common Criteria Mode Parameter

1. Specify the Cluster-Wide Parameters > Mode parameter as described in the following table:

Parameter Action/Description

Common
Criteria
Mode

Common Criteria Mode is for specific deployments that require strict compliance to Common
Criteria requirements.
To enable or disable Common Criteria Mode, select TRUE or FALSE. The default is FALSE.
When you set Common Criteria Mode to TRUE, the following Warning message is displayed:
WARNING: Setting this value to TRUE enables strict validation of Certificates and changes to
modules in order to comply with Common Criteria requirements.

Table 6: Cluster-Wide Parameters > Mode Parameter

Common Criteria Mode

Use Common Criteria Mode for deployments that require strict compliance to Common Criteria requirements.
Common Criteria is an international standard for security certification.

Common Criteria Mode has the following restrictions and requirements:

n Common Criteria Mode requires that all the ClearPass servers in the cluster must have FIPS mode enabled
(see FIPS Page ).

n Server certificates must be updated before you enable Common Criteria Mode (see Certificate Store).

n Only Certificate Authority (CA)-issued certificates can be used for ClearPass server certificates.

n No self-signed certificates are allowed as trusted certificates.

n All X.509 v3 trusted Certicate Authority (CA) certificates must satisfy the basic constraints.

X.509 is an important standard for a public key infrastructure to manage digital certificates and public-key
encryption. X.509 is a key part of the Transport Layer Security protocol used to secure web and email
communication.

n All HTTPS communication to external services using X.509 v3 certificates must pass the basic constraint
checks.
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Database Parameters
The following figure displays the Cluster-Wide Parameters > Database dialog:

Figure 555 Cluster-Wide Parameters > Database Dialog

1. Configure the Cluster-Wide Parameters > Database parameters as described in the following table:

Parameter Action/Description

Auto backup configuration
options

Select any of the following auto-backup configuration options:
n Off: Select this to not to perform periodic backups.
n Select Off before upgrading ClearPass Policy Manager to avoid the interference

between Auto backup and migration process.
n Config: Perform a periodic backup of the configuration database only. This is the

default auto backup configuration option.
n Config|SessionInfo: Perform a backup of the configuration database and the

session log database.
NOTE: It is recommended that you set this option to Off or Config before starting an
upgrade. This ensures the Auto Backup process does not interfere with migration
post upgrade. If required, you can change this setting back to Config|SessionInfo 24
hours after upgrade completion.

Database user
"appexternal" password

Enter the password for the appexternal username for this connection to the
database.

Replication Batch Interval Configure the time interval (in seconds) at which the subscribers synchronize with
the Publisher.
The default value is 5 seconds. The allowed range is 1 to 60 seconds.

Store Password Hash for
MSCHAP authentication

To store passwords for admin and local users to Hash and NTLM hash formats
(which enables RADIUS MSCHAP authentications against admin or local
repositories), set this to TRUE.
If you set this to FALSE, RADIUS MSCHAP authentications are not possible because
the NTLM hash passwords are removed for all the users.
NOTE: When you set this value to TRUE, you must reset all the passwords to
reenable RADIUS MSCHAP authentication against the user repositories.

Store Local User Pass-
words using reversible
encryption

To enable cleartext password comparison against local users, set this to TRUE.
If you set this to FALSE, cleartext password comparison against local users is not
possible because the reversible passwords for local users are removed.
NOTE: After setting this value to TRUE, you must reset all the local user passwords
to reenable cleartext password comparison against local users.

Table 7: Cluster-Wide Parameters > Database Parameters
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Profiler Parameters
The following figure displays the Cluster-Wide Parameters > Profiler dialog:

Figure 556 Cluster-Wide Parameters > Profiler Dialog

1. Configure the Cluster-Wide Parameters > Profiler parameters as described in the following table:

Parameter Action/Description

Profiler Scan Ports To change the list of ports to scan and add custom fingerprints to classify
based on them, enter the new TCP port numbers.
The TCP ports scanner checks to see if the specified Profiler Scan Ports
are open. The default TCP ports are 135 and 3389.

Process wired device information
from IF-MAP interface

Choose whether to process wired device information from the IF-MAP
interface.
The default is FALSE.

Enable Endpoint Port Scans using
Nmap

Set this option to TRUE to enable Endpoint scans using Nmap (Network
Mapper).
NOTE: The Open Ports scanner is disabled when Nmap-based port
scanning is enabled.
When Nmap scan is enabled, the following warning is displayed:
WARNING: Setting this value to TRUE enables active scan of the host for
open ports. This can be resource intensive. Also, the Profiler Scan Ports
value is ignored when Nmap scan is enabled.

Enable Endpoint Port Scans using
WMI

Set this option to TRUE to enable Endpoint scans using WMI (Windows
Management Instrumentation).

Enable NTLMv1 for WMI scans Set this parameter to TRUE to enable NT LAN Manager v1 for WMI
(Windows Management Instrumentation) scans. The default is FALSE.

For more information, see WMI Credentials Configuration.

Netflow/sFlow Reprofile Interval Specify the interval after which endpoints will be reprofiled. The default
value is 24 hours. The minimum value is one hour.
For more information about the Netflow and sFlow collectors, see
Endpoint Information Collectors on page 482.

Table 8: Cluster-Wide Parameters > Profiler Tab Parameters
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TACACS Parameters
The following figure displays the Cluster-Wide Parameters > TACACS dialog:

Figure 557 Cluster-Wide Parameters > TACACS Dialog

1. Configure the Cluster-Wide Parameters > TACACS parameters as described in the following table:

Parameter Action/Description

Disable Change
Password for TACACS

When logging in for TACACS+ user authentication:
n If set to FALSE (the default setting), after entering a blank password, you are

presented with an option to change the TACACS+ user password.
n If set to TRUE, the option to enter the TACACS+ user password is displayed. The

option to change the TACACS+ password is not displayed.

TACACS User Prompt
Text

You can modify the text to be used for the TACACS+ username prompt as needed. The
default TACACS username prompt is as follows:

UserName:

TACACS Password
Prompt Text

You can modify the text to be used for the TACACS+ password prompt as needed. The
default TACACS password prompt is as follows:

Password:

TACACS Connection Idle
Timeout

An idle TACACS+ login session is one in which the CLI operational mode prompt is
displayed but there is no input from the keyboard. To close idle sessions automatically,
you must configure a time limit for each login class.
Specify the TACACS Connection Idle Timeout duration in seconds as needed.
n The default value is 900 seconds (15 minutes).
n The minimum allowed value is 60 seconds.
n The maximum allowed value is 172800 seconds (two days).

Admin UI Login Remote
TACACS Server IP

This option is used if you want the ClearPass server to authenticate against a TACACS+
server. In this case, the ClearPass server is acting as a TACACS+ client and talking to
the TACACS+ server in order to authenticate users.
Specify the IP address for the remote TACACS+ server.

Admin UI Remote
TACACS Server Shared
Secret

This option is used if you want the ClearPass server to authenticate against a TACACS+
server.
Enter the Shared Secret for the remote TACACS+ server.

Table 9: Cluster-Wide Parameters > TACACS Parameters
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Synchronizing the Cluster Date and Time with the NTP Server
n Restarting ClearPass Services

n Specifying the Time Zone on the Publisher Node

To synchronize the date and time on the nodes in a cluster with an NTP (Network Time Protocol) server:

The option to change the date and time for the ClearPass cluster is available only on the Publisher node. Subscriber
nodes in a cluster will synchronize the date and time from the Publisher node.

1. Log in to the Publisher node.

2. Navigate to the Administration > Server Manager > Server Configuration page.

3. Select the Set Date and Time link.

The Change Date and Time dialog opens to the Date & Time tab.

Figure 558 Change Date and Time > Date & Time Tab

4. Specify the Date & Time parameters as described in the following table, then click Save:
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Parameter Action/Description

Synchronize time with NTP
server

To synchronize with a Network Time Protocol (NTP) server, enable this check
box (enabled by default).
Manually Setting the Date and Time
NOTE: You can also specify the date and time for the cluster manually by
disabling the Synchronize time with NTP server check box and entering the
current date and time in the dialog provided:

Primary Server and Secondary Server

NTP Server Specify the IP address or host name for the Primary NTP server and the
Secondary NTP server. The IP address can be an IPv4 or IPv6 address.

Key Value The Key Value is a form of shared secret, which both the client and the
ClearPass server use for authenticating NTP messages.
The Key Value can be:
n Up to 20-character printable ASCII string
n Up to 40-character hex value
When entering an ASCII string for the Key Value, note that it cannot contain
the following characters:
n & (ampersand)
n ; (semicolon)
n ` (grave accent)
n | (pipe)
n < (left angle bracket)
n > (right angle bracket)
n ( (left parenthesis)
n ) (right parenthesis)
The Key Value ASCII string must start and end with one of the following
characters:
n - (hyphen)
n ' (apostrophe)
n " (quotation mark)

Algorithm Select one of the following encryption types:
n SHA
n SHA1
NOTE: In FIPS mode, only the SHA1 hashing algorithm is supported.

Table 1: Changing Date and Time Parameters
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Restarting ClearPass Services
Once you have saved the Date & Time configuration, you must restart ClearPass Policy Manager services.

The Audit Viewer (Monitoring > Audit Viewer) tracks NTP configuration changes.

To restart Policy Manager services:

1. Navigate to Administration > Server Manager > Server Configuration.

2. Select the ClearPass Publisher node.

3. From the Server Configuration page, select the Services Control tab.

Figure 559 Restarting Stopped Services

4. From the Action column, click Start for each service that needs to be restarted.

For each restarted service, the Start button is changed to Stop.

Specifying the Time Zone on the Publisher Node
To specify the time zone on the Publisher node:

1. Click the Time Zone on Publisher tab.

Figure 560 Time Zone on Publisher Dialog

The time zones are listed in alphabetical order.

2. Select the time zone where the Publisher node resides, then click Save.
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This option is available only on the Publisher. To set the time zone on a Subscriber node, select the specific server
and set the time zone from the server-specific page.

Changing the Cluster-Wide Password
To change the cluster-wide password:

1. Navigate to Administration > Server Manager > Server Configuration.

The Server Configuration page opens.

2. Click the Change Cluster Password link.

The Change Cluster Password dialog opens.

Figure 561 Change Cluster Password Dialog

3. Enter the new cluster password, then verify the password.

4. Click Save.

Changing this password changes the password for the CLI user appadmin as well.

Managing Policy Manager Zones

This section provides the following information:

n About Policy Manager Zones

n Adding Policy Manager Zones

n Mapping Policy Manager Zones to OnGuard Clients

About Policy Manager Zones
ClearPass Policy Manager shares a distributed cache of run-time states across all nodes in a cluster. These run-
time states include:

n Roles and postures of connected entities

n Connection status of all endpoints running OnGuard

n Endpoint details gathered by OnGuard Agent

ClearPass Policy Manager uses this run-time state information to make policy decisions across multiple
transactions.

In a deployment where a cluster spans WAN boundaries and multiple geographic zones, it is not necessary to
share all of this run-time state across all nodes in the cluster.
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For example, when endpoints present in one geographical area are not likely to authenticate or be present in
another area, it is more efficient from a network bandwidth usage and processing perspective to restrict the
sharing of such run-time state to a given geographical area.

You can configure zones in ClearPass Policy Manager to match with the geographical areas in your deployment.
There can be multiple zones per cluster, and each zone has a number of ClearPass Policy Manager nodes that
share their run-time state.

Adding Policy Manager Zones
To add a Policy Manager Zone:

1. Navigate to the Administration > Server Manager > Server Configuration page.

2. Click the Manage Policy Manager Zones link.

The Policy Manager Zones dialog opens:

Figure 562 Policy Manager Zones Dialog

3. To add a new Policy Manager Zone, click Click to add... and enter the name of the Policy Manager Zone to
be added.

4. Be sure to click the Save icon, then click Save.

5. To delete a zone, click the trash can icon ( ).

Mapping Policy Manager Zones to OnGuard Clients
To configure the Policy Manager Zone you created:

1. Navigate to Administration > Agents and Software Updates > OnGuard Settings.

The OnGuard Settings page opens.

2. Click the Policy Manager Zones link.

The Mappings for Policy Manager Zones to OnGuard Clients page opens.
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Figure 563 Mappings for Policy Manager Zones to OnGuard Clients Page

3. Specify the Mappings for Policy Manager Zones to OnGuard Clients parameters as described in the
following table:

Parameter Action/Description

Policy Manager Zone Select the Policy Manager Zone from the drop-down list.
If no Policy Manager zone is configured, the default Policy Manager zone is displayed
in this field.

Client Subnets Displays the client subnet addresses specified for the selected Policy Manager zone.

Server IPs Displays the server IP addresses specific to the selected Policy Manager zone.

Zone Network Details

Policy Manager Zone Select the Policy Manager zone from the drop-down list that is created from the
Administration > Server Manager > Server Configuration > Manage Policy
Manager Zones page.

Client Subnets Specify the client subnets that are configured for the selected zone.

Default ClearPass Server
IPs

Specify the IP address of the default ClearPass server.

Override Server IPs Optionally, specify the IP addresses or the Fully Qualified Domain Name (FQDN) to
which you want the OnGuard agent to send the request in the sequence.
You can specify the data port or load balancer IP address in this field.
The IP addresses configured here will override the IP address configured in the
Default ClearPass Server IPs field.
For example, if you have configured the IP addresses 10.17.XXX.1, 10.17.XXX.2, and
10.17.XXX.3, OnGuard agent will send the request in the same sequence.

Table 1: OnGuard Settings > Policy Manager Zones Parameters

4. Click Save.

The new Policy Manager Zone configuration settings are displayed.
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Configuring NetEvents Targets
NetEvents are a collection of information regarding various ClearPass Policy Manager users, endpoints, guests,
authentications, accounting details, and so on. This information is periodically posted to a server that is
configured as the NetEvents target.

If ClearPass Insight is enabled on a ClearPass Policy Manager server (see Enabling Insight and Specifying a
Master Insight Node), it will receive net events from all other server nodes within the same ClearPass cluster.

If you want to post these details to an external server that can aggregate these events or to an external
dedicated ClearPass Insight server for multiple ClearPass clusters, you have to configure an external NetEvents
Target.

To configure an external NetEvents Target:

1. Navigate to the Administration > Server Manager > Server Configuration page.

Figure 564 NetEvents Target Link on Server Configuration Page

2. Click the NetEvents Targets link.

The NetEvents Targets configuration dialog opens.

Figure 565 NetEvents Targets Configuration Dialog

3. Specify the NetEvents Targets parameters as described in the following table, then click Save:
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Parameter Action/Description

Target URL Enter the HTTP URL for the service that supports posting to the
NetEvents target and requires authentication using username and
password.
To specify an external Insight server, use the following Target URL:
https://<ClearPass-IP-address>netwatch/netevents

Username/Password Enter the ClearPass admin credentials configured for authentication
for the HTTP service that is provided in the Target URL.

Reset button Resets the values entered in this configuration dialog.

Delete button Deletes the specified Target URL.

Table 1: NetEvents Targets Parameters

Clearing Machine Authentication Cache
The Clear Machine Authentication Cache option clears the machine authentication cache from the local
node; this operation is synced during battery replication. On confirmation, machine authentication cache is
cleared from all nodes in the cluster.

Once the machine authentication cache is cleared, it takes up to 5 seconds to resync the cache.

To clear machine authentication cache on all the nodes in a cluster:

1. Navigate to the Administration > Server Manager > Server Configuration page.

The Server Configuration page opens:

Figure 566 Server Configuration Page > Clear Machine Authentication Cache

2. Click the Clear Machine Authentication Cache link.

The following prompt is displayed:

Are you sure you want to clear machine authentication cache?

3. To proceed with the operation, click Yes.

The following message appears:
Machine authentication cache cleared from all nodes

Configuring Virtual IP Settings
You can configure two nodes in a cluster to share a virtual IP address. The virtual IP address is bound to the
Primary node by default. The Secondary node takes over when the Primary node is unavailable.

In a virtual machine deployment of ClearPass Policy Manager, you must enable forged transmits on the VMWare
distributed virtual switch for the Virtual IP feature to be effective.
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To configure a virtual IP address:

1. Navigate to the Administration > Server Manager > Server Configuration page.

2. Click the Virtual IP Settings link.

By default, the Virtual IP Settings for IPv4 dialog opens:

Figure 567 Virtual IP Settings for IPv4

Figure 568 Virtual IP Settings for IPv6

3. Specify the Virtual IP Settings parameters as described in the following table, then click Save:

Parameter Action/Description

Select IP Version Select either the IPv4 or IPv6 addressing format.

Virtual IP Enter the IPv4 or IPv6 address you want to define as the virtual IP address.

Virtual Host ID To specify a unique virtual Host for this Virtual IP, enter the virtual router ID (1-255).

Primary Node Select the server to use as the primary node.
NOTE: When IPv6 is selected, the Primary Node and Secondary Node drop-down
lists are populated with the corresponding IPv6 addresses for selection.

Table 1: Virtual IPv4 and IPv6 Settings Parameters
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Parameter Action/Description

NOTE: To add an IPv6 address as a Virtual IP, it must be in the same subnet as the
Primary and Secondary nodes.

Secondary Node Select the server to use as the secondary node.

Interface When you select the primary node and the secondary node, the Interface field is
populated with that node's management interface IP address.
NOTE: If the Data/External port is configured, the Interface field is populated with both
the management interface IP address and the Data/External port IP address.

Subnet The Subnet value for the management interface IP address is automatically populated
when you select the primary node and secondary node.

Enabled The virtual IP settings configured here are enabled by default.

Making a Subscriber Node
In the Policy Manager cluster environment, the Publisher node acts as the master node. A Policy Manager
cluster can contain only one Publisher node. Administration, configuration, and database write operations can
occur only on the Publisher node.

The Policy Manager appliance defaults to a Publisher node unless it is made a Subscriber node. Cluster
commands can be used to change the state of the node, hence the Publisher can be made a Subscriber. When
it is a Subscriber, the Make Subscriber link is not displayed.

Note the following caveats when adding a Subscriber node:

n As part of this operation, configuration changes are blocked on the Publisher node during the initial cluster
sync process.

n All the application licenses on this server will be removed. To add and reactivate these application licenses,
contact Aruba Support—navigate to Administration > Support > Contact Support for contact
information.

To make a Publisher node a Subscriber node:

1. On a Publisher node, navigate to the Administration > Server Manager > Server Configuration page.

The Server Configuration page opens.

Figure 569 Make Subscriber Link

2. Click the Make Subscriber link.

The Add Subscriber Node page opens:
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Figure 570 Adding a Subscriber Node

3. Specify the Add Subscriber Node parameters as described in the following table, then click Save:

Parameter Action/Description

Publisher IP Enter the Publisher node's IP address.

Publisher Password Specify the Publisher node's password.
NOTE: The password specified here is the password for the CLI user
appadmin.

Restore the local log database after this
operation

To restore the log database after the Subscriber node has been
added, select the check box.

Do not backup the existing databases
before this operation

If you do not require a backup to the existing databases on this
node, select the check box.

Table 1: Add Subscriber Node Parameters

Dropping a Subscriber Node
To drop a Subscriber node from the cluster:

1. Navigate to the Administration > Server Manager > Server Configuration page.

2. Select the node you want to drop from the cluster.

3. Click the Drop Subscriber button.

This option is not available in a single-node deployment.

Collecting Logs
When you need to review performance or troubleshoot issues in detail, Policy Manager can compile and save
transactional and diagnostic data into several log files. These files are saved in Local Shared Folders and can be
downloaded to your computer (see Downloading Local Shared Folders).

To collect logs:

1. Navigate to Administration > Server Manager > Server Configuration.

The Server Configuration page opens.
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2. Click Collect Logs.

The Collect Logs dialog opens.

Figure 571 Collect Logs Dialog

3. Enter an output filename and add the .tar.gz extension to the filename.

4. Select the types of logging information you want to collect. The types of logging are:

l System Logs

l Logs from all Policy Manager services

l Capture network packets Duration of dump in seconds.

Use this option only when you want to debug a problem. System performance can be severely impacted.

l Diagnostic dumps from Policy Manager services

l Back up Policy Manager configuration data

5. Enter the time period for which you want to collect the information.

l Specify a number to collect logs for the number of days until the current day.

l To collect logs for the specified time period, select the Specify date range check box and enter a
start date and end date in yyyy-mm-dd format in the respective fields.

6. Click Start.

You'll see the progress of the information collection.

7. To finish, click Close
8. To save the log file to your computer, click Download File.

If you are attempting to open a capture file (.cap or .pcap) using WireShark, untar or unzip the file (based on the file
extension). When the entire file is extracted, navigate to the PacketCapture folder. In this folder, you will find a file
with a .cap extension. WireShark can be used to open this file and study the network traffic.
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Backing Up the Policy Manager Database
The backup file is automatically placed in the Shared Local Folder under folder type Backup Files (for details, see
Downloading Local Shared Folders).

Backup files are in the gzipped tar format (tar.gz extension).

To back up the Policy Manager database:

1. Navigate to the Administration > Server Manager > Server Configuration page.

2. Click the Back Up button.

The Back up Policy Manager Database dialog opens:

Figure 572 Backup Policy Manager Database Dialog

3. Specify the Back up Policy Manager Database parameters as described in the following table, then click
Start:

Parameter Action/Description

Generate file name To enable Policy Manager to generate a filename for the database backup,
select this check box.
This option is enabled by default.

File Name To manually specify the backup file name, clear the Generate file name
check box,, then enter the desired file name.

Back up ClearPass configuration
data

The option to back up Policy Manager configuration data is enabled by
default.

Back up ClearPass session log data To enable back up of Policy Manager session log data, select this check
box.

Back up Insight data To enable back up of ClearPass Insight data, select this check box.

Do not back up password fields in
configuration database

If you don't want to backup the password fields in the configuration
database, select this check box.

Table 1: Back up Policy Manager Database Parameters

Restoring Policy Manager Configuration Data
To restore the ClearPass Policy Manager configuration data:

1. Navigate to the Administration > Server Manager > Server Configuration page.

2. Click the Restore button.
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The Restore Policy Manager Database dialog opens:

Figure 573 Restore Policy Manager Database Dialog

3. Specify the Restore Policy Manager Database parameters as described in the following table, then click
Start:

Table 28: Restore Policy Manager Database Parameters

Parameter Action/Description

Restore file location Select either Upload file to server or File is on server.

Upload file path Browse to select name of backup file.
NOTE: This option is available only when the Upload file to server
option is selected.

Shared backup files present
on the server

If the files is on a server, select a file from the files in the local shared
folders. (See Downloading Local Shared Folders.)
NOTE: This is displayed only when the File on server option is
selected.

Restore CPPM configuration
data (if it exists in the
backup)

Select the check box to include an existing configuration data in the
restore.

Restore CPPM session log
data (if it exists in the
backup).

Select the check box to include the log data in the restore.

Restore Insight data (if it
exists in the backup)

Select the check box to include Insight reporting data in the restore.

Ignore version mismatch
and attempt data migration

Select the check box if you are migrating configuration and/or log data
from a backup file that was created with a previous compatible
version.

Restore cluster server/node
entries from backup.

Select the check box to include the cluster server/node entries in the
restore.

Do not backup the existing
databases before this
operation.

Select the check box if you do not want to backup the existing
databases before performing a restore.
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Performing a System Cleanup
You can perform a system cleanup operation to purge the following records:

n System and application log files

n Past authentication records

n Audit records

n Expired guest accounts

n Past auto and manual backups

n Endpoints

n Stored reports

To perform a system cleanup:

1. Navigate to the Administration > Server Manager > Server Configuration page.

2. Select the ClearPass server you wish to clean up.

3. Click the Cleanup button.

The Force Cleanup Files dialog opens.

Figure 574 Force Cleanup Files Dialog

4. Enter the number of days system files can remain before they are removed. The allowed range is 0 to 15
days.

5. To initiate the cleanup process, click Start.

The Force Cleanup Files status report opens:
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Figure 575 Force Cleanup Files Status Report

Shutting Down or Rebooting the Server

Shutting Down the Server
To shut down the current ClearPass server:

1. Navigate to the Administration > Server Manager > Server Configuration page .

2. Click the Shutdown button.

You receive the message:

Are you sure you want to shut down Policy Manager Server <IP_address>?

3. To proceed with the shut down operation, click Yes.

You receive the message:

Shut down of server initiated

The ClearPass server shuts down in an orderly manner.

4. To cancel the shut down operation, click Cancel.

Rebooting the Server
To reboot the current ClearPass server:

1. Navigate to the Administration > Server Manager > Server Configuration page .

2. Click the Reboot button.

You receive the message:

Are you sure you want to reboot Policy Manager Server <IP_address>?

3. To proceed with the reboot, click Yes.

4. To cancel the reboot operation, click Cancel.

Log Configuration
This section provides the following information:

n Service Log Configuration

n System Level Configuration
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Service Log Configuration

On the Service Log Configuration tab, you can specify the default log level for each service and its associated
modules.

To configure logs for services and system level:

1. Navigate to the Administration > Server Manager > Log Configuration page.

The Service Log Configuration page opens:

Figure 576 Log Configuration > Service Log Configuration Tab

2. Specify the Service Log Configuration parameters as described in the following table:

ClearPass 6.7 Policy Manager | User Guide Administration | 580
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1612



581 | Administration ClearPass 6.7 Policy Manager |  User Guide

Parameter Action/Description

Select Server From the Select Server drop-down, specify the server for which you want to configure
logs.
All nodes in the cluster appear in the drop-down list.

Select Service Specify the service for which you want to configure logs:
n Admin server
n AirGroup notification service
n Async network service
n ClearPass network services
n DB change notification server
n DB replication service
n Micros Fidelio FIAS
n Multi-master cache
n Policy server
n RadSec Service
NOTE: When you select the RadSec service and change the Log Level, it takes
approximately 8 seconds for the Radsec service to restart. Therefore, Aruba recommends
that you wait 8 to 10 seconds after you modify the Log Level before you collect logs
(Administration > Server Manager > Server Configuration > click the Collect Logs
button).
n Radius server
n Syslog client service
n Tacacs server

Module Log Level
Settings

Select the Module Log Level Settings check box to set the log level for each module
individually (listed in decreasing level of verbosity).
For optimal performance you must run Policy Manager with the log level set to ERROR or
FATAL. Available options include the following:
n DEBUG
n INFO
n WARN
n ERROR
n FATAL
If this option is disabled, then all module level logs are set to the default log level.

Default Log Level Specify the default logging level for all modules.
The Default Log Level drop-down list is available if the Module Log Level Settings
option is disabled. Available options include the following:
n DEBUG
n INFO
n WARN
n ERROR
n FATAL
NOTE: Set this option first, and then override any specific modules as necessary.

Restore
Defaults/Save

Click Save to save changes.
To restore the default settings, click Restore Defaults.

Table 1: Log Configuration > Service Log Configuration Parameters

System Level Configuration
On the System Level tab, you can specify the number and size of log files you need to maintain for each
service and the server to which they can be sent.

1. From the Log Configuration page, select the System Level tab.

The System Level page opens:
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Figure 577 Log Configuration > System Level Tab

2. Specify the System Level tab parameters as described in the following table:

Parameter Action/Description

Select Server Specify the server for which you want to configure logs.

Number of log files Specify the number of log files of a specific module to keep at any given time.
When a log file reaches the specified size (see Limit each log file size to), Policy
Manager rolls the log over to another file until the specified number of log files is reached.
Once the number of log files exceeds the specified value, Policy Manager overwrites the
oldest file.

Limit each log file
size to

Specify the size of each log file before the log rolls over to the next file.
The default value is 50 MB.

Syslog Settings

Syslog Server Specify the name of the syslog server.
Policy Manager sends the configured module logs to this syslog server.

Syslog Server Port Specify the syslog server port number.
The default is 514.

Enable Syslog To override the Syslog Filter Level for a service, select the Enable Syslog check box.

Syslog Filter Level If desired, change the Syslog Filter Level.
The current Syslog Filter level is based on the default log level specified on the Service
Log Configuration tab.

Restore
Defaults/Save

Click Save to save your changes.
To restore the default settings, click Restore Defaults.

Table 2: Log Configuration > System Level Parameters
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Downloading Local Shared Folders
The supported ClearPass folder types are:

n Backup files: Database backup files that are backed up manually.

n Log files: Log files backed up via the method described in Collecting Logs on page 574.

n Automated Backup files: Database backup files that are backed up automatically on a daily basis.

To download a local shared folder:

1. Navigate to Administration > Server Manager > Local Shared Folders.

The Local Shared Folders page opens.

2. Choose a folder type from the Select folder drop-down list.

The folders in the selected shared folder are displayed.

Figure 578 Local Shared Folders Page

3. Select the local shared folder you want to download.

The selected auto-backup file is downloaded to your system's Download folder.

License Management
This section describes the following topics:

n Activating the Platform License on a Cluster Node

n Updating a ClearPass Platform License

n Managing Application Licenses

n Adding an Application License

n Activating an Application License

n Updating an Application License

n Refreshing the License Usage Count

Activating the Platform License on a Cluster Node
The ClearPass Platform license provides the platform activation code that is installed on all the nodes in a
ClearPass cluster. You must have a ClearPass Platform license for every instance of the product.

You cannot have more than one ClearPass Platform license installed on a ClearPass node.
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The ClearPass Platform License is the base-level license. Each device has one ClearPass Platform License for the
physical hardware. Virtual devices have a ClearPass Platform License as well on a per-expected device level.

If the Publisher node is added to a cluster without first activating its ClearPass Platform license, the license
activation should be done from the Publisher node.

When a Subscriber node is added to the cluster, it already has a ClearPass Platform license. It is not activated by
default. This ClearPass Platform license can be activated or not.

n If not activated, the red Activate button is shown in the Administration > Licensing > Servers tab.

n If the ClearPass Platform license is already activated, it is shown with a green Activated button.

To activate the Platform license on a Publisher or Subscriber node:

1. Navigate to Administration > Server Manager > Licensing.

The Licensing page opens to the License Summary page.

2. Select the Servers tab.

The ClearPass Platform license for this ClearPass node is listed. The Activation Status column shows a red
circle next to the keyword Activate.

Figure 579 ClearPass Platform License Ready to Be Activated

3. Click Activate.

The Activate License page opens.

Figure 580 Activate License Page

4. In the Online Activation section, click Activate Now.

The ClearPass Platform license is now activated. The Servers tab > Activation Status column shows a
green circle next to the keyword Activated.
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Figure 581 ClearPass Platform License Activated

Offline Activation: Creating a Case to Receive the Activation Key
If you are not connected to the Internet, you must submit a case through the HP Enterprise My Networking
portal:

1. In the Offline Activation section, click Download to download an activation request token from the
Policy Manager server.

2. Go to the My Networking Portal and log in.

3. Click the Support link.

4. Click Open/View Case.

This will show all the cases you have submitted to Support.

5. Click Open a New Case.

The Case Submission form is displayed.

6. In the Case Submission > Problem Details section, complete all the fields in the Case Submission form as
shown in Figure 582.

Figure 582 My Networking > Case Submission Form

7. To attach the activation token from ClearPass, click Browse and select the activation request token.

8. Click Create a case.
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Figure 583 Create a Case Button

9. The Support team will activate the token and send you the activation key.

10.Click Browse to locate the activation key file on your system, then click Upload.

Updating a ClearPass Platform License
ClearPass Platform licenses are permanent and do not have an expiry date.

An Evaluation ClearPass Platform License does have an expiry date, after which it must be updated with a
permanent Platform license.

In the event that an incorrect Platform license key is entered when activating the license, the ClearPass
Platform license would have to be updated.

To update the ClearPass Platform license:

1. Navigate to Administration > Server Manager > Licensing.

The Licensing page opens to the License Summary page.

2. Select the Servers tab.

The ClearPass Platform license for this ClearPass node is listed.

Figure 584 ClearPass Platform License to Be Updated

3. Click Activated.

The Update License page opens.
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Figure 585 Update License Page

4. Click Update.

The ClearPass Platform license is now updated.

Managing Application Licenses
n Viewing Existing Application Licenses

n Viewing Application License Details

n Viewing Platform License Information

n Notifications of Application License Usage Exceeded

n Application License Types

n Subscription License Expiry

n License Behavior in a Cluster

Viewing Existing Application Licenses
ClearPass licensing computation is solely based on number of endpoints that successfully connect to the
network over a period of time. The Licensing page shows all the licenses that are installed for the ClearPass
Policy Manager cluster. There is one entry per server node in the cluster. The License Summary page displays
the number and type of purchased licenses, as well as the total license count and the number of licenses being
used.

To view the Application licenses that are currently installed for the cluster:

1. Navigate to Administration > Server Manager > Licensing. The Licensing page opens to the License
Summary page.

Figure 586 Application License Summary
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From the Licensing page, you can:

n Add new Application licenses (see Adding an Application License).

n Refresh the license usage count (see Refreshing the License Usage Count).

Viewing Application License Details

The Licensing > Applications page displays the ClearPass Policy Manager application license details such as
product type (Access, OnGuard, orOnboard), license type (Permanent, Subscription, or Evaluation), number of
endpoints, license duration, license activation status, and the date the application license was added.

The Applications tab is activated on adding an application license (Access, OnGuard, or Onboard).

Figure 587 Applications License Details

Viewing Platform License Information

The Licensing > Servers page displays the information for the ClearPass Platform license, including the server
IP address, the product (ClearPass Platform), license type (Permanent), current duration, license activation
status, and the date the Platform license was added.

Figure 588 Platform License Information

Notifications of Application License Usage Exceeded

License usage is calculated every 15 minutes. When Application license usage is exceeded, ClearPass sends
notifications that are displayed in the ClearPassDashboard and Event Viewer.

When the license limit for an Application license (Access, OnGuard, or Onboard) has been exceeded, the
information banner on the Dashboard page is updated with a license usage exceeded message. The message is
removed as soon as license usage falls within the allowed number.

License usage exceeded messages are also posted to the Event Viewer every 15 minutes for each ClearPass
application that exceeds its license limit. The Event Viewer displays the number of licenses purchased and the
current usage by application. When the appliance falls within the allowed usage, the Event Viewer displays a
message to that effect. No banner messages are posted to the Dashboard for CLABV (evaluation) systems or
for systems running in Evaluation mode or with Evaluation licenses. For CLABV systems or for applications
running under an Evaluation license, messages are posted to the Event Viewer once each night at 11:55 P.M.
local time.

Application License Types

ClearPass Policy Manager supports the following Application license types:
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Access License

The Access license accounts for authentications on the system. Guest functionality is embedded in Access
licenses.

Without an Access license, ClearPass user interface administration access and cluster operations are allowed.
However, the following service operations are disallowed: creation, copy, modification, deletion, and import.

ClearPass endpoints consume Access licenses based on active session counts. The active session is defined as a
duration between:

n RADIUS accounting Start and Stop

On a ClearPass system with a valid Access license, TACACS+ sessions are not counted towards Access license
consumption.

n OnConnect SNMP MAC address learned and MAC address removed or aged

If the session can't be identified (due to a lack of accounting), the Access license is consumed based on the MAC
address for 24 hours.

The Access license enables various authentication types: 802.1X, MAB, WebAuth, Oauth2, TACACS+, Guest,
etc.).

The Profiler feature is available after installing an Access license.

WebAuth (non-OnConnect), OAuth2, AppAuth, and API requests are not counted towards Access license
consumption.

Regarding Unactivated Access License Expiration

When an Access License that was not activated expires, service creation on that ClearPass server is blocked. For
this reason, Aruba recommends that if multiple Access Licenses are installed, activate them as soon as they are
installed. This ensures that even if one activated Access License is expired, service configuration will be allowed
if the other Access Licenses have not yet reached their expiration dates.

If ClearPass service creation has been blocked due to an Access License that was allowed to expire while it was
not activated, do the following:

1. Activate the expired license.

2. Verify whether the other Access Licenses are still within their valid date range.

3. Activate any other Access Licenses that have expired.

OnGuard License

The OnGuard license is responsible for all the activities related to ClearPass OnGuard. The OnGuard license is
consumed for all OnGuard deployments (Persistent and Dissolvable) and any mode of operation
(Authentication with Health Checks, Health Check only, Authentication only). The OnGuard license is consumed
on a device basis for a period of 24 hours.

Onboard License

ClearPass Onboard allows for the self-provisioning of users devices for a secure network, where the user
performs the work flow on his or her own. Onboard generates a unique device certificate and pushes the
certificate to the user's device, while also performing network configuration.The Onboard license is computed
based on the user for the lifetime of certificates.
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Manually created devices, certificates, and certificates provisioned through the ClearPass Simple Certificate
Enrollment Protocol (SCEP) service for Mobile Device Management systems are also counted towards the
Onboard license based on the provisioned user.Devices that received their certificates via Certificates
Authorities other than ClearPass, such as Microsoft Enterprise PKI, and not enrolled through ClearPass do not
use Onboard licenses.Onboard licenses are returned to the pool when they expire, or are revoked or deleted.

Subscription License Expiry

Access licenses are issued as Permanent or Subscription types. Subscription licenses can be valid for one, three,
or five years. Subscription licenses expire after the specified subscription period. When a Subscription license
expires, ClearPass continues to operate normally. However, ClearPass configuration changes cannot be made
and updates and upgrades are not operable.

License Behavior in a Cluster

The notable aspects of licensing behavior in a ClearPass cluster are as follows:

n All ClearPass license operations are performed on the Publisher node. All license computations are made at
the cluster level.

n When a node becomes part of the cluster, the new Subscriber node loses all of its licenses except for the
ClearPass Platform License.

n Any Application licenses (Access, Onboard, OnGuard) that were present on the ClearPass server prior to
becoming a Subscriber node must be added again to the Publisher.

n When a node is dropped from the cluster, all its licenses are removed except for its ClearPass Platform
License.

n When a Subscriber node is manually promoted to Publisher status, all the application licenses must be
reactivated.

n When a Subscriber node is automatically promoted to Publisher status, there are no changes to the
activation status of its licenses.

Adding an Application License
To add an application license:

1. Navigate to Administration > Server Manager > Licensing.

The Licensing page opens.

2. Click the Add License link.

The Add License page opens.
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Figure 589 Add License Page

l

3. Specify the Add License parameters as described in the following table:

Parameter Action/Description

Product Choose a ClearPass application license to be installed on the Publisher node in a ClearPass
cluster.
n Access
NOTE: Guest functionality is included in Access licenses.
n OnGuard
n Onboard
You can install multiple instances of each application license.

License Key Enter the license key for the selected application.

Terms and
Conditions

Click the I agree to the above terms and conditions check box.

Table 1: Add License Parameters

The Add button is now enabled.

4. Click Add.

You return to the Licensing > License Summary page, where the new application license is now listed
and the following message is displayed:

<Application name> license added successfully.

When you add an application license, the Applications tab is enabled to allow you to activate the
application licenses.

Activating an Application License
n Online Activation

n Offline Activation: Creating a Case to Receive the Activation Key

After you add or update an application license, it must be activated. Adding or updating an application license
enables the Applications tab on the Licensing page.

Online Activation
To activate the application licenses on the current ClearPass server:
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1. Navigate to Administration > Server Manager > Licensing.

The Licensing page opens to the License Summary page.

2. Select the Applications tab.

The new application licenses are listed. The Activation Status column shows a red circle next to the
keyword Activate.

Figure 590 ClearPass Application Licenses Ready to Be Activated

3. Click Activate.

The Activate License page opens.

Figure 591 Activate License Page

4. In the Online Activation section, click Activate Now.

The selected application license is now activated. The Applications tab > Activation Status column shows
a green circle next to the keyword Activated.

Figure 592 Application License Activated
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Offline Activation: Creating a Case to Receive the Activation Key
If you are not connected to the Internet, you must submit a case through the HP Enterprise My Networking
portal:

1. In the Offline Activation section, click Download to download an activation request token from the
Policy Manager server.

2. Go to the My Networking Portal and log in.

3. Click the Support link.

4. Click Open/View Case.

This will show all the cases you have submitted to Support.

5. Click Open a New Case.

The Case Submission form is displayed.

6. In the Case Submission > Problem Details section, complete all the fields in the Case Submission form as
shown in Figure 593.

Figure 593 My Networking > Case Submission Form

7. To attach the activation token from ClearPass, click Browse and select the activation request token.

8. Click Create a case.
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Figure 594 Create a Case Button

9. The Support team will activate the token and send you the activation key.

10. To locate the activation key file on your system, click Browse, then click Upload.

Updating an Application License
Application licenses typically require updating after they expire, for example, after the evaluation license
expires, or when capacity exceeds its licensed amount of unique endpoints (devices) that can be authenticated.

To update an application license:

1. Navigate to Administration > Server Manager > Licensing.

The Licensing page opens.

Figure 595 Licensing Page

2. Select the Applications tab.

Figure 596 Licensing Applications Tab

3. Select the application license you need to update.

The Update License dialog opens.
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Figure 597 Update License Dialog

4. Enter the new license key.

5. Click the I agree to the above terms and conditions check box.

The Update button is now activated.

6. Click Update.

The selected application license is updated.

Refreshing the License Usage Count
To update the latest usage count of all licenses in the ClearPass cluster:

1. Navigate to Administration > Server Manager > Licensing.

The Licensing page opens.

Figure 598 Licensing Page

2. Click the Refresh Count link.

When you click Refresh Count, the license usage count is refreshed immediately. You then receive the
following confirmation:

License count refreshed successfully

External Servers
This section provides the following information:

n SNMP Trap Receivers

n Syslog Targets
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n Syslog Export Filters

n Messaging Setup

n Endpoint Context Servers

n File Backup Servers

SNMP Trap Receivers
This section provides the following information:

n SNMP Trap Receivers Main Page on page 596

n Adding an SNMP Trap Server on page 597

n Importing an SNMP Trap Server on page 598

n Exporting All SNMP Trap Servers on page 599

n Exporting an SNMP Trap Server on page 600

n Deleting an SNMP Trap Server on page 601

ClearPass Policy Manager sends SNMP traps that expose the following server information:

n System up-time: Provides information about how long the ClearPass server has been running.

n Network interface statistics [up/down]: Provides information about whether the network interface is
up or down.

n Process monitoring information: Checks for the processes that should be running, including maximum
and minimum number of allowed instances. Sends traps if there is a change in value of the maximum and
minimum numbers.

n Disk usage: Checks for disk space usage of a partition. The agent can check the amount of available disk
space and make sure it's above the set limit. The value can be in percentage as well. Sends traps if there is a
change in the value.

n CPU load information: Checks for unreasonable load average values. For example, if CPU load average for
one minute exceeds the configured value (in percentage), the ClearPass server sends a trap to the
configured destination.

n Memory usage: Reports the ClearPass server's memory usage.

SNMP Trap Receivers Main Page
To view a list of SNMP trap receivers configured on the ClearPass Policy Manager server, navigate to
Administration > External Servers > SNMP Trap Receivers.

The following figure displays the SNMP Trap Receivers page:

Figure 599 SNMP Trap Receivers Page

About the ClearPass SNMP Private MIB
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For information about the ClearPass SNMP Private MIB, see ClearPass SNMP Private MIB.

Adding an SNMP Trap Server

A trap is an SNMP message sent from one application to another (which is typically on a remote host).

For SNMP trap server configuration, ClearPass provides the Type parameter to specify whether the SNMP
notification is a standard Trap notification or an Inform notification (see Figure 600). An Inform notification
is an acknowledged SNMP trap.

When you send an Inform notification, ClearPass uses an SNMP Engine ID when sending the message. The
Engine ID is a unique identifier for the SNMP v3 agent. The engine ID is used with a hashing function to
generate keys for authentication and encryption of SNMP v3 messages. The Engine ID is automatically
generated when you enable the stand-alone SNMP agent.

The default value for the SNMP Engine ID is 6620000004030662. This value can be changed in the Engine ID
field configured in the ClearPass Server Configuration > System Monitoring page (for details, see System
Monitoring Page).

To receive traps, the same Engine ID value must be configured on the trap receiver side.

To add an SNMP trap server:

1. Navigate to Administration > External Servers > SNMP Trap Receivers.

The SNMP Trap Receivers page opens.

2. Click the Add link.

The Add SNMP Trap Server dialog opens.

Figure 600 Add SNMP Trap Server Dialog

3. Specify the Add SNMP Trap Server parameters as described in the following table, then click Save:
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Parameter Action/Description

Host Address Enter the trap destination hostname or IP address.
NOTE: This server must have an SNMP trap receiver or trap viewer installed.

Description Enter a short description of the SNMP trap server.

SNMP Version Select one of the following SNMP versions:
l SNMP v1 with community strings
l SNMP v2 with community strings
l SNMP v3 with no Authentication
l SNMP v3 with Authentication using MD5 and no Privacy
l SNMP v3 with Authentication using MD5 and with Privacy
l SNMP v3 with Authentication using SHA and no Privacy
l SNMP v3 with Authentication using SHA and with Privacy

NOTE: The MD5 authentication type is not supported when you use ClearPass Policy Manager in
FIPS mode.

Username Specify the Admin user name for SNMP operations.
NOTE: This parameter is available in SNMP v3 only.

Type From the Type drop-down, select the type of SNMP notification:
l Inform
l Trap

Authentication
Key

Specify the SNMP v3 with authentication option (SHA or MD5).
NOTE: The EAP-MD5 authentication type is not supported if you run ClearPass Policy Manager in
FIPS mode.
NOTE: Authentication Key is available in SNMP v3 only.

Privacy Key Specify the SNMP v3 with privacy option.
NOTE: This parameter is available in SNMP v3 only.

Privacy
Protocol

Choose one of the available privacy protocols:
l DES-CBC
l AES-128

NOTE: This parameter is available in SNMP v3 with Privacy only. Privacy allows for encryption of
SNMP v3 messages to ensure confidentiality of data.

Server Port Specify the port number for sending the traps. By default, the port number is 162.
NOTE: Configure the trap server firewall for traffic on this port.

Table 1: Add SNMP Trap Server Parameters

Importing an SNMP Trap Server
To import an SNMP trap server:

1. Navigate to Administration > External Servers > SNMP Trap Receivers.
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2. Click the Import link on the top right section of the page. Enter the details based on Table 1.

3. Click Import.

The following figure displays the Import from file pop-up:

Figure 601 Import from file Pop-up

The following table describes the Import from file parameters:

Parameter Description

Select File Browse to the SNMP Trap Server configuration file to be imported.

Enter secret for the file (if any) If the file was exported with a secret key for encryption, enter the
secret key here.

Table 1: Import from file Parameters

Exporting All SNMP Trap Servers
This link exports all configured SNMP Trap Receivers. To export all SNMP trap servers:

1. Navigate to Administration > External Servers > SNMP Trap Receivers.

2. Click the Export All link on the top right section of the page. Enter the details based on Table 1.

3. Click Export.

4. Enter the XML file name in the Save As dialog box.

5. Click Save.

Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1631



The following figure displays the Export to file pop-up:

Figure 602 Export to file Pop-up

The following table describes the Export to file parameters:

Parameter Description

Export file with password
protection

Choose Yes to export the file with password protection.

Secret Key Enter the secret key.

Verify Secret Re-enter the secret key.

Table 1: Export to file Parameters

Exporting an SNMP Trap Server
To export a single SNMP trap server:

1. Navigate to Administration > External Servers > SNMP Trap Receivers.

2. Select the Host Address from the list of check boxes and click Export. Enter the details based on Table 1.

3. Enter the name of the XML file in the Save As dialog.

4. Click Save.

The following figure displays the Export to file pop-up:

Figure 603 Export to file Pop-up
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The following table describes the Export to file parameters:

Parameter Description

Export file with password
protection

Choose Yes to export the file with password protection.

Secret Key Enter the secret key.

Verify Secret Re-enter the secret key.

Table 1: Export to file Parameters

Deleting an SNMP Trap Server
To delete a single SNMP trap server:

1. Navigate to Administration > External Servers > SNMP Trap Receivers.

2. Click the check box next to the Host Address entry and click Delete.

3. Click Yes.

Syslog Targets
ClearPass Policy Manager can export session data (see Live Monitoring: Access Tracker on page 102), audit
records (see Audit Viewer on page 148) and event records (see Event Viewer on page 151). You can send this
information to one or more syslog targets (servers).

Adding a Syslog Target
To add a syslog target:

1. Navigate to Administration > External Servers > Syslog Targets.

The Syslog Targets page opens.

Figure 604 Syslog Targets Page

2. Click the Add link.

The Add Syslog Target dialog opens:
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Figure 605 Add Syslog Target Dialog

3. Specify the Add Syslog Target parameters as described in the following table:

Table 29: Add Syslog Target Parameters

Parameter Action/Description

Host Address Enter the Syslog server hostname or IP address.
The IP address can be an IPv4 or IPv6 address.

Description Enter a short description of the Syslog server.

Protocol Select one of the following options:
n UDP: This option reduces overhead and latency.
n TCP: This option provides error checking and packet delivery validation.

Server Port The default port number is 514.
If necessary, change the server port number.

4. Click Save.

The new Syslog Target is now added to the list:

Figure 606 Syslog Target Added

Syslog Export Filters
This section describes the following topics:

n About Syslog Export Filters

n Syslog Export Filters Page on page 603

n Adding a Syslog Export Filter
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n Importing a Syslog Filter on page 611

n Exporting All Syslog Filter on page 612

n Exporting a Syslog Filter on page 613

n Deleting a Syslog Filter on page 614

About Syslog Export Filters
Policy Manager can export session data (see Live Monitoring: Access Tracker on page 102), audit records (see
Audit Viewer on page 148), and event records (see Event Viewer on page 151).

You configure syslog export filters to instruct Policy Manager where to send this information, and what kind of
information should be sent through data filters.

Syslog Export Filters Page
To configure syslog export filters:

1. Navigate to Administration > External Servers > Syslog Export Filters.

The Syslog Export Filters page opens.

Figure 607 Syslog Export Filters Page

The following table describes the Syslog Export Filters parameters:

Parameter Action/Description

Name Displays the name of the syslog export filter.

Description Displays the description of the syslog export filter.

Export Template Displays the name of the Export Template selected in the Add Syslog
Export Filter dialog (see Adding a Syslog Export Filter ).

Export Event Format Displays the Export Event Format Type selected in the Add Syslog Export
Filter dialog; for example, LEEF (Log Event Extended Format) and CEF
(Common Event Format).

Table 1: Syslog Export Filters Page Parameters
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Parameter Action/Description

Status n A red icon indicates that the syslog export filter is currently disabled. To
enable a disabled filter, click the red icon.

n A green icon indicates that the syslog export filter is currently enabled.
To disable an enabled filter, click the green icon.

Export To export a syslog export filter, select the check box for the appropriate
filter, then click Export.
The Export to file dialog opens. For more information, see Importing and
Exporting Information.

Delete To delete a syslog export filter, select the check box for the appropriate
filter, then click Delete.

Adding a Syslog Export Filter
You can use filters to select the data sent from the Log server to the Syslog server. First add a Syslog Filter as
described below. You can then export and apply the Syslog filters separately to different kinds of logs.

To add a syslog export filter:

1. Navigate to Administration > External Servers > Syslog Export Filters.

2. From the Syslog Export Filters page, click Add.

The Add Syslog Filters page opens to the General tab.

Figure 608 Add Syslog Export Filters Page > General Tab

The Filter and Columns tab shown in the figure above is only visible if you select Insight Logs or Session Logs as
the export template. For more information, see Filter and Columns Tab on page 608.

The following table describes the Add Syslog Export Filters > General tab parameters:
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Parameter Action/Description

Name Enter the name of the syslog export filter.

Description Enter the description that provides additional information about the syslog export filter
(recommended).

Export
Template

Select any one of the templates from the following options:
n Audit Records
n Insight Logs
n Session Logs
n System Events
NOTE: If you select Insight Logs or Session Logs, the Filter and Columns tab is enabled. For
more information, see Filter and Columns Tab on page 608.

Export
Event
Format
Type

Select any one of the export event formats from the following options:
n Standard: Select this event format type to send the event types in raw syslog format. This is the

default event format type.
n LEEF: Select this event format type to send the event types in Log Enhanced Event Format

(LEEF).
n CEF: Select this event format type to send the event types in Common Event Format (CEF).

In Syslog Targets, CEF-format field mappings map as many fields as possible for each template.
Each template has unique mappings to customstrings, devicecustomdates, and
devicecustomnumbers.
For sample event format types, see Export Event Format Types—Examples on page 605.

Syslog
Servers

Syslog servers define the receivers of syslog messages sent by servers in the ClearPass cluster.
n To add a ClearPass syslog server, select it from the Select to Add drop-down list.
n To add a new ClearPass syslog server, click the Add New Syslog Target link (for more

information, see Adding a Syslog Target on page 601).
n To view details about a syslog server, select the syslog server, then click View Details.
n To change details about a syslog server, select the syslog server, then click Modify. For more

information, see Adding a Syslog Target on page 601.
n To remove a syslog server (from receiving syslog messages), select the syslog server, then click

Remove.

ClearPass
Servers

You can designate syslog messages to be sent from exactly one server in the ClearPass cluster or
from all of them.
n To add a ClearPass server, select it from the Select to Add drop-down list.
n To remove the ClearPass server, select the ClearPass server, then click Remove.
NOTE: When no servers are listed, syslog messages are sent from all servers in the cluster.

Table 1: Add Syslog Export Filters > General Tab Parameters

Export Event Format Types—Examples
This section provides several examples of Standard, LEEF, and CEF event format types for the syslog export
filter templates.

Standard Event Format Type > Audit Events

The following example describes the Standard event format type for the Audit Events syslog export filter
template:
Mar 20 21:18:56 10.17.5.228 2017-01-19 21:19:50,118 10.17.5.228 Audit Logs 96 1 0
TimestampFormat=yyyy-MM-dd
HH:mm:ss,S,User=clusteradmin,Category=Endpoint,Action=ADD,EntityName=34a39527afc0,src=10.17.5.
228,Timestamp=Jan 19, 2017 21:18:54 IST
Mar 20 21:20:56 10.17.5.228 2017-01-19 21:21:50,111 10.17.5.228 Audit Logs 97 1 0
TimestampFormat=yyyy-MM-dd HH:mm:ss,S,User=admin,Category=Cluster-wide
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Parameter,Action=MODIFY,EntityName=Endpoint Context Servers polling
interval,src=10.17.5.228,Timestamp=Jan 19, 2017 21:20:22 IST
Mar 21 09:28:59 10.17.5.228 2017-01-20 09:29:54,3 10.17.5.228 Audit Logs 99 1 0
TimestampFormat=yyyy-MM-dd HH:mm:ss,S,User=admin,Category=Network
Device,Action=REMOVE,EntityName=1.1.1.1,src=10.17.5.228,Timestamp=Jan 20, 2017 09:29:13 IST

Standard Event Format Type > System Events

The following example describes the Standard event format type for the System Events syslog export filter
template:
Mar 21 16:46:29 10.17.5.228 2017-01-20 16:47:23,880 10.17.5.228 System Events 0 1 0
TimestampFormat=yyyy-MM-dd HH:mm:ss,S,Description=User: arubasupport\nClient IP Address:
10.20.23.178,Category=Logged in,Action=None,Level=INFO,src=10.17.5.228,Component=Support
Shell,Timestamp=Jan 20, 2015 16:45:59 IST
Mar 21 16:49:10 10.17.5.228 2017-01-20 16:50:05,210 10.17.5.228 System Events 1 1 0
TimestampFormat=yyyy-MM-dd HH:mm:ss,S,Description='Failed to start ClearPass Virtual IP
service',Category=start,Action=Failed,Level=WARN,src=10.17.5.228,Component=ClearPass Virtual
IP service,Timestamp=Jan 20, 2017 16:48:53 IST
2015-01-20 16:50:05,210 [pool-6-thread-1] [R:] DEBUG com.avenda.tips.syslog.Syslogger - 2017-
01-20 16:50:05,210 10.17.5.228 System Events 2 1 0 TimestampFormat=yyyy-MM-dd
HH:mm:ss,S,Description=Performed action stop on cpass-domain-server_
CPATS,Category=stop,Action=Success,Level=INFO,src=10.17.5.228,Component=cpass-domain-server_
CPATS,Timestamp=Jan 20, 2017 16:48:57 IST
2015-01-20 16:50:05,211 [pool-6-thread-1] [R:] DEBUG com.avenda.tips.syslog.Syslogger - 2017-
01-20 16:50:05,211 10.17.5.228 System Events 3 1 0 TimestampFormat=yyyy-MM-dd
HH:mm:ss,S,Description=Performed action start on cpass-domain-server_
CPATS,Category=start,Action=Success,Level=INFO,src=10.17.5.228,Component=cpass-domain-server_
CPATS,Timestamp=Jan 20, 2017 16:49:00 IST

Standard Event Format Type > Session Events

The following example describes the Standard event format type for the Session Events syslog export filter
template:
Mar 21 16:31:49 10.17.5.211 2015-01-20 16:32:41,552 10.17.5.211 Radius Session Logs 4 1 0
Common.NAS-IP-Address=10.17.4.7,RADIUS.Acct-Delay-Time=null,RADIUS.Acct-Framed-IP-
Address=null,RADIUS.Auth-Source=AD:win2008R2-64bit.bangalore.avendasys.com,RADIUS.Acct-
Timestamp=null,RADIUS.Acct-Authentic=null,RADIUS.Auth-Method=EAP-PEAP,EAP-
MSCHAPv2,Common.Host-MAC-Address=58a2b5d05ac9,RADIUS.Acct-Termination-Cause=null,RADIUS.Acct-
Service-Name=null,RADIUS.Acct-Session-Time=null,TimestampFormat=yyyy-MM-dd
HH:mm:ss,S,RADIUS.Acct-NAS-Port=null,Common.Username=test1,RADIUS.Acct-Session-
Id=null,RADIUS.Acct-Called-Station-Id=null,RADIUS.Acct-NAS-Port-
Type=null,src=10.17.5.211,RADIUS.Acct-NAS-IP-Address=null,Common.Service=Test Post
Authentication Rules,RADIUS.Acct-Input-Pkts=null,RADIUS.Acct-Status-Type=null,RADIUS.Acct-
Calling-Station-Id=null,Common.Request-Timestamp=2015-01-20 16:31:46+05:30,RADIUS.Acct-Output-
Pkts=null,RADIUS.Acct-Output-Octets=null,RADIUS.Acct-Username=null,RADIUS.Acct-Input-
Octets=null
Mar 21 16:31:49 10.17.5.211 2015-01-20 16:32:41,550 10.17.5.211 Radius Session Logs 3 2 0
Common.NAS-IP-Address=10.17.4.7,RADIUS.Acct-Delay-Time=0,RADIUS.Acct-Framed-IP-
Address=10.17.4.148,RADIUS.Auth-Source=AD:win2008R2-64bit.bangalore.avendasys.com,RADIUS.Acct-
Timestamp=2015-01-20 16:31:50+05:30,RADIUS.Acct-Authentic=RADIUS,RADIUS.Auth-Method=EAP-
PEAP,EAP-MSCHAPv2,Common.Host-MAC-Address=e0f8471a5450,RADIUS.Acct-Termination-
Cause=null,RADIUS.Acct-Service-Name=null,RADIUS.Acct-Session-Time=null,TimestampFormat=yyyy-
MM-dd HH:mm:ss,S,RADIUS.Acct-NAS-Port=0,Common.Username=test1,RADIUS.Acct-Session-
Id=test1E0F8471A5450-54BE336C,RADIUS.Acct-Called-Station-Id=000B8661CD70,RADIUS.Acct-NAS-Port-
Type=Wireless-802.11,src=10.17.5.211,RADIUS.Acct-NAS-IP-Address=10.17.4.7,Common.Service=Test
Post Authentication Rules,RADIUS.Acct-Input-Pkts=null,RADIUS.Acct-Status-
Type=Start,RADIUS.Acct-Calling-Station-Id=E0F8471A5450,Common.Request-Timestamp=2015-01-20
16:31:45+05:30,RADIUS.Acct-Output-Pkts=null
Mar 21 16:35:58 10.17.5.228 2015-01-20 16:36:52,346 10.17.5.228 Tacacs authetnications 2 1 0
TACACS.Request-Type=TACACS_AUTHORIZATION,TACACS.Enforcement-Profiles=[TACACS Super
Admin],TACACS.Acct-Flags=null,TACACS.Authen-Service=AUTHEN_SVC_NONE,TACACS.Acct-Session-
Id=null,TACACS.Remote-Address=10.20.23.178,Common.Request-Timestamp=2015-01-20
16:34:54.647+05:30,TimestampFormat=yyyy-MM-dd HH:mm:ss,S,TACACS.Authen-Action=,TACACS.Authen-
Method=AUTHEN_METH_TACACSPLUS,Common.Username=a,TACACS.Authen-Type=AUTHEN_TYPE_
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PAP,TACACS.Auth-Source=[Local User Repository],src=10.17.5.228,TACACS.Privilege-
Level=1,Common.Service=[Policy Manager Admin Network Login Service]
Mar 21 16:35:58 10.17.5.228 2017-01-20 16:36:52,346 10.17.5.228 Tacacs authetnications 3 1 0
TACACS.Request-Type=TACACS_AUTHENTICATION,TACACS.Enforcement-Profiles=[TACACS Super
Admin],TACACS.Acct-Flags=null,TACACS.Authen-Service=AUTHEN_SVC_NONE,TACACS.Acct-Session-
Id=null,TACACS.Remote-Address=10.20.23.178,Common.Request-Timestamp=2017-01-20
16:34:54.647+05:30,TimestampFormat=yyyy-MM-dd HH:mm:ss,S,TACACS.Authen-Action=AUTHEN_ACTION_
LOGIN,TACACS.Authen-Method=AUTHEN_METH_TACACSPLUS,Common.Username=a,TACACS.Authen-Type=AUTHEN_
TYPE_PAP,TACACS.Auth-Source=[Local User Repository],src=10.17.5.228,TACACS.Privilege-
Level=1,Common.Service=[Policy Manager Admin Network Login Service]

LEEF Event Format Type > Insight Logs

The following example describes the LEEF event format type for the Insight Logs syslog export filter
template:
Dec 03 2017 16:50:44.085 IST 10.17.4.208 LEEF:1.0|Aruba Networks|ClearPass|6.5.0.69058|0-1-
0|Auth.Username=host/Asif-Test-PC2 Auth.Authorization-Sources=null Auth.Login-
Status=216 Auth.Request-Timestamp=2017-12-03 16:48:41+05:30 Auth.Protocol=RADIUS
Auth.Source=null Auth.Enforcement-Profiles=[Allow Access Profile] Auth.NAS-
Port=null Auth.SSID=cppm-dot1x-test TimestampFormat=MMM dd yyyy HH:mm:ss.SSS z
Auth.NAS-Port-Type=19 Auth.Error-Code=216 Auth.Roles=null Auth.Service=Test Wireless
Auth.Host-MAC-Address=6817294b0636 Auth.Unhealthy=null Auth.NAS-IP-Address=10.17.4.7

src=10.17.4.208 Auth.CalledStationId=000B8661CD70 Auth.NAS-
Identifier=ClearPassLab3600

CEF Event Format Type > Insight Logs

The following example describes the CEF event format type for the Insight Logs syslog export filter template:
Dec 03 2017 16:31:28.861 IST 10.17.4.208 CEF:0|Aruba Networks|ClearPass|6.5.0.69058|0-1-
0|Insight Logs|0|Auth.Username=host/Asif-Test-PC2 Auth.Authorization-Sources=null Auth.Login-
Status=216 Auth.Request-Timestamp=2017-12-03 16:28:20+05:30 Auth.Protocol=RADIUS
Auth.Source=null Auth.Enforcement-Profiles=[Allow Access Profile] Auth.NAS-Port=null
Auth.SSID=cppm-dot1x-test TimestampFormat=MMM dd yyyy HH:mm:ss.SSS zzz Auth.NAS-Port-Type=19
Auth.Error-Code=216 Auth.Roles=null Auth.Service=Test Wireless Auth.Host-MAC-
Address=6817294b0636 Auth.Unhealthy=null Auth.NAS-IP-Address=10.17.4.7 src=10.17.4.208
Auth.CalledStationId=000B8661CD70 Auth.NAS-Identifier=ClearPassLab3600

CEF Event Format Type > Audit Logs

The following example describes the CEF event format type for the Audit Logs syslog export filter template:
Nov 19 2017 18:22:40.700 IST 10.17.4.221 CEF:0|Aruba Networks|ClearPass|6.5.0.68754|13-1-
0|Audit Records|5|cat=Role timeFormat=MMM dd yyyy HH:mm:ss.SSS zzz rt=Nov 19, 2014 18:21:13
IST src=Test Role 10 act=ADD usrName=admin

LEEF Event Format Type > Audit Logs

The following example describes the LEEF event format type for the Audit Logs syslog export filter template:
Nov 19 2017 14:31:10.422 IST 10.17.4.221 LEEF:1.0|Aruba Networks|ClearPass|6.5.0.68754|0-1-
0|cat=Syslog Export Data devTime=Nov 19, 2014 14:30:35 IST action=ADD src=Audit
Events - LEEF usrName=admin devTimeFormat=MMM dd yyyy HH:mm:ss.SSS z

LEEF Event Format Type > System Events

The following example describes the LEEF event format type for the System Events syslog export filter
template:
Dec 02 2017 20:38:40.901 IST 10.17.4.206 LEEF:1.0|Aruba Networks|ClearPass|6.5.0.68878|295-1-
0|cat=start devTime=Dec 02, 2014 20:38:12 IST level=WARN description='Failed
to start ClearPass Virtual IP service' action=Failed src=ClearPass Virtual IP service

devTimeFormat=MMM dd yyyy HH:mm:ss.SSS z
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CEF Event Format Type > Session Logs

The following example describes the CEF event format type for the Session Logs syslog export filter template:
Dec 01 2017 15:28:40.540 IST 10.17.4.206 CEF:0Aruba Networks|ClearPass|6.5.0.68878|1604-1-
0|Session Logs|0|RADIUS.Acct-Calling-Station-Id=00:32:b6:2c:28:95 RADIUS.Acct-Framed-IP-
Address=192.167.230.129 RADIUS.Auth-Source=AD:10.17.4.130 RADIUS.Acct-Timestamp=2014-12-01
15:26:43+05:30 RADIUS.Auth-Method=PAP RADIUS.Acct-Service-Name=Authenticate-Only RADIUS.Acct-
Session-Time=3155 TimestampFormat=MMM dd yyyy HH:mm:ss.SSS zzz RADIUS.Acct-NAS-Port=0
RADIUS.Acct-Session-Id=R00001316-01-547c3b5a RADIUS.Acct-NAS-Port-Type=Wireless-802.11
RADIUS.Acct-Output-Octets=578470212 RADIUS.Acct-Username=A_user2 RADIUS.Acct-NAS-IP-
Address=10.17.6.124 RADIUS.Acct-Input-Octets=786315664

LEEF Event Format Type > Session Logs

The following example describes the LEEF event format type for the Session Logs syslog export filter
template:
Dec 02 2017 15:35:14.944 IST 10.17.4.206 LEEF:1.0Aruba Networks|ClearPass|6.5.0.68878|1309854-
1-0|RADIUS.Acct-Calling-Station-Id=00:88:57:2d:12:a4 RADIUS.Acct-Framed-IP-
Address=192.167.203.170 RADIUS.Auth-Source=AD:10.17.4.130 RADIUS.Acct-Timestamp=2017-
12-02 15:32:47+05:30 RADIUS.Auth-Method=PAP RADIUS.Acct-Service-Name=Authenticate-Only
RADIUS.Acct-Session-Time=565 TimestampFormat=MMM dd yyyy HH:mm:ss.SSS z RADIUS.Acct-
NAS-Port=0 RADIUS.Acct-Session-Id=R000a5038-01-547d8e47 RADIUS.Acct-NAS-Port-
Type=Wireless-802.11 RADIUS.Acct-Output-Octets=412895267 RADIUS.Acct-Username=A_
user706 RADIUS.Acct-NAS-IP-Address=10.17.6.124 RADIUS.Acct-Input-Octets=665942581

Filter and Columns Tab
This section describes the parameters in the Filter and Columns page of the Syslog Export Filters > Add
page.

This page provides two methods for configuring data filters: Insight Logs or Session Logs. These methods
are visible only if you select Insight Logs or Session Logs as the export template.

Insight Logs

This section describes the options if you select Insight Logs as the export template in the General tab.

The Insight Logs option is enabled only if you enable Insight on the current ClearPass server. To do so, navigate to
the Administration > Server Manager > Server Configuration > System tab, then enable the Enable Insight
check box.

Figure 609 displays the Syslog Export Filters > Filter and Columns > Insight Logs.
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Figure 609 Syslog Export Filters > Filter and Columns >Insight Logs

As shown in Figure 609, administrators can select EndpointTag attributes as a column in Syslog Export Filters.

Custom attributes fetched by users and recorded in an endpoint are sent in syslog export filters to the Syslog
server. When there is a update on endpoints, syslog events are generated.

The data collection interval for Insight logs is -4 to -2 minutes from the current time.

Specify the Syslog Export Filters > Filter and Columns > Insight Logs parameters as described in the
following table:

Parameter Action/Description

Columns Selection Determine the group of reports that you want to include in the
syslog filters. The column selection limits the type of records sent
to the syslog filters.
NOTE: You can add only the Insight reports that are already
created in Insight. You cannot create a new data filter for Insight
logs.

Predefined Field
Groups

Select the predefined Insight reports that are grouped for
addition.

Selected Columns After you select an entry from the Available Columns list, click
>> to add the selected entry to the Selected Columns list. Click
<< to remove an entry from the Selected Columns list.

Table 1: Syslog Export Filters > Filter and Columns > Insight Logs Parameters

Session Logs

This section describes the options if you select Session Logs as the export template in the General tab. On
selecting Session Logs, the following options are available:

n Option 1 allows you to choose from pre-defined field groups and to select columns based on the Type.

n Option 2 allows you to create a custom SQL query. You can view a sample template for the custom SQL by
clicking the link below the text entry field.

It is recommended to contact support if you choose the option 2. Support can assist you with entering the correct
information in this template.
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The following figure displays the Syslog Export Filters - Filter and Columns (Session Logs) tab.

Figure 610 Syslog Export Filters - Filter and Columns (Session Logs) Tab

The following table describes the Syslog Export Filters > Filter and Columns > Session Logs parameters:

Parameter Action/Description

Data Filter Specify the data filter. The data filter limits the type of records sent to the syslog target.

Modify/ Add
New Data
Filter

Modify the selected data filter, or add a new one.
Specifying a data filter filters the rows that are sent to the syslog target. You may also select the
columns that are sent to the syslog target. For more information on adding a data filter, see Adding
a Data Filter on page 155.

Columns
Selection

The column selection limits the type of columns sent to the syslog target.
n There are predefined field groups, which are column names grouped together for quick addition

to the report. For example, Logged in users field group has seven predefined columns. When you
click Logged in users the seven columns automatically appear in the Selected Columns list.

n Additional fields are available to add to the reports. You can select the type of attributes (which
are the different table columns available in the session database) from the Available Columns
Type drop down list. Policy Manager populates these column names by extracting the column
names from existing sessions in the session database.

n After you select an entry from the Available Columns list, click >> to add the selected entry to
the Selected Columns list.

n Click << to remove an entry from the Selected Columns list.

Custom SQL Specify custom SQL query for export. This option is for advanced use cases.
NOTE: If you choose this option, contact Aruba Support at Administration > Support > Contact
Support. Support can assist you with entering the correct information in this template.

Table 2: Syslog Export Filters > Filter and Columns > Insight Logs Parameters
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Summary Tab
This section describes the parameters in the Summary tab of the Administration > External Servers >
Syslog Export Filters > Add page. The following figure displays the Syslog Export Filters - Summary tab.

Figure 611 Syslog Export Filters - Summary Tab

The following table describes the Syslog Export Filters - Summary tab parameters:

Parameter Description

General

Name Displays the name of the syslog export filter.

Description Displays the description that provides additional information about the syslog export filter.

Export
Template

Displays the template selected as the export template.

Syslog Servers Displays the IP address of the syslog server selected during configuration.

ClearPass
Servers

Displays the IP address of the ClearPass servers selected during configuration.

Filter and Columns

Data Filter Displays the data filter selected when configuring option 1 in the Filter and Columns tab.

Columns
Selection

Displays the predefined field groups and available columns type selected when configuring
option 1 in the Filter and Columns tab.

Custom SQL Displays the SQL query selected when configuring option 2 in the Filter and Columns tab.

Table 1: Syslog Export Filters - Summary Tab Parameters

Importing a Syslog Filter
To import a syslog target:

1. Navigate to Administration > External Servers > Syslog Export Filters.
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2. Click the Import link on the top right section of the page. Enter the details based on Table 1.

3. Click Import.

The following figure displays the Import from file pop-up:

Figure 612 Import from file Pop-up

The following table describes the Import from file parameters:

Parameter Description

Select File Browse to the Syslog Filter configuration file to be imported.

Enter secret for the file (if any) If the file was exported with a secret key for encryption, enter the
same key here.

Table 1: Import from file Parameters

Exporting All Syslog Filter
To export all syslog filters:

1. Navigate to Administration > External Servers > Syslog Export Filters.

2. Click the Export All link on the top right section of the page. Enter the details based on Table 1.

3. Click Export.

4. Enter the XML file name in the Save As dialog box.

5. Click Save.
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The following figure displays the Export to file pop-up:

Figure 613 Export to file Pop-up

The following table describes the Export to file parameters:

Parameter Description

Export file with password
protection

Choose Yes to export the file with password protection.

Secret Key Enter the secret key.

Verify Secret Re-enter the secret key.

Table 1: Export to file Parameters

Exporting a Syslog Filter
To export a syslog filter:

1. Navigate to Administration > External Servers > Syslog Export Filters.

2. Select the Host Address from the list of check boxes and click Export. Enter the details based on Table 1.

3. Enter the name of the XML file in the Save As dialog.

4. Click Save.

The following figure displays the Export to file pop-up:

Figure 614 Export to file Pop-up
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The following table describes the Export to file parameters:

Parameter Description

Export file with password
protection

Choose Yes to export the file with password protection.

Secret Key Enter the secret key.

Verify Secret Re-enter the secret key.

Table 1: Export to file Parameters

Deleting a Syslog Filter
To delete a syslog filter:

1. Navigate to Administration > External Servers > Syslog Export Filters.

2. Click the check box next to the syslog filter entry and click Delete.

3. Click Yes.

Messaging Setup
This section provides the following information:

n Configuring Messaging

n Sending a Test Email Message

n Sending a Test SMS Message

n Resetting the SMTP Settings

ClearPass messaging setup provides an interface to configure the Simple Mail Transfer Protocol (SMTP) server
for email and SMS notifications.

Configuring Messaging
To configure messaging:

1. Navigate to Administration > External Servers > Messaging Setup.

The Messaging > SMTP Server page opens.

Figure 615 Messaging > SMTP Server Page

2. To configure a new SMS gateway using the ClearPass Guest portal, click the Configure SMS Gateway link
at the top right section of the page.
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The following table describes the Messaging > SMTP Server page parameters:

Parameter Action/Description

Server name Enter the Fully Qualified Domain Name (FQDN) or the IP address of the SMTP server.

User Name Enter the username if your email server requires authentication for sending email
messages.

Password Enter the password for the specified username, then verify the password.

Default From
address

Enter the email address that must to be displayed as the sender’s address in the message.

Connection Security To establish the communication with the SMTP server, select from one of the following
options:
n None: Select this option to disable secure communication with the server.
n SSL: Select this option to have a Secured Socket Layer communication with the server.
n Start TLS: Select this option to have a Transport Layer Security communication with the

server.

Port Enter the TCP port number that the SNMP server listens on.
The default value of the port is 25.

Connection timeout Enter the timeout value for connection to the SMTP server (in seconds).
The default value is 30 seconds.

Table 1: Messaging > SMTP Server Page Parameters

Sending a Test Email Message
To send a test mail message to the preferred email address:

1. Click Send Test Email.
The Send Test Email dialog opens.

Figure 616 Send Test Email Dialog

2. Recipient Email Address: Enter the email address of the recipient.

3. Message: Enter the test message.

4. Click Send Email.
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Sending a Test SMS Message
To send a test SMS message to the preferred email address:

1. Click Send Test SMS.

The Send Test SMS dialog opens.

Figure 617 Send Test SMS Dialog

2. Recipient in International format: Enter the mobile phone number of the recipient in international
format.

The recipient's mobile number must be entered in the international format consisting of a + sign, followed
by the country code and the mobile phone number (without the first ‘0′ of the number).

3. Message: Enter the test message.

4. Click Send SMS.

Resetting the SMTP Settings
To remove the current SMTP settings specified in the Messaging dialog, click Reset.

Endpoint Context Servers
This section describes the following topics:

n Introduction

n Endpoint Context Servers Page

n Adding an Endpoint Context Server

n Importing an Endpoint Context Server

n Exporting All Endpoint Context Servers

n Modifying an Endpoint Context Server

n Polling an Endpoint Context Server

n Deleting an Endpoint Context Server

For related information, see:

n Configuring Endpoint Context Server Actions

n Adding Vendor-Specific Endpoint Context Servers

n Endpoint Information Collectors

Introduction
ClearPass Policy Manager provides the ability to collect endpoint profile information from different types of
Aruba IAPs (Instant Access Points) and RAPs (Remote Access Points) via Aruba Activate.

ClearPass 6.7 Policy Manager | User Guide Administration | 616
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1648



617 | Administration ClearPass 6.7 Policy Manager |  User Guide

The mobile device management (MDM) platforms run on MDM servers. These servers provision mobile devices
to configure connectivity settings, enforce security policies, restore lost data, and other administrative services.
Information gathered from mobile devices can include policy breaches, data consumption, and existing
configuration settings.

Endpoint Context Servers Page
1. To access the Endpoint Context Servers page, navigate to Administration > External Servers >

Endpoint Context Servers.

The Endpoint Context Servers page opens:

Figure 618 Endpoint Context Servers Page

The following table describes the Endpoint Context Servers categories:

Parameter Description

Server Name Displays the name of the endpoint context server.

Server Type Displays the type of the endpoint context server.

Status Displays the status of the endpoint context server: Enabled or Disabled. For non-MDM
servers, the status is always displayed as Disabled.

Table 1: Endpoint Context Server Categories

Adding an Endpoint Context Server
To add an endpoint context server:

1. Navigate to Administration > External Servers > Endpoint Context Servers.

2. Click the Add link at the top right section of the page.

The Add Endpoint Context Server dialog opens.

The parameters that are displayed in the Add Endpoint Context Server dialog vary depending on which
Server Type you select (see Select Server Type in Table 2).
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Figure 619 Adding an Endpoint Context Server

3. In the Add Endpoint Context Server dialog, specify the parameters as described in Table 2.

4. Click Save.

Table 2 describes the Add Endpoint Context Servers parameters:

Parameter Description

Select Server Type Choose one of the Server Types (endpoint context server vendors) from the
following options.
The Server Type you select determines the configuration parameters.
n AirWatch
n Aruba Activate
n AirWave
n Google Admin Console
n Generic HTTP
n JAMF
n Juniper SRX
n MaaS360
n MobileIron
n Palo Alto Networks Firewall
n Palo Alto Networks Panorama
n SAP Afaria
n SOTI
n XenMobile
NOTE: You can add more than one endpoint context server of the same type.

Server Name Enter the name of the server or host.

Server Base URL Enter the full URL for the server.
The default is the name you entered above with "https://" prepended. You can
append a custom port, such as for an MDM server:
https://yourserver.yourcompany.com:customerportnumber.

Table 2: Add Endpoint Context Server Parameters

ClearPass 6.7 Policy Manager | User Guide Administration | 618
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1650



619 | Administration ClearPass 6.7 Policy Manager |  User Guide

Parameter Description

Authentication Method Select one of the following authentication methods:
n Basic
n OAuth2: When you select OAuth2 or Both, the following fields are displayed:

l OAuth2 Client ID
l OAuth2 Client Secret
l OAuth2 Resource URL
l Validate OAuth2 Credentials: Validate button: When you click Validate,

ClearPass retrieves a bearer token in order to validate whether the
OAuth token server is reachable and the credentials are correct. If the
credentials are not correct, an error message is displayed.

n Both: Selecting Both allows you to use both Basic and OAuth2 authentication.

Username Enter the username.

Password Enter the password of the server or host, then verify the password.

API Key Enter the API key that was provided by the vendor, then verify the API key.
This field is not displayed for all endpoint context servers.

Security Details Select this check box to enable this endpoint context server to fetch Endpoint
Security information.

Validate Server Select the Enable to validate the server certificate check box to validate.
By default, this field is disabled.
NOTE: Checking this option enables the Certificate tab.

Enable Server Select the Enable to fetch endpoints from the server check box to enable the
endpoint context server.
By default, this field is disabled.
NOTE: The Bypass Proxy field is enabled only if you enable this field. Checking
this option enables the Poll Status tab.

Bypass Proxy Select the Enable to bypass proxy server check box to bypass the proxy server.
By default, this field is disabled. You must enable the Enable Server parameter to
enable this field.
You can select this option to specify that the endpoint context server should not
use the configured proxy settings (if a proxy is used). ClearPass then bypasses
the proxy server for functions such MDM API, Endpoint Context Server Actions,
and Generic HTTP outbound enforcement.
NOTE: When this field is enabled, the proxy servers configured in the
Administration > Server Manager > Server Configuration > Service
Parameters tab > ClearPass System Services service page will be bypassed.
The server discovery occurs without any issues even when the proxy servers are
bypassed.

Add Endpoint Context Server > Actions Tab
Use the Actions tab to view the server actions that can be performed on the specified endpoint context server
and their descriptions. The server actions that are displayed in the Actions dialog vary depending on which
Server Type you select (see the Select Server Type vendor links listed in Table 2, "Add Endpoint Context
Server Parameters").

For more information about endpoint context server actions configuration, see Configuring Endpoint Context
Server Actions.
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Figure 620 Example of Default Endpoint Context Server Actions (Airwatch Endpoint Context Server)

Importing an Endpoint Context Server
To import an endpoint context server:

1. Navigate to Administration > External Servers > Endpoint Context Servers.

2. Click the Import link on the top right section of the page.

3. Enter the parameters based on Table 3.

4. Click Import.

Figure 621 displays the Import from File dialog:

Figure 621 Import from File Dialog

The following table describes the Import from file parameters:

Parameter Description

Select File Browse to the Endpoint Context Server configuration file to be imported.

Enter secret for the file (if any) If the file was exported with a secret key for encryption, enter the same key
here.

Table 3: Import from File Dialog Parameters

Exporting All Endpoint Context Servers
To export all endpoint context servers:

1. Navigate to Administration > External Servers > Endpoint Context Servers.

2. Click the Export All link.

The Export to File dialog opens.
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Figure 622 Export to File Dialog

3. Enter the parameters as described in Table 4.

4. Click Export.

5. Enter the XML file name in the Save As dialog box.

6. Click Save.

Table 4 describes the Export to file parameters:

Parameter Action/Description

Export file with password
protection

To export the file with password protection, choose Yes.

Secret Key Enter the secret key, then verify it.

Table 4: Export to File Dialog Parameters

Modifying an Endpoint Context Server
To modify an endpoint context server:

1. Navigate to Administration > External Servers > Endpoint Context Servers.

2. In the Endpoint Context Servers main page, click the desired server name entry.

3. In the Modify Endpoint Context Server dialog, enter the details based on specific Server Type (vendor)
listed in Table 2, "Add Endpoint Context Server Parameters."

4. Click Update.

The tabs that appear when you add or modify an endpoint context server vary depending on the type (vendor) of the
endpoint context server selected.

Server Tab
The following figure displays the Modify Endpoint Context Server > Server dialog:
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Figure 623 Modify Endpoint Context Server > Server Dialog

Modify the Modify Endpoint Context Server > Server parameters as described in the following table:

Parameter Action/Description

Server Type The Server Type cannot be modified.

Server Name Enter the name of the server or host.

Server Base URL Enter the full URL for the server.
The default is the name you entered above with "https://" prepended.
You can append a custom port, such as for an MDM server:
https://yourserver.yourcompany.com:customerportnumber

Authentication Method Select one of the following authentication methods:
n Basic
n OAuth2: When you select OAuth2 or Both, the following fields are displayed:

l OAuth2 Client ID
l OAuth2 Client Secret
l OAuth2 Resource URL
l Validate OAuth2 Credentials: Validate button: When you click Validate,

ClearPass retrieves a bearer token in order to validate whether the OAuth
token server is reachable and the credentials are correct. If the
credentials are not correct, an error message is displayed.

n Both: Selecting Both allows you to use both Basic and OAuth2 authentication.

Username Enter the username of the server or host.

Password Enter the password of the server or host, then verify the password.

Table 5: Modify Endpoint Context Server > Server Parameters
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Parameter Action/Description

Username Transformation Choose one of the following options:
n None: Do not use any username transformation.
n Prefix NetBIOS name: Use the Prefix NetBIOS name in UID updates.
n Use Full Username: Use the full username in UID updates.

Validate Server Enable this check box to validate the server certificate.
By default, this field is disabled.
NOTE: Checking this option enables the Certificate tab.

Bypass Proxy Select the Enable to bypass proxy server check box to bypass the proxy server.
By default, this field is disabled. You must enable the Enable Server parameter to
enable this field.
You can select this option to specify that the endpoint context server should not use
the configured proxy settings (if a proxy is used). ClearPass then bypasses the proxy
server for functions such MDM API, Endpoint Context Server Actions, and Generic
HTTP outbound enforcement.
NOTE: When this field is enabled, the proxy servers configured in the
Administration > Server Manager > Server Configuration > Service Parameters
tab > ClearPass System Services service page will be bypassed. The server
discovery occurs without any issues even when the proxy servers are bypassed.

Actions Tab
Use the Actions tab to view the server actions that can be performed on the specified endpoint context server
and their descriptions. The server actions that are displayed in the Actions dialog vary depending on which
Server Type you select (see the Select Server Type vendor links listed in Table 2, "Add Endpoint Context
Server Parameters").

For more information about endpoint context server actions configuration, see Configuring Endpoint Context
Server Actions.

The following figure displays an example of the Modify Endpoint Context Server > Actions tab:

Figure 624 Modify Endpoint Context Server > Actions Tab
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Polling an Endpoint Context Server
To poll an endpoint context server:

You can poll only one server at a time. You cannot poll multiple server entries. Also, you can only poll MDM-type
servers.

1. Navigate to Administration > External Servers > Endpoint Context Servers.

2. In the Endpoint Context Servers page, click the check box next to the server name entry.

Figure 625 Selecting the Trigger Poll Option

3. Click Trigger Poll.

Deleting an Endpoint Context Server
Deleting an endpoint context server removes the configuration information from the Policy Manager server.

To save the endpoint context server configuration prior to deleting the server:

1. Before you delete the endpoint context server, export the server.

2. Save the configuration so that you can import it in future if necessary.

To delete an endpoint context server:

1. Navigate to Administration > External Servers > Endpoint Context Servers.

2. Select the check box next to the server name entry, then click Delete.

3. To confirm the delete operation, click Yes.

Configuring Endpoint Context Server Actions
This section contains the following information:

n Configuring Endpoint Context Server Actions

n Filtering an Endpoint Context Server Action Report

n Storing Authentication Attributes in the Multi-Master Cache

n Adding machine-os and host-type Endpoint Attributes

Configuring Endpoint Context Server Actions
Use the Endpoint Context Server Actions page to configure actions that are performed on endpoints, such
as locking a device, triggering a remote, or enterprise wipe, and so on.

The Endpoint Context Server Actions page displays a list of all the Context Server Actions that are available
by default for each server type that ClearPass supports.

To configure endpoint context server actions:

1. Navigate to Administration > Dictionaries > Context Server Actions.
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The Endpoint Context Server Actions page opens.

Figure 626 Endpoint Context Server Actions Page

2. From the Endpoint Context Server Actions page, click a row in the report.

The Endpoint Content Server Details dialog opens.

Figure 627 Endpoint Context Server Details Dialog

3. Click a tab to view details about the selected Endpoint Context Server action.

4. Make any changes required, then click Save.
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Action Tab Parameters

Use the Action tab to specify the server type, action name, HTTP method, authentication method, and URL for
the endpoint context server action.

Specify the Endpoint Context Server Details > Action tab parameters as described in the following table,
then click Save.

Table 30: Action Parameters—Endpoint Context Server Details

Parameter Action/Description

Server Type Specifies the server type configured when the server action was configured. You can select
the server type from the drop-down list.

Server Name Lists the context servers specific to the server type selected in the Server Type field. This
field is visible only if you selected the service type Generic HTTP.

Action Name Specifies the name of the action configured.

Description Provides additional information about the action specified.

HTTP Method Select the HTTP method from the drop-down:
n DELETE
n GET
n POST (the default setting)
n PUT
n PATCH

You can use the HTTP method PATCH to append content to existing endpoints/values.

Authentication
Method

Select the authentication method:
n None: Select None to disable the HTTP basic authentication for endpoint context server

actions. This exposes the context server attributes to be used in context server actions.
n Basic
n OAuth2
NOTE: When associating context server actions with an endpoint context server, be sure to
specify the same authentication method that was configured for the endpoint context server.

URL Indicates the URL for the selected HTTP method.

Header Tab Parameters
Use the Header tab to specify the key-value pairs to be included in the HTTP header.

1. From the Header tab, select Click to add.
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Figure 628 Header Tab—Endpoint Context Server Details

2. Specify the Endpoint Context Server Details—Header parameters as described in the following table:

Table 31: Header Parameters—Specifying Key Value Pairs

Parameter Action/Description

Header Name Enter the name of the header to be included in the HTTP header.

Header Value Specify the value of the header specific to the name to be included in the HTTP header.

If a ClearPass server is used as an Endpoint context server to update the configuration using the REST API call, add
the HTTP header, Accept: application/json in the context server action.

3. Repeat these steps for each key-value pairs you need to add.

4. Click Save.

Content Tab
Use the Content tab to specify a content type and add non-default context server attributes (see Figure 629).

The information in the Content window is the template of what will be posted to the server. The fields
preceded by the % sign are replaced with their corresponding values.
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Figure 629 Content Tab—Endpoint Context Server Details

Specify the Endpoint Context Server Details—Content parameters as described in the following table:
Table 32: Content Parameters—Endpoint Context Server Details

Parameter Action/Description

Content-Type Specify the type of the content. Select from the following options:
n CUSTOM
n HTML
n JSON
n PLAIN
n XML

Content Specify the content.
For example, { "mac": "%{Connection:Client-Mac-Address-NoDelim}","nmap": {"device": "%
{DEVICECATEGORY}"}}.

For related information, see Adding machine-os and host-type Endpoint Attributes).

Attributes Tab Parameters
Use the Attributes tab to specify the mapping for attributes used in the content to parameterized values
from the request.

Figure 630 Attributes Tab—Endpoint Context Server Details
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Specify the Endpoint Context Server Details > Attributes parameters as described in the following table:
Table 33: Attributes Parameters—Endpoint Context Server Details

Parameter Action/Description

Attribute Name Enter attribute names and assign values to those names. These name/value pairs are included
in context server actions.

Attribute Value Enter the value for the selected name in the Attribute Name field.

Figure 631 Adding Endpoint Context Server Attributes

5. Click Save.

You receive the following message:

Context Server Action "Check Point Login (Generic HTTP)" updated successfully

Filtering an Endpoint Context Server Action Report
Use the Filter controls to configure a search for a subset of Endpoint Context Server Action items.

To filter an endpoint context server action report:

1. Navigate to Administration > Dictionaries > Context Server Actions.
The Endpoint Context Server Actions page opens (see Figure 626).

2. From the Filter drop-down, select a filter:

l ServerType
l Action Name
l HTTP method

3. To add up to four new search fields, click the Plus icon.

4. Select a search argument.

The search arguments are limited to contains or equals.

5. Click Go.
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Storing Authentication Attributes in the Multi-Master Cache
ClearPass provides a context server action that serves as an example of how to store attributes from an
authentication session into Multi-Master Cache for use in policy enforcement during an authentication session.
The Administrator can then clone it and customize the context server action to meet their requirements.

To access this context server action:

1. Navigate to Administration > Dictionaries > Context Server Actions.

The Endpoint Context Server Actions page opens.

Figure 632 Endpoint Context Server Actions Page: Store Attributes in Multi-Master Cache

2. Scroll down and select the Store Attributes in Multi-Master Cache endpoint context server action.

The Endpoint Context Server Details page opens.

Figure 633 Endpoint Context Server Details: Store Attributes in Multi-Master Cache

3. Modify and customize the Store Attributes in Multi-Master Cache endpoint context server action as
needed.

At Configuration > Authentication > Sources, the Multi-Master Cache Repository authentication
source will fetch the attributes stored in the Multi-Master Cache and proceed with authentication.
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Adding machine-os and host-type Endpoint Attributes
To be able to indicate the entire OS family (Android, Windows, Linux, etc.) and the type of device (iPad, iPhone,
etc.), you can add the machine-os Device Family attribute and the host-type Device Type attribute to the
default set of endpoint context attributes provided in the Content window:

To add the machine-os and host-type endpoint context attributes:

1. Navigate to Administration > Dictionaries > Context Server Actions.

The Endpoint Context Server Actions page opens.

2. Scroll to and select the Generic HTTP/Check PointLogin server action.

Figure 634 Selecting the Check Point Login Server Action

The Endpoint Context Server Details dialog opens.

3. Select the Content tab (see Figure 631).

4. In the Content field, add the following attributes (see Figure 631):

l "machine-os":" %{device_family}"

l "host-type":"%{device_type}"

Adding Vendor-Specific Endpoint Context Servers
This section provides information on the following topics:

n Adding an AirWatch Endpoint Context Server

n Adding an AirWave Endpoint Context Server

n Adding an Aruba Activate Endpoint Context Server

n Adding a Generic HTTP Endpoint Context Server

n Adding a Google Admin Console Endpoint Context Server

n Integrating ClearPass with Infoblox Endpoint Context Servers

n Adding a JAMF Endpoint Context Server

n Integrating ClearPass with Juniper Networks SRX Endpoint Context Server

n Adding a MaaS360 Endpoint Context Server

n Adding a MobileIron Endpoint Context Server
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n Integrating ClearPass with Palo Alto Networks Firewall Endpoint Context Server

n Adding a Palo Alto Networks Panorama Endpoint Context Server

n Adding a SAP Afaria Endpoint Context Server

n Adding a SOTI Endpoint Context Server

n Adding a XenMobile Endpoint Context Server

Adding an AirWatch Endpoint Context Server
Consult Airwatch's documentation for additional information about the parameters that you must enter to
configure this endpoint.

To add an Airwatch Endpoint Context Server:

1. Navigate to Administration > External Servers > Endpoint Context Servers.

The Endpoint Context Servers page opens.

2. Click Add.

The Add Endpoint Context Server page opens. This dialog opens in the Server tab.

3. From the Select Server Type drop-down, select airwatch.

Server Tab
The Airwatch Add Endpoint Context Server > Server page opens:

Figure 635 Adding an Airwatch Endpoint Context Server > Server Page

You can add more than one endpoint context server of the same type.
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Specify the Add Airwatch Endpoint Context Server > Server parameters as described in the following
table:

Parameter Action/Description

Select Server Type Choose AirWatch from the drop-down list.

Server Name Enter a valid server name. You can enter an IP address or a hostname.

Server Base URL Enter the full URL for the Airwatch server. You can append a custom port, such as for an
MDM server: https://yourserver.yourcompany.com:customerportnumber

Authentication
Method

Select one of the following authentication methods:
n Basic
n OAuth2: When you select OAuth2 or Both, the following fields are displayed:

l OAuth2 Client ID
l OAuth2 Client Secret
l OAuth2 Resource URL
l Validate OAuth2 Credentials: Validate button: When you click Validate,

ClearPass retrieves a bearer token in order to validate whether the OAuth
token server is reachable and the credentials are correct. If the credentials are
not correct, an error message is displayed.

n Both: Selecting Both allows you to use both Basic and OAuth2 authentication.

Username Enter the user for the Airwatch endpoint context server.

Password
Verify Password

Enter the password for the Airwatch endpoint context server, then verify the password.

API Key Enter the API key that is provided by the vendor.

Security Details Enable to fetch endpoint security information.

Validate Server Enable to validate the server certificate. Checking this option activates the Certificate
tab.

Enable Server Select the Enable to fetch endpoints from the server check box to enable the
endpoint context server. By default, this field is disabled. The Bypass Proxy field will be
enabled only if you enable this field.

Bypass Proxy You must enable the Enable Server parameter to enable the Bypass Proxy parameter.
Select the Enable to bypass proxy server check box to bypass the proxy server.
When this field is enabled, the proxy servers configured in the Administration > Server
Manager > Server Configuration > Service Parameters tab > ClearPass system
services service page will be bypassed.
The server discovery occurs without any issues even when the proxy servers are
bypassed. By default, this field is disabled.

Table 1: Adding an Airwatch Endpoint Context Server > Server Tab Parameters
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Actions Tab
The following figure displays the Airwatch Add Endpoint Context Server > Actions page:

Figure 636 Adding an Airwatch Endpoint Context Server > Actions Page

Specify the Airwatch Add Endpoint Context Server > Actions parameters as described in the following
table:

Parameter Action/Description

Clear Passcode Reset passcode on the device.

Enterprise Wipe Delete only stored corporate information.

Get Apps Get application information for the device.

Lock Device Lock the associated device.

Remote Wipe Delete all stored information.

Send Message Send message to the device.

Send Message (Parameterized) Send message with parameters to the device.

Table 2: Adding an Airwatch Endpoint Context Server > Actions Tab Parameters

The Imei attribute from an Airwatch server is mapped to the IMEI attribute in the ClearPass Endpoint dictionary.

The ComplianceStatus attribute from an Airwatch server is mapped to the Compliance attribute in the Endpoint
dictionary. The available Compliance attributes are: NotAvailable, NonCompliant, or Compliant.

ClearPass 6.7 Policy Manager | User Guide Administration | 634
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1666



635 | Administration ClearPass 6.7 Policy Manager |  User Guide

Adding an AirWave Endpoint Context Server
For more information about AirWave, refer to Aruba AirWave documentation.

To add an AirWave Endpoint Context Server:

1. Navigate to Administration > External Servers > Endpoint Context Servers.

The Endpoint Context Servers page opens.

2. Click Add.

The Add Endpoint Context Server dialog opens.

3. From the Select Server Type drop-down, select AirWave.

The following dialog is displayed:

Figure 637 Add an AirWave Endpoint Context Server > Server Dialog

You can add multiple endpoint context servers of the same type.

4. Enter the appropriate values for each of the AirWave Add Endpoint Context Server parameters described in
Table 1.

5. When satisfied with the settings, click Save.

Parameter Action/Description

Select Server Type 1. Choose AirWave from the Select Server Type drop-down list.

Server Name 2. Enter a valid server name. You can enter an IP address or hostname.

Server Base URL 3. Enter the full URL for the AirWave server.
You can append a custom port, such as for an MDM server:
https://yourserver.yourcompany.com:customerportnumber

Table 1: Adding an AirWave Endpoint Context Server > Server Parameters
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Parameter Action/Description

Username 4. Enter the username for the AirWave server.

Password 5. Enter the password for the server, then verify the password.

Verify Password

Validate Server 6. Enable Validate Server to validate the server certificate.
Checking this option enables the Certificate tab.

Bypass Proxy 7. Enable Bypass Proxy to bypass the proxy server.

Adding an Aruba Activate Endpoint Context Server
To add an Aruba Activate Endpoint Context Server:

1. Navigate to Administration > External Servers > Endpoint Context Servers.

The Endpoint Context Servers page opens.

2. Click Add.

The Add Endpoint Context Server page opens. This dialog opens in the Server tab.

3. From the Select Server Type drop-down, select Aruba Activate.

The Add Aruba Activate Endpoint Context Server page opens:

Figure 638 Adding an Aruba Activate Endpoint Context Server

4. Specify the Aruba Activate Add Endpoint Context Server parameters as described in the following
table:

ClearPass 6.7 Policy Manager | User Guide Administration | 636
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1668



637 | Administration ClearPass 6.7 Policy Manager |  User Guide

Parameter Action/Description

Select Server
Type

Choose Aruba Activate from the Select Server Type drop-down list.

Server Name Enter a valid server name. You can enter an IP address or a hostname.

Server Base URL Enter the complete URL for the Aruba Activate server.
You can append a custom port, such as for an MDM server:
https://yourserver.yourcompany.com:customerportnumber

Authentication
Method

Select one of the following authentication methods:
n Basic
n OAuth2: When you select OAuth2 or Both, the following fields are displayed:

l OAuth2 Client ID
l OAuth2 Client Secret
l OAuth2 Resource URL
l Validate OAuth2 Credentials: Validate button: When you click Validate, ClearPass

retrieves a bearer token in order to validate whether the OAuth token server is
reachable and the credentials are correct. If the credentials are not correct, an
error message is displayed.

n Both: Selecting Both allows you to use both Basic and OAuth2 authentication.

Username Enter the username for the Aruba Activate server.

Password Enter the password, then verify the password.

Device Filter The Device Filter field is populated with a default regular expression to retrieve only the
Remote AP (RAP) and Instant AP (IAP) information.

Folder Filter Set the value for Folder Filter to the Aruba Activate Folder ID.
To locate the Folder ID in Aruba Activate:

1. Log in to Aruba Activate.
2. Navigate to Setup.
3. Click the folder.
A URL is displayed. For example:
https://activate.arubanetworks.com/registration/#/setup/folder/detail
?id=3f1229d8-cef2-4440-add4-7a28309b46ea
In this example, the folder ID is:
3f1229d8-cef2-4440-add4-7a28309b46ea
4. Copy the folder ID from the URL and use it to specify the value for the Folder Filter
parameter.

NOTE: Multiple folder IDs can be specified as comma-separated values.

Disable Stale
Endpoints

To disable stale endpoints in the Endpoint database, enable this option.

Validate Server To validate the server certificate, enable (check) Validate Server.
Checking this option enables the Certificates tab.

Enable Server Enable Enable Server to fetch endpoints from the server.

Bypass Proxy Enable Bypass Proxy to bypass the proxy server.

Table 1: Adding an Aruba Activate Endpoint Context Server > Server Parameters

5. Click Save.
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Certificates Tab
The following figure displays the Aruba Activate Add Endpoint Context Server > Certificates tab:

Figure 639 Adding an Aruba Activate Endpoint Context Server > Certificates

Adding a Google Admin Console Endpoint Context Server
To add a Google Admin Console Endpoint Context Server:

1. Navigate to Administration > External Servers > Endpoint Context Servers.

The Endpoint Context Servers page opens.

2. Click Add.

The Add Endpoint Context Server page opens.

3. From the Select Server Type drop-down, select Google Admin Console.

The Add Google Admin Console Endpoint Context Server page opens:

Figure 640 Add Endpoint Context Server > Google Admin Console Page
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You can add more than one endpoint context server of the same type.

4. Specify the Add Endpoint Context Server > Google Admin Console parameters as described in the
following table:

Parameter Description

Select Server Type Choose Google Admin Console from the drop-down list.

Server Name Enter the server name.

Client ID Enter the client ID.

Client Secret Enter the client secret.

Google API Access Authenticate and authorize ClearPass for access to Google Admin APIs for your domain.

Validate Server Enable to validate the server certificate. Checking this option enables the Certificates tab.

Enable Server Enable this field to enable the server and fetch endpoints from the server.
By default, this field is disabled. The Bypass Proxy field is enabled when you enable this
field.

Bypass Proxy To bypass the proxy server, select the Enable to bypass proxy server check box. When
this field is enabled, the proxy servers configured in the Administration > Server
Manager > Server Configuration > Service Parameters tab > ClearPass system
services service page will be bypassed. The server discovery occurs without any issues
even when the proxy servers are bypassed. By default, this field is disabled.

Table 1: Add Endpoint Context Server > Google Admin Console Parameters

Certificates Tab
The following figure displays the Add Endpoint Context Server > Google Admin Console page:

Figure 641 Add Endpoint Context Server >Certificates > Google Admin Console
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Adding a Generic HTTP Endpoint Context Server
To add a Generic HTTP endpoint context server:

1. Navigate to Administration > External Servers > Endpoint Context Servers.

The Endpoint Context Servers page opens. This page lists the server name, server type, and status of the
currently configured endpoint context servers.

2. Click the Add link.

The Add Endpoint Context Server dialog opens.

3. From the Select Server Type drop-down, select Generic HTTP.

The Generic HTTP Add Endpoint Context Server page opens.

Figure 642 Adding a Generic HTTP Endpoint Context Server

You can add more than one endpoint context server of the same type.

4. Specify the Generic HTTP Add Endpoint Context Server > Server parameters as described in the
following table:

Parameter Action/Description

Select Server Type Choose Generic HTTP from the Select Server Type drop-down list.

Server Name Enter a valid server name. You can enter an IP address or a hostname.

Server Base URL Enter the server base URL in the following format:
https://{server_ip}/api/?type=keygen&user={username}&password={password}

Authentication Method Select one of the following authentication methods:

n Basic
n OAuth2: When you select OAuth2 or Both, the following fields are displayed:

l OAuth2 Client ID

Table 1: Add Endpoint Context Server > Server > Generic HTTP Parameters
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Parameter Action/Description

l OAuth2 Client Secret
l OAuth2 Resource URL
l Validate OAuth2 Credentials: Validate button: When you click Validate,

ClearPass retrieves a bearer token in order to validate whether the
OAuth token server is reachable and the credentials are correct. If the
credentials are not correct, an error message is displayed.

n Both: Selecting Both allows you to use both Basic and OAuth2 authentication.

Username Enter the username for the endpoint context server.

Password
Verify Password

Enter the password, then verify the password.

Validate Server Enable Validate Server to validate the server certificate.
Checking this option enables the Certificate tab.

Bypass Proxy You must enable the Enable Server parameter to enable the Bypass Proxy
parameter.
Select the Enable to bypass proxy server check box to bypass the proxy server.
When this field is enabled, the proxy servers configured in the Administration >
Server Manager > Server Configuration > Service Parameters tab >
ClearPass system services service page will be bypassed.
The server discovery occurs without any issues even when the proxy servers are
bypassed. By default, this field is disabled.
.

5. To save your changes, click Save .

Integrating ClearPass with Infoblox Endpoint Context Servers

This section provides the following information:

n Adding an Infoblox Endpoint Context Server

n Adding a Context Server Action to the Infoblox Server

n Creating an Infoblox Enforcement Profile

n Configuring an Infoblox RADIUS Enforcement Profile

n Creating an Infoblox Enforcement Policy

n Defining an Infoblox Service

n Authenticating External Devices Against the Infoblox Service

n Creating a Filter to Accept Information from the ClearPass Server

Infoblox is a server that provides a host of services, such as DNS, DHCP, and IPAM (IP address management).
Infoblox provides a DHCP management system that issues IP addresses to externally authenticated devices
and also maintains a MAC address context associated with the newly allocated IP address.

Integrating ClearPass with Infoblox typically tags the username context, as well as the external device being
authenticated, along with its respective MAC address, which further simplifies IP address management on the
Infoblox side.

This section describes the configurations that you must make on the ClearPass server in order for the ClearPass
server to send data to an Infoblox server.

Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1673



Adding an Infoblox Endpoint Context Server
To add an Infloblox endpoint context server:

1. Navigate to Administration > External Servers > Endpoint Context Servers.

The Endpoint Context Servers page opens.

Figure 643 Endpoint Context Servers Page

2. Click Add.

The Add Endpoint Context Server dialog opens. This dialog opens in the Server page.

Figure 644 Adding an Infoblox Endpoint Context Server

3. Enter the following information:

a. Select Server Type: From the drop-down list, select Generic HTTP.

b. Server Name: Enter the IP address of the Infoblox server.

c. Server Base URL: As you enter the IP address in the Server Name field, the Server Base URL is
populated automatically with the same IP address.

d. Password: Enter the password for this server, then verify the password.

4. When finished defining the parameters in the Server page, click Save.

You return to the Endpoint Context Servers page, where the endpoint context server you added is now
listed.
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Adding a Context Server Action to the Infoblox Server
This section describes how to define an Infoblox Login action and specify the URL to post content from the
ClearPass Policy Manager server to the Infoblox server.

To add a context server action to the Infoblox server:

1. Navigate to Administration > Dictionaries > Context Server Actions.

The Endpoint Context Server Actions page opens.

2. Select the Infoblox Login endpoint context server action.

The Endpoint Context Server Details dialog for the selected action is displayed.

For descriptions of the parameters in the Endpoint Context Servers Details tabs, refer to Configuring
Endpoint Context Server Actions.

Figure 645 Selecting the Infoblox Server for the Endpoint Context Server Action

3. Server Name: Select the IP address of the Infoblox server.

4. URL: Note the URL for posting content from the ClearPass server to the Infoblox server:
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/wapi/v2.0/macfilteraddress?

5. Click Save.

Attributes Sent to the Infoblox Server

6. To view the attributes that will be sent to the Infoblox server, click the Content tab.

As shown in Figure 646, the following attributes are sent in JSON format to the Infoblox server:

l Filter name "ClearPass"
l Username and MAC addresses of the authenticated devices

Figure 646 Attributes Sent to Infoblox Server

7. Click Cancel.

Creating an Infoblox Enforcement Profile
This section describes how to create a simple HTTP-based enforcement profile named "Infoblox Notify" that acts
against the Infoblox Login action. For additional details on configuring enforcement profiles, see Configuring
Enforcement Profiles.

To create an Infoblox enforcement profile:

1. Navigate to Configuration > Enforcement > Profiles.

The Enforcement Profiles page opens.

Figure 647 Enforcement Profiles Page

2. Click Add.
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The Add Enforcement Profiles dialog opens.

Figure 648 Adding the Infoblox Enforcement Profile

3. Configure the Add Enforcement Profile page as follows:

a. Template: Select HTTP Based Enforcement.

For details on configuring HTTP-based enforcement profiles, see HTTP Based Enforcement Profile.

b. Name: Enter Infoblox Notify.

c. Description: Optionally, enter a description of this enforcement profile.

d. Click Next.

The Enforcement Profiles Attributes page opens.

Figure 649 Specifying the Target Server and Enforcement Action

4. Configure the Enforcement Profile Attributes page as follows:

a. Target Server: Select the IP address of the Infoblox server.

b. Action: Select Infoblox Login.

c. Click Save.

You return to the Enforcement Profiles page, where the Infoblox Notify enforcement profile is now
listed.
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Configuring an Infoblox RADIUS Enforcement Profile
This section describes how to define a RADIUS Enforcement type profile for Infoblox. This profile configures
parameters to define tunnel parameters, VLAN ID, and the termination action.

This configuration is specific to the lab environments in which this feature has been tested. The RADIUS: IETF
attributes can take any values, depending on the lab environment.

For details on configuring a RADIUS-based enforcement policy, see RADIUS Based Enforcement Profile.

To define a RADIUS Enforcement profile:

1. Navigate to Configuration > Enforcement > Profiles.

The Enforcement Profiles page opens.

2. Click Add.

The Add Enforcement Profiles dialog opens.

Figure 650 Adding a RADIUS-Based Enforcement Profile

3. Enter the following information:

a. Template: Select RADIUS Based Enforcement.

b. Name: Enter Infoblox RADIUS Enforcement.

c. Description: Optionally, enter a description of this profile.

d. Click Next.

The Enforcement Profiles Attributes page opens. In the following steps, you will add the four RADIUS
Enforcement attributes illustrated in Figure 651.
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Figure 651 Adding Attributes to the RADIUS Enforcement Profile

Tunnel-Private_Group-Id

4. Click Click to add....
a. Type: Select Radius:IETF.

b. Name: Select Tunnel-Private_Group-Id.

c. Value: Enter the value configured for the Tunnel-Private_Group-Id attribute on the controller.

Session-Timeout

5. Click Click to add....
a. Type: Select Radius:IETF.

b. Name: Select Session-Timeout.

c. Value: Enter 21600 (which equals six hours in seconds).

Tunnel-Type

6. Click Click to add....
a. Type: Select Radius:IETF.

b. Name: Select Tunnel-Type.

c. Value: Select VLAN.

Termination-Action

7. Click Click to add....
a. Type: Select Radius:IETF.

b. Name: Select Termination-Action.

c. Value: Select RADIUS-Request.

8. Click Save.

You return to the Enforcement Profiles page. The following message is displayed:

Enforcement profile "Infoblox RADIUS Enforcement" added

Creating an Infoblox Enforcement Policy
This section describes how to create an enforcement policy to act against the "Infoblox Notify" and "Infoblox
RADIUS Enforcement" profiles so that external devices can authenticate against this policy.

For details on configuring enforcement policies, see Configuring Enforcement Policies.

To create an Infoblox Enforcement Policy:

1. Navigate to Configuration > Enforcement > Policies.

The Enforcement Policies page opens.
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2. Click Add.

The Add Enforcement Policies page opens.

Figure 652 Adding the Infoblox Enforcement Policy

3. Enter the following information:

a. Name: Enter Infoblox Policy.

b. Description: Optionally, enter a description of this profile.

c. Enforcement Type: Set by default to RADIUS.

d. Default Profile: Select Allow Access Profile.

e. Click Next.

The Rules page opens.

4. Click Add Rule.

The Rules Editor dialog opens.

Figure 653 Configuring Infoblox Enforcement Policy Rules

5. In the Conditions panel, click Click to add, then enter the following information:

a. Type: Select Tips.

b. Name: Select Role.

c. Operator: Select EQUALS.

d. Value: Select User Authenticated.

6. In the Enforcement Profiles panel:

a. Click Select to Add.
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You must add the enforcement profies in the order specified here.

b. Select [RADIUS] Infoblox RADIUS Enforcement.

c. Click Select to Add.

d. Select [HTTP] Infoblox Notify.

7. Click Save.

8. To view the Infoblox enforcement policy summary, click the Summary tab.

Figure 654 Summary of the Infoblox Enforcement Policy

9. Check the summary information to make sure the policy is correct, make any changes if necessary, then
click Save.

You return to the Enforcement Policies page where the new Infoblox Policy is now listed.

Defining an Infoblox Service

This section describes how to create a Generic RADIUS Enforcement wireless service named "Infoblox Service"
for the policy "Infoblox Policy."

To create the wireless service:

1. Navigate to Configuration > Services.

The Services page opens.

2. Click Add.

The Add Services page opens.

Figure 655 Adding an InfobloxWireless Service
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3. Enter the following information:

a. Type: Select 802.1X Wireless.

b. Name: Enter Infoblox Wireless Service.

c. Description: Optionally, enter a description of this service.

d. In the Service Rule panel, set Matches to ANY, then click Next.

The Authentication page appears.

Figure 656 Specifying Wireless Service Authentication Settings

4. Enter the following information:

a. Authentication Methods: Select the authentication method.

This example uses EAP MSCHAPv2.

b. Authentication Sources: Select the authentication source(s).

This example uses Local SQL DB.

5. Select the Enforcement tab.

Figure 657 Specifying the Enforcement Policy for the Service

6. From the Enforcement Policy drop down, select Infoblox Policy, then click Next.

The Infoblox Wireless Service Summary page is displayed.

7. Check the summary information to make sure the service is correct, make any changes if necessary, then
click Save.

You return to the Services page where the new Infoblox Wireless Service is now listed.
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Authenticating External Devices Against the Infoblox Service
This section defines the configuration on the Infoblox server to receive the MAC address and username
context from ClearPass.

The following procedure adds an IPv4 network that is used as a DHCP pool to assign IP addresses to the
external devices that must be authenticated.

To configure an Infoblox server to authenticate external devices:

1. Log into the Infoblox server.

The Infoblox IPAM Tasks page opens.

Figure 658 Infoblox Server Initial Page

2. Select the Data Management tab, then select the DHCP tab.

The DHCP Networks page opens.

Figure 659 Adding an IPv4 Network

3. To add a new network, click the Plus icon.

The Add IPv4 Network Wizard begins.
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Figure 660 Adding an IPv4 Network

4. With Add Network selected by default, click Next.

The following screen appears.

Figure 661 Specifying the Netmask

5. In the Netmask field, specify the netmask for the new network.

The netmask is set by default to /24 (that is, a Class C IP address), but you can set the netmask to any
appropriate netmask value for your network.

6. To add an IPv4 network, in the Networks panel, click the Plus sign (as shown in Figure 661 above).

7. In the Networks field, enter the IP address of the network, then click Next.

The Members screen opens.
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Figure 662 Adding Members

8. Click the Plus sign.

While adding members for the DHCP pool, the members group from Data Management > DHCP >
Members is populated automatically.

9. Click Next.

The following screen appears:

Figure 663 Specifying the Lease Time (Session-Timeout Value)

10.In the Lease Time Override panel, click Override.

11.In the Lease Time field, enter 21600; from the drop-down, select Seconds. Then click Next.

The Lease Time value you enter here must correspond to the Session-Timeout value defined under Infoblox RADIUS
Enforcement (see Figure 651).

The Extension Attributes screen opens. No changes are required here.

12.Click Next.

The Create IPv4 Network screen opens. You can choose to create the network now or schedule it for a
later day and time.
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Figure 664 Scheduling Date and Time for Creating the IPv4 Network

13.Specify when you choose to create the IPv4 network, then click Save & Close.

The new network is created.

Figure 665 New IPv4 Network Created

Creating a Filter to Accept Information from the ClearPass Server
To create a filter to accept information from the ClearPass server:

1. From the Data Management > DHCP tab, select the newly created network.

The Networks page opens.

2. Select the IPv4 Filters tab.

3. To add a filter, click the Plus sign.

The Add IPv4 MAC Address Filter dialog opens.

4. In the Name field, enter ClearPass.

The name of the filter must correspond to the filter value in the Endpoint Context Server Content page (see
Attributes Sent to the Infoblox Server).

5. Optionally, enter a comment to describe this filter, then click Next.

Step 2 of the Add IPv4 MAC Address Filter wizard appears.

6. In the Lease Time fields, enter 21600 Seconds, then click Next.
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Figure 666 Specifying Lease Time in the IPv4MAC Address Filter

The Lease Time value entered here must correspond to the Session-Timeout value defined under Infoblox RADIUS
Enforcement Profile (see Session-Timeout).

Step 3 of the IPv4 MAC Address Filter wizard opens.

Figure 667 Specifying the MAC Address Expiration in the IPv4MAC Address Filter

7. For the Default MAC Address Expiration setting:

a. Select the Automatically Expires in button.

b. Specify 21600 Seconds.

c. Then click Next.

The Extensible attributes screen opens.

8. No changes are required for this step, so click Next.

The Schedule Change dialog opens.
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Figure 668 Specifying Schedule Change Settings

9. Specify the Schedule Change settings:

a. If you wish to run the MAC address filter now, select Now.

b. If you wish to schedule the MAC address filter for later, select Later and specify the Start Date and
Start Time.

c. When finished with the Schedule Change settings, click Save & Close.

Integrating ClearPass with Juniper Networks SRX Endpoint Context Server
This section provides the following information:

n Adding a Juniper Networks SRX Endpoint Context Server

n Adding a Context Server Action to the Juniper SRX Server

n Viewing or Modifying Juniper Networks SRX Endpoint Context Server Actions

n Creating a Juniper SRX Enforcement Profile

n Creating a Juniper SRX Enforcement Policy

n Defining a Juniper SRX Wireless Service

For more information about the parameters that you must enter to configure this endpoint context server,
consult Juniper Network's documentation.

Integrating ClearPass with a Juniper Networks SRX endpoint context server typically tags the username
context, as well as the external devices being authenticated, along with its respective MAC address, which
further simplifies IP address management on the Juniper SRX endpoint context server side.

This section describes the configurations that you must make on the ClearPass server in order for the ClearPass
server to send data to a Juniper Networks SRX endpoint context server.

Adding a Juniper Networks SRX Endpoint Context Server
To add a Juniper Networks SRX Endpoint Context Server:

1. Navigate to Administration > External Servers > Endpoint Context Servers.

The Endpoint Context Servers page opens.

2. Click Add.

The Add Endpoint Context Server dialog appears. This dialog opens in the Server page.

3. From the Select Server Type drop-down, select Juniper Networks SRX.

Server Page

The following dialog is displayed (see Figure 669).

ClearPass 6.7 Policy Manager | User Guide Administration | 656
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1688



657 | Administration ClearPass 6.7 Policy Manager |  User Guide

Figure 669 Adding a Juniper Networks SRX Endpoint Context Server > Server Dialog

You can add multiple endpoint context servers of the same type.

4. Enter the appropriate values for each of the Juniper Networks SRX Add Endpoint Context Server parameters
described in Table 1.

5. When satisfied with the settings, click Save.

Parameter Action/Description

Select Server Type Choose Juniper Networks SRX.

Server Name Enter a valid server name. You can enter an IP address or a host name.

Server Base URL Enter the full URL for the server. You can append a custom port, such as for an MDM
server: https://yourserver.yourcompany.com:customerportnumber

Username Enter the user name.

Password Enter and verify the password.

Verify Password

Validate Server Enable the Validate Server check box to validate the server certificate. Enabling this
option activates the Certificate tab.

Enable Server Enable this option to fetch endpoints from the server. Enabling this option activates
the Poll Status tab.

Bypass Proxy Enable this option to bypass the proxy server.

Table 1: Specifying Juniper Networks SRX Endpoint Context Server - Server Page Parameters
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Adding a Context Server Action to the Juniper SRX Server
Figure 670 displays the Juniper Network SRX Add Endpoint Context Server > Actions page:

Figure 670 Adding a Juniper Networks SRX Endpoint Context Server > Actions Page

Table 2 describes the endpoint context server actions that are available:

Endpoint Context Server Action Description

Juniper Networks SRX Login Endpoint Context Server action to send a user or device login context to
a Juniper SRX server.

Juniper Networks SRX Logout Endpoint Context Server action to send a user or device logout context
to a Juniper SRX server.

Table 2: Juniper Networks SRX Endpoint Context Server Actions

Viewing or Modifying Juniper Networks SRX Endpoint Context Server Actions
To view or modify the Juniper Networks SRX endpoint context server actions:

1. Navigate to Administration > Dictionaries > Context Server Actions.

The Endpoint Context Server Actions page opens.

2. Select the Juniper Networks SRX endpoint context server action of interest.

The Endpoint Context Server Details dialog for the selected action is displayed.
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Figure 671 Endpoint Context Server Details for the Juniper SRX Action

For descriptions of the parameters in the Endpoint Context Servers Details pages, refer to Configuring
Endpoint Context Server Actions.

3. If necessary, modify the parameters in the Action page, then click Save.

4. To specify a content type and add non-default context server attributes, select the Content tab.

Figure 672 shows the content of the Juniper Networks SRX Login action:

Figure 672 Content for the Juniper Networks SRX Login Action

Figure 673 shows the content of the Juniper Networks SRX Logout action:
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Figure 673 Content for the Juniper Networks SRX Logout Action

5. Make any necessary changes to the Content page, then click Save.

You return to the Endpoint Context Servers page, where the endpoint context server you added is now
listed.

Creating a Juniper SRX Enforcement Profile
This section describes how to create a Session Notification Enforcement profile named "Juniper SRX Notify"
that acts against the Juniper SRX Login action.

For details on configuring enforcement profiles, see Configuring Enforcement Profiles.

To create a Juniper SRX endpoint context server enforcement profile:

1. Navigate to Configuration > Enforcement > Profiles.

The Enforcement Profiles page opens.

Figure 674 Enforcement Profiles Page

2. Click the Add link.

The Add Enforcement Profiles dialog opens.
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Figure 675 Adding the Juniper SRX Enforcement Profile

3. Configure the Add Enforcement Profile page as follows:

Parameter Action/Description

Template Select Session Notification Enforcement.

Name Enter Juniper SRX Notify.

Description Optionally (recommended), enter a brief description of this enforcement profile.

Type When you select Session Notification Enforcement, the Profile Type is set to Post_
Authentication.

Table 3: Juniper Networks SRX Endpoint Enforcement Profile Settings

4. Click Next.

The Add Enforcement Profiles Attributes page opens.

In the following steps, you will add the four Session-Notify Enforcement Profile attributes illustrated in
Figure 676.

Figure 676 Adding Attributes to the Enforcement Profile

5. Select Click to add, then specify the Session-Notify attributes as described in the following table:
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Type Name Value

Session-Notify Server Type
Enter Juniper Networks SRX.

Session-Notify Server IP
Enter the IP address of the Juniper Networks SRX endpoint context
server.

Session-Notify Login Action Select Juniper Networks SRX Login.

Session-Notify Logout Action Select Juniper Networks SRX Logout.

Table 4: Adding Juniper SRX Endpoint Enforcement Profile Attributes

6. Click Save.

You return to the Enforcement Profiles page, where the Juniper Networks SRX Notify enforcement profile
is now listed.

Creating a Juniper SRX Enforcement Policy
This section describes how to create an enforcement policy to act against the "Juniper SRX Notify"
enforcement profile so that external devices can authenticate against this policy.

For details on configuring enforcement policies, see Configuring Enforcement Policies.

To create a Juniper SRX endpoint context server enforcement policy:

1. Navigate to Configuration > Enforcement > Policies.

The Enforcement Policies page opens.

2. Click Add.

The Add Enforcement Policies dialog opens.

Figure 677 Adding the Juniper SRX Enforcement Policy

3. Enter the following information:

a. Name: Enter Juniper SRX Enforcement Policy.

b. Description: Optionally, enter a description of this policy.

c. Enforcement Type: Set by default to RADIUS.

d. Default Profile: Select Deny Access Profile.

e. Click Next.

The Rules page opens.

4. Click Add Rule.

The Rules Editor dialog opens.

ClearPass 6.7 Policy Manager | User Guide Administration | 662
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1694



663 | Administration ClearPass 6.7 Policy Manager |  User Guide

Figure 678 Configuring Juniper SRX Enforcement Policy Rules

Specify Conditions

5. In the Conditions panel, select Click to add, then enter the conditions for the rule(s) pertinent to this
enforcement policy.

Specify the Enforcement Profile

6. In the Enforcement Profiles panel:

a. Click Select to Add.

b. Select [Post Authentication] Juniper SRX Notify.

7. Click Save.

8. To view the Juniper SRX enforcement policy summary, click the Summary tab.

Figure 679 Summary of the Juniper SRX Enforcement Policy

9. Check the summary information to make sure the enforcement policy is correct, make any changes if
necessary, then click Save.

You return to the Enforcement Policies page where the new Juniper SRX Policy is now listed.

Defining a Juniper SRX Wireless Service
This section describes how to create an 802.1X wireless service named "Juniper SRX Wireless Service" to be
applied to the "Juniper SRX Policy."

To create the Juniper SRX wireless service:

1. Navigate to Configuration > Services.

The Services page opens.
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2. Click Add.

The Add Services page opens.

Figure 680 Adding a Juniper SRX Wireless Service

3. Specify the following information:

a. Type: Select 802.1X Wireless.

b. Name: Enter Juniper SRX Wireless Service.

c. Description: Optionally, enter a description of this service.

d. In the Service Rule panel, set Matches to ANY, then click Next.

The Authentication page opens.

Figure 681 Specifying the Wireless Service Authentication Settings

4. In the Authentication tab, specify the following information:

a. Authentication Methods: Select the authentication method of choice.

If you need an authentication method not provided from the Select to Add list, click the Add new
Authentication Method link.

This example uses EAP MSCHAPv2 as the authentication method.

b. Authentication Sources: Click Select to Add, then select the authentication source(s).

This example uses [Local User Repository] [Local SQL DB] as the authentication source.

If you need an authentication source not provided from the Select to Add list, click the Add new
Authentication Source link.
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c. Strip Username Rules: Enable this check box to specify a comma-separated list of rules in which the
username or suffixes have been stripped. For example, if a username is username@domain.com or
domain\username, you can enable Strip Username Rules to strip off @domain.com or domain\.

d. Service Certificate: Optionally, specify the Service Certificate. If the Service Certificate parameter
is left empty, ClearPass picks the Service Certificate from the RADIUS/EAP Server Certificate.

For detailed information about the selected Service Certificate, click the View Certificate Details link.

5. Select the Enforcement tab.

Figure 682 Specifying the Enforcement Policy for the Juniper SRX Wireless Service

6. From the Enforcement Policy drop-down, select Juniper SRX Policy, then click Next.

The Juniper SRX Wireless Service Summary is displayed.

7. Check the service summary information to make sure the service is correct, make any changes if necessary,
then click Save.

You return to the Services page where you see the following message:

Service "Juniper SRX Wireless Service" has been added

Adding a JAMF Endpoint Context Server
To add a JAMF endpoint context server:

1. Navigate to Administration > External Servers > Endpoint Context Servers.

The Endpoint Context Servers page opens. This page lists the server name, server type, and status of the
currently configured endpoint context servers.

2. Click the Add link.

The Add Endpoint Context Server dialog opens.

3. From the Select Server Type drop-down, select JAMF.

The Add JAMF Endpoint Context Server dialog opens:

Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1697



Figure 683 Adding a JAMF Endpoint Context Server

You can add more than one endpoint context server of the same type.

4. Specify the Add Endpoint Context Server > JAMF parameters as described in the following table:

Parameter Action/Description

Select Server Type Choose JAMF from the drop-down list.

Server Name Enter a valid server name. You can enter an IP address or hostname.

Server Base URL Enter the full URL for the server. You can append a custom port, such as for an MDM
server: https://yourserver.yourcompany.com:customerportnumber.

Authentication Method Select one of the following authentication methods:

n Basic
n OAuth2: When you select OAuth2 or Both, the following fields are displayed:

l OAuth2 Client ID
l OAuth2 Client Secret
l OAuth2 Resource URL
l Validate OAuth2 Credentials: Validate button: When you click Validate,

ClearPass retrieves a bearer token in order to validate whether the OAuth
token server is reachable and the credentials are correct. If the credentials
are not correct, an error message is displayed.

Username Enter the username for the endpoint context server.

Password
Verify Password

Enter and verify the password for the endpoint context server.

Table 1: Specifying JAMF Endpoint Context Server Parameters
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Parameter Action/Description

Fetch Computer Records Enable to fetch computer records from the endpoint context server.

Validate Server Enable to validate the server certificate. Checking this option enables the Certificates
tab.

Enable Server Enable to fetch endpoints from the server.
The Bypass Proxy field is enabled when you enable this field.

Bypass Proxy Enable to bypass the proxy server.
When this field is enabled, the proxy servers configured in the Administration >
Server Manager > Server Configuration > Service Parameters tab > ClearPass
system services service page will be bypassed.
The server discovery occurs without any issues even when the proxy servers are
bypassed. By default, this field is disabled.

5. To save your changes, click Save .

Adding a MaaS360 Endpoint Context Server
To add a MaaS360 endpoint context server:

1. Navigate to Administration > External Servers > Endpoint Context Servers.

The Endpoint Context Servers page opens. This page lists the server name, server type, and status of the
currently configured endpoint context servers.

2. Click the Add link.

The Add Endpoint Context Server dialog opens.

3. From the Select Server Type drop-down, select MaaS360.

The Add MaaS360 Endpoint Context Server dialog opens:

Figure 684 Add MaaS360 Endpoint Context Server Dialog

You can add more than one endpoint context server of the same type.
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4. Specify the Add MaaS360 Endpoint Context Serverparameters as described in the following table:

Parameter Action/Description

Select Server Type Choose MaaS360 from the drop-down list.

Server Name Enter a valid server name. You can enter an IP address or hostname.

Server Base URL Enter the full URL for the server. You can append a custom port, such as for an MDM
server: https://yourserver.yourcompany.com:customerportnumber.

Authentication
Method

Select one of the following authentication methods:
n Basic
n OAuth2: When you select OAuth2 or Both, the following fields are displayed:

l OAuth2 Client ID
l OAuth2 Client Secret
l OAuth2 Resource URL
l Validate OAuth2 Credentials: Validate button: When you click Validate,

ClearPass retrieves a bearer token in order to validate whether the OAuth token
server is reachable and the credentials are correct. If the credentials are not
correct, an error message is displayed.

Username Enter the username for the endpoint context server.

Password
Verify Password

Enter and verify the password for the endpoint context server.

Application Access
Key

Enter the application access key (API key), then verify it.

Application ID Enter the application ID.

Application Version Enter the application version number.

Platform ID Enter the Platform ID.

Billing ID Enter the Billing ID.

Validate Server Enable to validate the server certificate. Checking this option enables the Certificates tab.

Enable Server Enable to fetch endpoints from the server.

Bypass Proxy Enable to bypass the proxy server.

Table 1: Add MaaS360 Endpoint Context Server Parameters
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Actions Page
The following figure displays the MaaS360 Endpoint Context Server Actions page:

Figure 685 MaaS360 Endpoint Context Server Actions Page

The following table shows the MaaS360 Endpoint Context Server Actions:

Endpoint Context Server Actions Description

Approve Device in Messaging System Approve the device in Messaging System.

Block Device in Messaging System Block the device in Messaging System.

Cancel Pending Wipe Cancel outstanding Remote Wipe sent to the device.

Change Device Policy Assign a given policy to a device.

Check Action Status Check the status of a prior executed action.

Locate Device Get current or last know location of the device.

Lock Device Lock the device.

Refresh Device Create a request to refresh the device information.

Remove Device Mark the device as inactive.

Reset Device Passcode Reset the pass code on the device.

Revoke Selective Wipe Cancel Selective Wipe executed on the device.

Table 2: MaaS360 Endpoint Context Server Actions
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Endpoint Context Server Actions Description

Search Action History Search action history by Device ID.

Selective Wipe Device Execute a Selective Wipe on a device.

Wipe Device Delete all information stored on a device.

Adding a MobileIron Endpoint Context Server
Consult MobileIron's documentation for more information about the parameters that you must enter to
configure this endpoint context server.

To add a MobileIron Endpoint Context Server:

1. Navigate to Administration > External Servers > Endpoint Context Servers.

The Endpoint Context Servers page opens.

2. Click Add.

The Add Endpoint Context Server dialog opens to the Server tab.

3. From the Select Server Type drop-down, select MobileIron.

Server Page
The following figure displays the MobileIron Add Endpoint Context Server > Server page:

Figure 686 Adding a MobileIron Endpoint Context Server > Server Page

You can add multiple endpoint context servers of the same type.

4. Enter the appropriate values for each of the MobileIron Add Endpoint Context Server parameters
described in Table 1.
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Parameters Action/Description

Select Server Type Choose MobileIron from the drop-down list.

Server Name Enter a valid server name. You can enter an IP address or host name.

Server Base URL Enter the full URL for the server. You can append a custom port, such as for an MDM
server: https://yourserver.yourcompany.com:customerportnumber

Authentication Method Select one of the following authentication methods:
n Basic
n OAuth2: When you select OAuth2 or Both, the following fields are displayed:

l OAuth2 Client ID
l OAuth2 Client Secret
l OAuth2 Resource URL
l Validate OAuth2 Credentials: Validate button: When you click Validate,

ClearPass retrieves a bearer token in order to validate whether the OAuth
token server is reachable and the credentials are correct. If the credentials
are not correct, an error message is displayed.

n Both: Selecting Both allows you to use both Basic and OAuth2 authentication.

Username Enter the username for the MobileIron endpont context server.

Password
Verify Password

Enter the password for the MobileIron endpoint context server, then verify the
password.

Validate Server Enable to validate the server certificate.
Checking this option enables the Certificate tab.

Enable Server Select the Enable to fetch endpoints from the server check box to enable the
endpoint context server. By default, this field is disabled. The Bypass Proxy field is
enabled when you enable this field.

Bypass Proxy You must enable the Enable Server parameter to enable the Bypass Proxy
parameter.
Select the Enable to bypass proxy server check box to bypass the proxy server.
When this field is enabled, the proxy servers configured in the Administration >
Server Manager > Server Configuration > Service Parameters tab > ClearPass
system services service page will be bypassed.
The server discovery occurs without any issues even when the proxy servers are
bypassed. By default, this field is disabled.

Table 1: Adding a MobileIron Endpoint Context Server > Server Page Parameters

5. When satisfied with the settings, click Save.
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Actions Page
The following figure displays the MobileIron Add Endpoint Context Server > Actions page:

Figure 687 Adding a MobileIron Endpoint Context Server > Actions Page

Table 2 describes the Endpoint Context Server Actions that are available:

Actions Action/Description

Apply Label to Device Appies label to identify when devices have attached to corporate Wi-Fi and apply
corresponding policies.

Get Labels Gets labels information of the device.

Lock Device Locks the device.

Remote Wipe Deletes all information stored on the device.

Remove Label from Device Removes label and corresponding policies.

Retire/ Enterprise Wipe
(Device MAC Address)

Deletes only corporate information stored and remove device from MDM
management.

Send Message Sends message to the device.

Send Push Notification (UUID) Sends Push Notification message using UUID:
n APNs for Apple iOS
n C2DM GCM for Google Android
n WNS for Windows 8.1

Table 2: Adding a MobileIron Endpoint Context Server > Actions
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Actions Action/Description

Send SMS (UUID) Sends SMS Message (cellular devices only) using UUID

Unlock Device Unlocks the device.

Wake-up Device (Device MAC
Address)

Sends wake-up to device, request check-in.

Wake-up Device (UUID) Sends wake-up to device, request check-in.

6. Click Save.

Endpoints fetched from a MobileIron MDM server will have the Compliance attribute set to True if the device is
compliant. If the device is not compliant, theCompliance attribute is set to False.

Integrating ClearPass with Palo Alto Networks Firewall Endpoint Context Server
This feature provides admins with the ability to customize the context server action content for Palo Alto
Networks Firewall endpoint context servers.

Integrating ClearPass with Palo Alto Networks Firewall endpoint context servers typically tags the username
context, as well as the external devices being authenticated, along with its respective MAC address, which
further simplifies IP address management on the Palo Alto Networks Firewall endpoint context server side.

This section describes the configurations that you must make on the ClearPass server in order for the ClearPass
server to send data to a Palo Alto Networks Firewall endpoint context server.

This section provides the following information:

n Adding a Palo Alto Networks Firewall Endpoint Context Server

n Creating a Palo Alto Networks Firewall Enforcement Profile

n Creating a Palo Alto Networks Firewall Enforcement Policy

n Defining a Palo Alto Networks Firewall Wireless Service

Adding a Palo Alto Networks Firewall Endpoint Context Server
Consult Palo Alto Networks' documentation for more information about the parameters that you must enter
to configure this endpoint context server.

To add a Palo Alto Networks Firewall endpoint context server:

1. Navigate to Administration > External Servers > Endpoint Context Servers.

The Endpoint Context Servers page opens. This page lists the server name, server type, and status of the
currently configured endpoint context servers.

2. Click the Add link.

The Add Endpoint Context Server dialog opens.

3. From the Select Server Type drop-down, select Palo Alto Networks Firewall.
The following dialog is displayed (see Figure 688).
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Figure 688 Add Endpoint Context Server > Palo Alto Networks Firewall > Server Dialog

You can add multiple endpoint context servers of the same type.

4. Enter the appropriate values for each of the Palo Alto Networks Firewall > Add Endpoint Context
Server parameters described in Table 1.

Parameter Action/Description

Select Server Type Choose Palo Alto Networks Firewall from the drop-down.

Server Name Enter the IPv4 or IPv6 address/hostname of the Palo Alto Networks server.

Server Base URL Enter the server base URL in the following format:
https://{server_ip}/api/?type=keygen&user={username}&password={password}

Authentication Method Select one of the following authentication methods:
n Basic
n OAuth2: When you select OAuth2 or Both, the following fields are displayed:

l OAuth2 Client ID
l OAuth2 Client Secret
l OAuth2 Resource URL
l Validate OAuth2 Credentials: Validate button: When you click Validate,

ClearPass retrieves a bearer token in order to validate whether the OAuth
token server is reachable and the credentials are correct. If the
credentials are not correct, an error message is displayed.

n Both: Selecting Both allows you to use both Basic and OAuth2 authentication.

Username Enter the username.

Password Enter the password, then verify the password.

Table 1: Add Endpoint Context Server > Palo Alto Networks Firewall Parameters
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Parameter Action/Description

Username Transformation Choose one of the following options:
n None: Do not use any username transformation.
n Prefix NetBIOS name: Use the Prefix NetBIOS name in UID updates.
n Use Full Username: Use the full username in UID updates.

Validate Server Select this check box to validate the server certificate. Checking this option enables
the Certificate tab.

IP Version Specify the IP version:
n IPv4
n IPv6
n Both

5. When satisfied with the settings, click Save.

Add Endpoint Context Server > Actions Page
When you select the Add Endpoint Context Server > Actions tab, the Actions page lists the set of server
actions that can be performed on the Palo Alto Networks Firewall endpoint context server. The server actions
that are displayed in the Actions page vary depending on which Server Type you select.

Figure 689 Default Palo Alto Networks Firewall Endpoint Context Server Actions
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The following table describes the endpoint context server actions that are available for the Palo Alto Networks
Firewall endpoint context server:

Endpoint Context Server
Action Description

Register Device Registers device category information.

Unregister Device Unregisters device category information.

Register Posture Registers posture status for the endpoint.
NOTE: The Register Posture endpoint context server action requires that the
Eager handler polling frequency parameter must be 120 seconds or more.
To configure this parameter:

1. Navigate to Administration >Server Manager > Server Configuration.
2. From the list of ClearPass server, select the Publisher node, then select
the Service Parameters tab.
3. From the Select Service drop-down, select the Async network services
service (which is selected by default).
4. In the Post Auth section, set the Eager handler polling frequency
parameter to a value 120 seconds or more, then click Save.

Unregister Posture Unregisters posture status for the endpoint.

Register Role Registers Role information for the user.

Unregister Role Unregisters Role information for the user.

Send HIP Report (Global
Protect)

Sends HIP (Host Information Profiles) report data for the user enabled by the
GlobalProtect feature on the Palo Alto Networks Firewall endpoint context
server.
NOTE: You must enable the GlobalProtect license on the firewall for this to be
operable.

Send Login Info Sends login Information for the user.

Send Logout Info Sends logout Information for the user,

Table 2: Palo Alto Networks Firewall Endpoint Context Server Actions

Adding the Endpoint Repository as an Authorization Source
For this feature to work properly, the Endpoint Repository must be added as an authorization source and one
of the Profile attributes must be enabled as Role.

To add the Endpoint Repository as an authorization source:

1. Navigate to Configuration > Authentication > Sources.

The Authentication Sources page is displayed.

2. Select [Endpoints Repository].
3. From the Authentication Sources - [Endpoints Repository] page, select the Attributes tab.
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Figure 690 Authentication Sources - [Endpoints Repository] Page

Creating a Palo Alto Networks Firewall Enforcement Profile
This section describes how to create a session-notification enforcement profile named "Palo Alto Networks
Firewall Notify." For details on configuring enforcement profiles, see Configuring Enforcement Profiles.

In ClearPass and Palo Alto Networks integration, a logout action must be configured in the enforcement profile. If
there is no logout action configured in the enforcement profile, endpoint information is not removed from the refresh
list. In this case, ClearPass will keep sending login updates (refresh events), even when the client is disconnected
from the network.
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To create a Palo Alto Networks Firewall enforcement profile:

1. Navigate to Configuration > Enforcement > Profiles.

The Enforcement Profiles page opens.

Figure 691 Enforcement Profiles Page

2. Click the Add link.

The Add Enforcement Profiles dialog opens.

Figure 692 Adding the Palo Alto Networks Firewall Enforcement Profile

3. Configure the Add Enforcement Profile page as follows:

Parameter Action/Description

Template Select Session Notification Enforcement.

Name Enter Palo Alto Networks Firewall Notify Profile.

Description Optionally (recommended), enter a brief description of this enforcement profile.

Type When you select Session Notification Enforcement, the Profile Type is set to Post_
Authentication.

Table 3: Palo Alto Networks Endpoint Enforcement Profile Settings
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4. Click Next.

The Add Enforcement Profiles Attributes page opens.

In the following steps, you will add the Session-Notify Enforcement Profile attributes illustrated in Table 4.

5. Select Click to add, then specify the Session-Notify attributes as described in Table 4:

Type Name Value

Session-Notify Server Type
Enter Palo Alto Networks Firewall.

Session-Notify Server IP
Enter the IP address of the Palo Alto Networks endpoint context
server.

Session-Notify Login Action Select Send Login Info.

Session-Notify Login Action Select Register Device.

Session-Notify Login Action Select Send HIP Report (Global Protect).

Session-Notify Login Action Select Register Role.

Session-Notify Login Action Select Register Posture.

Session-Notify Logout Action Select Unregister Role.

Session-Notify Logout Action Select Unregister Device.

Session-Notify Logout Action Select Unregister Posture.

Session-Notify Logout Action Select Send Logout Info.

Table 4: Adding Palo Alto Networks Firewall Endpoint Enforcement Profile Attributes

Figure 693 Palo Alto Networks Firewall Enforcement Profile Attributes Entered into Profile

6. Click Save.
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You return to the Enforcement Profiles page, where the new Palo Alto Networks Notify enforcement
profile is now listed.

Creating a Palo Alto Networks Firewall Enforcement Policy
This section describes how to create an enforcement policy to act against the "Palo Alto Networks Firewall
Notify" enforcement profile so that external devices can authenticate against this policy.

For details on configuring enforcement policies, see Configuring Enforcement Policies.

To create a Palo Alto Networks Firewall endpoint context server enforcement policy:

1. Navigate to Configuration > Enforcement > Policies. The Enforcement Policies page opens.

2. Click the Add link.

The Add Enforcement Policies dialog opens.

Figure 694 Adding the Palo Alto Networks Firewall Enforcement Policy

3. Enter the following information:

a. Name: Enter Palo Alto Networks Firewall Enforcement Policy.

b. Description: Optionally, enter a description of this policy.

c. Enforcement Type: Set by default to RADIUS.

d. Default Profile: Select Deny Access Profile.

e. Click Next. The Rules page opens.

4. Click Add Rule.

The Rules Editor dialog opens.

Figure 695 Specifying the Enforcement Profile
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5. In the Conditions panel, select Click to add, then enter the conditions for the rule(s) pertinent to this
enforcement policy.

6. In the Enforcement Profiles panel:

a. Click Select to Add.

b. Select [Post Authentication] Palo Alto Networks Firewall Notify Profile.

7. Click Save.

8. To view the enforcement policy summary, click the Summary tab.

Figure 696 Summary of the Enforcement Policy

Defining a Palo Alto Networks Firewall Wireless Service
This section describes how to create an 802.1X wireless service named "Palo Alto Networks Wireless Service" to
be applied to the "Palo Alto Networks Firewall Enforcement Policy."

To create the Palo Alto Networks wireless service:

1. Navigate to Configuration > Services. The Services page opens.

2. Click the Add link.

The Add Services page opens.

Figure 697 Adding a Palo Alto Networks Wireless Service

3. In the Service tab, specify the following information:

a. Type: Select 802.1X Wireless.

b. Name: Enter Palo Alto Networks Wireless Service.

c. Description: Optionally, enter a description of this service.
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d. In the Service Rule panel, set Matches to ANY, then click Next. The Authentication page opens.

Figure 698 Specifying the Wireless Service Authentication Settings

4. In the Authentication tab, specify the following information:

a. Authentication Methods: Select the authentication method of choice.

If you need an authentication method not provided from the Select to Add list, click the Add new
Authentication Method link.

This example uses EAP MSCHAPv2 as the authentication method.

b. Authentication Sources: Click Select to Add, then select the authentication source(s).

This example uses [Local User Repository] [Local SQL DB] as the authentication source.

If you need an authentication source not provided from the Select to Add list, click the Add new
Authentication Source link.

c. Strip Username Rules: Enable this check box to specify a comma-separated list of rules in which the
username or suffixes have been stripped. For example, if a username is username@domain.com or
domain\username, you can enable Strip Username Rules to strip off @domain.com or domain\.

d. Service Certificate: Optionally, specify the Service Certificate. If the Service Certificate parameter
is left empty, ClearPass picks the Service Certificate from the RADIUS Server/EAP Certificate.

For detailed information about the selected Service Certificate, click the View Certificate Details link.

5. Select the Enforcement tab.

Figure 699 Specifying the Enforcement Policy for the Palo Alto Networks Wireless Service

6. From the Enforcement Policy drop-down, select Palo Alto Networks Enforcement Policy, then click
Next.
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The Palo Alto Networks Wireless Service Summary is displayed.

Figure 700 Summary of the Palo Alto Networks Wireless Service

7. Check the service summary information to make sure the service is correct, make any changes if necessary,
then click Save.

You return to the Services page where you see the following message:

Service "Palo Alto Networks Wireless Service" has been added

Adding a Palo Alto Networks Panorama Endpoint Context Server
Consult Palo Alto Networks' documentation for more information about the parameters that you must enter
to configure this endpoint context server.

To add a Palo Alto Networks Panorama endpoint context server:

1. Navigate to Administration > External Servers > Endpoint Context Servers.

The Endpoint Context Servers page opens.

2. Click Add.

The Add Endpoint Context Server dialog opens.

3. From the Select Server Type drop-down, select Palo Alto Networks Panorama.

The following dialog is displayed:
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Figure 701 Add Endpoint Context Server > Palo Alto Networks Panorama Dialog

You can add more than one endpoint context server of the same type. For example, you can add more than one Palo
Alto Networks endpoint context server.

4. Enter the appropriate values for each of the Palo Alto Networks Panorama > Add Endpoint Context
Server parameters described in Table 1.

Parameter Description

Select Server Type Choose Palo Alto Networks Panorama from the drop-down list.

Server Name Enter a valid server name. You can enter an IP address or hostname.

Server Base URL Enter the server base URL in the following format: https://{server_
ip}/api/?type=keygen&user={username}&password={password}

Authentication Method Select one of the following authentication methods:
n Basic
n OAuth2: When you select OAuth2 or Both, the following fields are

displayed:
l OAuth2 Client ID
l OAuth2 Client Secret
l OAuth2 Resource URL
l Validate OAuth2 Credentials: Validate button: When you click

Validate, ClearPass retrieves a bearer token in order to validate
whether the OAuth token server is reachable and the credentials
are correct. If the credentials are not correct, an error message is
displayed.

n Both: Selecting Both allows you to use both Basic and OAuth2
authentication.

Table 1: Add Endpoint Context Server > Palo Alto Networks Panorama Parameters
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Parameter Description

Username Enter the username.

Password Enter and verify the password for this server.

Username Transformation Choose one of the following options:
n None: Do not use any username transformation.
n Prefix NetBIOS name: Prefix NetBIOS name in UID updates.
n Use Full Username: Use full username in UID updates.

Palo Alto Firewall Serial Numbers Enter the Palo Alto firewall serial numbers.

Validate Server Click this check box to validate the server certificate. Checking this option
enables the Certificate tab.

IP Version Specify the IP version:
n IPv4
n IPv6
n Both

5. When satisfied with the settings, click Save.

Using the ClearPass Configuration API to Load Endpoint Context Servers
If you use the ClearPass Configuration API to load Palo Alto Networks endpoint context servers, you should
include the following attributes in the XML file:

n PA_Panorama_RegisterDevice

n PA_Panorama_SendRoles

Adding a SAP Afaria Endpoint Context Server
Consult SAP Afaria's documentation for additional information about the parameters that you must enter to
configure this endpoint.

To add a SAP Afaria Endpoint Context server:

1. Navigate to Administration > External Servers > Endpoint Context Servers.

The Endpoint Context Servers page opens.

2. Click Add.

The Add Endpoint Context Server dialog opens to the Server tab.

3. From the Select Server Type drop-down, select SAP Afaria.
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Server Tab
The following figure displays the Add Endpoint Context Server > Server page:

Figure 702 Add Endpoint Context Server > Server Page

You can add more than one endpoint context server of the same type.

The following table describes the Add SAP Afaria Endpoint Context Server parameters:

Parameter Action/Description

Select Server Type Choose SAP Afaria from the drop-down list.

Server Name Enter a valid server name. You can enter an IP address or a hostname.

Server Base URL Enter the full URL for the server. You can append a custom port, such as for an MDM
server: https://yourserver.yourcompany.com:customerportnumber.

Authentication Method Select one of the following authentication methods:
n Basic
n OAuth2: When you select OAuth2 or Both, the following fields are displayed:

l OAuth2 Client ID
l OAuth2 Client Secret
l OAuth2 Resource URL
l Validate OAuth2 Credentials: Validate button: When you click Validate,

ClearPass retrieves a bearer token in order to validate whether the OAuth
token server is reachable and the credentials are correct. If the credentials
are not correct, an error message is displayed.

n Both: Selecting Both allows you to use both Basic and OAuth2 authentication.

Username Enter the username.

Password Enter the server password, then verify the password.

Table 1: Add SAP Afaria Endpoint Context Server > Server Page Parameters
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Parameter Action/Description

Verify Password

Validate Server Enable to validate the server certificate. Checking this option enables the Certificate
tab.

Enable Server Enable this parameter to fetch endpoints from the server.
When you enable the Enable Server parameter, you enable the Bypass Proxy
parameter.

Bypass Proxy Select the Enable to bypass proxy server check box to bypass the proxy server.
When this field is enabled, the proxy servers configured in the Administration >
Server Manager > Server Configuration > Service Parameters tab > ClearPass
system services service page will be bypassed.
The server discovery occurs without any issues even when the proxy servers are
bypassed. By default, this field is disabled.

Actions Tab
The following figure displays the Add SAP Afaria Endpoint Context Server > Actions page:

Figure 703 Add SAP Afaria Endpoint Context Server > Actions Page

The following table describes the Add SAP Afari Endpoint Context Server > Actions:

Parameter Description

Enterprise Wipe Deletes only corporate information.

Lock Device Locks the associated device.

Remote Wipe Deletes all stored information.

Send Message Sends a message to the device.

Table 2: Add SAP Afaria Endpoint Context Server > Actions

Adding a SOTI Endpoint Context Server
Consult the SOTI MobiControl endpoint documentation for additional information about the parameters that
you must enter to configure this endpoint.

To add a SOTI Endpoint Context server:
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1. Navigate to Administration > External Servers > Endpoint Context Servers.

The Endpoint Context Servers page opens.

2. Click Add.

The Add Endpoint Context Server dialog opens.

3. From the Select Server Type drop-down, select SOTI.
The SOTI Add Endpoint Context Server dialog opens:

Figure 704 Adding a SOTI Endpoint Context Server

You can add more than one endpoint context server of the same type.

4. Specify the SOTI Add Endpoint Context Server parameters as described in the following table:

Parameter Action/Description

Select Server Type Choose SOTI from the Select Server Type drop-down list.

Server Name Enter a valid server name. You can enter an IP address or a hostname.

Server Base URL Enter the complete URL for the SOTI server.
You can append a custom port, such as for an MDM server:
https://yourserver.yourcompany.com:customerportnumber

Authentication Method Select one of the following authentication methods:
n Basic
n OAuth2: When you select OAuth2 or Both, the following fields are displayed:

l OAuth2 Client ID
l OAuth2 Client Secret
l OAuth2 Resource URL
l Validate OAuth2 Credentials: Validate button: When you click Validate,

ClearPass retrieves a bearer token in order to validate whether the OAuth

Table 1: Adding a SOTI Endpoint Context Server > Server Parameters
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Parameter Action/Description

token server is reachable and the credentials are correct. If the credentials
are not correct, an error message is displayed.

n Both: Selecting Both allows you to use both Basic and OAuth2 authentication.

Username Enter the username for the SOTI server.

Password
Verify Password

Enter the password for the SOTI server, then verify it.

Group ID Optionally, enter the group ID.

Validate Server To validate the server certificate, enable Validate Server.
Enabling this option enables the Certificate tab.

Enable Server Select the Enable to fetch endpoints from the server check box to enable the
endpoint context server. By default, this field is disabled. The Bypass Proxy field is
enabled when you enable this field.

Bypass Proxy You must enable the Enable Server parameter to enable the Bypass Proxy
parameter.
Select the Enable to bypass proxy server check box to bypass the proxy server.
When this field is enabled, the proxy servers configured in the Administration >
Server Manager > Server Configuration > Service Parameters tab > ClearPass
system services service page will be bypassed.
The server discovery occurs without any issues even when the proxy servers are
bypassed. By default, this field is disabled.

5. To save your changes, click Save.

Adding a XenMobile Endpoint Context Server
Consult the endpoint manufacturer's documentation for information about the parameters that you must
enter to configure this endpoint.

To add a XenMobile Endpoint Context server:

1. Navigate to Administration > External Servers > Endpoint Context Servers.

The Endpoint Context Servers page opens.

2. Click Add.

The Add Endpoint Context Server dialog opens.

3. From the Select Server Type drop-down, select XenMobile.

The XenMobile Add Endpoint Context Server > Server page opens:
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Figure 705 Add XenMobile Endpoint Context Server Page

You can add more than one endpoint context server of the same type.

4. Specify the Add Endpoint Context Server parameters as described in the following table:

Parameter Description

Select Server Type Choose XenMobile from the drop-down list.

Server Name Enter a valid server name. You can enter an IP address or hostname.

Server Base URL Enter the server base URL in the following format: https://{server_
ip}/api/?type=keygen&user={username}&password={password}

Authentication Method Select one of the following authentication methods:
n Basic
n OAuth2: When you select OAuth2 or Both, the following fields are displayed:

l OAuth2 Client ID
l OAuth2 Client Secret
l OAuth2 Resource URL
l Validate OAuth2 Credentials: Validate button: When you click Validate,

ClearPass retrieves a bearer token in order to validate whether the OAuth
token server is reachable and the credentials are correct. If the credentials
are not correct, an error message is displayed.

n Both: Selecting Both allows you to use both Basic and OAuth2 authentication.

Username Enter the username to log in to the XenMobile server.

Password
Verify Password

Enter the password to the XenMobile server, then verify the password.

Table 1: Add Endpoint Context Server - Server (XenMobile) Tab Parameters

ClearPass 6.7 Policy Manager | User Guide Administration | 690
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1722



691 | Administration ClearPass 6.7 Policy Manager |  User Guide

Parameter Description

Validate Server Enable to validate the server certificate. Checking this option enables the Certificate
tab.

Enable Server Select the Enable to fetch endpoints from the server check box to enable the
endpoint context server. By default, this field is disabled. The Bypass Proxy field is
enabled when you enable this field.

Bypass Proxy You must enable the Enable Server parameter to enable the Bypass Proxy
parameter.
Select the Enable to bypass proxy server check box to bypass the proxy server.
When this field is enabled, the proxy servers configured in the Administration >
Server Manager > Server Configuration > Service Parameters tab > ClearPass
system services service page will be bypassed.
The server discovery occurs without any issues even when the proxy servers are
bypassed. By default, this field is disabled.
.

File Backup Servers
ClearPass Policy Manager provides the ability to push scheduled data securely to an external server. You can
push the data using the SFTP and SCP protocols. Navigate to the Administration > External Servers > File
Backup Servers page and click the Add link at the top-right corner. The Add File Backup Server page opens.
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The following figure displays the Add File Backup Server page:

Figure 706 File Backup Servers - Add File Backup Server Page

The following table describes the Add File Backup Server page parameters:

Parameter Description

Host Enter the name or IP address of the host.

Description Enter the description that provides additional information about the File Backup server.

Protocol Specify the protocol to be used to upload the generated reports to an external server. You can
select from the following protocols:
n SFTP  (SSH File Transfer Protocol)
n SCP (Session Control Protocol)

Port Specify the port number. The default port is 22.

Username Enter the user name and password of the host server.

Password Enter the user name of the host server.

Table 1: Add File Backup Server Page Parameters
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Parameter Description

Verify Password Enter the password of the host server.

Timeout Specify the timeout value in seconds. The default value is 30 seconds.

Remote
Directory

Specify the location in this field to which the files to be copied. A folder will be automatically
created in the file path that you specify based on the selected ClearPass servers in the
ClearPass Servers field.

ClearPass
Servers

Specify the ClearPass servers. If a servers are specified, files will only be backed up from the
selected ClearPass servers. Otherwise, it will be backed up from all ClearPass servers in the
cluster. You can select the servers from the Select to Add drop-down list.

Certificate Store
This section describes the following topics:

n About the Certificate Store

n Viewing the Server Certificates

n Creating and Installing a Self-Signed Server Certificate

n Creating a Certificate Signing Request

n Importing a Server Certificate

n Exporting a Server Certificate

n Service Certificates

About the Certificate Store
ClearPass Policy Manager supports multiple RADIUS server certificates. You can tie different server certificates
to different ClearPass services (for example, Service A can use RADIUS/EAP server certificate A, while Service B
can use RadSec server certificate B).

The Certificate Store allows you to view the Server Certificates, create, modify, delete, and view Certificate
Signing Requests (CSRs), as well as import and export CSRs.

A root certificate is a public key certificate that identifies a root certificate authority (CA). A root certificate is the
top-most certificate of the certificate tree structure.

Viewing the Server Certificates
n RADIUS/EAP Server Certificate

n HTTPS Server Certificate

n RadSec Server Certificate

The Server Certificates page displays the parameters configured when a self-signed certificate has been
created and installed on a ClearPass server. The RADIUS/EAP Server Certificate is selected by default.

The ClearPass Certificate Store provides three types of server certificates.

n RADIUS/EAP Server Certificate
n HTTPS Server Certificate
n RadSec Server Certificate

The availability of three certificate types (internally signed and publicly signed) provides deployment flexibility.
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To view the Server Certificates available for the current ClearPass server:

1. Navigate to Administration > Certificates > Certificate Store.

The Certificate Store page opens to the Server Certificate tab:

Figure 707 Certificate Store > Server Certificates Page

RADIUS/EAP Server Certificate
The following table provides a summary of the RADIUS/EAP Server Certificate parameters:

Parameter Description

Select Server Select a ClearPass server in the cluster for server certificate operations.
NOTE: From the Publisher node, you can select the Publisher or any of the
Subscriber nodes.

Select Type Select RADIUS/EAP Server Certificate.

Subject Displays the Organization and Common Name.

Issued by Displays the Organization and Common Name that issued this certificate.

Issue Date Displays the date the self-signed certificate is installed.

Expiry Date Displays the date (in days) when the self-signed certificate expires.

Validity Status Displays the validity status of the self-signed certificate: Valid or Invalid.

Table 1: Summary of RADIUS/EAP Server Certificate Parameters

Viewing Server Certificate Details

Click the View Details button to view details about the certificate, such as signature algorithm, subject public
key Info, etc.

To view the Server Certificate details:

1. Navigate to Administration > Certificates > Certificate Store.
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The Server Certificate summary information is displayed.

2. Click View Details.

The Certificate Details window opens.

Figure 708 Server Certificate Details

3. When finished viewing the information, click Close.

HTTPS Server Certificate
The HTTPS Server Certificate page displays the parameters configured after a self-signed certificate with an
HTTPS Server Certificate has been created and installed.

With an HTTPS connection, all communications are securely encrypted. The major benefits of an HTTPS
certificate are:

n Customer information (such as credit card numbers) is encrypted and cannot be intercepted.

n Visitors can verify you are a registered business and that you own the domain.

n Customers are more likely to trust and complete transactions from sites that use HTTPS.

To access the HTTPS Server Certificate:

1. Navigate to the Administration > Certificate Store > Server Certificates tab.

2. From the Select Type drop-down, choose HTTPS Server Certificate.

The HTTPS Server Certificate page opens.
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Figure 709 HTTPS Server Certificate Page

The following table describes the HTTPS Server Certificate parameters:

Parameter Description

Select Server Select a ClearPass server in the cluster for server certificate operations.

Select Type Select HTTPS Server Certificate .

Subject Displays the Organization and Common Name.

Issued by Displays the Organization and Common Name that issued the server certificate.

Issue Date Displays the date the self-signed certificate is installed.

Expiry Date Displays the date when the self-signed certificate expires.

Validity Status Displays the validity status of the self-signed certificate.

Details To view details about the certificate, such as Signature Algorithm and Subject
Public Key Info, click the View Details button.

Table 2: HTTPS Server Certificate Parameters

RadSec Server Certificate
RADIUS-over-TLS (Transport Layer Security), or RadSec, employs a TLS tunnel to enable secure communication
between the controller and a ClearPass server.

Employing RADIUS communication over TLS increases the level of security for authentication. When
configured, the RadSec protocol is used to safely transmit authentication and accounting data across the
network.

To access the RadSec Server Certificate:

1. Navigate to the Administration > Certificate Store > Server Certificates tab.

2. From the Select Type drop-down, choose RadSec Server Certificate.

The RadSec Server Certificate page opens.
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Figure 710 RadSec Server Certificate Page

The following table describes the RadSec Server Certificate parameters:

Parameter Description

Select Server Select a ClearPass server in the cluster for server certificate operations.

Select Type Select RadSec Server Certificate.

Subject Displays the Organization and Common Name.

Issued by Displays the Organization and Common Name that issued this certificate.

Issue Date Displays the date the self-signed certificate is installed.

Expiry Date Displays the date (in days) when the self-signed certificate expires.

Validity Status Displays the validity status of the self-signed certificate: Valid or Invalid.

Table 3: Summary of RadSec Server Certificate Parameters

Creating and Installing a Self-Signed Server Certificate
After you select a server and a certificate type, you can create and install a self-signed server certificate.

When Common Criteria mode is enabled, the Create-Self Signed Certificate option for both HTTPS and RADIUS
certificates is not available from the Certificate Store page (for more information, see Common Criteria Mode
Parameter).

Creating a Self-Signed Server Certificate
To create a self-signed server certificate:

1. Navigate to Administration > Certificates > Certificate Store.

2. Select a server.

3. Click the Create Self-Signed Certificate link.

The Create Self-Signed Certificate dialog opens.
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Figure 711 Creating a Self-Signed Server Certificate

4. Configure the Create Self-Signed Certificate parameters as described in Table 1.

Parameter Action/Description

Certificate Type Select Server Certificate.

Server Displays the name of the selected ClearPass server on the Certificate Store
page.

Type Displays the selected certificate type for the server on the Certificate Store
page.

Common Name (CN) Enter the name associated with this entity. This can be a host name, IP
address, or other meaningful name. This field is mandatory.

Organization (O) Enter the name of the organization. This field is optional.

Organizational Unit
(OU)

Enter the name of the department, division, section, or other meaningful
name. This field is optional.

Location (L)
State (ST)
Country (C)

Enter the name of the location, state, country, and/or other meaningful
location information. These fields are optional.

Subject Alternate
Name (SAN)

Enter the alternative name for the specified Common Name. This field is
optional.
Enter the Subject Alternate Name in one of the following formats:

l email: email_address
l URI: uri
l IP: ip_address
l dns: dns_name
l rid: id

Table 1: Specifying Self-Signed Server Certificate Parameters
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Parameter Action/Description

Private Key Password Enter the Private Key password, then verify the password.

Private Key Type Select the length for the generated private key types from the following
options:

l 1024-bit RSA
l 2048-bit RSA
l 4096-bit RSA
l X9.62/SECG curve over a 256 bit prime field
l NIST/SECG curve over a 384 bit prime field

The default private key type is 2048-bit RSA.

Digest Algorithm Select the message digest algorithm from the following options:
l MD5
l SHA-1
l SHA-224
l SHA-256
l SHA-384
l SHA-512

NOTE: The MD5 algorithm is not available in FIPS mode.

Valid for Enter the certificate duration in number of days. The default is 180 days.

5. Click Submit.

The Create Self-Signed Certificate dialog opens (as shown in Figure 712 below).

Installing a Self-Signed Server Certificate
This page displays a summary of the values specified in the Create Self-Signed Certificate page and provides
the Install button to install the self-signed certificate.

1. Check the summary values for the Self-Signed Server Certificate.

Figure 712 Create Self-Signed Certificate Page

2. Click Install.
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After you click Install, you return to the Certificate Store page and Policy Manager generates a message
about the status of the certificate installation.

If the installation is successfu,l the page displays the message:

Server Certificate updated successfully.

Figure 713 Server Certificate Successfully Updated

3. Because all services are restarted after a successful certificate installation, you must click the Logout link,
then log in to the ClearPass client to continue.

Creating a Certificate Signing Request
After you select a certificate type (Server Certificate or Service Certificate), you can create a certificate
signing request (CSR).

When you generate certificate signing request, the Private Key is automatically stored on the current ClearPass
server. Thus, you can then upload (import) the certificate alone, without having to include the Private Key in
the import process.

To create a certificate signing request:

1. Navigate to Administration > Certificates > Certificate Store.

The Server Certificates tab is selected.

2. Click the Create Certificate Signing Request link.

The Create Certificate Signing Request dialog opens:

Figure 714 Create Certificate Signing Request Dialog
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3. Specify the Create Certificate Signing Request parameters as described in Table 1, then click Submit.

Parameter Action/Description

Common Name (CN) Enter the name associated with this entity. This field is mandatory.
This can be a host name, IP address, or other name.
The default is the fully-qualified domain name (FQDN).

Organization (O) Optionally, enter the name of the organization.

Organizational Unit (OU) Optionally, enter the name of the department, division, section, or other
meaningful name.

Location (L)
State (ST)
Country (C)

Optionally, enter the name of the location, state, country.

Subject Alternate Name
(SAN)

Optionally, enter the alternative names for the specified Common Name
in one of the following formats:

l email: email_address
l URI: uri
l IP: ip_address
l dns: dns_name
l rid: id

Private Key Password
Verify Private Key
Password

Enter the private key password, then verify it.

Private Key Type Select the length for the generated private key types from the following
options:

l 1024-bit RSA
l 2048-bit RSA. This is the default.
l 4096-bit RSA
l X9.62/SECG curve over a 256 bit prime field
l NIST/SECG curve over a 384 bit prime field

Digest Algorithm Select the message digest algorithm from the following options:
l SHA-1
l SHA-224
l SHA-256
l SHA-384
l SHA-512. This is the default.

Table 1: Create Certificate Signing Request Parameters

4. Click Submit.

The generated certificate signing request is displayed.
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Figure 715 Certificate Signing Request Generated

Note that the Private Key is automatically stored on the current ClearPass server. You can then upload
(import) the certificate without having to include the Private Key as part of the import process (for related
information, see Importing a Server Certificate).

5. Copy the certificate signing request content and paste it into the Web form as part of the enrollment
process.

6. To save and download the Certificate Signing Request file, click Download CSR.

Importing a Server Certificate
When you import the server certificate, you are provided with three upload options:

n Upload Certificate and Use Saved Private Key: This option allows the admin to upload only the
certificate. The server certificate is then matched against the private key saved on the ClearPass server.

n Upload PKCS#12 Certificate (.pfx or .p12 only): With this option, the admin uploads the PKCS#12 file
and provides a pass phrase.

n Upload Certificate and Private Key Files: The admin can choose to upload the private key file and
password along with the server certificate file.

To import a server certificate into the current ClearPass server:

1. Navigate to Administration > Certificates > Certificate Store.

2. From the Server Certificates tab, click the Import Certificate link.

The Import Certificate dialog opens:
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Figure 716 Import Server Certificate Dialog

For security reasons, certificates signed using SHA1RSA are not recommended. Importing certificates signed with
stronger keys, such as RSA with a length of more than 1024 bits, is recommended.

ClearPass does not support importing the HTTPS Server Certificate chain or RADIUS/EAP Server Certificate chain in
P7b Base64 format. A P7B file contains only certificates and chain certificates (intermediate certificate authorities),
not the private key.

3. Specify the Import Certificate parameters as described in the following table:

Parameter Action/Description

Certificate Type Select Server Certificate (selected by default).

Server Select the name of the ClearPass server that the server certificate will be
imported into.
NOTE: When importing a certificate to a Subscriber node from the Publisher
node, in the Server field, select the Subscriber node.

Type Select one of the following server certificate types:
n RADIUS/EAP Server Certificate
n HTTPS Server Certificate
n RadSec Server Certificate

Upload Method Select one of the following methods to upload the certificate:
n Upload Certificate and Use Saved Private Key

This option allows the administrator to upload only the certificate. The
certificate is then matched against the private key saved on the ClearPass
server.

n Upload PKCS#12 Certificate (.pfx or .p12 only)
With this option, the administrator uploads the PKCS#12 file and provides
a pass phrase.

n Upload Certificate and Private Key Files
The administrator can choose to upload the private key file and password

Table 1: Import Server Certificate Parameters
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Parameter Action/Description

along with the certificate file.

Certificate File Browse to the certificate file to be imported.
NOTE: Both certificates with a wild card as the common name and Extended
Validation certificates are not recommended for use as the RADIUS/EAP
server certificate. Some clients may be unable to authenticate when these
types of certificates are used.

4. Click Import.

Exporting a Server Certificate
To export a server certificate from the current ClearPass server:

1. Navigate to Administration > Certificates > Certificate Store.

The Certificate Store page opens.

Figure 717 Certificate Store Page

2. Click the Export link.

The Export to File dialog opens.

Figure 718 Export to File Dialog

3. Specify the Export to File parameters as described in the following table.
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Parameter Action/Description

Export file with password
protection

Select Yes (the default) or No to specify whether you want to require
password protection.

Secret Key
Verify Secret

Enter the secret key, then reenter the secret key to verify.

Table 1: Export to File Parameters

4. Click Export.

Upon clicking Export, the certificate is exported in PKCS#12 format.

The PKCS#12 (or PFX) format is a binary format for storing the server certificate, any intermediate
certificates, and the private key in one encryptable file.

Service Certificates
This section describes the following topics:

n Adding Service Certificates

n Creating a Self-Signed Service Certificate

n Creating a Service Certificate Signing Request

n Importing a Service Certificate

Adding Service Certificates
The Service Certificates feature allows you to create multiple service certificates, each of which can be
associated with a specific ClearPass service. For details, see Associating a RADIUS Service Certificate with a
Service.

You can also create a server certificate to replace the current server certificate.

Service Certificates must always be RADIUS certificates.

To view the Service Certificates page:

1. Navigate to Administration > Certificates > Certificate Store.

2. Select the Service Certificates tab.

Figure 719 Service Certificates Tab
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Creating a Self-Signed Service Certificate
This task creates a self-signed certificate to be signed by a CA (Certificate Authority).

To create a Self-Signed Service Certificate:

1. From the Certificate Store > Service Certificates page, click the Create Self-Signed Certificate link.

The Create Self-Signed Certificate dialog opens.

2. Specify the parameters for the Self-Signed Service Certificate as described in the following table:

Parameter Action/Description

Certificate Type Select Service Certificate.

Common Name (CN) Enter the name associated with this entity. This can be a host name, IP
address, or other meaningful name. This field is mandatory.

Organization (O) Optionally, enter the name of the organization. This field is optional.

Organizational Unit
(OU)

Enter the name of the department, division, section, or other meaningful
name. This field is optional.

Location (L) Enter the name of the location, state, country, and/or other meaningful
name. These fields are optional.

State (ST)

Country (C)

Subject Alternate
Name (SAN)

Enter the alternative name for the specified Common Name.
NOTE: Enter the Subject Alternate Name in one of the following formats:

l email: email_address
l URI: uri
l IP: ip_address
l dns: dns_name
l rid: id

Table 1: Specifying Self-Signed Service Certificate Parameters
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Parameter Action/Description

This field is optional.

Private Key Password Enter the Private Key password, then verify the password.

Verify Private Key
Password

Private Key Type Select the length for the generated private key types from the following
options:

l 1024-bit RSA
l 2048-bit RSA
l 4096-bit RSA
l X9.62/SECG curve over a 256 bit prime field
l NIST/SECG curve over a 384 bit prime field

The default private key type is 2048-bit RSA.

Digest Algorithm Select the message digest algorithm from the following options:
l MD5
l SHA-1
l SHA-224
l SHA-256
l SHA-384
l SHA-512

NOTE: The MD5 algorithm is not available in FIPS mode.

Valid for Enter the certificate duration in number of days. The default is 180 days.

3. Click Submit.

The new self-signed service certificate is added.

Figure 720 Self-Signed Service Certicate Added

4. Repeat these steps to add as many self-signed service certificates as required.

Creating a Service Certificate Signing Request
After you select a server and a certificate type, you can create a certificate signing request.

To create a certificate signing request:

1. Navigate to Administration > Certificates > Certificate Store.

The Server Certificates tab is selected.

2. Click the Create Certificate Signing Request link.

The Create Certificate Signing Request dialog opens:
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Figure 721 Create Certificate Signing Request Dialog

3. Specify the Create Certificate Signing Request parameters as described in the following table.

Parameter Action/Description

Common Name (CN) Enter the name associated with this entity. This field is mandatory.
This can be a host name, IP address, or other name.
The default is the fully-qualified domain name (FQDN).

Organization (O) Optionally, enter the name of the organization.

Organizational Unit (OU) Optionally, enter the name of the department, division, section, or other
meaningful name.

Location (L)
State (ST)
Country (C)

Optionally, enter the name of the location, state, country.

Subject Alternate Name
(SAN)

Optionally, enter the alternative names for the specified Common Name
in one of the following formats:

l email: email_address
l URI: uri
l IP: ip_address
l dns: dns_name
l rid: id

Table 2: Create Service Certificate Signing Request Parameters

ClearPass 6.7 Policy Manager | User Guide Administration | 708
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1740



709 | Administration ClearPass 6.7 Policy Manager |  User Guide

Parameter Action/Description

Private Key Password
Verify Private Key
Password

Enter the private key password, then verify it.

Private Key Type Select the length for the generated private key types from the following
options:

l 1024-bit RSA
l 2048-bit RSA. This is the default.
l 4096-bit RSA
l X9.62/SECG curve over a 256 bit prime field
l NIST/SECG curve over a 384 bit prime field

Digest Algorithm Select the message digest algorithm from the following options:
l SHA-1
l SHA-224
l SHA-256
l SHA-384
l SHA-512. This is the default.

4. Click Submit.

The generated certificate signing request is displayed.

Figure 722 Certificate Signing Request Generated

5. Copy the certificate signing request content and paste it into the Web form as part of the enrollment
process.

6. To save and download the Certificate Signing Request file, click Download CSR.

Importing a Service Certificate
To import a service certificate into the current ClearPass server:

1. Navigate to Administration > Certificates > Certificate Store.

2. From the Server Certificates tab, click the Import Certificate link.

The Import Certificate dialog opens:
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Figure 723 Import Server Certificate Dialog

For security reasons, certificates signed using SHA1RSA are not recommended. Importing certificates signed with
stronger keys, such as RSA with a length of more than 1024 bits, is recommended.

ClearPass does not support importing the HTTPS Server Certificate chain or RADIUS Server Certificate chain in P7b
Base64 format. A P7B file contains only certificates and chain certificates (intermediate certificate authorities), not
the private key.

3. Specify the Import Certificate parameters as described in the following table:

Parameter Action/Description

Certificate Type Select Service Certificate.

Upload Method Select one of the following upload methods:
n Upload Certificate and Use Saved Private Key
n Upload PKCS#12 Certificate (.pfx or .p12 only)
n Upload Certificate and Private Key Files

Certificate File Click Browse to specify the certificate file to be imported.
NOTE: Both certificates with a wild card as the common name and Extended
Validation certificates are not recommended for use as the RADIUS/EAP
server certificate. Some clients may be unable to authenticate when these
types of certificates are used.

Table 3: Import Service Certificate Parameters

4. Click Import.

Associating a RADIUS Service Certificate with a Service
The Service Certificates feature allows you to create multiple RADIUS service certificates (for details, see
Service Certificates on page 705). Once you create the RADIUS service certificates you need, you can associate
a service certificate with a specific ClearPass service. This creates a virtual mapping between a ClearPass service
and a RADIUS service certificate.

To associate a service certificate with a specific ClearPass service:

1. Navigate to Configuration > Services.

The Services page opens.

ClearPass 6.7 Policy Manager | User Guide Administration | 710
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1742



711 | Administration ClearPass 6.7 Policy Manager |  User Guide

Figure 724 Services Page

2. From the Services page, click Add.

The Add Services page opens.

Figure 725 Add Services Page

3. From the Type drop-down, select the type of service you want to add.

4. Enter the name of the new service.

5. Select the Authentication tab.

The Add Services > Authentication tab opens.

Figure 726 Selecting a Service Certificate

6. Select the Authentication Method.

7. Specify the Authentication Source.

8. Select the Service Certificate you want to associate with this service.

9. To view the details, click View Certificate Details.

The View Certificate Details window opens.
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Figure 727 Viewing the Service Certificate Details

10.Click Close, then click Save.

You return to the Services page. The following message is displayed:

Service "<service_name>" has been added.

11.Repeat this procedure for each service with which you want associate a service certificate.

Certificate Trust List
The Certificate Trust List page displays a list of trusted Certificate Authorities (CA). On this page, you can add,
view, or delete a certificate.

This section describes the following topics:

n Certificate Trust List Page on page 712

n Adding a Certificate on page 713

n Enabling a Certificate on page 714

n Deleting a Certificate on page 714

You cannot import the certificates that are created with the MD5 digest algorithm to the Certificate Trust List in the
FIPS mode.

Certificate Trust List Page
To display a list of trusted Certificate Authorities (CA):

1. Navigate to Administration > Certificates > Trust List.

The Certificate Trust List page opens:
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Figure 728 Certificate Trust List Main Page

The Certificate Trust List (Administration > Certificates > Trust List) page can include the following
certificates:

n DoD (Department of Defense) certificates: A DoD certificate allows a browser to trust web sites whose secure
communications are authenticated by a DoD agency. These certificates are disabled by default.

n Alcatel root certificate: An Alcatel root certificate allows Alcatel Lucent IP phones to authenticate using EAP-
TLS. These certificates are disabled by default.

The following table describes the information provided on Certificate Trust List:

Parameter Description

Subject Displays the Distinguished Name (DN) of the subject field in the certificate.

Validity Indicates whether the CA certificate is valid or expired.

Enabled Indicates whether the CA certificate is enabled or disabled.

Table 1: Certificate Trust List Information

Adding a Certificate
To add a certificate to the Certificate Trust List:

1. Navigate to Administration > Certificates > Trust List.

2. Click the Add link.

The Add Certificate dialog opens.

Figure 729 Adding a Certificate

3. To browse to the certificate file, click Choose File.

4. Select the file, then click Add Certificate.
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The selected certificate is added to the Certificate Trust List.

Enabling a Certificate
When you enable a CA certificate, Policy Manager considers the entity whose certificate is signed by this CA to
be trusted.

To enable a certificate that is currently disabled:

1. Select the desired entry from the Certificate Trust List.

The View Certificate Details page opens.

Figure 730 Viewing the Certificate Details

2. Click the Enable button.

The following message is displayed:

Certificate is enabled successfully

Deleting a Certificate
To delete a certificate:

1. Navigate to Administration > Certificates > Trust List.

2. Select the check box to the left of the certificate.

3. Click Delete.

Certificate Revocation Lists
This section provides the following information:

n About Certificate Revocation Lists

n Adding a Certificate Revocation List

n Deleting a Certificate Revocation List
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About Certificate Revocation Lists
A certificate revocation list (CRL) is a list of digital certificates that have been revoked by the issuing Certificate
Authority (CA) before their scheduled expiration date and should no longer be trusted.

Certificate revocation lists are a type of blacklist and they are used by various endpoints, including Web
browsers, to verify whether a certificate is valid and trustworthy.

Digital certificates are used in the encryption process to secure communications, most often by using the
Transport Layer Security (TLS) or the Secure Sockets Layer (SSL) protocols. The certificate, which is signed by
the issuing certificate authority, also provides proof of the identity of the certificate owner.

Adding a Certificate Revocation List
To add a certificate revocation list:

1. Navigate to Administration > Certificates > Revocation Lists.

The Certificate Revocation Lists page opens:

Figure 731 Certificate Revocation Lists Page

2. Click the Add link on the top-right section of the page.

The Add Certificate Revocation List dialog opens:

Figure 732 Add Certificate Revocation List Dialog

3. Configure the Add Certificate Revocation List parameters as described in Table 34, then click Save.
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Table 34: Add Certificate Revocation List Parameters

Parameter Action/Description

File Enable the File button to use a distribution file as the Certificate Revocation List
distribution point.
File is enabled by default.

Distribution File To select the distribution file to fetch the certificate revocation list, click Browse
and select the CRL distribution file.

URL Enable the URL button to use a URL as the CRL distribution point.
Selecting URL enables the Distribution URL option.

Distribution URL Specify the distribution URL to fetch the certificate revocation list.

Auto Update n To update the CRL at intervals specified in the list, select Update whenever
CRL is updated.

n To check periodically and at the specified frequency (in hours), select
Periodically update every _______ hour(s).

Bypass Proxy To bypass the proxy server, click the Enable to bypass proxy server option.

Deleting a Certificate Revocation List

To delete a certificate revocation list:

1. Navigate to Administration > Certificates > Revocation Lists.

2. Select the check box to the left of the certificate revocation list.

3. Click Delete.

Using ClearPass Dictionaries
This section provides the following information:

n RADIUS Dictionary

n RADIUS CoA Templates

n TACACS+ Services Dictionary

n Device Fingerprints Dictionary

n Dictionary Attributes

n Applications Dictionaries

n Configuring Endpoint Context Server Actions

n Enabling Ingress Event Dictionaries

RADIUS Dictionary
This page includes the list of available vendor dictionaries.

To configure RADIUS dictionaries:

1. Navigate to Administration >  Dictionaries > RADIUS.

The RADIUS Dictionaries page opens.
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Figure 733 RADIUS Dictionaries

2. To view the dictionary attributes, enable a dictionary, or export the dictionary, click on the row of interest.

For example, click on vendor 3com to see all its attributes and their data type. The following figure displays
the RADIUS 3Com dictionary attributes page:

Figure 734 RADIUS Attributes Page

Enabling a RADIUS Dictionary
To enable a RADIUS dictionary:

1. From the RADIUS Dictionaries page, select the dictionary of interest.

2. Click the Enable button.

You return to the RADIUS Dictionaries page. The following message is displayed:

Dictionary has been successfully enabled.

Exporting a RADIUS Dictionary
To export a RADIUS dictionary:

1. From the RADIUS Dictionaries page, select the dictionary of interest.

2. Click the Export button.
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3. Open or save the XML file.

4. You can make modifications to the dictionary and import the file back into Policy Manager as needed.

Importing a RADIUS Dictionary
You can add additional dictionaries using the Import option. To add a new vendor dictionary:

1. Navigate to Administration > Dictionaries > RADIUS.

2. Click the Import link.

The Import from file dialog opens:

Figure 735 Import RADIUS Dictionary Dialog

3. Specify the Import from file parameters as described in the following table:

Select File

If the file that you want to import is password protected, enter the secret here.

Editing an Existing RADIUS Dictionary
To edit an existing dictionary:

1. Export an existing dictionary.

2. Edit the exported XML file.

3. Then import the dictionary.

RADIUS CoA Templates
The RADIUS CoA Templates allows users to add or update custom Change of Authorization (CoA) and
Disconnect Message (DM) dictionaries for specific vendor IDs.

There is no user interface method for creating a RADIUS CoA Template—an existing template must be
exported, modified, and then reimported.

To access the RADIUS CoA Templates:

1. Navigate to Administration > Dictionaries > RADIUS CoA Templates.

The RADIUS CoA Templates page opens.
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Figure 736 RADIUS CoA Templates Page

2. To enable or disable a template, and to export the template, click the desired row.

The RADIUS CoA Template Attributes page opens.

Figure 737 RADIUS CoA Template Attributes

The following table describes the RADIUS COA Template Attributes action buttons:

Parameter Description

Export Click the Export button to save the template file in XML format. You can make
modifications to the template and import the file back into Policy Manager.

Enable/Disable Enable or disable this CoA template. Enabling a template makes it appear in the
Policy Manager Rules Editors (Service rules, Role mapping rules, etc.).

Table 1: RADIUS Dictionary Attributes Action Buttons

Importing a RADIUS CoA Template
To add additional templates:

1. From the RADIUS CoA Templates page, click the Import button.

The Import from File dialog opens.
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Figure 738 Import from File Dialog

2. Browse to the template file you wish to import.

3. Enter the secret for the file if required.

4. Click Import.

Editing a RADIUS CoA Template
To edit an existing CoA Template:

1. From the RADIUS CoA Templates page, select the CoA template you wish to modify, then click the Export
button.

The selected CoA template is converted to XML format.

2. Edit the exported XML file as necessary.

3. Then import the RADIUS CoA template back into the ClearPass server.

TACACS+ Services Dictionary
To view the contents of the TACACS+ service dictionary, navigate to Administration > Dictionaries >
TACACS+ Services and sort by Name or Display Name. To add a new TACACS+ service dictionary, click the
Import link. To add or modify attributes in an existing service dictionary, select the dictionary, export it, make
edits to the XML file, and import it back into Policy Manager.

The following figure displays the TACACS+ Services Dictionaries page:

Figure 739 TACACS+ Services Dictionaries Page
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The following table describes the TACACS+ Services Dictionaries parameters:

Parameter Description

Import Click to open the Import Dictionary pop up. Import the dictionary (XML file).

Export All Export all TACACS+ services into one XML file containing multiple dictionaries.

Table 1: TACACS+ Services Dictionaries Parameters

To export a specific service dictionary, select a service and click Export. To see all the attributes and their data
types, click a service row. For example, click shell service to see all shell service attributes and their data type.

The following figure displays the TACACS+ Service Dictionary Attributes pop-up:

Figure 740 TACACS+ Service Dictionary Attributes Pop-up

Device Fingerprints Dictionary
n Viewing the Contents of a Device Fingerprints Dictionary

n Importing and Exporting Custom Fingerprints

Device fingerprints are composed of information collected about an online computing device for the purpose
of unique identification of the device on subsequent visits. A device fingerprint can fully or partially identify
individual users or devices even when cookies and other tracking data are turned off.

The Device Fingerprints page shows a listing of all the device fingerprints recognized by the Profile module.
These fingerprints are updated from the Aruba ClearPass Updates Portal (see Software Updates for more
information).

Custom device fingerprints can be added and updated between ClearPass servers.

If custom fingerprints are configured, the custom rules are evaluated before the default rules are evaluated.
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Viewing the Contents of a Device Fingerprints Dictionary
To view the contents of the Device Fingerprints Dictionary:

1. Navigate to Administration > Dictionaries > Fingerprints.

The Device Fingerprints page opens.

Figure 741 Device Fingerprints Page

2. To drill down and view additional details about the category, click on a line in the Device Fingerprints list.

The Device Fingerprint Dictionary Attributes page opens.

Figure 742 Device Fingerprint Dictionary Attributes Page

Importing and Exporting Custom Fingerprints
When you click Import Custom Fingerprints or Export Custom Fingerprints, the standard Import from
File and Export to File dialogs are displayed.

You are not required to provide a new selection of rules when they are exported. All the associated rules for the
Custom Created Fingerprints are exported.

When imported on a node that does not have these details, the exported rules are associated with the Custom
Fingerprints present in the Import File.
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Importing Custom Fingerprints
To import custom fingerprints:

1. From the Device Fingerprints page, click Import Custom Fingerprints.

The Import from file dialog box opens.

Figure 743 Importing a Fingerprint Dictionary File

2. Browse to the Fingerprint Dictionary file that you want to import.

l Be sure to select an XML file that is in the correct format.

See Appendix B, "Using the ClearPass Configuration API" in the ClearPass Deployment Guide for more information
about the format and contents of XML files.

3. Enter secret for the file (if any): If you entered a secret key to encrypt the exported file, enter the same
secret key to import the device into this ClearPass server.

4. Click Import.

The Update Device Fingerprints dialog opens:

Figure 744 Update Device Fingerprints Dialog

5. Modify the Category, Family, or Name device fingerprinting attributes as desired, then click Update.
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Exporting Custom Fingerprints
ClearPassPolicy Manager allows you to export configuration and administration-related information from the
current ClearPass server to an XML file. You can set this file to be password protected.

To export custom fingerprints:

1. From the Device Fingerprints page, click Export Custom Fingerprints.

The Export to file dialog opens.

Figure 745

2. Specify the Export to file parameters as described in Table 1:

Parameter Action/Description

Export file with password
protection

To export the file with password protection, choose Yes.

Secret Key/ Verify Secret You can choose to encrypt the exported data with a key. This protects data such
as shared secret from being visible in the exported file. To import it back, you
specify the same key with which you exported
Enter the secret key. Then reenter the secret key.

Table 1: Export to File Dialog Parameters

3. Click Export.

The following figure shows ClearPass an example of the exported custom fingerprints file:
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Figure 746 Exported XML File

Dictionary Attributes
This section contains the following information:

n Introduction

n Adding a Dictionary Attribute

n Modifying Dictionary Attributes

n Importing Dictionary Attributes

n Exporting All Dictionary Attributes

n Exporting Selected Dictionary Attributes

Introduction
The Attributes dictionary page allows you to specify unique sets of criteria for local users, guest users,
endpoints, and devices. This information can then be used with role-based device policies for enabling
appropriate network access.

To view the contents of the attributes dictionary:

1. Navigate to Administration > Dictionaries > Attributes.

The dictionary Attributes page opens:
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Figure 747 Dictionary Attributes Page

Table 1 describes the dictionary Attributes parameters:

Parameter Action/Description

Filter Use the Filter drop-down list to create a search based on the Name, Entity, Data Type, Is
Mandatory, or Allow Multiple settings.

Name The name of the attribute.

Entity Indicates whether the attribute applies to a Local User, Guest User, Device, or Endpoint.

Data Type Indicates whether the data type is String, Integer, Boolean, List, Text, Date, MAC address, or
IPv4 address.

Is Mandatory Indicates whether the attribute is required for a specific entity.

Allow Multiple Indicates whether multiple attributes are allowed for an entity.

Table 1: Dictionary Attributes Parameters

Adding a Dictionary Attribute
To add a dictionary attribute:

1. From the Attributes page, click Add.

The Add Attribute dialog appears.

Figure 748 Add Attribute Dialog
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2. Specify the Add Attribute parameters as described in the following table, then click Add.

Parameter Action/Description

Entity Specify whether the attribute applies to a Device, Endpoint, Guest User, Local User, or
Onboard.

Name Enter a unique ID for this dictionary attribute.

Data Type From the drop-down, specify the data type.

Is Mandatory Specify whether the attribute is required for a specific entity.

Allow Multiple Specify whether multiple attributes are allowed for an entity.
NOTE: Multiple attributes are not permitted if Is Mandatory is specified as Yes.

Default Value Optionally, specify whether the default value is true or false.

Table 2: Attribute Setting Parameters

Modifying Dictionary Attributes
To modify dictionary attributes in a service dictionary:

1. From the Attributes page, select the dictionary attribute.

The Edit Attribute page opens.

2. Make any necessary changes, then click Save.

Importing Dictionary Attributes
To import attributes:

1. From the menu at the top right section of the page, click Import.

The Import from File dialog opens.
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Figure 749 Importing Dictionary Attributes

2. Enter the Import from File parameters as described in Table 3.

Parameter Description

Select File Browse to select the file that you want to import.

Enter secret for the file
(if any)

If the file that you want to import is password protected, enter the secret
here.

Table 3: Import From File Parameters

3. When finished, click Import.

The imported file is in XML format. To view a sample of this XML format, export a dictionary file and open it in an
XML viewer.

Exporting All Dictionary Attributes
To export all the dictionary attributes at once:

1. From the Attributes page, select Export All.
The Export to File dialog opens.

Figure 750 Exporting Dictionary Attributes

2. Specify the Export to File parameters as described in Table 4.
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Parameter Action/Description

Export file with
password protection

The Yes option is enabled by default.
If you wish to disable password protection when exporting a file, select No.

Secret Key If the file that you want to import is password protected, enter the secret
here. Then verify the secret key.

Table 4: Export to File Parameters

3. When finished, click Export.

The TagDictionary.xml file is created.

4. Download the file.

Exporting Selected Dictionary Attributes
To export selected dictionary attributes:

1. On the Attributes dictionary page, select one or more attribute entries.

The Export and Delete buttons on the lower right are now enabled.

2. Click Export.

The Export to File dialog opens.

3. Specify the Export to File parameters as described in Table 4.

When finished, click Export.

The TagDictionary.xml file is created.

4. Download the file.

Applications Dictionaries
Application dictionaries define the attributes of the Onboard Policy Manager application and the type of each
attribute.

When Policy Manager is used as the Policy Definition Point (PDP), it uses the information in these dictionaries
to validate the attributes and data types sent in a WEB-AUTH request.

Viewing an Application Dictionary
To view the contents of the application dictionary:

1. Navigate to Administration > Dictionaries > Applications.

The Applications Dictionaries page opens.
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Figure 751 Applications Dictionaries Page

2. To see the application attributes, click the name of an application.

The Application Attributes dialog box opens.

Figure 752 Application Attributes Page

Deleting an Application Dictionary
In general, there is no need to delete an application dictionary. They have no effect on Policy Manager
performance.

To delete an application dictionary:

1. Navigate to Administration > Dictionaries > Applications.

2. Click the check box next to an application name.

3. Click Delete.

Configuring Endpoint Context Server Actions
This section contains the following information:
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n Configuring Endpoint Context Server Actions

n Filtering an Endpoint Context Server Action Report

n Storing Authentication Attributes in the Multi-Master Cache

n Adding machine-os and host-type Endpoint Attributes

Configuring Endpoint Context Server Actions
Use the Endpoint Context Server Actions page to configure actions that are performed on endpoints, such
as locking a device, triggering a remote, or enterprise wipe, and so on.

The Endpoint Context Server Actions page displays a list of all the Context Server Actions that are available
by default for each server type that ClearPass supports.

To configure endpoint context server actions:

1. Navigate to Administration > Dictionaries > Context Server Actions.

The Endpoint Context Server Actions page opens.

Figure 753 Endpoint Context Server Actions Page

2. From the Endpoint Context Server Actions page, click a row in the report.

The Endpoint Content Server Details dialog opens.
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Figure 754 Endpoint Context Server Details Dialog

3. Click a tab to view details about the selected Endpoint Context Server action.

4. Make any changes required, then click Save.

Action Tab Parameters

Use the Action tab to specify the server type, action name, HTTP method, authentication method, and URL for
the endpoint context server action.

Specify the Endpoint Context Server Details > Action tab parameters as described in the following table,
then click Save.

Table 35: Action Parameters—Endpoint Context Server Details

Parameter Action/Description

Server Type Specifies the server type configured when the server action was configured. You can select
the server type from the drop-down list.

Server Name Lists the context servers specific to the server type selected in the Server Type field. This
field is visible only if you selected the service type Generic HTTP.

Action Name Specifies the name of the action configured.

Description Provides additional information about the action specified.

HTTP Method Select the HTTP method from the drop-down:
n DELETE
n GET
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Parameter Action/Description

n POST (the default setting)
n PUT
n PATCH

You can use the HTTP method PATCH to append content to existing endpoints/values.

Authentication
Method

Select the authentication method:
n None: Select None to disable the HTTP basic authentication for endpoint context server

actions. This exposes the context server attributes to be used in context server actions.
n Basic
n OAuth2
NOTE: When associating context server actions with an endpoint context server, be sure to
specify the same authentication method that was configured for the endpoint context server.

URL Indicates the URL for the selected HTTP method.

Header Tab Parameters
Use the Header tab to specify the key-value pairs to be included in the HTTP header.

1. From the Header tab, select Click to add.

Figure 755 Header Tab—Endpoint Context Server Details

2. Specify the Endpoint Context Server Details—Header parameters as described in the following table:

Table 36: Header Parameters—Specifying Key Value Pairs

Parameter Action/Description

Header Name Enter the name of the header to be included in the HTTP header.

Header Value Specify the value of the header specific to the name to be included in the HTTP header.

If a ClearPass server is used as an Endpoint context server to update the configuration using the REST API call, add
the HTTP header, Accept: application/json in the context server action.

3. Repeat these steps for each key-value pairs you need to add.

4. Click Save.
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Content Tab
Use the Content tab to specify a content type and add non-default context server attributes (see Figure 756).

The information in the Content window is the template of what will be posted to the server. The fields
preceded by the % sign are replaced with their corresponding values.

Figure 756 Content Tab—Endpoint Context Server Details

Specify the Endpoint Context Server Details—Content parameters as described in the following table:
Table 37: Content Parameters—Endpoint Context Server Details

Parameter Action/Description

Content-Type Specify the type of the content. Select from the following options:
n CUSTOM
n HTML
n JSON
n PLAIN
n XML

Content Specify the content.
For example, { "mac": "%{Connection:Client-Mac-Address-NoDelim}","nmap": {"device": "%
{DEVICECATEGORY}"}}.

For related information, see Adding machine-os and host-type Endpoint Attributes).
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Attributes Tab Parameters
Use the Attributes tab to specify the mapping for attributes used in the content to parameterized values
from the request.

Figure 757 Attributes Tab—Endpoint Context Server Details

Specify the Endpoint Context Server Details > Attributes parameters as described in the following table:
Table 38: Attributes Parameters—Endpoint Context Server Details

Parameter Action/Description

Attribute Name Enter attribute names and assign values to those names. These name/value pairs are included
in context server actions.

Attribute Value Enter the value for the selected name in the Attribute Name field.

Figure 758 Adding Endpoint Context Server Attributes

5. Click Save.

You receive the following message:

Context Server Action "Check Point Login (Generic HTTP)" updated successfully

Filtering an Endpoint Context Server Action Report
Use the Filter controls to configure a search for a subset of Endpoint Context Server Action items.

To filter an endpoint context server action report:

1. Navigate to Administration > Dictionaries > Context Server Actions.
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The Endpoint Context Server Actions page opens (see Figure 753).

2. From the Filter drop-down, select a filter:

l ServerType
l Action Name
l HTTP method

3. To add up to four new search fields, click the Plus icon.

4. Select a search argument.

The search arguments are limited to contains or equals.

5. Click Go.

Storing Authentication Attributes in the Multi-Master Cache
ClearPass provides a context server action that serves as an example of how to store attributes from an
authentication session into Multi-Master Cache for use in policy enforcement during an authentication session.
The Administrator can then clone it and customize the context server action to meet their requirements.

To access this context server action:

1. Navigate to Administration > Dictionaries > Context Server Actions.

The Endpoint Context Server Actions page opens.

Figure 759 Endpoint Context Server Actions Page: Store Attributes in Multi-Master Cache

2. Scroll down and select the Store Attributes in Multi-Master Cache endpoint context server action.

The Endpoint Context Server Details page opens.
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Figure 760 Endpoint Context Server Details: Store Attributes in Multi-Master Cache

3. Modify and customize the Store Attributes in Multi-Master Cache endpoint context server action as
needed.

At Configuration > Authentication > Sources, the Multi-Master Cache Repository authentication
source will fetch the attributes stored in the Multi-Master Cache and proceed with authentication.

Adding machine-os and host-type Endpoint Attributes
To be able to indicate the entire OS family (Android, Windows, Linux, etc.) and the type of device (iPad, iPhone,
etc.), you can add the machine-os Device Family attribute and the host-type Device Type attribute to the
default set of endpoint context attributes provided in the Content window:

To add the machine-os and host-type endpoint context attributes:

1. Navigate to Administration > Dictionaries > Context Server Actions.

The Endpoint Context Server Actions page opens.

2. Scroll to and select the Generic HTTP/Check PointLogin server action.
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Figure 761 Selecting the Check Point Login Server Action

The Endpoint Context Server Details dialog opens.

3. Select the Content tab (see Figure 758).

4. In the Content field, add the following attributes (see Figure 758):

l "machine-os":" %{device_family}"

l "host-type":"%{device_type}"

Enabling Ingress Event Dictionaries
By default, a set of ingress event dictionaries are available and initially set to disabled. You must enable the
ingress event dictionaries before you proceed.

To enable an ingress event dictionary:

1. Navigate to Administration > Dictionaries > Ingress Events.

The Ingress Events Dictionaries page opens. The set of ingress event dictionaries are displayed. By
default, they are disabled.

Figure 762 Viewing Ingress Event Dictionaries

2. To enable a dictionary, select the disabled Ingress Events Dictionary for the appropriate vendor.

The Events Attributes dialog opens.
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Figure 763 Enabling an Ingress Events Dictionary

3. To enable the selected ingress events dictionary, click Enable.

You return to the Ingress Events Dictionaries page. The dictionary information is no longer displayed in
red and the Status column is set to Enabled (see Figure 764).

Figure 764 Ingress Events Dictionary Enabled

OnGuard Settings and Agent Library Updates
This section provides the following information:

n Introduction

n Configuring OnGuard Settings

n OnGuard Agent Library Updates

n Certificate-Based Authentication Using OnGuard

n Installing Standalone VIA 3.2.x with OnGuard Agent

Introduction
Use the OnGuard Settings page to configure the agent deployment packages.

When you save the OnGuard configuration, ClearPass creates agent deployment packages for the Windows,
macOS, and Ubuntu operating systems and provides the packages at a fixed URL on the ClearPass Policy
Manager hardware or virtual appliance.
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You can then publish this URL to the user community or download the agent deployment packages to another
location.

To view the OnGuard Support Charts, see Accessing the OnGuard Support Charts.

Configuring OnGuard Settings
To configure the OnGuard settings:

1. Navigate to Administration > Agents and Software Updates > OnGuard Settings.

The OnGuard Settings page opens to the Settings tab:

Figure 765 OnGuard Settings Page > Settings Tab

2. Configure the OnGuard Settings parameters as described in Table 1, then click Save.

Parameter Action/Description

Global Agent Settings Click the Global Agent Settings link to configure the global agent settings for OnGuard
agents.
For more information, see OnGuard Global Agent Settings.

Policy Manager
Zones

Click the Policy Manager Zones link to configure the client subnets that comprise the
Policy Manager Zone.
For more information on configuring Policy Manager zones, see Managing Policy
Manager Zones.

Agent Version Indicates the current version of the OnGuard agent.

Table 1: OnGuard Settings Parameters
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Parameter Action/Description

Agent Library Version Indicates the version of the OnGuard Agent Library. OnGuard Agent uses this library for
health collection and auto-remediation.

Installer Mode Specify the action to be taken from the following options when the Aruba VIA component
is used to provide VPN-based access:
n Do not install/enable Aruba VIA component

NOTE: Selecting this option will automatically remove any existing and installed Aruba
VIA client software.

n Install and enable Aruba VIA component
NOTE: Selecting this option will automatically upgrade any existing and installed
Aruba VIA client software.

NOTE: For related information, see Installing Standalone VIA 3.2.x with OnGuard Agent.

Agent Customization

Managed Interfaces Select the type(s) of interfaces that OnGuard will manage on the endpoint. Select from the
following options:
n Wired
n Wireless
n VPN
n Other

Mode Select one of the following options:
n Authenticate with health checks: OnGuard collects the username and password

and also performs health checks on the endpoint. This is the default setting.
n Authenticate - no health checks: OnGuard collects the username and password but

does not perform health checks on the endpoint.
n Check health - no authentication: OnGuard does not collect the username and

password.
n Authentication type: OnGuard provides username and password authentication and

certificate-based authentication:
l Username & Password. Select this option for standard username and

password authentication.
l Certificate: The Certificate option is available only when you specify

Authenticate with health checks or Authenticate - no health checks.
When you select Certificate, the Certificate Filter Criteria option appears to
allow you to show or select certificates based on specific criteria.

The Certificate Filter Criteria setting is used by the OnGuard client. The OnGuard
client applies this filter to the list of installed user certificates on the client machine
prior to using them for authentication.
ClearPass OnGuard Agent supports certificates that are stored under the personal
certificate store of the user’s system (for example, under Certificates - Current User on
Windows) and smart cards. For details, refer to Certificate-Based Authentication Using
OnGuard.

n Username/Password Text:
l If desired, change the label for the Username and Password fields on the

OnGuard agent.
NOTE: This setting is not valid for the Check health - no authentication mode.
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Parameter Action/Description

Agent action when an
update is available

Determines what the ClearPass OnGuard Agent does when an update of OnGuard Agent
Library is available. Select one of the following options:
n Ignore: ClearPass OnGuard Agent ignores the available OnGuard Agent Library

update.
n Notify User: ClearPass OnGuard Agent notifies the user that a new version of

OnGuard Agent Library is available on the ClearPass server.
n Download and Install: When this option is selected and a new version of OnGuard

Agent Library is available on the ClearPass server, ClearPass OnGuard Agent
automatically downloads and installs the new version of OnGuard Agent Library from
the ClearPass server.

Agent Remediation User Interface Customization

Custom User
Interface

When you select the Configure check box, the Agent Remediation User Interface
Customization dialog opens.
n Web Pages: To create the OnGuard custom web pages and define the properties for

the web pages, click the Create link for the corresponding web page (for details, see
Creating OnGuard Custom Web Pages.

Native Dissolvable Agent Customization

Managed Interfaces The Native Dissolvable Agent performs health checks for one of the selected interfaces.
This feature ensures that, if both wired and wireless interfaces are connected, the
OnGuard Agent will send health requests through the correct interface.
Select the type(s) of managed interfaces that are supported for the Native Dissolvable
Agent.
Select from the following options:
n Wired
n Wireless
n VPN
n Other

OnGuard Agent Library Updates
OnGuard modules, including detection libraries for client programs (V4 SDK), can be upgraded without having
to upgrade your ClearPass or OnGuard installations.

To support this feature, OnGuard Agent Library update patches with new versions of the detection library/SDK
will be released periodically. When they are released, the OnGuard Agent Library update patches will be
available on the Software Updates page under Firmware & Patch Updates (see Software Updates Page).

When a new version of an OnGuard Agent Library patch is installed, it is immediately available in OnGuard
Settings. OnGuard Agents can be configured to install the update automatically, or administrators may install
them manually instead. The OnGuard Agent Library update patches are also available on the Aruba Support
Center for offline updates through the CLI.

OnGuard Agent Library update patch versions are independent of ClearPass and OnGuard versions, so newer
versions of OnGuard Agent Library update patches can be installed on older versions of ClearPass. This feature
is available for both the persistent and dissolvable agents, and for Windows, macOS, and Ubuntu operating
systems.

As OnGuard Agent Library update files become available, the files for the various operating systems are listed
on the new OnGuard Settings > Installers tab. Administrators can download these files for manual
installation or to push via Patch Management applications such as Microsoft System Center Configuration
Manager (SCCM).
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While auto-remediation or ClearPassUSHARemediate.exe is running, the OnGuard Agent Library update will fail on
Windows OS. Once auto-remediation has completed, you can install the OnGuard Agent Library update.

Important Points
Please note the following important points:

1. On a ClearPass server, new versions of an OnGuard Agent Library Update patch must be installed manually
from the Software Updates page.

2. OnGuard Agent Library Update patches are independent from ClearPass server versions (for example, the
same patch will be available for all 6.7.x versions).

3. The OnGuard Agent Library version is different than the ClearPass server and OnGuard Agent versions. The
currently installed version of OnGuard Agent Library is shown at Administration > Agents and Software
Updates > OnGuard Settings:

Figure 766 OnGuard Settings > Agent Library Version
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4. The current version of OnGuard Agent Library installed on the client is shown in the OnGuard Agent About
box:

Figure 767 Agent Library Version and the OnGuard Agent About Box

5. On a ClearPass server, the Software Updates page shows only those patches that have versions higher
than the currently installed version. Installing a patch that is a lower version (that is, downgrading the
version) on a ClearPass server is not supported.

6. OnGuard Agent Library Updates are supported for both Persistent and Native Dissolvable Agents on the
Windows, macOS, and Ubuntu operating systems.

7. Auto-updating OnGuard Agent Library is supported on Ubuntu clients having ClearPass OnGuard Agent
version 6.7.1 and higher.

8. Installing OnGuard Agent Library Update on clients having ClearPass OnGuard version 6.7.1 or higher will
restart OnGuard Agent and Services. Thirty to 60 seconds after installing OnGuard Agent Library Update,
ClearPass OnGuard Agent will be restarted.

9. OnGuard Agent Library Update patches will include only Library Update installers.

10.Installing a new version of the OnGuard Agent Library installs the new version of the V4 SDK library files.

11.While automatically updating the OnGuard Agent library, OnGuard Agent supports installing newer (higher)
versions on clients only. If the ClearPass server has a lower version than the version installed on the client,
OnGuard Agent does not automatically downgrade the OnGuard Agent library.

12.Downgrading the OnGuard Agent Library version on a client is supported via manual installation; that is, an
administrator can manually install a lower version of the OnGuard Agent Library on a client.

13.If auto-update of the OnGuard Agent Library is enabled and a new version of OnGuard Agent Library is
available on the ClearPass server, OnGuard Agent installs the new version after performing health checks as
OnGuard Agent performs enforcement actions (such as applying the Agent Enforcement profile).

14.After successful installation of a new version of OnGuard Agent Library Update, OnGuard Agent performs
health checks again, using the new version of the V4 SDK. This is applicable for both automatic and manual
installations.
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15.OnGuard Agent sends the installed version of OnGuard Agent Library update to the ClearPass server in a
WebAuth request. This information is available in Access Tracker > Input > Computed Attributes >
Host:AgentLibraryVersion. This attribute is available in Service Rules and Role Mapping.

16.Third-party support charts under Administration > Support > Documentation will also get updated
when a new version of the OnGuard Agent Library Update patch is installed on the ClearPass server.

17.On Windows clients, installing the OnGuard Agent Library manually restarts OnGuard Agent and Services.
Also, if multiple users are logged in at the time of installation, OnGuard Agent is launched only for the
current active user. For other, non-active users, OnGuard Agent must be restarted manually.

18.Uninstalling OnGuard Agent also uninstalls OnGuard Agent Library Update from the client. Reinstalling
OnGuard Agent does not install the new version OnGuard Agent Library update automatically, as the new
version of Library Update is not part of OnGuard Installer. If Enable to auto update OnGuard Agent
Library is set to True in the Agent Enforcement profile (see Configuring Agent Enforcement Attributes),
OnGuard Agent will install it again; otherwise, it must be installed manually.

Certificate-Based Authentication Using OnGuard
For certificate-based authentication, OnGuard agent uses the client certificate during the SSL handshake (the
private key can be obtained from OS store/TPM/smart card). The ClearPass server verifies the client certificate
against the configured trusted CA list.

On successful certificate verification, the client is authenticated. Additionally, ClearPass can perform user-
lookup for the identity fetched from the client certificate with the configured authentication source and display
an alert in Access Tracker if lookup fails.

Configuration
To configure certificate-based authentication:

1. Navigate to Administration > Agent and Software Updates >OnGuard Settings.

The OnGuard Settings page opens.

2. Under Agent Customization specify the Authentication Type as Certificate.

The Certificate Filter Criteria field is displayed.
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Figure 768 Specifying Authentication Type as Certificate

The Configure Filter Criteria parameter supports regular expressions with an exception of * (asterisk).

Figure 769 Asterisk (*) Specified as Certificate Filter Criteria

When * is configured for the certificate filter criteria, OnGuard Agent shows all the certificates that are
stored under the personal certificate store of the user’s system (for example, under Certificates - Current
User on Windows) and smart cards in the Certificate Selection dialog:
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Figure 770 Certificate Selection Dialog

Certificate Filter Criteria Example
If Certificate Filter Criteria is configured as “organizationalUnitName=ARUBA;organizationName=HPE”
OnGuard Agent selects the certificate that matches both the conditions:

Figure 771 Example of Certificate Filter Criteria with Two Conditions

If only one certificate is present in the personal certificate store of the user’s system that matches the filter criteria,
OnGuard Agent uses that certificate without prompting the Certificate Selection dialog.

Attribute OID

commonName 2.5.4.3

organizationalUnitName 2.5.4.11

organizationName 2.5.4.10

Table 2: Certificate Filter Criteria: Supported Attributes

Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1779



Attribute OID

certificateIssuer 2.5.29.29

userPrincipalName 1.3.6.1.4.1.311.20.2.3

emailAddress 1.2.840.113549.1.9.1

friendlyName 1.2.840.113549.1.9.2

OnGuard Agent Behavior for Certificate-Based Authentication
When Certificate-based Authentication Mode is selected:

n OnGuard Agent prompts for the Certificate Selection dialog.

n OnGuard Agent shows the information of the selected certificate in Diagnostic logs.

n If a smart card is used for authentication, OnGuard Agent prompts for the PIN dialog:

Figure 772 PIN Dialog When a Smart Card is Used for Authentication

During reconnect from the same running instance of the OnGuard Agent, the PIN may not be required again due to
internal caching supported by the operating system and the smart card provider.
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Figure 773 Certificate Connection Status

n OnGuard caches the certificate selection and PIN if the Save Credential setting is ON in the OnGuard
Agent Preferences.

Host:AuthType Attribute
In the WebAuth request, OnGuard Agent sends a new attribute—Host:AuthType.

Host:AuthType has two values:

n Certificate: For Certificate-based authentication.

n Password: For username and password-based authentication.
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Figure 774 Host:AuthType Attribute Displayed in Access Tracker

This attribute is available in Service Rules and Role Mapping.

Important Points

Please note the following important points:

1. Certificate-based authentication is supported for Persistent Agent on the Windows operating system.

2. If the ClearPass Policy Manager version is 6.7.5 and the OnGuard agent is older than 6.7.5 , OnGuard Agent
continues to work with user name password-based authentication.

3. Certificates that are installed in the machine store are not displayed in the Certificate Selection dialog.

4. OnGuard Agent discards expired certificates.

5. The user’s certificates that don't include the private key are displayed in the OnGuard Agent dialog, but
these certificates don't work when used for authentication.

6. ClearPass does not support SubjectAltName (SAN) in Certificate Filter Criteria. However, you can use
values inside the SAN as certificate filter criteria (for example email, IP, dns).

Installing Standalone VIA 3.2.x with OnGuard Agent
ClearPass supports standalone installation of both VIA 3.2.x and the OnGuard Agent. This allows
administrators to use VIA 3.2.x functionality that is not yet available in the Unified Agent in conjunction with
the OnGuard Agent. This feature is supported by OnGuard 6.7.2 and higher and by VIA 3.2.2 and higher. This
feature is available only on Windows OS.

To use this feature, OnGuard must be installed by passing the AllowBothVIAAndOnGuard flag to the
installer in the following format:

ClearPassOnGuardInstall.exe /AllowBothVIAAndOnGuard=1
msiexec /i ClearPassOnGuardInstall.msi ALLOWBOTHVIAANDONGUARD=1

Both OnGuard and VIA must be installed with this flag in order for them to co-exist on the same system. If
either of them is installed without this flag, the other cannot be installed.

In addition, VIA must be installed with the AllowBothVIAAndOnGuard flag in the following format:

msiexec /i Aruba-VIA-3.2.0.0.XXXXX-64(86).msi ALLOWBOTHVIAANDONGUARD=1

If the ClearPass OnGuard Unified Agent is installed with AllowBothVIAAndOnGuard=1, the Unified Agent will not
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enable the VPN component, even if it is enabled in the ClearPass user interface, i.e., the ClearPass OnGuard Unified
agent will run in OnGuard-only mode even if the Administration > Agents and Software Updates > OnGuard
Settings > Installer Mode option is set to Install and enable Aruba VIA component.

Onguard Agent Installers
To access the OnGuard Agent Installers:

1. Navigate to Administration > Agents and Software Updates > OnGuard Settings.

2. From the OnGuard Settings page, select the Installers tab.

The Installers tab provides all available installer files for OnGuard and for library updates.

For each OS (Windows, macOS, and Ubuntu), you have the option of initiating a full installation or an update
only, which installs only the OnGuard Agent for OPSWAT OESIS framework for the selected OS.

Figure 775 OnGuard Settings Page > Installers Tab

Parameter Action/Description

Windows Select the appropriate download link to download OnGuard Agent for Windows.
n The ClearPassOnGuardInstall binary file is provided in .exe and .msi formats.
n The ClearPassOnGuardLibraryUpdate file updates only the OnGuard Agent Libary for

Windows without requiring reinstallation of OnGuard Agent.

macOS Select the appropriate download link to download OnGuard Agent for macOS.
n The ClearPassOnGuardInstall binary file is provided in .DMG format.
n The ClearPassOnGuardLibraryUpdate file updates only the OnGuard Agent Libary for

macOS without requiring reinstallation of OnGuard Agent.

Ubuntu Select the appropriate download link to download OnGuard Ubuntu Agent for Linux.

Table 1: OnGuard Settings > Installers Parameters
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n The ClearPass OnGuardInstall binary file and the ClearPass OnGuardUpdate file are
provided in .tar.gz format.

n The ClearPassOnGuardLibraryUpdate file updates only the OnGuard Ubuntu Agent for
Linux without requiring reinstallation of OnGuard Agent.

Native Dissolvable Agent Apps

Windows n Click the OnGuard Windows Health Checker URL to install the Native Dissolvable
Agent for Windows.

n Click the OnGuard Windows Health Checker Library Update URL to update only
the Native Dissolvable Agent for Windows without requiring reinstallation of OnGuard
Agent.

macOS n Click the OnGuard Mac Health Checker URL to download Native Dissolvable Agent
for macOS.

n Click the OnGuard Mac Checker Library Update URL to update only the Native
Dissolvable Agent for macOS without requiring reinstallation of OnGuard Agent.

Ubuntu n Click the OnGuard Ubuntu Health Checker URL to download Native Dissolvable
Agent for macOS.

n Click the OnGuard Ubuntu Checker Library Update URL to update only the Native
Dissolvable Agent for Ubuntu without requiring reinstallation of OnGuard Agent.

NOTE: You can download the .tar.gz files specific to 32-bit (indicated by x86 in the
filename) and 64-bit systems.

Manually Installing a New Version of the OnGuard Agent Library
You can use the installers available on the OnGuard Settings > Installers page for offline or manual
installation of OnGuard Agent Library updates on clients.

To manually install a new version of the OnGuard Agent Library:

1. Download the applicable installer from the OnGuard Settings > Installers page.

2. Copy the installer file on the client and run it.

3. Wait for the installation to complete.

4. When the installation is complete:

a. On Windows clients, OnGuard Agent will be restarted.

b. On Ubuntu and macOS clients, OnGuard Agent will perform health checks.

Automatically Updating New Versions of OnGuard Agent Library from a ClearPass Server

This feature is supported by ClearPass OnGuard Agent for Windows and macOS. This feature is not supported for the
Ubuntu OS in ClearPass Policy Manager 6.7.0.

ClearPass OnGuard Agents support automatically downloading and installing new versions of the OnGuard
Agent Library from a ClearPass server when a new version is available.

While auto-remediation or ClearPassUSHARemediate.exe is running, the OnGuard Agent Library update will fail on
Windows OS. Once auto-remediation has completed, you can install the OnGuard Agent Library update.
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To enable automatic updates of the OnGuard Agent Library:

1. Navigate to Configuration > Enforcement > Profiles.

2. Configure a new Agent Enforcement profile or edit an existing Agent Enforcement profile.

3. Set the attribute Enable to auto update OnGuard Agent Library to True (for details, see Configuring
Agent Enforcement Attributes).

OnGuard Global Agent Settings
n About Global Agent Settings

n Global Agent Settings Parameters for OnGuard Agents

n Global Agent Settings: Run OnGuard As Parameter

About Global Agent Settings
Use the Global Agent Settings page to configure the global parameters for OnGuard agents.

1. Navigate to the Administration > Agents and Software Updates > OnGuard Settings page.

2. Click the Global Agent Settings link. The Configure Global Agent Settings page opens.

Figure 776 Configure Global Agent Settings Page

3. To add additional Global Agent Settings parameters, select Click to add.

a. Name: Select the desired Global Agent Setting (see Table 1).

b. Value: Specify the appropriate value.

4. Repeat these steps as necessary for each additional parameter, then click Save.

Global Agent Settings Parameters for OnGuard Agents
Table 1 describes the Global Agent Settings parameters for OnGuard agents:

Name Parameter Action/Description

Cache Credentials Interval (in
days)

Select the number of days the user credentials should be cached on OnGuard
agents.

Delay to bounce after Logout (in
minutes)

Specify the number of minutes that should elapse before OnGuard bounces the
interface if OnGuard remains disconnected.

Enable OnGuard requests load-
balancing

Enable this option to balance the load of OnGuard authentication requests
across ClearPass Policy Manager servers in a cluster.

Table 1: Configure Global Settings Parameters
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Name Parameter Action/Description

Enable access over Remote
Desktop Session

Enable this option to allow OnGuard access through a Remote Desktop session.

Enable to hide Logout button  Enable this option to hide the Logout button on OnGuard agent.

Enable to install VPN component Enable this option to install the OnGuard VPN component.

Enable to use Windows Single-
Sign On

Enable this option to allow use of a user's Windows credentials for
authentication.

Keep-alive Interval (in seconds) Specify a keep-alive interval for OnGuard agents.
The connected OnGuard Agents periodically send heart-beat (Keep-Alive)
messages to ClearPass Policy Manager. This interval is defined by the Keep-
alive Interval (in seconds) parameter. The default value is 60 seconds.
ClearPass uses Keep-Alive messages to:
n Update the status of OnGuard Agents regarding OnGuard Activity.
n Issue CoA (Change of Authorization) for a Session Restrictions Enforcement

Profile if OnGuard Agent is disconnected:
l Session-Check > Agent-Connection = Down
l Post-Auth-Check > Action = Disconnect

For related information, see Session Restrictions Enforcement Profile.

OnGuard Health Check Interval
(in hours)

Specify the number of hours that OnGuard will skip health checks for healthy
clients.
NOTE: Note the following information when you set the OnGuard Health
Check Interval parameter:

l Set this parameter if OnGuard mode is set to health only.
l This parameter is valid only for wired and wireless interface types.
l This parameter is not applicable for the OnGuard Dissolvable Agent,

VPN, and Other interface types.
You can also specify the health-check interval in the Agent Enforcement
profile (Configuration > Enforcement > Profiles > Add) to create different
Agent Enforcement Profiles for different users.

Run OnGuard As For details, see the next section, Global Agent Settings: Run OnGuard As
Parameter.

Server Certificate Validation Enables the ClearPass OnGuard Unified Agent to validate the ClearPass Server
Certificate when it sends a WebAuth health request to ClearPass.

Server Communication Mode Based on the value of this attribute, OnGuard Agent will use the IP address,
HostName, or FQDN (Fully Qualified Domain Name) to communicate with the
ClearPass server.
Select one of the following values:
n IP
n Hostname
n FQDN

Support Team Email Address Enter an email address that automatically populates the To field in the user's
email client when they send logs.

Use active Username in Health
Only mode

When this option is enabled (set to True) and the OnGuard Agent is running in
Health Only mode, instead of using the MAC address as the username,
OnGuard Agent sends the currently active user's username as the username in
the WebAuth request.
n Username format on Windows:

Local users: <host_name>\<username>
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Name Parameter Action/Description

Domain users: <domain_name>\<username>
n Username format on macOS and Ubuntu:

Local users and Domain users: <username>
NOTE: when this option is enabled, OnGuard Persistent Agent sends the
attribute Host:ActiveUserName in the WebAuth request. This attribute is
available in both Service Rules and Role Mapping.
NOTE: This option is not applicable for Native Dissolvable Agent and OnGuard
running as Service.

Use Current OS Language
(Windows Only)

Enables ClearPass OnGuard Agent to use the current user's display language,
if supported, overriding the language selected at installation time. This
parameter applies only to Windows clients.

VPN Device Names (Windows) This parameter lets you specify a VPN adapter (device) name and categorize
the network interface as a VPN on Windows.

1. Enter a Windows device name as a Value.
If OnGuard Agent finds a network interface with a matching device name, it
classifies it as a VPN interface. Admins can specify multiple names by using a
comma separator and adding each name in double quotes. For example:
"VPN", "F5", "Checkpoint".

Admins can also use an asterisk (*) as a wild-card character in this field. For
example:

n *VPN*: Specifies that any interface having VPN in its device name will be
set as a VPN interface.

n F5*: Specifies that any interface that has a device name starting with F5 will
be set as a VPN interface.

n *Checkpoint: Specifies that any interface name that ends with Checkpoint
will be set as a VPN interface.

All the string comparisons are case-insensitive.

VPN Device Names (macOS) This parameter lets you specify a VPN adapter (device) name and categorize
the network interface as a VPN on macOS.

1. Enter a macOS device name as a Value.
Refer to the description of VPN Device Names (Windows) above for
functionality details.

Global Agent Settings: Run OnGuard As Parameter
You can configure OnGuard to run health checks even if a user is not logged in.

1. Navigate to Administration > Agents and Software Updates > OnGuard Settings.

The OnGuard Settings page opens.

2. Click Global Agent Settings.

The Global Agent Settings dialog opens.
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Figure 777 Global Agent Settings Dialog

3. Click Click to add....
a. Name: Select Run OnGuard As.

b. Value: Select the appropriate option as described in Table 2.

Table 2 describes the available values for the Run OnGuard As parameter.

4. Click Save.

Run OnGuard
As Value Description

Agent Health checks are performed by the OnGuard Agent after the user logs in to the client.

Service OnGuard Agent performs health checks as soon as the client boots up, that is, even before the
user logs in to the client.
When a user logs in to the client, the user can view the most recent health check results via the
OnGuard Agent user interface. The user can perform health checks again by clicking the Retry
button. For details, see the next section, Limitations for the Run OnGuard As Parameter.

BothService
AndAgent

When the user is not logged in to the client, the ClearPass OnGuard Agent service performs
health checks. As soon as the user logs in to the client, the ClearPass OnGuard Agent service
stops health checks and the OnGuard Agent user interface initiates health checks.

Table 2: Global Agent Settings: Run OnGuard As Parameters

Limitations for the Run OnGuard As Parameter
When the Run OnGuard As parameter is set to Service, the following limitations pertain:

1. In Service mode, OnGuard always runs in Health Only mode; that is, OnGuard always sends the client's
MAC address as the User Name.

2. If a user is not logged in, some of the health checks and auto-remediation may fail in Service mode. These
health checks are user-level checks, such as Registry Keys (HKCU), Processes, and Installed Applications (user
applications).

3. When OnGuard Agent is running in Service mode, the OnGuard user interface is used only to display
messages and provide the Retry button (to perform health checks).

4. The Enable to Hide Quit Option does not have any effect in Service mode as the Quit button is only for
exiting the OnGuard user interface.
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Creating OnGuard Custom Web Pages
This section provides the following information:

n About the OnGuard Custom Interface and the Remediation Process

n Creating OnGuard Custom Web Pages

n HTML Content for OnGuard Custom Web Pages

n Important Points

n OnGuard Custom Script Exit Codes

About the OnGuard Custom Interface and the Remediation Process
OnGuard provides the ability to show end users a custom interface, or wizard, that guides them through the
remediation process if their device is quarantined.

When this feature is enabled and OnGuard needs to run a custom remediation script, the wizard tells the user
why the device was denied network access, describes the tasks that are required to fix the problem, and lets
the user choose whether to execute the remedial script or not. While the script is being executed and new
health checks are run, progress messages are displayed.

The pages of the wizard are created using ClearPass Guest’s Web Pages configuration forms, and can be
customized with logo, text, and images (for details, refer to the Custom User Interface parameter in Table 1,
theOnGuard Settings Parameters table).

Enabling the Show Custom User Interface for Custom Scripts Attribute
To configure the Show Custom UI for Custom Scripts attribute:

1. Navigate to Configuration > Enforcement > Profiles, then select or add the Agent Enforcement
profile.

Figure 778 Agent Enforcement > Profile Tab

2. Configure the Agent Enforcement Profile as described in Agent Enforcement Profile.

3. Select the Attributes tab.

4. From the Attribute Name drop-down, select Show Custom UI for Custom Scripts.
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Figure 779 Enabling the Show Custom UI for Custom Scripts Attribute

5. To set this attribute to True, click the Attribute Value check box.

Figure 780 Show Custom UI for Custom Scripts Attribute Enabled

6. If needed, complete the configuration for the Agent Enforcement Profile, then click Save.

7. Use the Agent Script Enforcement Profile to specify the Success Message, Failure Message, Progress
Message, and Description parameters, as well as other script-related attributes (for configuration details,
refer to Configuring Agent Script Enforcement Attributes).

This step is required because the attributes in the Agent Script Enforcement Profile are used when the
Custom UI for Custom Scripts is enabled.

Creating OnGuard Custom Web Pages
To create the OnGuard custom web pages:

1. Navigate to Administration > Agents and Software Updates > OnGuard Settings.

The OnGuard Settings page opens.

2. Scroll down to the Agent Remediation User Interface Customization section.
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Figure 781 Agent Remediation User Interface Customization

3. To enable the Custom User Interface configuration, click (enable) the Configure check box.

The dialog is expanded to show the list of custom web pages you can configure, as well as options to define
window behavior and managed interfaces.

Figure 782 Agent Remediation User Interface Customization Dialog

4. Configure window behavior as described in the following table:
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Parameter Action/Description

Window Behavior Enable one or more Window Behavior settings:
n Always on Top: The Custom User Interface window will always be on top of any other

windows present.
n Allow Minimize: When set to True, the Custom User Interface window can be

minimized.
n Allow Close: Prevents users from closing the Custom User Interface window. If set to

True, users will be allowed to close the Custom User Interface window; however, the
execution of custom scripts will continue in the background.

NOTE: Even if the Allow Close option is enabled, OnGuard Agent disables the Close
button of the custom custom user interface while it is loading a page.

Window Size Specify the window height and width, as well as whether the window size should be a
percentage of the the client's screen or defined by the size in pixels.

Native Dissolvable Agent Customization

Managed Interfaces The Native Dissolvable Agent performs health checks for one of the selected interfaces.
This feature ensures that, if both wired and wireless interfaces are connected, the
OnGuard Agent will send health requests through the correct interface.
Select the type(s) of managed interfaces that are supported for the Native Dissolvable
Agent.
Select the type(s) of interfaces that are supported for the Native Dissolvable Agent:
n Wired
n Wireless
n VPN
n Other

Table 1: Configuring the Custom Web Page Advanced Settings Parameters

5. Click the Create link for the OnGuard custom web page you want to create.

The Create Web Page (New) > Web Page Settings configuration dialog opens.
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Figure 783 Configuring a New OnGuard Custom Web Page

6. Specify the required Create Web Page parameters as described in the following table:

Attribute Name Action/Description

Name Enter a name for the web page. This name is shown only to administrators.

Page Name Enter a page name for this web page. The web page will be accessible from “/guest/page_
name.php."

Enabled Click (enable) this check box to enable this web page.

Description Optionally, enter comments or notes about this web page. This description is shown only
to administrators.

Table 2: Configuring OnGuard Create Web Page Parameters
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Attribute Name Action/Description

Skin From the Skin drop-down, select the skin to apply to this web page.

Title
Enter the title to be displayed on the web page.

HTML Enter the required names for each OnGuard custom web page as well as the
recommended HTML content. For details, see HTML Content for OnGuard Custom Web
Pages below.

Advanced Settings and Access Control
To configure the Custom Web Page Advanced Settings and Access Control settings:

1. From the Create Web Page (New) dialog, check (enable) the Show advanced settings option.

The Advanced Settings section expands to show the full set of advanced options.

Figure 784 Custom Web Page Advanced Settings

2. Specify the Advanced settings and Access Control settings as described in the following table:

Parameter Action/Description

Advanced Settings

Show advanced
settings

To view the Advanced Settings, click the Show advanced settings check box.

Prevent CNA The Apple Captive Network Assistant (CNA) is the pop-up browser shown when joining a
network that has a captive portal. Note that this option may not work with all vendors,
depending on how the captive portal is implemented.

Translations Enable this check box to skip automatic translation handling. Selecting this option keeps
all the current text as the default.
From ClearPass Guest, many fields and pages have translations available under
Configuration > Translations > Page Customizations.

Table 3: Configuring the Custom Web Page Advanced Settings and Access Control Parameters
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Parameter Action/Description

Access Control

Allowed Access Enter the IP addresses and networks from which access is permitted.

Denied Access Enter the IP addresses and networks that are denied access.

Deny Behavior From the drop-down, select one of the following responses to a request that is not
permitted:
n Send HTTP 404 Not Found status
n Show Access Denied page
n Show a blank page

3. Click Create Page.

The OnGuard custom web page is created.

HTML Content for OnGuard Custom Web Pages

The following information is provided in this section:

OnGuard Start Page

n OnGuard Progress Page

n OnGuard Finish Success Page

n OnGuard Finish Error Page

n OnGuard Finish Reboot Page

This section provides the required names for each OnGuard custom web page as well as the recommended
HTML content.

Be sure to use the Page Names specified here as ClearPass Policy Manager and OnGuard Agent look for pages
with these names. Text in italics should not be changed.

OnGuard Start Page
The OnGuard Start Page is the initial web page shown to the end user when script execution begins. This page
might include a Next button.

Page Name: onguard_start

HTML:

<p>Your device does not meet Minimum Specifications, which is required before you can connect to the
Network.</p>

<p>The following is required:</p>

<div id="tasks_list">

</div>

<p>Please click the Next button below to start the remediation needed.</p>

<p>You will be connected to the Network after verification that your device meets all Minimum Security
Specifications.</p>
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<p><button id="next_button" type="button" onclick=""/>Next</button></p>

If the Next button is missing on the OnGuard Start Page, OnGuard Agent will move to the OnGuard Progress Page
after 30 seconds. This time duration is not configurable.

OnGuard Progress Page
The OnGuard Progress Page shows the progress and status of custom scripts that are being executed.

Page Name:onguard_progress

HTML:

<p>Please do not disconnect your device.</p>

<div id="task_progress_list">

</div>

OnGuard Finish Success Page
The OnGuard Finish Success Page is shown after all the scripts have executed successfully and a system reboot
is not necessary. This page includes a Close button.

Page Name:onguard_finish_success

HTML:

<p>We will now rescan your system to verify that it meets Minimum Security Specifications and then connect
you to the Network.</p>

<p>If you are not connected in five minutes, please contact <b>12334</b> or <a
href="https://www.google.com">click here</a> .</p>

<p><button id="close_button" type="button" onclick=""/>Close</button></p>

OnGuard Finish Error Page
The OnGuard Finish Error Page is shown if at least one of the scripts returns Failure and a reboot is not
required. This page includes a Close button.

Page Name:onguard_finish_error

HTML:

<p>Remediating your device to meet Minimum Security Specifications was unsuccessful because:</p>

<div id="failed_tasks">

</div>

<p>Please visit this <a href="https://www.google.com">Support Page</a> to get assistance.</p>

<p><b>You are not yet connected to the Network.</b></p>

<p><button id="close_button" type="button" onclick=""/>Close</button></p>
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OnGuard Finish Reboot Page
Page Name:onguard_finish_reboot

The OnGuard Reboot Page is shown after all the scripts have executed successfully and a system reboot is
necessary. This page includes a Reboot button.

HTML:

<p>We will now rescan your system to verify that it meets Minimum Security Specifications and <b>reboot
your system</b>, then connect you to the Intel Network.</p>

<p>If you are not connected in five minutes, please contact <b>12334</b> or visit this <a
href="https://www.google.com">Support Page</a> to get assistance.</p>

<p><button id="reboot_button" type="button" onclick=""/>Reboot</button></p>

Important Points
This section provides important notes regarding OnGuard Agent behavior when using the Custom User
Interface for Custom Scripts.

In ClearPass Policy Manager 6.6.7, this feature is supported for Windows Persistent Agent only.

1. OnGuard Agent checks the custom script's exit code to compute the custom script's status.

2. OnGuard Agent determines the final page based on the script's exit codes and the client's health status. For
details, see the next section, OnGuard Custom Script Exit Codes.

3. This feature is not supported when OnGuard is running as a service.

4. The Custom User Interface loads a fresh web page from ClearPass Guest every time. It does not cache the
pages.

5. If the user closes the Custom User Interface while the script is executing, OnGuard Agent continues
executing scripts without the Custom User Interface.

6. Administrators will have to refresh or open the OnGuard Settings page again after creating web pages in
ClearPass Guest (Administration > Agents and Software Updates > OnGuard Settings).

7. If the ClearPass Server Certificate is not validated when ClearPass loads the web page for the first time, the
Custom User Interface displays the following security alert:
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Figure 785 Server Certificate Not Validated Security Alert

8. A new option, Server Communication Mode, has been added in Global Agent Settings that you can
configure to avoid receiving a Server Certificate security alert (see the Server Communication Mode
parameter description in Global Agent Settings Parameters for OnGuard Agents).

OnGuard Custom Script Exit Codes
The OnGuard custom script exit codes are comprised of Success Codes and Failure Codes as described
below:

Success Codes (0 to 63)
The range available to Administrators to define their own Success Codes = 3 (0x03) to 63 (0x3F).

n Script executed successfully = 0 (0x00)

n Reboot (Reboot is required) = 2 (0x02)

Failure Codes (65 to 255)
The range available to Administrators to define their own Failure Codes = 65 (0x41) to 255 (0xFF).

n Script executed successfully but its exit code indicates failure = 64 (0x40)

OnGuard Agent Codes (256 onwards):
n Unknown error = 256 (0x100)

n Timeout: Script did not finish execution in expected time = 257 (0x101)

n Failed to read exit code of script = 258 (0x102)

n OnGuard failed to execute script = 259 (0x103

n Script file not found = 260 (0x104)

n Script file did not pass validation checks = 261 (0x105)

n Failed to download script file = 262 (0x106)
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n Execution level is set to “User” but the user is not logged on, so OnGuard was not able to launch the script =
263 (0x107)

Software Updates
This section provides the following information:

n About Software Updates

n Software Updates Page on page 768

n Install Update Dialog Box on page 770

n Reinstalling a Patch on page 771

n Uninstalling a Skin on page 772

About Software Updates
This section describes the ClearPass Policy Manager server software update process.

ClearPass Policy Manager checks for available updates to the ClearPass Webservice server. The administrator
can download and install these updates directly from the Software Updates page (depending on the Cluster-
Wide Parameter settings for those parameters). Use the Software Updates page to register for and receive
live updates for:

n Posture Signature updates
These updates include AntiVirus version updates. The ClearPass server uses these updates to check if the
versions of the AntiVirus and the DAT file are the latest version.

n Windows Hotfixes updates
These updates include a list of available Windows Hotfixes for supported Windows operating systems. The
ClearPass server uses these updates to show a list of the available hotfixes in the Windows Hotfixes health
class.

n Endpoint Profile Fingerprints updates
These updates include fingerprints and are used by ClearPass in profiling endpoints.

Automatic download and installation for these three types of updates are not enabled by default (see General
Parameters for more information).

You can also:

n Reinstall a patch in the event the previous installation attempt fails.

n Uninstall a skin.
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Software Updates Page
To update the software on the current ClearPass server:

1. Navigate to Administration > Agents and Software Updates > Software Updates.

Figure 786 displays the Software Updates page:

Figure 786 Software Updates Page

Table 1 describes the Software Updates parameters

Parameter Action/Description

HPE Passport Credentials

HPE Passport
Credentials

Enter the HPE Passport Credentials provided to you.
This text box is enabled only on a Publisher node.
The first time the HPE Passport Credentials are saved, the ClearPass server
performs the following operations:
n Contacts the Webservice server to download the latest Posture & Profile

Data updates (depending on the Cluster-Wide Parameter settings for those
parameters).

n Checks for any available firmware and patch updates.

Posture & Profile Data Updates

Import Updates To download the Posture and Profile Data Updates to the client (for example, a
Windows laptop):

1. From the client device, log in to the Aruba Support Center.

Table 1: Software Updates Parameters
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Parameter Action/Description

2. Select the Download Software tab, then navigate to ClearPass > Tools >
Posture & Profile Data Updates.
3. Click the desired update(s) (which are in zip file format) and save the file.
4. From ClearPass, click the Posture and Profile Data Updates > Import
Updates button to import the downloaded file into ClearPass.

NOTE: In a ClearPass cluster, the Import Updates option is available on the
Publisher node only.
By default, updates for Posture Signature, Windows Hotfixes, and Endpoint
Profile Fingerprints are not automatically downloaded and installed. To set
these updates to be automatic, you must set the following Cluster-Wide
Parameters to TRUE:
n Automatically download Posture Signature and Windows Hotfixes

Updates
n Automatically download Endpoint Profile Fingerprints
For details, refer to General Parameters .

Firmware & Patch Updates

NOTE: The Firmware & Patch Updates table shows only the data that is known to Webservice or
imported using the Import Updates button.
NOTE: Patch residual files under /var/avenda/platform/backup, /var/avenda/platform/patches ,
and/var/avenda/platform/store/updates seven days old and older are automatically deleted daily.

Import Updates If the server is not able to reach the Webservice server, click Import Updates to
import the latest signed Firmware and Update patch binaries (obtained via
support or other means) into this server.
These patch binaries will appear in the table and can be installed by clicking the
Install button. When logged in as appadmin, you can manually install the
Upgrade and Patch binaries imported via the CLI using the following commands:
n system update (for patches)
n system upgrade (for upgrades)
If a patch requires a prerequisite patch, that patch's Install button will not be
enabled until the prerequisite patch is installed.

Install The Install button appears after the update has been downloaded.
Click Install.
When you click Install, the installation of the update starts and the Install
Update dialog box appears, showing the log messages that are generated.

Re-Install Click Re-Install to reinstall a patch in the event the previous attempt to install
fails.
Reinstalling a patch is available only for the last installed patch.

Uninstall To uninstall a skin, click Uninstall (for details, see Uninstalling a Skin).
NOTE: You cannot uninstall cumulative or point patch updates.

Needs Restart The Needs Restart link appears when an update needs a reboot of the server in
order to complete the installation.
Clicking this link displays the Install Update dialog box, which shows the log
messages generated during the installation.

Installed The Installed link appears when an update has been successfully installed.
Clicking this link displays the Install Update dialog box, which shows the log
messages generated during the installation.
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Parameter Action/Description

Install Error This link appears when an update install encounters an error. Clicking this link
displays the Install Update dialog box, which shows the log messages
generated during the install.

Other

Check Status Now Click this button to perform an on-demand check for available updates. Check
Status Now applies to updates only on a Publisher node, as well as Firmware &
Patch Updates.

Delete Use this option to delete a downloaded update.

Install Update Dialog Box
The Install Update dialog box shows the log messages generated during the installation of an update. This
dialog appears when you click the Install button.

If the dialog is closed, you can bring it up again by any one of the following methods:

n While the installation is in progress, click the Install in progress… link.

n Click the Installed > Install Error link.

n When the installation is completed, click the Needs Restart link.

The following figure displays the Install Update dialog box:

Figure 787 Install Update Dialog Box
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Specify the Install Update parameters as described in the following table:

Parameter Action/Description

Reboot To initiate a reboot of the server, click Reboot.
The Reboot button appears only for updates that require a reboot to complete the
installation.

Clear &
Close

To delete the log messages and close the dialog, click Clear & Close.
Clear & Close also removes the corresponding row from the Firmware & Patch
Updates table.
To delete the log messages from a failed installation, click Clear & Close.
After the log messages are cleared, attempt the installation again.

Close To close the dialog box, click Close.

Table 2: Install Update Parameters

Webservice Operations
System Events (as seen on the Monitoring > Event Viewer page) shows records for events, such as
communication failures with Webservice, successful or failed update downloads, and successful or failed
update installations.

The ClearPass server contacts the Webservice server every hour in the background to download any newly
available Posture & Profile Data updates.

The current list of firmware and patch updates is queried from Webservice every day at a random minute
between 4:00 a.m. and 5:00 a.m. The Webservice server is refreshed with the Antivirus data hourly and with
Windows Updates daily. Fingerprint data and Firmware & Patches are refreshed as soon as new ones are
available.

A new list of firmware and update patches that are available for download and installation are noted by the
Policy Manager server automatically and shown in the user interface. An event is generated and displayed in
the Event Viewer with the list of new updates that are available.

If the event affects an SMTP server, Alert Notification email addresses are configured, and an email from the
Publisher node is sent with the list of downloaded images.

Reinstalling a Patch
The Reinstall Patch feature allows the administrator to reinstall a patch in the event the previous attempt to
install fails.

You can only reinstall the last installed patch, which is indicated by a “!” symbol next to it in the Firmware &
Patch Updates table on the Administration > Agents and Software Updates > Software Updates page.

To reinstall a patch or software update:

1. Navigate to Administration > Agents and Software Updates > Software Updates.

2. In the Firmware & Patch Updates section, click the Installed, Install Error, or Needs Restart link.

3. To reinstall the patch or software update, click Re-Install.
The Install Update screen closes and the reinstallation process begins. A window displays, showing the
installation progress via log messages.
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Uninstalling a Skin
To uninstall a skin:

1. Navigate to Administration > Agents and Software Updates > Software Updates.

2. In the Firmware & Patch Updates section, select the installed skin that you want to uninstall.

Figure 788 Viewing the Installed Link for a Skin

3. Click the Installed link.

The Install Update dialog opens.

Figure 789 Install Update Dialog

4. To uninstall the skin, click Uninstall.
The Install Update screen closes and the software is uninstalled.

Support Services
The Administration > Contact Support page provide information for contacting Support, setting up a
Remote Assistance session, and viewing ClearPass Policy Manager documentation:

n Contacting Support on page 772

n Remote Assistance on page 774

n Accessing ClearPass Documentation on page 777

Contacting Support
The Administration > Support > Contact Support page provides you with information on how to contact
ArubaCare.
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Figure 790 Contact Support Page

Contacting North America Support
To contact ArubaCare Support in North America (United States and Canada), call this number:

1-800-943-5426

Contacting ArubaCare Support in Other Countries:
You can either call ArubaCare in the country of interest or contact Support or create a support case by clicking
the HPE My Networking website link.

To contact ArubaCare Support in countries other than the United States and Canada:

1. Click the Contact Support link.

The Contact Support page for other countries opens.

Figure 791 Contact Support Page for Foreign Countries

2. Scroll down to find the country of interest.
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Remote Assistance
This section provides the following information:

n Remote Assistance Process

n Setting Up a Remote Assistance Session

The Remote Assistance feature allows a Support engineer to log in remotely using Secured Shell (SSH) to a
customer's ClearPass Policy Manager server and perform the following tasks:

n View and operate the ClearPass Policy Manager user interface to debug any issues the customer is
experiencing.

n Perform proactive monitoring of the ClearPass server.

Remote Assistance Process
The Remote Assistance process is as follows:

1. The Administrator sets up a Remote Assistance session.

2. The Support contact receives an email with instructions and credentials to log in to the remote system.

3. The Remote Assistance session is terminated at the end of the specified duration.

You can terminate a session before its stipulated duration.

4. if the ClearPass Policy Manager user interface at the customer site is inaccessible, you can configure a
Remote Assistance session through the ClearPass CLI. For details, refer to the following System Commands.

l system start-rasession
l system status-rasession
l system terminate-rasession

Setting Up a Remote Assistance Session
You can set up a Remote Assistance session on a ClearPass Policy Manager server in either a single node or
cluster setup.

Sessions can be saved and deleted only from the Publisher node. Sessions can be terminated from Publisher
and Subscriber nodes.

To set up a Remote Assistance session:

1. Prior to setting up a Remote Assistance session, you must enter valid HPE Passport Credentials. To do so,
navigate to Administration > Agents and Software Updates > Software Updates.

The Software Updates page opens.
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Figure 792 Software Updates Page

2. Enter the HPE Passport Credentials, then click Save.

3. Navigate to Administration > Support > Remote Assistance.

The Remote Assistance page opens.

4. Click the Add Session link.

The Add Session dialog opens:

Figure 793 Remote Assistance > Add Session Dialog

5. Specify the Add Session parameters as described in Table 1, then click Save.
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Parameter Action/Description

Session Name Enter the name of the Remote Assistance session.

Session Type Specify the Session Type:
n One Time Now
n One Time Future: Initiates a session at a specified date and time.
n Weekly: Initiates a session on a specified weekday at the selected time.
n Monthly: Initiates a session on a specified day of every month at the selected

time.

Duration Specify the duration of the Remote Assistance session in hours and minutes.
The "session begin" time is the time relative to the ClearPass server’s time, and is
specified in a 24-hour format.

Status Indicates the session state. Available states are:
n Saving
n Scheduled
n Initiated
n Running
n Terminated
n Failed

HPE Support
Contact

Enter the email ID of the Hewlett Packard Enterprise (HPE) Support contact.

Table 1: Add Session Parameters

You return to the Remote Assistance page where the new session has been added:

Figure 794 Remote Assistance Session Added

The following table describes the information provided for configured Remote Assistance sessions:

Parameter Description

Name Name of the session.

Type Indicates if the session is a one-time session or a periodic session. To view the schedule
of the session, move the cursor over the entry.

Support
Contact

The email address of the support contact.

Table 2: Remote Assistance Page Description
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Parameter Description

Status Provides the session state. Available states are:
n Saving
n Scheduled
n Initiated
n Running
n Terminated
n Failed
NOTE: You can edit and save a session in Scheduled, Terminated, and Failed states.
n To terminate a session in Running state, select that session and click Terminate.
n To delete a session in Scheduled, Terminated, or Failed states, select that session

and click Delete.
n If a session fails, the Event Viewer indicates the cause of the failure.

Timestamp Displays the server time when the Remote Assistance session status was last updated.

Accessing ClearPass Documentation
The ClearPass Policy Manager Documentation page includes links to frequently-used sections of the
ClearPass Policy Manager Online Help system.

This page also provides links to the PDF version of the ClearPass Policy Manager User Guide and theOnGuard
Agent Support Charts for Plugin Version 1.0 (V3 SDK) and 2.0 (V4 SDK).

To access the Documentation page:

1. Navigate to Administration > Support > Documentation.

The Documentation page opens.
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Figure 795 ClearPass Policy Manager Documentation Page

2. Click the ClearPass documentation you wish to view.

Note that on some browsers (for example, Google Chrome), the selected documentation is displayed on
your screen. On other browsers (for example, Mozilla Firefox), the selected documentation is downloaded in
PDF format to yourDownloads folder.
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Chapter 13
Cluster Update and Upgrade

This chapter covers the following topics:

n Updating Clusters

n Upgrading Clusters

Updating Clusters
This section includes the following information:

n Cluster Update Overview

n Before Updating the Cluster

n Updating the Cluster

n Viewing Update Status

Cluster Update Overview
The Cluster Update page automates the process of updating the ClearPass cluster with Patch and Skin
releases. The cluster Publisher is updated first. You can select one or more Subscribers to be updated
automatically after the Publisher update is complete.

After you initiate the Cluster Update, no manual actions are required until the Publisher and all the selected
Subscribers have been updated.

The Cluster Update performs the following actions:

n Copies the update image to the selected Subscribers.

Subscribers copy the update image over an HTTPS connection from the Publisher.

If you want to avoid the copy on one or more Subscribers:

1. Log in to the Subscriber node.

2. Trigger a download of the update image in the Software Update page.

3. Alternatively, upload the update image through the Software Update page before initiating the cluster
update.

n The Publisher is updated and rebooted (reboot is initiated only if it is mandatory).

After the Publisher update completes, the Cluster Update page is accessible again to review progress and
log messages.

n The Cluster Update is now initiated on the selected Subscribers; after completion, the Subscribers are
rebooted (reboot is initiated only if it is mandatory).

n Where possible, multiple Subscribers are updated in parallel.

n After all selected Subscribers have been updated, you can select and trigger a Cluster Update for any
additional Subscribers.

Time Required for Subscriber Update
The time required for a Subscriber update depends on the following factors:

n Hardware or virtual appliance model. In the case of virtual machine installations, update times vary
significantly based on the I/O per second performance of your virtual machine infrastructure.

n For Subscribers, bandwidth and latency of the network link between the Subscriber and Publisher.
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Before Updating the Cluster
Before updating the ClearPass cluster, complete the following tasks:

1. Before starting the Cluster Update, plan for sufficient downtime and review the Release Notes for the
current ClearPass Policy Manager release.

2. Confirm that Relevant Patch updates are available under the Firmware & Patch Updates area of the
Software Updates page before starting the cluster update. Please download the patches by clicking the
Download button next to the patches on the Software Updates page or load them directly by clicking the
Import Updates button on the Software Updates page.

Only patches listed under Software Updates page are shown in the Cluster Update page.

3. Confirm that your Cluster sync and replications are fine before starting the Cluster Update.

4. When a particular Subscriber's version information is set to "UNKNOWN," it means the Publisher is not able
to contact the remote Subscriber. (If a Subscriber has been disabled and gone out of sync, the Cluster
Update page might not detect the disabled status until the patch failure has occurred, after which the
failed/inaccessible Subscriber is marked asUNKNOWN). Confirm the status of the cluster sync and service
status of Async Network Services in such cases (for details, see Async Network Services Options).

5. In virtual machine environments, ClearPass Policy Manager Virtual appliance host date and time settings
should be in sync with that of the VMware vSphere, Microsoft Hyper-V, or KVM server that is hosting the
instance. Otherwise, you might see inconsistent data in Time Taken columns of the Cluster Update page.

Updating the Cluster
To update the cluster:

1. From the Publisher node, navigate to Administration > Agents and Software Updates > Software
Updates.

2. Click the Cluster Update link.

The Cluster Update page opens.

3. Select the Update Image Name from the drop-down list.

Figure 796 Cluster Update Page

This page provides the information described below in Table 1.
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Field Description

Update Info Describes the patch update details, provides a link to the Release Notes, includes
release-specific comments, and specifies if a reboot is required for the patch.

Database Info Shows the size of the Configuration database.

Publisher Details Information for the Publisher and for all Subscribers in the cluster, including the
management IP address, version number, zone, Insight database size and whether
Insight is enabled, last update step completed, and update status.Subscriber Details

Current/Previous Update
Steps

During the cluster update, this area displays the status of each stage in the process.
As each stage completes, it displays how long it took to complete.

View Logs In each Publisher and Subscriber row, this button when clicked opens the Logs page,
which provides detailed status and log messages for each cluster update stage.

Table 1: Information on the Cluster Update Page

When the update is available locally and all Subscribers have been patched, the Start Update link is
available in the upper-right corner of the page.

4. Click Start Update.

The Start Cluster Update page opens.

Figure 797 The Start Cluster Update Page

You can update the entire cluster or just a subset of Subscribers.

5. In the Start Cluster Update page, use the check boxes to select the Subscriber nodes to update.

6. To force the update, select Force install patch update under the Install Option area.

7. Click Update.

This initiates the automated update process. No further manual steps are required until all selected
Subscribers have been updated. The Publisher is always updated and rebooted first.

The Cluster Update page is not available while the Publisher is rebooted. When the Publisher update is
complete, you can use the Cluster Update page to monitor update progress.
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Viewing Update Status
After the Publisher Update is complete, you can monitor the Update status of the Subscriber nodes at
Administration > Agents and Software Updates > Software Updates > Cluster Update.

The page provides two ways to monitor the progress of the update:

1. On the Cluster Update page, progress indicators in the Current/Previous Update Steps area display the
status of some of the main steps.

Indicators in the Publisher Details and Subscriber Details areas also display when the Publisher or each
Subscriber is in progress or completed.

When the update completes successfully, these areas display a successful update status for the Publisher
and every Subscriber.

2. For detailed progress information, click the View Logs button for a Publisher or Subscriber row.

The Logs page opens. This page includes tabs for the Download, Update, Reboot, and Onboot logs.

You can view detailed status in these logs during and after the update.

This button is not available while the Publisher is rebooted and data migration is in progress. It is available again
when the Publisher update is complete.

Upgrading Clusters
This section includes the following information:

n Cluster Upgrade Overview

n Sample Times Required for Upgrade

n Before You Upgrade

n Upgrading the Cluster

n Viewing Upgrade Status

n Steps in the Cluster Upgrade Automated Workflow

n Troubleshooting Tips

Cluster Upgrade Overview
The Cluster Upgrade page automates the upgrade procedure for a ClearPass cluster. When the upgrade is
initiated, no manual actions are required until the Publisher and all selected Subscriber nodes have been
upgraded.

The Cluster Upgrade page can be used to upgrade ClearPass 6.5.3, 6.5.7, and 6.6.x systems to ClearPass 6.7.
It cannot be used to upgrade to an earlier version of the Cluster Upgrade tool.

If you have an earlier version of the Cluster Upgrade Tool already installed, you can install this version directly
over the earlier version of the tool; no cleanup steps are needed.

Cluster Upgrade Process Overview
These tasks summarize the high-level cluster upgrade process:

1. Download the upgrade image from the Software Updates page.

2. Initiate the Upgrade procedure (see Upgrading the Cluster).

The Cluster Upgrade tool automatically performs the upgrade.

3. After the upgrade, verify that the Publisher and all Subscriber nodes in the cluster are back in sync and all
services are accessible (see Viewing Upgrade Status).

Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1815



Cloning a virtual machine to facilitate a ClearPass deployment is not recommended or supported.

Steps in the Cluster Upgrade Automated Workflow
This section describes the steps that are automatically completed by the Cluster Upgrade.

1. To prepare the Subscriber nodes for upgrade, a patch that provides required API support is automatically
installed by the Cluster Upgrade on every Subscriber.

The Cluster Upgrade uses remote API calls to control and monitor upgrade progress on the Subscribers.

To install the patch for API support on the subscribers, Subscribers must be able to access the Publisher over HTTP,
or they must be able to access the Publisher over HTTPS using its hostname and validate the certificate that is
presented (trust the issuer and match the hostname in the certificate CN).

2. After you select the Subscriber nodes and click Upgrade, the upgrade image is copied to the Subscribers
you selected.

The Subscribers copy the upgrade image over an HTTPS connection from the Publisher.

If the upgrade image is already present on a Subscriber node (assuming you have downloaded it from the
Software Updates page, or uploaded it in the Software Updates page), the existing upgrade image on the
Subscriber is used for the upgrade.

3. If the Standby Publisher settings were configured, they are temporarily disabled. This setting is restored
after all Subscribers have been upgraded.

4. The Publisher is the first to be upgraded and rebooted. Configuration database and Insight database
migration is performed on reboot.

5. When the Publisher upgrade is complete, you can use the Cluster Upgrade page to review log messages.

6. When the Publisher upgrade is complete, upgrade is initiated on each selected Subscriber. When possible,
multiple Subscribers are upgraded in parallel. When each Subscriber is complete, the Subscriber node is
rebooted.

7. During the parallel upgrade process, upgrade of the first Subscriber begins five minutes after the Publisher
upgrade is completed.

8. Upgrade of the second Subscriber begins five minutes after the upgrade of the first Subscriber begins. This
pattern continues sequentially for all Subscriber nodes in the cluster, with a five-minute delay between each
start time.

9. When each Subscriber is rebooted, it is added back into the cluster. Insight data is migrated and restored.

10.When all selected Subscribers have been upgraded, you can select and trigger the upgrade operation for any
additional Subscriber nodes.

11.When all the Subscribers in the cluster have been upgraded, the Standby Publisher settings are restored.

Detailed information for each of these steps is available in the Logs page during and after upgrade.

Sample Times Required for Upgrade
To help you estimate how much time the upgrade might take, Table 1 displays representative numbers for
upgrade times under test conditions. Keep in mind that the figures here are only examples. The actual time
required for your upgrade depends on several factors:

n Your hardware or virtual appliance model. In the case of virtual appliance installations, upgrade times vary
significantly based on the I/O per second performance of your virtual appliance infrastructure.

n The size of the configuration database to be migrated.

n For ClearPass Insight appliances, the size of the Insight database.
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n For Subscribers, the bandwidth and latency of the network link between the Subscriber and the Publisher.

For the most current information about times required for upgrade, refer to the "Before Upgrade" section of the
ClearPass 6.7 Release Notes.

Hardware
Model

Config DB
Size

Insight
DB Size

Publisher
Upgrade
Time

Subscriber
Upgrade Time

Insight Restoration
Time

C1000 100 MB 5 GB 50 minutes 50 minutes 20 minutes

200 MB 5 GB 60 minutes 60 minutes 20 minutes

C2000 100 MB 5 GB 50 minutes 50 minutes 15 minutes

200 MB 5 GB 60 minutes 60 minutes 15 minutes

C3000 200 MB 5 GB 30 minutes 30 minutes 15 minutes

500 MB 10 GB 40 minutes 40 minutes 20 minutes

Table 1: Sample Times Required for Upgrade

Before You Upgrade
Before you begin the cluster upgrade process, ensure that the following tasks have been completed:

1. Review this section and the latest Release Notes for ClearPass 6.7.

2. Plan for adequate downtime for the upgrade. Use the upgrade time estimates in Table 1 as a guide.

3. If the cluster password contains special characters, change it temporarily to only use alphanumeric
characters (letters and numbers) before installing this patch. You can change the cluster password back to
the old password after the cluster upgrade completes.

4. HTTP, HTTPS, and SSH port traffic must be allowed between the cluster appliances. This is required for the
Cluster Upgrade to be able to communicate between appliances.

Verify that the following ports are in an open state between the cluster appliances:

l Port 80 (HTTP)

l Port 443 (HTTPS)

l Port 22 (SSH)

5. Confirm that the Publisher and all Subscriber nodes in the cluster are in sync before starting the upgrade.

6. On the Software Updates page, enter the HPE Passport Credentials.

7. On the Publisher, download the ClearPass 6.7 upgrade image from the Software Updates page (see
Software Updates).

The Cluster Upgrade page automates the process of copying over the upgrade image to the selected
Subscriber nodes in the cluster.

8. If you are upgrading on a reverted system (retrying an upgrade), you will need to replace the contents of
certain directories first before triggering the new upgrade. Please contact Aruba Support (see Contacting
Support), who will assist you with the following tasks:

a. Copying the contents of the /var/avenda/platform/store/updates/backup/* directory to the
/var/avenda/platform/store/updates/ directory.

b. Clearing the contents of the /var/avenda/tips/upgrade/db/* directory.
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c. Restarting the cpass-admin-server on the Publisher (for more information, see Service Commands).

9. When a particular Subscriber's version information is set to "UNKNOWN," it indicates that the Publisher is
not able to contact the remote Subscriber.

If a Subscriber has been disabled and gone out of sync, the Cluster Upgrade page might not detect the
status until the patch failure has occurred, after which the failed or inaccessible subscriber is marked as
UNKNOWN.

In such cases, confirm the status of the cluster sync and the service status of Async network services (for
details, see Async Network Services Options).

a. In virtual machine environments, ClearPass Policy Manager virtual machine host date and time settings
should be in sync with that of the VMware vSphere Hypervisor server, Microsoft Hyper-V server, or KVM
server that is hosting the instance. Otherwise, you might see inconsistent data in Time Taken columns
of the Cluster Upgrade page.

Upgrading the Cluster
To upgrade the ClearPass cluster:

1. From the Publisher node, navigate to Administration > Agents and Software Updates > Software
Updates.

2. Click the Cluster Upgrade link.

The Cluster Upgrade page opens.

Figure 798 Cluster Upgrade Page

This page includes the information described below in Table 1.

Field Description

Upgrade Info Describes the upgrade image's name and size, and includes release-specific comments.

Database Info Shows the size of the Configuration database.

Table 1: Information on the Cluster Upgrade Page
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Field Description

Publisher Details Provides information for the Publisher and for all Subscribers in the cluster. Information
includes the management IP address, version number, zone, Insight database size, last
upgrade step completed, and upgrade status.

Upgrade Steps During the cluster upgrade, this area displays the status of each stage in the process. As
each stage completes, it displays how long it took to complete.

View Logs In each Publisher and Subscriber row, clicking this button opens the Logs page which
provides detailed status and log messages for each upgrade stage.

When you open the Cluster Upgrade page, it immediately prepares the Subscriber nodes for upgrade by
automatically installing the required additional API support.

This is a background process and does not require any actions from the user. A progress indicator is
displayed during this stage.

To install the patch for API support on subscribers, these subscribers must be able to access the Publisher over
HTTP, or they must be able to access the Publisher over HTTPS using its host name and validate the certificate that is
presented (that is, trust the issuer and match the host name in the certificate Common Name (CN)).

When the 6.7 upgrade image is available locally and all subscribers have been patched, the Start Upgrade
link is available.

3. Click Start Upgrade.

The Start Cluster Upgrade page opens.

Figure 799 The Start Cluster Upgrade Page

You can upgrade the entire cluster or just a subset of Subscribers.

4. In the Start Cluster Upgrade window, use the check boxes to select the Subscribers to upgrade.
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5. In the LogDB backup and restore options drop-down list, select one of these options:

a. Access tracker records are backed up but will not be restored: Select if you need a backup of the
access tracker records to potentially restore after upgrade.

This option increases the overall upgrade time.

b. Do not backup access tracker records: Select if you do not need a backup of the access tracker
records.

6. Click Upgrade.

The Cluster Upgrade begins the automated upgrade process.

No further manual steps are required until all selected Subscribers have been upgraded. For information on
the automated process, see Steps in the Cluster Upgrade Automated Workflow.

The Publisher is always upgraded and rebooted first. The Cluster Upgrade page is not available while the
Publisher is rebooted and data migration is in progress.

7. When the Publisher upgrade is complete, navigate to the Cluster Upgrade page to monitor upgrade
progress, as described in Viewing Upgrade Status.

8. After a successful upgrade, confirm that all the Subscriber nodes in the cluster are back in sync and all the
services are accessible.

9. Verify that any preexisting Standby Publisher settings are restored:

Navigate to Administration > Server Manager > Server Configuration > Cluster-Wide Parameters
link >  Standby Publisher tab.

Viewing Upgrade Status
After the publisher upgrade is complete, you can monitor the upgrade status of the Subscriber nodes at
Administration > Agents and Software Updates > Software Updates > Cluster Upgrade.

This feature provides two ways to monitor the progress of the upgrade:

1. On the Cluster Upgrade page, progress indicators in the Upgrade Steps area display the status of some
of the main steps.

Indicators in the Publisher Details and Subscriber Details areas also display when the Publisher or each
Subscriber node is in progress or completed.

When the upgrade is complete, these areas display a successful upgrade status for the Publisher and every
Subscriber node.

2. For detailed progress information, click the View Logs button for the publisher or subscriber row.

The Logs page opens. This page includes tabs for the Patch, Download, Upgrade, Reboot, and Onboot
logs.

You can view detailed status in these logs during and after the upgrade.

This option is not available while the Publisher is rebooted and data migration is in progress. It is available again
when the Publisher upgrade is complete.

Troubleshooting Tips
Here are a couple of troubleshooting tips when upgrading a cluster:

n If you encounter errors while upgrading a Subscriber node, use a manual upgrade procedure to upgrade the
Subscriber after the root cause for the upgrade failure has been fixed.

n If you need to revert to the previous version of ClearPass, you can do so manually from the CLI for
individual subscribers (see Cluster Commands).
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Be aware that all status and progress information is reset when the Publisher is reverted to a previous
version. You can initiate the upgrade again from the Cluster Upgrade page.
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Chapter 14
Configuring Processing for Ingress

Events

This chapter includes the following information:

n Enabling Ingress Event Dictionaries

n Configuring the Ingress Event Source

n Configuring an Event-Based Enforcement Service

n Configuring the Ingress Receiving Ports

n Enabling Ingress Events Processing

This chapter provides the procedures for configuring ClearPass Policy Manager to process ingress threat-
related events.

The ClearPass Ingress Event Engine processes inbound threat-related events (which are Syslog events received
from any third-party vendor device) and performs enforcements and actions based on the defined
enforcement policies and services.

Enabling Ingress Event Dictionaries
By default, a set of ingress event dictionaries are available and initially set to disabled. You must enable the
ingress event dictionaries before you proceed.

To enable an ingress event dictionary:

1. Navigate to Administration > Dictionaries > Ingress Events.

The Ingress Events Dictionaries page opens. The set of ingress event dictionaries are displayed. By
default, they are disabled.

Figure 800 Viewing Ingress Event Dictionaries

2. To enable a dictionary, select the disabled Ingress Events Dictionary for the appropriate vendor.

The Events Attributes dialog opens.
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Figure 801 Enabling an Ingress Events Dictionary

3. To enable the selected ingress events dictionary, click Enable.

You return to the Ingress Events Dictionaries page. The dictionary information is no longer displayed in
red and the Status column is set to Enabled (see Figure 802).

Figure 802 Ingress Events Dictionary Enabled

Configuring the Ingress Event Source
An event source is a device that sends Syslog events to ClearPass.

Any events sent that are not from configured event sources are ignored.

To configure an Event Source:

1. Navigate to Configuration > Network > Event Sources.

The Event Sources page opens.

2. To add the Event Source for the desired vendor, click Add.

The Add Event Source dialog opens.
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Figure 803 Adding an Event Source

3. Populate the Add Event Source parameters as described in Table 1.

Parameter Action/Description

Name Enter the name or the IP address of the device that will send Syslog events to ClearPass.

Description Optionally, enter a description of this Event Source.

IP Address Enter the IP address of the device that will send Syslog events to ClearPass.

Type From the drop-down, select Syslog.

Vendor From the drop-down, select the event source Vendor:
n Aruba Introspect
n Check Point
n Infoblox
n Juniper Networks
n Palo Alto Networks

Enable Select this check box to enable the device as an Event Source.

Table 1: Configuring the Add Event Source Parameters

4. When finished, click Add.

The Event Sources page now displays the new Event Sources (see Figure 804).

Figure 804 Event Sources Page

Note that the IP address displayed in Figure 804 is the IP address and host name of the Juniper SRX
gateway that sends Syslog events to ClearPass.
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Configuring the Ingress Receiving Ports
The ingress receiving ports are the TCP (Transmission Control Protocol) and UDP (User Datagram Protocol)
ports on the ClearPass server where the events source sends ingress-related events.

By default, the ingress receiving port is 514 for both TCP and UDP. You can modify the ingress receiving ports
with a custom value as necessary.

To confirm or change the ingress receiving ports on the ClearPass server:

1. Navigate to Administration > Server Manager > Server Configuration.

2. From the list of ClearPass servers, select the appropriate server.

The Server Configuration page opens.

3. Select the Service Parameters tab.

4. From the Select Service drop-down, choose Ingress syslog service (see Figure 805).

Figure 805 Selecting the Ingress Syslog Service

As you can see in Figure 805, the parameter value for both the TCP and UDP receiving ports is set to the
default value of 514.

5. If you wish to modify the port numbers for one or both of the receiving ports, enter the new value(s).

6. When satisfied with the settings, click Save.

Configuring an Event-Based Enforcement Service
This section provides the following information:

n Introduction

n Adding an Event-Based Enforcement Service

n Associating the Service with an Enforcement Policy

Introduction
This section describes how to add the Event-Based Enforcement service that manages enforcement actions
in response to threat-event processing.

When there is a suspicious user, this user could represent a common DOS attack or some other threat. When a
threat is detected, ClearPass performs enforcement operations as configured; for example, executing a change
of authorization ( COA ) to disconnect a suspicious user from the network.

Adding an Event-Based Enforcement Service
To add an event-based enforcement service:

1. Navigate to Configuration > Services.

The Services page opens.
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2. To add the service, click Add.

The Add Services dialog opens.

3. From the Type drop-down list, select Event-based Enforcement (see Figure 806).

Figure 806 Specifying Event -Based Enforcement

4. Specify the Service tab parameters for this service as described in the following table:

Parameter Action/Description

Type Select Event-based Enforcement.

Name Enter the name or label for the service you want to create.

Description Enter the description that provides additional information to identify the service. This field is
optional but recommended.

Monitor Mode Optionally, check Enable to monitor network access without enforcement to allow
authentication and health validation exchanges to take place between the endpoint and
Policy Manager, but without enforcement.
In Monitor Mode, no enforcement profiles (and associated attributes) are sent to the
network device.

Service Rule

Matches Select one of the following:
n ANY: Matches one of the configured conditions.
n ALL: Specifies to match all of the configured conditions.

Type Select the type of data filter:
n Date
n Event
Then configure the Name, Operator, and Value for the selected type accordingly.

Name Select the name of the attribute.
The Name list varies according to which Type you selected.

Operator Select any subset of string data type operators from the Operator drop-down list.

Value Enter or select the value of the attribute.

Table 1: Event-Based Enforcement > Service Parameters
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Associating the Service with an Enforcement Policy
After you create the event-based enforcement service, you must associate the service with an enforcement
policy.

To associate the service with an enforcement policy:

1. From the Add Services > Service page, click Next.

The Services > Enforcement page opens.

Figure 807 Selecting the Ingress Events Enforcement Policy

From the Add Services > Enforcement page, you can either select an existing enforcement policy or
create a new one.

2. Specify the Add Services > Enforcement parameters as described in the following table, then click Save.

Parameter Action/Description

Use Cached Results Select this check box to use cached roles and posture attributes from previous
sessions.

Enforcement Policy From the drop-down list, select the preconfigured enforcement policy. This is
mandatory.
If you do not have any preconfigured enforcement policies, click the Add New
Enforcement Policy link to create a new enforcement policy.

Enforcement Policy Details

Description Displays additional information about the selected enforcement policy.

Default Profile Displays the name of the profile applied by the selection of the enforcement
policy.

Rules Evaluation Algorithm Shows the first matched rule and returns the role; or selects all matched rules
and return a set of roles.

Conditions Displays the conditions configured for the selected enforcement policy rules
configuration.

Enforcement Profiles Displays the enforcement profile(s) specified in the selected enforcement
policy.

Table 2: Add Service > Enforcement Page Parameters
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Enabling Ingress Events Processing
The final task is to enable ingress events processing.

To enable ingress events processing on the ClearPass server:

1. Navigate to Administration > Server Manager > Server Configuration.

2. From the list of ClearPass servers, select the appropriate server.

The Server Configuration page opens to the System tab.

Figure 808 Enabling Ingress Event Processing

3. Click the Enable Ingress Events Processing check box.

The following warning dialog is displayed, alerting you to the impact on system performance that may occur
when you enable ingress events processing.

Figure 809 Warning Dialog for Enabling Ingress Events Processing

4. To proceed with ingress events processing on this server, click Yes.

For details on the Server Configuration > System Tab parameters, see System Page.
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Chapter 15
OnGuard Dissolvable and Native

Agents

This chapter includes the following information:

n Introduction

n Authentication in Guest Web Login Using OnGuard Native Dissolvable Agent

n Accessing the OnGuard Support Charts

n Unified Agent System Tray Status Icons

n Upgrading From OnGuard Plugin Version 1.0 to 2.0

n Native Agents Only Mode

n Configuring Web Agent Flow—Native Agent

Introduction
ClearPass OnGuard controls compromised devices by detecting and blocking access to unsecure or unhealthy
devices. The client is denied access to network resources across wired, wireless, and remote networks when it is
determined to be unsecure, which is accomplished by running an extensive posture assessment.

The OnGuard Agent is supported by Windows, Linux, and MacOS devices. For information on the supported
browsers for OnGuard Native agent, refer to the ClearPass Release Notes.

You can configure the OnGuard Dissolvable Agent flow in different modes to perform health scans on
endpoints. This section provides information on the end-to-end flow and how to configure OnGuard
Dissolvable Agent in Native Agents Only mode.

The Native Dissolvable Agent communicates with ClearPass Guest to send information about endpoints such
as status, health status, remediation messages and so on. This communication is independent of the operating
systems and browsers (for details, see Native Agents Only Mode).

Authentication in Guest Web Login Using OnGuard Native
Dissolvable Agent
n Creating a Guest Web Login Page for Native Dissolvable Agent

n Creating a RADIUS Service in ClearPass for VPN Authentication

n Configuring the Guest Access - Web Login Service Template

n Configuring a Web-Based Health Check Only Service

n Enabling the VPN Interface

n Access Tracker Requests Reflect Credentials

This section describes how to enable application authentication in Guest Web Login pages while using the
OnGuard Native Dissolvable Agent to also identify the username.

The Dissolvable Agent, by default, does not perform end-user authentication.

The OnGuard Dissolvable Agent can be supported with VPN interfaces when:
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n The same username is used to identify the client in both RADIUS VPN authentication and application
authentication.

n The Pre-Auth Check is configured using one of the following values (refer to Table 1 for details):

l App Authentication

l Local

l RADIUS

l Single Sign On

Creating a Guest Web Login Page for Native Dissolvable Agent
To create a Guest Web Login page for Native Dissolvable Agent:

1. Log in to ClearPass Guest, then navigate to Configuration > Pages > Web Logins.

The Web Logins page opens.

2. Click the Create a new web login page link.

The Guest Web Login Editor opens.

For details about the fields and settings available through the Web Login Editor, refer to the "Creating and
Editing Web Login Pages" section in the ClearPass Guest Online Help.

Figure 810 Guest Web Login Editor
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3. Specify the Web Login Editor parameters as described in the following table:

For details about all the settings available in the Web Login Editor, see the "Creating and Editing Web Login Page"
section in the ClearPass 6.7 Guest User Guide.

Field Action/Description

General Properties

Name (Required) Enter the name for the page.

Page Name Enter the Identifier page name that will appear in the URL—for example, "/guest/page_
name.php".
The Page Name must consist of letters, numbers, underscore ( _ ), or dash ( - ).

Description Enter additional information or comments about the page.

Vendor Settings (Required) Specifies vendor-specific settings for network configuration. This drop-down list
includes a list of vendors you can select from and a list of Other settings.
n Select Aruba Networks.

Login Method Specifies how the user's network login should be handled.
n Select Policy Initiated—An enforcement policy will control a change of

authorization.
This option should be selected if you are using OnGuard health checks.

Address (Required) Enter the IP address or hostname of the vendor's product.

Secure Login Specifies the security option to use for the Web login process. Options include:
n Use vendor default
n Secure login using HTTPS
n Send cleartext passwords over HTTP

Allowed Dynamic Enter the IP addresses and networks that will be allowed.

Denied Dynamic Enter the IP addresses and networks that will be denied.

Dynamic Address For multi-controller deployments, if selected, this option enables sending the IP address to
submit credentials. When enabled, the Allowed Dynamic and Denied Dynamic fields are
added to the form.

Page Redirect

Security Hash Specifies the level of checking to apply to URL parameters passed to the Web Login page.
n Select Do not check —login will always be permitted.

Login Form

Authentication Specifies the authentication requirement method to use.
n Select Credentials — Require a username and password.

Prevent CNA If selected, this option enables bypassing the Apple Captive Network Assistant (CNA). The
CNA is the pop-up browser shown when joining a network that has a captive portal.
n Click this check box to enable the Prevent CNA option.

Custom Form If selected, indicates you will provide a custom login form. You must supply your own HTML
login form for the header and footer HTML areas.

Table 1: Web Login Editor Properties for Native Dissolvable Agent Page
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Field Action/Description

Custom Labels If selected, this option enables altering the default labels and error messages. When
enabled, this option adds the Pre-Auth Error field to the form.

Pre-Auth Error Customized label text to display if username and password lookup fails. Leave blank to use
the default (Invalid username or password).

Pre-Auth Check Specifies how the username and password should be checked before authentication.
n Select App Authentication – check using Aruba Application Authentication.
When App Authentication is not enabled, Native Dissolvable Agent uses the MAC address
as the user name.
When App Authentication is enabled (with Health Check also enabled), instead of using
the MAC address as the username in the WebAuth Request, Native Dissolvable Agent
sends the username specified in the App Authentication option.
If Pre-Auth Check has one of the following values, Native Dissolvable Agent sends the
username specified in App Authentication:
n App Authentication: Check using Aruba Application Authentication.
n Local: Match a local account.
n RADIUS: Check using a RADIUS request.
n Single Sign On: Enable Single Sign-On for this web login.

When this option is selected, guests are redirected to the Identity Provider (IdP)
configured in ClearPass, where they authenticate themselves. They are redirected back
to ClearPass, which verifies the login was successful and uses the same credentials to
redirect to the actual Web login flow. (To enable SSO support, go to Policy Manager >
Configuration > Identity > Single Sign-On).

Terms Select this check box to require the user to mark a check box to accept a Terms and
Conditions agreement.

Default Destination Default Destination

Default URL (Required) Specify the default URL for the redirect page.
For external domains, this must include the http:// prefix.

Override Destination Select this check box to force the default destination for all clients, overriding any default
value already set on the client.

Login Page

For descriptions and details about the Login Page options, refer to the "Creating and Editing Web Login Pages"
section in the ClearPass Guest Online Help > Table 4: Web Login Editor, Login Page Parameters.

Advertising Services

Advertising The Enable Advertising Services content check box lets you selectively enable
Advertising Services for each Web Login page on which you want to display advertising.

Cloud Identity

Options in the Cloud Identity area let you present guests with various cloud identity or social network login
options.
For descriptions and details about the Cloud Identity options, refer to the "Creating and Editing Web Login Pages"
section in the ClearPass Guest Online Help> Table 5: Web Login Editor Form, Cloud Identity Area: Enabling Cloud Identity
or Social Network Logins and Table 6: Web Login Editor Form, Cloud Identity Area, Authentication Providers.

Multi-Factor Authentication
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Field Action/Description

Options in the Multi-Factor Authentication area let you require a secondary factor when authenticating. When the
guest enters their username to log in, they are sent a code which they must successfully retrieve and enter to
complete the login.
For descriptions and details about the Multi-Factor Authentication options, refer to the "Creating and Editing Web
Login Pages" section in the ClearPass Guest Online Help > Table 7: Web Logins Editor, Multi-Factor Authentication.

Network Login Access

Allowed Access Specify the IP addresses and networks from which logins will be allowed. (IPv4 and IPv6 are
both supported.)

Denied Access Specify the IP addresses and networks from which logins will be denied. (IPv4 and IPv6 are
both supported.)

Deny Behavior (Required) Specify the response shown to the user if their login request is denied. Options
in this drop-down list include:
n Send HTTP 404 Not Found status
n Show Access Denied page
n Show a blank page

Post-Authentication

Health Check Select this check box to require the guest to pass a health check before they can access the
network. The health check is done automatically through the OnGuard Dissolvable Agent.
n Header HTML: Enter the HTML content to display above the health check text. The

default content is shown, and can be modified. You can also use the drop-down list to
add images or other content items.

n Footer HTML: Enter the HTML content to display below the health check text. The default
content is shown, and can be modified. You can also use the drop-down list to add
images or other content items.

Update Endpoint To have the endpoint's attributes updated with other details from the user account, enable
(select) the Mark the user's MAC address as a known endpoint check box.
Specify the list of name-value pairs to pass as custom attributes. Follow the format user_
field | Endpoint Attribute. Examples are shown in this text box.

4. Click Save Changes.

You return to the Web Logins page, where the name of the new page is now displayed.

Figure 811 New Guest Web Login Page Added

Creating a RADIUS Service in ClearPass for VPN Authentication
To create a RADIUS service in ClearPass for VPN Authentication:
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1. In ClearPass, navigate to Configuration > Services.The Services page opens.

2. Click Add. The Add Services dialog opens.

3. From the Type drop-down, select RADIUS Enforcement (Generic). The RADIUS Enforcement
(Generic) service configuration dialog opens:

Figure 812 Add RADIUS Enforcement (Generic) Service Configuration Dialog

4. Proceed to configure the RADIUS Enforcement service to match the service settings displayed in Figure 813.

Figure 813 Summary of the RADIUS Enforcement Service

For details on configuring RADIUS Enforcement Services (Generic), refer to RADIUS Enforcement (Generic)
Service on page 75.

5. Specify the RADIUS Enforcement Service (Generic) service parameters as described in the table below.
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Parameter Action/Description

Service

Name Enter the name of the service.

Description Provide additional information that helps to identify the service.

Type Select RADIUS Enforcement (Generic) .

Status Enabled

Monitor Mode Disabled

More Options Not required.

Authentications

Authentication Methods Specify the following authentication methods:
n EAP-MSCHAPV2
n MSCHAPV2
n EAP-PEAP
Add additional authentication methods as needed for this service.

Authentication Sources Select the following authentication sources:
n [Local User Repository] [Local SQL DB]
n [Guest User Repository] [Local SQL DB]
NOTE: You can also add Active Directory (AD) as an authentication source.

Strip Username Rules Not required.

Service Certificate Not required.

Roles

Role Mapping Policy Not required.

Enforcement

User Cached Results Select this check box to use cached roles and posture attributes from previous
sessions.

Enforcement Policy Select [Sample Allow Access Policy].

Table 2: Aruba RADIUS Enforcement (Generic) Service Parameters

6. Click Save.

Configuring the Guest Access - Web Login Service Template
In this web login service, you associate theGuest Web Login page for Native Dissolvable Agent created earlier
(see Creating a Guest Web Login Page for Native Dissolvable Agent above) with the Guest Access - Web
Login service.
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To configure the Guest Access - Web Login service:

1. Navigate to Configuration > Service Templates & Wizards.

The list of ClearPass Service Templates and Wizards opens.

2. Select Guest Access - Web Login.

The Guest Access Web Login service template opens:

Figure 814 Guest Access- Web Login Service Template

3. In the Name Prefix field, enter the prefix.

This prefix is appended to services that use the Guest Access - Web Login template.

4. Click Next.

The Service Rule dialog opens.

Figure 815 Guest Access - Web Login Service Rule Configuration

5. Select the Guest Access Restrictions tab to specify the days of the week that guest users are allowed
network access.

6. Click Add Service.

You return to the Services page. The following message is displayed:

Added 1 Enforcement Policies

Added 1 Service(s)

Configuring a Web-Based Health Check Only Service
To create a Web-Based Health Check Only service:

1. Navigate to Configuration > Services, then click the Add link.

The Add Services dialog opens.

2. From the Type drop-down, select Web-based Health Check Only.

The Web-based Health Check Only service configuration dialog opens:
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Figure 816 Web-based Check Only Service > Service Tab

3. Proceed to configure the Web-based Health Check Only service to match the service settings displayed in
Figure 817.

Figure 817 Summary of Web-based Health Check Only Service

4. Specify the Web-based Health Check Only service parameters as described in the following table.

Parameter Action/Description

Service

Name Enter the name of the service.

Description Provide additional information that helps to identify the service.

Type Select Web-based Health Check Only .

Status Enabled

Table 3: Web-based Check Only Service Parameters
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Parameter Action/Description

Monitor Mode Disabled

More Options Click the check box for Posture Compliance.
The Posture tab is added.

Service Rule

Type Select Host.

Name Select CheckType.

Operator Select MATCHES_ALL.

Value Select Health.

Roles

Role Mapping Policy Not required.

Posture

Posture Policies Select Posture_Compliance.

Default Posture Token HEALTHY

Remediate End-Hosts Disabled

Remediation URL N/A

Enforcement

User Cached Results Disabled

Enforcement Policy Select [RADIUS_CoA_Terminate Session].

5. Click Save.

For details on configuring a Web-based Health Only service, refer to Web-based Health Check Only Service.
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Enabling the VPN Interface
To enable the VPN interface in the set of managed interfaces:

1. Navigate to Administration > Agents and Software Updates > OnGuard Settings.

The OnGuard Settings page opens.

Figure 818 Enabling the VPNManaged Interface

2. In the Native Dissolvable Agent Customization > Managed Interfaces section, check (enable) the
VPN check box. (The Wired and Wireless interfaces are enabled by default.)

3. Click Save.

Access Tracker Requests Reflect Credentials
As shown in Figure 819, the ClearPass Access Tracker shows that the credentials configured in the RADIUS
Enforcement service are the same credentials used in the Guest Web Login and the Webauth service.

Figure 819 Access Tracker Information

n The RADIUS request is obtained when connected to a VPN.

n The Application authentication is obtained when logged into Guest Web Login.

n The Webauth request is obtained after health checks have been performed.

Accessing the OnGuard Support Charts
For information about the OnGuard Agent Support Charts that are included with ClearPass Policy Manager,
navigate to:

Administration > Support > Documentation > OnGuard Agent Support Charts

There are two sets of support charts provided:

n OnGuard Agent Support Charts for Plugin Version 1.0 (OnGuard Detection V3 SDK)

n OnGuard Agent Support Charts for Plugin Version 2.0 (OnGuard Detection V4 SDK)

ClearPass 6.7 Policy Manager | User Guide OnGuard Dissolvable and Native Agents | 808
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1840



809 | OnGuard Dissolvable and Native Agents ClearPass 6.7 Policy Manager |  User Guide

The plugin version 2.0 support charts pertain to the V4 SDK.

Figure 820 OnGuard Agent Support Charts for Plugin Versions 1.0 and 2.0

Unified Agent System Tray Status Icons

This section provides the following information:

n About the Unified Agent

n Unified Agent System Tray Icons

n OnGuard-Only System Tray Icons

About the Unified Agent
ClearPass Onguard agent is integrated with Aruba VIA (Virtual Internet Adapter) to support both VIA
functionality and Onguard agent system health status collection. Thus, the integrated product is the called the
Unified Agent.

NAP (Network Access Protection) is a framework to collect system health status on Microsoft clients.ClearPass
supports health status collection for both NAP and OnGuard.

The Unified Agent System Tray icons display the following states of the Unified Agent status:

n OnGuard health status

n Trusted or untrusted network status

n VPN connectivity status

n Error conditions
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Unified Agent System Tray Icons
Table 1 describes that icons that indicate the possible states for the Unified Agent.

OnGuard Status Network Type VPN Status Icon

Healthy
Trusted Connected

Healthy Trusted Disconnected

Unhealthy Trusted Connected

Unhealthy Trusted Disconnected

Healthy Untrusted Connected

Healthy Untrusted Disconnected

Unhealthy Untrusted Connected

Unhealthy Untrusted Disconnected

Healthy N/A Error

Unhealthy N/A Error

Logged Out: No Health
Status

N/A Error

Error
Trusted Connected

Error Trusted Disconnected

Error Untrusted Connected

Error Untrusted Disconnected

Error No Profile N/A

Table 1: Unified Agent System Tray Icons
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OnGuard Status Network Type VPN Status Icon

Error N/A
Error

Healthy No Profile N/A

Unhealthy No Profile N/A

Logged Out: No Health
Status

No Profile N/A

Logged Out: No Health
Status

Trusted Connected

Logged Out: No Health
Status

Untrusted Disconnected

OnGuard-Only System Tray Icons
Table 2 describes that icons that indicate the possible states for OnGuard-only.

OnGuard Status Network Type VPN Status Icon

Healthy
N/A N/A

Unhealthy N/A N/A

Logged Out: No Health
Status

N/A
N/A

Error N/A N/A

Table 2: OnGuard-Only System Tray Icons

Upgrading From OnGuard Plugin Version 1.0 to 2.0
This section contains the following information:

n Overview

n Creating a New Enforcement Profile to Set the SDK Type

n Modifying an Existing Enforcement Policy for OnGuard Plugin v2.0

n Creating a New Posture Policy for OnGuard Plugin v2.0 Agents

n Creating a WebAuth Service for OnGuard Plugin v2.0 Agents

n Important Points
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Overview
The ClearPass OnGuard Agents for Windows and macOS support OnGuard plugin version 2.0, which provides
enhanced product detection.

The new OnGuard plugin version 2.0 is based on the OESIS V4 SDK, while the earlier plugin version 1.0 is
based on the OESIS V3 SDK. OnGuard continues to use plugin version 1.0 and your existing V3 SDK policies
until you explicitly upgrade to plugin version 2.0, as described in this section.

Customers who use ClearPass OnGuard must upgrade to the OnGuard Plugin version 2.0 (V4 SDK) in order to
maintain application signature and virus definition updates. As of May 1, 2018, the V3 SDK and AV Updates for
V3 SDK are no longer supported by OPSWAT. Since virus definitions are updated at least once a day, and
sometimes several times a day, it is important to maintain regular automatic updates.

To upgrade to plugin version 2.0, you will first upgrade the OnGuard agents, after which you create a new
enforcement profile, enforcement policy, and a Web Auth service. Finally, you will need to modify any existing
V3 SDK enforcement policies to use the V4 SDK.

Creating a New Enforcement Profile to Set the SDK Type
The first task in upgrading to the OnGuard plugin version 2.0 is to create a new enforcement profile where you
set the attribute SDK Type to V4.

To create the OnGuard plugin version 2.0 enforcement profile:

1. Navigate to Configuration > Enforcement > Profiles.

The Enforcement Profiles page opens.

2. Click the Add link.

The Add Enforcement Profile dialog opens.

Figure 821 Adding a V4 Agent Enforcement Profile

3. Specify the Add V4 Agent Enforcement Profile parameters as described in the following table:
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Parameter Action/Description

Template Select Agent Enforcement.

Name Enter a name for this enforcement profile.

Description Optionally (but recommended), add a description of this enforcement profile.

Type When you select the Agent Enforcement template, the enforcement profile Type
is set automatically to Agent.

Action Keep the default action: Accept.

Device Group List The Device Group List is no longer pertinent and this option is grayed out.

Table 1: Add V4 Agent Enforcement Profile Parameters

4. Click Next.

The Attributes dialog opens.

Figure 822 Specifying the SDK Type Attribute to V4

5. Optionally (but recommended), specify a message in the Message attribute.

6. Select Click to add, then make the following selections:

l Attribute Name: SDK Type
l Attribute Value: V4

7. Click Save.

The new enforcement profile is added.

Modifying an Existing Enforcement Policy for OnGuard Plugin v2.0
If you have an existing enforcement policy of the WebAuth service that is being used for OnGuard plugin
version 1.0: V3 SDK, you must modify the enforcement policy to support OnGuard plugin version 2.0.

To modify an existing enforcement policy to support OnGuard plugin version 2.0:

1. Navigate to Configuration > Enforcement > Policies.

The Enforcement Policies page opens.
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Figure 823 Enforcement Policies Page

2. Select the enforcement policy of the WebAuth service that is being used for the OnGuard plugin version
1.0.

The Edit Enforcement Policies page opens.

3. Select the Enforcement tab.

Figure 824 Modifying the V3 Enforcement Policy

4. Update the Name and Description if necessary.

5. Click Modify.

6. Select the Attributes tab.

Figure 825 Changing the SDK Type Attribute to V4

7. Change the SDK Type > Attribute Value to V4, then click Save.

The Enforcement Policy has been updated to support the OnGuard plugin version 2.0: V4 SDK. When the
agent next performs a health check, it picks OnGuard plugin version 2.0.

Creating a New Posture Policy for OnGuard Plugin v2.0 Agents
The supported posture policy for the OnGuard plugin version 2.0 is required because many third-party
products that were not supported by OnGuard plugin version 1.0 are supported by OnGuard plugin version
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2.0. Also, the names of some of the antivirus products that are recognized by the OnGuard plugin version 1.0
are changed in OnGuard plugin version 2.0.

When you create a new posture policy, by default the new posture policy uses V4 support charts (see Accessing
the OnGuard Support Charts).

To create a posture policy for OnGuard plugin version 2.0 V4 SDK agents:

1. Navigate to Configuration > Posture > Posture Policies.

The Add Posture Policies page opens.

Figure 826 Creating a Posture Policy for OnGuard Plugin Version 2.0 V4 SDK Agents

2. Specify the Add V4 Posture Policy parameters as described in the following table:

Parameter Action/Description

Policy Name Enter the name of this posture policy.

Description Optionally (but recommended), add a description of this posture policy.

Posture Agent Specify OnGuard Agent (the default).

Host Operating System Specify Windows (the default).

Plugin Version Plugin version 2.0 is specified by default. This is the plugin version required by
the V4 SDK.

Restrict by Roles Configure the roles as required by your installation.
For more information on role configuration, see Adding and Modifying Roles.

Table 2: Adding V4 Posture Policy Parameters

3. Click Next.

The Posture Plugins page opens.
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Figure 827 Selecting the Posture Plugin

4. Click the check box for the ClearPass Windows Universal System Health Validator, then click
Configure:

Figure 828 Configuring the V4 Posture Plugin

5. Specify the ClearPass Windows Universal System Health Validator parameters as described in the
following table:

Parameter Action/Description

Windows OS list Select the Windows version of choice.

Enable checks for Windows
<version>

Select the check box for Enable checks for the selected version of Windows.

Firewall From the list of Windows checks, select Firewall.

Table 3: Add V4 Posture Plugin Parameters
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Parameter Action/Description

Firewall application Select the check box for A firewall application is on.

Product-specific checks To allow any firewall product, uncheck Product-specific checks.

6. Click Save.

Once you have defined the posture hosts, agents, and plugins, you must configure the rules for the posture
policy.

7. Select the Rules tab, then click Add Rule.

The Rules Editor opens.

Figure 829 Configuring OnGuard Plugin Version 2.0 Posture Policy Rules

8. Specify the Rules Editor parameters as described in the following table, then click Save:

Parameter Action/Description

Conditions

Select Plugin Checks Select Passes all SHV checks (the default setting).
The following plugin check types are available for System Health Validators
(SHVs):
n Passes all SHV checks
n Passes one or more SHV checks
n Fails all SHV checks
n Fails one or more SHV checks

Select Plugins Select the plugin to which the plugin checks should apply.
In this case, the ClearPass Windows Universal System Health Validator
plugin has been automatically selected.

Table 4: Rules Editor Parameters
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Parameter Action/Description

Actions

Posture Token Select HEALTHY (0) (the default setting).
The following Posture Token settings are available:
n HEALTHY (0)
n CHECKUP (10)
n TRANSITION (15)
n QUARANTINE (20)
n INFECTED (30)
n UNKNOWN (100)

The following figure displays a summary of all the settings for this posture policy:

Figure 830 Summary of V4 SDK Agents Posture Policy

Creating a WebAuth Service for OnGuard Plugin v2.0 Agents
The final task is to create a WebAuth service for OnGuard plugin version 2.0 V4 SDK Agents. To do so:

1. Navigate to Configuration > Services.

2. Click Add.

The Add Services page opens.
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Figure 831 Adding a Web-Based Authentication Service

3. Type: Select Web-based Authentication.

4. Name: Enter the name for this service.

5. Service Rule:

a. Matches: Leave the default setting, ALL of the following conditions.

b. Select Click to add... and specify the following attributes:

c. Type: Select Host.

d. Name: Select SDKType.

e. Operator: Select EQUALS.

f. Value: Select V4.

6. Select the Authentication tab and specify the authentication source(s).

7. Select the Enforcement tab and select the enforcement policy created in the previous section.

8. Click Save.

9. From the Services page, click Reorder, then place the service for the V4 SDK before the service for the V3
SDK.

This ensures that WebAuth requests with the V4 SDK are evaluated by the service configured for the V4
SDK.

Important Points

This section provides the important points to keep in mind and, in some cases, follow up on, when upgrading
to OnGuard plugin version 2.0.

1. After installing ClearPass 6.7.0, OnGuard Agent is configured to use the OnGuard plugin version 2.0: OESIS
V4 SDK by default. Thus, to fully configure the OnGuard plugin version 2.0, you must follow the procedure
described above in Creating a WebAuth Service for OnGuard Plugin v2.0 Agents.

2. To locate the support charts for OnGuard plugin version 2.0, navigate to Administration > Support >
Documentation > OnGuard Agent Support Charts for Plugin Version 2.0.

3. The Plugin Version field in the Posture Policy > Summary tab indicates the version and related SDK as
follows (see Figure 830):

l Plugin Version 1.0: OESIS V3 SDK

l Plugin Version 2.0: OESIS V4 SDK

Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1851



4. The names of some of the third-party products (for example, AntiVirus, Firewall, and Patch Management)
have changed in the OnGuard plugin version 2.0, so be sure to test the OnGuard plugin version 2.0 Service
and Posture policies in your lab before applying them in a production environment.

5. In OnGuard plugin version 2.0 Posture Policy for Windows and macOS, AntiVirus and AntiSpyware
health classes are merged into the AntiVirus health class.

6. The following features/checks are not supported with the OnGuard plugin version 2.0:

l AntiVirus health class: Engine Version Check, Display Update URL, Disable RTP Check (see Antivirus
Health Check on page 275).

l Patch Management health class: Selected On Server and Security options in the Install Level Check
Type (see Patch Management).

7. Note that new posture policies created on ClearPass Policy Manager 6.7.0 and later will be for OnGuard
plugin version 2.0: OESIS V4 SDK.

8. ClearPass Policy Manager 6.7.0 and later does not allow creating a new Posture Policy for OnGuard plugin
version 1.0: OESIS V4 SDK. However, you can import a Posture Policy for OnGuard plugin version 1.0 from
the previously released versions of ClearPass.

9. Make sure that the Agent Enforcement profile has the required SDK Type configured—V3 or V4 (see
Modifying an Existing Enforcement Policy for OnGuard Plugin v2.0).

10.Make sure to use the posture policy having Plugin Version 2.0, if V4 SDK is enabled. Similarly for V3 SDK, use
the posture policy with Plugin Version 1.0 (see Creating a New Posture Policy for OnGuard Plugin v2.0
Agents).

11.You can change the SDK Type from V4 to V3 by modifying the Agent Enforcement profile to have V3 as
the SDK Type. In this case, be sure to configure the service posture policy is set to Plugin Version 1.0 (see
Creating a New Enforcement Profile to Set the SDK Type).

12.OnGuard Agent sends two WebAuth requests when the SDK Type is changed on a client. The first request
uses the previously configured SDK Type, and the second request is for the new SDK Type.

13.If an Agent Enforcement Profile without the SDK Type attribute is applied, it will not reset the SDK Type on
the client; that is, once the SDK Type is changed on the client by the Agent Enforcement profile, it will not
change until a new Agent Enforcement profile having a different SDK Type is applied.

14.If the Host:SDK Type attribute is missing in WebAuth Requests, it indicates that OnGuard Agent is using
the V3 SDK as versions prior to OnGuard Agents version 6.7.0 do not send the Host:SDK Type attribute.

15.You can check the value of the Host:SDKType attribute in Monitoring > Access Tracker > Input >
Computed Attributes.

Native Agents Only Mode
n Configuring Workflow in Native Agents Only Mode

n End-to-End Flow in Native Agents Only Mode

The Native Dissolvable Agent communicates with ClearPass Guest portal to send information about endpoints,
such as status, health status, remediation messages, and so on. This communication is independent of the
operating systems and browsers.
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Native Dissolvable Agent supports the following browsers and operating systems:

OS Browsers

Windows n Internet Explorer
n Google Chrome
n FireFox (versions less than 52.x)

macOS n Safari
n Google Chrome
n FireFox (versions less than 52.x)

Linux n FireFox (versions less than 52.x)

Table 1: Native Dissolvable Agent: Supported Operating Systems and Browsers

n ClearPass Policy Manager hosts the Native Dissolvable Agent binary files with OnGuard Persistent Agent
installers.

n You can use the links to download the binaries in the OnGuard Settings page for Windows (.exe) and
macOS (.DMG).

Configuring Workflow in Native Agents Only Mode
In ClearPass Guest, the web login page is enhanced to avoid an additional web authentication service and
simplifies the configuration of dissolvable agent flow with the policy-initiated guest web login method.

To configure the OnGuard Dissolvable Agent in Native agents only mode:

1. In ClearPass Guest, navigate to Configuration > Pages > Web Logins.

The Web Logins page opens.

Figure 832 Guest Web Logins Page

2. To edit an existing Web Login page, select the page from the list and click Edit.

3. To create new Web Login page, click the Create a new web login page link.

The Web Login (new) page opens.

4. As shown in Figure 833, in the Login Method field, select the Policy-initiated - An enforcement policy
will control a change of authorization option from the drop-down.
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Figure 833 Specifying the Policy-Initiated Guest Web Login Method

5. Scroll down to the Post-Authentication section of the Web Login page and, in theHealth Check field,
select the Require a successful OnGuard health check check box.

Select this check box to require the guest to pass a health check before they can access the network. The
health check is done automatically through the OnGuard Dissolvable Agent.

Figure 834 Enabling OnGuard Health Checks

6. Click Save Changes.
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End-to-End Flow in Native Agents Only Mode
This section describes the end-to-end flow of the OnGuard Dissolvable Agent running in Native agents only
mode.

1. You are redirected to the ClearPass Guest Portal where you can download the Native Agent installer.

2. After accepting the terms and conditions for collecting end point posture assessment scan checks and
performing remediation actions, run the Native Agent Installer.

The following figure shows an example of the Native Dissolvable Agent Login page:

Figure 835 Native Dissolvable Agent Login Page

The Terms specified in the Login page are optional. You can configure this optionally by selecting the Require a
Terms and Conditions confirmation check box in the Terms field in the ClearPass Guest Login Form.

3. Click the Terms check box, then click Log In.

The following OnGuard Agent download prompt appears when you log in to the Native Dissolvable Agent
for the first time:

Figure 836 Native Dissolvable Agent Installer Prompt

The download options are available only when you log in for the first time. Alternatively, you can download the
OnGuard agent by clicking the Download ClearPass OnGuard Agent link.

4. To proceed to download the OnGuard Agent, click OK.

The OnGuard Windows Health Checker binary download dialog opens:

If you are running Windows OS, Internet Explorer provides options to Run or Save. FireFox and Chrome browsers
provide the option to only save the .exe files.
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Figure 837 Native Dissolvable Agent Binary Downloader

5. To download the OnGuard agent, click Save File.

TheOnGuard Windows Health Checker.exe file is downloaded to your system.

6. To install the OnGuard agent, click Run.

Figure 838 Native Dissolvable Agent Installation

If you are running macOS, FireFox provides options to open the binary file with DiskImageMounter orsave the .DMG
files. Safari and Google Chrome browsers provide the option to Save only.

7. From the Launch Application page, select the ClearPass OnGuard Web Agent application.
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Figure 839 Native Dissolvable Agent Application Launcher

8. To register and perform auto-launch of native OnGuard agent on successive logins, select Remember my
choice for onguardwebagent links, then click OK.

The following screen shows the installation progress:

Figure 840 Native Dissolvable Agent Installation Progress

After the successful installation, the health check scanning is initiated.

After the health-check scanning is completed, the figure similar to the following example appears with the
health check results if the client is unhealthy:

Figure 841 Health Check Results

9. Take the appropriate actions to fix the issues listed in remediation and agent enforcement messages, then
click Scan Again.

Repeat this step until the client becomes healthy. Once the client is healthy, you can access the destination
URL.

10.You can track the events with the end-to-end flow in the Access Tracker.

The following figure is an example of the Access Tracker page showing the Native Dissolvable Agent flow:
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Figure 842 Access Tracker Page

The Auto-launch feature works in the Native agents only and Java Only modes without user intervention, except for
needing to configure Terms on the Guest Login page.

About Auto-Login
The Native Dissolvable Agent supports the Auto-Login method, which eliminates the Require a Terms and
Conditions confirmation check box in the Guest Web Login page by avoiding the web page and submitting
automatically.

Accessing Native Dissolvable Agent Flow Logs
Accessing the Native Dissolvable Agent flow logs can help with troubleshooting issues.

n In Windows, Native Dissolvable Agent flow logs are available at:

%appdata%Aruba Networks/ ClearPassOnguard Temp/Logs

n In macOS, the Native dissolvable agent flow logs are available at:

~/Library/Logs/ClearPassOnGuardTemp/logs

Configuring Web Agent Flow—Native Agent
You can configure a new web agent flow in two different applications (ClearPass Policy Manager and ClearPass
Guest) to perform health scans on endpoints.

Configuring Web Agent Flow in ClearPass Policy Manager
To configure a new web agent flow in ClearPass Policy Manager:

1. Create an 802.1X service to perform RADIUS authentication and enforce restricted or full access based on
end point posture assessments.

The following figure shows an example of the Web Agent Flow - 802.1X Service > Enforcement page:
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Figure 843 Web Agent Flow - 802.1X Service

2. Create a service named Web-based Health Check Only on the ClearPass Policy Manager server.

The following figure shows an example of the Web Agent Flow - Health Only > Enforcement page:

Figure 844 Web Agent Flow - Health Only Service

3. Create a simple Web Auth service to authenticate users against ClearPass Guest user database to accept or
perform App authentication request after completing a sandwich flow. The following figure shows an
example of the Web Agent Flow - Services Web Auth > Authentication page:

Figure 845 Web Agent Flow - Services Web Auth

Configuring Web Agent Flow in ClearPass Guest
To create a web agent flow in ClearPass Guest:

1. In ClearPass Guest, navigate to Configuration > Pages > Web Logins.

The Web Logins page opens.
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2. Click the Create a new web login page link.

The Web Login Editor page opens:

Figure 846 ClearPass Guest Web Login Editor

Figure 847 Web Login - Login Form

3. Authentication: Select the Anonymous - Do not require a username or password option from the
drop-down.

4. Prevent CNA: Check the Enable bypassing the Apple Captive Network Assistant option.

5. Pre-Auth Check:Select the Local - match a local account option.

6. Terms: Check the Require Terms and Conditions confirmation option.
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7. Default destination: Specify the destination URL to which the client must be redirected after health
checks.

8. Post Authentication:Select the Local - match a local account option.

The following figure shows an example of the Web Login - Post-Authentication page:

Figure 848 Web Login - Post-Authentication

The following figure shows an example of the final web agent flow:

For more information, refer to ClearPass Guest Online Help.
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Chapter 16
ClearPass Insight Reports

This chapter describes how to use the ClearPass 6.7 Insight Reporting tool.

This chapter includes the following information:

n About ClearPass Insight

n About the Insight Dashboard

n Searching the Insight Database

n Creating Alerts

n Creating Reports

n Insight Report Categories

n Insight Inventory

n Administration Operations

n Managing Insight Admin Privileges

About ClearPass Insight

This section presents an overview of ClearPass Insight. It provides the following information:

n Introduction

n Enabling Insight and Specifying a Master Insight Node

n Launching Insight

n Special Characters Supported in Passwords for All ClearPass Modules

Introduction
ClearPass Insight is an application for use with ClearPass Policy Manager that is capable of aggregating data
from multiple Policy Manager appliances that contain archived network access logs.

You can access each application within the ClearPass suite with a single login. You need only sign in once for
access to ClearPass Policy Manager, Insight, Onboard, and Guest. For more information, see Launching Insight
below. Insight supports the following features:

n Customizable dashboard "widgets" allow you view the specific kinds of information you need to monitor
and understand what is occurring on the network. You can create customized dashboards to track detailed
authentication records, audit trails, and details on network-access trends (see About the Insight
Dashboard).

n The Insight Search feature allows you to search for clients, users, ClearPass servers, and network access
devices (see Searching the Insight Database).

n Customized reports analyze authentication information, device profiling, client health, licensing and posture
data, as well as guest and BYOD use cases (for details, see Creating Reports and Insight Report Categories).

n Alerts allow you to receive near-real-time messages regarding anomalous network activity. Alerts can be
delivered via SMS or email notification to multiple recipients. Monitor a user watchlist (a list of VIPs,
executives or devices that warrant special tracking) for authentication failures or other key events (see
Creating Alerts).
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This chapter also provides information on how to configure operational elements about file transfers, as well as
database and report data retention (see Administration Operations).

Browsers Supported
ClearPass Insight uses a Web-based management interface. The following browsers are supported:

n Apple Safari 6.2.x, 7.1.x, 8.0

n Google Chrome 47.x, 48.x

n Microsoft Edge 25.x

n Microsoft Internet Explorer 11.0

n Mozilla Firefox 43, 44

Enabling Insight and Specifying a Master Insight Node

Before you can use Insight, you must enable it on the current ClearPass server. If multiple nodes in a cluster
have Insight enabled, one node should be configured as an Insight Master.

Insight Reports, Alerts, and Administration settings can be configured on a Master Insight node only. To be able to
generate a report, enabling the node as an Insight Master (even in a single-node cluster) is mandatory.

To enable Insight :

1. Navigate to Administration > Server Manager > Server Configuration.

2. From the list of ClearPass servers, click the server on which you want to enable Insight.

The Server Configuration > System page opens.

Figure 849 Server Configuration > System Page

a. Enable Insight: Select this check box to enable ClearPass Insight on the current server.

b. Enable as Insight Master: Select this check box to specify this server as an Insight Master.

To enable replication of Insight configurations across a cluster, you must configure one ClearPass server in the
cluster as an Insight Master node.

3. Click Save.
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Launching Insight
To launch ClearPass Insight:

1. Use one of the following methods to launch ClearPass Insight.

l Log in to Policy Manager, and then select Insight in the Dashboard > Applications widget. This opens
Insight in a new tab.

l Access Policy Manager by pointing the browser to https://<ClearPass-host-name>/tips, then select the
ClearPass Insight link (see Figure 850).

l Point the browser to https://<ClearPass-host-name>/insight.

2. Enter the default username and password, then click Login to launch Insight.

Figure 850 displays the ClearPass Access page:

Figure 850 ClearPass Access Page

Special Characters Supported in Passwords for All ClearPass Modules
The special characters that are supported in passwords for all ClearPass modules (Policy Manager, ClearPass
Guest, ClearPass OnGuard, ClearPass Onboard, and ClearPass Insight) are described in the following table:

Special Character Description

+ Plus sign

, Comma

- Hyphen

. Period

; Semicolon

= Equal sign

? Question mark

_ Underscore

Table 1: Special Characters Supported
for ClearPass Module Passwords
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About the Insight Dashboard
This section provides the following information:

n Dashboard Overview

n Adding a Report Widget to the Dashboard Landing Page

n Removing a Report Widget from the Dashboard Landing Page

n Creating a Report or Alert From the Dashboard

n Specifying the Date Range for Data Collection

n Authentication Dashboard

n Endpoints Dashboard

n Guest Dashboard

n Licensing Dashboard

n Network Dashboard

n Posture Dashboard

n System Monitor Dashboard

Dashboard Overview
The Dashboard Landing Page opens immediately when you successfully log in to ClearPass Insight. The
Dashboard includes report widgets that provide a summarized and graphical view of your network analytics.
The Insight header statistics at the top of the dashboard display authentication, endpoints and user statistics
collected over the previous 24 hours. You can click any of these values to display a dashboard page with
additional information.

You can customize the Dashboard to display the report widgets that you use most often by adding widgets to
the Dashboard Landing Page; you can also remove any report widget from the Dashboard Landing Page as
needed.

Figure 851 Insight Header Statistics

The following report widgets are included by default on the Dashboard Landing page:

n Authentication Trend

n Authentication Distribution

n Authentication Status

n Authentication Service

n Top 10 MAC Address Authentications

n Top 20 NAD Authentications

n Top 10 Authentication Errors

n Latest 10 Authentication Alerts
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Figure 852 Insight Dashboard Landing Page

Adding a Report Widget to the Dashboard Landing Page
When you add a report widget to the Dashboard Landing page, that widget will appear in the Landing page,
and the widget will also continue to be available on its Dashboard category page; for example, if you added the
Top 10 Restarted Services widget from the System Monitor Dashboard, the Top 10 Restarted Services
widget would be present in both the Dashboard Landing page and the System Monitor Dashboard.

To add a report widget to the Dashboard Landing page:

1. From any of the Dashboard category pages, click the arrow icon in the right corner of the widget title bar.

2. Select Add to Dashboard (see Figure 853).

That report widget will appear when you return to the Dashboard Landing page.

Figure 853 Adding a Widget to the Dashboard Landing Page

3. To view the newly-added widget, return to the Dashboard Landing page.
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Removing a Report Widget from the Dashboard Landing Page
You can only remove a report widget from the Dashboard Landing Page. Report widgets cannot be deleted
from Dashboard category pages (for example, if you choose to remove the Top 10 MAC Address
Authentications widget from the Landing page, it will remain in the set of report widgets provided in the
Authentication Dashboard).

To remove a report widget from the Dashboard Landing page:

1. From the Dashboard Landing Page, locate the widget you want to remove.

2. Click the arrow icon in the right corner of the widget title bar.

3. From the menu, select Remove from Dashboard (see Figure 854).

Figure 854 Removing a Widget From the Dashboard

When you refresh the page, that widget will disappear from the Dashboard.

Creating a Report or Alert From the Dashboard
The widgets on the Dashboard include links to the Create Reports and Create Alerts pages.

To define and to receive a regular report of data for that Dashboard:

n To open the Create Reports wizard from the Dashboard, click the down-arrow icon in the widget title bar
and select Create Report.

To define and to receive alerts when customized thresholds are reached:

n To open the Create Alerts wizard from the Dashboard, click the down-arrow icon in the widget title bar
and select Create Alert.
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Figure 855 Opening the Reports or Alerts Wizard from the Dashboard

For detailed procedures to create reports and alerts, see Creating Reports and Creating Alerts.

Specifying the Date Range for Data Collection
By default, the Insight widgets, including those on the Dashboard page as well as all the other Insight widgets,
such as Endpoints, Guest, Posture, and so on, display information collected over the previous seven days. The
System Monitor widget is an exception as it displays data for the previous two hours.

You can modify the Authentication, Endpoints, Guest, Posture, and System widgets to display widget data for
today, one week, one month, or a custom date and time range.

To specify the date range to have data collected for a Dashboard widget:

1. To specify data collection for today, one week, or one month, from the upper right corner of the
Dashboard, select Today, 1w (for one week), or 1m (for one month) as desired.

The Dashboard widgets then display the information for the specified number of days.

2. To specify a customized period for Insight data collection, click the Custom button.

You are prompted to specify the start and end dates for your date range, as shown in Figure 856.
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Figure 856 Specifying a Custom Date Range

3. Select the Start Date and End Date from the calendar, then click Apply.

The Dashboard widgets then display the information for the specified range of dates.

Authentication Dashboard
Authentication Dashboard widgets focus on authentication analytics and include widgets on trends,
distribution, status, service, alerts, and statistics.

To access the Authentication Dashboard, navigate to Dashboard > Authentication.

Figure 857 Authentication Dashboard

The following widgets are included by default on the Authentication Dashboard:

n Authentication Trend

n Authentication Distribution

n Authentication Service

n Authentication Status

n Top 10 MAC Address Authentications

n Top 20 NAD Authentications

n Top 10 Authentication Errors

n Latest 10 Authentication Alerts
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For more information about the Authentication reports and the widgets provided for each report, see
Authentication Category Reports.

Endpoints Dashboard
The Endpoints Dashboard widgets provide analytics that focus on Endpoint trends, distribution, device profile,
and bandwidth usage.

To access the Authentication Dashboard, navigate to Dashboard > Endpoints.

Figure 858 Endpoints Dashboard

The following widgets are included by default on the Endpoints Dashboard:

n Endpoint Unique Trend

n Endpoint Device Profiling

n Endpoint Device Categories

n Endpoint Device Families

n Endpoint Device Names

n Top 20 Bandwidth Users

For more information about the Authentication reports and the widgets provided for each report, see
Endpoint Category Reports.
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Guest Dashboard
To access the Guest Dashboard, navigate to Dashboard > Guest.

Figure 859 Guest Dashboard

The following widgets are included by default on the Guest Dashboard:

n Guests Authentication Trend

n Unique Guest Authentication

n Guests Provisioned

n Guest Device Category

n Guest Device Families

n Guest Device Names

n Top 20 Bandwidth Guest Users

For more information about the Guest reports and the widgets provided for each report, see Guest
Authentication Category Reports.
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Licensing Dashboard
To access the Licensing dashboard, navigate to Dashboard > Licensing.

Figure 860 Licensing Dashboard

The following widgets are included by default on the Guest Licensing:

n Current License Usage

n License Usage in the Last 24 Hours

n Maximum License Usage

This page displays the current Access, OnGuard and Onboard license usage over the previous 15 minutes and
previous 24 hour interval, and the maximum usage for each of these license types in the previous day, week or
month. For more information, see Licensing Reports.
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Network Dashboard
To access the Network Dashboard, navigate to Dashboard > Network.

Figure 861 Network Dashboard: NAD Vendor Distribution

The following widget is included on the Network Dashboard:

n NAD Vendor Distribution

This widget displays the list of all the NAD (Network Access Device) vendors, including the number of NADs
by each vendor. Each vendor is associated with a unique color, and those colors are reflected in the circle
graph that displays the distribution percentage each NAD vendor represents.

For more information about the Network reports, see Network Category Reports.

Posture Dashboard
The Posture Dashboard widgets focus on device health status and device profiles. To access the Posture
Dashboard, navigate to Dashboard > Posture.

Figure 862 Posture Dashboard

The following widgets are included by default on the Posture Dashboard:

n Health Status

n Unhealthy Devices
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For more information about the Posture-related reports, see OnGuard Category Reports.

System Monitor Dashboard
The System Monitor Dashboard widgets focus on health, including Authentication health, processing time, and
CPU, memory, and disk usage.

You cannot pin System Monitor widgets to the Dashboard.

To access the System Monitor Dashboard, navigate to Dashboard > System Monitor.

Figure 863 System Monitor Dashboard

The following widgets are included by default on the System Monitor Dashboard:

n Authentication Health

n End-to-End Request Processing Time

n Memory Usage

n Swap Memory Usage

n Disk Usage

n CPU Usage

n CPU Load

n Top 10 Restarted Services

n Insight Disk usage

The System Monitor Dashboard differs from the other Dashboard pages in that it can show data for two
hours only (2h).

To define a custom two-hour time slot:

1. Click the Custom drop-down list.
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Figure 864 Specifying the Hour to Start System Monitor Scan

2. Select the starting date.

3. Click the HH field, then use the up- and down-arrows to specify the hour to start the system monitor scan.

For example, specifying 13 in the HH field indicates that the start time for the two-hour period is 1:00 PM.

4. Click Apply.

Searching the Insight Database
This section provides the following information:

n About Insight Search

n Search Example

About Insight Search
Use the Insight Search feature to query the Insight database.

You can search for the following entities:

n Endpoint IP address (Framed-IP-Address)

n Clients by MAC address, hostname, or IP address

n User name

n ClearPass servers by name or IP address

n Network access devices by name or IP address

You can add clients and users to the Watchlist from Search results. For details, see Adding or Removing Users
from the Watchlist.

The Insight Search window is always available at the top of every page.

Search works on all pages except the Report Configuration and Alert Configuration pages.

Figure 865 Search Window
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Search Example
Let's take the example of searching for an endpoint hostname:

1. Start entering the endpoint hostname into the Search window.

As you type in the endpoint hostname, Insight Search may discover that there are multiple entities with the
same initial characters (see Figure 866).

Figure 866 Search Locating Matching Entities

2. To locate the desired entity:

a. Click on the suggestion and see which entity you are looking for from the list displayed.

b. Or refine your search by typing more characters to further specify the search entity.

In this example, the MAC address is identified as an Endpoint.

Figure 867 Locating and Identifying the Search Object

3. Select the search object.

The endpoint hostname report is automatically displayed in an endpoint details page(see Figure 868). For
more information about the data displayed in an endpoint details page, see Viewing Endpoints Details on
page 879.
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Figure 868 Report of Search Result

Creating Alerts
This section provides the following information:

n Introduction

n Creating New Alerts

n Modifying the User Watchlist

n Adding or Removing Users from the Watchlist

Introduction
Alerts provide network managers with near-real-time messages about anomalous network activity. Such
activity could consist of:

n Irregular authentication activity

n Irregular network device access activity

n Users attempting privileged commands on network devices

n Irregular activity on the ClearPass servers

Reports and alerts include templates for easy configuration. These templates allow you to quickly configure
and monitor network activity. In addition to email notifications, you can also send alerts to mobile devices via
SMS, providing the capability to receive mission-critical information on the go.

Any Error-level System Event/Event Viewer entries in ClearPass servers are notified with a System Alert Notification.
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Creating New Alerts
To create a new alert:

1. Navigate to the Alerts page.

2. Click Configuration.

The Alerts Configuration page opens.

Figure 869 Alerts Configuration Page

l Enable button: From the switch, you can enable or disable the selected alert.

l Mute button: Allows you to mute alert output while you work to address the alert.

3. Click Create New Alert.

Figure 870 Creating a New Alert
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4. Enter the information for each Create New Alert parameter as described in Table 1, then click Save.

Alert Field Action/Description

Alert Name Enter the name of the alert.

Description Optionally, enter a summary description of the alert.

Category Select the alert Category, then specify the desired alert type in the selected
category:
n Authentication

l Failed Authentication
l RADIUS Failed Authentication
l Total Authentication
l WEBAUTH Authentication

n System
n TACACS

l TACACS Commands
l TACACS Failures

Notifications Specify report notifications:
n Notify by Email. When you select this option, enter the list of email addresses

to be notified. The alert notification is sent whenever the trigger threshold is
met.

NOTE: Enabling Notify by Email is mandatory.
n Notify by SMS. When you select this option, enter the phone numbers of each

recipient. The alert notification is sent whenever the trigger threshold is met.
NOTE: If you have not configured the SMTP mail server for email notifications, you
will be unable to configure Alert Notifications.
For the procedure, see Messaging Setup.

Filter To configure an Alert filter:
1. From the Filter drop-down, select the type of filter; for example, Access Point
or ClearPass Server.
2. Specify the operator:

l Equals
l Not_Equals
l Starts_With
l Contains
l Not_Contains

3. Enter the value.
To create another filter, click the Add Another link.
To remove a filter, click the trashcan logo.

Trigger Severity From the Trigger Severity drop-down, select one of the following:
n Critical
n Warning

Trigger Threshold Specify Threshold and Interval values as criteria for determining whether an alert
is necessary.
For example, if you specify the threshold as 25 and the interval as 15 minutes,
once the threshold of 25 is met within 15 minutes, an alert is triggered.

Trigger Interval Specify the Interval, then select Minutes or Hours.

Alert Summary When you have configured the alert settings, the Alert Summary displays the
settings for your review.

Table 1: Create New Alert Parameters
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Modifying the User Watchlist
A Watchlist is a list of VIPs, executives, and devices known to be problematic that are monitored for
authentication failures. ClearPass collects all user authentication status.

When ClearPass finds a user defined in the Watchlist that both fails to authenticate and also matches the
Watchlist triggers (severity, threshold, and interval), an alert notification is sent to the notification list via email
or to mobile devices via SMS. This allows the authentication failure to be resolved proactively before the
problem is reported by the user.

The Watchlist generates an alert only when an unsuccessful authentication for a specific device occurs.

Default Watchlist Trigger Settings
The default Watchlist trigger settings are as follows:

n Severity = Critical

n Threshold = 1

n Interval = 30 seconds

You cannot edit the The Watchlist trigger settings.

To modify the User Watchlist:

1. From the Insight navigation panel, choose Alerts, then select Configuration.

The Alerts Configuration is displayed, which shows the default User Watchlist (see Figure 871).

Figure 871 User Watchlist

2. Click Watchlist, then click Modify Watchlist.

The Edit Alert page for the User Watchlist opens.
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Figure 872 Modifying the User Watchlist

3. Enter the desired settings for each User Watchlist parameter as described in Table 2, then click Save.

Alert Field Action/Description

Alert Name Optionally, you can modify the name of the User Watchlist.

Description Optionally (and recommended), enter a summary description of the User Watchlist.

Category The Category is set to Alert > User Watchlist. This is not an editable field.

Table 2: Modify User Watchlist Parameters
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Alert Field Action/Description

Notifications Specify Watchlist notifications.
n Notify by Email. When you select this option, enter the list of email addresses to

be notified. The alert notification is sent whenever the threshold is met.
n Notify by SMS. When you select this option, enter the phone numbers of each

recipient. An SMS message is sent with an alert notification whenever threshold is
met.

NOTE: A warning message appears if you have not configured the SMTP mail server
for email notifications (for details, see Messaging Setup).

Filter: Username The User Watchlist has only one filter: Username.
From the Username drop-down, select one or more users to add to the Watchlist.

Alert Summary When you have configured the Watchlist settings, the Alert Summary displays the
settings for your review.

Adding or Removing Users from the Watchlist
You can use the Insight Search function to add users to or remove users from the Watchlist.

Adding a User to the Watchlist
To add a user to the Watchlist:

1. In the Insight Search window, enter the name of the user.

The Insight User Information page for the selected user is displayed.
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Figure 873 Insight User Information Page

2. To add a user to the Watchlist, click the star icon next to the username as shown in Figure 873.

The User Information page now displays the following information:

Figure 874 User Successfully Added toWatchlist

The star icon color is now set to orange, indicating the user has been added to the Watchlist.

The following message is displayed:

<User> added to User Watchlist successfully. Please configure SMS and email notifications.

Removing a User from the Watchlist
To remove a user from the Watchlist:

1. In the Insight Search window, enter the name of the user.

The Insight User Information page for the selected user opens.
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Figure 875 Removing a User from the Watchlist

2. Click the orange star icon next to the username.

The user is removed from the Watchlist. The star icon is now white. You receive the following message:

<User> removed from User Watchlist successfully.

Creating Reports
This section provides the following information:

n Overview

n Creating a New Report: Settings Configuration

n Report Filters Configuration

n Specifying the Logo and Branding

n Report Summary Page

n Configured Reports Page

n Importing and Exporting Reports

n Viewing Generated Reports

n Regenerating Existing Reports

Overview
The Reports page provides a method for creating reports with data filters and customized time ranges up to
the previous two months.
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Figure 876 Reports Page

Run Reports Now or on a Specified Schedule
You can set up reports to run immediately or you can schedule a report to run on a daily, weekly, or monthly
basis. Although Insight reports show data over the previous two-month period, Insight can retain data for up
to two years.

Select Report Filters
Many reports allow you to select filters that include a simple AND condition. For example, you can use filters to
create a report that displays data for RADIUS Authentications from the Active Directory AND the Guest User
Repository source.

PDF, CSV, and HTML Report Formats Are Available
After a report is configured and run, the report is available for download in PDF and CSV formats. You can also
open a report and view it in HTML format.

Deleting a configured report deletes both the report configuration and all related report output.

Creating a New Report: Settings Configuration
To create a new report:

1. From the Insight navigation panel, click Reports.

2. Select Create New Report.

The Settings page of the Create New Report Wizard opens.
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Figure 877 Create New Report Wizard: Settings

3. Enter the appropriate information as described in Table 1, then click Next.

Report Parameter Action/Description

Report Name Enter the name of the report.

Description Optionally, enter a summary description of the report.

Category Select the report Category, then specify the desired report type in the selected
category:
n Authentication
n Endpoint
n Guest Authentication
n Licensing
n Network
n OnGuard
n Onboard
n RADIUS Authentication
n System
n TACACS
NOTE: For detailed information about what report types are provided for each
report category, see Insight Report Categories.

Notifications Optionally, specify report notifications. These report notification options require
that you first configure the SMTP mail server for email notifications. For details, see
Messaging Setup.
n Notify by Email. When you select this option, enter the list of email addresses

Table 1: Specifying the Report Settings Parameters

ClearPass 6.7 Policy Manager | User Guide ClearPass Insight Reports | 854
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1886



855 | ClearPass Insight Reports ClearPass 6.7 Policy Manager |  User Guide

Report Parameter Action/Description

(separated by commas) to be notified. When Insight Reports are sent via email
to notification recipients, the recipients will receive an email with an
HTML version of the report and a zip file containing the report in CSV and PDF
formats. If the zip file is larger than 2 MB, the CSV file will not be included in the
zip file, but the email will include a link to download that file.

n Notify by SMS. When you select this option, enter the phone numbers of each
recipient (separated by commas).

Options NOTE: Before you can enable one or both of these two options, you must configure
the File Transfer Settings (including the Remote Directory) in the Administration
section. For more information, see File Transfer Settings Configuration.
n Include raw data in output

A full set of raw data is customizable in the CSV reports only.
n Enable remote copy

This option lets you copy reports to the location specified in the Administration
> Remote Directory setting.

Repeat Scheduled Report Specify whether you want to generate this report Daily, Weekly, or Monthly. The
default is No Repeat.
n To rerun a No Repeat report or a static report, edit and save the report. Insight

will then automatically run the report.
n When you create a report with the No Repeat option selected, the report runs

when you click Save.
n When you create a periodic report (Daily, Weekly, or Monthly), the report is

run according to the specified schedule.

Preset Date Range You can choose to specify a Preset Date Range for this report:
n Custom Date
When you select Custom Date, specify the Start Date and Time and the End Date
and Time.
n Today
n Since Yesterday
n This Week
n Within Last Week
n Within Last 2 Weeks
n This Month
n Within Last Month
When you select one of these date range options (with the exception of Custom
Date), Insight automatically populates the Start Date/Time and End Date/Time
settings.

Report Summary When you have configured the report settings, the Report Summary displays them
for your review.

Report Filters Configuration
When you complete the Settings page in the Create New Report wizard and click Next, the page that opens
allows you to configure the filters for your report. For maximum flexibility in defining your reports, the
complete set of filters are available for each report.

Report filters apply the data fetched from the database, then Insight displays the result in the report. The
filters that are available depend on the report category you specify. If you don't apply a filter, Insight includes
all the data in the generated report that matches the report category.
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Figure 878 Specifying a Report Filter

1. Specify the report filter parameters as described in the following table:

Filter Parameter Action/Description

Field Click the Field drop-down list and select the parameter you wish to use as a filter.
The available parameters vary, according to the report type.

Operator Select the operator to determine how Insight filters the setting in the Value field.
Supported options are:
n Equals: The field is an exact match with the value string
n Not_Equals: The field does not exactly match the value string
n Starts_with: The field starts with the specified value string
n Contains: The field parameter contains the value string anywhere within the field

parameter.
n Not_Contains: The field parameter does not contain the Value parameter

Value Select the appropriate value.

Add Another Click this link to add another filter.

Table 2: Specifying the Filters Parameters

Specifying the Logo and Branding
1. When you complete the report filters configuration, scroll to the Logo and Branding section on the same

page.

The initial Logo and Branding screen presents a prompt, asking if you want to change the logo:

Figure 879 Prompt for Changing the Logo

2. If you don't wish to change the logo, simply click Next to proceed.

3. If you do want to change the logo, click the check box.

The Logo and Branding configuration section opens:
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Figure 880 Logo and Branding Section

4. To specify the logo and branding information, enter the information as described in Table 3, then click
Next.

Report Parameter Action/Description

Select Template From the drop-down, select the logo and branding template.

Page Title Enter the page title.

Top Section Enter the header for the top of the page.

Logo Image To browse to the appropriate logo image, click Replace Image.

Bottom Section Enter the footer text.

Copyright Enter the copyright information. For example, "Copyright 2019 NewSales, Inc."

Save Template To save the new branding and logo settings, click Save Template.

Table 3: Specifying Logo and Branding Parameters

Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1889



Report Summary Page
When you complete the Logo and Branding section, the Report Summary is displayed.

Figure 881 Report Summary

1. Review the report summary.

a. If you wish to change any aspect of the report, click Edit Report.

The Report Summary dialog opens. You can edit the current report settings as needed.

b. Make any necessary changes, then click Save.

2. When the report settings are satisfactory, click Save.

Insight generates the report. You return to the Configured Reports page.

Uploading a Custom Report Template
Starting with ClearPass 6.7, you can upload a custom report template using the Import option on the Reports
> Custom Reports page.

To create a new report based on a custom report template:

1. Navigate to Reports > Configuration.
2. Select the Custom option in the Category drop-down list.
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Configured Reports Page
To see the set of configured reports, select Reports > Configuration. From this view, you can edit or copy
report settings, run or delete a configured report, and import or export reports between ClearPass servers.

Figure 882 Configured Reports Page

A green dot next to a report name indicates that the report generation is complete, while a yellow dot indicates
that Insight is still creating the report. A red dot by the report name indicates that the report failed to generate.
To display a tooltip with additional information about why a report fail to generate, hover your mouse over red
dot.

This page also provides two report widgets:

n Top 10 Reports Time to Run 30 Days
This widget lists the ten reports that took the longest (in seconds) to run over the last 30 days.

n Top 10 Reports Last 30 Days
This widget lists the ten most frequently run reports over the last 30 days.

Importing and Exporting Reports
Insight allows you to import or export individual reports, or import and export multiple report definitions at
once.

To export a single report definition:

1. Navigate to the Reports > Configuration page.

2. In the Configuration table, click the checkbox to the left of a report name to select that report.

3. to export the selected report definition as a JavaScript Object Notation (JSON) file, click the Export ( ) icon
to the right of the report name in the Configuration table, or click the Export button above the
Configuration table.

To export multiple report definitions at once (bulk export):

1. Navigate to the Reports > Configuration page.
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2. In the Configuration table, click the check box to the left of each report name you want to export, or click
the check box in the header of the Configuration table to select all reports.

3. Click the Export button above the Configuration table.

All selected reports are exported in a single JSON file.

Figure 883 Selecting Multiple Report Definitions for Bulk Export

To import one or more report definitions:

1. Click the Import Report button.

2. Browse to and select a JSON report definition file.

3. If you select a file with multiple report definitions, the import process will add all reports in that file, and
Insight will display a status message listing all the report definitions that have been added or updated.

If you upload a report definition that uses an existing custom report template name, Insight displays a warning
stating that the template name already exists, and that uploading a new report will overwrite the previous uploaded
custom report configuration.

Viewing Generated Reports
You can view or download an existing report on the Reports page of the Insight user interface. To view a
generated report:

1. From the navigation panel, click Reports.

2. Scroll to the Created Reports section.
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Figure 884 Created Reports

3. To download the zip file that contains the reports in PDF and CSV formats, click the Download icon (as
shown in Figure 884).

4. To view the desired report in HTML format (which opens in new tab), click the name of the report.

The generated report is displayed (see Figure 885).

Figure 885 Report Displayed in HTML Format

Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1893



Regenerating Existing Reports
To regenerate an updated version of an existing report definition, click the run ( ) icon beside any report
definition on the Reports or Reports > Configured Reports pages.

Insight Report Categories
This section provides the following information:

n Introduction

n Authentication Category Reports

n Custom Reports

n Endpoint Category Reports

n Guest Authentication Category Reports

n Licensing Reports

n Network Category Reports

n OnGuard Category Reports

n Onboard Category Report

n RADIUS Authentication Category Reports

n System Monitor Category Reports

n TACACS Category Reports

Introduction
This section provides detailed information about each of the report types and their associated widgets
available for each Insight Report category. The Insight report templates are organized into categories, where
each category has multiple report types that each contain a unique set of report data.

The following sections describe each report category, including the available reports within each category, and
the contents of each report.

Authentication Category Reports
The reports available in the Authentication category described in Table 1 provide the list of authentications that
occurred during the report duration.

Additional authentication statistics are displayed on the Authentication Dashboard. For more information,
see Authentication Dashboard.
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Report Type Report Widgets

Accounting—Bandwidth and Session

Provides the statistics using the accounting data
generated during report duration. This report
allows you to filter the report data by:
n ClearPass server
n Network access device IP address
n Device category
n Device family
n Device name
n SSID
n Endpoint IP address
n User name

This report type includes the following bandwidth and session
information:
n Bandwidth Statistics: Total Bandwidth, Average Bandwidth,

Maximum Bandwidth, Maximum Upstream Bandwidth,
Maximum Downstream Bandwidth, Sessions, Maximum
Duration, Users, Endpoints

n Upstream Bandwidth and Downstream Bandwidth Trend
n Total Bandwidth and Average Bandwidth Trend
n Average Session Time Trend
n Unique Session Trend
n Top 10 Device Categories with Most Bandwidth Consumed
n Top 10 Device Categories with Most Sessions
n Top 10 Device Categories with Most Duration
n Top 10 Device Families with Most Bandwidth Consumed
n Top 10 Device Families with Most Sessions
n Top 10 Device Families with Most Duration
n Top 10 Endpoints with Most Bandwidth Consumed
n Top 10 Endpoints with Most Sessions
n Top 10 Endpoints with Most Duration
n Top 20 Users with Most Bandwidth Consumed
n Top 10 Users with Most Sessions
n Top 10 Users with Most Duration
n Domain Summary: Provides an overview of authentications

per domain.

Authentication by Authentication Source

Provides the statistics for successful and failed
authentications per authentication source.

This report type includes the following information:
n Authentication Statistics
n Total Authentication Trend
n Failed Authentication Trend
n Authentication Distribution Across Authentication Source
n Authentication Distribution Across Authorization Source
n Authentication Distribution Across Authentication Source
NOTE: This report allows you to filter the report data by
authentication source.

Authentication by ClearPass

Provides the statistics for successful and failed
authentications per ClearPass servers in a
cluster.

This report type includes the following information:
n Authentication Statistics
n Total Authentication Trend
n Failed Authentication Trend
n Authentication Distribution—Error Types
n Authentication Distribution Across Service
n Top 10 ClearPass with Most Authentications
n Top 10 ClearPass with Most Failed Authentications
n Top 10 ClearPass with Most MAC Address Authentications
n Top 10 ClearPass with Most Users
NOTE: This report allows you to filter the report data by
ClearPass Policy Manager server.

Table 1: Authentication Category Reports
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Report Type Report Widgets

Authentication Overview

Provides statistics in general for the report
duration, such as total authentications per day,
unique devices authentications trend by day,
unique users authentication trend by day,
authentication distribution based on
authentication status, service, ClearPass server,
SSID, VLAN, enforcement profile, authentication
source, and top 10 users with most
authentications, and so on.

This report type includes the following information:
n Authentication Statistics
n Total Authentication Trend
n Authentication Status Trend
n Unique Devices Authentication Trend
n Unique Users Authentication Trend
n Authentication Distribution Across Auth Status
n Authentication Distribution Across Cluster
n Authentication Distribution Across Service
n Authentication Distribution Across VLAN
n Authentication Distribution Across SSID
n Authentication Distribution Across Enforcement Profiles
n Authentication Distribution Across Role
n Authentication Distribution Across Authentication Source
n Top 10 Users with Most Authentications
n Top 10 MAC Addresses with Most Authentications
n Top 10 Services with Most Authentications
n Top 10 Auth Sources with Most Authentications
n Top 10 ClearPass Roles Assigned
n Top 10 Authorization Sources
n Top 20 NADs with Most Authentications
n Top 10 Enforcement Profiles Users
NOTE: This report allows you to filter the report data by
ClearPass Policy Manager host name, Network Attached Device
(NAD) IP address, SSID, and Error Code.

Authentication Trend

Provides authentication trend statistics for today
and yesterday, today and the same day a week
ago, and so on.

This report type includes the following information:
n Authentication Statistics
n Total Authentication Trend
n Authentication Trend for Today and Yesterday
n Authentication Trend for Today and Same Day Week Ago
n Total Authentication for 1 Month (per month)
NOTE: This report allows you to filter the report data by
ClearPass Policy Manager host name, Network Access Device
(NAD) IP address, and SSID.

Failed Authentication

Provides statistics based on failed
authentications.

This report type includes the following information:
n Error Statistics
n Failed Authentication Trend
n Authentication Distribution—Error Types
n Failed Authentication Distribution across Service
n Failed Authentication Distribution across Authentication

Source
n Top 10 Errors with Most Failed Authentications
n Top 20 NADs with Most Failed Authentications
n Top 10 ClearPass Servers with Most Failed Authentications
n Top 10 Users with Most Failed Authentications
n Top 10 Endpoints with Most Failed Authentications
n Top 10 Services with Most Failed Authentications
NOTE: This report allows you to filter the report data by
ClearPass Policy Manager host name, Network Access Device
(NAD) IP address, SSID, and Error Code.

Unique Failed Authentication This report type includes the following information:
n Error Statistics
n Failed Authentication Trend
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Report Type Report Widgets

Provides statistics based on failed
authentications.

n Authentication Distribution—Error Types
n Failed Authentication Distribution across Service
n Failed Authentication Distribution across Authentication

Source
n Top 10 Errors with Most Failed Authentications
n Top 20 NADs with Most Failed Authentications
n Top 10 ClearPass Servers with Most Failed Authentications
n Top 10 Users with Most Failed Authentications
n Top 10 Endpoints with Most Failed Authentications
n Top 10 Services with Most Failed Authentications
NOTE: This report allows you to filter the report data by
ClearPass Policy Manager host name, Network Access Device
(NAD) IP address, SSID, and Error Code.

Custom Reports

If you imported a custom report template via the Reports > Custom Reports page, you can select the
Custom Reports option on the Reports > Configuration page to create a new custom report based upon
that template. You can edit a custom report definition to add filters supported by that custom template type,
and select raw data columns to appear in the CSV format output for that report. Note that the Custom option
does not appear in the Reports> Configuration page unless you have previously uploaded a custom report
template.

Log files for custom report events are separate from other Insight event log files, and are located at
/var/avenda/tips/insight/admin/customreports/upload_logs.txt.

Endpoint Category Reports
The Endpoint category provides information on endpoints discovered during the report duration. The reports
available in the Endpoint category described in Table 2 contain data that can also be found in the dndpoints
widgets on the Endpoints Dashboard page. For additional information about the Endpoints Dashboard, see
Endpoints Dashboard.
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Report Type Report Widgets

Endpoint Authentication Overview This report type includes the following information for all
endpoint types:
n Endpoint Statistics
n Endpoints Distribution Across Device Category
n Endpoints Distribution Across Device Family
n Endpoints Distribution Across Device Name
n Top 10 Users with Most Endpoints
n Top 10 Device Categories with Most Endpoints
n Top 10 Device Names with Most Endpoints
n Top 10 Device Families with Most Endpoints
NOTE: This report also allows you to filter the report data by
Network Access Device (NAD) IP address, Device Category,
Device Family, Device name, and SSID.

Endpoint Overview This report type includes the following information for all
endpoint types:
n Top 10 Reports Time to Run 30 Days
n Top 10 Reports Last 30 Days

Guest—Endpoint Overview This report type includes the following information for endpoints
using Guest Authentication:
n Endpoint Statistics
n Endpoints Distribution Across Device Category
n Endpoints Distribution Across Device Family
n Endpoints Distribution Across Device Name
n Top 10 Users with Most Endpoints
n Top 10 Device Categories with Most Endpoints
n Top 10 Device Names with Most Endpoints
n Top 10 Device Families with Most Endpoints
NOTE: This report also allows you to filter the report data by
Network Access Device (NAD) IP address, Device Category,
Device Family, Device name, and SSID.

RADIUS—Endpoint Overview This report type includes the following information for endpoints
using RADIUS authentication:

n Endpoint Statistics
n Endpoints Distribution Across Device Category
n Endpoints Distribution Across Device Family
n Endpoints Distribution Across Device Name
n Top 10 Users with Most Endpoints
n Top 10 Device Categories with Most Endpoints
n Top 10 Device Names with Most Endpoints
n Top 10 Device Families with Most Endpoints
NOTE: This report also allows you to filter the report data by
Network Access Device (NAD) IP address, Device Category,
Device Family, Device name, and SSID.

Table 2: Endpoint Category Reports

Guest Authentication Category Reports
The reports available in the Guest Authentication category described in Table 3 provide statistics based on
Guest authentications from the Guest database. The statistics for authentication trend and usage for guest
users are drawn from the accounting data.

Additional authentication statistics are displayed on the Guest Dashboard. For additional information about
the Guest Dashboard, see Guest Dashboard.
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Report Type Report Widgets

Guest—Auth Overview This report includes the following report widgets:
n Authentication Statistics
n Total Authentication Trend
n Authentication Status Trend
n Unique Devices Authentication Trend
n Unique Guests Authentication Trend
n Authentication Distribution Across Authentication Status
n Authentication Distribution Across Cluster
n Authentication Distribution Across Service
n Authentication Distribution Across VLAN
n Authentication Distribution Across SSID
n Authentication Distribution Across Enforcement Profiles
n Authentication Distribution Across Roles
n Authentication Distribution Across Authentication Source
n Top 10 Guests with Most Authentications
n Top 10 MAC Addresses with Most Authentications
n Top 10 IPs with Most Authentications
n Top 10 Services with Most Authentications
n Top 10 Authentication Sources with Most Authentications
n Top 10 ClearPass Roles Assigned
n Top 10 Authorization Sources with Most Authentications
n Top 20 NADs with Most Authentications
n Top 10 Enforcement Profiles Used
NOTE: This report also allows you to filter the report data by ClearPass host
name and Network Access Device (NAD) IP address.

Guest—Auth Trend This report includes the following report widgets:
n Authentication Statistics
n Total Authentication Trend
n Authentication Trend for Today and Yesterday
n Authentication Trend for Today and Same Day Week Ago
n Total Authentication for One Month
n Sponsor List
NOTE: This report also allows you to filter the report data by ClearPass Policy
Manager host name and Network Access Device (NAD) IP address.

Guest—Auth by ClearPass This report type includes the following information guest authentications by
ClearPass:
n Authentication Statistics
n Total Authentication Trend
n Failed Authentication Trend
n Authentication Distribution—Error Types
n Authentication Distribution Across Service
n Top 10 ClearPass with Most Authentications
n Top 10 ClearPass with Most Failed Authentications
n Top 10 ClearPass with Most MAC Authentications
n Top 10 ClearPass with Most Guests
NOTE: This report also allows you to filter the report data by ClearPass Policy
Manager host name.

Guest - Hotspot This report includes the following information about hotspot user logins
recorded over the selected time frame:
n Hotspot plan distribution (for example, free vs hourly paid access)
n Purchase amount distribution: purchase totals per plan type, in either

dollars or the currency used to purchase the plan.

Table 3: Guest Authentication Category Reports
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Report Type Report Widgets

Guest—Social Login This report type includes the following information for guest authentication for
Social Logins:
n Social Authentication Trend
n Endpoint Distribution Across Social Providers
n Authentication Distribution Across Authentication Source
NOTE: This report also allows you to filter the report data by ClearPass host
name and Network Access Device (NAD) IP address.

Guest Accounting—Bandwidth
and Session

This report allows you to filter the
report data by:
n ClearPass server
n Network access device IP

address
n Device category
n Device family
n Device name
n SSID
n Endpoint IP address
n User name

This report type includes the following bandwidth and session information:

n Bandwidth Statistics: Total Bandwidth, Average Bandwidth, Maximum
Bandwidth, Maximum Upstream Bandwidth, Maximum Downstream
Bandwidth, Sessions, Maximum Duration, Guests, Endpoints

n Upstream Bandwidth and Downstream Bandwidth Trend
n Total Bandwidth and Average Bandwidth Trend
n Average Session Time Trend
n Unique Session Trend
n Top 10 Device Categories with Most Bandwidth Consumed
n Top 10 Device Categories with Most Sessions
n Top 10 Device Categories with Most Duration
n Top 10 Device Families With Most Bandwidth Consumed
n Top 10 Device Families With Most Sessions
n Top 10 Device Families With Most Duration
n Top 10 Endpoints with Most Bandwidth Consumed
n Top 10 Endpoints with Most Sessions
n Top 10 Endpoints with Most Duration
n Top 20 Guests with Most Bandwidth Consumed
n Top 10 Guests with Most Sessions
n Top 10 Guests with Most Duration

Guest Devices—Expired The Guest Devices—Expired report lets you view information about expired
guest devices.
This report type includes the following report widgets:
n Guest Expiry Statistics
n Guest Expiry List (MAC Address and Device Name)

Guest Users and Devices—
Expired

The Guest Users and Devices—Expired report lets you view information about
expired guest accounts and devices.
This report type includes the following report widgets:
n Guest Expiry Statistics
n Guest Expiry List (MAC Address and Visitor Name)

Guest Users—Expired The Guest Users—Expired report lets you view information about expired guest
accounts.
This report type includes the following report widgets:
n Guest Expiry Statistics
n Guest Expiry List

Licensing Reports

The licensing report category allows you to generate a report about license usage over the selected time period.
Similar information can also be found in the Licensing widgets on the Licensing Dashboard. For additional
information, see Licensing Dashboard.
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Report Type Report Widgets

License Usage This report type includes the following licensing information:
n License statistics, including the total number of licenses, and the

number of licenses used for each license type
n Number of unique endpoints on the network over the selected time

period
n Number of ClearPass Access licenses used over the selected time

period
n Number of ClearPass Guest licenses used over the selected time

period
n ClearPass licenses distribution (available vs used)
n ClearPass license usage per host

Table 4: Licensing Report Content

Network Category Reports
The reports available in the Network category described in Table 5 contain data about network access devices
and gives details on authentication trends such as successful and failed authentications on a per-day basis.

Similar information can also be found in the Network widgets on the Network Dashboard. For additional
information, see Licensing Dashboard.

Report Type Report Widgets

Authentication by NAD This report type includes the following information for Network
Access Devices (NADs) using guest authentication.
n Authentication Statistics
n Total Authentication Trend
n Failed Authentication Trend
n Authentication Distribution Across NAD Ports
n Top 20 NADs with Most Authentication
n Top 10 Services with Most Authentications
n Top 20 NADs with Most Failed Authentications
n Top 20 NADs with Most MAC Addresses
n Top 20 NADs with Most Users
NOTE: This report also allows you to filter the report data by
NAD IP address.

Guest—Authentication by NAD This report type includes the following information for Network
Access Devices (NADs) using guest authentication
n Authentication Statistics
n Total Authentication Trend
n Failed Authentication Trend
n Authentication Distribution Across NAD Ports
n Top 20 NADs with Most Authentication
n Top 10 Services with Most Authentications
n Top 20 NADs with Most Failed Authentications
n Top 20 NADs with Most MAC Addresses
n Top 20 NADs with Most Guests
NOTE: This report also allows you to filter the report data by
NAD IP address.

RADIUS—Auth by NAD This report type includes the following information for Network
Access Devices (NADs) using guest authentication:
n Authentication Statistics

Table 5: Network Category Reports
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n Authentication Distribution Across NAD Ports
n Top 20 NADs with Most Authentication
n Top 10 Services with Most Authentications
n Top 20 NADs with Most Failed Authentications
n Top 20 NADs with Most MACs
n Top 20 NADs with Most Users
NOTE: This report also allows you to filter the report data by
NAD IP address.

OnGuard Category Reports

The reports available in the OnGuard category provide analysis on the devices' posture and health status.
These widgets contain data that can also be found in the Posture widgets on the Posture Dashboard. For
additional information, see Posture Dashboard.
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Report Type Report Widgets

Apple Mac Endpoint Posture This report type includes the following posture information for
Apple/Macintosh endpoints:
n OnGuard Statistics
n OnGuard Device Authentication Trend
n OnGuard Device Distribution Across Health Status
n Antispyware Product Name
n Antispyware Dat File Version
n Antispyware Engine Version
n OnGuard Device Distribution Across Antispyware Real-Time Protection

Status
n Antispyware Version
n Antivirus Product Name
n Antivirus Dat File Version
n Antivirus Engine Version
n OnGuard Device Distribution Across Antivirus RealTimeProtection

Status
n Antivirus Version
n Disk Encryption Product Name
n Disk Encryption Version
n Firewall Product Name
n OnGuard Device Distribution Across Firewall Status
n Firewall Version
n OnGuard Device Distribution Across Network Connection Type
n OnGuard Device Distribution Across P2P Application Name
n OnGuard Device Distribution Across P2P Status
n OnGuard Device Distribution Across Patch Agent Name
n Missing Patches Count
n OnGuard Device Distribution Across Patch Agent Status
n OnGuard Device Distribution Across Client Operating System
n OnGuard Device Distribution Across Client Running as VM
NOTE: This report also allows you to filter the report data by System
Posture Token (SPT).

Endpoint Posture Overview This report type includes the following endpoint posture information:
n OnGuard Statistics
n OnGuard Device Distribution Across Health Status
n Unhealthy OnGuard Device Distribution Across Device Family
n OnGuard Device Distribution Across Agent Type
n OnGuard Device Distribution Across Agent Version
n Health Class
n Missing Hotfixes
NOTE: This report also allows you to filter the report data by System
Posture Token (SPT).

Linux Endpoint Posture This report type includes the following posture information for endpoints
using a Linux operating system:
n OnGuard Statistics
n OnGuard Device Authentication Trend
n OnGuard Device Distribution Across Health Status
n Antivirus Product Name
n Antivirus Dat File Version
n Antivirus Engine Version
n OnGuard Device Distribution Across Antivirus RealTimeProtection

Status
n Antivirus Version

Table 6: OnGuard Category Reports
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NOTE: This report also allows you to filter the report data by System
Posture Token (SPT).

Windows Endpoint Posture This report type includes the following posture information for endpoints
using a Windows operating system:

n OnGuard Statistics
n OnGuard Device Authentication Trend
n OnGuard Device Distribution Across Health Status
n Antispyware Product Name
n Antispyware Dat File Version
n Antispyware Engine Version
n OnGuard Device Distribution Across Antispyware Real-Time Protection

Status
n Antispyware Version
n Antivirus Product Name
n Antivirus Dat File Version
n Antivirus Engine Version
n OnGuard Device Distribution Across Antivirus RealTimeProtection

Status
n Antivirus Version
n Disk Encryption Product Name
n Disk Encryption Version
n Firewall Product Name
n OnGuard Device Distribution Across Firewall Status
n Firewall Version
n OnGuard Device Distribution Across Network Connection Type
n OnGuard Device Distribution Across P2P Application Name
n OnGuard Device Distribution Across P2P Status
n OnGuard Device Distribution Across Patch Agent Name
n Missing Patches Count
n OnGuard Device Distribution Across Patch Agent Status
n OnGuard Device Distribution Across Client Operating System
n OnGuard Device Distribution Across Client Running as VM
NOTE: This report also allows you to filter the report data by System
Posture Token (SPT).
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Onboard Category Report
The reports available in the Onboard category provides analysis on onboarded devices during the report
period, such as the active users and devices count, revoked devices count, onboarded devices distribution
based on device type, and Onboard enrollment details.

Report Type Report Widgets

Onboard Certificate This report type includes the following certificate information:
n Onboard statistics for numbers of revoked devices, active devices,

and users
n Latest Onboard Device Distribution
n Active Onboard Device Distribution
n Top 10 Users with Most Active Devices

Onboard Certificate - Due to Expire This report type includes the following information for manually created
certificates due to expire within the selected time frame:

n Total number of devices of each device type with certificates due to
expire.

n Top 10 Users with Most Active Devices

Onboard Enrollment This report type provides the following information:
n Total Devices Onboarded
n Onboarded Devices Enrollment Trend
n Onboarded Devices
n Unique Users and Their Associated Total Number of Devices
n Unique Onboarded Devices

Table 7: Onboard Report Content
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RADIUS Authentication Category Reports
The reports available in the RADIUS Authentication provide detailed analysis on authentication trends on
successful and failed RADIUS authentication.

Additional authentication statistics are displayed on the Authentication Dashboard. For additional
information, see Authentication Dashboard.

Report Type Report Widgets

RADIUS—Authentication by Authentication
Source

This report type includes the following information for RADIUS
authentication:
n Authentication statistics for numbers and percentages of

authentications successes and failures
n Total Authentication Trend
n Failed Authentication Trend
n Authentication Distribution Across Authentication Source
n Authentication Distribution Across Authorization Source
n Failed Authentication Distribution Across Authentication

Source
NOTE: This report also allows you to filter the report data by
ClearPass Policy Manager host name.

RADIUS—Authentication by ClearPass This report type includes the following information for RADIUS
authentication:
n Authentication Statistics, including numbers and

percentages of authentications successes and failures
n Total Authentication Trend
n Failed Authentication Trend
n Authentication Distribution Error Types
n Authentication Distribution Across Service
n Top 10 ClearPass with Most Authentications
n Top 10 ClearPass with Most Failed Authentications
n Top 10 ClearPass with Most MAC Addresses
n Top 10 ClearPass with Most Users
NOTE: This report also allows you to filter the report data by
authentication source.

RADIUS—Authentication Overview This report type includes the following information for RADIUS
authentication:
n Authentication statistics, including numbers and

percentages of authentications successes and failures, and
numbers of users, endpoints, network devices, roles,
ClearPass servers and enforcement profiles

n Total Authentication Trend
n Authentication Status Trend
n Unique Devices Authentication Trend
n Unique Users Authentication Trend
n Authentication Distribution Across Auth Status
n Authentication Distribution Across Cluster
n Authentication Distribution Across Service
n Authentication Distribution Across VLAN
n Authentication Distribution Across SSID
n Authentication Distribution Across Enforcement Profiles
n Authentication Distribution Across Role
n Authentication Distribution Across Auth Source
n Top 10 Users with Most Authentications
n Top 10 MACs with Most Authentications

Table 8: RADIUS Authentication Category Reports
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Report Type Report Widgets

n Top 10 Services with Most Authentications
n Top 10 ClearPass Roles Assigned
n Top 10 Authorization Sources
n Top 20 NADs with Most Authentications
n Top 10 Enforcement Profiles Used
NOTE: This report also allows you to filter the report data by
ClearPass Policy Manager host name, Network Access Device
(NAD) IP address, SSID and authentication service name.

RADIUS—Authentication Trend This report type includes the following information:
n Authentication Statistics, including authentication data for

the previous day and week
n Total Authentication Trend
n Authentication Trend for Today and Yesterday
n Authentication Trend for Today and Same Day Week Ago
n Total Authentication for 1 Month (per month)
NOTE: This report also allows you to filter the report data by
ClearPass Policy Manager name, Network Access Device (NAD)
IP address, and SSID.

RADIUS—Failed Authentication This report type includes the following information:
n Error Statistics
n Failed Authentication Trend
n Authentication Distribution—Error Types
n Failed Authentication Distribution Across Service
n Failed Authentication Distribution Across Authentication

Sources
n Top 10 Errors with Most Failed Authentications
n Top 10 ClearPass Servers with Most Failed Authentications
n Top 20 NADs with Most Failed Authentications
n Top 10 Users with Most Failed Authentications
n Top 10 Endpoints with Most Failed Authentications
n Top 10 Services with Most Failed Authentications
NOTE: This report also allows you to filter the report data by
ClearPass Policy Manager host name, Network Access Device
(NAD) IP, SSID, and Error Code.

System Monitor Category Reports
The reports available in the System Monitorcategory provide information about system-level events, such as
configuration changes performed on the ClearPass server (configuration audit), license usage, and system
events.

Additional system statistics are displayed on the System Monitor Dashboard. For additional information
about the System Dashboard, see System Monitor Dashboard.
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Configuration Audit This report type includes the following information for each
configuration audit record:
n Name of change
n Action (for example, modify, add, or delete)
n Category
n Updated by
n Update timestamp

System Events This report type includes the following information for each
system event :
n ClearPass host name
n Source of Event
n Event Category
n Event Level
n Timestamp
n Description
NOTE: This report also allows you to filter the report data by
ClearPass Policy Manager host name.

Table 9: System Monitor Category Reports

TACACS Category Reports
The reports available in the TACACS category provide TACACS authentication trends such as successful and
failed TACACS authentication and command authorizations.

Report Type Report Widgets

TACACS—Authentication This report type includes the following licensing information
n TACACS statistics, including the numbers and percentages

of successful and failed authentications, and the numbers of
users, ClearPass servers, and network devices.

n Total Authentication Trend
n Authentication Status Trend
n Authentication Trend For Today and Yesterday
n Command List
n Authentication Distribution Across Authentication Status
n Authentication Distribution Across Cluster
n Top 10 Errors with Most Failed Authentications
n Top 20 NADs with Most Authentication
n Top 10 Users with Most Authentications
NOTE: This report also allows you to filter the report data by
ClearPass server and NAD IP address.

Table 10: TACACS Reports Content

Insight Inventory
n About the Insight Inventory

n Sorting and Filtering Inventory Table Data

n Viewing Endpoints Details

About the Insight Inventory

Insight lists all authenticated endpoints on the network on the Inventory page.
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View inventory information for all endpoints by navigating to Insight > Inventory, or click a graph widget on
the Endpoints, Posture or Authentication Insight dashboards and drill down to display inventory data
related to that graph.

Figure 886 The Insight Inventory Table

The endpoints information in the Inventory table is described in Table 1.

Column Description

MAC Address MAC address of the endpoint.

IP address IP address of the endpoint.

Hostname Host name of the endpoint.

Category Category assigned to the profiled endpoint device; for example, Access Points, Computer,
Server Smart Device, or VoIP phone.

Family The operating system (OS) family used by the endpoint device. For example, when the
category is Computer, Insight can show a device OS family of Windows, Linux, or Apple Mac.

Device Name The Device Name column describes a more specific device type within a device family. For
example, a computer in the Windows device family may show a device type of Windows
Vista/7/2008 or Windows 8/10.

Table 1: Endpoints Table Parameters

Sorting and Filtering Inventory Table Data
By default, each page of the Inventory table displays endpoints sorted by MAC address.

Click any column heading to resort the table by that column data type.

Click the filter ( )icon on the Inventory table header to select one or more filter options and modify the table
display only selected endpoint types.

The available filter types are described in Table 2 below.
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Column Action/Description

Device Category The Device Category drop-down list displays a list of the categories of devices found on your
network, such as a server or printer. By default, the All option is selected, and the inventory
displays devices in all categories.
Click this drop-down list and select any other device category to filter the table and display
only devices of the selected type.
The contents of this drop-down list may vary, depending upon the types of devices in your
network.

Device Family The Device Family drop-down list displays a list of the device families found on your
network, such as a Hewlett Packard, Aruba, or Intel. By default, the All option is selected, and
the inventory displays devices in all categories.
Click this drop-down list and select any other device category to filter the table and display
only devices of the selected type.
The contents of this drop-down list may vary, depending upon the types of devices in your
network, and the selected device category.

Device Name The Device Name drop-down list displays a list of the device names found on your network,
such as an Apple iPhone. By default, the All option is selected, and the inventory displays
devices in all categories.
Click this drop-down list and select any other device category to filter the table and display
only devices of the selected type.
The contents of this drop-down list may vary, depending upon the types of devices in your
network, and the selected device category.

Static IP Click the Static IP drop-down list and select one of the following options:
n All: Display endpoints with static and non-static IP addresses.
n True: Display endpoints with a static IP address.
n False: Display endpoints with a non-static IP address.

Conflict Status Click the Conflict Status drop-down list and select one of the following options:
n All: Display all endpoints.
n True: Display endpoints with a conflict (device is profiled into two or more different

categories.)
n False: Display endpoints with no conflict.

Fingerprint Type Insight can obtain fingerprint information for network devices through a variety of sources
(for example, obtained directly from the host, or via DHCP or SNMP) The fingerprint drop-
down list displays a list of fingerprint information sources for the devices found on your
network. By default, the All option is selected, and the inventory displays devices identified by
all fingerprinting types. Click this drop-down list and select any other fingerprinting type to
filter the table and display only devices identified by the selected fingerprinting method.
NOTE: The contents of this drop-down list may vary, depending upon the fingerprinting
methods used to identify devices on your network.

Posture Click the Posture option select one of the following options to filter endpoints that have a
posture status as a result of having undergone a health check.
n All: Display all endpoints.
n True: Display endpoints that have posture information.
n False: Display endpoints that do not have posture information

Table 2: Inventory Table Filter Parameters
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Column Action/Description

System Posture
Status

Click this option to filter the Inventory table by one or more of the posture status types for
the endpoints on your network that have undergone a health check and have posture status
information. This field will only return information for endpoints that have a posture status of
True. The available parameters in this filter may vary, depending upon the posture status of
the devices on your network.

Added at Enter a start date and an end date to display devices added within a specified time range. You
can also click the calendar ( ) icon in the Start Date and End Date fields to select a start
and end date from a calendar.

Last Updated Enter a start date and an end date to display devices updated within a specified time range.
You can also click the calendar ( ) icon in the Start Date and End Date fields to select a
start and end date from a calendar.

Authentication At Enter a start date and an end date to display devices authenticated within a specified time
range. You can also click the calendar ( ) icon in the Start Date and End Date fields to
select a start and end date from a calendar.

Viewing Endpoints Details
The Endpoint Details page appears when you select any MAC address in the Inventory table, or when you
enter and search for a search string in the Insight search bar. This data can include information in the following
categories:

n Summary: Total number of successful authentications for that device over the selected time period.

n Overview: This section displays endpoint information such as the device IP address, MAC address and host
name, and network details such as the AP , controller or switch port to which the endpoint is connected.

n Device Profile: Conflict information, and device profile data, such as the device category, family and name,
and the time the device was first added or last updated.

n Onguard: This section displays Onguard health check data, if available.

n Endpoint Details: This section displays authentication details, endpoint role and policy information, the IP
address of the NAD (Network Access Device), and the current authentication status.

n Fingerprint Details: This section displays fingerprint details and information about fingerprint
information sources for that endpoint.

n Authentication Trend: A line chart showing the number of successful authentications during each day of
the selected time period

n Bandwidth Usage: A bar chart showing bandwidth used by the endpoint during each day of the selected
time period.

If the endpoint is seen on the trunk port instead of an access port, the information shown in the Switch Port field of
the Network Details section displays the word (Trunk) after the network switch port number.

Administration Operations
This section provides the following information:

n Overview

n File Transfer Settings Configuration

n Database Settings Configuration
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Overview
You can use the Administration page to do the following tasks:

n Specify the number of days to retain information in the database.

n Test the new notification settings to review Insight log files.

n Store reports offline using the SCP or SFTP file transfer protocol.

To access the Administration page:

1. From the Insight navigation pane, click Administration.

The Administration page appears.

Figure 887 Administration Page

Support Information
n Insight database migration is supported.

n Configuration migration is not supported.

n Database retention default: 30 days

n Report retention default: 60 days

n CSV report limit: 50,000 rows

File Transfer Settings Configuration
You can specify the file transfer settings for uploading generated Insight reports to a FileStore.

To configure the file transfer settings:

1. Navigate to the Administration page.
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Figure 888 Specifying the Insight File Transfer Settings

2. In the File Transfer Settings section, enter the appropriate values as described in Table 1.

3. When finished, click Save.

Parameter Action/Description

Host Specify the IP address of the destination host FTP server.

Protocol Specify the protocol to be used to upload the generated reports to a FileStore.
You can select from the following protocols:
n SCP (Session Control Protocol)
n SFTP (SSH File Transfer Protocol)

Port Specify the destination port number.
The default destination port is 22.

Username/Password Enter the username and password of the host FTP server.

Timeout Specify the timeout value in seconds.
The default value is 30 seconds.

Remote Directory Specify the location where the generated reports are to be copied.
If the remote directory location is same as default root of FTP, you can leave this
field blank.
NOTE: To copy reports to a remote directory, you must enable the Reports >
Create New Report > Enable remote copy option.

Table 1: Insight File Transfer Parameters

Testing File Transfer Configuration
When you have configured the Insight file transfer settings, you can then test to see if file transfer is
operational.

To test the Insight file transfer configuration:

1. Review the File Transfer Settings to ensure they are correct.

2. Click the Test button.

You see the message: File Transfer Settings testing in progress...

Then the following screen opens:
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Figure 889 Successful File Transfer Test

You are now ready to commence transferring Insight files to the FTP server as needed.

Database Settings Configuration
To configure the Insight database parameters:

1. Navigate to the Administration page.

The Database Settings section is at the bottom of the Administration page.

Figure 890 Specifying the Insight Database Settings

2. In the Database Settings section, enter the appropriate values as described in Table 2.

3. When finished, click Save.

Parameter Action/Description

Database Retention Specify the number of days to retain the database.
The supported range is from 1 to 730 days. The default value is 30 days.

Report Retention Specify the number of days to retain the generated reports.
The supported range is from 1 to 365 days. The default value is 60 days.

CSV Report Limit Specify the number of rows for a CSV report.
The supported range is from 1 to 50,000 rows. The default value is 50000 rows.

Table 2: Insight Database Parameters

Managing Insight Admin Privileges
This section provides the following information:

n Overview

n Viewing the Default Insight Admin Privileges
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n Defining Custom Insight Admin Privileges

n Insight User Interface Differences for Read-Only Users

Overview
ClearPass supports multilevel Insight administrators, each with a different level of administrative access to
Insight. ClearPass provides a default Admin Privileges Read-only Administrator. The default sets of admin
privileges cannot be modified.

Each of the Insight modules (Dashboard, Reports, Alerts, Administration, and Inventory) can have three
privilege levels or no privileges:

n Read-only

n Read and Write

n Read, Write, and Delete

In the case of a user with no Insight admin privileges, the navigation panel on the left side of the Insight user
interface is not displayed.

Viewing the Default Insight Admin Privileges
The settings for the default admin privileges cannot be modified. To view the default Insight admin privileges
defined in ClearPass Policy Manager:

1. From the ClearPass Policy Manager user interface, navigate to Administration > Users and Privileges >
Admin Privileges.

The Admin Privileges page opens.

Figure 891 Admin Privileges Page

2. To view the Read-only admin privileges for Insight, select Read-only Administrator.

The Edit Admin Privileges dialog opens.

3. Select the Insight tab.

The default Insight admin privileges for the Read-only Administrator are displayed.
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Figure 892 Insight Read-Only Administrator Admin Privileges

As shown in Figure 892, the default admin privileges for the Insight Read-only Administrator specifies Read-
only access to all of the Insight modules:

l Dashboard

l Reports

l Alerts

l Administration

l Inventory

Defining Custom Insight Admin Privileges
As described above, ClearPass provides a default Read-only Administrator. The default sets of admin privileges
cannot be modified.

When a different set of admin privileges is needed (for example, if you require different admin privileges for
the Report module than the admin privileges defined for the other Insight modules), you must create a new
admin privileges administrator.

Insight privileges can be defined from two locations:

n Operator Profiles in ClearPass Guest

n Admin Privileges in ClearPass

To define custom admin privileges for Insight:

1. Navigate to Administration > Users and Privileges > Admin Privileges.

The Admin Privileges page opens.

2. Click the Add link.

The Add Admin Privileges dialog opens.
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Figure 893 Add Admin Privileges Dialog: Basic Information Tab

3. Specify the parameters in the Basic Information tab as described in Table 39.

Table 39: Add Admin Privileges Parameters: Basic Information Tab

Parameter Action/Description

Name Enter the name of the Admin Privileges administrator.

Description Provide a description of this new admin privileges administrator.

Access Type Select one of the following Access Types:
n Give full access to the Admin
n Give UI access to the Admin
n Give API access to the Admin

Allow Passwords Select this check box if you want to allow password access.

Specifying Insight Admin Privileges
To specify the Insight admin privileges for the new administrator:

1. When you complete the Basic Information parameters, select the Insight tab.

The Add Admin Privileges > Insight dialog opens.
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Figure 894 Add Admin Privileges > Insight Dialog

You must configure the admin privileges for Policy Manager also, otherwise the changes to the Insight admin
privileges cannot be saved.

2. Specify the desired admin privileges for each of the Insight modules, then click Save.

Insight User Interface Differences for Read-Only Users
When Insight is accessed by a user who has Read-only privileges for all five Insight modules (Dashboard,
Reports, Alerts, Inventory and Administration), that user is not allowed to create or delete reports.

As shown in Figure 895, when a Read-only administrator logs in to Insight, the Create New Report button is
not visible.

Likewise, the Delete icon on the Configured Reports table is not visible for a Read-only administrator.

Figure 895 Create New Report Button Not Present for Read-Only User

Various action buttons, icons, and so on throughout the Insight user interface are shown only to users who are
allowed to execute the actions provided by their admin privilege level.
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Appendix A

Command Line Interface

Refer to the following sections to perform various tasks using the Command Line Interface (CLI):

n Cluster Commands

n Configure Commands

n Miscellaneous Commands

n Network Commands

n Service Commands

n Show Commands

n SSH Timed Account Lockout

n System Commands

Cluster Commands
The Policy Manager command line interface includes the following cluster commands:

n cluster drop-subscriber

n cluster list

n cluster make-publisher

n cluster make-subscriber

n cluster reset-database

n cluster set-cluster-passwd

n cluster sync-cluster-passwd

cluster drop-subscriber
Use the drop-subscriber command to remove a specific subscriber node from the cluster.

Syntax
cluster drop-subscriber [-f] [-i <IP address>] -s

Table 1 describes the required and optional parameters for the drop-subscriber command:

Parameter/Flag Action/Description

-f Enter the -f parameter to force ClearPass to drop even the nodes that are down.

-i <IP Address> Specify the Management IP address of the node.
If this IP address is not specified and the current node is a Subscriber, Policy Manager drops
the current node.

-s Restricts resetting the database on the dropped node.
By default, Policy Manager drops the current node—if it's a Subscriber—from the cluster.

Table 1: Drop-Subscriber Command Parameters
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Example
The following example removes the IP address 192.xxx.1.1 from the cluster:

[appadmin]# cluster drop-subscriber -f -i 192.xxx.1.1 -s

cluster list
Use the cluster list command to list all the nodes in the cluster.

Syntax
cluster list

Example
The following example lists all the nodes in a cluster:

[appadmin]# cluster list

cluster make-publisher
Use the cluster make-publisher command to promote a specific subscriber node to be the publisher node in
the same cluster.

When running this command, do not close the shell or interrupt the command execution.

Example
The following example promotes a subscriber node to publisher node status:

[appadmin]# cluster make-publisher
********************************************************
* WARNING: Executing this command will promote the *
* current machine (which must be a subscriber in the *
* cluster) to the cluster publisher. Do not close the *
* shell or interrupt this command execution. *
********************************************************
Continue? [y|Y]: y

To continue the make-publisher operation, enter y.

cluster make-subscriber
Run the cluster make-subscriber command on a standalone Publisher to make the standalone node a
Subscriber node and add it to the cluster.

Syntax
cluster make-subscriber -b -i <IP address> [-l]

Table 2 describes the required and optional parameters for the make-subscriber command:
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Parameter/Flag Action/Description

-b Generates a backup of the publisher before you make it a subscriber in the event the
make-subscriber process fails and you need to restore the Publisher.

-i <IP address> Specify the Publisher's IP address. This field is mandatory.

-l Restores the local log database after this operation. This field is optional.

Table 2: Cluster Make-Subscriber Command Parameters

Example
The following example converts the node with IP address 192.xxx.1.1 to a subscriber node:

[appadmin]# cluster make-subscriber –i 192.xxx.1.1 -l

cluster reset-database
Use the reset-database command to reset the local database and erase its configuration.

Running this command erases the Policy Manager configuration and resets the database to its default
configuration—all the configured data will be lost.

When running this command, do not close the shell or interrupt the command execution.

Syntax
cluster reset-database

Example
The following example reset the database:

[appadmin]# cluster reset-database
**********************************************************
* WARNING: Running this command will erase the Policy Manager *
* configuration and leave the database with default *
* configuration. You will lose all the configured data. *
* Do not close the shell or interrupt this command *
* execution. *
*********************************************************
Continue? [y|Y]: y

To continue the reset-database operation, enter y.

cluster set-cluster-passwd
Use the cluster set-cluster-passwd command to change the cluster password on all nodes in the cluster.
You may only issue this command from the publisher node.

Setting the cluster password changes the appadmin password for all the nodes in the cluster

Syntax
cluster set-cluster-passwd

ClearPass 6.7 Policy Manager | User Guide Command Line Interface | 890
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1922



891 | Command Line Interface ClearPass 6.7 Policy Manager |  User Guide

Example
The following example changes the cluster password on publisher nodes:

[appadmin]# cluster set-cluster-passwd
cluster set-cluster-passwd

Continue? [y|n]: y

Enter Cluster Passwd: college.162

Re-enter Cluster Passwd: college.162

INFO - Password changed on local (publisher) node
Cluster password changed

cluster sync-cluster-passwd
Use the cluster sync-cluster-passwd command to synchronize the cluster (appadmin) password currently
set on the publisher with all the subscriber nodes in the cluster.

Synchronizing the cluster password changes the appadmin password for all the nodes in the
cluster

Syntax
cluster sync-cluster-passwd

Example
The following example synchronizes the cluster password:

[appadmin]# cluster sync-cluster-passwd
Continue? [y|n]: y

Enter Password: college.205

Re-enter Password: college.205

Configure Commands
The ClearPass Policy Manager command line interface includes the following configure commands:

n configure date

n configure dns

n configure fips-mode

n configure hostname

n configure ip

n configure ip6

n configure mtu

n configure timezone

configure date
Use the configure date command to specify the cluster's primary and secondary NTP (Network Time
Protocol) servers, the key index, key value, encryption type, and optionally, the time zone for the Publisher
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node.

The Audit Viewer (Monitoring > Audit Viewer) tracks NTP configuration changes.

Syntax
configure date -p <ntp_server1> [-a <key-index> -v <key-value> -t <encryption-type>] [-s <ntp_server2> [-
a <key-index> -v <key-value> -t <encryption-type>]] [-z <timezone>]

The following table describes the parameters for the configure date command:

Flag/Parameter Action/Description

-p <ntp_server1>
-p <ntp_server2>

Specify the primary and secondary NTP server names or IP addresses.
NOTE: You can specify a destination node with an IPv6 address enabled.

-a <key-index> The Key Index (also referred to as the Key ID) is a number that specifies the index for key
values.
The key-index value can be from 1 to 65534 inclusive.
Typically an NTP client and server have to trust the same key index and key value pair for
authentication to succeed.

-v <key-value> The Key Value is a form of shared secret, which both the client and server use for
authenticating NTP messages. The Key Value can be:
n Up to 20-character printable ASCII string
n Up to 40-character hex value
When entering an ASCII string for the Key Value, note that it cannot contain the following
characters:
n & (ampersand)
n ; (semicolon)
n `(grave accent)
n | (pipe)
n < (left angle bracket)
n > (right angle bracket)
n ( (left parenthesis)
n ) (right parenthesis)
Finally, the Key Value ASCII string must start and end with one of the following characters:
n - (hyphen)
n ' (apostrophe)
n " (quote)

-t <encryption-type> Select one of the two options for Encryption Type:
n SHA
n SHA1
NOTE: In FIPS mode, SHA is not a supported encryption type.

-z <timezone> Specify the time zone on the Publisher node.
To view the list of supported time zones, enter show all-timezones. This field is optional.

Table 1: Configure Date Command Parameters

Example 1
The following example configures the key-index, key-value, and encryption type for the primary and secondary
NTP servers:

[appadmin]# configure date -p ntp1.cppm.main -a 24 -v cp1234567890 -t SHA -s ntp2.cppm.main -
a 16 -v cp53.56 -t SHA1
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Example 2
The following example synchronizes with the primary NTP server. Note that in this example, the key-value is a
hex code. Using a hex code for the key-value is supported only in the CLI, not in the user interface.

[appadmin]# configure date -p ntp1.cppm.main -a 96 -v 6bf60ca1876b57248311aa07c7783d391be95d6c
-t SHA1

configure dns
Use the configure dns command to configure DNS servers. You must specify a minimum of one DNS server;
you can specify a maximum of three DNS servers.

Syntax
configure dns <primary> [secondary] [tertiary]

Example 1: DNS Server
The following example configures a DNS server:

[appadmin]# configure dns 192.168.xx.1

Example 2: Primary and Secondary DNS Servers
The following example configures the primary and secondary DNS servers. You can configure IPv6 address as
described in this example.

[appadmin]# configure dns 192.168.xx.1 2001:4860:4860::8888

Example 3: Primary, Secondary, and Tertiary DNS Servers
The following example configures primary, secondary, and tertiary DNS servers:

[appadmin]# configure dns 192.168.xx.1 2001:4860:4860::8888 192.168.xx.2

configure fips-mode
Use the configure fips-mode command to enable or disable FIPS (Federal Information Processing Standard)
mode.

Running this command erases the ClearPass Policy Manager configuration settings and returns the database to the
default configuration. All configured data will be lost. This command also shuts down all running applications and
reboots the system.

Syntax
configure fips-mode [0|1]

The following table describes the parameters for the configure fips-mode command:

Flag/Parameter Action/Description

0 To disable FIPS mode, enter 0.
Read the warning message carefully before enabling or disabling FIPS mode.

1 To enable FIPS mode, enter 1.

Table 2: Configure fips-mode Command Parameters
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Example 1
The following example disables FIPS mode:

[appadmin]# configure fips-mode 0
******************************************************************
* *
* WARNING: Running this command will erase the Policy Manager *
* configuration and leave the database with default *
* configuration. You will lose all the configured data. *
* *
* This command will also shutdown all applications and reboot *
* the system. *
* *
* Do not close the shell or interrupt this command execution. *
* *
******************************************************************
Continue? [y|n]: y

Clicking y in this example disables FIPS mode.

configure hostname
Use the configure hostname command to configure the hostname.

Syntax
configure hostname <hostname>

Example
The following example configures a hostname:

[appadmin]# configure hostname sun.us.arubanetworks.com

configure ip
Use the configure ip command to configure the IPv4 address of the management interface or the data
interface, netmask, and gateway address.

Syntax
[appadmin]# configure ip <mgmt|data> <ipaddress> netmask <netmask address> gateway <gateway
address>

The following table describes the parameters used in the configure ip command:

Flag/Parameter Action/Description

ip <mgmt|data> <IP address> Specify the network interface type: management port interface or data
point interface.
<ip address> specifies the IPv4 address of the host.

netmask <netmask> Specify the netmask for the IP address.

gateway <gateway address> Specify the IP address for the network gateway.

Table 3: Configure IP Command Parameters
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Example
The following example configures the IP address for the data interface, the netmask for that address, and the
gateway address:

[appadmin]# configure ip data 192.168.xx.12 netmask 255.255.255.0 gateway 192.168.xx.1

configure ip6
There are two methods for using the configure ip6 command to configure IPv6:

Syntax
n [appadmin]# configure ip6 <mgmt|data> <IPv6 address/PrefixLen> gateway <gateway address>

n [appadmin]# configure ip6 <mgmt|data> <IPv6 address> netmask <netmask> gateway <gateway

address>

The following table describes the parameters used in the configure ip6 command:

Flag/Parameter Action/Description

ip6 <mgmt|data> <IP address> Specifies the network interface type: management interface or data interface.

IP address/PrefixLen The prefix-length in IPv6 is the equivalent of the subnet mask in IPv4.

netmask <netmask> Specifies the netmask.
For example, ffff:ffff:ffff:ffff:0000:0000:0000:0000.

gateway <gateway address> Specifies the gateway address.
For example, fe90:0000:0000:0000:020c:29ff:fe7e:d3a2.

Table 4: Configure ip6 Command Parameters

Example
n The following example configures the IPv6 management interface, IPv6 address/PrefixLength, and gateway

address:

[appadmin]# configure ip6 mgmt 2001:100:200:128::157/64 gateway 2001:100:200:128::129

n The following example configures the IPv6 management interface, netmask, and gateway address:

[appadmin]# configure ip6 mgmt fe90:0000:0000:0000:020c:29ff:fe7e:d3e1 netmask
ffff:ffff:ffff:ffff:0000:0000:0000:0000 gateway fe90:0000:0000:0000:020c:29ff:fe7e:d3a1

configure mtu
Use the configure mtu command to set the MTU (Maximum Transmission Unit) for the management and
data port interfaces.

Running this command might cause the ClearPass server to lose network connectivity.

Syntax
configure mtu <mgmt|data> <mtu-value>
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The following table describes the configure mtu command parameters:

Flag/Parameter Action/Description

mtu <mgmt|data> Specify the network interface types: management port interface or data port interface.

<MTU value> Specify the MTU value in bytes. The default value is 1500 bytes.

Table 5: Configure mtu Command Parameters

Example 1
The following example configures the MTU management interface:

[appadmin] # configure mtu mgmt 1498
********************************************************
* *
* WARNING: Running this command might cause system *
* to lose network connectivity and may require relogin.*
* *
********************************************************
Continue? [y|Y]: y
INFO: Restarting network services
INFO: Successfully applied MTU settings

Example 2
The following example configures the MTU data port value:

[appadmin]# configure mtu data 1498
********************************************************
* *
* WARNING: Running this command might cause system *
* to lose network connectivity and may require relogin.*
* *
********************************************************
Continue? [y|Y]: y
INFO: Restarting network services
INFO: Successfully applied MTU settings

Example 3
Use the show ip command to display the settings of the MTU management and data port interfaces:

[appadmin]# show ip
===========================================
Device Type : Management Port
-------------------------------------------
IPv4 Address : 10.2.xx.86

Subnet Mask : 255.255.255.0
Gateway : 10.2.xx.1

IPv6 Address : 2607:f0d0:1002:0011:0000:0000:0000:0002
Subnet Mask : ffff:ffff:ffff:ffff:0000:0000:0000:0000
Gateway : 2607:f0d0:1002:0011:0000:0000:0000:0001
Hardware Address : 00:0C:29:70:27:40
MTU : 1499
===========================================
Device Type : Data Port
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-------------------------------------------
IPv4 Address : <not configured>
Subnet Mask : <not configured>
Gateway : <not configured>
IPv6 Address : fe80:0000:0000:0000:020c:29ff:fe70:274a
Subnet Mask : ffff:ffff:ffff:ffff:0000:0000:0000:0000
Gateway : fe80:0000:0000:0000:020c:29ff:fe70:2741
Hardware Address : 00:0C:29:70:27:4A
MTU : 1498
===========================================
DNS Information
-------------------------------------------
Primary DNS : 10.2.xx.3

Secondary DNS : 10.1.xx.50

Tertiary DNS : 10.1.xx.200

===========================================

configure timezone
Use the configure timezone command to interactively configure the time zone.

Syntax
configure timezone

Example
The following example configures the time zone interactively:

[appadmin]# configure timezone
configure timezone
*********************************************************
* WARNING: When the command is completed Policy Manager services *
* are restarted to reflect the changes. *
*********************************************************
Continue? [y|Y]: y

Network Commands
The ClearPass Policy Manager command line interface includes the following network commands:

n network ip6

n network ip

n nslookup

n network ping6

n network ping6

n network reset

n network traceroute6

n network traceroute
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network ip6
Use the network ip6 command to add, delete, or list custom routes to the data or management interface
routing table in IPv6 networks.

Syntax: network ip6 add
network ip6 add <mgmt|data> [-i <id>] <[-s <SrcAddr>] [-d <DestAddr>]> [-g <ViaAddr>]

The following table describes the required and optional parameters for the network ip6 command:

Flag/Parameter Description

<mgmt|data> Specifies the management or the data interface.

-i <id> Specifies the ID of the network IP rule. If this ID is not specified, the system
generates an ID automatically.
NOTE: This ID determines the priority in the ordered list of rules in the routing table.

-s <SrcAddr> Specifies the source interface IPv6 address or netmask from where the network
IPv6 rule is specified. For example, fe82::20c:29ff:fe7e:d3e1. A valid IPv6 address or
a netmask or 0/0 values are allowed. This parameter is optional.

-d <DestAddr> Specifies the destination interface IPv6 address or netmask where the network IPv6
rule is specified. A valid IPv6 address or a netmask or 0/0 values are allowed. This
parameter is optional.

-g <ViaAddr> Specifies the via or gateway IPv6 address through which the network traffic should
flow. A valid IPv6 address is allowed. This parameter is optional.

Table 1: Network IP6 Add Command Parameters

Example: Adding an IPv6 Custom Route

You can use an IPv6 address when adding a custom route.

The following example adds a custom route:

[appadmin]# network ip6 add data -s fe82::20c:29ff:fe7e:d3e1/d3e24

Syntax: network ip6 del
This command deletes an IPv6 custom route.

network ip6 del <-i <id>>

Syntax: network ip6 list
This command lists all custom routing rules.

network ip6 list

Example: Listing All IPv6 Custom Routing Rules

The following example lists all custom routing rules:

[appadmin]# network ip6 list

===============================================
IP Rule Information
-----------------------------------------------
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0: from all lookup local
13000: from all to fe82::20c:99ff:fe7e:d3e1 lookup mgmt
13001: from all to fe82::20c:99ff:fe7e:d3e4 lookup mgmt
13002: from all to fe82::20c:99ff:fe7e:d3e7 lookup mgmt
13003: from all to fe82::20c:99ff:fe7e:d3e8 lookup mgmt
13004: from all to fe82::20c:99ff:fe7e:d3e9 lookup mgmt
13005: from all to fe82::20c:99ff:fe7e:d3ea lookup static
32766: from all lookup main
===============================================

Syntax: network ip6 reset
network ip6 reset

This command resets the routing table to the factory default settings and all custom routes are removed.

network ip
Use the network ip command to add, delete, or list custom routes to the data or management interface
routing table.

Syntax: network ip add

network ip add <mgmt|data|greN|vlanN> [-i <id>] <[-s <SrcAddr>] [-d <DestAddr>]> [-g
<ViaAddr>]

The following table describes the required and optional parameters for the network ip add command:

Flag/Parameter Description

<mgmt | data| greN
|vlanN>

Configures the management interface, data interface, the name of the GRE tunnel,
or the VLAN number.
n <greN>: N specifies the GRE tunnel number ranging from 1,2,3...N.
n <vlanN>: N specifies the VLAN number.

-i <id> Specifies the ID of the network IP rule. If this ID is not specified, the system
generates an ID automatically.
NOTE: This ID determines the priority in the ordered list of rules in the routing table.

-s <SrcAddr> Specifies the IP address or network. For example, 192.168.xx.0/24 or 0/0 (for all
traffic) of traffic originator. You must specify only one source IP address. This
parameter is optional.

-d <DestAddr> Specifies the destination IP address or network. For example, 192.168.xx.0/24 or 0/0
(for all traffic). You must specify only one destination IP address. This parameter is
optional.

-g <ViaAddr> Specifies the via or gateway IP address through which the network traffic should
flow. A valid IP address is allowed. This parameter is optional.

Table 2: Network IP Add Command Parameters

Syntax: network ip del
network ip del <-i <id>>

The following table describes the parameter for the network ip del command:
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Flag/Parameter Description

-i <id> Specifies the ID of the rule to delete.

Table 3: Network IP Del Command Parameters

Syntax: network ip list
network ip list

This command lists all routing rules.

Example: Adding a Custom Route

The following example adds a custom route:

[appadmin]# network ip add data -s 192.168.xx.0/24

Example: Listing All Custom Routes

The following example lists all custom routes:

[appadmin]# network ip list
===============================================

IP Rule Information
-----------------------------------------------
0: from all lookup local
10020: from all to 10.xx.4.0/24 lookup mgmt
10040: from 10.xx.4.200 lookup mgmt
10060: from 10.xx.5.200 lookup data
32766: from all lookup main
32767: from all lookup default
===============================================

Syntax: network ip reset
network ip reset

This command resets the routing table to the factory default settings. All custom routes are removed.

nslookup
Use the network nslookup command to get the IP address of the host using DNS.

Syntax: network nslookup
network nslookup -q <record-type> <host>

The following table describes the required and optional parameters for the nslookup command:

Flag/Parameter Description

<record-type> Specifies the type of DNS record. The record types available are:
n A
n AAAA
n CNAME
n PTR
n SRV

<host> Specifies the host or domain name to be queried.

Table 4: Network Nslookup Command Parameters
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Example: Obtaining Address of Host or Domain

The following examples obtain the IPv4 and IPv6 addresses of the host or domain using DNS:

[appadmin]# nslookup sun.us.arubanetworks.com
[appadmin]# network nslookup 2001:4860:4860::8888

Example: Querying for SRV Records

The following example queries a host or domain for SRV records:

[appadmin]# nslookup -q SRV arubanetworks.com

Syntax
Use the AAAA flag with the -q option to perform network nslookup with IPv6 destinations.

nslookup -q AAAA <IPv6_addr>

Example: Nslookup for IPv6 Address

The following example performs network nslookup for the destination with an IPv6 address:

[appadmin]# network nslookup 2001::93
Server: 2001::94
Address: 2001::94#53
3.9.0.0.0.0.0.0.0.0.0.0.0.0.0.0.0.0.0.0.0.0.0.0.0.0.0.0.1.0.0.2.ip6.arpa name = ipv6test-
n1.cppmipv6.com

[appadmin]# network nslookup -q AAAA ipv6test-n1.cppmipv6.com
Server: 2001::94
Address: 2001::94#53
ipv6test-n1.cppmipv6.com has AAAA address 2001::93

network ping6
Use the network ping6 command to test the reachability of the network host.

Syntax: network ping6
network ping6 [-i <SrcIPv6Addr>] [-t] <host>

The following table describes the required and optional parameters for the network ping6 command:

Flag/Parameter Description

-i <SrcIPv6Addr> Specifies the originating IPv6 address for the ping. This field is optional.

-t Use this parameter to ping indefinitely. This field is optional.

<host> Specifies the host to be pinged.

Table 5: Network Ping6 Command Parameters

Example

The following example pings an IPv6 network host to test its reachability:

[appadmin]# network ping6 –i fe82::20c:29ff:fe7e:d3e1 –t sun.us.
arubanetworks

.com
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network ping
Use the network ping command to test the reachability of the network host.

Syntax: network ping
network ping [-i <SrcIpAddr>] [-t] <host>

The following table describes the required and optional parameters for the network ping command:

Flag/Parameter Description

-i <SrcIpAddr> Specifies the originating IP address for the ping. This field is optional.

-t Use this parameter to ping indefinitely. This field is optional.

<host> Specifies the host to be pinged.

Table 6: Network Ping Command Parameters

Example: Testing Reachability

The following example pings a network host to test the reachability:

[appadmin]# network ping –i 192.168.xx.10 –t sun.us.arubanetworks.com

network reset
Use the network reset command to reset the network data and management ports. You can use this
command to reset both IPv4 and IPv6 addresses.

Syntax: network reset
network reset <data[v4|v6]/mgmt>

The following table describes the required and optional parameters for the network reset command:

Flag/Parameter Description

data [v4|v6] Specifies the name of network data port to reset, as well as whether it is an IPv4 or IPv6
address. This parameter is mandatory.

mgmt Specifies the name of network management port to reset.

Table 7: Network Reset Command Parameters

Example

The following example resets the IPv6 network data port:

[appadmin]# network reset data v6

network traceroute6
Use the network traceroute6 command to print the route taken to reach the IPv6 network host.

Syntax: network traceroute6
network traceroute6 <host>

The following table describes the required and optional parameters for the network traceroute6 command:
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Flag/Parameter Description

<host> Specifies the name of network host. You can specify the host with an IPv6 address.

Table 8: Network Traceroute6 Command Parameters

Example

The following example prints the route taken to reach the network host:

[appadmin]# network traceroute6 sun.us.arubanetworks.com

network traceroute
Use the network traceroute command to print the route taken to reach the network host.

Syntax: network traceroute
network traceroute <host>

The following table describes the required parameter for the network traceroute command:

Flag/Parameter Description

<host> Specifies the name of the network host.

Table 9: Network Traceroute Command Parameters

Example

The following example prints the route taken to reach the network host:

[appadmin]# network traceroute sun.us.arubanetworks.com

Miscellaneous Commands
The Policy Manager command line interface includes the following miscellaneous commands:

n ad auth

n ad netjoin

n ad netleave

n ad passwd-server

n ad testjoin

n alias

n backup

n dump certchain

n dump logs

n dump servercert

n exit

n help

n krb auth

n krb list

n ldapsearch

n quit
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n restore

ad auth
Use the ad auth command to authenticate the user against Active Directory. This command manually checks
against Active Directory to indicate whether or not a username and password are valid.

Syntax
ad auth -u <username> -n <NetBIOS domain name>

The following table describes the parameters for the ad auth command:

Flag/Parameter Description

-u <username> Specifies the username of the authenticating user. This is a mandatory parameter.

-n <domain NetBIOS
name>

Specifies the domain name. This field is optional.

Table 1: AD Auth Command Parameter

Example
The following example authenticates the user against Active Directory:

1. Enter the command:

[appadmin]# ad auth -u jbrown -n sanfranedu

You are prompted to enter the password.

2. Enter the password.

If the username and password you provide in this command are correct, the following message is displayed:

INFO – NT_STATUS_OK: Success (0x0)

This message indicates that NT LAN Manager (NTLM) authentication (NTLM being the mechanism that
ClearPass uses to authenticate users) has succeeded.

ad netjoin
Use the ad netjoin command to join the host to the domain.

Syntax
ad netjoin <domain-controller.domain-name> [domain NetBIOS name] [domain REALM name]
[ou=<object container>]

The following table describes the parameters for the ad netjoin command:
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Parameter Action/Description

<domain-controller. domain-
name>

Specify the complete Fully Qualified Domain Name (FQDN) of the domain
controller, including its hostname.
For example, if atlas.org is the Domain FQDN and DC01.atlas.org is one of its
domain controllers, then this argument would be correctly expressed as
DC01.atlas.org
This field is mandatory.

[domain NetBIOS name] Specify the NetBIOS name of the domain (optional argument).
You can specify this argument if the derived NetBIOS name is different from the
actual name. This is an optional argument.

[domain REALM name] You can specify this argument if the derived REALM is different from the actual.
This is an optional argument.

[ou=<object container>] If the computer account must be created in a different OU, this argument
specifies the Object Container .
For example 'ou=Domain Computer' OR 'ou=Domain Computer+Linux Hosts'.
Note the usage of the separator '+' to specify the OU hierarchy.

Table 2: AD Netjoin Command Parameters

Example
The following example joins the host to the domain:

[appadmin]# ad netjoin DC01.atlas.org.arubanetworks.com

ad netleave
Use the ad netleave command to remove the host from the domain.

Syntax
ad netleave <domain NetBIOS name> [-f]

Flag/Parameter Description

<domain NetBIOS name> Specifies the host to be joined to the domain. This field is mandatory.

-f Forces the removal of Active Directory domain membership even if the operation
fails.

Table 3: AD Netleave Command Parameters

Example
The following example removes the host from the domain:

[appadmin]# ad netleave balsamcollege.edu -f

ad passwd-server

Use the ad passwd-server command to do the following tasks:

n Set the Active Directory password servers.

n List the configured Active Directory password servers.

n Reset the Active Directory password servers.
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When an Active Directory password server is updated in the domain server configuration, the RADIUS service
is restarted.

Syntax
ad passwd-server <server> <list> <reset>

Flag/Parameter Description

set
n -n <domain NetBIOS name>
n -s <Server1> [Server2 Server3 Server4

...]

Sets the password servers.
The -n parameter specifies the domain name.
The -s parameter specifies one or more password server names.

list -n <domain NetBIOS name> Lists the configured password servers.

reset -n <domain NetBIOS name> Resets the password servers.

Table 4: AD passwd-server Command Parameters

Example
The following example sets the configured password servers:

[appadmin]# ad passwd-server set -n balsamcollege.edu -s cppm.campus1

ad testjoin
Use the ad testjoin command to test if the ad netjoin command succeeded. This command also tests
whether Policy Manager is a member of the Active Directory domain.

Syntax
ad testjoin <domain NetBIOS name>

Flag/Parameter Description

<domain NetBIOS name> Specifies the host to be joined to the domain. This field is mandatory.

Table 5: AD Netjoin Command Parameter

Example
The following example tests if the ad testjoin command succeeded:

[appadmin]# ad testjoin balsamcollege.edu

alias
Use the alias command to create or remove aliases.

Syntax
alias <name>=<command>

The following table describes the parameters for the alias command:
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Flag/Parameter Description

<name>=<command> Sets <name> as the alias for <command>.

<name>= Removes the association.

Table 6: Alias Command Parameters

Example 1

This example set the alias "sh" for the show command:

[appadmin]# alias sh=show

Example 2

This example removes the alias "sh":

[appadmin]# alias sh=

backup
Use the backup command to create a backup of Policy Manager configuration data. If no arguments are
entered, the system automatically generates a filename and backs up the configuration to this file.

Syntax
backup [-f <filename>] [-c] [-l] [-r] [-w] [-P]

The following table describes the parameters for the backup command:

Flag/Parameter Description

[-f <filename>] Specifies the backup target. If not specified, Policy Manager automatically
generates a filename. This field is optional.

-c Backs up ClearPass Policy Manager configuration data.

-l Backs up ClearPass Policy Manager session log data.

-r Backs up Insight data.

-P Does not backup password fields from the configuration database. This field is
optional.

-w Backs up only the most recent records from the log database (the last one week).

Table 7: Backup Command Parameters

Example
[appadmin]# backup -f PolicyManager-data.tar.gz
Continue? [y|Y]: y
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dump certchain
Use the dump certchain command to remove the certificate chain of any SSL-secured server.

Syntax
dump certchain <hostname:port-number>

The following table describes the parameter for the dump certchain command:

Flag/Parameter Description

<hostname:port-number> Specifies the hostname and SSL port number.

Table 8: Dump Certchain Command Parameter

Example 1

The following example dumps the certificate chain of an SSL-secured server:

[appadmin]# dump certchain ldap.acme.com:636

dump logs
Use the dump logs command to remove Policy Manager application log files.

Syntax
dump logs -f <output-file-name> [-s yyyy-mm-dd] [-e yyyy-mm-dd] [-n <days>] [-t <log-type>] [-
h]

The following table describes the parameters for the dump logs command:

Flag/Parameter Description

-f <output-file-name> Specifies the target for concatenated logs.

-s yyyy-mm-dd Specifies the start date range. The default value is today's date. This field is optional.

-e yyyy-mm-dd Specifies the end date range. The default value is today's date. This field is optional.

-n <days> Specifies the duration in days (from today). This field is optional.

-t <log-type> Specifies the type of log to collect. This field is optional.

-h Specifies the print help for available log types.

Table 9: Dump Logs Command Parameters

Example 1
The following example dumps Policy Manager application log files:

[appadmin]# dump logs –f tips-system-logs.tgz -s 2007-10-06 –e 2007-10-17 –t SystemLogs

Example 2
The following example prints help for the available log types:

[appadmin]# dump logs -h
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dump servercert
Use the dump servercert command to remove the server certificate of an SSL-secured server.

Syntax
dump servercert <hostname:port-number>

The following table describes the parameter for the dump servercert command:

Flag/Parameter Description

<hostname:port-number> Specifies the hostname and SSL port number.

Table 10: Dump Servercert Command Parameter

Example
The following example removes the server certificate of the specified SSL-secured server:

[appadmin]# dump servercert ldap.acme.com:636

exit
Use the exit command to exit the shell.

Syntax
exit

Example
The following example exits the shell:

[appadmin]# exit

help
Use the help command to display the list of supported commands:

Syntax
help <command>

Example
The following example displays the list of supported commands:

[appadmin]# help
help
alias Create aliases
backup Backup Policy Manager data
cluster Policy Manager cluster related commands
configure Configure the system parameters
dump Dump Policy Manager information
exit Exit the shell
help Display the list of supported commands
netjoin Join host to the domain
netleave Remove host from the domain
network Network troubleshooting commands
quit Exit the shell
restore Restore Policy Manager database
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service Control Policy Manager services
show Show configuration details
system System commands

krb auth
User the krb auth command to perform a Kerberos authentication against a Kerberos server (such as
Microsoft Active Directory).

Syntax
krb auth <user@domain>

The following table describes the parameter for the krb auth command:

Flag/Parameter Description

<user@domain> Specifies the username and domain.

Table 11: Kerberos Authentication Command Parameter

Example
The following example performs a kerberos authentication against a kerberos server:

[appadmin]# krb auth mike@corp-ad.acme.com

krb list
Use the krb list command to list the cached Kerberos tickets.

Syntax
krb list

Example
The following example lists the cached Kerberos tickets:

[appadmin]# krb list

ldapsearch
Use the Linux ldapsearch command to find objects in an LDAP directory. Note that only the Policy Manager-
specific command line arguments are listed. For other command line arguments, refer to ldapsearch man
pages on the Internet.

Syntax
ldapsearch -B <user@hostname>

The following table describes the parameters for the ldapsearch command:

Flag/Parameter Description

-B Finds the bind DN (Distinguished Name) of the LDAP directory.

<user@hostname> Specifies the username and the full qualified domain name of the host.

Table 12: LDAP Search Command Parameter
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Example
The following example finds objects in an LDAP directory:

[appadmin]# ldapsearch -B admin@corp-ad.acme.com

quit
Use the quit command to exit the shell.

Syntax
quit

Example
The following command quits the shell:

[appadmin]# quit

restore
Use the restore command to restore Policy Manager configuration data from the backup file.

Syntax 1
restore user@hostname:/<backup-filename> [-l] [-i] [-b] [-c] [-r] [-n|-N] [-s]

Syntax 2
restore http://hostname/<backup-filename>[-l] [-i] [-b] [-c] [-e] [-n|-N] [-s]

Syntax 3
restore <backup-filename>[-l] [-i] [-b] [-c] [-e] [-n|-N] [-s]

The following table describes the parameters for the restore command:

Flag/Parameter Description

n user@hostname:/<backup-
filename>

n http://hostname/<backup-
filename>

n <backup-filename>

Specifies the filepath of the the restore source.

-b Does not backup the current configuration data before the restore operation
starts.

-c Restores ClearPass Policy Manager configuration data.

-l If it exists in the backup file, restores the ClearPass Policy Manager log database.
This field is optional.

-i Ignores version mismatch errors and attempts data migration. This field is
optional.

Table 13: Restore Command Parameters
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Flag/Parameter Description

-n Retains local node configuration data, such as certificates, after the restore
operation (default).

-N Does not retain local node configuration data after the restore operation.

-r Restores Insight data if it exists in the backup.

-s Restores cluster server/node entries from the backup file. Node entries are in a
disabled state upon restore. This field is optional.

Example
The following example restores Policy Manager configuration data from the backup file:

[appadmin]# restore user@hostname:/tmp/cppm1-backup.tgz -l -i -c -s

Service Commands
The Policy Manager CLI includes the following service <action> commands:

n service list

n service restart

n service start

n service status

n service stop

service <action> <service-name>
Use the service <action> <service-name> command to control the specified Policy Manager service.

Syntax
service <action> <service-name>
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Service Parameter Description

action 1. Choose an action:
l list
l restart
l start
l status
l stop

service-name 2. Choose a service:
l airgroup-notify
l cpass-admin-server
l cpass-async-netd
l cpass-carbon-server
l cpass-dbcn-server
l cpass-dbwrite-server
l cpass-domain-server_<NetBIOS_name>
l cpass-igssyslog-server
l cpass-igslogger-server
l cpass-igslogrepo-server
l cpass-ipsec-service
l cpass-multi-master-cache-server
l cpass-policy-server
l cpass-radius-server
l cpass-radsec
l cpass-repl-server
l cpass-statsd-server
l cpass-sysmon-server
l cpass-system-auxiliary-server
l cpass-tacacs-server
l cpass-vip
l fias_server

Table 1: Service Action Command Parameters

Example
[appadmin]# service list all
Policy server [ cpass-policy-server ]
Admin UI service [ cpass-admin-server ]
System auxiliary services [ cpass-system-auxiliary-server ]
Radius server [ cpass-radius-server ]
RadSec server [ cpass-radsec ]

Tacacs server [ cpass-tacacs-server ]
Async DB write service [ cpass-dbwrite-server ]
DB change notification server [ cpass-dbcn-server ]
DB replication service [ cpass-repl-server ]

System monitor service [ cpass-sysmon-server ]
Async network services [ cpass-async-netd ]
Multi-master cache [ cpass-multi-master-cache-server ]
Virtual IP service [ cpass-vip ]
Stats collection service [ cpass-statsd-server ]

Stats aggregation service [ cpass-carbon-server ]
ClearPass IPsec service [ cpass-ipsec-service ]
AirGroup notification service [ airgroup-notify ]
Micros Fidelio FIAS [ fias_server ]
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Ingress logger service [ cpass-igslogger-server ]
Ingress syslog service [ cpass-igssyslog-server ]

Show Commands
The Policy Manager command line interface includes the following show commands:

n show all-timezones

n show date

n show dns

n show domain

n show fipsmode

n show fipsmode

n show hostname

n show ip

n show license

n show ntp

n show sysinfo

n show timezone

n show version

show all-timezones
Use the show all-timezones command to view all available time zones.

Syntax
show all-timezones

Example
The following displays an example of the show all-timezones command output:

[appadmin]# show all-timezones
America/Aruba
America/Barbados
America/Belem
America/Belize
[More]

show date
Use the show date command to view the system date, time, and time zone information.

Syntax
show date

Example
The following displays an example of the show date command output:

[appadmin]# show date

Wed Feb 27 13:30039 UTC 2018
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show dns
Use the show dns command to view DNS (Domain Name System) servers.

Syntax
show dns

Example
The following example of show dns command output displays the DNS servers configured for the current
ClearPass server:

[appadmin]# show dns
===========================================
DNS Information
-------------------------------------------
Primary DNS : 192.xxx.5.3
Secondary DNS : <not configured>

Tertiary DNS : <not configured>

===========================================

show domain
Use the show domain command to view the Active Directory Domain controller information.

The show domain command is operational only when the current ClearPass server is joined to an Active Directory
domain.

Syntax
show domain

Example
The following displays an example of the show domain command output:

[appadmin]# show domain

=======================================================

Domain Information

-------------------------------------------------------

Domain Name : COLLEGE152.COM
Domain NETBIOS Name : COLLEGE152
Domain Server IP Address : 10.xx.110

Domain Server Name : balsam.college152.com
Domain Status : online

-------------------------------------------------------

=======================================================
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show fipsmode
Use the show fipsmode command to find whether FIPS (Federal Information Processing Standard) mode is
enabled or disabled.

Example
The following example shows that FIPS mode is enabled:

[appadmin]# show fipsmode
FIPS Mode: Enabled

show hostname
Use the show hostname command to view the hostname of the current ClearPass server.

Syntax

show hostname

Example
The following displays an example of the show hostname command:

[appadmin]# show hostname

cppm.chicago.1

show ip
Use the show ip command to view the IPv4, IPv6, and DNS information of the host.

Syntax
show ip

Example
The following example of the show ip command displays the IPv4, IPv6, and DNS information of the host:

[appadmin]# show ip
===========================================
Device Type : Management Port
-------------------------------------------
IPv4 Address : 10.2.xx.86

Subnet Mask : 255.255.255.0
Gateway : 10.2.xx.1
IPv6 Address : 2607:f0d0:1002:0011:0000:0000:0000:0002
Subnet Mask : ffff:ffff:ffff:ffff:0000:0000:0000:0000
Gateway : 2607:f0d0:1002:0011:0000:0000:0000:0001
Hardware Address : 00:0C:29:70:27:40
MTU : 1499
===========================================
Device Type : Data Port
-------------------------------------------
IPv4 Address : <not configured>
Subnet Mask : <not configured>
Gateway : <not configured>
IPv6 Address : fe80:0000:0000:0000:020c:29ff:fe70:274a
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Subnet Mask : ffff:ffff:ffff:ffff:0000:0000:0000:0000
Gateway : fe80:0000:0000:0000:020c:29ff:fe70:2741
Hardware Address : 00:0C:29:70:27:4A
MTU : 1498
===========================================
DNS Information
-------------------------------------------
Primary DNS : 10.2.xx.30

Secondary DNS : 10.1.xx.50

Tertiary DNS : 10.1.xx.200

===========================================

show license
Use the show license command to view the Policy Manager license information.

Syntax
show license

Example
The following displays an example of the show license command output:

[appadmin]# show license
-------------------------------------------------------
Application : ClearPass Platform
License key : YFKV-MW62AB-Y2PZ-B7GNJX-06T4NB-WLSV-RTQUPQ-WODIFNJI-CD7N-5UR73Q
License key type : Permanent
License added on : 2018-01-24 10:15:38
Validity : <not applicable>
Customer ID : SWCKTYM7
Licensed features : <not applicable>

-------------------------------------------------------

show ntp
Use the show ntp command to view the IP addresses of the primary and secondary Network Time Protocol
(NTP) servers configured for the current ClearPass server.

The show ntp command also displays information such as the NTP authentication key details corresponding
to the NTP server configured (for example, Key ID and hash algorithm).

Syntax
show ntp

Example
The following displays an example of the show ntp command output:
[appadmin]# show ntp
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===========================================

NTP Server Information
-------------------------------------------
Primary NTP : 10.xx.x.1
Key ID: 24
Algorithm: SHA1

Secondary NTP : 10.x.x.2
Key ID: 48
Algorithm: SHA1

===========================================

show sysinfo
Use the show sysinfo command to view the node uptime, disk utilization, and memory utilization
information:

Syntax
show sysinfo

Example
The following displays an example of the show sysinfo command output:

[appadmin]# show sysinfo
System Uptime : 1 day, 23:29:15.510000
===========================================
Disk Utilization
-------------------------------------------
Total : 115.48 GB
Free : 5.42 GB (6%)
===========================================
Memory Utilization
-------------------------------------------
Total : 4.00 GB
Free : 1.36 GB (36%)
===========================================

show timezone
Use the show timezone command to view the current system time zone.

Syntax
show timezone

Example
The following displays an example of the show timezone command output:

[appadmin]# show timezone

Timezone is set to 'Asia/Kolkata'

show version
Use the show version command to view the Policy Manager software version and the hardware model.
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Syntax
show version

Example
The following displays an example of the show version command output:
[appadmin]# show version
=======================================
Policy Manager software version : 6.7.1.103378

Policy Manager model number : C1000V
=======================================

SSH Timed Account Lockout

This section provides the following information:

n Introduction

n SSH Account Lockout Configuration

n SSH Account Lockout Alerts

n SSH Account Lockout Behavior

Introduction
The SSH Timed Account Lockout feature provides an administrator with the ability to configure the number
of successive unsuccessful authentication attempts for administrators attempting to authenticate remotely.

When the defined number of unsuccessful authentication attempts has occurred, the CLI account is locked and
administrators cannot log in to the system via the CLI until one of the following conditions are met:

n Prevent the offending remote administrator from successfully authenticating until an action is taken by a
local administrator.

n Prevent the offending remote administrator from successfully authenticating until time period defined by
the administrator has elapsed.

Node-Specific
This feature is node-specific. In a cluster with multiple nodes, SSH timed account lockout must be configured
on each node in the cluster.

The cluster reset-database command does not impact this feature.

Account Lockout Persistence
l The SSH timed account lockout feature configuration persists across reboots, updates and upgrades.

l The account lock status persists across reboots.
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SSH Account Lockout Configuration
The SSH Timed Lockout options are exposed as a part of the ssh command set.

Figure 896 SSH Command Set

SSH Lockout
The ssh lockout command set provides ability to configure SSH lockout configuration options. This command
exposes three options :

n count

n duration

n reset

Figure 897 SSH Lockout Command Set

SSH Lockout Count
Sets the maximum number of failed login attempts before the account is locked out. The default is 5.

Figure 898 SSH Lockout Count Command

Syntax
ssh lockout count <N>

Example
ssh lockout count 3
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SSH Lockout Duration

Sets the amount of time in minutes that the account will remain locked after the number of SSH password
login attempts exceeds the SSH lockout count.

Figure 899 SSH Lockout Duration Command

Syntax

ssh lockout duration <N minutes>

Example

ssh lockout duration 3

SSH Lockout Reset
Resets the SSH lockout count and duration to factory defaults and disables this feature.

The SSH timed account lockout feature is disabled by default.

Figure 900 SSH Lockout Reset Command

SSH Unlock
Unlocks any SSH locked accounts.

When the account is locked, you can perform this operation by logging into the system via the console or from
a host that is enabled for SSH public key authentication with ClearPass.

Figure 901 SSH Unlock Command
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Show SSH
Shows the SSH lockout configuration settings and the active SSH client sessions.

Figure 902 Show SSH Command

SSH Account Lockout Alerts

Alerts for SSH lockout events are logged in to the Event Viewer when any of the following conditions are
present:

l SSH lockout configurations are performed

l Account is locked

l Account is unlocked

l Failed SSH login attempts

SSH Account Lockout Behavior
The SSH account lockout feature is disabled by default.

1. To enable SSH account lockout:

l Perform the ssh lockout count or ssh lockout duration configuration options.

2. To disable the feature, perform ssh lockout reset.

3. If the SSH account lockout feature is configured with failed attempts=3 and unlock time = 5 minutes:
l CLI access via SSH (password-based) authentication is locked on three consecutive failed login attempts.

l If the failed password attempt continues (even after the account is locked), the unlock time shifts for the
next five minutes (as in this example) from the current time from the last failed login attempt.

l Successful password-based SSH logins are rejected during the lockout period.

l Console-based logins are allowed during the lockout period.

l SSH logins via public key methods are allowed during the lockout period.

4. Administrators can use any of the above options to reset the SSH account lockout by issuing the ssh
unlock command.

5. After the lockout period, successful SSH logins are accepted and the account is unlocked.
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System Commands
The ClearPass Policy Manager command line interface (CLI) includes the following system commands:

n system apps-access-reset

n system boot-image

n system cleanup

n system create-api-client

n system factory-reset

n system install-image

n system morph-vm

n system patch-rollback

n system refresh-license

n system reset-server-certificate

n system restart

n system shutdown

n system sso-reset

n system start-rasession

n system status-rasession

n system terminate-rasession

n system update

n system upgrade

system apps-access-reset
Use the system apps-access-reset command to reset the access control restrictions for Policy Manager.

Syntax
system apps-access-reset

Example
The following example resets the access control restrictions for Policy Manager:
[appadmin]# system apps-access-reset
Policy Manager application access is restored

system boot-image
Use the system boot-image command to set system boot image control options.

Syntax
system boot-image [-l] [-a <version>]

The following table describes the required and optional parameters for the system boot-image command:
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Flag/Parameter Description

-l Lists the boot images installed on the system.

-a <version> Sets the active boot image version in A.B.C.D syntax. This field is optional.

Table 1: Boot-Image Command Parameters

Example
The following example sets the system boot image control options:
[appadmin]# system boot-image -l

system cleanup
Use the system cleanup command to perform a system cleanup operation that purges the following records:

n System and application log files

n Past authentication records

n Audit records

n Expired guest accounts

n Past auto and manual backups

n Stored reports

Syntax
system cleanup <num_days

The following table describes the required parameter for the system cleanup command:

Flag/Parameter Description

<num_days> This is the cleanup interval that specifies the number of days to retain the data. This
field is mandatory.

Table 2: System Cleanup Command Parameter

Example

The following example performs a system cleanup operation that retains records for four days:
[appadmin]# system cleanup 4

********************************************************
* *
* WARNING: This command will perform system cleanup *
* operation that will result in purging of: *
* [*] system and application log files *
* [*] past authentication records *
* [*] audit records *
* [*] expired guest accounts *
* [*] past auto and manual backups *
* [*] stored reports etc... *
* *
********************************************************
Are you sure you want to continue? [y|n]: y
INFO - Starting system cleanup
INFO - Purging diagnostic dumps
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INFO - Detected empty core directory
INFO - Performing system cleanup tasks
INFO - Purging platform logs
INFO - Purging application logs
INFO - Performing database cleanup tasks
INFO - Completed system cleanup

system create-api-client
Use the system create-api-client command create a new API client.

Syntax
system create-api-client <Client_ID> <Client_Secret>

Example
The following example creates an API client and specifies the client ID and client secret:

[appadmin]#system create-api-client Win.139 college52

system factory-reset
The system factory-reset command restores a ClearPass hardware appliance to factory defaults. This
command is available only to the appadmin user.

The system factory-reset command is inherently a destructive one as it wipes out data, includingany
licenses on the current partitio and any backups currently stored on the server. Hence, the user should create
data backups outside of the target ClearPass server before running this command.

The system factory-reset command essentially consists of two operations:

n Resets all ClearPass configurations in the current partition only, including Policy Manager server settings, all
ClearPass Guest, Onboard and extensions, Active Directory domain settings, NTP settings, hostname,
network settings, and date, time, and password settings.

n Cleans and resets ClearPass logs and configuration files, including those for ClearPass Guest.

When running the system factory-reset in a ClearPass cluster:

n If the current node is a Publisher node, running this command will drop it from the cluster. The Standby
Publisher node then becomes the Publisher.

n If the current node is a Subscriber node, it will be dropped from the cluster, and will become a stand-alone
node.

After successful configuration and reboot, you will be presented with the bootstrap configuration screen,
where you will have to reset all the ClearPass parameters.

Example
The following example restores a ClearPass hardware appliance to factory defaults:

[appadmin]# system factory-reset

system install-image
The system install-image command installs a fresh image of the major product version specified in the
second partition of a ClearPass hardware appliance.

This command is available only for the appadmin user.
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The system install-image command is supported for ClearPass versions prior to 6.7 as well as versions 6.7 and
above.

After successful execution of the system install-image command, the system will reboot and you will return
to the installed image.

After successful configuration and reboot, you will be presented with the bootstrap configuration screen,
where you will have to reset all the ClearPass parameters.

Any data present in the second partition prior to the execution of the system install-image command will be
wiped out. Also, no licensing information from where the command is executed is carried forward.

You can apply the system install-image command in the following ways:

System install-image Method Description

system install-image http(s)://hostname/<filename> Installs the ClearPass image through http or https.

system install-image user@hostname:/<filename> Installs the image through SCP (Secure Copy Protocol).

system install-image <filename> Installs the image imported to the ClearPass server
and available locally (offline install-image).

Table 3: System Install-Image Command Methods

Example

[appadmin]# system install-image CPPM-x86_64-6.X.Y.Z-<any-image>.signed.tar

n X.Y.Z stands for a specific patch release version.

n <any-image> stands for the description of the patch.

n signed.tar is common nomenclature for all types of updates.

system morph-vm
Use the system morph-vm command to convert an evaluation virtual machine (VM) to a production virtual
machine .

With this command, licenses are still required to be installed after the morph operation is completed.

To convert an evaluation virtual machine to a production virtual machine:

1. Determine the type of the appliance to which you want to morph your evaluation virtual machine .

2. Procure the license for the target virtual appliance.

3. Shut down the virtual machine.

4. Determine the required capacity of an additional hard disk and attach it to the target virtual appliance.

5. Adjust the CPU and Memory settings for the evaluation virtual machine to match the target virtual
appliance.

6. Boot the virtual machine.

7. Execute the system morph-vm command.

The configuration data from the evaluation virtual machine will migrate to the newly-attached disk. The
node will reboot as a virtual machine of the selected appliance model.

8. Log in to the user interface and enter the permanent license.

The evaluation virtual machine is now a production virtual machine.
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Syntax
system morph-vm <C1000V | C2000V | C3000V>

The following table describes the parameters for the system morph-vm command:

Flag/Parameter Description

<vm-version> This is the updated ClearPass version of the virtual appliances. The following options
are available:
n C1000V
n C2000V
n C3000V
This field is mandatory.

Table 4: System Morph-VM Command

Example
The following example converts an evaluation virtual machine to a production C3000V virtual appliance:

[appadmin]# system morph-vm C3000V

system patch-rollback
The system patch-rollback command allows a user with appadmin credentials to revert to the most recent
ClearPass installed version. For example, if a ClearPass system is at 6.7.1 and cumulative update 6.7.x is
applied, ClearPass can be reverted to 6.7.1 through the system patch-rollback command.

This command can also be used if there is a problem after the patch update process—for example, if an issue is
identified in production that was not identified during testing, resulting in a degradation of capabilities.

Before using this command to revert from 6.7.1 to 6.7.0, you must first download the 6.7.0_source-rollback-package
from the Software Updates page and install it (see Software Updates).

Important Points
When issuing the system patch-rollback command, keep in mind the following points:

n Patch rollback is supported only for ClearPass versions 6.7 and above.

n The system patch-rollback command reverts only the most recently installed cumulative patch update
within the major version. After the cumulative patch is reverted, the user will be in the patch version that
was installed prior to the patch update.

The system patch-rollback command cannot be used after an upgrade to revert to an earlier major version (for
example, ClearPass 6.6.X).

n Although you can only roll back to the last version that was installed, if multiple hotfix patches are included
within the cumulative patch version you are rolling back from, then you can roll back multiple hotfix
patches, one at a time, to a specific hotfix within the current version. To roll back to the previously installed
version, you must first roll back each intervening hotfix patch.

n As best practice, users should always back up all data before proceeding with an update.

n This command can also be used at the cluster level. In this case, system patch-rollback must be run
individually on each appliance in the cluster within 24 hours after the rollback in order to maintain the
cluster status.

n Any custom skins that are installed in the current version are retained after the rollback to the earlier
version.
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n System rollback events are logged in the Event Viewer.

Syntax
system patch-rollback

Example
[appadmin]# system patch-rollback
****************************************************************************************
* WARNING: This command is recommended to be executed from local console unless otherwise instructed by TAC *
Execution through SSH console may result in system instability.
*
* WARNING: This command will undo software changes done by the currently installed patch. Configuration

*changes should not be affected by this action.

* As a best practice, please be sure to back-up this system before starting the operation.
*
* Are you sure you want to continue? y
*******************************************************************************************
INFO: Preparing for rollback
INFO: 2018022-clearpass-6.7-updates-2 will be rolled back
INFO: This will take a few minutes to complete. Please wait.
INFO: Running pre-rollback scripts
INFO: Executing rollback
INFO: Running post-rollback scripts
INFO: Please reboot now for the changes to take effect.
*******************************************************************************************

For example, if ClearPass has been installed in the order 6.7.0 > 6.7.1 > 6.7.2, when the appadmin user
executes the system patch-rollback command, the system will revert to a time just before ClearPass 6.7.2
was installed.

If, in this example, the installed 6.7.2 patch added an rpm-X, system patch-rollback deletes rpm-Y, and
updates rpm-Z to rpm-Z+1 version. Then system patch-rollback deletes rpm-X, adds rpm-Y, and restores
rpm-Z.

The system patch-rollback command also removes any configuration and database changes that were done as
part of post-installation during the patch update.

The system patch-rollback command can also be used at the cluster level, but this command must be run
individually on all cluster nodes. For patch rollback across a cluster, the appadmin user must go to each
ClearPass server in the cluster to rollback the last applied patch.

system refresh-license
Use the system refresh-license command to refresh the license count information.

Syntax
system refresh-license

Example
The following example refreshes the license count information:

[appadmin]# system refresh-license
INFO: Refreshing license count information
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INFO: Successfully refreshed license count information

system reset-server-certificate
Use the system reset-server-certificate command to reset the HTTP server certificate or RADIUS/EAP
server certificate or both.

After executing the command, the Policy Manager services are restarted to reflect the changes.

Syntax
system reset-server-certificate

Example
The following example resets the HTTP, RADIUS/EAP, and RadSec server certificates:

[appadmin]# system reset-server-certificate

******************************************************************
* *
* WARNING: When the command is completed Policy Manager services *
* are restarted to reflect the changes. *
* *
******************************************************************
Continue? [y|n]: y
0: Reset Http and Radius/EAP Server Certificates
1: Reset Radius/EAP Server Certificate
2: Reset Http Server Certificate
3: Reset RadSec Server Certificate
4: Quit
Updating the server certificate...
Updating of server certificate complete

system restart
Use the system restart command to restart the system.

Executing this command shuts down all running applications and reboots the system.

Syntax
system restart

Example
The following example restarts the system with a confirmation before proceeding:

[appadmin]# system restart
system restart
*********************************************************
* WARNING: This command will shut down all applications *

* and reboot the system *
********************************************************
Are you sure you want to continue? [y|Y]: y
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system shutdown
Use the system shutdown command to shut down the current ClearPass server.

Executing this command shuts down all running applications and powers off the system.

Syntax
[appadmin]# system shutdown

Example
The following example shuts down the system with a confirmation before proceeding:

[appadmin]# system shutdown
********************************************************
* WARNING: This command will shut down all applications *

* and power off the system *
********************************************************
Are you sure you want to continue? [y|Y]: y

system sso-reset
Use the system sso-reset command to reset the Single Sign-On (SSO) configuration.

Syntax
system sso-reset

system start-rasession
Use the system start-rasession command to start a Remote Assistance (RA) session.

Syntax
system start-rasession [duration_hours | duration_mins | contact_id | cppm_server_ip]

The following table describes the parameters for the system start-rasession command:

Parameter Action/Description

duration_hours Specify the session duration in hours.
You can specify values from 0 to 12.

duration_mins Specify the session duration in minutes.
You can specify values from 0 to 59.

contact_id Enter the username ID part of the Aruba TAC or Engineering contact.

cppm_server_ip Specify the ClearPass Policy Manager server IP address.

Table 5: System Start Remote Assistance Session Command Parameters
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system status-rasession
Use the system status-rasession command to view the status of a Remote Assistance session.

Syntax
system status-rasession <session_id>

Example
The following example displays the status of a Remote Assistance session 3001:

[appadmin]# system status-rasession 3001

system terminate-rasession
Use the system terminate-rasession command to terminate a running Remote Assistance session.

Syntax
system terminate-rasession <session_id>

Example
The following example terminates a running RemoteAssist session 3001:

[appadmin]# system terminate-rasession 3001

system update
The system update command provides options to manage system patch updates.

Syntax
system update [-i [-f] <user@hostname:/<filename> | http://hostname/<filename>>]

system update [-f]

system update [-l]

The following table describes the required and optional parameters for the system update command:

Flag/Parameter Description

-i user@hostname:/<filename>
| http://hostname/<filename>

Installs the specified patch on the system. This field is optional.

-f Reinstalls the patch in the event of a problem with the initial installation attempt.
This field is optional.

-l Lists the patches installed on the system. This field is optional.

Table 6: System Update Command Parameters

This command supports Secure Copy (SCP), HTTPS, HTTP, and local uploads.
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Example
The following example of the system update command will reinstall the patch if necessary and list the patches
currently installed on the ClearPass server:

[appadmin]# system update -f -l

system upgrade
The system upgrade command upgrades the system. This command provides you with the following system
upgrade options:

n From a Linux server

n From a Web server

n Performing an offline upgrade

Syntax
system upgrade <session_id>

Syntax
n Upgrading from a Linux server

system upgrade user@hostname:/<filepath> [-w] [-l] [-L]

See Example 1: Upgrading from a Linux Server.

n Upgrading from a Web server
system upgrade http://hostname/<filepath> [-w] [-l] [-L]

See Example 2: Upgrading from a Web Server.

n Performing an offline upgrade
system upgrade <filepath> [-w] [-l] [-L]

See Example 3: Performing an Offline Upgrade.

Flag/Parameter Description

-w Restores last (one) week of access tracker records after the upgrade.

-l Restores all access tracker records from this version.

-L Does not backup or restore access tracker records from this version.

<filepath> Enter the filepath using the syntax provided in the two examples below. This field is
mandatory.

Table 7: System Upgrade Command Parameters

This command supports Secure Copy (SCP), HTTPS, HTTP, and local uploads.

If none of these system upgrade command options are specified, Access Tracker records are backed up, but they
are not restored by default.

Example 1: Upgrading from a Linux Server
To upgrade the Policy Manager image from a Linux server:

1. Upload the upgrade image to a Linux server.
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2. Use the following syntax to upload the upgrade image:
system upgrade user@hostname:/<filepath> [-w] [-l] [-L]

For example:

[appadmin]# system upgrade admin@sun.us.arubanetworks

Example 2: Upgrading from a Web Server
To upgrade the Policy Manager image from a Web server:

1. Upload the upgrade image to a Web server.

2. Use the following syntax to upload the upgrade image:
system upgrade http://hostname/<filepath> [-w] [-l] [-L]

For example:

[appadmin]# system upgrade http://sun.us.arubanetworks.com/downloads/PolicyManager-x86-64-

upgrade-71.tgz

Example 3: Performing an Offline Upgrade
To perform an offline upgrade:

1. Log in to the Aruba Support Center and select the Download Software tab.

2. Navigate to the ClearPass > Policy Manager > Current Release folder > Upgrade folder.

The Upgrade page opens.

3. In the Description/Remarks section, click the link for the appropriate upgrade.

The upgrade file is uploaded to your local system.

4. Navigate to the ClearPass Policy Manager Software Updates page at Administration > Agents and
Software Updates > Software Updates.

5. In the Firmware & Patch Updates section of the Software Updates page, click the Import Updates
button.

The Import from File dialog opens.

6. Browse to the location of the upgrade file on your system, then click Import.

The selected upgrade file is uploaded to the ClearPass Policy Manager.

7. Log in to the Policy Manager command line interface (CLI) with the following user name: appadmin.

8. Initiate the upgrade process by entering the following command:
system upgrade <filepath> [-w] [-l] [-L]

For example:

[appadmin]# system upgrade CPPM-upgradeimage.bin

9. After the upgrade process is complete, restart the machine by issuing the following command in the CLI:
system restart

The Policy Manager restarts and boots up to the most recent version of ClearPass Policy Manager.
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Appendix B

SNMP, System Events & Error
Codes

This appendix contains the following information:

n ClearPass SNMP Private MIB

n SNMP Trap Details

n Important System Events

n Error Codes

ClearPass SNMP Private MIB
This section contains the following information:

n Introduction

n System MIB Entries

n RADIUS Server MIB Entries

n Policy Server MIB Entries

n Web Authentication Server MIB Entries

n TACACS+ Server MIB Entries

n Network Traffic MIB Entries

Introduction
A MIB (Management Information Base) is a collection of definitions that define the properties of the managed
object within the device to be managed. The various pieces of information are accessed by a protocol such as
SNMP.

This section describes the MIB objects exposed and traps sent through the ClearPass Policy Manager Private
SNMP MIB.

System MIB Entries
Table 1 describes the CPPMSystemTableEntry MIB objects.

MIB Object Description

cppmClusterNodeType ClearPass cluster node type indicating whether the node is a Publisher or
Subscriber

cppmNwDataPortIPAddress ClearPass server data port IP address

cppmNwDataPortMACAddress ClearPass server data port MAC address

cppmNwMgmtPortIPAddress ClearPass server management port IP address

cppmNwMgmtPortMACAddress ClearPass server management port MAC address

Table 1: CPPMSystemTableEntry System MIB Objects
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MIB Object Description

cppmSystemDiskSpaceFree Amount of disk space free (in bytes) in the ClearPass server

cppmSystemDiskSpaceTotal Total amount of disk space available (in bytes) in the ClearPass server

cppmSystemHostname ClearPass server host name

cppmSystemMemoryFree Amount of memory free (in bytes) in the ClearPass server

cppmSystemMemoryTotal Total amount of memory available (in bytes) in the ClearPass server

cppmSystemModel Model of the ClearPass server

cppmSystemNumCPUs Total number of CPUs in the ClearPass server

cppmSystemSerialNumber Serial number of the ClearPass server

cppmSystemUptime Amount of time the ClearPass server has been up

cppmSystemVersion Product version of the ClearPass server

RADIUS Server MIB Entries

RadiusServerTableEntry
Table 2 describes the RadiusServerTableEntry objects.

MIB Object Description

radAuthRequestTime Total time taken for an end-to-end RADIUS request

radPolicyEvalTime Time taken for policy evaluation from the RADIUS server perspective

radServerCounterCounts Total number of successful RADIUS authentications

radServerCounterFailure Total number of failed RADIUS authentications

radServerCounterSuccess Total number of successful RADIUS authentications

Table 2: RadiusServerTableEntry Objects
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RadiusServerAuthTableEntry
RadiusServerAuthTableEntry exposes the following counters that refer to authSourceName wherever
applicable (see Table 3). Counters and delays reflect details that are logged into Graphite.

MIB Object Description

radAuthCounterCount Total number of RADIUS authentications

radAuthCounterFailure Total number of failed RADIUS authentications

radAuthCounterSuccess Total number of successful RADIUS authentications

radAuthCounterTime Time taken to perform RADIUS authentications

radAuthSourceName Name of the RADIUS server authentication source

Table 3: RadiusServerAuthEntry MIB MIB Objects

Policy Server MIB Entries

PolicyServerTableEntry
PolicyServerTableEntry exposes the following MIB objects (see Table 4). Counters and delays reflect details
logged into Graphite.

MIB Object Description

psAuditPolicyEvalCount Audit policy evaluation count

psAuditPolicyEvalTime Audit policy evaluation time

psAuthCounterFailure Number of failed Policy Server authentications

psAuthCounterSuccess Number of successful Policy Server authentications

psAuthCounterTotal Total number of Policy Server authentications

psEnforcementPolicyEvalCount Enforcement policy evaluation count

psEnforcementPolicyEvalTime Enforcement policy evaluation time

psPosturePolicyEvalCount Posture policy evaluation count

psRestrictionPolicyEvalCount Authorization restriction policy evaluation count

psRolemappingPolicyEvalCount Role mapping policy evaluation count

psRolemappingPolicyEvalTime Role mapping policy evaluation time

Table 4: PolicyServerTableEntry Objects
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MIB Object Description

psPosturePolicyEvalTime Posture policy evaluation time

psRestrictionPolicyEvalTime Restriction policy evaluation time

psServicePolicyEvalCount Service policy evaluation count

psServicePolicyEvalTime Service policy evaluation time

psSessionlogTime Policy Server session logging time

dailySuccessAuthCount Total daily number of successful authentications

dailyFailedAuthCount Total daily number of failed authentications

dailyTotalAuthCount Total daily number of authentications

PolicyServerProtoTableEntry
PolicyServerProtoTableEntry exposes MIB objects for the counter values for the RADIUS, TACACS, WEBAUTH,
and APPLICATION protocols.

MIB Object Description

psPolicyEvalTime Policy evaluation time for the protocol

psProtocolName Name of the protocol

Table 5: PolicyServerProtoTableEntry MIB Objects

PolicyServerAutzTableEntry
PolicyServerAutzTableEntry exposes MIB objects for authorization counters (see Table 6).

MIB Object Description

psAutzCounterCount Total number of Policy Server authorizations

psAutzCounterFailure Number of failed Policy Server authorizations

psAutzCounterSuccess Number of successful Policy Server authorizations

psAutzCounterTime Time taken to perform Policy Server authorizations

psAutzAuthSourceName Name of the Policy Server authorization source

Table 6: PolicyServerAutzTableEntry MIB Objects
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Web Authentication Server MIB Entries

WebAuthProtoTableEntry exposes MIB objects for the WebLogin, AppLogin, SamlIdp, and SamlSp web
authentication protocols.

MIB Object Description

waAuthCounterAuthTime Time taken for web authentication

waAuthCounterCount Total number of web authentications

pwaAuthCounterFailure Number of failed web authentications

waAuthCounterSuccess Number of successful web authentications

waAuthCounterTime Total time taken for web login

waPolicyEvalTime Time taken to perform policy evaluation

waProtocolName Name of the protocol

pwaServicePolicyEvalTime Time taken to perform service policy evaluation

Table 7: WebAuthProtoTableEntry MIB Objects

TACACS+ Server MIB Entries

TacacsAuthTableEntry

TacacsAuthTableEntry exposes MIB objects for TACACS+ authentication counters.

MIB Object Description

tacAuthCounterAuthTime Time taken for TACACS+ authentications

tacAuthCounterCount Total number of TACACS+ server authentications

tacAuthCounterFailure Number of failed TACACS+ server authentications

tacAuthCounterSuccess Number of successful TACACS+ server authentications

tacAuthCounterTime Total time taken for TACACS+ login

tacPolicyEvalTime Time taken to perform policy evaluation

tacServicePolicyEvalTime Time taken to perform service policy evaluation

Table 8: TacacsAuthTableEntry Objects

TacacsAutzTableEntry

TacacsAutzTableEntry exposes MIB objects for TACACS+ authorization counters.
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MIB Object Description

tacAutzCounterCount Total number of TACACS+ server authorizations

tacAutzCounterFailure Number of failed TACACS+ server authorizations

tacAutzCounterSuccess Number of successful TACACS+ server authorizations

tacAutzCounterTime Total time taken for TACACS+ authorizations

Table 9: TacacsAuthTableEntry Objects

Network Traffic MIB Entries

NetworkTrafficTableEntry exposes MIB objects for network protocol and applications. These MIB objects cover
the following:

n agent_controller (6658)

n db (5432)

n http (80)

n https (443)

n ntp (123)

n radius (1645, 1646, 1812, 1813)

n ssh (22)

n tacacs (49)

MIB Object Description

nwAppPort Application port

nwAppName Application name

nwTrafficTotal Total network traffic in bytes

Table 10: TacacsAuthTableEntry Objects

ClearPass SNMP Traps and OIDs
This section provides the following information:

n Introduction

n Hardware Monitoring OIDs

n Interface Statistics Monitoring OIDs

n Daily Authentication Statistics OIDs

n Authentication Count OIDs

n ClearPass SNMP Traps
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Introduction
This section describes the traps that ClearPass Policy Manager supports as part of the ClearPass SNMP Private
MIB (Management Information Base). OIDs (Object Identifiers) uniquely identify managed objects in a MIB
hierarchy. These OIDs are in the cppmServerInfoGroup of the cppmSystemTable of the ClearPass Management
Information Base (CPPM-MIB).

Hardware Monitoring OIDs
The hardware monitoring OIDs allow admins to monitor the fan, power, and disk status of the ClearPass C2000
and ClearPass C3000 hardware appliances using the snmpget and snmpwalk commands.

The hardware monitoring OIDs enable sending hardware traps in the event of a fan, power, or disk failure in a
hardware appliance. SNMP v1, v2, and v3 queries are supported. Traps for hardware failure are not ClearPass
enterprise-specific traps, but native traps sent by the HP agent running on the hardware appliance.

These OIDs monitor hardware and authentication status through SNMP polling only.

The hardware monitoring OIDs are not available for the ClearPass C1000 hardware appliance, nor are they available
for virtual appliances. For a ClearPass C1000 hardware appliance or a virtual appliance, these OIDs return N/A as the
value.

Trap Name OID Description

cppmHardwareDiskStatus .1.3.6.1.4.1.14823.1.6.1.1.1.1.1.22 Disk Status

cppmHardwareFanStatus 1.3.6.1.4.1.14823.1.6.1.1.1.1.1.19 Fan Status

cppmHardwarePowerStatus .1.3.6.1.4.1.14823.1.6.1.1.1.1.1.20 Power Status

cppmHardwarePowerStatusDetails .1.3.6.1.4.1.14823.1.6.1.1.1.1.1.21 Power Status Details

Table 1: Hardware Status Monitoring OIDs

ClearPassPolicy Manager obtains the underlying hardware configuration from the dmidecode (Linux) system
manufacturer property. If the vendor details are not correctly set under the system manufacturer, ClearPass
assumes that the underlying configuration does not correspond to the current HP/Aruba hardware, which
would lead to incorrect installation and set up.

Interface Statistics Monitoring OIDs
These OIDs monitor interface statistics through SNMP polling.

Trap Name OID Description

ifInOctets .1.3.6.1.2.1.2.2.1.10 Total number of octets received on the interface, including
framing characters.

ifOutOctets .1.3.6.1.2.1.2.2.1.16 Total number of octets transmitted out of the interface, including
framing characters.

ifInDiscards .1.3.6.1.2.1.2.2.1.13 Number of inbound packets that were chosen to be discarded,
even though no errors had been detected, to prevent their being
deliverable to a higher-layer protocol. One possible reason for
discarding such a packet could be to free up buffer space.

Table 2: Interface Statistics Monitoring OIDs

ClearPass 6.7 Policy Manager | User Guide SNMP, System Events & Error Codes | 940
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1972



941 | SNMP, System Events & Error Codes ClearPass 6.7 Policy Manager |  User Guide

Trap Name OID Description

ifOutDiscards .1.3.6.1.2.1.2.2.1.19 Number of outbound packets that were chosen to be discarded,
even though no errors had been detected, to prevent their being
transmitted. One possible reason for discarding such a packet
could be to free up buffer space.

ifInErrors .1.3.6.1.2.1.2.2.1.14 Number of inbound packets that contained errors, preventing
them from being deliverable to a higher-layer protocol.

ifOutErrors .1.3.6.1.2.1.2.2.1.20 Number of outbound packets that could not be transmitted
because of errors.

Daily Authentication Statistics OIDs
These OIDs monitor daily authentication statistics on ClearPass. These OIDs show the total number of
authenticationss on the ClearPass server for the given day. There are no traps associated with these OIDs.

OID Description

.1.3.6.1.4.1.14823.1.6.1.1.2.3.1.17 Daily successful authentications

.1.3.6.1.4.1.14823.1.6.1.1.2.3.1.18 Daily failed authentications

.1.3.6.1.4.1.14823.1.6.1.1.2.3.1.19 Total number of authentications

Table 3: Daily Authentication Statistics OIDs

Authentication Count OIDs
This section describes the SNMP trap OIDs in the policyServerTable of the ClearPass MIB (CPPM-MIB) that show
the total number of authentications and authorizations on the ClearPass server over the past 24 hours.

Authentication counts are calculated from 00:00:00 through 23:59:59 each day.

If polls are done several times a day, by subtracting a previous poll’s count from the latest poll’s count, the
number of authentications within a polling interval can be calculated. The authentication count traps and their
OIDs are described in the following table:

Trap Name OID Description

dailyFailedAuthCount .1.3.6.1.4.1.14823.1.6.1.1.2.3.1.18 Total daily number of failed authentications

dailySuccessAuthCount 1.3.6.1.4.1.14823.1.6.1.1.2.3.1.17 Total daily number of successful
authentications

dailyTotalAuthCount .1.3.6.1.4.1.14823.1.6.1.1.2.3.1.19 Total daily number of authentications

Table 4: Authentication Count OIDs
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ClearPass SNMP Traps
Table 5 provides the description and OID for each ClearPass SNMP trap.

Trap Name OID Description

cppmActivationExpiry .1.3.6.1.4.1.14823.1.6.1.1.200.1002 Indicates that one or more licensing activations
associated with the
<cppmNodeApplicationName> on the ClearPass
Server will expire in
<cppmActivationDaysRemaining> days

cppmClusterLicense
Usage

.1.3.6.1.4.1.14823.1.6.1.1.200.1016 Indicates the ClearPass cluster license
utilization details.
n <clearpassServerApplicationName> indicates

the name of the application.
n <clearpassClusterLicenseTotalCount>

indicates the application's total cluster-wide
license count.

n <clearpassClusterLicenseUsageCount>
indicates the count of the application's used
cluster-wide licenses.

cppmClusterNode
AddNotification

.1.3.6.1.4.1.14823.1.6.1.1.200.1006 Indicates the addition of a ClearPass node to
the cluster.
<cppmClusterServerIp> indicates the IP address
of the node added to the cluster.

cppmClusterNode
DbldNotification

.1.3.6.1.4.1.14823.1.6.1.1.200.1009 Indicates that a ClearPass node in the cluster
has been disabled.
<cppmClusterServerIp> indicates the IP address
of the disabled node.

cppmClusterNode
DelNotification

.1.3.6.1.4.1.14823.1.6.1.1.200.1007 Indicates that a ClearPass node has been
deleted from the cluster.
<cppmClusterServerIp> indicates the IP address
of the node removed from the cluster.

cppmClusterNode
NSyncNotification

.1.3.6.1.4.1.14823.1.6.1.1.200.1010 Indicates the ClearPass node in the cluster
that is in the out-of-sync state.
n <cppmClusterServerIp> indicates the IP

address of the out-of-sync node.
n <cppmClusterOutOfSyncMinutes> indicates

the number of minutes that the node has
been out-of-sync.

cppmClusterNode
PromNotification

.1.3.6.1.4.1.14823.1.6.1.1.200.1008 Indicates the promotion of a ClearPass node
to Publisher status.
<cppmClusterServerIp> indicates the IP address
of the node promoted to Publisher.

cppmClusterPwd
ChangedNotification

.1.3.6.1.4.1.14823.1.6.1.1.200.1011 Indicates that the cluster password has been
changed.

Table 5: SNMP Traps Supported by the SNMP Private MIB
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Trap Name OID Description

cppmConfigReset .1.3.6.1.4.1.14823.1.6.1.1.200.1012 Indicates that the ClearPass node's
configuration has been reset.

cppmConfigRestore .1.3.6.1.4.1.14823.1.6.1.1.200.1013 Indicates that the ClearPass node's
configuration has been restored.

cppmLicenseExpiry .1.3.6.1.4.1.14823.1.6.1.1.200.1001 Indicates that one or more licenses associated
with a ClearPass application
<cppmNodeApplicationName> on the ClearPass
server will expire in
<cppmLicenseDaysRemaining> days.

cppmLowDiskSpace .1.3.6.1.4.1.14823.1.6.1.1.200.1004 Indicates that the system is running low on
disk space as indicated by
<cppmDiskSpaceRemaining> with the units
specified in <cppmResourceUnit>.

cppmLowMemory .1.3.6.1.4.1.14823.1.6.1.1.200.1005 Indicates that the system is running low on
memory as indicated by
<cppmMemoryRemaining> with the units
specified in <cppmResourceUnit>.

cppmNodeCertExpiry .1.3.6.1.4.1.14823.1.6.1.1.200.1003 Indicates that a server certificate associated
with the <cppmNodeCertApplicationName> on
the ClearPass Server will expire in
<cppmCertDaysRemaining> days.

cppmUpdateNotification .1.3.6.1.4.1.14823.1.6.1.1.200.1014 Indicates that the CPPM node's installation has
been updated.

cppmUpgrade
Notification

.1.3.6.1.4.1.14823.1.6.1.1.200.1015 Indicates that the CPPM node's installation has
been upgraded.
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Trap Name OID Description

cppmActivationExpiry .1.3.6.1.4.1.14823.1.6.1.1.200.1002 Indicates that one or more licensing
activations associated with the
<cppmNodeApplicationName> on the
ClearPass Server will expire in
<cppmActivationDaysRemaining> days

cppmClusterLicense
Usage

.1.3.6.1.4.1.14823.1.6.1.1.200.1016 Indicates the ClearPass cluster license
utilization details.
n <clearpassServerApplicationName>

indicates the name of the application.
n <clearpassClusterLicenseTotalCount>

indicates the application's total cluster-
wide license count.

n <clearpassClusterLicenseUsageCount>
indicates the count of the application's
used cluster-wide licenses.

cppmClusterNode
AddNotification

.1.3.6.1.4.1.14823.1.6.1.1.200.1006 Indicates the addition of a ClearPass node
to the cluster.
<cppmClusterServerIp> indicates the IP
address of the node added to the cluster.

cppmClusterNode
DbldNotification

.1.3.6.1.4.1.14823.1.6.1.1.200.1009 Indicates that a ClearPass node in the
cluster has been disabled.
<cppmClusterServerIp> indicates the IP
address of the disabled node.

cppmClusterNode
DelNotification

.1.3.6.1.4.1.14823.1.6.1.1.200.1007 Indicates that a ClearPass node has been
deleted from the cluster.
<cppmClusterServerIp> indicates the IP
address of the node removed from the
cluster.

cppmClusterNode
NSyncNotification

.1.3.6.1.4.1.14823.1.6.1.1.200.1010 Indicates the ClearPass node in the cluster
that is in the out-of-sync state.
n <cppmClusterServerIp> indicates the IP

address of the out-of-sync node.
n <cppmClusterOutOfSyncMinutes>

indicates the number of minutes that
the node has been out-of-sync.

cppmClusterNode
PromNotification

.1.3.6.1.4.1.14823.1.6.1.1.200.1008 Indicates the promotion of a ClearPass
node to Publisher status.
<cppmClusterServerIp> indicates the IP
address of the node promoted to Publisher.

cppmClusterPwd
ChangedNotification

.1.3.6.1.4.1.14823.1.6.1.1.200.1011 Indicates that the cluster password has
been changed.

cppmConfigReset .1.3.6.1.4.1.14823.1.6.1.1.200.1012 Indicates that the ClearPass node's
configuration has been reset.

cppmConfigRestore .1.3.6.1.4.1.14823.1.6.1.1.200.1013 Indicates that the ClearPass node's
configuration has been restored.

Table 6: SNMP Traps Supported by the SNMP Private MIB
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Trap Name OID Description

cppmLicenseExpiry .1.3.6.1.4.1.14823.1.6.1.1.200.1001 Indicates that one or more licenses
associated with a ClearPass application
<cppmNodeApplicationName> on the
ClearPass server will expire in
<cppmLicenseDaysRemaining> days.

cppmLowDiskSpace .1.3.6.1.4.1.14823.1.6.1.1.200.1004 Indicates that the system is running low on
disk space as indicated by
<cppmDiskSpaceRemaining> with the units
specified in <cppmResourceUnit>.

cppmLowMemory .1.3.6.1.4.1.14823.1.6.1.1.200.1005 Indicates that the system is running low on
memory as indicated by
<cppmMemoryRemaining> with the units
specified in <cppmResourceUnit>.

cppmNodeCertExpiry .1.3.6.1.4.1.14823.1.6.1.1.200.1003 Indicates that a server certificate
associated with the
<cppmNodeCertApplicationName> on the
ClearPass Server will expire in
<cppmCertDaysRemaining> days.

cppmUpdateNotification .1.3.6.1.4.1.14823.1.6.1.1.200.1014 Indicates that the CPPM node's installation
has been updated.

cppmUpgrade
Notification

.1.3.6.1.4.1.14823.1.6.1.1.200.1015 Indicates that the CPPM node's installation
has been upgraded.

Trap Name OID Description

cppmActivationExpiry .1.3.6.1.4.1.14823.1.6.1.1.200.1002 Indicates that one or more licensing
activations associated with the
<cppmNodeApplicationName> on the
ClearPass Server will expire in
<cppmActivationDaysRemaining> days

cppmClusterLicense
Usage

.1.3.6.1.4.1.14823.1.6.1.1.200.1016 Indicates the ClearPass cluster license
utilization details.
n <clearpassServerApplicationName>

indicates the name of the application.
n <clearpassClusterLicenseTotalCount>

indicates the application's total cluster-
wide license count.

n <clearpassClusterLicenseUsageCount>
indicates the count of the application's
used cluster-wide licenses.

cppmClusterNode
AddNotification

.1.3.6.1.4.1.14823.1.6.1.1.200.1006 Indicates the addition of a ClearPass node
to the cluster.
<cppmClusterServerIp> indicates the IP
address of the node added to the cluster.

Table 7: SNMP Traps Supported by the SNMP Private MIB
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Trap Name OID Description

cppmClusterNode
DbldNotification

.1.3.6.1.4.1.14823.1.6.1.1.200.1009 Indicates that a ClearPass node in the
cluster has been disabled.
<cppmClusterServerIp> indicates the IP
address of the disabled node.

cppmClusterNode
DelNotification

.1.3.6.1.4.1.14823.1.6.1.1.200.1007 Indicates that a ClearPass node has been
deleted from the cluster.
<cppmClusterServerIp> indicates the IP
address of the node removed from the
cluster.

cppmClusterNode
NSyncNotification

.1.3.6.1.4.1.14823.1.6.1.1.200.1010 Indicates the ClearPass node in the cluster
that is in the out-of-sync state.
n <cppmClusterServerIp> indicates the IP

address of the out-of-sync node.
n <cppmClusterOutOfSyncMinutes>

indicates the number of minutes that
the node has been out-of-sync.

cppmClusterNode
PromNotification

.1.3.6.1.4.1.14823.1.6.1.1.200.1008 Indicates the promotion of a ClearPass
node to Publisher status.
<cppmClusterServerIp> indicates the IP
address of the node promoted to Publisher.

cppmClusterPwd
ChangedNotification

.1.3.6.1.4.1.14823.1.6.1.1.200.1011 Indicates that the cluster password has
been changed.

cppmConfigReset .1.3.6.1.4.1.14823.1.6.1.1.200.1012 Indicates that the ClearPass node's
configuration has been reset.

cppmConfigRestore .1.3.6.1.4.1.14823.1.6.1.1.200.1013 Indicates that the ClearPass node's
configuration has been restored.

cppmLicenseExpiry .1.3.6.1.4.1.14823.1.6.1.1.200.1001 Indicates that one or more licenses
associated with a ClearPass application
<cppmNodeApplicationName> on the
ClearPass server will expire in
<cppmLicenseDaysRemaining> days.

cppmLowDiskSpace .1.3.6.1.4.1.14823.1.6.1.1.200.1004 Indicates that the system is running low on
disk space as indicated by
<cppmDiskSpaceRemaining> with the units
specified in <cppmResourceUnit>.

cppmLowMemory .1.3.6.1.4.1.14823.1.6.1.1.200.1005 Indicates that the system is running low on
memory as indicated by
<cppmMemoryRemaining> with the units
specified in <cppmResourceUnit>.
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Trap Name OID Description

cppmNodeCertExpiry .1.3.6.1.4.1.14823.1.6.1.1.200.1003 Indicates that a server certificate
associated with the
<cppmNodeCertApplicationName> on the
ClearPass Server will expire in
<cppmCertDaysRemaining> days.

cppmUpdateNotification .1.3.6.1.4.1.14823.1.6.1.1.200.1014 Indicates that the CPPM node's installation
has been updated.

cppmUpgrade
Notification

.1.3.6.1.4.1.14823.1.6.1.1.200.1015 Indicates that the CPPM node's installation
has been upgraded.

SNMP Trap Details
ClearPass Policy Manager leverages native SNMP support from the UC Davis ‘net-SNMP’ MIB package to send
trap notifications for the following events.

In these trap OIDs, the value of X varies from 1 through N, depending on the number of process states that are
being checked. Details about specific OIDs associated with the processes are listed in this section.

For more information, see:

n ClearPass Processes Stop and Start Events

n CPU Load Average Exceed Events

n CPU Load Average Traps

n Disk Space Threshold Traps

n Disk Utilization Threshold Exceed Events

n Network Interface Link Up and Link Down Events

n Network Interface Status Traps

n Process Status Traps

n SNMP Daemon Trap Events

ClearPass Processes Stop and Start Events
The OIDs for the start and stop events for ClearPass processes are described in the following table:

OID Description

.1.3.6.1.4.1.2021.8.1.2.X Process Name

.1.3.6.1.4.1.2021.2.1.101.X Process Status Message.

Table 1: ClearPass Processes Stop and Start Events

CPU Load Average Exceed Events
The OIDs for the CPU load average exceed events for 1, 5, and 15 minute threshold are described in the
following table:
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OID Description

.1.3.6.1.4.1.2021.9.1.100.1 Error flag for disk partition

.1.3.6.1.4.1.2021.9.1.2.1 Name of the partition.

Table 1: CPU Load Average Exceed Events or 1, 5, and 15Minute Threshold

CPU Load Average Traps
The OIDs for the CPU load average traps are described in the following tables:

CPU Load-1 Average Traps

OID Description

.1.3.6.1.4.1.2021.10.1.100.1 Error flag on the CPU load-1 average. Value of 1 indicates the load-1 has
crossed its threshold; a value of 0 indicates otherwise.

.1.3.6.1.4.1.2021.10.1.2.1 Name of CPU load-1 average.

Table 1: CPU Load-1 Average Traps

Figure 903 CPU Load-1 Average Traps Example

CPU Load-5 Average Traps

OID Description

.1.3.6.1.4.1.2021.10.1.100.2 Error flag on the CPU load-5 average. Value of 1 indicates the load-5 has
crossed its threshold; a value of 0 indicates otherwise.

.1.3.6.1.4.1.2021.10.1.2.2 Name of CPU load-5 average.

Table 2: CPU Load-5 Average Traps

Figure 904 CPU load-5 Average Traps Example
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CPU Load-15 Average Traps

OID Description

.1.3.6.1.4.1.2021.10.1.100.3 Error flag on the CPU load-15 average. Value of 1 indicates the load-15
has crossed its threshold; a value of 0 indicates otherwise.

.1.3.6.1.4.1.2021.10.1.2.3 Name of CPU load-15 average.

Table 3: CPU Load-5 Average Traps

Figure 905 CPU Load-15 Average Traps Example

Disk Space Threshold Traps
The OIDs for the disk space threshold s traps are described in the following table:

OID Description

.1.3.6.1.4.1.2021.9.1.100.1 Error flag indicating the disk or partition is under the minimum required
disk space configured for it. A value of 1 indicates that the system has
reached the threshold; a value of 0 indicates otherwise.

.1.3.6.1.4.1.2021.9.1.2.1 Indicates the name of the partition that has met the above condition.

Table 1: Disk Space Threshold Traps

Disk Utilization Threshold Exceed Events
The OIDs for the disk utilization threshold exceed events are described in the following table:

OID Description

.1.3.6.1.4.1.2021.9.1.100.1 Error flag for the disk partition.

.1.3.6.1.4.1.2021.9.1.2.1 Name of the disk partition.

Table 1: Disk Utilization Threshold Exceed Events

Network Interface Status Traps
The OIDs for the network interface status traps are described in the following table:

OID Description

.1.3.6.1.6.3.1.1.5.3 Indicates the link down trap with the ifAdminStatus and ifOperStatus
values set to 2.

.1.3.6.1.6.3.1.1.5.4 Indicates the link up trap with the ifAdminStatus and ifOperStatus
values set to 1.

Table 1: Network Interface Status Traps
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In each case, the ifIndex value is set to 2 for the management interface and 3 for the data port interface.

Network Interface Link Up and Link Down Events
The network interface up and down events are described in the following table:

OID Description

.1.3.6.1.6.3.1.1.5.3 Link Down.

.1.3.6.1.6.3.1.1.5.4 Link Up

Table 1: Network Interface Link Up and Link Down OIDs

SNMP Daemon Trap Events
This section contains OIDs for various trap events that are sent from ClearPass Policy Manager.

OID Description

.1.3.6.1.6.3.1.1.5.1 Cold Start trap indicates the reinitialization of the netsnmp daemon and
that its configuration file may have been altered.

.1.3.6.1.6.3.1.1.5.2 Warm Start trap indicates the reinitialization of the netsnmp daemon
and that its configuration file has not been altered.

Table 1: SNMP Daemon Trap Events

Important System Events

This section provides the following information:

n Admin User Interface Events

n Admin Server Events

n Async Service Events

n ClearPass Domain Controller Events

n ClearPass System Configuration Events

n ClearPass Update Events

n Cluster Events

n Command Line Events

n Database Replication Services Events

n Licensing Events

n Policy Server Events

n RADIUS/TACACS+ Server Events

n Service Names

n SNMP Events

n Support Shell Events

n System Auxiliary Service Events

n System Monitor Events

ClearPass 6.7 Policy Manager | User Guide SNMP, System Events & Error Codes | 950
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1982



951 | SNMP, System Events & Error Codes ClearPass 6.7 Policy Manager |  User Guide

This topic describes the important System Events logged by ClearPass. These messages are available for
consumption on the administrative interface, and in the form of a syslog stream. The events below are in the
following format

<Source>, <Level>, <Category>, <Message>

Elements listed below within angle brackets (for example, <content>) are variable, and are substituted by
ClearPass as applicable (such as an IP address).

For the list of available service names, refer to Service Names.

Admin User Interface Events

Critical Events
“Admin UI”, “ERROR” “Email Failed”, “Sending email failed”

“Admin UI”, “ERROR” “SMS Failed”, “Sending SMS failed”

“Admin UI”, “WARN”, “Login Failed”, “User:<X>”

"Admin UI", "WARN", "Login Failed", description

Info Events
"Admin UI", "INFO", "Logged out"

"Admin UI", "INFO", "Session destroyed"

"Admin UI", "INFO", "Logged in", description

"Admin UI", "INFO", "Clear Authentication Cache", “Cache is cleared for authentication source <X>"

"Admin UI", "INFO", "Clear Blacklist User Cache", “Blacklist Users cache is cleared for authentication source <X>"

"Admin UI", "INFO", "Server Certificate", "Subject:<X>“, "Updated"

"Install Update", "INFO", "Installing Update", "File: <X>", "Success"

"Admin UI", “INFO” “Email Successful”, “Sending email succeeded”

"Admin UI", “INFO” “SMS Successful”, “Sending SMS succeeded”

Admin Server Events

Info Events
“Admin server”, “INFO”, “Performed action start on Admin server”

Async Service Events

Info Events
“Async DB write service”, “INFO”, “Performed action start on Async DB write service”

“Multi-master cache”, “INFO”, “Performed action start on Multi-master cache”

“Async netd service”, “INFO”, “Performed action start on Async netd service”

ClearPass Domain Controller Events

Critical Events
“netleave”, “ERROR”, “Failed to remove <HOSTNAME> from the domain <DOMAIN_NAME>”
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“netjoin”, “WARN”, “configuration”, “<HOSTNAME> failed to join the domain <DOMAIN NAME> with domain
controller as <DOMAIN CONTROLLER>”

Info Events
“Netjoin”, “INFO”, "<HOSTNAME> joined the domain <REALM>"

“Netjoin”, “INFO”, “<HOSTNAME> removed from the domain <DOMAIN_NAME>“

ClearPass System Configuration Events

Critical Events
“DNS”, “ERROR”, “Failed configure DNS servers = <X>”

“datetime”, “ERROR”, “Failed to change system datetime.”

“hostname”, “ERROR”, “Setting hostname to <X> failed”

“ipaddress”, “ERROR”, “Testing cluster node connectivity failed”

“System TimeCheck “, “ WARN ,” , “Restarting CPPM services as the system detected time drift , Current system
time= 2016-07-13 17:00:01, System time 5 mins back = 2016-06-20 16:55:01”

Info Events
“Cluster”, “INFO”, “Setup”, “Database initialized”

“hostname”, “INFO”, “configuration”, “Hostname set to <X>”

“ipaddress”, “INFO”, “configuration”, Management port information updated to - IpAddress = <X>, Netmask =
<X>, Gateway = <X>”

“IpAddress”, “INFO”, "Data port information updated to - IpAddress = <X>, Netmask = <Y>, Gateway = <Z>"

“DNS”, “INFO”, “configuration”, “Successfully configured DNS servers - <X>”

“Time Config”, “INFO”, “Remote Time Server”, “Old List: <X>\nNew List: <Y>”

“timezone”, “INFO”, “configuration”, “”

“datetime”, “INFO”, “configuration”, “Successfully changed system datetime.\nOld time was <X>”

ClearPass Update Events

Critical Events
“Install Update”, “ERROR”, “Installing Update”, “File: <X>”, “Failed with exit status - <Y>”

“ClearPass Firmware Update Checker”, “ERROR”, “Firmware Update Checker”, “No HPE Passport Credentials
were supplied. To find new plugins, you must provide your HPE Passport Credentials in the application
configuration”

Info Events
“ClearPass Updater”, “INFO”, “Hotfixes Updates”, “Updated Hotfixes from File”

“ClearPass Updater”, “INFO”, “Fingerprints Updates”, “Updated fingerprints from File”

“ClearPass Updater”, “INFO”, “Updated AV/AS from ClearPass Portal (Online)”

“ClearPass Updater”, “INFO”,” Updated Hotfixes from ClearPass Portal (Online)”
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Cluster Events

Critical Events
“Cluster”, “ERROR”, “SetupSubscriber”, “Failed to add subscriber node with management IP=<IP>“

Info Events
"AddNode", “INFO”, "Added subscriber node with management IP=<IP>"

"DropNode", “INFO”, "Dropping node with management IP=<IP>, hostname=<Hostname>"

Command Line Events

Info Events
"Command Line”, “INFO”, “User:appadmin"

Database Replication Services Events

Info Events
"DB replication service”, “INFO”, “Performed action start on DB replication service”

"DB replication service”, “INFO”, “Performed action stop on DB replication service”

“DB change notification server”, “INFO”, “Performed action start on DB change notification server”

“DB replication service”, “INFO”, “Performed action start on DB replication service”

Licensing Events

Critical Events
“Admin UI”, “WARN”, “Activation Failed”, “Action Status: This Activation Request Token is already in use by
another instance\nProduct Name: Policy Manager\nLicense Type: <X>\nUser Count: <Y>”

Info Events
“Admin UI”, “INFO”, “Add License”, “Product Name: Policy Manager\nLicense Type: <X>\nUser Count: <Y>”

Policy Server Events

Info Events
“Policy Server”, “INFO”, “Performed action start on Policy server”

“Policy Server”, “INFO”, “Performed action stop on Policy server”

RADIUS/TACACS+ Server Events

Critical Events
“TACACSServer”, “ERROR”, “Request”, “Nad Ip=<X> not configured”

“RADIUS”, “WARN”, “Authentication”, “Ignoring request from unknown client <IP>:<PORT>”

“RADIUS”, “ERROR”, “Authentication”, “Received packet from <IP> with invalid Message-Authenticator! (Shared
secret is incorrect.)”

“RADIUS”, “ERROR”, “Received Accounting-Response packet from client <IP Address> port 1813 with invalid
signature (err=2)! (Shared secret is incorrect.)”
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“RADIUS”, “ERROR”, “Received Access-Accept packet from client <IP Address> port 1812 with invalid signature
(err=2)! (Shared secret is incorrect.)”

Info Events
“RADIUS”, “INFO”, “Performed action start on Radius server”

“RADIUS”, “INFO”, “Performed action restart on Radius server

“TACACS server”, “INFO”, “Performed action start on TACACS server”

“TACACS server”, “INFO”, “Performed action stop on TACACS server”

Service Names
n AirGroup notification service

n Async DB write service

n Async network services

n DB change notification server

n DB replication service

n Micros Fidelio FIAS

n Multi-master cache

n Policy server

n RADIUS server

n System auxiliary services

n System monitor service

n TACACS server

n Virtual IP service

n [YourServerName] Domain service

SNMP Events

Critical Events
“SNMPService”, “ERROR”, “ReadDeviceInfo”, “SNMP GET failed for device <X> with error=No response
received\nReading sysObjectId failed for device=<X>\nReading switch initialization info failed for <X>”

"SNMPService","ERROR", "Error fetching table snmpTargetAddr. Request timed out. Error reading SNMP target
table for NAD=10.1.1.1 Maybe SNMP target address table is not supported by device? Allow NAD update.
SNMP GET failed for device 10.1.1.1 with error=No response received Reading sysObjectId failed for
device=10.1.1.1 Reading switch initialization info failed for 10.1.1.1”

Info Events
“SNMPService”, “INFO”, “Device information not read for <Ip Address> since no traps are configured to this
node”

Support Shell Events

Info Events
“Support Shell” , “INFO”, “User:customersupport”
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System Auxiliary Service Events

Info Events
“System auxiliary service”, “INFO”, “Performed action start on System auxiliary service”

System Monitor Events

Critical Events
“Sysmon”, “ERROR”, “System”, “System is running with low memory. Available memory = <X>%”

“Sysmon”, “ERROR”, “System”, “System is running with low disk space. Available disk space = <X>%”

“System TimeCheck”, “WARN”, “Restart Services”, “Restarting CPPM services as the system detected time drift.
Current system time= <X>, System time 5 mins back = <Y>”

Info Events
“<Service Name>”, “INFO”, “restart”, “Performed action restart on <Service Name>”

“SYSTEM”, “INFO”, “<X> restarted”, “System monitor restarted <X>, as it seemed to have stopped abruptly”

"SYSTEM", "ERROR", "Updating CRLs failed", "Could not retrieve CRL from <URL>."

“System monitor service”, “INFO”, “Performed action start on System monitor service”

"Shutdown” “INFO” system "System is shutting down" Success

Error Codes
Table 1 describes the ClearPass Policy Manager error codes:

Code Description Type

0 Success Success

101 Failed to perform service classification Internal Error

102 Failed to perform policy evaluation Internal Error

103 Failed to perform posture notification Internal Error

104 Failed to query authstatus Internal Error

105 Internal error in performing authentication Internal Error

106 Internal error in RADIUS server Internal Error

201 User not found Authentication failure

202 Password mismatch Authentication failure

203 Failed to contact Authentication Source Authentication failure

204 Failed to classify request to service Authentication failure

205 Authentication Source not configured for service Authentication failure

Table 1: ClearPass Policy Manager Error Codes
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Code Description Type

206 Access denied by policy Authentication failure

207 Failed to get client MAC Address in order to perform Web authentication Authentication failure

208 No response from home server Authentication failure

209 No password in request Authentication failure

210 Unknown CA in client certificate Authentication failure

211 Client certificate not valid Authentication failure

212 Client certificate has expired Authentication failure

213 Certificate comparison failed Authentication failure

214 No certificate in authentication source Authentication failure

215 TLS session error Authentication failure

216 User authentication failed Authentication failure

217 Search failed due to insufficient permissions Authentication failure

218 Authentication source timed out Authentication failure

219 Bad search filter Authentication failure

220 Search failed Authentication failure

221 Authentication source error Authentication failure

222 Password change error Authentication failure

223 Username not available in request Authentication failure

224 CallingStationID not available in request Authentication failure

225 User account disabled Authentication failure

226 User account expired or not active yet Authentication failure

227 User account needs approval Authentication failure

228 User account has exceeded bandwidth limit Authentication failure

229 User account has exceeded session duration limit Authentication failure

230 User account has exceeded session count limit Authentication failure

5001 Internal Error Command and Control

5002 Invalid MAC Address Command and Control

5003 Invalid request received Command and Control
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Code Description Type

5004 Insufficient parameters received Command and Control

5005 Query - No MAC address record found Command and Control

5006 Query - No supported actions Command and Control

5007 Query - Cannot fetch MAC address details Command and Control

5008 Request: MAC address not online Command and Control

5009 Request: No MAC address record found Command and Control

6001 Unsupported TACACS parameter in request TACACS Protocol

6002 Invalid sequence number TACACS Protocol

6003 Sequence number overflow TACACS Protocol

6101 Not enough inputs to perform authentication TACACS Authentication

6102 Authentication privilege level mismatch TACACS Authentication

6103 No enforcement profiles matched to perform authentication TACACS Authentication

6201 Authorization failed as session is not authenticated TACACS Authorization

6202 Authorization privilege level mismatch TACACS Authorization

6203 Command not allowed TACACS Authorization

6204 No enforcement profiles matched to perform command authorization TACACS Authorization

6301 New password entered does not match TACACS Change Password

6302 Empty password TACACS Change Password

6303 Change password allowed only for local users TACACS Change Password

6304 Internal error in performing change password TACACS Change Password

9001 Wrong shared secret RADIUS Protocol

9002 Request timed out RADIUS Protocol

9003 Phase 2 PAC failure RADIUS Protocol

9004 Client rejected after PAC provisioning RADIUS Protocol

9005 Client does not support posture request RADIUS Protocol

9006 Received error TLV from client RADIUS Protocol

9007 Received failure TLV from client RADIUS Protocol

9008 Phase 2 PAC not found RADIUS Protocol
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Code Description Type

9009 Unknown Phase 2 PAC RADIUS Protocol

9010 Invalid Phase 2 PAC RADIUS Protocol

9011 PAC verification failed RADIUS Protocol

9012 PAC binding failed RADIUS Protocol

9013 Session resumption failed RADIUS Protocol

9014 Cached session data error RADIUS Protocol

9015 Client does not support configured EAP methods RADIUS Protocol

9016 Client did not send Cryptobinding TLV RADIUS Protocol

9017 Failed to contact OCSP Server RADIUS Protocol

9018 RADIUS protocol error RADIUS Protocol

9019 Client sent conflicting identities RADIUS Protocol
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Appendix C

Use Cases

This appendix contains several specific ClearPass Policy Manager use cases. Each one explains what it is
typically used for, and then describes how to configure Policy Manager for that use case.

n 802.1X Wireless Use Case

n Web Based Authentication Use Case

n MAC Authentication Use Case

n TACACS+ Use Case

n Single Port Use Case

802.1X Wireless Use Case
The basic Policy Manager Use Case configures a Policy Manager Service to identify and evaluate an 802.1X
request from a user logging into a Wireless Access Device. The following image illustrates the flow of control for
this service:

Figure 906 Flow of Control, Basic 802.1X Configuration Use Case
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Policy Manager ships with fourteen preconfigured services. In this use case, you select a service that supports
802.1X wireless requests. Follow the steps below to configure this basic 802.1X service that uses [EAP FAST],
one of the pre-configured Policy Manager authentication methods, and Active Directory Authentication
Source (AD), an external authentication source within your existing enterprise.

Policy Manager fetches attributes used for role mapping from the authorization sources (that are associated with the
authentication source). In this example, the authentication and authorization source are one and the same.

Policy Manager tests client identity against role-mapping rules, appending any match (multiple roles
acceptable) to the request for use by the enforcement policy. In the event of role-mapping failure, Policy
Manager assigns a default role. This use case create the role mapping policy RMP_DEPARTMENT that
distinguishes clients by department and the corresponding roles ROLE_ENGINEERING and ROLE_FINANCE, to
which it maps.

Policy Manager can be configured for a third-party posture server, to evaluate client health based on vendor-
specific credentials, typically credentials that cannot be evaluated internally by Policy Manager (that is, not in
the form of internal posture policies). Currently, Policy Manager supports the following posture server
interface: Microsoft NPS (RADIUS).

For purposes of posture evaluation, you can configure a posture policy (internal to Policy Manager), a posture server
(external), or an audit server (internal or external). Each of the first three use cases demonstrates one of these
options; here, the posture server.

Configuring a Service
1. Navigate to Configuration > Services.

2. Click the icon to add a service. The Configuration > Services > Add window opens.
3. If it is not already selected, click the Service tab and define basic service information.

a. Enter a name for the service in the Name field.

b. Click the Type drop-down list and select 802.1X Wireless.

c. (Optional) click the Monitor Mode checkbox to allow handshakes to occur (for monitoring purposes),
but without enforcement.

d. Click Next to display the Authentication tab.

4. Configure authentication.

a. In the Authentication Methods field, select [EAP Fast].
b. In the Authentication Sources field, click the Select to Add drop-down list and select the following

sources.

n [Local User Repository] [Local SQL DB]

n [Guest User Repository] [Local SQL DB]

n [Guest Device Repository] [Local SQL DB]

n [Endpoints Repository] [Local SQL DB]

n [Onboard Devices Repository] [Local SQL DB]

n [Admin User Repository] [Local SQL DB]

n [Active Directory]

c. (Optional) Select Strip Username Rules to pre-process the user name (to remove prefixes and
suffixes) before sending it to the authentication source.

Creating a New Role Mapping Policy
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To create a new Role Mapping policy:

1. Click the Roles tab.

2. Click Add new Role Mapping Policy. The Role Mappings page opens.

Figure 907 Role Mapping Navigation and Settings

3. Add a new role, navigate to the Policy tab. Enter the Policy Name, For example, ROLE_ENGINEER and click
Save. Repeat the same step for ROLE_FINANCE. The following figure displays the Policy tab:

Figure 908 Policy Tab

4. Click the Next button in the Rules Editor.

5. Create rules to map client identity to a role. From the Mapping Rules tab, select the Rules Evaluation
Algorithm radio button. The following figure displays the Mapping Rules tab:
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Figure 909 Mapping Rules Tab

6. Select the Select all matches radio button.

7. Match the conditions with the role name. Click the Add Rule button. The Rules Editor pop-up opens.
Upon completion of each rule, click the Save button in the Rules Editor.

8. Click the Save button.

9. Add the new role mapping policy to the service from the Roles tab. The following figure displays the Roles
tab:

Figure 910 Roles Tab

10.Select Role Mapping Policy, for example, RMP_DEPARTMENT. Click Next.
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11.Add an Micrsoft NPS external posture serverto the 802.1X service. Click the Posture tab. The following
figure displays the Posture tab:

Figure 911 Posture Tab

12.Click Add new Posture Server to add a new posture server.

13.Configure the following posture settings examples:

n Name (freeform): PS_NPS
n Server Type radio button: Microsoft NPS
n Default Posture Token (selector): UNKOWN

The following figure displays the Posture Server tab:

Figure 912 Posture Server Tab

14.Click Next.

15.Configure connection settings in the Primary/ Backup Server tabs by entering the connection
information for the RADIUS posture server. The following figure displays the Primary Server tab:

ClearPass 6.7 Policy Manager | User Guide Use Cases | 964
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 1996



965 | Use Cases ClearPass 6.7 Policy Manager |  User Guide

Figure 913 Primary Server Tab

16.Click Next from primary server to backup server. Click Save.

17.Add the new posture server to the service. From the Posture tab, enter the Posture Servers, for example,
PS_NPS, then click the Add button. The following figure displays the Posture tab:

Figure 914 Posture Tab

18.Click the Next button. Assign an enforcement policy.

19.Enforcement policies contain dictionary-based rules for evaluation of Role, Posture Tokens, and System
Time to evaluation profiles. Policy Manager applies all matching enforcement profiles to the request. In the
case of no match, Policy Manager assigns a default enforcement profile. The following figure displays the
Enforcement tab:

Table 40: Enforcement Policy Navigation and Settings
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20. From the Enforcement tab, select the Enforcement Policy. For instructions about how to build an
enforcement policy, refer to Configuring Enforcement Policies.

21.Save the service.

Web Based Authentication Use Case
This Service supports known Guests with inadequate 802.1X supplicants or posture agents. The following
figure illustrates the overall flow of control for this Policy Manager Service.

Figure 915 Flow-of-Control of Web-Based Authentication for Guests

Configuring a Service
Perform the following steps to configure Policy Manager for WebAuth-based Guest access.

1. Prepare the switch to pre-process WebAuth requests for the Policy Manager Aruba WebAuth service.

Refer to your Network Access Device documentation to configure the switch such that it redirects HTTP
requests to the Aruba Guest Portal, which captures username and password and optionally launches an
agent that returns posture data.

2. Create a WebAuth-based Service.
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Navigation Settings

Create a new Service:
n Services >
n Add Service >

Name the Service and
select a pre-
configured Service
Type:
n Service (tab) >
n Type (selector):

Aruba Web-Based
Authentication >

n

Name/Descriptio
n (freeform) >

n Upon completion,
click Next.

Table 1: Service Navigation and Settings

3. Set up the Authentication.

a. Method: The Policy Manager WebAuth service authenticates WebAuth clients internally.

b. Source: Administrators typically configure Guest Users in the local Policy Manager database.

4. Configure a Posture Policy.

For purposes of posture evaluation, you can configure a Posture Policy (internal to Policy Manager), a Posture Server
(external), or an Audit Server (internal or external). Each of the first three use cases demonstrates one of these
options. This use case demonstrates the Posture Policy.

As of the current version, Policy Manager ships with five pre-configured posture plugins that evaluate the
health of the client and return a corresponding posture token.

To add the internal posture policy IPP_UNIVERSAL_XP, which (as you will configure it in this Use Case, checks
any Windows® XP clients to verify the most current Service Pack).
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Navigation Settings

Select the local Policy
Manager database:
n Authentication (tab) >
n Sources (Select drop-down

list): [Local User
Repository] >

n Add >
n Strip Username Rules

(check box) >
n Enter an example of

preceding or following
separators (if any), with the
phrase “user” representing
the username to be
returned. For
authentication, Policy
Manager strips the
specified separators and
any paths or domains
beyond them.

n Upon completion, click
Next (until you reach
Enforcement Policy).

Table 2: Local Policy Manager Database Navigation and Settings
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Navigation Setting

Create a
Posture Policy:
n Posture

(tab) >
n Enable

Validation
Check
(check box) >

n Add new
Internal
Policy (link)
>

Name the
Posture Policy
and specify a
general class of
operating
system:
n Policy (tab)

>
n Policy

Name
(freeform):
IPP_
UNIVERSAL >

n Host
Operating
System
(radio
buttons):
Windows >

n When
finished
working in
the Policy
tab, click
Next to
open the
Posture
Plugins tab

Table 3: Posture Policy Navigation and Settings
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Navigation Setting

Select a
Validator:
n Posture

Plugins (tab)
>

n Enable
Windows
Health
System
Validator >

n Configure
(button) >

Configure the
Validator:
n Windows

System
Health
Validator
(popup) >

n Enable all
Windows
operating
systems
(check box) >

n Enable
Service Pack
levels for
Windows 7,
Windows
Vista®,
Windows XP
Windows
Server®
2008,
Windows
Server 2008
R2, and
Windows
Server 2003
(check
boxes) >

n Save
(button) >

n When
finished
working in
the Posture
Plugin tab
click Next to
move to the
Rules tab)
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Navigation Setting

Set rules to
correlate
validation
results with
posture tokens:
n Rules (tab) >
n Add Rule

(button
opens
popup) >

n Rules Editor
(popup) >

n Conditions/
Actions:
match
Conditions
(Select
Plugin/
Select Plugin
checks) to
Actions
(Posture
Token)>

n In the Rules
Editor, upon
completion
of each rule,
click the
Save button
>

n When
finished
working in
the Rules
tab, click the
Next button.

Add the new
Posture Policy to
the Service:
Back in Posture
(tab) >
Internal
Policies
(selector): IPP_
UNIVERSAL_XP,
then click the
Add button

The following fields deserve special mention:

l Default Posture Token. Value of the posture token to use if health status is not available.
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l Remediate End-Hosts. When a client does not pass posture evaluation, redirect to the indicated server
for remediation.

l Remediation URL. URL of remediation server.

5. Create an Enforcement Policy.

Because this Use Case assumes theGuest role, and the Aruba Web Portal agent has returned a posture
token, it does not require configuration of Role Mapping or Posture Evaluation.

The SNMP_POLICY selected in this step provides full guest access to a Role of [Guest] with a Posture of Healthy, and
limited guest access.

Navigation Setting

Add a new
Enforcement Policy:
n Enforcement

(tab) >
n Enforcement

Policy (selector):
SNMP_POLICY

n Upon
completion, click
Save.

Table 4: Enforcement Policy Navigation and Settings

6. Save the Service.

Click Save. The Service now appears at the bottom of the Services list.

MAC Authentication Use Case
This service supportsNetwork Devices, such as printers or hand-helds.

In this service, an audit is initiated on receiving the first MAC Authentication request. A subsequent MAC
Authentication request (triggered after the audit, or triggered after a short session timeout) uses the cached
results from the audit to determine the posture and role(s) for the device.

The following diagram illustrates the overall flow of control for this Policy Manager service.

Figure 916 Flow-of-Control of MAC Authentication for Network Devices
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Configuring the Service
To configure ClearPass for MAC-based network device access:

1. First create a MAC Authentication Service by navigating to Configuration > Services.

The Services page opens.

2. Click the Add link.

The Add Services dialog opens.
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Figure 917 MAC Authentication Service Configuration Dialog

3.

Navigation Settings

Create a new Service:
n Services >
n Add Service (link) >

Name the Service and
select a pre-configured
Service Type:
n Service (tab) >
n Type (selector): MAC

Authentication >
n Name/Description

(freeform) >
n Upon completion, click

Next to configure
Authentication

Table 1: MAC Authentication Service Navigation and Settings

4. Set up Authentication.

You can select any type of authentication/authorization source for a MAC Authentication service. Only a
static host list of type MAC Address List or MAC Address Regular Expression shows up in the list of
authentication sources (of type Static Host List).

For more information on static host list, see Managing Static Host Lists. You can also select any other
supported type of authentication source.

ClearPass 6.7 Policy Manager | User Guide Use Cases | 974
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 2006



975 | Use Cases ClearPass 6.7 Policy Manager |  User Guide

Navigation Settings

Select an Authentication
Method and two
authentication sources—one
of type Static Host List and
the other of type Generic
LDAP server (that you have
already configured in Policy
Manager):
n Authentication (tab) >
n Methods (This method is

automatically selected for
this type of service): [MAC
AUTH] >

n Add >
n Sources (Select drop-

down list): Handhelds
[Static Host List] and
Policy Manager Clients
White List [Generic LDAP]
>

n Add >
n Upon completion, Next

(to Audit)

Table 2: Authentication Method Navigation and Settings

5. Configure an Audit Server.

This step is optional if no Role Mapping Policy is provided, or if you want to establish health or roles using an
audit. For more information, see Configuring Audit Servers.

An audit server determines health by performing a detailed system and health vulnerability analysis
(Nessus).

You can also configure the audit server (Nmap or Nessus) with post-audit rules that enable Policy Manager
to determine client identity.

Navigation Settings

Configure the Audit Server:
n Audit (tab) >
n Audit End Hosts (enable) >
n Audit Server (selector):

NMAP
n Trigger Conditions (radio

button): For MAC
authentication requests

n Reauthenticate client (check
box): Enable

Table 3: Audit Server Navigation and Settings

Upon completion of the audit, Policy Manager caches Role (Nmap and Nessus) and Posture (Nessus), then
resets the connection (or the switch reauthenticates after a short session timeout), triggering a new request,
which follows the same path until it reaches Role Mapping/Posture/Audit; this appends cached information
for this client to the request for passing to Enforcement.

6. Select the Enforcement Policy Sample_Allow_Access_Policy:

Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 2007



Navigation Setting

Select the Enforcement Policy:
n Enforcement (tab) >
n Use Cached Results (check

box): Select Use cached
Roles and Posture
attributes from previous
sessions >

n Enforcement Policy
(selector):
UnmanagedClientPolicy

n When you are finished with
your work in this tab, click
Save.

Table 4: Enforcement Policy Navigation and Settings

Unlike the 802.1X service, which uses the same Enforcement Policy (but uses an explicit Role Mapping
Policy to assess Role), in this use case, Policy Manager applies post-audit rules against attributes captured by
the Audit server to infer Role(s).

7. Click Save.

The service now appears at the bottom of the Services list.

TACACS+ Use Case
This Service supports Administrator connections to Network Access Devices via TACACS+. The following image
illustrates the overall flow of control for this Policy Manager Service.

Figure 918 Administrator connections to Network Access Devices via TACACS+
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Configuring the Service
Perform the following steps to configure Policy Manager for TACACS+-based access:

1. Navigate to Configuration > Services.

2. Click the icon to add a service. The Configuration > Services > Add window opens.
3. If it is not already selected, click the Service tab and define basic service information.

a. Enter a name for the service in the Name field.

b. Click the Type drop-down list and select the preconfigured service type that matches your Policy
Manager Admin Network Login Service.

c. Click Next to display the Authentication tab.

4. Define the Authentication settings for the service. Authentication methods can be left to their default
values, as the Policy Manager TACACS+ service authenticates TACACS+ requests internally.

a. In the Authentication Sources section, click the Select to Add drop-down list.

b. Select AD (Active Directory). For this use case example, Network Access Device authentication data
will be stored in the Active Directory.

5. Click the Enforcement tab and select an Enforcement Policy.

Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 2009



a. Click the Enforcement Policy drop-down list and select the Enforcement Policy [Admin Network Login
Policy] that distinguishes the two allowed roles (Net Admin Limited and Device SuperAdmin).

6. Click Save. The Service now appears at the bottom of the Services list.

Single Port Use Case
This Service supports all three types of connections on a single port.

The following figure illustrates both the overall flow of control for this hybrid service, in which complementary
switch and Policy Manager configurations allow all three types of connections on a single port:

Figure 919 Flow of the Multiple Protocol Per Port Case

ClearPass 6.7 Policy Manager | User Guide Use Cases | 978
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 2010



979 | Use Cases ClearPass 6.7 Policy Manager |  User Guide
Anexo 06 ITEM 01 (0592515)         SEI 0008478-63.2018.6.02.8000 / pg. 2011



ClearPass 6.7 Policy Manager | User Guide Rules Editing and Namespaces | 980

Appendix D

Rules Editing and Namespaces

The Policy Manager administration User Interface allows you to create different types of objects:

n Service rules

n Role mapping policies

n Internal user policies

n Enforcement policies

n Enforcement profiles

n Post-audit rules

n Proxy attribute pruning rules

n Filters for Access Tracker and activity reports

n Attributes editing for policy simulation

When editing all these elements, you are presented with a tabular interface with the same column headers:

n Type: Type is the namespace from which these attributes are defined. This is a drop-down list that contains
namespaces defined in the system for the current editing context.

n Name: Name is the name of the attribute. This is a drop-down list with the names of the attributes present
in the namespace.

n Operator: Operator is a list of operators appropriate for the data type of the attribute. The drop-down list
shows the operators appropriate for data type on the left (that is, the attribute).

n Value: The value is the value of the attribute. Again, depending on the data type of the attribute, the value
field can be a free-form one-line edit box, a free-form multi-line edit box, a drop-down list containing pre-
defined values (enumerated types), or a time or date widget.

In some editing interfaces (for example, enforcement profile and policy simulation attribute editing interfaces)
the operator does not change; it is always the EQUALS operator.

Providing a uniform tabular interface to edit all these elements enables you to use the same steps while
configuring these elements. Also, providing a context-sensitive editing experience (for names, operators and
values) takes the guess-work out of configuring these elements.

The following sections describe namespaces, variables, and operators:

n Namespaces on page 980

n Variables on page 990

n Operators on page 991

Namespaces
Multiple namespaces are displayed in the rules-editing interfaces, depending upon what you are editing.

For detailed information about the available namespaces, see the following topics:

n Application Namespace

n Audit Namespaces

n Authentication Namespaces

n Authorization Namespaces

n Certificate Namespaces
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n Connection Namespaces

n Date Namespaces

n Device Namespaces

n Endpoint Namespaces

n Guest User Namespaces

n Host Namespaces

n Local User Namespaces

n RADIUS Namespaces

n TACACS Namespaces

n Tips Namespaces

Application Namespace
The Application namespace has one name attribute. This attribute is an enumerated type currently containing
the following string values:

n Guest

n Insight

n PolicyManager

n Onboard

n ClearPass

The Application:ClearPass namespace has the following string values available for the Name field:

n AssertionConsumerUrl

n Configuration-Profile-ID

n Device-Compromised

n Device-ICCID

n Device-IMEI

n Device-MAC

n Device-MDM-Managed

n Device-NAME

n Device-OS

n Device-PRODUCT

n Device-SERIAL

n Device-UDID

n Device-VERSION

n IDDP-COOKIE-TIMEOUT-MINS

n IDPURL

n MDM-Data-Roaming

n MDM-Voice-Roaming

n Onboard-Max-Devices

n Page-Name

n Provisioning-Settings-ID

n SAMLRequest

n SAMLResponse
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n Session-Timeout

n User-Email-Address

Audit Namespaces
The dictionaries in the audit namespace are provided with ClearPass Policy Manager. The Audit namespace has
the notation Vendor:Audit, where Vendor is the name of the company that has defined attributes in the
dictionary.

Examples of dictionaries in the audit namespace are AvendaSystems:Audit or Qualys:Audit.

The Audit namespace appears when editing post-audit rules. See Audit Service Flow Control for more
information.

The Avenda Systems:Audit namespace appears when editing post-audit rules for NESSUS and NMAP audit
servers.

The following table displays the Audit Namespace attributes:

Attribute Name Values

Audit-Status n AUDIT_ERROR
n AUDIT_INPROGRESS
n AUDIT_SUCCESS

Device-Type Type of device returned by an NMAP port scan.

Output-Msgs The output message returned by Nessus plugin after a vulnerability scan.

Network-Apps String representation of the open network ports (HTTP, Telnet, etc.).

Mac-Vendor Vendor associated with MAC address of the host.

OS-Info OS information string returned by NMAP.

Open-Ports The port numbers of open applications on the host.

Table 1: Audit Namespace Attributes

Authentication Namespaces
The authentication namespace can be used in role mapping policies to define roles based on the type of
authentication method used or the status of the authentication.
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Authentication Namespace Editing Context
The following table describes the Authentication Namespace Attributes parameters:

Attribute
Name Values

InnerMethod n CHAP
n EAP-GTC
n EAP-MD5
n EAP-MSCHAPv2
n EAP-TLS
n MSCHAP
n PAP
NOTE: The EAP-MD5 authentication type is not supported if you use the ClearPass Policy
Manager in the FIPS mode.

OuterMethod n CHAP
n EAP-FAST
n EAP-MD5
n EAP-PEAP
n EAP-TLS
n EAP-TTLS
n MSCHAP
n PAP
NOTE: The EAP-MD5 authentication type is not supported if you use the ClearPass Policy
Manager in the FIPS mode.

Phase1PAC n None: No PAC was used to establish the outer tunnel in the EAP-FAST authentication method
n Tunnel: A tunnel PAC was used to establish the outer tunnel in the EAP-FAST authentication

method
n Machine: A machine PAC was used to establish the outer tunnel in the EAP-FAST

authentication method; machine PAC is used for machine authentication (see EAP-FAST in
Adding and Modifying Authentication Methods).

Phase2PAC n None: No PAC was used instead of an inner method handshake in the EAP-FAST authentication
method

n UserAuthPAC : A user authentication PAC was used instead of the user authentication inner
method handshake in the EAP-FAST authentication method

n PosturePAC: A posture PAC was used instead of the posture credential handshake in the EAP-
FAST authentication method

Posture n Capable : The client is capable of providing posture credentials
n Collected: Posture credentials were collected from the client
n Not-Capable: The client is not capable of providing posture credentials
n Unknown: It is not known whether the client is capable of providing credentials

Status n None: No authentication took place
n User: The user was authenticated
n Machine: The machine was authenticated
n Failed: Authentication failed
n AuthSource-Unreachable: The authentication source was unreachable

MacAuth n NotApplicable: Not a MAC Auth request
n Known Client: Client MAC address was found in an authentication source
n Unknown Client: Client MAC address was not found in an authentication source

Table 1: Authentication Namespace Attributes
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Attribute
Name Values

Username The username as received from the client (after the strip user name rules are applied).

Full-
Username

The username as received from the client (before the strip user name rules are applied).

Source The name of the authentication source used to authenticate the user.

Authorization Namespaces
Policy Manager supports multiple types of authorization sources. Authorization sources from which values of
attributes can be retrieved to create role mapping rules have their own separate namespaces (prefixed with
Authorization).

Authorization editing context

Role mapping policies

AD Instance Namespace
For each instance of an Active Directory authentication source, there is an AD instance namespace that appears
in the rules editing interface. The AD instance namespace consists of all the attributes that were defined when
the authentication source was created. These attribute names are pre-populated. For Policy Manager to fetch
the values of attributes from Active Directory, you need to define filters for that authentication source (see
Adding and Configuring Authentication Sources for more information).

Authorization
The authorization namespace has one attribute: sources. The values are pre-populated with the authorization
sources defined in Policy Manager. Use this to check for the authorization source(s) from which attributes were
extracted for the authenticating entity.

LDAP Instance Namespace
For each instance of an LDAP authentication source, there is an LDAP instance namespace that appears in the
rules editing interface. The LDAP instance namespace consists of all the attributes that were defined when the
authentication source was created. These attribute names are pre-populated. For Policy Manager to fetch the
values of attributes from an LDAP-compliant directory, you need to define filters for that authentication
source (see Adding and Configuring Authentication Sources).

RSAToken Instance Namespace
For each instance of an RSA Token Server authentication source, there is an RSA Token Server instance
namespace that appears in the rules editing interface. The RSA Token Server instance namespace consists of
attributes names defined when you created an instance of this authentication source. The attribute names are
pre-populated for administrative convenience.

Sources
This is the list of the authorization sources from which attributes were fetched for role mapping. Authorization
namespaces appear in Role mapping policies.
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SQL Instance Namespace
For each instance of an SQL authentication source, there is an SQL instance namespace that appears in the
rules editing interface. The SQL instance namespace consists of attributes names defined when you created an
instance of this authentication source. The attribute names are pre-populated for administrative convenience.
For Policy Manager to fetch the values of attributes from a SQL-compliant database, you need to define filters
for that authentication source.

Certificate Namespaces
The certificate namespace can be used in role mapping policies to define roles based on attributes in the client
certificate presented by the end host. Client certificates are presented in mutually authenticated 802.1X EAP
methods (EAP-TLS, PEAP/TLS, EAP-FAST/TLS).

Certificate Namespace Editing Context

Role mapping policies

Attribute Name Values

Version Certificate version

Serial-Number Certificate serial number

n Subject-C
n Subject-CN
n Subject-DC
n Subject-DN
n Subject-emailAddress
n Subject-GN
n Subject-L
n Subject-O
n Subject-OU
n Subject-SN
n Subject-ST
n Subject-UID

Attributes associated with the subject (user or machine, in this case). Not all of
these fields are populated in a certificate.

Table 1: Certificate Namespace Attributes
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Attribute Name Values

n Issuer-C
n Issuer-CN
n Issuer-DC
n Issuer-DN
n Issuer-emailAddress
n Issuer-GN
n Issuer-L
n Issuer-O
n Issuer-OU
n Issuer-SN
n Issuer-ST
n Issuer-UID

Attributes associated with the issuer (Certificate Authorities or the enterprise CA).
Not all of these fields are populated in a certificate.

n Subject-AltName-
DirName

n Subject-AltName-DNS
n Subject-AltName-

EmailAddress
n Subject-AltName-

IPAddress
n Subject-AltName-msUPN
n Subject-AltName-

RegisterdID
n Subject-AltName-URI

Attributes associated with the subject (user or machine, in this case) alternate
name. Not all of these fields are populated in a certificate.

Connection Namespaces
The connection namespace can be used in role mapping policies to define roles based on where the protocol
request originated from and where it terminated.

Connection Namespace Editing Contexts
n Role mapping policies

n Service rules

The following table describes the Connection Namespace Pre-defined Attributes parameters:

Attribute Description

Src-IP-Address Src-IP-Address and Src-Port are the IP address and port from which the
request (RADIUS, TACACS+, etc.) originated.

Src-Port

Dest-IP-Address Dst-IP-Address and Dst-Port are the IP address and port at which Policy
Manager received the request (RADIUS, TACACS+, etc.).

Dest-Port

Protocol Request protocol: RADIUS, TACACS+, WebAuth.

NAD-IP-Address IP address of the network device from which the request originated.

Table 1: Connection Namespace Pre-defined Attributes
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Attribute Description

Client-Mac-Address MAC address of the client.

n Client-Mac-Address-Colon
n Client-Mac-Address-Dot
n Client-Mac-Address-Hyphen
n Client-Mac-Address-Nodelim

Client MAC address in different formats.

Client-IP-Address IP address of the client (if known).

Date Namespaces

The date namespace has three pre-defined attributes:

n Day-of-Week

n Date-of-Year

n Time-of-Day

For Day-of-Week, the supported operators are BELONG_TO and NOT_BELONGS_TO, and the value field shows
a multi-select list box with days from Monday through Sunday.

The Time-of-Day attribute shows a time icon in the value field.

The Date-of-Year attribute shows a date, month and year icon in the value field.

The operators supported for Date-of-Year and Time-of-Day attributes are the similar to the ones supported for
the integer data type.

Date Namespace Editing Contexts
n Enforcement policies

n Filter rules for Access Tracker and Activity Reports

n Role mapping policies

n Service rules

Device Namespaces
The Device namespace has four pre-defined attributes:

n Location

n OS-Version

n Device-Type

n Device-Vendor

Custom attributes also appear in the attribute list if they are defined as custom tags for the device.

These attributes can be used only if you have pre-populated the values for these attributes when a network device is
configured.
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Endpoint Namespaces
Use these attributes to look for attributes of authenticating endpoints, which are present in the Policy Manager
endpoints list. The Endpoint namespace has the following attributes:

n Disabled By

n Disabled Reason

n Enabled By

n Enabled Reason

n Info URL

Guest User Namespaces
The GuestUser namespace has the attributes associated with the guest user (resident in the Policy Manager
guest user database) who authenticated in this session. This namespace is only applicable if a guest user is
authenticated. The GuestUser namespace has six pre-defined attributes:

n Company-Name

n Designation

n Email

n Location

n Phone

n Sponsor

Custom attributes also appear in the attribute list if they are defined as custom tags for the guest user.

These attributes can be used only if you have pre-populated the values for these attributes when a guest user is
configured in Policy Manager.

Host Namespaces
The Host namespace has the following predefined attributes:

n Name*

n OSType*

n FQDN*

n UserAgent**

n CheckType**

n UniqueID

n AgentType*

n InstalledSHAs*

* Only populated when request is originated by a Microsoft NAP-compatible agent.

** Only present if Policy Manager acts as a Web authentication portal.

Local User Namespaces

The LocalUser namespace has the attributes associated with the local user (resident in the Policy Manager local
user database) who authenticated in this session. This namespace is only applicable if a local user is
authenticated.
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The LocalUser namespace has four pre-defined attributes:

n Designation

n Email

n Phone

n Sponsor

Custom attributes also appear in the attribute list if they are defined as custom tags for the local user.

These attributes can be used only if you have pre-populated the values for these attributes when a local user is
configured in Policy Manager.

RADIUS Namespaces
Dictionaries in the RADIUS namespace come pre-packaged with the product. The administration interface does
provide a way to add dictionaries into the system (See RADIUS Dictionary on page 716 for more information).
RADIUS namespace has the notation RADIUS:Vendor, where Vendor is the name of the Company that has
defined attributes in the dictionary. Sometimes, the same vendor has multiple dictionaries, in which case the
"Vendor" portion has the name suffixed by the name of device or some other unique string.

IETF is a special vendor for the dictionary that holds the attributes defined in the RFC 2865 and other
associated RFCs. Policy Manager comes pre-packaged with a number of vendor dictionaries.

Some examples of dictionaries in the RADIUS namespace are:

n RADIUS:Aruba

n RADIUS:IETF

n RADIUS:Juniper

n RADIUS:Microsoft

RADIUS Namespace Editing Contexts
n Filter rules for Access Tracker and Activity Reports

n Policy simulation attributes

n Post-proxy attribute pruning rules

n RADIUS Enforcement profiles: All RADIUS namespace attributes that can be sent back to a RADIUS client
(the ones marked with the OUT or INOUT qualifier)

n Role mapping policies

n Service rules: All RADIUS namespace attributes that can appear in a request (the ones marked with the IN or
INOUT qualifier)

TACACS Namespaces
The TACACS (Terminal Access Controller Access-Control System) namespace has the attributes associated with
attributes available in a TACACS+ request. Available attributes are:

n AuthSource

n AvendaAVPair

n UserName

Tips Namespaces
The pre-defined attributes for the Tips namespace are Role and Posture. Values are assigned to these attributes
at run-time after Policy Manager evaluates role mapping and posture related policies.
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Role
The value for the Role attribute is a set of roles assigned by either the role mapping policy or the post-audit
policy. The value of the Role attribute can also be a dynamically fetched “Enable as role” attribute from the
authorization source. The posture value is computed after Policy Manager evaluates internal posture policies,
and gets posture status from posture servers or audit servers.

Posture
The value for the Posture attribute is one of the following:

n CHECKUP

n HEALTHY

n INFECTED

n QUARANTINE

n TRANSITION

n UNKNOWN

Tips Namespace Editing Context

Enforcement policies

Variables
Variables are populated with the connection-specific values. Variable names (prefixed with % and enclosed in
curly braces; for example, %{Username}”) can be used in filters, role mapping, enforcement rules, and
enforcement profiles.

Policy Manager does in-place substitution of the value of the variable during run-time rule evaluation.

The following built-in variables are supported in Policy Manager:

Variable Description

%{attribute-
name}

attribute-name is the alias name for an attribute that you have configured to be retrieved
from an authentication source. See Adding and Configuring Authentication Sources on page
186.

%
{Radius:IETF:MAC-
Address-Colon}

MAC address of client in aa:bb:cc:dd:ee:ff format

%
{Radius:IETF:MAC-
Address-Hyphen}

MAC address of client in aa-bb-cc-dd-ee-ff format

%
{RadiusS:IETF:MAC-
Address-Dot}

MAC address of client in aabb.ccdd.eeff format

%
{Radius:IETF:MAC-
Address-NoDelim}

MAC address of client in aabbccddeeff format

Table 1: Policy Manager Variables Supported by ClearPass
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You can also use any other dictionary-based attributes (or namespace attributes) as variables in role-mapping rules,
enforcement rules, enforcement profiles, and LDAP or SQL filters. For example, you can use %{Radius:IETF:Calling-
Station-ID}or %{Radius:Airespace:Airespace-Wlan-Id} in rules or filters.

Operators
The Rules editing interface in Policy Manager supports a rich set of operators.

The type of operators presented are based on the data type of the attribute for which the operator is being
used. Where the data type of the attribute is not known, the attribute is treated as a string type.
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The following table lists the operators presented for common attribute data types:

Attribute Type Operators

String n BELONGS_TO
n NOT_BELONGS_TO

n BEGINS_WITH
n NOT_BEGINS_WITH

n CONTAINS
n NOT_CONTAINS

n ENDS_WITH
n NOT_ENDS_WITH

n EQUALS
n NOT_EQUALS

n EQUALS_IGNORE_CASE
n NOT_EQUALS_IGNORE_CASE

n EXISTS
n NOT_EXISTS
n MATCHES_REGEX
n NOT_MATCHES_REGEX

Integer n BELONGS_TO
n NOT_BELONGS_TO

n EQUALS
n NOT_EQUALS

n EXISTS
n NOT_EXISTS

n GREATER_THAN
n GREATER_THAN_OR_EQUALS

n LESS_THAN
n LESS_THAN_OR_EQUALS

Time or Date n EQUALS
n NOT_EQUALS
n GREATER_THAN
n GREATER_THAN_OR_EQUALS
n LESS_THAN
n LESS_THAN_OR_EQUALS
n IN_RANGE

Table 1: Attribute Operators
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Attribute Type Operators

Day n BELONGS_TO
n NOT_BELONGS_TO

List (Example: Role) n EQUALS
n NOT_EQUALS

n MATCHES_ALL
n NOT_MATCHES_ALL

n MATCHES_ANY
n NOT_MATCHES_ANY

n MATCHES_EXACT
n NOT_MATCHES_EXACT

Group (Example: Calling-Station-
Id, NAS-IP-Address)

n BELONGS_TO_GROUP
n NOT_BELONGS_TO_GROUP

The following table describes all operator types:
Table 41: Operator Descriptions

Operator Description

BEGINS_WITH For string data type, true if the run-time value of the attribute begins with the
configured value.
Example: Radius:IETF:NAS-Identifier BEGINS_WITH "SJ-"

BELONGS_TO For string data type, true if the run-time value of the attribute matches a set
of configured string values.
Example: Radius:IETF:Service-Type BELONGS_TO Login-User,Framed-
User,Authenticate-Only
For integer data type, true if the run-time value of the attribute matches a set
of configured integer values.
Example: Radius:IETF:NAS-Port BELONGS_TO 1,2,3
For day data type, true if run-time value of the attribute matches a set of
configured days of the week.
Example: Date:Day-of-Week BELONGS_TO MONDAY,TUESDAY,WEDNESDAY
When Policy Manager is aware of the values that can be assigned to
BELONGS_TO operator, it populates the value field with those values in a
multi-select list box; you can select the appropriate values from the presented
list. Otherwise, you must enter a comma separated list of values.

BELONGS_TO_GROUP For group data types, true if the run-time value of the attribute belongs to the
configured group (either a static host list or a network device group,
depending on the attribute).
Example: Radius:IETF:Calling-Station-Id BELONGS_TO_GROUP
Printers.

CONTAINS For string data type, true if the run-time value of the attribute is a substring of
the configured value.
Example: Radius:IETF:NAS-Identifier CONTAINS "VPN"

ENDS_WITH For string data type, true if the run-time value of the attribute ends with the
configured value.
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Example: Radius:IETF:NAS-Identifier ENDS_WITH "DEVICE"

EQUALS True if the run-time value of the attribute matches the configured value. For
string data type, this is a case-sensitive comparison.
Example: Radius:IETF:NAS-Identifier EQUALS "SJ-VPN-DEVICE"

EQUALS_IGNORE_CASE For string data type, true if the run-time value of the attribute matches the
configured value, regardless of whether the string is upper case or lower
case.
Example: Radius:IETF:NAS-Identifier EQUALS_IGNORE_CASE "sj-
vpn-device"

EXISTS For string data type, true if the run-time value of the attribute exists. This is a
unary operator.
Example: Radius:IETF:NAS-Identifier EXISTS

GREATER_THAN For integer, time and date data types, true if the run-time value of the
attribute is greater than the configured value.
Example: Radius:IETF:NAS-Port GREATER_THAN 10

GREATER_THAN_OR_EQUALS For integer, time and date data types, true if the run-time value of the
attribute is greater than or equal to the configured value.
Example: Radius:IETF:NAS-Port GREATER_THAN_OR_EQUALS 10

IN_RANGE For time and date data types, true if the run-time value of the attribute is less
than or equal to the first configured value and less than equal to the second
configured value.
Example: Date:Date-of-Year IN_RANGE 2007-06-06,2007-06-12

LESS_THAN For integer, time and date data types, true if the run-time value of the
attribute is less than the configured value.
Example: Radius:IETF:NAS-Port LESS_THAN 10

LESS_THAN_OR_EQUALS For integer, time and date data types, true if the run-time value of the
attribute is less than or equal to the configured value.
Example: Radius:IETF:NAS-Port LESS_THAN_OR_EQUALS 10

MATCHES_ALL For list data types, true if all of the run-time values in the list are found in the
configured values.
Example: Tips:Role MATCHES_ALL HR,ENG,FINANCE. In this example, if
the run-time values of Tips:Role are HR,ENG,FINANCE,MGR,ACCT the
condition evaluates to true.
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MATCHES_ANY For list data types, true if any of the run-time values in the list match one of
the configured values.
Example: Tips:Role MATCHES_ANY HR,ENG,FINANCE

MATCHES_EXACT For list data types, true if all of the run-time values of the attribute match all
of the configured values.
Example: Tips:Role MATCHES_ALL HR,ENG,FINANCE. In this example, if
the run-time values of Tips:Role are HR,ENG,FINANCE,MGR,ACCT the
condition evaluates to false, because there are some values in the
configured values that are not present in the run-time values.

MATCHES_REGEX For string data type, true if the run-time value of the attribute matches the
regular expression in the configured value.
Example: Radius:IETF:NAS-Identifier MATCHES_REGEX sj-device[1-
9]-dev*

Applications Dictionaries
Application dictionaries define the attributes of the Onboard Policy Manager application and the type of each
attribute.

When Policy Manager is used as the Policy Definition Point (PDP), it uses the information in these dictionaries
to validate the attributes and data types sent in a WEB-AUTH request.

Viewing an Application Dictionary
To view the contents of the application dictionary:

1. Navigate to Administration > Dictionaries > Applications.

The Applications Dictionaries page opens.

Figure 920 Applications Dictionaries Page

2. To see the application attributes, click the name of an application.

The Application Attributes dialog box opens.
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Figure 921 Application Attributes Page

Deleting an Application Dictionary
In general, there is no need to delete an application dictionary. They have no effect on Policy Manager
performance.

To delete an application dictionary:

1. Navigate to Administration > Dictionaries > Applications.

2. Click the check box next to an application name.

3. Click Delete.
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Introduction	  
With	  the	  release	  of	  ClearPass	  Policy	  Manager	  6.4.0	  in	  August	  2014	  we	  have	  continued	  to	  
build	  on	  our	  previous	  industry	  leading	  functionality,	  now	  with	  the	  CPPM	  6.4.0	  release	  we	  
maintain	  and	  extend	  our	  technology	  lead	  with	  the	  major	  Enterprise	  Mobility	  Management	  
(EMM)	  platforms,	  allowing	  Aruba	  ClearPass	  customers	  to	  extend	  the	  knowledge	  of	  
managed	  device	  state	  (device	  type,	  policy	  compliance	  etc.)	  down	  to	  the	  business	  rules	  that	  
govern	  their	  corporate	  network	  admission	  policies.	  With	  the	  release	  of	  CPPM	  6.4.0	  we	  
added	  support	  for	  SAP’s	  Afaria.	  

For	  example,	  if	  the	  EMM	  platform	  detects	  that	  a	  device	  is	  jailbroken,	  the	  EMM	  platform	  only	  
has	  the	  option	  to	  attempt	  to	  enforce	  the	  business	  policy	  at	  the	  device	  level.	  By	  extending	  
this	  policy	  state	  to	  ClearPass	  as	  the	  network	  policy	  definition	  point,	  the	  jailbreak	  status	  of	  a	  
device	  can	  be	  used	  to	  deny	  access	  or	  quarantine	  this	  device	  the	  next	  time	  it	  attempts	  to	  
connect	  to	  the	  secure	  network.	  

This	  walkthrough	  explains	  the	  details	  of	  the	  current	  integration,	  the	  configuration	  steps	  to	  
establish	  the	  API	  relationship	  between	  ClearPass	  Policy	  Manager	  and	  the	  customer’s	  
chosen	  EMM	  platform	  and	  finally,	  the	  expected	  device	  inventory	  and	  policy	  compliance	  
data	  expected	  from	  each	  EMM	  vendor.	  

Some	  familiarity	  with	  Mobile	  Device	  Management	  concepts	  and	  the	  use	  of	  ClearPass	  Policy	  
Manager’s	  network	  enforcement	  methodology	  are	  assumed	  throughout	  this	  Tech	  Note.	  	  
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EMM	  Integration	  
ClearPass	  Policy	  Manager	  has	  an	  extensible	  database	  for	  tracking	  devices	  attempting	  to	  
connect	  to	  secure	  corporate	  networks.	  The	  devices	  are	  stored	  within	  the	  Endpoints	  table	  
that	  is	  indexed	  on	  a	  unique	  identifier	  for	  each	  device,	  its	  MAC	  Address.	  	  

Typically	  the	  Endpoints	  table	  stores	  only	  basic	  information	  about	  the	  device	  collected	  from	  
RADIUS	  authentication	  transactions	  associated	  with	  its	  usage	  on	  the	  wired	  or	  wireless	  
access	  networks	  as	  shown	  below	  on	  the	  right-‐‑hand-‐‑side.	  In-‐‑depth	  information	  relating	  to	  
the	  device	  posture	  is	  not	  available	  as	  no	  Attribute	  data	  is	  shown	  and	  only	  basic	  information	  
can	  be	  extracted	  such	  as	  the	  OUI	  (first	  3-‐‑bytes	  of	  the	  mac)	  to	  identify	  the	  manufacturer.	  	  

	  
Figure	  1	  -‐‑	  Basic	  endpoint	  smart-‐‑device	  information	  

The	  knowledge	  about	  this	  device	  is	  increased	  through	  the	  use	  of	  ClearPass	  Policy	  
Manager’s	  built-‐‑in	  device	  profiling	  capabilities	  by	  monitoring	  traffic	  patterns	  from	  the	  
device	  as	  it	  attempts	  to	  connect	  to	  the	  network.	  Information	  extracted	  from	  DHCP,	  HTTP	  
packets	  and	  other	  sources	  of	  context	  can	  help	  provide	  additional	  details	  about	  the	  
manufacturer	  and	  class	  of	  device.	  
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Figure	  2	  -‐‑	  Additional	  endpoint	  information	  retrieved	  thru	  DHCP	  fingerprinting	  

However,	  many	  customers	  have	  invested	  in	  EMM	  platforms	  to	  help	  them	  manage	  large	  
rollouts	  of	  corporate	  issued	  smartphones	  or	  tablets.	  These	  EMM	  deployments	  can	  hold	  
additional	  information	  about	  the	  device	  policy	  state	  that	  cannot	  be	  retrieved	  by	  passively	  
monitoring	  network	  traffic	  as	  it	  enters	  the	  corporate	  network.	  

The	  EMM	  integration	  as	  part	  of	  ClearPass	  Policy	  Manager	  6.0.2	  and	  above	  leverages	  the	  
extensive	  dataset	  that	  each	  entry	  in	  the	  Endpoints	  table	  can	  hold,	  by	  adding	  a	  set	  of	  EMM	  
normalized	  data	  tags.	  These	  additional	  data	  tags	  can	  then	  be	  referenced	  in	  enforcement	  
policies	  to	  implement	  various	  business	  rules	  based	  on	  the	  device	  state	  information	  
received	  from	  the	  EMM	  platforms.	  

Below	  we	  show	  an	  example	  of	  the	  additional	  attributes	  that	  can	  be	  integrated	  into	  the	  
ClearPass	  Endpoint	  profiler	  database	  that	  could	  be	  received	  from	  an	  EMM	  vendor.	  Not	  all	  
EMM	  vendors	  expose	  the	  same	  level	  of	  data,	  we	  normalize	  the	  information	  received	  and	  
present	  it	  in	  a	  standard	  attribute	  template.	  

Notice	  no	  
endpoint	  
attributes	  
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Figure	  3	  -‐‑	  Endpoint	  plus	  EMM	  attributes	  
	  

	  
Figure	  4	  -‐‑	  More	  EMM	  attributes	  
	  

	  
Figure	  5	  -‐‑	  Even	  more	  EMM	  attributes	  
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Additionally,	  the	  ClearPass	  EMM	  integration	  updates	  the	  internal	  device	  Profile	  database	  
with	  knowledge	  of	  the	  device	  type	  learned	  from	  the	  configured	  EMM	  platform.	  This	  
valuable	  inventory	  data	  about	  the	  device	  manufacturer,	  its	  hardware	  platform	  type	  and	  
software	  version	  are	  all	  recorded	  in	  the	  ClearPass	  Endpoint	  profiler	  database	  and	  provide	  
the	  definitive	  knowledge	  of	  the	  device	  type	  that	  could	  not	  otherwise	  be	  collected	  from	  
passive	  network	  monitoring.	  This	  level	  of	  detail	  is	  equivalent	  to	  the	  device	  information	  
recovered	  from	  ClearPass’	  own	  Onboard	  device	  provisioning	  and	  OnGuard	  device	  posture	  
assessment	  technologies.	  

Configuration	  of	  EMM	  Vendors	  

From	  the	  Administration	  menu	  of	  ClearPass	  Policy	  Manager,	  a	  new	  menu	  option	  has	  been	  
added	  under	  External	  Servers	  called	  Endpoint	  Context	  Servers,	  under	  6.0.2	  (the	  initial	  
release	  when	  we	  added	  EMM	  support)	  the	  menu	  looks	  like	  the	  below	  screen	  shot.	  

	  
Figure	  6	  -‐‑	  Endpoint	  Context	  Server	  configuration	  for	  CPPM	  v6.0.2	  

Since	  CPPM	  6.1	  the	  configuration	  varies	  slightly,	  in	  that	  under	  the	  Endpoint	  Context	  
Servers,	  you	  can	  now	  define	  multiple	  servers	  and	  these	  will	  now	  operate	  concurrently,	  i.e.	  
multiple	  EMM	  vendors	  can	  be	  configured	  and	  CPPM	  will	  ingest	  data	  from	  more	  than	  one	  
EMM	  vendor.	  As	  previously	  stated	  under	  6.2	  we	  added	  Citrix	  XenMobile,	  in	  6.4.0	  we	  added	  
to	  the	  list	  of	  supported	  EMM	  vendors,	  SAP	  Afaria.	  The	  configuration	  under	  6.1	  &	  6.2	  
requires	  that	  you	  use	  the	  menu	  option	  ‘Add	  Context	  Server’,	  under	  Administration-‐‑>	  
External	  Servers-‐‑>Endpoint	  Context	  Servers	  the	  pop-‐‑up	  box	  below	  show	  the	  current	  full	  
list	  of	  supported	  vendors.	  
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Figure	  7	  -‐‑	  Endpoint	  Context	  Server	  configuration	  for	  CPPM	  v6.4.0	  

Server	  Configuration	  varies	  slightly	  by	  vendor.	  But	  for	  all	  EMM	  partners	  some	  baseline	  
parameter	  are	  required	  such	  as,	  Server	  Name,	  Server	  Base	  URL,	  User	  Name,	  and	  Password.	  
Authentication	  is	  typically	  HTTPS	  authentication.	  

The	  differences	  that	  exist	  in	  addition	  to	  the	  baseline	  options	  discussed	  above	  are:	  

•   AirWatch	  makes	  use	  of	  an	  API	  Key	  
•   MaaS360	  makes	  use	  of	  an	  Application	  Access	  Key,	  Application	  ID,	  Application	  

Version,	  Platform	  ID	  and	  a	  Billing	  ID.	  
•   SOTI	  (sometimes)	  makes	  use	  of	  a	  Group	  ID	  attribute	  

The	  details	  behind	  the	  above	  options	  are	  explained	  further	  in	  the	  section	  titled	  	  
Supported	  EMM	  Vendors.	  

The	  Update	  Frequency	  configuration	  defines	  how	  often	  ClearPass	  Policy	  Manager	  will	  
check	  in	  with	  the	  configured	  EMM	  platform	  to	  retrieve	  any	  new	  managed	  device	  details	  or	  
update	  the	  status	  of	  an	  existing	  managed	  devices.	  Policy	  Manager	  is	  tracking	  the	  changes	  
within	  the	  EMM	  device	  records	  and	  will	  only	  update	  an	  Endpoint	  record	  in	  the	  event	  of	  a	  
change	  in	  device	  inventory	  or	  policy	  state.	  

Note:	  In	  v6.1.0,	  the	  Update	  Frequency	  option	  has	  been	  replaced	  by	  the	  cluster-‐‑wide	  service	  
parameter	  “Endpoint	  Context	  Servers	  polling	  interval”.	  Go	  to	  Administration	  >	  Server	  
Manager	  >	  Server	  Configuration	  and	  click	  on	  Cluster-‐‑Wide	  Parameters.	  

	  
Figure	  8	  -‐‑	  Cluster-‐‑Wide	  Parameters	  
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Figure	  9	  -‐‑	  Endpoint	  Context	  Servers	  polling	  interval	  –	  default	  60	  minutes	  

Typically	  the	  Update	  Frequency	  (Polling	  Interval)	  should	  be	  set	  relative	  to	  the	  device	  
check-‐‑in	  interval	  configured	  on	  the	  EMM	  platform.	  Each	  EMM	  vendor	  will	  have	  a	  different	  
default	  check-‐‑in	  interval	  used	  to	  get	  updated	  status	  information	  from	  the	  devices	  it	  has	  
under	  management.	  This	  check-‐‑in	  interval	  is	  how	  often	  the	  EMM	  agent	  on	  the	  device	  itself	  
connects	  back	  to	  the	  EMM	  server.	  For	  many	  platforms	  this	  could	  be	  4	  hours	  or	  longer,	  so	  
there	  is	  no	  benefit	  to	  having	  an	  aggressive	  polling	  interval	  on	  ClearPass	  as	  the	  data	  
returned	  will	  largely	  be	  the	  same.	  

Note:	  Customers	  are	  recommended	  to	  consult	  their	  chosen	  EMM	  vendor	  on	  the	  best	  update	  
frequency	  based	  on	  their	  deployment	  configuration.	  
	  

Normalized	  Dataset	  

ClearPass	  Policy	  Manager	  communicates	  with	  the	  configured	  EMM	  platform	  via	  their	  
published	  API	  interface.	  Typically	  these	  are	  HTTP	  Based	  API's	  -‐‑	  Typically	  these	  API	  
communications	  are	  defined	  using	  RESTful	  API	  calls	  returning	  XML	  or	  JSON	  output..	  The	  
ClearPass	  integration	  consumes	  these	  XML	  or	  JSON	  outputs,	  which	  are	  very	  specific	  to	  each	  
EMM	  platform,	  and	  normalizes	  their	  output	  to	  a	  common	  set	  of	  Endpoint	  tags	  that	  can	  be	  
added	  to	  the	  ClearPass	  database.	  

By	  normalizing	  the	  output,	  common	  and	  easy	  to	  understand	  enforcement	  policies	  can	  be	  
created	  within	  ClearPass	  without	  the	  need	  for	  the	  administrator	  to	  understand	  the	  
semantics	  of	  the	  EMM	  API	  interface.	  
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The	  following	  table	  shows	  the	  currently	  available	  normalized	  data	  set	  implemented	  by	  the	  
ClearPass	  EMM	  Integration.	  Not	  all	  of	  these	  attributes	  will	  be	  available	  consistently	  from	  
each	  EMM	  platform	  or	  for	  each	  device	  type	  within	  a	  chosen	  EMM	  platform.	  For	  example,	  
the	  Carrier	  attribute	  will	  not	  be	  available	  for	  a	  WiFi	  only	  tablet	  as	  it	  does	  not	  have	  a	  cellular	  
chipset.	  

In	  the	  event	  that	  an	  attribute	  is	  not	  available	  from	  the	  configured	  EMM	  platform	  or	  not	  
supported	  on	  the	  returned	  device	  type,	  the	  ClearPass	  Endpoints	  table	  will	  not	  contain	  a	  
value	  for	  that	  normalized	  attribute.	  

Endpoint  Tag   Tag  Type   Comments  
Manufacturer   Inventory   Manufacture  name  such  as  Apple,  Samsung,  etc.  For  

Activate  will  always  be  “Aruba  Networks”  

Model   Inventory   Model  name  such  as  iPad,  DROID  X,  etc.  with  
extraneous  sub-model  info  removed.  

OS  Version   Inventory   Version  number  such  as  iOS  6.1,  Android  4.0,  etc.  
Minor  version  numbers  are  removed  so  that  6.1.1  
becomes  6.1.  

UDID   Inventory   Device  unique  identifier  

Serial  Number   Inventory   Device  serial  number  

IMEI   Inventory   Cellular  only  devices  

Phone  Number   Inventory   Cellular  only  devices  

Carrier   Inventory   Cellular  only  devices  

Owner   Inventory   Registered  enterprise  username  

Display  Name   Inventory   Full  name  of  registered  owner  

Description   Inventory   Display  a  description  of  the  device.  

Source   Inventory   Display  which  EMM  vendor  supplied  the  device  details  

Ownership   Inventory   “Corporate”  or  “Employee”  

EMM  Identifier   Inventory   Internal  identifier  used  by  EMM  API  interface.  This  
varies  between  EMM  vendors.  

Compromised   Policy   “True”  or  “False”.  Jail  broken  device  or  Root-kit  
detected.  

Encryption  Enabled   Policy   Device  level  encryption  status  

Blacklisted  App   Policy   “True”  or  “False”.  A  blacklisted  app  is  installed  on  the  
device.  

Required  App   Policy   “True”  or  “False”.  A  required  corporate  app  is  missing  
from  the  device.  

EMM  Enabled   Policy   “True”  or  “False”.  The  device  is  under  EMM  
management.  

Last  Check  In   Policy   Last  time  the  device  last  checked  in  to  EMM  server  
	  
Figure	  10	  -‐‑	  List	  of	  all	  possible	  normalized	  attributes	   	  
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Using	  EMM	  Data	  for	  Network	  Enforcement	  

Once	  the	  EMM	  integration	  is	  configured	  and	  device	  data	  is	  being	  populated	  to	  the	  
Endpoints	  and	  Profile	  databases	  within	  ClearPass,	  this	  information	  can	  be	  used	  to	  enforce	  
various	  business	  rules	  on	  how	  these	  corporate	  managed	  devices	  are	  admitted	  on	  to	  the	  
network.	  

Given	  EMM	  platforms	  are	  largely	  focused	  on	  smartphone	  and	  tablet	  devices,	  the	  network	  of	  
interest	  is	  typically	  limited	  to	  WiFi	  connectivity.	  The	  following	  examples	  provide	  some	  
guidance	  on	  how	  to	  leverage	  the	  EMM	  data	  to	  change	  the	  way	  these	  mobile	  devices	  are	  
admitted	  onto	  a	  corporate	  WiFi	  network.	  

Endpoint	  Data	  
The	  data	  retrieved	  from	  the	  EMM	  platform	  and	  stored	  in	  the	  Endpoints	  table	  as	  additional	  
tags	  contains	  both	  inventory	  data	  and	  policy	  state	  information.	  Therefore,	  an	  incredibly	  
rich	  set	  of	  business	  rules	  can	  be	  enforced	  on	  the	  corporate	  network	  as	  it	  relates	  to	  the	  
device	  type,	  ownership,	  compromised	  status,	  and	  the	  impact	  of	  Apps	  that	  are	  installed	  or	  
missing,	  just	  to	  name	  a	  few.	  The	  following	  sample	  business	  rules	  included	  below	  illustrate	  
how	  the	  EMM	  data	  included	  in	  the	  Endpoints	  table	  can	  be	  used	  to	  enforce	  network	  policy	  
decisions	  and	  control	  the	  way	  these	  devices	  are	  admitted	  onto	  the	  network.	  
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Jail	  broken	  or	  Rooted-‐Device	  Detected	  
A	  common	  used	  case	  of	  EMM	  platforms	  is	  to	  leverage	  the	  presence	  of	  the	  EMM	  agent	  (App)	  
to	  attempt	  to	  detect	  if	  a	  device	  has	  been	  jail	  broken	  (Apple	  iOS	  devices)	  or	  a	  root-‐‑kit	  
installed	  (Android).	  This	  status	  of	  the	  device	  being	  compromised	  is	  reported	  by	  the	  EMM	  
agent	  back	  to	  the	  EMM	  server	  either	  during	  a	  regular	  check-‐‑in	  interval	  or	  as	  an	  alert	  
message	  and	  will	  then	  be	  reflected	  in	  the	  ClearPass	  Endpoints	  table	  via	  the	  API	  integration.	  

A	  device	  being	  compromised	  will	  often	  result	  in	  the	  IT	  administrator	  being	  less	  trusting	  of	  
the	  device	  and	  depending	  on	  the	  local	  security	  policy	  may	  result	  in	  a	  reduced	  level	  of	  
network	  access	  or	  complete	  quarantining	  of	  the	  device.	  ClearPass’	  rich	  policy	  enforcement	  
allows	  the	  administrator	  to	  chose	  how	  these	  compromised	  devices	  should	  be	  handled	  the	  
next	  time	  the	  user	  attempts	  to	  connect	  to	  the	  enterprise	  network.	  The	  following	  
enforcement	  policy	  example	  shows	  how	  the	  Endpoint	  Compromised	  data	  tag	  is	  being	  
referenced	  whenever	  a	  device	  attempts	  to	  connect	  to	  the	  enterprise	  network.	  	  

	  
Figure	  11	  -‐‑	  Enforcement	  Policy	  –	  Endpoint	  compromised	  

In	  the	  event	  that	  this	  flag	  is	  set	  to	  True	  by	  the	  configured	  EMM	  platform,	  then	  the	  network	  
enforcement	  profile	  applied	  will	  result	  in	  the	  device	  being	  placed	  in	  a	  quarantine	  state.	  This	  
is	  achieved	  by	  ClearPass	  informing	  the	  Aruba	  controller	  to	  redirect	  the	  access	  attempt	  to	  a	  
captive	  portal	  page	  informing	  the	  user	  of	  their	  breach	  of	  network	  access	  policy.	  
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Figure	  12	  -‐‑	  Enforcement	  Profile	  –	  redirect	  for	  Jailbreak/rooted	  devices	  
	  

	  
Figure	  13	  -‐‑	  Captive	  portal	  Jailbreak	  detection	  warning	  
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Blacklisted	  App	  Detected	  
Several	  EMM	  platforms	  have	  the	  ability	  to	  build	  compliance	  policies	  around	  the	  Apps	  that	  
have	  been	  installed	  on	  a	  smartphone	  or	  tablet.	  This	  is	  possible	  because	  the	  EMM	  platform	  
will	  harvest	  the	  entire	  list	  of	  Apps	  that	  have	  been	  installed	  on	  the	  device	  and	  track	  them	  on	  
an	  ongoing	  basis.	  This	  is	  a	  key	  reason	  why	  EMM	  is	  more	  appropriate	  for	  corporate	  issued	  
devices	  where	  there	  are	  no	  privacy	  concerns	  about	  personally	  installed	  Apps	  that	  is	  often	  
the	  case	  in	  a	  BYOD	  environment.	  

As	  part	  of	  the	  EMM	  compliance	  policy,	  a	  list	  of	  Blacklisted	  Apps	  can	  be	  defined	  and	  during	  a	  
device	  check-‐‑in,	  if	  one	  of	  these	  Apps	  is	  installed	  on	  the	  device,	  the	  compliance	  state	  can	  be	  
triggered.	  The	  EMM	  integration	  with	  ClearPass	  does	  not	  recover	  the	  details	  of	  the	  Apps	  
installed	  on	  the	  device,	  but	  instead	  recognizes	  that	  the	  EMM	  has	  detected	  the	  presence	  of	  a	  
Blacklisted	  App	  by	  the	  EMM	  internal	  compliance	  policy.	  This	  allows	  ClearPass	  to	  maintain	  
its	  BYOD	  friendly	  approach,	  which	  is	  central	  to	  its	  Onboard	  provisioning	  solution,	  by	  
avoiding	  any	  potential	  violation	  of	  the	  end	  user	  privacy	  through	  personal	  App	  visibility.	  

The	  following	  enforcement	  policy	  example	  shows	  how	  the	  Endpoint	  Blacklist	  App	  data	  tag	  
is	  being	  referenced	  whenever	  a	  device	  attempts	  to	  connect	  to	  the	  enterprise	  network.	  

	  
Figure	  14	  -‐‑	  Enforcement	  Policy	  –	  Blacklisted	  App	  
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In	  the	  event	  that	  this	  flag	  is	  set	  to	  True	  by	  the	  configured	  EMM	  platform,	  then	  the	  network	  
enforcement	  profile	  applied	  will	  result	  in	  the	  device	  being	  redirected	  to	  a	  Blacklisted	  App	  
portal	  informing	  the	  user	  of	  their	  breach	  of	  network	  access	  policy.	  Optionally	  the	  device	  
could	  be	  restricted	  network	  access,	  such	  as	  only	  to	  the	  Internet.	  

	  
Figure	  15	  -‐‑	  Enforcement	  Profile	  –	  redirect	  for	  Blacklisted	  App	  

Corporate	  Issued	  vs.	  Employee	  Liable	  Device	  
Many	  EMM	  platforms	  allow	  the	  administrator	  to	  define	  the	  ownership	  type	  of	  each	  device	  
taken	  under	  management.	  Corporate-‐‑owned	  or	  Employee-‐‑owned	  device	  types	  are	  tracked	  
and	  can	  be	  reported	  to	  ClearPass	  via	  the	  API	  integration.	  

Some	  customers	  may	  wish	  to	  leverage	  this	  knowledge	  of	  corporate	  issued	  devices	  and	  an	  
associated	  rollout	  of	  a	  corporate	  application	  to	  change	  the	  way	  that	  device	  accesses	  the	  
network.	  

The	  following	  enforcement	  policy	  example	  shows	  how	  the	  Endpoint	  Ownernship	  data	  tag	  is	  
being	  referenced	  whenever	  a	  device	  attempts	  to	  connect	  to	  the	  enterprise	  network.	  	  
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Figure	  16	  -‐‑	  Enforcement	  Policy	  –	  Corporate	  device	  

	  
In	  the	  event	  that	  this	  flag	  is	  set	  to	  Corporate	  by	  the	  configured	  EMM	  platform,	  then	  the	  
network	  enforcement	  profile	  applied	  will	  result	  in	  the	  device	  being	  placed	  in	  the	  corporate	  
access	  role	  which	  grants	  access	  to	  specific	  application	  servers	  and	  also	  enables	  a	  high	  level	  
of	  Quality	  of	  Service	  (QoS)	  for	  these	  applications.	  Alternatively,	  if	  the	  flag	  is	  set	  to	  
Employee,	  the	  network	  enforcement	  profile	  applied	  will	  restrict	  access	  to	  only	  essential	  
internal	  resources	  and	  apply	  a	  best	  effort	  QoS	  profile	  for	  the	  user.	  

	  
Figure	  17	  -‐‑	  Enforcement	  Profile	  –	  Corporate	  device	  
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EMM	  Agent	  Removed	  
A	  common	  scenario	  in	  many	  EMM	  deployments	  occurs	  when	  a	  user	  either	  purposely	  (to	  
avoid	  corporate	  monitoring)	  or	  by	  accident	  removes	  the	  EMM	  agent	  or	  profile	  from	  their	  
device.	  This	  results	  in	  the	  device	  management	  communication	  channels	  being	  severed	  and	  
the	  ability	  for	  the	  EMM	  platform	  to	  enforce	  policy	  to	  be	  become	  marginalized.	  	  

The	  ability	  for	  ClearPass	  to	  learn	  via	  the	  API	  integration	  that	  the	  device	  is	  no	  longer	  under	  
management	  allows	  the	  administrator	  to	  differentiate	  this	  device	  the	  next	  time	  it	  attempts	  
to	  access	  the	  enterprise	  network	  and	  redirect	  it	  back	  to	  the	  device	  management	  portal	  for	  
re-‐‑provisioning.	  

The	  following	  enforcement	  policy	  example	  shows	  how	  the	  Endpoint	  EMM	  Enabled	  data	  tag	  
is	  being	  referenced	  whenever	  a	  device	  attempts	  to	  connect	  to	  the	  enterprise	  network.	  	  	  

	  
Figure	  18	  -‐‑	  BYOD	  enforcement	  –	  endpoint	  EMM	  managed	  

In	  the	  event	  that	  this	  flag	  is	  set	  to	  False	  by	  the	  configured	  EMM	  platform,	  then	  the	  network	  
enforcement	  profile	  applied	  will	  result	  in	  the	  device	  being	  placed	  in	  a	  quarantine	  state	  and	  
redirected	  to	  the	  device	  management	  provisioning	  page.	  This	  results	  in	  the	  user	  being	  
forced	  to	  comply	  with	  the	  corporate	  policy	  and	  place	  the	  device	  back	  under	  management	  if	  
they	  wish	  to	  access	  any	  corporate	  resources,	  without	  any	  manual	  intervention	  from	  the	  IT	  
helpdesk	  staff.	  	  	  	  
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Profile	  Data	  
The	  data	  retrieved	  from	  the	  EMM	  platform	  and	  stored	  in	  the	  Profile	  database	  table	  consists	  
of	  a	  dataset	  made	  up	  of	  Device	  Category,	  OS	  Family	  and	  Device	  Name	  as	  shown	  in	  the	  
screenshot	  below.	  

	  
Figure	  19	  -‐‑	  Profile	  database	  info	  

The	  inventory	  data	  available	  from	  the	  EMM	  platforms	  allows	  for	  explicit	  device	  type	  
knowledge	  such	  as	  the	  Samsung	  device	  listed	  above.	  Alternatively,	  relying	  solely	  on	  
passively	  collected	  network	  data	  would	  result	  in	  the	  device	  only	  being	  seen	  as	  a	  generic	  
Android	  device	  manufactured	  by	  Samsung.	  

The	  following	  sample	  business	  rules	  included	  below	  illustrate	  how	  the	  EMM	  data	  included	  
in	  the	  device	  Profile	  database	  can	  be	  used	  to	  enforce	  network	  policy	  decisions	  and	  control	  
the	  way	  these	  devices	  are	  admitted	  onto	  the	  network.	  
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iPad	  vs	  iPhone/iPod	  Network	  Access	  
Small	  screen	  devices	  are	  not	  always	  appropriate	  for	  the	  roll	  out	  of	  some	  corporate	  
applications.	  For	  example,	  if	  a	  customer	  had	  deployed	  a	  corporate	  application	  that	  is	  
designed	  to	  be	  accessed	  via	  a	  VDI	  solution	  such	  as	  Citrix	  Receiver,	  the	  administrator	  may	  
wish	  to	  restrict	  use	  to	  iPad	  devices	  to	  take	  advantage	  of	  the	  larger	  screen.	  Having	  
knowledge	  of	  the	  class	  of	  device	  as	  it	  connects	  to	  the	  network	  and	  being	  able	  to	  
differentiate	  iPads	  allows	  the	  administrator	  to	  open	  up	  access	  to	  the	  Citrix	  server	  farm	  and	  
potentially	  provide	  differentiated	  QoS	  for	  the	  Citrix	  ICA	  traffic.	  

The	  following	  enforcement	  policy	  example	  shows	  how	  the	  Profiler	  Model	  attribute	  is	  being	  
referenced	  whenever	  a	  device	  attempts	  to	  connect	  to	  the	  enterprise	  network.	  	  

	  
Figure	  20	  -‐‑	  Network	  Enforcement	  –	  Device	  Model	  type	  

In	  the	  event	  that	  this	  attribute	  contains	  a	  reference	  to	  iPad	  as	  configured	  by	  the	  EMM	  
platform,	  then	  the	  network	  enforcement	  profile	  applied	  will	  result	  in	  the	  device	  being	  
placed	  in	  the	  corporate	  access	  role	  which	  grants	  access	  to	  the	  Citrix	  application	  servers	  and	  
also	  enables	  a	  high	  level	  of	  Quality	  of	  Service	  (QoS)	  for	  these	  applications.	  Alternatively,	  if	  
this	  attribute	  does	  not	  include	  a	  reference	  to	  iPad	  as	  the	  device	  name,	  the	  network	  
enforcement	  profile	  applied	  will	  restrict	  access	  to	  only	  essential	  internal	  resources	  and	  
apply	  a	  best	  effort	  QoS	  profile.	  
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Quarantine	  Device	  Type	  
It	  has	  become	  a	  regular	  occurrence	  that	  vulnerabilities	  are	  being	  discovered	  on	  smart	  
phones	  and	  tablets.	  The	  open	  source	  nature	  of	  the	  Android	  operating	  system	  has	  provided	  
a	  rich	  environment	  for	  potential	  vulnerabilities	  to	  be	  exposed	  and	  being	  able	  to	  classify	  
devices	  at	  a	  granular	  level	  allows	  for	  administrators	  to	  quickly	  put	  in	  place	  quarantine	  
rules	  in	  the	  event	  of	  a	  targeted	  exposure	  being	  discovered.	  

For	  example	  in	  early	  2012,	  a	  vulnerability	  in	  a	  range	  of	  HTC	  smartphones	  was	  discovered	  
where	  enterprise	  802.1x	  credentials	  could	  be	  recovered	  from	  the	  operating	  system	  from	  a	  
rouge	  application	  and	  potentially	  published	  remotely	  via	  standard	  Internet	  access.	  	  

Leveraging	  the	  EMM	  inventory	  data,	  ClearPass	  can	  clearly	  differentiate	  between	  Android	  
devices	  from	  different	  manufacturers	  such	  as	  Samsung,	  HTC	  and	  Motorola	  and	  moreover	  
leverage	  knowledge	  of	  individual	  model	  types	  of	  devices	  if	  such	  a	  granular	  policy	  is	  needed.	  	  

The	  following	  enforcement	  policy	  example	  shows	  how	  the	  Profiler	  Device	  Name	  attribute	  is	  
being	  referenced	  whenever	  a	  device	  attempts	  to	  connect	  to	  the	  enterprise	  network.	  	  

	  
Figure	  21	  -‐‑	  Network	  Enforcement	  –	  device	  name	  

In	  the	  event	  that	  this	  attribute	  contains	  a	  reference	  to	  HTC	  as	  configured	  by	  EMM	  platform,	  
then	  the	  network	  enforcement	  profile	  applied	  will	  result	  in	  the	  device	  being	  placed	  in	  a	  
quarantine	  state	  and	  redirected	  to	  a	  captive	  portal	  page	  informing	  the	  user	  of	  the	  potential	  
vulnerability	  on	  their	  device	  and	  advise	  on	  remediation	  steps	  via	  software	  upgrade.	  For	  
more	  information	  on	  this	  vulnerability,	  please	  refer	  to	  the	  following	  article.	  
http://www.kb.cert.org/vuls/id/763355	  
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Managing	  Endpoint	  Data	  
The	  data	  received	  from	  EMM	  vendors	  is	  normalized	  and	  stored	  into	  the	  Endpoint	  database	  
can	  be	  accessed	  from	  the	  ClearPass	  Configuration	  >	  Identity	  >	  Endpoints	  menu	  option.	  

Using	  the	  Endpoint	  information	  in	  the	  Endpoint	  Database	  you	  can	  query	  the	  ingested	  
endpoint	  information	  using	  the	  following	  options.	  

Note:	  A	  filter	  can	  be	  created	  within	  the	  Endpoint	  database	  to	  restrict	  the	  view	  of	  endpoints	  
to	  only	  those	  populated	  via	  the	  selected/preferred	  EMM	  platforms.	  

	  
Figure	  22	  –	  Example	  of	  Endpoint	  device	  list	  

It’s	  important	  you	  configure	  the	  Filter	  in	  the	  following	  fashion.	  

•   Filter	  =	  ’Attribute’	  
•   Equals	  =	  ’Source’	  
•   Contains	  =	  ’as	  shown	  in	  the	  table	  below’	  

	  
	  

Vendor   MobileIron   AirWatch   SOTI   JAMF   MaaS360   XenMobile   SAP  

Use  this  value  
in  the  Contains  
field  

MI   AIRWATCH   SOTI   JAMF   M360   XenMobile   SAP  
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Supported	  EMM	  Vendors	  s/w	  Versions	  

Below	  are	  the	  current	  EMM	  vendors	  supported	  and	  the	  version	  of	  ClearPass	  in	  which	  their	  
support	  first	  appeared.	  Other	  vendors	  may	  be	  added	  depending	  on	  the	  market	  dynamics	  
and	  the	  demand	  from	  the	  field.	  In	  addition,	  though	  not	  an	  EMM	  solution,	  Aruba	  Activate	  
support	  is	  provided	  to	  obtain	  device	  information	  about	  registered	  access	  points.	  

EMM  Vendors   Minimum  
Software  
Release  

Latest  
Software  
Tested  

ClearPass  
Version  

AirWatch   6.2   7.3.0.400   6.0.2  or    la ter   

F iberL ink  MaaS360   4.0   Latest   C loud   6.0.2  or    la ter   

JAMF  Casper  Sui te    8 .5   9.4.28064.se   6.0.2  or    la ter   

Mobi l ie I ron  VSP   4.5.3   6.0   6.0.2  or    la ter   

SOTI  MobiContro l    9 .03   11.01.14221   6.0.2  or    la ter   

C i t r ix   XenMobi le    8 .5    8.6.0   (9 .0)    6 .2 .0  or    la ter   

SAP  Afar ia    7 .0  SP4   7.0  SP4   6.4.0  or    la ter   

B lackBerry       BES10   BES10   6.4.0  or    la ter   
	  
Figure	  23	  –	  Supported	  EMM	  Vendor	  software	  levels	  

Enable	  /	  Disable	  Individual	  MDM	  Context	  Servers	  
In	  CPPM	  6.4,	  we	  added	  the	  ability	  to	  effectively	  disable	  or	  enable	  a	  Context	  Server.	  When	  
adding	  context-‐‑severs	  they	  are	  enabled,it	  may	  be	  pertinent	  to	  disable	  the	  server	  for	  testing.	  

Note:	  Only	  one	  server	  for	  a	  particular	  EMM	  vendor	  can	  be	  active/enabled	  at	  the	  same	  time.	  
Using	  this	  feature	  allow	  you	  to	  define	  multiple	  say	  MobileIron	  context	  servers,	  with	  one	  
active	  and	  one	  disabled	  as	  required.	  

Note:	  When	  adding	  new	  Context	  servers	  in	  CPPM	  6.4+	  you	  need	  to	  specifically	  ‘enable’	  the	  
context	  server	  as	  highlighted	  below.	  
	  

	  

	  

	  

	  

	  
Figure	  24	  -‐‑	  Enabling/Disabling	  Context	  Servers	  	   	  
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AirWatch	  (Acquired	  by	  VMware	  in	  January	  2014)	  
To	  configure	  the	  AirWatch	  connector,	  enter	  a	  hostname	  into	  the	  “Server	  Name”	  field.	  This	  
hostname	  can	  be	  derived	  as	  shown	  in	  the	  next	  paragraph.	  You	  typically	  do	  not	  need	  to	  alter	  
the	  “Server	  Base	  URL”.	  The	  API	  Key	  can	  be	  found	  in	  the	  location	  described	  later	  in	  this	  
section.	  

	  
Figure	  25	  -‐‑	  AirWatch	  Context	  Server	  configuration	  screen	  

Note:	  We	  have	  seen	  that	  AirWatch	  instances	  can	  be	  referenced	  proceeding	  with	  either	  ‘as’	  
or	  ‘cn’	  characters,	  i.e.	  asXXX.awEMM.com	  or	  cnXXX.awEMM.com.	  	  
Note:	  The	  EMM	  instances	  that	  begin	  with	  cnXXX	  typically	  do	  not	  support	  the	  API	  interface	  
required	  for	  CPPM	  to	  extract	  information	  from	  the	  EMM	  instance.	  
	  
A	  foolproof	  way	  to	  determine	  the	  appropriate	  value	  for	  “Server	  Name”	  is	  to	  look	  in	  the	  
AirWatch	  portal	  configuration	  under	  Menu	  >	  System	  Configuration	  >	  System	  >	  
Advanced	  >	  Site	  URLs.	  The	  value	  required	  for	  “Server	  Name”	  is	  the	  hostname	  portion	  of	  
the	  value	  in	  the	  field	  “REST	  API	  URL”.	  

	  
Figure	  26	  -‐‑	  AirWatch	  server	  name	  

AirWatch	  utilizes	  a	  variable	  called	  the	  API	  Key.	  This	  is	  configured	  within	  the	  AirWatch	  
portal,	  and	  must	  be	  enabled	  for	  CPPM	  to	  authenticate	  itself	  with	  AirWatch.	  

In	  the	  AirWatch	  portal,	  go	  to	  Menu	  >	  System	  >	  Advanced	  >	  API	  >	  REST	  API	  as	  shown	  
below	  and	  click	  the	  “Enable	  API	  Access”	  checkbox.	  This	  API	  key	  is	  leveraged	  by	  the	  EMM	  
Integration	  API	  calls	  between	  CPPM	  and	  AirWatch	  to	  provide	  an	  additional	  level	  of	  
authentication	  over	  and	  above	  the	  basic	  HTTP	  authentication	  of	  Username	  and	  Password.	  
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Figure	  27	  -‐‑	  AirWatch	  portal	  configuration	  

The	  account	  you	  use	  for	  API	  access	  must	  have	  either	  a	  role	  of	  System	  Administrator	  or	  
API	  Full	  Access.	  The	  role	  can	  be	  changed	  by	  creating	  an	  administrator-‐‑type	  account	  (under	  
Menu	  >	  Accounts	  >	  Administrators)	  and	  setting	  the	  role	  on	  the	  Roles	  tab.	  

	  
Figure	  28	  -‐‑	  Enable	  AirWatch	  admin	  account	  for	  API	  access	  

Finally	  to	  allow	  CPPM	  to	  ‘communicate’	  with	  AirWatch,	  the	  admin	  account	  you’re	  using	  
must	  be	  enabled	  to	  support	  HTTP	  authentication	  for	  API	  access	  to	  the	  Air-‐‑Watch	  EMM	  
platform.	  

	  
Figure	  29	  -‐‑	  Enable	  AirWatch	  admin	  account	  for	  Basic	  Authentication	  
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AirWatch	  Endpoint	  Attributes	  
The	  CPPM	  EMM	  service	  will	  normalize	  data	  received	  from	  AirWatch	  in	  the	  Endpoint	  
identity	  database.	  The	  table	  below	  shows	  the	  normalized	  data	  attributes	  that	  are	  available	  
from	  AirWatch.	  If	  there	  are	  specific	  normalized	  values,	  those	  are	  also	  shown	  in	  the	  table.	  

	  

	  
Figure	  30	  -‐‑	  AirWatch	  Endpoints	  Attributes	  

	  

Endpoint  Tag   Tag  
Type  

Specific  Values  

Manufacturer   Inventory     

Model   Inventory     

OS  Version   Inventory     

UDID   Inventory     

Serial  Number   Inventory     

Phone  Number   Inventory     

Description   Inventory     

Source   Inventory   AirWatch  

Ownership   Inventory   Corporate/Employee/Shared  

EMM  Identifier   Inventory     

Compromised   Policy   True  or  False  

Encryption  Enabled   Policy   True  or  False  

EMM  Enabled   Policy   True  or  False  

Last  Check  In   Policy     

Required  Application   Policy   False/Installed/Missing  

Blacklisted  Application   Policy   True  or  False  
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JAMF	  Configuration	  
To	  configure	  the	  JAMF	  connector,	  enter	  a	  hostname	  into	  the	  “Server	  Name”	  field.	  This	  is	  
typically	  jss.jamfcloud.com	  for	  cloud-‐‑hosted	  deployments.	  On	  premises	  installations	  will	  
differ	  and	  will	  most	  likely	  be	  the	  local	  server’s	  hostname.	  For	  the	  “Server	  Base	  URL”,	  you	  
will	  most	  likely	  have	  to	  add	  on	  your	  customer	  name	  or	  other	  identifier	  to	  form	  the	  
complete	  URL.	  The	  value	  in	  the	  ‘Server	  Base	  URL’	  field	  should	  be	  the	  same	  URL	  used	  to	  
access	  your	  JAMF	  console.	  

	  
Figure	  31	  -‐‑	  JAMF	  Context	  Server	  configuration	  screen	  

Note:	  Starting	  in	  CPPM	  6.2.0	  we	  added	  the	  ability	  to	  ingest	  Computer	  in	  addition	  to	  the	  
existing	  smart-‐‑devices	  that	  are	  under	  JAMF	  management.	  To	  enable	  this	  feature	  select	  the	  
‘Fetch	  Computer	  Records’	  option	  as	  shown	  above	  in	  the	  JAMF	  endpoint	  definition.	  
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JAMF	  Endpoint	  Attributes	  
The	  CPPM	  EMM	  service	  will	  normalize	  data	  received	  from	  JAMF	  into	  the	  Endpoint	  
database.	  The	  table	  below	  shows	  the	  normalized	  data	  attributes	  that	  are	  available	  from	  
JAMF,	  any	  specific	  attributes	  are	  noted	  below.	  	  

Endpoint  Tag   Tag  Type   Specific  Values  
Model   Inventory     

OS  Version   Inventory     

UDID   Inventory     

Serial  Number   Inventory     

Ownership   Inventory     

Source   Inventory   JAMF  

IMEI      Inventory   Field  only  shown  for  Smartphones  

Phone  Number   Inventory   Shown  even  for  Computers  

Display  Name   Inventory     

EMM  Identifier   Inventory     

EMM  Enabled   Policy   True  or  False  

Compromised   Policy   True  or  False  

Encryption  Enabled   Policy   True  or  False  

Blacklisted  App   Policy   True  or  False  

Required  Application   Policy   False/Installed/Missing  

Last  Check  In   Policy     
	  
Figure	  32	  -‐‑	  JAMF	  Endpoints	  Attributes	  

Note:	  While	  the	  EMM	  vendor	  does	  not	  report	  the	  Manufacturer,	  DHCP	  fingerprinting	  can	  
be	  used	  to	  provide	  this.	  
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MaaS360	  Configuration	  (Acquired	  by	  IBM	  in	  December	  2013)	  
To	  configure	  the	  MaaS360	  connector,	  you	  will	  need	  a	  considerable	  amount	  of	  information.	  
To	  start,	  enter	  a	  hostname	  into	  the	  “Server	  Name”	  field.	  This	  is	  typically	  
services.fiberlink.com.	  You	  should	  not	  need	  to	  alter	  the	  “Server	  Base	  URL”.	  See	  the	  
following	  paragraph	  for	  an	  explanation	  of	  the	  additional	  values	  required.	  

	  
Figure	  33	  -‐‑	  MaaS360	  Context	  Server	  configuration	  screen	  

	  
MaaS360	  utilizes	  multiple	  attributes	  over	  and	  above	  basic	  HTTP	  authentication	  as	  shown	  
above.	  The	  following	  inputs	  will	  need	  to	  be	  configured	  inside	  of	  ClearPass.	  

•   Application	  Access	  Key:	  <Obtained from MaaS360>	  
•   App	  ID	  (for	  App	  authorized	  to	  use	  MaaS360	  services):	  <your-network-

domain.com>	  
•   App	  Version:	  1.0	  
•   Platform	  ID:	  3	  
•   Billing	  ID:	  <Your MaaS360 ID>	  

Most	  of	  the	  above	  details	  will	  be	  supplied	  by	  Fiberlink,	  however	  your	  Billing	  ID	  is	  visible	  in	  
the	  footer	  of	  your	  MaaS360	  portal	  page	  (	   labeled	  Account	  #)	  as	  shown	  below.	  
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MaaS360	  Endpoint	  Attributes	  
The	  CPPM	  EMM	  service	  will	  normalize	  data	  received	  from	  MaaS360	  in	  the	  Endpoint	  
identity	  database.	  The	  table	  below	  shows	  the	  normalized	  data	  attributes	  that	  are	  available	  
from	  MaaS360.	  If	  there	  are	  specific	  normalized	  values,	  those	  are	  also	  shown	  in	  the	  table.	  

Endpoint  Tag   Tag  
Type  

Specific  Values  

Manufacturer   Inventory     

Model   Inventory     

OS  Version   Inventory     

Phone  Number   Inventory     

Source   Inventory   MaaS360  

Owner   Inventory     

UDID   Inventory     

IMEI   Inventory     

Display  Name   Inventory     

Ownership   Inventory     

EMM  Identifier   Inventory     

Last  Check  In   Policy     

Compromised   Policy   True  or  False  

Blacklisted  App   Policy   True  or  False  

Required  Apps   Policy   False/Installed/Missing  

Encryption  Enabled   Policy   True  or  False  
	  
Figure	  34	  -‐‑	  Maas360	  Endpoints	  Attributes	  

Note:	  Not	  all	  endpoint	  attributes	  are	  available	  for	  all	  OS	  types.	  
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MobileIron	  Configuration	  
To	  configure	  the	  MobileIron	  connector,	  enter	  a	  hostname	  into	  the	  “Server	  Name”	  field.	  This	  
is	  typically	  m.mobileiron.net	  for	  cloud-‐‑based	  deployments.	  On	  premises	  installations	  will	  
differ	  and	  will	  most	  likely	  be	  the	  local	  server’s	  FQDN.	  For	  the	  “Server	  Base	  URL”,	  you	  will	  
most	  likely	  have	  to	  append	  your	  customer	  name	  or	  other	  identifier	  to	  form	  the	  complete	  
Server	  Base	  URL.	  	  	  

Note:	  Use	  the	  following	  URL	  https://trust.mobileiron.com	  to	  check	  the	  service	  status	  of	  the	  
MobileIron	  global	  system	  operations.	  You	  can	  also	  subscribe	  to	  updates	  from	  this	  portal.	  
	  
	  
	  
	  
	  
	  

	  
	  
	  
Figure	  35	  -‐‑	  MobileIron	  Context	  Server	  configuration	  screen.	  
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MobileIron	  Endpoint	  Attributes	  
The	  CPPM	  EMM	  service	  will	  normalize	  data	  received	  from	  MobileIron	  in	  the	  Endpoint	  
identity	  database.	  The	  table	  below	  captures	  the	  normalized	  data	  attributes	  from	  MI.	  	  

Endpoint  Tag   Tag  Type   Specific  Values  

Manufacturer   Inventory     

Model   Inventory     

OS  Version   Inventory     

UDID   Inventory   See  Note  

Serial  Number   Inventory   See  Note  

IMEI   Inventory     

Phone  Number   Inventory     

Carrier   Inventory     

Source   Inventory   MobileIron  

Owner   Inventory     

Display  Name   Inventory     

Ownership   Inventory     

EMM  Identifier   Inventory     

Compromised   Policy   True  or  False  

Encryption   Policy   True  or  False  

Blacklisted  App   Policy   True  or  False  

Required  App   Policy   Installed/False/Missing  

EMM  Enabled   Policy   True  or  False  

Last  Check  In   Policy     
	  
Figure	  36	  -‐‑	  MobileIron	  Endpoints	  Attributes	  

Note:	  UDID	  and	  Serial	  Number	  are	  only	  available	  for	  IOS	  devices.	  
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SOTI	  Configuration	  
To	  configure	  the	  SOTI	  connector,	  enter	  a	  hostname	  into	  the	  “Server	  Name”	  field.	  This	  is	  
typically	  XXXX.mobicontrolcloud.com	  for	  cloud-‐‑based	  deployments.	  The	  XXXX	  portion	  
will	  be	  your	  specific	  customer	  name	  or	  other	  identifier.	  On	  premises	  installations	  will	  differ	  
and	  will	  most	  likely	  be	  the	  local	  server’s	  hostname.	  The	  “Server	  Name”	  field	  should	  be	  the	  
same	  hostname	  you	  use	  to	  access	  your	  MobiControl	  console.	  No	  changes	  are	  required	  to	  
the	  “Server	  Base	  URL”	  which	  will	  be	  populated	  from	  you	  adding	  the	  Server	  Name.	  

	  
Figure	  37	  -‐‑	  SOTI	  Context	  Server	  configuration	  screen	  

You	  may	  have	  been	  provided	  with	  a	  Group	  ID	  from	  SOTI.	  If	  you	  don’t	  have	  a	  Group	  ID,	  leave	  
the	  field	  blank.	  However,	  on	  CPPM	  v6.0.2	  the	  Group	  ID	  field	  is	  mandatory,	  just	  enter	  
“0000000000”	  (that’s	  ten	  zeros).	  

	   	  

Anexo 07 ITEM 01 (0592516)         SEI 0008478-63.2018.6.02.8000 / pg. 2064



ClearPass	  6.x	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	   Tech	  Note:	  ClearPass	  and	  EMM	  Integration	  Guide	  November	  2015	  -‐	  V5	  

Aruba	  an	  HP	  Enterprise	  company	   36	  

SOTI	  Endpoint	  Attributes	   	  
The	  CPPM	  EMM	  service	  will	  normalize	  data	  received	  from	  SOTI	  in	  the	  Endpoint	  identity	  
database.	  The	  table	  below	  shows	  the	  normalized	  data	  attributes	  that	  are	  available	  from	  
SOTI.	  If	  there	  are	  specific	  normalized	  values,	  those	  are	  also	  shown	  in	  the	  table.	  

Endpoint  
Tag  

Tag  
Type  

Specific  
Values  

Manufacturer   Inventory     

Model   Inventory     

OS  Version   Inventory     

Serial  Number   Inventory     

Phone  Number   Inventory     

Source   Inventory   SOTI  

Ownership   Inventory     

Display  Name   Inventory     

EMM  Identifier   Inventory     

Encryption   Policy   True  or  False  

Compromised   Policy   True  or  False  

EMM  Enabled   Policy   True  or  False  

Last  Check  In   Policy     

Required  Apps   Policy   Installed  /  Missing  

Blacklisted  Apps   Policy   True  or  False  
	  
Figure	  38	  -‐‑	  SOTI	  Endpoint	  Attributes	  
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XenMobile	  Configuration	  
To	  configure	  the	  XenMobile	  EMM	  integration	  the	  Server	  Base	  URL	  is	  made	  up	  of	  several	  
components.	  For	  cloud	  deployments	  there	  is	  a	  concept	  of	  a	  customer	  instance	  and	  this	  
instance	  name	  is	  referenced	  twice	  in	  the	  Base	  URL	  as	  shown	  below:	  

https://<instance-‐‑name>.zc.zenprise.com/<instance-‐‑name>/nac	  

for	  example.	  https://aruba.zc.zenprise.com/aruba/nac	  

	  

Figure	  39	  -‐‑	  XenMobile	  Context	  Server	  configuration	  screen	  

Note:	  For	  on-‐‑prem	  deployment	  of	  XenMobile,	  the	  concept	  of	  a	  customer	  instance	  is	  no	  
longer	  required	  and	  the	  base	  URL	  reverts	  back	  to	  default	  format	  that	  includes	  the	  
/zdm/nac	  suffix	  as	  shown	  below:	  

https://<customer-‐‑on-‐‑prem-‐‑deployment-‐‑fqdn>/zdm/nac	  
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Xenprise	  Endpoint	  Attributes	  
The	  CPPM	  EMM	  service	  will	  normalize	  data	  received	  from	  Xenprise	  in	  the	  Endpoint	  
identity	  database.	  The	  table	  below	  shows	  the	  normalized	  data	  attributes	  that	  are	  available	  
from	  Xenprise.	  If	  there	  are	  specific	  normalized	  values,	  those	  are	  also	  shown	  in	  the	  table.	  

Endpoint  
Tag  

Tag  
Type  

Specific  
Values  

Manufacturer   Inventory     

Model   Inventory     

OS  Version   Inventory     

Source   Inventory   XenMobile  

IMEI   Inventory     

Ownership   Inventory     

Serial  Number   Inventory     

Phone  Number   Inventory     

EMM  Identifier   Inventory     

Encryption   Policy     True  or  False  

Compromised   Policy   True  or  False  

EMM  Enabled   Policy   True  or  False  

Blacklisted  Apps   Policy   True  or  False  

Required  Apps   Policy   True  or  False  
	  
Figure	  40	  -‐‑	  Xenprise	  Endpoint	  Attributes	  
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SAP	  Afaria	  Configuration	  
Included	  in	  the	  CPPM	  6.4.0	  release	  is	  support	  for	  SAP	  Afaria	  as	  an	  EMM	  Vendor,	  
complementing	  the	  existing	  vendors	  we	  support.	  To	  configure	  the	  Afaria	  EMM	  integration,	  
enter	  a	  hostname	  into	  the	  “Server	  Name”	  field.	  There	  is	  no	  specific	  name	  formatting	  for	  the	  
HOST	  FQDN	  URL.	  SAP	  also	  supports	  an	  on-‐‑prem	  VM	  version	  of	  their	  application,	  this	  is	  
deployed	  as	  a	  VM	  and	  there	  is	  no	  SAP	  appliance	  based	  hardware.	  

To	  use	  the	  Afaria	  NAC	  API,	  the	  credentials	  used	  in	  the	  API	  call	  need	  to	  be	  mapped	  to	  the	  
specific	  tenant	  and	  they	  must	  have	  the	  Access	  Control	  Role	  configured.	  	  

	  

Figure	  41	  -‐‑	  SAP	  Afaria	  Context	  Server	  configuration	  screen	  
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Afaria	  Endpoint	  Attributes	  
The	  CPPM	  EMM	  service	  will	  normalize	  data	  received	  from	  Afaria	  in	  to	  the	  Endpoint	  identity	  
database.	  The	  table	  below	  shows	  the	  normalized	  data	  attributes	  that	  are	  available	  from	  
Afaria.	  If	  there	  are	  specific	  normalized	  values,	  those	  are	  also	  shown	  in	  the	  table.	  

Endpoint  Tag   Tag  Type   Specific  Values  

Manufacturer   Inventory     

Model   Inventory     

OS  Version   Inventory     

Serial  Number   Inventory     

IMEI   Inventory     

Phone  Number   Inventory     

Source   Inventory   SAP  Afaria  

Ownership   Inventory     

EMM  Identifier   Inventory     

Compromised   Policy   True  or  False  

Encryption   Policy   True  or  False  

Blacklisted  App   Policy   True  or  False  

Required  App   Policy     

EMM  Enabled   Policy   True  or  False  
	  
Figure	  42	  -‐‑	  SAP	  Afaria	  Endpoint	  Attributes	  
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Blackberry	  Enterprise	  Server	  v10	  
The	  integration	  we	  developed	  for	  BlackBerry	  BES10	  server	  is	  slightly	  different	  than	  the	  
other	  EMM	  integrations.	  It’s	  important	  to	  know	  this	  was	  co-‐‑developed.	  The	  BlackBerry	  
server	  runs	  on	  top	  of	  a	  Microsoft	  SQL	  DB,	  and	  the	  integration	  involves	  CPPM	  making	  real-‐‑
time	  SQL	  calls	  to	  the	  BES10	  MS-‐‑SQL	  tables.	  BlackBerry	  co-‐‑operation	  with	  Aruba	  developed	  
a	  special	  MS-‐‑SQL	  view	  of	  their	  underlying	  tables	  to	  allow	  us	  to	  check	  on	  a	  number	  of	  
attributes	  related	  to	  enrolled	  devices.	  In	  the	  example	  below	  we	  show	  how	  to	  make	  an	  
Authz	  call	  to	  the	  BES	  MS-‐‑SQL	  DB	  to	  extract	  the	  Ownership	  of	  an	  endpoint	  and	  then	  use	  this	  
to	  drive	  the	  role-‐‑mapping	  for	  a	  user.	  A	  list	  of	  the	  other	  exposed	  SQL	  attributes	  is	  shown	  
later	  in	  this	  section.	  

We	  are	  assuming	  that	  you	  have	  the	  BES	  Server	  installed.	  We	  do	  not	  cover	  the	  setup	  or	  
installation	  of	  BES	  or	  the	  enrollment	  of	  Devices	  in	  BES.	  Once	  this	  has	  been	  completed	  we	  
recommend	  the	  use	  of	  the	  the	  Microsoft	  SQL	  Management	  Studio	  Express	  for	  SQL-‐‑Admin	  
activities.	  It	  can	  be	  downloaded	  from	  https://www.microsoft.com/en-‐‑
ca/download/details.aspx?id=7593	  	  

Before	  you	  begin	  the	  below	  configuration,	  we	  recommend	  you	  take	  a	  backup	  of	  the	  BES	  
Database.	  

BES10	  Configuration	  

Once	  the	  SQL	  Mgmt	  tool	  is	  installed,	  we	  need	  to	  create	  the	  SQL	  view.	  At	  the	  top	  of	  SQL	  
Mgmt	  studio	  you	  should	  see	  a	  spot	  where	  you	  can	  select	  the	  database.	  	  It’s	  a	  drop	  down	  
box.	  	  It’s	  probably	  set	  to	  Master.	  	  Open	  up	  a	  new	  query	  window,	  Select	  the	  drop	  down	  box	  
and	  select	  BDSMgmt_UDS,	  load	  the	  script	  into	  a	  new	  query	  window	  and	  click	  “Execute”,	  see	  
below	  for	  how	  to	  access	  this	  script.	  	  

The	  script	  will	  create	  a	  view	  called	  vw_wifi_mac_device.	  	  To	  test	  this	  is	  working	  you	  just	  
need	  to	  run	  “SELECT	  *	  FROM	  vw_wifi_mac_device”	  to	  obtain	  the	  data	  from	  it.	  Be	  careful	  
as	  this	  will	  select	  all	  endpoint	  records	  in	  the	  DB.	  If	  you	  know	  the	  MAC	  address	  of	  a	  single	  
device,	  a	  better	  test	  would	  be	  to	  just	  query	  for	  that	  device.	  Use	  the	  following	  SQL	  to	  test	  for	  
a	  single	  device	  “SELECT	  *	  FROM	  vw_wifi_mac_device	  WHERE	  WiFiMac	  
='00:11:22:33:44:55”	  	  [change	  00:11:22:33:44:55	  to	  equal	  your	  MAC	  address].	  It’s	  a	  
good	  test	  to	  ensure	  the	  above	  SELECT	  works	  as	  this	  is	  a	  final	  acceptance	  test	  to	  be	  certain	  
the	  SQL	  View	  is	  installed	  correctly.	  
	  
To	  obtain	  the	  SQL	  source	  to	  create	  the	  table	  view	  contact	  danny@arubanetworks.com.	  We	  
are	  not	  generally	  publishing	  the	  SQL	  at	  this	  time,	  as	  we	  want	  to	  make	  sure	  the	  CPPM	  and	  
BES10	  integration	  are	  managed	  successfully.	  
	  
To	  check	  the	  view	  has	  been	  created	  successfully,	  review	  the	  following	  example	  below	  on	  
the	  left	  to	  check	  the	  view	  has	  been	  created.	  Also	  below	  on	  the	  RHS	  of	  the	  page	  is	  a	  copy	  of	  
all	  of	  the	  available	  fields	  exposed	  under	  the	  SQL	  view	  we	  have	  just	  created.	  In	  theory	  you	  
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could	  use	  any	  of	  these	  fields	  in	  processing	  on	  Authz	  check	  within	  CPPM.	  For	  our	  
documented	  example	  we	  will	  only	  be	  using	  the	  ‘Ownership’	  field,	  not	  the	  Owner	  field.	  

	  	  

Figure	  43	  -‐‑	  Checking	  new	  SQL	  is	  created	  

Figure	  44	  -‐‑	  All	  fields	  exposed	  in	  new	  SQL	  view	  
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Figure	  45	  -‐‑	  Setting	  Table	  View	  	  security	  

Above	  we	  see	  some	  of	  the	  SQL-‐‑Admin	  changes	  we	  had	  to	  make.	  For	  our	  testing	  we	  created	  
a	  new	  user	  that	  was	  authorized	  to	  the	  table-‐‑view.	  It’s	  recommended	  that	  you	  consult	  with	  
the	  enduser/customer	  to	  ensure	  that	  any	  security/access	  to	  the	  SQL-‐‑DB	  is	  secured	  as	  
required.	  Our	  above	  example	  is	  more	  for	  the	  simplicity	  of	  our	  LAB	  testing.	  

We	  created	  a	  user	  ‘cppm’	  as	  can	  be	  see	  above,	  then	  we	  edited	  the	  Permissions	  for	  the	  SQL	  
view	  and	  granted	  all	  access	  to	  cppm.	  As	  can	  be	  seen	  below	  we	  then	  used	  this	  user	  ‘cppm’	  
configured	  within	  ClearPass	  as	  the	  Login	  user	  to	  the	  MS-‐‑SQL	  DB.	  
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ClearPass	  Configuration	  for	  BESv10	  

ClearPass	  configuration	  requires	  several	  steps.	  The	  first	  is	  to	  configure	  and	  connect	  CPPM	  
to	  the	  MS-‐‑SQL	  DB	  we	  want	  to	  access.	  Configure	  this	  under	  Configuration	  -‐‑>	  Authentication	  
-‐‑>	  Sources	  -‐‑>	  [Add	  a	  new	  source]	  

As	  you	  can	  see	  below,	  add	  a	  new	  SQL	  source	  (ensure	  you	  select	  MSSQL	  on	  the	  later),	  
provide	  the	  required	  IP	  address,	  Login	  Name/Password	  and	  leave	  the	  Password	  type	  as	  
‘Cleartext’.	  	  

	  

Figure	  46	  –	  Adding	  a	  the	  BES10	  SQL	  database	  into	  ClearPass	  

Within	  the	  Attributes	  Tab,	  you	  need	  to	  take	  particular	  care	  of	  the	  configuration.	  Create	  a	  
filter	  and	  add	  a	  field-‐‑name.	  I	  suggest	  you	  follow	  my	  guidance	  below	  but	  you	  may	  want	  
multiple	  fields	  or	  want	  to	  call	  your	  fields	  by	  another	  name.	  Be	  aware	  as	  some	  of	  the	  fields	  
you	  create	  are	  referenced	  in	  other	  places	  so	  making	  changes	  can	  cause	  additional	  issues.	  

	  

Figure	  47	  -‐‑	  Creating	  the	  SQL	  filter	  to	  'grab'	  data	  from	  the	  BES10	  MS-‐‑SQL	  view	  
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Below	  I	  have	  added	  the	  actual	  SQL	  Query	  that	  you	  need	  to	  paste	  when	  creating	  the	  Filter	  
above.	  Again	  note	  the	  field	  nummac,	  which	  I	  also	  used	  in	  the	  filter.	  The	  key	  to	  the	  below	  is	  
the	  use	  of	  the	  Connection	  namespace.	  We	  grab	  the	  MAC	  address	  in	  colon	  format.	  All	  of	  the	  
MAC	  addresses	  in	  the	  BES10	  DB	  are	  stored	  in	  colon	  format,	  so	  the	  below	  is	  taking	  the	  MAC	  
from	  the	  incoming	  RADIUS	  auth	  and	  using	  this	  to	  lookup	  the	  endpoint	  in	  the	  BES10	  DB.	  The	  
other	  important	  thing	  to	  be	  aware	  of	  from	  the	  below	  is	  we	  are	  also	  grabbing	  the	  ownership	  
of	  the	  endpoint.	  As	  we	  discussed	  there	  could	  be	  other	  attributes	  you	  want	  to	  check	  in	  the	  
BES10	  DB	  but	  hopefully	  the	  example	  here	  provides	  enough	  information	  for	  you	  to	  
expand/modify	  as	  required.	  

select count(ownership) nummac from vw_wifi_mac_device where 

wifimac='%{Connection:Client-Mac-Address-Colon}' and 

ownership='Corporate' 

Figure	  48	  –	  CPPM	  SQL	  Query	  to	  check	  on	  MAC	  address	  and	  grab	  Ownership	  attribute	  

Now	  that	  we	  have	  the	  BES10	  SQL-‐‑DB	  defined	  and	  the	  SQL	  Query	  setup	  in	  CPPM	  we	  can	  
now	  use	  these	  attributes/fields	  within	  our	  Service	  Policy.	  The	  process	  to	  use	  the	  BES10	  
context	  in	  our	  example	  is	  to	  examine	  the	  Ownership	  of	  the	  endpoint.	  By	  this	  we	  want	  to	  
make	  a	  role	  mapping	  decision	  based	  upon	  if	  the	  endpoint	  is	  enrolled	  within	  BES	  and	  the	  
ownership	  is	  Corporate.	  By	  this	  we	  know	  the	  user	  is	  using	  a	  Company	  provided	  Smart-‐‑
Device	  and	  as	  such	  we	  can	  assign	  network	  privileges	  accordingly.	  

	  

Figure	  49	  –	  Assigning	  a	  role	  to	  the	  session	  based	  upon	  the	  BES	  lookup	  

The	  above	  role-‐‑mapping	  is	  using	  the	  BES10	  DB	  to	  perform	  an	  Authorization	  lookup.	  We	  
check	  above	  in	  our	  SQL	  Query	  for	  the	  MAC	  being	  present	  AND	  the	  Ownership	  being	  set	  to	  
Corporate.	  If	  both	  of	  these	  check	  are	  true	  then	  we	  will	  return	  a	  value	  of	  ‘1’	  else	  a	  value	  of	  ‘0’.	  
Our	  role	  mapping	  above	  checks	  for	  a	  1	  being	  returned	  by	  the	  SQL	  Query	  and	  sets	  a	  Role	  of	  
BES-‐‑Corporate.	  	  

Your	  logic	  can	  and	  will	  likely	  differ.	  
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Note:	  Remember	  to	  add	  the	  SQL	  Auth	  source	  to	  the	  actual	  Service	  Policy	  you	  will	  process	  
this	  under	  

	  

Figure	  50	  –	  Remember	  to	  add	  the	  BES10	  as	  an	  Authorization	  source	  
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Globo	  GO!	  Enterprise	  v3.9.2	  
The	  integration	  we	  developed	  for	  Globo	  GO!	  Enterprise	  is	  slightly	  different	  than	  the	  most	  of	  
our	  other	  MDM/EMM	  integrations,	  it	  does	  follow	  a	  similar	  framework	  we	  recently	  
completed	  for	  BlackBerry	  in	  that	  we	  are	  querying	  an	  underlying	  SQL	  DB	  and	  using	  this	  as	  
an	  Authz	  source	  when	  processing	  the	  users	  network-‐‑access.	  It’s	  important	  to	  know	  this	  
solution	  was	  co-‐‑developed	  with	  Globo	  and	  has	  their	  approval.	  	  
	  
The	  Globo	  GO!	  server	  runs	  on	  top	  of	  a	  Microsoft	  SQL	  DB,	  and	  this	  integration	  involves	  
CPPM	  making	  real-‐‑time	  SQL	  calls	  to	  the	  MS-‐‑SQL	  tables.	  With	  the	  co-‐‑operation	  of	  Globo	  we	  
have	  been	  able	  build/test	  and	  document	  a	  few	  common	  integration	  use	  cases.	  In	  the	  two	  
examples	  that	  follows	  we	  show	  how	  to	  make	  an	  authz	  call	  to	  the	  MS-‐‑SQL	  DB	  to	  extract	  the	  
Ownership	  of	  an	  endpoint	  and	  then	  use	  this	  to	  drive	  the	  role-‐‑mapping	  for	  a	  user,	  and	  
separately	  how	  to	  check	  on	  the	  device	  being	  jailbroken.	  These	  being	  just	  two	  simple	  but	  
common	  request	  to	  utilize	  the	  device	  context	  which	  Globlo	  Go!	  has	  as	  an	  authorization	  
source	  for	  the	  users	  device.	  

We	  are	  assuming	  that	  you	  have	  the	  Globo	  GO!	  Server	  installed.	  We	  do	  not	  cover	  the	  setup	  
or	  installation	  or	  the	  enrollment	  of	  Devices	  in	  Globo	  GO!.	  Once	  this	  has	  been	  completed	  we	  
recommend	  the	  use	  of	  the	  the	  Microsoft	  SQL	  Management	  Studio	  Express	  for	  SQL-‐‑Admin	  
activities.	  It	  can	  be	  downloaded	  from	  https://www.microsoft.com/en-‐‑
ca/download/details.aspx?id=7593	  	  

	  

Note:	  We	  make	  the	  assumption	  that	  the	  Globo	  GO!	  Enterprise	  software	  is	  deployed,	  we	  
provide	  no	  installation/configuration	  guidelines	  for	  the	  deployment	  and	  configuration	  of	  
the	  Globo	  product.	  

Note:	  Globo	  has	  not	  performance	  tested	  this	  integration	  and	  therefore	  any	  Customer	  
should	  have	  their	  DBA	  closely	  baseline	  this	  process	  before	  and	  after	  integration	  to	  ensure	  
general	  SQL	  performance	  is	  not	  negatively	  impacted.	  	  
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Globo	  Configuration	  

Following	  on	  from	  the	  installation	  of	  the	  MSFT	  SQL	  Mgmt	  Studio	  we	  must	  complete	  some	  
additional	  network	  specific	  configuration	  changes	  to	  allow	  CPPM	  to	  access	  the	  SQL	  DB.	  

Load	  the	  SQL	  Server	  Configuration	  Manager,	  and	  then	  there	  are	  several	  checks	  and	  changes	  
we	  need	  to	  make	  to	  complete	  the	  configuration.	  	  

	  
Figure	  51	  -‐‑	  SQL	  Server	  Configuration	  Manager	  

Select	  the	  ‘SQL	  Server	  Network	  Configuration’,	  expand	  that,	  select	  the	  ‘Protocols	  for….’	  
And	  double-‐‑click	  on	  ‘TCP/IP’.	  	  
	  
Under	  the	  Protocol	  Tab	  on	  TCP/IP	  Properties	  –	  ‘Enabled’	  &	  ‘Listen	  All’	  are	  set	  as	  Yes,	  if	  
either/any	  are	  set	  to	  No,	  click	  on	  the	  box,	  select	  Yes	  and	  hit	  Apply	  at	  the	  bottom.	  
	  

	  
Figure	  52	  -‐‑	  Setting	  Listen	  All	  to	  'Yes'	  
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Next	  click	  on	  the	  IP	  Address	  Tab…………	  
	  

	  
Figure	  53	  -‐‑	  Setting	  the	  TCP	  Port	  to	  '1433'	  and	  disable	  Dynamic	  Ports	  

	  
Under	  the	  IP	  Address	  Tab	  there	  will	  be	  multiple	  entries	  based	  upon	  the	  number	  of	  
physical	  interfaces	  on	  the	  server,	  and	  additionally	  the	  IPv4	  and	  IPv6	  interfaces.	  We	  are	  
specifically	  interested	  in	  setting	  the	  configuration	  for	  the	  IP	  address	  that	  you	  want	  
ClearPass	  to	  communicate	  with.	  In	  the	  above,	  we	  are	  interested	  in	  the	  highlighted	  interface	  
with	  IP	  address	  10.2.100.119.	  We	  have	  set	  the	  TCP	  Dynamic	  Ports	  to	  ‘0’	  that's	  a	  zero	  and	  
hard-‐‑configured	  the	  TCP	  Port	  to	  listen	  on	  port	  1433.	  Again	  ensure	  the	  interface	  in	  question	  
is	  Active	  and	  Enabled.	  	  
	  
Note:	  Consider	  that	  you	  may	  have	  to	  amend	  the	  Server	  firewall	  to	  allow	  SQL	  traffic	  through	  
[TCP	  port	  1433],	  whilst	  testing	  and	  to	  remove	  additional	  complication	  during	  this	  stage	  we	  
recommend	  you	  consider	  disabling	  the	  server	  firewall	  to	  remove	  the	  potential	  of	  additional	  
complications	  and	  then	  once	  the	  process	  of	  the	  CPPM	  integration	  is	  complete	  you	  re-‐‑visit	  
the	  firewall	  configuration	  issue.	  
	  
The	  final	  step	  we	  need	  to	  perform	  for	  the	  Globo	  configuration	  is	  to	  ensure	  we	  have	  a	  user-‐‑
id	  configured	  in	  the	  MSFT	  SQL	  DB	  that	  can	  be	  used	  by	  CPPM	  to	  query	  the	  underlying	  tables.	  	  
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Load	  the	  MSFT	  SQL	  Serer	  Management	  Studio,	  expand	  the	  Databases	  and	  under	  
Security,	  expand	  Login……..	  then	  right-‐‑click	  on	  Logins	  to	  create	  a	  New	  Logins……	  	  
	  

	  
Figure	  54	  -‐‑	  Creating	  a	  user	  in	  the	  MSFT	  SQL	  DB	  

A	  few	  settings	  are	  required,	  I’ve	  documented	  how	  I	  set	  this	  up	  to	  work	  in	  my	  LAB,	  your	  SQL	  
DB-‐‑Admins	  may	  have	  a	  different	  preferred	  approach.	  
	  
Ensure	  you	  choose	  ‘SQL	  Server	  authentication’,	  de-‐‑select	  ‘User	  must	  change	  password	  
at	  next	  login’,	  and	  set	  the	  Default	  database	  to	  ‘MDM’.	  Under	  ‘Server	  Roles’	  below	  check	  
‘public’	  is	  selected.	  
	  

	  
Figure	  55	  -‐‑	  Check	  SQL	  Server	  Roles	  
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Under	  the	  User	  Mapping,	  ensure	  you	  set	  up	  the	  options	  for	  the	  ‘MDM’	  database	  set	  as	  
shown	  below……….	  

	  

Figure	  56	  -‐‑	  Configure	  User	  Mapping	  

After	  creating	  the	  user,	  we	  nee	  d	  to	  make	  a	  couple	  of	  final	  changes	  in	  the	  Security/Users	  
section	  for	  our	  user,	  ensure	  that	  for	  Owned	  Schemas	  &	  Membership	  that	  db_owner	  is	  
selected.	  
	  

	  
Figure	  57	  -‐‑	  Check	  Security	  setting	  for	  user	  
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ClearPass	  Configuration	  for	  Globo	  GO!	  

The	  first	  thing	  we	  have	  to	  do	  on	  ClearPass	  is	  define	  Globo	  Go!	  as	  an	  authentication	  source,	  
go	  to	  Configuration-‐‑>Authentication-‐‑>Sources-‐‑>	  Add	  provide	  a	  name	  and	  click	  Next.	  

	  

Figure	  58	  -‐‑	  Adding	  a	  Globo	  as	  an	  SQL	  Authentication	  source	  

Next	  you	  need	  to	  add	  the	  Globo	  GO!	  Server	  IP	  address,	  the	  port	  we	  will	  use	  that	  we	  fixed	  
previously,	  the	  DB	  Name	  [always	  MDM],	  the	  Username/Password	  we	  set	  up	  inside	  of	  SQL	  
previously	  and	  then	  ensure	  you	  select	  MSSQL	  as	  the	  ODBC	  Driver,	  finally	  ensure	  you	  leave	  
the	  Password	  as	  Cleartext.	  

	  

Figure	  59	  -‐‑	  Defining	  the	  Globo	  Go!	  SQL	  Database	  
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The	  next	  section	  is	  the	  most	  critical	  and	  prone	  to	  errors,	  so	  take	  special	  care	  when	  creating	  
the	  next	  few	  steps.	  We	  have	  provided	  below	  two	  SQL	  filters	  which	  we	  will	  use	  later	  to	  
process	  an	  Authz	  against	  a	  users	  Authentication.	  This	  is	  a	  brief	  list	  of	  the	  two	  filters	  many	  
other	  possible	  filters	  can	  be	  created	  once	  the	  correct	  tables	  structure	  is	  understood.	  

	  

Figure	  60	  -‐‑	  Summary	  of	  the	  two	  SQL	  Filters	  

The	  first	  filter	  is	  used	  to	  check	  on	  whether	  a	  device	  that	  is	  authenticating	  on	  the	  network	  is	  
actually	  enrolled	  as	  a	  Corporately	  Owned	  and	  enrolled	  device	  in	  the	  Globo	  Go!	  MDM.	  We	  
use	  the	  Mac-‐‑Address	  from	  the	  in-‐‑coming	  RADIUS	  Request	  to	  go	  and	  make	  a	  SQL	  call.	  If	  we	  
find	  a	  record	  i.e.	  COUNT>0	  then	  the	  device	  exists	  and	  is	  Corporately	  Owned,	  this	  is	  flagged	  
by	  Liability=2.	  Ensure	  you	  create	  the	  filter	  as	  defined	  below.	  

	  

Figure	  61	  -‐‑	  Filter	  to	  check	  on	  Device	  Enrollment	  and	  being	  Corporately	  Owned	  

	  

You	  can	  copy	  the	  below	  SQL	  into	  your	  Filter	  Query	  to	  minimize	  errors.	  

SELECT COUNT(DeviceStatistics.WiFiMAC) nummac FROM Devices INNER JOIN 

DeviceStatistics ON Devices.DeviceSAKey = DeviceStatistics.DeviceSAKey 

WHERE Devices.Liability = 2 AND DeviceStatistics.WiFiMAC = 

'%{Connection:Client-Mac-Address-Colon}' 

Figure	  62	  -‐‑	  SQL	  to	  track	  device	  enrollment	  and	  Corporate	  ownership	  
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The	  second	  filter	  is	  used	  to	  check	  on	  whether	  a	  device	  that	  is	  authenticating	  on	  the	  network	  
is	  jailbroken	  and	  an	  enrolled	  device	  in	  the	  Globo	  Go!	  MDM.	  We	  use	  the	  Mac-‐‑Address	  from	  
the	  in-‐‑coming	  RADIUS	  Request	  to	  go	  and	  make	  a	  SQL	  call.	  If	  we	  find	  a	  record	  i.e.	  COUNT>0	  
then	  the	  device	  exists	  and	  is	  NOT	  Jailbroken,	  this	  is	  flagged	  by	  JailBrokenDevice	  =0.	  Ensure	  
you	  create	  the	  filter	  as	  defined	  below.	  

	  

Figure	  63	  –	  Filter	  to	  check	  on	  a	  device	  enrollment	  and	  not	  being	  Jailbroken	  

You	  can	  copy	  the	  below	  SQL	  into	  your	  Filter	  Query	  to	  minimize	  errors.	  
	  

SELECT COUNT(WiFiMAC) rootjailbroken FROM DeviceStatistics WHERE 

JailBrokenDevice = 0 AND WiFiMAC = '%{Connection:Client-Mac-Address-

Colon}' 

Figure	  64	  -‐‑	  SQL	  to	  track	  device	  enrollment	  and	  Jailbroken	  status	  

Now	  we	  have	  defined	  the	  above	  two	  example	  filters	  we	  can	  use	  and	  reference	  these	  in	  our	  
role-‐‑mapping	  process	  shown	  below	  to	  set	  a	  role	  for	  the	  user	  which	  could	  then	  be	  enforced	  
via	  a	  standard	  enforcement	  policy.	  

	  

Figure	  65	  -‐‑	  Role-‐‑mapping	  using	  the	  authz	  results	  

This	  completes	  the	  section	  covering	  ClearPass	  and	  Globo	  Go!	  MDM	  integration.	  
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CPPM	  &	  MDM/EMM	  SCEP	  Setup	  
This	  feature	  introduced	  in	  CPPM	  6.3	  provides	  for	  a	  3rd	  party	  gateway	  to	  send	  Simple	  
Certificate	  Enrollment	  Protocol	  (SCEP)	  requests	  to	  the	  ClearPass	  Onboard	  CA	  to	  automate	  
the	  enrollment	  provisioning	  process	  and	  leverage	  certificates	  for	  advanced	  user	  
authentication.	  Primarily	  we	  have	  tested	  with	  EMM	  vendors	  as	  the	  SCEP	  client	  (Proxy).	  

CPPM	  SCEP	  Configuration	  

Configuring	  the	  SCEP	  Server	  functionality	  on	  CPPM	  is	  very	  simple.	  We	  are	  assuming	  you	  
already	  have	  configured	  a	  Certificate	  Authority	  (CA)	  for	  Onboard.	  Initially	  when	  we	  added	  
the	  proxy-‐‑enrollment	  process	  we	  provided	  for	  just	  SCEP	  based	  enrollment.	  In	  CPPM	  6.4	  we	  
added	  support	  for	  Enrollment	  over	  Secure	  Transport	  (EST),	  a	  new	  comprehensive	  and	  
more	  secure	  method	  of	  obtaining	  certificates	  than	  previous	  approaches,	  such	  as	  SCEP.	  

For	  CPPM	  6.4,	  enable	  this	  within	  the	  Onboard	  CA	  Guest	  -‐‑>	  Onboard	  -‐‑>	  Certificate	  
Authorities.	  Take	  special	  notice	  of	  the	  SCEP/EST	  URL	  that	  will	  be	  used	  on	  the	  SCEP/EST	  
proxy	  server.	  Set	  a	  strong-‐‑shared	  SCEP/EST	  password.	  
	  
	  
	  
	  
	  
	  

	  
Figure	  66	  -‐‑	  Configuring	  SCEP	  &	  EST	  in	  CPPM	  6.4	  

In	  releases	  prior	  to	  6.4	  the	  SCEP	  server	  was	  enabled	  in	  Guest	  -‐‑>	  Onboard	  +Workspace	  -‐‑>	  
Initial	  Setup	  -‐‑>	  Certificate	  Authorities.	  Take	  special	  notice	  of	  the	  SCEP	  URL	  that	  will	  be	  
used	  on	  the	  SCEP	  proxy	  server.	  Set	  a	  strong	  shared	  SCEP	  password.	  
	  
	  
	  
	  
	  
	  
	  

	  

	  
Figure	  67	  -‐‑	  Configuring	  SCEP	  Server	  in	  CPPM	  6.3	  
	  

Anexo 07 ITEM 01 (0592516)         SEI 0008478-63.2018.6.02.8000 / pg. 2084



ClearPass	  6.x	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	   Tech	  Note:	  ClearPass	  and	  EMM	  Integration	  Guide	  November	  2015	  -‐	  V5	  

Aruba	  an	  HP	  Enterprise	  company	   56	  

EMM	  SCEP	  Configuration	  

Configuration	  within	  the	  EMM	  portals	  differs	  as	  vendors	  have	  differing	  frameworks	  and	  
workflows.	  We	  will	  enhance	  this	  section	  as	  we	  document	  the	  workflows	  of	  other	  vendors.	  

AirWatch	  SCEP	  Configuration	  
Creating	  the	  SCEP	  server	  and	  template	  is	  the	  first	  step,	  this	  template	  has	  to	  be	  included	  in	  a	  
profile	  that	  will	  be	  pushed	  to	  the	  managed	  device.	  	  AirWatch	  has	  an	  interesting	  model	  for	  
scoping	  which	  devices	  should	  get	  which	  profile	  (employee	  owned	  vs	  corporate,	  device	  type,	  
os	  version	  etc).	  To	  complete	  the	  configuration	  you	  must	  have	  Admin	  credentials	  sign	  on.	  

Configure	  SCEP	  in	  AirWatch	  
From	  the	  LHS	  nav	  bar,	  go	  Groups	  &	  Settings,	  All	  Settings,	  System,	  Enterprise	  
Integration,	  Certificate	  Authorities……	  then	  you	  need	  to	  add	  a	  new	  CA,	  this	  will	  be	  the	  
CPPM	  OnBoard	  CA	  you	  configured	  previously.	  

	  

Figure	  68	  -‐‑	  Adding	  a	  NEW	  CA	  (SCEP)	  Server	  in	  AirWatch…	  part1	  

	  

Figure	  69	  -‐‑	  Adding	  a	  NEW	  CA	  (SCEP	  Server)	  in	  AirWatch…	  part2	  

Note:	  At	  the	  bottom	  of	  the	  configuration	  screen	  is	  an	  the	  option	  to	  TEST	  CONNECTION…	  In	  
our	  testing	  this	  option	  never	  worked.	  See	  a	  section	  later	  for	  generating	  a	  test	  scep	  request.	  
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Next	  we	  create	  a	  Request	  Template,	  notice	  the	  highlighted	  box	  below	  on	  the	  RHS……	  

	  

Figure	  70	  -‐‑	  Adding	  a	  NEW	  Request	  Template	  in	  AirWatch	  

When	  creating	  the	  Request	  template,	  ensure	  that	  for	  the	  Certificate	  Authority,	  you	  choose	  
from	  the	  drop-‐‑down	  the	  CA	  you	  just	  configured	  in	  the	  previous	  step.	  The	  Common	  Name	  in	  
our	  example	  is	  set	  to	  use	  ‘EnrollmentUser’,	  this	  effectively	  creates	  the	  client-‐‑certificate	  
with	  the	  CN	  equal	  to	  the	  user	  name	  as	  shown	  below.	  
	  
	  
	  
	  
	  
	  
	  
	  
	  
	  

	  

Figure	  71	  -‐‑	  Setting	  the	  Certificate	  Template	  to	  use	  the	  Onboard	  CA	  and	  CN=User	  

After	  creating	  the	  above,	  we	  need	  to	  create	  or	  change	  our	  platform	  profile	  that	  will	  be	  
applied	  to	  the	  managed	  devices.	  	  

Create:	  If	  you	  need	  to	  create	  a	  new	  Profile	  follow	  these	  steps,	  go	  to	  Devices,	  Profile,	  List	  
View,	  Add	  [Choose	  relevant	  device	  platform]	  	  

	  

Figure	  72	  -‐‑	  Adding	  a	  platform	  profile	  
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Choose	  the	  required	  template…..	  

	  

Figure	  73	  -‐‑	  Many	  different	  Platform	  templates	  supported	  

Depending	  on	  the	  platform	  you	  are	  configuring	  different	  options	  exist	  based	  on	  the	  
template	  previously	  choosen.	  Be	  aware	  that	  a	  lot	  of	  the	  supported	  platform	  templates	  do	  
not	  support	  SCEP.	  Only	  iOS,	  MAC	  OSX	  and	  Windows	  8	  support	  SCEP	  on	  the	  AirWatch	  
platform.	  When	  configuring	  SCEP	  you	  are	  able	  to	  choose	  the	  CA	  and	  Certificate	  templates	  
configured	  previously.	  Be	  sure	  to	  select	  in	  the	  ‘General’	  option	  which	  you	  can	  see	  in	  red	  
below	  the	  required	  Smart	  Groups	  this	  SCEP	  profile	  will	  apply	  to.	  You	  may	  have	  to	  create	  a	  
new	  Smart	  Group.	  

Note:	  Devices	  should	  be	  added	  to	  the	  correct	  SmartGroups	  after/during	  the	  enrollment	  
process.	  

	  

Figure	  74	  –	  Setting	  policy	  configuration,	  SSID,	  Passcode,	  SCEP	  Etc.	  

Anexo 07 ITEM 01 (0592516)         SEI 0008478-63.2018.6.02.8000 / pg. 2087



ClearPass	  6.x	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	  	   Tech	  Note:	  ClearPass	  and	  EMM	  Integration	  Guide	  November	  2015	  -‐	  V5	  

Aruba	  an	  HP	  Enterprise	  company	   59	  

For	  the	  testing	  we	  created	  a	  Smart	  Group	  (ios-‐‑scep-‐‑test)	  and	  assigned	  a	  device	  to	  this	  
group.	  This	  was	  the	  group	  we	  selected	  in	  the	  ‘General’	  section	  above.	  Notice	  below	  that	  
once	  the	  profile	  has	  been	  saved	  and	  applied	  its	  shows	  as	  pending	  whilst	  the	  SCEP	  request	  is	  
serviced	  by	  CPPM.	  

	  

Figure	  75	  -‐‑	  SCEP	  request	  sent	  to	  CPPM	  for	  processing	  

On	  CPPM,	  you	  can	  see	  that	  a	  tls-‐‑client	  certificate	  was	  created	  upon	  receiving	  this	  request	  
from	  AirWatch.	  For	  the	  testing	  we	  created	  a	  new	  CA	  (SCEP_TEST-‐‑CA)	  within	  CPPM	  to	  
handle	  SCEP.	  	  

	  

Figure	  76	  -‐‑	  SCEP	  request	  on	  CPPM,	  client	  TLS	  cert	  created	  

Note:	  Pay	  attention	  to	  the	  Common	  Name	  of	  the	  certificate	  created,	  “danny648092411”	  
above	  by	  the	  SCEP	  request.	  This	  appears	  below	  in	  the	  iPAD	  Device	  Identity	  Certificate.	  	  	  
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On	  the	  iPAD	  Client	  we	  see	  the	  device	  identity	  certificate	  installed	  succesfully…….	  

	  

Figure	  77	  -‐‑	  Certificates	  etc.	  installed	  successfully	  on	  the	  iPad	  

Note:	  Take	  notice	  of	  the	  device	  identity	  certificate	  (danny648092411)	  above	  installed	  on	  
the	  iPad.	  This	  matches	  the	  Onboard	  client	  cert	  that	  was	  created	  and	  shown	  previously.	  
	  
Within	  the	  AirWatch	  console	  you	  can	  also	  see	  the	  confirmation	  messages	  of	  the	  above	  
process	  go	  to	  Accounts	  -‐‑>	  Users	  -‐‑>	  List	  View	  [click	  on	  your	  user]	  and	  it	  will	  show	  the	  
activity	  for	  this	  user.	  Below	  can	  be	  seen	  the	  Profile	  etc.	  being	  installed	  

	  

Figure	  78	  -‐‑	  AirWatch	  console	  messages	  
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Airwatch/SCEP-‐Server/Endpoint	  Dataflow	  
The	  data	  flow	  shown	  below	  is	  important	  to	  understand.	  Once	  the	  Endpoint	  has	  had	  its	  SCEP	  
configuration	  applied	  it	  makes	  a	  calls	  to	  the	  SCEP	  Server.	  The	  SCEP	  request	  comes	  directly	  
from	  the	  Endpoint	  to	  ClearPass.	  The	  data	  is	  returned	  directly	  to	  the	  device	  as	  shown	  below.	  

	  

Figure	  79	  –	  Airwatch	  SCEP	  workflow	  enrollment	  with	  ClearPass	  CA	  
	  

Generating	  a	  SCEP	  Test	  Request	  in	  Airwatch	  
Airwatch	  provides	  a	  very	  useful	  tool	  for	  generating	  SCEP	  request.	  From	  the	  LHS	  nav	  bar,	  go	  
to	  Groups	  &	  Settings,	  All	  Settings,	  Admin,	  Troubleshooting,	  SCEP	  Certificate	  Tool	  as	  
shown	  below	  in	  the	  SCEP	  Cert	  Tool	  UI.	  Ensure	  you	  select	  the	  correct	  CA	  and	  Certificate	  
Template	  before	  you	  generate	  the	  SCEP	  request	  to	  the	  ClearPass	  Onboard	  CA	  by	  clicking	  on	  
the	  ‘Test	  Certificate	  Retrieval’.	  If	  this	  is	  successful	  then	  you	  will	  see	  a	  returned	  test	  
certificate	  in	  at	  the	  top	  of	  the	  screen,	  this	  can	  be	  clearly	  seen	  below	  in	  green	  text.	  
	  
	  
	  
	  
	  
	  
	  
	  
	  
	  
	  
	  
	  

Figure	  80	  -‐‑	  Generating	  an	  Airwatch	  SCEP	  test	  request	  
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MobileIron	  SCEP	  Configuration	  can	  provision	  certificates	  onto	  the	  many	  platforms	  
via	  SCEP-‐‑PROXY.	  They	  support	  SCEP	  enrollment	  for	  iOS,	  Google	  Android,	  Windows	  Phone	  
8,	  and	  Windows	  8.1	  RT/Pro	  (though	  there	  are	  some	  additional	  steps	  for	  Windows	  devices).	  	  
	  
Note:	  MobileIron	  currently	  does	  not	  support	  EST,	  we	  understand	  it	  is	  under	  investigation.	  

Different	  vendors	  support/implement	  differing	  workflows	  for	  SCEP	  enrollment,	  MobileIron	  
support	  a	  couple.	  One	  allows	  the	  SCEP	  enabled	  mobile	  device	  to	  communicate	  and	  enroll	  
directly	  with	  CPPM	  whilst	  the	  other	  ‘forces’	  the	  enrollment	  through	  the	  MobileIron	  VSP	  
platform.	  Whichever	  workflow	  you	  take	  is	  controlled	  by	  whether	  or	  not	  you	  select	  the	  
“Enable	  Proxy”	  check	  box	  in	  the	  SCEP	  setting	  in	  VSP.	  If	  you	  select	  Enable	  Proxy,	  
MobileIron	  Core	  will	  proxy	  the	  request	  to	  CPPM.	  If	  you	  uncheck	  that	  box,	  the	  device	  will	  
attempt	  to	  access	  the	  server	  directly.	  Our	  advice	  is	  to	  always	  use	  the	  proxy,	  because	  you	  
can	  allow	  enrollment	  from	  outside	  the	  network	  (e.g.	  3G/4G/LTE)	  and	  not	  have	  to	  expose	  
the	  SCEP	  server	  to	  the	  Internet	  (which	  is	  not	  a	  recommended	  design).	  

Configure	  SCEP	  in	  MobileIron	  
So	  to	  create	  the	  SCEP	  configuration	  from	  the	  VSP	  console…..	  Go	  to	  Policies	  &	  Configs	  -‐‑>	  
Configurations	  -‐‑>	  ‘Add	  New’	  -‐‑>	  SCEP…	  then	  fill	  in	  the	  template	  as	  in	  the	  next	  screen	  shot.	  

	  

Figure	  81	  -‐‑	  Configuring	  SCEP	  on	  MobileIron	  ...	  part1	  

We	  have	  set	  the	  below	  SCEP	  configuration	  such	  that	  the	  Subject	  for	  the	  certificate	  will	  be	  
the	  UserID.	  We	  can	  also	  set	  a	  multitude	  of	  additional	  parameters	  that	  will	  be	  passed	  in	  the	  
SCEP	  request	  sent	  to	  CPPM.	  Below	  is	  a	  list	  of	  the	  supported	  variables	  in	  MobileIron.	  In	  
Figure	  59	  below	  we	  have	  chosen	  several	  values	  to	  be	  include	  in	  the	  SCEP	  request	  that	  is	  
sent	  to	  CPPM	  for	  the	  creation	  of	  the	  certificate.	  We	  selected	  the	  Common	  name	  (CN)	  to	  be	  
that	  of	  the	  User	  Name,	  additionally	  we	  selected	  some	  fields	  for	  the	  Subject	  Alternate	  Name	  
(SAN).	  You	  can	  select	  the	  CN	  and	  SAN	  fields	  as	  required.	  
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Figure	  82	  -‐‑	  List	  of	  attributes	  available	  on	  MI	  for	  SCEP	  request	  

	  

	  

	  
	  
	  
	  

	  

	  
Figure	  83	  -‐‑	  Configuring	  SCEP	  on	  MobileIron	  ...	  part2	  
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After	  clicking	  on	  ‘Save’	  MobileIron	  will	  attempt	  to	  connect	  to	  CPPM’s	  CA	  and	  create	  a	  test	  
certificate,	  an	  example	  of	  this	  is	  as	  shown	  below	  in	  Figure	  61.	  

If	  the	  step	  of	  creating	  the	  test	  certificate	  is	  successful	  the	  following	  is	  displayed	  on	  the	  
screen….	  

	  

Figure	  84	  -‐‑	  Creation	  of	  SCEP	  certificate	  –	  successful	  on	  CPPM	  

Below	  is	  an	  example	  of	  the	  test	  certificates	  created	  within	  the	  Onboard	  CA	  from	  the	  
previous	  step	  of	  generating	  test	  certificates.	  So	  as	  not	  to	  ‘burn’	  Onboarding	  licenses	  with	  in	  
your	  CPPM	  production	  environment	  it	  would	  be	  good	  practice	  to	  delete	  these	  Test	  
certificate.	  	  

	  

Figure	  85	  -‐‑	  SCEP	  test	  certificate	  

After	  you	  have	  created	  the	  SCEP	  configuration	  and	  proved	  connectivity	  between	  
MobileIron	  and	  the	  CPPM	  SCEP	  service	  the	  remaining	  steps	  required	  relate	  to	  Policy	  and	  
Configuration	  on	  the	  VSP	  portal	  for	  the	  endpoints.	  

Note:	  We	  are	  assuming	  that	  you	  have	  enrolled	  the	  device	  within	  the	  MobileIron	  VSP	  
platform	  and	  the	  EMM	  profiles	  are	  installed	  on	  the	  endpoint.	  
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Setting	  SCEP	  policy	  against	  EMM	  endpoint	  
Next	  we	  need	  to	  create	  configuration	  and	  policy,	  you	  need	  to	  utilize	  ‘Labels’	  to	  drive	  this.	  
First	  lets	  create	  a	  ‘Label’…	  create	  this	  under	  User	  &	  Devices	  -‐‑>	  Labels	  

	  

Figure	  86	  -‐‑	  Creating	  a	  MobileIron	  'Label'	  

Next	  we	  have	  to	  assign	  the	  Label	  just	  created	  to	  the	  SCEP	  configuration	  we	  previously	  
created.	  Do	  this	  in	  Policy	  &	  Config	  -‐‑>	  Configuration	  -‐‑>	  [Choose	  the	  Policy]	  More	  Actions	  
-‐‑>	  Apply	  To	  Label	  (not	  shown)	  -‐‑>	  [Select	  the	  Label]	  
	  

	  
	  
	  
	  
	  
	  
	  
	  
	  
	  
	  
	  
	  
	  
	  
	  

	  
Figure	  87	  -‐‑	  Adding	  the	  Label	  to	  the	  SCEP	  Policy	  
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Now	  we	  have	  created	  the	  SCEP	  Configuration	  and	  associated	  the	  new	  scep-test-
enrollment	  label	  with	  this	  configuration	  we	  need	  to	  finally	  assign	  the	  label	  to	  one	  of	  the	  
managed	  devices.	  

Above	  you	  notice	  on	  the	  ‘ClearPass	  SCEP’	  line,	  there	  are	  no	  devices	  assigned	  to	  this	  Profile	  
under	  ‘#	  Phones’.	  From	  Users	  &	  Devices	  -‐‑>	  Devices	  -‐‑>	  Actions	  -‐‑>	  Apply	  to	  Label	  (not	  
shown)	  -‐‑>	  [Select	  the	  Label]	  -‐‑>	  Apply	  below	  you	  can	  see	  that	  the	  label	  we	  have	  created	  is	  
showing	  currently	  as	  ‘Not	  Applied’.	  

	  

Figure	  88	  -‐‑	  Applying	  the	  Label	  to	  an	  endpoint	  
	  

A	  confirmation	  message	  should	  be	  received	  on	  the	  GUI.	  
	  
	  
	  
	  
	  

	  

Figure	  89	  -‐‑	  Label	  applied	  and	  queued	  for	  action	  

At	  this	  point,	  MobileIron	  will	  make	  a	  request	  to	  CPPM’s	  CA	  via	  SCEP	  for	  the	  certificate.	  You	  
can	  see	  below	  the	  Label	  ‘scep-‐‑test-‐‑enrollment’	  assigned	  to	  the	  Device.	  This	  can	  be	  reviewed	  
from	  Users	  &	  Devices	  -‐‑>	  Devices	  
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Figure	  90	  -‐‑	  Labels	  assigned	  to	  the	  endpoint	  

You	  can	  see	  the	  labels	  above	  that	  have	  been	  assigned	  to	  this	  endpoint,	  including	  the	  scep-‐‑
test-‐‑enrollment	  label.	  

	  

Figure	  91	  -‐‑	  Configuration	  applied	  to	  the	  endpoint	  

Above	  the	  endpoint	  shows	  the	  SCEP	  configuration	  is	  ‘Applied’.	  
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MobileIron/SCEP-‐Server/Endpoint	  Dataflow	  
Below	  shows	  the	  SCEP	  workflow	  for	  the	  MobileIron	  framework.	  This	  differs	  from	  Airwatch	  
in	  that	  the	  MobileIron	  solution	  proxies	  all	  request	  to/from	  the	  ClearPass	  CA.	  
	  

	  
Figure	  92	  -‐‑	  MobileIron	  SCEP	  workflow	  enrollment	  with	  ClearPass	  CA	  
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Deleting	  Client	  TLS	  Certificates	  on	  MobileIron	  
The	  certificates	  that	  are	  created	  and	  download	  to	  the	  device	  exist	  within	  our	  eco-‐‑system	  in	  
several	  places.	  A	  copy	  exist	  in	  the	  CPPM	  CA,	  a	  cached	  copy	  also	  exist	  in	  the	  MobileIron	  VSP.	  

We	  previously	  discussed	  deleting	  the	  certs	  in	  CPPM	  (https://cppm_fqdn/guest/)	  then	  go	  to	  
Onboard-‐‑>Management	  and	  Control-‐‑>View	  by	  Certificate.	  

	  

Figure	  93	  -‐‑	  Deleting	  client	  certs	  in	  CPPM	  CA	  

If	  you	  must	  delete	  the	  cached	  client	  certificates	  within	  MobileIron,	  follow	  these	  steps	  Logs	  
and	  Events-‐‑>Certificate	  Logs-‐‑>	  [Select	  the	  Cert]	  then	  select	  ‘Revoke’	  as	  shown	  below.	  
	  
	  
	  
	  
	  
	  
	  
	  
	  
	  
	  
	  

Figure	  94	  -‐‑	  Deleting	  Certs	  in	  MobileIron	   	  
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Troubleshooting	  
Logging	  information	  regarding	  the	  Endpoint	  Context	  servers	  is	  available	  in	  the	  Event	  
Viewer.	  	  

Go	  to	  Monitoring	  >	  Event	  Viewer.	  You	  should	  see	  various	  messages	  relating	  to	  your	  
configured	  EMM	  connectors.	  

	  

	  

	  

	  

	  

	  

	  

	  

	  

	  

Figure	  95	  -‐‑	  Event	  Viewer	  
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Checking	  Logs	  files	  in	  CPPM	  

CPPM	  collects	  multiple	  log	  files	  that	  can	  assist	  the	  user	  in	  debugging	  CPPM‘s	  EMM	  
integration	  problem.	  The	  most	  useful	  of	  these	  logs	  is	  the	  mdm.log	  file.	  	  

To	  collect	  and	  access	  this	  log	  file	  is	  slightly	  complicated	  and	  lengthy,	  follow	  these	  steps….	  

Under	  Administration	  -‐>	  Server	  Manager	  -‐>	  Server	  Configuration,	  select	  your	  system	  then	  
‘Collect	  Logs’.	  Once	  this	  process	  has	  completed	  you	  need	  to	  download	  this	  tar	  file	  and	  open	  
with	  an	  appropriate	  application.	  For	  OS-‐‑X,	  finder	  will	  allow	  you	  to	  extract	  the	  file	  to	  a	  
folder	  for	  analysis.	  For	  MSFT	  Windows	  multiple	  applications	  exist,	  but	  a	  really	  good	  free	  
one	  is	  7-‐‑Zip	  http://www.7-‐‑zip.org.	  

	  

Figure	  96	  -‐‑	  How	  to	  collecting	  CPPM	  Logs	  

	  

After	  you	  have	  opened	  the	  archive,	  the	  mdm.log	  file	  can	  be	  found	  in	  the	  following	  path…	  

PolicyManagerLogs/async-‐‑netd/mdm.log	  as	  shown	  below.	  
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Figure	  97	  -‐‑	  Where	  to	  locate	  mdm.log	  file	  

	  

	  

	  

	  

	  

	  

	  

	  

	  

  
  

www.arubanetworks.com  
  

1344  Crossman  Avenue  
Sunnyvale,  CA  94089  

Phone:  1-800-WIFI-LAN  (+800-943-4526)  
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General	  SCEP/EST	  –	  Licensing	  –	  Q&A….	  
Anything	  you	  configure	  within	  the	  'Onboard'	  menu	  that	  interact	  with	  a	  device	  for	  
provisioning,	  will	  consume	  an	  'onboard'	  license.	  	  That	  includes	  MSFT	  Active	  Directory	  
Certificate	  Services	  and	  SCEP/EST	  server.	  Therefore	  EVERY	  issued	  certificate	  will	  consume	  
and	  require	  a	  license	  in	  Onboard.	  
	  

Caveats/Queries	  for	  CPPM	  SCEP/EST	  
SCEP/EST	  is	  only	  for	  TLS	  client	  certificates	  (and	  device	  identity	  certificates	  used	  for	  
configuration	  profiles,	  an	  internal	  detail	  of	  iOS/OS	  X	  over-‐‑the-‐‑air	  provisioning).	  

Q)	  Is	  it	  programmable	  via	  API,	  i.e,	  Can	  we	  revoke	  certificates	  via	  API	  calls?	  

A)	  No,	  today	  we	  do	  not	  provide	  an	  API	  interface	  into	  the	  CPPM	  CA	  to	  revoke/disable	  
certificate.	  

Q)	  If	  Onboard	  CA	  is	  being	  used	  only	  to	  issue	  certificates	  via	  SCEP/EST	  then	  how	  is	  Onboard	  
expected	  to	  know	  the	  "device/user	  attributes"?	  

A)	  SCEP	  signs	  the	  certificate	  request	  and	  sends	  back	  the	  result	  as	  a	  certificate	  -‐‑	  Whatever	  is	  
in	  the	  CSR	  should	  be	  part	  of	  the	  certificate.	  Onboard	  will	  honor	  the	  attributes	  presented	  in	  
the	  CSR	  of	  a	  SCEP	  /	  EST	  request	  so	  it	  is	  critical	  to	  ensure	  that	  the	  EMM	  configured	  CSR	  
meets	  your	  deployment	  requirements.	  
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Integrating	  with	  ClearPass	  HTTP	  APIs	  
	  

HTTP	  based	  APIs	  
	  

The	  world	  of	  APIs	  is	  full	  concepts	  that	  are	  not	  immediately	  obvious	  to	  those	  of	  us	  
without	  software	  development	  backgrounds	  and	  terms	  like	  REST,	  RPC,	  XML,	  
JSON,	  SOAP,	  WDSL	  etc	  can	  be	  initially	  overwhelming.	  Reviewing	  some	  of	  the	  
common	  characteristics	  found	  in	  many	  of	  today’s	  HTTP	  based	  APIs	  can	  provide	  a	  
solid	  foundation	  for	  further	  research	  on	  more	  advanced	  topics	  such	  as	  RESTful	  
API	  design.	  

The	  following	  high	  description	  aims	  to	  provide	  a	  basic	  understanding	  of	  the	  
components	  that	  are	  typically	  used	  to	  describe	  an	  APIs	  design	  and	  hence	  the	  
critical	  information	  needed	  for	  a	  successful	  API	  integration.	  
	  

Who:	  API	  Authentication	  
Typically	  APIs	  are	  authenticated	  as	  they	  are	  providing	  access	  to	  data	  
programmatically	  that	  would	  otherwise	  only	  be	  available	  through	  a	  user	  login	  
workflow.	  There	  are	  many	  different	  approaches	  to	  authenticating	  and	  
authorizing	  API	  access	  and	  these	  often	  differ	  based	  on	  the	  class	  of	  data	  being	  
accessed.	  

Some	  of	  the	  most	  common	  API	  authorization	  techniques	  used	  in	  API	  design	  are:	  

• Basic	  Authorization	  (presented	  in	  HTTP	  Header	  –	  Base64	  user:password)	  
• API	  Key	  (presented	  in	  HTTP	  header	  or	  in	  API	  payload)	  
• OAuth	  2.0	  (Authorization	  framework	  for	  authorizing	  access	  to	  your	  data)	  

	  

Deep	  discussion	  of	  each	  of	  these	  authorization	  options	  is	  outside	  of	  the	  scope	  of	  
this	  overview	  document	  but	  given	  the	  new	  support	  for	  OAuth2	  based	  
authorization	  in	  ClearPass,	  the	  following	  section	  will	  discuss	  the	  technology	  and	  
how	  it	  is	  applied	  to	  the	  new	  ClearPass	  API	  surface.	  

Where:	  URL	  Location	  
Anyone	  wanting	  to	  interact	  with	  an	  API	  needs	  to	  know	  where	  to	  find	  the	  API	  
server	  and	  importantly	  the	  URL	  path	  to	  the	  resource	  they	  are	  interested	  in.	  This	  
is	  no	  different	  to	  a	  URL	  that	  would	  be	  typed	  into	  a	  web	  browser	  and	  the	  API	  
documentation	  should	  detail	  where	  to	  find	  the	  resource	  you	  wish	  to	  interact	  
with.	  

All	  of	  the	  new	  ClearPass	  APIs	  can	  be	  accessed	  from	  the	  root	  location	  of	  /api	  
from	  any	  of	  the	  nodes	  in	  your	  ClearPass	  cluster.	  As	  with	  any	  many	  of	  the	  
functions	  within	  the	  ClearPass	  cluster	  deployments,	  read-‐access	  is	  available	  from	  
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all	  nodes	  in	  the	  cluster	  and	  ClearPass	  will	  internally	  proxy	  any	  write	  requests	  
back	  to	  the	  Publisher	  node	  to	  ensure	  database	  consistency.	  

The	  following	  are	  examples	  of	  published	  API	  endpoints	  available	  from	  the	  
ClearPass	  server	  as	  part	  of	  the	  6.5	  release.	  

OAuth2	  endpoint	  for	  
authorization:	  

https://<ClearPass FQDN>/api/oauth 

Guest	  endpoint	  to	  retrieving	  
guest	  accounts:	  

https://<ClearPass FQDN>/api/guest 

How:	  HTTP	  Method	  
The	  HTTP	  method	  of	  an	  API	  describes	  how	  the	  server	  is	  expecting	  to	  receive	  the	  
API	  request.	  A	  web	  browser	  by	  default	  is	  using	  a	  HTTP	  GET	  when	  downloading	  a	  
web	  page	  and	  a	  HTTP	  POST	  when	  a	  user	  fills	  out	  a	  form	  and	  submits	  it	  to	  a	  
server.	  APIs	  work	  in	  a	  very	  similar	  fashion	  to	  the	  web	  browser	  with	  the	  
additional	  capability	  of	  being	  able	  to	  take	  advantage	  of	  other	  HTTP	  methods	  such	  
as	  PUT	  (replace	  an	  object	  on	  the	  server),	  DELETE	  (remove	  an	  object	  on	  the	  
server)	  or	  potentially	  PATCH	  (update	  an	  object	  on	  the	  server).	  Using	  the	  HTTP	  
method	  to	  signal	  the	  intent	  of	  an	  API	  call	  is	  at	  the	  heart	  of	  the	  REST	  API	  design	  
principal	  which	  is	  considered	  a	  best	  practice	  for	  modern	  API	  design.	  

The	  new	  ClearPass	  APIs	  have	  adopted	  this	  design	  pattern	  of	  leveraging	  the	  HTTP	  
method	  to	  indicate	  the	  intent	  of	  the	  API	  transaction.	  For	  example,	  the	  following	  
table	  shows	  some	  examples	  of	  how	  the	  HTTP	  method	  could	  be	  applied	  to	  the	  
/api/guest	  endpoint.	  

	  

Endpoint	   HTTP	  Method	   Intention	  

/api/guest	   GET	   Retrieve	  the	  collection	  of	  currently	  
managed	  guest	  accounts	  

/api/guest/{id}	   GET	   Retrieve	  the	  guest	  account	  identified	  by	  
{id}	  

/api/guest	   POST	   Create	  a	  new	  guest	  account	  based	  on	  
contents	  of	  API	  Payload	  

/api/guest/{id}	   PUT	   Update	  guest	  user	  (full	  replace)	  

/api/guest/{id}	   PATCH	   Partial	  update	  of	  guest	  user	  (merge)	  
identified	  by	  {id}	  

/api/guest/{id}	   DELETE	   Delete	  a	  guest	  user	  identified	  by	  {id}	  
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What:	  API	  Payload	  /	  Content	  
The	  API	  content	  needs	  to	  be	  presented	  in	  a	  format	  that	  can	  be	  understood	  by	  the	  
server	  and	  the	  specifics	  are	  the	  format	  detailed	  in	  the	  API	  documentation.	  Some	  
of	  the	  more	  common	  formats	  supported	  by	  APIs	  are:	  

• JSON	  (application/json)	  
• XML	  (application/xml)	  
• Form	  Encoded	  (application/x-‐www-‐form-‐urlencoded)	  
• Plain	  Text	  (text/plain)	  

	  

Also	  included	  in	  the	  list	  above	  is	  the	  value	  that	  needs	  to	  be	  included	  the	  HTTP	  
Content-‐Type	  header	  so	  the	  API	  server	  knows	  what	  format	  you	  are	  sending	  in	  
the	  API	  payload.	  

The	  ClearPass	  APIs	  are	  designed	  to	  expect	  the	  JSON	  content	  type	  when	  the	  API	  
call	  requires	  a	  HTTP	  body	  to	  be	  submitted	  (typically	  in	  unsafe	  operations	  such	  as	  
POST,	  PUT,	  PATCH	  and	  DELETE).	  
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API	  Documentation	  
Detailed	  documentation	  is	  available	  for	  the	  ClearPass	  APIs	  by	  clicking	  on	  the	  API	  
Explorer	  link	  from	  the	  top	  right	  hand	  corner	  of	  the	  API	  Services	  configuration	  
page	  from	  Administration	  >	  API	  Services	  >	  API	  Clients	  menu	  option.	  

	  

Alternatively	  the	  documentation	  can	  be	  directly	  accessed	  from	  the	  following	  
URL:	  

http://<ClearPass-Server-IP-or-FQDN>/api-docs 

Accessing	  this	  page	  will	  display	  a	  catalog	  of	  available	  API	  entry	  points	  based	  on	  
the	  various	  sub-‐systems	  of	  ClearPass	  that	  are	  currently	  exposed	  through	  the	  new	  
HTTP	  APIs.	  

	  

Selecting	  one	  of	  the	  API	  entry	  points	  will	  then	  display	  the	  interactive	  API	  
document	  for	  all	  of	  the	  API	  methods	  available	  for	  that	  ClearPass	  resource.	  The	  
following	  screenshot	  shows	  the	  example	  of	  the	  ClearPass	  Guest	  resource	  and	  the	  
API	  methods	  available.	  
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API	  Configuration	  Options	  
Several	  global	  configuration	  options	  can	  be	  modified	  by	  browsing	  to	  the	  
Administration	  >	  Plugin	  Manager	  menu	  option	  of	  the	  ClearPass	  Guest	  
administrative	  interface	  and	  clicking	  on	  the	  Configuration	  option	  of	  the	  API	  
Framework	  plugin.	  

	  

From	  the	  resulting	  page	  allows	  options	  such	  as	  token	  lifetimes,	  logging	  levels	  
and	  support	  for	  cross	  origin	  access	  typically	  associated	  with	  client	  side	  
technologies	  such	  as	  javascript.	  
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Default	  Lifetimes	  
Although	  token	  lifetimes	  can	  be	  configured	  on	  an	  individual	  basis	  for	  each	  API	  
Client	  defined	  from	  the	  Administration	  >	  API	  Services	  >	  API	  Client	  configuration	  
page,	  the	  global	  default	  token	  lifetimes	  can	  be	  updated	  from	  the	  plugin	  
configuration.	  

Logging	  
During	  development	  of	  a	  new	  App	  that	  is	  leveraging	  the	  ClearPass	  APIs,	  there	  
maybe	  a	  requirement	  to	  increase	  the	  logging	  level	  from	  the	  default	  Standard	  
(basic)	  logging	  detail.	  This	  level	  of	  detail	  can	  be	  updated	  from	  the	  plugin	  
configuration	  and	  the	  log	  output	  is	  available	  from	  the	  Administration	  >	  Support	  
>	  Application	  Log	  menu	  option.	  

It	  is	  recommended	  that	  post	  any	  development	  testing	  of	  APIs	  that	  the	  logging	  
level	  be	  returned	  to	  the	  default	  standard	  (basic)	  logging	  detail.	  

Cross	  Origin	  Resource	  Sharing	  (CORS)	  Support	  
The	  ClearPass	  APIs	  provide	  an	  option	  to	  enable	  server	  side	  support	  for	  Cross	  
Origin	  Resource	  Sharing	  by	  specifying	  a	  whitelist	  of	  either	  individual	  servers	  or	  
domains	  that	  should	  be	  permitted	  to	  access	  the	  API	  resources	  from	  a	  browser	  
interface	  even	  though	  the	  initial	  webpage	  did	  not	  originate	  from	  the	  ClearPass	  
server.	  

Modern	  web	  browsers	  have	  inbuilt	  security	  to	  protect	  users	  from	  malicious	  
websites	  that	  attempt	  to	  access	  3rd	  party	  websites	  (or	  post	  data	  to)	  whilst	  a	  user	  
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is	  browsing	  their	  intended	  destination.	  By	  enabling	  the	  CORS	  support	  on	  
ClearPass	  the	  APIs	  can	  be	  accessed	  in	  this	  manner	  and	  is	  typically	  used	  in	  
development	  environments	  where	  a	  local	  webserver	  on	  the	  development	  host	  is	  
used	  to	  temporarily	  host	  the	  basic	  HTML,	  CSS	  whilst	  the	  content	  is	  drawn	  from	  
the	  API	  responses.	  

As	  noted	  in	  the	  user	  interface	  screenshot	  above,	  wildcards	  can	  be	  used	  to	  
nominate	  an	  entire	  domain	  or	  potentially	  whitelist	  all	  origins	  during	  a	  
development	  and	  testing	  phase.	  For	  a	  production	  deployment,	  it	  is	  
recommended	  that	  only	  specific	  hosts	  or	  known	  domains	  be	  included	  in	  the	  
CORS	  whitelist.	  
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Summary	  
The	  following	  table	  summarizes	  the	  various	  API	  conventions	  that	  make	  up	  the	  
new	  ClearPass	  HTTP	  based	  APIs.	  

Who	   API	  
Authentication	  

OAuth2	   See	  following	  section	  for	  
grant	  types	  supported	  

Where	   URL	  Location	   /api/<resource>	   All	  APIs	  available	  from	  the	  
root	  /api	  

How	   HTTP	  Method	   GET,	  POST,	  PUT,	  
PATCH,	  DELETE	  

REST	  based	  design	  to	  use	  
HTTP	  Method	  as	  the	  intent	  of	  
the	  API	  call	  

What	   API	  Payload	   JSON	   Not	  required	  for	  read-‐only	  
GET	  requests	  
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API	  Authorization	  –	  OAuth2	  
	  

The	  industry	  has	  largely	  aligned	  on	  the	  use	  of	  OAuth2	  and	  /	  or	  OpenID	  Connect	  
as	  the	  solution	  for	  providing	  authentication	  and	  authorization	  for	  developer	  API	  
access.	  The	  OAuth	  2	  RFC	  6749	  specification	  accommodates	  various	  different	  API	  
access	  scenarios	  ranging	  from	  simple	  server	  to	  server	  integration	  to	  the	  
increasingly	  common	  use	  case	  of	  a	  user	  of	  a	  particular	  service	  granting	  
authorized	  access	  to	  all	  or	  a	  subset	  of	  their	  data	  to	  a	  3rd	  party	  application.	  

Overview	  	  
OAuth	  2.0	  is	  a	  simple	  and	  secure	  authorization	  framework.	  It	  allows	  applications	  
to	  acquire	  an	  access	  token	  for	  authorized	  API	  access	  via	  various	  different	  
workflows	  supported	  within	  the	  OAuth2	  specification.	  Once	  an	  application	  has	  
an	  access	  token,	  it	  can	  access	  the	  various	  API’s	  serviced	  by	  server	  platform	  either	  
to	  configure	  the	  platform	  itself	  or	  act	  on	  behalf	  of	  a	  related	  user.	  At	  a	  very	  high	  
level,	  authorization	  with	  OAuth	  can	  be	  accomplished	  in	  the	  following	  steps.	  

• Decide	  on	  the	  use	  case	  for	  API	  Access	  –	  administrative	  configuration	  of	  
the	  server	  platform	  or	  managing	  the	  hosted	  data	  on	  behalf	  of	  a	  user.	  

• Create	  API	  Client	  definition	  on	  the	  server	  that	  matches	  the	  above	  use	  case	  	  
• Request	  an	  Access	  Token	  using	  the	  Client	  ID	  details	  from	  the	  API	  client	  

definition	  created	  in	  the	  previous	  step.	  
• Make	  authorized	  API	  calls	  to	  the	  server	  APIs	  by	  including	  the	  Bearer 

<access_token>	  in	  the	  HTTP	  Authorization	  header.	  

OAuth	  Basics	  
The	  best	  way	  to	  understand	  the	  different	  use	  cases	  for	  OAuth2	  is	  to	  start	  with	  the	  
various	  roles	  that	  make	  up	  a	  possible	  OAuth2	  transaction.	  

Resource	  Owner	  
The	  resource	  owner	  is	  the	  person	  or	  application	  that	  owns	  the	  data	  that	  is	  to	  be	  
shared.	  For	  example,	  a	  user	  on	  Facebook	  or	  Twitter	  could	  be	  a	  resource	  owner	  
and	  the	  resource	  they	  own	  is	  their	  data	  on	  these	  social	  platforms.	  Typically	  the	  
resource	  owner	  is	  thought	  of	  as	  a	  person	  but	  it	  could	  also	  be	  an	  application.	  The	  
OAuth	  2.0	  specification	  supports	  different	  workflows	  for	  each	  of	  these	  use	  cases.	  

Within	  the	  context	  of	  ClearPass,	  the	  resource	  owner	  can	  be	  thought	  of	  a	  the	  
Sponsor	  or	  ClearPass	  operator	  that	  is	  acting	  upon	  the	  data	  stored	  within	  the	  
ClearPass	  platform	  

Resource	  Server	  
The	  resource	  server	  is	  the	  server	  hosting	  the	  resources.	  For	  example,	  a	  platform	  
such	  as	  Facebook	  or	  Twitter	  would	  be	  considered	  a	  resource	  server.	  It	  is	  
essentially	  the	  server	  hosting	  the	  protected	  content	  that	  will	  be	  accessed	  via	  the	  
APIs.	  
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Relating	  this	  back	  to	  ClearPass	  API	  use	  cases	  the	  resource	  server	  is	  the	  ClearPass	  
server	  or	  cluster	  of	  server	  depending	  on	  the	  deployment	  type.	  All	  nodes	  within	  
the	  ClearPass	  cluster	  can	  service	  read-‐only	  API	  calls	  and	  any	  unsafe	  API	  
operations	  (POST,	  PUT,	  DELETE)	  will	  be	  internally	  proxied	  to	  the	  ClearPass	  
publisher	  for	  database	  synchronization.	  

Client	  Application	  
The	  client	  application	  is	  the	  application	  requesting	  access	  to	  the	  protected	  
resources	  stored	  on	  the	  resource	  server.	  	  

This	  will	  be	  the	  application	  that	  is	  being	  developed	  to	  leverage	  the	  APIs	  and	  data	  
hosted	  by	  the	  ClearPass	  platform.	  This	  App	  could	  take	  many	  forms,	  from	  a	  native	  
mobile	  App	  through	  to	  a	  server	  side	  script	  that	  is	  run	  on	  a	  periodical	  basis.	  

Authorization	  Server	  
The	  authorization	  server	  is	  authorizing	  the	  client	  application	  to	  access	  the	  
resources	  of	  the	  resource	  owner.	  The	  authorization	  server	  and	  the	  resource	  
server	  can	  be	  deployed	  as	  part	  of	  the	  same	  server,	  but	  the	  OAuth	  2.0	  
specification	  does	  not	  dictate	  whether	  they	  should	  be	  collocated	  or	  separated.	  	  

In	  the	  case	  of	  the	  ClearPass	  platform	  and	  in	  the	  interests	  of	  simplicity	  it	  is	  fair	  to	  
assume	  the	  resource	  server	  and	  authorization	  server	  are	  co-‐located	  on	  the	  same	  
server.	  	  
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OAuth2	  Client	  
Before	  any	  OAuth	  transactions	  can	  be	  processed,	  the	  first	  step	  is	  to	  register	  a	  
new	  app	  definition.	  When	  registering	  a	  new	  app	  with	  the	  ClearPass	  
Authorization	  Server,	  basic	  information	  such	  as	  application	  name	  and	  the	  
OAuth2	  grant	  type	  are	  specified.	  	  

From	  the	  ClearPass	  Guest	  administration	  interface	  a	  new	  OAuth2	  API	  client	  can	  
be	  created	  by	  browsing	  to	  the	  Administration	  >	  API	  Services	  >	  API	  Clients	  web	  
page.	  Click	  on	  the	  Create	  API	  client	  button	  in	  the	  top	  right	  corner	  and	  following	  
form	  can	  be	  completed	  to	  suit	  the	  requirements	  of	  the	  current	  API	  integration.	  

	  

A	  more	  detailed	  discussion	  of	  the	  various	  options	  when	  configuring	  an	  OAuth2	  
client	  is	  included	  in	  Getting	  Started	  chapter	  of	  this	  document.	  

The	  result	  of	  registering	  an	  OAuth2	  app	  is	  a	  client	  id	  and	  client	  secret.	  These	  will	  
need	  to	  be	  retained	  and	  shared	  with	  the	  App	  developer	  to	  enable	  them	  to	  
successfully	  authorize	  the	  API	  access	  and	  make	  subsequent	  API	  calls.	  

Client	  ID	  and	  Secret	  
After	  registering	  your	  app,	  you	  will	  receive	  a	  client	  ID	  and	  a	  client	  secret.	  The	  
client	  ID	  is	  considered	  public	  information,	  and	  is	  used	  to	  build	  login	  URLs,	  or	  
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included	  in	  JavaScript	  source	  code	  on	  a	  page.	  The	  client	  secret	  must	  be	  kept	  
confidential.	  If	  a	  deployed	  app	  cannot	  keep	  the	  secret	  confidential,	  such	  as	  
JavaScript	  or	  native	  apps,	  then	  the	  secret	  is	  not	  to	  be	  used.	  

Authorization	  Grant	  Types	  
OAuth	  2	  provides	  several	  "grant	  types"	  for	  different	  use	  cases.	  The	  grant	  types	  
defined	  are:	  

• Authorization	  Code	  for	  apps	  running	  on	  a	  web	  server	  
• Implicit	  for	  browser-‐based	  or	  mobile	  apps	  
• Password	  for	  logging	  in	  with	  a	  username	  and	  password	  
• Client	  credentials	  for	  application	  access	  

	  

Note:	  For	  the	  initial	  release	  of	  OAuth2	  support	  for	  API	  authentication	  and	  
authorization,	  ClearPass	  6.5	  will	  only	  be	  supporting	  the	  password	  and	  client	  
credentials	  grant	  types.	  Subsequent	  releases	  will	  add	  the	  additional	  grant	  types	  
as	  the	  customer	  and	  partner	  uses	  cases	  drive	  the	  need	  for	  these	  browser	  based	  
workflows.	  The	  description	  of	  how	  the	  Authorization	  and	  the	  Implicit	  Flow	  grant	  
types	  differ	  from	  those	  currently	  supported	  by	  ClearPass,	  have	  been	  included	  in	  
Appendix	  A	  for	  completeness.	  
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Resource	  Owner	  Password	  
OAuth	  2	  also	  provides	  a	  password	  grant	  type,	  which	  can	  be	  used	  to	  exchange	  a	  
username	  and	  password	  for	  an	  access	  token	  directly.	  This	  is	  often	  compared	  
with	  HTTP	  basic	  authentication	  as	  the	  same	  credentials	  are	  being	  exchanged	  but	  
has	  the	  same	  security	  benefits	  of	  the	  other	  OAuth2	  grant	  types	  in	  expiring	  access	  
token	  and	  the	  ability	  to	  refresh	  the	  access	  token	  without	  the	  need	  to	  cache	  or	  
resubmit	  the	  user	  credentials.	  

Since	  this	  requires	  the	  application	  to	  natively	  collect	  the	  user's	  credentials,	  this	  
grant	  type	  should	  only	  be	  used	  for	  Apps	  with	  a	  direct	  relationship	  (first	  party)	  
with	  the	  Authorization	  server.	  A	  real	  world	  example	  could	  be	  the	  official	  mobile	  
App	  for	  a	  social	  networking	  site	  versus	  allowing	  3rd	  party	  developers	  leverage	  
API’s	  to	  develop	  their	  own	  mobile	  experience	  for	  the	  social	  platform	  (they	  should	  
be	  leveraging	  the	  Implicit	  flow).	  

The	  following	  diagram	  shows	  the	  transaction	  flow	  of	  the	  Password	  grant	  type.	  

	  

1.	  User	  enter	  credentials	  directly	  into	  the	  App’s	  native	  user	  interface	  

• App	  should	  not	  cache	  user	  credentials	  under	  any	  circumstances	  
2.	  The	  App	  submits	  the	  user	  credentials	  to	  the	  Authorization	  Server.	  

• Includes	  grant_type=password,	  user,	  password,	  client_id,	  client_secret	  *	  
• *client_secret	  is	  not	  required	  is	  the	  OAuth2	  App	  is	  defined	  as	  a	  public	  client	  

3.	  Resource	  Server	  returns	  access	  token	  for	  use	  in	  subsequent	  API	  calls	  

• Includes	  access_token,	  expiry	  time,	  token_type=bearer,	  refresh_token	  
4.	  The	  App	  includes	  access	  token	  in	  the	  HTTP	  Authorization	  header.	  

• Includes	  Bearer	  access_token	  	  
5.	  Resource	  Server	  returns	  authenticated	  API	  payload.	  
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Client	  Credentials	  
The	  simplest	  grant	  type	  offered	  by	  OAuth2	  doesn’t	  include	  a	  3rd	  party	  user	  at	  all	  
and	  is	  essentially	  intended	  for	  server-‐to-‐server	  integrations	  for	  updating	  the	  
application	  server	  configuration.	  In	  this	  case,	  applications	  need	  a	  way	  to	  get	  an	  
access	  token	  for	  their	  own	  user	  and	  do	  this	  outside	  the	  context	  of	  any	  specific	  
user.	  OAuth	  provides	  the	  client	  credentials	  grant	  type	  for	  this	  purpose.	  

Given	  the	  simplicity	  of	  this	  grant	  type,	  many	  developers	  may	  leverage	  its	  basic	  
workflow	  to	  recover	  an	  access	  token	  so	  they	  can	  get	  and	  up	  running	  quickly	  with	  
the	  API’s.	  That	  being	  said,	  client	  credentials	  should	  never	  be	  used	  in	  production	  
where	  an	  untrusted	  3rd	  party	  developer	  has	  access	  to	  the	  client	  secret.	  

The	  following	  diagram	  shows	  the	  transaction	  flow	  of	  the	  client	  credentials	  grant	  
type.	  

	  

1.	  The	  first	  party	  App	  submits	  an	  access	  token	  request	  to	  the	  Authorization	  
Server.	  

• Includes	  grant_type=client_credentials,	  client_id,	  client_secret	  
2.	  Resource	  Server	  returns	  access	  token	  for	  use	  in	  subsequent	  API	  calls	  

• Includes	  access_token,	  expiry	  time,	  token_type=bearer	  
3.	  The	  App	  includes	  access	  token	  in	  the	  HTTP	  Authorization	  header.	  

• Includes	  Bearer	  access_token	  	  
4.	  Resource	  Server	  returns	  authenticated	  API	  payload.	  
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Getting	  Started	  
	  

This	  chapter	  is	  designed	  to	  walk	  a	  ClearPass	  administrator	  through	  the	  steps	  
required	  to	  get	  a	  basic	  API	  integration	  up	  and	  running	  in	  preparation	  for	  the	  
deployment	  of	  a	  mobile	  App,	  such	  as	  the	  QuickAccess	  App	  developed	  by	  Aruba.	  

The	  mobile	  App	  will	  leverage	  the	  ClearPass	  OAuth2	  support	  to	  authenticate	  and	  
authorize	  a	  mobile	  user.	  All	  subsequent	  API	  calls	  will	  be	  made	  on	  behalf	  of	  this	  
user	  and	  reflect	  their	  privileges	  on	  the	  ClearPass	  server.	  

Based	  on	  this	  use	  case	  the	  appropriate	  OAuth2	  grant	  type	  will	  be	  the	  Password	  
grant	  type	  as	  the	  App	  is	  working	  on	  data	  associated	  with	  a	  specific	  user.	  

Step	  1.	  Create	  API	  Client	  
Browsing	  to	  the	  Administration	  >	  API	  Services	  >	  API	  Clients	  menu	  option,	  a	  new	  
API	  Client	  can	  be	  defined	  by	  clicking	  on	  the	  Create	  API	  Client	  link	  found	  in	  the	  
top	  right	  hand	  corner	  of	  the	  page.	  

The	  API	  Client	  definition	  is	  the	  method	  of	  establishing	  a	  relationship	  between	  the	  
ClearPass	  Authorization	  Server	  and	  the	  client	  application	  that	  is	  being	  developed	  
and	  wishes	  to	  leverage	  the	  API	  resources	  hosted	  by	  ClearPass.	  	  
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Operator	  Profile	  
The	  Operator	  Profile	  defines	  the	  class	  of	  user	  and	  privileges	  associated	  with	  the	  
API	  access	  that	  will	  be	  granted	  to	  a	  client	  application	  based	  upon	  successful	  
authorization.	  

The	  details	  of	  the	  ClearPass	  privileges	  associated	  with	  a	  particular	  operator	  
profile	  can	  be	  reviewed	  or	  modified	  by	  browsing	  to	  the	  Administration	  >	  
Operator	  Logins	  >	  Profiles	  menu	  option.	  

Grant	  Type	  
Referring	  back	  to	  the	  previous	  OAuth2	  technology	  overview,	  the	  API	  Client	  
definition	  allows	  the	  administrator	  to	  currently	  select	  from	  the	  following	  
supported	  grant	  types:	  

• Client	  Credentials	  
• Resource	  Owner	  Password	  

Future	  versions	  of	  ClearPass	  will	  extend	  the	  OAuth2	  use	  cases	  to	  cover	  
Authorization	  Code	  and	  Implicit	  grant	  types.	  

Public	  Client	  
In	  the	  case	  that	  the	  Password	  grant	  type	  has	  been	  selected,	  the	  default	  operation	  
is	  to	  create	  a	  Client	  Secret	  as	  shown	  in	  the	  example	  screenshot	  below.	  

	  

As	  discussed	  in	  the	  OAuth2	  technology	  overview,	  the	  client	  secret	  must	  also	  be	  
kept	  secret	  to	  avoid	  potential	  security	  breaches.	  In	  some	  deployment	  scenarios	  
the	  App	  will	  be	  deployed	  as	  a	  native	  mobile	  App	  where	  the	  operating	  system	  and	  
the	  App	  itself	  cannot	  be	  guaranteed	  to	  be	  trusted	  and	  any	  credentials	  stored	  
within	  the	  App	  are	  at	  risk	  of	  being	  exposed.	  

For	  this	  reason	  the	  password	  grant	  type	  offers	  the	  ability	  to	  define	  the	  API	  client	  
as	  a	  public	  client	  and	  in	  this	  deployment	  scenario	  the	  App	  does	  not	  need	  to	  
present	  the	  client	  secret	  as	  part	  of	  OAuth2	  authorization	  request.	  

The	  user	  of	  the	  App	  needs	  to	  make	  a	  determination	  as	  to	  whether	  they	  trust	  the	  
native	  App	  before	  entering	  in	  their	  user	  credentials	  to	  login	  into	  the	  service	  
provided.	  	  

Refresh	  Token	  
The	  refresh	  token	  allows	  an	  App	  a	  method	  to	  recover	  a	  short-‐lived	  access	  token	  
from	  the	  ClearPass	  server.	  The	  access	  token	  is	  typically	  short	  lived	  to	  limit	  the	  
exposure	  to	  a	  compromised	  token	  as	  the	  attacker	  has	  a	  limited	  window	  in	  which	  
to	  abuse	  it.	  
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Whilst	  the	  refresh	  token	  has	  not	  expired,	  an	  authorized	  App	  is	  able	  to	  make	  
subsequent	  authorization	  requests	  to	  recover	  new	  access	  tokens	  and	  continue	  to	  
transact	  API	  calls.	  

The	  administrator	  can	  choose	  to	  enable	  refresh	  token	  support	  on	  each	  API	  client	  
definition	  by	  checking	  the	  option	  shown	  in	  the	  screenshot	  above.	  

Access	  Token	  Lifetime	  
The	  short	  lived	  access	  token	  lifetime	  can	  be	  defined	  for	  each	  individual	  API	  client	  
to	  suit	  the	  use	  case	  of	  the	  API	  access	  being	  enabled.	  

Refresh	  Token	  Lifetime	  
Similarly,	  if	  refresh	  tokens	  have	  been	  enabled	  for	  the	  API	  client	  in	  question,	  the	  
lifetime	  of	  the	  refresh	  time	  can	  be	  customized	  to	  suit	  the	  use	  case	  of	  the	  API	  
access	  that	  is	  being	  enabled.	  

Step	  2.	  Ensure	  API	  Access	  Enabled	  for	  users	  
Each	  operator	  profile	  has	  the	  ability	  to	  define	  whether	  API	  access	  is	  enabled	  for	  
that	  class	  of	  users.	  This	  setting	  will	  override	  any	  individual	  ClearPass	  privileges	  
that	  may	  have	  been	  enabled	  through	  the	  Operator	  profile	  elsewhere	  so	  it	  is	  
critical	  to	  ensure	  this	  option	  is	  enabled	  for	  the	  target	  users	  of	  the	  App.	  
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Step	  3.	  Verify	  User	  Account	  	  
As	  the	  API	  client	  has	  been	  configured	  based	  on	  the	  Password	  grant	  type,	  all	  API	  
calls	  will	  be	  to	  be	  executed	  with	  the	  context	  of	  a	  user	  known	  to	  ClearPass.	  
Although	  various	  external	  user	  databases	  are	  supported	  by	  ClearPass,	  this	  
example	  will	  just	  leverage	  the	  local	  user	  database.	  

From	  the	  ClearPass	  Policy	  Manager	  administration	  user	  interface,	  select	  the	  
Configuration	  >	  Identity	  >	  Local	  Users	  menu	  option	  to	  verify	  an	  account	  already	  
existing	  and	  belong	  to	  the	  appropriate	  Operator	  Profile.	  

If	  an	  appropriate	  account	  doesn’t	  exist	  a	  new	  one	  can	  be	  quickly	  created	  by	  
clicking	  on	  the	  +Add	  button	  in	  the	  top	  right	  corner	  and	  filling	  out	  the	  required	  
fields	  as	  shown	  below.	  

	  

Click	  the	  Add	  button	  to	  commit	  the	  new	  user	  to	  the	  ClearPass	  database.	  
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Step	  4.	  Create	  Policy	  Manager	  Service	  	  
In	  order	  for	  ClearPass	  Policy	  Manager	  to	  successfully	  authenticate	  the	  OAuth2	  
authorization	  requests	  for	  any	  of	  the	  configured	  API	  clients,	  a	  new	  service	  
definition	  must	  be	  created.	  ClearPass	  Policy	  Manager	  has	  a	  built	  in	  wizard	  for	  
quickly	  creating	  the	  required	  service	  definition	  to	  support	  OAuth2	  based	  API	  
authorization	  and	  this	  can	  be	  created	  by	  browsing	  to	  the	  Configuration	  >	  Start	  
Here	  menu	  option	  from	  within	  the	  administration	  interface.	  

Scrolling	  down	  the	  list	  of	  available	  service	  definition	  wizards	  the	  OAuth2	  API	  
User	  Access	  wizard	  can	  be	  found	  towards	  the	  bottom.	  

	  

Click	  on	  the	  OAuth2	  API	  User	  Access	  wizard	  and	  fill	  out	  a	  descriptive	  name	  for	  
the	  service	  so	  it	  can	  be	  easily	  identified	  in	  the	  Policy	  Manager’s	  service	  list	  in	  the	  
future.	  Click	  the	  Add	  Service	  button	  to	  commit	  the	  service	  to	  the	  policy	  engine.	  

	  

Now	  referencing	  the	  ClearPass	  Policy	  Manager’s	  service	  list,	  the	  new	  OAuth2	  
service	  definition	  should	  be	  available	  and	  enabled	  for	  API	  access	  as	  shown	  in	  the	  
screenshot	  below.	  
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Step	  5.	  Test	  API	  Authorization	  
The	  ClearPass	  OAuth2	  authorization	  endpoint	  is	  available	  using	  the	  following	  
details:	  

Location	   Method	   Content	  Type	   Payload	  

/api/oauth	   POST	   JSON	   grant_type,	  username,	  password,	  
client_id,	  client_secret*	  

	  

*	  client_secret	  required	  if	  the	  API	  client	  definition	  is	  not	  configured	  as	  public	  
client.	  

In	  order	  to	  test	  the	  OAuth2	  API	  authorization	  on	  ClearPass	  any	  basic	  HTTP	  client	  
can	  be	  used	  to	  craft	  the	  API	  call.	  There	  are	  many	  browser	  plugins	  (RESTClient,	  
Postman	  etc)	  and	  command	  line	  tools	  available	  that	  support	  this	  style	  of	  API	  
integration.	  

The	  following	  example	  is	  using	  a	  widely	  deployed	  command	  line	  tool	  found	  in	  
many	  operating	  systems	  call	  cURL.	  More	  details	  on	  the	  cURL	  client	  can	  be	  found	  
on	  the	  following	  website.	  (http://curl.haxx.se/)	  

curl -X POST "https://test.clearpassbeta.com/api/oauth" \ 

     -H "Content-Type: application/json" \ 

     -d $'{"grant_type": "password", "username": "qa", "password": 
"abc123", "client_id": "QuickAccess"}' \ 

     -m 30 \ 

     -v \ 

     -k 

	  

*	  Note	  –	  if	  you	  are	  using	  the	  Windows	  version	  of	  cURL	  you	  may	  need	  to	  remove	  
the	  slashes	  (	  \	  )	  and	  collapse	  the	  entire	  command	  into	  a	  single	  line.	  
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If	  the	  configuration	  of	  the	  ClearPass	  server	  is	  correct,	  a	  JSON	  object	  similar	  to	  the	  
one	  below	  should	  be	  returned.	  The	  JSON	  object	  contains	  the	  following	  attribute	  
value	  pairs:	  

• access_token	  :	  to	  token	  associated	  with	  the	  authorized	  user	  
• expires_in	  :	  the	  above	  access	  token	  will	  expire	  in	  x	  seconds	  
• token_type	  :	  bearer	  token	  will	  be	  included	  in	  all	  subsequent	  API	  calls	  
• scope	  :	  reserved	  for	  future	  use	  in	  ClearPass	  	  
• refresh_token	  :	  to	  be	  stored	  to	  recovering	  a	  new	  access	  token	  on	  expiry	  

{"access_token":"81d3136c9025c394222d6202375924d30330ce9a","expires_i
n":28800,"token_type":"Bearer","scope":null,"refresh_token":"2fb63c38
824eb2c0c75bf3894eda9109019b8c86"} 

Returning	  to	  the	  ClearPass	  Policy	  Manager	  administration	  interface,	  the	  
Monitoring	  >	  Live	  Monitoring	  >	  Access	  Tracker	  menu	  option	  can	  be	  selected	  and	  
the	  successful	  OAuth2	  transactions	  can	  be	  reviewed.	  
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Step	  6.	  Test	  API	  Transaction	  
Now	  that	  the	  OAuth2	  authorization	  step	  is	  complete	  and	  an	  access	  token	  has	  
been	  successfully	  retrieved	  from	  the	  ClearPass	  server,	  any	  required	  API	  calls	  can	  
now	  be	  made	  to	  the	  server.	  

In	  order	  to	  reference	  the	  context	  of	  the	  authorized	  user,	  the	  access	  token	  must	  be	  
included	  in	  every	  subsequent	  API	  call.	  As	  per	  the	  OAuth2	  specification,	  this	  
access	  token	  must	  be	  included	  in	  the	  HTTP	  Authorization	  Header	  in	  the	  
following	  format.	  

Authorization: Bearer <access_token> 

Using	  the	  cURL	  command	  again,	  an	  API	  call	  can	  be	  made	  to	  a	  defined	  API	  
endpoint	  that	  will	  return	  all	  of	  the	  ClearPass	  privileges	  associated	  with	  the	  user	  
authorized	  and	  associated	  with	  the	  given	  access	  token.	  

Location	   Method	   Content	  Type	   Payload	  

/api/oauth/privileges	   GET	   n/a	   n/a	  

	  

	  

curl -X GET "https://test.clearpassbeta.com/api/oauth/privileges" \ 

     -H "Accept: application/json" \ 

     -H "Authorization: Bearer 
cd3f7cb063d951e65b43270cfca9cb1d97276556" \ 

     -m 30 \ 

     -v \ 

     -k 

	  

*	  Note	  –	  if	  you	  are	  using	  the	  Windows	  version	  of	  cURL	  you	  may	  need	  to	  remove	  
the	  slashes	  (	  \	  )	  and	  collapse	  the	  entire	  command	  into	  a	  single	  line.	  

The	  following	  JSON	  object	  details	  the	  privileges	  associated	  with	  the	  authorized	  
user	  on	  the	  ClearPass	  server.	  The	  notation	  of	  the	  privileges	  includes	  a	  prefix	  
which	  denotes	  the	  class	  of	  access	  that	  is	  enabled:	  

• # - TBD 
• ? – TBD 

For	  more	  information	  of	  ClearPass	  API	  privileges	  please	  refer	  the	  User	  Guide	  in	  
Chapter	  XX	  
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{ 
  "privileges": [ 
    "#guest_sessions_history", 
    "#guest_show_details", 
    "#mdps_view_own_certificate", 
    "?api_index", 
    "?guestmanager", 
    "?mdps_index", 
    "apigility", 
    "change_expiration", 
    "create_multi", 
    "create_user", 
    "full-user-control", 
    "guest_multi", 
    "guest_sessions", 
    "guest_users", 
    "mac_create", 
    "mac_list", 
    "mdps_own_device_delete", 
    "mdps_own_device_disable", 
    "mdps_own_device_enable", 
    "mdps_own_device_manage", 
    "mdps_shared_device_delete", 
    "mdps_shared_device_disable", 
    "mdps_shared_device_enable", 
    "mdps_shared_device_manage", 
    "remove_account", 
    "reset_password" 
  ] 
} 

At	  this	  point	  successful	  API	  access	  has	  been	  established	  and	  verified	  and	  the	  App	  
developers	  should	  be	  in	  a	  position	  to	  start	  development	  and	  testing	  against	  the	  
ClearPass	  API	  service.	   	  
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Appendix	  A	  –	  OAuth2	  Grant	  Types	  

Authorization	  Code	  	  
The	  authorization	  code	  grant	  type	  is	  intended	  for	  web	  server	  applications	  using	  
a	  server	  side	  programming	  language	  such	  as	  PHP	  or	  Python	  where	  the	  source	  
code	  of	  the	  application	  is	  not	  available	  to	  the	  public	  –	  hence	  protecting	  the	  client	  
secret.	  

The	  use	  case	  for	  this	  grant	  type	  is	  to	  allow	  a	  user	  of	  the	  web	  server	  application	  to	  
grant	  access	  to	  all	  or	  some	  of	  their	  data	  to	  a	  3rd	  party	  application.	  A	  real	  world	  
example	  of	  this	  could	  a	  social	  network	  application	  requesting	  access	  to	  a	  user’s	  
photos	  on	  a	  photo	  sharing	  web	  site.	  The	  photo	  sharing	  web	  site	  is	  able	  to	  expose	  
their	  user	  profiles	  and	  data	  (photos)	  through	  an	  OAuth2	  application	  on	  their	  
platform	  whilst	  not	  exposing	  their	  client	  secret	  in	  the	  process.	  

The	  following	  diagram	  shows	  the	  transaction	  flow	  of	  the	  Authorization	  code	  
grant	  type.	  

	  

	  

1.	  Redirect	  the	  user	  browser	  to	  Authorization	  Server.	  

• Includes	  response_type=code,	  client_id,	  redirect_uri,	  scope,	  state	  
2.	  User	  authenticates	  and	  grants	  authorization	  to	  the	  3rd	  party	  App.	  

• User	  submits	  their	  credentials	  for	  the	  Authorization	  Server	  
3.	  Authorization	  Server	  now	  redirects	  back	  to	  the	  web	  application	  (redirect	  URI)	  
including	  the	  authorization	  code	  

• Includes	  authorization	  code,	  state	  
4.	  Web	  application	  verifies	  the	  redirect	  and	  sends	  request	  to	  exchange	  the	  
authorization	  code	  for	  an	  access	  token	  (query	  param	  &	  post	  body	  supported)	  
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• Includes	  response_type=authorization_code,	  code,	  client_id,	  client_secret,	  redirect_uri	  
5.	  Authorization	  Server	  returns	  access	  token	  for	  use	  in	  subsequent	  API	  calls	  

• Includes	  access_token,	  expiry	  time,	  token_type=bearer,	  refresh_token	  
6.	  Web	  application	  includes	  access	  token	  in	  the	  HTTP	  Authorization	  header.	  

• Includes	  Bearer	  access_token	  	  
7.	  Resource	  Server	  returns	  authenticated	  API	  payload.	  
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Implicit	  	  
Browser-‐based	  apps	  run	  entirely	  in	  the	  browser	  after	  loading	  the	  source	  code	  
from	  a	  web	  page	  typically	  based	  on	  a	  client	  side	  programming	  language	  such	  as	  
JavaScript.	  Since	  the	  entire	  source	  code	  is	  available	  to	  the	  browser,	  these	  apps	  
cannot	  maintain	  the	  confidentiality	  of	  their	  client	  secret,	  so	  the	  secret	  is	  not	  used	  
in	  this	  case.	  

Like	  browser-‐based	  apps,	  mobile	  apps	  also	  cannot	  maintain	  the	  confidentiality	  of	  
their	  client	  secret.	  Because	  of	  this,	  mobile	  apps	  must	  also	  use	  an	  OAuth2	  flow	  
that	  does	  not	  require	  a	  client	  secret	  such	  as	  the	  implicit	  flow.	  

	  

The	  following	  diagram	  shows	  the	  transaction	  flow	  of	  the	  implicit	  grant	  type.	  

1.	  Redirect	  the	  user	  browser	  to	  Authorization	  Server.	  

• Includes	  response_type=token,	  client_id,	  redirect_uri,	  scope,	  state	  
2.	  User	  authenticates	  and	  grants	  authorization	  to	  the	  3rd	  party	  App.	  

• User	  submits	  their	  credentials	  for	  the	  Authorization	  Server	  
3.	  Authorization	  Server	  now	  redirects	  back	  to	  the	  client	  side	  application	  
(redirect	  URI)	  including	  the	  access	  token	  

• Includes	  access_token,	  state	  
4.	  Client	  side	  application	  recovers	  the	  access	  token	  from	  the	  redirect	  request.	  	  

• Uses	  client	  side	  javascript	  or	  registered	  AppURL	  for	  mobile	  to	  parse	  access	  token	  	  
5.	  Client	  side	  application	  includes	  access	  token	  in	  the	  HTTP	  Authorization	  
header.	  

• Includes	  Bearer	  access_token	  	  
6.	  Resource	  Server	  returns	  authenticated	  API	  payload.	  
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Appendix	  B	  -‐	  OAuth2	  Error	  Messages	  
	  

{"type":"http://www.w3.org/Protocols/rfc2616/rfc2616-
sec10.html","title":"invalid_client","status":400,"detail":"Th
is client is invalid or must authenticate using a client 
secret"} 

	  

{"type":"http://www.w3.org/Protocols/rfc2616/rfc2616-
sec10.html","title":"Forbidden","status":403,"detail":"Client 
does not have \u2018Allow API Access\u2019 privilege"} 

 

 

{"type":"http://www.w3.org/Protocols/rfc2616/rfc2616-
sec10.html","title":"Not 
Acceptable","status":406,"detail":"Cannot honor Accept type 
specified"}	  
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Chapter 1
About this Guide

ClearPass Guest 6.7 provides a simple and personalized user interface through which operational staff can
quickly and securely manage visitor network access. An HTML version of this User Guide is also available.

Audience
This User Guide is intended for system administrators and people who are installing and configuring ClearPass
Guest 6.7 as their visitor management solution. It describes the installation and configuration process.

Related Documents
The following documents are part of the complete documentation set for the ClearPass platform:

l ClearPass Guest 6.7 User Guide

l ClearPass Policy Manager 6.7 User Guide

l ClearPass Deployment Guide

l ClearPass 6.7.x Release Notes

l ClearPass Insight 6.7 User Guide

l ClearPass Policy Manager 6.7 Getting Started Guide

l ClearPass Policy Manager Configuration API Guide

l ClearPass Policy Model: An Introduction

l Tech Note: Installing or Upgrading ClearPass 6.7 on a Virtual Machine

l Tech Note: Upgrading to ClearPass 6.7

Conventions
The following conventions are used throughout this guide to emphasize important concepts:

Type Style Description

Italics This style is used to emphasize important terms and to mark the titles of books.

System items This fixed-width font depicts the following:
l Sample screen output
l System prompts
l Filenames, software devices, and specific commands when mentioned in the text

Commands In the command examples, this bold font depicts text that you must type exactly as
shown.

<Arguments> In the command examples, italicized text within angle brackets represents items that
you should replace with information appropriate to your specific situation. For example:

Table 2: Typographical Conventions
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Type Style Description

# send <text message>

In this example, you would type “send” at the system prompt exactly as shown, followed
by the text of the message you wish to send. Do not type the angle brackets.

[Optional] Command examples enclosed in brackets are optional. Do not type the brackets.

{Item A |

Item B}

In the command examples, items within curled braces and separated by a vertical bar
represent the available choices. Enter only one choice. Do not type the braces or bars.

The following informational icons are used throughout this guide:

Indicates helpful suggestions, pertinent information, and important things to remember.

Indicates a risk of damage to your hardware or loss of data.

Indicates a risk of personal injury or death.

Contacting Support

Main Site arubanetworks.com

Support Site support.arubanetworks.com

Airheads Social Forums and
Knowledge Base

community.arubanetworks.com

North American Telephone 1-800-943-4526 (Toll Free)
1-408-754-1200

International Telephones arubanetworks.com/support-services/contact-support/

Software Licensing Site hpe.com/networking/support

End-of-Life information arubanetworks.com/support-services/end-of-life/

Security Incident
Response Team

Site: arubanetworks.com/support-services/security-bulletins/
Email: sirt@arubanetworks.com
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Chapter 2
ClearPass Guest Overview

This chapter explains the terms, concepts, processes, and equipment involved in managing guest access to a
network, and helps you understand how ClearPass Guest 6.7 can be successfully integrated into your network
infrastructure. It is intended for network architects, IT administrators, and security consultants who are
planning to deploy guest access, or who are in the early stages of deploying a guest access solution.

This chapter includes the following sections:

l "About ClearPass Guest" on page 22

l "Guest Access Scenarios" on page 23

l "Reference Network Diagram" on page 24

l "Key Interactions" on page 25

l "AAA Framework" on page 26

l "Key Features" on page 27

l "Guest Management Terminology" on page 29

l "ClearPass Guest Deployment Process" on page 29

l "AirGroup Deployment Process" on page 31

l "Documentation and User Assistance" on page 32

l "Use of Cookies" on page 34

About ClearPass Guest
ClearPass Guest 6.7 provides a simple and personalized user interface through which operational staff can
quickly and securely manage guest network access. It gives your non-technical staff controlled access to a
dedicated guest management user database. Through a customizable Web portal, your staff can easily create
an account, reset a password, or set an expiry time for guests. Access permissions to ClearPass Guest functions
are controlled through an operator profile that can be integrated with an LDAP server or Active Directory login.

Guests can be registered at reception and provisioned with an individual guest account that defines their guest
profile and the duration of their visit. The guest can be given a printed customized receipt with account details,
or the receipt can be delivered wirelessly using the integrated SMS services. Companies are also able to pre-
generate custom scratch cards, each with a defined network access time, which can then be handed out in a
corporate environment or sold in public access scenarios.

You can use the customization features to define settings that allow your guests to self-provision their own
guest accounts. Guests register through a branded and customized Web portal, ensuring a streamlined and
professional experience. Surveys can also be presented during the self-registration process and the data stored
for later analysis and reporting, providing additional insight to your guests and their network usage.

ClearPass Guest integrates with all leading wireless and NAC solutions through a flexible definition point,
ClearPass Policy Manager. This ensures that IT administrators have a standard integration with the network
security framework, but gives operational staff the user interface they require.
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Guest Access Scenarios
The following figure shows a high-level representation of a typical guest access scenario.

Figure 1 Guest Access Using ClearPass Guest

In this scenario, guests are using their own mobile devices to access a corporate wireless network. Because
access to the network is restricted, guests must first obtain a username and password. A guest account may be
provisioned by a corporate operator such as a receptionist, who can then give the guest a print receipt that
shows their username and password for the network.

When guests use self-registration, as might be the case for a network offering public access, the process is
broadly similar but does not require a corporate operator to create the guest account. The username and
password for a self-provisioned guest account may be delivered directly to the guest’s Web browser, or sent via
SMS or email.
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Reference Network Diagram
The following figure shows the network connections and protocols used by ClearPass Guest.

Figure 2 Reference Network Diagram for Guest Access

The network administrator, operators, and guests may use different network interfaces to access the guest
management features. The exact topology of the network and the connections made to it will depend on the
type of network access offered to guests and the geographical layout of the access points.
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Key Interactions
The following figure shows the key interactions between ClearPass Guest and the people and other
components involved in providing guest access.

Figure 3 Interactions Involved in Guest Access

ClearPass Guest is part of your network’s core infrastructure and manages guest access to the network.

NAS devices, such as wireless access points and wired switches on the edge of the network, use the RADIUS
protocol to ask ClearPass Policy Manager to authenticate the username and password provided by a guest
logging in to the network. If authentication is successful, the guest is then authorized to access the network.

Roles are assigned to a guest as part of the context ClearPass Policy Manager uses to apply its policies. RADIUS
attributes that define a role’s access permissions are contained within Policy Manager’s Enforcement Profile.
Additional features such as role mapping for ClearPass Guest can be performed in ClearPass Policy Manager.

The network usage of authorized guests is monitored by the NAS and reported in summary form to ClearPass
Policy Manager using RADIUS accounting, which allows administrators to generate network reports in
ClearPass Insight.
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AAA Framework
ClearPass Guest is built on the industry standard AAA framework, which consists of authentication,
authorization, and accounting components.

The following figure shows how the different components of this framework are employed in a guest access
scenario.

Figure 4 Sequence Diagram for Network Access Using AAA

In the standard AAA framework, network access is provided to a user according to the following process:

l The user connects to the network by associating with a local access point [1].

l A landing page is displayed to the user [2] which allows them to log in to the NAS [3], [4] using the login
name and password of their guest account.

l The NAS authenticates the user with the RADIUS protocol [5].

l ClearPass Policy Manager determines whether the user is authorized, and, if so, returns vendor-specific
attributes [6] that are used to configure the NAS based on the user’s role and other policies [7].
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l If the user’s access is granted, the NAS permits the guest access to the network based on the settings
provided by the ClearPass Policy Manager server.

l The NAS reports details about the user’s session to the ClearPass Policy Manager server using RADIUS
accounting messages [8].

l After the user’s session times out [9], the NAS will return the user to an unauthorized state and finalize the
details of the user’s session with an accounting update [10].

Licenses
Access to ClearPass Guest is included with the ClearPass Platform License and Access License. License
management is available through the user interface at Policy Manager > Administration > Server
Manager > Licensing. License usage counts are computed every 15 minutes, and the count on the
Licensing page is updated accordingly.

The Access License handles authentications on the ClearPass appliance. It is based on actual current usage —
that is, each user or device consumes an Access License during an active session — and is not associated with
an appliance. The Access License is available as either a perpetual license, or as a one year, three year, or five
year subscription license. The minimum number of Onboard licenses is 100.

Onboard Application Licenses may be added as needed. Each Onboard Application License is computed based
on the number of users with Onboard-generated device certificates. It is available as either a perpetual license,
or as a one year, three year, or five year subscription license. The minimum number of Onboard licenses is 100.

Key Features
Refer to the table below for a list of key features and a cross-reference to the relevant section of this User
Guide.

Feature Reference

Guest Access

Web server providing content delivery for guests "Managing Content: Private
Files and Public Files" on page
277

Self-registration "Customizing Self-
Registration" on page 348

Guest Management

Create and manage guest accounts, individually or in groups "Using Standard Guest
Management Features" on
page 44

Manage active RADIUS sessions using RFC 3576 Dynamic Authorization support "Active Sessions
Management" on page 38

Import and export guest accounts "Importing Guest Accounts"
on page 63

Table 3: List of Key Features
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Feature Reference

Create self-registration forms "Creating a Self-Registration
Page" on page 355

Configure a self-service portal for guests "Self-Service Portal
Properties" on page 394

Local printer, SMS or email delivery of account receipts "Editing Guest Receipt Page
Properties" on page 364

Guest Account Features

Independent activation time, expiration time, and maximum usage time "Business Logic for Account
Creation" on page 287

Define unlimited custom fields "Customizing Fields" on page
337

Username up to 64 characters "GuestManager Standard
Fields" on page 738

Customization Features

Create new fields and forms for guest management "Customizing Forms" on page
297

Use built-in data validation to implement guest survey forms "Form Validation Properties"
on page 319

Create print templates for guest account receipts "Editing Guest Receipt Page
Properties" on page 364

Administrative Management Features

Operators defined and authenticated locally "Local Operator
Authentication" on page 694

Operators authenticated via LDAP "External Operator
Authentication" on page 694

Role based access control for operators "Operator Profiles" on page
684

Plugin-based application features, automatically updated by ClearPass Policy
Manager

"Plugin Manager" on page
648

User Interface Features

Context-sensitive help with searchable online documentation "Documentation and User
Assistance" on page 32
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Guest Management Terminology
The following table describes the common terms used in ClearPass Guest and this guide.

Term Explanation

Accounting Process of recording summary information about network access by users and
devices.

Authentication Verification of a user’s credentials; typically a username and password.

Authorization Controls the type of access that an authenticated user is permitted to have.

Captive Portal Implemented by a Network Access Server to restrict network access to authorized
users only.

Field In a user interface or database, a single item of information about a user account.

Form In a user interface, a collection of editable fields displayed to an operator.

Network Access Server Device that provides network access to users, such as a wireless access point,
network switch, or dial-in terminal server. When a user connects to the NAS
device, a RADIUS access request is generated by the NAS.

Operator Profile Characteristics assigned to a class of operators, such as the permissions granted
to those operators.

Operator/Operator Login User of ClearPass Guest to create guest accounts or perform system
configuration.

Print Template Formatted template used to generate guest account receipts.

Role Type of access being granted to guests. You can define multiple roles. Such roles
could include employee, guest, team member, or press.

Sponsor Operator

User Database Database listing the guest accounts in ClearPass Guest.

View In a user interface, a table displaying data, such as guest account information, to
operators.

Guest Someone who is permitted to access the Internet through your Network Access
Server.

Guest Account Settings for a guest stored in the user database, including username, password,
and other fields.

Web Login/NAS Login Login page displayed to a guest user.

Table 4: Common Terms

ClearPass Guest Deployment Process
As part of your preparations for deploying a guest management solution, you should consider the following
areas:

l Management decisions about security policy

l Decisions about the day-to-day operation of guest management
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l Technical decisions related to network provisioning

Operational Concerns
When deploying a guest management solution, you should consider these operational concerns:

l Who is going to be responsible for managing guest accounts? What privileges will the guest account
manager have? Will this person only create guest accounts or will this person also be permitted access to
reports?

l Do you want guests to be able to self-provision their own network access? What settings should be applied
to self-provisioned guest accounts?

l How will operator logins be provisioned? Should operators be authenticated against an LDAP server?

l Who will manage reporting of guest access? What are the reports of interest? Are any custom reports
needed?

Network Provisioning
ClearPass Guest requires provisioning the following:

l Physical location – rack space, power and cooling requirements; or deployment using virtualization

l Network connectivity – VLAN selection, IP address, and hostname

l Security infrastructure – SSL certificate

Site Preparation Checklist
The following is a checklist of the items that should be considered when setting up ClearPass Guest.

ü Policy Decision

Security Policy

Segregated guest accounts?

Type of network access?

Time of day access?

Bandwidth allocation to guests?

Prioritization of traffic?

Different guest roles?

IP address ranges for operators?

Enforce access via HTTPS?

Operational Concerns

Who will manage guest accounts?

Guest account self provisioning?

Table 5: Site Preparation Checklist
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ü Policy Decision

What privileges will the guest managers have?

Who will be responsible for printing reports?

Network Management Policy

Password format for guest accounts?

Shared secret format?

Operator provisioning?

Network Provisioning

Physical location?

Network connectivity?

Security infrastructure?

Security Policy Considerations
To ensure that your network remains secure, decisions have to be made regarding guest access:

l Do you wish to segregate guest access? Do you want a different VLAN, or different physical network
infrastructure to be used by your guests?

l What resources are you going to make available to guests (for example, type of network access; permitted
times of day; bandwidth allocation)?

l Will guest access be separated into different roles? If so, what roles are needed?

l How will you prioritize traffic on the network to differentiate quality of service for guest accounts and non-
guest accounts?

l What will be the password format for guest accounts? Will you be changing this format on a regular basis?

l What requirements will you place on the shared secret, between NAS and the RADIUS server to ensure
network security is not compromised?

l What IP address ranges will operators be using to access the server?

l Should HTTPS be required in order to access the guest management server?

AirGroup Deployment Process
AirGroup allows users to register their personal mobile devices on the local network and define a group of
friends or associates who are allowed to share them. You use ClearPass Guest to define AirGroup
administrators and operators. AirGroup administrators can then use ClearPass Guest to register and manage
an organization’s shared devices and configure access according to username, role, location, or time. AirGroup
operators (end users) can use ClearPass Guest to register their personal devices and define the group who can
share them.

Table 6 summarizes the steps for configuring Aruba AirGroup functionality in ClearPass Guest. Details for these
steps are provided in the relevant sections of this Guide. This table does not include the configuration steps
performed in ClearPass Policy Manager or the ArubaOS controller. For complete AirGroup deployment
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information, refer to the AirGroup sections in the ArubaOS User Guide and the ClearPass Policy Manager
documentation.

Step Section in this Guide

Create AirGroup administrators "Creating a New Operator" on page 694

Create AirGroup operators

Configure an operator’s device limit "Configuring AirGroup Operator Device Limit" on page 693

Configure an AirGroup controller "AirGroup Controllers" on page 549

Enable support for dynamic notifications "Configuring AirGroup Services" on page 651

To authenticate AirGroup users via LDAP:
Define the LDAP server
Define appropriate translation rules

"External Operator Authentication" on page 694
"LDAP Translation Rules" on page 703

AirGroup administrator: Register devices or groups
of devices

"AirGroup Device Registration" on page 82

AirGroup operator: Register personal devices

(Optional) Configure device registration form with
drop-down lists for existing locations and roles

"Customizing AirGroup Registration Forms" on page 345

Set up time-based sharing "About AirGroup Time-Based Sharing" on page 92

Table 6: Summary of AirGroup Configuration Steps in ClearPass Guest

Documentation and User Assistance
This section describes the variety of user assistance available for ClearPass Guest.

Navigation
You can use the Menu in the upper corner of the ClearPass user interface to move between the Policy
Manager, Guest, Onboard, or Insight modules, to open the context-sensitive help in a new tab, to access
Support, or to log out.
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In the online help, you can use the Search box in the top right corner to search for the information you need.

Type in keywords related to your search and click the Search button to display a list of matches. The most
relevant matches will be displayed first. Words may be excluded from the search by typing a minus sign directly
before the word to exclude (for example, -exclude). Exact phrase matches may also be searched for by
enclosing the phrase in double quotes (for example, “word phrase”).

If your browser has pop-up blocking set, you might need to allow the online help before it can be displayed.

User Guide and Context-Sensitive Online Help
This ClearPass Guest User Guide provides complete information for all ClearPass Guest features. The following
quick links may be useful in getting started.

For information about... Refer to...

What guest management is and how it works "About ClearPass Guest" on page 22

Using the guest management features "Using Standard Guest Management Features" on
page 44

Role-based access control for operators "Operator Profiles" on page 684

Setting up LDAP authentication for operators "External Operator Authentication" on page 694

Guest self-provisioning features "Self Provisioned Guest Access" on page 38

Dynamic Authorization extensions "RFC 3576 Dynamic Authorization" on page 40

Table 7: Quick Links
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For information about... Refer to...

SMS receipts for guest accounts "SMS Services" on page 462

Email receipts for guest accounts "Email Receipts and SMTP Services" on page 444

Network administration of the appliance "Administration" on page 548

Field Help
ClearPass Guest has field help in every form. The field help provides a short summary of the purpose of the
field at the point you need it most. In many cases this is sufficient to use the application without further
assistance or training.

Quick Help

In list views, click the Quick Help tab located at the top left of the list to display additional information
about the list you are viewing and the actions that are available within the list.

On some forms and views, the Quick Help icon may also be used to provide additional detail about a field.

If You Need More Assistance
If you encounter a problem using ClearPass Guest, your first step should be to consult the appropriate section
in this User Guide.

If you cannot find an answer here, the next step is to contact your reseller. The reseller can usually provide you
with the answer or obtain a solution to your problem.

If you still need information, you can click Menu > Support for contact information, or see "Contacting
Support" on page 21.

Use of Cookies
Cookies are small text files that are placed on a user’s computer by Web sites the user visits. They are widely
used in order to make Web sites work, or work more efficiently, as well as to provide information to the owners
of a site. Session cookies are temporary cookies that last only for the duration of one user session.
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When a user registers or logs in via an Aruba captive portal, Aruba uses session cookies solely to remember
between clicks who a guest or operator is. Aruba uses this information in a way that does not identify any user-
specific information, and does not make any attempt to find out the identities of those using its ClearPass
products. Aruba does not associate any data gathered by the cookie with any personally identifiable
information (PII) from any source. Aruba uses session cookies only during the user’s active session and does
not store any permanent cookies on a user’s computer. Session cookies are deleted when the user closes
his/her Web browser.
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Chapter 3
Guest Manager

The ability to easily create and manage guest accounts is the primary function of ClearPass Guest. The Guest
Manager module provides complete control over the user account creation process.

Guest Manager features for managing guest accounts let you:

l View and manage active sessions

l Create single or multiple guest accounts and receipts

l Create new MAC devices

l Bulk edit accounts

l Export a list of accounts

l Import new accounts from a text file

l View guest accounts and edit individual or multiple guest accounts

l View MAC devices and edit individual or multiple devices

Many features can also be customized. For information on customizing Guest Manager settings, forms and
views, guest self-registrations, and print templates, see "Configuration" on page 274.

Accessing Guest Manager
To access ClearPass Guest’s guest management features, click the Guest link in the left navigation.
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About Guest Management Processes
There are two major ways to manage guest access – either by your operators provisioning guest accounts, or
by the guests self-provisioning their own accounts. Both of these processes are described in this chapter.

Sponsored Guest Access
The following figure shows the process of sponsored guest access.

Figure 5 Sponsored Guest Access with Guest Created by Operator

The operator creates the guest accounts and generates a receipt for the account.

The guest logs on to the Network Access Server (NAS) using the credentials provided on her receipt. The NAS
authenticates and authorizes the guest’s login in ClearPass Guest. After authorization, the guest is able to
access the network.
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Self Provisioned Guest Access
Self-provisioned access is similar to sponsored guest access, but there is no need for an operator to create the
account or to print the receipt. The following figure shows the process of self-provisioned guest access.

Figure 6 Guest Access When Guest is Self-Provisioned

The guest logs on to the Network Access Server (NAS), which captures the guest and redirects them to a captive
portal login page. From the login page, guests without an account can browse to the self-registration page,
where the guest creates a new account. At the conclusion of the registration process, the guest is automatically
redirected to the NAS to log in.

The guest can print or download a receipt, or have the receipt information delivered by SMS or email.

The NAS performs authentication and authorization for the guest in ClearPass Guest. After authorization, the
guest is able to access the network.

See "Customizing Self-Registration" on page 348 for details on creating and managing self-registration pages.

Active Sessions Management

The RADIUS server maintains a list of active guest sessions. If your NAS equipment has RFC 3576 support, the
RADIUS Dynamic Authorization extensions allow you to disconnect or modify an active session. For more
information, see "RFC 3576 Dynamic Authorization" on page 40.

To view and manage active sessions for the RADIUS server, go to Guest > Active Sessions. The Active
Sessions list opens. Click a session’s row in the list for more options. You can use this list to modify, disconnect
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or reauthorize, or send SMS notifications for active guest sessions; manage multiple sessions; or customize the
list to include additional fields.

Figure 7 The Active Sessions List View

Field Description

Show
Details

Lets you view details for an active session.

Disconnect Disconnects an active session. A message is displayed to show that the disconnect is in progress
and to acknowledge when it is complete.

Reauthorize Reauthorizes a session that was disconnected. The Reauthorize Session form opens. Click the
Reauthorize Session button on the form.

Manage To disconnect multiple sessions, click tis tab. The form expands to include the Manage Multiple

Table 8: Active Sessions List View
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Field Description

Multiple Sessions form. For more information, see "Disconnecting Multiple Active Sessions " on page 42.

List
Accounts

To view and work with the guest accounts associated with a session, click the session’s row in the
list, and then click its link. The Guest Manager Accounts view opens. See "Managing Single Guest
Accounts " on page 67 for more information.

Filter To display only sessions that meet certain criteria, click this tab. For more information, see "Filtering
the List of Active Sessions" on page 41.

SMS To send SMS notifications to guests, click this tab. For more information, see "Sending Multiple SMS
Alerts " on page 42.

More
Options

To include additional columns in the Active Sessions list, or delete columns from it, click this tab.
The form expands to include the Choose Columns options. You can filter for fields that have been
configured for quick search.

Paging Con-
trol

You can use the paging control at the bottom of the list to jump forwards or backwards by one page,
or to the first or last page of the list. You can also click an individual page number to jump directly to
that page.

Table 8: Active Sessions List View(Continued)

Session States
A session may be in one of three possible states:

l Active—An active session is one for which the RADIUS server has received an accounting start message
and has not received a stop message, which indicates that service is being provided by a NAS on behalf of an
authorized client.

While a session is in progress, the NAS sends interim accounting update messages to the RADIUS server.
This maintains up-to-date traffic statistics and keeps the session active. The frequency of the accounting
update messages is configurable in the RADIUS server.

l Stale—If an accounting stop message is never sent for a session—for example, if the guest does not log
out— that session will remain open. After 24 hours without an accounting update indicating session traffic,
the session is considered ‘stale’ and is not counted towards the active sessions limit for a guest account. To
ensure that accounting statistics are correct, you should check the list for stale sessions and close them.

l Closed—A session ends when the guest logs out or if the session is disconnected. When a session is
explicitly ended in either of these ways, the NAS sends an accounting stop message to the RADIUS server.
This closes the session. No further accounting updates are possible for a closed session.

RFC 3576 Dynamic Authorization
Dynamic Authorization describes the ability to make changes to a guest account’s session while it is in progress.
This includes disconnecting a session, or updating some aspect of the authorization for the session.

The Active Sessions page provides two Dynamic Authorization capabilities that apply to currently active
sessions:

l Disconnect causes a Disconnect-Request message to be sent to the NAS for an active session,
requesting that the NAS terminate the session immediately. The NAS should respond with a Disconnect-ACK
message if the session was terminated or Disconnect-NAK if the session was not terminated.
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l Reauthorize causes a Disconnect-Request message to be sent to the NAS for an active session. This
message will contain a Service-Type attribute with the value ‘Authorize Only’. The NAS should respond with a
Disconnect-NAK message, and should then reauthorize the session by sending an Access-Request message
to the RADIUS server. The RADIUS server’s response will contain the current authorization details for the
guest account, which will then update the corresponding properties in the NAS session.

If the NAS does not support RFC 3576, attempts to perform Dynamic Authorization will time out and result in a
‘No response from NAS’ error message.

Refer to RFC 3576 for more details about Dynamic Authorization extensions to the RADIUS protocol.

Filtering the List of Active Sessions

On the Guest > Active Sessions list, you can use the Filter tab to narrow the search parameters and
quickly find all matching sessions.

Figure 8 The Filter Settings Form for Active Sessions

Enter a username or IP address in the Filter field. Additional fields can be included in the search if the “Include
values when performing a quick search” option was selected for the field within the view. To control this
option, use the Choose Columns command link on the More Options tab.

You may enter a simple substring to match a portion of the username or any other fields that are configured
for search, and you can include the following operators:

Operator Meaning Additional Information

= is equal to You may search for multiple values when using the
equality (=) or inequality !=) operators. To specify multiple
values, list them separated by the pipe character ( | ).

For example, specifying the filter "role_id=2|3, custom_
field=Value" restricts the accounts displayed to those with
role IDs 2 and 3 (Guest and Employee), and with the field
named "custom_field" set to "Value".

!= is not equal to

> is greater than

>= is greater than or equal to

< is less than

<= is less than or equal to

~ matches the regular expression

!~ does not match the regular
expression

Table 9: Operators Supported in Filters
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To restore the default view, click the Clear Filter link.

Click the Apply Filter button to save your changes and update the view, or click the Reset button to
remove the filter and return to the default view.

Disconnecting Multiple Active Sessions
To disconnect multiple sessions:

1. On the Guest > Active Sessions list view, click the Manage Multiple tab. The Manage Multiple
Sessions form opens.

Figure 9 The Manage Multiple Sessions Form

2. To close all active sessions, leave the Start Time and End Time fields empty and click Make Changes. All
active sessions are closed and are removed from the Active Sessions list.

To disconnect sessions in a specified time range:

1. To close all sessions that started after a particular time, click the button in the Start Time row. The calendar
picker opens. Use the calendar to specify the year, month, and day, and click the numbers in the Time fields
to increment the hours and minutes. All sessions that started after the specified date and time will be
disconnected.

2. To close all sessions that started before a particular time, click the button in the End Time row. The calendar
picker opens. Use the calendar to specify the year, month, and day, and click the numbers in the Time fields
to increment the hours and minutes. All sessions that started before the specified date and time will be
disconnected.

3. Click Make Changes. The specified sessions are closed and are removed from the Active Sessions list.

Sending Multiple SMS Alerts
The SMS tab on the Active Sessions page lets you send an SMS alert message to all active sessions that have a
valid phone number. An SMS alert during an active session can be used to send a group of guests information
you might want them to have immediately—for example, a special offer that will only be available for an hour,
a change in a meeting’s schedule or location, or a public safety announcement.

To create an SMS message:

1. Click the SMS tab on the Active Sessions page. The Send SMS Notification form opens.
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Figure 10 The Send SMS Notification Form

2. Use the filter to specify the group of addresses that should receive the message. See "Filtering the List of
Active Sessions" on page 41. Only accounts with valid phone numbers can be sent SMS alerts.

3. Enter the message in the Message text box. Messages may contain up to 160 characters.

4. Click Send.

About SMS Guest Account Receipts

You can send SMS receipts for guest accounts that are created using either sponsored guest access or self-
provisioned guest access. This is convenient in situations where the guest might not be physically present to
receive a printed receipt.

ClearPass Guest may be configured to automatically send SMS receipts to guests, or to send receipts only on
demand.

To manually send an SMS receipt:

1. Go to the Guest > Manage Accounts and click to expand the row of the guest to whom you want to send
a receipt.

2. Click Print to display the Updated Account Details view, and then click the Send SMS receipt link. The
SMS Receipt form opens.

3. Use the fields on the SMS Receipt form to enter the service to use, the recipient’s mobile phone number,
and the message text.
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Figure 11 The SMS Receipt Form

When using guest self-registration, SMS Delivery options are available for the receipt page actions. See "Editing
Receipt Actions" on page 365 for full details. For more information on SMS services, see "SMS Services" on page
462.

Using Standard Guest Management Features
This section describes:

l "Creating a Guest Account " on page 44

l "Creating a Guest Account Receipt " on page 47

l "Creating a Device" on page 48

l "Creating Multiple Guest Accounts" on page 53

l "Creating Multiple Guest Account Receipts" on page 55

l "Creating a Single Password for Multiple Accounts " on page 57

l "Managing Single Guest Accounts " on page 67

l "Managing Multiple Guest Accounts " on page 80

l "Exporting Guest Account Information " on page 61

l "Importing Guest Accounts" on page 63

l "Managing Single Guest Accounts " on page 67

l "Managing Devices " on page 73

l "Managing Multiple Guest Accounts " on page 80

To customize self-registrations, please see Configuration on page 274.

Creating a Guest Account
To create a new account, go to Guest > Create Account, or click the Create New Guest Account command
link on the Guest > Start Here page. The Create New Guest Account form opens.
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The Create New Guest Account form (create_user) can be customized by adding new fields, or modifying or
removing the existing fields. See "Customizing Self-Registration" on page 348 for details about the customization
process. The default settings for this form are described below.

Figure 12 The Create New Guest Account Form

Field Description

Guest's
Name

(Required) Name of the guest user for this account.

Company
Name

(Required) Name of the organization the guest user belongs to.

Email
Address

(Required) The guest user's email address. This email address will be the guest's username.

Account
Activation

Specifies the activation time for the account. The guest's account cannot be used before the
activation time. Options include:

Table 10: The Create New Guest Account Form
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Field Description

l Now
l Disable account
l Tomorrow
l Next Monday
l 1 hour from now
l 1 day from now
l 1 week from now
l Activate at specified time...

Activation
Time

Specifies the date and time to activate the account. Click the button to open the calendar picker. In
the calendar, use the arrows to select the year and month, click the numbers in the Time fields to
increment the hours and minutes, and then click a day to select the date. If no selection is made, the
account will be enabled immediately.

Account
Expiration

Lets you change the expiration setting. The guest's account cannot be used after the expiration
time. Options include:
l Account will not expire
l Now
l Tonight
l Friday night
l 1 hour from now
l 1 day from now
l 1 week from now
l 30 days from now
l 90 days from now
l 180 days from now
l 1 year from now
l Account expires after...
l Account expires at specified time...

Expires
After

Specifies the amount of time after which the account will expire. Options include increments of one
to twenty hours and one to fourteen days.

Expiration
Time

Specifies the date and time when the account will expire. Click the button to open the calendar
picker. In the calendar, use the arrows to select the year and month, click the numbers in the Time
fields to increment the hours and minutes, and then click a day to select the date. If no selection is
made, the account will not expire.

Account
Role

(Required) Specify the type of account the guest should have. Options include:
l Contractor
l Employee
l Guest
If you are editing an account’s role, see "Changing a Guest Account Role" on page 47.

Password Displays the random password created for each guest account. The password also available on the
guest account receipt.

Notes You may enter notes about this guest account.

Terms of
Use

(Required) You must select the check box in this field in order to create the account.

Create Creates the guest's account.
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Changing a Guest Account Role
If you are changing a guest account’s role, you must also configure change of authorization (CoA) requests to
handle the change correctly. This ensures that the appropriate CoA requests are triggered for active sessions.
The following steps are performed in ClearPass Policy Manager:

1. Go to Policy Manager > Configuration > Enforcement > Profiles > Add.

2. On the Profile tab, open the the Template drop-down list and select RADIUS Change of Authorization
(CoA).

3. In the Name field, the name you enter for the profile must include the exact role name in square brackets.
For example, for the role “[Guest]”, the profile name might be “My Company [Guest] CoA”.

4. On the Attributes tab, open the Select RADIUS CoA Template drop-down list and select Aruba -
Change-User-Role.

5. Click a row and add an attribute with the Type as Radius:IETF. For the Value enter the role name, but
without the square brackets this time.

Creating a Guest Account Receipt
After you click the Create button on the Create New Guest Account form, the details for that account are
displayed.

Figure 13 The Account Details View

To print a receipt for the guest, select an appropriate template from the Open print window using
template… list. A new Web browser window opens and the browser’s Print dialog box is displayed.

Click the Send SMS receipt link to send a guest account receipt via text message. Use the SMS Receipt
form to enter the mobile telephone number to which the receipt should be sent.

Sending SMS receipts requires the SMS Services plugin. If the administrator has enabled automatic SMS, and
the guest’s phone number was typed into the Create New Guest Account form, an SMS message will be sent
automatically. A message is displayed on the account receipt page after an SMS message has been sent.

Click the Send email receipt link to send an email copy of the guest account receipt. Use the Email Receipt
form to enter the email address to which the receipt should be sent. You can also specify the subject line for
the email message. If the administrator has enabled automatic email for guest account receipts, and the guest’s
email address was typed into the Create New Guest Account form, an email receipt will be sent
automatically. A message is displayed on the account receipt page after an email has been sent.

Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2176



Creating a Device
Device accounts may be created in three ways:

l Manually in ClearPass Guest using the Create New Device form

l During a guest self-registration by a MAC parameter passed in the redirect URL, if the process is configured
to create a MAC device account

l During a guest self-registration by a MAC parameter passed in the redirect URL, creating a parallel account
paired with the guest account

This section includes:

l "Creating Devices Manually in ClearPass Guest" on page 48

l "Creating Devices During Self-Registration - MAC Only" on page 51

l "Creating Devices During Self-Registration - Paired Accounts" on page 52

Creating Devices Manually in ClearPass Guest
If you have the MAC address, you can create a new device manually. To create a new device, go to Guest
> Create Device, or go to Guest > Manage Devices and then click the Create link.

The Create New Device form opens.

ClearPass Guest 6.7 | User Guide Guest Manager | 48
Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2177



49 | Guest Manager ClearPass Guest 6.7 | User Guide

Figure 14 The New Device Form

Field Description

MAC Address (Required) Enter the device's MAC address.

Device Name (Required) Enter the name for the device.
If you need to modify the configuration for expected separator format or case, go to
Administration > Plugin Manager > Manage Plugins and click the Configuration link
for the MAC Authentication Plugin.

AirGroup Enables AirGroup for the device. Configuration options are added to the form.

Ownership Specifies whether device ownership should be personal or shared. Personal devices are
automatically shared with the owner's other devices.

Shared With Usernames of people who can share this device. Enter usernames as a comma-separated
list. To make the device available to all users, leave this field blank.
Each username may not exceed 64 characters. A maximum of 100 usernames may be
entered. The maximum character limit for the list is 1000 characters (including comma

Table 11: New Device
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Field Description

separators).

Shared Locations Locations where the device can be shared. When you type a location name in the Shared
Locations field and press the Enter key, the location appears as a "tag" and is created in the
system when the form is saved.
Each location name may not exceed 64 characters. A maximum of 100 location names may
be entered. The maximum character limit for the list is 1000 characters (including comma
separators).

Shared Roles User roles that can share this device. When you type a role name in the Shared Roles field
and press the Enter key, the role appears as a "tag" and is created in the system when the
form is saved.
Each role name may not exceed 64 characters. A maximum of 100 role names may be
entered. The maximum character limit for the list is 1000 characters (including comma
separators).

Shared Groups User groups that can share this device. These will be available in the Shared Groups field
for users to choose from when they share a device.
When you type a name for the group in the Group Names field and press the Enter key, the
group appears as a "tag" and is created in the system when the form is saved.
Each group name may not exceed 64 characters. A maximum of 32 group names may be
entered. The maximum character limit for the list is 320 characters (including comma
separators).
This feature requires AOS 6.4 or later.

Time Sharing Time-based sharing rules for this device. For more information, see "About AirGroup Time-
Based Sharing" on page 92.

Syntax Opens the help topic "AirGroup Time-Based Sharing Syntax Examples" on page 88

Account Activation Specifies when the account will be activated. Options include: Activate the account
immediately, at a preset interval of hours or days, at a specified time, or leave the account
disabled.
If you choose Activate at a specified time, the ActivationTime row is added to the form.
Click the button to open the calendar picker. In the calendar, use the arrows to select the
year and month, click the numbers in the Time fields to increment the hours and minutes,
and then click a day to select the date.

Account Expiration Specifies when the account will expire. Options include: Never expire, expire at a preset
interval of hours or days, or expire at a specified time.
l If you choose any time in the future, the Expire Action row is added to the form.

Indicate the expiration action for the account—either delete, delete and log out, disable,
or disable and log out. The action will be applied at the time set in the Account Expiration
row.

l If you choose Account expires after, the ExpiresAfter row is added to the form.
Choose an interval of hours, days, or weeks. The maximum is two weeks.

l If you choose Account Expires at a specified time, the ExpirationTime row is added
to the form. In the calendar picker, use the arrows to select the year and month, click the
numbers in the Time fields to increment the hours and minutes, and then click a day to
select the date.
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Field Description

Account Role Assigns the guest’s role.

Terms of Use Click the terms of use link and read the agreement, and then mark the check box to agree
to the terms.

Create Device Commits your changes and creates the device. The Account Details and print options are
displayed. For more information, see "Printing Device Details" on page 79.

Creating Devices During Self-Registration - MAC Only

This section describes how to configure a guest self-registration so that it creates a MAC device account. After
the guest is registered, future authentication can take place without the need for the guest to enter their
credentials. A registration can be converted to create a MAC device instead of standard guest credentials.

This requires a vendor to pass a MAC parameter in the redirect URL. ClearPass Guest does not support
querying the controller or DHCP servers for the client's MAC based on IP.

To edit the registration form fields:

1. Go to Configuration > Pages > Forms and Views.

2. In the guest_register row, click the Edit Fields link. The Customize Form Fields page opens.

3. If you do not see mac or mac_auth in the list, click the Customize fields link above the list.

4. Click the Edit link in the field’s row. In the Edit Field form, edit the following registration form fields:

l Add or enable mac

n UI: Hidden field

n Field Required: checked

n Validator: IsValidMacAddress

l Add or enable mac_auth

n UI: Hidden field

l Any other expiration options, role choice, surveys, and so on can be entered as usual.
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Figure 15 Modify fields

5. Edit the following receipt form fields:

l Edit username to be a Hidden field

l Edit password to be a Hidden field

6. Adjust any headers or footers as needed.

When the guest registers, they should be able to still log in via the Log In button. The MAC will be passed as
their username and password via standard captive portal means.

The account will only be visible on the List Devices page.

If the guest logs out and reconnects, they should be immediately logged in without being redirected to the
captive portal page.

Creating Devices During Self-Registration - Paired Accounts

Paired accounts is a means to create a standard guest account with credentials, but to have a MAC account
created in parallel that is directly tied to the guest account. These accounts share the same role, expiration and
other properties.

This requires a vendor passing a mac parameter in the redirect URL. ClearPass Guest does not support
querying the controller or DHCP servers for the client's MAC based on IP.

To edit the registration form fields:

1. Go to Configuration > Pages > Forms and Views.

2. In the guest_register row, click the Edit Fields link. The Customize Form Fields page opens.

3. If you do not see mac or mac_auth_pair in the list, click the Customize fields link above the list.

4. Click the Edit link in the field’s row. In the Define Custom Field form, edit the following registration form
fields:

l Add or enable mac

n UI: Hidden field

n Field Required: optional
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n Validator: IsValidMacAddress

l Add or enable mac_auth_pair

n UI: Hidden field

n Initial Value: -1

l Any other expiration options, role choice, surveys and so on can be entered as usual.

You will see an entry under both List Accounts and List Devices. Each should have a View Pair action that
cross-links the two.

If you delete the base account, all of its pairings will also be deleted. If RFC-3576 has been configured, all pairs will be
logged out.

Creating Multiple Guest Accounts
The Create Multiple Guest Accounts form is used to create a group of guest accounts.

To create multiple accounts, go to Guest > Create Multiple, or click the Create Multiple Guest Accounts
command link on the Guest > Start Here page. The Create Multiple Guest Accounts form opens.

The Create Multiple Guest Accounts form (create_multi) can be customized by adding new fields, or modifying or
removing the existing fields. See "Customizing Self-Registration" on page 348 for details about the customization
process. The default settings for this form are described below.

Figure 16 The Create Multiple Guest Accounts Form
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Field Description

Number of
Accounts

(Required) Enter the number of accounts to create.

Account
Activation

Activation time for the accounts. The guests' accounts cannot be used before the activation time.
Options include:
l Now
l Disable account
l Tomorrow
l Next Monday
l 1 hour from now
l 1 day from now
l 1 week from now
l Activate at specified time...

Activation
Time

Specifies the date and time to activate the accounts. Click the button to open the calendar picker. In
the calendar, use the arrows to select the year and month, click the numbers in the Time fields to
increment the hours and minutes, and then click a day to select the date. If no selection is made, the
accounts will be enabled immediately.

Account
Expiration

Specifies the expiration time for the accounts. The guests' accounts cannot be used after the
expiration time. Options include:
l Account will not expire
l Now
l Tonight
l Friday night
l 1 hour from now
l 1 day from now
l 1 week from now
l 30 days from now
l 90 days from now
l 180 days from now
l 1 year from now
l Account expires after...
l Account expires at specified time...

Expires
After

Specifies an amount of time after which the accounts will expire. Options include intervals of hours,
days, or weeks.

Expiration
Time

Specifies the date and time the accounts will expire. Click the button to open the calendar picker. In
the calendar, use the arrows to select the year and month, click the numbers in the Time fields to
increment the hours and minutes, and then click a day to select the date. If no selection is made, the
accounts will not expire.

Expire
Action

(Required) Specify the behavior of the expiration. Options include:
l Delete and log out at specified time
l Delete at specified time
l Disable and log out at specified time
l Disable at specified time
Be aware that a logout can only occur if the NAS is RFC-3576 compliant.

Table 12: The Create New Guest Account Form

ClearPass Guest 6.7 | User Guide Guest Manager | 54
Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2183



55 | Guest Manager ClearPass Guest 6.7 | User Guide

Field Description

Account
Role

(Required) Specify the type of account the guest should have. Options include:
l Contractor
l Employee
l Guest

Notes You may enter notes about these guest accounts.

Terms of
Use

(Required) You must select the check box in this field in order to create the accounts.

Create
Accounts

When your entries on the form are complete, click this button to create the accounts.

A random username and password will be created for each guest account. This is not displayed on this form,
but will be available on the guest account receipt. The default password length is six characters.

Creating Multiple Guest Account Receipts
After a group of guest accounts has been created, the details for the accounts are displayed.
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Figure 17 Account Details Displayed for Multiple Accounts

To print the receipts, select an appropriate template from the Open print window using template…
drop-down list. A new browser window opens with the Print dialog displayed.
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To download a copy of the receipt information in CSV format, click the Save list for scratch cards (CSV
file) link. You will be prompted to either open or save the spreadsheet (CSV) file. The fields available in the CSV
file are shown in Table 13.

Field Description

Number Sequential number of the guest account, starting at one.

Username Username for the guest account.

Password Password for the guest account. The default password length is six characters. The maximum
password length is 128 characters. ClearPass passwords can include letters, numbers, and the
following special characters:
! @ # $ % ^ & * ( ) < > [ ] { } ' : ~ ` / \ | " + , - . ; = ? _

Role The guest account’s role.

Activation
Time

Date and time at which the account will be activated, or N/A if there is no activation time.

Expiration
Time

Date and time at which the account will expire, or N/A if there is no activation time.

Lifetime Account lifetime in minutes, or N/A if the account does not have a lifetime specified.

Successful “Yes” if the account was created successfully, or “No” if there was an error creating the account.

Table 13: Fields in the CSV Spreadsheet File

Creating a Single Password for Multiple Accounts
You can create multiple accounts that have the same password. In order to do this, you first customize the
Create Multiple Guest Accounts form to include the Password field.

To include the Password field on the Create Multiple Guest Accounts form:

1. Go to Configuration > Pages > Forms & Views.

2. Click the create_multi row, and then click its Edit Fields link. The Customize Form Fields view opens,
showing a list of the fields included in the Create Multiple Guest Accounts form and their descriptions.

At this point, the Password field is not listed because the Create Multiple Guest Accounts form (create_
multi) has not yet been customized to include it. You will create it for the form in the next step.

3. Click on any field in the list to expand a row, and then click the Insert After link (you can modify this
placement later). The Form Field Editor form opens.

4. In the Field Name row, choose password from the drop-down list. The form displays configuration
options for the Password field.
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Figure 18 Password Field in Form Field Editor

Field Description

Field If selected, the password field will be included in the form.

Rank Lets you change the rank number to adjust the relative placement of the password field on the Create
Multiple Guest Accounts form. Fields are displayed in order of increasing rank.

User
Interface

Choose Password text field from the drop-down list.

Label (Optional) You may change the label that is displayed on the form.

Field
Required

If selected, the password field cannot be left blank.

Validator Select IsValidPassword in the drop-down list.

Save
Changes

Saves your changes. The Customize Form Fields view opens again, and the password field is now
included and can be edited.

Table 14: The Form Field Editor for the Password Field

To create multiple accounts that all use the same password:

1. Go to Guest > Create Multiple. The Create Multiple Guest Accounts form opens, and includes the
Guest Password field.
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Figure 19 The Create Guest Accounts Form with Guest Password Field Included

Field Description

Number
of
Accounts

(Required) Enter the number of accounts you wish to create.

Guest
Password

(Required) Enter the password that is to be used by all the accounts. The minimum password length is
six characters. The maximum password length is 128 characters. ClearPass passwords can include
letters, numbers, and the following special characters:
! @ # $ % ^ & * ( ) < > [ ] { } ' : ~ ` / \ | " + , - . ; = ? _

Account
Activation

Specify the activation time for the account. Options include:
l Now
l Disable account
l Tomorrow
l Next Monday
l 1 hour from now
l 1 day from now
l 1 week from now
l Activate at specified time...

Activation
Time

Specifies a date and time when the account will be activated. Click the button to open the calendar
picker. In the calendar, use the arrows to select the year and month, click the numbers in the Time
fields to increment the hours and minutes, and then click a day to select the date.

Account
Expiration

Specify the expiration time for the account. Options include:
l Account will not expire
l Now
l Tonight
l Friday night
l 1 hour from now
l 1 day from now
l 1 week from now

Table 15: The Create Guest Accounts Form
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Field Description

l 30 days from now
l 90 days from now
l 180 days from now
l 1 year from now
l Account expires after...
l Account expires at specified time...

Expires
After

Specifies the amount of time after which the account will expire. Options include increments of one to
twenty hours and one to fourteen days.

Expiration
Time

Specifies a date and time when the account will expire. Click the button to open the calendar picker. In
the calendar, use the arrows to select the year and month, click the numbers in the Time fields to
increment the hours and minutes, and then click a day to select the date.

Expire
Action

(Required) Specify the action to take when the account expires. Options include:
l Delete and log out at specified time
l Delete at specified time
l Disable and log out at specified time
l Disable at specified time

Account
Lifetime

Specifies the amount of time after the first login when the account will expire and be deleted. Options
include increments of days or weeks, up to one week.

Account
Role

(Required) Specify the role to assign to the account. Options include:
l Contractor
l Employee
l Guest

Notes You may enter additional information.

Create
Accounts

Saves your changes and creates the accounts. The Finished Creating Guest Accounts view opens.
The password and other account details are displayed for each account.
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Figure 20 Account Details Displayed for Multiple Accounts with Single Password

Exporting Guest Account Information
Guest account information may be exported to a file in one of several different formats.

To export a file with the current list of guest accounts, go to Guest > Export Accounts, or go to Guest
> Start Here and click the Export Guest Accounts command link. The Export Accounts page opens with
three options displayed. Click the appropriate command link to save a list of all guest accounts in comma-
separated values (CSV), tab-separated values (TSV), or XML format.
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The Export Accounts view (guest_export) may be customized by adding new fields, or by modifying or
removing the existing fields. See "Customizing Self-Registration" on page 348 for details about this
customization process.

About CSV and TSV Exports
In CSV and TSV format, the following default fields are included in the export:

l Number – Sequential number of the guest account in the exported data

l User ID – Numeric user ID of the guest account

l Username – Username for the guest account

l Role – Role for the guest account

l Activation – Date and time at which the guest account will be activated, or “N/A” if there is no activation
time

l Expiration – Date and time at which the guest account will expire, or “N/A” if there is no expiration time

l Lifetime – The guest account’s lifetime in minutes after login, or 0 if the account lifetime is not set

l Expire Action – Number specifying the action to take when the guest account expires (0 through 4)

About XML Exports

The default XML format consists of a <GuestUsers> element containing a <GuestUser> element for each
exported guest account. The numeric ID of the guest account is provided as the “id” attribute of the
<GuestUser> element. This format is compatible with the ClearPass Policy Manager XML format for guest
users.

The values for both standard and custom fields for guest accounts are exported as the contents of an XML tag,
where the tag has the same name as the guest account field.

An example XML export is given below:
<?xml version="1.0" encoding="UTF-8" standalone="true"?>

<MyContents xmlns="http://www.example.com/myapiDefs/1.0">

<MyHeader version="6.0" exportTime="Sun, 16 Dec 2012 16:36:03 PST"/>

<GuestUsers>

<GuestUser guestType="USER" enabled="true" sponsorName="55480025"

expiryTime="2012-12-04 13:39:25" startTime="1969-12-31 16:00:00"

password="08654361" name="55480025">

<GuestUserTags tagValue="Hotspot Services self-provisioned guest account

Source IP: 10.11.10.254 MAC: unknown Plan: Free Access x 1 Transaction

Amount: $0.00 Invoice Number: P-15 Transaction ID: " tagName="notes"/>

<GuestUserTags tagValue="2" tagName="[Role ID]"/>

<GuestUserTags tagValue="1" tagName="do_expire"/>

ClearPass Guest 6.7 | User Guide Guest Manager | 62
Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2191



63 | Guest Manager ClearPass Guest 6.7 | User Guide

<GuestUserTags tagValue="1" tagName="simultaneous_use"/>

<GuestUserTags tagValue="ff" tagName="Company Name"/>

<GuestUserTags tagValue="2012-12-04 12:39:14" tagName="Create Time"/>

<GuestUserTags tagValue="fff@df" tagName="Email"/>

<GuestUserTags tagValue="ff" tagName="first_name"/>

<GuestUserTags tagValue="plan0" tagName="hotspot_plan_id"/>

<GuestUserTags tagValue="Free Access" tagName="hotspot_plan_name"/>

<GuestUserTags tagValue="ff" tagName="last_name"/>

<GuestUserTags tagValue="ff ff" tagName="Guest Name"/>

<GuestUserTags tagValue="ff" tagName="zip"/>

</GuestUser>

Importing Guest Accounts
Guest accounts may be created from an existing list by uploading the list to ClearPass Guest.

To import a file with the current list of guest accounts, go to Guest > Import Accounts, or go to Guest
> Start Here and click the Import Guest Accounts command link. The Import Accounts page opens with
the first part of the form displayed, Upload User List.

The Upload User List form provides you with different options for importing guest account data. To
complete the form, you must either specify a file containing account information, or type or paste in the
account information.

Figure 21 The Upload User List Form for Importing Guest Accounts
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Field Description

Accoun
ts File

Lets you specify a file that contains a list of user accounts. Click the Choose File button in this row to
browse to the file and select it.

Accoun
ts Text

Lets you enter the account information directly. Type or paste the information in the text box in this row.

Advanc
ed

To display the advanced options, select the Show additional import options check box in this row.

Charac
ter Set

Specifies the character set encoding of the file.
ClearPass Guest uses the UTF-8 character set encoding internally to store guest account information. If
your accounts file is not encoded in UTF-8, the import might fail or produce unexpected results if non-
ASCII characters are used. To avoid this, you should specify what character set encoding you are using.

Import
Format

Specifies the file format of the file. Options include:
l Automatically detect format (This default option recognizes guest accounts exported from

ClearPass Policy Manager in XML format)
l XML
l Comma separated values
l Tab separated values
l Pipe (|) separated values
l Semicolon (;) separated values
l Colon (:) separated values
The format of the accounts file is automatically detected. You may specify a different encoding type if
automatic detection is not suitable for your data.

Header If your data contains a header row that specifies the field names, select the Force first row as header
row check box in this row. This option is only required if the header row is not automatically detected.

The header row must contain the mac_auth and mac columns. The mac_auth value should be set to
1, and the mac value should be the MAC address. Any other fields may also be included.

Next
Step

Uploads the account data and proceeds to the next step.

Table 16: The Import Accounts Form, Step 1: Upload User List

In step 2 of 3, ClearPass Guest determines the format of the uploaded account data and matches the
appropriate fields to the data. The first few records in the data are displayed, together with any automatically
detected field names.

In this example, the following data was used:
username,guest_name,password,expire_time

demo005,Demo five,secret005,2011-06-10 09:00

demo006,Demo six,secret006,2011-06-11 10:00

demo007,Demo seven,secret007,2011-06-12 11:00

demo008,Demo eight,secret008,2011-06-13 12:00

demo009,Demo nine,secret009,2011-06-13 12:00

demo010,Demo ten,secret010,2011-06-13 12:00

demo011,Demo eleven,secret011,2011-06-13 12:00
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Because this data includes a header row that contains field names, the corresponding fields were automatically
detected in the data:

Figure 22 Data File with Fields Detected from Header Row

Use the Match Fields form to identify which guest account fields are present in the imported data. You can
also specify the values to be used for fields that are not present in the data.

Figure 23 The Match Fields Form

To complete the Match Fields form, make a selection from each of the drop-down lists. Choose a column
name to use the values from that column when importing guest accounts, or select one of the other available
options to use a fixed value for each imported guest account.
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Click the Next Step button to preview the final result. Import Step 3 of 3, the Import Accounts form,
opens and shows a preview of the import operation. The values of each guest account field are determined,
and any conflicts with existing user accounts are shown.

Figure 24 The Import Accounts Form

The icon displayed for each user account indicates whether it is a new entry ( ) or if an existing user account
will be updated ( ).

By default, this form shows ten entries per page. To view additional entries, click the arrow button at the
bottom of the form to display the next page, or click the 10 rows per page drop-down list at the bottom of
the form and select the number of entries that should appear on each page.

Click the check box by the account entries you want to create, or click one of the links in the Select field at the
top of the form to select the desired accounts. These options links are described in Table 17.

Field Description

This Page Selects all entries on the current page.

All Selects all entries on all pages.

None Deselects all entries.

New Selects all new entries.

Existing Selects all existing user accounts in the list.

Create Guest Accounts Click the button to finish the import process. The selected items will be
created or updated. You can then print new guest account receipts or
download a list of the guest accounts. See "Creating Multiple Guest Account
Receipts" on page 55 in this chapter for more information.

Table 17: The Import Accounts Form, Options Links
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Managing Single Guest Accounts
Use the Manage Guest Accounts list view to work with individual guest accounts. To open the Manage
Guest Accounts list, go to Guest > Manage Accounts.

The Manage Guest Accounts list view opens. This view (guest_users) may be customized by adding new
fields or modifying or removing the existing fields. See "Customizing Fields" on page 337 for details about this
customization process. The default settings for this view are described below.

Figure 25 The Manage Guest Accounts List View

The Username, Role, State, Activation, and Expiration columns display information about the guest
accounts that have been created:

l The value in the Expiration column is colored red if the account will expire within the next 24 hours. The
expiration time is additionally highlighted in boldface if the account will expire within the next hour.

l In addition, icons in the Username column indicate the account’s activation status:

n —Guest account is active

n —Guest account was created but is not activated yet

n —Guest account was disabled by Administrator

n —Guest account has expired

n —Guest account was deleted

l If you are editing an account’s role, see "Changing a Guest Account Role" on page 82.
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You can use the Filter field to narrow the search parameters. You may enter a simple substring to match a
portion of the username or any other fields that are configured for search, and you can include the following
operators:

Operator Meaning Additional Information

= is equal to You may search for multiple values when using the
equality (=) or inequality !=) operators. To specify multiple
values, list them separated by the pipe character ( | ).

For example, specifying the filter "role_id=2|3, custom_
field=Value" restricts the accounts displayed to those with
role IDs 2 and 3 (Guest and Employee), and with the field
named "custom_field" set to "Value".

!= is not equal to

> is greater than

>= is greater than or equal to

< is less than

<= is less than or equal to

~ matches the regular expression

!~ does not match the regular
expression

Table 18: Operators supported in filters

To restore the default view, click the Clear Filter link.

You can use the paging controls at the bottom of the list to jump forwards or backwards by one page or to
jump directly to an individual page number, or to change the number of rows that are displayed on one page.

Figure 26 The Paging Control

When the list contains numerous user accounts, consider using the Filter field to speed up finding a specific user
account.

Use the Create tab to create new guest accounts using the Create New Guest Account form. See
"Creating a Guest Account " on page 44 for details about this form.

Use the More Options tab for additional functions, including import and export of guest accounts and the
ability to customize the view.

Click a user account’s row to select it. You can then select from one of these actions:

l Reset password – Changes the password for a guest account. A new randomly generated password is
displayed on the Reset Password form. The default password length is six characters. The maximum
password length is 128 characters.

ClearPass Guest 6.7 | User Guide Guest Manager | 68
Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2197



69 | Guest Manager ClearPass Guest 6.7 | User Guide

Figure 27 The Reset Password Form

Click Update Account to reset the guest account’s password. A new account receipt is displayed,
allowing you to print a receipt showing the updated account details.

l Change expiration – Lets you change the expiration time for a guest account.

Figure 28 The Change Expiration Form

This form (change_expiration) can be customized by adding new fields, or modifying or removing the existing fields.
See "Customizing Forms" on page 297 for details about this customization process.

Select an option from the drop-down list to change the expiration time of the guest account.

Click Update Account to set the new expiration time for the guest account. A new account receipt is
displayed, allowing you to print a receipt showing the updated account details.

l Remove – Disables or deletes a guest account.

Figure 29 The Remove Account Form

Select the appropriate Action radio button, and click Make Changes to disable or delete the account.
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If you wish to have automatic disconnect messages sent when the enabled value changes, you can specify
this in the Configuration module. See "Configuring ClearPass Guest Authentication " on page 276.

l Activate – Re-enables a disabled guest account, or specifies an activation time for the guest account.

Figure 30 The Enable Guest Account Form

Select an option from the drop-down list to change the activation time of the guest account. To re-enable
an account that has been disabled, choose Now. Click Enable Account to set the new activation time for
the guest account. A new account receipt is displayed, allowing you to print a receipt showing the updated
account details.

l Edit – Lets you change the properties of a guest account. The account’s row expands to include the Edit
Account form. This form is similar to the Create Account form, and all fields can be edited. If you are editing
the account’s role, see "Changing a Guest Account Role" on page 82.
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Figure 31 The Edit Account Form

This form can be customized by adding new fields, or modifying or removing the existing fields. See "Customizing
Forms" on page 297 for details about this customization process.

Click Update Account to update the properties of the guest account. A new account receipt is displayed,
allowing you to print a receipt showing the updated account details.

l Sessions – Displays the active sessions for a guest account. See "Active Sessions Management" on page
38 in this chapter for details about managing active sessions.

l Print – Displays the guest account’s receipt and the delivery options for the receipt. For security reasons,
the guest’s password is not displayed on this receipt. To recover a forgotten or lost guest account password,
use the Reset password link.

l Show Details—The row expands to display all the properties of the guest's account in a table, including
endpoint details. This option is only available to users whose operator profile includes the Show Details
privilege.
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Figure 32 The Show Details View

Changing a Guest Account Role
If you are changing a guest account’s role, you must also configure change of authorization (CoA) requests to
handle the change correctly. This ensures that the appropriate CoA requests are triggered for active sessions.
The following steps are performed in ClearPass Policy Manager:

1. Go to Policy Manager > Configuration > Enforcement > Profiles > Add.

2. On the Profile tab, open the the Template drop-down list and select RADIUS Change of Authorization
(CoA).

3. In the Name field, the name you enter for the profile must include the exact role name in square brackets.
For example, for the role “[Guest]”, the profile name might be “My Company [Guest] CoA”.

4. On the Attributes tab, open the Select RADIUS CoA Template drop-down list and select Aruba -
Change-User-Role.

5. Click a row and add an attribute with the Type as Radius:IETF. For the Value enter the role name, but
without the square brackets this time.
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Managing Devices
To view the list of current MAC devices, go to Guest > Manage Devices.

The Manage Devices list view opens.

Figure 33 The Manage Devices List View

All devices created by one of methods described in the section "Creating a Device" on page 48 are listed.
Options let you change a device’s account expiration time; activate, remove, or edit the device; view active
sessions or details for the device; or print details, receipts, confirmations, or other information.

The MAC Address, Device Name, Expiration, Sponsor, and Sharing columns display information about the
device accounts that have been created:

l The value in the Expiration column is colored red if the device account will expire within the next 24 hours.
The expiration time is additionally highlighted in boldface if the device account will expire within the next
hour.

l In addition, icons in the MAC Address column indicate the device account’s activation status:

n —Device account is active

n —Device account was created but is not activated yet

n —Device account was disabled by Administrator

n —Device account has expired

n —Device account was deleted

You can use the Filter field to narrow the search parameters. You may enter a simple substring to match a
portion of any fields that are configured for search, and you can include the following operators:

Operator Meaning Additional Information

= is equal to You may search for multiple values when using the
equality (=) or inequality !=) operators. To specify
multiple values, list them separated by the pipe
character ( | ).

For example, specifying the filter "role_id=2|3,
custom_field=Value" restricts the accounts displayed
to those with role IDs 2 and 3 (Guest and Employee),
and with the field named "custom_field" set to
"Value".

!= is not equal to

> is greater than

>= is greater than or equal to

< is less than

Table 19: Operators supported in filters
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Operator Meaning Additional Information

<= is less than or equal to

~ matches the regular expression

!~ does not match the regular
expression

To restore the default view, click the Clear Filter link.

You can use the paging controls at the bottom of the list to jump forwards or backwards by one page or to
jump directly to an individual page number, or to change the number of rows that are displayed on one page.

Figure 34 The Paging Control

To select a device, click the device you want to work with.

Changing a Device’s Expiration Date

To change a device’s expiration date, click the device’s row in the Manage Devices list, and then click its
Change expiration link. The row expands to include the Change Expiration form.

Figure 35 The Change Expiration Form

Field Description

Username The device’s MAC address.

Account
Expiration

The first Account Expiration row displays the expiration setting that is currently configured.

Account Lets you change the expiration setting. Options include:

Table 20: The Change Expiration Form
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Field Description

Expiration l No changes: Account will not expire
l Now
l Tonight
l Friday night
l 1 hour from now
l 1 day from now
l 1 week from now
l 30 days from now
l 90 days from now
l 180 days from now
l 1 year from now
l Account expires after...
l Account expires at a specified time

Expire
Action

Specifies the action to take at expiration. Options include:
l Delete and log out at specified time
l Delete at specified time
l Disable and log out at specified time
l Disable at specified time

Expires
After

Specifies an amount of time after which the account will expire. Options include intervals of hours,
days, or weeks.

Expiration
Time

Specifies a date and time when the account will expire. Click the button to open the calendar picker.
In the calendar, use the arrows to select the year and month, click the numbers in the Time fields to
increment the hours and minutes, and then click a day to select the date.

Update
Account

Commits your changes.

Disabling and Deleting Devices

To remove a device’s account by disabling or deleting it, click the device’s row in the Manage Devices list, and
then click its Remove link. The row expands to include the Remove Account form.

Figure 36 The Remove Account Form

You may choose to either disable or delete the account. If you disable it, it remains in the device list and you
may activate it again later. If you delete the account, it is removed from the list permanently.
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Activating a Device

To activate a disabled device’s account, click the device’s row in the Manage Devices list, and then click its
Activate link. The row expands to include the Enable Guest Account form.

Figure 37 The Enable Guest Account Form

Field Description

Username The MAC address of the device.

Account
Expiration

The expiration setting that is currently configured.

Activate
Account

Specifies when to activate the account. You may choose an interval, or you may choose to specify a
time.

Activation
Time

Specifies the date and time to activate the account. Click the button to open the calendar picker. In the
calendar, use the arrows to select the year and month, click the numbers in the Time fields to
increment the hours and minutes, and then click a day to select the date.

Enable
Account

Commits your changes.

Table 21: The Enable Guest Account Form
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Editing a Device
To edit a device’s account, click the device’s row in the Manage Devices list, and then click its Edit link. The row
expands to include the Edit Device form. You can edit any of the device's properties.

Figure 38 The Edit Device Form

Field Description

MAC Address The device's MAC address.

Device Name The name for the device.
If you need to modify the configuration for the expected separator format or case, go to
Administration > Plugin Manager > Manage Plugins and click the Configuration link
for the MAC Authentication Plugin.

AirGroup Enables AirGroup for the device. Configuration options are added to the form.

Ownership Specifies whether device ownership should be personal or shared. Personal devices are
automatically shared with the owner's other devices.

Table 22: The Edit Device Form
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Field Description

Shared With Usernames of people who can share this device. Enter usernames as a comma-separated
list. To make the device available to all users, leave this field blank.
Each username may not exceed 64 characters. A maximum of 100 usernames may be
entered. The maximum character limit for the list is 1000 characters (including comma
separators).

Shared Locations Locations where the device can be shared. When you type a location name in the Shared
Locations field and press the Enter key, the location appears as a "tag" and is created in
the system when the form is saved.
Each location name may not exceed 64 characters. A maximum of 100 location names may
be entered. The maximum character limit for the list is 1000 characters (including comma
separators).

Shared Roles User roles that can share this device. When you type a role name in the Shared Roles field
and press the Enter key, the role appears as a "tag" and is created in the system when the
form is saved.
Each role name may not exceed 64 characters. A maximum of 100 role names may be
entered. The maximum character limit for the list is 1000 characters (including comma
separators).

Shared Groups User groups that can share this device. These will be available in the Shared Groups field
for users to choose from when they share a device.
When you type a name for the group in the Group Names field and press the Enter key,
the group appears as a "tag" and is created in the system when the form is saved.
Each group name may not exceed 64 characters. A maximum of 32 group names may be
entered. The maximum character limit for the list is 320 characters (including comma
separators).

Time Sharing Time-based sharing rules for this device. For more information, see "About AirGroup Time-
Based Sharing" on page 92.

Syntax Opens the help topic "AirGroup Time-Based Sharing Syntax Examples" on page 88.

Account Activation Options include: Activate the account immediately, at a preset interval of hours or days, at a
specified time, or leave the account disabled.

Activation Time Specifies the date and time to activate the account. Click the button to open the calendar
picker. In the calendar, use the arrows to select the year and month, click the numbers in
the Time fields to increment the hours and minutes, and then click a day to select the date.

Account Expiration Lets you change the expiration setting. Options include: Never expire, expire at a preset
interval of hours or days, or expire at a specified time.
l If you choose any time in the future, the Expire Action row is added to the form.

Indicate the expiration action for the account—either delete, delete and log out, disable,
or disable and log out. The action will be applied at the time set in the Account
Expiration row.

l If you choose Account expires after, the ExpiresAfter row is added to the form.
Choose an interval of hours, days, or weeks. The maximum is two weeks.

l If you choose Account Expires at a specified time, the ExpirationTime row is added
to the form. In the calendar picker, use the arrows to select the year and month, click the
numbers in the Time fields to increment the hours and minutes, and then click a day to
select the date.
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Field Description

Account Role Assigns the guest’s role.

Notes Optional additional information.

Update Device Commits your changes and updates the device. The Updated Device Details and print
options are displayed.

Viewing Current Sessions for a Device

To view any sessions that are currently active for a device, click the device’s row in the Manage Devices list,
and then click its Sessions link. The Active Sessions list opens. For more information, see "Active Sessions
Management" on page 38.

Printing Device Details
To print details, receipts, confirmations, or other information for a device, click the device’s row in the Manage
Devices list, and then click its Print link. The row expands to include the Updated Device Details and a drop-
down list of information that can be printed for the device.

Figure 39 The Updated Device Details and Printing Options

Choosing an option in the Open print window using template drop-down list opens a print preview
window and the printer dialog. Options include account details, receipts in various formats, a session expiration
alert, and a sponsorship confirmation notice.

Viewing Device Details

To view details for a device, click the device’s row in the Manage Devices list, and then click its Show Details
link. The row expands to display all the properties of the device's account in a table. This option is only available
to users whose operator profile includes the Show Details privilege.
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Managing Multiple Guest Accounts
Use the Bulk Edit Accounts list view to work with multiple guest accounts. To open the Bulk Edit Accounts
list, go to Guest > Manage Multiple Accounts.

This view (guest_multi) may be customized by adding new fields or by modifying or removing the existing
fields. See "Customizing Self-Registration" on page 348 for details about this customization process. The
default settings for this view are described below.

Figure 40 The Bulk Edit Accounts List View

The Username, Role, State, Activation, Expiration, and Lifetime columns display information about the
guest accounts that have been created:

l The value in the Expiration column is colored red if the guest account will expire within the next 24 hours.
The expiration time is additionally highlighted in boldface if the guest account will expire within the next
hour.

l In addition, icons in the Username column indicate the account’s activation status:

n —Guest account is active

n —Guest account was created but is not activated yet

n —Guest account was disabled by Administrator

n —Guest account has expired

You can use the Filter field to narrow the search parameters. You may enter a simple substring to match a
portion of the username or any other fields that are configured for search, and you can include the following
operators:

Operator Meaning Additional Information

= is equal to You may search for multiple values when using the
equality (=) or inequality !=) operators. To specify multiple
values, list them separated by the pipe character ( | ).

For example, specifying the filter "role_id=2|3, custom_
field=Value" restricts the accounts displayed to those with
role IDs 2 and 3 (Guest and Employee), and with the field
named "custom_field" set to "Value".

!= is not equal to

> is greater than

>= is greater than or equal to

< is less than

Table 23: Operators supported in filters
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Operator Meaning Additional Information

<= is less than or equal to

~ matches the regular expression

!~ does not match the regular
expression

To restore the default view, click the Clear Filter link.

You can use the paging controls at the bottom of the list to jump forwards or backwards by one page or to
jump directly to an individual page number, or to change the number of rows that are displayed on one page.

Figure 41 The Paging Control

To select guest accounts, you may click either mark the account’s check box or click the account’s row.

Use the icons in the row at the top of the table to work with the accounts you’ve selected. The number of
currently selected accounts is shown. When a filter is in effect, the All Matching link can be used to add all
pages of the filtered result to the selection.

Use the Create tab to create new guest accounts using the Create Multiple Guest Accounts form. See
"Managing Multiple Guest Accounts " on page 80 in this chapter for details about this form.

Use the Delete tab to delete the guest accounts that you have selected. This option is not active if there are
no guest accounts selected.

Use the Edit tab to make changes to multiple guest accounts at once. This option is not active if there are no
guest accounts selected. If you are editing an account’s role, see "Changing a Guest Account Role" on page 82.

Figure 42 The Edit Guest Accounts Form

The Edit Guest Accounts form may be customized by adding new fields, or modifying or removing the
existing fields. See "Customizing Self-Registration" on page 348 for details about this customization process.
This is the guest_multi_form form.

The Results tab will be automatically selected after you have made changes to one or more guest accounts.
You can create new guest account receipts or download the updated guest account information. See "Creating
Multiple Guest Account Receipts" on page 55 in this chapter for more information.
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The More Options tab includes the Choose Columns command link. You can click this link to open the
Configuration module’s Customize View Fields form, which may be used to customize the Edit Guest
Accounts view.

Changing a Guest Account Role
If you are changing a guest account’s role, you must also configure change of authorization (CoA) requests to
handle the change correctly. This ensures that the appropriate CoA requests are triggered for active sessions.
The following steps are performed in ClearPass Policy Manager:

1. Go to Policy Manager > Configuration > Enforcement > Profiles > Add.

2. On the Profile tab, open the the Template drop-down list and select RADIUS Change of Authorization
(CoA).

3. In the Name field, the name you enter for the profile must include the exact role name in square brackets.
For example, for the role “[Guest]”, the profile name might be “My Company [Guest] CoA”.

4. On the Attributes tab, open the Select RADIUS CoA Template drop-down list and select Aruba -
Change-User-Role.

5. Click a row and add an attribute with the Type as Radius:IETF. For the Value enter the role name, but
without the square brackets this time.

AirGroup Device Registration
AirGroup allows users to register their personal mobile devices on the local network and define a group of
friends or associates who are allowed to share them. If AirGroup Services is enabled, AirGroup administrators
can provision their organization’s shared devices and manage access, and AirGroup operators can register and
provision a limited number of their own personal devices for sharing. For complete AirGroup deployment
information, refer to the AirGroup sections in the ArubaOS User Guide and the ClearPass Policy Manager
documentation.

This section includes:

l "Registering Groups of Devices or Services" on page 83

l "Registering Personal Devices" on page 85

l "AirGroup Time-Based Sharing Syntax Examples" on page 88

l "About AirGroup Time-Based Sharing" on page 92
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Registering Groups of Devices or Services
This functionality is only available to AirGroup administrators.

To register and manage an organization’s shared devices and configure device access, log in as the AirGroup
administrator and go to Guest > Create Device. The Register Shared Device form opens.

Figure 43 The Register Shared Device Form

Field Description

Device
Name

(Required) Enter the name used to identify the device.

Device
Type

(Required) Specifies the device type.

MAC
Address

(Required) Enter the device’s MAC address.

Shared
Locations

Lets you specify the locations where the device can be shared. To allow the device to be shared with all
locations, leave this field blank.
Each location name may not exceed 64 characters. A maximum of 100 location names may be
entered. The maximum character limit for the list is 1000 characters (including comma separators).
Each location is entered as a tag=value pair describing the MAC address of the access point (AP)
closest to the registered device. Use commas to separate the tag=value pairs in the list. Tag=value
pair formats are as follows:

Table 24: The Register Shared Device Form
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Field Description

AP Type Tag=Value Format

Name-based AP ap-name=<name>

Group-based AP ap-group=<group>

FQLN-based AP fqln=<fqln>

l AP FQLNs should be configured in the format <ap name>.<floor>.<building>.<campus>

l Floor names should be in the format floor <number>

l The <ap-name> should not include periods ( . )
Example:
AP105-1.Floor 1.TowerD.Mycompany

Shared
With

Lets you specify the usernames of your organization’s staff or students who are allowed to use the
device. Use commas to separate usernames in the list.
Each username may not exceed 64 characters. A maximum of 100 usernames may be entered. The
maximum character limit for the list is 1000 characters (including comma separators).
l If the Shared With field is left blank, this device can be accessed by all devices.
l If users are entered in the Shared With field, the device can only be accessed by the specified

users.

Shared
Roles

Lets you specify the user roles that are allowed to use the device. Use commas to separate the roles in
the list.
Each role name may not exceed 64 characters. A maximum of 100 role names may be entered. The
maximum character limit for the list is 1000 characters (including comma separators).
l To make the device available to all roles, leave this field blank.
l If roles are entered in the Shared Roles field, the device can only be accessed by users with

matching roles.

Register
Shared
Device

Saves your changes and registers the device. The Finished Creating Guest Account page opens.
This page displays Account Details and provides printer options.

To view and edit your organization’s shared AirGroup devices:

1. Go to Guest > List Devices, or click the Manage my AirGroup Devices link on the Create AirGroup
Device page. The AirGroup Devices page opens. This page lists all the shared AirGroup devices for the
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organization. You can remove a device; edit a device’s name, MAC address, shared locations, shared-user list,
or shared roles; print device details; or add a new device.

2. To work with a device, click the device’s row in the list. The form expands to include the Remove, Edit, and
Print options.

Figure 44 The Edit Shared Device Form

3. To edit properties of a shared device, click the Edit link for the device. The row expands to include the Edit
Shared Device form. You can modify the device’s name, MAC address, shared locations, group of users,
and shared roles.

4. When your edits are complete, click Save Changes.

Registering Personal Devices
This functionality is available to AirGroup operators.

To register your personal devices and define a group who can share them:

1. Log in as the AirGroup operator and go to Guest > Create Device. The Register Device form opens.
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Figure 45 The Register Device Form

Field Description

Your
Name

(Required) Enter your username for your organization.

Device
Name

(Required) Enter the name used to identify the device.

Device
Type

(Required) Select the device type.

Table 25: The Register Device Form
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Field Description

MAC
Address

(Required) Enter the device’s MAC address.

Shared
With

Lets you enter the usernames of your friends or colleagues who are allowed to use the device. Use
commas to separate usernames in the list. You may enter up to ten usernames.
l If the Shared With field is left blank, this device can only be accessed by devices registered by the

same operator or with a dot1x username that matches the operator’s name.
l If users are entered in the Shared With field, the device can be accessed by the device owner and

by the specified users.

Register
Device

Saves your changes and registers the device. The Finished Creating Guest Account page opens. This
page displays account details and provides printer options.

To view and edit your personal AirGroup devices:

l Go to Guest > List Devices, or click the Manage my AirGroup Devices link on the Create AirGroup
Device page. The AirGroup Devices page opens. This page lists all your personal AirGroup devices. You
can remove a device; edit a device’s name, MAC address, or shared-user list; print device details; or add a
new device.

l To work with a device, click the device’s row in the list. The form expands to include the Remove, Edit, and
Print options.

Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2216



Figure 46 The Edit Device Form

l To edit properties of a device, click the Edit link for the device. The row expands to include the Edit Device
form. You can modify the device’s name, MAC address, and group of users. When your edits are complete,
click Save Changes.

AirGroup Time-Based Sharing Syntax Examples
This section provides examples and discussions of syntax for time-based sharing policies for AirGroup shared
devices.

For information on using time-based sharing for AirGroup, see "About AirGroup Time-Based Sharing" on page
92. For supplemental time-based syntax information, see "Time-Based Syntax Reference" on page 91.

Example:
periodic Monday 9am to 10am shared users A, B

The device is shared with users A and B, from 9am to 10am every Monday (relative to the server's current
time zone). Outside of this time slot, the device is not shared (except as otherwise controlled by AOS).

Example:
periodic Monday 9:00 to 10:30 shared users A, B

periodic Monday 12:00 to 13:30 shared users A, B

periodic Monday 15:00 to 16:30 shared users C, D

ClearPass Guest 6.7 | User Guide Guest Manager | 88
Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2217



89 | Guest Manager ClearPass Guest 6.7 | User Guide

The device is shared with users A and B, from 9am to 10:30am and from noon to 1:30pm every Monday
(relative to the server's current time zone). From 3pm to 4:30pm, the device is shared with users C and D.

Outside of these two time slots, the device is not shared.

With periodic, times may be specified either in 24-hour format (hh:mm, from 0:00 to 24:00), or in 12-hour
format (hh:mm and am or pm).

Don't specify overlapping time ranges with periodic rules; this can lead to unexpected results.

The synonyms rep, repeat or repeating may also be used in place of period or periodic. All of these
terms are treated identically.

Example:
default allow

periodic mon 9am to 10am shared users A, B

As in the first example, the device is shared with users A and B, from 9am to 10am every Monday. Outside
of this time slot, the device is shared as specified by the other sharing state fields (shared users, locations,
roles and/or groups). This is the meaning of the default allow statement.

If default allow is not specified, the normal behavior is default deny, which is the same as in the first
example. Note that with default deny in effect, the AirGroup time sharing policy will override any other
sharing rules that are specified, for as long as the time sharing policy is in effect.

Two and three-character shortened forms of weekdays are acceptable (e.g. "Mon" or "Mo" can be used for
Monday, "Tue" or "Tu" for Tuesday, etc.) Case is not significant in the time sharing policy, so "Mon", "MON",
and "mon" are all equivalent ways to specify "Monday".

Example:
default deny

not after 01-Feb-2014

periodic mon 9am to 10am shared users A, B

The device is shared with users A and B, from 9am to 10am every Monday. The not after date sets the end
of the time sharing policy. Monday, January 27, 2014 is the last day that this time sharing policy will take
effect.

After 10am on this date, the time sharing policy is no longer in effect; any other sharing rules that have
been specified will then take effect.

Example:
default deny

not before 1/1/14

not after 01-Feb-2014

periodic mon 9am to 10am shared users A, B

The device is shared with users A and B, from 9am to 10am every Monday. The not before date sets the
beginning of the time sharing policy. In this case, Monday, January 6, 2014 is the first day that this time
sharing policy will take effect.

Prior to 9am 6 January 2014, the device is not shared (due to the default deny).

After 10am on 27 January 2014, the time sharing policy is no longer in effect; any other sharing rules that
have been specified will then take effect.

Example:
time zone America/Los_Angeles

periodic Monday 9am to 10am shared users A, B

Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2218



The device is shared with users A and B, from 9am to 10am every Monday (relative to the U.S. Pacific time
zone). Daylight savings time rules are observed; the time period 9am to 10am is always relative to that
time zone.

Example:
periodic mon tue wed thu fri 9am to 10am shared users A, B

The device is shared with users A and B, from 9am to 10am every weekday (Monday, Tuesday, Wednesday,
Thursday and Friday).

Example:
periodic weekdays 9am to 10am shared users A, B

weekday or weekdays can be used as a synonym for "Monday Tuesday Wednesday Thursday Friday".
Similarly, weekend or weekends can be used as a synonym for "Saturday Sunday".

Example:
on Sep 16 9:00 to 13:00 shared location AP-Name=1341-ap01 shared group ABC shared role

SomeRole shared user user02, user03, "user04", 'user05'

The device is shared with a single access point named 1341-ap01, a single group named ABC, a single role
named SomeRole, and 4 users named user02,user03, user04, and user05.

Note the quotes are not considered to be part of the user names user04 and user05. (In this case, the
quotes are redundant as there is no space or comma that requires quoting.)

No time zone is specified, so the date and time are determined relative to the server's time zone.

No year is specified, so the server's current year is used. In particular, after September 16 of any year, this
rule will have no effect until the following year.

Example:
default allow

periodic 0:00 to 24:00 shared roles default_role

periodic mon 9am to 5pm shared roles other_role

The device is normally shared ("default allow") with a single role named default_role ("periodic 0:00 to
24:00 shared roles default_role").

On Monday from 9am to 5pm, the device is shared with a different role named other_role.

Note that even though the time ranges overlap, the sharing policies are completely distinct; on Mondays
from 9am to 5pm, the role default_role will NOT have access to the device, because a different sharing rule
is in effect. (The rule could instead have been written "periodic mon 9am to 5pm shared roles default_role,
other_role" if this was the desired result.)

This example shows how to use an overlapping time range: place the most general time range first, with
more specific time ranges later. In particular, reversing the order of the periodic statements will not work.

Example:
default deny

periodic 9:00 to 22:00 shared roles default_role

no periodic thu 9:00 to 17:00

periodic fri 9:00 to 17:00 not shared

This example shows how to share a device with a basic policy, and demonstrates two ways to disable
sharing for a subset of the time period.

The device will be shared with a single role named default_role, from 9:00 to 22:00 each day. ("periodic
9:00 to 22:00 shared roles default_role").

On Thursday, the device is not shared between 9:00 and 17:00.
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On Friday, the device is not shared between 9:00 and 17:00.

Example:
default allow

periodic 9:00 to 22:00 shared roles default_role

no periodic thu 9:00 to 17:00

periodic fri 9:00 to 17:00 not shared

This example is similar to the previous example; the device is not shared on Thursday and Friday between
9:00 and 17:00.

The difference is after 22:00 and before 9:00: in the previous example, the device is not shared during this
time period, whereas with default allow the other AirGroup sharing rules will take effect (any shared users,
roles, groups or locations that have been defined for the device).

Time-Based Syntax Reference

This reference describes the syntax used for time formats in time-based sharing rules. It supplements the
examples for AirGroup time-based sharing by user groups discussed in "AirGroup Time-Based Sharing Syntax
Examples" on page 88. For more information on using time-based sharing with AirGroup, see "About AirGroup
Time-Based Sharing" on page 92.

The syntax for AirGroup time-based sharing policies supports all the default time-based ACL rules specified in
TimeRangeACL. This ACL is a sequence of rules, one per line, according to the following syntax:

l default allow|deny

Specifies the default behavior for unmatched times; this is 'allow' only if no 'periodic' or 'absolute' rules are
specified, otherwise it is 'deny'. Use 'default allow' if the remaining rules exclude times, otherwise use
'default deny' if the remaining rules are to include times. This rule may only be used once.

l [time] zone default|server|...

Specifies the time zone to use for matching times and specifying the time of day. If unset, the current time
zone setting is used (note that this may vary due to operator and/or profile settings). If the value "default"
or "server" is specified, the system's time zone is used. Otherwise, the named time zone is used. This rule
may only be used once, and must be before any rules specifying a time interval.

l [not] period(ic) [day-list] hh:mm to [day] hh:mm

Specifies a periodic or daily interval. Recognized days include Sunday, Monday, Tuesday, Wednesday,
Thursday, Friday, Saturday and 3-letter abbreviations; the tokens "weekends" and "weekdays" may also be
used. Without a day-list, all days of the week are matched. Time may be specified in 12 or 24 hour format,
with the special time 24:00 indicating the end of the day.

Example: periodic monday 8:00 to friday 17:00 matches between 8am and 5pm, Monday
through Friday.

Example: periodic weekdays 8:00 to 17:00 specifies the same thing as the example in the previous
line.

Example: periodic wed 11am to 11pm matches between 11:00 and 23:00 on a Wednesday.

Example: periodic weekend 0:00 to 24:00 matches any time on a Saturday or Sunday.

Example: periodic saturday sunday 0:00 to 24:00 specifies the same thing as the example in the
previous line.

The 'not' keyword may be specified to invert the allow/deny decision.

Example: default allow; not period 23:00 to 6:00 (on 2 separate lines) allows access, except
between 11pm and 6am.
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Example: period 6:00 to 23:00 is equivalent to the example in the previous line.

l not before [date-and-time]

Specifies an absolute time before which access will always be rejected.

Example: not before 2010-07-01 09:00 matches after 9am on 1 July 2010.

l not after [date-and-time]

Specifies an absolute time after which access will always be rejected.

Example: not after 2011-01-01 00:00 matches before midnight on New Year's Day 2011.

l [not] abs(olute) [start-date-and-time] to [end-date-and-time]

Specifies a start and end interval. The date and time is a format recognized by strtotime(). Times between
the start and end point are matched. The 'not' keyword may be specified to invert the allow/deny decision.

Example: absolute December 25 to December 26 matches all day on Christmas Day each year. (This
does not match on December 26 as midnight on this date is the endpoint of the interval.)

A blank time ACL means "all times are allowed".

The following examples give common usage:

l 8:00 to 18:00 - allows access 8am to 6pm, every day, but not outside those times

l weekdays 9am to 5pm - allows access 9am to 5pm, Monday through Friday, but not outside those times

l weekdays 9am to 5pm

weekends 10am to 4pm - allows access 9am to 5pm, Monday through Friday, with reduced hours on
Saturday and Sunday

Annual recurrences may be specified:

l weekdays 9am to 5pm

not absolute December 25 to December 26 - allows access 9am to 5pm, Monday through Friday,
but not on Christmas Day

Less common cases:

l default allow

not 23:00 to 6:00 - allows access, except between 11pm and 6am daily

l 9:00 to 18:00

not before 2010-02-01 - allows daily access between 9am and 6pm, starting on February 1, 2010

l time zone Etc/GMT

9:00 to 18:00

not before 2010-02-01 - allows daily access between 9am and 6pm, starting on February 1, 2010, in
the GMT time zone (useful if server is in a different time zone)

About AirGroup Time-Based Sharing
This section discusses time-based sharing policies for an AirGroup shared device.

For information on the syntax for time-based sharing policies for a AirGroup shared devices, see "AirGroup
Time-Based Sharing Syntax Examples" on page 88

Time-based sharing is used in settings where an organization's shared devices are made available to groups of
users according to a regular schedule, and device access is configured by group at the user level—for example:
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l A university classroom or laboratory is used by a first-year physics class on Mondays, Wednesdays, and
Fridays, by a group of researchers on Tuesdays and Thursdays, and for visiting speakers every other
Saturday.

l A convention center has several major exhibitors who each hold an annual event, and who reserve their
customary section of the convention center several years in advance.

In cases like this, you can enter rules to define the schedule on which shared devices in an area will be available
to certain groups. You can also specify times when a device will not be available. This is a time-based sharing
policy.

Device association is dynamic: When a shared device is available to a group, any user with that group attribute
can access the device. When the user is no longer a member of the group (for example, at the end of the
semester), they no longer have access, but the time-based sharing policy remains in effect and new users who
are assigned the group attribute can access the shared device.

Basics of Time-Based Sharing Setup

When you create a device, enable it for AirGroup Services, and configure it as a shared device, you also have the
option to specify time-based sharing (time fencing) for the device.

You first use the Administration > AirGroup Services > Configure form to create the groups who can
share devices. When you type a name for the group in the Group Name field, press the Enter key, and click
Save, the group is created in the system and appears as a "tag".

Figure 47 Tags Added in the Group Names Field

On the Guest > Create Device or Guest > List Devices > Edit forms, the shared user groups you created
are then available for selection when you click in the Shared Groups field. (This feature requires AOS 6.4 or
later)

Figure 48 Groups Created as Tags Available for Selection in the Shared Groups Field

On the same screen, the next step is then to enter the rules for the time-based sharing policy, using the group
names you created. For more information, see "AirGroup Time-Based Sharing Syntax Examples" on page 88
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Figure 49 Entering Rules that Use the New Groups

MAC Authentication in ClearPass Guest
ClearPass Guest supports a number of options for MAC Authentication and the ability to authenticate devices.

The advanced features described in this section generally require a WLAN capable of MAC authentication with
captive portal fallback. Please refer to the Aruba WLAN documentation for setting up the controller
appropriately.

To verify that you have the most recent MAC Authentication Plugin installed and enabled before you configure
these advanced features, go to Administration > Plugin Manager. For information on plugin management,
see "Plugin Manager" on page 648.

MAC Address Formats
Different vendors format the client MAC address in different ways—for example:

l 112233AABBCC

l 11:22:33:aa:bb:cc

l 11-22-33-AA-BB-CC

ClearPass Guest supports adjusting the expected format of a MAC address. To configure formatting of
separators and case in the address, as well as user detection and device filtering for views, go to
Administration > Plugin Manager and click the Configuration link for the MAC Authentication plugin.
The MAC Authentication Configuration page opens.

Figure 50 MAC Authentication Plugin Configuration
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Field Description

MAC Detect (Required) If selected, users can be detected by their MAC address, providing access to user
configuration for headers, footers, etc. on login and registration pages. Requires a vendor that
passed the MAC address as part of the redirect.
Because a passed MAC address can easily be changed by the user, personal details should not be
displayed.

Device Filter Specifies which views should not display devices (user accounts with the “mac_auth” field set).
Views that can be specified include:
l Manage Accounts
l Manage Multiple Accounts

Save
Configuration

Saves your changes.

Table 26: The Configure MAC Authentication Form

On the controller, the fields look as follows:

Figure 51 MAC Authentication Profile

Automatically Registering MAC Devices in ClearPass
You can configure a guest MAC address to be automatically registered as an endpoint record in ClearPass Policy
Manager when the guest uses a Web login page or a guest self-registration workflow. This customization option
is available if a valid Local or RADIUS pre-authentication check was performed.

To configure auto-registration for an address through a Web login page:

1. Go to Configuration > Pages > Web Logins, click the row of the page you wish to configure, and then
click its Edit link. The Web Login Editor form opens.

2. Scroll down to the Post-Authentication area.
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Figure 52 The Web Login Editor Form, Post-Authentication Area

3. Select the check box in the Update Endpoint row. This will mark the guest’s MAC address as a known
endpoint, and will also update the the endpoint’s attributes with other details of the user account.

4. To specify custom attributes to store in the endpoint, select the check box in the Advanced row.

5. In the Endpoint Attributes field, enter a list of name-value pairs to pass as custom attributes. Follow the
format “user_field | Endpoint Attribute”. Examples are shown in this text box.

6. Click Save Changes to complete this configuration and continue with other tasks, or click Save and
Reload to proceed to Policy Manager and apply the network settings.

Importing MAC Devices
The standard Guest > Import Accounts form supports importing MAC devices. At a minimum the following
two columns are required: mac and mac_auth.
mac_auth,mac,notes

1,aa:aa:aa:aa:aa:aa,Device A

1,bb:bb:bb:bb:bb:bb,Device B

1,cc:cc:cc:cc:cc:cc,Device C

Any of the other standard fields can be added similar to importing regular guests.

Advanced MAC Features
This section describes some advanced features for MAC authentication.

User Detection on Landing Pages

When mac is passed in the redirect URL, the user is detected and a customized message displays on the
landing page.
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To use this feature:

1. Go to Administration > Plugin Manager: MAC Authentication: Configuration and enable MAC
Detect.

2. Edit the header of your redirect landing page (login or registration) and include the following:
<p>{if $guest_receipt.u.visitor_name}

Welcome back to the show, {$guest_receipt.u.visitor_name|htmlspecialchars}!

{else}

Welcome to the show!

{/if}</p>

3. For debugging purposes, include the following to see all the fields available:
{dump var=$guest_receipt export=html}

Click-Through Login Pages

A click-through login page will present a splash or terms screen to the guest, yet still provide MAC-auth style
seamless authentication. Under this scenario, you could have people create an account, with a paired MAC, yet
still have them click the terms and conditions on every new connection.

To use this feature:

1. Disable MAC authentication on the controller.

2. Go to Administration > Plugin Manager: MAC Authentication: Configuration and enable MAC
Detect.

3. Create a Web Login. Include the following settings:

l Authentication: Anonymous

l Anonymous User: _mac (_mac is a special secret value)

l Pre-Auth Check: Local

l Terms: Require a Terms and Conditions confirmation

4. Set the Web login as your landing page and test. Using a registered device the 'Log In' button should be
enabled, otherwise it will be disabled.

5. You might also want to add a message so guests get some direction:
<p>{if $guest_receipt.u.username}

{if $guest_receipt.u.visitor_name}

Welcome back, {$guest_receipt.u.visitor_name|htmlspecialchars}!

{else}

Welcome back.

{/if}

Please accept the terms before proceeding.

{else}

You need to register...

{/if}</p>

6. You can hide the login form by having the final line of the header be:
{if !$guest_receipt.u.username}<div style="display:none">{/if}

and the first line of the footer be:
{if !$guest_receipt.u.username}</div>{/if}
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Chapter 4
Onboard

Onboarding is the process of preparing a device for use on an enterprise network by creating the appropriate
access credentials and setting up the network connection parameters. ClearPass Onboard automates 802.1X
configuration and provisioning for “bring your own device” (BYOD) and IT-managed devices across wired,
wireless, and virtual private networks (VPNs).

ClearPass Onboard includes the following key features:

l Automatic configuration of network settings for wired and wireless endpoints

l Provisioning of unique device credentials for BYOD and IT-managed devices

l Support for Windows, macOS, iOS, and Android devices

l Ability to revoke unique credentials on a specific user's device

l ClearPass Profiler for identifying device type, manufacturer, and model

Accessing Onboard
To access the device provisioning features of ClearPass Onboard, click the Onboard link in the left navigation.
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About ClearPass Onboard
ClearPass Onboard automates 802.1X configuration and provisioning for “bring your own device” (BYOD) and
IT-managed devices—Windows, macOS, iOS and Android—across wired, wireless, and virtual private networks
(VPNs).

ClearPass Onboard includes the following key features:

l Automatic configuration of network settings for wired and wireless endpoints.

l Provisioning of unique device credentials for BYOD and IT-managed devices.

l Support for Windows, macOS, iOS, and Android devices.

l Enables the revocation of unique credentials on a specific user’s device.

l Uses ClearPass Profiler to identify device type, manufacturer, and model.

This section provides the following important information about ClearPass Onboard:

l "Onboard Deployment Checklist " on page 100

l "Onboard Feature List " on page 102

l "Supported Platforms" on page 103

l "Public Key Infrastructure for Onboard" on page 104

l "Revoking Unique Device Credentials" on page 105
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l "Network Requirements for Onboard" on page 106

l "Network Architecture for Onboard" on page 108

l "The ClearPass Onboard Process" on page 110

l "Configuring the User Interface for Device Provisioning" on page 116

l "Onboard Troubleshooting" on page 117

Onboard Deployment Checklist
Table 27 lists planning, configuration, and testing procedures. Use this checklist to complete your Onboard
deployment.

Onboard events are stored in the Application Log for seven days by default. After seven days, significant
runtime events are listed in the Audit Viewer in ClearPass Policy Manager’s Monitoring module. Onboard events
that are listed include:

l Changing the CA certificate

l Issuing a new certificate

l Signing a certificate signing request

l Revoking a certificate

l Deleting a certificate

l Importing a trusted certificate

l Uploading a code-signing or other certificate

Deployment Step Reference

Planning and Preparation

Review the Onboard feature list to identify the major areas of
interest for your deployment.

"Onboard Feature List " on page 102

Review the list of platforms supported by Onboard, and identify the
platforms of interest for your deployment.

"Supported Platforms" on page 103

Review the Onboard public key infrastructure, and identify any
Certificate Authorities that will be needed during the deployment.

"Public Key Infrastructure for Onboard" on
page 104

Review the network requirements and the network architecture
diagrams to determine how and where to deploy the Onboard
solution.

Refer to the ClearPass Policy Manager
documentation, and "Network Architecture
for Onboard" on page 108 in this chapter

Configuration

Configure the hostname and networking properties of the Onboard
provisioning server.
l DNS is required for SSL.
l Ensure that hostname resolution will work for devices being

provisioned.

Refer to the ClearPass Policy Manager
documentation

Configure SSL certificate for the Onboard provisioning server.
A commercial SSL certificate is required to enable secure device

Refer to the ClearPass Policy Manager
documentation

Table 27: Onboard Deployment Checklist
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Deployment Step Reference

provisioning for iOS devices.

Configure the Onboard Certificate Authority.
l Decide whether to use the Root CA or Intermediate CA mode of

operation.
Create the certificate for the Certificate Authority.

"Certificate Authorities " on page 119

Configure device provisioning settings.
l Select certificate options for device provisioning.
Select which device types should be supported.

"About Configuring Provisioning Settings " on
page 224

Configure network settings for device provisioning.
l Set network properties.
l Upload 802.1X server certificates.
Set device-specific networking settings.

"Network Settings " on page 168

Configure networking equipment for non-provisioned devices.
l Set authentication for the provisioning SSID, if required.
Ensure the captive portal redirects non-provisioned devices to the
device provisioning page.

"Network Requirements for Onboard" on
page 106

Configure networking equipment to authenticate provisioned
devices.
l Ensure 802.1X authentication methods and trust settings are

configured correctly for all EAP types that are required.
Configure OCSP or CRL on the authentication server to check for
client certificate validity.

"Network Requirements for Onboard" on
page 106

Configure the user interface for device provisioning.
l Set display options for iOS devices.
l Set user interface options for other Onboard devices.
Setup the device provisioning Web login page.

"Configuring the User Interface for Device
Provisioning" on page 116

Testing and Verification

Test device provisioning.
l Verify that each type of device can be provisioned successfully.
Verify that each type of device can join the provisioned network
and is authenticated successfully.

Test device revocation.
l Revoke a device’s certificate.
l Verify that the device is no longer able to authenticate.
Verify that re-provisioning the device fails.

Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2230



Onboard Feature List
The following features are available in ClearPass Onboard.

Feature Uses

Automatic configuration of network settings
for wired and wireless endpoints.

l Configure wired networks using 802.1X
l Configure Wi-Fi networks using either 802.1X or Pre-Shared Key

(PSK)
l Configure trusted server certificates for 802.1X
l Configure Windows-specific networking settings
l Configure HTTP proxy settings for client devices (Android,

macOS only)

Secure provisioning of unique device
credentials for BYOD and IT-managed
devices.

l Configure EAP-TLS and PEAP-MSCHAPv2 without user
interaction

l Revoke unique device credentials to prevent network access

Support for Windows, macOS, iOS, and
Android devices.

l Leverage ClearPass Profiling to identify device type,
manufacturer, and model

l Control the user interface displayed during device provisioning

Certificate Authority enables the creation
and revocation of unique credentials on a
specific user’s device.

l Root and intermediate CA modes of operation
l Supports SCEP enrollment of certificates
l Supports CRL generation to list revoked certificates
l Supports OCSP responder to query for certificate status
l Approve certificate signing request
l Reject certificate signing request
l Sign certificate from uploaded certificate signing request (CSR)
l Issue certificate
l Revoke certificate
l Display certificates
l Export certificate
l Renew root certificate

Provision additional settings specific to iOS
devices

l Exchange ActiveSync
l Passcode policy
l VPN settings

Table 28: Onboard Features
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Supported Platforms
The platforms supported by ClearPass Onboard and the version requirements for each platform are
summarized in the following table.

Platform Example Devices Version Required for Onboard Support Notes

Android Samsung Galaxy
Motorola Droid
Google Pixel

Android 6.0 and later 2

Apple iOS iPhone
iPad
iPod Touch

iOS 10 and later 1, 3

Apple macOS MacBook Pro
MacBook Air

macOS 10.11 and later 1

macOS 10.11 and later 2

Microsoft Windows Laptop
Desktop
Tablet

Windows 10.x
Windows 8.x
Windows 7.x with Service Pack 1

2, 4

Ubuntu Desktop
Server

14.04
16.04

Table 29: Platforms Supported by ClearPass Onboard

Note 1: Uses the “Over-the-air provisioning” method.
Note 2: Uses the “Onboard provisioning” method.
Note 3: Onboard may also be used to provision VPN settings, Exchange ActiveSync settings, and passcode policy on these

devices.
Note 4: Windows 10 Mobile is not currently supported in Onboard.
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Public Key Infrastructure for Onboard
During the device provisioning process, one or more digital certificates are issued to the device. These are used
as the unique credentials for a device. To issue the certificate, ClearPass Onboard must operate as a Certificate
Authority (CA). The following sections explain how the Certificate Authority works, and which certificates are
used in this process.

Certificate Hierarchy
In a public key infrastructure (PKI) system, certificates are related to each other in a tree-like structure.

Figure 53 Relationship of Certificates in the Onboard Public Key Infrastructure

The root Certificate Authority (CA) is typically an enterprise Certificate Authority, with one or more intermediate
CAs used to issue certificates within the enterprise.

Onboard may operate as a root CA directly, or as an intermediate CA. See "Certificate Authorities " on page 119.
For information on setting up certificates when using Onboard in a cluster, see "Certificate Configuration in a
Cluster " on page 105.

The Onboard CA issues certificates for several purposes:

l The Profile Signing Certificate is used to digitally sign configuration profiles that are sent to iOS devices.

n The identity information in the profile signing certificate is displayed during device provisioning.

l One or more Server Certificates may be issued for various reasons – typically, for an enterprise’s
authentication server.

n The identity information in the server certificate may be displayed during network authentication.

l One or more Device Certificates may be issued – typically, one or two per provisioned device.
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n The identity information in the device certificate uniquely identifies the device and the user that
provisioned the device.

You do not need to manually create the profile signing certificate; it is created when it is needed See "About
Configuring Provisioning Settings " on page 224 to control the contents of this certificate.

You may revoke the profile signing certificate. It will be recreated when it is needed for the next device
provisioning attempt.

Certificate Configuration in a Cluster

When you use Onboard in a cluster, you must use one common root Certificate Authority (CA) to issue all
ClearPass appliance certificates for the cluster. This allows the “verified” message in iOS and lets you verify that
a ClearPass appliance’s certificate is valid during EAP-PEAP or EAP-TLS authentication.

In a cluster of ClearPass appliances, devices can be onboarded through any node or authenticated through any
node. Each ClearPass appliance has a different certificate, used for both SSL and RADIUS server identity. In the
default configuration, these are self-signed certificates—that is, they are not issued by a root CA. This
configuration of multiple self-signed certificates will not work for Onboard: Although a single self-signed
certificate can be trusted, multiple self-signed certificates are not.

There are two ways to configure a common root CA to issue all the ClearPass appliance certificates for a cluster:

l Use the Onboard Certificate Authority. Create a certificate signing request on each ClearPass node, sign the
certificates using Onboard, and install them in ClearPass. You can then onboard devices on any node in the
cluster, and can perform secure EAP authentication from a provisioned device to any node in the cluster.

l Use a commercial Certificate Authority to issue ClearPass appliance certificates. Verify that the same root CA
is at the top of the trust chain for every server certificate, and that it is the trusted root certificate for
Onboard. Provisioning and authentication will then work across the entire cluster.

Revoking Unique Device Credentials
Because each provisioned device uses unique credentials to access the network, it is possible to disable
network access for an individual device. This offers a greater degree of control than traditional user-based
authentication — disabling a user’s account would impact all devices using those credentials.

To disable network access for a device, revoke the TLS client certificate provisioned to the device. See "Working
with Certificates in the List" on page 152.

Revoking access for a device is only possible when using an enterprise network. Personal (PSK) networks do not
support this capability.

Revoking Credentials to Prevent Network Access

Revoking a device's certificate will cause the device to be unable to authenticate. It will not prevent it from being re-
provisioned. If you wish to deny access to a device, use the Manage Access link in the device's row on the Onboard
> Management and Control > View by Device form.

If the device is provisioned with an EAP-TLS client certificate, revoking the certificate will cause the Certificate
Authority to update the certificate’s state. When the certificate is next used for authentication, it will be
recognized as a revoked certificate and the device will be denied access.

When using EAP-TLS authentication, you must configure your authentication server to use either OCSP or CRL to
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check the revocation status of a client certificate. OCSP is recommended as it offers a real-time status update for
certificates. If the device is provisioned with PEAP unique device credentials, revoking the certificate will
automatically delete the unique username and password associated with the device. When this username is next
used for authentication, it will not be recognized as valid and the device will be denied access.

OCSP and CRL are not used when using PEAP unique device credentials. The ClearPass Onboard server
automatically updates the status of the username when the device's client certificate is revoked.

Re-Provisioning a Device

Because “bring your own” devices are not under the complete control of the network administrator, it is
possible for unexpected configuration changes to occur on a provisioned device.

For example, the user may delete the configuration profile containing the settings for the provisioned network,
instruct the device to forget the provisioned network settings, or reset the device to factory defaults and
destroy all the configuration on the device.

When these events occur, the user will not be able to access the provisioned network and will need to re-
provision their device.

The Onboard server detects a device that is being re-provisioned and prompts the user to take a suitable action
(such as connecting to the appropriate network). If this is not possible, the user may choose to restart the
provisioning process and re-provision the device.

Re-provisioning a device will reuse an existing TLS client certificate or unique device credentials, if these
credentials are still valid.

If the TLS client certificate has expired then the device will be issued a new certificate. This enables re-
provisioning to occur on a regular basis.

A new certificate is generated when any of the following conditions occur:

l The key is set to be created by the device

l The fields in the certificate change

l The previous certificate has only 25% of its validity period remaining

Network Requirements for Onboard
To achieve complete functionality, ClearPass Onboard has certain requirements that must be met by the
provisioning network and the provisioned network:

l The provisioning network must use a captive portal or other method to redirect a new device to the device
provisioning page.

l The provisioning server (Onboard server) must have an SSL certificate that is trusted by devices that will be
provisioned. In practice, this means a commercial SSL certificate is required.

l The provisioned network must support EAP-TLS and PEAP-MSCHAPv2 authentication methods.

l The provisioned network must support either OCSP or CRL checks to detect when a device has been
revoked and deny access to the network.
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Using Same SSID for Provisioning and Provisioned Networks
To configure a single SSID to support both provisioned and non-provisioned devices, use the following
guidelines:

l Configure the network to use both PEAP and EAP-TLS authentication methods.

l When a user authenticates via PEAP with their domain credentials, place them into a provisioning role.

l The provisioning role should have limited network access and a captive portal that redirects users to the
device provisioning page.

l When a user authenticates via PEAP with unique device credentials, place them into a provisioned role.

l When a user authenticates via EAP-TLS using an Onboard client certificate, place them into a provisioned
role.

For provisioned devices, additional authorization steps can be taken after authentication has completed to
determine the appropriate provisioned role.

Using Different SSID for Provisioning and Provisioned Networks
To configure dual SSIDs to support provisioned devices on one network, and non-provisioned devices on a
separate network, use the following guidelines:

l Configure the provisioning SSID to use PEAP, or another suitable authentication method.

l When a user connects to the provisioning SSID, place them into a provisioning role.

n The provisioning role should have limited network access and a captive portal that redirects users to the
device provisioning page.

l When a user connects to the provisioned SSID, authenticate based on the type of credentials presented.

n For PEAP authentication with unique device credentials, place them into a provisioned role.

n For EAP-TLS authentication using an Onboard client certificate, place them into the provisioned role.

n In all other cases, deny access.

As for the single-SSID case, additional authorization steps may be taken after authentication has completed to
determine the appropriate provisioned role.

Configuring Online Certificate Status Protocol

Onboard supports the Online Certificate Status Protocol (OCSP) to provide a real-time check on the validity of a
certificate.

To configure OCSP for your network, you will need to provide the URL of an OCSP service to your network
equipment. This URL can be constructed by using the relative path mdps_ocsp.php/1.

For example, if the Onboard server’s hostname is onboard.example.com, the OCSP URL to use is:
http://onboard.example.com/guest/mdps_ocsp.php/1.

OCSP does not require the use of HTTPS and can be configured to use HTTP.

Configuring Certificate Revocation List (CRL)

Onboard supports generating a Certificate Revocation List (CRL) that lists the serial numbers of certificates that
have been revoked.
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To configure a CRL, you will need to provide its URL to your network equipment. This URL can be constructed
by using the relative path mdps_crl.php?id=1.

For example, if the Onboard server’s hostname is onboard.example.com, the location of the CRL is:
http://onboard.example.com/guest/mdps_crl.php?id=1.

A certificate revocation list does not require the use of HTTPS and can be configured to use HTTP.

Providing MAC Addresses for Android 6 Devices

The MAC address is not provided by Android 6 and later devices. Instead, it must be provided in the captive
portal redirect. When an Aruba controller is used, we strongly recommend that you enable the URL hash to
prevent tampering.

Network Architecture for Onboard
The high-level network architecture for the Onboard solution is shown in the following figure.

Figure 54 ClearPass Onboard Network Architecture

The sequence of events shown in Figure 54 is:

1. Users bring their own device to the enterprise.

2. The ClearPass Onboard workflow is used to provision the user’s device securely and with a minimum of user
interaction.

3. After it is provisioned, the device re-authenticates to the network using a set of unique device credentials.
These credentials uniquely identify the device and user and enable management of provisioned devices.

4. Administrators can configure all aspects of the provisioning workflow – including the devices that have been
provisioned, policies to apply to devices and the overall user experience for BYOD.

A more detailed view of the network architecture is shown in Figure 55. This diagram shows different types of
client devices using the Onboard workflow to gain access to the network. Some of the components that may
be configured by the network administrator are also shown.

ClearPass Guest 6.7 | User Guide Onboard | 108
Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2237



109 | Onboard ClearPass Guest 6.7 | User Guide

Figure 55 Detailed View of the ClearPass Onboard Network Architecture

The components shown in Figure 55 are:

1. Users bring different kinds of client devices with them. Onboard supports “smart devices” that use the iOS
or Android operating systems, such as smartphones and personal tablets. Onboard also supports the most
common versions of Windows and macOS operating systems found on desktop computers, laptops, and
netbooks.

2. The Onboard workflow is used to provision the user’s device securely and with a minimum of user
interaction. The provisioning method used depends on the type of device.

a. Newer versions of macOS (10.7 and later) and iOS devices use the “over-the-air” provisioning method.

b. Other supported platforms use the “Onboard provisioning” method.

3. After it is provisioned, a client device uses a secure authentication method based on 802.1X and the
capabilities best supported by the device.

a. The unique device credentials issued during provisioning are in the form of an EAP-TLS client certificate
for iOS devices and macOS (10.7+) devices.

b. Other supported devices are also issued a client certificate, but will use the PEAP-MSCHAPv2
authentication method with a unique username and strong password.

4. Administrators can manage all Onboard devices using the certificate issued to that device.

Network Architecture for Onboard when Using ClearPass Guest

ClearPass Guest supports the provisioning, authentication, and management aspects of the complete Onboard
solution. Figure 56 shows the high-level network architecture for the Onboard solution when using ClearPass
Guest as the provisioning and authentication server.
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Figure 56 ClearPass Onboard Network Architecture when Using ClearPass Guest

The user experience for device provisioning is the same in Figure 56 and Figure 54, however there are
implementation differences between these approaches.

The ClearPass Onboard Process
This section provides provisioning process overviews for different device types. It includes the following:

l "Devices Supporting Over-the-Air Provisioning" on page 111

l "Devices Supporting Onboard Provisioning" on page 113
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Devices Supporting Over-the-Air Provisioning
ClearPass Onboard supports secure device provisioning for iOS 4, iOS 5, iOS 6, and recent versions of macOS
(10.7 “Lion” and later). These are collectively referred to as “iOS devices”. The Onboard process for iOS devices
is shown in Figure 57.

Figure 57 Onboard Process for iOS Devices

The Onboard process is divided into three stages:

1. Pre-provisioning. The enterprise’s root certificate is installed on the iOS device.

2. Provisioning. The user is authenticated at the device provisioning page and then provisions their device
with the Onboard server. The device is configured with appropriate network settings and a device-specific
certificate.

3. Authentication. After configuration is complete, the user switches to the secure network and is
authenticated using an EAP-TLS client certificate.

A sequence diagram showing the interactions between each component of this workflow is shown in Figure 58.
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Figure 58 Sequence Diagram for the Onboard Workflow on iOS Platform

1. When a BYOD device first joins the provisioning network it does not have a set of unique device credentials.
This will trigger the captive portal for that device, which brings the user to the mobile device provisioning
page.

2. A link on the mobile device provisioning page prompts the user to install the enterprise’s root certificate.
Installing the enterprise’s root certificate enables the user to establish the authenticity of the provisioning
server during device provisioning.

3. The user then authenticates with their provisioning credentials – these are typically the user’s enterprise
credentials from Active Directory. If the user is authorized to provision a mobile device, the over-the-air
provisioning workflow is then triggered (see Figure 59, below).

4. After provisioning has completed, the device switches to EAP-TLS authentication using the newly
provisioned client certificate. Mutual authentication is performed (the authentication server verifies the
client certificate, and the client verifies the authentication server’s certificate).

5. The device is now onboarded and is able to securely access the provisioned network.

Over-the-air provisioning is used to securely provision a device and configure it with network settings. Figure
59 shows a sequence diagram that explains the steps involved in this workflow.
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Figure 59 Over-the-Air Provisioning Workflow for iOS Platform

1. The only user interaction required is to accept the provisioning profile. This profile is signed by the Onboard
server, so that the user can be assured of its authenticity.

2. An iOS device will have two certificates after over-the-air provisioning is complete:

a. A Simple Certificate Enrollment Protocol (SCEP) certificate is issued to the device during the provisioning
process. This certificate identifies the device uniquely, and is used to encrypt the device configuration
profile so that only this device can read its unique settings.

b. A Transport Layer Security (TLS) client certificate is issued to the device. This certificate identifies the
device and the user that provisioned the device. It is used as the device’s network identity during EAP-
TLS authentication.

Devices Supporting Onboard Provisioning

ClearPass Onboard supports secure device provisioning for Microsoft Windows Vista, Microsoft Windows 7,
Apple macOS 10.5 and 10.6, and Android devices (smartphones and tablets). These are collectively referred to
as “Onboard-capable devices”. The Onboard process for these devices is shown in Figure 60.
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Figure 60 ClearPass Onboard Process for Onboard-Capable Devices

The Onboard process is divided into three stages:

1. Pre-provisioning. This step is only required for Android devices; the Aruba QuickConnect app must be
installed for secure provisioning of the device.

2. Provisioning. The device provisioning page detects the device type and downloads or starts the
QuickConnect app. The app authenticates the user and then provisions their device with the Onboard
server. The device is configured with appropriate network settings and credentials that are unique to the
device. See Figure 61 for details.

3. Authentication. After configuration is complete, the user switches to the secure network and is
authenticated using PEAP-MSCHAPv2 unique device credentials.
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Figure 61 Sequence Diagram for the Onboard Workflow on Android Platform

1. When a BYOD device first joins the network it does not have a set of unique device credentials. This will
trigger the captive portal for that device, which brings the user to the mobile device provisioning page.

2. The Onboard portal is displayed. The user’s device type is detected, and a link is displayed depending on the
device type:

a. For Android devices, the link is to a file containing the Onboard configuration settings; downloading this
file will launch the QuickConnect app on the device.

b. For Windows and Mac, the link is to a executable file appropriate for that operating system that includes
both the QuickConnect app and the Onboard configuration settings.

3. The QuickConnect app uses the Onboard provisioning workflow to authenticate the user and provision
their device with the Onboard server. The device is configured with appropriate network settings and
credentials that are unique to the device.

4. After provisioning has completed, the app switches the device to PEAP authentication using the newly
provisioned unique device credentials. Mutual authentication is performed (the authentication server
verifies the client’s username and password, and the client verifies the authentication server’s certificate).

5. The device is now onboarded and is able to securely access the network.
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The Onboard provisioning workflow is used to securely provision a device and configure it with network
settings. Figure 62 shows a sequence diagram that explains the steps involved in this workflow.

Figure 62 Onboard Provisioning Workflow in the QuickConnect App

Configuring the User Interface for Device Provisioning
The user interface for device provisioning can be customized in three different ways:

l Customizing the Web login page used for device provisioning.

All devices will reach the device provisioning Web login page as the first step of the provisioning process. See
"Configuring Provisioning Settings for the Web Login Page" on page 232 to make changes to the content or
formatting of this page.

l Customizing the properties of the device provisioning profile for iOS and macOS devices.

After starting the provisioning process, users of iOS and macOS are prompted to accept a configuration
profile. See "About Configuring Provisioning Settings " on page 224 to make changes to the content of this
profile.

l Customizing the user interface of the QuickConnect app for Windows, macOS, and Android devices.

The provisioning process for Windows, macOS, and Android devices uses a separate app, which has a
customizable user interface. See "Configuring Options for Onboard Client Devices" on page 264 to make
changes to the user interface.

Using the {nwa_mdps_config} Template Function

Certain properties can be extracted from the Onboard configuration and used in the device provisioning page.
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To obtain these properties, use the {nwa_mdps_config} Smarty template function. The “name” parameter
specifies which property should be returned, as described in Table 30.

Name Description

root_cert URL of the Onboard Certificate Authority’s root certificate.
Browsing to this URL will install the root certificate on the device, which is required
as part of the pre-provisioning step.
Example:
<a href="{nwa_mdps_config name=root_cert}"> Install

Onboard root certificate</a>

wifi_ssid Name of the wireless network. See "Configuring Basic Network Access Settings "
on page 169.
Example:
Connect to the network named {nwa_mdps_config name=wifi_ssid}

organization_name The organization name. See "Configuring General Provisioning Settings" on page
225.
Example:
<h2> Welcome to {nwa_mdps_config name=organization_name}

</h2>

Table 30: Properties Available with the (nwa_mdps_config Smarty Template Function

Onboard Troubleshooting
If you encounter a problem that is not listed here, refer to the "Onboard Deployment Checklist " on page 100
and check each of the configuration steps listed there.

iOS Device Provisioning Failures

Symptom: Device provisioning fails on iOS with the message “The server certificate for https://… is invalid”.
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Figure 63 “Server certificate... invalid” Message on the Device Enrollment Form

Resolution: If you use HTTPS for device provisioning, you must obtain a commercial SSL certificate.

Self-signed SSL certificates, and SSL server certificates that have been issued by an untrusted or unknown root
Certificate Authority, will cause iOS device provisioning to fail with the message “The server certificate for … is
invalid”.

A workaround for this issue is to install an appropriate root certificate on the iOS device. This root certificate
must be the Web server’s SSL certificate (if it is a self-signed certificate), or the Certificate Authority that issued
the SSL certificate. This is not recommended for production deployments as it increases the complexity of
deployment for users with iOS devices.

Hostname-to-Certificate Match Failures

Symptom: Device provisioning fails with the message "Onboard provisioning cannot be performed at this
address. If you were directed here, please contact a network administrator."

This occurs if the hostname used to access ClearPass does not match the hostname configured in the ClearPass
appliance’s certificate. These items must match or device provisioning will fail. This error is detected by
Onboard and results in the above message.

Resolution: To correct the problem, ensure that the DNS is correctly configured for the server, ensure that the
hostname is correctly set, and ensure that the server's certificate contains the correct hostname.
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Onboard Interface Not Displayed

If Onboard is not visible in the ClearPass Guest user interface, verify whether Public Facing Enterprise (PFE)
mode is set in ClearPass Policy Manager. If PFE mode is enabled, Onboard is not permitted and Onboard
licenses cannot be added. The PFE mode is enabled or disabled in ClearPass on the Mode tab at
Administration > Server Manager > Server Configuration > Cluster-Wide Parameters.

Certificate Authorities

You can create and manage multiple Certificate Authorities for Onboard. To view and work with the list of
Certificate Authorities and to configure new Certificate Authorities, go to Onboard > Certificate Authorities.
The Certificate Authorities list view opens. All Certificate Authorities that have been set up are included in
the list. Information shown for each Certificate Authority includes its name, mode, status, expiration time, and
OCSP URL.

Figure 64 The Certificate Authorities List View

You can click a Certificate Authority's row in the list for additional options:

Option Description

Show
Details

Displays details for the Certificate Authority. The form expands to show a summary of the settings
defined for it, including information for certificate issuing, retention policy, identity, private key, and
self-signed certificate.

Edit Lets you edit any of a Certificate Authority's attributes and configure certificate issuing options on
the Certificate Authority Settings form. See "Editing Certificate Authority Settings" on page 126.

Duplicate Lets you create a copy of a Certificate Authority configuration to use as a basis for a new Certificate
Authority. The first page of the Certificate Authority Settings form opens with the identity, private
key, and self-signed certificate attributes prepopulated and "Copy" appended to the name. You can
rename the new Certificate Authority and edit any of its attributes.

Delete Deletes the Certificate Authority. You will be asked to confirm the deletion.

Show
Usage

Lets you verify whether the Certificate Authority is currently used. The form expands to show a list of
provisioning sets that use the Certificate Authority.

Trust
Chain

Displays the trust chain for the Certificate Authority on the Certificate Authority Trust Chain page.
See "The Trust Chain and Uploading Certificates for the CA " on page 135.

Table 31: Options in the Certificate Authorities List View
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Option Description

Certificates Displays a list of certificates associated with the Certificate Authority on the Certificate
Management page. See "Certificate Management (View by Certificate) " on page 149.

Renew Renews the Certificate Authority. If it is an intermediate Certificate Authority, the Intermediate
Certificate Renewal page opens, where you can send a certificate signing request; see "Requesting
a Certificate for the Certificate Authority" on page 133. If it is a root Certificate Authority, the row
expands to include the Root Certificate Renewal option. Click the Renew Root Certificate button.

Renewing the certificate uses the same private key for the root certificate, but reissues the root CA
certificate with an updated validity period. This will maintain the validity of all certificates issued by
the CA. When you renew a certificate, you should distribute a new copy of the root certificate to all
users of that certificate.

Delete
Client
Certificates

Deletes a Certificate Authority's client certificates. The row expands to include the Delete Client
Certificates form. To confirm the deletion, you must mark the Reset the specified items check
box in the Confirm Reset field, and then click the Delete Client Certificates button. Doing so will
permanently delete all client certificates for the Certificate Authority. This action cannot be reversed.

Create new
certificate
authority

To create a new Certificate Authority, click this link in the upper right corner. The initial setup page of
the Certificate Authority Settings form opens. See the next section, "Creating a New Certificate
Authority" on page 120.

Table 31: Options in the Certificate Authorities List View(Continued)

Creating a New Certificate Authority
The first page of the Certificate Authority Settings form is used to create the Onboard Certificate Authority
(CA) and to configure some basic properties:

l Give it a name and description

l Specify root CA, intermediate CA, local CA, or Registration Authority (RA) mode

l Configure the identity, private key, and self-signed certificate attributes

To create an Onboard Certificate Authority, go to Onboard > Certificate Authorities, and then either click
the Duplicate link for a Certificate Authority in the Certificate Authorities list or click the Create new
certificate authority link. The initial setup page of the Certificate Authority Settings form opens.
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Figure 65 Mode Options on the Certificate Authority Settings Form

Field Description

Name Short name that clearly identifies the Certificate Authority. Certificate Authority names can include
spaces. If you are duplicating a CA, the original name has "Copy" appended to it. You may highlight
the name and replace it with a new name.

Description You may include a brief description of the CA. This description is shown in the Certificate
Authorities list.
The Name and Description fields are used internally to identify this Certificate Authority for the
network administrator. These values are never displayed to the user during device provisioning.

Mode Specifies the type of Certificate Authority:

Table 32: Certificate Authority Settings Form, Basic and Mode Areas
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Field Description

l Root CA—The Onboard Certificate Authority issues its own root certificate. The Certificate
Authority issues client and server certificates using a local signing certificate, which is an
intermediate CA that is subordinate to the root certificate. Use this option when you do not have
an existing public-key infrastructure (PKI), or if you want to completely separate the certificates
issued for Onboard devices from your existing PKI.

l Intermediate CA—The Onboard Certificate Authority is issued a certificate by an external
Certificate Authority. The Onboard Certificate Authority issues client and server certificates using
this certificate. Use this option when you already have a public-key infrastructure (PKI), and would
like to include the certificate issued for Onboard devices in that infrastructure.

l Imported CA— If you choose Imported CA, the following fields are removed from the form. If
you choose Root or Intermediate, complete the following fields.

l Registration Authority — Onboard is used as the Registration Authority (RA). Instead of issuing
certificates, Onboard will proxy a certificate request to another Certificate Authority (CA) via
SCEP. Only client certificates are stored locally.

Table 32: Certificate Authority Settings Form, Basic and Mode Areas(Continued)

Figure 66 The Identity Area
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Field Description

Country Two-letter ISO country code for your organization. This value forms part of the distinguished
name for the certificate.

State Full name of the state or province for your organization. This value forms part of the
distinguished name for the certificate.

Locality Name of the town or city where your organization is located. This value forms part of the
distinguished name for the certificate.

Organization Name of your organization. This value forms part of the distinguished name for the certificate.

Organizational
Unit

(Optional) Name of your organizational unit (section or division of the organization). This value
forms part of the distinguished name for the certificate.

Common
Name

Descriptive name for the certificate. This value is used to identify the certificate as the issuer of
other certificates, notably the signing certificate.

Signing
Common
Name

(Included for root certificates) Descriptive name for the signing certificate. This value is used to
identify the signing certificate as the issuer of client and server certificates from this Certificate
Authority. The other identity information in the signing certificate will be the same as for the root
certificate.

Email Address Contact email address. This email address is included in the root and signing certificates, and
provides a way for users of the certificate authority to contact your organization.

Table 33: Certificate Authority Settings Form, Identity Area

Figure 67 The Private Key and Self-Signed Certificates Areas
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Field Description

Key Type Specify the type of private key that should be created for the certificate:
l 1024-bit RSA (Not recommended for a root certificate. Not available in FIPS mode.)
l 2048-bit RSA (Recommended for general use.)
l 4096-bit RSA (Higher security.)
l X9.62/SECG curve over a 256-bit prime field
l NIST/SECG curve over a 384-bit prime field

CA
Expiration

(Included for root certificates) Specifies the lifetime of the root certificate in days. The default value is
365 days.

Digest
Algorithm

Specifies which hash algorithm should be used to sign the digital certificate request. Options include:
l SHA-1 (not recommended)
l SHA-224
l SHA-256
l SHA-384
l SHA-512 (Default)

Create
Certificate
Authority

Creates the Certificate Authority:
l If you selected root mode, the root certificate is included in the Certificate Authorities list.
l If you selected intermediate mode, the Intermediate Certificate Request page opens with text

for the certificate signing request (CSR). You can send the CSR to a Certificate Authority, who will
generate a signed certificate you can install. See "Requesting a Certificate for the Certificate
Authority" on page 133.

l If you selected imported mode, the Certificate Authority Certificate Import form opens, where
you can upload the digital certificates and private key to the server. See"Installing a Certificate
Authority’s Certificate " on page 133.

Table 34: Certificate Authority Settings Form, Private Key and Self-Signed Certificates Areas

Figure 68 The Registration Authority Area
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Field Description

SCEP URL URL of the SCEP server that will act as the Certificate Authority (CA) for this Registration
Authority.

SCEP Challenge
Password

Shared secret for the SCEP Certificate Authority, used for generating the Registration Authority
certificate. If the SCEP server will not enforce a challenge password, leave this field empty.

Confirm SCEP
Challenge
Password

CRL URL URL of the Certificate Revocation List (CRL) for the Certificate Authority. If a URL is entered in
this field, Onboard will synchronize the revocation status of certificates.

Fetch CA
Certificate

The form expands to show the CA certificate details and additional fields for confirming the
certificate and customizing the certificate subject.

Confirm CA
Certificate

if selected, validates that the certificate is the trusted certificate for your Certificate Authority.

Details Displays the details of the certificate.

Certificate
Subject

if selected, the form expands to include options for modifying the subject fields of the
certificates used for the SCEP protocol.

Certificate
Subject

if selected, the form expands to include options for modifying the subject fields of the
certificates used for the SCEP protocol.

SCEP Client, SCEP Signing, and SCEP Encryption Areas

Country Two-letter ISO country code for your country.

State Full name of your state or province.

Locality Name of your city or town.

Organization Name of your company or organization.

Organizational
Unit

Name of your organizational unit (the section or division or your company).

Common Name Name for the certificate. This will be the common name of the digital certificate.

Email Address Enter an email address.

Create
Certificate
Authority

Creates the certificate authority. The RA certificate is included in the Certificate Authorities
list.

Table 35: Certificate Authority Settings Form, Registration Authority Area

After you have configured the SCEP-RA certificate, you may specify the CA to use for TLS certificates
independently of the CA used for enrollment by using the SCEP-RA option in the TLS Certificate Authority
and Certificate Authority fields on the Provisioning Settings form. For more information, see "Configuring
General Provisioning Settings" on page 225.
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Editing Certificate Authority Settings
You can edit some properties of a Certificate Authority after you create it, and configure some attributes that
were not included on the setup form.

To edit a Certificate Authority, go to Onboard > Certificate Authorities, click the certificate to expand its
row, and click its Edit link. The Certificate Authority Settings form opens.

In the basic information area at the top of the form, the Name and Description fields are used internally to
identify this Certificate Authority for the network administrator. These values are never displayed to the user
during device provisioning.

Figure 69 The Certificate Authority Settings Form, Basic Information Area

Field Description

Name Short name that identifies the certificate clearly. Certificate Authority names can include spaces.

Description Briefly describes the CA. This description is shown in the Certificate Authorities list.

Mode Either Root CA, Intermediate CA, Imported CA, or Registration Authority. The certificate's mode
cannot be edited after creation.

Table 36: Edit Certificate Authority Settings Form, Basic and Mode Areas

In the Certificate Issuing area:

Figure 70 The Certificate Authority Settings Form, Certificate Issuing Area
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Authority
Info Access

Specify one of the following options to control automatic certificate revocation checks:
l Do not include OCSP responder URL – The Authority Info Access extension is not included in

the client certificate. Certificate revocation checking must be configured manually on the
authentication server. This is the default option.

l Include OCSP responder URL – The Authority Info Access extension is added to the client
certificates, with the OCSP responder URL set to a predetermined value. This value is displayed
as the “OCSP URL”.

l Specify an OCSP responder URL – The Authority Info Access extension is added to the client
certificates, with the OCSP responder URL set to a value defined by the administrator. This value
may be specified in the “OCSP URL” field.

Validity
Period

Specifies the maximum length of time for which a client certificate issued during device provisioning
will remain valid.

Clock Skew
Allowance

Adds a small amount of time to the start and end of the client certificate’s validity period. This
permits a newly issued certificate to be recognized as valid in a network where not all devices are
perfectly synchronized.

For example, if the current time is 12:00 and the clock skew allowance is set to the default value of 15
minutes, then the client certificate will be issued with a “not valid before” time of 11:45. In this case, if
the authentication server that receives the client certificate has a time of 11:58, it will still recognize
the certificate as valid. If the clock skew allowance was set to 0 minutes, then the authentication
server would not recognize the certificate as valid until its clock has reached 12:00.

The default of 15 minutes is reasonable. If you expect that all devices on the network will be
synchronized, then the value may be reduced. A setting of 0 minutes is not recommended as this
does not permit any variance in clocks between devices.

When issuing a certificate, the certificate’s validity period is determined as follows:
l The “not valid before” time is set to the current time, less the clock skew allowance.
l The “not valid after” time is first calculated as the earliest of the following:

n The current time, plus the maximum validity period.
n The expiration time of the user account for whom the device certificate is being issued.

l The “not valid after” time is then increased by the clock skew allowance.

Subject
Alternative
Name

To include additional fields in the TLS client certificate issued for a device, mark the Include device
information in TLS client certificates check box. These fields are stored in the subject alternative
name (subjectAltName) of the certificate. Refer to Table 38 for a list of the fields that are stored in
the certificate when this option is enabled.

Storing additional device information in the client certificate allows for additional authorization
checks to be performed during device authentication.

Digest
Algorithm

Algorithm used to sign issued certificates.

Table 37: Edit Certificate Authority Settings Form, Certificate Issuing Area

If you are using an Aruba controller to perform EAP-TLS authentication using these client certificates, you must have
ArubaOS 6.1 or later to enable the Subject Alternative Name option and store device information in the subject
alternative name.
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Name Description OID

Device ICCID Integrated Circuit Card Identifier (ICCID) number from the
Subscriber Identity Module (SIM) card present in the device. This is
only available for devices with GSM (cellular network) capability,
where a SIM card has been installed.

mdpsDeviceIccid (.4)

Device IMEI International Mobile Equipment Identity (IMEI) number allocated to
this device. This is only available for devices with GSM (cellular
network) capability.

mdpsDeviceImei (.3)

Device Serial Serial number of the device. mdpsDeviceSerial (.9)

Device Type Type of device, such as “iOS”, “Android”, etc. mdpsDeviceType (.1)

Device UDID Unique device identifier (UDID) for this device. This is typically a
64-bit, 128-bit or 160-bit number represented in hexadecimal (16,
32, or 40 characters, respectively).

mdpsDeviceUdid (.2)

MAC Address IEEE MAC address of this device. This element may be present
multiple times, if a device has more than one MAC address (for
example, an Ethernet port and a Wi-Fi adapter).

mdpsMacAddress (.5)

Product Name Product string identifying the device and often including the
hardware version information.

mdpsProductName (.6)

Product Version String containing the software version number for the device. mdpsProductVersion (.7)

User Name String containing the username of the user who provisioned the
device.

mdpsUserName (.8)

Table 38: Device Information Stored in TLS Client Certificates

In the Retention Policy area:

Figure 71 The Certificate Authority Settings Form, Retention Policy Area

Field Description

Maximum
Period

Specify values that are appropriate for your organization’s retention policy. The default data
retention policy specifies a maximum period of 52 weeks.

Store
Certificates

If selected, a copy of the issued certificate is stored. If this check box is not selected, only metadata
about the certificate is stored.

Table 39: Edit Certificate Authority Settings Form, Retention Policy Area
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To enable the Delete Certificate and Delete Request actions in the Certificate Management list view, use a blank
value for Minimum Period. This is useful for testing and initial deployment.

In the SCEP Server area:

Figure 72 The Certificate Authority Settings Form, SCEP Server Area

Onboard may be used as a CA with third-party products that use Simple Certificate Enrollment Protocol (SCEP)
to enroll certificates.

Field Description

SCEP Server If selected, enables access to the SCEP server. The form expands to include SCEP server
configuration options.

SCEP URL Shows the URL for this SCEP server.

SCEP Secret (Required) Enter the shared secret that SCEP clients must supply.

Allowed
Access

Enter the IP addresses and networks from which logins are permitted. (IPv4 and IPv6 are both
supported)

Denied
Access

Enter IP addresses and networks that are denied login access. (IPv4 and IPv6 are both supported)

Table 40: Edit Certificate Authority Settings Form, SCEP Server Area
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In the EST Server area:

Figure 73 The Certificate Authority Settings Form, EST Server Area

Onboard may be used as a CA with third-party products that use the Enrollment over Secure Transport (EST)
protocol to enroll certificates.
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Field Description

EST Server If selected, enables access to the EST server. The form expands to include EST server
configuration options.

EST URL Shows the URL for this EST server.

EST Auth Method Specifies the method for authenticating EST requests. Options include:
l Shared Secret
l HTTP Basic or Digest Authentication

EST Secret Enter the shared secret that EST clients must supply.

Allowed Access Enter the IP addresses and networks from which logins are permitted. (IPv4 and IPv6 are
both supported)

Denied Access Enter IP addresses and networks that are denied login access. (IPv4 and IPv6 are both
supported)

EST Key Type Specifies the type of private key EST clients should generate. Options include:
l 1024-bit RSA (Not available for FIPS mode)
l 2048-bit RSA
l 4096-bit RSA
l X9.62/SECG curve over a 256 bit prime field
l NIST/SECG curve over a 384 bit prime field

EST Digest
Algorithm

Specifies the digest algorithm EST clients should use for CSRs. Options include:
l SHA-1
l SHA-224
l SHA-256
l SHA-384
l SHA-512

Identity The information in these fields cannot be edited after creation.

Private Key

Self-Signed
Certificate

Table 41: Edit Certificate Authority Settings Form, EST Server Area
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In the Registration Authority area:

Figure 74 The Certificate Authority Settings Form, Registration Authority Area

Field Description

SCEP URL (Required) Shows the URL of the SCEP server that will act as the Certificate Authority
for this Registration Authority.

SCEP Challenge Password Shared secret for the SCEP CA used to generate the RA certificate.
If the SCEP server does not enforce a challenge password, leave this field empty.

Confirm SCEP Challenge
Password

Details Displays the certificate details such as the data and signature algorithm. This field
cannot be edited after creation.

Confirm CA Certificate if selected, validates that the certificate is the trusted certificate for your Certificate
Authority.

CRL URL URL of the Certificate Revocation List for the Certificate Authority. If this is supplied
here, Onboard will synchronize the revocation status of certificates.

SCEP Client, SCEP Signing, and SCEP Encryption Areas

Country Two-letter ISO country code for your country.

State Full name of your state or province.

Locality Name of your city or town.

Organization Name of your company or organization.

Table 42: Edit Certificate Authority Settings Form, Registration Authority Area
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Field Description

Organizational Unit Name of your organizational unit (the section or division or your company).

Common Name Name for the certificate. This will be the common name of the digital certificate.

Email Address Enter an email address.

Save Changes Saves your changes and creates the certificate authority. The RA certificate is
included in the Certificate Authorities list.

When you are done, click Edit Certificate Authority to complete your changes.

Requesting a Certificate for the Certificate Authority
The Intermediate Certificate Request page displays the certificate signing request for the Certificate
Authority’s intermediate certificate.

You can copy the certificate signing request in text format using your Web browser. Use this option when you
can paste the request directly into another application to obtain a certificate.

You can click the Download the current CSR link to download the certificate signing request as a file. Use
this option when you need to provide the certificate signing request as a file to obtain a certificate.

After you have obtained the certificate, click the Install a signed certificate link to continue configuring
the intermediate Certificate Authority. See "Installing a Certificate Authority’s Certificate " on page 133.

You can also click the Change CA settings link to return to the main Certificate Authority Settings
form. Use this option to switch to a root CA, or to change the name or properties of the intermediate CA and
reissue the certificate signing request.

Installing a Certificate Authority’s Certificate
You can import a private key and certificate pair to use for the root certificate or intermediate certificate. The
CA Certificate Import page may be used to:

l Upload a certificate that has been issued by another Certificate Authority. This process is required when
configuring an intermediate Certificate Authority.

n A private key is not required, as the Certificate Authority has already generated one and used it to create
the certificate signing request.

l Upload a certificate and private key to be used as the Certificate Authority’s certificate. This process may be
used to configure a root Certificate Authority.

n A private key is required, as the Certificate Authority’s existing private key will be replaced.

This form may be used multiple times in order to import each of the certificates in the trust chain. Check the
message displayed above the form to determine which certificate or type of file must be uploaded next.

To upload a certificate:

1. On either the Certificate Management or Intermediate Certificate Settings page, click the Import
Certificate link above the form. The Step 1 area of the CA Certificate Import form opens.
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Figure 75 The CA Certificate Import Form, Step 1

2. Select one of the radio buttons to either copy and paste the certificate as encoded text or browse to the file
to upload. The form expands to include options for that method.

3. If you selected Copy and paste certificate as text:

l To upload a single certificate, copy and paste the certificate into the Certificate text field. The text must
include the “BEGIN CERTIFICATE” and “END CERTIFICATE” lines. Leave the passphrase fields blank.

l To upload a certificate and private key, copy and paste the certificate and private key into the
Certificate text field. The text must include the “BEGIN CERTIFICATE” and “END CERTIFICATE” lines, as
well as the “BEGIN RSA PRIVATE KEY” and “END RSA PRIVATE KEY” lines.

Figure 76 The CA Certificate Import Form, Step 2

4. If you selected Upload certificate file, click Choose File in the Certificate row to browse to the file and
select it.

l To upload a single certificate, choose a certificate file in PEM (base-64 encoded) or binary format (.crt or
PKCS#7). Leave the passphrase fields blank.
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l To upload a certificate’s private key as a separate file, choose the private key file in PEM (base-64
encoded) format. If the private key has a passphrase, enter it in the Private Key Passphrase and
Confirm Passphrase fields. The private key will be automatically matched to its corresponding
certificate when uploaded.

l To upload a combined certificate and private key, choose a file in either PEM (base-64 encoded) or
PKCS#12 format. If the private key has a passphrase, enter it in the Private Key Passphrase and
Confirm Passphrase fields.

Figure 77 The CA Certificate Import Form, Step 3

5. Click Upload Certificate to save your changes.

If additional certificates are required, you will remain at the same page. Check the message displayed above the
form to determine which certificate or type of file must be uploaded next. When the trust chain is complete, it
will be displayed. This completes the initialization of the certificate authority.

The Trust Chain and Uploading Certificates for the CA

The Certificate Authority Trust Chain page is used to view the Certificate Authority’s current trust chain, or
to upload a new certificate in the trust chain when configuring a Certificate Authority.

Viewing the Trust Chain

To view the Certificate Authority’s trust chain, go to Onboard > Certificate Authorities and click the Trust
Chain link for a certificate in the list. The Certificate Authority Trust Chain page opens. This page shows a
graphical representation of the certificates that make up the trust chain.
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Figure 78 The Certificate Authority Trust Chain Page

The first certificate listed is the root certificate. Root certificates are always self-signed and are explicitly trusted
by clients.

Each additional certificate shown is an intermediate certificate. The last certificate in the list is the signing
certificate that is used to issue client and server certificates.

For RADIUS certificates that are not self-signed, only the chain (root and intermediate certificates) is pushed to
the user’s device, and not the certificate itself. This avoids the need to reprovision when the certificate expires.
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Viewing Certificate Properties

To view the properties of a certificate in the trust chain, click the Show certificate link. The Certificate
Information view opens.

Figure 79 The Certificate Information View

Exporting the Certificate

To export a certificate:

1. Click the Download Bundle link on the Certificate Authority Trust Chain page. The Export Certificate
form opens.
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Figure 80 The Export Certificate Form

2. In the Format row, choose the certificate format. The form expands to include configuration options for
that format.

3. Complete the fields with the appropriate information, and then click Export Certificate.

Considerations for iOS Devices

The server certificate is used by ClearPass to secure Web (HTTPS) and authentication (RADIUS) traffic. It can be
configured in ClearPass Policy Manager under Administration > Certificates > Server Certificate.

The optimal configuration for Onboard is a server certificate issued by a trusted commercial Certificate
Authority. A list of Certificate Authorities trusted by iOS devices can be found at
http://support.apple.com/kb/HT5012.

Alternatively, if you only wish to use a single Onboard Certificate Authority, then you can use that Certificate
Authority to sign the server certificate. Users will then have to install the certificate as part of the provisioning
process.

For testing purposes, you can disable the requirement for HTTPS on the Policy Manager > Configuration
> Authentication page; however, this is an insecure configuration that should not be used in a production
environment.

Using Microsoft Active Directory Certificate Services
To use Microsoft Active Directory Services:

1. Go to the Microsoft Active Directory Certificate Services Web page. This page is typically found at
https://<yourdomain>/certsrv/. The Welcome page opens.
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Figure 81 The Welcome Page

2. Click the Request a Certificate link on this page. The Request a Certificate page opens.

Figure 82 The Request a Certificate Page

3. Click the link to submit an advanced certificate request. The Advanced Certificate Request page
opens.

Figure 83 The Advanced Certificate Request Page

4. Click the link to submit a request using a base-64-encoded CMC or PKCS #10 file. The Submit a
Certificate Request or Renewal Request page is displayed.
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Figure 84 The Submit a Certificate Request or Renewal Request Page

5. Copy and paste the certificate signing request text into the Saved Request text field.

6. Because this certificate is for a Certificate Authority, select Subordinate Certificate Authority in the
Certificate Template drop-down list.

7. Click the Submit button to issue the certificate. Either the Certificate Pending or the Certificate Issued
page is displayed.

Figure 85 The Certificate Pending Page

8. If the Certificate Pending page is displayed, follow the directions on the page to retrieve the certificate
when it is issued.
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Figure 86 The Certificate Issued Page

9. If the Certificate Issued page is displayed, select the Base 64 encoded option and then click the
Download certificate chain link. A file containing the intermediate certificate and the issuing certificates
in the trust chain will be downloaded to your system.

Refer to the instructions in "Installing a Certificate Authority’s Certificate " on page 133 for information on
uploading the certificate file to Onboard.

Management and Control

The Management and Control section in the Onboard navigation lets you view and manage devices and the
users and certificates associated with them, as well as the asset database of corporate devices. To access the
device management features, go to Onboard > Management and Control > Start Here.

l To view and manage your list of devices, see "Device Management (View by Device) " on page 141

l To view and manage the list of users associated with the devices, see "Device Management (View by
Username)" on page 146

l To view, create, and manage digital certificates for devices, servers, and certificate authorities, see
"Certificate Management (View by Certificate) " on page 149

Device Management (View by Device)

The Device Management (View by Device) page lists all devices and lets you manage the devices' access to
the network. For each device, you can allow or deny network access.

To work with the list of device users, see "Device Management (View by Username)" on page 146.

When a device is denied access, its certificates are revoked. For a device that has had its access denied, you can
grant access again, allowing it to re-enroll and obtain a new certificate.

To calculate license usage, Onboard considers the username in certificates created via EST or SCEP. Onboard
License usage is not counted per device. A single user with multiple devices consumes only one Onboard Application
License.
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To view the list of devices, go to Onboard > Management and Control > View by Device. The Device
Management (View by Device) list view opens. This list displays all currently provisioned devices.
Information shown for each device includes its device type, device name (operating system), device ID (MAC
address), user, the device's network access status, whether it is currently onboarded, and its MDM status.

You can can filter the list, and you can click a device's row in the list to show the available options. Depending
on the type of device, the available options might include configuration details, device details, show users,
access management, device actions, certificate details, and device deletion.

Figure 87 The Device Management (View by Device) List View

Field Description

Device
Type

Lets you filter by device type. Options include:
l All
l Android
l Chromebook
l External
l iOS
l macOS
l Ubuntu
l Windows
l Web

Status Lets you filter by status. Options include:
l All
l All Allowed
l Allowed - Enrolled
l Allowed - Not Enrolled
l Denied

Managed
By

The field lets you filter by management. Options include:
l All
l None

Table 43: The Device Management (View by Device) List View
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Field Description

Keywords You can use the field to filter by device type, device name, username, MAC address, or device UDID.

Show
Config

Lets you configure device details. In the Configuration form that opens, you can click the Default
Profile link to edit the device's configuration profile, or click the Local Device Provisioning link to
edit the device's provisioning settings. When you change the configuration profile here, all apps that
were previously pushed to the device are replaced with the apps in the new configuration profile.

Device
Details

Displays a summary of the device's details. The row expands to include the Device Details form.

Manage
Access

Lets you change a device's access status. In the Manage Access window that opens, use the drop-
down list in the Access field to select either Allow access to this device or Deny access to this
device. When you select the Deny option, a message advises you that any certificates associated
with it will be revoked. The device cannot be re-enrolled as long as access is denied. To re-enroll the
device, you must use this field to allow access again.

Device
Actions

Lets you delete all users. Select the Delete All Users check box, and then click Apply.

Table 43: The Device Management (View by Device) List View(Continued)
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Field Description

Certificates Displays certificate details and lets you revoke or delete all client certificates for the device. The
form expands to include both the Certificate Information view and the Manage Certificates form.
The Certificate Information view lets you review all details of the certificate:

Table 43: The Device Management (View by Device) List View(Continued)
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Field Description

The Manage Certificates form lets you revoke or delete all TLS client certificates issued to the
device. Mark the appropriate radio button, and then click Manage Certificates.

Table 43: The Device Management (View by Device) List View(Continued)
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Field Description

Delete
Device

Deletes the device. You will be asked to confirm the deletion. Deleting the device will also delete all
user, certificate, and other data associated with the device. Certificates are deleted according to the
Certificate Authority's retention policy. After a device is deleted, it can still access the network and
be reprovisioned. To deny network access for the device, use the Manage Access link instead.

Table 43: The Device Management (View by Device) List View(Continued)

Device Management (View by Username)

The Device Management (View by Username) page lists all users associated with devices. For each user,
you can:

l View and edit default configuration profile and provisioning settings

l View and manage all devices registered to the user

l Allow or deny network access for the user

l Delete all the user's devices

l Revoke or delete all TLS client certificates issued to the user

l Delete the user

To work with the list of devices, see "Device Management (View by Device) " on page 141.

To calculate license usage, Onboard considers the username in certificates created via EST or SCEP. Onboard
License usage is not counted per device. A single user with multiple devices consumes only one Onboard Application
License.

To view the list of users, go to Onboard > Management and Control > View by Username. The Device
Management (View by Username) list view opens. Information shown in this list for each user includes
username, network access status, number of devices, and number of onboarded devices.

You can filter the list by keywords, and you can click a user’s row in the list to show the available options. These
include configuration details, device information, access management, device actions, certificate actions, and
user deletion.
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Figure 88 The Device Management (View by Username) List View

Field Description

Keywords Lets you filter by username.

Show
Config

Lets you configure the user’s details. The row expands to include the Configuration form. You can
click the Default Profile link to edit the user's device configuration profile, or click the Local Device
Provisioning link to edit the user's local device provisioning settings.

Device
Details

Displays a list of the user's devices.

Certificates Displays details of certificates belonging to this user, and lets you revoke or delete all client
certificates issued to the user. The form expands to include both the Certificate Information view
and the Manage Certificates form.
The Certificate Information view lets you review all details of the certificate:

Table 44: The Device Management (View by Username) List View
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Field Description

The Manage Certificates form lets you revoke or delete all TLS client certificates issued to the user.
Mark the appropriate radio button, and then click Manage Certificates.

Table 44: The Device Management (View by Username) List View(Continued)
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Field Description

Delete
User

Deletes the user. You will be asked to confirm the deletion. Deleting the user will also delete all
devices, TLS client certificates, and other data associated with the user. Certificates are deleted
according to the Certificate Authority's retention policy.

Table 44: The Device Management (View by Username) List View(Continued)

Certificate Management (View by Certificate)

To view the list of certificates and work with them, go to Onboard > Management and Control > View by
Certificate. The Certificate Management list view opens. This list displays all of the certificates and
certificate requests in the Onboard system.

Figure 89 The Certificate Management (View by Certificate) List View

The default columns in the Certificate Management list provide information about the common name,
certificate authority, serial number (if available), certificate type, validity date range, and device type—iOS,
Android, Windows, or None (if not associated with a device type).

To calculate license usage, Onboard considers the username in certificates created via EST or SCEP. Onboard
License usage is not counted per device. A single user with multiple devices consumes only one Onboard Application
License.
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To display different columns, click the Columns link above the list view. The view expands to include the
Choose Columns form. You can select or deselect columns to change the way the Certificate Management
list view is displayed.

Figure 90 The Certificate Management View, Choose Columns Form

Table 45 lists the types of certificate that are displayed in the Certificate Management list view.

Certificate Type “Type” Column Notes

Root certificate ca Self-signed certificate for the Certificate
Authority

Intermediate certificate ca Issued by the root CA or another
intermediate CA

Certificate signing request tls-client or trusted The type shown depends on the kind of
certificate requested

Rejected certificate signing
request

tls-client or trusted Certificate request that was rejected due
to an administrator decision

Table 45: Types of Certificate Supported by Onboard Certificate Management
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Certificate Type “Type” Column Notes

Device certificate scep-client Issued to iOS and macOS (10.7+) devices
only

Client certificate tls-client Identity certificate issued to a specific
user’s device

Server certificate trusted Identity certificate issued to a server

Code-signing certificate ca Used for signing the Windows
provisioning application and iOS/macOS
profiles

Revoked certificate -- Certificate that has been administratively
revoked and is no longer valid

Expired certificate -- Certificate that is outside its validity
period and is no longer valid

HTTPS Certificate for HTTPS server certificates

l To create a new certificate, see "Creating a Certificate " on page 160.

l To search for certificates, see "Searching for Certificates in the List " on page 151.

l To work with your certificates, see "Working with Certificates in the List" on page 152.

l To work with certificate signing requests, see "Working with Certificate Signing Requests " on page 154.

l To import a code-signing certificate, see "Importing a Code-Signing Certificate " on page 158.

l To import a trusted certificate, see "Importing a Trusted Certificate " on page 159.

Searching for Certificates in the List
In the Certificate Management list, the Filter field can be used to quickly search for a matching certificate.
Type a username into this field to quickly locate all certificates matching that username.

The filter is applied to all columns displayed in the list view. To search by another field, such as MAC address,
device type, or device serial number, click the Columns tab, select the appropriate column(s), and then click
the Save and Reload button. The list view will refresh to update the results of the filter.

Click the Clear Filter link to restore the default view.

Use the paging control at the bottom of the list to jump forwards or backwards by one page, or to the first or
last page of the list. You can also click an individual page number to jump directly to that page.

When the list contains many thousands of certificates, consider using the Filter field to speed up finding a specific
certificate.

Click the column headers to sort the list view by that column. Click the column header a second time to reverse
the direction of the sort.
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Working with Certificates in the List
To work with a certificate in the Certificate Management list, go to Onboard > Management and Control
> View by Certificate and click a certificate in the list to select it. You can then select from View Certificate,
Export Certificate, Revoke Certificate, and Delete Certificate actions:

View Certificate

The View certificate link displays the properties of the certificate. Information includes certificate details,
issuer details, and the certificate's "fingerprint" or "thumbprint". In the Details row, you can click the Show link
to display advanced details, including such things as the version, serial number, signature algorithms, and
public key algorithms. SHA-512, SHA-384, SHA-256, and SHA-224 are supported as digest algorithms. Click the

Cancel button to close the certificate properties.

Export Certificate

Export certificate – Displays the Export Certificate form.

Figure 91 The Export Certificate Form

Use the Format drop-down list to select the format in which the certificate should be exported. The following
formats are supported:

l PKCS#7 Certificates (.p7b)—Exports the certificate, and optionally the other certificates forming the trust
chain for the certificate, as a PKCS#7 container.

l Base-64 Encoded (.pem)—Exports the certificate as a base-64 encoded text file. This is also known as
“PEM format”. You may optionally include the other certificates forming the trust chain for the certificate.

l Binary Certificate (.crt)—Exports the certificate as a binary file. This is also known as “DER format”.

l Open SSL Text Format—Exports the certificate as a full openssl text-format output, allowing you to view
advanced details such as X509v3 extensions. It also includes the certificate in .pem format appended to the
.txt file.

To protect against brute-force password attacks and ensure the security of the private key, you should use a strong
passphrase – one consisting of several words, mixed upper- and lower-case letters, and punctuation or other symbol
characters.

Click Export Certificate to download the certificate file in the selected format.
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Revoke Certificate

The Revoke certificate link displays the Revoke Certificate form.

Figure 92 The Revoke Certificate Form

Mark the Revoke this client certificate check box to confirm that the certificate should be revoked, and
then click Revoke Certificate.

After the certificate has been revoked, future checks of the certificate’s validity using OCSP or CRL will indicate
that the certificate is no longer valid.

Due to the way in which certificate revocation lists work, a certificate cannot be un-revoked. A new certificate must
be issued if a certificate is revoked in error.

Revoking a device’s certificate will cause the device to be unable to authenticate. It will not prevent it from being re-
provisioned. If you wish to deny access to a device, use the Manage Access link in the device's row on the
Management and Control > View by Device form.
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Delete Certificate

The Delete certificate link removes the certificate from the list. Certificates can be deleted even if they are
still valid. This will have the effect of revoking them at the same time as deleting them.

Figure 93 The Delete Certificate Form

The Delete Certificate form is displayed. Mark the Delete this client certificate check box to confirm the
certificate’s deletion, and then click Delete Certificate.

Working with Certificate Signing Requests

Certificate signing requests can be managed through the Certificate Management list view at Onboard
> Management and Control > View by Certificate. This allows server certificates, subordinate Certificate
Authorities, and other client certificates not associated with a device to be issued by the Onboard Certificate
Authority.

Click a certificate request to select it. You can then select from the View Request, Export Request, Sign
Request, Reject Request, and Delete Request actions:

View Request

The View request link displays the properties of the certificate request. Click Cancel to close the
certificate request properties.
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Export Request

The Export request link displays the Export Certificate Request form.

Figure 94 The Export Certificate Form

Use the Format drop-down list on the Export Certificate form to select the format in which the certificate
signing request should be exported. The following formats are supported:

l PKCS#10 Certificate Request (.p10) – Exports the certificate signing request in binary format.

l Base-64 Encoded (.pem) – Exports the certificate signing request as a base-64 encoded text file. This is
also known as “PEM format”.

If you choose Base-64 Encoded, the form expands to include the Trust Chain row. You can use this option to
create and export a certificate bundle that includes the Intermediate CA and Root CA and can be imported in
ClearPass Policy Manager as the server certificate (ClearPass Policy Manager does not accept PKCS#7). To
include the trust chain in a certificate bundle that can be imported as the server certificate in ClearPass Policy
Manager, mark the Include certificate trust chain check box, and then click Export Certificate.

Click Export Request to download the certificate signing request file in the selected format.

Sign Request

The Sign request link opens the Sign Request form. Use this action to approve the request for a
certificate and issue the certificate.
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Figure 95 The Sign Request Form

Use the Expiration text field to specify how long the issued certificate should remain valid.

Mark the Sign this request check box to confirm that the certificate should be issued, and then click Sign
Request. The certificate will be issued and will then replace the certificate signing request in the list view.

Reject Request

The Reject request link opens the Reject Request form. Use this action to reject the request for a
certificate. Rejected requests are automatically deleted according to the data retention policy.
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Figure 96 The Reject Request Form

Mark the Reject this request check box to confirm that the certificate signing request should be rejected,
and then click the Reject Request button.

Delete Request

The Delete request link opens the Delete Request form. You can use this form to remove the certificate
signing request from the list. This option is only available if the data retention policy is configured to permit the
certificate signing request’s deletion.

Figure 97 The Delete Request Form
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Mark the Delete this request check box to confirm the certificate signing request’s deletion, and then click
Delete Request.

Importing a Code-Signing Certificate

ClearPass Onboard supports importing a code-signing certificate chain and private key for signing the Windows
provisioning application. Certificates can be uploaded as PFX, PKCS-12, SPC, or PKCS-7, and can include a chain
of certificates. An operator’s profile must include the Import Code-Signing Certificate privilege in order to
access this feature. Code-signing certificates can also be used as profile-signing certificates.

To import a trusted certificate, see "Importing a Trusted Certificate " on page 159.

To import a code-signing certificate, do one of the following:

l Go to Onboard > Management and Control > View by Certificate and click the Upload a code-
signing certificate link.

l Go to Onboard > Deployment and Provisioning > Provisioning Settings. You can either click the
Create new provisioning settings link at the top of the page, or click the Edit link for a configuration set
in the list. In the page that opens, click the Upload a code-signing certificate link in the upper-right
corner.

The Code-Signing Certificate Import form opens.

Figure 98 The Code-Signing Certificate Import Form

Field Description

Certificate Click Choose File to navigate to the code-signing certificate file to upload.

Private Key If the private key for the code-signing certificate was issued as a separate file, click the Choose
File button to navigate to the private key file.

Private Key
Passphrase

Passphrase that was used to encrypt the private key. If the private key is not encrypted, leave
empty.

Upload
Certificate

Uploads the certificate. The certificate chain is displayed.

Table 46: The Code-Signing Certificate Import Form

To use the certificate for code-signing:

1. Go to Onboard > Deployment and Provisioning > Provisioning Settings > Windows tab.

2. In the Windows Provisioning area, use the Code-Signing Certificate drop-down list to select the
uploaded certificate.
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Figure 99 The Windows Provisioning Area

To create a test certificate:

1. Go to Onboard > Management and Control > View by Certificate and click the Generate a new
certificate signing request link. The Certificate Request Settings form opens.

2. In the Certificate Type drop-down list, choose Code-Signing.

3. Complete the rest of the form with your information. Mark the Issue this certificate immediately check
box, and then click Create Certificate Request.

The test certificate is displayed in the list on the Certificate Management page, and can be selected on
the Provisioning Settings form.

Importing a Trusted Certificate

Onboard’s Certificate Management page supports importing trusted certificates. Certificates may be
uploaded in PEM format (*.pem).

(To import a code-signing certificate, see "Importing a Code-Signing Certificate " on page 158

To import a trusted certificate:

1. Go to Onboard > Management and Control > View by Certificate and click the Upload a trusted
certificate link. The Trusted Certificate Import form opens.

Figure 100 The Trusted Certificate Import Form

2. Click Choose File to browse to the certificate on your system, and then click Upload Certificate. A
confirmation message is displayed, and the imported certificate is included in the Certificate
Management list. You can click the Show Certificate link next to the certificate’s name to view the
certificate’s details.

Figure 101 The Certificate Information View

3. You can use the following additional options in the upper-right corner of the Import Trusted Certificate
page:

l Click the Upload another trusted certificate link to upload additional certificates.
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l Click the Edit <certificate name> trust settings link to open the Trust tab of the Network Settings
form.

Creating a Certificate

To create a new certificate, go to Onboard > Management and Control > View by Certificate. The
Certificate Management page opens. Click the Generate a new certificate signing request link. The
Certificate Request Settings form opens.

Figure 102 The Certificate Request Settings Form
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To create a new certificate or certificate signing request, first specify the Certificate Authority and the type:

Field Description

Certificate
Authority

Specifies the Certificate Authority that will be used to sign the request.

Certificate
Type

Specifies the type of certificate to create. Options include:
l TLS Client Certificate—Use this option when the certificate is to be issued to a client, such as a

user or a user’s device. When this option is selected, the issued certificate’s extended key usage
property will contain a value of “Client Auth”, indicating that the certificate may be used to identify
a client. When you create a TLS Client certificate, corresponding entries are created in the
Onboard > Management and Control > View by Device and Onboard > Management and
Control > View by Username lists.

l Trusted Certificate—Use this option when the certificate is to be issued to a network server,
such as a Web server or as the EAP-TLS authentication server. When this option is selected, the
issued certificate’s extended key usage property will contain a value of “Server Auth”, indicating
that the certificate may be used to identify a server. Trusted certificates include the id-kp-
eapOverLAN extended key usage.

l Certificate Authority—Use this option when the certificate is for a subordinate Certificate
Authority. When this option is selected, the issued certificate will contain an extension identifying it
as an intermediate Certificate Authority, and the extended key usage property will contain the
three values “Client Auth”, “Server Auth” and “OCSP Signing”.

l Code Signing—Use this option for signing the Windows provisioning application.
l HTTPS—Use this option to create certificates suitable for use as HTTPS server certificates.

Table 47: Certificate Request Settings Form

The fields available on the rest of the Certificate Request Settings form depend on your selection in the
Certificate Type field, and are described in the following sections. For information on configuring these fields,
see "Specifying the Identity of the Certificate Subject" on page 161 and "Issuing the Certificate Request" on
page 163.

Specifying the Identity of the Certificate Subject

In the Identity area of the Certificate Request Settings form, provide the identity of the person or device
for which the certificate is to be issued (the “subject” of the certificate). Together, these fields are collectively
known as a distinguished name, or “DN”:

Field Description

Country (Required) Two-letter ISO country code for your organization. This value forms part of the
distinguished name for the certificate.

State (Required) Full name of the state or province for your organization. This value forms part of the
distinguished name for the certificate.

Locality (Required) Name of the town or city where your organization is located. This value forms part of the
distinguished name for the certificate.

Organizati
on

(Required) Name of your organization. This value forms part of the distinguished name for the
certificate.

Organizati
onal Unit

(Optional) Name of your organizational unit (section or division of the organization). This value forms
part of the distinguished name for the certificate.

Table 48: Certificate Request Settings Form, Identity and Private Key Areas
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Field Description

Common
Name

(Required) Descriptive name for the certificate. This value is used to identify the certificate as the
issuer of other certificates, notably the signing certificate.

Email
Address

(Required) Contact email address. This email address is included in the root and signing certificates,
and provides a way for users of the certificate authority to contact your organization.

Key Type (Required) Specifies the type of private key that should be created for the certificate. Options include:
l 1024-bit RSA – (Lower security. Not available for FIPS mode.)
l 2048-bit RSA – (Recommended for general use.)
l 4096-bit RSA – (Higher security.)

Using a private key containing more bits will increase security, but will also increase the
processing time required to create the certificate and authenticate the device. The additional
processing required will also affect the battery life of a mobile device. It is recommended to use
the smallest private key size that is feasible for your organization.

Table 48: Certificate Request Settings Form, Identity and Private Key Areas(Continued)

Figure 103 The Subject Alternative Name Area

If you selected TLS Client as the certificate type, the Subject Alternative Name area is also included on the
Certificate Request Settings form. The alternative name can be used to specify additional identification
details for the certificate’s subject. These details are optional. If one or more of these options are provided, the
issued certificate will contain a subject AltName extension with the specified values.

Table 49 explains the fields that may be included as part of the subject alternative name.
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Field Description

Device Type Type of device, such as “iOS”, “Android”, etc.

Device Name The hostname of the device at the time of enrollment.

Device UDID Unique device identifier (UDID) for this device. This is typically a 64-bit,
128-bit or 160-bit number represented in hexadecimal (16, 32 or 40
characters, respectively).

Device IMEI International Mobile Equipment Identity (IMEI) number allocated to this
device.

Device ICCID Integrated Circuit Card Identifier (ICCID) number from the Subscriber
Identity Module (SIM) card present in the device.

Device Serial Serial number of the device.

MAC Address IEEE MAC address of this device.

Product Name Product string identifying the device and often including the hardware
version information.

Product Version Software version number for the device.

User Name Username of the user who provisioned the device.

Custom Field A custom field to be used as needed.

User Email Address The email address of the user who provisioned a device.

Table 49: Subject Alternative Name Fields Supported When Creating a TLS Client Certificate Signing Request

Issuing the Certificate Request

When you have completed the other fields on the Certificate Request Settings form, use the fields in the
Issue Certificate area to create the request.

Figure 104 The Issue Certificate Area
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Field Description

Approval To issue the certificate immediately, select the check box in this field. The form expands to include the
Expiration field.

Expiration To override the default validity period and specify a lifetime for the certificate, enter the number of
days the certificate should be valid, up to the maximum configured for the Certificate Authority. This
field does not accept a zero (0) as a numerical entry. To use the default validity period (usually 365
days), leave this field empty.

Create
Certificate
Request

Saves your changes or submits the request:
l If the “Issue this certificate immediately” check box is marked, the certificate is issued immediately

and is displayed in the Certificate Management list view.
l If the “Issue this certificate immediately” check box is not marked, your changes are saved and the

request is displayed in the Certificate Management list view. The certificate can then be issued
or rejected at a later time. While the certificate request is displayed in the Certificate
Management list view, the options for the request let you view details, export, sign, reject, or
delete the request.

Table 50: Certificate Request Settings, Issue Certificate Area

Figure 105 The Certificate Management List View, Request Information Form

Requesting a Certificate

To upload a certificate signing request file, go to Onboard > Management and Control > View by
Certificate and click the Upload a certificate signing request link. The Certificate Signing Request
form opens.
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Figure 106 The Certificate Signing Request Form

Field Description

Certificate
Authority

(Required) Specifies the Certificate Authority that will be used to sign the request.

Certificate
Signing
Request

(Required) Click the Choose File button in this field to browse to the PEM-encoded PKCS#10
certificate request file on your system.

Certificate
Type

(Required) Specifies the type of certificate to create. Options include:
l TLS Client Certificate—Use this option when the certificate is to be issued to a client, such as a

user or a user’s device. When this option is selected, the issued certificate’s extended key usage
property will contain a value of “Client Auth”, indicating that the certificate may be used to identify
a client. When you create a TLS Client certificate, corresponding entries are created in the
Onboard > Management and Control > View by Device and Onboard > Management and
Control > View by Username lists.

l Trusted Certificate—Use this option when the certificate is to be issued to a network server,
such as a Web server or as the EAP-TLS authentication server. When this option is selected, the
issued certificate’s extended key usage property will contain a value of “Server Auth”, indicating
that the certificate may be used to identify a server. Trusted certificates include the id-kp-
eapOverLAN extended key usage.

l Certificate Authority—Use this option when the certificate is for a subordinate Certificate
Authority. When this option is selected, the issued certificate will contain an extension identifying it
as an intermediate Certificate Authority, and the extended key usage property will contain the
three values “Client Auth”, “Server Auth” and “OCSP Signing”.

l Code Signing—Use this option for signing the Windows provisioning application.
l HTTPS—Use this option to create certificates suitable for use as HTTPS server certificates.

Table 51: Certificate Signing Request Form
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Field Description

Approval To issue the certificate immediately, select the check box in this field. The form expands to include the
Expiration field.

Expiration To override the default validity period and specify a lifetime for the certificate, enter the number of
days the certificate should be valid, up to the maximum configured for the Certificate Authority. This
field does not accept a zero (0) as a numerical entry. To use the default validity period (usually 365
days), leave this field empty.

Submit
Certificate
Signing
Request

Saves your changes or submits the request:
l If the “Issue this certificate immediately” check box is marked, the certificate is issued immediately

and is displayed in the Certificate Management list view.
l If the “Issue this certificate immediately” check box is not marked, your changes are saved and the

request is displayed in the Certificate Management list view. The certificate can then be issued
or rejected at a later time. While the certificate request is displayed in the Certificate
Management list view, the options for the request let you view details, export, sign, reject, or
delete the request. For more information, see "Working with Certificate Signing Requests " on
page 154.

Onboard Usage

The Onboard Usage page displays the count of all current users with valid certificates, as well as device counts
and certificate counts for Onboard devices.

To calculate license usage, Onboard considers the username in certificates created via EST or SCEP. Onboard
License usage is not counted per device. A single user with multiple devices consumes only one Onboard Application
License.

To see the usage list, go to Onboard > Management and Control > Usage. The Onboard Usage list view
opens.
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Figure 107 The Onboard Usage List View

Field Description

License
Usage

The license usage count expressed as the total number of users with currently valid certificates. This
is the count at the time of the query; it is not an average.

Devices Summary of Onboard device statistics by device type. Information categories include Enrolled, Not
Enrolled, and Denied for each device type, as well as the Total count for each category for all
device types.

Certificates Summary of certificate statistics. Information categories include Valid, Expired, and Revoked for
each Certificate Authority, as well as the Total count for each category for all Certificate
Authorities.

Table 52: Onboard Usage List

Onboard Configuration

Onboard lets you create and manage the configuration settings that can be provisioned to onboarded devices.
To manage configuration settings, go to Onboard > Configuration > Start Here. The index page opens. It
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includes with command links for accessing the different configuration settings as well as the configuration
profiles that use them.

l For network settings, see "Network Settings " on page 168

l For iOS device settings, see "iOS Settings" on page 180

l For configuration profiles, see "Configuration Profiles" on page 219

Network Settings

You can define multiple network settings that can be sent to provisioned devices. Each network you configure
is also a "configuration unit" that you can include in a configuration profile.

To create and work with network settings, go to Onboard > Configuration > Network Settings. The
Networks list view opens.

Figure 108 The Networks List View

All networks that have been provisioned are included in the list. You can click a network's row in the list for
additional options:

Field Description

Show
Details

Displays details for the network. The form expands to show its name, description, and configuration
values for network access, wireless networks, enterprise protocols, enterprise authentication,
enterprise trust, Windows networking, and proxy settings.

Edit Edit any of a network's attributes. The Network Settings form opens.

Duplicate Creates a copy of a network configuration to use as a basis for a new network. The Network Settings
form opens with all attributes prepopulated and "Copy" appended to its name. You can rename the
new configuration, and edit any of its attributes.

Show
Usage

Displays a list of configuration profiles that use the network.

Create
new
network

To create a new network, click this link in the upper right corner. The Network Settings form opens.

Table 53: The Network Settings List
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For information on creating, editing, or duplicating a Network Settings configuration, see:

l "Configuring Basic Network Access Settings " on page 169

l "Configuring Enterprise Protocol Settings" on page 171

l "Configuring Device Authentication Settings" on page 173

l "Configuring Certificate Trust Settings" on page 175

l "Configuring Windows-Specific Network Settings" on page 177

l "Configuring Proxy Settings" on page 178

Configuring Basic Network Access Settings
1. On the Onboard > Configuration > Network Settings list view, to configure the network settings that

will be provisioned to devices, click the network’s Edit link. To create a new network, click the Create new
network link in the upper-right corner. The Network Settings form opens with the Access tab displayed.

The configuration process is the same for editing an existing network and for creating a new network. The
Network Access form is divided into several tabs:

Tab Description

Access Specifies basic network properties, such as the name of the wireless network and the type of
security that is used. This form is described below.

Protocols Specifies the 802.1X authentication protocols that are used by the network. See "Configuring
Enterprise Protocol Settings" on page 171.

Authentication Specifies the type of device authentication to be used for the network. See "Configuring
Device Authentication Settings" on page 173.

Trust Specifies options related to mutual authentication. See "Configuring Certificate Trust
Settings" on page 175.

Windows Specifies networking options used only by devices using the Windows operating system. See
"Configuring Windows-Specific Network Settings" on page 177.

Proxy Specifies a proxy server to be used by devices connecting to the network. See "Configuring
Proxy Settings" on page 178.

Navigating between different tabs will save the changes you have made in each tab. The modified settings are
indicated with a “#” marker in the tab. The settings used for device provisioning are not modified in the database until
you click Create Network.

To edit the network’s basic and wireless network access options, click the Access tab:
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Figure 109 The Access Tab of the Network Settings Form

Field Description

Name Name of the network.

Descript
ion

(Optional) You may enter additional identifying information.

Network
Type

The type of network to be provisioned. Options include:
l Both — Wired and Wireless – Configures both wired (Ethernet) and wireless network adapters.

Use this option when you have 802.1X configured for all types of network access.

Table 54: Network Settings Form, Access Tab
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Field Description

l Wireless only – Configures only wireless network adapters.
l Wired only – Configures only wired (Ethernet) network adapters.

Wired-only networks are not supported for Android, iOS, or OS X 10.7+ clients.

Security
Type

Authentication method used for the network. Options include:
l Enterprise (802.1X) – Use this option to setup a network that requires user authentication.

This option is the only available choice when the Network Type is set to “Wired only”.
l Personal (PSK) – Use this option to setup a network that requires only a Pre-Shared Key (password)

to access the network.
This option is only available when the Network Type is set to “Wireless only”.

Selecting the PSK security type will hide the Protocols, Authentication, and Trust tabs.

Security
Version

The field lets you set the encryption version for the wireless network to WPA with TKIP or WPA2 with
AES.

SSID The SSID of the wireless network to connect to.

Passwor
d

If the Personal (PSK) security type is selected, you must provide the Pre-Shared Key in this field. The
minimum password length is six characters.

Wireless If the wireless network is not open or broadcasting, select the Hidden network check box in this row.

Auto
Join

If the device should be automatically connected to the network when it is provisioned, select the
Automatically join network check box in this row. If only one network is available to the user, the
device will be connected automatically. If multiple networks are available, the user will be able to
choose the network to connect to. If the Automatically join network option is not selected on this
form, an option to manually connect to the network will be shown to the user.

Next Opens the Protocols tab.

Save
Changes

Saves your changes. The new network configuration settings take effect.

Cancel Discards your changes. The Onboard > Configuration > Network Settings list view opens.

Table 54: Network Settings Form, Access Tab(Continued)

For information about the list of network settings, see "Network Settings " on page 168. For more information
about configuration profiles, see "Configuration Profiles" on page 219

Configuring Enterprise Protocol Settings
To configure enterprise protocols for a network, on the Onboard > Configuration > Network Settings
form, click the Protocols tab.

Use this form to specify the authentication methods required by your network infrastructure. The default EAP
type is TLS for all platforms that support this method.

The following best practices are recommended when choosing the 802.1X authentication methods to
provision:

l Configure PEAPv0/EAP-MSCHAPv2 for legacy macOS (10.5/10.6).

l Configure EAP-TLS for Android, Windows, iOS, and macOS (10.7 or later).
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l Other EAP methods, while possible, are limited in their applicability and should only be used if you have a
specific requirement for that method.

Figure 110 The Protocols Tab of the Network Settings Form

Field Description

iOS & macOS
EAP

Authentication protocol to use when configuring iOS or macOS 7+ devices. This option supports:
l TLS
l TTLS
l PEAP
l EAP-FAST
l EAP-SIM

Legacy OS X
EAP

Authentication protocol to use when configuring OS X 10.5/6 devices. This option supports:
l PEAP with MSCHAPv2

Android EAP Authentication protocol to use when configuring an Android device. This option supports:

Table 55: Network Settings Form, Protocols Tab
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Field Description

l EAP-SIM
l TLS
l PEAP with MSCHAPv2
l PEAP with GTC
l TTLS with MSCHAPv2
l TTLS with GTC
l TTLS with PAP

Windows EAP Authentication protocol to use when configuring a Windows device. This option supports:
l TLS
l PEAP with MSCHAPv2

Fast
Reconnect

To enable Fast Reconnect for the Windows device, select the Enable Fast Reconnect check box
in this row. Fast Reconnect is a PEAP property that enables wireless clients to move between
wireless access points on the same network without being re-authenticated each time they
associate with a new access point.
If TLS is selected, Fast Reconnect is not available.

Quarantine To obtain a system statement-of-health (SSoH) for the Windows device from the OnGuard or
Microsoft NAP Agent and send it to the authentication server during the 802.1X authentication
process, select the Enforce Network Access Protection check box in this row. Use this option to
enforce network access control (NAC) protections on the network.
If TLS is selected, Enforce Network Access Protection is not available.

Cryptobinding To enforce cryptobinding for the Windows device, select the Enforce Cryptobinding check box
in this row. Cryptobinding is a process that protects the authentication protocol negotiation
against man-in-the-middle attacks. The cryptobinding request and response performs a two-way
handshake between the peer and the authentication server using key materials.
If TLS is selected, Enforce Cryptobinding is not available.

Ubuntu Authentication protocol to use when configuring an Ubuntu device. This option supports:
l TLS
l PEAP with MSCHAPv2

Previous Opens the Access tab.

Next Opens the Authentication tab.

Save Changes Saves your changes. The new network configuration settings take effect.

Cancel Discards your changes. The Onboard > Configuration > Network Settings list view opens.

Table 55: Network Settings Form, Protocols Tab(Continued)

For information about the list of network settings, see "Network Settings " on page 168. For more information
about configuration profiles, see "Configuration Profiles" on page 219

Configuring Device Authentication Settings

To configure authentication settings for a network, on the Onboard > Configuration > Network Settings
form, click the Authentication tab.

The Windows Authentication area is included on this tab if TLS was chosen for Windows EAP on the
Protocols tab.
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Figure 111 The Authentication Tab of the Network Settings Form

Field Description

Android Authentication

Certificate
Store

Specifies the certificate store where the client certificate will be provisioned when configuring an
Android device. Options include:
l Private – This is the default.
l System – Certificates will be available for use by other applications but might require additional

security prompts during provisioning.

iOS and macOS Authentication

iOS &
macOS
Credentials

Specifies the type of credentials to provision for iOS and macOS 10.7+ devices. Options include:
l Certificate – A device certificate will be provisioned and used for EAP-TLS client authentication.

When this option is selected, EAP-TLS must be selected on the Protocols tab.
l Username & Password – A device certificate will be provisioned, but the client authentication

will use unique device credentials (as for Onboard devices). When this option is selected, EAP-
TTLS or PEAP must be selected on the Protocols tab.

Windows Authentication

Certificate
Store

Specifies the certificate store where the client certificate will be provisioned when configuring a
Windows device. Options include:
l User – Use user-only credentials. This is the default.
l Machine – Use computer-only credentials.
l Machine and User – Use computer-only credentials or user-only credentials. When a user is

logged on, the user's credentials are used for authentication. When no user is logged on,
computer-only credentials are used for authentication.

Previous Opens the Protocols tab.

Next Opens the Trust tab.

Save
Changes

Saves your changes. The new network configuration settings take effect.

Cancel Discards your changes. The Onboard > Configuration > Network Settings list view opens.

Table 56: Network Settings Form, Authentication Tab

For information about the list of network settings, see "Network Settings " on page 168. For more information
about configuration profiles, see "Configuration Profiles" on page 219
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Configuring Certificate Trust Settings
To configure trust settings for a network, on the Onboard > Configuration > Network Settings form, click
the Trust tab.

Figure 112 The Trust Tab of the Network Settings Form, Automatic Configuration Selected

Figure 113 The Trust Tab of the Network Settings Form, Manual Configuration Selected
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Field Description

Configur
e
Trusted
Servers

Specifies automatic or manual configuration of trusted certificate servers. Options include:
l Automatically configure trusted servers (recommended) — Default. The common names of all

ClearPass appliances in the cluster will be trusted.
l Manually configure certificate trusted servers — If you are not using ClearPass for

RADIUS authentication, or if you plan to expand your ClearPass cluster, you should select manual
configuration. You may use a wildcard in this field if will be expanding your cluster later.

Trusted
Server
Names

For manual trusted server configuration, enter the certificate names that can be expected from the
authentication server. If a server presents a certificate that is not in this list, it will not be trusted. Enter
each name on a separate line. Wildcards may be used.

Configur
e Trust

Specifies automatic or manual configuration of trust settings. Options include:
l Automatically configure trust settings (recommended) — Select this option if you are using

Policy Manager for authentication. Onboard automatically determines the appropriate certificate
trust configuration for your deployment. The complete trust chain is included in the profile
download.

l Manually configure trust settings — To change the recommended default setting and configure
trust settings manually, select this option. The form expands to include configuration options.

Trusted
Certifica
tes

Specifies the certificates the device should use during authentication. This should include the root CA
that has issued the authentication server’s certificate. The recommended certificate is selected by
default. You may click the field to open the drop-down list and select a different certificate the client
should trust. You can select multiple certificates. You should include the root certificate that issued the
authentication server’s certificate, and you should provide the certificate for each authentication server
a provisioned device will use.

Upload
Certifica
te

Lets you import additional trusted certificates. Click Choose File to navigate to the file on your
computer, and then click Upload. The certificate is imported, and the certificate name is displayed
above the form. You can click the Show certificate link next to the name to view certificate details. The
certificate is also displayed in the Certificate Management list with the type “trusted.”

Dynamic
Trust

If selected, allows trust decisions to be made by the user (a dialog box will be presented to them).

You should avoid marking the Allow trust exceptions check box – the network administrator should
make all trust decisions. Users will not generally review certificates for potential issues before
accepting them. Letting the user make trust decisions is an insecure configuration, as the user can
override a security warning if a man-in-the-middle attack occurs.

Android Area

Trusted
Certifica
te

Specifies the certificate the Android device should trust. Android supports only a single trusted
certificate; this must be the root CA that issued the authentication server’s certificate. Be aware that if
None is selected, 802.1x authentication might not work.

Windows Area

Validate
Certifica
te

Leave this check box selected to have the provisioned device check that the server certificate is valid
before using the server for authentication.

Disabling the Validate Certificate option is an insecure configuration. An attacker could provide
another server certificate which the client would not verify.

Previous Opens the Authentication tab.

Table 57: Network Settings, Trust Tab
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Field Description

Next Opens the Windows tab.

Save
Changes

Saves your changes. The new network configuration settings take effect.

Cancel Discards your changes. The Onboard > Configuration > Network Settings list view opens.

Table 57: Network Settings, Trust Tab(Continued)

For information about the list of network settings, see "Network Settings " on page 168. For more information
about configuration profiles, see "Configuration Profiles" on page 219

Configuring Windows-Specific Network Settings
To configure settings for Windows devices on a network, on the Onboard > Configuration > Network
Settings form, click the Windows tab.

Figure 114 The Windows Tab of the Network Settings Form
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Field Description

NAP
Services

If selected, enables NAP for Microsoft Windows clients. You will also need to mark the Enable
Quarantine Checks check box on the Protocols tab.
Network Access Protection (NAP) is a feature in Windows Server 2008 that controls access to
network resources based on a client computer’s identity and compliance with corporate
governance policy. NAP allows network administrators to define granular levels of network access
based on who a client is, the groups to which the client belongs, and the degree to which that client
is compliant with corporate governance policy. If a client is not compliant, NAP provides a
mechanism to automatically bring the client back into compliance and then dynamically increase its
level of network access.
Deploying NAP requires a NAP-compatible authentication server, so that appropriate policies may
be implemented based on the statement of health provided by the NAP client.

Admin
Username

If configuration of networking requires administrator credentials, enter the admin username in this
field.
Embedding administrator credentials allows privileged operations such as application installation
to be done during onboarding by end users who otherwise do not have admin privileges. (Not
supported by Windows 8 or above)

Admin
Password

If configuration of networking requires administrator credentials, enter the admin password in this
field.
Embedding administrator credentials allows privileged operations such as application installation
to be done during onboarding by end users who otherwise do not have admin privileges. (Not
supported by Windows 8 or above)

IP Address If selected, assigns an IP address using DHCP,

DNS If selected, assigns DNS using DHCP,

DNS
Registration

If selected, registers IP address with DNS,

Configure
Using

If selected, uses Windows to configure wireless,

Notification
Icon

If selected, shows icon in notification,

Notify
Connectivity

If selected, notifies when connectivity is limited,

Previous Opens the Trust tab.

Next Opens the Proxy tab.

Save
Changes

Saves your changes. The new network configuration settings take effect.

Cancel Discards your changes. The Onboard > Configuration > Network Settings list view opens.

Table 58: Network Settings Form, Windows Tab

For information about the list of network settings, see "Network Settings " on page 168. For more information
about configuration profiles, see "Configuration Profiles" on page 219

Configuring Proxy Settings

To configure proxy settings for a network, on the Onboard > Configuration > Network Settings form, click
the Proxy tab.
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Figure 115 The Proxy Tab of the Network Settings Form

Field Description

Proxy
Type

Specifies the network’s proxy server configuration type. Options include:
l None– No proxy server will be configured.
l Manual– A proxy server will be configured, if the device supports it. Specify the proxy server

settings in the Server and Server Port fields.
l Automatic– The device will configure its own proxy server, if the device supports it. Specify the

location of a proxy auto-config file in the PAC URLtext field.

Server Enter the proxy server’s network address.

Server
Port

Enter the proxy server’s port number.

PAC URL Enter the URL of the PAC file that defines the proxy configuration.

Previous Opens the Windows tab.

Save
Changes

Saves your changes. The new network configuration settings take effect.

Cancel Discards your changes. The Onboard > Configuration > Network Settings list view opens.

Table 59: Network Settings Form, Proxy Tab

For information about the list of network settings, see "Network Settings " on page 168. For more information
about configuration profiles, see "Configuration Profiles" on page 219
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iOS Settings

You can manage iOS device settings for provisioned devices. A variety of settings are available, including such
things as contacts, email, passcode policy, VPN, and Web clips settings. After you define each of the settings
you wish to use, you can include them in configuration profiles. The configuration profiles are available in the
Provisioning Settings form, and can be associated with a device provisioning configuration set.

To create and work with iOS settings, go to Onboard > Configuration > iOS Settings. The iOS Settings list
view opens.

Figure 116 The iOS Settings List View

All iOS settings that have been configured are included in the list. Each setting's name and type are shown in
the list. You can click and iOS setting's row in the list for additional options:

Field Description

Show
Details

Displays details for the iOS setting. The form expands to show its name, description, and configuration
values specific to the type of setting.

Edit Edit the iOS setting's configuration. The Settings form for the type of iOS setting opens.

Duplicate Creates a copy of an iOS setting to use as a basis for a new setting. The Settings form specific to the
type of setting opens with all attributes prepopulated and "Copy" appended to its name. You can
rename the new setting, and edit any of its attributes.

Delete Deletes the iOS setting. You will be asked to confirm the deletion.

Show
Usage

Displays a list of configuration profiles that use the iOS setting.

Add New To create a new iOS setting, click this link above the table. The Settings form specific to the type of iOS
setting opens.

Table 60: The iOS Settings List

For information on creating, editing, or duplicating the different types of iOS settings, see:

l "Configuring ActiveSync Settings " on page 181

l "Configuring AirPlay Settings" on page 184

l "Configuring AirPrint Settings" on page 186
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l "Configuring APN Settings" on page 187

l "Configuring Calendar (CalDAV) Settings" on page 188

l "Configuring Contacts (CardDAV) Settings" on page 190

l "Configuring Device Restrictions Settings" on page 192

l "Configuring Email Settings" on page 200

l "Configuring an iOS Device Passcode Policy " on page 203

l "Configuring Calendar Subscription Settings" on page 206

l "Configuring an iOS Device VPN Connection" on page 207

l "Configuring Web Clips" on page 216

Configuring ActiveSync Settings

Exchange ActiveSync configurations you define can be used in configuration profiles to automatically configure
an email account on an iOS device. Use an ActiveSync configuration when you have an Exchange mail server
and want to automatically provide the email settings to users provisioning their mobile devices. You can define
multiple ActiveSync settings.

Exchange ActiveSync settings are only supported by iOS devices; they will be ignored by all other device types.

To create and work with Exchange ActiveSync configurations, go to Onboard > Configuration > iOS
Settings. Either click an existing ActiveSync setting's name in the list; or click Add New, select ActiveSync
Settings in the Settings Type drop-down list, and click Create. The Exchange ActiveSync Settings form
opens.
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Figure 117 The Exchange ActiveSync Settings Form, General Area

Field Description

Name (Required) Enter a short name that identifies the ActiveSync configuration clearly. ActiveSync
configuration names can include spaces.
If you are duplicating a configuration, the original name has a number appended to it. You may
highlight this name and replace it with a new name.

Description Brief description of the ActiveSync setting.

ActiveSync
Host

(Required) Enter the hostname or IP address of the server the device will connect to.

Use SSL If selected, specifies that all communications are encrypted.

Magic
String

Value to send as the "X-Apple-Config-Magic" header in each EAS HTP request.

Allow Move If selected, allows the user to move messages out of this email account into another account. Leave
this field blank to prevent moving messages between accounts, and to prevent forwarding or
replying from other than the message's originating account.

Allow
Recent
Address
Sync

If selected, includes this email account in recent address syncing.

Use Only
in Mail

If selected, sends outgoing mail from this account only from the Mail app, and prevents sending mail
in third-party applications.

Table 61: Exchange ActiveSync Settings Form, Basic Properties and General Area
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Figure 118 The Account Settings Area

Field Description

Account
Details

(Required) Specifies how user account information is supplied. Options include:
l User provided — entered by user on device. This option requires the user to enter their

credentials on the device to access their email.
l Identity certificate — created during provisioning. This option uses the device’s TLS client

certificate to authenticate the user. Using this option requires configuration of the ActiveSync
server to authenticate a user based on the client certificate.

l Provisioning — values acquired during device provisioning.
l Shared preset values — testing only. This option provides a fixed set of credentials to the device.

These settings cannot be modified for each user when provisioning a device, so it is recommended
that these settings only be used when testing Exchange integration.

Domain You may enter the domain for the account.

Email
Address

Specifies how the email address for the user account will be defined. Options include:
l Let system define
l Same as username
l Generate using username.

When to
Add
Email
Address
Domain

If “Generate using username” was selected in the Email Address field, this field is added. Options
include:
l Only if username is not a valid email address
l Always append

User If "Shared preset values - testing only" was chosen in the Account Details field, the form includes these
fields for login credentials. Enter the login information for testing in the User, Password, and Confirm
Password fields. The minimum password length is six characters. If both the Domain and User fields
are blank, the device will prompt the user.Password

Table 62: Exchange ActiveSync Settings Form, Account Settings and Sync Settings Areas
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Field Description

Confirm

Days of
Mail

Specifies the number of past days of mail to synchronize. Options include:
l No Limit
l 1 day
l 3 days
l 1 week
l 2 weeks
l 1 month

Save
Changes

Saves your changes and creates the ActiveSync setting. The Exchange ActiveSync setting is available
as a configuration unit on the Configuration Profile form.

Table 62: Exchange ActiveSync Settings Form, Account Settings and Sync Settings Areas (Continued)

For more information about configuration profiles, see "Configuration Profiles" on page 219

Configuring AirPlay Settings

AirPlay settings you define can be used in configuration profiles for an iOS device. An AirPlay setting includes its
name and description, the destinations that are available to the device, and passwords for each destination.
You can define multiple AirPlay settings.

AirPlay settings are only supported by iOS 7 devices; they will be ignored by all other device types.
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To configure an AirPlay setting, go to Onboard > Configuration > iOS Settings. Either click an existing
AirPlay setting's name in the list; or click Add New, select AirPlay Settings in the Settings Type drop-down
list, and click Create. The AirPlay Settings form opens.

Figure 119 The AirPlay Settings Form

Field Description

Name (Required) Enter a short name that identifies the AirPlay configuration clearly. AirPlay
configuration names can include spaces.
If you are duplicating a configuration, the original name has a number appended to it. You may
highlight this name and replace it with a new name.

Description Brief description of the AirPlay setting.

AirPlay
Destinations

Specifies the device ID of each AirPlay destination that will be available to the device. Each device
ID must be entered on a new line. To make all destinations available, leave this field empty.

AirPlay
Destination
Passwords

You may enter a device password for each destination. The minimum password length is six
characters.

Save Changes Saves your changes and creates the AirPlay setting. The AirPlay setting is available as a
configuration unit on the Configuration Profile form.

Table 63: AirPlay Settings Form

For more information about configuration profiles, see "Configuration Profiles" on page 219
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Configuring AirPrint Settings

AirPrint settings you define can be used in configuration profiles for an iOS device. An AirPrint setting includes
its name and description, and AirPrint printer locations that are available to the user. You can define multiple
AirPrint settings.

AirPrint settings are only supported on iOS 7 devices; they are ignored by all other devices.

To configure an AirPrint setting, go to Onboard > Configuration > iOS Settings. Either click an existing
AirPrint setting's name in the list; or click Add New, select AirPrint Settings in the Settings Type drop-down
list, and click Create. The AirPrint Settings form opens.

Figure 120 The AirPrint Settings Form

Field Description

Name (Required) Enter a short name that identifies the AirPrint configuration clearly. AirPrint configuration
names can include spaces.
If you are duplicating a configuration, the original name has a number appended to it. You may
highlight this name and replace it with a new name.

Description Brief description of the AirPrint setting.

AirPrint
Printers

(Required) Specifies the Destination IP address and Resource Path of each AirPrint location that
will be available to the user.

Save
Changes

Saves your changes and creates the AirPrint setting. The AirPrint setting is available as a
configuration unit on the Configuration Profile form.

Table 64: AirPrint Settings Form
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For more information about configuration profiles, see "Configuration Profiles" on page 219

Configuring APN Settings

APN settings you define can be used in configuration profiles for an iOS device. An APN setting includes its
name and description, carrier and proxy server information, and user account provisioning details. You can
define multiple APN settings.

APN settings are only supported on iOS devices; they are ignored by all other devices.

To configure an APN setting, go to Onboard > Configuration > iOS Settings. Either click an existing APN
setting's name in the list; or click Add New, select APN Settings in the Settings Type drop-down list, and click
Create. The APN Settings form opens.

Figure 121 The APN Settings Form
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Field Description

Name (Required) Enter a short name that identifies the APN configuration clearly. APN configuration
names can include spaces.
If you are duplicating a configuration, the original name has a number appended to it. You may
highlight this name and replace it with a new name.

Description Brief description of the APN setting.

Access Point
Name

(Required) Enter the name of the carrier (GPRS) access point.

Proxy Server Fully-qualified address of the proxy server.

Port Port number of the proxy server.

Account
Details

(Required) Specifies how the user account information should be supplied. Options include:
l User provided - entered by user on device
l Provisioning - values acquired during device provisioning
l Shared preset values - testing only

Access Point
Username

Username to connect to the access point.

Access Point
Password

Password to connect to the access point.

Confirm
Password

Save Changes Saves your changes and creates the APN setting. The APN setting is available as a configuration
unit on the Configuration Profile form.

Table 65: APN Settings Form

For more information about configuration profiles, see "Configuration Profiles" on page 219

Configuring Calendar (CalDAV) Settings

CalDAV settings you define can be used in configuration profiles for an iOS device. CalDAV accounts give a
provisioned device access to scheduling information on a remote server. A CalDAV setting includes its name
and description, the account description and hostname, port, principal URL, and whether SSL is enabled, as well
as additional account details. You can define multiple CalDAV settings.

APN settings are only supported on iOS devices; they are ignored by all other devices.
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To configure a CalDAV account, go to Onboard > Configuration > iOS Settings. Either click an existing
Calendar setting's name in the list; or click Add New, select Calendar Settings in the Settings Type drop-
down list, and click Create. The CalDAV Account Settings form opens.

Figure 122 The CalDAV Account Settings Form

Field Description

Name (Required) Enter a short name that identifies the CalDAV configuration clearly. CalDAV configuration
names can include spaces.
If you are duplicating a configuration, the original name has a number appended to it. You may
highlight this name and replace it with a new name.

Description Brief description of the calendar settings.

Account
Description

Display name for the account.

Account
Hostname

(Required) Enter the hostname or IP address of the CalDAV server.

Port (Required) Enter the port number of the CalDAV server.

Table 66: CalDAV Account Settings Form
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Field Description

Use SSL If selected, enables secure socket layer communication with the CalDAV server.

Account
Principal
URL

You may enter the principal URL for the CalDAV account.

Account
Details

(Required) Specifies how user account information should be supplied. Options include:
l User provided - entered by user on device
l Provisioning - values acquired during device provisioning
l Shared preset values - testing only

User If "Shared preset values - testing only" was chosen in the Account Details field, the form includes
these fields for login credentials. Enter the login information for testing in the User, Password, and
Confirm Password fields. The minimum password length is six characters.Password

Confirm

Save
Changes

Saves your changes and creates the CalDAV setting. The CalDAV setting is available as a
configuration unit on the Configuration Profile form.

Table 66: CalDAV Account Settings Form(Continued)

For more information about configuration profiles, see "Configuration Profiles" on page 219

Configuring Contacts (CardDAV) Settings

CardDAV settings you define can be used in configuration profiles for an iOS device. CardDAV accounts allow
users of a provisioned device to access and share contact data on a server. A CardDAV setting includes its name
and description, the account description and hostname, port, principal URL, and whether SSL is enabled, as well
as additional account details. You can define multiple CardDAV settings.

CardDAV account settings are only supported on iOS devices; they are ignored by all other devices.
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To configure a CardDAV account, go to Onboard > Configuration > iOS Settings. Either click an existing
CardDAV setting's name in the list; or click Add New, select Contacts Settings in the Settings Type drop-
down list, and click Create. The CardDAV Account Settings form opens.

Figure 123 The CardDAV Account Settings Form

Field Description

Name (Required) Enter a short name that identifies the contacts configuration clearly. Contacts
configuration names can include spaces.
If you are duplicating a configuration, the original name has a number appended to it. You may
highlight this name and replace it with a new name.

Description Brief description of the contacts settings.

Account
Description

Display name for the account.

Account
Hostname

(Required) Enter the hostname or IP address of the CalDAV server.

Port (Required) Enter the port number of the CardDAV server.

Table 67: CardDAV Account Settiings Form
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Field Description

Use SSL If selected, enables secure socket layer communication with the CardDAV server.

Account
Principal
URL

You may enter the principal URL for the CardDAV account.

Account
Details

(Required) Specifies how user account information should be supplied. Options include:
l User provided - entered by user on device
l Provisioning - values acquired during device provisioning
l Shared preset values - testing only

Username If "Shared preset values - testing only" was chosen in the Account Details field, the form includes
these fields for login credentials. Enter the login information for testing in the User, Password, and
Confirm Password fields. The minimum password length is six characters.Password

Confirm
Password

Save
Changes

Saves your changes and creates the CalDAV setting. The CalDAV setting is available as a
configuration unit on the Configuration Profile form.

Table 67: CardDAV Account Settiings Form(Continued)

For more information about configuration profiles, see "Configuration Profiles" on page 219

Configuring Device Restrictions Settings

Device Restrictions settings you define specify the activities that will be allowed and settings that will be
enabled on a provisioned device. A device restrictions setting includes its name and description, and the
applications, content settings, security and privacy settings, device functionality settings, iCloud settings, and
game center settings that will be enabled or disabled on the provisioned device.

Device Restrictions settings are only supported by iOS devices; they will be ignored by all other device types.

To create and work with Device Restrictions configurations, go to Onboard > Configuration > iOS Settings.
Either click an existing Device Restrictions setting's name in the list; or click Add New, select Device
Restrictions Settings in the Settings Type drop-down list, and click Create. The Device Restrictions
Settings form opens.

Figure 124 The Device Restrictions Settings Form, Basic Properties Area
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Field Description

Name (Required) Enter a short name that identifies the Device Restrictions configuration clearly. Device
Restrictions configuration names can include spaces.
If you are duplicating a configuration, the original name has a number appended to it. You may
highlight this name and replace it with a new name.

Description Brief description of the Device Restrictions settings.

Table 68: Device Restrictions Settings Form, Basic Properties Area

Figure 125 The Device Restrictions Settings Form, Applications Area
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In the Applications area, you can allow or enable application behavior.

Field Description

Allow
Installing
apps

If selected, enables the App Store. Users can install or update their apps.

Allow
Camera

If selected, enables the camera. Users can take photographs.

Allow Video
conferencing

If selected, allows the Facetime application.

Allow
YouTube

If selected, enables the YouTube app.
(Not available for iOS 6 or later.)

Allow iTunes If selected, enables the iTunes music store. Users can preview, purchase, and download content.

Allow
iBookstore

If selected, allows the use of iBookstore from the iBooks app.
(Only applies to supervised devices.)

Allow Open
in
Unmanaged
Apps

If selected, documents in managed apps and accounts can be opened in unmanaged apps and
accounts. If this option is deselected, documents in managed apps and accounts can only open in
other managed apps and accounts.
(Available only in iOS 7.0 and later.)

Allow Open
in Managed
Apps

If selected, documents in unmanaged apps and accounts can be opened in managed apps and
accounts. If this option is deselected, documents in unmanaged apps and accounts can only open
in other unmanaged apps and accounts.
(Available only in iOS 7.0 and later.)

Autonomous
single-mode
apps

App identifiers (bundle IDs) that are allowed to autonomously enter Single App Mode. Enter each
app identifier on a separate line.
(Only applies to supervised devices. Available only in iOS 7.0 and later.)

Table 69: Device Restrictions Settings Form, Applications Area

Figure 126 The Device Restrictions Settings Form, Safari Area
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Field Description

Allow Safari If selected, enables the Safari Web browser. Users can also open Web clips.

Enable Autofill If selected, enables autofill for Safari.

Fraud Warning If selected, users are warned when they visit fraudulent Web sites.

Enable JavaScript If selected, enables Javascript for Safari.

Block Pop-ups if selected, pop-up windows are blocked for Safari.

Accept Cookies Specifies when Safari should accept cookies. Options include:
l Never
l From visited sites
l Always

Table 70: Device Restrictions Settings Form, Safari Area

Figure 127 The Device Restrictions Settings Form, Content Settings Area

Field Description

Rating Region Specifies the region (country or territory) for content ratings.

Explicit Music and
Podcasts

If selected, allows music, videos, and podcasts containing explicit material.

Movies Specifies the maximum allowed rating for movies. Options include:
l Don’t allow movies
l G
l PG
l PG-13
l R
l NC-17
l All all movies

TV Shows Specifies the maximum allowed rating for TV shows. Options include:
l Don’t allow TV shows

Table 71: Device Restrictions Settings Form, Content Settings Area
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Field Description

l TV-Y
l TV-Y7
l TV-G
l TV-PG
l TV-14
l TV-MA
l Allow all TV shows

Apps Specifies the maximum allowed rating for apps. Options include:
l Don’t allow apps
l 4+
l 9+
l 12+
l 17+
l Allow all apps

Books If selected, allows download from the iBookstore of media that are tagged as
erotica.

Allow In-App Purchase If selected, apps can perform in-app purchases.

Force iTunes Password If selected, requires the user to enter their iTunes password for each transaction.

Table 71: Device Restrictions Settings Form, Content Settings Area(Continued)

Figure 128 The Device Restrictions Settings Form, Security and Privacy Settings Area

Field Description

Allow Diagnostic
Data

If selected, the device automatically submits diagnostic reports to Apple.

Prompt for
Untrusted TLS
Certificate

If selected, displays a prompt and allows the user to accept untrusted TLS certificates. If
deselected, the device automatically rejects untrusted TLS certificates without prompting the
user.

Force Encrypted
Backups

If selected, backups from the device are encrypted.

Table 72: Device Restrictions Settings Form, Security and Privacy Settings Area
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Field Description

Allow PKI
Updates

If selected, enables OTA PKI updates.
( Available only in iOS 7.0 and later.)

Limit Ad
Tracking

If selected, limits ad tracking.
(Available only in iOS 7.0 and later.)

Host Pairing If selected, enables host pairing.
If deselected, disables host pairing with the exception of the supervision host. If no
supervision host is configured, disables all host pairing.
(Only applies to supervised devices. Available only in iOS 7.0 and later.)

Table 72: Device Restrictions Settings Form, Security and Privacy Settings Area(Continued)

Figure 129 The Device Restrictions Settings Form, Device Functionality Settings Area
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Field Description

Screen Capture If selected, users can save a screenshot of the display.

Automatic Sync If selected, allows autosync while roaming.

Allow Assistant If selected, allows using Siri on the device.

Allow Assistant on Lock If selected, allows using Siri when the device is locked. This restriction only applies
if a passcode has been set on the device.

Allow Assistant for User-
Generated Content

If selected, allows Siri to query user-generated content from the Web.
(Only applies to supervised devices. Available only in iOS 7.0 and later.)

Allow Voice Dialing If selected, users can use the voice dialing feature.

Allow Fingerprint If selected, Touch ID can be used to unlock the device.
(Available only in iOS 7.0 and later.)

Allow Passbook on Lock If selected, Passbook notifications will be shown on the lock screen.

Control Center on Lock If selected, Control Center will appear on the lock screen.
(Available only in iOS 7.0 and later.)

Notifications View on Lock If selected, enables the Notifications view in the Notification Center on the lock
screen.
(Available only in iOS 7.0 and later.)

Today View on Lock If selected, enables the Today view in the Notification Center on the lock screen.
(Available only in iOS 7.0 and later.)

Configuration Profile
Installation

If selected, the user can install configuration profiles and certificates interactively.
(Only applies to supervised devices.)

Accounts If selected, accounts can be added, removed, or modified in Mail, Contacts, and
Calendars.
(Only applies to supervised devices. Available only in iOS 7.0 and later.)

Cellular Data Use If selected, allows changes to cellular data usage for apps.
(Only applies to supervised devices. Available only in iOS 7.0 and later.)

Find My Friends If selected, allows changes to the friends list and the current settings.
(Only applies to supervised devices. Available only in iOS 7.0 and later.)

Allow AirDrop If selected, enables AirDrop.
(Only applies to supervised devices. Available only in iOS 7.0 and later.)

Table 73: Device Restrictions Settings Form, Device Functionality Settings Area
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Figure 130 The Device Restrictions Settings Form, iCloud Settings Area

Field Description

Allow Backup If selected, allows backups to iCloud.

Allow Document Sync If selected, documents and key-values are synced to iCloud.

Allow Photo Stream If selected, allows photostream. If deselected, photostream is not allowed, which can
result in some data loss.

Allow Shared Photo
Streams

If selected, allows shared photo streams in iCloud.

Allow Keychain Sync If selected, keychain is synced to iCloud.
(Available only in iOS 7.0 and later.)

Table 74: Device Restrictions Settings Form, iCloud Settings Area

Figure 131 The Device Restrictions Settings Form, Game Center Settings Area

Field Description

Game Center If selected, enables Game Center and its icon is displayed on the Home screen.
(Only applies to supervised devices.)

Multiplayer Gaming If selected, allows multiplayer gaming on the device.

Game Center Friends If selected, allows adding Game Center friends.

Table 75: Device Restrictions Settings Form, Game Center Settings Area

When your changes are complete on the Device Restrictions Settings form, click Save Changes. The device
restrictions settings are available as a configuration unit on the Configuration Profile list view.
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Configuring Email Settings

Email settings you define can be used in configuration profiles for an iOS device. You can define multiple Email
settings.

Email settings are only supported on iOS devices; they are ignored by all other devices.

To configure email settings, go to Onboard > Configuration > iOS Settings. Either click an existing email
setting's name in the list; or click Add New, select Email Settings in the Settings Type drop-down list, and
click Create. The Email Settings form opens.

Figure 132 The Email Settings Form, Basic Properties and General Settings Area

Field Description

Name (Required) Short name that identifies the email setting clearly. Email settings names can include
spaces.
If you are duplicating an email settings, the original name has "Copy" appended to it. You may
highlight this name and replace it with a new name.

Description Brief description of the characteristics of the email settings.

Account
Description

Display name for the mail account.

Get Email
Address
From

(Required) Specifies how the user’s email address should be supplied. Options include:
l User provided - entered by user on device
l Provisioning - values acquired during device provisioning

Table 76: Email Settings Form, Basic and General Settings Areas
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Field Description

l Shared preset values - testing only
The fields available in the General Settings area will vary according to your choice in the this drop-
down list.

Email
Address

Full email address for the account.

Email
Address
Domain

Domain name to append to the username. For example, if the username is “user” and the domain is
“example.com”, the full email address would be “user@example.com”.

When to
Add Email
Address
Domain

Specifies when the email address domain should be added to the username. Options include:
l Only if username is not a valid email address
l Always add the domain

Allow Move If selected, allows the user to move messages out of the account into another account. If deselected,
messages may not be moved by the user, and the user also cannot forward or reply from a different
account than the one where the message originated.

Allow
Recent
Address
Sync

If selected, includes the account in recent address syncing.

Use Only
in Mail

If selected, outgoing mail for this account is only sent from the Mail app, and the account is not
available for sending mail in third-party applications.

Table 76: Email Settings Form, Basic and General Settings Areas(Continued)

Figure 133 The Email Settings Form, Incoming Mail Server Settings Area
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Field Description

Incoming Mail
Server

(Required) Hostname or IP address of the server for the incoming mail (for example,
mail.exampleprovider.com). The hostname will only be accepted if the corresponding IP address
can be resolved.

Port (Required) Click this field and use the counter to select the port number of the server for
incoming mail.

Use SSL If selected, enables secure socket layer communication with the server and ensures that
incoming communications are encrypted.

Authentication
Type

Specifies the authentication method for the incoming mail server. Options include:
l Password
l MD5 Challenge-Response
l NTLM
l HTTP MD5 Digest
l None

Account
Details

Specifies how user account information should be supplied. Options include:
l User provided - entered by user on device
l Provisioning - values acquired during device provisioning
l Shared preset values - testing only

Username If Shared preset values - testing only is selected in the Account Details drop-down list, the
Username field is added to the form. Enter the username for connecting to the server for
incoming mail.

Password If Shared preset values - testing only is selected in the Account Details drop-down list, the
password fields are added to the form. Enter the CalDAV password for connecting to the server
for incoming mail. The minimum password length is six characters.Confirm

Password

Table 77: Email Settings Form, Incoming Mail Server Settings Form

Figure 134 The Email Settings Form, Outgoing Mail Server Settings Area
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Field Description

Outgoing Mail
Server

(Required) Hostname or IP address of the server for the outgoing mail (for example,
smtp.exampleprovider.com).

Port (Required) Click this field and use the counter to select port number of the server to use for
outgoing mail.

Use SSL If selected, enables secure socket layer communication with the server and ensures that
outgoing communications are encrypted.

Authentication
Type

Specifies the authentication method for the outgoing mail server. Options include:
l Password
l MD5 Challenge-Response
l NTLM
l HTTP MD5 Digest
l None

Account Details Specifies how user account information should be supplied. Options include:
l User provided - entered by user on device
l Provisioning - values acquired during device provisioning
l Shared preset values - testing only

User Name If Shared preset values - testing only is selected in the Account Details drop-down list,
Username field is added to the form. Enter the username for connecting to the server for
outgoing mail.

Outgoing
Password Same
as Incoming

If selected, the same password is used for incoming and outgoing mail.

Use S/MIME If selected, the email account supports S/MIME.

Table 78: Email Settings Form, Outgoing Mail Server Settings Area

When you have completed your changes on this form, click Save Changes. The application set is available as a
configuration unit on the Configuration Profile list view.

For more information about configuration profiles, see "Configuration Profiles" on page 219

Configuring an iOS Device Passcode Policy

Passcode policy settings are typically used when you provision a corporate-owned device, or when a user is
given remote access to sensitive information. Passcode policy settings you define can be used in configuration
profiles for an iOS device. You can define multiple passcode policy settings.

Passcode policy settings are only supported by iOS devices; they are ignored by all other device types.
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To configure a passcode policy, go to Onboard > Configuration > iOS Settings. Either click an existing
passcode policy setting's name in the list; or click Add New, select Passcode Policy Settings in the Settings
Type drop-down list, and click Create. The Passcode Policy Settings form opens.

Figure 135 The Passcode Policy Settings Form
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Field Description

Name (Required) Short name that identifies the passcode policy clearly. Passcode policy names can
include spaces.
If you are duplicating a passcode policy, the original name has "Copy" appended to it. You may
highlight this name and replace it with a new name.

Description Brief description of the characteristics of the passcode policy.

Force PIN If selected, requires the user to create a passcode.

Allow Simple If selected, no restrictions are placed on the passcode for repeated or sequential characters. A
simple passcode can include repeated characters, or increasing or decreasing characters such
as 123 or CBA.

Require
Alphanumeric

If selected, the passcode must include alphabetic characters in addition to numbers.

Max Failed
Attempts

Use the counter to limit the number of times the passcode may be entered incorrectly before the
device is locked.

Max
Inactivity

Specifies the number of minutes the device is allowed to be idle before it is locked and the user
must re-enter the passcode. Options include:
l Unlimited
l 2
l 5
l 10
l 15
The user may set a lower number.

Max PIN Age Use the counter to specify a maximum duration for the passcode. After the specified number of
days, the device is locked and the user must change their passcode.

Min Complex
Chars

Specifies whether the passcode must include complex characters. Use the counter to specify how
many complex characters it must contain. Complex, or special, characters are non-alphanumeric,
such as &%$#.

Max Grace
Period

Specifies a maximum time in which the user may unlock the device without re-entering the
passcode. Use the counter to select a number of minutes. The user may set a lower number.

Min Length Use the counter to specify the minimum number of characters the passcode must include.

PIN History Specifies that when the user changes their passcode the new value cannot be one that was used
within a defined period of the passcode's history. Use the counter to specify the number of recent
passwords whose values will not be allowed.

Table 79: Passcode Policy Settings Form

When you have completed your changes on this form, click Save Changes. The passcode policy is available as
a configuration unit on the Configuration Profile form.

For more information about configuration profiles, see "Configuration Profiles" on page 219
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Configuring Calendar Subscription Settings

Subscribed calendar settings let you configure the calendar subscriptions that will be sent to the provisioned
device. A calendar subscription's settings include its name and description, the account description, server, and
whether SSL is enabled, as well as additional account details. Subscribed calendar settings you define can be
used in configuration profiles for an iOS device. You can define multiple subscribed calendar settings.

Subscribed calendar settings are only supported on iOS devices; they are ignored by all other devices.

To configure a calendar subscription setting, go to Onboard > Configuration > iOS Settings. Either click an
existing subscribed calendar setting's name in the list; or click Add New, select Subscribed Calendar Settings
in the Settings Type drop-down list, and click Create. The Subscribed Calendar Settings form opens.

Figure 136 The Calendar Subscription Settings Form
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Field Description

Name (Required) Short name that identifies this calendar subscription setting clearly. Calendar
subscription settings names can include spaces.
If you are duplicating a calendar subscription setting, the original name has "Copy" appended to it.
You may highlight this name and replace it with a new name.

Description Brief description of the characteristics of the calendar subscription setting.

Account
Description

Display name for the calendar subscription.

Server (Required) URL of the calendar file.

Use SSL If selected, enables secure socket layer communication with the server.

Account
Details

Specifies how user account information should be supplied. Options include:
l User provided - entered by user on device
l Provisioning - values acquired during device provisioning
l Shared preset values - testing only

Username If Shared preset values - testing only is selected in the Account Details drop-down list, the
username field is added to the form. Enter the username to be used for the subscribed calendar.

Password If Shared preset values - testing only is selected in the Account Details drop-down list, the
password fields are added to the form. Enter the password to be used for the subscribed calendar.
The minimum password length is six characters.Confirm

Password

Table 80: Calendar Subscription Settings Form

When you have completed your changes on this form, click Save Changes. The calendar settings are available
as a configuration unit on the Configuration Profile form.

For more information about configuration profiles, see "Configuration Profiles" on page 219

Configuring an iOS Device VPN Connection

Use VPN configuration profiles when you have deployed a VPN infrastructure and want to automatically
provide the secure connection settings to users at the time of device provisioning. You can automatically
configure virtual private network (VPN) settings on iOS and OS X 10.7+ devices. VPN settings you define can be
used in configuration profiles for an iOS device. You can define multiple VPN settings.

VPN configuration profiles are only supported by iOS and OS X 10.7+ (Lion or later) devices; they are ignored
by all other device types.

For information on configuring VPN connections, see:

l "Configuring an iOS Device VIA Connection " on page 208

l "Configuring an iOS Device L2TP, PPTP, or IPsec Connection " on page 212
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Configuring an iOS Device VIA Connection

Aruba VIA is a remote access solution that provides secure connections for Enterprise networks. VIA detects
the user’s network environment (trusted and un-trusted) and automatically connects the user to their
enterprise network.

To configure the Aruba VIA solution on an iOS device, go to Onboard > Configuration > iOS Settings. Either
click a VPN setting's name in the list; or click Add New, select VPN Settings in the Settings Type drop-down
list, and click Create. The VPN Settings form opens.

Figure 137 The VPN Settings Form, Basic and General Settings Areas for VIA

Field Description

Name (Required) Short name that identifies the VPN setting clearly. VPN configuration names can include
spaces.
If you are duplicating a VPN configuration, the original name has "Copy" appended to it. You may
highlight this name and replace it with a new name.

Description Brief description of the characteristics of the VPN configuration.

Connection
Type

(Required) Select Aruba VIA in the drop-down list. The VPN Settings form expands to include
additional options.

Table 81: VPN Settings Form, Basic and General Settings Areas
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Figure 138 The VPN Settings Form, Aruba VIA Settings Area

Field Description

Server (Required) Hostname or IP address of the server the device should connect to.

IKE Version Specifies the version number for the Internet Key Exchange (IKE) protocol. Options include:
l v2 - IKEv2 supports a wider variety of authentication mechanisms and it is faster when

compared to IKEv1 method. IKEv2 has only single phase authentication process
l v1 - This protocol performs the authentication in two phases.

Authentication Specifies the authentication type for the connection. The options available in this list depend on
the selection you made in the IKE Version field.
l If you choose the IKEv1 protocol, you can specify the following authentication types:

n Certificate – The client certificate issued during device provisioning will also be used as
the identity certificate for VPN connections. This option requires configuring your VPN
server to allow VIA authentication using a client certificate.

n Shared Secret / Group Name – An optional group name may be specified. A shared
secret (Pre-Shared Key) is used to establish the VIA connection. Authentication is
performed with a username and password.

l If you choose the IKEv2 protocol, you can specify the following authentication types. For VIA
deployments that use IKEv2, the VPN server always uses a certificate for IKEv2 authentication
phase. However, the devices can use certificates, EAP-MSCHAPv2, or EAP-TLS:
n Certificate

Table 82: VPN Settings Form, Aruba VIA Settings Area
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Field Description

n EAP-TLS
n EAP-MSCHAPv2

Internal IP Internal IP address assigned to the controller. This is used for SSL fallback and configuration
after the tunnel is set up.

DNS Suffix DNS domain name for the resolution of the internal resources.

Split
Tunneling

If selected, all the traffic to the VIA tunneled networks goes through the controller and the rest is
bridged directly on the device.

Split Tunnels If the Enable Split Tunnel option is selected, the Split Tunnels field is added to the form. You
must specify the addresses and netmask to which data will be tunneled through VIA. Click the
Add a tunnel to match link and enter the information for each IP address and netmask.

On Demand If selected, the VPN connection will be automatically established when accessing certain
domains.

On Demand
Match

If the Enable VPN on Demand option is selected, the On Demand Match field is added to the
form. You must specify the domain names and the on-demand action that need to be applied to
these domains. Click the Add a domain or host name to match link and enter the information
for each domain and action.

Table 82: VPN Settings Form, Aruba VIA Settings Area(Continued)

Figure 139 The VPN Settings Form, VIA Connection, Advanced Area
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Field Description

Show Advanced
Settings

If selected, the advanced configuration options for VIA are added to this form.

Hash Algorithm Hash algorithm to use. Options include:
l OAKLEY_SHA
l OAKLEY_SHA_256
l OAKLEY_SHA_384
l OAKLEY_SHA_512
l OAKLEY_MD5

Encryption Algorithm Encryption algorithm to use. Options include:
l OAKLEY_AES_CBC
l OAKLEY_3DES_CBC

DH Group Diffie-Hellman group to use. Options include:
l MODP1024
l MODP768
l ECP256
l ECP384

Phase2 Auth Algorithm Phase 2 authentication algorithm to use. Options include:
l SHA1
l MD5

Phase2 Encryption
Algorithm

Phase 2 encryption algorithm to use. Options include:
l AES
l GCM
l 3DES

PFS If selected, enables perfect forward secrecy.

Suite B If selected, enables Suite B cryptography.

FIPS If selected, enables FIPS mode for VIA.

VPN Custom Data Lets you enter VPN-specific custom data. Click the Add a new item link and enter the
key and value pairs.

Table 83: VPN Settings Form, VIA Connection, Advanced Area
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Figure 140 The VPN Settings Form, VIA Connection, Proxy Settings Area

Field Description

Proxy Setup Specifies the proxy server to use when the VPN connection is active. Options include:
l None — No proxy server will be configured with this VPN profile.
l Manual — A proxy server will be configured with this VPN profile. Specify the proxy server

settings in the Server and Port field.
l Automatic — The proxy server will be automatically configured with this VPN profile. Specify

the location of a proxy auto-config file in the Proxy Server URL field.

Proxy Server
URL

If Automatic was selected in the Proxy Setup field, enter the URL used to retrieve the proxy
settings.

Server and
Port

If Manual was selected in the Proxy Setup field, enter the hostname or IP address and the port
number of the proxy the device should connect to. The hostname will only be accepted if the
corresponding IP address can be resolved.

Authentication If authentication is required to access this proxy, enter the proxy username.

Password If authentication is required to access this proxy, enter the proxy password. The minimum
password length is six characters.

Confirm

Table 84: VPN Settings Form, VIA Connection, Proxy Settings Area

When you have completed your changes on this form, click Save Changes. The VPN configuration is
available as a configuration unit on the Configuration Profile form.

For more information about configuration profiles, see "Configuration Profiles" on page 219

Configuring an iOS Device L2TP, PPTP, or IPsec Connection

You can use VPN settings when you have deployed a VPN infrastructure and want to automatically provide the
secure connection settings to users at the time of device provisioning.
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To configure the L2TP, PPTP, or IPsec VPN settings, go to Onboard > Configuration > iOS Settings. Either
click a VPN setting's name in the list; or click Add New, select VPN Settings in the Settings Type drop-down
list, and click Create. The VPN Settings form opens.

Figure 141 The VPN Settings Form, Basic and General Settings Areas for L2TP, PPTP, or IPsec

Field Description

Name (Required) Short name that identifies the VPN setting clearly. VPN configuration names can include
spaces.
If you are duplicating a VPN configuration, the original name has "Copy" appended to it. You may
highlight this name and replace it with a new name.

Description Brief description of the characteristics of the VPN configuration.

Connection
Type

(Required) Select either L2TP, PPTP, or IPsec in the drop-down list, as appropriate. The VPN Settings
form expands to include additional options specific to that connection type.
l L2TP — Uses the Layer 2 Tunneling Protocol.
l PPTP — Uses the Point-to-Point Tunneling Protocol.
l IPsec — Uses the Internet Protocol with security extensions.

Table 85: VPN Settings Form, Basic and General Settings Areas for L2TP, PPTP, or IPsec
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Figure 142 The VPN Settings Form, Area for L2TP, PPTP, or IPsec Settings

The options available in the Settings area depend on your selection in the Connection Type field.

Field Description

Server (Required) Hostname or IP address of the server the device should connect to.

Override
Routing

If selected, overrides the primary route and sends all traffic through the VPN connection.

Encryption
Level

Specifies the level of data encryption to apply to the PPTP connection. Options include:
l None
l Automatic
l Maximum (128-bit)

Authentication
Type

(Required) Specifies the type of authentication to use for the IPsec connection. Options include:
l Identity Certificate — The client certificate issued during device provisioning will also be

used as the identity certificate for VPN connections. This option requires configuring your
VPN server to allow IPSec authentication using a client certificate.

l Shared Secret / Group Name — An optional group name may be specified. A shared
secret (Pre-Shared Key) is used to establish the IPsec VPN. Authentication is performed with a
username and password.

Group Name Group identity for the IPsec connection.

Shared Secret Shared secret for the L2TP or IPsec connection. If this field is left blank, the user will be prompted
to create the shared secret.

Confirm

Hybrid
Authentication

If selected, authentication for this IPsec connection will use the secret, name, and server-side
certificate.

Table 86: VPN Settings Form, Settings Area for L2TP, PPTP, or IPsec
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Field Description

Account User account for authenticating the connection. If this field is left blank, the user will be
prompted to enter the account information.

User
Authentication

Authentication type for the L2TP or PPTP connection. Options include: 
l Password
l RSA SecurID

Password
Prompt

Specifies whether the password for the IPsec connection must be entered every time. Options
include:
l Save and reuse the pasword — greater convenience
l Always ask for the password — greater security

Table 86: VPN Settings Form, Settings Area for L2TP, PPTP, or IPsec(Continued)

Figure 143 The VPN Settings Form, Proxy Settings Area

Field Description

Proxy Setup Specifies the proxy server to use when the VPN connection is active. Options include:
l None — No proxy server will be configured with this VPN profile.
l Manual — A proxy server will be configured with this VPN profile. Specify the proxy server

settings in the Server and Port field.
l Automatic — The proxy server will be automatically configured with this VPN profile. Specify

the location of a proxy auto-config file in the Proxy Server URL field.

Proxy Server
URL

If Automatic was selected in the Proxy Setup field, enter the URL used to retrieve the proxy
settings.

Server and
Port

If Manual was selected in the Proxy Setup field, enter the hostname or IP address and the port
number of the proxy the device should connect to. The hostname will only be accepted if the
corresponding IP address can be resolved.

Authentication If authentication is required to access this proxy, enter the proxy username.

Password If authentication is required to access this proxy, enter the proxy password. The minimum
password length is six characters.

Confirm

Table 87: VPN Settings Form, Proxy Settings Area
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When you have completed your changes on this form, click Save Changes. The VPN configuration is
available as a configuration unit on the Configuration Profile form.

For more information about configuration profiles, see "Configuration Profiles" on page 219

Configuring Web Clips

When you create a Web clip, you can make any URL look like a native app on your device. You can assign it an
icon, and when the icon is selected, the URL opens in its own frame. Web clip settings let you create a library of
Web clips and bookmarks that can be sent to the provisioned device. A Web clip's settings include its name and
description, the icon if one was chosen, the URL, and whether the user can remove it. Web clip settings you
define can be used in configuration profiles for an iOS device. You can define multiple Web clip settings.

Web clip settings are only supported on iOS devices; they are ignored by all other devices.

To configure a Web clip setting, go to Onboard > Configuration > iOS Settings. Either click an existing Web
clip setting's name in the list; or click Add New, select Web Clip Settings in the Settings Type drop-down list,
and click Create. The Web Clip Settings form opens.

Figure 144 The Web Clip Settings Form
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Field Description

Name (Required) Short name that identifies the Web clip clearly. Web clip names can include spaces.
If you are duplicating a Web clip, the original name has "Copy" appended to it. You may highlight this
name and replace it with a new name.

Description Brief Description of the characteristics of the Web clip.

Icon If an icon was uploaded through Configuration > Content Manager, it is displayed in this field.

URL The URL of the Web clip.

Removable If selected, the user can remove the Web clip.

Choose
New Icon

If selected, you can specify an icon for the Web clip. The form expands to include the Custom Icon
field.

Custom
Icon

If icon files have been uploaded in Content Manager, they are displayed in the Custom Icon field.
Highlight the icon to be used. If no images are displayed, upload your icon image or images to
Content Manager, and then return to this form. If no icon is assigned to the Web clip, a white square
is shown to the user.

Save
Changes

Saves your changes. The Web clip is available as a configuration unit on the Configuration Profile
form.

Table 88: Web Clip Settings Form

For more information about configuration profiles, see "Configuration Profiles" on page 219

Windows Applications

Application sets let you specify either individual apps or groups of apps that should be installed during device
provisioning, and indicate whether they should be restarted when the device is provisioned. After you define
each of the sets you wish to use, you can include them in configuration profiles. The configuration profiles are
available in the Provisioning Settings form, and can be associated with a device provisioning configuration
set.

To create and work with Windows application sets, go to Onboard > Configuration > Windows
Applications. The App Sets list view opens.

Figure 145 The App Sets List View

All Windows application sets that have been configured are included in the list. Each set's name is shown in the
list. You can click a Windows application set's row in the list for additional options.
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Field Description

Show
Details

Displays details for the Windows application set. The form expands to show its name, description, and
configuration values.

Edit Edit the Windows application set's configuration. The App Set form opens.

Duplicate Creates a copy of a Windows application set to use as a basis for a new set. The App Set form opens
with all attributes prepopulated and "Copy" appended to its name. You can rename the new app set,
and edit any of its attributes.

Delete Deletes the Windows application set. You will be asked to confirm the deletion.

Show
Usage

Displays a list of configuration profiles that use the Windows application set.

Create
new app
set

To create a new Windows application set, click this link above the table. The App Set configuration
form opens.

Table 89: The Windows App Set List

For information on configuring a Windows app set, see "Configuring App Sets" on page 218.

Configuring App Sets

Windows app sets you define let you specify an app or group of apps to be installed during device provisioning,
and whether an app requires the device to be restarted after provisioning.

To configure an app set, go to Onboard > Configuration > Windows Applications, and then either click the
Edit link for and app set in the list, or click the Create new app set link in the upper-right corner. The App Set
form opens.

Figure 146 The App Set Form
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Field Description

Name Short name that identifies the app set clearly. App set names can include spaces.
If you are duplicating an app set, the original name has "Copy" appended to it. You may highlight this
name and replace it with a new name.

Description Brief description of the characteristics of the app set.

Installers Apps you have downloaded to Content Manager are listed in this field.
l To specify that an app should be installed during provisioning, mark its Install application check

box.
l To specify that the device needs to be restarted after the app is installed, mark its Requires

restart check box.

Save
Changes

Saves your changes. The app set is available as a configuration unit on the Configuration Profile
form.

Table 90: App Set Form

To add or manage apps in Content Manager, click the Content Manager link above the form. You can
download apps to your system as content items, and then upload them to Content Manager.

For more information about configuration profiles, see "Configuration Profiles" on page 219

Deployment and Provisioning

Onboard lets you configure deployment and provisioning settings. Configuration profiles let you define the
profile settings that will be provisioned to devices, including configuration units. Provisioning settings let you
define the settings for device provisioning. The configuration profiles are available in the Provisioning Settings
form.

l To create and manage configuration profiles, see "Configuration Profiles" on page 219

l To create and manage provisioning settings, see "Provisioning Settings " on page 223

Configuration Profiles

Onboard lets you create and manage multiple configuration profiles to choose from for your captive portal
pages. To manage the configuration profiles that will be provisioned to onboarded devices, go to Onboard >
Deployment and Provisioning > Configuration Profiles. The Configuration Profiles list view opens.
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Figure 147 The Configuration Profile List View

All configuration profiles that have been created are included in the list. You can click a profile's row in the list
for additional options.

Field Description

Show Details Displays details of the configuration profile: The device's name and description, a list of the
configuration units that will be provisioned to it, and a list of supervised devices. For information
on configuration units, see "Onboard Configuration" on page 167.

Edit Opens the Configuration Profile form, where you can edit any of the configuration profile's
attributes.

Duplicate Creates a copy of the configuration profile to use as a basis for a new profile. The Configuration
Profile form opens with all attributes prepopulated and a number appended to the profile's name.
You can rename the new profile, and edit any of its attributes.

Delete Deletes the configuration profile. You will be asked to confirm the deletion. This option is not
available for the default profile or for configuration profiles that are currently used for device
provisioning.

Show Usage Displays a list of the provisioning settings that use the configuration profile. For more information,
see "Provisioning Settings " on page 223.

Create new
configuration
profile

Opens the Configuration Profile form, where you can create a new configuration profile.

Table 91: Configuration Profiles

For information on creating, editing, or duplicating a configuration profile, see "Creating and Editing
Configuration Profiles" on page 220.

Creating and Editing Configuration Profiles

To create or edit a configuration profile, go to Onboard > Deployment and Provisioning > Configuration
Profiles, and then either click the Create new configuration profile link or click the Edit or Duplicate link
for a profile in the list. The Configuration Profile form opens.
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Figure 148 The Configuration Profile Form
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Field Description

Name (Required) Short name that identifies the configuration profile clearly. Configuration
profile names can include spaces. If you are duplicating a profile, the original name has a
number appended to it. You may highlight this name and replace it with a new name.

Description Brief description of the characteristics of the profile.

AirPlay Specifies AirPlay settings to include in the profile. AirPlay settings in this list were created
on the Onboard > Configuration > iOS Settings > AirPlay Settings form. For more
information, see "Configuring AirPlay Settings" on page 184.

AirPrint Specifies AirPrint settings to include in the profile. AirPrint settings in this list were created
on the Onboard > Configuration > iOS Settings > AirPrint Settings form. For more
information, see "Configuring AirPrint Settings" on page 186.

Access Point Name
(APN)

Specifies APN settings to include in the profile. APN settings in this list were created on
the Onboard > Configuration > iOS Settings > APN Settings form. For more
information, see "Configuring APN Settings" on page 187.

App Set Specifies app sets to included in the profile. App sets in this list were created on the
Onboard > Configuration > Windows Applications form. For more information, see
"Configuring App Sets" on page 218.

Calendar Specifies calendar sets to include in the profile. Calendar sets in this list were created on
the Onboard > Configuration > iOS Settings > Calendar Settings form. For more
information, see "Configuring Calendar (CalDAV) Settings" on page 188.

Contacts Specifies contacts settings to include in the profile. Contacts settings in this list were
created on the Onboard > Configuration > iOS Settings > Contacts Settings form. For
more information, see "Configuring Contacts (CardDAV) Settings" on page 190.

Device Restrictions Specifies device restrictions settings to include in the profile. Device restrictions settings
in this list were created on the Onboard > Configuration > iOS Settings > Device
Restrictions Settings form. For more information, see "Configuring Device Restrictions
Settings" on page 192.

Email Specifies email settings to include in the profile. Email settings in this list were created on
the Onboard > Configuration > iOS Settings > Email Settings form. For more
information, see "Configuring Email Settings" on page 200.

Exchange ActiveSync Specifies Exchange ActiveSync settings to include in the profile. ActiveSync configuration
settings in this list were created on the Onboard > Configuration > iOS Settings >
Exchange ActiveSync Settings form. For more information, see "Configuring ActiveSync
Settings " on page 181.

Networks Specifies networks to include in the profile. Select the check box of each network to
include. Networks available here were created on the Onboard > Configuration
> Network Settings form. For more information, see "Configuring Basic Network Access
Settings " on page 169 and the related topics for the form.

Passcode Policy Specifies passcode policy settings to include in the profile. Passcode policy settings in this
list were created on the Onboard > Configuration > iOS Settings > Passcode Policy
Settings form. For more information, see "Configuring an iOS Device Passcode Policy " on
page 203.

Subscribed Calendar Specifies calendar subscription settings to include in the profile. Calendar subscription
settings in this list were created on the Onboard > Configuration > iOS Settings >
Calendar Subscription Settings form. For more information, see "Configuring Calendar

Table 92: Configuration Profile Form
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Field Description

Subscription Settings" on page 206.

VPN Settings Specifies VPN settings to include in the profile. VPN settings in this list were created on the
Onboard > Configuration > iOS Settings > VPN Settings form. For more information,
see "Configuring an iOS Device VPN Connection" on page 207.

Web Clips Specifies Web clip settings to include in the profile. This drop-down list is only available if
you have defined Web clip settings on the Onboard > Configuration > iOS Settings >
Web Clip Settings form. For more information, see "Configuring Web Clips" on page 216.

When you have completed your changes on this form, click Save Changes, the configuration profile is
included in the Configuration Profile drop-down list on the Provisioning Settings form and can be
associated with a device provisioning configuration set.

Provisioning Settings

The Provisioning Settings page lists all your device provisioning configuration settings, and lets you define
multiple device provisioning configurations for Onboard captive portal pages. You can assign different network
settings to each of them. You can also choose from a variety of configuration profiles you have already
defined, such as application sets, ActiveSync settings, passcode policies, or VPN settings.

To view the list of device provisioning configuration sets and work with them, go to Onboard > Deployment
and Provisioning > Provisioning Settings. The Provisioning Settings list view opens. All device
provisioning configuration settings that have been created are included in the list. Information shown for each
setting includes its name, Certificate Authority (CA), and the configuration profile assigned to it.

Figure 149 The Provisioning Settings List View

You can click a provisioning setting's row in the list for additional options:
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Field Description

Show
Details

Displays details of the provisioning setting. The form expands to show a summary of the settings
defined for it, including information for identity, authorization, supported devices, Web login page,
device provisioning, profile signing, and reconnect behavior.

Edit Opens the Device Provisioning Settings form. You can edit any of the provisioning setting's
attributes.

Duplicate Creates a copy of the provisioning setting to use as a basis for a new configuration. The Device
Provisioning Settings form opens with all attributes prepopulated and "Copy" appended to its
name. You can rename the new configuration, and edit any of its attributes.

Delete Deletes the provisioning set. You will be asked to confirm the deletion.

Test To view and test a device provisioning Web login page, this link opens the page in a new tab as it
would appear to a user. The default login page includes the username and password fields. If you
have configured sponsorship confirmation, it will also include the sponsor’s email field:

Create new
provisioning
settings

Opens the Device Provisioning Settings form, where you can create a new provisioning set.

Table 93: Provisioning Settings List View

For information on creating, editing, or duplicating a configuration profile, see "About Configuring Provisioning
Settings " on page 224.

About Configuring Provisioning Settings

On the Onboard > Deployment and Provisioning > Provisioning Settings list view, to modify a
provisioning set for Onboard captive portal pages, click its Edit link. To create a new provisioning set, click
the Create new provisioning settings link. The Device Provisioning Settings form opens with the
General tab displayed.

The configuration process is the same for editing an existing provisioning set and for creating a new set. The
Device Provisioning Settings form is divided into several tabs:
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Tab Description

General Specifies basic provisioning settings such as information about identity settings,
authorization, and actions. See "Configuring General Provisioning Settings" on
page 225.

Supported Devices Lets you specify the supported operating systems for which devices may be
enabled for provisioning, and specify some OS-specific or Web-based information.
See "Configuring Provisioning Settings for Supported Devices" on page 230.

Web Login Specifies options for the Web login captive portal page such as the page name,
redirect, authentication, labels and messages, skin, header and footer HTML,
configuration for logins through cloud identity or social network, and access
control. See "Configuring Provisioning Settings for the Web Login Page" on page
232.

Instructions & Messages Specifies text for labels and messages shown before, during, and after
provisioning. It includes general messages as well as sections for messages
specific to each operating system. See "Configuring Provisioning Settings for
Instructions and Messages" on page 242

iOS/macOS Profile Specifies options for Apple iOS and macOS device provisioning such as display
text, profile security, and certificate source. See "About Configuring Provisioning
Settings " on page 224.

Onboard Client Specifies options for Windows, Android, and legacy OS X (10.5/6) device
provisioning such as provisioning address and access, certificate validation, logo,
and support information. See "Configuring Options for Onboard Client Devices" on
page 264.

Sponsorship
Confirmation

Specifies sponsor confirmation and authentication, sponsor email configuration,
and UI overrides. See "Configuring Provisioning Settings for Sponsorship
Confirmation" on page 268"Configuring Provisioning Settings for Sponsorship
Confirmation" on page 268.

Configuring General Provisioning Settings

To configure basic provisioning settings, go to Onboard > Deployment and Provisioning > Provisioning
Settings. The Provisioning Settings list opens. Either click the Edit link for a configuration set in the list, or
click the Create new provisioning settings link to open the Provisioning Settings configuration form.
This form has several tabs. The first tab that opens is the General tab, and is used to specify basic information
about Onboard provisioning.

Figure 150 The General Tab, Device Provisioning Settings Form
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Field Description

Name (Required) Name of this configuration set. This name is used internally to identify this set of
Onboard settings for the network administrator. This value is never displayed to the user during
device provisioning.

Description Brief description of this configuration set. This description is used internally to identify this set of
Onboard settings for the network administrator. This value is never displayed to the user during
device provisioning.

Organization (Required) The name of your organization. This is displayed to the user during the device
provisioning process.

Table 94: Provisioning Settings, General Tab, Basic Information Area

Figure 151 The Provisioning Settings Form, General Tab, Identity and Authorization Areas

If you use Active Directory Certificate Services (ADCS), you might need to add your ADCS certificate to the Trust List.
When connecting to ADCS to issue an Onboard certificate, the server certificate is verified against the ClearPass
Trust List.
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Field Description

Certificate Authority (Required) Specifies the Certificate Authority (CA) used to sign profiles and
messages (see "Creating a New Certificate Authority" on page 120). Options
include:
l Local Certificate Authority
l SCEP-RA

Signer (Required) Specifies the source to use for signing TLS client certificates. Options
include:
l Onboard Certificate Authority
l Active Directory Certificate Services — The ADCS URL and ADCS Template

rows are added to the form. ACDS can only be used with certificate-based
authentication; it cannot be used with username/password authentication.

TLS Certificate Authority (Required) Specifies the Certificate Authority (CA) used to use to sign TLS client
certificates. Options include:
l Local Certificate Authority
l SCEP-RA

ADCS URL (Required) If Active Directory Certificate Services was chosen in the Signer field,
enter the URL of the ADCS server in the field. This URL should be the Web interface
for ADCS, and is typically http://<server>/certsrv/.

ADCS Template (Required) If Active Directory Certificate Services was chosen in the Signer field,
enter the name of the template to use when requesting the certificate. If the name
is not known, you can use the default name of "user".

Key Type (Required) Specifies the type of private key to use when issuing a new certificate.
Options include:
l 1024-bit RSA – created by server: Lower security. Not available in FIPS mode.
l 1024-bit RSA – created by device: Lower security. Uses SCEP to provision the

EAP-TLS certificate. Not available in FIPS mode.
l 2048-bit RSA – created by server: Recommended for general use.
l 2048-bit RSA – created by device: (Default) Recommended for general use.

Uses SCEP to provision the EAP-TLS certificate.
l 4096-bit RSA – created by server: Higher security.
l X9.62/SECG curve over a 256 bit prime field - created by server
l NIST/SECG curve over a 384 bit prime field - created by server
See Note below this table.

Unique Device Credentials (Required) If selected, includes the username as a prefix in the device's PEAP
credentials.

Table 95: Provisioning Settings Form, General Tab, Identity Area

Using a private key containing more bits will increase security, but will also increase the processing time required to
create the certificate and authenticate the device. The additional processing required will also affect the battery life
of a mobile device. It is recommended to use the smallest private key size that is feasible for your organization. The
“created by device” options use SCEP to provision the EAP-TLS device certificate, so the private key is known only to
the device rather than also known by the user. When a “created by device” option is selected, the generated key is
used instead of a username/password authentication defined in Network Settings.
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Field Description

Authorization Method Specifies the authorization method for devices. Options include:
l App Auth – check using Aruba Application Authentication
l RADIUS – check using a RADIUS request

Use SSO If selected, users will be required to authenticate using Single Sign-On (SSO).
(SSO support is enabled at Policy Manager > Configuration > Identity > Single
Sign-On.)

Configuration Profile (Required) Specifies the configuration profile to provision to devices. All
configuration profiles that have been created are included in this list. A
configuration profile specifies an application set, Exchange ActiveSync settings,
network settings, passcode policy, VPN, and other settings. For more information,
see "Onboard Configuration" on page 167.

Maximum Devices (Required) Enter a number to specify the maximum number of devices that each
user may provision. To be enrolled, a device must have a currently valid certificate,
and its status set to Allowed (at Onboard > Management and Control > View
by Device).

Table 96: Provisioning Settings Form, General Tab, Authorization Area

Figure 152 The Provisioning Settings Form, General Tab, Actions Area
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Field Description

Certificate Expiry Specifies that users will receive an email notification when their device's network
credentials are about to expire. The form expands to include options for configuring the
notification email.

Send Email
Notification

(Required) Specifies when to send the notification email. Options include:
l 1 week prior to expiration
l 2 weeks prior to expiration
l 3 weeks prior to expiration
l 4 weeks prior to expiration

If Email is Unknown (Required) Specifies action to take if the user's email address is not recorded with the
certificate. Options include:
l Do not send any message
l Send a message to a fixed email address
l Send a message to username@domain

Unknown Address Address to use when no email address is known for the user.

Unknown Domain Domain to append to the username to form an email address.

Subject Line (Required) Subject line for the notification email.

Email Message (Required) Plain text or HTML print template to use when generating the email message.
Options include:
l Account List
l Certificate Expiry
l Download Receipt
l GuestManager Receipt
l One account per page
l SMS Receipt
l Sponsorship Confirmation
l Two-column scratch cards

Email Skin (Required) Format to use for email receipts. Options include:
l Use the default skin
l No skin – Plain text only
l No skin – HTML only
l No skin – Native receipt format
l Aruba ClearPass Skin
l Blank Skin
l ClearPass Guest Skin
l Custom Skin 1
l Custom Skin 2
l Galleria Skin
l Galleria Skin 2

Send Copies (Required) Specifies how to send copies to the recipients in the Copies To list. Options
include:
l Do not send copies
l Always send using "cc:"

Table 97: Provisioning Settings Form, General Tab, Actions Area
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Field Description

l Always send using "Bcc:"

Revoke Inactive If selected, certificates for devices are revoked after a specified amount of time that the
device is not seen on the network.
You must have an Insight master node enabled with an appropriate data retention period
configured.

Inactivity Period (Required) Number of days that a device should be absent from the network before its
certificate is revoked.

Delete Duplicates If selected, old certificates from previous enrollments are automatically deleted.

Deletion Delay (Required) Number of days that should pass after re-enrollment before old (duplicate)
certificates are deleted.

Provisioning Address Hostname or IP address to use for device provisioning.

Click Next to proceed to the next tab, or Save Changes to complete your edits.

To return to the list of links to all Provisioning Settings tabs, see "About Configuring Provisioning Settings " on
page 224.

Configuring Provisioning Settings for Supported Devices
To configure which operating systems to support for device provisioning, and to specify some OS-specific or
Web-based information, go to Onboard > Deployment and Provisioning > Provisioning Settings,
expand the provisioning setting's row in the list, and click its Edit link. In the Device Provisioning Settings
form, click the Supported Devices tab.

When you enable a device operating system on the Supported Devices tab, fields are added for it on the
Instructions & Messages tab. You cannot configure instructions or instructions for a device type until it is
enabled on the Supported Devices tab.

Field Description

Android Provisioning Area

Android
Devices

If selected, enables Android devices for provisioning. An Android application is downloaded and
executed on the user’s device to complete provisioning.

Android
Rootkit
Detection

Specifies whether Android devices with a rootkit may be provisioned. Options include:
l Provision all devices— All Android devices will be provisioned.
l Do not provision rooted devices—Onboard will detect a jailbroken Android device and will not

provision the device if it has been compromised.

Android
Browser
Check

If selected, forces Android users to provision with the default browser (Chrome). A warning
message is displayed if a non-default browser is detected.

Chromebook Provisioning Area

Chromebook
Devices

If selected, enables Chromebook devices for provisioning. A certificate is provided to Chromebook
devices. The device must be under management and the QuickConnect extension must be
configured for pre-installation.

Table 98: Provisioning Settings, Supported Devices Configuration
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Field Description

Setup
Instructions

You must configure the Chromebook extension in the Google admin console. Go to Device
Management > Chrome > User Settings and configure Pre-installed Apps and Extensions.
Search for ClearPass Onboard in the Chrome Web Store and add it to the pre-installation list.

Chromebook
Token

Specifies the hardware token to store the certificates against. Options include:
l User-Specific
l System-Wide

iOS Provisioning Area

iOS Devices If selected, enables iOS devices for provisioning. The iOS devices are provisioned by Apple’s “Over-
the-Air” profile delivery process.

iOS Browser
Check

If selected, forces iOS users to use the default browser (Safari). A warning message is displayed if a
non-default browser is detected.

macOS Provisioning Area

macOS
Devices

If selected, enables macOS 10.7+ (Lion or later) devices for provisioning. The macOS devices are
provisioned by Apple’s “Over-the-Air” profile delivery process.

Profile Type Specifies the type of profile to create when provisioning macOS 10.7+ (Lion or later) devices.
Options include:
l User
l System

Legacy OS X Provisioning Area

OS X 10.5/6
Devices

If selected, enables OS X 10.5 (Leopard) and 10.6 (Snow Leopard) devices for provisioning. An OS X
application is downloaded and executed on the user’s device to complete provisioning.

Ubuntu Provisioning Area

Ubuntu
Devices

If selected, enables Ubuntu devices for provisioning. An Ubuntu application is downloaded and
executed on the user’s device to complete provisioning.

Windows Provisioning Area

Windows
Devices

If selected, enables Windows devices for provisioning. A Windows application is downloaded and
executed on the user’s device to complete provisioning.

Web-Based Provisioning Area

Web-Based
Devices

If selected, enables Web-based devices for provisioning. A certificate is generated for manual
installation on devices for which there is no Onboard client support.

Override Device Type Detection Area

Detection
Override

Specifies whether users can override browser device detection. In cases where a non-default
browser is used and the operating system can’t be detected, this option allows users to identify
their operating system in a drop-down list.

Table 98: Provisioning Settings, Supported Devices Configuration(Continued)

Click Next to proceed to the next tab, or Save Changes to complete your edits.
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To return to the list of links to all Provisioning Settings tabs, see "About Configuring Provisioning Settings "
on page 224.

Configuring Provisioning Settings for the Web Login Page
Onboard creates a default Web login page that is used to start the device provisioning process. You can
configure options such as the page name, redirect, authentication, labels and messages, skin, header and
footer HTML, logins through cloud identity or social networks, and access control.

To configure the Web login captive portal page, go to Onboard > Deployment and Provisioning
> Provisioning Settings, expand the provisioning setting's row in the list, and click its Edit link. In the
Provisioning Settings form, click the Web Login tab.

Basic and Login Form Areas

Figure 153 The Provisioning Settings Form, Web Login Tab, Basic and Login Form Areas

Field Description

Page Name (Required) The page name (filename) for the Web login page. This will be part of the URL for
accessing the page — for example, “/guest/page_name.php”.

Page Redirect Area

Security Hash Specifies the level of checking to apply to URL parameters passed to the Web login page. Use a
security hash to detect when URL parameters such as the MAC address have been modified by
the user. Security hash is not supported by all vendors. Options include:
l Do not check - login will always be permitted
l Permit login on validation error - validation errors will be logged
l Deny login on validation error - login will not be permitted

Table 99: Provisioning Settings Form, Web Login Tab, Basic and Login Form Areas
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Field Description

URL Hash Key (Required) The shared secret (64 characters) used by ClearPass and the NAD for the hash key to
validate the redirect URL. This must be entered twice in order to verify the key.

Confirm Key

Login Form Area

Authentication Specifies the authentication requirement. Options include:
l Credentials - Require a username and password
l Access Code – Only require username for authentication — Requires a single code

(username) to be entered, and requires the account to have the Username Authentication
field set.

l Anonymous – Do not require a username or password — Allows a blank form requiring
just the terms or a Log In button. Requires a pre-existing account, and requires the account to
have the Username Authentication field set.

l Auto – Do not require a username or password and automatically submit the page —
Similar to Anonymous, but the page is automatically submitted.

Auto-Generate If selected, auto-generates the anonymous account. The account is created without a session
limit or expiration time, and with the Guest role (ID 2).

Anonymous
User

(Required) Account to use for anonymous authentication. The password will be visible in the
HTML. The account Session Limit should be increased to the number of guests to be supported.
To use a specific username, enter it in this field. To randomly generate a user name, leave this
field blank.

Prevent CNA If selected, enables bypassing the Apple Captive Network Assistant (CNA). The CNA is the pop-up
browser shown when joining a network that has a captive portal. This option might not work with
all vendors; it depends on how the captive portal is implemented.

Custom Form If selected, you must provide your own HTML login form in the header and footer areas.

Custom Labels If selected, allows you to modify the login form's labels and error messages. The form expands
to include the Username Label, Password Label, and Log In Label fields. Complete these
fields with your customized label text.

Terms If selected, forces the user to accept a "Terms and Conditions" statement. The form expands to
include the Terms Label, Terms Text, Terms Layout, and Terms Error fields. Complete these
fields with your customized values.

Custom Fields You can click in this field to open a drop-down list where you can select additional fields to be
displayed on the login form. The values entered in these fields will be added to the subject alt-
name of the client’s certificate.
To configure sponsorship confirmation in order for a user to enroll their device, select Sponsor’s
Email: (sponsor_email) in this list, and then complete the Sponsorship Confirmation tab.

Table 99: Provisioning Settings Form, Web Login Tab, Basic and Login Form Areas(Continued)
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Login Page Area

Figure 154 The Provisioning Settings Form, Web Login Tab, Login Page Area

Field Description

Skin (Required) Specifies the skin to use for the Web login page. Options include:
l (Default)
l Aruba ClearPass Skin
l Blank Skin
l ClearPass Guest Skin
l Custom Skin 1
l Custom Skin 2
l Galleria Skin
l Galleria Skin 2

Title Title that will be displayed on the Web login page.

Header
HTML

Default text for the header and footer is shown in these fields and may be edited. You can also use the
drop-down lists in these fields to add images or other content items or to insert a self-registration link.

Footer
HTML

Table 100: Provisioning Settings Form, Web Login Tab, Login Page Area

ClearPass Guest 6.7 | User Guide Onboard | 234
Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2363



235 | Onboard ClearPass Guest 6.7 | User Guide

Cloud Identity Area

Figure 155 The Provisioning Settings Form, Web Login Tab, Cloud Identity Area: Enabling Cloud Identity or Social
Network Logins

Field Description

Enabled If selected, enables the use of cloud identity credentials to log in. The form expands to include
Authentication Providers configuration options.

Authentication
Providers

After you enable logins with cloud identity credentials, options in this area let you specify the
authentication provider and configure options for them.

Add new
authentication
provider

Opens the properties form for adding and configuring an authentication provider.

Buttons Shows the syntax for displaying cloud identity login buttons on the page. You must add
{nwa_social_logins} to either the HTML Header or HTML Footer area.

Debug If selected, cloud identity debugging will be included in the application log.

Table 101: Provisioning Settings Form, Web Login Tab, Cloud Identity Area: Enabling Cloud Identity or Social
Network Logins

Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2364



Figure 156 The Provisioning Settings Form, Cloud Identity Area, Authentication Providers Area (Facebook selected
as an example provider)
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Field Description

Provider (Required) Specifies the cloud identity authentication provider to use. All authentication providers
that have been configured are included in this list.
The following options presented in the Authentication Providers area depend on the provider
selected in this drop-down list.

Enabled If this check box is selected, the specified provider can be used.

Advanced If selected, displays additional options on this form.

Allow Guests (G Suite) If selected, allows Google accounts that are not part of your domain to log in as guests.
The social_vip flag will be set to false for these users.

Authorization
Code

(Required) (G Suite) When you generate a new code, it is automatically entered in this field, and
you can close the redirect window.

Auto Redirect If selected, local logins and other providers will not be supported. If this option is selected, we
recommend you also enable Custom Form in the Login Form area.

Clever Profile (Clever) If selected, access to the client’s full profile is requested and the Client ID must have
advanced privileges.

Client ID (Required) Client ID to use with this provider. The provider might use a different label.

Client Secret (Required) Client secret to use with this provider. The provider might use a different label.

Cloud
identity
whitelists
link

The Cloud identity whitelists for use in captive portals link opens Aruba's cloud identity
whitelists page of GitHub. GitHub is an external, third-party platform for hosting and sharing code.
You can use this page to access the latest whitelist entries for cloud identity providers that are
used by ClearPass for cloud logins and Onboarding.

Delete Removes the provider from the list and deletes its configuration. You will be asked to confirm the
deletion.

Destination URL to which guests authenticating with this provider will be redirected after logging in.

Disable Disables the provider. To enable it again, click the Enable link.

Disconnect
Action

(Facebook WiFi) For the Facebook Wi-Fi provider, specifies the action to take when a disconnect is
requested by Facebook. Options include:
l Terminate Session
l Cisco - Disable Host-Port
l Cisco - Bounce-Host-Port
l Cisco - Reauthenticate Session

District ID (Clever) Identifier for the school district. During authentication, this ID is compared to the
ID returned by a Clever Instant Login. If no value is entered in this field, Clever’s District Picker will
handle the details.

Edit Opens the Properties form. You can edit any of the configuration options for the provider.

Email If selected, allows access to the guest's email address. Access requires additional permission for
the provider.

Endpoint Specifies whether to create endpoint attributes, and how they will be handled. Options include:

Table 102: Provisioning Settings Form, Cloud Identity Area, Authentication Providers
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Field Description

Attributes l Do not create additional attributes
l Create Endpoint attributes converting any arrays to JSON
l Create Endpoint attributes flattening the entire data set
If one of the Create options is selected, an endpoint attribute is created for every attribute
returned by the user. This is only needed if you are creating specialized enforcement policies on
them.

Flatten
Prefix

If Endpoint Attributes was selected, you may enter text to prepend to all keys when flattening.
This stores a normalized version of all the returned attributes in the endpoint. If nothing is entered
in this field, the default "social" will be used.

Friends (Facebook) If selected, allows a list of the guest’s friends to be retrieved, if permission is granted
by the guest. The list is limited to only those friends who also use your application ID.

Generate
Code

(G Suite) To generate a new authorization code, click the link in this field. You will be redirected to
a new window to generate an authorization code.

Google Apps
VIP

Name of the user record attribute to apply to the social_vip flag. For more information, refer
to the Google Directory API for retrieving users.

Google
Groups

(G Suite) If selected, all groups associated with the account will be retrieved and stored as a list of
group names and a list of matching email addresses. The Admin SDK Refresh Token and
Authorization Code must also be regenerated.

Google Plus (Google) if selected, allows access to the guest's Google Plus profile. Access requires additional
permission for the provider.

Group
Membership

(Microsoft Azure AD) If selected, all groups associated with the account will be retrieved and
stored as a list of group names and a list of matching email addresses.

Hostname If specified, overrides the hostname guests are redirected to for authentication. This field is
optional; leave it empty if you are unsure.

Icon Label Overrides the default label on the provider's icon.

LinkedIn VIP (Linkedin) Enter a LinkedIn Distance value (0 - 3). If the guest is within this distance, the social_
vip flag will be enabled for them.

Move Up
Move Down

Moves the provider up or down in the list.

Notes You may enter additional notes or comments about the provider. This description is only seen by
administrators.

Scope Overrides the scope requested during OAuth. For syntax information, refer to the provider’s
documentation.

Twitter VIP (Twitter) Name of a Twitter account. If the guest follows this account, they will have the “social_vip”
flag enabled.

Username
Prefix

Text to prepend to all usernames. A prefix can be useful if you are providing a way to log in using a
variety of providers.
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Field Description

Username
Suffix

Text to append to all usernames. A suffix can be useful if you are providing a way to log in using a
variety of providers.

VIP Attribute (G Suite; Microsoft Azure AD) Name of the user record attribute to apply to the social_vip
flag. For more information, refer to the Microsoft Graph API for retrieving users.

Add When your entries are complete on the Properties form, click this button. The Properties form
closes and the provider is included in the Authentication Providers list.

Multi-Factor Authentication Area

Options in the Multi-Factor Authentication area let you require a secondary factor when authenticating.
When the guest enters their username to log in, they are sent a code which they must successfully retrieve and
enter to complete the login. For more information, see "About Multi-Factor Authentication" on page 420.

Figure 157 The Provisioning Settings Form, Web Login Tab, Multi-Factor Authentication Area

Field Description

Provider Specifies the mulit-factor authentication provider. Options include:
l No multi-factor authentication
l Duo Security - Two Factor Authentication
l Facial Network - ZOOM Multi-Factor Authentication
l Kasada - authenticator
l Kasada - authenticator (legacy)
l ImageWare Systems - Solutions Powered by GoVerifyID
l SMS Verification Codes

App Name (Required) App name to use with this provider.

Authentication Specifies the authentication order. Options include:

Table 103: Provisioning Settings Form, Web Login Tab, Multi-Factor Authentication Area
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Field Description

Order l Credentials and then device
l Device and then credentials

Client ID (Required) Client ID to use for this provider.

Duo AKEY (Required) A string that you should generate and keep secret from Duo. The string should be at
least 40 characters long. The Duo Web site provides tips for how to generate this key.

Duo API
Hostname

(Required) The Duo API hostname.

Duo
Integration
Key

(Required) The Duo ikey.

Duo Secret
Key

(Required) The Duo skey.

Email If selected, emails will be sent during application enrollment. If deselected, the user must scan
the QR code.

Enroll If selected, usernames will be automatically enrolled with the provider.

Factors The number of factors to require. For some providers, options are included to specify types of
factor, such as:
l photolock - The Photo
l fingerprint - The Fingerprint
l gridlock - The Pattern
l onetap - The Onetap
l password - The Password
To use your own defaults, leave this field empty.

Footer HTML HTML template code displayed after the provider’s vendor-specific authentication area. This is
the login “wait” page displayed to the user while the authentication code is sent to and submitted
by them. You can also use the drop-down lists to add images or other content items, or to insert
a self-registration link. To appear in this list, content items must first be uploaded to the Content
Manager.

Grace Period Specifies the number of hours between multi-factor authentication checks. If the user logs in
again before this interval expires, they can skip the secondary check if the device name and
username have not changed. To require full authentication every time, leave this field empty.
The default interval is 24 hours.

Header HTML HTML template code to display before the provider’s vendor-specific authentication area. This is
the login “wait” page displayed to the user while the authentication code is sent to and submitted
by them. You can also use the drop-down lists to add images or other content items, or to insert
a self-registration link. To appear in this list, content items must first be uploaded to the Content
Manager.

Hostname (Required) Hostname of the ImageWare server.

Message Message to display during verification.

Message
Expiration

Number of seconds a verification request should be valid.

Table 103: Provisioning Settings Form, Web Login Tab, Multi-Factor Authentication Area(Continued)
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Field Description

Password (Required) Password to use with this provider.

Phone
Attribute

(Required) For SMS Verification Codes, the attribute name containing mobile numbers. Names
should be entered as a comma-separated list. The order of the list determines the lookup
priority.

Role Your role ID.

Secret Key (Required) The Facial Networks client secret.

Service
Provider

Service provider to use when sending SMS messages.

Tenant Name (Required) Tenant name to use with the GoMobile provider. A tenant is a company or other entity
that has created a tenant account with ImageWare in order to use the GoMobile server for
security.

Username (Required) Username to use with this provider.

Verify
Template

The full URL of the verification template.

Table 103: Provisioning Settings Form, Web Login Tab, Multi-Factor Authentication Area(Continued)

Network Login Access Area

Figure 158 The Provisioning Settings Form, Web Login Tab, Network Login Access Area

Field Description

Allowed
Access

Enter the IP addresses and networks from which logins will be allowed. (IPv4 and IPv6 are both
supported)

Denied
Access

Enter the IP addresses and networks from which logins will be denied. (IPv4 and IPv6 are both
supported)

Deny
Behavior

(Required) Specifies the response shown to the user if their login request is denied. Options
include:

Table 104: Provisioning Settings Form, Web Login Tab, Network Login Access Area
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Field Description

l Send HTTP 404 Not Found status
l Show Access Denied page
l Show a blank page.

Table 104: Provisioning Settings Form, Web Login Tab, Network Login Access Area(Continued)

Click Next to proceed to the next tab, or Save Changes to complete your edits.

To return to the list of links to all Provisioning Settings tabs, see "About Configuring Provisioning Settings " on
page 224.

Configuring Provisioning Settings for Instructions and Messages
To configure the text for labels and messages shown before, during, and after provisioning, including messages
specific to each operating system, go to Onboard > Deployment and Provisioning, expand the provisioning
setting's row in the list, and click its Edit link. In the Device Provisioning Settings form, click the
Instructions & Messages tab.

To add the fields for a device’s operating system to the Provisioning Settings > Instructions & Messages tab, you
must first enable provisioning for that operating system on the Supported Devices tab.

This section describes the following areas on the Onboard > Deployment and Provisioning > Provisioning
Settings > Instructions & Messages tab:

l "Provisioning Instructions Area" on page 243

l "Device Status Area" on page 245

l "Android Instructions Area" on page 247

l "Chromebook Instructions Area" on page 249

l "iOS Instructions Area" on page 251

l "macOS Instructions Area" on page 253

l "Legacy OS X Instructions Area" on page 255

l "Ubuntu Instructions Area" on page 257

l "Windows Instructions Area" on page 259

l "Web-Based Instructions Area" on page 261
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Provisioning Instructions Area

Figure 159 The Provisioning Settings Form, Instructions & Messages Tab, Provisioning Instructions Area

Field Description

Provisioning
Device

Specifies how to configure the message that is shown to the user after they log in and during
provisioning. Options include:
l Use default message
l Use custom message

Provisioning
Message

Enter the instructions that are shown to the user after they log in and during provisioning. The text
can be entered as HTML code, and you can use Smarty template functions. If this field is left
empty, the default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.
To insert the configured device-specific message, you can use the {onboard_device_
message} Smarty template.

To insert a download link for the current step, you can use the {onboard_device_link}
Smarty template.

Complete,
Reconnected

Specifies how to configure the message that is shown to the user after enrollment is complete and
the device has automatically reconnected. Options include:
l Use default message
l Use custom message
Automatic reconnection is only supported by Android, iOS, Windows, and Ubuntu devices.
For iOS devices to reconnect, Insight must be enabled and a single-SSID setup must be used.

Complete,
Reconnected
Message

Enter the instructions that are shown to the user after enrollment is complete and the device has
automatically reconnected. The text can be entered as HTML code, and you can use Smarty
template functions. If this field is left empty, the default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Table 105: Provisioning Settings Form, Instructions & Messages Tab, Provisioning Instructions Area
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Field Description

To insert the configured device-specific message, you can use the {onboard_device_
message} Smarty template.

Complete,
Reconnect
Required

Specifies how to configure the message that is shown to the user after enrollment is complete and
the user must manually reconnect their device. Options include:
l Use default message
l Use custom message
Manual reconnection is required by Chromebook, macOS, and Web-based enrollments.
If Insight is not enabled or a dual-SSID setup is used, iOS devices also require manual
reconnection.

Complete,
Reconnect
Required
Message

Enter the instructions that are shown to the user after enrollment is complete and the user must
manually reconnect their device. The text can be entered as HTML code, and you can use Smarty
template functions. If this field is left empty, the default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.
To insert the configured device-specific message, you can use the {onboard_device_
message} Smarty template.

Table 105: Provisioning Settings Form, Instructions & Messages Tab, Provisioning Instructions Area(Continued)

To return to the list of links to all Provisioning Settings tabs, see "About Configuring Provisioning Settings "
on page 224.
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Device Status Area

Figure 160 The Provisioning Settings Form, Instructions & Messages Tab, Device Status Area

Field Description

Denied
Device

Specifies how to configure the error that is shown to the user when their device is denied access.
Options include:
l Use default message
l Use custom message

Denied
Device
Message

Enter the instructions that are shown to the user when their device is denied access. The text can
be entered as HTML code, and you can use Smarty template functions. If this field is left empty, the
default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Expired
Device

Specifies how to configure the message that is shown to the user when their device credentials
have expired. This message is displayed above the normal login page. Options include:
l Use default message
l Use custom message

Expired
Device
Message

Enter the instructions that are shown to the user when their device credentials have expired. The
text can be entered as HTML code, and you can use Smarty template functions. If this field is left
empty, the default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Override
Device
Detection

Specifies how to configure the message that allows the user to override the detected device type.
Options include:
l Use default message
l Use custom message

Reprovision
Device

Specifies how to configure the message that is shown to the user if their device is already enrolled.
Options include:
l Do not display a message, allow normal provisioning
l Use default message
l Use custom message

Table 106: Provisioning Settings Form, Instructions & Messages Tab, Device Status Area
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Field Description

Reprovision
Device
Message

Enter the instructions that are shown to the user if their device is already enrolled. The text can be
entered as HTML code, and you can use Smarty template functions. If this field is left empty, the
default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.
To insert a link to the provisioning page, you can use the {$reprovision_link} Smarty
variable.

Unsupported
Browser

Specifies how to configure the error that is shown to the user if they attempt to provision using an
unsupported browser. Options include:
l Use default message
l Use custom message

Unsupported
Browser
Message

Enter the instructions that are shown to the user if they attempt to provision using an unsupported
browser. The text can be entered as HTML code, and you can use Smarty template functions. If this
field is left empty, the default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.
To insert the name of the supported browser for the device, you can use the {$supported_
browser} Smarty variable.

Unsupported
Device

Specifies how to configure the error that is shown to the user if they attempt to provision an
unsupported device. Options include:
l Use default message
l Use custom message

Unsupported
Device
Message

Enter the instructions that are shown to the user if they attempt to provision an unsupported
device. The text can be entered as HTML code, and you can use Smarty template functions. If this
field is left empty, the default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Table 106: Provisioning Settings Form, Instructions & Messages Tab, Device Status Area(Continued)

To return to the list of links to all Provisioning Settings tabs, see "About Configuring Provisioning Settings "
on page 224.

ClearPass Guest 6.7 | User Guide Onboard | 246
Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2375



247 | Onboard ClearPass Guest 6.7 | User Guide

Android Instructions Area

To add the Android Instructions area to the Provisioning Settings > Instructions & Messages tab, you
must first enable Android provisioning on the Supported Devices tab.

Figure 161 The Provisioning Settings Form, Instructions & Messages Tab, Android Instructions Area

Field Description

Pre-Login Specifies how to configure the instructions that are shown to the user before they log in using an
Android device. Options include:
l Use default message
l Use custom message

Pre-Login
Message

Enter the instructions that are shown to the user before they log in using an Android device. The text
can be entered as HTML code, and you can use Smarty template functions. If this field is left empty,
the default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

App
Download

Specifies how to configure the instructions that are shown to the user when they are asked to
download the Android app. Options include:
l Use default message
l Use custom message

App
Download
Message

Enter the instructions that are shown to the user when they are asked to download the Android app.
The text can be entered as HTML code, and you can use Smarty template functions. If this field is left
empty, the default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Profile
Download

Specifies how to configure the instructions that are shown to the user when they are asked to
download the Android profile. Options include:
l Use default message
l Use custom message

Profile
Download
Message

Enter the instructions that are shown to the user when they are asked to download the Android
profile. The text can be entered as HTML code, and you can use Smarty template functions. If this field
is left empty, the default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Table 107: Provisioning Settings Form, Instructions & Messages Tab, Android Instructions Area
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Field Description

Installing
Profile

Specifies how to configure the instructions that are shown to the user while the Android profile is
installed. Options include:
l Use default message
l Use custom message

Installing
Profile
Message

Enter the instructions that are shown to the user while the Android profile is installed. The text can be
entered as HTML code, and you can use Smarty template functions. If this field is left empty, the
default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Complete Specifies how to configure the instructions that are shown to the user when Android provisioning is
complete. Options include:
l Use default message
l Use custom message

Complete
Message

Enter the instructions that are shown to the user when Android provisioning is complete. The text can
be entered as HTML code, and you can use Smarty template functions. If this field is left empty, the
default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Link Text Specifies how to configure the labels that are shown on download links during Android provisioning.
Options include:
l Use default labels
l Use custom labels

App Link
Command

Enter the short description that is shown for Android app download.

App Link
Text

Enter the detailed description that is shown for Android app download.

App Link
Skip

Enter the text to display on the link to skip the app download step.

Profile
Link
Command

Enter the short description that is shown for Android profile download.

Profile
Link Text

Enter the detailed description that is shown for Android profile download.

Table 107: Provisioning Settings Form, Instructions & Messages Tab, Android Instructions Area(Continued)

To return to the list of links to all Provisioning Settings tabs, see "About Configuring Provisioning Settings "
on page 224.
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Chromebook Instructions Area

To add the Chromebook Instructions area to the Provisioning Settings > Instructions & Messages tab,
you must first enable Chromebook provisioning on the Supported Devices tab.

Figure 162 The Provisioning Settings Form, Instructions & Messages Tab, Chromebook Instructions Area

Field Description

Pre-Login Specifies how to configure the instructions that are shown to the user before they log in using a
Chromebook device. Options include:
l Use default message
l Use custom message

Pre-Login
Message

Enter the instructions that are shown to the user before they log in using a Chromebook device. The
text can be entered as HTML code, and you can use Smarty template functions. If this field is left
empty, the default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Plugin
Launch

Specifies how to configure the instructions that are shown to the user when they are asked to launch
the Chromebook plugin. Options include:
l Use default message
l Use custom message

Plugin
Launch
Message

Enter the instructions that are shown to the user when they are asked to launch the Chromebook
plugin. The text can be entered as HTML code, and you can use Smarty template functions. If this field
is left empty, the default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Installing
Profile

Specifies how to configure the instructions that are shown to the user while the Chromebook
certificate is installed. Options include:
l Use default message
l Use custom message

Installing
Profile
Message

Enter the instructions that are shown to the user while the Chromebook certificate is installed. The
text can be entered as HTML code, and you can use Smarty template functions. If this field is left
empty, the default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Complete Specifies how to configure the instructions that are shown to the user when Chromebook provisioning
is complete. Options include:

Table 108: Provisioning Settings Form, Instructions & Messages Tab, Chromebook Instructions Area

Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2378



Field Description

l Use default message
l Use custom message

Complete
Message

Enter the instructions that are shown to the user when Chromebook provisioning is complete. The text
can be entered as HTML code, and you can use Smarty template functions. If this field is left empty,
the default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Link Text Specifies how to configure the labels that are shown on download links during Chromebook
provisioning. Options include:
l Use default labels
l Use custom labels

Plugin
Launch
Command

Enter the short description that is shown for Chromebook plugin launch.

Plugin
Launch
Text

Enter the detailed description that is shown for Chromebook plugin launch.

Table 108: Provisioning Settings Form, Instructions & Messages Tab, Chromebook Instructions Area(Continued)

To return to the list of links to all Provisioning Settings tabs, see "About Configuring Provisioning Settings "
on page 224.

ClearPass Guest 6.7 | User Guide Onboard | 250
Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2379



251 | Onboard ClearPass Guest 6.7 | User Guide

iOS Instructions Area

To add the iOS Instructions area to the Provisioning Settings > Instructions & Messages tab, you must
first enable iOS provisioning on the Supported Devices tab.

Figure 163 The Provisioning Settings Form, Instructions & Messages Tab, iOS Instructions Area

Field Description

Pre-Login Specifies how to configure the instructions that are shown to the user before they log in using an
iOS device. Options include:
l Use default message
l Use custom message

Pre-Login
Message

Enter the instructions that are shown to the user before they log in using an iOS device. The text
can be entered as HTML code, and you can use Smarty template functions. If this field is left empty,
the default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Root
Certificate
Download

Specifies how to configure the instructions that are shown to the user when they are asked to
download the iOS root certificate. Options include:
l Use default message
l Use custom message

Root
Certificate
Download
Message

Enter the instructions that are shown to the user when they are asked to download the iOS root
certificate. The text can be entered as HTML code, and you can use Smarty template functions. If
this field is left empty, the default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Profile
Download

Specifies how to configure the instructions that are shown to the user when they are asked to
download the iOS profile. Options include:
l Use default message
l Use custom message

Profile
Download
Message

Enter the instructions that are shown to the user when they are asked to download the iOS profile.
The text can be entered as HTML code, and you can use Smarty template functions. If this field is
left empty, the default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Table 109: Provisioning Settings Form, Instructions & Messages Tab, iOS Instructions Area
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Field Description

Installing
Profile

Specifies how to configure the instructions that are shown to the user while the iOS profile is
installed. Options include:
l Use default message
l Use custom message

Installing
Profile
Message

Enter the instructions that are shown to the user while the iOS profile is installed. The text can be
entered as HTML code, and you can use Smarty template functions. If this field is left empty, the
default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Complete Specifies how to configure the instructions that are shown to the user when iOS provisioning is
complete. Options include:
l Use default message
l Use custom message

Complete
Message

Enter the instructions that are shown to the user when iOS provisioning is complete. The text can
be entered as HTML code, and you can use Smarty template functions. If this field is left empty, the
default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Link Text Specifies how to configure the labels that are shown on download links during iOS provisioning.
Options include:
l Use default labels
l Use custom labels

Root
Certificate
Command

Enter the short description that is shown for iOS root certificate download.

Root
Certificate
Text

Enter the detailed description that is shown for iOS root certificate download.

Profile Link
Command

Enter the short description that is shown for iOS profile download.

Profile Link
Text

Enter the detailed description that is shown for iOS profile download.

Table 109: Provisioning Settings Form, Instructions & Messages Tab, iOS Instructions Area(Continued)

To return to the list of links to all Provisioning Settings tabs, see "About Configuring Provisioning Settings "
on page 224.
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macOS Instructions Area

To add the macOS Instructions area to the Provisioning Settings > Instructions & Messages tab, you
must first enable macOS provisioning on the Supported Devices tab.

Figure 164 The Provisioning Settings Form, Instructions & Messages Tab, macOS Instructions Area

Field Description

Pre-Login Specifies how to configure the instructions that are shown to the user before they log in using an
macOS device. Options include:
l Use default message
l Use custom message

Pre-Login
Message

Enter the instructions that are shown to the user before they log in using a macOS device. The text
can be entered as HTML code, and you can use Smarty template functions. If this field is left empty,
the default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Root
Certificate
Download

Specifies how to configure the instructions that are shown to the user when they are asked to
download the macOS root certificate. Options include:
l Use default message
l Use custom message

Root
Certificate
Download
Message

Enter the instructions that are shown to the user when they are asked to download themacOS root
certificate. The text can be entered as HTML code, and you can use Smarty template functions. If
this field is left empty, the default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Profile
Download

Specifies how to configure the instructions that are shown to the user when they are asked to
download the macOS profile. Options include:
l Use default message
l Use custom message

Profile
Download
Message

Enter the instructions that are shown to the user when they are asked to download the macOS
profile. The text can be entered as HTML code, and you can use Smarty template functions. If this
field is left empty, the default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Table 110: Provisioning Settings Form, Instructions & Messages Tab, macOS Instructions Area
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Field Description

Installing
Profile

Specifies how to configure the instructions that are shown to the user while the mac OS profile is
installed. Options include:
l Use default message
l Use custom message

Installing
Profile
Message

Enter the instructions that are shown to the user while the macOS profile is installed. The text can
be entered as HTML code, and you can use Smarty template functions. If this field is left empty, the
default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Complete Specifies how to configure the instructions that are shown to the user when macOS provisioning is
complete. Options include:
l Use default message
l Use custom message

Complete
Message

Enter the instructions that are shown to the user when mac OS provisioning is complete. The text
can be entered as HTML code, and you can use Smarty template functions. If this field is left empty,
the default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Link Text Specifies how to configure the labels that are shown on download links during macOS provisioning.
Options include:
l Use default labels
l Use custom labels

Root
Certificate
Command

Enter the short description that is shown for macOS root certificate download.

Root
Certificate
Text

Enter the detailed description that is shown for macOS root certificate download.

Profile Link
Command

Enter the short description that is shown for macOS profile download.

Profile Link
Text

Enter the detailed description that is shown for macOS profile download.

Table 110: Provisioning Settings Form, Instructions & Messages Tab, macOS Instructions Area(Continued)

To return to the list of links to all Provisioning Settings tabs, see "About Configuring Provisioning Settings "
on page 224.
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Legacy OS X Instructions Area

To add the Legacy OS X Instructions area to the Provisioning Settings > Instructions & Messages tab,
you must first enable Legacy OS X provisioning on the Supported Devices tab.

Figure 165 The Provisioning Settings Form, Instructions & Messages Tab, Legacy OS X Instructions Area

Field Description

Pre-Login Specifies how to configure the instructions that are shown to the user before they log in using a
legacy OS X device. Options include:
l Use default message
l Use custom message

Pre-Login
Message

Enter the instructions that are shown to the user before they log in using a legacy OS X device. The
text can be entered as HTML code, and you can use Smarty template functions. If this field is left
empty, the default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

App
Download

Specifies how to configure the instructions that are shown to the user when they are asked to
download the legacy OS X app. Options include:
l Use default message
l Use custom message

App
Download
Message

Enter the instructions that are shown to the user when they are asked to download the legacy OS X
app. The text can be entered as HTML code, and you can use Smarty template functions. If this field is
left empty, the default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Installing
Profile

Specifies how to configure the instructions that are shown to the user while the legacy OS X certificate
is installed. Options include:
l Use default message
l Use custom message

Installing
Profile
Message

Enter the instructions that are shown to the user while the legacy OS X certificate is installed. The text
can be entered as HTML code, and you can use Smarty template functions. If this field is left empty,
the default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Complete Specifies how to configure the instructions that are shown to the user when legacy OS X provisioning
is complete. Options include:

Table 111: Provisioning Settings Form, Instructions & Messages Tab, Legacy OS X Instructions Area
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Field Description

l Use default message
l Use custom message

Complete
Message

Enter the instructions that are shown to the user when legacy OS X provisioning is complete. The text
can be entered as HTML code, and you can use Smarty template functions. If this field is left empty,
the default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Link Text Specifies how to configure the labels that are shown on download links during legacy OS X
provisioning. Options include:
l Use default labels
l Use custom labels

App
Download
Command

Enter the short description that is shown for legacy OS X app download.

App
Download
Text

Enter the detailed description that is shown for legacy OS X app download.

Table 111: Provisioning Settings Form, Instructions & Messages Tab, Legacy OS X Instructions Area(Continued)

To return to the list of links to all Provisioning Settings tabs, see "About Configuring Provisioning Settings "
on page 224.
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Ubuntu Instructions Area

To add the Ubuntu Instructions area to the Provisioning Settings > Instructions & Messages tab, you
must first enable Ubuntu provisioning on the Supported Devices tab.

Figure 166 The Provisioning Settings Form, Instructions & Messages Tab, Ubuntu Instructions Area

Field Description

Pre-Login Specifies how to configure the instructions that are shown to the user before they log in using an
Ubuntu device. Options include:
l Use default message
l Use custom message

Pre-Login
Message

Enter the instructions that are shown to the user before they log in using an Ubuntu device. The text
can be entered as HTML code, and you can use Smarty template functions. If this field is left empty,
the default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

App
Download

Specifies how to configure the instructions that are shown to the user when they are asked to
download the Ubuntu app. Options include:
l Use default message
l Use custom message

App
Download
Message

Enter the instructions that are shown to the user when they are asked to download the Ubuntu app.
The text can be entered as HTML code, and you can use Smarty template functions. If this field is left
empty, the default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Installing
Profile

Specifies how to configure the instructions that are shown to the user while the Ubuntu certificate is
installed. Options include:
l Use default message
l Use custom message

Installing
Profile
Message

Enter the instructions that are shown to the user while the Ubuntu certificate is installed. The text can
be entered as HTML code, and you can use Smarty template functions. If this field is left empty, the
default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Complete Specifies how to configure the instructions that are shown to the user when Ubuntu provisioning is
complete. Options include:

Table 112: Provisioning Settings Form, Instructions & Messages Tab, Ubuntu Instructions Area
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Field Description

l Use default message
l Use custom message

Complete
Message

Enter the instructions that are shown to the user when Ubuntu provisioning is complete. The text can
be entered as HTML code, and you can use Smarty template functions. If this field is left empty, the
default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Link Text Specifies how to configure the labels that are shown on download links during Ubuntu provisioning.
Options include:
l Use default labels
l Use custom labels

App
Download
Command

Enter the short description that is shown for Ubuntu app download.

App
Download
Text

Enter the detailed description that is shown for Ubuntu app download.

Table 112: Provisioning Settings Form, Instructions & Messages Tab, Ubuntu Instructions Area(Continued)

To return to the list of links to all Provisioning Settings tabs, see "About Configuring Provisioning Settings "
on page 224.
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Windows Instructions Area

To add the Windows Instructions area to the Provisioning Settings > Instructions & Messages tab, you
must first enable Windows provisioning on the Supported Devices tab.

Figure 167 The Provisioning Settings Form, Instructions & Messages Tab, Windows Instructions Area

Field Description

Pre-Login Specifies how to configure the instructions that are shown to the user before they log in using a
Windows device. Options include:
l Use default message
l Use custom message

Pre-Login
Message

Enter the instructions that are shown to the user before they log in using a Windows device. The text
can be entered as HTML code, and you can use Smarty template functions. If this field is left empty, the
default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

App Down-
load

Specifies how to configure the instructions that are shown to the user when they are asked to
download the Windows app. Options include:
l Use default message
l Use custom message

App Down-
load Mes-
sage

Enter the instructions that are shown to the user when they are asked to download the Windows app.
The text can be entered as HTML code, and you can use Smarty template functions. If this field is left
empty, the default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Installing
Profile

Specifies how to configure the instructions that are shown to the user while the Windows certificate is
installed. Options include:
l Use default message
l Use custom message

Installing
Profile
Message

Enter the instructions that are shown to the user while the Windows certificate is installed. The text can
be entered as HTML code, and you can use Smarty template functions. If this field is left empty, the
default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Complete Specifies how to configure the instructions that are shown to the user when Windows provisioning is
complete. Options include:

Table 113: Provisioning Settings Form, Instructions & Messages Tab, Windows Instructions Area
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Field Description

l Use default message
l Use custom message

Complete
Message

Enter the instructions that are shown to the user when Windows provisioning is complete. The text can
be entered as HTML code, and you can use Smarty template functions. If this field is left empty, the
default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Link Text Specifies how to configure the labels that are shown on download links during Ubuntu provisioning.
Options include:
l Use default labels
l Use custom labels

App Down-
load Com-
mand

Enter the short description that is shown for Ubuntu app download.

App Down-
load Text

Enter the detailed description that is shown for Ubuntu app download.

Table 113: Provisioning Settings Form, Instructions & Messages Tab, Windows Instructions Area(Continued)

To return to the list of links to all Provisioning Settings tabs, see "About Configuring Provisioning Settings "
on page 224.
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Web-Based Instructions Area

To add the Web-Based Instructions area to the Provisioning Settings > Instructions & Messages tab,
you must first enable Web-based provisioning on the Supported Devices tab.

Figure 168 The Provisioning Settings Form, Instructions & Messages Tab, Web-Based Instructions Area

Field Description

Pre-Login Specifies how to configure the instructions that are shown to the user before they log in using a Web-
based device. Options include:
l Use default message
l Use custom message

Pre-Login
Message

Enter the instructions that are shown to the user before they log in using a Web-based device. The text
can be entered as HTML code, and you can use Smarty template functions. If this field is left empty, the
default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

App Down-
load

Specifies how to configure the instructions that are shown to the user when they are asked to
download the Web app. Options include:
l Use default message
l Use custom message

App Down-
load Mes-
sage

Enter the instructions that are shown to the user when they are asked to download the Web app. The
text can be entered as HTML code, and you can use Smarty template functions. If this field is left
empty, the default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Complete Specifies how to configure the instructions that are shown to the user when Web provisioning is
complete. Options include:
l Use default message
l Use custom message

Complete
Message

Enter the instructions that are shown to the user when Web provisioning is complete. The text can be
entered as HTML code, and you can use Smarty template functions. If this field is left empty, the
default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Link Text Specifies how to configure the labels that are shown on download links during Web-based provisioning.
Options include:

Table 114: Provisioning Settings Form, Instructions & Messages Tab, Web-Based Instructions Area
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Field Description

l Use default labels
l Use custom labels

App Down-
load Com-
mand

Enter the short description that is shown for Web-based certificate download.

App Down-
load Text

Enter the detailed description that is shown for Web-based certificate download.

Table 114: Provisioning Settings Form, Instructions & Messages Tab, Web-Based Instructions Area(Continued)

To return to the list of links to all Provisioning Settings tabs, see "About Configuring Provisioning Settings "
on page 224.

Configuring Provisioning Settings for iOS and macOS Profiles
To specify provisioning settings related to iOS and macOS devices, go to Onboard > Deployment and
Provisioning > Provisioning Settings, expand the provioning setting's row in the list, and click its Edit link.
On the Provisioning Settings form, click the iOS & macOS Profile tab.

Figure 169 The Provisioning Settings Form, iOS/macOS Profile Tab, iOS/macOS Provisioning Area
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Field Description

iOS and macOS Provisioning Area

Display
Name

Enter text for the title that is displayed on the “Install Profile” screen of the device.

Profile
Description

Enter text for the description that is displayed on the “Install Profile” screen of the device. This should
provide help text for the user and instruct them to install the profile.

Profile
Security

Specifies when the configuration profile may be removed. Options include:
l Always allow removal – The user may remove the configuration profile at any time, which will

also remove the associated device configuration and unique device credentials.
l Remove only with authorization – The user may remove the configuration profile if they also

provide a password. The administrator must specify the password in the Removal Password and
Confirm Removal Password fields.

l Never allow removal – The user cannot remove the configuration profile. This option should be
used with caution, as the only way to remove the profile is to reset the device to factory defaults,
and destroy all data on the device.

Removal
Password

If Remove only with authorization was selected in the Profile Security drop-down list, enter the
password to use when removing the profile. The minimum password length is six characters.

Confirm
Removal
Password

Edit ID To change the profile ID, select the check box in this row. The profile ID is a unique value associated
with the configuration profile. It is used to identify the configuration settings as being from a
particular source, and should be globally unique.
When an iOS device receives a new configuration profile that has the same profile ID as an existing
profile, the existing profile will be replaced with the new profile.

ID If the Change the profile ID check box is selected in the Edit ID row, you may edit the ID displayed
in this field. The ID is a reverse-DNS name used to uniquely identify the profile service. Changing the
ID will cause the reprovisioned device to install an additional profile - it does not update the existing
profile.

Table 115: Provisioning Settings Form, iOS/macOS Profile Tab, iOS/macOS Provisioning Area

Changing the profile ID will affect any device that has already been provisioned with the existing profile ID. The
default value is automatically generated and is globally unique. You should only change this value during initial
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configuration of device provisioning

Figure 170 The Provisioning Settings Form, iOS/macOS Profile Tab, Profile Signing Area

Field Description

Certificate
Source

Specifies how to obtain the certificate used to sign the iOS and macOS 10.7+ profiles. Options include:
l Generate using the Onboard CA -- This method establishes a trust chain when the CA

certificate is already installed.
l Use an uploaded certificate -- This method can be used for public access situations, and allows

a .mobileconfig profile to be signed using a public SSL certificate (for example, one issued by
VeriSign).

Common
Name

Enter the display name of the certificate used to sign the configuration profile. This certificate will be
automatically created by the certificate authority, and appears as the “Signed” field on the device
when the user authorizes the device provisioning.

Table 116: Provisioning Settings Form, iOS/macOS Profile Tab, Profile Signing Area

Click Next to proceed to the next tab, or Save Changes to complete your edits.

To return to the list of links to all Provisioning Settings tabs, see "About Configuring Provisioning Settings "
on page 224.

Configuring Options for Onboard Client Devices

The Onboard Client tab is used to edit basic configuration options for Windows, Android, and legacy OS X
(10.5 and 10.6) devices. This form is not used for iOS or OS X 10.7+ devices.

To specify provisioning settings related to Onboard-capable devices, go to Onboard > Deployment and
Provisioning > Provisioning Settings, expand the provisioning setting's row in the list, and click its Edit link.
On the Provisioning Settings form, click the Onboard Client tab.
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Figure 171 The Provisioning Settings Form, Onboard Client Tab
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Field Description

Code-
Signing
Certificat
e

Specifies the code-signing certificate to use for signing the Windows provisioning application.

Provision
ing
Address

Specifies the hostname or IP address to use for device provisioning. Options include:
l The system’s hostname (requires DNS resolution) – Select this option to use the system

hostname for device provisioning.

This option requires that the device be able to resolve the listed hostname at the time the device is
provisioned.

l The system’s IP address (network adapter name) – Select this option to use the IP address of the
system for device provisioning. The drop-down list includes one option for each of the IP addresses
detected on the system.

l Use this option when DNS resolution of the system’s hostname is not available for devices that are
in a provisioning role.

l Other IP address or hostname… – Select this option to override the hostname or IP address to be
specified during device provisioning. The administrator must enter the hostname or IP address in
the “Address” text field.

Use this option when special DNS or NAT conditions apply to devices that are in a provisioning role.

Address If you chose Other IP address or hostname in the Provisioning Address drop-down list, enter the
hostname or IP address to use for device provisioning.

Provision
ing
Access

This warning message is displayed when HTTPS is not required for guest access. HTTPS is
recommended for all deployments as it secures the unique device credentials that will be issued to the
device.

When using HTTPS for device provisioning, you must obtain a commercial SSL certificate. Self-signed
SSL certificates, and SSL server certificates that have been issued by an untrusted or unknown root
Certificate Authority, will cause iOS device provisioning to fail with the message “The server
certificate for … is invalid”.

Bypass
Proxy

If selected, the proxy server configured on the client will not be used during the Onboard enrollment
process.

Validate
Certificat
e

Specifies whether the SSL server’s certificate should be validated as trusted. Options include:
l Yes, validate this web server’s certificate (recommended) — If selected, a certificate

validation failure on the client device will cause device provisioning to fail. This is the default option.
l No, do not validate this web server’s certificate — Use this option only during testing, or if you

are waiting for a commercial SSL certificate.

Table 117: Provisioning Settings Form, Onboard Client Tab
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Field Description

Logo
Image

To display your enterprise’s logo in the provisioning wizard, select an image from the list in this field.
Go to Administration > Content Manager to upload new images to use as the logo.
The native size of the logo used in the QuickConnect client is 188 pixels wide, 53 pixels high. You may
use an image of a different size and it will be scaled to fit, but for the best quality results it is
recommended that you provide an image that is already the correct size.

Wizard
Title

Specifies the title displayed to users on the wizard for Windows or legacy OS X (10.5/6) devices.

Password
Recovery
URL

Helpdesk
URL

If provided, these fields may be used to provide additional resources to users who encounter trouble
in provisioning their devices.
Note: Ensure that users in the provisioning role can access these URLs.

Table 117: Provisioning Settings Form, Onboard Client Tab(Continued)

Click Next to proceed to the next tab, or Save Changes to complete your edits.

To return to the list of links to all Provisioning Settings tabs, see "About Configuring Provisioning Settings "
on page 224.
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Configuring Provisioning Settings for Sponsorship Confirmation
To specify provisioning settings related to sponsorship confirmation and UI overrides, go to Onboard
> Deployment and Provisioning > Provisioning Settings, expand the provisioning setting's row in the list,
and click its Edit link. On the Provisioning Settings form, click the Sponsorship Confirmation tab.

Sponsorship Confirmation Area

Figure 172 The Provisioning Settings Form, Sponsorship Confirmation Tab, Sponsorship Confirmation Area

Field Description

Enabled If selected, sponsor confirmation is required prior to enabling the account.
You must also add the field for the sponsor’s email to the login form as a custom field. See
"Configuring Provisioning Settings for the Web Login Page" on page 232.

Authentication If selected, the sponsor must successfully authenticate prior to approving the request. The
sponsor’s profile must include the Guest Manager > Remove Accounts privilege.

Email Field Specifies the attribute to use for field containing the sponsor’s email address. The default is
sponsor_email.

Email
Confirmation

Specifies the plain text or HTML print template to send to the sponsor for email confirmation.
The default is Sponsor Device Provisioning.

Email Skin Specifies the skin to use for email confirmations. Options include:
l No skin - Plain text only
l No skin - HTML only
l No skin - Native receipt format
l (Use the default skin
l Aruba ClearPass Skin
l Blank Skin
l ClearPass Guest Skin
l Custom Skin 1
l Custom Skin 2

Table 118: Provisioning Settings Form, Sponsorship Confirmation Tab, Sponsorship Confirmation Area
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Field Description

l Galleria Skin
l Galleria Skin 2

Send Copies Specifies when to send guest account receipts to the recipients in the Copies To list. Options
include:
l Do not send copies
l Always send using “cc:”
l Always send using “Bcc:”

Copies To List of email addresses to which copies of guest account receipts will be sent. To have the email
sent to the sponsor’s email address, enter _admin.

Reply-To If selected, the Reply- To Address will be overridden by the guest’s email field.

Override From If selected, the From Address will be overridden instead of using the Reply-To value. This might
require configuration of your mail server to allow the override.

Table 118: Provisioning Settings Form, Sponsorship Confirmation Tab, Sponsorship Confirmation Area
(Continued)
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UI Overrides Area

Figure 173 The Provisioning Settings Form, Sponsorship Confirmation Tab, UI Overrides Area

Field Description

UI Overrides If selected, the form expands to include fields for configuring overrides to UI text and labels.

Subject Line You may specify the template to use for the subject line for emailed guest account receipts. If this
field is left blank, the default will be used (Device provisioning request from: {if $email}{else}
{$username}{/if}).

Confirmation
Title

You may specify text to override the default page title. If this field is left blank, the default will be
used (Device Provisioning Request).

Header
HTML

You may enter HTML template code for the header that is displayed before the login form. If this
field is left empty, the default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Form
Override

If selected, allows overriding the form.

Confirm
Button

You may specify text to override the default confirm button. If this field is left blank, the default will
be used (Confirm).

Table 119: Provisioning Settings Form, Sponsorship Confirmation Tab, QuickAccess and UI Overrides Areas
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Field Description

Reject
Button

You may specify text to override the default reject button. If this field is left blank, the default will
be used (Reject).

Footer HTML You may enter HTML template code for the footer that is displayed after the confirmation form. If
this field is left empty, the default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Pending
Approval

You may enter HTML template code for the message that is displayed on the pending approval
page. If this field is left empty, the default text will be displayed.
You may use the Insert content item drop-down list to add an image file or link.

Table 119: Provisioning Settings Form, Sponsorship Confirmation Tab, QuickAccess and UI Overrides Areas
(Continued)

Click Next to proceed to the next tab, or Save Changes to complete your edits.

To return to the list of links to all Provisioning Settings tabs, see "About Configuring Provisioning Settings "
on page 224.

About the Self-Service Portal
The Onboard > Self-Service Portal page allows users to manage their onboarded BYOD devices without
requiring IT intervention.

Figure 174 The Self-Service Portal List View

The Self-Service Portal list displays Onboard devices. Select the type from the Device Type drop-down list in
the filter area. Information shown for each device includes the device's name, owner's name, device type, the
device's network access status, and the device ID (MAC address).

tLog in as the local user in the Self-Service portal to view the list of your devices. For more information on configuring
the local user credentials, see the section, Adding and Modifying Local Users in the latest ClearPass Policy Manager
User Guide.

Guest users can perform the following operations:

l View, enable, disable, or delete a device.

l Report a device as lost or stolen.

In addition, ClearPass operators can revoke a device’s client certificate.
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For more information on various device actions, see "Device Management (View by Device) " on page 141.
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Chapter 5
Configuration

ClearPass Guest’s Configuration editor lets you customize many aspects of the appearance, settings, and
behavior of the application. Areas you can customize include:

l Advertising services. See "Advertising Services" on page 482.

l Authentication settings. See "Configuring ClearPass Guest Authentication " on page 276.

l Content asset management. See "Content Manager" on page 276.

l Guest Manager configuration. See "Configuring Guest Manager " on page 280.

l Hotspot Manager. See "Hotspot Manager" on page 518.

l Pages, including:

n Fields, forms, and views in ClearPass Guest. See "Customizing Fields" on page 337 and "Customizing
Forms" on page 297.

n Guest self-registration processes and forms. See "Customizing Self-Registration" on page 348.

n Web login pages. See "Managing Web Logins" on page 403.

n Web pages. See "Managing Web Pages" on page 421.

l Receipts, including:

n Digital passes. See "Digital Passes" on page 429.

n Settings for emailing guest account receipts. See "Email Receipts and SMTP Services" on page 444.

n SMS guest account receipt settings. See "Customizing SMS Receipt" on page 451.

n Guest Manager print templates. See "Customizing Print Templates " on page 453.

l SMS services. See "SMS Services" on page 462.

l Translation packs. See "About Translations" on page 474.

Accessing Configuration
To access ClearPass Guest’s application customization features, click the Configuration link in the left
navigation.

Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2403



275 | Configuration ClearPass Guest 6.7 | User Guide
Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2404



Configuring ClearPass Guest Authentication
You can use the Configuration module to modify authentication settings for the ClearPass Guest application.

To configure ClearPass Guest’s authentication settings, go to Configuration > Authentication. The
Authentication Settings form opens.

Figure 175 The Authentication Settings Form

Field Description

Dynamic
Authorization

If selected, Guest sends automatic disconnect or re-authorization messages when enabled values
or role values change. This requires a network access server (NAS) type that supports RFC-3576.

NAS Type Specifies the default type for network access servers.

RFC-3576
Bind Address

To force a specific bind address for RFC-3576 requests, enter a value. This might be needed in an
AirGroup environment.

Internal Auth
Type

Specifies the RADIUS authentication type used for internal RADIUS requests. Options include:
l PAP
l CHAP
l MS-CHAP

Security If selected, redirects HTTP access to use HTTPS instead.

Save
Changes

Saves your changes.

Table 120: Authentication Settings Form

Content Manager

The Content Manager allows you to upload content items to ClearPass Guest. Content items are assets such as
text, images, and animations. To work with your content items, go to Configuration > Content Manager >
Start Here.

ClearPass Guest 6.7 | User Guide Configuration | 276
Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2405



277 | Configuration ClearPass Guest 6.7 | User Guide

Content assets are organized into private files and public files. Private files are only available within the
ClearPass application. Public files are accessible via HTTP/HTTPS for guest access using the application’s built-in
Web server.

This section includes:

l "Managing Content: Private Files and Public Files" on page 277

l "Uploading Content " on page 278

l "Downloading Content" on page 279

l "Creating a New Content Directory" on page 279

Managing Content: Private Files and Public Files
Content items are assets such as text, images, and animations. After you upload them to ClearPass, you can
use them in registrations, receipts, digital passes, and so on.

To use a content item, you can insert a reference to it into any custom HTML editor within the application. To
do this, select the content item you want to insert from the drop-down list located in the lower right corner of
the HTML editor. The item will be inserted using HTML that is most suited to the type of content inserted. To
manually reference a content item, you can use the URL of the item directly. For example, an item named
logo.jpg could be accessed using a URL such as: http://192.0.2.23/public/logo.jpg.

Content items are organized into two categories, private files and public files, and stored and accessed
separately:

l Private Files—Content items in the Private Files list are only available within the ClearPass application.
These files are not accessible to guests. To work with your private content items, go to Configuration >
Content Manager > Private Files. The Private Files list view opens.

l Public Files—Public files are accessible via HTTP/HTTPS for guest access using the application’s built-in Web
server. To work with your public content items, go to Configuration > Content Manager > Public Files.
The Public Files list view opens.

The list views and procedures are the same for both private and public files. Columns in the list show the
filename, owner, file type, last modification date, and file size.

Figure 176 The List Views for the Public Files and for the Private Files Are Similar
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Field Description

Upload New
Content

Add a new content item from your system. See "Uploading Content " on page 278.

Download New
Content

Add a new content item from another Web server. See "Downloading Content" on page 279.

Create New
Directory

Add a new subdirectory under the currently displayed directory. See "Creating a New Content
Directory" on page 279.

Properties Displays the content file's properties. Information includes the file's owner, filename,
description, type, image size, date modified, and file size.

Delete Deletes the content file from the directory. You will be asked to confirm the deletion.

Rename Modify the file's name or move it to another directory.

Download Download a copy of the file to your local Downloads folder.

View Content Opens a preview of the content item in a new browser tab.

Quick View Displays a preview of the content item within the file's row in the list.

Table 121: Content Files List View, Private Files or Public Files

Uploading Content
1. To add a new content item using your Web browser, go to Configuration > Content Manager, and then

go to either Private Files or Public Files, as appropriate. The list view opens. The procedures are the same
for both private and public files.

2. Click the Upload New Content tab . The Add Content form opens.

Figure 177 The Add Content Form

3. In the File row, click Browse to navigate to the file you wish to upload. The Maximum file size is 15 MB.

You can upload single content files, multiple content asset files and folders, or a Web deployment archive.
To upload multiple assets, first compress the files as a “tarball” or zip file, and then browse to it in the File
field. Allowed file formats are .tgz, .tar.gz, .tb2, .tar.bz2, or .zip. When you have uploaded the file, the
Extract option lets you create the new directory, navigate into it, and view and extract the files. Directory
structure is preserved when extracting.

4. You may enter a description of the content assets in the Description text area.
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5. To overwrite a previous file of the same name, mark the Overwrite check box.

6. Click Upload Content to upload the file.

If you clicked the Upload New Content link on the Private Files list view, the file is added to the private
directory in ClearPass. If you clicked the link on the Public Files list view, it is added to the public directory on
the Web server. You can reference the file when creating custom HTML templates.

Downloading Content
1. To add a new content item from the internet or another Web server, go to Configuration > Content

Manager, and then go to either Private Files or Public Files, as appropriate. The list view opens. The
procedures are the same for both private and public files.

2. Click the Download New Content tab. The Fetch Content form opens.

Figure 178 The Fetch Content Form

3. In the Content URL row, enter the URL of the content item to download. Allowed formats are HTTP,
HTTPS, and FTP only.

4. You may enter a description of the content assets in the Description text area.

5. To overwrite a previous file of the same name, mark the Overwrite check box.

6. Click Fetch Content to download the file.

If you clicked the Upload New Content link on the Private Files list view, the file is added to the private
directory in ClearPass. If you clicked the link on the Public Files list view, it is added to the public directory on
the Web server. You can reference the file when creating custom HTML templates.

Creating a New Content Directory
1. To add a new content subdirectory under either the private or public directory, go to Configuration >

Content Manager, and then go to either Private Files or Public Files, as appropriate. The list view
opens. The procedures are the same for both private and public files.

2. Click the Create New Directory tab. The Create New Directory form opens.
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Figure 179 The Create New Directory Form

3. In the New Filename row, enter the name for the new subdirectory.

4. You may enter a description of the directory in the Description text area.

5. Click Create Directory.

If you clicked the Create New Directory link on the Private Files list view, the subdirectory is added under
the private directory in ClearPass. If you clicked the link on the Public Files list view, it is added under the
public directory on the Web server. You can reference files in this subdirectory when creating custom HTML
templates.

Configuring Guest Manager

The Guest Manager module allows the entire guest account provisioning process to be customized. This is
useful in many different situations, such as:

l Self-registration — Allow your guests to self-register and create their own temporary guest accounts.

l Visitor surveys — Define custom fields to store data of interest to you, and collect this information from
guests using customized forms.

l Branded print receipts — Add your own branding images and text to print receipts.

l SMS and email receipts — Include a short text message with your guest’s username and password, or
send HTML emails containing images.

l Advanced customization — ClearPass Guest is flexible and can be used to provide location sensitive
content and advertising.

Default Settings for Account Creation
The Configure Guest Manager plugin configuration form lets you control the default settings for account
creation.

To modify settings for the Guest Manager plugin configuration, go to Configuration > Guest Manager. The
Configure Guest Manager form opens.

You can also access this form from the Administration > Plugin Manager > Guest Manager >
Configuration link.
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Figure 180 The Configure Guest Manager Form, Username Options Area

Field Description

Username
Type

(Required) Specifies the default method used to generate random account usernames (when creating
groups of accounts). This may be overridden by using the random_username_method field.

Username
Length

(Required) Default length of random account usernames (when creating groups of accounts). This
may be overridden by using the random_username_length field. This field is displayed if the
Username Type is set to “Random digits”, “Random letters”, “Random letters and digits” or “Sequential
numbering”.

Initial
Sequence

This field contains the next available sequence number for each username prefix that has been used.
Automatic sequence numbering is used when the value of the multi_initial_sequence field is set to -
1. The username prefix is taken from the multi_prefix field when usernames are automatically
generated using the “nwa_sequence” method. You can edit the values stored here to change the next
sequence numbers that will be used. This is an automatically managed field; in most situations there
is no need to edit it.

Table 122: Configure Guest Manager Form, Username Options Area

Figure 181 The Configure Guest Manager Form, Password Options Area
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Field Description

Random
Password
Type

(Required) Default method used to generate random account passwords (when creating groups of
accounts). This may be overridden by using the random_password_method field.

Random
Password
Length

(Required) Default length of random account passwords (when creating groups of accounts). This
may be overridden by using the random_password_length field.

Password
Complexity

(Required) Policy to enforce when guests change their account passwords using the guest self-
service user interface. Different levels of password complexity can require guests to select
passwords that contain different combinations of uppercase letters, lowercase letters, digits, and
symbols or special characters such as:
! @ # $ % ^ & * ( ) < > [ ] { } ' : ~ ` / \ | " + , - . ; = ? _
Options include:
l No password complexity requirement
l At least one uppercase and one lowercase letter
l At least one digit
l At least one letter and one digit
l At least one of each: uppercase letter, lowercase letter, digit
l At least one symbol
l At least one of each: uppercase letter, lowercase letter, digit, and symbol

Minimum
Password
Length

(Required) Minimum acceptable password length for guests changing their account passwords. The
original default password length is six characters.

Disallowed
Password
Characters

Special characters that should not be allowed in a guest password. Spaces are not allowed by
default. You can specify special characters, numbers, and letters to exclude from passwords—for
example, letters and numbers that can look similar, such as i, l, 1, 0, O, o, 5, S, 8, B.

Disallowed
Password
Words

Comma- separated list of words that are disallowed and will not be created by the random words
password generator.

Password
Logging

If selected, passwords for created guest accounts are logged in the application log and may be
recovered from there. For increased security, you may prevent this password from being logged by
deselecting this check box.

Password
Display

If selected, enables the display of guest account passwords in the user list. To reveal passwords, the
password field must be added to the “guest_users” or “guest_edit” view, and the operator profile in
use must also have the View Passwords privilege.

Table 123: Configure Guest Manager Form, Password Options Area
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Figure 182 The Configure Guest Manager Form, Expiration Options Area

Field Description

Expire
Action

(Required) Default action when the expiration time is reached. Available options available are:
l Disable at specified time
l Delete and logout at specified time
l Delete at specified time
l Disable and logout at specified time

Expiration
Options

(Required) The options that should be available to select from when choosing the expiration time of a
guest account (expire_after). These options are displayed as the values of the “Expires After” field
when creating a user account. Values are in hours for relative account expiration times.

Modify
Expiration
Options

(Required) The options that should be available to select from when modifying an account's expiration
(modify_expire_time). Some items may be dynamically removed based on the state of the account.

Lifetime
Options

(Required) The options that should be available to select from when choosing the lifetime for a guest
account (expire_postlogin). These options are displayed as the values of the “Account Lifetime” field
when creating a user account. Values are in minutes for relative account lifetimes.

Table 124: Configure Guest Manager Form, Expiration Options Area
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Figure 183 The Configure Guest Manager Form, Expiration Warning Options Area

Field Description

Account
Expiry
Warning

If selected, users will receive an email notification before their device's network credentials are
about to expire. Expiration warning configuration options are added to the form.

Account
Expiry
Notification

(Required) Number of days before account expiration that the notification email will be sent. You
may specify a number from 1 through 30.

If Email is
Unknown

(Required) Specifies where to send emails if the user's account does not have an email address
recorded. Options include:
l Do not send any message
l Send a message to a fixed email address
l Send a message to username@domain

Subject Line (Required) Enter the subject line for the notification email.

Table 125: Configure Guest Manager Form, Expiration Warning Options Area
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Field Description

Email
Message

(Required) Specifies the print template to use when generating the email message. Options
include:
l Account List
l Certificate Expiry
l Download Receipt
l Guest Account Expiry
l GuestManager Receipt
l One account per page
l SMS Receipt
l SMS Sponsor Confirmation Alert
l Sponsorship Confirmation
l Two-column scratch cards

Email Skin (Required) Specifies the format for the email receipts. Options include:
l No skin - Plain text only
l No skin - HTML only
l No skin - Native receipt format
l Use the default skin
l Aruba ClearPass Skin
l Blank Skin
l ClearPass Guest Skin
l Custom Skin 1
l Custom Skin 2
l Galleria Skin
l Galleria Skin 2

Send Copies (Required) Specifies when to send to recipients in the Copies To list. Options include:
l Do not send copies
l Always send using "cc:"
l Always send using "Bcc:"

Table 125: Configure Guest Manager Form, Expiration Warning Options Area(Continued)

Figure 184 The Configure Guest Manager Form, Receipt Options Area
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Field Description

Site
SSID

Public name of the wireless local area network (WLAN). The default setting for this field is Aruba, and
can be changed. The site SSID is displayed in the guest receipt as the WiFi Network, shown below this
table.

Site
WPA
Key

Encryption key used to secure the wireless network. If a value is entered in this field, it will appear on
guest print receipts.

Receipt
Printing

If selected, the receipt page provides a drop-down list of print templates and a Print link that must be
clicked to display the account receipt:

If this option is not selected, the default behavior is to provide a drop-down list of print templates and to
open a new window when one is selected:

Table 126: Configure Guest Manager Form, Receipt Options Area

Figure 185 Example Guest Receipt, Showing Site SSID Displayed as the WiFi Network
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Figure 186 The Configure Guest Manager Form, General Options Area

Field Description

Terms
of Use
URL

URL of a terms and conditions page provided to sponsors. The default, terms.php, displays the
preconfigured Web page provided at Configuration > Pages > Web Pages > Terms and Conditions.
You can edit that page, or you can use Content Manager to upload an HTML file describing the terms
and conditions of use (See "Managing Content: Private Files and Public Files" on page 277).
l If your site is hosted externally, be sure the proper access control lists (ACLs) are in place.
l If terms are required, it is best practice to edit the terms field on you forms to a UI type "hidden" and

an initial value of 1.

Active
Sessions

Default maximum number of active sessions that should be allowed for a guest account. This may be
overridden by using the simultaneous_use field when creating or editing a guest account.

About
Guest
Network
Access

Specifies the template code to display on the Guest Manager start page under the “About Guest
Network Access” heading.
l To use the default text, leave this field blank.
l To specify custom text, select an item in the drop-down list.
l To remove the default text and the heading, enter a single hyphen ( - ) in this field.

Table 127: Configure Guest Manager Form, General Options Area

About Fields, Forms, and Views
l A field is a named item of information. It may be used to display information to a user as static text, or it

may be an interactive field where a user can select an option or enter text.

l A form is a group of fields that is used to collect information from an operator.

l A view is a grouping of fields that is used to display information to an operator.

Business Logic for Account Creation
When guest accounts are created, there are certain rules that must be followed in order to create a valid
account. These rules apply to all accounts, regardless of how the account was created.

The business logic rules that control all guest account creation are described below. To see the display name
corresponding to a field name, go to Configuration > Pages > Fields and scroll to the field name. Display
names are shown in the Column Title column.

For information on customizing fields, see "Customizing Fields" on page 337.
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Verification Properties
The following table describes the verification properties fields for guest account creation at Configuration
> Pages > Fields.

Field Description

creator_
accept_
terms

This field must be set to 1, indicating the creator has accepted the terms of use for creating the
account. If the field is not present or is not set to 1, the guest account is not created.

password2 If this field is specified, its value must be equal to the “password” field, or else the guest account is not
created.

auto_
update_
account

If this field is present and set to a non-zero value, account creation will not fail if the username
already exists – any changes will be merged into the existing account using an update instead.

Table 128: Verification Properties Fields

Basic User Properties
The following table describes the basic user properties fields for guest account creation at Configuration
> Pages > Fields.

Field Description

username This field is the name for the guest account and may be provided directly. If this field is not
specified, then use the email address from the email field, and if that is also not specified, then
randomly generate a username (according to the value of the random_username_method and
random_username_length fields).

modify_
password

This field controls password modification for the guest account. It may be set to one of these
values:
l “reset” to randomly generate a new password according to the values of the random_

password_method and random_password_length fields
l “password” to use the password specified in the password field
l “random_password” to use the password specified in the random_password field
l If blank or unset, the default password behavior is used, which is to use any available value

from the random_password field and the password field, or assume that “reset” was
specified otherwise.

password This field is the password for the guest account and may be provided directly. If this field is not
specified, then randomly generate a password (according to the values of the random_
password_method and random_password_length fields).

role_id This field is the role to assign to the guest account and may be specified directly. If this field is not
specified, then determine the role ID from the role_name field. If no valid role ID is able to be
determined, the guest account is not created.

simultaneous_
use

This field determines the maximum number of concurrent sessions allowed for the guest
account. If this field is not specified, the default value from the GuestManager configuration is
used.

random_
username_
method

The method used to generate a random account username. If not specified, the default value
from the GuestManager configuration is used.

Table 129: Basic User Properties Fields
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Field Description

random_
username_
length

The length in characters of random account usernames. If not specified, the default value from
the GuestManager configuration is used.

random_
password_
method

The method used to generate a random account password. If not specified, the default value
from the GuestManager configuration is used.

random_
password_
length

The length in characters of random account passwords. If not specified, the default value from
the GuestManager configuration is used. The default password length is six characters.

Table 129: Basic User Properties Fields(Continued)

Guest Account Activation Properties
The following table describes the guest account activation properties fields for guest account creation at
Configuration > Pages > Fields.

Field Description

enabled This field determines whether the account is enabled or disabled; if not specified, the default is 1
(account is enabled).

do_
schedule

These fields are used to determine the time at which the guest account will be activated.
l If modify_schedule_time is “none”, then the account is disabled and has no activation time set.
l If modify_schedule_time is “now”, then the account is enabled and has no activation time set.
l If modify_schedule_time is a value that specifies a relative time change, for example “+1h”, then

the guest account’s activation time is modified accordingly.
l If modify_schedule_time is a value that specifies an absolute time, for example “2010-12-31

17:00”, then the guest account’s activation time is set to that value.
l If modify_schedule_time is “schedule_after” or “schedule_time”, then the activation time is

determined according to the schedule_after or schedule_time fields as explained below.
l If schedule_after is set and not zero, then add that time in hours to the current time and use it as

the activation time (setting do_schedule to 1); enabled will be set to zero.
l Otherwise, if schedule_after is zero, negative or unset, and schedule_time has been specified,

use that activation time (set do_schedule to 1 and enabled to 0). If the schedule_time specified is
in the past, set do_schedule to 0 and enabled to 1.

l Otherwise, if schedule_time if not specified, then the guest account has no activation time and do_
schedule will default to zero.

modify_
schedule_
time

schedule_
after

schedule_
time

Table 130: Guest Account Activation Properties Fields
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Guest Account Expiration Properties
The following table describes the guest account expiration properties fields for guest account creation at
Configuration > Pages > Fields.

Field Description

do_
expire

These fields are used to determine the time at which the guest account will expire.
l If modify_expire_time is “none”, then the account has no expiration time set.
l If modify_expire_time is “now”, then the account is disabled and has no expiration time set.
l If modify_expire_time is a value that specifies a relative time change, for example “+1h”, then the

guest account’s expiration time is modified accordingly.
l If modify_expire_time is a value that specifies an absolute time, for example “2010-12-31 17:00”,

then the guest account’s expiration time is set to that value.
l If modify_expire_time is “expire_after” or “expire_time”, then the expiration time is determined

according to the expire_after or expire_time fields as explained below.
l If expire_after is set and not zero and the account will be activated immediately, then add the value

in hours to the current time to determine the expiration time.
l If expire_after is set and not zero and account activation is set for a future time (schedule_time)

instead of the current time, then the expiration time is calculated relative to the activation time
instead of the current time.

l Otherwise, if expire_after is zero, negative or unset, and expire_time has been specified, use that
expiration time. If the expire_time specified is in the past, set do_expire to 0 and ignore the
specified expiration time.

l If the expire_timezone field is used in conjunction with expire_time and a time zone and date are
selected, the date calculation is adjusted relative to the time zone.

l Otherwise, if expire_time is not specified, then the expire_time is not set and do_expire will
always be set to zero.

l If the do_expire field is not included in the form, the default expiration action is 4, Logout and
Delete. This can be configured on the Customize Guest Manager page.

modify_
expire_
time

expire_
after

expire_
time

expire_
postlogin

This field determines the amount of time after the initial login for which the guest account will remain
valid. If this field is not specified, the default value is 0 (account lifetime not set).

expire_
usage

This field determines the total amount of login time permitted for the guest account. If this field is not
specified, the default value is 0 (account usage is unlimited).

Table 131: Guest Account Expiration Properties Fields

Other Properties
l All other properties specified at creation time are stored with the guest account (for example, email,

visitor_name, visitor_company, visitor_phone, sponsor_name as well as any custom fields that have
been defined).

Standard Fields
See "Field, Form, and View Reference" on page 738 for a listing of the standard fields shipped with ClearPass
Guest.
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Standard Forms and Views
The figure below shows the standard forms and views in the application.

Figure 187 Standard Forms and Views in the ClearPass Guest Application

The table below lists all the forms and views used for guest management.

Name Type Guest Management Function Editable?

change_expiration Form Change Expiration Yes

create_multi Form Create Multiple Yes

create_user Form Create Account Yes

guest_edit Form Edit Account Yes

guest_export View Export Accounts Yes

guest_multi View Edit Multiple Accounts Yes

guest_multi_form Form Edit Multiple Accounts Yes

guest_receipt Form Print Receipt No

guest_register Form Guest Self-Registration Yes

guest_register_receipt Form Guest Self-Registration Receipt Yes

guest_sessions View Active Sessions Yes

guest_users View List Accounts Yes

remove_account Form Remove Account No

reset_password Form Reset Password No

Table 132: Guest Management Forms and Views
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These forms are accessed directly:

l create_multi form – multiple account creation

l create_user form – sponsored account creation

l guest_register form – guest self-registration form

These forms are accessed through the action row of the guest_users view:

l change_expiration form – change expiration time for a single account

l guest_multi_form form – editing multiple accounts

l guest_edit form – editing single account

l reset_password form – reset password for a single account

These forms are the standard self-registration forms:

l guest_register form – self-registration form

l guest_register_receipt form – self-registration receipt

These standard views are defined in Guest Manager:

l guest_export view – view used when exporting guest account information

l guest_multi view – displays a list of guest accounts optimized for working with multiple accounts

l guest_sessions view – displays a list of current or historical sessions (See "Active Sessions Management" on
page 38.)

l guest_users view – displays a list of guest accounts optimized for working with individual accounts

Configuring Access Code Logins
This section explains how to configure Guest Manager to create multiple accounts that have the ability to log in
with only the username. We will refer to this as an Access Code.

Customize Random Username and Passwords

In this example we will set the random usernames and passwords to be a mix of letters and digits.

1. Go to Configuration > Guest Manager. The Configure Guest Manager form opens.

2. In the Username Type field, select Random Letters and digits. The generator matching the complexity
will also include a mix of upper and lower case letters.

3. In the Username Length field, select 6 characters.

4. Configure other settings. See "Default Settings for Account Creation" on page 280 for a description. Click
Save Configuration to save your changes.

Create the Print Template

By default, the print templates include username, password, and expiration, as well as other options. For the
purpose of access codes, we only want the username presented. This access code login example bases the print
template off an existing scratch card template.

1. Go to Configuration > Receipts > Templates.

2. Select Two-column scratch cards, and then click Duplicate.

3. Select the Copy of Two-column scratch cards template, and then click Edit.

4. In the Name field, substitute Access Code for Username as shown below.
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Figure 188 The Edit Print Template Form

5. Remove extraneous data from the User Account HTML field. Example text is shown below.
<table {$table_class_content}>

<thead>

<tr>

<th class="nwaTop" colspan="3">Access Details</th>

</tr>

</thead>

<tbody>

<tr>

<td class="nwaBody" rowspan="99" valign="top"><img src="images/icon-user48.png"

width="48" height="48" border="0" alt=""></td>

<th class="nwaLeft">Access Code</th>

<td class="nwaBody" style="width:12em">{$u.username|htmlspecialchars}</td>

</tr>

{if $u.create_result.error}

<tr>

<th class="nwaLeft">Error</th>

<td class="nwaBody"><span class="nwaError">{$u.create_result.message}</span></td>

</tr>

{/if}

</tbody>

</table>

6. Click Save Changes to save your settings.

7. To preview the new template, select the template in the Guest Manager Print Templates list, and then
click Preview. The template is displayed. The template created by the example text given above would look
like this:
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Figure 189 Example Template

Customize the Guest Accounts Form
Next, modify the Guest Accounts form to add a flag that to allows access-code based authentication.

1. Go to Configuration > Pages > Forms & Views.

2. In the Customize Forms & Views list, select create_multi and then click Edit Fields.

3. In the Edit Fields list, look for a field named username_auth. If the field exists but is not bolded and
enabled, select it and click Enable Field.

Figure 190 The username_auth Field in the Customize Form Fields List View

If the field does not exist, select any field in the list (for example, num_accounts) and then select Insert
After. Click the Field Name drop-down list, select username_auth and allow the page to refresh. The
defaults should be acceptable, but feel free to customize the label or description.

4. Click Save Changes to save your settings. After the field is enabled or inserted, you should see it bolded
in the list of fields.

Create the Access Code Guest Accounts
After the account fields have been customized, you can create new accounts.

1. Go to Guest > Create Multiple.

2. In the Create Multiple Guest Accounts form, select the check box in the Username Authentication
row that was added in the procedure above (see "Customize the Guest Accounts Form " on page 294). If
you do not select this check box and if the username is entered on the login screen, the authentication will
be denied. The example shown below will create 10 accounts that will expire in two weeks, or fours hours
after the guests first log in, whichever comes first.
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Figure 191 The Create Multiple Guest Accounts Form, Showing the Username Authentication Field

3. Click Create Accounts to display the Finished Creating Guest Accounts page. If you create a large
number of accounts, they are created at one time but might not all be displayed at the same time. (This will
not affect the printing action in the following step.)
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Figure 192 The Account Details Displayed for Multiple Accounts

4. Confirm that the accounts settings are as you expected with respect to letters and digits in the username
and password, expiration, and role.

5. Click the Open print window using template drop-down list and select the new print template you
created using this procedure See "Create the Print Template" on page 292 for a description of this
procedure. A new window or tab will open with the cards.
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Pages

The Pages area of the user interface lets you customize the pages that are available to guests and sponsors. To
work with pages configuration, go to Configuration > Pages > Start Here.

This section includes:

l "Customizing Fields" on page 337

l "Customizing Forms" on page 297

l "Customizing Self-Registration" on page 348

l "Managing Web Logins" on page 403

Customizing Forms

You can view a list of ClearPass Guest's forms. You can change the layout of forms, add new fields to a form, or
alter the behavior of an existing field.

To view or customize forms, go to Configuration > Pages > Forms. The Customize Forms list view opens.
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Figure 193 The Customize Forms List View

Various ClearPass Guest forms are included in the list, and are identified by their database field name and their
title (display name). You can click a form's row in the list or use the links provided on the page for additional
options:
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Field Description

Edit Edit a form's basic properties. The row expands to include the Edit Properties form. See "Editing
Forms and Views " on page 332.

Edit Fields Edit the form’s fields. The Customize Form Fields list view for the form opens. You can add a new
field to a form, reorder the fields, or make changes to an existing field. See "Editing Forms " on
page 301.Editing Views

Duplicate Creates a copy of the form to use as a template in order to provide different forms to different
operator profiles. See "Role-Based Access Control for Multiple Operator Profiles" on page 681 for a
description. This enables you to provide different views of the underlying guest accounts in the
database depending on the operator’s profile.
The form is copied and the new one is added to the list with a number appended to the end of its
name—for example, if you were to duplicate the change_expiration form, the duplicated form
would be change_expiration_1. This name cannot be changed. Use the Title and Description
properties of the duplicated item to describe the intended purpose for the form.

Show Usage Expands the row to display a list of operator profiles that reference the form. You can click an
operator profile’s name in this list to edit the form’s fields.

Translations Lets you edit field and label translations for the form in either a text file or a user interface page.

Customize
Fields

To customize fields used in the form, click this link in the upper right corner. The Customize Fields
list view opens. See "Customizing Fields" on page 337.

Table 133: The Customize Forms List

Editing Forms and Views

You can change the general properties of a form or view such as its title and description. To edit the form or
view, go to Configuration > Pages > Forms or to Configuration > Pages > List Views, click the form’s or
view’s row, and then click its Edit link. The row expands to include the Edit Properties form.
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Figure 194 The Edit Properties Form

Field Description

Name Filename of the page in the application.

Type Page type, either form or view.

Title Title of the form or view.

Description Brief description of the form or view.

Width Total width of the list view in pixels. If this field is left blank, a default value is used.
The Width field is only displayed for views.

Page Title Title that is displayed on the form or view in the user interface.

Header
HTML

HTML template code displayed before the form or view. You can use the drop-down list to add
images or links.

Footer HTML template code displayed after the form or view. You can use the drop-down list to add

Table 134: The Edit Properties Form
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Field Description

HTML images or links.

Translations Lets you edit field and label translations for the form in either a text file or a user interface page.

Save
Changes

Saves your changes to this form. On the Customize Forms page or the Customize List Views
page, an asterisk (*) is shown next to the form or view to indicate that it has been modified. To reset
it to default values, you can click the Reset to defaults link. You will be asked to confirm the
change. Resetting a form or view is a destructive operation and cannot be undone.

Table 134: The Edit Properties Form(Continued)

Editing Forms

To add a new field to a form, reorder the fields, or make changes to an existing field, go to Configuration >
Pages > Forms, click the form’s row in the list, and then click the Edit Fields link. The Customize Form
Fields list view opens and includes the fields that are used in the selected form.

Figure 195 The Customize Form Fields List View

Field Description

Rank Specifies the relative ordering of the fields when displaying the form. This list always shows
the fields in order by rank.

Field The name of the field in the database.

Type Controls what kind of user interface element is used to interact with the user.

Label or Title The label for this field as it is displayed on the form or view.

Description The description for this field as it is displayed on the form.

Table 135: Customize Form Fields

To work with a form field, click its row in the list. The row expands to include configuration options:
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Field Description

Edit Make changes to an existing field. The Form Field Editor opens. Any changes made to the
field using this editor will apply only to this field on this form. See "Form Field Editor " on page
302.

Edit Base Field Make changes to an existing field’s definition. The Edit Field form opens. Any changes made
to the field using this editor will apply to all forms that are using this field (except where the
form field has already been modified to be different from the underlying field definition). See
"Creating a Custom Field " on page 338.

Remove Removes the field from the form. To add a field back to the form after it has been removed,
use the Insert Before or Insert After option and select it from the Field Name drop-down list
in the Form Field Editor that opens.

Insert Before
Adds a new field to the form. Clicking one of these links opens a blank form field editor and
automatically sets the rank number of the new field.Insert After

Disable Field Disables this field on the form. To enable it on the form again, click Enable Field.

Preview Form Opens an example of the form so you can see what it looks like. This preview form can be
submitted to test the field validation rules you have defined. If all fields are able to be
validated, the form submit is successful and a summary of the values submitted is displayed.
This allows you to verify any data conversion and formatting rules you have set up.

Table 136: Customize Form Fields, Options

Form Field Editor

The Form Field Editor is used to control both the data gathering aspects and user interface characteristics of a
field.

To modify these aspects of a form field, go to Configuration > Pages > Forms, click a form’s row in the list,
click its Edit Fields link, click the field, and then click the field's Edit link. The Form Field Editor opens.

Figure 196 The Form Field Editor Form

Each field can only appear once on a form. The Field Name drop-down list specifies which underlying field is
being represented on the form. This also determines which options are available in the rest of the Form Field
Editor.

The rest of the Form Field Editor is split into three areas:

l Form Display Properties — See "Form Display Properties" on page 303

l Form Validation Properties — "Form Validation Properties" on page 319

l Advanced Properties — "Advanced Form Field Properties" on page 324
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Form Display Properties

Figure 197 The Form Field Editor Form, Form Display Properties Area

On the Form Field Editor (see "Form Field Editor " on page 302), the form display properties control the user
interface this field will have. Different options are available in this section, depending on the selection you
make in the User Interface drop-down list.

Fields with a green border use their base field's value. If you enter a different value to override the base field's value,
a Revert option lets you return to the original value.

The available user interface elements are described below, together with an example of each.

Use Default

If the (Use default) user interface option is selected, the default user interface type defined for the field will
be used.

No User Interface

If the No user interface option is selected, the field does not have a user interface specified. Using this value
will cause a diagnostic message to be displayed (“Form element is missing the ‘ui’ element”) when using the
form.
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CAPTCHA Security Code

If the CAPTCHA user interface is selected, a distorted image of several characters will be displayed to the user,
as shown below:

Figure 198 A CAPTCHA Code Image in a Field

A new image may be generated, or the image may be played as an audio sample for visually impaired users.
When using the recommended validator for this field (NwaCaptchaIsValid), the security code must be matched
or the form submit will fail with an error.

Figure 199 Form Display Properties Options for the CAPTCHA User Interface

Checkbox

If the Checkbox user interface is selected, a check box is displayed for the field, as shown below:

Figure 200 A Check Box in a Field

The check box label can be specified using HTML. If the check box is selected, the field is submitted with its
value set to the check box value (default and recommended value 1). If the check box is not selected, the field
is not submitted with the form.
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Figure 201 Form Display Properties Options for the Check Box User Interface

Checklist

If the Checklist user interface is selected, a list of check boxes is displayed, as shown below:

Figure 202 A Checklist in a Field

The text displayed for each check box is the value from the options list. Zero or more check boxes may be
selected. This user interface type submits an array of values containing the option key values of each selected
check box. Because an array value may not be stored directly in a custom field, you should use the conversion
and value formatting facilities to convert the array value to and from a string when using this user interface
type.

To store a comma-separated list of the selected values:

1. Enable the Advanced options.

2. In the Conversion drop-down list, select NwaImplodeComma.

3. In the Display Function drop-down list, select NwaExplodeComma.

4. In the Display Param field, enter the field’s name.
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The “Vertical” and “Horizontal” layout styles control whether the check boxes are organized in top-to-bottom or
left-to-right order. The default is “Vertical” if not specified. When using these options, you may also specify the
desired number of columns or rows to adjust the layout appropriately.

Figure 203 Form Display Properties Options for the Checklist User Interface
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Figure 204 Advanced Properties Options for the Checklist User Interface

For example, suppose the first two check boxes are selected (in this example, with keys “one” and “two”). The
incoming value for the field will be an array containing 2 elements, which can be written as array("one",
"two"). The NwaImplodeComma conversion is applied, which converts the array value into the string value
“one,two”, which is then used as the value for the field. Finally, when the form is displayed and the value needs
to be converted back from a string, the NwaExplodeComma display function is applied, which turns the
“one,two” string value into an array value array("one", "two"), which is used by the checklist to mark the
first two items as selected.

Date/Time Picker

If the Date/time picker user interface is selected, a text field is displayed with an attached button that
displays a calendar and time chooser. A date may be typed directly into the text field, or selected using the
calendar.

The text value typed is submitted with the form. If using a date/time picker, you should validate the field value
to ensure it is a date.

Certain guest account fields, such as expire_time and schedule_time, require a date/time value to be
provided as a UNIX time value. In this case, the conversion and display formatting options should be used to
convert a human-readable date and time to the equivalent UNIX time and vice versa.
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Figure 205 Advanced Properties for the Date/time picker User Interface

Drop-Down List

If the Drop-down list user interface is selected, the field is displayed allowing a single choice from a drop-down
list.

Figure 206 A Drop-Down List in a Field

The text displayed for each option is the value from the options list. When the form is submitted, the key of
the selected value becomes the value of the field.

If the Hide when no options are selectable check box is selected, and there is only a single option in the
drop-down list, it will be displayed as a static text item rather than as a list with only a single item in it.
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Figure 207 Form Display Properties Options for the Drop-down list User Interface

File Upload

If the File upload user interface is selected, a file selection text field and dialog box are displayed (the exact
appearance differs from browser to browser).

File uploads cannot be stored in a custom field. This user interface type requires special form implementation
support and is not recommended for use in custom fields.

Hidden Field

If the Hidden Field user interface is selected, the field is not displayed to the user, but is submitted with the
form. This option is often used to force a specific value such as a user’s role or an expiration date. However, it is
possible for someone to use browser tools to modify the initial value when the form is submitted. If the value
should be forced, use the Force Value setting under Advanced Properties to ensure the value cannot be
overridden. For more information, see "Advanced Form Field Properties" on page 324.

To set the value to submit for this field, use the Initial Value option in the Form Field Editor.
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Figure 208 Form Display Properties Options for the Hidden Field User Interface

Figure 209 Initial Values for a Form

Multiple Selection List

If the Multiple selection list user interface is selected, a list of selectable options will be displayed.

The text displayed for each check box or radio button is the value from the options list. Zero or more check
boxes may be selected. This user interface type submits an array of values containing the option key values of
each selected check box. Because an array value may not be stored directly in a custom field, you should use
the conversion and value formatting facilities to convert the array value to and from a string when using this
user interface type.

To store a comma-separated list of the selected values:

1. Enable the Advanced options.

2. In the Conversion drop-down list, select NwaImplodeComma.

3. In the Display Function drop-down list, select NwaExplodeComma.

4. In the Display Param field, enter the field’s name.

The “Vertical” and “Horizontal” layout styles control whether the check boxes are organized in top-to-bottom or
left-to-right order. The default is “Vertical” if not specified. When using these options, you may also specify the
desired number of columns or rows to adjust the layout appropriately.

ClearPass Guest 6.7 | User Guide Configuration | 310
Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2439



311 | Configuration ClearPass Guest 6.7 | User Guide

Figure 210 Form Display Properties Options for the Multiple selection list User Interface

Password Text Field

If the Password text field user interface is selected, the field is displayed as a text field, with input from the
user obscured. The text typed in this field is submitted as the value for the field.

Figure 211 A Text Field in a Form, with the User’s Entry Obscured
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Figure 212 Form Display Properties Options for the Password text field User Interface

Radio Buttons

If the Radio buttons user interface is selected, the field is displayed as a group of radio buttons, allowing one
to be selected, as shown below:

Figure 213 Radio Buttons in a Field

The text displayed for each option is the value from the options list. When the form is submitted, the key of
the selected value becomes the value of the field.
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Figure 214 Form Display Properties Options for the Radio buttons User Interface

The “Vertical” and “Horizontal” layout styles control whether the radio buttons are organized in top-to-bottom
or left-to-right order. The default is “Vertical” if not specified.

Static Text

If the Static text user interface is selected, the field’s value is displayed as a non-editable text string. An icon
image may optionally be displayed before the field’s value. A hidden element is also included for the field,
thereby including the field’s value when the form is submitted.

Figure 215 A Static Text Field in a Form

If the Hide when no options are selectable check box is selected in the Collapse row, the field will be
hidden if its value is blank.

To set the value of this field, use the Initial Value option in the Form Validation Properties area of the form
field editor.
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Figure 216 Form Display Properties Options for the Static text User Interface

Static Text (Raw Value)

If the Static text (Raw value) user interface is selected, the field’s value is displayed as a non-editable text
string. HTML characters in the value are not escaped, which allows you to display HTML markup such as
images, links and font formatting.

Figure 217 A Static Text Field in a Form, with HTML Formatting

Use caution when using this type of user interface element, particularly if the field’s value is collected from
guests. Allowing HTML from untrusted sources is a potential security risk.
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Figure 218 Form Display Properties Options for the Static text (Raw value) User Interface

If the Hide when no options are selectable check box is selected in the Collapse row, the field will be
hidden if its value is blank.

To set the value of this field, use the Initial Value option in the Form Validation Properties area of the form
field editor.

Static Text (Options Lookup)

If the Static text (Options lookup) user interface is selected, the value of the field is assumed to be one of
the keys from the field’s option list. The value displayed is the corresponding value for the key, as a non-
editable text string.

An icon image may optionally be displayed before the field’s value. A hidden element is also included for the
field, thereby including the field’s value when the form is submitted.

Figure 219 A Static Text Field in a Form, Displaying a Value from the Field’s Options List
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Figure 220 Form Display Properties Options for the Static text (Options lookup) User Interface

If the Hide when no options are selectable check box is selected in the Collapse row, the field will be
hidden if its value is blank.

To set the value of this field, use the Initial Value option in the Form Validation Properties area of the form
field editor.

Static Group Heading

If the Static group heading user interface is selected, the label and description of the field is used to display a
group heading on the form, as shown below. The field’s value is not used, and the field is not submitted with
the form.

Figure 221 A Group Heading on a Form

When using this user interface element, it is recommended that you use the “nwaImportant” CSS class to
visually distinguish the group heading’s title.
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Figure 222 Form Display Properties Options for the Static group heading User Interface

Submit Button

If the Submit button user interface is selected, the field is displayed as a clickable form submit button, with
the label of the field as the label of the button.

Figure 223 A Button on a Form

Figure 224 Form Display Properties Options for the Submit button User Interface

The description is not used. The field’s value is ignored, and will be set to NULL when the form is submitted. To
place an image on the button, an icon may be specified.

To match the existing user interface conventions, you should ensure that the submit button has the highest
rank number and is displayed at the bottom of the form.
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Text Area

If the Text area user interface is selected, the field is displayed as a multiple-line text box. The text typed in
this box is submitted as the value for the field.

Figure 225 A Text Area on a Form

Figure 226 Form Display Properties Options for the Text area User Interface

We recommend that you specify the desired minimum dimensions of the text area, either with the Rows and
Columns options, or by specifying a width in the CSS Style option (for example, “width: 460px; height:
100px;” specifies a 460 x 100 pixel minimum area).

Text Field

If the Text field user interface is selected, the field is displayed as a single-line text box. The text typed in this
box is submitted as the value for the field.

Figure 227 A Text Field on a Form

A short text label may be placed after the text box using the Label After option. This field allows you to
specify HTML (using Smarty template syntax) instead of plain text to be displayed after the input field.

ClearPass Guest 6.7 | User Guide Configuration | 318
Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2447



319 | Configuration ClearPass Guest 6.7 | User Guide

Figure 228 Form Display Properties Options for the Text field User Interface

If you select Text or Password as the User Interface type, the Placeholder row is added to this form. You
may use this field to enter a temporary value, such as a hint for how to complete the field, that can later be
overridden by the user completing the form that uses this field.

Form Validation Properties
On the Form Field Editor (see "Form Field Editor " on page 302), the form validation properties control the
validation of data entered into a form. By specifying appropriate validation rules, you can detect when users
attempt to enter incorrect data and require them to correct their mistake. All fields must be successfully
validated before any form processing can take place. This ensures that the form processing always has user
input that is known to be valid.

Figure 229 Form Field Editor, Form Validation Properties Area
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Field Description

Field
Required

If selected, the field cannot be omitted or left empty. Required fields are marked with an asterisk, as
shown below:

All values supplied for a required field are always validated, including blank values.
An optional field may be left blank. In this case, the field is not validated as there is no value for the
field. However, any value that is supplied for an optional field is subject to validation checks.

Initial
Value

Initial value for the form field. Use this option when a field value has a sensible default. The initial
value should be expressed in the same way as the field’s value. In particular, for drop-down list and
radio button selections, the initial value should be the key of the desired default option. Likewise, for
date/time fields that have a display function set, the initial value should be a value that can be passed
to the display function.

Validator (Required) Specifies the validator function for the field. See "Form Field Validation Functions" on page
751 for a description of the built-in validators.

Validator
Param

Specifies the name of the field on the form, the value of which should be passed to the validator as its
argument. This could be used to validate one field based on the contents of another. However, in
most deployments this does not need to be set.
To provide a fixed value as the argument to the validator, set the Validator Param selection to its
default value, (Use argument).

Validator
Argument

Provides further instructions to the selected validator. Not all validators require an argument; a
validator such as IsValidEmail is entirely self-contained and will ignore the Validator Argument.
Validators such as IsEqual, IsInRange and IsRegexMatch use the argument to perform validation.

Validation
Error

Error message to display if the field’s value fails validation and the validator does not return an empty
message directly. Validation errors are displayed to the user by highlighting the field(s) that are in
error and displaying the validation error message with the field:

Table 137: Form Field Editor, Form Validation Properties Area
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Examples of Form Field Validation

Example 1 — Integer Value Between 1 and 100 (Inclusive)

To create a form field that requires an integer value between 1 and 100 (inclusive) to be provided, use the
following settings in the Form Field Editor (see "Form Field Editor " on page 302):

Figure 230 Form Field Editor, Form Validation Properties Area, Example Range of Integer Values

The form field will contain an integer value, so you should set the field's type to Integer when you create it.

In the Validator field, to specify the minimum and maximum values for the IsInRange validator, use the PHP
syntax array(1, 100). After saving changes on the form, this value will be internally converted to the
equivalent code:

array (

0 => 1,

1 => 100,

)

With these validator settings, users that enter an invalid value will now receive a validation error message:

Figure 231 Example Validation Error Message for an Invalid Range Value

Furthermore, be aware that blank values, or non-numeric values, will result in a different error message:

Figure 232 Example Validation Error Message for a Missing or Non-Numeric Entry
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The reason for this is that in this case, the validation has failed due to a type error — the field is specified to
have an integer type, and a blank or non-numeric value cannot be converted to an integer. To set the error
message to display in this case, use the Type Error option in the Advanced Properties area.

Example 2 — Small Number of String Values

To create a form field that accepts one of a small number of string values, use the following settings in the form
field editor:

Figure 233 Form Field Editor, Form Validation Properties Area, Example Array Values

This example could be used for a string field named visitor_department. Because the values are known in
advance, a drop-down list is the most suitable user interface. An initial value for the form field, as shown above,
could be used if most guests are in fact there to visit the sales team.

To match against a list of options used for a drop-down list or set of radio buttons, you can use the
IsInOptionsList validator.
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Example 3 — US Social Security Numbers

To create a form field that validates US social security numbers using a regular expression, use the following
settings in the form field editor:

Figure 234 Form Field Editor, Form Validation Properties Area, Example Regular Expression Values

Notice that the regular expression used here includes beginning and ending delimiters (in this case the /
character), and ensures that the whole string matches by the start-of-string marker ^ and the end-of-string
marker $. The construct \d is used to match a single digit. Many equivalent regular expressions could be
written to perform this validation task. See "Regular Expressions" on page 764 for more information about
regular expressions.
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Advanced Form Field Properties

Figure 235 Form Field Editor, Advanced Properties Area

On the Form Field Editor (see "Form Field Editor " on page 302), options in the Advanced Properties area
control certain optional form processing behaviors. You can also specify JavaScript expressions to build
dynamic forms similar to those found elsewhere in the application.

Field Description

Advanced If selected, displays the advanced properties options in the Form Field Editor.

Conversion Specifies the function used to convert an incoming field value prior to validation.
This option can be used to enable certain form processing behavior. See "Form Field Conversion
Functions" on page 759 and "Form Field Display Formatting Functions" on page 760.

Type Error Error message to display if the field’s value is not supplied, has an incorrect type, or the conversion
fails.

Value
Format

Specifies the function used to format the field value after validation.
This option can be used to enable certain form processing behavior. See "Form Field Conversion
Functions" on page 759 and "Form Field Display Formatting Functions" on page 760.

Table 138: Form Field Editor, Advanced Properties Area
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Field Description

Display
Function

Specifies the function used to convert a field to a displayable value on the form.
This option can be used to enable certain form processing behavior. See "Form Field Conversion
Functions" on page 759 and "Form Field Display Formatting Functions" on page 760.

Display
Param

Name of the field whose value will be supplied as the argument to a display function.

Display
Arguments

Value to supply as the argument to a display function.

Static
Display
Function

Specifies the function used to convert a static field to a displayable value on the form.

Force Value If selected, sets the field’s value to the initial value specified above when the form is submitted.
Prevents attempts to override the value set for the field. When this option is set, if a user modifies
the field’s value, it reverts to the specified initial value when the form is submitted. A similar effect
can be achieved by using appropriate validation rules, but selecting this check box is easier. Using
this option is recommended for hidden fields, particularly those related to security, such as role ID
or expiration date.

Pre-
Registration

For accounts that have been created prior to registration, specifies whether the guest’s entry must
match the preliminary value provided for the field during pre-registration. For pre-registered guest
accounts, some fields may be completed during pre-registration and some fields may be left for the
guest to complete at registration. Options include:
l Field was not pre-registered — Select this option if a value was not provided for a field when

the account was created
l Guest must supply field — Select this option if a preliminary value was provided for the field

but the guest’s entered value does not need to match case or all characters. For example, a bulk
account creation might use random usernames, and each guest’s entry in that field would not
need to match exactly.

l Guest must supply field (match case) — Select this option if a preliminary value was
provided for the field and the guest’s entered value must match case or all characters. If the
guest’s entry does not successfully match the preregistered value, the account registration will
not succeed. For example, if a list of email addresses and phone numbers was imported for pre-
registration, each guest’s entries for those fields at registration must match.

Enable If Javascript conditional expression for the field’s enabled property. The expression “f.value” returns
the in-form value of field “f”.

Visible If Javascript conditional expression for the field’s visibility. The expression “f.value” returns the in-form
value of field “f”.

Save
Changes

Saves your changes on this form and returns you to the Customize Form Fields list view at
Configuration > Pages > Forms & Views.

Table 138: Form Field Editor, Advanced Properties Area(Continued)

Creating a Single Password for Multiple Accounts

You can create multiple accounts that have the same password. In order to do this, you first customize the
Create Multiple Guest Accounts form to include the Password field.

To include the Password field on the Create Multiple Guest Accounts form:

1. Go to Configuration > Pages > Forms & Views. Click the create_multi row, and then click its Edit Fields
link. The Customize Form Fields view opens, showing a list of the fields included in the Create Multiple
Guest Accounts form and their descriptions.
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At this point, the Password field is not listed because the Create Multiple Guest Accounts form (create_
multi) has not yet been customized to include it. You will create it for the form in the next step.

2. Click on any field in the list to expand a row, and then click the Insert After link (you can modify this
placement later). The Customize Form Field form opens.

3. In the Field Name row, choose password from the drop-down list. The form displays configuration
options for this field.

Figure 236 Form Field Editor, Password Configuration Options

4. In the Field row, mark the Enable this field check box.

5. To adjust the placement of the password field on the Create Multiple Guest Accounts form, you may
change the number in the Rank field.

6. In the User Interface row, choose Password text field from the drop-down list. The Field Required
check box should now be automatically marked, and the Validator field should be set to IsNonEmpty.

7. Click Save Changes. The Customize Form Fields view opens again, and the password field is now
included and can be edited.

To create the multiple accounts that all use the same password, see "Creating Multiple Guest Accounts" on
page 53.

Form Field Validation Processing Sequence

The following figure shows the interaction between the user interface displayed on a form and the various
conversion and display options available on the Form Field Editor (see "Form Field Editor " on page 302).
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Figure 237 Steps Involved in Form Field Processing

The Conversion step should be used when the type of data displayed in the user interface is different from the
type required when storing the field.

For example, consider a form field displayed as a date/time picker, such as the expire_time field used to
specify an account expiration time on the create_user form. The user interface is displayed as a text field, but
the value that is required for the form processing is a UNIX time (integer value).
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Figure 238 Form Field Editor, Advanced Properties Area for a Field Using a Date/Time Picker

In this case, the Conversion function is set to NwaConvertOptionalDateTime to convert the string time
representation from the form field (for example, “2008-01-01”) to UNIX time (for example, 1199145600).

The Validator for the expire_time field is IsValidFutureTimestamp, which checks an integer argument
against the current time.

The Value Formatter is applied after validation. This may be used in situations where the validator requires the
specific type of data supplied on the form, but the stored value should be of a different type. In the expire_
time field example, this is not required, and so the value formatter is not used. However, if the Conversion
function had not been used, and the Validator had been set to IsValidFutureDateTime (which checks a string
date/time value), then the Value Formatter would need to be set to NwaConvertOptionalDateTime to perform
the data conversion before the form processing.
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A comparison of these two approaches is shown below to illustrate the difference:

Figure 239 Comparison of Two Validation Approaches

When using a Conversion or Value Format function, you will almost always have to set up a Display Function
for the form field. This function is used to perform the conversion in the reverse direction – between the
internal stored value and the value displayed in the form field.

See "Form Field Conversion Functions" on page 759 for a detailed list of the options available to you for the
Conversion and Value Format functions.

The Display Param is the name of a form field, the value of which will be passed to the Display Function. In
almost all cases this option should contain the name of the form field.

Display Arguments are available for use with a form field and are used to control the conversion process. In the
case of the expire_time form field, the Display Function is set to NwaDateFormat to perform a conversion
from a UNIX time to a date/time string, and the Display Argument specifies the format to use for the
conversion.

See "Form Field Display Formatting Functions" on page 760 for a detailed list of the options available to you for
the Display Function and Static Display Function.

The Enable If and Visible If options in the Form Field Editor allow you to specify JavaScript expressions. The
result obtained by evaluating these expressions is used to enable/disable, or show/hide the form field in real
time, while an operator is using the form.

Unlike the other parts of the form field editor, the Enable If and Visible If expressions are evaluated by the
operator’s Web browser. These expressions are not used by the server for any other purpose.
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The expression must be a Boolean expression in the JavaScript language; statements and other code should
not be included as this will cause a syntax error when the form is displayed in a Web browser.

Because of the scoping rules of JavaScript, all of the user interface elements that make up the form are
available as variables in the local scope with the same name as the form field. Thus, to access the current value
of a text field named sample_field in a JavaScript expression, you would use the code sample_field.value.

Most user interface elements support the value property to retrieve the current value. For check boxes,
however, use the checked property to determine if the check box is currently selected.

The most practical use for this capability is to hide a form field until a certain value of some other related field
has been selected.

For example, the default create_user form has an Account Expiration drop-down list. One of the values in
this list is special: the -1 option displays the value Account expires at a specified time…

Figure 240 The Account Expiration Drop-Down List

When this option is selected, the form expands to include the Expires After row, allowing the user to specify a
time other than one of the options in the list.

The expire_time field uses the JavaScript expression expire_after.value < 0 for the Visible If option. When
the -1 option has been selected, this condition will become true and the field will be displayed.

If the expire_timezone field is used in conjunction with expire_time and a time zone and date are selected,
the date calculation is adjusted relative to the time zone.

Additional examples of the Visible If conditional expressions can be found in the guest_edit form.

Customizing List Views

You can view a list of ClearPass Guest's list views and customize them. You can change the layout of views, add
new fields, alter the behavior of an existing field, view usage, or manage translations.

To view or customize a list view, go to Configuration > Pages > List Views. The Customize Views page
opens.
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Figure 241 The Customize Views List View

All views in the application are included in the list. You can click a view’s row in the list or use the links provided
on the page for additional options:

Field Description

Edit Edit a view's basic properties. The row expands to include the Edit Properties form. See "Editing
Forms and Views " on page 332.

Edit Fields Edit the view’s fields. The Customize Form Fields list view for the view opens. You can add a new
field to a form, reorder the fields, or make changes to an existing field. See "Editing Forms " on
page 301 or "Editing Views " on page 333.Editing Views

Duplicate Creates a copy of the view to use as a template in order to provide different views to different
operator profiles. See "Role-Based Access Control for Multiple Operator Profiles" on page 681 for a
description. This enables you to provide different views of the underlying guest accounts in the
database depending on the operator’s profile.
The form or view is copied and the new one is added to the list with a number appended to the end
of its name—for example, if you were to duplicate the change_expiration form, the duplicated
form would be change_expiration_1. This name cannot be changed. Use the Title and Description
properties of the duplicated item to describe the intended purpose for the form or view.

Show Usage Expands the row to display a list of operator profiles that reference the view. You can click an
operator profile’s name in this list to edit the form’s fields.

Translations Lets you edit field and label translations for the form in either a text file or a user interface page.

Use Opens the form or view. The view opens in a separate tab, and the List Views tab stays open so
you can work in both.

Delete Deletes the form or view. You will be asked to confirm the deletion. A form or view cannot be
removed if it is referenced by an operator login account or an operator profile.

Reset to
defaults

An asterisk (*) shown next to a form or view indicates that the form or view has been modified from
the defaults. To reset a form or view to default values, click this link. You will be asked to confirm the
change. Resetting a form or view is a destructive operation and cannot be undone.

Customize
Fields

To customize fields used in the application, click this link in the upper right corner. The Customize
Fields list view opens. See "Customizing Fields" on page 337.

Table 139: The Customize Views List
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Editing Forms and Views

You can change the general properties of a form or view such as its title and description. To edit the form or
view, go to Configuration > Pages > Forms or to Configuration > Pages > List Views, click the form’s or
view’s row, and then click its Edit link. The row expands to include the Edit Properties form.

Figure 242 The Edit Properties Form

Field Description

Name Filename of the page in the application.

Type Page type, either form or view.

Title Title of the form or view.

Description Brief description of the form or view.

Width Total width of the list view in pixels. If this field is left blank, a default value is used.
The Width field is only displayed for views.

Table 140: The Edit Properties Form
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Field Description

Page Title Title that is displayed on the form or view in the user interface.

Header
HTML

HTML template code displayed before the form or view. You can use the drop-down list to add
images or links.

Footer
HTML

HTML template code displayed after the form or view. You can use the drop-down list to add
images or links.

Translations Lets you edit field and label translations for the form in either a text file or a user interface page.

Save
Changes

Saves your changes to this form. On the Customize Forms page or the Customize List Views
page, an asterisk (*) is shown next to the form or view to indicate that it has been modified. To reset
it to default values, you can click the Reset to defaults link. You will be asked to confirm the
change. Resetting a form or view is a destructive operation and cannot be undone.

Table 140: The Edit Properties Form(Continued)

Editing Views

A view is a page in the application that displays data, similar to a form, but does not contain interactive fields
the user can modify. It consists of one or more columns, each of which contains a single field. You can change
which fields are displayed and how each field is displayed. You can also define your own fields using the
Customize Fields page, and then add them to a view by choosing appropriate display options for each new
column.

To add a new field to a view, reorder the fields, or make changes to an existing field in a view, go to
Configuration > Pages > List Views, click the view, and click its Edit Fields link. The Customize View
Fields editor opens.

Figure 243 The Customize View Fields List View

The Customize View Fields list view includes the following columns:

l Rank — Specifies the relative ordering of the columns when displaying the view. The Customize View
Fields editor always shows the columns in order by rank.

l Field — The field name.
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l Type — The type of the field. This controls what kind of user interface element is used to display the
column, and whether the column is to be sortable or not. Values displayed in italics are default values
defined for the field being displayed.

l Title — The title of the column. Values displayed in italics are default values defined for the field being
displayed.

l Width — The width of the column. Values displayed in italics are default values defined for the field being
displayed.

All fields that have been defined for the view are included in the list. You can click a field's row in the list or use
the links provided on the page for additional options:

Field Description

Edit Make changes to an existing column. The row expands to include the View Field Editor. Any
changes made to the field using this editor will apply only to this field on the view being edited. See
"View Field Editor" on page 334.

Edit Base
Field

Make changes to an existing field definition. The Edit Field form opens. Any changes made to the
field using this editor will apply to all views that are using this field (except where the view field has
already been modified to be different from the underlying field definition). See "Creating a Custom
Field " on page 338.

Remove Deletes the field from the view. You will be asked to confirm the deletion.

Insert Before Adds a new column to the view. Opens a blank View Field Editor form and automatically sets the
rank number of the new column. You can specify the field that this field should be above.

Insert After Adds a new column to the view. Opens a blank View Field Editor form and automatically sets the
rank number of the new column. You can specify the field that this field should be below.

Enable Field Immediately enables display of the column. A progress indicator is briefly displayed.

Disable
Field

Immediately disables display of the column. A progress indicator is briefly displayed.

Translations Lets you edit field and label translations for the form in either a text file or a user interface page.

Customize
fields

Lets you modify existing fields. The Customize Fields list view opens (Configuration > Pages
> Fields). See "Customizing Fields" on page 337.

Back to list of
forms & views

Returns to the parent page, the Customize Forms & Views list view (Configuration > Pages > Forms
& Views). See "Customizing Forms" on page 297.

Use this
view

Opens the view in the application.

Table 141: Customize View Fields

View Field Editor

The view field editor is used to control the data-display aspects of a column within the view. Each column in a
view displays the value of a single field.

To edit a field for a view, go to Configuration > Pages > List Views, click a view in the list, and click its Edit
Fields link. In the Customize View Fields list, click a field and then click the field’s Edit link. The row expands
to include the View Field Editor.
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Figure 244 The View Field Editor

Field Description

Field
Name

(Required) Specifies the field definition to display in the view.

Field If selected, enables the field.
To use the default view display properties for a field, you only need to select this check box to enable
the field to display in the column, and then click Save Changes. No further changes are needed on this
form.

Rank (Required) Indicates the field’s position in the relative ordering of the fields. Fields are displayed in
order of increasing rank.

Advanced If selected, lets you override the default view options and customize the view display properties. This
form expands to include the advanced options.

Default
Title

Default title text for this field’s column. The default value cannot be edited.

Column
Title

Lets you override the default and specify title text to display for this field’s column. To use the default,
leave this text field empty.

Default
Type

Default type of the column used for this field. The default value cannot be edited.

Column
Type

Lets you override the default and specify the type of column used to display this field. To use the
default, leave this drop-down selection empty. Options include:
l Text – The column displays a value as text.
l Sortable text – The column displays a value as text, and may be sorted by clicking on the column

heading.
l Sortable text, case-insensitive – The same as “Sortable text”, but the column sorting will treat

Table 142: View Field Editor
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Field Description

uppercase and lowercase letters the same.
l Sortable numeric – The column displays a numeric value, and may be sorted by clicking on the

column heading.

Default
Width

Default width for the field’s column, in pixels. The default value cannot be edited.

Column
Width

Lets you override the default and specify a width in pixels for the field’s column. To use the default,
leave this text field empty.

CSS Class CSS class name to apply to the field.

Default
CSS Style

Default CSS style text to apply to the field. The default value cannot be edited.

CSS Style Lets you override the default and specify the CSS style text to apply to this field. To use the default,
leave this field empty.

Default
Format

Default format for displaying the field. The default value cannot be edited.

Column
Format

Lets you override the default and specify how the field’s value should be displayed. To use the default,
leave this field empty. Options include:
l Field Value — The value of the field is displayed as plain text.
l Field Value (Unescaped) — The value of the field is displayed as HTML.
l Boolean – Yes/No — The value of the field is converted to Boolean and displayed as “Yes” or “No”.
l Boolean – Enabled/Disabled — The value of the field is converted to Boolean and displayed as

“Enabled” or “Disabled”.
l Boolean – On/Off — The value of the field is converted to Boolean and displayed as “On” or “Off”.
l Date — The value of the field is assumed to be a UNIX timestamp value and is displayed as a date

and time.
l Duration (from seconds) — The value of the field is assumed to be a time period measured in

seconds and is displayed as a duration (for example, “23 seconds”, “45 minutes”)
l Duration (from minutes) — The value of the field is assumed to be a time period measured in

minutes and is displayed as a duration (for example, “45 minutes”, “12 hours”)
l Use form options — The value of the field is assumed to be one of the keys from the field’s option

list. The value displayed is the corresponding value for the key.
l Custom expression… — The Display Expression text area is displayed allowing a custom

JavaScript expression to be entered. See "View Display Expression Technical Reference" on page
761 for technical information about this display expression and a list of the functions that are
available to format the value.

Default
Search

Default value for whether the field will be included in filter searches. The default value cannot be
edited.

Search Many views include the ability to filter results. If selected, and the field is enabled, it will be included in
the search.

Save
Changes

Saves your changes to the View Field Editor form.

Table 142: View Field Editor(Continued)
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Customizing Fields

Custom fields are fields that you define yourself to cater for areas of interest to your organization. You are able
to define custom fields for your guest accounts as well as edit the existing fields.

In addition you can delete and duplicate fields. For your convenience you are also able to list any forms or
views that use a particular field.

Fields that have a lock symbol cannot be deleted.

To work with fields or create a new field, go to Configuration > Pages > Fields. The Customize Fields list
view opens.

Figure 245 The Customize Fields List View

All fields that have been defined are included in the list. To display only the fields that have been created, click
the Custom Fields Only link in the bottom row of the list view. To return to displaying all fields, click the
All Fields link.

You can click a field's row in the list or use the links provided on the page for additional options:
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Field Description

Edit Edit a field's basic properties. The Edit Field form opens. You can make changes to the description or
other properties. For an existing field, the name and type cannot be changed. See "Creating a Custom
Field " on page 338.

Duplicate Creates a copy of the field to use as a basis for a new field. The field is copied and the new field is
added to the list with a number appended to the end of the field name—for example, if you were to
duplicate the card_code field, the duplicated field would be card_code_1. To rename the field, click
Edit.

Show
Forms

Expands the row to display a list of forms that use the field. You can click the Edit Fields link next
to a form in this list to edit the form’s fields. You can click the Use link to open the form that uses
that field. If the field is used on multiple forms, you can select which form you would like to view.

Show
Views

Expands the row to display a list of views that use the field. You can also click the Edit Fields link
next to a view in the list to edit the view’s fields. You can click the Use link to open the view that
uses the field. If the field is used on multiple views, you are able to select which view you would like to
see.

Delete Deletes the field. You will be asked to confirm the deletion. A message indicates when the deletion is
completed.
Only fields that do not have a lock symbol in the Type column can be deleted. A field that is
currently in use on a form or view cannot be deleted.

Customize
Forms &
Views

To customize forms and views within the application, click this link in the upper right corner. The
Customize Forms & Views list view opens.

Create
new field

To create a new field, click this link in the upper right corner. The Define Custom Field form opens.
See "Creating a Custom Field " on page 338.

Reset all
to
defaults

To reset all fields in the list to default values, click this link in the upper right corner. You will be asked
to confirm the change.

Table 143: The Customize Fields List

For information on properties of some specific fields, see "Business Logic for Account Creation" on page 287.

Creating a Custom Field

To create a custom field, go to Configuration > Pages > Fields and click the Create tab at the top of the
form or the Create new field link in the upper-right corner. The Create Field form is displayed.
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Figure 246 The Create Field Form, Basic Information Area

Field Description

Field
Name

(Required) Unique name for this field. The field name cannot include spaces, but can include
underscores.

Field Type (Required) Type of data to store in this field. Options include:
l String
l Integer
l Boolean
l Scalar
l No data type — Used for a label or a submit button

Description Brief description of the field. If you enter a multiple-line description, multiple lines will be displayed
on the form.

Table 144: Create Field Form, Basic Information Area
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Figure 247 The Create Field Form, Default View Display Properties Area

The Default View Display Properties area lets you specify the default properties to use when adding this
field to a view. For a list of the view display fields, including the Column Type and Column Format fields, see
"View Field Editor" on page 334.

Field Description

Column
Type

Specifies the default column type properties to use when adding this field to a view. Options include:
l Text
l Sortable text
l Sortable text, case insensitive
l Sortable numeric

Column
Title

(Required) Header text to display for this field’s column.

Column
Width

Default width of this field in pixels.

CSS Class CSS class name to apply to this form field.

CSS Style CSS style text to apply to this form field.

Column
Format

Specifies the default column format properties to use when adding this field to a view. Options
include:
l Field Value
l Field Value (Unescaped)
l Boolean - Yes/No

Table 145: Create Field Form, Default View Display Properties Area
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Field Description

l Boolean - Enabled/Disabled
l Boolean - On/Off
l Date
l Duration (from seconds)
l Duration (from minutes)
l Use form options
l Custom expression

Display
Expression

If Custom Expression was selected as the Column Format, you can enter the Javascript display
expression for the field. The expression “data.f” returns the value of field “f”.

Search If selected, if this field is enabled it will be included in filter results for views that include filters.

Table 145: Create Field Form, Default View Display Properties Area(Continued)

Figure 248 The Create Field Form, Default Form Display Properties Area

The Default Form Display Properties area lets you specify the default properties to use when adding the
field to a form. For a list of the available user interface types, see "View Field Editor" on page 334.

Field Description

User
Interface

Specifies the type of user interface element to use for this field (for example, drop-down list,
CAPTCHA code, text field, and so on).

Label Label to display for this field on the form.

Description Brief description to display for this form on the field.

Checkbox
Value

Value to use for a selected check box. The default value is 1.

Collapse If selected, automatically hides the form field when only one choice is available.

Columns Number of columns to display in the user interface element.

CSS Class CSS class name to apply to this form field.

CSS Style CSS style text to apply to this form field.

Generator
Arguments

Value to supply as the argument to the options generator.

Horizontal
Rows

Number of rows for the checklist.

Table 146: Create Field Form, Default Form Display Properties Area
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Field Description

HTML HTML text to display next to the check box as its label.

Icon Image Image to display with the user interface element.

Label After
(HTML)

HTML to display after the user interface element. Smarty template functions can be used. You can
also use the drop-down list to add images or links.

Layout Specifies the layout mode for the checklist options. Options include:
Vertical
Horizontal

Legend Title for the group of check boxes or radio buttons.

Max File
Size

Maximum allowed size for an uploaded file.

Max Length Maximum number of characters that can be entered in the field.

Options List of available options. Enter each “key | value” pair on a separate line, where the key and value
are separated by a pipe character ( | ).

Options
Generator

Specifies the function used to generate the list of available options for the multiple selection list or
group of check boxes or radio buttons.

Options
Generator
Param

Specifies the name of the field whose value will be supplied as the argument to the options.

Placeholder If Text or Password was selected as the User Interface type, you can use this field to enter a
temporary value, such as a hint for how to complete the field, that can later be overridden by the
user when they complete the form that uses this field.

Rows Number of rows to display in the user interface element. Use -1 to automatically resize the height to
fit the contents.

Searchable If selected, enables searching and autocomplete with the “select2” user interface.

Sort Specifies the method to use to sort the available options. Options include:
l No sorting
l Sort options by key

Table 146: Create Field Form, Default Form Display Properties Area(Continued)
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Field Description

l Sort options by value

Time of
Day

If Date/time picker was selected in the User Interface field, entering a value in this field will
change the interface to be only a date picker, and the time will always be the value entered here.

Vertical
Columns

Number of columns for the checklist.

Table 146: Create Field Form, Default Form Display Properties Area(Continued)

Figure 249 The Create Field Form, Form Validation Properties Area

The Form Validation Properties area lets you specify the default validation rules that should be applied to
this field when it is added to a form. See "Form Validation Properties" on page 319 in this chapter for further
information about form validation properties.

Field Description

Field Required If selected, the field cannot be omitted or left blank.

Initial Value Value to initialize this field with when the form is first displayed.

Validator Specifies the function used to validate the contents of a field.

Validator
Param

Specifies the name of a field whose value will be supplied as the argument to the validator.

Validator
Argument

Value to supply as the argument to a validator.

Validation
Error

Error message to display if the field’s value fails validation and the validator does not return an
error message directly.

Table 147: Create Field Form, Form Validation Properties Area
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Figure 250 The Create Field Form, Advanced Properties Area

The Advanced Properties area lets you specify additional properties related to conversion, display, and
dynamic form behavior. The fields displayed in the Advanced area will vary according to your selections on the
rest of the Create Field form. See "View Field Editor" on page 334 in this chapter for more information about
advanced properties.

Field Description

Advanced If selected, this form expands to include advanced options.

Conversion Specifies the function used to convert an incoming field prior to validation.

Type Error Error message to display if the field’s value is not supplied, has an incorrect type, or if conversion
fails.

Value
Format

Specifies the function used to format a field value after validation.

Display
Function

Specifies the function used to convert a field to a displayable value on the form.

Display
Param

Name of the field whose value will be supplied as the argument to a display function.

Display
Arguments

Value to supply as the argument to a display function.

Static
Display
Function

Specifies the function used to convert a static field to a displayable value on the form.

Static
Display
Param

Name of the field whose value will be supplied as the argument to a display function.

Static
Display
Arguments

Value to display as the argument to a display function.

Force Value If selected, sets the field’s value to the initial value specified above when the form is submitted.

Table 148: Create Field Form, Advanced Properties Area
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Field Description

Pre-
Registration

Specifies the pre-registration type. Options include:
l Field was not pre-registered
l Guest must supply field
l Guest must supply field (match case)
Pre-registration applies to accounts that were created prior to registration. A field requiring a
match will be searched in the account list. If a single match is found, the registration can continue.

Enable If Javascript conditional expression for this field’s enabled property. The expression “f.value” returns
the in-form value of field “f”.

Visible If Javascript conditional expression for this field’s visibility. The expression “f.value” returns the in-form
value of field “f”.

Table 148: Create Field Form, Advanced Properties Area(Continued)

When your changes are complete on this form, click Save Changes to complete the creation of a new field.
The new field is added at the top of the custom fields list at Configuration > Pages > Fields. To change the
position of the new field, you can re-sort the list or you can reload the page.

Customizing AirGroup Registration Forms

AirGroup allows users to register their personal mobile devices on the local network and define a group of
friends or associates who are allowed to share them. If AirGroup Services is enabled, AirGroup administrators
can provision their organization’s shared devices and manage access, and AirGroup operators can register and
provision a limited number of their own personal devices for sharing. For complete AirGroup deployment
information, refer to the AirGroup sections in the ArubaOS User Guide and the ClearPass Policy Manager
documentation.

On the device registration forms for AirGroup administrators and operators, the default Shared Locations
and Shared Roles fields are text boxes where the user enters the information. These fields can be configured
as selection options populated with existing locations or roles.

Configuring the Shared Locations and Shared Role Fields

To configure a predefined list of shared locations or shared roles:

1. Go to Configuration > Pages > Fields and click the airgroup_shared_location or airgroup_shared_role
row. The form expands to include the Edit, Duplicate, Show Forms, and Show Views links.

2. Click the Edit link. The Define Custom Field form opens. Scroll to the Default Form Display Properties
area.
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Figure 251 The Define Custom Field Form, Default Form Display Properties Area

3. In the User Interface drop-down list, select Checklist.

4. In the Description text box, delete the existing text, and then enter Select the location IDs where this
device will be shared. Leave blank to share with all locations.

5. Delete any text from the CSS Class and the CSS Style fields.

6. In the Options Generator drop-down list, select (Use options).

7. In the Options text box, enter a list of values to use as the checklist options that presented to the user.

The values you enter in the Options text box control both the values stored in the shared_location field in
the database as well as the text displayed to the user in the checklist. Use the following format:

tag1=value1 | Option 1

tag2=value2 | Option 2

...where the tag=value pair tag1=value1 represents the value stored in the shared_location field in the
database, the pipe character ( | ) is a separator, and Option 1 represents the text displayed in the checklist.

8. (Optional) To sort the locations by key or value, choose an option from the Sort drop-down list.
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9. (Optional) To control the layout of the checklist on the form, first use the Layout drop-down list to select
either Vertical or Horizontal. The name of the next field changes to correspond to your choice in this field.
Enter the appropriate number in the Vertical Rows or Horizontal Rows field. If the Layout field is left
blank, the default layout of a single list of checklist options is displayed.

To ensure the values are stored correctly as a comma-separated list:

1. Scroll to the Advanced Properties section of the form and mark the check box in the Advanced row. The
form expands to include the advanced options.

Figure 252 The Define Custom Field Form, Advanced Properties Area

2. In the Conversion drop-down list, select NwaImplodeComma. The form expands to include the Type
Error row.
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3. In the Display Function drop-down list, select NwaExplodeComma. The form expands to include the
Display Param and Display Arguments rows.

4. In the Display Param text field, enter the value _self. Be sure to include the leading underscore character.

5. Click Save Changes.

Example:

If the layout is set to vertical and the following options are specified:

AP-Group=Location-1 | Location One

AP-Group=Location-2 | Location Two

AP-Location-3 | Location Three

The user interface appears as follows:

Figure 253 The Register Shared Device Form Showing the Configured Fields

Customizing Self-Registration

Self-registration allows an administrator to customize the process for guests to create their own guest
accounts. Self-registration is also referred to as self-provisioned access. The registration process consists of a
data collection step (the ‘registration page’) and a confirmation step (the ‘receipt page’):

l On the registration page, you can define what information is collected from guests. New fields and data
validation rules can be defined with the custom form editor. Specific details about the type of guest
accounts created are also set here.

l The receipt page typically contains static information about the guest account, but several different actions
can be included, enabling guests to obtain their receipt in different ways. The receipt page can also be used
to automatically log the guest into a Network Access Server, enabling them to start using the network
immediately.
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Detailed user interface customization can be performed for all parts of the self-registration process. You can
define page titles, template code for the page header and footer, and choose a skin that controls the overall
look and feel of self-registration. The default user interface customization can be disabled.

A self-registration process consists of many different settings. The Customize Guest Registration form
organizes these settings into the different stages of the registration process, each on its own section of the
form. These sections are displayed as separate pages in the Configuration UI. When you create a new
registration page, the process walks you through these pages of the form one at a time. When you edit a
registration page, links let you go directly to the section for the stage of the process you want to edit.

This section includes:

l "Accessing the Self-Registration Customization Forms" on page 349

l "Self-Registration Sequence Diagram" on page 353

l "Editing Self-Registration Pages" on page 354

l "Creating a Self-Registration Page" on page 355

l "Configuring Basic Properties for Self-Registration" on page 357

l "Editing Registration Page Properties" on page 360

l "Editing the Default Self-Registration Form Settings" on page 362

l "Editing Guest Receipt Page Properties" on page 364

l "Editing Receipt Actions" on page 365

l "Editing Login Page Properties" on page 380

l "Editing Cloud Identity Properties" on page 386

l "Self-Service Portal Properties" on page 394

l "Resetting Passwords with the Self-Service Portal" on page 401

l "Enabling and Editing NAS Login Properties" on page 391

Accessing the Self-Registration Customization Forms

To create a new guest self-registration page, go to Configuration > Pages > Self-Registrations and click the
Create new self-registration page link in the upper-right corner. The first part of the Customize Self-
Registration form opens. See "Creating a Self-Registration Page" on page 355.

To work with an existing self-registration page, go to Configuration > Pages > Self-Registrations. The Self-
Registrations list view opens. All self-registration pages that have been created are included in this list.

Figure 254 The Self-Registrations List View
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Click a page's row in the list to select it. The row expands to include options for working with the self-
registration pages.

Field Description

Edit Edit any of the self-registration page's properties. The Customize Guest Registration workflow
diagram opens. Links in the workflow diagram provide access to any section of the registration
page's properties. For information on editing the different parts of the self-registration process, see
"Editing Self-Registration Pages" on page 354.

Delete Deletes the guest self-registration page. You will be asked to confirm the deletion.

Duplicate Creates a copy of the self-registration page and appends a number to page name. See "Duplicating
a Self-Registration Page" on page 350.

Enable Enables the self-registration page so it can be used.

Disable Disables the self-registration page for the user and displays a message. See "Disabling a Self-
Registration Page" on page 351.

Launch Displays a preview of the Guest Registration network access form. See "The "Launch" Option: The
Registration Page" on page 351.

Launch
Self-Service

Displays a preview of the Self Service Login portal. See "The "Launch" Option " on page 352.

Launch
Login

Displays a preview of the Network Login form. See "The "Launch Login" Option" on page 353.

Create new
self-
registration

Create a new self-registration page. See "Creating a Self-Registration Page" on page 355.

Table 149: Self-Registrations

Duplicating a Self-Registration Page

When you choose the Duplicate option for a self-registration page, the row expands to include the Duplicate
Guest Registration form. Complete the fields to rename the page and enter a name for the Register Page.
You can also give the page a description and indicate the parent page.

The Register page does not exist until you create it here. There are no spaces in this name. This page name will
become part of the URL used to access the self provisioning page. For example, the default “guest_register”
page is accessed using the URL guest_register.php.
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Figure 255 The Duplicate Guest Registration Form

Disabling a Self-Registration Page

When you choose the Disable option for a self-registration page, the row expands to include the Disable
Guest Registration form. In the Disabled Message text box, you may enter the HTML content to display
on the page when guest registration is disabled. You can also use the drop-down list to add images or other
content items.

Figure 256 The Disable Guest Registration Form

The "Launch" Option: The Registration Page

When you choose the Launch option for a self-registration page, the row expands to show an active preview
of the Guest Registration page and form as the guest would see it. This is the registration page and data
collection step. You may test the behavior of the form.
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Figure 257 The Guest Registration Form

The Receipt Page

After the guest successfully registers, the receipt page is their confirmation and provides their login and access
information.

Figure 258 The Guest Registration Receipt

The "Launch" Option

When you choose the Launch Self-Service option for a self-registration page, the row expands to show an
active preview of the Self Service Login page and form as the guest would see it. This form lets the guest
access their account information. You may test the behavior of the form.
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Figure 259 The Self-Service Login Form

The "Launch Login" Option

When you choose the Launch Login option for a self-registration page, the row expands to show an active
preview of the Network Login page and form as the guest would see it. This is the page the guest sees when
they log in to the network. You may test the behavior of the form.

Figure 260 The Network Login Form

Self-Registration Sequence Diagram

To set up a captive portal with guest self-registration, you configure your Network Access Servers (NAS) to
redirect guests to the URL of the ‘Go To’ link. To complete the portal, you ensure that the NAS is configured to
authorize users with the ClearPass Guest RADIUS server, and set up the self-registration NAS login to redirect
registered guests back to the NAS.

This process is shown below.
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Figure 261 Sequence Diagram for Self-Registration

In this diagram, the stages in the self-registration process are identified by the numbers in brackets, as follows:

The captive portal redirects unauthorized users [1] to the registration page [2]. After submitting the registration
form [3], the guest account is created and the receipt page is displayed [4] with the details of the guest account.
If NAS login is enabled (the default), submitting the form on this page will display a login message [5] and
automatically redirect the guest to the NAS login [6]. After authentication and authorization the guest’s security
profile is applied by the NAS [7], enabling the guest to access the network [8].

Editing Self-Registration Pages

When you edit a registration page, links let you go directly to the section of the Customize Guest
Registration form that corresponds to the stage of the process you want to edit.

To edit a self-registration page, go to Configuration > Pages > Guest Self-Registrations, select the page in
the list, and click its Edit link. The Customize Guest Registration workflow diagram opens.
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Figure 262 Guest Self-Registration Workflow Diagram
.

The diagram shows the guest self-registration process. The solid orange arrows show the workflow for the
guest. The dotted blue arrows show the workflow for the administrator. The blue headings in the diagram are
links to the corresponding sections of the Customize Guest Registration form. Click an icon or label in the
diagram to jump directly to the editor for that item.

To view the Guest Registration network access form (the registration page), click the Launch this guest
registration page link in the upper-right corner. To view the self-service portal the guest can use to log in to
their account details after registration, click the Launch self-service portal link. To view the guest's network
access login form, click the Launch network login link.

Creating a Self-Registration Page

The Customize Guest Registration form is divided across several pages, which are displayed separately.
When you create a new registration page, the process walks you through these pages of the form one at a
time. As you complete each page of the form, you can click Save and Continue to move to the next section of
the form. At any point, you can click Save and Continue or use your browser's Back button to move back
and forth through the pages, or you can click Save Changes to exit the process and go to the self-registration
process diagram.

To create a new guest self-registration page, go to Configuration > Pages > Guest Self-Registration and
click the Create new self-registration page link. The first section of Customize Guest Registration
form opens, where you can configure basic properties and access control. The registration age does not exist
until you create it here.
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Figure 263 The Customize Guest Registration Form

Field Description

Name (Required) The name of this self-registration page to identify it —for example, "Guest
Self-Registration". This name can include spaces. This name is only displayed to
administrators within ClearPass; it is not seen by the guest.

Description You may enter comments to further identify or describe this page. This description is
only displayed within ClearPass.

Enabled When creation of this page is complete, select this check box to make it available to
use. Deselect the check box if the page should not be used.
When self-registration is enabled, you can edit, delete, duplicate or go to the page
after it is created.

Register Page (Required) The base page name for the guest registration page. Do not use spaces.
Allowed characters are letters, numbers, underscores, and hyphens.
This name becomes part of the URL used to access the self provisioning page. For
example, the default “guest_register” page is accessed using the URL guest_
register.php.
This name is only displayed to administrators within ClearPass; it is not seen by the
guest.

Parent The page to use as a basis for this page's configuration. If a parent page is selected
from this dropdown list, the parent page's values will be used for the new page's
configuration. These values can be edited. If the (No parent - standalone) option is
selected, all values must be configured.

Hotspot Select this check box if the page will be used for Hotspot transactions. Requires the

Table 150: Customize Guest Registration
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Field Description

guest to pay for access.

Authentication Requires operator credentials to access the page. The sponsor's operator profile
must include the Guest Manager > Create New Guest Account privilege.

Save Changes Saves your changes and creates the self-registration page. This form closes and the
self registration process diagram opens.

Save and
Continue

Saves your changes and creates the self-registration page. The next section of the
Customize Guest Registration form opens.

Table 150: Customize Guest Registration(Continued)

Configuring Basic Properties for Self-Registration
To edit the basic settings for a self-registration page, click either the Master Enable, User Database, Choose
Skin, or Rename Page links on the diagram at Configuration > Pages > Self-Registrations > Edit link.

Figure 264 Customize Self-Registration, Basic Properties

Field Description

Name (Required) Enter a name for the page. This name is seen only by administrators in ClearPass Guest.

Description Optional comments or notes about the page.

Enabled Specifies whether the self-registration is enabled or disabled for use.

Register
Page

(Required) Enter the guest registration page name (filename) that will appear in the URL-- for
example, "register_page_name".

Parent To use the settings from a previously configured self-registration page, select an existing page

Table 151: Customize Self-Registration, Basic Properties
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Field Description

name from the drop-down list. This is useful if you need to configure multiple registrations. You can
override parent page values by editing field values yourself. To create a self-registration page with
new values, select the Self-Registration (guest_register) option from the Parent field drop-down
menu.

HotSpot If the standalone self -registration (No parent- standalone) option was selected in the Parent
field, the Hotspot option is available. You can configure this setting so that registrants have to pay
for access.

User
Database

(Required) The service handler used to create the self-provisioned guest accounts.

Skin (Required) Skin to use for the Web page. Options include:
l (Default)
l Aruba ClearPass Skin
l Blank Skin
l ClearPass Guest Skin
l Custom Skin 1
l Custom Skin 2
l Galleria Skin
l Galleria Skin 2

Prevent
CNA

Enables bypassing the Apple Captive Network Assistant (CNA). The CNA is the pop-up browser
shown when joining a network that has a captive portal. This option might not work with all vendors;
it is dependent on how the captive portal is implemented.

Advertising To enable Advertising Services content on this registration page, select the check box in this row.

Translations If the Skip automatic translation handling check box is selected, the self-registration page will
not be translated and will keep the default text.

Table 151: Customize Self-Registration, Basic Properties(Continued)
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When you complete the Basic Properties area and click Save and Continue, the form expands to include
the Access Control area, where you can specify access restrictions for the self-registration page.

Figure 265 Customize Self-Registration, Access Control Area

Field Description

Authentication To require an operator to log in with their credentials before they can create a new guest
account, select the Require operator credentials prior to registering guest check box in this
row. The sponsor’s operator profile must include the Guest Manager > Create New Guest
Account privilege. If you choose this option, the authenticated page it produces for creating
accounts is very simple, and does not include navigation or other links that would otherwise be
available in the operator user interface.

Allowed
Access

The IP addresses and networks from which access is allowed or denied (IPv4 and IPv6 are both
supported).
These access control lists determine whether a client is permitted to access this self-registration
page. You can specify multiple IP addresses and networks, one per line, using the following
syntax :
l 1.2.3.4 – IP address
l 1.2.3.4/24 – IP address with network prefix length
l 1.2.3.4/255.255.255.0 – IP address with explicit network mask

Denied Access

Table 152: Customize Self-Registration, Access Control
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Field Description

Deny Behavior (Required) The response shown to the user if their request is denied. Options in this drop-down
list include:
l Send HTTP 404 Not Found status
l Show Access Denied page
l Show a blank page

Time Access The Time Access field allows you to specify the days and times that self-registration is enabled.
Times must be entered in 24-hour clock format. For example:
l Mondays, Wednesdays and Fridays, 8:00 to 17:00
l Weekdays, 6:00 to 18:00
l Weekends 10:00 to 22:00 and Thursday 11:00 to 13:00

Table 152: Customize Self-Registration, Access Control(Continued)

Access Control Rules

The access control rules will be applied in order, from the most specific match to the least specific match.

Access control entries are more specific when they match fewer IP addresses. The most specific entry is a single
IP address (for example, 1.2.3.4), while the least specific entry is the match-all address of 0.0.0.0/0.

As another example, the network address 192.168.2.0/24 is less specific than a smaller network such as
192.168.2.192/26, which in turn is less specific than the IP address 192.168.2.201 (which may also be written
as 192.168.2.201/32).

To determine the result of the access control list, the most specific rule that matches the client’s IP address is
used. If the matching rule is in the Denied Access field, then the client will be denied access. If the matching
rule is in the Allowed Access field, then the client will be permitted access.

If the Allowed Access field is empty, all access will be allowed, except to clients with an IP address that
matches any of the entries in the Denied Access field. This behavior is equivalent to adding the entry
0.0.0.0/0 to the Allowed Access field.

If the Denied Access list is empty, only clients with an IP address that matches one of the entries in the
Allowed Access list will be allowed access. This behavior is equivalent to adding the entry 0.0.0.0/0 to the
Denied Access list.

Editing Registration Page Properties
To edit the properties of the registration page:

1. Go to Configuration > Pages > Self-Registrations.

2. Select an entry in the Self-Registrations list and click its Edit link. The Customize Self-Registration
workflow diagram opens.

3. Click the Register Page link, or one of the Title, Header, or Footer fields for the Register Page. The
Register Page UI area of the Customize Self-Registration form opens.
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Figure 266 The Customize Self-Registration Form, Register Page UI Area

Field Description

Title Title to display on the self-registration page. Template code may be specified. See "Smarty Template
Syntax" on page 713 for details on the template code that may be inserted.

Header
HTML

HTML for the message that is displayed above the self-registration form. Template code may be
specified. See "Smarty Template Syntax" on page 713 for details on the template code that may be
inserted.

Footer
HTML

HTML for the message that is displayed below the self-registration form. Template code may be
specified. See "Smarty Template Syntax" on page 713 for details on the template code that may be
inserted.

Override
Form

If selected, lets you replace the HTML of the form and override the normal behavior of the registration
page, which is to display the registration form between the header and footer templates.

Table 153: Customize Self-Registration Form, Register Page UI Area
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Field Description

Save and
Reload

Saves your changes, updates the self-registration page, and launches or refreshes a second browser
window to show the effects of the changes.

Save
Changes

Saves your changes and returns to the process diagram for self-registration.

Save and
Continue

Saves your changes, updates the self-registration page, and continues to the next editor.

Table 153: Customize Self-Registration Form, Register Page UI Area(Continue)

Editing the Default Self-Registration Form Settings

To edit the fields on the self-registration form, go to Configuration > Pages > Guest Self-Registration,
click the registration page's row in the list, and then click its Edit link. On the Customize Guest Registration
diagram, click the Form link for the Register Page. The Customize Form Fields (guest_register) list view
opens.

Figure 267 The Customize Form Fields List View

The default settings for this form are as follows:
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l The visitor_name and email fields are enabled. The email address of the guest will become their username
for the network.

l The expire_after field is set to a value of 24 by default; this sets the default expiration time for a self-
registered guest account to be 1 day after it was created. This field is hidden by default on the register page.

l The role_id field is set to a value of 2 by default; this sets the default role for a self-registered guest account
to the built-in Guest role. This field is hidden by default on the register page.

l The auto_update_account field is set by default. This is to ensure that a guest who registers again with the
same email address has their existing account automatically updated.

Columns on the form editor:

Field Description

Rank Specifies the relative ordering of the fields when displaying the form. This list always shows the
fields in order by rank.

Type Controls what kind of user interface element is used to interact with the user.

Label The label for this field as it is displayed on the form.

Description The description for this field as it is displayed on the form.

Table 154: Form Editor Columns

To work with a form field, click its row in the list. The row expands to include configuration options:

Field Description

Edit Make changes to an existing field. The Form Field Editor opens. Any changes made to the
field using this editor will apply only to this field on this form.

Edit Base Field Make changes to an existing field’s definition. Any changes made to the field using this editor
will apply to all forms that are using this field (except where the form field has already been
modified to be different from the underlying field definition).

Remove Removes the field from the form. To add a field back to the form after it has been removed,
use the Insert Before or Insert After option and select it from the Field Name drop-down
list in the Form Field Editor that opens.

Insert Before Add a new field to the form. Clicking one of these links opens a blank form field editor and
automatically sets the rank number of the new field.

Insert After

Disable Field Disables this field on the form. To enable it on the form again, click Enable Field.

Preview Form Opens an example of the form so you can see what it looks like. This preview form can be
submitted to test the field validation rules you have defined. If all fields are able to be
validated, the form submit is successful and a summary of the values submitted is displayed.
This allows you to verify any data conversion and formatting rules you have set up.

Table 155: Form Editor Options

See also:

"Editing Self-Registration Pages" on page 354
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Editing Guest Receipt Page Properties
To edit the properties of the guest receipt page:

1. Go to Configuration > Pages > Guest Self-Registration

2. Select an entry in the Guest Self-Registration list and click its Edit link. The Customize Guest
Registration workflow diagram opens.

3. Click the Receipt Page link or one of the Title, Header, or Footer fields for the Receipt Page to edit the
properties of the receipt page. This page is shown to guests after their guest account has been created.

Figure 268 The Customize Guest Registration Form, Receipt Page UI Area

Field Description

Title Title to display on the guest receipt page. Template code may be specified. See "Smarty Template
Syntax" on page 713 for details on the template code that may be inserted.

Header
HTML

HTML for the message that is displayed above the guest receipt. Template code may be specified. See
"Smarty Template Syntax" on page 713 for details on the template code that may be inserted.

Footer
HTML

HTML for the message that is displayed below the guest receipt. Template code may be specified. See
"Smarty Template Syntax" on page 713 for details on the template code that may be inserted.

Override
Receipt

If selected, lets you replace the HTML of the guest receipt.

Save
Changes

Saves your changes and returns to the process diagram for self-registration.

Save and
Continue

Saves your changes, updates the self-registration page, and continues to the next editor (Receipt
Actions).

Table 156: Customize Guest Registration Form, Receipt Page UI Area
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Editing Receipt Actions
To edit the actions that are available after a guest account has been created:

1. Go to Configuration > Pages > Self-Registrations.

2. Select an entry in the Self-Registrations list and click its Edit link. The Customize Self-Registration
workflow diagram opens.

3. In the Receipt Page area of the diagram, click the Actions link. The Receipt Actions part of the
Customize Self-Registration form opens.

Figure 269 The Actions Link on the Workflow Diagram

Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2494



Figure 270 The Customize Guest Registration Form, Receipt Actions Page, Download Area

Editing Download Actions for Guest Receipt Delivery

The Download area on the Receipt Actions part of the Customize Guest Registration form lets you
configure template and display options to deliver a receipt to the user as a downloadable file.

Field Description

Enabled If selected, enables download of guest receipts. The form expands to include configuration options for
receipt downloads.

Rank Specifies the relative ordering number for this receipt action.

Print
Template

Specifies the print template to use to generate the receipt. Options include:
l Account List
l Certificate Expiry

Table 157: Customize Guest Registration Form, Receipt Actions Page, Download Area
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Field Description

l Download Receipt
l Guest Account Expiry
l GuestManager Receipt
l One account per page
l SMS Receipt
l SMS Sponsor Confirmation Alert
l Sponsor Device Provisioning
l Sponsorship Confirmation
l Two-column scratch cards

Filename The template code to evaluate to generate the filename for the receipt.

Action
Icon

Specifies a custom icon to use for the download receipt action. Image files that have been uploaded to
Content Manager will be included in this drop-down list.

Action
Text

Label to use for the download receipt action.

Table 157: Customize Guest Registration Form, Receipt Actions Page, Download Area(Continued)

Editing Print Actions for Guest Receipt Delivery

The Print area on the Receipt Actions part of the Customize Guest Registration form lets you configure
options for displaying the receipt in a printable window in the guest’s browser.

Figure 271 The Customize Guest Registration Form, Receipt Actions Page, Print Area

Field Description

Enabled If selected, enables the print window for guest receipts. The form expands to include configuration
options for printer actions.

Rank Specifies the relative ordering number for this receipt action.

Print
Template

Specifies the print template to use to generate the receipt. Options include:
l Account List
l Certificate Expiry
l Download Receipt

Table 158: Customize Guest Registration Form, Receipt Actions Page, Print Area
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Field Description

l Guest Account Expiry
l GuestManager Receipt
l One account per page
l SMS Receipt
l SMS Sponsor Confirmation Alert
l Sponsor Device Provisioning
l Sponsorship Confirmation
l Two-column scratch cards

Action
Icon

Specifies a custom icon to use for the printer receipt action. Image files that have been uploaded to
Content Manager will be included in this drop-down list.

Action
Text

Label to use for the printer receipt action.

Table 158: Customize Guest Registration Form, Receipt Actions Page, Print Area(Continued)

Editing Email Delivery of Guest Receipts

The Email Delivery options available for the receipt page actions allow you to specify the email subject line,
the print template and email format, and other fields relevant to email delivery.

Figure 272 The Customize Guest Registration Form, Receipt Actions Area, Email Delivery Options
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Field Description

Enabled Specifies options for disabling or configuring the sending of guest receipts by email. Options include:
l Disable sending guest receipts by email — Email receipts are never sent for a guest

registration.
l Always auto-send guest receipts by email — An email receipt is always generated using the

selected options, and will be sent to the guest’s email address.
l Auto-send guest receipts by email with a special field set — If the auto-send field available for

this delivery option is set to a non-empty string or a non-zero value, an email receipt will be
generated and sent to the guest’s email address. The auto-send field can be used to create an “opt-
in” facility for guests. Use a check box for the auto_send_smtp field and add it to the create_user
form, or a guest self-registration instance, and email receipts will be sent to the guest only if the
check box has been selected.

l Display a link enabling a guest receipt via email — A link is displayed on the receipt page; if the
guest clicks this link, an email receipt will be generated and sent to the guest’s email address.

l Send an email to a list of fixed addresses — An email receipt is always generated using the
selected options, and will be sent only to the list of email addresses specified in the Copies To field.

Auto-
Send
Field

(Required) Specifies the field that, if it contains a non-empty string or non-zero value, will cause an
account receipt email to be automatically sent upon creation of a guest account.

Email
Field

(Required) Specifies the field containing the guest account’s email address.

Subject
Line

Template specifying the subject line for emailed guest account receipts. To use the default (Guest
account receipt for {$email}), leave this field empty.

Email
Receipt

(Required) Specifies the plain text or HTML print template to use when generating an email receipt.
Options include:
l (Use Default: GuestManager Receipt)
l Account List
l Certificate Expiry
l Download Receipt
l Guest Account Expiry
l GuestManager Receipt
l One account per page
l SMS Receipt
l SMS Sponsor Confirmation Alert
l Sponsor Device Provisioning
l Sponsorship Confirmation
l Two-column scratch cards

Email
Skin

(Required) Specifies the format in which to send email receipts. Options include:
l (Use Default: Use the default skin)
l No skin — Plain text only
l No skin — HTML only
l No skin — Native receipt format
l Use the default skin
l Aruba ClearPass skin
l Blank skin
l ClearPass Guest skin
l Custom Skin 1

Table 159: Customize Guest Registration Form, Receipt Actions Area, Email Delivery Options
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Field Description

l Custom Skin 2
l Galleria Skin 1
l Galleria Skin 2

Send
Copies

(Required) Specifies when to send guest account receipts to the recipients in the Copies To list. Options
include;
l (Use Default: Use “Bcc:” if sending to a guest)
l Do not send copies
l Always send using “cc:”
l Always send using “Bcc:”
l Use “cc:” if sending to a guest
l Use “Bcc:” if sending to a guest

Copies
To

List of email addresses to which copies of guest account receipts will be sent. To have the email sent to
the sponsor’s email address, enter “_admin”.

Reply-To If selected, the reply-to address will be overridden by the sponsor_email field. To use the global From
Address, leave this check box unselected.

Override
From

If selected, the From Address will be overridden instead of using the reply-to value specified above. To
allow this override, this feature might require configuration on your mail server.

Rank Specifies the relative ordering number for this receipt action.

Action
Icon

Specifies a custom icon to use for the email delivery receipt action. Image files that have been
uploaded to Content Manager will be included in this drop-down list.

Action
Text

Label to use for the email delivery receipt action.

Table 159: Customize Guest Registration Form, Receipt Actions Area, Email Delivery Options(Continued)
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Editing SMS Delivery of Guest Receipts

The SMS Delivery options available for the receipt page actions allow you to specify the field containing the
guest’s phone number, the service provider, and the SMS receipt template.

Figure 273 The Customize Guest Registration Form, Receipt Actions Area, SMS Delivery Options

Field Description

Enabled Specifies options for disabling or configuring SMS delivery. Options include:
l Disable sending guest receipts by SMS — SMS receipts are never sent for a guest registration.
l Always auto-send guest receipts by SMS — An SMS receipt is always generated using the

selected options, and will be sent to the guest’s phone number.
l Auto-send guest receipts by SMS with a special field set — If the Auto-Send Field is set to a

non-empty string or a non-zero value, an SMS receipt will be generated and sent to the guest’s
phone number. The auto-send field can be used to create an “opt-in” facility for guests. Use a check
box for the auto_send_sms field and add it to the create_user form, or a guest self-registration
instance, and SMS messages will be sent to the specified phone number only if the check box has
been selected.

l Display a link enabling a guest receipt via SMS — A link is displayed on the receipt page; if the
guest clicks this link, an SMS receipt will be generated and sent to the guest’s phone number. Only
one SMS receipt per guest registration can be sent in this way.

Auto-
Send
Field

Specifies the field that, if it contains a non-empty string or non-zero value, will cause an account receipt
SMS to be automatically sent upon creation of a guest account.

Phone
Number
Field

Specifies the field to use for the guest’s phone number.

Service
Provider

Specifies the service provider to use when sending SMS messages.

SMS
Receipt

Specifies the plain text format print template to use when generating an SMS receipt. Options include:
l (Use Default: SMS Receipt)

Table 160: Customize Guest Registration Form, Receipt Actions Area, SMS Delivery Options
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Field Description

l Download Receipt
l SMS Receipt
l SMS Sponsor Confirmation Alert

Rank Specifies the relative ordering number for this receipt action.

Action
Icon

Specifies a custom icon to use for the SMS delivery receipt action. Image files that have been uploaded
to Content Manager will be included in this drop-down list.

Action
Text

Label to use for the SMS delivery receipt action.

Table 160: Customize Guest Registration Form, Receipt Actions Area, SMS Delivery Options(Continued)

Enabling Downloading Passes

The Download Pass area of the Receipt Actions form provides options for downloading a guest receipt as a
pass to use with Apple Passbook.

l If a pass certificate is not installed, an error is displayed. For information on digital passes and installing pass
certificates, see "Digital Passes" on page 429.

l If a pass certificate is installed, select the appropriate pass template.

When your changes are complete on the Receipt Actions part of the Customize Guest Registration form,
click Save Changes.

Editing Sponsor Confirmation
You can allow the sponsor to choose the role for the guest account at the time the sponsor approves the self-
registered account. When a guest submits the registration form, the sponsor receives an email notification. To
confirm the guest’s access and change the guest’s role, the sponsor clicks a link in the email and is redirected to
the Guest Registration Confirmation form.

To enable role selection by the sponsor and configure the email notification:

1. Go to Configuration > Pages > Guest Self-Registrations.

2. Select an entry in the Guest Self-Registration list and click its Edit link. The Customize Guest
Registration workflow diagram opens.

3. In the Receipt Page area of the diagram, click the Sponsor Confirmation link. The Sponsorship
Confirmation part of the Customize Guest Registration form opens.
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Figure 274 The Sponsor Confirmation Link on the Workflow Diagram
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Figure 275 The Customize Guest Registration Form, Sponsorship Confirmation Page, Email Delivery Area

Editing Email Delivery Options for Sponsorship Confirmation

The Email Delivery area on the Sponsorship Confirmation part of the Customize Guest Registration
form lets you configure options for the notification email that is sent to the sponsor, such as sponsor
authentication and the print template and email format.
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Field Description

Enabled If selected, sponsorship confirmation is required before the guest account can be enabled. The
form expands to include configuration options for sponsorship confirmation.

Authentication if selected, sponsors must provide credentials and be successfully authenticated before they can
approve the guest account request. The sponsor’s operator profile must include the Guest
Manager > Remove Accounts privilege.

Email Field (Required) Specifies the field to use for the sponsor’s email address.

Email
Confirmation

Specifies the print template to use to generate the email to the sponsor. Options include:
l Account List
l Certificate Expiry
l Download Receipt
l Guest Account Expiry
l GuestManager Receipt
l One account per page
l SMS Receipt
l SMS Sponsor Confirmation Alert
l Sponsor Device Provisioning
l Sponsorship Confirmation
l Two-column scratch cards

Email Skin (Required) Specifies the format in which to send the email to the sponsor. Options include:
l (Use Default: Use the default skin)
l No skin — Plain text only
l No skin — HTML only
l No skin — Native receipt format
l Use the default skin
l Aruba ClearPass skin
l Blank skin
l ClearPass Guest skin
l Custom Skin 1
l Custom Skin 2
l Galleria Skin 1
l Galleria Skin 2

Send Copies (Required) Specifies when to send copies of the sponsorship email to the recipients in the Copies
To list. Options include;
l Do not send copies
l Always send using “cc:”
l Always send using “Bcc:”

Copies To List of email addresses to which copies of the sponsorship email will be sent. To have the email
sent to the sponsor’s email address, enter “_admin”.

Reply-To If selected, the reply-to address will be overridden by the guest’s email field.

Override From If selected, the From Address will be overridden instead of using the reply-to value specified
above. To allow this override, this feature might require configuration on your mail server.

Table 161: Customize Guest Registration Form, Sponsorship Confirmation Page, Email Delivery Area
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Editing SMS Delivery Options for Sponsorship Confirmation

The SMS Delivery options available for sponsorship confirmation allow you to specify the field containing the
guest’s phone number, the service provider, and the SMS receipt template.

Figure 276 The Customize Guest Registration Form, Sponsorship Confirmation Page, SMS Delivery Area

Field Description

SMS If selected, an SMS message will be sent to the sponsor notifying them of the guest account request.
The form expands to include configuration options for SMS delivery.

Phone
Number
Field

Specifies the field to use for the sponsor’s phone number.

Service
Provider

Specifies the service provider to use when sending SMS messages.

SMS
Receipt

Specifies the plain text format print template to use when generating an SMS receipt. Options
include:
l (Use Default: SMS Receipt)
l Download Receipt
l SMS Receipt
l SMS Sponsor Confirmation Alert

Table 162: Customize Guest Registration Form, Sponsorship Confirmation Page, SMS Delivery Area
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Editing UI Override Options for Sponsorship Confirmation

The UI Overrides area on the Sponsorship Confirmation part of the Customize Guest Registration form
lets you customize the user interface text and labels, overriding the default values.

Figure 277 The Customize Guest Registration Form, Sponsorship Confirmation Page, UI Overrides Area

Field Description

UI Overrides If selected, lets you customize the user interface text and labels. The form expands to include
configuration options to override default values.

Subject Line Template specifying the subject line for emailed guest account receipts. To use the default
(Wireless access request from: {$email}), leave this field empty.

Confirmation
Title

Title for the confirmation page. To use the default title (Guest Registration Confirmation), leave
this field empty.

Table 163: Customize Guest Registration Form, Sponsorship Confirmation Page, UI Overrides Area
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Field Description

Header
HTML

HTML for the message that is displayed before the login form. Template code may be specified.
See "Smarty Template Syntax" on page 713 for details on the template code that may be inserted.
You can use the drop-down list to add images or links.

Form
Override

If selected, lets you override the form. The Confirm Button and Reject Button configuration
options are removed from this form.

Confirm
Button

Label for the Confirm button. To use the default (Confirm), leave this field empty.

Reject
Button

Label for the Reject button. To use the default (Reject), leave this field empty.

Footer HTML HTML for the message that is displayed after the confirmation form. Template code may be
specified. See "Smarty Template Syntax" on page 713 for details on the template code that may be
inserted. You can use the drop-down list to add images or links.

Registration
Receipt

HTML for the message that is displayed on the guest receipt prior to confirmation. Template code
may be specified. See "Smarty Template Syntax" on page 713 for details on the template code that
may be inserted. You can use the drop-down list to add images or links.

Table 163: Customize Guest Registration Form, Sponsorship Confirmation Page, UI Overrides Area(Continued)

Editing Account Override Options for Sponsorship Confirmation

The Account Overrides area on the Sponsorship Confirmation part of the Customize Guest
Registration form provides options for changing the guest’s role, account expiration, and account state.

Figure 278 The Customize Guest Registration Form, Sponsorship Confirmation Page, Account Overrides Area
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Field Description

Role
Override

Specifies the role assigned to the guest when the sponsor’s confirmation is successful, or lets the
sponsor assign the role during confirmation. Options include:
l (No override)
l (Prompt)
l [Contractor]
l [Employee]
l [Guest]
If “Prompt” is selected, the sponsor chooses the role for the guest from the Account Role drop-down
list of the guest registration receipt.

For more information, see "Changing a Guest Account Role" on page 379.

Extend
Expiration

To extend the guest account’s expiration time, you may enter a value in this field. To use the original
expiration time, leave this field empty.
To automatically add time, enter a single value.
To display an option to the sponsor, enter a list of values, one per line (”Value | Label”).
Example values: +12h, +30d, or +1y.

Account
State

Specifies the state to assign to the account upon confirmation. Options include:
l Enabled — Account will have network access prior to confirmation
l Disabled — Account will remain disabled until confirmation

Save
Changes

Saves your changes and returns to the process diagram for self-registration.

Save and
Continue

Saves your changes, updates the self-registration page, and continues to the next editor (Login
Page).

Table 164: Customize Guest Registration Form, Sponsorship Confirmation Page, Account Overrides Area

Changing a Guest Account Role

If you are changing a guest account’s role, you must also configure change of authorization (CoA) requests to
handle the change correctly. This ensures that the appropriate CoA requests are triggered for active sessions.
The following steps are performed in ClearPass Policy Manager:

1. Go to Policy Manager > Configuration > Enforcement > Profiles > Add.

2. On the Profile tab, open the the Template drop-down list and select RADIUS Change of Authorization
(CoA).
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3. In the Name field, the name you enter for the profile must include the exact role name in square brackets.
For example, for the role “[Guest]”, the profile name might be “My Company [Guest] CoA”.

4. On the Attributes tab, open the Select RADIUS CoA Template drop-down list and select Aruba -
Change-User-Role.

5. Click a row and add an attribute with the Type as Radius:IETF. For the Value enter the role name, but
without the square brackets this time.

Editing Login Page Properties
The login page is displayed if automatic guest login is enabled and a guest clicks the Submit button from the
receipt page to log in.

To edit the properties of the login page:

1. Go to Configuration > Pages > Self-Registrations. Click to expand the registration page's row in the
form, and then click its Edit link. The Customize Self-Registration diagram opens.

2. Under the Receipt Page > Submit area of the diagram, click either the Title or Login Message link to edit
the properties of the login page.

Figure 279 The Login Page Links on the Workflow Diagram

Figure 280 The Customize Self-Registration Form, Login Form Page, Enabled/Disabled Area
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Field Description

Enabled Specifies the login or device enrollment method. Options include:
l Disabled
l Enable guest login to a Network Access Server — Allows NAS login. The form expands to

include configuration options. See "Configuring the Login Form Part of the Page" on page 381
and "Configuring the Login Message Part of the Page" on page 384.

l Enable Onboard device enrollment — Allows simultaneous self-registration and Onboard
device enrollment. The form expands to include configuration options. See "Configuring Self-
Registration with Onboard Device Enrollment" on page 385

Health Check If selected, the guest must pass a health check prior to accessing the network.

Authentication
Providers

Specifies an authentication provider. All authentication providers that have been configured are
included in this list. To add a new authentication provider, click the Add new authentication
provider link. The row expands to include the Properties form, where you can select and
configure a cloud identity or social network provider for authentication.

Save Changes Saves your changes and returns to the process diagram for self-registration.

Save and
Continue

Saves your changes, updates the self-registration page, and continues to the next editor (Self-
Service Portal).

Table 165: Customize Self-Registration Form, Login Form Page, Enabled/Disabled Area

Configuring the Login Form Part of the Page

The login page is also a separate page that can be accessed by guests using the login page URL. The login page
URL has the same base name as the registration page, but with login appended. To determine the login page
URL for a self-registration page, first ensure that the Enable guest login to a Network Access Server
option is checked, and then click the Launch network login link from the self-registration process
diagram.

The login page consists of two separate parts: the login form page, and a login message page.

The options available under the Login Form heading may be used to customize the login page.
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Login Form and Post-Authentication Areas

Figure 281 The Customize Self-Registration Form, Login Form and Post-Authentication Areas

Field Description

Custom Form Indicates you will provide a custom login form. If selected, you must supply your own HTML login
form for the header or footer HTML areas.

Custom Labels Enables altering the default labels and error messages.

Username
Label

Label that appears on the form for the username field. Leave blank to use the default,
(Username:).

Password
Label

Label that appears on the form for the password field. Leave blank to use the default
(Password:).

Pre-Auth
Check

Specifies how the username and password will be checked before proceeding to the NAS
authentication. Do not select this option if an external authentication server is used. Options
include:
l None — no extra checks will be made
l App Authentication — check using Aruba Application Authentication
l Local — match a local account
l RADIUS — check using a RADIUS request

Pre-Auth Error Customized label text to display if username and password lookup fails. Leave blank to use the
default (Invalid username or password).

Table 166: The Customize Self-Registration Form, Login Form and Post-Authentication
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Field Description

Username
Authentication

Allows the user to log in with only a username. The Password field will not be displayed. Only
accounts with the Username Authentication flag set can log in.

Terms Requires the user mark a check box to accept a Terms and Conditions agreement.

Terms Label Label that appears on the form for the terms check box. Leave blank to use the default (Terms:).

Terms Text Enter the HTML code containing your terms and conditions. Leave blank to use the default, (I
accept the <a href="{nwa_global name=guest_account_terms_of_use_url}" target="_
blank">terms of use</a>)

Terms Layout Layout for the terms and conditions text—either above or below the Terms check box.

Terms Error Text to display if the terms are not accepted. Leave blank to use the default (In order to log in,
you must accept the terms and conditions.).

Log In Label Label that appears on the form for the login button. Leave blank to use the default (Log In).

Health Check Requires the guest to pass a health check before they can access the network. The health check
is done automatically through the OnGuard Dissolvable Agent.

Header HTML The HTML content to display above the health check text. You can use the drop-down list to add
images or other content items.

Footer HTML The HTML content to display below the health check text. You can use the drop-down list to add
images or other content items.

Update
Endpoint

Marks the user's MAC address as a known endpoint, and updates the endpoint's attributes with
other details from the user account (for example, the SSID, AP, and MAC address). If this check
box is selected, the form expands to include the Advanced field.

Advanced Lets you specify custom attributes to store in the endpoint. If this check box is selected, the form
expands to include the Endpoint Attributes field.

Endpoint
Attributes

Enter the list of name-value pairs to pass as custom attributes. Follow the format user_field |
Endpoint Attribute. Examples are shown.

Login UI Area

The login form page contains a form prompting for the guest’s username and password. The title, header, and
footer of this page can be customized. If the Provide a custom login form option is selected, then the form
must also be provided in either the Header HTML or Footer HTML sections.
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Figure 282 The Customize Self-Registration Form, Login UI Area

Field Description

Login Page
Title

The title that will be displayed on the NAS login page.

Header
HTML

The HTML content to display above the NAS login form. You can use the drop-down lists to add
images or other content items.

Footer
HTML

The HTML content to display below the NAS login form. You can use the drop-down lists to add
images or other content items.

Table 167: The Customize Self-Registration Form, Login UI Section

Click the Save Changes button to return to the process diagram for self-registration.

Configuring the Login Message Part of the Page

The login message page is displayed after the login form has been submitted, while the guest is being
redirected to the NAS for login. The title and message displayed on this page can be customized.

Figure 283 The Customize Self-Registration Form, Login Page Area, Title and Login Message Fields

The login delay can be set. This is the time period, in seconds, for which the login message page is displayed.
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Figure 284 The Customize Self-Registration Form, Automatic Login Area, Login Delay Option

Click the Save Changes button to return to the process diagram for self-registration.

Configuring Self-Registration with Onboard Device Enrollment

To allow Onboard enrollment with self-registrations:

1. Go to Configuration > Pages > Self-Registrations. Click to expand the registration page's row in the
form, and then click its Edit link. The Customize Self-Registration diagram opens.

2. Under the Receipt Page > Submit area of the diagram, click the Login Message link to edit the
properties of the login page.

Figure 285 The Login Message Link on the Workflow Diagram

Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2514



Figure 286 The Customize Self-Registration Page, Onboard Enrollment Options

Field Description

Enabled To allow simultaneous self-registration and Onboard device enrollment, select Enable Onboard
device enrollment.

Provisioning
Settings

Local Device Provisioning is the only option available in this field when Onboard device
enrollment is selected.

Health Check To require the device to pass a health check before access is granted, select the check box in
this row.

Header HTML Enter the HTML for the message that is displayed before the health check. You can use the drop-
down lists to add images or links.

Footer HTML Enter the HTML for the message that is displayed after the health check. You can use the drop-
down lists to add images or links.

Table 168: Customize Self-Registration, Onboard Enrollment

Click the Save Changes button to return to the process diagram for self-registration.

Editing Cloud Identity Properties
Options in the Cloud Identity area let you present guests with a variety of cloud identity or social network
login options.

To edit the cloud identity properties of the login page:

1. Go to Configuration > Pages > Self-Registrations. Click to expand the registration page's row in the
form, and then click its Edit link. The Customize Self-Registration diagram opens.

2. Under the Receipt Page > Submit area of the diagram, click either the Title or Login Message link to edit
the properties of the login page.
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3. Scroll to the Cloud Identity area of the form.

Figure 287 The Customize Self-Registration Form, Login Form Page, Cloud Identity Area: Enabling Cloud Identity
or Social Logins

Field Description

Enabled If selected, enables the use of cloud identity credentials to log in. The form expands to include
Authentication Providers configuration options.

Authentication
Providers

After you enable logins with cloud identity credentials, options in this area let you specify the
authentication provider and configure options for them.

Add new
authentication
provider

Opens the properties form for adding and configuring an authentication provider.

Buttons Shows the syntax for displaying cloud identity login buttons on the page. You must add
{nwa_social_logins} to either the HTML Header or HTML Footer area.

Debug If selected, cloud identity debugging will be included in the application log.

Table 169: Customize Self-Registration Form, Login Form Page, Cloud Identity Area: Enabling Cloud Identity or
Social Logins
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Figure 288 The Customize Self-Registration Form, Login Form Page, Authentication Providers Area (Facebook
selected as an example provider)

ClearPass Guest 6.7 | User Guide Configuration | 388
Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2517



389 | Configuration ClearPass Guest 6.7 | User Guide

Field Description

Provider (Required) Specifies the cloud identity authentication provider to use. All authentication providers
that have been configured are included in this list.
The following options presented in the Authentication Providers area depend on the provider
selected in this drop-down list.

Enabled If this check box is selected, the specified provider can be used.

Advanced If selected, displays additional options on this form.

Allow Guests (G Suite) If selected, allows Google accounts that are not part of your domain to log in as guests.
The social_vip flag will be set to false for these users.

Authorization
Code

(Required) (G Suite) When you generate a new code, it is automatically entered in this field, and
you can close the redirect window.

Auto Redirect If selected, local logins and other providers will not be supported. If this option is selected, we
recommend you also enable Custom Form in the Login Form area.

Clever Profile (Clever) If selected, access to the client’s full profile is requested and the Client ID must have
advanced privileges.

Client ID (Required) Client ID to use with this provider. The provider might use a different label.

Client Secret (Required) Client secret to use with this provider. The provider might use a different label.

Cloud
identity
whitelists
link

The Cloud identity whitelists for use in captive portals link opens Aruba's cloud identity
whitelists page of GitHub. GitHub is an external, third-party platform for hosting and sharing code.
You can use this page to access the latest whitelist entries for cloud identity providers that are
used by ClearPass for cloud logins and Onboarding.

Delete Removes the provider from the list and deletes its configuration. You will be asked to confirm the
deletion.

Destination URL to which guests authenticating with this provider will be redirected after logging in.

Disable Disables the provider. To enable it again, click the Enable link.

Disconnect
Action

(Facebook WiFi) For the Facebook Wi-Fi provider, specifies the action to take when a disconnect is
requested by Facebook. Options include:
l Terminate Session
l Cisco - Disable Host-Port
l Cisco - Bounce-Host-Port
l Cisco - Reauthenticate Session

District ID (Clever) Identifier for the school district. During authentication, this ID is compared to the
ID returned by a Clever Instant Login. If no value is entered in this field, Clever’s District Picker will
handle the details.

Edit Opens the Properties form. You can edit any of the configuration options for the provider.

Email If selected, allows access to the guest's email address. Access requires additional permission for
the provider.

Endpoint Specifies whether to create endpoint attributes, and how they will be handled. Options include:

Table 170: Customize Self-Registration Form, Login Form Page, Authentication Providers
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Field Description

Attributes l Do not create additional attributes
l Create Endpoint attributes converting any arrays to JSON
l Create Endpoint attributes flattening the entire data set
If one of the Create options is selected, an endpoint attribute is created for every attribute
returned by the user. This is only needed if you are creating specialized enforcement policies on
them.

Flatten
Prefix

If Endpoint Attributes was selected, you may enter text to prepend to all keys when flattening.
This stores a normalized version of all the returned attributes in the endpoint. If nothing is entered
in this field, the default "social" will be used.

Friends (Facebook) If selected, allows a list of the guest’s friends to be retrieved, if permission is granted
by the guest. The list is limited to only those friends who also use your application ID.

Generate
Code

(G Suite) To generate a new authorization code, click the link in this field. You will be redirected to
a new window to generate an authorization code.

Google Apps
VIP

Name of the user record attribute to apply to the social_vip flag. For more information, refer
to the Google Directory API for retrieving users.

Google
Groups

(G Suite) If selected, all groups associated with the account will be retrieved and stored as a list of
group names and a list of matching email addresses. The Admin SDK Refresh Token and
Authorization Code must also be regenerated.

Google Plus (Google) if selected, allows access to the guest's Google Plus profile. Access requires additional
permission for the provider.

Group
Membership

(Microsoft Azure AD) If selected, all groups associated with the account will be retrieved and
stored as a list of group names and a list of matching email addresses.

Hostname If specified, overrides the hostname guests are redirected to for authentication. This field is
optional; leave it empty if you are unsure.

Icon Label Overrides the default label on the provider's icon.

LinkedIn VIP (Linkedin) Enter a LinkedIn Distance value (0 - 3). If the guest is within this distance, the social_
vip flag will be enabled for them.

Move Up
Move Down

Moves the provider up or down in the list.

Notes You may enter additional notes or comments about the provider. This description is only seen by
administrators.

Scope Overrides the scope requested during OAuth. For syntax information, refer to the provider’s
documentation.

Twitter VIP (Twitter) Name of a Twitter account. If the guest follows this account, they will have the “social_vip”
flag enabled.

Username
Prefix

Text to prepend to all usernames. A prefix can be useful if you are providing a way to log in using a
variety of providers.
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Field Description

Username
Suffix

Text to append to all usernames. A suffix can be useful if you are providing a way to log in using a
variety of providers.

VIP Attribute (G Suite; Microsoft Azure AD) Name of the user record attribute to apply to the social_vip
flag. For more information, refer to the Microsoft Graph API for retrieving users.

Add When your entries are complete on the Properties form, click this button. The Properties form
closes and the provider is included in the Authentication Providers list.

Enabling and Editing NAS Login Properties
If automatic guest login is not enabled, the submit button on the receipt page will not be displayed, and
automatic Network Access Server (NAS) login will not be performed.

To enable and edit the properties for automatic NAS login:

1. Go to Configuration > Pages > Self-Registrations. Click to expand the registration page’s row in the
form, and then click its Edit link. The Customize Self-Registration diagram opens.

2. In the lower-right corner of the diagram, click the image of the NAS box or click the NAS Vendor Settings
link. The Login form opens.

Figure 289 The NAS Vendor Settings Area of the Diagram

Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2520



Figure 290 The Customize Self-Registration Form, NAS Login Area

Field Description

Enabled Specifies the NAS login method. Options include:
l Disabled
l Enable guest login to a Network Access Server
l Enable Onboard device enrollment

Provisioning
Settings

(Required) For Onboard device enrollment, specifies the provisioning settings to use when enrolling
self-registered devices.

Vendor
Settings

(Required) Specifies the vendor or other settings to use for standard network configurations.
Options include:
l A list of Vendors
l Custom Settings —The form includes options for configuring your custom settings.
l Captive Portal with ClearPass Web Auth —The form includes the options for configuring this

vendor setting.
l Single Sign-On — SAML Identity Provider — If this option is selected, an appropriate service

must be created in ClearPass using the ClearPass IDP service template. The external service
provider must then be configured to use the SAML Web login page as the IdP.

l Single Sign-On — Authorize Only

Login
Method

Specifies how the user’s network login will be handled. Options include:
l Controller-initiated — Guest browser performs HTTP form submit
l Server-initiated — Change of authorization (RFC 3576) sent to the controller
Server-initiated logins require the user’s MAC address to be available, usually from the captive
portal redirect process.

Table 171: Customize Self-Registration Form, NAS Login Area
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Field Description

IP Address (Required) IP address or hostname of the vendor’s product.

Secure
Login

Specifies the security option to apply to the Web login process. Options include:
l Use vendor default
l Secure login using HTTPS
l Send cleartext passwords over HTTP

Dynamic
Address

If selected, the controller will send the IP address to submit credentials. The address entered in the
IP Address field above will be used if the parameter is not available or fails the Denied Dynamic
and Allowed Dynamic requirements.

Denied
Dynamic

IP addresses and networks from which dynamic addresses are denied.

Allowed
Dynamic

IP addresses and networks from which dynamic addresses are permitted.

Security
Hash

Specifies the level of checking to apply to URL parameters that are passed to the Web login page.
You can select one of these options to detect when URL parameters have been modified by the
user (for example, their MAC address). Options include:
l Do not check — login will always be permitted
l Deny login on validation error — login will not be permitted

URL Hash
Key

(Required) Key that will be used to hash the Redirect URL.

Confirm Key

Submit URL (Required) URL of the NAS device’s login form.

Submit
Method

(Required) Method to use when logging in to the NAS. Options include:
l POST
l GET

Username
Field

(Required) Name of the username field for the NAS device’s login form.

Password
Field

(Required) Name of the password field for the NAS device’s login form.

Password
Encryption

(Required) Specifies the type of password encryption to use when logging in to the NAS. Options
include:
l No encryption (plaintext password)
l UAM basic
l UAM with shared secret
l PAP with shared secret
l MS-CHAP with shared secret

Extra Fields You may enter additional field names and values to send to the NAS device as name=value pairs,
one per line.

Username
Suffix

You may enter a suffix to automatically append to the username before logging in to the NAS.

Table 171: Customize Self-Registration Form, NAS Login Area(Continued)
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Field Description

UAM Secret Shared secret between the NAS device and the Web login form.

URL Field Name of the destination field required by the NAS.

Default URL (Required) Default URL to which to redirect clients.

Override
Destination

If selected, the default destination will be forced for all clients, and the client’s default destination
will be overridden regardless of its value.

Save
Changes

Saves your changes and returns to the process diagram for self-registration.

Save and
Continue

Saves your changes, updates the self-registration page, and continues to the next editor (Self-
Service Portal).

Table 171: Customize Self-Registration Form, NAS Login Area(Continued)

Self-Service Portal Properties

The self-service portal offers guests the ability to log in with their account details, view their account details, or
change their password. Additionally, the Reset Password link provides a method that allows guests to recover
a forgotten account password.

When the self-service portal is enabled, a Launch Self-Service link is displayed on the list of self-registration
pages, and may be used to determine the URL that guests should use to access the portal.

The self-service portal is accessed through a separate link that must be published to guests. The page name for
the portal is derived from the registration page name by appending “_portal”.

To edit the properties of the self-service portal:

1. Go to Configuration > Pages > Self-Registrations. Click to expand the registration page’s row in the
form, and then click its Edit link. The Customize Self-Registration diagram opens.

2. In the Self-Service Portal area, click either the Self-Service Portal link or click one of the links below it:
Login Page, Summary Page, Change Password, or Reset Password . The Self-Service Portal area of
the Customize Self-Registration form opens.

Figure 291 The Self-Service Portal Page Links on the Workflow Diagram
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Figure 292 The Customize Self-Registration Form, Self-Service Portal

The fields at the top of the form let you configure basic properties for the self-service portal.

Field Description

Enabled If selected, enables the self-service portal for guest access. If this check box is not selected, access to
the portal is disabled and a “disabled” message is displayed to the user.

Disabled
Message

The message to display to the user if the self-service portal is not enabled. To use the default value,
leave this field empty.

Disabled
Users

If selected, users whose accounts are disabled cannot log in to the self-service portal.

Silent
Login

If selected, a user will be logged in automatically if their client IP address matches the IP address of an
active RADIUS accounting session (that is, the guest’s HTTP client address is the same as the RADIUS
Framed-IP-Address attribute for an active session).

Table 172: The Customize Self-Registration Form, Self-Service Portal Area, Basic Properties
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Figure 293 The Customize Self-Registration Form, Self-Service Portal Page, Login Page Area

The Login Page area of the form lets you configure the self-service portal’s login page.

Field Description

UI Overrides If selected, lets you customize the self-service portal’s login form’s text and HTML. The form
expands to include configuration options.

Create
Account

If selected, removes the “Create Account” link from the self-service portal’s login page.

Page Title Title to display on the self-service portal’s login page. To use the default value, leave this field
empty.

Table 173: Customize Self-Registration Form, Self-Service Portal Page, Login Page Area
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Field Description

Header HTML The HTML content to display before the login form. You can use the drop-down list to add images
or other content items.

Login Form
Override

If selected, overrides the login form.

Form Title Title to display on the login form. To use the default value, leave this field empty.

Username
Label

Label to display on the username field. To use the default value, leave this field empty.

Password
Label

Label to display on the password field. To use the default value, leave this field empty.

Login Button Label to display on the login button. To use the default value, leave this field empty.

Footer HTML The HTML content to display after the login form. You can use the drop-down list to add images
or other content items.

Table 173: Customize Self-Registration Form, Self-Service Portal Page, Login Page Area(Continued)

Figure 294 The Customize Self-Registration Form, Self-Service Portal Page, Summary Page Area
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The Summary Page area of the form lets you configure the self-service portal’s summary page.

Field Description

UI Overrides If selected, lets you customize the self-service portal’s summary page’s text and HTML. The form
expands to include configuration options.

Page Title Title to display on the self-service portal’s summary page. To use the default value, leave this field
empty.

Header
HTML

The HTML content to display before the summary. You can use the drop-down list to add images or
other content items.

Footer HTML The HTML content to display after the summary. You can use the drop-down list to add images or
other content items.

Table 174: Customize Self-Registration Form, Self-Service Portal Page, Summary Page Area

Figure 295 The Customize Self-Registration Form, Self-Service Portal Page, Change Password Area
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The Change Password area of the form lets you configure the self-service portal’s password fields.

Field Description

Change
Password

If selected, guests cannot use the self-service portal to change their passwords.

Extend
Expiration

Amount of time to extend an account’s expiration window whenever the password is changed. If a
value is entered, the account's lifetime will be automatically renewed in cases where it would
otherwise expire before the next required password change. To use the original expiration time,
leave this field empty.

UI
Overrides

If selected, lets you customize the self-service portal’s password fields. The form expands to include
configuration options.

Page Title Title to display on the self-service portal’s password form. To use the default value, leave this field
empty.

Header
HTML

The HTML content to display before the password form. You can use the drop-down list to add
images or other content items.

Form Title Title to display on the password form. To use the default value, leave this field empty.

Old
Password
Label

Label to display on the old password field. To use the default value, leave this field empty.

Old
Password
Description

Label to display on the old password description field. To use the default value, leave this field
empty.

New
Password
Label

Label to display on the new password field. To use the default value, leave this field empty.

New
Password
Description

Label to display on the new password description field. To use the default value, leave this field
empty.

Confirm
Password
Label

Label to display on the confirm password field. To use the default value, leave this field empty.

Confirm
Password
Description

Label to display on the confirm password description field. To use the default value, leave this field
empty.

Change
Password
Button

Label to display on the change password button. To use the default value, leave this field empty.

Footer
HTML

The HTML content to display after the password form. You can use the drop-down list to add images
or other content items.

Table 175: Customize Self-Registration Form, Self-Service Portal Page, Change Password Area
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Figure 296 The Customize Self-Registration Form, Self-Service Portal Page, Reset Password Area

The Reset Password area of the form lets you configure the self-service portal’s password reset fields. For
more information, see "Resetting Passwords with the Self-Service Portal" on page 401.

Field Description

Reset
Password

If selected, guests cannot use the self-service portal to reset a forgotten password.

Required Field Specifies the field to use for a value the guest must match in order to confirm their identity
before they can reset their password.

Match If selected, a case-insensitive match is performed on the value the user enters in the required
field.

Password
Generation

Specifies the password reset method to use in the self-service portal. Options include:
l Passwords will be randomly generated
l Manually enter passwords

UI Overrides If selected, lets you customize the self-service portal’s password reset fields. The form expands
to include configuration options.

Page Title Title to display on the self-service portal’s reset password form. To use the default value, leave
this field empty.

Header HTML The HTML content to display before the reset password form. You can use the drop-down list to
add images or other content items.

Table 176: Customize Self-Registration Form, Self-Service Portal Page, Reset Password Area
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Field Description

Reset Form
Override

If selected, overrides the reset password form.

Form Title Title to display on the reset password form. To use the default value, leave this field empty.

Footer HTML The HTML content to display after the reset password form. You can use the drop-down list to
add images or other content items.

Save and
Reload

Saves your changes on this form and stays on this page.

Save Changes Saves your changes and returns to the process diagram for self-registration.

Table 176: Customize Self-Registration Form, Self-Service Portal Page, Reset Password Area(Continued)

Resetting Passwords with the Self-Service Portal

The self-service portal includes the ability to reset a guest account’s password.

The default user interface for the self-service portal is shown below:

Figure 297 The Self-Service Login Form

When the user clicks the  I’ve forgotten my password link, it displays a form where the user can reset their
password:

Figure 298 The Reset Password Form

If the user enters a valid username, the password for that user account is reset, and the receipt page showing
the new password and a login option (if NAS login has been enabled) is displayed.
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This feature allows the password to be reset for any guest account on the system, which might pose a security
risk. It is strongly recommended that when this feature of the self-service portal is enabled, guest registrations
should also store a secret question/secret answer field.

To enable a more secure password reset operation, use the Reset Password fields described in "Self-Service
Portal Properties" on page 394 to perform the following steps.

First, enable the secret_question and secret_answer fields to the registration form. The default appearance
of these fields on the registration form is shown below:

Figure 299 The Self-Registration Form

Next, enable the Required Field option in the Self-Service Portal properties. Setting this to (Secret
Question) will ask the guest the secret_question and will only permit the password to be reset if the guest
supplies the correct secret_answer value.

With these settings, the user interface for resetting the password now includes a question and answer prompt
after the username has been determined:

Figure 300 The Reset Password Form
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Selecting a different value for the Required Field allows other fields of the guest account to be checked. These
fields should be part of the registration form. For example, selecting the visitor_name field as the required
field results in a Reset Password form like this:

Figure 301 The Reset Password Form with the Guest’s Name as a Required Field

Managing Web Logins

The Web Logins page lists all the Web login pages you have created, and lets you edit and test them and
create new Web login pages.

To view the list of your Web login pages and work with them, go to Configuration > Pages > Web Logins.
The Web Logins list view opens. All Web login pages you have created are included in the list. Information
shown for each page includes its name for internal identification, title as displayed in the user interface,
filename, and the skin assigned to it.

Figure 302 The Web Logins List View

You can click a page's row in the list for additional options:

Field Description

Edit Edit any of a Web login page's attributes. The Web Login Editor form opens. For
more information, see "Creating and Editing Web Login Pages" on page 404.

Duplicate Create a copy of a Web login page to use as a basis for a new page. A progress
bar is shown while the page settings are duplicated. When it is complete, the
new page is displayed in the list with "Copy of" prepended to its name. The copy
has all attributes prepopulated from the original page. You can click the copy's
row in the list to open the editor and edit any of its attributes.

Delete Delete the page. You will be asked to confirm the deletion.

Table 177: The Web Logins List View
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Field Description

Test View and test a Web login page. The page opens in a new tab as it would appear
to a user:

Create new Web login page Create a new Web login page. For more information, see "Creating and Editing
Web Login Pages" on page 404.

Creating and Editing Web Login Pages

Onboard device provisioning pages are now managed from the Web Login tab in Onboard > Provisioning
Settings.

Onboard creates a default Web login page that is used to start the device provisioning process. The Web Login
Editor form lets you create a new Web login page, edit an existing page, or copy an existing page to use as a
basis for a new Web login page. To perform these tasks, go to Configuration > Pages > Web Logins, and
then:

l To create a new Web login page, click the Create a new web login page link in the upper-right corner.

l To edit an existing Web login page, click the Edit link for a page in the list.

l To make a copy of an existing Web login page to use as a basis for a new page, click the Duplicate link for a
page in the list.
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The Web Login Editor form opens.

General Properties Area

Figure 303 The Web Login Editor Form, General Properties Area

Field Description

Name (Required) Name for the page.

Page Name Identifier page name that will appear in the URL -- for example, "/guest/page_name.php".

Description Additional information or comments about the page.

Vendor Settings (Required) Specifies vendor-specific settings for network configuration. This drop-down list
includes a list of Vendors you can select from, and a list of Other settings:
l Custom Settings — The form includes options for configuring your custom settings.
l Captive portal with ClearPass Web Auth — The form includes the options for

configuring this vendor setting.
l Single Sign-On - SAML Identity Provider — Complete the configuration options for

this vendor setting. An appropriate service must also be created in ClearPass using the
ClearPass Identity Provider (IdP) service template. The external service provider must

Table 178: Web Login Editor, General Properties
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Field Description

then be configured to use the SAML Web login page as the IdP.
l Single Sign-On - SAML Identity Provider - Authorize Only — Allows the server to be

configured as an IdP, and a login form is not displayed. If the AppAuth request to
validate the SAML SP request is successful, the user is logged in through the normal
SAML IdP flow. If the AppAuth request is not successful, a SAML Failure response is
returned to the service provider. This vendor setting is useful if you have configured
Aruba Auto SignOn (ASO) with third-party Identity providers.

l Single Sign-On - SAML Service Provider - Aruba VIA — Supports SAML single sign-
on (SSO) logins for Aruba VIA and lets you create a Web login page for the SAML service
provider. ClearPass will provide network access control based on the attributes in the
SAML response issued by an identity provider (IdP).

Login Method Specifies how the user's network login should be handled. Options include:
l Controller-initiated—Guest browser performs HTTP form submit
l Server-initiated—Change of authorization (RFC 3576) sent to controller—Server-

initiated logins require the user's MAC address to be available. This is usually acquired
through the captive portal redirect.
If you are setting up Multi-Factor Authentication (MFA) with username-only
authentication, choose this option.

l Policy Initiated—An enforcement policy will control a change of authorization—
This option should be selected if a Policy Manager policy that includes a "bounce client"
will be run as part of the page's actions. This option should be selected if you are using
OnGuard health checks.

Address (Required) IP address or hostname of the vendor's product.

Secure Login Specifies the security option to use for the Web login process. Options include:
l Use vendor default
l Secure login using HTTPS
l Send cleartext passwords over HTTP.

Dynamic Address For multi-controller deployments, if selected, enables sending the IP to submit credentials.
The Allowed Dynamic and Denied Dynamic fields are added to the form.

Allowed Dynamic IP addresses and networks that will be allowed.

Denied Dynamic IP addresses and networks that will be denied.

Security Hash Specifies the level of checking to apply to URL parameters passed to the Web login page.
Detects when URL parameters have been modified by the user (for example, their MAC
address). To prevent the user from tampering with parameters passed in the redirect URL
(for example, their MAC address), select one of the validation error options. Options
include:
l Do not check —login will always be permitted
l Deny login on validation error — login will not be permitted

If one of the validation error options is selected, the form expands to include the URL
Hash Key fields.

URL Hash Key (Required) The shared secret (64 characters) used by ClearPass and the NAD for the hash
key to validate the redirect URL. This must be entered twice in order to verify the key.

Confirm Key
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Login Form Area

Options in the Login Form area specify the behavior and content of the login form. The options available in
this area depend on the selection you made in the Vendor Settings field.

Figure 304 The Web Login Editor Form, Login Form Area

Field Description

Submit URL URL of the NAS device's login form.

Submit Method Method to use when submitting the login form to the NAS. Options include:
l POST
l GET

Authentication Specifies the authentication requirement method to use. Options include:
l Credentials — Require a username and password
l Access Code — Only require a username for authentication—This option does not

require a password.
If you are setting up Multi-Factor Authentication (MFA) with username-only
authentication, choose this option.

l Anonymous — Do not require a username or password—This option adds the Auto-
Generate and Anonymous User fields to the form. It allows a blank form with only the
terms or a Log In button. A pre-existing account is required.

l Auto — Do not require a username or password and automatically submit the
page—This option can be used if now authentication or prompting is needed. A pre-
existing local anonymous account is required. This option should be selected if you are
using OnGuard health checks.

Auto-Generate If selected, auto-generates the anonymous account. The account is created without a
session limit or expiration time, and with the Guest role (ID 2).

Table 179: Web Login Editor, Login Form Properties
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Field Description

Anonymous User (Required) Account to use for anonymous authentication. The password will be visible in the
HTML. The account Session Limit should be increased to the number of guests to be
supported.
To use a specific username, enter it in this field. To randomly generate a user name, leave
this field blank.

Client Certificate If Single Sign-On - SAML Identity Provider was selected in Vendor Settings, you can
specify whether the user should select a client certificate when authenticating. Options
include:
l None — Do not request a client certificate from the user
l Optional — Request a client certificate from the user, but allow none
l Required — Require a client certificate from the user

Prevent CNA If selected, enables bypassing the Apple Captive Network Assistant (CNA). The CNA is the
pop-up browser shown when joining a network that has a captive portal. This option might
not work with all vendors; it is dependent on how the captive portal is implemented.

Custom Form If selected, indicates you will provide a custom login form. You must supply your own HTML
login form for the header or footer HTML areas.

Custom Labels If selected, enables altering the default labels and error messages. This option adds the
Pre-Auth Error field to the form.

Username Field Name of the username field for the login form. This value is passed to the NAS device when
the form is submitted.

Username Suffix Suffix automatically appended to the username before submitting the login form to the
NAS.

Username Label Label that appears on the form for the username field. Leave blank to use the default,
(Username:).

Password Field Name of the password field for the login form. This value is passed to the NAS device when
the form is submitted.

Password
Encryption

Type of password encryption to use when submitting the login form. Options include:
l No Encryption (plaintext password)
l UAM basic
l UAM with shared secret
l PAP with shared secret
l MS-CHAP with shared secret

Password Label Label that appears on the form for the password field. Leave blank to use the default
(Password:).

UAM Secret Shared secret between the NAS device and the Web login form.

Pre-Auth Check Specifies how the username and password should be checked before authentication.
Options include:
l None – no extra checks will be made — If you are setting up Multi-Factor

Authentication (MFA) with username-only authentication, choose this option.
l App Authentication – check using Aruba Application Authentication — When this

option is selected, if the user is denied access, an error message attribute is returned
from the policy evaluation. A more detailed error message is then displayed to the user,
instead of the default ”Invalid username or password”. This gives the user more
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Field Description

information about why access was rejected — for example, it might indicate they are
using the service outside of permitted hours, or the account is in the wrong group, or
that an external authentication source has a denied message.

l App Authorization – check using Aruba Application Authorization
l Local – match a local account
l RADIUS – check using a RADIUS request
l Single Sign-On – enable SSO for this Web login — When this option is selected,

guests are redirected to the Identity Provider (IdP) configured in ClearPass, where they
authenticate themselves. They are redirected back to ClearPass, which verifies the login
was successful and uses the same credentials to redirect to the actual Web login flow.
(SSO support is enabled at Policy Manager > Configuration > Identity > Single Sign-
On)

Pre-Auth Error Customized label text to display if username and password lookup fails. Leave blank to use
the default (Invalid username or password).

Terms If selected, requires the user to mark a check box to accept a Terms and Conditions
agreement.

Extra Fields You may specify any additional field names and values to send to the NAS device. Enter
these as name=value pairs, one per line.

Terms Label Label that appears on the form for the terms check box. Leave blank to use the default
(Terms:).

Terms Text HTML code containing your terms and conditions. Leave blank to use the default, (I accept
the <a href="{nwa_global name=guest_account_terms_of_use_url}"
target="_blank">terms of use</a>)

Terms Layout Layout for the terms and conditions text—either above or below the Terms check box.

Terms Error Text to display if the terms are not accepted. Leave blank to use the default (In order to log
in, you must accept the terms and conditions.).

Log In Label Label that appears on the form for the login button. Leave blank to use the default (Log In).

Title Title to display on the Web login page. To use the default (Login), leave this field blank.

Login Message HTML template code for the text to display while the login is in progress.

Login Delay Specifies the number of seconds to delay while displaying the login message. The default
content is shown, and can be modified. You can also use the drop-down list to add images
or other content items.

Default Destination Area

Options in the Default Destination area control the destination page users are redirected to after login.

Figure 305 The Web Login Editor Form, Default Destination Area
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Field Description

Default URL (Required) Default URL for the redirect page. For external domains, this must include the
http:// prefix.

Override
Destination

If selected, forces the default destination for all clients, overriding any default value already
set on the client.

Table 180: Web Login Editor, Default Destination Properties

Login Page Area

Options in the Login Page area control the look and feel of the login page.

Figure 306 The Web Login Editor Form, Login Page Area

ClearPass Guest 6.7 | User Guide Configuration | 410
Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2539



411 | Configuration ClearPass Guest 6.7 | User Guide

Field Description

Skin (Required) Specifies the skin to use for the login page. Options include:
l (Default)
l Aruba ClearPass Skin
l Blank Skin
l ClearPass Guest Skin
l Custom Skin 1
l Custom Skin 2
l Galleria Skin
l Galleria Skin 2

Title Title that will be displayed on the page.

Header
HTML

HTML content to display above the login form. The default content is shown, and can be modified. You
can also use the drop-down lists to add images or other content items, or to insert a self-registration
link. To appear in this list, content items must first be uploaded to the Content Manager.

Footer
HTML

HTML content to display below the login form. The default content is shown, and can be modified. You
can also use the drop-down lists to add images or other content items, or to insert a self-registration
link. To appear in this list, content items must first be uploaded to the Content Manager.

Login
Message

HTML template code for the text to display while the login attempt is in progress. The default content is
shown, and can be modified. You can also use the drop-down list to add images or other content items.
To appear in this list, content items must first be uploaded to the Content Manager.

Login
Delay

(Required) Specifies the number of seconds to delay while displaying the login message.

Table 181: Web Login Editor, Login Page Properties

Advertising Services Area

The check box in the Advertising Services area lets you selectively enable Advertising Services for each Web
login page on which you want to display advertising.

Figure 307 The Web Login Editor Form, Advertising Services Area
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Cloud Identity Area

Options in the Cloud Identity area let you present guests with various cloud identity or social network login
options.

Figure 308 The Web Login Editor Form, Cloud Identity Area: Enabling Cloud Identity or Social Network Logins

Field Description

Enabled If selected, enables the use of cloud identity credentials to log in. The form expands to include
Authentication Providers configuration options.

Authentication
Providers

After you enable logins with cloud identity credentials, options in this area let you specify the
authentication provider and configure options for them.

Add new
authentication
provider

Opens the properties form for adding and configuring an authentication provider.

Buttons Shows the syntax for displaying cloud identity login buttons on the page. You must add
{nwa_social_logins} to either the HTML Header or HTML Footer area.

Debug If selected, cloud identity debugging will be included in the application log.

Table 182: Web Login Editor Form, Cloud Identity Area: Enabling Cloud Identity or Social Network Logins
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Figure 309 The Web Login Editor Form, Cloud Identity Area, Authentication Providers (Facebook selected as an
example provider)
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Field Description

Provider (Required) Specifies the cloud identity authentication provider to use. All authentication providers
that have been configured are included in this list.
The following options presented in the Authentication Providers area depend on the provider
selected in this drop-down list.

Enabled If this check box is selected, the specified provider can be used.

Advanced If selected, displays additional options on this form.

Allow Guests (G Suite) If selected, allows Google accounts that are not part of your domain to log in as guests.
The social_vip flag will be set to false for these users.

Authorization
Code

(Required) (G Suite) When you generate a new code, it is automatically entered in this field, and
you can close the redirect window.

Auto Redirect If selected, local logins and other providers will not be supported. If this option is selected, we
recommend you also enable Custom Form in the Login Form area.

Clever Profile (Clever) If selected, access to the client’s full profile is requested and the Client ID must have
advanced privileges.

Client ID (Required) Client ID to use with this provider. The provider might use a different label.

Client Secret (Required) Client secret to use with this provider. The provider might use a different label.

Cloud
identity
whitelists
link

The Cloud identity whitelists for use in captive portals link opens Aruba's cloud identity
whitelists page of GitHub. GitHub is an external, third-party platform for hosting and sharing code.
You can use this page to access the latest whitelist entries for cloud identity providers that are
used by ClearPass for cloud logins and Onboarding.

Delete Removes the provider from the list and deletes its configuration. You will be asked to confirm the
deletion.

Destination URL to which guests authenticating with this provider will be redirected after logging in.

Disable Disables the provider. To enable it again, click the Enable link.

Disconnect
Action

(Facebook WiFi) For the Facebook Wi-Fi provider, specifies the action to take when a disconnect is
requested by Facebook. Options include:
l Terminate Session
l Cisco - Disable Host-Port
l Cisco - Bounce-Host-Port
l Cisco - Reauthenticate Session

District ID (Clever) Identifier for the school district. During authentication, this ID is compared to the
ID returned by a Clever Instant Login. If no value is entered in this field, Clever’s District Picker will
handle the details.

Edit Opens the Properties form. You can edit any of the configuration options for the provider.

Email If selected, allows access to the guest's email address. Access requires additional permission for
the provider.

Endpoint Specifies whether to create endpoint attributes, and how they will be handled. Options include:

Table 183: Web Login Editor Form, Cloud Identity Area, Authentication Providers
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Field Description

Attributes l Do not create additional attributes
l Create Endpoint attributes converting any arrays to JSON
l Create Endpoint attributes flattening the entire data set
If one of the Create options is selected, an endpoint attribute is created for every attribute
returned by the user. This is only needed if you are creating specialized enforcement policies on
them.

Flatten
Prefix

If Endpoint Attributes was selected, you may enter text to prepend to all keys when flattening.
This stores a normalized version of all the returned attributes in the endpoint. If nothing is entered
in this field, the default "social" will be used.

Friends (Facebook) If selected, allows a list of the guest’s friends to be retrieved, if permission is granted
by the guest. The list is limited to only those friends who also use your application ID.

Generate
Code

(G Suite) To generate a new authorization code, click the link in this field. You will be redirected to
a new window to generate an authorization code.

Google Apps
VIP

Name of the user record attribute to apply to the social_vip flag. For more information, refer
to the Google Directory API for retrieving users.

Google
Groups

(G Suite) If selected, all groups associated with the account will be retrieved and stored as a list of
group names and a list of matching email addresses. The Admin SDK Refresh Token and
Authorization Code must also be regenerated.

Google Plus (Google) if selected, allows access to the guest's Google Plus profile. Access requires additional
permission for the provider.

Group
Membership

(Microsoft Azure AD) If selected, all groups associated with the account will be retrieved and
stored as a list of group names and a list of matching email addresses.

Hostname If specified, overrides the hostname guests are redirected to for authentication. This field is
optional; leave it empty if you are unsure.

Icon Label Overrides the default label on the provider's icon.

LinkedIn VIP (Linkedin) Enter a LinkedIn Distance value (0 - 3). If the guest is within this distance, the social_
vip flag will be enabled for them.

Move Up
Move Down

Moves the provider up or down in the list.

Notes You may enter additional notes or comments about the provider. This description is only seen by
administrators.

Scope Overrides the scope requested during OAuth. For syntax information, refer to the provider’s
documentation.

Twitter VIP (Twitter) Name of a Twitter account. If the guest follows this account, they will have the “social_vip”
flag enabled.

Username
Prefix

Text to prepend to all usernames. A prefix can be useful if you are providing a way to log in using a
variety of providers.
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Field Description

Username
Suffix

Text to append to all usernames. A suffix can be useful if you are providing a way to log in using a
variety of providers.

VIP Attribute (G Suite; Microsoft Azure AD) Name of the user record attribute to apply to the social_vip
flag. For more information, refer to the Microsoft Graph API for retrieving users.

Add When your entries are complete on the Properties form, click this button. The Properties form
closes and the provider is included in the Authentication Providers list.

Multi-Factor Authentication Area

Options in the Multi-Factor Authentication area let you require a secondary factor when authenticating.
When the guest enters their username to log in, they are sent a code which they must successfully retrieve and
enter to complete the login. For more information, see "About Multi-Factor Authentication" on page 420.

Figure 310 The Web Logins Editor Form, Multi-Factor Authentication Area

Field Description

Provider Specifies the mulit-factor authentication provider. Options include:
l No multi-factor authentication
l Duo Security - Two Factor Authentication
l Facial Networks - ZOOM Multi-Factor Authentication
l Kasada - authenticator
l Kasada - authenticator (legacy)
l ImageWare Systems - Solutions Powered by GoVerifyID
l SMS Verification Codes

App Name (Required) App name to use with this provider.

Authentication Specifies the authentication order. Options include:

Table 184: Web Logins Editor, Multi-Factor Authentication
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Field Description

Order l Credentials and then device — If you are setting up Multi-Factor Authentication (MFA) with
username-only authentication, choose this option.

l Device and then credentials

Client ID (Required) Client ID to use for this provider.

Duo AKEY (Required) A string that you should generate and keep secret from Duo. The string should be at
least 40 characters long. The Duo Web site provides tips for how to generate this key.

Duo API
Hostname

(Required) The Duo API hostname.

Duo
Integration
Key

(Required) The Duo ikey.

Duo Secret
Key

(Required) The Duo skey.

Email If selected, emails will be sent during application enrollment. If deselected, the user must scan
the QR code.

Enroll If selected, usernames will be automatically enrolled with the provider.

Factors The number of factors to require. For some providers, options are included to specify types of
factor, such as:
l photolock - The Photo
l fingerprint - The Fingerprint
l gridlock - The Pattern
l onetap - The Onetap
l password - The Password
To use your own defaults, leave this field empty.

Footer HTML HTML template code displayed after the provider’s vendor-specific authentication area. This is
the login “wait” page displayed to the user while the authentication code is sent to and submitted
by them. You can also use the drop-down lists to add images or other content items, or to insert
a self-registration link. To appear in this list, content items must first be uploaded to the Content
Manager.

Grace Period Specifies the number of hours between multi-factor authentication checks. If the user logs in
again before this interval expires, they can skip the secondary check if the device name and
username have not changed. To require full authentication every time, leave this field empty.
The default interval is 24 hours.

Header HTML HTML template code to display before the provider’s vendor-specific authentication area. This is
the login “wait” page displayed to the user while the authentication code is sent to and submitted
by them. You can also use the drop-down lists to add images or other content items, or to insert
a self-registration link. To appear in this list, content items must first be uploaded to the Content
Manager.

Hostname (Required) Hostname of the ImageWare server.

Message Message to display during verification.

Message Number of seconds a verification request should be valid.

Table 184: Web Logins Editor, Multi-Factor Authentication(Continued)
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Field Description

Expiration

Password (Required) Password to use with this provider.

Phone
Attribute

(Required) For SMS Verification Codes, the attribute name containing mobile numbers. Names
should be entered as a comma-separated list. The order of the list determines the lookup
priority.

Role Your role ID.

Secret Key (Required) The Facial Networks client secret.

Service
Provider

Service provider to use when sending SMS messages.

Tenant Name (Required) Tenant name to use with this provider. A tenant is a company or other entity that has
created a tenant account with ImageWare in order to use the GoMobile server for security.

Username (Required) Username to use with this provider.

Verify
Template

The full URL of the verification template.

Table 184: Web Logins Editor, Multi-Factor Authentication(Continued)

Network Login Access Area

Options in the Network Login Access area control access to the login page.

Figure 311 The Web Login Editor Form, Network Login Access Area

Field Description

Allowed
Access

IP addresses and networks from which logins will be allowed. (IPv4 and IPv6 are both supported)

Denied
Access

IP addresses and networks from which logins will be denied. (IPv4 and IPv6 are both supported)

Deny
Behavior

(Required) Response shown to the user if their login request is denied. Options in this drop-down
list include:
l Send HTTP 404 Not Found status

Table 185: Web Login Editor, Network Login Access Properties
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Field Description

l Show Access Denied page
l Show a blank page

Post-Authentication Area

Options in the Post-Authentication area control the actions to perform after a successful pre-authentication.

Figure 312 The Web Login Editor Form, Post-Authentication Area

Field Description

Health
Check

If selected, requires the guest to pass a health check before they can access the network. The health
check is done automatically through the OnGuard Dissolvable Agent.

Header
HTML

HTML content to display above the health check text. The default content is shown, and can be
modified. You can also use the drop-down list to add images or other content items.

Footer
HTML

HTML content to display below the health check text. The default content is shown, and can be
modified. You can also use the drop-down list to add images or other content items.

Update
Endpoint

If selected, marks the user's MAC address as a known endpoint, and updates the endpoint's attributes
with other details from the user account. If this check box is selected, the form expands to include the
Advanced field.

Advanced If selected, lets you specify custom attributes to store in the endpoint. The form expands to include the
Endpoint Attributes field.

Endpoint
Attributes

List of name-value pairs to pass as custom attributes. Follow the format user_field | Endpoint
Attribute. Examples are shown in this text box.

Table 186: Web Login Editor, Post-Authentication Properties
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About Multi-Factor Authentication
Multi-factor authentication (MFA) lets you require multiple factors, or proofs of identity, when authenticating a
user. Usually at least two of the following categories are required:

l Knowledge: A secret the user knows, such as their password or PIN.

l Possession: Something the user has, such as a security token generator or a certificate. This requirement
can also be met by having the user answer a registered phone number or email address to retrieve a
temporary code.

l Inherence: A physical characteristic of the user, such as their voice, face, or fingerprint.

Policy configurations can define how often multi-factor authentication will be required, or conditions that will
trigger it:

l Time-based policy: Policy might require MFA on a daily or weekly basis, or if the user has not logged in from
the device for a certain number of days, or if the device was unhealthy in the past 30 days.

l Posture-based policy: Policy might require MFA if the device’s posture changes to unhealthy, or if the
posture of any of the user’s other devices changes to unhealthy, or if a company alert or security check is
issued.

l Policy based on other conditions: Policy might require MFA if the user has never logged in from the location
before, or has failed authentication three times, or if a third-party application or system triggers MFA.

Configuring Multi-Factor Authentication

To configure multi-factor authentication in ClearPass, you first create an account with an MFA provider and
create the users for the guest account. Next, you set up either a captive portal login or an Onboard login.

To set up the MFA provider and the users:

1. Collect any required elements from the selected MFA provider’s account. These might include such things as
a secret key, integration key, hostname, tenant name, app name, client ID, or special username and
password.

2. Create a user account in ClearPass Guest with the same name that is configured in the MFA provider.

To set up a captive portal login:

1. Configure ClearPass for regular guest services.

2. Go to ClearPass Guest > Configuration > Pages > Web Logins and either create a new Web login page
or edit an existing one. Scroll to the Multi-Factor Authentication area and provide the following
information:

a. In the Provider drop-down list, select the appropriate MFA provider.

b. Complete all the required fields for the provider.

c. Select one of the options in the Authentication Order drop-down list. Options include Credentials
and then device or Device and then credentials.

d. Complete the rest of the form. For more information, see "Creating and Editing Web Login Pages" on
page 404.

3. Redirect the captive portal to this Web login page.

4. Connect a device. You will be prompted for a username twice. Depending on the authentication order you
specified the Web Login Editor, the user will be authenticated by the provider either first or second.

5. Approve the authentication request of the provider through the authorized device for the account.
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To set up an Onboard login:

1. Configure ClearPass for regular Onboard services.

2. Go to ClearPass Guest > Onboard > Deployment and Provisioning > Provisioning Settings and
either create a new provisioning setting or edit an existing one. On the Web Login tab, scroll to the Multi-
Factor Authentication area and provide the following information:

a. In the Provider drop-down list, select the appropriate MFA provider.

b. Complete all the required fields for the provider.

c. Select one of the options in the Authentication Order drop-down list. Options include Credentials
and then device or Device and then credentials.

d. Complete the rest of the form. For more information, see "Configuring Provisioning Settings for the Web
Login Page" on page 232.

3. Redirect the captive portal to the Onboard page.

4. Connect a device. You will be prompted for a username twice. Depending on the authentication order you
specified the Web Login Editor, the user will be authenticated by the provider either first or second.

5. Approve the authentication request of the provider through the authorized device for the account. The rest
of the onboarding process will be the same as usual.

Managing Web Pages

Simple Web pages provide additional information to guests -- for example, advising them that the device does
not meet security requirements, service is unavailable, their browser is unsupported, the device is jailbroken, to
provide “terms and conditions” information, or to present a custom user interface in OnGuard for remediation.

The Web Pages view lists all the Web pages you have created, and lets you edit and preview them and create
new Web pages. It also includes templates for new Web pages. Each template may be used as it is or can be
used as the basis for a page you design. For more information, see "The Web Page Templates" on page 423.

To view the list of your Web pages and work with them, go to Configuration > Pages > Web Pages. The Web
Pages list view opens. The templates and all Web pages you have created or enabled are included in the list.
Information shown for each page includes its name as displayed to administrators in ClearPass Guest, the page
title that is displayed to guests, the page’s filename used in the URL, and the skin currently assigned to it.
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Figure 313 The Web Pages List View

You can click a Web page’s row in the list for additional options:

Field Description

Edit Edit any of a Web page's attributes. The Edit Web Page form opens. For more information, see
"Creating and Editing Simple Web Pages" on page 426.

Duplicate Create a copy of a Web page to use as a basis for a new page. The Copy Web Page form opens,
where you can edit any of the page’s attributes. For more information, see "Creating and Editing
Simple Web Pages" on page 426.

Launch
Page

View the page. The page opens in a new tab as it would appear to the guest.

Delete Delete the page. You will be asked to confirm the deletion.

Create a
new Web
page

Create a new Web login page. For more information, see "Creating and Editing Simple Web Pages" on
page 426.

Table 187: The Web Pages List View
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The Web Page Templates
ClearPass Guest provides the following templates for simple Web pages. You can use these templates as they
are, or edit any of their properties to suit your needs, or copy them to use as a basis for new Web pages. These
templates are available at Configuration > Pages > Web Pages.

Browser Unsupported Page Template

The Browser Unsupported template can be used to show a message advising the guest that their browser is
not supported.

Figure 314 The Page Displayed by the Default Browser Unsupported Template
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Jailbroken Device Page Template

The Jailbroken Device template can be used to show a message advising the guest that the iOS device has
been modified, or jailbroken.

Figure 315 The Page Displayed by the Default Jailbroken Device Template

Posture Check Page Template

The Posture Check template can be used to show a message advising the guest that the device does not meet
the organization’s minimum security requirements (detected by OnGuard).

Figure 316 The Page Displayed by the Default Posture Check Template
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Service Unavailable Page Template

The Service Unavailable template can be used to show a message advising the guest that service is
temporarily unavailable.

Figure 317 The Page Displayed by the Default Service Unavailable Template

Terms and Conditions Page Template

The Terms and Conditions template can be used to provide information to the user about the terms and
conditions of use.

Figure 318 The Page Displayed by the Default Terms and Conditions Template

OnGuard Remediation Wizard Custom Interface Page Templates

You can configure ClearPass OnGuard to show end users a custom interface, or wizard, that guides them
through the remediation process if their device is quarantined. When this feature is enabled and OnGuard
needs to run a custom remediation script, the wizard tells the user why the device was denied network access
and describes the tasks that are required to fix the problem. While the script is being executed and new health
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checks are run, pages showing status and progress messages are displayed. The user can close the wizard at
any time and the remediation script will continue to execute in the background. This feature is only available
for the Windows operating system.

Configuration of the remediation wizard is done partly in Policy Manager and partly in Guest:

l The custom user interface must first be enabled at Policy Manager > Administration > Agents and
Software Updates > OnGuard Settings.

l Links are then provided there to the Guest > Configuration > Pages > Web Page Settings form
described in this section, where you can configure the pages and customize the text, logo, and images.

l In Policy Manager, configure the Agent Enforcement profile and configure the Show Custom UI for
Custom Scripts attribute for it.

l In Policy Manager, configure the Agent Script Enforcement profile and configure the Success
Message, Failure Message, Progress Message, and Description attributes for it.

Complete instructions for the configuration process are provided in the ”About the OnGuard Custom Interface
and the Remediation Process” section of the ClearPass Policy Manager User Guide.

The OnGuard remediation wizard includes five Web page templates, each of which can be customized with
logo, text, and images. When you configure the custom user interface in Policy Manager’s OnGuard Settings,
the links provided to ClearPass Guest’s Web Page Settings form let you configure and customize the
following pages of the wizard. These pages are not displayed in the Web Pages list of templates unless you
have configured them:

l Start page — The start page of the custom interface lets the user know that their device did not meet
health requirements and that automatic remediation actions will be performed, after which it will be
connected to the network.

l Progress page — While the remediation actions are being executed, the progress page of the custom
interface displays an indicator and requests that the user not disconnect their device.

l Finish page, success — When the remediation is successfully completed, the success page lets the user
know it was successful, and that after OnGuard scans and verifies their system it will connect them to the
network.

l Finish page, reboot — If the remediation is successfully completed but any of the remediation actions
require a system reboot, the reboot page lets the user know it was successful, and that after OnGuard
scans, verifies, and reboots their system it will connect them to the network.

l Finish page, error — If remediation of the device could not be completed, the error page lets the user
know it was unsuccessful, lists the issues that could not be resolved, provides a link to Support, and informs
the user that the device is not connected to the network.

Creating and Editing Simple Web Pages

The Web Page Settings form lets you create a new simple Web page, edit an existing page, or copy a template
or existing page to use as a basis for a new page. To perform these tasks, go to Configuration > Pages > Web
Pages, and then:

l To create a new simple Web page, click the Create a new Web page link in the upper-right corner.

l To edit an existing simple Web page, click the Edit link for a page in the list.

l To make a copy of a template or existing page to use as a basis for a new page, click the Duplicate link for a
template or page in the list.

The Web Page Settings form opens.
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Figure 319 The Web Page Settings Editor, General Settings

Figure 320 The Web Page Settings Editor, Advanced Settings
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Field Description

Name (Required) Name for the page. This name is seen only by administrators in ClearPass Guest.

Page Name Page name (filename) that will appear in the URL-- for example, "page_name".

Enabled If selected, enables the page for use.

Description Optional comments or notes about the page.

Skin Specifies the skin to use for the Web page. Options include:
l (Default)
l Aruba ClearPass Skin
l Blank Skin
l ClearPass Guest Skin
l Custom Skin 1
l Custom Skin 2
l Galleria Skin
l Galleria Skin 2

Title Title to display on the Web page. To not use a title, leave this field blank.

HTML HTML content for the page. If you are editing a template or copy of another page, that page’s
content is shown and can be modified. You can also use the drop-down list to add images or links.

Advanced
Settings

If selected, adds advanced configuration options to the form.

Prevent
CNA

If selected, enables bypassing the Apple Captive Network Assistant (CNA). The CNA is the pop-up
browser shown when joining a network that has a captive portal. This option might not work with all
vendors; it is dependent on how the captive portal is implemented.

Allowed
Access

IP addresses and networks from which access is allowed. (IPv4 and IPv6 are both supported)

Denied
Access

IP addresses and networks that are denied access. (IPv4 and IPv6 are both supported)

Deny
Behavior

(Required) Specifies the response shown to the user if their request is denied. Options in this drop-
down list include:
l Send HTTP 404 Not Found status
l Show Access Denied page
l Show a blank page

Table 188: Web Page Editor, General Properties

Receipts

The Receipts area of the user interface lets you customize the receipts that are available to guests and
sponsors. To work with receipts configuration, go to Configuration > Receipts > Start Here.

This section includes:

l "Digital Passes" on page 429
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l "Email Receipts and SMTP Services" on page 444

l "Customizing SMS Receipt" on page 451

l "Customizing Print Templates " on page 453

Digital Passes

Digital passes are cryptographically signed files containing fields and images that are used as boarding passes,
event tickets, coupons, store passes, or other scannable items.

In ClearPass Guest, you can upload and install digital pass certificates, create new templates for digital passes,
and use the passes for guest receipts.

To work with digital passes, go to Configuration > Receipts > Digital Pass Templates.

This section includes:

l "About Digital Passes" on page 429

l "Viewing Digital Pass Certificates" on page 433

l "Installing Digital Pass Certificates" on page 434

l "Managing Digital Passes" on page 435

l "Creating and Editing a Digital Pass Template" on page 436

l "Example Template Code Variables" on page 442

l "Images in Digital Passes" on page 443

About Digital Passes

A digital pass is a cryptographically signed file that contains fields and images. When viewed by a user, a pass
looks like a simple card, with a front side and a back side. Passes are issued to users as boarding passes, event
tickets, coupons, store passes, or other scannable items (for example, a membership pass).
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Figure 321 Example Digital Pass: A Boarding Pass

Passes can be organized in Apple Passbook on the user's device. Good visual design practices ensure that each
pass can be quickly recognized when displayed amongst other passes. (Apple Passbook is available on Apple
iOS 6+ devices.)
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Figure 322 Example Apple Passbook

To use a pass such as a membership card or store card, the user selects it from the passbook and displays it so
the barcode can be scanned. To use a pass such as a boarding pass or event ticket where date relevance or
location relevance was configured, it can be accessed when it becomes active on the lock screen at the relevant
time or place.

Passes for Guest Receipts in ClearPass Guest

In ClearPass Guest, you can use passes to provide a guest receipt to a user who has registered using a guest
self-registration page. ClearPass Guest supports the pass format specified for the Apple Passbook application.

The front of a guest receipt pass typically shows the site SSID, the username, password, and account expiration
time. The back of the pass provides instructions for connecting to the network. It also contains logos and icons,
typically those of the organization providing the guest receipt. The exact details of what is written into the
guest receipt pass are determined by a pass template.

When the guest has registered and the guest receipt page is displayed, they can click the Add to Passbook link.
This generates the new guest receipt pass, using fields from the registered guest account such as the username,
password, and expiration time. The fields included in the pass, as well as where they are placed and how they
are formatted, are determined by the pass template that was selected for the guest self registration. The pass
is also cryptographically signed using a Pass Certificate. The generated pass is provided as a download, and the
user can add the downloaded pass to their passbook.

Pass Templates

The pass template defines what is written into the pass. You can create, edit, copy, and delete pass templates.
For more information, see "Managing Digital Passes" on page 435 and "Creating and Editing a Digital Pass
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Template" on page 436.

Pass templates define:

l Name and a description: Used to identify the template in ClearPass administrative forms and views.

l Style: Boarding Pass, Event ticket, Coupon, Store Pass, or Generic.

l Colors: Foreground, background, and label. If no alternate colors are specified, then default colors will be
used. If there are alternate colors specified, then they will be used instead of the default colors.

l Summary: Short description for a voice-over.

l Icon: Displayed on the lock screen. A shine effect is automatically applied to the icon. To select an icon
image, it must first be uploaded to the Public Files area of the content manager.

l Logo: Displayed in the top left corner of the front of the pass. To select a logo image, it must first be
uploaded to the Public Files area of the content manager.

l Fields: For the front and back of the pass. The information shown on the pass is broken up into fields. Each
field is defined by a dictionary which gives it a value and label (which are displayed to the user), a unique key,
and optional information about how its value should be formatted.

l Relevant locations (GPS coordinates) and relevant date: Used by Apple Passbook to show a message on the
Lock screen where and when the pass becomes relevant.

Many settings for a pass template accept standard template code. This is the same template code that is
supported for print templates. This allows an administrator to specify either simple direct values or more
complex values based upon the evaluation of template code. All template code is evaluated at the time that
the pass is generated from the pass template, using values from the guest receipt as inputs to the pass
template.

A pass can contain both a low-resolution version (i.e. for non-Retina displays) and a high-resolution version (i.e.
for Retina displays) of each image. If uploaded to the content manager, the high-resolution version of an image
is also automatically included in the pass. The high-resolution version must be named with a @2x suffix placed
just before the file extension—for example:

Company_Logo.png (low-resolution file name)

Company_Logo@2x.png (high-resolution file name)

Apple Passbook Certificates

You must have a Pass Certificate issued by Apple to be able to generate Apple Passbook passes.

As part of the generation process, the pass is cryptographically signed using a Pass Certificate. A Pass Certificate
is a special type of X.509 certificate issued by Apple through the Apple Developer portal. You need a Pass
Certificate to cryptographically sign the passes when they are generated and downloaded. This cryptographic
signature is verified by Passbook when adding a pass. Passbook will only accept a pass that has been signed by
a valid Pass Certificate issued by Apple. To obtain a pass certificate, you must have an Apple developer account.
You may register for a developer account at developer.apple.com.

For more information, see "Viewing Digital Pass Certificates" on page 433 and "Installing Digital Pass
Certificates" on page 434.

Digital Passes Process Overview

To obtain and install an Apple Passbook certificate:

1. Log in to the Apple Developer portal at developer.apple.com.
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2. Register a Pass Type ID for your pass.

3. Create a certificate for your Pass Type ID.

4. Follow the portal’s instructions to create a certificate signing request using Keychain Access (a standard
macOS application) and submit it to the portal.

5. Download the Pass Type ID certificate.

You also need to provide the private key for the pass certificate. If you created the certificate signing request
using Keychain Access:

1. In Keychain Access, locate the private key for the certificate signing request.

2. Export this private key to a Personal Information Exchange (.p12) file.

To install the pass certificate and the associated private key in ClearPass Guest, go to Configuration >
Receipts > Digital Pass Templates and click the Install Pass Certificate link. For more information, see
"Installing Digital Pass Certificates" on page 434.

To enable pass downloads:

1. Go to Configuration > Pages > Guest Self-Registration, click an enabled guest self registration's row,
and then click its Edit link.

2. In the diagram, click the Actions link for the Receipt Page.

3. Scroll down to the Download Pass area and set the Enabled field to Display a link enabling download
of a guest receipt pass.

4. Select the template to use (there should be at least one default template available for selection).

Viewing Digital Pass Certificates

You must have a pass certificate in order to generate and download passes. A Pass Certificate is a special type
of X.509 certificate issued by Apple through the Apple Developer portal. You need a Pass Certificate to
cryptographically sign the passes when they are generated and downloaded. This cryptographic signature is
verified by Passbook when adding a pass. Passbook will only accept a pass that has been signed by a valid Pass
Certificate issued by Apple.

To view the certificate that will be used to sign Apple Passbook digital passes, go to Configuration > Receipts
> Digital Pass Templates and click the View pass certificate link. If a pass certificate has been installed,
this page displays the certificate details.
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Figure 323 The Pass Certificate View

If no pass certificate is installed yet, no details are displayed. Click the Upload pass certificate link to obtain
and install a certificate. See "Installing Digital Pass Certificates" on page 434.

Installing Digital Pass Certificates

You must have a valid Pass Certificate issued by Apple in order to generate and download passes. To obtain a
pass certificate, you first need an Apple developer account. Developer accounts are free; to register for an
account, go to developer.apple.com and click the register link at the bottom of the page.

To obtain the Apple Passbook certificate that will be used to sign digital passes:

1. Log in to the Apple Developer portal at developer.apple.com.

2. Register a Pass Type ID for your pass.

3. Create a certificate for your Pass Type ID.

4. Follow the portal’s instructions to create a certificate signing request using Keychain Access (a standard
macOS application) and submit it to the portal.

5. Download the Pass Type ID certificate.

You also need to provide the private key for the pass certificate. If you created the certificate signing request
using Keychain Access:

1. In Keychain Access, locate the private key for the certificate signing request.

2. Export this private key to a Personal Information Exchange (.p12) file.
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To install the certificate, go to Configuration > Receipts > Digital Pass Templates and click the Install
Pass Certificate link. Step 1 of the Install Pass Certificate form opens.

Figure 324 The Install Pass Certificate Form

Field Description

Format Specifies whether you will upload the certificate as a file or paste in the certificate text.
The form expands to include the Step 2 options.

Certificate (Required) For certificates pasted as text, copy and paste the digital certificate's text.
This is a block of encoded text and should include the "BEGIN CERTIFICATE" and "END
CERTIFICATE" lines.
For uploaded certificate files, browse to the certificate to upload. This should be one of
the following:
PEM encoded X.509 file containing the certificate (*.pem)
PKCS#12 encoded file containing both the certificate and the private key (*.p12)

Private Key (Required) For private keys pasted as text, copy and paste the private key's text. This is
a block of encoded text and should include the "BEGIN PRIVATE KEY" and "END
PRIVATE KEY" lines.
For uploaded private key files, if the certificate file does not include the private key,
browse to the private key to upload. The private key should be either a PEM-encoded
or a Personal Information Exchange (.p12) file.

Passphrase Passphrase that was used to encrypt the file containing the private key. If the private
key is not encrypted, leave this field blank.

Confirm Passphrase

Upload Certificate The certificate is uploaded and the details are displayed on the Pass Certificate page.
See Viewing the Digital Pass Certificate.

Table 189: Install Pass Certificate

Managing Digital Passes

Pass properties are defined in pass templates. These properties include name and a description, style (type of
pass), colors, summary, icon, logo, fields, relevant locations, relevant date, and associated apps.
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To view or work with your list of digital pass templates, go to Configuration > Receipts > Digital Pass
Templates. The Pass Templates list view opens.

Figure 325 The Digital Pass Templates List View

Field Description

Edit Edit any of the template's properties.

Duplicate Make a copy of the template to use as a basis for a new template.

Reset to Defaults Resets the default template to its original settings if changes were made. (Only
available for the default template)

Delete Deletes the pass template. (The default Guest Receipt template cannot be deleted)

Create a new template Create a new template.

Table 190: Pass Templates

Creating and Editing a Digital Pass Template

To create or edit a digital pass template, go to Configuration > Receipts > Digital Pass Templates, and
then click the Create a new template link in the upper right corner, or click the Edit link for a template in the
list. The Pass Template Settings form opens.

Defining Basic Properties

Figure 326 The Pass Template Settings Form, Basic Properties

Field Description

Name (Required) Short name that identifies the template clearly. Digital pass template names can
include spaces. You may highlight this name and replace it with a new name.

Description Comments or notes about the template. This description is only seen by administrators.

Table 191: Basic Properties, Pass Template Settings
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Defining Pass Properties

Figure 327 The Pass Template Settings Form, Pass Properties Area

For examples of variables that can be used in the Summary and Logo Text fields described in the following
table, click the Example 'template code' replacements link above the form, or see "Example Template Code
Variables" on page 442.

For a list of image fields supported by each of the different pass styles, click the A note regarding images
and icons link above the form, or see "Images in Digital Passes" on page 443.
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Field Description

Background Color Color used for the background of both the front and back of the pass. To use the default
color, leave this field blank.

Foreground Color Color used for the "values" field on the front of the pass. To use the default foreground
color, leave this field blank.

Label Color Color used for the labels of fields shown on the front of the pass. To use the default label
color, leave this field blank.

Summary (Required) Short summary for the pass. This lets VoiceOver make the pass accessible to
blind and low-vision users.
Summary text typically contains standard template code that is evaluated when the pass is
generated. Template code entered here must produce a summary for the pass to be valid.

Pass Style (Required) Specifies the style of pass to generate. Options include:
l Generic — a general purpose pass
l Boarding Pass (e.g., airline, boat, bus, train)
l Coupon (e.g., coupon, special offer, discount)
l Event Ticket (e.g., conference, sporting event, concert, movie)
l Store Card (e.g., loyalty, discount, points, gift)

Icon Image Icon shown on the lock screen and in notifications and emails where the pass is attached.
To use the default icon, leave this field blank.
The low-resolution version of the icon image should be 29 x 29 pixels.
If an "@2x" high-resolution version is available, it will also be added to the pass. The "@2x"
high-resolution version should be 58 x 58 pixels.

Logo Image Logo shown at the top-left corner of the front of the pass. To use the default logo, leave this
field blank.
The low-resolution version of the logo image should be 50 x 50 pixels.
If an "@2x" high-resolution version is available, it will also be added to the pass. The "@2x"
high-resolution version should be 100 x 100 pixels.

Logo Text Text shown next to the logo at the top of the pass. To have no text next to the logo, leave
this field blank.
Logo text typically contains standard template code that is evaluated when the pass is
generated.

Thumbnail Image Image shown to the right of the primary field. To have no thumbnail image, leave this field
blank.
The thumbnail image is only shown on the Event Ticket or Generic pass styles.
If an "@2x" high-resolution version is available, it will also be added to the pass.

Transit Type Transport type for a Boarding Pass style of pass. Options include Air, Boat, Bus, Generic,
or Train. The icon corresponding to the selected type of transit will be shown on the front of
the pass between the first two primary fields.

Table 192: Pass Properties, Pass Template Settings
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Field Description

Footer Image Image shown below all of the fields on the front of a Boarding Pass style of pass. To have
no footer image, leave this field blank.
If an "@2x" high-resolution version is available, it will also be added to the pass.

Strip Image Image shown behind the primary field on the front of the pass. To have no strip image,
leave this field blank.
The strip image is only used on the Coupon, Event Ticket, or Store Card pass styles.
The low-resolution version of the strip image should be 312 x 84 pixels for Event Tickets,
and 312 x 123 for Store Card and Coupon pass styles.
If an "@2x" high-resolution version is available, it will also be added to the pass.The "@2x"
high-resolution version of the strip image should be double the width and height of the low-
resolution version for each pass style.

Background Image Image shown as a background on the front of an Event Ticket. If a background image is
specified, any background color that was specified will be ignored. To have no background
image, leave this field blank.
The background image is only shown on the Event Ticket pass style.
If an "@2x" high-resolution version is available, it will also be added to the pass.

Defining Pass Fields

Figure 328 The Pass Template Settings Form, Pass Fields Area

Field Description

Fields (Required) List of fields currently included in this pass template, with descriptions. You
can click a field's row for configuration options.

Edit Opens the Field Properties editor, where you can enable the field and modify its
placement, content, and presentation properties.

Disable Disables the field for the pass. To enable it again, click its Enable link.

Table 193: Pass Fields, Pass Template Settings
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Field Description

Move Up Fields are shown in this list in their rank order. You can use the Move Up and Move
Down links to modify the order.

Move Down

Delete Deletes a field from this pass template. You will be asked to confirm the deletion.

Add new field Lets you add and configure a new field. The row expands to include the Field Properties
form.

Defining Relevant Locations

When a relevant location is configured and enabled, the pass can be displayed on the user's lock screen when
they arrive within a radius of the specified coordinates — for example, a Boarding Pass can be displayed when
the user arrives at a station or airport. The size of the location's radius is determined by the pass style.

Figure 329 The Pass Template Settings Form, Relevant Locations Area

Field Description

Relevant
Locations

If selected, shows the digital pass on the user's lock screen when near a given location.
Passbook determines the appropriate distance around the location for the pass to be
displayed on the lock screen.

Location Limit A pass template may only contain 10 locations. More may be added here, but only the first 10
valid locations will be included in the pass.

Locations (Required) Lists the locations that have been defined for this pass template.

Add new location Lets you add and configure a new location. The row expands to include the Location
Properties form.

Table 194: Relevant Locations, Pass Template Settings

Defining Relevant Dates

When a relevant date is configured and enabled, the pass can be displayed on the user's lock screen during an
appropriate window of time—for example, an Event Ticket pass would be displayed within the time window for
entry to the event. The length of the time window is determined by the pass style.

If the result of processing a ‘date’ field is a number, then that number will be interpreted as a UNIX timestamp
(i.e. the number of seconds since the UNIX epoch of 1st January 1970 00:00:00 GMT). A UNIX timestamp of 0
(zero) or less will be treated the same as an empty value.

If the result of processing a ‘date’ field is textual (i.e. not a number and not empty), then the text will be
converted to a valid date and time value. If conversion fails, or if the date is on or prior to the 1st January 1970
00:00:00 GMT (i.e. a UNIX timestamp of 0 or less), then the field will be treated as though it were empty.
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If you set a relevant date for a Generic pass template, it must also include a relevant location.

For examples of variables that can be used in the Date field described in the following table, click the Example
'template code' replacements link above the form, or see "Example Template Code Variables" on page 442.

Figure 330 The Pass Template Settings Form, Relevant Date Area

Field Description

Relevant Date If selected, shows the digital pass on the user's lock screen when near a given date.
Passbook determines the appropriate span of time around the date for the pass to be
displayed on the lock screen.
You can also edit a date type field in the Pass Fields area of the form to be a relevant date.

Date and Location If the template is a Generic pass style, a relevant location must also be included in order for a
relevant date to take effect.

Date Mode (Required) Specifies whether a date for this field is required or optional. Options include:
l Optional — The pass can still be generated even if no value is supplied for the

date field
l Required — The pass will not be generated if the value for the date field is

empty

Date Rank Rank order for processing the date field defined here. If multiple relevant date fields are
included in the template, they are processed in ascending order, and the first field that has a
valid date will be the relevant date for the pass.

Date Text for the relevant date. For no value, leave this field empty.
Date text typically contains standard template code that is evaluated when the pass is
generated.

Date Fields If the result of processing a date field is a number, the number is interpreted as a
UNIX timestamp.
If the result of processing a date field is textual (not a number and not empty), the text is
converted to a valid date and time value.

Table 195: Relevant Dates, Pass Template Settings

Defining Associated Apps

Multiple associated apps can be added. An Apple ID must be provided for each app. Although multiple
associated apps may be referenced by a pass, a link is displayed on the back of the pass only for the first app
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that is compatible with the device. If the app is installed on the device, the link displayed on the pass opens the
app. If the app is not installed on the device, the link opens the App Store at that app.

Figure 331 The Pass Template Settings Form, Associated Apps Area

Field Description

Associated Apps If selected, shows an associated application on the back of the pass. Passbook
determines the appropriate distance around the location for the pass to be displayed on
the lock screen.

First Compatible
App

Multiple associate apps can be referenced by a pass, but only the first app that is
compatible with the current device will have a link shown on the back of the pass. If the
app is installed on the device, that link will open the app. If the app is not installed, the link
will open the app store and show the app.

Apps (Required) Lists the associated apps that are referenced by this pass template.

Add new app Lets you add and configure a new app. The row expands to include the App Properties
form.

Table 196: Associated Apps, Pass Template Settings

When you have completed your entries on this page, click Save Changes. The new service is created and
displayed in the IP Phone Services list.

Example Template Code Variables

When you create or edit a digital pass template, many of the settings accept standard template code. This is the
same code that is supported for print templates. This allows you to specify either simple direct values or more
complex values based upon the evaluation of template code. All template code is evaluated when the pass is
generated from the pass template, using values from the guest receipt as inputs to the pass template.

The illustration below shows some of the special variables that can be used in the pass template fields that
accept template code. This variables list is also available when you go to Configuration > Receipts > Digital
Pass Templates, click the Edit or Create link, and then click the Example 'template code' replacements
link. Variables are available for user fields and certificate fields.
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Figure 332 Template Code Variables Available for Digital Passes

Images in Digital Passes

To make images available for selection, they must first be uploaded to the Public Files area in Content
Manager.

The images supported by each style of pass are shown below. This images list is also available when you go to
Configuration > Receipts > Digital Pass Templates, click the Edit or Create link, and then click the A note
regarding images and icons link.
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Figure 333 Images Supported by Each Style of Pass

Only PNG image files (*.png) are supported by passes.

A pass can contain both a low-resolution version (i.e. for non-Retina displays) and a high-resolution version (i.e.
for Retina displays) of each image. If it has been uploaded to the content manager, the high-resolution version
of an image is also automatically included in the pass. The high-resolution version must be named with the
suffix @2x at the end of the filename, just before the file extension—for example:

l Company_Logo.png (low-resolution filename)

l Company_Logo@2x.png (high-resolution filename)

Email Receipts and SMTP Services

With SMTP Services, you can configure ClearPass Guest to send customized guest account receipts to guests
and sponsors by email. Email receipts may be sent in plain text or HTML format. You may also send email
receipts using any of the installed skins to provide a look and feel.

To use the email sending features, you must have the SMTP Services Plugin installed.

This section includes:

l "About Email Receipts" on page 444

l "Configuring Email Receipts " on page 447

l "Email Receipt Options" on page 447

l "About Customizing SMTP Email Receipt Fields" on page 449

About Email Receipts

You can send email receipts for guest accounts that are created using either sponsored guest access or self-
provisioned guest access. This is convenient in situations where the guest might not be physically present to
receive a printed receipt.
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ClearPass Guest may be configured to automatically send email receipts to guests, or to send receipts only on
demand. Email receipts may be sent manually from the guest account receipt page by clicking the Send email
receipt link displayed there.

When using guest self-registration, the email delivery options available for the receipt page actions allow you to
specify the email subject line, the print template and email format, and other fields relevant to email delivery.

To configure these email delivery options:

1. Go to Configuration > Pages > Guest Self-Registrations. Click to expand the Guest Self-Registration
row in the form, and then click its Edit link. The Customize Guest Self-Registration diagram opens.

2. In the Receipt Page area, click the Actions link. The Receipt Actions form opens.

3. Scroll to the Email Delivery section of the form and choose one of the options from the Enabled drop-
down list. The form expands to include configuration options for email delivery.

Figure 334 The Actions Link on the Workflow Diagram
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Figure 335 The Customize Guest Registration Form, Email Delivery Area

The options shown in Table 197 are available in the Enabled drop-down list to control email delivery. For more
information on configuring these options, see "Editing Receipt Actions" on page 365.

Field Description

Disable sending guest receipts by
email

Email receipts are never sent for a guest registration.

Always auto-send guest receipts
by email

An email receipt is always generated using the selected options, and is
sent to the guest’s email address.

Auto-send guest receipts by email
with a special field set

If the Auto-Send Field is set to a non-empty string or a non-zero value, an
email receipt is generated and sent to the guest’s email address. The
auto-send field can be used to create an “opt-in” facility for guests. Use a
check box for the auto_send_sms field and add it to the create_user form,
or a guest self-registration instance, and SMS messages are sent to the
specified phone number only if the check box has been selected.

Display a link enabling a guest
receipt via email

A link is displayed on the receipt page; if the guest clicks this link, an email
receipt is generated and sent to the guest’s email address.

Send an email to a list of fixed
addresses

An email receipt is always generated using the selected options, and is
sent only to the list of email addresses specified in the “Copies To” field.

Table 197: Email Delivery Options, Customize Guest Self-Registration

ClearPass Guest 6.7 | User Guide Configuration | 446
Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2575



447 | Configuration ClearPass Guest 6.7 | User Guide

Configuring Email Receipts

You can configure the default settings used when generating an email receipt by going to Configuration >
Receipts > Email Receipt.

See "Email Receipt Options" on page 447 for details about the email receipt options.

Email Receipt Options
The Customize Email Receipt form may be used to set default options for guest account email receipts. To
configure email receipt options, go to Configuration > Receipts > Email Receipt. The Customize Email
Receipt form opens.

Figure 336 The Customize Email Receipt Form
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Field Description

Subject Line May contain template code, including references to guest account fields. The
default value, Guest account receipt for {$email}, uses the value of
the email field. See "Smarty Template Syntax" on page 713 for more
information on template syntax.

Email Receipt (Required) Specifies the plain text or HTML template to use for the email
receipt.

Skin (Required) Specifies the skin to use to provide the basic appearance of the
email. Options include:
l No skin – Plain text only – A skin is not used, and the email will be sent

in plain text format. Use this option to remove all formatting from the
email.

l No skin – HTML only – A skin is not used, but the email will be sent in
HTML format. Use this option to provide a basic level of formatting in the
email.

l No skin – Native receipt format – A skin is not used. The email will be
sent in either plain text or HTML format, depending on the type of print
template that was selected.

l Use the default skin – The skin currently marked as the default skin is
used.

l Aruba ClearPass Skin
l Blank Skin
l ClearPass Guest Skin
l Custom Skin 1
l Custom Skin 2
l Galleria Skin
l Galleria Skin 2
When sending an email message using HTML formatting, the images and
other resources required to display the page will be included in the message.

Copies To Creates a list of additional email addresses that are designated to receive
copies of the generated email receipts. To have the email receipt sent to the
sponsor's email address, enter the keyword _admin in this field. In this case
the email receipt will be sent to the current operator.

Send Copies (Required) Specifies how copies of the email receipts will be sent to the
additional email addresses listed in the Copies To field:
l Do not send copies – The Copies To list is ignored and email is not

copied.
l Always send using ‘cc:’ – The Copies To list is always sent a copy of any

guest account receipt (even if no guest account email address is
available).

l Always send using ‘bcc:’ – The Copies To list is always sent a blind copy
of any guest account receipt (even if no guest account email address is
available).

l Use ‘cc:’ if sending to a guest – If a guest account email address is
available, the email addresses in the Copies To list will be copied.

l Use ‘bcc:’ if sending to a guest – If a guest account email address is
available, the email addresses in the Copies To list will be blind copied.

Reply-To If selected, the Reply-To address will be overridden by the sponsor_email field
of the user, or by the admin's email. When you select this check box, the

Table 198: The Customize Email Receipt Form
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Field Description

Override From field is added to the form.
To use the global From Address, do not select the check box in this field.

Override From If selected, overrides the From Address instead of using the Reply-To value.

Email Field (Required) Specifies the field that will contain the guest's email address.

Auto-Send Field (Required) Specifies the field that will cause an account receipt email to be
automatically sent when a guest account is created. The email receipt will
only be sent if the field selected here contains a non-empty string of non-zero
value.

Test Mail Settings To preview and verify the appearance of the email receipt, you can send
yourself or another person a test message. Enter the test message
recipient’s email address, and then click Send Test Message. The test
message is sent immediately.

Figure 337 Example of Email Receipt Test Message Content

About Customizing SMTP Email Receipt Fields

The behavior of email receipt operations can be customized with certain guest account fields. You do this on a
per-user basis.
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Field Description

smtp_enabled May be set to a non-zero value to enable sending an email receipt. If unset, the
default value from the email receipt configuration is used. The special values “_Auto”
(Always auto-send guest receipts by email), “_AutoField” (Auto-send guest receipts by
email with a special field set), “_Click” (Display a link enabling a guest receipt via
email), and “_Cc” (Send an email to a list of fixed addresses) may also be used.

smtp_subject Specifies the subject line for the email message. Template variables appearing in the
value will be expanded. If the value is “default”, the default subject line from the email
receipt configuration is used.

smtp_template_id Specifies the print template ID to use for the email receipt. If blank or unset, the
default value from the email receipt configuration is used.

smtp_receipt_format Specifies the email format to use for the receipt. It may be one of “plaintext” (No skin
– plain text only), “html_embedded” (No skin – HTML only), “receipt” (No skin – Native
receipt format), “default” (Use the default skin), or the plugin ID of a skin plugin to
specify that skin. If blank or unset, the default value from the email receipt
configuration is used.

smtp_email_field Specifies the name of the field that contains the guest’s email address. If blank or
unset, the default value from the email receipt configuration is used. Additionally, the
special value “_None” indicates that the guest should not be sent any email.

smtp_auto_send_field Specifies the name of the field that contains the auto-send flag. If blank or unset, the
default value from the email receipt configuration is used. Additionally, the special
values “_Disabled” and “_Enabled” may be used to never send email or always send
email, respectively.

smtp_cc_list Sspecifies a list of additional email addresses that will receive a copy of the guest
account receipt. If the value is “default”, the default carbon-copy list from the email
receipt configuration is used.

smtp_cc_action Specifies how to send copies of email receipts. It may be one of “never”, “always_cc”,
“always_bcc”, “conditional_cc”, or “conditional_bcc”. If blank or unset, the default value
from the email receipt configuration is used.

Table 199: SMTP Email Receipt Fields

Logic for Sending Email Receipts

The logic used to send an email receipt is:

l If email receipts are disabled, take no action.

l Otherwise, check the auto-send field.

n If it is “_Disabled” then no receipt is sent.

n If it is “_Enabled” then continue processing.

n If it is any other value, assume the auto-send field is the name of another guest account field. Check the
value of that field, and if it is zero or the empty string then no receipt is sent.

l Determine the email recipients:

n Address the email to the value specified by the email field in the guest account. If the email field is “_
None” then do not send an email directly to the guest.

n Depending on the value of the Send Copies setting, add the email addresses from the Copies To: list to
the email’s “Cc:” or “Bcc:” list.
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l If there are any “To:”, “Cc:” or “Bcc:” recipients, generate an email message using the specified print template
and send it to the specified recipient list.

l Additional options and considerations are described in the following table:

Field Description

smtp_warn_before_subject This field overrides what is specified in the subject line under Logout
Warnings on the email receipt. If the value is “default”, the default
subject line under the Logout Warnings section on the email receipt
configuration is used.

smtp_warn_before_template_id This fieldoverrides the print template ID specified under Logout
Warnings on the email receipt. If the value is “default”, the default
template ID under the Logout Warnings section on the email receipt
configuration is used.

smtp_warn_before_receipt_format This field overrides the email format under Logout Warnings to use for
the receipt. It may be one of “plaintext” (No skin – plain text only),
“html_embedded” (No skin – HTML only), “receipt” (No skin – Native
receipt format), “default” (Use the default skin), or the plugin ID of a
skin plugin to specify that skin. If blank or unset, the default value in the
Email Field under the Logout Warnings on the email receipt
configuration is used.

smtp_warn_before_cc_list This overrides the list of additional email addresses that receive a
copy of the guest account receipt under Logout Warnings on the email
receipt. If the value is “default”, the default carbon-copy list under
Logout Warnings from the email receipt configuration is used.

smtp_warn_before_cc_action This field overrides how copies are sent as indicated under Logout
Warnings on the email receipt. to send copies of email receipts. It may
be one of “never”, “always_cc”, “always_bcc”, “conditional_cc”, or
“conditional_bcc”. If blank or unset, the default value from the email
receipt configuration is used.

warn_before_from_sponsor This field overrides the Reply To field (that is, the sponsor_email field
of a user, or the admin's email) under the Logout Warnings on the
email receipt. If the value is “default”, the Reply To field under Logout
Warnings from the email receipt configuration is used.

warn_before_from This field overrides the Override From field under the Logout Warnings
on the email receipt. If the value is “default”, the Override From field
under Logout Warnings from the email receipt configuration is used.

Table 200: Logic for Email Receipts: Additional Options

Customizing SMS Receipt
To configure SMS receipt options, go to Configuration > Receipts > SMS Receipt. The Customize
SMS Receipt page opens.

The fields described below are for the SMS plugin configuration page. Use the SMS receipt page for further
customization. For information on standard SMS services, see "SMS Services" on page 462.
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Figure 338 The Customize SMS Receipt Form

Field Description

SMS Receipt Specifies the plain text format print template to use when generating an SMS receipt. Options
include:
l Download Receipt
l SMS Receipt
l SMS Sponsor Confirmation Alert

Phone
Number
Field

Specifies the field that contains the guest’s phone number.

Auto-Send
Field

Specifies the field that, if it contains a non-empty string or a null value, will cause an account
receipt SMS to be automatically sent when the guest account is created.

Save
Configuration

Saves your changes on this form and returns you to the Start Here page of the Configuration
module.

Table 201: Customize SMS Receipt Form

SMS Receipt Fields

The behavior of SMS receipt operations can be customized with certain guest account fields. You can override
global settings by setting these fields.

l sms_enabled – This field may be set to a non-zero value to enable sending an SMS receipt. If unset, the
default value is true.

l sms_handler_id – This field specifies the handler ID for the SMS service provider. If blank or unset, the
default value from the SMS plugin configuration is used.

l sms_template_id – This field specifies the print template ID for the SMS receipt. If blank or unset, the
default value from the SMS plugin configuration is used.

l sms_phone_field – This field specifies the name of the field that contains the guest’s phone number. If
blank or unset, the default value from the SMS plugin configuration is used.
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l sms_auto_send_field – This field specifies the name of the field that contains the auto-send flag. If blank
or unset, the default value from the SMS plugin configuration is used. Additionally, the special values “_
Disabled” and “_Enabled” may be used to never send an SMS or always send an SMS, respectively.

The logic used to send an SMS receipt is:

l If SMS receipts are disabled, take no action.

l Otherwise, check the auto-send field.

n If it is “_Disabled” then no receipt is sent.

n If it is “_Enabled” then continue processing.

n If it is any other value, assume the auto-send field is the name of another guest account field. Check the
value of that field, and if it is zero or the empty string then no receipt is sent.

l Determine the phone number – if the phone number field is set and the value of this field is at least 7
characters in length, then use the value of this field as the phone number. Otherwise, if the value of the
auto-send field is at least 7 characters in length, then use the value of this field as the phone number.

l If the phone number is at least 7 characters long, generate a receipt using the specified plain-text print
template and send it to the specified phone number.

Customizing Print Templates
Print templates are used to define the format and appearance of a guest account receipt. To work with print
templates, go to Configuration > Receipts > Templates. The Guest Manager Print Templates list view
opens. All print templates you have created are included in the list. Information shown for each template
includes its name for internal identification, format, and status.

Figure 339 The Guest Manager Print Templates List View

You can click a print template's row in the list for additional options:
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Field Description

Edit Edit the print template. The Edit Print Template page opens. See "Creating New Print
Templates" on page 454.

Duplicate Creates a copy of the print template that you can use as the basis of a new template.

Delete Deletes the print template. You will be asked to confirm the deletion.

Preview The template’s row expands to display a preview of the print template as the user would see
it.

Show Usage The template’s row expands to show a list of the receipts that currently use the template.
You can click an item in the list to edit it.

Permissions The Edit Print Template Permissions form opens, where you can modify which operator
profiles and other users have access to the print template.

Edit code This option is available if a print template was created using the wizard but has since been
modified. See "Modifying Wizard-Generated Templates" on page 460 for further
information.

Create new print
template using
wizard

Create a new template using the wizard. The Print Template Wizard (new) page opens.
See "Print Template Wizard " on page 457.

Create new print
template

Create a new print template. The Create Print Template page opens. See "Creating New
Print Templates" on page 454.

Table 202: Guest Manager Print Templates List View

Options to show where a print template is being used, and to control individual permissions for a print
template, are also available when selecting a print template. See "Setting Print Template Permissions" on page
460.

Plain text print templates may be used with SMS services to send guest account receipts; see "About SMS
Guest Account Receipts " on page 470 for details. Because SMS has a 160 character limit, the number of
characters used in the plain text template will be displayed below the preview. If you are including a guest
account’s email address in the SMS, remember to allow for lengthy email addresses (up to 50 characters is a
useful rule of thumb).

Creating New Print Templates

To define a new print template, go to Configuration > Receipts > Templates and click the Create new
print template link in the upper-right corner. The Create Print Template page opens. This page has two
parts.

The first part provides a list of the variables that can be used in the template together with their meaning and
an example of each. User and certificate fields are available for print templates.
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Figure 340 Template Code Variables Available for Print Templates

This section is followed by the Create Print Template form used to configure the sections of the template:
the body, the header and the footer. Each section must be written in HTML. You can use the drop-down list in
each section to add images or other content items.
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Figure 341 The Create Print Template Form

Field Description

Name (Required) Name for the print template. The name is used to select which template to use when
printing a list of accounts.

Enabled If selected, enables this print template for use.

Layout (Required) Specifies how the guest account list will be printed when this template is used. Options
include:
l Plain text format
l One account per page
l 1-column list
l 2-column list
l 3-column list
l 4-column list
l 5-column list

User
Account
HTML

HTML template code used to generate a single account receipt. This template is used once for each
guest account in the document. You can use the drop-down list to add images or links.

Document
Header
HTML

HTML template code used at the beginning of the document. This template is used only once, before
the account receipts are generated. You can use the drop-down list to add images or links.

Document
Footer
HTML

HTML template code used at the end of the document. This template is used only once, after the
account receipts are generated. You can use the drop-down list to add images or links.

Create
Template

Saves the new template and returns to the list at Configuration > Receipts > Templates.

Create and
Reload

Saves the new template and stays on this Create Print Template page.

Table 203: Create Print Template Form
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You can add Smarty template functions and blocks to your code. These act as placeholders to be substituted
when the template is actually used.

See "Smarty Template Syntax" on page 713 for further information on Smarty template syntax.

You can use an {if} statement to define a single print template that caters to multiple situations. For example, if
you want to customize the print template to display different content depending on the action that has been
taken, the following code could be used:

{if $action == "create"}

<p>

Your guest account has been created and is now ready to use!

</p>

<ul>

{if $site_ssid}

<li>Connect to the wireless network named: <b>{$site_ssid}</b></li>

{/if}

<li>Make sure your network adapter is set to 'DHCP - Obtain an IP address

Automatically'.</li>

<li>Open your Web browser.</li>

<li>Enter your username and password in the spaces provided.</li>

</ul>

{elseif $action == "edit"}

<p>

Your guest account has been updated.

</p>

{elseif $action == "delete"}

{/if}

<table {$table_class_content} width="500">

<tbody>

{if $u.guest_name}

<tr>

<th class="nwaLeft">guest name</th>

<td class="nwaBody">{$u.guest_name}</td>

</tr>

{/if}

If this code is placed in the User Account HTML section, it will cater to the create, edit, and delete options.

Print Template Wizard

The Print Template Wizard provides a simplified way to create print templates. You can select a basic style
and provide a logo image, title, and content text, and select the guest account fields to include.

Each of the basic styles provides support for a logo image, title area, subtitle area, notes area, and footer text.
These items can be customized by typing in an appropriate value in the Print Template Wizard. A real-time
preview allows changes made to the design to be viewed immediately.

Because the print template is an HTML template, it is possible to use HTML syntax as well as Smarty template code in
these areas. See the "Reference" on page 710 chapter for reference material about HTML and Smarty template
code.

To use the Print Template Wizard, go to Configuration > Receipts > Templates and click the Create new
print template using wizard link in the upper-right corner. The Print Template Wizard page opens.
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Figure 342 The Print Template Wizard
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Field Description

Style (Required) Specifies the style of print template to use. Small thumbnail images are shown to indicate
the basic layout of each style. Options include:
l Table – Best for square or nearly square logo images, and well suited for use with “scratch card”

guest accounts.
l Simple – Best for wide or tall logo images and for situations where an operator will print a page

with guest account details.
l Centered – Best for wide logo images; less formal design.
l Label Printer – Three sizes are provided. These print template styles are designed for small

thermal printers in various widths. On-screen assistance is provided when printing to ensure that a
consistent result can be obtained.

Preview
at right

After a style is selected, you can click one of these links to display the real-time preview of the print
template at either the right side or the bottom of the Print Template Wizard.

Preview
at
bottom

Logo
Image

Specifies the logo image to use on the print template. All images that have been uploaded to the
Content Manager are displayed in this field. To select an image, click to highlight it in this field.

Title Title to display on the print template.

Subtitle Subtitle to display on the print template.

Field
Header

Field header for the details that are displayed on the print template.

Fields Specifies the guest account fields to display on the print template. Use a drop-down list to choose a
field name. By default, the wizard sets up the template with the username, password and role_name
fields, but these may be customized. You can add fields, remove fields, or change the order of fields.
Your changes are shown in the preview. To expand the row to display configuration options, either click
the drop-down list, or click the icon at the left of the drop-down list. Options include:
l Remove — Removes the field from this form and from the print template.
l Move Up — Moves this field to appear above the previous field in the list.
l Move Down — Moves the field to appear below the next field in the list.
l Insert Before — Adds a new drop-down list above the active row so you can add a new field to the

print template.
l Insert After — Adds a new drop-down list below the active row so you can add a new field to the

print template.

Notes Notes to display in the print template — for example, a welcome message or usage instructions.

Table 204: Print Template Wizard
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Field Description

Footer Footer text to display on the print template.

Print
Template
Preview

Real-time preview of the print template as a guest would see it. Shows the changes you make in the
wizard. Use the links above the wizard to change the position of the preview.

Create
Template

Saves the new print template and returns to the Guest Manager Print Templates list view.

Table 204: Print Template Wizard(Continued)

Modifying Wizard-Generated Templates

After you create a print template using the Print Template Wizard, you can return to the wizard to modify it.

Click the Edit print template code (Advanced) link to use the standard print template editor. See
"Creating New Print Templates" on page 454 for a description.

If you use the wizard to edit a print template after changes have been made to it outside the wizard, those outside
changes will be lost. This is indicated with the warning message "The print template code has been modified. Making
changes using the wizard will destroy any changes made outside of the wizard."

Setting Print Template Permissions

On the Guest Manager Print Templates list view, the Permissions link for a template can be used to
control access to an individual print template at the level of an operator profile. The Permissions link is only
displayed for a template if the current operator has the Object Permissions privilege. The Object Permissions
privilege is located in the Administrator group of privileges.

To view and work with permissions for a print template:

1. Go to Configuration > Receipts > Templates. The Guest Manager Print Templates list view opens.

2. Click the template’s row in the list, and then click its Permissions link. The Edit Print Template
Permissions form opens.

Figure 343 The Edit Print Template Permissions Form
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Field Description

Object Name of the selected print template. The name cannot be edited.

Owner
Profile

Name of the operator profile that will always have full access to the print template.

Access Specifies who has access to this print template, and the level of permissions they have for it. Use
the Entity and Permissions drop-down lists in this row to set permissions.

Entity Specifies the operator profiles or other entities that can have access to this print template. Options
include:
l Operator Profiles: — Any of the following specific operator profiles may be selected. The

corresponding permissions will apply to all operators with that operator profile.
n Null Profile
n Operations and Marketing
n Receptionist
n Network Administrator
n Help Desk
n Read-only Administrator
n Device Registration
n BYOD Operator
n API Guest Operator

l Other Entities:
n Authenticated Operators — The permissions for all operators (other than the owner

profile) may be set using this item. Permissions for an individual operator profile will take
precedence over this item.

n Guests — The permissions for guests may be set using this item.

Permissions Specifies the permissions for the user type selected in the corresponding Entity list. Options
include:
l No access — The print template is not visible in the list, and cannot be used, edited, duplicated,

or deleted.
l Visible-only access — The print template is visible in the list, but cannot be edited, duplicated,

or deleted.

l Read-only access — The print template is visible in the list, and the settings for it may be
viewed. The print template cannot be edited or deleted.

l Update access — The print template is visible in the list, and may be edited. The print template
cannot be deleted and the permissions for the print template cannot be modified.

l Update and delete access — The print template is visible in the list, and may be edited or
deleted. The permissions for the print template cannot be modified.

Table 205: Edit Print Template Permissions Form
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l Full access (ownership) — The print template is visible in the list, and may be edited or
deleted. The permissions for the print template can be modified, if the operator has the Object
Permissions privilege.

Delete To remove an entity from the list in the Access field, click anywhere in the entity’s row. A Delete link
is displayed for that row. Click the Delete link to remove the entity’s row from the list. You will be
asked to confirm the deletion.

Add To add an entity to the list in the Access field, click anywhere in an entity’s row. An Add link is
displayed for that row. Click the Add link to add a new pair of Entity and Permissions fields.

Save
Changes

Saves your changes on this form and returns to the Guest Manager Print Templates list view.

Save and
Reload

Saves your changes on this form and stays on this form.

Table 205: Edit Print Template Permissions Form(Continued)

SMS Services

With SMS Services, you can configure ClearPass Guest to send SMS messages to guests. You can use SMS to
send a customized guest account receipt to your guest’s mobile phone. You can also use SMS Services to send
an SMS from your Web browser. To use the SMS features, you must have the SMS Services plugin installed.

This section describes:

l "Viewing SMS Gateways" on page 463

l "Creating or Editing an SMS Gateway" on page 463

l "Sending an SMS " on page 469

l "About SMS Credits" on page 470

l "About SMS Guest Account Receipts " on page 470

l "About SMS Receipt Options" on page 471

l "Working with the Mobile Carriers List" on page 471
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Viewing SMS Gateways

A ClearPass Guest SMS service is automatically added when a subscription ID is configured in ClearPass. You
can also add one, and work with existing gateways.

To view and work with the list of SMS gateways, go to Configuration > SMS Services > Gateways. The SMS
Gateways list view opens.

Figure 344 The SMS Gateways List View

All SMS gateways that have been defined are included in the list, and their names and available credits are
displayed. You can click a gateway's row in the list or use the links provided on the page for additional options:

Field Description

Edit Edit a gateway’s properties. See "Creating or Editing an SMS Gateway" on page 463.

Duplicate Creates a copy of the gateway to use as a base for a new gateway. A new gateway will be added
to the list with the name “Copy of <original gateway>”.

Delete Deletes the gateway from the list. You are asked to confirm the deletion. Click OK at the prompt
to delete the gateway.

Make Default Makes this gateway the default gateway for SMS messages.

Send SMS Lets you send an SMS message via this gateway. The row expands to include the New SMS
Message form, where you can enter the recipient’s mobile phone number and the message text,
and then send the message. In the Recipient field, use the drop-down list to select the country
code and enter the number in international format. The Recipient field is validated.

Create new
SMS gateway

To add a carrier to the list, click this link in the upper-right corner. The Create SMS Gateway
opens. See "Creating or Editing an SMS Gateway" on page 463.

Table 206: SMS Gateways List

Creating or Editing an SMS Gateway
An SMS gateway is automatically created and added to the SMS Gateways list when you enter your
subscription ID in ClearPass Policy Manager at Administration > Agents and Software Updates >
Software Updates. You can also use ClearPass Guest to create a new SMS gateway.

The SMS Gateway Configuration form is used to create and to edit an SMS gateway.

To create a new SMS gateway through ClearPass Guest:

1. Go to Configuration > SMS Services > Gateways. The SMS Gateways list view opens.

2. Click the Create new SMS gateway link in the upper right corner. The SMS Gateway Configuration
form opens.
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To edit an existing SMS gateway:

1. Go to Configuration > SMS Services > Gateways. The SMS Gateways list view opens.

2. Click the gateway’s row in the list, and then click its Edit link. The SMS Gateway Configuration form
opens.

Figure 345 The SMS Gateway Configuration Form, Service Settings Area (Custom HTTP Handler selected as the
gateway)
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The first part of the SMS Gateway Configuration form includes the Service Settings options:

Field Description

SMS Gateway (Required) If you are creating a new gateway, specifies the SMS gateway service to use. If you
are editing an existing gateway, this field cannot be edited. Options include:
l ClearPass Guest SMS Service
l Custom HTTP Handler
l SMS over SMTP
l SMPP v3.4
l External Providers
The following options presented in the Service Settings area depend on the gateway selected
here.

Address (Required) If a fixed email address was specified, enter the email address to which all SMS
messages will be sent.

Address
Template

(Required) If a template to determine the address was specified, enter an example address that
will be used as the pattern for the address format.

API ID Optional API ID, if required by the SMS provider.

Authentication
Method

(Required) Specifies how the username and password will be passed to the gateway. Options
include:
l Substituted parameters
l HTTP Basic Authentication

Carrier
Selection

Specifies how the carrier will be determined. Options include:
l Registration form will have the visitor_carrier field—The guest will supply the carrier

information when they register. The Mobile Carrier field will be included in the guest’s
registration form, and added to the Test SMS Settings area of the forms.

l Select a carrier—The form expands to include the Mobile Carrier field. Choose the carrier
from the Mobile Carrier drop-down list.

l Configure Carrier Settings—The form expands to include configuration options for the
carrier.

Display Name Name for this gateway service handler. The name entered here is the one that will be displayed
to operators using the system.

HTTP Headers If the POST option was selected in the Service Method field for a custom HTTP handler gateway,
you can use this text field to override the HTTP header. For example:
Content-Type: text/xml

HTTP Post (Required) If the POST option was selected in the Service Method field for a custom HTTP
handler gateway, you can use this text field to enter the text to post. See the service URL field for
available substitutions.

Message
Encoding

Message encoding to use when sending messages to the SMPP provider.

Message
Format

If selected, specifies that the message format should be converted to hex-encoded UTF-16
(Unicode). This is not needed for all custom SMS handlers; refer to your service provider’s
documentation.

Mobile Carrier (Required) Specifies the carrier to use.

Table 207: SMS Gateway Configuration Form, Gateway and Service Settings Areas
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Field Description

Null
Terminate
Strings

If selected, C-Octet strings on SMPP SMS servers will be null-terminated.

Number
Format

Specifies the country code requirement of the carrier. Options include:
l Use the guest’s value
l Always include the country code
l Never include the country code

Port Number The port number used to reach the server. To use the default, leave this field empty.

Service
Method

(Required) If Custom HTTP Handler was selected in the SMS Gateway field, select the HTTP
method to use. Options include:
l GET
l POST

Service
Password

Your password for your SMS service provider.
If you are using ClearPass Guest SMS Service and have entered your ClearPass subscription ID
in the Software Updates page of ClearPass Policy Manager’s Administration module, leave this
field blank. The subscription ID is automatically used as the password for the ClearPass SMS
Service.

Confirm
Password

Service URL (Required) The URL template to use when sending a message. Use the following items in the
template:
l @USERNAME@ – Service Username
l @PASSWORD@ – Service Password
l @API_ID@ – API ID
l @FROM@ – SMS Source Address
l @TO@ – Recipient
l @MESSAGE@ – Message
l @MESSAGE_ENC@ – Message that has already been URL encoded

Service
Username

Your authorization username for your SMS service provider.
If you are using ClearPass Guest SMS Service and have entered your ClearPass subscription ID
in the Software Updates page of ClearPass Policy Manager’s Administration module, leave this
field blank. The subscription ID is automatically used as the username for the ClearPass SMS
Service.

SMPP Server
Address

IP address or DNS name of the SMPP server.

SMPP System
Type

(Required) The registered SMPP System Type.

SMS Address Specifies how the email address will be determined. Options Include:
l Use a template to determine the email address
l Use a fixed email address

SMS Source
Address

Originator address of sent SMS messages. Depending on the provider, this may be either a
phone number or a short string.

Source
Address NPI

Numbering plan identification (NPI) type of the source address. Options include:
l NPI_UNKNOWN
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Field Description

l NPI_E164
l NPI_DATA
l NPI_TELEX
l NPI_E212
l NPI_NATIONAL
l NPI_PRIVATE
l NPI_ERMES
l NPI_INTERNET
l NPI_WAPCLIENT

SSL Certificate Path of the uploaded SSL certificate (public/cert.pem). This must be in .pem format.

SSL
Passphrase Passphrase for the certificate specified in the SSL Certificate field. If there is no passphrase,

leave this field blank.
Confirm
Passphrase

Subject Line Text for the message’s subject line. This field supports Smarty template syntax. For a Smarty
template syntax description, See "Smarty Template Syntax" on page 713.

The Mobile Number Settings area of the SMS Gateway Configuration form includes options for defining
the mobile phone number settings:

Figure 346 The SMS Gateway Configuration Form, Mobile Number Settings Area

Field Description

Country
Code

Default country code to use for mobile telephone numbers that start with the national prefix. Most
SMS providers require that the number be sent with the country code.

Default
Length

If your country has a default length, enter it here. The country code entered in the previous field will be
automatically added if it is required. For example, North American numbers have a default length of 10,
and country code 1.

Auto
Plus
Length

If your SMS provider requires a "+" for international numbers, enter the minimum length for
international numbers. If a phone number is entered whose length is greater than or equal to this value,
the "+" will automatically be prepended.
For example, North American numbers have a default length of 10 and a country code of 1, so the Auto

Table 208: SMS Gateway Configuration -- Mobile Number Settings Options
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Plus Length would be 11.

National
Prefix

If your country uses a national dialing prefix such as "0", you may enter it here. When sending an SMS
to a number that starts with the national dialing prefix, the prefix is removed and replaced with the
country code instead.

The lower part of the SMS Gateway Configuration form includes the Connection Settings, Debug, and
Test SMS Settings areas:

Figure 347 The SMS Gateway Configuration Form, Connection Settings, Debug, and Test SMS Settings Areas

Field Description

Connection
Timeout

(Required) The connection timeout for this SMS service, in seconds.

HTTP
Timeout

(Required) The timeout for the HTTP transfer to complete, in seconds.

Enable
Debug

If selected, debug messages will be generated for each stage of the HTTP transaction and the
detailed information will be included in the application log.

Table 209: SMS Gateway Configuration -- Connection Settings, Debug, and Test SMS Settings Options
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Field Description

Message (Required) The message to send to verify the configuration.

Recipient (Required) The test recipient's mobile phone number for verifying the configuration. Use the drop-
down list to select the country code and enter the number in international format. This field is
validated.

Send Test
Message

To verify the configuration, after you enter the test message and the test recipient's mobile number,
click this button. The test recipient should receive the message and confirm the results.

When you have completed your changes on this form, click Save and Close. The new configuration settings
take effect immediately.

When you save your entries for the SMS over SMTP option, a new screen, Mobile Carriers, is added to the left
navigation. For more information, see "Working with the Mobile Carriers List" on page 471.

Sending an SMS

You can send an SMS message if the system has been configured to allow this.

To send an SMS message:

1. Go to Configuration > SMS Services > Send SMS. The New SMS Message form opens.

Figure 348 The New SMS Message Form
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Field Description

Service Service that will be used to send the message. If multiple services are available, you may specify the
service to use.

Recipient (Required) Mobile number of the recipient, in international format. Use the drop-down list to select the
country code and enter the number in international format. This field is validated.

Message (Required) Message to send. The maximum message length is 160 characters.

Send
Message

Sends the SMS message.

Table 210: New SMS Message Form

About SMS Credits
Most SMS providers use a system of credits for sending messages. In ClearPass Guest SMS Services, one credit
is used for each sent message. The credit is used when the message is sent, regardless of whether the recipient
actually receives the message. Please review your provider’s details and pricing.

To determine the number of remaining SMS credits for a service, go to the Configuration > SMS Services >
Gateways list, and find the service's row in the list. The Credits Available column indicates the number of
remaining SMS credits for your account. This value is determined when the first message is sent, and is
updated when each message is sent.

When credits are running low, a warning message is emailed to the administrator group. The email address is
determined by looking up all local operators with the special IT Administrators operator profile, and using any
configured email address for those operators.

Up to three messages will be sent:

l A low-credit warning is sent when the “Credits Available” value reaches the warning threshold (the default
value is 50).

l A second low-credit warning is sent when the “Credits Available” value reaches half the warning threshold.

l A final message is sent when the “Credits Available” value reaches zero.

To adjust the warning threshold, set the Credit Warning value in the configuration for the SMS Services Plugin. See
"Configuring the SMS Services Plugin" on page 667.

About SMS Guest Account Receipts

You can send SMS receipts for guest accounts that are created using either sponsored guest access or self-
provisioned guest access. This is convenient in situations where the guest might not be physically present to
receive a printed receipt.

ClearPass Guest may be configured to automatically send SMS receipts to guests, or to send receipts only on
demand.

To manually send an SMS receipt:

1. Go to the Guest > Manage Accounts and click to expand the row of the guest to whom you want to send
a receipt.
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2. Click Print to display the Updated Account Details view, and then click the Send SMS receipt link. The
SMS Receipt form opens.

3. Use the fields on the SMS Receipt form to enter the service to use, the recipient’s mobile phone number,
and the message text.

Figure 349 The SMS Receipt Form

When using guest self-registration, SMS Delivery options are available for the receipt page actions. See "Editing
Receipt Actions" on page 365 for full details. For more information on SMS services, see "SMS Services" on page
462.

About SMS Receipt Options

SMS receipt configuration options are available in the Configuration module (see "Customizing SMS Receipt" on
page 451). Advanced configuration options for the SMS Services, including receipt options, are also available in
the plugin configuration (see "Configuring Plugins" on page 649).

Working with the Mobile Carriers List

If you have included SMS over SMTP gateways in your SMS gateways list, you can manage the list of SMTP
carriers that are included in the Mobile Carrier drop-down list on the Configuration > SMS Services >
Gateways > Edit SMS Gateway form.

To include the Mobile Carrier field in the guest’s registration form, when you create or edit a gateway you
must choose Registration form will have the visitor_carrier field in the Carrier Selection drop-down
list. The Mobile Carrier field will be included in the guest’s registration form, and added to the Test SMS
Settings area of the forms. See Creating or Editing an SMS Gateway.
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To view or work with the mobile carriers list, go to Configuration > SMS Services > Mobile Carriers. The
Mobile Carrier List view opens. The carriers in this list are the ones that are included in the Mobile Carrier
drop-down list on the SMS Services > Gateways > Edit SMS Gateway form.

Figure 350 The Mobile Carrier List View

Field Description

Quick
Help

Displays some information about the SMS SMTP carrier list and about how to use the Mobile Carrier
List view.

Display
Lists

Lets you filter the list. The form expands to include the Carrier Lists form. Use the drop-down lists on
this form to specify the SMS carrier or the MMS carrier, and then click OK. To be available in the drop-
down lists on this Carrier Lists form, a carrier must first be enabled.

Create Add a carrier to the list. The Mobile Carrier List view expands to include the Mobile Carrier Editor
form. See "The Mobile Carrier Editor Form" on page 473, below.

Table 211: Mobile Carrier List View
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Field Description

Edit Edit the carrier. The row expands to include the Mobile Carrier Editor form for that carrier. See "The
Mobile Carrier Editor Form" on page 473, below.

Enable To enable a carrier, click the Enable link in its row and then refresh the screen. The carrier will then be
available to work with and will be included in the drop-down lists when you click the Display Lists link.

Delete Deletes the carrier, You will be asked to confirm the deletion.

Table 211: Mobile Carrier List View(Continued)

Figure 351 The Mobile Carrier Editor Form

The procedures for adding and for editing a carrier are the same. To open the Mobile Carrier Editor form,
click either the Create link or an Edit link on the Mobile Carrier List. The list view expands to include the
Mobile Carrier Editor form.

Field Description

Name (Required) Name of the carrier. If there is more than one format of the carrier company’s name, use
the format the public most readily identifies with the carrier service.

Enable (Required) If selected, the carrier is included in the list of available choices for users.

Country Country where the carrier’s service is offered. If appropriate, you may also indicate an area within the
country, such as a city, county, state, or province.

SMS
Address

Specifies how the email address will be determined. Options include:
l Use a template to determine the email address— When this option is chosen, the next field’s

name becomes SMS Template.
l Use a fixed email address—Use this option if all SMS messages are to be sent to the same

address. When this option is chosen, the next field’s name becomes Address.

Table 212: Mobile Carrier Editor Form
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Field Description

SMS
Template

(Required) Example email address for SMS messages. This provides the pattern for the address
format. The default is to substitute the number for all characters preceding the @ sign, producing the
pattern number@address.
Use the keyword “NUMBER” where appropriate, otherwise everything after the @ sign will be used.
Some carriers require additional characters before or after the phone number. In this case, use the
keyword string NUMBER in the pattern to limit the substitution to just the phone number portion of the
address—for example, NUMBER.msg@carrier.example.com, or username+NUMBER@mymail.com

Address (Required) Email address to which all SMS messages will be sent.

MMS (Required) If selected, the SMS template will also be used for all MMS messages, and the MMS
Template row is removed from the form.
To use an MMS template for MMS messages, leave this check box unmarked.

MMS
Template

Example email address for MMS messages. This provides the pattern for the address format.
Use the keyword “NUMBER” where appropriate, otherwise everything after the @ sign will be used.

Number
Format

Specifies the country code requirement of the carrier. Options include:
l Use the guest’s value
l Always include the country code
l Never include the country code

Subject
Line

Text for the message’s subject line. This field supports Smarty template syntax, and the number is
available as {$number}.
For example:

Sent to: {$number} in the year {‘Y’|date}

...would produce:
Sent to: 15555551234 in the year 2012

For a Smarty template syntax description, See "Smarty Template Syntax" on page 713.

Create
Carrier

Creates the new carrier and adds it to the Mobile Carrier List.

Save
Changes

Saves your changes to the existing carrier and updates the Mobile Carrier List.

Table 212: Mobile Carrier Editor Form(Continued)

About Translations

Translation services let you configure the language that will be displayed to guests in the ClearPass Guest
interface. You can set a default language, enable auto-detection based on the user's browser settings, enable
various language packs, and allow the user to select the language. Language packs are editable, letting you
customize label and message text and numerous other settings. You can use the Plugin Manager to enable the
translation assistant features, and to configure ClearPass Guest's language settings for your own use.

l To set the default language, show IDs for labels and messages, and provide a language selector on each
page of the user interface, see "Translation Assistant" on page 475.

l To view and manage your list of enabled translation packs, see "Language Packs" on page 476.
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l To edit basic information for a translation pack, see "Creating and Editing Language Packs" on page 477.

l To customize a translation pack's labels and messages, see "Customizing Translated User Interface Text" on
page 478.

l To view the Translation Plugin settings, see "Configuring the Translations Plugin" on page 672 in the
Administration module.

Translation Assistant
To configure some basic user assistance features for translation overrides, go to Configuration
> Translations > Assistant. The Translation Assistant form opens.

Figure 352 The Translation Assistant Form

Figure 353 The Translation Assistant Form with Text IDs Showing
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Field Description

Default Language Specifies the default language pack for the user's application.

Auto-Detection If selected, disables automatic browser-based language detection and enforces the
default language pack instead. The default behavior is to use the language the user's
browser has detected as preferred, instead of using the default language pack.

Text IDs If selected, the text IDs are displayed on all headings and field names in the ClearPass
Guest user interface, and an Override all translations generated for this page link is
displayed at the bottom of each page. Displaying the text IDs lets translators easily
identify the fields on each page in order to customize translations. For more information,
see "Customizing Translated User Interface Text" on page 478.

Translate Links If selected, Translate links are displayed on guest-facing configuration fields for which
translations are supported — this includes logins, onboarding, self-registrations, pages,
and print templates.

Language Selector If selected, provides language selection options on each page of the user interface. A row
of language links with flags is displayed at the bottom of each page. If this check box is
not selected, the language selection options are only displayed on the login page.

Save Changes Saves your changes on this form.

Table 213: Translation Assistant Configuration

Language Packs
To work with individual translation packs, go to Configuration > Translations > Language Packs. The
Language Packs list view opens.

Figure 354 The Language Packs List View
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All translation packs that have been enabled are included in the list. You can click a translation pack's row in the
list for additional options:

Field Desription

Edit Enable or disable the language pack and edit its name, display name, language code,
flag image, and list of locale identifiers. For more information, see "Creating and
Editing Language Packs" on page 477.

Translations Specify and edit the translated wording of the application's labels and messages to
override the default settings for the language. For more information, see
"Customizing Translated User Interface Text" on page 478.

Export Download your customized translations to a file and send them to your ClearPass
Support team. Your feedback helps us enhance the default translations.

Export custom form
templates

Download your customized form templates to a file and send them to your ClearPass
Support team.

Duplicate Create a new language pack. You can give the copy of the language pack a new
name, enable it, and edit its display name, language code, flag image, and locales
list. For more information, see "Creating and Editing Language Packs" on page 477.

Use Applies this language pack. Labels in ClearPass Guest are displayed in the language.
To revert, click the Use link for a different language in the list.

Make Default Use a language pack as the new default language for the application. You can also
reset the default language from the Translation Assistant form.

Table 214: Language Packs List View Options

Creating and Editing Language Packs

To create or edit a language pack:

Go to Configuration > Translations > Language Packs, and then click the Edit or Duplicate link for a
language pack in the list. The Language Pack Configuration form opens.

Figure 355 The Language Pack Configuration Form
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Field Description

Parent Name of the language pack you used as a basis. This field only appears if you are duplicating a
language pack, and cannot be edited.

Name Name of this language pack. This identifying name is different from the display name, and is only seen
by application administrators.

Enabled If selected, enables this language pack. To create the language pack but not enable it yet, leave this
check box unselected. Each language code can have only one corresponding language pack enabled
at a time.

Display
Name

Name to display in the language selection options in the user interface.

Language
Code

Unique ISO 639-1 language code that corresponds to this language pack. Only one language pack at a
time can be enabled for each language code.

Flag Specifies the filename of the flag image to use for this language pack. Image files should have been
previously uploaded to the Content Manager.
In the user interface's language selection options, a small image of a flag is shown next to each
language.

Locales Comma-separated list of locale identifiers for this language pack. Locale identifiers let you customize
language packs for regional differences.

RTL If selected, specifies that this language displays text right-to-left.

Save
Changes

Saves your changes and returns to the Language Packs list view.

Table 215: Language Pack Configuration

Customizing Translated User Interface Text

You can override the default translations provided for labels and messages in the user interface, customizing
these items in each language pack.

To customize label and message text for a language pack, do one of the following:

l Go to Configuration > Translations > Language Packs, and then click the Translations link for a
language pack in the list. The Language Pack Configuration form opens. In the Translations area of the
form, the Text IDs field shows a list of any items that already have custom overrides. To edit a different
field, you can enter its text ID and refresh the form. A row will be added for the field.

Figure 356 The Translation Pack Configuration Form
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l Go to Configuration > Translations > Assistant. Select the language, select the check box in the Text
IDs field, and save your changes. Text IDs are shown with every label, and an Override all translations
generated for this page link is now displayed at the bottom of every page in ClearPass Guest. To
customize translations for a certain page or group of pages, go to the page you want to translate and click
its Override all translations generated for this page link. The Edit Translations form opens. Text IDs
for that page and the set of pages it belongs to (for example, all pages related to Web Logins) are listed in
the Translations area of the form. The form includes a row for each text ID, where you can provide a
custom translation.

Figure 357 The Translation Pack Configuration Form with Text IDs Showing

Field Description

Name

These fields show the information for this language pack and cannot be edited on this form.

Display Name

Language Code

Locales

Table 216: The Language Pack Configuration Form

Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2608



Field Description

Enabled If selected, enables this language pack. If this language pack should not be enabled at this
time, leave this check box unselected. Each language code can have only one corresponding
language pack enabled at a time.

Text IDs Comma-separated list of text IDs for labels and messages in the ClearPass Guest user
interface.
l If you accessed this form from the Overide Translations link on the Language Packs list

view, this field is empty. If you know the text IDs of fields you want to edit, enter them here,
separated by commas, and then click Refresh. To view or edit just the items that already
have custom overrides, you can leave this field blank.

l If you accessed this form from the Override all translations generated for this page
link at the bottom of any page in ClearPass Guest, this field contains a list of all the text
IDs for that page and related pages and messages.

Common IDs Each link in this field corresponds to a group of related pages and messages. Click a link to
display the text IDs for all labels and messages in that group. The text IDs are listed in the
Text IDs field, and a row is added to the form for each text ID.

(text ID numbers) These rows appear if text IDs were specified in the Text IDs field. The default text for the field
is shown below the text box. For each item you want to override, enter the new text in the text
box.

Refresh If you entered items in the Text IDs field, click this button to add their rows to the form so you
can edit them.

Save and Reload Saves your changes and reloads this form.

Save Changes Saves your changes and returns to the Language Packs list view.
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Chapter 6
Advertising Services

Advertising Services lets you deliver marketing promotions and advertisements to your users on a variety of
Guest Management registration, receipt, and login pages.

To work with ClearPass Guest Advertising Services, go to Configuration > Advertising > Start Here.

This section includes:

l "About Advertising Services" on page 482

l "About the Tutorial" on page 483

l "Advertising Pages" on page 485

l "Advertising Spaces" on page 493

l "Advertising Campaigns" on page 501

l "Advertising Promotions" on page 505

l "Advertising Materials" on page 511

About Advertising Services
This section describes the main elements you work with to configure Advertising Services to deliver marketing
promotions and advertisements through ClearPass Guest: materials, promotions, campaigns, spaces, and
pages.

Materials
A material is the individual advertisement you deliver — the ad the user sees. You can deliver ads through Web
browsers, email, and SMS. The "type" of an advertising material can be a text, image, Flash, raw HTML, YouTube,
or SMS text advertisement. Materials can also be assigned any number of labels, which can be used by
promotions to create labeled promotions and to provide intelligent delivery.

Promotions
Most of the rules for how and when advertisements are delivered and what materials should be included are
defined in a promotion. These rules are applied to all of the advertising materials that the promotion includes,
whether those materials are included directly or indirectly.

A promotion can include both materials and/or other promotions. You can use this feature to build simple
groupings of materials with simple rules or more complex groupings of materials and promotions with more
complex rules.

Promotions can be enabled and disabled, and have a start date and an end date. They can also be assigned any
number of labels. Promotions can include materials and/or other promotions using a fixed, rotating, weighted,
or labeled content selection type.
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Promotions can also be configured to use intelligent delivery, which uses labels to match relevant advertising to
users.

Materials and promotions are then organized into advertising campaigns that run over a specified date range
and with a specified priority (rank and weight).

Campaigns
An advertising campaign is the strategy by which you organize the presentation of your ads. It defines which
promotions and materials to deliver, and when they should be delivered. You can rank and weight a campaign
to balance it against other campaigns. A campaign can also be configured for presentation between a specified
start date and end date.

Spaces
Spaces are the areas of a page that are defined for advertising content. Spaces use simple rules to select
advertisements with the appropriate size, number, and format of materials. The space determines what types
of materials can be shown (images, text ads, SMS ads) and, in the case of images, any size constraints on the
size of the ad. For example, size constraints on a ‘top’ space would normally ensure that only wide but short
images are displayed, whereas the constraints on a ‘right’ space would often allow any type of ad but require
that the ad be narrower (e.g. 320 pixels wide).

Pages
Finally, for each ClearPass Guest page or group of pages, you can specify the advertising spaces you want to
make active and the campaigns and materials to present on them. Advertising can be placed on login,
registration, receipt, and self-service pages, and email and SMS receipts.

Advertising Services Process Overview
To use advertising services:

1. Enable the Advertising Services option for each Web login or guest self-registration page that is to display
advertising. This option is enabled in either Web Logins or Guest Self-Registration configuration.

2. Add fields for gathering demographic information to Guest self-registration forms.

3. Create the materials and upload them to ClearPass Guest.

4. Create a promotion.

5. Create a campaign.

6. Enable at least one space.

7. For each page or group of pages, specify which campaigns and spaces can be presented.

8. Fine-tune campaign delivery to ensure the best user experience.

About the Tutorial
ClearPass Guest provides a Getting Started tutorial to help you become familiar with Advertising Services
concepts and procedures. You can refer to the tutorial at any time.

To view the tutorial, go to Configuration > Advertising > Start Here and click the Getting Started link. The
first page of the tutorial window opens.
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Figure 358 The Advertising Services Getting Started Tutorial

Topics in the tutorial cover how to create materials, promotions, and campaigns and configure spaces. You can
view the finished product of the practice exercises. Tips are provided on how to troubleshoot the different
stages of the process.

Navigating the Tutorial

To Do This: Use These Controls:

Move through the
tutorial sequentially

Click the Continue link in the bottom right corner next to the count of completed tasks.

Move one page
forward or
backward

Use the right and left arrows in the top left corner.

Jump to any section
of the tutorial

Use the navigation links on the right side.

See additional
navigation options

Click the More Options link in the upper right corner. The navigation menu expands to
include the Getting Started, Restart Tutorial, and Quit Tutorial links.

Go back to the
beginning

Click the More Options link in the upper right corner, and then click the Restart Tutorial
link. You will be asked to confirm, and are returned to the Getting Started page.

Exit the tutorial at
any time

Click the More Options link in the upper right corner, and then click the Quit Tutorial link.

Table 217: Tutorial Navigation Elements

After you open the tutorial window, it remains open on your screen as you navigate through the application.
This lets you refer to it and to related areas of the application at the same time. To close the tutorial window,
click the Quit Tutorial link.
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Advertising Pages

The Advertising Pages form lists the Guest Manager areas whose pages can be used for advertising, and
provides access to advertising configuration for them. In ClearPass Guest, these pages include login,
registration, receipt and self-service pages, and email and SMS receipts.

To work with the advertising settings for a Guest Manager page group or page, go to Configuration >
Advertising > Pages. The Advertising Pages list view opens.

Figure 359 The Advertising Pages List View

Columns show the page group, the type of page, and the number of child pages in that group. For example, the
Guest Management page group has four child pages and the Guest Self-Registration page group has eight child
pages, as shown in the following table.

Page Group Child Pages

Guest Management Web Receipts
Download Receipt
Email Receipts
SMS Receipts

Guest Self-Registration Registration Page
Receipt Page
Receipt Download
Receipt Email
Login Page
Login Message
Receipt SMS
Self-Service :Portal

Table 218: Page Groups and Child Pages
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You can click a page group in the Advertising Pages list for additional options:

Field Description

Edit Edit the advertising settings for any of the pages in the Guest Management or Self-Registrations page
groups. See "Editing Advertising Pages" on page 486.

Go To Opens the corresponding area of the ClearPass Guest application:
l For guest management, opens the Start page of the Guest Manager module.
l For Self-Registrations, opens the Customize Self-Registration edit diagram.

Launch For Self-Registrations, opens the self-registration login page in a new tab.

Table 219: Advertising Pages List

Editing Advertising Pages
In ClearPass Guest, advertising can be placed on registration pages, receipt and self-service pages, and email
and SMS receipts. For each of these pages, you can specify whether or not advertising will be delivered, the
advertising spaces that will be used, and the campaigns to present on the page. These settings can be applied
to all pages in a page group, or can be overridden for single pages in the group.

Advertising Services must be enabled for each Web login or guest self-registration page that is to display advertising.
To enable this option, go to either Configuration > Pages > Web Logins or Configuration > Pages > Guest Self-
Registration > Master Enable and select the Advertising Services check box.

To edit advertising settings for a page group or page, go to Configuration > Advertising > Pages, and then
click the Edit link for a page group. The Edit Page form opens.

Figure 360 The Edit Page Form

In the General Properties area of the form, select either the page group or page and configure the basic
properties.
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If you leave the Edit Page form set to the parent page, your edits will apply to the parent page of the group and to all
the child pages in the group. To override these settings for a child page, you must click Show Children, and then
click the Page advertising settings link for the child page.

Field Description

Page The page group being edited. The page group name is a link to the corresponding area of the
application:
l The Guest Management link opens the Start page of the Guest Manager module.
l The Guest Self-Registration link opens the Customize Self-Registration edit diagram.

Parent
Page

Indicates the page's parent page, if there is one. This field only contains links when you are editing a
child page:
l Launch page — Opens the parent page.
l Page advertising settings — Lets you configure advertising for the parent page.

Child
Pages

Indicates the page's child pages, if there are any. This field only contains links when you are editing a
parent page.
l Show Children — Displays the list of child pages.
l Page advertising settings — Lets you configure advertising services for a specific child page.
l You can click a child page's name to go to the Customize Self-Registration form for that child

page.

Advertising
Enabled

Specifies whether the page is enabled or disabled for advertising.
l Use default setting (Enable advertising on this page) — Enables advertising on this page and

on its child pages. Available for page group only.
l Use parent setting — Ensures that advertising on this child page is only enabled if advertising is

enabled for the parent page. Available for child pages only. Default setting for a child page.
l Disable advertising on this page — Disables advertising on this page. If this is a parent page,

disables advertising for all child pages that are configured to "Use parent setting".
l Enable advertising on this page — Enables advertising on this page. If this is a parent page,

enables advertising for all child pages that are configured to "Use parent setting".

Description Optional comments or notes about the page.

Table 220: General Properties, Edit Page

Figure 361 The Edit Page Form, Space Options Area
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In the Space Options area of the form, set the options that control which advertising spaces can be shown on
this page. The final set of advertising spaces that is used is determined by first applying the Allowed Spaces
policy, and then applying the Denied Spaces policy.

Field Description

Allowed Spaces Policy Specifies which spaces to use. Options include:
l Use default setting (Allow advertising in all spaces) — Allows advertising in all

enabled and applicable advertising spaces. Available for page group only.
l Allow advertising in... — The form expands to include the Allowed Spaces row.

Available for page group only.
l Use parent spaces — Allows advertising in the list of spaces defined by the parent

page's space options (determined by applying the Allowed Spaces Policy followed
by the Denied Spaces Policy). Available for child pages only.

l Use parent spaces, but also allow advertising in... — The form expands to
include the Allowed Spaces row. Additional spaces you select are added to the list
of spaces defined by the parent page's space options (determined by applying the
Allowed Spaces Policy followed by the Denied Spaces Policy). Available for child
pages only.

l Allow advertising in all spaces — Allows advertising in all enabled and applicable
spaces.

The Denied Spaces Policy is applied after this field, so the final list of spaces that is
used might be less than what is allowed here.

Allowed Spaces If Use parent spaces, but also allow advertising in is selected in the Allowed
Spaces Policy, use the controls in this field to add and sort spaces. Any advertising
space you specify in this field will be added to the list of spaces used to deliver
advertisements. (To be displayed, spaces must also be enabled)
Suggestion: You can use this field at the page group level to specify a small number of
allowed spaces, and then at the child page level to add extra spaces as needed,

Denied Spaces Policy Specifies whether to deny advertising in any spaces. Options include:
l No change — Leaves the list of spaces allowed by the Allowed Spaces Policy

unchanged.
l Deny advertising in... — The form expands to include the Denied Spaces row.
l Deny advertising in all spaces — Denies advertising in all spaces for this page.

Denied Spaces Specifies the denied spaces.
Suggestion: You can also use this field to specify an exception to an "Allow advertising
in all spaces" setting.

Preview Displays a preview of the form showing your changes. To review the chosen set of
advertising spaces, click the Save and Reload button and then expand this Preview
list.

Table 221: Space Options, Edit Page
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Figure 362 The Edit Page Form, Campaign Options Area

In the Campaign Options area of the form, set the options that control which campaigns can deliver
advertising on this page. The final set of advertising campaigns that is used is determined by first applying the
Allowed Campaigns Policy, and then applying the Denied Campaigns Policy.
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Field Description

Allowed Campaigns Policy Specifies which campaigns to use. Options include:
l Use default setting (Allow advertising from all campaigns) — Allows

advertising from all enabled and applicable campaigns. Available for page
group only.

l Allow advertising from... — The form expands to include the Allowed
Campaigns row. Available for page group only.

l Allow advertising from all campaigns — Allows advertising from all enabled
and applicable advertising campaigns.

l Use parent campaigns — Allows advertising from the list of campaigns defined
by the parent page's campaign options (determined by applying the Allowed
Campaigns Policy followed by the Denied Campaigns Policy). Available for
child pages only.

l Use parent campaigns, but also allow advertising from... — The form
expands to include the Allowed Campaigns row. Additional campaigns you
select are added to the list of campaigns defined by the parent page's campaign
options (determined by applying the Allowed Campaigns Policy followed by
the Denied Campaigns Policy). Available for child pages only.

The Denied Campaigns Policy is applied after this field, so the final list of
campaigns that is used might be less than what is allowed here.

Allowed Campaigns If Use parent campaigns, but also allow advertising from... is selected, use the
controls in this field to add and sort campaigns. (To display ads, campaigns must
also be enabled)
Suggestion: You can use this field at the page group level to specify a small number
of allowed campaigns, and then at the child page level to add extra campaigns as
needed,

Denied Campaigns Policy Specifies whether to deny advertising in any campaigns. Options include:
l No change — Leaves the list of campaigns allowed by the Allowed Campaigns

Policy unchanged.
l Deny advertising from... — The form expands to include the Denied

Campaigns row.
l Deny advertising from all campaigns — Denies advertising from all

campaigns for this page.
Suggestion: You can also use this field to specify an exception to an "Allow
advertising from all campaigns" setting.

Denied Campaigns If Deny advertising from... is selected, use the controls in this field to specify the
denied campaigns.

Preview Displays a preview of the form showing your changes. To review the chosen set of
advertising campaigns, click the Save and Reload button and then expand this
Preview list.

Table 222: Campaign Options, Edit Page

The nwa_adspace Smarty Template Tag

For details about Smarty Template syntax and HTML, see "Smarty Template Syntax" on page 713 of the
Reference chapter.

The nwa_adspace Smarty Template tag is for advanced users. You need to understand HTML and Smarty
Templates in order to use it correctly.

The nwa_adspace tag can be placed into HTML fields that:
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l Support Smarty Template evaluation

l Belong to pages that support advertising

The nwa_adspace tag supports the following parameters:

l location

l name

l media

l stage

l container

l style

location

The value of the Location field that must be set for an advertising space to be matched by location. The
Location field and the Other Location field are configured on the Edit Space form (see "Creating and Editing
Advertising Spaces" on page 495).

You must specify either a location or a name. The nwa_adspace tag will give an error if you do not specify at
least one of these parameters.

if a location parameter is specified, then the value of the location parameter will be compared to the
Location field of each advertising space. If the values match, then advertisements will be delivered at the point
in the HTML where the nwa_adspace tag is defined, and according to any constraints defined by the advertising
space.

To see which Location value a space uses, review the Location column in the Advertising Spaces list
view ("Advertising Spaces" on page 493).

Advertising spaces support a number of preset location options as well as custom locations via the Other
Location field. The following parameters are supported for the location parameter:

Value Description

N/A None—for manually-positioned spaces

web_top Page Top—above content

web_left Page Left—to the left of content

web_bottom Page Bottom—below content

web_right Page Right—to the right of content

web_interstitial Page Interstitial—briefly replaces content

Table 223: Values for the location Parameter
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Value Description

sms_top SMS Top—above content

sms_bottom SMS Bottom—below content

Use Other Location Other—for user-defined locations

name

The value of the Name field that must be set for an advertising space to be matched by name.

You must specify either a location or a name. The nwa_adspace tag will give an error if you do not specify at
least one of these parameters.

if a name parameter is specified, then the value of the name parameter will be compared to the Name field of
each advertising space. If the values match, then advertisements will be delivered at the point in the HTML
where the nwa_adspace tag is defined, and according to any constraints defined by the advertising space.

media

The type of media that advertisements are being delivered to.

You must specify a media value. The nwa_adspace tag will give an error if you do not specify this parameter.

The media parameter must be set correctly for the context in which the nwa_adspace tag will be processed. The
following values are supported for the media parameter:

Value Description

sms Specify this value to deliver SMS advertisements only.

web Specify this value to deliver Web and Email
advertisements only.

Table 224: Values for the media Parameter

stage

The value of the Stage field that must be set for an advertising campaign to be matched.

You must specify a stage value. The nwa_adspace tag will be unable to match any advertising campaigns if you
do not specify this parameter.

The stage parameter is used when processing advertising campaigns. Only the promotions or materials
specified at the corresponding stage of the advertising campaign will be delivered. The following values are
supported for the stage parameter:
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Value Description

web_login Specify this value to deliver advertising on a login page
(landing page).

web_registration Specify this value to deliver advertising on a guest self-
registration page.

web_receipt Specify this value to deliver advertising on a receipt
page.

web_self_service Specify this value to deliver advertising on a guest self-
service page.

web_after_login Specify this value to deliver advertising on a login
message page (post-login page).

sms_receipt Specify this value to deliver advertising on an SMS
receipt.

Table 225: Values for the stage Parameter

container

The name of the HTML element tag in which advertisements will be placed.

The nwa_adspace Smarty Template tag is for advanced users. You need to understand HTML and Smarty
Templates in order to use it correctly.

When advertisements are to be delivered to a Web page or an email, they can be grouped and their layout
controlled more effectively by placing them in a container. Typically, a DIV container would be used, but other
valid HTML tags can be specified.

If the container parameter is not specified, then advertisements are delivered to the Web page or email without
any extra grouping.

style

The style attribute of the HTML container element.

This parameter is only relevant when the media parameter is set to web and an HTML tag name has
been specified for the container parameter.

If you specify a container, you can use the style parameter to specify style attributes for the container. The
style parameter is optional.

Advertising Spaces

Spaces are the areas of a page that are defined for advertising content. The Advertising Spaces list shows
and describes the spaces that are currently defined on each type of page, differentiated by device. Descriptions
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include typical uses of the space. Several built-in spaces are available. You can also create new custom
advertising spaces.

To work with the settings for advertising spaces, go to Configuration > Advertising > Spaces. The
Advertising Spaces list view opens.

Figure 363 The Advertising Spaces List View

All advertising spaces that have been created are included in this list. You can click a space's row in the list for
additional options.

Field Description

Edit Edit any of the space's properties. See "Creating and Editing Advertising
Spaces" on page 495.

Delete Deletes a custom space. You will be asked to confirm the deletion. Not available
for built-in spaces.

Enable Enable the space so advertising will be displayed in it.
Before advertising will be delivered in an enabled space on a specific page, the
page's settings also need to allow advertising in the space.

Table 226: Advertising Spaces List
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Field Description

Disable To make advertising inactive again for an enabled space, click the Disable link.

Duplicate Make a copy of the space configuration to use as a basis for a new
configuration.
Suggestion: If you want to have multiple advertising spaces in the same
location—for example, one for images and one just for text—creating a copy of
a space and making slight changes to it might be the simplest way.

Create new advertising space Create a new custom advertising space.

Creating and Editing Advertising Spaces
Spaces define the areas of a page that can display advertising content. Spaces use simple rules to select
advertisements with the appropriate size, number, and format of materials. The space determines what types
of materials can be shown (images, text ads, SMS ads) and, in the case of images, any size constraints on the
size of the ad. For example, size constraints on a ‘top’ space would normally ensure that only wide but short
images are displayed, whereas the constraints on a ‘right’ space would often allow any type of ad but require
that the ad be narrower (e.g. 320 pixels wide).

Each space is configured to deliver advertisements in a particular location on a page, such as the top, bottom,
left, or right. There is also what is called an "interstitial location": Instead of being displayed in an area of a page,
interstitial ads replace the main content of a page for a brief time. For example, after a user logs in, an
interstitial ad might be displayed for a moment before the main page content is displayed.

Each space is also given a rank. A rank of 1 is given higher preference than a rank of 2. The relative ranks you
assign to spaces ensure they are displayed in the order you want. For example, if you have two spaces defined
to be in the same location, the space you give a rank of 1 will be placed above the space that has a rank of 2.

The built-in advertising spaces are created automatically by the Advertising Services plugin. Most properties
of a built-in space can be edited. You can also create new custom advertising spaces.

l To edit advertising settings for either a built-in or custom space, go to Configuration > Advertising >
Spaces, and then click the Edit link for a space. The Edit Space form opens.

l To create a new custom advertising space, click the Create new advertising space link in the upper-right
corner. The Create Space form opens.

The Edit Space and Create Space forms are identical, and are described below.
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Figure 364 The Edit Space Form, General Properties Area

In the General Properties area of the form, set the basic properties for the space:

Field Description

Name (Required) Name that clearly identifies this space. For a built-in space, this cannot be edited.

Enabled If selected, allows advertising to be shown in this space. If this check box is not selected, the
space will not show any advertisements.
Before advertising will be delivered in an enabled space on a specific page, the page's settings
also need to allow advertising in the space.

Rank (Required) Applies a relative rank to the space. A rank of 1 is given higher preference than a
rank of 2.

Table 227: General Properties, Edit Space
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Field Description

Description Optional comments or notes about this advertising space.

Location Describes position of the space on the page. For a built-in space, this cannot be edited. For
custom spaces, options include:
l None - for manually positioned spaces — Select this option if you will use the nwa_

adspace Smarty Template tag, and to only specify the name parameter, not the
location parameter. For more information, see "The nwa_adspace Smarty Template
Tag" on page 490.

l Page Top - above content — The space will deliver advertisements above the main content
of a Web page.

l Page Left - to the left of content — The space will deliver advertisements to the left of the
main content of a Web page.

l Page Bottom - below content — The space will deliver advertisements below the main
content of a Web page.

l Page Right - to the right of content — The space will deliver advertisements to the right
of the main content of a Web page.

l Page Interstitial - briefly replaces content — The space will deliver advertisements that
will briefly replace the main content of a Web page.

l SMS Top - above content — The space will deliver advertisements above the main content
of an SMS message.

l SMS Bottom - below content — The space will deliver advertisements below the main
content of an SMS message.

l Other - for user defined locations — Select this option if you will use the nwa_adspace
Smarty Template tag to define a custom location by specifying the location parameter,
not the name parameter. For more information, see "The nwa_adspace Smarty Template
Tag" on page 490. If you select this option, the Other Location field is added to the form.

Other Location If you selected Other - for user-defined locations in the Location field, use this field to
define a name for a custom location. The custom location can then be referenced in any
Smarty Template by using the nwa-adspace Smarty Template tag.

"Other Location" Example

If you wanted to add a custom advertising space that is positioned on the far-right edge of the registration
page, you could do it as shown in the following example:

1. Choose Other - for user defined locations in the Location field.

2. In the Other Location field, create the name custom_right.

3. In a guest self-registration page, edit the Footer HTML to include an nwa_adspace Smarty Template tag as
follows:
{nwa_adspace media="web"

location="custom_right"

stage="web_registration"

container="div"

style="position:absolute; left:839px; top:92px; width:320px; margin:20px 0 0 20px;"}

For more information, see "The nwa_adspace Smarty Template Tag" on page 490.
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Figure 365 The Edit Space Form, Geometry Area

In the Geometry area of the form, set the options that control the width and height of the space.

Some devices, such as desktop computers and laptops, have a large screen. Other devices, such as smart
phones, have a small screen. Although it is possible to deliver large advertisements to small screens, it does not
provide the best user experience. Geometry constraints let you configure an advertising space to be only
displayed on a large screen or only displayed on a small screen. Typically, the width and height constraints
would also be set to values that are appropriate for the selected screen type.

The screen type is detected by looking at the browser's User Agent value. Laptops, desktops, and devices like the
iPad are treated as large-screen devices. Smart phones and other mobile devices are treated as small-screen
devices.

While we endeavor to correctly detect the screen type for as many devices as possible, we are unable to test every
possible device, so we do not claim detection to be correct for all devices.
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Field Description

Screen Types Limits the types of screen that will show this space. This setting only applies to Web
advertising. Options include:
l All Screens — show on both small and large screens — Ignores the detected screen

type.
l Small Screens — show on small screens only (phones; mobile devices) — This

space will only be shown if the user's device is detected to be a small-screen device.
l Large Screens — show on large screens only (laptops, desktops) — This space will

only be shown if the user's device is detected to be a large-screen device.

Minimum Width Optimum minimum width in pixels for advertising materials shown in this space. If an
advertisement has a size (for example, a Flash or YouTube ad), the width of that
advertisement must be at least as large as this minimum width if it is to be shown in this
space. If you do not want to have a minimum width constraint, leave this field blank.

Maximum Width Optimum maximum width in pixels for advertising materials shown in this space. If an
advertisement has a size (for example, a Flash or YouTube ad), the width of that
advertisement must be no larger than this maximum width if it is to be shown in this space. If
you do not want to have a maximum width constraint, leave this field blank.
Best Practice: Because an advertising space also has padding, it is best to set the maximum
width constraint to be 20 pixels wider than the widest image that will be displayed in this
space.

Width Minimum and/or maximum width in pixels for this space.

Minimum Height Optimum minimum height in pixels for advertising materials shown in this space. If an
advertisement has a size (for example, a Flash or YouTube ad), the height of that
advertisement must be at least as large as this minimum height if it is to be shown in this
space. If you do not want to have a minimum height constraint, leave this field blank.

Maximum Height Optimum maximum height in pixels for advertising materials shown in this space. If an
advertisement has a size (for example, a Flash or YouTube ad), the height of that
advertisement must be no larger than this maximum height if it is to be shown in this space.
If you do not want to have a maximum height constraint, leave this field blank.
Best Practice: Because an advertising space also has padding, it is best to set the maximum
height constraint to be 20 pixels wider than the tallest image that will be displayed in this
space.

Height Minimum and/or maximum height in pixels for this space.

Maximum Rows Maximum number of rows of advertisements to show in this space. A space can show
multiple rows of ads, up to the maximum number of rows specified here. However, if a
maximum height was specified, the system will only output as many rows as will fit within the
maximum height constraint for the space.

Maximum
Columns

Maximum number of columns of advertisements to show in this space. A space can show
multiple columns of ads, up to the maximum number of columns specified (there is always at
least one column). However, if a maximum width was specified, the system will only output
as many columns as will fit within the maximum width constraint for the space.

Table 228: Geometry Options, Edit Space

"Maximum Height" Example
If a maximum height was specified, the system will only output as many rows as will fit within the maximum
height constraint for the space. For example, with a maximum height constraint of 100 and a maximum rows
constraint of 3, the system could output any of the following:

l Three rows with heights 40, 40, and 20
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l Three rows with heights 30, 30, and 30

l Two rows with heights 60 and 40

l Two rows with heights 50 and 50

l One row of height 80

l One row of height 100

"Maximum Width" Example
If a maximum width was specified, the system will only output as many columns as will fit within the maximum
width constraint for the space. For example, with a maximum width constraint of 100 and a maximum
columns constraint of 3, the system could output any of the following:

l Three columns with widths 40, 40, and 20

l Three columns with widths 30, 30, and 30

l Two columns with widths 60 and 40

l Two columns with widths 50 and 50

l One columns of widths 80

l One columns of widths 100

Figure 366 The Edit Space Form, Promotional Material Constraints Area

In the Promotional Material Constraints area of the form, set the options that control what can and cannot
be shown in the advertising space:

Field Description

Allowed Material The types of promotional material that should be allowed in this space. Types included are:
l Flash advertisement [Web]
l HTML code (advanced) [Web]
l Image advertisement [Web]
l Text advertisement [Web]
l YouTube video advertisement [Web]
l Text advertisement [SMS]

Table 229: Promotional Material Constraints, Edit Space
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When you have completed your entries on this form: 

l If you are creating a new space, click Create to create the new space and return to the Advertising Spaces
list, or click Create and Reload to create the new space and reload the Edit Space form.

l If you are editing an existing space, click Save to save your changes and return to the Advertising Spaces
list, or click Save and Reload to save your changes and reload the Edit Space form.

Advertising Campaigns

An advertising campaign is the strategy by which you organize the presentation of your ads. It defines which
promotions and materials to deliver, and when they should be delivered.

The system requires at least one advertising campaign to be configured and enabled for any advertisements to be
delivered.

To create and work with advertising campaigns, go to Configuration > Advertising > Campaigns. The
Advertising Campaigns list view opens.

Figure 367 The Advertising Campaigns List View

All advertising campaigns that have been created are included in this list. You can click a campaign's row in the
list for additional options.

Field Description

Edit Edit any of the campaign's properties. See "Creating and Editing Advertising Campaigns" on
page 502.

Delete Delete the campaign from the system. You will be asked to confirm the deletion.

Enable Enable the advertising campaign so it will provide advertisements.
Before advertising will be delivered from an enabled campaign on a specific page, the page's
settings also need to allow advertising from the campaign.

Disable Disable the campaign. To make the campaign active again, click the Enable link.

Duplicate Make a copy of the campaign's settings to use as a basis for a new campaign.

Create new
advertising
campaign

Create a new advertising campaign.

Table 230: Advertising Campaigns List
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Creating and Editing Advertising Campaigns
An advertising campaign is the strategy by which you organize the presentation of your ads. It defines which
promotions and materials to deliver, and at which stages they should be delivered. You can rank and weight a
campaign to balance it against other campaigns. A campaign can also be configured for presentation between a
specified start date and end date.

Campaigns can be delivered at the following stages:

l On the login page

l On the registration page

l On the registration receipt

l On the self-service portal pages

l Immediately after login

l On the SMS registration receipt

You can edit advertising campaigns, and you can create new advertising campaigns.

l To edit an advertising campaign, go to Configuration > Advertising > Campaigns, and then click the Edit
link for a campaign in the list. The Edit Campaign form opens.

l To create a new advertising campaign, click the Create new advertising campaign link in the upper-right
corner. The Create Campaign form opens.

The Edit Campaign and Create Campaign forms are identical, and are described below.

Figure 368 The Edit Campaign Form, General Properties Area
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In the General Properties area of the form, set the basic properties for the campaign:

Field Description

Name (Required) Name that clearly identifies this campaign.

Enabled If selected, allows promotions from this campaign to be delivered. If this check box is not selected,
no ads will be provided from this campaign.
Before advertising will be delivered from a campaign to a specific page, the page's settings also
need to allow advertising from the campaign.

Start Date (Optional) Date and time on which this campaign will begin. To start delivering this campaign
immediately, leave this field blank.
Click the button to open the calendar picker. In the calendar, use the arrows to select the year and
month, click the numbers in the Time fields to increment the hours and minutes, and then click a day
to select the date.

End Date (Optional) Date and time after which the campaign will no longer be delivered. To deliver this
campaign indefinitely, leave this field blank.
Click the button to open the calendar picker. In the calendar, use the arrows to select the year and
month, click the numbers in the Time fields to increment the hours and minutes, and then click a day
to select the date.

Rank (Required) Applies a relative rank to the campaign, which defines the order in which campaigns are
processed when delivering ads. A rank of 1 is higher than a rank of 2. For information about
campaign ranks, see "Campaign Rank and Weight" on page 504.

Weight (Required) Applies a weight to a campaign. If two campaigns have equal rank, one with a greater
weight will be displayed more than the other. For information about campaign weights, see
"Campaign Rank and Weight" on page 504.

Description Optional comments or notes about the campaign.

Table 231: General Properties, Edit Campaign

At the time ads are delivered on your pages, the system processes the information in the General Properties
area in the following order:

1. Verifies which campaigns are enabled and ignores ones that are not.

2. Checks for start dates that are less than or equal to "now" and ignores campaigns that are not scheduled to
start yet.

3. Checks for end dates that are greater than "now" and ignores campaigns whose end date is past.

4. Checks the rank of each remaining campaign. Includes only the highest ranked campaign, or multiple
campaigns that have the same highest rank.

5. If there are multiple campaigns, checks the weight of each remaining campaign.
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Figure 369 The Edit Campaign Form, Web Promotions Delivery and SMS Promotions Delivery Areas

In the Web Promotions Delivery area of the form, set the options that define when the campaign's Web
promotions are delivered. Use the SMS Promotions Delivery area to set when the campaign's SMS
promotions are delivered.

The drop-down lists in the Web Promotions area also allow you to select a material instead of a promotion.
This usage is rare, though, as it would display only a single static item.

Field Description

With Login Specifies the promotion to deliver on the landing page (login page). To not display ads at this
stage, select None.

With
Registration

Specifies the promotion to deliver on the registration page. To not display ads at this stage,
select None.

With Receipt Specifies the promotion to deliver on the registration receipt. To not display ads at this stage,
select None.

With Self-
Service

Specifies the promotion to deliver on the self-service portal pages. To not display ads at this
stage, select None.

After Login Specifies the promotion to deliver when the user has logged in. To not display ads at this stage,
select None.

With Receipt Specifies the promotion to deliver on the SMS registration receipt. To not display ads at this
stage, select None.

Table 232: Web Promotions Delivery, Edit Campaign

Campaign Rank and Weight

Each advertising campaign must be assigned a rank and weight. These numbers let you balance how campaigns
are chosen relative to each other.

l Rank—This number determines which of the available campaigns will be used. A lower number has a higher
rank or priority, so a rank of 1 takes priority over a rank of 2. When the available campaigns are compared,
the campaign with the highest rank (for example, rank = 1) is used and the other campaigns are ignored. To
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use multiple campaigns at the same time, they must have the same rank; they will be dropped if they have a
lower rank.

l Weight—When multiple campaigns of equal rank are used, the weight determines how often each
campaign's ads should be displayed relative to ads from the other campaigns.

Suppose you have multiple advertising campaigns that are defined to provide ads at the same time and stage.
You can modify the rank to ensure that ads are displayed from the campaigns in the order you want. You can
modify theweight to ensure that, on average, more ads are displayed from campaigns with higher weight. The
frequency of display is determined by the ratio of each weight to the total weights.

n Example: Assume two campaigns of equal rank. If campaign A has a weight of 10, and campaign B has a
weight of 5, campaign A's ads will be shown twice as often as campaign B's ads. To look at this another
way, 10 + 5 = 15, and campaign A's ads will be shown, on average, 10 out of every 15 times.

n Example: Assume three campaigns of equal rank. Campaign A has a weight of 2, campaign B has a weight
of 3, and campaign C has a weight of 5. These numbers add up to 10, so on average, campaign A will be
shown 2 out of every 10 times, campaign B would be shown 3 out of every 10 times, and campaign C
would be shown 5 out of every 10 times.

Ranks and weights are assigned to campaigns when they are created or edited. See "Creating and Editing
Advertising Campaigns" on page 502.

Advertising Promotions

Promotions define rules for how and when advertisements are delivered and what materials should be
included. Promotions can also be configured to use intelligent delivery, presenting relevant advertising to
users.

To create and work with advertising promotions, go to Configuration > Advertising > Promotions. The
Advertising Promotions list view opens.

Figure 370 The Advertising Promotions List View

All advertising promotions that have been created are included in this list. You can click a promotion's row in
the list for additional options.
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Field Description

Edit Lets you edit any of the promotion's properties. See "Creating and Editing
Advertising Promotions" on page 506.

Delete Deletes the promotion from the system. You will be asked to confirm the
deletion.

Enable Enables the promotion so it will provide advertisements.

Disable Disables the promotion. To make the promotion active again, click the
Enable link.

Duplicate Makes a copy of the promotion's settings to use as a basis for a new
promotion.

Create new advertising
promotion

Lets you create a new advertising promotion.

Table 233: Advertising Promotions List

Creating and Editing Advertising Promotions
Most of the rules for how and when advertisements are delivered and what materials should be included are
defined in a promotion. These rules are applied to all of the advertising materials that the promotion includes,
whether those materials are included directly or indirectly.

A promotion can include both materials and/or other promotions. You can use this feature to build simple
groupings of materials with simple rules, or more complex groupings of materials and promotions with more
complex rules.

Promotions can be enabled and disabled, and have a start date and an end date. They can also be assigned any
number of labels. Promotions can include materials and/or other promotions using a fixed, rotating, weighted,
or labeled content selection type. Promotions can also be configured to use intelligent delivery, which uses
labels to match relevant advertising to users.

You can edit advertising promotions, and you can create new advertising promotions.

l To edit an advertising promotion, go to Configuration > Advertising > Promotions, and then click the
Edit link for a promotion in the list. The Edit Promotion form opens.

l To create a new advertising promotion, click the Create new advertising promotion link in the upper-
right corner. The Create Promotion form opens.
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The Edit Promotion and Create Promotion forms are identical, and are described below.

Figure 371 The Edit Promotion Form, General Properties Area

In the General Properties area of the form, set the basic properties for the promotion:

Field Description

Name (Required) Name that clearly identifies this promotion.

Enabled If selected, allows this promotional to deliver ads. If this check box is not selected, no ads will be
provided by this promotion.

Start Date Date and time when the promotion can start providing ads. To have this promotion start providing
ads immediately, leave this field blank.
Click the button to open the calendar picker. In the calendar, use the arrows to select the year and
month, click the numbers in the Time fields to increment the hours and minutes, then click a day to
select the date.

End Date Date and time after which the promotion will no longer provide ads. To have this promotion deliver
ads indefinitely, leave this field blank.
Click the button to open the calendar picker. In the calendar, use the arrows to select the year and
month, click the numbers in the Time fields to increment the hours and minutes, and then click a day
to select the date.

Table 234: General Properties, Edit Promotion
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Field Description

Description Optional comments or notes about this promotional material.

Labels To apply labels to this promotion, enter the labels in this field. To create new labels, enter the new
label names separated by commas or new lines. The system creates each new label as a "tag". If
some labels were already created, clicking in this field displays a list of the existing label tags to
choose from.
If you include labels here, other promotions will detect this promotion as labeled content.
Labels are used to include or exclude this promotion when creating another higher-level labeled-
content promotion. When processing intelligent delivery rules, labels are applied to all materials that
are included, either directly or indirectly, by this promotion. For more information, see "Using Labels
in Advertising Services" on page 510.

Type (Required) The type of content. Options include:
l Rotating content
l Fixed content
l Weighted content
l Labeled content
When you make a selection here, the name of the next area of the form changes to match and
includes the appropriate options.

Figure 372 The Edit Promotions Form, Rotating Content Area

Depending on the selection in the Type field, the next area of the form will be either Rotating Content,
Weighted Content, Fixed Content, or Labeled Content. In this area, set the options that control the
content of the promotion.
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Field Description

Content For fixed content, select a single content item for the promotion.

Content Items (Required) For rotating or weighted content, all items in this list are initially selected. Click an
item's row to access controls for removing items or changing their order.

Content Types (Labeled content) Types of content to include in this promotion. Options include:
l All content types
l Materials only
l Promotions only

Inclusion Mode (Labeled content) How the list of inclusive labels is matched to the available content. Options
include:
l All of the "inclusive labels" must match
l At least one of the "inclusive labels" must match

Inclusive Labels (Labeled content) Enter inclusive labels, separated by commas or new lines. Content must
match these labels to be included in the promotion. (Refer to the Defined Labels field in the
Intelligence area of the form)

Exclusion Mode (Labeled content) How the list of exclusive labels is matched to the available content. Options
include:
l All of the "exclusive labels" must match
l At least one of the "exclusive labels" must match

Exclusive Labels (Labeled content) Enter exclusive labels, separated by commas or new lines. Content is
excluded from the promotion if it matches these labels. (Refer to the Defined Labels field in
the Intelligence area of the form)

Selected Content List of the content selected on this form. After making changes to the content selection, click
the Save and Reload button to refresh this list.

Table 235: Rotating, Fixed, Weighted, or Labeled Content, Edit Promotion
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Figure 373 The Edit Promotions Form, Intelligence Area

In the Intelligence area of the form, set the options that control intelligent delivery of content for the
promotion:

Field Description

Enabled If selected, allows a more selective delivery by matching user labels to material labels.
(Material also inherits labels from the promotions that include it)

Requirement
Levels

How often the specified labels should be matched. These settings override the Default Level in
the next field.
Use the controls to select label groups and a requirement level for each one.

Default Level How often all other labels should be matched (applies to labels not selected in the
Requirement Levels field).

Defined Labels List of currently-defined user labels.

Table 236: Intelligence Options, Edit Promotion

Using Labels in Advertising Services

A label identifies a user attribute or category. In Advertising Services, you can add intelligent delivery to your
campaigns by creating labels and applying them to your promotions and materials:

1. Configure your pages to include fields for collecting user information such as gender, age, hobbies, or
product preferences. When a user completes these fields, the attributes are stored in ClearPass (see
"Creating a Custom Field " on page 338).
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2. In the Edit Promotion form, use the Labels field to apply or easily create labels that correspond to the
information-gathering fields you added to your pages (see "Creating and Editing Advertising Promotions" on
page 506).

3. Configure the promotion to use labeled content (promotions, materials, or both), and specify which labels
to include or exclude.

4. Also on the Edit Promotion form, enable the promotion for intelligent delivery. Indicate the percentage of
ads that should match the labels. (For reference, this form provides a list of the labels that have already
been defined in the system.)

5. On the Edit Materials form, you can also use the Labels field to apply existing labels or create new ones
(see "Creating and Editing Advertising Materials" on page 512).

6. After the promotions and materials that include the labels and intelligent delivery configuration are
complete, include them in a campaign (see "Creating and Editing Advertising Campaigns" on page 502).

7. When a user visits the pages while the campaign is running, Advertising Services displays ads with the
labeled content that matches the user's attributes.

When you create labels in the Edit Promotion or Edit Materials forms, they are created as "tags" in the system.
Clicking in a Labels field provides an auto-suggested list of existing tags to choose from. To see a list of Label
tags that have already been created for your advertising campaigns, go to Administration > Plugin
Manager and click the Configuration link for the Advertising Services plugin:

Figure 374 The Advertising Services Plugin Configuration Form

Advertising Materials

A material is the individual advertisement you deliver — the ad the user sees.

To create and work with advertising materials, go to Configuration > Advertising > Materials. The
Advertising Materials list view opens.
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Figure 375 The Advertising Materials List View

All advertising materials that have been created are included in this list. You can click a material's row in the list
for additional options.

Field Description

Edit Lets you edit any of the material's properties. See "Creating and Editing
Advertising Materials" on page 512.

Delete Deletes the material from the system. You will be asked to confirm the
deletion.

Disable Disables the material. To make the material active again, click the Enable
link.

Duplicate Makes a copy of the material's settings to use as a basis for a new material.

Preview The form expands to show a preview of the banner image.

Create new advertising
promotion

Lets you create a new advertising material.

Table 237: Advertising Materials List

Creating and Editing Advertising Materials
An advertising material is the individual advertisement you deliver — the ad the user sees. You can deliver ads
through Web browsers, email, and SMS. The medium of an advertising material can be a text, image, Flash, raw
HTML, YouTube, or SMS text advertisement. Materials can also be assigned any number of labels, which can be
used by promotions to create labeled promotions and to provide intelligent delivery.

You can edit advertising materials, and you can create new advertising materials.

l To edit an advertising material, go to Configuration > Advertising > Materials, and then click the Edit
link for a material in the list. The Edit Promotional Material form opens.
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l To create a new advertising material, click the Create new advertising material link in the upper-right
corner. The Create Promotional Material form opens.

The Edit Promotional Material and Create Promotional Material forms are identical, and are described
below.

Figure 376 The Edit Promotional Material Form, General Properties Area

In the General Properties area of the form, set the basic properties for the material:

Field Description

Name (Required) Name for this material.

Enabled If selected, allows this material to be delivered.

Start Date Date and time on which this campaign will begin. To start delivering this material immediately, leave
this field blank.

End Date Date and time after which the material will no longer be delivered. To deliver this material
indefinitely, leave this field blank.

Table 238: General Properties, Edit Promotional Material
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Field Description

Description Optional comments or notes about the material.

Labels To apply labels to this material, enter the labels in this field. To create new labels, enter the new
label names separated by commas or new lines. The system creates each new label as a "tag". If
some labels were already created, clicking in this field displays a list of the existing label tags to
choose from.
If you include labels here, promotions will detect this material as labeled content.
Labels are used to include or exclude material for a labeled content promotion. Labels are matched
when processing intelligent delivery rules of a promotion that includes this material.

Type (Required) The type of content. Options include:
l Web browser content
l SMS content
When you make a selection here, the name of the next area of the form changes to match and
includes the appropriate options.

Figure 377 The Edit Promotional Materials Form, Web Content Area

Depending on the selection in the Type field, the next area of the form will be either SMS Content or Web
Content. In this area, set the options that control either the content of the SMS text messages promotion, or
the content and formatting of the Web promotion.
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Field Description

Text (SMS content) Enter the message text. To keep messages short, use 80 characters
or fewer.

Format (Web content) (Required) If Web browser content is selected in the Type field,
use this field to select the format of the Web content material. Options include: 
l Flash advertisement
l HTML code (advanced)
l Image advertisement
l Text advertisement
l YouTube video advertisement
When you make a selection here, the rest of the form includes the appropriate
options.

Flash (Flash) The Flash animation file (.swf) of the material. Either select a file that is
already uploaded to Content Manager, or upload a new file. Maximum file upload
size is 15.0 MB.

Template Code (HTML code) To code your own advertisement using raw HTML, enter the HTML
code to display. Smarty template functions can be used. You can also use the drop-
down list to add images or other content items.

Preview (HTML code) Preview of the HTML. The preview is updated when you modify the
contents of the Template Code field.

Hyperlink (Image advertisement; Text advertisement) The destination page URL to which the
advertisement is linked. To not associate a destination URL with the advertisement,
leave this field blank.

Image (Image advertisement) The image file for the advertisement. Either select a file
that is already uploaded to Content Manager, or upload a new file. Maximum file
upload size is 15.0 MB.

Title (Image advertisement; Text advertisement) Specify alternative text for the image.
For a text advertisement, the title is shown as the first line of the ad; if a hyperlink
is also specified, the title is clickable.

Preview (Image advertisement) Preview of the selected advertisement. The preview is
updated as you modify the properties of the advertisement.

Body (Text advertisement) Content for the text advertisement.

Footer (Text advertisement) The last line of a text advertisement. If a hyperlink is also
specified, the footer is clickable

Video ID (YouTube video advertisement) (Required) The YouTube video identifier for the
video to display. This is a unique identifier for a video that has already been
uploaded to YouTube.

Width (YouTube video advertisement) (Required) The desired width in pixels for the
video.

Height (YouTube video advertisement) (Required) The desired height in pixels for the
video.

Edit Global Settings (YouTube video advertisement) Select this option to configure global settings that

Table 239: SMS Content or Web Content, Edit Material
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Field Description

will apply to all advertising materials.

Experimental YouTube API (YouTube video advertisement) Specifies whether the experimental API is enabled
for all devices. Options include:
l All devices —Use the experimental API for all devices
l Disabled —Use the standard YouTube API (recommended)
l Select Devices — Use the experimental API for specific devices

IFrame API Devices (YouTube video advertisement) If selected, the experimental YouTube IFrame API
is used only for iOS devices.
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Chapter 7
Hotspot Manager

The Hotspot Manager controls self-provisioned guest accounts. This is where the customer is able to create his
or her own guest account on your network for access to the Internet. This can save you time and resources
when dealing with individual accounts.

Accessing Hotspot Manager
To access ClearPass Guest’s hotspot management features, go to Configuration > Hotspot Manager.
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About Hotspot Management
The following diagram shows how the process of customer self provisioning works.

Figure 378 Guest Self-Provisioning

1. Your customer associates to a local access point and is redirected by a captive portal to the login page.

2. Existing customers may log in with their Hotspot username and password to start browsing.

New customers click the Hotspot Sign-up link.

3. On page 1, the customer selects one of the Hotspot plans you have created.

4. On page 2, the customer enters their personal details, including credit card information if purchasing access.

5. The customer’s transaction is processed, and, if approved, their guest account is created according to the
appropriate Hotspot plan.

6. On page 3, the customer receives an invoice containing confirmation of their transaction and the details of
their newly created guest account.

7. The customer is automatically logged in with their username and password, providing instant Hotspot
access.

Managing the Hotspot Sign-up Interface

To enable guest access self provisioning, go to Configuration > Hotspot Manager > Start Here and select
the Manage Hotspot Sign-up command.
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The Hotspot Preferences form opens. This form allows you to change user interface options and set global
preferences for the self-provisioning of guest accounts.

Figure 379 The Hotspot Preferences Form
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Field Description

On/Off
Switch

If selected, enables self-provisioning for guest access.

Require
HTTPS

If selected, requires an HTTPS connection for guests creating hotspot accounts, providing greater
security. The guest is redirected to the HTTPS connection.

User
Database

(Required) Service handler used to create self-provisioned guest accounts.

Transaction
Processing

(Required) Service handler used to process hotspot transactions. If no transaction processor exists
yet, click the Create a new transaction processor link. The Edit Transaction Processor opens. For
more information, see "Creating a New Transaction Processor " on page 531.

Service Not
Available
Title

(Required) Title of the page that is displayed if self-provisioning is disabled.

Service Not
Available
Message

HTML for the message that is displayed to guests if self-provisioning is disabled. For details about
the template syntax you can use to format this message, see "Smarty Template Syntax" on page
713 in the Reference chapter. You can also use the drop-down list below this field to add images or
links.

Hotspot
Sign-Up
URL

URL that starts the self-provisioning process. For external captive portals, redirect guests to this URL
to start the sign-up process. For more information, see "Captive Portal Integration" on page 522.

Skin Specifies the skin to use for the hotspot guest access pages. Options include:
l Default — The default skin is the one that is enabled in Plugin Manager.
l Aruba ClearPass Skin
l Blank Skin
l ClearPass Guest Skin
l Custom Skin 1
l Custom Skin 2
l Galleria Skin
l Galleria Skin 2

SMS
Receipt

Specifies the plain-text format print template to use when generating an SMS receipt. Options
include:
l Use Default: SMS Receipt
l Download Receipt
l SMS Receipt
l SMS Sponsor Confirmation Alert

Phone
Number
Field

Specifies the Guest Manager field containing the guest’s phone number. The default is visitor_
phone.

Auto-Send
Field

Specifies the Guest Manager field that, if it contains a non-empty string or non-zero value, will cause
an account receipt to be automatically sent when the guest account is created. The default is
visitor_phone.

Save
Changes

Saves your changes on this form.

Table 240: Hotspot Preferences
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Captive Portal Integration
To start the guest self-provisioning process, new guest registration is performed by redirecting the guest to the
URL specified on the Hotspot Preferences page; for example: https://guest.example.com/hotspot_plan.php.
The Hotspot Sign-Up page opens to the first page of the wizard, Choose Plan.

The hotspot_plan.php page accepts two parameters:

l The source parameter is the IP address of the customer.

l The destination parameter is the original URL the customer was attempting to access (that is, the
customer’s home page). This is used to automatically redirect the customer on successful completion of the
sign-up process.

For browsers without JavaScript, you may use the <noscript> tag to allow customers to sign up:
<noscript>

<a href="https://guest.example.com/ hotspot_plan.php">Hotspot Sign-Up</a>

</noscript>

However, in this situation the MAC address of the customer will not be available, and no automatic redirection
to the customer's home page will be made. You may want to recommend to your customers that JavaScript be
enabled for best results.

Managing Hotspot Plans

Your Hotspot plans determine how a customer is to pay for Internet access when connected through ClearPass
Guest. You also have the option to allow free access.

To view the list of hotspot plans your guests can select and to access plan management, go to Configuration
> Hotspot Manager > Start Here and click the Manage Hotspot Plans link.
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The Manage Hotspot Plans list view opens, showing the list of default plans. Plans that are enabled have
their name in bold and their icon in color: . Plans that are not enabled have their icon in gray: .

Figure 380 The Manage Hotspot Plans List View

Field Description

Edit Let you edit an existing plan. See "Editing or Creating a Hotspot Plan" on page 523.

Delete Lets you delete an existing plan. You are asked to confirm the deletion. When a plan is deleted
you cannot undo the deletion.

Create Hotspot
plan

Lets you create a new plan. See "Editing or Creating a Hotspot Plan" on page 523.

Table 241: Manage Hotspot Plans List View

Editing or Creating a Hotspot Plan
When you create or edit a hotspot plan, you can customize which plans are available for selection, and any of
the plan’s details, such as its description, cost to purchase, allocated role, and the format of the customer’s
generated username and password.

To create or edit a plan, first go to Configuration > Hotspot Manager > Start Here, click the Manage
Hotspot Plans link, and then:

l To create a new plan, click the Create Hotspot plan link in the upper-right corner. The Create Hotspot
Plan form opens.

l To edit a plan, click the Edit link in the plan’s row. The Edit Hotspot Plan form opens.

The procedures are the same for both the Create Hotspot Plan and the Edit Hotspot Plan forms.
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Figure 381 The Edit Hotspot Plan Form, Plan Details Area

The Plan Details area of the form lets you configure items that are displayed to the user in the user interface
and customer invoice.

Field Description

Plan Name Name for this plan. Users select a hotspot plan on the strength of the name, so choose a name that
helps the user clearly identify your service. Avoid names that might be difficult for the user to
identify and trust.

Description Description of the hotspot plan that is displayed with the plan’s name.

Invoice
Description

Description of the hotspot plan that is displayed on the customer’s invoice along with the plan’s
name.

Enabled If selected, enables this hotspot plan. If deselected, the disabled plan is not displayed to customers.

Table 242: Edit Hotspot Plan Form, Plan Details Area

Figure 382 The Edit Hotspot Plan Form, User Account Details Area
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In the User Account Details area, you can specify the usage of numbers, letters, and symbols in the
generated username and password, and specify a role for accounts.

Field Description

Generated
Username

(Required) Lets you format the combination of numbers, letters, and symbols in the generated
username.
To use the customer’s email address as the username, leave this field empty.
To use only digits, leave the value set to ######. To indicate a different combination of numbers,
letters, or symbols, use the following parameters:
l The number or hash symbol (#) is replaced with a random digit (0-9)
l The dollar symbol ($) is replaced with a random letter
l The underscore symbol (_) is replaced with a random lowercase letter
l The carat symbol (^) is replaced with a random uppercase letter
l The asterisk symbol (*) is replaced with a random letter or digit
l The “at” symbol (@) is replaced with a random letter or digit, excluding vowels
l The exclamation symbol (!) is replaced with a random punctuation symbol
l The ampersand symbol (&) is replaced with a random character (letter, digit, or punctuation

symbol)
l All other characters are used without modification.
For more information, see "Format Picture String Symbols" on page 750.

Username
Example

This field shows a sample username generated according to the rules you specified by your entry in
the Generated Username field. To view different examples, click the Generate link.

Generated
Password

Lets you format the combination of letters, numbers, and symbols in the generated password.
To use the password specified on the customer information form, leave this field empty. This might
require adding the “password” field to the customer information form.
To use only digits, leave the value set to ######. To indicate a different combination of numbers,
letters, or symbols, use the following parameters:
l The number or hash symbol (#) is replaced with a random digit (0-9)
l The dollar symbol ($) is replaced with a random letter
l The underscore symbol (_) is replaced with a random lowercase letter
l The carat symbol (^) is replaced with a random uppercase letter
l The asterisk symbol (*) is replaced with a random letter or digit
l The “at” symbol (@) is replaced with a random letter or digit, excluding vowels
l The exclamation symbol (!) is replaced with a random punctuation symbol
l The ampersand symbol (&) is replaced with a random character (letter, digit, or punctuation

symbol)
l All other characters are used without modification.
For more information, see "Format Picture String Symbols" on page 750.

Password
Example

This field shows a sample password generated according to the rules you specified by your entry in
the Generated Password field. To view different examples, click the Generate link.

Role Specifies the role to assign to accounts created for this plan.

Table 243: Edit Hotspot Plan Form, User Account Details Area
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Figure 383 The Edit Hotspot Plan Form, Time & Cost Details Area

In the Time & Cost area, you can specify the time and cost of each unit. A unit is the amount of time
purchased, as defined in the Time Tracking field.

Field Description

Time
Tracking

Specifies the amount or duration of time purchased. This defines the “unit”. Options include:
l Fixed date - Unit purchase is relative to the transaction time — The duration of the unit ends

at a specified amount of time after the account is created.
l Cumulative usage - Unit purchase is for total time spent online — The duration of the unit is

calculated as the cumulative time the user actually spends online.
l Checkout date - Expiration will be midnight the day of the checkout (Hotel PMS only) —

The duration of the unit is begins when the account is created and ends at midnight of the day the
user is scheduled to check out of the hotel.

l Already paid - Select for other devices to share a paid plan (Hotel PMS only) — Allows
multiple devices to use a plan that is already created and paid for.

Unit Cost (Required) Cost for a single unit of this plan. To create a free access plan, enter 0.

Minimum
Units

(Required) Minimum number of units that can be purchased.

Maximum
Units

(Required) Maximum number of units that can be purchased. To hide the quantity option, enter the
value you entered in the Minimum Units field.

Table 244: Edit Hotspot Plan Form, Time & Cost Details Area
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Field Description

Unit Time (Required) The length in time, in seconds, of a single unit of this plan.
One hour = 3600
One day = 86400
ONe week = 604800

Unit
Name

The name used to describe one or more units of this plan.

Update
Plan

Saves the plan and opens the Manage Hotspot Plans list with the new plan displayed.

Table 244: Edit Hotspot Plan Form, Time & Cost Details Area(Continued)

Managing Transaction Processors
Your hotspot plan must also identify the transaction processing gateway used to process credit card payments.
ClearPass Guest supports plugins for the following transaction processing gateways:

l Credit Card Processors:

n Authorize.Net AIM

n CashNet

n CyberSource

n Demo — A Demo transaction processor that you can use to create hotspot forms and test hotspot
transactions

n eWAY

n Netregistry

n PayPal Express

n PayPal PayFlow Pro

n Wirecard Checkout

n WorldPay

l Hotel Property Management Systems:

n FIAS – Micros Opera / Protel / Silverbyte

n HTNG – Agilisys

To view or work with transaction processor gateways, go to Configuration > Hotspot Manager
> Transaction Processors. The Hotspot Transaction Processors list view opens. All transaction
processors you have defined are included in the list.

Figure 384 The Hotspot Transaction Processors List View
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Field Description

Edit Lets you change the properties of the specified transaction processor. The Transaction Processor
Configuration form opens. For more information, see "Creating a New Transaction Processor " on
page 531.

Delete Deletes the processor from the Hotspot Transaction Processors list. You will be asked to confirm
the deletion.

Duplicate Creates a copy of a transaction processor to use as a basis for a new processor.

Show Usage The transaction processor’s row expands to show a list of any hotspots associated with it. Each
hotspot entry is a link to the Hotspot Preferences form, where you can change user interface
options and set global preferences for the self-provisioning of guest accounts. For more
information, see "Managing the Hotspot Sign-up Interface " on page 519.

Rooms Opens the Occupied Room List page, showing all current room reservation details. For more
information, see "Occupied Room List" on page 529.

Re-
Synchronize
Rooms

Opens the Confirm Transaction Processor Sync form, where you can verify when the room data
was last synchronized and update room details. For more information , see "Re-Synchronizing
Rooms" on page 530.

Table 245: Hotspot Transaction Processors List View
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Occupied Room List
To view all current room reservation details, click the Rooms link for a transaction processor at Configuration
> Hotspot Manager > Transaction Processors. The Occupied Room List page opens. This view-only page
displays information about transaction events for the selected processor, and all rooms that are currently
reserved or transactions that are in progress are included in the list. All data is shown in real time.

Figure 385 The Occupied Room List, Transaction Processors

Field Description

Current
Status

Connection status between the transaction processor’s database and ClearPass. If the status is
shown as OK, ClearPass is connected to the transaction processor and all data shown on this page
is current.

Last
Recorded
Event
Stamps

List of the most recent connection commands and events, and the timestamps for when they
occurred. Events include:
l Last — The most recent event type
l (LS) Link Start
l (LC) Link Configuration
l (LA) Link Active
l (DE) Data Resync End
l (GI) Guest In
This list will also include any pending event and any items in the queue.

Room The hotel room number.

First Name The guest’s first name.

Last Name The guest’s last name.

Reservation The reservation number.

Table 246: Occupied Room List, Transaction Processors
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Field Description

Purchase The purchase status.

Date The date of the transaction, in YYYY-MM-DD format.

Arrive The date the guest will arrive, in YYYY-MM-DD format.

Depart The date the guest will leave, in YYYY-MM-DD format.

Table 246: Occupied Room List, Transaction Processors (Continued)

Additional columns might be included if the transaction processing gateway supports custom fields. For an
explanation of the labels for these columns, see the field description for Custom Fields in "Creating a New
Transaction Processor " on page 531.

Re-Synchronizing Rooms
Room data is displayed in real time; however, if an error occurs when the transaction processor’s database
sends information to ClearPass, the data might become out of synch. To resynchronize room data between
ClearPass and the transaction processor’s database, click the Re-Synchronize Rooms link for a transaction
processor at Configuration > Hotspot Manager > Transaction Processors. The row expands to include
the Confirm Transaction Processor Sync form.

Figure 386 The Confirm Transaction Processor Sync Form

Field Description

Last
Data
Sync
Start

Date and time the last data synchronization began.

Last
Data
Sync
End

Date and time the last data synchronization ended.

Pending Displays any pending room transaction requests. If a transaction is triggered while one is already in
progress, the new request is added to the pending queue and will not be sent to the transaction
processor until the results of the previous request are received. If there are multiple transaction

Table 247: Hotspot Transaction Processors, Confirm Transaction Processor Sync Form
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Field Description

requests in the queue, each one must be processed in turn.

Clear Clears the existing room data. Options include:
Re-Synchronize all room details — Clears all current room data and any queued transactions.
Clear the current pending command — Clears only the currently pending transaction. All past room
data is retained, and other queued transaction requests can proceed.

Confirm Consider carefully before re-synchronizing all room details, as this will delete all current room data and
any pending payment requests.

OK Commits the selected re-synchronization option.

Cancel Cancels your entries and closes this form.

Table 247: Hotspot Transaction Processors, Confirm Transaction Processor Sync Form (Continued)

Creating a New Transaction Processor
The Transaction Processor Configuration form is used to create and to edit transaction processors.

To define a new transaction processor:

1. Go to Configuration > Hotspot Manager > Transaction Processors and click the Create new
transaction processor link in the upper-right corner. The Transaction Processor Configuration form
opens.

Figure 387 The Transaction Processor Configuration Form

2. In the Name field, enter a name for the transaction processor.

3. In the Processing Gateway drop-down list, select the gateway with which you have a service account. The
form expands to include additional configuration fields for that gateway type.

Each transaction processing gateway type requires unique merchant identification, password, and
configuration information. Depending on the gateway provider, these configuration items will include some
of the following:
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Field Description

Allowed
Access

IP addresses and networks from which callbacks are permitted. (IPv4 and IPv6 are both
supported)

API Login (Required) The Authorize.Net API account name.

API Password (Required) The API password for this transaction processor.

Confirm
Password

API Username (Required) The API username for this transaction processor.

Auto Email If selected, passes along the flag to directly email the customer from Authorize.Net.

Beagle Anti-
Fraud

if selected, enables Beagle GEO Anti-Fraud.

Business
Center Login

URL for logging in to the business center.

Character Set The character set this transaction processor’s server is using when sending text.

Client ID The PayPal app credentials pair client ID.

Client Secret The PayPal app credentials pair secret.

Confirm
Secret

Confirmation
Email

Email address to which all payment details will be sent.
For more information, refer to https://integration.wirecard.at/doku.php/request_
parameters#confirmmail.

Confirmation
URL

URL that will capture and log all payment details, if you have one.
For more information, refer to https://integration.wirecard.at/doku.php/request_
parameters#confirmurl.

Country Code (Required) Country code to use. Please refer to the PayPal country code guide for the appropriate
value.
For more information, refer to https://developer.paypal.com/docs/classic/api/country_codes/ This
value will be overwritten if the form has the “country” field.

Currency
Code

(Required) Country currency code to use. Please refer to the Wirecard currency code guide for
the appropriate value.
For more information, refer to https://integration.wirecard.at/doku.php/request_
parameters#currency.

Customer ID (Required) The customer’s ID for this transaction processor.

Custom
Fields

Lets you include additional fields for the FIAS transaction processor. Users should be aware that
some vendors or servers might not return information for some custom fields. Before you
configure custom fields, you should verify whether your gateway provider allows them. Options
include:
l User Definable Fields (A0-A9)
l Guest Group Number (GG)

Table 248: Transaction Processor Configuration
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Field Description

l Guest Language (GL)
l Guest Shared Room (GS)
l Guest Title (GT)
l Minibar Rights (MR)
l TV Rights (TV)
l Video Rights (VR)
l Workstation ID (WS)

Data Sync (Required) Options include:
l Only sync the database the first time it is seen
l Sync the database whenever the local service restarts
l Sync the database whenever the server comes online
l Poll - Do not sync the data and poll for details
l External - Synchronization is being done on a different server

Denied
Access

IP addresses and networks that are denied callbacks.
(IPv4 and IPv6 are both supported)

Hostname (Required) The server hostname or IP address.

Installation
ID

The installation ID to use when starting a transaction with this transaction processor.

Item Code (Required) The item code for the Wi-Fi service.

Keep Alive Specifies whether and how to send periodic keepalive commands to the FIAS server. May be
needed in scenarios where room updates are infrequent, or other networking devices such as
switches or firewalls might drop connections. Options include:
l None
l Via Link Start (LS) — This option receives a response from the PMS software.
l Via Link Alive (LA)

Keep Alive
Repeat

If Keep Alive is configured, specifies the interval at which the periodic keepalive commands are
sent to the FIAS server. Options include:
l 5 minutes
l 10 minutes
l 20 minutes
l 30 minutes
l 1 hour

Logging If selected, details are logged to cybs.log. Advised for debugging only.

Merchant ID (Required) The merchant ID to use for this transaction processor when starting a transaction.

Mode If selected, enables transaction processing in the production environment.

Name Match (Required) Specifies how much of the last name must be matched. If the name is shorter than the
required length, it will be matched in full. Matches are not case-sensitive. Options include:
l Exact last name match
l First 3 letters of the last name
l First 4 letters of the last name

Table 248: Transaction Processor Configuration(Continued)
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Field Description

l First 5 letters of the last name
l First 6 letters of the last name
l First 7 letters of the last name

No-Post
Status

(Required) Options include:
l Ignore the NP flag and allow access
l Deny paid access to accounts with the NP flag
l Deny all access to accounts with the NP flag

Payment ID The payment ID as required by the PMS.

Payment
Type

Specifies the payment method. Options include Select within Wirecard Payment Page, as well
as a variety of other methods.
For more information, refer to https://integration.wirecard.at/doku.php/request_
parameters#paymenttype.

Port (Required) The server TCP port. The port must not be in use by this appliance.

Production
Environment
URL

(Required) URL used for transactions when in production mode.

Requirements (Required) Options include:
l Room number and last name
l Reservation number and last name

Resort ID The resort ID as entered in the PMS system.

Revenue
Center ID

The revenue center ID as required by the PMS.

Secret (Required) The Wirecard secret.

Confirm
Secret

Service URL The URL for this transaction processor’s server.

Shared Secret The MD5 shared secret to use for securing the transaction. Up to 16 characters are allowed. This
must be the same as the “MD5 secret for transactions” that was configured in the transaction
processor’s administration interface.

Shop ID The Wirecard shp ID, if you have one configured.
For more information, refer to https://integration.wirecard.at/doku.php/request_
parameters#shopid.

Signature (Required) The API signature for this transaction processor.

Confirm
Signature

Test
Environment
URL

(Required) This URL is used for transactions when not in production mode.

Table 248: Transaction Processor Configuration(Continued)
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Field Description

Test WSDL (Required) URL of the SOAP WSDL in non-production mode.

Time Zone Specifies the time zone to use to override the system time zone if the hotel Property
Management System (PMS) and ClearPass are in different time zones. By default, timestamps
used in the FIAS protocol are relative to the ClearPass system’s time.

Transaction
Key

(Required) The SOAP transaction key.

Transaction
Password

(Required) This transaction processor’s API transaction password.

Confirm
Password

Transactions
Timeout

(Required) Timeout, in seconds, of the transaction request.

WSDL (Required) URL of the SOAP WSDL in production mode.

Your Logo
URL

(Required) URL of your online shop where your online shop logo is located.
For more information, refer to https://integration.wirecard.at/doku.php/request_
parameters#imageurl.

Your Service
URL

URL of an information page in your online shop that informs your consumer about different ways
to contact you. Do not use this URL to link to the shopping basket of your consumer.
For more information, refer to https://integration.wirecard.at/doku.php/request_
parameters#serviceurl.

Table 248: Transaction Processor Configuration(Continued)

If your transaction processor requires guests to enter their address, ClearPass Guest will automatically include
address fields in the guest self-registration forms that use that transaction processor.

Managing Customer Information

You can customize the fields that the customer sees, the details of these fields, and the order in which they are
presented. To customize the fields, go to Configuration > Hotspot Manager > Start Here and click the
Manage Hotspot Customer Information link.

The Customize Form Fields view opens for the customer information form. See "Customizing Forms" on
page 297 for instructions for completing the form field editor.
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Managing Hotspot Invoices

After the customer’s transaction has been processed successfully, the customer receives an invoice containing
confirmation of their transaction and the details of their newly created hotspot user account. You can
customize the title shown on the invoice and how the invoice number is created. You can also customize the
currency displayed on the invoice.

To customize the hotspot invoice, go to Configuration > Hotspot Manager > Start Here and then click the
Manage Hotspot Invoice link. The Manage Invoice form opens.

Figure 388 The Manage Invoice Form
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Field Description

Invoice Title (Required) HTML template code used to display the title on the customer’s invoice. For more
information, see "Basic HTML Syntax" on page 710

Invoice
Numbering

(Required) Specifies the method used to generate invoice numbers. Options include:
l Default numbered format
l Sequential numbering from 1
l Specify format using template

Invoice
Number

Expression that describes the invoice number format.

Preview This field shows an example of an invoice number generated using the current settings.

Currency
Format

(Required) The currency format to use when formatting a monetary amount for display.

Currency
Code

The currency code to specify to the transaction service provider.

Login Code HTML template code to display in the bottom panel of the invoice.

Save
Changes

Saves your changes to the invoice configuration.

Table 249: Manage Invoice Form

You can use Smarty functions on this page. See "Smarty Template Syntax" on page 713 for further information
on these. You can also insert content items such as logos or prepared text. See "Customizing Self-Registration"
on page 348 for details on how to do this.

Customizing the User Interface
Each aspect of the user interface your hotspot customers see can be customized.

This section includes:

l "Customizing Guest Sign-Up Page One " on page 537 — Page One lets the guest select a plan.

l "Customizing Guest Sign-Up Page Two " on page 540 — Page Two asks for the guest’s personal information
and payment method.

l "Customizing Guest Sign-Up Page Three " on page 544 — Page Three is the customer’s receipt.

Customizing Guest Sign-Up Page One

Page one of the guest self-provisioning process asks the guest to select a plan. An example of the default
“Choose Plan” page is shown below.
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Figure 389 Example Choose Plan Page

To customize how this page is displayed to the guest, go to Configuration > Hotspot Manager > Start
Here, click the Manage Hotspot Sign-Up link, and then click the Customize page 1 (Choose Plan) link in
the upper-right corner.

The Edit Hotspot Plan Selection Page form opens. You can use this form to edit the title, introductory text,
and footer of the “Choose Plan” page. The introduction and the footer are HTML text that can use template
syntax. For more information, see "Smarty Template Syntax" on page 713 in the Reference chapter.
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Figure 390 The Edit Page Form, Step 1: Choose Plan

Field Description

Page Title (Required) Title for the page where the guest selects a plan.

Introductory
HTML

HTML code for the text to display at the top of the page, above the list of hotspot plans.

Footer
HTML

HTML code for the text to display at the bottom of the page, below the list of hotspot plans.

Options If selected, the standard form on this page will not be included when the page is generated. This
option is recommended for advanced users only.

Save
Changes

Saves your changes to the plan selection page.

Table 250: Edit Page Form, Step One: Plan Selection Page
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Customizing Guest Sign-Up Page Two

Page two of the guest self-provisioning process asks the guest to provide their personal details and payment
method.

The example below shows the default “Your Details” page if the customer chooses to pay for the Hourly Access
plan.

Figure 391 Example “Your Details” Page Shown to Customer, Hourly Plan

Although it is not shown in this illustration, the default page also includes footer text providing information
about privacy policies and security pertaining to the data collected by this page.
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The example below shows the default “Your Details” page for a customer who chooses the Free Access plan.

Figure 392 Example “Your Details” Page Shown to Customer, Free Access Plan

To customize how the “Your Details” page is displayed to the guest, go to Configuration > Hotspot Manager
> Start Here, click the Manage Hotspot Sign-Up link, and then click the Customize page 2 (Customer
Details) link in the upper-right corner.

The Edit Hotspot User Details Page form opens. You can use this form to edit the content displayed when
the customer enters their personal details, including credit card information if purchasing access. The progress
of the user’s transaction is also shown on this page. For information about the template syntax you can use to
format the content on this page, "Smarty Template Syntax" on page 713.
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Figure 393 The Edit Page Form, Step 2: Customer Details
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Field Description

Page Title (Required) Title for the page where the guest enters their personal information and payment
method.

Introductory
HTML

HTML code for the text to display at the top of the page, above the guest’s personal information.

Footer HTML HTML code for the text to display at the bottom of the page, below the guest’s personal
information.

Transaction
Header HTML

HTML code for the text to display while the transaction is in progress. This text is displayed at
the top of the page, above the progress notification area.

Transaction
Footer HTML

HTML code for the text to display while the transaction is in progress. This text is displayed at
the bottom of the page, below the progress notification area.

Options If selected, the standard form on this page will not be included when the page is generated. This
option is recommended for advanced users only.

Save Changes Saves your changes to the personal information and payment page.

Table 251: Edit Page Form, Step Two: User Details and Payment Page
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Customizing Guest Sign-Up Page Three

Page three of the guest self-provisioning process provides the customer an invoice containing confirmation of
their transaction and the details of their newly created wireless account. An example of the default receipt page
is shown below.

Figure 394 Example “Your Invoice” Page Shown to Customer

To customize how the “Your Receipt” page is displayed to the guest, go to Configuration > Hotspot
Manager > Start Here, click the Manage Hotspot Sign-Up link, and then click the Customize page 3
(Invoice or Receipt) link in the upper-right corner.

The Edit Hotspot User Receipt Page form opens. You can use this form to edit the title, introductory text,
and footer text of the receipt page. For more information about the template syntax you can use to format
the content of this page, see "Smarty Template Syntax" on page 713
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Figure 395 The Edit Page Form, Step 3: Invoice or Receipt

Field Description

Page Title (Required) Title for the guest’s receipt page.

Introductory
Text

HTML code for the text to display at the top of the page, above the guest’s invoice details.

Footer Text HTML code for the text to display at the bottom of the page, below the guest’s invoice details.

Options If selected, the standard layout on this page will not be included when the page is generated. This
option is recommended for advanced users only.

Save
Changes

Saves your changes to the receipt page.

Table 252: Edit Page Form, Step Three: Receipt Page

Viewing the Hotspot User Interface
ClearPass Guest lets you view and test the hotspot self-provisioning pages you create. To view the hotspot
page:

1. Go to Configuration > Pages > Self-Registrations and click Create new self-registration page. The
Customize Self-Registration form opens.
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2. Select the check box in the Hotspot row to enable hotspot registration for the self-registration page.

3. Complete the self-registration configuration. See "Creating a Self-Registration Page" on page 355.

4. Return to Configuration > Pages > Self-Registrations and click the page’s row in the list.

5. Click one of the following links:

l The Launch Self-Service link opens an active preview of the self-service login page and form as the
guest would see it. This is the form that lets the guest access their account information. You can test the
behavior of the form.

l The Launch Login link opens an active preview of the network login page and form as the guest would
see it. This is the page the guest sees when they log in to the network. You may test the behavior of the
form.
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Chapter 8
Administration

The Administration module provides tools used by a network administrator to perform both the initial
configuration and ongoing maintenance of ClearPass Guest.

Accessing Administration
To access ClearPass Guest’s administration features, click the Administration link in the left navigation.

Figure 396 The Administration Module’s Left Navigation
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AirGroup Services

This section describes creating and managing AirGroup controllers and configuring the AirGroup plugin, and
provides links to other AirGroup steps performed in ClearPass Guest. For an overview of AirGroup
functionality, see "AirGroup Deployment Process" on page 31. For complete AirGroup deployment
information, refer to the AirGroup sections in the ArubaOS User Guide and the ClearPass Policy Manager
documentation.

This section describes the following:

l "AirGroup Controllers" on page 549

l "Creating and Editing AirGroup Controllers " on page 551

l "Configuring AirGroup Services" on page 651

l "AirGroup Diagnostics" on page 554

l "AirGroup Time-Based Sharing Syntax Examples" on page 88

l "Creating AirGroup Administrators" on page 556

l "Creating AirGroup Operators" on page 556

l "Authenticating AirGroup Users via LDAP " on page 556

l "Configuring LDAP User Search for AirGroup" on page 556

AirGroup Controllers

You can create and manage multiple AirGroup controllers. You may configure each controller's remote access
and other information, poll the current configuration, and view configuration details.

To work with your AirGroup controllers, go to Administration > AirGroup Services > Controllers. The
AirGroup Controllers list view opens.

Figure 397 The AirGroup Controllers List View

All AirGroup controllers that have been created are included in the list. You can click an AirGroup controller's
row in the list for additional options:
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Field Description

Show Details Lets you view details for the AirGroup controller: Name, hostname or IP address and port
number, configuration status, last polling time, currently defined roles and AP groups, and
AP database details. See "AirGroup Controller Details" on page 550

Edit Lets you edit the AirGroup controller's attributes. The Edit AirGroup Controller form
opens. For more information, see "Creating and Editing AirGroup Controllers " on page
551 .

Disable Disables the AirGroup controller. To enable it again at any time, click its Enable link.

Delete Deletes the AirGroup controller. You are asked to confirm the deletion.

Read Configuration Polls the AirGroup controller's current configuration. A progress bar is shown during the
polling action. When the poll is complete, you can click Show Details to review the
updated configuration details for the roles, AP groups, and AP database. For information
on setting an automatic polling schedule, see "Configuring AirGroup Services" on page
651.

Create Controller Lets you create a new AirGroup controller. The Create AirGroup Controller form opens.
For more information, see "Creating and Editing AirGroup Controllers " on page 551.

AirGroup Diagnostics Lets you perform AirGroup diagnostics. For more information, see "AirGroup Diagnostics"
on page 554.

Table 253: AirGroup List Options

Figure 398 AirGroup Controller Details
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Creating and Editing AirGroup Controllers
When you create a new AirGroup controller or edit an existing one, you may configure its name, description,
notification status, its network connection and authentication settings, and SSH (Secure Shell) details for
remote access.

To create a new AirGroup controller or edit an existing controller:

1. Go to Administration > AirGroup Services > Controllers, and then either click Create AirGroup
controller at the top of the form, or click a controller's Edit link. The Create Controller form opens.

Figure 399 The Create Controller Form
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Field Description

Name Short name that identifies the controller clearly. AirGroup controller names can include
spaces.

Description Additional useful information about the controller.

Enabled Enables Policy Manager's AirGroup notification service for the controller. With this service
enabled, the controller receives change of authorization (CoA) Requests for sharing events
from associated MAC addresses and the events are logged.

Hostname Hostname or IP address of the controller.

RFC 3576 Port UDP port number for receiving CoA notifications. The default in ClearPass Guest is 5999.

Shared secret Shared secret for AirGroup dynamic notifications.

SSH Username SSH username for accessing the controller.

SSH Password SSH password for accessing the controller. The minimum password length is six characters.

Enable Password The enable password for the controller.

SSH Timeout Timeout limit in seconds for reading the configuration. The default is 15 seconds.

Table 254: Create AirGroup Controller
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Configuring AirGroup Services
To enable support for dynamic notification of AirGroup events when new devices are added, each AirGroup-
enabled controller must also be defined in ClearPass Guest. Configuration options include specifying roles to
exclude from the user interface, and setting message parameters and logging levels.

To configure AirGroup Services, go to Administration > AirGroup Services > Configuration. The
Configure AirGroup Services form opens.

Figure 400 The Configure AirGroup Services Form
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Field Description

Exclusions Role names, AP group names, or AP names that should not be displayed in the AirGroup
user interface. Enter each item on a separate line. Entries are not case-sensitive. To add a
comment, enter it on a separate line that begins with the "#" character.

Group Names Enter names of shared groups that should be available in the Shared Groups field for
users to choose from when they share a device. If additional user groups are also entered
by users when they share a device, the list in the configuration is automatically updated to
capture these fields. Removing a group name from this list does not remove it from other
shared group lists.
When you type a name for the group in the Group Names field, press the Enter key, and
click Save, the group is created in the system and appears as a "tag". For more information,
see "About AirGroup Time-Based Sharing" on page 92.
Each group name may not exceed 64 characters. A maximum of 32 group names may be
entered. The maximum character limit for the list is 320 characters (including comma
separators).

Network Interface Specifies the interface AirGroup will use to send outbound notification messages. To enable
using a virtual IP address, select the appropriate interface. Options include:
l Automatic — Automatically chooses the appropriate source IP address; either the

management port or the data port, depending on the controller's IP address.
l Management port [MGMT] — Always uses the management port as the source

address.
l Data/External port [DATA] — Always uses the data port as the source address.

Timeout Number of seconds after which an attempt to send an AirGroup message will time out.

Attempts Maximum number of times the system should attempt to send an AirGroup message.

AirGroup Logging Specifies the logging level. Options include:
l Disabled—Do not log AirGroup related events
l Standard (Recommended)—Log basic information
l Extended—Log additional information
l Debug—Log debug information
l Trace—Log all debug information

Table 255: Configure AirGroup Services

AirGroup Diagnostics
The AirGroup Diagnostics form lets you perform several diagnostic actions. To access this form, go to
Administration > AirGroup Services > Configuration, and then click the AirGroup Diagnostics link in the
upper-right corner. The AirGroup Diagnostics form opens.
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Figure 401 The AirGroup Diagnostics Form

When you choose the diagnostic you want to run, the form expands to include fields for identifying
information. When you enter the information and click Submit, the results of the query are displayed below
the form. To run another diagnostic, click the Reset Form link before selecting the diagnostic.

Field Description

Show information about a device Enter the device's MAC address. Information shown includes:
l Device information (as entered on Guest > Create Device)
l Controller IP address and AirGroup protocol version
l Hostname of associated server, management IP address, and role
l Times of AirGroup authorization requests along with controller IPs

and enforcement profiles

Show information about a controller Enter the controller's IP address or hostname. Information shown
includes:
l Times of AirGroup authorization requests along with MAC

address, controller IPs, and enforcement profiles
l MAC address, AirGroup state, time of last update, and expiration

setting for devices associated with the controller

Associate a device with a controller Links a MAC address to a controller as though the controller had
issued an AirGroup authorization request for the device.
Enter the device's MAC address and controller's IP address or
hostname. Select the AirGroup protocol version. Two links are added
below the form, one for viewing the device information, and one for
viewing the controller information.

Disassociate a device from a controller Removes the link between the MAC address and the controller as
though the controller had reported the device no longer present on
the network.
Enter the device's MAC address and controller's IP address or
hostname. Two links are added below the form, one for viewing the
device information, and one for viewing the controller information.

Show information about the AirGroup
notification service

Displays a list of statistics from the AirGroup notification service,
showing values for various work items, CoA clients and requests, and
RADIUS items.

Download AirGroup notification service
log file

Downloads the log file to your system's Download folder.

Table 256: AirGroup Diagnostics
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See also:

l "Configuring AirGroup Services" on page 651

l "AirGroup Controllers" on page 549

l "AirGroup Services " on page 549

Creating AirGroup Administrators
AirGroup administrators are users of ClearPass Guest who can define and manage their organization’s shared
devices. Devices can be shared globally, or shared with restrictions based on the username, role, or location of
the user trying to access the device.

The AirGroup administrator profile is automatically created in ClearPass Guest when the AirGroup Services
plugin is installed. This profile is used to define the AirGroup administrator role. To create an AirGroup
administrator, see "Creating a New Operator" on page 694.

Creating AirGroup Operators
AirGroup operators are users of ClearPass Guest who can provision a limited number of their own personal
devices. Each device provisioned by an operator is automatically shared with all of that operator’s provisioned
devices. The operator can also define a group of other users who are allowed to share the operator’s devices.

The AirGroup operator profile is automatically created in ClearPass Guest when the AirGroup Services plugin is
installed. This profile is used to define the AirGroup operator role. To create an AirGroup operator, see
"Creating a New Operator" on page 694.

Authenticating AirGroup Users via LDAP
ClearPass Guest supports LDAP authentication for administrators and operators. To provide AirGroup Services
to LDAP-authenticated users:

1. Define the LDAP server for AirGroup. See "External Operator Authentication" on page 694.

2. Define the appropriate translation rules to categorize the LDAP users. See "Custom LDAP Translation
Processing" on page 707.

Configuring LDAP User Search for AirGroup
On the AirGroup device registration portal, the Shared Roles and Shared Locations lists allow searching and
selecting from the roles and locations defined in an AirGroup-enabled controller in order to specify the users
with whom an AirGroup device should be shared. This section describes how to configure ClearPass Guest to
enable interactive directory-based user search for these AirGroup fields.

This section includes:

l "LDAP User Search Architecture for AirGroup" on page 557

l "Configuration Summary for AirGroup" on page 557

l "Basic LDAP Server Settings for AirGroup" on page 557

l " User Search Settings for AirGroup" on page 559

l "Configuring the AirGroup Shared User Field" on page 560

l "Select2 Options Details" on page 562

l "Select2 Hook Details" on page 563
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LDAP User Search Architecture for AirGroup

The LDAP user search feature has several architectural components, as shown in the following diagram.

Figure 402 LDAP User Search Components

User Search Workflow for AirGroup

The workflow for a typical user search operation is:

1. The user of the AirGroup portal starts typing a username. This triggers a dynamic request to ClearPass
Guest.

2. ClearPass Guest performs a search operation against the configured LDAP server.

3. Search results are returned to the portal user, who can then select from one of the matching item, or
continue typing to further narrow the search.

Configuration Summary for AirGroup

To configure LDAP user search for AirGroup, you will:

1. Create a ClearPass Guest LDAP server

2. Enable user search for this server

3. Configure the user interface for the airgroup_shared_user field

4. Specify user search options for the user interface

Each of these steps is described in the following sections.

Basic LDAP Server Settings for AirGroup

In ClearPass Guest, go to Administration > Operator Logins > Servers and click the Create new LDAP
server link. The Server Configuration form opens.
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Figure 403 The Server Configuration Form

In the basic properties and Operator Logins areas of the Server Configuration form:

Field Description

Name (Required) Name for the LDAP server.

Priority (Required) Priority rank of the service handler for
authentication of local operators. The lowest number has the
highest priority.

Server Type (Required) Specifies the type of server to connect to.

Server URL (Required) The LDAP URL of the server. This would typically be
in the form:
ldap://ldap-server-

hostname.example.com/<LDAP Base DN>

Bind DN If your directory server requires authentication, provide
suitable credentials.
A typical base DN for Microsoft Active Directory might be
DC=example,DC=com.

Bind Username

Bind Password

Enabled Clear the Use this server to authenticate operator
loginscheck box unless you also plan to configure LDAP
operator logins with this server.

Table 257: Edit Authentication Server, Basic Properties
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User Search Settings for AirGroup

Figure 404 The Server Configuration Form, User Search Area

In the User Search area of the Edit Authentication Server form:

Field Description

Enabled If selected, the server will be used to search for matching users. The form expands to
include additional options.

Filter (Required) Filter methods. Options include:
l Use the default LDAP filter—Uses an LDAP filter suitable for an Active Directory

search operation.
n The default filter matches user accounts based on any portion of the username

(sAMAccountName attribute), or any portion of the user’s full name (displayName
attribute), and eliminates resources (display name starting with “*”), disabled
accounts, and users without a userPrincipalName attribute.

l Specify a custom LDAP filter…—Allows you to enter a specific LDAP filter expression.
n This should be a valid LDAP filter expression per RFC 4515.
n The keyword @SEARCH@ is replaced with the user’s actual search term when the

filter is used.

Display Attributes
*

(Required) Provide a list of LDAP attributes to retrieve when searching, and the treatment to
apply to each attribute:
l id—Use the LDAP attribute as the value of a matching item. This value is used when a

matching item is selected. This would normally be the case for the LDAP attribute that
specifies the username. The directory should contain unique values in this attribute.

l text—Use the LDAP attribute as the text to display for a matching item.
l This would normally be the case for the LDAP attribute that specifies the user’s common

name (displayName in Microsoft Active Directory). Users will typically want to search on
this attribute.

l desc—Use the LDAP attribute as additional descriptive text to display for a matching
item. This is an optional item.

There must be exactly one attribute that is identified as an “id” attribute.
Multiple LDAP attributes may be identified as “text” or “desc” attributes, in which case all the
values are displayed together in the search results.
If no LDAP attribute is identified as a “text” attribute, the “id” attribute will be used as the text.
To use one attribute in different ways, provide a list of types. For example, specify
sAMAccountName = id, desc to have the username act as both the ID and the description

Table 258: Edit Authentication Server, User Search
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Field Description

text.
Comments may be entered in this field by starting a line with the “#” character.

Sort By Specify the name of an attribute on which to order the search results. Otherwise, the default
value of displayName orders the results by the user's full name.

Maximum Results (Required) Limits the total number of search results that can be displayed.

* In the Display Attributes field, the default value field provides the following behavior:

l sAMAccountName = id—The username is used as the value for a selected item.

l displayName = text—The user’s full name is displayed as the label for a matching item.

l # title = desc—Commented out and not used by default. Enables the title of the user to be shown in the
description.

l userPrincipalName = desc—The user’s email address is displayed as descriptive text for a matching item.

Configuring the AirGroup Shared User Field

Figure 405 The Server Configuration Form, AirGroup Field

The AirGroup row of the Edit Authentication Server form is the starting point to enable the server for user
search in AirGroup. This row provides a brief description of the process and a link to the airgroup_shared_
user field's configuration form.

The airgroup_shared_user field stores a list of usernames with whom an AirGroup device should be shared.
To enable user search, this field must be updated with new configuration options.

To configure the airgroup_shared_user field, do one of the following:

l From the Administration > Operator Logins > Servers > Edit Authentication Server form, click the
Edit airgroup_shared_user field link provided in the Tip in the AirGroup row.

l If you are not starting from the Edit Authentication Server form, go to Configuration > Pages > Fields,
select the airgroup_shared_user field in the list, and then click Edit. The Define Custom Field form for
that field opens.
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Figure 406 The Define Custom Field Form, Default Form Display Properties Area

Use the Default Form Display Properties area of the form to set the field type and enable search:

Field Description

User
Interface

Type of user interface element to use for this field. Select Multiple selection list from this drop-
down list.

Searchable Select the Enable searching and advanced UI check box in this row. The Select2 Options and
Select2 Hook fields are added to the form.

Table 259: Default Form Display Properties, Relevant Fields

Figure 407 The Define Custom Field Form, Select2 Options and Select2 Hook Fields

In the Advanced Properties area of the form, you will customize the user interface for single and multiple-
selection capabilities.
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Field Description

Advanced Select the Show advanced properties check box. Additional configuration options are added
to the form.

Select2 Options Used to customize the user interface for the “select2” control, which provides both single and
multiple-selection capabilities.
Default values are preconfigured for these fields. These defaults are intended for use with user
search. However, the ajax.args.server parameter must be configured with the name of the
LDAP server that should be searched.

Select2 Hook

Save Changes After the server name is specified in the ajax.args.server parameter in the Select2 Hook field,
when you save your changes the AirGroup device registration portal includes the capability to
search the directory based on username.

Table 260: Advanced Properties, Relevant Fields

For details of the advanced options, functions, and additional parameters provided in the Select2 Options
and Select2 Hook fields, see "Select2 Options Details" on page 562 and "Select2 Hook Details" on page 563.
For in-depth technical information about these functions, refer to the Select2 programmer’s documentation at
http://ivaynberg.github.com/select2/.

Select2 Options Details

When configuring the airgroup_shared_user field for AirGroup user search, the advanced options provided in
the Select2 Options field are shown in the following table:

Option Description

multiple = 1 Specifies that the field allows multiple selections. When this parameter is set,
individual selections can be cleared by clicking an “x” delete icon displayed with
each selection, or by using the Backspace key to erase a selected item.

placeholder = (Select one or
more users)

Specifies the placeholder text that is displayed when the field is empty.

minimumInputLength = 1 Specifies that at least one character must be typed before a search operation is
triggered. If the directory has a large number of user accounts in it, performing a
single-character search is not likely to return any useful results, in which case this
value should be increased.

_advancedRender = 1 Specifies that the list of matching items should be rendered in a way which
includes an icon, text and description. If this parameter is not specified, only text
is displayed in the matching items.

resultsCss.max-height =
400px

Specifies that the list of matching items should be up to 400 pixels in height.
Additional CSS properties may be specified using the “resultsCss” value, if
required.

ajax.dataType = sajax Specifies that the field should use a dynamic query mechanism to look up a
search term. This parameter should not be changed.

Table 261: Details, Select2 Options Field
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Option Description

ajax.url =
NwaAirGroupUserSearchAjax

Specifies that the field should perform a user search. This parameter should not
be changed.

ajax.args.server = … Specifies the name of the LDAP server that should be searched. This parameter
must match the name of the LDAP server that was created, or else the search
operation will fail.

ajax.quietMillis = 500 Specifies that the user search operation should be performed after half a second
(500 ms). This parameter is used to avoid performing searches while the user is
still typing. To increase the responsiveness of the user interface, this parameter
can be reduced, but doing so may increase the number of search operations
performed against the LDAP server.

Additional parameters that may be specified in this field include:

Option Description

width = 460px Specifies the width of the field. A value in pixels may be specified, or another length unit
supported by CSS. This parameter does not need to be specified if the CSS Style field is
already used to specify a width.

maximumInputLength
= <number>

Specifies the maximum number of characters that may be entered.

maximumSelectionSize
= <number>

Specifies the maximum number of items that can be selected. After this number has
been reached, the drop-down list will show a message returned by the
formatSelectionTooBig function.

closeOnSelect = false Specify this option to prevent the drop-down list from closing when a value is selected.
This parameter is not recommended when dynamic search is enabled, as a dynamic list
does not contain all possible items that may be selected.

containerCss.<style-
name> = <style-value>

Specify CSS properties that will be applied to the containing element of the “select2”
control.

dropdownCss.<style-
name> = <style-value>

Specify CSS properties that will be applied to the drop-down list element of the “select2”
control.

Table 262: Additional Parameters, Select2 Options Field

For in-depth technical information about these functions, refer to the Select2 programmer’s documentation at
http://ivaynberg.github.com/select2/. For information on configuring AirGroup for LDAP user search, see
"Configuring LDAP User Search for AirGroup" on page 556.

Select2 Hook Details

The Select2 Hook field may be used to attach certain dynamic behaviors to the “select2” control.

This field must contain the definition of a JavaScript function that takes a single argument. The argument to
this function specifies certain behavioral properties of the control. The function should return the argument,
updated as necessary to specify the behavior that you want.

To change the behavior of the “select2” control, you need to attach a JavaScript function definition to one or
more properties of the hook function’s argument.

The hook function may also set or update any of the properties specified in the “Select2 Options”.
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A simple example is included as the default value with the airgroup_shared_user field:

function (args) {

args.formatInputTooShort = function (text) {

return "Start typing a user name.";

};

return args;

}

The functions that may be defined by the “Select2 Hook” function shown in the following table:

Function Description

sortResults(results,
container, query)

Used to sort the results list for searching right before it is displayed. Useful for sorting
matches by relevance to
the user’s search term.

formatNoMatches
(term)

Function used to render the “No matches” message. Should return an HTML string.

formatSearching() Function used to render the “Searching…” message that is displayed while a search is in
progress. Should return an HTML string, or null to disable the message.

formatInputTooShort
(term, minLength)

Function used to render the “Search input too short” message. Should return an HTML
string.

formatSelectionTooBig
(maxSize)

Function used to render the “You cannot select any more choices” message. Should
return an HTML string.

Table 263: Select2 Hook Functions

For in-depth technical information about these functions, refer to the Select2 programmer’s documentation at
http://ivaynberg.github.com/select2/. For information on configuring AirGroup for LDAP user search, see
"Configuring LDAP User Search for AirGroup" on page 556.

Device Registration Services

Device Registration allows users to register their personal mobile devices on a local network. Each device
registered by an operator is automatically shared with all of that operator’s registered devices. There is no limit
to the number of device accounts an operator can create, and no expiration time is set on device accounts.

You use ClearPass Policy Manager to create Device Registration operators. Device Registration operators can
then log in through ClearPass Guest to register and manage their devices.

For example, in a university setting, Device Registration provides a simple way for students to register their
various devices on the network:

l The student is authenticated and can register as many devices as they wish.

l Device Registration automatically detects each device's OS type, letting the network administrator easily
build an inventory of the devices on the network and architect an appropriate network policy.

l As with other ClearPass Guest forms and views, the user interface seen by Device Registration operators can
be customized by adding a custom skin or options such as an "Add Another Device" button.

This section describes the following:
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l "Creating Device Registration Operators" on page 565

l "Managing a Device Registration Operator’s Devices " on page 566

l "Registering a Device Registration Operator’s Devices " on page 567

l "Automatically Supplying the Device Address" on page 569

Creating Device Registration Operators
Device Registration operators are users of ClearPass Guest who can register their personal devices on a local
network. The Device Registration operator profile and translation rule are already available in ClearPass Guest,
and the Device Registration role is available in ClearPass Policy Manager. No expiration time is set on Device
Registration operator accounts.

To create a Device Registration operator, in ClearPass Policy Manager, go to Configuration > Identity
> Local Users and click Add. The Add Local User form opens.

Figure 408 The Add Local User Form in Policy Manager

Field Description

User ID The Device Registration operator's username.

Name The Device Registration operator’s name.

Password Password for the Device Registration user. The minimum password length is six characters. Passwords
can include letters, numbers, and the following special characters:
! @ # $ % ^ & * ( ) < > [ ] { } ' : ~ ` / \ | " + , - . ; = ? _Verify

Password

Enable If selected, enables this Device Registration operator. The new operator is enabled by default. If the

Table 264: Add Local User Form in Policy Manager
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Field Description

User operator is not to be activated until a later time, you may deselect this check box.

Role Specifies the operator’s role. Select the Device Registration Operator option.

Attribute Lets you add attributes for additional information such as Phone, Email, Sponsor, Title, Department,
or Designation, and provide values for these attributes.

Cancel Cancels your entries on this form.

Add Adds the new Device Registration operator to the Local Users list view.

Table 264: Add Local User Form in Policy Manager(Continued)

Managing a Device Registration Operator’s Devices
The Device Registration operators you create can log in to ClearPass Guest to register their devices on their
local network. Their view of the Guest user interface only includes the Create Device and Manage Devices
pages.

Device Registration operators can create and manage multiple device accounts. Options include editing,
printing details, disabling, and deleting accounts.

To work with Device Registration devices, log in to ClearPass Guest as a Device Registration operator. The
Manage Devices list view opens.

Figure 409 The Manage Devices List View
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All devices that have been registered for the user are included in the list. You can click a device account's row in
the list for additional options:

Field Description

Edit Lets you edit any of a device account's attributes. The Edit Device form opens. The process for editing a
device account is the same as for creating the account. For more information, see "Registering a Device
Registration Operator’s Devices " on page 567.

Print Lets you print a copy of the device account's details. The Account Details form opens and includes print
options.

Remove Lets you disable or delete a device account. A confirmation dialog opens. You may specify either
Disable or Delete, and then click Make Changes. To enable a disabled account, click its Activate link.

Table 265: Manage Devices List View

Registering a Device Registration Operator’s Devices
The Register Device form is used by Device Registration operators to create their device accounts on their
local network. There is no limit to the number of accounts a Device Registration operator can create, and no
expiration time is set on device accounts.

To register a Device Registration device, log in to ClearPass Guest as a Device Registration operator and go to
Guest > Create Device. The Register Device form opens.
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Figure 410 The Register Device Form

The default Register Device form is described here. ClearPass administrators can customize this form with
additional fields.

Field Description

MAC Address (Required) The MAC address of the device is prepopulated for the user. This is enabled in the
Mobility Controller. For more information, see "Automatically Supplying the Device Address" on
page 569.

Device Name Name for the device.

Device Type The type of device (computer, printer, or other device type). This value is prepopulated if
detected.

Device
Platform

The device platform (Windows, Mac, Linux, or Android platform, and whether it is a mobile
phone). This value is prepopulated if detected.

Browser
Vendor/Version

The vendor and version of the browser (Internet Explorer, Google Chrome, Mozilla Firefox, or
other browser). This value is prepopulated if detected.

Enabled By The sponsoring operator's name.

Create MAC Registers the device and creates the account. The device account is included in the Manage
Devices list, and can be shared with the operator's other registered devices.

Table 266: Register Device Form

About MAC Addresses

A MAC address is a number that uniquely identifies your device's network interface. A MAC address is
sometimes referred to as an Ethernet hardware address (EHA), hardware address, or physical address.

MAC addresses are usually formatted as twelve characters grouped in pairs separated by either colons or
hyphens. They may consist of only number pairs, or include number pairs and letter pairs, and in some cases
do not include separators—for example:

00:11:22:33:44:55

00-11-22-33-44-55

11:22:33:AA:BB:CC

112233AABBCC

If for some reason the Mac Address field on the Register Device form is not prepopulated, you might need
to find your device's address. Methods for finding the MAC address differ according to the type of device and
operating system. Due to the variety of devices, these methods cannot all be described here, but they are easy
to find on the Internet. An Internet search for "mac address" will return a number of pages describing how to
quickly find MAC addresses for different device types.
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Automatically Supplying the Device Address
To ensure that the MAC address, device type, and browser vendor/version are prepopulated on the Register
Device form, verify that these options are set in the Mobility Controller.

To set Device Registration prepopulating options:

1. Log in to the Mobility Controller.

2. In the Configuration tab, go to Security > Authentication in the left menu.

3. Click the L3 Authentication tab, and then choose Captive Portal Authentication Profile > cpg-qa-
captiveportal.

4. On the form, select the check box in the Add switch IP address in the redirection URL row.

Figure 411 Setting Device Registration Prepopulation Options in the Mobility Controller

API Services

API Services includes all APIs and API-related privileges that are available for ClearPass Guest. To work with API
services, go to Administration > API Services.

This section includes:

l "API Clients" on page 570

l "Configuring the API Framework Plugin" on page 652

l "Setting API Privileges in Operator Profiles" on page 575

l "About OAuth" on page 576

l "SOAP Web Services and API" on page 580
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l "The XML-RPC Interface and API" on page 607

API Clients

You can create and manage multiple API clients. You may configure each API client's operator profile, grant
type, refresh token, and other information.

The API Framework plugin provides API services. To configure the plugin, see "Configuring the API Framework
Plugin" on page 652.

To work with API clients, go to Administration > API Services > API Clients. The API Clients list view opens.

Figure 412 The API Clients List View

All API clients that have been created are included in the list. You can click an API client's row in the list for
additional options:

Field Description

Edit Lets you edit theAPI client's attributes. The Edit API Client form opens. For more
information, see "Creating and Editing API Clients" on page 571.

Disable Disables the API client. You will be asked to confirm the action. Disabling an API client also
invalidates any access tokens, refresh tokens, or authorization codes associated with it.

Enable Enables a disabled API client.

Delete Deletes the API client. You will be asked to confirm the deletion.

Generate Access
Token

Generates a new access token. The form expands to show details, including its HTTP
authorization, expiration, and syntax. This option is only available if Client credentials
was selected as the grant type for the client.

Create API Client Opens the Create API Client form. For more information, see "Creating and Editing API
Clients" on page 571.

Revoke all access
tokens

Opens the Revoke All Access Tokens form. For more information, see "Revoking All
Access Tokens" on page 571.

API Explorer Opens the API Explorer. For more information, see "API Explorer" on page 574.

API sample code on
GitHub

Opens Aruba's sample code page of GitHub. GitHub is an external, third-party platform
for hosting and sharing code. You can use this page to access ClearPass API sample code.

Table 267: API Clients List Options
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Figure 413 Generate Access Token Details View

Revoking All Access Tokens

In the event of security concerns (for example, if malicious activity is suspected), a link on the API Clients page
lets you revoke all access tokens.

To revoke all access tokens, click the Revoke all access tokens link at the top of the API Clients page. The
Revoke All Access Tokens form opens and asks you to confirm the revocation.

Figure 414 Revoke All Access Tokens Confirmation Form

If you select the Confirm check box and click the Revoke Access Tokens button, all OAuth access tokens
that were previously issued are revoked (except for those that are allocated to extensions). Clients must
reauthenticate in order to continue using API requests. Until they reauthenticate, they will get “403 Forbidden”
errors due to the revoked access tokens.

After revocation, a message stating the number of revoked tokens is displayed at the top of the API Clients
page.

Creating and Editing API Clients

To create or edit an API client, go to Administration > API Services > API Clients and either click the Edit
link for an API client in the list, or click the Create API client link in the upper-right corner. The Edit API Client
or Create API Client form opens. The procedure is the same for both forms.
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Figure 415 The Create API Client Form

Field Description

Client ID (Required) Name for the API client. Enter a unique string.
(Use this value in the OAuth2 client_id parameter)

Description Additional information or comments about the API client.

Enabled If selected, enables the API client.

Operator Profile (Required) Specifies the role that can access this API client, and determines which API
objects and methods are available. Options include:
l API Guest Operator
l BYOD Operator
l Device Registration
l Help Desk
l Network Administrator
l Null Profile
l Operations and Marketing
l Read-only Administrator
l Receptionist
l Super Administrator

Table 268: Create API Client
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Field Description

Grant Type (Required) Specifies the OAuth2 grant type authentication method to be used with this API
client ID. Only the selected authentication method will be allowed. Options include:
l Client credentials (grant_type=client_credentials)
l Username and password credentials (grant_type=password)

Public Client If selected, the API client will be a public (trusted) client, and will not require a client secret.

Refresh Token If selected, an OAuth2 refresh token may be used to obtain an updated access token.
(Use grant_type=refresh_token)

Client Secret If a client secret is required, it is displayed in this field. Record this value for reference.
When the API client is created, this value is encrypted and cannot be displayed again. When
you edit an existing API client, this field includes the option to generate and display a new
secret.
(Use this value in the OAuth2 client_secret parameter)

Access Token
Lifetime

Specifies the lifetime of the OAuth2 access token. Enter a number in the first text field, and
use the drop-down list to indicate the unit of time. Options include:
l seconds
l minutes
l hours
l days
l weeks

Refresh Token
Lifetime

Specifies the lifetime of the OAuth2 refresh token, if one was specified. Enter a number in
the first text field, and use the drop-down list to indicate the unit of time. Options include:
l seconds
l minutes
l hours
l days
l weeks

Create API Client Creates the API client. It is included in the API Clients list view.

Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2702



API Explorer
The API Explorer provides access to various APIs used for configurations in Guest and Onboard. To see the
APIs, go to Administration > API Services > API Clients and click the API Explorer link. The API Explorer
opens.

The APIs in the Explorer use REST semantics, and OAuth2 for authentication and authorization. All information
for the REST APIs is provided in the API Explorer itself: It lists all ClearPass REST APIs that are currently
implemented, including documentation and built-in tools that allow you to try them out.

Figure 416 The API Explorer’s Top-Level Index Page

The Explorer includes the following APIs:

l ApiFramework

l Authentication

l Certificates

l Dictionaries

l DigitalPass

l Events

l Extension

l ExternalServers

l GuestManager

l Identity

l Insight

l MessagingServices

l Network

l Onboard

l OnGuard

l OperatorLogins

l Platform

l SmsServices

l UsersAndPrivileges

ClearPass Guest 6.7 | User Guide Administration | 574
Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2703



575 | Administration ClearPass Guest 6.7 | User Guide

Setting API Privileges in Operator Profiles
To use ClearPass Guest's API services, the API privileges must be set up in the user's operator profile. Existing
operator profiles that have the Administrator privilege set to Full Access must be updated to specifically include
the appropriate privilege in order for XML-RPC clients to work.

To set up API privileges:

1. Go to Administration > Operator Logins > Profiles, and either click the Edit link for an existing profile in
the list or click the Create a new operator profile link to create a new profile. The Operator Profile
Editor form opens.

Figure 417 The Operator Profile Editor Form

2. In the Privileges field, select Custom in the API Services drop-down list. The field expands to show the
API privileges. Privileges included here are:

l Allow API Access

l Configure SOAP Web Services (Legacy)

l List SOAP Web Services (Legacy)

l Manage API Clients

l SOAP API (Legacy)

l XMLRPC API (Legacy)

3. For the Allow API Access privilege, select the Allow Access radio button.

4. For each of the remaining privileges in the list, select the appropriate access level. Access levels include:

l No Access

l Read Only
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l Full

l Allow Access

5. If you want to allow the API operator profile to query for Guest Manager configuration settings, set the
Manage Customization privilege to Read Only access.

6. Complete the rest of the settings appropriately for the operator profile and then click Save Changes. For
more information, see "Creating an Operator Profile" on page 686.

About OAuth
The OAuth 2 RFC 6749 specification for accessing a new set of modern API’s is supported by ClearPass 6.4 and
later. All OAuth2 requests MUST use the SSL endpoint available at https://<ClearPass IP or
FQDN>/api/oauth.

OAuth 2.0 is a simple and secure authorization framework. It allows applications to acquire an access token for
ClearPass through a variety of workflows supported within the OAuth2 specification. After an application has
an access token, it can access the various APIs serviced by ClearPass either to configure the platform itself or
act on behalf of a ClearPass Operator. To use OAuth for authorization:

l Decide on the use case for API Access — Either ClearPass administrative configuration, or managing
ClearPass data on behalf of a ClearPass Operator (Guest Management, Onboarded devices, Device
Registration etc).

l Create a ClearPass API Client definition that matches the use case above — Either Service Account (client
credentials) or Authorized User Account (resource owner password), respectively.

l Request an Access Token using the Client ID details from the ClearPass API client definition created in the
previous step.

l Make authorized API calls to the ClearPass APIs by including the Bearer <access_token> in the HTTP
Authorization header.

This section includes:

l "OAuth Basics" on page 576

l "OAuth2 Client or App for OAuth" on page 577

l "Client ID and Secret for OAuth" on page 577

l "Redirect URI" on page 577

l "Anti-Forgery State Token for OAuth" on page 577

l "Authorization Grant Types for OAuth" on page 578

l "Application Service Accounts for OAuth" on page 579

OAuth Basics

The best way to understand the different use cases for OAuth2 is to start with the various roles that make up a
possible OAuth2 transaction.

Resource Owner

The resource owner is the person or application that owns the data that is to be shared. For example, a user on
Facebook or Twitter could be a resource owner, in the same way as an Operator on ClearPass. The resource
they own is their data. Typically the resource owner is thought of as a person but it could also be an
application. The OAuth 2.0 specification supports different workflows for each of these use cases.
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Resource Server

The resource server is the server hosting the resources. For example, either a platform such as Facebook or a
ClearPass appliance could be considered a resource server. It is essentially the server hosting the protected
content that will be accessed via the APIs.

Client Application

The client application is the application requesting access to the protected resources stored on the resource
server.

Authorization Server

The authorization server authorizes the client application to access the resources of the resource owner. The
authorization server and the resource server can be deployed as part of the same server, but the OAuth 2.0
specification does not dictate whether they should be co-located or separated. For simplicity, the rest of this
document assumes the resource server and authorization server are co-located on the same server.

OAuth2 Client or App for OAuth

Before any OAuth transactions can be processed, the first step is to register a new app with the service (API
Client definition in ClearPass). When you register a new app with the Authorization Server, you specify basic
information such as the application name and the OAuth2 grant type. Depending on the grant type selected, a
redirect URI may also be requested in order to whitelist the redirect destination for OAuth2 workflows that are
initiated from Web server, browser-based, or mobile apps.

The output of registering an OAuth2 app is a client id and client secret.

Client ID and Secret for OAuth

After you register your app, you will receive a client ID and a client secret. The client ID is considered public
information, and is used to build login URLs, or is included in JavaScript source code on a page. The client secret
must be kept confidential. If a deployed app such as JavaScript or native apps cannot keep the secret
confidential, then the secret is not used.

Redirect URI

During registration of the new OAuth app, often a redirect URI must be included. This redirect URI is used when
a resource owner grants authorization to the client application. When a resource owner has successfully
authorized the client application via the authorization server, the resource owner is redirected back to the client
application, to the redirect URI. It is important to maintain the redirect URI accurately as this forms a key
security mechanism of OAuth2 to whitelist the redirect destination and avoid hi-jacking of the authorization
workflow, as publicized in articles such as http://tetraph.com/covert_redirect/oauth2_openid_covert_
redirect.html.

Anti-Forgery State Token for OAuth

To protect the security of your users by preventing request forgery attacks, the client app should create an
anti-forgery state token. The first step is to create a unique session token that holds state between your app
and the user's client. The app later match this unique session token with the authentication response returned
by the Authorization server to verify that the user is making the request, and not a malicious attacker. These
tokens are often referred to as cross-site request forgery (CSRF) tokens.
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Authorization Grant Types for OAuth

OAuth 2 provides several "grant types" for different use cases. ClearPass supports the following defined grant
types:

l Password— For logging in with a username and password

l Client credentials— For application access

Resource Owner Password Grant Type

OAuth 2 also provides a password grant type, which can be used to exchange a username and password for an
access token directly. This is often compared with HTTP basic authentication because the same credentials are
being exchanged, but it has the same security benefits as the other OAuth2 grant types in expiring the access
token and the ability to refresh the access token without the need to cache or resubmit the user credentials.

Since this requires the application to natively collect the user's credentials, this grant type should only be used
for apps with a direct relationship (first party) with the authorization server. A real world example would be the
official mobile app for a social networking site versus allowing 3rd party developers to leverage APIs to develop
their own mobile experience for the social platform (they should be leveraging the Implicit flow).

The following diagram shows the transaction flow of password grant type.

Figure 418 Password Grant Type Transaction Flow

1. The user enters credentials directly into the app’s native user interface. The app should not cache user
credentials under any circumstances.

2. The app submits the user credentials to the authorization server. Credentials include grant_
type=password, user, password, client_id, and client_secret. The client_secret is not
required if the OAuth2 app is defined as a public client.

3. The resource server returns the access token to use in subsequent API calls. This includes access_token,
expiry time, token_type=bearer, and refresh_token.

4. The app includes the access token in the HTTP Authorization header. This includes the Bearer access_
token.

5. The resource server returns the authenticated API payload.

ClearPass Guest 6.7 | User Guide Administration | 578
Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2707



579 | Administration ClearPass Guest 6.7 | User Guide

Client Credentials Grant Type

The simplest grant type offered by OAuth2 doesn’t include a 3rd party user at all and is essentially intended for
server-to-server integrations for updating the application server configuration. In this case, applications need a
way to get an access token for their own user and need to do this outside the context of any specific user.
OAuth provides the client credentials grant type for this purpose.

Given the simplicity of this grant type, many developers may use its basic workflow to recover an access token
so they can quickly get started with the APIs. That being said, client credentials should never be used in
production where an untrusted 3rd party developer has access to the client secret.

The following diagram shows the transaction flow of the client credentials grant type.

Figure 419 Credentials Grant Type Transaction Flow

1. The first-party app submits an access token request to the authorization server. This includes grant_
type=client_credentials, client_id, and client_secret.

2. The resource server returns the access token to use in subsequent API calls. This includes access_token,
expiry time, and token_type=bearer.

3. The app includes the access token in the HTTP Authorization header. This includes Bearer access_token.

4. The resource server returns authenticated API payload.

Revoking Access Tokens

In the event of security concerns (for example, if malicious activity is suspected), a link on the API Clients page
lets you revoke all access tokens. For more information, see "Revoking All Access Tokens" on page 571.

Application Service Accounts for OAuth

Google APIs such as the Prediction API and Google Cloud Storage can act on behalf of your application without
accessing user information. In these situations your application needs to prove its own identity to the API, but
no user consent is necessary. Similarly, in enterprise scenarios, your application can request delegated access to
some resources.
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For these types of server-to-server interactions you need a service account, which is an account that belongs to
your application instead of to an individual end-user. Your application calls Google APIs on behalf of the service
account, and user consent is not required. (In non-service-account scenarios, your application calls Google APIs
on behalf of end-users, and user consent is sometimes required.)

SOAP Web Services and API

SOAP Web Services provide a way of transferring data across the Internet to integrate Web-based applications.
Web services let businesses share data and processes programmatically, and can be added to a user interface
to provide functionality.

To access this feature in ClearPass Guest, you must have the SOAP Web Services plugin installed.

Viewing Available Web Services
To view the Web services available in ClearPass Guest:

1. Go to Administration > API Services > SOAP Web Services. The SOAP Web Services list opens.

Figure 420 The SOAP Web Services List

2. To view details for a service, click its image in the Web Service field. The form expands to include the
Service URL and Service Info fields for that Web service.
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Figure 421 The SOAP Web Services List with a Service Selected

3. The Service Info field briefly describes the processes this Web service provides. In the Service URL field,
you can click the link to view the Web Service Description Language (WSDL) that defines that service. The
WSDL opens in a new tab.

Figure 422 The Web Service Description Language (WSDL) for a Service

4. When you have finished reviewing the available Web services, click Done.
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SOAP API Introduction

The SOAP interface is available to third-party applications that will integrate with the ClearPass Guest Manager
appliance.

Audience

This API is intended for developers of applications that must interoperate with a ClearPass Guest-based guest
management solution. Solution developers are assumed to be familiar with HTTP-based Web services and the
associated concepts and technologies related to these services, including Extensible Markup Language (XML),
XML Schemas, Web Service Definition Language (WSDL), and the Simple Object Access Protocol (SOAP).

Many software development tools provide assistance with Web services integration. While this document
cannot cover all possible integration methods, examples are given using Microsoft Visual C# 2008.

API Documentation Overview
l "About the SOAP API" on page 582 provides a high-level overview of the API, explaining what it is and how

to use it.

l "Integration Example" on page 587 provides an integration example to demonstrate the usage of SOAP
Web Services.

l "API Documentation" on page 592 contains a detailed list of the available API calls, including documentation
about each method defined by the web services.

Disclaimer

The topics of network design, security architectures, and guest access are complex subjects, and no single
document can hope to cover all of the possible combinations of network equipment, network design,
deployment requirements, and device configurations, nor can all the possible security implications for a
particular recommendation be covered. Therefore, while you read this document, it is best to consider it as a
guide to developing your own understanding of the network design topics covered, and as a basis for further
investigation.

About the SOAP API

The ClearPass Guest SOAP API provides direct access to the underlying functionality of ClearPass Guest.
Developers wishing to provide integrated applications can make use of this API to programmatically perform
actions that would otherwise require manual operation of the user interface.

Architecture Overview

The ClearPass Guest software is built using multiple layers:
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Figure 423 Layers of Software in ClearPass Guest

l At the lowest level, the kernel provides basic functions common to the entire system. This includes the Web
interface framework, appliance operating system, and runtime support services.

l The network layer provides critical networking support, including the RADIUS server and the ability for
network administrators to manage and control the networking aspects of the appliance.

l The services layer provides one or more implementations of application services that are used by the layers
above. Examples of these services include managing a user database used for AAA, handling the
authentication of operators, and providing translated text resources.

l The presentation layer supplies the tools and framework necessary for the appliance software to interact
with the outside world. The basic presentation layer services include authentication checks, session
establishment, input checking, validation and conversion, and command execution. Both SOAP and HTML
presentation methods are supplied, which adapt the underlying basic presentation to appropriate
conventions suitable for a machine-to-machine or human-to-machine interaction.

l The application layer provides the page templates, business logic, and the concrete features making up
guest management applications such as Guest Manager or Hotspot Manager. These applications are built
using the services provided by the lower layers.

Authentication and Access Control

SOAP API requests require that operator authentication information is provided using HTTP Basic
authentication.

Page privileges are applied to SOAP authenticated sessions in the same way as the HTML user interface.
However, SOAP access also requires the SOAP API privilege to be granted.

Refer to "Using the SOAP API" on page 585 for details on creating an operator profile with suitable privileges
for SOAP API access.
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HTTP headers

When making a SOAP API request, the SOAPAction HTTP header is required. The value of this header indicates
the type of request being made.

The Content-Type header must be specified as either text/xml or the application/soap+xml MIME type.

The Authorization header must contain a valid HTTP Basic authentication string, as specified in RFC 2617.

Character Set Encoding

ClearPass Guest supports the Unicode character set, using the UTF-8 encoding. Although other character sets
are supported, it is recommended that all SOAP API requests be constructed using the UTF-8 character set, as
this eliminates the need for character set conversions while also allowing all Unicode characters to be
expressed directly.

The character set encoding of a request may be specified using the Content-Type header, for example:

Content-Type: text/xml; charset=utf-8

SOAP Faults

SOAP 1.1 defines a generalized fault response which is used to indicate that the server could not process the
body of the request. The SOAP <Fault> element contains a description of the error, which is divided into a
<faultcode> that briefly summarizes the problem, and a <faultstring> that contains a description of the
error.

Additionally, the API-specific details of the error are provided in a <details> element.

The following table lists the fault codes and corresponding descriptions that might be encountered while using
the SOAP API:

Fault Reason for Fault

Client.BadRequest Request exceeds the maximum allowable size. Increase the
maximum SOAP request size, or reduce the size of the request.

Client.Authentication Invalid username or password. Check that the credentials supplied
are correct.

Client.MethodNotFound The SOAP method request was not found.

Client.Error Another non-specific client error occurred. Check the
<faultstring> for more details.

Server.MethodNotImplemented The SOAP method requested is not implemented.

Server.Error An error occurred while attempting to convert data, or another non-
specific server error occurred. Check the <faultstring> for more
details.

Table 269: Fault Codes and Descriptions

Certain conditions might also cause errors that are not reported as a fault. These cases are typically caused by
errors in constructing the SOAP request. In these cases, a non-XML result may be returned; check the body of
the result, or the application log for details about the cause of the error.
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Using the SOAP API

This section describes how to access, configure, and debug Web Services, create a SOAP API operator, and
access the WSDL.

Accessing and Configuring SOAP Web Services

To access the SOAP Web Services user interface, go to Administration > API Services > SOAP Web
Services. Click the Configure SOAP Web Services link to make changes to system settings affecting the
SOAP API.

Figure 424 The Configure SOAP Web Services Form

SOAP Debugging

Select a higher level for the SOAP Debugging configuration option to log additional details to the application
log.

To access the application log, go to Administration > Plugin Manager > Application Log.

At the highest debugging level of 4, every SOAP request and response will be logged including full HTTP headers
and contents, which may be useful when trying to identify the exact cause of a problem.

Creating a SOAP API Operator

The SOAP API requires both authentication and authorization components.

l Authentication means that suitable credentials must be provided via the HTTP “basic” access
authentication method. A valid ClearPass Guest operator username and password must be provided.

l Authorization for the SOAP API requires that the corresponding user account has sufficient privileges to
perform the requested operation. In the ClearPass Guest role-based access control system, this requires at
a minimum that the SOAP API privilege is granted, as well as any additional privileges required for the
operation requested.

While the default administrative account will automatically gain SOAP API privileges, for security reasons it is
strongly recommended that a specific operator profile be created for use by SOAP API clients.

To create a suitable operator profile:

1. Go to Administration > Operator Logins > Profiles, and then click the Create a new operator profile
link.

2. In the Privileges list, select Custom for the API Services privilege.

3. For the Configure SOAP Web Services, List SOAP Web Services, and SOAP API privileges, choose either
No Access, Read Only, or Full.
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4. You should also select suitable permissions for the Guest Manager privilege, depending on the type of
requests that will be made.

An example profile is shown below.

Figure 425 Example Profile in the Operator Profile Editor

After you have created a suitable operator profile, create the operator login. See "Local Operator
Authentication" on page 694 and "External Operator Authentication" on page 694.

Accessing the WSDL

At Guest > Administration > API Services > Start Here, use the SOAP Web Services link to browse the
list of available Web services and obtain additional details about each one.
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Figure 426 The SOAP Web Services List

In the Web Service field, click the icon for GuestManager Web Services to view the Service URL and
additional information about the service.

If the "Allow anonymous access to WSDL" option is specified in the SOAP Web Services configuration, accessing the
WSDL through the specified Service URL does not require logging in to the ClearPass Guest user interface. For more
information, see "Configuring the SOAP Web Services Plugin" on page 674.

Integration Example

In this section, a simple console application will be developed using Microsoft Visual C# 2008 Express Edition.
The “Add Service Reference” feature of this development tool will be used to automatically create a Web service
interface which can then be used from the code.

Create a New Project

From the File menu, choose New Project.
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Figure 427 The New Project Dialog

Add Service Reference

1. In the Solution Explorer, right-click the References folder, and then click Add Service Reference.

Figure 428 Solution Explorer, Add Service Reference

2. The Add Service Reference dialog box appears. Enter the Service URL for the GuestManager Web
Services into the Address box, and click the Go button.

The WSDL is downloaded, and a list of the Web services and operations found is displayed.
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Figure 429 The Add Service Reference Dialog

3. In the Namespace text field, type in a name. This name is used to organize the automatically generated
code that interfaces with the Web service.

4. Click the OK button to create the Web service reference.

5. To browse the created classes, double-click the GuestManager service reference. The Object Browser is
displayed with the selected namespace highlighted.

Figure 430 The Object Browser

Configuring HTTP Basic Authentication

Performing a simple API call, such as the “Ping” operation described in "Operations" on page 596, can be used
to verify that the Web service is correctly configured and ready for use.

Because the SOAP API requires HTTP Basic authentication, ensure that you have a suitable operator profile and
operator login credentials, as explained in"Using the SOAP API" on page 585.
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Configuring the Web service reference to use authentication requires editing the app.config file to make two
changes:

l The mode attribute of the <security> tag must be changed to “TransportCredentialOnly”.

l The clientCredentialType attribute of the <transport> tag must be changed to “Basic”.

The updated app.config file is shown below, with the appropriate changes highlighted.

Figure 431 The Updated app.config File

Performing an API Call

This section outlines the C# code required to use the Web service.

First, add a using declaration for the namespace containing the Web services:

using SoapGuestManager.GuestManager;

The following code can now be added to invoke the Ping operation and display the result.
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Figure 432 Code to Add for Invoking the Ping Operation

When invoked, this performs the Ping operation and displays the following output:

Figure 433 Output Displayed after the Ping Operation

Securing Web Services Using HTTPS

Because HTTP Basic authentication is insecure, it is strongly recommended that the HTTPS transport be used
for all SOAP API calls.

To use HTTPS as the transport for SOAP API requests, the following changes should be made to the application
configuration file:

l The mode attribute of the <security> tag must be changed to “Transport”.

l The address attribute of the <endpoint> tag must be changed to a URL including the “https:” prefix.

The updated app.config file is shown below, with the relevant changes highlighted.
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Figure 434 The Updated app.config File

Additionally, if a self-signed certificate is being used on the remote server, you will need to provide a suitable
ServerCertificateValidationCallback implementation to validate the peer’s certificate.

The following code is a minimal implementation that accepts all server certificates without verification:

// Trust self-signed certificates

System..Net.ServicePointManager.ServerCertificateValidationCallback =

((sender, certificate, chain, sslPolicyErrors) => true);

In a production environment, it is strongly recommended that you deploy an SSL certificate that is signed by a trusted
root CA known to all parties, and use the built-in server certificate validation procedures. This will ensure the security
of the transaction cannot be compromised by a man-in-the-middle attack.

API Documentation

This section describes the following:

l "XML Namespaces" on page 592

l "SOAP Addressing" on page 593

l "Types" on page 593

l "Operations" on page 596

XML Namespaces

The XML namespace for the GuestManager Web Services is:

http://www.amigopod.com/go/GuestManager.wsdl

The table below indicates additional XML namespaces that are referenced:
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Component XML Namespace

SOAP Envelope http://schemas.xmlsoap.org/wsdl/soap/

SOAP Encoding http://schemas.xmlsoap.org/soap/encoding/

WSDL http://schemas.xmlsoap.org/wsdl/

XML Schema http://www.w3.org/2001/XMLSchema

Table 270: XML Namespaces

SOAP Addressing

Web Service Endpoint

The endpoint of the SOAP service is located at the relative URL:

soap_guestmanager.php.

This path is relative to the full Guest URL, which can be constructed using http: or https: and the fully-qualified
domain name of the ClearPass Guest appliance.

l Example: http://192.168.2.122/guest/soap_guestmanager.php

l Example: https://192.168.2.122/guest/soap_guestmanager.php (secure)

Web Service Definition

The WSDL for the web service may be accessed by appending ?wsdl to the service URL.

l Example: http://192.168.2.122/guest/soap_guestmanager.php?wsdl

Types

This section describes the types defined in the WSDL schema.

EmptyType

This type must be empty, that is, containing zero child elements.

l Example:

ErrorFlagType

The error flag indicates if the operation completed successfully.

Only the values zero (0) and one (1) are supported.

l A successful operation is indicated with:

l A failed operation is indicated with:

IdResultType

Standard result type), with an optional <id> element.
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l Example:

l Example:

IdType

Specifies a user ID. The user ID is a positive integer value, starting at 1.

l Example:

ResultType

Operations return a standard result type. The <error> flag indicates if the operation completed successfully. If
the operation failed, the <message> contains a description of the error.

l Example of a successful operation:

l Example of a successful operation with message:

l Example of an unsuccessful operation:

UserResultType

Standard result type, with an optional <user> element.

l Example of a successful operation:
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l Example of an unsuccessful operation:

UserType

The User type defines a guest account, which consists of a number of fields.

The fields available may be customized in Guest Manager. Go to Guest Manager > Configuration > Fields
to create new fields or modify existing fields.

Adding or removing fields will update the UserType schema in the WSDL for GuestManager Web Services. Ensure
that you update any clients using this WSDL if the fields are modified.

Each field of the guest account corresponds to an XML element with the same name as the field.

All fields within the UserType schema are marked as optional; however, certain operations may require that
particular fields are provided.

l Example of a user definition:
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Operations

CreateUser

Creates a new user account.

l The standard business logic for guest account creation applies to guest accounts created with the SOAP API.
For details, refer to the section “Business logic for account creation” in the ClearPass Guest User Guide, or
search for this term in the online help.

l The creator_accept_terms field must be set to the Boolean value “true” in order to create an account.

l A value for the role_id field must be specified to create a guest account. The SOAP API user must also be
permitted to create guest accounts with this role.

Example code implementing guest account creation:
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Example request for CreateUser:

Successful response:

Failure response:
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DeleteUser

Deletes a user account by ID or matching fields

l This operation deletes a single guest account that matches all of the field values specified in the user
parameter.

l Exactly one account must match; if more than one match is found, or if no match is found, an error will be
returned and no guest accounts will be deleted.

Example code implementing guest account deletion:
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Example request for DeleteUser:

Successful response:

Failure response:

EditUser
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Modifies properties of a user account by ID.

l This operation modifies the properties of a guest account to match the field values specified in the user

parameter.

l The id field must be specified to indicate the ID of the guest account to modify. This field is assigned by the
system when the guest account is created and cannot be changed.

Example code implementing guest account modification:

Example request for EditUser:
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Successful response:

Failure response:

FindUser

Returns properties of a user account by matching fields.
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l This operation locates a single guest account that matches all of the field values specified in the user

parameter.

l Exactly one account must match; if more than one match is found, or if no match is found, an error will be
returned.

l If a guest account was found, its properties will be returned in the <user> element of the result.

Example code implementing search for a guest account based on a username.

Example request for FindUser:
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Successful response:

Failure response:

GetUser

Returns properties of a user account by ID.
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l Returns a <user> element corresponding to the guest account with the specified ID.

l If the specified ID is invalid, no <user> element is returned and the <error> flag is set to 1.

Example code implementing a guest lookup operation:

Example request for GetUser:
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Successful response:

Failure response -- for example, user ID not found:

Ping

Checks that the SOAP server is alive.
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l Returns a standard result type with the message set to "pong".

Example code implementing a Ping test operation.

Example request for Ping:

Successful response:
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The XML-RPC Interface and API
This section describes the XML-RPC interface available to third-party applications that will integrate with the
ClearPass Guest Manager appliance.

Audience:

l Developers of integrated applications. Some familiarity with HTTP based web services and XMLRPC is
assumed.

l System administrators of the ClearPass Guest application.

System Requirements:

l ClearPass Guest 6.1.0 (minimum)

l XML-RPC client

For more details about XML-RPC, or to read the XML-RPC specification, visit http://xmlrpc.scripting.com/.

This section includes the following:

l "About the XML-RPC API" on page 607

l "Accessing the API" on page 610

l "Invoking the API" on page 613

l "Method Summary" on page 614

l "API Documentation" on page 614

About the XML-RPC API

The ClearPass Guest XML-RPC API provides direct access to the underlying functionality of the ClearPass Guest
Manager appliance. Developers wishing to provide integrated applications can use this API to programmatically
perform actions that would otherwise require manual operation of the user interface.

Architecture Overview

The ClearPass Guest VMA software is built using multiple layers of software.
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Figure 435 Layers of VMA Software in ClearPass Guest

At the lowest level, the kernel provides basic functions common to the entire system. This includes the Web
interface framework, appliance operating system, and runtime support services.

The network layer provides critical networking support, including the RADIUS server and the ability for network
administrators to manage and control the networking aspects of the VMA.

The services layer provides one or more implementations of application services that are used by the layers
above. Examples of these services include managing a user database used for AAA, handling the authentication
of operators, and providing translated text resources.

The presentation layer supplies the tools and framework necessary for the VMA software to interact with the
outside world. The basic presentation layer services include authentication checks, session establishment, input
checking, validation and conversion, and command execution. Both XML-RPC and HTML presentation
methods are supplied, which adapt the underlying basic presentation to appropriate conventions suitable for a
machine-to-machine or human-to-machine interaction.

The application layer provides the page templates, business logic, and the concrete features making up guest
management applications, such as Guest Manager or Hotspot Manager. These applications are built using the
services provided by the lower layers.

API Symmetry

Because ClearPass Guest VMA applications are built using the framework supplied by the presentation layer,
there is a direct symmetry between application features provided to operators using a Web browser (HTML
presentation), and application features provided to external applications using the XML-RPC presentation.

In particular, the following items are shared between HTML and XML-RPC presentations:

l Access control

l Parameter names

l Parameter validation rules

ClearPass Guest 6.7 | User Guide Administration | 608
Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2737



609 | Administration ClearPass Guest 6.7 | User Guide

l Customized fields and their rules

Access Control

Page privileges are applied to XML-RPC authenticated sessions in the same way as the HTML user interface.
However, XML-RPC access also requires the XML-RPC API privilege to be granted.

Parameter Names

The parameter names passed to the XML-RPC interface are the same as the field names in the HTML user
interface.

Parameter Validation

Each field of the forms in the HTML user interface is subject to validation according to the rules defined for that
field. The same rules also apply to XML-RPC parameters.

If a required field is missing, or an invalid value for a field is supplied, an error is generated by the presentation
layer and returned to the XML-RPC client.

Field Customization

Some forms in the HTML user interface are customizable. New fields may be defined (for example, stored with
a guest account) and used as part of the form in the presentation layer. Policy-based processing of fields
includes form validation, data conversion and input formatting, and user interface metadata (for example, the
list of valid options for a multiple-choice “dropdown” control).

These custom fields are automatically inherited as XML-RPC parameters, and the same policy-based processing
is applied to them.

Parameter Types

The XML-RPC specification supports a wide range of data types. The following data types are supported by the
XML-RPC presentation layer:

Data Type Description

Array Associative array using numeric keys with a 0-based index

Boolean True or false

Flag Scalar value of 0 or 1, implicitly Boolean

Integer Integer, 32-bit range

Number Numeric value, floating point OK

Scalar Non-array value

String String, UTF-8 encoded

Struct Associative array using string keys
May be nested (shown in the syntax as first.second, etc.)

Table 271: Data Types Supported by XML-RPC

Data Representation

Unless otherwise specified, all strings should be considered to be UTF-8 encoded Unicode.
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Dates and times are represented in an ISO-8601 compatible format:

YYYY-MM-DD hh:mm:ss

XML-RPC Faults

An XML-RPC Fault is a specific kind of return value indicating that an error has occurred in the presentation
layer. The return value is a struct containing three named values:

Name Type Description

error Flag Set to 1 for an XML-RPC Fault

faultCode Integer Status code indicating the cause of the fault

faultString String Description of the fault

Table 272: XML-RPC Faults

This type of return might appear as:

'error' => 1,

'faultCode' => 401,

'faultString' => 'Invalid username or password',

These are the predefined XML-RPC Fault codes:

Code Description

401 Authentication problem -- invalid username or password

404 File implementation of XML-RPC method not found

501 XML-RPC implementation not found

502 XML-RPC method registration failed

503 XML-RPC server creation failed

504 Access denied

505 No XML-RPC implementation for this page

Table 273: XML-RPC Faults

Accessing the API

Accessing the API requires an operator account with a profile that has the XML-RPC API privilege, plus any
privileges required for the API calls. You will first create the operator profile, and then create the role, a local
user, and a translation rule to map the role name to the profile. Some steps are performed in ClearPass Guest
and some steps are performed in ClearPass Policy Manager.

Creating the Profile

To create a sample XML-RPC API profile:

1. In ClearPass Guest, go to Administration > Operator Logins > Profiles and click the Create a new
operator profile link. The Operator Profile Editor form opens.

2. Enter a name and description that clearly identify the profile.
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3. In the Access area, select the Allow operator logins check box.

4. In the API Services drop-down list, select Custom. The row expands to include additional options.

5. For the XMLRPC API (Legacy) option, select the Allow Access radio button.

6. In the Guest Manager drop-down list, select Full Access.

Figure 436 The Operator Profile Editor Form

7. Click Save Changes. The profile is added to the Operator Profiles list.

Creating the Role

After you create the profile, the next step is to create the role:

1. In ClearPass Policy Manager, go to Configuration > Identity > Roles and click the Add link. The Add
New Role form opens.

2. Enter a name and description that clearly identify the role.
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Figure 437 The Add New Role Form

3. Click Save. The role is added to the Roles list.

Creating the Local User

After you create the role, you create the local user:

1. In Clear Pass Policy Manager, go to Configuration > Identity > Local Users and click Add. The Add
Local User form opens.

2. In the Role drop-down list, select the XML-RPC Operator role you created.

3. Complete the rest of the fields appropriately, and then click Add. The new XML-RPC operator is added to
the Local Users list.

Creating the Translation Rule

After you have created the profile, role, and local user (operator), create a translation rule to map the role name
to the operator profile.

1. In ClearPass Guest, go to Administration > Operator Logins > Translation Rules and click the
Create new translation rule link. The Edit Translation Rule form opens.
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Figure 438 The Edit Translation Rule Form

2. In the Name field, enter a descriptive name for the translation rule. In the example shown above, the
translation rule is to check that the operator is an XML-RPC user, hence the name MatchXML-RPC.

3. Select the Enabled check box to enable this rule after you create it. If you do not select this check box, the
rule you create will appear in the rules list, but will not be active until you enable it.

4. In the Matching Rule drop-down list, select equals.

5. In the Value field, enter the name of the XML-RPC Operator role you defined.

6. In the On Match drop-down list, select Assign fixed operator profile. The form expands to include the
Operator Profile row.

7. In the Operator Profile drop-down list, select the XML-RPC profile.

8. If you want to use multiple translation rules, select the Fallthrough check box.

9. Click Save Changes.

The user you created can now use the XML-RPC API functions.

Invoking the API

An XMLRPC method call consists of:

l An XML document specifying the method name and parameters,

l sent as a HTTP POST with Content-Type: text/xml,

l using HTTP Basic user authorization,

l at https://amigopod/xmlrpc.php
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SSL Security

Different levels of certificate validation checks may be necessary, depending on the SSL certificate that has
been installed. This corresponds to the user interface provided by Web browsers for certificate trust and
verification.

The examples presented in this document assume a self-signed certificate has been installed, and reduce the
level of SSL verification accordingly. In a secure environment, make use of the peer verification that SSL
provides by either installing an SSL certificate signed by a well-known Certificate Authority, or issue your own
certificates from a network’s Certificate Authority.

Method Summary

These methods are currently available:

Method Name Synopsis

amigopod.guest.change.expiration Change the expiration time of a guest account

amigopod.guest.create Create a new guest account

amigopod.guest.delete Disable or remove a guest account

amigopod.guest.edit Change one of more properties of a guest account

amigopod.guest.enable Enable a guest account

amigopod.guest.get List one or more guest accounts

amigopod.guest.list List guest accounts

amigopod.guest.reset.password Reset a guest account's password

amigopod.mac.create Create a new MAC device account

amigopod.mac.edit Change one or more properties of a device account

amigopod.mac.list List MAC device accounts

Table 274: XML-RPC Method Summary

For more details on these methods, refer to "API Documentation" on page 614.

API Documentation

This section describes the following methods:

l "Method amigopod.guest.change.expiration" on page 615

l "Method amigopod.guest.create" on page 616

l "Method amigopod.guest.delete" on page 617

l "Method amigopod.guest.edit" on page 619

l "Method amigopod.guest.enable" on page 621

l "Method amigopod.guest.get" on page 622

l "Method amigopod.guest.list" on page 624

l "Method amigopod.guest.reset.password" on page 625
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l "Method amigopod.mac.create" on page 626

l "Method amigopod.mac.edit" on page 628

l "Method amigopod.mac.list" on page 631

Method amigopod.guest.change.expiration

Change the expiration time of a guest account.

Parameters

Name Type Description

uid Scalar ID of the guest account to update

guestaccountexpiry Scalar Amount of time in hours before the guest account will expire

Table 275: Parameters, amigopod.guest.change.expiration

Return Values

Name Type Description

error Flag 0 if successful, 1 if an error occurred

message String Status message describing the operation

item Struct Updated user information record

*_error String Field-specific error message

*_error_flag Flag Field-specific error flag, set to 1 if present

Table 276: Return Values, amigopod.guest.change.expiration

Access Control

Requires the change_expiration privilege (Guest Manager > Change Expiration in the Operator Profile
Editor).

Example Usage

Sample parameters for the call:
'uid' => 162,

'guestaccountexpiry' => 24,

Result returned by a successful operation:
'error' => 0,

'message' => 'Changed expiration time of guest account

Account will expire at 2014-11-28 23:27:00',

'item' => array (

'id' => 162,

'do_expire' => 4,

'expire_time' => 1196256420,

'username' => '',

)

Result returned by a failed operation:
'uid' => 162,

'username' => '',

'expiration_time' => '',
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'user_enabled' => '',

'guestaccountexpiry_error' => 'Please choose from one of these options.',

'guestaccountexpiry_error_flag' => 1,

'error' => 1,

Method amigopod.guest.create

Create a new guest account.

Parameters

Name Type Description

sponsor_name String Name of the person sponsoring the
guest account.

visitor_name String Name of the guest.

visitor_company String Company name of the guest.

email String The guest's email address. This will
become their username to log in to
the network.

expire_after Numeric Amount of time before the account
will expire. Specified in hours.

expire_time String Optional date and time at which the
guest account will expire.

role_id Integer RADIUS role ID to assign to the guest
account.

creator_accept_terms Flag Set to 1 to indicate acceptance of the
service's terms of use.

* * Other fields as specified by create_
user form customization.

Table 277: Parameters, amigopod.guest.create

Return Values

Name Type Description

error Flag Set to 1 if the guest account was not
created

id Integer Set to the ID of the guest account if
the account was created

password String Set to a randomly-generated value
(default behavior only)

*_error String Field-specific error message

*_error_flag Flag Field-specific error flag, set to 1 if
present

Table 278: Return Values, amigopod.guest.create
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Access Control

Requires the create_user privilege (Guest > Create Guest Account in the Operator Profile Editor).

Example Usage

Sample parameters for the call:
'sponsor_name' => 'Sponsor Name',

'visitor_name' => 'Visitor Name',

'visitor_company' => 'Visitor Company',

'email' => 'demo@example.com',

'expire_after' => 4,

'expire_time' => '',

'role_id' => 2,

'visitor_phone' => '0',

'creator_accept_terms' => 1,

Result returned by a successful operation:
'username' => 'demo@example.com',

'password' => '73067792',

'role_id' => 2,

'role_name' => 'Guest',

'simultaneous_use' => '1',

'do_schedule' => 0,

'enabled' => true,

'expire_time' => 1196769257,

'do_expire' => 4,

'expire_postlogin' => 0,

'sponsor_name' => 'Sponsor Name',

'visitor_name' => 'Visitor Name',

'visitor_company' => 'Visitor Company',

'email' => 'demo@example.com',

'creator_accept_terms' => true,

'id' => 1,

Result returned by a failed operation:
'password' => 78342029',

'expire_time' => '',

'submit' => '',

'sponsor_name_error' => 'You cannot leave this field blank.',

'sponsor_name_error_flag' => 1,

'visitor_name_error' => 'You cannot leave this field blank.',

'visitor_name_error_flag' => 1,

'visitor_company_error' => 'You cannot leave this field blank.',

'visitor_company_error_flag' => 1,

'email_error' => 'Please enter a valid email address.',

'email_error_flag' => 1,

'expire_after_error' => 'Please choose from one of the available options.',

'expire_after_error_flag' => 1,

'expire_time_error' => 'Please enter a valid date and time.',

'expire_time_error_flag' => 1,

'role_id_error' => 'Parameter must be provided.',

'role_id_error_flag' => 1,

'creator_accept_terms_error' => 'You must accept the terms of use to continue.',

'creator_accept_terms_error_flag' => 1,

'error' => 1,

Method amigopod.guest.delete

Disable or remove a guest account.

Parameters
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Name Type Description

uid Integer ID of the guest account to delete

delete_account Flag Set to 0 to disable the guest account,
1 to delete the guest account

Table 279: Parameters, amigopod.guest.delete

Return Values

This function might return a Boolean false value if some input parameters are invalid.

Name Type Description

error Flag Set to 1 if the guest account was not
deleted

message String Message describing the success or
failure of the operation

item Struct User structure containing updated
field values

uid Integer ID of the guest account

*_error String Field-specific error message

*_error_flag Flag Field-specific error flag, set to 1 if
present

Table 280: Return Values, amigopod.guest.delete

Access Control

Requires the remove_account privilege (Guest Manager > Remove Accounts in the Operator Profile
Editor).

Example Usage

Sample parameters for the call:
'uid' => '162',

'delete_account' => '0',

Result returned by a successful operation:
'error' => 0,

'message' => 'Disabled guest account ',

'item' =>

array (

'id' => 162,

'enabled' => 0,

'username' => '',

),

Result returned by a failed operation:
'uid' => 162,

'username' => '',

'expiration_time' => '',

'user_enabled' => '',

'delete_account_error' => 'Please choose from one of these options.',
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'delete_account_error_flag' => 1,

'error' => 1,

Method amigopod.guest.edit

Change one of more properties of a guest account.

Parameters

Name Type Description

uid Integer ID of the guest account to edit

username String Name of the guest account

password String May be:
random_password to indicate the
guest account's password should be
set to a random password
password_value to indicate the
guest account's password should be
set to the value in the password_
value field
The empty string to leave the
password unmodified

password_value String Optional password to set the guest
account's password (if the password
field is password_value)

role_id Integer RADIUS role ID to assign to the guest
account

enabled Flag Boolean value indicating whether the
guest account is enabled

simultaneous_use Integer Number of simultaneous sessions
allowed by the guest account

do_schedule Flag Flag indicating if the guest account
should be enabled at schedule_time

schedule_time String Date and time at which the guest
account will be enabled

do_expire Integer Action to take when the expire_time
is reached

expire_time String Time at which the guest account will
expire

expire_postlogin Integer Time period for which the guest
account will be valid after the first
login, or 0 for indefinitely

Table 281: Parameters, amigopod.guest.edit
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Return Values

Name Type Description

error Flag Set to 1 if the guest account was not
modified

message String Message describing the success or
failure of the operation

item Struct User structure containing updated
field values

uid Integer ID of the guest account

*_error String Field-specific error message

*_error_flag Flag Field-specific error flag, set to 1 if
present

Table 282: Return Values, amigopod.guest.edit

Access Control

Requires the full_user_control privilege (Guest Manager > Full User Control in the Operator Profile
Editor).

Example Usage

Sample parameters for the call:
'uid' => 162,

'username' => 'demo@example.com',

'password' => 'password_value',

'password_value' => 'password',

'role_id' => 2,

'enabled' => 1,

'simultaneous_use' => 1,

'do_schedule' => 0,

'schedule_time' => '',

'do_expire' => 4,

'expire_time' => '2014-12-01 00:00:00',

'expire_postlogin' => 0,

Sample successful call:
'error' => 0,

'message' => 'Edited properties of guest account demo@example.com',

'item' =>

array (

'id' => 162,

'username' => 'demo@example.com',

'role_id' => 2,

'enabled' => true,

'simultaneous_use' => 1,

'do_schedule' => 0,

'do_expire' => 4,

'expire_postlogin' => 0,

'role_name' => 'Guest',

'expire_time' => 1196431200,

),
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Sample failed call:
'uid' => 162,

'random_password' => '59447116',

'password_value' => '',

'schedule_time' => '',

'expire_time' => '',

'user_enabled' => '',

'username_error' => 'You cannot leave this field blank.',

'username_error_flag' => 1,

'password_error' => 'Please choose from one of the available options',

'password_error_flag' => 1,

'role_id_error' => 'Please choose from one of the available options',

'role_id_error_flag' => 1,

'enabled_error' => 'Parameter must be provided',

'enabled_error_flag' => 1,

'simultaneous_use_error' => 'Please enter a non-negative integer value.',

'simultaneous_use_error_flag' => 1,

'do_schedule_error' => 'Please choose from one of the available options',

'do_schedule_error_flag' => 1,

'schedule_time_error' => 'Parameter must be a string',

'schedule_time_error_flag' => 1,

'do_expire_error' => 'Please choose from one of the available options',

'do_expire_error_flag' => 1,

'expire_time_error' => 'Parameter must be a string',

'expire_time_error_flag' => 1,

'expire_postlogin_error' => 'Please choose from one of the available options',

'expire_postlogin_error_flag' => 1,

'error' => 1,

Method amigopod.guest.enable

Enable a guest account.

Parameters

Name Type Description

uid Integer ID of the guest account to enable

Table 283: Parameters, amigopod.guest.enable

Return Values

This function might return a Boolean false value if some input parameters are invalid.

Name Type Description

error Flag Set to 1 if the guest account was not
enabled

message String Message describing the success or
failure of the operation

item Struct User structure containing updated
field values

Table 284: Return Values, amigopod.guest.enable
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Name Type Description

uid Integer ID of the guest account

*_error String Field-specific error message

*_error_flag Flag Field-specific error flag, set to 1 if
present

Table 284: Return Values, amigopod.guest.enable(Continued)

Access Control

Requires the remove_account privilege (Guest Manager > Remove Accounts in the Operator Profile
Editor).

Example Usage

Sample parameters for the call:
'uid' => '162',

Sample successful call:
'error' => 0,

'message' => 'Guest account has been re-enabled',

'item' =>

array (

'id' => 162,

'enabled' => 1,

'username' => '',

),

Sample failed call:
'error' => 1,

'message' => 'Account not found: ID 162',

Method amigopod.guest.get

List one or more guest accounts.

Parameters

Name Type Description

id Integer Array Retrieve a single guest account by ID
(integer parameter), or multiple
guest accounts by ID (array
parameter)

Table 285: Parameters, amigopod.guest.get
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Return Values

Name Type Description

id Mixed ID or IDs of the guest accounts being
returned

users Array l If a single ID was requested,
users contains the guest account
requested (or an error field if an
error occurred)

l If multiple IDs were requested,
users contains an array of results

Table 286: Return Values, amigopod.guest.get

Access Control

Requires the guest_users privilege (Guest Manager > List Guest Accounts in the Operator Profile Editor).

Example Usage

Sample parameters:
'id' => array(150, 162)

Sample successful call:
'id' =>

array (

0 => 150,

1 => 162,

),

'users' =>

array (

0 =>

array (

'id' => '150',

'username' => '44454318',

'enabled' => '1',

'role_id' => '2',

'email' => '',

'notes' => 'GuestManager account 22 of 30 created by root from 192.168.2.3',

'do_expire' => '0',

'expire_time' => '',

'simultaneous_use' => '1',

'expire_postlogin' => '0',

'do_schedule' => '0',

'schedule_time' => '',

'ip_address' => '',

'netmask' => '',

),

1 =>

array (

'id' => '162',

'username' => 'demo@example.com',

'enabled' => '1',

'role_id' => '2',

'email' => 'demo@example.com',

'notes' => '',

'do_expire' => '4',

'expire_time' => '1196253480',

'simultanous_use' => '1',

'expire_postlogin' => '0',
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'do_schedule' => '0',

'schedule_time' => '',

'ip_address' => '',

'netmask' => '',

'auto_send_sms' => '',

'creator_accept_terms' => '1',

'role_name' => 'Guest',

'sponsor_name' => 'Sponsor Name',

'visitor_company' => 'Company Name',

'visitor_name' => 'Guest’s Name',

'visitor_phone' => '0',

),

),

Sample failed call:
'id' => 162,

'users' =>

array (

'error' => 1,

'message' => 'Account not found: ID 162',

),

Method amigopod.guest.list

List guest accounts. (To retrieve devices, see "Method amigopod.mac.list" on page 631)

Parameters

Name Type Description

details Flag Optional parameter; if set to 1 then
full details of all guest accounts are
returned, otherwise only the IDs are
returned

sort string Optional parameter. If set to 1, then
sorts first by the specified column,
and then by username. For the field_
name and +field_name formats,
sort order will be ascending (A to Z);
for the -field_name format the sort
order will be descending (Z to A).

filter string Allows searching for multiple values
when using the equality (=) or
inequality (!=) operators. For more
information, see the Filter description
in "Managing Single Guest Accounts
" on page 67.

Table 287: Parameters, amigopod.guest.list

ClearPass Guest 6.7 | User Guide Administration | 624
Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2753



625 | Administration ClearPass Guest 6.7 | User Guide

Return Values

Name Type Description

ids Array Array of guest account IDs (if details
was 0)

users Array Array of guest account structures (if
details was 1)

Table 288: Return Values, amigopod.guest.list

Access Control

Requires the guest_users privilege (Guest Manager > List Guest Accounts in the Operator Profile Editor).

Example Usage

Sample parameters:
'details' => 0,

Sample successful call:
'ids' =>

array (

0 => '37',

1 => '141',

2 => '40',

...

),

Method amigopod.guest.reset.password

Reset a guest account's password to a random value.

Parameters

Name Type Description

uid Integer ID of the guest account to reset the
password for

Table 289: Parameters, amigopod.guest.reset.password

Return Values

Name Type Description

error Flag Set to 1 if the password was not
reset

message String Message describing the success or
failure of the operation

item Struct User structure containing updated
field values

*_error String Field-specific error message

*_error_flag Flag Field-specific error flag, set to 1 if
present

Table 290: Return Values, amigopod.guest.reset.password
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Access Control

Requires the reset_password privilege (Guest Manager > Reset Password in the Operator Profile Editor).

Example Usage

Sample parameters for the call:
'uid' => 162,

Sample successful call:
'error' => 0,

'message' => 'Guest account password reset for

Password changed to 37172833',

'item' =>

array (

'id' => 162,

'password' => '37172833',

'username' => '',

),

Sample failed call:
'error' => 1,

'message' => 'Account not found: ID 162',

Method amigopod.mac.create

Create a new MAC device account.

Parameters

Name Type Description

sponsor_name String Name of the person sponsoring the
device account.

visitor_name String Name of the guest.

visitor_company String Company name of the guest.

email String The guest's email address. This will
become their username to log in to
the network.

expire_after Numeric Amount of time before the device
account will expire. Specified in
hours.

expire_time String Optional date and time at which the
device account will expire.

role_id Integer RADIUS role ID to assign to the
device account.

creator_accept_terms Flag Set to 1 to indicate acceptance of the
service's terms of use.

* * Other fields as specified by create_
user form customization.

Table 291: Parameters, amigopod.mac.create
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Return Values

Name Type Description

error Flag Set to 1 if the device account was not
created

id Integer Set to the ID of the device account if
the account was created

password String Set to a randomly-generated value
(default behavior only)

*_error String Field-specific error message

*_error_flag Flag Field-specific error flag, set to 1 if
present

Table 292: Return Values, amigopod.mac.create

Access Control

Requires the mac_create privilege (Guest Manager > Create New MAC Authentication in the Operator
Profile Editor).

Example Usage

Sample parameters for the call:
'sponsor_name' => 'Sponsor Name',

'visitor_name' => 'Visitor Name',

'visitor_company' => 'Visitor Company',

'email' => 'demo@example.com',

'expire_after' => 4,

'expire_time' => '',

'role_id' => 2,

'visitor_phone' => '0',

'creator_accept_terms' => 1,

Result returned by a successful operation:
'username' => 'demo@example.com',

'password' => '73067792',

'role_id' => 2,

'role_name' => 'Guest',

'simultaneous_use' => '1',

'do_schedule' => 0,

'enabled' => true,

'expire_time' => 1196769257,

'do_expire' => 4,

'expire_postlogin' => 0,

'sponsor_name' => 'Sponsor Name',

'visitor_name' => 'Visitor Name',

'visitor_company' => 'Visitor Company',

'email' => 'demo@example.com',

'creator_accept_terms' => true,

'id' => 1,

Result returned by a failed operation:
'password' => 78342029',

'expire_time' => '',

'submit' => '',

'sponsor_name_error' => 'You cannot leave this field blank.',

'sponsor_name_error_flag' => 1,
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'visitor_name_error' => 'You cannot leave this field blank.',

'visitor_name_error_flag' => 1,

'visitor_company_error' => 'You cannot leave this field blank.',

'visitor_company_error_flag' => 1,

'email_error' => 'Please enter a valid email address.',

'email_error_flag' => 1,

'expire_after_error' => 'Please choose from one of the available options.',

'expire_after_error_flag' => 1,

'expire_time_error' => 'Please enter a valid date and time.',

'expire_time_error_flag' => 1,

'role_id_error' => 'Parameter must be provided.',

'role_id_error_flag' => 1,

'creator_accept_terms_error' => 'You must accept the terms of use to continue.',

'creator_accept_terms_error_flag' => 1,

'error' => 1,

Method amigopod.mac.edit

Change one of more properties of a device account.

Parameters

Name Type Description

uid Integer ID of the device account to edit

username String Name of the device account

password String May be:
random_password to indicate the
device account's password should be
set to a random password
password_value to indicate the
device account's password should be
set to the value in the password_
value field
The empty string to leave the
password unmodified

password_value String Optional password to set the device
account's password (if the password
field is password_value)

role_id Integer RADIUS role ID to assign to the
device account

enabled Flag Boolean value indicating whether the
device account is enabled

simultaneous_use Integer Number of simultaneous sessions
allowed by the device account

do_schedule Flag Flag indicating if the device account
should be enabled at schedule_time

schedule_time String Date and time at which the device
account will be enabled

do_expire Integer Action to take when the expire_time

Table 293: Parameters, amigopod.mac.edit
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Name Type Description

is reached

expire_time String Time at which the device account will
expire

expire_postlogin Integer Time period for which the device
account will be valid after the first
login, or 0 for indefinitely

Table 293: Parameters, amigopod.mac.edit(Continued)

Return Values

Name Type Description

error Flag Set to 1 if the device account was not
modified

message String Message describing the success or
failure of the operation

item Struct User structure containing updated
field values

uid Integer ID of the device account

*_error String Field-specific error message

*_error_flag Flag Field-specific error flag, set to 1 if
present

Table 294: Return Values, amigopod.mac.edit

Access Control

Requires the full_user_control privilege (Guest Manager > Full User Control in the Operator Profile
Editor).

Example Usage

Sample parameters for the call:
'uid' => 162,

'username' => 'demo@example.com',

'password' => 'password_value',

'password_value' => 'password',

'role_id' => 2,

'enabled' => 1,

'simultaneous_use' => 1,

'do_schedule' => 0,

'schedule_time' => '',

'do_expire' => 4,

'expire_time' => '2014-12-01 00:00:00',

'expire_postlogin' => 0,

Sample successful call:
'error' => 0,

'message' => 'Edited properties of guest account demo@example.com',

'item' =>

array (
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'id' => 162,

'username' => 'demo@example.com',

'role_id' => 2,

'enabled' => true,

'simultaneous_use' => 1,

'do_schedule' => 0,

'do_expire' => 4,

'expire_postlogin' => 0,

'role_name' => 'Guest',

'expire_time' => 1196431200,

),

Sample failed call:
'uid' => 162,

'random_password' => '59447116',

'password_value' => '',

'schedule_time' => '',

'expire_time' => '',

'user_enabled' => '',

'username_error' => 'You cannot leave this field blank.',

'username_error_flag' => 1,

'password_error' => 'Please choose from one of the available options',

'password_error_flag' => 1,

'role_id_error' => 'Please choose from one of the available options',

'role_id_error_flag' => 1,

'enabled_error' => 'Parameter must be provided',

'enabled_error_flag' => 1,

'simultaneous_use_error' => 'Please enter a non-negative integer value.',

'simultaneous_use_error_flag' => 1,

'do_schedule_error' => 'Please choose from one of the available options',

'do_schedule_error_flag' => 1,

'schedule_time_error' => 'Parameter must be a string',

'schedule_time_error_flag' => 1,

'do_expire_error' => 'Please choose from one of the available options',

'do_expire_error_flag' => 1,

'expire_time_error' => 'Parameter must be a string',

'expire_time_error_flag' => 1,

'expire_postlogin_error' => 'Please choose from one of the available options',

'expire_postlogin_error_flag' => 1,

'error' => 1,
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Method amigopod.mac.list

List MAC device accounts. (To retrieve guest accounts, see "Method amigopod.guest.list" on page 624)

Parameters

Name Type Description

details Flag Optional parameter; if set to 1 then
full details of all device accounts are
returned, otherwise only the IDs are
returned.

sort string Optional parameter. If set to 1, then
sorts first by the specified column,
and then by username. For the field_
name and +field_name formats,
sort order will be ascending (A to Z);
for the -field_name format the sort
order will be descending (Z to A).

filter string Allows searching for multiple values
when using the equality (=) or
inequality (!=) operators. For more
information, see the Filter description
in "Managing Single Guest Accounts
" on page 67.

Table 295: Parameters, amigopod.mac.list

Return Values

Name Type Description

ids Array Array of device account IDs (if
details was 0).

users Array Array of device account structures (if
details was 1).

Table 296: Return Values, amigopod.mac.list

Access Control

Requires the mac_list privilege (Guest Manager > List MAC Authentication Accounts in the Operator
Profile Editor).

Example Usage

Sample parameters:
'details' => 0,

Sample successful call:
'ids' =>

array (

0 => '37',

1 => '141',

2 => '40',

...

),
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Data Retention

The Data Retention Policy form (Administration > Data Retention) lets you manage historical data by
deleting it.

Figure 439 The Manage Data Retention Form

1. To enable the data retention policy option, select the Enable check box, and then enter the time of day at
which records will be deleted.

2. To configure Onboard certificate retention, click the link in the Certificate Retention row. The Certificate
Authorities list in the Onboard module opens.

If you wish to configure the times after which expired accounts are deleted, refer to the ClearPass Policy
Manager documentation for cluster-wide parameters. Data retention of guest accounts and logs is configured
in Policy Manager under Administration > Server Configuration > Cluster-Wide Parameters.

Extensions Management
You can create and manage multiple ClearPass extensions. ClearPass extensions are self-contained micro-
services that can run on top of the ClearPass platform and provide access to some features that are not yet
part of the current ClearPass version. Extensions are easy to install from the ClearPass Extensions Store. In a
cluster, extensions can be installed on a subscriber independently of the publisher.

To view and work with the list of extensions and to install and configure new extensions, go to Guest >
Administration > Extensions. The Manage Extensions list view opens. All extensions that have been
installed are included in the list. Information shown for each extension includes its name, version, state
(running or stopped), hostname, and IP address.
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Figure 440 The Manage Extensions List View

You can click an extension’s row in the list for additional options:

Field Description

Name The name of the extension.

Version The version number of the extension.

State The extension’s current state, either Running or Not Running.

Hostname The hostname for the extension.

IP Address The IPv4 address used for the extension. This address will be within the network range
172.17.0.1/16.

Filter Lets you filter for an extension by name, version, state, hostname, or IP address.

Show Details Displays details for the extension such as its state, instance ID, store ID, and any content items.

Reinstall Opens the Extension Reinstall form, which lets you delete and then reinstall the extension. You
may also modify the IP address. When it is reinstalled, it retains its previous configuration and
includes any current Extension Store updates for the extension. After it is reinstalled, the
extension’s details show the time it was installed.

Delete Deletes the extension. You will be asked to confirm the deletion.

Stop Stops a running extension.

Restart Restarts a stopped extension.

Show Logs Displays log messages for extensions actions and various extension-related actions.

Configuration The form expands to include the Extension Configuration form with the extension’s current
configuration, if any. If you modify the default configuration, you must then select the Restart
extension after updating configuration check box in order to have the changes take effect,
and then click Save Changes. A progress bar is displayed while the extension is being restarted.

Install
extension

To install an extension, click this link in the list or in the upper right corner. The initial setup page
of the Install Extension form opens. See the next section, "Installing Extensions" on page 634.

Refresh Clears any filter selections and refreshes the full list of installed extensions.

Table 297: Options in the Manage Extensions List View
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Installing Extensions
The Install Extension page is used to search for and install ClearPass extensions from the Extensions Store.

Field Description

Extension The name of the extension to be installed.

Start If selected, the extension will be started automatically immediately after it is installed.

IP Address The IPv4 address to use for the extension. To specify an address, enter an IP Address
that is within the network range 172.17.0.1/16. To have an IP address automatically
assigned, leave this field empty.

Configuration Specifies the properties file to use as the default startup configuration for the extension.

Certificate Specifies the server certificate required for HTTPS termination.

Private Key Specifies the private key to associate with the server certificate.

Install Installs the extension on the current ClearPass appliance.

Table 298: Install Extension Form

To install a new ClearPass Extension:

1. Go to Administration > Extensions and click the Install Extension link in the list or in the upper-right
corner. The Install Extension form opens.

Figure 441 The Install Extension Form

2. In the Search field, enter the extension ID of the extension you wish to install, and then click Search.

3. The form expands to include the Results field, which displays the extension’s name, version, and state
(installed or not installed).

Figure 442 The Install Extension Form with Search Results Displayed

4. Click the extension’s name. The Results field expands to include the Install link.
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Figure 443 The Install Extension Form’s Install Link

5. Click the Install link. The Install Extension form now displays the extension’s name, and includes the
Start and IP Address options.

Figure 444 The Install Extension Form with IP Address Option Displayed

6. To have the extension started automatically as it is installed, select the check box in the Start field.

7. To allocate a specific IPv4 address to the extension, enter an address in the IP Address field that is within
the network range 172.17.0.1/16. To have an IP address automatically assigned, leave this field empty.

8. Click Install.

9. The extension is displayed in the Manage Extensions list view. If you selected the check box in the Start
field to have the extension automatically started, its State is shown as Running.

Some extensions might require additional configuration after installation. If this is the case, a Configuration
link is included in the extension’s row in the Manage Extensions list view.

3.9 Configuration Import

To help ClearPass Guest 3.9 customers transition to ClearPass Guest 6.x, the Import Configuration forms let
you:

l Create a full or custom backup of your Guest implementation. See "Creating a Customized Configuration
Backup" on page 636.
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l Upload a 3.9 configuration backup file to your ClearPass Guest 6.x file system, making the items in it
available for import. See "Uploading the 3.9 Backup File " on page 636.

l Select items from it to import, restoring those configurations in your ClearPass Guest 6.x system. See
"Restoring Configuration Items " on page 638

l Review details for configuration items after import, including anything that might be different between 3.9
and 6.2 and any actions you might need to take. See "Viewing Imported Item Details " on page 640 and
"Import Information for Specific Import Items " on page 642.

Creating a Customized Configuration Backup
You can use the Configuration Backup form to create and export a full or customized configuration backup
file.

To create a configuration backup:

1. Go to Administration > Import Configuration > Import Configuration, and then click the Create a
customized backup link in the upper-right corner. The Export Configuration form opens.

2. In the Backup Mode drop-down list, select either Complete backup or Custom backup, as appropriate.

3. In the Backup Name field, enter the name of the backup file.

4. If you selected Custom backup, the form expands to include the Backup Set field, which displays a list of
items to choose from. When this list first opens, all items are included by default. Categories are displayed—
for example, Guest Manager, SMS Services, and so on—and subordinate items in the categories are hidden.
To configure a custom backup, use the controls in the Backup Set list to specify just the items you want to
include:

l The green arrow and bold font indicate an item and all its subordinate items will be included.

l The blue arrow is a visual aid marking an item as a category that has subordinate items listed below it.
To view the subordinate items, click the blue arrow. If the arrow is gray, there are no subordinate items.

l To exclude an item from the import, click the X in the item's row. The X turns red to indicate it will be
excluded. You can click the X for a category to exclude all items in that category. To include an excluded
item, click the arrow in its row.

5. When you have completed and verified your selections, click Download Backup. The configuration backup
is saved to your Downloads folder as a .dat file. You can then click either the Restore a backup
configuration link, or Import Configuration > Import Configuration in the left navigation to upload
and restore the file.

Uploading the 3.9 Backup File
To upload a Guest 3.9 configuration to ClearPass Guest 6.x:

1. Upgrade your 3.9 system to the latest 3.9.x monthly patch.

2. Deploy your 6.x system, and upgrade it to the latest 6.x monthly patch.

3. In your 3.9 system, make a complete configuration backup. For details on how to back up your system,
refer to the "Backup and Restore" section in the "Administrator Tasks" chapter of your "ClearPass Guest 3.9
Deployment Guide."

Be sure to use the Complete backup option in your 3.9 system's Backup Mode drop-down list to ensure that
references between items are properly migrated. Partial imports might not work as expected.
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4. In your 6.x system, go to Administration > Import Configuration > Import Configuration. The Import
Configuration: Step 1 page opens with the Upload File form displayed.

5. If your file does not exceed the 15.0 MB size limit, you can use this Upload File form to browse to the
location where you stored your 3.9 backup file. To use the Upload File form, click the Browse button in the
Backup File row to navigate to and select the backup file you want to restore.

Figure 445 The Upload File Form

If your file is larger than the maximum file upload size of 15.0 MB, you must specify a URL instead. Click the
Restore a backup from a URL link above the Upload File form. The Specify Backup File form is
displayed. Enter the URL for the backup file.

Figure 446 The Specify Backup File Form

6. Click Continue. The backup file is uploaded to your 6.x system, making the items available for import, and
the Import Configuration: Step 2 page opens.
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Figure 447 The Configuration Backup List View

This form shows every configuration item in your backup file, and provides options for restoring items or
excluding them from the restoration. For more information, see the next section, "Restoring Configuration
Items " on page 638.

Restoring Configuration Items
This section describes how to use the Import Configuration: Step 2 form to import 3.9 configuration items
to your 6.x system after you upload them.

To select and restore your configuration items:

1. Go to Administration > Import Configuration > Import Configuration and complete the steps
described in "Uploading the 3.9 Backup File " on page 636.

2. When the Import Configuration: Step 2 form is displayed, review the list of items. You can use the
options in the Restore column to select the items to import.

Partial imports might not work as expected. To ensure that references between items are properly migrated, use the
default Restore settings.
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Figure 448 The Configuration Backup List View

l To exclude an item from the import, click the X in the item's row. The X turns red to indicate it will be
excluded. You can click the X for a category to exclude all items in that category.

l To make it easier to select just a few items, you can scroll to the bottom of the list and click the
Unselect All link. All items are then marked with a red X and will be excluded from the import. You can
then select the green check marks for just the items you want.

l The blue arrow is a visual aid marking an item as a category that has subordinate items listed below it.

l To include an item in the import, click the check mark in the item's row. The check mark turns green
and the item's name is highlighted in bold font to indicate it will be included. You can click the check
mark for a category to include all items in the category.

3. Select the items in the list that you want to restore, and then mark the Restore settings from backup
check box to confirm.

Restoring the backup will overwrite your current settings.
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4. Click Restore Configuration. System progress is displayed while items are being imported. When the
import is complete, the Finished Import page displays the Import Notices list for the restored items. For
more information, see "Viewing Imported Item Details " on page 640.

Viewing Imported Item Details
After you click Restore Configuration to import your 3.9 configuration to your 6.x system, the Finished
Import page displays the Import Notices list for the restored items. You can click an item's row in the list for
additional options. For some items, a link is provided to the relevant page in the application.

To view information for imported configuration items:

1. Go to Administration > Import Configuration > Last Import. The Import Notices list opens.

Figure 449 The Import Notices List View

The Import Notices list provides information about items that were handled during the last import. This
list includes the following columns:

l Status -- The import status of the item in the same row. Possible statuses include Imported, Migrated,
Obsolete, Action Required, Error, Processed, Unsupported, and Warning. These statuses are described
more fully in the table below.
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l Operation/Notice -- This column shows the operation performed on the item, and the name of the
item. If the item was imported, the value in this column will be "Import <item name>. If the item could
not be imported, you can click the row to view the item details for more information.

l Count -- The number of items imported for each configuration item. For example, the number shown in
the Count column for Guest Manager Custom Fields indicates the number of customized fields that
were imported.

2. You can click a configuration item's row in the list for additional options.

l For some items, you can click a link to go to the relevant page in the application.

l To view details for a configuration item, click its Show Details link. The form expands to show details of
the import results for the item. The details explain the import status, and advise you of any further
action that might be required.

Status Description

Imported The item was successfully imported with no changes.

Migrated The item was successfully imported but some aspects were modified for 6.2, as
described in Show Details for the item.
For example, if a field imported in a 3.9 configuration has a different name in 6.2 but was
successfully matched and updated, the change is indicated by an arrow:
Migrated field: schedule_time --> start_time

Processed The item was processed for the import but was not applicable and was ignored, as
described in Show Details for the item.
For example, a disabled network configuration, or a service that is now handled in Policy
Manager instead of Guest, or a plugin version that was already up to date.

Action Required Items with this status might or might not have been imported, and require further
verification or manual configuration, as described in Show Details for the item.
For example, print templates that should be reviewed, reports that should be recreated
using Insight instead of Reporting Manager, custom database settings that are not
supported, items that should now be configured in Policy Manager instead of Guest, or
server addresses that should be verified to ensure they are current.

Unsupported The item was not imported because it is not supported in 6.2.
For example, RADIUS certificates, RADIUS Dictionary, custom items for which no handler
could be found, or items such as the system log or RADIUS database that are now
managed in Policy Manager.

Obsolete The item was not imported because it is obsolete in 6.2.
For example, fields that no longer exist, obsolete operator login settings,
RADIUS database settings or server configurations, or deleted user accounts.

Error The item was not imported because it was missing or unavailable.
For example, missing service handler implementations or unavailable skin plugins.

Warning The item was imported but the details include information the operator should be aware
of.
For example, plugins might have been exported from your 3.9 system by out-of-date
plugin versions.

Table 299: Configuration Import Statuses
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For import details specific to each import item, see "Import Information for Specific Import Items " on page
642.

Import Information for Specific Import Items
For each configuration category on the Import Notices list, this section describes items that might be
changed, unsupported, or obsolete, and any actions you might need to take.

This section includes the following:

l "Import Information: AirGroup Services" on page 642

l "Import Information: Cisco IP Phones" on page 642

l "Import Information: Guest Manager" on page 642

l "Import Information: High Availability (HA)" on page 643

l "Import Information: Hotspot Manager" on page 644

l "Import Information: Onboard" on page 644

l "Import Information: Operator Logins" on page 644

l "Import Information: Palo Alto Network Services" on page 644

l "Import Information: RADIUS Services" on page 644

l "Import Information: Reporting Manager Definitions" on page 646

l "Import Information: Server Configuration" on page 646

l "Import Information: SMS Services" on page 647

l "Import Information: SMTP Services" on page 647

Import Information: AirGroup Services
l The following AirGroup 3.9 fields are renamed:

3.9 Name 6.1 Name

shared_location = airgroup_shared_location

shared_role = airgroup_shared_role

shared_user = airgroup_shared_user

Table 300: Renamed AirGroup Fields

l The definitions of some fields are also updated.

l AirGroup controller names default to the hostname.

Import Information: Cisco IP Phones
l The user database is the default ClearPass Policy Manager user database.

l The SMS service handler ID might be updated.

Import Information: Guest Manager

Guest Manager Configuration:

l The new default for the Expire Action setting is 1. Any non-default setting is updated to this new default.
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l Any Account Retention setting is removed.

l Any non-default Session Warning setting is updated to the new default.

Custom Fields:

l The following 3.9 custom fields are obsolete and are not imported:

do_schedule

delete_time

l The following 3.9 custom fields are renamed:

3.9 Name 6.2 Name

schedule_time = start_time

modify_schedule_time = modify_start_time

schedule_after = start_after

Table 301: Renamed Guest Manager Fields

Custom Forms and Views:

l Forms and views that referenced renamed fields are updated to reference the new field name.

l Forms and views that referenced obsolete fields have those fields removed from the definition.

Print Templates:

l Print templates are flagged as Action Required. Print templates might require changes where defaults
have changed or fields have been renamed. Review the templates and correct as necessary to fix fields that
have been changed.

Self Registration:

l The user database is the default ClearPass Policy Manager user database.

LDAP Sponsor Lookups:

l All LDAP operator servers and translation rules are imported. All 6.2 LDAP translation rules are also kept,
because the new default LDAP rules are required for correct operation.

l Imported LDAP translation rules should be reviewed for correct order.

MAC Authentication Configuration:

l Non-default MAC Separator settings are updated to the new default ( - ).

l Non-default MAC Case settings are updated to the new default (lower).

l AirGroup Debug settings are obsolete and are removed.

Import Information: High Availability (HA)
l If HA was not configured, the shared configuration is processed but ignored.

l If HA was configured, it is unsupported.

l If HA nodes were configured, do the following for each shared configuration :

n Configure a Virtual IP address in ClearPass.
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n Configure Publisher Redundancy in ClearPass.

Import Information: Hotspot Manager
l Non-default User Database settings are updated to the default ClearPass Policy Manager user database.

l Non-default Transaction Processing settings reference the correct transaction processor.

l A cookie check (nwa_cookiecheck) is added to the default hotspot plan template.

Import Information: Onboard

To restore your Onboard device provisioning pages, you must import RADIUS Web logins.

l The server certificate in ClearPass might need to be configured before provisioned devices can connect
to the network.

l The QuickConnect client provisioning address might need to be verified as the correct one for the new
server.

Import Information: Operator Logins

Operator Login Configuration

l A client-side cookie check (nwa_cookiecheck) is added to the Login Message setting.

Operator Logins

l Operator logins are obsolete.

Operator Profiles

l If the IT Administrators profile is imported, it is updated to keep existing privileges and is migrated.

l Any non-default Password Change Policy is removed and the profile is migrated.

l Any non-default user skins are reset to the default skin and the profile is migrated.

Operator Servers

l Operator servers are imported as service handlers.

Operator Translation Rules

l If there are any new translation rules, the translation rules should be reviewed for correct order.

Import Information: Palo Alto Network Services
l If Palo Alto Network Services Configuration was disabled, it is processed and ignored.

l If it was enabled, it must be configured in ClearPass.

Import Information: RADIUS Services

RADIUS services are now handled in ClearPass Policy Manager instead of ClearPass Guest.

RADIUS Authentication Servers

l Default authentication servers are processed but ignored (Local User Database, Local Certificate Authority)

ClearPass Guest 6.7 | User Guide Administration | 644
Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2773



645 | Administration ClearPass Guest 6.7 | User Guide

l For all other authentication servers, an authentication source must be created in ClearPass.

RADIUS Certificates

l RADIUS certificates are unsupported.

RADIUS Database Accounting Records

l RADIUS database accounting records are unsupported.

RADIUS Database Connections

l The RADIUS database connection for the local RADIUS server is obsolete.

l For any custom user databases, an authentication source must be created in ClearPass.

RADIUS Database User Accounts

l User accounts are migrated and keep the status (disabled, pending, active, expired) they had in 3.9. Any
field names that differ in 6.2 are updated.

l User accounts with the Deleted status are obsolete.

RADIUS Dictionary

l The RADIUS dictionary is unsupported.

RADIUS NAS List

l Each RADIUS network access server (NAS) is imported as a ClearPass network access device (NAD) client.

RADIUS Server Configuration

l Non-default RADIUS Server Number settings are obsolete.

l Non-default RADIUS Server Port settings are obsolete.

l Default RADIUS Server Options are not applicable; they are processed and ignored.

l For any non-default RADIUS Server Options, an authentication source must be created in ClearPass.

l Non-default Case Insensitive Username settings are obsolete.

l Non-default Include Active Sessions settings are obsolete.

l Non-default EAP Server settings are obsolete.

l Non-default AAA Debug settings are obsolete.

l Non-default Extra RADIUS Attributes settings are obsolete.

l Non-default Interim Accounting settings are obsolete.

l RADIUS Server Configuration is imported (and flagged as imported or action required)
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RADIUS User Roles

l For any role that does not have the default attributes ( Reply-Message := <?= $role['name'], the role
must be manually configured in ClearPass.

l For any role that had MAC caching enabled, the role must be manually configured in ClearPass.

RADIUS Web Logins

l RADIUS Web logins are imported.

Import Information: Reporting Manager Definitions

l Reports must be re-created in ClearPass Insight.

Import Information: Server Configuration

l ClearPass settings are obsolete.

Data Retention

l Data Retention settings for Onboard are imported.

Database Configuration

l Default (empty) database configuration settings are processed and ignored.

l Non-default database configuration settings should be reviewed for potential issues.

Installed Plugin List

l For imported plugins that were not up-to-date (e.g. pre-3.9), you must review the version numbers
provided in Show Details, upgrade those plugins in your 3.9 system, and import the plugins again.

Network Hostname

l The network hostname must be set in ClearPass.

Network Hosts

l Default hosts files (references to localhost only) are obsolete.

l For a non-default hosts file, the DNS must be properly configured.

Network Interface Configuration

l Network interfaces are unsupported.

Security Audit Settings

l Security audit settings are obsolete.

Server Time Setup

l Server time settings must be configured in ClearPass.

SNMP Configuration

l If SNMP was enabled, settings must be configured in ClearPass.

ClearPass Guest 6.7 | User Guide Administration | 646
Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2775



647 | Administration ClearPass Guest 6.7 | User Guide

SSL Certificate Setup

l The backup certificate is processed and ignored.

l For other certificates, the certificate and the private key should be downloaded and the certificate
imported into ClearPass.

Subscription IDs

l If the following settings do not have default values, they are updated to the new default values and
migrated:

n Session ID

n Update URL

n Facility

l For non-default Application URLs, changes should be reviewed.

l Subscription IDs must be added to ClearPass.

l For non-default HTTP Proxy settings, the HTTP proxy must be configured in ClearPass.

System HTTP Proxy

l For non-default HTTP Proxy settings, the HTTP proxy must be configured in ClearPass.

System Kernel Configuration

l System kernel configuration is obsolete.

System Log Setup

l System log setup is obsolete.

l If a local collector was enabled, it is unsupported.

Web Application Configuration

l Default Application Configuration settings are processed and ignored.

l For non-default Application Configuration settings, PHP settings must be configured in ClearPass.

Web Server Configuration

l Web server configuration is obsolete.

Import Information: SMS Services
l SMS gateways are imported as service handlers.

Import Information: SMTP Services

l The following settings are updated to the new defaults and the configuration is migrated:

n Additional Headers

n Copies To

n Email Receipt

n Enable warnings
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n From Address

n Logout Warnings

n Mail Transfer Settings

n Override From

n Password

n Reply-To

n Send Copies

n Skin

n SMTP Port

n SMTP Server

n Subject Line

n Username

n Use Sendmail

n Use SSL encryption

Plugin Manager

Plugins are the software components that fit together to make your Web application. The Available Plugins
list shows all the plugins currently included in your application. It lets you view information about each plugin
and configure some aspects of most plugins. You can click a plugin’s name to go directly to that area of the
application—for example, clicking the name of the SMTP Services plugin opens the Customize Email
Receipt page in the Configuration module.

Viewing Available Plugins

To access the list of available plugins, go to Administration > Plugin Manager. The Available Plugins list
view opens. Plugins are listed by category and include:

l Standard Plugins — Provide corresponding functionality in the application for interactive use by
operators

l Kernel Plugins — Provide the basic framework for the application

l Operator Login Plugins — Control access to the Web application

l Skin Plugins — Provide the style for the application’s visual appearance

l Transaction Processor Plugins — Provide transaction service handlers for interfacing with various
payment solution providers

l Translation Plugins — Provides configurable language settings for the application
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Figure 450 The Available Plugins List View

The About link displays information about the plugin, including the installation date and update date. The
About page for the Kernel plugin also includes links to verify the integrity of all plugin files or perform an
application check.

Figure 451 The Plugin Information View for the ClearPass Guest Services Plugin

Click a plugin’s Configuration link to view or modify its settings. See "Configuring Plugins" on page 649 for
details about the configuration settings.

Configuring Plugins
You can configure most standard, kernel, skin, and translation plugins. Skin plugins can also be enabled or
disabled, letting you choose which skin to use. To work with plugins, go to Administration > Plugin
Manager. The Available Plugins list view opens.
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Figure 452 Options for a Plugin in the List

To view or change the configuration settings for a plugin, click the plugin’s Configuration link. The
Configure Plugin form shows the current configuration settings for a plugin, and allows you to make changes
to these settings.

Figure 453 The Configuration Form for the MAC Authentication Plugin

To undo any changes to the plugin’s configuration, click the plugin’s Restore default configuration link.
The plugin’s configuration is restored to the factory default settings.

In most cases, plugin configuration settings do not need to be modified directly. Use the customization options
available elsewhere in the application to make configuration changes.

For more information about plugin configuration:

l AirGroup Services—See "Configuring AirGroup Services" on page 651

l API Services—See "Configuring the API Framework Plugin" on page 652

l Aruba ClearPass Skin — See "Configuring the Aruba ClearPass Skin Plugin" on page 654

l ClearPass Onboard — "Configuring the ClearPass Onboard Plugin" on page 656

l Guest Manager—See "Default Settings for Account Creation" on page 280

l IP Phone Services—See "Configuring the IP Phone Services Plugin" on page 663

l Kernel—See "Configuring the Kernel Plugin" on page 664

l MAC Authentication—See "Configuring the MAC Authentication Plugin" on page 665

l Platform Services—See "Configuring the Platform Services Plugin" on page 666

l SMS Services—See "Configuring the SMS Services Plugin" on page 667

l SMTP Services—See "Email Receipt Options" on page 447

l Translation Services—See "Configuring the Translations Plugin" on page 672

l Web Analytics —See "Configuring the Web Analytics Plugin" on page 673

l SOAP Web Services—See "Configuring the SOAP Web Services Plugin" on page 674
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Configuring AirGroup Services
To enable support for dynamic notification of AirGroup events when new devices are added, each AirGroup-
enabled controller must also be defined in ClearPass Guest. Configuration options include specifying roles to
exclude from the user interface, and setting message parameters and logging levels.

To configure AirGroup Services, go to Administration > AirGroup Services > Configuration. The
Configure AirGroup Services form opens.

Figure 454 The Configure AirGroup Services Form
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Field Description

Exclusions Role names, AP group names, or AP names that should not be displayed in the AirGroup
user interface. Enter each item on a separate line. Entries are not case-sensitive. To add a
comment, enter it on a separate line that begins with the "#" character.

Group Names Enter names of shared groups that should be available in the Shared Groups field for
users to choose from when they share a device. If additional user groups are also entered
by users when they share a device, the list in the configuration is automatically updated to
capture these fields. Removing a group name from this list does not remove it from other
shared group lists.
When you type a name for the group in the Group Names field, press the Enter key, and
click Save, the group is created in the system and appears as a "tag". For more information,
see "About AirGroup Time-Based Sharing" on page 92.
Each group name may not exceed 64 characters. A maximum of 32 group names may be
entered. The maximum character limit for the list is 320 characters (including comma
separators).

Network Interface Specifies the interface AirGroup will use to send outbound notification messages. To enable
using a virtual IP address, select the appropriate interface. Options include:
l Automatic — Automatically chooses the appropriate source IP address; either the

management port or the data port, depending on the controller's IP address.
l Management port [MGMT] — Always uses the management port as the source

address.
l Data/External port [DATA] — Always uses the data port as the source address.

Timeout Number of seconds after which an attempt to send an AirGroup message will time out.

Attempts Maximum number of times the system should attempt to send an AirGroup message.

AirGroup Logging Specifies the logging level. Options include:
l Disabled—Do not log AirGroup related events
l Standard (Recommended)—Log basic information
l Extended—Log additional information
l Debug—Log debug information
l Trace—Log all debug information

Table 302: Configure AirGroup Services

Configuring the API Framework Plugin
The API Framework plugin supports OAuth2 authentication and authorization, and provides all application
programming interface (API) services for ClearPass Guest. Settings you can configure for this plugin include the
access token lifetime, refresh token lifetime, API logging level, and security settings for Cross-Origin Resource
Sharing (CORS).

To view or configure the API Framework plugin:

1. Go to Administration > Plugin Manager. The Available Plugins list opens.

2. Scroll to the Standard Plugins > API Framework row and click its Configuration link. The Configure API
Framework form opens.
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Figure 455 The API Framework Plugin Configuration Form

Field Description

Access Token
Lifetime

(Optional) Specifies the default lifetime of an OAuth2 access token. Unless it is changed, the
default value is 8 hours. To change the value, enter a number in the first text field, and use the
drop-down list to indicate the unit of time. Options include:
l seconds
l minutes
l hours
l days
l weeks
The value for this parameter may also be configured separately for each API client (see "Creating
and Editing API Clients" on page 571).

Refresh
Token
Lifetime

Specifies the default lifetime of an OAuth2 refresh token. Unless it is changed, the default value is
14 days. To change the value, enter a number in the first text field, and use the drop-down list to
indicate the unit of time. Options include:
l seconds
l minutes
l hours
l days
l weeks
The value for this parameter may also be configured separately for each API client (see "Creating
and Editing API Clients" on page 571).

API Logging (Required) Specifies the logging level for API-related events. Options include:
l Disabled - do not log API-related events
l Standard (Recommended) - log basic information

Table 303: API Framework Plugin Configuration
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Field Description

l Extended - log additional information — (this option logs all API calls)
l Debug - log debug information
l Trace - log all debug information — The ‘Trace’ logging level exposes the following security

risks:
n Information disclosure: Full request/response traces are logged, including potentially

sensitive information such as access tokens, passwords, and/or shared secrets.
n Denial-of-service: Every API request generates a log message, including authentication and

authorization failures.

Security
Warning

Displays security risks warnings if you selected Trace - log all debug information in the API
Logging field.

Allowed
Origins

Specifies a list of hostnames that may be used for Cross-Origin Resource Sharing (CORS). Enter
each hostname on a separate line. The asterisk character may be used by itself to allow all
origins, or it can be used as a wildcard (*.example.com). To never allow cross-domain API
requests, leave this field blank.

Arbitrary Sort If selected, overrides default sort-field settings and allows any field to be specified as the sort
column through the API.
Users should be aware that large query results might cause a performance impact.

Save
Configuration

Commits your changes.

Configuring the Aruba ClearPass Skin Plugin

A Web application’s skin determines its visual style—the colors, menus, and graphics. You can use either the
standard Aruba ClearPass skin plugin, the ClearPass Guest skin, a Galleria skin, a blank plugin if you are
providing your own complete HTML page, or custom skin plugins that let you configure the colors, navigation,
logo, and icons.

To view or configure the standard Aruba ClearPass skin plugin:

1. Go to Administration > Plugin Manager. The Available Plugins list opens.

2. Scroll to the Skin Plugins > Aruba ClearPass Skin row and click its Configuration link. The Configure
Aruba ClearPass Skin form opens.
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Figure 456 The Aruba ClearPass Skin Plugin Configuration Form

Field Description

Navigation
Layout

Specifies the navigation’s expansion level. The default navigation layout is “expanded.” Options
include:
l Use Default
l simple — Only the current L1 item has L2 items, L3 only when L2 active
l expando — Show items in expanding/collapsing lists
l expanded — All L1 items have L2 items, L3 only when L2 active
l all-expanded — All items shown to L3
l l1 expanded — All L1 items have L2 items, L3 only when L1 active
l all-l1 — All current L1 items shown to L3
l No navigation

Page Heading Additional custom heading text to display at the very top of the page.

Font Family List of fonts to use as the font family.

(Color fields) Specify the colors and highlight colors for various areas. To change a color in any of the color
fields, click the color sample box to open the color picker. Set a color, and then click Select in the
color picker for that item. Repeat for each color you want to change.
l Welcome Background Color — Background color for the welcome block

Table 304: Configure Aruba ClearPass Skin Form
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Field Description

l Welcome Foreground Color — Foreground color for the welcome block
l Welcome Highlight — Highlight color for the name
l Network Color — Color for the network area
l Network Highlight — Highlight color for the network
l Instructions Color — Color for the instructions
l Instructions Highlight — Highlight color for the instructions

Save
Configuration

Saves your changes.

Table 304: Configure Aruba ClearPass Skin Form(Continued)

The default skin used by the ClearPass Guest application is the one that is enabled in the Plugin Manager. To
change the default skin globally, go to the plugin list and click the Enable link for the skin you would like to use
as the default. When you install a new custom skin, it is automatically enabled and becomes the default skin. If
your application’s appearance does not automatically change, find the custom plugin in the list, click
Configure, and click its Enable link. If you prefer to use the standard Aruba ClearPass skin, navigate to it in the
Available Plugins list and click its Enable link.

The default skin is displayed on all pages seen by guests, and on the login page if no other skin is specified for
it. However; you can override this for a particular operator profile, an individual operator, or give the login page
a different appearance than the rest of the application. You can also specify a skin for guest self-registration
pages.

l To use a different skin for a particular operator profile, see "Creating an Operator Profile" on page 686.

l To use a different skin for an individual operator login, see "Local Operator Authentication" on page 694.

l To have the login page use a different skin than the rest of the application, see "Operator Logins
Configuration" on page 681.

l To specify a skin for a customized guest self-registration page, see "Configuring Basic Properties for Self-
Registration" on page 357.

Configuring the ClearPass Onboard Plugin

The ClearPass Onboard plugin lets you set the configuration options for Onboard. Onboard provides secure
enrollment and management capabilities for networked devices. The Onboard plugin configuration lets you set
logging options, control whether overlapping MAC addresses should be merged, and set a time of day for
background processing operations.

To view or configure the Onboard plugin: 

1. Go to Administration > Plugin Manager. The Available Plugins list opens.

2. Scroll to the Standard Plugins > ClearPass Onboard row and click its Configuration link. The Configure
ClearPass Onboard form opens.
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Figure 457 The ClearPass Onboard Plugin Configuration Form

Field Description

MDPS Logging Specifies how to log events related to Mobile Device Provisioning Services (MDPS). Options
include:
l Disabled — do not log MDPS related events
l Standard (Recommended) — log basic information
l Extended — log additional information
l Debug — log debug information
l Trace — log all debug information

Merge Devices If selected, devices with overlapping MAC addresses will be merged.

Action Time
of Day

Specifies the time of day to run background processing actions such as notification emails and
expiration of inactive devices.

Save
Configuration

Saves your changes.

Table 305: Configure Onboard Form

Configuring the Guest Manager Plugin
The Configure Guest Manager plugin configuration form lets you control the default settings for account
creation.

To modify settings for the Guest Manager plugin configuration, go to Configuration > Guest Manager. The
Configure Guest Manager form opens.

You can also access this form from the Administration > Plugin Manager > Guest Manager >
Configuration link.

Figure 458 The Configure Guest Manager Form, Username Options Area
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Field Description

Username
Type

(Required) Specifies the default method used to generate random account usernames (when creating
groups of accounts). This may be overridden by using the random_username_method field.

Username
Length

(Required) Default length of random account usernames (when creating groups of accounts). This
may be overridden by using the random_username_length field. This field is displayed if the
Username Type is set to “Random digits”, “Random letters”, “Random letters and digits” or “Sequential
numbering”.

Initial
Sequence

This field contains the next available sequence number for each username prefix that has been used.
Automatic sequence numbering is used when the value of the multi_initial_sequence field is set to -
1. The username prefix is taken from the multi_prefix field when usernames are automatically
generated using the “nwa_sequence” method. You can edit the values stored here to change the next
sequence numbers that will be used. This is an automatically managed field; in most situations there
is no need to edit it.

Table 306: Configure Guest Manager Form, Username Options Area

Figure 459 The Configure Guest Manager Form, Password Options Area

Field Description

Random
Password
Type

(Required) Default method used to generate random account passwords (when creating groups of
accounts). This may be overridden by using the random_password_method field.

Random
Password
Length

(Required) Default length of random account passwords (when creating groups of accounts). This
may be overridden by using the random_password_length field.

Password
Complexity

(Required) Policy to enforce when guests change their account passwords using the guest self-
service user interface. Different levels of password complexity can require guests to select
passwords that contain different combinations of uppercase letters, lowercase letters, digits, and
symbols or special characters such as:
! @ # $ % ^ & * ( ) < > [ ] { } ' : ~ ` / \ | " + , - . ; = ? _
Options include:
l No password complexity requirement
l At least one uppercase and one lowercase letter

Table 307: Configure Guest Manager Form, Password Options Area
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Field Description

l At least one digit
l At least one letter and one digit
l At least one of each: uppercase letter, lowercase letter, digit
l At least one symbol
l At least one of each: uppercase letter, lowercase letter, digit, and symbol

Minimum
Password
Length

(Required) Minimum acceptable password length for guests changing their account passwords. The
original default password length is six characters.

Disallowed
Password
Characters

Special characters that should not be allowed in a guest password. Spaces are not allowed by
default. You can specify special characters, numbers, and letters to exclude from passwords—for
example, letters and numbers that can look similar, such as i, l, 1, 0, O, o, 5, S, 8, B.

Disallowed
Password
Words

Comma- separated list of words that are disallowed and will not be created by the random words
password generator.

Password
Logging

If selected, passwords for created guest accounts are logged in the application log and may be
recovered from there. For increased security, you may prevent this password from being logged by
deselecting this check box.

Password
Display

If selected, enables the display of guest account passwords in the user list. To reveal passwords, the
password field must be added to the “guest_users” or “guest_edit” view, and the operator profile in
use must also have the View Passwords privilege.

Table 307: Configure Guest Manager Form, Password Options Area(Continued)

Figure 460 The Configure Guest Manager Form, Expiration Options Area
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Field Description

Expire
Action

(Required) Default action when the expiration time is reached. Available options available are:
l Disable at specified time
l Delete and logout at specified time
l Delete at specified time
l Disable and logout at specified time

Expiration
Options

(Required) The options that should be available to select from when choosing the expiration time of a
guest account (expire_after). These options are displayed as the values of the “Expires After” field
when creating a user account. Values are in hours for relative account expiration times.

Modify
Expiration
Options

(Required) The options that should be available to select from when modifying an account's expiration
(modify_expire_time). Some items may be dynamically removed based on the state of the account.

Lifetime
Options

(Required) The options that should be available to select from when choosing the lifetime for a guest
account (expire_postlogin). These options are displayed as the values of the “Account Lifetime” field
when creating a user account. Values are in minutes for relative account lifetimes.

Table 308: Configure Guest Manager Form, Expiration Options Area

Figure 461 The Configure Guest Manager Form, Expiration Warning Options Area

Field Description

Account
Expiry
Warning

If selected, users will receive an email notification before their device's network credentials are
about to expire. Expiration warning configuration options are added to the form.

Account
Expiry
Notification

(Required) Number of days before account expiration that the notification email will be sent. You
may specify a number from 1 through 30.

If Email is
Unknown

(Required) Specifies where to send emails if the user's account does not have an email address
recorded. Options include:
l Do not send any message
l Send a message to a fixed email address
l Send a message to username@domain

Subject Line (Required) Enter the subject line for the notification email.

Email (Required) Specifies the print template to use when generating the email message. Options

Table 309: Configure Guest Manager Form, Expiration Warning Options Area
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Field Description

Message include:
l Account List
l Certificate Expiry
l Download Receipt
l Guest Account Expiry
l GuestManager Receipt
l One account per page
l SMS Receipt
l SMS Sponsor Confirmation Alert
l Sponsorship Confirmation
l Two-column scratch cards

Email Skin (Required) Specifies the format for the email receipts. Options include:
l No skin - Plain text only
l No skin - HTML only
l No skin - Native receipt format
l Use the default skin
l Aruba ClearPass Skin
l Blank Skin
l ClearPass Guest Skin
l Custom Skin 1
l Custom Skin 2
l Galleria Skin
l Galleria Skin 2

Send Copies (Required) Specifies when to send to recipients in the Copies To list. Options include:
l Do not send copies
l Always send using "cc:"
l Always send using "Bcc:"

Table 309: Configure Guest Manager Form, Expiration Warning Options Area(Continued)

Figure 462 The Configure Guest Manager Form, Receipt Options Area
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Field Description

Site
SSID

Public name of the wireless local area network (WLAN). The default setting for this field is Aruba, and
can be changed. The site SSID is displayed in the guest receipt as the WiFi Network, shown below this
table.

Site
WPA
Key

Encryption key used to secure the wireless network. If a value is entered in this field, it will appear on
guest print receipts.

Receipt
Printing

If selected, the receipt page provides a drop-down list of print templates and a Print link that must be
clicked to display the account receipt:

If this option is not selected, the default behavior is to provide a drop-down list of print templates and to
open a new window when one is selected:

Table 310: Configure Guest Manager Form, Receipt Options Area

Figure 463 Example Guest Receipt, Showing Site SSID Displayed as the WiFi Network
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Figure 464 The Configure Guest Manager Form, General Options Area

Field Description

Terms
of Use
URL

URL of a terms and conditions page provided to sponsors. The default, terms.php, displays the
preconfigured Web page provided at Configuration > Pages > Web Pages > Terms and Conditions.
You can edit that page, or you can use Content Manager to upload an HTML file describing the terms
and conditions of use (See "Managing Content: Private Files and Public Files" on page 277).
l If your site is hosted externally, be sure the proper access control lists (ACLs) are in place.
l If terms are required, it is best practice to edit the terms field on you forms to a UI type "hidden" and

an initial value of 1.

Active
Sessions

Default maximum number of active sessions that should be allowed for a guest account. This may be
overridden by using the simultaneous_use field when creating or editing a guest account.

About
Guest
Network
Access

Specifies the template code to display on the Guest Manager start page under the “About Guest
Network Access” heading.
l To use the default text, leave this field blank.
l To specify custom text, select an item in the drop-down list.
l To remove the default text and the heading, enter a single hyphen ( - ) in this field.

Table 311: Configure Guest Manager Form, General Options Area

Configuring the IP Phone Services Plugin

The Cisco IP Phone Services plugin configuration allows you to configure debugging levels for Cisco IP Phone
service requests. The higher the debugging level, the more information will be included in the application log.

To view or configure the Cisco IP Phone Services plugin:

1. Go to Administration > Plugin Manager. The Available Plugins list opens.

2. Scroll to the Standard Plugins > Cisco IP Phone Services row and click its Configuration link. The
Configure Cisco IP Phone Services form opens.

Figure 465 The IP Phone Services Plugin Configuration Form
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Field Description

Debugging (Required) Specifies the debugging level for Cisco IP Phone service requests. Higher levels
provide more information in the application log. Options include:
l 0 — No debugging output
l 1 — Log requests
l 2 — Log requests with full details

Save
Configuration

Saves your changes.

Table 312: Configure Cisco IP Phone Services Plugin Form

Configuring the Kernel Plugin
The Kernel Plugin provides the basic framework for the application. Settings you can configure for this plugin
include the application title, the debugging level, the base URL, and the application URL, and autocomplete.

To view or configure the Kernel plugin:

1. Go to Administration > Plugin Manager. The Available Plugins list opens.

2. Scroll to the Kernel Plugins > Kernel row and click its Configuration link. The Configure Kernel form
opens.

Figure 466 The Kernel Plugin Configuration Form
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Field Description

Application
Title

(Required) Name to display as the title of your Web application (for example, your company
name).

Debug Level (Required) The Debug Level and Application URL options should not be modified unless you are
instructed to do so by Aruba support.

Application
URL

Base URL for the application.

Form Auto
Complete

If selected, turns turn off autocomplete on forms. Selecting this option will disable credentials
caching.

Security If selected, enables protection against clickjacking attacks and prevents the Web application from
being used from within another frame.

SSL
Verification

If selected, allows access to secure Web sites providing an invalid certificate.

Default
Language

Specifies the default language for the application. Options include:
l Arabic Translations
l Chinese Translations
l Danish Translations
l Dutch Translations
l English Translations
l French Translations
l German Translations
l Japanese Translations
l Korean Translations
l Spanish Translations

Initial
Sequence

The initial sequences for {nwa_makeid ifle=...}.

Save
Configuration

Saves your changes.

Restore
default
configuration

Restores the plugin’s configuration to the original settings. A message alerts you that the change
cannot be undone, and a comparison of the current and default settings highlights the changes
that will be made.
Review the differences between the current settings and the default configuration. To commit the
change to the default settings. click the Restore Default Configuration link.

Table 313: Configure Kernel Plugin Form

Configuring the MAC Authentication Plugin
Different vendors format the client MAC address in different ways—for example:

l 112233AABBCC

l 11:22:33:aa:bb:cc

l 11-22-33-AA-BB-CC

ClearPass Guest supports adjusting the expected format of a MAC address. To configure formatting of
separators and case in the address, as well as user detection and device filtering for views, go to
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Configuration link for the MAC Authentication plugin. The MAC Authentication Configuration page
opens.

Figure 467 MAC Authentication Plugin Configuration

Field Description

MAC Detect (Required) If selected, users can be detected by their MAC address, providing access to user
configuration for headers, footers, etc. on login and registration pages. Requires a vendor that
passed the MAC address as part of the redirect.
Because a passed MAC address can easily be changed by the user, personal details should not be
displayed.

Device Filter Specifies which views should not display devices (user accounts with the “mac_auth” field set).
Views that can be specified include:
l Manage Accounts
l Manage Multiple Accounts

Save
Configuration

Saves your changes.

Table 314: The Configure MAC Authentication Form

On the controller, the fields look as follows:

Figure 468 MAC Authentication Profile

Configuring the Platform Services Plugin
The Platform Services plugin may be used to set default options for ClearPass platform services.

To view or configure platform services options:

1. Go to Administration > Plugin Manager. The Available Plugins list opens.

2. Scroll to the Standard Plugins > Platform Services row and click its Configuration link. The Configure
Platform Services form opens.
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Figure 469 The Configure Platform Services Form

Field Description

Captive Portal Whitelist Regular expression used to match the User-Agent header of captive portal
clients. Clients that match this expression will be shown the captive portal
without any redirects. You can enter a list of regular expressions used to
match the User-Agent headers of captive portal clients, separated by the
forward-slash character ( / ).

Captive Portal Blacklist Regular expression used to match the User-Agent header of captive portal
clients. Clients that match this expression will be denied access to the captive
portal. You can enter a list of regular expressions used to match the User-
Agent headers of captive portal clients, separated by the forward-slash
character ( / ).

Save Configuration Saves your changes to this form.

Table 315: Configure Platform Services Form

Configuring the SMS Services Plugin

The SMS Services plugin configuration allows you to configure options related to SMS receipts. You may also
configure SMS receipt options in the Customization module (see "Customizing SMS Receipt" on page 451).

To view or configure SMS services and receipt options:

1. Go to Administration > Plugin Manager. The Available Plugins list opens.

2. Scroll to the Standard Plugins > SMS Services row and click its Configuration link. The Configure SMS
Services form opens.
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Figure 470 The SMS Services Plugin Configuration Form

Field Description

Service
Provider

Specifies the default SMS gateway to use when sending messages. Options include ClearPass
Guest SMS and any other gateways that have been configured.

SMS Receipt Specifies the plain-text format print template to use when an SMS receipt is generated. Options
include:
l ClearPass demo SMS Receipt
l Download Receipt
l SMS Receipt
l SMS Sponsor Confirmation Alert

Phone
Number
Field

Specifies the guest account field that contains the guest’s mobile telephone number. This field is
used to determine the SMS recipient address.

Table 316: Configure SMS Services Plugin Form

ClearPass Guest 6.7 | User Guide Administration | 668
Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2797



669 | Administration ClearPass Guest 6.7 | User Guide

Field Description

Auto-Send
Field

Specifies the guest account field which, if set to a non-empty string or non-zero value, will trigger
an automatic SMS when the guest account is created or updated. The auto-send field can be
used to create an “opt-in” facility for guests. Use a check box for the auto_send_sms field and add
it to the create_user form, or a guest self-registration instance, and SMS messages will be sent to
the specified phone number only if the check box has been selected.

Credit
Warning

(Required) The number of available credits at which a warning is sent. When the remaining
number of SMS credits reaches this threshold, the system will send a warning to the system
administrator.

Sponsor
Phone
Number
Field

Specifies the field containing the sponsor’s phone number.

Sponsor
SMS Receipt

Specifies the plain-text format print template to use when an SMS receipt is generated.

Advanced
Gateways

If selected, lets you configure SMS gateways from multiple SMS providers and define custom
gateways. For more information, see "Creating or Editing an SMS Gateway" on page 463.

SMS via
SMTP

If selected, enables support for sending SMS messages by SMTP. Guest account receipt
messages will be sent in an email using the defined SMTP server.

Default
Number
Format

Specifies forcing the addition or removal of a country code. Otherwise, the phone number
normalization process translates phone strings that are entered in various formats into a single
standard format. Options include:
l Use the guest’s value — When you select this option, the SMS gateway will always send the

SMS message using the phone number and country code entered by the guest.
l Always include the country code — When you select this option, the SMS gateway will

always send the SMS message using the global country code and default phone number
length specified in the Default Country Code and Default Phone Length fields. For
example, consider an Australian mobile phone number with a default number length of 9 plus
a leading zero, and a country code of 61. If you selected the Always include the country
code option, the Australian mobile number 0412345678 would normalize to +61412345678 in
the internationalized format.

l Never include the country code — When you select this option, any country code specified
by the guest is removed before the SMS message is sent.

Default
Country Code

The global country code used for phone number normalization.

Default
Phone
Length

The number of digits required to normalize the phone number. To ignore the length, enter a value
of 0.

Save
Configuration

Saves your changes.

Table 316: Configure SMS Services Plugin Form(Continued)

Configuring the SMTP Services Plugin
The SMTP Services plugin may be used to set default options for SMTP Services and email receipts.

To view or configure SMTP services options:

1. Go to Administration > Plugin Manager. The Available Plugins list opens.

2. Scroll to the Standard Plugins > SMTP Services row and click its Configuration link. The Configure
SMTP Services form opens.
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Figure 471 The Configure SMTP Services Form

Field Description

Subject Line Template specifying the subject line for guest account receipts sent by email.
May contain template code, including references to guest account fields. The
default value, Guest account receipt for {$email}, uses the value of
the email field. See "Smarty Template Syntax" on page 713 for more
information on template syntax.

Email Receipt (Required) Specifies the plain text or HTML template to use for the email
receipt.

Skin (Required) Specifies the email format or skin to use to provide the basic
appearance of the email. Options include:
l No skin – Plain text only – A skin is not used, and the email will be sent

Table 317: Configure SMTP Services Form

ClearPass Guest 6.7 | User Guide Administration | 670
Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2799



671 | Administration ClearPass Guest 6.7 | User Guide

Field Description

in plain text format. Use this option to remove all formatting from the
email.

l No skin – HTML only – A skin is not used, but the email will be sent in
HTML format. Use this option to provide a basic level of formatting in the
email.

l No skin – Native receipt format – A skin is not used. The email will be
sent in either plain text or HTML format, depending on the type of print
template that was selected.

l Use the default skin – The skin currently marked as the default skin is
used.

l Aruba ClearPass Skin
l Blank Skin
l ClearPass Guest Skin
l Custom Skin 1
l Custom Skin 2
l Galleria Skin
l Galleria Skin 2
When sending an email message using HTML formatting, the images and
other resources required to display the page will be included in the message.

Copies To Creates an optional list of additional email addresses that are designated to
receive copies of the generated email receipts. To have the email receipt
sent to the sponsor's email address, enter the keyword _admin in this field.
In this case the email receipt will be sent to the current operator.

Send Copies (Required) Specifies how copies of the email receipts will be sent to the
additional email addresses listed in the Copies To field:
l Do not send copies – The Copies To list is ignored and email is not

copied.
l Always send using ‘cc:’ – The Copies To list is always sent a copy of any

guest account receipt (even if no guest account email address is
available).

l Always send using ‘bcc:’ – The Copies To list is always sent a blind copy
of any guest account receipt (even if no guest account email address is
available).

l Use ‘cc:’ if sending to a guest – If a guest account email address is
available, the email addresses in the Copies To list will be copied.

l Use ‘bcc:’ if sending to a guest – If a guest account email address is
available, the email addresses in the Copies To list will be blind copied.

Reply-To If selected, the Reply-To address will be overridden by the sponsor_email field
of the user, or by the admin's email. When you select this check box, the
Override From field is added to the form.
To use the global From Address, do not select the check box in this field.

Override From If selected, overrides the From Address instead of using the Reply-To value.

Email Field (Required) Specifies the field that will contain the guest's email address.

Auto-Send Field (Required) Specifies the field that will cause an account receipt email to be
automatically sent when a guest account is created. The email receipt will
only be sent if the field selected here contains a non-empty string of non-zero
value.
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Field Description

Request Subject Line Template specifying the subject line for sponsorship requests.

Sponsorship Receipt Specifies the plain text or HTML print template to use when sending a
sponsorship request. Options include:
l Account List
l Certificate Expiry
l Download Receipt
l Guest Account Expiry
l GuestManager Receipt
l One account per page
l SMS Receipt
l SMS Sponsor Confirmation Alert
l Sponsor Device Provisioning
l Sponsorship Confirmation
l Two-column scratch cards

Request Subject Line Template specifying the subject line for sponsored Onboard requests.

Sponsorship Receipt Specifies the plain text or HTML print template to use when sending a
sponsored Onboard request. Options include:
Account List
Certificate Expiry
Download Receipt
Guest Account Expiry
GuestManager Receipt
One account per page
SMS Receipt
SMS Sponsor Confirmation Alert
Sponsor Device Provisioning
Sponsorship Confirmation
Two-column scratch cards

Save Configuration Saves your changes to this form.

Configuring the Translations Plugin

The Translation Assistant plugin shows the current version, type, original installation date, date of last update,
whether it can be configured, and the copyright date. The Translation Assistant plugin cannot be configured.

To view the Translation Assistant plugin:

1. Go to Administration > Plugin Manager. The Available Plugins list opens.

2. Scroll to the Standard Plugins > Translation Assistant row and click its About link. The Plugin
Information form opens.
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Figure 472 The Translation Assistant Plugin Information View

By default, the display language for the ClearPass Guest user interface is automatically detected based on the
user's browser settings. To enable or disable language packs, set a default language for ClearPass Guest, or
customize label and message text, see "About Translations" on page 474.

Configuring the Web Analytics Plugin

The Web Analytics plugin configuration allows you to configure a tracking code and specify which pages should
include it.

To view or configure the Web Analytics plugin:

1. Go to Administration > Plugin Manager. The Available Plugins list opens.

2. Scroll to the Standard Plugins > Web Analytics row and click its Configuration link. The Configure
Web Analytics form opens.

Figure 473 The Web Analytics Plugin Configuration Form
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Field Description

Tracking
Code

The page tracking code to add before the </body> tag.
If you use this field to add page tracking code for guests using a restricted pre-authentication role,
be sure to whitelist any required URLs or domains for that role.

Insert Into Specifies the pages in the application that will receive the tracking code. Options include:
l All pages
l Operator pages only
l Guest access pages only
The tracking code will be added immediately before the </body> tag on the specified pages. The
tracking code does not collect any user information.

Save
Configuration

Saves your changes.

Table 318: Configure Web Analytics Plugin Form

Configuring the SOAP Web Services Plugin
SOAP Web Services provide a way of transferring data across the Internet to integrate Web-based applications.
Web services let businesses share data and processes programmatically, and can be added to a user interface
to provide functionality.

To configure the SOAP Web Services plugin, do one of the following:

l Go to Administration > Web Services > Configure Web Services. The Configure SOAP Web Services
form opens.

Or:

1. Go to Administration > Plugin Manager. The Available Plugins list opens.

2. Scroll to the Standard Plugins > SOAP Web Services row and click its Configuration link. The Configure
SOAP Web Services form opens.

Figure 474 The SOAP Web Services Plugin Configuration Form
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Field Description

WSDL Access If selected, allows operators to make (WSDL) requests without being logged in.

Maximum
Request Size

Maximum size in kilobytes that will be allowed for a SOAP request. Requests larger than this
value will be rejected.

SOAP Debugging Specifies the debugging level for SOAP service requests. Options include:
l 0 — No debugging output
l 1 — Log SOAP errors only
l 2 — Log SOAP errors with full request body
l 3 — Log all SOAP requests
l 4 — Log all SOAP requests with full details

Save
Configuration

Saves your changes. The configuration is applied to all SOAP Web Services in the application.

Table 319: Configure SOAP Web Services Plugin Form

Support

The Administration > Support page provides links to ClearPass Guest documentation, the application log,
and Aruba Customer Support contact information.
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Viewing the Application Log

To view events and messages generated by the application, go to Administration > Support > Application
Log. The Application Log view opens.

Figure 475 The Application Log List View

To view in-depth information about an event, click the event’s row. The form expands to show details. Click the
event’s row again to close it.

Figure 476 Information Displayed for an Event in the Application Log

To view the logs for a different server when in a cluster, use the Server drop-down list above the table.

To search for a particular log record, use the Keywords field above the table to enter search terms. You can
use the hyphen character (-) in front of a keyword to exclude items, and you can use quotes (“ “) to group
words as a key phrase.
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The Application Log lists the events, messages, and configuration changes for the past seven days. To view
events and messages for a different period, or to limit the search items, click the Filter tab. The Filter Settings
form opens.

Figure 477 The Filter Settings Form

Field Description

Times Specifies a time period to search.

Severity Specifies the minimum severity of messages to search for:
l Error— Returns Error items
l Warning— Returns Error and Warning items
l Info— Returns Error, Warning, and Info items
l Debug— Returns Error, Warning, Info, and Debug items

Options If selected, all fields of the log record will be searched. The default setting is to search only the Client
IP and Message fields.

Apply
Filter

Applies your filter settings and runs a new search. Results are displayed in the Application Log list.

Reset Cancels your entries in the filter and restores the default filter settings.

Table 320: Application Log Filter

Events are stored in the Application Log for seven days by default. To review a record of significant runtime
events prior to the last seven days, you can use the Audit Viewer in ClearPass Policy Manager’s Monitoring
module.
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Exporting the Application Log
To save the log in other formats, click the Export tab on the Administration > Support > Application Log
view. The Application Log expands to include the Export Application Logs form.

Figure 478 The Export Application Logs Form

Field Description

Format Specifies the format in which to save the file and export the logs. Options include:
l Comma-Separated Values (*.csv) — This is the default format
l HTML document (*.html)
l Tab-Separated Values (*.tsv)
l Text file (*.txt)
l XML document (*.xml)

Range Specifies the range of pages to save. Options include:
l Single page — export the current page only
l Multiple from current — start the export from the current page
l Multiple from first — start the download from the first page that matched

Download
Limit

If you entered a range of pages in the Range drop-down list, the form expands to include the row.
Maximum number of log messages to download if you entered a range of pages in the Range field. To
download all messages, leave this field empty. Users should be aware that downloading all messages
could take a long time.

Export Exports the log file and downloads it to your system.

Table 321: Export Application Logs Form

Contacting Support
To view contact information for Aruba Support, go to Administration > Support > Contact Support. The
Contact Support page opens. This page provides the following information:

l A toll-free telephone number for North American support

l A link to Aruba’s online Contact Support page, which includes telephone numbers and other contact
information for over 30 countries
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Viewing Documentation

To view ClearPass Guest documentation, go to Administration > Support > Documentation. The
Documentation page opens.

l To view this User Guide in your browser as online help, click Browse Documentation. The document
opens in a separate browser tab.

l To view the User Guide as a PDF, click Deployment Guide. The PDF file opens in a separate tab.
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Chapter 9
Operator Logins

An operator is a company’s staff member who is able to log in to ClearPass Guest. Different operators may
have different roles that can be specified with an operator profile. These profiles might be to administer the
ClearPass Guest network, manage guests, or run reports.

Operators may be defined locally in ClearPass Guest, or externally in an LDAP directory server.

Accessing Operator Logins
To access ClearPass Guest’s operator login features, click the Administration link in the left navigation, and
then click Operator Logins.

About Operator Logins
ClearPass Guest supports role-based access control through the use of operator profiles. Each operator using
the application is assigned a profile which determines the actions that the operator may perform, as well as
global settings such as the look and feel of the user interface.
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Your profile may only allow you to create guest accounts, or your profile might allow you to create guest
accounts as well as print reports. What your profile permits is determined by the network administrator.

Two types of operator logins are supported: local operators and operators who are defined externally in your
company’s directory server. Both types of operators use the same login screen.

Role-Based Access Control for Multiple Operator Profiles
Using the operator profile editor, the forms and views used in the application may be customized for a specific
operator profile, which enables advanced behaviors to be implemented as part of the role-based access control
model.

This process is shown in the following diagram.

Figure 479 Operator Profiles and Guest Access Control

See "About Operator Logins" on page 680 for details on configuring different forms and views for operator
profiles.

Operator Logins Configuration

You can configure a message on the login screen that will be displayed to all operators. This must be written in
HTML. You may also use template code to further customize the appearance and behavior of the login screen.

To modify these configuration parameters, go to Administration > Operator Logins > Login
Configuration. The Operator Logins Configuration form opens.

Operator Login UI Area

If you are deploying ClearPass Guest in a multi-lingual environment, options in the Operator Login UI area of
the form let you specify different login messages depending on the currently selected language.
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Figure 480 The Operator Logins Configuration Form, Operator Login UI Area

Field Description

Login
Message

(Required) HTML for the message that will be displayed in the header of the operator login screen. You
can also use the drop-down list to add images or other content items or links (content items must first
have been uploaded in Content Manager).

Login
Footer

HTML for the message that will be displayed in the footer of the operator login screen. You can also use
the drop-down list to add images or other content items or links (content items must first have been
uploaded in Content Manager).

Login
Skin

Specifies the skin for the operator login screen. Options include:
l (Default)
l Aruba ClearPass Skin
l Blank Skin
l ClearPass Guest Skin
l Custom Skin 1
l Custom Skin 2
l Galleria Skin
l Galleria Skin 2

Table 322: Operator Logins Configuration Form, Operator Login UI Area

The following example of a custom login message from the demonstration site uses Danish (da), Spanish (es),
and the default language English, as highlighted in bold:

{if $current_language == 'da'}

<p>

Indtast brugernavn og password for at <br>

få adgang til ClearPass Guest

</p>

<p>

Kontakt <a href="http://www.airwire.dk/">Airwire</a> (Norden) for at få demoadgang

</p>

{elseif $current_language == 'es'}

<p>
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Para entrar en el web demo de ClearPass Guest,<br>

necesitas un nombre y contraseña.

</p>

<p>

Si no tienes un login, puedes obtener uno<br>

<a href="http://www.arubanetworks.com/">contactando con Aruba Networks</a>.

</p>

{else}

<p>

The ClearPass Guest demo site <br>

requires a username and password.

</p>

<p>

If you don’t have a login, <br>

<a href="http://www.arubanetworks.com/">contact Aruba Networks</a> to obtain one.

</p>

{/if}

<br clear="all">

Advanced Options Area
The Advanced Options area lets you configure such things as logging levels, service handler ranking, and
session parameters.

Figure 481 The Operator Logins Configuration Form, Advanced Options Area

Field Description

Logging Specifies the level of logging to use when the application is accessed. Log messages for operator
logins, whether successful or unsuccessful, are shown in the application log. Options include:
l No logging
l Log only failed operator login attempts
l Log only Web logins
l Log only XMLRPC access
l Log all access

ClearPass
Operator
Priority

The priority rank of the service handler for authentication of ClearPass operators. Lower numbers
represent higher priorities.

Logout After Amount of idle time, in hours, after which an operator’s session will be ended. You can use
fractional numbers for values less than an hour; for example, use 0.25 to specify a 15 minute idle

Table 323: Operator Logins Configuration Form, Advanced Options Area
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Field Description

When this field is set to the default value of zero, ClearPass Guest will use the value that is
configured in ClearPass Policy Manager for the Admin Session Idle Timeout cluster-wide
parameter.
If a cumulative patch is applied, this field will retain the value it had before the patch.

Session
Checking

Specifies the amount of validity checking to perform on operator login sessions at each page load.
Higher settings reduce performance. Options include:
l No checking
l Check operator is enabled
l Full checking

Check
Interval

Minimum interval in seconds between checks of a session’s validity.

Save
Changes

Saves your changes to the login configuration.

Table 323: Operator Logins Configuration Form, Advanced Options Area(Continued)

Operator Profiles

An operator profile determines what actions an operator is permitted to take when using ClearPass Guest.

Some of the settings in an operator profile may be overridden in a specific operator’s account settings. These
customized settings will take precedence over the default values defined in the operator profile.

To define new operator profiles and to make changes to existing operator profiles, go to Administration >
Operator Logins > Profiles. The Operator Profiles list view opens.
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Figure 482 The Operator Profiles List View

All operator profiles that have been created are included in the list. You can click a profile's row in the list for
additional options:

Field Description

View
Details

Displays or hides configuration details for the selected operator profile, including the profile name,
description, operator login access, and the settings for the defined skin, start page, language and time
zone.

Hide
Details

Edit Lets you edit the properties of the specified operator profile.

Delete Removes the operator profile from the Operator Profiles list. You will be asked to confirm the deletion.

Duplicate Creates a copy of the operator profile to use as a basis for a new profile.

Show The form expands to show a list of operator login names associated with that operator profile.

Table 324: Operator Profiles Options
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Field Description

Operators

Show
Usage

The form expands to show whether the profile is in use, and lists any LDAP authentication servers,
LDAP translation rules, and operator logins associated with that profile. Each entry in this window
appears as a link to the form that lets you edit that LDAP or operator login setting.

Create a
new
operator
profile

Lets you create a new operator login associated with the selected operator profile. The Create
Operator Login form opens.

Table 324: Operator Profiles Options(Continued)

Creating an Operator Profile

To create a new operator profile, on the Administration > Operator Logins > Profiles page, click the
Create a new operator profile link.

The Operator Profile Editor form opens. This form has several sections, which are described in more detail
below.

Figure 483 The Operator Profile Editor Form, Basic Properties Area

Field Description

Name (Required) Name for this operator profile. Operator profile names must be unique.

Description Brief description of or additional information about this operator profile.

Enabled If selected, allows operators with this profile to log in. To disable the profile, unmark the Allow
Operator Logins check box. If a profile is disabled, any operators with that profile will be unable to
log in to the system. This can be useful when performing system maintenance tasks.

Table 325: Operator Profile Editor Form, Basic Properties

ClearPass Guest 6.7 | User Guide Operator Logins | 686
Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2815



687 | Operator Logins ClearPass Guest 6.7 | User Guide

Figure 484 The Operator Profile Editor Form, Privileges List
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Field Description

Privileges For each ClearPass Guest functionality area, specifies the appropriate permissions for this operator
profile. The default in all cases is No Access. This means that you must select the appropriate
privileges in order for the profile to work. Options include:
l No Access — Default
l Read Only Access
l Full Access
l Custom — The form expands to include additional privileges specific to that item. Select the

appropriate permission level for each additional option.
For details about the available access levels for each privilege, see "Operator Profile Privileges" on
page 693.

Table 326: Operator Profile Editor Form, Privileges List

Figure 485 The Operator Profile Editor Form, Access Area

ClearPass Guest 6.7 | User Guide Operator Logins | 688
Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2817



689 | Operator Logins ClearPass Guest 6.7 | User Guide

Field Description

User
Roles

If selected, each check box specifies a user databases and guest account role that operators with this
operator profile can access. Options include:
l [Contractor]
l [Guest]
l [Employee]
l [PersonalDevice]
If one or more roles are selected, then only those roles will be available for the operator to select from
when creating a new guest account. The guest account list is also filtered to show only guest accounts
with these roles.
If a database is selected in the User Roles list but no roles within that database are selected, then all
roles defined in the database will be available. This is the default option.

Operator
Filter

Specifies the default operator filtering to apply to guest accounts. This can be used to limit the types of
accounts that can be viewed by operators. Options include:
l No operator filter
l Only show accounts created by the operator
l Only show accounts created by operators with this profile

User
Account
Filter

Lets you create a persistent filter to apply to the user account list. For example, this can be useful in
large deployments where an operator only wants to have a filtered view of some accounts. To create
an account filter, enter a comma-delimited list of field-value pairs. Supported operators are described
below in "Operators Supported in Filters" on page 690.

Session
Filter

Lets you create a filter that only lasts for a single session. To create a session filter, enter a comma-
delimited list of field-value pairs. Supported operators are described below in "Operators Supported in
Filters" on page 690.

Account
Limit

Maximum number of accounts an operator with this operator profile can create. Disabled accounts are
included in the account limit. To set no limit, leave this field empty.
When you create or edit an AirGroup operator, the value you enter in this field specifies the maximum
number of devices an AirGroup operator with this profile can create.

Table 327: Operator Profile Editor Form, Access Area
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Operators Supported in Filters
When you create a session filter or a persistent user account filter, the user can enter a simple substring to
match a portion of the username or any other fields that are configured for search, and may include the
following operators:

Operator Meaning Additional Information

= is equal to You can search for multiple values when using the equality
(=) or inequality !=) operators. To specify multiple values,
list them separated by the pipe character ( | ).

For example, specifying the filter "role_id=2|3, custom_
field=Value" restricts the user accounts displayed to those
with role IDs 2 and 3 (Guest and Employee), and with the
field named "custom_field" set to "Value".

!= is not equal to

> is greater than

>= is greater than or equal to

< is less than

<= is less than or equal to

~ matches the regular expression

!~ does not match the regular
expression

Table 328: Operators Supported in Filters

Configuring the User Interface

The fields in the User Interface area of the form determine elements of the application’s visual appearance
and behavior that operators with this profile will see. The Skin, Start Page, Language, and Time Zone
options specify the defaults to use for operators with this profile. Individual operator logins may have different
settings, which will be used instead of the values specified in the operator profile. For information on specifying
options at the individual operator level, see "Local Operator Authentication" on page 694.

Figure 486 The Operator Profile Editor Form, User Interface Area
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Field Description

Skin Specifies the skin to use for operators with this profile. For more information on skins, see "Plugin
Manager" on page 648. Options include:
l (Default) — Indicates that the skin plugin currently marked as enabled in the Plugin Manager

will be used.
l Aruba ClearPass Skin
l Blank Skin
l ClearPass Guest Skin
l Custom Skin 1
l Custom Skin 2
l Galleria Skin
l Galleria Skin 2

Start Page Specifies the initial ClearPass application page to show to this operator after they log in. The
Default setting option indicates that the application’s standard Home page will be the first page
displayed after login. To have a different start page displayed to users with this operator profile,
choose a page from the drop-down list. For example, if a profile is designed for users who do only
certain tasks, you might want the application to open at the module where those tasks are
performed.

Language Specifies the default language to use for operators with this profile. Options include:
l Auto-detect — Default. This lets the application determine the operator’s language

preference from their local system settings.
l Danish
l German
l English
l Spanish
l French
l Dutch
l Arabic
l Japanese
l Chinese
l Korean

Time Zone Specifies the default time zone for operators with this profile. The Default setting indicates that
the operator’s time zone will default to the system’s currently configured time zone.

Customization If selected, lets you override the application’s default forms and views and specify different ones
to use for the operator profile. The form expands to show the forms and views that can be
modified. If alternative forms or views have been created, you may use the drop-down lists to
specify which ones to use. See Figure 487.

Save Changes Saves your changes and creates the operator profile.

Table 329: Operator Profile Editor Form, User Interface Area
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Figure 487 The Operator Profile Editor Form, User Interface Area, Customization Options
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Operator Profile Privileges
The privilege selections available for an operator profile (see "Creating an Operator Profile" on page 686)
provide you with control over the functionality that is available to operators. Refer to the description of each
individual operator privilege to determine what the effects of granting that permission will be.

Privilege
Level

Description

No Access The operator will have no access to the particular area of functionality. Options for that functionality
will not appear for that operator in the menus.

Read Only
Access

The operator can see the options available but is unable to make any changes to them.

Full Access All the options are available to be used by the operator.

Custom Allows you to specify individual permissions within each group. For example, Guest Manager allows
you to control access to the following areas:
l Active sessions management
l Viewing historical data for active sessions
l Changing expiration time of guest accounts
l Creating multiple guest accounts
l Creating new guest accounts
l Editing multiple guest accounts
l Exporting guest account data
l Full user control of guest accounts
l Importing guest accounts
l Listing guest accounts
l Managing customization of guest accounts
l Managing print templates
l Removing or disabling guest accounts
l Resetting guest passwords

Table 330: Operator Profile Privilege Levels

Configuring AirGroup Operator Device Limit
By default, an AirGroup operator can create up to five personal devices. To change this default:

1. Go to Administration > Operator Logins > Profiles, and then select the AirGroup Operator profile in
the list.

2. Click the Edit link. The Edit Operator Profile form opens.

3. In the Account Limit field, specify an appropriate value. This is the maximum number of personal devices
that an operator with this profile can create.

4. Click Save Changes.

You can create a set of operator profiles and configure each profile with a different account limit. This makes it
easy to assign operator profiles appropriately for small groups, larger groups, or events. To create each profile
in the set, duplicate the built-in AirGroup Operator profile, and update the Account Limit field in the new
profile.
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Local Operator Authentication

ClearPass Policy Manager profiles and ClearPass Guest profiles are different. To create a ClearPass Guest
operator login, local users are first defined in ClearPass Policy Manager with a role that matches an operator
profile in Guest, and then rules are used to map the role to the Guest operator profile.

Creating a New Operator

To create a new operator or administrator for ClearPass Guest or AirGroup, some steps are performed in
ClearPass Policy Manager, and some steps are performed in ClearPass Guest, as described below:

1. Create an operator profile in ClearPass Guest, or use an existing one. See "Operator Profiles" on page 684.

l To create an AirGroup operator, choose either the AirGroup Administrator or AirGroup Operator
profile, as appropriate. These profiles are automatically included in ClearPass Guest when the AirGroup
Services plugin is installed.

l Device Registration operators are created entirely in Policy Manager.

2. When you create an operator profile, AirGroup operator, or Device Registration operator in ClearPass Guest,
the matching role is automatically created in Policy Manager and is available at Policy Manager
> Configuration > Identity > Roles.

3. Create a local user for the operator: In Policy Manager, go to Configuration > Identity > Local Users and
click Add User. In the Add Local User form, complete the fields and choose the appropriate role from the
Role drop-down list.

l To create an AirGroup operator, choose either the AirGroup Administrator or AirGroup Operator
role, as appropriate.

l To create a Device Registration operator, choose the Device Registration role. This form completes
Device Registration user creation; the following steps are not required.

4. Create a translation rule to map the ClearPass role name to the ClearPass Guest operator profile: In
ClearPass Guest, go to Administration > Operator Logins > Translation Rules.

5. In the Translation Rules list, find the profile in the list, look at the Action column to verify the operator
profile assignment, and then click its Edit link. The row expands to include the Edit Translation Rule form.

6. Edit the fields appropriately to match the ClearPass role name to the ClearPass Guest operator profile. See
"LDAP Translation Rules" on page 703.

7. Click Save Changes.

External Operator Authentication

Operators defined externally in your company’s directory server form the second type of operator.
Authentication of the operator is performed using LDAP directory server operations. The attributes stored for
an authenticated operator are used to determine what operator profile should be used for that user.
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At Administration > Operator Logins > Start Here, the Manage Operator Servers and the Translation
Rules commands allow you to set up operator logins integrated with a Microsoft Active Directory domain or
another LDAP server.

The operator management features, such as creating and editing operator logins, apply only to local operator logins
defined in ClearPass Guest. You cannot create or edit operator logins using LDAP. Only authentication is supported.

Managing LDAP Operator Authentication Servers

ClearPass Guest supports a flexible authentication mechanism that can be readily adapted to any LDAP
server’s method of authenticating users by name. There are built-in defaults for Microsoft Active Directory
servers and POSIX-compliant directory servers.

When an operator attempts to log in, each LDAP server that is enabled for authentication is checked, in order
of priority from lowest to highest.

When a server is found that can authenticate the operator’s identity (typically with a username and password),
the LDAP server is queried for the attributes associated with the user account.

These LDAP attributes are then translated to operator attributes using the rules defined in the LDAP
translation rules. In particular, an operator profile will be assigned to the authenticated user with this process,
which controls what that user is permitted to do.

Viewing the LDAP Server List
If you have defined one or more LDAP servers, those servers will appear in the LDAP server list at
Administration > Operator Logins > Servers.

Figure 488 The Operator Servers List View
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Select any of the LDAP servers in the list to display options to perform the following actions on the selected
server:

Field Description

Edit Lets you make changes to the properties of the LDAP server. The Server Configuration form opens.

Delete Removes the server from the LDAP server list. You will be asked to confirm the deletion.

Duplicate Creates a copy of an LDAP server to use as a basis for a new server.

Disable Temporarily disables the server while retaining its entry in the server list.

Enable Re-enables a disabled LDAP server.

Ping Sends a ping message (echo request) to the LDAP server to verify connectivity between the LDAP
server and the ClearPass Guest server. The form expands to show the ping test progress and results.

Test Auth Adds a Test Operator Login area in the LDAP servers list that allows you to test authentication of
operator login values.

Test
Lookup

Adds a Test Operator Lookup form in the LDAP servers list that allows you to look up sponsor names.
This option is only available if sponsor lookup has been enabled for the server on the Edit
Authentication Server page.

Table 331: Operator Servers List View
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Creating an LDAP Server

To create an LDAP server, go to Administration > Operator Logins > Servers, and click the Create new
LDAP server link in the upper-right corner. The authentication Server Configuration form opens.

Figure 489 The Server Configuration Form, General Properties and User Search Areas

Field Description

Name (Required) Name for this authentication server.

Priority (Required) Priority rank of the service handler for authentication of local operators. Lower numbers
represent higher priorities.

Server
Type

(Required) Specifies the type of server your system will connect to. Options include:
l Microsoft Active Directory — For more information on the Microsoft Active Directory server

type, see "Advanced LDAP URL Syntax" on page 700.

Table 332: Serverr Configuration Form, General Properties and User Search Areas
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Field Description

l POSIX Compliant
l Custom

Server
URL

(Required) The URL of the LDAP server.
Examples:
ldap://hostname/ or
ldap://192.168.88.1/ou=IT-Services,ou=Departments,dc=amigopod,dc=com

To specify a basic LDAP server connection (hostname and optional port number), use a server URL of
the form ldap://hostname/ or ldap://hostname:port/. See "Advanced LDAP URL Syntax" on page
700 for more details about the types of LDAP URL you may specify.

Bind DN The password to use when binding to the LDAP server. For an anonymous bind, leave this field empty.

Bind
Username

The username and domain to use when binding to the directory. Use either of the following formats:
l username@domain
l domain\username
To perform an anonymous bind, leave this field empty.

Bind
Password

The password to use when binding to the LDAP server. Leave this field blank to use an anonymous
bind.
If you selected Microsoft Active Directory in the Server Type field, and if your LDAP server does not
use anonymous bind, you must supply the required credentials to bind to the directory.

Base DN The Distinguished Name to use for the LDAP search.

Unique ID The name of an LDAP attribute used to match the username.

Filter Additional LDAP filters to use to search for the server.

Attributes List of LDAP attributes to retrieve. To retrieve all attributes, leave this field empty (the default).

User Search Area

Enabled If selected, The form expands to include AirGroup and Sponsor Lookup options.

Filter (Required) Specifies the LDAP filter to use. Options include:
l Use the default LDAP filter — The default filter looks for people based on their full name or

their user ID.
l Specify a custom LDAP filter

Filter
Expression

(Required) The LDAP filter expression to use when searching. The keyword @SEARCH@ will be
replaced with the search query.

Display
Attributes

(Required) The LDAP attributes to retrieve from the directory, and their type.
Use the syntax “attributeName = type”, where type may be: “id”, “text” or “desc”.

Sort By Name of the LDAP attribute on which the results should be sorted.

Table 332: Serverr Configuration Form, General Properties and User Search Areas (Continued)
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Field Description

Maximum
Results

(Required) The maximum number of results to return for each query.

AirGroup Area

Tip Displays information about how to enable user search in AirGroup, and provides a link to the related
configuration form.

Table 332: Serverr Configuration Form, General Properties and User Search Areas (Continued)

Figure 490 The Server Configuration Form, Operator Logins and Authentication Parameters Areas

Field Description

Sponsor Lookups Area

Tip Displays information about how to enable sponsor lookups in a self-registration, and provides a link to
the related configuration form.
If you want to enable the validation of sponsor emails during self-registration, follow the instructions
provided. The server will then look up sponsors during self-registration and double-check the attribute
used for emails on the LDAP server. This option requires that the sponsor_email and do_ldap_
lookup fields are enabled in the registration form, and that you have the LDAP Sponsor Lookup plugin
installed. Use the Plugin Manager to verify that this plugin is available.

Attribute
Mapping

(Required) The attribute mappings to apply to the configuration. Enter a list of "FORM_FIELD | LDAP_
ATTRIBUTE" pairs, one per line.

Table 333: Server Configuration Form, Operator Logins and Authentication Parameters Areas
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Field Description

Operator Logins Area

Enabled If selected, this server will be used to authenticate operator logins. LDAP servers for operator logins
are configured in Policy Manager.

Default
Profile

(Required) Specifies the default operator profile to assign to operators authorized by this server.

Authentication Parameters Area

Test The type of test to run, either authentication or lookup.

Test
Username

The username to use when performing an authentication or lookup test.

Test
Password

The password to use when performing an authentication test. The minimum password length is six
characters.

Advanced If selected, detailed test results are displayed.

Search
Mode

The type of search mode to use, either lookup or search.

Test
Settings

Lets you test your settings when your entries on this form are complete and you have provided a test
username and test password. If the authentication or search is successful, the operator profile
assigned to the username is displayed. If the authentication fails, an error message is displayed. See
"LDAP Operator Server Troubleshooting" on page 701 for information about common error messages
and troubleshooting steps to diagnose the problem.Search

Directory

Save
Changes

Saves your changes and creates this LDAP Server. If the server is marked as enabled, subsequent
operator login attempts will use this server for authentication immediately.

Table 333: Server Configuration Form, Operator Logins and Authentication Parameters Areas(Continued)

Advanced LDAP URL Syntax
If you select Microsoft Active Directory as the Server Type on the Administration > Operator Logins
> Servers > Server Configuration form, the LDAP server connection will use a default distinguished name of
the form dc=domain,dc=com, where the domain name components are taken from the bind username.

To specify a different organizational unit within the directory, include a distinguished name in the LDAP server
URL, using a format such as:

ldap://192.0.2.1/ou=IT%20Services,ou=Departments,dc=server,dc=com

To specify a secure connection over SSL/TLS, use the prefix ldaps://.

To specify the use of LDAP v3, use the prefix ldap3://, or ldap3s:// if you are using LDAP v3 over SSL/TLS.

When Microsoft Active Directory is selected as the Server Type, LDAP v3 is automatically used.

An LDAP v3 URL has the format ldap://host:port/dn?attributes?scope?filter?extensions.

l dn is the base X.500 distinguished name to use for the search.

l attributes is often left empty.

l scope may be ‘base’, ‘one’ or ‘sub’.

l filter is an LDAP filter string, for example, (objectclass=*)
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l extensions is an optional list of name=value pairs.

Refer to RFC 2255 for further details.

LDAP Operator Server Troubleshooting
At Administration > Operator Logins > Servers, you can use the LDAP Operator Servers list to
troubleshoot network connectivity and operator authentication, and to look up operator usernames.

Testing Connectivity

To test network connectivity between an LDAP server and the ClearPass Guest server, click the Ping link in
the server’s row. The results of the test appear below the server entry in the LDAP server table.

Testing Operator Login Authentication
1. To test authentication of operator login values, select a server name in the LDAP Server table, and then click

the Test Auth link. The form expands to include the Test Operator Login form.

Figure 491 The Test Operator Login Form in the Operator Servers List View

2. Enter an operator username and password for the LDAP Server. The minimum password length is six
characters. ClearPass passwords can include letters, numbers, and the following special characters:

! @ # $ % ^ & * ( ) < > [ ] { } ' : ~ ` / \ | " + , - . ; = ? _

3. (Optional) To display detailed authorization information for the specified operator, select the Advanced
check box.

4. Click Log In to attempt to authenticate the LDAP server, or click Cancel to cancel the test. The
Authentication Test area is added above the server names to indicate the test’s progress.
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Figure 492 The Authentication Test Progress Area

You can also verify operator authentication when you create a new LDAP server configuration using the
Test Settings button on the LDAP Configuration form (See "Creating an LDAP Server" on page 697 for a
description).

Looking Up Sponsor Names

This option is only available if sponsor lookup has been enabled for the server on the Edit Authentication
Server page.

1. To look up a sponsor, select a server name in the LDAP Server table, and then click the Test Lookup link.
The Test Operator Lookup area is added to the LDAP servers list.

2. In the Lookup field, enter a lookup value. This can be an exact username, or you can include wildcards. If
you use wildcards, the search might return multiple values.

3. In the Search Mode field, use the drop-down list to specify whether to search for an exact match or use
wildcard values.

4. (Optional) To display detailed authorization information for the specified sponsor, select the Advanced
check box.

5. Click Search Directory to attempt to find sponsor names that match the lookup values, or click
Cancel to cancel the test. The Authentication Test area is added above the server names to indicate the
search’s progress.

Troubleshooting Error Messages

The error messages in the following table can be used to diagnose error messages. For example, in the
following error message:
“LDAP Bind failed: Invalid credentials (80090308: LdapErr: DSID-0C090334, comment: AcceptSecurityContext
error, data 525, vece), bind DN was: …”,
...the number 525 is identified in the following table as “User not found”.

Error Data Reason

525 User not found

52e Invalid credentials (password is incorrect)

530 Not permitted to log on at this time

Table 334: LDAP Error Messages
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Error Data Reason

531 Not permitted to log on at this workstation

532 Password has expired

533 Account is disabled

701 Account has expired

773 User must reset password

775 User account is locked

Other items to consider when troubleshooting LDAP connection problems:

l Verify that you are using the correct LDAP version – use ldap:// for version 2 and ldap3:// to specify
LDAP version 3.

l Verify that you are using an SSL/TLS connection – use ldaps:// or ldap3s:// as the prefix of the Server
URL.

l Verify that the Bind DN is correct – the correct DN will depend on the structure of your directory, and
is only required if the directory does not permit anonymous bind.

l Verify that the Base DN is correct – the Base DN for user searches is fixed and must be specified as
part of the Server URL. If you need to search in different Base DNs to match different kinds of operators,
then you should define multiple LDAP Servers and use the priority of each to control the order in which the
directory searches are done.

LDAP Translation Rules

To create and work with LDAP operator translation rules, go to Administration > Operator Logins
> Translation Rules. The Operator Translation Rules list view opens.

Figure 493 The Operator Translation Rules List View
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All translation rules that have been created are included in the list. You can click a translation rule's row in the
list for additional options:

Field Description

Edit Lets you edit the configuration of the translation rule. The form expands to include the Edit
Translation Rule form. See "Configuring LDAP Translation Rules" on page 704.

Delete Deletes the translation rule. You are asked to confirm the deletion.

Duplicate Creates a copy of an the translation rule to use as a basis for a new rule.

Disable Temporarily disables the translation rule without deleting it from the rule list.

Enable Re-enables a disabled translation rule.

Edit Profile Lets you edit the operator profile assigned to the translation rule. The Edit Operator Profile form
opens.

Move Up Moves the rule up to a higher priority or down to a lower priority in the rule list. Translation rules
are processed in order until a matching rule is found that does not have the Fallthrough field set.

Move Down

Create new
translation
rule

Lets you create a new translation rule. The Edit Translation Rule form opens in a new page. See
"Configuring LDAP Translation Rules" on page 704.

Operator
Servers

Lets you work with an LDAP server. The Operator Servers list view opens. See "Managing LDAP
Operator Authentication Servers " on page 695.

Table 335: Operator Translation Rules List View

Configuring LDAP Translation Rules
LDAP translation rules specify how to determine operator profiles based on LDAP attributes for an
authenticated operator.
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To create a new LDAP translation rule, go to Administration > Operator Logins > Translation Rules, and
then click the Create new translation rule link. The Edit Translation Rule form opens.

Figure 494 The Edit Translation Rule Form

Field Description

Name (Required) Name for this translation rule that describes what the rule does. In the example shown in
Figure 494, the translation rule is to check that the user is an administrator, hence the name
MatchAdmin.

Enabled If selected, this rule will be used when processing reply attributes. If this check box is not selected,
the rule will appear in the rules list, but will not be active until you enable it.

Attribute
Name

Name of the attribute; for example, “memberof”. For all attributes, use an asterisk (*).

Matching
Rule

Specifies the matching rule to apply to the value of the attribute. Options include:
l always match
l contains — Case-insensitive substring match anywhere in string.
l matches — Regular expression match, where the value is a Perl-compatible regular expression

including delimiters. For example, to match the regular expression “admin” case-insensitively,
use the value “/admin/i”. See "Regular Expressions" on page 764 for more details about regular
expressions.

l equals — Case-insensitive string comparison, matches on equality.
l does not equal — Case-insensitive string comparison, matches on inequality.
l less than — Numerical value is less than the match value.
l greater than — Numerical value is greater than the match value.
l starts with — Case-insensitive substring match at start of string.
l ends with — Case-insensitive substring match at end of string.

Table 336: Edit Translation Rule Form
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Field Description

Value The value against which to match the attribute. In the example shown in Figure 494, the value
CN=Administrators is used to look for a specific group of which the user is a member.

On Match Specifies the action the system should take when the translation rule matches an attribute. Options
include:
l Do nothing — Makes no changes.
l Assign fixed operator profile — Assigns the selected Operator Profile to the operator.
l Assign attribute’s value to operator field — Uses the value of the attribute as the value for an

operator field. This option can be used to store operator configuration details in the directory.
(For operator profiles from enforcement profiles, matching can be performed on either their IDs
or their name values, even if the Fallthrough option is not selected)

l Assign custom value to operator field — Uses a template to assign a value to a specific
operator field. If you choose this option, the form expands to include the Custom text box for you
to enter your custom template code. See "Custom LDAP Translation Processing" on page 707.
(For operator profiles from enforcement profiles, matching can be performed on either their IDs
or their name values, even if the Fallthrough option is not selected)

l Apply custom processing — Evaluates a template that may perform custom processing on the
LDAP operator. If you choose this option, the form expands to include the Custom text box for
you to enter your custom template code. See "Custom LDAP Translation Processing" on page
707.

l Remove attribute from operator — Removes the selected LDAP attribute from the operator.

Operator
Profile

Specifies which operator profile to assign if there is a rule match. In the example shown in Figure
494, if the Administrator group is matched, the IT Administrators profile will be assigned.

Operator
Field

Specifies which operator field the profile will be assigned to. Options include:
l username
l email
l comment
l profile
l enabled
l start_page
l userskin
l lang
l timezone_id
l password_action
l password_action_time

Custom Custom template code to apply when the rule matches. You can use the drop-down list to add
images, links, or other content items. To be included in this list, content items must first be uploaded
to Content Manager.

Fallthrough If selected, multiple translation rules can be applied. When you create multiple rules, you can build a
complete logical structure to perform any type of processing on the LDAP attributes available in
your directory.

Save
Changes

Saves the your changes. If you are creating a new rule, it is added to the Operator Translation
Rules list.

Table 336: Edit Translation Rule Form(Continued)
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Custom LDAP Translation Processing

When matching an LDAP translation rule, custom processing may be performed using a template.

The template variables available are listed in Table 337.

Variable Description

$attr The name of the LDAP attribute that was matched.

$user Contains settings for the operator, including all LDAP attributes returned from the server.

Table 337: Template Variables

For a Smarty template syntax description, See "Smarty Template Syntax" on page 713. These may be used to
make programmatic decisions based on the LDAP attribute values available at login time.
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For example, to permit non-administrator users to access the system only between the hours of 8:00 am and
6:00 pm, you could define the following LDAP translation rule:

Figure 495 The Edit Translation Rule Form Showing an Example Custom Rule

The Custom rule is:
{strip}

{if stripos($user.memberof, "CN=Administrators")!==false}

1

{elseif date('H') >= 8 && date('H') < 18}

1

{else}

0

{/if}

{/strip}

Explanation: The rule will always match on the “memberof” attribute that contains the user’s list of groups. The
operator field “enabled” will determine if the user is permitted to log in or not. The custom template uses the
{strip} block function to remove any whitespace, which makes the contents of the template easier to
understand. The {if} statement first checks for membership of the Administrators group using the PHP stripos
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() function for case-insensitive substring matching; if matched, the operator will be enabled. Otherwise, the
server’s current time is checked to see if it is after 8am and before 6pm; if so, the operator will be enabled. If
neither condition has matched, the “enabled” field will be set to 0 and login will not be permitted.
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Chapter 10
Reference

This chapter includes the following sections:

l "Basic HTML Syntax" on page 710

l "Standard HTML Styles" on page 711

l "Smarty Template Syntax" on page 713

l "Date/Time Format Syntax" on page 730

l "Programmer’s Reference" on page 732

l "Field, Form, and View Reference" on page 738

l "LDAP Standard Attributes for User Class" on page 763

l "Regular Expressions" on page 764

Basic HTML Syntax
ClearPass Guest allows different parts of the user interface to be customized using the Hypertext Markup
Language (HTML).

Most customization tasks only require basic HTML knowledge, which is covered in this section.

HTML is a markup language that consists primarily of tags that are enclosed inside angle brackets, for example,
<p>. Most tags are paired to indicate the start and end of the text being marked up; an end tag is formed by
including the tag inside the angle brackets with a forward slash, for example, </p>.

Use the following standard HTML tags in customization:

Item HTML Syntax

Basic Content

<h1>Main Heading</h1>

<h2>Subheading</h2>

<h3>Section heading</h3>

<p>Paragraph text</p>

<br>

<br /> – equivalent syntax (XHTML)

<ul>

<li>List item text</li>

</ul>

Table 338: Standard HTML Tags
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Item HTML Syntax

<ol>

<li>List item text</li>

</ol>

Text Formatting

<b>words to be made bold</b>

<strong>equivalent syntax</strong>

<i>words to be made italic</i>

<em>equivalent syntax</em>

<u>words to underline</u>

<tt>Shown in fixed-width font</tt>

<span style="…">Uses CSS formatting</span>

<span class="…">Uses predefined style</span>

<div style="…">Uses CSS formatting</div>

<div class="…">Uses predefined style</div>

Hypertext

<a href="url">Link text to click on</a>

<img src="url">

<img src="url" /> – XHTML equivalent

<img src="url" align="left">

For more details about HTML syntax and detailed examples of its use, consult a HTML tutorial or reference
guide.

Standard HTML Styles
ClearPass Guest defines standard CSS classes you can use to provide consistent formatting within the user
interface.

Examples of these styles are given below.
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Figure 496 Example Formatting of Some Standard CSS Classes

Class Name Applies To Description

nwaIndent Tables Indent style used in tables

nwaLayout Tables Used when you want to lay out material in a table without the
material looking as if it is in a table; in other words, without
borders

nwaContent Tables Class used for a standard table with borders

nwaTop Table Header Table heading at top

nwaLeft Table Header Left column of table

nwaRight Table Header Right column of table

nwaBottom Table Header Table heading at bottom

nwaBody Table Cell Style to apply to table cell containing data

nwaHighlight Table Cell Highlighted text (used for mouseover)

nwaSelected Table Cell Selected text (table row after mouse click)

nwaSelectedHighlight Table Cell Selected text with mouseover highlight

nwaInfo All Informational text message

nwaError All Error text message

Table 339: Formatting Classes
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Class Name Applies To Description

nwaImportant All Text that should be prominently displayed
Table subheadings

nwaUsername All Text used to display a username

nwaPassword All Text used to display a password

Smarty Template Syntax
ClearPass Guest’s user interface is built using the Smarty template engine. This template system separates the
program logic and visual elements, enabling powerful yet flexible applications to be built.

When customizing template code that is used within the user interface, you have the option of using Smarty
template syntax within the template. Using the programming features built into Smarty, you can add your own
logic to the template. You can also use predefined template functions and block functions to ensure a
consistent user interface.

Basic Template Syntax
Following is a brief introduction to the usage of the Smarty template engine. For more information, please
refer to the Smarty documentation at http://www.smarty.net/docs.php, or the Smarty Crash Course at
http://www.smarty.net/crashcourse.php.

Text Substitution
Simple text substitution in the templates may be done with the syntax {$variable}, as shown below:

The current page’s title is: {$title}

Template File Inclusion
To include the contents of another file, this can be done with the following syntax:

{include file="public/included_file.html"}

Smarty template syntax found in these files is also processed, as if the file existed in place of the {include} tag
itself.

Comments
To remove text entirely from the template, comment it out with the Smarty syntax {* commented text *}. Be
aware that this is different from an HTML comment, in that the Smarty template comment will never be
included in the page sent to the Web browser.

Variable Assignment
To assign a value to a page variable, use the following syntax:

{assign var=name value=value}

The “value” can be a text value (string), number, or Smarty expression to be evaluated, as shown in the
examples below:

{assign var=question value="forty plus two"}

The question is: {$question}

Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2842

http://www.smarty.net/documentation
http://www.smarty.net/crash_course


{assign var=answer value=42}

The answer is: {$answer}

{assign var=question_uppercase value=$question|strtoupper}

THE QUESTION IS: {$question_uppercase}

Conditional Text Blocks
To include a block of text only if a particular condition is true, use the following syntax:

{if $username != ""}

<tr>

<td class="nwaBody">Username:</td>

<td class="nwaBody">{$username}</td>

</tr>

{else}

<!-- No user name, no table row -->

{/if}

The condition tested in the {if} … {/if} block should be a valid PHP expression. The {else} tag does not require
a closing tag.

Script Blocks
The brace characters { and } are specially handled by the Smarty template engine. Using text that contains
these characters, such as CSS and JavaScript blocks, requires a Smarty block {literal} … {/literal}:

<script type="text/javascript" language="JavaScript">

{literal}

<!--

function my_function() {

// some Javascript code here

}

// -->

{/literal}

</script>

Failing to include the {literal} tag will result in a Smarty syntax error when using your template. Single
instances of a { or } character can be replaced with the Smarty syntax {ldelim} and {rdelim} respectively.

Repeated Text Blocks
To repeat a block of text for each item in a collection, use the {section} … {/section} tag:

{section loop=$collection name=i}

<tr>

<td class="nwaBody">

{$collection[i].name}

</td>

</tr>

{sectionelse}

<!-- included if $collection is empty -->

{/section}

The content after a {sectionelse} tag is included only if the {section} block would otherwise be empty.

Foreach Text Blocks
An easier to use alternative to the {section} … {/section} tag is to use the {foreach} … {/foreach} block:

{foreach key=key_var item=item_var from=$collection}

{$key_var} = {$item_var}

{foreachelse}

<!—included if $collection is empty -->

{/foreach}
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The advantage of this syntax is that each item in the collection is immediately available as the named item
variable, in this example {$item_var}. This construct is also useful when iterating through associative arrays
indexed by key, as the key is immediately available with each item.

A name= attribute may be supplied with the opening {foreach} tag. When a name is supplied, the following
additional Smarty variables are available for use inside the {foreach} … {/foreach} block:

l {$smarty.foreach.name.first} – true if the item being processed is the first item in the collection

l {$smarty.foreach.name.last} – true if the item being processed is the last item in the collection

l {$smarty.foreach.name.index} – counter for the current item, starting at 0 for the first item

l {$smarty.foreach.name.iteration} – counter for the current item, starting at 1 for the first item

l {$smarty.foreach.name.total} – value indicating the total number of items in the collection

The content after a {foreachelse} tag is included only if the {foreach} block would otherwise be empty.

Modifiers
Smarty providesmodifiers that can be used to gain greater control over the formatting of data. Modifiers can
be included by following a variable with a vertical bar | and the name of the modifier. Any arguments to the
modifier can be specified using a colon : followed by the arguments.

The following example prints a date using the YYYY-MM-DD syntax:

{$expire_time|nwadateformat:"%Y-%m-%d"}

See "Date/Time Format Syntax" on page 730 for detailed information on the date/time format modifiers, and
see Table 340.

Modifier Description

htmlspecialchars Escapes characters used in HTML syntax with the equivalent HTML entities (&amp; for
&, &lt; for < and &gt; for >)

nl2br Replaces newline characters in the value with HTML line breaks (<br>)

number_format Formats a numerical value for display; an optional modifier argument may be used to
specify the number of decimal places to display (default is 0)

nwadateformat Date/time formatting; see "nwadateformat Modifier" on page 730 for details about
this modifier function

nwatimeformat Date/time formatting; see "Date/Time Format String Reference" on page 731 for
details about this modifier function

nwamoneyformat Formats a monetary amount for display purposes; an optional modifier argument may
be used to specify the format string. This modifier is equivalent to the
NwaMoneyFormat() function; see "NwaMoneyFormat" on page 735 for details.

strtolower Converts the value to lowercase

strtoupper Converts the value to uppercase

ucfirst Converts the first character of the value to uppercase

ucwords Converts the first character of each word in the value to uppercase

Table 340: Smarty Modifiers
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Predefined Template Functions
Template functions are used to perform different kinds of processing when the template is used. The result of
a template function takes the place of the function in the output of the template.

Functions are of two kinds: block functions, which have a beginning and ending tag enclosing the text operated
on by the function, and template functions, which have just a single tag and do not enclose text.

To use a function, enclose the function name in curly braces { } and provide any attributes that may be
required for the function. Block functions also require a closing tag.

dump
{dump var=$value}

Smarty registered template function. Displays the value of a variable.

Use the following Smarty syntax to print a variable’s contents:

{dump var=$var_to_dump export=html}

The contents of the variable are printed in a <pre> block. Use the attribute “export=1” to use PHP’s var_
export() format, or omit this attribute to get the default behavior – PHP’s var_dump() format.

Use the attribute “html=1” to escape any HTML special characters in the content. This can also be done with
attribute “export=html”, and is recommended for use in most situations (so that any embedded HTML is not
interpreted by the browser).

nwa_commandlink
{nwa_commandlink} … {/nwa_commandlink}

Smarty registered block function. Generates a “command link” consisting of an icon, main text and explanatory
text.

Command links are block elements and are roughly the equivalent of a form button. A command link is
typically used to represent a choice the user should make to proceed. The command link contains an icon,
command text (that sums up the action taken by the command link), and any explanatory text needed for the
command.

Usage example:

{nwa_commandlink icon="images" command="Command Link" linkwidth="400"

commandclass="nwaImportant" text="This is a sentence explaining the command."

textclass="nwaInfo"}link_here.php{/nwa_commandlink}

l The “icon” parameter is the SRC to the image of the icon. This should normally be a relative path.

l The “command” parameter is the main text of the command link.

l The “text” parameter is the explanatory text describing the action that lies behind the command link. (This is
optional.)

l The “linkwidth” parameter, if specified, indicates the width of the command link in pixels. This should be at
least 250; the recommended value is 400.

l The “width” and “height” parameters, if specified, provide the dimensions of the icon to display. If not
specified, this is automatically determined from the image.

l The “onclick” parameter, if specified, provides the contents for the onclick attribute of the link.

l The “commandclass” parameter, if specified, sets the class attribute of the DIV element enclosing the
command text. The default class is “nwaImportant”.
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l The “textclass” parameter, if specified, sets the class attribute of the P element enclosing the command link’s
descriptive text. The default class is “nwaInfo”.

l The “alt” parameter, if specified, sets the ALT attribute of the command link’s icon. If not specified, the
default alt text used is the command text.

l The “target” parameter, if specified, sets the TARGET attribute of the hyperlink. If not specified, no TARGET
attribute is provided.

The body of the element is the HREF of the command link. The “icon” and “command” parameters are
required. All other parameters are optional.

nwa_iconlink
{nwa_iconlink} … {/nwa_iconlink}

Smarty registered block function. Generates a combined icon and text link to a specified URL.

Usage example:

{nwa_iconlink icon="images/icon-info22.png" text="More Information"}more_information.php

{/nwa_iconlink}

l The “icon” parameter is the SRC to the image of the icon. This should normally be a relative path.

l The “text” parameter is the text to display next to the icon. This will also be used as the alternate text (that
is, a tooltip) for the icon image.

l The “width” and “height” parameters, if specified, provide the dimensions of the icon to display. If not
specified, this is automatically determined from the image.

l The “onclick” parameter, if specified, provides the contents for the onclick attribute of the link.

l The “target” parameter, if specified, provides the contents for the target attribute of the link.

l The “alt” parameter, if specified, sets the ALT attribute of the icon. If not specified, the default alt text used
is the icon text.

l The “style” parameter, if specified, provides CSS for the SPAN element used to implement the icon link.

The body of the element is the HREF of the link. This HREF will be added to both the icon and the text. If the
content of the link is empty, no link will be inserted. This can be used to insert an icon and text as an inline
group. No HTML entity escaping is performed when inserting content using this function.

nwa_icontext
{nwa_icontext} … {/nwa_icontext}

Smarty registered block function. Generates a block of text with a marker icon displayed in the top left.

Usage examples:
{nwa_icontext icon="images/icon-info22.png"}Text to display{/nwa_icontext}

{nwa_icontext type="info"}Information block{/nwa_icontext}

l The “icon” parameter, if specified, is the SRC to the image of the icon. This should normally be a relative
path.

l The “width” and “height” parameters, if specified, provide the dimensions of the icon to display. If not
specified, this is automatically determined from the image.

l The “alt” parameter, if specified, provides the alternate text for the icon.

l The “class” parameter, if specified, is the style name to apply to a containing DIV element wrapped around
the content. If this is empty, and a default is not provided through the “type” parameter, no wrapper DIV is
added.
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l The “style” parameter, if specified, is the CSS inline style to apply to a containing DIV element, as for the
“class” parameter.

l The “type” parameter, if specified, indicates a predefined style to apply; this may be one of the following:

n error – red cross symbol

n fatal – skull symbol

n info – information symbol

n note (or arrow) – right-pointing arrow

n ClearPass Guest – ClearPass Guest logo

n ok (or tick) – green tick mark

n warn (or warning) – warning symbol

n wait – animated spinner

If “noindent=1” is specified, the block is not indented using the ‘nwaIndent’ style. If “novspace=1” is specified,
the block uses a ‘DIV’ element, rather than a ‘P’ element. If neither “icon” nor “type” is supplied, the default
behavior is to insert an “info” type image. Specifying a “type” is equivalent to specifying an “icon", “width",
“height” and “alt” parameter, and may also include a “class” depending on the type selected.

Usage example:
{nwa_icontext struct=$error}{/nwa_icontext}

The “struct” parameter, if specified, uses a standard result type. If the “error” key is set and non-zero, the “type”
parameter is set to the value error, and the “message” key is converted to a HTML formatted error message for
display.

nwa_qrcode
{nwa_qrcode} ... {/nwa_qrcode}

Smarty registered block function. Generates an inline image tag for a QR code.

The content of the tag is encoded within the QR code. For example, this might be a URL.

Usage example:

{nwa_qrcode width=128 format=png fg=000000 bg=ffffff padding=0 error_correction=0 class=""

style="" alt="" title=""}

Your QR code text goes here

{/nwa_qrcode}

l The “width” parameter, if specified, provides the width in pixels of the generated QR code.

l The “format” parameter is the image format for the QR code (png, gif, jpg).

l The “fg” parameter, if specified, sets the foreground color. This value uses 6 hexadecimal digits.

l The “bg” parameter, if specified, sets the background color. This value uses 6 hexadecimal digits.

l The “padding” parameter indicates the minimum padding around the QR code itself (within the image), in
pixels.

l The “error_correction” parameter, if specified, provides the amount of error correction to embed in the QR
code.

l The “class” parameter, if specified, is the HTML class attribute to apply to the image element.

l The “style” parameter, if specified, is the HTML style attribute to apply to the image element.

l The “alt” parameter, if specified, sets the HTML ALT attribute to apply to the image element.
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l The “title” parameter is the HTML title attribute to apply to the image element.

nwa_quotejs
{nwa_quotejs} … {/nwa_quotejs}

Smarty registered block function. Quotes its content in a string format suitable for use in JavaScript. This
function also translates UTF-8 sequences into the corresponding JavaScript Unicode escape sequence (\uXXXX)

Usage example:
{nwa_quotejs}String with ' and "{/nwaquote_js}

The output of this will be:
'String with \' and \"'

The “body” parameter, if set, indicates that the string quotes are already supplied; in this case the beginning
and ending quotes are not included in the output.

nwa_radius_query
{nwa_radius_query _method=MethodName _assign=var …}

Smarty registered template function. Performs accounting-based queries on the RADIUS server and returns
the result for use in a template.

Usage example:
{nwa_radius_query _method=GetCallingStationTraffic

callingstationid=$dhcp_lease.mac_address

from_time=86400 in_out=out _assign=total_traffic}

This example uses the GetCallingStationTraffic query function and passes the “callingstationid”,
“from_time” and “in_out” parameters. The result is assigned to a template variable called total_traffic, and will
not generate any output.

This template function accepts the following parameters to select a RADIUS database and other connection
options:

l _db – ID of the RADIUS database service handler (this parameter is optional, the default service handler will
be used if it not set)

l _debug – Set to a nonzero value to enable debugging

l _quiet – Set to a nonzero value to inhibit warning/error messages

The following parameters control the query to be executed:

l _method (required) – Name of the query function to execute. A brief listing of the available methods is
provided below.

l _arg0, _arg1, …, _argN (optional) – Positional arguments for the query function.

l Named arguments may also be supplied; the arguments must be named identically to the function
arguments listed in the documentation for the query function.

The following parameters control how the result should be processed:

l _assign – Name of a page variable to store the output; if not set, output is sent to the browser as the result
of evaluating the template function.

l _output – Index of item to return from the RPC result; if not set, the complete result is returned. This may
be of use when an array containing multiple values is returned and only one of these values is required.

l _default – Default value to display or return if an error occurs or the _output field is not available in the
result.
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For ease of use, “assign” is also supported as a synonym for “_assign”.

This template function does not generate any output if the _assign parameter is set.

The methods that are available for use with this function are listed below. The $criteria array consists of one or
more criteria on which to perform a database search. The array is used for advanced cases where pre-defined
helper functions do not provide required flexibility.

ChangeToRole()
ChangeToRole($username, $role_name)

Changes the RADIUS role assigned to the user. If the user currently has active sessions, this function will trigger
an RFC 3576 Change-of-Authorization (CoA) Request to the network access server.

The $username parameter specifies the user account to modify; use the expression GetAttr('User-Name') to
use the value from the RADIUS User-Name attribute.

The $role_name parameter specifies the name of the RADIUS User Role to apply to the user.

Example:

Use the following as a conditional expression for an attribute. If the user's traffic in the past 24 hours exceeds
50 MB, the user is changed to the "Over-Quota" role.

return GetUserTraffic(86400) > 50e6 && ChangeToRole("Over-Quota");

GetCallingStationCurrentSession()
GetCallingStationCurrentSession($callingstationid, $mac_format = null)

Looks up the current (most recent) active session for the specified calling station ID.

Because different NAS equipment can send differently-formatted MAC addresses in the Calling-Station-Id
attribute, the $mac_format argument may be specified. This should be a sprintf-style format string that
accepts 6 arguments (the octets of the MAC address). The default if not specified is the IEEE 802 standard
format, %02X-%02X-%02X-%02X-%02X-%02X – that is, uppercase hexadecimal with each octet separated
with a hyphen.

See "GetCurrentSession()" on page 721 for details of the return value.

GetCallingStationSessions()
GetCallingStationSessions($callingstationid, $from_time, $to_time = null, $mac_format =

null)

Calculate the number of sessions for accounting records matching a specific calling-station-id. The calling
station id address is looked up automatically from the RADIUS Access-Request (Calling-Station-ID attribute).

Because different NAS equipment can send differently-formatted MAC addresses in the Calling-Station-Id
attribute, the $mac_format argument may be specified. This should be a sprintf-style format string that
accepts 6 arguments (the octets of the MAC address). The default if not specified is the IEEE 802 standard
format, %02X-%02X-%02X-%02X-%02X-%02X – that is, uppercase hexadecimal with each octet separated
with a hyphen.

See "GetTraffic()" on page 724 for details on how to specify the time interval.

GetCallingStationTime()
GetCallingStationTime($callingstationid, $from_time, $to_time = null, $mac_format = null)
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Calculate sum of session times in a specified time interval.

Because different NAS equipment can send differently-formatted MAC addresses in the Calling-Station-Id
attribute, the $mac_format argument may be specified. This should be a sprintf-style format string that
accepts 6 arguments (the octets of the MAC address). The default if not specified is the IEEE 802 standard
format, %02X-%02X-%02X-%02X-%02X-%02X – that is, uppercase hexadecimal with each octet separated
with a hyphen.

The calling station ID is looked up automatically from the RADIUS Access-Request (Calling-Station-ID attribute).

See "GetTraffic()" on page 724 for details on how to specify the time interval.

GetCallingStationTraffic()
GetCallingStationTraffic($callingstationid, $from_time, $to_time = null,

$in_out = null, $mac_format = null)

Calculate sum of traffic counters in a time interval. Sessions are summed if they have the same Calling-Station-
Id attribute as that specified in the RADIUS Access-Request.

If no Calling-Station-Id attribute was included in the request, returns zero.

Because different NAS equipment can send differently-formatted MAC addresses in the Calling-Station-Id
attribute, the $mac_format argument may be specified. This should be a sprintf-style format string that
accepts 6 arguments (the octets of the MAC address). The default if not specified is the IEEE 802 standard
format, %02X-%02X-%02X-%02X-%02X-%02X – that is, uppercase hexadecimal with each octet separated
with a hyphen. This string matches what ClearPass Guest sees from the NAS.

The time interval specified by $from_time and optionally $to_time is also used to narrow the search.

If $to_time is not specified, $from_time is a “look back” time, that is, the time interval in seconds before the
current time.

If $to_time is specified, the interval considered is between $from_time and $to_time.

$in_out may be “in” to count only input octets, “out” to count only output octets, or any other value to count
both input and output octets towards the traffic total.

Examples:

l Use the following as the condition expression for a RADIUS role attribute. Authorizes a user only if their
total traffic (in + out) in the past day does not exceed 10 MB. Be aware that the attribute with this condition
expression will never be included in the response!

l return GetUserTraffic(86400) > 10485760 && AccessReject()

l Like the above, but only considers output (that is, user downloads):

l return GetUserTraffic(86400,'out') > 10485760 && AccessReject()

l Another way to limit the past 30 days downloads to 100 MB:

l return GetUserTraffic($now - 86400*30, $now, 'out') > 100*1024*1024 && AccessReject()

l Limit by MAC address, 50 MB download in past 24 hours:
return GetCallingStationTraffic(86400, 'out') > 50000000 && AccessReject()

GetCurrentSession()
GetCurrentSession($criteria)

Looks up the details for an active session, based on the specified criteria.
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This is a multi-purpose function that has a very flexible query interface. For ease of use, consider using one of the
related functions "GetCallingStationCurrentSession()" on page 720, "GetIpAddressCurrentSession()" on page 722, or
"GetUserCurrentSession()" on page 725.

Returns null if there is no matching session, otherwise returns a single session array – a typical result follows:
array (

'id' => '2073',

'acctsessionid' => '4a762dbf00000002',

'acctuniqueid' => 'c199b5a94ebf5184',

'username' => 'demo@example.com',

'realm' => '',

'role_name' => 'Guest',

'nasipaddress' => '192.168.2.20',

'nasportid' => '',

'nasporttype' => '',

'calledstationid' => '',

'callingstationid' => '',

'acctstarttime' => '1249258943',

'connectinfo_start' => '',

'acctstoptime' => NULL,

'connectinfo_stop' => NULL,

'acctsessiontime' => 0,

'acctinputoctets' => 0,

'acctoutputoctets' => 0,

'acctterminatecause' => NULL,

'servicetype' => '',

'framedipaddress' => '192.168.2.3',

'framedprotocol' => '',

'acctauthentic' => '',

'nastype' => 'cisco_3576',

'nas_name' => 'centos',

'total_traffic' => 0,

'state' => 'stale',

'traffic_input' => 0,

'traffic_output' => 0,

'traffic_usage' => 0,

'session_time' => 29641260,

)

GetIpAddressCurrentSession()
GetIpAddressCurrentSession($ip_addr = null)

Looks up the current (most recent) active session for the specified client IP address. If ip_addr is not specified,
it defaults to the current value of $smarty.server.REMOTE_ADDR, which may not be the same value as the IP
address of the session if there is a NAT.

See "GetCurrentSession()" on page 721 for details of the return value.

GetIpAddressSessions()
GetIpAddressSessions($ip_addr, $from_time = null, $to_time = null)

Calculate the number of sessions for accounting records matching a specific IP address. The IP address
attribute is looked up automatically from the RADIUS Access-Request (Framed-IP-Address attribute).

See "GetTraffic()" on page 724 for details on how to specify the time interval.

See "GetIpAddressTraffic()" on page 723 for additional details on the $ip_addr argument.

GetIpAddressTime()
GetIpAddressTime($ip_addr, $from_time = null, $to_time = null)
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Calculate sum of session times in a specified time interval. The IP address is looked up automatically from the
RADIUS Access-Request (Framed-IP-Address attribute).

See "GetTraffic()" on page 724 for details on how to specify the time interval.

See "GetIpAddressTraffic()" on page 723 for additional details on the $ip_addr argument.

GetIpAddressTraffic()
GetIpAddressTraffic($ip_addr, $from_time = null, $to_time = null, $in_out = null)

Calculate sum of traffic counters in a time interval. The IP address used is determined based on the context. If
processing a RADIUS Access-Request, the IP address is determined using the Framed-IP-Address attribute. If
processing a HTTP request, the current client IP address is assumed
(from $_SERVER['REMOTE_ADDR']).

Specifying an empty value for the IP address (such as null, false, or empty string) also causes the current client
IP address to be used.

See "GetTraffic()" on page 724 for details on how to specify the time interval.

GetSessions()
GetSessions($criteria, $from_time, $to_time = null)

Calculate the number of sessions from accounting records in the database.

This is a multi-purpose function that has a very flexible query interface. For ease of use, consider using one of the
related functions "GetCallingStationSessions()" on page 720, "GetIpAddressSessions()" on page 722,
"GetUserActiveSessions()" on page 724, or "GetUserSessions()" on page 725.

$criteria is the criteria on which to search for matching accounting records.

As well as the criteria specified, the time interval specified by $from_time and optionally $to_time is also
used to narrow the search.

If $to_time is not specified, $from_time is a “look back” time, that is, the time interval in seconds before the
current time.

If $to_time is specified, the interval considered is between $from_time and $to_time.

Returns the total number of sessions for matching accounting records in the time interval specified.

GetSessionTimeRemaining()
GetSessionTimeRemaining($username, $format = “relative”)

Calculates the session time remaining for a given user account, if the user account was to be authenticated at
the moment of the call.

The $username parameter is required. This is the username for the authentication.

The $format parameter is optional, and defaults to “relative” if not otherwise specified. This parameter may be
one of the following values:

l “relative” or “session_time”: Calculates the session timeout as for the Session-Timeout RADIUS attribute,
that is, the number of seconds before the session should end. If the session does not have a session
timeout, the value returned is 0.

l “time”: Calculates the session end time, as the UNIX time at which the session should end. If the session
does not have an expiration time, the value returned is 0.
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l Other values: These are interpreted as a date format (see “NwaDateFormat”) and the session end time is
returned in this format. (Examples: “iso8601”, “longdate”, “recent”, ‘%Y-%m-%d %H:%M’, etc.). If the session
does not have an expiration time, the value returned is a blank string.

GetTime()
GetTime($criteria, $from_time, $to_time = null)

Calculate the sum of session times for accounting records in the database.

This is a multi-purpose function that has a very flexible query interface. For ease of use, consider using one of the
related functions. See "GetCallingStationTime()" on page 720, "GetIpAddressTime()" on page 722, or "GetUserTime()
" on page 725.

$criteria is the criteria on which to search for matching accounting records.

As well as the criteria specified, the time interval specified by $from_time and optionally $to_time is also
used to narrow the search.

If $to_time is not specified, $from_time is a “look back” time, that is, the time interval in seconds before the
current time.

If $to_time is specified, the interval considered is between $from_time and $to_time.

Returns the total session time for all matching accounting records in the time interval specified.

GetTraffic()
GetTraffic($criteria, $from_time, $to_time = null, $in_out = null)

Calculate the sum of traffic counters for accounting records in the database.

Revoking access for a device is only possible This is a multi-purpose function that has a very flexible query interface.
For ease of use, consider using one of the related functions "GetCallingStationTraffic()" on page 721,
"GetIpAddressTraffic()" on page 723, or "GetUserTraffic()" on page 725.

$criteria is the criteria on which to search for matching accounting records. The time interval specified by
$from_time and optionally $to_time is used with the criteria to narrow the search.

If $to_time is not specified, $from_time is a “look back” time, that is, the time interval in seconds before the
current time. If $to_time is specified, the interval considered is between $from_time and $to_time.

$in_out may be “in” to count only input octets, “out” to count only output octets, or any other value to count
both input and output octets towards the traffic total. This argument returns the computed total of traffic for
all matching accounting records.

GetUserActiveSessions()
GetUserActiveSessions($username, $callingstationid = null)

Looks up the list of all sessions for the specified username.

The username attribute is looked up automatically from the RADIUS Access-Request (User-Name attribute). If a
$callingstationid argument is supplied, sessions that match that Calling-Station-Id are excluded from the
count of active sessions.

GetUserActiveSessionCount()
GetUserActiveSessionCount($username)

Counts the number of currently active sessions for the current username.
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The username attribute is looked up automatically from the RADIUS Access-Request (User-Name attribute).

GetUserCumulativeUsage()
GetUserCumulativeUsage($username)

Looks up the total cumulative time for the username.

The username attribute is looked up automatically from the RADIUS Access-Request (User-Name attribute).

GetUserCurrentSession()
GetUserCurrentSession($username)

Looks up the current (most recent) active session for the specified username.

See "GetCurrentSession()" on page 721 for details of the return value.

GetUserFirstLoginTime()
GetUserFirstLoginTime($username)

Looks up the first login time for the specified username.

The username attribute is looked up automatically from the RADIUS Access-Request (User-Name attribute).

GetUserSessions()
GetUserSessions($username, $from_time, $to_time = null)

Calculate the number of sessions for accounting records matching a specific user-name. The username
attribute is looked up automatically from the RADIUS Access-Request (User-Name attribute).

See "GetTraffic()" on page 724 for details on how to specify the time interval.

GetUserTime()
GetUserTime($username, $from_time, $to_time = null)

Calculate sum of session times in a specified time interval.

See "GetTraffic()" on page 724 for details on how to specify the time interval.

GetUserTraffic()
GetUserTraffic($username, $from_time, $to_time = null, $in_out = null)

Calculate sum of traffic counters in a time interval. Sessions are summed if they have the same User-Name
attribute as that specified in the RADIUS Access-Request.

See "GetCallingStationTraffic()" on page 721 for details on how to specify the time interval.

Advanced Developer Reference
The reference documentation in this section is intended for advanced usage by developers.

nwa_assign
{nwa_assign …}

Smarty registered template function. Assigns a page variable based on the output of a generator function.

Simple usage example:
{nwa_assign var=my_variable value=my_value}

l The “var” parameter specifies the page variable that will receive the output.

l The “value” parameter specifies the value to assign to “var”.
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The various request variables may also be accessed using the following supported method:

l {nwa_assign var=smarty.get.get_variable value=...}

Alternative usage example:
{nwa_assign var=userskin_plugin generator=NwaGetPluginDetails arg=$u.userskin}

l The “generator” parameter specifies the generator function to be called.

l A single “arg” parameter, if specified, provides a 1-argument form of calling the function; alternatively,
“arg1”, “arg2”, ... may be specified to form an array of arguments to pass to the generator.

nwa_bling
{nwa_bling …}

Smarty registered template function. Adds various kinds of visual effects to the page.

Usage example:
{nwa_bling id=$some_id type=fade}

The “id” parameter is the ID of the HTML element to which you will add ‘bling’ effects The “type” parameter is
the kind of bling desired:

l “fade”: element smoothly fades in and out

l “blink”: element blinks slowly

nwa_makeid
{nwa_makeid …}

Smarty registered template function. Creates a unique identifier and assigns it to a named page variable.
Identifiers are unique for a given page instantiation.

Usage example:
{nwa_makeid var=some_id}

The “var” parameter specifies the page variable that will be assigned.

Alternative usage:
{nwa_makeid var=some_id file=filename}

The “file” parameter specifies a file which contains a unique ID. This allows issued IDs to be unique across
different page loads. To return the value rather than assign it to a variable, use the syntax:

{nwa_makeid [file=filename] output=1}

Otherwise, this template function does not generate any output.

nwa_nav
{nwa_nav} … {/nwa_nav}

Smarty registered block function. Defines a block area for navigation, a control, or generates navigation control
HTML of a particular type.

Blocks are individual components of the navigation area, which basically consist of HTML. Blocks for actual
navigation items have substitution tags in the form @tagname@.

The recognized tags are described in the table below.
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Tag Description

@a@ <a href="navigation_href">navigation name</a>

@name@ navigation item name (HTML safe)

@jsname@ navigation item name (JavaScript quoted)

@href@ navigation item hyperlink

@jshref@ navigation item hyperlink (JavaScript quoted)

@icon@ navigation item icon, if specified

Table 341: Navigation Tags

When used with the “block” parameter, the {nwa_nav} control does not generate any HTML. When used with
the “type” parameter, the {nwa_nav} control uses the previously defined blocks to generate the HTML
navigation area. The following types are recognized:

l simple – Only the current L1 item has L2 items, L3 only when L2 active

l all-l1 – All current L1 items are shown to L3, otherwise L1 only

l expanded – All L1 items have L2 items, L3 only when L2 active

l all-expanded – All items shown to L3

The “reset” parameter may be specified to clear any existing navigation settings.
Usage example:

{nwa_nav block=level1_active}<li class="active">@a@</li>{/nwa_nav}{nwa_nav block=level1_

inactive}<li>@a@</li>{/nwa_nav}...{nwa_nav type=simple}{/nwa_nav} {* this generates the

HTML *}

Block types can be one of the following types:

l enter_level1_item

l enter_level2_item

l enter_level3_item

l exit_level1_item

l exit_level2_item

l exit_level3_item

l between_level1_items

l between_level2_items

l between_level3_items

l level1_active

l level1_inactive

l level2_active

l level2_inactive

l level2_parent_active

l level2_parent_inactive

l level3_active
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l level3_inactive

l enter_level1

l enter_level2

l enter_level3

l exit_level1

l exit_level2

l exit_level3

nwa_plugin
{nwa_plugin …}

Smarty registered template function. Generates plugin information based on the parameters specified.
Specifying which plugin:

l The ‘id’ parameter specifies a plugin ID.

l The ‘name’ parameter specifies a plugin name, or plugin filename.

l The ‘page’ parameter specifies a page name provided by the plugin.

l The ‘privilege’ parameter specifies a privilege defined by the plugin.

If none of the above is specified, the default is the same as specifying the ‘page’ parameter with the current
script name as argument (that is, the current page).

Specifying the output:

l The ‘notfound’ parameter specifies the return value, if the plugin was not found (default is the empty
string).

l The ‘output’ parameter specifies the metadata field to return

If ‘output’ is not specified, the default is ‘output=id’; that is, the plugin ID is returned.

nwa_privilege
{nwa_privilege} … {/nwa_privilege}

Smarty registered block function. Includes output only if a certain kind of privilege has been granted.

Usage examples:
{nwa_privilege access=create_user} .. content .. {/nwa_privilege}

The “access” parameter specifies the name of a privilege to check for any access.

{nwa_privilege readonly=create_user} .. content .. {/nwa_privilege}

The “readonly” (synonym “ro”) parameter specifies the name of a privilege to check for read-only access. Be
aware that an operator with read-write access also has read-only access. To include content if the user ONLY
has read access, that is, not if the user has full access, prefix the privilege name with a # character and use the
parameter name “readonly” (or “ro”).

{nwa_privilege full=create_user} .. content .. {/nwa_privilege}

The “full” (synonym “rw”) parameter specifies the name of a privilege to check for full read-write access. The
“name” parameter is the name of the privilege to check. If “name” is prefixed with a “!”, the output is included
only if that privilege is NOT granted (inverts the sense of the test). An optional “level” parameter may be
specified, which is the level of access to the privilege required (default is 0, or any access).
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nwa_replace
{nwa_replace 1=… 2=…} … {/nwa_replace}

Smarty registered block function. Replace %1, %2, etc with the passed parameters 1=, 2=, etc.

Usage example:
{nwa_replace 1=$param1 2=$param2 ...}

This is the text resource to be replaced, where %1 and %2

are the arguments, etc.

{/nwa_replace}

The numbered parameters are expanded in the translated string with the positional arguments %1, %2 and so
forth.

nwa_text
{nwa_text} … {/nwa_text}

Smarty registered block function. Translates the block’s content, if a language pack is available.

Usage example:
{nwa_text id=TEXT_ID 1=$param1 2=$param2 ...}

This is the text resource to be translated, where %1 and %2 are the arguments, etc.

{/nwa_text}

l The “id” parameter is the text ID of the resource.

l The numbered parameters are expanded in the translated string with the positional arguments %1, %2 and
so forth.

nwa_userpref
{nwa_userpref …}

Smarty template function. Returns the current setting of a user preference (stored with the Web application
user account)

Usage examples:
{nwa_userpref name=prefName}

{nwa_userpref name=prefName default=10}

{nwa_userpref has=prefName}

l “name”: return the named user preference

l “default”: supply a value to be returned if the preference is not set

l “has”: return 1 if the named preference exists for the current user, 0 if the preference does not exist

nwa_youtube
{nwa_youtube video=ID width=cx height=cy …} … {/nwa_youtube}

Smarty registered block function. Provides simple support for embedding a YouTube video in the body of a
page. The content of this block is the initial “alternate content” that will be presented until the YouTube player
can be embedded (if it can be embedded).

Not all devices are capable of playing back YouTube video content.

Usage example:
{nwa_youtube video=Y7dpJ0oseIA width=320 height=240}

YouTube is the world’s most popular online video community.

{/nwa_youtube}
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The supported parameters for this block function are:

l video (required) – the YouTube video ID to embed.

l width (required) – the width in pixels of the video.

l height (required) – the height in pixels of the video.

l autoplay (optional) – if true, auto-play the video.

l chrome (optional) – if true, use the chromed player; that is, provide a user experience with playback
controls.

l version (optional) – the minimum version required to play the video.

l onended (optional) – the name of a global function (that is, a member of the JavaScript “window” object)
that is to be called at the end of video playback.

Date/Time Format Syntax
This section describes the two basic modifiers available for you to use in ClearPass Guest:

l "nwadateformat Modifier" on page 730

l "nwatimeformat Modifier" on page 731

nwadateformat Modifier
The date format takes one or two arguments – the format description and an optional default value (used if
there is no time/date to display). UTF-8 is the character encoding used throughout the application, as this
covers languages such as Spanish that use non-ASCII characters.

The full list of special formats is:

Preset Name Date/Time Format Example

hhmmss %H%M%S 141345

hh:mm:ss %H:%M:%S 14:13:45

iso8601 %Y%m%d 20080407

iso8601t %Y%m%d%H%M%S 20080407141345

iso-8601 %Y-%m-%d 2008-04-07

iso-8601t %Y-%m-%d %H:%M:%S 2008-04-07 14:13:45

longdate %A, %d %B %Y, %I:%M %p Monday, 07 April 2008, 2:13
PM

rfc822 %a, %d %b %Y %H:%M:%S %Z Mon, 07 Apr 2008 14:13:45
EST

displaytime %l:%M %p 2:13 PM

recent – 2 minutes ago

Table 342: Date and Time Formats

The % items on the right hand side are the same as those supported by the php function strftime().
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The string “?:”, if present will return the string following the “?:” if the time value is 0. Otherwise, the format
string up to the “?:” is used.

See "Date/Time Format String Reference" on page 731 in this chapter for a full list of the supported date/time
format string arguments.

Examples of date formatting using the nwadateformat Smarty modifier are as follows:

{$u.expire_time|nwadateformat:"longdate"}
Monday, 07 April 2008, 2:13 PM

{$u.expire_time|nwadateformat:"iso8601"}
20080407

{$u.expire_time|nwadateformat:"iso-8601t"}
2008-04-07 14:13:45

{$u.expire_time|nwadateformat:"iso8601?:N/A"}
20080407   (or N/A if no time specified)

{$u.expire_time|nwadateformat:"%m/%d/%Y"}
04/07/2008

nwatimeformat Modifier
The nwatimeformat modifier takes one argument – the format description. The “minutes_to_natural”
argument converts an argument specified in minutes to a text string describing an equivalent but more natural
measurement for the time interval (hours, days or minutes depending on the value). An example of this usage
is for the expire_postlogin field which has a value measured in minutes:
{$u.expire_postlogin|nwatimeformat:"minutes_to_natural"}

The other formats accepted for this modifier are the same as those described for the nwadateformat modifier.
See "nwadateformat Modifier" on page 730.

Date/Time Format String Reference

Format Result

%a Abbreviated weekday name for the current locale

%A Full weekday name for the current locale

%b Abbreviated month name for the current locale

%B Full month name for the current locale

%c Preferred date and time representation for the current locale

%C Century number (2-digit number, 00 to 99)

%d Day of the month as a decimal number (01 to 31)

%D Same as %m/%d/%y

Table 343: Date and Time Format Strings
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Format Result

%e Day of the month as a decimal number; a single digit is preceded by a space (‘ 1’ to ‘31’)

%h Same as %b

%H Hour as a decimal number (00 to 23)

%l Hour as a decimal number (01 to 12)

%m Month as a decimal number (01 to 12)

%M Minute as a decimal number (00 to 59)

%p “AM” or “PM”

%r Local time using 12-hour clock (%l:%M %p)

%R Local time using 24-hour clock (%H:%M)

%S Second as a decimal number (00 to 60)

%T Current time (%H:%M:%S)

%u Weekday as a decimal number (1=Monday…7=Sunday)

%w Weekday as a decimal number (0=Sunday…6=Saturday)

%x Preferred date representation for the current locale, without the time

%X Preferred time representation for the current locale, without the date

%y Year as a decimal number without the century (00 to 99)

%Y Year as a decimal number

%% A literal % character

Programmer’s Reference
This section describes the following:

l "NwaAlnumPassword" on page 733

l "NwaBoolFormat" on page 733

l "NwaByteFormat" on page 733

l "NwaByteFormatBase10" on page 733

l "NwaComplexPassword" on page 733

l "NwaCsvCache" on page 734

l "NwaDigitsPassword($len)" on page 734

l "NwaDynamicLoad" on page 734

l "NwaGeneratePictureString" on page 734
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l "NwaGenerateRandomPasswordMix" on page 734

l "NwaLettersDigitsPassword" on page 735

l "NwaLettersPassword" on page 735

l "NwaMoneyFormat" on page 735

l "NwaParseCsv" on page 735

l "NwaParseXml" on page 736

l "NwaPasswordByComplexity" on page 736

l "NwaSmsIsValidPhoneNumber" on page 737

l "NwaStrongPassword" on page 737

l "NwaVLookup" on page 737

l "NwaWordsPassword" on page 738

NwaAlnumPassword
NwaAlnumPassword($len)

Generates an alpha-numeric password (mixed case) of length $len characters.

NwaBoolFormat
NwaBoolFormat($value, $options = null)

Formats a Boolean value as a string. If 3 function arguments are supplied, the 2nd and 3rd arguments are the
values to return for false and true, respectively. Otherwise, the $options parameter specifies how to do the
conversion:

l If an integer 0 or 1, the string values “0” and “1” are returned.

l If a string containing a “|” character, the string is split at this separator and used as the values for false and
true respectively.

l If an array, the 0 and 1 index values are used for false and true values.

l Otherwise, the string values “true” and “false” are returned.

NwaByteFormat
NwaByteFormat($bytes, $unknown = null)

Formats a non-negative size in bytes as a human readable number (bytes, KB, MB, GB, etc.) Assumes that 1 KB
= 1024 bytes, 1 MB = 1024 KB, etc. If a negative value is supplied, returns the $unknown string. If a non-
numeric value is supplied, that value is returned directly.

NwaByteFormatBase10
NwaByteFormatBase10($bytes, $unknown = null)

Formats a non-negative size in bytes as a human readable number (bytes, KB, MB, GB, etc.) Assumes “base 10”
rules in measurement; that is, 1 KB = 1000 bytes, 1 MB = 1000 KB, etc. If a negative value is supplied, returns
the $unknown string. If a non-numeric value is supplied, that value is returned directly.

NwaComplexPassword
NwaComplexPassword($len = 8)
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Generates complex passwords of at least $len characters in length, where $len must be at least 4. A complex
password includes at least 1 each of a lower case character, upper case character, digit, and punctuation
(symbol).

NwaCsvCache
NwaCsvCache($csv_file, $use_cache = true, $options = null)

Loads and parses the contents of a CSV file, using a built-in cache. The cache may be cleaned for a specific file
by setting $use_cache to false. The cache may be cleaned for ALL files by setting $csv_file to the empty
string and $use_cache to false.

CSV parsing options (see "NwaParseCsv" on page 735) may be specified in $options. Additionally, a 2-
argument form of this function may be used by passing an array of $options as the second argument; in this
case, $use_cache is assumed to be true. This function returns false if the file does not exist; otherwise,
returns an array of arrays containing each of the parsed records from the file.

NwaDigitsPassword($len)
NwaDigitsPassword($len)

Generates digit-only passwords of at least $len characters in length.

NwaDynamicLoad
NwaDynamicLoad($func)

Loads the PHP function $func for use in the current expression or code block. Returns true if the function
exists (that is, the function is already present or was loaded successfully), or false if the function does not exist.

Attempting to use an undefinced function will result in a PHP Fatal Error. Use this function before using any of the
standard Nwa...() functions.

NwaGeneratePictureString
NwaGeneratePictureString($string)

Creates a password based on a format string. For details on the special characters recognized in $string, see
"Format Picture String Symbols" on page 750.

NwaGenerateRandomPasswordMix
NwaGenerateRandomPasswordMix($password_len, $lower = 1, $upper = 1, $digit = 1, $symbol = -

1)

Generates a random password that meets a certain minimum complexity requirement.

l $password_len specifies the total length in characters of the generated password. The password returned
will be at least $upper + $lower + $digit + $symbol characters in length. Any length beyond the
required minimum will be made up of any allowed characters.

l $lower specifies the minimum number of lowercase characters to include, or -1 to not use any lowercase
characters.

l $upper specifies the minimum number of uppercase characters to include, or -1 to not use any uppercase
characters.

l $digit specifies the minimum number of digits to include, or -1 to not use any digits.
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l $symbol specifies the minimum number of symbol characters to include, or -1 to not use any symbol or
punctuation characters.

NwaLettersDigitsPassword
NwaLettersDigitsPassword($len)

Generates an alpha-numeric password of $len characters in length consisting of lowercase letters and digits.

NwaLettersPassword
NwaLettersPassword($len)

Generates a password of $len characters in length consisting of lowercase letters.

NwaMoneyFormat
NwaMoneyFormat($amount, $format = null)

Formats a monetary amount for display purposes. The current page language is used to adjust formatting to
the country specified. Returns a result that is guaranteed to be in UTF-8.

The $format argument may be null, to specify the default behavior (U.S. English format), or it may be a
pattern string containing the following:

l currency symbol (prefix)

l thousands separator

l decimal point

l number of decimal places

The format “€1.000,00” uses the Euro sign as the currency symbol, “.” as the thousands separator, “,” as the
decimal point, and 2 decimal places.

If not specified explicitly, the default format is “$1,000.00”.

NwaParseCsv
NwaParseCsv($text, $options = null)

Parses text containing comma-separated values and returns the result as a list of records, where each record
contains a list of fields. Supports CSV escaping using double quotes.

$options may be specified to control additional parsing options described in the table below.

Function Description

fs The field separator character (default is comma “,”)

rs The record separator character (default is newline “\n”)

quo The quote character (default is double quote ")

excel_compatible If true, recognize ="..." syntax as well as "..." (default true)

dos_compatible If true, convert \r\n line endings to \n (default true)

Table 344: Parsing Options
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Function Description

encoding If set, specifies the input character set to convert from (default not set)

out_charset If set, specifies the desired character set to convert to using the iconv() function .
(default is "UTF-8//TRANSLIT")

max_records maximum number of records to return

max_fields maximum number of fields per record

skip_records number of records to skip at start of input

skip_fields number of fields to skip at start of each record

sort post-processing option; order string for NwaCreateUsortFunc to sort the records by
the specified column(s)

slice_offset post-processing option: starting offset of slice to return; see array_slice() function

slice_length post-processing option: length of slice to return; see array_slice() function

See "NwaParseCsv" on page 735 and "NwaVLookup" on page 737.

NwaParseXml
NwaParseXml($xml_text)

Parses a string as an XML document and returns the corresponding document structure as an associative
array. Returns an array containing the following elements:

l error – set if there was a problem parsing the XML

l message – describes the parse error

Otherwise, the return is an array with these elements:

l name – name of the document element

l attributes – attributes of the document element

l children – array containing any child elements

l content – element content text

NwaPasswordByComplexity
NwaPasswordByComplexity($len, $mode = false)

Generates a random password of at least $len characters in length, based on one of the standard complexity
requirements specified in $mode. If $mode is false or the empty string, the default password complexity is
taken from the Guest Manager plugin configuration.

Otherwise, $mode should be one of the following values:

l none – No password complexity requirement

l case – At least one uppercase and one lowercase letter

l number – At least one digit

l punctuation – At least one symbol

l complex – At least one of each: uppercase letter, lowercase letter, digit, and symbol
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NwaSmsIsValidPhoneNumber
NwaSmsIsValidPhoneNumber($phone_number)

Validates a phone number supplied in E.164 international dialing format, including country code.

l Any spaces and non-alphanumeric characters are removed.

l If the first character is a plus sign (+), the phone number is assumed to be in E.164 format already and the
plus sign is removed; otherwise, if the SMS service handler national prefix is set and the phone number
starts with that prefix, then the prefix is replaced with the country code.

l The phone number must contain no fewer than 5 and no more than 15 digits.

l The phone number is validated for a valid country code prefix.

l If all the foregoing conditions are met, the validator returns TRUE; otherwise, the validator returns FALSE.

NwaStrongPassword
NwaStrongPassword($len)

Generate strong passwords of $len characters in length.

A strong password may contain uppercase letters, lowercase letters, digits and certain symbols. The strong
password does not contain commonly-confused characters such as “O” and “0” (capital O and zero), “I” and “l”
(capital I and lowercase L), “2” and “Z” (two and capital Z), or “8” and “B” (eight and capital B).

NwaVLookup
NwaVLookup($value, $table, $column_index, $range_lookup = true, $value_column = 0, $cmp_fn

= null)

Table lookup function, similar to the Excel function VLOOKUP(). This function searches for a value in the first
column of a table and returns a value in the same row from another column in the table. This function
supports the values described in the table below.

Option Description

$value The value to be searched for

$table A 2D array of data to search; for example, a data table returned by NwaCsvCache()
or NwaParseCsv()

$column_index The desired index of the data

$range_lookup Specifies whether to find an exact or approximate match.
If true (default), assumes the table is sorted and returns either an exact match, or the
match from the row with the next largest value that is less than $value. If false, only
an exact match is returned; NULL is returned on no match

value_column Specifies the column index in the table that contains the values; the default is 0; in
other words, the first column.

$cmp_fn Specifies a comparison function to use for values; if null, the default is used (simple
equality operator ==, or the == and > operators if using binary search).
The comparison function should take 2 arguments and return a value < 0, == 0, > 0
depending on the sort ordering of the arguments.

Table 345: NwaVLookup Options
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Be aware of the following differences from Excel VLOOKUP:

l Column indexes are 0-based.

l Column indexes can also be strings.

See "NwaParseCsv" on page 735 and "NwaCsvCache" on page 734.

NwaWordsPassword
NwaWordsPassword($len)

Generates a password consisting of two randomly-chosen words, separated by a small number (1 or 2 digits);
that is, in the format word1XXword2. The random words selected will have a maximum length of $len
characters, and a minimum length of 3 characters. $len must be at least 3.

Field, Form, and View Reference
This section describes the following:

l "GuestManager Standard Fields" on page 738

l "Hotspot Standard Fields" on page 747

l "SMS Services Standard Fields" on page 748

l "SMTP Services Standard Fields" on page 748

l "Format Picture String Symbols" on page 750

l "Form Field Validation Functions" on page 751

l "Form Field Conversion Functions" on page 759

l "Form Field Display Formatting Functions" on page 760

l "View Display Expression Technical Reference" on page 761

GuestManager Standard Fields
The table below describes standard fields available for the GuestManager form.
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Field Description

account_activation String. The current account activation time in long form. This field is available on
the change_expiration and guest_enable forms. The value is generated from the
start_time field, and may be one of the following:
l Account will be enabled at date andtime
l Account is currently active
l No account activation

auto_update_account Boolean flag indicating that an already existing account should be updated,
rather than failing to create the account. This field should normally be enabled
for guest self-registration forms, to ensure that a guest that registers again with
the same email address has their existing account automatically updated. Set
this field to a non-zero value or a non-empty string to enable automatic update
of an existing account. This field controls account creation behavior; it is not
stored with created guest accounts.

auto_update_account Boolean flag indicating that an already existing account should be updated,
rather than failing to create the account. This field should normally be enabled
for guest self-registration forms, to ensure that a guest that registers again with
the same email address has their existing account automatically updated. Set
this field to a non-zero value or a non-empty string to enable automatic update
of an existing account. This field controls account creation behavior; it is not
stored with created guest accounts.

captcha Special field used to enable the use of a CAPTCHA security code on a form. This
field should be used with the user interface type “CAPTCHA security code” and
the standard validator NwaCaptchaIsValid in order to provide the standard
security code functionality.

change_of_
authorization

Boolean flag indicating that any existing sessions for a guest account should be
disconnected or modified using RFC 3576. If this field is not specified on a form
that modifies the guest account, the default value is taken from the
configuration for the RADIUS Services plugin.
Set this field to a non-zero value or a non-empty string to enable RFC 3576
updates for active sessions. Set this field to a zero value or the empty string to
disable RFC 3576 updates for active sessions.

create_time Integer. Time at which the account was first created. The creation time is
specified as a UNIX timestamp. This field is automatically configured with the
current time when the Initial Value is set to: array('generator' => 'time')

If the same username is registered again, the create_time field is not
overwritten.

creator_accept_terms Boolean flag indicating that the creator has accepted the terms and conditions
of use. When creating an account, this field must be present, and must be set to
the value 1. If this field is unset, or has any other value, account creation will fail
with an error message.
To set the correct value for this field, use a check box (to require confirmation
from the creator) or a hidden field (if use of the form is considered acceptance
of the terms and conditions). This field controls account creation behavior; it is
not stored with created guest accounts.

creator_name String. Name of the creator of the account. This field does not have a default
value. See "sponsor_name" on page 746.

do_expire Integer that specifies the action to take when the expire time of the account is

Table 346: GuestManager Standard Fields
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Field Description

reached. See "expire_time" on page 741.
l 0—Account will not expire
l 1—Disable
l 2—Disable and logout
l 3—Delete
l 4—Delete and logout
“Disable” indicates that the enabled field will be set to 0, which will prevent
further authorizations using this account.
“Logout” indicates that a RADIUS Disconnect-Request will be used for all active
sessions that have a username matching the account username. This option
requires the NAS to support RFC 3576 Dynamic Authorization. See "RFC 3576
Dynamic Authorization" on page 40 for more information.

dynamic_expire_time Integer. Time at which the account will expire, calculated according to the
account’s expiration timers. The value of this field is a UNIX timestamp. This field
is available when modifying an account using the change_expiration or guest_
edit forms.

dynamic_is_authorized Boolean flag indicating if the user account is authorized to log in. This field is
available when modifying an account using the change_expiration or guest_edit
forms.

dynamic_is_expired Boolean flag indicating if the user account has already expired. This field is
available when modifying an account using the change_expiration or guest_edit
forms.

dynamic_session_time Integer. The maximum session time that would be allowed for the account, if an
authorization request was to be performed immediately. Measured in seconds.
Set to 0 if the account is either unlimited (dynamic_is_expired is false), or if the
account has expired (dynamic_is_expired is true). This field is available when
modifying an account using the change_expiration or guest_edit forms.

email String. Email address for the account. This field may be up to 100 characters in
length. When creating an account, if the username field is not set then the
email field is used as the username of the account.

enabled Boolean flag indicating if the account is enabled. Set this field to 0 to disable the
account. If an account is disabled, authorization requests for the account will
always fail. Set this field to 1 to enable the account.

expiration_time String. Description of the account’s expiration time. This field is set when
modifying an account. This field is available on the change_expiration and guest_
enable forms. The value is generated from the do_expire, expire_time, expire_
postlogin and expire_usage fields, and may be one of the following:
l Account will expire at date andtime, or interval after first login, or after

interval total usage
l Account will expire at date andtime or interval after first login
l Account will expire at date andtime or after interval total usage
l Account will expire at date andtime
l Expires interval after first login or after interval total usage
l Expires interval after first login
l Expires after interval total usage
l No expiration time set

Table 346: GuestManager Standard Fields(Continued)
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Field Description

expire_time Integer. Time at which the account will expire. The expiration time should be
specified as a UNIX timestamp.
Setting an expire_time value also requires a non-zero value to be set for the
do_expire field; otherwise, the account expiration time will not be used. Set this
field to 0 to disable this account expiration timer.
If the expire_timezone field is used in conjunction with expire_time and a time
zone and date are selected, the date calculation is adjusted relative to the time
zone.

expire_timezone String. Provides a drop-down list of time zones to use in conjunction with expire_
time and start_time. When expire_timezone is selected and a date is chosen,
the date is adjusted to be relative to the time zone. Receipts and edits made
after an account is created are displayed in the account’s local time zone.
By default, expire_timezone uses the NwaGenerateTimeZoneList options
generator. To use a smaller subset of time zones, change the Options
Generator to (Use options) and provide your "value | name" pairs. Please
reference the default list for valid time zone values.

expire_usage Integer. The total time period in seconds for which the account may be used.
Usage is calculated across all accounting sessions with the same username. Set
this field to 0 to disable this account expiration timer.

http_user_agent String. Identifies the Web browser that you are using. This tracks user’s
browsers when they are registering. This is stored with the user’s account.

id String. Internal user ID used to identify the guest account to the system.

ip_address String. The IP address to assign to stations authenticating with this account. This
field may be up to 20 characters in length. The value of this field is not currently
used by the system. However, a RADIUS user role may be configured to assign
IP addresses using this field by adding the Framed-IP-Address attribute, and
setting the value for the attribute to: <?= $user["ip_address"]

modify_expire_postlogin String Value indicating how to modify the expire_postlogin field.
This field is only of use when editing a guest account. It may be set to one of the
following values:
l “expire_postlogin” to set the post-login expiration time to the value in the

expire_postlogin field;
l “plus X” or “minus X”, where X is a time measurement, to extend or reduce the

post-login expiration timer by X (minutes, but may have a “ywdhms” suffix to
indicate years, weeks, days, hours, minutes, seconds respectively);

l A number, to set the post-login expiration time to the value specified;
l Any other value to leave expire_postlogin unmodified.
This field controls account modifications; it is not stored with the guest account.

modify_expire_time String. Value indicating how to modify the expire_time field.
This field may be provided when creating or editing a guest account. It may be
set to one of the following values:
l “none” to disable the account expiration timer (do_expire and expire_time

will both be set to 0);
l “now” to disable the account immediately;
l “expire_time” to use the expiration time specified in the expire_time field;
l “expire_after” to set the expiration time to the current time, plus the number

Table 346: GuestManager Standard Fields(Continued)
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Field Description

of hours in the expire_after field;
l “plus X” or “minus X”, where X is a time measurement, to extend or reduce the

expiration time by X (hours, but may have a “ywdhms” suffix to indicate years,
weeks, days, hours, minutes, seconds respectively);

l A time measurement “X”, to set the expiration time to the current time plus X;
l Any other value to leave expire_time unmodified.
This field controls account creation and modification behavior; it is not stored
with created or modified guest accounts.

modify_expire_usage String. Value indicating how to modify the expire_usage field. This field is only of
use when editing a guest account. It may be set to one of the following values:
l “expire_usage” to set the cumulative usage expiration timer to the value in

the expire_usage field;
l “plus X” or “minus X”, where X is a time measurement, to extend or reduce

the cumulative usage expiration timer by X (seconds, but may have a
“ywdhms” suffix to indicate years, weeks, days, hours, minutes, seconds
respectively);

l A number, to set the cumulative usage expiration time to the value specified;
l Any other value to leave expire_usage unmodified.
This field controls account modifications; it is not stored with the guest account.

modify_password String. Value indicating how to modify the account password.
l It may be one of the following values:
l “random_password” to use the password specified in the random_password

field;
l “reset” to create a new password, using the method specified in the

random_password_method field (or the global defaults, if no value is
available in this field);

l “password” to use the value from the password field;
l Any other value leaves the password unmodified.
This field controls account creation and modification behavior; it is not stored
with created or modified guest accounts.

modify_start_time String. Value indicating how to modify the start_time field.
It may be one of the following values:
l “none” to disable the account activation time;
l “now” to activate the account immediately;
l “start_time” to use the activation time specified in the start_time form field

(normally a UNIX time, but may be 0 to disable activation time);
l “start_after” to set the activation time to the current time plus the number of

hours in the start_after field;
l “plus X”, where X is a time measurement, to extend the activation time by X.

The time measurement is normally hours, but may have a “ywdhms” suffix to
indicate years, weeks, days, hours, minutes, or seconds, respectively.
Alternatively, this operation may be written equivalently as ‘+X’, ‘pX’, ‘plusX’,
‘add X’, ‘addX’, or ‘aX’. Example: to delay activation time by 2 days, use the
value +2d.

l “minus X”, where X is a time measurement, to reduce the activation time by X.
See above for details about specifying a time measurement. Alternatively,
this operation may be written equivalently as ‘-X’, ‘mX’, ‘minusX’, ‘sub X’, ‘subX’,
or ‘sX’. Example: to bring forward activation time by 12 hours, use the value -

Table 346: GuestManager Standard Fields(Continued)
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Field Description

12h.
l A time measurement “X”, to set the activation time to the current time plus X.
l A time and date specification, to set the activation time to that time and date.

Many different formats are specified; for clarity it is recommended that a
standard format such as ISO-8601 is used (“YYYY-MM-DD hh:mm:ss”
format).

l Any other value to leave start_time unmodified.
This field controls account creation and modification behavior; it is not stored
with created or modified guest accounts.

multi_initial_sequence Integer. Initial sequence number. This field is used when creating guest
accounts and the random_username_method field is set to “nwa_sequence”. If
this field is not set, the next available sequence number for the given multi_
prefix is used. Sequence numbering will start with 0 if no initial sequence
number has been set.

multi_prefix String. The prefix of each username generated when creating guest accounts
and the random_username_method field is set to “nwa_sequence”.

netmask String. Network address mask to use for stations using the account. This field
may be up to 20 characters in length. The value of this field is not currently used
by the system. However, a RADIUS user role may be configured to assign
network masks using this field by adding the Framed-IP-Netmask attribute, and
setting the value for the attribute to: <?= $user["netmask"]

no_password Boolean. If set, prevents a user from changing their own password using the
guest self-service portal. Set this field to a non-zero value or a non-empty string
to disable guest-initiated password changes. The default is to allow guest-
initiated password changes, unless this field is set.

no_portal Boolean. If set, prevents a user from logging into the guest service portal. Set
this field to a non-zero value or a non-empty string to disable guest access to
the self-service portal. The default is to allow guest access to the self-service
portal, unless this field is set.

no_warn_before Boolean. User does not receive a logout expiration warning. The admin or user
can opt out of this option by setting the field to 1.

notes String. Comments or notes stored with the account. This field may be up to 255
characters in length.

num_accounts Integer. The number of accounts to create when using the create_multi form.
This field controls account creation behavior; it is not stored with created guest
accounts.

password String. Password for the account. This field may be up to 64 characters in length.

password2 String. Password for the account. If this field is set, its value must match the
value of the password field for the account to be created or updated. This can
be used to verify that a password has been typed correctly. This field controls
account creation and modification behavior; it is not stored with created or
modified guest accounts.

password_action String. Controls the password changing behavior for a guest account. This field
may be set to one of the following values:

Table 346: GuestManager Standard Fields(Continued)
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l empty string – Default behavior; that is, guests are not required to change
their password

l deny – Prevents the guest from changing their password
l first – Requires the guest to change their password on their first login
l next – Requires the guest to change their password on their next login
l recur – Require the guest to change their password on a regular schedule

(as specified by the password_action_recur field)
l recur_next – Require the guest to change their password on their next (or

first) login, and then on a regular schedule (as specified by the password_
action_recur field)

If the guest is required to change their password, this will take place during a
network login, before the guest is redirected to the NAS for login. Guest
password changes are only supported for Web login pages and guest self-
registration pages that have the “Perform a local authentication check” option
enabled.
The default behavior is to leave guest passwords under the control of the guest.
With the default behavior, guests are not prevented from changing their
password, but are also not required to change it on any particular schedule.

password_action_recur String. Specifies a date or relative time, after which a guest will be required to
change their password. Using this field also requires the password_action field
to be set to the value ‘recur’. The value of this field should be a relative time
measurement, indicated with a plus sign; for example “+15 days” or “+2 months”.

password_last_change Integer. The time that the guest’s password was last changed. The password
change time is specified as a UNIX timestamp. This field is automatically
updated with the current time when the guest changes their password using the
self-service portal.

random_password String. This field contains a randomly-generated password. This field is set when
modifying an account (guest_edit form).

random_password_length String. The length, in characters, of randomly generated account passwords.
l For nwa_words_password, the random_password_length is the maximum

length of the random words to use. Two random words will be used to create
the password, joined together with a small number (up to 2 digits).

l For nwa_picture_password, the random_password_length is ignored.

random_password_
method

String. Identifier specifying how passwords are to be created. It may be one of
the following identifiers:
l nwa_digits_password to create a password using random digits. The length

of the password is specified by the random_password_length field.
l nwa_letters_password to create a password using random lowercase

letters (a through z). The length of the password is specified by the random_
password_length field.

l nwa_lettersdigits_password to create a password using random lowercase
letters and digits (a through z and 0 through 9). The length of the password is
specified by the random_password_length field.

l nwa_alnum_password to create a password using a combination of random
digits, uppercase letters and lowercase letters (a-z, A-Z and 0-9). The length
of the password is specified by the random_password_length field.

l nwa_strong_password to create a password using a combination of digits,
uppercase letters, lowercase letters, and some punctuation. Certain

Table 346: GuestManager Standard Fields(Continued)
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Field Description

characters are omitted from the password. The length of the password is
specified by the random_password_length field.

l nwa_complex_password to create a complex password string which
contains uppercase letters, lowercase letters, digits and symbol characters.

l nwa_complexity_password is dynamic and matches your complexity
setting for password generation. For example, if you require your passwords
to have both letters and digits, then this validator will confirm that the
password has at least one of each.

l nwa_words_password to create a random password using a combination of
two randomly-selected words and a number between 1 and 99. The
maximum length of each of the randomly-selected words is specified by the
random_password_length field.

l nwa_picture_password to create a password using the format string
specified by the random_password_picture field.

random_password_picture String. The format string to use when creating a random password, if random_
password_method is set to “nwa_picture_password”.

random_username_length The length, in characters, of randomly generated account usernames.
l For nwa_words_password, the random_username_length is the maximum

length of the random words to use. Two random words will be used to create
the username, joined together with a small number (up to 2 digits).

l For nwa_picture_password, the random_username_length is ignored.

l For nwa_sequence, the random_username_length is the length of the
sequence number in the username; the sequence number will be zero-
padded. For example, specifying a length of 4 will result in sequence
numbers 0001, 0002, etc.

random_username_
method

String. Identifier specifying how usernames are to be created. It may be one of
the following identifiers:
l nwa_sequence to assign sequential usernames. In this case, the multi_

prefix field is used as the prefix for the username, followed by a sequential
number; the number of digits is specified by the random_username_length
field.

l nwa_picture_password to create a random username using the format
string specified by the random_username_picture field.

l nwa_digits_password to create a username using random digits. The length
of the username is specified by the random_username_length field.

l nwa_letters_password to create a username using random lowercase
letters. The length of the username is specified by the random_username_
length field.

l nwa_lettersdigits_password to create a username using random
lowercase letters and digits. The length of the username is specified by the
random_username_length field.

l nwa_alnum_password to create a username using a combination of
random digits, uppercase letters and lowercase letters. The length of the
username is specified by the random_username_length field.

l nwa_strong_password to create a username using a combination of digits,
uppercase letters, lowercase letters, and some punctuation. Certain
characters are omitted from the generated username to ensure its
readability (for example, “o”, “O” and “0”). The length of the username is
specified by the random_username_length field.

l nwa_words_password to create a username using a combination of two

Table 346: GuestManager Standard Fields(Continued)
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randomly-selected words and a number between 1 and 99. The maximum
length of each of the randomly-selected words is specified by the random_
username_length field.

random_username_
picture

String. The format string to use when creating a username, if the random_
username_method field is set to nwa_picture_password. See "Format Picture
String Symbols" on page 750 for a list of the special characters that may be
used in the format string.

remote_addr String. The IP address of the guest at the time the guest account was
registered.This field may be up to 20 characters in length. The value of this field
is not currently used by the system.

role_id Integer. Role to assign to the account.The value of this field must be the integer
ID of a valid RADIUS user role.

role_name String. Name of the role assigned to the account.

start_after Integer. Time period, in hours, after which the account will be enabled. This field
is used when the modify_start_time field is set to start_after. The value is
specified in hours and is relative to the current time. This field controls account
creation behavior; it is not stored with created guest accounts.

start_time Integer. Time at which the account will be enabled. The time should be specified
as a UNIX timestamp.

secret_answer String. The guest’s answer to the secret question that is stored in the secret_
question field. To use this field, first add both the secret_question and secret_
answer fields to a guest self-registration form. Then, in the self-service portal
for a guest self-registration page, select the “Secret Question” as the Required
Field. This configuration requires that guests provide the correct answer in
order to reset their account password. Answers must match with regards to
case in order to be considered as correct.

secret_question String. The guest’s secret question used to confirm the identity of a guest during
a reset password operation.

simultaneous_use Integer. Maximum number of simultaneous sessions allowed for the account.

sponsor_email Email address of the sponsor of the account. If the sponsor_email field can be
inserted into an email receipt and used future emails, the “Reply-To” email
address will always be the email address of the original sponsor, not the current
operator.

sponsor_name String. Name of the sponsor of the account. The default value of this field is the
username of the current operator.

submit No Type. Field attached to submit buttons. This field controls account creation
behavior; it is not stored with created guest accounts.

user_activity Integer. Login activity of the guest account. This field is available in views and
may be used to determine the most recent start and stop time of guest account
sessions.

username String. Username of the account. This field may be up to 64 characters in length.

Table 346: GuestManager Standard Fields(Continued)
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Field Description

visitor_company String. The guest’s company name.

visitor_name String. The guest’s full name.

visitor_phone String. The guest’s contact telephone number.

Table 346: GuestManager Standard Fields(Continued)

Hotspot Standard Fields
The table below describes standard fields available for the Hotspot form.

Field Description

address String. The guest’s street address.

card_code String. The 3 or 4 digit cardholder verification code printed on the credit card. This
field is only used during transaction processing.

card_expiry String. Credit card expiry date. This field is only used during transaction processing.

card_name String. Name shown on the credit card. This field is only used during transaction
processing.

card_number String. Credit card number. This field is only used during transaction processing.

city String. The guest’s city or town name.

country String. The guest’s country name.

first_name String. The guest’s first name.

hotspot_plan_id No Type. The ID of the plan (guest access settings) selected by the guest.

hotspot_plan_name No Type. The name of the plan (guest access settings) selected by the guest.

last_name String. The guest’s last name.

password2 String. Password for the account (used to confirm a manually typed password).

personal_details No Type. Field attached to a form label.

purchase_amount No Type. Total amount of the transaction. This field is only used during transaction
processing.

purchase_details No Type. Field attached to a form label.

state String. The guest’s state or locality name.

submit_free No Type. Field attached to a form submit button.

Table 347: Hotspot Standard Fields
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visitor_accept_
terms

Boolean. Flag indicating that the guest has accepted the terms and conditions of use.

visitor_fax String. The guest’s fax telephone number.

zip String. The guest’s zip or postal code.

SMS Services Standard Fields
The table below describes standard fields available for the SMS Services form.

Field Description

auto_send_sms Boolean. Flag indicating that a SMS receipt should be automatically sent
upon creation of the account.

sms_auto_send_field String. This field specifies the name of the field that contains the auto-send
flag. If blank or unset, the default value from the SMS plugin configuration is
used. Additionally, the special values “_Disabled” and “_Enabled” may be
used to never send an SMS or always send an SMS, respectively.

sms_enabled Boolean. This field may be set to a non-zero value to enable sending an SMS
receipt. If unset, the default value is true.

sms_handler_id String. This field specifies the handler ID for the SMS service provider. If
blank or unset, the default value from the SMS plugin configuration is used.

sms_phone_field String. This field specifies the name of the field that contains the guest’s
phone number. If blank or unset, the default value from the SMS plugin
configuration is used.

sms_template_id String. This field specifies the print template ID for the SMS receipt. If blank
or unset, the default value from the SMS plugin configuration is used.

sms_warn_before_message String. This field overrides the logout warning message. If blank or unset,
the default value from the Customize SMS Receipt page is used

visitor_carrier String. The guest’s mobile phone carrier.

Table 348: SMS Services Standard Fields

SMTP Services Standard Fields
The table below describes standard fields available for the SMTP Services.
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Field Description

auto_send_smtp Boolean. Flag indicating that an email receipt should be automatically
sent upon creation of the guest account. Set this field to a non-zero value
or a non-empty string to enable an automatic email receipt to be sent.
This field can be used to create an opt-in facility for guests. Use a check
box for the auto_send_smtp field and add it to the create_user form, or a
guest self-registration instance, and email receipts will be sent to the
guest only if the check box has been selected. Alternatively, to always
send an SMTP receipt, this field can be set to a value of 1 using a hidden
field.

smtp_auto_send_field String. This field specifies the name of the field that contains the auto-
send flag. If blank or unset, the default value from the email receipt
configuration is used. Additionally, the special values _Disabled and _
Enabled may be used to never send email or always send email,
respectively.

smtp_cc_action String. This field specifies how to send copies of email receipts. It may be
one of never, always_cc, always_bcc, conditional_cc, or conditional_
bcc. If blank or unset, the default value from the email receipt
configuration is used.

smtp_cc_list String. This field specifies a list of additional email addresses that will
receive a copy of the guest account receipt. If the value is default, the
default carbon-copy list from the email receipt configuration is used.

smtp_email_field String. This field specifies the name of the field that contains the guest’s
email address. If blank or unset, the default value from the email receipt
configuration is used. Additionally, the special value _None indicates that
the guest should not be sent any email.

smtp_enabled String. This field may be set to a non-zero value to enable sending an
email receipt. If unset, the default value from the email receipt
configuration is used. The special values _Auto (Always auto-send guest
receipts by email), _AutoField (Auto-send guest receipts by email with a
special field set), _Click (Display a link enabling a guest receipt via
email), and _Cc (Send an email to a list of fixed addresses) may also be
used.

smtp_receipt_format String. This field specifies the email format to use for the receipt. It may
be one of plaintext (No skin – plain text only), html_embedded (No skin
– HTML only), receipt (No skin – Native receipt format), default (Use the
default skin), or the plugin ID of a skin plugin to specify that skin. If blank
or unset, the default value from the email receipt configuration is used.

smtp_subject String. This field specifies the subject line for the email message.
Template variables appearing in the value will be expanded. If the value
is default, the default subject line from the email receipt configuration is
used.

smtp_template_id String. This field specifies the print template ID to use for the email
receipt. If blank or unset, the default value from the email receipt
configuration is used.

smtp_warn_before_cc_action String. This field overrides how copies are sent as indicated under
Logout Warnings on the email receipt. to send copies of email receipts. It
may be one of “never”, “always_cc”, “always_bcc”, “conditional_cc”, or
“conditional_bcc”. If blank or unset, the default value from the email

Table 349: SMPT Services Standard Fields
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smtp_warn_before_cc_list String. This overrides the list of additional email addresses that receive a
copy of the guest account under Logout Warnings on the email receipt. If
the value is “default”, the default carbon-copy list under Logout Warnings
from the email receipt configuration is used.

smtp_warn_before_receipt_
format

String. This field overrides the format in the Email Receipt field under
Logout Warnings. It may be one of “plaintext” (No skin – plain text only),
“html_embedded” (No skin – HTML only), “receipt” (No skin – Native
receipt format), “default” (Use the default skin), or the plugin ID of a skin
plugin to specify that skin. If blank or unset, the default value in the
Email Receipt Field under the Logout Warnings on the email receipt
configuration is used.

smtp_warn_before_subject String. This field overrides what is specified in the subject line under
Logout Warnings on the email receipt. If the value is “default”, the default
subject line under the Logout Warnings section on the email receipt
configuration is used.

smtp_warn_before_template_id String. This field overrides the print template ID specified under Logout
Warnings on the email receipt. If the value is “default”, the default
template ID under the Logout Warnings section on the email receipt
configuration is used.

warn_before_from String. This field overrides the Override From field under the Logout
Warnings on the email receipt. If the value is “default”, the Override From
field under Logout Warnings from the email receipt configuration is
used.

warn_before_from_sponsor String. This field overrides the Reply To field (that is, the sponsor_email
field of a user, or the admin's email) under the Logout Warnings on the
email receipt. If the value is “default”, the Reply To field under Logout
Warnings from the email receipt configuration is used.

Format Picture String Symbols
When generating a username or password using the nwa_picture_password method, a “picture string”
should be provided to specify the format of generated username or password in the random_username_
picture or random_password_picture field.

The picture string is used as the username or password, with the following symbols replaced with a random
character:

Symbol Replacement

# Random digit (0-9)

$ or ? Random letter (A-Z, a-z)

_ Random lowercase letter (a-z)

^ Random uppercase letter (A-Z)

* Random letter or digit (A-Z, a-z, 0-9)

Table 350: Picture String Symbols
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Symbol Replacement

! Random punctuation symbol, excluding apostrophe and quotation marks

& Random character (letter, digit or punctuation excluding apostrophe and quotation marks)

@ Random letter or digit, excluding vowels

Any other alphanumeric characters in the picture string will be used in the resulting username or password.
Some examples of the picture string are shown below:

Picture String Sample Password

#### 3728

user#### user3728

v^^#__ vQU3nj

@@@@@ Bh7Pm

Table 351: Picture String Example Passwords

Form Field Validation Functions
See "Form Validation Properties" on page 319, and "Examples of Form Field Validation" on page 321 for details
about using validation functions for form fields.

The built-in validator functions are:

l IsArrayKey — Checks that the value is one of the keys in the array supplied as the argument to the
validator.

l IsArrayValue — Checks that the value is one of the values in the array supplied as the argument to the
validator.

l IsEqual — Checks that the value is equal to the value supplied as the argument to the validator, allowing for
standard type conversion rules.

l IsGreaterThan — Checks that the value is strictly greater than a specified minimum value supplied as the
argument to the validator.

l IsIdentical — Checks that the value is equal to the value supplied as the argument to the validator, and has
the same type.

l IsInRange — Checks that the value is in a specified range between a minimum and maximum value. The
minimum and maximum values are specified as a 2-element array as the argument to the validator.

l IsInOptionsList—Checks against a list of options in the policy definition.

l IsNonEmpty — Checks that the value is a non-empty string (length non-zero and not all whitespace), or a
non-empty array.

l IsNonNegative — Checks that the value is numeric and non-negative.

l IsRegexMatch — Checks that the value matches a regular expression supplied as the argument the
validator. The regular expression should be a Perl-compatible regular expression with delimiters. For
example, the validator argument /^a/i will match any value that starts with an “a”, case-insensitively.
"Regular Expressions" on page 764 for more information about regular expression syntax.
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l IsValidAirGroupSharedGroups — Checks that the value is a valid shared group list. Otherwise, returns a
description of the error(s).

If $arg is an array it may specify the following options:

n syntax_only: Default true. If false, requires that the values provided correspond to those from the
AirGroup plugin configuration.

n protocol_version: Default 2. If 1, changes the default validation properties (see below).

n max_groups: Maximum number of groups to allow, default 32.

n max_group_length: Maximum length in characters of any single group name, default 64.

n max_group_list_length: Maximum total length of the group list, including comma separator
characters, default 320.

Shared groups are only available in AirGroup protocol version 2. If validation is performed with AirGroup
protocol version 1 (i.e., $arg is set to array ('protocol_version' => 1) ), then a non-empty group
list is considered an error.

Setting a max_* parameter to 0 disables validation of that property.

l IsValidAirGroupSharedLocations — Checks that the value is a valid shared location list. Otherwise,
returns a description of the error(s).

1. Checks if a value consists of valid tag = value pairs. Tag should be AP-Name, AP-Group, or FQLN, else
error is thrown.

2. FQLN format is dot-separated and the format is APname.Floor.Building.Campus. Floor bit has to be
"floor" + an integer.

3. The number of tag=value pairs should not be more than 5.

4. AP-Name value should not contain a '.'

If $arg is an array it may specify the following options:

n syntax_only: Default true. If false, requires that the values provided correspond to those from the
AirGroup controller configuration.

n protocol_version: Default 2. If 1, changes the default validation properties (see below).

n max_locations: Maximum number of location tags to allow, default 100.

n max_location_length: Maximum length in characters of any single location tag, default 64.

n max_location_list_length: Maximum total length of the shared location list, including comma
separator characters, default 1000.

n include_ap_group: Default true. Allows AP-Group=... tags.

n include_ap_name: Default true. Allows AP-Name=... tags.

n include_fqln: Default true. Allows FQLN=... tags.

For the same validation as performed in AirGroup protocol version 1, set $arg to array('protocol_

version' => 1).

Setting a max_* parameter to 0 disables validation of that property.

l IsValidAirGroupSharedRoles — Checks that value is a valid shared role list. Otherwise, returns a
description of the error(s).

If $arg is an array it may specify the following options:
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n syntax_only: Default true. If false, requires that the values provided correspond to those from the
AirGroup controller configuration.

n protocol_version: Default 2. If 1, changes the default validation properties (see below).

n max_roles: Maximum number of roles to allow, default 100.

n max_role_length: Maximum length in characters of any single role name, default 64.

n max_role_list_length: Maximum total length of the role list, including comma separator characters,
default 1000.

For the same validation as performed in AirGroup protocol version 1, set $arg to array('protocol_

version' => 1).

Setting a max_* parameter to 0 disables validation of that property.

l IsValidAirGroupSharedTime — Checks that the value is a valid time-based sharing policy. Otherwise,
returns a description of the error(s). Validation is first performed on the basic time sharing rules. For
information about the type of validation performed, see "AirGroup Time-Based Sharing Syntax Examples"
on page 88.

If $arg is an array, it may specify any of the options accepted by the sub-validators for shared users, shared
roles, shared locations, and shared groups.

General validation options:

n syntax_only: Default true. If false, requires that the values provided correspond to those from the
AirGroup controller configuration.

n protocol_version: Default 2. If 1, changes the default validation properties (see below).

Validating shared locations:

n max_locations: Maximum number of location tags to allow, default 100.

n max_location_length: Maximum length in characters of any single location tag, default 64.

n max_location_list_length: Maximum total length of the shared location list, including comma
separator characters, default 1000.

n include_ap_group: Default true. Allows AP-Group=... tags.

n include_ap_name: Default true. Allows AP-Name=... tags.

n include_fqln: Default true. Allows FQLN=... tags.

Validating shared roles:

n max_roles: Maximum number of roles to allow, default 100.

n max_role_length: Maximum length in characters of any single role name, default 64.

n max_role_list_length: Maximum total length of the role list, including comma separator characters,
default 1000.

Validating shared users:

n max_users: Maximum number of usernames to allow, default 100.

n max_user_length: Maximum length in characters of any single username, default 64.

n max_user_list_length: Maximum total length of the username list, including comma separator
characters, default 1000.

For the same validation as performed in AirGroup protocol version 1, set $arg to array('protocol_

version' => 1).
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Setting a max_* parameter to 0 disables validation of that property.

l IsValidAirGroupSharedUser — Checks that the value is a comma-separated user list, where user names
should not contain "," or space.

If $arg is an array it may specify the following options:

n protocol_version: Default 2. If 1, changes the default validation properties (see below).

n max_users: Maximum number of usernames to allow, default 100.

n max_user_length: Maximum length in characters of any single username, default 64.

n max_user_list_length: Maximum total length of the username list, including comma separator
characters, default 1000.

For the same validation as performed in AirGroup protocol version 1, set $arg to array('protocol_

version' => 1).

Setting a max_* parameter to 0 disables validation of that property.

l IsValidBool — Checks that the value is a standard Boolean truth value. Valid Boolean values are the
integers 0 and 1 and the PHP values false and true.

l IsValidDateTime — Checks that the value appears to be a valid time specification string according to the
rules of the PHP function strtotime(). Valid date/time syntax includes ISO 8601 standard times (YYYY-MM-
DD hh:mm:ss) with and without time zone specifications, as well as many other formats. The $value is
expected to be an integer specifying a UNIX time value (seconds since 1970-01-01 00:00:00 UTC).

$arg may be:

n null, to not perform any min/max check

n a scalar value, to use as the maximum allowable value

n an array containing "min" or "max" entries

Use the syntax:
array(

'min' => '1 day',

'max' => '90 days',

)

l IsValidEmail — Checks that the value appears to be a valid RFC 822-compliant email address. When using
the IsValidEmail validator, the validator argument may be specified with a whitelist/blacklist of domain
names, or with a whitelist/blacklist of email addresses.

Use the syntax:
array (

'deny' => array (

0 => 'blocked-email@corp-domain.com',

),

'allow' => array (

0 => 'corp-domain.com',

1 => 'other-corp-domain.com',

2 => 'other-domain.com',

),

)

n The keys ‘whitelist’ and ‘blacklist’ may also be used for ‘allow’ and ‘deny’, respectively.

n An ‘allow’ or ‘deny’ value that is a string is converted to a single element array.
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n Wildcard matching may be used on domain names: the prefix ‘*.’ means match any domain that ends
with the given suffix. A ‘*’ component can also be used inside the hostname, and will match zero or more
domain name components.

n If the ‘allow’ list is empty or unset, the default behavior is to accept ALL domains other than those listed
in the ‘deny’ list.

n If the ‘deny’ list is empty or unset, the default behavior is to deny ALL domains other than those listed in
the ‘allow’ list.

n If both ‘allow’ and ‘deny’ lists are provided, the default behavior is to accept a domain name that does
not match any of the patterns provided. The ‘allow’ list is checked first, followed by ‘deny’. To obtain the
opposite behavior, specify the wildcard ‘*’ as the last entry in the ‘deny’ list.

l IsValidEmailList — Similar to IsValidEmail but takes a comma-delimited list of emails. Any
whitelist/blacklist checks must be OK against all addresses.

l IsValidFileUpload — Checks that the value is a file upload.

l IsValidFutureDateTime — Checks that the value is a valid time specification string according to the rules
of the PHP function strtotime(), and that the time specification refers to a point in the future. The $value is
expected to be an integer specifying a UNIX time value (seconds since 1970-01-01 00:00:00 UTC).

$arg may be:

n null, to not perform any min/max check

n a scalar value, to use as the maximum allowable value

n an array containing "min" or "max" entries

Use the syntax:
array(

'min' => '1 day',

'max' => '90 days',

)

l IsValidFutureTimestamp — Checks that the value is a valid UNIX time referring to a point in the future.
The $value is expected to be an integer specifying a UNIX time value (seconds since 1970-01-01 00:00:00
UTC).

$arg may be:

n null, to not perform any min/max check

n a scalar value, to use as the maximum allowable value

n an array containing "min" or "max" entries

Use the syntax:
array(

'min' => '1 day',

'max' => '90 days',

)

l IsValidHostname — Checks that the value is a valid IP address or a hostname that resolves to an IP
address.

l IsValidHostnameCidr — Checks that the value is a valid IP address or hostname, which may also have an
optional /N suffix indicating the network prefix length in bits (CIDR notation).

l IsValidHostnamePort — Checks that the value is a valid IP address or hostname, which may optionally
include a port number specified with the syntax hostname:port.

l IsValidIpAddr — Checks that the value is a valid IP address.
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l IsValidLdapAttribute — Checks that the value is a valid LDAP attribute name; that is, a string that starts
with a letter, and which contains only letters, numbers, underscore (_) and hyphen (-).

l IsValidMacAddress — Checks that the input looks anything like a valid MAC address. This function accepts
MAC addresses in all of the following formats:

n 3456789abcde

n 34:56:78:9a:bc:de

n 3456.789a.bcde

n 34-56-78-9A-BC-DE

l IsValidNetmask — Checks that the value is a valid network mask in dotted-quad notation; that is, an IP
address such as 255.255.255.128 that contains a single string of N 1 bits followed by (32 – N) 0 bits.

l IsValidNumber — Checks that the value is numeric; that is, an integer or a decimal value. The validator
argument may be an array containing one or more of the following additional options:

n no_negative — if set to true, negative numbers are not accepted as a valid value.

n no_zero — if set to true, zero is not accepted as a valid value.

n only_integer — if set to true, decimal numbers are not accepted and only integer values are valid.

l IsValidPassword — Checks that password entries satisfy requirements for guest users. This function is
essentially equivalent to IsValidPassword2 but with the settings configured based on Guest Manager's
configuration settings. Most deployments with a need to validate passwords should use the
IsValidPassword2 validator.

l IsValidPassword2 — Checks that the value is a valid password that satisfies certain requirements. The
validator argument must be an array describing which of the following requirements to check. To perform
any password checking, the “minimum_length” and “complexity_mode” fields must be specified.

n password2 — specifies the name of the field containing the duplicate password entry (optional, for
password validation). Defaults to “password2” if not specified.

n password2_required — if nonzero, indicates that the “password2” entry must be supplied.

n username — specifies the name of the field containing the username. If empty or unset, the password
is not checked against this field for a match.

n minimum_length — specifies the minimum length of the password in characters.

n disallowed_chars — if set, specifies characters that are not allowed in the password.

n complexity_mode — specifies the set of rules to use when checking the password.

n complexity — if set, specifies rules for checking the composition of the password. If unset, defaults to a
preset value for password complexity with modes “none”, “basic”, “number”, “punctuation” and
“complex”. These rules check that passwords obey certain requirements according to the following table:

Rule Set Min. Length Description

none – No special requirements

basic 8 Non-space characters

number 8 At least 1 digit

Table 352: Complexity Requirements
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Rule Set Min. Length Description

punctuation 8 At least 1 punctuation character (non-alphanumeric)

complex 8 At least 1 digit, 1 non-alphanumeric, 1 uppercase and 1 lowercase letter

l IsValidPatternMatch – Validator that returns true if $value matches a certain pattern, specified as a
series of 'allow' and 'deny' patterns. The $arg may be specified with a whitelist/blacklist of patterns.

Use the syntax:
array(

'allow' => array(),

'deny' => array(

'gmail.com',

'yahoo.com',

'*.cn',

)

)

Allow/deny list syntax:

n The keys 'whitelist' and 'blacklist' may also be used for 'allow' and deny', respectively.

n An 'allow' or 'deny' value that is a string is converted to a single element array.

n Wildcard matching may be used in patterns: the '*' character matches zero or more characters, '?'
matches a single character.

n If the 'allow' list is empty or unset, the default behavior is to accept ALL values other than those listed in
the 'deny' list.

n If the 'deny' list is empty or unset, the default behavior is to deny ALL values other than those listed in
the 'allow' list.

n If both 'allow' and 'deny' lists are provided, the default behavior is to check the 'deny' list, followed by
the 'allow' list. If the value does not match any pattern, then the default is to accept the value. To obtain
the opposite behavior (i.e. deny by default), specify the wildcard '*' as the last entry in the 'deny' list.

n This behavior may be altered using the 'order' and 'default' options described below.

Additional options:

n 'trim' => false may be specified in $arg to not strip leading and trailing whitespace from the value
being checked (and the patterns). The default is 'trim' => true, i.e., leading/trailing whitespace is
ignored.

n 'case_sensitive' => true may be specified in $arg to perform case-sensitive pattern matching.
The default is 'case_sensitive' => false, i.e., case-insensitive matching.

n 'order' => 'allow,deny' or 'order' => 'deny,allow' may be used to change the order in
which the pattern lists are checked. The default is 'allow,deny', i.e., the allow list is checked first,
followed by the deny list.

n 'default' => 'allow' or 'default' => 'deny' may be used to change the result returned when
no pattern matches. The default is 'allow'.

n 'regexp' => '/.../' specifies a complete PCRE pattern (including delimiters and option characters,
if required) against which the pattern will be matched on entry. This matching step is performed before
any whitelist or blacklist processing is done. A failed match will result in the validator failing.
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n 'use_regexp' => true may be specified if all of the allow/deny patterns are actually complete PCRE
patterns (including delimiters and option characters). The default is 'use_regexp' => false, i.e., the
pattern rules specified above are used.

l IsValidSentence – Checks that the value is considered to be a ‘sentence”; that is, a string which starts with
an upper-case letter and ends in a full stop.

l IsValidSpanishDNI – Checks that a string is a valid Spanish DNI/NIE.

n DNI = Documento Nacional de Identidad

n NIE = Número de Identificación de Extranjeros

These identifiers are nine letters/digits long, in the format:

00000000A (DNI)

X0000000A (NIE)

where '0' indicates a number, 'X' indicates a letter, and 'A' indicates a checksum letter.

l IsValidTimestamp – Checks that the value is a numeric UNIX timestamp (which measures the time in
seconds since January 1, 1970 at midnight UTC).

l IsValidTimeZone – Checks that the value is a valid string describing a recognized time zone.

l IsValidUrl – Checks that the value appears to be a valid URL that includes a scheme, hostname and path.
For example, in the URL http://www.example.com/, the scheme is http, the hostname is
www.example.com and the path is /. The validator argument may optionally be an array containing a
‘scheme’ key that specifies an array of acceptable URL protocols.

l IsValidUsername – Checks that the value is a valid username. Usernames cannot be blank or contain
spaces.

l NwaCaptchaIsValid – Checks that the value matches the security code generated in the CAPTCHA image.
This validator should only be used with the standard captcha field.

l NwaGuestManagerIsValidRoleId – Checks that the value is a valid role ID for the current operator and
user database.

l NwaHotspotIsValidCardCode – Checks a cardholder verification code.

l NwaHotspotIsValidCardExpiry – Checks a card expiry date. Expects a number in one of the following
formats:

n MMYY

n MM/YY

n MM-YY

n MM.YY

n MMYYYY

n MM/YYYY

n MM-YYYY

n MM.YYYY

The year is expected to be between the current year and 2036, inclusive.

l NwaHotspotIsValidCardNumber – Checks the entry of a credit card number.

l NwaSmsIsValidPhoneNumber – Validates an E.164 international phone number. E.164 numbers must
start with a recognized country code. Additional punctuation such as space, -, and () are removed. A leading
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+ (international prefix) is removed if present.

l NwaIsValidExpireAfter – Checks that the value is one of the account expiration time options specified in
the Guest Manager configuration.

l NwaIsValidLifetime – Checks that the value is one of the account lifetime options specified in the Guest
Manager configuration.

Form Field Conversion Functions
The Conversion and Value Format functions that are available are listed below:

l NwaConvertOptionalDateTime – Converts a string representation of a time to the UNIX time
representation (integer value). The conversion leaves blank values unmodified.

l NwaConvertOptionalInt – Converts a string representation of an integer to the equivalent integer value.
The conversion leaves blank values unmodified.

l NwaConvertStringToOptions – Converts a multi-line string representation of the form
key1 | value1

key2 | value2

to the array representation

array (

'key1' => 'value1',

'key2' => 'value2',

)

l NwaImplodeComma – Converts an array to a string by joining all of the array values with a comma.

l NwaTrim – Removes leading and trailing whitespace from a string value.

l NwaTrimAll – Removes all whitespace from a string (including embedded spaces, newlines, carriage
returns, tabs, etc).

l NwaStrToUpper – Formats the text string to all uppercase letters.

l NwaStrToLower – Formats the text string to all lowercase letters.

l NwaNormalizePhoneNumber – Removes all spaces, dashes, parenthesis and non-numerical characters
from the phone number.
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Form Field Display Formatting Functions
The Display Functions that are available are listed below:

Function Description

NwaBoolFormat Formats a Boolean value as a string.
l If the argument is 0 or 1, a 0 or 1 is returned for false and true, respectively.
l If the argument is a string containing a “|” character, the string is split at the |

separator and used for false and true values.
l If the argument is an array, the 0 and 1 index values are used for false and true

values.
Otherwise, the string values “false” and “true” are returned.

NwaByteFormat Formats a non-negative size in bytes as a human readable number (bytes, KB, MB,
GB, etc). 1 KB is defined as 1,024 bytes, 1 MB as 1,024 KB (1,048,576 bytes), and 1 GB
as 1,024 MB (1,073,741,824 bytes).
l If a negative value is supplied, returns the argument (or null if no argument was

supplied).
l If a non-numeric value is supplied, that value is returned directly.

NwaCurrencyFormat Formats a numeric value that indicates a monetary amount as a string.
If the argument is null or not supplied, the current locale’s settings are used to format
the monetary value.
l The argument may be an array, which will override the current locale’s settings

(see NwaNumberFormat for the list of settings that are used).
l The argument may be a numeric value, which is used as the number of fractional

digits to use when formatting the monetary amount (other locale settings will
remain unchanged in this case).

NwaDateFormat Format a date like the PHP function strftime(), using the argument as the date format
string. Returns a result guaranteed to be in UTF-8 and correct for the current page
language. See "Date/Time Format Syntax" on page 730 for a list of available
date/time formats, or use one of the following special format strings:
l hhmmss, hh:mm:ss – time of day
l iso8601, iso8601t, iso-8601, iso-8601t – various ISO 8601 date formats with and

without hyphen separators and the time of day
l longdate – date and time in long form
l displaytime – time of day
l ?: – returns the string following the ?: if the time value is 0, or uses the format

string before the ?: otherwise
l recent – for example, “2 minutes ago”, “3 months ago”

NwaDurationFormat Converts a time measurement into a description of the corresponding duration.
l Format parameters: seconds, minutes, hours, days, weeks.
l Any format can be converted to another.
l By default, this function converts an elapsed time value specified in seconds to a

value that is displayed in weeks, days, hours, minutes and seconds.
Up to four additional arguments may be supplied to control the conversion:
l in_format – The current units of the value being converted (seconds, minutes,

hours, days, weeks)
l max_format – Controls the max increment you want displayed.
l min_format – Controls the min increment you want displayed. Only whole

numbers are printed.

Table 353: Form Field Display Functions
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Function Description

l default – If set, this value will be returned when the resulting duration (after min_
format is taken into account) is 0.

NwaExplodeComma Converts a string to an array by splitting the string at each comma and forming an
array of all the substrings created in this way.

NwaNumberFormat Formats a numeric value as a string. If the argument is null or not supplied, the
current locale’s settings are used to format the numeric value. The argument may be
an array or a numerica value. If the argument is an array, it will override the current
locale’s settings (see below for the list of settings that are used). If the argument is a
numeric value, it is used as the number of fractional digits to use when formatting the
string (other locale settings will remain unchanged in this case).
The specific locale settings used are from localeconv(), and are listed below.
For general numeric formatting :
l frac_digits – number of decimal places to display
l decimal_point – character to use for decimal point
l thousands_sep – character to use for thousands separator
For signs for positive/negative values:
l positive_sign – sign for positive values
l p_sign_posn – position of sign for positive values (0..4)
l negative_sign – sign for negative values
l n_sign_posn – position of sign for negative values (0..4)
For formatting for monetary amounts:
l mon_decimal_point – decimal point character for monetary values
l mon_thousands_sep – thousands separator for monetary values
l p_sep_by_space – true if a space separates currency symbol from a positive value
l p_cs_precedes – true if currency symbol precedes positive value
l n_sep_by_space – true if a space separates currency symbol from a negative

value
l n_cs_precedes – true if currency symbol precedes negative value
Additionally, the special value monetary, if true, indicates that a currency value
should be formatted, rather than a regular numeric value.

View Display Expression Technical Reference
A page that contains a view is displayed in an operator’s Web browser. The view contains data that is loaded
from the server dynamically. Because of this, both data formatting and display operations for the view are
implemented with JavaScript in the Web browser.

For each item displayed in the view, a JavaScript object is constructed. Each field of the item is defined as a
property of this object. When evaluating the JavaScript Display Expression, the data variable is used to refer to
this object. Thus, the expression data.my_field would return the value of the field named “my_field”.
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Figure 497 Fields on a List View

In the above view (the guest_users view), the four columns displayed correspond to the username, role_
name, enabled, and expire_time fields.

Value Description

Display Expressions

data.username.bold() Displays the username string as bold text.

data.role_name Displays the name of the role.

Nwa_BooleanText(data.enabled, "Enabled",
"Disabled")

Displays either “Enabled” or “Disabled” depending on the
value of the enabled field.

(parseInt(data.do_expire) != 0) ? Nwa_
DateFormat(data.expire_time, "%Y-%m-%d
%H:%M") : "N/A"

Displays “N/A” if the account has no expiration time, or a
date and time string if an expiration time has been set.

JavaScript functions

Nwa_BooleanText(
value, if_true, if_false[, if_undefined])

Returns the value of if_true or if_false depending on
whether the value evaluates to a Boolean true or false,
respectively. If the value has an undefined type (in other
words. has not been set), and the if_undefined parameter
was provided, returns if_undefined.

Nwa_DateFormat(value, format) Converts a numerical value (UNIX time) to a string using
the date and time format string format. The format string
uses similar syntax to the NwaDateFormat() function. See
"Date/Time Format String Reference" on page 731 for a
full list of the supported format strings.

Nwa_FloatFormat(value, decimals) Converts a numerical value to a string, with the number
of decimal places specified in decimals.

Nwa_MinutesToNatural(value) Converts a numeric value measuring a time in minutes to
a natural time representation (such as “2 minutes”, “3
hours”, “11 days”).

Nwa_NumberFormat(value[, if_undefined])
Nwa_NumberFormat(
value, decimals)Nwa_NumberFormat(
value, decimals, dec_point, thousands_sep[, if_
undefined])

Converts a numerical value to a string. If the value has an
undefined type (in other words, has not been set), and the
if_undefined parameter was provided, returns if_
undefined. Otherwise, the number is converted to a string
using the number of decimal places specified in decimals

Table 354: Display Expressions for Data Formatting
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Value Description

(default 0), the decimal point character in dec_point
(default “.”), and the thousands separator character in
thousands_sep (default “,”).

Nwa_TrimText(value, length) Trims excessively long strings to a maximum of length
characters, appending an ellipsis (“…”) if the string was
trimmed.

Nwa_ValueText(value[, if_undefined]) If the value has an undefined type (in other words, has not
been set), and the if_undefined parameter was provided,
returns if_undefined, or a HTML non-breaking space
(“&nbsp;”) otherwise. Otherwise, the value is converted to
a string for display.

LDAP Standard Attributes for User Class
The following list provides some of the attributes for the LDAP User class. For a complete list you should
consult http://msdn2.microsoft.com/en-us/library/ms683980(VS.85).aspx#windows_2000_server_attributes.

l userPrincipalName: The userPrincipalName is a single-valued and indexed property that is a string that
specifies the user principal name (UPN) of the user. The UPN is an Internet-style login name for the user
based on the Internet standard RFC 822. The sAMAccountName property is a single-valued property that is
the logon name The objectSid property is a single-valued property that specifies the security identifier (SID)
of the user.

l accountExpires: The accountExpires property specifies when the account will expire.

l badPasswordTime: The badPasswordTime property specifies when the last time the user tried to log onto
the account using an incorrect password.

l badPwdCount: The badPwdCount property specifies the number of times the user tried to log on to the
account using an incorrect password.

l codePage: The codePage property specifies the code page for the user's language of choice. This value is
not used by Windows 2000.

l countryCode: The countryCode property specifies the country code for the user's language of choice. This
value is not used by Windows 2000.

l lastLogoff: The lastLogoff property specifies when the last logoff occurred.

l lastLogon: The lastLogon property specifies when the last logon occurred.

l logonCount: The logonCount property counts the number of successful times the user tried to log on to
this account.

l mail: The mail property is a single-valued property that contains the SMTP address for the user (such as
demo@example.com).

l memberOf: The memberOf property is a multi-valued property that contains groups of which the user is a
direct member.

l primaryGroupID: The primaryGroupID property is a single-valued property containing the relative
identifier (RID) for the primary group of the user.

l sAMAccountType: The sAMAccountType property specifies an integer that represents the account type.

l unicodePwd: The unicodePwd property is the password for the user.
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Regular Expressions
The characters shown in Table 355 can be used to perform pattern matching tasks using regular expressions.

Regex Matches

a Any string containing the letter “a”

^a Any string starting with “a”

^a$ Only the string “a”

a$ Any string ending with “a”

. Any single character

\. A literal “.”

[abc] Any of the characters a, b, or c

[a-z0-9A-Z] Any alphanumeric character

[^a-z] Any character not in the set a through z

a? Matches zero or one “a”

a+ Matches one or more: a, aa, aaa, …

a* Matches zero or more: empty string, a, aa, aaa…

a|b Alternate matches: Matches an “a” or “b”

(a.*z) Grouping: matches sequentially within parentheses

a*? “Non-greedy” zero or more matches

\ooo The character with octal code ooo

\040 A space

\d Any decimal digit

\D Any character that is not a decimal digit

Table 355: Regular Expressions for Pattern Matching

The regular expression syntax used is Perl-compatible. For further details on writing regular expressions,
consult a tutorial or programming manual.
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Appendix 1
Chromebook in Onboard

This appendix describes Chromebook functionality in ClearPass Onboard. It provides an introduction to
Chromebook in Onboard, and discusses considerations as well as Onboard and Google Admin configuration
for Chromebook.

This section includes:

l "About Chromebook in Onboard" on page 766

l "Caveats and Recommendations" on page 767

l "Onboard Configuration for Chromebook" on page 769

l "Google Admin Configuration for Chromebook" on page 771

About Chromebook in Onboard
Chromebook is a managed device. When you use Google Apps for Business or Google Apps for Education, you
use the Google Admin console for provisioning, management, and control of Chromebook devices.

However, Chromebook still requires a Wi-Fi connection to work.

Administrators can take advantage of ClearPass Onboard's Chromebook support for certificate enrolling. Users
can be provided with EAP-TLS client certificates to securely establish their network identity. All of the existing
capabilities of Onboard can then be leveraged to ensure reliable and policy-controlled access to the network.

Figure 498 Network Architecture
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In the network architecture diagram shown in "Network Architecture " on page 766:

l Chromebook users access the network through the local Wi-Fi.

l The Google Apps domain provides user login services and other apps, such as the Chrome Web Store,
Google Docs, Google Sheets, and more.

l The Admin Console is used by administrators to provision new Chromebooks and manage existing
Chromebooks.

l Chromebook Sync is used to ensure that settings from the Admin Console are applied to all Chromebooks
in the domain.

l Users, groups, and other details can be provisioned in Google Apps from an existing directory using the
Google Apps Directory Sync tool.

l ClearPass Onboard provides device provisioning and certificate enrollment services.

l The Chrome Extension provides support for Onboard device provisioning for Chromebook devices.

Caveats and Recommendations
This section describes requirements related to licenses, extensions, deployment, versions, certificates,
provisioning, and authentication sources.

Google Admin Chromebook License is Required
Chromebook management is only available in the Google Admin console (https://admin.google.com) if a
suitable license has been added for the domain under management.

Managed Chromebook Deployment is Required
Chromebook is a managed device, not a “BYOD” device. The support for Onboard is limited to device
provisioning and enrollment in an administrator-managed network. Non-managed Chromebook devices
cannot be enrolled using ClearPass Onboard.

Chrome Extension is Required
Chromebook does not natively support device enrollment with products such as ClearPass Onboard. For this, a
Chrome extension is required.

Additionally, because of the software security model used by Chromebook, “normal” Chrome extensions (for
example, those installed from the Chrome Web Store) do not have permissions to alter the certificate store on
the device. To do this requires an administratively configured extension, which is why Chromebook must be
managed for Onboard enrollment to work.

For details of how to configure the Google Admin console to automatically install this extension when a user
logs into Chromebook, refer to the Configure Chrome Extension section in "Google Admin Configuration for
Chromebook" on page 771 .

Chromebook Release 37 or Later is Required
The Onboard extension requires Chrome version 37 or later. As of the time of this writing (July 2014) this
version of Chrome is only available in the development channel.

To provision Chromebook devices with the development channel, create an organizational unit within your
organization. For that organizational unit, configure Device Settings and set the Release Channel to Move
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to Development Channel. Then move one or more devices into this organizational unit to enable the
development channel.

When the stable release catches up with the development channel, no special configuration will be required to
enable Onboard for Chromebook.

For more information on the Chromebook stable, beta and development channels, refer to this article:
https://support.google.com/chromebook/answer/1086915

Chromebook Supports Only “Created by Device” Certificates
Chromebook includes a trusted platform module (TPM) for protection of cryptographic private keys, including
the private key for the TLS client certificate issued to the device by Onboard.

Because of this, Chromebook will always create its own private key. The Key Type option in the device
Provisioning Settings will be ignored by Chromebook devices, and will always default to created by device.

The key size is 1024 bits or 2048 bits, as specified in the device Provisioning Settings.

If an unsupported selection is made in the Provisioning Settings form, the default used will be a 2048-bit private key.

A Separate Provisioning SSID is Required
Chromebook cannot be provisioned unless it is already online, in order to sync with the appropriate settings
from the Google Admin console.

To handle the initial configuration task, we recommend you follow these steps:

l Configure an Onboard provisioning SSID.

n Ensure that this SSID has an access-control list that allows the Chromebook to log in and sync with
Google Apps. For details on the contents of the ACL, refer to this article:
https://support.google.com/chrome/a/answer/3504942#sslinspection

n Use a captive portal on this SSID that redirects users to the Onboard device provisioning page.

n Note that this SSID can also be used to Onboard other devices that are supported by ClearPass
Onboard.

l Ensure that the Chromebook is enrolled.

n To manually enroll a brand-new Chromebook, press Ctrl+Alt+E before attempting to log in with any
domain credentials.

n Be aware that once a user has signed in to a device, you cannot enroll the device. The device must be
wiped in order to restart the enrollment process.

n For more details on enrolling a Chrome device, including details on automatic enrollment, refer to this
article: https://support.google.com/chrome/a/answer/1360534

l Sign in to the device using the credentials of an account in the Google Apps domain.

n Connect to the provisioning SSID using the Chrome setup wizard.

Do not save the credentials you used to connect to the provisioning SSID.

n The device will sync with the Admin console settings.
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n This will also install the Onboard Chrome extension, if it is configured correctly in the Google Admin
console.

l Open the Chrome browser on the device.

n The captive portal will redirect you to the device provisioning page.

n Sign in with appropriate credentials.

n The Chrome device will be provisioned with a new certificate.

n The provisioned network should be automatically activated when it is available. If not, manually connect
to the network to verify that EAP-TLS is working correctly.

Directory-Based Authentication Source is Recommended
When a Chromebook user with an EAP-TLS certificate connects to the network, an authorization check is
performed to ensure that the certificate is still valid, and that the user account associated with the certificate is
still permitted to use the network.

ClearPass Policy Manager provides this capability for multiple authentication sources. However, at this time, no
built-in Google Apps authentication source is available.

Many Chromebook deployments will take advantage of Google Apps Directory Sync to use an existing LDAP or
Active Directory authentication source. In this environment, a ClearPass authentication source can be used to
verify the status of a user account when a device connects to the network.

If your deployment does not have an LDAP or Active Directory source, you can still use Onboard to provision
Chromebook devices. However, in this environment you must manually revoke the certificates of users who
are no longer authorized to access the network.

Onboard Configuration for Chromebook
The Provisioning Settings form provides Chromebook configuration settings.

Enable Chromebook Provisioning
You must first enable Chromebook in a provisioning setting. This adds the configuration fields for it:

1. Go to Onboard > Deployment and Provisioning > Provisioning Settings and click the Supported
Devices tab.
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Figure 499 Provisioning Settings, Supported Devices Tab, Chromebook Area

2. In the Chromebook Devices row, select the Enable Chromebook device provisioning check box.

3. In the Chromebook Token row, select the hardware token to store certificates against. Options include:

l User-Specific

l System-Wide

4. Click Save Changes. Configuration fields for Chromebook are added to the Instructions & Messages
tab.

For more information, see "Configuring Provisioning Settings for Supported Devices" on page 230.

Configure Instructions and Messages
1. After you enable Chromebook on the Supported Devices tab, click the Instructions & Messages tab.

The text displayed on the device provisioning page for Chromebook devices can be customized here.

Figure 500 Provisioning Settings, Instructions & Messages Tab, Chromebook Area

2. Make the appropriate selections in the Provisioning Instructions, Device Status, and Chromebook
Instructions areas. For more information, see "Configuring Provisioning Settings for Instructions and
Messages" on page 242.

3. Click Save Changes.
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4. Use the other tabs in the Provisioning Settings form to complete the configuration for the provisioning
setting, and save the configuration. For more information, see "About Configuring Provisioning Settings " on
page 224.

Google Admin Configuration for Chromebook
This section describes Google Admin configuration for Chromebook in Onboard.

To begin, log in to the Google admin console at https://admin.google.com/.

Configuring the Chrome extension
1. In the Google Admin console, select the Device Management option.

Figure 501 The Device Management Option in the Google Admin Console

2. Select the Chrome option.

Figure 502 The Chrome Option

3. Go to User Settings.

Figure 503 The User Settings Option

If you have multiple organizational units or levels, be sure to select the appropriate organizational unit or level
before you make changes to the settings.

4. In the user settings, find the Pre-installed Apps and Extensions section, and then click the Manage pre-
installed apps link.
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5. Select Specify a Custom App.

Figure 504 Pre-Installed Apps and Extensions, Specify a Custom App

6. Enter the ID and URL of the Onboard Chromebook extension and then click Add.

Figure 505 Specify a Custom App, ID and URL

The ID and URL information is available on the Onboard > Deployment and Provisioning > Provisioning
Settings > Chromebook tab.

If you have a cluster environment, the URL may be modified to refer to any subscriber node.

7. Verify that the extension is listed in the Pre-installed Apps and Extensions list, and then click Save.
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8. Remember to save your changes using the Save changes button at the bottom left of the page.

Configuring Network Settings
1. From the Chrome Management page, go to Network.

Figure 506 The Network Option

2. You should see the For Users tab selected. Click the Add Wi-Fi button on the right.

Figure 507 The For Users Tab

3. Specify a Name and SSID for the network, and select the Automatically Connect option.

4. Change the Security Type to WPA/WPA2 Enterprise (802.1X),

5. Under Extensible Authentication Protocol, select EAP-TLS.

6. The Username can be set as a fixed value (for example, anonymous), or it can take the variables ${LOGIN_
ID} (for example, johndoe) or ${LOGIN_EMAIL} (for example, johndoe@mydomain.com).

7. If your RADIUS server doesn’t have a commercially issued certificate, then you might need to use the Add
new certificate... option for Server Certificate Authority to upload the signer of the RADIUS
certificate.

Be sure to use the Root CA and not the Signer CA.

If you already have an appropriate certificate in the list, then it can be selected directly.
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Figure 508 The Add Wi-Fi Network Form

8. For Client enrollment URL, provide the URL of the Onboard captive portal page—for example,
https://server/onboard/device_provisioning.php.

9. You should also specify the Common Name of the Onboard CA’s issuing certificate in Issuer pattern >
Common name—for example, “ClearPass Onboard Local Certificate Authority (Signing)”.

10.Click Save to save the network settings, and remember to click Save changes to commit.
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Glossary

$criteria
Array that consists of one or more criteria on which to perform a data-based search. This array is used for
advanced cases where predefined helper functions do not provide required flexibility.

802.1X
IEEE standard for port-based network access control, designed to enhance 802.11 WLAN security. 802.1X
provides an authentication framework that allows a user to be authenticated by a central authority. The actual
algorithm that is used to determine whether a user is authentic is left open, and multiple algorithms are pos-
sible.

AAA
Authentication, Authorization, and Accounting. Security architecture for distributed systems that provides con-
trol over who can access services and that tracks the resources they use. - Authentication: Verification of a
user’s credentials.Typically accomplished with a username and password, a one-time token, or a digital sig-
nature. - Authorization: Controls the type of access an authenticated user is permitted to have based on the
user's authentication type. - Accounting: Process of recording summary information about network access by
users and devices. Tracks network resource consumption and records events such as authentication failures.

access point
Device that serves as a point of connection between the WLAN and a wired network, and which connects
devices within the network. The number of access points a WLAN needs is determined by the number of users
and the size of the network.

Access-Accept
Response from RADIUS server indicating successful authentication, and containing authorization information.

Access-Reject
Response from RADIUS server indicating a user is not authorized.

Access-Request
RADIUS packet sent to a RADIUS server requesting authorization.

accounting
Process of recording summary information about network access by users and devices.

accounting session time
Length of time the guest has been using the network.

Accounting-Request
RADIUS packet type sent to a RADIUS server containing accounting summary information.

Accounting-Response
RADIUS packet sent by the RADIUS server to acknowledge receipt of an Accounting-Request.
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Active Directory
Microsoft Active Directory. Directory server that stores information about a variety of things, such as organ-
izations, sites, systems, users, shares, and other network objects or components. It also provides authen-
tication and authorization mechanisms, and a framework within which related services can be deployed.

ActiveSync
Mobile data synchronization app developed by Microsoft that allows a mobile device to be synchronized with
either a desktop or a server running compatible software products.

AD
Microsoft Active Directory. Directory server that stores information about a variety of things, such as organ-
izations, sites, systems, users, shares, and other network objects or components. It also provides authen-
tication and authorization mechanisms, and a framework within which related services can be deployed.

AES
Advanced Encryption Standard. Used to encrypt and protect electronic data, AES encrypts and decrypts data
in blocks of 128 bits (16 bytes), and can use keys of 128, 192, and 256 bits.

agent
Agents such as persistent agents, dissolvable agents, or the ClearPass OnGuard Unified Agent perform
device fingerprinting, posture assessments, and health checks. See also dissolvable agent, persistent agent,
native agent, and OnGuard.

AirGroup
ClearPass application that allows end users to register their personal mobile devices on a local network and
define a group of friends or associates who are allowed to share them. Primarily designed for colleges and
other institutions. AirGroup uses zero configuration networking to allow Apple mobile devices, such as the
AirPrint wireless printer service and the AirPlay mirroring service, to communicate over a complex access net-
work topology.

Amigopod
Original name of the ClearPass Guest application. No longer used, but still appears in some syntax.

app
Application. This shortened form of the word is used for mobile devices.

application identifier
Unique identifier generated when a provisioning profile is created. In combination with the approved domain,
it allows app distribution.

audit server
Evaluates the health of clients that do not have an installed agent, or that cannot respond to Policy Manager
interactions. Audit servers typically operate in lieu of authentication methods, authentication sources, or
internal posture policies and posture servers.

authentication
Verification of a user’s credentials, typically a username and password.
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authentication source
Identity repository against which Policy Manager verifies identity. ClearPass supports the following authen-
tication source types: Microsoft Active Directory, LDAP-compliant directories, RSA or other RADIUS-based
token servers, and SQL database, as well as Static Host lists for MAC-based authentication.

authenticator
Permits or denies network access to supplicants.

authorization
Authorization controls the type of access that an authenticated user is permitted to have.

authorization source
Collects attributes for use in role-mapping rules. You specify the attributes you want to collect when you con-
figure the authentication source. CPPM supports the following authorization source types: Microsoft Active Dir-
ectory, any LDAP compliant directory, RSA or other RADIUS-based token servers, and SQL database, including
the local user store.

bounce
To shut down and restart a service or port.

BYOD
Bring your own device. Refers to using personal mobile devices within an employer's enterprise network infra-
structure, and the associated network and resource management challenges.

CA
Certificate Authority. Entity in a public key infrastructure system that issues certificates to clients. A certificate
signing request received by the CA is converted into a certificate when the CA adds a signature that is gen-
erated with the CA’s private key. See digital certificate, private key, and public key infrastructure.

captive portal
Implemented by NAS. Provides access to the network only to authorized users.

Certificate Authority
Entity in a public key infrastructure system that issues certificates to clients. A certificate signing request
received by the Certificate Authority (CA) is converted into a certificate when the CA adds a signature that is
generated with the CA’s private key. See digital certificate, private key, and public key infrastructure.

CHAP
Challenge-Handshake Authentication Protocol. Authentication scheme used by Point to Point Protocol (PPP)
servers to validate the identity of remote clients.

ClearPass
Access Management System for creating and enforcing policies across a network to all devices and applic-
ations. The ClearPass integrated platform includes Policy Manager, Guest, Onboard, OnGuard, Insight, Pro-
filer, AirGroup, and QuickConnect.

ClearPass Guest
Configurable ClearPass application for secure guest network access management. Access permissions to
ClearPass Guest features are controlled through an operator profile that can be integrated with an LDAP
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server or Active Directory login. The ClearPass Guest application can be accessed either directly or through
Policy Manager.

client
In a server-client relationship, the client is a device or appliance that relies on the server for information,
access, or other actions.

cluster
Group of independent servers connected through a dedicated network that act as a single system, allowing
high availability and load balancing. Resources in a cluster are dynamically assigned. See also publisher, sub-
scriber.

CNA
Apple Captive Network Assistant. Pop-up browser shown when joining a network that has a captive portal.

CoA
Change of Authorization.

collector
Network elements providing data for profiling endpoints. The following collectors send endpoint attributes to
Profiler: DHCP, Onboard, HTTP User Agent, MAC OUI, ActiveSync plugin, OnGuard, SNMP, and Subnet Scan-
ner.

common name
See distinguished name.

controller
Acts as the authenticator for the network, relaying information between the authentication server and the sup-
plicant.

CRL
Certificate Revocation List. List of revoked certificates maintained by a Certificate Authority and regularly
updated.

cryptobinding
Short for cryptographic binding. Procedure in a tunneled EAP method that binds together the tunnel protocol
and the tunneled authentication method(s), ensuring the relationship between a collection of data assets and
protecting authentication protocol negotiation against man-in-the-middle attacks. Cryptographic binding
focuses on protecting the server; mutual cryptographic binding protects both peer and server.

CSR
Certificate Signing Request.

CSV
Comma-separated values.

device category
Classification describing a device's type—for example, computer, smartdevice, printer, access point, and so
on. One of three hierarchical elements in a device profile.
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device family
Within the device category, a classification based on the type of operating system or vendor—for example, if
the device category is Computer, the value for device family might be Windows, Linux, or macOS. One of three
hierarchical elements in a device profile.

device fingerprint
Information collected about a device for the purpose of identification. Fingerprints can fully or partially identify
individual users or devices even when cookies are turned off.

device name
Within the device family, a classification based on granular details such as OS version—for example, if the
device family is Windows, the value for device name might be Windows 7 or Windows 2008 Server. One of
three hierarchical elements in a device profile.

device provisioning
Process of preparing a device for use on an enterprise network, by creating the appropriate access cre-
dentials and setting up the network connection parameters. Same as onboarding.

Device Registration
Functionality within Guest that allows end users to register their personal mobile devices on a local network.
Each device registered by an operator is automatically shared with all of that operator’s registered devices.
There is no limit to the number of device accounts an operator can create, and no expiration time is set on
device accounts. Device Registration operators are created in Policy Manager, and can then log in through
ClearPass Guest to register and manage their devices.

DHCP
Dynamic Host Configuration Protocol. An auto-configuration protocol used on IP networks. Computers or any
network peripherals that are connected to IP networks must be configured before they can communicate with
other computers on the network. DHCP allows a computer to be configured automatically, eliminating the
need for a network administrator. DHCP also provides a central database to keep track of computers con-
nected to the network; this database helps prevent any two computers from being configured with the same
IP address.

digital certificate
Contains identification data (see distinguished name) and the public key portion of a public/private key pair,
and a signature that is generated by a Certificate Authority. The signature ensures the integrity of the data in
the certificate (only the Certificate Authority can create valid certificates).

Disconnect-Ack
NAS response packet to a Disconnect-Request, indicating that the session was disconnected.

Disconnect-Nak
NAS response packet to a Disconnect-Request, indicating that the session could not be disconnected.

Disconnect-Request
RADIUS packet type sent to a NAS requesting that a user or session be disconnected.

dissolvable agent
Functionality within ClearPass OnGuard that performs device fingerprinting, posture assessments, and health
checks. Performs a one-time check at login to ensure policy compliance. Dissolvable agents cannot perform

ClearPass Guest 6.7 | User Guide Glossary | 780
Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2909



781 | Glossary ClearPass Guest 6.7 | User Guide

remediation; devices not meeting compliance can be redirected to a captive portal for manual remediation.
Dissolvable agents are browser-based and are not installed on the endpoint. They are temporary: when the
browser page used during authentication is closed, the dissolvable agent is removed, leaving no trace. The
Web-based dissolvable agent is ideal for personal, non IT-issued devices that connect via a captive portal and
do not allow agents to be permanently installed. See also persistent agent, native agent, and OnGuard.

distinguished name
(DN) Series of fields in a digital certificate that, taken together, constitute the unique identity of the person or
device that owns the digital certificate. Common fields in a distinguished name include country, state, locality,
organization, organizational unit, and the “common name”, which is the primary name used to identify the cer-
tificate.

DN
See Distinguished Name.

EAP
Extensible Authentication Protocol. An authentication framework that supports multiple authentication meth-
ods, such as token cards, smart cards, certificates, one-time passwords, and public key encryption authen-
tication. In tunneled EAP methods, authentication and posture credential exchanges occur inside of a
protected outer tunnel.

EAP-FAST
EAP Flexible Authentication Secure Tunnel. (tunneled)

EAP-GTC
EAP Generic Token Card. (non-tunneled)

EAP-MD5
EAP Method Digest 5. (non-tunneled)

EAP-MSCHAP
EAP Microsoft Challenge Handshake Authentication Protocol. EAP-MSCHAP is version 1 and EAP-MSCHAPv2
is version 2. (non-tunneled)

EAP-MSCHAPv2
EAP Microsoft Challenge Handshake Authentication Protocol. EAP-MSCHAP is version 1 and EAP-MSCHAPv2
is version 2. (non-tunneled)

EAPoUDP
EAP over UDP. See also UDP.

EAP-PEAP
Protected EAP. Widely-used protocol for securely transporting authentication data across a network.
(tunneled)

EAP-TLS
EAP Transport Layer Security. Certificate-based authentication method supporting mutual authentication,
integrity-protected ciphersuite negotiation, and key exchange between two endpoints.

Anexo 09 ITEM 01 (0592519)         SEI 0008478-63.2018.6.02.8000 / pg. 2910



EAP-TTLS
EAP Tunneled Transport Layer Security. Certificate-based authentication method supporting mutual authen-
tication, integrity-protected ciphersuite negotiation, and key exchange between two endpoints. It is designed
to be as strong as EAP-TLS but does not require that each user be issued a certificate, instead issuing cer-
tificates only to the authentication servers.

extension
Self-contained microservice that can run on top of the ClearPass platform and provide access to some fea-
tures that are not yet part of the current ClearPass version -- for example, custom features developed for a
ClearPass customer or by a partner or customer.

field
In a database or a user interface, a single item of information; attribute.

form
Interactive page in the application where users can provide or modify data.

FQLN
Fully Qualified Location Name. A device location identifier in the format: APname.Floor.Building.Campus.

GET
HTTP request method that submits data to be processed to a specified resource.

guest
Someone who is permitted to access the Internet through your Network Access Server.

Guest
Configurable ClearPass application for secure guest network access management. Access permissions to
ClearPass Guest features are controlled through an operator profile that can be integrated with an LDAP
server or Active Directory login. The ClearPass Guest application can be accessed either directly or through
Policy Manager.

Identity Provider
Service that authenticates a user or client identity and issues security tokens for ACS.

IdP
Service that authenticates a user or client identity and issues security tokens for ACS.

Insight
ClearPass analytics and reporting application.

intermediate CA
Certificate Authority with a certificate that was issued by another Certificate Authority. See trust chain.

iOS
Operating system from Apple, Inc. for mobile devices, including the iPhone, iPad, and iPod Touch.

jailbroken
Condition of an iOS device that has been modified in order to download applications, extensions, or themes
not authorized by Apple. The term is also sometimes used to describe similar activity on non-Apple devices.
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The legal implications of jailbreaking a device vary by country and by device.

JSON
JavaScript Object Notation. An open-standard, language-independent, lightweight data-interchange format
used to transmit data objects consisting of attribute–value pairs. JSON uses a "self-describing" text format
that is easy for humans to read and write, and that can be used as a data format by any programming lan-
guage.

keepalive
Signal sent at periodic intervals from one device to another to verify that the link between the two devices is
working. If no reply is received, data will be sent by a different path until the link is restored. A keepalive can
also be used to indicate that the connection should be preserved so that the receiving device does not con-
sider it timed out and drop it.

landing page
Login page displayed to a guest.

LDAP
Lightweight Directory Access Protocol. Communications protocol used to maintain and access distributed dir-
ectory information about users and other objects over a network.

MAC address
Media Access Control Address. Unique identifier assigned to network interfaces for communications on a net-
work. A device may have a wired network address and a wireless network address.

MAC auth
MAC Authentication Method. Authenticates devices based on their MAC address. MAC authentication might
be the only method of client authentication or clients may also be required to authenticate themselves using
other methods, depending on the network privileges required.

MAC OUI
The OUI, or Organizationally Unique Identifier, is the first half of a MAC address. It can be useful in some
cases for better identifying endpoints, or for profiling devices like printers that might be configured with static
IP addresses. See also OUI.

macOS
Operating system from Apple, Inc. for desktop and laptop computers. The first version to use the macOS
name was macOS 10.12 (Sierra), replacing the Mac OS X name used for versions 10.0 (Cheetah) through
10.11 (El Capitan). For simplicity, the macOS name is sometimes used in this book to refer to any 10.x version.

MAM
Mobile Application Management. The employee owns the mobile device used for work, and the company
provides and manages the features.

MDM
Mobile Device Management. The company owns and manages the mobile device the employee uses for work.
A company-issued laptop is actually an MDM device, but MDM features in ClearPass allow company man-
agement to be applied to a variety of devices.
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MFA
See multi-factor authentication.

MIB
Management Information Base. Hierarchical database used by SNMP to manage the devices being mon-
itored.

multi-factor authentication
Multi-factor authentication (MFA) lets you require multiple factors, or proofs of identity, when authenticating a
user. Policy configurations define how often multi-factor authentication will be required, or conditions that will
trigger it.

NAD
Network Access Device. The device that automatically connects the user to the preferred network; for
example, an AP or an Ethernet switch.

NAK
Negative AcKnowledgement code. Response indicating that a transmitted message was received with errors
or corrupted, or that the receiving end is not ready to accept transmissions.

NAP
Network Access Protection. Functionality in the Windows Server that allows network administrators to define
specific levels of network access based on identity, groups, and policy compliance. The NAP Agent is a service
that collects and manages health information for NAP client computers. If a client is not compliant, NAP
provides a mechanism to automatically bring the client back into compliance and then dynamically increase
its level of network access.

NAS
Network Access Server. Device -- such as a wireless access point, network switch, or dial-in terminal server --
that provides network access to users. When a user connects to the NAS device, a RADIUS user authentication
request (Access-Request) is generated by the NAS.

native agent
Browser-based dissolvable agent that uses a separate binary file for each operating system. See also dis-
solvable agent, persistent agent, and OnGuard.

NetBIOS
Network Basic Input/Output System. Program that lets applications on different computers communicate
within a local area network (LAN).

Network Access Server
(NAS) Device that provides network access to users, such as a wireless access point, network switch, or dial-in
terminal server. When a user connects to the NAS device, a RADIUS user authentication request (Access-
Request) is generated by the NAS.

nMAP
Network Mapper. Open source utility for network discovery and security auditing. Nmap uses IP packets to
determine such things as the hosts available on a network and their services, operating systems and versions,
types of packet filters/firewalls, and so on.
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NTP
Network Time Protocol. Protocol for synchronizing the clocks of computers over a network.

OAuth
Open Authorization. Open protocol for token-based authentication and authorization over the Web, allowing
account information to be securely used by third-party services.

OCSP
Online certificate status protocol (RFC 2560). Protocol used to determine the current status of a digital cer-
tificate without requiring CRLs.

Onboard
ClearPass application for automating 802.1x configuration and provisioning for “bring your own device”
(BYOD) and IT-managed devices across wired, wireless, and virtual private networks (VPNs). Information
Onboard collects during device onboarding is sent to Profile and used for device category, family, and name
classification. ClearPass Onboard features are part of the Onboard module in the ClearPass Guest applic-
ation.

onboard provisioning
Process used to securely provision a device and configure it with network settings.

onboard-capable
Device supported by the QuickConnect application.

onboarding
Process of preparing a device for use on an enterprise network, by creating the appropriate access cre-
dentials and setting up the network connection parameters. Same as device provisioning.

OnGuard
Functionality within ClearPass that uses persistent and dissolvable agents to perform endpoint protection, pos-
ture assessments, and health checks, ensuring compliance is met before devices connect. See also persistent
agent, dissolvable agent, and native agent.

OnGuard Unified Agent
Combination of OnGuard and Aruba VIA.

operator
Person who uses ClearPass Guest to create guest accounts or perform system administration. Operators act
as sponsors for guest access.

operator login
Configuration defining a ClearPass Guest operator's roles and access privileges.

operator profile
Characteristics assigned to a class of operators, such as the permissions granted to those operators.

OS X
Operating system from Apple, Inc. for desktop and laptop computers. The OS X name was used for versions
10.0 (Cheetah) through 10.11 (El Capitan) but was replaced by the name macOS starting with version 10.12.
For simplicity, the macOS name is sometimes used in this book to refer to any 10.x version.
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OUI
Organizationally Unique Identifier. Synonymous with Company ID or Vendor ID, an OUI is a 24-bit, globally-
unique assigned number referenced by various standards. The OUI is used as the first half of a MAC address.

over-the-air provisioning
Process used to securely provision a device and configure it with network settings; applies to iOS and macOS
10.7+ only.

PANW
Palo Alto Networks. Network security company whose products include a firewall with which ClearPass integ-
rates, exchanging user context related to posture assessments.

PAP
Password Authentication Protocol. Validates users by password, PAP does not encrypt passwords for trans-
mission and is thus considered insecure.

PEAP
Protected EAP. See EAP-PEAP.

persistent agent
Functionality within ClearPass OnGuard that performs device fingerprinting, posture assessments, and health
checks. Provides nonstop monitoring and automatic remediation and control, and supports automatic and
manual remediation. When running persistent OnGuard agents, ClearPass can centrally send system-wide
notifications and alerts, and allow or deny network access. Persistent agents are OS-based. They are installed
on the endpoint; a user must have admin privileges in order to install them. Persistent agents are typically
used for corporate-owned and managed devices. See also dissolvable agent, native agent, and OnGuard.

ping
Test network connectivity using an ICMP echo request (“ping”).

PKCS#n
Public-key cryptography standard N. Refers to a numbered standard related to topics in cryptography, includ-
ing private keys (PKCS#1), digital certificates (PKCS#7), certificate signing requests (PKCS#10), and secure
storage of keys and certificates (PKCS#12).

PKI
See public-key infrastructure.

Policy Manager
ClearPass Policy Manager is the main application of the ClearPass access management platform, and is used
to create and enforce policies across a network for all devices and applications. Policy Manager also includes
links to Guest, Insight, and Onboard. OnGuard and Profile features and some AirGroup configuration items
are included within the Policy Manager user interface.

POST
HTTP request method that requests data from a specified resource.

posture
Set of characteristics describing the health of an endpoint device seeking access to the network. These may
include such things as device type, operating system, or antivirus software. Posture assessment or posture
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validation: Using rules to evaluate and provide a security assessment for the endpoint and its user, assuring
they are compliant. Posture token: Health status of the endpoint.

posture policy
Internal posture policies test requests against internal posture rules to assess health. Posture rule conditions
can contain attributes present in vendor-specific posture dictionaries.

posture server
Evaluates client health based on specified vendor-specific posture credentials, typically posture credentials
that cannot be evaluated internally by Policy Manager (that is, not by internal posture policies). Currently,
Policy Manager supports two forms of posture server interfaces: RADIUS posture servers and GAMEv2 pos-
ture servers.

Pre-Shared Key
See PSK.

print template
Defines the format and appearance of a guest account receipt.

private key
The part of a public/private key pair that is always kept private. The private key is used to encrypt a message’s
signature to authenticate the sender (only the sender knows the private key). The private key is also used to
decrypt a message that was encrypted with the sender’s public key (only the sender can decrypt it). See also
public key.

Profiler
Functionality within ClearPass that automatically classifies endpoints, using attributes obtained from col-
lectors. It associates an endpoint with a specific user or location, secures access for devices like printers and
IP cameras, and can be used to implement BYOD flows where access is controlled based on the type of the
device and the identity of the user.

provisioning
Process used to securely provision a device and configure it with network settings.

PSK
Pre-shared Key. Shared secret that was previously shared between the two parties using a secure channel
before it needed to be used.

public key
The part of a public/private key pair that is made public. The public key is used to encrypt a message; the recip-
ient’s private key is required to decrypt the message. A large part of a digital certificate is the certificate
owner’s public key. See also private key.

public-key infrastructure
Security technology based on digital certificates and the assurances provided by strong cryptography. See
also Certificate Authority, digital certificate, public key, private key.

publisher
Required server in a cluster. Each cluster can have only one publisher; it is the first server installed on the
cluster. The publisher provides database services to the subscribers in the cluster. See also cluster,
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subscriber.

push certificates
Enable the server to work with the Apple Push Notification Service (APNS) and Apple iOS devices connected to
an MDM account.

QC
See QuickConnect.

QuickConnect
Functionality within ClearPass used to securely provision an Android, Windows, Linux, or macOS device and
configure it with network settings. QuickConnect's functionality is incorporated within Onboard.

RADIUS
Remote Authentication Dial-In User Service. Network access-control protocol for verifying and authenticating
users; provides AAA management. A RADIUS transaction might be 802.1X, MAC-Auth, or generic RADIUS.

Registration Authority
Type of Certificate Authority that processes certificate requests. The Registration Authority (RA) verifies that
requests are valid and comply with certificate policy, and authenticates the user's identity. The RA then for-
wards the request to the Certificate Authority to sign and issue the certificate.

RFC
Request For Comments; a commonly-used format for Internet standards documents.

RFC 3576 Dynamic Authorization
Dynamic authorization describes the ability to make changes to a guest account’s session while it is in pro-
gress. This might include disconnecting a session or updating some aspect of the authorization for the ses-
sion.

role
Type of access being granted. ClearPass lets you define multiple roles. Such roles could include employee,
guest, team member, or press. Roles are used for both guest access (user role) and operator access to
ClearPass. See operator profile.

root CA
Certificate Authority that signs its own certificate (a self-signed certificate), and must be explicitly trusted by
users of the CA.

SAML
Security Assertion Markup Language. XML-based framework for communicating user authentication, enti-
tlement, and attribute information. SAML enables single sign-on by allowing users to authenticate at an iden-
tity provider and then access service providers without additional authentication.

SAN
Subject Alternative Name. SANs let you specify a list of host names to be protected by a single SSL certificate.
Multiple domain names are secured by adding them to the Subject Alternative Name (SAN) field during enroll-
ment. The common name, or primary domain name, on the certificate must be a registered fully qualified
domain name.
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SCEP
Simple certificate enrollment protocol. Protocol for requesting and managing digital certificates.

SCP
Secure copy; SCP Protocol. Network protocol that supports file transfers between hosts on a network.

self-signed certificate
See root CA.

session
Service provided by a NAS to an authorized user.

skin
A Web site’s visual appearance, or “look and feel.” It can be thought of as a container that holds the applic-
ation, its layout, style sheet (font size and color for example), header and footer, and so forth.

Smarty
Template engine for PHP, facilitating the separation of presentation (HTML/CSS) from application logic.

SMS
Short Message System; a method for delivering short messages (up to 140 characters) to mobile phones.

SNMP
Simple Network Management Protocol. A TCP/IP standard protocol for managing devices on IP networks. Net-
work administrators use SNMP to monitor and map network availability, and facilitate the exchange of inform-
ation between network devices.

SOAP Web Services
SOAP Web services provide a way of transferring data across the Internet to integrate Web-based applic-
ations. Web services let businesses share data and processes programmatically, and can be added to a user
interface to provide functionality. The SOAP interface is available to third-party applications that will integrate
with the ClearPass Visitor Management Appliance (ClearPass Guest). The API provides direct access to the
underlying functionality of the ClearPass Visitor Management Appliance. Developers wishing to provide integ-
rated applications can use the API to programmatically perform actions that would otherwise require manual
operation of the user interface.

SoH
Statement of Health.

sponsor
See operator.

SSID
Service Set Identifier. Unique identifier attached to the header of packets sent over a WLAN, and which acts as
a password when a mobile device tries to connect to the basic service set (BSS).

SSO
Single Sign-On. Access-control property that lets a user log in once to access multiple related but independent
applications or systems to which they have privileges. The process authenticates the user across all allowed
resources during their session, eliminating additional login prompts.
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static host
A hostname; a relationship between a name and an IP address. A static host list is a named list of MAC or IP
addresses.

subscriber
Server in a cluster that “subscribes” to the publisher to receive updated database information. As redundant
servers, subscribers improve performance through load balancing, and provide failover and high availability.
Sometimes referred to as a node. See also cluster, publisher.

supplicant
Device attempting to gain access to the network. See also client.

TACACS
Terminal Access Controller Access Control System. Family of protocols that handle remote authentication and
related services for network access control through a centralized server.

TLS
See EAP-TLS.

trust chain
Sequence of certificates, starting at a trusted root certificate, that establishes the identity of each certificate in
the chain.

trusted root
See root CA.

TSV
Tab-separated values.

TTY
TTY-enabled devices allow telephones to transmit text communications for people who are deaf or hard of
hearing as well as transmitting voice communication.

UAM
Universal Access Method. Used by Wi-Fi operators to allow access to a wireless network, or to allow access to
another network while roaming. For roaming, a Web browser is used to access a login page on a captive
portal.

UDID
Unique Device Identifier for an iOS device.

UDP
User Datagram Protocol. Part of the TCP/IP family of protocols used for data transfer. UDP is typically used for
streaming media, and is a "stateless" protocol, meaning it does not acknowledge that the packets being sent
have been received.

unique device credentials
Network authentication credentials that uniquely identify the device and user and enable management of pro-
visioned devices. May be a username and password or a TLS client certificate, depending on the type of
device.
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user database
Database of the guests on the system.

UUID
Universally Unique Identifier. Unique identifier generated when a provisioning profile is created, allowing
proper app distribution permissions.

VA
Virtual appliance.

VIA
Aruba's Virtual Intranet Access client. Provides secure remote network connectivity for Android, Apple iOS,
macOS, and Windows mobile devices and laptops. Automatically scans and selects the best secure connection
to the corporate network.

view
Page in the application that displays data but does not contain interactive fields the user can modify. Usually a
table listing things like accounts or other sets of data and providing links to related actions or forms.

VIP
Virtual IP address.

visitor
See guest.

VMA
Visitor Management Appliance. Refers to ClearPass Guest.

VPN
Virtual Private Network. Enables secure access to a corporate network when located remotely. It allows a com-
puter to send and receive data across shared or public networks as if it were directly connected to the private
network, while benefiting from the functionality, security, and management policies of the private network.
This is done by establishing a virtual point-to-point connection through the use of dedicated connections,
encryption, or a combination of the two.

VSA
Vendor-specific attribute.

walled garden
Defined set of internet or network resources that can or cannot be accessed by unauthorized users through
the captive portal.

Web Auth
User-authentication system for Web pages and Web applications. Web authentication transactions through
the dissolvable agent in OnGuard.

Web login
Login page displayed to a guest.
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Wi-Fi
Technology that allows devices to connect to a Wireless LAN (WLAN) network, mainly using the 2.4 gigahertz
and 5 gigahertz radio bands.

WLAN
Wireless Local Area Network. Local Area Network (LAN) that users access through a wireless connection.
802.11 standards specify WLAN technologies. WLANs, in most cases, are some portion of a wired LAN.

WPA2
Wi-Fi Protected Access II. Certified interoperable version of the full IEEE 802.11i specification. WPA2 supports
IEEE 802.1X/EAP authentication or PSK technology, but includes an advanced encryption mechanism using
Counter-Mode/CBC-MAC Protocol (CCMP) called the Advanced Encryption Standard (AES).

WSDL
Web Service Description Language. An XML-based interface definition language used to describe the func-
tionality provided by a Web service.

X.509
Standard defining the format and contents of digital certificates.

XML-RPC
XML Remote Procedure Call. Protocol that uses XML to encode its calls and HTTP as a transport mechanism.
The XML-RPC interface is available to third-party applications that will integrate with the ClearPass Visitor Man-
agement Appliance (ClearPass Guest). The ClearPass Guest XML-RPC API provides direct access to the under-
lying functionality of the ClearPass Visitor Management Appliance. Developers wishing to provide integrated
applications can use the API to programmatically perform actions that would otherwise require manual oper-
ation of the user interface.
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print templates 292

protocol settings 171

provisioning instructions, Onboard 243
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shared_role field 345
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directory, creating 279

downloading 279

management 276
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guest self-registration receipts 368
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guest accounts, editing 69

exporting

application log 678

certificates 152

configuration backup 636

guest accounts 61

extensions

configuring 632, 634

installing 632, 634

F
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ClearPass Onboard 
With the broad adoption of personal mobile devices and the 
applications that run on those devices, today’s users are increasingly 
demanding a “bring your own device” (BYOD) solution for the networks 
that they use. 

A network administrator’s traditional tasks of maintaining security and 
managing device provisioning are no longer enough: in a BYOD 
network these elements are constantly changing. Furthermore, users expect to be able to 
manage their own device. 

To solve this problem, ClearPass Onboard automates 802.1X configuration and 
provisioning for BYOD and IT-managed devices – Windows, Mac OS X, iOS and Android – 
across wired, wireless and VPNs. 

The ClearPass Onboard solution provides network administrators with much greater 
control over how consumer-oriented mobile devices, such as smartphones and tablet 
devices, are connected to an enterprise network. 

The result is a streamlined method for applying wired, wireless and VPN settings, and an 
easy-to-manage process for delivering and revoking unique device credentials. 

Key features: 

 Automatic configuration of network settings for wired and wireless endpoints. 

 Provisioning of unique device credentials for BYOD and IT-managed devices. 

 Supports Windows, Mac OS X, iOS and Android devices. 

 Enables the revocation of unique credentials on a specific user’s device. 

 Leverages ClearPass profiling to identify device type, manufacturer and model. 
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Accessing Onboard 

Use the ClearPass Onboard command link on the Unified Visitor Management home page to 
access the Onboard features. 

 

About ClearPass Onboard 

Onboarding is defined as the process of preparing a device for use on an enterprise 
network by creating the appropriate access credentials and setting up the network 
connection parameters. 

Refer to the sections below for more detailed information about ClearPass Onboard: 

 Onboard Deployment Checklist 

 Terminology for Onboard 

 Onboard Features 

 Platforms Supported by Onboard  

 Public Key Infrastructure for Onboard  

 Revoking Unique Device Credentials 

 Network Requirements for Onboard  

 Network Architecture for Onboard 

 Onboard Process  

Onboard Deployment Checklist 

Use the following checklist to complete your Onboard deployment. 
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Table 1 – Onboard deployment checklist 

 Deployment Step Reference 

Planning and Preparation 

 Review the Onboard feature list to identify the major 
areas of interest for your deployment. 

See “Onboard Features” 

 Review the list of platforms supported by Onboard, and 
identify the platforms of interest for your deployment. 

See “Platforms Supported by 
Onboard” 

 Review the Onboard public key infrastructure, and 
identify any certificate authorities that will be needed 
during the deployment. 

See “Public Key 
Infrastructure for Onboard” 

 Review the network requirements and the network 
architecture diagrams to determine how and where to 
deploy the Onboard solution. 

See “Network Requirements 
for Onboard” and “Network 
Architecture for Onboard” 

Configuration 

 Configure the hostname and networking properties of the 
Onboard provisioning server. 

 DNS is required for SSL. 

 Ensure that hostname resolution will work for 
devices being provisioned. 

Administrator chapter – 
Network configuration  

 Configure SSL certificate for the Onboard provisioning 
server. 

 A commercial SSL certificate is required to enable 
secure device provisioning for iOS devices. 

Administrator chapter – SSL 
configuration  

 Configure the Onboard certificate authority. 

 Decide whether to use the Root CA or 
Intermediate CA mode of operation. 

 Create the certificate for the certificate authority. 

See “Configuring the 
Certificate Authority”  

 Configure the data retention policy for the certificate 
authority.  

See “Configuring data 
retention policy for 
certificates”  

 Configure ClearPass integration. 

 Set Policy Manager connection and authentication 
details. 

 Set Profiler options, if required. 

See “Configuring ClearPass 
Servers for Device 
Provisioning” 

 Configure device provisioning settings. 

 Select certificate options for device provisioning. 

See “Configuring 
Provisioning Settings”  

Anexo 10 ITEM 01 (0592522)         SEI 0008478-63.2018.6.02.8000 / pg. 2947



ClearPass Onboard  Deployment Guide 

Aruba Networks 7 

 Deployment Step Reference 

 Select which device types should be supported. 

 Configure network settings for device provisioning. 

 Set network properties. 

 Upload 802.1X server certificates. 

 Set device-specific networking settings. 

See “Configuring Network 
Settings for Device 
Provisioning”  

 Configure networking equipment for non-provisioned 
devices. 

 Set authentication for the provisioning SSID, if 
required. 

 Ensure the captive portal redirects non-
provisioned devices to the device provisioning 
page. 

See “Network Requirements 
for Onboard”  

 Configure networking equipment to authenticate 
provisioned devices. 

 Ensure 802.1X authentication methods and trust 
settings are configured correctly for all EAP types 
that are required. 

 Configure OCSP or CRL on the authentication 
server to check for client certificate validity. 

See “Network Requirements 
for Onboard”  

 Configure the user interface for device provisioning. 

 Set display options for iOS devices. 

 Set user interface options for other Onboard 
devices. 

 Setup the device provisioning Web login page. 

See “Configuring the User 
Interface for Device 
Provisioning” 

Testing and Verification 

 Test device provisioning. 

 Verify that each type of device can be provisioned 
successfully. 

 Verify that each type of device can join the 
provisioned network and is authenticated 
successfully. 

 

 Test device revocation. 

 Revoke a device’s certificate. 

 Verify that the device is no longer able to 
authenticate. 

 Verify that re-provisioning the device fails.  
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Terminology for Onboard 

Table 2 defines the terms that are used in this document. 

Table 2 – Definition of terms for ClearPass Onboard 

Term Definition 

802.1X IEEE standard for port-based network access control 

BYOD “Bring your own device” – refers to the trend of personal 
mobile devices being used with enterprise network 
infrastructure 

CA See “certificate authority” 

Certificate authority Entity in a public key infrastructure system that issues 
certificates to clients. A certificate signing request received 
by the CA is converted into a certificate when the CA adds a 
signature that is generated with the CA’s private key. See 
“digital certificate”, “private key”, “public key infrastructure” 

Common name (CN) See “distinguished name” 

CRL “Certificate revocation list” – list of revoked certificates 
maintained by a certificate authority and regularly updated 

Device provisioning The process of preparing a device for use on an enterprise 
network, by creating the appropriate access credentials and 
setting up the network connection parameters 

Digital certificate Contains identification data (see “distinguished name”) and 
the public key portion of a public/private key pair, and a 
signature that is generated by a certificate authority. The 
signature ensures the integrity of the data in the certificate 
(only the certificate authority can create valid certificates)  

Distinguished name A series of fields in a digital certificate that, taken together, 
comprise the unique identity of the person or device that 
owns the digital certificate. Common fields in a distinguished 
name include country, state, locality, organization, 
organizational unit, and the “common name”, which is the 
primary name used to identify the certificate 

DN See “distinguished name” 

EAP “Extensible Authentication Protocol” (RFC 3748), an 
authentication framework that supports multiple 
authentication methods 

EAP-TLS “Extensible Authentication Protocol – Transport Layer 
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Term Definition 

Security” (RFC 5216), a certificate-based authentication 
method supporting mutual authentication, integrity-
protected ciphersuite negotiation and key exchange between 
two endpoints  

EAP-PEAP “Protected EAP” – a widely-used protocol for securely 
transporting authentication data across a network  

Intermediate CA A certificate authority with a certificate that was issued by 
another certificate authority; see “trust chain”  

iOS Operating system from Apple, Inc. for mobile devices 
including the iPhone, iPad and iPod Touch 

OCSP “Online certificate status protocol” (RFC 2560) – protocol 
used to determine the current status of a digital certificate 
without requiring CRLs 

Onboarding See “device provisioning” 

Onboard provisioning Process used to securely provision a device and configure it 
with network settings 

Onboard-capable device Device supported by QuickConnect app 

OS X Operating system from Apple, Inc. for desktop and laptop 
computers 

Over-the-air provisioning Process used to securely provision a device and configure it 
with network settings; applies to iOS and OS X 10.7+ only 

PEAP “Protected EAP” – see “EAP-PEAP” 

PKCS#n “Public-key cryptography standard N” – refers to a numbered 
standard related to topics in cryptography, including private 
keys (PKCS#1), digital certificates (PKCS#7), certificate 
signing requests (PKCS#10) and secure storage of keys and 
certificates (PKCS#12) 

PKI “Public-key infrastructure” – a security technology based on 
digital certificates and the assurances provided by strong 
cryptography. See also “certificate authority”, “digital 
certificate”, “public key”, “private key” 

Private key The part of a public/private key pair that is always kept 
private. The private key is used to encrypt a message’s 
signature to authenticate the sender (only the sender knows 
the private key). The private key is also used to decrypt a 
message that was encrypted with the sender’s public key 
(only the sender can decrypt it) 
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Term Definition 

Public key The part of a public/private key pair that is made public. The 
public key is used to encrypt a message; the recipient’s 
private key is required to decrypt the message. A large part 
of a digital certificate is the certificate owner’s public key 

Root CA A certificate authority that signs its own certificate (a self-
signed certificate), and must be explicitly trusted by users of 
the CA 

QuickConnect app Application used to securely provision an Android, Windows 
or Mac OS X device and configure it with network settings 

SCEP “Simple certificate enrollment protocol” – protocol for 
requesting and managing digital certificates 

Self-signed certificate See “Root CA” 

TLS See “EAP-TLS” 

Trust chain A sequence of certificates, starting at a trusted root 
certificate, that establishes the identity of each certificate in 
the chain 

Trusted root See “Root CA” 

Unique device credentials Network authentication credentials that uniquely identify 
the device and user and enable management of provisioned 
devices; may be a username and password or a TLS client 
certificate, depending on the type of device 

VPN “Virtual private network” – enables secure access to a 
corporate network when located remotely 

X.509 Standard defining the format and contents of digital 
certificates 

Onboard Features 

The following features are available in ClearPass Onboard: 

 Automatic configuration of network settings for wired and wireless endpoints. 

o Configure wired networks using 802.1X 

o Configure Wi-Fi networks using either 802.1X or pre-shared key (PSK) 

o Configure trusted server certificates for 802.1X 

o Configure Windows-specific networking settings 
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o Configure HTTP proxy settings for client devices (Android, OS X only) 

 Secure provisioning of unique device credentials for BYOD and IT-managed devices. 

o Configure EAP-TLS and PEAP-MSCHAPv2 without user interaction 

o Revoke unique device credentials to prevent network access 

 Supports Windows, Mac OS X, iOS and Android devices. 

o Leverages ClearPass Profiling to identify device type, manufacturer and 
model 

o Control the user interface displayed during device provisioning 

 Certificate authority enables the creation and revocation of unique credentials on a 
specific user’s device. 

o Root and intermediate CA modes of operation 

o Supports SCEP enrollment of certificates 

o Supports CRL generation to list revoked certificates 

o Supports OCSP responder to query for certificate status 

o Approve certificate signing request 

o Reject certificate signing request 

o Sign certificate from uploaded certificate signing request (CSR) 

o Issue certificate 

o Revoke certificate 

o Display certificates 

o Export certificate 

o Renew root certificate 

 Provision additional settings specific to iOS devices 

o Exchange ActiveSync 

o Passcode policy 

o VPN settings 
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Platforms Supported by Onboard 

Table 3 summarizes the platforms supported and the version requirements for those 
platforms to be supported by ClearPass Onboard. 

Table 3 – Platforms supported by ClearPass Onboard 

Platform Example devices Version required for 
ClearPass Onboard support 

Notes 

Apple iOS iPhone 

iPad 

iPod Touch 

iOS 4 

iOS 5 

1, 3 

Apple Mac OS X MacBook Pro 

MacBook Air 

Mac OS X 10.8 “Mountain Lion” 

Mac OS X 10.7 “Lion” 

1 

Mac OS X 10.6 “Snow Leopard” 

Mac OS X 10.5 “Leopard” 

2 

Android Samsung Galaxy S 

Samsung Galaxy Tab 

Motorola Droid 

Android 2.2 (or higher) 2 

Microsoft Windows Laptop 

Netbook 

Windows XP with Service Pack 3 

Windows Vista with Service Pack 3 

Windows 7 

2 

Note 1:  Uses the “Over-the-air provisioning” method. 

Note 2:  Uses the “Onboard provisioning” method. 

Note 3:  Onboard may also be used to provision VPN settings, Exchange ActiveSync 
settings, and passcode policy on these devices. 

Public Key Infrastructure for Onboard 

During the device provisioning process, one or more digital certificates are issued to the 
device. These are used as the unique credentials for a device. 

To issue the certificate, ClearPass Onboard must operate as a certificate authority. The 
following sections explain how the certificate authority works, and which certificates are 
used in this process. 
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Certificate Hierarchy 

In a public key infrastructure (PKI) system, certificates are related to each other in a tree-
like structure. See Figure 1. 

Figure 1 – Relationship of certificates in the Onboard public key infrastructure 

 

The root certificate authority (CA) is typically an enterprise certificate authority, with one 
or more intermediate CAs used to issue certificates within the enterprise. 

Onboard may operate as a root CA directly, or as an intermediate CA. See “Configuring the 
Certificate Authority”. 

The Onboard CA issues certificates for several purposes: 

 The Profile Signing Certificate is used to digitally sign configuration profiles that 
are sent to iOS devices. 

o The identity information in the profile signing certificate is displayed during 
device provisioning. 

 One or more Server Certificates may be issued for various reasons – typically, for 
an enterprise’s authentication server. 

o The identity information in the server certificate may be displayed during 
network authentication. 
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 One or more Device Certificates may be issued – typically, one or two per 
provisioned device. 

o The identity information in the device certificate uniquely identifies the 
device and the user that provisioned the device. 

You do not need to manually create the profile signing certificate; it is created when it is 
needed. See “Provisioning settings for iOS and OS X” to control the contents of this 
certificate. 

You may revoke the profile signing certificate; it will be recreated when it is needed for the 
next device provisioning attempt. 

Revoking Unique Device Credentials 

Because each provisioned device uses unique credentials to access the network, it is 
possible to disable network access for an individual device. This offers a greater degree of 
control than traditional user-based authentication — disabling a user’s account would 
impact all devices using those credentials. 

To disable network access for a device, revoke the TLS client certificate provisioned to the 
device. See “Working with certificates”. 

Note: Revoking access for a device is only possible when using an enterprise network. 
Personal (PSK) networks do not support this capability. 

Revoking credentials to prevent network access 

Revoking a device’s certificate will also prevent the device from being re-
provisioned. 

This is necessary to prevent the user from simply re-provisioning and obtaining a new 
certificate. To re-provision the device, the revoked certificate must be deleted. 

If the device is provisioned with an EAP-TLS client certificate, revoking the certificate will 
cause the certificate authority to update the certificate’s state. When the certificate is next 
used for authentication, it will be recognized as a revoked certificate and the device will be 
denied access. 

Note: When using EAP-TLS authentication, you must configure your authentication server 
to use either OCSP or CRL to check the revocation status of a client certificate. OCSP is 
recommended as it offers a real-time status update for certificates. 

If the device is provisioned with PEAP unique device credentials, revoking the certificate 
will automatically delete the unique username and password associated with the device. 
When this username is next used for authentication, it will not be recognized as valid and 
the device will be denied access. 
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Note: OCSP and CRL are not used when using PEAP unique device credentials. The 
Onboard server automatically updates the status of the username when the device’s client 
certificate is revoked. 

Re-provisioning a device 

Because “bring your own” devices are not under the complete control of the network 
administrator, it is possible for unexpected configuration changes to occur on a provisioned 
device. 

For example, the user may delete the configuration profile containing the settings for the 
provisioned network, instruct the device to forget the provisioned network settings, or 
reset the device to factory defaults and destroy all the configuration on the device. 

When these events occur, the user will not be able to access the provisioned network and 
will need to re-provision their device. 

The Onboard server detects a device that is being re-provisioned and prompts the user to 
take a suitable action (such as connecting to the appropriate network). If this is not 
possible, the user may choose to restart the provisioning process and re-provision the 
device. 

Re-provisioning a device will reuse an existing TLS client certificate or unique device 
credentials, if these credentials are still valid. 

If the TLS client certificate has expired then the device will be issued a new certificate. This 
enables re-provisioning to occur on a regular basis. 

If the TLS client certificate has been revoked, then the device will not be permitted to re-
provision. The revoked certificate must be deleted before the device is able to be 
provisioned. 

Network Requirements for Onboard 

For complete functionality to be achieved, ClearPass Onboard has certain requirements 
that must be met by the provisioning network and the provisioned network: 

 The provisioning network must use a captive portal or other method to redirect a 
new device to the device provisioning page. 

 The provisioning server (Onboard server) must have an SSL certificate that is 
trusted by devices that will be provisioned. In practice, this means a commercial SSL 
certificate is required. 

 The provisioned network must support EAP-TLS and PEAP-MSCHAPv2 
authentication methods. 
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 The provisioned network must support either OCSP or CRL checks to detect when a 
device has been revoked and deny access to the network. 

Using the same SSID for the provisioning and provisioned networks 

To configure a single SSID to support both provisioned and non-provisioned devices, use 
the following guidelines: 

 Configure the network to use both PEAP and EAP-TLS authentication methods. 

 When a user authenticates via PEAP with their domain credentials, place them into a 
provisioning role. 

o The provisioning role should have limited network access and a captive 
portal that redirects users to the device provisioning page. 

 When a user authenticates via PEAP with unique device credentials, place them into 
a provisioned role. 

 When a user authenticates via EAP-TLS using an Onboard client certificate, place 
them into a provisioned role. 

For provisioned devices, additional authorization steps can be taken after authentication 
has completed to determine the appropriate provisioned role. 

Using a different SSID for the provisioning and provisioned networks 

To configure dual SSIDs to support provisioned devices on one network, and non-
provisioned devices on a separate network, use the following guidelines: 

 Configure the provisioning SSID to use PEAP, or another suitable authentication 
method. 

 When a user connects to the provisioning SSID, place them into a provisioning role. 

o The provisioning role should have limited network access and a captive 
portal that redirects users to the device provisioning page. 

 When a user connects to the provisioned SSID, authenticate based on the type of 
credentials presented. 

o For PEAP authentication with unique device credentials, place them into a 
provisioned role. 

o For EAP-TLS authentication using an Onboard client certificate, place them 
into the provisioned role. 

o In all other cases, deny access.  
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As for the single-SSID case, additional authorization steps may be taken after 
authentication has completed to determine the appropriate provisioned role. 

Configuring the Online Certificate Status Protocol (OCSP) for the 
Provisioned Network 

Onboard supports the Online Certificate Status Protocol (OCSP) to provide a real-time 
check on the validity of a certificate. 

To configure OCSP for your network, you will need to provide the URL of an OCSP service 
to your network equipment. This URL can be constructed by using the relative path 
mdps_ocsp.php/1. 

For example, if the Onboard server’s hostname is onboard.example.com, the OCSP URL to 
use is: http://onboard.example.com/mdps_ocsp.php/1. 

Note: OCSP does not require the use of HTTPS and can be configured to use HTTP. 

Configuring a Certificate Revocation List (CRL) for the Provisioned Network 

Onboard supports generating a Certificate Revocation List (CRL) that lists the serial 
numbers of certificates that have been revoked. 

To configure a CRL, you will need to provide its URL to your network equipment. This URL 
can be constructed by using the relative path mdps_crl.php?id=1. 

For example, if the Onboard server’s hostname is onboard.example.com, the location of the 
CRL is: http://onboard.example.com/mdps_crl.php?id=1. 

Note: A certificate revocation list does not require the use of HTTPS and can be configured 
to use HTTP. 

Network Architecture for Onboard 

The high-level network architecture for the Onboard solution is shown in Figure 2. 
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Figure 2 – ClearPass Onboard network architecture 

 

The sequence of events shown in Figure 2 is: 

1. Users bring their own device to the enterprise. 

2. The ClearPass Onboard workflow is used to provision the user’s device securely and 
with a minimum of user interaction. 

3. Once provisioned, the device re-authenticates to the network using a set of unique 
device credentials.  These credentials uniquely identify the device and user and 
enable management of provisioned devices. 

4. Administrators can configure all aspects of the provisioning workflow – including 
the devices that have been provisioned, policies to apply to devices and the overall 
user experience for BYOD. 

A more detailed view of the network architecture is shown in Figure 3 below. This diagram 
shows different types of client devices using the Onboard workflow to gain access to the 
network. Some of the components that may be configured by the network administrator 
are also shown. 
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Figure 3 – Detailed view of the ClearPass Onboard network architecture 

 

The components shown in Figure 3 are: 

1. Users bring different kinds of client device with them. Onboard supports “smart 
devices” that use the iOS or Android operating systems, such as smartphones and 
personal tablets. Onboard also supports the most common versions of Windows and 
Mac OS X operating systems found on desktop computers, laptops and netbooks. 

2. The Onboard workflow is used to provision the user’s device securely and with a 
minimum of user interaction. The provisioning method used depends on the type of 
device. 

a. Newer versions of Mac OS X (10.7 and later) and iOS devices use the “over-
the-air” provisioning method. 

b. Other supported platforms use the “Onboard provisioning” method. 

3. Once provisioned, client devices use a secure authentication method based on 
802.1X and the capabilities best supported by the device. 

a. The unique device credentials issued during provisioning are in the form of 
an EAP-TLS client certificate for iOS devices and OS X (10.7+) devices. 
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b. Other supported devices are also issued a client certificate, but will use the 
PEAP-MSCHAPv2 authentication method with a unique username and strong 
password. 

4. Administrators can manage all Onboard devices using the certificate issued to that 
device. 

Amigopod-Based Network Architecture for Onboard 

Amigopod version 3.9 supports the provisioning, authentication and management aspects 
of the complete Onboard solution. 

Figure 4 shows the high-level network architecture for the Onboard solution when using 
Amigopod as the provisioning and authentication server. 

Figure 4 – ClearPass Onboard network architecture when using Amigopod 

 

The user experience for device provisioning is the same in Figure 4 and Figure 2, however 
there are implementation differences between these approaches: 

 When using the Amigopod RADIUS server for provisioning and authentication, EAP-
TLS and PEAP authentication must be configured. 

Navigate to RADIUS > Authentication > EAP & 802.1X to configure a server 
certificate and the appropriate EAP types for the Amigopod RADIUS server. 

 ClearPass Policy Manager supports a rich policy definition framework. If you have 
complex policies to enforce, multiple authentication or authorization sources that 
define user accounts, or you need features beyond those available in the Amigopod 
RADIUS server, you should deploy Policy Manager for authentication. 
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Onboard Process 

Devices supporting over-the-air provisioning 

ClearPass Onboard supports secure device provisioning for iOS 4, iOS 5, and recent 
versions of Mac OS X (10.7 “Lion” and later). These are collectively referred to as “iOS 
devices”. 

The onboard process for iOS devices is shown in Figure 5. 

Figure 5 – ClearPass Onboard process for iOS devices 

 

The Onboard process is divided into three stages: 

1. Pre-provisioning. The enterprise’s root certificate is installed on the iOS device. 

2. Provisioning. The user is authenticated at the device provisioning page and then 
provisions their device with the Onboard server. The device is configured with 
appropriate network settings and a device-specific certificate. 

3. Authentication. Once configuration is complete, the user switches to the secure 
network and is authenticated using an EAP-TLS client certificate. 
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A sequence diagram showing the interactions between each component of this workflow is 
shown in Figure 6. 

Figure 6 – Sequence diagram for the Onboard workflow on iOS platform 

 

1. When a BYOD device first joins the provisioning network it does not have a set of 
unique device credentials. This will trigger the captive portal for that device, which 
brings the user to the mobile device provisioning page. 

2. A link on the mobile device provisioning page prompts the user to install the 
enterprise’s root certificate. Installing the enterprise’s root certificate enables the 
user to establish the authenticity of the provisioning server during device 
provisioning. 

3. The user then authenticates with their provisioning credentials – these are typically 
the user’s enterprise credentials from Active Directory. If the user is authorized to 
provision a mobile device, the over-the-air provisioning workflow is then triggered 
(see Figure 7, below). 

4. After provisioning has completed, the device switches to EAP-TLS authentication 
using the newly provisioned client certificate. Mutual authentication is performed 
(the authentication server verifies the client certificate, and the client verifies the 
authentication server’s certificate). 

5. The device is now onboard and is able to securely access the provisioned network. 
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Over-the-air provisioning is used to securely provision a device and configure it with 
network settings. Figure 7 shows a sequence diagram that explains the steps involved in 
this workflow. 

Figure 7 – Over-the-air provisioning workflow for iOS platform 

 

1. The only user interaction required is to accept the provisioning profile. This profile 
is signed by the Onboard server, so that the user can be assured of its authenticity. 

2. An iOS device will have two certificates after over-the-air provisioning is complete: 

a. A Simple Certificate Enrollment Protocol (SCEP) certificate is issued to the 
device during the provisioning process. This certificate identifies the device 
uniquely, and is used to encrypt the device configuration profile so that only 
this device can read its unique settings. 

b. A Transport Layer Security (TLS) client certificate is issued to the device. 
This certificate identifies the device and the user that provisioned the device. 
It is used as the device’s network identity during EAP-TLS authentication. 

Devices supporting Onboard provisioning 

ClearPass Onboard supports secure device provisioning for Microsoft Windows XP (service 
pack 3 and later), Microsoft Windows Vista, Microsoft Windows 7, Apple Mac OS X 10.5 and 
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10.6, and Android devices (smartphones and tablets). These are collectively referred to as 
“Onboard-capable devices”. 

The onboard process for these devices is shown in Figure 8. 

Figure 8 – ClearPass Onboard process for Onboard-capable devices 

 

The Onboard process is divided into three stages: 

1. Pre-provisioning. This step is only required for Android devices; the Aruba 
Networks QuickConnect app must be installed for secure provisioning of the device. 

2. Provisioning. The device provisioning page detects the device type and downloads 
or starts the QuickConnect app. The app authenticates the user and then provisions 
their device with the Onboard server. The device is configured with appropriate 
network settings and credentials that are unique to the device. See Figure 9 for 
details. 

3. Authentication. Once configuration is complete, the user switches to the secure 
network and is authenticated using PEAP-MSCHAPv2 unique device credentials.  
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Figure 9 – Sequence diagram for the Onboard workflow on Android platform 

 

1. When a BYOD device first joins the network it does not have a set of unique device 
credentials. This will trigger the captive portal for that device, which brings the user 
to the mobile device provisioning page. 

2. The Onboard portal is displayed. The user’s device type is detected, and a link is 
displayed depending on the device type: 

a. For Android devices, the link is to a file containing the Onboard configuration 
settings; downloading this file will launch the QuickConnect app on the 
device. 

b. For Windows and Mac, the link is to a executable file appropriate for that 
operating system that includes both the QuickConnect app and the Onboard 
configuration settings. 

3. The QuickConnect app uses the Onboard provisioning workflow to authenticate the 
user and provision their device with the Onboard server. The device is configured 
with appropriate network settings and credentials that are unique to the device. 

4. After provisioning has completed, the app switches the device to PEAP 
authentication using the newly provisioned unique device credentials. Mutual 
authentication is performed (the authentication server verifies the client’s 
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username and password, and the client verifies the authentication server’s 
certificate). 

5. The device is now onboard and is able to securely access the network. 

The Onboard provisioning workflow is used to securely provision a device and configure it 
with network settings. Figure 10 shows a sequence diagram that explains the steps 
involved in this workflow. 

Figure 10 – Onboard provisioning workflow in the QuickConnect app 

 

Onboard Reference 

The settings in the Onboard user interface are documented in this section.  

 Configuring Provisioning Settings 

 Configuring Network Settings for Device Provisioning 

 Configuring an iOS Device VPN Connection 

 Configuring an iOS Device Email Account 
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 Configuring an iOS Device Passcode Policy 

 Resetting Onboard Certificates and Configuration 

 Advanced: Device Authentication during Provisioning 

 Configuring the User Interface for Device Provisioning 

 Configuring ClearPass Servers for Device Provisioning 

 Configuring the Certificate Authority 

 Uploading Certificates for the Certificate Authority 

 Creating a Certificate 

 Managing Certificates 

 Requesting a Certificate  

 Configuring Provisioning Settings 

 Configuring Network Settings for Device Provisioning 

 Configuring an iOS Device VPN Connection 

 Configuring an iOS Device Email Account 

 Configuring an iOS Device Passcode Policy 

 Resetting Onboard Certificates and Configuration 

 Advanced: Device Authentication during Provisioning 

Configuring the User Interface for Device Provisioning 

The user interface for device provisioning can be customized in three different ways: 

 Customizing the web login page used for device provisioning. 

All devices will reach the device provisioning web login page as the first step of the 
provisioning process. See “Customizing the device provisioning web login page”  to 
make changes to the content or formatting of this page. 

 Customizing the properties of the device provisioning profile for iOS and OS X 
devices. 
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After starting the provisioning process, users of iOS and OS X are prompted to 
accept a configuration profile. See “Provisioning settings for iOS and OS X”  to make 
changes to the content of this profile. 

 Customizing the user interface of the QuickConnect app for Windows, Mac OS X and 
Android devices. 

The provisioning process for Windows, Mac OS X and Android devices uses a 
separate app, which has a customizable user interface. See “Provisioning settings for 
Mac OS X, Windows and Android devices”  to make changes to the user interface. 

Customizing the device provisioning web login page 

Onboard creates a default web login page that is used to start the device provisioning 
process. 

To edit this page, navigate to Customization > Web Logins, select the 

device_provisioning page in the list, and then click  Edit. 

Refer to the RADIUS Web Logins documentation  for details about this form. The Onboard-
specific settings required for a device provisioning page are described below: 

 

Mark the Enable device provisioning checkbox to activate the Onboard features for this 
web login page. 

Note: If this checkbox is not marked, device provisioning will be inoperative. 

Select the appropriate Onboard configuration from the Configuration drop-down list. 

To modify the instructions provided to users on the device provisioning page, edit the 
contents of the Header HTML text area. 

The default instructions appear as: 
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This corresponds to the Header HTML: 

<p> 
Please configure security and network settings on your device to allow 
secure<br> 
access to the internal network. Please follow the instructions listed 
below:<br> 
<br> 
<strong>1.</strong>&nbsp;&nbsp;&nbsp;&nbsp;{nwa_iconlink icon="images/icon-
certificate22.png" text="Install root certificate (click 
here)"}{nwa_mdps_config name=root_cert}{/nwa_iconlink}<br> 
<strong>2.</strong>&nbsp;&nbsp;&nbsp;&nbsp;Login below using your 
{nwa_mdps_config name=organization_name} credentials<br> 
<strong>3.</strong>&nbsp;&nbsp;&nbsp;&nbsp;Install the certificate when 
prompted<br> 
<strong>4.</strong>&nbsp;&nbsp;&nbsp;&nbsp;Go to your Wi-Fi settings and 
connect to SSID: <strong>{nwa_mdps_config name=wifi_ssid}</strong> 
<br> 
</p> 

The {nwa_mdps_config} Template Function 

Certain properties can be extracted from the Onboard configuration and used in the device 
provisioning page. 

To obtain these properties, use the {nwa_mdps_config} Smarty template function. The 
“name” parameter specifies which property should be returned, as described in Table 4. 

Table 4 – Properties available for use with the {nwa_mdps_config} Smarty template function 

Name Description 

root_cert URL of the Onboard certificate authority’s root certificate. 

Browsing to this URL will install the root certificate on the device, 
which is required as part of the pre-provisioning step. 

Example: 
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Name Description 

<a href="{nwa_mdps_config name=root_cert}"> 
  Install Onboard root certificate 
</a> 

wifi_ssid Name of the wireless network. See “Configuring basic network 
access settings”.  

Example: 
Connect to the network named {nwa_mdps_config 
name=wifi_ssid} 

organization_name The organization name. See “Basic provisioning settings”. 

Example: 
<h2> 
  Welcome to {nwa_mdps_config name=organization_name} 
</h2>  

Configuring ClearPass Servers for Device Provisioning 

Navigate to Administrator > Network Setup > ClearPass, or click the ClearPass command 
link to display the Manage ClearPass Servers form. 

 

The first part of the form is used to specify the connection details for the ClearPass Policy 
Manager. 

Mark the Send device information to ClearPass Policy Manager checkbox when you will 
use Policy Manager as the authentication server for devices provisioned with Onboard. 

Specify the hostname or IP address of the Policy Manager publisher node in the Host text 
field. 

You must provide a valid username and password for the Policy Manager. This account 
should have “Super Administrator” privileges. 

Note: Onboard requires only the ability to create guest user accounts, Onboard accounts, 
and endpoint records. No other configuration changes are made using these credentials. 
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The second part of the form specifies options for ClearPass Profiler. 

Mark the Send device information to ClearPass Profiler checkbox when you will use 
Profiler to collect device information. 

Select the events of interest in the Profiling Events checklist: 

 When client requests a guest-facing page – Device information is sent to Profiler 
as soon as a guest-facing page (such as a web login page, guest self-registration 
page, or device provisioning captive portal page) is requested. 

Note: Selecting this option may collect information about devices that are not 
actively using the network, i.e. devices that are not logged in. 

 When client registers a guest account – Device information is sent to Profiler 
when a guest self-registration form is completed and a guest account is created or 
updated. 
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 When client submits a web login form – Device information is sent to Profiler 
when a web login form is submitted, indicating a login attempt has been made. 

 When client provisions a device – Device information is sent to Profiler when a 
valid device provisioning request has been received. 

The Profiling Interval text field may be used to limit the rate of repeated updates for the 
same client. This option can be used to reduce the load on the Profiler server, especially if 
the “When client requests a guest-facing page” profiling event is enabled. 

A primary Profiler server must be configured. Specify the hostname or IP address of the 
Profiler server in the Host text field. You must also provide a valid username and password 
for the Profiler. 

A secondary Profiler server may also be configured. This server will be used if the primary 
Profiler server is unreachable. 

Click the  Save Changes button to apply the new configuration settings. 

Configuring the Certificate Authority  

Navigate to Onboard > Certificate Authority Settings, or click the Certificate 
Authority Settings command link to display the Certificate Authority Settings form. 

 

This page is used to configure the Onboard certificate authority and to perform 
maintenance tasks for the CA. 

 Set up a root or intermediate certificate authority (see “Setting up the certificate 
authority”) 

 Determine the OCSP URL for the certificate authority 

 View the trust chain for the certificate authority (see “Viewing the certificate 
authority’s trust chain”) 

 Renew the certificate authority’s certificate (see “Renewing the certificate 
authority’s certificate”) 

 Configure the data retention policy applied to certificates issued by the authority 
(see “Configuring data retention policy for certificates”)  
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Setting up the certificate authority 

The Certificate Authority Settings form is used to set up the mode of operation for the 
certificate authority. 

 

The Name and Description fields are used internally to identify this certificate authority 
for the network administrator. These values are never displayed to the user during device 
provisioning. 

Anexo 10 ITEM 01 (0592522)         SEI 0008478-63.2018.6.02.8000 / pg. 2974



ClearPass Onboard  Deployment Guide 

Aruba Networks 34 

Select the appropriate mode for the certificate authority: 

 Root CA – The Onboard certificate authority issues its own root certificate. The 
certificate authority issues client and server certificates using a local signing 
certificate, which is an intermediate CA that is subordinate to the root certificate. 

Use this option when you do not have an existing public-key infrastructure (PKI), or 
if you want to completely separate the certificates issued for Onboard devices from 
your existing PKI. 

Click the  Continue button to proceed to the second step. See “Setting up a root 
certificate authority”. 

 Intermediate CA – The Onboard certificate authority is issued a certificate by an 
external certificate authority. The Onboard certificate authority issues client and 
server certificates using this certificate. 

Use this option when you already have a public-key infrastructure (PKI), and would 
like to include the certificate issued for Onboard devices in that infrastructure. 

Click the  Continue button to proceed to the second step. See “Setting up an 
intermediate certificate authority”. 

Setting up a root certificate authority 

If you already have a certificate and private key for the certificate authority, see “Installing 
a certificate authority’s certificate”. 

The Root Certificate Settings form is used to configure the distinguished name and 
properties for the certificate authority’s root (self-signed) certificate. 

Note: If you intend to change any of the root certificate’s distinguished name properties, 
and you have previously created any client or server certificates or performed device 
provisioning using the existing root certificate, these certificates will be invalidated and 
deleted as the root certificate’s distinguished name has changed. 

To avoid the complication of revoking and reissuing certificates, it is recommended that 
you configure the certificate authority before any device provisioning or other 
configuration is done. 
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In the Identity section of the form: 

 Enter values in the Country, State, Locality, Organization and Organizational 
Unit text fields that correspond to your organization. These values form part of the 
distinguished name for the root certificate. 

 Enter a descriptive name for the root certificate in the Common Name text field. 
This value will be used to identify the root certificate as the issuer of other 
certificates, notably the signing certificate. 
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 Enter a descriptive name for the signing certificate in the Signing Common Name 
text field. This value will be used to identify the signing certificate as the issuer of 
client and server certificates from this certificate authority. 

The other identity information in the signing certificate will be the same as for the 
root certificate. 

 Enter a contact email address in the Email Address text field. This email address 
will be included in the root and signing certificates, and provides a way for users of 
the certificate authority to contact your organization. 

In the Private Key section: 

 Mark the Generate a new private key checkbox to create a new private key for the 
root certificate. This is only necessary if you are recreating the entire certificate 
authority from the beginning. 

Note: If you have previously created any client or server certificates or performed 
device provisioning using the existing root certificate, these certificates will be 
invalidated when changing the root certificate’s private key. 

 The Key Type drop-down list specifies the type of private key that should be 
created for the certificate. You can select one of these options: 

o 1024-bit RSA – not recommended for a root certificate 

o 2048-bit RSA – recommended for general use 

o 4096-bit RSA – higher security 

In the Self-Signed Certificate section: 

 Use the CA Expiration field to specify the lifetime of the root certificate in days. The 
default value of 3653 days is a 10-year lifetime. 

 The Clock Skew Allowance field adds a small amount of time to the start and end of 
the root certificate’s validity period. This permits a newly issued certificate to be 
recognized as valid in a network where not all devices are perfectly synchronized. 

 The Digest Algorithm drop-down list allows you to specify which hash algorithm 
should be used. 

Note: MD5 is not recommended for use with root certificates. 

Mark the Generate CA certificate and invalidate all other certificates checkbox to 
confirm the changes. 
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Click the  Create Root Certificate button to save the settings and generate a new root 
certificate. 

Setting up an intermediate certificate authority 

The Intermediate Certificate Settings form is used to configure the distinguished name and 
properties for the certificate authority’s certificate, which will be issued by an external 
certificate authority. 

Note: If you intend to change any of the intermediate certificate’s distinguished name 
properties, and you have previously created any client or server certificates or performed 
device provisioning using the existing intermediate certificate, these certificates will be 
invalidated as the intermediate certificate’s distinguished name has changed. 

In this case, you should use the Reset to Factory Defaults form (see “Resetting Onboard 
Certificates and Configuration”) to delete all client certificates and re-provision all devices. 
You will also need to reissue any server or subordinate CA certificates. 

To avoid the complication of revoking and reissuing certificates, it is recommended that 
you configure the certificate authority before any device provisioning or other 
configuration is done. 
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In the Identity section of the form: 

 Enter values in the Country, State, Locality, Organization and Organizational 
Unit text fields that correspond to your organization. These values form part of the 
distinguished name for the certificate authority. 

 Enter a descriptive name for the certificate authority in the Common Name text 
field. This value will be used to identify the intermediate certificate as the issuer of 
client and server certificates from this certificate authority. 

 Enter a contact email address in the Email Address text field. This email address 
will be included in the certificate authority’s certificate, and provides a way for 
users of the certificate authority to contact your organization. 
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In the Private Key section: 

 Mark the Generate a new private key checkbox to create a new private key for the 
intermediate certificate. This is only necessary if you are recreating the entire 
certificate authority from the beginning. 

Note: If you have previously created any client or server certificates or performed 
device provisioning using the existing intermediate CA certificate, these certificates 
will be invalidated when changing the intermediate CA’s private key. 

 The Key Type drop-down list specifies the type of private key that should be 
created for the certificate. You can select one of these options: 

o 1024-bit RSA – not recommended for a certificate authority 

o 2048-bit RSA – recommended for general use 

o 4096-bit RSA – higher security 

In the Intermediate Certificate section: 

 The Digest Algorithm drop-down list allows you to specify which hash algorithm 
should be used. 

Note: MD5 is not recommended for use with certificate authority certificates. 

Mark the Generate CA certificate request and invalidate all other certificates checkbox 
to confirm the changes. 

Click the  Create Certificate Request button to save the settings and generate a new 
certificate signing request. 

Obtaining a certificate for the certificate authority 

The Intermediate Certificate Request page displays the certificate signing request for the 
certificate authority’s intermediate certificate. 

This page is also used to renew the certificate authority’s intermediate certificate when it is 
close to expiring. 

You can copy the certificate signing request in text format using your Web browser. Use 
this option when you can paste the request directly into another application to obtain a 
certificate. 

You can click the  Download the current CSR link to download the certificate signing 
request as a file. Use this option when you need to provide the certificate signing request as 
a file to obtain a certificate. 
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Once you have obtained the certificate, click the  Install a signed certificate link to 
continue configuring the intermediate certificate authority. See “Installing a certificate 
authority’s certificate”. 

You can also click the  Change CA settings link to return to the main Certificate 
Authority Settings form. Use this option to switch to a root CA, or to change the name or 
properties of the intermediate CA and reissue the certificate signing request. 

Using Microsoft Active Directory Certificate Services 

Navigate to the Microsoft Active Directory Certificate Services web page. This page is 
typically found at https://yourdomain/certsrv/. 

The Welcome page is displayed. 

 

Click the Request a Certificate link on this page. The Request a Certificate page is 
displayed. 
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Click the link to submit an advanced certificate request. The Submit a Certificate Request or 
Renewal Request page is displayed. 

 

Copy and paste the certificate signing request text into the Saved Request text field. 

Because this certificate is for a certificate authority, select the “Subordinate Certificate 
Authority” in the Certificate Template drop-down list. 

Click the Submit button to issue the certificate. The Certificate Issued page is displayed. 

 

Select the Base 64 encoded option and then click the Download certificate chain link. 

A file containing the intermediate certificate and the issuing certificates in the trust chain 
will be downloaded. 
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Refer to the instructions in “Installing a certificate authority’s certificate” for information 
on uploading this certificate file. 

Installing a certificate authority’s certificate 

The CA Certificate Import page may be used to: 

 Upload a certificate that has been issued by another certificate authority. This 
process is required when configuring an intermediate certificate authority. 

o A private key is not required, as the certificate authority has already 
generated one and used it to create the certificate signing request. 

 Upload a certificate and private key to be used as the certificate authority’s 
certificate. This process may be used to configure a root certificate authority. 

o A private key is required, as the certificate authority’s existing private key 
will be replaced. 

Note: This form may be used multiple times, to import each of the certificates in the trust 
chain. Check the message displayed above the form to determine which certificate or type 
of file must be uploaded next. 

In the Step 1 section of the form, select one of the following options in the Format radio 
buttons: 

 Copy and paste certificate as text – Step 2 is displayed on the CA Certificate 
Import form. 

 

To upload a single certificate, copy and paste the certificate into the Certificate text 
field. The text must include the “BEGIN CERTIFICATE” and “END CERTIFICATE” 
lines. Leave the passphrase fields blank. 
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To upload a certificate and private key, copy and paste the certificate and private 
key into the Certificate text field. The text must include the “BEGIN CERTIFICATE” 
and “END CERTIFICATE” lines, as well as the “BEGIN RSA PRIVATE KEY” and “END 
RSA PRIVATE KEY” lines. 

 Upload certificate file – Step 2 and Step 3 are displayed on the CA Certificate 
Import form. 

 

Choose the file to upload in the Certificate field. 

To upload a single certificate, choose a certificate file in PEM (base-64 encoded) or 
binary format (.crt or PKCS#7). Leave the passphrase fields blank. 

To upload a certificate’s private key as a separate file, choose the private key file in 
PEM (base-64 encoded) format. If the private key has a passphrase, enter it in the 
Private Key Passphrase and Confirm Passphrase fields. The private key will be 
automatically matched to its corresponding certificate when uploaded. 

To upload a combined certificate and private key, choose a file in either PEM (base-
64 encoded) or PKCS#12 format. If the private key has a passphrase, enter it in the 
Private Key Passphrase and Confirm Passphrase fields. 

Click the  Upload Certificate button to save your changes.  

 If additional certificates are required, you will remain at the same page. Check the 
message displayed above the form to determine which certificate or type of file 
must be uploaded next. 

 When the trust chain is complete, it will be displayed. This completes the 
initialization of the certificate authority. 

Anexo 10 ITEM 01 (0592522)         SEI 0008478-63.2018.6.02.8000 / pg. 2984



ClearPass Onboard  Deployment Guide 

Aruba Networks 44 

Renewing the certificate authority’s certificate 

When a root certificate is close to expiration, it must be renewed. 

Navigate to Onboard > Certificate Authority Settings and click the Renew Root 
Certificate link. The Root Certificate Renewal form is displayed. 

 

Select an option in the Renewal Type drop-down list: 

 Basic Renewal – Uses the same private key for the root certificate, but reissues the 
root CA certificate with an updated validity period. Use this option to maintain the 
validity of all certificates issued by the CA.  

 Replacement Renewal – Generates a new private key for the root certificate, and 
reissues the root CA certificate with an updated validity period. Use this option if the 
root certificate has been compromised, or if you want to invalidate all certificate 
that were previously issued by the CA. 

Whether you renew or replace the root certificate, you should distribute a new copy of the 
root certificate to all users of that certificate. 

Click the  Renew Root Certificate button to perform the renewal action. 

Configuring data retention policy for certificates 

The data retention policy for certificates and certificate requests can be configured by 

navigating to Onboard > Certificate Authority Settings and clicking the  Configure 
data retention link. 

The Manage Data Retention form is displayed. 
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In the Mobile Device Certificates section of the form, specify a value in the Minimum 
Period and Maximum Period fields that is appropriate for your organization’s retention 
policy. 

Note: Use a blank value for Minimum Period to enable the  Delete Certificate and  
Delete Request actions in the Certificate Management list view. This is useful for testing 
and initial deployment. 

The default data retention policy specifies the values: 

 Minimum Period of 12 weeks 

 Maximum Period of 52 weeks 

Uploading Certificates for the Certificate Authority 

This page is used to view the certificate authority’s current trust chain, or to upload a new 
certificate in the trust chain when configuring a certificate authority. 

Viewing the certificate authority’s trust chain 

Navigate to Onboard > Certificate Authority Settings and click the View CA Certificate 
link. 

The Certificate Authority Trust Chain page is displayed. This page shows a graphical 
representation of the certificates that make up the trust chain. 

 

The first certificate listed is the root certificate. Root certificates are always self-signed and 
are explicitly trusted by clients. 

Each additional certificate shown is an intermediate certificate. The last certificate in the 
list is the signing certificate that is used to issue client and server certificates. 

Click the  Show certificate link to view the properties of a certificate in the trust chain. 

Creating a Certificate 

From the Certificate Management page, click the  Generate a new certificate signing 
request link to access the Certificate Request form. 
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To create a new certificate or certificate signing request, first select the type of certificate 
you want to create from the Certificate Type drop-down list: 

 TLS Client Certificate – Use this option when the certificate is to be issued to a 
client, such as a user or a user’s device. 

o When this option is selected, the issued certificate’s extended key usage 
property will contain a value of “Client Auth”, indicating that the certificate 
may be used to identify a client. 

 TLS Server Certificate – Use this option when the certificate is to be issued to a 
network server, such as a Web server or as the EAP-TLS authentication server. 

o When this option is selected, the issued certificate’s extended key usage 
property will contain a value of “Server Auth”, indicating that the certificate 
may be used to identify a server. 

 Certificate Authority – Use this option when the certificate is for an subordinate 
certificate authority. 

o When this option is selected, the issued certificate will contain an extension 
identifying it as an intermediate certificate authority, and the extended key 
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usage property will contain the three values “Client Auth”, “Server Auth” and 
“OCSP Signing”. 

Specifying the identity of the certificate subject 

In the first part of the form, provide the identity of the person or device for which the 
certificate is to be issued (the “subject” of the certificate). Together, these fields are 
collectively known as a distinguished name, or “DN”. 

 Country 

 State 

 Locality 

 Organization 

 Organizational Unit 

 Common Name – this is the primary name used to identify the certificate 

 Email Address 

The Key Type drop-down list specifies the type of private key that should be created for 
the certificate. You can select one of these options: 

 1024-bit RSA – lower security 

 2048-bit RSA – recommended for general use 

 4096-bit RSA – higher security 

Note: Using a private key containing more bits will increase security, but will also increase 
the processing time required to create the certificate and authenticate the device. The 
additional processing required will also affect the battery life of a mobile device. It is 
recommended to use the smallest private key size that is feasible for your organization. 
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If you have selected TLS Client as the certificate type, the Subject Alternative Name section 
is also shown. The alternative name can be used to specify additional identification details 
for the certificate’s subject. If one or more of these options are provided, the issued 
certificate will contain a subjectAltName extension with the specified values. 

Table 5 explains the fields that may be included as part of the subject alternative name. 

Table 5 – Subject alternative name fields supported when creating a TLS client certificate 
signing request 

Name Description 

Device Type Type of device, such as “iOS”, “Android”, etc. 

Device UDID Unique device identifier (UDID) for this device. This is typically a 64-
bit, 128-bit or 160-bit number represented in hexadecimal (16, 32 or 
40 characters, respectively). 

Device IMEI International Mobile Equipment Identity (IMEI) number allocated to 
this device.  

Device ICCID Integrated Circuit Card Identifier (ICCID) number from the Subscriber 
Identity Module (SIM) card present in the device. 

Device Serial Serial number of the device. 

MAC Address IEEE MAC address of this device. 

Product Name Product string identifying the device and often including the hardware 
version information. 

Product Version Software version number for the device. 
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Name Description 

User Name Username of the user who provisioned the device. 

Issuing the certificate request 

Mark the Issue this certificate immediately checkbox to automatically create the 
certificate. 

Click the  Create Certificate Request button to save your changes. 

 If the “Issue this certificate immediately” checkbox is marked, the certificate will be 
issued immediately and will be displayed in the Certificate Management list view. 

 If the “Issue this certificate immediately” checkbox is not marked, the certificate 
request will be displayed in the Certificate Management list view. The certificate can 
then be issued or rejected at a later time. 

Managing Certificates 

Navigate to Onboard > Certificate Management, or click the Certificate 
Management command link to display the list of certificates. 

 

This list view displays all of the certificates and certificate requests in the Onboard system. 
Table 6 lists the types of certificate that are displayed in this list. 

Table 6 – Types of certificate supported by Onboard Certificate Management 

Certificate Type “Type” Column Notes 

 Root certificate ca Self-signed certificate for the 
certificate authority 

 Intermediate certificate ca Issued by the root CA or another 
intermediate CA 

 Profile signing 
certificate 

profile-signing Issued by the certificate authority 

 Certificate signing 
request 

tls-client or tls-server The type shown depends on the 
kind of certificate requested 

 Rejected certificate tls-client or tls-server Certificate request that was rejected 
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Certificate Type “Type” Column Notes 

signing request due to an administrator decision 

 Device certificate scep-client Issued to iOS and OS X (10.7+) 
devices only 

 Client certificate tls-client Identity certificate issued to a 
specific user’s device 

 Server certificate tls-server Identity certificate issued to a 
server 

 Revoked certificate – Certificate that has been 
administratively revoked and is no 
longer valid 

 Expired certificate – Certificate that is outside its validity 
period and is no longer valid 

Searching for certificates 

The Filter field can be used to quickly search for a matching certificate. Type a username 
into this field to locate all certificates matching that username quickly. 

The filter is applied to all columns displayed in the list view. To search by another field, 

such as MAC address, device type, or device serial number, click the  Columns tab, select 

the appropriate column(s), and then click the  Save and Reload button. The list view 
will refresh to update the results of the filter. 

Click the  Clear Filter link to restore the default view. 

Use the paging control at the bottom of the list to jump forwards or backwards by one page, 
or to the first or last page of the list.  You can also click an individual page number to jump 
directly to that page. 

Note: When the list contains many thousands of certificates, consider using the Filter field 
to speed up finding a specific certificate. 

Click the column headers to sort the list view by that column. Click the column header a 
second time to reverse the direction of the sort. 

Working with certificates 

Click on a certificate to select it. You can then select from one of these actions: 

  View certificate – Displays the properties of the certificate. Click the  Cancel 
button to close the certificate properties. 
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  Export certificate – Displays the Export Certificate form. 

 

Use the Format drop-down list to select the format in which the certificate should 
be exported. The following formats are supported: 

o PKCS#7 Certificates (.p7b) – Exports the certificate, and optionally the 
other certificates forming the trust chain for the certificate, as a PKCS#7 
container. 

o Base-64 Encoded (.pem) – Exports the certificate as a base-64 encoded text 
file. This is also known as “PEM format”.  

o Binary Certificate (.crt) – Exports the certificate as a binary file. This is also 
known as “DER format”. 

o PKCS#12 Certificate & Key (.p12) – Exports the certificate and its 
associated private key, and optionally any other certificates required to 
establish the trust chain for the certificate, as a PKCS#12 container. This 
option is only available if the private key for the certificate is available to the 
server. 

If you selected the PKCS#12 format, you must enter a passphrase to protect the 
private key stored in the file. 

Note: To protect against brute-force password attacks and ensure the security of 
the private key, you should use a strong passphrase – one consisting of several 
words, mixed upper- and lower-case letters, and punctuation or other symbol 
characters. 

Click the  Export Certificate button to download the certificate file in the 
selected format. 

  Revoke certificate – Displays the Revoke Certificate form. 
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Mark the Revoke this client certificate checkbox to confirm that the certificate 

should be revoked, and then click the  Revoke Certificate button. 

Once the certificate has been revoked, future checks of the certificate’s validity using 
OCSP or CRL will indicate that the certificate is no longer valid. 

Note: Due to the way in which certificate revocation lists work, a certificate cannot 
be un-revoked. A new certificate must be issued if a certificate is revoked in error. 

Note: Revoking a device’s certificate will also prevent the device from being re-
provisioned. This is necessary to prevent the user from simply re-provisioning and 
obtaining a new certificate. To re-provision the device, the revoked certificate must 
be deleted. 

  Delete certificate – Removes the certificate from the list. This option is only 
available if the data retention policy is configured to permit the certificate’s deletion. 
See “Configuring data retention policy for certificates”. 
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The Delete Certificate form is displayed. Mark the Delete this client certificate 

checkbox to confirm the certificate’s deletion, and then click the  Delete 
Certificate button. 

Working with certificate signing requests 

Certificate signing requests can be managed through the Certificate Management list view. 
This allows for server certificates, subordinate certificate authorities, and other client 
certificates not associated with a device to be issued by the Onboard certificate authority. 

Click on a certificate request to select it. You can then select from one of these actions: 

  View request – Displays the properties of the certificate request. Click the  
Cancel button to close the certificate request properties. 

  Export request – Displays the Export Certificate Request form. 
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Use the Format drop-down list to select the format in which the certificate signing 
request should be exported. The following formats are supported: 

o PKCS#10 Certificate Request (.p10) – Exports the certificate signing 
request in binary format. 

o Base-64 Encoded (.pem) – Exports the certificate signing request as a base-
64 encoded text file. This is also known as “PEM format”.  

Click the  Export Request button to download the certificate signing request file 
in the selected format. 

  Sign request – Displays the Sign Request form. Use this action to approve the 
request for a certificate and issue the certificate.  

 

Use the Expiration text field to specify how long the issued certificate should 
remain valid. 

Mark the Sign this request checkbox to confirm that the certificate should be 

issued, and then click the  Sign Request button. The certificate will be issued and 
will then replace the certificate signing request in the list view. 

  Reject request – Displays the Reject Request form. Use this action to reject the 
request for a certificate. Rejected requests are automatically deleted according to 
the data retention policy. 
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Mark the Reject this request checkbox to confirm that the certificate signing 

request should be rejected, and then click the  Reject Request button. 

  Delete request – Removes the certificate signing request from the list. This 
option is only available if the data retention policy is configured to permit the 
certificate signing requests’s deletion. See “Configuring data retention policy for 
certificates”. 

 

The Delete Request form is displayed. Mark the Delete this request checkbox to 

confirm the certificate signing request’s deletion, and then click the  Delete 
Request button. 
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Requesting a Certificate 

From the Certificate Management page, click the  Upload a certificate signing request 
link to access the Certificate Signing Request form. 

Providing a certificate signing request in text format 

If you have a certificate signing request in text format, click the Copy and paste certificate 
signing request as text radio button. 

 

Paste the text into the Certificate Signing Request text field. Be sure to include the 
complete block of text, including the beginning and ending lines. 

A complete certificate signing request looks like the following: 

-----BEGIN CERTIFICATE REQUEST----- 
MIIB7DCCAVUCAQAwgasxCzAJBgNVBAYTAlVTMRMwEQYDVQQIEwpDYWxpZm9ybmlh 
MRIwEAYDVQQHEwlTdW5ueXZhbGUxFzAVBgNVBAoTDkFDTUUgU3Byb2NrZXRzMRkw 
FwYDVQQLExBWaXNpdG9yIFNlcnZpY2VzMR4wHAYDVQQDExVBdXRoZW50aWNhdGlv 
biBTZXJ2ZXIxHzAdBgkqhkiG9w0BCQEWEGluZm9AZXhhbXBsZS5jb20wgZ8wDQYJ 
KoZIhvcNAQEBBQADgY0AMIGJAoGBALR4wRSH26wlcf3OEPEIh34iXRQIUrnYnDfo 
+ZezeB/i4NZUhRvLMvhPW7DcLpiZJ17ILj3aPPUXWDBYYiiuOkmuFX3dG7eKCLMH 
Z4E9z1ozK5Znm8cWIj56kg69le7QrAZBYrd5QaBTMxEe0F9CGFsYbFx1viMUMxN6 
EJILaCTBAgMBAAGgADANBgkqhkiG9w0BAQUFAAOBgQB8/So9KU5BS3oxjyxftIwF 
dWvNP2CNruKyQaba5RQ1ixdHAsPE+3uYIHNvlqqIpSzBlfYkr21S4DdR3SSC3bXy 
t4l/fyMuC1cEG/RpPSxdDALpeT8MuoGV1JonKo2BDitOEd4y5SXGmHmDBHrPW2Nd 
gthkrtBb/a2WAkNcRfDuiQ== 
-----END CERTIFICATE REQUEST----- 
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Providing a certificate signing request file 

Alternatively, if you have the certificate signing request as a file, click the Upload 
certificate signing request file radio button. 

 

Use the Certificate Signing Request field to select the appropriate file for upload. 

Note: The file should be a base-64 encoded (PEM format) PKCS#10 certificate signing 
request. 

Specifying certificate properties 

Select the type of certificate from the Certificate Type drop-down list. Choose from one of 
the following options: 

 TLS Client Certificate – Use this option when the certificate is to be issued to a 
client, such as a user or a user’s device. 

o When this option is selected, the issued certificate’s extended key usage 
property will contain a value of “Client Auth”, indicating that the certificate 
may be used to identify a client. 

 TLS Server Certificate – Use this option when the certificate is to be issued to a 
network server, such as a Web server or as the EAP-TLS authentication server. 

o When this option is selected, the issued certificate’s extended key usage 
property will contain a value of “Server Auth”, indicating that the certificate 
may be used to identify a server. 

 Certificate Authority – Use this option when the certificate is for an subordinate 
certificate authority. 
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o When this option is selected, the issued certificate will contain an extension 
identifying it as an intermediate certificate authority, and the extended key 
usage property will contain the three values “Client Auth”, “Server Auth” and 
“OCSP Signing”. 

Mark the Issue this certificate immediately checkbox to automatically issue the 
certificate. 

Click the  Submit Certificate Signing Request button to save your changes. 

 If the “Issue this certificate immediately” checkbox is marked, the certificate will be 
issued immediately and will be displayed in the Certificate Management list view. 

 If the “Issue this certificate immediately” checkbox is not marked, the certificate 
request will be displayed in the Certificate Management list view. The certificate can 
then be issued or rejected at a later time. 

Configuring Provisioning Settings 

Navigate to Onboard > Provisioning Settings, or click the Provisioning Settings 
command link to display the Onboard Device Provisioning Settings page. 

 

This page is used to configure the settings for ClearPass Onboard device provisioning, 
including: 

 The organization name displayed during device provisioning 

 Properties for the certificates issued to devices when they are provisioned 

 Which operating systems should be supported 

 Authorization properties – the number of devices that a user may provision 

Basic provisioning settings 

The first part of the form is used to specify basic information about the Onboard 
provisioning. 

Anexo 10 ITEM 01 (0592522)         SEI 0008478-63.2018.6.02.8000 / pg. 2999



ClearPass Onboard  Deployment Guide 

Aruba Networks 59 

 

The Name and Description fields are used internally to identify this set of Onboard 
settings for the network administrator. These values are never displayed to the user during 
device provisioning. 

Use the Organization field to provide the name of your organization; this will be displayed 
to the user during the device provisioning process. 

Certificate properties for device provisioning 

The second part of the form is used to specify the properties for certificates issued to 
devices. 

 

The Certificate Authority drop-down list can be used to select a different certificate 
authority. By default, there is only a single certificate authority. 

Use the Validity Period text field to specify the maximum length of time for which a client 
certificate issued during device provisioning will remain valid. 
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The Clock Skew Allowance text field adds a small amount of time to the start and end of 
the client certificate’s validity period. This permits a newly issued certificate to be 
recognized as valid in a network where not all devices are perfectly synchronized. 

For example, if the current time is 12:00, and the clock skew allowance is set to the default 
value of 15 minutes, then the client certificate will be issued with a “not valid before” time 
of 11:45. In this case, if the authentication server that receives the client certificate has a 
time of 11:58, it will still recognize the certificate as valid. If the clock skew allowance was 
set to 0 minutes, then the authentication server would not recognize the certificate as valid 
until its clock has reached 12:00. 

The default of 15 minutes is reasonable. If you expect that all devices on the network will 
be synchronized then the value may be reduced. A setting of 0 minutes is not recommended 
as this does not permit any variance in clocks between devices. 

When issuing a certificate, the certificate’s validity period is determined as follows: 

 The “not valid before” time is set to the current time, less the clock skew allowance. 

 The “not valid after” time is first calculated as the earliest of the following: 

o The current time, plus the maximum validity period. 

o The expiration time of the user account for whom the device certificate is 
being issued. 

 The “not valid after” time is then increased by the clock skew allowance. 

The Key Type drop-down list specifies the type of private key that should be created when 
issuing a new certificate. You can select one of these options: 

 1024-bit RSA – lower security 

 2048-bit RSA – recommended for general use 

 4096-bit RSA – higher security 

Note: Using a private key containing more bits will increase security, but will also increase 
the processing time required to create the certificate and authenticate the device. The 
additional processing required will also affect the battery life of a mobile device. It is 
recommended to use the smallest private key size that is feasible for your organization. 

Mark the Include device information in TLS client certificates checkbox to include 
additional fields in the TLS client certificate issued for a device. These fields are stored in 
the subject alternative name (subjectAltName) of the certificate. Refer to Table 7 for a list 
of the fields that are stored in the certificate when this option is enabled. 
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Storing additional device information in the client certificate allows for additional 
authorization checks to be performed during device authentication.  

Note: If you are using an Aruba Controller to perform EAP-TLS authentication using these 
client certificates, you must have Aruba OS 6.1 or later to enable this option.  

Table 7 – Device information stored in TLS client certificates 

Name Description OID 1 

Device ICCID Integrated Circuit Card Identifier (ICCID) 
number from the Subscriber Identity 
Module (SIM) card present in the device. 
This is only available for devices with 
GSM (cellular network) capability, where 
a SIM card has been installed. 

mdpsDeviceIccid (.4) 

Device IMEI International Mobile Equipment Identity 
(IMEI) number allocated to this device. 
This is only available for devices with 
GSM (cellular network) capability. 

mdpsDeviceImei (.3) 

Device Serial Serial number of the device. mdpsDeviceSerial (.9) 

Device Type Type of device, such as “iOS”, “Android”, 
etc. 

mdpsDeviceType (.1) 

Device UDID Unique device identifier (UDID) for this 
device. This is typically a 64-bit, 128-bit 
or 160-bit number represented in 
hexadecimal (16, 32 or 40 characters, 
respectively). 

mdpsDeviceUdid (.2) 

MAC Address IEEE MAC address of this device. This 
element may be present multiple times, if 
a device has more than one MAC address 
(for example, an Ethernet port and a Wi-
Fi adapter). 

mdpsMacAddress (.5) 

Product Name Product string identifying the device and 
often including the hardware version 
information. 

mdpsProductName (.6) 

Product Version String containing the software version 
number for the device. 

mdpsProductVersion (.7) 

User Name String containing the username of the 
user who provisioned the device. 

mdpsUserName (.8) 

Note 1:  Object Identifier. These OIDs are relative to the ClearPass Guest base OID, which is 
1.3.6.1.4.1.14823.1.5.1. 
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Specify one of the following options in the Authority Info Access drop-down list to control 
automatic certificate revocation checks: 

 Do not include OCSP responder URL – The Authority Info Access extension is not 
included in the client certificate. Certificate revocation checking must be configured 
manually on the authentication server. This is the default option. 

 Include OCSP responder URL – The Authority Info Access extension is added to the 
client certificates, with the OCSP responder URL set to a predetermined value. This 
value is displayed as the “OCSP URL”.  

 Specify an OCSP responder URL – The Authority Info Access extension is added to 
the client certificates, with the OCSP responder URL set to a value defined by the 
administrator. This value may be specified in the “OCSP URL” field. 

Provisioning settings for iOS and OS X 

The third part of the form is used to specify provisioning settings related to iOS devices. 

 

Mark the Enable iOS and OS X 10.7+ (Lion or later) device provisioning checkbox to 
enable provisioning for these devices. 
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Mark the Enable device authentication checkbox to enable an additional authorization 
step to be performed during device provisioning. See “Advanced: Device Authentication 
during Provisioning” for details about this process. 

Use the Display Name and Profile Description text fields to control the user interface 
displayed during device provisioning. 

 

Select one of the following options in the Profile Security drop-down list to control how a 
device provisioning profile may be removed: 

 Always allow removal – The user may remove the device provisioning profile at 
any time, which will also remove the associated device configuration and unique 
device credentials. 

 Remove only with authorization – The user may remove the device provisioning 
profile if they also provide a password. The administrator must specify the 
password in the “Removal Password” and “Confirm Removal Password” fields. 

 Never allow removal – The user cannot remove the device provisioning profile. 
This option should be used with caution, as the only way to remove the profile is to 
reset the device to factory defaults, and destroy all data on the device. 

Use the Profile Signing text field to specify the display name of the certificate used to sign 
the configuration profile. This certificate will be automatically created by the certificate 
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authority, and appears as the “Signed” field on the device when the user authorizes the 
device provisioning. 

Mark the Change the profile ID checkbox to change the unique value associated with the 
configuration profile. This value is used to identify the configuration settings as being from 
a particular source, and should be globally unique. 

When an iOS device receives a new configuration profile that has the same profile ID as an 
existing profile, the existing profile will be replaced with the new profile. 

Note: Changing the profile ID will affect any device that has already been provisioned with 
the existing profile ID. The default value is automatically generated and is globally unique. 
You should only change this value during initial configuration of device provisioning. 

Provisioning settings for Mac OS X, Windows and Android devices 

The fourth part of the form is used to specify provisioning settings related to Onboard-
capable devices. 

 

Mark the appropriate checkboxes here to enable device provisioning on the respective 
platforms: 

 Enable OS X 10.5 (Leopard) and 10.6 (Snow Leopard) device provisioning 

 Enable Windows XP, Vista and 7 (or later) device provisioning 

 Enable Android device provisioning 
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Select one of the options in the Provisioning Address drop-down list to control where a 
device is directed to during provisioning: 

 The system’s hostname (requires DNS resolution) – Select this option to use the 
system hostname for device provisioning. 

Note that this option requires that the device be able to resolve the listed hostname 
at the time the device is provisioned. 

 The system’s IP address (network adapter name) – Select this option to use the 
IP address of the system for device provisioning. The drop-down list includes one 
option for each of the IP addresses detected on the system. 

Use this option when DNS resolution of the system’s hostname is not available for 
devices that are in a provisioning role. 

 Other IP address or hostname… – Select this option to override the hostname or 
IP address to be specified during device provisioning.  The administrator must enter 
the hostname or IP address in the “Address” text field. 

Use this option when special DNS or NAT conditions apply to devices that are in a 
provisioning role. 

The Provisioning Access warning message is displayed when HTTPS is not required for 
guest access. HTTPS is recommended for all deployments as it secures the unique device 
credentials that will be issued to the device. 

Note: When using HTTPS for device provisioning, you must obtain a commercial SSL 
certificate. Self-signed SSL certificates, and SSL server certificates that have been issued by 
an untrusted or unknown root certificate authority, will cause iOS device provisioning to 
fail with the message “The server certificate for … is invalid”. 
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The Validate Certificate drop-down list is used to specify whether the SSL server’s 
certificate should be validated as trusted. When this option is set to “Yes, validate this web 
server’s certificate (recommended)”, a certificate validation failure on the client device will 
cause device provisioning to fail. This is the default option. 

You should change this option to “No, do not validate this web server’s certificate” only 
during testing, or if you are waiting for a commercial SSL certificate. 

User interface options for Mac OS X, Windows and Android devices 

The Device Provisioning section of the form allows you to customize the user interface 
displayed by the QuickConnect app. 

 

To display your enterprise’s logo, select an image from the list in the Logo Image field. 
Navigate to Administrator > Content Manager to upload new images for use as the logo. 

The native size of the logo used in the QuickConnect client is 188 pixels wide, 53 pixels 
high. You may use an image of a different size and it will be scaled to fit, but for the best 
quality results it is recommended that you provide an image that is already the correct size. 

The Wizard Title text field may be used to specify the text displayed to users when they 
launch the QuickConnect app to provision their device. 

If provided, the Password Recovery URL and Helpdesk URL fields may be used to 
provide additional resources to users who encounter trouble in provisioning their devices. 

Note: Ensure that users in the provisioning role can access these URLs. 

Authorization settings for device provisioning 

The fifth part of the form is used to specify authorization settings for device provisioning. 
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Enter a number in the Maximum Devices field to limit the maximum number of devices 
that each user may provision. 

Devices are recognized as unique when they have a different MAC address, or a different 
device identifier (when the MAC address is not available). 

Configuring Network Settings for Device Provisioning 

Navigate to Onboard > Network Settings, or click the Network Settings command 
link to display the Onboard Network Settings page. 

This page is used to configure the network settings that will be provisioned to devices. 

Note: Some devices do not support all possible combinations of network settings. If you 
make a selection that is incompatible with a certain type of device, a message will be 
displayed in the Onboard user interface. 

 

The Network Access form is divided into several tabs: 

  Access – Specifies basic network properties, such as the name of the wireless 
network and the type of security that is used. See “Configuring basic network access 
settings”. 

  Protocols – Specifies the 802.1X authentication protocols that are used by the 
network. See “Configuring 802.1X authentication network settings”. 

  Authentication – Specifies the type of device authentication to be used for the 
network. See “Configuring device authentication settings”. 

  Trust – Specifies options related to mutual authentication. See “Configuring 
mutual authentication settings”. 

  Windows – Specifies networking options used only by devices using the 
Windows operating system. See “Configuring Windows-specific network settings”. 

  Proxy – Specifies a proxy server to be used by devices connecting to the 
network. See “Configuring proxy settings”. 

  Post Install – Specifies additional information and instructions to users after the 
network is configured. See “Configuring post-installation instructions”. 
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Note: Navigating between different tabs will save the changes you have made. The 
modified settings are indicated with a “#” marker in the tab. The settings used for device 

provisioning are not modified until you click the  Save Changes button.  

Configuring basic network access settings 

Click the  Access tab to display the Network Access form. 

 

The options available in the Network Type drop-down list are: 

 Both — Wired and Wireless – Configures both wired (Ethernet) and wireless 
network adapters. Use this option when you have 802.1X configured for all types of 
network access. 

 Wireless only – Configures only wireless network adapters. 

 Wired only – Configures only wired (Ethernet) network adapters. 
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The options available in the Security Type drop-down list are: 

 Enterprise (802.1X) – Use this option to setup a network that requires user 
authentication. 

This option is the only available choice when the Network Type is set to “Wired 
only”. 

 Personal (PSK) – Use this option to setup a network that requires only a pre-shared 
key (password) to access the network. 

This option is only available when the Network Type is set to “Wireless only”. 

If you have selected the Personal (PSK) security type, you must provide the pre-shared 

key in the Password field. Selecting this security type will hide the  Protocols, 

 Authentication and  Trust tabs. 

Click the  Next button to continue to the  Protocols tab. Click the  Save Changes 

button to make the new network configuration settings take effect. Click the  Cancel 
button to discard your changes and return to the main Onboard configuration user 
interface. 

Configuring 802.1X authentication network settings 

Click the  Protocols tab to display the Enterprise Protocols form. 
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Use this form to specify the authentication methods required by your network 
infrastructure. 

 The Legacy OS X EAP option supports only PEAP with MSCHAPv2. 

 The Windows EAP option supports only PEAP with MSCHAPv2. 

These best practices are recommended when choosing the 802.1X authentication methods 
to provision: 

 Configure PEAP with MSCHAPv2 for Onboard devices – Android, Windows, and 
legacy OS X (10.5/10.6). 

 Configure EAP-TLS for iOS devices and OS X (10.7 or later). 

 Other EAP methods, while possible, are limited in their applicability and should only 
be used if you have a specific requirement for that method. 
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The Windows EAP options that may be specified include: 

 Enable Fast Reconnect – Fast Reconnect is a PEAP property that enables wireless 
clients to move between wireless access points on the same network without being 
re-authenticated each time they associate with a new access point. 

 Enable Quarantine Checks – Enable this option to obtain a system statement-of-
health (SSoH) from the OnGuard or Microsoft NAP Agent and send it to the 
authentication server during the 802.1X authentication process. Use this option to 
enforce network access control (NAC) protections on the network. 

 Enforce Cryptobinding – Cryptobinding is a process that protects the 
authentication protocol negotiation against man-in-the-middle attacks. The 
cryptobinding request and response performs a two-way handshake between the 
peer and the authentication server using key materials. 

Click the  Previous button to return to the  Access tab. Click the  Next button to 

continue to the  Authentication tab. Click the  Save Changes button to make the 

new network configuration settings take effect. Click the  Cancel button to discard your 
changes and return to the main Onboard configuration user interface. 

Configuring device authentication settings 

Click the  Authentication tab to display the Enterprise Authentication form. 
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Select one of these options in the iOS & OS X Credentials drop-down list:  

 Certificate – A device certificate will be provisioned and used for EAP-TLS client 

authentication. When this option is selected, EAP-TLS must be selected on the  
Protocols tab. 

 Username & Password – A device certificate will be provisioned, but the client 
authentication will use unique device credentials (as for Onboard devices). When 

this option is selected, EAP-TTLS or PEAP must be selected on the  Protocols tab. 

The Windows Authentication options that may be selected are: 

 Machine Only – Use computer-only credentials. 

 User Only – Use user-only credentials 

 Machine Or User – Use computer-only credentials or user-only credentials. When a 
user is logged on, the user's credentials are used for authentication. When no user is 
logged on, computer-only credentials are used for authentication. 

 Guest – Use guest-only credentials. 

Click the  Previous button to return to the  Protocols tab. Click the  Next button 

to continue to the  Trust tab. Click the  Save Changes button to make the new 

network configuration settings take effect. Click the  Cancel button to discard your 
changes and return to the main Onboard configuration user interface. 

Configuring mutual authentication settings 

Click the  Trust tab to display the Enterprise Trust form. 
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In the list of Trusted Certificates, mark the checkbox for each server certificate that the 
client should trust. 

Use the Upload Certificate field to upload additional server certificates. These certificates 
will be displayed in the certificate management list view with the type “tls-server”. 

These best practices are recommended for enterprise trust options: 

 Provide the certificate for each authentication server that a provisioned device will 
use, and select it in the Trusted Certificates list. 

 Avoid marking the Allow trust exceptions checkbox – the network administrator 
should make all trust decisions. Users will not generally review certificates for 
potential issues before accepting them. 

 Mark the Validate the server certificate checkbox for Windows. This ensures that 
the provisioned device will check the server certificate is valid before using the 
server for authentication. 

Click the  Previous button to return to the  Authentication tab. Click the  Next 

button to continue to the  Windows tab. Click the  Save Changes button to make the 
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new network configuration settings take effect. Click the  Cancel button to discard your 
changes and return to the main Onboard configuration user interface. 

Configuring Windows-specific network settings 

Click the  Windows tab to display the Windows Network Settings form. 

 

Network Access Protection (NAP) is a feature in Windows Server 2008 that controls 
access to network resources based on a client computer’s identity and compliance with 
corporate governance policy. NAP allows network administrators to define granular levels 
of network access based on who a client is, the groups to which the client belongs, and the 
degree to which that client is compliant with corporate governance policy. If a client is not 
compliant, NAP provides a mechanism to automatically bring the client back into 
compliance and then dynamically increase its level of network access. 

Deploying NAP requires a NAP-compatible authentication server, so that appropriate 
policies may be implemented based on the statement of health provided by the NAP client. 

To enable NAP for Microsoft Windows clients, mark the Enable NAP services checkbox on 

this tab. You will also need to mark the Enable Quarantine Checks checkbox on the  
Protocols tab.  

Click the  Previous button to return to the  Trust tab. Click the  Next button to 

continue to the  Proxy tab. Click the  Save Changes button to make the new network 
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configuration settings take effect. Click the  Cancel button to discard your changes and 
return to the main Onboard configuration user interface. 

Configuring proxy settings 

Click the  Proxy tab to display the Proxy Settings form. 

 

Select one of these options in the Proxy Type drop-down list: 

 None – No proxy server will be configured. 

 Manual – A proxy server will be configured, if the device supports it. Specify the 
proxy server settings in the Server and Server Port fields. 

 Automatic – The device will configure its own proxy server, if the device supports 
it. Specify the location of a proxy auto-config file in the PAC URL text field. 

Click the  Previous button to return to the  Windows tab. Click the  Next button 

to continue to the  Post Install tab. Click the  Save Changes button to make the new 

network configuration settings take effect. Click the  Cancel button to discard your 
changes and return to the main Onboard configuration user interface. 

Configuring post-installation instructions 

Click the  Post Install tab to display the Post-Installation form. 
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The Instructions text field can be used to provide more information or instructions to an 
iOS or OS X user immediately after device provisioning has completed. 

For example, if you have provisioned Wi-Fi network settings for an SSID that is separate 
from the initial provisioning SSID, you could add a message requesting that the user now 
switch to the new SSID in order to complete setup. 

Click the  Previous button to return to the  Proxy tab. Click the  Save Changes 

button to make the new network configuration settings take effect. Click the  Cancel 
button to discard your changes and return to the main Onboard configuration user 
interface. 

Configuring an iOS Device VPN Connection 

Navigate to Onboard > VPN Settings, or click the VPN Settings command link to 
display the Onboard VPN Settings page. 
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This page is used to automatically configure virtual private networking (VPN) settings on 
the iOS device. Use this option when you have deployed a VPN infrastructure and want to 
automatically provide the secure connection settings to users at the time of device 
provisioning. 

NOTE: Onboard VPN settings can only be used with iOS 4 and iOS 5 devices. Other 
platforms are not supported. 

 

Mark the Add this VPN to the device profile checkbox to enable provisioning of VPN 
settings. 
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The Display Name text field specifies the name for this VPN connection. This will be 
displayed on the device in the Settings app. To help the user identify the connection easily, 
include your organization’s name in the Display Name field. For example, use “ACME 
Sprockets VPN”. 

Select the appropriate Connection Type from the drop-down list: 

 L2TP – Connection uses the Layer 2 Tunneling Protocol. Complete the fields shown 
in the L2TP Connection Settings section of the form. 

 PPTP – Connection uses the Point-to-Point Tunneling Protocol. Complete the fields 
shown in the PPTP Connection Settings section of the form. 

 IPSec – Connection uses the Internet Protocol with security extensions. Complete 
the fields shown in the IPSec Connection Settings section of the form. 

The Authentication Type drop-down list provides these options when configuring 
an IPSec VPN: 

o Identity Certificate – The client certificate issued during device provisioning 
will also be used as the identity certificate for VPN connections. This option 
requires configuring your VPN server to allow IPSec authentication using a 
client certificate. 

o Shared Secret / Group Name – An optional group name may be specified. A 
shared secret (pre-shared key) is used to establish the IPSec VPN. 
Authentication is performed with a username and password. 

The Proxy Settings section of the form specifies a proxy server that is used when the VPN 
connection is active. Select one of these options in the Proxy Setup drop-down list: 

 None – No proxy server will be configured with this VPN profile. 

 Manual – A proxy server will be configured with this VPN profile. Specify the proxy 
server settings in the Server and Port fields. 

If authentication is required to access this proxy, you may specify the username and 
password using the Authentication and Password text fields. 

 Automatic – The proxy server will be automatically configured with this VPN 
profile. Specify the location of a proxy auto-config file in the Proxy Server URL text 
field. 

Click the  Save Changes button to save the VPN connection profile and return to the 
main Onboard configuration user interface. 
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Configuring an iOS Device Email Account 

Navigate to Onboard > Exchange ActiveSync, or click the Exchange ActiveSync 
command link to display the Onboard Exchange ActiveSync Settings page. 

 

This page is used to automatically configure an email account on the iOS device. Use this 
option when you have an Exchange mail server and want to automatically provide the 
email settings to users provisioning their mobile devices. 

Note: Onboard Exchange ActiveSync settings can only be used with iOS 4 and iOS 5 devices. 
Other platforms are not supported. 

 

Mark the Add this ActiveSync configuration to the device profile checkbox to enable 
email account provisioning. 

The Account Name text field specifies the name for this email account. This will be 
displayed on the device in the Settings app, and also within the Mail app to identify the 
mailbox. To help the user identify this mailbox easily, include your organization’s name in 
the Account Name field. For example, use “ACME Sprockets Mail”. 
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In the Account Settings group, choose one of the following options from the Account 
Details drop-down list: 

 User provided — entered by user on device. This option requires the user to 
enter their credentials on the device to access their email. 

 Identity certificate — created during provisioning. This option uses the device’s 
TLS client certificate to authenticate the user. Using this option requires 
configuration of the ActiveSync server to authenticate a user based on the client 
certificate. 

 Shared preset values — testing only. This option provides a fixed set of 
credentials to the device. These settings cannot be modified for each user when 
provisioning a device, so it is recommended that these settings only be used when 
testing Exchange integration. 

 

In the Sync Settings group, choose one of the following options from the Days of Mail drop-
down list: 

 No Limit 

 1 day 

 3 days 

 1 week 

 2 weeks 
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 1 month 

Click the  Save Changes button to save the Exchange ActiveSync profile and return to 
the main Onboard configuration user interface. 

Configuring an iOS Device Passcode Policy 

Navigate to Onboard > Passcode Policy, or click the Passcode Policy command 
link to display the Onboard Passcode Policy Settings page. 

 

This page is used to configure a passcode policy that is applied to iOS devices when 
provisioned. 

Typically, you would enable this policy when provisioning a corporate-owned device, or if 
you are allowing a user to access sensitive information remotely. 

NOTE: Onboard Passcode Policy settings can only be used with iOS 4 and iOS 5 devices. 
Other platforms are not supported. 
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To enable the passcode policy on all iOS devices, mark the Enable passcode policy 
checkbox and configure the remaining options according to your enterprise’s security 
requirements. 
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Click the  Save Changes button to save the passcode policy settings and return to the 
main Onboard configuration user interface. 

Resetting Onboard Certificates and Configuration 

Navigate to Onboard > Reset to Factory Defaults, or click the Reset to Factory 
Defaults command link to display the Mobile Device Provisioning Reset page. 

 

This page is used to delete certificates, or restore the default configuration for Onboard. 
These options are useful while trialing the Onboard workflow with a set of test devices. 

 

Select one of the following options in the Reset Type drop-down list: 

 Delete all client certificates – Removes all client certificates from Certificate 
Management. The certificate authority’s root certificate, intermediate certificate, 
profile signing certificate, and any server certificates are not affected. The 
provisioning settings for iOS and Onboard-capable devices are not modified. 

 Delete all certificates – Removes all certificates from Certificate Management, 
including the certificate authority’s root certificate, intermediate certificate, profile 
signing certificate, and any server certificates. The default certificate authority 
certificate will be recreated. The provisioning settings for iOS and Onboard-capable 
devices are not modified. 

 Re-create the MDPS weblogin page – Select this option to create the default 
device_provisioning web login page, if it has been deleted or has been modified and 
no longer functions correctly. All certificates and settings are left unmodified. 

 Delete all certificates and reset configuration to factory defaults – Removes all 
certificates from Certificate Management, including the certificate authority’s root 
certificate, intermediate certificate, profile signing certificate, and any server 
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certificates. The provisioning settings for iOS and Onboard-capable devices are 
restored to the default settings. The default certificate authority will be recreated. 

Mark the Reset the specified items checkbox to indicate that the reset operation should 

be performed, and then click  Reset to Factory Defaults to perform the operation. 

Advanced: Device Authentication during Provisioning 

When the Enable device authentication checkbox is marked, a RADIUS request is 
performed during the device provisioning step. 

The local RADIUS server is always used for this request. 

The attributes sent with the RADIUS request are listed in Table 8 below. 

Table 8 – RADIUS attributes included with a device authentication request. 

RADIUS Attribute Value 

User-Name (1) The username for the current device provisioning process. 

User-Password (2) Password credentials supplied by the user during device 
provisioning. 

Calling-Station-Id (31) MAC address of the device being provisioned. 

This attribute is omitted if the MAC address information is 
unavailable. 

If multiple MAC addresses are available, only the first MAC 
address will be included in the RADIUS request. 

Framed-IP-Address (8) IPv4 address of the device being provisioned. 

NAS-IP-Address (4) Always set to “127.0.0.1”. 

NAS-Identifier (32) Set to the hostname of the Onboard server. 

NAS-Port (5) Always set to “0”. 

NAS-Port-Type (61) Always set to “Ethernet” (15). 

Service-Type (6) Always set to “Authorize-Only” (17). 

Event-Timestamp (55) Set to a value indicating the current time. 

Mdps-Device-Name1 (19) Type of device, such as “iOS”, “Android”, etc. 

Mdps-Device-Product1 (20) Product string identifying the device and often including the 
hardware version information. 

Mdps-Device-Version1 (21) Software version number for the device. 

Mdps-Device-Udid1 (15) Unique device identifier (UDID) for this device. This is 
typically a 64-bit, 128-bit or 160-bit number represented in 
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RADIUS Attribute Value 

hexadecimal (16, 32 or 40 characters, respectively). 

Mdps-Device-Imei1 (16) International Mobile Equipment Identity (IMEI) number 
allocated to this device.  

Mdps-Device-Iccid1 (17) Integrated Circuit Card Identifier (ICCID) number from the 
Subscriber Identity Module (SIM) card present in the device. 

Mdps-Device-Serial1 (22) Serial number of the device. 

Note 1:  This is a vendor-specific attribute with vendor ID 14823. 

If the RADIUS server responds with an Access-Reject, then the device provisioning will fail. 
The value of the Reply-Message attribute, if one was included in the Access-Reject message, 
will be used to construct the error message. 

If the RADIUS server responds with an Access-Accept message, then the device 
provisioning proceeds as normal. 

Onboard Troubleshooting 

If you encounter a problem that is not listed here, refer to the “Onboard Deployment 
Checklist” and check each of the configuration steps listed there. 

iOS Device Provisioning Failures 

Symptom:  Device provisioning fails on iOS with the message “The server certificate for 
https://… is invalid”. 
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Resolution: When using HTTPS for device provisioning, you must obtain a commercial SSL 
certificate. 

Self-signed SSL certificates, and SSL server certificates that have been issued by an 
untrusted or unknown root certificate authority, will cause iOS device provisioning to fail 
with the message “The server certificate for … is invalid”. 

A workaround for this issue is to install an appropriate root certificate on the iOS device. 
This root certificate must be the web server’s SSL certificate (if it is a self-signed 
certificate), or the certificate authority that issued the SSL certificate. This is not 
recommended for production deployments as it increases the complexity of deployment 
for users with iOS devices. 
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Chapter 1
About this Guide

ClearPass Guest provides a simple and personalized user interface through which operational staff can quickly
and securely manager visitor network access.

Audience
This User Guide is intended for system administrators and people who are installing and configuring ClearPass
Guest as their visitor management solution. It describes the installation and configuration process.

Conventions
The following conventions are used throughout this guide to emphasize important concepts:

Type Style Description

Italics This style is used to emphasize important terms and to mark the titles of books.

System items

This fixed-width font depicts the following:
l Sample screen output
l System prompts
l Filenames, software devices, and specific commands when mentioned in the text

Commands In the command examples, this bold font depicts text that you must type exactly as
shown.

<Arguments>

In the command examples, italicized text within angle brackets represents items that
you should replace with information appropriate to your specific situation. For example:
# send <text message>
In this example, you would type “send” at the system prompt exactly as shown, followed
by the text of the message you wish to send. Do not type the angle brackets.

[Optional] Command examples enclosed in brackets are optional. Do not type the brackets.

{Item A |
Item B}

In the command examples, items within curled braces and separated by a vertical bar
represent the available choices. Enter only one choice. Do not type the braces or bars.

Table 1: Typographical Conventions

The following informational icons are used throughout this guide:

Indicates helpful suggestions, pertinent information, and important things to remember.

Indicates a risk of damage to your hardware or loss of data.

Indicates a risk of personal injury or death.
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Contacting Support

Main Site arubanetworks.com

Support Site support.arubanetworks.com

Airheads Social Forums and
Knowledge Base community.arubanetworks.com

North American Telephone 1-800-943-4526 (Toll Free)
1-408-754-1200

International Telephones arubanetworks.com/support-services/support-program/contact-support/

Software Licensing Site licensing.arubanetworks.com

End of Support information arubanetworks.com/support-services/end-of-life-products/end-of-life-
policy/

Wireless Security Incident
Response Team (WSIRT) arubanetworks.com/support-services/security-bulletins/

Support Email Addresses

Americas and APAC
EMEA support@arubanetworks.com

WSIRT Email
Please email details of any
security problem found in an
Aruba product.

sirt@arubanetworks.com
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Chapter 2
ClearPass Guest Overview

This chapter explains the terms, concepts, processes, and equipment involved in managing visitor access to a
network, and helps you understand how ClearPass Guest can be successfully integrated into your network
infrastructure. It is intended for network architects, IT administrators, and security consultants who are
planning to deploy visitor access, or who are in the early stages of deploying a visitor access solution.

This chapter includes the following sections:

l "About ClearPass Guest" on page 19

l "Visitor Access Scenarios" on page 20

l "Reference Network Diagram" on page 21

l "Key Interactions" on page 22

l "AAA Framework" on page 23

l "Key Features" on page 24

l "Visitor Management Terminology" on page 25

l "ClearPass Guest Deployment Process" on page 26

l "AirGroup Deployment Process" on page 28

l "Documentation and User Assistance" on page 29

l "Use of Cookies" on page 30

About ClearPass Guest
ClearPass Guest provides a simple and personalized user interface through which operational staff can quickly
and securely manage visitor network access. It gives your non-technical staff controlled access to a dedicated
visitor management user database. Through a customizable Web portal, your staff can easily create an
account, reset a password, or set an expiry time for visitors. Access permissions to ClearPass Guest functions
are controlled through an operator profile that can be integrated with an LDAP server or Active Directory login.

Visitors can be registered at reception and provisioned with an individual guest account that defines their
visitor profile and the duration of their visit. The visitor can be given a printed customized receipt with account
details, or the receipt can be delivered wirelessly using the integrated SMS services. Companies are also able to
pre-generate custom scratch cards, each with a defined network access time, which can then be handed out in
a corporate environment or sold in public access scenarios.

You can use the customization features to define settings that allow your visitors to self-provision their own
guest accounts. Visitors register through a branded and customized Web portal, ensuring a streamlined and
professional experience. Surveys can also be presented during the self-registration process and the data stored
for later analysis and reporting, providing additional insight to your visitors and their network usage.

ClearPass Guest integrates with all leading wireless and NAC solutions through a flexible definition point,
ClearPass Policy Manager. This ensures that IT administrators have a standard integration with the network
security framework, but gives operational staff the user interface they require.
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Visitor Access Scenarios
The following figure shows a high-level representation of a typical visitor access scenario.

Figure 1 Visitor access using ClearPass Guest

In this scenario, visitors are using their own mobile devices to access a corporate wireless network. Because
access to the network is restricted, visitors must first obtain a username and password. A guest account may
be provisioned by a corporate operator such as a receptionist, who can then give the visitor a print receipt that
shows their username and password for the network.

When visitors use self-registration, as might be the case for a network offering public access, the process is
broadly similar but does not require a corporate operator to create the guest account. The username and
password for a self-provisioned guest account may be delivered directly to the visitor’s Web browser, or sent
via SMS or email.
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Reference Network Diagram
The following figure shows the network connections and protocols used by ClearPass Guest.

Figure 2 Reference network diagram for visitor access

The network administrator, operators, and visitors may use different network interfaces to access the visitor
management features. The exact topology of the network and the connections made to it will depend on the
type of network access offered to visitors and the geographical layout of the access points.
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Key Interactions
The following figure shows the key interactions between ClearPass Guest and the people and other
components involved in providing guest access.

Figure 3 Interactions involved in guest access

ClearPass Guest is part of your network’s core infrastructure and manages guest access to the network.

NAS devices, such as wireless access points and wired switches on the edge of the network, use the RADIUS
protocol to ask ClearPass Policy Manager to authenticate the username and password provided by a guest
logging in to the network. If authentication is successful, the guest is then authorized to access the network.

Roles are assigned to a guest as part of the context ClearPass Policy Manager uses to apply its policies. RADIUS
attributes that define a role’s access permissions are contained within Policy Manager’s Enforcement Profile.
Additional features such as role mapping for ClearPass Guest can be performed in ClearPass Policy Manager.

The network usage of authorized guests is monitored by the NAS and reported in summary form to ClearPass
Policy Manager using RADIUS accounting, which allows administrators to generate network reports in
ClearPass Insight.
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AAA Framework
ClearPass Guest is built on the industry standard AAA framework, which consists of authentication,
authorization, and accounting components.

The following figure shows how the different components of this framework are employed in a guest access
scenario.

Figure 4 Sequence diagram for network access using AAA

In the standard AAA framework, network access is provided to a user according to the following process:

l The user connects to the network by associating with a local access point [1].

l A landing page is displayed to the user [2] which allows them to log in to the NAS [3], [4] using the login
name and password of their guest account.

l The NAS authenticates the user with the RADIUS protocol [5].

l ClearPass Policy Manager determines whether the user is authorized, and, if so, returns vendor-specific
attributes [6] that are used to configure the NAS based on the user’s role and other policies [7].

l If the user’s access is granted, the NAS permits the guest access to the network based on the settings
provided by the ClearPass Policy Manager server.

l The NAS reports details about the user’s session to the ClearPass Policy Manager server using RADIUS
accounting messages [8].

l After the user’s session times out [9], the NAS will return the user to an unauthorized state and finalize the
details of the user’s session with an accounting update [10].
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Key Features
Refer to the table below for a list of key features and a cross-reference to the relevant section of this User
Guide.

Feature Reference

Visitor Access

Web server providing content delivery for guests
"Managing Content: Private
Files and Public Files" on page
189

Guest self-registration "Customizing Guest Self-
Registration" on page 235

Visitor Management

Create and manage visitor accounts, individually or in groups
"Using Standard Guest
Management Features" on
page 38

Manage active RADIUS sessions using RFC 3576 dynamic authorization support "Active Sessions
Management" on page 33

Import and export visitor accounts "Importing Guest Accounts"
on page 52

Create guest self-registration forms "Creating a Self-Registration
Page" on page 241

Configure a self-service portal for guests "Self-Service Portal
Properties" on page 257

Local printer, SMS or email delivery of account receipts "Editing Guest Receipt Page
Properties" on page 248

Visitor Account Features

Independent activation time, expiration time, and maximum usage time "Business Logic for Account
Creation" on page 198

Define unlimited custom fields "Customizing Fields" on page
206

Username up to 64 characters "GuestManager Standard
Fields" on page 502

Customization Features

Create new fields and forms for visitor management "Customizing Forms and
Views" on page 212

Use built-in data validation to implement visitor survey forms "Form Validation Properties"
on page 227

Create print templates for visitor account receipts "Editing Guest Receipt Page
Properties" on page 248

Table 2: List of Key features
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Feature Reference

Administrative Management Features

Operators defined and authenticated locally "Local Operator
Authentication" on page 462

Operators authenticated via LDAP "External Operator
Authentication" on page 463

Role based access control for operators "Operator Profiles" on page
456

Plugin-based application features, automatically updated by ClearPass Policy
Manager

"Plugin Manager" on page
443

User Interface Features

Context-sensitive help with searchable online documentation "Documentation and User
Assistance" on page 29

Visitor Management Terminology
The following table describes the common terms used in ClearPass Guest and this guide.

Term Explanation

Accounting Process of recording summary information about network access by users and
devices.

Authentication Verification of a user’s credentials; typically a username and password.

Authorization Controls the type of access that an authenticated user is permitted to have.

Captive Portal Implemented by a Network Access Server to restrict network access to authorized
users only.

Field In a user interface or database, a single item of information about a user account.

Form In a user interface, a collection of editable fields displayed to an operator.

Network Access Server
Device that provides network access to users, such as a wireless access point,
network switch, or dial-in terminal server. When a user connects to the NAS
device, a RADIUS access request is generated by the NAS.

Operator Profile Characteristics assigned to a class of operators, such as the permissions granted
to those operators.

Operator/Operator Login User of ClearPass Guest to create guest accounts or perform system
configuration.

Print Template Formatted template used to generate guest account receipts.

Role Type of access being granted to visitors. You can define multiple roles. Such roles
could include employee, guest, team member, or press.

Table 3: Common Terms
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Term Explanation

Sponsor Operator

User Database Database listing the guest accounts in ClearPass Guest.

View In a user interface, a table displaying data, such as visitor account information, to
operators.

Visitor/Guest Someone who is permitted to access the Internet through your Network Access
Server.

Visitor Account Settings for a visitor stored in the user database, including username, password
and other fields.

Web Login/NAS Login Login page displayed to a guest user.

ClearPass Guest Deployment Process
As part of your preparations for deploying a visitor management solution, you should consider the following
areas:

l Management decisions about security policy

l Decisions about the day-to-day operation of visitor management

l Technical decisions related to network provisioning

Operational Concerns
When deploying a visitor management solution, you should consider these operational concerns:

l Who is going to be responsible for managing guest accounts? What privileges will the guest account
manager have? Will this person only create guest accounts or will this person also be permitted access to
reports?

l Do you want guests to be able to self-provision their own network access? What settings should be applied
to self-provisioned visitor accounts?

l How will operator logins be provisioned? Should operators be authenticated against an LDAP server?

l Who will manage reporting of guest access? What are the reports of interest? Are any custom reports
needed?

Network Provisioning
ClearPass Guest requires provisioning the following:

l Physical location – rack space, power and cooling requirements; or deployment using virtualization

l Network connectivity – VLAN selection, IP address, and hostname

l Security infrastructure – SSL certificate
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Site Preparation Checklist
The following is a checklist of the items that should be considered when setting up ClearPass Guest.

ü Policy Decision

Security Policy

Segregated guest accounts?

Type of network access?

Time of day access?

Bandwidth allocation to guests?

Prioritization of traffic?

Different guest roles?

IP address ranges for operators?

Enforce access via HTTPS?

Operational Concerns

Who will manage guest accounts?

Guest account self provisioning?

What privileges will the guest managers have?

Who will be responsible for printing reports?

Network Management Policy

Password format for guest accounts?

Shared secret format?

Operator provisioning?

Network Provisioning

Physical location?

Network connectivity?

Security infrastructure?

Table 4: Site Preparation Checklist

Security Policy Considerations
To ensure that your network remains secure, decisions have to be made regarding guest access:

l Do you wish to segregate guest access? Do you want a different VLAN, or different physical network
infrastructure to be used by your guests?
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l What resources are you going to make available to guests (for example, type of network access; permitted
times of day; bandwidth allocation)?

l Will guest access be separated into different roles? If so, what roles are needed?

l How will you prioritize traffic on the network to differentiate quality of service for guest accounts and non-
guest accounts?

l What will be the password format for guest accounts? Will you be changing this format on a regular basis?

l What requirements will you place on the shared secret, between NAS and the RADIUS server to ensure
network security is not compromised?

l What IP address ranges will operators be using to access the server?

l Should HTTPS be required in order to access the visitor management server?

AirGroup Deployment Process
AirGroup allows users to register their personal mobile devices on the local network and define a group of
friends or associates who are allowed to share them. You use ClearPass Guest to define AirGroup
administrators and operators. AirGroup administrators can then use ClearPass Guest to register and manage
an organization’s shared devices and configure access according to username, role, location, or time. AirGroup
operators (end users) can use ClearPass Guest to register their personal devices and define the group who can
share them.

Table 5 summarizes the steps for configuring Aruba AirGroup functionality in ClearPass Guest. Details for these
steps are provided in the relevant sections of this Guide. This table does not include the configuration steps
performed in ClearPass Policy Manager or the ArubaOS controller. For complete AirGroup deployment
information, refer to the AirGroup sections in the ArubaOS User Guide and the ClearPass Policy Manager
documentation.

Step Section in this Guide

Create AirGroup administrators
"Creating a New Operator" on page 462

Create AirGroup operators

Configure an operator’s device limit "Configuring AirGroup Operator Device Limit" on page 462

Configure an AirGroup controller "AirGroup Controllers" on page 358

Enable support for dynamic notifications "Configuring AirGroup Services" on page 361

To authenticate AirGroup users via LDAP:
Define the LDAP server
Define appropriate translation rules

"External Operator Authentication" on page 463
"LDAP Translation Rules" on page 469

AirGroup administrator: Register devices or groups
of devices

"AirGroup Device Registration" on page 66

AirGroup operator: Register personal devices

(Optional) Configure device registration form with
drop-down lists for existing locations and roles "Customizing AirGroup Registration Forms" on page 209

Set up time-based sharing "About AirGroup Time-Based Sharing" on page 75

Table 5: Summary of AirGroup Configuration Steps in ClearPass Guest
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Documentation and User Assistance
This section describes the variety of user assistance available for ClearPass Guest.

User Guide and Online Help
This User Guide provides complete information for all ClearPass Guest features. The following quick links may
be useful in getting started.

For information about... Refer to...

What visitor management is and how it works "About ClearPass Guest" on page 19

Using the guest management features "Using Standard Guest Management Features" on
page 38

Role-based access control for operators "Operator Profiles" on page 456

Setting up LDAP authentication for operators "External Operator Authentication" on page 463

Guest self-provisioning features "Self Provisioned Guest Access" on page 32

Dynamic authorization extensions "RFC 3576 Dynamic Authorization" on page 35

SMS receipts for guest accounts "SMS Services" on page 296

Email receipts for guest accounts "Email Receipts and SMTP Services" on page 284

Network administration of the appliance "Administration" on page 357

Table 6: Quick Links

Context-Sensitive Help
For more detailed information about the area of the application you are using, click the context-sensitive Help
link displayed at the top right of the page. This opens a new browser tab showing the relevant section of this
User Guide.

The User Guide may be searched using the Search box in the top right corner.

Type in keywords related to your search and click the Search button to display a list of matches. The most
relevant matches will be displayed first. Words may be excluded from the search by typing a minus sign directly
before the word to exclude (for example-exclude). Exact phrase matches may also be searched for by enclosing
the phrase in double quotes (for example, “word phrase”).

Field Help
The ClearPass Guest user interface has field help built into every form. The field help provides a short summary
of the purpose of the field at the point you need it most. In many cases this is sufficient to use the application
without further assistance or training.
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Quick Help

In list views, click the Quick Help tab located at the top left of the list to display additional information
about the list you are viewing and the actions that are available within the list.

On some forms and views, the Quick Help icon may also be used to provide additional detail about a field.

If You Need More Assistance
If you encounter a problem using ClearPass Guest, your first step should be to consult the appropriate section
in this User Guide.

If you cannot find an answer here, the next step is to contact your reseller. The reseller can usually provide you
with the answer or obtain a solution to your problem.

If you still need information, you can refer to the Contact Support command available under Support
Services in the user interface, or see "Contacting Support" on page 18.

Use of Cookies
Cookies are small text files that are placed on a user’s computer by Web sites the user visits. They are widely
used in order to make Web sites work, or work more efficiently, as well as to provide information to the owners
of a site. Session cookies are temporary cookies that last only for the duration of one user session.

When a user registers or logs in via an Aruba captive portal, Aruba uses session cookies solely to remember
between clicks who a guest or operator is. Aruba uses this information in a way that does not identify any user-
specific information, and does not make any attempt to find out the identities of those using its ClearPass
products. Aruba does not associate any data gathered by the cookie with any personally identifiable
information (PII) from any source. Aruba uses session cookies only during the user’s active session and does
not store any permanent cookies on a user’s computer. Session cookies are deleted when the user closes
his/her Web browser.
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Chapter 3
Guest Manager

The ability to easily create and manage guest accounts is the primary function of ClearPass Guest. The Guest
Manager module provides complete control over the user account creation process.

Guest Manager features for managing guest accounts let you:

l View and manage active sessions

l Create single or multiple guest accounts and receipts

l Create new MAC devices

l Bulk edit accounts

l Export a list of accounts

l Import new accounts from a text file

l View guest accounts and edit individual or multiple guest accounts

l View MAC devices and edit individual or multiple devices

Many features can also be customized. For information on customizing Guest Manager settings, forms and
views, guest self-registration, and print templates, see "Configuration" on page 187.

Accessing Guest Manager
To access ClearPass Guest’s guest management features, click the Guest link in the left navigation.
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About Guest Management Processes
There are two major ways to manage guest access – either by your operators provisioning guest accounts, or
by the guests self-provisioning their own accounts. Both of these processes are described in the next sections.

Sponsored Guest Access
The following figure shows the process of sponsored guest access.

Figure 5 Sponsored guest access with guest created by operator

The operator creates the guest accounts and generates a receipt for the account.

The guest logs on to the Network Access Server (NAS) using the credentials provided on her receipt. The NAS
authenticates and authorizes the guest’s login in ClearPass Guest. After authorization, the guest is able to
access the network.

Self Provisioned Guest Access
Self-provisioned access is similar to sponsored guest access, but there is no need for an operator to create the
account or to print the receipt. The following figure shows the process of self-provisioned guest access.

Figure 6 Guest access when guest is self-provisioned

The guest logs on to the Network Access Server (NAS), which captures the guest and redirects them to a captive
portal login page. From the login page, guests without an account can browse to the guest self-registration
page, where the guest creates a new account. At the conclusion of the registration process, the guest is
automatically redirected to the NAS to log in.

The guest can print or download a receipt, or have the receipt information delivered by SMS or email.

Anexo 11 ITEM 01 (0592523)         SEI 0008478-63.2018.6.02.8000 / pg. 3059



The NAS performs authentication and authorization for the guest in ClearPass Guest. After authorization, the
guest is able to access the network.

See "Customizing Guest Self-Registration" on page 235 for details on creating and managing self-registration
pages.

Active Sessions Management

The RADIUS server maintains a list of active visitor sessions. If your NAS equipment has RFC 3576 support, the
RADIUS dynamic authorization extensions allow you to disconnect or modify an active session.

To view and manage active sessions for the RADIUS server, go to Guest > Active Sessions. The Active
Sessions list opens. You can use this list to modify, disconnect or reauthorize, or send SMS notifications for
active visitor sessions; manage multiple sessions; or customize the list to include additional fields.

l To view details for an active session, click the session’s row in the list, then click its Show Details link. The
form expands to include the Session Details view.
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l If the NAS equipment has RFC 3576 support, you can disconnect or dynamically reauthorize active sessions.
See "RFC 3576 Dynamic Authorization" on page 35 for more information.

n To disconnect an active session, click the session’s row in the list, then click its Disconnect link. A
message is displayed to show that the disconnect is in progress and acknowledge when it is complete.

n To reauthorize a session that was disconnected, click the session’s row in the list, then click its
Reauthorize link. The Reauthorize Session form opens. Click Reauthorize Session. A message is
displayed to show that the disconnect is in progress and acknowledge when it is complete.

n To disconnect multiple sessions, click the Manage Multiple tab. The form expands to include the
Manage Multiple Sessions form. For more information, see "Disconnecting Multiple Active Sessions " on
page 37.

l To view and work with the guest accounts associated with a session, click the session’s row in the list, then
click its List Accounts link. The Guest Manager Accounts view opens. See "Managing Single Guest Accounts
" on page 55 for more information.

l To display only sessions that meet certain criteria, click the Filter tab. For more information, see "Filtering
the List of Active Sessions" on page 36.

l To send SMS notifications to visitors, click the SMS tab. For more information, see "Sending Multiple SMS
Alerts " on page 37.

l To include additional fields in the Active Sessions list, or delete fields from it, click the More Options tab.
The Customize View Fields page opens. For more information, see "Editing Forms " on page 214.
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l You can use the paging control at the bottom of the list to jump forwards or backwards by one page, or to
the first or last page of the list. You can also click an individual page number to jump directly to that page.

Session States
A session may be in one of three possible states:

l Active—An active session is one for which the RADIUS server has received an accounting start message
and has not received a stop message, which indicates that service is being provided by a NAS on behalf of an
authorized client.

While a session is in progress, the NAS sends interim accounting update messages to the RADIUS server.
This maintains up-to-date traffic statistics and keeps the session active. The frequency of the accounting
update messages is configurable in the RADIUS server.

l Stale—If an accounting stop message is never sent for a session—for example, if the visitor does not log
out— that session will remain open. After 24 hours without an accounting update indicating session traffic,
the session is considered ‘stale’ and is not counted towards the active sessions limit for a visitor account. To
ensure that accounting statistics are correct, you should check the list for stale sessions and close them.

l Closed—A session ends when the visitor logs out or if the session is disconnected. When a session is
explicitly ended in either of these ways, the NAS sends an accounting stop message to the RADIUS server.
This closes the session. No further accounting updates are possible for a closed session.

RFC 3576 Dynamic Authorization
Dynamic authorization describes the ability to make changes to a visitor account’s session while it is in
progress. This includes disconnecting a session, or updating some aspect of the authorization for the session.

The Active Sessions page provides two dynamic authorization capabilities that apply to currently active
sessions:

l Disconnect causes a Disconnect-Request message to be sent to the NAS for an active session,
requesting that the NAS terminate the session immediately. The NAS should respond with a Disconnect-ACK
message if the session was terminated or Disconnect-NAK if the session was not terminated.

l Reauthorize causes a Disconnect-Request message to be sent to the NAS for an active session. This
message will contain a Service-Type attribute with the value ‘Authorize Only’. The NAS should respond with a
Disconnect-NAK message, and should then reauthorize the session by sending an Access-Request message
to the RADIUS server. The RADIUS server’s response will contain the current authorization details for the
visitor account, which will then update the corresponding properties in the NAS session.

If the NAS does not support RFC 3576, attempts to perform dynamic authorization will time out and result in a
‘No response from NAS’ error message.

Refer to RFC 3576 for more details about dynamic authorization extensions to the RADIUS protocol.
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Filtering the List of Active Sessions

On the Guest > Active Sessions list, you can use the Filter tab to narrow the search parameters and
quickly find all matching sessions:

Enter a username or IP address in the Filter field. Additional fields can be included in the search if the “Include
values when performing a quick search” option was selected for the field within the view. To control this
option, use the Choose Columns command link on the More Options tab.

You may enter a simple substring to match a portion of the username or any other fields that are configured
for search, and you can include the following operators:

Operator Meaning Additional Information

= is equal to

You may search for multiple values when using the
equality (=) or inequality !=) operators. To specify multiple
values, list them separated by the pipe character ( | ).

For example, specifying the filter "role_id=2|3, custom_
field=Value" restricts the accounts displayed to those with
role IDs 2 and 3 (Guest and Employee), and with the field
named "custom_field" set to "Value".

!= is not equal to

> is greater than

>= is greater than or equal to

< is less than

<= is less than or equal to

~ matches the regular expression

!~ does not match the regular
expression

Table 7: Operators supported in filters

To restore the default view, click the Clear Filter link.

Click the Apply Filter button to save your changes and update the view, or click the Reset button to
remove the filter and return to the default view.
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Disconnecting Multiple Active Sessions

To disconnect multiple sessions, click the Manage Multiple tab. The Manage Multiple Sessions form opens.

l To close all active sessions, leave the Start Time and End Time fields empty and click Make Changes. All
active sessions are closed and are removed from the Active Sessions list.

You can specify sessions in a time range.

1. To close all sessions that started after a particular time, click the button in the Start Time row. The calendar
picker opens. Use the calendar to specify the year, month, and day, and click the numbers in the Time fields
to increment the hours and minutes. All sessions that started after the specified date and time will be
disconnected.

2. To close all sessions that started before a particular time, click the button in the End Time row. The calendar
picker opens. Use the calendar to specify the year, month, and day, and click the numbers in the Time fields
to increment the hours and minutes. All sessions that started before the specified date and time will be
disconnected.

3. Click Make Changes. The specified sessions are closed and are removed from the Active Sessions list.

Sending Multiple SMS Alerts
The SMS tab on the Active Sessions page lets you send an SMS alert message to all active sessions that have a
valid phone number. An SMS alert during an active session can be used to send a group of visitors information
you might want them to have immediately—for example, a special offer that will only be available for an hour,
a change in a meeting’s schedule or location, or a public safety announcement.

To create an SMS message:

1. Click the SMS tab on the Active Sessions page. The Send SMS Notification form opens.

2. Use the filter to specify the group of addresses that should receive the message. See "Filtering the List of
Active Sessions" on page 36. Only accounts with valid phone numbers can be sent SMS alerts.

3. Enter the message in the Message text box. Messages may contain up to 160 characters.
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4. Click Send.

About SMS Guest Account Receipts

You can send SMS receipts for guest accounts that are created using either sponsored guest access or self-
provisioned guest access. This is convenient in situations where the visitor may not be physically present to
receive a printed receipt.

ClearPass Guest may be configured to automatically send SMS receipts to visitors, or to send receipts only on
demand.

To manually send an SMS receipt:

1. Go to the Guest > Manage Accounts and click to expand the row of the guest to whom you want to send
a receipt.

2. Click Print to display the Updated Account Details view, and then click the Send SMS receipt link. The
SMS Receipt form opens. Use the fields on this form to enter the service to use, the recipient’s mobile
phone number, and the message text.

When using guest self-registration, SMS Delivery options are available for the receipt page actions; See "Editing
Receipt Actions" on page 248 for full details. For more information on SMS services, see "SMS Services" on page
296.

Using Standard Guest Management Features
This section describes:

l "Creating a Guest Account " on page 39

l "Creating a Guest Account Receipt " on page 41

l "Creating a Device" on page 41

l "Creating Multiple Guest Accounts" on page 45

l "Creating Multiple Guest Account Receipts" on page 46

l "Creating a Single Password for Multiple Accounts " on page 48
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l "Managing Single Guest Accounts " on page 55

l "Managing Multiple Guest Accounts " on page 64

l "Exporting Guest Account Information " on page 50

l "Importing Guest Accounts" on page 52

l "Managing Single Guest Accounts " on page 55

l "Managing Devices " on page 59

l "Managing Multiple Guest Accounts " on page 64

To customize guest self-registration, please see Configuration on page 187.

Creating a Guest Account
To create a new account, go to Guest > Create Account, or click the Create New Guest Account command
link on the Guest Manager page. The Create New Guest Account form opens.

The Create New Guest Account form (create_user) can be customized by adding new fields, or modifying or
removing the existing fields. See "Customizing Guest Self-Registration" on page 235 for details about the
customization process. The default settings for this form are described below.

Field Description

Guest's
Name (Required) Name of the guest user for this account.

Company
Name (Required) Name of the organization the guest user belongs to.

Table 8: The Create New Guest Account Form
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Field Description

Email
Address (Required) The guest user's email address. This email address will be the guest's username.

Account
Activation

You can select an activation time from this drop-down list. The guest's account cannot be used
before the activation time. Options include:
l Now
l Disable account
l Tomorrow
l Next Monday
l 1 hour from now
l 1 day from now
l 1 week from now
l Activate at specified time...

Activation
Time

If you selected "Activate at specified time", use the calendar picker in this field to specify the date
and time. If no selection is made, the account will be enabled immediately.

Account
Expiration

You can select an expiration time from this drop-down list. The guest's account cannot be used after
the expiration time. Options include:
l Account will not expire
l Now
l Tonight
l Friday night
l 1 hour from now
l 1 day from now
l 1 week from now
l 30 days from now
l 90 days from now
l 180 days from now
l 1 year from now
l Account expires after...
l Account expires at specified time...

Expires
After

If you selected "Account expires after", use this drop-down list to specify a length of time. Options
include several intervals of hours, days, or weeks.

Expiration
Time

If you selected "Account expires at specified time", use the calendar picker in this field to specify the
date and time. If no selection is made, the account will not expire.

Account
Role

(Required) Specify the type of account the guest should have. Options include:
l Contractor
l Employee
l Guest

Password A random password is created for each visitor account. This is displayed on this form, but will also
be available on the guest account receipt.

Notes You may enter notes about this guest account.

Terms of
Use (Required) You must select the check box in in this field in order to create the account.

Create When your entries on the form are complete, click this button to create the guest's account.
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Creating a Guest Account Receipt
After you click the Create button on the Create New Guest Account form, the details for that account are
displayed.

To print a receipt for the guest, select an appropriate template from the Open print window using
template… list. A new Web browser window opens and the browser’s Print dialog box is displayed.

Click the Send SMS receipt link to send a guest account receipt via text message. Use the SMS Receipt
form to enter the mobile telephone number to which the receipt should be sent.

Sending SMS receipts requires the SMS Services plugin. If the administrator has enabled automatic SMS, and
the visitor’s phone number was typed into the Create New Guest Account form, an SMS message will be
sent automatically. A message is displayed on the account receipt page after an SMS message has been sent.

Click the Send email receipt link to send an email copy of the guest account receipt. Use the Email Receipt
form to enter the email address to which the receipt should be sent. You can also specify the subject line for
the email message. If the administrator has enabled automatic email for guest account receipts, and the
visitor’s email address was typed into the Create New Guest Account form, an email receipt will be sent
automatically. A message is displayed on the account receipt page after an email has been sent.

Creating a Device
Device accounts may be created in three ways:

l Manually in ClearPass Guest using the Create New Device form

l During guest self-registration by a MAC parameter passed in the redirect URL, if the process is configured to
create a MAC device account

l During guest self-registration by a MAC parameter passed in the redirect URL, creating a parallel account
paired with the visitor account

Creating Devices Manually in ClearPass Guest
If you have the MAC address, you can create a new device manually. To create a new device, go to Guest
> Create Device, or go to Guest > Manage Devices and click the Create link.

The Create New Device form opens.
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Field Description

MAC Address (Required) Enter the device's MAC address.

Device Name

(Required) Enter the name for the device.
If you need to modify the configuration for expected separator format or case, go to
Administration > Plugin Manager > Manage Plugins and click the Configuration link
for the MAC Authentication Plugin.

AirGroup Enables AirGroup for the device. Configuration options are added to the form.

Ownership Specifies whether device ownership should be personal or shared. Personal devices are
automatically shared with the owner's other devices.

Shared With

Usernames of people who can share this device. Enter usernames as a comma-separated
list. To make the device available to all users, leave this field blank.
Each username may not exceed 64 characters. A maximum of 100 usernames may be
entered. The maximum character limit for the list is 1000 characters (including comma
separators).

Shared Locations

Locations where the device can be shared. When you type a location name in the Shared
Locations field and press the Enter key, the location appears as a "tag" and is created in the
system when the form is saved.
Each location name may not exceed 64 characters. A maximum of 100 location names may
be entered. The maximum character limit for the list is 1000 characters (including comma
separators).

Shared Roles

User roles that can share this device. When you type a role name in the Shared Roles field
and press the Enter key, the role appears as a "tag" and is created in the system when the
form is saved.
Each role name may not exceed 64 characters. A maximum of 100 role names may be
entered. The maximum character limit for the list is 1000 characters (including comma
separators).

Table 9: New Device
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Field Description

Shared Groups

User groups that can share this device. These will be available in the Shared Groups field
for users to choose from when they share a device.
When you type a name for the group in the Group Names field and press the Enter key, the
group appears as a "tag" and is created in the system when the form is saved.
Each group name may not exceed 64 characters. A maximum of 32 group names may be
entered. The maximum character limit for the list is 320 characters (including comma
separators).
This feature requires AOS 6.4 or later.

Time Sharing Time-based sharing rules for this device. For more information, see "About AirGroup Time-
Based Sharing" on page 75.

Syntax Opens the help topic "AirGroup Time-Based Sharing Syntax Examples" on page 71

Account Activation

Options include: Activate the account immediately, at a preset interval of hours or days, at a
specified time, or leave the account disabled.
If you choose Activate at a specified time, the ActivationTime row is added to the form.
Click the button to open the calendar picker. In the calendar, use the arrows to select the
year and month, click the numbers in the Time fields to increment the hours and minutes,
then click a day to select the date.

Account Expiration

Options include: Never expire, expire at a preset interval of hours or days, or expire at a
specified time.
l If you choose any time in the future, the Expire Action row is added to the form.

Indicate the expiration action for the account—either delete, delete and log out, disable,
or disable and log out. The action will be applied at the time set in the Account Expiration
row.

l If you choose Account expires after, the ExpiresAfter row is added to the form.
Choose an interval of hours, days, or weeks. The maximum is two weeks.

l If you choose Account Expires at a specified time, the ExpirationTime row is added
to the form. In the calendar picker, use the arrows to select the year and month, click the
numbers in the Time fields to increment the hours and minutes, then click a day to
select the date.

Account Role Assigns the visitor’s role.

Terms of Use Click the terms of use link and read the agreement, then mark the check box to agree to
the terms.

Create Device Commits your changes and creates the device. The Account Details and print options are
displayed. For more information, see "Printing Device Details" on page 64.

Creating Devices During Self-Registration - MAC Only
This section describes how to configure a guest self-registration so that it creates a MAC device account. After
the guest is registered, future authentication can take place without the need for the guest to enter their
credentials. A registration can be converted to create a MAC device instead of standard guest credentials.

This requires a vendor to pass a MAC parameter in the redirect URL. ClearPass Guest does not support
querying the controller or DHCP servers for the client's MAC based on IP.

To edit the registration form fields, go to Configuration > Forms and Views. In the guest_register row,
click the Edit Fields link. The Customize Form Fields page opens. If you do not see mac or mac_auth in the list,
click the Customize fields link above the list. Click the Edit link in the field’s row. In the Define Custom Field
form, edit the registration form fields:

l Add or enable mac

n UI: Hidden field
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n Field Required: checked

n Validator: IsValidMacAddress

l Add or enable mac_auth

n UI: Hidden field

l Any other expiration options, role choice, surveys, and so on can be entered as usual.

Figure 7 Modify fields

l Edit the receipt form fields:

n Edit username to be a Hidden field

n Edit password to be a Hidden field

l Adjust any headers or footers as needed.

When the visitor registers, they should be able to still log in via the Log In button. The MAC will be passed as
their username and password via standard captive portal means.

The account will only be visible on the List Devices page.

If the guest logs out and reconnects, they should be immediately logged in without being redirected to the
captive portal page.

Creating Devices During Self-Registration - Paired Accounts
Paired accounts is a means to create a standard visitor account with credentials, but to have a MAC account
created in parallel that is directly tied to the visitor account. These accounts share the same role, expiration and
other properties.

This requires a vendor passing a mac parameter in the redirect URL. ClearPass Guest does not support
querying the controller or DHCP servers for the client's MAC based on IP.

To edit the registration form fields, go to Configuration > Forms and Views. In the guest_register row,
click the Edit Fields link. The Customize Form Fields page opens. If you do not see mac or mac_auth_pair in the
list, click the Customize fields link above the list. Click the Edit link in the field’s row. In the Define Custom
Field form, edit the registration form fields:

l Add or enable mac

n UI: Hidden field

n Field Required: optional

n Validator: IsValidMacAddress

l Add or enable mac_auth_pair
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n UI: Hidden field

n Initial Value: -1

l Any other expiration options, role choice, surveys and so on can be entered as usual.

You will see an entry under both List Accounts and List Devices. Each should have a View Pair action that
cross-links the two.

If you delete the base account, all of its pairings will also be deleted. If RFC-3576 has been configured, all pairs will be
logged out.

Creating Multiple Guest Accounts
The Create Multiple Guest Accounts form is used to create a group of visitor accounts.

To create multiple accounts, go to Guest > Create Multiple, or click the Create Multiple Guest Accounts
command link on the Guest Manager > Start Here page. The Create Multiple Guest Accounts form opens.

The Create Multiple Guest Accounts form (create_multi) can be customized by adding new fields, or modifying or
removing the existing fields. See "Customizing Guest Self-Registration" on page 235 for details about the
customization process. The default settings for this form are described below.

Field Description

Number of
Accounts (Required) Enter the number of accounts to create.

Account
Activation

You can select an activation time from this drop-down list. The guests' accounts cannot be used
before the activation time. Options include:
l Now
l Disable account
l Tomorrow
l Next Monday
l 1 hour from now

Table 10: The Create New Guest Account Form
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Field Description

l 1 day from now
l 1 week from now
l Activate at specified time...

Activation
Time

If you selected "Activate at specified time", use the calendar picker in this field to specify the date
and time. If no selection is made, the account will be enabled immediately.

Account
Expiration

You can select an expiration time from this drop-down list. The guests' accounts cannot be used
after the expiration time. Options include:
l Account will not expire
l Now
l Tonight
l Friday night
l 1 hour from now
l 1 day from now
l 1 week from now
l 30 days from now
l 90 days from now
l 180 days from now
l 1 year from now
l Account expires after...
l Account expires at specified time...

Expires
After

If you selected "Account expires after", use this drop-down list to specify a length of time. Options
include several intervals of hours, days, or weeks.

Expiration
Time

If you selected "Account expires at specified time", use the calendar picker in this field to specify the
date and time. If no selection is made, the account will not expire.

Expire
Action

(Required) Specify how the behavior of the expiration. Options include:
l Delete and log out at specified time
l Delete at specified time
l Disable and log out at specified time
l Disable at specified time
Be aware that a logout can only occur if the NAS is RFC-3576 compliant.

Account
Role

(Required) Specify the type of account the guest should have. Options include:
l Contractor
l Employee
l Guest

Notes You may enter notes about this guest account.

Terms of
Use (Required) You must select the check box in in this field in order to create the account.

Create
Accounts When your entries on the form are complete, click this button to create the guests' accounts.

A random username and password will be created for each visitor account. This is not displayed on this form,
but will be available on the guest account receipt. The default password length is six characters.

Creating Multiple Guest Account Receipts
After a group of guest accounts has been created, the details for the accounts are displayed.
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To print the receipts, select an appropriate template from the Open print window using template…
drop-down list. A new browser window opens with the Print dialog displayed.

To download a copy of the receipt information in CSV format, click the Save list for scratch cards (CSV
file) link. You will be prompted to either open or save the spreadsheet (CSV) file. The fields available in the CSV
file are:

l Number – The sequential number of the visitor account, starting at one.

l Username – The username for the visitor account.

l Password – The password for the visitor account. The default password length is six characters.

l Role – The visitor account’s role.

l Activation Time – The date and time at which the account will be activated, or N/A if there is no activation
time.

l Expiration Time – The date and time at which the account will expire, or N/A if there is no activation time.

l Lifetime – The account lifetime in minutes, or N/A if the account does not have a lifetime specified.
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l Successful – “Yes” if the account was created successfully, or “No” if there was an error creating the
account.

Creating a Single Password for Multiple Accounts
You can create multiple accounts that have the same password. In order to do this, you first customize the
Create Multiple Guest Accounts form to include the Password field.

To include the Password field on the Create Multiple Guest Accounts form:

1. Go to Configuration > Forms & Views. Click the create_multi row, then click its Edit Fields link. The
Customize Form Fields view opens, showing a list of the fields included in the Create Multiple Guest
Accounts form and their descriptions.

At this point, the Password field is not listed because the Create Multiple Guest Accounts form (create_
multi) has not yet been customized to include it. You will create it for the form in the next step.

2. Click on any field in the list to expand a row, then click the Insert After link (you can modify this placement
later). The Customize Form Field form opens.

3. In the Field Name row, choose password from the drop-down list. The form displays configuration
options for this field.

4. In the Field row, mark the Enable this field check box.

5. To adjust the placement of the password field on the Create Multiple Guest Accounts form, you may change
the number in the Rank field.

6. In the User Interface row, choose Password text field from the drop-down list. The Field Required
check box should now be automatically marked, and the Validator field should be set to IsNonEmpty.

7. Click Save Changes. The Customize Form Fields view opens again, and the password field is now included
and can be edited.

To create multiple accounts that all use the same password:

1. Go to Guest > Create Multiple. The Create Guest Accounts form opens, and includes the Visitor
Password field.
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2. In the Number of Accounts field, enter the number of accounts you wish to create.

3. In the Visitor Password field, enter the password that is to be used by all the accounts. The minimum
password length is six characters.

4. Complete the other fields with the appropriate information, then click Create Accounts. The Finished
Creating Guest Accounts view opens. The password and other account details are displayed for each
account.
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Exporting Guest Account Information
Guest account information may be exported to a file in one of several different formats.

To export a file with the current list of guest accounts, go to Guest > Export Accounts, or go to Guest
> Start Here and click the Export Guest Accounts command link. The Export Accounts page opens with
three options displayed. Click the appropriate command link to save a list of all guest accounts in comma-
separated values (CSV), tab-separated values (TSV), or XML format.
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The Export Accounts view (guest_export) may be customized by adding new fields, or by modifying or
removing the existing fields. See "Customizing Guest Self-Registration" on page 235 for details about this
customization process.

About CSV and TSV Exports
In CSV and TSV format, the following default fields are included in the export:

l Number – Sequential number of the guest account in the exported data

l User ID – Numeric user ID of the guest account

l Username – Username for the guest account

l Role – Role for the guest account

l Activation – Date and time at which the guest account will be activated, or “N/A” if there is no activation
time

l Expiration – Date and time at which the guest account will expire, or “N/A” if there is no expiration time

l Lifetime – The guest account’s lifetime in minutes after login, or 0 if the account lifetime is not set

l Expire Action – Number specifying the action to take when the guest account expires (0 through 4)

About XML Exports
The default XML format consists of a <GuestUsers> element containing a <GuestUser> element for each
exported guest account. The numeric ID of the guest account is provided as the “id” attribute of the
<GuestUser> element. This format is compatible with the ClearPass Policy Manager XML format for guest
users.

The values for both standard and custom fields for guest accounts are exported as the contents of an XML tag,
where the tag has the same name as the guest account field.

An example XML export is given below:
<?xml version="1.0" encoding="UTF-8" standalone="true"?>
<MyContents xmlns="http://www.example.com/myapiDefs/1.0">

<MyHeader version="6.0" exportTime="Sun, 16 Dec 2012 16:36:03 PST"/>
<GuestUsers>

<GuestUser guestType="USER" enabled="true" sponsorName="55480025"
expiryTime="2012-12-04 13:39:25" startTime="1969-12-31 16:00:00"
password="08654361" name="55480025">

<GuestUserTags tagValue="Hotspot Services self-provisioned guest account
Source IP: 10.11.10.254 MAC: unknown Plan: Free Access x 1 Transaction
Amount: $0.00 Invoice Number: P-15 Transaction ID: " tagName="notes"/>

<GuestUserTags tagValue="2" tagName="[Role ID]"/>
<GuestUserTags tagValue="1" tagName="do_expire"/>
<GuestUserTags tagValue="1" tagName="simultaneous_use"/>
<GuestUserTags tagValue="ff" tagName="Company Name"/>
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<GuestUserTags tagValue="2012-12-04 12:39:14" tagName="Create Time"/>
<GuestUserTags tagValue="fff@df" tagName="Email"/>
<GuestUserTags tagValue="ff" tagName="first_name"/>
<GuestUserTags tagValue="plan0" tagName="hotspot_plan_id"/>
<GuestUserTags tagValue="Free Access" tagName="hotspot_plan_name"/>
<GuestUserTags tagValue="ff" tagName="last_name"/>
<GuestUserTags tagValue="ff ff" tagName="Visitor Name"/>
<GuestUserTags tagValue="ff" tagName="zip"/>

</GuestUser>

Importing Guest Accounts
Guest accounts may be created from an existing list by uploading the list to ClearPass Guest.

To import a file with the current list of guest accounts, go to Guest > Import Accounts, or go to Guest
> Start Here and click the Import Guest Accounts command link. The Import Accounts page opens with the
first part of the form displayed, Upload User List.

The Upload User List form provides you with different options for importing guest account data.

To complete the form, you must either specify a file containing account information, or type or paste in the
account information to the Accounts Text area.

Select the Show additional import options check box to display the following advanced import options:

l Character Set: ClearPass Guest uses the UTF-8 character set encoding internally to store visitor account
information. If your accounts file is not encoded in UTF-8, the import may fail or produce unexpected
results if non-ASCII characters are used. To avoid this, you should specify what character set encoding you
are using.

l Import format: The format of the accounts file is automatically detected. You may specify a different
encoding type if automatic detection is not suitable for your data. The Import Format drop-down list
includes the following options:

n Automatically detect format (This default option recognizes guest accounts exported from ClearPass
Policy Manager in XML format)

n XML

n Comma separated values

n Tab separated values

Anexo 11 ITEM 01 (0592523)         SEI 0008478-63.2018.6.02.8000 / pg. 3079



n Pipe ( | ) separated values

n Colon ( : ) separated values

n Semicolon ( ; ) separated values

l Select the Force first row as header row check box if your data contains a header row that specifies the
field names. This option is only required if the header row is not automatically detected.

Click Next Step to upload the account data.

In step 2 of 3, ClearPass Guest determines the format of the uploaded account data and matches the
appropriate fields to the data. The first few records in the data are displayed, together with any automatically
detected field names.

In this example, the following data was used:
username,visitor_name,password,expire_time
demo005,Demo five,secret005,2011-06-10 09:00
demo006,Demo six,secret006,2011-06-11 10:00
demo007,Demo seven,secret007,2011-06-12 11:00
demo008,Demo eight,secret008,2011-06-13 12:00
demo009,Demo nine,secret009,2011-06-13 12:00
demo010,Demo ten,secret010,2011-06-13 12:00
demo011,Demo eleven,secret011,2011-06-13 12:00

Because this data includes a header row that contains field names, the corresponding fields were automatically
detected in the data:

Use the Match Fields form to identify which guest account fields are present in the imported data. You can
also specify the values to be used for fields that are not present in the data.
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To complete the Match Fields form, make a selection from each of the drop-down lists. Choose a column
name to use the values from that column when importing guest accounts, or select one of the other available
options to use a fixed value for each imported guest account.

Click the Next Step button to preview the final result. Import Step 3 of 3, the Import Accounts form, opens
and shows a preview of the import operation. The values of each guest account field are determined, and any
conflicts with existing user accounts are shown.

The icon displayed for each user account indicates if it is a new entry ( ) or if an existing user account will be
updated ( ).

By default, this form shows ten entries per page. To view additional entries, click the arrow button at the
bottom of the form to display the next page, or click the 10 rows per page drop-down list at the bottom of
the form and select the number of entries that should appear on each page.

Click the check box by the account entries you want to create, or click one of the following options to select the
desired accounts:

l Click the This Page link to select all entries on the current page.

l Click the All link to select all entries on all pages

l Click the None link to deselect all entries

l Click the New link to select all new entries
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l Click the Existing link to select all existing user accounts in the list.

Click the Create Accounts button to finish the import process. The selected items will be created or
updated. You can then print new guest account receipts or download a list of the guest accounts. See "Creating
Multiple Guest Account Receipts" on page 46 in this chapter for more information.

Managing Single Guest Accounts
Use the Manage Guest Accounts list view to work with individual guest accounts. To open the Manage Guest
Accounts list, go to Guest > Manage Accounts.

The Manage Guest Accounts list view opens.This view (guest_users) may be customized by adding new fields or
modifying or removing the existing fields. See "Customizing Fields" on page 206 for details about this
customization process. The default settings for this view are described below.

The Username, Role, State, Activation, and Expiration columns display information about the visitor
accounts that have been created:

l The value in the Expiration column is colored red if the account will expire within the next 24 hours. The
expiration time is additionally highlighted in boldface if the account will expire within the next hour.

l In addition, icons in the Username column indicate the account’s activation status:

n —Visitor account is active

n —Visitor account was created but is not activated yet

n —Visitor account was disabled by Administrator

n —Visitor account has expired

n —Visitor account was deleted
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You can use the Filter field to narrow the search parameters. You may enter a simple substring to match a
portion of the username or any other fields that are configured for search, and you can include the following
operators:

Operator Meaning Additional Information

= is equal to

You may search for multiple values when using the
equality (=) or inequality !=) operators. To specify multiple
values, list them separated by the pipe character ( | ).

For example, specifying the filter "role_id=2|3, custom_
field=Value" restricts the accounts displayed to those with
role IDs 2 and 3 (Guest and Employee), and with the field
named "custom_field" set to "Value".

!= is not equal to

> is greater than

>= is greater than or equal to

< is less than

<= is less than or equal to

~ matches the regular expression

!~ does not match the regular
expression

Table 11: Operators supported in filters

To restore the default view, click the Clear Filter link.

Use the paging control at the bottom of the list to jump forwards or backwards by one page, or to the first or
last page of the list. You can also click an individual page number to jump directly to that page.

When the list contains numerous user accounts, consider using the Filter field to speed up finding a specific user
account.

Use the Create tab to create new visitor accounts using the Create New Guest Account form. See
"Creating a Guest Account " on page 39 for details about this form.

Use the More Options tab for additional functions, including import and export of guest accounts and the
ability to customize the view.

Click a user account’s row to select it. You can then select from one of these actions:

l Reset password – Changes the password for a guest account. A new randomly generated password is
displayed on the Reset Password form. The default password length is six characters.

Click Update Account to reset the guest account’s password. A new account receipt is displayed,
allowing you to print a receipt showing the updated account details.
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l Change expiration – Changes the expiration time for a guest account.

This form (change_expiration) can be customized by adding new fields, or modifying or removing the existing fields.
See "Customizing Forms and Views" on page 212 for details about this customization process.

Select an option from the drop-down list to change the expiration time of the guest account.

Click Update Account to set the new expiration time for the guest account. A new account receipt is
displayed, allowing you to print a receipt showing the updated account details.

l Remove – Disables or deletes a guest account.

Select the appropriate Action radio button, and click Make Changes to disable or delete the account.

If you wish to have automatic disconnect messages sent when the enabled value changes, you can specify
this in the Configuration module. See "Configuring ClearPass Guest Authentication " on page 188.

l Activate – Re-enables a disabled guest account, or specifies an activation time for the guest account.

Select an option from the drop-down list to change the activation time of the guest account. To re-enable
an account that has been disabled, choose Now. Click Enable Account to set the new activation time for
the guest account. A new account receipt is displayed, allowing you to print a receipt showing the updated
account details.

l Edit – Changes the properties of a guest account.
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This form can be customized by adding new fields, or modifying or removing the existing fields. See "Customizing
Forms and Views" on page 212 for details about this customization process.

Click Update Account to update the properties of the guest account. A new account receipt is displayed,
allowing you to print a receipt showing the updated account details.

l Sessions – Displays the active sessions for a guest account. See "Active Sessions Management" on page
33 in this chapter for details about managing active sessions.

l Print – Displays the guest account’s receipt and the delivery options for the receipt. For security reasons,
the guest’s password is not displayed on this receipt. To recover a forgotten or lost guest account password,
use the Reset password link.

l Show Details—The row expands to display all the properties of the guest's account in a table, including
endpoint details. This option is only available to users whose operator profile includes the Show Details
privilege.
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Managing Devices
To view the list of current MAC devices, go to Guest > Manage Devices.

The Guest Manager Devices page opens.

All devices created by one of methods described in the following section are listed. Options on the form let you
change a device’s account expiration time; activate, remove, or edit the device; view active sessions or details
for the device; or print details, receipts, confirmations, or other information.

The MAC Address, Device Name, Expiration, Sponsor, and Sharing columns display information about the
device accounts that have been created:

l The value in the Expiration column is colored red if the device account will expire within the next 24 hours.
The expiration time is additionally highlighted in boldface if the device account will expire within the next
hour.

l In addition, icons in the MAC Address column indicate the device account’s activation status:

n —Device account is active

n —Device account was created but is not activated yet
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n —Device account was disabled by Administrator

n —Device account has expired

n —Device account was deleted

You can use the Filter field to narrow the search parameters. You may enter a simple substring to match a
portion of any fields that are configured for search, and you can include the following operators:

Operator Meaning Additional Information

= is equal to

You may search for multiple values when using the
equality (=) or inequality !=) operators. To specify
multiple values, list them separated by the pipe
character ( | ).

For example, specifying the filter "role_id=2|3,
custom_field=Value" restricts the accounts displayed
to those with role IDs 2 and 3 (Guest and Employee),
and with the field named "custom_field" set to
"Value".

!= is not equal to

> is greater than

>= is greater than or equal to

< is less than

<= is less than or equal to

~ matches the regular expression

!~ does not match the regular
expression

Table 12: Operators supported in filters

To restore the default view, click the Clear Filter link.

Use the paging control at the bottom of the list to jump forwards or backwards by one page, or to the first or
last page of the list. You can also click an individual page number to jump directly to that page.

To select a device, click the device you want to work with.

Changing a Device’s Expiration Date
To change a device’s expiration date, click the device’s row in the Guest Manager Devices list, then click its
Change expiration link. The row expands to include the Change Expiration form.
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1. In the Account Expiration row, choose one of the options in the drop-down list to set an expiration date:

l If you choose Account expires after, the Expires After row is added to the form. Choose an interval
of hours, days, or weeks from the drop-down list.

l If you choose Account Expires at a specified time, the Expiration Time row is added to the form.
Click the button to open the calendar picker. In the calendar, use the arrows to select the year and
month, click the numbers in the Time fields to increment the hours and minutes, then click a day to
select the date.

2. If you choose any option other than “will not expire” or “now” in the Account Expiration field, the Expire
Action row is added to the table. Use the drop-down list in this row to specify one of the following actions:
delete, delete and log out, disable, or disable and log out.

3. Click Update Account to commit your changes.

Disabling and Deleting Devices
To remove a device’s account by disabling or deleting it, click the device’s row in the Guest Manager Devices list,
then click its Remove link. The row expands to include the Remove Account form.

You may choose to either disable or delete the account. If you disable it, it remains in the device list and you
may activate it again later. If you delete the account, it is removed from the list permanently.

Activating a Device
To activate a disabled device’s account, click the device’s row in the Guest Manager Devices list, then click its
Activate link. The row expands to include the Enable Guest Account form.

1. In the Activate Account row, choose one of the options in the drop-down list to specify when to activate
the account. You may choose an interval, or you may choose to specify a time.

2. If you choose Activate at specified time, the Activation Time row is added to the form. Click the
button to open the calendar picker. In the calendar, use the arrows to select the year and month, click the
numbers in the Time fields to increment the hours and minutes, then click a day to select the date.

3. Click Enable Account to commit your changes.
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Editing a Device
To edit a device’s account, click the device’s row in the Guest Manager Devices list, then click its Edit link. The
row expands to include the Edit Device form. You can edit any of the device's properties.

Field Description

MAC Address The device's MAC address.

Device Name

The name for the device.
If you need to modify the configuration for expected separator format or case, go to
Administration > Plugin Manager > Manage Plugins and click the Configuration link
for the MAC Authentication Plugin.

AirGroup Enables AirGroup for the device. Configuration options are added to the form.

Ownership Specifies whether device ownership should be personal or shared. Personal devices are
automatically shared with the owner's other devices.

Shared With

Usernames of people who can share this device. Enter usernames as a comma-separated
list. To make the device available to all users, leave this field blank.
Each username may not exceed 64 characters. A maximum of 100 usernames may be
entered. The maximum character limit for the list is 1000 characters (including comma
separators).

Shared Locations

Locations where the device can be shared. When you type a location name in the Shared
Locations field and press the Enter key, the location appears as a "tag" and is created in the
system when the form is saved.
Each location name may not exceed 64 characters. A maximum of 100 location names may
be entered. The maximum character limit for the list is 1000 characters (including comma
separators).

Shared Roles User roles that can share this device. When you type a role name in the Shared Roles field

Table 13: New Device
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Field Description

and press the Enter key, the role appears as a "tag" and is created in the system when the
form is saved.
Each role name may not exceed 64 characters. A maximum of 100 role names may be
entered. The maximum character limit for the list is 1000 characters (including comma
separators).

Shared Groups

User groups that can share this device. These will be available in the Shared Groups field
for users to choose from when they share a device.
When you type a name for the group in the Group Names field and press the Enter key, the
group appears as a "tag" and is created in the system when the form is saved.
Each group name may not exceed 64 characters. A maximum of 32 group names may be
entered. The maximum character limit for the list is 320 characters (including comma
separators).

Time Sharing Time-based sharing rules for this device. For more information, see "About AirGroup Time-
Based Sharing" on page 75.

Syntax Opens the help topic "AirGroup Time-Based Sharing Syntax Examples" on page 71.

Account Activation

Options include: Activate the account immediately, at a preset interval of hours or days, at a
specified time, or leave the account disabled.
If you choose Activate at a specified time, the ActivationTime row is added to the form.
Click the button to open the calendar picker. In the calendar, use the arrows to select the
year and month, click the numbers in the Time fields to increment the hours and minutes,
then click a day to select the date.

Account Expiration

Options include: Never expire, expire at a preset interval of hours or days, or expire at a
specified time.
l If you choose any time in the future, the Expire Action row is added to the form.

Indicate the expiration action for the account—either delete, delete and log out, disable,
or disable and log out. The action will be applied at the time set in the Account Expiration
row.

l If you choose Account expires after, the ExpiresAfter row is added to the form.
Choose an interval of hours, days, or weeks. The maximum is two weeks.

l If you choose Account Expires at a specified time, the ExpirationTime row is added
to the form. In the calendar picker, use the arrows to select the year and month, click the
numbers in the Time fields to increment the hours and minutes, then click a day to
select the date.

Account Role Assigns the visitor’s role.

Notes Optional additional information.

Update Device Commits your changes and updates the device. The Updated Device Details and print
options are displayed.

Viewing Current Sessions for a Device
To view any sessions that are currently active for a device, click the Sessions link in the device’s row on the
Guest Manager Devices form. The Active Sessions list opens. For more information, see "Active Sessions
Management" on page 33.
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Printing Device Details
To print details, receipts, confirmations, or other information for a device, click the device’s row in the Guest
Manager Devices list, then click its Print link. The row expands to include the Account Details form and a drop-
down list of information that can be printed for the device.

Choosing an option in the Open print window using template drop-down list opens a print preview
window and the printer dialog. Options include account details, receipts in various formats, a session expiration
alert, and a sponsorship confirmation notice.

Viewing Device Details
l Show Details—The row expands to display all the properties of the device's account in a table. This option

is only available to users whose operator profile includes the Show Details privilege.

Managing Multiple Guest Accounts
Use the Bulk Edit Accounts list view to work with multiple guest accounts. To open the Bulk Edit Accounts
list, go to Guest > Manage Multiple Accounts.

This view (guest_multi) may be customized by adding new fields or by modifying or removing the existing
fields. See "Customizing Guest Self-Registration" on page 235 for details about this customization process. The
default settings for this view are described below.
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The Username, Role, State, Activation, Expiration, and Lifetime columns display information about the
visitor accounts that have been created:

l The value in the Expiration column is colored red if the visitor account will expire within the next 24 hours.
The expiration time is additionally highlighted in boldface if the visitor account will expire within the next
hour.

l In addition, icons in the Username column indicate the account’s activation status:

n —Visitor account is active

n —Visitor account was created but is not activated yet

n —Visitor account was disabled by Administrator

n —Visitor account has expired

You can use the Filter field to narrow the search parameters. You may enter a simple substring to match a
portion of the username or any other fields that are configured for search, and you can include the following
operators:

Operator Meaning Additional Information

= is equal to

You may search for multiple values when using the
equality (=) or inequality !=) operators. To specify multiple
values, list them separated by the pipe character ( | ).

For example, specifying the filter "role_id=2|3, custom_
field=Value" restricts the accounts displayed to those with
role IDs 2 and 3 (Guest and Employee), and with the field
named "custom_field" set to "Value".

!= is not equal to

> is greater than

>= is greater than or equal to

< is less than

<= is less than or equal to

~ matches the regular expression

!~ does not match the regular
expression

Table 14: Operators supported in filters

To restore the default view, click the Clear Filter link.

Use the paging control at the bottom of the list to jump forwards or backwards by one page, or to the first or
last page of the list. You can also click an individual page number to jump directly to that page.

To select guest accounts, click the accounts you want to work with. You may click either the check box or the
row to select a visitor account. To select or unselect all visible visitor accounts, click the check box in the header
row of the table.

Use the selection row at the top of the table to work with the current set of selected accounts. The number of
currently selected accounts is shown. When a filter is in effect, the “All Matching” link can be used to add all
pages of the filtered result to the selection.
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Use the Create tab to create new visitor accounts using the Create Multiple Guest Accounts form. See
"Managing Multiple Guest Accounts " on page 64 in this chapter for details about this form.

Use the Delete tab to delete the visitor accounts that you have selected. This option is not active if there are
no visitor accounts selected.

Use the Edit tab to make changes to multiple visitor accounts at once. This option is not active if there are
no visitor accounts selected.

The Edit Guest Accounts form may be customized by adding new fields, or modifying or removing the existing
fields. See "Customizing Guest Self-Registration" on page 235 for details about this customization process. This
is the guest_multi_form form.

The Results tab will be automatically selected after you have made changes to one or more guest accounts.
You can create new guest account receipts or download the updated guest account information. See "Creating
Multiple Guest Account Receipts" on page 46 in this chapter for more information.

The More Options tab includes the Choose Columns command link. You can click this link to open the
Configuration module’s Customize View Fields form, which may be used to customize the Edit Guest Accounts
view.

AirGroup Device Registration
AirGroup allows users to register their personal mobile devices on the local network and define a group of
friends or associates who are allowed to share them. If AirGroup Services is enabled, AirGroup administrators
can provision their organization’s shared devices and manage access, and AirGroup operators can register and
provision a limited number of their own personal devices for sharing. For complete AirGroup deployment
information, refer to the AirGroup sections in the ArubaOS User Guide and the ClearPass Policy Manager
documentation.
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Registering Groups of Devices or Services
This functionality is only available to AirGroup administrators.

To register and manage an organization’s shared devices and configure device access, log in as the AirGroup
administrator and go to Guest > Create Device. The Register Shared Device form opens.

1. In the Device Name field, enter the name used to identify the device.

2. In the Device Type field, use the drop-down list to select the device type.

3. In the MAC Address field, enter the device’s MAC address.

4. In the Shared Locations field, enter the locations where the device can be shared. To allow the device to
be shared with all locations, leave this field blank.

Each location name may not exceed 64 characters. A maximum of 100 location names may be entered. The
maximum character limit for the list is 1000 characters (including comma separators).

Each location is entered as a tag=value pair describing the MAC address of the access point (AP) closest to
the registered device. Use commas to separate the tag=value pairs in the list. Tag=value pair formats are
shown in the following table:

AP Type Tag=Value Format

Name-based AP ap-name=<name>

Group-based AP ap-group=<group>

FQLN-based AP fqln=<fqln>

Table 15: Tag=Value Pair Formats

l AP FQLNs should be configured in the format <ap name>.<floor>.<building>.<campus>

l Floor names should be in the format floor <number>

l The <ap-name> should not include periods ( . )

Example:
AP105-1.Floor 1.TowerD.Mycompany

5. In the Shared With field, enter the usernames of your organization’s staff or students who are allowed to
use the device. Use commas to separate usernames in the list.
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Each username may not exceed 64 characters. A maximum of 100 usernames may be entered. The
maximum character limit for the list is 1000 characters (including comma separators).

l If the Share With field is left blank, this device can be accessed by all devices.

l If users are entered in the Shared With field, the device can only be accessed by the specified users.

6. In the Shared Roles field, enter the user roles that are allowed to use the device. Use commas to separate
the roles in the list.

Each role name may not exceed 64 characters. A maximum of 100 role names may be entered. The
maximum character limit for the list is 1000 characters (including comma separators).

l To make the device available to all roles, leave this field blank.

l If roles are entered in the Shared Roles field, the device can only be accessed by users with matching
roles.

7. Click Register Shared Device. The Finished Creating Guest Account page opens. This page displays
Account Details and provides printer options.

To view and edit your organization’s shared AirGroup devices:

1. Go to Guest > List Devices, or click the Manage my AirGroup Devices link on the Create AirGroup
Device page. The AirGroup Devices page opens. This page lists all the shared AirGroup devices for the
organization. You can remove a device; edit a device’s name, MAC address, shared locations, shared-user list,
or shared roles; print device details; or add a new device.

2. To work with a device, click the device’s row in the list. The form expands to include the Remove, Edit, and
Print options.
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3. To edit properties of a shared device, click the Edit link for the device. The row expands to include the Edit
Shared Device form. You can modify the device’s name, MAC address, shared locations, group of users, and
shared roles.

4. When your edits are complete, click Save Changes.

Registering Personal Devices
This functionality is available to AirGroup operators.

To register your personal devices and define a group who can share them:

1. Log in as the AirGroup operator and go to Guest > Create Device. The Register Device form opens.

2. In the Your Name field, enter your username for your organization.

3. In the Device Name field, enter the name used to identify the device.

4. In the Device Type drop-down list, select the device type.

5. In the MAC Address field, enter the device’s MAC address.

6. In the Shared With field, enter the usernames of your friends or colleagues who are allowed to use the
device. Use commas to separate usernames in the list. You may enter up to ten usernames.
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l If the Shared With field is left blank, this device can only be accessed by devices registered by the same
operator or with a dot1x username that matches the operator’s name.

l If users are entered in the Shared With field, the device can be accessed by the device owner and by the
specified users.

7. Click Register Device. The Finished Creating Guest Account page opens. This page displays Account Details
and provides printer options.

To view and edit your personal AirGroup devices, go to Guest > List Devices, or click the Manage my
AirGroup Devices link on the Create AirGroup Device page. The List Device page lets you remove a device;
edit a device’s name, MAC address, or shared-user list; print device details; or add a new device.

To view and edit your personal AirGroup devices:

1. Go to Guest > List Devices, or click the Manage my AirGroup Devices link on the Create AirGroup
Device page. The AirGroup Devices page opens. This page lists all your personal AirGroup devices. You can
remove a device; edit a device’s name, MAC address, or shared-user list; print device details; or add a new
device.

2. To work with a device, click the device’s row in the list. The form expands to include the Remove, Edit, and
Print options.

3. To edit properties of a device, click the Edit link for the device. The row expands to include the Edit Device
form. You can modify the device’s name, MAC address, and group of users.

4. When your edits are complete, click Save Changes.
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AirGroup Time-Based Sharing Syntax Examples
This section provides examples and discussions of syntax for time-based sharing policies for AirGroup shared
devices.

For information on using time-based sharing for AirGroup, see "About AirGroup Time-Based Sharing" on page
75. For supplemental time-based syntax information, see "Time-Based Syntax Reference" on page 73.

Example:
periodic Monday 9am to 10am shared users A, B

The device is shared with users A and B, from 9am to 10am every Monday (relative to the server's current
time zone). Outside of this time slot, the device is not shared (except as otherwise controlled by AOS).

Example:
periodic Monday 9:00 to 10:30 shared users A, B
periodic Monday 12:00 to 13:30 shared users A, B
periodic Monday 15:00 to 16:30 shared users C, D

The device is shared with users A and B, from 9am to 10:30am and from noon to 1:30pm every Monday
(relative to the server's current time zone). From 3pm to 4:30pm, the device is shared with users C and D.

Outside of these two time slots, the device is not shared.

With periodic, times may be specified either in 24-hour format (hh:mm, from 0:00 to 24:00), or in 12-hour
format (hh:mm and am or pm).

Don't specify overlapping time ranges with periodic rules; this can lead to unexpected results.

The synonyms rep, repeat or repeating may also be used in place of period or periodic. All of these
terms are treated identically.

Example:
default allow
periodic mon 9am to 10am shared users A, B

As in the first example, the device is shared with users A and B, from 9am to 10am every Monday. Outside
of this time slot, the device is shared as specified by the other sharing state fields (shared users, locations,
roles and/or groups). This is the meaning of the default allow statement.

If default allow is not specified, the normal behavior is default deny, which is the same as in the first
example. Note that with default deny in effect, the AirGroup time sharing policy will override any other
sharing rules that are specified, for as long as the time sharing policy is in effect.

Two and three-character shortened forms of weekdays are acceptable (e.g. "Mon" or "Mo" can be used for
Monday, "Tue" or "Tu" for Tuesday, etc.) Case is not significant in the time sharing policy, so "Mon", "MON",
and "mon" are all equivalent ways to specify "Monday".

Example:
default deny
not after 01-Feb-2014
periodic mon 9am to 10am shared users A, B

The device is shared with users A and B, from 9am to 10am every Monday. The not after date sets the end
of the time sharing policy. Monday, January 27, 2014 is the last day that this time sharing policy will take
effect.

After 10am on this date, the time sharing policy is no longer in effect; any other sharing rules that have
been specified will then take effect.
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Example:
default deny
not before 1/1/14
not after 01-Feb-2014
periodic mon 9am to 10am shared users A, B

The device is shared with users A and B, from 9am to 10am every Monday. The not before date sets the
beginning of the time sharing policy. In this case, Monday, January 6, 2014 is the first day that this time
sharing policy will take effect.

Prior to 9am 6 January 2014, the device is not shared (due to the default deny).

After 10am on 27 January 2014, the time sharing policy is no longer in effect; any other sharing rules that
have been specified will then take effect.

Example:
time zone America/Los_Angeles
periodic Monday 9am to 10am shared users A, B

The device is shared with users A and B, from 9am to 10am every Monday (relative to the U.S. Pacific time
zone). Daylight savings time rules are observed; the time period 9am to 10am is always relative to that
time zone.

Example:
periodic mon tue wed thu fri 9am to 10am shared users A, B

The device is shared with users A and B, from 9am to 10am every weekday (Monday, Tuesday, Wednesday,
Thursday and Friday).

Example:
periodic weekdays 9am to 10am shared users A, B

weekday or weekdays can be used as a synonym for "Monday Tuesday Wednesday Thursday Friday".
Similarly, weekend or weekends can be used as a synonym for "Saturday Sunday".

Example:
on Sep 16 9:00 to 13:00 shared location AP-Name=1341-ap01 shared group ABC shared role Some
Role shared user user02, user03, "user04", 'user05'

The device is shared with a single access point named 1341-ap01, a single group named ABC, a single role
named SomeRole, and 4 users named user02,user03, user04, and user05.

Note the quotes are not considered to be part of the user names user04 and user05. (In this case, the
quotes are redundant as there is no space or comma that requires quoting.)

No time zone is specified, so the date and time are determined relative to the server's time zone.

No year is specified, so the server's current year is used. In particular, after September 16 of any year, this
rule will have no effect until the following year.

Example:
default allow
periodic 0:00 to 24:00 shared roles default_role
periodic mon 9am to 5pm shared roles other_role

The device is normally shared ("default allow") with a single role named default_role ("periodic 0:00 to
24:00 shared roles default_role").

On Monday from 9am to 5pm, the device is shared with a different role named other_role.

Note that even though the time ranges overlap, the sharing policies are completely distinct; on Mondays
from 9am to 5pm, the role default_role will NOT have access to the device, because a different sharing rule
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is in effect. (The rule could instead have been written "periodic mon 9am to 5pm shared roles default_role,
other_role" if this was the desired result.)

This example shows how to use an overlapping time range: place the most general time range first, with
more specific time ranges later. In particular, reversing the order of the periodic statements will not work.

Example:
default deny
periodic 9:00 to 22:00 shared roles default_role
no periodic thu 9:00 to 17:00
periodic fri 9:00 to 17:00 not shared

This example shows how to share a device with a basic policy, and demonstrates two ways to disable
sharing for a subset of the time period.

The device will be shared with a single role named default_role, from 9:00 to 22:00 each day. ("periodic
9:00 to 22:00 shared roles default_role").

On Thursday, the device is not shared between 9:00 and 17:00.

On Friday, the device is not shared between 9:00 and 17:00.

Example:
default allow
periodic 9:00 to 22:00 shared roles default_role
no periodic thu 9:00 to 17:00
periodic fri 9:00 to 17:00 not shared

This example is similar to the previous example; the device is not shared on Thursday and Friday between
9:00 and 17:00.

The difference is after 22:00 and before 9:00: in the previous example, the device is not shared during this
time period, whereas with default allow the other AirGroup sharing rules will take effect (any shared users,
roles, groups or locations that have been defined for the device).

Time-Based Syntax Reference
This reference describes the syntax used for time formats in time-based sharing rules. It supplements the
examples for AirGroup time-based sharing by user groups discussed in "AirGroup Time-Based Sharing Syntax
Examples" on page 71. For more information on using time-based sharing with AirGroup, see "About AirGroup
Time-Based Sharing" on page 75.

The syntax for AirGroup time-based sharing policies supports all the default time-based ACL rules specified in
TimeRangeACL. This ACL is a sequence of rules, one per line, according to the following syntax:

l default allow|deny

Specifies the default behavior for unmatched times; this is 'allow' only if no 'periodic' or 'absolute' rules are
specified, otherwise it is 'deny'. Use 'default allow' if the remaining rules exclude times, otherwise use
'default deny' if the remaining rules are to include times. This rule may only be used once.

l [time] zone default|server|...

Specifies the time zone to use for matching times and specifying the time of day. If unset, the current time
zone setting is used (note that this may vary due to operator and/or profile settings). If the value "default"
or "server" is specified, the system's time zone is used. Otherwise, the named time zone is used. This rule
may only be used once, and must be before any rules specifying a time interval.

l [not] period(ic) [day-list] hh:mm to [day] hh:mm

Specifies a periodic or daily interval. Recognized days include Sunday, Monday, Tuesday, Wednesday,
Thursday, Friday, Saturday and 3-letter abbreviations; the tokens "weekends" and "weekdays" may also be
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used. Without a day-list, all days of the week are matched. Time may be specified in 12 or 24 hour format,
with the special time 24:00 indicating the end of the day.

Example: periodic monday 8:00 to friday 17:00 matches between 8am and 5pm, Monday through
Friday.

Example: periodic weekdays 8:00 to 17:00 specifies the same thing as the example in the previous line.

Example: periodic wed 11am to 11pm matches between 11:00 and 23:00 on a Wednesday.

Example: periodic weekend 0:00 to 24:00 matches any time on a Saturday or Sunday.

Example: periodic saturday sunday 0:00 to 24:00 specifies the same thing as the example in the
previous line.

The 'not' keyword may be specified to invert the allow/deny decision.

Example: default allow; not period 23:00 to 6:00 (on 2 separate lines) allows access, except between
11pm and 6am.

Example: period 6:00 to 23:00 is equivalent to the example in the previous line.

l not before [date-and-time]

Specifies an absolute time before which access will always be rejected.

Example: not before 2010-07-01 09:00 matches after 9am on 1 July 2010.

l not after [date-and-time]

Specifies an absolute time after which access will always be rejected.

Example: not after 2011-01-01 00:00 matches before midnight on New Year's Day 2011.

l [not] abs(olute) [start-date-and-time] to [end-date-and-time]

Specifies a start and end interval. The date and time is a format recognized by strtotime(). Times between
the start and end point are matched. The 'not' keyword may be specified to invert the allow/deny decision.

Example: absolute December 25 to December 26 matches all day on Christmas Day each year. (This does
not match on December 26 as midnight on this date is the endpoint of the interval.)

A blank time ACL means "all times are allowed".

The following examples give common usage:

l 8:00 to 18:00 - allows access 8am to 6pm, every day, but not outside those times

l weekdays 9am to 5pm - allows access 9am to 5pm, Monday through Friday, but not outside those times

l weekdays 9am to 5pm

weekends 10am to 4pm - allows access 9am to 5pm, Monday through Friday, with reduced hours on
Saturday and Sunday

Annual recurrences may be specified:

l weekdays 9am to 5pm

not absolute December 25 to December 26 - allows access 9am to 5pm, Monday through Friday, but not
on Christmas Day

Less common cases:

l default allow

not 23:00 to 6:00 - allows access, except between 11pm and 6am daily

l 9:00 to 18:00

not before 2010-02-01 - allows daily access between 9am and 6pm, starting on February 1, 2010

Anexo 11 ITEM 01 (0592523)         SEI 0008478-63.2018.6.02.8000 / pg. 3101



l time zone Etc/GMT

9:00 to 18:00

not before 2010-02-01 - allows daily access between 9am and 6pm, starting on February 1, 2010, in the
GMT time zone (useful if server is in a different time zone)

About AirGroup Time-Based Sharing
This section discusses time-based sharing policies for an AirGroup shared device.

For information on the syntax for time-based sharing policies for a AirGroup shared devices, see "AirGroup
Time-Based Sharing Syntax Examples" on page 71

Time-based sharing is used in settings where an organization's shared devices are made available to groups of
users according to a regular schedule, and device access is configured by group at the user level—for example:

l A university classroom or laboratory is used by a first-year physics class on Mondays, Wednesdays, and
Fridays, by a group of researchers on Tuesdays and Thursdays, and for visiting speakers every other
Saturday.

l A convention center has several major exhibitors who each hold an annual event, and who reserve their
customary section of the convention center several years in advance.

In cases like this, you can enter rules to define the schedule on which shared devices in an area will be available
to certain groups. You can also specify times when a device will not be available. This is a time-based sharing
policy.

Device association is dynamic: When a shared device is available to a group, any user with that group attribute
can access the device. When the user is no longer a member of the group (for example, at the end of the
semester), they no longer have access, but the time-based sharing policy remains in effect and new users who
are assigned the group attribute can access the shared device.

Basics of Time-Based Sharing Setup
When you create a device, enable it for AirGroup Services, and configure it as a shared device, you also have the
option to specify time-based sharing (time fencing) for the device.

You first use the Administration > AirGroup Services > Configure form to create the groups who can
share devices. When you type a name for the group in the Group Name field, press the Enter key, and click
Save, the group is created in the system and appears as a "tag".

On the Guest > Create Device or Guest > List Devices > Edit forms, the shared user groups you created
are then available for selection when you click in the Shared Groups field. (This feature requires AOS 6.4 or
later)
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On the same screen, the next step is then to enter the rules for the time-based sharing policy, using the group
names you created. For more information, see "AirGroup Time-Based Sharing Syntax Examples" on page 71

MAC Authentication in ClearPass Guest
ClearPass Guest supports a number of options for MAC Authentication and the ability to authenticate devices.

The advanced features described in this section generally require a WLAN capable of MAC authentication with
captive portal fallback. Please refer to the Aruba WLAN documentation for setting up the controller
appropriately.

To verify that you have the most recent MAC Authentication Plugin installed and enabled before you configure
these advanced features, go to Administration > Plugin Manager . For information on plugin management,
see "Plugin Manager" on page 443.

MAC Address Formats
Different vendors format the client MAC address in different ways—for example:

l 112233AABBCC

l 11:22:33:aa:bb:cc

l 11-22-33-AA-BB-CC

ClearPass Guest supports adjusting the expected format of a MAC address. To configure formatting of
separators and case in the address, as well as user detection and device filtering for views, go to
Administration > Plugin Manager and click the Configuration link for the MAC Authentication plugin.
The MAC Authentication Configuration page opens.

Figure 8 MAC Authentication Plugin—Configuration

On the controller, the fields look as follows:

Figure 9 MAC Authentication Profile

Automatically Registering MAC Devices in ClearPass Policy Manager
If ClearPass Policy Manager is enabled, you can configure a guest MAC address to be automatically registered
as an endpoint record in ClearPass Policy Manager when the guest uses a Web login page or a guest self-
registration workflow. This customization option is available if a valid Local or RADIUS pre-authentication check
was performed.
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To configure auto-registration for an address through a Web login page:

1. Go to Configuration > Pages > Web Logins, click the row of the page you wish to configure, then click its
Edit link. The RADIUS Web Login Editor form opens.

2. Scroll down to the Post-Authentication area.

3. In the Policy Manager row, mark the check box to register the guest’s MAC address with ClearPass Policy
Manager. The Advanced row is added to the form.

4. In the Advanced row, mark the check box to enable advanced options in ClearPass Policy Manager. The
Endpoint Attributes row is added to the form.

5. In the Endpoint Attributes row, enter name|value pairs for the user fields and Endpoint Attributes to be
passed.

6. Click Save Changes to complete this configuration and continue with other tasks, or click Save and
Reload to proceed to Policy Manager and apply the network settings.

Importing MAC Devices
The standard Guest > Import Accounts form supports importing MAC devices. At a minimum the following
two columns are required: mac and mac_auth.
mac_auth,mac,notes
1,aa:aa:aa:aa:aa:aa,Device A
1,bb:bb:bb:bb:bb:bb,Device B
1,cc:cc:cc:cc:cc:cc,Device C

Any of the other standard fields can be added similar to importing regular guests.

Advanced MAC Features
This section describes some advanced features for MAC authentication.

User Detection on Landing Pages
When mac is passed in the redirect URL, the user is detected and a customized message displays on the
landing page.

To use this feature:

1. Go to Administration > Plugin Manager: MAC Authentication: Configuration and enable MAC
Detect.

2. Edit the header of your redirect landing page (login or registration) and include the following:
<p>{if $guest_receipt.u.visitor_name}
Welcome back to the show, {$guest_receipt.u.visitor_name|htmlspecialchars}!
{else}
Welcome to the show!
{/if}</p>
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3. For debugging purposes, include the following to see all the fields available:
{dump var=$guest_receipt export=html}

Click-Through Login Pages
A click-through login page will present a splash or terms screen to the guest, yet still provide MAC-auth style
seamless authentication. Under this scenario, you could have people create an account, with a paired MAC, yet
still have them click the terms and conditions on every new connection.

To use this feature:

1. Disable MAC authentication on the controller.

2. Go to Administration > Plugin Manager: MAC Authentication: Configuration and enable MAC
Detect.

3. Create a Web Login. Include the following settings:

l Authentication: Anonymous

l Anonymous User: _mac (_mac is a special secret value)

l Pre-Auth Check: Local

l Terms: Require a Terms and Conditions confirmation

4. Set the Web login as your landing page and test. Using a registered device the 'Log In' button should be
enabled, otherwise it will be disabled.

5. You might also want to add a message so visitors get some direction:
<p>{if $guest_receipt.u.username}
{if $guest_receipt.u.visitor_name}
Welcome back, {$guest_receipt.u.visitor_name|htmlspecialchars}!
{else}
Welcome back.
{/if}
Please accept the terms before proceeding.

{else}
You need to register...
{/if}</p>

6. You can hide the login form by having the final line of the header be:
{if !$guest_receipt.u.username}<div style="display:none">{/if}

and the first line of the footer be:
{if !$guest_receipt.u.username}</div>{/if}
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Chapter 4
Onboard

Onboarding is the process of preparing a device for use on an enterprise network by creating the appropriate
access credentials and setting up the network connection parameters. ClearPass Onboard automates 802.1X
configuration and provisioning for “bring your own device” (BYOD) and IT-managed devices across wired,
wireless, and virtual private networks (VPNs).

ClearPass Onboard includes the following key features:

l Automatic configuration of network settings for wired and wireless endpoints

l Provisioning of unique device credentials for BYOD and IT-managed devices

l Support for Windows, Mac OS X, iOS, and Android devices

l Ability to revoke unique credentials on a specific user's device

l ClearPass Profile for identifying device type, manufacturer, and model

Accessing Onboard
To access the device provisioning features of ClearPass Onboard, click the Onboard link in the left navigation.
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About ClearPass Onboard
ClearPass Onboard automates 802.1X configuration and provisioning for “bring your own device” (BYOD) and
IT-managed devices—Windows, Mac OS X, iOS and Android—across wired, wireless, and virtual private
networks (VPNs).

ClearPass Onboardincludes the following key features:

l Automatic configuration of network settings for wired and wireless endpoints.

l Provisioning of unique device credentials for BYOD and IT-managed devices.

l Support for Windows, Mac OS X, iOS, and Android devices.

l Enables the revocation of unique credentials on a specific user’s device.

l Leverages ClearPass Profile to identify device type, manufacturer, and model.

This section provides the following important information about ClearPass Onboard:

l "Onboard Deployment Checklist " on page 81

l "Onboard Feature List " on page 82

l "Supported Platforms" on page 83

l "Public Key Infrastructure for Onboard" on page 84

l "Revoking Unique Device Credentials" on page 85

l "Network Requirements for Onboard" on page 86
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l "Network Architecture for Onboard" on page 88

l "The ClearPass Onboard Process" on page 90

l "Configuring the User Interface for Device Provisioning" on page 94

l "Onboard Troubleshooting" on page 95

Onboard Deployment Checklist
Table 16 lists planning, configuration, and testing procedures. Use this checklist to complete your Onboard
deployment.

Onboard events are stored in the Application Log for seven days by default. After seven days, significant
runtime events are listed in the Audit Viewer in ClearPass Policy Manager’s Monitoring module. Onboard events
that are listed include:

l Changing the CA certificate

l Issuing a new certificate

l Signing a certificate signing request

l Revoking a certificate

l Deleting a certificate

l Importing a trusted certificate

l Uploading a code-signing or other certificate

Deployment Step Reference

Planning and Preparation

Review the Onboard feature list to identify the major areas of
interest for your deployment. "Onboard Feature List " on page 82

Review the list of platforms supported by Onboard, and identify the
platforms of interest for your deployment. "Supported Platforms" on page 83

Review the Onboard public key infrastructure, and identify any
certificate authorities that will be needed during the deployment.

"Public Key Infrastructure for Onboard" on
page 84

Review the network requirements and the network architecture
diagrams to determine how and where to deploy the Onboard
solution.

Refer to the ClearPass Policy Manager
documentation, and "Network Architecture
for Onboard" on page 88 in this chapter

Configuration

Configure the hostname and networking properties of the Onboard
provisioning server.
l DNS is required for SSL.
l Ensure that hostname resolution will work for devices being

provisioned.

Refer to the ClearPass Policy Manager
documentation

Configure SSL certificate for the Onboard provisioning server.
A commercial SSL certificate is required to enable secure device
provisioning for iOS devices.

Refer to the ClearPass Policy Manager
documentation

Table 16: Onboard Deployment Checklist
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Deployment Step Reference

Configure the Onboard certificate authority.
l Decide whether to use the Root CA or Intermediate CA mode of

operation.
Create the certificate for the certificate authority.

"Certificate Authorities " on page 96

Configure device provisioning settings.
l Select certificate options for device provisioning.
Select which device types should be supported.

"About Configuring Provisioning Settings " on
page 168

Configure network settings for device provisioning.
l Set network properties.
l Upload 802.1X server certificates.
Set device-specific networking settings.

"Network Settings " on page 129

Configure networking equipment for non-provisioned devices.
l Set authentication for the provisioning SSID, if required.
Ensure the captive portal redirects non-provisioned devices to the
device provisioning page.

"Network Requirements for Onboard" on
page 86

Configure networking equipment to authenticate provisioned
devices.
l Ensure 802.1X authentication methods and trust settings are

configured correctly for all EAP types that are required.
Configure OCSP or CRL on the authentication server to check for
client certificate validity.

"Network Requirements for Onboard" on
page 86

Configure the user interface for device provisioning.
l Set display options for iOS devices.
l Set user interface options for other Onboard devices.
Setup the device provisioning Web login page.

"Configuring the User Interface for Device
Provisioning" on page 94

Testing and Verification

Test device provisioning.
l Verify that each type of device can be provisioned successfully.
Verify that each type of device can join the provisioned network
and is authenticated successfully.

Test device revocation.
l Revoke a device’s certificate.
l Verify that the device is no longer able to authenticate.
Verify that re-provisioning the device fails.

Onboard Feature List
The following features are available in ClearPass Onboard.

Feature Uses

Automatic configuration of network settings
for wired and wireless endpoints.

l Configure wired networks using 802.1X
l Configure Wi-Fi networks using either 802.1X or pre-shared key

(PSK)
l Configure trusted server certificates for 802.1X
l Configure Windows-specific networking settings

Table 17: OnboardFeatures
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Feature Uses

l Configure HTTP proxy settings for client devices (Android, OS X
only)

Secure provisioning of unique device
credentials for BYOD and IT-managed
devices.

l Configure EAP-TLS and PEAP-MSCHAPv2 without user
interaction

l Revoke unique device credentials to prevent network access

Support for Windows, Mac OS X, iOS, and
Android devices.

l Leverage ClearPass Profiling to identify device type,
manufacturer, and model

l Control the user interface displayed during device provisioning

Certificate authority enables the creation
and revocation of unique credentials on a
specific user’s device.

l Root and intermediate CA modes of operation
l Supports SCEP enrollment of certificates
l Supports CRL generation to list revoked certificates
l Supports OCSP responder to query for certificate status
l Approve certificate signing request
l Reject certificate signing request
l Sign certificate from uploaded certificate signing request (CSR)
l Issue certificate
l Revoke certificate
l Display certificates
l Export certificate
l Renew root certificate

Provision additional settings specific to iOS
devices

l Exchange ActiveSync
l Passcode policy
l VPN settings

Supported Platforms
The platforms supported by ClearPass Onboard and the version requirements for each platform are
summarized in the following table.

Platform Example Devices Version Required for Onboard Support Notes

Apple iOS
iPhone
iPad
iPod Touch

iOS 4
iOS 5 1, 3

Apple Mac OS X MacBook Pro
MacBook Air

Mac OS X 10.8 “Mountain Lion”
Mac OS X 10.7 “Lion” 1

Mac OS X 10.6 “Snow Leopard”
Mac OS X 10.5 “Leopard” 2

Android
Samsung Galaxy S
Samsung Galaxy Tab
Motorola Droid

Android 2.2 (or higher) 2

Microsoft Windows Laptop
Netbook

Windows XP with Service Pack 3
Windows Vista with Service Pack 3
Windows 7
Windows 8
Windows 8.1

2

Table 18: Platforms Supported by ClearPass Onboard
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Note 1: Uses the “Over-the-air provisioning” method.
Note 2: Uses the “Onboard provisioning” method.
Note 3: Onboard may also be used to provision VPN settings, Exchange ActiveSync settings, and passcode policy on these

devices.

Public Key Infrastructure for Onboard
During the device provisioning process, one or more digital certificates are issued to the device. These are used
as the unique credentials for a device. To issue the certificate, ClearPass Onboard must operate as a certificate
authority (CA). The following sections explain how the certificate authority works, and which certificates are
used in this process.

Certificate Hierarchy
In a public key infrastructure (PKI) system, certificates are related to each other in a tree-like structure.

Figure 10 Relationship of Certificates in the Onboard Public Key Infrastructure

The root certificate authority (CA) is typically an enterprise certificate authority, with one or more intermediate
CAs used to issue certificates within the enterprise.

Onboardmay operate as a root CA directly, or as an intermediate CA. See "Certificate Authorities " on page 96.
For information on setting up certificates when using Onboard in a cluster, see "Certificate Configuration in a
Cluster " on page 85.

The Onboard CA issues certificates for several purposes:

l The Profile Signing Certificate is used to digitally sign configuration profiles that are sent to iOS devices.

n The identity information in the profile signing certificate is displayed during device provisioning.

l One or more Server Certificates may be issued for various reasons – typically, for an enterprise’s
authentication server.

n The identity information in the server certificate may be displayed during network authentication.

l One or more Device Certificates may be issued – typically, one or two per provisioned device.
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n The identity information in the device certificate uniquely identifies the device and the user that
provisioned the device.

You do not need to manually create the profile signing certificate; it is created when it is needed See
"Configuring Provisioning Settings for iOS and OS X" on page 174 to control the contents of this certificate.

You may revoke the profile signing certificate. It will be recreated when it is needed for the next device
provisioning attempt.

Certificate Configuration in a Cluster
When you use Onboard in a cluster, you must use one common root certificate authority (CA) to issue all CPPM
server certificates for the cluster. This allows the “verified” message in iOS and lets you verify that the CPPM
server certificate is valid during EAP-PEAP or EAP-TLS authentication.

In a cluster of CPPM servers, devices can be onboarded through any node or authenticated through any node.
Each CPPM server has a different certificate, used for both SSL and RADIUS server identity. In the default
configuration, these are self-signed certificates—that is, they are not issued by a root CA. This configuration of
multiple self-signed certificates will not work for Onboard: Although a single self-signed certificate can be
trusted, multiple self-signed certificates are not.

There are two ways to configure a common root CA to issue all the CPPM server certificates for a cluster:

l Use the Onboard certificate authority. Create a certificate signing request on each CPPM node, sign the
certificates using Onboard, and install them in CPPM. You can then onboard devices on any node in the
cluster, and can perform secure EAP authentication from a provisioned device to any node in the cluster.

l Use a commercial certificate authority to issue CPPM server certificates. Verify that the same root CA is at
the top of the trust chain for every server certificate, and that it is the trusted root certificate for Onboard.
Provisioning and authentication will then work across the entire cluster.

Revoking Unique Device Credentials
Because each provisioned device uses unique credentials to access the network, it is possible to disable
network access for an individual device. This offers a greater degree of control than traditional user-based
authentication — disabling a user’s account would impact all devices using those credentials.

To disable network access for a device, revoke the TLS client certificate provisioned to the device. See "Working
with Certificates in the List" on page 115.

Revoking access for a device is only possible when using an enterprise network. Personal (PSK) networks do not
support this capability.

Revoking Credentials to Prevent Network Access

Revoking a device's certificate will cause the device to be unable to authenticate. It will not prevent it from being re-
provisioned. If you wish to deny access to a device, use the Manage Access link in the device's row on the Onboard
> Management and Control > View by Device form.

If the device is provisioned with an EAP-TLS client certificate, revoking the certificate will cause the certificate
authority to update the certificate’s state. When the certificate is next used for authentication, it will be
recognized as a revoked certificate and the device will be denied access.

When using EAP-TLS authentication, you must configure your authentication server to use either OCSP or CRL to
check the revocation status of a client certificate. OCSP is recommended as it offers a real-time status update for
certificates. If the device is provisioned with PEAP unique device credentials, revoking the certificate will
automatically delete the unique username and password associated with the device. When this username is next
used for authentication, it will not be recognized as valid and the device will be denied access.
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OCSP and CRL are not used when using PEAP unique device credentials. The ClearPass Onboard server
automatically updates the status of the username when the device's client certificate is revoked.

Re-Provisioning a Device
Because “bring your own” devices are not under the complete control of the network administrator, it is
possible for unexpected configuration changes to occur on a provisioned device.

For example, the user may delete the configuration profile containing the settings for the provisioned network,
instruct the device to forget the provisioned network settings, or reset the device to factory defaults and
destroy all the configuration on the device.

When these events occur, the user will not be able to access the provisioned network and will need to re-
provision their device.

The Onboard server detects a device that is being re-provisioned and prompts the user to take a suitable action
(such as connecting to the appropriate network). If this is not possible, the user may choose to restart the
provisioning process and re-provision the device.

Re-provisioning a device will reuse an existing TLS client certificate or unique device credentials, if these
credentials are still valid.

If the TLS client certificate has expired then the device will be issued a new certificate. This enables re-
provisioning to occur on a regular basis.

If the TLS client certificate has been revoked, then the device will not be permitted to re-provision. The revoked
certificate must be deleted before the device is able to be provisioned.

Network Requirements for Onboard
To achieve complete functionality, ClearPass Onboard has certain requirements that must be met by the
provisioning network and the provisioned network:

l The provisioning network must use a captive portal or other method to redirect a new device to the device
provisioning page.

l The provisioning server (Onboard server) must have an SSL certificate that is trusted by devices that will be
provisioned. In practice, this means a commercial SSL certificate is required.

l The provisioned network must support EAP-TLS and PEAP-MSCHAPv2 authentication methods.

l The provisioned network must support either OCSP or CRL checks to detect when a device has been
revoked and deny access to the network.

Using Same SSID for Provisioning and Provisioned Networks
To configure a single SSID to support both provisioned and non-provisioned devices, use the following
guidelines:

l Configure the network to use both PEAP and EAP-TLS authentication methods.

l When a user authenticates via PEAP with their domain credentials, place them into a provisioning role.

l The provisioning role should have limited network access and a captive portal that redirects users to the
device provisioning page.

l When a user authenticates via PEAP with unique device credentials, place them into a provisioned role.

l When a user authenticates via EAP-TLS using an Onboard client certificate, place them into a provisioned
role.
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For provisioned devices, additional authorization steps can be taken after authentication has completed to
determine the appropriate provisioned role.

Using Different SSID for Provisioning and Provisioned Networks
To configure dual SSIDs to support provisioned devices on one network, and non-provisioned devices on a
separate network, use the following guidelines:

l Configure the provisioning SSID to use PEAP, or another suitable authentication method.

l When a user connects to the provisioning SSID, place them into a provisioning role.

n The provisioning role should have limited network access and a captive portal that redirects users to the
device provisioning page.

l When a user connects to the provisioned SSID, authenticate based on the type of credentials presented.

n For PEAP authentication with unique device credentials, place them into a provisioned role.

n For EAP-TLS authentication using an Onboard client certificate, place them into the provisioned role.

n In all other cases, deny access.

As for the single-SSID case, additional authorization steps may be taken after authentication has completed to
determine the appropriate provisioned role.

Configuring Online Certificate Status Protocol
Onboardsupports the Online Certificate Status Protocol (OCSP) to provide a real-time check on the validity of a
certificate.

To configure OCSP for your network, you will need to provide the URL of an OCSP service to your network
equipment. This URL can be constructed by using the relative path mdps_ocsp.php/1.

For example, if the Onboard server’s hostname is onboard.example.com, the OCSP URL to use is:
http://onboard.example.com/guest/mdps_ocsp.php/1.

OCSP does not require the use of HTTPS and can be configured to use HTTP.

Configuring Certificate Revocation List (CRL)
Onboardsupports generating a Certificate Revocation List (CRL) that lists the serial numbers of certificates that
have been revoked.

To configure a CRL, you will need to provide its URL to your network equipment. This URL can be constructed
by using the relative path mdps_crl.php?id=1.

For example, if the Onboard server’s hostname is onboard.example.com, the location of the CRL is:
http://onboard.example.com/guest/mdps_crl.php?id=1.

A certificate revocation list does not require the use of HTTPS and can be configured to use HTTP.
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Network Architecture for Onboard
The high-level network architecture for the Onboard solution is shown in the following figure.

Figure 11 ClearPass Onboard Network Architecture

The sequence of events shown in Figure 11 is:

1. Users bring their own device to the enterprise.

2. The ClearPass Onboard workflow is used to provision the user’s device securely and with a minimum of user
interaction.

3. After it is provisioned, the device re-authenticates to the network using a set of unique device credentials.
These credentials uniquely identify the device and user and enable management of provisioned devices.

4. Administrators can configure all aspects of the provisioning workflow – including the devices that have been
provisioned, policies to apply to devices and the overall user experience for BYOD.

A more detailed view of the network architecture is shown in Figure 12. This diagram shows different types of
client devices using the Onboard workflow to gain access to the network. Some of the components that may
be configured by the network administrator are also shown.

Figure 12 Detailed View of the ClearPass Onboard Network Architecture

Anexo 11 ITEM 01 (0592523)         SEI 0008478-63.2018.6.02.8000 / pg. 3115



The components shown in Figure 12 are:

1. Users bring different kinds of client device with them. Onboard supports “smart devices” that use the iOS or
Android operating systems, such as smartphones and personal tablets. Onboard also supports the most
common versions of Windows and Mac OS X operating systems found on desktop computers, laptops and
netbooks.

2. The Onboard workflow is used to provision the user’s device securely and with a minimum of user
interaction. The provisioning method used depends on the type of device.

a. Newer versions of Mac OS X (10.7 and later) and iOS devices use the “over-the-air” provisioning method.

b. Other supported platforms use the “Onboard provisioning” method.

3. After it is provisioned, a client device uses a secure authentication method based on 802.1X and the
capabilities best supported by the device.

a. The unique device credentials issued during provisioning are in the form of an EAP-TLS client certificate
for iOS devices and OS X (10.7+) devices.

b. Other supported devices are also issued a client certificate, but will use the PEAP-MSCHAPv2
authentication method with a unique username and strong password.

4. Administrators can manage all Onboard devices using the certificate issued to that device.

Network Architecture for Onboard when Using ClearPass Guest
ClearPass Guest supports the provisioning, authentication, and management aspects of the complete Onboard
solution. Figure 13 shows the high-level network architecture for the Onboard solution when using ClearPass
Guest as the provisioning and authentication server.

Figure 13 ClearPass Onboard Network Architecture when Using ClearPass Guest
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The user experience for device provisioning is the same in Figure 13 and Figure 11, however there are
implementation differences between these approaches.

The ClearPass Onboard Process

Devices Supporting Over-the-Air Provisioning
ClearPass Onboard supports secure device provisioning for iOS 4, iOS 5, and recent versions of Mac OS X (10.7
“Lion” and later). These are collectively referred to as “iOS devices”. The Onboard process for iOS devices is
shown in Figure 14.

Figure 14 Onboard Process for iOS Devices

The Onboard process is divided into three stages:

1. Pre-provisioning. The enterprise’s root certificate is installed on the iOS device.

2. Provisioning. The user is authenticated at the device provisioning page and then provisions their device
with the Onboard server. The device is configured with appropriate network settings and a device-specific
certificate.

3. Authentication. After configuration is complete, the user switches to the secure network and is
authenticated using an EAP-TLS client certificate.

A sequence diagram showing the interactions between each component of this workflow is shown in Figure 15.
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Figure 15 Sequence Diagram for the Onboard Workflow on iOS Platform

1. When a BYOD device first joins the provisioning network it does not have a set of unique device credentials.
This will trigger the captive portal for that device, which brings the user to the mobile device provisioning
page.

2. A link on the mobile device provisioning page prompts the user to install the enterprise’s root certificate.
Installing the enterprise’s root certificate enables the user to establish the authenticity of the provisioning
server during device provisioning.

3. The user then authenticates with their provisioning credentials – these are typically the user’s enterprise
credentials from Active Directory. If the user is authorized to provision a mobile device, the over-the-air
provisioning workflow is then triggered (see Figure 16, below).

4. After provisioning has completed, the device switches to EAP-TLS authentication using the newly
provisioned client certificate. Mutual authentication is performed (the authentication server verifies the
client certificate, and the client verifies the authentication server’s certificate).

5. The device is now onboard and is able to securely access the provisioned network.

Over-the-air provisioning is used to securely provision a device and configure it with network settings. Figure
16 shows a sequence diagram that explains the steps involved in this workflow.

Figure 16 Over-the-Air Provisioning Workflow for iOS Platform
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1. The only user interaction required is to accept the provisioning profile. This profile is signed by the Onboard
server, so that the user can be assured of its authenticity.

2. An iOS device will have two certificates after over-the-air provisioning is complete:

a. A Simple Certificate Enrollment Protocol (SCEP) certificate is issued to the device during the provisioning
process. This certificate identifies the device uniquely, and is used to encrypt the device configuration
profile so that only this device can read its unique settings.

b. A Transport Layer Security (TLS) client certificate is issued to the device. This certificate identifies the
device and the user that provisioned the device. It is used as the device’s network identity during EAP-
TLS authentication.

Devices Supporting Onboard Provisioning
ClearPass Onboard supports secure device provisioning for Microsoft Windows XP (service pack 3 and later),
Microsoft Windows Vista, Microsoft Windows 7, Apple Mac OS X 10.5 and 10.6, and Android devices
(smartphones and tablets). These are collectively referred to as “Onboard-capable devices”. The Onboard
process for these devices is shown in Figure 17.

Figure 17 ClearPass Onboard Process for Onboard-Capable Devices

The Onboard process is divided into three stages:

1. Pre-provisioning. This step is only required for Android devices; the Aruba Networks QuickConnect app
must be installed for secure provisioning of the device.

2. Provisioning. The device provisioning page detects the device type and downloads or starts the
QuickConnect app. The app authenticates the user and then provisions their device with the Onboard
server. The device is configured with appropriate network settings and credentials that are unique to the
device. See Figure 18 for details.

3. Authentication. After configuration is complete, the user switches to the secure network and is
authenticated using PEAP-MSCHAPv2 unique device credentials.
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Figure 18 Sequence Diagram for the Onboard Workflow on Android Platform

1. When a BYOD device first joins the network it does not have a set of unique device credentials. This will
trigger the captive portal for that device, which brings the user to the mobile device provisioning page.

2. The Onboard portal is displayed. The user’s device type is detected, and a link is displayed depending on the
device type:

a. For Android devices, the link is to a file containing the Onboard configuration settings; downloading this
file will launch the QuickConnect app on the device.

b. For Windows and Mac, the link is to a executable file appropriate for that operating system that includes
both the QuickConnect app and the Onboard configuration settings.

3. The QuickConnect app uses the Onboard provisioning workflow to authenticate the user and provision
their device with the Onboard server. The device is configured with appropriate network settings and
credentials that are unique to the device.

4. After provisioning has completed, the app switches the device to PEAP authentication using the newly
provisioned unique device credentials. Mutual authentication is performed (the authentication server
verifies the client’s username and password, and the client verifies the authentication server’s certificate).

5. The device is now onboard and is able to securely access the network.
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The Onboard provisioning workflow is used to securely provision a device and configure it with network
settings. Figure 19 shows a sequence diagram that explains the steps involved in this workflow.

Figure 19 Onboard Provisioning Workflow in the QuickConnect App

Configuring the User Interface for Device Provisioning
The user interface for device provisioning can be customized in three different ways:

l Customizing the Web login page used for device provisioning.

All devices will reach the device provisioning Web login page as the first step of the provisioning process. See
"Configuring Provisioning Settings for the Web Login Page" on page 173 to make changes to the content or
formatting of this page.

l Customizing the properties of the device provisioning profile for iOS and OS X devices.

After starting the provisioning process, users of iOS and OS X are prompted to accept a configuration
profile. See "Configuring Provisioning Settings for iOS and OS X" on page 174 to make changes to the
content of this profile.

l Customizing the user interface of the QuickConnect app for Windows, Mac OS X, and Android devices.

The provisioning process for Windows, Mac OS X, and Android devices uses a separate app, which has a
customizable user interface. See "Configuring Options for Onboard Client Devices" on page 183 to make
changes to the user interface.

Using the {nwa_mdps_config} Template Function
Certain properties can be extracted from the Onboard configuration and used in the device provisioning page.

To obtain these properties, use the {nwa_mdps_config} Smarty template function. The “name” parameter
specifies which property should be returned, as described in Table 19.

Name Description

root_cert URL of the Onboard certificate authority’s root certificate.
Browsing to this URL will install the root certificate on the device, which is required

Table 19: Properties Available with the (nwa_mdps_config Smarty Template Function
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Name Description

as part of the pre-provisioning step.
Example:
<a href="{nwa_mdps_config name=root_cert}"> Install Onboard root
certificate</a>

wifi_ssid

Name of the wireless network. See "Configuring Basic Network Access Settings "
on page 130.
Example:
Connect to the network named {nwa_mdps_config name=wifi_ssid}

organization_name

The organization name. See "Configuring Basic Provisioning Settings" on page
169.
Example:
<h2> Welcome to {nwa_mdps_config name=organization_name}</h2>

Onboard Troubleshooting
If you encounter a problem that is not listed here, refer to the "Onboard Deployment Checklist " on page 81
and check each of the configuration steps listed there.

iOS Device Provisioning Failures
Symptom: Device provisioning fails on iOS with the message “The server certificate for https://… is invalid”.

Resolution: When using HTTPS for device provisioning, you must obtain a commercial SSL certificate.

Self-signed SSL certificates, and SSL server certificates that have been issued by an untrusted or unknown root
certificate authority, will cause iOS device provisioning to fail with the message “The server certificate for … is
invalid”.

A workaround for this issue is to install an appropriate root certificate on the iOS device. This root certificate
must be the Web server’s SSL certificate (if it is a self-signed certificate), or the certificate authority that issued
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the SSL certificate. This is not recommended for production deployments as it increases the complexity of
deployment for users with iOS devices.

Hostname-to-Certificate Match Failures
Symptom: Device provisioning fails with the message "Onboard provisioning cannot be performed at this
address. If your were directed here, please contact a network administrator."

This occurs if the hostname used to access CPPM does not match the hostname configured in the CPPM server
certificate. These items must match or device provisioning will fail. This error is detected by Onboard and
results in the above message.

Resolution: To correct the problem, ensure that the DNS is correctly configured for the server, ensure that the
hostname is correctly set, and ensure that the server's certificate contains the correct hostname.

Onboard Interface Not Displayed
If Onboard is not visible in the ClearPass Guest user interface, verify whether Public Facing Enterprise (PFE)
mode is set in ClearPass Policy Manager. If PFE mode is enabled, Onboard is not permitted and Onboard
licenses cannot be added. The PFE mode is enabled or disabled in CPPM on the Mode tab at Administration
> Server Manager > Server Configuration > Cluster-Wide Parameters.

Certificate Renewal through OS X Mavericks
OS X Mavericks allows users to renew certificates automatically, and provides a notice and an Update link in the
Mavericks Profile fifteen days before a certificate expires. Onboard supports certificate renewal through OS X
Mavericks. However, only local certificates can be renewed; ADCS is not supported. Also, certificates that have
been revoked cannot be renewed.

Certificate Authorities

You can create and manage multiple certificate authorities for Onboard. To view and work with the list of
certificate authorities and to configure new certificate authorities, go to Onboard > Certificate Authorities.
The Certificate Authorities list view opens. All certificate authorities that have been set up are included in the
list. Information shown for each certificate authority includes its name, mode, status, expiration time, and
OCSP URL.

You can click a certificate authority's row in the list for additional options:

l To view details for a certificate authority, click its Show Details link. The form expands to show a summary
of the settings defined for it, including information for certificate issuing, retention policy, identity, private
key, and self-signed certificate.

l To edit any of a certificate authority's attributes and configure certificate issuing options, click its Edit link.
The Certificate Authority Settings form opens. See "Editing Certificate Authority Settings" on page 100.
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l To create a copy of a certificate authority configuration to use as a basis for a new certificate authority, click
its Duplicate link. The first page of the Certificate Authority Settings form opens with the identity, private
key, and self-signed certificate attributes prepopulated and "Copy" appended to the name. You can rename
the new certificate authority and edit any of its attributes.

l To delete a certificate authority, you can click its Delete link. You will be asked to confirm the deletion
before it commits.

l To see if the certificate authority is currently used, click its Show Usage link. The form expands to show a
list of provisioning sets that use the certificate authority.

l To view the trust chain for the certificate authority, click its Trust Chain link. The Certificate Authority Trust
Chain page opens. See "The Trust Chain and Uploading Certificates for the CA " on page 127.

l To view a list of certificates associated with the certificate authority, click its Certificates link. The Certificate
Management page opens. See "Certificate Management (View by Certificate) " on page 114.

l To renew the certificate authority, click its Renew link. If it is an intermediate certificate authority, the
Intermediate Certificate Renewal page opens, where you can send a certificate signing request; see
"Requesting a Certificate for the Certificate Authority" on page 104. If it is a root certificate authority, the
row expands to include the Root Certificate Renewal option. Click the Renew Root Certificate button.

Renewing the certificate uses the same private key for the root certificate, but reissues the root CA
certificate with an updated validity period. This will maintain the validity of all certificates issued by the CA.
When you renew a certificate, you should distribute a new copy of the root certificate to all users of that
certificate.

l To delete a certificate authority's client certificates, click its Delete Client Certificates link. The row
expands to include the Delete Client Certificates form. To confirm the deletion, you must mark the Reset
the specified items check box in the Confirm Reset field, and then click the Delete Client Certificates
button. Doing so will permanently delete all client certificates for the certificate authority. This action
cannot be reversed.

l To create a new certificate authority, click the Create new certificate authority link in the upper right
corner. The initial setup page of the Certificate Authority Settings form opens. See the next section,
"Creating a New Certificate Authority" on page 97.

Creating a New Certificate Authority
The first page of the Certificate Authority Settings form is used to create the Onboard certificate authority (CA)
and to configure some basic properties:

l Give it a name and description

l Specify root CA, intermediate CA, or local CA mode
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l Configure the identity, private key, and self-signed certificate attributes

To create an Onboard certificate authority:

1. Go to Onboard > Certificate Authorities, and then either click the Duplicate link for a certificate
authority in the Certificate Authorities list or click the Create new certificate authority link. The initial
setup page of the Certificate Authority Settings form opens.

2. In the Name field, give the CA a short name that identifies it clearly. Certificate authority names can include
spaces. If you are duplicating a CA, the original name has "Copy" appended to it. You may highlight the
name and replace it with a new name.

3. In the Description field, briefly describe the CA. This description is shown in the Certificate Authorities list.

The Name and Description fields are used internally to identify this certificate authority for the network
administrator. These values are never displayed to the user during device provisioning.

4. The mode is used to set up the mode of operation for the certificate authority. In the Mode area, click one
of the descriptions to specify the type of certificate authority:

l Root CA—The Onboard certificate authority issues its own root certificate. The certificate authority
issues client and server certificates using a local signing certificate, which is an intermediate CA that is
subordinate to the root certificate. Use this option when you do not have an existing public-key
infrastructure (PKI), or if you want to completely separate the certificates issued for Onboard devices
from your existing PKI.
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l Intermediate CA—The Onboard certificate authority is issued a certificate by an external certificate
authority. The Onboard certificate authority issues client and server certificates using this certificate. Use
this option when you already have a public-key infrastructure (PKI), and would like to include the
certificate issued for Onboard devices in that infrastructure.

l Imported CA— If you choose Imported CA, the following fields are removed from the form. If you
choose Root or Intermediate, complete the following fields.

5. In the Identity area, enter values in the Country, State, Locality, Organization, and Organizational
Unit fields that correspond to your organization. These values form part of the distinguished name for the
certificate.

6. Enter a descriptive name for the certificate in the Common Name field. This value is used to identify the
certificate as the issuer of other certificates, notably the signing certificate.

7. For a root certificate, the Signing Common Name field is included on the form. Enter a descriptive name for
the signing certificate in the Signing Common Name field. This value is used to identify the signing
certificate as the issuer of client and server certificates from this certificate authority. The other identity
information in the signing certificate will be the same as for the root certificate.

8. Enter a contact email address in the Email Address field. This email address is included in the root and
signing certificates, and provides a way for users of the certificate authority to contact your organization.

9. In the Private Key area, use the Key Type drop-down list to specify the type of private key that should be
created for the certificate:

l 1024-bit RSA (not recommended for a root certificate)
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l 2048-bit RSA (recommended for general use)

l 4096-bit RSA (higher security)

l X9.62/SECG curve over a 256-bit prime field

l NIST/SECG curve over a 384-bit prime field

10.In the Self-Signed Certificate area, for a root certificate the CA Expiration field is included in the form.
Use this field to specify the lifetime of the root certificate in days. The default value is 365 days.

11.Use the Digest Algorithm drop-down list to specify which hash algorithm should be used to sign the
digital certificate request. Options include:

l SHA-1

l SHA-224

l SHA-256

l SHA-384

l SHA-512

12.Click Create Certificate Authority.

l If you selected root mode, the root certificate is included in the Certificate Authorities list.

l If you selected intermediate mode, the Intermediate Certificate Request page opens with text for the
certificate signing request (CSR). You can send the CSR to a certificate authority, who will generate a
signed certificate you can install. See "Requesting a Certificate for the Certificate Authority" on page 104.

l If you selected imported mode, the Certificate Authority Certificate Import form opens, where you can
upload the digital certificates and private key to the server. See"Installing a Certificate Authority’s
Certificate " on page 104.

Editing Certificate Authority Settings
You can edit some properties of a certificate authority after you create it, and configure some attributes that
were not included on the setup form.

To edit a certificate authority, go to Onboard > Certificate Authorities, click the certificate to expand its row,
and click its Edit link. The Certificate Authority Settings form opens.

In the basic information area at the top of the form, the Name and Description fields are used internally to
identify this certificate authority for the network administrator. These values are never displayed to the user
during device provisioning.

Field Description

Name Short name that identifies the certificate clearly. Certificate authority names can include
spaces.
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Field Description

Description Briefly describes the CA. This description is shown in the Certificate Authorities list.

Mode Either Root, Intermediate, or Imported. The certificate's mode cannot be edited after
creation.

In the Certificate Issuing area:

Authority
Info Access

Specify one of the following options to control automatic certificate revocation checks:
l Do not include OCSP responder URL – The Authority Info Access extension is not

included in the client certificate. Certificate revocation checking must be configured
manually on the authentication server. This is the default option.

l Include OCSP responder URL – The Authority Info Access extension is added to the
client certificates, with the OCSP responder URL set to a predetermined value. This value
is displayed as the “OCSP URL”.

l Specify an OCSP responder URL – The Authority Info Access extension is added to the
client certificates, with the OCSP responder URL set to a value defined by the
administrator. This value may be specified in the “OCSP URL” field.

Validity
Period

Specifies the maximum length of time for which a client certificate issued during device
provisioning will remain valid.

Clock Skew
Allowance

Adds a small amount of time to the start and end of the client certificate’s validity period. This
permits a newly issued certificate to be recognized as valid in a network where not all devices
are perfectly synchronized.

For example, if the current time is 12:00, and the clock skew allowance is set to the default
value of 15 minutes, then the client certificate will be issued with a “not valid before” time of
11:45. In this case, if the authentication server that receives the client certificate has a time of
11:58, it will still recognize the certificate as valid. If the clock skew allowance was set to 0
minutes, then the authentication server would not recognize the certificate as valid until its
clock has reached 12:00.

The default of 15 minutes is reasonable. If you expect that all devices on the network will be
synchronized then the value may be reduced. A setting of 0 minutes is not recommended as
this does not permit any variance in clocks between devices.

When issuing a certificate, the certificate’s validity period is determined as follows:
l The “not valid before” time is set to the current time, less the clock skew allowance.
l The “not valid after” time is first calculated as the earliest of the following:

n The current time, plus the maximum validity period.
n The expiration time of the user account for whom the device certificate is being issued.

l The “not valid after” time is then increased by the clock skew allowance.

Subject
Alternative

To include additional fields in the TLS client certificate issued for a device, mark the Include
device information in TLS client certificates check box. These fields are stored in the
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Name

subject alternative name (subjectAltName) of the certificate. Refer to Table 20 for a list of the
fields that are stored in the certificate when this option is enabled.

Storing additional device information in the client certificate allows for additional
authorization checks to be performed during device authentication.

Digest
Algorithm Algorithm used to sign issued certificates.

If you are using an Aruba controller to perform EAP-TLS authentication using these client certificates, you must have
Aruba OS 6.1 or later to enable the Subject Alternative Name option and store device information in the subject
alternative name.

Name Description OID

Device ICCID

Integrated Circuit Card Identifier (ICCID) number from the
Subscriber Identity Module (SIM) card present in the device.
This is only available for devices with GSM (cellular network)
capability, where a SIM card has been installed.

mdpsDeviceIccid (.4)

Device IMEI
International Mobile Equipment Identity (IMEI) number
allocated to this device. This is only available for devices with
GSM (cellular network) capability.

mdpsDeviceImei (.3)

Device Serial Serial number of the device. mdpsDeviceSerial (.9)

Device Type Type of device, such as “iOS”, “Android”, etc. mdpsDeviceType (.1)

Device UDID
Unique device identifier (UDID) for this device. This is typically
a 64-bit, 128-bit or 160-bit number represented in hexadecimal
(16, 32, or 40 characters, respectively).

mdpsDeviceUdid (.2)

MAC Address
IEEE MAC address of this device. This element may be present
multiple times, if a device has more than one MAC address (for
example, an Ethernet port and a Wi-Fi adapter).

mdpsMacAddress (.5)

Product Name Product string identifying the device and often including the
hardware version information. mdpsProductName (.6)

Product
Version String containing the software version number for the device. mdpsProductVersion

(.7)

User Name String containing the username of the user who provisioned
the device. mdpsUserName (.8)

Table 20: Device Information Stored in TLS Client Certificates

In the Retention Policy area:

Anexo 11 ITEM 01 (0592523)         SEI 0008478-63.2018.6.02.8000 / pg. 3129



Field Description

Minimum
Period

Specify values that are appropriate for your organization’s retention policy. The
default data retention policy specifies a minimum period of 12 weeks and a max-
imum period of 52 weeks.Maximum

Period

To enable the Delete Certificate and Delete Request actions in the Certificate Management list view, use a blank
value for Minimum Period. This is useful for testing and initial deployment.

In the SCEP & EST Server area:

Onboard may be used as a CA with third-party products that use Simple Certificate Enrollment Protocol (SCEP)
to enroll certificates.

Field Description

SCEP & EST
Server

To enable access to the SCEP and EST servers, select this check box. The form expands to
include SCEP and EST server configuration options.

SCEP URL Shows the SCEP URL for this SCEP server.

EST URL Shows the EST URL for this SCEP server.

SCEP & EST
Secret Enter the shared secret that SCEP and EST clients must supply.

Allowed Enter the IP addresses and networks from which logins are permitted.
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Field Description

Access

Denied
Access Enter IP addresses and networks that are denied login access.

Identity

The information in these fields cannot be edited after creation.
Private Key

Self-Signed
Certificate

When you are done, click Edit Certificate Authority to complete your changes.

Requesting a Certificate for the Certificate Authority
The Intermediate Certificate Request page displays the certificate signing request for the certificate authority’s
intermediate certificate.

You can copy the certificate signing request in text format using your Web browser. Use this option when you
can paste the request directly into another application to obtain a certificate.

You can click the Download the current CSR link to download the certificate signing request as a file. Use
this option when you need to provide the certificate signing request as a file to obtain a certificate.

After you have obtained the certificate, click the Install a signed certificate link to continue configuring
the intermediate certificate authority. See "Installing a Certificate Authority’s Certificate " on page 104.

You can also click the Change CA settings link to return to the main Certificate Authority Settings form.
Use this option to switch to a root CA, or to change the name or properties of the intermediate CA and reissue
the certificate signing request.

Installing a Certificate Authority’s Certificate
You can import a private key and certificate pair to use for the root certificate or intermediate certificate. The
CA Certificate Import page may be used to:

l Upload a certificate that has been issued by another certificate authority. This process is required when
configuring an intermediate certificate authority.

n A private key is not required, as the certificate authority has already generated one and used it to create
the certificate signing request.

l Upload a certificate and private key to be used as the certificate authority’s certificate. This process may be
used to configure a root certificate authority.

n A private key is required, as the certificate authority’s existing private key will be replaced.

This form may be used multiple times in order to import each of the certificates in the trust chain. Check the
message displayed above the form to determine which certificate or type of file must be uploaded next.

To upload a certificate:

1. On either the Certificate Management or Intermediate Certificate Settings page, click the Import
Certificate link above the form. The Step 1 area of the CA Certificate Import form opens.
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2. Select one of the radio buttons to either copy and paste the certificate as encoded text or browse to the file
to upload. The form expands to include options for that method.

3. If you selected Copy and paste certificate as text:

l To upload a single certificate, copy and paste the certificate into the Certificate text field. The text must
include the “BEGIN CERTIFICATE” and “END CERTIFICATE” lines. Leave the passphrase fields blank.

l To upload a certificate and private key, copy and paste the certificate and private key into the
Certificate text field. The text must include the “BEGIN CERTIFICATE” and “END CERTIFICATE” lines, as
well as the “BEGIN RSA PRIVATE KEY” and “END RSA PRIVATE KEY” lines.

4. If you selected Upload certificate file, click Choose File in the Certificate row to browse to the file and
select it.

l To upload a single certificate, choose a certificate file in PEM (base-64 encoded) or binary format (.crt or
PKCS#7). Leave the passphrase fields blank.

l To upload a certificate’s private key as a separate file, choose the private key file in PEM (base-64
encoded) format. If the private key has a passphrase, enter it in the Private Key Passphrase and
Confirm Passphrase fields. The private key will be automatically matched to its corresponding
certificate when uploaded.

l To upload a combined certificate and private key, choose a file in either PEM (base-64 encoded) or
PKCS#12 format. If the private key has a passphrase, enter it in the Private Key Passphrase and
Confirm Passphrase fields.
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5. Click Upload Certificate to save your changes.

If additional certificates are required, you will remain at the same page. Check the message displayed above the
form to determine which certificate or type of file must be uploaded next. When the trust chain is complete, it
will be displayed. This completes the initialization of the certificate authority.

Using Microsoft Active Directory Certificate Services
Go to the Microsoft Active Directory Certificate Services Web page. This page is typically found at
https://yourdomain/certsrv/. The Welcome page opens.

Click the Request a Certificate link on this page. The Request a Certificate page opens.

Click the link to submit an advanced certificate request. The Advanced Certificate Request page opens.
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Click the link to submit a request using a base-64-encoded CMC or PKCS #10 file. The Submit a Certificate
Request or Renewal Request page is displayed.

Copy and paste the certificate signing request text into the Saved Request text field.

Because this certificate is for a certificate authority, select the “Subordinate Certificate Authority” in the
Certificate Template drop-down list.

Click the Submit button to issue the certificate. Either the Certificate Pending or the Certificate Issued page is
displayed.

If the Certificate Pending page is displayed, follow the directions on the page to retrieve the certificate when it
is issued.
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If the Certificate Issued page is displayed, select the Base 64 encoded option and then click the Download
certificate chain link. A file containing the intermediate certificate and the issuing certificates in the trust
chain will be downloaded to your system.

Refer to the instructions in "Installing a Certificate Authority’s Certificate " on page 104 for information on
uploading the certificate file to Onboard.

Management and Control

The Management and Control section in the Onboard navigation lets you view and manage devices and the
users and certificates associated with them, as well as the asset database of corporate devices. To access the
device management features, go to Onboard > Management and Control > Start Here.

l To view and manage your list of devices, see "Device Management (View by Device) " on page 108

l To view and manage the list of users associated with the devices, see "Device Management (View by
Username)" on page 112

l To view, create, and manage digital certificates for devices, servers, and certificate authorities, see
"Certificate Management (View by Certificate) " on page 114

Device Management (View by Device)

The Device Management (View by Device) page lists all devices and lets you manage the devices' access to the
network. For each device, you can allow or deny network access.

To work with the list of device users, see "Device Management (View by Username)" on page 112.

When a device is denied access, its certificates are revoked. For a device that has had its access denied, you can
grant access again, allowing it to re-enroll and obtain a new certificate.

To view and filter the list of devices:

1. Go to Onboard > Management and Control > View by Device. The Device Management (View by
Device) list view opens. This list displays all currently provisioned devices. Information shown for each
device includes its device type, device name (operating system), device ID (MAC address), user, the device's
network access status, and whether it is currently onboarded.
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2. The Device Type filter lets you filter for All, Android, iOS, OS X, Windows, or External device types.

3. The Status field lets you filter for Enrolled, Allowed, or Denied status.

4. You can use the Keywords field to filter by device type, device name, username, MAC address, or device
UDID.

To work with a device:

1. Click the device's row in the list to show the available options. Depending on the type of device, the
available options might include configuration details, device details, show users, access management, device
actions, certificate details, and device deletion.

2. To work with configuration details for a device, click its Show Config link. In the Configuration window that
opens, you can click the Default Profile link to edit the device's configuration profile, or click the Local
Device Provisioning link to edit the device's provisioning settings. When you change the configuration
profile here, all apps that were previously pushed to the device are replaced with the apps in the new
configuration profile.

3. To view a summary of the device's details, click the Device Details link. The row expands to include the
Device Details form.

4. To change a device's access status, click its Manage Access link. In the Manage Access window that
opens, use the drop-down list in the Access field to select either Allow access to this device or Deny
access to this device. When you select the Deny option, a message advises you that any certificates
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associated with it will be revoked. The device cannot be re-enrolled as long as access is denied. To re-enroll
the device, you must use this field to allow access again.

5. To delete all users, click the device's Device Actions link. Select the Delete All Users check box, and then
click Apply.

6. To view certificate details, or to revoke or delete all client certificates for the device, click its Certificates
link. The form expands to include both the Certificate Information view and the Manage Certificates form.

The Certificate Information view lets you review all details of the certificate:
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The Manage Certificates form lets you revoke or delete all TLS client certificates issued to the device.
Mark the appropriate radio button, and then click Manage Certificates.

7. To delete a device, click its Delete Device link. You will be asked to confirm the deletion. Deleting the
device will also delete all user, certificate, and other data associated with the device. Certificates are deleted
according to the Certificate Authority's retention policy. After a device is deleted, it can still access the
network and be reprovisioned. To deny network access for the device, use the Manage Access link instead.
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Device Management (View by Username)

The Device Management (View by Username) page lists all users associated with devices. For each user, you
can:

l View and edit default configuration profile and provisioning settings

l View and manage all devices registered to the user

l Allow or deny network access for the user

l Delete all the user's devices

l Revoke or delete all TLS client certificates issued to the user

l Delete the user

To work with the list of devices, see "Device Management (View by Device) " on page 108.

To view and filter the list of users:

1. Go to Onboard > Management and Control > View by Username. The Device Management (View by
Username) list view opens. Information shown in this list for each user includes username, network access
status, number of devices, and number of onboarded devices.

2. You can use the Keywords field to filter by username.

To work with a username:

1. Click the user's row in the list to show the available options. These include configuration details, device
information, access management, device actions, certificate actions, and user deletion.

2. To work with configuration details for a user, click their Show Config link. The row expands to include the
Configuration form. You can click the Default Profile link to edit the user's device configuration profile, or
click the Local Device Provisioning link to edit the user's local device provisioning settings.

3. To view a list of the user's devices, click the Device Details link.
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4. To view details of certificates belonging to this user, or to revoke or delete all client certificates issued to the
user, click the Certificates link. The form expands to include both the Certificate Information view and the
Manage Certificates form.

The Certificate Information view lets you review all details of the certificate:

The Manage Certificates form lets you revoke or delete all TLS client certificates issued to the user. Mark
the appropriate radio button, and then click Manage Certificates.
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5. To delete a user, click their Delete User link. You will be asked to confirm the deletion. Deleting the user will
also delete all devices, TLS client certificates, and other data associated with the user. Certificates are deleted
according to the Certificate Authority's retention policy.

Certificate Management (View by Certificate)

To view the list of certificates and work with them, go to Onboard > Management and Control > View by
Certificate. The Certificate Management list view opens. This list displays all of the certificates and certificate
requests in the Onboard system.

Information provided in the Certificate Management list includes common name, certificate authority, serial
number (if available), certificate type, validity date range, and device type—iOS, Android, Windows, or None (if
not associated with a device type). Table 21 lists the types of certificate that are displayed in this list.

Certificate Type “Type” Column Notes

Root certificate ca Self-signed certificate for the certificate
authority

Intermediate certificate ca Issued by the root CA or another
intermediate CA

Profile signing certificate profile-signing Issued by the certificate authority

Certificate signing request tls-client or trusted The type shown depends on the kind of
certificate requested

Rejected certificate signing
request tls-client or trusted Certificate request that was rejected due

to an administrator decision

Table 21: Types of Certificate Supported by Onboard Certificate Management
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Certificate Type “Type” Column Notes

Device certificate scep-client Issued to iOS and OS X (10.7+) devices
only

Client certificate tls-client Identity certificate issued to a specific
user’s device

Server certificate trusted Identity certificate issued to a server

Code-signing certificate ca Used for signing the Windows
provisioning application

Revoked certificate -- Certificate that has been administratively
revoked and is no longer valid

Expired certificate -- Certificate that is outside its validity
period and is no longer valid

l To create a new certificate, see "Creating a Certificate " on page 122.

l To search for certificates, see "Searching for Certificates in the List " on page 115.

l To work with your certificates, see "Working with Certificates in the List" on page 115.

l To work with certificate signing requests, see "Working with Certificate Signing Requests " on page 118.

l To import a code-signing certificate or profile-signing certificate, see "Importing a Code-Signing Certificate "
on page 121.

l To import a trusted certificate, see "Importing a Trusted Certificate " on page 122.

Searching for Certificates in the List
In the Certificate Management list, the Filter field can be used to quickly search for a matching certificate. Type
a username into this field to quickly locate all certificates matching that username.

The filter is applied to all columns displayed in the list view. To search by another field, such as MAC address,
device type, or device serial number, click the Columns tab, select the appropriate column(s), and then click
the Save and Reload button. The list view will refresh to update the results of the filter.

Click the Clear Filter link to restore the default view.

Use the paging control at the bottom of the list to jump forwards or backwards by one page, or to the first or
last page of the list. You can also click an individual page number to jump directly to that page.

When the list contains many thousands of certificates, consider using the Filter field to speed up finding a specific
certificate.

Click the column headers to sort the list view by that column. Click the column header a second time to reverse
the direction of the sort.

Working with Certificates in the List
To work with a certificate in the Certificate Management list, click on a certificate to select it. You can then select
from one of these actions:

l View certificate – Displays the properties of the certificate. Information includes certificate details,
issuer details, and the certificate's "fingerprint" or "thumbprint". In the Details row, you can click the Show
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link to display advanced details, including such things as the version, serial number, signature algorithms,
and public key algorithms. SHA 1 and SHA 256 are supported as digest algorithms. Click the Cancel
button to close the certificate properties.

l Export certificate – Displays the Export Certificate form.

Use the Format drop-down list to select the format in which the certificate should be exported. The
following formats are supported:

l PKCS#7 Certificates (.p7b)—Exports the certificate, and optionally the other certificates forming the
trust chain for the certificate, as a PKCS#7 container.

l Base-64 Encoded (.pem)—Exports the certificate as a base-64 encoded text file. This is also known as
“PEM format”. You may optionally include the other certificates forming the trust chain for the
certificate.

l Binary Certificate (.crt)—Exports the certificate as a binary file. This is also known as “DER format”.

l Open SSL Text Format—Exports the certificate as a full openssl text-format output, allowing you to
view advanced details such as X509v3 extensions. It also includes the certificate in .pem format
appended to the .txt file.

l PKCS#12 Certificate & Key (.p12)—Exports the certificate and its associated private key, and
optionally any other certificates required to establish the trust chain for the certificate, as a PKCS#12
container. This option is only available if the private key for the certificate is available to the server. If you
select the PKCS#12 format, you must enter a passphrase to protect the private key stored in the file.

To protect against brute-force password attacks and ensure the security of the private key, you should use a strong
passphrase – one consisting of several words, mixed upper- and lower-case letters, and punctuation or other symbol
characters.

Click the Export Certificate button to download the certificate file in the selected format.

l Revoke certificate—Displays the Revoke Certificate form.
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Mark the Revoke this client certificate check box to confirm that the certificate should be revoked, and
then click the Revoke Certificate button.

After the certificate has been revoked, future checks of the certificate’s validity using OCSP or CRL will
indicate that the certificate is no longer valid.

Due to the way in which certificate revocation lists work, a certificate cannot be un-revoked. A new certificate must
be issued if a certificate is revoked in error.

Revoking a device’s certificate will cause the device to be unable to authenticate. It will not prevent it from being re-
provisioned. If you wish to deny access to a device, use the Manage Access link in the device's row on the
Management and Control > View by Device form.

l Delete certificate—Removes the certificate from the list. Trusted certificates that were imported into
Onboard may be deleted at any time after import. For all other certificates, this option is only available if the
data retention policy is configured to permit the certificate’s deletion.
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The Delete Certificate form is displayed. Mark the Delete this client certificate check box to confirm the
certificate’s deletion, and then click the Delete Certificate button.

Working with Certificate Signing Requests
Certificate signing requests can be managed through the Certificate Management list view. This allows for
server certificates, subordinate certificate authorities, and other client certificates not associated with a device
to be issued by the Onboard certificate authority.

Click on a certificate request to select it. You can then select from one of these actions:

l View request – Displays the properties of the certificate request. Click the Cancel button to close the
certificate request properties.

l Export request – Displays the Export Certificate Request form.

Use the Format drop-down list to select the format in which the certificate signing request should be
exported. The following formats are supported:

n PKCS#10 Certificate Request (.p10) – Exports the certificate signing request in binary format.

n Base-64 Encoded (.pem) – Exports the certificate signing request as a base-64 encoded text file. This is
also known as “PEM format”.
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If you choose Base-64 Encoded, the form expands to include the Trust Chain row. You can use this option
to create and export a certificate bundle that includes the Intermediate CA and Root CA and can be
imported in ClearPass Policy Manager as the server certificate (ClearPass Policy Manager does not accept
PKCS#7). To include the trust chain in a certificate bundle that can be imported as the server certificate in
ClearPass Policy Manager, mark the Include certificate trust chain check box, then click the Export
Certificate button.

Click the Export Request button to download the certificate signing request file in the selected format.

l Sign request – Displays the Sign Request form. Use this action to approve the request for a certificate
and issue the certificate.

Use the Expiration text field to specify how long the issued certificate should remain valid.

Mark the Sign this request check box to confirm that the certificate should be issued, and then click the
Sign Request button. The certificate will be issued and will then replace the certificate signing request in

the list view.

l Reject request – Displays the Reject Request form. Use this action to reject the request for a certificate.
Rejected requests are automatically deleted according to the data retention policy.
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Mark the Reject this request check box to confirm that the certificate signing request should be rejected,
and then click the Reject Request button.

l Delete request – Removes the certificate signing request from the list. This option is only available if the
data retention policy is configured to permit the certificate signing requests’s deletion.

The Delete Request form is displayed. Mark the Delete this request check box to confirm the certificate
signing request’s deletion, and then click the Delete Request button.
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Importing a Code-Signing Certificate
ClearPass Onboard supports importing a code-signing certificate chain and private key for signing the Windows
provisioning application. Certificates can be uploaded as PFX, PKCS-12, SPC, or PKCS-7, and can include a chain
of certificates. An operator’s profile must include the Import Code-Signing Certificate privilege in order to
access this feature.

The procedure for importing a profile-signing certificate is the same as that for importing a code-signing
certificate. To import a trusted certificate, see "Importing a Trusted Certificate " on page 122.

To import a code-signing certificate:

1. Do one of the following:

l Go to Onboard > Management and Control > View by Certificate and click the Upload a code-
signing certificate link in the upper-right corner of the page.

l Go to Onboard > Deployment and Provisioning > Provisioning Settings. You can either click the
Create new provisioning settings link at the top of the page, or click the Edit link for a configuration
set in the list. In the page that opens, click the Upload a code-signing certificate link in the upper-
right corner.

The Code-Signing Certificate Import form opens.

2. In the Certificate field, navigate to the code-signing certificate file to upload.

3. If the private key for the code-signing certificate was issued as a separate file, use the Private Key field to
navigate to the private key file.

4. Click Upload Certificate. The certificate chain is displayed.

To use the certificate for code-signing:

1. Go to Onboard > Deployment and Provisioning > Provisioning Settings > Windows tab.

2. In the Windows Provisioning section, use the Code-Signing Certificate drop-down list to select the
uploaded certificate.

To create a test certificate:

1. Go to Onboard > Management and Control > View by Certificate and click the Generate a new
certificate signing request link. The Certificate Request Settings form opens.

2. In the Certificate Type drop-down list, choose Code-Signing.

3. Complete the rest of the form with your information. Mark the Issue this certificate immediately check
box, then click Create Certificate Request.

The test certificate is displayed in the list on the Certificate Management page, and can be selected on the
Provisioning Settings form.
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Importing a Trusted Certificate
Onboard’s Certificate Management page supports importing trusted certificates. Certificates may be uploaded
in PEM format (*.pem).

(To import a code-signing certificate, see "Importing a Code-Signing Certificate " on page 121

To import a trusted certificate:

1. Go to Onboard > Management and Control > View by Certificate and click the Upload a trusted
certificate link in the upper-right corner. The Trusted Certificate Import form opens.

2. Click Choose File to browse to the certificate on your system, and then click Upload Certificate. A
confirmation message is displayed, and the imported certificate is included in the Certificate Management
list. You can click the Show Certificate link next to the certificate’s name to view the certificate’s details.

3. You can use the following additional options in the upper-right corner of the Import Trusted Certificate
page:

l Click the Upload another trusted certificate link to upload additional certificates.

l Click the Edit <certificate name> trust settings link to open the Trust tab of the Network Settings
form.

Creating a Certificate
To create a new certificate, go to Onboard > Management and Control > View by Certificate. The
Certificate Management page opens. In the upper-right corner, click the Generate a new certificate
signing request link. The Certificate Request Settings form opens.
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To create a new certificate or certificate signing request:

In the Certificate Authority drop-down list, select the certificate authority that will be used to sign the
request.

In the Certificate Type drop-down list, select the type of certificate you want to create:

l TLS Client Certificate—Use this option when the certificate is to be issued to a client, such as a user or a
user’s device.

n When this option is selected, the issued certificate’s extended key usage property will contain a value of
“Client Auth”, indicating that the certificate may be used to identify a client.

n When you create a TLS Client certificate, corresponding entries are created in the Onboard >
Management and Control > View by Device and Onboard > Management and Control > View
by Username lists.

l Trusted Certificate—Use this option when the certificate is to be issued to a network server, such as a
Web server or as the EAP-TLS authentication server.

n When this option is selected, the issued certificate’s extended key usage property will contain a value of
“Server Auth”, indicating that the certificate may be used to identify a server. Trusted certificates include
the id-kp-eapOverLAN extended key usage.

l Certificate Authority—Use this option when the certificate is for a subordinate certificate authority.

n When this option is selected, the issued certificate will contain an extension identifying it as an
intermediate certificate authority, and the extended key usage property will contain the three values
“Client Auth”, “Server Auth” and “OCSP Signing”.

l Code Signing—Use this option for signing the Windows provisioning application.

Specifying the Identity of the Certificate Subject

In the first part of the Certificate Request Settings form, provide the identity of the person or device for which
the certificate is to be issued (the “subject” of the certificate). Together, these fields are collectively known as a
distinguished name, or “DN”:

l Country

l State
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l Locality

l Organization

l Organizational Unit

l Common Name – this is the primary name used to identify the certificate

l Email Address

The Key Type drop-down list specifies the type of private key that should be created for the certificate. You
can select one of these options:

l 1024-bit RSA – lower security

l 2048-bit RSA – recommended for general use

l 4096-bit RSA – higher security

Using a private key containing more bits will increase security, but will also increase the processing time required to
create the certificate and authenticate the device. The additional processing required will also affect the battery life
of a mobile device. It is recommended to use the smallest private key size that is feasible for your organization.

If you have selected TLS Client as the certificate type, the Subject Alternative Name section is also shown. The
alternative name can be used to specify additional identification details for the certificate’s subject. If one or
more of these options are provided, the issued certificate will contain a subject AltName extension with the
specified values.

Table 22 explains the fields that may be included as part of the subject alternative name.

Name Description

Device Type Type of device, such as “iOS”, “Android”, etc.

Device Name The hostname of the device at the time of enrollment.

Device UDID
Unique device identifier (UDID) for this device. This is typically a 64-bit,
128-bit or 160-bit number represented in hexadecimal (16, 32 or 40
characters, respectively).

Device IMEI International Mobile Equipment Identity (IMEI) number allocated to this

Table 22: Subject Alternative Name Fields Supported When Creating a TLS Client Certificate Signing Request
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Name Description

device.

Device ICCID Integrated Circuit Card Identifier (ICCID) number from the Subscriber
Identity Module (SIM) card present in the device.

Device Serial Serial number of the device.

MAC Address IEEE MAC address of this device.

Product Name Product string identifying the device and often including the hardware
version information.

Product Version Software version number for the device.

User Name Username of the user who provisioned the device.

Custom Field A custom field to be used as needed.

User Email Address The email address of the user who provisioned a device.

Issuing the Certificate Request

To create the certificate, when you have completed the other fields on the Certificate Request Settings form,
mark the Issue this certificate immediately check box.

Click the Create Certificate Request button to save your changes.
l If the “Issue this certificate immediately” check box is marked, the certificate will be issued immediately and

will be displayed in the Certificate Management list view.

l If the “Issue this certificate immediately” check box is not marked, the certificate request will be displayed in
the Certificate Management list view. The certificate can then be issued or rejected at a later time.

Requesting a Certificate

From the Onboard > Management and Control > View by Certificate page, click the Upload a
certificate signing request link to access the Certificate Signing Request form.
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Providing a Certificate Signing Request in Text Format

If you have a certificate signing request in text format, click the Copy and paste certificate signing request
as text radio button on the Certificate Signing Request form.

Paste the text into the Certificate Signing Request text field. Be sure to include the complete block of text,
including the beginning and ending lines.

A complete certificate signing request looks like the following:
-----BEGIN CERTIFICATE REQUEST----------END CERTIFICATE REQUEST-----

Providing a Certificate Signing Request File

Alternatively, if you have the certificate signing request as a file, click the Upload certificate signing request
file radio button.

Use the Certificate Signing Request field to select the appropriate file for upload.
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The file should be a base-64 encoded (PEM format) PKCS#10 certificate signing request.

Specifying Certificate Properties

On the Certificate Signing Request form, select the type of certificate from the Certificate Type drop-
down list. Choose from one of the following options:

l TLS Client Certificate – Use this option when the certificate is to be issued to a client, such as a user or a
user’s device.

n When this option is selected, the issued certificate’s extended key usage property will contain a value of
“Client Auth”, indicating that the certificate may be used to identify a client.

l Trusted Certificate—Use this option when the certificate is to be issued to a network server, such as a
Web server or as the EAP-TLS authentication server.

n When this option is selected, the issued certificate’s extended key usage property will contain a value of
“Server Auth”, indicating that the certificate may be used to identify a server. Trusted certificates include
the id-kp-eapOverLAN extended key usage.

l Certificate Authority – Use this option when the certificate is for an subordinate certificate authority.

n When this option is selected, the issued certificate will contain an extension identifying it as an
intermediate certificate authority, and the extended key usage property will contain the three values
“Client Auth”, “Server Auth” and “OCSP Signing”.

l Code Signing—Use this option for signing the Windows provisioning application.

l TLS Server Certificate – Use this option when the certificate is to be issued to a network server, such as a
Web server or as the EAP-TLS authentication server.

n When this option is selected, the issued certificate’s extended key usage property will contain a value of
“Server Auth”, indicating that the certificate may be used to identify a server.

Mark the Issue this certificate immediately check box to automatically issue the certificate.

Click the Submit Certificate Signing Request button to save your changes.
l If the “Issue this certificate immediately” check box is marked, the certificate will be issued immediately and

will be displayed in the Certificate Management list view.

l If the “Issue this certificate immediately” check box is not marked, the certificate request will be displayed in
the Certificate Management list view. The certificate can then be issued or rejected at a later time.

The Trust Chain and Uploading Certificates for the CA
The Certificate Authority Trust Chain page is used to view the certificate authority’s current trust chain, or to
upload a new certificate in the trust chain when configuring a certificate authority.

To view the Certificate Authority’s trust chain, go to Onboard > Certificate Authorities and click the Trust
Chain link for a certificate. The Certificate Authority Trust Chain page opens. This page shows a graphical
representation of the certificates that make up the trust chain.
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The first certificate listed is the root certificate. Root certificates are always self-signed and are explicitly trusted
by clients.

Each additional certificate shown is an intermediate certificate. The last certificate in the list is the signing
certificate that is used to issue client and server certificates.

To view the properties of a certificate in the trust chain, click the Show certificate link. The Certificate
Information view opens.

To export a certificate:

1. Click the Download Bundle link. The Export Certificate form opens.
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2. In the Format row, choose the certificate format. The form expands to include configuration options for
that format.

3. Complete the fields with the appropriate information, and then click Export Certificate.

Considerations for iOS Devices
The server certificate is used by ClearPass to secure Web (HTTPS) and authentication (RADIUS) traffic. It can be
configured in ClearPass Policy Manager under Administration > Certificates > Server Certificate.

The optimal configuration for Onboard is a server certificate issued by a trusted commercial certificate
authority. A list of certificate authorities trusted by iOS devices can be found at
http://support.apple.com/kb/HT5012.

Alternatively, if you only wish to use a single Onboard Certificate Authority, then you can use that Certificate
Authority to sign the server certificate. Users will then have to install the certificate as part of the provisioning
process.

For testing purposes, you can disable the requirement for HTTPS on CPPM's Configuration
> Authentication page; however, this is an insecure configuration that should not be used in a production
environment.

Onboard Configuration

Onboard lets you create and manage the configuration settings that can be provisioned to onboarded devices.
To manage configuration settings, go to Onboard > Configuration > Start Here. The index page opens. It
includes with command links for accessing the different configuration settings as well as the configuration
profiles that use them.

l For network settings, see "Network Settings " on page 129

l For iOS device settings, see "iOS Settings" on page 139

l For configuration profiles, see "Configuration Profiles" on page 163

Network Settings

You can define multiple network settings that can be sent to provisioned devices. Each network you configure
is also a "configuration unit" that you can include in a configuration profile.

To create and work with network settings, go to Onboard > Configuration > Network Settings. The
Networks list view opens.

ClearPass Guest 6.4 | User Guide Onboard | 129
Anexo 11 ITEM 01 (0592523)         SEI 0008478-63.2018.6.02.8000 / pg. 3156

http://support.apple.com/kb/HT5012


130 | Onboard ClearPass Guest 6.4 | User Guide

All networks that have been provisioned are included in the list. You can click a network's row in the list for
additional options:

Field Description

Show
Details

Displays details for the network. The form expands to show its name, description, and configuration
values for network access, wireless networks, enterprise protocols, enterprise authentication,
enterprise trust, Windows networking, and proxy settings.

Edit Edit any of a network's attributes. The Network Settings form opens.

Duplicate
Creates a copy of a network configuration to use as a basis for a new network. The Network Settings
form opens with all attributes prepopulated and "Copy" appended to its name. You can rename the
new configuration, and edit any of its attributes.

Show
Usage Displays a list of configuration profiles that use the network.

Create
new
network

To create a new network, click this link in the upper right corner. The Network Settings form opens.

Table 23: The Network Settings List

For information on creating, editing, or duplicating n Network Settings configuration set, see:

l "Configuring Basic Network Access Settings " on page 130

l "Configuring Enterprise Protocol Settings" on page 133

l "Configuring Device Authentication Settings" on page 134

l "Configuring Certificate Trust Settings" on page 135

l "Configuring Windows-Specific Network Settings" on page 137

l "Configuring Proxy Settings" on page 138

Configuring Basic Network Access Settings
1. On the Onboard > Configuration > Network Settings list view, to configure the network settings that

will be provisioned to devices, click the network’s Edit link. To create a new network, click the Create
new network link in the upper-right corner. The Network Access form opens with the Access tab
displayed.

The configuration process is the same for editing an existing network and for creating a new network. The
Network Access form is divided into several tabs:
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Tab Description

Access
Specifies basic network properties, such as the name of the wireless network and the type of
security that is used. This form is described below.

Protocols
Specifies the 802.1X authentication protocols that are used by the network. See "Configuring
Enterprise Protocol Settings" on page 133.

Authentication
Specifies the type of device authentication to be used for the network. See "Configuring
Device Authentication Settings" on page 134.

Trust
Specifies options related to mutual authentication. See "Configuring Certificate Trust
Settings" on page 135.

Windows
Specifies networking options used only by devices using the Windows operating system. See
"Configuring Windows-Specific Network Settings" on page 137.

Proxy
Specifies a proxy server to be used by devices connecting to the network. See "Configuring
Proxy Settings" on page 138.

Navigating between different tabs will save the changes you have made in each tab. The modified settings are
indicated with a “#” marker in the tab. The settings used for device provisioning are not modified in the database until
you click Create Network.

To edit the network’s basic and wireless network access options, click the Access tab:

1. If you need to edit the network’s name, enter the new name in the Name field.
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2. (Optional) You may enter additional identifying information in the Description field.

3. The options available in the Network Type drop-down list are:

l Both — Wired and Wireless – Configures both wired (Ethernet) and wireless network adapters. Use
this option when you have 802.1X configured for all types of network access.

l Wireless only – Configures only wireless network adapters.

l Wired only – Configures only wired (Ethernet) network adapters.

4. The options available in the Security Type drop-down list are:

l Enterprise (802.1X) – Use this option to setup a network that requires user authentication.

l This option is the only available choice when the Network Type is set to “Wired only”.

l Personal (PSK) – Use this option to setup a network that requires only a pre-shared key (password) to
access the network.

This option is only available when the Network Type is set to “Wireless only”.

5. If you have selected the Personal (PSK) security type, you must provide the pre-shared key in the
Password field. The minimum password length is six characters. Selecting the PSK security type will hide the

Protocols, Authentication, and Trust tabs.

6. In the Wireless Network Settings area:

l The Security Version field lets you set the encryption version for the wireless network to WPA with
TKIP or WPA2 with AES.

l In the Auto Join row, you can mark the Automatically join network check box to specify that the
device should be automatically connected to the network when it is provisioned. If only one network is
available to the user, the device will be connected automatically. If multiple networks are available, the
user will be able to choose the network to connect to. If the Automatically join network option is not
selected on this form, an option to manually connect to the network will be shown to the user.

7. Do one of the following:

l Click Next to continue to the Protocols tab.

l Click Save Changes to make the new network configuration settings take effect.

l Click Cancel to discard your changes and return to the main Onboard configuration user interface.

For information about the list of network settings, see "Network Settings " on page 129. For more information
about configuration profiles, see "Configuration Profiles" on page 163

Anexo 11 ITEM 01 (0592523)         SEI 0008478-63.2018.6.02.8000 / pg. 3159



Configuring Enterprise Protocol Settings

On the Onboard > Configuration > Network Settings form, click the Protocols tab to display the
Enterprise Protocols form.

Use this form to specify the authentication methods required by your network infrastructure. The default EAP
type is TLS for all platforms that support this method.

l The iOS & OS X EAP option supports TLS, TTLS, PEAP, and EAP-FAST.

l The Legacy OS X EAP option supports only PEAP with MSCHAPv2.

l The Android EAP option supports TLS, PEAP with MSCHAPv2, PEAP with GTC, TTLS with MSCHAPv2, TTLS
with GTC, and TTLS with PAP.

l The Windows EAP option supports TLS and PEAP with MSCHAPv2.

l The Ubuntu option supports TLS and PEAP with MSCHAPv2.

These best practices are recommended when choosing the 802.1X authentication methods to provision:

l Configure PEAP with MSCHAPv2 for Onboard devices – Android, Windows, and legacy OS X (10.5/10.6).

l Configure EAP-TLS for iOS devices and OS X (10.7 or later).

l Other EAP methods, while possible, are limited in their applicability and should only be used if you have a
specific requirement for that method.

The Windows EAP options that may be specified include:

l Enable Fast Reconnect – Fast Reconnect is a PEAP property that enables wireless clients to move between
wireless access points on the same network without being re-authenticated each time they associate with a
new access point. If TLS is selected, Fast Reconnect is not available.
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l Enforce Network Access Protection– Enable this option to obtain a system statement-of-health (SSoH)
from the OnGuard or Microsoft NAP Agent and send it to the authentication server during the 802.1X
authentication process. Use this option to enforce network access control (NAC) protections on the
network. If TLS is selected, Enforce Network Access Protection is not available.

l Enforce Cryptobinding – Cryptobinding is a process that protects the authentication protocol negotiation
against man-in-the-middle attacks. The cryptobinding request and response performs a two-way
handshake between the peer and the authentication server using key materials. If TLS is selected, Enforce
Cryptobinding is not available.

The Ubuntu EAP field lets you configure the authentication protocol to use when configuring an Ubuntu
device. Options include:

l TLS

l PEAP with MSCHAPv2

When you have completed your selections on this tab, do one of the following:

l Click Previous to return to the Access tab.

l Click Next to continue to the Authentication tab.

l Click Save Changes to make the new network configuration settings take effect.

l Click Cancel to discard your changes and return to the main Onboard configuration user interface.

For information about the list of network settings, see "Network Settings " on page 129. For more information
about configuration profiles, see "Configuration Profiles" on page 163

Configuring Device Authentication Settings
On the Onboard > Configuration > Network Settings form, click the Authentication tab to display the
Enterprise Authentication form.

1. Select one of these options in the iOS & OS X Credentials drop-down list:

l Certificate – A device certificate will be provisioned and used for EAP-TLS client authentication. When
this option is selected, EAP-TLS must be selected on the Protocols tab.

l Username & Password – A device certificate will be provisioned, but the client authentication will use
unique device credentials (as for Onboard devices). When this option is selected, EAP-TTLS or PEAP must
be selected on the Protocols tab.

2. The Windows Authentication area is included on this tab if TLS was chosen for Windows EAP on the
Protocols tab.
The Certificate Store field in this area lets you specify the certificate store where the client certificate will
be provisioned. Options available for this field are:

l User – Use user-only credentials. This is the default.

l Machine – Use computer-only credentials.
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l Machine and User – Use computer-only credentials or user-only credentials. When a user is logged on,
the user's credentials are used for authentication. When no user is logged on, computer-only credentials
are used for authentication.

3. Do one of the following:

l Click Previous to return to the Protocols tab.

l Click Next to continue to the Trust tab.

l Click Save Changes to make the new network configuration settings take effect

l Click Cancel to discard your changes and return to the main Onboard Configuration user interface.

For information about the list of network settings, see "Network Settings " on page 129. For more information
about configuration profiles, see "Configuration Profiles" on page 163

Configuring Certificate Trust Settings

On the Onboard > Configuration > Network Settings form, click the Trust tab to display the Enterprise
Trust form. Use this form to create the network settings that will be sent to a provisioned device.

Configuring Trust Settings Automatically

1. When you open this tab, the default selection in the Configure Trust field is Automatically configure
trust settings (recommended). With this option selected, Onboard automatically determines the
appropriate certificate trust configuration for your deployment.

2. If the deployment is not using the built-in CA, you may use the Trusted Server Names text field to enter
the certificate names to accept from the authentication server. Only certificates included in this list will be
trusted. Enter each server name on a separate line. You can use wildcards.

3. Do one of the following:

l Click Previous to return to the Authentication tab.

l Click Next to continue to the Windows tab.

l Click Save Changesto make the new network configuration settings take effect.

l Click Cancel to discard your changes and return to the main Onboard configuration user interface.
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Configuring Trust Settings Manually

1. In the Configure Trust drop-down list:

l If you are using Policy Manager for authentication, leave this option set to Automatically configure
trust settings. The complete trust chain is included in the profile download.

l To change the recommended default setting and configure trust settings manually, choose Manually
configure certificate trust settings . The form expands to include configuration options.

2. If the deployment is not using the built-in CA, you may use the Trusted Server Names text field to enter
the certificate names to accept from the authentication server. Only certificates included in this list will be
trusted. Enter each server name on a separate line. You can use wildcards.

3. In the Trusted Certificates row, the recommended certificate is selected by default. You may click the field
to open the drop-down list and select a different certificate the client should trust. You should include the
root certificate that issued the authentication server’s certificate, and you should provide the certificate for
each authentication server a provisioned device will use.

4. You can use the Upload Certificate options to import additional trusted certificates. Click Choose File to
navigate to the file on your computer, then click Upload. The certificate is imported, and the certificate
name is displayed above the form. You can click the Show certificate link next to the name to view
certificate details. The certificate is also displayed in the Certificate Management list with the type “trusted.”

5. In the Dynamic Trust row, you should avoid marking the Allow trust exceptions check box – the
network administrator should make all trust decisions. Users will not generally review certificates for
potential issues before accepting them. If you wish to enable trust decisions to be made by the user, you
may unmark the Allow trust exceptions check box. Be aware that this is an insecure configuration, as a
user can override a security warning if a man-in-the-middle attack occurs.

6. In the Android Trust area, use the Trusted Certificate drop-down list to select a certificate the device
should trust. Android supports only a single trusted certificate; this must be the root CA that issued the
authentication server’s certificate. Be aware that if None is selected, 802.1x authentication might not work.
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7. In the Windows Trust area, mark the Validate the server certificate check box. This ensures that the
provisioned device will check the server certificate is valid before using the server for authentication. If this
check box is unmarked, the configuration will not be secure. An attacker could provide another server
certificate which the client would not verify.

8. Do one of the following:

l Click Previous to return to the Authentication tab.

l Click Next to continue to the Windows tab.

l Click Save Changes to make the new network configuration settings take effect

l Click Cancel to discard your changes and return to the main Onboard configuration user interface.

For information about the list of network settings, see "Network Settings " on page 129. For more information
about configuration profiles, see "Configuration Profiles" on page 163

Configuring Windows-Specific Network Settings

On the Onboard > Configuration > Network Settings form, click the Windows tab to display the
Windows Network Settings form.

Network Access Protection (NAP) is a feature in Windows Server 2008 that controls access to network
resources based on a client computer’s identity and compliance with corporate governance policy. NAP allows
network administrators to define granular levels of network access based on who a client is, the groups to
which the client belongs, and the degree to which that client is compliant with corporate governance policy. If a
client is not compliant, NAP provides a mechanism to automatically bring the client back into compliance and
then dynamically increase its level of network access.

Deploying NAP requires a NAP-compatible authentication server, so that appropriate policies may be
implemented based on the statement of health provided by the NAP client.

To enable NAP for Microsoft Windows clients, mark the Enable NAP services check box on this tab. You will
also need to mark the Enable Quarantine Checks check box on the Protocols tab.

The Admin Username field can be used if configuration of networking requires administrator credentials. This
field lets you embed administrator credentials so you can allow privileged operations such as application
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installation to be done during onboarding by end users who otherwise do not have admin privileges. (Not
supported by Windows 8 or above)

l Do one of the following:

n Click Previous to return to the Trust tab.

n Click Next to continue to the Proxy tab.

n Click Save Changesto make the new network configuration settings take effect.

n Click Cancel to discard your changes and return to the main Onboard configuration user interface.

For information about the list of network settings, see "Network Settings " on page 129. For more information
about configuration profiles, see "Configuration Profiles" on page 163

Configuring Proxy Settings

On the Onboard > Configuration > Network Settings form, click the Proxy tab to display the Proxy
Settings form.

Select one of these options in the Proxy Type drop-down list:

l None– No proxy server will be configured.

l Manual– A proxy server will be configured, if the device supports it. Specify the proxy server settings in the
Server and Server Port fields.

l Automatic– The device will configure its own proxy server, if the device supports it. Specify the location of
a proxy auto-config file in the PAC URLtext field.

l Do one of the following:

n Click Previous to return to the Windows tab.

l Click Save Changesto make the new network configuration settings take effect

n Click Cancel to discard your changes and return to the main Onboard configuration user interface.

For information about the list of network settings, see "Network Settings " on page 129. For more information
about configuration profiles, see "Configuration Profiles" on page 163
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iOS Settings

You can manage iOS device settings for provisioned devices. A variety of settings are available, including such
things as contacts, email, passcode policy, VPN, and Web clips settings. After you define each of the settings
you wish to use, you can include them in configuration profiles. The configuration profiles are available in the
Provisioning Settings form, and can be associated with a device provisioning configuration set.

To create and work with iOS settings, go to Onboard > Configuration > iOS Settings. The iOS Settings list
view opens.

All iOS settings that have been configured are included in the list. Each setting's name and type are shown in
the list. You can click and iOS setting's row in the list for additional options:

Field Description

Show
Details

Displays details for the iOS setting. The form expands to show its name, description, and configuration
values specific to the type of setting.

Edit Edit the iOS setting's configuration. The Settings form for the type of iOS setting opens.

Duplicate
Creates a copy of an iOS setting to use as a basis for a new setting. The Settings form specific to the
type of setting opens with all attributes prepopulated and "Copy" appended to its name. You can
rename the new setting, and edit any of its attributes.

Delete Deletes the iOS setting. You will be asked to confirm the deletion.

Show
Usage Displays a list of configuration profiles that use the iOS setting.

Add New To create a new iOS setting, click this link above the table. The Settings form specific to the type of iOS
setting opens.

Table 24: The iOS Settings List

For information on creating, editing, or duplicating the different types of iOS settings, see:

l "Configuring ActiveSync Settings " on page 140

l "Configuring AirPlay Settings" on page 142

l "Configuring AirPrint Settings" on page 143

l "Configuring APN Settings" on page 144

l "Configuring Calendar Settings" on page 144

l "Configuring Contacts Settings" on page 146

l "Configuring Email Settings" on page 147
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l "Configuring Global HTTP Proxy Settings" on page 150

l "Configuring an iOS Device Passcode Policy " on page 151

l "Configuring Single Sign-On Settings" on page 153

l "Configuring Calendar Subscription Settings" on page 154

l "Configuring an iOS Device VPN Connection" on page 155

l "Configuring Web Clips" on page 159

l "Configuring Web Content Filter Settings" on page 160

Configuring ActiveSync Settings

Exchange ActiveSync configurations you define can be used in configuration profiles to automatically configure
an email account on an iOS device. Use an ActiveSync configuration when you have an Exchange mail server
and want to automatically provide the email settings to users provisioning their mobile devices. You can define
multiple ActiveSync settings.

Exchange ActiveSync settings are only supported by iOS devices; they will be ignored by all other device types.

To create and work with Exchange ActiveSync configurations, go to Onboard > Configuration > iOS
Settings. Either click an existing ActiveSync setting's name in the list; or click Add New, select ActiveSync
Settings in the Settings Type drop-down list, and click Create. The Exchange ActiveSync Settings form
opens.

1. In the Name field, give the ActiveSync configuration a short name that identifies it clearly. ActiveSync
configuration names can include spaces.

If you are duplicating a configuration, the original name has a number appended to it. You may highlight
this name and replace it with a new name.

2. In the Description field, briefly describe the characteristics of the ActiveSync setting.

In the General Settings area:

1. (Required) In the ActiveSync Host field, enter the hostname or IP address of the server the device will
connect to.

2. To ensure that all communications are encrypted, select the check box in the Use SSL field.
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3. In the Magic String field, enter the value to send as the "X-Apple-Config-Magic" header in each EAS HTP
request.

4. To allow the user to move messages out of this email account into another account, select the check box in
the Allow Move field. Leave this field blank to prevent moving messages between accounts, and to prevent
forwarding or replying from other than the message's originating account.

5. To include this email account in recent address syncing, select the check box in the Allow Recent Address
Sync field.

6. To send outgoing mail from this account only from the Mail app, and prevent sending mail in third-party
applications, select the check box in the Use Only in Mail field.

In the Account Settings area:

1. (Required) Choose one of the following options from the Account Details drop-down list:

l User provided — entered by user on device. This option requires the user to enter their credentials
on the device to access their email.

l Identity certificate — created during provisioning. This option uses the device’s TLS client
certificate to authenticate the user. Using this option requires configuration of the ActiveSync server to
authenticate a user based on the client certificate.

l Provisioning — values acquired during device provisioning.

l Shared preset values — testing only. This option provides a fixed set of credentials to the device.
These settings cannot be modified for each user when provisioning a device, so it is recommended that
these settings only be used when testing Exchange integration.

2. In the Domain field, enter the domain for the account.

3. Select the appropriate option n the Email Address field. Options include Let system define, Same as
username, and Generate using username.

4. If "Shared preset values - testing only" was chosen in the Account Details field, this form includes fields for
login credentials. Enter the login information for testing in the User, Password, and Confirm fields. The
minimum password length is six characters. If both the Domain and User fields are blank, the device will
prompt the user.

In the Sync Settings area:

1. Choose one of the following options from the Days of Mail drop-down list:

l No Limit

l 1 day

l 3 days

l 1 week
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l 2 weeks

l 1 month

2. Click Save Changes. The Exchange ActiveSync setting is available as a configuration unit on the
Configuration Profile form.

For more information about configuration profiles, see "Configuration Profiles" on page 163

Configuring AirPlay Settings

AirPlay settings you define can be used in configuration profiles for an iOS device. An AirPlay setting includes its
name and description, the destinations that are available to the device, and passwords for each destination.
You can define multiple AirPlay settings.

AirPlay settings are only supported by iOS 7 devices; they will be ignored by all other device types.

To configure an AirPlay setting:

1. Go to Onboard > Configuration > iOS Settings. Either click an existing AirPlay setting's name in the list;
or click Add New, select AirPlay Settings in the Settings Type drop-down list, and click Create. The
AirPlay Settings form opens.

2. In the Name field, give this AirPlay setting a short name that identifies it clearly. AirPlay setting names can
include spaces.

If you are duplicating an AirPlay setting, the original name has "Copy" appended to it. You may highlight this
name and replace it with a new name.

3. In the Description field, you can briefly describe the characteristics of the AirPlay setting.

4. In the AirPlay Destinations field, specify the device ID of each AirPlay destination that will be available to
the device. Each device ID must be entered on a new line. To make all destinations available, leave this field
empty.

5. (Optional) In the AirPlay Destination Passwords field, you may enter a device password for each
destination. The minimum password length is six characters.
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6. Click Save Changes. The AirPlay setting is available as a configuration unit on the Configuration Profile
form.

For more information about configuration profiles, see "Configuration Profiles" on page 163

Configuring AirPrint Settings

AirPrint settings you define can be used in configuration profiles for an iOS device. An AirPrint setting includes
its name and description, and AirPrint printer locations that are available to the user. You can define multiple
AirPrint settings.

AirPrint settings are only supported on iOS 7 devices; they are ignored by all other devices.

To configure an AirPrint setting:

1. Go to Onboard > Configuration > iOS Settings. Either click an existing AirPrint setting's name in the list;
or click Add New, select AirPrint Settings in the Settings Type drop-down list, and click Create. The
AirPrint Settings form opens.

2. In the Name field, give this AirPrint setting a short name that identifies it clearly. AirPrint setting names can
include spaces.

If you are duplicating an AirPrint setting, the original name has "Copy" appended to it. You may highlight
this name and replace it with a new name.

3. In the Description field, you can briefly describe the characteristics of the AirPrint setting.

4. (Required) In the AirPrint Printers field, specify the Destination IP address and Resource Path of each
AirPrint location that will be available to the user.

5. Click Save Changes. The AirPrint setting is available as a configuration unit on the Configuration Profile
form.

For more information about configuration profiles, see "Configuration Profiles" on page 163
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Configuring APN Settings

APN settings you define can be used in configuration profiles for an iOS device. An APN setting includes its
name and description, carrier and proxy server information, and user account provisioning details. You can
define multiple APN settings.

APN settings are only supported on iOS devices; they are ignored by all other devices.

To configure an APN setting:

1. Go to Onboard > Configuration > iOS Settings. Either click an existing APN setting's name in the list; or
click Add New, select APN Settings in the Settings Type drop-down list, and click Create. The APN
Settings form opens.

2. In the Name field, give this APN setting a short name that identifies it clearly. APN setting names can
include spaces.

If you are duplicating an APN setting, the original name has "Copy" appended to it. You may highlight this
name and replace it with a new name.

3. In the Description field, you can briefly describe the characteristics of the APN setting.

4. Click Save Changes. The APN setting is available as a configuration unit on the Configuration Profile form.

For more information about configuration profiles, see "Configuration Profiles" on page 163

Configuring Calendar Settings

CalDAV settings you define can be used in configuration profiles for an iOS device. CalDAV accounts give a
provisioned device access to scheduling information on a remote server. A CalDAV setting includes its name
and description, the account description and hostname, port, principal URL, and whether SSL is enabled, as well
as additional account details. You can define multiple CalDAV settings.

APN settings are only supported on iOS devices; they are ignored by all other devices.
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To configure a CalDAV account:

1. Go to Onboard > Configuration > iOS Settings. Either click an existing Calendar setting's name in the
list; or click Add New, select Calendar Settings in the Settings Type drop-down list, and click Create. The
CalDAV Account Settings form opens.

2. In the Name field, give this calendar setting a short name that identifies it clearly. Calendar settings names
can include spaces.

If you are duplicating a calendar setting, the original name has "Copy" appended to it. You may highlight this
name and replace it with a new name.

3. In the Description field, you can briefly describe the characteristics of the calendar settings.

4. In the Account Description field, you can enter the display name for the account.

5. (Required) In the Account Hostname field, enter the hostname of IP address of the CalDAV server.

6. (Required) In the Port field, use the counter to enter the port number of the CalDAV server.

7. To enable secure socket layer communication with the CalDAV server, mark the check box in the Use SSL
row.

8. In the Account Principal URL field, you can enter the principal URL for the CalDAV account.

9. (Required) Choose an option from the Account Details drop-down list to indicate how user account
information should be supplied. Options available in the list include:

l User provided - entered by user on device

l Provisioning - values acquired during device provisioning

l Shared preset values - testing only

10.If Shared preset values - testing only is selected in the Account Details drop-down list, the Username
and Password fields are added to the form. Enter the CalDAV username and password to be used. The
minimum password length is six characters.

11.Click Save Changes. The calendar settings are available as a configuration unit on the Configuration Profile
form.
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For more information about configuration profiles, see "Configuration Profiles" on page 163

Configuring Contacts Settings

CardDAV settings you define can be used in configuration profiles for an iOS device. CardDAV accounts allow
users of a provisioned device to access and share contact data on a server. A CardDAV setting includes its name
and description, the account description and hostname, port, principal URL, and whether SSL is enabled, as well
as additional account details. You can define multiple CardDAV settings.

CardDAV account settings are only supported on iOS devices; they are ignored by all other devices.

To configure a CardDAV account:

1. Go to Onboard > Configuration > iOS Settings. Either click an existing CardDAV setting's name in the
list; or click Add New, select Contacts Settings in the Settings Type drop-down list, and click Create. The
CardDAV Account Settings form opens.

2. In the Name field, give this contacts setting a short name that identifies it clearly. Contacts settings names
can include spaces.

If you are duplicating a contacts setting, the original name has "Copy" appended to it. You may highlight this
name and replace it with a new name.

3. In the Description field, you can briefly describe the characteristics of the contacts settings.

4. In the Account Description field, you can enter the display name for the account.

5. (Required) In the Account Hostname field, enter the hostname of IP address of the CardDAV server.

6. (Required) In the Port field, use the counter to enter the port number of the CardDAV server.

7. To enable secure socket layer communication with the CardDAV server, mark the check box in the Use SSL
row.

8. In the Account Principal URL field, you can enter the principal URL for the CardDAV account.
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9. (Required) Choose an option from the Account Details drop-down list to indicate how user account
information should be supplied. Options available in the list include:

l User provided - entered by user on device

l Provisioning - values acquired during device provisioning

l Shared preset values - testing only

10.If Shared preset values - testing only is selected in the Account Details drop-down list, the Username
and Password fields are added to the form. Enter the CardDAV username and password to be used. The
minimum password length is six characters.

11.Click Save Changes. The contacts settings are available as a configuration unit on the Configuration Profile
form.

For more information about configuration profiles, see "Configuration Profiles" on page 163

Configuring Email Settings

Email settings you define can be used in configuration profiles for an iOS device. You can define multiple Email
settings.

Email settings are only supported on iOS devices; they are ignored by all other devices.

To configure email settings:

1. Go to Onboard > Configuration > iOS Settings. Either click an existing Email setting's name in the list; or
click Add New, select Email Settings in the Settings Type drop-down list, and click Create. The Email
Settings form opens.

2. In the Name field, give the email settings a short name that identifies it clearly. Email settings names can
include spaces.

If you are duplicating an email settings, the original name has "Copy" appended to it. You may highlight this
name and replace it with a new name.

3. In the Description field, briefly describe the characteristics of the email settings.

In the General Settings area:

4. In the Account Description field, you can enter the display name for the mail account.

ClearPass Guest 6.4 | User Guide Onboard | 147
Anexo 11 ITEM 01 (0592523)         SEI 0008478-63.2018.6.02.8000 / pg. 3174



148 | Onboard ClearPass Guest 6.4 | User Guide

5. In the Get Email Address From field, choose an option from the drop-down list to indicate how user
account information should be supplied. Options available in the list include:

l User provided - entered by user on device

l Provisioning - values acquired during device provisioning

l Shared preset values - testing only

The remaining fields available in the General Settings area will vary according to your choice in the this drop-
down list.

6. In the Email Address field, enter the full email address for the account.

7. In the Email Address Domain field, enter the domain name to append to the username.

8. Choose an option in the When to Add Email Address Domain field. Available options include Only if
username is not a valid email address and Always add the domain.

9. To allow users to move messages from the account, mark the check box in the Allow Move field.

10.To include the account in recent address syncing, mark the check box in the Allow Recent Address Sync
field.

11.In the Use Only in Mail field, mark the check box if outgoing mail should only be sent from the Mail app,
and should not be available for sending mail in third-party applications.

In the Incoming Mail Server Settings area:

1. Enter the hostname or IP address of the server for the incoming mail in the Incoming Mail Server field
(for example, mail.exampleprovider.com).

2. In the Port drop-down list, use the counter to select the server to user for incoming mail.

3. To enable secure socket layer communication with the server and ensure that communications are
encrypted, mark the check box in the Use SSL row.

4. Choose an authentication method from the drop-down list in the Authentication Type row. Options
include:

l Password

l MD5 Challenge-Response

l NTLM

l HTTP MD5 Digest

l None

5. Choose an option from the Account Details drop-down list to indicate how user account information
should be supplied. Options available in the list include:

l User provided - entered by user on device
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l Provisioning - values acquired during device provisioning

l Shared preset values - testing only

6. If Shared preset values - testing only is selected in the Account Details drop-down list, the Username
and Password fields are added to the form. Enter the CalDAV username and password for connecting to
the server for incoming mail. The minimum password length is six characters.

In the Outgoing Mail Server Settings area:

1. Enter the hostname or IP address of the server for the outgoing mail in the Outgoing Mail Server field
(for example, smtp.exampleprovider.com).

2. In the Port drop-down list, use the counter to select the server to user for outgoing mail.

3. To enable secure socket layer communication with the server and ensure that communications are
encrypted, mark the check box in the Use SSL row.

4. Choose an authentication method from the drop-down list in the Authentication Type row. Options
include:

l Password

l MD5 Challenge-Response

l NTLM

l HTTP MD5 Digest

l None

5. Choose an option from the Account Details drop-down list to indicate how user account information
should be supplied. Options available in the list include:

l User provided - entered by user on device

l Provisioning - values acquired during device provisioning

l Shared preset values - testing only

6. If Shared preset values - testing only is selected in the Account Details drop-down list, the Username
field is added to the form. Enter the username for connecting to the server for outgoing mail.

7. To use the same password for incoming and outgoing mail, mark the check box in the Outgoing Password
Same as Incoming field.

8. To have the email account support S/MIME, mark the check box in the Use S/MIME row.

9. Click Save Changes. The application set is available as a configuration unit on the Configuration Profile
form.

For more information about configuration profiles, see "Configuration Profiles" on page 163
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Configuring Global HTTP Proxy Settings

Global HTTP proxy settings you define can be used in configuration profiles for an iOS device. A global
HTTP proxy setting includes its name, description, and common global HTTP proxy settings. You can define
multiple global HTTP proxy settings.

Global HTTP proxy settings are only supported on supervised iOS devices; they are ignored by all other devices.

To configure a global HTTP proxy setting:

1. Go to Onboard > Configuration > iOS Settings. Either click an existing global HTTP proxy setting's name
in the list; or click Add New, select Global HTTP Proxy Settings in the Settings Type drop-down list, and
click Create. The Global HTTP Proxy Settings form opens.

2. In the Name field, give the global HTTP proxy setting a short name that identifies it clearly. Global
HTTP proxy setting names can include spaces.

If you are duplicating a global HTTP proxy setting, the original name has "Copy" appended to it. You may
highlight this name and replace it with a new name.

3. In the Description field, briefly describe the characteristics of the global HTTP proxy setting.

4. (Required) In the Proxy Setup drop-down list, choose either Manual or Automatic. If you choose Manual,
the form includes options for server, authentication, and login information. If you choose Automatic, the
form includes options for PAC URL and fallback.

5. (Required for Manual setting) In the Server field, enter the proxy server's network address.

6. (Required for Manual setting) In the Server Port field, select the value for the proxy server's port.

7. In the Authentication field, enter the username that will be used to connect to the proxy server.

8. In the Password and Confirm fields, enter the password that will be used to connect to the proxy server.
The minimum password length is six characters.

9. In the PAC URL field, you may enter the URL of the PAC file that defines the proxy configuration. To let
devices use the Web proxy autodiscovery protocol (WPAD) to discover proxies, leave this field blank.
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10.To allow the device to bypass the proxy server and display the login page for captive networks, mark the
check box in the Captive Networks Login field. This option is only available for iOS 7.0 and later.

11.To allow devices to connect directly to the destination if the PAC file is unreachable, mark the check box in
the Allow Fallback field. If this check box is not selected, devices are prevented from connecting directly to
the destination in the event that the PAC file is unreachable. This option is only available for iOS 7.0 and
later.

12.Click Save Changes. The global HTTP proxy setting is available as a configuration unit on the Configuration
Profile form.

For more information about configuration profiles, see "Configuration Profiles" on page 163

Configuring an iOS Device Passcode Policy

Passcode policy settings are typically used when you provision a corporate-owned device, or when a user is
given remote access to sensitive information. Passcode policy settings you define can be used in configuration
profiles for an iOS device. You can define multiple passcode policy settings.

Passcode policy settings are only supported by iOS devices; they will be ignored by all other device types.

To configure a passcode policy:

1. Go to Onboard > Configuration > iOS Settings. Either click an existing passcode policy setting's name in
the list; or click Add New, select Passcode Policy Settings in the Settings Type drop-down list, and click
Create. The Passcode Policy Settings form opens.

2. In the Name field, give the passcode policy a short name that identifies it clearly. Passcode policy names
can include spaces.

If you are duplicating a passcode policy, the original name has "Copy" appended to it. You may highlight this
name and replace it with a new name.

3. In the Description field, briefly describe the characteristics of the passcode policy.

4. To require the user to create a passcode, mark the check box in the Force PIN field.
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5. If the passcode will not need restrictions on repeated or sequential characters, you can mark the check box
in the Allow Simple field.

6. If the passcode must include alphabetic characters in addition to numbers, mark the check box in the
Require Alphanumeric field.

7. To disable all push operations while the user is roaming, requiring the user to manually fetch new data, mark
the check box in the Manual Fetching When Roaming field.

8. To limit the number of times the passcode may be entered incorrectly before the device is locked, use the
counter in the Max Failed Attempts field to specify the maximum number of attempts allowed.

9. To limit the time the device is allowed to be idle before it is locked and the user must re-enter the passcode,
use the drop-down list in the Max Inactivity field to select a number of minutes. Options in this list are
Unlimited or 2, 5, 10, or 15 minutes. The user may set a lower number.

10.To specify a maximum duration for the passcode, use the counter in the Max PIN Age field. After the
specified number of days, the device is locked and the user must change their passcode.

11.To require that the passcode include complex characters, use the counter in the Min Complex Chars field
to specify how many complex characters it must contain. Complex, or special, characters are non-
alphanumeric, such as &%$#.

12.To set a maximum time in which the user may unlock the device without re-entering the passcode, use the
drop-down list in the Max Grace Period field to select a number of minutes. The user may set a lower
number.

13.To specify the minimum number of characters the passcode must include, use the counter in the Min
Length field to select the number of characters.
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14.To specify that when the user changes their passcode the new value cannot be one that was used within a
defined period of the passcode's history, use the counter in the PIN History field. The number you select is
the number of recent passwords whose values will not be allowed.

15.Click Save Changes. The passcode policy is available as a configuration unit on the Configuration Profile
form.

For more information about configuration profiles, see "Configuration Profiles" on page 163

Configuring Single Sign-On Settings

Single Sign-On (SSO) settings let you configure the access-control properties that allow a user to log in once to
access multiple related but independent applications or systems. SSO authenticates the user across all allowed
resources during their session, eliminating additional login prompts. An SSO setting includes its name and
description, the account's display name, and the Kerberos account principal name, realm name, and URL prefix
matches. SSO settings you define can be used in configuration profiles for an iOS device. You can define
multiple SSO settings.

SSO settings are only supported on iOS devices; they are ignored by all other devices.

To configure an SSO setting:

1. Go to Onboard > Configuration > iOS Settings. Either click an existing SSO setting's name in the list; or
click Add New, select SSO Settings in the Settings Type drop-down list, and click Create. The Single
Sign-On Settings form opens.

2. In the Name field, give the SSO setting a short name that identifies it clearly. SSO setting names can include
spaces.

3. If you are duplicating an SSO setting, the original name has "Copy" appended to it. You may highlight this
name and replace it with a new name.

4. In the Description field, briefly describe the characteristics of the SSO setting.

5. In the Account Description field, enter the account display name.

6. In the Kerberos SSO area, enter the Kerberos principal name in the Principal Name field. This is a unique
ID, and includes three parts: the primary, the instance, and the realm. These follow the format
primary/instance@REALM, where:
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l Primary = First part of the principal name. For a user, it is the username. For a host, the it is the word
"host".

l Instance = Optional string. Must be separated from the primary by a slash character. For a user, the
instance might be null. For a host, this is the fully-qualified hostname—for example,
"support.exampleSchool.edu".

l Realm = The Kerberos realm. Usually the same as the domain name, in uppercase letters—for example,
"EXAMPLESCHOOL.EDU".

7. In the Realm Name field, enter the Kerberos realm name.

8. In the URL Prefix Matches field, enter the list of URL prefixes that must be matched for Kerberos
authentication. Each URL prefix must begin with either http:// or https://. If a URL prefix does not end in /, a
/ is appended to it. Leave this field blank to match all http:// and https:// URLs.

9. Click Save Changes. The SSO setting is available as a configuration unit on the Configuration Profile form.

For more information about configuration profiles, see "Configuration Profiles" on page 163

Configuring Calendar Subscription Settings

Subscribed calendar settings let you configure the calendar subscriptions that will be sent to the provisioned
device. A calendar subscription's settings include its name and description, the account description, server, and
whether SSL is enabled, as well as additional account details. Subscribed calendar settings you define can be
used in configuration profiles for an iOS device. You can define multiple subscribed calendar settings.

Subscribed calendar settings are only supported on iOS devices; they are ignored by all other devices.

To configure a calendar subscription setting:

1. Go to Onboard > Configuration > iOS Settings. Either click an existing subscribed calendar setting's
name in the list; or click Add New, select Subscribed Calendar Settings in the Settings Type drop-down
list, and click Create. The Subscribed Calendar Settings form opens.

2. In the Name field, give this calendar subscription setting a short name that identifies it clearly. Calendar
subscription settings names can include spaces.
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If you are duplicating a calendar subscription setting, the original name has "Copy" appended to it. You may
highlight this name and replace it with a new name.

3. In the Description field, you can briefly describe the characteristics of the calendar subscription settings.

4. In the Account Description field, you can enter the display name for the calendar subscription.

5. In the Server field, enter the URL of the calendar file.

6. To enable secure socket layer communication with the server, mark the check box in the Use SSL row.

7. In the Account Settings area, choose an option from the Account Details drop-down list to indicate how
user account information should be supplied. Options available in the list include:

l User provided - entered by user on device

l Provisioning - values acquired during device provisioning

l Shared preset values - testing only

8. If Shared preset values - testing only is selected in the Account Details drop-down list, the Username
and Password fields are added to the form. Enter the username and password to be used for the
subscribed calendar. The minimum password length is six characters.

9. Click Save Changes. The calendar settings are available as a configuration unit on the Configuration Profile
form.

For more information about configuration profiles, see "Configuration Profiles" on page 163

Configuring an iOS Device VPN Connection

Use VPN configuration profiles when you have deployed a VPN infrastructure and want to automatically
provide the secure connection settings to users at the time of device provisioning. You can automatically
configure virtual private network (VPN) settings on iOS and OS X 10.7+ devices. VPN settings you define can be
used in configuration profiles for an iOS device. You can define multiple VPN settings.

VPN configuration profiles are only supported by iOS and OS X 10.7+ (Lion or later) devices; they will be
ignored by all other device types.

For information on configuring VPN connections, see:

l "Configuring an iOS Device VIA Connection " on page 155

l "Configuring an iOS Device L2TP, PPTP, or IPSec Connection " on page 157

Configuring an iOS Device VIA Connection

ArubaVIA is a remote access solution that provides secure connections for Enterprise networks. VIA detects the
user’s network environment (trusted and un-trusted) and automatically connects the user to their enterprise
network.

To configure the Aruba VIA solution on an iOS device:

1. Go to Onboard > Configuration > iOS Settings. Either click a VPN setting's name in the list; or click Add
New, select VPN Settings in the Settings Type drop-down list, and click Create. The VPN Settings form
opens.
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2. In the Name field, give the VPN configuration a short name that identifies it clearly. VPN configuration
names can include spaces.

If you are duplicating a VPN configuration, the original name has "Copy" appended to it. You may highlight
this name and replace it with a new name.

3. In the Description field, briefly describe the characteristics of the VPN configuration.

4. In the Connection Type drop-down list, choose Aruba VIA. The Aruba VIA Settings form expands to include
additional options.

5. In the Server field, enter a hostname or IP address of the server the device should connect to.

6. In the IKE Version field, select the version number for the Internet Key Exchange (IKE) protocol:

l v1 - This protocol performs the authentication in two phases.

l v2 - IKEv2 supports a wider variety of authentication mechanisms and it is faster when compared to
IKEv1 method. IKEv2 has only single phase authentication process

7. In the Authentication drop-down list, configure the following authentication types based on the IKE
version you select:

a. If you choose the IKEv1 protocol, you can specify the following authentication types:

n Certificate – The client certificate issued during device provisioning will also be used as the identity
certificate for VPN connections. This option requires configuring your VPN server to allow VIA
authentication using a client certificate.
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n Shared Secret / Group Name – An optional group name may be specified. A shared secret (pre-
shared key) is used to establish the VIA connection. Authentication is performed with a username and
password.

b. If you choose the IKEv2 protocol, you can specify the following authentication types. For VIA
deployments that use IKEv2, the VPN server always uses a certificate for IKEv2 authentication phase.
However, the devices can use certificates, EAP-MSCHAPv2, or EAP-TLS

n Certificate

n EAP-TLS

n EAP-MSCHAPv2

8. Enter the Internal IP address assigned to the controller.

9. In the DNS Suffix field, enter the DNS domain name for the resolution of the internal resources.

10.If you select the Enable Split Tunneling option, all the traffic to the VIA tunneled networks goes through
the controller and the rest is bridged directly on the device. You must specify the addresses and netmask to
which data will be tunneled through VIA when you enable this option.

11.If you enable the Enable VPN on Demand option, the VPN connection will be automatically established
when accessing certain domains. You must specify the domain names and the on-demand action that need
to be applied to these domains when you enable this option.

12.To configure the advanced settings for VIA, check the option Show Advanced Settings and select the
appropriate values.

13.You can specify a proxy server to use when the VPN connection is active. In the Proxy Settings area of the
form, choose one of the following options from the Proxy Setup drop-down list:

l None – No proxy server will be configured with this VPN profile.

l Manual – A proxy server will be configured with this VPN profile. Specify the proxy server settings in the
Server and Port fields.

l If authentication is required to access this proxy, you may specify the username and password using the
Authentication and Password text fields. The minimum password length is six characters.

l Automatic – The proxy server will be automatically configured with this VPN profile. Specify the
location of a proxy auto-config file in the Proxy Server URL text

14.Click Save Changes. The VPN configuration is available as a configuration unit on the Configuration
Profile form.

For more information about configuration profiles, see "Configuration Profiles" on page 163

Configuring an iOS Device L2TP, PPTP, or IPSec Connection

You can use VPN settings when you have deployed a VPN infrastructure and want to automatically provide the
secure connection settings to users at the time of device provisioning.

To configure the L2TP, PPTP, or IPSec VPN settings:

1. Go to Onboard > Configuration > iOS Settings. Either click a VPN setting's name in the list; or click Add
New, select VPN Settings in the Settings Type drop-down list, and click Create. The VPN Settings form
opens.
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2. In the Name field, give the VPN configuration a short name that identifies it clearly. VPN configuration
names can include spaces.

If you are duplicating a VPN configuration, the original name has "Copy" appended to it. You may highlight
this name and replace it with a new name.

3. In the Description field, briefly describe the characteristics of the VPN configuration.

4. In the Connection Type drop-down list, choose the appropriate connection type to enable:

l L2TP – Uses the Layer 2 Tunneling Protocol. Complete the fields displayed on the form for this
connection type.

l PPTP – Uses the Point-to-Point Tunneling Protocol. Complete the fields displayed on the form for this
connection type.

l IPSec – Uses the Internet Protocol with security extensions. Complete the fields displayed on the form
for this connection type.

5. If you chose IPSec as the connection type, the Authentication Type includes a drop-down list with the
following options:

l Identity Certificate – The client certificate issued during device provisioning will also be used as the
identity certificate for VPN connections. This option requires configuring your VPN server to allow IPSec
authentication using a client certificate.

l Shared Secret / Group Name – An optional group name may be specified. A shared secret (pre-shared
key) is used to establish the IPSec VPN. Authentication is performed with a username and password.
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6. In the Machine Authentication area, you may enter a value in the Shared Secret fields, or leave them
blank to prompt the user to create the shared secret.

7. In the User Authentication area of the form, you may enter a value in the Account field, or leave them
blank to prompt the user to enter the account.

8. In the User Authentication field, select either Password or RSA SecurID as the authentication type for
the connection.

9. You can specify a proxy server to use when the VPN connection is active. In the Proxy Settings area of the
form,. Choose one of the following options from the Proxy Setup drop-down list:

l None – No proxy server will be configured with this VPN profile.

l Manual – A proxy server will be configured with this VPN profile. Specify the proxy server settings in the
Server and Port fields.

l If authentication is required to access this proxy, you may specify the username and password using the
Authentication and Password text fields. The minimum password length is six characters.

l Automatic – The proxy server will be automatically configured with this VPN profile. Specify the
location of a proxy auto-config file in the Proxy Server URL text field.

10.Click Save Changes. The VPN configuration is available as a configuration unit on the Configuration
Profile form.

For more information about configuration profiles, see "Configuration Profiles" on page 163

Configuring Web Clips

When you create a Web clip, you can make any URL look like a native app on your device. You can assign it an
icon, and when the icon is selected, the URL opens in its own frame. Web clip settings let you create a library of
Web clips and bookmarks that can be sent to the provisioned device. A Web clip's settings include its name and
description, the icon if one was chosen, the URL, and whether the user can remove it. Web clip settings you
define can be used in configuration profiles for an iOS device. You can define multiple Web clip settings.

Web clip settings are only supported on iOS devices; they are ignored by all other devices.
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To configure a Web clip setting:

1. Go to Onboard > Configuration > iOS Settings. Either click an existing Web clip setting's name in the list;
or click Add New, select Web Clip Settings in the Settings Type drop-down list, and click Create. The
Web Clip Settings form opens.

2. In the Name field, give the Web clip a short name that identifies it clearly. Web clip names can include
spaces.

If you are duplicating a Web clip, the original name has "Copy" appended to it. You may highlight this name
and replace it with a new name.

3. In the Description field, briefly describe the characteristics of the Web clip.

4. In the URL field, enter the URL of the Web clip.

5. To enable the user to remove the Web clip, mark the check box in the Removable field.

6. If you wish to specify an icon for the Web clip, mark the check box in the Choose New Icon field. The form
expands to include the Custom Icon field.

7. If icon files have been uploaded in Content Manager, they are displayed in the Custom Icon field. Highlight
the icon to be used. If no images are displayed, upload your icon image or images to Content Manager, then
return to this form.

8. Click Save Changes. The Web clip is available as a configuration unit on the Configuration Profile form.

For more information about configuration profiles, see "Configuration Profiles" on page 163

Configuring Web Content Filter Settings

Web content filter settings let you configure the lists of whitelisted and blacklisted Web URLs that will be sent
to supervised provisioned devices. Web content filter settings you define can be used in configuration profiles
for an iOS device. A Web content filter setting includes its name and description, automatic filtering option, and
lists of permitted URLs, whitelisted bookmarks, and blacklisted URLs. You can define multiple Web content
filter settings.
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Web content filter settings are only supported on supervised iOS 7 devices; they are ignored by all other
devices.

To configure a Web content filter setting:

1. Go to Onboard > Configuration > iOS Settings. Either click an existing Web content filter setting's name
in the list; or click Add New, select Web Content Filter Settings in the Settings Type drop-down list, and
click Create. The Web Content Filter Settings form opens.

2. In the Name field, give the Web content filter a short name that identifies it clearly. Web content filter
names can include spaces.

If you are duplicating a Web content filter, the original name has "Copy" appended to it. You may highlight
this name and replace it with a new name.

3. In the Description field, briefly describe the characteristics of the Web content filter.

4. To enable automatic filtering, select the check box in the Automatic Filtering field. The Permitted URLs
field is added to the form.

5. If automatic filtering was selected, use the Permitted URLs field to specify URLs that should be accessible
even if they would otherwise be denied by the automatic filter. Each URL must begin with either http:// or
https://. If this field is left blank, all Web sites will be blocked.

6. In the Whitelisted Bookmarks field, enter the URLs to add to the bookmarks in Safari. The user will only
be allowed to visit these sites. The bookmark title and URL are both required. If a folder name is not
entered, the bookmark is added to the default bookmarks list in Safari.

7. In the Blacklisted URLs field, enter the URLs to block. Each URL must begin with either http:// or https://.
All characters of the URL prefix must be an exact match.

8. Click Save Changes. The Web content filter is available as a configuration unit on the Configuration Profile
form.

For more information about configuration profiles, see "Configuration Profiles" on page 163
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Windows Applications

Application sets let you specify either individual apps or groups of apps that should be installed during device
provisioning, and indicate whether they should be restarted when the device is provisioned. After you define
each of the sets you wish to use, you can include them in configuration profiles. The configuration profiles are
available in the Provisioning Settings form, and can be associated with a device provisioning configuration set.

To create and work with Windows application sets, go to Onboard > Configuration > Windows
Applications. The App Sets list view opens.

All Windows application sets that have been configured are included in the list. Each set's name is shown in the
list. You can click a Windows application set's row in the list for additional options:

Field Description

Show
Details

Displays details for the Windows application set. The form expands to show its name, description, and
configuration values.

Edit Edit the Windows application set's configuration. The App Set form opens.

Duplicate
Creates a copy of a Windows application set to use as a basis for a new set. The App Set form opens
with all attributes prepopulated and "Copy" appended to its name. You can rename the new app set,
and edit any of its attributes.

Delete Deletes the Windows application set. You will be asked to confirm the deletion.

Show
Usage Displays a list of configuration profiles that use the Windows application set.

Create
new app
set

To create a new Windows application set, click this link above the table. The App Set configuration
form opens.

Table 25: The Windows App Set List

For information on configuring a Windows app set, see "Configuring App Sets" on page 162.

Configuring App Sets
App sets you define let you specify an app or group of apps to be installed during device provisioning, and
whether an app requires the device to be restarted after provisioning.

To configure an app set:

1. Go to Onboard > Configuration > Windows Applications, and then either click the Edit link for and app
set in the list, or click the Create new app set link in the upper-right corner. The App Set form opens.
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2. In the Name field, give the app set a short name that identifies it clearly. App set names can include spaces.

If you are duplicating an app set, the original name has "Copy" appended to it. You may highlight this name
and replace it with a new name.

3. In the Description field, briefly describe the characteristics of the app set.

4. In the Windows Applications area, apps you have downloaded through the Content Manager are listed in
the Installers field.

l To specify that an app should be installed during provisioning, mark its Install application check box.

l To specify that the device needs to be restarted after the app is installed, mark its Requires restart
check box.

5. Click Save Changes. The app set is available as a configuration unit on the Configuration Profile form.

To add or manage apps in Content Manager, click the Content Manager link above the form. You can
download apps to your system as content items, then upload them to the Content Manager.

For more information about configuration profiles, see "Configuration Profiles" on page 163

Deployment and Provisioning

Onboard lets you configure deployment and provisioning settings. Configuration profiles let you define the
profile settings that will be provisioned to devices, including configuration units. Provisioning settings let you
define the settings for device provisioning. The configuration profiles are available in the Provisioning Settings
form.

l To create and manage configuration profiles, see "Configuration Profiles" on page 163

l To create and manage provisioning settings, see "Provisioning Settings " on page 167

Configuration Profiles

Onboard lets you create and manage multiple configuration profiles to choose from for your captive portal
pages. To manage the configuration profiles that will be provisioned to onboarded devices, go to Onboard >
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Deployment and Provisioning > Configuration Profiles. The Configuration Profiles list view opens.

All configuration profiles that have been created are included in the list. You can click a profile's row in the list
for additional options:

l To view details for a configuration profile, click its Show Details link.The form expands to show the
following settings that will be provisioned to devices using it: The device's name and description, a list of the
configuration units that will be provisioned to it, and a list of supervised devices. For information on
configuration units, see "Onboard Configuration" on page 129.

l To edit any of a configuration profile's attributes, click its Edit link. The Profile form opens, where you can
edit any of the profile's attributes.

l To create a copy of a profile to use as a basis for a new profile, click its Duplicate link. The Profile form
opens with all attributes prepopulated and a number appended to the profile's name. You can rename the
new profile, and edit any of its attributes.

l If a configuration profile is not currently being used, a Delete option is also available for it. This option is
not available for the default profile or for configuration profiles that are currently used for device
provisioning.

l To see if the configuration profile is currently used, click its Show Usage link. The form expands to show a
list of device provisioning sets that use the profile. For more information, see "Provisioning Settings " on
page 167.

l To create a new profile, click the Create new configuration profile link in the upper right corner. The
Configuration Profile form opens.

For information on creating, editing, or duplicating a configuration profile, see "Creating and Editing
Configuration Profiles" on page 164.

Creating and Editing Configuration Profiles
To create or edit a configuration profile:

1. Go to Onboard > Deployment and Provisioning > Configuration Profiles.

2. Click the Create new configuration profile link or click the Edit or Duplicate link for a profile in the list.
The Configuration Profile form opens.
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Field Description

Name
(Required) Short name that identifies the configuration profile clearly. Configuration
profile names can include spaces. If you are duplicating a profile, the original name has a
number appended to it. You may highlight this name and replace it with a new name.

Table 26: Create/Edit Configuration Profile Fields
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Field Description

Description (Optional) Brief description of the characteristics of the profile.

AirPlay
(Optional) AirPlay settings in this list were created on the Onboard > Configuration >
iOS Settings > AirPlay Settings form. For more information, see "Configuring AirPlay
Settings" on page 142.

AirPrint
(Optional) AirPrint settings in this list were created on the Onboard > Configuration >
iOS Settings > AirPrint Settings form. For more information, see "Configuring AirPrint
Settings" on page 143.

Access Point Name
(APN)

(Optional) APN settings in this list were created on the Onboard > Configuration >
iOS Settings > APN Settings form. For more information, see "Configuring APN
Settings" on page 144.

App Set
(Optional) Application sets in this list were created on the Onboard > Configuration >
Windows Applications form. For more information, see "Configuring App Sets" on page
162.

Calendar
(Optional) Calendar sets in this list were created on the Onboard > Configuration >
iOS Settings > Calendar Settings form. For more information, see "Configuring
Calendar Settings" on page 144.

Contacts
(Optional) Calendar sets in this list were created on the Onboard > Configuration >
iOS Settings > Contacts Settings form. For more information, see "Configuring Contacts
Settings" on page 146.

Email
(Optional) Email settings in this list were created on the Onboard > Configuration >
iOS Settings > Email Settings form. For more information, see "Configuring Email
Settings" on page 147.

Exchange ActiveSync
(Optional) ActiveSync configurations in this list were created on the Onboard
> Configuration > iOS Settings > Exchange ActiveSync Settings form. For more
information, see "Configuring ActiveSync Settings " on page 140.

Networks

(Optional) Select the check box of each network to include. Networks available here were
created on the Onboard > Configuration > Network Settings form. For more
information, see "Configuring Basic Network Access Settings " on page 130 and the
related topics for the form.

Passcode Policy
(Optional) Passcode policy configurations in this list were created on the Onboard
> Configuration > iOS Settings > Passcode Policy Settings form. For more
information, see "Configuring an iOS Device Passcode Policy " on page 151.

Subsribed Calendar
(Optional) Calendar subscription settings in this list were created on the Onboard >
Configuration > iOS Settings > Calendar Subscription Settings form. For more
information, see "Configuring Calendar Subscription Settings" on page 154.

VPN Settings
(Optional) VPN configurations in this list were created on the Onboard > Configuration
> iOS Settings > VPN Settings form. For more information, see "Configuring an iOS
Device VPN Connection" on page 155.

Web Clips
(Optional) This drop-down list is only available if you have defined Web clip settings on the
Onboard > Configuration > iOS Settings > Web Clip Settings form. For more
information, see "Configuring Web Clips" on page 159.

Global HTTP Proxy
(Optional) HTTP proxy settings in this list were created on the Onboard > Configuration
> iOS Settings > Global HTTP Proxy Settings form. This option is only available for
supervised devices. For more information, see "Configuring Global HTTP Proxy Settings"
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Field Description

on page 150.

Web Content Filter

(Optional) Web content filter settings in this list were created on the Onboard >
Configuration > iOS Settings > Web Content Filter Settings form. This option is only
available for supervised devices. For more information, see "Configuring Web Content
Filter Settings" on page 160.

When you have completed your changes on this form, click Save Changes, the configuration profile is included in the
Configuration Profile drop-down list on the Provisioning Settings form and can be associated with a device provisioning
configuration set.

Provisioning Settings

The Provisioning Settings page lists all your device provisioning configuration settings, and lets you define
multiple device provisioning configurations for Onboard captive portal pages. You can assign different network
settings to each of them. You can also choose from a variety of configuration profiles you have already defined
for application sets, ActiveSync settings, passcode policies, and VPN settings.

To view the list of device provisioning configuration sets and work with them, go to Onboard > Deployment
and Provisioning > Provisioning Settings. The Provisioning Settings list view opens. All device provisioning
configuration settings that have been created are included in the list. Information shown for each setting
includes its name, certificate authority (CA), and the configuration profile assigned to it.

You can click a provisioning setting's row in the list for additional options:

l To view details for a provisioning setting, click its Show Details link. The form expands to show a summary
of the settings defined for it, including information for identity, authorization, supported devices, Web login
page, device provisioning, profile signing, and reconnect behavior.

l To edit any of a provisioning setting's attributes, click its Edit link. The Device Provisioning Settings form
opens.

l To create a copy of a provisioning setting to use as a basis for a new configuration, click its Duplicate link.
The Device Provisioning Settings form opens with all attributes prepopulated and "Copy" appended to its
name. You can rename the new configuration, and edit any of its attributes.

l To delete a provisioning set, you can click its Delete link.

l To view and test a device provisioning Web login page, click its Test link. The page opens in a new tab as it
would appear to a user:
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l To create a new provisioning set, click the Create new provisioning settings link in the upper right
corner. The Device Provisioning Settings form opens.

For information on creating, editing, or duplicating a configuration profile, see "About Configuring Provisioning
Settings " on page 168.

About Configuring Provisioning Settings
On the Onboard > Deployment and Provisioning > Provisioning Settings list view, to modify a
provisioning set for Onboard captive portal pages, click its Edit link. To create a new provisioning set, click
the Create new provisioning settings link in the upper-right corner. The Device Provisioning Settings
form opens with the General tab displayed.

The configuration process is the same for editing an existing provisioning set and for creating a new set. The
Device Provisioning Settings form is divided into several tabs:

Tab Description

General
Specifies basic provisioning settings such as information about identity settings,
authorization, and supported devices. See "Configuring Basic Provisioning Settings" on
page 169.

Web Login
Specifies options for the Web login captive portal page such as the page name, labels and
messages, skin, header and footer HTML, and access control. See "Configuring
Provisioning Settings for the Web Login Page" on page 173.

iOS and OS X
Specifies options for Apple iOS and OS X device provisioning such as display text, profile
security, certificate source, and reconnect behavior. See "Configuring Provisioning
Settings for iOS and OS X" on page 174.

Legacy OS X
Specifies text displayed during legacy OS X device provisioning. See "Configuring
Provisioning Settings for Legacy OS X Devices" on page 177.

Windows
Specifies options for Windows device provisioning such as the code-signing certificate and
text displayed during provisioning. See "Configuring Provisioning Settings for Windows
Devices" on page 178.

Android
Specifies options for Android devices such the rootkit detection and text displayed during
provisioning. See "Configuring Provisioning Settings for Android Devices" on page 179.

Ubuntu
Specifies options for Ubuntu device provisioning such as instructions shown to the user
during provisioning. See "Configuring Provisioning Settings for Ubuntu" on page 181.
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Tab Description

Chromebook

Specifies options for Chromebook device provisioning such as instructions shown to the
user during provisioning. See "Configuring Provisioning Settings for Chromebook" on page
182.
For more information about using Chromebook, see the appendix "Chromebook in
Onboard" on page 525

Onboard Client
Specifies options for Windows, Android, and legacy OS X (10.5/6) device provisioning such
as provisioning address and access, certificate validation, logo, and support information.
See "Configuring Options for Onboard Client Devices" on page 183.

Configuring Basic Provisioning Settings
To configure basic provisioning settings, go to Onboard > Deployment and Provisioning > Provisioning
Settings. The Provisioning Settings list opens. Either click the Edit link for a configuration set in the list, or click
the Create new provisioning settings link in the upper-right corner to open the Device Provisioning
Settings configuration form. This form has several tabs. The first tab that opens is the General tab, and is used
to specify basic information about Onboard provisioning.

Field Description

Name
Used internally to identify this set of Onboard settings for the network administrator. These values
are never displayed to the user during device provisioning.Description

Organization The name of your organization. This is displayed to the user during the device provisioning
process.

Table 27: Device Provisioning Settings, General Tab, Top Area
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Field Description

Certificate Authority

(Required) You may select a different certificate authority (CA) if one has been
created. This drop-down list originally contains a single certificate authority by
default. If additional certificate authorities are created, they are included in this
drop-down list (see "Creating a New Certificate Authority" on page 97).

Signer

(Required) Select the source to use for signing TLS client certificates. Options
include Onboard Certificate Authority and Active Directory Certificate
Services (ADCS). If Active Directory Certificate Services is chosen, the ADCS URL
and ADCS Template rows are added to the form. ACDS can only be used with
certificate-based authentication; it cannot be used with username/password
authentication.

ADCS URL
(Required) If Active Directory Certificate Services was chosen in the Signer field,
enter the URL of the ADCS server in the field. This URL should be the Web interface
for ADCS, and is typically http://<server>/certsrv/.

ADCS Template
(Required) If Active Directory Certificate Services was chosen in the Signer field,
enter the name of the template to use when requesting the certificate. If the name
is not known, you can use the default name of "user".

Key Type

(Required) Specifies the type of private key that should be created when issuing a
new certificate. You can select one of these options:
l 1024-bit RSA – created by server: Lower security.
l 1024-bit RSA – created by device: Lower security. Uses SCEP to provision the

EAP-TLS certificate.
l 2048-bit RSA – created by server: Recommended for general use.
l 2048-bit RSA – created by device: Recommended for general use. Uses SCEP

to provision the EAP-TLS certificate.
l 4096-bit RSA – created by server: Higher security.
l X9.62/SECG curve over a 256 bit prime field - created by server
l NIST/SECG curve over a 384 bit prime field - created by server
See Note below this table.

Unique Device Credentials Includes the username as a prefix in the device's PEAP credentials.

Table 28: Device Provisioning Settings, General Tab, Identity Area

Using a private key containing more bits will increase security, but will also increase the processing time required to
create the certificate and authenticate the device. The additional processing required will also affect the battery life
of a mobile device. It is recommended to use the smallest private key size that is feasible for your organization. The
“created by device” options use SCEP to provision the EAP-TLS device certificate, so the private key is known only to
the device rather than also known by the user. When a “created by device” option is selected, the generated key is
used instead of a username/password authentication defined in Network Settings.

Field Description

Authorization Method Authorization method for devices. Options include App Auth and RADIUS.

Configuration Profile

Configuration profile to provision to devices. All configuration profiles that have
been created are included in this list. A configuration profile specifies an
application set, Exchange ActiveSync settings, network settings, passcode policy,
VPN, and other settings. For more information, see "Onboard Configuration" on
page 129.

Maximum Devices Enter a number to limit the maximum number of devices that each user may

Table 29: Device Provisioning Settings, General Tab, Authorization Area
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Field Description

provision. To be enrolled, a device must have a currently valid certificate, and its
status set to Allowed (at Onboard > Management and Control > View by
Device).

Unique Device Credentials Adds the username as a prefix to the device's PEAP credentials.

Field Description

iOS & OS X Devices
OS X 10.5.6 Devices
Windows Devices
Android Devices
Chromebook Devices
Ubuntu Devices

(Required) To enable device types for provisioning, mark their check boxes. When
you unmark a check box for a device type that will not be provisioned, the
corresponding tab is removed from this tabbed form.

Unsupported Device HTML code for the message displayed to the user if their device is not supported.

Table 30: Device Provisioning Settings, General Tab, Supported Devices Area

ClearPass Guest 6.4 | User Guide Onboard | 171
Anexo 11 ITEM 01 (0592523)         SEI 0008478-63.2018.6.02.8000 / pg. 3198



172 | Onboard ClearPass Guest 6.4 | User Guide

Field Description

Certificate Expiry
Specifies that users will receive an email notification when their device's network
credentials are about to expire. The form expands to include options for configuring the
notification email.

Send Email
Notification When to send the email. Options include one, two, three, or four weeks before expiration.

If Email is Unknown

Action to take if the user's email address is not recorded with the certificate. Options
include:
l Do not send any message
l Send a message to a fixed email address
l Send a message to username@domain

Unknown Address
Address to use when no email address is known for the user.This field is added to the
form if the "Send a message to a fixed email address" option is selected for unknown
email addresses.

Unknown Domain
Domain to append to the username to form an email address.This field is added to the
form if the "Send a message to username@domain" option is selected for unknown email
addresses.

Subject Line Subject line for the notification email.

Email Message

Plain text or HTML print template to use when generating the email message. Options
include:
l Account List
l Certificate Expiry
l Download Receipt
l GuestManager Receipt
l One account per page
l SMS Receipt
l Sponsorship Confirmation
l Two-column scratch cards

Email Skin

Format to use for email receipts. Options include:
l Use the default skin
l No skin – Plain text only
l No skin – HTML only
l No skin – Native receipt format
l Aruba ClearPass Skin
l Blank Skin
l ClearPass Guest Skin
l Custom Skin 1
l Custom Skin 2

Send Copies

How to send copies to the recipients in the Copies To list. Options include:
l Do not send copies
l Always send using "cc:"
l Always send using "Bcc:"

Table 31: Device Provisioning Settings, General Tab, Actions Area

Click Next to proceed to the next tab, or Save Changes to complete your edits.

Anexo 11 ITEM 01 (0592523)         SEI 0008478-63.2018.6.02.8000 / pg. 3199



Configuring Provisioning Settings for the Web Login Page
Onboard creates a default Web login page that is used to start the device provisioning process. To specify
options for the Web login landing page:

1. Go to Onboard > Deployment and Provisioning, expand the provioning setting's row in the list, and
click its Edit link. In the Device Provisioning Settings form, click the Web Login tab.

2. In the Page Name field, enter the page name for the Web login page.

3. In the Page Redirect area, use the Security Hash drop-down list to select the level of checking to apply to
URL parameters passed to the Web login page. Options include:

l Do not check - login will always be permitted

l Permit login on validation error - validation errors will be logged

l Deny login on validation error - login will not be permitted

4. In the URL Hash Key and Confirm Key fields, enter the shared secret that will be used to hash the redirect
URL.

In the Login Form area:

1. In the Authentication drop-down list, select the authentication requirement. Options include:

l Single Sign-On – Enable SSO for device provisioning (SSO support is enabled at CPPM >
Configuration > Identity > Single Sign-On)

l Access Code – Only require username for authentication

l Anonymous – Do not require a username or password

2. To enable bypassing the Apple Captive Network Assistant (CNA), select the Prevent CNA check box. The
CNA is the pop-up browser shown when joining a network that has a captive portal. This option might not
work with all vendors; it is dependent on how the captive portal is implemented.

3. Mark the Custom Form check box to use your own HTML login form in the header and footer areas.

4. To modify the login form's labels and error messages, mark the Custom Labels check box. The form
expands to include the Username Label, Password Label, and Log In Label fields. Complete these fields
with your customized label text.

5. To force the user to accept a "Terms and Conditions" statement, mark the check box in the Terms row. The
form expands to include the Terms Label, Terms Text, Terms Layout, and Terms Error fields.
Complete these fields with your customized values.
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6. In the Custom Fields text box, you can enter values for custom fields that you have created in Guest
Manager to be displayed on the Web login page.

In the Login Page area:

1. Use the Skin drop-down list to specify the skin to use for the login page.

2. Enter the title that will be displayed on the page in the Title field.

3. The device-specific tabs of the Provisioning Settings form may be used to customize the header and footer
HTML instructions for each device type. Default text for the header and footer is shown in the Header
HTML and Footer HTML fields and may be edited. You can also use the drop-down lists in these fields to
add images or other content items or to insert a self-registration link.

In the Network Login Access area:

1. In the Allowed Access field, enter the IP addresses and networks from which logins will be allowed.

2. In the Denied Access field, enter the IP addresses and networks from which logins will be denied.

3. Use the drop-down list in the Deny Behavior field to select the response shown to the user if their login
request is denied. Options in this list include Send HTTP 404 Not Found status, Show Access Denied
page, and Show a blank page.

4. When your entries are complete in this tab, click Save Changes. You can click Next to continue to the next
tab, or Previous to return to the previous tab.

Configuring Provisioning Settings for iOS and OS X
To specify provisioning settings related to iOS and OS X devices:

1. Go to Onboard > Deployment and Provisioning, expand the provioning setting's row in the list, and
click its Edit link. On the Device Provisioning Settings form, click the iOS & OS X tab.
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2. Use the Display Name and Profile Description text fields to control the user interface displayed during
device provisioning.

3. In the Profile Security row, select one of the following options from the drop-down list to control how a
device provisioning profile may be removed:

l Always allow removal – The user may remove the device provisioning profile at any time, which will
also remove the associated device configuration and unique device credentials.

l Remove only with authorization – The user may remove the device provisioning profile if they also
provide a password. The administrator must specify the password in the “Removal Password” and
“Confirm Removal Password” fields. The minimum password length is six characters.

l Never allow removal – The user cannot remove the device provisioning profile. This option should be
used with caution, as the only way to remove the profile is to reset the device to factory defaults, and
destroy all data on the device.

4. Use the drop-down list in the Profile Type row to select the type of profile to create, either User or
System, when provisioning OS X 10.7+ (Lion or later) devices.

5. In the Edit ID row, Mark the Change the profile ID check box to change the unique value associated with
the configuration profile. This value is used to identify the configuration settings as being from a particular
source, and should be globally unique.
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When an iOS device receives a new configuration profile that has the same profile ID as an existing profile,
the existing profile will be replaced with the new profile.

Changing the profile ID will affect any device that has already been provisioned with the existing profile ID. The
default value is automatically generated and is globally unique. You should only change this value during initial
configuration of device provisioning.

6. In the Profile Signing area, use the drop-down list in the Certificate Source row to specify how to obtain
the certificate used to sign the profiles. The options available in the list are:

l Generate using the Onboard CA -- This method establishes a trust chain when the CA certificate is
already installed.

l Use an uploaded certificate -- This method can be used for public access situations, and allows a
.mobileconfig profile to be signed using a public SSL certificate (for example, one issued by VeriSign).

7. In the Common Name field, enter the display name of the certificate used to sign the configuration profile.
This certificate will be automatically created by the certificate authority, and appears as the “Signed” field on
the device when the user authorizes the device provisioning.

Configuring Instructions for iOS and OS X

To edit the instruction text shown during provisioning for iOS and OS X devices:

1. In the Before Provisioning text box, enter the instructions that are shown to the user before they
provision their device. The text can be entered as HTML code, and you can use Smarty template functions.
If this field is left empty, the default text will be displayed.

2. In the After Provisioning text box, enter the instructions that are shown to the user after they have
provisioned their device. The text can be entered as HTML code, and you can use Smarty template
functions. If this field is left empty, the default text will be displayed.

3. In the iOS-4 Same SSID text box, enter the instructions that are shown to the user of an iOS 4 device if they
attempt to provision their device while connected to an SSID that will be provisioned. “Same SSID”
provisioning is not supported. The text can be entered as HTML code, and you can use Smarty template
functions. If this field is left empty, the default text will be displayed.

Configuring Reconnect Behavior for iOS and OS X

Reconnect is only supported by iOS 5+ and OS X 10.7+ (Lion or later) devices.

To configure the reconnect behavior iOS and OS X devices:

1. In the Allow Automatic Reconnect row, mark the check box if you want to allow the device to be
automatically reconnected to the provisioned network. Automatic reconnect only applies when there is a
single network configured to “Automatically join network.”

2. In the Allow Manual Reconnect row, mark the check box if you want to allow the device to be manually
reconnected to the provisioned network. Manual reconnect only applies when automatic reconnect is not
allowed or not applicable.

3. In the Manual Reconnect Interface row, enter the text that will be shown to the user if manual
reconnect is allowed and applicable. Enter the text as HTML code. You can use Smarty template functions. If
this field is left empty, the default text will be displayed.
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4. In the Connect Success row, enter the text that will be shown to the user after successful reconnect. Enter
the text as HTML code. You can use Smarty template functions. If this field is left empty, the default text will
be displayed.

5. In the Connect Failure row, enter the text that will be shown to the user after a failed reconnect or if the
device does not support reconnection (for example, for iOS 4 and earlier devices). Enter the text as HTML
code. You can use Smarty template functions. If this field is left empty, the default text will be displayed.

6. In the After Connect row, enter the text that will be shown after a reconnect attempt, regardless of
success or failure. Enter the text as HTML code. You can use Smarty template functions. If this field is left
empty, the default text will be displayed.

To configure delay and timeout settings:

1. Mark the check box in the Advanced Settings row. The form expands to include these options.

2. In the Disconnect Delay row, enter the duration in seconds for the Web server to wait after receiving a
disconnect request before it sends the request to the controller. This delay gives the client time to receive a
valid HTTP response before begin disconnected from the network.

3. In the Reconnect Delay row, enter the duration in seconds for the client to wait after sending a disconnect
request to the Web server before it sends a reconnect request. This duration must give the Web server and
the controller adequate time to negotiate a disconnect for the device first.

4. In the Reconnect Timeout row, enter the duration in seconds for the client to wait for a valid response
after sending a reconnect request to the Web server. This duration must allow enough time for the client to
be reconnected to the network (using the newly-installed settings) and for the Web server to then
acknowledge the HTTP request.

5. When your entries are complete in this tab, click Save Changes. You can click Next to continue to the next
tab, or Previous to return to the previous tab.

Configuring Provisioning Settings for Legacy OS X Devices
To specify provisioning settings related to legacy OS X 10.5 and 10.6 (Leopard and Snow Leopard) devices:

1. Go to Onboard > Deployment and Provisioning, expand the provioning setting's row in the list, and
click its Edit link. On the Device Provisioning Settings form, click the Legacy OS X tab.

2. In the Before Provisioning text box, enter the instructions that are shown to the user before they
provision their device. The text can be entered as HTML code, and you can use Smarty template functions.
If this field is left empty, the default text will be displayed.
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3. In the After Provisioning text box, enter the instructions that are shown to the user after they have
provisioned their device. The text can be entered as HTML code, and you can use Smarty template
functions. If this field is left empty, the default text will be displayed.

4. In the Before Web Login area, enter the instructions that are shown to the user before they log in to
provision an OS X 10.5 or 10.6 device. The text can be entered as HTML code, and you can use Smarty
template functions. If this field is left empty, the default text will be displayed.

5. You may use the Insert content item drop-down list to add an image file or other content item.

6. When your entries are complete in this tab, click Save Changes. You can click Next to continue to the next
tab, or Previous to return to the previous tab.

Configuring Provisioning Settings for Windows Devices
To specify provisioning settings related to Windows devices:

1. Go to Onboard > Deployment and Provisioning, expand the provioning setting's row in the list, and
click its Edit link. On the Device Provisioning Settings form, click the Windows tab.

2. In the Code-Signing Certificate drop-down list, select a certificate for signing the provisioning application,
or leave the default setting of None-Do not sign the application.

3. In the Before Web Login area, enter the instructions that are shown to the user before they log in to
provision a Windows device. The text can be entered as HTML code, and you can use Smarty template
functions. If this field is left empty, the default text will be displayed.
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4. In the Before Provisioning text box, enter the instructions that are shown to the user before they
provision their device. The text can be entered as HTML code, and you can use Smarty template functions.
If this field is left empty, the default text will be displayed.

5. In the After Provisioning text box, enter the instructions that are shown to the user after they have
provisioned their device. The text can be entered as HTML code, and you can use Smarty template
functions. If this field is left empty, the default text will be displayed.

6. You may use the Insert content item drop-down list to add an image file or other content item.

7. When your entries are complete in this tab, click Save Changes. You can click Next to continue to the next
tab, or Previous to return to the previous tab.

Configuring Provisioning Settings for Android Devices
To specify provisioning settings related to Android devices:

1. Go to Onboard > Deployment and Provisioning, expand the provioning setting's row in the list, and
click its Edit link. On the Device Provisioning Settings form, click the Android tab.
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2. In the Android Rootkit Detection drop-down list, choose one of the following options:

l Provision all devices— All Android devices will be provisioned.

l Do not provision rooted devices—Onboard will detect a jailbroken Android device and will not
provision the device if it has been compromised.

3. In the Before Web Login area, enter the instructions that are shown to the user before they log in to
provision an Android device. The text can be entered as HTML code, and you can use Smarty template
functions. If this field is left empty, the default text will be displayed.

4. In the Before Provisioning text box, enter the instructions that are shown to the user before they
provision their device. The text can be entered as HTML code, and you can use Smarty template functions.
If this field is left empty, the default text will be displayed.

5. In the Next Step text box, enter the instructions that are shown to the user after they download the
application to their device. The text can be entered as HTML code, and you can use Smarty template
functions. If this field is left empty, the default text will be displayed.

Anexo 11 ITEM 01 (0592523)         SEI 0008478-63.2018.6.02.8000 / pg. 3207



6. In the Before Profile Install text box, enter the instructions that are shown to the user before they install
the network profile on their device. The text can be entered as HTML code, and you can use Smarty
template functions. If this field is left empty, the default text will be displayed.

7. In the After Provisioning text box, enter the instructions that are shown to the user after they have
provisioned their device. The text can be entered as HTML code, and you can use Smarty template
functions. If this field is left empty, the default text will be displayed.

8. You may use the Insert content item drop-down list to add an image file or other content item.

9. When your entries are complete in this tab, click Save Changes. You can click Next to continue to the next
tab, or Previous to return to the previous tab.

Configuring Provisioning Settings for Ubuntu
To specify provisioning settings related to Ubuntu devices:

1. Go to Onboard > Deployment and Provisioning, expand the provioning setting's row in the list, and
click its Edit link. On the Device Provisioning Settings form, click the Ubuntu tab.

2. In the Before Web Login text box, enter the instructions that are shown to the user before they log in to
provision an Ubuntu device. The text can be entered as HTML code, and you can use Smarty template
functions. If this field is left empty, the default text will be displayed.

3. In the Before Provisioning text box, enter the instructions that are shown to the user before they
provision their Ubuntu device. The text can be entered as HTML code, and you can use Smarty template
functions. If this field is left empty, the default text will be displayed.

4. In the After Provisioning text box, enter the instructions that are shown to the user after they have
provisioned their Ubuntu device. The text can be entered as HTML code, and you can use Smarty template
functions. If this field is left empty, the default text will be displayed.

5. You may use the Insert content item drop-down list to add an image file or other content item.

6. When your entries are complete in this tab, click Save Changes. You can click Next to continue to the next
tab, or Previous to return to the previous tab.
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Configuring Provisioning Settings for Chromebook
To specify provisioning settings related to Chromebook devices:

1. Go to Onboard > Deployment and Provisioning, expand the provioning setting's row in the list, and
click its Edit link. On the Device Provisioning Settings form, click the Chromebook tab.

2. In the Extension field, read and follow the instructions for configuring the Chromebook extension in the
Google admin console and adding the custom app. This field provides ID and server information that is
specific to your installation.

3. In the Before Web Login text box, enter the instructions that are shown to the user before they log in to
provision a Chromebook device. The text can be entered as HTML code, and you can use Smarty template
functions. If this field is empty, the default text will be displayed.

4. In the Before Provisioning text box, enter the instructions that are shown to the user before they
provision their Chromebook device. The text can be entered as HTML code, and you can use Smarty
template functions. If this field is empty, the default text will be displayed.

5. In the After Provisioning text box, enter the instructions that are shown to the user after they have
provisioned their Ubuntu device. The text can be entered as HTML code, and you can use Smarty template
functions. If this field is empty, the default text will be displayed.

6. In the No Extension text box, enter the instructions that are shown to the user if the Onboard
Chromebook extension is not installed. The text can be entered as HTML code, and you can use Smarty
template functions. If this field is empty, the default text will be displayed.
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7. You may use the Insert content item drop-down list to add an image file or other content item.

8. When your entries are complete in this tab, click Save Changes. You can click Next to continue to the next
tab, or Previous to return to the previous tab.

Configuring Options for Onboard Client Devices
The Onboard Client tab is used to edit basic configuration options for Windows, Android, and legacy OS X (10.5
and 10.6) devices. This form is not used for iOS or OS X 10.7+ devices.

To specify provisioning settings related to these Onboard-capable devices:

1. Go to Onboard > Deployment and Provisioning, expand the provioning setting's row in the list, and
click its Edit link. On the Device Provisioning Settings form, click the Onboard Client tab.

2. In the Provisioning Address drop-down list, choose the hostname or IP address to use for device
provisioning:

l The system’s hostname (requires DNS resolution) – Select this option to use the system hostname
for device provisioning.

This option requires that the device be able to resolve the listed hostname at the time the device is provisioned.

l The system’s IP address (network adapter name) – Select this option to use the IP address of the
system for device provisioning. The drop-down list includes one option for each of the IP addresses
detected on the system.

Use this option when DNS resolution of the system’s hostname is not available for devices that are in a
provisioning role.
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l Other IP address or hostname… – Select this option to override the hostname or IP address to be
specified during device provisioning. The administrator must enter the hostname or IP address in the
“Address” text field.

Use this option when special DNS or NAT conditions apply to devices that are in a provisioning role.

3. If you chose Other IP address or hostname in the Provisioning Address drop-down list, use the Address
field to enter a hostname or IP address.

4. The Provisioning Access warning message is displayed when HTTPS is not required for guest access.
HTTPS is recommended for all deployments as it secures the unique device credentials that will be issued to
the device.

When using HTTPS for device provisioning, you must obtain a commercial SSL certificate. Self-signed SSL certificates,
and SSL server certificates that have been issued by an untrusted or unknown root certificate authority, will cause
iOS device provisioning to fail with the message “The server certificate for … is invalid”.

5. The Validate Certificate drop-down list is used to specify whether the SSL server’s certificate should be
validated as trusted. When this option is set to Yes, validate this web server’s certificate
(recommended), a certificate validation failure on the client device will cause device provisioning to fail.
This is the default option.

You should change this option to No, do not validate this web server’s certificate only during testing,
or if you are waiting for a commercial SSL certificate.

6. To display your enterprise’s logo, select an image from the list in the Logo Image field. Go to
Administration > Content Manager to upload new images to use as the logo.

The native size of the logo used in the QuickConnect client is 188 pixels wide, 53 pixels high. You may use an
image of a different size and it will be scaled to fit, but for the best quality results it is recommended that
you provide an image that is already the correct size.

7. The Wizard Title text field may be used to specify the text displayed to users when they launch the
QuickConnect app to provision their device.

8. If provided, the Password Recovery URL and Helpdesk URL fields may be used to provide additional
resources to users who encounter trouble in provisioning their devices.

Ensure that users in the provisioning role can access these URLs.

9. When your entries are complete in this tab, click Save Changes. You can click Previous to return to the
previous tab.

About the Self-Service Portal
The Self-Service Portal allows users to manage their onboarded BYOD devices without requiring IT
intervention.
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Figure 20 Self-Service Portal

The Self-Service Portal list displays Onboard devices. Select the type from the Device Type drop-down list in
the filter area. Information shown for each device includes the device's name, owner's name, device type, the
device's network access status, and the device ID (MAC address).

tLog in as the local user in the Self-Service portal to view the list of devices. For more information on configuring the
local user credentials, see the section, Adding and Modifying Local Users in the latest ClearPass Policy Manager User
Guide.

Users can perform the following operations:

l View, enable, disable, or delete a device.

l Revoke a device's client certificate.

l Report a device as lost or stolen.

For more information on various device actions, see "Device Management (View by Device) " on page 108.
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Chapter 5
Configuration

ClearPass Guest’s built-in Configuration editor lets you customize many aspects of the appearance, settings,
and behavior of the application. Areas you can customize include:

l Advertising services (see "Advertising Services" on page 313)

l Authentication settings

l Content asset management

l Guest Manager configuration

l Hotspot Manager (see "Hotspot Manager" on page 341)

l Pages, including:

n Fields, forms, and views in ClearPass Guest

n Guest self-registration processes and forms

n Web login pages

l Receipts, including:

n Digital passes

n Settings for emailing visitor account receipts

n SMS visitor account receipt settings

l SMS services

l Translation packs

l Visitor account provisioning services for IP phones

Accessing Configuration
To access ClearPass Guest’s application customization features, click the Configuration link in the left
navigation.
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Configuring ClearPass Guest Authentication
You can use the Configuration module to modify authentication settings for the ClearPass Guest application.

To configure ClearPass Guest’s authentication settings:

1. Go to Configuration > Authentication. The Authentication Settings form opens.

2. To send automatic disconnect or re-authorization messages when enabled or role values change, mark the
check box in the Dynamic Authorization row. This requires a network access server (NAS) type that
supports RFC-3576.

3. In the NAS Type row, use the drop-down list to choose the default type for network access servers.

4. To force a specific bind address for RFC-3576 requests, enter a value in the RFC-3576 Bind Address row.
This might be needed in an AirGroup environment.
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5. In the Internal Auth Type row, choose a type from the drop-down list. Choices in list include PAP, CHAP,
and MS-CHAP. The internal authentication type controls the RADIUS authentication used for internal
RADIUS requests.

6. To redirect HTTP access to use HTTPS instead, mark the check box in the Security row.

Content Manager

The Content Manager allows you to upload content items to ClearPass Guest. Content items are assets such as
text, images, and animations. To work with your content items, go to Configuration > Content Manager >
Start Here.

Content assets are organized into private files and public files. Private files are only available within the
ClearPass application. Public files are accessible via HTTP/HTTPS for guest access using the application’s built-in
Web server.

This section includes:

l "Managing Content: Private Files and Public Files" on page 189

l "Uploading Content " on page 190

l "Downloading Content" on page 191

l "Creating a New Content Directory" on page 191

Managing Content: Private Files and Public Files
Content items are assets such as text, images, and animations. After you upload them to ClearPass, you can
use them in registrations, receipts, digital passes, and so on.

To use a content item, you can insert a reference to it into any custom HTML editor within the application. To
do this, select the content item you want to insert from the drop-down list located in the lower right corner of
the HTML editor. The item will be inserted using HTML that is most suited to the type of content inserted. To
manually reference a content item, you can use the URL of the item directly. For example, an item named
logo.jpg could be accessed using a URL such as: http://192.0.2.23/public/logo.jpg.

Content items are organized into two categories, private files and public files, and stored and accessed
separately:

l Private Files—Content items in the Private Files list are only available within the ClearPass application.
These files are not accessible to guests. To work with your private content items, go to Configuration >
Content Manager > Private Files. The Private Files list view opens.

l Public Files—Public files are accessible via HTTP/HTTPS for guest access using the application’s built-in Web
server. To work with your public content items, go to Configuration > Content Manager > Public Files.
The Public Files list view opens.

The list views and procedures are the same for both private and public files. Columns in the list show the
filename, owner, file type, last modification date, and file size.
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Field Description

Upload New
Content Add a new content item from your system. See "Uploading Content " on page 190.

Download New
Content Add a new content item from another Web server. See "Downloading Content" on page 191.

Create New
Directory

Add a new subdirectory under the currently displayed directory. See "Creating a New Content
Directory" on page 191.

Properties Displays the content file's properties. Information includes the file's owner, filename,
description, type, image size, date modified, and file size.

Delete Deletes the content file from the directory. You will be asked to confirm the deletion.

Rename Modify the file's name or move it to another directory.

Download Download a copy of the file to your local Downloads folder.

View Content Opens a preview of the content item in a new browser tab.

Quick View Displays a preview of the content item within the file's row in the list.

Table 32: Content Files List View, Private Files or Public Files

Uploading Content
1. To add a new content item using your Web browser, go to Configuration > Content Manager, and then

go to either Private Files or Public Files, as appropriate. The list view opens. The procedures are the same
for both private and public files.

2. Click the Upload New Content tab . The Add Content form opens.

3. In the File row, click Browse to navigate to the file you wish to upload. The Maximum file size is 15 MB.

You can upload single content files, multiple content asset files and folders, or a Web deployment archive.
To upload multiple assets, first compress the files as a “tarball” or zip file, then browse to it in the File field.

Anexo 11 ITEM 01 (0592523)         SEI 0008478-63.2018.6.02.8000 / pg. 3217



Allowed file formats are .tgz, .tar.gz, .tb2, .tar.bz2, or .zip. When you have uploaded the file, the Extract
option lets you create the new directory, navigate into it, and view and extract the files. Directory structure
is preserved when extracting.

4. (Optional) You may enter a description of the content assets in the Description text area.

5. To overwrite a previous file of the same name, mark the Overwrite check box.

6. Click Upload Content to upload the file.

If you clicked the Upload New Content link on the Private Files list view, the file is added to the private
directory in ClearPass. If you clicked the link on the Public Files list view, it is added to the public directory on
the Web server. You can reference the file when creating custom HTML templates.

Downloading Content
1. To add a new content item from the internet or another Web server, go to Configuration > Content

Manager, and then go to either Private Files or Public Files, as appropriate. The list view opens. The
procedures are the same for both private and public files.

2. Click the Download New Content tab. The Fetch Content form opens.

3. In the Content URL row, enter the URL of the content item to download.

4. (Optional) You may enter a description of the content assets in the Description text area.

5. To overwrite a previous file of the same name, mark the Overwrite check box.

6. Click Fetch Content to download the file.

If you clicked the Upload New Content link on the Private Files list view, the file is added to the private
directory in ClearPass. If you clicked the link on the Public Files list view, it is added to the public directory on
the Web server. You can reference the file when creating custom HTML templates.

Creating a New Content Directory
1. To add a new content subdirectory under either the private or public directory, go to Configuration >

Content Manager, and then go to either Private Files or Public Files, as appropriate. The list view
opens. The procedures are the same for both private and public files.

2. Click the Create New Directory tab. The Create New Directory form opens.
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3. In the New Filename row, enter the name for the new subdirectory.

4. (Optional) You may enter a description of the directory in the Description text area.

5. Click Create Directory.

If you clicked the Create New Directory link on the Private Files list view, the subdirectory is added under the
private directory in ClearPass. If you clicked the link on the Public Files list view, it is added under the public
directory on the Web server. You can reference files in this subdirectory when creating custom HTML
templates.

Configuring Guest Manager

The Guest Manager module allows the entire guest account provisioning process to be customized. This is
useful in many different situations, such as:

l Self-registration – Allow your guests to self-register and create their own temporary visitor accounts.

l Visitor surveys – Define custom fields to store data of interest to you, and collect this information from
guests using customized forms.

l Branded print receipts – Add your own branding images and text to print receipts.

l SMS and email receipts – Include a short text message with your guest’s username and password, or
send HTML emails containing images.

l Advanced customization – ClearPass Guest is flexible and can be used to provide location sensitive
content and advertising.

Default Settings for Account Creation
The Guest Manager plugin configuration form lets you control the default settings for account creation.

To modify settings for the Guest Manager plugin configuration, go to Configuration > Guest Manager. The
Configure Guest Manager form opens.

You can also access this form from the Administration > Plugin Manager > Guest Manager >
Configuration link.

Figure 21 Configure Guest Manager, Username Options

Field Description

Username
Type

The default method used to generate random account usernames (when creating groups of
accounts). This may be overridden by using the random_username_method field.

Username
Length

This field is displayed if the Username Type is set to “Random digits”, “Random letters”, “Random
letters and digits” or “Sequential numbering”. The default length of random account usernames (when
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Field Description

creating groups of accounts). This may be overridden by using the random_username_length field.

Username
Example

(Optional) Shows a sample username generated according to the rules specified by the selections in
the Username Type and Username Length fields. You can click the Generate link to view different
examples.

Username
Format

This field is displayed if the Username Type is set to “Format picture”. It sets the format of the
username to be created. See "Format Picture String Symbols" on page 513 for a list of the special
characters that may be used in the format string. This may be overridden by using the random_
username_picture field.

Initial
Sequence

(Optional) This field contains the next available sequence number for each username prefix that has
been used. Automatic sequence numbering is used when the value of the multi_initial_sequence
field is set to -1. The username prefix is taken from the multi_prefix field when usernames are
automatically generated using the “nwa_sequence” method. You can edit the values stored here to
change the next sequence numbers that will be used. This is an automatically managed field; in most
situations there is no need to edit it.

Figure 22 Customize Guest Manager, Password Options

Field Description

Random
Password
Type

The default method used to generate random account passwords (when creating groups of
accounts). This may be overridden by using the random_password_method field.

Random
Password
Length

The default length of random account passwords (when creating groups of accounts). This may be
overridden by using the random_password_length field.

Password
Format

This field is displayed if the Password Type field is set to “Format picture”. It sets the format of the
password to be created. See "Format Picture String Symbols" on page 513 for a list of the special
characters that may be used in the format string. This may be overridden by using the random_
password_picture field.

Password
Complexity

The policy to enforce when guests change their account passwords using the guest self-service user
interface. Different levels of password complexity can require guests to select passwords that
contain different combinations of uppercase letters, lowercase letters, digits and symbols (!#$%&()
*+,-./:;<=>?@[\\]^_{|}~,). The available options for this setting are:
l No password complexity requirement
l At least one uppercase and one lowercase letter
l At least one digit
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Field Description

l At least one letter and one digit
l At least one of each: uppercase letter, lowercase letter, digit
l At least one symbol
l At least one of each: uppercase letter, lowercase letter, digit, and symbol

Minimum
Password
Length

The minimum acceptable password length for guests changing their account passwords. The
original default password length is six characters.

Disallowed
Password
Characters

Special characters that should not be allowed in a guest password. Spaces are not allowed by
default. You can specify special characters, numbers, and letters to exclude from passwords—for
example, letters and numbers that can look similar, such as i, l, 1, 0, O, o, 5, S, 8, B.

Disallowed
Password
Words

(Optional) Enter a comma- separated list of words that are disallowed and will not be created by the
random words password generator.

Password
Example

(Optional) Shows a sample password generated according to the rules specified by the selections in
the Password Type and Password Length fields. You can click the Generate link to view different
examples.

Password
Logging

(Optional) By default, the passwords for created guest accounts are logged in the application log and
may be recovered from there. For increased security, you may prevent this password from being
logged by unselecting this check box.

Password
Display

(Optional) Select the View guest account passwords option to enable the display of visitor account
passwords in the user list. To reveal passwords, the password field must be added to the “guest_
users” or “guest_edit” view, and the operator profile in use must also have the View Passwords
privilege.

Figure 23 Configure Guest Manager, Expiration Options

Field Description

Expire
Action

Default action when the expiration time is reached. Available options available are:
l Disable at specified time
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Field Description

l Delete and logout at specified time
l Delete at specified time
l Disable and logout at specified time

Expiration
Options

The options that should be available to select from when choosing the expiration time of a guest
account (expire_after). These options are displayed as the values of the “Expires After” field when
creating a user account. Values are in hours for relative account expiration times.

Modify
Expiration
Options

The options that should be available to select from when modifying an account's expiration (modify_
expire_time). Some items may be dynamically removed based on the state of the account.

Lifetime
Options

The options that should be available to select from when choosing the lifetime for a guest account
(expire_postlogin). These options are displayed as the values of the “Account Lifetime” field when
creating a user account. Values are in minutes for relative account lifetimes.

Figure 24 Configure Guest Manager, Expiration Warning Options

Field Description

Account
Expiry
Warning

(Optional) If selected, users will receive an email notification 24 hours before their device's network
credentials are about to expire. Expiration warning configuration options are added to the form.

If Email is
Unknown

Use the drop-down list to specify where to send emails if the user's account does not have an email
address recorded. Options include:
l Do not send any message
l Send a message to a fixed email address
l Send a message to username@domain

Subject
Line Enter the subject line for the notification email.

Email
Message

Use the drop-down list to specify the print template to use when generating the email message.
Options include:
l Account List
l Certificate Expiry
l Download Receipt
l Guest Account Expiry
l GuestManager Receipt
l One account per page
l SMS Receipt
l SMS Sponsor Confirmation Alert
l Sponsorship Confirmation
l Two-column scratch cards

Email Skin The format for the email receipts. Options include:
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Field Description

l Use default: Use the default skin
l No skin - Plain text only
l No skin - HTML only
l No skin - Native receipt format
l Use the default skin
l Aruba ClearPass Skin
l Blank Skin
l ClearPass Guest Skin
l Custom Skin 1
l Custom Skin 2

Send
Copies

Use the drop-down list to specify when to send to recipients in the Copies To list. Options include:
l Do not send copies
l Always send using "cc:"
l Always send using "Bcc:"

Figure 25 Configure Guest Manager, Receipt Options

Field Description

Site
SSID

(Optional) The Site SSID is the public name of the wireless local area network (WLAN). The default
setting for this field is Aruba, and can be changed. The site SSID is displayed in the guest receipt as the
WiFi Network, shown below this table.

Site
WPA
Key

(Optional) The encryption key used to secure the wireless network. If a value is entered in this field, it will
appear on guest print receipts.

Receipt
Printing

(Optional) Select the “Require click to print” option to change the behavior of the receipt page. When this
option is not selected, the default behavior is to provide a drop-down list of print templates and to open
a new window when one is selected:

When “Require click to print” is selected, the receipt page provides a drop-down list of print templates
and a Print link that must be clicked to display the account receipt:
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Figure 26 Example Guest Receipt, Showing Site SSID Displayed as the WiFi Network

Figure 27 Configure Guest Manager, General Options

Field Description

Terms
of Use
URL

(Optional) URL of a terms and conditions page provided to sponsors. You may upload an HTML file
describing the terms and conditions of use by using the Content Manager (See "Managing Content:
Private Files and Public Files" on page 189). If this file is called terms.html, then the Terms of Use URL
should be public/terms.html.
l If your site is hosted externally, be sure the proper access control lists (ACLs) are in place.
l If terms are required, it is best practice to edit the terms field on you forms to a UI type "hidden" and

an initial value of 1.

Active
Sessions

(Optional) Default maximum number of active sessions that should be allowed for a guest account. This
may be overridden by using the simultaneous_use field when creating or editing a guest account.

About
Guest
Network
Access

(Optional) Allows the text displayed to operators on the Guest Manager start page to be customized, or
removed (if a single hyphen “-” is entered).
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About Fields, Forms, and Views
l A field is a named item of information. It may be used to display information to a user as static text, or it

may be an interactive field where a user can select an option or enter text.

l A form is a group of fields that is used to collect information from an operator.

l A view is a grouping of fields that is used to display information to an operator.

Business Logic for Account Creation
When guest accounts are created, there are certain rules that must be followed in order to create a valid
account. These rules apply to all accounts, regardless of how the account was created.

The business logic rules that control all guest account creation are described below. To see the display name
corresponding to a field name, go to Configuration > Pages > Fields and scroll to the field name. Display
names are shown in the Column Title column.

For information on customizing fields, see "Customizing Fields" on page 206.

Verification Properties
l creator_accept_terms: This field must be set to 1, indicating the creator has accepted the terms of use for

creating the account. If the field is not present or is not set to 1, the visitor account is not created.

l password2: If this field is specified, its value must be equal to the “password” field, or else the visitor
account is not created.

l auto_update_account: If this field is present and set to a non-zero value, account creation will not fail if
the username already exists – any changes will be merged into the existing account using an update instead.

Basic User Properties
l username: This field is the name for the visitor account and may be provided directly. If this field is not

specified, then use the email address from the email field, and if that is also not specified, then randomly
generate a username (according to the value of the random_username_method and random_
username_length fields).

l modify_password: This field controls password modification for the visitor account. It may be set to one of
these values:

n “reset” to randomly generate a new password according to the values of the random_password_
method and random_password_length fields

n “password” to use the password specified in the password field

n “random_password” to use the password specified in the random_password field

n If blank or unset, the default password behavior is used, which is to use any available value from the
random_password field and the password field, or assume that “reset” was specified otherwise.

l password: This field is the password for the visitor account and may be provided directly. If this field is not
specified, then randomly generate a password (according to the values of the random_password_method
and random_password_length fields).

l role_id: This field is the role to assign to the visitor account and may be specified directly. If this field is not
specified, then determine the role ID from the role_name field. If no valid role ID is able to be determined,
the visitor account is not created.

l simultaneous_use: This field determines the maximum number of concurrent sessions allowed for the
visitor account. If this field is not specified, the default value from the GuestManager configuration is used.
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l random_username_method – The method used to generate a random account username. If not
specified, the default value from the GuestManager configuration is used.

l random_username_length – The length in characters of random account usernames. If not specified, the
default value from the GuestManager configuration is used.

l random_password_method – The method used to generate a random account password. If not specified,
the default value from the GuestManager configuration is used.

l random_password_length – The length in characters of random account passwords. If not specified, the
default value from the GuestManager configuration is used. The default password length is six characters.

Visitor Account Activation Properties
l enabled: This field determines if the account is enabled or disabled; if not specified, the default is 1

(account is enabled).

l do_schedule, modify_schedule_time, schedule_after and schedule_time: These fields are used to
determine the time at which the visitor account will be activated.

n If modify_schedule_time is “none”, then the account is disabled and has no activation time set.

n If modify_schedule_time is “now”, then the account is enabled and has no activation time set.

n If modify_schedule_time is a value that specifies a relative time change, for example “+1h”, then the
visitor account’s activation time is modified accordingly.

n If modify_schedule_time is a value that specifies an absolute time, for example “2010-12-31 17:00”,
then the visitor account’s activation time is set to that value.

n If modify_schedule_time is “schedule_after” or “schedule_time”, then the activation time is determined
according to the schedule_after or schedule_time fields as explained below.

n If schedule_after is set and not zero, then add that time in hours to the current time and use it as the
activation time (setting do_schedule to 1); enabled will be set to zero.

n Otherwise, if schedule_after is zero, negative or unset, and schedule_time has been specified, use that
activation time (set do_schedule to 1 and enabled to 0). If the schedule_time specified is in the past,
set do_schedule to 0 and enabled to 1.

n Otherwise, if schedule_time if not specified, then the visitor account has no activation time and do_
schedule will default to zero.

Visitor Account Expiration Properties
l do_expire, modify_expire_time, expire_after and expire_time: These fields are used to determine the

time at which the visitor account will expire.

n If modify_expire_time is “none”, then the account has no expiration time set.

n If modify_expire_time is “now”, then the account is disabled and has no expiration time set.

n If modify_expire_time is a value that specifies a relative time change, for example “+1h”, then the
visitor account’s expiration time is modified accordingly.

n If modify_expire_time is a value that specifies an absolute time, for example “2010-12-31 17:00”, then
the visitor account’s expiration time is set to that value.

n If modify_expire_time is “expire_after” or “expire_time”, then the expiration time is determined
according to the expire_after or expire_time fields as explained below.

n If expire_after is set and not zero and the account will be activated immediately, then add the value in
hours to the current time to determine the expiration time.
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n If expire_after is set and not zero and account activation is set for a future time (schedule_time) instead
of the current time, then the expiration time is calculated relative to the activation time instead of the
current time.

n Otherwise, if expire_after is zero, negative or unset, and expire_time has been specified, use that
expiration time. If the expire_time specified is in the past, set do_expire to 0 and ignore the specified
expiration time.

n If the expire_timezone field is used in conjunction with expire_time and a time zone and date are
selected, the date calculation is adjusted relative to the time zone.

n Otherwise, if expire_time is not specified, then the expire_time is not set and do_expire will always be
set to zero.

n If the do_expire field is not included in the form, the default expiration action is 4, Logout and Delete.
This can be configured on the Customize Guest Manager page.

l expire_postlogin: This field determines the amount of time after the initial login for which the visitor
account will remain valid. If this field is not specified, the default value is 0 (account lifetime not set).

l expire_usage: This field determines the total amount of login time permitted for the visitor account. If this
field is not specified, the default value is 0 (account usage is unlimited).

Other Properties
l All other properties specified at creation time are stored with the visitor account (for example, email,

visitor_name, visitor_company, visitor_phone, sponsor_name as well as any custom fields that have
been defined)

Standard Fields
See "Field, Form, and View Reference" on page 502 for a listing of the standard fields shipped with ClearPass
Guest.

Standard Forms and Views
The figure below shows the standard forms and views in the application.
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The table below lists all the forms and views used for visitor management.

Name Type Visitor Management Function Editable?

change_expiration Form Change Expiration Yes

create_multi Form Create Multiple Yes

create_user Form Create Account Yes

guest_edit Form Edit Account Yes

guest_export View Export Accounts Yes

guest_multi View Edit Multiple Accounts Yes

guest_multi_form Form Edit Multiple Accounts Yes

guest_receipt Form Print Receipt No

guest_register Form Guest Self-Registration Yes

guest_register_receipt Form Guest Self-Registration Receipt Yes

guest_sessions View Active Sessions Yes

guest_users View List Accounts Yes

remove_account Form Remove Account No

reset_password Form Reset Password No

Table 33: Visitor Management Forms and Views

These forms are accessed directly:

l create_multi form – multiple account creation

l create_user form – sponsored account creation

l guest_register form – guest self-registration form

These forms are accessed through the action row of the guest_users view:

l change_expiration form – change expiration time for a single account

l guest_multi_form form – editing multiple accounts

l guest_edit form – editing single account

l reset_password form – reset password for a single account

These forms are the standard self-registration forms:

l guest_register form – self-registration form

l guest_register_receipt form – self-registration receipt

These standard views are defined in Guest Manager:

l guest_export view – view used when exporting guest account information

l guest_multi view – displays a list of guest accounts optimized for working with multiple accounts
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l guest_sessions view – displays a list of current or historical sessions (See "Active Sessions Management" on
page 33.)

l guest_users view – displays a list of guest accounts optimized for working with individual accounts

Configuring Access Code Logins
This section explains how to configure Guest Manager to create multiple accounts that have the ability to log in
with only the username. We will refer to this as an Access Code.

Customize Random Username and Passwords
In this example we will set the random usernames and passwords to be a mix of letters and digits.

1. Go to Configuration > Guest Manager. The Configure Guest Manager form opens.

2. In the Username Type field, select Random Letters and digits. The generator matching the complexity
will also include a mix of upper and lower case letters.

3. In the Username Length field, select 6 characters.

4. Configure other settings. See "Default Settings for Account Creation" on page 192 for a description. Click
Save Configuration to save your changes.

Create the Print Template
By default, the print templates include username, password, and expiration, as well as other options. For the
purpose of access codes, we only want the username presented. This access code login example bases the print
template off an existing scratch card template.

1. Go to Configuration > Receipts > Templates.

2. Select Two-column scratch cards, and then click Duplicate.

3. Select the Copy of Two-column scratch cards template, and then click Edit.

4. In the Name field, substitute Access Code for Username as shown below.

5. Remove extraneous data from the User Account HTML field. Example text is shown below.
<table {$table_class_content}>
<thead>
<tr>

<th class="nwaTop" colspan="3">Access Details</th>
</tr>
</thead>
<tbody>
<tr>
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<td class="nwaBody" rowspan="99" valign="top"><img src="images/icon-user48.png" width="4
8" height="48" border="0" alt=""></td>

<th class="nwaLeft">Access Code</th>
<td class="nwaBody" style="width:12em">{$u.username|htmlspecialchars}</td>
</tr>
{if $u.create_result.error}
<tr>
<th class="nwaLeft">Error</th>

<td class="nwaBody"><span class="nwaError">{$u.create_result.message}</span></td>
</tr>
{/if}
</tbody>
</table>

6. Click Save Changes to save your settings.

7. To preview the new template, select the template in the Guest Manager Print Templates list, then click
Preview. The template is displayed. The template created by the example text given above would look like
this:

Customize the Guest Accounts Form
Next, modify the Guest Accounts form to add a flag that to allows access-code based authentication.

1. Go to Configuration > Pages > Forms & Views.

2. In the Customize Forms & Views list, select create_multi and then click Edit Fields.

3. In the Edit Fields list, look for a field named username_auth. If the field exists but is not bolded and
enabled, select it and click Enable Field.

If the field does not exist, select any field in the list (for example, num_accounts) and select Insert After.
Click the Field Name drop-down list, select username_auth and allow the page to refresh. The defaults
should be acceptable, but feel free to customize the label or description.

4. Click Save Changes to save your settings. After the field is enabled or inserted, you should see it bolded
in the list of fields.

Create the Access Code Guest Accounts
After the account fields have been customized, you can create new accounts.

1. Go to Guest > Create Multiple.

2. In the Create Multiple Guest Accounts form, select the check box in the Username Authentication
row that was added in the procedure above (see "Customize the Guest Accounts Form " on page 203). If
you do not select this check box and if the username is entered on the login screen, the authentication will
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be denied. The example shown below will create 10 accounts that will expire in two weeks, or fours hours
after the visitors first log in, whichever comes first.

3. Click Create Accounts to display the Finished Creating Guest Accounts page. If you create a large
number of accounts, they are created at one time but might not all be displayed at the same time. (This will
not affect the printing action in the following step.)
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4. Confirm that the accounts settings are as you expected with respect to letters and digits in the username
and password, expiration, and role.

5. Click the Open print window using template drop-down list and select the new print template you
created using this procedure See "Create the Print Template" on page 202 for a description of this
procedure. A new window or tab will open with the cards.
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Pages

The Pages area of the user interface lets you customize the pages that are available to guests and sponsors. To
work with pages configuration, go to Configuration > Pages > Start Here.

This section includes:

l "Customizing Fields" on page 206

l "Customizing Forms and Views" on page 212

l "Customizing Guest Self-Registration" on page 235

l "Managing Web Logins" on page 260

Customizing Fields

Custom fields are fields that you define yourself to cater for areas of interest to your organization. You are able
to define custom fields for your guest accounts as well as edit the existing fields.

In addition you can delete and duplicate fields. For your convenience you are also able to list any forms or
views that use a particular field.

Fields that have a lock symbol cannot be deleted.

A complete list of fields is displayed on the Configuration > Pages > Fields form.

To display only the fields that have been created, click the Custom Fields Only link in the bottom row of
the list view. To return to displaying all fields, click the All Fields link.

For information on properties of some specific fields, see "Business Logic for Account Creation" on page 198.

Creating a Custom Field

To create a custom field, go to Configuration > Pages > Fields and click the Create tab at the top of the
form or the Create a new field link in the upper-right corner. The Create Field form is displayed.
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The Field Name is not permitted to have spaces but you can use underscores.

The Field Type can be one of String, Integer, Boolean or No data type. The No data type field would be
used as a label, or a submit button.

Enter a description in the Description field. You can enter multiple-line descriptions which result in separate
lines displayed on the form.

You can specify the default properties to use when adding this field to a view. See "View Field Editor" on page
234 for a description of the view display fields, including the Column Type and Column Format fields.

You can specify the default properties to use when adding the field to a form. See "View Field Editor" on page
234 for a list of the available user interface types.

If you select Text or Password as the User Interface type, the Placeholder row is added to this form. You
may use this field to enter a temporary value, such as a hint for how to complete the field, that can later be
overridden by the user completing the form that uses this field.
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You can specify the default validation rules that should be applied to this field when it is added to a form. See
"Form Validation Properties" on page 227 in this chapter for further information about form validation
properties.

Select the Show advanced properties check box to reveal additional properties related to conversion, display
and dynamic form behavior. See "View Field Editor" on page 234 in this chapter for more information about
advanced properties.

Click the Save Changes button to complete the creation of a new field. The new field is added at the top of
the field list. To change the position of the new field, you can re-sort the list or you can reload the page.

Duplicating a Field
To duplicate a field, go to Configuration > Pages > Fields, click the field to be duplicated, and then click its
Duplicate link. The field is copied and a number appended to the end of the field name—for example, if you
were to duplicate the card_code field, the duplicated field would be card_code_1. To rename the field, click
Edit.

Editing a Field
You are able to alter the properties of the field by making changes to the Field Name, Field Type, or Description.
To edit a field, go to Configuration > Pages > Fields, click the field to be edited, and then click its Edit link.

Click Save Changes to commit your changes to the field.

Deleting a Field
Fields that do not have a lock symbol can be deleted. A field that is currently in use on a form or view may
not be deleted.

To delete a field, go to Configuration > Pages > Fields, click the field to be deleted, and then click its
Delete link. You will be asked to confirm the deletion. A message indicates when the deletion is completed.
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Displaying Forms that Use a Field
To see a list of the forms that use a field, go to Configuration > Pages > Fields, click the field, and then click
its Show Forms link.

The list displays the forms that use the selected field. It also allows you to edit the form’s fields by clicking the
Edit Fields link. Click the Use link to open the form that uses that field.

If the field is used on multiple forms, you can select which form you would like to view.

Displaying Views that Use a Field

To see a list of views that use a field, go to Configuration > Pages > Fields, click the field, and then click its
Show Views.

The list displays the views that use the selected field. It also allows you to edit the view’s fields by clicking on the
Edit Fields link. Click the Use link to display the view.

If the field is used on multiple views, you are able to select which view you would like to see.

Customizing AirGroup Registration Forms
AirGroup allows users to register their personal mobile devices on the local network and define a group of
friends or associates who are allowed to share them. If AirGroup Services is enabled, AirGroup administrators
can provision their organization’s shared devices and manage access, and AirGroup operators can register and
provision a limited number of their own personal devices for sharing. For complete AirGroup deployment
information, refer to the AirGroup sections in the ArubaOS User Guide and the ClearPass Policy Manager
documentation.

On the device registration forms for AirGroup administrators and operators, the default Shared Locations
and Shared Roles fields are text boxes where the user enters the information. These fields can be configured
as selection options populated with existing locations or roles.

Configuring the Shared Locations and Shared Role Fields

To configure a predefined list of shared locations or shared roles:

1. Go to Configuration > Pages > Fields and click the airgroup_shared_location or airgroup_shared_role
row. The form expands to include the Edit, Duplicate, Show Forms, and Show Views links.

2. Click the Edit link. The Define Custom Field form opens. Scroll to the Default Form Display Properties
section.
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3. In the User Interface drop-down list, select Checklist.

4. In the Description text box, delete the existing text, then enter Select the location IDs where this
device will be shared. Leave blank to share with all locations.

5. Delete any text from the CSS Class and the CSS Style fields.

6. In the Options Generator drop-down list, select (Use options).

7. In the Options text box, enter a list of values to use as the checklist options that presented to the user.

The values you enter in the Options text box control both the values stored in the shared_location field in
the database as well as the text displayed to the user in the checklist. Use the following format:

tag1=value1 | Option 1

tag2=value2 | Option 2

...where the tag=value pair tag1=value1 represents the value stored in the shared_location field in the
database, the pipe character ( | ) is a separator, and Option 1 represents the text displayed in the checklist.

8. (Optional) To sort the locations by key or value, choose an option from the Sort drop-down list.

9. (Optional) To control the layout of the checklist on the form, first use the Layout drop-down list to select
either Vertical or Horizontal. The name of the next field changes to correspond to your choice in this field.
Enter the appropriate number in the Vertical Rows or Horizontal Rows field. If the Layout field is left
blank, the default layout of a single list of checklist options is displayed.

To ensure the values are stored correctly as a comma-separated list:

1. Scroll to the Advanced Properties section of the form and mark the check box in the Advanced row. The
form expands to include the advanced options.
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2. In the Conversion drop-down list, select NwaImplodeComma. The form expands to include the Type
Error row.

3. In the Display Function drop-down list, select NwaExplodeComma. The form expands to include the
Display Param and Display Arguments rows.

4. In the Display Param text field, enter the value _self. Be sure to include the leading underscore character.

5. Click Save Changes.

Example:

If the layout is set to vertical and the following options are specified:

AP-Group=Location-1 | Location One

AP-Group=Location-2 | Location Two

AP-Location-3 | Location Three
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The user interface appears as follows:

Customizing Forms and Views

You can view a list of ClearPass Guest's forms and views. From this list view, you can change the layout of
forms or views, add new fields to a form or view, or alter the behavior of an existing field.

To view or customize forms and views, go to Configuration > Pages > Forms & Views. The Customize
Forms and Views page opens.

You can open a form or view directly from the Forms and Views page. To open form or view to use it, go to
Configuration > Pages > Forms & Views, click the form’s or view’s row in the list, and then click its Use
link. The form or view opens in a separate tab, and the Forms and Views tab stays open so you can work in
both.

An asterisk (*) shown next to a form or view indicates that the form or view has been modified from the
defaults. You can click the Reset to Defaults link to remove your modifications and restore the original
form. Resetting a form or view is a destructive operation and cannot be undone. You will be prompted to
confirm the form or view reset before it proceeds.

Editing Forms and Views
You can change the general properties of a form or view such as its title and description. To edit the form or
view, go to Configuration > Pages > Forms & Views, click the form’s or view’s row in the list, and then click
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its Edit link. The row expands to include the Edit Properties form.

The Width field is only displayed for views. It specifies the total width of the list view in pixels. If blank, a
default value is used.

You can customize the page title, header HTML, and footer HTML for many forms and views (for example,
Create Guest Account, Edit Guest Accounts, and others). When these options are available, the Page
Properties area is included on the Edit Properties form.

Duplicating Forms and Views
You can make a copy of a form or view to use as a template in order to provide different forms and views to
different operator profiles. See "Role-Based Access Control for Multiple Operator Profiles" on page 454 for a
description. This enables you to provide different views of the underlying visitor accounts in the database
depending on the operator’s profile.

To make a copy of the form or view, go to Configuration > Pages > Forms & Views, click the form’s or view’s
row in the list, and then click its Duplicate link. The copy is added to the Forms and Views list.

The name of the duplicated form or view is the same as the original with a number appended. This name
cannot be changed. Use the Title and Description properties of the duplicated item to describe the intended
purpose for the form or view.

Click the Show Usage link for a duplicated form or view to see the operator profiles that are referencing it.

Click the Delete link for a duplicated form or view to remove the copy. A duplicated item cannot be
removed if it is referenced by an operator login account or an operator profile.
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Editing Forms
To add a new field to a form, reorder the fields, or make changes to an existing field, go to Configuration >
Pages > Forms & Views, click the form’s row in the Customize Forms & Views list, and then click the Edit
Fields link. The Customize Form Fields view opens.

Field Description

Rank Specifies the relative ordering of the fields when displaying the form. This list always shows
the fields in order by rank.

Field The name of the field in the database.

Type Controls what kind of user interface element is used to interact with the user.

Label The label for this field as it is displayed on the form.

Description The description for this field as it is displayed on the form.

To work with a form field, click its row in the list. The row expands to include configuration options:

Field Description

Edit Make changes to an existing field. The Form Field Editor opens. Any changes made to the field
using this editor will apply only to this field on this form.

Edit Base Field
Make changes to an existing field’s definition. Any changes made to the field using this editor
will apply to all forms that are using this field (except where the form field has already been
modified to be different from the underlying field definition).

Remove
Removes the field from the form. To add a field back to the form after it has been removed,
use the Insert Before or Insert After option and select it from the Field Name drop-down list
in the Form Field Editor that opens.

Insert Before
Add a new field to the form. Clicking one of these links opens a blank form field editor and
automatically sets the rank number of the new field.Insert After

Disable Field Disables this field on the form. To enable it on the form again, click Enable Field.

Preview Form

Opens an example of the form so you can see what it looks like. This preview form can be
submitted to test the field validation rules you have defined. If all fields are able to be
validated, the form submit is successful and a summary of the values submitted is displayed.
This allows you to verify any data conversion and formatting rules you have set up.
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Form Field Editor
The form field editor is used to control both the data gathering aspects and user interface characteristics of a
field.

To open the Form Field Editor, go to Configuration > Pages > Forms & Views, click a form or view, click its
Edit Fields link, click the field, and then click the field's Edit link.

Each field can only appear once on a form. The Field Name selects which underlying field is being represented
on the form.

The remainder of the form field editor is split into three sections:

l Form Display Properties

l Form Validation Properties

l Advanced Properties

See "Form Display Properties" on page 215 for detailed descriptions of these form sections.

Form Display Properties

On the Form Field Editor (see "Form Field Editor " on page 215), the form display properties control the user
interface that this field will have. Different options are available in this section, depending on the selection you
make in the User Interface drop-down list.

Fields with a green border use their base field's value. If you enter a different value to override the base field's
value, a Revert option lets you return to the original value.

The available user interface elements are listed below, together with an example of each.

l (Use default) – The default user interface type defined for the field will be used.
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l No user interface – The field does not have a user interface specified. Using this value will cause a
diagnostic message to be displayed (“Form element is missing the ‘ui’ element”) when using the form.

l CAPTCHA security code – A distorted image of several characters will be displayed to the user, as shown
below:

A new image may be generated, or the image may be played as an audio sample for visually impaired users.
When using the recommended validator for this field (NwaCaptchaIsValid), the security code must be
matched or the form submit will fail with an error.

l Check box – A check box is displayed for the field, as shown below:

The check box label can be specified using HTML. If the check box is selected, the field is submitted with its
value set to the check box value (default and recommended value 1). If the check box is not selected, the
field is not submitted with the form.
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l Checklist – A list of check boxes is displayed, as shown below:

The text displayed for each check box is the value from the options list. Zero or more check boxes may be
selected. This user interface type submits an array of values containing the option key values of each
selected check box. Because an array value may not be stored directly in a custom field, you should use the
conversion and value formatting facilities to convert the array value to and from a string when using this
user interface type.

To store a comma-separated list of the selected values, enable the Advanced options, select
“NwaImplodeComma” for Conversion, select “NwaExplodeComma” for Display Function and enter the
field’s name for Display Param.

The “Vertical” and “Horizontal” layout styles control whether the check boxes are organized in top-to-
bottom or left-to-right order. The default is “Vertical” if not specified. When using these options, you may
also specify the desired number of columns or rows to adjust the layout appropriately.
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For example, suppose the first two check boxes are selected (in this example, with keys “one” and “two”).
The incoming value for the field will be an array containing 2 elements, which can be written as array
("one", "two"). The NwaImplodeComma conversion is applied, which converts the array value into the
string value “one,two”, which is then used as the value for the field. Finally, when the form is displayed and
the value needs to be converted back from a string, the NwaExplodeComma display function is applied,
which turns the “one,two” string value into an array value array("one", "two"), which is used by the
checklist to mark the first two items as selected.

l Date/time picker – A text field is displayed with an attached button that displays a calendar and time
chooser. A date may be typed directly into the text field, or selected using the calendar:

The text value typed is submitted with the form. If using a date/time picker, you should validate the field
value to ensure it is a date.

Certain guest account fields, such as expire_time and schedule_time, require a date/time value to be
provided as a UNIX time value. In this case, the conversion and display formatting options should be used
to convert a human-readable date and time to the equivalent UNIX time and vice versa.
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l Drop-down list – The field is displayed allowing a single choice from a drop-down list.

The text displayed for each option is the value from the options list. When the form is submitted, the key of
the selected value becomes the value of the field.

If the “Hide when no options are selectable” check box is selected, and there is only a single option in the
drop-down list, it will be displayed as a static text item rather than as a list with only a single item in it.

l File upload – Displays a file selection text field and dialog box (the exact appearance differs from browser
to browser).

File uploads cannot be stored in a custom field. This user interface type requires special form
implementation support and is not recommended for use in custom fields.

l Hidden field – If Hidden Field is selected in the User Interface drop-down list, the field is not displayed to
the user, but is submitted with the form. This option is often used to force a specific value such as a user’s
role or an expiration date. However, it is possible for someone to use browser tools to modify the initial
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value when the form is submitted. If the value should be forced, use the Force Value setting under
Advanced Properties to ensure the value cannot be overridden. For more information, see "Advanced
Form Field Properties" on page 230.

To set the value to submit for this field, use the Initial Value option in the form field editor.

l Multiple Selection List -- A list of selectable options will be displayed.

The text displayed for each check box or radio button is the value from the options list. Zero or more check
boxes may be selected. This user interface type submits an array of values containing the option key values
of each selected check box. Because an array value may not be stored directly in a custom field, you should
use the conversion and value formatting facilities to convert the array value to and from a string when using
this user interface type.

To store a comma-separated list of the selected values, enable the Advanced options, select
“NwaImplodeComma” for Conversion, select “NwaExplodeComma” for Display Function and enter the
field’s name for Display Param.

The “Vertical” and “Horizontal” layout styles control whether the check boxes are organized in top-to-
bottom or left-to-right order. The default is “Vertical” if not specified. When using these options, you may
also specify the desired number of columns or rows to adjust the layout appropriately.
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l Password text field – The field is displayed as a text field, with input from the user obscured. The text
typed in this field is submitted as the value for the field.

l Radio buttons – The field is displayed as a group of radio buttons, allowing one to be selected, as shown
below:

The text displayed for each option is the value from the options list. When the form is submitted, the key of
the selected value becomes the value of the field.
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The “Vertical” and “Horizontal” layout styles control whether the radio buttons are organized in top-to-
bottom or left-to-right order. The default is “Vertical” if not specified.

l Static text – The field’s value is displayed as a non-editable text string. An icon image may optionally be
displayed before the field’s value. A hidden element is also included for the field, thereby including the field’s
value when the form is submitted.

If the Hide when no options are selectable check box is selected in the Collapse row, the field will be
hidden if its value is blank.

To set the value of this field, use the Initial Value option in the Form Validation Properties area of the
form field editor.
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l Static text (Raw value) – The field’s value is displayed as a non-editable text string. HTML characters in
the value are not escaped, which allows you to display HTML markup such as images, links and font
formatting.

Use caution when using this type of user interface element, particularly if the field’s value is collected from
visitors. Allowing HTML from untrusted sources is a potential security risk.
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If the Hide when no options are selectable check box is selected in the Collapse row, the field will be
hidden if its value is blank.

To set the value of this field, use the Initial Value option in the Form Validation Properties area of the
form field editor.

l Static text (Options lookup) – The value of the field is assumed to be one of the keys from the field’s
option list. The value displayed is the corresponding value for the key, as a non-editable text string.

An icon image may optionally be displayed before the field’s value. A hidden element is also included for the
field, thereby including the field’s value when the form is submitted.

If the Hide when no options are selectable check box is selected in the Collapse row, the field will be
hidden if its value is blank.

To set the value of this field, use the Initial Value option in the Form Validation Properties area of the
form field editor.

l Static group heading – The label and description of the field is used to display a group heading on the
form, as shown below. The field’s value is not used, and the field is not submitted with the form.

When using this user interface element, it is recommended that you use the “nwaImportant” CSS class to
visually distinguish the group heading’s title.
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l Submit button – The field is displayed as a clickable form submit button, with the label of the field as the
label of the button.

The description is not used. The field’s value is ignored, and will be set to NULL when the form is submitted.
To place an image on the button, an icon may be specified.

To match the existing user interface conventions, you should ensure that the submit button has the highest
rank number and is displayed at the bottom of the form.

l Text area – The field is displayed as a multiple-line text box. The text typed in this box is submitted as the
value for the field.
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It is recommended that you specify the desired minimum dimensions of the text area, either with the Rows
and Columns options, or by specifying a width in the CSS Style option (for example, “width: 460px; height:
100px;” specifies a 460 x 100 pixel minimum area).

l Text field – The field is displayed as a single-line text box. The text typed in this box is submitted as the
value for the field.

A short text label may be placed after the text box using the Label After option. This field allows you to
specify HTML (using Smarty template syntax) instead of plain text to be displayed after the input field.

If you select Text or Password as the User Interface type, the Placeholder row is added to this form. You
may use this field to enter a temporary value, such as a hint for how to complete the field, that can later be
overridden by the user completing the form that uses this field.
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Form Validation Properties
On the Form Field Editor (see "Form Field Editor " on page 215), the form validation properties control the
validation of data entered into a form. By specifying appropriate validation rules, you can detect when users
attempt to enter incorrect data and require them to correct their mistake.

The initial value for a form field may be specified. Use this option when a field value has a sensible default. The
initial value should be expressed in the same way as the field’s value. In particular, for drop-down list and radio
button selections, the initial value should be the key of the desired default option. Likewise, for date/time fields
that have a display function set, the initial value should be a value that can be passed to the display function.

Select the Field value must be supplied check box to mark the field as a required field. Required fields are
marked with an asterisk, as shown below:

An optional field may be left blank. In this case, the field is not validated as there is no value for the field.
However, any value that is supplied for an optional field is subject to validation checks.

All values supplied for a required field are always validated, including blank values.

Validation errors are displayed to the user by highlighting the field(s) that are in error and displaying the
validation error message with the field:

All fields must be successfully validated before any form processing can take place. This ensures that the form
processing always has user input that is known to be valid.

To validate a specific field, choose a validator from the drop-down list. See "Form Field Validation Functions" on
page 514 for a description of the built-in validators.

The Validator Param is the name of a field on the form, the value of which should be passed to the validator as
its argument. This could be used to validate one field based on the contents of another. However, in most
deployments this does not need to be set.

Set the Validator Param to its default value, “(Use argument)”, to provide a fixed value as the argument to the
validator.

The Validator Argument is used to provide further instructions to the selected validator. Not all validators
require an argument; a validator such as IsValidEmail is entirely self-contained and will ignore the Validator
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Argument. Validators such as IsEqual, IsInRange and IsRegexMatch use the argument to perform
validation.

Examples of Form field Validation
Example 1 – To create a form field that requires an integer value between 1 and 100 (inclusive) to be provided,
use the following settings in the form field editor (see "Form Field Editor " on page 215):

The form field will contain an integer value, so you should set the field's type to Integer when you create it.

Use the PHP syntax array(1, 100) to specify the minimum and maximum values for the IsInRange validator.
After saving changes on the form, this value will be internally converted to the equivalent code:

array (
0 => 1,
1 => 100,

)

With these validator settings, users that enter an invalid value will now receive a validation error message:

Furthermore, be aware that blank values, or non-numeric values, will result in a different error message:

The reason for this is that in this case, the validation has failed due to a type error – the field is specified to have
an integer type, and a blank or non-numeric value cannot be converted to an integer. To set the error message
to display in this case, use the Type Error option under the Advanced Properties.
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Example 2 – To create a form field that accepts one of a small number of string values, use the following
settings in the form field editor:

This example could be used for a string field named visitor_department. Because the values are known in
advance, a drop-down list is the most suitable user interface. An initial value for the form field, as shown above,
could be used if most visitors are in fact there to visit the sales team.

To match against a list of options used for a drop-down list or set of radio buttons, you can use the
IsInOptionsList validator.

Example 3 – To create a form field that validates U.S. social security numbers using a regular expression, use
the following settings in the form field editor:

Notice that the regular expression used here includes beginning and ending delimiters (in this case the /
character), and ensures that the whole string matches by the start-of-string marker ^ and the end-of-string
marker $. The construct \d is used to match a single digit. Many equivalent regular expressions could be
written to perform this validation task. See "Regular Expressions" on page 523 for more information about
regular expressions.
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Advanced Form Field Properties

On the Form Field Editor (see "Form Field Editor " on page 215), the Advanced Properties control certain
optional form processing behaviors. You can also specify JavaScript expressions to build dynamic forms similar
to those found elsewhere in the application.

On the Customize Form Fields page, select the Show advanced properties check box to display the advanced
properties in the form field editor.

The Conversion, Value Format, and Display Function options can be used to enable certain form
processing behavior. See "Form Field Conversion Functions" on page 519 and "Form Field Display Formatting
Functions" on page 519.

In the Force Value row, use the Always use initial value on form submit check box to prevent attempts
to override the value set for a field. When this option is set, if a user modifies the field’s value, it reverts to the
specified initial value when the form is submitted. A similar effect can be achieved by using appropriate
validation rules, but selecting this check box is easier. Using this option is recommended for hidden fields,
particularly those related to security, such as role ID or expiration date.

For pre-registered guest accounts, some fields may be completed during pre-registration and some fields may
be left for the guest to complete at registration. You can use the Pre-Registration field to specify whether the
guest’s entry must match the preliminary value provided for a field during pre-registration.

l If a value was not provided for a field when the account was created, choose Field was not pre-
registered from the drop-down list.

l If a preliminary value was provided for the field but the guest’s entered value does not need to match case
or all characters, choose Guest must supply field from the drop-down list. For example, a bulk account
creation might use random usernames, and each visitor’s entry in that field would not need to match
exactly.

l If a preliminary value was provided for the field and the guest’s entered value must match case or all
characters, choose Guest must supply field (match case) from the drop-down list. If the guest’s entry
does not successfully match the preregistered value, the account registration will not succeed. For example,
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if a list of email addresses and phone numbers was imported for pre-registration, each visitor’s entries for
those fields at registration must match.

Form Field Validation Processing Sequence
The following figure shows the interaction between the user interface displayed on a form and the various
conversion and display options available on the Form Field Editor (see "Form Field Editor " on page 215) .

Figure 28 Steps involved in form field processing

The Conversion step should be used when the type of data displayed in the user interface is different from the
type required when storing the field.

For example, consider a form field displayed as a date/time picker, such as the expire_time field used to
specify an account expiration time on the create_user form. The user interface is displayed as a text field, but
the value that is required for the form processing is a UNIX time (integer value).
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In this case, the Conversion function is set to NwaConvertOptionalDateTime to convert the string time
representation from the form field (for example, “2008-01-01”) to UNIX time (for example, 1199145600).

The Validator for the expire_time field is IsValidFutureTimestamp, which checks an integer argument
against the current time.

The Value Formatter is applied after validation. This may be used in situations where the validator requires the
specific type of data supplied on the form, but the stored value should be of a different type. In the expire_
time field example, this is not required, and so the value formatter is not used. However, if the Conversion
function had not been used, and the Validator had been set to IsValidFutureDateTime (which checks a string
date/time value), then the Value Formatter would need to be set to NwaConvertOptionalDateTime to perform
the data conversion before the form processing.

A comparison of these two approaches is shown below to illustrate the difference:

When using a Conversion or Value Format function, you will almost always have to set up a Display Function
for the form field. This function is used to perform the conversion in the reverse direction – between the
internal stored value and the value displayed in the form field.

See "Form Field Conversion Functions" on page 519 for a detailed list of the options available to you for the
Conversion and Value Format functions.

The Display Param is the name of a form field, the value of which will be passed to the Display Function. In
almost all cases this option should contain the name of the form field.

Display Arguments are available for use with a form field and are used to control the conversion process. In the
case of the expire_time form field, the Display Function is set to NwaDateFormat to perform a conversion
from a UNIX time to a date/time string, and the Display Argument specifies the format to use for the
conversion.

See "Form Field Display Formatting Functions" on page 519 for a detailed list of the options available to you for
the Display Function and Static Display Function.

The Enable If and Visible If options in the form field editor allow you to specify JavaScript expressions. The
result obtained by evaluating these expressions is used to enable/disable, or show/hide the form field in real
time, while an operator is using the form.
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Unlike the other parts of the form field editor, the Enable If and Visible If expressions are evaluated by the
operator’s Web browser. These expressions are not used by the server for any other purpose.

The expression must be a Boolean expression in the JavaScript language; statements and other code should
not be included as this will cause a syntax error when the form is displayed in a Web browser.

Because of the scoping rules of JavaScript, all of the user interface elements that make up the form are
available as variables in the local scope with the same name as the form field. Thus, to access the current value
of a text field named sample_field in a JavaScript expression, you would use the code sample_field.value.

Most user interface elements support the value property to retrieve the current value. For check boxes,
however, use the checked property to determine if the check box is currently selected.

The most practical use for this capability is to hide a form field until a certain value of some other related field
has been selected.

For example, the default create_user form has an Account Expiration drop-down list. One of the values in
this list is special: the -1 option displays the value Account expires at a specified time…

When this option is selected, the form expands to include the Expires After row, allowing the user to specify a
time other than one of the options in the list.

The expire_time field uses the JavaScript expression expire_after.value < 0 for the Visible If option. When
the -1 option has been selected, this condition will become true and the field will be displayed.

If the expire_timezone field is used in conjunction with expire_time and a time zone and date are selected,
the date calculation is adjusted relative to the time zone.

Additional examples of the Visible If conditional expressions can be found in the guest_edit form.

Editing Views
A view is a page in the application that displays data, similar to a form, but does not contain interactive fields
the user can modify. It consists of one or more columns, each of which contains a single field. You can change
which fields are displayed and how each field is displayed. You can also define your own fields using the
Customize Fields page, and then add them to a view by choosing appropriate display options for each new
column.

To add a new field to a view, reorder the fields, or make changes to an existing field in a view, go to
Configuration > Pages > Forms & Views, click the view, and click its Edit Fields link. The Customize View
Fields editor opens.
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View fields have a Rank number, which specifies the relative ordering of the columns when displaying the view.
The Customize View Fields editor always shows the columns in order by rank.

The Type of each field is displayed. This controls what kind of user interface element is used to display the
column, and whether the column is to be sortable or not. The Title of the column and the Width of the
column are also shown in the list view. Values displayed in italics are default values defined for the field being
displayed.

Click a view field in the list view to select it.

Use the Edit link to make changes to an existing column using the View Field Editor. Any changes made to
the field using this editor will apply only to this field on this view.

Use the Edit Base Field link to make changes to an existing field definition. Any changes made to the field
using this editor will apply to all views that are using this field (except where the view field has already been
modified to be different from the underlying field definition).

The Insert Before and Insert After links can be used to add a new column to the view. Clicking one of
these links will open a blank view field editor and automatically set the rank number of the new column.

Use the Enable Field and Disable Field links to quickly turn the display of a column on or off.

Click the Add Field tab to add a new column to the view.

View Field Editor
The view field editor is used to control the data-display aspects of a column within the view.

Each column in a view displays the value of a single field.

To use the default view display properties for a field, you only need to select the field to display in the column
and then click the Save Changes button.
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To customize the view display properties, click the Advanced view options… check box.

The column type must be one of the following:

l Text – The column displays a value as text.

l Sortable text – The column displays a value as text, and may be sorted by clicking on the column heading.

l Sortable text, case-insensitive – The same as “Sortable text”, but the column sorting will treat uppercase
and lowercase letters the same.

l Sortable numeric – The column displays a numeric value, and may be sorted by clicking on the column
heading.

The Column Format may be used to specify how the field’s value should be displayed. You may choose from
one of the following:

l Field Value – The value of the field is displayed as plain text.

l Field Value (Un-Escaped) – The value of the field is displayed as HTML.

l Boolean – Yes/No – The value of the field is converted to Boolean and displayed as “Yes” or “No”.

l Boolean – Enabled/Disabled – The value of the field is converted to Boolean and displayed as “Enabled”
or “Disabled”.

l Boolean – On/Off – The value of the field is converted to Boolean and displayed as “On” or “Off”.

l Date – The value of the field is assumed to be a UNIX timestamp value and is displayed as a date and time.

l Duration (from seconds) – The value of the field is assumed to be a time period measured in seconds and
is displayed as a duration (for example, “23 seconds”, “45 minutes”)

l Duration (from minutes) – The value of the field is assumed to be a time period measured in minutes
and is displayed as a duration (for example, “45 minutes”, “12 hours”)

l Use form options – The value of the field is assumed to be one of the keys from the field’s option list. The
value displayed is the corresponding value for the key.

l Custom expression… – The Display Expression text area is displayed allowing a custom JavaScript
expression to be entered. See "View Display Expression Technical Reference" on page 521 for technical
information about this display expression and a list of the functions that are available to format the value.

The Display Expression is a JavaScript expression that is used to generate the contents of the column.
Generally, this is a simple expression that returns an appropriate piece of data for display, but more complex
expressions can be used to perform arbitrary data processing and formatting tasks.

Customizing Guest Self-Registration

Guest self-registration allows an administrator to customize the process for guests to create their own visitor
accounts. Self-registration is also referred to as self-provisioned access. The registration process consists of a
data collection step (the ‘registration page’) and a confirmation step (the ‘receipt page’):

l On the registration page, you can define what information is collected from visitors. New fields and data
validation rules can be defined with the custom form editor. Specific details about the type of visitor
accounts created are also set here.

l The receipt page typically contains static information about the guest account, but several different actions
can be included, enabling visitors to obtain their receipt in different ways. The receipt page can also be used
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to automatically log the guest into a Network Access Server, enabling them to start using the network
immediately.

Detailed user interface customization can be performed for all parts of the self-registration process. You can
define page titles, template code for the page header and footer, and choose a skin that controls the overall
look and feel of self-registration. The default user interface customization can be disabled.

A guest self-registration process consists of many different settings. The Customize Guest Registration form
organizes these settings into the different stages of the registration process, each on its own section of the
form. These sections are displayed as separate pages in the Configuration UI. When you create a new
registration page, the process walks you through these pages of the form one at a time. When you edit a
registration page, links let you go directly to the section for the stage of the process you want to edit.

Accessing the Guest Self-Registration Customization Forms
To create a new guest self-registration page, go to Configuration > Pages > Guest Self-Registrations and
click the Create new self-registration page link in the upper-right corner. The first part of the Customize
Guest Registration form opens. See "Creating a Self-Registration Page" on page 241.

To work with an existing guest self-registration page, go to Configuration > Guest Self-Registrations. The
Guest Self-Registration list view opens. All self-registration pages that have been created are included in this
list.

Click a page's row in the list to select it. The row expands to include options for working with the self-
registration pages.

Field Description

Edit

Edit any of the self-registration page's properties. The Customize Guest Registration workflow
diagram opens. Links in the workflow diagram provide access to any section of the registration
page's properties. For information on editing the different parts of the self-registration process, see
"Editing Self-Registration Pages" on page 240.

Delete Deletes the guest self-registration page. You will be asked to confirm the deletion.

Duplicate Creates a copy of the self-registration page and appends a number to page name. See "Duplicating
a Self-Registration Page" on page 237.

Enable Enables the self-registration page so it can be used.

Disable Disables the self-registration page for the user and displays a message. See "Disabling a Self-
Registration Page" on page 237.

Go To Displays a preview of the Visitor Registration network access form. See "The "Go To" Option: The
Registration Page" on page 237.

Go to
Portal Displays a preview of the Self Service Login portal. See "The "Go to Portal" Option " on page 238.

Go to Login Displays a preview of the Network Login form. See "The "Go to Login" Option" on page 239.
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Field Description

Create new
self-
registration

Create a new self-registration page. See "Creating a Self-Registration Page" on page 241.

Duplicating a Self-Registration Page

When you choose the Duplicate option for a self-registration page, the row expands to include the Duplicate
Guest Registration form. Complete the fields to rename the page and enter a name for the Register page.
You can also give the page a description and indicate the parent page.

The Register page does not exist until you create it here. There are no spaces in this name. This page name will
become part of the URL used to access the self provisioning page. For example, the default “guest_register”
page is accessed using the URL guest_register.php.

Disabling a Self-Registration Page

When you choose the Disable option for a self-registration page, the row expands to include the Disable
Guest Registration form. In the Disabled Message text box, you may enter the HTML content to display
on the page when guest registration is disabled. You can also use the drop-down list to add images or other
content items.

The "Go To" Option: The Registration Page

When you choose the Go To option for a self-registration page, the row expands to show an active preview of
the Visitor Registration page and form as the visitor would see it. This is the registration page and data
collection step. You may test the behavior of the form.
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The Receipt Page

After the visitor successfully registers, the receipt page is their confirmation and provides their login and access
information.

The "Go to Portal" Option

When you choose the Go To Portal option for a self-registration page, the row expands to show an active
preview of the Self Service Login page and form as the visitor would see it. This form lets the visitor access
their account information. You may test the behavior of the form.
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The "Go to Login" Option

When you choose the Go To Login option for a self-registration page, the row expands to show an active
preview of the Network Login page and form as the visitor would see it. This is the page the visitor sees when
they log in to the network. You may test the behavior of the form.

Self-Registration Sequence Diagram
To set up a captive portal with guest self-registration, you configure your Network Access Servers to redirect
guests to the URL of the ‘Go To’ link. To complete the portal, you ensure that the NAS is configured to
authorize users with the ClearPass Guest RADIUS server, and set up the self-registration NAS login to redirect
registered guests back to the NAS.

This process is shown below.
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Figure 29 Sequence Diagram for Guest Self-Registration

In this diagram, the stages in the self-registration process are identified by the numbers in brackets, as follows:

The captive portal redirects unauthorized users [1] to the registration page [2]. After submitting the registration
form [3], the guest account is created and the receipt page is displayed [4] with the details of the guest account.
If NAS login is enabled (the default), submitting the form on this page will display a login message [5] and
automatically redirect the guest to the NAS login [6]. After authentication and authorization the guest’s security
profile is applied by the NAS [7], enabling the guest to access the network [8].

Editing Self-Registration Pages
When you edit a registration page, links let you go directly to the section of the Customize Guest Registration
form that corresponds to the stage of the process you want to edit.

To edit a self-registration page, go to Configuration > Pages > Guest Self-Registrations, select the page in
the list, and click its Edit link. The Customize Guest Registration workflow diagram opens.
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Figure 30 Guest Self-Registration Workflow Diagram
.

The diagram shows the guest self-registration process. The solid orange arrows show the workflow for the
visitor. The dotted blue arrows show the workflow for the administrator. The blue headings in the diagram are
links to the corresponding sections of the Customize Guest Registration form. Click an icon or label in the
diagram to jump directly to the editor for that item.

To view the Visitor Registration network access form (the registration page), click the Launch this guest
registration page link in the upper-right corner. To view the self-service portal the visitor can use to log in to
their account details after registration, click the Launch self-service portal link. To view the visitor's network
access login form, click the Launch network login link.

Creating a Self-Registration Page
The Customize Guest Registration form is divided across several pages, which are displayed separately. When
you create a new registration page, the process walks you through these pages of the form one at a time. As
you complete each page of the form, you can click Save and Continue to move to the next section of the
form. At any point, you can click Save and Continue or use your browser's Back button to move back and
forth through the pages, or you can click Save Changes to exit the process and go to the self-registration
process diagram.

To create a new guest self-registration page, go to Configuration > Pages > Guest Self-Registration and
click the Create new self-registration page link. The first section of Customize Guest Registration form
opens, where you can configure basic properties and access control. The Registration Page does not exist until
you create it here.
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Field Description

Name
(Required) The name of this self-registration page to identify it —for example, "Guest
Self-Registration". This name can include spaces. This name is only displayed to
administrators within ClearPass; it is not seen by the visitor.

Description You may enter comments to further identify or describe this page. This description is
only displayed within ClearPass.

Enabled

When creation of this page is complete, select this check box to make it available to
use. Deselect the check box if the page should not be used.
When self-registration is enabled, you can edit, delete, duplicate or go to the page
after it is created.

Register Page

(Required) The base page name for the guest registration page. Do not use spaces.
Allowed characters are letters, numbers, underscores, and hyphens.
This name becomes part of the URL used to access the self provisioning page. For
example, the default “guest_register” page is accessed using the URL guest_
register.php.
This name is only displayed to administrators within ClearPass; it is not seen by the
visitor.

Parent

The page to use as a basis for this page's configuration. If a parent page is selected
from this dropdown list, the parent page's values will be used for the new page's
configuration. These values can be edited. If the (No parent - standalone) option is
selected, all values must be configured.

Hotspot Select this check box if the page will be used for Hotspot transactions. Requires the
visitor to pay for access.

Authentication Requires operator credentials to access the page. The sponsor's operator profile
must include the Guest Manager > Create New Guest Account privilege.

Save Changes Saves your changes and creates the self-registration page. This form closes and the
self registration process diagram opens.

Save and
Continue

Saves your changes and creates the self-registration page. The next section of the
Customize Guest Registration form opens.
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Configuring Basic Properties for Self-Registration
Click the Master Enable, User Database, Choose Skin, or Rename Page links to edit the basic settings for
guest self-registration.

The Basic Properties window has configurable settings such as Name, Description, enabling guest-self
registration, Register Page, Parent, and Authentication.

Using a Parent Page

To use the settings from a previously configured self-registration page, select an existing page name from the
Parent drop-down menu. This is useful if you need to configure multiple registrations. You can always
override parent page values by editing field values yourself. To create a self-registration page with new values,
select the Guest Self-Registration (guest_register) option from the Parent field drop-down menu.

Paying for Access

If you select a standalone self -registration, (No parent- standalone) option you can also configure the
Hotspot option. You can configure this setting so that registrants have to pay for access.

Requiring Operator Credentials

If you want to require an operator to log in with their credentials before they can create a new guest account,
select the Require operator credentials prior to registering guest check box. The sponsor’s operator
profile must have the Guest Manager > Create New Guest Account privilege already configured.

If you choose this option, the authenticated page it produces for creating accounts is very simple, and does not
include navigation or other links that would otherwise be available in the operator user interface.

You can specify access restrictions for the self-registration page in the Access Control section of this form.
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The Allowed Access and Denied Access fields are access control lists that determine if a client is permitted to
access this guest self-registration page. You can specify multiple IP addresses and networks, one per line, using
the following syntax:

l 1.2.3.4 – IP address

l 1.2.3.4/24 – IP address with network prefix length

l 1.2.3.4/255.255.255.0 – IP address with explicit network mask

Use the Deny Behavior drop-down list to specify the action to take when access is denied. The Time Access
field allows you to specify the days and times that self-registration is enabled. Times must be entered in 24-
hour clock format. For example:

l Mondays, Wednesdays and Fridays, 8:00 to 17:00

l Weekdays, 6:00 to 18:00

l Weekends 10:00 to 22:00 and Thursday 11:00 to 13:00

The access control rules will be applied in order, from the most specific match to the least specific match.

Access control entries are more specific when they match fewer IP addresses. The most specific entry is a single
IP address (for example, 1.2.3.4), while the least specific entry is the match-all address of 0.0.0.0/0.

As another example, the network address 192.168.2.0/24 is less specific than a smaller network such as
192.168.2.192/26, which in turn is less specific than the IP address 192.168.2.201 (which may also be written
as 192.168.2.201/32).

To determine the result of the access control list, the most specific rule that matches the client’s IP address is
used. If the matching rule is in the Denied Access field, then the client will be denied access. If the matching
rule is in the Allowed Access field, then the client will be permitted access.

If the Allowed Access field is empty, all access will be allowed, except to clients with an IP address that
matches any of the entries in the Denied Access field. This behavior is equivalent to adding the entry
0.0.0.0/0 to the Allowed Access field.

If the Denied Access list is empty, only clients with an IP address that matches one of the entries in the
Allowed Access list will be allowed access. This behavior is equivalent to adding the entry 0.0.0.0/0 to the
Denied Access list.
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Editing Registration Page Properties
To edit the properties of the registration page:

1. Go to Configuration > Pages > Guest Self-Registration.

2. Select an entry in the Guest Self-Registration list and click its Edit link. The Customize Guest
Registration workflow page appears.

3. Click the Register Page link, or one of the Title, Header, or Footer fields for the Register Page.

Figure 31 The Customize Guest Registration Form

Template code for the title, header, and footer may be specified. See "Smarty Template Syntax" on page 478
for details on the template code that may be inserted.

Select the Do not include guest registration form contents check box to override the normal behavior of
the registration page, which is to display the registration form between the header and footer templates.

Click the Save and Reload button to update the self-registration page and launch or refresh a second
browser window to show the effects of the changes.

Click the Save Changes button to return to the process diagram for self-registration.

Click the Save and Continue button to update the self-registration page and continue to the next editor.

Editing the Default Self-Registration Form Settings
To edit the fields on the self-registration form, go to Configuration > Pages > Guest Self-Registration,
click the registration page's row in the list, and then click its Edit link. On the Customize Guest Registration
diagram, click the Form link for the Register Page. The Customize Form Fields (guest_register) list opens.
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The default settings for this form are as follows:

l The visitor_name and email fields are enabled. The email address of the visitor will become their
username for the network.

l The expire_after field is set to a value of 24 by default; this sets the default expiration time for a self-
registered visitor account to be 1 day after it was created. This field is hidden by default on the register
page.

l The role_id field is set to a value of 2 by default; this sets the default role for a self-registered visitor account
to the built-in Guest role. This field is hidden by default on the register page.

l The auto_update_account field is set by default. This is to ensure that a visitor who registers again with
the same email address has their existing account automatically updated.

Columns on the form editor:

Field Description

Rank Specifies the relative ordering of the fields when displaying the form. This list always shows the
fields in order by rank.

Type Controls what kind of user interface element is used to interact with the user.

Label The label for this field as it is displayed on the form.

Description The description for this field as it is displayed on the form.

Table 34: Form Editor Columns

To work with a form field, click its row in the list. The row expands to include configuration options:
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Field Description

Edit Make changes to an existing field. The Form Field Editor opens. Any changes made to the
field using this editor will apply only to this field on this form.

Edit Base Field
Make changes to an existing field’s definition. Any changes made to the field using this editor
will apply to all forms that are using this field (except where the form field has already been
modified to be different from the underlying field definition).

Remove
Removes the field from the form. To add a field back to the form after it has been removed,
use the Insert Before or Insert After option and select it from the Field Name drop-down list
in the Form Field Editor that opens.

Insert Before
Add a new field to the form. Clicking one of these links opens a blank form field editor and
automatically sets the rank number of the new field.Insert After

Disable Field Disables this field on the form. To enable it on the form again, click Enable Field.

Preview Form

Opens an example of the form so you can see what it looks like. This preview form can be
submitted to test the field validation rules you have defined. If all fields are able to be
validated, the form submit is successful and a summary of the values submitted is displayed.
This allows you to verify any data conversion and formatting rules you have set up.

Table 35: Form Editor Options

See also:

"Editing Self-Registration Pages" on page 240

Creating a Single Password for Multiple Accounts
You can create multiple accounts that have the same password. In order to do this, you first customize the
Create Multiple Guest Accounts form to include the Password field.

To include the Password field on the Create Multiple Guest Accounts form:

1. Go to Configuration > Pages > Forms & Views. Click the create_multi row, then click its Edit Fields
link. The Customize Form Fields view opens, showing a list of the fields included in the Create Multiple Guest
Accounts form and their descriptions.

At this point, the Password field is not listed because the Create Multiple Guest Accounts form (create_
multi) has not yet been customized to include it. You will create it for the form in the next step.

2. Click on any field in the list to expand a row, then click the Insert After link (you can modify this placement
later). The Customize Form Field form opens.

3. In the Field Name row, choose password from the drop-down list. The form displays configuration
options for this field.

4. In the Field row, mark the Enable this field check box.
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5. To adjust the placement of the password field on the Create Multiple Guest Accounts form, you may change
the number in the Rank field.

6. In the User Interface row, choose Password text field from the drop-down list. The Field Required
check box should now be automatically marked, and the Validator field should be set to IsNonEmpty.

7. Click Save Changes. The Customize Form Fields view opens again, and the password field is now included
and can be edited.

To create the multiple accounts that all use the same password, see "Creating Multiple Guest Accounts" on
page 45.

Editing Guest Receipt Page Properties
To edit the properties of the guest receipt page:

1. Go to Configuration > Pages > Guest Self-Registration

2. Select an entry in the Guest Self-Registration list and click its Edit link. The Customize Guest
Registration workflow page appears.

3. Click the Receipt Page link or one of the Title, Header, or Footer fields for the Receipt Page to edit the
properties of the receipt page. This page is shown to guests after their visitor account has been created.

Click the Save Changes button to return to the process diagram for self-registration.

Editing Receipt Actions
To edit the actions that are available after a visitor account has been created:

1. Go to Configuration > Pages > Guest Self-Registration.

2. Select an entry in the Guest Self-Registration list and click its Edit link. The Customize Guest
Registration workflow page appears.

3. In the Receipt Page area of the diagram, click the Actions link. The Receipt Actions form opens.
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Enabling Sponsor Confirmation for Role Selection

You can allow the sponsor to choose the role for the user account at the time the sponsor approves the self-
registered account.

To enable role selection by the sponsor:

1. Go to Configuration > Pages > Guest Self-Registration. Click the Guest Self-Registration row, then
click its Edit link. The Customize Guest Registration diagram opens.

2. In the Receipt Page area of the diagram, click the Actions link.
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The Receipt Actions form opens.

3. In the Sponsorship Confirmation area at the bottom of the form, mark the Enabled check box for
Require sponsor confirmation prior to enabling the account. The form expands to let you configure
this option.

4. In the Authentication row, mark the check box for Require sponsors to provide credentials prior to
sponsoring the guest.

5. In the Role Override row, choose (Prompt) from the drop-down list.

6. Complete the rest of the form with the appropriate information, then click Save Changes. The Customize
Guest Registration diagram opens again.

7. You can click the Launch this guest registration page link at the upper-right corner of the Customize
Guest Registration diagram to preview the Guest Registration login page.

The Guest Registration login page is displayed as the guest would see it.
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When a guest completes the form and clicks the Register button, the sponsor receives an email
notification.

8. To confirm the guest’s access, the sponsor clicks the click here link in the email, and is redirected to the
Guest Registration Confirmation form.

9. In the Account Role drop-down list, the sponsor chooses the role for the guest, then clicks the Confirm
button.

Editing Download and Print Actions for Guest Receipt Delivery

To enable the template and display options to deliver a receipt to the user as a downloadable file, or display the
receipt in a printable window in the visitor’s browser:

1. Go to Configuration > Pages > Guest Self-Registration. Click the Guest Self-Registration row, then
click its Edit link. The Customize Guest Registration diagram opens.

2. In the Receipt Page area of the diagram, click the Actions link. The Receipt Actions form opens.

3. Select either the Enable download of guest receipt check box in the Download area, or the Enable
print window for guest receipts check box in the Print area. The form expands to include configuration
options.
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Editing Email Delivery of Guest Receipts

The Email Delivery options available for the receipt page actions allow you to specify the email subject line, the
print template and email format, and other fields relevant to email delivery.

When email delivery is enabled, the following options are available to control email delivery:

l Disable sending guest receipts by email – Email receipts are never sent for a guest registration.

l Always auto-send guest receipts by email – An email receipt is always generated using the selected
options, and will be sent to the visitor’s email address.

l Auto-send guest receipts by email with a special field set – If the Auto-Send Field available for this
delivery option is set to a non-empty string or a non-zero value, an email receipt will be generated and sent
to the visitor’s email address. The auto-send field can be used to create an “opt-in” facility for guests. Use a
check box for the auto_send_smtp field and add it to the create_user form, or a guest self-registration
instance, and email receipts will be sent to the visitor only if the check box has been selected.

l Display a link enabling a guest receipt via email – A link is displayed on the receipt page; if the visitor
clicks this link, an email receipt will be generated and sent to the visitor’s email address.

l Send an email to a list of fixed addresses – An email receipt is always generated using the selected
options, and will be sent only to the list of email addresses specified in “Copies To”.
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Editing SMS Delivery of Guest Receipts

The SMS Delivery options available for the receipt page actions allow you to specify the print template to use,
the field containing the visitor’s phone number, and the name of an auto-send field.

These options under Enabled are available to control delivery of SMS receipts:

l Disable sending guest receipts by SMS – SMS receipts are never sent for a guest registration.

l Always auto-send guest receipts by SMS – An SMS receipt is always generated using the selected
options, and will be sent to the visitor’s phone number.

l Auto-send guest receipts by SMS with a special field set – If the Auto-Send Field is set to a non-
empty string or a non-zero value, an SMS receipt will be generated and sent to the visitor’s phone number.
The auto-send field can be used to create an “opt-in” facility for guests. Use a check box for the auto_
send_sms field and add it to the create_user form, or a guest self-registration instance, and SMS messages
will be sent to the specified phone number only if the check box has been selected.

l Display a link enabling a guest receipt via SMS – A link is displayed on the receipt page; if the visitor
clicks this link, an SMS receipt will be generated and sent to the visitor’s phone number. Only one SMS
receipt per guest registration can be sent in this way.

Enabling Downloading Passes

To enable downloading the receipt to the user as a digital pass:

1. Go to Configuration > Pages > Guest Self-Registration. Click the Guest Self-Registration row, then
click its Edit link. The Customize Guest Registration diagram opens.

2. In the Receipt Page area of the diagram, click the Actions link. The Receipt Actions form opens.

3. Scroll down to the Download Pass area of the form.

l If a Pass Certificate is not installed, an error is displayed. For information on digital passes and installing
pass certificates, see "Digital Passes" on page 270.

l If the Pass Certificate is installed, select the appropriate pass template.

Enabling and Editing NAS Login Properties
To enable and edit the properties for automatic NAS login:

1. Go to Configuration > Pages > Guest Self-Registration. Click to expand the Guest Self-Registration
row in the form, then click its Edit link. The Customize Guest Self-Registration diagram opens.

2. In the lower-right corner of the diagram, click the NAS box or the NAS Vendor Settings link. The NAS
Login form opens.
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If automatic guest login is not enabled, the submit button on the receipt page will not be displayed, and
automatic NAS login will not be performed.

In the Vendor Settings field, if Single Sign-On - SAML Identity Provider is selected, an appropriate service
must be created in CPPM using the ClearPass IDP service template. The external service provider must then be
configured to use the SAML Web login page as the IdP.

Editing Login Page Properties
The login page is displayed if automatic guest login is enabled and a guest clicks the Submit button from the
receipt page to log in.

To edit the properties of the login page:

1. Go to Configuration > Pages > Guest Self-Registration. Click to expand the registration page's row in
the form, then click its Edit link. The Customize Guest Self-Registration diagram opens.

2. In the Receipt Page area of the diagram, click the Title or Login Message fields for the login page to edit
the properties of the login page, then mark the Enable guest login to a Network Access Server check
box.The form expands to include configuration options.

The login page is also a separate page that can be accessed by guests using the login page URL. The login page
URL has the same base name as the registration page, but with login appended. To determine the login page
URL for a guest self-registration page, first ensure that the Enable guest login to a Network Access Server
option is checked, and then click the Launch network login link from the self-registration process
diagram.

The login page consists of two separate parts: the login form page, and a login message page.

Configuring the Login Form Part of the Page

The options available under the Login Form heading may be used to customize the login page.
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Field Description

Custom Form Indicates you will provide a custom login form. If selected, you must supply your own HTML login
form for the header or footer HTML areas.

Custom Labels Enables altering the default labels and error messages.

Username
Label

Label that appears on the form for the username field. Leave blank to use the default,
(Username:).

Password
Label

Label that appears on the form for the password field. Leave blank to use the default
(Password:).

Pre-Auth
Check

The username and password will be checked locally before proceeding to the NAS
authentication. Do not select this option if an external authentication server is used.

Pre-Auth Error Customized label text to display if username and password lookup fails. Leave blank to use the
default (Invalid username or password).

Username
Authentication

Allows the user to log in with only a username. The Password field will not be displayed. Only
accounts with the Username Authentication flag set can log in.

Prevent CNA
Enables bypassing the Apple Captive Network Assistant (CNA). The CNA is the pop-up browser
shown when joining a network that has a captive portal. This option might not work with all
vendors; it is dependent on how the captive portal is implemented.

Terms Requires the user mark a check box to accept a Terms and Conditions agreement.

Terms Label Label that appears on the form for the terms check box. Leave blank to use the default (Terms:).

Terms Text
Enter the HTML code containing your terms and conditions. Leave blank to use the default, (I
accept the <a href="{nwa_global name=guest_account_terms_of_use_url}" target="_
blank">terms of use</a>)
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Field Description

Terms Layout Layout for the terms and conditions text—either above or below the Terms check box.

Terms Error Text to display if the terms are not accepted. Leave blank to use the default (In order to log in,
you must accept the terms and conditions.).

Log In Label Label that appears on the form for the login button. Leave blank to use the default (Log In).

Health Check Requires the visitor to pass a health check before they can access the network. The health check
is done automatically through the OnGuard dissolvable agent.

Client Agents

The agent option OnGuard should use for client scanning. Options available in this drop-down list
are:
l Native agents with Java fallback
l Java Only
l Native agents only
Native agents are available for the Microsoft Windows and Apple OS X operating systems. Each
native agent is native to a specific platform and does not require Java.

Header HTML The HTML content to display above the health check text. You can use the drop-down list to add
images or other content items.

Footer HTML The HTML content to display below the health check text. You can use the drop-down list to add
images or other content items.

Update
Endpoint

Marks the user's MAC address as a known endpoint, and updates the endpoint's attributes with
other details from the user account (for example, the SSID, AP, and MAC address). If this check
box is selected, the form expands to include the Advanced field.

Advanced Lets you specify custom attributes to store in the endpoint. If this check box is selected, the form
expands to include the Endpoint Attributes field.

Endpoint
Attributes

Enter the list of name-value pairs to pass as custom attributes. Follow the format user_field |
Endpoint Attribute. Examples are shown.

The login form page contains a form prompting for the guest’s username and password. The title, header, and
footer of this page can be customized. If the Provide a custom login form option is selected, then the form
must also be provided in either the Header HTML or Footer HTML sections.
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Field Description

Login Page
Title The title that will be displayed on the NAS login page.

Header
HTML

The HTML content to display above the NAS login form. You can use the drop-down lists to add
images or other content items.

Footer
HTML

The HTML content to display below the NAS login form. You can use the drop-down lists to add
images or other content items.

Configuring the Login Message Part of the Page

The login message page is displayed after the login form has been submitted, while the guest is being
redirected to the NAS for login. The title and message displayed on this page can be customized.

The login delay can be set. This is the time period, in seconds, for which the login message page is displayed.

Click the Save Changes button to return to the process diagram for self-registration.

Self-Service Portal Properties
To edit the properties of the self-service portal:

1. Go to Configuration > Pages > Guest Self-Registration. Click to expand the Guest Self-Registration
row in the form, then click its Edit link. The Customize Guest Self-Registration diagram opens.

2. Click the Self-Service Portal link or one of the Login Page, Summary Page, Change Password, or
Reset Password links for the Self-Service Portal.

The self-service portal is accessed through a separate link that must be published to guests. The page name for
the portal is derived from the registration page name by appending “_portal”.

When the self-service portal is enabled, a Go To Portal link is displayed on the list of guest self-registration
pages, and may be used to determine the URL that guests should use to access the portal.

The portal offers guests the ability to log in with their account details, view their account details, or change their
password. Additionally, the Reset Password link provides a method allowing guests to recover a forgotten
account password.
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To adjust the user interface, use the override check boxes to display additional fields on the form. These fields
allow you to customize all text and HTML displayed to users of the self-service portal.

The behavioral properties of the self-service portal are described below:

l The “Enable self-service portal” check box must be selected for guests to be able to access the portal. Access
to the portal when it is disabled results in a disabled message being displayed; this message may be
customized using the “Disabled Message” field.

l The “Disabled Users” check box controls whether a user account that has been disabled is allowed to log in
to the portal.

l The “Change Password” check box controls whether guests are permitted to change their account password
using the portal.

l The “Reset Password” check box controls whether guests are permitted to reset a forgotten account
password using the portal. If this check box is enabled, the “Required Field” may be used to select a field
value that the guest must match in order to confirm the password reset request.

If the “Auto login by IP address” option is selected, a guest accessing the self-service portal will be automatically
logged in if their client IP address matches the IP address of an active RADIUS accounting session (that is, the
guest’s HTTP client address is the same as the RADIUS Framed-IP-Address attribute for an active session).

The Password Generation drop-down list controls what kind of password reset method is used in the portal.
The default option is “Passwords will be randomly generated”, but the alternative option “Manually enter
passwords” may be selected to enable guests to select their own password through the portal.

Click the Save Changes button to return to the process diagram for self-registration.

Resetting Passwords with the Self-Service Portal
The self-service portal includes the ability to reset a guest account’s password.
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The default user interface for the self-service portal is shown below:

Clicking the  I’ve forgotten my password link displays a form where the user password may be reset:

Entering a valid username will reset the password for that user account, and will then display the receipt page
showing the new password and a login option (if NAS login has been enabled).

This feature allows the password to be reset for any guest account on the system, which may pose a security
risk. It is strongly recommended that when this feature of the self-service portal is enabled, guest registrations
should also store a secret question/secret answer field.

To enable a more secure password reset operation, first enable the secret_question and secret_answer
fields to the registration form. The default appearance of these fields is shown below:

Next, enable the Required Field option in the Self-Service Portal properties. Setting this to (Secret Question)
will ask the guest the secret_question and will only permit the password to be reset if the guest supplies the
correct secret_answer value.
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With these settings, the user interface for resetting the password now includes a question and answer prompt
after the username has been determined:

Selecting a different value for the “Required Field” allows other fields of the visitor account to be checked.
These fields should be part of the registration form. For example, selecting the visitor_name field as the
“Required Field” results in a Reset Password form like this:

Managing Web Logins

The Web Logins page lists all the Web login pages you have created, and lets you edit and test them and create
new Web login pages.

To view the list of your Web login pages and work with them, go to Configuration > Pages > Web Logins.
The Web Logins list view opens. All Web login pages you have created are included in the list. Information
shown for each page includes its name for internal identification, title as displayed in the user interface,
filename, and the skin assigned to it.

You can click a page's row in the list for additional options:

Field Description

Edit
Edit any of a Web login page's attributes. The Web Login Editor form opens. For
more information, see "HeanCreating and Editing Web Login Pages" on page
261.

Table 36: The Web Logins List View
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Field Description

Duplicate

Create a copy of a Web login page to use as a basis for a new page. A progress
bar is shown while the page settings are duplicated. When it is complete, the
new page is displayed in the list with "Copy of" prepended to its name. The copy
has all attributes prepopulated from the original page. You can click the copy's
row in the list to open the editor and edit any of its attributes.

Delete Delete the page. You will be asked to confirm the deletion.

Test

View and test a Web login page. The page opens in a new tab as it would appear
to a user:

Create new Web login page Create a new Web login page. For more information, see "HeanCreating and
Editing Web Login Pages" on page 261.

HeanCreating and Editing Web Login Pages

Onboard device provisioning pages are now managed from the Web Login tab in Onboard > Provisioning Settings.
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Onboard creates a default Web login page that is used to start the device provisioning process.

To create a new Web login page, go to Configuration > Pages > Web Logins and click the Create new Web
login page link in the upper-right corner. The Web Login Editor form opens.

Field Description

Name (Required) Enter a name for the page.

Page Name Identifier page name that will appear in the URL -- for example, "/guest/page_name.php".

Description Additional information or comments about the page.

Vendor Settings

(Required) Vendor-specific settings for network configuration. This drop-down list includes a
list of Vendors to you can select from, and a list of Other settings:
l Custom Settings—The form includes options for configuring your custom settings.
l Captive portal with ClearPass Web Auth—The form includes the options for

configuring this vendor setting.
l Single Sign-On - SAML Identity Provided—Complete the configuration options for

this vendor setting. An appropriate service must also be created in CPPM using the
ClearPass IDP service template. The external service provider must then be configured
to use the SAML Web login page as the IdP.

l Single Sign-On - Authorize Only—Allows the server to be configured as an IdP, and a
login form is not displayed. If the AppAuth request to validate the SAML SP request is
successful, the user is logged in through the normal SAML IdP flow. If the AppAuth
request is not successful, a SAML Failure response is returned to the service provider.
This vendor setting is useful if you have configured Aruba Auto Sign0On (ASO) with
third-party identity providers.

Login Method

Specifies how the user's network login should be handled. Options include:
l Controller-initiated—Guest browser performs HTTP form submit
l Server-initiated—Change of authorization (RFC 3576) sent to controller—Server-

initiated logins require the user's MAC address to be available. This is usually acquired
through the captive portal redirect.

Table 37: Web Login Editor, General Properties
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Field Description

l Policy Initiated—An enforcement policy will control a change of authorization—
This option should be selected if a Policy Manager policy that includes a "bounce client"
will be run as part of the page's actions. This option should be selected if you are using
OnGuard health checks.

Address (Required) IP address or hostname of the vendor's product.

Secure Login

Security option to use for the Web login process. Options include:
l Use vendor default
l Secure login using HTTPS
l Send cleartext passwords over HTTP.

Dynamic Address For multi-controller deployments, enables sending the IP to submit credentials. The
Allowed Dynamic and Denied Dynamic fields are added to the form.

Allowed Dynamic IP addresses and networks that will be allowed.

Denied Dynamic IP addresses and networks that will be denied.

Security Hash

Level of checking to apply to URL parameters passed to the Web login page. Detects when
URL parameters have been modified by the user (for example, their MAC address). To
prevent the user from tampering with parameters passed in the redirect URL (for example,
their MAC address), select one of the validation error options.
If one of the validation error options is selected, the form expands to include the URL Hash
Key fields.

URL Hash Key
Confirm Key

(Required) Enter the RADIUS shared secret for the redirect URL's hash verification process
in both fields.

Options in the Login Form area specify the behavior and content of the login form. The options available in
this area depend on the selection you made in the Vendor Settings field:

Field Description

Submit URL URL of the NAS device's login form.

Submit Method Method to use when submitting the login form to the NAS. Options include:
l POST

Table 38: Web Login Editor, Login Form Properties
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Field Description

l GET

Authentication

Authentication requirement options include:
l Credentials — Require a username and password
l Access Code — Only require a username for authentication—This option does not

require a password.
l Anonymous — Do not require a username or password—This option adds the Auto-

Generate and Anonymous User fields to the form. It allows a blank form with only the
terms or a Log In button. A pre-existing account is required.

l Auto — Do not require a username or password and automatically submit the
page—This option can be used if now authentication or prompting is needed. A pre-
existing local anonymous account is required. This option should be selected if you are
using OnGuard health checks.

Auto-Generate Auto-generates the anonymous account. Account is created without a session limit or
expiration time, and with the Guest role (ID 2).

Anonymous User
(Required) Account to use for anonymous authentication. The password will be visible in the
HTML. The account Session Limit should be increased to the number of guests to be
supported.

Prevent CNA
Enables bypassing the Apple Captive Network Assistant (CNA). The CNA is the pop-up
browser shown when joining a network that has a captive portal. This option might not work
with all vendors; it is dependent on how the captive portal is implemented.

Custom Form Indicates you will provide a custom login form. If selected, you must supply your own HTML
login form for the header or footer HTML areas.

Custom Labels Enables altering the default labels and error messages. This option adds the Pre-Auth
Error field to the form.

Username Field Name of the username field for the login form. This value is passed to the NAS device when
the form is submitted.

Username Suffix Suffix automatically appended to the username before submitting the login form to the
NAS.

Username Label Label that appears on the form for the username field. Leave blank to use the default,
(Username:).

Password Field Name of the password field for the login form. This value is passed to the NAS device when
the form is submitted.

Password
Encryption

Type of password encryption to use when submitting the login form. Options include:
l No Encryption (plaintext password)
l UAM basic
l UAM with shared secret

Password Label Label that appears on the form for the password field. Leave blank to use the default
(Password:).

UAM Secret Shared secret between the NAS device and the Web login form.

Pre-Auth Check

How the username and password should be checked before authentication. Options
include:
l None — no extra checks will be made
l App Auth — check using Aruba Application Authentication (the default)
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Field Description

l Local — match a local acount
l RADIUS — check using a RADIUS request
l Single Sign-On — enable SSO for this Web login—When this option is selected,

guests are redirected to the identity provider (IdP) configured in CPPM, where they
authenticate themselves. They are redirected back to CPPM, which verifies the login was
successful and uses the same credentials to redirect to the actual Web login flow. (SSO
support is enabled at CPPM > Configuration > Identity > Single Sign-On)

Pre-Auth Error Customized label text to display if username and password lookup fails. Leave blank to use
the default (Invalid username or password).

Terms Requires the user mark a check box to accept a Terms and Conditions agreement.

Extra Fields You may specify any additional field names and values to send to the NAS device. Enter
these as name=value pairs, one per line.

Terms Label Label that appears on the form for the terms check box. Leave blank to use the default
(Terms:).

Terms Text
Enter the HTML code containing your terms and conditions. Leave blank to use the default,
(I accept the <a href="{nwa_global name=guest_account_terms_of_use_url}"
target="_blank">terms of use</a>)

Terms Layout Layout for the terms and conditions text—either above or below the Terms check box.

Terms Error Text to display if the terms are not accepted. Leave blank to use the default (In order to log
in, you must accept the terms and conditions.).

Log In Label Label that appears on the form for the login button. Leave blank to use the default (Log In).

Skin

Skin to use for the Web login page. Options include:
l (Default)
l Aruba ClearPass Skin
l Blank Skin
l ClearPass Guest Skin
l Custom Skin 1
l Custom Skin 2

Title Title to display on the Web login page. To use the default (Login), leave this field blank.

Login Message Enter the HTML template code for the text to display while the login is in progress.

Login Delay
Specifies the number of seconds to delay while displaying the login message. The default
content is shown, and can be modified. You can also use the drop-down list to add images
or other content items.

Options in the Default Destination area control the destination page users are redirected to after login:
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Field Description

Default URL The default URL for the redirect page. For external domains, this must include the http://
prefix.

Override
Destination

Forces the default destination for all clients, overriding any default value already set on the
client.

Table 39: Web Login Editor, Default Destination Properties

Options in the Login Page area control the look and feel of the login page:

Field Description

Skin (Required) Specifies the skin to use for the login page.

Title The title that will be displayed on the page.

Header
HTML

The HTML content to display above the login form. The default content is shown, and can be modified.
You can also use the drop-down lists to add images or other content items, or to insert a self-
registration link.

Footer
HTML

The HTML content to display below the login form. The default content is shown, and can be modified.
You can also use the drop-down lists to add images or other content items, or to insert a self-
registration link.

Login
Message

Enter the HTML template code for the text to display while the login attempt is in progress. The default
content is shown, and can be modified. You can also use the drop-down list to add images or other
content items.

Login
Delay Specifies the number of seconds to delay while displaying the login message.

Table 40: Web Login Editor, Login Page Properties
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Options in the Social Logins area let you present guests with various social login options:

Field Description

Social Login To enable the use of social network credentials to log in, select this check box. The form expands
to include social login configuration options.

Authentication
Providers All social network providers that have been configured are included in this list.

Add new
authentication
provider

Opens the properties form for adding and configuring a social network provider.

Debug If selected, social logins debugging will be included in the application log.

Edit Opens the Properties form. You can edit any of the configuration options for the provider.

Disable Disables the provider. To enable it again, click the Enable link.

Move Up Moves the provider up or down in the list.

Table 41: Web Logins Editor, Social Logins Properties
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Field Description

Move Down

Delete Removes the provider from the list and deletes its configuration. You will be asked to confirm the
deletion.

Add new
authentication
provider

Opens the properties form for adding and configuring a social network provider.

Provider (Required) Select a social network provider from the drop-down list.

Enabled If selected, this provider can be used.

Client ID The client ID to use with this provider. The provider might use a different label.

Client Secret The client secret to use with this provider. The provider might use a different label.

Advanced Displays additional options on this form.

Destination URL to which guests authenticating with this provider will be redirected after logging in.

Auto Redirect If selected, local logins and other providers will not be supported. If this option is selected, we
recommend you also enable Custom Form in the Login Form area.

Endpoint
Attributes

If selected, an endpoint attribute is created for every attribute returned by the user. This is only
needed if you are creating specialized enforcement policies on them.

Flatten Prefix
If Endpoint Attributes was selected, you may enter text to prepend to all keys when flattening.
This stores a normalized version of all the returned attributes in the endpoint. If nothing is
entered in this field, the default "social" will be used.

Username
Prefix

Text to prepend to all usernames. A prefix can be useful if you are providing a way to log in using
a variety of providers.

Username
Suffix

Text to append to all usernames. A suffix can be useful if you are providing a way to log in using
a variety of providers.

Icon Label Overrides the default label on the provider's icon.

Notes You may enter additional notes or comments about the provider. This description is only seen by
administrators.

Email If selected, allows the provider to request access to the guest's email address. Access requires
additional permission for the provider.

Google Plus if selected, allows the provider to request access to the guest's Google Plus profile. Access
requires additional permission for the provider.

Google Apps
VIP

Name of the user record attribute to apply to the social_vip flag. For more information, refer
to the Google Directory API for retrieving users.

Allow Guests If selected, allows Google accounts that are not part of your domain to log in as guests. The
social_vip flag will be set to false for these users.

Admin SDK
Refresh Token

(Required) Enter a valid Google API admin refresh token. To generate a new refresh token, clear
this value. You will need to generate a new authorization code.
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Field Description

Generate Code To generate a new authorization code, click the link in this field. You will be redirected to a new
window to generate an authorization code.

Authorization
Code

(Required) When you generate a new code, it is automatically entered in this field, and you can
close the redirect window.

LinkedIn VIP Enter a LinkedIn Distance value (0 - 3). If the guest is within this distance, the social_vip flag
will be enabled for them.

Add When your entries are complete on the Properties, form, click this button. The Properties form
closes and the provider is included in the Authentication Providers list.

Options in the Network Login Access area control access to the login page:

Field Description

Allowed
Access The IP addresses and networks from which logins will be allowed.

Denied
Access The IP addresses and networks from which logins will be denied.

Deny
Behavior

(Required) The response shown to the user if their login request is denied. Options in this drop-
down list include:
l Send HTTP 404 Not Found status
l Show Access Denied page
l Show a blank page

Table 42: Web Login Editor, Network Login Access Properties

Options in the Post-Authentication area control the actions to perform after a successful pre-authentication:

Field Description

Health
Check

Requires the visitor to pass a health check before they can access the network. The health check is
done automatically through the OnGuard dissolvable agent.

Client
Agents

The agent option OnGuard should use for client scanning. Options available in this drop-down list are:
l Native agents with Java fallback
l Java Only

Table 43: Web Login Editor, Post-Authentication Properties
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Field Description

l Native agents only
Native agents are available for the Microsoft Windows and Apple OS X operating systems. Each native
agent is native to a specific platform and does not require Java.

Header
HTML

The HTML content to display above the health check text. The default content is shown, and can be
modified. You can also use the drop-down list to add images or other content items.

Footer
HTML

The HTML content to display below the health check text. The default content is shown, and can be
modified. You can also use the drop-down list to add images or other content items.

Update
Endpoint

Marks the user's MAC address as a known endpoint, and updates the endpoint's attributes with other
details from the user account. If this check box is selected, the form expands to include the Advanced
field.

Advanced Lets you specify custom attributes to store in the endpoint. If this check box is selected, the form
expands to include the Endpoint Attributes field.

Endpoint
Attributes

Enter the list of name-value pairs to pass as custom attributes. Follow the format user_field |
Endpoint Attribute. Examples are shown in this text box.

Receipts

The Receipts area of the user interface lets you customize the receipts that are available to guests and
sponsors. To work with receipts configuration, go to Configuration > Receipts > Start Here.

This section includes:

l "Digital Passes" on page 270

l "Email Receipts and SMTP Services" on page 284

l "Customizing SMS Receipt" on page 290

l "Customizing Print Templates " on page 291

Digital Passes

Digital passes are cryptographically signed files containing fields and images that are used as boarding passes,
event tickets, coupons, store passes, or other scannable items.

In ClearPass Guest, you can upload and install digital pass certificates, create new templates for digital passes,
and use the passes for guest receipts.

To work with digital passes, go to Configuration > Receipts > Digital Pass Templates.

This section includes:

l "About Digital Passes" on page 271

l "Viewing Digital Pass Certificates" on page 274

l "Installing Digital Pass Certificates" on page 275
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l "Managing Digital Passes" on page 276

l "Creating and Editing a Digital Pass Template" on page 277

l "Example Template Code Variables" on page 282

l "Images in Digital Passes" on page 283

About Digital Passes
A digital pass is a cryptographically signed file that contains fields and images. When viewed by a user, a pass
looks like a simple card, with a front side and a back side. Passes are issued to users as boarding passes, event
tickets, coupons, store passes, or other scannable items (for example, a membership pass).

Passes can be organized in Apple Passbook on the user's device. Good visual design practices ensure that each
pass can be quickly recognized when displayed amongst other passes. (Apple Passbook is available on Apple
iOS 6+ devices.)
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To use a pass such as a membership card or store card, the user selects it from the passbook and displays it so
the barcode can be scanned. To use a pass such as a boarding pass or event ticket where date relevance or
location relevance was configured, it can be accessed when it becomes active on the lock screen at the relevant
time or place.

Passes for Guest Receipts in ClearPass Guest

In ClearPass Guest, you can use passes to provide a guest receipt to a user who has registered using a guest
self-registration page. ClearPass Guest supports the pass format specified for the Apple Passbook application.

The front of a guest receipt pass typically shows the site SSID, the username, password, and account expiration
time. The back of the pass provides instructions for connecting to the network. It also contains logos and icons,
typically those of the organization providing the guest receipt. The exact details of what is written into the
guest receipt pass are determined by a pass template.

When the guest has registered and the guest receipt page is displayed, they can click the Add to Passbook link.
This generates the new guest receipt pass, using fields from the registered guest account such as the username,
password, and expiration time. The fields included in the pass, as well as where they are placed and how they
are formatted, are determined by the pass template that was selected for the guest self registration. The pass
is also cryptographically signed using a Pass Certificate.The generated pass is provided as a download, and the
user can add the downloaded pass to their passbook.

Pass Templates

The pass template defines what is written into the pass. You can create, edit, copy, and delete pass templates.
For more information, see "Managing Digital Passes" on page 276 and "Creating and Editing a Digital Pass
Template" on page 277.

Pass templates define:

l Name and a description: Used to identify the template in ClearPass administrative forms and views.
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l Style: Boarding Pass, Event ticket, Coupon, Store Pass, or Generic.

l Colors: Foreground, background, and label. If no alternate colors are specified, then default colors will be
used. If there are alternate colors specified, then they will be used instead of the default colors.

l Summary: Short description for a voice-over.

l Icon: Displayed on the lock screen. A shine effect is automatically applied to the icon. To select an icon
image, it must first be uploaded to the Public Files area of the content manager.

l Logo: Displayed in the top left corner of the front of the pass. To select a logo image, it must first be
uploaded to the Public Files area of the content manager.

l Fields: For the front and back of the pass. The information shown on the pass is broken up into fields. Each
field is defined by a dictionary which gives it a value and label (which are displayed to the user), a unique key,
and optional information about how its value should be formatted.

l Relevant locations (GPS coordinates) and relevant date: Used by Apple Passbook to show a message on the
Lock screen where and when the pass becomes relevant.

Many settings for a pass template accept standard template code. This is the same template code that is
supported for print templates. This allows an administrator to specify either simple direct values or more
complex values based upon the evaluation of template code. All template code is evaluated at the time that
the pass is generated from the pass template, using values from the guest receipt as inputs to the pass
template.

A pass can contain both a low-resolution version (i.e. for non-Retina displays) and a high-resolution version (i.e.
for Retina displays) of each image. If uploaded to the content manager, the high-resolution version of an image
is also automatically included in the pass. The high-resolution version must be named with a @2x suffix placed
just before the file extension—for example:

Company_Logo.png (low-resolution file name)

Company_Logo@2x.png (high-resolution file name)

Apple Passbook Certificates

You must have a Pass Certificate issued by Apple to be able to generate Apple Passbook passes.

As part of the generation process, the pass is cryptographically signed using a Pass Certificate. A Pass Certificate
is a special type of X.509 certificate issued by Apple through the Apple Developer portal. You need a Pass
Certificate to cryptographically sign the passes when they are generated and downloaded. This cryptographic
signature is verified by Passbook when adding a pass. Passbook will only accept a pass that has been signed by
a valid Pass Certificate issued by Apple. To obtain a pass certificate, you must have an Apple developer account.
You may register for a developer account at developer.apple.com.

For more information, see "Viewing Digital Pass Certificates" on page 274 and "Installing Digital Pass
Certificates" on page 275.

Digital Passes Process Overview

To obtain and install an Apple Passbook certificate:

1. Log in to the Apple Developer portal at developer.apple.com.

2. Register a Pass Type ID for your pass.

3. Create a certificate for your Pass Type ID.

4. Follow the portal’s instructions to create a certificate signing request using Keychain Access (a standard Mac
OS X application) and submit it to the portal.
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5. Download the Pass Type ID certificate.

You also need to provide the private key for the pass certificate. If you created the certificate signing request
using Keychain Access:

1. In Keychain Access, locate the private key for the certificate signing request.

2. Export this private key to a Personal Information Exchange (.p12) file.

To install the pass certificate and the associated private key in ClearPass Guest, go to Configuration > Digital
Passes > Start Here and click Install Pass Certificate. For more information, see "Installing Digital Pass
Certificates" on page 275.

To enable pass downloads:

1. Go to Configuration > Guest Self-Registration, click an enabled guest self registration's row, and then
click its Edit link.

2. In the diagram, click the Actions link for the Receipt Page.

3. Scroll down to the Download Pass area and set the Enabled field to Display a link enabling download
of a guest receipt pass.

4. Select the Template to use (there should be at least one default template available for selection).

Viewing Digital Pass Certificates

You must have a pass certificate in order to generate and download passes. A Pass Certificate is a special type
of X.509 certificate issued by Apple through the Apple Developer portal. You need a Pass Certificate to
cryptographically sign the passes when they are generated and downloaded. This cryptographic signature is
verified by Passbook when adding a pass. Passbook will only accept a pass that has been signed by a valid Pass
Certificate issued by Apple.

To view the certificate that will be used to sign Apple Passbook digital passes, go to Configuration > Digital
Passes > Pass Certificate. If a pass certificate has been installed, this page displays the certificate details.
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If no pass certificate is installed yet, no details are displayed. Click the Upload pass certificate link to obtain
and install a certificate. See "Installing Digital Pass Certificates" on page 275.

Installing Digital Pass Certificates
You must have a valid Pass Certificate issued by Apple in order to generate and download passes. To obtain a
pass certificate, you first need an Apple developer account. Developer accounts are free; to register for an
account, go to developer.apple.com and click the register link at the bottom of the page.

To obtain the Apple Passbook certificate that will be used to sign digital passes:

1. Log in to the Apple Developer portal at developer.apple.com.

2. Register a Pass Type ID for your pass.

3. Create a certificate for your Pass Type ID.

4. Follow the portal’s instructions to create a certificate signing request using Keychain Access (a standard Mac
OS X application) and submit it to the portal.

5. Download the Pass Type ID certificate.

You also need to provide the private key for the pass certificate. If you created the certificate signing request
using Keychain Access:

1. In Keychain Access, locate the private key for the certificate signing request.

2. Export this private key to a Personal Information Exchange (.p12) file.

To install the certificate, go to Configuration > Digital Passes > Start Here and click the Install Pass
Certificate link, or go to Configuration > Digital Passes > Pass Certificate and click the Upload pass
certificate link. Step 1 of the Install Pass Certificate form opens.
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Field Description

Format Specify whether you will upload the certificate as a file or paste in the certificate text.
The form expands to include the Step 2 options.

Certificate

For certificates pasted as text, copy and paste the digital certificate's text. This is a
block of encoded text and should include the "BEGIN CERTIFICATE" and "END
CERTIFICATE" lines.
For uploaded certificate files, browse to the certificate to upload. This should be one of
the following:
PEM encoded X.509 file containing the certificate (*.pem)
PKCS#12 encoded file containing both the certificate and the private key (*.p12)

Private Key

For private keys pasted as text, copy and paste the private key's text. This is a block of
encoded text and should include the "BEGIN PRIVATE KEY" and "END PRIVATE KEY"
lines.
For uploaded private key files, if the certificate file does not include the private key,
browse to the private key to upload. The private key should be either a PEM-encoded
or a Personal Information Exchange (.p12) file.

Passphrase
Confirm Passphrase

The passphrase that was used to encrypt the file containing the private key. If the
private key is not encrypted, leave this field blank.

Upload Certificate The certificate is uplpaded and the details are displayed on the Pass Certificate page.
See Viewing the Digital Pass Certificate.

Managing Digital Passes
Pass properties are defined in pass templates. These properties include name and a description, style (type of
pass), colors, summary, icon, logo, fields, relevant locations, relevant date, and associated apps.

To view or work with your list of digital pass templates, go to Configuration > Digital Passes > Pass
Templates. The Pass Templates list view opens.

Anexo 11 ITEM 01 (0592523)         SEI 0008478-63.2018.6.02.8000 / pg. 3303



Field Description

Edit Edit any of the template's properties.

Copy Make a copy of the template to use as a basis for a new template.

Reset to Defaults Resets the default template to its original settings if changes were made. (Only
available for the default template)

Delete Deletes the pass template. (The default Guest Receipt template cannot be deleted)

Create a new template Create a new template.

Creating and Editing a Digital Pass Template
To create or edit a digital pass template, go to Configuration > Digital Passes > Pass Templates, and then
click the Create a new template link in the upper right corner, or click the Edit link for a template in the list.
The Pass Template Settings form opens.

Defining Basic Properties

Field Description

Name Short name that identifies the template clearly. Digital pass template names can include
spaces. You may highlight this name and replace it with a new name.

Description Comments or notes about the template. This description is only seen by administrators.

Table 44: Basic Properties, Pass Template Settings
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Defining Pass Properties

For examples of variables that can be used in the Summary and Logo Text fields described in the following
table, click the Example 'template code' replacements link above the form, or see "Example Template Code
Variables" on page 282.

For a list of image fields supported by each of the different pass styles, click the A note regarding images
and icons link above the form, or see "Images in Digital Passes" on page 283.

Field Description

Background Color Color used for the background of both the front and back of the pass. To use the default
color, leave this field blank.

Foreground Color Color used for the "values" field on the front of the pass. To use the default foreground
color, leave this field blank.

Label Color Used for the labels of fields shown on the front of the pass. To use the default label color,
leave this field blank.

Summary

(Required) Short summary for the pass. This lets VoiceOver make the pass accessible to
blind and low-vision users.
Summary text typically contains standard template code that is evaluated when the pass is
generated. Template code entered here must produce a summary for the pass to be valid.

Pass Style

(Required) Style of pass to generate. Options include:
l Generic — a general purpose pass
l Boarding Pass (e.g., airline, boat, bus, train)
l Coupon (e.g., coupon, special offer, discount)
l Event Ticket (e.g., conference, sporting event, concert, movie)
l Store Card (e.g., loyalty, discount, points, gift)

Table 45: Pass Properties, Pass Template Settings
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Field Description

Icon Image

Icon shown on the lock screen and in notifications and emails where the pass is attached.
To use the default icon, leave this field blank.
The low-resolution version of the icon image should be 29 x 29 pixels.
If an "@2x" high-resolution version is available, it will also be added to the pass. The "@2x"
high-resolution version should be 58 x 58 pixels.

Logo Image

Logo shown at the top-left corner of the front of the pass. To use the default logo, leave this
field blank.
The low-resolution version of the logo image should be 50 x 50 pixels.
If an "@2x" high-resolution version is available, it will also be added to the pass. The "@2x"
high-resolution version should be 100 x 100 pixels.

Logo Text

Text shown next to the logo at the top of the pass. To have no text next to the logo, leave
this field blank.
Logo text typically contains standard template code that is evaluated when the pass is
generated.

Thumbnail Image

Image shown to the right of the primary field. To have no thumbnail image, leave this field
blank.
The thumbnail image is only shown on the Event Ticket or Generic pass styles.
If an "@2x" high-resolution version is available, it will also be added to the pass.

Transit Type
Transport type for a Boarding Pass style of pass. Options include Air, Boat, Bus, Generic,
or Train. The icon corresponding to the selected type of transit will be shown on the front of
the pass between the first two primary fields.

Footer Image
Image shown below all of the fields on the front of a Boarding Pass style of pass. To have
no footer image, leave this field blank.
If an "@2x" high-resolution version is available, it will also be added to the pass.

Strip Image

Image shown behind the primary field on the front of the pass. To have no strip image,
leave this field blank.
The strip image is only used on the Coupon, Event Ticket, or Store Card pass styles.
The low-resolution version of the strip image should be 312 x 84 pixels for Event Tickets,
and 312 x 123 for Store Card and Coupon pass styles.
If an "@2x" high-resolution version is available, it will also be added to the pass.The "@2x"
high-resolution version of the strip image should be double the width and height of the low-
resolution version for each pass style.

Background Image

Image shown as a background on the front of an Event Ticket. If a background image is
specified, any background color that was specified will be ignored. To have no background
image, leave this field blank.
The background image is only shown on the Event Ticket pass style.
If an "@2x" high-resolution version is available, it will also be added to the pass.
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Defining Pass Fields

Field Description

Fields List of fields currently included in this pass template, with descriptions. You can click a
field's row for configuration options.

Edit Opens the Field Properties editor, where you can enable the field and modify its
placement, content, and presentation properties.

Disable Disables the field for the pass. To enable it again, click its Enable link.

Move Up Fields are shown in this list in their rank order. You can use the Move Up and Move Down
links to modify the order.

Move Down

Delete Deletes a field from this pass template. You will be asked to confirm the deletion.

Add new field Click this link to add and configure a new field.

Table 46: Pass Fields, Pass Template Settings

Defining Relevant Locations

When a relevant location is configured and enabled, the pass can be displayed on the user's lock screen when
they arrive within a radius of the specified coordinates — for example, a Boarding Pass can be displayed when
the user arrives at a station or airport. The size of the location's radius is determined by the pass style.

Field Description

Relevant
Locations

If selected, shows the digital pass on the user's lock screen when near a given location.
Passbook determines the appropriate distance around the location for the pass to be
displayed on the lock screen.

Location Limit A pass template may only contain 10 locations. More may be added here, but only the first 10
valid locations will be included in the pass.

Table 47: Relevant Locations, Pass Template Settings
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Field Description

Locations (Required) Lists the locations that have been defined for this pass template.

Add new location Click this link to add and configure a new location.

Defining Relevant Dates

When a relevant date is configured and enabled, the pass can be displayed on the user's lock screen during an
appropriate window of time—for example, an Event Ticket pass would be displayed within the time window for
entry to the event. The length of the time window is determined by the pass style.

If the result of processing a ‘date’ field is a number, then that number will be interpreted as a UNIX timestamp
(i.e. the number of seconds since the UNIX epoch of 1st January 1970 00:00:00 GMT). A UNIX timestamp of 0
(zero) or less will be treated the same as an empty value.

If the result of processing a ‘date’ field is textual (i.e. not a number and not empty), then the text will be
converted to a valid date and time value. If conversion fails, or if the date is on or prior to the 1st January 1970
00:00:00 GMT (i.e. a UNIX timestamp of 0 or less), then the field will be treated as though it were empty.

If you set a relevant date for a Generic pass template, it must also include a relevant location.

For examples of variables that can be used in the Date field described in the following table, click the Example
'template code' replacements link above the form, or see "Example Template Code Variables" on page 282.

Field Description

Relevant Date

If selected, shows the digital pass on the user's lock screen when near a given date.
Passbook determines the appropriate span of time around the date for the pass to be
displayed on the lock screen.
You can also edit a date type field in the Pass Fields area of the form to be a relevant date.

Date and Location If the template is a Generic pass style, a relevant location must also be included in order for a
relevant date to take effect.

Date Mode

Options include:
l Optional — The pass can still be generated even if no value is supplied for the

date field
l Required — The pass will not be generated if the value for the date field is

empty

Date Rank
Rank order for processing the date field defined here. If multiple relevant date fields are
included in the template, they are processed in ascending order, and the first field that has a
valid date will be the relevant date for the pass.

Table 48: Relevant Dates, Pass Template Settings
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Field Description

Date
Text for the relevant date. For no value, leave this field empty.
Date text typically contains standard template code that is evaluated when the pass is
generated.

Date Fields

If the result of processing a date field is a number, the number is interpreted as a
UNIX timestamp.
If the result of processing a date field is textual (not a number and not empty), the text is
converted to a valid date and time value.

Defining Associated Apps

Multiple associated apps can be added. An Apple ID must be provided for each app. Although multiple
associated apps may be referenced by a pass, a link is displayed on the back of the pass only for the first app
that is compatible with the device. If the app is installed on the device, the link displayed on the pass opens the
app. If the app is not installed on the device, the link opens the App Store at that app.

Field Description

Associated Apps
If selected, shows an associated application on the back of the pass. Passbook
determines the appropriate distance around the location for the pass to be displayed on
the lock screen.

First Compatible
App

Multiple associate apps can be referenced by a pass, but only the first app that is
compatible with the current device will have a link shown on the back of the pass. If the
app is installed on the device, that link will open the app. If the app is not installed, the link
will open the app store and show the app.

Apps Lists the associated apps that are referenced by this pass template.

Add new app Click this link to add a reference to a new associated app to the pass template.

Table 49: Associated Apps, Pass Template Settings

When you have completed your entries on this page, click Save Changes. The new service is created and
displayed in the IP Phone Services list.

Example Template Code Variables
When you create or edit a digital pass template, many of the settings accept standard template code. This is the
same code that is supported for print templates. This allows you to specify either simple direct values or more
complex values based upon the evaluation of template code. All template code is evaluated when the pass is
generated from the pass template, using values from the guest receipt as inputs to the pass template.

The table below shows some of the special variables that can be used in the pass template fields that accept
template code. This variables list is also available when you go to Configuration > Digital Passes > Pass
Templates, click the Edit or Create link, and then click the Example 'template code' replacements link.
Variables are available for user fields and certificate fields.
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Images in Digital Passes
To make images available for selection, they must first be uploaded to the Public Files area in Content Manager.

The images supported by each style of pass are shown below. This images list is also available when you go to
Configuration > Digital Passes > Pass Templates, click the Edit or Create link, and then click the A note
regarding images and icons link.

Only PNG image files (*.png) are supported by passes.

A pass can contain both a low-resolution version (i.e. for non-Retina displays) and a high-resolution version (i.e.
for Retina displays) of each image. If it has been uploaded to the content manager, the high-resolution version
of an image is also automatically included in the pass. The high-resolution version must be named with the
suffix @2x at the end of the filename, just before the file extension—for example:

l Company_Logo.png (low-resolution filename)

l Company_Logo@2x.png (high-resolution filename)
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Email Receipts and SMTP Services

With SMTP Services, you can configure ClearPass Guest to send customized guest account receipts to visitors
and sponsors by email. Email receipts may be sent in plain text or HTML format. You may also send email
receipts using any of the installed skins to provide a look and feel.

To use the email sending features, you must have the SMTP Services Plugin installed.

This section includes:

l "About Email Receipts" on page 284

l "Configuring Email Receipts " on page 285

l "Email Receipt Options" on page 286

l "About Customizing SMTP Email Receipt Fields" on page 288

About Email Receipts

You can send email receipts for guest accounts that are created using either sponsored guest access or self-
provisioned guest access. This is convenient in situations where the visitor may not be physically present to
receive a printed receipt.

ClearPass Guest may be configured to automatically send email receipts to visitors, or to send receipts only on
demand. Email receipts may be sent manually from the guest account receipt page by clicking the Send
email receipt link displayed there.

When using guest self-registration, the email delivery options available for the receipt page actions allow you to
specify the email subject line, the print template and email format, and other fields relevant to email delivery.

To configure these email delivery options:

1. Go to Configuration > Pages > Guest Self-Registration. Click to expand the Guest Self-Registration
row in the form, and then click its Edit link. The Customize Guest Self-Registration diagram opens.

2. In the Receipt Page area, click the Actions link. The Receipt Actions form opens.

3. Scroll to the Email Delivery section of the form and choose one of the options from the Enabled drop-
down list. The form expands to include configuration options for email delivery.
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The following options are available in the Enabled drop-down list to control email delivery:

Field Description

Disable sending guest receipts by
email Email receipts are never sent for a guest registration.

Always auto-send guest receipts
by email

An email receipt is always generated using the selected options, and is
sent to the visitor’s email address.

Auto-send guest receipts by email
with a special field set

If the Auto-Send Field is set to a non-empty string or a non-zero value, an
email receipt is generated and sent to the visitor’s email address. The
auto-send field can be used to create an “opt-in” facility for guests. Use a
check box for the auto_send_sms field and add it to the create_user form,
or a guest self-registration instance, and SMS messages are sent to the
specified phone number only if the check box has been selected.

Display a link enabling a guest
receipt via email

A link is displayed on the receipt page; if the visitor clicks this link, an email
receipt is generated and sent to the visitor’s email address.

Send an email to a list of fixed
addresses

An email receipt is always generated using the selected options, and is
sent only to the list of email addresses specified in the “Copies To” field.

Table 50: Email Delivery Options, Customize Guest Self-Registration

Configuring Email Receipts

You can configure the default settings used when generating an email receipt by going to Configuration >
Receipts > Email Receipts.

See "Email Receipt Options" on page 286 for details about the email receipt options.
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Email Receipt Options
The Customize Email Receipt form may be used to set default options for visitor account email receipts. To
configure email receipt options, go to Configuration > Pages > Email Receipts. The Customize Email Receipt
form opens.

Figure 32 Customize Email Receipt page

Field Description

Subject Line

May contain template code, including references to guest account fields. The
default value, Visitor account receipt for {$email}, uses the value of
the email field. See "Smarty Template Syntax" on page 478 for more
information on template syntax.

Email Receipt Select the plain text or HTML template to use for the email receipt.

Skin

Specifies a skin to be used to provide the basic appearance of the email. You
may select from one of the installed skins, or use one of these special
options:
l No skin – Plain text only – A skin is not used, and the email will be sent

in plain text format. Use this option to remove all formatting from the
email.

l No skin – HTML only – A skin is not used, but the email will be sent in
HTML format. Use this option to provide a basic level of formatting in the
email.

l No skin – Native receipt format – A skin is not used. The email will be
sent in either plain text or HTML format, depending on the type of print
template that was selected.

l Use the default skin – The skin currently marked as the default skin is
used.

When sending an email message using HTML formatting, the images and
other resources required to display the page will be included in the message.

Copies To
Creates a list of additional email addresses that are designated to receive
copies of the generated email receipts. To have the email receipt sent to the
sponsor's email address, enter the keyword _admin in this field. In this case

Table 51: The Customize Email Receipt Form
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Field Description

the email receipt will be sent to the current operator.

Send Copies

Choose a value from the drop-down list to specify how copies of the email
receipts will be sent to the additional email addresses listed in the Copies To
field:
l Do not send copies – The Copies To list is ignored and email is not

copied.
l Always send using ‘cc:’ – The Copies To list is always sent a copy of any

guest account receipt (even if no guest account email address is
available).

l Always send using ‘bcc:’ – The Copies To list is always sent a blind copy
of any guest account receipt (even if no guest account email address is
available).

l Use ‘cc:’ if sending to a visitor – If a guest account email address is
available, the email addresses in the Copies To list will be copied.

l Use ‘bcc:’ if sending to a visitor – If a guest account email address is
available, the email addresses in the Copies To list will be blind copied.

Reply-To

To use the global From Address, do not mark the check box in the field. If you
want the Reply-To address to be overridden by the sponsor_email field of the
user, or by the admin's email, select the check box in this field. When you
select this check box, the Override From field is added to the form.

Override From Overrides the From Address instead of using the Reply-To value.

Email Field The field that will contain the visitor's email address.

Auto-Send Field
The field that will cause an account receipt email to be automatically sent
when a visitor account is created. The email receipt will only be sent if the
field selected here contains a non-empty string of non-zero value.

Test Mail Settings

To preview and verify the appearance of the email receipt, you can send
yourself or another person a test message.Enter the test message recipient’s
email address, then click Send Test Message. The test message is sent
immediately.
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Figure 33 Example of Email Receipt Test Message Content

About Customizing SMTP Email Receipt Fields
The behavior of email receipt operations can be customized with certain guest account fields. You do this on a
per-user basis.

Field Description

smtp_enabled

May be set to a non-zero value to enable sending an email receipt. If unset, the
default value from the email receipt configuration is used. The special values “_Auto”
(Always auto-send guest receipts by email), “_AutoField” (Auto-send guest receipts by
email with a special field set), “_Click” (Display a link enabling a guest receipt via
email), and “_Cc” (Send an email to a list of fixed addresses) may also be used.

smtp_subject
Specifies the subject line for the email message. Template variables appearing in the
value will be expanded. If the value is “default”, the default subject line from the email
receipt configuration is used.

smtp_template_id Specifies the print template ID to use for the email receipt. If blank or unset, the
default value from the email receipt configuration is used.

smtp_receipt_format

Specifies the email format to use for the receipt. It may be one of “plaintext” (No skin
– plain text only), “html_embedded” (No skin – HTML only), “receipt” (No skin – Native
receipt format), “default” (Use the default skin), or the plugin ID of a skin plugin to
specify that skin. If blank or unset, the default value from the email receipt
configuration is used.

smtp_email_field Specifies the name of the field that contains the visitor’s email address. If blank or
unset, the default value from the email receipt configuration is used. Additionally, the

Table 52: SMTP Email Receipt Fields
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Field Description

smtp_auto_send_field

Specifies the name of the field that contains the auto-send flag. If blank or unset, the
default value from the email receipt configuration is used. Additionally, the special
values “_Disabled” and “_Enabled” may be used to never send email or always send
email, respectively.

smtp_cc_list
Sspecifies a list of additional email addresses that will receive a copy of the visitor
account receipt. If the value is “default”, the default carbon-copy list from the email
receipt configuration is used.

smtp_cc_action
Specifies how to send copies of email receipts. It may be one of “never”, “always_cc”,
“always_bcc”, “conditional_cc”, or “conditional_bcc”. If blank or unset, the default value
from the email receipt configuration is used.

Logic for Sending Email Receipts

The logic used to send an email receipt is:

l If email receipts are disabled, take no action.

l Otherwise, check the auto-send field.

n If it is “_Disabled” then no receipt is sent.

n If it is “_Enabled” then continue processing.

n If it is any other value, assume the auto-send field is the name of another guest account field. Check the
value of that field, and if it is zero or the empty string then no receipt is sent.

l Determine the email recipients:

n Address the email to the value specified by the email field in the visitor account. If the email field is “_
None” then do not send an email directly to the visitor.

n Depending on the value of the Send Copies setting, add the email addresses from the Copies To: list to
the email’s “Cc:” or “Bcc:” list.

l If there are any “To:”, “Cc:” or “Bcc:” recipients, generate an email message using the specified print template
and send it to the specified recipient list.

l Additional options and considerations are described in the following table:

Field Description

smtp_warn_before_subject

This field overrides what is specified in the subject line under Logout
Warnings on the email receipt. If the value is “default”, the default
subject line under the Logout Warnings section on the email receipt
configuration is used.

smtp_warn_before_template_id

This fieldoverrides the print template ID specified under Logout
Warnings on the email receipt. If the value is “default”, the default
template ID under the Logout Warnings section on the email receipt
configuration is used.

smtp_warn_before_receipt_format

This field overrides the email format under Logout Warnings to use for
the receipt. It may be one of “plaintext” (No skin – plain text only),
“html_embedded” (No skin – HTML only), “receipt” (No skin – Native
receipt format), “default” (Use the default skin), or the plugin ID of a

Table 53: Logic for Email Receipts: Additional Options
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Field Description

smtp_warn_before_cc_list

This overrides the list of additional email addresses that receive a
copy of the visitor account receipt under Logout Warnings on the email
receipt.If the value is “default”, the default carbon-copy list under
Logout Warnings from the email receipt configuration is used.

smtp_warn_before_cc_action

This field overrides how copies are sent as indicated under Logout
Warnings on the email receipt. to send copies of email receipts. It may
be one of “never”, “always_cc”, “always_bcc”, “conditional_cc”, or
“conditional_bcc”. If blank or unset, the default value from the email
receipt configuration is used.

warn_before_from_sponsor

This field overrides the Reply To field (that is, the sponsor_email field
of a user, or the admin's email) under the Logout Warnings on the
email receipt. If the value is “default”, the Reply To field under Logout
Warnings from the email receipt configuration is used.

warn_before_from
This field overrides the Override From field under the Logout Warnings
on the email receipt. If the value is “default”, the Override From field
under Logout Warnings from the email receipt configuration is used.

Customizing SMS Receipt
To configure SMS receipt options, go to Configuration > Receipts > SMS Receipts. The Customize
SMS Receipt page opens.

The fields described below are for the SMS plugin configuration page. Use the SMS receipt page for further
customization. For information on standard SMS services, see "SMS Services" on page 296.

Figure 34 Customize SMS Receipt page

SMS Receipt Fields
The behavior of SMS receipt operations can be customized with certain guest account fields. You can override
global settings by setting these fields.

l sms_enabled – This field may be set to a non-zero value to enable sending an SMS receipt. If unset, the
default value is true.

l sms_handler_id – This field specifies the handler ID for the SMS service provider. If blank or unset, the
default value from the SMS plugin configuration is used.
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l sms_template_id – This field specifies the print template ID for the SMS receipt. If blank or unset, the
default value from the SMS plugin configuration is used.

l sms_phone_field – This field specifies the name of the field that contains the visitor’s phone number. If
blank or unset, the default value from the SMS plugin configuration is used.

l sms_auto_send_field – This field specifies the name of the field that contains the auto-send flag. If blank
or unset, the default value from the SMS plugin configuration is used. Additionally, the special values “_
Disabled” and “_Enabled” may be used to never send an SMS or always send an SMS, respectively.

The logic used to send an SMS receipt is:

l If SMS receipts are disabled, take no action.

l Otherwise, check the auto-send field.

n If it is “_Disabled” then no receipt is sent.

n If it is “_Enabled” then continue processing.

n If it is any other value, assume the auto-send field is the name of another guest account field. Check the
value of that field, and if it is zero or the empty string then no receipt is sent.

l Determine the phone number – if the phone number field is set and the value of this field is at least 7
characters in length, then use the value of this field as the phone number. Otherwise, if the value of the
auto-send field is at least 7 characters in length, then use the value of this field as the phone number.

l If the phone number is at least 7 characters long, generate a receipt using the specified plain-text print
template and send it to the specified phone number.

ClearPass Guest 3.9 and earlier used www.amigopod.com for a number of actions, including updates, SMS, and
network diagnostics. The address used now is clearpass.arubanetworks.com. If you have opened host-specific
openings in your firewall for the ClearPass appliance, please update them to the new name.

Customizing Print Templates
Print templates are used to define the format and appearance of a guest account receipt. To work with print
templates, go to Configuration > Receipts > Templates. The Guest Manager Print Templates list view
opens.

Click a print template’s row in the list to select it. The template’s row expands to include the Edit, Duplicate,
Delete, Preview, Show Usage, and Permissions options.

The Edit code action is displayed for a print template when it has been created using the wizard, but
subsequently modified. See "Modifying Wizard-Generated Templates" on page 294 in this chapter for further
information.

Options to show where a print template is being used, and to control individual permissions for a print
template, are also available when selecting a print template. See "Setting Print Template Permissions" on page
294.

ClearPass Guest 6.4 | User Guide Configuration | 291
Anexo 11 ITEM 01 (0592523)         SEI 0008478-63.2018.6.02.8000 / pg. 3318



292 | Configuration ClearPass Guest 6.4 | User Guide

Plain text print templates may be used with SMS services to send guest account receipts; see "About SMS
Guest Account Receipts " on page 304 for details. Because SMS has a 160 character limit, the number of
characters used in the plain text template will be displayed below the preview. If you are including a guest
account’s email address in the SMS, remember to allow for lengthy email addresses (up to 50 characters is a
useful rule of thumb).

Creating New Print Templates

To define a new print template, go to Configuration > Receipts > Templates and click the Create new
print template link in the upper-right corner. This opens a window with four parts.

The first part lists the variables that can be used in the template together with their meaning and an example of
each. User and certificate fields are available for print templates.

This section is followed by three other sections: the body, the header and the footer. Each section must be
written in HTML. There is provision in each section for the insertion of multiple content items such as logos.

You are able to add Smarty template functions and blocks to your code. These act as placeholders to be
substituted when the template is actually used.

Anexo 11 ITEM 01 (0592523)         SEI 0008478-63.2018.6.02.8000 / pg. 3319



See "Smarty Template Syntax" on page 478 for further information on Smarty template syntax.

You can use an {if} statement to define a single print template that caters to multiple situations. For example, if
you want to customize the print template to display different content depending on the action that has been
taken, the following code could be used:

{if $action == "create"}
<p>
Your guest account has been created and is now ready to use!
</p>
<ul>
{if $site_ssid}
<li>Connect to the wireless network named: <b>{$site_ssid}</b></li>
{/if}
<li>Make sure your network adapter is set to 'DHCP - Obtain an IP address Automatically'.<
/li>
<li>Open your Web browser.</li>
<li>Enter your username and password in the spaces provided.</li>
</ul>
{elseif $action == "edit"}
<p>
Your guest account has been updated.
</p>
{elseif $action == "delete"}
{/if}
<table {$table_class_content} width="500">
<tbody>
{if $u.guest_name}
<tr>
<th class="nwaLeft">guest name</th>
<td class="nwaBody">{$u.guest_name}</td>
</tr>
{/if}

If this code is placed in the User Account HTML section, it will cater to the create, edit, and delete options.

Print Template Wizard

The Create new print template using wizard link on the Configuration > Receipts > Templates page
provides a simplified way to create print templates by selecting a basic style and providing a logo image, title
and content text, and selecting the guest account fields to include.

A real-time preview allows changes made to the design to be viewed immediately.

To use the Print Template Wizard, first select a style of print template from the Style list. Small thumbnail
images are shown to indicate the basic layout of each style. There are four built-in styles:

l Table – Best for square or nearly square logo images, and well suited for use with “scratch card” guest
accounts.

l Simple – Best for wide or tall logo images and for situations where an operator will print a page with guest
account details.

l Centered – Best for wide logo images; less formal design.

l Label Printer – These print template styles are designed for small thermal printers in various widths. On-
screen assistance is provided when printing to ensure that a consistent result can be obtained.

Click the Preview at right or Preview at bottom link at the top of the page to move the real-time
preview of the print template.

Each of the basic styles provides support for a logo image, title area, subtitle area, notes area, and footer text.
These items can be customized by typing in an appropriate value in the Print Template Wizard.
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As the print template is a HTML template, it is possible to use HTML syntax as well as Smarty template code in these
areas. See the "Reference" on page 475 chapter for reference material about HTML and Smarty template code.

The print template may also contain visitor account fields. The value of each field is displayed in the print
template. By default, the wizard sets up the template with the username, password and role_name fields,
but these may be customized.

Options in the Fields row let you add, remove, or change the order of fields. Use the drop-down list to choose
the field name, then click the icon at the left of the drop-down list. The field’s row expands to include the
option links.

Use the Remove, Move Up, Move Down, Insert Before, and Insert After links to adjust the
fields that are to be included on the print template.

Click the Create Template button to save your newly created print template and return to the list.

Modifying Wizard-Generated Templates
After you create a print template using the print template wizard, you can return to the wizard to modify it.

Click the Edit print template code (Advanced) link to use the standard print template editor. See
"Creating New Print Templates" on page 292 for a description.

If you use the wizard to edit a print template after changes have been made to it outside the wizard, those outside
changes will be lost. This is indicated with the warning message "The print template code has been modified. Making
changes using the wizard will destroy any changes made outside of the wizard."

Setting Print Template Permissions

On the Configuration > Receipts > Templates list view, the Permissions link for a template can be used
to control access to an individual print template at the level of an operator profile. The Permissions link is only
displayed if the current operator has the Object Permissions privilege. This privilege is located in the
Administrator group of privileges.
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The permissions defined on this screen apply to the print template identified in the “Object” line.

The owner profile always has full access to the print template.

To control access to this print template by other entities, add or modify the entries in the “Access” list. To add
an entry to the list, or remove an entry from the list, click one of the icons in the row. A Delete icon and an

Add icon will then be displayed for that row.

Select one of the following entities in the Entity drop-down list:

l Operator Profiles – a specific operator profile may be selected. The corresponding permissions will
apply to all operators with that operator profile.

l Other Entities

n Authenticated operators – the permissions for all operators (other than the owner profile) may be
set using this item. Permissions for an individual operator profile will take precedence over this item.

n Guests – the permissions for guests may be set using this item.

The permissions for the selected entity can be set using the Permissions drop-down list:

n No access – the print template is not visible in the list, and cannot be used, edited, duplicated, or
deleted.

n Visible-only access – the print template is visible in the list, but cannot be edited, duplicated, or
deleted.

n Read-only access – the print template is visible in the list, and the settings for it may be viewed. The
print template cannot be edited or deleted.

n Update access – the print template is visible in the list, and may be edited. The print template cannot
be deleted and the permissions for the print template cannot be modified.

n Update and delete access – the print template is visible in the list, and may be edited or deleted.
The permissions for the print template cannot be modified.

n Full access (ownership) – the print template is visible in the list, and may be edited or deleted. The
permissions for the print template can be modified, if the operator has the Object Permissions privilege.
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SMS Services

With SMS Services, you can configure ClearPass Guest to send SMS messages to guests. You can use SMS to
send a customized guest account receipt to your guest’s mobile phone. You can also use SMS Services to send
an SMS from your Web browser. To use the SMS features, you must have the SMS Services plugin installed.

This section describes:

l "Viewing SMS Gateways" on page 296

l "Creating a New SMS Gateway" on page 297

l "Editing an SMS Gateway" on page 301

l "Sending an SMS " on page 303

l "About SMS Credits" on page 303

l "About SMS Guest Account Receipts " on page 304

l "SMS Receipt Options" on page 305

l "Working with the Mobile Carriers List" on page 305

ClearPass Guest 3.9 and earlier used www.amigopod.com for a number of actions, including updates, SMS, and
network diagnostics. The address used now is clearpass.arubanetworks.com. If you have host-specific openings in
your firewall for the ClearPass appliance, please update them to the new address.

Viewing SMS Gateways

To view the list of SMS gateways, go to Configuration > SMS Services > Gateways. The SMS Gateways list
displays the name and available credits for any currently defined SMS gateways. A ClearPass Guest SMS service
is automatically added when a subscription ID is configured in CPPM. You can also add one here.

l To work with a gateway, click its row in the list. The gateway’s row expands to include the Edit, Duplicate,
Delete, Make Default, and Send SMS options.

Field Description

Edit Lets you make changes to the gateway. See "Editing an SMS Gateway" on page 301.

Duplicate Lets you make a copy of the gateway to use as a base for a new gateway. A new gateway will be

Table 54: SMS Gateways List
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Field Description

added to the list with the name “Copy of <original gateway>”.

Delete Lets you remove the gateway from the list. You are asked to confirm the deletion. Click OK at the
prompt to delete the gateway.

Make Default Lets you make this gateway the default gateway for SMS messages.

Send SMS
Lets you send an SMS message via this gateway. The row expands to include the New SMS
Message form, where you can enter the recipient’s mobile phone number and the message text,
then send the message.

l To add a carrier to the list, click the Create a new SMS gateway link in the upper-right corner. The Create
SMS Gateway opens. See "Creating a New SMS Gateway" on page 297.

Creating a New SMS Gateway
An SMS gateway is automatically created and added to the SMS Gateways list when you enter your
subscription ID in ClearPass Policy Manager at Administration > Agents and Software Updates >
Software Updates. You can also use ClearPass Guest to create an SMS gateway.

To create a new SMS gateway through ClearPass Guest:

1. Go to Configuration > SMS Services > Gateways. The SMS Gateways list view opens.

2. Click the Create new SMS gateway link in the upper right corner. The SMS Gateway Configuration
form opens.

The first part of the SMS Gateway Configuration form includes the Service Settings options:
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Field Description

SMS Gateway

(Required) The SMS gateway service to use. Options in this drop-down list include:
l ClearPass Guest SMS Service
l Custom HTTP Handler
l SMS over SMTP
l External Providers
The options presented in the Service Settings area depend on the gateway selected here.

Display Name Name for this gateway service handler. The name entered here is the one that will be displayed
to operators using the system.

Carrier
Selection

Select how the carrier will be determined. Options in this list include:
l Registration form will have the visitor_carrier field—The visitor will supply the carrier

information when they register.
l Select a carrier—The form expands to include the Mobile Carrier field. Choose the carrier

from the Mobile Carrier drop-down list.
l Configure Carrier Settings—The form expands to include configuration options for the

carrier.

Mobile Carrier (Required) If you chose the Select a carrier option in the Carrier Selection field, you must
specify a carrier from this drop-down list.

SMS Address If a carrier was specified, indicate how the email address will be determined. Options are Use a
template to determine the email address, or Use a fixed email address.

Table 55: SMS Gateway Configuration -- Gateway and Service Settings Options
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Field Description

Address (Required) If a fixed email address was specified, enter the email address to which all SMS
messages will be sent.

Address
Template

(Required) If a template to determine the address was specified, enter an example address that
will be used as the pattern for the address format.

Number
Format

Choose a country code requirement option from this drop-down list. The available options are
Use the visitor’s value, Always include the country code, or Never include the country
code.

Country Code (Required) The carrier's country code.

Subject Line Text for the message’s subject line. This field supports Smarty template syntax. For a Smarty
template syntax description, See "Smarty Template Syntax" on page 478.

Service URL

(Required) The URL template to use when sending a message. Use the following items in the
template:
l @USERNAME@ – Service Username
l @PASSWORD@ – Service Password
l @API_ID@ – API ID
l @FROM@ – SMS Source Address
l @TO@ – Recipient
l @MESSAGE@ – Message
l @MESSAGE_ENC@ – Message that has already been URL encoded

Service
Method

(Required) If Custom HTTP Handler was selected in the SMS Gateway field, specify the HTTP
method to use—either GET or POST.

HTTP Headers
If the POST option was selected in the Service Method field for a custom HTTP handler gateway,
you can use this text field to override the HTTP header. For example:
Content-Type: text/xml

HTTP Post
(Required) If the POST option was selected in the Service Method field for a custom HTTP
handler gateway, you can use this text field to enter the text to post. See the service URL field for
available substitutions.

Authentication
Method

(Required) Specifies how the username and password will be passed to the gateway. Select
either Substituted parameters or HTTP Basic Authentication.

Service
Username

(Required) Your authorization username for your SMS service provider.
If you are using ClearPass Guest SMS Service and have entered your ClearPass subscription ID
in the Software Updates page of ClearPass Policy Manager’s Administration module, leave this
field blank. The subscription ID is automatically used as the username for the ClearPass SMS
Service.

Service
Password

(Required) Your password for your SMS service provider.
If you are using ClearPass Guest SMS Service and have entered your ClearPass subscription ID
in the Software Updates page of ClearPass Policy Manager’s Administration module, leave this
field blank. The subscription ID is automatically used as the password for the ClearPass SMS
Service.

Confirm
Password

API ID Optional API ID, if required by the SMS provider.

SSL Certificate Path of the uploaded SSL certificate (public/cert.pem). This must be in .pem format.

SSL
Passphrase Passphrase for the certificate specified in the SSL Certificate field. If there is no passphrase,
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Field Description

leave this field blank.Confirm
Passphrase

SMS Source
Address

Enter the originator address of sent SMS messages. Depending on the provider, this may be
either a phone number or a short string.

Message
Format

If needed for custom SMS handlers, you can select the check box to specify that the message
format should be converted to hex-encoded UTF-16 (Unicode).

The Mobile Number Settings area of the SMS Gateway Configuration form includes options for defining the
mobile phone number settings:

Field Description

Country
Code

Default country code to use for mobile telephone numbers that start with the national prefix. Most
SMS providers require that the number be sent with the country code.

Default
Length

If your country has a default length, enter it here. The country code entered in the previous field will be
automatically added if it is required. For example, North American numbers have a default length of 10,
and country code 1.

Auto
Plus
Length

If your SMS provider requires a "+" for international numbers, enter the minimum length for
international numbers. If a phone number is entered whose length is greater than or equal to this value,
the "+" will automatically be prepended.
For example, North American numbers have a default length of 10 and a country code of 1, so the Auto
Plus Length would be 11.

National
Prefix

If your country uses a national dialing prefix such as "0", you may enter it here. When sending an SMS
to a number that starts with the national dialing prefix, the prefix is removed and replaced with the
country code instead.

Table 56: SMS Gateway Configuration -- Mobile Number Settings Options

The lower part of the SMS Gateway Configuration form includes the Connection Settings, Debug, and Test
SMS Settings areas:
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Field Description

Connection
Timeout (Required) The connection timeout for this SMS service, in seconds.

HTTP
Timeout (Required) The timeout for the HTTP transfer to complete, in seconds.

Enable
Debug

To log detailed information in the application log for each stage of the HTTP transaction, select the
check box in this row.

Message (Required) To verify the configuration, enter a test message.

Recipient (Required) To verify the configuration, enter the test recipient's mobile phone number.

Send Test
Message

To verify the configuration, after you enter the test message and the test recipient's mobile number,
click this button. The test recipient should receive the message and confirm the results.

Table 57: SMS Gateway Configuration -- Connection Settings, Debug, and Test SMS Settings Options

Complete the fields with the appropriate information, then click Save and Close. The new configuration
settings will take effect immediately.

When you save your entries for the SMS over SMTP option, a new screen, Mobile Carriers, is added to the left
navigation. For more information, see "Working with the Mobile Carriers List" on page 305.

Editing an SMS Gateway
To edit an SMS gateway:

1. Go to Configuration > SMS Services > Gateways. The SMS Gateways list view opens.

2. Click the gateway’s row in the list, then click its Edit link. The Edit SMS Gateway form opens.
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3. The SMS Gateway field displays the gateway service that was selected when the gateway was created. This
cannot be edited after creation.

4. In the Service Settings area, you may edit the Display Name.

5. When you duplicate an SMS over SMTP gateway, the Carrier Selection configuration options are included. In
the Carrier Selection drop-down list, choose one of the following options:

l Registration form will have the visitor_carrier field—The visitor will supply the carrier information
when they register.

l Select a carrier—The form includes the Mobile Carrier field. Choose the carrier from the Mobile
Carrier drop-down list.

l Configure Carrier Settings—The form expands to include configuration options for the carrier:

n SMS Address—You may choose to use a template to determine the email address, or to use a fixed
address.

n Address Template or Address—If you chose to use a template to determine the address, the next
field is Address Template. Enter an example email address that will be used as the pattern for the
address format. If you chose to use a fixed email address, the next field is Address. Enter the email
address to which all messages will be sent.
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n Number Format—Choose a country code requirement option from this drop-down list. The
available options are Use the visitor’s value, Always include the country code, or Never
include the country code.

n Subject Line—You may enter text for the message’s subject line. This field supports Smarty
template syntax. For a Smarty template syntax description, See "Smarty Template Syntax" on page
478.

6. To log detailed information in the application log for each stage of the HTTP transaction, mark the check
box in the Enable Debug row.

7. To verify the configuration, enter a test message in the Message field and enter the test recipient’s mobile
phone number in the Recipient field, then click Send Test Message.

8. When all fields are completed appropriately, click Save and Close. The SMS Gateways list is updated with
the changes.

Sending an SMS

You are able to send an SMS message if the system has been configured to allow this.

To send an SMS message:

1. Go to Configuration > SMS Services > Send SMS. The New SMS Message form opens.

2. Complete the form by typing in the SMS message and entering the mobile phone number that you are
sending the SMS to. The maximum length for the message is 160 characters. If multiple services are
available, you may also choose the service to use when sending the message.

3. Click Send Message.

About SMS Credits
Most SMS providers use a system of credits when for sending messages. In ClearPass Guest SMS Services, one
credit is used for each sent message. The credit is used when the message is sent, regardless of whether the
recipient actually receives the message. Please review your provider’s details and pricing.

ClearPass Guest 6.4 | User Guide Configuration | 303
Anexo 11 ITEM 01 (0592523)         SEI 0008478-63.2018.6.02.8000 / pg. 3330



304 | Configuration ClearPass Guest 6.4 | User Guide

To determine the number of remaining SMS credits for a service, go to the Configuration > SMS Services >
Gateways list, and find the service's row in the list. The Credits Available column indicates the number of
remaining SMS credits for your account. This value is determined when the first message is sent, and is
updated after sending each message.

When credits are running low, a warning message is emailed to the administrator group. The email address is
determined by looking up all local operators with the special IT Administrators operator profile, and using any
configured email address for those operators.

Up to three messages will be sent:

l A low-credit warning is sent when the “Credits Available” value reaches the warning threshold (the default
value is 50).

l A second low-credit warning is sent when the “Credits Available” value reaches half the warning threshold.

l A final message is sent when the “Credits Available” value reaches zero.

To adjust the warning threshold, set the Credit Warning value in the configuration for the SMS Services Plugin.

About SMS Guest Account Receipts

You can send SMS receipts for guest accounts that are created using either sponsored guest access or self-
provisioned guest access. This is convenient in situations where the visitor may not be physically present to
receive a printed receipt.

ClearPass Guest may be configured to automatically send SMS receipts to visitors, or to send receipts only on
demand.

To manually send an SMS receipt:

1. Go to the Guest > Manage Accounts and click to expand the row of the guest to whom you want to send
a receipt.

2. Click Print to display the Updated Account Details view, and then click the Send SMS receipt link. The
SMS Receipt form opens. Use the fields on this form to enter the service to use, the recipient’s mobile
phone number, and the message text.
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When using guest self-registration, SMS Delivery options are available for the receipt page actions; See "Editing
Receipt Actions" on page 248 for full details. For more information on SMS services, see "SMS Services" on page
296.

SMS Receipt Options

SMS receipt configuration options are available in the Customization module (see "Customizing SMS Receipt"
on page 290). Advanced configuration options for the SMS Services, including receipt options, are also available
in the plugin configuration (see "Configuring Plugins" on page 444 in this chapter).

Working with the Mobile Carriers List

If you have included SMS over SMTP gateways in your SMS gateways list, you can manage the list of SMTP
carriers that are included in the Mobile Carrier drop-down list on the Configuration > SMS Services >
Gateways > Edit SMS Gateway form.

To view or work with the Mobile Carriers list:

1. Go to Administration > SMS Services > Mobile Carriers. The Mobile Carrier List view opens. The
carriers in this list are the ones that are included in the Mobile Carrier drop-down list on the SMS Services >
SMS Gateways > Edit SMS Gateway form.

2. To filter the list, click the Display Lists tab above the form. The form expands to include the Carrier Lists
options. Use this drop-down list to specify the visitor carrier or MMS carrier.

To be available in the drop-down lists on this Carrier Lists form, a carrier must first be enabled.
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3. To enable, disable, or delete a carrier, click the carrier in the list. The carrier’s row expands to include the Edit,
Enable or Disable, and Delete options.

l To enable a carrier, click the Enable link in its row, then refresh the screen. The carrier will then be
available to work with and will be included in the drop-down lists when you click the Display Lists link.

4. The procedures for adding and for editing a carrier are the same.

l To add a carrier to the list, click the Create tab above the form. The Mobile Carrier Editor form is added
at the top of the list.

l To edit an existing carrier, click the carrier’s row in the list, then click its Edit link. The row expands to
include the Mobile Carrier Editor form for that carrier.

l When creating or editing a gateway, to include the Mobile Carrier field in the visitor’s registration form,
choose Registration form will have the visitor_carrier field in the Carrier Selection drop-down
list. The Mobile Carrier field is also added to the Test SMS Settings area of the forms.

5. In the Name field, enter the carrier’s name. If there is more than one format of the carrier company’s name,
use the format the public most readily identifies with the carrier service.

6. To include the carrier in the list of choices for users, mark the Enable check box.

7. (Optional) In the Country field, enter the country where the carrier’s service is offered. If appropriate, you
may also indicate an area within the country, such as a city, county, or state.

8. In the SMS Address drop-down list, choose one of the following options:

l Use a template to determine the email address— When this option is chosen, the next field’s
name becomes SMS Template.

l Use a fixed email address—Use this option if all SMS messages are to be sent to the same address.
When this option is chosen, the next field’s name becomes Address.

9. Configure the option you chose in the previous step:

l If you chose Use a template... in the SMS Address field, enter an example email address in the SMS
Template field. This provides the pattern for the address format.
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n The default is to substitute the number for all characters preceding the @ sign, producing the pattern
number@address.

n Some carriers require additional characters before or after the phone number. In this case, use the
keyword string NUMBER in the pattern to limit the substitution to just the phone number portion of
the address—for example, NUMBER.msg@carrier.example.com, or
username+NUMBER@mymail.com

l If you chose Use a fixed email address n the SMS Template field, use the Address field to enter the
email address to which all SMS messages will be sent.

10.In the MMS row:

l To use the SMS template for MMS messages, mark the check box in this row. The SMS Address
configuration will be applied to MMS messages, and the MMS Template row is removed from the form.

l To use an MMS template for MMS messages, leave this check box unmarked.

11.If you will use an MMS template for MMS messages, enter an example email address in the MMS Template
field. This provides the pattern for the address format.

12.In the Number Format row, choose a country code requirement option from the drop-down list. The
available options are Use the visitor’s value, Always include the country code, or Never include
the country code.

13.(Optional) In the Subject Line field, you may enter text for the message’s subject line. This field supports
Smarty template syntax, and the number is available as {$number}.

For example:

Sent to: {$number} in the year {‘Y’|date}

...would produce:

Sent to: 15555551234 in the year 2012

For a Smarty template syntax description, See "Smarty Template Syntax" on page 478.

14.When all fields are completed appropriately, click Save Changes. The Mobile Carrier List is updated with the
changes.

About Translations

Translation services let you configure the language that will be displayed to guests in the ClearPass Guest
interface. You can set a default language, enable auto-detection based on the user's browser settings, enable
various language packs, and allow the user to select the language. Language packs are editable, letting you
customize label and message text and numerous other settings. You can use the Plugin Manager to enable the
translation assistant features, and to configure ClearPass Guest's language settings for your own use.

l To view and manage your list of enabled translation packs, see "Translation Packs" on page 308.

l To edit basic information for a translation pack, see "Creating and Editing Translation Packs" on page 308.

l To set the default language, show IDs for labels and messages, and provide a language selector on each
page of the user interface, see "Translation Assistant" on page 310.

l To customize a translation pack's labels and messages, see "Customizing Translated User Interface Text" on
page 311.
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l To view the Translation Plugin settings, see "Configuring the Translations Plugin" on page 449 in the
Administration module.

Translation Packs
To work with individual translation packs, go to Configuration > Translations > Translation Packs. The
Language Packs list view opens.

All translation packs that have been enabled are included in the list. You can click a translation pack's row in the
list for additional options:

Field Desription

Edit
Enable or disable the translation pack and edit its name, display name, language
code, flag image, and list of locale identifiers. For more information, see "Creating
and Editing Translation Packs" on page 308.

Override Translations Specify and edit the translated wording of the application's labels and messages. For
more information, see "Customizing Translated User Interface Text" on page 311.

Export

Lets you download your customized translations to a file and send them to your
ClearPass Support team. Your feedback helps us enhance the default translations. In
the form that opens when you click Export, enter support@arubanetworks.com in
the recipients field. This form is only available if you have created customized
translations.

Duplicate
Create a new translation pack. You can give the copy of the translation pack a new
name, enable it, and edit its display name, language code, flag image, and locales
list. For more information, see "Creating and Editing Translation Packs" on page 308.

Use Applies this language pack. Labels in ClearPass Guest are displayed in the language.
To revert, click the Use link for a different language in the list.

Make Default Use a translation pack as the new default language for the application. You can also
reset the default language from the Translation Assistant form.

Table 58: Translation Packs List View Options

Creating and Editing Translation Packs
To create or edit a translation pack:

Go to Configuration > Translations > Translation Packs, then click the Edit or Duplicate link for a
translation pack in the list. The Edit Translation Pack or Create Translation Pack form opens.
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Field Description

Parent Name of the translation pack you used as a basis. This field only appears if you are duplicating a
translation pack,

Name Name of this translation pack. This identifying name is different from the display name, and is only
seen by application administrators.

Enabled
You can select the check box to enable this translation pack, or leave it unselected to create the
translation pack but not enable it yet. Each language code can have only one corresponding
translation pack enabled at a time.

Display
Name Name to display in the language selection options in the user interface.

Language
Code

The unique ISO 639-1 language code that corresponds to this translation pack. Only one translation
pack at a time can be enabled for each language code.

Flag

Filename of the flag image to use for this translation pack. Image files should have been previously
uploaded to the Content Manager.
In the user interface's language selection options, a small image of a flag is shown next to each
language.

Locales Enter a comma-delimited list of locale identifiers for this language pack. Locale identifiers let you
customize translation packs for regional differences.

Save
Changes Saves your changes and returns you to the Translations Pack list view.

Table 59: Translation Pack Configuration
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Translation Assistant
To configure some basic user assistance features for the user interface's language settings, go to
Configuration > Translations > Translation Assistant. The Translation Assistant form opens.

Field Description

Default Language Sets the default language pack for the user's application.

Auto-Detection
If selected, disables automatic browser-based language detection and enforces the
default translation pack instead. The default behavior is to use the language the user's
browser has detected as preferred, instead of using the default translation pack.

Text IDs

If selected, the text IDs are displayed on all headings and field names in the ClearPass
Guest user interface, and an Override all translations generated for this page link is
displayed at the bottom of each page. Displaying the text IDs lets translators easily
identify the fields on each page in order to customize translations. For more information,
see "Customizing Translated User Interface Text" on page 311.

Language Selector
If selected, provides language selection options on each page of the user interface. A row
of language links with flags is displayed at the bottom of each page. If this check box is
not selected, the language selection options are only displayed on the login page.

Save Changes Saves your changes on this form.

Table 60: Translation Assistant Configuration
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Customizing Translated User Interface Text
You can override the default translations provided for labels and messages in the user interface, customizing
these items in each translation pack.

To customize label and message text for a translation pack, do one of the following:

l Go to Configuration > Translations > Translation Packs, and then click the Override Translations
link for a translation pack in the list. The Edit Translations form opens. Text IDs for any items that already
have custom overrides are listed in the Translations area of the form. To edit a different field, you can
enter its text ID and refresh the form. A row will be added for the field.

l Go to Configuration > Translations > Translation Assistant. Select the language, select the check box
in the Text IDs field, and save your changes. Text IDs are shown with every label, and an Override all
translations generated for this page link is now displayed at the bottom of every page in ClearPass
Guest. To customize translations for a certain page or group of pages, go to the page you want to translate
and click its Override all translations generated for this page link. The Edit Translations form opens.
Text IDs for that page and the set of pages it belongs to (for example, all pages related to Web Logins) are
listed in the Translations area of the form. The form includes a row for each text ID, where you can provide
a custom translation.
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Field Description

Name

These fields show the information for this translation pack and cannot be edited on this form.

Display Name

Language
Code

Locales

Enabled
If selected, enables this translation pack. If this translation pack should not be enabled at this
time, leave this check box unselected. Each language code can have only one corresponding
translation pack enabled at a time.

Text IDs

List of text IDs for labels and messages in the ClearPass Guest user interface.
l If you accessed this form from the Overide Translations link on the Translation Packs list

view, this field is empty. If you know the text IDs of fields you want to edit, enter them here,
separated by commas, and then click Refresh. To view or edit just the items that already have
custom overrides, you can leave this field blank.

l If you accessed this form from the Override all translations generated for this page link at
the bottom of any page in ClearPass Guest, this field contains a list of all the text IDs for that
page and related pages and messages.

Common IDs
Each link in this field corresponds to a group of related pages and messages. Click a link to
display the text IDs for all labels and messages in that group. The text IDs are listed in the Text
IDs field, and a row is added to the form for each text ID.

(text ID
numbers)

These rows appear if text IDs were specified in the Text IDs field. The default text for the field is
shown below the text box. For each item you want to override, enter the new text in the text box.

Refresh If you entered items in the Text IDs field, click this button to add their rows to the form so you can
edit them.

Save and
Reload Saves your changes and reloads this form.

Save Changes Saves your changes and returns to the Translation Packs list view.

Table 61: The Translation Pack Configuration Form
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Advertising Services

Advertising Services lets you deliver marketing promotions and advertisements to your users on a variety of
Guest Management registration, receipt, and login pages.

To work with ClearPass Guest Advertising Services, go to Configuration > Advertising > Start Here.

This section includes:

l "About Advertising Services" on page 313

l "About the Tutorial" on page 314

l "Advertising Pages" on page 315

l "Advertising Spaces" on page 323

l "Advertising Campaigns" on page 328

l "Advertising Promotions" on page 332

l "Advertising Materials" on page 337

About Advertising Services
This section describes the main elements you work with to configure Advertising Services to deliver marketing
promotions and advertisements through ClearPass Guest: materials, promotions, campaigns, spaces, and
pages.

Materials
A material is the individual advertisement you deliver — the ad the user sees. You can deliver ads through Web
browsers, email, and SMS. The "type" of an advertising material can be a text, image, Flash, raw HTML, YouTube,
or SMS text advertisement. Materials can also be assigned any number of labels, which can be used by
promotions to create labeled promotions and to provide intelligent delivery.

Promotions
Most of the rules for how and when advertisements are delivered and what materials should be included are
defined in a promotion. These rules are applied to all of the advertising materials that the promotion includes,
whether those materials are included directly or indirectly.

A promotion can include both materials and/or other promotions. You can use this feature to build simple groupings of
materials with simple rules or more complex groupings of materials and promotions with more complex rules.

Promotions can be enabled and disabled, and have a start date and an end date. They can also be assigned any
number of labels. Promotions can include materials and/or other promotions using a fixed, rotating, weighted,
or labeled content selection type.

Promotions can also be configured to use intelligent delivery, which uses labels to match relevant advertising to
users.
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Materials and promotions are then organized into advertising campaigns that run over a specified date range
and with a specified priority (rank and weight).

Campaigns
An advertising campaign is the strategy by which you organize the presentation of your ads. It defines which
promotions and materials to deliver, and when they should be delivered. You can rank and weight a campaign
to balance it against other campaigns. A campaign can also be configured for presentation between a specified
start date and end date.

Spaces
Spaces are the areas of a page that are defined for advertising content. Spaces use simple rules to select
advertisements with the appropriate size, number, and format of materials. The space determines what types
of materials can be shown (images, text ads, SMS ads) and, in the case of images, any size constraints on the
size of the ad. For example, size constraints on a ‘top’ space would normally ensure that only wide but short
images are displayed, whereas the constraints on a ‘right’ space would often allow any type of ad but require
that the ad be narrower (e.g. 320 pixels wide).

Pages
Finally, for each ClearPass Guest page or group of pages, you can specify the advertising spaces you want to
make active and the campaigns and materials to present on them. Advertising can be placed on login,
registration, receipt, and self-service pages, and email and SMS receipts.

Advertising Services Process Overview
To use advertising services:

1. Add fields for gathering demographic information to Guest self-registration forms.

2. Create the materials and upload them to ClearPass Guest.

3. Create a promotion.

4. Create a campaign.

5. Enable at least one space.

6. For each page or group of pages, specify which campaigns and spaces can be presented.

7. Fine-tune campaign delivery to ensure the best user experience.

About the Tutorial
ClearPass Guest provides a Getting Started tutorial to help you become familiar with Advertising Services
concepts and procedures. You can refer to the tutorial at any time.

To view the tutorial, go to Configuration > Advertising > Start Here and click the Getting Started link. The
first page of the tutorial window opens.
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Topics in the tutorial cover how to create materials, promotions, and campaigns and configure spaces. You can
view the finished product of the practice exercises. Tips are provided on how to troubleshoot the different
stages of the process.

Navigating the Tutorial

To: Do This:

Move through the
tutorial sequentially Click the Continue link in the bottom right corner next to the count of completed tasks.

Move one page
forward or
backward

Use the right and left arrows in the top left corner.

Jump to any section
of the tutorial Use the navigation links on the right side.

See additional
navigation options

Click the More Options link in the upper right corner. The navigation menu expands to
include the Getting Started, Restart Tutorial, and Quit Tutorial links.

Go back to the
beginning

Click the More Options link in the upper right corner, and then click the Restart Tutorial
link. You will be asked to confirm, and are returned to the Getting Started page.

Exit the tutorial at
any time Click the More Options link in the upper right corner, and then click the Quit Tutorial link.

Table 62: Tutorial Navigation Elements

After you open the tutorial window, it remains open on your screen as you navigate through the application.
This lets you refer to it and to related areas of the application at the same time. To close the tutorial window,
click the Quit Tutorial link.

Advertising Pages

The Advertising Pages form lists the Guest Manager areas whose pages can be used for advertising, and
provides access to advertising configuration for them. In ClearPass Guest, these pages include login,
registration, receipt and self-service pages, and email and SMS receipts.

To work with the advertising settings for a Guest Manager page group or page, go to Configuration >
Advertising > Pages. The Edit Page list view opens.
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Columns show the page group, the type of page, and the number of child pages in that group. For example, the
Guest Management page group has four child pages and the Guest Self-Registration page group has eight child
pages, as shown in the following table.

Page Group Child Pages

Guest Management

Web Receipts
Download Receipt
Email Receipts
SMS Receipts

Guest Self-Registration

Registration Page
Receipt Page
Receipt Download
Receipt Email
Login Page
Login Message
Receipt SMS
Self-Service :Portal

Table 63: Page Groups and Child Pages

You can click a page group in the Advertising Pages list for additional options:

Field Description

Edit Edit the advertising settings for any of the pages in the Guest Management or Self-Registration page
groups. See "Editing Advertising Pages" on page 316.

Go To
Opens the corresponding area of the ClearPass Guest application:
For Guest Management, opens the Start page of the Guest Manager module.
For Guest Self-Registration, opens the Customize Guest Registration edit diagram.

Launch For Guest Self-Registration, opens the visitor self-registration login page in a new tab.

Table 64: Advertising Pages List

Editing Advertising Pages
In ClearPass Guest, advertising can be placed on registration pages, receipt and self-service pages, and email
and SMS receipts. For each of these pages, you can specify whether or not advertising will be delivered, the
advertising spaces that will be used, and the campaigns to present on the page. These settings can be applied
to all pages in a page group, or can be overridden for single pages in the group.

To edit advertising settings for a page group or page, go to Configuration > Advertising > Pages, then click
the Edit link for a page group. The Edit Page form opens.
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In the General Properties area of the form, select either the page group or page and configure the basic
properties.

If you leave the Edit Page form set to the parent page, your edits will apply to the parent page of the group and to all
the child pages in the group. To override these settings for a child page, you must click Show Children, and then
click the Page advertising settings link for the child page.

Field Description

Page

The page group being edited. The page group name is a link to the corresponding area of the
application:
l The Guest Management link opens the Start page of the Guest Manager module.
l The Guest Self-Registration link opens the Customize Guest Registration edit diagram.

Parent
Page

Indicates the page's parent page, if there is one. This field only contains links when you are editing a
child page.
l Click Launch page to open the parent page.
l Click Page advertising settings to configure advertising for the parent page.

Child
Pages

Indicates the page's child pages, if there are any. This field only contains links when you are editing a
parent page.
l Click Show Children to display the list of child pages.
l You can click a child page's name to go to the Customize Guest Registration form for that child

page.
l To configure advertising services for a specific child page, click the Page advertising settings

link for the child page.

Advertising
Enabled

Specifies whether the page is enabled or disabled for advertising.
l Use default setting (Enable advertising on this page)—Enables advertising on this page and

on its child pages. Available for page group only.
l Use parent setting—Ensures that advertising on this child page is only enabled if advertising is

enabled for the parent page. Available for child pages only. Default setting for a child page.
l Disable advertising on this page—Disables advertising on this page. If this is a parent page,

disables advertising for all child pages that are configured to "Use parent setting".
l Enable advertising on this page—Enables advertising on this page. If this is a parent page,

enables advertising for all child pages that are configured to "Use parent setting".

Description Optional comments or notes about the page.

Table 65: General Properties, Edit Page
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In the Space Options area of the form, set the options that control which advertising spaces can be shown on
this page. The final set of advertising spaces that is used is determined by first applying the Allowed Spaces
policy, and then applying the Denied Spaces policy.

Field Description

Allowed Spaces Policy

Specifies which spaces to use. Options include:
l Use default setting (Allow advertising in all spaces)—Allows advertising in all

enabled and applicable advertising spaces. Available for page group only.
l Allow advertising in...—The form expands to include the Allowed Spaces row.

Available for page group only.
l Use parent spaces—Allows advertising in the list of spaces defined by the parent

page's space options (determined by applying the Allowed Spaces Policy followed by
the Denied Spaces Policy). Available for child pages only.

l Use parent spaces, but also allow advertising in...—The form expands to include
the Allowed Spaces row. Additional spaces you select are added to the list of spaces
defined by the parent page's space options (determined by applying the Allowed
Spaces Policy followed by the Denied Spaces Policy). Available for child pages only.

l Allow advertising in all spaces—Allows advertising in all enabled and applicable
spaces.

The Denied Spaces Policy is applied after this field, so the final list of spaces that is used
might be less than what is allowed here.

Allowed Spaces

If Use parent spaces, but also allow advertising in is selected in the Allowed Spaces
Policy, use the controls in this field to add and sort spaces. Any advertising space you
specify in this field will be added to the list of spaces used to deliver advertisements. (To
be displayed, spaces must also be enabled)
Suggestion: You can use this field at the page group level to specify a small number of
allowed spaces, and then at the child page level to add extra spaces as needed,

Denied Spaces Policy

Specifies whether to deny advertising in any spaces. Options include:
l No change—Leaves the list of spaces allowed by the Allowed Spaces Policy

unchanged.
l Deny advertising in...—The form expands to include the Denied Spaces row.
l Deny advertising in all spaces—Denies advertising in all spaces for this page.

Denied Spaces

If Deny advertising in... is selected, use the controls in this field to specify the denied
spaces.
Suggestion: You can also use this field to specify an exception to an "Allow advertising
in all spaces" setting.

Preview Displays a preview of the form showing your changes. To review the chosen set of
advertising spaces, click the Save and Reload button and then expand this Preview list.

Table 66: Space Options, Edit Page
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In the Campaign Options area of the form, set the options that control which campaigns can deliver
advertising on this page. The final set of advertising campaigns that is used is determined by first applying the
Allowed Campaigns Policy, and then applying the Denied Campaigns Policy.

Field Description

Allowed Campaigns Policy

Specifies which campaigns to use. Options include:
l Use default setting (Allow advertising from all campaigns)—Allows

advertising from all enabled and applicable campaigns. Available for page
group only.

l Allow advertising from...—The form expands to include the Allowed Campaigns
row. Available for page group only.

l Allow advertising from all campaigns—Allows advertising from all enabled
and applicable advertising campaigns.

l Use parent campaigns—Allows advertising from the list of campaigns defined
by the parent page's campaign options (determined by applying the Allowed
Campaigns Policy followed by the Denied Campaigns Policy). Available for child
pages only.

l Use parent campaigns, but also allow advertising from...—The form
expands to include the Allowed Campaigns row. Additional campaigns you
select are added to the list of campaigns defined by the parent page's campaign
options (determined by applying the Allowed Campaigns Policy followed by the
Denied Campaigns Policy). Available for child pages only.

The Denied Campaigns Policy is applied after this field, so the final list of campaigns
that is used might be less than what is allowed here.

Allowed Campaigns

If Use parent campaigns, but also allow advertising from... is selected, use the
controls in this field to add and sort campaigns. (To display ads, campaigns must
also be enabled)
Suggestion: You can use this field at the page group level to specify a small number
of allowed campaigns, and then at the child page level to add extra campaigns as
needed,

Denied Campaigns Policy

Specifies whether to deny advertising in any campaigns. Options include:
l No change—Leaves the list of campaigns allowed by the Allowed Campaigns

Policy unchanged.
l Deny advertising from...—The form expands to include the Denied Campaigns

Table 67: Campaign Options, Edit Page
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Field Description

row.
l Deny advertising from all campaigns—Denies advertising from all campaigns

for this page.
Suggestion: You can also use this field to specify an exception to an "Allow
advertising from all campaigns" setting.

Denied Campaigns If Deny advertising from... is selected, use the controls in this field to specify the
denied campaigns.

Preview
Displays a preview of the form showing your changes. To review the chosen set of
advertising campaigns, click the Save and Reload button and then expand this
Preview list.

The nwa_adspace Smarty Template Tag
For details about Smarty Template syntax and HTML, see "Smarty Template Syntax" on page 478 of the
Reference chapter.

The nwa_adspace Smarty Template tag is for advanced users. You need to understand HTML and Smarty
Templates in order to use it correctly.

The nwa_adspace tag can be placed into HTML fields that:

l Support Smarty Template evaluation

l Belong to pages that support advertising

The nwa_adspace tag supports the following parameters:

l location

l name

l media

l stage

l container

l style

location

The value of the Location field that must be set for an advertising space to be matched by location. The
Location field and the Other Location field are configured on the Edit Space form (see "Creating and Editing
Advertising Spaces" on page 324).

You must specify either a location or a name. The nwa_adspace tag will give an error if you do not specify at least
one of these parameters.

if a location parameter is specified, then the value of the location parameter will be compared to the
Location field of each advertising space. If the values match, then advertisements will be delivered at the point
in the HTML where the nwa_adspace tag is defined, and according to any constraints defined by the advertising
space.
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To see which Location value a space uses, review the Location column in the Advertising Spaces list
view ("Advertising Spaces" on page 323).

Advertising spaces support a number of preset Location options as well as custom locations via the Other
Location field. The following parameters are supported for the location parameter:

Value Description

N/A None—for manually-positioned spaces

web_top Page Top—above content

web_left Page Left—to the left of content

web_bottom Page Bottom—below content

web_right Page Right—to the right of content

web_interstitial Page Interstitial—briefly replaces content

sms_top SMS Top—above content

sms_bottom SMS Bottom—below content

Use Other Location Other—for user-defined locations

Table 68: Values for the location Parameter

name

The value of the Name field that must be set for an advertising space to be matched by name.

You must specify either a location or a name. The nwa_adspace tag will give an error if you do not specify at least
one of these parameters.

if a name parameter is specified, then the value of the name parameter will be compared to the Name field of
each advertising space. If the values match, then advertisements will be delivered at the point in the HTML
where the nwa_adspace tag is defined, and according to any constraints defined by the advertising space.

media

The type of media that advertisements are being delivered to.

You must specify a media value. The nwa_adspace tag will give an error if you do not specify this parameter.

The media parameter must be set correctly for the context in which the nwa_adspace tag will be processed. The
following values are supported for the media parameter:
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Value Description

sms Specify this value to deliver SMS advertisements only.

web Specify this value to deliver Web and Email
advertisements only.

Table 69: Values for the media Parameter

stage

The value of the Stage field that must be set for an advertising campaign to be matched.

You must specify a stage value. The nwa_adspace tag will be unable to match any advertising campaigns if you do
not specify this parameter.

The stage parameter is used when processing advertising campaigns. Only the promotions or materials
specified at the corresponding stage of the advertising campaign will be delivered. The following values are
supported for the stage parameter:

Value Description

web_login Specify this value to deliver advertising on a login page
(landing page).

web_registration Specify this value to deliver advertising on a guest self-
registration page.

web_receipt Specify this value to deliver advertising on a receipt
page.

web_self_service Specify this value to deliver advertising on a guest self-
service page.

web_after_login Specify this value to deliver advertising on a login
message page (post-login page).

sms_receipt Specify this value to deliver advertising on an SMS
receipt.

Table 70: Values for the stage Parameter

container

The name of the HTML element tag in which advertisements will be placed.

The nwa_adspace Smarty Template tag is for advanced users. You need to understand HTML and Smarty
Templates in order to use it correctly.

When advertisements are to be delivered to a Web page or an email, they can be grouped and their layout
controlled more effectively by placing them in a container. Typically, a DIV container would be used, but other
valid HTML tags can be specified.

If the container parameter is not specified, then advertisements are delivered to the Web page or email without
any extra grouping.
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style

The style attribute of the HTML container element.

This parameter is only relevant when the media parameter is set to web and an HTML tag name has been
specified for the container parameter.

If you specify a container, you can use the style parameter to specify style attributes for the container. The
style parameter is optional.

Advertising Spaces

Spaces are the areas of a page that are defined for advertising content. The Advertising Spaces list shows and
describes the spaces that are currently defined on each type of page, differentiated by device. Descriptions
include typical uses of the space. Several built-in spaces are available. You can also create new custom
advertising spaces.

To work with the settings for advertising spaces, go to Configuration > Advertising > Spaces. The
Advertising Spaces list view opens.

All advertising spaces that have been created are included in this list. You can click a space's row in the list for
additional options.

Field Description

Edit Edit any of the space's properties. See "Creating and Editing Advertising
Spaces" on page 324.

Delete Deletes a custom space. You will be asked to confirm the deletion. Not available

Table 71: Advertising Spaces List
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Field Description

for built-in spaces.

Enable
Enable the space so advertising will be displayed in it.
Before advertising will be delivered in an enabled space on a specific page, the
page's settings also need to allow advertising in the space.

Disable To make advertising inactive again for an enabled space, click the Disable link.

Copy

Make a copy of the space configuration to use as a basis for a new
configuration.
Suggestion: If you want to have multiple advertising spaces in the same
location—for example, one for images and one just for text—creating a copy of
a space and making slight changes to it might be the simplest way.

Create new advertising space Create a new custom advertising space.

Creating and Editing Advertising Spaces
Spaces define the areas of a page that can display advertising content. Spaces use simple rules to select
advertisements with the appropriate size, number, and format of materials. The space determines what types
of materials can be shown (images, text ads, SMS ads) and, in the case of images, any size constraints on the
size of the ad. For example, size constraints on a ‘top’ space would normally ensure that only wide but short
images are displayed, whereas the constraints on a ‘right’ space would often allow any type of ad but require
that the ad be narrower (e.g. 320 pixels wide).

Each space is configured to deliver advertisements in a particular location on a page, such as the top, bottom,
left, or right. There is also what is called an "interstitial location": Instead of being displayed in an area of a page,
interstitial ads replace the main content of a page for a brief time. For example, after a user logs in, an
interstitial ad might be displayed for a moment before the main page content is displayed.

Each space is also given a rank. A rank of 1 is given higher preference than a rank of 2. The relative ranks you
assign to spaces ensure they are displayed in the order you want. For example, if you have two spaces defined
to be in the same location, the space you give a rank of 1 will be placed above the space that has a rank of 2.

The built-in advertising spaces are created automatically by the Advertising Services plugin. Most properties of
a built-in space can be edited. You can also create new custom advertising spaces.

l To edit advertising settings for either a built-in or custom space, go to Configuration > Advertising >
Spaces, then click the Edit link for a space. The Edit Space form opens.

l To create a new custom advertising space, click the Create new advertising space link in the upper-right
corner. The Create Space form opens.

The Edit Space and Create Space forms are identical, and are described below.
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In the General Properties area of the form, set the basic properties for the space:

Field Description

Name (Required) Name that clearly identifies this space. For a built-in space, this cannot be edited.

Enabled

If selected, allows advertising to be shown in this space. If this check box is not selected, the
space will not show any advertisements.
Before advertising will be delivered in an enabled space on a specific page, the page's settings
also need to allow advertising in the space.

Rank (Required) Applies a relative rank to the space. A rank of 1 is given higher preference than a
rank of 2.

Description Optional comments or notes about this advertising space.

Location

Describes position of the space on the page. For a built-in space, this cannot be edited. For
custom spaces, options include:
l None - for manually positioned spaces—Select this option if you will use the nwa_

adspace Smarty Template tag, and to only specify the name parameter, not the location
parameter. For more information, see "The nwa_adspace Smarty Template Tag" on page
320.

l Page Top - above content—The space will deliver advertisements above the main content
of a Web page.

l Page Left - to the left of content—The space will deliver advertisements to the left of the
main content of a
Web page.

l Page Bottom - below content—The space will deliver advertisements below the main
content of a Web page.

l Page Right - to the right of content—The space will deliver advertisements to the right of
the main content of a Web page.

l Page Interstitial - briefly replaces content—The space will deliver advertisements that
will briefly replace the main content of a Web page.

l SMS Top - above content—The space will deliver advertisements above the main content
of an SMS message.

l SMS Bottom - below content—The space will deliver advertisements below the main
content of an SMS message.

l Other - for user defined locations—Select this option if you will use the nwa_adspace
Smarty Template tag to define a custom location by specifying the location parameter,
not the name parameter. For more information, see "The nwa_adspace Smarty Template
Tag" on page 320. If you select this option, the Other Location field is added to the form.

Other Location
If you selected Other - for user-defined locations in the Location field, use this field to
define a name for a custom location. The custom location can then be referenced in any
Smarty Template by using the nwa-adspace Smarty Template tag.

Table 72: General Properties, Edit Space

"Other Location" Example
If you wanted to add a custom advertising space that is positioned on the far-right edge of the registration
page, you could do it as shown in the following example:

1. Choose Other - for user defined locations in the Location field.

2. In the Other Location field, create the name custom_right.

3. In a guest self-registration page, edit the Footer HTML to include an nwa_adspace Smarty Template tag as
follows:
{nwa_adspace media="web"

location="custom_right"
stage="web_registration"
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container="div"
style="position:absolute; left:839px; top:92px; width:320px; margin:20px 0 0 20px;"}

For more information, see "The nwa_adspace Smarty Template Tag" on page 320.

In the Geometry area of the form, set the options that control the width and height of the space.

Some devices, such as desktop computers and laptops, have a large screen. Other devices, such as smart
phones, have a small screen. Although it is possible to deliver large advertisements to small screens, it does not
provide the best user experience. Geometry constraints let you configure an advertising space to be only
displayed on a large screen or only displayed on a small screen. Typically, the width and height constraints
would also be set to values that are appropriate for the selected screen type.

The screen type is detected by looking at the browser's User Agent value. Laptops, desktops, and devices like the
iPad are treated as large-screen devices. Smart phones and other mobile devices are treated as small-screen
devices.

While we endeavor to correctly detect the screen type for as many devices as possible, we are unable to test every
possible device, so we do not claim detection to be correct for all devices.

Field Description

Screen Types

Limits the types of screen that will show this space. This setting only applies to Web
advertising. Options include:
l All Screens — show on both small and large screens—Ignores the detected screen

type.
l Small Screens — show on small screens only (phones; mobile devices)—This space

will only be shown if the user's device is detected to be a small-screen device.
l Large Screens — show on large screens only (laptops, desktops)—This space will

only be shown if the user's device is detected to be a large-screen device.

Minimum Width Optimum minimum width in pixels for advertising materials shown in this space. If an

Table 73: Geometry Options, Edit Space
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Field Description

advertisement has a size (for example, a Flash or YouTube ad), the width of that
advertisement must be at least as large as this minimum width if it is to be shown in this
space. If you do not want to have a minimum width constraint, leave this field blank.

Maximum Width

Optimum maximum width in pixels for advertising materials shown in this space. If an
advertisement has a size (for example, a Flash or YouTube ad), the width of that
advertisement must be no larger than this maximum width if it is to be shown in this space. If
you do not want to have a maximum width constraint, leave this field blank.
Best Practice: Because an advertising space also has padding, it is best to set the maximum
width constraint to be 20 pixels wider than the widest image that will be displayed in this
space.

Width Minimum and/or maximum width in pixels for this space.

Minimum Height

Optimum minimum height in pixels for advertising materials shown in this space. If an
advertisement has a size (for example, a Flash or YouTube ad), the height of that
advertisement must be at least as large as this minimum height if it is to be shown in this
space. If you do not want to have a minimum height constraint, leave this field blank.

Maximum Height

Optimum maximum height in pixels for advertising materials shown in this space. If an
advertisement has a size (for example, a Flash or YouTube ad), the height of that
advertisement must be no larger than this maximum height if it is to be shown in this space.
If you do not want to have a maximum height constraint, leave this field blank.
Best Practice: Because an advertising space also has padding, it is best to set the maximum
height constraint to be 20 pixels wider than the tallest image that will be displayed in this
space.

Height Minimum and/or maximum height in pixels for this space.

Maximum Rows

Maximum number of rows of advertisements to show in this space. A space can show
multiple rows of ads, up to the maximum number of rows specified here. However, if a
maximum height was specified, the system will only output as many rows as will fit within the
maximum height constraint for the space.

Maximum
Columns

Maximum number of columns of advertisements to show in this space. A space can show
multiple columns of ads, up to the maximum number of columns specified (there is always at
least one column). However, if a maximum width was specified, the system will only output
as many columns as will fit within the maximum width constraint for the space.

"Maximum Height" Example
If a maximum height was specified, the system will only output as many rows as will fit within the maximum
height constraint for the space. For example, with a maximum height constraint of 100 and a maximum rows
constraint of 3, the system could output any of the following:

l Three rows with heights 40, 40, and 20

l Three rows with heights 30, 30, and 30

l Two rows with heights 60 and 40

l Two rows with heights 50 and 50

l One row of height 80

l One row of height 100

"Maximum Width" Example
If a maximum width was specified, the system will only output as many columns as will fit within the maximum
width constraint for the space. For example, with a maximum width constraint of 100 and a maximum
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columns constraint of 3, the system could output any of the following:

l Three columns with widths 40, 40, and 20

l Three columns with widths 30, 30, and 30

l Two columns with widths 60 and 40

l Two columns with widths 50 and 50

l One columns of widths 80

l One columns of widths 100

In the Promotional Material Constraints area of the form, set the options that control what can and cannot
be shown in the advertising space:

Field Description

Allowed
Material

Select each type of promotional material that should be allowed in this space. Types included
are:
l Flash advertisement [Web]
l HTML code (advanced) [Web]
l Image advertisement [Web]
l Text advertisement [Web]
l YouTube video advertisement [Web]
l Text advertisement [SMS]

Table 74: Promotional Material Constraints, Edit Space

When you have completed your entries on this form: 

l If you are creating a new space, click Create to create the new space and return to the Advertising Spaces
list, or click Create and Reload to create the new space and reload the Edit Space form.

l If you are editing an existing space, click Save to save your changes and return to the Advertising Spaces list,
or click Save and Reload to save your changes and reload the Edit Space form.

Advertising Campaigns

An advertising campaign is the strategy by which you organize the presentation of your ads. It defines which
promotions and materials to deliver, and when they should be delivered.
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The system requires at least one advertising campaign to be configured and enabled for any advertisements to be
delivered.

To create and work with advertising campaigns, go to Configuration > Advertising > Campaigns. The
Advertising Campaigns list view opens.

All advertising campaigns that have been created are included in this list. You can click a campaign's row in the
list for additional options.

Field Description

Edit Edit any of the campaign's properties. See "Creating and Editing Advertising Campaigns" on
page 329.

Delete Delete the campaign from the system. You will be asked to confirm the deletion.

Enable
Enable the advertising campaign so it will provide advertisements.
Before advertising will be delivered from an enabled campaign on a specific page, the page's
settings also need to allow advertising from the campaign.

Disable Disable the campaign. To make the campaign active again, click the Enable link.

Copy Make a copy of the campaign's settings to use as a basis for a new campaign.

Create new
advertising
campaign

Create a new advertising campaign.

Table 75: Advertising Campaigns List

Creating and Editing Advertising Campaigns
An advertising campaign is the strategy by which you organize the presentation of your ads. It defines which
promotions and materials to deliver, and at which stages they should be delivered. You can rank and weight a
campaign to balance it against other campaigns. A campaign can also be configured for presentation between a
specified start date and end date.

Campaigns can be delivered at the following stages:

l On the login page

l On the registration page

l On the registration receipt

l On the self-service portal pages

l Immediately after login

l On the SMS registration receipt

You can edit advertising campaigns, and you can create new advertising campaigns.
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l To edit an advertising campaign, go to Configuration > Advertising > Campaigns, and then click the Edit
link for a campaign in the list. The Edit Campaign form opens.

l To create a new advertising campaign, click the Create new advertising campaign link in the upper-right
corner. The Create Campaign form opens.

The Edit Campaign and Create Campaign forms are identical, and are described below.

In the General Properties area of the form, set the basic properties for the campaign:

Field Description

Name (Required) Name that clearly identifies this campaign.

Enabled

If selected, allows promotions from this campaign to be delivered. If this check box is not selected,
no ads will be provided from this campaign.
Before advertising will be delivered from a campaign to a specific page, the page's settings also
need to allow advertising from the campaign.

Start Date

(Optional) Date and time on which this campaign will begin. To start delivering this campaign
immediately, leave this field blank.
Click the button to open the calendar picker. In the calendar, use the arrows to select the year and
month, click the numbers in the Time fields to increment the hours and minutes, then click a day to
select the date.

End Date

(Optional) Date and time after which the campaign will no longer be delivered. To deliver this
campaign indefinitely, leave this field blank.
Click the button to open the calendar picker. In the calendar, use the arrows to select the year and
month, click the numbers in the Time fields to increment the hours and minutes, then click a day to
select the date.

Rank
(Required) Applies a relative rank to the campaign, which defines the order in which campaigns are
processed when delivering ads. A rank of 1 is higher than a rank of 2. For information about
campaign ranks, see "Campaign Rank and Weight" on page 331.

Weight
(Required) Applies a weight to a campaign. If two campaigns have equal rank, one with a greater
weight will be displayed more than the other. For information about campaign weights, see
"Campaign Rank and Weight" on page 331.

Description Optional comments or notes about the campaign.

Table 76: General Properties, Edit Campaign

At the time ads are delivered on your pages, the system processes the information in the General Properties
area in the following order:

1. Verifies which campaigns are enabled and ignores ones that are not.
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2. Checks for start dates that are less than or equal to "now" and ignores campaigns that are not scheduled to
start yet.

3. Checks for end dates that are greater than "now" and ignores campaigns whose end date is past.

4. Checks the rank of each remaining campaign. Includes only the highest ranked campaign, or multiple
campaigns that have the same highest rank.

5. If there are multiple campaigns, checks the weight of each remaining campaign.

In the Web Promotions Delivery area of the form, set the options that define when the campaign's Web
promotions are delivered. Use the SMS Promotions Delivery area to set when the campaign's SMS
promotions are delivered.

The drop-down lists in the Web Promotions area also allow you to select a material instead of a promotion. This
usage is rare, though, as it would display only a single static item.

Field Description

With Login Select the promotion to deliver on the landing page (login page). To not display ads at this stage,
select None.

With
Registration

Select the promotion to deliver on the registration page. To not display ads at this stage, select
None

With Receipt Select the promotion to deliver on the registration receipt. To not display ads at this stage, select
None

With Self-
Service

Select the promotion to deliver on the self-service portal pages. To not display ads at this stage,
select None

After Login Select the promotion to deliver when the user has logged in. To not display ads at this stage,
select None

With Receipt Select the promotion to deliver on the SMS registration receipt. To not display ads at this stage,
select None

Table 77: Web Promotions Delivery, Edit Campaign

Campaign Rank and Weight
Each advertising campaign must be assigned a rank and weight. These numbers let you balance how campaigns
are chosen relative to each other.

l Rank—This number determines which of the available campaigns will be used. A lower number has a higher
rank or priority, so a rank of 1 takes priority over a rank of 2. When the available campaigns are compared,
the campaign with the highest rank (for example, rank = 1) is used and the other campaigns are ignored. To
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use multiple campaigns at the same time, they must have the same rank; they will be dropped if they have a
lower rank.

l Weight—When multiple campaigns of equal rank are used, the weight determines how often each
campaign's ads should be displayed relative to ads from the other campaigns.

Suppose you have multiple advertising campaigns that are defined to provide ads at the same time and stage.
You can modify the rank to ensure that ads are displayed from the campaigns in the order you want. You can
modify theweight to ensure that, on average, more ads are displayed from campaigns with higher weight. The
frequency of display is determined by the ratio of each weight to the total weights.

n Example: Assume two campaigns of equal rank. If campaign A has a weight of 10, and campaign B has a
weight of 5, campaign A's ads will be shown twice as often as campaign B's ads. To look at this another
way, 10 + 5 = 15, and campaign A's ads will be shown, on average, 10 out of every 15 times.

n Example: Assume three campaigns of equal rank. Campaign A has a weight of 2, campaign B has a weight
of 3, and campaign C has a weight of 5. These numbers add up to 10, so on average, campaign A will be
shown 2 out of every 10 times, campaign B would be shown 3 out of every 10 times, and campaign C
would be shown 5 out of every 10 times.

Ranks and weights are assigned to campaigns when they are created or edited. See "Creating and Editing
Advertising Campaigns" on page 329.

Advertising Promotions

Promotions define rules for how and when advertisements are delivered and what materials should be
included. Promotions can also be configured to use intelligent delivery, presenting relevant advertising to
users.

To create and work with advertising promotions, go to Configuration > Advertising > Promotions. The
Advertising Promotions list view opens.

All advertising promotions that have been created are included in this list. You can click a promotion's row in
the list for additional options.

Field Description

Edit Edit any of the promotion's properties. See "Creating and Editing Advertising
Promotions" on page 333.

Delete Delete the promotion from the system. You will be asked to confirm the

Table 78: Advertising Promotions List
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Field Description

deletion.

Enable Enable the promotion so it will provide advertisements.

Disable Disable the promotion. To make the promotion active again, click the Enable
link.

Copy Make a copy of the promotion's settings to use as a basis for a new
promotion.

Create new advertising
promotion Create a new advertising promotion.

Creating and Editing Advertising Promotions
Most of the rules for how and when advertisements are delivered and what materials should be included are
defined in a promotion. These rules are applied to all of the advertising materials that the promotion includes,
whether those materials are included directly or indirectly.

A promotion can include both materials and/or other promotions. You can use this feature to build simple groupings of
materials with simple rules, or more complex groupings of materials and promotions with more complex rules.

Promotions can be enabled and disabled, and have a start date and an end date. They can also be assigned any
number of labels. Promotions can include materials and/or other promotions using a fixed, rotating, weighted,
or labeled content selection type. Promotions can also be configured to use intelligent delivery, which uses
labels to match relevant advertising to users.

To edit an advertising promotion, go to Configuration > Advertising > Promotions, then click the Edit link
for a promotion. The Edit Promotion form opens.

In the General Properties area of the form, set the basic properties for the promotion:

Field Description

Name (Required) Name that clearly identifies this promotion.

Table 79: General Properties, Edit Promotion
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Field Description

Enabled If selected, allows this promotional to deliver ads. If this check box is not selected, no ads will be
provided by this promotion.

Start Date

(Optional) Date and time when the promotion can start providing ads. To have this promotion start
providing ads immediately,leave this field blank.
Click the button to open the calendar picker. In the calendar, use the arrows to select the year and
month, click the numbers in the Time fields to increment the hours and minutes, then click a day to
select the date.

End Date

Date and time after which the promotion will no longer provide ads. To have this promotion deliver
ads indefinitely, leave this field blank.
Click the button to open the calendar picker. In the calendar, use the arrows to select the year and
month, click the numbers in the Time fields to increment the hours and minutes, then click a day to
select the date.

Description Optional comments or notes about this promotional material.

Labels

To apply labels to this promotion, enter the labels in this field. To create new labels, enter the new
label names separated by commas or new lines. The system creates each new label as a "tag". If
some labels were already created, clicking in this field displays a list of the existing label tags to
choose from.
If you include labels here, other promotions will detect this promotion as labeled content.
Labels are used to include or exclude this promotion when creating another higher-level labeled-
content promotion. When processing intelligent delivery rules, labels are applied to all materials that
are included, either directly or indirectly, by this promotion. For more information, see "Using Labels
in Advertising Services" on page 336.

Type

(Required) The type of content. Options include:
l Rotating content
l Fixed content
l Weighted content
l Labeled content
When you make a selection here, the name of the next area of the form changes to match and
includes the appropriate options.

Depending on the selection in the Type field, the next area of the form will be either Rotating Content,
Weighted Content, Fixed Content, or Labeled Content. In this area, set the options that control the
content of the promotion.
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Field Description

Content For fixed content, select a single content item for the promotion.

Content Items (Required) For rotating or weighted content, all items in this list are initially selected. Click an
item's row to access controls for removing items or changing their order.

Content Types

(Labeled content) Types of content to include in this promotion. Options include:
l All content types
l Materials only
l Promotions only

Inclusion Mode

(Labeled content) How the list of inclusive labels is matched to the available content. Options
include:
l All of the "inclusive labels" must match
l At least one of the "inclusive labels" must match

Inclusive Labels
(Labeled content) Enter inclusive labels, separated by commas or new lines. Content must
match these labels to be included in the promotion. (Refer to the Defined Labels field in the
Intelligence area of the form)

Exclusion Mode

(Labeled content) How the list of exclusive labels is matched to the available content. Options
include:
l All of the "exclusive labels" must match
l At least one of the "exclusive labels" must match

Exclusive Labels
(Labeled content) Enter exclusive labels, separated by commas or new lines. Content is
excluded from the promotion if it matches these labels. (Refer to the Defined Labels field in
the Intelligence area of the form)

Selected Content List of the content selected on this form. After making changes to the content selection, click
the Save and Reload button to refresh this list.

Table 80: Rotating, Fixed, Weighted, or Labeled Content, Edit Promotion

In the Intelligence area of the form, set the options that control intelligent delivery of content for the
promotion:
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Field Description

Enabled If selected, allows a more selective delivery by matching user labels to material labels.
(Material also inherits labels from the promotions that include it)

Requirement
Levels

How often the specified labels should be matched. These settings override the Default Level in
the next field.
Use the controls to select label groups and a requirement level for each one.

Default Level How often all other labels should be matched (applies to labels not selected in the
Requirement Levels field).

Defined Labels List of currently-defined user labels.

Table 81: Intelligence Options, Edit Promotion

Using Labels in Advertising Services
A label identifies a user attribute or category. In Advertising Services, you can add intelligent delivery to your
campaigns by creating labels and applying them to your promotions and materials:

1. Configure your pages to include fields for collecting user information such as gender, age, hobbies, or
product preferences. When a user completes these fields, the attributes are stored in ClearPass (see
"Creating a Custom Field " on page 206).

2. In the Edit Promotion form, use the Labels field to apply or easily create labels that correspond to the
information-gathering fields you added to your pages (see "Creating and Editing Advertising Promotions" on
page 333).

3. Configure the promotion to use labeled content (promotions, materials, or both), and specify which labels
to include or exclude.

4. Also on the Edit Promotion form, enable the promotion for intelligent delivery. Indicate the percentage of
ads that should match the labels. (For reference, this form provides a list of the labels that have already
been defined in the system.)

5. On the Edit Materials form, you can also use the Labels field to apply existing labels or create new ones
(see "Creating and Editing Advertising Materials" on page 337).

6. After the promotions and materials that include the labels and intelligent delivery configuration are
complete, include them in a campaign (see "Creating and Editing Advertising Campaigns" on page 329).

7. When a user visits the pages while the campaign is running, Advertising Services displays ads with the
labeled content that matches the user's attributes.

When you create labels in the Edit Promotion or Edit Materials forms, they are created as "tags" in the system.
Clicking in a Labels field provides an auto-suggested list of existing tags to choose from. To see a list of Label
tags that have already been created for your advertising campaigns, go to Administration > Plugin
Manager and click the Configuration link for the Advertising Services plugin:
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Advertising Materials

A material is the individual advertisement you deliver — the ad the user sees.

To create and work with advertising materials, go to Configuration > Advertising > Materials. The
Advertising Materials list view opens.

All advertising materials that have been created are included in this list. You can click a material's row in the list
for additional options.

Field Description

Edit Edit any of the material's properties. See "Creating and Editing Advertising
Materials" on page 337.

Delete Delete the material from the system. You will be asked to confirm the
deletion.

Disable Disable the material. To make the material active again, click the Enable link.

Copy Make a copy of the material's settings to use as a basis for a new material.

Create new advertising
promotion Create a new advertising material.

Table 82: Advertising Materials List

Creating and Editing Advertising Materials
An advertising material is the individual advertisement you deliver — the ad the user sees. You can deliver ads
through Web browsers, email, and SMS. The medium of an advertising material can be a text, image, Flash, raw
HTML, YouTube, or SMS text advertisement. Materials can also be assigned any number of labels, which can be
used by promotions to create labeled promotions and to provide intelligent delivery.

To edit settings for an advertising material, go to Configuration > Advertising > Materials, then click the
Edit link for a material. The Edit Promotional Material form opens.
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In the General Properties area of the form, set the basic properties for the material:

Field Description

Name (Required) Name for this material.

Enabled If selected, allows this material to be delivered.

Start Date Date and time on which this campaign will begin. To start delivering this material immediately, leave
this field blank.

End Date Date and time after which the material will no longer be delivered. To deliver this material
indefinitely, leave this field blank.

Description Optional comments or notes about the material.

Labels

To apply labels to this material, enter the labels in this field. To create new labels, enter the new
label names separated by commas or new lines. The system creates each new label as a "tag". If
some labels were already created, clicking in this field displays a list of the existing label tags to
choose from.
If you include labels here, promotions will detect this material as labeled content.
Labels are used to include or exclude material for a labeled content promotion. Labels are matched
when processing intelligent delivery rules of a promotion that includes this material.

Type

(Required) The type of content. Options include:
l Web browser content
l SMS content
When you make a selection here, the name of the next area of the form changes to match and
includes the appropriate options.

Table 83: General Properties, Edit Promotional Material
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Depending on the selection in the Type field, the next area of the form will be either SMS Content or Web
Content. In this area, set the options that control either the content of the SMS text messages promotion, or
the content and formatting of the Web promotion.

Field Description

Text (SMS content) Enter the message text. To keep messages short, use 80 characters
or fewer.

Format

(Web content) (Required) If Web browser content is selected in the Type field, use
this field to select the format of the Web content material. Options include: 
l Flash advertisement
l HTML code (advanced)
l Image advertisement
l Text advertisement
l YouTube video advertisement
When you make a selection here, the rest of the form includes the appropriate
options.

Flash
(Flash) The Flash animation file (.swf) of the material. Either select a file that is
already uploaded to Content Manager, or upload a new file. Maximum file upload
size is 15.0 MB.

Template Code
(HTML code) To code your own advertisement using raw HTML, enter the HTML
code to display. Smarty template functions can be used. You can also use the drop-
down list to add images or other content items.

Preview (HTML code) Preview of the HTML. The preview is updated when you modify the
contents of the Template Code field.

Hyperlink
(Image advertisement; Text advertisement) The destination page URL to which the
advertisement is linked. To not associate a destination URL with the advertisement,
leave this field blank.

Image
(Image advertisement) The image file for the advertisement. Either select a file
that is already uploaded to Content Manager, or upload a new file. Maximum file
upload size is 15.0 MB.

Title
(Image advertisement; Text advertisement) Specify alternative text for the image.
For a text advertisement, the title is shown as the first line of the ad; if a hyperlink
is also specified, the title is clickable.

Preview (Image advertisement) Preview of the selected advertisement. The preview is
updated as you modify the properties of the advertisement.

Table 84: SMS Content or Web Content, Edit Material
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Field Description

Body (Text advertisement) Content for the text advertisement.

Footer (Text advertisement) The last line of a text advertisement. If a hyperlink is also
specified, the footer is clickable

Video ID
(YouTube video advertisement) (Required) The YouTube video identifier for the
video to display. This is a unique identifier for a video that has already been
uploaded to YouTube.

Width (YouTube video advertisement) (Required) The desired width in pixels for the
video.

Height (YouTube video advertisement) (Required) The desired height in pixels for the
video.

Edit Global Settings (YouTube video advertisement) Select this option to configure global settings that
will apply to all advertising materials.

Experimental YouTube API

(YouTube video advertisement) Specifies whether the experimental API is enabled
for all devices. Options include:
l All devices —Use the experimental API for all devices
l Disabled —Use the standard YouTube API (recommended)
l Select Devices — Use the experimental API for specific devices

IFrame API Devices (YouTube video advertisement) If selected, the experimental YouTube IFrame API
is used only for iOS devices.
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Chapter 7
Hotspot Manager

The Hotspot Manager controls self-provisioned guest or visitor accounts. This is where the customer is able to
create his or her own guest account on your network for access to the Internet. This can save you time and
resources when dealing with individual accounts.

Accessing Hotspot Manager
To access ClearPass Guest’s hotspot management features, go to Configuration > Hotspot Manager.
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About Hotspot Management
The following diagram shows how the process of customer self provisioning works.

Figure 35 Guest self-provisioning

l Your customer associates to a local access point and is redirected by a captive portal to the login page.

l Existing customers may log in with their Hotspot username and password to start browsing.

l New customers click the Hotspot Sign-up link.

l On page 1, the customer selects one of the Hotspot plans you have created.

l On page 2, the customer enters their personal details, including credit card information if purchasing access.

l The customer’s transaction is processed, and, if approved, their visitor account is created according to the
appropriate Hotspot plan.

l On page 3, the customer receives an invoice containing confirmation of their transaction and the details of
their newly created visitor account.

l The customer is automatically logged in with their username and password, providing instant Hotspot
access.

Managing the Hotspot Sign-up Interface

You can enable visitor access self provisioning by navigating to Configuration > Hotspot Manager > Start
Here and selecting the Manage Hotspot Sign-up command.

The Hotspot Preferences form opens. This form allows you to change user interface options and set global
preferences for the self-provisioning of visitor accounts.
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The Enable guest access self-provisioning check box must be selected for self-provisioning to be available.

The Require HTTPS field, when enabled, redirects guests to an HTTPS connection for greater security.

The Service Not Available Message allows an HTML message to be displayed to visitors if self-provisioning
has been disabled. See "Smarty Template Syntax" on page 478 in the Reference chapter for details about the
template syntax you may use to format this message.

Click the Save Changes button after you have entered all the required data.

Captive Portal Integration
To start the visitor self-provisioning process, new visitor registration is performed by redirecting the visitor to
the URL specified on the Hotspot Preferences page; for example: https://guest.example.com/hotspot_
plan.php. The Hotspot Sign-Up page opens to the first page of the wizard, Choose Plan.

The hotspot_plan.php page accepts two parameters:

l The source parameter is the IP address of the customer.

l The destination parameter is the original URL the customer was attempting to access (that is, the
customer’s home page). This is used to automatically redirect the customer on successful completion of the
sign-up process.

For browsers without JavaScript, you may use the <noscript> tag to allow customers to sign up:
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<noscript>
<a href="https://guest.example.com/ hotspot_plan.php">Hotspot Sign-Up</a>

</noscript>

However, in this situation the MAC address of the customer will not be available, and no automatic redirection
to the customer's home page will be made. You may want to recommend to your customers that JavaScript be
enabled for best results.

Web Site Look-and-Feel
The skin of a Web site is its external look and feel. It can be thought of as a container that holds the application,
its style sheet (font size and color for example), its header and footer, button style, and so on.

The default skin used by ClearPass Guest is the one that is enabled in the Plugin Manager. The skin is seen by all
users on the login page.

SMS Services
Configure the following settings in the SMS Services section of the Hotspot Preferences form to override
the default SMS settings with your own custom configuration.

l SMS Receipt: Click this drop-down list to select the template you want to use for SMS receipts. The default
value is SMS Receipt.

l Phone Number Field: Click this drop down list and identify the field that contains the visitor’s phone
number. The default value is visitor_phone.

l Auto-Send Field: Click this drop-down list and select the field which, when configured with any string or
non-zero value, will trigger the automatic sending of an SMS receipt. The default value of this field is auto_
send_sms.

Managing Hotspot Plans

Your Hotspot plans determine how a customer is to pay for Internet access when connected through ClearPass
Guest. You also have the option to allow free access.

To view the list of hotspot plans your visitors can select and to access plan management, go to Configuration
> Hotspot Manager > Start Here and click the Manage Hotspot Plans link.
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The Manage Hotspot Plans page opens, showing the list of default plans. Plans that are enabled have their
name in bold and their icon in color: . Plans that are not enabled have their icon in gray: .

l To create or edit an existing plan, see "Editing or Creating a Hotspot Plan" on page 345.

l To delete a plan, click the Delete button in the plan’s row. When a plan is deleted it is not possible to
undo the deletion.

Editing or Creating a Hotspot Plan
When you create or edit a hotspot plan, you can customize which plans are available for selection, and any of
the plan’s details, such as its description, cost to purchase, allocated role, and the format of the customer’s
generated username and password.

1. To create or edit a plan, first go to Configuration > Hotspot Manager > Start Here, click the Manage
Hotspot Plans link, and then:

l To create a new plan, click the Create Hotspot plan link in the upper-right corner. The Create
Hotspot Plan form opens.

l To edit a plan, click the Edit link in the plan’s row. The Edit Hotspot Plan form opens.

The procedures are the same for both the Create Hotspot Plan and the Edit Hotspot Plan forms.

Figure 36 Edit Hotspot Plan, Plan Details

2. In the Plan Details area, enter a name for the plan and descriptions to display in the UI and the customer
invoice.

3. To enable the plan, leave the Enabled check box marked. To disable the plan, unmark this check box.
Disabled plans are not displayed to customers.
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Figure 37 Edit Hotspot Plan, User Account Details

4. In the User Account Details area, you can specify the usage of numbers, letters, and symbols in the
generated username and password. To use only digits, leave the value in the Generated Username and
Generated Password fields set to ######. To indicate a different combination of numbers, letters, or
symbols, use the following parameters:

l The number or hash symbol (#) is replaced with a random digit (0-9)

l The dollar symbol ($) is replaced with a random letter

l The underscore symbol (_) is replaced with a random lowercase letter

l The carat symbol (^) is replaced with a random uppercase letter

l The asterisk symbol (*) is replaced with a random letter or digit

l The “at” symbol (@) is replaced with a random letter or digit, excluding vowels

l The exclamation symbol (!) is replaced with a random punctuation symbol

l The ampersand symbol (&) is replaced with a random character (letter, digit, or punctuation symbol)

l All other characters are used without modification

For more information, see "Format Picture String Symbols" on page 513.

The Username Example field shows a sample username generated according to the rules specified by the
entries in the Generated Username field. You can click the Generate link to view different examples.

The Password Example field shows a sample password generated according to the rules specified by the
entires in the Generated Password field. You can click the Generate link to view different examples.

Figure 38 Edit Hotspot Plan, Time and Cost Details

5. Complete the rest of the fields appropriately for your organization’s needs, then click Create Plan or Edit
Plan. The Manage Hotspot Plans list opens with the new plan displayed.

Managing Transaction Processors
Your hotspot plan must also identify the transaction processing gateway used to process credit card payments.
ClearPass Guest supports plugins for the following transaction processing gateways:

l Authorize.Net AIM

l CashNet
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l CyberSource

l eWAY

l Micros Fidelio

l Netregistry

l Paypal

l WorldPay

ClearPass Guest also includes a Demo transaction processor that you can use to create hotspot forms and test
hotspot transactions.

Creating a New Transaction Processor
The Transaction Processor Configuration form is used to create and to edit transaction processors.

To define a new transaction processor:

1. Go to Configuration > Hotspot Manager > Transaction Processors and click the Create new
transaction processor link in the upper-right corner. The Transaction Processor Configuration form
opens.

2. In the Name field, enter a name for the transaction processor.

3. In the Processing Gateway drop-down list, select the gateway with which you have a service account. The
form expands to include additional configuration fields for that gateway type.

Each transaction processing gateway type requires unique merchant identification, password, and
configuration information. Depending on the gateway provider, these configuration items will include some
of the following:

l API Login

l API Password

l API Username

l Auto Email

l Beagle Anti-Fraud

l Business Center Login

l Customer ID

l Installation ID

l Logging

l Merchant ID

l Mode

l Production Environment URL

l Shared Secret
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l Signature

l Test Environment URL

l Test WSDL

l Transaction Key

l Transaction Password

l Transactions Timeout

If your transaction processor requires visitors to enter their address, ClearPass Guest will automatically include
address fields in the guest self-registration forms that use that transaction processor.

Managing Existing Transaction Processors
After you define a transaction processor, it is included in the transaction processor list. When you select an
individual processor in the list, the following options are available:

l Edit – changes the properties of the specified transaction processor

l Delete – removes the processor from the Transaction Processors list

l Duplicate – creates a copy of a transaction processor

l Show Usage – opens a window in the Transaction Processors list that shows if the profile is in use, and
lists any hotspots associated with that transaction processor. Each entry in this window appears as a link to
the General Hotspot References form that lets you change the transaction processor associated with
that hotspot.

Managing Customer Information

You can customize the fields that the customer sees, the details of these fields, and the order in which they are
presented. To customize the fields, go to Configuration > Hotspot Manager > Start Here and click the
Manage Hotspot Customer Information link.

The Customize Form Fields view opens for the customer information form. See "Duplicating Forms and Views"
on page 213 for instructions for completing the form field editor.

Managing Hotspot Invoices

After the customer’s transaction has been processed successfully, the customer receives an invoice containing
confirmation of their transaction and the details of their newly created hotspot user account. You can
customize the title shown on the invoice and how the invoice number is created. You can also customize the
currency displayed on the invoice.
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To customize the hotspot invoice:

1. Go to Configuration > Hotspot Manager > Start Here and then click the Manage Hotspot Invoice
link. The Manage Hotspot Invoice form opens.

2. The Invoice Title must be written in HTML. See "Basic HTML Syntax" on page 475 for details about basic
HTML syntax.

3. Complete the rest of the fields appropriately. You can use Smarty functions on this page. See "Smarty
Template Syntax" on page 478 for further information on these. You can also insert content items such as
logos or prepared text. See "Customizing Guest Self-Registration" on page 235 for details on how to do this.

4. Click Save Changes.

Customizing the User Interface
Each aspect of the user interface your hotspot customers see can be customized.

Customizing Visitor Sign-Up Page One

Page one of the guest self-provisioning process asks the guest to select a plan. An example of the default
“Choose Plan” page is shown below.
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To customize how this page is displayed to the guest, go to Configuration > Hotspot Manager > Start
Here, click the Manage Hotspot Sign-Up link, and then click the Customize page 1 (Choose Plan) link in
the upper-right corner.

The Edit Hotspot Plan Selection Page form opens. You can use this form to edit the title, introductory text, and
footer of the “Choose Plan” page. The introduction and the footer are HTML text that can use template syntax.
See "Smarty Template Syntax" on page 478 in the Reference chapter.

Anexo 11 ITEM 01 (0592523)         SEI 0008478-63.2018.6.02.8000 / pg. 3377



Customizing Visitor Sign-Up Page Two

Page two of the guest self-provisioning process asks the guest to provide their personal details and payment
method.

The example below shows the default “Your Details” page if the customer chooses to pay for the Hourly Access
plan.

Although it is not shown in this illustration, the default page also includes footer text providing information
about privacy policies and security pertaining to the data collected by this page.
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The example below shows the default “Your Details” page for a customer who chooses the Free Access plan.

To customize how the “Your Details” page is displayed to the guest, go to Configuration > Hotspot Manager
> Start Here, click the Manage Hotspot Sign-Up link, and then click the Customize page 2 (Customer
Details) link in the upper-right corner.

The Edit Hotspot User Details Page form opens. You can use this form to edit the content displayed when the
customer enters their personal details, including credit card information if purchasing access. The progress of
the user’s transaction is also shown on this page.
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See "Smarty Template Syntax" on page 478 for details about the template syntax you may use to format the
content on this page.
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Customizing Visitor Sign-Up Page Three

Page three of the guest self-provisioning process provides the customer an invoice containing confirmation of
their transaction and the details of their newly created wireless account. An example of the default “Your
Receipt” page is shown below.

To customize how the “Your Receipt” page is displayed to the guest, go to Configuration > Hotspot
Manager > Start Here, click the Manage Hotspot Sign-Up link, and then click the Customize page 3
(Invoice or Receipt) link in the upper-right corner.

The Edit Hotspot User Receipt Page form opens. You can use this form to edit the title, introductory text, and
footer text of the receipt page.
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See "Smarty Template Syntax" on page 478 for details about the template syntax you may use to format the
content on this page.

Viewing the Hotspot User Interface
The Hotspot Manager allows you to view and test Hotspot self-provisioning pages, as well as log in to and view
the Hotspot self-service portal that allows customers to view their current account expiration date, purchase
time extensions, log out of the Hotspot, or change their user password.

To access either of these user pages, go to Configuration > Hotspot manager and select the Self-
Provisioning or Self-Service links in the left navigation menu.
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Chapter 8
Administration

The Administration module provides tools used by a network administrator to perform both the initial
configuration and ongoing maintenance of ClearPass Guest.

Accessing Administration
To access ClearPass Guest’s administration features, click the Administration link in the left navigation.

Figure 39 The Administration Module’s Left Navigation

AirGroup Services

This section describes creating and managing AirGroup controllers and configuring the AirGroup plugin, and
provides links to other AirGroup steps performed in ClearPass Guest. For an overview of AirGroup
functionality, see "AirGroup Deployment Process" on page 28. For complete AirGroup deployment
information, refer to the AirGroup sections in the ArubaOS User Guide and the ClearPass Policy Manager
documentation.

This section describes the following:

l "AirGroup Controllers" on page 358

l "Creating and Editing AirGroup Controllers " on page 359

l "Configuring AirGroup Services" on page 361

l "AirGroup Diagnostics" on page 362
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l "AirGroup Time-Based Sharing Syntax Examples" on page 71

l "Creating AirGroup Administrators" on page 363

l "Creating AirGroup Operators" on page 364

l "Authenticating AirGroup Users via LDAP " on page 364

l "Configuring LDAP User Search for AirGroup" on page 364

AirGroup Controllers

You can create and manage multiple AirGroup controllers. You may configure each controller's remote access
and other information, poll the current configuration, and view configuration details.

To work with your AirGroup controllers, go to Administration > AirGroup Services > Controllers. The
AirGroup Controllers list view opens.

All AirGroup controllers that have been created are included in the list. You can click an AirGroup controller's
row in the list for additional options:

Field Description

Show Details
View details for the AirGroup controller: Name, hostname or IP address and port number,
configuration status, last polling time, currently defined roles and AP groups, and AP
database details. See "AirGroup Controller Details" on page 359

Edit Edit the AirGroup controller's attributes. The Edit AirGroup Controller form opens. For
more information, see "Creating and Editing AirGroup Controllers " on page 359 .

Disable Disables the AirGroup controller. To enable it again at any time, click its Enable link.

Delete Deletes the AirGroup controller. You are asked to confirm the deletion.

Read Configuration

Immediately poll the AirGroup controller's current configuration. A progress bar is shown
during the polling action. When the poll is complete, you can click Show Details to review
the updated configuration details for the roles, AP groups, and AP database. For
information on setting an automatic polling schedule, see "Configuring AirGroup Services"
on page 361.

Create Controller Create a new AirGroup controller. The Create AirGroup Controller form opens. For more
information, see "Creating and Editing AirGroup Controllers " on page 359.

AirGroup Diagnostics Perform AirGroup diagnostics. For more information, see "AirGroup Diagnostics" on page
362.

Table 85: AirGroup List Options
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Figure 40 AirGroup Controller Details

Creating and Editing AirGroup Controllers
When you create a new AirGroup controller or edit an existing one, you may configure its name, description,
notification status, its network connection and authentication settings, and SSH (Secure Shell) details for
remote access.

To create a new AirGroup controller or edit an existing controller:

1. Go to Administration > AirGroup Services > Controllers, then either click Create AirGroup
controller at the top of the form, or click a controller's Edit link. The Create Controller form opens.
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Field Description

Name Short name that identifies the controller clearly. AirGroup controller names can include
spaces.

Description Additional useful information about the controller.

Enabled
Enables Policy Manager's AirGroup notification service for the controller. With this service
enabled, the controller receives change of authorization (CoA) Requests for sharing events
from associated MAC addresses and the events are logged.

Hostname Hostname or IP address of the controller.

RFC 3576 Port UDP port number for receiving CoA notifications. The default in ClearPass Guest is 5999.

Shared secret Shared secret for AirGroup dynamic notifications.

SSH Username SSH username for accessing the controller.

SSH Password SSH password for accessing the controller. The minimum password length is six characters.

Enable Password The enable password for the controller.

SSH Timeout Timeout limit in seconds for reading the configuration. The default is 15 seconds.

Table 86: Create AirGroup Controller
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Configuring AirGroup Services
To enable support for dynamic notification of AirGroup events when new devices are added, each AirGroup-
enabled controller must also be defined in ClearPass Guest. Configuration options include specifying roles to
exclude from the user interface, and setting an automatic polling schedule, message parameters, and logging
levels.

To configure AirGroup Services, go to Administration > AirGroup Services > Configuration. The Configure
AirGroup Services form opens.

Field Description

Exclusions
Role names, AP group names, or AP names that should not be displayed in the AirGroup
user interface. Enter each item on a separate line. Entries are not case-sensitive. To add a
comment, enter it on a separate line that begins with the "#" character.

Polling If selected, schedules automatic polling of AirGroup controller configuration. The form
expands to include scheduling options.

Schedule

Choose one of the following options from the drop-down list and complete the scheduling
details:
l None -- Run task at once: In the Run At field, use the calendar picker to specify the

month, day, and time to poll for configuration.
l Hourly: In the Minute field, enter the number of minutes past the hour to poll for

configuration, or 00 to poll on the hour. If you do not need to poll every hour, you can use
the check boxes in the Hours field to specify which hours of the day the poll should run.

l Daily: Use the text boxes in the Time of Day field to enter the hour and minute of the
day the poll should run.

l Weekly: Use the check boxes in the Weekdays field to specify the day or days of the
week the poll should run, then use the text boxes in the Time of Day field to enter the
hour and minute of the day the poll should run.

l Monthly: Use the check boxes in the Months field to specify which month or months the
poll should run, then use the text boxes in the Days field to specify the day or days of the
month. Use the text boxes in the Time of Day field to enter the hour and minute of the
day the poll should run.

l Yearly: In the Run On field, use the drop-down list to select a month, then enter the day
and time in the text boxes.

Table 87: Configure AirGroup Services
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Field Description

When a poll is run, you may click Show Details in the Controllers list to view the updated
configuration. For more information, see "AirGroup Controllers" on page 358. Automatic
polling is run only on the publisher node.

Group Names

Enter names of shared groups that should be available in the Shared Groups field for users
to choose from when they share a device. If additional user groups are also entered by
users when they share a device, the list in the configuration is automatically updated to
capture these fields. Removing a group name from this list does not remove it from other
shared group lists.
When you type a name for the group in the Group Names field, press the Enter key, and
click Save, the group is created in the system and appears as a "tag". For more information,
see "About AirGroup Time-Based Sharing" on page 75.
Each group name may not exceed 64 characters. A maximum of 32 group names may be
entered. The maximum character limit for the list is 320 characters (including comma
separators).

Network Interface

Interface AirGroup will use to send outbound notification messages. To enable using a
virtual IP address, select the appropriate interface. Options include:
l Automatic — Automatically chooses the appropriate source IP address; either the

management port or the data port, depending on the controller's IP address.
l Management port [MGMT] — Always uses the management port as the source

address.
l Data/External port [DATA] — Always uses the data port as the source address.

Timeout Number of seconds after which an attempt to send an AirGroup message will time out.

Attempts Maximum number of times the system should attempt to send an AirGroup message.

AirGroup Logging

Choose one of the following options:
l Disabled—Do not log AirGroup related events
l Standard (Recommended)—Log basic information
l Extended—Log additional information
l Debug—Log debug information
l Trace—Log all debug information

See also:

l "AirGroup Diagnostics" on page 362

l "AirGroup Services " on page 357

AirGroup Diagnostics
The AirGroup Diagnostics form lets you perform several diagnostic actions. To access this form, go to
Administration > AirGroup Services > Configuration, and then click the AirGroup Diagnostics link in the
upper-right corner. The AirGroup Diagnostics form opens.
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When you choose the diagnostic you want to run, the form expands to include fields for identifying
information. When you enter the information and click Submit, the results of the query are displayed below
the form. To run another diagnostic, click the Reset Form link before selecting the diagnostic.

Field Description

Show information about a device

Enter the device's MAC address. Information shown includes:
l Device information (as entered on Guest > Create Device)
l Controller IP address and AirGroup protocol version
l Hostname of associated server, management IP address, and role
l Times of AirGroup authorization requests along with controller IPs

and enforcement profiles

Show information about a controller

Enter the controller's IP address or hostname. Information shown
includes:
l Times of AirGroup authorization requests along with MAC

address, controller IPs, and enforcement profiles
l MAC address, AirGroup state, time of last update, and expiration

setting for devices associated with the controller

Associate a device with a controller

Links a MAC address to a controller as though the controller had
issued an AirGroup authorization request for the device.
Enter the device's MAC address and controller's IP address or
hostname. Select the AirGroup protocol version. Two links are added
below the form, one for viewing the device information, and one for
viewing the controller information.

Disassociate a device from a controller

Removes the link between the MAC address and the controller as
though the controller had reported the device no longer present on
the network.
Enter the device's MAC address and controller's IP address or
hostname. Two links are added below the form, one for viewing the
device information, and one for viewing the controller information.

Show information about the AirGroup
notification service

Displays a list of statistics from the AirGroup notification service,
showing values for various work items, CoA clients and requests, and
RADIUS items.

Download AirGroup notification service log
file Downloads the log file to your system's Download folder.

Table 88: AirGroup Diagnostics

See also:

l "Configuring AirGroup Services" on page 361

l "AirGroup Controllers" on page 358

l "AirGroup Services " on page 357

Creating AirGroup Administrators
AirGroup Administrators are users of ClearPass Guest who can define and manage their organization’s shared
devices. Devices can be shared globally, or shared with restrictions based on the username, role, or location of
the user trying to access the device.

The AirGroup Administrator profile is automatically created in ClearPass Guest when the AirGroup Services
plugin is installed. This profile is used to define the AirGroup Administrator role. To create an AirGroup
Administrator, see "Creating a New Operator" on page 462.
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Creating AirGroup Operators
AirGroup Operators are users of ClearPass Guest who can provision a limited number of their own personal
devices. Each device provisioned by an operator is automatically shared with all of that operator’s provisioned
devices. The operator can also define a group of other users who are allowed to share the operator’s devices.

The AirGroup Operator profile is automatically created in ClearPass Guest when the AirGroup Services plugin is
installed. This profile is used to define the AirGroup Operator role. To create an AirGroup Operator, see
"Creating a New Operator" on page 462.

Authenticating AirGroup Users via LDAP
ClearPass Guest supports LDAP authentication for administrators and operators. To provide AirGroup Services
to LDAP-authenticated users:

1. Define the LDAP server for AirGroup. See "External Operator Authentication" on page 463.

2. Define the appropriate translation rules to categorize the LDAP users. See "Custom LDAP Translation
Processing" on page 472.

Configuring LDAP User Search for AirGroup
On the AirGroup device registration portal, the Shared Roles and Shared Locations lists allow searching and
selecting from the roles and locations defined in an AirGroup-enabled controller in order to specify the users
with whom an AirGroup device should be shared. This section describes how to configure ClearPass Guest to
enable interactive directory-based user search for these AirGroup fields.

LDAP User Search Architecture
The LDAP user search feature has several architectural components, as shown in the following diagram.

User Search Workflow
The workflow for a typical user search operation is:

1. The user of the AirGroup portal starts typing a username. This triggers a dynamic request to ClearPass
Guest.

2. ClearPass Guest performs a search operation against the configured LDAP server.
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3. Search results are returned to the portal user, who can then select from one of the matching item, or
continue typing to further narrow the search.

Configuration Summary
To configure LDAP user search for AirGroup, you will:

1. Create a ClearPass Guest LDAP server

2. Enable user search for this server

3. Configure the user interface for the airgroup_shared_user field

4. Specify user search options for the user interface

Each of these steps is described in the following sections.

Basic LDAP Server Settings
In ClearPass Guest, go to Administration > Operator Logins > Servers and click the Create new LDAP
server link.

In the basic properties and Operator Logins areas of the Edit Authentication Server form:

Field Description

Name Enter a name for the LDAP server.

Server URL

Provide the LDAP URL of the server. This would typically be in
the form:
ldap://ldap-server-hostname.example.com/<LDAP Base
DN>

Bind DN If your directory server requires authentication, provide
suitable credentials.
A typical base DN for Microsoft Active Directory might be
DC=example,DC=com.Bind Password

Enabled
Clear the Use this server to authenticate operator
loginscheck box unless you also plan to configure LDAP
operator logins with this server.

Table 89: Edit Authentication Server, Basic Properties
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User Search Settings

In the User Search area of the Edit Authentication Server form:

Field Description

Enabled Mark the Use this server to search for matching users checkbox. The form expands to
include additional options.

Filter

(Required) Select one of the following options:
l Use the default LDAP filter—Uses an LDAP filter suitable for an Active Directory

search operation.
n The default filter matches user accounts based on any portion of the username

(sAMAccountName attribute), or any portion of the user’s full name (displayName
attribute), and eliminates resources (display name starting with “*”), disabled
accounts, and users without a userPrincipalName attribute.

l Specify a custom LDAP filter…—Allows you to enter a specific LDAP filter expression.
n This should be a valid LDAP filter expression per RFC 4515.
n The keyword @SEARCH@ is replaced with the user’s actual search term when the

filter is used.

Display Attributes
*

(Required) Provide a list of LDAP attributes to retrieve when searching, and the treatment to
apply to each attribute:
l id—Use the LDAP attribute as the value of a matching item. This value is used when a

matching item is selected. This would normally be the case for the LDAP attribute that
specifies the username. The directory should contain unique values in this attribute.

l text—Use the LDAP attribute as the text to display for a matching item.
l This would normally be the case for the LDAP attribute that specifies the user’s common

name (displayName in Microsoft Active Directory). Users will typically want to search on
this attribute.

l desc—Use the LDAP attribute as additional descriptive text to display for a matching
item. This is an optional item.

There must be exactly one attribute that is identified as an “id” attribute.
Multiple LDAP attributes may be identified as “text” or “desc” attributes, in which case all the
values are displayed together in the search results.
If no LDAP attribute is identified as a “text” attribute, the “id” attribute will be used as the text.
To use one attribute in different ways, provide a list of types. For example, specify
sAMAccountName = id, desc to have the username act as both the ID and the description
text.
Comments may be entered in this field by starting a line with the “#” character.

Sort By Specify the name of an attribute on which to order the search results. Otherwise, the default
value of displayName orders the results by the user's full name.

Maximum Results (Required) Limits the total number of search results that can be displayed.

Table 90: Edit Authentication Server, User Search

* In the Display Attributes field, the default value field provides the following behavior:
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l sAMAccountName = id—The username is used as the value for a selected item.

l displayName = text—The user’s full name is displayed as the label for a matching item.

l # title = desc—Commented out and not used by default. Enables the title of the user to be shown in the
description.

l userPrincipalName = desc—The user’s email address is displayed as descriptive text for a matching item.

Configuring the AirGroup Shared User Field

The AirGroup row of the Edit Authentication Server form is the starting point to enable the server for user
search in AirGroup. This row provides a brief description of the process and a link to the airgroup_shared_
user field's configuration form.

The airgroup_shared_user field stores a list of usernames with whom an AirGroup device should be shared.
To enable user search, this field must be updated with new configuration options.

To configure the airgroup_shared_user field, do one of the following:

l From the Administration > Operator Logins > Servers > Edit Authentication Server form, click the
Edit airgroup_shared_user field link provided in the Tip in the AirGroup row.

l If you are not starting from the Edit Authentication Server form, go to Configuration > Fields, select the
airgroup_shared_user field in the list, and then click Edit. The Define Custom Field form for that field
opens.

Use the Default Form Display Properties area of the form to set the field type and enable search:

Field Description

User
Interface

Type of user interface element to use for this field. Select Multiple selection list from this drop-
down list.

Searchable Select the Enable searching and advanced UI check box in this row. The Select2 Options and
Select2 Hook fields are added to the form.

Table 91: Default Form Display Properties, Relevant Fields
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In the Advanced Properties area of the form, you will customize the user interface for single and multiple-
selection capabilities.

Field Description

Advanced Select the Show advanced properties check box. Additional configuration options are added
to the form.

Select2 Options Used to customize the user interface for the “select2” control, which provides both single and
multiple-selection capabilities.
Default values are preconfigured for these fields. These defaults are intended for use with user
search. However, the ajax.args.server parameter must be configured with the name of the
LDAP server that should be searched.Select2 Hook

Save Changes
After the server name is specified in the ajax.args.server parameter in the Select2 Hook field,
when you save your changes the AirGroup device registration portal includes the capability to
search the directory based on username.

Table 92: Advanced Properties, Relevant Fields

For details of the advanced options, functions, and additional parameters provided in the Select2 Options
and Select2 Hook fields, see "Select2 Options Details" on page 368 and "Select2 Hook Details" on page 369.
For in-depth technical information about these functions, refer to the Select2 programmer’s documentation at
http://ivaynberg.github.com/select2/.

Select2 Options Details
When configuring the airgroup_shared_user field for AirGroup user search, the advanced options provided in
the Select2 Options field are shown in the following table:

Option Description

multiple = 1
Specifies that the field allows multiple selections. When this parameter is set,
individual selections can be cleared by clicking an “x” delete icon displayed with
each selection, or by using the Backspace key to erase a selected item.

placeholder = (Select one or
more users) Specifies the placeholder text that is displayed when the field is empty.

minimumInputLength = 1

Specifies that at least one character must be typed before a search operation is
triggered. If the directory has a large number of user accounts in it, performing a
single-character search is not likely to return any useful results, in which case this
value should be increased.

_advancedRender = 1
Specifies that the list of matching items should be rendered in a way which
includes an icon, text and description. If this parameter is not specified, only text
is displayed in the matching items.

Table 93: Details, Select2 Options Field
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Option Description

resultsCss.max-height =
400px

Specifies that the list of matching items should be up to 400 pixels in height.
Additional CSS properties may be specified
using the “resultsCss” value, if required.

ajax.dataType = sajax Specifies that the field should use a dynamic query mechanism to look up a
search term. This parameter should not be changed.

ajax.url =
NwaAirGroupUserSearchAjax

Specifies that the field should perform a user search. This parameter should not
be changed.

ajax.args.server = …
Specifies the name of the LDAP server that should be searched. This parameter
must match the name of the LDAP server that was created, or else the search
operation will fail.

ajax.quietMillis = 500

Specifies that the user search operation should be performed after half a second
(500 ms). This parameter is used to avoid performing searches while the user is
still typing. To increase the responsiveness of the user interface, this parameter
can be reduced, but doing so may increase the number of search operations
performed against the LDAP server.

Additional parameters that may be specified in this field include:

Option Description

width = 460px
Specifies the width of the field. A value in pixels may be specified, or another length unit
supported by CSS. This parameter does not need to be specified if the CSS Style field is
already used to specify a width.

maximumInputLength
= <number> Specifies the maximum number of characters that may be entered.

maximumSelectionSize
= <number>

Specifies the maximum number of items that can be selected. After this number has
been reached, the drop-down list will show a message returned by the
formatSelectionTooBig function.

closeOnSelect = false
Specify this option to prevent the drop-down list from closing when a value is selected.
This parameter is not recommended when dynamic search is enabled, as a dynamic list
does not contain all possible items that may be selected.

containerCss.<style-
name> = <style-value>

Specify CSS properties that will be applied to the containing element of the “select2”
control.

dropdownCss.<style-
name> = <style-value>

Specify CSS properties that will be applied to the drop-down list element of the “select2”
control.

Table 94: Additional Parameters, Select2 Options Field

For in-depth technical information about these functions, refer to the Select2 programmer’s documentation at
http://ivaynberg.github.com/select2/. For information on configuring AirGroup for LDAP user search, see
"Configuring LDAP User Search for AirGroup" on page 364.

Select2 Hook Details
The Select2 Hook field may be used to attach certain dynamic behaviors to the “select2” control.

This field must contain the definition of a JavaScript function that takes a single argument. The argument to
this function specifies certain behavioral properties of the control. The function should return the argument,
updated as necessary to specify the behavior that you want.
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To change the behavior of the “select2” control, you need to attach a JavaScript function definition to one or
more properties of the hook function’s argument.

The hook function may also set or update any of the properties specified in the “Select2 Options”.

A simple example is included as the default value with the airgroup_shared_user field:
function (args) {
args.formatInputTooShort = function (text) {
return "Start typing a user name.";
};
return args;
}

The functions that may be defined by the “Select2 Hook” function shown in the following table:

Function Description

sortResults(results,
container, query)

Used to sort the results list for searching right before it is displayed. Useful for sorting
matches by relevance to
the user’s search term.

formatNoMatches
(term) Function used to render the “No matches” message. Should return an HTML string.

formatSearching() Function used to render the “Searching…” message that is displayed while a search is in
progress. Should return an HTML string, or null to disable the message.

formatInputTooShort
(term, minLength)

Function used to render the “Search input too short” message. Should return an HTML
string.

formatSelectionTooBig
(maxSize)

Function used to render the “You cannot select any more choices” message. Should
return an HTML string.

Table 95: Select2 Hook Functions

For in-depth technical information about these functions, refer to the Select2 programmer’s documentation at
http://ivaynberg.github.com/select2/. For information on configuring AirGroup for LDAP user search, see
"Configuring LDAP User Search for AirGroup" on page 364.

API Services

API Services includes all APIs and API-related privileges that are available for ClearPass Guest. To work with API
services, go to Administration > API Services.

This section includes:

l "API Clients" on page 371

l "Configuring the API Framework Plugin" on page 373

l "Setting API Privileges in Operator Profiles" on page 374

l "About OAuth" on page 375

l "SOAP Web Services and API" on page 379

l "The XML-RPC Interface and API" on page 403
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API Clients

You can create and manage multiple API clients. You may configure each API client's operator profile, grant
type, refresh token, and other information.

To work with API clients, go to Administration > API Services > API Clients. The API Clients list view opens.

All API clients that have been created are included in the list. You can click an API client's row in the list for
additional options:

Field Description

Edit Edit theAPI client's attributes. The Edit API Client form opens. For more information, see
"Creating and Editing API Clients" on page 371.

Disable Disables the API client. You will be asked to confirm the action. Disabling an API client also
invalidates any access tokens, refresh tokens, or authorization codes associated with it.

Enable Enables a disabled API client.

Delete Deletes the API client. You will be asked to confirm the deletion.

Create API Client Opens the Create API Client form. For more information, see "Creating and Editing API
Clients" on page 371.

Table 96: AirGroup List Options

Creating and Editing API Clients
To create or edit an API client, go to Administration > API Services > API Clients and either click the Edit
link for an API client in the list, or click the Create API client link in the upper-right corner. The Edit API Client
or Create API Client form opens. The procedure is the same for both forms.
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Field Description

Client ID (Required) Name for the API client. Enter a unique string.
(Use this value in the OAuth2 client_id parameter)

Description Additional information or comments about the API client.

Enabled If selected, enables the API client.

Operator Profile

(Required) Specifies the role that can access this API client, and determines which API
objects and methods are available. Options include:
l API Guest Operator
l BYOD Operator
l Device Registration
l Help Desk
l Network Administrator
l Null Profile
l Operations and Marketing
l Read-only Administrator
l Receptionist
l Super Administrator

Grant Type

(Required) Specifies the OAuth2 grant type authentication method to be used with this API
client ID. Only the selected authentication method will be allowed. Options include:
l Client credentials (grant_type=client_credentials)
l Username and password credentials (grant_type=password)

Public Client If selected, the API client will be a public (trusted) client, and will not require a client secret.

Refresh Token If selected, an OAuth2 refresh token may be used to obtain an updated access token.
(Use grant_type=refresh_token)

Client Secret
If a client secret is required, it is displayed in this field. Record this value for reference.
When the API client is created, this value is encrypted and cannot be displayed again. When
you edit an existing API client, this field includes the option to generate and display a new

Table 97: Create API Client
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Field Description

secret.
(Use this value in the OAuth2 client_secret parameter)

Access Token
Lifetime

Specifies the lifetime of the OAuth2 access token. Enter a number in the first text field, and
use the drop-down list to indicate the unit of time. Options include:
l seconds
l minutes
l hours
l days
l weeks

Refresh Token
Lifetime

Specifies the lifetime of the OAuth2 refresh token, if one was specified. Enter a number in
the first text field, and use the drop-down list to indicate the unit of time. Options include:
l seconds
l minutes
l hours
l days
l weeks

Create API Client Creates the API client. It is included in the API Clients list view.

Configuring the API Framework Plugin
The API Framework plugin supports OAuth2 authentication and authorization, and provides all application
programming interface (API) services for ClearPass Guest. Settings you can configure for this plugin include the
access token lifetime, the authorization code lifetime, the refresh token lifetime, and the API logging level.

Field Description

Access Token
Lifetime

(Optional) Specifies the default lifetime of an OAuth2 access token. Unless it is changed, the
default value is 8 hours. To change the value, enter a number in the first text field, and use the
drop-down list to indicate the unit of time. Options include:
l seconds
l minutes
l hours
l days
l weeks
The value for this parameter may also be configured separately for each API client (see "Creating

Table 98: API Framework Plugin Configuration
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Field Description

and Editing API Clients" on page 371).

Authorization
Code
Lifetime

(Optional) Specifies the default lifetime of an OAuth2 authorization code. Unless it is changed, the
default value is 15 minutes. To change the value, enter a number in the first text field, and use the
drop-down list to indicate the unit of time. Options include:
l seconds
l minutes
l hours
l days
l weeks
The value for this parameter may also be configured separately for each API client (see "Creating
and Editing API Clients" on page 371).

Refresh
Token
Lifetime

(Optional) Specifies the default lifetime of an OAuth2 refresh token. Unless it is changed, the
default value is 14 days. To change the value, enter a number in the first text field, and use the
drop-down list to indicate the unit of time. Options include:
l seconds
l minutes
l hours
l days
l weeks
The value for this parameter may also be configured separately for each API client (see "Creating
and Editing API Clients" on page 371).

API Logging

(Required) Specifies the logging level for API-related events. Options include:
l Disabled - do not log API-related events
l Standard (Recommended) - log basic information
l Extended - log additional information (this option logs all API calls)
l Debug - log debug information
l Trace - log all debug information

Save
Configuration Commits your changes.

Setting API Privileges in Operator Profiles
To use ClearPass Guest's API services, the API privileges must be set up in the user's operator profile. Existing
operator profiles that have the Administrator privilege set to Full Access must be updated to specifically include
the appropriate privilege in order for XML-RPC clients to work.

To set up API privileges:

1. Go to Administration > Operator Logins > Profiles, and either click the Edit link for an existing profile in
the list or click the Create a new operator profile link to create a new profile. The Operator Profile
Editor form opens.
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2. In the Privileges field, select Custom in the API Services drop-down list. The field expands to show the
API privileges. Privileges included here are:

l Allow API Access

l Configure SOAP Web Services

l List SOAP Web Services

l Manage API Clients

l SOAP API

l XMLRPC API

3. For the Allow API Access privilege, select the Allow Access radio button.

4. For each of the remaining privileges in the list, select the appropriate access level. Access levels include:

l No Access

l Read Only

l Full

l Allow Access

5. If you want to allow the API operator profile to query for Guest Manager configuration settings, set the
Manage Customization privilege to Read Only access.

6. Complete the rest of the settings appropriately for the operator profile and then click Save Changes.

About OAuth
The OAuth 2 RFC 6749 specification for accessing a new set of modern API’s is supported by ClearPass 6.4 and
later. All OAuth2 requests MUST use the SSL endpoint available at https://<ClearPass IP or
FQDN>/api/oauth.

OAuth 2.0 is a simple and secure authorization framework. It allows applications to acquire an access token for
ClearPass through a variety of workflows supported within the OAuth2 specification. After an application has
an access token, it can access the various API’s serviced by ClearPass either to configure the platform itself or
act on behalf of a ClearPass Operator. To use OAuth for authorization:
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l Decide on the use case for API Access — Either ClearPass administrative configuration, or managing
ClearPass data on behalf of a ClearPass Operator (Guest Management, Onboarded devices, Device
Registration etc).

l Create a ClearPass API Client definition that matches the use case above — Either Service Account (client
credentials) or Authorized User Account (resource owner password), respectively.

l Request an Access Token using the Client ID details from the ClearPass API client definition created in the
previous step.

l Make authorized API calls to the ClearPass APIs by including the Bearer <access_token> in the HTTP
Authorization header.

OAuth Basics
The best way to understand the different use cases for OAuth2 is to start with the various roles that make up a
possible OAuth2 transaction.

Resource Owner

The resource owner is the person or application that owns the data that is to be shared. For example, a user on
Facebook or Twitter could be a resource owner, in the same way as an Operator on ClearPass. The resource
they own is their data. Typically the resource owner is thought of as a person but it could also be an
application. The OAuth 2.0 specification supports different workflows for each of these use cases.

Resource Server

The resource server is the server hosting the resources. For example, either a platform such as Facebook or a
ClearPass Server could be considered a resource server. It is essentially the server hosting the protected
content that will be accessed via the APIs.

Client Application

The client application is the application requesting access to the protected resources stored on the resource
server.

Authorization Server

The authorization server authorizes the client application to access the resources of the resource owner. The
authorization server and the resource server can be deployed as part of the same server, but the OAuth 2.0
specification does not dictate whether they should be co-located or separated. For simplicity, the rest of this
document assumes the resource server and authorization server are co-located on the same server.

OAuth2 Client or App
Before any OAuth transactions can be processed, the first step is to register a new app with the service (API
Client definition in ClearPass). When you register a new app with the Authorization Server, you specify basic
information such as the application name and the OAuth2 grant type. Depending on the grant type selected, a
redirect URI may also be requested in order to whitelist the redirect destination for OAuth2 workflows that are
initiated from Web server, browser-based, or mobile apps.

The output of registering an OAuth2 app is a client id and client secret.

Client ID and Secret
After you register your app, you will receive a client ID and a client secret. The client ID is considered public
information, and is used to build login URLs, or is included in JavaScript source code on a page. The client secret
must be kept confidential. If a deployed app such as JavaScript or native apps cannot keep the secret
confidential, then the secret is not used.
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Redirect URI
During registration of the new OAuth app, often a redirect URI must be included. This redirect URI is used when
a resource owner grants authorization to the client application. When a resource owner has successfully
authorized the client application via the authorization server, the resource owner is redirected back to the client
application, to the redirect URI. It is important to maintain the redirect URI accurately as this forms a key
security mechanism of OAuth2 to whitelist the redirect destination and avoid hi-jacking of the authorization
workflow, as publicized in articles such as http://tetraph.com/covert_redirect/oauth2_openid_covert_
redirect.html.

State
To protect the security of your users by preventing request forgery attacks, the client app should create an
anti-forgery state token. The first step is to create a unique session token that holds state between your app
and the user's client. The app later match this unique session token with the authentication response returned
by the Authorization server to verify that the user is making the request, and not a malicious attacker. These
tokens are often referred to as cross-site request forgery (CSRF) tokens.

Authorization Grant Types for OAuth
OAuth 2 provides several "grant types" for different use cases. ClearPass supports the following defined grant
types:

l Password— For logging in with a username and password

l Client credentials— For application access

Resource Owner Password Grant Type

OAuth 2 also provides a password grant type, which can be used to exchange a username and password for an
access token directly. This is often compared with HTTP basic authentication because the same credentials are
being exchanged, but it has the same security benefits as the other OAuth2 grant types in expiring the access
token and the ability to refresh the access token without the need to cache or resubmit the user credentials.

Since this requires the application to natively collect the user's credentials, this grant type should only be used
for apps with a direct relationship (first party) with the authorization server. A real world example would be the
official mobile app for a social networking site versus allowing 3rd party developers to leverage APIs to develop
their own mobile experience for the social platform (they should be leveraging the Implicit flow).

The following diagram shows the transaction flow of password grant type.
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1. The user enters credentials directly into the app’s native user interface. The app should not cache user
credentials under any circumstances.

2. The app submits the user credentials to the authorization server. Credentials include grant_type=password,
user, password, client_id, and client_secret. The client_secret is not required if the OAuth2 app is
defined as a public client.

3. The resource server returns the access token to use in subsequent API calls. This includes access_token,
expiry time, token_type=bearer, and refresh_token.

4. The app includes the access token in the HTTP Authorization header. This includes the Bearer access_
token.

5. The resource server returns the authenticated API payload.

Client Credentials Grant Type

The simplest grant type offered by OAuth2 doesn’t include a 3rd party user at all and is essentially intended for
server-to-server integrations for updating the application server configuration. In this case, applications need a
way to get an access token for their own user and need to do this outside the context of any specific user.
OAuth provides the client credentials grant type for this purpose.

Given the simplicity of this grant type, many developers may use its basic workflow to recover an access token
so they can quickly get started with the APIs. That being said, client credentials should never be used in
production where an untrusted 3rd party developer has access to the client secret.

The following diagram shows the transaction flow of the client credentials grant type.

1. The first-party app submits an access token request to the authorization server. This includes grant_
type=client_credentials, client_id, and client_secret.

2. The resource server returns the access token to use in subsequent API calls. This includes access_token,
expiry time, and token_type=bearer.

3. The app includes the access token in the HTTP Authorization header. This includes Bearer access_token.

4. The resource server returns authenticated API payload.
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Application Service Accounts for OAuth
Google APIs such as the Prediction API and Google Cloud Storage can act on behalf of your application without
accessing user information. In these situations your application needs to prove its own identity to the API, but
no user consent is necessary. Similarly, in enterprise scenarios, your application can request delegated access to
some resources.

For these types of server-to-server interactions you need a service account, which is an account that belongs to
your application instead of to an individual end-user. Your application calls Google APIs on behalf of the service
account, and user consent is not required. (In non-service-account scenarios, your application calls Google APIs
on behalf of end-users, and user consent is sometimes required.)

SOAP Web Services and API

SOAP Web services provide a way of transferring data across the Internet to integrate Web-based applications.
Web services let businesses share data and processes programmatically, and can be added to a user interface
to provide functionality.

To access this feature in ClearPass Guest, you must have the SOAP Web Services plugin installed.

Viewing Available Web Services
To view the Web services available in ClearPass Guest:

1. Go to Administration > Web Services > List Web Services. The Available Web Services list view opens.

2. To view details for a service, click its image in the Web Service field. The row expands to include the Service
URL and Service Info fields for that Web service.
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3. The Service Info field briefly describes the processes this Web service provides.In the Service URL field,
you can click the link to view the Web Service Description Language (WSDL) that defines that service. The
WSDL opens in a new tab.

4. When you have finished reviewing the available Web services, click Done.

Configuring Web Services
To configure the SOAP Web Services plugin:

1. Go to Administration > Web Services > Configure Web Services. The Configure Web Services form
opens.
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2. To allow operators to make WSDL requests without being logged in, mark the check box in the WSDL
Access field.

3. Use the counter in the Maximum Request Size field to set the maximum size in kilobytes that will be
allowed for a SOAP request.

4. In the SOAP Debugging row, use the drop-down list to set the debugging level for SOAP service requests.
Options include:

l 1 -- Log SOAP errors only

l 2 -- Log SOAP errors with full request body

l 3 -- Log all SOAP requests

l 4 -- Log all SOAP requests with full details

5. When your changes are complete, click Save Configuration. The configuration is applied to all SOAP Web
services in the application.

SOAP API Introduction
The SOAP interface is available to third-party applications that will integrate with the ClearPass Guest Visitor
Management Appliance.

Audience
This API is intended for developers of applications that must interoperate with a ClearPass Guest-based visitor
management solution. Solution developers are assumed to be familiar with HTTP-based Web services and the
associated concepts and technologies related to these services, including Extensible Markup Language (XML),
XML Schemas, Web Service Definition Language (WSDL), and the Simple Object Access Protocol (SOAP).

Many software development tools provide assistance with Web services integration. While this document
cannot cover all possible integration methods, examples are given using Microsoft Visual C# 2008.

API Documentation Overview
l "About the SOAP API" on page 382 provides a high-level overview of the API, explaining what it is and how

to use it.

l "Integration Example" on page 386 provides an integration example to demonstrate the usage of SOAP web
services.

l "API Documentation" on page 391 contains a detailed list of the available API calls, including documentation
about each method defined by the web services.

Disclaimer
The topics of network design, security architectures, and visitor access are complex subjects, and no single
document can hope to cover all of the possible combinations of network equipment, network design,
deployment requirements, and device configurations, nor can all the possible security implications for a
particular recommendation be covered. Therefore, while you read this document, it is best to consider it as a
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guide to developing your own understanding of the network design topics covered, and as a basis for further
investigation.

About the SOAP API
The ClearPass Guest SOAP API provides direct access to the underlying functionality of ClearPass Guest.
Developers wishing to provide integrated applications can make use of this API to programmatically perform
actions that would otherwise require manual operation of the user interface.

Architecture Overview

The ClearPass Guest software is built using multiple layers:

l At the lowest level, the kernel provides basic functions common to the entire system. This includes the Web
interface framework, appliance operating system, and runtime support services.

l The network layer provides critical networking support, including the RADIUS server and the ability for
network administrators to manage and control the networking aspects of the appliance.

l The services layer provides one or more implementations of application services that are used by the layers
above. Examples of these services include managing a user database used for AAA, handling the
authentication of operators, and providing translated text resources.

l The presentation layer supplies the tools and framework necessary for the appliance software to interact
with the outside world. The basic presentation layer services include authentication checks, session
establishment, input checking, validation and conversion, and command execution. Both SOAP and HTML
presentation methods are supplied, which adapt the underlying basic presentation to appropriate
conventions suitable for a machine-to-machine or human-to-machine interaction.

l The application layer provides the page templates, business logic, and the concrete features making up
visitor management applications such as Guest Manager or Hotspot Manager. These applications are built
using the services provided by the lower layers.

Authentication and Access Control

SOAP API requests require that operator authentication information is provided using HTTP Basic
authentication.
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Page privileges are applied to SOAP authenticated sessions in the same way as the HTML user interface.
However, SOAP access also requires the SOAP API privilege to be granted.

Refer to "Using the SOAP API" on page 384 for details on creating an operator profile with suitable privileges
for SOAP API access.

HTTP headers

When making a SOAP API request, the SOAPAction HTTP header is required. The value of this header indicates
the type of request being made.

The Content-Type header must be specified as either text/xml or the application/soap+xml MIME type.

The Authorization header must contain a valid HTTP Basic authentication string, as specified in RFC 2617.

Character Set Encoding

ClearPass Guest supports the Unicode character set, using the UTF-8 encoding. Although other character sets
are supported, it is recommended that all SOAP API requests be constructed using the UTF-8 character set, as
this eliminates the need for character set conversions while also allowing all Unicode characters to be
expressed directly.

The character set encoding of a request may be specified using the Content-Type header, for example:
Content-Type: text/xml; charset=utf-8

SOAP Faults

SOAP 1.1 defines a generalized fault response which is used to indicate that the server could not process the
body of the request. The SOAP <Fault> element contains a description of the error, which is divided into a
<faultcode> that briefly summarizes the problem, and a <faultstring> that contains a description of the
error.

Additionally, the API-specific details of the error are provided in a <details> element.

The following table lists the fault codes and corresponding descriptions that might be encountered while using
the SOAP API:

Fault Reason for Fault

Client.BadRequest Request exceeds the maximum allowable size. Increase the
maximum SOAP request size, or reduce the size of the request.

Client.Authentication Invalid username or password. Check that the credentials supplied
are correct.

Client.MethodNotFound The SOAP method request was not found.

Client.Error
Another non-specific client error occurred. Check the
<faultstring> for more details.

Server.MethodNotImplemented The SOAP method requested is not implemented.

Server.Error
An error occurred while attempting to convert data, or another non-
specific server error occurred. Check the <faultstring> for more
details.

Table 99: Fault Codes and Descriptions
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Certain conditions might also cause errors that are not reported as a fault. These cases are typically caused by
errors in constructing the SOAP request. In these cases, a non-XML result may be returned; check the body of
the result, or the application log for details about the cause of the error.

Using the SOAP API
This section describes how to access, configure, and debug Web Services, create a SOAP API operator, and
access the WSDL.

Accessing SOAP Web Services

Use the List Web Services command link available from the Administration page, or go to Administration >
Web Services, to access the SOAP Web Services user interface.

Configuring SOAP Web Services

Use the Configure Web Services command link to make changes to system settings affecting the SOAP API.

SOAP Debugging

Select a higher level for the SOAP Debugging configuration option to log additional details to the application
log.

To access the application log, go to Administration > Plugin Manager > Application Log.

At the highest debugging level of 4, every SOAP request and response will be logged including full HTTP headers
and contents, which may be useful when trying to identify the exact cause of a problem.

Creating a SOAP API Operator

The SOAP API requires both authentication and authorization components.

l Authentication means that suitable credentials must be provided via the HTTP “basic” access
authentication method. A valid ClearPass Guest operator username and password must be provided.

l Authorization for the SOAP API requires that the corresponding user account has sufficient privileges to
perform the requested operation. In the ClearPass Guest role-based access control system, this requires at
a minimum that the SOAP API privilege is granted, as well as any additional privileges required for the
operation requested.

While the default administrative account will automatically gain SOAP API privileges, for security reasons it is
strongly recommended that a specific operator profile be created for use by SOAP API clients.
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To create a suitable operator profile, go to Administration > Operator Logins > Profiles, then click the
Create a new operator profile link.

In the Privileges list, select either Full Access for the SOAP Web Services privilege, or choose Custom… and
then select either Read Only or Full for the SOAP API privilege.

You should also select suitable permissions for the Guest Manager privilege, depending on the type of
requests that will be made.

An example profile is shown below.

After you have created a suitable operator profile, create the operator login. See "Local Operator
Authentication" on page 462 and "External Operator Authentication" on page 463, or refer to the "Configuring
LDAP Operator Logins" article on Arubapedia.
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Accessing the WSDL

Use the List Web Services command link to browse the available Web services and obtain additional details
about each one.

In the Web Service field, click the icon for GuestManager Web Services to view the Service URL and
additional information about the service.

If the "Allow anonymous access to WSDL" option is specified in the SOAP Web Services configuration, accessing the
WSDL through the specified Service URL does not require logging in to the ClearPass Guest user interface. For more
information, see "Configuring Web Services " on page 380.

Integration Example
In this section, a simple console application will be developed using Microsoft Visual C# 2008 Express Edition.
The “Add Service Reference” feature of this development tool will be used to automatically create a Web service
interface which can then be used from the code.

Create a New Project

From the File menu, choose New Project.
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Add Service Reference

In the Solution Explorer, right-click the References folder, and click Add Service Reference.

The Add Service Reference dialog box appears. Enter the Service URL for the GuestManager Web Services into
the Address box, and click the Go button.

The WSDL is downloaded, and a list of the Web services and operations found is displayed.

In the Namespace text field, type in a name. This name is used to organize the automatically generated code
that interfaces with the Web service.
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Click the OK button to create the Web service reference.

To browse the created classes, double-click the GuestManager service reference. The Object Browser will be
displayed with the selected namespace highlighted.

Configuring HTTP Basic Authentication

Performing a simple API call, such as the “Ping” operation described in "Operations" on page 394, can be used
to verify that the Web service is correctly configured and ready for use.

Because the SOAP API requires HTTP Basic authentication, ensure that you have a suitable operator profile and
operator login credentials, as explained in"Using the SOAP API" on page 384.

Configuring the Web service reference to use authentication requires editing the app.config file to make two
changes:

l The mode attribute of the <security> tag must be changed to “TransportCredentialOnly”.

l The clientCredentialType attribute of the <transport> tag must be changed to “Basic”.

The updated app.config file is shown below, with the appropriate changes highlighted.
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Performing an API Call

This section outlines the C# code required to use the Web service.

First, add a using declaration for the namespace containing the Web services:
using SoapGuestManager.GuestManager;

The following code can now be added to invoke the Ping operation and display the result.
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When invoked, this performs the Ping operation and displays the following output:

Securing Web Services Using HTTPS

Because HTTP Basic authentication is insecure, it is strongly recommended that the HTTPS transport be used
for all SOAP API calls.

To use HTTPS as the transport for SOAP API requests, the following changes should be made to the application
configuration file:

l The mode attribute of the <security> tag must be changed to “Transport”.

l The address attribute of the <endpoint> tag must be changed to a URL including the “https:” prefix.

The updated app.config file is shown below, with the relevant changes highlighted.

Additionally, if a self-signed certificate is being used on the remote server, you will need to provide a suitable
ServerCertificateValidationCallback implementation to validate the peer’s certificate.

The following code is a minimal implementation that accepts all server certificates without verification:
// Trust self-signed certificates
System..Net.ServicePointManager.ServerCertificateValidationCallback =

((sender, certificate, chain, sslPolicyErrors) => true);

In a production environment, it is strongly recommended that you deploy an SSL certificate that is signed by a trusted
root CA known to all parties, and use the built-in server certificate validation procedures. This will ensure the security
of the transaction cannot be compromised by a man-in-the-middle attack.
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API Documentation
This section describes the following:

l "XML Namespaces" on page 391

l "SOAP Addressing" on page 391

l "Types" on page 391

l "Operations" on page 394

XML Namespaces

The XML namespace for the GuestManager Web Services is:

http://www.amigopod.com/go/GuestManager.wsdl

The table below indicates additional XML namespaces that are referenced:

Component XML Namespace

SOAP Envelope http://schemas.xmlsoap.org/wsdl/soap/

SOAP Encoding http://schemas.xmlsoap.org/soap/encoding/

WSDL http://schemas.xmlsoap.org/wsdl/

XML Schema http://www.w3.org/2001/XMLSchema

Table 100: XML Namespaces

SOAP Addressing

Web Service Endpoint

The endpoint of the SOAP service is located at the relative URL:

soap_guestmanager.php.

This path is relative to the full Guest URL, which can be constructed using http: or https: and the fully-qualified
domain name of the ClearPass Guest appliance.

l Example: http://192.168.2.122/guest/soap_guestmanager.php

l Example: https://192.168.2.122/guest/soap_guestmanager.php (secure)

Web Service Definition

The WSDL for the web service may be accessed by appending ?wsdl to the service URL.

l Example: http://192.168.2.122/guest/soap_guestmanager.php?wsdl

Types

This section describes the types defined in the WSDL schema.

EmptyType

This type must be empty, that is, containing zero child elements.

l Example:

ErrorFlagType
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The error flag indicates if the operation completed successfully.

Only the values zero (0) and one (1) are supported.

l A successful operation is indicated with:

l A failed operation is indicated with:

IdResultType

Standard result type), with an optional <id> element.

l Example:

l Example:

IdType

Specifies a user ID. The user ID is a positive integer value, starting at 1.

l Example:

ResultType

Operations return a standard result type. The <error> flag indicates if the operation completed successfully. If
the operation failed, the <message> contains a description of the error.

l Example of a successful operation:

l Example of a successful operation with message:

l Example of an unsuccessful operation:
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UserResultType

Standard result type, with an optional <user> element.

l Example of a successful operation:

l Example of an unsuccessful operation:

UserType

The User type defines a visitor account, which consists of a number of fields.

The fields available may be customized in Guest Manager. Go to Guest Manager > Configuration > Fields
to create new fields or modify existing fields.

Adding or removing fields will update the UserType schema in the WSDL for GuestManager Web Services. Ensure
that you update any clients using this WSDL if the fields are modified.

Each field of the visitor account corresponds to an XML element with the same name as the field.

All fields within the UserType schema are marked as optional; however, certain operations may require that
particular fields are provided.

l Example of a user definition:
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Operations

CreateUser

Creates a new user account.

l The standard business logic for visitor account creation applies to visitor accounts created with the SOAP
API. For details, refer to the section “Business logic for account creation” in the ClearPass Guest User Guide,
or search for this term in the online help.

l The creator_accept_terms field must be set to the Boolean value “true” in order to create an account.

l A value for the role_id field must be specified to create a visitor account. The SOAP API user must also be
permitted to create visitor accounts with this role.

Example code implementing visitor account creation:

Anexo 11 ITEM 01 (0592523)         SEI 0008478-63.2018.6.02.8000 / pg. 3421



Example request for CreateUser:

Successful response:

Failure response:

DeleteUser

Deletes a user account by ID or matching fields
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l This operation deletes a single visitor account that matches all of the field values specified in the user
parameter.

l Exactly one account must match; if more than one match is found, or if no match is found, an error will be
returned and no visitor accounts will be deleted.

Example code implementing visitor account deletion:

Example request for DeleteUser:

Successful response:
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Failure response:

EditUser

Modifies properties of a user account by ID.

l This operation modifies the properties of a visitor account to match the field values specified in the user

parameter.

l The id field must be specified to indicate the ID of the visitor account to modify. This field is assigned by the
system when the visitor account is created and cannot be changed.

Example code implementing visitor account modification:
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Example request for EditUser:

Successful response:

Failure response:

FindUser

Returns properties of a user account by matching fields.

Anexo 11 ITEM 01 (0592523)         SEI 0008478-63.2018.6.02.8000 / pg. 3425



l This operation locates a single visitor account that matches all of the field values specified in the user

parameter.

l Exactly one account must match; if more than one match is found, or if no match is found, an error will be
returned.

l If a visitor account was found, its properties will be returned in the <user> element of the result.

Example code implementing search for a visitor account based on a username.

Example request for FindUser:
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Successful response:

Failure response:

GetUser

Returns properties of a user account by ID.

l Returns a <user> element corresponding to the visitor account with the specified ID.
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l If the specified ID is invalid, no <user> element is returned and the <error> flag is set to 1.

Example code implementing a guest lookup operation:

Example request for GetUser:

Successful response:

Failure response -- for example, user ID not found:
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Ping

Checks that the SOAP server is alive.

l Returns a standard result type with the message set to "pong".

Example code implementing a Ping test operation.

Example request for Ping:

Successful response:
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The XML-RPC Interface and API
This section describes the XML-RPC interface available to third-party applications that will integrate with the
ClearPass Guest Visitor Management Appliance.

Audience:

l Developers of integrated applications. Some familiarity with HTTP based web services and XMLRPC is
assumed.

l System administrators of the ClearPass Guest application.

System Requirements:

l ClearPass Guest 6.1.0 (minimum)

l XML-RPC client

For more details about XML-RPC, or to read the XML-RPC specification, visit http://xmlrpc.scripting.com/.

This section includes the following:

l "About the XML-RPC API" on page 403

l "Accessing the API" on page 406

l "Invoking the API" on page 408

l "Method Summary" on page 409

l "API Documentation" on page 409

About the XML-RPC API
The ClearPass Guest XML-RPC API provides direct access to the underlying functionality of the ClearPass Guest
Visitor Management Appliance. Developers wishing to provide integrated applications can use this API to
programmatically perform actions that would otherwise require manual operation of the user interface.

Architecture Overview

The ClearPass Guest VMA software is built using multiple layers of software.

At the lowest level, the kernel provides basic functions common to the entire system. This includes the Web
interface framework, appliance operating system, and runtime support services.
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The network layer provides critical networking support, including the RADIUS server and the ability for network
administrators to manage and control the networking aspects of the VMA.

The services layer provides one or more implementations of application services that are used by the layers
above. Examples of these services include managing a user database used for AAA, handling the authentication
of operators, and providing translated text resources.

The presentation layer supplies the tools and framework necessary for the VMA software to interact with the
outside world. The basic presentation layer services include authentication checks, session establishment, input
checking, validation and conversion, and command execution. Both XML-RPC and HTML presentation
methods are supplied, which adapt the underlying basic presentation to appropriate conventions suitable for a
machine-to-machine or human-to-machine interaction.

The application layer provides the page templates, business logic, and the concrete features making up visitor
management applications, such as Guest Manager or Hotspot Manager. These applications are built using the
services provided by the lower layers.

API Symmetry

Because ClearPass Guest VMA applications are built using the framework supplied by the presentation layer,
there is a direct symmetry between application features provided to operators using a Web browser (HTML
presentation), and application features provided to external applications using the XML-RPC presentation.

In particular, the following items are shared between HTML and XML-RPC presentations:

l Access control

l Parameter names

l Parameter validation rules

l Customized fields and their rules

Access Control

Page privileges are applied to XML-RPC authenticated sessions in the same way as the HTML user interface.
However, XML-RPC access also requires the XML-RPC API privilege to be granted.

Parameter Names

The parameter names passed to the XML-RPC interface are the same as the field names in the HTML user
interface.

Parameter Validation

Each field of the forms in the HTML user interface is subject to validation according to the rules defined for that
field. The same rules also apply to XML-RPC parameters.

If a required field is missing, or an invalid value for a field is supplied, an error is generated by the presentation
layer and returned to the XML-RPC client.

Field Customization

Some forms in the HTML user interface are customizable. New fields may be defined (for example, stored with
a guest account) and used as part of the form in the presentation layer. Policy-based processing of fields
includes form validation, data conversion and input formatting, and user interface metadata (for example, the
list of valid options for a multiple-choice “dropdown” control).

These custom fields are automatically inherited as XML-RPC parameters, and the same policy-based processing
is applied to them.
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Parameter Types

The XML-RPC specification supports a wide range of data types. The following data types are supported by the
XML-RPC presentation layer:

Data Type Description

Array Associative array using numeric keys with a 0-based index

Boolean True or false

Flag Scalar value of 0 or 1, implicitly Boolean

Integer Integer, 32-bit range

Number Numeric value, floating point OK

Scalar Non-array value

String String, UTF-8 encoded

Struct Associative array using string keys
May be nested (shown in the syntax as first.second, etc.)

Table 101: Data Types Supported by XML-RPC

Data Representation

Unless otherwise specified, all strings should be considered to be UTF-8 encoded Unicode.

Dates and times are represented in an ISO-8601 compatible format:
YYYY-MM-DD hh:mm:ss

XML-RPC Faults

An XML-RPC Fault is a specific kind of return value indicating that an error has occurred in the presentation
layer. The return value is a struct containing three named values:

Name Type Description

error Flag Set to 1 for an XML-RPC Fault

faultCode Integer Status code indicating the cause of the fault

faultString String Description of the fault

Table 102: XML-RPC Faults

This type of return might appear as:
'error' => 1,
'faultCode' => 401,
'faultString' => 'Invalid username or password',

These are the predefined XML-RPC Fault codes:
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Code Description

401 Authentication problem -- invalid username or password

404 File implementation of XML-RPC method not found

501 XML-RPC implementation not found

502 XML-RPC method registration failed

503 XML-RPC server creation failed

504 Access denied

505 No XML-RPC implementation for this page

Table 103: XML-RPC Faults

Accessing the API
Accessing the API requires an operator account with a profile that has the XML-RPC API privilege, plus any
privileges required for the API calls. You will first create the operator profile, then create the role, a local user,
and a translation rule to map the role name to the profile. Some steps are performed in ClearPass Guest and
some steps are performed in ClearPass Policy Manager.

Creating the Profile

To create a sample XML-RPC API profile:

1. In ClearPass Guest, go to Administration > Operator Logins > Profiles and click the Create a new
operator profile link. The Operator Profile Editor form opens.

2. Enter a name and description that clearly identify the profile.

3. In the Access area, mark the Allow operator logins check box.

4. In the Administrator drop-down list, choose Custom. The row expands to include additional options.

5. For the XMLRPC API option, mark the Allow Access radio button.

6. In the Guest Manager drop-down list, choose Full Access.
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7. Click Save Changes. The profile is added to the Operator Profiles list.

Creating the Role

After you create the profile, the next step is to create the role:

1. In ClearPass Policy Manager, go to Configuration > Identity > Roles and click the Add User link. The Add
New Role form opens.

2. Enter a name and description that clearly identify the role.

3. Click Save. The role is added to the Roles list.

Creating the Local User

After you create the role, you create the local user:

1. In ClearPass Policy Manager, go to Configuration > Identity > Local Users and click Add User. The Add
Local User form opens.
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2. In the Role drop-down list, choose the XML-RPC Operator role you created.

3. Complete the rest of the fields appropriately, then click Add. The new XML-RPC operator is added the Local
Users list.

Creating the Translation Rule

After you have created the profile, role, and local user (operator), create a translation rule to map the role name
to the operator profile.

1. In ClearPass Guest, go to Administration > Operator Logins > Translation Rules and click the Create
new translation rule link. The Edit Translation Rule form opens.

2. In the Name field, enter a descriptive name for the translation rule. In the example shown above, the
translation rule is to check that the operator is an XML-RPC user, hence the name MatchXML-RPC.

3. Mark the Enabled check box to enable this rule after you create it. If you do not select this check box, the
rule you create will appear in the rules list, but will not be active until you enable it.

4. In the Matching Rule drop-down list, select equals.

5. In the Value field, enter the name of the XML-RPC Operator role you defined.

6. In the On Match drop-down list, select Assign fixed operator profile. The form expands to include the
Operator Profile row.

7. In the Operator Profile drop-down list, select the XML-RPC profile.

8. If you want to use multiple translation rules, select the Fallthrough check box.

9. Click Save Changes.

The user you created can now use the XML-RPC API functions.

Invoking the API
An XMLRPC method call consists of:

l An XML document specifying the method name and parameters,

l sent as a HTTP POST with Content-Type: text/xml,

l using HTTP Basic user authorization,

l at https://amigopod/xmlrpc.php
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SSL Security

Different levels of certificate validation checks may be necessary, depending on the SSL certificate that has
been installed. This corresponds to the user interface provided by Web browsers for certificate trust and
verification.

The examples presented in this document assume a self-signed certificate has been installed, and reduce the
level of SSL verification accordingly. In a secure environment, make use of the peer verification that SSL
provides by either installing an SSL certificate signed by a well-known certificate authority, or issue your own
certificates from a network’s certificate authority.

Method Summary
These methods are currently available:

Method Name Synopsis

amigopod.guest.change.expiration Change the expiration time of a guest account

amigopod.guest.create Create a new guest account

amigopod.guest.delete Disable or remove a guest account

amigopod.guest.edit Change one of more properties of a guest account

amigopod.guest.enable Enable a guest account

amigopod.guest.get List one or more guest accounts

amigopod.guest.list List guest accounts

amigopod.guest.reset.password Reset a guest account's password

amigopod.mac.create Create a new MAC device account

amigopod.mac.edit Change one or more properties of a device account

amigopod.mac.list List MAC device accounts

Table 104: XML-RPC Method Summary

For more details on these methods, refer to "API Documentation" on page 409.

API Documentation
This section describes the following methods:

l "Method amigopod.guest.change.expiration" on page 410

l "Method amigopod.guest.create" on page 411

l "Method amigopod.guest.delete" on page 412

l "Method amigopod.guest.edit" on page 414

l "Method amigopod.guest.enable" on page 416

l "Method amigopod.guest.get" on page 417

l "Method amigopod.guest.list" on page 419

l "Method amigopod.guest.reset.password" on page 420
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l "Method amigopod.mac.create" on page 421

l "Method amigopod.mac.edit" on page 423

l "Method amigopod.mac.list" on page 425

Method amigopod.guest.change.expiration

Change the expiration time of a guest account.

Parameters

Name Type Description

uid Scalar ID of the guest account to update

guestaccountexpiry Scalar Amount of time in hours before the guest account will expire

Return Values

Name Type Description

error Flag 0 if successful, 1 if an error occurred

message String Status message describing the operation

item Struct Updated user information record

*_error String Field-specific error message

*_error_flag Flag Field-specific error flag, set to 1 if present

Access Control

Requires the change_expiration privilege (Guest Manager > Change Expiration in the Operator Profile
Editor).

Example Usage

Sample parameters for the call:
'uid' => 162,
'guestaccountexpiry' => 24,

Result returned by a successful operation:
'error' => 0,
'message' => 'Changed expiration time of guest account
Account will expire at 2014-11-28 23:27:00',
'item' => array (

'id' => 162,
'do_expire' => 4,
'expire_time' => 1196256420,
'username' => '',

)

Result returned by a failed operation:
'uid' => 162,
'username' => '',
'expiration_time' => '',
'user_enabled' => '',
'guestaccountexpiry_error' => 'Please choose from one of these options.',
'guestaccountexpiry_error_flag' => 1,
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'error' => 1,

Method amigopod.guest.create

Create a new guest account.

Parameters

Name Type Description

sponsor_name String Name of the person sponsoring the
guest account.

visitor_name String Name of the visitor.

visitor_company String Company name of the visitor.

email String
The visitor's email addresss. This will
become their username to log in to
the network.

expire_after Numeric Amount of time before the account
will expire. Specified in hours.

expire_time String Optional date and time at which the
guest account will expire.

role_id Integer RADIUS role ID to assign to the guest
account.

creator_accept_terms Flag Set to 1 to indicate acceptance of the
service's terms of use.

* * Other fields as specified by create_
user form customization.

Return Values

Name Type Description

error Flag Set to 1 if the guest account was not
created

id Integer Set to the ID of the guest account if
the account was created

password String Set to a randomly-generated value
(default behavior only)

*_error String Field-specific error message

*_error_flag Flag Field-specific error flag, set to 1 if
present

Access Control

Requires the create_user privilege (Guest > Create Guest Account in the Operator Profile Editor).
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Example Usage

Sample parameters for the call:
'sponsor_name' => 'Sponsor Name',
'visitor_name' => 'Visitor Name',
'visitor_company' => 'Visitor Company',
'email' => 'demo@example.com',
'expire_after' => 4,
'expire_time' => '',
'role_id' => 2,
'visitor_phone' => '0',
'creator_accept_terms' => 1,

Result returned by a successful operation:
'username' => 'demo@example.com',
'password' => '73067792',
'role_id' => 2,
'role_name' => 'Guest',
'simultaneous_use' => '1',
'do_schedule' => 0,
'enabled' => true,
'expire_time' => 1196769257,
'do_expire' => 4,
'expire_postlogin' => 0,
'sponsor_name' => 'Sponsor Name',
'visitor_name' => 'Visitor Name',
'visitor_company' => 'Visitor Company',
'email' => 'demo@example.com',
'creator_accept_terms' => true,
'id' => 1,

Result returned by a failed operation:
'password' => 78342029',
'expire_time' => '',
'submit' => '',
'sponsor_name_error' => 'You cannot leave this field blank.',
'sponsor_name_error_flag' => 1,
'visitor_name_error' => 'You cannot leave this field blank.',
'visitor_name_error_flag' => 1,
'visitor_company_error' => 'You cannot leave this field blank.',
'visitor_company_error_flag' => 1,
'email_error' => 'Please enter a valid email address.',
'email_error_flag' => 1,
'expire_after_error' => 'Please choose from one of the available options.',
'expire_after_error_flag' => 1,
'expire_time_error' => 'Please enter a valid date and time.',
'expire_time_error_flag' => 1,
'role_id_error' => 'Parameter must be provided.',
'role_id_error_flag' => 1,
'creator_accept_terms_error' => 'You must accept the terms of use to continue.',
'creator_accept_terms_error_flag' => 1,
'error' => 1,

Method amigopod.guest.delete

Disable or remove a guest account.

Parameters
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Name Type Description

uid Integer ID of the guest account to delete

delete_account Flag Set to 0 to disable the guest account,
1 to delete the guest account

Return Values

This function might return a Boolean false value if some input parameters are invalid.

Name Type Description

error Flag Set to 1 if the guest account was not
deleted

message String Message describing the success or
failure of the operation

item Struct User structure containing updated
field values

uid Integer ID of the guest account

*_error String Field-specific error message

*_error_flag Flag Field-specific error flag, set to 1 if
present

Access Control

Requires the remove_account privilege (Guest Manager > Remove Accounts in the Operator Profile
Editor).

Example Usage

Sample parameters for the call:
'uid' => '162',
'delete_account' => '0',

Result returned by a successful operation:
'error' => 0,
'message' => 'Disabled guest account ',
'item' =>
array (

'id' => 162,
'enabled' => 0,
'username' => '',

),

Result returned by a failed operation:
'uid' => 162,
'username' => '',
'expiration_time' => '',
'user_enabled' => '',
'delete_account_error' => 'Please choose from one of these options.',
'delete_account_error_flag' => 1,
'error' => 1,
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Method amigopod.guest.edit

Change one of more properties of a guest account.

Parameters

Name Type Description

uid Integer ID of the guest account to edit

username String Name of the guest account

password String

May be:
random_password to indicate the
guest account's password should be
set to a random password
password_value to indicate the
guest account's password should be
set to the value in the password_
value field
The empty string to leave the
password unmodified

password_value String
Optional password to set the guest
account's password (if the password
field is password_value)

role_id Integer RADIUS role ID to assign to the guest
account

enabled Flag Boolean value indicating whether the
guest account is enabled

simultaneous_use Integer Number of simultaneous sessions
allowed by the guest account

do_schedule Flag Flag indicating if the guest account
should be enabled at schedule_time

schedule_time String Date and time at which the guest
account will be enabled

do_expire Integer Action to take when the expire_time
is reached

expire_time String Time at which the guest account will
expire

expire_postlogin Integer
Time period for which the guest
account will be valid after the first
login, or 0 for indefinitely

Return Values

Name Type Description

error Flag Set to 1 if the guest account was not
modified
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Name Type Description

message String Message describing the success or
failure of the operation

item Struct User structure containing updated
field values

uid Integer ID of the guest account

*_error String Field-specific error message

*_error_flag Flag Field-specific error flag, set to 1 if
present

Access Control

Requires the full_user_control privilege (Guest Manager > Full User Control in the Operator Profile
Editor).

Example Usage

Sample parameters for the call:
'uid' => 162,
'username' => 'demo@example.com',
'password' => 'password_value',
'password_value' => 'password',
'role_id' => 2,
'enabled' => 1,
'simultaneous_use' => 1,
'do_schedule' => 0,
'schedule_time' => '',
'do_expire' => 4,
'expire_time' => '2014-12-01 00:00:00',
'expire_postlogin' => 0,

Sample successful call:
'error' => 0,
'message' => 'Edited properties of guest account demo@example.com',
'item' =>
array (

'id' => 162,
'username' => 'demo@example.com',
'role_id' => 2,
'enabled' => true,
'simultaneous_use' => 1,
'do_schedule' => 0,
'do_expire' => 4,
'expire_postlogin' => 0,
'role_name' => 'Guest',
'expire_time' => 1196431200,

),

Sample failed call:
'uid' => 162,
'random_password' => '59447116',
'password_value' => '',
'schedule_time' => '',
'expire_time' => '',
'user_enabled' => '',
'username_error' => 'You cannot leave this field blank.',
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'username_error_flag' => 1,
'password_error' => 'Please choose from one of the available options',
'password_error_flag' => 1,
'role_id_error' => 'Please choose from one of the available options',
'role_id_error_flag' => 1,
'enabled_error' => 'Parameter must be provided',
'enabled_error_flag' => 1,
'simultaneous_use_error' => 'Please enter a non-negative integer value.',
'simultaneous_use_error_flag' => 1,
'do_schedule_error' => 'Please choose from one of the available options',
'do_schedule_error_flag' => 1,
'schedule_time_error' => 'Parameter must be a string',
'schedule_time_error_flag' => 1,
'do_expire_error' => 'Please choose from one of the available options',
'do_expire_error_flag' => 1,
'expire_time_error' => 'Parameter must be a string',
'expire_time_error_flag' => 1,
'expire_postlogin_error' => 'Please choose from one of the available options',
'expire_postlogin_error_flag' => 1,
'error' => 1,

Method amigopod.guest.enable

Enable a guest account.

Parameters

Name Type Description

uid Integer ID of the guest account to enable

Return Values

This function might return a Boolean false value if some input parameters are invalid.

Name Type Description

error Flag Set to 1 if the guest account was not
enabled

message String Message describing the success or
failure of the operation

item Struct User structure containing updated
field values

uid Integer ID of the guest account

*_error String Field-specific error message

*_error_flag Flag Field-specific error flag, set to 1 if
present

Access Control

Requires the remove_account privilege (Guest Manager > Remove Accounts in the Operator Profile
Editor).
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Example Usage

Sample parameters for the call:
'uid' => '162',

Sample successful call:
'error' => 0,
'message' => 'Guest account has been re-enabled',
'item' =>
array (

'id' => 162,
'enabled' => 1,
'username' => '',

),

Sample failed call:
'error' => 1,
'message' => 'Account not found: ID 162',

Method amigopod.guest.get

List one or more guest accounts.

Parameters

Name Type Description

id Integer Array

Retrieve a single guest account by ID
(integer parameter), or multiple
guest accounts by ID (array
parameter)

Return Values

Name Type Description

id Mixed ID or IDs of the guest accounts being
returned

users Array

l If a single ID was requested,
users contains the guest account
requested (or an error field if an
error occurred)

l If multiple IDs were requested,
users contains an array of results

Access Control

Requires the guest_users privilege (Guest Manager > List Guest Accounts in the Operator Profile Editor).

Example Usage

Sample parameters:
'id' => array(150, 162)

Sample successful call:
'id' =>
array (

0 => 150,
1 => 162,

),
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'users' =>
array (

0 =>
array (

'id' => '150',
'username' => '44454318',
'enabled' => '1',
'role_id' => '2',
'email' => '',
'notes' => 'GuestManager account 22 of 30 created by root from 192.168.2.3',
'do_expire' => '0',
'expire_time' => '',
'simultaneous_use' => '1',
'expire_postlogin' => '0',
'do_schedule' => '0',
'schedule_time' => '',
'ip_address' => '',
'netmask' => '',

),
1 =>
array (

'id' => '162',
'username' => 'demo@example.com',
'enabled' => '1',
'role_id' => '2',
'email' => 'demo@example.com',
'notes' => '',
'do_expire' => '4',
'expire_time' => '1196253480',
'simultanous_use' => '1',
'expire_postlogin' => '0',
'do_schedule' => '0',
'schedule_time' => '',
'ip_address' => '',
'netmask' => '',
'auto_send_sms' => '',
'creator_accept_terms' => '1',
'role_name' => 'Guest',
'sponsor_name' => 'Sponsor Name',
'visitor_company' => 'Visitor Company',
'visitor_name' => 'Visitor Name',
'visitor_phone' => '0',

),
),

Sample failed call:
'id' => 162,
'users' =>
array (

'error' => 1,
'message' => 'Account not found: ID 162',

),
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Method amigopod.guest.list

List guest accounts. (To retrieve devices, see "Method amigopod.mac.list" on page 425)

Parameters

Name Type Description

details Flag

Optional parameter; if set to 1 then
full details of all guest accounts are
returned, otherwise only the IDs are
returned

sort string

Optonal parameter. If set to 1, then
sorts first by the specified column,
and then by username. For the field_
name and +field_name formats,
sort order will be ascending (A to Z);
for the -field_name format the sort
order will be descending (Z to A).

filter string

Allows searching for multiple values
when using the equality (=) or
inequality (!=) operators. For more
information, see the Filter description
in "Managing Single Guest Accounts
" on page 55.

Return Values

Name Type Description

ids Array Array of guest account IDs (if details
was 0)

users Array Array of guest account structures (if
details was 1)

Access Control

Requires the guest_users privilege (Guest Manager > List Guest Accounts in the Operator Profile Editor).

Example Usage

Sample parameters:
'details' => 0,

Sample successful call:
'ids' =>
array (

0 => '37',
1 => '141',
2 => '40',
...

),
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Method amigopod.guest.reset.password

Reset a guest account's password to a random value.

Parameters

Name Type Description

uid Integer ID of the guest account to reset the
password for

Return Values

Name Type Description

error Flag Set to 1 if the password was not
reset

message String Message describing the success or
failure of the operation

item Struct User structure containing updated
field values

*_error String Field-specific error message

*_error_flag Flag Field-specific error flag, set to 1 if
present

Access Control

Requires the reset_password privilege (Guest Manager > Reset Password in the Operator Profile Editor).

Example Usage

Sample parameters for the call:
'uid' => 162,

Sample successful call:
'error' => 0,
'message' => 'Guest account password reset for
Password changed to 37172833',
'item' =>
array (

'id' => 162,
'password' => '37172833',
'username' => '',

),

Sample failed call:
'error' => 1,
'message' => 'Account not found: ID 162',
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Method amigopod.mac.create

Create a new MAC device account.

Parameters

Name Type Description

sponsor_name String Name of the person sponsoring the
device account.

visitor_name String Name of the visitor.

visitor_company String Company name of the visitor.

email String
The visitor's email address. This will
become their username to log in to
the network.

expire_after Numeric
Amount of time before the device
account will expire. Specified in
hours.

expire_time String Optional date and time at which the
device account will expire.

role_id Integer RADIUS role ID to assign to the
device account.

creator_accept_terms Flag Set to 1 to indicate acceptance of the
service's terms of use.

* * Other fields as specified by create_
user form customization.

Return Values

Name Type Description

error Flag Set to 1 if the device account was not
created

id Integer Set to the ID of the device account if
the account was created

password String Set to a randomly-generated value
(default behavior only)

*_error String Field-specific error message

*_error_flag Flag Field-specific error flag, set to 1 if
present

Access Control

Requires the mac_create privilege (Guest Manager > Create New MAC Authentication in the Operator
Profile Editor).

ClearPass Guest 6.4 | User Guide Administration | 421
Anexo 11 ITEM 01 (0592523)         SEI 0008478-63.2018.6.02.8000 / pg. 3448



422 | Administration ClearPass Guest 6.4 | User Guide

Example Usage

Sample parameters for the call:
'sponsor_name' => 'Sponsor Name',
'visitor_name' => 'Visitor Name',
'visitor_company' => 'Visitor Company',
'email' => 'demo@example.com',
'expire_after' => 4,
'expire_time' => '',
'role_id' => 2,
'visitor_phone' => '0',
'creator_accept_terms' => 1,

Result returned by a successful operation:
'username' => 'demo@example.com',
'password' => '73067792',
'role_id' => 2,
'role_name' => 'Guest',
'simultaneous_use' => '1',
'do_schedule' => 0,
'enabled' => true,
'expire_time' => 1196769257,
'do_expire' => 4,
'expire_postlogin' => 0,
'sponsor_name' => 'Sponsor Name',
'visitor_name' => 'Visitor Name',
'visitor_company' => 'Visitor Company',
'email' => 'demo@example.com',
'creator_accept_terms' => true,
'id' => 1,

Result returned by a failed operation:
'password' => 78342029',
'expire_time' => '',
'submit' => '',
'sponsor_name_error' => 'You cannot leave this field blank.',
'sponsor_name_error_flag' => 1,
'visitor_name_error' => 'You cannot leave this field blank.',
'visitor_name_error_flag' => 1,
'visitor_company_error' => 'You cannot leave this field blank.',
'visitor_company_error_flag' => 1,
'email_error' => 'Please enter a valid email address.',
'email_error_flag' => 1,
'expire_after_error' => 'Please choose from one of the available options.',
'expire_after_error_flag' => 1,
'expire_time_error' => 'Please enter a valid date and time.',
'expire_time_error_flag' => 1,
'role_id_error' => 'Parameter must be provided.',
'role_id_error_flag' => 1,
'creator_accept_terms_error' => 'You must accept the terms of use to continue.',
'creator_accept_terms_error_flag' => 1,
'error' => 1,
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Method amigopod.mac.edit

Change one of more properties of a device account.

Parameters

Name Type Description

uid Integer ID of the device account to edit

username String Name of the device account

password String

May be:
random_password to indicate the
device account's password should be
set to a random password
password_value to indicate the
device account's password should be
set to the value in the password_
value field
The empty string to leave the
password unmodified

password_value String
Optional password to set the device
account's password (if the password
field is password_value)

role_id Integer RADIUS role ID to assign to the
device account

enabled Flag Boolean value indicating whether the
device account is enabled

simultaneous_use Integer Number of simultaneous sessions
allowed by the device account

do_schedule Flag Flag indicating if the device account
should be enabled at schedule_time

schedule_time String Date and time at which the device
account will be enabled

do_expire Integer Action to take when the expire_time
is reached

expire_time String Time at which the device account will
expire

expire_postlogin Integer
Time period for which the device
account will be valid after the first
login, or 0 for indefinitely

Return Values

Name Type Description

error Flag Set to 1 if the device account was not
modified
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Name Type Description

message String Message describing the success or
failure of the operation

item Struct User structure containing updated
field values

uid Integer ID of the device account

*_error String Field-specific error message

*_error_flag Flag Field-specific error flag, set to 1 if
present

Access Control

Requires the full_user_control privilege (Guest Manager > Full User Control in the Operator Profile
Editor).

Example Usage

Sample parameters for the call:
'uid' => 162,
'username' => 'demo@example.com',
'password' => 'password_value',
'password_value' => 'password',
'role_id' => 2,
'enabled' => 1,
'simultaneous_use' => 1,
'do_schedule' => 0,
'schedule_time' => '',
'do_expire' => 4,
'expire_time' => '2014-12-01 00:00:00',
'expire_postlogin' => 0,

Sample successful call:
'error' => 0,
'message' => 'Edited properties of guest account demo@example.com',
'item' =>
array (

'id' => 162,
'username' => 'demo@example.com',
'role_id' => 2,
'enabled' => true,
'simultaneous_use' => 1,
'do_schedule' => 0,
'do_expire' => 4,
'expire_postlogin' => 0,
'role_name' => 'Guest',
'expire_time' => 1196431200,

),

Sample failed call:
'uid' => 162,
'random_password' => '59447116',
'password_value' => '',
'schedule_time' => '',
'expire_time' => '',
'user_enabled' => '',
'username_error' => 'You cannot leave this field blank.',
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'username_error_flag' => 1,
'password_error' => 'Please choose from one of the available options',
'password_error_flag' => 1,
'role_id_error' => 'Please choose from one of the available options',
'role_id_error_flag' => 1,
'enabled_error' => 'Parameter must be provided',
'enabled_error_flag' => 1,
'simultaneous_use_error' => 'Please enter a non-negative integer value.',
'simultaneous_use_error_flag' => 1,
'do_schedule_error' => 'Please choose from one of the available options',
'do_schedule_error_flag' => 1,
'schedule_time_error' => 'Parameter must be a string',
'schedule_time_error_flag' => 1,
'do_expire_error' => 'Please choose from one of the available options',
'do_expire_error_flag' => 1,
'expire_time_error' => 'Parameter must be a string',
'expire_time_error_flag' => 1,
'expire_postlogin_error' => 'Please choose from one of the available options',
'expire_postlogin_error_flag' => 1,
'error' => 1,

Method amigopod.mac.list

List MAC device accounts. (To retrieve guest accounts, see "Method amigopod.guest.list" on page 419)

Parameters

Name Type Description

details Flag

Optional parameter; if set to 1 then
full details of all device accounts are
returned, otherwise only the IDs are
returned.

sort string

Optonal parameter. If set to 1, then
sorts first by the specified column,
and then by username. For the field_
name and +field_name formats,
sort order will be ascending (A to Z);
for the -field_name format the sort
order will be descending (Z to A).

filter string

Allows searching for multiple values
when using the equality (=) or
inequality (!=) operators. For more
information, see the Filter description
in "Managing Single Guest Accounts
" on page 55.

Return Values

Name Type Description

ids Array Array of device account IDs (if
details was 0).

users Array Array of device account structures (if
details was 1).
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Access Control

Requires the mac_list privilege (Guest Manager > List MAC Authentication Accounts in the Operator
Profile Editor).

Example Usage

Sample parameters:
'details' => 0,

Sample successful call:
'ids' =>
array (

0 => '37',
1 => '141',
2 => '40',
...

),

MACTrac Services

MACTrac allows users to register their personal mobile devices on a local network. Each device registered by an
operator is automatically shared with all of that operator’s registered devices. There is no limit to the number
of device accounts an operator can create, and no expiration time is set on device accounts.

You use ClearPass Policy Manager to create MACTrac operators. MACTrac operators can then log in through
ClearPass Guest to register and manage their devices.

For example, in a university setting, MACTrac provides a simple way for students to register their various
devices on the network:

l The student is authenticated and can register as many devices as they wish.

l MACTrac automatically detects each device's OS type, letting the network administrator easily build an
inventory of the devices on the network and architect an appropriate network policy.

l There is no additional license fee for these devices: Although MACTrac is part of ClearPass Guest, MACTrac
device registrations do not count against the ClearPass Guest license.

l As with other ClearPass Guest forms and views, the MACTrac user interface can be customized by adding a
custom skin or options such as an "Add Another Device" button.

This section describes the following:

l "Creating MACTrac Operators" on page 426

l "Managing MACTrac Devices " on page 427

l "Registering MACTrac Devices " on page 429

l "Automatically Supplying the MACTrac Device Address" on page 430

Creating MACTrac Operators
MACTrac operators are users of ClearPass Guest who can register their personal devices on a local network. The
MACTrac operator profile and translation rule are already available in ClearPass Guest, and the MACTrac role is
available in ClearPass Policy Manager. No expiration time is set on MACTrac operator accounts.

To create a MACTrac operator:
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1. In ClearPass Policy Manager, go to Configuration > Identity > Local Users and click Add User. The Add
Local User form opens.

2. In the User ID field, enter the MACTrac operator's username.

3. Complete the Name and Password fields. The minimum password length is six characters.

4. The new operator is enabled by default. If the operator is not to be activated until a later time, you may
unmark the check box in the Enable User field.

5. In the Role drop-down list, select MACTrac Operator.

6. You may use the Attribute drop-down lists to include additional information such as Phone, Email,
Sponsor, Title, Department, or Designation and provide values for these attributes.

7. Click Add. The new MACTrac operator is added to the Local Users list view. To edit any of the values shown
above, click the operator's row in the list.

Managing MACTrac Devices
The MACTrac operators you create can log in to ClearPass Guest to register their devices on their local network.
Their view of the Guest user interface only includes the MACTrac features.

MACTrac operators can create and manage multiple device accounts. Options include editing, printing details,
disabling, and deleting accounts.

To work with MACTrac devices, log in to ClearPass Guest as a MACTrac operator and go to Guest > List
Devices. The MACTrac Devices list view opens.
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All MACTrac devices that have been registered are included in the list. You can click a device account's row in the
list for additional options:

l To edit any of a device account's attributes, click its Edit link. The Edit MACTrac Device form opens. The
process for editing a device account is the same as for creating the account. For more information, see
"Registering MACTrac Devices " on page 429.

l To print a copy of the device account's details, click its Print link. The Account Details form opens and
includes print options.
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l To disable or delete a device account, click its Remove link. A confirmation dialog opens. You may specify
either Disable or Delete, then click Make Changes. To enable a disabled account, click its Activate link.

Registering MACTrac Devices
The Register Device form is used by MACTrac operators to create their device accounts on their local network.
There is no limit to the number of accounts an operator can create, and no expiration time is set on device
accounts.

To register a MACTrac device:

1. Log in to ClearPass Guest as a MACTrac operator and go to Guest > Create Device. The Register Device
form opens.

2. The MAC Address field is required, and should be prepopulated for the user. This is enabled in the Mobility
Controller. For more information, see "Automatically Supplying the MACTrac Device Address" on page 430.

3. (Optional) Enter a name for the device in the Device Name field.

4. (Optional) The Device Type field is prepopulated if detected, and indicates whether it is a computer,
printer, or other type of device.

5. (Optional) The Device Platform field is prepopulated if detected, and indicates whether it is a Windows,
Mac, Linux, or Android platform, and whether it is a mobile phone.

6. (Optional) The Browser Vendor/Version field is prepopulated if detected, and indicates whether it is an
Internet Explorer, Google Chrome, Mozilla Firefox, or other browser.

7. (Optional) The Enabled By field displays the operator's name.

8. Click Create MAC to register the device and create the account. The device account is included in the
MACTrac Devices list, and can be shared with the operator's other registered devices.
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The default Register Device form is described here. ClearPass administrators can customize this form with
additional fields.

About MAC Addresses
A MAC address is a number that uniquely identifies your device's network interface. A MAC address is
sometimes referred to as an Ethernet hardware address (EHA), hardware address, or physical address.

MAC addresses are usually formatted as twelve characters grouped in pairs separated by either colons or
hyphens. They may consist of only number pairs, or include number pairs and letter pairs, and in some cases
do not include separators—for example:

00:11:22:33:44:55

00-11-22-33-44-55

11:22:33:AA:BB:CC

112233AABBCC

If for some reason the Mac Address field on the Register Device form is not prepopulated, you may need to
find your device's address. Methods for finding the MAC address differ according to the type of device and
operating system. Due to the variety of devices, these methods cannot all be described here, but they are easy
to find on the Internet. An Internet search for "mac address" will return a number of pages describing how to
quickly find MAC addresses for different device types.

Automatically Supplying the MACTrac Device Address
To ensure that the MAC address, device type, and browser vendor/version are prepopulated on the MACTrac
Register Device form, verify that these options are set in the Mobility Controller.

To set MACTrac prepopulating options:

1. Log in to the Mobility Controller.

2. In the Configuration tab, go to Security > Authentication in the left menu.

3. Click the L3 Authentication tab, then choose Captive Portal Authentication Profile > cpg-qa-
captiveportal.

4. On the form, mark the check box in the Add switch IP address in the redirection URL row.
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Data Retention

The Data Retention Policy page (Administration > Data Retention) lets you manage historical data by
deleting it.

Figure 41 Data Retention Policy page

1. To enable the data retention policy option, mark the Enable check box, and then enter the time of day at
which records will be deleted.

2. To configure Onboard certificate retention, click the link in the Certificate Retention row. The Certificate
Authorities list in the Onboard module opens.

If you wish to configure the times after which expired accounts are deleted, refer to the ClearPass Policy
Manager documentation for cluster-wide parameters. Data retention of guest accounts and logs is configured
in CPPM under Administration > Server Configuration > Cluster-Wide Parameters.

3.9 Configuration Import

To help ClearPass Guest 3.9 customers transition to ClearPass Guest 6.x, the Import Configuration forms let
you:

l Create a full or custom backup of your Guest implementation. See "Creating a Customized Configuration
Backup" on page 431.

l Upload a 3.9 configuration backup file to your ClearPass Guest 6.x file system, making the items in it
available for import. See "Uploading the 3.9 Backup File " on page 432.

l Select items from it to import, restoring those configurations in your ClearPass Guest 6.x system. See
"Restoring Configuration Items " on page 433

l Review details for configuration items after import, including anything that might be different between 3.9
and 6.2 and any actions you might need to take. See "Viewing Imported Item Details " on page 435 and
"Import Information for Specific Import Items " on page 436.

Creating a Customized Configuration Backup
You can use the Configuration Backup form to create and export a full or customized configuration backup file.

To create a configuration backup:
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1. Go to Administration > Import Configuration > Import Configuration, then click the Create a
customized backup link in the upper-right corner. The Configuration Backup form opens.

2. In the Backup Mode drop-down list, select either Complete backup or Custom backup, as appropriate.

3. In the Backup Name field, enter the name of the backup file.

4. If you choose to do a custom backup, the form expands to include the list of items to choose from. When
this list first opens, all items are included by default. Categories are displayed—for example, Guest Manager,
SMS Services, and so on—and subordinate items in the categories are hidden. To configure a custom
backup, use the controls in the Backup Set list to specify just the items you want to include:

l The green arrow and bold font indicate an item and all its subordinate items will be included.

l The blue arrow is a visual aid marking an item as a category that has subordinate items listed below it.
To view the subordinate items, click the blue arrow. If the arrow is gray, there are no subordinate items.

l To exclude an item from the import, click the X in the item's row. The X turns red to indicate it will be
excluded. You can click the X for a category to exclude all items in that category. To include an excluded
item, click the arrow in its row.

5. When you have completed and verified your selections, click Download Backup. The configuration backup
is saved to your Downloads folder as a .dat file. You can then click either the Restore a backup
configuration link, or Import Configuration > Import Configuration in the left navigation to upload
and restore the file.

Uploading the 3.9 Backup File
To upload a Guest 3.9 configuration to ClearPass Guest 6.2:

1. Upgrade your 3.9 system to the latest 3.9.x monthly patch.

2. Deploy your 6.2 system, and upgrade it to the latest 6.2.x monthly patch.

3. In your 3.9 system, make a complete configuration backup. For details on how to back up your system,
refer to the "Backup and Restore" section in the "Administrator Tasks" chapter of your "ClearPass Guest 3.9
Deployment Guide."

Be sure to use the Complete backup option in your 3.9 system's Backup Mode drop-down list to ensure that
references between items are properly migrated. Partial imports might not work as expected.

4. In your 6.2 system, go to Administration > Import Configuration. The Import Configuration: Step 1
page opens with the Upload File form displayed.

5. If your file does not exceed the 15.0 MB size limit, you can use this Upload File form to browse to the
location where you stored your 3.9 backup file. To use the Upload File form, click the Browse button in the
Backup File row to navigate to and select the backup file you want to restore.
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If your file is larger than the maximum file upload size of 15.0 MB, you must specify a URL instead. Click the
Restore a backup from a URL link above the Upload File form. The Specify Backup File form is
displayed. Enter the URL for the backup file.

6. Click Continue. The backup file is uploaded to your 6.2 system, making the items available for import, and
the Import Configuration: Step 2 page opens.

This form shows every configuration item in your backup file, and provides options for restoring items or
excluding them from the restoration. For more information, see the next section, "Restoring Configuration
Items " on page 433.

Restoring Configuration Items
This section describes how to use the Import Configuration: Step 2 form to import 3.9 configuration items
to your 6.2 system after you upload them.

To select and restore your configuration items:

1. Go to Administration > Import Configuration and complete the steps described in "Uploading the 3.9
Backup File " on page 432.
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2. When the Import Configuration: Step 2 form is displayed, review the list of items. You can use the
options in the Restore column to select the items to import.

Partial imports might not work as expected. To ensure that references between items are properly migrated, use the
default Restore settings.

l To exclude an item from the import, click the X in the item's row. The X turns red to indicate it will be
excluded. You can click the X for a category to exclude all items in that category.

l To make it easier to select just a few items, you can scroll to the bottom of the list and click the
Unselect All link. All items are then marked with a red X and will be excluded from the import. You can
then select the green check marks for just the items you want.

l The blue arrow is a visual aid marking an item as a category that has subordinate items listed below it.

l To include an item in the import, click the check mark in the item's row. The check mark turns green
and the item's name is highlighted in bold font to indicate it will be included. You can click the check
mark for a category to include all items in the category.

3. Select the items in the list that you want to restore, then mark the Restore settings from backup check
box to confirm.

Restoring the backup will overwrite your current settings.

4. Click Restore Configuration. System progress is displayed while items are being imported. When the
import is complete, the Finished Import page displays the Import Notices list for the restored items. For
more information, see "Viewing Imported Item Details " on page 435.
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Viewing Imported Item Details
After you click Restore Configuration to import your 3.9 configuration to your 6.2 system, the Finished Import
page displays the Import Notices list for the restored items. You can click an item's row in the list for additional
options. For some items, a link is provided to the relevant page in the application.

To view information for imported configuration items:

1. Go to Administration > Import Configuration > Last Import. The Import Notices list opens.

The Import Notices list provides information about items that were handled during the last import. This list
includes the following columns:

l Status -- The import status of the item in the same row. Possible statuses include Imported, Migrated,
Obsolete, Action Required, Error, Processed, Unsupported, and Warning. These statuses are described
more fully in the table below.

l Operation/Notice -- This column shows the operation performed on the item, and the name of the
item. If the item was imported, the value in this column will be "Import <item name>. If the item could
not be imported, you can click the row to view the item details for more information.

l Count -- The number of items imported for each configuration item. For example, the number shown in
the Count column for Guest Manager Custom Fields indicates the number of customized fields that were
imported.

2. You can click a configuration item's row in the list for additional options.

l For some items, you can click a link to go to the relevant page in the application.

l To view details for a configuration item, click its Show Details link. The form expands to show details of
the import results for the item. The details explain the import status, and advise you of any further
action that might be required.
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Status Description

Imported The item was successfully imported with no changes.

Migrated

The item was successfully imported but some aspects were modified for 6.2, as described
in Show Details for the item.
For example, if a field imported in a 3.9 configuration has a different name in 6.2 but was
successfully matched and updated, the change is indicated by an arrow:
Migrated field: schedule_time --> start_time

Processed

The item was processed for the import but was not applicable and was ignored, as
described in Show Details for the item.
For example, a disabled network configuration, or a service that is now handled in Policy
Manager instead of Guest, or a plugin version that was already up to date.

Action
Required

Items with this status might or might not have been imported, and require further
verification or manual configuration, as described in Show Details for the item.
For example, print templates that should be reviewed, reports that should be recreated
using Insight instead of Reporting Manager, custom database settings that are not
supported, items that should now be configured in Policy Manager instead of Guest, or
server addresses that should be verified to ensure they are current.

Unsupported

The item was not imported because it is not supported in 6.2.
For example, RADIUS certificates, RADIUS Dictionary, custom items for which no handler
could be found, or items such as the system log or RADIUS database that are now managed
in Policy Manager.

Obsolete
The item was not imported because it is obsolete in 6.2.
For example, fields that no longer exist, obsolete operator login settings, RADIUS database
settings or server configurations, or deleted user accounts.

Error The item was not imported because it was missing or unavailable.
For example, missing service handler implementations or unavailable skin plugins.

Warning
The item was imported but the details include information the operator should be aware of.
For example, plugins might have been exported from your 3.9 system by out-of-date plugin
versions.

Table 105: Configuration Import Statuses

For import details specific to each import item, see "Import Information for Specific Import Items " on page
436.

Import Information for Specific Import Items
For each configuration category on the Import Notices list, this section describes items that might be changed,
unsupported, or obsolete, and any actions you might need to take.

This section includes the following:

l "Import Information: Advertising Services" on page 437

l "Import Information: AirGroup Services" on page 437

l "Import Information: Cisco IP Phones" on page 437

l "Import Information: Guest Manager" on page 437

l "Import Information: High Availability (HA)" on page 438

l "Import Information: Hotspot Manager" on page 438
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l "Import Information: Onboard" on page 438

l "Import Information: Operator Logins" on page 439

l "Import Information: Palo Alto Network Services" on page 439

l "Import Information: RADIUS Services" on page 439

l "Import Information: Reporting Manager Definitions" on page 440

l "Import Information: Server Configuration" on page 440

l "Import Information: SMS Services" on page 442

l "Import Information: SMTP Services" on page 442

Import Information: Advertising Services

l Advertising Services is unsupported.

Import Information: AirGroup Services
l The following AirGroup 3.9 fields are renamed:

3.9 Name 6.1 Name

shared_location = airgroup_shared_location

shared_role = airgroup_shared_role

shared_user = airgroup_shared_user

l The definitions of some fields are also updated.

l AirGroup controller names default to the hostname.

Import Information: Cisco IP Phones
l The user database is the default ClearPass Policy Manager user database.

l The SMS service handler ID might be updated.

Import Information: Guest Manager

Guest Manager Configuration

l The new default for the Expire Action setting is 1. Any non-default setting is updated to this new default.

l Any Account Retention setting is removed.

l Any non-default Session Warning setting is updated to the new default.

Custom Fields:

l The following 3.9 custom fields are obsolete and are not imported:

do_schedule

delete_time

l The following 3.9 custom fields are renamed:
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3.9 Name 6.2 Name

schedule_time = start_time

modify_schedule_time = modify_start_time

schedule_after = start_after

Custom Forms and Views:

l Forms and views that referenced renamed fields are updated to reference the new field name.

l Forms and views that referenced obsolete fields have those fields removed from the definition.

Print Templates:

l Print templates are flagged as Action Required. Print templates might require changes where defaults
have changed or fields have been renamed. Review the templates and correct as necessary to fix fields that
have been changed.

Self Registration:

l The user database is the default ClearPass Policy Manager user database.

LDAP Sponsor Lookups:

l All LDAP operator servers and translation rules are imported. All 6.2 LDAP translation rules are also kept,
because the new default LDAP rules are required for correct operation.

l Imported LDAP translation rules should be reviewed for correct order.

MAC Authentication Configuration:

l Non-default MAC Separator settings are updated to the new default ( - ).

l Non-default MAC Case settings are updated to the new default (lower).

l AirGroup Debug settings are obsolete and are removed.

Import Information: High Availability (HA)
l If HA was not configured, the shared configuration is processed but ignored.

l If HA was configured, it is unsupported.

l If HA nodes were configured, do the following for each shared configuration :

n Configure a Virtual IP address in CPPM.

n Configure Publisher Redundancy in CPPM.

Import Information: Hotspot Manager
l Non-default User Database settings are updated to the default ClearPass Policy Manager user database.

l Non-default Transaction Processing settings reference the correct transaction processor.

l A cookie check (nwa_cookiecheck) is added to the default hotspot plan template.

Import Information: Onboard

To restore your Onboard device provisioning pages, you must import RADIUS Web logins.
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l The server certificate in CPPM might need to be configured before provisioned devices can connect to
the network.

l The QuickConnect client provisioning address might need to be verified as the correct one for the new
server.

Import Information: Operator Logins

Operator Login Configuration

l A client-side cookie check (nwa_cookiecheck) is added to the Login Message setting.

Operator Logins

l Operator logins are obsolete.

Operator Profiles

l If the IT Administrators profile is imported, it is updated to keep existing privileges and is migrated.

l Any non-default Password Change Policy is removed and the profile is migrated.

l Any non-default user skins are reset to the default skin and the profile is migrated.

Operator Servers

l Operator servers are imported as service handlers.

Operator Translation Rules

l If there are any new translation rules, the translation rules should be reviewed for correct order.

Import Information: Palo Alto Network Services
l If Palo Alto Network Services Configuration was disabled, it is processed and ignored.

l If it was enabled, it must be configured in CPPM.

Import Information: RADIUS Services
RADIUS services are now handled in ClearPass Policy Manager instead of ClearPass Guest.

RADIUS Authentication Servers

l Default authentication servers are processed but ignored (Local User Database, Local Certificate Authority)

l For all other authentication servers, an authentication source must be created in CPPM.

RADIUS Certificates

l RADIUS certificates are unsupported.

RADIUS Database Accounting Records

l RADIUS database accounting records are unsupported.

RADIUS Database Connections

l The RADIUS database connection for the local RADIUS server is obsolete.

l For any custom user databases, an authentication source must be created in CPPM.
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RADIUS Database User Accounts

l User accounts are migrated and keep the status (disabled, pending, active, expired) they had in 3.9. Any
field names that differ in 6.2 are updated.

l User accounts with the Deleted status are obsolete.

RADIUS Dictionary

l The RADIUS dictionary is unsupported.

RADIUS NAS List

l Each RADIUS network access server (NAS) is imported as a CPPM network access device (NAD) client.

RADIUS Server Configuration

l Non-default RADIUS Server Number settings are obsolete.

l Non-default RADIUS Server Port settings are obsolete.

l Default RADIUS Server Options are not applicable; they are processed and ignored.

l For any non-default RADIUS Server Options, an authentication source must be created in CPPM.

l Non-default Case Insensitive Username settings are obsolete.

l Non-default Include Active Sessions settings are obsolete.

l Non-default EAP Server settings are obsolete.

l Non-default AAA Debug settings are obsolete.

l Non-default Extra RADIUS Attributes settings are obsolete.

l Non-default Interim Accounting settings are obsolete.

l RADIUS Server Configuration is imported (and flagged as imported or action required)

RADIUS User Roles

l For any role that does not have the default attributes ( Reply-Message := <?= $role['name'], the role
must be manually configured in CPPM.

l For any role that had MAC caching enabled, the role must be manually configured in CPPM.

RADIUS Web Logins

l RADIUS Web logins are imported.

Import Information: Reporting Manager Definitions

l Reports must be re-created in ClearPass Insight.

Import Information: Server Configuration

l ClearPass settings are obsolete.
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Data Retention

l Data Retention settings for Onboard are imported.

Database Configuration

l Default (empty) database configuration settings are processed and ignored.

l Non-default database configuration settings should be reviewed for potential issues.

Installed Plugin List

l For imported plugins that were not up-to-date (e.g. pre-3.9), you must review the version numbers
provided in Show Details, upgrade those plugins in your 3.9 system, and import the plugins again.

Network Hostname

l The network hostname must be set in CPPM.

Network Hosts

l Default hosts files (references to localhost only) are obsolete.

l For a non-default hosts file, the DNS must be properly configured.

Network Interface Configuration

l Network interfaces are unsupported.

Security Audit Settings

l Security audit settings are obsolete.

Server Time Setup

l Server time settings must be configured in CPPM.

SNMP Configuration

l If SNMP was enabled, settings must be configured in CPPM.

SSL Certificate Setup

l The backup certificate is processed and ignored.

l For other certificates, the certificate and the private key should be downloaded and the certificate
imported into CPPM.

Subscription IDs

l If the following settings do not have default values, they are updated to the new default values and
migrated:

n Session ID

n Update URL

n Facility

l For non-default Application URLs, changes should be reviewed.
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l Subscription IDs must be added to CPPM.

l For non-default HTTP Proxy settings, the HTTP proxy must be configured in CPPM.

System HTTP Proxy

l For non-default HTTP Proxy settings, the HTTP proxy must be configured in CPPM.

System Kernel Configuration

l System kernel configuration is obsolete.

System Log Setup

l System log setup is obsolete.

l If a local collector was enabled, it is unsupported.

Web Application Configuration

l Default Application Configuration settings are processed and ignored.

l For non-default Application Configuration settings, PHP settings must be configured in CPPM.

Web Server Configuration

l Web server configuration is obsolete.

Import Information: SMS Services
l SMS gateways are imported as service handlers.

Import Information: SMTP Services

l The following settings are updated to the new defaults and the configuration is migrated:

n Additional Headers

n Copies To

n Email Receipt

n Enable warnings

n From Address

n Logout Warnings

n Mail Transfer Settings

n Override From

n Password

n Reply-To

n Send Copies

n Skin

n SMTP Port

n SMTP Server

n Subject Line
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n Username

n Use Sendmail

n Use SSL encryption

Plugin Manager

Plugins are the software components that fit together to make your Web application. The Available Plugins list
shows all the plugins currently included in your application. It lets you view information about each plugin and
configure some aspects of most plugins. You can click a plugin’s name to go directly to that area of the
application—for example, clicking the name of the SMTP Services plugin opens the Customize Email Receipt
page in the Configuration module.

Viewing Available Plugins

To access the Available Plugins list, go to Administration > Plugin Manager.The Available Plugins page
opens.Plugins are listed by category and include:

l Standard application plugins—Provide corresponding functionality for interactive use by operators

l Kernel plugins—Provide the basic framework for the application

l Operator Login plugins—Control access to the Web application

l Skin plugins—Provide the style for the application’s visual appearance

l Transaction Processor plugins—Provide transaction service handlers for interfacing with various payment
solution providers

l Translation—Provides configurable language settings for the application

The About link displays information about the plugin, including the installation date and update date. The
About page for the Kernel plugin also includes links to verify the integrity of all plugin files or perform an
application check.
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Click a plugin’s Configuration link to view or modify its settings. See "Configuring Plugins" on page 444 for
details about the configuration settings.

Configuring Plugins
You can configure most standard, kernel, skin, and translation plugins. Skin plugins can also be enabled or
disabled, letting you choose which skin to use. To view or change a plugin’s configuration, go to the
Administration > Plugin Manager page and click the List Available Plugins command.

To view or change the configuration settings for a plugin, click the plugin’s Configuration link. The
Configure Plugin form shows the current configuration settings for a plugin, and allows you to make changes
to these settings.

To undo any changes to the plugin’s configuration, click the plugin’s Restore default configuration link.
The plugin’s configuration is restored to the factory default settings.

In most cases, plugin configuration settings do not need to be modified directly. Use the customization options
available elsewhere in the application to make configuration changes.

For more information about plugin configuration:

l AirGroup Services—See "Configuring AirGroup Services" on page 361

l API Services—See "Configuring the API Framework Plugin" on page 373

l ArubaClearPass Skin—See "Configuring Plugins" on page 444

l Guest Manager—See "Default Settings for Account Creation" on page 192

l IP Phone Services—See "Configuring the IP Phone Services Plugin" on page 448

l Kernel—See "Configuring Plugins" on page 444

l MAC Authentication—See "MAC Address Formats" on page 76

l SMS Services—See "Configuring Plugins" on page 444

l SMTP Services—See "Email Receipt Options" on page 286

l SOAP Web Services—See "Configuring Web Services " on page 380

Anexo 11 ITEM 01 (0592523)         SEI 0008478-63.2018.6.02.8000 / pg. 3471



l Translation Services—See "Configuring the Translations Plugin" on page 449

Configuring the Kernel Plugin
The Kernel Plugin provides the basic framework for the application. Settings you can configure for this plugin
include the application title, the debugging level, the base URL, and the application URL, and autocomplete.

1. To change the application’s title, enter the new name in the Application Title field (for example, your
company name) to display that text as the title of your Web application. Click Save Configuration.

2. The Kernel plugin’s Debug Level and Application URL options should not be modified unless you are
instructed to do so by Aruba support.

3. To turn off autocomplete on forms, mark the check box in the Form Auto Complete row. This disables
credentials caching.

4. In the Security row, to prevent the Web application being used from within another frame, mark the check
box for Enable protection against "Clickjacking" attacks.

5. To allow access to secure Web sites providing an invalid certificate, you can mark the check box in the SSL
Verification row.

6. To restore the plugin’s configuration to the original settings, click the Restore default configuration link
below the form. A message alerts you that the change cannot be undone, and a comparison of the current
and default settings highlights the changes that will be made.

7. Review the differences between the current settings and the default configuration. To commit the change
to the default settings. click the Restore Default Configuration link.
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Configuring the Aruba ClearPass Skin Plugin
A Web application’s skin determines its visual style—the colors, menus, and graphics. You can use either the
standard Aruba ClearPass skin plugin, a blank plugin if you are providing your own complete HTML page, or
custom skin plugins that let you configure the colors, navigation, logo, and icons.

1. To modify the standard Aruba ClearPass skin plugin, click its Configuration link on the Available Plugins
page.

2. The default navigation layout is “expanded.” To change the behavior of the navigation menu, click the
Navigation Layout drop-down list and select a different expansion level for menu items.

3. The Page Heading field allows you to enter additional heading text to be displayed at the very top of the
page.

4. In the Font Family row, to change the font, delete the current selection and enter the list of fonts to use.

5. To change a color in any of the color fields, click the color sample box to open the color picker. Set a color,
then click Select in the color picker for that item. Repeat for each color you want to change.

6. Click Save Configuration.

The default skin used by the ClearPass Guest application is the one that is enabled in the Plugin Manager. To
change the default skin globally, go to the plugin list and click the Enable link for the skin you would like to use
as the default. When you install a new custom skin, it is automatically enabled and becomes the default skin. If
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your application’s appearance does not automatically change, find the custom plugin in the list, click
Configure, and click its Enable link. If you prefer to use the standard Aruba ClearPass skin, navigate to it in the
Available Plugins list and click its Enable link.

The default skin is displayed on all visitor pages, and on the login page if no other skin is specified for it.
However; you can override this for a particular operator profile, an individual operator, or give the login page a
different appearance than the rest of the application. You can also specify a skin for guest self-registration
pages.

l To use a different skin for a particular operator profile, see "Creating an Operator Profile" on page 456.

l To use a different skin for an individual operator login, see "Local Operator Authentication" on page 462.

l To have the login page use a different skin than the rest of the application, see "Operator Logins
Configuration" on page 454.

l To specify a skin for a customized guest self-registration page, see "Configuring Basic Properties for Self-
Registration" on page 243.

Configuring the SMS Services Plugin
The SMS Services plugin configuration allows you to configure options related to SMS receipts. You may also
configure SMS receipt options in the Customization module (see "Customizing SMS Receipt" on page 290).

To view or configure SMS services and receipt options:

1. Go to Administration > Plugin Manager. The Available Plugins list opens.

2. Scroll to the SMS Services row and click its Configuration link. The Configure SMS Services form opens.

Figure 42 Configure SMS Services Plugin

SMS Receipt – Select the print template to be used when an SMS receipt is created. The print template used
for the receipt must be in plain text format.

l Phone Number Field – Select which guest account field contains the guest’s mobile telephone number.
This field is used to determine the SMS recipient address.
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l Auto-Send Field – Select a guest account field which, if set to a non-empty string or non-zero value, will
trigger an automatic SMS when the guest account is created or updated. The auto-send field can be used
to create an “opt-in” facility for guests. Use a check box for the auto_send_sms field and add it to the
create_user form, or a guest self-registration instance, and SMS messages will be sent to the specified
phone number only if the check box has been selected.

l Credit Warning – When SMS credits get below this threshold, the system will send a warning to the system
administrator.

l Advanced Gateways – Select this option to configure SMS gateways from multiple SMS providers.
ClearPass Guest SMS services support SMS USA, SMS Worldwide, AQL, Sirocco, Tempos 21 and Upside
Wireless SMS gateways.

l SMS via SMTP – Select this option to allow visitor account receipt messages to be sent in an email using the
defined SMTP server.

l Phone Number Normalization – The phone number normalization process translates phone strings that
are entered in various formats into a single standard format. Click this drop-down list and select one of the
following options:

n Use the visitors value: When you select this option, the SMS gateway will always send the SMS
message using the phone number and country code entered by the visitor.

n Always include the country code: When you select this option, the SMS gateway will always send the
SMS message using the global country code and default phone number length specified in the Default
Country Code and Default Phone Length fields. For example, consider an Australian mobile phone
number with a default number length of 9 plus a leading zero, and a country code of 61. If you selected
the Always include the country code option, the Australian mobile number 0412345678would
normalize to +61412345678 in the internationalized format.

n Never include the country code: When you select this option, any country code specified by the
visitor is removed before the SMS message is sent.

ClearPass Guest 3.9 and earlier used www.amigopod.com for a number of actions, including updates, SMS, and
network diagnostics. The address used now is clearpass.arubanetworks.com. If you have host-specific openings in
your firewall for the ClearPass appliance, please update them to the new address.

Configuring the IP Phone Services Plugin
The Cisco IP Phone Services plugin configuration allows you to configure debugging levels for Cisco IP Phone
service requests. The higher the debugging level, the more information will be included in the application log.

Available debugging levels are:

l 0 — No debugging output

l 1 — Log requests

l 2 — Log requests with full details
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Configuring the Translations Plugin
The Translation Assistant plugin shows the current version, type, original installation date, date of last update,
whether it can be configured, and the copyright date. The Translation Assistant plugin cannot be configured.

By default, the display language for the ClearPass Guest user interface is automatically detected based on the
user's browser settings. To enable or disable language packs, set a default language for ClearPass Guest, or
customize label and message text, see "About Translations" on page 307.

Support Services

The Administration > Support Services page provides links to ClearPass Guest documentation, the
application log, and Aruba Customer Support contact information.
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Viewing the Application Log

To view events and messages generated by the application, go to Administration > Support > Application
Log. The Application Log view opens.

To view in-depth information about an event, click the event’s row. The form expands to show details. Click the
event’s row again to close it.

To view the logs for a different server when in a cluster, use the Server drop-down list above the table.

To search for a particular log record, use the Keywords field above the table to enter search terms. You can
use the hyphen character (-) in front of a keyword to exclude items, and you can use quotes (“ “) to group
words as a key phrase.

The Application Log lists the events, messages, and configuration changes for the past seven days. To view
events and messages for a different period, or to limit the search items:

1. Click the Filter tab. The Filter Settings form opens.

2. You can use the Times drop-down list to specify a time period to filter for.

3. The Severity drop-down list lets you limit the range of severity to search for:
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l Error—Returns Error items

l Warning—Returns Error and Warning items

l Info—Returns Error, Warning, and Info items

l Debug—Returns Error, Warning, Info, and Debug items

4. By default, only the Client IP and Message fields are searched. To search all fields, mark the check box in the
Options row.

Events are stored in the Application Log for seven days by default. To review a record of significant runtime
events prior to the last seven days, you can use the Audit Viewer in ClearPass Policy Manager’s Monitoring
module.

Exporting the Application Log
To save the log in other formats:

1. Click the Export tab. The Export Application Logs form opens.

2. In the Format drop-down list, choose the format you want the file saved as. The available formats are
HTML document (.html), Comma-Separated Values (.CSV), Tab-Separated Values (.tsv), Text file (.txt), and
XML document (.xml). The default format is HTML.

3. In the Range drop-down list, select the range of pages to save. Options include the current page only, all
pages starting from the current page, or all pages starting from the first page that matched any keyword or
filter criteria you entered.

4. If you entered a range of pages in the Range drop-down list, the form expands to include the Download
Limit row.

5. Click Export. You are given the option to open the file, save it to your Downloads folder (the default), or
save it to another location.

Contacting Support
To view contact information for Aruba Support, go to Administration > Support > Contact Support. The
Contact Support page opens. This page provides the following information:

l Toll-free telephone numbers for North American support

l A link to contact Aruba Support by email

l A link to Aruba’s online Contact Support page, which includes telephone numbers and other contact
information for over 30 countries
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Viewing Documentation

To view ClearPass Guest documentation, go to Administration > Support > Documentation. The
Documentation page opens.

l To view this User Guide in your browser as online help, click Browse Documentation. The document
opens in a separate browser tab.

l To view the User Guide as a PDF, click Deployment Guide. The PDF file opens in a separate tab.
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Chapter 9
Operator Logins

An operator is a company’s staff member who is able to log in to ClearPass Guest. Different operators may
have different roles that can be specified with an operator profile. These profiles might be to administer the
ClearPass Guest network, manage guests, or run reports.

Operators may be defined locally in ClearPass Guest, or externally in an LDAP directory server.

Accessing Operator Logins
To access ClearPass Guest’s operator login features, click the Administration link in the left navigation, then
click Operator Logins.

About Operator Logins
ClearPass Guest supports role-based access control through the use of operator profiles. Each operator using
the application is assigned a profile which determines the actions that the operator may perform, as well as
global settings such as the look and feel of the user interface.

Your profile may only allow you to create guest accounts, or your profile might allow you to create guest
accounts as well as print reports. What your profile permits is determined by the network administrator.
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Two types of operator logins are supported: local operators and operators who are defined externally in your
company’s directory server. Both types of operators use the same login screen.

Role-Based Access Control for Multiple Operator Profiles
Using the operator profile editor, the forms and views used in the application may be customized for a specific
operator profile, which enables advanced behaviors to be implemented as part of the role-based access control
model.

This process is shown in the following diagram.

Figure 43 Operator profiles and visitor access control

See "About Operator Logins" on page 453 for details on configuring different forms and views for operator
profiles.

Operator Logins Configuration

You are able to configure a message on the login screen that will be displayed to all operators. This must be
written in HTML. You may also use template code to further customize the appearance and behavior of the
login screen.

Options related to operator passwords may also be specified, including the complexity requirements to
enforce for operator passwords.

Go to Administration > Operator Logins and click the Operator Logins Configuration command link to
modify these configuration parameters.
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Custom Login Message

If you are deploying ClearPass Guest in a multi-lingual environment, you can specify different login messages
depending on the currently selected language.

The following example from the demonstration site uses Danish (da), Spanish (es) and the default language
English, as highlighted in bold:

{if $current_language == 'da'}

<p>
Indtast brugernavn og password for at <br>
få adgang til ClearPass Guest
</p>
<p>
Kontakt <a href="http://www.airwire.dk/">Airwire</a> (Norden) for at få demoadgang
</p>
{elseif $current_language == 'es'}
<p>
Para entrar en el web demo de ClearPass Guest,<br>
necesitas un nombre y contraseña.
</p>
<p>
Si no tienes un login, puedes obtener uno<br>
<a href="http://www.arubanetworks.com/">contactando con Aruba Networks</a>.
</p>
{else}
<p>
The ClearPass Guest demo site <br>
requires a username and password.
</p>
<p>
If you don’t have a login, <br>
<a href="http://www.arubanetworks.com/">contact Aruba Networks</a> to obtain one.
</p>
{/if}
<br clear="all">

In the Login Footer field, enter any HTML information that you want displayed in the Operator Login form.
Select the login skin from the Login Skin drop-down menu. Options include the default skin or a customized
skin.
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Advanced Operator Login Options

The following options are available in the Logging drop-down list:

l No logging

l Log only failed operator login attempts

l Log only Web logins

l Log only XMLRPC access

l Log all access

Log messages for operator logins, whether successful or unsuccessful, are shown in the application log.

Automatic Logout
The Logout After option in the Advanced Options section lets you configure an amount of idle time after which
an operator’s session will be ended.

The value for Logout After should be specified in hours. You can use fractional numbers for values less than an
hour; for example, use 0.25 to specify a 15 minute idle timeout.

Operator Profiles

An operator profile determines what actions an operator is permitted to take when using ClearPass Guest.

Some of the settings in an operator profile may be overridden in a specific operator’s account settings. These
customized settings will take precedence over the default values defined in the operator profile.

To define new operator profiles and to make changes to existing operator profiles, go to Administration >
Operator Logins > Profiles. The Operator Profiles page opens with the profiles list displayed.

Creating an Operator Profile

On the Administration > Operator Logins > Operator Profiles page, click the Create a new operator
profile link to create a new operator profile.

The Edit Operator Profile (new) form is displayed. This form has several sections, which are described in
more detail below.
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The fields in the first area of the form identify the operator profile and capture any optional information:

1. You must enter a name for this profile in the Name field.

2. (Optional) You may enter additional information about the profile in the Description field.

The fields in the Access area of the form define permissions for the operator profile:

1. In the Enabled row, the Allow Operator Logins check box is selected by default. To disable a profile,
unmark the Allow Operator Logins check box. If a profile is disabled, any operators with that profile will
be unable to log in to the system. This may be useful when performing system maintenance tasks.

2. In the Operator Privileges area, use the drop-down lists to select the appropriate permissions for this
operator profile.

For each permission, you may grant No Access, Read Only Access, Full Access, or Custom access. The
default in all cases is No Access. This means that you must select the appropriate privileges in order for the
profile to work. See "Operator Profile Privileges" on page 460 for details about the available access levels for
each privilege.

If you choose the Custom setting for an item, the form expands to include additional privileges specific to
that item.

3. The User Roles list allows you to specify which user databases and roles the operator will be able to access.
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If one or more roles are selected, then only those roles will be available for the operator to select from when
creating a new guest account. The guest account list is also filtered to show only guest accounts with these
roles.

If a database is selected in the User Roles list, but no roles within that database are selected, then all roles
defined in the database will be available. This is the default option.

4. The Operator Filter may be set to limit the types of accounts that can be viewed by operators. Options
include: default, no operator filter, only show accounts created by the operator, and only show accounts
created by operators within their profile.

5. The User Account Filter and Session Filter fields are optional, and allow you to create and configure
these filtering options:

l The User Account Filter field lets you create a persistent filter applied to the user account list. For
example, this feature is useful in large deployments where an operator only wants to have a filtered view
of some accounts. To create an account filter, enter a comma-delimited list of field-value pairs.
Supported operators are described below.

l The Session Filter field lets you create a filter for only that session. To create a session filter, enter a
comma-delimited list of field-value pairs. Supported operators are described below.

The user can enter a simple substring to match a portion of the username or any other fields that are
configured for search, and may include the following operators:
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Operator Meaning Additional Information

= is equal to

You may search for multiple values when using the
equality (=) or inequality !=) operators. To specify multiple
values, list them separated by the pipe character ( | ).

For example, specifying the filter "role_id=2|3, custom_
field=Value" restricts the user accounts displayed to those
with role IDs 2 and 3 (Guest and Employee), and with the
field named "custom_field" set to "Value".

!= is not equal to

> is greater than

>= is greater than or equal to

< is less than

<= is less than or equal to

~ matches the regular expression

!~ does not match the regular
expression

Table 106: Operators supported in filters

6. In the Account Limit row, you can enter a number to specify the maximum number of accounts an
operator can create. Disabled accounts are included in the account limit. To set no limit, leave the Account
Limit field blank.

When you create or edit an AirGroup operator, the value you enter in the Account Limit field specifies the
maximum number of devices an AirGroup operator with this profile can create.

Configuring the User Interface

The fields in the User Interface area of the form determine elements of the application’s visual appearance
and behavior that operators with this profile will see. The Skin, Start Page, Language, and Time Zone
options specify the defaults to use for operators with this profile. Individual operator logins may have different
settings, which will be used instead of the values specified in the operator profile. For information on specifying
options at the individual operator level, see "Local Operator Authentication" on page 462.

1. (Optional) In the Skin row, the Default setting indicates that the skin plugin currently marked as enabled in
the Plugin Manager will be used. To have a different skin displayed for users with this operator profile,
choose one of the available skins from the drop-down list. For more information on skins, see "Plugin
Manager" on page 443.

2. (Optional) In the Start Page row, the Default setting indicates that the application’s standard Home page
will be the first page displayed after login. To have a different start page displayed to users with this
operator profile, choose a page from the drop-down list. For example, if a profile is designed for users who
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do only certain tasks, you might want the application to open at the module where those tasks are
performed.

3. (Optional) In the Language row, the default setting is Auto-detect. This lets the application determine the
operator’s language preference from their local system settings. To specify a particular language to use in
the application, choose the language from the drop-down list.

4. (Optional) In the Time Zone row, the Default setting indicates that the operator’s time zone will default to
the system’s currently configured time zone. You can use the drop-down list to specify a particular time
zone.

5. (Optional) In the Customization row, you can choose to override the application’s default forms and views.
For more information, see the next section, "Customizing Forms and Views" on page 212.

Customizing Forms and Views
You can use the Customization option in the Operator Profile Editor to override default forms and views and
specify different ones to be used for the operator profile.

To specify that an operator profile should use a different form when creating a new visitor account:

1. (Optional) In the Customization row, select the Override the application’s forms and views check
box. The form expands to show the forms and views that can be modified. If alternative forms or views
have been created, you may use the drop-down lists to specify which ones to use.

2. When you have selected the custom forms and views to use, click Save Changes to complete the
creation of the operator profile.

Operator Profile Privileges
The privilege selections available for an operator profile provide you with control over the functionality that is
available to operators.

No Access means that the operator will have no access to the particular area of functionality. Options for that
functionality will not appear for that operator in the menus.
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Read Only Access means that the operator can see the options available but is unable to make any changes
to them.

Full Access means that all the options are available to be used by the operator.

Custom access allows you to choose individual permissions within each group. For example, Guest Manager
allows you to control access to the following areas:

l Active sessions management

l Viewing historical data for active sessions

l Changing expiration time of guest accounts

l Creating multiple guest accounts

l Creating new guest accounts

l Editing multiple guest accounts

l Exporting guest account data

l Full user control of guest accounts

l Importing guest accounts

l Listing guest accounts

l Managing customization of guest accounts

l Managing print templates

l Removing or disabling guest accounts

l Resetting guest passwords

Refer to the description of each individual operator privilege to determine what the effects of granting that
permission will be.

Managing Operator Profiles
After a profile is created you are able to view, to edit and to create new profiles. When you click an operator
profile entry in the Operator Profiles list, a menu appears that allows you to perform any of the following
operations:

l View/Hide Details – displays or hides configuration details for the selected operator profile, including
the profile name, description, operator login access, and the settings for the defined skin, start page,
language and time zone.

l Edit – changes the properties of the specified operator profile

l Delete – removes the operator profile from the Operator Profiles list

l Duplicate – creates a copy of an operator profile

l Create Operator – opens the Create Operator Login form, allowing you to create a new operator
login associated with the selected operator profile.

l Show Operators – shows a list of operator login names associated with that operator profile

l Show Usage – opens a window in the Operator Profiles list that shows if the profile is in use, and lists
any LDAP authentication servers, LDAP translation rules, and operator logins associated with that profile.
Each entry in this window appears as a link to the form that lets you edit that LDAP or operator login
setting.
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Configuring AirGroup Operator Device Limit
By default, an AirGroup operator can create up to five personal devices. To change this default:

1. Go to Administration > Operator Logins > Profiles, then select the AirGroup Operator profile in the
list.

2. Click the Edit link. The Edit Operator Profile form opens.

3. In the Account Limit field, specify an appropriate value. This is the maximum number of personal devices
that an operator with this profile can create.

4. Click Save Changes.

You can create a set of operator profiles and configure each profile with a different account limit. This makes it
easy to assign operator profiles appropriately for small groups, larger groups, or events. To create each profile
in the set, duplicate the built-in AirGroup Operator profile, and update the Account Limit field in the new
profile.

Local Operator Authentication

ClearPass Policy Manager profiles and ClearPass Guest profiles are different. To create a ClearPass Guest
operator login, local users are first defined in ClearPass Policy Manager with a role that matches an operator
profile in Guest, then rules are used to map the role to the Guest operator profile.

Creating a New Operator

To create a new operator or administrator for ClearPass Guest or AirGroup, some steps are performed in
ClearPass Policy Manager (CPPM), and some steps are performed in ClearPass Guest, as described below:

1. Create an operator profile in ClearPass Guest, or use an existing one. See "Operator Profiles" on page 456.

l To create an AirGroup user, choose either the AirGroup Administrator or AirGroup Operator profile,
as appropriate. These profiles are automatically included in ClearPass Guest when the AirGroup Services
plugin is installed.

l MACTrac users are created entirely in CPPM.

2. Create a CPPM role for the operator: In CPPM, go to Configuration > Identity > Roles and create a role
that matches the operator profile. Refer to the ClearPass Policy Manager documentation for information on
creating the role.

l When creating AirGroup users or MACTrac users, the appropriate roles are already created in CPPM.

3. Create a local user for the operator: In CPPM, go to Configuration > Identity > Local Users and click Add
User. In the Add Local User form, complete the fields and choose the appropriate role from the Role drop-
down list.

l To create an AirGroup user, choose either the AirGroup Administrator or AirGroup Operator role, as
appropriate.

l To create a MACTrac user, choose the MACTrac Operator role. This form completes MACTrac user
creation; the following steps are not required.
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4. Create a translation rule to map the CPPM role name to the ClearPass Guest operator profile: In ClearPass
Guest, go to Administration > Operator Logins > Translation Rules.

5. In the Translation Rules list, find the profile in the list, look at the Action column to verify the operator
profile assignment, and then click its Edit link. The row expands to include the Edit Translation Rule form.

6. Edit the fields appropriately to match the CPPM role name to the ClearPass Guest operator profile. See
"LDAP Translation Rules" on page 469.

7. Click Save Changes.

External Operator Authentication

Operators defined externally in your company’s directory server form the second type of operator.
Authentication of the operator is performed using LDAP directory server operations. The attributes stored for
an authenticated operator are used to determine what operator profile should be used for that user.

At Administration > Operator Logins > Start Here, the Manage Operator Servers and the Translation
Rules commands allow you to set up operator logins integrated with a Microsoft Active Directory domain or
another LDAP server.

The operator management features, such as creating and editing operator logins, apply only to local operator logins
defined in ClearPass Guest. You cannot create or edit operator logins using LDAP. Only authentication is supported.

Manage LDAP Operator Authentication Servers

ClearPass Guest supports a flexible authentication mechanism that can be readily adapted to any LDAP
server’s method of authenticating users by name. There are built-in defaults for Microsoft Active Directory
servers and POSIX-compliant directory servers.

When an operator attempts to log in, each LDAP server that is enabled for authentication is checked, in order
of priority from lowest to highest.

When a server is found that can authenticate the operator’s identity (typically with a username and password),
the LDAP server is queried for the attributes associated with the user account.

These LDAP attributes are then translated to operator attributes using the rules defined in the LDAP
translation rules. In particular, an operator profile will be assigned to the authenticated user with this process,
which controls what that user is permitted to do.
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Viewing the LDAP Server List
If you have defined one or more LDAP servers, those servers will appear in the LDAP server list at
Administration > Operator Logins > Servers.

Select any of the LDAP servers in the list to display options to perform the following actions on the selected
server:

l Edit—Opens the Server Configuration form, where you can make changes to the properties of the LDAP
server.

l Delete—Removes the server from the LDAP server list.

l Duplicate—Creates a copy of an LDAP server. You can then click the Edit link to open the Server
Configuration form and use original server’s properties as a template for creating a new server.

l Disable—Temporarily disables a server while retaining its entry the server list.

l Enable—Reenables a disabled LDAP server.

l Ping—Sends a ping message (echo request) to the LDAP server to verify connectivity between the LDAP
server and the ClearPass Guest server.

l Test Auth—Adds a Test Operator Login area in the LDAP servers form that allows you to test
authentication of operator login values.

l Test Lookup—Adds a Test Operator Lookup form in the LDAP servers list that allows you to look up
sponsor names. This option is only available if sponsor lookup has been enabled for the server on the Edit
Authentication Server page.
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Creating an LDAP Server

To create an LDAP server, go to Administration > Operator Logins > Servers, and click the Create new
LDAP server link in the upper-right corner. The authentication Server Configuration form opens.

To specify a basic LDAP server connection (hostname and optional port number), use a Server URL of the form
ldap://hostname/ or ldap://hostname:port/. See "Advanced LDAP URL Syntax" on page 467 for more
details about the types of LDAP URL you may specify.

This form allows you to specify the type of LDAP server your system will use. Click the Server Type drop-down
list and select one of the following options:

Server Type Required Configuration Parameters

Microsoft Active
Directory

l Server URL: The URL of the LDAP server
l Bind DN: The password to use when binding to the LDAP server, or empty for an

anonymous bind.
l Bind Password: If your LDAP server does not use anonymous bind, you must supply

the required credentials to bind to the directory. (Leave this field blank to use an
anonymous bind.)

For more information on the Microsoft Active Directory server type, see "Advanced
LDAP URL Syntax" on page 467.

POSIX Compliant

l Server URL: The URL of the LDAP server
l Bind DN: The password to use when binding to the LDAP server, or empty for an

anonymous bind.
l Bind Password: The password to use when binding to the LDAP server. Leave this

Table 107: Server Type Parameters
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Server Type Required Configuration Parameters

field blank to use an anonymous bind.
l Base DN: The Distinguished Name to use for the LDAP search.

Custom

l Server URL: The URL of the LDAP server
l Bind DN: The password to use when binding to the LDAP server, or empty for an

anonymous bind.
l Bind Password: The password to use when binding to the LDAP server. Leave this

field blank to use an anonymous bind.
l Base DN: The Distinguished Name to use for the LDAP search.
l Unique ID: The name of an LDAP attribute used to match the username.
l Filter: Additional LDAP filters to use to search for the server.
l Attributes: List of LDAP attributes to retrieve. Or leave bland to retrieve all attributes

(default).

If you mark the Enabled check box in the User Search area, the form expands to include the AirGroup and
Sponsor Lookup configuration options.

For Sponsor Lookups, if you want to enable the validation of sponsor emails during self-registration, you
must add the sponsor_lookup field to the registration and change the user interface to "Multiple selection list"
and then check the Select2 Options for additional properties. The server will then look up sponsors during self-
registration and double-check the attribute used for emails on the LDAP server. This option requires that the
sponsor_email and do_ldap_lookup fields are enabled in the registration form, and that you have the LDAP
Sponsor Lookup plugin installed. Use the Plugin Manager to verify that this plugin is available.

In the Operator Logins area, to use this LDAP server to authenticate operator logins, select the Enabled
check box. Use the Default Profile drop-down list to select the default operator profile to assign to operators
authorized by this LDAP server.LDAP servers for operator logins are configured in Policy Manager.

When you have completed the form, you can check your settings. Use the Test Username and Test
Password fields to supply a username and password for the authentication check, then click the Test
Settings button. The minimum password length is six characters. If the authentication is successful, the
operator profile assigned to the username will be displayed. If the authentication fails, an error message will be
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displayed. See "LDAP Operator Server Troubleshooting" on page 467 for information about common error
messages and troubleshooting steps to diagnose the problem.

Click the Save Changes button to save this LDAP Server. If the server is marked as enabled, subsequent
operator login attempts will use this server for authentication immediately.

Advanced LDAP URL Syntax
If you select Microsoft Active Directory as the Server Type on the Administration > Operator Logins
> Servers > Server Configuration form, the LDAP server connection will use a default distinguished name of
the form dc=domain,dc=com, where the domain name components are taken from the bind username.

To specify a different organizational unit within the directory, include a distinguished name in the LDAP server
URL, using a format such as:

ldap://192.0.2.1/ou=IT%20Services,ou=Departments,dc=server,dc=com

To specify a secure connection over SSL/TLS, use the prefix ldaps://.

To specify the use of LDAP v3, use the prefix ldap3://, or ldap3s:// if you are using LDAP v3 over SSL/TLS.

When Microsoft Active Directory is selected as the Server Type, LDAP v3 is automatically used.

An LDAP v3 URL has the format ldap://host:port/dn?attributes?scope?filter?extensions.

l dn is the base X.500 distinguished name to use for the search.

l attributes is often left empty.

l scope may be ‘base’, ‘one’ or ‘sub’.

l filter is an LDAP filter string, for example, (objectclass=*)

l extensions is an optional list of name=value pairs.

Refer to RFC 2255 for further details.

LDAP Operator Server Troubleshooting
At Administration > Operator Logins > Servers, you can use the LDAP Operator Servers list to
troubleshoot network connectivity, operator authentication, and to look up operator usernames.

Testing Connectivity

To test network connectivity between an LDAP server and the ClearPass Guest server, click the Ping link in
the server’s row. The results of the test appear below the server entry in the LDAP server table.

Testing Operator Login Authentication
1. To test authentication of operator login values, select a server name in the LDAP Server table, then click the

Test Auth link. The Test Operator Login form is added to the page.
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2. Enter an operator username and password for the LDAP Server. The minimum password length is six
characters.

3. (Optional) Click the Advanced check box to display detailed authorization information for the specified
operator.

4. Click Log In to attempt to authenticate the LDAP server, or click Cancel to cancel the test. The
Authentication Test area is added above the server names to indicate the test’s progress.

You can also verify operator authentication when you create a new LDAP server configuration using the
Test Settings button on the LDAP Configuration form (See "Creating an LDAP Server" on page 465 for a
description).

Looking Up Sponsor Names
This option is only available if sponsor lookup has been enabled for the server on the Edit Authentication
Server page.

1. To look up a sponsor, select a server name in the LDAP Server table, then click the Test Lookup link. The
Test Operator Lookup area is added to the LDAP servers list.

2. In the Lookup field, enter a lookup value. This can be an exact username, or you can include wildcards.If
you use wildcards, the search might return multiple values.

3. In the Search Mode field, use the drop-down list to specify whether to search for an exact match or use
wildcard values.

4. (Optional) Click the Advanced check box to display detailed authorization information for the specified
sponsor.

Anexo 11 ITEM 01 (0592523)         SEI 0008478-63.2018.6.02.8000 / pg. 3495



5. Click Search Directory to attempt to find sponsor names that match the lookup values, or click
Cancel to cancel the test. The Authentication Test area is added above the server names to indicate the
search’s progress.

Troubleshooting Error Messages
The error messages in the following table can be used to diagnose error messages such as: “LDAP Bind failed:
Invalid credentials (80090308: LdapErr: DSID-0C090334, comment: AcceptSecurityContext error, data 525,
vece), bind DN was: …”

Error Data Reason

525 User not found

52e Invalid credentials (password is incorrect)

530 Not permitted to log on at this time

531 Not permitted to log on at this workstation

532 Password has expired

533 Account is disabled

701 Account has expired

773 User must reset password

775 User account is locked

Table 108: LDAP Error Messages

Other items to consider when troubleshooting LDAP connection problems:

l Verify that you are using the correct LDAP version – use ldap:// for version 2 and ldap3:// to specify
LDAP version 3.

l Verify that you are using an SSL/TLS connection – use ldaps:// or ldap3s:// as the prefix of the Server
URL.

l Verify that the Bind DN is correct – the correct DN will depend on the structure of your directory, and
is only required if the directory does not permit anonymous bind.

l Verify that the Base DN is correct – the Base DN for user searches is fixed and must be specified as
part of the Server URL. If you need to search in different Base DNs to match different kinds of operators,
then you should define multiple LDAP Servers and use the priority of each to control the order in which the
directory searches are done.

LDAP Translation Rules

LDAP translation rules specify how to determine operator profiles based on LDAP attributes for an
authenticated operator.
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To create a new LDAP translation rule:

1. Go to Administration > Operator Logins > Translation Rules, and then click the Create new
translation rule link. The Edit Translation Rule form opens.

2. In the Name field, enter a self-explanatory name for the translation rule. In the example above, the
translation rule is to check that the user is an administrator, hence the name MatchAdmin.

3. Select the Enabled check box to enable this rule after you create it. If you do not select this check box, the
rule you create will appear in the rules list, but will not be active until you enable it.

4. Click the Matching rule drop-down list and select a rule. The Matching Rule field can be one of:

n (blank) – always matches

n contains – case-insensitive substring match anywhere in string

n matches – regular expression match, where the value is a Perl-compatible regular expression including
delimiters (for example, to match the regular expression “admin” case-insensitively, use the value
“/admin/i”; See "Regular Expressions" on page 523 for more details about regular expressions)

n equals – case-insensitive string comparison, matches on equality

n does not equal – case-insensitive string comparison, matches on inequality

n less than – numerical value is less than the match value

n greater than – numerical value is greater than the match value

n starts with – case-insensitive substring match at start of string

n ends with – case-insensitive substring match at end of string

5. Select a Value. The Value field states what is to be matched, in this case CN=Administrators to look for a
specific group of which the user is a member.

6. Click the On Match drop-down list and select the action the system should take when there is a match.
Your options here are to:

n Do nothing – makes no changes.

n Assign fixed operator profile – assigns the selected Operator Profile to the operator.

n Assign attribute’s value to operator field – uses the value of the attribute as the value for an
operator field. This option can be used to store operator configuration details in the directory. (For
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operator profiles from enforcement profiles, matching can be performed on either their IDs or their
name values, even if the Fallthrough option is not selected)

n Assign custom value to operator field – uses a template to assign a value to a specific operator field.
If you choose this option, the form expands to include the Custom text box for you to enter your
custom template code. See "Custom LDAP Translation Processing" on page 472. (For operator profiles
from enforcement profiles, matching can be performed on either their IDs or their name values, even if
the Fallthrough option is not selected)

n Apply custom processing – evaluates a template that may perform custom processing on the LDAP
operator. If you choose this option, the form expands to include the Custom text box for you to enter
your custom template code. See "Custom LDAP Translation Processing" on page 472.

n Remove attribute from operator – removes the selected LDAP attribute from the operator.

7. Click the Operator Profile drop-down list and select the profile to be assigned if there is a rule match. In
the example shown above, if the Administrator group is matched, the Administrator profile is to be
assigned.

8. Select the Fallthrough check box if you want to use multiple translation rules. When you create multiple
rules, you can build a complete logical structure to perform any type of processing on the LDAP attributes
available in your directory.

9. Click Save Changes to save your rule settings.

The Administration > Operator Logins > Translation Rules window shows a list of all configured
translation rules.

Translation rules are processed in order, until a matching rule is found that does not have the Fallthrough field
set.

To edit the matching rule list, select an entry in the table to display a menu that lets you perform the following
actions:

l Edit – Changes the configuration of matching rule

l Delete – Removes matching rule from the list

l Duplicate – Creates a duplicate copy of an existing rule

l Disable – Temporarily disables the rule without deleting it from the rule list

l Enable – Re-enables a disabled operator login

l Edit Profile – Opens the Edit Operator Profile form for the operator profile assigned to the selected
translation rule

l Move Up – Moves the rule up to a higher priority on the rule list

l Move Down – Moves the rule down to a lower priority on the rule list
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Custom LDAP Translation Processing

When matching an LDAP translation rule, custom processing may be performed using a template.

The template variables available are listed in the table below.

Variable Description

$attr The name of the LDAP attribute that was matched.

$user Contains settings for the operator, including all LDAP attributes returned from the server.

Table 109: Template Variables

For a Smarty template syntax description, See "Smarty Template Syntax" on page 478. These may be used to
make programmatic decisions based on the LDAP attribute values available at login time.

For example, to permit non-administrator users to access the system only between the hours of 8:00 am and
6:00 pm, you could define the following LDAP translation rule:
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The Custom rule is:
{strip}
{if stripos($user.memberof, "CN=Administrators")!==false}
1
{elseif date('H') >= 8 && date('H') < 18}
1
{else}
0
{/if}
{/strip}

Explanation: The rule will always match on the “memberof” attribute that contains the user’s list of groups. The
operator field “enabled” will determine if the user is permitted to log in or not. The custom template uses the
{strip} block function to remove any whitespace, which makes the contents of the template easier to
understand. The {if} statement first checks for membership of the Administrators group using the PHP stripos
() function for case-insensitive substring matching; if matched, the operator will be enabled. Otherwise, the
server’s current time is checked to see if it is after 8am and before 6pm; if so, the operator will be enabled. If
neither condition has matched, the “enabled” field will be set to 0 and login will not be permitted.
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Chapter 10
Reference

This chapter includes the following sections:

l "Basic HTML Syntax" on page 475

l "Standard HTML Styles" on page 476

l "Smarty Template Syntax" on page 478

l "Date/Time Format Syntax" on page 494

l "Programmer’s Reference" on page 496

l "Field, Form, and View Reference" on page 502

l "LDAP Standard Attributes for User Class" on page 522

l "Regular Expressions" on page 523

Basic HTML Syntax
ClearPass Guest allows different parts of the user interface to be customized using the Hypertext Markup
Language (HTML).

Most customization tasks only require basic HTML knowledge, which is covered in this section.

HTML is a markup language that consists primarily of tags that are enclosed inside angle brackets, for example,
<p>. Most tags are paired to indicate the start and end of the text being marked up; an end tag is formed by
including the tag inside the angle brackets with a forward slash, for example, </p>.

Use the following standard HTML tags in customization:

Item HTML Syntax

Basic Content

<h1>Main Heading</h1>

<h2>Subheading</h2>

<h3>Section heading</h3>

<p>Paragraph text</p>

<br>
<br /> – equivalent syntax (XHTML)

<ul>
<li>List item text</li>

</ul>

Table 110: Standard HTML Tags
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Item HTML Syntax

<ol>
<li>List item text</li>

</ol>

Text Formatting

<b>words to be made bold</b>
<strong>equivalent syntax</strong>

<i>words to be made italic</i>
<em>equivalent syntax</em>

<u>words to underline</u>

<tt>Shown in fixed-width font</tt>

<span style="…">Uses CSS formatting</span>
<span class="…">Uses predefined style</span>

<div style="…">Uses CSS formatting</div>
<div class="…">Uses predefined style</div>

Hypertext

<a href="url">Link text to click on</a>

<img src="url">
<img src="url" /> – XHTML equivalent

<img src="url" align="left">

For more details about HTML syntax and detailed examples of its use, consult a HTML tutorial or reference
guide.

Standard HTML Styles
ClearPass Guest defines standard CSS classes you can use to provide consistent formatting within the user
interface.

Examples of these styles are given below.
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Class Name Applies To Description

nwaIndent Tables Indent style used in tables

nwaLayout Tables
Used when you want to lay out material in a table without the
material looking as if it is in a table; in other words, without
borders

nwaContent Tables Class used for a standard table with borders

nwaTop Table Header Table heading at top

nwaLeft Table Header Left column of table

nwaRight Table Header Right column of table

nwaBottom Table Header Table heading at bottom

nwaBody Table Cell Style to apply to table cell containing data

nwaHighlight Table Cell Highlighted text (used for mouseover)

nwaSelected Table Cell Selected text (table row after mouse click)

nwaSelectedHighlight Table Cell Selected text with mouseover highlight

nwaInfo All Informational text message

nwaError All Error text message

nwaImportant All Text that should be prominently displayed
Table subheadings

nwaUsername All Text used to display a username

nwaPassword All Text used to display a password

Table 111: Formatting Classes
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Smarty Template Syntax
ClearPass Guest’s user interface is built using the Smarty template engine. This template system separates the
program logic and visual elements, enabling powerful yet flexible applications to be built.

When customizing template code that is used within the user interface, you have the option of using Smarty
template syntax within the template. Using the programming features built into Smarty, you can add your own
logic to the template. You can also use predefined template functions and block functions to ensure a
consistent user interface.

Basic Template Syntax
Following is a brief introduction to the usage of the Smarty template engine. For more information, please
refer to the Smarty documentation at http://www.smarty.net/docs.php, or the Smarty Crash Course at
http://www.smarty.net/crashcourse.php.

Text Substitution
Simple text substitution in the templates may be done with the syntax {$variable}, as shown below:

The current page’s title is: {$title}

Template File Inclusion
To include the contents of another file, this can be done with the following syntax:

{include file="public/included_file.html"}

Smarty template syntax found in these files is also processed, as if the file existed in place of the {include} tag
itself.

Comments
To remove text entirely from the template, comment it out with the Smarty syntax {* commented text *}. Be
aware that this is different from an HTML comment, in that the Smarty template comment will never be
included in the page sent to the Web browser.

Variable Assignment
To assign a value to a page variable, use the following syntax:

{assign var=name value=value}

The “value” can be a text value (string), number, or Smarty expression to be evaluated, as shown in the
examples below:

{assign var=question value="forty plus two"}
The question is: {$question}
{assign var=answer value=42}
The answer is: {$answer}
{assign var=question_uppercase value=$question|strtoupper}
THE QUESTION IS: {$question_uppercase}

Conditional Text Blocks
To include a block of text only if a particular condition is true, use the following syntax:
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{if $username != ""}
<tr>
<td class="nwaBody">Username:</td>
<td class="nwaBody">{$username}</td>
</tr>

{else}
<!-- No user name, no table row -->

{/if}

The condition tested in the {if} … {/if} block should be a valid PHP expression. The {else} tag does not require
a closing tag.

Script Blocks
The brace characters { and } are specially handled by the Smarty template engine. Using text that contains
these characters, such as CSS and JavaScript blocks, requires a Smarty block {literal} … {/literal}:

<script type="text/javascript" language="JavaScript">
{literal}
<!--
function my_function() {

// some Javascript code here
}
// -->
{/literal}
</script>

Failing to include the {literal} tag will result in a Smarty syntax error when using your template. Single
instances of a { or } character can be replaced with the Smarty syntax {ldelim} and {rdelim} respectively.

Repeated Text Blocks
To repeat a block of text for each item in a collection, use the {section} … {/section} tag:

{section loop=$collection name=i}
<tr>
<td class="nwaBody">
{$collection[i].name}
</td>

</tr>
{sectionelse}
<!-- included if $collection is empty -->

{/section}

The content after a {sectionelse} tag is included only if the {section} block would otherwise be empty.

Foreach Text Blocks
An easier to use alternative to the {section} … {/section} tag is to use the {foreach} … {/foreach} block:

{foreach key=key_var item=item_var from=$collection}
{$key_var} = {$item_var}

{foreachelse}
<!—included if $collection is empty -->

{/foreach}

The advantage of this syntax is that each item in the collection is immediately available as the named item
variable, in this example {$item_var}. This construct is also useful when iterating through associative arrays
indexed by key, as the key is immediately available with each item.

A name= attribute may be supplied with the opening {foreach} tag. When a name is supplied, the following
additional Smarty variables are available for use inside the {foreach} … {/foreach} block:

l {$smarty.foreach.name.first} – true if the item being processed is the first item in the collection

l {$smarty.foreach.name.last} – true if the item being processed is the last item in the collection
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l {$smarty.foreach.name.index} – counter for the current item, starting at 0 for the first item

l {$smarty.foreach.name.iteration} – counter for the current item, starting at 1 for the first item

l {$smarty.foreach.name.total} – value indicating the total number of items in the collection

The content after a {foreachelse} tag is included only if the {foreach} block would otherwise be empty.

Modifiers
Smarty providesmodifiers that can be used to gain greater control over the formatting of data. Modifiers can
be included by following a variable with a vertical bar | and the name of the modifier. Any arguments to the
modifier can be specified using a colon : followed by the arguments.

The following example prints a date using the YYYY-MM-DD syntax:
{$expire_time|nwadateformat:"%Y-%m-%d"}

See "Date/Time Format Syntax" on page 494 for detailed information on the date/time format modifiers, and
see Table 112.

Modifier Description

htmlspecialchars Escapes characters used in HTML syntax with the equivalent HTML entities (&amp; for
&, &lt; for < and &gt; for >)

nl2br Replaces newline characters in the value with HTML line breaks (<br>)

number_format Formats a numerical value for display; an optional modifier argument may be used to
specify the number of decimal places to display (default is 0)

nwadateformat Date/time formatting; see "nwadateformat Modifier" on page 494 for details about
this modifier function

nwatimeformat Date/time formatting; see "Date/Time Format String Reference" on page 495 for
details about this modifier function

nwamoneyformat
Formats a monetary amount for display purposes; an optional modifier argument may
be used to specify the format string. This modifier is equivalent to the
NwaMoneyFormat() function; see "NwaMoneyFormat" on page 499 for details.

strtolower Converts the value to lowercase

strtoupper Converts the value to uppercase

ucfirst Converts the first character of the value to uppercase

ucwords Converts the first character of each word in the value to uppercase

Table 112: Smarty Modifiers

Predefined Template Functions
Template functions are used to perform different kinds of processing when the template is used. The result of
a template function takes the place of the function in the output of the template.

Functions are of two kinds: block functions, which have a beginning and ending tag enclosing the text operated
on by the function, and template functions, which have just a single tag and do not enclose text.

To use a function, enclose the function name in curly braces { } and provide any attributes that may be
required for the function. Block functions also require a closing tag.
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dump
{dump var=$value}

Smarty registered template function. Displays the value of a variable.

Use the following Smarty syntax to print a variable’s contents:
{dump var=$var_to_dump export=html}

The contents of the variable are printed in a <pre> block. Use the attribute “export=1” to use PHP’s var_
export() format, or omit this attribute to get the default behavior – PHP’s var_dump() format.

Use the attribute “html=1” to escape any HTML special characters in the content. This can also be done with
attribute “export=html”, and is recommended for use in most situations (so that any embedded HTML is not
interpreted by the browser).

nwa_commandlink
{nwa_commandlink} … {/nwa_commandlink}

Smarty registered block function. Generates a “command link” consisting of an icon, main text and explanatory
text.

Command links are block elements and are roughly the equivalent of a form button. A command link is
typically used to represent a choice the user should make to proceed. The command link contains an icon,
command text (that sums up the action taken by the command link), and any explanatory text needed for the
command.

Usage example:
{nwa_commandlink icon="images" command="Command Link" linkwidth="400" commandclass="nwaImpo
rtant" text="This is a sentence explaining the command." textclass="nwaInfo"}link_here.php{
/nwa_commandlink}

l The “icon” parameter is the SRC to the image of the icon. This should normally be a relative path.

l The “command” parameter is the main text of the command link.

l The “text” parameter is the explanatory text describing the action that lies behind the command link. (This is
optional.)

l The “linkwidth” parameter, if specified, indicates the width of the command link in pixels. This should be at
least 250; the recommended value is 400.

l The “width” and “height” parameters, if specified, provide the dimensions of the icon to display. If not
specified, this is automatically determined from the image.

l The “onclick” parameter, if specified, provides the contents for the onclick attribute of the link.

l The “commandclass” parameter, if specified, sets the class attribute of the DIV element enclosing the
command text. The default class is “nwaImportant”.

l The “textclass” parameter, if specified, sets the class attribute of the P element enclosing the command link’s
descriptive text. The default class is “nwaInfo”.

l The “alt” parameter, if specified, sets the ALT attribute of the command link’s icon. If not specified, the
default alt text used is the command text.

l The “target” parameter, if specified, sets the TARGET attribute of the hyperlink. If not specified, no TARGET
attribute is provided.

The body of the element is the HREF of the command link. The “icon” and “command” parameters are
required. All other parameters are optional.
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nwa_iconlink
{nwa_iconlink} … {/nwa_iconlink}

Smarty registered block function. Generates a combined icon and text link to a specified URL.

Usage example:
{nwa_iconlink icon="images/icon-info22.png" text="More Information"}more_information.php{/n
wa_iconlink}

l The “icon” parameter is the SRC to the image of the icon. This should normally be a relative path.

l The “text” parameter is the text to display next to the icon. This will also be used as the alternate text (that
is, a tooltip) for the icon image.

l The “width” and “height” parameters, if specified, provide the dimensions of the icon to display. If not
specified, this is automatically determined from the image.

l The “onclick” parameter, if specified, provides the contents for the onclick attribute of the link.

l The “target” parameter, if specified, provides the contents for the target attribute of the link.

l The “alt” parameter, if specified, sets the ALT attribute of the icon. If not specified, the default alt text used
is the icon text.

l The “style” parameter, if specified, provides CSS for the SPAN element used to implement the icon link.

The body of the element is the HREF of the link. This HREF will be added to both the icon and the text. If the
content of the link is empty, no link will be inserted. This can be used to insert an icon and text as an inline
group. No HTML entity escaping is performed when inserting content using this function.

nwa_icontext
{nwa_icontext} … {/nwa_icontext}

Smarty registered block function. Generates a block of text with a marker icon displayed in the top left.

Usage examples:
{nwa_icontext icon="images/icon-info22.png"}Text to display{/nwa_icontext}
{nwa_icontext type="info"}Information block{/nwa_icontext}

l The “icon” parameter, if specified, is the SRC to the image of the icon. This should normally be a relative
path.

l The “width” and “height” parameters, if specified, provide the dimensions of the icon to display. If not
specified, this is automatically determined from the image.

l The “alt” parameter, if specified, provides the alternate text for the icon.

l The “class” parameter, if specified, is the style name to apply to a containing DIV element wrapped around
the content. If this is empty, and a default is not provided through the “type” parameter, no wrapper DIV is
added.

l The “style” parameter, if specified, is the CSS inline style to apply to a containing DIV element, as for the
“class” parameter.

l The “type” parameter, if specified, indicates a predefined style to apply; this may be one of the following:

n error – red cross symbol

n fatal – skull symbol

n info – information symbol

n note (or arrow) – right-pointing arrow

n ClearPass Guest – ClearPass Guest logo
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n ok (or tick) – green tick mark

n warn (or warning) – warning symbol

n wait – animated spinner

If “noindent=1” is specified, the block is not indented using the ‘nwaIndent’ style. If “novspace=1” is specified,
the block uses a ‘DIV’ element, rather than a ‘P’ element. If neither “icon” nor “type” is supplied, the default
behavior is to insert an “info” type image. Specifying a “type” is equivalent to specifying an “icon", “width",
“height” and “alt” parameter, and may also include a “class” depending on the type selected.

Usage example:
{nwa_icontext struct=$error}{/nwa_icontext}

The “struct” parameter, if specified, uses a standard result type. If the “error” key is set and non-zero, the “type”
parameter is set to the value error, and the “message” key is converted to a HTML formatted error message for
display.

nwa_quotejs
{nwa_quotejs} … {/nwa_quotejs}

Smarty registered block function. Quotes its content in a string format suitable for use in JavaScript. This
function also translates UTF-8 sequences into the corresponding JavaScript Unicode escape sequence (\uXXXX)

Usage example:
{nwa_quotejs}String with ' and "{/nwaquote_js}

The output of this will be:
'String with \' and \"'

The “body” parameter, if set, indicates that the string quotes are already supplied; in this case the beginning
and ending quotes are not included in the output.

nwa_radius_query
{nwa_radius_query _method=MethodName _assign=var …}

Smarty registered template function. Performs accounting-based queries on the RADIUS server and returns
the result for use in a template.

Usage example:
{nwa_radius_query _method=GetCallingStationTraffic
callingstationid=$dhcp_lease.mac_address
from_time=86400 in_out=out _assign=total_traffic}

This example uses the GetCallingStationTraffic query function and passes the “callingstationid”, “from_
time” and “in_out” parameters. The result is assigned to a template variable called total_traffic, and will not
generate any output.

This template function accepts the following parameters to select a RADIUS database and other connection
options:

l _db – ID of the RADIUS database service handler (this parameter is optional, the default service handler will
be used if it not set)

l _debug – Set to a nonzero value to enable debugging

l _quiet – Set to a nonzero value to inhibit warning/error messages

The following parameters control the query to be executed:

l _method (required) – Name of the query function to execute. A brief listing of the available methods is
provided below.

l _arg0, _arg1, …, _argN (optional) – Positional arguments for the query function.
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l Named arguments may also be supplied; the arguments must be named identically to the function
arguments listed in the documentation for the query function.

The following parameters control how the result should be processed:

l _assign – Name of a page variable to store the output; if not set, output is sent to the browser as the result
of evaluating the template function.

l _output – Index of item to return from the RPC result; if not set, the complete result is returned. This may
be of use when an array containing multiple values is returned and only one of these values is required.

l _default – Default value to display or return if an error occurs or the _output field is not available in the
result.

For ease of use, “assign” is also supported as a synonym for “_assign”.

This template function does not generate any output if the _assign parameter is set.

The methods that are available for use with this function are listed below. The $criteria array consists of one or
more criteria on which to perform a database search. The array is used for advanced cases where pre-defined
helper functions do not provide required flexibility.

ChangeToRole()
ChangeToRole($username, $role_name)

Changes the RADIUS role assigned to the user. If the user currently has active sessions, this function will trigger
an RFC 3576 Change-of-Authorization (CoA) Request to the network access server.

The $username parameter specifies the user account to modify; use the expression GetAttr('User-Name') to
use the value from the RADIUS User-Name attribute.

The $role_name parameter specifies the name of the RADIUS User Role to apply to the user.

Example:

Use the following as a conditional expression for an attribute. If the user's traffic in the past 24 hours exceeds
50 MB, the user is changed to the "Over-Quota" role.
return GetUserTraffic(86400) > 50e6 && ChangeToRole("Over-Quota");

GetCallingStationCurrentSession()
GetCallingStationCurrentSession($callingstationid, $mac_format = null)

Looks up the current (most recent) active session for the specified calling station ID.

Because different NAS equipment can send differently-formatted MAC addresses in the Calling-Station-Id
attribute, the $mac_format argument may be specified. This should be a sprintf-style format string that
accepts 6 arguments (the octets of the MAC address). The default if not specified is the IEEE 802 standard
format, %02X-%02X-%02X-%02X-%02X-%02X – that is, uppercase hexadecimal with each octet separated
with a hyphen.

See "GetCurrentSession()" on page 486 for details of the return value.

GetCallingStationSessions()
GetCallingStationSessions($callingstationid, $from_time, $to_time = null, $mac_format = nul
l)

Calculate the number of sessions for accounting records matching a specific calling-station-id. The calling
station id address is looked up automatically from the RADIUS Access-Request (Calling-Station-ID attribute).

Because different NAS equipment can send differently-formatted MAC addresses in the Calling-Station-Id
attribute, the $mac_format argument may be specified. This should be a sprintf-style format string that
accepts 6 arguments (the octets of the MAC address). The default if not specified is the IEEE 802 standard
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format, %02X-%02X-%02X-%02X-%02X-%02X – that is, uppercase hexadecimal with each octet separated
with a hyphen.

See "GetTraffic()" on page 488 for details on how to specify the time interval.

GetCallingStationTime()
GetCallingStationTime($callingstationid, $from_time, $to_time = null, $mac_format = null)

Calculate sum of session times in a specified time interval.

Because different NAS equipment can send differently-formatted MAC addresses in the Calling-Station-Id
attribute, the $mac_format argument may be specified. This should be a sprintf-style format string that
accepts 6 arguments (the octets of the MAC address). The default if not specified is the IEEE 802 standard
format, %02X-%02X-%02X-%02X-%02X-%02X – that is, uppercase hexadecimal with each octet separated
with a hyphen.

The calling station ID is looked up automatically from the RADIUS Access-Request (Calling-Station-ID attribute).

See "GetTraffic()" on page 488 for details on how to specify the time interval.

GetCallingStationTraffic()
GetCallingStationTraffic($callingstationid, $from_time, $to_time = null,
$in_out = null, $mac_format = null)

Calculate sum of traffic counters in a time interval. Sessions are summed if they have the same Calling-Station-
Id attribute as that specified in the RADIUS Access-Request.

If no Calling-Station-Id attribute was included in the request, returns zero.

Because different NAS equipment can send differently-formatted MAC addresses in the Calling-Station-Id
attribute, the $mac_format argument may be specified. This should be a sprintf-style format string that
accepts 6 arguments (the octets of the MAC address). The default if not specified is the IEEE 802 standard
format, %02X-%02X-%02X-%02X-%02X-%02X – that is, uppercase hexadecimal with each octet separated
with a hyphen. This string matches what ClearPass Guest sees from the NAS.

The time interval specified by $from_time and optionally $to_time is also used to narrow the search.

If $to_time is not specified, $from_time is a “look back” time, that is, the time interval in seconds before the
current time.

If $to_time is specified, the interval considered is between $from_time and $to_time.

$in_out may be “in” to count only input octets, “out” to count only output octets, or any other value to count
both input and output octets towards the traffic total.

Examples:

l Use the following as the condition expression for a RADIUS role attribute. Authorizes a user only if their
total traffic (in + out) in the past day does not exceed 10 MB. Be aware that the attribute with this condition
expression will never be included in the response!

l return GetUserTraffic(86400) > 10485760 && AccessReject()

l Like the above, but only considers output (that is, user downloads):

l return GetUserTraffic(86400,'out') > 10485760 && AccessReject()

l Another way to limit the past 30 days downloads to 100 MB:

l return GetUserTraffic($now - 86400*30, $now, 'out') > 100*1024*1024 && AccessReject()

l Limit by MAC address, 50 MB download in past 24 hours:
return GetCallingStationTraffic(86400, 'out') > 50000000 && AccessReject()
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GetCurrentSession()
GetCurrentSession($criteria)

Looks up the details for an active session, based on the specified criteria.

This is a multi-purpose function that has a very flexible query interface. For ease of use, consider using one of the
related functions "GetCallingStationCurrentSession()" on page 484, "GetIpAddressCurrentSession()" on page 486, or
"GetUserCurrentSession()" on page 489.

Returns null if there is no matching session, otherwise returns a single session array – a typical result follows:
array (
'id' => '2073',
'acctsessionid' => '4a762dbf00000002',
'acctuniqueid' => 'c199b5a94ebf5184',
'username' => 'demo@example.com',
'realm' => '',
'role_name' => 'Guest',
'nasipaddress' => '192.168.2.20',
'nasportid' => '',
'nasporttype' => '',
'calledstationid' => '',
'callingstationid' => '',
'acctstarttime' => '1249258943',
'connectinfo_start' => '',
'acctstoptime' => NULL,
'connectinfo_stop' => NULL,
'acctsessiontime' => 0,
'acctinputoctets' => 0,
'acctoutputoctets' => 0,
'acctterminatecause' => NULL,
'servicetype' => '',
'framedipaddress' => '192.168.2.3',
'framedprotocol' => '',
'acctauthentic' => '',
'nastype' => 'cisco_3576',
'nas_name' => 'centos',
'total_traffic' => 0,
'state' => 'stale',
'traffic_input' => 0,
'traffic_output' => 0,
'traffic_usage' => 0,
'session_time' => 29641260,

)

GetIpAddressCurrentSession()
GetIpAddressCurrentSession($ip_addr = null)

Looks up the current (most recent) active session for the specified client IP address. If ip_addr is not specified,
it defaults to the current value of $smarty.server.REMOTE_ADDR, which may not be the same value as the IP
address of the session if there is a NAT.

See "GetCurrentSession()" on page 486 for details of the return value.

GetIpAddressSessions()
GetIpAddressSessions($ip_addr, $from_time = null, $to_time = null)

Calculate the number of sessions for accounting records matching a specific IP address. The IP address
attribute is looked up automatically from the RADIUS Access-Request (Framed-IP-Address attribute).

See "GetTraffic()" on page 488 for details on how to specify the time interval.
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See "GetIpAddressTraffic()" on page 487 for additional details on the $ip_addr argument.

GetIpAddressTime()
GetIpAddressTime($ip_addr, $from_time = null, $to_time = null)

Calculate sum of session times in a specified time interval. The IP address is looked up automatically from the
RADIUS Access-Request (Framed-IP-Address attribute).

See "GetTraffic()" on page 488 for details on how to specify the time interval.

See "GetIpAddressTraffic()" on page 487 for additional details on the $ip_addr argument.

GetIpAddressTraffic()
GetIpAddressTraffic($ip_addr, $from_time = null, $to_time = null, $in_out = null)

Calculate sum of traffic counters in a time interval. The IP address used is determined based on the context. If
processing a RADIUS Access-Request, the IP address is determined using the Framed-IP-Address attribute. If
processing a HTTP request, the current client IP address is assumed
(from $_SERVER['REMOTE_ADDR']).

Specifying an empty value for the IP address (such as null, false, or empty string) also causes the current client
IP address to be used.

See "GetTraffic()" on page 488 for details on how to specify the time interval.

GetSessions()
GetSessions($criteria, $from_time, $to_time = null)

Calculate the number of sessions from accounting records in the database.

This is a multi-purpose function that has a very flexible query interface. For ease of use, consider using one of the
related functions "GetCallingStationSessions()" on page 484, "GetIpAddressSessions()" on page 486,
"GetUserActiveSessions()" on page 488, or "GetUserSessions()" on page 489.

$criteria is the criteria on which to search for matching accounting records.

As well as the criteria specified, the time interval specified by $from_time and optionally $to_time is also
used to narrow the search.

If $to_time is not specified, $from_time is a “look back” time, that is, the time interval in seconds before the
current time.

If $to_time is specified, the interval considered is between $from_time and $to_time.

Returns the total number of sessions for matching accounting records in the time interval specified.

GetSessionTimeRemaining()
GetSessionTimeRemaining($username, $format = “relative”)

Calculates the session time remaining for a given user account, if the user account was to be authenticated at
the moment of the call.

The $username parameter is required. This is the username for the authentication.

The $format parameter is optional, and defaults to “relative” if not otherwise specified. This parameter may be
one of the following values:

l “relative” or “session_time”: Calculates the session timeout as for the Session-Timeout RADIUS attribute,
that is, the number of seconds before the session should end. If the session does not have a session
timeout, the value returned is 0.
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l “time”: Calculates the session end time, as the UNIX time at which the session should end. If the session
does not have an expiration time, the value returned is 0.

l Other values: These are interpreted as a date format (see “NwaDateFormat”) and the session end time is
returned in this format. (Examples: “iso8601”, “longdate”, “recent”, ‘%Y-%m-%d %H:%M’, etc.). If the session
does not have an expiration time, the value returned is a blank string.

GetTime()
GetTime($criteria, $from_time, $to_time = null)

Calculate the sum of session times for accounting records in the database.

This is a multi-purpose function that has a very flexible query interface. For ease of use, consider using one of the
related functions. See "GetCallingStationTime()" on page 485, "GetIpAddressTime()" on page 487, or "GetUserTime()
" on page 489.

$criteria is the criteria on which to search for matching accounting records.

As well as the criteria specified, the time interval specified by $from_time and optionally $to_time is also
used to narrow the search.

If $to_time is not specified, $from_time is a “look back” time, that is, the time interval in seconds before the
current time.

If $to_time is specified, the interval considered is between $from_time and $to_time.

Returns the total session time for all matching accounting records in the time interval specified.

GetTraffic()
GetTraffic($criteria, $from_time, $to_time = null, $in_out = null)

Calculate the sum of traffic counters for accounting records in the database.

Revoking access for a device is only possible This is a multi-purpose function that has a very flexible query interface.
For ease of use, consider using one of the related functions "GetCallingStationTraffic()" on page 485,
"GetIpAddressTraffic()" on page 487, or "GetUserTraffic()" on page 489.

$criteria is the criteria on which to search for matching accounting records. The time interval specified by
$from_time and optionally $to_time is used with the criteria to narrow the search.

If $to_time is not specified, $from_time is a “look back” time, that is, the time interval in seconds before the
current time. If $to_time is specified, the interval considered is between $from_time and $to_time.

$in_out may be “in” to count only input octets, “out” to count only output octets, or any other value to count
both input and output octets towards the traffic total. This argument returns the computed total of traffic for
all matching accounting records.

GetUserActiveSessions()
GetUserActiveSessions($username, $callingstationid = null)

Looks up the list of all sessions for the specified username.

The username attribute is looked up automatically from the RADIUS Access-Request (User-Name attribute). If a
$callingstationid argument is supplied, sessions that match that Calling-Station-Id are excluded from the
count of active sessions.

GetUserActiveSessionCount()
GetUserActiveSessionCount($username)

Counts the number of currently active sessions for the current username.
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The username attribute is looked up automatically from the RADIUS Access-Request (User-Name attribute).

GetUserCumulativeUsage()
GetUserCumulativeUsage($username)

Looks up the total cumulative time for the username.

The username attribute is looked up automatically from the RADIUS Access-Request (User-Name attribute).

GetUserCurrentSession()
GetUserCurrentSession($username)

Looks up the current (most recent) active session for the specified username.

See "GetCurrentSession()" on page 486 for details of the return value.

GetUserFirstLoginTime()
GetUserFirstLoginTime($username)

Looks up the first login time for the specified username.

The username attribute is looked up automatically from the RADIUS Access-Request (User-Name attribute).

GetUserSessions()
GetUserSessions($username, $from_time, $to_time = null)

Calculate the number of sessions for accounting records matching a specific user-name. The username
attribute is looked up automatically from the RADIUS Access-Request (User-Name attribute).

See "GetTraffic()" on page 488 for details on how to specify the time interval.

GetUserTime()
GetUserTime($username, $from_time, $to_time = null)

Calculate sum of session times in a specified time interval.

See "GetTraffic()" on page 488 for details on how to specify the time interval.

GetUserTraffic()
GetUserTraffic($username, $from_time, $to_time = null, $in_out = null)

Calculate sum of traffic counters in a time interval. Sessions are summed if they have the same User-Name
attribute as that specified in the RADIUS Access-Request.

See "GetCallingStationTraffic()" on page 485 for details on how to specify the time interval.

Advanced Developer Reference
The reference documentation in this section is intended for advanced usage by developers.

nwa_assign
{nwa_assign …}

Smarty registered template function. Assigns a page variable based on the output of a generator function.

Simple usage example:
{nwa_assign var=my_variable value=my_value}

l The “var” parameter specifies the page variable that will receive the output.

l The “value” parameter specifies the value to assign to “var”.

The various request variables may also be accessed using one of two supported methods:
l {nwa_assign var=_GET.get_variable value=...}
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l {nwa_assign var=smarty.get.get_variable value=...}

The variables that can be accessed this way are _GET (smarty.get), _POST (smarty.post), _REQUEST
(smarty.request), _SESSION (smarty.session), _COOKIE (smarty.cookies), and _ENV (smarty.env).

Assigning to values in _SESSION will persist the value for the next page load in the session.

Alternative usage example:
{nwa_assign var=userskin_plugin generator=NwaGetPluginDetails arg=$u.userskin}

l The “generator” parameter specifies the generator function to be called.

l A single “arg” parameter, if specified, provides a 1-argument form of calling the function; alternatively,
“arg1”, “arg2”, ... may be specified to form an array of arguments to pass to the generator.

nwa_bling
{nwa_bling …}

Smarty registered template function. Adds various kinds of visual effects to the page.

Usage example:
{nwa_bling id=$some_id type=fade}

The “id” parameter is the ID of the HTML element to which you will add ‘bling’ effects The “type” parameter is
the kind of bling desired:

l “fade”: element smoothly fades in and out

l “blink”: element blinks slowly

nwa_makeid
{nwa_makeid …}

Smarty registered template function. Creates a unique identifier and assigns it to a named page variable.
Identifiers are unique for a given page instantiation.

Usage example:
{nwa_makeid var=some_id}

The “var” parameter specifies the page variable that will be assigned.

Alternative usage:
{nwa_makeid var=some_id file=filename}

The “file” parameter specifies a file which contains a unique ID. This allows issued IDs to be unique across
different page loads. To return the value rather than assign it to a variable, use the syntax:

{nwa_makeid [file=filename] output=1}

Otherwise, this template function does not generate any output.

nwa_nav
{nwa_nav} … {/nwa_nav}

Smarty registered block function. Defines a block area for navigation, a control, or generates navigation control
HTML of a particular type.

Blocks are individual components of the navigation area, which basically consist of HTML. Blocks for actual
navigation items have substitution tags in the form @tagname@.

The recognized tags are described in the table below.
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Tag Description

@a@ <a href="navigation_href">navigation name</a>

@name@ navigation item name (HTML safe)

@jsname@ navigation item name (JavaScript quoted)

@href@ navigation item hyperlink

@jshref@ navigation item hyperlink (JavaScript quoted)

@icon@ navigation item icon, if specified

Table 113: Navigation Tags

When used with the “block” parameter, the {nwa_nav} control does not generate any HTML. When used with
the “type” parameter, the {nwa_nav} control uses the previously defined blocks to generate the HTML
navigation area. The following types are recognized:

l simple – Only the current L1 item has L2 items, L3 only when L2 active

l all-l1 – All current L1 items are shown to L3, otherwise L1 only

l expanded – All L1 items have L2 items, L3 only when L2 active

l all-expanded – All items shown to L3

The “reset” parameter may be specified to clear any existing navigation settings.
Usage example:

{nwa_nav block=level1_active}<li class="active">@a@</li>{/nwa_nav}{nwa_nav block=level1_ina
ctive}<li>@a@</li>{/nwa_nav}...{nwa_nav type=simple}{/nwa_nav} {* this generates the HTML *
}

Block types can be one of the following types:

l enter_level1_item

l enter_level2_item

l enter_level3_item

l exit_level1_item

l exit_level2_item

l exit_level3_item

l between_level1_items

l between_level2_items

l between_level3_items

l level1_active

l level1_inactive

l level2_active

l level2_inactive

l level2_parent_active

l level2_parent_inactive

l level3_active
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l level3_inactive

l enter_level1

l enter_level2

l enter_level3

l exit_level1

l exit_level2

l exit_level3

nwa_plugin
{nwa_plugin …}

Smarty registered template function. Generates plugin information based on the parameters specified.
Specifying which plugin:

l The ‘id’ parameter specifies a plugin ID.

l The ‘name’ parameter specifies a plugin name, or plugin filename.

l The ‘page’ parameter specifies a page name provided by the plugin.

l The ‘privilege’ parameter specifies a privilege defined by the plugin.

If none of the above is specified, the default is the same as specifying the ‘page’ parameter with the current
script name as argument (that is, the current page).

Specifying the output:

l The ‘notfound’ parameter specifies the return value, if the plugin was not found (default is the empty
string).

l The ‘output’ parameter specifies the metadata field to return

If ‘output’ is not specified, the default is ‘output=id’; that is, the plugin ID is returned.

nwa_privilege
{nwa_privilege} … {/nwa_privilege}

Smarty registered block function. Includes output only if a certain kind of privilege has been granted.

Usage examples:
{nwa_privilege access=create_user} .. content .. {/nwa_privilege}

The “access” parameter specifies the name of a privilege to check for any access.
{nwa_privilege readonly=create_user} .. content .. {/nwa_privilege}

The “readonly” (synonym “ro”) parameter specifies the name of a privilege to check for read-only access. Be
aware that an operator with read-write access also has read-only access. To include content if the user ONLY
has read access, that is, not if the user has full access, prefix the privilege name with a # character and use the
parameter name “readonly” (or “ro”).

{nwa_privilege full=create_user} .. content .. {/nwa_privilege}

The “full” (synonym “rw”) parameter specifies the name of a privilege to check for full read-write access. The
“name” parameter is the name of the privilege to check. If “name” is prefixed with a “!”, the output is included
only if that privilege is NOT granted (inverts the sense of the test). An optional “level” parameter may be
specified, which is the level of access to the privilege required (default is 0, or any access).

nwa_replace
{nwa_replace 1=… 2=…} … {/nwa_replace}
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Smarty registered block function. Replace %1, %2, etc with the passed parameters 1=, 2=, etc.

Usage example:
{nwa_replace 1=$param1 2=$param2 ...}
This is the text resource to be replaced, where %1 and %2
are the arguments, etc.
{/nwa_replace}

The numbered parameters are expanded in the translated string with the positional arguments %1, %2 and so
forth.

nwa_text
{nwa_text} … {/nwa_text}

Smarty registered block function. Translates the block’s content, if a language pack is available.

Usage example:
{nwa_text id=TEXT_ID 1=$param1 2=$param2 ...}
This is the text resource to be translated, where %1 and %2 are the arguments, etc.
{/nwa_text}

l The “id” parameter is the text ID of the resource.

l The numbered parameters are expanded in the translated string with the positional arguments %1, %2 and
so forth.

nwa_userpref
{nwa_userpref …}

Smarty template function. Returns the current setting of a user preference (stored with the Web application
user account)

Usage examples:
{nwa_userpref name=prefName}
{nwa_userpref name=prefName default=10}
{nwa_userpref has=prefName}

l “name”: return the named user preference

l “default”: supply a value to be returned if the preference is not set

l “has”: return 1 if the named preference exists for the current user, 0 if the preference does not exist

nwa_youtube
{nwa_youtube video=ID width=cx height=cy …} … {/nwa_youtube}

Smarty registered block function. Provides simple support for embedding a YouTube video in the body of a
page. The content of this block is the initial “alternate content” that will be presented until the YouTube player
can be embedded (if it can be embedded).

Not all devices are capable of playing back YouTube video content.

Usage example:
{nwa_youtube video=Y7dpJ0oseIA width=320 height=240}
YouTube is the world’s most popular online video community.
{/nwa_youtube}

The supported parameters for this block function are:

l video (required) – the YouTube video ID to embed.

l width (required) – the width in pixels of the video.
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l height (required) – the height in pixels of the video.

l autoplay (optional) – if true, auto-play the video.

l chrome (optional) – if true, use the chromed player; that is, provide a user experience with playback
controls.

l version (optional) – the minimum version required to play the video.

l onended (optional) – the name of a global function (that is, a member of the JavaScript “window” object)
that is to be called at the end of video playback.

Date/Time Format Syntax
This section describes the two basic modifiers available for you to use in ClearPass Guest:

l "nwadateformat Modifier" on page 494

l "nwatimeformat Modifier" on page 495

nwadateformat Modifier
The date format takes one or two arguments – the format description and an optional default value (used if
there is no time/date to display). UTF-8 is the character encoding used throughout the application, as this
covers languages such as Spanish that use non-ASCII characters.

The full list of special formats is:

Preset Name Date/Time Format Example

hhmmss %H%M%S 141345

hh:mm:ss %H:%M:%S 14:13:45

iso8601 %Y%m%d 20080407

iso8601t %Y%m%d%H%M%S 20080407141345

iso-8601 %Y-%m-%d 2008-04-07

iso-8601t %Y-%m-%d %H:%M:%S 2008-04-07 14:13:45

longdate %A, %d %B %Y, %I:%M %p Monday, 07 April 2008, 2:13
PM

rfc822 %a, %d %b %Y %H:%M:%S %Z Mon, 07 Apr 2008 14:13:45
EST

displaytime %l:%M %p 2:13 PM

recent – 2 minutes ago

Table 114: Date and Time Formats

The % items on the right hand side are the same as those supported by the php function strftime().

The string “?:”, if present will return the string following the “?:” if the time value is 0. Otherwise, the format
string up to the “?:” is used.
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See "Date/Time Format String Reference" on page 495 in this chapter for a full list of the supported date/time
format string arguments.

Examples of date formatting using the nwadateformat Smarty modifier are as follows:

{$u.expire_time|nwadateformat:"longdate"}
Monday, 07 April 2008, 2:13 PM

{$u.expire_time|nwadateformat:"iso8601"}
20080407

{$u.expire_time|nwadateformat:"iso-8601t"}
2008-04-07 14:13:45

{$u.expire_time|nwadateformat:"iso8601?:N/A"}
20080407   (or N/A if no time specified)

{$u.expire_time|nwadateformat:"%m/%d/%Y"}
04/07/2008

nwatimeformat Modifier
The nwatimeformat modifier takes one argument – the format description. The “minutes_to_natural”
argument converts an argument specified in minutes to a text string describing an equivalent but more natural
measurement for the time interval (hours, days or minutes depending on the value). An example of this usage
is for the expire_postlogin field which has a value measured in minutes:
{$u.expire_postlogin|nwatimeformat:"minutes_to_natural"}

The other formats accepted for this modifier are the same as those described for the nwadateformat modifier.
See "nwadateformat Modifier" on page 494.

Date/Time Format String Reference

Format Result

%a Abbreviated weekday name for the current locale

%A Full weekday name for the current locale

%b Abbreviated month name for the current locale

%B Full month name for the current locale

%c Preferred date and time representation for the current locale

%C Century number (2-digit number, 00 to 99)

%d Day of the month as a decimal number (01 to 31)

%D Same as %m/%d/%y

%e Day of the month as a decimal number; a single digit is preceded by a space (‘ 1’ to ‘31’)

%h Same as %b

Table 115: Date and Time Format Strings
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Format Result

%H Hour as a decimal number (00 to 23)

%l Hour as a decimal number (01 to 12)

%m Month as a decimal number (01 to 12)

%M Minute as a decimal number (00 to 59)

%p “AM” or “PM”

%r Local time using 12-hour clock (%l:%M %p)

%R Local time using 24-hour clock (%H:%M)

%S Second as a decimal number (00 to 60)

%T Current time (%H:%M:%S)

%u Weekday as a decimal number (1=Monday…7=Sunday)

%w Weekday as a decimal number (0=Sunday…6=Saturday)

%x Preferred date representation for the current locale, without the time

%X Preferred time representation for the current locale, without the date

%y Year as a decimal number without the century (00 to 99)

%Y Year as a decimal number

%% A literal % character

Programmer’s Reference
This section describes the following:

l "NwaAlnumPassword" on page 497

l "NwaBoolFormat" on page 497

l "NwaByteFormat" on page 497

l "NwaByteFormatBase10" on page 497

l "NwaComplexPassword" on page 497

l "NwaCsvCache" on page 497

l "NwaDigitsPassword($len)" on page 498

l "NwaDynamicLoad" on page 498

l "NwaGeneratePictureString" on page 498

l "NwaGenerateRandomPasswordMix" on page 498

l "NwaLettersDigitsPassword" on page 498

l "NwaLettersPassword" on page 498
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l "NwaMoneyFormat" on page 499

l "NwaParseCsv" on page 499

l "NwaParseXml" on page 500

l "NwaPasswordByComplexity" on page 500

l "NwaSmsIsValidPhoneNumber" on page 500

l "NwaStrongPassword" on page 501

l "NwaVLookup" on page 501

l "NwaWordsPassword" on page 501

NwaAlnumPassword
NwaAlnumPassword($len)

Generates an alpha-numeric password (mixed case) of length $len characters.

NwaBoolFormat
NwaBoolFormat($value, $options = null)

Formats a boolean value as a string. If 3 function arguments are supplied, the 2nd and 3rd arguments are the
values to return for false and true, respectively. Otherwise, the $options parameter specifies how to do the
conversion:

l If an integer 0 or 1, the string values “0” and “1” are returned.

l If a string containing a “|” character, the string is split at this separator and used as the values for false and
true respectively.

l If an array, the 0 and 1 index values are used for false and true values.

l Otherwise, the string values “true” and “false” are returned.

NwaByteFormat
NwaByteFormat($bytes, $unknown = null)

Formats a non-negative size in bytes as a human readable number (bytes, KB, MB, GB, etc.) Assumes that 1 KB
= 1024 bytes, 1 MB = 1024 KB, etc. If a negative value is supplied, returns the $unknown string. If a non-
numeric value is supplied, that value is returned directly.

NwaByteFormatBase10
NwaByteFormatBase10($bytes, $unknown = null)

Formats a non-negative size in bytes as a human readable number (bytes, KB, MB, GB, etc.) Assumes “base 10”
rules in measurement; that is, 1 KB = 1000 bytes, 1 MB = 1000 KB, etc. If a negative value is supplied, returns
the $unknown string. If a non-numeric value is supplied, that value is returned directly.

NwaComplexPassword
NwaComplexPassword($len = 8)

Generates complex passwords of at least $len characters in length, where $len must be at least 4. A complex
password includes at least 1 each of a lower case character, upper case character, digit, and punctuation
(symbol).

NwaCsvCache
NwaCsvCache($csv_file, $use_cache = true, $options = null)
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Loads and parses the contents of a CSV file, using a built-in cache. The cache may be cleaned for a specific file
by setting $use_cache to false. The cache may be cleaned for ALL files by setting $csv_file to the empty
string and $use_cache to false.

CSV parsing options (see "NwaParseCsv" on page 499) may be specified in $options. Additionally, a 2-
argument form of this function may be used by passing an array of $options as the second argument; in this
case, $use_cache is assumed to be true. This function returns false if the file does not exist; otherwise,
returns an array of arrays containing each of the parsed records from the file.

NwaDigitsPassword($len)
NwaDigitsPassword($len)

Generates digit-only passwords of at least $len characters in length.

NwaDynamicLoad
NwaDynamicLoad($func)

Loads the PHP function $func for use in the current expression or code block. Returns true if the function
exists (that is, the function is already present or was loaded successfully), or false if the function does not exist.

Attempting to use an undefinced function will result in a PHP Fatal Error. Use this function before using any of the
standard Nwa...() functions.

NwaGeneratePictureString
NwaGeneratePictureString($string)

Creates a password based on a format string. For details on the special characters recognized in $string, see
"Format Picture String Symbols" on page 513.

NwaGenerateRandomPasswordMix
NwaGenerateRandomPasswordMix($password_len, $lower = 1, $upper = 1, $digit = 1, $symbol = -
1)

Generates a random password that meets a certain minimum complexity requirement.

l $password_len specifies the total length in characters of the generated password. The password returned
will be at least $upper + $lower + $digit + $symbol characters in length. Any length beyond the
required minimum will be made up of any allowed characters.

l $lower specifies the minimum number of lowercase characters to include, or -1 to not use any lowercase
characters.

l $upper specifies the minimum number of uppercase characters to include, or -1 to not use any uppercase
characters.

l $digit specifies the minimum number of digits to include, or -1 to not use any digits.

l $symbol specifies the minimum number of symbol characters to include, or -1 to not use any symbol or
punctuation characters.

NwaLettersDigitsPassword
NwaLettersDigitsPassword($len)

Generates an alpha-numeric password of $len characters in length consisting of lowercase letters and digits.

NwaLettersPassword
NwaLettersPassword($len)
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Generates a password of $len characters in length consisting of lowercase letters.

NwaMoneyFormat
NwaMoneyFormat($amount, $format = null)

Formats a monetary amount for display purposes. The current page language is used to adjust formatting to
the country specified. Returns a result that is guaranteed to be in UTF-8.

The $format argument may be null, to specify the default behavior (U.S. English format), or it may be a
pattern string containing the following:

l currency symbol (prefix)

l thousands separator

l decimal point

l number of decimal places

The format “€1.000,00” uses the Euro sign as the currency symbol, “.” as the thousands separator, “,” as the
decimal point, and 2 decimal places.

If not specified explicitly, the default format is “$1,000.00”.

NwaParseCsv
NwaParseCsv($text, $options = null)

Parses text containing comma-separated values and returns the result as a list of records, where each record
contains a list of fields. Supports CSV escaping using double quotes.

$options may be specified to control additional parsing options described in the table below.

Function Description

fs The field separator character (default is comma “,”)

rs The record separator character (default is newline “\n”)

quo The quote character (default is double quote ")

excel_compatible If true, recognize ="..." syntax as well as "..." (default true)

dos_compatible If true, convert \r\n line endings to \n (default true)

encoding If set, specifies the input character set to convert from (default not set)

out_charset
If set, specifies the desired character set to convert to using the iconv() function .
(default is "UTF-8//TRANSLIT")

max_records maximum number of records to return

max_fields maximum number of fields per record

skip_records number of records to skip at start of input

skip_fields number of fields to skip at start of each record

sort post-processing option; order string for NwaCreateUsortFunc to sort the records by

Table 116: Parsing Options
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Function Description

the specified column(s)

slice_offset post-processing option: starting offset of slice to return; see array_slice() function

slice_length post-processing option: length of slice to return; see array_slice() function

See "NwaParseCsv" on page 499 and "NwaVLookup" on page 501.

NwaParseXml
NwaParseXml($xml_text)

Parses a string as an XML document and returns the corresponding document structure as an associative
array. Returns an array containing the following elements:

l error – set if there was a problem parsing the XML

l message – describes the parse error

Otherwise, the return is an array with these elements:

l name – name of the document element

l attributes – attributes of the document element

l children – array containing any child elements

l content – element content text

NwaPasswordByComplexity
NwaPasswordByComplexity($len, $mode = false)

Generates a random password of at least $len characters in length, based on one of the standard complexity
requirements specified in $mode. If $mode is false or the empty string, the default password complexity is
taken from the Guest Manager plugin configuration.

Otherwise, $mode should be one of the following values:

l none – No password complexity requirement

l case – At least one uppercase and one lowercase letter

l number – At least one digit

l punctuation – At least one symbol

l complex – At least one of each: uppercase letter, lowercase letter, digit, and symbol

NwaSmsIsValidPhoneNumber
NwaSmsIsValidPhoneNumber($phone_number)

Validates a phone number supplied in E.164 international dialing format, including country code.

l Any spaces and non-alphanumeric characters are removed.

l If the first character is a plus sign (+), the phone number is assumed to be in E.164 format already and the
plus sign is removed; otherwise, if the SMS service handler national prefix is set and the phone number
starts with that prefix, then the prefix is replaced with the country code.

l The phone number must contain no fewer than 5 and no more than 15 digits.

l The phone number is validated for a valid country code prefix.
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l If all the foregoing conditions are met, the validator returns TRUE; otherwise, the validator returns FALSE.

NwaStrongPassword
NwaStrongPassword($len)

Generate strong passwords of $len characters in length.

A strong password may contain uppercase letters, lowercase letters, digits and certain symbols. The strong
password does not contain commonly-confused characters such as “O” and “0” (capital O and zero), “I” and “l”
(capital I and lowercase L), “2” and “Z” (two and capital Z), or “8” and “B” (eight and capital B).

NwaVLookup
NwaVLookup($value, $table, $column_index, $range_lookup = true, $value_column = 0, $cmp_fn
= null)

Table lookup function, similar to the Excel function VLOOKUP(). This function searches for a value in the first
column of a table and returns a value in the same row from another column in the table. This function
supports the values described in the table below.

Option Description

$value The value to be searched for

$table
A 2D array of data to search; for example, a data table returned by NwaCsvCache()
or NwaParseCsv()

$column_index The desired index of the data

$range_lookup

Specifies whether to find an exact or approximate match.
If true (default), assumes the table is sorted and returns either an exact match, or the
match from the row with the next largest value that is less than $value. If false, only
an exact match is returned; NULL is returned on no match

value_column
Specifies the column index in the table that contains the values; the default is 0; in
other words, the first column.

$cmp_fn

Specifies a comparison function to use for values; if null, the default is used (simple
equality operator ==, or the == and > operators if using binary search).
The comparison function should take 2 arguments and return a value < 0, == 0, > 0
depending on the sort ordering of the arguments.

Table 117: NwaVLookup Options

Be aware of the following differences from Excel VLOOKUP:

l Column indexes are 0-based.

l Column indexes can also be strings.

See "NwaParseCsv" on page 499 and "NwaCsvCache" on page 497.

NwaWordsPassword
NwaWordsPassword($len)

Generates a password consisting of two randomly-chosen words, separated by a small number (1 or 2 digits);
that is, in the format word1XXword2. The random words selected will have a maximum length of $len
characters, and a minimum length of 3 characters. $len must be at least 3.
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Field, Form, and View Reference
This section describes the following:

l "GuestManager Standard Fields" on page 502

l "Hotspot Standard Fields" on page 510

l "SMS Services Standard Fields" on page 511

l "SMTP Services Standard Fields" on page 511

l "Format Picture String Symbols" on page 513

l "Form Field Validation Functions" on page 514

l "Form Field Conversion Functions" on page 519

l "Form Field Display Formatting Functions" on page 519

l "View Display Expression Technical Reference" on page 521

GuestManager Standard Fields
The table below describes standard fields available for the GuestManager form.

Field Description

account_activation

String. The current account activation time in long form. This field is available on
the change_expiration and guest_enable forms. The value is generated from the
do_schedule and schedule_time fields, and may be one of the following:
l Account will be enabled at date andtime
l Account is currently active
l No account activation

auto_update_account

Boolean flag indicating that an already existing account should be updated,
rather than failing to create the account. This field should normally be enabled
for guest self-registration forms, to ensure that a visitor that registers again
with the same email address has their existing account automatically updated.
Set this field to a non-zero value or a non-empty string to enable automatic
update of an existing account. This field controls account creation behavior; it is
not stored with created visitor accounts.

auto_update_account

Boolean flag indicating that an already existing account should be updated,
rather than failing to create the account. This field should normally be enabled
for guest self-registration forms, to ensure that a visitor that registers again
with the same email address has their existing account automatically updated.
Set this field to a non-zero value or a non-empty string to enable automatic
update of an existing account. This field controls account creation behavior; it is
not stored with created visitor accounts.

captcha

Special field used to enable the use of a CAPTCHA security code on a form. This
field should be used with the user interface type “CAPTCHA security code” and
the standard validator NwaCaptchaIsValid in order to provide the standard
security code functionality.

change_of_
authorization

Boolean flag indicating that any existing sessions for a visitor account should be
disconnected or modified using RFC 3576. If this field is not specified on a form
that modifies the visitor account, the default value is taken from the
configuration for the RADIUS Services plugin.
Set this field to a non-zero value or a non-empty string to enable RFC 3576

Table 118: GuestManager Standard Fields
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updates for active sessions. Set this field to a zero value or the empty string to
disable RFC 3576 updates for active sessions.

create_time
Integer. Time at which the account was created. The creation time is specified
as a UNIX timestamp. This field is automatically configured with the current time
when the Initial Value is set to: array('generator' => 'time')

creator_accept_terms

Boolean flag indicating that the creator has accepted the terms and conditions
of use. When creating an account, this field must be present, and must be set to
the value 1. If this field is unset, or has any other value, account creation will fail
with an error message.
To set the correct value for this field, use a check box (to require confirmation
from the creator) or a hidden field (if use of the form is considered acceptance
of the terms and conditions). This field controls account creation behavior; it is
not stored with created visitor accounts.

creator_name String. Name of the creator of the account. This field does not have a default
value. See "sponsor_name" on page 509.

do_expire

Integer that specifies the action to take when the expire time of the account is
reached. See "expire_time" on page 504.
l 0—Account will not expire
l 1—Disable
l 2—Disable and logout
l 3—Delete
l 4—Delete and logout
“Disable” indicates that the enabled field will be set to 0, which will prevent
further authorizations using this account.
“Logout” indicates that a RADIUS Disconnect-Request will be used for all active
sessions that have a username matching the account username. This option
requires the NAS to support RFC 3576 dynamic authorization. See "RFC 3576
Dynamic Authorization" on page 35 for more information.

do_schedule

Boolean flag indicating if the account should be enabled at schedule_time. Set
this field to 0 to disable automatic activation of the account at the activation
time. Set this field to 1, and provide a valid time in the schedule_time field, to
automatically enable the account at the specified activation time. See
"schedule_time" on page 509.

dynamic_expire_time

Integer. Time at which the account will expire, calculated according to the
account’s expiration timers. The value of this field is a UNIX timestamp. This
field is available when modifying an account using the change_expiration or
guest_edit forms.

dynamic_is_authorized
Boolean flag indicating if the user account is authorized to log in. This field is
available when modifying an account using the change_expiration or guest_edit
forms.

dynamic_is_expired
Boolean flag indicating if the user account has already expired. This field is
available when modifying an account using the change_expiration or guest_edit
forms.

dynamic_session_time

Integer. The maximum session time that would be allowed for the account, if an
authorization request was to be performed immediately. Measured in seconds.
Set to 0 if the account is either unlimited (dynamic_is_expired is false), or if the
account has expired (dynamic_is_expired is true). This field is available when
modifying an account using the change_expiration or guest_edit forms.
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Field Description

email
String. Email address for the account. This field may be up to 100 characters in
length. When creating an account, if the username field is not set then the
email field is used as the username of the account.

enabled
Boolean flag indicating if the account is enabled. Set this field to 0 to disable the
account. If an account is disabled, authorization requests for the account will
always fail. Set this field to 1 to enable the account.

expiration_time

String. Description of the account’s expiration time. This field is set when
modifying an account. This field is available on the change_expiration and
guest_enable forms. The value is generated from the do_expire, expire_time,
expire_postlogin and expire_usage fields, and may be one of the following:
l Account will expire at date andtime, or interval after first login, or after

interval total usage
l Account will expire at date andtime or interval after first login
l Account will expire at date andtime or after interval total usage
l Account will expire at date andtime
l Expires interval after first login or after interval total usage
l Expires interval after first login
l Expires after interval total usage
l No expiration time set

expire_time

Integer. Time at which the account will expire. The expiration time should be
specified as a UNIX timestamp.
Setting an expire_time value also requires a non-zero value to be set for the
do_expire field; otherwise, the account expiration time will not be used. Set this
field to 0 to disable this account expiration timer.
If the expire_timezone field is used in conjunction with expire_time and a time
zone and date are selected, the date calculation is adjusted relative to the time
zone.

expire_timezone

String. Provides a drop-down list of time zones to use in conjunction with
expire_time and start_time. When expire_timezone is selected and a date is
chosen, the date is adjusted to be relative to the time zone.
By default, expire_timezone uses the NwaGenerateTimeZoneList options
generator. To use a smaller subset of time zones, change the Options
Generator to (Use options) and provide your "value | name" pairs. Please
reference the default list for valid time zone values.

expire_usage
Integer. The total time period in seconds for which the account may be used.
Usage is calculated across all accounting sessions with the same username. Set
this field to 0 to disable this account expiration timer.

http_user_agent String. Identifies the Web browser that you are using. This tracks user’s
browsers when they are registering. This is stored with the user’s account.

id String. Internal user ID used to identify the guest account to the system.

ip_address

String. The IP address to assign to stations authenticating with this account. This
field may be up to 20 characters in length. The value of this field is not currently
used by the system. However, a RADIUS user role may be configured to assign
IP addresses using this field by adding the Framed-IP-Address attribute, and
setting the value for the attribute to: <?= $user["ip_address"]

modify_expire_postlogin
String Value indicating how to modify the expire_postlogin field.
This field is only of use when editing a visitor account. It may be set to one of the
following values:
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l “expire_postlogin” to set the post-login expiration time to the value in the
expire_postlogin field;

l “plus X” or “minus X”, where X is a time measurement, to extend or reduce
the post-login expiration timer by X (minutes, but may have a “ywdhms” suffix
to indicate years, weeks, days, hours, minutes, seconds respectively);

l A number, to set the post-login expiration time to the value specified;
l Any other value to leave expire_postlogin unmodified.
This field controls account modifications; it is not stored with the visitor account.

modify_expire_time

String. Value indicating how to modify the expire_time field.
This field may be provided when creating or editing a visitor account. It may be
set to one of the following values:
l “none” to disable the account expiration timer (do_expire and expire_time

will both be set to 0);
l “now” to disable the account immediately;
l “expire_time” to use the expiration time specified in the expire_time field;
l “expire_after” to set the expiration time to the current time, plus the number

of hours in the expire_after field;
l “plus X” or “minus X”, where X is a time measurement, to extend or reduce

the expiration time by X (hours, but may have a “ywdhms” suffix to indicate
years, weeks, days, hours, minutes, seconds respectively);

l A time measurement “X”, to set the expiration time to the current time plus X;
l Any other value to leave expire_time unmodified.
This field controls account creation and modification behavior; it is not stored
with created or modified visitor accounts.

modify_expire_usage

String. Value indicating how to modify the expire_usage field. This field is only of
use when editing a visitor account. It may be set to one of the following values:
l “expire_usage” to set the cumulative usage expiration timer to the value in

the expire_usage field;
l “plus X” or “minus X”, where X is a time measurement, to extend or reduce

the cumulative usage expiration timer by X (seconds, but may have a
“ywdhms” suffix to indicate years, weeks, days, hours, minutes, seconds
respectively);

l A number, to set the cumulative usage expiration time to the value specified;
l Any other value to leave expire_usage unmodified.
This field controls account modifications; it is not stored with the visitor account.

modify_password

String. Value indicating how to modify the account password.
l It may be one of the following values:
l “random_password” to use the password specified in the random_password

field;
l “reset” to create a new password, using the method specified in the

random_password_method field (or the global defaults, if no value is
available in this field);

l “password” to use the value from the password field;
l Any other value leaves the password unmodified.
This field controls account creation and modification behavior; it is not stored
with created or modified visitor accounts.

modify_schedule_time

String. Value indicating how to modify the schedule_time field.
It may be one of the following values:
l “none” to disable the account activation time;
l “now” to activate the account immediately;
l “schedule_time” to use the activation time specified in the schedule_time

form field (normally a UNIX time, but may be 0 to disable activation time);
l “schedule_after” to set the activation time to the current time plus the
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Field Description

number of hours in the schedule_after field;
l “plus X”, where X is a time measurement, to extend the activation time by X.

The time measurement is normally hours, but may have a “ywdhms” suffix to
indicate years, weeks, days, hours, minutes, or seconds, respectively.
Alternatively, this operation may be written equivalently as ‘+X’, ‘pX’, ‘plusX’,
‘add X’, ‘addX’, or ‘aX’. Example: to delay activation time by 2 days, use the
value +2d.

l “minus X”, where X is a time measurement, to reduce the activation time by X.
See above for details about specifying a time measurement. Alternatively,
this operation may be written equivalently as ‘-X’, ‘mX’, ‘minusX’, ‘sub X’, ‘subX’,
or ‘sX’. Example: to bring forward activation time by 12 hours, use the value -
12h.

l A time measurement “X”, to set the activation time to the current time plus X.
l A time and date specification, to set the activation time to that time and date.

Many different formats are specified; for clarity it is recommended that a
standard format such as ISO-8601 is used (“YYYY-MM-DD hh:mm:ss”
format).

l Any other value to leave schedule_time unmodified.
This field controls account creation and modification behavior; it is not stored
with created or modified visitor accounts.

multi_initial_sequence

Integer. Initial sequence number. This field is used when creating guest
accounts and the random_username_method field is set to “nwa_sequence”. If
this field is not set, the next available sequence number for the given multi_
prefix is used. Sequence numbering will start with 0 if no initial sequence
number has been set.

multi_prefix String. The prefix of each username generated when creating guest accounts
and the random_username_method field is set to “nwa_sequence”.

netmask

String. Network address mask to use for stations using the account. This field
may be up to 20 characters in length. The value of this field is not currently used
by the system. However, a RADIUS user role may be configured to assign
network masks using this field by adding the Framed-IP-Netmask attribute, and
setting the value for the attribute to: <?= $user["netmask"]

no_password

Boolean. If set, prevents a user from changing their own password using the
guest self-service portal. Set this field to a non-zero value or a non-empty string
to disable guest-initiated password changes. The default is to allow guest-
initiated password changes, unless this field is set.

no_portal

Boolean. If set, prevents a user from logging into the guest service portal. Set
this field to a non-zero value or a non-empty string to disable guest access to
the self-service portal. The default is to allow guest access to the self-service
portal, unless this field is set.

no_warn_before Boolean. User does not receive a logout expiration warning. The admin or user
can opt out of this option by setting the field to 1.

notes String. Comments or notes stored with the account. This field may be up to 255
characters in length.

num_accounts
Integer. The number of accounts to create when using the create_multi form.
This field controls account creation behavior; it is not stored with created visitor
accounts.

password String. Password for the account. This field may be up to 64 characters in length.
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password2

String. Password for the account. If this field is set, its value must match the
value of the password field for the account to be created or updated. This can
be used to verify that a password has been typed correctly. This field controls
account creation and modification behavior; it is not stored with created or
modified visitor accounts.

password_action

String. Controls the password changing behavior for a guest account. This field
may be set to one of the following values:
l empty string – Default behavior; that is, guests are not required to change

their password
l deny – Prevents the guest from changing their password
l first – Requires the guest to change their password on their first login
l next – Requires the guest to change their password on their next login
l recur – Require the guest to change their password on a regular schedule

(as specified by the password_action_recur field)
l recur_next – Require the guest to change their password on their next (or

first) login, and then on a regular schedule (as specified by the password_
action_recur field)

If the guest is required to change their password, this will take place during a
network login, before the guest is redirected to the NAS for login. Guest
password changes are only supported for Web login pages and guest self-
registration pages that have the “Perform a local authentication check” option
enabled.
The default behavior is to leave guest passwords under the control of the guest.
With the default behavior, guests are not prevented from changing their
password, but are also not required to change it on any particular schedule.

password_action_recur

String. Specifies a date or relative time, after which a guest will be required to
change their password. Using this field also requires the password_action field
to be set to the value ‘recur’. The value of this field should be a relative time
measurement, indicated with a plus sign; for example “+15 days” or “+2
months”.

password_last_change

Integer. The time that the guest’s password was last changed. The password
change time is specified as a UNIX timestamp. This field is automatically
updated with the current time when the guest changes their password using the
self-service portal.

random_password String. This field contains a randomly-generated password. This field is set when
modifying an account (guest_edit form).

random_password_length

String. The length, in characters, of randomly generated account passwords.
l For nwa_words_password, the random_password_length is the maximum

length of the random words to use. Two random words will be used to create
the password, joined together with a small number (up to 2 digits).

l For nwa_picture_password, the random_password_length is ignored.

random_password_
method

String. Identifier specifying how passwords are to be created. It may be one of
the following identifiers:
l nwa_digits_password to create a password using random digits. The length

of the password is specified by the random_password_length field.
l nwa_letters_password to create a password using random lowercase

letters (a through z). The length of the password is specified by the random_
password_length field.

l nwa_lettersdigits_password to create a password using random lowercase
letters and digits (a through z and 0 through 9). The length of the password
is specified by the random_password_length field.

l nwa_alnum_password to create a password using a combination of
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random digits, uppercase letters and lowercase letters (a-z, A-Z and 0-9).
The length of the password is specified by the random_password_length
field.

l nwa_strong_password to create a password using a combination of digits,
uppercase letters, lowercase letters, and some punctuation. Certain
characters are omitted from the password. The length of the password is
specified by the random_password_length field.

l nwa_complex_password to create a complex password string which
contains uppercase letters, lowercase letters, digits and symbol characters.

l nwa_complexity_password is dynamic and matches your complexity
setting for password generation. For example, if you require your passwords
to have both letters and digits, then this validator will confirm that the
password has at least one of each.

l nwa_words_password to create a random password using a combination of
two randomly-selected words and a number between 1 and 99. The
maximum length of each of the randomly-selected words is specified by the
random_password_length field.

l nwa_picture_password to create a password using the format string
specified by the random_password_picture field.

random_password_
picture

String. The format string to use when creating a random password, if random_
password_method is set to “nwa_picture_password”.

random_username_length

The length, in characters, of randomly generated account usernames.
l For nwa_words_password, the random_username_length is the maximum

length of the random words to use. Two random words will be used to create
the username, joined together with a small number (up to 2 digits).

l For nwa_picture_password, the random_username_length is ignored.
l For nwa_sequence, the random_username_length is the length of the

sequence number in the username; the sequence number will be zero-
padded. For example, specifying a length of 4 will result in sequence
numbers 0001, 0002, etc.

random_username_
method

String. Identifier specifying how usernames are to be created. It may be one of
the following identifiers:
l nwa_sequence to assign sequential usernames. In this case, the multi_

prefix field is used as the prefix for the username, followed by a sequential
number; the number of digits is specified by the random_username_length
field.

l nwa_picture_password to create a random username using the format
string specified by the random_username_picture field.

l nwa_digits_password to create a username using random digits. The
length of the username is specified by the random_username_length field.

l nwa_letters_password to create a username using random lowercase
letters. The length of the username is specified by the random_username_
length field.

l nwa_lettersdigits_password to create a username using random
lowercase letters and digits. The length of the username is specified by the
random_username_length field.

l nwa_alnum_password to create a username using a combination of
random digits, uppercase letters and lowercase letters. The length of the
username is specified by the random_username_length field.

l nwa_strong_password to create a username using a combination of digits,
uppercase letters, lowercase letters, and some punctuation. Certain
characters are omitted from the generated username to ensure its
readability (for example, “o”, “O” and “0”). The length of the username is
specified by the random_username_length field.

l nwa_words_password to create a username using a combination of two
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randomly-selected words and a number between 1 and 99. The maximum
length of each of the randomly-selected words is specified by the random_
username_length field.

random_username_
picture

String. The format string to use when creating a username, if the random_
username_method field is set to nwa_picture_password. See "Format Picture
String Symbols" on page 513 for a list of the special characters that may be
used in the format string.

remote_addr
String. The IP address of the guest at the time the guest account was
registered.This field may be up to 20 characters in length. The value of this field
is not currently used by the system.

role_id Integer. Role to assign to the account.The value of this field must be the integer
ID of a valid RADIUS user role.

role_name String. Name of the role assigned to the account.

schedule_after

Integer. Time period, in hours, after which the account will be enabled. This field
is used when the modify_schedule_time field is set to schedule_after. The
value is specified in hours and is relative to the current time. This field controls
account creation behavior; it is not stored with created visitor accounts.

schedule_time Integer. Time at which the account will be enabled. The time should be specified
as a UNIX timestamp.

secret_answer

String. The guest’s answer to the secret question that is stored in the secret_
question field. To use this field, first add both the secret_question and secret_
answer fields to a guest self-registration form. Then, in the self-service portal
for a guest self-registration page, select the “Secret Question” as the Required
Field. This configuration requires that guests provide the correct answer in
order to reset their account password. Answers must match with regards to
case in order to be considered as correct.

secret_question String. The guest’s secret question used to confirm the identity of a guest during
a reset password operation.

simultaneous_use Integer. Maximum number of simultaneous sessions allowed for the account.

sponsor_email

Email address of the sponsor of the account. If the sponsor_email field can be
inserted into an email receipt and used future emails, the “Reply-To” email
address will always be the email address of the original sponsor, not the current
operator.

sponsor_name String. Name of the sponsor of the account. The default value of this field is the
username of the current operator.

submit No Type. Field attached to submit buttons. This field controls account creation
behavior; it is not stored with created visitor accounts.

user_activity
Integer. Login activity of the guest account. This field is available in views and
may be used to determine the most recent start and stop time of visitor account
sessions.

username String. Username of the account. This field may be up to 64 characters in length.

visitor_company String. The visitor’s company name.
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visitor_name String. The visitor’s full name.

vvisitor_phone String. The visitor’s contact telephone number.

Hotspot Standard Fields
The table below describes standard fields available for the Hotspot form.

Field Description

address String. The visitor’s street address.

card_code String. The 3 or 4 digit cardholder verification code printed on the credit card. This
field is only used during transaction processing.

card_expiry String. Credit card expiry date. This field is only used during transaction processing.

card_name String. Name shown on the credit card. This field is only used during transaction
processing.

card_number String. Credit card number. This field is only used during transaction processing.

city String. The visitor’s city or town name.

country String. The visitor’s country name.

first_name String. The visitor’s first name.

hotspot_plan_id No Type. The ID of the plan (visitor access settings) selected by the visitor.

hotspot_plan_name No Type. The name of the plan (visitor access settings) selected by the visitor.

last_name String. The visitor’s last name.

password2 String. Password for the account (used to confirm a manually typed password).

personal_details No Type. Field attached to a form label.

purchase_amount No Type. Total amount of the transaction. This field is only used during transaction
processing.

purchase_details No Type. Field attached to a form label.

state String. The visitor’s state or locality name.

submit_free No Type. Field attached to a form submit button.

visitor_accept_
terms Boolean. Flag indicating that the visitor has accepted the terms and conditions of use.

visitor_fax String. The visitor’s fax telephone number.

zip String. The visitor’s zip or postal code.

Table 119: Hotspot Standard Fields
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SMS Services Standard Fields
The table below describes standard fields available for the SMS Services form.

Field Description

auto_send_sms Boolean. Flag indicating that a SMS receipt should be automatically sent
upon creation of the account.

sms_auto_send_field

String. This field specifies the name of the field that contains the auto-send
flag. If blank or unset, the default value from the SMS plugin configuration is
used. Additionally, the special values “_Disabled” and “_Enabled” may be
used to never send an SMS or always send an SMS, respectively.

sms_enabled Boolean. This field may be set to a non-zero value to enable sending an SMS
receipt. If unset, the default value is true.

sms_handler_id String. This field specifies the handler ID for the SMS service provider. If
blank or unset, the default value from the SMS plugin configuration is used.

sms_phone_field
String. This field specifies the name of the field that contains the visitor’s
phone number. If blank or unset, the default value from the SMS plugin
configuration is used.

sms_template_id String. This field specifies the print template ID for the SMS receipt. If blank
or unset, the default value from the SMS plugin configuration is used.

sms_warn_before_message String. This field overrides the logout warning message. If blank or unset, the
default value from the Customize SMS Receipt page is used

visitor_carrier String. The visitor’s mobile phone carrier.

Table 120: SMS Services Standard Fields

SMTP Services Standard Fields
The table below describes standard fields available for the SMTP Services.

Field Description

auto_send_smtp

Boolean. Flag indicating that an email receipt should be automatically
sent upon creation of the guest account. Set this field to a non-zero value
or a non-empty string to enable an automatic email receipt to be sent.
This field can be used to create an opt-in facility for guests. Use a check
box for the auto_send_smtp field and add it to the create_user form, or a
guest self-registration instance, and email receipts will be sent to the
visitor only if the check box has been selected. Alternatively, to always
send an SMTP receipt, this field can be set to a value of 1 using a hidden
field.

smtp_auto_send_field

String. This field specifies the name of the field that contains the auto-
send flag. If blank or unset, the default value from the email receipt
configuration is used. Additionally, the special values _Disabled and _
Enabled may be used to never send email or always send email,
respectively.

smtp_cc_action
String. This field specifies how to send copies of email receipts. It may be
one of never, always_cc, always_bcc, conditional_cc, or conditional_

Table 121: SMPT Services Standard Fields
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bcc. If blank or unset, the default value from the email receipt
configuration is used.

smtp_cc_list
String. This field specifies a list of additional email addresses that will
receive a copy of the visitor account receipt. If the value is default, the
default carbon-copy list from the email receipt configuration is used.

smtp_email_field

String. This field specifies the name of the field that contains the visitor’s
email address. If blank or unset, the default value from the email receipt
configuration is used. Additionally, the special value _None indicates that
the visitor should not be sent any email.

smtp_enabled

String. This field may be set to a non-zero value to enable sending an
email receipt. If unset, the default value from the email receipt
configuration is used. The special values _Auto (Always auto-send guest
receipts by email), _AutoField (Auto-send guest receipts by email with a
special field set), _Click (Display a link enabling a guest receipt via
email), and _Cc (Send an email to a list of fixed addresses) may also be
used.

smtp_receipt_format

String. This field specifies the email format to use for the receipt. It may
be one of plaintext (No skin – plain text only), html_embedded (No skin
– HTML only), receipt (No skin – Native receipt format), default (Use the
default skin), or the plugin ID of a skin plugin to specify that skin. If blank
or unset, the default value from the email receipt configuration is used.

smtp_subject

String. This field specifies the subject line for the email message.
Template variables appearing in the value will be expanded. If the value
is default, the default subject line from the email receipt configuration is
used.

smtp_template_id
String. This field specifies the print template ID to use for the email
receipt. If blank or unset, the default value from the email receipt
configuration is used.

smtp_warn_before_subject

String. This field overrides what is specified in the subject line under
Logout Warnings on the email receipt. If the value is “default”, the default
subject line under the Logout Warnings section on the email receipt
configuration is used.

smtp_warn_before_template_id

String. This field overrides the print template ID specified under Logout
Warnings on the email receipt. If the value is “default”, the default
template ID under the Logout Warnings section on the email receipt
configuration is used.

smtp_warn_before_receipt_
format

String. This field overrides the format in the Email Receipt field under
Logout Warnings. It may be one of “plaintext” (No skin – plain text only),
“html_embedded” (No skin – HTML only), “receipt” (No skin – Native
receipt format), “default” (Use the default skin), or the plugin ID of a skin
plugin to specify that skin. If blank or unset, the default value in the
Email Receipt Field under the Logout Warnings on the email receipt
configuration is used.

smtp_warn_before_cc_list

String. This overrides the list of additional email addresses that receive a
copy of the visitor account under Logout Warnings on the email receipt.
If the value is “default”, the default carbon-copy list under Logout
Warnings from the email receipt configuration is used.
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smtp_warn_before_cc_action

String. This field overrides how copies are sent as indicated under
Logout Warnings on the email receipt. to send copies of email receipts. It
may be one of “never”, “always_cc”, “always_bcc”, “conditional_cc”, or
“conditional_bcc”. If blank or unset, the default value from the email
receipt configuration is used.

warn_before_from_sponsor

String. This field overrides the Reply To field (that is, the sponsor_email
field of a user, or the admin's email) under the Logout Warnings on the
email receipt. If the value is “default”, the Reply To field under Logout
Warnings from the email receipt configuration is used.

warn_before_from

String. This field overrides the Override From field under the Logout
Warnings on the email receipt. If the value is “default”, the Override From
field under Logout Warnings from the email receipt configuration is
used.

Format Picture String Symbols
When generating a username or password using the nwa_picture_password method, a “picture string”
should be provided to specify the format of generated username or password in the random_username_
picture or random_password_picture field.

The picture string is used as the username or password, with the following symbols replaced with a random
character:

Symbol Replacement

# Random digit (0-9)

$ or ? Random letter (A-Z, a-z)

_ Random lowercase letter (a-z)

^ Random uppercase letter (A-Z)

* Random letter or digit (A-Z, a-z, 0-9)

! Random punctuation symbol, excluding apostrophe and quotation marks

& Random character (letter, digit or punctuation excluding apostrophe and quotation marks)

@ Random letter or digit, excluding vowels

Table 122: Picture String Symbols

Any other alphanumeric characters in the picture string will be used in the resulting username or password.
Some examples of the picture string are shown below:

Picture String Sample Password

#### 3728

Table 123: Picture String Example Passwords
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Picture String Sample Password

user#### user3728

v^^#__ vQU3nj

@@@@@ Bh7Pm

Form Field Validation Functions
See "Form Validation Properties" on page 227, and "Examples of Form field Validation" on page 228 for details
about using validation functions for form fields.

The built-in validator functions are:

l IsArrayKey – Checks that the value is one of the keys in the array supplied as the argument to the
validator.

l IsArrayValue – Checks that the value is one of the values in the array supplied as the argument to the
validator.

l IsEqual – Checks that the value is equal to the value supplied as the argument to the validator, allowing for
standard type conversion rules.

l IsGreaterThan – Checks that the value is strictly greater than a specified minimum value supplied as the
argument to the validator.

l IsIdentical – Checks that the value is equal to the value supplied as the argument to the validator, and has
the same type.

l IsInRange – Checks that the value is in a specified range between a minimum and maximum value. The
minimum and maximum values are specified as a 2-element array as the argument to the validator.

l IsInOptionsList—Checks against a list of options in the policy definition.

l IsNonEmpty – Checks that the value is a non-empty string (length non-zero and not all whitespace), or a
non-empty array.

l IsNonNegative – Checks that the value is numeric and non-negative.

l IsRegexMatch – Checks that the value matches a regular expression supplied as the argument the
validator. The regular expression should be a Perl-compatible regular expression with delimiters. For
example, the validator argument /^a/i will match any value that starts with an “a”, case-insensitively.
"Regular Expressions" on page 523 for more information about regular expression syntax.

l IsValidAirGroupSharedGroups – Checks that the value is a valid shared group list. Otherwise, returns a
description of the error(s).

If $arg is an array it may specify the following options:

n syntax_only: Default true. If false, requires that the values provided correspond to those from the
AirGroup plugin configuration.

n protocol_version: Default 2. If 1, changes the default validation properties (see below).

n max_groups: Maximum number of groups to allow, default 32.

n max_group_length: Maximum length in characters of any single group name, default 64.

n max_group_list_length: Maximum total length of the group list, including comma separator characters,
default 320.
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Shared groups are only available in AirGroup protocol version 2. If validation is performed with AirGroup
protocol version 1 (i.e., $arg is set to array ('protocol_version' => 1) ), then a non-empty group list is
considered an error.

Setting a max_* parameter to 0 disables validation of that property.

l IsValidAirGroupSharedLocations – Checks that the value is a valid shared location list. Otherwise, returns
a description of the error(s).

1. Checks if a value consists of valid tag = value pairs. Tag should be AP-Name, AP-Group, or FQLN, else
error is thrown.

2. FQLN format is dot-separated and the format is APname.Floor.Building.Campus. Floor bit has to be
"floor" + an integer.

3. The number of tag=value pairs should not be more than 5.

4. AP-Name value should not contain a '.'

If $arg is an array it may specify the following options:

n syntax_only: Default true. If false, requires that the values provided correspond to those from the
AirGroup controller configuration.

n protocol_version: Default 2. If 1, changes the default validation properties (see below).

n max_locations: Maximum number of location tags to allow, default 100.

n max_location_length: Maximum length in characters of any single location tag, default 64.

n max_location_list_length: Maximum total length of the shared location list, including comma
separator characters, default 1000.

n include_ap_group: Default true. Allows AP-Group=... tags.

n include_ap_name: Default true. Allows AP-Name=... tags.

n include_fqln: Default true. Allows FQLN=... tags.

For the same validation as performed in AirGroup protocol version 1, set $arg to array('protocol_

version' => 1).

Setting a max_* parameter to 0 disables validation of that property.

l IsValidAirGroupSharedRoles – Checks that value is a valid shared role list. Otherwise, returns a
description of the error(s).

If $arg is an array it may specify the following options:

n syntax_only: Default true. If false, requires that the values provided correspond to those from the
AirGroup controller configuration.

n protocol_version: Default 2. If 1, changes the default validation properties (see below).

n max_roles: Maximum number of roles to allow, default 100.

n max_role_length: Maximum length in characters of any single role name, default 64.

n max_role_list_length: Maximum total length of the role list, including comma separator characters,
default 1000.

For the same validation as performed in AirGroup protocol version 1, set $arg to array('protocol_

version' => 1).

Setting a max_* parameter to 0 disables validation of that property.
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l IsValidAirGroupSharedUser – Checks that the value is a comma-separated user list, where user names
should not contain "," or space.

If $arg is an array it may specify the following options:

n protocol_version: Default 2. If 1, changes the default validation properties (see below).

n max_users: Maximum number of usernames to allow, default 100.

n max_user_length: Maximum length in characters of any single username, default 64.

n max_user_list_length: Maximum total length of the username list, including comma separator
characters, default 1000.

For the same validation as performed in AirGroup protocol version 1, set $arg to array('protocol_

version' => 1).

Setting a max_* parameter to 0 disables validation of that property.

l IsValidBool – Checks that the value is a standard Boolean truth value. Valid Boolean values are the integers
0 and 1 and the PHP values false and true.

l IsValidDateTime – Checks that the value appears to be a valid time specification string according to the
rules of the PHP function strtotime(). Valid date/time syntax includes ISO 8601 standard times (YYYY-MM-
DD hh:mm:ss) with and without time zone specifications, as well as many other formats. The $value is
expected to be an integer specifying a UNIX time value (seconds since 1970-01-01 00:00:00 UTC).

$arg may be:

n null, to not perform any min/max check

n a scalar value, to use as the maximum allowable value

n an array containing "min" or "max" entries

Use the syntax:
array(
'min' => '1 day',
'max' => '90 days',

)

l IsValidEmail – Checks that the value appears to be a valid RFC 822-compliant email address. When using
the IsValidEmail validator, the validator argument may be specified with a whitelist/blacklist of domain
names. Use the syntax:
array(
'allow' => array(
'corp-domain.com',
'other-domain.com',

),
'deny' => array(
'blocked-domain.com',
'other-blocked-domain.com',

),
)

n The keys ‘whitelist’ and ‘blacklist’ may also be used for ‘allow’ and ‘deny’, respectively.

n An ‘allow’ or ‘deny’ value that is a string is converted to a single element array.

n Wildcard matching may be used on domain names: the prefix ‘*.’ means match any domain that ends
with the given suffix. A ‘*’ component can also be used inside the hostname, and will match zero or more
domain name components.
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n If the ‘allow’ list is empty or unset, the default behavior is to accept ALL domains other than those listed
in the ‘deny’ list.

n If the ‘deny’ list is empty or unset, the default behavior is to deny ALL domains other than those listed in
the ‘allow’ list.

n If both ‘allow’ and ‘deny’ lists are provided, the default behavior is to accept a domain name that does
not match any of the patterns provided. The ‘allow’ list is checked first, followed by ‘deny’. To obtain the
opposite behavior, specify the wildcard ‘*’ as the last entry in the ‘deny’ list.

l IsValidFileUpload – Checks that the value is a file upload.

l IsValidFutureDateTime – Checks that the value is a valid time specification string according to the rules of
the PHP function strtotime(), and that the time specification refers to a point in the future. The $value is
expected to be an integer specifying a UNIX time value (seconds since 1970-01-01 00:00:00 UTC).

$arg may be:

n null, to not perform any min/max check

n a scalar value, to use as the maximum allowable value

n an array containing "min" or "max" entries

Use the syntax:
array(
'min' => '1 day',
'max' => '90 days',

)

l IsValidFutureTimestamp – Checks that the value is a valid UNIX time referring to a point in the future.
The $value is expected to be an integer specifying a UNIX time value (seconds since 1970-01-01 00:00:00
UTC).

$arg may be:

n null, to not perform any min/max check

n a scalar value, to use as the maximum allowable value

n an array containing "min" or "max" entries

Use the syntax:
array(
'min' => '1 day',
'max' => '90 days',

)

l IsValidHostname – Checks that the value is a valid IP address or a hostname that resolves to an IP
address.

l IsValidHostnameCidr – Checks that the value is a valid IP address or hostname, which may also have an
optional /N suffix indicating the network prefix length in bits (CIDR notation).

l IsValidHostnamePort – Checks that the value is a valid IP address or hostname, which may optionally
include a port number specified with the syntax hostname:port.

l IsValidIpAddr – Checks that the value is a valid IP address.

l IsValidLdapAttribute – Checks that the value is a valid LDAP attribute name; that is, a string that starts
with a letter, and which contains only letters, numbers, underscore (_) and hyphen (-).

l IsValidNetmask – Checks that the value is a valid network mask in dotted-quad notation; that is, an IP
address such as 255.255.255.128 that contains a single string of N 1 bits followed by (32 – N) 0 bits.
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l IsValidNumber – Checks that the value is numeric; that is, an integer or a decimal value. The validator
argument may be an array containing one or more of the following additional options:

n no_negative – if set to true, negative numbers are not accepted as a valid value.

n no_zero – if set to true, zero is not accepted as a valid value.

n only_integer – if set to true, decimal numbers are not accepted and only integer values are valid.

l IsValidPassword2 – Checks that the value is a valid password that satisfies certain requirements. The
validator argument must be an array describing which of the following requirements to check. To perform
any password checking, the “minimum_length” and “complexity_mode” fields must be specified.

n password2 – specifies the name of the field containing the duplicate password entry (optional, for
password validation). Defaults to “password2” if not specified.

n password2_required – if nonzero, indicates that the “password2” entry must be supplied.

n username – specifies the name of the field containing the username. If empty or unset, the password is
not checked against this field for a match.

n minimum_length – specifies the minimum length of the password in characters.

n disallowed_chars – if set, specifies characters that are not allowed in the password.

n complexity_mode – specifies the set of rules to use when checking the password.

n complexity – if set, specifies rules for checking the composition of the password. If unset, defaults to a
preset value for password complexity with modes “none”, “basic”, “number”, “punctuation” and
“complex”. These rules check that passwords obey certain requirements according to the following table:

Rule Set Min. Length Description

none – No special requirements

basic 8 Non-space characters

number 8 At least 1 digit

punctuation 8 At least 1 punctuation character (non-alphanumeric)

complex 8 At least 1 digit, 1 non-alphanumeric, 1 uppercase and 1 lowercase letter

Table 124: Complexity Requirements

l IsValidSentence – Checks that the value is considered to be a ‘sentence”; that is, a string which starts with
an upper-case letter and ends in a full stop.

l IsValidTimestamp – Checks that the value is a numeric UNIX timestamp (which measures the time in
seconds since January 1, 1970 at midnight UTC).

l IsValidTimeZone – Checks that the value is a valid string describing a recognized time zone.

l IsValidUrl – Checks that the value appears to be a valid URL that includes a scheme, hostname and path.
For example, in the URL http://www.example.com/, the scheme is http, the hostname is
www.example.com and the path is /. The validator argument may optionally be an array containing a
‘scheme’ key that specifies an array of acceptable URL protocols.

l IsValidUsername – Checks that the value is a valid username. Usernames cannot be blank or contain
spaces.
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l NwaCaptchaIsValid – Checks that the value matches the security code generated in the CAPTCHA image.
This validator should only be used with the standard captcha field.

l NwaGuestManagerIsValidRoleId – Checks that the value is a valid role ID for the current operator and
user database.

l NwaIsValidExpireAfter – Checks that the value is one of the account expiration time options specified in
the Guest Manager configuration.

l NwaIsValidLifetime – Checks that the value is one of the account lifetime options specified in the Guest
Manager configuration.

Form Field Conversion Functions
The Conversion and Value Format functions that are available are listed below:

l NwaConvertOptionalDateTime – Converts a string representation of a time to the UNIX time
representation (integer value). The conversion leaves blank values unmodified.

l NwaConvertOptionalInt – Converts a string representation of an integer to the equivalent integer value.
The conversion leaves blank values unmodified.

l NwaConvertStringToOptions – Converts a multi-line string representation of the form
key1 | value1
key2 | value2

to the array representation
array (
'key1' => 'value1',
'key2' => 'value2',

)

l NwaImplodeComma – Converts an array to a string by joining all of the array values with a comma.

l NwaTrim – Removes leading and trailing whitespace from a string value.

l NwaTrimAll – Removes all whitespace from a string (including embedded spaces, newlines, carriage
returns, tabs, etc).

l NwaStrToUpper – Formats the text string to all uppercase letters.

l NwaStrToLower – Formats the text string to all lowercase letters.

l NwaNormalizePhoneNumber – Removes all spaces, dashes, parenthesis and non-numerical characters
from the phone number.

Form Field Display Formatting Functions
The Display Functions that are available are listed below:

Function Description

NwaBoolFormat

Formats a Boolean value as a string.
l If the argument is 0 or 1, a 0 or 1 is returned for false and true, respectively.
l If the argument is a string containing a “|” character, the string is split at the |

separator and used for false and true values.
l If the argument is an array, the 0 and 1 index values are used for false and true

values.
Otherwise, the string values “false” and “true” are returned.

Table 125: Form Field Display Functions
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Function Description

NwaByteFormat

Formats a non-negative size in bytes as a human readable number (bytes, KB, MB,
GB, etc). 1 KB is defined as 1,024 bytes, 1 MB as 1,024 KB (1,048,576 bytes), and 1 GB
as 1,024 MB (1,073,741,824 bytes).
l If a negative value is supplied, returns the argument (or null if no argument was

supplied).
l If a non-numeric value is supplied, that value is returned directly.

NwaCurrencyForma
t

Formats a numeric value that indicates a monetary amount as a string.
If the argument is null or not supplied, the current locale’s settings are used to format
the monetary value.
l The argument may be an array, which will override the current locale’s settings

(see NwaNumberFormat for the list of settings that are used).
l The argument may be a numeric value, which is used as the number of fractional

digits to use when formatting the monetary amount (other locale settings will
remain unchanged in this case).

NwaDateFormat

Format a date like the PHP function strftime(), using the argument as the date format
string. Returns a result guaranteed to be in UTF-8 and correct for the current page
language. See "Date/Time Format Syntax" on page 494 for a list of available
date/time formats, or use one of the following special format strings:
l hhmmss, hh:mm:ss – time of day
l iso8601, iso8601t, iso-8601, iso-8601t – various ISO 8601 date formats with and

without hyphen separators and the time of day
l longdate – date and time in long form
l displaytime – time of day
l ?: – returns the string following the ?: if the time value is 0, or uses the format

string before the ?: otherwise
l recent – for example, “2 minutes ago”, “3 months ago”

NwaDurationFormat

Converts a time measurement into a description of the corresponding duration.
l Format parameters: seconds, minutes, hours, days, weeks.
l Any format can be converted to another.
l By default, this function converts an elapsed time value specified in seconds to a

value that is displayed in weeks, days, hours, minutes and seconds.
Up to four additional arguments may be supplied to control the conversion:
l in_format – The current units of the value being converted (seconds, minutes,

hours, days, weeks)
l max_format – Controls the max increment you want displayed.
l min_format – Controls the min increment you want displayed. Only whole

numbers are printed.
l default – If set, this value will be returned when the resulting duration (after min_

format is taken into account) is 0.

NwaExplodeComma Converts a string to an array by splitting the string at each comma and forming an
array of all the substrings created in this way.

NwaNumberFormat

Formats a numeric value as a string. If the argument is null or not supplied, the
current locale’s settings are used to format the numeric value. The argument may be
an array or a numerica value. If the argument is an array, it will override the current
locale’s settings (see below for the list of settings that are used). If the argument is a
numeric value, it is used as the number of fractional digits to use when formatting the
string (other locale settings will remain unchanged in this case).
The specific locale settings used are from localeconv(), and are listed below.
For general numeric formatting :
l frac_digits – number of decimal places to display
l decimal_point – character to use for decimal point
l thousands_sep – character to use for thousands separator
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For signs for positive/negative values:
l positive_sign – sign for positive values
l p_sign_posn – position of sign for positive values (0..4)
l negative_sign – sign for negative values
l n_sign_posn – position of sign for negative values (0..4)
For formatting for monetary amounts:
l mon_decimal_point – decimal point character for monetary values
l mon_thousands_sep – thousands separator for monetary values
l p_sep_by_space – true if a space separates currency symbol from a positive value
l p_cs_precedes – true if currency symbol precedes positive value
l n_sep_by_space – true if a space separates currency symbol from a negative

value
l n_cs_precedes – true if currency symbol precedes negative value
Additionally, the special value monetary, if true, indicates that a currency value
should be formatted, rather than a regular numeric value.

View Display Expression Technical Reference
A page that contains a view is displayed in an operator’s Web browser. The view contains data that is loaded
from the server dynamically. Because of this, both data formatting and display operations for the view are
implemented with JavaScript in the Web browser.

For each item displayed in the view, a JavaScript object is constructed. Each field of the item is defined as a
property of this object. When evaluating the JavaScript Display Expression, the data variable is used to refer to
this object. Thus, the expression data.my_field would return the value of the field named “my_field”.

In the above view (the guest_users view), the four columns displayed correspond to the username, role_
name, enabled, and expire_time fields.

Value Description

Display Expressions

data.username.bold() Displays the username string as bold text.

data.role_name Displays the name of the role.

Nwa_BooleanText(data.enabled, "Enabled",
"Disabled")

Displays either “Enabled” or “Disabled” depending on the
value of the enabled field.

(parseInt(data.do_expire) != 0) ? Nwa_
DateFormat(data.expire_time, "%Y-%m-%d
%H:%M") : "N/A"

Displays “N/A” if the account has no expiration time, or a
date and time string if an expiration time has been set.

Table 126: Display Expressions for Data Formatting
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Value Description

JavaScript functions

Nwa_BooleanText(
value, if_true, if_false[, if_undefined])

Returns the value of if_true or if_false depending on
whether the value evaluates to a Boolean true or false,
respectively. If the value has an undefined type (in other
words. has not been set), and the if_undefined parameter
was provided, returns if_undefined.

Nwa_DateFormat(value, format)

Converts a numerical value (UNIX time) to a string using
the date and time format string format. The format string
uses similar syntax to the NwaDateFormat() function. See
"Date/Time Format String Reference" on page 495 for a
full list of the supported format strings.

Nwa_FloatFormat(value, decimals) Converts a numerical value to a string, with the number
of decimal places specified in decimals.

Nwa_MinutesToNatural(value)
Converts a numeric value measuring a time in minutes to

a natural time representation (such as “2 minutes”, “3
hours”, “11 days”).

Nwa_NumberFormat(value[, if_undefined])
Nwa_NumberFormat(
value, decimals)Nwa_NumberFormat(
value, decimals, dec_point, thousands_sep[, if_
undefined])

Converts a numerical value to a string. If the value has an
undefined type (in other words, has not been set), and the
if_undefined parameter was provided, returns if_
undefined. Otherwise, the number is converted to a string
using the number of decimal places specified in decimals
(default 0), the decimal point character in dec_point
(default “.”), and the thousands separator character in
thousands_sep (default “,”).

Nwa_TrimText(value, length)
Trims excessively long strings to a maximum of length
characters, appending an ellipsis (“…”) if the string was
trimmed.

Nwa_ValueText(value[, if_undefined])

If the value has an undefined type (in other words, has not
been set), and the if_undefined parameter was provided,
returns if_undefined, or a HTML non-breaking space
(“&nbsp;”) otherwise. Otherwise, the value is converted to
a string for display.

LDAP Standard Attributes for User Class
The following list provides some of the attributes for the LDAP User class. For a complete list you should
consult http://msdn2.microsoft.com/en-us/library/ms683980(VS.85).aspx#windows_2000_server_attributes.

l userPrincipalName: The userPrincipalName is a single-valued and indexed property that is a string that
specifies the user principal name (UPN) of the user. The UPN is an Internet-style login name for the user
based on the Internet standard RFC 822. The sAMAccountName property is a single-valued property that is
the logon name The objectSid property is a single-valued property that specifies the security identifier (SID)
of the user.

l accountExpires: The accountExpires property specifies when the account will expire.

l badPasswordTime: The badPasswordTime property specifies when the last time the user tried to log onto
the account using an incorrect password.

l badPwdCount: The badPwdCount property specifies the number of times the user tried to log on to the
account using an incorrect password.
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l codePage: The codePage property specifies the code page for the user's language of choice. This value is
not used by Windows 2000.

l countryCode: The countryCode property specifies the country code for the user's language of choice. This
value is not used by Windows 2000.

l lastLogoff: The lastLogoff property specifies when the last logoff occurred.

l lastLogon: The lastLogon property specifies when the last logon occurred.

l logonCount: The logonCount property counts the number of successful times the user tried to log on to
this account.

l mail: The mail property is a single-valued property that contains the SMTP address for the user (such as
demo@example.com).

l memberOf: The memberOf property is a multi-valued property that contains groups of which the user is a
direct member.

l primaryGroupID: The primaryGroupID property is a single-valued property containing the relative
identifier (RID) for the primary group of the user.

l sAMAccountType: The sAMAccountType property specifies an integer that represents the account type.

l unicodePwd: The unicodePwd property is the password for the user.

Regular Expressions
The characters shown in Table 127 can be used to perform pattern matching tasks using regular expressions.

Regex Matches

a Any string containing the letter “a”

^a Any string starting with “a”

^a$ Only the string “a”

a$ Any string ending with “a”

. Any single character

\. A literal “.”

[abc] Any of the characters a, b, or c

[a-z0-9A-Z] Any alphanumeric character

[^a-z] Any character not in the set a through z

a? Matches zero or one “a”

a+ Matches one or more: a, aa, aaa, …

a* Matches zero or more: empty string, a, aa, aaa…

a|b Alternate matches: Matches an “a” or “b”

Table 127: Regular Expressions for Pattern Matching
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Regex Matches

(a.*z) Grouping: matches sequentially within parentheses

a*? “Non-greedy” zero or more matches

\ooo The character with octal code ooo

\040 A space

\d Any decimal digit

\D Any character that is not a decimal digit

The regular expression syntax used is Perl-compatible. For further details on writing regular expressions,
consult a tutorial or programming manual.
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Appendix 1
Chromebook in Onboard

This appendix describes Chromebook functionality in ClearPass Onboard. It provides an introduction to
Chromebook in Onboarrd, and discusses considerations as well as Onboard and Google Admin configuration
for Chromebook.

This section includes:

l "About Chromebook in Onboard" on page 525

l "Caveats and Recommendations" on page 526

l "Onboard Configuration for Chromebook" on page 528

l "Google Admin Configuration for Chromebook" on page 529

About Chromebook in Onboard
Chromebook is a managed device. When you use Google Apps for Business or Google Apps for Education, you
use the Google Admin console for provisioning, management, and control of Chromebook devices.

However, Chromebook still requires a Wi-Fi connection to work.

Administrators can take advantage of ClearPass Onboard's Chromebook support for certificate enrolling. Users
can be provided with EAP-TLS client certificates to securely establish their network identity. All of the existing
capabilities of Onboard can then be leveraged to ensure reliable and policy-controlled access to the network.

Figure 44 Network Architecture

In the network architecture diagram shown in "Network Architecture " on page 525:

l Chromebook users access the network through the local Wi-Fi.

l The Google Apps domain provides user login services and other apps, such as the Chrome Web Store,
Google Docs, Google Sheets, and more.

l The Admin Console is used by administrators to provision new Chromebooks and manage existing
Chromebooks.

l Chromebook Sync is used to ensure that settings from the Admin Console are applied to all Chromebooks
in the domain.
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l Users, groups, and other details can be provisioned in Google Apps from an existing directory using the
Google Apps Directory Sync tool.

l ClearPass Onboard provides device provisioning and certificate enrollment services.

l The Chrome Extension provides support for Onboard device provisioning for Chromebook devices.

Caveats and Recommendations
This section describes requirements related to licenses, extensions, deployment, versions, certificates,
provisioning, and authentication sources.

Google Admin Chromebook License is Required
Chromebook management is only available in the Google Admin console (https://admin.google.com) if a
suitable license has been added for the domain under management.

Managed Chromebook Deployment is Required
Chromebook is a managed device, not a “BYOD” device. The support for Onboard is limited to device
provisioning and enrollment in an administrator-managed network. Non-managed Chromebook devices
cannot be enrolled using ClearPass Onboard.

Chrome Extension is Required
Chromebook does not natively support device enrollment with products such as ClearPass Onboard. For this, a
Chrome extension is required.

Additionally, because of the software security model used by Chromebook, “normal” Chrome extensions (for
example, those installed from the Chrome Web Store) do not have permissions to alter the certificate store on
the device. To do this requires an administratively configured extension, which is why Chromebook must be
managed for Onboard enrollment to work.

For details of how to configure the Google Admin console to automatically install this extension when a user
logs into Chromebook, refer to the Configure Chrome Extension section in "Google Admin Configuration for
Chromebook" on page 529 .

Chromebook Release 37 or Later is Required
The Onboard extension requires Chrome version 37 or later. As of the time of this writing (July 2014) this
version of Chrome is only available in the development channel.

To provision Chromebook devices with the development channel, create an organizational unit within your
organization. For that organizational unit, configure Device Settings and set the Release Channel to Move to
Development Channel. Then move one or more devices into this organizational unit to enable the
development channel.

When the stable release catches up with the development channel, no special configuration will be required to
enable Onboard for Chromebook.
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For more information on the Chromebook stable, beta and development channels, refer to this article:
https://support.google.com/chromebook/answer/1086915

Chromebook Supports Only “Created by Device” Certificates
Chromebook includes a trusted platform module (TPM) for protection of cryptographic private keys, including
the private key for the TLS client certificate issued to the device by Onboard.

Because of this, Chromebook will always create its own private key. The Key Type option in Device
Provisioning Settings will be ignored by Chromebook devices, and will always default to created by device.

The key size is 1024 bits or 2048 bits, as specified in the Device Provisioning Settings.

If an unsupported selection is made in the Provisioning Settings form, the default used will be a 2048-bit private key.

A Separate Provisioning SSID is Required
Chromebook cannot be provisioned unless it is already online, in order to sync with the appropriate settings
from the Google Admin console.

To handle the initial configuration task, we recommend you follow these steps:

l Configure an Onboard provisioning SSID.

n Ensure that this SSID has an access-control list that allows the Chromebook to log in and sync with
Google Apps. For details on the contents of the ACL, refer to this article:
https://support.google.com/chrome/a/answer/3504942#sslinspection

n Use a captive portal on this SSID that redirects users to the Onboard device provisioning page.

n Note that this SSID can also be used to Onboard other devices that are supported by ClearPass
Onboard.

l Ensure that the Chromebook is enrolled.

n To manually enroll a brand-new Chromebook, press Ctrl+Alt+E before attempting to log in with any
domain credentials.

n Be aware that once a user has signed in to a device, you cannot enroll the device. The device must be
wiped in order to restart the enrollment process.

n For more details on enrolling a Chrome device, including details on automatic enrollment, refer to this
article: https://support.google.com/chrome/a/answer/1360534

l Sign in to the device using the credentials of an account in the Google Apps domain.

n Connect to the provisioning SSID using the Chrome setup wizard.

Do not save the credentials you used to connect to the provisioning SSID.

n The device will sync with the Admin console settings.

n This will also install the Onboard Chrome extension, if it is configured correctly in the Google Admin
console.

l Open the Chrome browser on the device.

n The captive portal will redirect you to the device provisioning page.

n Sign in with appropriate credentials.
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n The Chrome device will be provisioned with a new certificate.

n The provisioned network should be automatically activated when it is available. If not, manually connect
to the network to verify that EAP-TLS is working correctly.

Directory-Based Authentication Source is Recommended
When a Chromebook user with an EAP-TLS certificate connects to the network, an authorization check is
performed to ensure that the certificate is still valid, and that the user account associated with the certificate is
still permitted to use the network.

ClearPass Policy Manager provides this capability for multiple authentication sources. However, at this time, no
built-in Google Apps authentication source is available.

Many Chromebook deployments will take advantage of Google Apps Directory Sync to use an existing LDAP or
Active Directory authentication source. In this environment, a ClearPass authentication source can be used to
verify the status of a user account when a device connects to the network.

If your deployment does not have an LDAP or Active Directory source, you can still use Onboard to provision
Chromebook devices. However, in this environment you must manually revoke the certificates of users who
are no longer authorized to access the network.

Onboard Configuration for Chromebook
The Onboard > Deployment and Provisioning > Provisioning Settings > Chromebook tab provides
Chromebook configuration settings:
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The text displayed on the device provisioning page for Chromebook devices can be customized using
additional settings on this tab.

In addition, to ensure that Chromebook support is enabled, use the Enable Chromebook device
provisioning check box on the General tab (this check box is selected by default).

For more information, see "Configuring Provisioning Settings for Chromebook" on page 182 in the Onboard
chapter.

Google Admin Configuration for Chromebook
This section describes Google Admin configuration for Chromebook in Onboard.

To begin, log in to the Google admin console at https://admin.google.com/.

Configuring the Chrome extension
1. In the Google Admin console, select the Device Management option.

2. Select the Chrome option.

3. Go to User Settings.
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If you have multiple organizational units or levels, be sure to select the appropriate organizational unit or level
before you make changes to the settings.

4. In the user settings, find the Pre-installed Apps and Extensions section, and then click the Manage pre-
installed apps link.

5. Select Specify a Custom App.

6. Enter the ID and URL of the Onboard Chromebook extension and then click Add.

The ID and URL infornation is available on the Onboard > Deployment and Provisioning > Provisioning Settings
> Chromebook tab.

If you have a cluster environment, the URL may be modified to refer to any subscriber node.
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7. Verify that the extension is listed in the Pre-installed Apps and Extensions list, and then click Save.

8. Remember to save your changes using the Save changes button at the bottom left of the page.

Configuring Network Settings
1. From the Chrome Management page, go to Network.

2. You should see the For Users tab selected. Click the Add Wi-Fi button on the right.

3. Specify a Name and SSID for the network, and select the Automatically Connect option.

4. Change the Security Type to WPA/WPA2 Enterprise (802.1X),

5. Under Extensible Authentication Protocol, select EAP-TLS.

6. The Username can be set as a fixed value (for example, anonymous), or it can take the variables ${LOGIN_
ID} (for example, johndoe) or ${LOGIN_EMAIL} (for example, johndoe@mydomain.com).

7. If your RADIUS server doesn’t have a commercially issued certificate, then you might need to use the Add
new certificate... option for Server Certificate Authority to upload the signer of the RADIUS
certificate.

Be sure to use the Root CA and not the Signer CA.

If you already have an appropriate certificate in the list, then it can be selected directly.

ClearPass Guest 6.4 | User Guide Chromebook in Onboard | 531
Anexo 11 ITEM 01 (0592523)         SEI 0008478-63.2018.6.02.8000 / pg. 3558



532 | Chromebook in Onboard ClearPass Guest 6.4 | User Guide

8. For Client enrollment URL, provide the URL of the Onboard captive portal page—for example,
https://server/onboard/device_provisioning.php.

9. You should also specify the Common Name of the Onboard CA’s issuing certificate in Issuer pattern >
Common name—for example, “ClearPass Onboard Local Certificate Authority (Signing)”.

10.Click Save to save the network settings, and remember to click Save changes to commit.
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Chapter 2
Glossary

$criteria Array that consists of one or more criteria on which to perform a data-based search. This array is
used for advanced cases where predefined helper functions do not provide required flexibility.

802.1X Standard for port-based network access control, designed to enhance 802.11 WLAN security. The
802.1X standard provides an authentication framework, allowing a user to be authenticated by a central
authority. The actual algorithm that is used to determine whether a user is authentic is left open and multiple
algorithms are possible.

AAA Authentication, Authorization, and Accounting.

Access-Accept Response from RADIUS server indicating successful authentication, and containing
authorization information.

Access-Reject Response from RADIUS server indicating a user is not authorized.

Access-Request RADIUS packet sent to a RADIUS server requesting authorization.

accounting Process of recording summary information about network access by users and

devices.

Accounting-Request RADIUS packet type sent to a RADIUS server containing accounting summary
information.

Accounting-Response RADIUS packet sent by the RADIUS server to acknowledge receipt of an Accounting-
Request.

accounting session time Length of time the guest has been using the network.

Active Directory (AD) Microsoft Active Directory. Directory server that stores information about a variety of
things, such as organizations, sites, systems, users, shares, and other network objects or components. It also
provides authentication and authorization mechanisms, and a framework within which related services can be
deployed.

ActiveSync Mobile data synchronization app developed by Microsoft that allows a mobile device to be
synchronized with either a desktop or a server running compatible software products.

AirGroup Application that allows end users to register their personal mobile devices on a local network and
define a group of friends or associates who are allowed to share them. Primarily designed for colleges and
other institutions. AirGroup configuration is distributed across the Aruba mobility controller, ClearPass Policy
Manager, and ClearPass Guest.

Amigopod Original name of the ClearPass Guest application. No longer used, but still appears in some syntax.

app Application.

application identifier Unique identifier generated when a provisioning profile is created. In combination with
the approved domain, it allows app distribution.

audit servers Evaluate the health of clients that do not have an installed agent, or that cannot respond to
Policy Manager interactions. Audit servers typically operate in lieu of authentication methods, authentication
sources, or internal posture policies and posture servers.

authentication Verification of a user’s credentials, typically a username and password.
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authentication source Identity repository against which Policy Manager verifies identity. CPPM supports the
following authentication source types: Microsoft Active Directory, LDAP-compliant directories, RSA or other
RADIUS-based token servers, and SQL database, as well as Static Host lists for MAC-based authentication.

authorization Authorization controls the type of access that an authenticated user is permitted to have.

authorization source Collects attributes for use in role-mapping rules. You specify the attributes you want to
collect when you configure the authentication source. CPPM supports the following authorization source
types: Microsoft Active Directory, any LDAP compliant directory, RSA or other RADIUS-based token servers,
and SQL database, including the local user store.

bounce To shut down and restart a service or port.

BYOD Bring your own device.Refers to using personal mobile devices within an employer's enterprise network
infrastructure, and the associated network and resource management challenges.

CA See Certificate Authority.

captive portal Implemented by NAS. Provides access to network only to authorized users.

Certificate Authority (CA) Entity in a public key infrastructure system that issues certificates to clients. A
certificate signing request received by the CA is converted into a certificate when the CA adds a signature that is
generated with the CA’s private key. See digital certificate, private key, and public key infrastructure.

CHAP Challenge-Handshake Authentication Protocol. Authentication scheme used by Point to Point Protocol
(PPP) servers to validate the identity of remote clients.

ClearPass Access Management System for creating and enforcing policies across a network to all devices and
applications. The ClearPass integrated platform includes Policy Manager, Guest, Onboard, OnGuard, Insight,
Profile, AirGroup, and MACTrac.

ClearPass Guest SeeGuest.

CoA Change of Authorization.

collectors Network elements providing data for profiling endpoints. The following collectors send endpoint
attributes to Profile: DHCP, Onboard, HTTP User Agent, MAC OUI, ActiveSync plugin, OnGuard, SNMP, and
Subnet Scanner.

common name (CN) See distinguished name.

CPPM ClearPass Policy Manager. May refer to the Policy Manager application, or all applications within the
ClearPass platform. See also Policy Manager.

CRL Certificate revocation list. List of revoked certificates maintained by a certificate authority and regularly
updated.

cryptobinding Short for cryptographic binding. Procedure in a tunneled EAP method that binds together the
tunnel protocol and the tunneled authentication method(s), ensuring the relationship between a collection of
data assets. Cryptographic binding focuses on protecting the server; mutual cryptographic binding protects
both peer and server.

CSR Certificate Signing Request.

CSV Comma-separated values.

device category Classification describing a device's type—for example, computer, smartdevice, printer, access
point, and so on. One of three hierarchical elements in a device profile.

device family Within the device category, a classification based on the type of operating system or vendor—
for example, if the device category is Computer, the value for device family might be Windows, Linux, or Mac
OS. One of three hierarchical elements in a device profile.
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device fingerprint Information collected about a device for the purpose of identification. Fingerprints can
fully or partially identify individual users or devices even when cookies are turned off.

device name Within the device family, a classification based on granular details such as OS version—for
example, if the device family is Windows, the value for device name might be Windows 7 or Windows 2008
Server. One of three hierarchical elements in a device profile.

device provisioning Process of preparing a device for use on an enterprise network, by creating the
appropriate access credentials and setting up the network connection parameters. Same as onboarding.

DHCP Dynamic Host Configuration Protocol. An auto-configuration protocol used on IP networks. Computers
or any network peripherals that are connected to IP networks must be configured before they can
communicate with other computers on the network. DHCP allows a computer to be configured automatically,
eliminating the need for a network administrator. DHCP also provides a central database to keep track of
computers connected to the network; this database helps prevent any two computers from being configured
with the same IP address.

digital certificate Contains identification data (see distinguished name) and the public key portion of a
public/private key pair, and a signature that is generated by a certificate authority. The signature ensures the
integrity of the data in the certificate (only the certificate authority can create valid certificates).

Disconnect-Ack NAS response packet to a Disconnect-Request, indicating that the session was disconnected.

Disconnect-Nak NAS response packet to a Disconnect-Request, indicating that the session could not be
disconnected.

Disconnect-Request RADIUS packet type sent to a NAS requesting that a user or session be disconnected.

dissolvable agent Functionality within ClearPass OnGuard. Performs a one-time check at login to ensure
policy compliance. Devices not meeting compliance can be redirected to a captive portal for manual
remediation. When the browser page used during authentication is closed, the dissolvable agent is removed,
leaving no trace. The Web-based dissolvable agent is ideal for personal, non IT-issued devices that connect via a
captive portal and do not allow agents to be permanently installed. See also persistent agent and OnGuard.

distinguished name (DN) Series of fields in a digital certificate that, taken together, constitute the unique
identity of the person or device that owns the digital certificate. Common fields in a distinguished name include
country, state, locality, organization, organizational unit, and the “common name”, which is the primary name
used to identify the certificate.

DN See distinguished name.

EAP Extensible Authentication Protocol (RFC 3748). An authentication framework that supports multiple
authentication methods. In tunneled EAP methods, authentication and posture credential exchanges occur
inside of a protected outer tunnel.

EAP-FAST EAP – Flexible Authentication Secure Tunnel. (tunneled)

EAP-GTC EAP Generic Token Card. (non-tunneled)

EAP-MD5 EAP-Method Digest 5. (non-tunneled)

EAP-MSCHAP; EAP-MSCHAPv2 EAP Microsoft Challenge Handshake Authentication Protocol, version 1 and
version 2. (non-tunneled)

EAPoUDP EAP over UDP. See also UDP.

EAP-PEAP Protected EAP. A widely-used protocol for securely transporting authentication data across a
network. (tunneled)

EAP-TLS EAP – Transport LayerSecurity (RFC 5216). A certificate-based authentication method supporting
mutual authentication, integrity-protected ciphersuite negotiation and key exchange between two endpoints.
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EAP-TTLS EAP – Transport Layer Security (RFC 5216). A certificate-based authentication method supporting
mutual authentication, integrity-protected ciphersuite negotiation and key exchange between two endpoints.

form Interactive page in the application where users can provide or modify data.

field In a database or user interface, a single item of information about a visitor account; attribute.

FQLN Fully Qualified Location Name. A device location identifier in the format:
APname.Floor.Building.Campus.

GET HTTP request method that submits data to be processed to a specified resource.

Guest Configurable ClearPass application for secure visitor network access management. Access permissions
to ClearPass Guest features are controlled through an operator profile that can be integrated with an LDAP
server or Active Directory login. The ClearPass Guest application can be accessed either directly or through
CPPM.

guest See Visitor.

IdP Identity Provider. Service that authenticates a user or client identity and issues security tokens for ACS.

Insight ClearPass analytics and reporting application.

intermediate CA Certificate authority with a certificate that was issued by another certificate authority. See
trust chain.

iOS Operating system from Apple, Inc. for mobile devices, including the iPhone, iPad, and iPod Touch.

jailbreak; jailbroken Modifying an iOS device in order to download applications, extensions, or themes not
authorized by Apple. The term is also sometimes used to describe similar activity on non-Apple devices. The
legal implications of jailbreaking a device vary by country and by device.

landing page SeeWeb login.

LDAP Lightweight Directory Access Protocol; communications protocol used to store and retrieve information
about users and other objects in a directory.

MAC address Media Access Control Address. Unique identifier assigned to network interfaces for
communications on a network. A device may have a wired network address and a wireless network address.

MAC auth MAC Authentication Method. Authenticates devices based on their MAC address. MAC
authentication might be the only method of client authentication or clients may also be required to
authenticate themselves using other methods, depending on the network privileges required.

MAC OUI The OUI is the first half of a MAC address. It can be useful in some cases for better identifying
endpoints, or for profiling devices like printers that might be configured with static IP addresses. See also OUI.

MACTrac Application that allows end users to register their personal mobile devices on a local network. Each
device registered by an operator is automatically shared with all of that operator’s registered devices. There is
no limit to the number of device accounts an operator can create, and no expiration time is set on device
accounts. MACTrac operators are created in CPPM, and can then log in through ClearPass Guest to register and
manage their devices.

MAM Mobile Application Management. The employee owns the mobile device used for work, and the
company provides and manages the features.

MDM Mobile Device Management. The company owns and manages the mobile device the employee uses for
work. A company-issued laptop is actually an MDM device, but MDM features in ClearPass allow company
management to be applied to a variety of devices.

MIB Management Information Base. Hierarchical database used by SNMP to manage the devices being
monitored.
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NAD Network Access Device. The device that automatically connects the user to the preferred network; for
example, an AP or an Ethernet switch.

NAK Negative AcKnowledgement code. Response indicating that a transmitted message was received with
errors or corrupted, or that the receiving end is not ready to accept transmissions.

NAP Network Access Protection. Platform on the Windows Server that allows network administrators to define
specific levels of network access based on identity, groups, and policy compliance. The NAP Agent is a service
that collects and manages health information for NAP client computers.

Network Access Server (NAS) Device that provides network access to users, such as a wireless access point,
network switch, or dial-in terminal server. When a user connects to the NAS device, a RADIUS user
authentication request (Access-Request) is generated by the NAS.

nMAP Network Mapper. Open source utility for network discovery and security auditing. Nmap uses IP
packets to determine such things as the hosts available on a network and their services, operating systems and
versions, types of packet filters/firewalls, and so on.

NTP Network Time Protocol. Protocol for synchronizing the clocks of computers over a network.

OCSP Online certificate status protocol (RFC 2560). Protocol used to determine the current status of a digital
certificate without requiring CRLs.

Onboard ClearPass application for automating 802.1X configuration and provisioning for “bring your own
device” (BYOD) and IT-managed devices across wired, wireless, and virtual private networks (VPNs).
Information Onboard collects during device onboarding is sent to Profile and used for device category, family,
and name classification. ClearPass Onboard features are part of the Onboard module in the ClearPass Guest
application.

onboarding Process of preparing a device for use on an enterprise network, by creating the appropriate access
credentials and setting up the network connection parameters. Same as device provisioning.

onboard-capable device Device supported by the QuickConnect application.

onboard provisioning Process used to securely provision a device and configure it with network settings.

OnGuard Functionality within ClearPass that uses persistent and dissolvable agents to perform endpoint
protection, posture assessments, and health checks, ensuring compliance is met before devices connect. See
also dissolvable agent and persistent agent.

operator Person who uses ClearPass Guest to create guest accounts or perform system administration.
Operators act as sponsors for visitor access.

operator login Configuration defining a ClearPass Guest operator's roles and access privileges.

operator profile Characteristics assigned to a class of operators, such as the permissions granted to those
operators.

OS X Operating system from Apple, Inc. for desktop and laptop computers.

OUI Organizationally Unique Identifier. Synonymous with Company ID or Vendor ID, an OUI is a 24-bit,
globally-unique assigned number referenced by various standards. The OUI is used as the first half of a MAC
address.

over-the-air provisioning Process used to securely provision a device and configure it with network settings;
applies to iOS and OS X 10.7+ only.

PANW Palo Alto Networks. Network security company whose products include a firewall with which ClearPass
integrates, exchanging user context related to posture assessments.

PAP Password Authentication Protocol. Validates users by password, PAP does not encrypt passwords for
transmission and is thus considered insecure.
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PEAP Protected EAP. See EAP-PEAP.

persistent agent Functionality within ClearPass OnGuard. Provides nonstop monitoring and automatic
remediation and control, and supports automatic and manual remediation. When running persistent OnGuard
agents, CPPM can centrally send system-wide notifications and alerts, and allow or deny network access. See
also dissolvable agent and OnGuard.

ping Test network connectivity using an ICMP echo request (“ping”).

PKCS#n Public-key cryptography standard N. Refers to a numbered standard related to topics in cryptography,
including private keys (PKCS#1), digital certificates (PKCS#7), certificate signing requests (PKCS#10), and secure
storage of keys and certificates (PKCS#12).

PKI See public-key infrastructure.

Policy Manager ClearPass Policy Manager (CPPM) is the main application of the ClearPass access
management platform, and is used to create and enforce policies across a network for all devices and
applications. CPPM also includes links to Guest, Insight, and Onboard. OnGuard and Profile features and some
AirGroup configuration items are included within the Policy Manager user interface.

POST HTTP request method that requests date from a specified resource.

posture Set of characteristics describing the health of an endpoint device seeking access to the network. These
may include such things as device type, operating system, or antivirus software. Posture assessment or
posture validation: Using rules to evaluate and provide a security assessment for the endpoint and its user,
assuring they are compliant. Posture token: Health status of the endpoint.

posture policies, internal Internal posture policies test requests against internal posture rules to assess
health. Posture rule conditions can contain attributes present in vendor-specific posture dictionaries.

posture servers Evaluate client health based on specified vendor-specific posture credentials, typically
posture credentials that cannot be evaluated internally by Policy Manager (that is, not by internal posture
policies). Currently, Policy Manager supports two forms of posture server interfaces: RADIUS posture servers
and GAMEv2 posture servers.

pre-shared key See PSK.

print template Defines the format and appearance of a guest account receipt.

private key The part of a public/private key pair that is always kept private. The private key is used to encrypt
a message’s signature to authenticate the sender (only the sender knows the private key). The private key is
also used to decrypt a message that was encrypted with the sender’s public key (only the sender can decrypt
it). See also public key.

Profile Functionality within ClearPass that automatically classifies endpoints, using attributes obtained from
collectors. It associates an endpoint with a specific user or location, secures access for devices like printers and
IP cameras, and can be used to implement BYOD flows where access is controlled based on the type of the
device and the identity of the user.

PSK Pre-shared key. Shared secret that was previously shared between two parties over a secure channel prior
to use.

public key The part of a public/private key pair that is made public. The public key is used to encrypt a
message; the recipient’s private key is required to decrypt the message. A large part of a digital certificate is the
certificate owner’s public key. See also private key.

public-key infrastructure Security technology based on digital certificates and the assurances provided by
strong cryptography. See also certificate authority, digital certificate, public key, private key.

push certificates Enable the server to work with the Apple Push Notification Service (APNS) and Apple iOS
devices connected to an MDM account.
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QC SeeQuickConnect.

QuickConnect Functionality within ClearPass used to securely provision an Android, Windows, or OS X device
and configure it with network settings. QuickConnect's functionality is now incorporated within Onboard.

RADIUS Remote Access Dial-In User Server. Network access-control protocol for verifying and authenticating
users; provides AAA management. A RADIUS transaction might be 802.1X, MAC-Auth, or generic RADIUS.

RFC Request For Comments; a commonly-used format for Internet standards documents.

RFC 3576 Dynamic Authorization Dynamic authorization describes the ability to make changes to a visitor
account’s session while it is in progress. This might include disconnecting a session or updating some aspect of
the authorization for the session.

role Type of access being granted. ClearPass lets you define multiple roles. Such roles could include employee,
guest, team member, or press. Roles are used for both guest access (user role) and operator access to
ClearPass. See operator profile.

root CA Certificate authority that signs its own certificate (a self-signed certificate), and must be explicitly
trusted by users of the CA.

SAML Security Assertion Markup Language. XML-based framework for communicating user authentication,
entitlement, and attribute information. SAML enables single sign-on by allowing users to authenticate at an
identity provider and then access service providers without additional authentication.

SAN Subject Alternative Name. SANs let you specify a list of host names to be protected by a single SSL
certificate. Multiple domain names are secured by adding them to the Subject Alternative Name (SAN) field
during enrollment. The common name, or primary domain name, on the certificate must be a registered fully
qualified domain name.

SCP Secure copy; SCP Protocol. Network protocol that supports file transfers between hosts on a network.

SCEP Simple certificate enrollment protocol. Protocol for requesting and managing digital certificates.

self-signed certificate See root CA.

session Service provided by a NAS to an authorized user.

skin A Web site’s visual appearance, or “look and feel.” It can be thought of as a container that holds the
application, its layout, style sheet (font size and color for example), header and footer, and so forth.

Smarty Template engine for PHP, facilitating the separation of presentation (HTML/CSS) from application
logic.

SMS Short Message System; a method for delivering short messages (up to 140 characters) to mobile phones.

SNMP Simple Network Management Protocol. A TCP/IP standard protocol for managing devices on IP
networks. Network administrators use SNMP to monitor and map network availability, and facilitate the
exchange of information between network devices.

SOAP Web Services SOAP Web services provide a way of transferring data across the Internet to integrate
Web-based applications. Web services let businesses share data and processes programmatically, and can be
added to a user interface to provide functionality. The SOAP interface is available to third-party applications
that will integrate with the ClearPass Guest Visitor Management Appliance. The API provides direct access to
the underlying functionality of the ClearPass Guest Visitor Management Appliance. Developers wishing to
provide integrated applications can use the API to programmatically perform actions that would otherwise
require manual operation of the user interface.

SoH Statement of Health.

sponsor See operator.
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SSID Service Set Identifier. Unique identifier attached to the header of packets sent over a WLAN that acts as a
password when a mobile device tries to connect to the basic service set (BSS).

SSO Single Sign-On. Access-control property that lets a user log in once to access multiple related but
independent applications or systems to which they have privileges. The process authenticates the user across
all allowed resources during their session, eliminating additional login prompts.

static host A hostname; a relationship between a name and an IP address. A static host list is a named list of
MAC or IP addresses.

TACACS Family of protocols that handle remote authentication and related services for network access control
through a centralized server.

TLS See EAP-TLS.

trust chain Sequence of certificates, starting at a trusted root certificate, that establishes the identity of each
certificate in the chain.

trusted root See root CA.

TTY TTY-enabled devices allow telephones to transmit text communications for people who are deaf or hard of
hearing as well as voice communication.

UDID Unique Device Identifier for an iOS device.

UDP User Datagram Protocol. Part of the TCP/IP family of protocols used for data transfer. UDP is typically
used for streaming media, and is a "stateless" protocol, meaning it doesn't acknowledge that the packets being
sent have been received.

unique device credentials Network authentication credentials that uniquely identify the device and user
and enable management of provisioned devices. May be a username and password or a TLS client certificate,
depending on the type of device.

user database Database of the guests on the system.

UUID Universally Unique Identifier. Unique identifier generated when a provisioning profile is created, allowing
proper app distribution permissions.

view Page in the application that displays data but does not contain interactive fields the user can modify.
Usually a table listing things like accounts or other sets of data and providing links to related actions or forms.

visitor Someone who is permitted to access the Internet through your Network Access Server. Also referred to
as a guest.

VMA Visitor Management Appliance. Refers to the ClearPass Guest application.

VPN Virtual private network. Enables secure access to a corporate network when located remotely.

VSA Vendor-specific attribute.

walled garden Defined set of internet or network resources that can or cannot be accessed by unauthorized
users through the captive portal.

WebAuth User-authentication system for Web pages and Web applications. Web authentication transactions
through the dissolvable agent in OnGuard.

Web login Login page displayed to a visitor.

Wi-Fi Wireless Fidelity. Wireless technology providing connectivity within an local area network.

X.509 Standard defining the format and contents of digital certificates.

XML-RPC XML Remote Procedure Call. Protocol that uses XML to encode its calls and HTTP as a transport
mechanism. The XML-RPC interface is available to third-party applications that will integrate with the ClearPass
Guest Visitor Management Appliance. The ClearPass Guest XML-RPC API provides direct access to the
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integrated applications can use the API to programmatically perform actions that would otherwise require
manual operation of the user interface.
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private files 189

public files 189

uploading 190

creating

account filter 458

AirGroup administrator 462

AirGroup groups 67

AirGroup operator 462

certificate authority 97

configuration profiles 164

content directory 191

device accounts 41

ClearPass Guest 6.4 | User Guide Index | 545

field 206

guest account 39

hotspot plan 345

LDAP server 465

LDAP translation rule 469

multiple guest accounts 45, 50

operator 462

operator profile 456

operator profiles 456

print template 292

self registration 241

session filter 458

SMS gateway 297

credits, SMS 303

CSV

caching 498

parsing 499

customer support 451

customizing

content 189

email receipt 285-286

fields 206

Guest Manager 192

hotspot invoice 348

hotspot receipt 354

hotspot selection interface 350, 352, 354

login message 257

login page 254

receipt actions 248

receipt page 248

Register Shared Device 209

registration form 245

registration page 245

self-service portal 258

view fields 233

D

data retention 81, 431

databases, user 26

Anexo 11 ITEM 01 (0592523)         SEI 0008478-63.2018.6.02.8000 / pg. 3572



default skin 446

deleting

certificate 117

field 208

SMS gateways 296

SMTP carrier 305

deployment

network provisioning 26

operational issues 26

overview 26

security policy 27

site checklist 27

device management 108, 112

device type 114

devices 59

creating accounts 41

editing 70

filtering 60

importing 77

list 108, 112

paired accounts 44

personal, AirGroup 69

provisioning configuration 168

shared 67

viewing 70

digital passes 270

Apple Passbook certificates 273

creating and editing a template 277

images 283

managing 276

process overview 273

template code variables 282

templates 272

viewing certificates 274

disabling

SMTP carrier 305

disconnecting session 34-35

documentation, viewing 452
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duplicating

fields 208

forms and views 213

SMS gateways 296

dynamic authorization 33, 35

E

editing

base field 214, 234, 247

certificate authorities 100

devices 70

expiration time, guest account 57

fields 208

form fields 215

forms 212, 214

guest accounts 467

guest self-registration 240

hotspot plans 345

print templates 294

receipt pages 248

self-registration 245

SMS gateway 301

SMS gateways 296

views 212, 233

email 147

guest self-registration receipts 252

receipts 41, 284

receipts, customizing 285

SMTP services 284

enabling

SMTP carrier 305

encoding 52

encryption key, in guest receipt 196

Exchange ActiveSync 140

expiration

guest accounts, editing 57

exporting

certificates 116

guest accounts 50

Anexo 11 ITEM 01 (0592523)         SEI 0008478-63.2018.6.02.8000 / pg. 3573



F

fields 25, 198

account_activation 502

address 510

auto_send_sms 511

auto_send_smtp 511

auto_update_account 198, 502

captcha 502

card_code 510

card_expiry 510

card_name 510

card_number 510

change_of_authorization 502

city 510

country 510

create_time 503

creating 206

creator_accept_terms 198, 503

creator_name 503

customizing 206

Delete 208

deleting 208

do_expire 199, 503

do_schedule 199, 503

duplicating 208

dynamic_expire_time 503

dynamic_is_authorized 503

dynamic_is_expired 503

dynamic_session_time 503

Edit 208

email 198, 504

enabled 199, 504

expiration_time 504

expire_after 199

expire_postlogin 200

expire_time 199, 504

expire_timezone 504

expire_usage 200, 504
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first_name 510

hotspot_plan_id 510

hotspot_plan_name 510

http_user_agent 504

id 504

importing matching 53

ip_address 504

last_name 510

modify_expire_postlogin 504

modify_expire_time 199, 505

modify_expire_usage 505

modify_password 198, 505

modify_schedule_time 199, 505

multi_initial_sequence 193, 506

multi_prefix 193, 506

netmask 506

no_password 506

no_portal 506

no_warn_before 506

notes 506

num_accounts 506

password 194, 198, 294, 506

password_action 507

password_action_recur 507

password_last_change 507

password2 198, 507, 510

personal_details 510

purchase_amount 510

purchase_details 510

random_password 198, 507

random_password_length 198-199, 507

random_password_method 198-199, 507

random_password_picture 513

random_username_length 192, 198-199,
508

random_username_method 193, 198-199,
508

random_username_picture 193, 509, 513

rank ordering 214
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remote_addr 509

role_id 198, 509

role_name 198, 294, 509

schedule_after 199, 509

schedule_time 199, 509

secret_answer 259, 509

secret_question 259, 509

Show forms 209

show views 209

simultaneous_use 197-198, 509

sms_auto_send_field 291, 511

sms_enabled 290, 511

sms_handler_id 290, 511

sms_phone_field 291, 511

sms_template_id 291, 511

sms_warn_before_message 511

smtp_auto_send_field 289, 511

smtp_cc_action 289, 511

smtp_cc_list 289, 512

smtp_email_field 288, 512

smtp_enabled 288, 512

smtp_receipt_format 288, 512

smtp_subject 288, 512

smtp_template_id 288, 512

smtp_warn_before_cc_action 290, 513

smtp_warn_before_cc_list 290, 512

smtp_warn_before_receipt_format 289, 512

smtp_warn_before_subject 289, 512

smtp_warn_before_template_id 289, 512

sponsor_email 509

sponsor_name 509

state 510

submit 509

submit_free 510

user_activity 509

username 198, 294, 509

visitor_accept_terms 510

visitor_carrier 511
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visitor_company 509

visitor_fax 510

visitor_name 260, 510

visitor_phone 510

warn_before_from 290, 513

warn_before_from_sponsor 290, 513

zip 510

filtering

application log 450

devices 60

guest accounts 56, 65

sessions 36

form fields

advanced properties 230

CAPTCHA 216

check box 216

checklist 217

conversion functions 519

customizing 212

date/time picker 218

display functions 214, 519

display properties 215

drop-down list 219

duplicating 213

editing 212, 214

enable if 232

form field editor 215

group heading 224

hidden 219

initial value 227

password 221

previewing 214

radio buttons 221

static text 222

static text (options lookup) 224

static text (raw value) 223

text area 225

text field 226
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validation errors 227

validation properties 227

validator functions 514

value conversion 231

value format functions 519

value formatter 232

visible if 232

formats, certificates 116

forms 25, 198, 201

change_expiration 201

create_multi 201

create_user 201

guest_edit 201

guest_multi_form 66, 201

guest_register 201

guest_register_receipt 201

previewing 247

reset_password 201

G

global HTTP proxy 150

grant types, OAuth 377

guest 26

guest access

business rules 198

click to print 196

email receipt 284

NAS login 236

receipt page 235

registration page 235

roles 22

guest access, self-provisioned 32

guest accounts

activate 57

change expiration 57

creating 39

creating multiple 45, 50

delete 57

disable 57
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editing expiration 57

email receipt 41

export 50

exporting 50

filtering 56, 65

importing 52

list 55

paging 56

print 58

receipts 41

reset password 56

selection row 65

SMS receipt 41

view passwords 194

XML export 51

guest management 31-32

custom fields 206

customizing 192

email receipts 284

print template wizard 293

print templates 291

self provisioned 235

sessions 33

SMS receipts 38, 304

Guest module 31

guest self-registration

download receipt 251

email receipts 252

login page 254

print receipt 251

self-service portal 257

SMS receipt 253

H

help

context-sensitive 29

field help 29

quick help 30

searching 29
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hotspot management 341

captive portal 343

creating plan 345

customer information 348

customizing invoice 348

customizing receipt 354

customizing selection interface 350, 352,
354

editing plan 345

invoice 348

plans 344

Hotspot Manager 341

HTML

Smarty templates 478

standard styles 476

syntax 475

I

importing

certificate, code-signing 121

devices 77

guest accounts 52

matching fields 53

trusted certificate 122

interstitial ads 324

iOS settings 139

IPSec connection 157

K

key 196

key type 170

L

labels, advertising 336

language packs 307

LDAP

authenticating AirGroup users 364

custom rules 472

matching actions 470

matching rules 470
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operator logins 463

POSIX-compliant servers 463

server, creating 465

standard attributes 522

translation rules 463

translation rules, creating 469

URL syntax 467

user search for AirGroup, configuring 364

local operators 462

locations, AirGroup 67

log files 450

logging

passwords 194

M

MAC

address formats 76

advanced features 77

authentication 76

registering devices 76

message, sending SMS 303

methodsSee also XML-RPC API

Microsoft Active Directory Certificate
Services 106

MMS

SMS template for 307

mobile carrier

selecting 302

N

NAS 32

login 26

login, guest self-registration 253

network 129

Network Access Server 25

nwa_radius_query 483

O

OAuth 375

authorization servers 376
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client applications 376

client ID 376

client secret 376

grant types 377

redirect URI 377

registering app 376

resource owners 376

resource servers 376

service accounts 379

state token 377

Onboard

certificate authorities 96

certificate authority

creating 97

editing 100

date retention 81

deployment checklist 81

device management 108, 112

management and control 108

Smarty template functions 94

Onboard configuration 129

AirPlay 142

AirPrint 143

APN 144

calendar 144

Chromebook 528

configuration profiles 163-164

contacts 146

deployment and provisioning 163

email 147

Exchange ActiveSync 140

global HTTP proxy 150

iOS settings 139

network 129

passcode policy 151

provisioning settings 167-168

single sign-on (SSO) 153

subscribed calendar 154
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VPN 155

VPN IPSec connection 157

VPN VIA connection 155

Web clips and bookmarks 159

Web content filter 160

Windows applications (app sets) 162

Onboard module 79

Open SSL text format 116

operator logins 453

advanced options 456

configuration 454

LDAP 463

LDAP server, creating 465

password options 457

user roles 457

operator profiles 25, 453, 456

API privileges 374

automatic logout 456

creating 456

privileges 460

operators 25

creating 462

local 462

login message 455

P

pages

configuring 206

paired accounts 44

passcode policy 151

password grant type 377

passwords

generating 193

logging 194

multiple accounts 247

recovery 184

resetting 56

picture string 513

PKCS#12 116

Anexo 11 ITEM 01 (0592523)         SEI 0008478-63.2018.6.02.8000 / pg. 3578



PKCS#7 116

plugin management 443

plugins

configuring 444, 446

configuring, API Framework 373

configuring, Kernel 445

configuring, skin 446

IP Phone Services 448

Plugin Manager 443

SMS Services 447

Translation Assistant 449

viewing 443

POSIX, LDAP 463

previewing

forms 214, 247

print templates 25, 291

creating 292

creating using wizard 293

custom fields 294

editing 294

permissions 294

SMS receipts 292

private files, content 189

programmer’s reference 475

provisioning settings 163, 167

configuring 168

public files, content 189

Q

quick start, Smarty template syntax 478

R

RADIUS server 22

accounting query 483

active sessions 33

disconnecting session 34-35

reauthorizing session 34-35

reauthorizing

session 34-35
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receipt page 235

editing 248

receipts 38, 304

configuring 270, 305

email 284

redirect URI 377

reference 475

time-based sharing syntax 73

Register page 235

registering app, OAuth 376

registering MAC devices 76

regular expressions 523

resetting

passwords 56, 258

resource owners 376

resource servers 376

revoking certificate 116

RFC 2255 468-469

RFC 3576 35

role-based access 22

Role-based access control 453

roles 25

shared 68

RSA 170

S

searching

application log 450

documentation 452

security policy checklist 27

selecting

mobile carrier 302

self-registration

creating device 43

creating page 241

editing 245

self-service portal 184, 257

accessing 257

auto login 258
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password generation 258

resetting passwords 258

secret question 259

sending

SMS alert 37

SMS message 303

sequence diagram

AAA 23

guest self-registration 240

servers

LDAP, creating 465

service account, OAuth 379

session filters, creating 458

sessions

active 33, 35

closed 35

closing 37

device 63

disconnecting 34-35

filtering 36

reauthorizing 34-35

SMS alert 37

stale 35

shared locations 67

shared roles 68

single sign-on (SSO) 153

skin

configuring 446

email receipt 286

Smarty syntax

subject line 286

Smarty template functions 478

assign function 478

comments 478

foreach block 479

if block 478

include 478

literal block 479
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modifiers 480

nwa_adspace tag 320

Onboard 94

section block 479

variables 478

SMS

alert for session 37

alerts 37

character limit 292

credits 303

guest account receipts 41

guest self-registration receipts 253

subject line 286

SMS gateways

creating 297

editing 296, 301

viewing 296

SMS services 296

configuring 296

credits available 304

guest receipts 38, 304

low credit warning 304

receipt options 305

sending message 303

SMS gateways 296

SMTP services 284

customizing receipt 288

sending receipt 289

SOAP Web services 379

sponsors 26

SSO 153

stale session 35

state token, OAuth 377

subject line

email receipt 284

subscribed calendar 154

support 451

support services 449

Anexo 11 ITEM 01 (0592523)         SEI 0008478-63.2018.6.02.8000 / pg. 3580



syntax

time-based sharing, examples 71

time-based sharing, reference 73

T

tab-separated values 50, 52

tag=value pair 67

template

predefined template functions 480

time-based sharing 75

examples 71

time fencing 75

translation rules 469

translation services 307

customizing translated user interface
text 311

plugin 449

translation assistant 310

translation packs 308

creating and editing 308

troubleshooting

application integrity check 443

Onboard 95

TSV 50, 52

U

uploading

code-signing certificate 121

content 190

user database 26

V

viewing

application log 450

devices 70, 108

documentation 452

plugins 443

sessions, device 63

SMS gateways 296

SMTP carriers 305
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users 112

views 26, 198, 201

column format 235

customization 212

duplicating 213

editing 212, 233

field editor 234

guest_export 51, 201

guest_multi 64, 201

guest_sessions 34, 202

guest_users 55, 202

visitors 26

account 26

VPN 155, 157

VPN settings 155

W

Web clips and bookmarks 159

Web content filter 160

Web logins 26, 260

creating and editing pages 261

Windows applications 162

wizards

print template 293

WPA key 196

X

XML

guest account list 51

parsing 500

XML-RPC API 403

about 403

access control 404

accessing the API 406

API Symmetry 404

architecture overview 403

data representation 405

data types 405

faults 405
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field customization 404

invoking the API 408

method
amigopod.guest.change.expiration
410

method amigopod.guest.create 411

method amigopod.guest.delete 412

method amigopod.guest.edit 414

method amigopod.guest.enable 416

method amigopod.guest.get 417

method amigopod.guest.list 419

method
amigopod.guest.reset.password 420

method amigopod.mac.create 421

method amigopod.mac.edit 423

method amigopod.mac.list 425

method summary 409

parameter names 404

parameter validation 404
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HPE Networking Product Warranty & Support Summary (October 2018) 
 

The most current version of this document is available at www.hpe.com/networking/warrantysummary 
HPE Networking product warranty policy details are available at www.hpe.com/networking/warranty 

Information on services for HPE Networking products can be found at www.hpe.com/networking/services  
 The information contained herein is subject to change without notice.  Warranties for HPE products and services are set forth in the express warranty statements 

accompanying such products and services.   In addition, our goods come with guarantees that cannot be excluded under Australian and New Zealand consumer laws.  
Subject to the foregoing, nothing herein should be construed as constituting an additional warranty.  HPE shall not be liable for technical or editorial errors or omissions 

contained herein. 

 
 

 

 

 Products 
Warranty 
duration1 

Hardware 
replacement2 

Business 
Hours 

Technical 
Support3 

24x7 
Technical 
Support3 

(After Dec. 1, 2015) 

Software/OS 
Releases4 

S
w

it
c
h

e
s

 

Modular      

 129xx, 125xx, 119xx 1 year 10 days 1 year N/A As long as owned4 

 105xx, 75xx 1 year 10 days 1 year 90 days As long as owned4 

 84xx, 83xx 5 years 10 days 90 days N/A 5 years4 

 82xxzl, 54xxzl/R, 42xxvl 
Lifetime5 NBD Ship 

As long as 
owned5 

90 days As long as owned4 

Fixed-configuration      

 79xx, 59xx/AF, 583x/AF, 582x/AF, 57xx 1 year 10 days 1 year N/A As long as owned4 

 Altoline 9xxx, 6xxx Switches (Purchased after March 31, 2016) 1 year 10 days 1 year N/A N/A 

 Arista switches (See http://www.arista.com/assets/data/pdf/Warranty.pdf for details) 1 year15 10 days15 1 year15 N/A N/A 

 580x/AF 
Lifetime5 NBD Ship 

As long as 
owned5 

N/A As long as owned4 

 55xx, 513x, 512x, 38xx, 36xx, 35xx/yl, 31xx, 29xx/al, 281x, 26xx, 25xx/G 
Lifetime5 NBD Ship 

As long as 
owned5 

90 days As long as owned4 

Smart Managed       

 195x, 192x, 191x, 18xx, 1620 (Purchased after October 1, 2017) 

Lifetime14 NBD Ship 

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14 

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14 

As long as owned4 

Unmanaged       

 1420, 1410 (Purchased after October 1, 2017) 

Lifetime14 NBD Ship 

90 days 
Phone 

support-Chat 
support entire 

warranty 
period 14 

90 days 
Phone 

support-Chat 
support entire 

warranty 
period 14 

N/A 

 1405 (Purchased after October 1, 2017) 3 years14 NBD Ship 90 days 
Phone 

support-Chat 
support entire 

warranty 
period 14 

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14 

N/A 

W
ir

e
le

s
s
 L

A
N

 

Indoor Access Points      

 Aruba Controller-Managed Access Points (APs) 
Lifetime10 

30 day 
NBD/Return-to-

factory11 
90 days N/A 90 days (bug fix only) 

 3WN/P, 155/P, 108/109 Aruba Remote Access points (RAPs)  
Lifetime10 

30 day 
NBD/Return-to-

factory11 
90 days N/A 

Periodic updated 

image13 

 Aruba Instant Access Points (IAPs) 
Lifetime10 

30 day 
NBD/Return-to-

factory11 
90 days N/A 

Periodic updated 

image13 

 M330, M2xx 
Lifetime5 NBD Ship 

As long as 
owned5 

90 days 
As long as owned4 

 OfficeConnect 20 Access Point 

3 years14 NBD Ship 

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14 

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14 

As long as owned4 

Controllers      

 Aruba controllers 

1 year 
30 day 

NBD/Return-to-
factory11 

90 days12 N/A N/A 

 Aruba Mobility Access Switches Lifetime10 NBD Ship 90 days 90 days As long as owned4 

Other WLAN products       

 Aruba Controller-Managed 2xx Series Outdoor Access Points 
Lifetime10 

30 day 
NBD/Return-to-

factory11 
90 days N/A 90 days (bug fix only) 

 Aruba Instant 2xx Series Outdoor Access Points (IAPs) 
Lifetime10 

30 day 
NBD/Return-to-

factory11 
90 days N/A 

Periodic updated 

image13 

 AirWave Appliances, ClearPass Appliances, IntroSpect Appliances 
1 year 

30 day 
NBD/Return-to-

factory11 
90 days12 

N/A 
90 days (bug fix only) 

 MST2HP, MST2HAC, MSR2KP, MSR4KP Aruba Outdoor Wireless Mesh 
Routers 1 year 

30 day 
NBD/Return-to-

factory11 
90 days12 N/A 90 days (bug fix only) 

 Aruba Beacons 
90 days 

30 day 
NBD/Return-to-

factory11 
90 days N/A 90 days (bug fix only) 

 Cape Sensors 
90 days 

30 day 
NBD/Return-to-

factory11 
90 days N/A 90 days (bug fix only) 

 Aruba Power Supplies, Antennae, Accessories 
1 year 

30 day 
NBD/Return-to-

factory11 
90 days N/A N/A 
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HPE Networking Product Warranty & Support Summary (October 2018) 
 

The most current version of this document is available at www.hpe.com/networking/warrantysummary 
HPE Networking product warranty policy details are available at www.hpe.com/networking/warranty 

Information on services for HPE Networking products can be found at www.hpe.com/networking/services  
 The information contained herein is subject to change without notice.  Warranties for HPE products and services are set forth in the express warranty statements 

accompanying such products and services.   In addition, our goods come with guarantees that cannot be excluded under Australian and New Zealand consumer laws.  
Subject to the foregoing, nothing herein should be construed as constituting an additional warranty.  HPE shall not be liable for technical or editorial errors or omissions 

contained herein. 

 
 

 

 

R
o

u
te

rs
 

Routers      

 88xx, HSR68xx 1 year 10 days 1 year N/A As long as owned4 

 HSR66xx, 66xx, MSR50, MSR4xxx, MSR3xxx, MSR30 1 year 10 days 1 year 90 days As long as owned4 

 MSR2xxx, MSR20, MSR1xxx, MSR9xx 1 year NBD Ship 1 year 90 days As long as owned4 

 ALU 77xx 
1 year9 

Return-to-
factory9 

1 year9 N/A 
All updates for 

purchased license9 

 VSR routers  90 days 
(Media only) 

N/A 90 days N/A 
All updates for 

purchased license8 

M
a

n
a

g
e

m
e
n

t 

Network Management      

 Intelligent Management Center (support details at www.hpe.com/networking/IMCSupport) 90 days 
 (Media only) 

N/A 90 days N/A 90 days (bug fix only) 

 AirWave, ALE, ArubaCentral, ClearPass, Meridian, VIA, Visual RF 90 days 
 (Media only) 

N/A 90 days N/A 90 days (bug fix only) 

 HPE VAN SDN controller and HPE SDN applications 90 days 
 (Media only) 

N/A 90 days N/A All updates for 
purchased license8 

 HPE Distributed Cloud Networking 90 days 
 (Media only) 

N/A N/A N/A None 

 Big Switch Networks controller appliances (See www.bigswitch.com/support for 

warranty & support details) 
N/A16 N/A16 N/A16 N/A16 N/A16 

A
d

d
it

io
n

a
l 

N
e
tw

o
rk

in
g

 

P
ro

d
u

c
ts

 

Transceivers      

 Aruba Transceivers (Transceiver product numbers JWxxxx for Controllers 
and MAS Switches)  
 

1 year  
30 day 

NBD/Return-to-
factory11 

90 days N/A N/A 

 Aruba branded transceivers (except transceiver product numbers JWxxxx) 
  and 
HPE X244, X242, X142, X132, X131, X129, X122, X121, X119, X112, X111 

Lifetime5 NBD Ship As long as 
owned5 

N/A N/A 

 Aruba 100G transceivers 1 year 10 days 1 year N/A N/A 

 HPE X2A0, X240, X190, X180, X170, X160, X150, X140, X135, X130, 
X125, X124, X120, X115, X114, X110 

1 year 30 days 1 year N/A N/A 

 

1) Removable power supplies, modules and accessories such as antennas, fans, power cords, 
etc. may have different warranty coverage than the host device.  See the HPE Networking 
Warranty Coverage Quick Reference at www.hpe.com/networking/warrantyquickref for more 
details.  

2) Response time is based on commercially reasonable effort and subject to a daily shipment 
cutoff time.  In some countries and regions and under certain supplier constraints, response 
time may vary.  Contact your local HPE service organization for response time availability in 
your area.  NBD Ship = Next Business Day shipment. 

3) Warranty phone and electronic case technical support is provided during local HPE business 
hours for the entire warranty period for the purposes of diagnosing hardware or software 
defects.  Many products purchased after December 1, 2015 include 90 days of 24x7 technical 
support as noted.  See product’s Hewlett-Packard Limited Warranty Statement for additional 
coverage details.  Extended coverage services are available. 

4) Includes all generally available software/OS releases offered for the specific products listed, 
when and if available, for as long as the customer owns the product, except where noted.  
Some software releases may require additional or new hardware.  Customers who desire 
specific feature updates, patches and fixes to be prioritized into future releases should 
purchase the appropriate support services from HPE. 

5) For products purchased after December 1, 2014, the warranty extends only for as long as the 
original end user owns the product. Includes coverage of any built-in fans and power supplies 
for the entire warranty period. You may be required to provide proof of purchase or lease as a 
condition of receiving warranty service.   

6) Hardware warranty, technical support and all software releases provided for hardware and the 
ONE Service OS only, when and if available, for as long as the original end user owns the 
product.  See product specific documentation for application support.  5 year warranty on the 
disk drive in the HPE Alliance One Advanced Services zl Modules. 

7) Products purchased before August 1, 2013 include 1 year of technical support and 1 year 
(bug fix only).  

8) Includes all software updates offered for the licensed version, when and if available.  Software 
upgrades will require purchase of appropriate SKU, packaged support services or contract. 

9) All technical, hardware and software support for ALU 77xx products is provided directly by 
Alcatel-Lucent only and not HPE.  For support from Alcatel-Lucent, select the country from 
which the customer is calling in the following link and it will present the appropriate ALU 
support contact information: https://services.support.alcatel-lucent.com/product_support/.  
Hardware warranty requires shipping failed product to ALU for repair or replacement.  
Logistics cost for shipment of product from customer’s site to ALU site for repair or 
replacement will be covered by the customer.  Software maintenance releases are included 
for the major software release purchased.  Major software release upgrades are NOT 
included.  Services may be purchased from HPE or Alcatel-Lucent to extend your support 
coverage and software upgrades.  Support will be provided by Alcatel Lucent for these 
services. 

10) For products purchased after December 1, 2015, the warranty extends only for as long as the 
original end user owns the product and is limited to five (5) years from the end of sale date. 

11) For the first 30 days from shipment, HPE will provide same day ship advanced 
replacement for the covered hardware products.  After thirty (30) days from shipment 
through the remaining warranty period, HPE will replace or repair any non-compliant 
Product and return it in operable condition, shipping after HPE’s receipt of the non-
compliant Product via HPE’s RMA procedure, with receipt by customer within ten 
(10) days on a commercially reasonable basis. 

12) HPE will provide next business day email response for the purposes of diagnosing 
hardware or software defects during standard Pacific Time Zone business hours for 
the first 90 days after purchase.  

13) HPE will make one recent Instant OS software release image available on the 
software portal.  This image is also available for Remote Access Points (RAPs) 
running Instant OS. 

14) These products are covered by 90 days of 24x7 phone support.  Thereafter, only 
chat support would be available for the remaining warranty period.  Limited lifetime 
warranty (where applicable) extends only for as long as the original end user owns 
the product and is limited to five (5) years from the end of sale date.  This warranty 
includes coverage of any built-in fans and power supplies for the entire warranty 
period. You may be required to provide proof of purchase or lease as a condition of 
receiving warranty service. See www.hpe.com/OfficeConnect/support/ for more 
information on the new OfficeConnect support process.  

15) All technical, hardware and software support for Arista products is provided directly 
by Arista and not HPE.   Consult the Arista customer support page for contact 
information: https://www.arista.com/en/support/customer-support.  Transportation 
costs, if any, incurred in connection with the return of a defective Hardware to an 
Arista repair center shall be borne by Customer. Arista shall pay any transportation 
costs incurred with the redelivery of a repaired or replaced Hardware. Services may 
be purchased from HPE or Arista to extend your support coverage and software 
upgrades.  Support will be provided by Arista for these services.  For details on 
Arista warranty and support, see: 
http://www.arista.com/assets/data/pdf/Warranty.pdf. 

16) All technical, hardware and software support for Big Switch Networks products is 
provided directly by BSN and not HPE.  Consult the Big Switch Networks customer 
support page for contact information: www.bigswitch.com/support.  For details on 
Big Switch Networks warranty and support options, see: 
http://bigswitch.com/sites/default/files/bsn_support_and_maintenance_policy.v2.2.20
16.11.14.pdf. 
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Resultado da pesquisa da Central de Serviços de Suporte

Serviços de Suporte HPE - Simplificar, salvar e proteger

Os Serviços de Suporte permitem que você se concentre em sua atividade principal, fornecendo um poderoso portfólio de serviços para proteger seu negócio de TI, preservando os ativos
digitais e as informações confidenciais com consistência global.

Data 10/09/2019

Número do Produto H9WX3E

Nome do Produto Aruba 3 Year Foundation Care 24x7 ClearPass Cx000V VM Appl E-LTU Service

País  BR

Visão geral
O Suporte técnico de Software HPE proporciona serviços gerais e atualizações que lhe ajudam a melhorar o rendimento e a disponibilidade do software HPE e dos importantes
fornecedores.

Benefícios
Contato direto com os engenheiros do Centro de resposta HPE para assistência através de comunicação telefônica ou eletrônica.

Recepção de assistência para solução de problemas e ajuste de parâmetros de configuração.

O completo software HPE e de terceiros e as atualizações da documentação a disposição do gestor do sistema.

Acesso a assistência eletrônica HPE para obter patches de software, uma bse de dados de soluções sintomáticas, descrições do produto, especificações, documentação técnica, etc.

Especificações
Cobertura de garantia In Warranty

Resposta 2 hour SW response

Período de Cobertura 24 horas por dia, 7 dias por semana

ServiceType Foundation Care

Duração 3 anos

Método de serviço SW Support
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Observação: Os níveis de serviço e tempos de resposta para os Serviços de Suporte Hewlett Packard Enterprise podem variar de acordo com sua localização geográfica. O serviço tem
início na data da compra do hardware. Restrições e limitações são aplicáveis. Os serviços HPE são regidos pelos termos e condições de serviço HPE aplicáveis fornecidos ou indicados para
o cliente no momento da compra. O cliente pode ter direitos legais obrigatórios adicionais, de acordo com as leis locais aplicáveis, e tais direitos não são afetados de qualquer forma pelos
termos e condições de serviço HPE ou pela garantia limitada HPE fornecida com o seu produto HPE.Para garantir a precisão dos Serviços de Suporte HPE, retorne à primeira página,
verifique se o país selecionado está correto e insira um número de produto ou número de série de hardware ou software específico para o qual deseja encontrar Serviços de Suporte HPE.

Saiba mais em www.hpe.com/services/ssc

Planos de serviços estendidos permitem estender a cobertura de serviços além do período de garantia básica e estão disponíveis em incrementos de um ano para durações de um a cinco
anos.

Consulte a Folha de dados e os termos e condições dos Serviços de Suporte Hewlett Packard Enterprise para obter os detalhes completos.
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Resultado da pesquisa da Central de Serviços de Suporte

Serviços de Suporte HPE - Simplificar, salvar e proteger

Os Serviços de Suporte permitem que você se concentre em sua atividade principal, fornecendo um poderoso portfólio de serviços para proteger seu negócio de TI, preservando os ativos
digitais e as informações confidenciais com consistência global.

Data 10/09/2019

Número do Produto H9XH3E

Nome do Produto Aruba 3 Year Foundation Care 24x7 ClearPass NL AC 1K CE E-LTU Service

País  BR

Visão geral
O Suporte técnico de Software HPE proporciona serviços gerais e atualizações que lhe ajudam a melhorar o rendimento e a disponibilidade do software HPE e dos importantes
fornecedores.

Benefícios
Contato direto com os engenheiros do Centro de resposta HPE para assistência através de comunicação telefônica ou eletrônica.

Recepção de assistência para solução de problemas e ajuste de parâmetros de configuração.

O completo software HPE e de terceiros e as atualizações da documentação a disposição do gestor do sistema.

Acesso a assistência eletrônica HPE para obter patches de software, uma bse de dados de soluções sintomáticas, descrições do produto, especificações, documentação técnica, etc.

Especificações
Cobertura de garantia In Warranty

Resposta 2 hour SW response

Período de Cobertura 24 horas por dia, 7 dias por semana

ServiceType Foundation Care

Duração 3 anos

Método de serviço SW Support
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Observação: Os níveis de serviço e tempos de resposta para os Serviços de Suporte Hewlett Packard Enterprise podem variar de acordo com sua localização geográfica. O serviço tem
início na data da compra do hardware. Restrições e limitações são aplicáveis. Os serviços HPE são regidos pelos termos e condições de serviço HPE aplicáveis fornecidos ou indicados para
o cliente no momento da compra. O cliente pode ter direitos legais obrigatórios adicionais, de acordo com as leis locais aplicáveis, e tais direitos não são afetados de qualquer forma pelos
termos e condições de serviço HPE ou pela garantia limitada HPE fornecida com o seu produto HPE.Para garantir a precisão dos Serviços de Suporte HPE, retorne à primeira página,
verifique se o país selecionado está correto e insira um número de produto ou número de série de hardware ou software específico para o qual deseja encontrar Serviços de Suporte HPE.

Saiba mais em www.hpe.com/services/ssc

Planos de serviços estendidos permitem estender a cobertura de serviços além do período de garantia básica e estão disponíveis em incrementos de um ano para durações de um a cinco
anos.

Consulte a Folha de dados e os termos e condições dos Serviços de Suporte Hewlett Packard Enterprise para obter os detalhes completos.

A
nexo 17 IT

E
M

 01 (0592529)         S
E

I 0008478-63.2018.6.02.8000 / pg. 3589



Anexo 18 ITEM 01 (0592530)         SEI 0008478-63.2018.6.02.8000 / pg. 3590



Anexo 18 ITEM 01 (0592530)         SEI 0008478-63.2018.6.02.8000 / pg. 3591



Worldwide support numbers for these product 
families:*

 – Aruba products
 – HPE Nimble Storage products

Support matrix

Technical Support Phone Numbers
Country Support type Support phone number Hours of operations

Aland Contract +358 20 320 300 24x7

Warranty and Out of Warranty +358 20 353 232 M–F 8:00–17:00

Albania Contract & Warranty/Out of Warranty +355 42 322 411 24x7

Algeria Contract & Warranty/Out of Warranty +216 23 92 5000 24x7

Andorra Contract +34 902 220 030 24x7

Warranty and Out of Warranty +34 902 010 333 M–F 8:30–17:30

Angola Contract & Warranty/Out of Warranty +234 1 27 14 777
+44 203 564 4148

24x7

Anguilla Contract & Warranty 1-800-225-5288 then 
844 692-8150

24x7

Antigua and Barbuda Contract & Warranty #1 then 844 692-8151 24x7

Argentina Contratos 0 800 444 7867
+52 55 5258 4500

24x7

Garantías 0 800 333 4857
+52 55 1500 3155

M–F 8:00–17:00

Armenia Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Aruba Contract & Warranty +1 844 264 1328 24x7

Australia Contract & Warranty/Out of Warranty 13 11 47
+61 2 8031 8315

24x7

Azerbaijan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

* For all other product types, please call the support number for your country listed in this document.
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Support matrix Page 2

Country Support type Support phone number Hours of operations

Bahamas Contract & Warranty 1-800-872-2881 then 
844 692-8152

24x7

Bahrain Contract & Warranty/Out of Warranty +973 1 619 82 94 24x7

Barbados Contract & Warranty 1-800-225-5288 then 
844 692-8153

24x7

Belarus Contract & Warranty/Out of Warranty 8 8200 073 01 01
+7 495 411 69 07

24x7

Belgium Contract 078 250 144
+32 26 200 055

24x7

Warranty and Out of Warranty 078 600 600
+32 26 200 099

M–F 8:00–17:00

Belize Contract & Warranty 811 then 844 692-8148 24x7

Benin Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Bermuda Contract & Warranty 1-800-225-5288 then 
844 692-8154

24x7

Bolivia Contratos 800 110 348
+52 55 5258 4500

24x7

Garantías 800 110 348
+52 55 1500 3155

M–F 8:00–17:00

Bonaire (Sint Eustatius, Saba) Contract & Warranty 001-800-872-2881 then 
844 752-2839

24x7

Bosnia and Herzegovina Contract & Warranty/Out of Warranty +387 338 219 22 24x7

Botswana Contract & Warranty/Out of Warranty +234 1 27 14 777
+44 203 564 4148

24x7

Bouvet Island Contract & Warranty/Out of Warranty 800 56 044 24x7

Brasil Contract 0800 55 6405
+55 11 3173 8802 
+55 11 4688 5102

24x7

Warranty 0800 710 2029
+55 11 2377 1002 
+55 11 2377 0002

M–F 8:00–17:00
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Support matrix Page 3

Country Support type Support phone number Hours of operations

British Indian Ocean Territory Contract & Warranty/Out of Warranty +234 1 27 14 777
+44 203 564 4148

24x7

British Virgin Islands Contract & Warranty 1-800-872-2881 then 
844 692-8156

24x7

Bulgaria Contract & Warranty/Out of Warranty 0700-1-47-47 24x7

Burkina Faso Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Burundi Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Cameroon Contract & Warranty/Out of Warranty +234 1 27 14 777
+44 203 564 4148

24x7

Canada Contract
Contrat

1-800-633-3600 24x7

Warranty and Out of Warranty
Produits garantis et hors garantie

1-844-806-3425 24x7 for most products

Cape Verde Contract & Warranty/Out of Warranty +234 1 27 14 777
+44 203 564 4148

24x7

Cayman Islands Contract & Warranty 1-800-225-5288 then 
844 692-8157

24x7

Central African Republic Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Chad Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Chile Contratos 800 362 365
+52 55 5258 4500

24x7

Garantías 800 123 605
+52 55 1500 3155

M–F 8:00–17:00

Collectivity of Saint Martin Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Colombia Contratos 01 800 051 4747
+57 1 6004150

24x7

Garantías 800 051 7127
+52 55 1500 3155

M–F 9:00–18:00

Comoros Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7
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Support matrix Page 4

Country Support type Support phone number Hours of operations

Costa Rica Contratos 800 794 4401
+52 55 5258 4500

24x7

Garantías 800 794 4401
+52 55 1500 3155

M–F 8:00–17:00

Croatia Contract & Warranty/Out of Warranty 0800 303 556 24x7

Curaçao Contract & Warranty 001-800-872-2881 then 
844 264-1326

24x7

Cyprus Contract & Warranty/Out of Warranty 801 11 47 22 73
+30 211 181 3846

24x7

Czech Republic Contract & Warranty/Out of Warranty 239 018 791 24x7

Denmark Contract +45 70 10 80 25 24x7

Warranty and Out of Warranty +45 70 11 77 00 M–F 8:00–17:00

Deutschland Dienstleistungsverträge/Contracts +49 69 380 789 143 24x7

Produkte innerhalb und außerhalb der Herstellergarantie +49 69 380 789 142 Montag–Freitag
8:00–17:00
(außer an bundeseinheitlichen Feiertagen)

Djibouti Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Dominica Contract & Warranty 1-800-225-5288 then 
844 264-1327

24x7

Dominican Republic Contract & Warranty 1-888-225-5288 then 
844 264-1328
+52 55 5258 4500

24x7

Ecuador Contratos 1-800-225-528 then 
844 845-8165
+52 55 5258 4500

24x7

Garantías 1-800-225-528 then 
844 845-8165
+52 55 1500 3155 

M–F 8:00–17:00

Egypt Contract & Warranty/Out of Warranty 0800 000 0814
+20 2 353 131 62

24x7
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Support matrix Page 5

Country Support type Support phone number Hours of operations

El Salvador Contratos 800-1785 then 
844 845-8167
+52 55 5258 4500

24x7

Garantías 800-1785 then 
844 845-8167
+52 55 1500 3155 

M–F 8:00–17:00

Equatorial Guinea Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Eritrea Contract & Warranty/Out of Warranty +234 1 27 14 777
+44 203 564 4148

24x7

España Contrato de Mantenimiento +34 902 220 030
+34 913496569

24x7

Garantía y fuera de garantía +34 902 010 333
+34 913496559

Lunes a viernes, 8:30 a 17:30 de julio y agosto,  
8:30 a 14:30

Estonia Contract & Warranty/Out of Warranty +372 686 88 71 24x7

Ethiopia Contract & Warranty/Out of Warranty +234 1 27 14 777
+44 203 564 4148

24x7

Falkland Islands Contract & Warranty/Out of Warranty +44 845 161 0050 24x7

Faroe Islands Contract +45 70 10 80 25 24x7

Warranty and Out of Warranty +45 70 11 77 00 M–F 8:00–17:00

Finland Contract +358 20 320 300 24x7

Warranty and Out of Warranty +358 20 353 232 M–F 8:00–17:00

France Contrat 0825 00 41 23
+33 173018471

24x7
Ligne payante au tarif local en France

Garantie et Hors Garantie 0826 10 49 49
+33 173018475

Lundi–Vendredi 
8:30–18:00
(à l’exception des jours fériés et jours de fermeture d’HPE)

French Guiana Contract & Warranty 0800 99 00 11 then 
844 264-1329

24x7

French Polynesia Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

French Southern Territories Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Gabon Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7
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Support matrix Page 6

Country Support type Support phone number Hours of operations

Gambia Contract & Warranty/Out of Warranty +234 1 27 14 777
+44 203 564 4148

24x7

Georgia Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Ghana Contract & Warranty/Out of Warranty +234 1 27 14 777
+44 203 564 4148

24x7

Gibraltar Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

Greece Contract & Warranty/Out of Warranty 801 11 47 22 73
+30 211 181 3846

24x7

Greenland Contract +45 70 10 80 25 24x7

Warranty and Out of Warranty +45 70 11 77 00 M–F 8:00–17:00

Grenada Contract & Warranty 1-800-225-5288 then 
844 264-1330

24x7

Guadeloupe Contract & Warranty 0-800-99-0011 then 
844 264-1331

24x7

Guatemala Contratos 999-9190 then 
844 845-8169
+52 55 5258 4500

24x7

Garantías 999-9190 then 
844 845-8169
+52 55 1500 3155

M–F 8:00–17:00

Guernsey Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

Guinea Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Guinea-Bissau Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Guyana Contract & Warranty 159 then 844 752-2835 24x7

Haiti Contract & Warranty +1 844 264 1328 24x7
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Support matrix Page 7

Country Support type Support phone number Hours of operations

Honduras Contratos 800-0-123 then 
844 752-2837
+52 55 5258 4500

24x7

Garantías 800-0-123 then 
844 752-2837
+52 55 1500 3155 

M–F 8:00–17:00

Hong Kong Contract +852 2292 3333 24x7
Alpha, ProLiant, and attached HPE Storage Systems

Warranty +852 3071 3873 M–F 8:30–17:30
HPE Networking, UNIX® system, NetServer, and attached 
HPE Storage systems 

Warranty +852 2904 8338 24x7
ProLiant & attached 
HPE Storage Systems 
Value line (need PIN code during AOH)

Hungary Contract 1 778 9670 24x7

Warranty and Out of Warranty 1 778 9669 M–F 9:00–17:00

Iceland Contract +47 800 56 044 24x7

Warranty and Out of Warranty +47 800 62 800 M–F 8:00–17:00

India Warranty 1800 419 8080 (Callers in India)
+91 806 703 7209 (International Callers)

M–F 9:00–18:00

Indonesia Contract & Warranty 0018 0385 20668
+62 21 5799 4050

24x7

Iran Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Iraq Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Ireland Contract 1850 924 590
+ 353 1 4118915

24x7

Warranty and Out of Warranty 1890 946 500
+ 353 1 4118912

M–F 8:00–18:00
(except Bank Holidays)

Isle of Man Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00
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Support matrix Page 8

Country Support type Support phone number Hours of operations

Israel Contract & Warranty/Out of Warranty 1-809-400-300
+972 3-3726489

24x7

Italia Contratti 02 452 790 50 24x7

In garanzia o fuori garanzia 02 385 912 12 Lunedì–Venerdì 8:00–17:00

Ivory Coast Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Jamaica Contract & Warranty 1-800-872-2881 then 
844 264-1332

24x7

日本 Warranty support.hpe.com/hpsc/doc/public/display?docId=emr_
na-c04770344

Jersey Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

Jordan Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Kazakhstan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Kenya Contract & Warranty/Out of Warranty +234 1 27 14 777
+44 203 564 4148

24x7

Kosovo Contract & Warranty/Out of Warranty 0800 300 003/0800 190 038 (Serbia)
035 542 322 411 (Albania)

24x7

Kuwait Contract & Warranty/Out of Warranty 632 9930 24x7

Kyrgyzstan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Latvia Contract & Warranty/Out of Warranty 678 521 84 24x7

Lebanon Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Lesotho Contract & Warranty/Out of Warranty +234 1 27 14 777
+44 203 564 4148

24x7

Liberia Contract & Warranty/Out of Warranty +234 1 27 14 777
+44 203 564 4148

24x7

Libya Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Liechtenstein Contract +41 0848 800 724 24x7

Warranty and Out of Warranty +41 0848 80 20 20 M–F 8:00–18:00

Lithuania Contract & Warranty/Out of Warranty +370 521 415 92 24x7
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Support matrix Page 9

Country Support type Support phone number Hours of operations

Luxembourg Contract +352 27 303 111 24x7

Warranty and Out of Warranty +352 27 303 303 M–F 8:00–17:00

Macedonia Contract & Warranty/Out of Warranty 0800 90 472 24x7

Madagascar Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Malawi Contract & Warranty/Out of Warranty +234 1 27 14 777
+44 203 564 4148

24x7

Malaysia Contract & Warranty 1800 88 1811 (Callers in Malaysia)
+60 3 6207 4533 (International Callers)

24x7

Mali Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Malta Contract & Warranty/Out of Warranty +356 27 781 269 24x7

Martinique Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Mauritania Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Mauritius Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Mayotte Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

México Contratos 800 501 9800
+52 55 5258 4500

24x7

Garantías 800 890 6348
+52 55 1500 3155

M–F 8:00–17:00

Moldova Contract & Warranty/Out of Warranty +7 499 272 37 82 24x7

Monaco Contrat +33 1 73 01 84 71 24x7
Ligne payante au tarif local en France

Garantie et Hors Garantie +33 1 73 01 84 75 Lundi–Vendredi 
8:30–18:00
(à l’exception des jours fériés et jours de fermeture d’HPE)

Montenegro Contract & Warranty/Out of Warranty 0800 300 003 24x7

Montserrat Contract & Warranty 1-800-225-5288 then 
844 264-1333

24x7

Morocco Contract & Warranty/Out of Warranty 00 212 5 22 24 87 70
+44 1793 794886

24x7
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Country Support type Support phone number Hours of operations

Mozambique Contract & Warranty/Out of Warranty +234 1 27 14 777
+44 203 564 4148

24x7

Namibia Contract & Warranty/Out of Warranty +234 1 27 14 777
+44 203 564 4148

24x7

Netherlands Contract 0900 115 0000
+31 205 040 666

24x7

Warranty and Out of Warranty 0900 117 0000 M–F 8:00–17:00

New Caledonia Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

New Zealand Contract & Warranty/Out of Warranty 0800 664 747
+61 2 8031 8316

24x7

Nicaragua Contratos 1-800-0164 then 
844 752-2840
+52 55 5258 4500

24x7

Garantías 1-800-0164 then 
844 752-2840
+52 55 1500 3155

M–F 8:00–17:00

Niger Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Nigeria Contract & Warranty/Out of Warranty 01 27 14 777
+44 203 564 4148

24x7

Norway Contract 800 56 044 24x7

Warranty and Out of Warranty 800 62 800 M–F 8:00–17:00

Oman Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Österreich Dienstleistungsverträge/Contracts 08 1000 2000 24x7

Produkte innerhalb und ausserhalb der
Herstellergarantie

08 1000 1000 M–F 8:00–18:00

Palestinian Territory Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Panama Contratos 800-2288 then 
844 845-8163
+52 55 5258 4500

24x7

Garantías 800-2288 then 
844 845-8163
+52 55 1500 3155 

M–F 8:00–17:00
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Paraguay Contratos 008-11-800 then 
844 752-2842
+52 55 5258 4500

24x7

Garantías 008-11-800 then 
844 752-2842
+52 55 1500 3155 

M–F 8:00–17:00

Perú Contratos 0 800 1 9703
+52 55 5258 4500

24x7

Garantías 0800 44 366
+52 55 1500 3155 

M–F 8:00–17:00

Philippines Contract & Warranty 1800 1441 0669
 1800 8908 6404
+63 2395 3565

24x7

Poland Contract & Warranty/Out of Warranty 0 800 702 284
(22) 306 04 84

24x7

Portugal Contract 808 203 203 24x7

Warranty and Out of Warranty 213 164 164 M–F 9:00–18:00

Puerto Rico Contratos 844 752-2843
+52 55 5258 4500

24x7

Garantías 844 752-2843
+52 55 1500 3155 

M–F 8:00–17:00

Qatar Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Republic of Congo Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Réunion Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Romania Contract & Warranty/Out of Warranty +40 317 305 020 24x7

Россия Поддержка 8 800 500 92 55
+7 495 411 69 07

24x7

Rwanda Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Saint Barthélemy Contract 0-800-990-011 then 
844 845-8168

24x7

Warranty and Out of Warranty +212 5 22 24 87 70 24x7
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Saint Helena (Ascension and Tristan da Cunha) Contract & Warranty/Out of Warranty +234 1 27 14 777
+44 203 564 4148

24x7

Saint Kitts and Nevis Contract & Warranty 1-800-225-5288 then 
844 264-1334

24x7

Saint Lucia Contract & Warranty/Out of Warranty 1 844 231 8954 24x7

Saint Pierre and Miquelon Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Saint Vincent and the Grenadines Contract & Warranty 1-800-225-5288 then 
844 845-8160

24x7

San Marino Contract 02 452 790 50 24x7

Warranty and Out of Warranty 02 385 912 12 M–F 8:00–17:00

Sao Tome and Principe Contract & Warranty/Out of Warranty +234 1 27 14 777
+44 203 564 4148

24x7

Saudi Arabia Contract & Warranty/Out of Warranty 800 844 4611 24x7

Schweiz
Suisse

Dienstleistungsvertrag/
Contrat de services

0848 800 724
+41 43 557 9021

24x7
8Rp./Min*

Herstellergarantie/
Produits garantis

0848 80 20 20
+41 44 200 4115

Montag–Freitag
Lundi–Vendredi
8:00–17:00
(außer Feiertage) 
8Rp./Min*
*aus dem schweizerischen Festnetz; abweichende Preise aus 
Mobilfunknetzen sind je nach Anbieter möglich.

Senegal Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Serbia Contract & Warranty/Out of Warranty 0800 300 003
0800 190 038 

24x7

Seychelles Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Sierra Leone Contract & Warranty/Out of Warranty +234 1 27 14 777
+44 203 564 4148

24x7

Singapore Contract & Warranty 1800 272 4333 (Callers in Singapore)
+65 6272 4333 (International Callers)

24x7

Sint Maarten Contract & Warranty 800-99-0011 then 
844 264-1335

24x7
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Slovakia Contract & Warranty/Out of Warranty 02 686 221 79 24x7

Slovenia Contract & Warranty/Out of Warranty 0800 80 745 24x7

Somalia Contract & Warranty/Out of Warranty +234 1 27 14 777
+44 203 564 4148

24x7

South Africa Contract 0860 001 020 24x7

Warranty and Out of Warranty 0860 001 030 M–F 8:00–17:00
(except public Holidays)

South Georgia and the South Sandwich Islands Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

대한민국 Contract & Warranty +82 1577 3270 M–F 09:00–18:00
Server & Storage

Contract & Warranty +82 1588 0142 M–F 09:00–18:00
Networking

South Sudan Contract & Warranty/Out of Warranty +234 1 27 14 777
+44 203 564 4148

24x7

Sudan Contract & Warranty/Out of Warranty +234 1 27 14 777
+44 203 564 4148

24x7

Suriname Contract & Warranty/Out of Warranty 156 then 844 231-8955 24x7

Svalbard and Jan Mayen Contract +47 800 56 044 24x7

Warranty and Out of Warranty +47 800 62 800 M–F 8:00–17:00

Swaziland Contract & Warranty/Out of Warranty +234 1 27 14 777
+44 203 564 4148

24x7

Sweden Contract 0771 30 30 50 24x7

Warranty and Out of Warranty 0771 30 30 00 M–F 8:00–17:00

Syria Contract & Warranty/Out of Warranty +234 1 27 14 777
+44 203 564 4148

24x7

Taiwan Contract & Warranty 0800 211 666
+886 2 2656 7204

M–F 8:30–17:30

Tajikistan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7
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Tanzania Contract & Warranty/Out of Warranty +234 1 27 14 777
+44 203 564 4148

24x7

Thailand Contract 1800 441 4048
+66 2 118 6000

24x7

Warranty 1800 441 4085
+66 2 118 6300

M–F 8:30–17:30

The Democratic Republic of Congo Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Togo Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Trinidad and Tobago Contract & Warranty/Out of Warranty 1-800-872-2881 then 
844 845-8161

24x7

Tunisia Contract & Warranty/Out of Warranty +216 23 92 5000 24x7

Turkey Contract 850 759 0 724
+90 850 759 0 724

24x7

Warranty and Out of Warranty 850 759 0 473
+90 850 759 0 473

08:30–17:30 GMT+3

Turkmenistan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Turks and Caicos Islands Contract & Warranty 1-800-225-5288 then 
844 845-8162

24x7

Uganda Contract & Warranty/Out of Warranty +234 1 27 14 777
+44 203 564 4148

24x7

Ukraine Contract & Warranty/Out of Warranty 0 800 501 526 24x7

United Arab Emirates Contract & Warranty/Out of Warranty 800 0444 1477 24x7

United Kingdom Contract 0845 161 0050 24x7

Warranty and Out of Warranty 0845 161 0030 M–F 8:00–18:00

United States Contract 1-800-633-3600 24x7

Warranty and Out of Warranty 1-844-806-3425 24x7

Uruguay Contratos 0004 110 032 632
+52 55 5258 4500

24x7

Garantías 0004 110 032 632
+52 55 1500 3155 

M–F 8:00–17:00
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Country Support type Support phone number Hours of operations

US Virgin Islands Contract & Warranty +1 844 845-8164 24x7

Uzbekistan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Vatican City Contract 02 45279050 24x7

Warranty and Out of Warranty 02 38591212 M–F 8:00–17:00

Venezuela Contratos & Garantías +58 212 7102103 24x7

Vietnam Contract & Warranty +84 28 4458 2390 24x7

Wallis and Futuna Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Western Sahara Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Yemen Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Zambia Contract & Warranty/Out of Warranty +234 1 27 14 777
+44 203 564 4148

24x7

Zimbabwe Contract & Warranty/Out of Warranty +234 1 27 14 777
+44 203 564 4148

24x7

Anexo 19 ITEM 01 (0592531)         SEI 0008478-63.2018.6.02.8000 / pg. 3606

http://www.hpe.com/info/getupdated
https://www.hpe.com/global/hpechat/index.html?jumpid=Collaterals_a00039121ENW


HPE Intelligent Management Center Standard Software Platform
 

 

Models
HPE IMC Standard Software Platform with 50-node E-LTU JG747AAE

Aruba IMC Standard Software Platform with 50-node E-LTU JH704AAE

 

Key features
Highly flexible and scalable deployment options
Powerful administration control
Rich resource management
Detailed performance monitoring and management, flexible centralized reporting
Fault, Configuration, Accounting, Performance and Security (FCAPS) capabilities
Integration with Aruba AirWave ,ClearPass and HPE OneView
Cisco Nexus support
VxLAN support and API Enhancements

 

Product overview
The HPE Intelligent Management Center (IMC) Standard Software Platform is a comprehensive
management platform that was built from the ground up to support the Fault, Configuration, Accounting,
Performance, Security (FCAPS) model. It provides features and functions that are designed for
comprehensive management of the network infrastructure. IMC was designed to provide the following
functions:

Supports the ITIL operational center of excellence IT practices model
Uses a single-pane management paradigm to enable end-to-end business management of IT services
Provides scalability by supporting distributed and hierarchical system architectures, through additional
operating system and database support.
Uses an SOA model to provide full resource, service, and user management.
Enables the integration of traditionally separate management tools using a modular design.
Enables enterprises to expand their infrastructure management in scale and to seamlessly
accommodate new technologies at the same time.

IMC software supports the management of Hewlett Packard Enterprise and third-party devices, and is
compatible with Microsoft® Windows® and Linux operating systems. IMC Standard software comes with an
initial license for 50 managed devices. Additional node licenses are available to extend the node limit.

 

Features and Benefits
Management

Integration with Aruba AirWave, ClearPass, and HPE OneView

allows administrators from IMC to use AirWave for "user centric" wired management and wireless
management while IMC provides edge to core infrastructure management, monitoring, and
troubleshooting. Integration with ClearPass ensures IMC has the user context, allowing the
administrator to easily associate an IP address to the logged on user. OneView integration automates
the provisioning of ToR switches when VLANs are added.
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Role-based administrative controls

provides administrators with both the tools and the ability to grant access to only those features and
resources operators need. IMC also provides controls and audit trails to support IT management best
practices. IN IMC, management rights and access to all resources are granted through operator and
device groups or custom views of the devices. Operator groups grant and restrict access to specific
parts of IMC.
Resource management

provides comprehensive element management for multi-vendor devices via single Web portal.
Administrators can access resources for managing and monitoring a device, add devices to the
network, and view devices in a network topology, IP, or custom view. Administrators can see device
health through the device details page, revealing real-time data, summary information, connectivity
testing, and more; supports End-of-Life Notifications available as well
Virtualization management

− HPE IMC Software integrates management and the capability to integrate, discover, map,

manage and monitor virtualized environments, helping to identify VM sprawl.

− Provides insight and management of virtual networks, and reduces migration complexity by

aligning as well as automating network policies with virtual images.

− Supports VMware®, Hyper-V, and KVM; IMC Virtual Network Management Software; and

automatic tracking of the network access port of virtual machines

Flexible, centralized reporting

offers administrator performance, operator performance, and resource reporting options for network
assets, configuration and configuration changes, network device and link status, alarms, and network
device health. Report types offered are in real-time and quick-custom. Device data is offered for
status, label, IP address, MAC address, device type, model, vendor, location, and many more.
Global ACL management

provides operators with a comprehensive feature set for managing ACLs including viewing and
configuring ACLs on devices managed by IMC, and importing ACLs. The ACL Manager supports
basic, advanced, link, and user-defined ACLs. The ACL Assistant facilitates ACL template rule
creation and easier management. The ACL Resource List provides a portal for viewing and managing
ACLs with a Rule Set List. The ACL Deployment Wizard assists in the deployment of ACLs.
Configuration and change management

combines the tasks of network device change and configuration management to effectively manage
devices and audit changes Like the IMC Resource Management feature, the Configuration Center has
a portal for accessing most of IMC change and configuration management features. Operators can
view and deploy software to devices, access configuration templates, utilize a system software library,
clean the device for new deployments, and back the system up.
Compliance center

supports organization adherence to compliance policies and standards. This feature enables
operators to create compliance policies and rules that check the configuration of devices.
Network asset management

tracks assets as well as changes to assets. This feature provides operators with a list of asset and
drilldown capabilities into individual device details or device audit details. Operators can also query
IMC for specific audit records and manage the device auditing process.
Real time fault management

integrates network management system of fault, performance, auditing, security, and configuration
reduces the effort required to manage complex network infrastructures, allowing network managers to
have one database of network devices in IMC that drives various tasks of network management. The
database integrates with all IMC functions. The alarm or event management system in IMC uses the
existing device database and generates alarms in events of interest.
Global VLAN management

gives administrators the ability to create standardized VLANs across all devices in the infrastructure
that support VLANs. They can create VLANs, then add, configure, or remove them from all devices
that support this feature. VLANs can be deployed in batch or individually for devices configuring
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VLANs. Administrators can also see VLANs on a topology view.
Customized functions and third-party device support

extends device management and configuration functions; users can either extend an existing function
to support third-party devices by compiling interactive scripts and XML files, or customize a function by
compiling interactive scripts, XML files, and UI configuration files.
Performance monitoring and management

provides the ability to monitor the performance of devices managed by IMC. The Performance
Management features provide the ability to customize the collection, alarming, and presentation of
performance data. IMC enables real-time and historical performance management for managed
devices like routers and switches on data like IPSec VPNs, WSM, and QoS. Also customizable are
threshold settings, performance views and data, and global monitors; real-time viewing.
Security Control Center

defines policies and enforces device settings consistently on selected devices; you can also use
policies to manage VLANs and VLAN port settings or automatically apply a configuration template on
newly discovered devices. Configure policies to send alarms when device configurations become
noncompliant.
Network data collection

generates, packages, and sends archived information about your network, device, or IMC Software to
the appropriate Hewlett Packard Enterprise support or sales organizations in one simple step; this
feature gathers the data you selected and generates reports and data files containing the relevant
information; it delivers the reports to your selected destination by email, FTP, SFTP, or to a file
location.
Intuitive user interface

desktop UI provides up to eight customizable icon-based screen interfaces that can be organized
along specific tasks. Includes many features enabling administrators and operators to manage the
network infrastructure. IMC also provides operators with many paths to the same destination.
Operators are provided with quick start guides. With the My Favorites feature, operators can create
links to the IMC features they use most often.
eAPI library and third-party applications

the IMC eAPI library utilizes a RESTful implementation for simplified integration with HPE and third-
party applications; eAPI calls are available in the library, which is included with IMC Standard
software.
Highly flexible and scalable deployment models

helps deliver an extensive set of capabilities for managing large heterogeneous networks, and
provides scalability and high availability through a flexible distributed deployment model. With its
modular design, IMC software can be deployed across multiple servers to provide increased scalability
and resilience.
Rich Resource management

provides network discovery and topology, including detailed inventory of the network and accurate
depictions of how it is configured. Supported views include Layer 2 and 3 as well as VLAN topology
and the ability to create custom views like a dashboard homepage. Customization enables
administrators to organize and control the network infrastructure. Supports multidevice context,
Intelligent Resilient Fabric, and End-of-Life Notifications via device discovery
Telnet/SSH proxy

with the Telnet/SSH proxy, an administrator can use a browser to remotely access and manage
devices through Telnet/SSH without installing a Telnet/SSH tool on the PC client used to access the
device. This promotes secure and controlled access to devices while providing auditing of changes on
any device; supports SSH v1/v2
Service Monitor

monitors the availability and responsiveness of common network services via probes that you
configure; the probes reside on local and remote IMC software agents and test services from servers
and devices that you select when configuring the probes; monitor these protocols: DNS, FTP, HTTP,
TCP, UDP, VoIP (using NTA module), SMTP, DHCP, ICMP, Radius, TACACS+
High availability (Optional add-on license)

Provides high availability (HA) for the IMC system by offering one or multiple standby IMC servers for

QuickSpecs
HPE Intelligent Management Center Standard Software

Platform

Overview

DA - 13834   Worldwide QuickSpecs — Version 13 — 2/6/2017 Page  3

Anexo I A IV - ITEM 02 (0592537)         SEI 0008478-63.2018.6.02.8000 / pg. 3609



redundancy. IMC HA can be implemented using a deployment with a remote database or shared
storage.

Warranty and support

Electronic and telephone support

Limited electronic and business-hours telephone support is available from Hewlett Packard Enterprise;
to reach our support centers, refer to http://www.hpe.com/networking/contact-support; for details

on the duration of support provided with your product purchase, refer to
http://www.hpe.com/networking/warrantysummary

Software releases

to find software for your product, refer to http://www.hpe.com/networking/support; for details on the

software releases available with your product purchase, refer to
http://www.hpe.com/networking/warrantysummary
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HPE IMC Standard Software Platform with 50-node E-LTU (JG747AAE)

Aruba IMC Standard Software Platform with 50-node E-LTU (JH704AAE)

Minimum system

hardware

Server:
Intel® Pentium® 4 3.0 GHz
4 GB RAM memory
50 GB storage
10/100 Mbps NIC
Video card supporting 1024 x 768 resolution and sound card
 
Client:
Intel® Pentium® 4 2.0 GHz
2 GB RAM memory
50 GB storage
10/100 Mbps NIC
Video card supporting 1024 x 768 resolution and sound card

System requirements,

recommended

Server:
3.0 GHz Intel® Xeon® or Intel® Core™ 2 Duo processor or equivalent
4 GB RAM memory
100 GB storage
10/100 Mbps NIC
Video card supporting 1024 x 768 resolution and sound card

Software (required) Server:
Operating system: Red Hat Enterprise Linux 5.5 (Enterprise and Standard versions
only)
Red Hat Enterprise Linux 5.5 X64 (Enterprise and Standard versions only)
Red Hat Enterprise Linux 5.9 (Enterprise and Standard versions only)
Red Hat Enterprise Linux 5.9 X64 (Enterprise and Standard versions only)
Red Hat Enterprise Linux 6.x X64 (Enterprise and Standard versions only)
Windows Server 2008 R2 with Service Pack 1
Windows Server 2008 R2 X64 with Service Pack 1
Windows Server 2008 with Service Pack 2
Windows Server 2008 X64 with Service Pack 2
Windows Server 2012 R2 X64
Windows Server 2012 X64 with KB2836988
 
Database:
Microsoft SQL Server 2008 Service Pack 3 (Windows only)
Microsoft SQL Server 2008 R2 Service Pack 2 (Windows only)
Microsoft SQL Server 2012 Service Pack 2 (Windows only)
Microsoft SQL Server 2014 (Windows only)
Oracle 11g Release 1 (Linux only)
Oracle 11g Release 2 (Linux only)
MySQL Enterprise Server 5.5 (Linux and Windows) (Up to 1000 devices are
supported)
MySQL Enterprise Server 5.6 (Linux and Windows) (Up to 1000 devices are
supported)

Recommended

software

Client:
Windows XP SP3 or later

Browser supported IE 10 or 11
Firefox 30 or later
Chrome 35 or later
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Hypervisor VMware Workstation 6.5.x
VMware Workstation 9.0.x
VMware ESX Server 4.x
VMware ESX Server 5.x
Windows Server 2008 R2 Hyper-V
Windows Server 2012 Hyper-V

Notes Operating systems marked X64 are recommended. Client: JRE 1.6.0_update 27 or
later is recommended.
For fewer than 500 nodes, 1 CPU is sufficient; From 500 to 2,000 nodes, there
should be 2 CPUs or 1 dual-core CPU; For more than 2,000 nodes, there should
be 4 CPUs or 2 dual-core CPUs.

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the service-level

descriptions and product numbers. For details about services and response times
in your area, please contact your local Hewlett Packard Enterprise sales office.
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HPE Intelligent Management Center Standard Software Platform accessories
License

HPE IMC Standard and Enterprise Additional 50-node E-LTU JG749AAE

Aruba IMC Standard and Enterprise Additional 50-node E-LTU JH714AAE

HPE PCM+ to IMC Standard Software Platform Upgrade with 200-node E-LTU JG768AAE

HPE Intelligent Management Center High Availability Software E-LTU JG771AAE

Aruba IMC High Availability Software E-LTU JH711AAE

Software

HPE IMC Wireless Service Manager Software Module 50 Access Point E-LTU JF414AAE

HPE IMC User Access Manager Software Module with 50-user E-LTU JG752AAE

HPE IMC Endpoint Admission Defense Software Module with 50-user E-LTU JG754AAE

HPE IMC TACACS+ Authentication Manager Software Module with 50-node E-LTU JG764AAE

HPE IMC Network Traffic Analyzer Software Module with 5-node E-LTU JG750AAE

Aruba IMC Network Traffic Analyzer Software Module with 5-node E-LTU JH706AAE

HPE Intelligent Management Center QoS Manager E-LTU JF408AAE

HPE IMC MPLS VPN Software Module with 50-node E-LTU JF410AAE

HPE IMC Intelligent Analysis Reporter Software E-LTU JG138AAE

HPE IMC Service Operation Management Software Module E-LTU JG139AAE

HP IMC IPSec VPN Manager Software Module with 25-node E-LTU JG144AAE

HP IMC Branch Intelligent Management System Software Module with 50-node E-LTU JG265AAE

Aruba IMC Branch Intelligent Management System Software Module with 50-node E-LTU JH708AAE

HPE IMC Service Health Manager Software Module E-LTU JG398AAE

Aruba IMC Service Health Manager Software Module E-LTU JH710AAE

HPE IMC Application Performance Manager Software Module 25-monitor E-LTU JG489AAE

Aruba IMC Application Performance Manager Software Module with 25-monitor E-LTU JH712AAE

HPE IMC VAN Connection Manager Software Module with E-LTU JG494AAE

HPE IMC Remote Site Manager Software Module with E-LTU JG495AAE

HPE IMC User Behavior Auditor Software Module with 50-user E-LTU JG760AAE

HPE IMC Virtual Application Networking Fabric Manager Software E-LTU JG770AAE

HPE IMC Virtual Application Networking Resource Automation Manager Software E-LTU JG826AAE

HPE IMC Virtual Application Networking Software Defined Network Manager Software E-
LTU JG827AAE

HPE IMC Unified Communications Health Manager SW Module 2-monitor E-LTU JG930AAE

HPE IMC Business Service Performance Software Module E-LTU JH320AAE
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Date Version History Action Description of Change

06-Feb-2017 From Version 13
to 14

Added Model added: JH704AAE

SKUs added: JH714AAE, JH711AAE,
JH706AAE, JH708AAE, JH710AAE, JH712AAE

05-Dec-2016 From Version 12
to 13

Changed Software feature update

17-June-2016 From Version 11
to 12

Changed Product description updated.

11-Dec-2015 From Version 10
to 11

Removed SKU removed: JG399AAE

01-Dec-2015 From Version 9 to
10

Changed QuickSpecs name changed to HPE Intelligent
Management Center Standard Software
Platform

Product overview, Features and benefits and
Technical Specifications were updated

29-Sep-2014 From Version 8 to
9

Changed The QuickSpecs was completely revised

18-Sep-2014 From Version 7 to
8

Changed Changes made on Features and Benefits

30-Sep-2013 From Version 6 to
7

Changed The Product overview, Key Features, Features
and Benefits, model specifications and Options
were updated.

13-Jun-2013 From Version 5 to
6

Removed License models were removed.

19-Feb-2013 From Version 4 to
5

Changed The Product overview, Key Features, Features
and Benefits, model specifications and Options
were updated.

13-Feb-2012 From Version 3 to
4

Changed The Features and Benefits, model names and
Options were updated.

06-Apr-2011 From Version 2 to
3

Changed The QuickSpecs was completely revised,
including updating the title.

01-Mar-2011 From Version 1 to
2

Changed An issue with the QuickSpecs PDF was
corrected.
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© Copyright 2017 Hewlett Packard Enterprise Development LP. The information

contained herein is subject to change without notice. The only warranties for

Hewlett Packard Enterprise products and services are set forth in the express

warranty statements accompanying such products and services. Nothing herein

should be construed as constituting an additional warranty. Hewlett Packard

Enterprise shall not be liable for technical or editorial errors or omissions

contained herein.

To learn more, visit http://www.hpe.com/networking  

 

Intel Pentium, Intel Core, and Intel Xeon are trademarks of Intel Corporation in the
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Resultado da pesquisa da Central de Serviços de Suporte

Serviços de Suporte HPE - Simplificar, salvar e proteger

Os Serviços de Suporte permitem que você se concentre em sua atividade principal, fornecendo um poderoso portfólio de serviços para proteger seu negócio de TI, preservando os ativos
digitais e as informações confidenciais com consistência global.

Data 10/09/2019

Número do Produto H6RQ4E

Nome do Produto Aruba 3 Year Foundation Care 24x7 IMC Std Ent Add 50-node E-LTU Service

País  BR

Visão geral
O Suporte técnico de Software HPE proporciona serviços gerais e atualizações que lhe ajudam a melhorar o rendimento e a disponibilidade do software HPE e dos importantes
fornecedores.

Benefícios
Contato direto com os engenheiros do Centro de resposta HPE para assistência através de comunicação telefônica ou eletrônica.

Recepção de assistência para solução de problemas e ajuste de parâmetros de configuração.

O completo software HPE e de terceiros e as atualizações da documentação a disposição do gestor do sistema.

Acesso a assistência eletrônica HPE para obter patches de software, uma bse de dados de soluções sintomáticas, descrições do produto, especificações, documentação técnica, etc.

Especificações
Cobertura de garantia In Warranty

Resposta 2 hour SW response

Período de Cobertura 24 horas por dia, 7 dias por semana

ServiceType Foundation Care

Duração 3 anos

Método de serviço SW Support
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Observação: Os níveis de serviço e tempos de resposta para os Serviços de Suporte Hewlett Packard Enterprise podem variar de acordo com sua localização geográfica. O serviço tem
início na data da compra do hardware. Restrições e limitações são aplicáveis. Os serviços HPE são regidos pelos termos e condições de serviço HPE aplicáveis fornecidos ou indicados para
o cliente no momento da compra. O cliente pode ter direitos legais obrigatórios adicionais, de acordo com as leis locais aplicáveis, e tais direitos não são afetados de qualquer forma pelos
termos e condições de serviço HPE ou pela garantia limitada HPE fornecida com o seu produto HPE.Para garantir a precisão dos Serviços de Suporte HPE, retorne à primeira página,
verifique se o país selecionado está correto e insira um número de produto ou número de série de hardware ou software específico para o qual deseja encontrar Serviços de Suporte HPE.

Saiba mais em www.hpe.com/services/ssc

Planos de serviços estendidos permitem estender a cobertura de serviços além do período de garantia básica e estão disponíveis em incrementos de um ano para durações de um a cinco
anos.

Consulte a Folha de dados e os termos e condições dos Serviços de Suporte Hewlett Packard Enterprise para obter os detalhes completos.
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Worldwide support numbers for these product 

families:*

 – Aruba products

 – HPE Nimble Storage products

Support matrix

Technical Support Phone Numbers

Country Support type Support phone number Hours of operations

Aland Contract +358 20 320 300 24x7

Warranty and Out of Warranty +358 20 353 232 M–F 8:00–17:00

Albania Contract & Warranty/Out of Warranty +355 42 322 411 24x7

Algeria Contract & Warranty/Out of Warranty +216 23 92 5000 24x7

Andorra Contract +34 902 220 030 24x7

Warranty and Out of Warranty +34 902 010 333 M–F 8:30–17:30

Angola Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Anguilla Contract & Warranty 1-800-225-5288 then 

844 692-8150

24x7

Antigua and Barbuda Contract & Warranty #1 then 844 692-8151 24x7

Argentina Contratos 0 800 444 7867

+52 55 5258 4500

24x7

Garantías 0 800 333 4857

+52 55 1500 3155

M–F 8:00–17:00

Armenia Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Aruba Contract & Warranty +1 844 264 1328 24x7

Australia Contract & Warranty/Out of Warranty 13 11 47

+61 2 8031 8315

24x7

Azerbaijan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

* For all other product types, please call the support number for your country listed in this document.
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Support matrix Page 2

Country Support type Support phone number Hours of operations

Bahamas Contract & Warranty 1-800-872-2881 then 

844 692-8152

24x7

Bahrain Contract & Warranty/Out of Warranty +973 1 619 82 94 24x7

Barbados Contract & Warranty 1-800-225-5288 then 

844 692-8153

24x7

Belarus Contract & Warranty/Out of Warranty 8 8200 073 01 01

+7 495 411 69 07

24x7

Belgium Contract 078 250 144

+32 26 200 055

24x7

Warranty and Out of Warranty 078 600 600

+32 26 200 099

M–F 8:00–17:00

Belize Contract & Warranty 811 then 844 692-8148 24x7

Benin Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Bermuda Contract & Warranty 1-800-225-5288 then 

844 692-8154

24x7

Bolivia Contratos 800 110 348

+52 55 5258 4500

24x7

Garantías 800 110 348

+52 55 1500 3155

M–F 8:00–17:00

Bonaire (Sint Eustatius, Saba) Contract & Warranty 001-800-872-2881 then 

844 752-2839

24x7

Bosnia and Herzegovina Contract & Warranty/Out of Warranty +387 338 219 22 24x7

Botswana Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Bouvet Island Contract & Warranty/Out of Warranty 800 56 044 24x7

Brasil Contract 0800 55 6405

+55 11 3173 8802 

+55 11 4688 5102

24x7

Warranty 0800 710 2029

+55 11 2377 1002 

+55 11 2377 0002

M–F 8:00–17:00
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Support matrix Page 3

Country Support type Support phone number Hours of operations

British Indian Ocean Territory Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

British Virgin Islands Contract & Warranty 1-800-872-2881 then 

844 692-8156

24x7

Bulgaria Contract & Warranty/Out of Warranty 0700-1-47-47 24x7

Burkina Faso Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Burundi Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Cameroon Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Canada Contract

Contrat

1-800-633-3600 24x7

Warranty and Out of Warranty

Produits garantis et hors garantie

1-844-806-3425 24x7 for most products

Cape Verde Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Cayman Islands Contract & Warranty 1-800-225-5288 then 

844 692-8157

24x7

Central African Republic Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Chad Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Chile Contratos 800 362 365

+52 55 5258 4500

24x7

Garantías 800 123 605

+52 55 1500 3155

M–F 8:00–17:00

Collectivity of Saint Martin Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Colombia Contratos 01 800 051 4747

+57 1 6004150

24x7

Garantías 800 051 7127

+52 55 1500 3155

M–F 9:00–18:00

Comoros Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7
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Support matrix Page 4

Country Support type Support phone number Hours of operations

Costa Rica Contratos 800 794 4401

+52 55 5258 4500

24x7

Garantías 800 794 4401

+52 55 1500 3155

M–F 8:00–17:00

Croatia Contract & Warranty/Out of Warranty 0800 303 556 24x7

Curaçao Contract & Warranty 001-800-872-2881 then 

844 264-1326

24x7

Cyprus Contract & Warranty/Out of Warranty 801 11 47 22 73

+30 211 181 3846

24x7

Czech Republic Contract & Warranty/Out of Warranty 239 018 791 24x7

Denmark Contract +45 70 10 80 25 24x7

Warranty and Out of Warranty +45 70 11 77 00 M–F 8:00–17:00

Deutschland Dienstleistungsverträge/Contracts +49 69 380 789 143 24x7

Produkte innerhalb und außerhalb der Herstellergarantie +49 69 380 789 142 Montag–Freitag

8:00–17:00

(außer an bundeseinheitlichen Feiertagen)

Djibouti Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Dominica Contract & Warranty 1-800-225-5288 then 

844 264-1327

24x7

Dominican Republic Contract & Warranty 1-888-225-5288 then 

844 264-1328

+52 55 5258 4500

24x7

Ecuador Contratos 1-800-225-528 then 

844 845-8165

+52 55 5258 4500

24x7

Garantías 1-800-225-528 then 

844 845-8165

+52 55 1500 3155 

M–F 8:00–17:00

Egypt Contract & Warranty/Out of Warranty 0800 000 0814

+20 2 353 131 62

24x7
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Support matrix Page 5

Country Support type Support phone number Hours of operations

El Salvador Contratos 800-1785 then 

844 845-8167

+52 55 5258 4500

24x7

Garantías 800-1785 then 

844 845-8167

+52 55 1500 3155 

M–F 8:00–17:00

Equatorial Guinea Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Eritrea Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

España Contrato de Mantenimiento +34 902 220 030

+34 913496569

24x7

Garantía y fuera de garantía +34 902 010 333

+34 913496559

Lunes a viernes, 8:30 a 17:30 de julio y agosto,  

8:30 a 14:30

Estonia Contract & Warranty/Out of Warranty +372 686 88 71 24x7

Ethiopia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Falkland Islands Contract & Warranty/Out of Warranty +44 845 161 0050 24x7

Faroe Islands Contract +45 70 10 80 25 24x7

Warranty and Out of Warranty +45 70 11 77 00 M–F 8:00–17:00

Finland Contract +358 20 320 300 24x7

Warranty and Out of Warranty +358 20 353 232 M–F 8:00–17:00

France Contrat 0825 00 41 23

+33 173018471

24x7

Ligne payante au tarif local en France

Garantie et Hors Garantie 0826 10 49 49

+33 173018475

Lundi–Vendredi 

8:30–18:00

(à l’exception des jours fériés et jours de fermeture d’HPE)

French Guiana Contract & Warranty 0800 99 00 11 then 

844 264-1329

24x7

French Polynesia Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

French Southern Territories Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Gabon Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7
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Support matrix Page 6

Country Support type Support phone number Hours of operations

Gambia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Georgia Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Ghana Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Gibraltar Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

Greece Contract & Warranty/Out of Warranty 801 11 47 22 73

+30 211 181 3846

24x7

Greenland Contract +45 70 10 80 25 24x7

Warranty and Out of Warranty +45 70 11 77 00 M–F 8:00–17:00

Grenada Contract & Warranty 1-800-225-5288 then 

844 264-1330

24x7

Guadeloupe Contract & Warranty 0-800-99-0011 then 

844 264-1331

24x7

Guatemala Contratos 999-9190 then 

844 845-8169

+52 55 5258 4500

24x7

Garantías 999-9190 then 

844 845-8169

+52 55 1500 3155

M–F 8:00–17:00

Guernsey Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

Guinea Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Guinea-Bissau Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Guyana Contract & Warranty 159 then 844 752-2835 24x7

Haiti Contract & Warranty +1 844 264 1328 24x7
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Support matrix Page 7

Country Support type Support phone number Hours of operations

Honduras Contratos 800-0-123 then 

844 752-2837

+52 55 5258 4500

24x7

Garantías 800-0-123 then 

844 752-2837

+52 55 1500 3155 

M–F 8:00–17:00

Hong Kong Contract +852 2292 3333 24x7

Alpha, ProLiant, and attached HPE Storage Systems

Warranty +852 3071 3873 M–F 8:30–17:30

HPE Networking, UNIX® system, NetServer, and attached 

HPE Storage systems 

Warranty +852 2904 8338 24x7

ProLiant & attached 

HPE Storage Systems 

Value line (need PIN code during AOH)

Hungary Contract 1 778 9670 24x7

Warranty and Out of Warranty 1 778 9669 M–F 9:00–17:00

Iceland Contract +47 800 56 044 24x7

Warranty and Out of Warranty +47 800 62 800 M–F 8:00–17:00

India Warranty 1800 419 8080 (Callers in India)

+91 806 703 7209 (International Callers)

M–F 9:00–18:00

Indonesia Contract & Warranty 0018 0385 20668

+62 21 5799 4050

24x7

Iran Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Iraq Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Ireland Contract 1850 924 590

+ 353 1 4118915

24x7

Warranty and Out of Warranty 1890 946 500

+ 353 1 4118912

M–F 8:00–18:00

(except Bank Holidays)

Isle of Man Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00
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Support matrix Page 8

Country Support type Support phone number Hours of operations

Israel Contract & Warranty/Out of Warranty 1-809-400-300

+972 3-3726489

24x7

Italia Contratti 02 452 790 50 24x7

In garanzia o fuori garanzia 02 385 912 12 Lunedì–Venerdì 8:00–17:00

Ivory Coast Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Jamaica Contract & Warranty 1-800-872-2881 then 

844 264-1332

24x7

日本 Warranty support.hpe.com/hpsc/doc/public/display?docId=emr_

na-c04770344

Jersey Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

Jordan Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Kazakhstan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Kenya Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Kosovo Contract & Warranty/Out of Warranty 0800 300 003/0800 190 038 (Serbia)

035 542 322 411 (Albania)

24x7

Kuwait Contract & Warranty/Out of Warranty 632 9930 24x7

Kyrgyzstan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Latvia Contract & Warranty/Out of Warranty 678 521 84 24x7

Lebanon Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Lesotho Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Liberia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Libya Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Liechtenstein Contract +41 0848 800 724 24x7

Warranty and Out of Warranty +41 0848 80 20 20 M–F 8:00–18:00

Lithuania Contract & Warranty/Out of Warranty +370 521 415 92 24x7
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Support matrix Page 9

Country Support type Support phone number Hours of operations

Luxembourg Contract +352 27 303 111 24x7

Warranty and Out of Warranty +352 27 303 303 M–F 8:00–17:00

Macedonia Contract & Warranty/Out of Warranty 0800 90 472 24x7

Madagascar Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Malawi Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Malaysia Contract & Warranty 1800 88 1811 (Callers in Malaysia)

+60 3 6207 4533 (International Callers)

24x7

Mali Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Malta Contract & Warranty/Out of Warranty +356 27 781 269 24x7

Martinique Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Mauritania Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Mauritius Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Mayotte Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

México Contratos 800 501 9800

+52 55 5258 4500

24x7

Garantías 800 890 6348

+52 55 1500 3155

M–F 8:00–17:00

Moldova Contract & Warranty/Out of Warranty +7 499 272 37 82 24x7

Monaco Contrat +33 1 73 01 84 71 24x7

Ligne payante au tarif local en France

Garantie et Hors Garantie +33 1 73 01 84 75 Lundi–Vendredi 

8:30–18:00

(à l’exception des jours fériés et jours de fermeture d’HPE)

Montenegro Contract & Warranty/Out of Warranty 0800 300 003 24x7

Montserrat Contract & Warranty 1-800-225-5288 then 

844 264-1333

24x7

Morocco Contract & Warranty/Out of Warranty 00 212 5 22 24 87 70

+44 1793 794886

24x7
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Support matrix Page 10

Country Support type Support phone number Hours of operations

Mozambique Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Namibia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Netherlands Contract 0900 115 0000

+31 205 040 666

24x7

Warranty and Out of Warranty 0900 117 0000 M–F 8:00–17:00

New Caledonia Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

New Zealand Contract & Warranty/Out of Warranty 0800 664 747

+61 2 8031 8316

24x7

Nicaragua Contratos 1-800-0164 then 

844 752-2840

+52 55 5258 4500

24x7

Garantías 1-800-0164 then 

844 752-2840

+52 55 1500 3155

M–F 8:00–17:00

Niger Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Nigeria Contract & Warranty/Out of Warranty 01 27 14 777

+44 203 564 4148

24x7

Norway Contract 800 56 044 24x7

Warranty and Out of Warranty 800 62 800 M–F 8:00–17:00

Oman Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Österreich Dienstleistungsverträge/Contracts 08 1000 2000 24x7

Produkte innerhalb und ausserhalb der

Herstellergarantie

08 1000 1000 M–F 8:00–18:00

Palestinian Territory Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Panama Contratos 800-2288 then 

844 845-8163

+52 55 5258 4500

24x7

Garantías 800-2288 then 

844 845-8163

+52 55 1500 3155 

M–F 8:00–17:00
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Support matrix Page 11

Country Support type Support phone number Hours of operations

Paraguay Contratos 008-11-800 then 

844 752-2842

+52 55 5258 4500

24x7

Garantías 008-11-800 then 

844 752-2842

+52 55 1500 3155 

M–F 8:00–17:00

Perú Contratos 0 800 1 9703

+52 55 5258 4500

24x7

Garantías 0800 44 366

+52 55 1500 3155 

M–F 8:00–17:00

Philippines Contract & Warranty 1800 1441 0669

 1800 8908 6404

+63 2395 3565

24x7

Poland Contract & Warranty/Out of Warranty 0 800 702 284

(22) 306 04 84

24x7

Portugal Contract 808 203 203 24x7

Warranty and Out of Warranty 213 164 164 M–F 9:00–18:00

Puerto Rico Contratos 844 752-2843

+52 55 5258 4500

24x7

Garantías 844 752-2843

+52 55 1500 3155 

M–F 8:00–17:00

Qatar Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Republic of Congo Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Réunion Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Romania Contract & Warranty/Out of Warranty +40 317 305 020 24x7

Россия Поддержка 8 800 500 92 55

+7 495 411 69 07

24x7

Rwanda Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Saint Barthélemy Contract 0-800-990-011 then 

844 845-8168

24x7

Warranty and Out of Warranty +212 5 22 24 87 70 24x7
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Support matrix Page 12

Country Support type Support phone number Hours of operations

Saint Helena (Ascension and Tristan da Cunha) Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Saint Kitts and Nevis Contract & Warranty 1-800-225-5288 then 

844 264-1334

24x7

Saint Lucia Contract & Warranty/Out of Warranty 1 844 231 8954 24x7

Saint Pierre and Miquelon Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Saint Vincent and the Grenadines Contract & Warranty 1-800-225-5288 then 

844 845-8160

24x7

San Marino Contract 02 452 790 50 24x7

Warranty and Out of Warranty 02 385 912 12 M–F 8:00–17:00

Sao Tome and Principe Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Saudi Arabia Contract & Warranty/Out of Warranty 800 844 4611 24x7

Schweiz
Suisse

Dienstleistungsvertrag/

Contrat de services

0848 800 724

+41 43 557 9021

24x7

8Rp./Min*

Herstellergarantie/

Produits garantis

0848 80 20 20

+41 44 200 4115

Montag–Freitag

Lundi–Vendredi

8:00–17:00

(außer Feiertage) 

8Rp./Min*

*aus dem schweizerischen Festnetz; abweichende Preise aus 

Mobilfunknetzen sind je nach Anbieter möglich.

Senegal Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Serbia Contract & Warranty/Out of Warranty 0800 300 003

0800 190 038 

24x7

Seychelles Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Sierra Leone Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Singapore Contract & Warranty 1800 272 4333 (Callers in Singapore)

+65 6272 4333 (International Callers)

24x7

Sint Maarten Contract & Warranty 800-99-0011 then 

844 264-1335

24x7
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Support matrix Page 13

Country Support type Support phone number Hours of operations

Slovakia Contract & Warranty/Out of Warranty 02 686 221 79 24x7

Slovenia Contract & Warranty/Out of Warranty 0800 80 745 24x7

Somalia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

South Africa Contract 0860 001 020 24x7

Warranty and Out of Warranty 0860 001 030 M–F 8:00–17:00

(except public Holidays)

South Georgia and the South Sandwich Islands Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

대한민국 Contract & Warranty +82 1577 3270 M–F 09:00–18:00

Server & Storage

Contract & Warranty +82 1588 0142 M–F 09:00–18:00

Networking

South Sudan Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Sudan Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Suriname Contract & Warranty/Out of Warranty 156 then 844 231-8955 24x7

Svalbard and Jan Mayen Contract +47 800 56 044 24x7

Warranty and Out of Warranty +47 800 62 800 M–F 8:00–17:00

Swaziland Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Sweden Contract 0771 30 30 50 24x7

Warranty and Out of Warranty 0771 30 30 00 M–F 8:00–17:00

Syria Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Taiwan Contract & Warranty 0800 211 666

+886 2 2656 7204

M–F 8:30–17:30

Tajikistan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7
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Country Support type Support phone number Hours of operations

Tanzania Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Thailand Contract 1800 441 4048

+66 2 118 6000

24x7

Warranty 1800 441 4085

+66 2 118 6300

M–F 8:30–17:30

The Democratic Republic of Congo Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Togo Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Trinidad and Tobago Contract & Warranty/Out of Warranty 1-800-872-2881 then 

844 845-8161

24x7

Tunisia Contract & Warranty/Out of Warranty +216 23 92 5000 24x7

Turkey Contract 850 759 0 724

+90 850 759 0 724

24x7

Warranty and Out of Warranty 850 759 0 473

+90 850 759 0 473

08:30–17:30 GMT+3

Turkmenistan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Turks and Caicos Islands Contract & Warranty 1-800-225-5288 then 

844 845-8162

24x7

Uganda Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Ukraine Contract & Warranty/Out of Warranty 0 800 501 526 24x7

United Arab Emirates Contract & Warranty/Out of Warranty 800 0444 1477 24x7

United Kingdom Contract 0845 161 0050 24x7

Warranty and Out of Warranty 0845 161 0030 M–F 8:00–18:00

United States Contract 1-800-633-3600 24x7

Warranty and Out of Warranty 1-844-806-3425 24x7

Uruguay Contratos 0004 110 032 632

+52 55 5258 4500

24x7

Garantías 0004 110 032 632

+52 55 1500 3155 

M–F 8:00–17:00
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Support matrix

Make the right purchase 
decision. Click here to 
chat with our presales 
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Country Support type Support phone number Hours of operations

US Virgin Islands Contract & Warranty +1 844 845-8164 24x7

Uzbekistan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Vatican City Contract 02 45279050 24x7

Warranty and Out of Warranty 02 38591212 M–F 8:00–17:00

Venezuela Contratos & Garantías +58 212 7102103 24x7

Vietnam Contract & Warranty +84 28 4458 2390 24x7

Wallis and Futuna Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Western Sahara Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Yemen Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Zambia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Zimbabwe Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7
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HPE IMC Network Traffic Analyzer Software
 

 

Models
HPE IMC Network Traffic Analyzer Software Module with 5-node E-LTU JG750AAE

Aruba IMC Network Traffic Analyzer Software Module with 5-node E-LTU JH706AAE

 

Key features
Real-time and historical reporting on network application usage
Automatic generation of reports
Uses instruments embedded in switches and routers
Support for sFlow, NetFlow, and NetStream
Granular insight of applications, users, and ports

 

Product overview
HPE Intelligent Management Center (IMC) software is a modular comprehensive resource management
platform. With its extensive device support, IMC software provides true end-to-end management for the
entire network, as well as the open operation cycle.

The NTA service module integrates network layer 4 through 7 monitoring into the IMC network management
platform. NTA uses the instrumentation in network devices such as routers and switches to provide real-
time and historical reporting on network application usage. Administrators tailor NTA data collection and
reporting capabilities to meet specific reporting needs. Administrators and operators view NTA reports
directly from the IMC integrated platform.

Network bandwidth statistics provided by the IMC NTA software module help plan, monitor, enhance, and
troubleshoot networks, as well as identify bottlenecks and apply corrective measures for enhanced
throughput. The software also monitors Internet egress traffic, helping administrators to analyze the
bandwidth usage of specific applications and monitor the impact of non-business applications (e.g., network
games) on user productivity. Granular, network-wide surveillance of complex multilayer switched and routed
environments helps rapidly identify and resolve network threats.

 

QuickSpecs HPE IMC Network Traffic Analyzer Software

Overview
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Features and Benefits
Additional information

Network-wide surveillance

provides visibility of complex multilayer switched and routed environments, delivering the rapid
identification and resolution of any threat to the network; this information allows administrators to
enforce security policies, identify suspicious behavior quickly, respond to security threats, provide
quality of service, account for network usage, and reduce network costs
Intelligent traffic analysis

automatically generates a traffic baseline from general network usage; with this baseline, IMC NTA
software can find abnormal network usage and send an alarm to the administrator
Advanced application and protocol mapping

breaks down your network traffic into applications you can recognize by providing insight into top
application usage and reports for in/out/total bandwidth organized by source, destination, protocol,
application, and application groups
In-depth visibility

provides both quick-glance reports for a better understanding of the bandwidth utilization in your
network as well as the ability to drill down into data for more thorough analysis; the software can also
automatically discover the interfaces sending traffic
Industry-standard IP flow monitoring

supports most standard IP network flow monitoring protocols including NetStream v5/v9, NetFlow
v5/v9, sFlow v5, NTA supports Hewlett Packard Enterprise proprietary probe traffic logs using vMon.
HPE IMC Virtualization Monitor software

is an IMC module that supports port running features for any switch or hub in physical and virtual
environments; it allows IT departments to analyze network traffic and track security information; the
software is vendor agnostic and is therefore not dependent on vendor-specific devices

Warranty and support

Electronic and telephone support

limited electronic and business-hours telephone support is available from Hewlett Packard Enterprise;
to reach our support centers, refer to http://www.hpe.com/networking/contact-support; for details

on the duration of support provided with your product purchase, refer to
http://www.hpe.com/networking/warrantysummary.

Software releases

to find software for your product, refer to http://www.hpe.com/networking/support; for details on the

software releases available with your product purchase, refer to
http://www.hpe.com/networking/warrantysummary

QuickSpecs HPE IMC Network Traffic Analyzer Software

Overview
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HPE IMC Network Traffic Analyzer Software Module with 5-node E-LTU (JG750AAE)

Aruba IMC Network Traffic Analyzer Software Module with 5-node E-LTU (JH706AAE)

   

Platform required Server:
HPE Intelligent Management Center Enterprise Software
HPE Intelligent Management Center Standard Software

Notes See the HPE IMC Standard or Enterprise Platform data sheet for the required
software environment.
Should be a standalone server, and not on the same server as the IMC platform.
Also, depending on the scale of management, multiple NTA components can be
deployed on separate servers.

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the service-level

descriptions and product numbers. For details about services and response times
in your area, please contact your local Hewlett Packard Enterprise sales office.

 

QuickSpecs HPE IMC Network Traffic Analyzer Software

Technical Specifications
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HPE IMC Network Traffic Analyzer Software accessories
 

License

HPE IMC Network Traffic Analyzer Software Module Additional 5-node E-LTU JG751AAE

Aruba IMC Network Traffic Analyzer Software Module Additional 5-node E-LTU JH707AAE

   

Software

HPE IMC Virtualization Monitor Software with E-LTU JG547AAE

 

QuickSpecs HPE IMC Network Traffic Analyzer Software

Accessories
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Date Version History Action Description of Change

06-Feb-2017 From Version 8 to
9

Added Model added: JH706AAE

SKUs added: JH707AAE
17-June-2016 From Version 7 to

8
Changed Product descriptions updated.

01-Dec-2015 From Version 6 to
7

Changed QuickSpecs name changed to HPE IMC
Network Traffic Analyzer Software

Product overview, Features and benefits and
Technical Specifications updated

29-Sep-2014 From Version 5 to
6

Changed Updated Key Features, Product Overview,
Features and Benefits and Technical
Specifications

30-Sep-2013 From Version 4 to
5

Changed The Product overview, Key Features, Features
and Benefits, model specifications and Options
were updated.

30-Aug-2013 From Version 3 to
4

Changed The title was changed.

13-Jun-2013 From Version 2 to
3

Removed License models were removed.

06-Apr-2011 From Version 1 to
2

Changed The QuickSpecs was completely revised. 
Please note the title has changed as well.

 

     

Sign up for updates

 

 
 

© Copyright 2017 Hewlett Packard Enterprise Development LP. The information

contained herein is subject to change without notice. The only warranties for

Hewlett Packard Enterprise products and services are set forth in the express

warranty statements accompanying such products and services. Nothing herein

should be construed as constituting an additional warranty. Hewlett Packard

Enterprise shall not be liable for technical or editorial errors or omissions

contained herein.

To learn more, visit http://www.hpe.com/networking

Microsoft and Windows Server are trademarks of the Microsoft Group of

companies. Red Hat is a registered trademark of Red Hat, Inc. in the United

States and other countries. Linux is the registered trademark of Linus Torvalds in

the U.S. and other countries. VMware is a registered trademark or trademark of

VMware, Inc. in the United States and/or other jurisdictions. Oracle is a registered

trademark of Oracle and/or its affiliates.

c04111577 - 13833 - Worldwide - V9 - 6-February-2017
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Resultado da pesquisa da Central de Serviços de Suporte

Serviços de Suporte HPE - Simplificar, salvar e proteger

Os Serviços de Suporte permitem que você se concentre em sua atividade principal, fornecendo um poderoso portfólio de serviços para proteger seu negócio de TI, preservando os ativos
digitais e as informações confidenciais com consistência global.

Data 10/09/2019

Número do Produto H6RS8E

Nome do Produto Aruba 3 Year Foundation Care 24x7 IMC NTA SW Mod 5-node E-LTU Service

País  BR

Visão geral
O Suporte técnico de Software HPE proporciona serviços gerais e atualizações que lhe ajudam a melhorar o rendimento e a disponibilidade do software HPE e dos importantes
fornecedores.

Benefícios
Contato direto com os engenheiros do Centro de resposta HPE para assistência através de comunicação telefônica ou eletrônica.

Recepção de assistência para solução de problemas e ajuste de parâmetros de configuração.

O completo software HPE e de terceiros e as atualizações da documentação a disposição do gestor do sistema.

Acesso a assistência eletrônica HPE para obter patches de software, uma bse de dados de soluções sintomáticas, descrições do produto, especificações, documentação técnica, etc.

Especificações
Cobertura de garantia In Warranty

Resposta 2 hour SW response

Período de Cobertura 24 horas por dia, 7 dias por semana

ServiceType Foundation Care

Duração 3 anos

Método de serviço SW Support
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Observação: Os níveis de serviço e tempos de resposta para os Serviços de Suporte Hewlett Packard Enterprise podem variar de acordo com sua localização geográfica. O serviço tem
início na data da compra do hardware. Restrições e limitações são aplicáveis. Os serviços HPE são regidos pelos termos e condições de serviço HPE aplicáveis fornecidos ou indicados para
o cliente no momento da compra. O cliente pode ter direitos legais obrigatórios adicionais, de acordo com as leis locais aplicáveis, e tais direitos não são afetados de qualquer forma pelos
termos e condições de serviço HPE ou pela garantia limitada HPE fornecida com o seu produto HPE.Para garantir a precisão dos Serviços de Suporte HPE, retorne à primeira página,
verifique se o país selecionado está correto e insira um número de produto ou número de série de hardware ou software específico para o qual deseja encontrar Serviços de Suporte HPE.

Saiba mais em www.hpe.com/services/ssc

Planos de serviços estendidos permitem estender a cobertura de serviços além do período de garantia básica e estão disponíveis em incrementos de um ano para durações de um a cinco
anos.

Consulte a Folha de dados e os termos e condições dos Serviços de Suporte Hewlett Packard Enterprise para obter os detalhes completos.
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Worldwide support numbers for these product 

families:*

 – Aruba products

 – HPE Nimble Storage products

Support matrix

Technical Support Phone Numbers

Country Support type Support phone number Hours of operations

Aland Contract +358 20 320 300 24x7

Warranty and Out of Warranty +358 20 353 232 M–F 8:00–17:00

Albania Contract & Warranty/Out of Warranty +355 42 322 411 24x7

Algeria Contract & Warranty/Out of Warranty +216 23 92 5000 24x7

Andorra Contract +34 902 220 030 24x7

Warranty and Out of Warranty +34 902 010 333 M–F 8:30–17:30

Angola Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Anguilla Contract & Warranty 1-800-225-5288 then 

844 692-8150

24x7

Antigua and Barbuda Contract & Warranty #1 then 844 692-8151 24x7

Argentina Contratos 0 800 444 7867

+52 55 5258 4500

24x7

Garantías 0 800 333 4857

+52 55 1500 3155

M–F 8:00–17:00

Armenia Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Aruba Contract & Warranty +1 844 264 1328 24x7

Australia Contract & Warranty/Out of Warranty 13 11 47

+61 2 8031 8315

24x7

Azerbaijan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

* For all other product types, please call the support number for your country listed in this document.
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Support matrix Page 2

Country Support type Support phone number Hours of operations

Bahamas Contract & Warranty 1-800-872-2881 then 

844 692-8152

24x7

Bahrain Contract & Warranty/Out of Warranty +973 1 619 82 94 24x7

Barbados Contract & Warranty 1-800-225-5288 then 

844 692-8153

24x7

Belarus Contract & Warranty/Out of Warranty 8 8200 073 01 01

+7 495 411 69 07

24x7

Belgium Contract 078 250 144

+32 26 200 055

24x7

Warranty and Out of Warranty 078 600 600

+32 26 200 099

M–F 8:00–17:00

Belize Contract & Warranty 811 then 844 692-8148 24x7

Benin Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Bermuda Contract & Warranty 1-800-225-5288 then 

844 692-8154

24x7

Bolivia Contratos 800 110 348

+52 55 5258 4500

24x7

Garantías 800 110 348

+52 55 1500 3155

M–F 8:00–17:00

Bonaire (Sint Eustatius, Saba) Contract & Warranty 001-800-872-2881 then 

844 752-2839

24x7

Bosnia and Herzegovina Contract & Warranty/Out of Warranty +387 338 219 22 24x7

Botswana Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Bouvet Island Contract & Warranty/Out of Warranty 800 56 044 24x7

Brasil Contract 0800 55 6405

+55 11 3173 8802 

+55 11 4688 5102

24x7

Warranty 0800 710 2029

+55 11 2377 1002 

+55 11 2377 0002

M–F 8:00–17:00
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British Indian Ocean Territory Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

British Virgin Islands Contract & Warranty 1-800-872-2881 then 

844 692-8156

24x7

Bulgaria Contract & Warranty/Out of Warranty 0700-1-47-47 24x7

Burkina Faso Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Burundi Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Cameroon Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Canada Contract

Contrat

1-800-633-3600 24x7

Warranty and Out of Warranty

Produits garantis et hors garantie

1-844-806-3425 24x7 for most products

Cape Verde Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Cayman Islands Contract & Warranty 1-800-225-5288 then 

844 692-8157

24x7

Central African Republic Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Chad Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Chile Contratos 800 362 365

+52 55 5258 4500

24x7

Garantías 800 123 605

+52 55 1500 3155

M–F 8:00–17:00

Collectivity of Saint Martin Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Colombia Contratos 01 800 051 4747

+57 1 6004150

24x7

Garantías 800 051 7127

+52 55 1500 3155

M–F 9:00–18:00

Comoros Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7
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Costa Rica Contratos 800 794 4401

+52 55 5258 4500

24x7

Garantías 800 794 4401

+52 55 1500 3155

M–F 8:00–17:00

Croatia Contract & Warranty/Out of Warranty 0800 303 556 24x7

Curaçao Contract & Warranty 001-800-872-2881 then 

844 264-1326

24x7

Cyprus Contract & Warranty/Out of Warranty 801 11 47 22 73

+30 211 181 3846

24x7

Czech Republic Contract & Warranty/Out of Warranty 239 018 791 24x7

Denmark Contract +45 70 10 80 25 24x7

Warranty and Out of Warranty +45 70 11 77 00 M–F 8:00–17:00

Deutschland Dienstleistungsverträge/Contracts +49 69 380 789 143 24x7

Produkte innerhalb und außerhalb der Herstellergarantie +49 69 380 789 142 Montag–Freitag

8:00–17:00

(außer an bundeseinheitlichen Feiertagen)

Djibouti Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Dominica Contract & Warranty 1-800-225-5288 then 

844 264-1327

24x7

Dominican Republic Contract & Warranty 1-888-225-5288 then 

844 264-1328

+52 55 5258 4500

24x7

Ecuador Contratos 1-800-225-528 then 

844 845-8165

+52 55 5258 4500

24x7

Garantías 1-800-225-528 then 

844 845-8165

+52 55 1500 3155 

M–F 8:00–17:00

Egypt Contract & Warranty/Out of Warranty 0800 000 0814

+20 2 353 131 62

24x7
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El Salvador Contratos 800-1785 then 

844 845-8167

+52 55 5258 4500

24x7

Garantías 800-1785 then 

844 845-8167

+52 55 1500 3155 

M–F 8:00–17:00

Equatorial Guinea Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Eritrea Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

España Contrato de Mantenimiento +34 902 220 030

+34 913496569

24x7

Garantía y fuera de garantía +34 902 010 333

+34 913496559

Lunes a viernes, 8:30 a 17:30 de julio y agosto,  

8:30 a 14:30

Estonia Contract & Warranty/Out of Warranty +372 686 88 71 24x7

Ethiopia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Falkland Islands Contract & Warranty/Out of Warranty +44 845 161 0050 24x7

Faroe Islands Contract +45 70 10 80 25 24x7

Warranty and Out of Warranty +45 70 11 77 00 M–F 8:00–17:00

Finland Contract +358 20 320 300 24x7

Warranty and Out of Warranty +358 20 353 232 M–F 8:00–17:00

France Contrat 0825 00 41 23

+33 173018471

24x7

Ligne payante au tarif local en France

Garantie et Hors Garantie 0826 10 49 49

+33 173018475

Lundi–Vendredi 

8:30–18:00

(à l’exception des jours fériés et jours de fermeture d’HPE)

French Guiana Contract & Warranty 0800 99 00 11 then 

844 264-1329

24x7

French Polynesia Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

French Southern Territories Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Gabon Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7
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Gambia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Georgia Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Ghana Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Gibraltar Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

Greece Contract & Warranty/Out of Warranty 801 11 47 22 73

+30 211 181 3846

24x7

Greenland Contract +45 70 10 80 25 24x7

Warranty and Out of Warranty +45 70 11 77 00 M–F 8:00–17:00

Grenada Contract & Warranty 1-800-225-5288 then 

844 264-1330

24x7

Guadeloupe Contract & Warranty 0-800-99-0011 then 

844 264-1331

24x7

Guatemala Contratos 999-9190 then 

844 845-8169

+52 55 5258 4500

24x7

Garantías 999-9190 then 

844 845-8169

+52 55 1500 3155

M–F 8:00–17:00

Guernsey Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

Guinea Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Guinea-Bissau Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Guyana Contract & Warranty 159 then 844 752-2835 24x7

Haiti Contract & Warranty +1 844 264 1328 24x7
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Honduras Contratos 800-0-123 then 

844 752-2837

+52 55 5258 4500

24x7

Garantías 800-0-123 then 

844 752-2837

+52 55 1500 3155 

M–F 8:00–17:00

Hong Kong Contract +852 2292 3333 24x7

Alpha, ProLiant, and attached HPE Storage Systems

Warranty +852 3071 3873 M–F 8:30–17:30

HPE Networking, UNIX® system, NetServer, and attached 

HPE Storage systems 

Warranty +852 2904 8338 24x7

ProLiant & attached 

HPE Storage Systems 

Value line (need PIN code during AOH)

Hungary Contract 1 778 9670 24x7

Warranty and Out of Warranty 1 778 9669 M–F 9:00–17:00

Iceland Contract +47 800 56 044 24x7

Warranty and Out of Warranty +47 800 62 800 M–F 8:00–17:00

India Warranty 1800 419 8080 (Callers in India)

+91 806 703 7209 (International Callers)

M–F 9:00–18:00

Indonesia Contract & Warranty 0018 0385 20668

+62 21 5799 4050

24x7

Iran Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Iraq Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Ireland Contract 1850 924 590

+ 353 1 4118915

24x7

Warranty and Out of Warranty 1890 946 500

+ 353 1 4118912

M–F 8:00–18:00

(except Bank Holidays)

Isle of Man Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00
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Israel Contract & Warranty/Out of Warranty 1-809-400-300

+972 3-3726489

24x7

Italia Contratti 02 452 790 50 24x7

In garanzia o fuori garanzia 02 385 912 12 Lunedì–Venerdì 8:00–17:00

Ivory Coast Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Jamaica Contract & Warranty 1-800-872-2881 then 

844 264-1332

24x7

日本 Warranty support.hpe.com/hpsc/doc/public/display?docId=emr_

na-c04770344

Jersey Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

Jordan Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Kazakhstan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Kenya Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Kosovo Contract & Warranty/Out of Warranty 0800 300 003/0800 190 038 (Serbia)

035 542 322 411 (Albania)

24x7

Kuwait Contract & Warranty/Out of Warranty 632 9930 24x7

Kyrgyzstan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Latvia Contract & Warranty/Out of Warranty 678 521 84 24x7

Lebanon Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Lesotho Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Liberia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Libya Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Liechtenstein Contract +41 0848 800 724 24x7

Warranty and Out of Warranty +41 0848 80 20 20 M–F 8:00–18:00

Lithuania Contract & Warranty/Out of Warranty +370 521 415 92 24x7
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Luxembourg Contract +352 27 303 111 24x7

Warranty and Out of Warranty +352 27 303 303 M–F 8:00–17:00

Macedonia Contract & Warranty/Out of Warranty 0800 90 472 24x7

Madagascar Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Malawi Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Malaysia Contract & Warranty 1800 88 1811 (Callers in Malaysia)

+60 3 6207 4533 (International Callers)

24x7

Mali Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Malta Contract & Warranty/Out of Warranty +356 27 781 269 24x7

Martinique Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Mauritania Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Mauritius Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Mayotte Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

México Contratos 800 501 9800

+52 55 5258 4500

24x7

Garantías 800 890 6348

+52 55 1500 3155

M–F 8:00–17:00

Moldova Contract & Warranty/Out of Warranty +7 499 272 37 82 24x7

Monaco Contrat +33 1 73 01 84 71 24x7

Ligne payante au tarif local en France

Garantie et Hors Garantie +33 1 73 01 84 75 Lundi–Vendredi 

8:30–18:00

(à l’exception des jours fériés et jours de fermeture d’HPE)

Montenegro Contract & Warranty/Out of Warranty 0800 300 003 24x7

Montserrat Contract & Warranty 1-800-225-5288 then 

844 264-1333

24x7

Morocco Contract & Warranty/Out of Warranty 00 212 5 22 24 87 70

+44 1793 794886

24x7
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Mozambique Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Namibia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Netherlands Contract 0900 115 0000

+31 205 040 666

24x7

Warranty and Out of Warranty 0900 117 0000 M–F 8:00–17:00

New Caledonia Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

New Zealand Contract & Warranty/Out of Warranty 0800 664 747

+61 2 8031 8316

24x7

Nicaragua Contratos 1-800-0164 then 

844 752-2840

+52 55 5258 4500

24x7

Garantías 1-800-0164 then 

844 752-2840

+52 55 1500 3155

M–F 8:00–17:00

Niger Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Nigeria Contract & Warranty/Out of Warranty 01 27 14 777

+44 203 564 4148

24x7

Norway Contract 800 56 044 24x7

Warranty and Out of Warranty 800 62 800 M–F 8:00–17:00

Oman Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Österreich Dienstleistungsverträge/Contracts 08 1000 2000 24x7

Produkte innerhalb und ausserhalb der

Herstellergarantie

08 1000 1000 M–F 8:00–18:00

Palestinian Territory Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Panama Contratos 800-2288 then 

844 845-8163

+52 55 5258 4500

24x7

Garantías 800-2288 then 

844 845-8163

+52 55 1500 3155 

M–F 8:00–17:00
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Paraguay Contratos 008-11-800 then 

844 752-2842

+52 55 5258 4500

24x7

Garantías 008-11-800 then 

844 752-2842

+52 55 1500 3155 

M–F 8:00–17:00

Perú Contratos 0 800 1 9703

+52 55 5258 4500

24x7

Garantías 0800 44 366

+52 55 1500 3155 

M–F 8:00–17:00

Philippines Contract & Warranty 1800 1441 0669

 1800 8908 6404

+63 2395 3565

24x7

Poland Contract & Warranty/Out of Warranty 0 800 702 284

(22) 306 04 84

24x7

Portugal Contract 808 203 203 24x7

Warranty and Out of Warranty 213 164 164 M–F 9:00–18:00

Puerto Rico Contratos 844 752-2843

+52 55 5258 4500

24x7

Garantías 844 752-2843

+52 55 1500 3155 

M–F 8:00–17:00

Qatar Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Republic of Congo Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Réunion Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Romania Contract & Warranty/Out of Warranty +40 317 305 020 24x7

Россия Поддержка 8 800 500 92 55

+7 495 411 69 07

24x7

Rwanda Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Saint Barthélemy Contract 0-800-990-011 then 

844 845-8168

24x7

Warranty and Out of Warranty +212 5 22 24 87 70 24x7
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Saint Helena (Ascension and Tristan da Cunha) Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Saint Kitts and Nevis Contract & Warranty 1-800-225-5288 then 

844 264-1334

24x7

Saint Lucia Contract & Warranty/Out of Warranty 1 844 231 8954 24x7

Saint Pierre and Miquelon Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Saint Vincent and the Grenadines Contract & Warranty 1-800-225-5288 then 

844 845-8160

24x7

San Marino Contract 02 452 790 50 24x7

Warranty and Out of Warranty 02 385 912 12 M–F 8:00–17:00

Sao Tome and Principe Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Saudi Arabia Contract & Warranty/Out of Warranty 800 844 4611 24x7

Schweiz
Suisse

Dienstleistungsvertrag/

Contrat de services

0848 800 724

+41 43 557 9021

24x7

8Rp./Min*

Herstellergarantie/

Produits garantis

0848 80 20 20

+41 44 200 4115

Montag–Freitag

Lundi–Vendredi

8:00–17:00

(außer Feiertage) 

8Rp./Min*

*aus dem schweizerischen Festnetz; abweichende Preise aus 

Mobilfunknetzen sind je nach Anbieter möglich.

Senegal Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Serbia Contract & Warranty/Out of Warranty 0800 300 003

0800 190 038 

24x7

Seychelles Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Sierra Leone Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Singapore Contract & Warranty 1800 272 4333 (Callers in Singapore)

+65 6272 4333 (International Callers)

24x7

Sint Maarten Contract & Warranty 800-99-0011 then 

844 264-1335

24x7
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Slovakia Contract & Warranty/Out of Warranty 02 686 221 79 24x7

Slovenia Contract & Warranty/Out of Warranty 0800 80 745 24x7

Somalia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

South Africa Contract 0860 001 020 24x7

Warranty and Out of Warranty 0860 001 030 M–F 8:00–17:00

(except public Holidays)

South Georgia and the South Sandwich Islands Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

대한민국 Contract & Warranty +82 1577 3270 M–F 09:00–18:00

Server & Storage

Contract & Warranty +82 1588 0142 M–F 09:00–18:00

Networking

South Sudan Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Sudan Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Suriname Contract & Warranty/Out of Warranty 156 then 844 231-8955 24x7

Svalbard and Jan Mayen Contract +47 800 56 044 24x7

Warranty and Out of Warranty +47 800 62 800 M–F 8:00–17:00

Swaziland Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Sweden Contract 0771 30 30 50 24x7

Warranty and Out of Warranty 0771 30 30 00 M–F 8:00–17:00

Syria Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Taiwan Contract & Warranty 0800 211 666

+886 2 2656 7204

M–F 8:30–17:30

Tajikistan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7
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Tanzania Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Thailand Contract 1800 441 4048

+66 2 118 6000

24x7

Warranty 1800 441 4085

+66 2 118 6300

M–F 8:30–17:30

The Democratic Republic of Congo Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Togo Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Trinidad and Tobago Contract & Warranty/Out of Warranty 1-800-872-2881 then 

844 845-8161

24x7

Tunisia Contract & Warranty/Out of Warranty +216 23 92 5000 24x7

Turkey Contract 850 759 0 724

+90 850 759 0 724

24x7

Warranty and Out of Warranty 850 759 0 473

+90 850 759 0 473

08:30–17:30 GMT+3

Turkmenistan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Turks and Caicos Islands Contract & Warranty 1-800-225-5288 then 

844 845-8162

24x7

Uganda Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Ukraine Contract & Warranty/Out of Warranty 0 800 501 526 24x7

United Arab Emirates Contract & Warranty/Out of Warranty 800 0444 1477 24x7

United Kingdom Contract 0845 161 0050 24x7

Warranty and Out of Warranty 0845 161 0030 M–F 8:00–18:00

United States Contract 1-800-633-3600 24x7

Warranty and Out of Warranty 1-844-806-3425 24x7

Uruguay Contratos 0004 110 032 632

+52 55 5258 4500

24x7

Garantías 0004 110 032 632

+52 55 1500 3155 

M–F 8:00–17:00
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decision. Click here to 
chat with our presales 
specialists.

Country Support type Support phone number Hours of operations

US Virgin Islands Contract & Warranty +1 844 845-8164 24x7

Uzbekistan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Vatican City Contract 02 45279050 24x7

Warranty and Out of Warranty 02 38591212 M–F 8:00–17:00

Venezuela Contratos & Garantías +58 212 7102103 24x7

Vietnam Contract & Warranty +84 28 4458 2390 24x7

Wallis and Futuna Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Western Sahara Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Yemen Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Zambia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Zimbabwe Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7
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Aruba ClearPass Policy Manager Platform
The most advanced Secure NAC platform available

 

 

Product overview
 

Aruba's ClearPass Policy Manager, part of the Aruba 360 Secure Fabric, provides role- and device-based
secure network access control for IoT, BYOD, corporate devices, as well as employees, contractors and
guests across any multivendor wired, wireless and VPN infrastructure. 
With a built-in context-based policy engine, RADIUS, TACACS+, non-RADIUS enforcement using
OnConnect, device profiling, posture assessment, onboarding, and guest access options, ClearPass is
unrivaled as a foundation for network security for organizations of any size. 
For comprehensive integrated security coverage and response using firewalls, EMM/MDM and other
existing solutions, ClearPass supports the Aruba 360 Security Exchange Program. This allows for
automated threat detection and response workflows that integrate with third- party security vendors and IT
systems previously requiring manual IT intervention. 
In addition, ClearPass supports secure self-service capabilities, making it easier for end users trying to
access the network. Users can securely configure their own devices for enterprise use or Internet access
based on admin policy controls. Aruba wireless customers in particular can take advantage of unique
integration capabilities such as AirGroup, as well as ClearPass Auto Sign-On (ASO). ASO enables a user's
network authentication to pass automatically to their enterprise mobile apps so they can get right to work.
 
The result is detailed visibility of all wired and wireless devices connecting to the enterprise, increased
control through simplified and automated authentication or authorization of devices, and faster, better
incident analysis and response through the integration of Aruba IntroSpect UEBA and third-party partner
ecosystems. This is achieved with a comprehensive and scalable policy management platform that goes
beyond traditional AAA solutions to deliver extensive enforcement capabilities for IT-owned and BYOD
security requirements.

Key Features
Role-based, unified network access enforcement across multi-vendor wireless, wired and VPN
networks.
Intuitive policy configuration templates and visibility troubleshooting tools.
Supports multiple authentication/authorization sources (AD, LDAP, SQL dB).
Self-service device onboarding with built-in certificate authority (CA) for BYOD.
Guest access with extensive customization, branding and sponsor-based approvals.
Integration with key EMM/MDM solutions for in-depth device assessments.
Comprehensive integration with the Aruba 360 Security Exchange Program.

QuickSpecs Aruba ClearPass Policy Manager Platform
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Single sign-on (SSO) support works with Ping, Okta and other identity management tools to improve
user experience to SAML 2.0-based applications.

The ClearPass Difference
ClearPass is the only policy platform that centrally enforces all aspects of enterprise-grade access security for any industry.
Granular policy enforcement is based on a user's role, device type and role, authentication method, EMM/MDM attributes,
device health, traffic patterns, location, and time-of-day.

Deployment scalability supports tens of thousands of devices and authentications which surpasses the
capabilities offered by legacy AAA solutions. Options exist for small to large organizations, from centralized
to distributed environments.

Advanced Policy Management
Enforcement and visibility for wired and wireless

With ClearPass, organizations can deploy wired or wireless using standards-based 802.1X enforcement for
secure authentication. ClearPass also supports MAC address authentication for IoT and headless devices
that may lack support for 802.1X. For wired environments where RADIUS based authentication cannot be
deployed, OnConnect, offers an alternative using SNMP based enforcement.
Authentication methods can be used to concurrently support a variety of use-cases. It also includes support
for multi- factor authentication based on log-in times, posture checks, and other context such as new user,
new device, and more.
Attributes from multiple identity stores such as Microsoft Active Directory, LDAP-compliant directory, ODBC-
compliant SQL database, token servers and internal databases across domains can be used within a single
policy for fine- grained control.
Contextual data from these profiled devices allows for IT to define what devices can access either the wired,
VPN, or wireless network. Device profile changes are dynamically used to modify authorization privileges.
For example, if a Windows laptop appears as a printer, ClearPass policies can automatically deny access.
 
Secure device configuration of personal devices

ClearPass Onboard provides automated provisioning of any Windows, macOS, iOS, Android, Chromebook,
and Ubuntu devices via a user driven self-guided portal. Network details, security settings and unique
device identity certificates are automatically configured on authorized devices. Cloud identity services like
Microsoft Azure Active Directory, Google G Suite and Okta can also be leveraged as identity providers with
Onboard for secure certificate enrollment.
 
Device health checks

ClearPass OnGuard delivers endpoint posture assessments over wireless, wired and VPN connections.
OnGuard's health-check capabilities ensure endpoints meet security and compliance policies before they
connect to the network.  OnGuard offers a variety of flexible deployment options including agentless,
disolvable agents and agent-based configuration.
 
Customizable visitor management

ClearPass Guest simplifies visitor workflow processes to enable employees, receptionists, and other non-IT
staff to create temporary guest accounts for secure wireless and wired access. Highly customizable, mobile
friendly portals provide easy-to-use login processes that include self- registration, sponsor approval, and
bulk credential creation support any visitor needs - enterprise, retail, education, large public venue.
Credentials can be delivered by SMS, email, printed badges, or input directly through cloud identity
providers such as Facebook or Twitter.
Built in support for commercial oriented guest Wi-Fi hotspots with credit card billing and 3rd party
advertising driven workflows make it simple to integrate into a wide variety of environments.

Aruba 360 Security Exchange Program
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Integrate with security and workflow systems

Support for the Aruba 360 Security Exchange Program is an integrated component of ClearPass. Using
features like REST- based APIs, RADIUS Accounting Proxy, and Syslog ingestion help facilitate workflows
with EMM/MDM, SIEM, firewalls, help-desk systems and more. Context is shared between each component
for end-to-end policy enforcement and visibility. The ClearPass Ingress Event Engine provides 3rd party
systems the means to share information in real-time using Syslog. This enables ClearPass to respond to
changing threats for users and devices after they have authenticated to the network. By utilizing an open
dictionary approach, anyone can write a parsing ruleset without the need for costly add-ons or locked in 3rd
party ecosystems.

Advanced Reporting and Alerting
ClearPass Insight provides advanced reporting capabilities via customizable reports. Information about
authentication trends, profiled devices, guest data, on-boarded devices, and endpoint health can also be
viewed in an easy to use dashboard. Insight also has support for granular alerts and a watchlist to monitor
specific authentication failures.

Specifications
Appliances

ClearPass is available as hardware or as a virtual appliance. Virtual appliances are supported on VMware
vSphere Hypervisor (ESXi), Microsoft Hyper-V, CentOS KVM & Amazon EC2.

VMware ESXi 6 up to 6.7
Microsoft Hyper-V 2012/2016 R2 and Windows 2012/2016 R2 Enterprise
KVM on CentOS 6.8
Amazon AWS (EC2) 

Platform

Deployment templates for any network type, identity store and endpoint
802.1X, MAC authentication and captive portal support
ClearPass OnConnect for SNMP-based enforcement on wired switches
Advanced reporting, analytics and troubleshooting tools
Interactive policy simulation and monitor mode utilities
Multiple device registration portals - Guest, Aruba AirGroup, BYOD, and un-managed devices
Admin/operator access security via CAC and TLS certificates 

Framework and protocol support

RADIUS, RADIUS CoA, TACACS+, web authentication, SAML v2.0
RadSec
EAP-FAST (EAP-MSCHAPv2, EAP-GTC, EAP-TLS)
PEAP (EAP-MSCHAPv2, EAP-GTC, EAP-TLS, EAP-PEAP- Public, EAP-PWD)
TTLS (EAP-MSCHAPv2, EAP-GTC, EAP- TLS, EAP-MD5, PAP, CHAP)
EAP-TLS
PAP, CHAP, MSCHAPv1 and 2, EAP-MD5
OAuth2
WPA3
Windows machine authentication
SMB v2/v3
Online Certificate Status Protocol (OCSP)
SNMP generic MIB, SNMP private MIB
Common Event Format (CEF), Log Event Extended Format (LEEF) 

Supported identity stores

Microsoft Active Directory
RADIUS
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Any LDAP compliant directory
MySQL, Microsoft SQL, PostGRES and Oracle 11g ODBC-compliant SQL server
Token servers
Built-in SQL store, static hosts list
Kerberos
Microsoft Azure Active Directory
Google G Suite 

RFC standards

2246, 2248, 2407, 2408, 2409, 2548, 2759, 2865, 2866, 2869, 2882, 3079, 3579, 3580, 3748, 3779, 4017,
4137, 4301, 4302, 4303, 4308, 4346, 4514, 4518, 4809, 4849, 4851, 4945, 5176, 5216, 5246, 5280, 5281,
5282, 5755, 5759, 6614, 6818, 6960, 7030, 7296, 7321, 7468, 7815, 8032, 8247 
Internet drafts

Protected EAP Versions 0 and 1, Microsoft CHAP extensions, dynamic provisioning using EAP-FAST,
TACACS+, draft-ietf- curdle-pkix-00 EdDSA, Ed25519, Ed448, Curve25519 and Curve448 for X.509, draft-
nourse-scep-23 (Simple Certificate Enrollment Protocol) 
Profiling methods

Active: Nmap, WMI, SSH, SNMP
Passive: MAC OUI, DHCP, TCP, Netflow v5/v10, IPFIX, sFLOW, ‘SPAN’ Port, HTTP User-Agent, IF-
MAP
Integrated & 3rd Party: Onboard, OnGuard, ArubaOS, EMM/MDM, Cisco device sensor

 
IPv6 Support

Web and CLI based management
IPv6 addressed authentication & authorization servers
IPv6 accounting proxy
IPv6 addressed endpoint context servers
Syslog, DNS, NTP, IPsec IPv6 targets
IPv6 Virtual IP for high availability
HTTP Proxy
Ingress Event Engine Syslog sources

 
Information assurance validations

FIPS 140-2 - Certificate #2577
Common Criteria NDcPP + Authentication Server (ClearPass)
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Ordering Guidance
Please refer to the ClearPass Scaling & Ordering Guide for detailed information on appropriate sizing and
required licensing to deploy ClearPass. This can be found on the Aruba support website in the ClearPass

documentation section.

   

Ordering Information
   

Description Part Number

   

Hardware Appliances  

Aruba ClearPass C1000 S-1200 R4 HW-Based Appliance JZ508A

Aruba ClearPass C2000 DL20 Gen9 HW-Based Appliance JZ509A

Aruba ClearPass C3000 DL360 Gen9 HW-Based Appliance JZ510A

   

Virtual Appliances  

Aruba ClearPass Cx000V VM-Based Appliance E-LTU JZ399AAE

   

Power Supplies  

Aruba ClearPass DL20 Spare Power Supply JX923A

Aruba ClearPass-Airwave DL360 500W Spare Power Supply JX922A

   

Hardware/Virtual Appliance Warranty  

1 year parts* Hardware

90 days* Software

   

* Extended with support contract  

   

Perpetual Licenses  

Aruba ClearPass New Licensing Access 100 Concurrent Endpoints E-LTU JZ400AAE

Aruba ClearPass New Licensing Access 500 Concurrent Endpoints E-LTU JZ401AAE

Aruba ClearPass New Licensing Access 1K Concurrent Endpoints E-LTU JZ402AAE

Aruba ClearPass New Licensing Access 2500 Concurrent Endpoints E-LTU JZ403AAE

Aruba ClearPass New Licensing Access 5K Concurrent Endpoints E-LTU JZ404AAE

Aruba ClearPass New Licensing Access 10K Concurrent Endpoints E-LTU JZ405AAE

Aruba ClearPass New Licensing Access 25K Concurrent Endpoints E-LTU JZ406AAE

Aruba ClearPass New Licensing Access 50K Concurrent Endpoints E-LTU JZ407AAE

Aruba ClearPass New Licensing Access 100K Concurrent Endpoints E-LTU JZ408AAE

Aruba ClearPass New Licensing Entry 100 Concurrent Endpoints E-LTU R1U35AAE

Aruba ClearPass New Licensing Entry 500 Concurrent Endpoints E-LTU R1U36AAE

Aruba ClearPass New Licensing Entry 1K Concurrent Endpoints E-LTU R1U37AAE

Aruba ClearPass New Licensing Entry 2500 Concurrent Endpoints E-LTU R1U38AAE

Aruba ClearPass New Licensing Entry 5K Concurrent Endpoints E-LTU R1U39AAE

Aruba ClearPass New Licensing Entry 10K Concurrent Endpoints E-LTU R1U40AAE

Aruba ClearPass New Licensing Entry 25K Concurrent Endpoints E-LTU R1U41AAE

Aruba ClearPass New Licensing Entry 50K Concurrent Endpoints E-LTU R1U42AAE

Aruba ClearPass New Licensing Entry 100K Concurrent Endpoints E-LTU R1U43AAE
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Aruba ClearPass New Licensing Access Upgrade 100 Concurrent Endpoints E-
LTU

R1U44AAE

Aruba ClearPass New Licensing Access Upgrade 500 Concurrent Endpoints E-
LTU

R1U45AAE

Aruba ClearPass New Licensing Access Upgrade 1K Concurrent Endpoints E-
LTU

R1U46AAE

Aruba ClearPass New Licensing Access Upgrade 2500 Concurrent Endpoints E-
LTU

R1U47AAE

Aruba ClearPass New Licensing Access Upgrade 5K Concurrent Endpoints E-
LTU

R1U48AAE

Aruba ClearPass New Licensing Access Upgrade 10K Concurrent Endpoints E-
LTU

R1U49AAE

Aruba ClearPass New Licensing Access Upgrade 25K Concurrent Endpoints E-
LTU

R1U50AAE

Aruba ClearPass New Licensing Access Upgrade 50K Concurrent Endpoints E-
LTU

R1U51AAE

Aruba ClearPass New Licensing Access Upgrade 100K Concurrent Endpoints E-
LTU

R1U52AAE

   

Perpetual Licenses Warranty  

90 days* Software

   

* Extended with support contract  

   

Subscription Licenses (1 Year)  

Aruba ClearPass New Licensing Access 100 Concurrent Endpoints 1yr E-STU JZ409AAE

Aruba ClearPass New Licensing Access 500 Concurrent Endpoints 1yr E-STU JZ410AAE

Aruba ClearPass New Licensing Access 1K Concurrent Endpoints 1yr E-STU JZ411AAE

Aruba ClearPass New Licensing Access 2500 Concurrent Endpoints 1yr E-STU JZ412AAE

Aruba ClearPass New Licensing Access 5K Concurrent Endpoints 1yr E-STU JZ413AAE

Aruba ClearPass New Licensing Access 10K Concurrent Endpoints 1yr E-STU JZ414AAE

Aruba ClearPass New Licensing Access 25K Concurrent Endpoints 1yr E-STU JZ415AAE

Aruba ClearPass New Licensing Access 50K Concurrent Endpoints 1yr E-STU JZ416AAE

Aruba ClearPass New Licensing Access 100K Concurrent Endpoints 1yr E-STU JZ417AAE

   

Subscription Licenses (3 Year)  

Aruba ClearPass New Licensing Access 100 Concurrent Endpoints 3yr E-STU JZ418AAE

Aruba ClearPass New Licensing Access 500 Concurrent Endpoints 3yr E-STU JZ419AAE

Aruba ClearPass New Licensing Access 1K Concurrent Endpoints 3yr E-STU JZ420AAE

Aruba ClearPass New Licensing Access 2500 Concurrent Endpoints 3yr E-STU JZ421AAE

Aruba ClearPass New Licensing Access 5K Concurrent Endpoints 3yr E-STU JZ422AAE

Aruba ClearPass New Licensing Access 10K Concurrent Endpoints 3yr E-STU JZ423AAE

Aruba ClearPass New Licensing Access 10K Concurrent Endpoints 3yr E-STU JZ423AAE

Aruba ClearPass New Licensing Access 10K Concurrent Endpoints 3yr E-STU JZ423AAE

Aruba ClearPass New Licensing Access 10K Concurrent Endpoints 3yr E-STU JZ423AAE

   

Subscription Licenses (5 Year)  

Aruba ClearPass New Licensing Access 100 Concurrent Endpoints 5yr E-STU JZ427AAE

Aruba ClearPass New Licensing Access 500 Concurrent Endpoints 5yr E-STU JZ428AAE

Aruba ClearPass New Licensing Access 1K Concurrent Endpoints 5yr E-STU JZ429AAE
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Aruba ClearPass New Licensing Access 2500 Concurrent Endpoints 5yr E-STU JZ430AAE

Aruba ClearPass New Licensing Access 5K Concurrent Endpoints 5yr E-STU JZ431AAE

Aruba ClearPass New Licensing Access 10K Concurrent Endpoints 5yr E-STU JZ432AAE

Aruba ClearPass New Licensing Access 25K Concurrent Endpoints 5yr E-STU JZ433AAE

Aruba ClearPass New Licensing Access 50K Concurrent Endpoints 5yr E-STU JZ434AAE

Aruba ClearPass New Licensing Access 100K Concurrent Endpoints 5yr E-STU JZ435AAE

   

Customized Guest Portal  

Aruba ClearPass Guest Custom Skin Delivery E-LTU JW470AAE

   

Expandable application software  

ClearPass Onboard - device configuration and certificate management Refer to ClearPass
Onboard Datasheet

ClearPass OnGuard - endpoint device health Refer to ClearPass
Onboard Datasheet
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C1000 Appliance

(JZ508A)

C2000 Appliance

(JZ509A)

C3000 Appliance

(JZ510A)

 

Hardware Model Unicom S-1200 R4 HPE DL20 Gen 9 HPE DL360 Gen 9

CPU
(1) Eight Core 2.4GHz Atom

C2758

(1) Xeon 3.5Ghz E3-
1240v5 with Four Cores

(8 Threads)

(2) Xeon 2.4GHz E5-
2620_V3 with Six Cores

(12 Threads)

Memory 8 GB 16 GB 64 GB

Hard drive storage
(1) SATA (7.3K RPM)

1TB hard drive

(2) SATA (7.2K RPM) 1TB
hard drives, RAID-1

controller

(6) SAS (10K RPM)
600GB Hot-Plug hard

drives, RAID-10
controller

Out of Band
Management

N/A
HPE Integrated Lights-Out

(iLO) Standard
HPE Integrated Lights-

Out (iLO) Advanced

Serial Port Yes (RJ-45) Yes (Virtual Serial via iLO) Yes (DB-9)

Performance & Scale
Please refer to the

ClearPass  Scaling &
Ordering Guide

Please refer to the
ClearPass  Scaling &

Ordering Guide

Please refer to the
ClearPass  Scaling &

Ordering Guide

Form Factor

Dimensions (WxHxD) 17.2” x 1.7” x 11.3” 17.11” x 1.70” x 15.05” 17.1” x 1.7” x 27.5”

Weight (Max Config) 8.5 Lbs Up to 19.18 Lbs Up to 33.3 Lbs

Power

Power supply 200 watts max
HPE 900W AC 240VDC

Power Input FIO Module*

HPE 500W Flex Slot
Platinum Hot Plug Power

Supply

Power redundancy N/A Optional Optional

AC input voltage 100/240 VAC auto-selecting 100/240 VAC auto-selecting 100/240 VAC auto-selecting
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AC input frequency 50/60 Hz auto-selecting 50/60 Hz auto-selecting 50/60 Hz auto-selecting

Environmental

Operating temperature
5º C to 35º C

(41º F to 95º F)
10º C to 35º C
(50º F to 95º F)

10º C to 35º C
(50º F to 95º F)

Operating vibration
0.25 G at 5 Hz to 200 Hz for 15

minutes

Random vibration at 0.000075
G²/Hz, 10Hz to 300Hz, (0.15

G’s nominal)

Random vibration at 0.000075
G²/Hz, 10Hz to 300Hz, (0.15

G’s nominal)

Operating shock 1 shock pulse of 20 G for up to
2.5 ms

2 G's 2 G's

Operating altitude -16 m to 3,048 m
(-50 ft to 10,000 ft)

3,050 m (10,000 ft) 3,050 m (10,000 ft)

 
*The HPE 900W Redundant Power Supply supports100VAC to 240VAC and also supports 240VDC..
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Date Version History Action Description of Change

04-Mar-2018 Version 5 Added SKUs added: R1U35AAE,
R1U36AAE, R1U37AAE,
R1U38AAE, R1U39AAE,
R1U40AAE, R1U41AAE,
R1U42AAE, R1U43AAE,
R1U44AAE, R1U45AAE,
R1U46AAE, R1U47AAE,
R1U48AAE, R1U49AAE,
R1U50AAE, R1U51AAE, R1U52AAE

Changed Overview section updated
18-Dec-2017 Version 4 Changed Minor edit on Configuration section
04-Dec-2017 Version 3 Added SKUs added: JZ508A, JZ509A,

JZ510A, JZ399AAE, JX923A
Changed All document sections updated

07-Nov-2016 Version 2 Added SKUs added: JW771A, JW772A
01-Nov-2016 Version 1 Created Document creation.

     

Sign up for updates

 

 
 

© Copyright 2019 Hewlett Packard Enterprise Development LP. The

information contained herein is subject to change without notice. The only

warranties for Hewlett Packard Enterprise products and services are set forth

in the express warranty statements accompanying such products and services.

Nothing herein should be construed as constituting an additional warranty.

Hewlett Packard Enterprise shall not be liable for technical or editorial errors or

omissions contained herein.

To learn more, visit: http://www.hpe.com/networking
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Resultado da pesquisa da Central de Serviços de Suporte

Serviços de Suporte HPE - Simplificar, salvar e proteger

Os Serviços de Suporte permitem que você se concentre em sua atividade principal, fornecendo um poderoso portfólio de serviços para proteger seu negócio de TI, preservando os ativos
digitais e as informações confidenciais com consistência global.

Data 10/09/2019

Número do Produto H9XB3E

Nome do Produto Aruba 3 Year Foundation Care 24x7 ClearPass NL AC 500 CE E-LTU Service

País  BR

Visão geral
O Suporte técnico de Software HPE proporciona serviços gerais e atualizações que lhe ajudam a melhorar o rendimento e a disponibilidade do software HPE e dos importantes
fornecedores.

Benefícios
Contato direto com os engenheiros do Centro de resposta HPE para assistência através de comunicação telefônica ou eletrônica.

Recepção de assistência para solução de problemas e ajuste de parâmetros de configuração.

O completo software HPE e de terceiros e as atualizações da documentação a disposição do gestor do sistema.

Acesso a assistência eletrônica HPE para obter patches de software, uma bse de dados de soluções sintomáticas, descrições do produto, especificações, documentação técnica, etc.

Especificações
Cobertura de garantia In Warranty

Resposta 2 hour SW response

Período de Cobertura 24 horas por dia, 7 dias por semana

ServiceType Foundation Care

Duração 3 anos

Método de serviço SW Support
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Observação: Os níveis de serviço e tempos de resposta para os Serviços de Suporte Hewlett Packard Enterprise podem variar de acordo com sua localização geográfica. O serviço tem
início na data da compra do hardware. Restrições e limitações são aplicáveis. Os serviços HPE são regidos pelos termos e condições de serviço HPE aplicáveis fornecidos ou indicados para
o cliente no momento da compra. O cliente pode ter direitos legais obrigatórios adicionais, de acordo com as leis locais aplicáveis, e tais direitos não são afetados de qualquer forma pelos
termos e condições de serviço HPE ou pela garantia limitada HPE fornecida com o seu produto HPE.Para garantir a precisão dos Serviços de Suporte HPE, retorne à primeira página,
verifique se o país selecionado está correto e insira um número de produto ou número de série de hardware ou software específico para o qual deseja encontrar Serviços de Suporte HPE.

Saiba mais em www.hpe.com/services/ssc

Planos de serviços estendidos permitem estender a cobertura de serviços além do período de garantia básica e estão disponíveis em incrementos de um ano para durações de um a cinco
anos.

Consulte a Folha de dados e os termos e condições dos Serviços de Suporte Hewlett Packard Enterprise para obter os detalhes completos.
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Worldwide support numbers for these product 

families:*

 – Aruba products

 – HPE Nimble Storage products

Support matrix

Technical Support Phone Numbers

Country Support type Support phone number Hours of operations

Aland Contract +358 20 320 300 24x7

Warranty and Out of Warranty +358 20 353 232 M–F 8:00–17:00

Albania Contract & Warranty/Out of Warranty +355 42 322 411 24x7

Algeria Contract & Warranty/Out of Warranty +216 23 92 5000 24x7

Andorra Contract +34 902 220 030 24x7

Warranty and Out of Warranty +34 902 010 333 M–F 8:30–17:30

Angola Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Anguilla Contract & Warranty 1-800-225-5288 then 

844 692-8150

24x7

Antigua and Barbuda Contract & Warranty #1 then 844 692-8151 24x7

Argentina Contratos 0 800 444 7867

+52 55 5258 4500

24x7

Garantías 0 800 333 4857

+52 55 1500 3155

M–F 8:00–17:00

Armenia Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Aruba Contract & Warranty +1 844 264 1328 24x7

Australia Contract & Warranty/Out of Warranty 13 11 47

+61 2 8031 8315

24x7

Azerbaijan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

* For all other product types, please call the support number for your country listed in this document.
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Support matrix Page 2

Country Support type Support phone number Hours of operations

Bahamas Contract & Warranty 1-800-872-2881 then 

844 692-8152

24x7

Bahrain Contract & Warranty/Out of Warranty +973 1 619 82 94 24x7

Barbados Contract & Warranty 1-800-225-5288 then 

844 692-8153

24x7

Belarus Contract & Warranty/Out of Warranty 8 8200 073 01 01

+7 495 411 69 07

24x7

Belgium Contract 078 250 144

+32 26 200 055

24x7

Warranty and Out of Warranty 078 600 600

+32 26 200 099

M–F 8:00–17:00

Belize Contract & Warranty 811 then 844 692-8148 24x7

Benin Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Bermuda Contract & Warranty 1-800-225-5288 then 

844 692-8154

24x7

Bolivia Contratos 800 110 348

+52 55 5258 4500

24x7

Garantías 800 110 348

+52 55 1500 3155

M–F 8:00–17:00

Bonaire (Sint Eustatius, Saba) Contract & Warranty 001-800-872-2881 then 

844 752-2839

24x7

Bosnia and Herzegovina Contract & Warranty/Out of Warranty +387 338 219 22 24x7

Botswana Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Bouvet Island Contract & Warranty/Out of Warranty 800 56 044 24x7

Brasil Contract 0800 55 6405

+55 11 3173 8802 

+55 11 4688 5102

24x7

Warranty 0800 710 2029

+55 11 2377 1002 

+55 11 2377 0002

M–F 8:00–17:00
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Support matrix Page 3

Country Support type Support phone number Hours of operations

British Indian Ocean Territory Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

British Virgin Islands Contract & Warranty 1-800-872-2881 then 

844 692-8156

24x7

Bulgaria Contract & Warranty/Out of Warranty 0700-1-47-47 24x7

Burkina Faso Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Burundi Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Cameroon Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Canada Contract

Contrat

1-800-633-3600 24x7

Warranty and Out of Warranty

Produits garantis et hors garantie

1-844-806-3425 24x7 for most products

Cape Verde Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Cayman Islands Contract & Warranty 1-800-225-5288 then 

844 692-8157

24x7

Central African Republic Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Chad Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Chile Contratos 800 362 365

+52 55 5258 4500

24x7

Garantías 800 123 605

+52 55 1500 3155

M–F 8:00–17:00

Collectivity of Saint Martin Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Colombia Contratos 01 800 051 4747

+57 1 6004150

24x7

Garantías 800 051 7127

+52 55 1500 3155

M–F 9:00–18:00

Comoros Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7
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Support matrix Page 4

Country Support type Support phone number Hours of operations

Costa Rica Contratos 800 794 4401

+52 55 5258 4500

24x7

Garantías 800 794 4401

+52 55 1500 3155

M–F 8:00–17:00

Croatia Contract & Warranty/Out of Warranty 0800 303 556 24x7

Curaçao Contract & Warranty 001-800-872-2881 then 

844 264-1326

24x7

Cyprus Contract & Warranty/Out of Warranty 801 11 47 22 73

+30 211 181 3846

24x7

Czech Republic Contract & Warranty/Out of Warranty 239 018 791 24x7

Denmark Contract +45 70 10 80 25 24x7

Warranty and Out of Warranty +45 70 11 77 00 M–F 8:00–17:00

Deutschland Dienstleistungsverträge/Contracts +49 69 380 789 143 24x7

Produkte innerhalb und außerhalb der Herstellergarantie +49 69 380 789 142 Montag–Freitag

8:00–17:00

(außer an bundeseinheitlichen Feiertagen)

Djibouti Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Dominica Contract & Warranty 1-800-225-5288 then 

844 264-1327

24x7

Dominican Republic Contract & Warranty 1-888-225-5288 then 

844 264-1328

+52 55 5258 4500

24x7

Ecuador Contratos 1-800-225-528 then 

844 845-8165

+52 55 5258 4500

24x7

Garantías 1-800-225-528 then 

844 845-8165

+52 55 1500 3155 

M–F 8:00–17:00

Egypt Contract & Warranty/Out of Warranty 0800 000 0814

+20 2 353 131 62

24x7
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Country Support type Support phone number Hours of operations

El Salvador Contratos 800-1785 then 

844 845-8167

+52 55 5258 4500

24x7

Garantías 800-1785 then 

844 845-8167

+52 55 1500 3155 

M–F 8:00–17:00

Equatorial Guinea Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Eritrea Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

España Contrato de Mantenimiento +34 902 220 030

+34 913496569

24x7

Garantía y fuera de garantía +34 902 010 333

+34 913496559

Lunes a viernes, 8:30 a 17:30 de julio y agosto,  

8:30 a 14:30

Estonia Contract & Warranty/Out of Warranty +372 686 88 71 24x7

Ethiopia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Falkland Islands Contract & Warranty/Out of Warranty +44 845 161 0050 24x7

Faroe Islands Contract +45 70 10 80 25 24x7

Warranty and Out of Warranty +45 70 11 77 00 M–F 8:00–17:00

Finland Contract +358 20 320 300 24x7

Warranty and Out of Warranty +358 20 353 232 M–F 8:00–17:00

France Contrat 0825 00 41 23

+33 173018471

24x7

Ligne payante au tarif local en France

Garantie et Hors Garantie 0826 10 49 49

+33 173018475

Lundi–Vendredi 

8:30–18:00

(à l’exception des jours fériés et jours de fermeture d’HPE)

French Guiana Contract & Warranty 0800 99 00 11 then 

844 264-1329

24x7

French Polynesia Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

French Southern Territories Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Gabon Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7
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Support matrix Page 6

Country Support type Support phone number Hours of operations

Gambia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Georgia Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Ghana Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Gibraltar Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

Greece Contract & Warranty/Out of Warranty 801 11 47 22 73

+30 211 181 3846

24x7

Greenland Contract +45 70 10 80 25 24x7

Warranty and Out of Warranty +45 70 11 77 00 M–F 8:00–17:00

Grenada Contract & Warranty 1-800-225-5288 then 

844 264-1330

24x7

Guadeloupe Contract & Warranty 0-800-99-0011 then 

844 264-1331

24x7

Guatemala Contratos 999-9190 then 

844 845-8169

+52 55 5258 4500

24x7

Garantías 999-9190 then 

844 845-8169

+52 55 1500 3155

M–F 8:00–17:00

Guernsey Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

Guinea Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Guinea-Bissau Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Guyana Contract & Warranty 159 then 844 752-2835 24x7

Haiti Contract & Warranty +1 844 264 1328 24x7
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Country Support type Support phone number Hours of operations

Honduras Contratos 800-0-123 then 

844 752-2837

+52 55 5258 4500

24x7

Garantías 800-0-123 then 

844 752-2837

+52 55 1500 3155 

M–F 8:00–17:00

Hong Kong Contract +852 2292 3333 24x7

Alpha, ProLiant, and attached HPE Storage Systems

Warranty +852 3071 3873 M–F 8:30–17:30

HPE Networking, UNIX® system, NetServer, and attached 

HPE Storage systems 

Warranty +852 2904 8338 24x7

ProLiant & attached 

HPE Storage Systems 

Value line (need PIN code during AOH)

Hungary Contract 1 778 9670 24x7

Warranty and Out of Warranty 1 778 9669 M–F 9:00–17:00

Iceland Contract +47 800 56 044 24x7

Warranty and Out of Warranty +47 800 62 800 M–F 8:00–17:00

India Warranty 1800 419 8080 (Callers in India)

+91 806 703 7209 (International Callers)

M–F 9:00–18:00

Indonesia Contract & Warranty 0018 0385 20668

+62 21 5799 4050

24x7

Iran Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Iraq Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Ireland Contract 1850 924 590

+ 353 1 4118915

24x7

Warranty and Out of Warranty 1890 946 500

+ 353 1 4118912

M–F 8:00–18:00

(except Bank Holidays)

Isle of Man Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

Anexo I A IV - ITEM 04 (0592586)         SEI 0008478-63.2018.6.02.8000 / pg. 3679



Support matrix Page 8

Country Support type Support phone number Hours of operations

Israel Contract & Warranty/Out of Warranty 1-809-400-300

+972 3-3726489

24x7

Italia Contratti 02 452 790 50 24x7

In garanzia o fuori garanzia 02 385 912 12 Lunedì–Venerdì 8:00–17:00

Ivory Coast Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Jamaica Contract & Warranty 1-800-872-2881 then 

844 264-1332

24x7

日本 Warranty support.hpe.com/hpsc/doc/public/display?docId=emr_

na-c04770344

Jersey Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

Jordan Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Kazakhstan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Kenya Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Kosovo Contract & Warranty/Out of Warranty 0800 300 003/0800 190 038 (Serbia)

035 542 322 411 (Albania)

24x7

Kuwait Contract & Warranty/Out of Warranty 632 9930 24x7

Kyrgyzstan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Latvia Contract & Warranty/Out of Warranty 678 521 84 24x7

Lebanon Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Lesotho Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Liberia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Libya Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Liechtenstein Contract +41 0848 800 724 24x7

Warranty and Out of Warranty +41 0848 80 20 20 M–F 8:00–18:00

Lithuania Contract & Warranty/Out of Warranty +370 521 415 92 24x7
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Support matrix Page 9

Country Support type Support phone number Hours of operations

Luxembourg Contract +352 27 303 111 24x7

Warranty and Out of Warranty +352 27 303 303 M–F 8:00–17:00

Macedonia Contract & Warranty/Out of Warranty 0800 90 472 24x7

Madagascar Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Malawi Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Malaysia Contract & Warranty 1800 88 1811 (Callers in Malaysia)

+60 3 6207 4533 (International Callers)

24x7

Mali Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Malta Contract & Warranty/Out of Warranty +356 27 781 269 24x7

Martinique Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Mauritania Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Mauritius Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Mayotte Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

México Contratos 800 501 9800

+52 55 5258 4500

24x7

Garantías 800 890 6348

+52 55 1500 3155

M–F 8:00–17:00

Moldova Contract & Warranty/Out of Warranty +7 499 272 37 82 24x7

Monaco Contrat +33 1 73 01 84 71 24x7

Ligne payante au tarif local en France

Garantie et Hors Garantie +33 1 73 01 84 75 Lundi–Vendredi 

8:30–18:00

(à l’exception des jours fériés et jours de fermeture d’HPE)

Montenegro Contract & Warranty/Out of Warranty 0800 300 003 24x7

Montserrat Contract & Warranty 1-800-225-5288 then 

844 264-1333

24x7

Morocco Contract & Warranty/Out of Warranty 00 212 5 22 24 87 70

+44 1793 794886

24x7
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Country Support type Support phone number Hours of operations

Mozambique Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Namibia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Netherlands Contract 0900 115 0000

+31 205 040 666

24x7

Warranty and Out of Warranty 0900 117 0000 M–F 8:00–17:00

New Caledonia Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

New Zealand Contract & Warranty/Out of Warranty 0800 664 747

+61 2 8031 8316

24x7

Nicaragua Contratos 1-800-0164 then 

844 752-2840

+52 55 5258 4500

24x7

Garantías 1-800-0164 then 

844 752-2840

+52 55 1500 3155

M–F 8:00–17:00

Niger Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Nigeria Contract & Warranty/Out of Warranty 01 27 14 777

+44 203 564 4148

24x7

Norway Contract 800 56 044 24x7

Warranty and Out of Warranty 800 62 800 M–F 8:00–17:00

Oman Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Österreich Dienstleistungsverträge/Contracts 08 1000 2000 24x7

Produkte innerhalb und ausserhalb der

Herstellergarantie

08 1000 1000 M–F 8:00–18:00

Palestinian Territory Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Panama Contratos 800-2288 then 

844 845-8163

+52 55 5258 4500

24x7

Garantías 800-2288 then 

844 845-8163

+52 55 1500 3155 

M–F 8:00–17:00
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Paraguay Contratos 008-11-800 then 

844 752-2842

+52 55 5258 4500

24x7

Garantías 008-11-800 then 

844 752-2842

+52 55 1500 3155 

M–F 8:00–17:00

Perú Contratos 0 800 1 9703

+52 55 5258 4500

24x7

Garantías 0800 44 366

+52 55 1500 3155 

M–F 8:00–17:00

Philippines Contract & Warranty 1800 1441 0669

 1800 8908 6404

+63 2395 3565

24x7

Poland Contract & Warranty/Out of Warranty 0 800 702 284

(22) 306 04 84

24x7

Portugal Contract 808 203 203 24x7

Warranty and Out of Warranty 213 164 164 M–F 9:00–18:00

Puerto Rico Contratos 844 752-2843

+52 55 5258 4500

24x7

Garantías 844 752-2843

+52 55 1500 3155 

M–F 8:00–17:00

Qatar Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Republic of Congo Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Réunion Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Romania Contract & Warranty/Out of Warranty +40 317 305 020 24x7

Россия Поддержка 8 800 500 92 55

+7 495 411 69 07

24x7

Rwanda Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Saint Barthélemy Contract 0-800-990-011 then 

844 845-8168

24x7

Warranty and Out of Warranty +212 5 22 24 87 70 24x7
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Saint Helena (Ascension and Tristan da Cunha) Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Saint Kitts and Nevis Contract & Warranty 1-800-225-5288 then 

844 264-1334

24x7

Saint Lucia Contract & Warranty/Out of Warranty 1 844 231 8954 24x7

Saint Pierre and Miquelon Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Saint Vincent and the Grenadines Contract & Warranty 1-800-225-5288 then 

844 845-8160

24x7

San Marino Contract 02 452 790 50 24x7

Warranty and Out of Warranty 02 385 912 12 M–F 8:00–17:00

Sao Tome and Principe Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Saudi Arabia Contract & Warranty/Out of Warranty 800 844 4611 24x7

Schweiz
Suisse

Dienstleistungsvertrag/

Contrat de services

0848 800 724

+41 43 557 9021

24x7

8Rp./Min*

Herstellergarantie/

Produits garantis

0848 80 20 20

+41 44 200 4115

Montag–Freitag

Lundi–Vendredi

8:00–17:00

(außer Feiertage) 

8Rp./Min*

*aus dem schweizerischen Festnetz; abweichende Preise aus 

Mobilfunknetzen sind je nach Anbieter möglich.

Senegal Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Serbia Contract & Warranty/Out of Warranty 0800 300 003

0800 190 038 

24x7

Seychelles Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Sierra Leone Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Singapore Contract & Warranty 1800 272 4333 (Callers in Singapore)

+65 6272 4333 (International Callers)

24x7

Sint Maarten Contract & Warranty 800-99-0011 then 

844 264-1335

24x7
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Slovakia Contract & Warranty/Out of Warranty 02 686 221 79 24x7

Slovenia Contract & Warranty/Out of Warranty 0800 80 745 24x7

Somalia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

South Africa Contract 0860 001 020 24x7

Warranty and Out of Warranty 0860 001 030 M–F 8:00–17:00

(except public Holidays)

South Georgia and the South Sandwich Islands Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

대한민국 Contract & Warranty +82 1577 3270 M–F 09:00–18:00

Server & Storage

Contract & Warranty +82 1588 0142 M–F 09:00–18:00

Networking

South Sudan Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Sudan Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Suriname Contract & Warranty/Out of Warranty 156 then 844 231-8955 24x7

Svalbard and Jan Mayen Contract +47 800 56 044 24x7

Warranty and Out of Warranty +47 800 62 800 M–F 8:00–17:00

Swaziland Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Sweden Contract 0771 30 30 50 24x7

Warranty and Out of Warranty 0771 30 30 00 M–F 8:00–17:00

Syria Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Taiwan Contract & Warranty 0800 211 666

+886 2 2656 7204

M–F 8:30–17:30

Tajikistan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7
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Support matrix Page 14

Country Support type Support phone number Hours of operations

Tanzania Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Thailand Contract 1800 441 4048

+66 2 118 6000

24x7

Warranty 1800 441 4085

+66 2 118 6300

M–F 8:30–17:30

The Democratic Republic of Congo Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Togo Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Trinidad and Tobago Contract & Warranty/Out of Warranty 1-800-872-2881 then 

844 845-8161

24x7

Tunisia Contract & Warranty/Out of Warranty +216 23 92 5000 24x7

Turkey Contract 850 759 0 724

+90 850 759 0 724

24x7

Warranty and Out of Warranty 850 759 0 473

+90 850 759 0 473

08:30–17:30 GMT+3

Turkmenistan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Turks and Caicos Islands Contract & Warranty 1-800-225-5288 then 

844 845-8162

24x7

Uganda Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Ukraine Contract & Warranty/Out of Warranty 0 800 501 526 24x7

United Arab Emirates Contract & Warranty/Out of Warranty 800 0444 1477 24x7

United Kingdom Contract 0845 161 0050 24x7

Warranty and Out of Warranty 0845 161 0030 M–F 8:00–18:00

United States Contract 1-800-633-3600 24x7

Warranty and Out of Warranty 1-844-806-3425 24x7

Uruguay Contratos 0004 110 032 632

+52 55 5258 4500

24x7

Garantías 0004 110 032 632

+52 55 1500 3155 

M–F 8:00–17:00
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Country Support type Support phone number Hours of operations

US Virgin Islands Contract & Warranty +1 844 845-8164 24x7

Uzbekistan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Vatican City Contract 02 45279050 24x7

Warranty and Out of Warranty 02 38591212 M–F 8:00–17:00

Venezuela Contratos & Garantías +58 212 7102103 24x7

Vietnam Contract & Warranty +84 28 4458 2390 24x7

Wallis and Futuna Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Western Sahara Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Yemen Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Zambia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Zimbabwe Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7
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Aruba 3810M Switch Series
 

 

Models
Aruba 3810M 24G 1-slot Switch JL071A
Aruba 3810M 48G 1-slot Switch JL072A
Aruba 3810M 24G PoE+ 1-slot Switch JL073A
Aruba 3810M 48G PoE+ 1-slot Switch JL074A
Aruba 3810M 16SFP+ 2-slot Switch JL075A
Aruba 3810M 40G 8 HPE Smart Rate PoE+ 1-slot Switch JL076A
Aruba 3810M 48G PoE+ 4SFP+ 680W Switch JL428A
Aruba 3810M 48G PoE+ 4SFP+ 1050W Switch JL429A
Aruba 3810M 24SFP+ 250W Switch JL430A

 

Key features
Advanced Layer 3 switch series with backplane stacking, dynamic segmentation, low latency and
resiliency
Advanced security and network management via Aruba ClearPass Policy Manager, Aruba AirWave
and Aruba Central
Modular 10GbE and 40GbE uplinks for wireless aggregation
HPE Smart Rate for high-speed multi-gigabit capacity and PoE+ power
Software-defined ready with REST APIs and OpenFlow support
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Product overview
The Aruba 3810 Switch Series provides performance and resiliency for enterprises, SMBs, and branch
office networks. With HPE Smart Rate multi-gigabit ports for high speed access points and IoT devices, this
advanced Layer 3 network switch delivers a better application experience with low latency, virtualization with
resilient stacking technology, and line rate 40GbE for plenty of back haul capacity. 
A powerful Aruba ProVision ASIC delivers performance, robust feature support, and value with flexible
programmability for the latest applications.  The 3810 delivers resiliency and scalability via innovative
backplane stacking technology and redundant, hot-swappable power supplies all in a convenient 1U form
factor.  It supports an advanced Layer 2 and 3 feature set with OSPF, IPv6, IPv4 BGP, Dynamic
Segmentation, robust QoS, and policy-based routing are included with no software licensing. 
The 3810M is easy to deploy, use and manage using Aruba AirWave or Aruba Central. Aruba ClearPass
offers centralized security and external captive portal support.  The switches offer a limited lifetime warranty.

 

Enhanced Capabilities and benefits
Software-defined networks

Supports multiple programmatic interfaces
including REST APIs and Openflow 1.0 and 1.3, to enable automation of network operations,
monitoring, and troubleshooting.

Unified Wired and Wireless Support

ClearPass Policy Manager support
unified wired and wireless policies using Aruba ClearPass Policy Manager
Switch auto-configuration
automatically configures switch for different settings such as VLAN, CoS, PoE max power, and PoE
priority when an Aruba access point is detected.
User role
defines a set of switch-based policies in areas such as security, authentication, and QoS. A user role
can be assigned to a group of users or devices, using switch-based local user role or download from
ClearPass
Dynamic segmentation
provides a secured tunnel to transport network traffic on a per-port or per-user-role basis to an Aruba
Controller.  In per-user-role Tunneled Node, users are authenticated with ClearPass Policy Manager
which can direct the traffic to be tunneled to Aruba controller or switch locally.
Static IP visibility
provides a way for ClearPass to do accounting for clients with static IP addresses

Quality of Service (QoS)

Advanced classifier-based QoS
classifies traffic using multiple match criteria based on Layer 2, 3, and 4 information; applies QoS
policies such as setting priority level and rate limit to selected traffic on a per-port or per-VLAN basis
Layer 4 prioritization
based on TCP/UDP port numbers
Class of Service (CoS)
sets the IEEE 802.1p priority tag based on IP address, IP Type of Service (ToS), Layer 3 protocol,
TCP/UDP port number, source port, and DiffServ
Bandwidth shaping:

- Port-based rate limiting: provides per-port ingress-/egress-enforced increased bandwidth
- Classifier-based rate limiting: uses an access control list (ACL) to enforce increased bandwidth

for ingress traffic on each port
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- Reduced bandwidth: provides per-port, per-queue egress-based reduced bandwidth

Remote intelligent mirroring
mirrors selected ingress/egress traffic based on an ACL, port, MAC address, or VLAN to a local or
remote HPE 8200 zl, 6600, 6200 yl, 5400 zl, or 3500 switch anywhere on the network
Remote monitoring (RMON), Extended RMON (XRMON), and sFlow v5
provide advanced monitoring and reporting capabilities for statistics, history, alarms, and events
Traffic prioritization
allows real-time traffic classification into eight priority levels that are mapped to eight queues
Unknown Unicast Rate Limiting
throttles unicast packets with unknown destination addresses and limits flooding on the VLAN

Simplified management and configuration

Flexible management
supports both cloud-based Central and on-premise AirWave without ripping and replacing switching
infrastructure
Aruba Central cloud-based management platform
offers simple, secure, and cost effective way to manage switches
Built-in programmable and easy to use REST API interface
provides configuration automation for campus networks
Friendly port names
allows assignment of descriptive names to ports
IEEE 802.1AB Link Layer Discovery Protocol (LLDP)
advertises and receives management information from adjacent devices on a network, facilitating easy
mapping by network management applications
Command authorization
leverages RADIUS to link a custom list of CLI commands to an individual network administrator's login;
an audit trail documents activity
Multiple configuration files
stores easily to the flash image
Dual flash images
provides independent primary and secondary operating system files for backup while upgrading
Out-of-band Ethernet management port
enables management over a separate physical management network; and keeps management traffic
segmented from network data traffic
Zero Touch ProVisioning (ZTP)
simplifies installation of the switch infrastructure using the Aruba Activate-based or a DHCP-based
process with AirWave and Central Network Management
Unidirectional Link Detection (UDLD)
monitors the link between two switches and blocks the ports on both ends of the link if the link goes
down at any point between the two devices
IP service level agreements (SLA) for voice
monitor quality of voice traffic using the UDP jitter and UDP jitter for VoIP tests

Connectivity

Jumbo frames on Gigabit Ethernet and 10-Gigabit Ethernet ports
allow high-performance remote backup and disaster-recovery services
IEEE 802.3at Power over Ethernet (PoE+)
provides up to 30 W per port that allows support of the latest PoE+ capable devices such as IP
phones, wireless access points, and security cameras, as well as any IEEE 802.3af compliant end
device; eliminates the cost of additional electrical cabling and circuits that would otherwise be
necessary in IP phone and WLAN deployments
Support for pre-standard PoE
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detects and provides power to pre-standard PoE devices
Choice of uplinks:

- SFP+ uplink models: provide fiber-optic (up to 70 km) or direct-attach-cable (DAC) connectivity
- 10GBASE-T uplink models: offer 10GbE speeds, using standard RJ-45 connectors and

standard twisted-pair cabling up to 100 m

Auto-MDIX
provides automatic adjustments for straight-through or crossover cables on all RJ-45 ports
IPv6:

- IPv6 host: enables switch management in an IPv6 network
- Dual stack (IPv4 and IPv6): transitions IPv4 to IPv6, supporting connectivity for both protocols
- MLD snooping: forwards IPv6 multicast traffic to the appropriate interface
- IPv6 ACL/QoS: supports ACL and QoS for IPv6 traffic
- IPv6 routing: supports static, RIPng, OSPFv3 routing protocols
- 6in4 tunneling: supports encapsulation of IPv6 traffic in IPv4 packets
- Security: provides RA guard, DHCPv6 protection, dynamic IPv6 lockdown, and ND snooping

Performance and efficiency

Selectable queue configurations
allows for increased performance by selecting the number of queues and associated memory buffering
that best meet the requirements of the network applications
Energy-efficient design:

- 80 PLUS Silver Certified power supply: increases power efficiency and savings
- Energy-efficient Ethernet (EEE) support: reduces power consumption in accordance with

IEEE 802.3az

Meshed stacking technology:
- High-performance stacking: provides up to 336 Gb/s of stacking throughput; each 4-port

stacking module can support up to 42 Gb/s in each direction per stacking port
- Ring, chain, and mesh topologies: support up to a 10-member ring or chain and 5-member

fully meshed stacks; meshed topologies offer increased resiliency vs. a standard ring
- Virtualized switching: provides simplified management as the switches appear as a single

chassis when stacked

Aruba ProVision ASIC
provides very low latency, increased packet buffering, and adaptive power consumption

Resiliency and high availability

Virtual Router Redundancy Protocol (VRRP)
allows groups of two routers to dynamically back each other up to create highly available routed
environments in IPv4 and IPv6 networks
Nonstop switching and routing
improves network availability to better support critical applications, such as unified communication and
mobility; traffic will continue to be forwarded during failovers, when the backup member of the stack
becomes the commander
IEEE 802.3ad Link Aggregation Protocol (LACP) and Hewlett Packard Enterprise port trunking
support up to 144 trunks, each with up to 8 links (ports) per trunk
IEEE 802.1s Multiple Spanning Tree
provides high link availability in multiple VLAN environments by allowing multiple spanning trees;
provides legacy support for IEEE 802.1d and IEEE 802.1w
Dual hot-swappable power supplies

- Increased resiliency: with secondary power supply to enable complete switch power redundancy
in case of power line or supply failure
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- Secondary power supply increases available PoE+ power

Distributed trunking
enables loop-free and redundant network topology without using Spanning Tree Protocol; allows a
server or switch to connect to two switches using one logical trunk for redundancy and load sharing
SmartLink
provides easy-to-configure link redundancy of active and standby links

Layer 2 switching

IEEE 802.1ad QinQ
increases the scalability of an Ethernet network by providing a hierarchical structure; connects multiple
LANs on a high-speed campus or metro network
VLAN support and tagging
supports the IEEE 802.1Q standard and 4096 VLANs simultaneously
IEEE 802.1v protocol VLANs
isolate select non-IPv4 protocols automatically into their own VLANs
MAC-based VLAN
provides granular control and security; uses RADIUS to map a MAC address/user to specific VLANs
Rapid Per-VLAN Spanning Tree (RPVST+)
allows each VLAN to build a separate spanning tree to improve link bandwidth usage; is compatible
with PVST+
Aruba 3810M switch meshing
dynamically load balances across multiple active redundant links to increase available aggregate
bandwidth; allows concurrent Layer 3 routing
GVRP and MVRP
allows automatic learning and dynamic assignment of VLANs

Layer 3 services

Loopback interface address
defines an address in Routing Information Protocol (RIP) and Open Standard Path First (OSPF),
improving diagnostic capability
Route maps
provide more control during route redistribution; allow filtering and altering of route metrics
User datagram protocol (UDP) helper function
allows UDP broadcasts to be directed across router interfaces to specific IP unicast or subnet
broadcast addresses; and helps prevent server spoofing for UDP services such as DHCP
DHCP server
centralizes and reduces the cost of IPv4 address management
Bidirectional Forwarding Detection (BFD)
enables link connectivity monitoring and reduces network convergence time for static routing, OSPFv2,
and VRRP

Layer 3 routing

Static IP routing
provides manually configured routing for both IPv4 and IPv6 networks
OSPF
provides OSPFv2 for IPv4 routing and OSPFv3 for IPv6 routing
Policy-based routing
makes routing decisions based on policies set by the network administrator
Border Gateway Protocol (BGP)
provides IPv4 Border Gateway Protocol routing, which is scalable, robust, and flexible
Routing Information Protocol (RIP)
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provides RIPv1, RIPv2, and RIPng routing

Security

Control plane policing
sets rate limit on control protocols to protect CPU overload from DOS attacks
Source-port filtering
allows only specified ports to communicate with each other
RADIUS/TACACS+
eases switch management security administration by using a password authentication server
Secure shell
encrypts all transmitted data for secure remote CLI access over IP networks
Secure Sockets Layer (SSL)
encrypts all HTTP traffic, allowing secure access to the browser-based management GUI in the switch
Port security
allows access only to specified MAC addresses, which can be learned or specified by the administrator
MAC address lockout
prevents particular configured MAC addresses from connecting to the network
Detection of malicious attacks
monitors 10 types of network traffic and sends a warning when an anomaly that potentially can be
caused by malicious attacks is detected
Secure FTP
allows secure file transfer to and from the switch; protects against unwanted file downloads or
unauthorized copying of a switch configuration file
Switch management logon security
helps secure switch CLI logon by optionally requiring either RADIUS or TACACS+ authentication
Secure management access
delivers secure encryption of all access methods (CLI, GUI, or MIB) through SSHv2, SSL, and/or
SNMPv3
ICMP throttling
defeats ICMP denial-of-service attacks by enabling any switch port to automatically throttle ICMP
traffic
Identity-driven ACL
enables implementation of a highly granular and flexible access security policy and VLAN assignment
specific to each authenticated network user
STP BPDU port protection
blocks Bridge Protocol Data Units (BPDUs) on ports that do not require BPDUs, preventing forged
BPDU attacks
Dynamic IP lockdown
works with DHCP protection to block traffic from unauthorized hosts, preventing IP source address
spoofing
DHCP protection
blocks DHCP packets from unauthorized DHCP servers, preventing denial-of-service attacks
Dynamic ARP protection
blocks ARP broadcasts from unauthorized hosts, preventing eavesdropping or theft of network data
STP root guard
protects the root bridge from malicious attacks or configuration mistakes
Management Interface Wizard
helps secure management interfaces such as SNMP, Telnet, SSH, SSL, Web, and USB at the desired
level
Security banner
displays a customized security policy when users log in to the switch
Switch CPU protection
provides automatic protection against malicious network traffic trying to shut down the switch
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ACLs
provide filtering based on the IP field, source/destination IP address/subnet and source/destination
TCP/UDP port number on a per-VLAN or per-port basis
Multiple authentication methods

- IEEE 802.1X
authenticates multiple IEEE 802.1X users per port; prevents a user from "piggybacking" on
another user's authentication

- Supports web-based authentication
- MAC-based client authentication
- Concurrent authentication modes

enables a switch port to accept up to 32 sessions of 802.1X, Web, and MAC authentication

Private VLAN
provides network security by restricting peer-to-peer communication to prevent a variety of malicious
attacks; typically a switch port can only communicate with other ports in the same community and/or
an uplink port, regardless of VLAN ID or destination MAC address
IEEE 802.1AE MACsec
provides security on a link between two switch ports (1Gbps or 10Gbps) using standard encryption and
authentication
Open authentication role
simplifies first-time deployment of AAA in brownfield deployments by allowing full network access for
failed clients and provides instant connectivity as soon as a client is plugged-in
Critical authentication role
ensures that important infrastructure devices such as IP phones are allowed network access even in
the absence of a RADIUS server
MAC pinning
allows non-chatty legacy devices to stay authenticated by pinning client MAC addresses to the port
until the clients logoff or get disconnected

Convergence

IP multicast snooping (data-driven IGMP)
prevents flooding of IP multicast traffic
LLDP-MED (Media Endpoint Discovery)
defines a standard extension of LLDP that stores values for parameters such as QoS and VLAN to
configure automatically network devices such as IP phones
PoE allocations
supports multiple methods (automatic, IEEE 802.3af class, LLDP-MED, or user-specified) to allocate
PoE power for more efficient energy savings
Protocol Independent Multicast for IPv6
supports one-to-many and many-to-many media casting use cases such as IPTV over IPv6 networks
IP multicast routing
includes PIM sparse and dense modes to route IP multicast traffic
Auto VLAN configuration for voice

- RADIUS VLAN
uses a standard RADIUS attribute and LLDP-MED to automatically configure a VLAN for IP
phones

- CDPv2
uses CDPv2 to configure legacy IP phones

Local MAC Authentication
assigns attributes such as VLAN and QoS using locally configured profile that can be a list of MAC
prefixes

Warranty and support
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Limited Lifetime Warranty
see http://www.hpe.com/networking/warrantysummary for warranty and support information
included with your product purchase.
Software releases
to find software for your product, refer to http://www.hpe.com/networking/support; for details on the
software releases available with your product purchase, refer to
http://www.hpe.com/networking/warrantysummary
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Build To Order:
BTO is a standalone unit with no integration. BTO products ship standalone are not part of a CTO or Rack-
Shippable solution.
   
Aruba 3810M 24G 1-slot Switch JL071A

24 RJ-45 autosensing 10/100/1000 ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

 

   
Aruba 3810M 48G 1-slot Switch JL072A

48 RJ-45 autosensing 10/100/1000 ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

 

   
Aruba 3810M 24G PoE+ 1-slot Switch JL073A

24 RJ-45 autosensing 10/100/1000 PoE+ ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

 

   
Aruba 3810M 48G PoE+ 1-slot Switch JL074A

48 RJ-45 autosensing 10/100/1000 PoE+ ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

 

   
Aruba 3810M 16SFP+ 2-slot Switch JL075A

16 fixed 1000/10000 SFP/SFP+ ports
min=0 \ max=16 SFP/SFP+  Transceivers
1 open stacking module slot
2 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

See
Configuration

NOTE: 1

   
Aruba 3810M 40G 8 HPE Smart Rate PoE+ 1-slot Switch JL076A

40 RJ-45 autosensing 10/100/1000 PoE+ ports
8 RJ-45 1/2.5/5/XGT PoE+ ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

 

   
Aruba 3810M 48G PoE+ 4SFP+ 680W Switch JL428A

Includes 1 3810M 48 Port PoE+ Switch (JL074A) See
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48 RJ-45 autosensing 10/100/1000 PoE+ ports
4 fixed 1000/10000 SFP/SFP+ ports
min=0 \ max=4 SFP/SFP+  Transceivers
1 open stacking module slot
Includes 1 uplink module (JL083A)
Includes 1 680W Power Supply (JL086A, Max 2)
1U - Height

Configuration
NOTE: 1, 2

   
PDU Cable NA/MEX/TW/JP JL428A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL428A#B2C

C15 PDU Jumper Cord (ROW)  
   
High Volt Power Supply to Wall Power Cord JL428A#B2E

NEMA L6-20P Cord (NA/MEX/JP/TW)  
   
No Power Cord JL428A#AC3

No Localized Power Cord Selected  
   
Aruba 3810M 48G PoE+ 4SFP+ 1050W Switch JL429A

Includes 1 3810M 48 Port PoE+ Switch (JL074A)
48 RJ-45 autosensing 10/100/1000 PoE+ ports
4 fixed 1000/10000 SFP/SFP+ ports
min=0 \ max=4 SFP/SFP+  Transceivers
1 open stacking module slot
Includes 1 uplink module (JL083A)
Includes 1 1050W Power Supply (JL087A, Max 2)
1U - Height

See
Configuration
NOTE: 1, 2

   
PDU Cable NA/MEX/TW/JP JL429A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL429A#B2C

C15 PDU Jumper Cord (ROW)  
   
High Volt Power Supply to Wall Power Cord JL429A#B2E

NEMA L6-20P Cord (NA/MEX/JP/TW)  
   
No Power Cord JL429A#AC3

No Localized Power Cord Selected  
   
Aruba 3810M 24SFP+ 250W Switch JL430A

Includes 1 3810M 16 Port SFP+ Switch (JL075A)
16 fixed 1000/10000 SFP/SFP+ ports
8 port SFP+ ports on the included modules
min=0 \ max=24 SFP/SFP+  Transceivers
1 open stacking module slot
Includes 2 uplink modules (JL083A)
Includes 1 250W Power Supply (JL085A, Max 2)
1U - Height

See
Configuration
NOTE: 1, 2
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PDU Cable NA/MEX/TW/JP JL430A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL430A#B2C

C15 PDU Jumper Cord (ROW)  
   
High Volt Power Supply to Wall Power Cord JL430A#B2E

NEMA L6-20P Cord (NA/MEX/JP/TW)  
   
No Power Cord JL430A#AC3

No Localized Power Cord Selected  
   
Configuration Rules:  
   
NOTE 1 The following Transceivers install into this Switch (For the 1000/10000 SFP+ Ports):  

HPE X111 100M SFP LC FX Transceiver J9054C
HPE X121 1G SFP LC LH Transceiver J4860C
HPE X121 1G SFP LC LX Transceiver J4859C
HPE X121 1G SFP LC SX Transceiver J4858C
HPE X122 1G SFP LC BX-D Transceiver J9142B
HPE X122 1G SFP LC BX-U Transceiver J9143B
Aruba 1G SFP LC SX 500m OM2 MMF Transceiver J4858D
Aruba 1G SFP LC LX 10km SMF Transceiver J4859D
Aruba 1G SFP LC LH 70km SMF Transceiver J4860D
Aruba 1G SFP RJ45 T 100m Cat5e Transceiver J8177D
Aruba 100M SFP LC FX 2km MMF Transceiver J9054D
HPE X132 10G SFP+ LC SR Transceiver J9150A
HPE X132 10G SFP+ LC ER Transceiver J9153A
HPE X132 10G SFP+ LC LR Transceiver J9151A
HPE X132 10G SFP+ LC LRM Transceiver J9152A
Aruba 10G SFP+ LC SR 300m OM3 MMF Transceiver J9150D
Aruba 10G SFP+ LC LR 10km SMF Transceiver J9151D
Aruba 10G SFP+ LC LRM 220m OM2 MMF Transceiver J9152D
Aruba 10G SFP+ LC ER 40km SMF Transceiver J9153D
Aruba 10G SFP+ to SFP+ 1m Direct Attach Copper Cable J9281D
Aruba 10G SFP+ to SFP+ 3m Direct Attach Copper Cable J9283D
Aruba 10G SFP+ to SFP+ 7m Direct Attach Copper Cable J9285D
HPE X242 10G SFP+ to SFP+ 1m Direct Attach Copper Cable J9281B
HPE X242 10G SFP+ to SFP+ 3m Direct Attach Copper Cable J9283B
HPE X242 10G SFP+ to SFP+ 7m Direct Attach Copper Cable J9285B

   
NOTE 2 Localization required on orders without #B2B, #B2C, #B2E options.  
   

 Box Level Integration CTO Models  
   
CTO Solution SKU  
   
Aruba 38xx Configure-to-order Switch Solution JG501A
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SSP trigger SKU  
   
CTO Switch Chassis  
   
Aruba 3810M 24G 1-slot Switch JL071A

24 RJ-45 autosensing 10/100/1000 ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

See
Configuration
NOTE: 10,

11

   
Aruba 3810M 48G 1-slot Switch JL072A

48 RJ-45 autosensing 10/100/1000 ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

See
Configuration
NOTE: 10,

11

   
Aruba 3810M 24G PoE+ 1-slot Switch JL073A

24 RJ-45 autosensing 10/100/1000 PoE+ ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

See
Configuration
NOTE: 10,

11

   
Aruba 3810M 48G PoE+ 1-slot Switch JL074A

48 RJ-45 autosensing 10/100/1000 PoE+ ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

See
Configuration
NOTE: 10,

11

   
Aruba 3810M 16SFP+ 2-slot Switch JL075A

16 fixed 1000/10000 SFP/SFP+ ports
min=0 \ max=16 SFP/SFP+  Transceivers
1 open stacking module slot
2 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

See
Configuration
NOTE: 1, 10,

11

   
Aruba 3810M 40G 8 HPE Smart Rate PoE+ 1-slot Switch JL076A

40 RJ-45 autosensing 10/100/1000 PoE+ ports
8 RJ-45 1/2.5/5/XGT PoE+ ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

See
Configuration
NOTE: 10,

11

   
Configuration Rules:  
   
NOTE 1 The following Transceivers install into this Switch (For the 1000/10000 SFP+ Ports):  

HPE X111 100M SFP LC FX Transceiver J9054C
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HPE X121 1G SFP LC LH Transceiver J4860C
HPE X121 1G SFP LC LX Transceiver J4859C
HPE X121 1G SFP LC SX Transceiver J4858C
HPE X122 1G SFP LC BX-D Transceiver J9142B
HPE X122 1G SFP LC BX-U Transceiver J9143B
Aruba 1G SFP LC SX 500m OM2 MMF Transceiver J4858D
Aruba 1G SFP LC LX 10km SMF Transceiver J4859D
Aruba 1G SFP LC LH 70km SMF Transceiver J4860D
Aruba 1G SFP RJ45 T 100m Cat5e Transceiver J8177D
Aruba 100M SFP LC FX 2km MMF Transceiver J9054D
HPE X132 10G SFP+ LC SR Transceiver J9150A
HPE X132 10G SFP+ LC ER Transceiver J9153A
HPE X132 10G SFP+ LC LR Transceiver J9151A
HPE X132 10G SFP+ LC LRM Transceiver J9152A
Aruba 10G SFP+ LC SR 300m OM3 MMF Transceiver J9150D
Aruba 10G SFP+ LC LR 10km SMF Transceiver J9151D
Aruba 10G SFP+ LC LRM 220m OM2 MMF Transceiver J9152D
Aruba 10G SFP+ LC ER 40km SMF Transceiver J9153D
Aruba 10G SFP+ to SFP+ 1m Direct Attach Copper Cable J9281D
Aruba 10G SFP+ to SFP+ 3m Direct Attach Copper Cable J9283D
Aruba 10G SFP+ to SFP+ 7m Direct Attach Copper Cable J9285D
HPE X242 10G SFP+ to SFP+ 1m Direct Attach Copper Cable J9281B
HPE X242 10G SFP+ to SFP+ 3m Direct Attach Copper Cable J9283B
HPE X242 10G SFP+ to SFP+ 7m Direct Attach Copper Cable J9285B

     
NOTE 10 If the Switch Chassis is to be Factory Integrated (CTO), Then the #0D1 is

required on the Switch Chassis and integrated to the JG501A - HP 3800
CTO Enablement. (Min 1/Max 1 Switch per SSP)

 

     
NOTE 11 If this Switch is selected, Then a Minimum of 1 factory integrated accessory

must be ordered and integrated to CTO chassis.  See Menu below, option
must have a #0D1 to be integrated to the CTO Chassis. 

 

     
Remarks: Clic UNB - If an option is ordered with #0D1/#B01, then the switch must

have #0D1 option.
 

   

 Rack Level Integration CTO Models  
   
Aruba 3810M 24G 1-slot Switch JL071A

24 RJ-45 autosensing 10/100/1000 ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

See
Configuration
NOTE: 10,

11

   
Aruba 3810M 48G 1-slot Switch JL072A
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48 RJ-45 autosensing 10/100/1000 ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

See
Configuration
NOTE: 10,

11

   
Aruba 3810M 24G PoE+ 1-slot Switch JL073A

24 RJ-45 autosensing 10/100/1000 PoE+ ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

See
Configuration
NOTE: 10,

11

   
Aruba 3810M 48G PoE+ 1-slot Switch JL074A

48 RJ-45 autosensing 10/100/1000 PoE+ ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

See
Configuration
NOTE: 10,

11

   
Aruba 3810M 16SFP+ 2-slot Switch JL075A

16 fixed 1000/10000 SFP/SFP+ ports
min=0 \ max=16 SFP/SFP+  Transceivers
1 open stacking module slot
2 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

See
Configuration
NOTE: 1, 10,

11

   
Aruba 3810M 40G 8 HPE Smart Rate PoE+ 1-slot Switch JL076A

40 RJ-45 autosensing 10/100/1000 PoE+ ports
8 RJ-45 1/2.5/5/XGT PoE+ ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

See
Configuration
NOTE: 10,

11

   
Aruba 3810M 48G PoE+ 4SFP+ 680W Switch JL428A

Includes 1 3810M 48 Port PoE+ Switch (JL074A)
48 RJ-45 autosensing 10/100/1000 PoE+ ports
4 fixed 1000/10000 SFP/SFP+ ports
min=0 \ max=4 SFP/SFP+  Transceivers
1 open stacking module slot
Includes 1 uplink module (JL083A)
Includes 1 680W Power Supply (JL086A, Max 2)
1U - Height

See
Configuration
NOTE: 1, 3,

4, 10, 11

   
PDU Cable NA/MEX/TW/JP JL428A

#B2B
C15 PDU Jumper Cord (NA/MEX/TW/JP)  

   
PDU Cable ROW JL428A

#B2C
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C15 PDU Jumper Cord (ROW)  
   
High Volt Power Supply to Wall Power Cord JL428A

#B2E
NEMA L6-20P Cord (NA/MEX/JP/TW)  

   
No Power Cord JL428A#AC3

No Localized Power Cord Selected  
   
Aruba 3810M 48G PoE+ 4SFP+ 1050W Switch JL429A

Includes 1 3810M 48 Port PoE+ Switch (JL074A)
48 RJ-45 autosensing 10/100/1000 PoE+ ports
4 fixed 1000/10000 SFP/SFP+ ports
min=0 \ max=4 SFP/SFP+  Transceivers
1 open stacking module slot
Includes 1 uplink module (JL083A)
Includes 1 1050W Power Supply (JL087A, Max 2)
1U - Height

See
Configuration
NOTE: 1, 3,

4, 10, 11

   
PDU Cable NA/MEX/TW/JP JL429A

#B2B
C15 PDU Jumper Cord (NA/MEX/TW/JP)  

   
PDU Cable ROW JL429A

#B2C
C15 PDU Jumper Cord (ROW)  

   
High Volt Power Supply to Wall Power Cord JL429A

#B2E
NEMA L6-20P Cord (NA/MEX/JP/TW)  

   
No Power Cord JL429A

#AC3
No Localized Power Cord Selected  

   
Aruba 3810M 24SFP+ 250W Switch JL430A

Includes 1 3810M 16 Port SFP+ Switch (JL075A)
16 fixed 1000/10000 SFP/SFP+ ports
8 port SFP+ ports on the included modules
min=0 \ max=24 SFP/SFP+  Transceivers
1 open stacking module slot
Includes 2 uplink modules (JL083A)
Includes 1 250W Power Supply (JL085A, Max 2)
1U - Height

See
Configuration
NOTE: 1, 3,

4, 10, 11

   
PDU Cable NA/MEX/TW/JP JL430A

#B2B
C15 PDU Jumper Cord (NA/MEX/TW/JP)  

   
PDU Cable ROW JL430A

#B2C
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C15 PDU Jumper Cord (ROW)  
   
High Volt Power Supply to Wall Power Cord JL430A

#B2E
NEMA L6-20P Cord (NA/MEX/JP/TW)  

   
No Power Cord JL430A

#AC3
No Localized Power Cord Selected  

   
Configuration Rules:  
   
NOTE 1 The following Transceivers install into this Switch (For the 1000/10000 SFP+ Ports):  

HPE X111 100M SFP LC FX Transceiver J9054C
HPE X121 1G SFP LC LH Transceiver J4860C
HPE X121 1G SFP LC LX Transceiver J4859C
HPE X121 1G SFP LC SX Transceiver J4858C
HPE X122 1G SFP LC BX-D Transceiver J9142B
HPE X122 1G SFP LC BX-U Transceiver J9143B
Aruba 1G SFP LC SX 500m OM2 MMF Transceiver J4858D
Aruba 1G SFP LC LX 10km SMF Transceiver J4859D
Aruba 1G SFP LC LH 70km SMF Transceiver J4860D
Aruba 1G SFP RJ45 T 100m Cat5e Transceiver J8177D
Aruba 100M SFP LC FX 2km MMF Transceiver J9054D
HPE X132 10G SFP+ LC SR Transceiver J9150A
HPE X132 10G SFP+ LC ER Transceiver J9153A
HPE X132 10G SFP+ LC LR Transceiver J9151A
HPE X132 10G SFP+ LC LRM Transceiver J9152A
Aruba 10G SFP+ LC SR 300m OM3 MMF Transceiver J9150D
Aruba 10G SFP+ LC LR 10km SMF Transceiver J9151D
Aruba 10G SFP+ LC LRM 220m OM2 MMF Transceiver J9152D
Aruba 10G SFP+ LC ER 40km SMF Transceiver J9153D
Aruba 10G SFP+ to SFP+ 1m Direct Attach Copper Cable J9281D
Aruba 10G SFP+ to SFP+ 3m Direct Attach Copper Cable J9283D
Aruba 10G SFP+ to SFP+ 7m Direct Attach Copper Cable J9285D
HPE X242 10G SFP+ to SFP+ 1m Direct Attach Copper Cable J9281B
HPE X242 10G SFP+ to SFP+ 3m Direct Attach Copper Cable J9283B
HPE X242 10G SFP+ to SFP+ 7m Direct Attach Copper Cable J9285B

     
NOTE 3 Localization required on orders without #B2B, #B2C, #B2E options.  
     
NOTE 4 When Switches are Factory Racked with this power supply, Then #B2B, or

#B2C should be the Defaulted Power Cable option on the Power Supplies.
(See Drop down remark in “Internal Power Supplies” section.)

 

     
NOTE 10 If switch is 0D1 to Racks, then the J9583A#0D1 is also required.   
     
NOTE 11 If the CTO Switch Chassis needs to be racked, Then the CTO Base Model

needs to integrate (with #0D1) to the HPE Network Rack. 
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Remarks:    
  Drop down under power supply should offer the following options and

results:
Switch/Router/Power Supply to PDU Power Cord -  #B2B in North America,
Mexico, Taiwan, and Japan or #B2C ROW. (Watson Default B2B or B2C
for Rack Level CTO)
Switch/Router/Power Supply to Wall Power Cord - Localized Option
(Watson Default for BTO and Box Level CTO)
High Volt Switch/Router/Power Supply to Wall Power Cord -  #B2E Option.
(Offered only in North America, Mexico, Taiwan, and  Japan)

 

     
  Watson Blue NOTE: It is recommended that both power supplies match for

full redundancy in the case of a fully populated switch, but not required.
 

     
  Clic UNB - If an option is ordered with #0D1/#B01, then the switch must

have #0D1 option.
 

   
Enter the following menu selections as integrated to the CTO Model X switch above if order is
factory built.   
   

Modules  
   
Stacking Modules  
   
 System (std 0 // max=1) User Selection (min 0 / max=1) per Chassis  
   
Aruba 3810M 4-port Stacking Module JL084A

min=1 \ max=4 Stacking cables See
Configuration

NOTE: 1
   
Configuration Rules:  
   
NOTE 1 One of the following Stacking Cables must be selected:  
  Aruba 3800/3810M 0.5m Stacking Cable J9578A
  Aruba 3800/3810M 1m Stacking Cable J9665A
  Aruba 3800/3810M 3m Stacking Cable J9579A
   
Uplink Modules  
   
JL071A, JL072A, JL073A, JL074A, JL076A Only System (std 0 // max 1) User Selection (min 0 / max 1) per
Chassis
JL075A Only System (std 0 // max 2) User Selection (min 0 / max 2) per Chassis  
JL428A, JL429A Only System (std 1 // max 1) User Selection (min 0 / max 0) per Chassis  
JL430A Only System (std 2 // max 2) User Selection (min 0 / max 0) per Chassis  
   
Aruba 3810M/2930M 1-port QSFP+ 40GbE Module JL078A
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min=0 \ max=1 QSFP+  Transceiver See
Configuration

NOTE: 1
   

Aruba 3810M 2QSFP+ 40GbE Module JL079A
min=0 \ max=2 QSFP+  Transceiver See

Configuration
NOTE: 1, 3

   
Aruba 3810M 4 HPE Smart Rate PoE+ Module JL081A

4 x HPE Smart Rate Ports  
   
Aruba 3810M/2930M 4-port 100M/1G/10G SFP+ MACsec Module JL083A

min=0 \ max=4 SFP/SFP+  Transceivers See
Configuration

NOTE: 2
   
Configuration Rules:  
   
NOTE 1 The following Transceivers install into this Module: (Use #0D1 or #B01 if switch is

CTO) - if applicable
 

HPE X142 40G QSFP+ MPO SR4 Transceiver JH231A
HPE X142 40G QSFP+ LC LR4 SM Transceiver JH232A
HPE X142 40G QSFP+ MPO eSR4 300M Transceiver JH233A
HPE X242 40G QSFP+ to QSFP+ 1m Direct Attach Copper Cable JH234A

HPE X242 40G QSFP+ to QSFP+ 3m Direct Attach Copper Cable JH235A
HPE X242 40G QSFP+ to QSFP+ 5m Direct Attach Copper Cable JH236A

  Aruba 40G QSFP+ LC Bidirectional 150m MMF 2-strand Transceiver JL308A
     
NOTE 2 The following Transceivers install into this Switch (For the 1000/10000 SFP+ Ports):

HPE X111 100M SFP LC FX Transceiver J9054C
HPE X121 1G SFP LC LH Transceiver J4860C
HPE X121 1G SFP LC LX Transceiver J4859C
HPE X121 1G SFP LC SX Transceiver J4858C
HPE X122 1G SFP LC BX-D Transceiver J9142B
HPE X122 1G SFP LC BX-U Transceiver J9143B
Aruba 1G SFP LC SX 500m OM2 MMF Transceiver J4858D
Aruba 1G SFP LC LX 10km SMF Transceiver J4859D
Aruba 1G SFP LC LH 70km SMF Transceiver J4860D
Aruba 1G SFP RJ45 T 100m Cat5e Transceiver J8177D
Aruba 100M SFP LC FX 2km MMF Transceiver J9054D
HPE X132 10G SFP+ LC SR Transceiver J9150A
HPE X132 10G SFP+ LC ER Transceiver J9153A
HPE X132 10G SFP+ LC LR Transceiver J9151A
HPE X132 10G SFP+ LC LRM Transceiver J9152A
Aruba 10G SFP+ LC SR 300m OM3 MMF Transceiver J9150D
Aruba 10G SFP+ LC LR 10km SMF Transceiver J9151D
Aruba 10G SFP+ LC LRM 220m OM2 MMF Transceiver J9152D
Aruba 10G SFP+ LC ER 40km SMF Transceiver J9153D
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Aruba 10G SFP+ to SFP+ 1m Direct Attach Copper Cable J9281D
Aruba 10G SFP+ to SFP+ 3m Direct Attach Copper Cable J9283D
Aruba 10G SFP+ to SFP+ 7m Direct Attach Copper Cable J9285D
HPE X242 10G SFP+ to SFP+ 1m Direct Attach Copper Cable J9281B
HPE X242 10G SFP+ to SFP+ 3m Direct Attach Copper Cable J9283B
HPE X242 10G SFP+ to SFP+ 7m Direct Attach Copper Cable J9285B

     
NOTE 3 This module is only available for the following switches:  

Aruba 3810M 48G 1-slot Switch JL072A
Aruba 3810M 48G PoE+ 1-slot Switch JL074A
Aruba 3810M 40G 8 HPE Smart Rate PoE+ 1-slot Switch JL076A

     
Remarks: Watson Only Blue NOTE Although all 3810M/2930M Switches are

compatible with the 4 Port HPE Smart Rate module, non PoE switches do
not provide PoE power to the HPE Smart Rate Module.

 

   

Transceivers  
   
SFP Transceivers  
   
HPE X121 1G SFP LC LH Transceiver J4860C
HPE X121 1G SFP LC LX Transceiver J4859C
HPE X121 1G SFP LC SX Transceiver J4858C
HPE X122 1G SFP LC BX-D Transceiver J9142B
HPE X122 1G SFP LC BX-U Transceiver J9143B
HPE X111 100M SFP LC FX Transceiver J9054C
Aruba 100M SFP LC FX 2km MMF Transceiver J9054D
Aruba 1G SFP LC SX 500m OM2 MMF Transceiver J4858D
Aruba 1G SFP LC LX 10km SMF Transceiver J4859D
Aruba 1G SFP LC LH 70km SMF Transceiver J4860D
Aruba 1G SFP RJ45 T 100m Cat5e Transceiver J8177D
   
SFP+ Transceivers  
   
HPE X132 10G SFP+ LC ER Transceiver J9153A
HPE X132 10G SFP+ LC SR Transceiver J9150A
HPE X132 10G SFP+ LC LR Transceiver J9151A
HPE X132 10G SFP+ LC LRM Transceiver J9152A
Aruba 10G SFP+ LC SR 300m OM3 MMF Transceiver J9150D
Aruba 10G SFP+ LC LR 10km SMF Transceiver J9151D
Aruba 10G SFP+ LC LRM 220m OM2 MMF Transceiver J9152D
Aruba 10G SFP+ LC ER 40km SMF Transceiver J9153D
Aruba 10G SFP+ to SFP+ 1m Direct Attach Copper Cable J9281D
Aruba 10G SFP+ to SFP+ 3m Direct Attach Copper Cable J9283D
Aruba 10G SFP+ to SFP+ 7m Direct Attach Copper Cable J9285D
HPE X242 10G SFP+ to SFP+ 1m Direct Attach Copper Cable J9281B
HPE X242 10G SFP+ to SFP+ 3m Direct Attach Copper Cable J9283B
HPE X242 10G SFP+ to SFP+ 7m Direct Attach Copper Cable J9285B
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QSFP+ Transceivers  
   
HPE X142 40G QSFP+ MPO SR4 Transceiver JH231A
HPE X142 40G QSFP+ LC LR4 SM Transceiver JH232A
HPE X142 40G QSFP+ MPO eSR4 300M Transceiver JH233A
Aruba 40G QSFP+ LC Bidirectional 150m MMF 2-strand Transceiver JL308A
HPE X242 40G QSFP+ to QSFP+ 1m Direct Attach Copper Cable JH234A
HPE X242 40G QSFP+ to QSFP+ 3m Direct Attach Copper Cable JH235A
HPE X242 40G QSFP+ to QSFP+ 5m Direct Attach Copper Cable JH236A
   

Internal Power Supplies  
   
  System (std 0 // max=2) User Selection (min 1 / max=2) per Switch  
  For JL428A, JL429A, JL430A System (std 1 // max=2) User Selection (min 0 / max=1) per
Switch  
   
Aruba X371 12VDC 250W 100-240VAC Power Supply JL085A

  See
Configuration
NOTE: 1, 3,

4
   

PDU Cable NA/MEX/TW/JP
JL085A
#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   

PDU Cable ROW
JL085A
#B2C

C15 PDU Jumper Cord (ROW)  
   

High Volt Power Supply to Wall Power Cord
JL085A
#B2E

NEMA L6-20P Cord (NA/MEX/JP/TW)  
   

No Power Cord
JL085A
#AC3

No Localized Power Cord Selected  
   
Aruba X372 54VDC 680W 100-240VAC Power Supply JL086A

  See
Configuration
NOTE: 2, 3,

4
   

PDU Cable NA/MEX/TW/JP
JL086A
#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   

PDU Cable ROW
JL086A
#B2C
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C15 PDU Jumper Cord (ROW)  
   

High Volt Power Supply to Wall Power Cord
JL086A
#B2E

NEMA L6-20P Cord (NA/MEX/JP/TW)  
   

No Power Cord
JL086A
#AC3

No Localized Power Cord Selected  
   
Aruba X372 54VDC 1050W 110-240VAC Power Supply JL087A

  See
Configuration
NOTE: 2, 3,

4
   

PDU Cable NA/MEX/TW/JP
JL087A
#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   

PDU Cable ROW
JL087A
#B2C

C15 PDU Jumper Cord (ROW)  
   

High Volt Power Supply to Wall Power Cord
JL087A
#B2E

NEMA L6-20P Cord (NA/MEX/JP/TW)  
   

No Power Cord
JL087A
#AC3

No Localized Power Cord Selected  
   
Configuration Rules:  
   
NOTE 1 If this Power supply is selected, Then  JL071A, JL072A, JL075A, JL430A 

must be the switch its installed into.
 

     
NOTE 2 If this Power supply is selected, Then JL073A, JL074A, JL076A, JL428A,

JL429A must be the switch its installed into.
 

     
NOTE 3 Localization required on orders without #B2B or #B2C options.  
     
NOTE 4 When Switches are Factory Racked with this power supply, Then #B2B, or

#B2C should be the Defaulted Power Cable option on the Power Supplies.
(See Drop down remark in “Internal Power Supplies” section.)

 

     
Remarks: Drop down under power supply should offer the following options and

results:
Switch/Router/Power Supply to PDU Power Cord -  #B2B in North America,
Mexico, Taiwan, and Japan or #B2C ROW. (Watson Default B2B or B2C
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for Rack Level CTO)
Switch/Router/Power Supply to Wall Power Cord - Localized Option
(Watson Default for BTO and Box Level CTO)
High Volt Switch/Router/Power Supply to Wall Power Cord -  #B2E Option.
(Offered only in North America, Mexico, Taiwan, and  Japan)
No Localized Power Cord Selected - #AC3 Option

  Watson Blue NOTE: It is recommended that both power supplies match for
full redundancy in the case of a fully populated switch, but not required.

 

     

Cables  
   
Stacking Cables  
(std 0 // max 99) User Selection (min 0 // max 99) per switch  
   
Aruba 3800/3810M 0.5m Stacking Cable J9578A
Aruba 3800/3810M 1m Stacking Cable J9665A
Aruba 3800/3810M 3m Stacking Cable J9579A
   
Console Cables  
(std 0 // max 99) User Selection (min 0 // max 99) per switch  
   
Aruba X2C2 RJ45 to DB9 Console Cable JL448A

   
Multi-Mode Cables  
(std 0 // max 99) User Selection (min 0 // max 99) per switch  
   
HPE LC to LC Multi-mode OM3 2-Fiber 0.5m 1-Pack Fiber Optic Cable AJ833A
HPE LC to LC Multi-mode OM3 2-Fiber 1.0m 1-Pack Fiber Optic Cable AJ834A
HPE LC to LC Multi-mode OM3 2-Fiber 2.0m 1-Pack Fiber Optic Cable AJ835A
HPE LC to LC Multi-mode OM3 2-Fiber 5.0m 1-Pack Fiber Optic Cable AJ836A
HPE LC to LC Multi-mode OM3 2-Fiber 15.0m 1-Pack Fiber Optic Cable AJ837A
HPE LC to LC Multi-mode OM3 2-Fiber 30.0m 1-Pack Fiber Optic Cable AJ838A
HPE LC to LC Multi-mode OM3 2-Fiber 50.0m 1-Pack Fiber Optic Cable AJ839A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 1m Cable QK732A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 2m Cable QK733A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 5m Cable QK734A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 15m Cable QK735A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 30m Cable QK736A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 50m Cable QK737A
   

Switch Enclosure Options  
   
Rack Mount Kit  
(std 0 // max 1) User Selection (min 0 // max 1) per switch  
   
HPE X410 1U Universal 4-post Rackmount Kit J9583A

  See
Configuration

NOTE: 1
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Configuration Rules:  
   
NOTE 1 If this switch is factory installed in HPE Network Racks, Then the

J9583A#0D1 is required. 
 

   
Fan Tray  
   
Aruba 3810 Switch Fan Tray JL088A

This is a Spare Only  
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Aruba 3810M 24G 1-slot Switch (JL071A)

Included
accessories

1 Aruba 3810 Switch Fan Tray (JL088A)

I/O ports and slots 24 RJ-45 autosensing 10/100/1000 ports (IEEE 802.3 Type 10BASE-T, IEEE 802.3u
Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T); Duplex: 10BASE-
T/100BASE-TX: half or full; 1000BASE-T: full only; Ports 1 - 24 support MACSec
Supports a maximum of 4 SFP+ ports or 1 40GbE ports, with optional module
1 open module slot
Supports a maximum of 4 SFP+ ports or 1 40GbE ports, with optional module

Additional ports and
slots

1 stacking module slot
1 RJ-45 serial console port
1 RJ-45 out-of-band management port
1 dual-personality (RJ-45 or USB micro-B)

Power supplies 2 power supply slots
1 minimum power supply required (ordered separately)

Fan tray includes: 1 x JL088A
1 fan tray slot
Switch ships with 1 JL088A fan tray installed. Spares ordered separately.

Physical
characteristics

Dimensions 17.42(w) x 16.98(d) x 1.73(h) in (44.25 x 43.13 x 4.39 cm)
(1U height)

Weight 12.76 lb (5.79 kg)

Memory and
processor

P2020 Dual Core @ 1.2 GHz, 4 GB DDR3 SDRAM, 1 GB SD Card
Dual ARM Coretex A9 @ 1 GHz, 2 GB DDR3 SDRAM; Packet buffer size: 13.5 MB
Internal

Mounting and
enclosure

Mounts in an EIA-standard 19 in. telco rack or equipment cabinet (hardware
included); Horizontal surface mounting only

Performance IPv6 Ready Certified  
1000 Mb Latency < 2.8 µs (FIFO 64-byte packets)

10 Gbps Latency < 1.8 µs (FIFO 64-byte packets)

40 Gbps Latency < 1.5 µs (FIFO 64-byte packets)

Throughput up to 95.2 Mpps (64-byte packets)

Routing/Switching
capacity

160 Gbps

Switch fabric speed 169 Gbps

Routing table size 10000 entries (IPv4), 5000 entries (IPv6)

MAC address table
size

64000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Nonoperating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing
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Altitude up to 10,000 ft (3 km)

Acoustic Power: 39 dB, Pressure: 22.8 dB

 
Primary Airflow
Direction

Front-to-side and front-to-rear

Electrical
Characteristics

Frequency 50/60Hz

Voltage JL085A PSU: 100-127/200-240 VAC 

Current JL085A PSU (Each): 1A/0.5A 

Max/Idle Power
Rating (Switch+ 1
PSU)

JL078A: 4W/3W
JL079A: 7W/3W
JL081A: 4W/3W
JL083A: 11W/4W

Maximum Heat
Dissipation *(Max
Case)

310.31 

PoE Power (Max
Possible)

N/A

Notes Idle power is the actual power consumption of the device
with no ports connected. Maximum power rating and
maximum heat dissipation are the worst case theoretical
maximum numbers provide for planning the infrastructure
with fully loaded PoE (if equipped), 100% traffic, all ports
plugged in, and all modules populated. This is a modular
product.
 
*Switch + 2 power supplies + one JL083A Uplink. For most
accurate heat dissipation, idle and max power for any
combination of chassis and accessories, please consult
configurator. 

Safety EN 60950/IEC 60950; UL 60950; UL 60950-1; CAN/CSA 22.2 No. 60950; EN 60825;
CSA 22.2 60950-1; EN62479:2010; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; EN 62368-1, Ed. 2; IEC 60950-1:2005 Ed.2; Am
1:2009+A2:2013; IEC 60825:2007; EN60850-1:2007 / IEC 60825-1: 2007 Class1
Class 1 Laser Products / Laser Klasse 1; UL 62368-1 Ed.2

Emissions FCC Class A; VCCI Class A; EN 55022/CISPR 22 Class A; EN 60950-1:2006
+A11:2009 +A1:2010 +A12:2011+A2:2013

Immunity Generic EN55022: 2010

EN EN55024: 2010

ESD IEC 61000-4-2

Radiated IEC 61000-4-3; 3 V/m

EFT/Burst IEC 61000-4-4; 1.0 kV (power line), 0.5 kV (signal line)

Surge IEC 61000-4-5; 1 kV/2 kV AC

Conducted IEC 61000-4-6; 3 V

Power frequency
magnetic field

IEC 61000-4-8; 1 A/m, 50 or 60 Hz

Voltage dips and
interruptions

IEC 61000-4-11; >95% reductions, 0.5 period; 30%
reduction, 25 periods

Harmonics EN61000-3-2:2006 +A1:2009 +A2:2009 Class A

Flicker EN61000-3-3:2008
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Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; Out-of-band
management (RJ-45 Ethernet); In-line and out-of-band; Out-of-band management
(serial RS-232c or micro usb)

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services
for details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 

 

 

 

Aruba 3810M 48G 1-slot Switch (JL072A)

Included
accessories

1 Aruba 3810 Switch Fan Tray (JL088A)

I/O ports and slots 48 RJ-45 autosensing 10/100/1000 ports (IEEE 802.3 Type 10BASE-T, IEEE 802.3u
Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T); Duplex: 10BASE-
T/100BASE-TX: half or full; 1000BASE-T: full only; Ports 1 - 48 support MACSec
1 open module slot
Supports a maximum of 4 SFP+ ports or 2 40GbE ports, with optional module

Additional ports and
slots

1 stacking module slot
1 RJ-45 serial console port
1 RJ-45 out-of-band management port
1 dual-personality (RJ-45 or USB micro-B)

Power supplies 2 power supply slots
1 minimum power supply required (ordered separately)

Fan tray includes: 1 x JL088A
1 fan tray slot
Switch ships with 1 JL088A fan tray installed. Spares ordered separately.

Physical
characteristics

Dimensions 17.42(w) x 16.98(d) x 1.73(h) in (44.25 x 43.13 x 4.39 cm)
(1U height)

Weight 13.20 lb (5.99 kg)

Memory and
processor

P2020 Dual Core @ 1.2 GHz, 4 GB DDR3 SDRAM, 1 GB SD Card
Dual ARM Coretex A9 @ 1 GHz, 2 GB DDR3 SDRAM; Packet buffer size: 13.5 MB
Internal

Mounting and
enclosure

Mounts in an EIA-standard 19 in. telco rack or equipment cabinet (hardware
included); Horizontal surface mounting only

Performance IPv6 Ready Certified  
1000 Mb Latency < 2.8 µs (FIFO 64-byte packets)

10 Gbps Latency < 1.8 µs (FIFO 64-byte packets)

40 Gbps Latency < 1.5 µs (FIFO 64-byte packets)

Throughput up to 190.5 Mpps (64-byte packets)

Routing/Switching
capacity

320 Gbps

Switch fabric speed 338 Gbps

Routing table size 10000 entries (IPv4), 5000 entries (IPv6)
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MAC address table
size

64000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Nonoperating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 38 dB, Pressure: 21.8 dB

 
Primary Airflow
Direction

Front-to-side and front-to-rear

Electrical
Characteristics

Frequency 50/60Hz

Voltage JL085A PSU: 100-127/200-240 VAC

Current JL085A PSU (Each): 1A/0.5A

Max/Idle Power
Rating (Switch+ 1
PSU)

95W/78W

Second PSU Power
Adder

10W

Max/Idle Uplink
Power Adder

JL078A: 4W/3W
JL079A: 7W/3W
JL081A: 4W/3W
JL083A: 11W/4W

Maximum Heat
Dissipation *(Max
Case)

395.56

PoE Power (Max
Possible)

N/A

Notes Idle power is the actual power consumption of the device
with no ports connected. Maximum power rating and
maximum heat dissipation are the worst case theoretical
maximum numbers provide for planning the infrastructure
with fully loaded PoE (if equipped), 100% traffic, all ports
plugged in, and all modules populated. This is a modular
product.
 
*Switch + 2 power supplies + one JL083A Uplink. For most
accurate heat dissipation, idle and max power for any
combination of chassis and accessories, please consult
configurator.

Safety EN 60950/IEC 60950; UL 60950; UL 60950-1; CAN/CSA 22.2 No. 60950; EN 60825;
CSA 22.2 60950-1; EN62479:2010; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; EN 62368-1, Ed. 2; IEC 60950-1:2005 Ed.2; Am
1:2009+A2:2013; IEC 60825:2007; EN60850-1:2007 / IEC 60825-1: 2007 Class1
Class 1 Laser Products / Laser Klasse 1; UL 62368-1 Ed.2
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Emissions FCC Class A; VCCI Class A; EN 55022/CISPR 22 Class A; EN 60950-1:2006
+A11:2009 +A1:2010 +A12:2011+A2:2013

Immunity Generic EN55022: 2010

EN EN55024: 2010

ESD IEC 61000-4-2

Radiated IEC 61000-4-3; 3 V/m

EFT/Burst IEC 61000-4-4; 1.0 kV (power line), 0.5 kV (signal line)

Surge IEC 61000-4-5; 1 kV/2 kV AC

Conducted IEC 61000-4-6; 3 V

Power frequency
magnetic field

IEC 61000-4-8; 1 A/m, 50 or 60 Hz

Voltage dips and
interruptions

IEC 61000-4-11; >95% reductions, 0.5 period; 30%
reduction, 25 periods

Harmonics EN61000-3-2:2006 +A1:2009 +A2:2009 Class A

Flicker EN61000-3-3:2008

Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; Out-of-band
management (RJ-45 Ethernet); In-line and out-of-band; Out-of-band management
(serial RS-232c or micro usb)

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services
for details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 

 

Aruba 3810M 24G PoE+ 1-slot Switch (JL073A)

Included
accessories

1 Aruba 3810 Switch Fan Tray (JL088A)

I/O ports and slots 24 RJ-45 autosensing 10/100/1000 PoE+ ports (IEEE 802.3 Type 10BASE-T, IEEE
802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T, IEEE 802.3at PoE+);
Duplex: 10BASE-T/100BASE-TX: half or full; 1000BASE-T: full only; Ports 1 - 24
support MACSec
1 open module slot
Supports a maximum of 4 SFP+ ports or 1 40GbE ports, with optional module

Additional ports and
slots

1 stacking module slot
1 RJ-45 serial console port
1 RJ-45 out-of-band management port
1 dual-personality (RJ-45 or USB micro-B)

Power supplies 2 power supply slots
1 minimum power supply required (ordered separately)

Fan tray includes: 1 x JL088A
1 fan tray slot
Switch ships with 1 JL088A fan tray installed. Spares ordered separately

Physical
characteristics

Dimensions 17.42(w) x 16.98(d) x 1.73(h) in (44.25 x 43.13 x 4.39 cm)
(1U height)

Weight 13.02 lb (5.91 kg)
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Memory and
processor

P2020 Dual Core @ 1.2 GHz, 4 GB DDR3 SDRAM, 1 GB SD Card
Dual ARM Coretex A9 @ 1 GHz, 2 GB DDR3 SDRAM; Packet buffer size: 13.5 MB
Internal

Mounting and
enclosure

Mounts in an EIA-standard 19 in. telco rack or equipment cabinet (hardware
included); Horizontal surface mounting only

Performance IPv6 Ready Certified  
1000 Mb Latency < 2.8 µs (FIFO 64-byte packets)

10 Gbps Latency < 1.8 µs (FIFO 64-byte packets)

40 Gbps Latency < 1.5 µs (FIFO 64-byte packets)

Throughput up to 95.2 Mpps (64-byte packets)

Routing/Switching
capacity

160 Gbps

Switch fabric speed 169 Gbps

Routing table size 10000 entries (IPv4), 5000 entries (IPv6)

MAC address table
size

64000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Nonoperating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 44 dB, Pressure: 27.6 dB

 
Primary Airflow
Direction

Front-to-side and front-to-rear

Electrical
Characteristics

Frequency 50/60Hz

Voltage JL086A PSU: 100-127/200-240 VAC
JL087A PSU: 110-127/200-240 VAC

Current JL086A PSU (Each): 5A/2.5A
JL087A PSU (Each): 8.5A/5A

Max/Idle Power
Rating (Switch+ 1
PSU)

95W/82W

Second PSU Power
Adder

10W

Max/Idle Uplink
Power Adder

JL078A: 4W/3W
JL079A: 7W/3W
JL081A: 4W/3W
JL083A: 11W/4W

Maximum Heat
Dissipation *(Max
Case)

395.56
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PoE Power (Max
Possible)

840W

Notes Idle power is the actual power consumption of the device
with no ports connected. Maximum power rating and
maximum heat dissipation are the worst case theoretical
maximum numbers provide for planning the infrastructure
with fully loaded PoE (if equipped), 100% traffic, all ports
plugged in, and all modules populated. This is a modular
product.
 
*Switch + 2 power supplies + one JL083A Uplink. For most
accurate heat dissipation, idle and max power for any
combination of chassis and accessories, please consult
configurator.

Safety EN 60950/IEC 60950; UL 60950; UL 60950-1; CAN/CSA 22.2 No. 60950; EN 60825;
CSA 22.2 60950-1; EN62479:2010; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; EN 62368-1, Ed. 2; IEC 60950-1:2005 Ed.2; Am
1:2009+A2:2013; IEC 60825:2007; EN60850-1:2007 / IEC 60825-1: 2007 Class1
Class 1 Laser Products / Laser Klasse 1; UL 62368-1 Ed.2

Emissions FCC Class A; VCCI Class A; EN 55022/CISPR 22 Class A; EN 60950-1:2006
+A11:2009 +A1:2010 +A12:2011+A2:2013

Immunity Generic EN55022: 2010

EN EN55024: 2010

ESD IEC 61000-4-2

Radiated IEC 61000-4-3; 3 V/m

EFT/Burst IEC 61000-4-4; 1.0 kV (power line), 0.5 kV (signal line)

Surge IEC 61000-4-5; 1 kV/2 kV AC

Conducted IEC 61000-4-6; 3 V

Power frequency
magnetic field

IEC 61000-4-8; 1 A/m, 50 or 60 Hz

Voltage dips and
interruptions

IEC 61000-4-11; >95% reductions, 0.5 period; 30%
reduction, 25 periods

Harmonics EN61000-3-2:2006 +A1:2009 +A2:2009 Class A

Flicker EN61000-3-3:2008

Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; Out-of-band
management (RJ-45 Ethernet); In-line and out-of-band; Out-of-band management
(serial RS-232c or micro usb)

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services
for details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

Aruba 3810M 48G PoE+ 1-slot Switch (JL074A)

Included
accessories

1 Aruba 3810 Switch Fan Tray (JL088A)

I/O ports and slots 48 RJ-45 autosensing 10/100/1000 PoE+ ports (IEEE 802.3 Type 10BASE-T, IEEE
802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T, IEEE 802.3at PoE+);
Duplex: 10BASE-T/100BASE-TX: half or full; 1000BASE-T: full only; Ports 1 - 48
support MACSec
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1 open module slot
Supports a maximum of 4 SFP+ ports or 2 40GbE ports, with optional module

Additional ports and
slots

1 stacking module slot
1 RJ-45 serial console port
1 RJ-45 out-of-band management port
1 dual-personality (RJ-45 or USB micro-B)

Power supplies 2 power supply slots
1 minimum power supply required (ordered separately)

Fan tray includes: 1 x JL088A
1 fan tray slot
Switch ships with 1 JL088A fan tray installed. Spares ordered separately.

Physical
characteristics

Dimensions 17.42(w) x 16.98(d) x 1.73(h) in (44.25 x 43.13 x 4.39 cm)
(1U height)

Weight 13.62 lb (6.18 kg)

Memory and
processor

P2020 Dual Core @ 1.2 GHz, 4 GB DDR3 SDRAM, 1 GB SD Card
Dual ARM Coretex A9 @ 1 GHz, 2 GB DDR3 SDRAM; Packet buffer size: 13.5 MB
Internal

Mounting and
enclosure

Mounts in an EIA-standard 19 in. telco rack or equipment cabinet (hardware
included); Horizontal surface mounting only

Performance IPv6 Ready Certified  
1000 Mb Latency < 2.8 µs (FIFO 64-byte packets)

10 Gbps Latency < 1.8 µs (FIFO 64-byte packets)

40 Gbps Latency < 1.5 µs (FIFO 64-byte packets)

Throughput up to 190.5 Mpps (64-byte packets)

Routing/Switching
capacity

320 Gbps

Switch fabric speed 338 Gbps

Routing table size 10000 entries (IPv4), 5000 entries (IPv6)

MAC address table
size

64000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Nonoperating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 47 dB, Pressure: 29.4 dB

 
Primary Airflow
Direction

Front-to-side and front-to-rear

Electrical
Characteristics

Frequency 50/60Hz

Voltage JL086A PSU: 100-127/200-240 VAC
JL087A PSU: 110-127/200-240 VAC
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Current JL086A PSU (Each): 5A/2.5A
JL087A PSU (Each): 8.5A/5A

Max/Idle Power
Rating (Switch+ 1
PSU)

135W/103W

Second PSU Power
Adder

10W

Max/Idle Uplink
Power Adder

JL078A: 4W/3W
JL079A: 7W/3W
JL081A: 4W/3W
JL083A: 11W/4W

Maximum Heat
Dissipation *(Max
Case)

531.96

PoE Power (Max
Possible)

1440W

Notes Idle power is the actual power consumption of the device
with no ports connected. Maximum power rating and
maximum heat dissipation are the worst case theoretical
maximum numbers provide for planning the infrastructure
with fully loaded PoE (if equipped), 100% traffic, all ports
plugged in, and all modules populated. This is a modular
product.
 
*Switch + 2 power supplies + one JL083A Uplink. For most
accurate heat dissipation, idle and max power for any
combination of chassis and accessories, please consult
configurator.

Safety EN 60950/IEC 60950; UL 60950; UL 60950-1; CAN/CSA 22.2 No. 60950; EN 60825;
CSA 22.2 60950-1; EN62479:2010; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; EN 62368-1, Ed. 2; IEC 60950-1:2005 Ed.2; Am
1:2009+A2:2013; IEC 60825:2007; EN60850-1:2007 / IEC 60825-1: 2007 Class1
Class 1 Laser Products / Laser Klasse 1; UL 62368-1 Ed.2

Emissions FCC Class A; VCCI Class A; EN 55022/CISPR 22 Class A; EN 60950-1:2006
+A11:2009 +A1:2010 +A12:2011+A2:2013

Immunity Generic EN55022: 2010

EN EN55024: 2010

ESD IEC 61000-4-2

Radiated IEC 61000-4-3; 3 V/m

EFT/Burst IEC 61000-4-4; 1.0 kV (power line), 0.5 kV (signal line)

Surge IEC 61000-4-5; 1 kV/2 kV AC

Conducted IEC 61000-4-6; 3 V

Power frequency
magnetic field

IEC 61000-4-8; 1 A/m, 50 or 60 Hz

Voltage dips and
interruptions

IEC 61000-4-11; >95% reductions, 0.5 period; 30%
reduction, 25 periods

Harmonics EN61000-3-2:2006 +A1:2009 +A2:2009 Class A

Flicker EN61000-3-3:2008
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Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; Out-of-band
management (RJ-45 Ethernet); In-line and out-of-band; Out-of-band management
(serial RS-232c or micro usb)

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services
for details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

Aruba 3810M 16SFP+ 2-slot Switch (JL075A)

Included
accessories

1 Aruba 3810 Switch Fan Tray (JL088A)

I/O ports and slots 16 SFP+ fixed 1000/10000 SFP+ ports; Duplex: 100BASE-TX: half or full;
1000BASE-T: full only; Ports 1 - 16 support MACSec
2 open module slots
Supports a maximum of 8 SFP+ ports or 2 40GbE ports, with optional module

Additional ports and
slots

1 stacking module slot
1 RJ-45 serial console port
1 RJ-45 out-of-band management port
1 dual-personality (RJ-45 or USB micro-B)

Power supplies 2 power supply slots
1 minimum power supply required (ordered separately)

Fan tray includes: 1 x JL088A
1 fan tray slot
Switch ships with 1 JL088A fan tray installed. Spares ordered separately.

Physical
characteristics

Dimensions 17.42(w) x 16.98(d) x 1.73(h) in (44.25 x 43.13 x 4.39 cm)
(1U height)

Weight 13.28 lb (6.02 kg)

Memory and
processor

P2020 Dual Core @ 1.2 GHz, 4 GB DDR3 SDRAM, 1 GB SD Card
Dual ARM Coretex A9 @ 1 GHz, 2 GB DDR3 SDRAM; Packet buffer size: 13.5 MB
Internal

Mounting and
enclosure

Mounts in an EIA-standard 19 in. telco rack or equipment cabinet (hardware
included); Horizontal surface mounting only

Performance IPv6 Ready Certified  
1000 Mb Latency < 2.8 µs (FIFO 64-byte packets)

10 Gbps Latency < 1.8 µs (FIFO 64-byte packets)

40 Gbps Latency < 1.5 µs (FIFO 64-byte packets)

Throughput up to 285.7 Mpps (64-byte packets)

Routing/Switching
capacity

480 Gbps

Switch fabric speed 508 Gbps

Routing table size 10000 entries (IPv4), 5000 entries (IPv6)

MAC address table
size

64000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)
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Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Nonoperating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 39 dB, Pressure: 22.3 dB

 
Primary Airflow
Direction

Front-to-side and front-to-rear

Electrical
Characteristics

Frequency 50/60Hz

Voltage JL085A PSU: 100-127/200-240 VAC

Current JL085A PSU (Each): 1A/0.5A

Max/Idle Power
Rating (Switch+ 1
PSU)

120W/95W

Second PSU Power
Adder

10W

Max/Idle Uplink
Power Adder

JL078A: 4W/3W
JL079A: 7W/3W
JL081A: 4W/3W
JL083A: 11W/4W

Maximum Heat
Dissipation *(Max
Case)

480.81

PoE Power (Max
Possible)

N/A

Notes Idle power is the actual power consumption of the device
with no ports connected. Maximum power rating and
maximum heat dissipation are the worst case theoretical
maximum numbers provide for planning the infrastructure
with fully loaded PoE (if equipped), 100% traffic, all ports
plugged in, and all modules populated. This is a modular
product.
 
*Switch + 2 power supplies + one JL083A Uplink. For most
accurate heat dissipation, idle and max power for any
combination of chassis and accessories, please consult
configurator

Safety EN 60950/IEC 60950; UL 60950; UL 60950-1; CAN/CSA 22.2 No. 60950; EN 60825;
CSA 22.2 60950-1; EN62479:2010; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; EN 62368-1, Ed. 2; IEC 60950-1:2005 Ed.2; Am
1:2009+A2:2013; IEC 60825:2007; EN60850-1:2007 / IEC 60825-1: 2007 Class1
Class 1 Laser Products / Laser Klasse 1; UL 62368-1 Ed.2

Emissions FCC Class A; VCCI Class A; EN 55022/CISPR 22 Class A; EN 60950-1:2006
+A11:2009 +A1:2010 +A12:2011+A2:2013

Immunity Generic EN55022: 2010

EN EN55024: 2010
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ESD IEC 61000-4-2

Radiated IEC 61000-4-3; 3 V/m

EFT/Burst IEC 61000-4-4; 1.0 kV (power line), 0.5 kV (signal line)

Surge IEC 61000-4-5; 1 kV/2 kV AC

Conducted IEC 61000-4-6; 3 V

Power frequency
magnetic field

IEC 61000-4-8; 1 A/m, 50 or 60 Hz

Voltage dips and
interruptions

IEC 61000-4-11; >95% reductions, 0.5 period; 30%
reduction, 25 periods

Harmonics EN61000-3-2:2006 +A1:2009 +A2:2009 Class A

Flicker EN61000-3-3:2008

Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; Out-of-band
management (RJ-45 Ethernet); In-line and out-of-band; Out-of-band management
(serial RS-232c or micro usb)

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services
for details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 

 

 

Aruba 3810M 40G 8 HPE Smart Rate PoE+ 1-slot Switch (JL076A)

Included
accessories

1 Aruba 3810 Switch Fan Tray (JL088A)

I/O ports and slots 40 RJ-45 autosensing 10/100/1000 PoE+ ports (IEEE 802.3 Type 10BASE-T, IEEE
802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T, IEEE 802.3at PoE+);
Duplex: 10BASE-T/100BASE-TX: half or full; 1000BASE-T: full only; Ports 1 - 40
support MACSec
8 RJ-45 HPE Smart Rate Multi-Gigabit ports; Ports 1 - 8 support MACSec
1 open module slot
Supports a maximum of 4 SFP+ ports or 2 40GbE ports, with optional module

Additional ports and
slots

1 stacking module slot
1 RJ-45 serial console port
1 RJ-45 out-of-band management port
1 dual-personality (RJ-45 or USB micro-B)

Power supplies 2 power supply slots
1 minimum power supply required (ordered separately)

Fan tray includes: 1 x JL088A
1 fan tray slot
Switch ships with 1 JL088A fan tray installed. Spares ordered separately.

Physical
characteristics

Dimensions 17.42(w) x 16.98(d) x 1.73(h) in (44.25 x 43.13 x 4.39 cm)
(1U height)

Weight 13.61 lb (6.17 kg)
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Memory and
processor

P2020 Dual Core @ 1.2 GHz, 4 GB DDR3 SDRAM, 1 GB SD Card
Dual ARM Coretex A9 @ 1 GHz, 2 GB DDR3 SDRAM; Packet buffer size: 13.5 MB
Internal

Mounting and
enclosure

Mounts in an EIA-standard 19 in. telco rack or equipment cabinet (hardware
included); Horizontal surface mounting only

Performance IPv6 Ready Certified  
1000 Mb Latency < 2.8 µs (FIFO 64-byte packets)

10 Gbps Latency < 1.8 µs (FIFO 64-byte packets)

40 Gbps Latency < 1.5 µs (FIFO 64-byte packets)

Throughput up to 273.8 Mpps (64-byte packets)

Routing/Switching
capacity

480 Gbps

Switch fabric speed 508 Gbps

Routing table size 10000 entries (IPv4), 5000 entries (IPv6)

MAC address table
size

64000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Nonoperating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 49 dB, Pressure: 31.5 dB

 
Primary Airflow
Direction

Front-to-side and front-to-rear

Electrical
Characteristics

Frequency 50/60Hz

Voltage JL086A PSU: 100-127/200-240 VAC
JL087A PSU: 110-127/200-240 VAC

Current JL086A PSU (Each): 5A/2.5A
JL087A PSU (Each): 8.5A/5A

Max/Idle Power
Rating (Switch+ 1
PSU)

190W/158W

Second PSU Power
Adder

10W

Max/Idle Uplink
Power Adder

JL078A: 4W/3W
JL079A: 7W/3W
JL081A: 4W/3W
JL083A: 11W/4W

Maximum Heat
Dissipation *(Max
Case)

719.51
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PoE Power (Max
Possible)

1440W

Notes Idle power is the actual power consumption of the device
with no ports connected. Maximum power rating and
maximum heat dissipation are the worst case theoretical
maximum numbers provide for planning the infrastructure
with fully loaded PoE (if equipped), 100% traffic, all ports
plugged in, and all modules populated. This is a modular
product.
 
*Switch + 2 power supplies + one JL083A Uplink. For most
accurate heat dissipation, idle and max power for any
combination of chassis and accessories, please consult
configurator.

Safety EN 60950/IEC 60950; UL 60950; UL 60950-1; CAN/CSA 22.2 No. 60950; EN 60825;
CSA 22.2 60950-1; EN62479:2010; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; EN 62368-1, Ed. 2; IEC 60950-1:2005 Ed.2; Am
1:2009+A2:2013; IEC 60825:2007; EN60850-1:2007 / IEC 60825-1: 2007 Class1
Class 1 Laser Products / Laser Klasse 1; UL 62368-1 Ed.2

Emissions FCC Class A; VCCI Class A; EN 55022/CISPR 22 Class A; EN 60950-1:2006
+A11:2009 +A1:2010 +A12:2011+A2:2013

Immunity Generic EN55022: 2010

EN EN55024: 2010

ESD IEC 61000-4-2

Radiated IEC 61000-4-3; 3 V/m

EFT/Burst IEC 61000-4-4; 1.0 kV (power line), 0.5 kV (signal line)

Surge IEC 61000-4-5; 1 kV/2 kV AC

Conducted IEC 61000-4-6; 3 V

Power frequency
magnetic field

IEC 61000-4-8; 1 A/m, 50 or 60 Hz

Voltage dips and
interruptions

IEC 61000-4-11; >95% reductions, 0.5 period; 30%
reduction, 25 periods

Harmonics EN61000-3-2:2006 +A1:2009 +A2:2009 Class A

Flicker EN61000-3-3:2008

Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; Out-of-band
management (RJ-45 Ethernet); In-line and out-of-band; Out-of-band management
(serial RS-232c or micro usb)

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services
for details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
Aruba 3810M 48G PoE+ 4SFP+ 680W Switch (JL428A)

Included
accessories

1 Aruba 3810M 48G PoE+ 1-slot Switch (JL074A)
1 Aruba X372 54VDC 680W Power Supply (JL086A)
1 Aruba 3810M 4SFP+ Module (JL083A)
1 Aruba 3810 Switch Fan Tray (JL088A)

I/O ports and slots 48 RJ-45 autosensing 10/100/1000 PoE+ ports (IEEE 802.3 Type 10BASE-T, IEEE
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802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T, IEEE 802.3at PoE+);
Duplex: 10BASE-T/100BASE- TX: half or full; 1000BASE-T: full only; Ports 1 - 48
support MACSec
1 open module slot
Supports a maximum of 4 SFP+ ports or 2 40GbE ports, with optional module

Additional ports and
slots

1 stacking module slot
1 RJ-45 serial console port
1 RJ-45 out-of-band management port
1 dual-personality (RJ-45 or USB micro-B)

Power supplies 2 power supply slots
1 minimum power supply required (ordered separately)

Fan tray includes: 1 x JL088A
1 fan tray slot
Switch ships with 1 JL088A fan tray installed. Spares ordered separately.

Physical
characteristics

Dimensions 17.42(w) x 16.98(d) x 1.73(h) in (44.25 x 43.13 x 4.39 cm)
(1U height)

Weight 13.62 lb (6.18 kg)

Memory and
processor

P2020 Dual Core @ 1.2 GHz, 4 GB DDR3 SDRAM, 1 GB SD Card
Dual ARM Coretex A9 @ 1 GHz, 2 GB DDR3 SDRAM; Packet buffer size: 13.5 MB
Internal

Mounting and
enclosure

Mounts in an EIA-standard 19 in. telco rack or equipment cabinet (hardware
included); Horizontal surface mounting only

Performance IPv6 Ready Certified  
1000 Mb Latency < 2.8 µs (FIFO 64-byte packets)

10 Gbps Latency < 1.8 µs (FIFO 64-byte packets)

40 Gbps Latency < 1.5 µs (FIFO 64-byte packets)

Throughput up to 190.5 Mpps (64-byte packets)

Routing/Switching
capacity

320 Gbps

Switch fabric speed 338 Gbps

Routing table size 10000 entries (IPv4), 5000 entries (IPv6)

MAC address table
size

64000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Nonoperating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 47 dB, Pressure: 29.4 dB

 
Primary Airflow
Direction

Front-to-side and front-to-rear

Electrical
Characteristics

Frequency 50/60Hz

Voltage JL085A PSU: 100-127/200-240 VAC
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Current JL085A PSU (Each): 1A/0.5A

Max/Idle Power
Rating (Switch+ 1
PSU)

70W/55W

Second PSU Power
Adder

10W 

Max/Idle Uplink
Power Adder

JL078A: 4W/3W
JL079A: 7W/3W
JL081A: 4W/3W
JL083A: 11W/4W 

Maximum Heat
Dissipation *(Max
Case)

310.31

PoE Power (Max
Possible)

N/A

Notes Idle power is the actual power consumption of the device
with no ports connected. Maximum power rating and
maximum heat dissipation are the worst case theoretical
maximum numbers provide for planning the infrastructure
with fully loaded PoE (if equipped), 100% traffic, all ports
plugged in, and all modules populated. This is a modular
product.
 
*Switch + 2 power supplies + one JL083A Uplink. For most
accurate heat dissipation, idle and max power for any
combination of chassis and accessories, please consult
configurator.

Safety EN 60950/IEC 60950; UL 60950; UL 60950-1; CAN/CSA 22.2 No. 60950; EN
60825; CSA 22.2 60950-1; EN62479:2010; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; EN 62368-1, Ed. 2; IEC 60950-1:2005 Ed.2; Am
1:2009+A2:2013; IEC 60825:2007; EN60850-1:2007 / IEC 60825-1: 2007 Class1
Class 1 Laser Products / Laser Klasse 1; UL 62368-1 Ed.2

Emissions FCC Class A; VCCI Class A; EN 55022/CISPR 22 Class A; EN 60950-1:2006
+A11:2009 +A1:2010 +A12:2011+A2:2013

Immunity Generic EN55022: 2010

EN EN55024: 2010

ESD IEC 61000-4-2

Radiated IEC 61000-4-3; 3 V/m

EFT/Burst IEC 61000-4-4; 1.0 kV (power line), 0.5 kV (signal line)

Surge IEC 61000-4-5; 1 kV/2 kV AC

Conducted IEC 61000-4-6; 3 V

Power frequency
magnetic field

IEC 61000-4-8; 1 A/m, 50 or 60 Hz

Voltage dips and
interruptions

IEC 61000-4-11; >95% reductions, 0.5 period; 30%
reduction, 25 periods

Harmonics EN61000-3-2:2006 +A1:2009 +A2:2009 Class A

Flicker EN61000-3-3:2008
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Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; Out-of-band
management (RJ-45 Ethernet); In-line and out-of- band; Out-of-band management
(serial RS-232c or micro usb)

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services
for details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
Aruba 3810M 48G PoE+ 4SFP+ 1050W Switch (JL429A)

Included
accessories

1 Aruba 3810M 48G PoE+ 1-slot Switch (JL074A)
1 Aruba X372 54VDC 1050W Power Supply (JL087A)
1 Aruba 3810M 4SFP+ Module (JL083A)
1 Aruba 3810 Switch Fan Tray (JL088A)

I/O ports and slots 48 RJ-45 autosensing 10/100/1000 PoE+ ports (IEEE 802.3 Type 10BASE-T, IEEE
802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T, IEEE 802.3at PoE+);
Duplex: 10BASE-T/100BASE- TX: half or full; 1000BASE-T: full only; Ports 1 - 48
support MACSec
1 open module slot
Supports a maximum of 4 SFP+ ports or 2 40GbE ports, with optional module

Additional ports and
slots

1 stacking module slot
1 RJ-45 serial console port
1 RJ-45 out-of-band management port
1 dual-personality (RJ-45 or USB micro-B)

Power supplies 2 power supply slots
1 minimum power supply required (ordered separately)

Fan tray includes: 1 x JL088A 1 fan tray slot
Switch ships with 1 JL088A fan tray installed. Spares ordered separately.

Physical
characteristics

Dimensions 17.42(w) x 16.98(d) x 1.73(h) in (44.25 x 43.13 x 4.39 cm)
(1U height)

Weight 13.62 lb (6.18 kg)

Memory and
processor

P2020 Dual Core @ 1.2 GHz, 4 GB DDR3 SDRAM, 1 GB SD Card
Dual ARM Coretex A9 @ 1 GHz, 2 GB DDR3 SDRAM; Packet buffer size: 13.5 MB
Internal

Mounting and
enclosure

Mounts in an EIA-standard 19 in. telco rack or equipment cabinet (hardware
included); Horizontal surface mounting only

Performance IPv6 Ready Certified  
1000 Mb Latency < 2.8 µs (FIFO 64-byte packets)

10 Gbps Latency < 1.8 µs (FIFO 64-byte packets)

40 Gbps Latency < 1.5 µs (FIFO 64-byte packets)

Throughput up to 190.5 Mpps (64-byte packets)

Routing/Switching
capacity

320 Gbps

Switch fabric speed 338 Gbps

Routing table size 10000 entries (IPv4), 5000 entries (IPv6)

MAC address table
size

64000 entries

Environment Operating 32°F to 113°F (0°C to 45°C)
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temperature

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Nonoperating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 47 dB, Pressure: 29.4 dB

 
Primary Airflow
Direction

Front-to-side and front-to-rear

Electrical
Characteristics

Frequency 50/60Hz

Voltage JL085A PSU: 100-127/200-240 VAC 

Current JL085A PSU (Each): 1A/0.5A

Max/Idle Power
Rating (Switch+ 1
PSU)

70W/55W

Second PSU Power
Adder

10W 

Max/Idle Uplink
Power Adder

JL078A: 4W/3W
JL079A: 7W/3W
JL081A: 4W/3W
JL083A: 11W/4W 

Maximum Heat
Dissipation *(Max
Case)

310.31 

PoE Power (Max
Possible)

N/A

Notes Idle power is the actual power consumption of the device
with no ports connected. Maximum power rating and
maximum heat dissipation are the worst case theoretical
maximum numbers provide for planning the infrastructure
with fully loaded PoE (if equipped), 100% traffic, all ports
plugged in, and all modules populated. This is a modular
product.
 
*Switch + 2 power supplies + one JL083A Uplink. For most
accurate heat dissipation, idle and max power for any
combination of chassis and accessories, please consult
configurator. 

Safety EN 60950/IEC 60950; UL 60950; UL 60950-1; CAN/CSA 22.2 No. 60950; EN
60825; CSA 22.2 60950-1; EN62479:2010; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; EN 62368-1, Ed. 2; IEC 60950-1:2005 Ed.2; Am
1:2009+A2:2013; IEC 60825:2007; EN60850-1:2007 / IEC 60825-1: 2007 Class1
Class 1 Laser Products / Laser Klasse 1; UL 62368-1 Ed.2

Emissions FCC Class A; VCCI Class A; EN 55022/CISPR 22 Class A; EN 60950-1:2006
+A11:2009 +A1:2010 +A12:2011+A2:2013

Immunity Generic EN55022: 2010

EN EN55024: 2010
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ESD IEC 61000-4-2

Radiated IEC 61000-4-3; 3 V/m

EFT/Burst IEC 61000-4-4; 1.0 kV (power line), 0.5 kV (signal line)

Surge IEC 61000-4-5; 1 kV/2 kV AC

Conducted IEC 61000-4-6; 3 V

Power frequency
magnetic field

IEC 61000-4-8; 1 A/m, 50 or 60 Hz

Voltage dips and
interruptions

IEC 61000-4-11; >95% reductions, 0.5 period; 30%
reduction, 25 periods

Harmonics EN61000-3-2:2006 +A1:2009 +A2:2009 Class A

Flicker EN61000-3-3:2008

Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; Out-of-band
management (RJ-45 Ethernet); In-line and out-of- band; Out-of-band management
(serial RS-232c or micro usb)

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services
for details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
Aruba 3810M 24SFP+ 250W Switch (JL430A)

Included
accessories

1 Aruba 3810M 16SFP+ 2-slot Switch (JL075A)
1 Aruba X371 12VDC 250W Power Supply (JL085A)
2 Aruba 3810M 4SFP+ Module (JL083A)
1 Aruba 3810 Switch Fan Tray (JL088A)

I/O ports and slots 16 SFP+ fixed 1000/10000 SFP+ ports; Duplex: 100BASE-TX: half or full;
1000BASE-T: full only; Ports
1 - 16 support MACSec
2 open module slots
Supports a maximum of 8 SFP+ ports or 2 40GbE ports, with optional module

Additional ports and
slots

1 stacking module slot
1 RJ-45 serial console port
1 RJ-45 out-of-band management port
1 dual-personality (RJ-45 or USB micro-B)

Power supplies 2 power supply slots
1 minimum power supply required (ordered separately)

Fan tray includes: 1 x JL088A
1 fan tray slot
Switch ships with 1 JL088A fan tray installed. Spares ordered separately.

Physical
characteristics

Dimensions 17.42(w) x 16.98(d) x 1.73(h) in (44.25 x 43.13 x 4.39 cm)
(1U height)

Weight 13.28 lb (6.02 kg)

Memory and
processor

P2020 Dual Core @ 1.2 GHz, 4 GB DDR3 SDRAM, 1 GB SD Card
Dual ARM Coretex A9 @ 1 GHz, 2 GB DDR3 SDRAM; Packet buffer size: 13.5 MB
Internal

Mounting and
enclosure

Mounts in an EIA-standard 19 in. telco rack or equipment cabinet (hardware
included); Horizontal surface mounting only
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Performance IPv6 Ready Certified  
1000 Mb Latency < 2.8 µs (FIFO 64-byte packets)

10 Gbps Latency < 1.8 µs (FIFO 64-byte packets)

40 Gbps Latency < 1.5 µs (FIFO 64-byte packets)

Throughput up to 285.7 Mpps (64-byte packets)

Routing/Switching
capacity

480 Gbps

Switch fabric speed 508 Gbps

Routing table size 10000 entries (IPv4), 5000 entries (IPv6)

MAC address table
size

64000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Nonoperating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 39 dB, Pressure: 22.3 dB

 
Primary Airflow
Direction

Front-to-side and front-to-rear

Electrical
Characteristics

Frequency 50/60Hz

Voltage JL085A PSU: 100-127/200-240 VAC 

Current JL085A PSU (Each): 1A/0.5A

Max/Idle Power
Rating (Switch+ 1
PSU)

142W/103W

Second PSU Power
Adder

10W 

Max/Idle Uplink
Power Adder

JL078A: 4W/3W
JL079A: 7W/3W
JL081A: 4W/3W
JL083A: 11W/4W 

Maximum Heat
Dissipation *(Max
Case)

310.31 

PoE Power (Max
Possible)

N/A

Notes Idle power is the actual power consumption of the device
with no ports connected. Maximum power rating and
maximum heat dissipation are the worst case theoretical
maximum numbers provide for planning the infrastructure
with fully loaded PoE (if equipped), 100% traffic, all ports
plugged in, and all modules populated. This is a modular
product.
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*Switch + 2 power supplies + one JL083A Uplink. For most
accurate heat dissipation, idle and max power for any
combination of chassis and accessories, please consult
configurator. 

Safety EN 60950/IEC 60950; UL 60950; UL 60950-1; CAN/CSA 22.2 No. 60950; EN
60825; CSA 22.2 60950-1; EN62479:2010; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; EN 62368-1, Ed. 2; IEC 60950-1:2005 Ed.2; Am
1:2009+A2:2013; IEC 60825:2007; EN60850-1:2007 / IEC 60825-1: 2007 Class1
Class 1 Laser Products / Laser Klasse 1; UL 62368-1 Ed.2

Emissions FCC Class A; VCCI Class A; EN 55022/CISPR 22 Class A; EN 60950-1:2006
+A11:2009 +A1:2010 +A12:2011+A2:2013

Immunity Generic EN55022: 2010

EN EN55024: 2010

ESD IEC 61000-4-2

Radiated IEC 61000-4-3; 3 V/m

EFT/Burst IEC 61000-4-4; 1.0 kV (power line), 0.5 kV (signal line)

Surge IEC 61000-4-5; 1 kV/2 kV AC

Conducted IEC 61000-4-6; 3 V

Power frequency
magnetic field

IEC 61000-4-8; 1 A/m, 50 or 60 Hz

Voltage dips and
interruptions

IEC 61000-4-11; >95% reductions, 0.5 period; 30%
reduction, 25 periods

Harmonics EN61000-3-2:2006 +A1:2009 +A2:2009 Class A

Flicker EN61000-3-3:2008

Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; Out-of-band
management (RJ-45 Ethernet); In-line and out-of- band; Out-of-band management
(serial RS-232c or micro usb)

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services
for details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
 
Standards and protocols (applies to all products in series)

BGP RFC 1997 BGP Communities Attribute
RFC 2918 Route Refresh Capability
RFC 4271 A Border Gateway Protocol 4 (BGP-4)
RFC 4456 BGP Route Reflection: An Alternative to Full Mesh Internal BGP (IBGP)
RFC 4724 Graceful Restart Mechanism for BGP
RFC 5492 Capabilities Advertisement with BGP-4

Denial of service
protection

CPU DoS Protection

Device Management RFC 1591 DNS (client)
RFC 2576 (Coexistence between SNMP V1, V2, V3)
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RFC 2579 (SMIv2 Text Conventions)
RFC 2580 (SMIv2 Conformance)
RFC 3416 (SNMP Protocol Operations v2)
RFC 3417 (SNMP Transport Mappings)
HTML and telnet management

General Protocols IEEE 802.1ad Q-in-Q
IEEE 802.1AX-2008 Link Aggregation
IEEE 802.1D MAC Bridges
IEEE 802.1p Priority
IEEE 802.1Q VLANs
IEEE 802.1s Multiple Spanning Trees
IEEE 802.1v VLAN classification by Protocol and Port
IEEE 802.1w Rapid Reconfiguration of Spanning Tree
IEEE 802.3ad Link Aggregation Control Protocol (LACP)
IEEE 802.3af Power over Ethernet
IEEE 802.3az Energy Efficient Ethernet
IEEE 802.3x Flow Control
IEEE 802.3bz 2.5Gb/s and 5Gb/s interfaces
RFC 768 UDP
RFC 783 TFTP Protocol (revision 2)
RFC 792 ICMP
RFC 793 TCP
RFC 826 ARP
RFC 854 TELNET
RFC 868 Time Protocol
RFC 951 BOOTP
RFC 1058 RIPv1
RFC 1350 TFTP Protocol (revision 2)
RFC 1519 CIDR
RFC 1542 BOOTP Extensions
RFC 1918 Address Allocation for Private Internet
RFC 2030 Simple Network Time Protocol (SNTP) v4
RFC 2131 DHCP
RFC 2453 RIPv2
RFC 2548 (MS-RAS-Vendor only)
RFC 3046 DHCP Relay Agent Information Option
RFC 3575 IANA Considerations for RADIUS
RFC 3576 Ext to RADIUS (CoA only)
RFC 3768 VRRP
RFC 4675 RADIUS VLAN & Priority
RFC 5798 VRRP (exclude Accept Mode and sub-sec timer)
RFC 5880 Bidirectional Forwarding Detection
RFC 5905 Network Time Protocol Version 4: Protocol and Algorithms Specification
UDLD (Uni-directional Link Detection)

IP Multicast RFC 3376 IGMPv3
RFC 3973 PIM Dense Mode
RFC 4601 PIM Sparse Mode

IPv6 RFC 1981 IPv6 Path MTU Discovery
RFC 2080 RIPng for IPv6
RFC 2081 RIPng Protocol Applicability Statement
RFC 2082 RIP-2 MD5
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RFC 2375 IPv6 Multicast Address Assignments
RFC 2460 IPv6 Specification
RFC 2464 Transmission of IPv6 over Ethernet Networks
RFC 2710 Multicast Listener Discovery (MLD) for IPv6
RFC 2925 Definitions of Managed Objects for Remote Ping, Traceroute, and
Lookup Operations (Ping only)
RFC 3019 MLDv1 MIB
RFC 3315 DHCPv6 (client only)
RFC 3484 Default Address Selection for IPv6
RFC 3587 IPv6 Global Unicast Address Format
RFC 3596 DNS Extension for IPv6
RFC 3810 MLDv2 for IPv6
RFC 4022 MIB for TCP
RFC 4087 IP Tunnel MIB
RFC 4113 MIB for UDP
RFC 4213 Basic Transition Mechanisms for IPv6 Hosts and Routers
RFC 4251 SSHv6 Architecture
RFC 4252 SSHv6 Authentication
RFC 4253 SSHv6 Transport Layer
RFC 4254 SSHv6 Connection
RFC 4291 IP Version 6 Addressing Architecture
RFC 4293 MIB for IP
RFC 4294 IPv6 Node Requirements
RFC 4419 Key Exchange for SSH
RFC 4443 ICMPv6
RFC 4541 IGMP & MLD Snooping Switch
RFC 4861 IPv6 Neighbor Discovery
RFC 4862 IPv6 Stateless Address Auto-configuration
RFC 5095 Deprecation of Type 0 Routing Headers in IPv6
RFC 5340 OSPFv3 for IPv6
RFC 5453 Reserved IPv6 Interface Identifiers
RFC 5519 Multicast Group Membership Discovery MIB (MLDv2 only)
RFC 5722 Handling of Overlapping IPv6 Fragments
RFC 6620 FCFS SAVI
draft-ietf-savi-mix

MIBs IEEE 802.1ap (MSTP and STP MIB's only)
IEEE 8021-Bridge-MIB (2008)
IEEE 8021-Q-Bridge-MIB (2008)
RFC 1155 Structure & ID of Mgmt Info for TCP/IP Internets
RFC 1213 MIB II
RFC 1493 Bridge MIB
RFC 1724 RIPv2 MIB
RFC 1850 OSPFv2 MIB
RFC 2021 RMONv2 MIB
RFC 2096 IP Forwarding Table MIB
RFC 2578 Structure of Management Information Version 2 (SMIv2)
RFC 2613 SMON MIB
RFC 2618 RADIUS Client MIB
RFC 2620 RADIUS Accounting MIB
RFC 2665 Ethernet-Like-MIB
RFC 2668 802.3 MAU MIB
RFC 2674 802.1p and IEEE 802.1Q Bridge MIB
RFC 2737 Entity MIB (Version 2)
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RFC 2787 VRRP MIB
RFC 2863 The Interfaces Group MIB
RFC 2925 Ping MIB
RFC 2932 IP (Multicast Routing MIB)
RFC 2933 IGMP MIB
RFC 4836 Managed Objects for 802.3 Medium Attachment Units (MAU)
RFC 7331 BFD MIB

Network
Management

IEEE 802.1AB Link Layer Discovery Protocol (LLDP)
RFC 2819 Four groups of RMON: 1 (statistics), 2 (history), 3 (alarm) and 9 (events)
RFC 3176 sFlow
RFC 3411 SNMP Management Frameworks
RFC 3412 Message Processing and Dispatching for the Simple Network
Management Protocol (SNMP)
RFC 3413 Simple Network Management Protocol (SNMP) Applications
RFC 3414 User-based Security Model (USM) for version 3 of the Simple Network
Management Protocol (SNMPv3)
RFC 3415 View-based Access Control Model (VACM) for the Simple Network
Management Protocol (SNMP)
RFC 3418 Management Information Base (MIB) for the Simple Network
Management Protocol (SNMP)
RFC 5424 Syslog Protocol
ANSI/TIA-1057 LLDP Media Endpoint Discovery (LLDP-MED)
SNMPv1/v2c/v3
XRMON

OSPF RFC 2328 OSPFv2
RFC 3101 OSPF NSSA
RFC 3623 Graceful OSPF Restart (Unplanned Outages only)
RFC 5340 OSPFv3 for IPv6

QoS/CoS RFC 2474 DiffServ Precedence, including 8 queues/port
RFC 2475 DiffServ Architecture
RFC 2597 DiffServ Assured Forwarding (AF)
RFC 2598 DiffServ Expedited Forwarding (EF)

Security IEEE 802.1X Port Based Network Access Control
RFC 1321 The MD5 Message-Digest Algorithm
RFC 2698 A Two Rate Three Color Marker
RFC 2818 HTTP Over TLS
RFC 2865 RADIUS (client only)
RFC 2866 RADIUS Accounting
RFC 3579 RADIUS Support For Extensible Authentication Protocol (EAP)
Secure Sockets Layer (SSL)
SSHv2 Secure Shell
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Aruba 3810M Switch Series accessories  
   
Modules  
Aruba 3810M 4-port Stacking Module JL084A
Aruba 3810M/2930M 4-port 100M/1G/10G SFP+ MACsec Module JL083A
Aruba 3810M/2930M 1-port QSFP+ 40GbE Module JL078A
Aruba 3810M 2QSFP+ 40GbE Module JL079A
   
Transceivers  
Aruba 100M SFP LC FX 2km MMF Transceiver J9054D
Aruba 1G SFP RJ45 T 100m Cat5e Transceiver J8177D
Aruba 1G SFP LC SX 500m OM2 MMF Transceiver J4858D
Aruba 1G SFP LC LX 10km SMF Transceiver J4859D
Aruba 1G SFP LC LH 70km SMF Transceiver J4860D
Aruba 10G SFP+ LC SR 300m OM3 MMF Transceiver J9150D
Aruba 10G SFP+ LC LR 10km SMF Transceiver J9151D
Aruba 10G SFP+ LC LRM 220m OM2 MMF Transceiver J9152D
Aruba 10G SFP+ LC ER 40km SMF Transceiver J9153D
Aruba 10G SFP+ to SFP+ 1m Direct Attach Copper Cable J9281D
Aruba 10G SFP+ to SFP+ 3m Direct Attach Copper Cable J9283D
Aruba 10G SFP+ to SFP+ 7m Direct Attach Copper Cable J9285D
Aruba 40G QSFP+ LC Bidirectional 150m MMF 2-strand Transceiver JL308A
HPE X142 40G QSFP+ MPO SR4 Transceiver JH231A
HPE X142 40G QSFP+ LC LR4 SM Transceiver JH232A
HPE X142 40G QSFP+ MPO eSR4 300M Transceiver JH233A
HPE X242 40G QSFP+ to QSFP+ 1m Direct Attach Copper Cable JH234A
HPE X242 40G QSFP+ to QSFP+ 3m Direct Attach Copper Cable JH235A
HPE X242 40G QSFP+ to QSFP+ 5m Direct Attach Copper Cable JH236A
   
Cables  
Aruba X2C2 RJ45 to DB9 Console Cable JL448A
Aruba 3800/3810M 0.5m Stacking Cable J9578A
Aruba 3800/3810M 1m Stacking Cable J9665A
Aruba 3800/3810M 3m Stacking Cable J9579A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 1m Cable QK732A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 2m Cable QK733A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 5m Cable QK734A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 15m Cable QK735A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 30m Cable QK736A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 50m Cable QK737A
   
Power Supply  
Aruba X371 12VDC 250W 100-240VAC Power Supply JL085A
Aruba X372 54VDC 680W 100-240VAC Power Supply JL086A
Aruba X372 54VDC 1050W 110-240VAC Power Supply JL087A
   
Fan Tray  
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Aruba 3810 Switch Fan Tray JL088A
   
Mounting Kit  
HPE X410 1U Universal 4-post Rackmount Kit J9583A
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Date Version History Action Description of Change
03-Dec-2018 Version 18 Changed Software feature update: Key features, Product

overview and Enhanced Capabilities updated
02-Jul-2018 Version 17 Changed Software feature update
07-May-2018 Version 16 Added Edits made on Configuration section and

Technical Specifications
05-Mar-2018 Version 15 Changed Configuration section updated.
05-Feb-2018 Version 14 Changed Configuration section updated.

Document name updated to match Product
Master.

08-Jan-2018 Version 13 Changed Software feature update
07-Aug-2017 Version 12 Added SKU added: JL308A
03-Jul-2017 Version 11 Added SKU added: JL448A
08-May-2017 Version 10 Changed Configuration section updated
03-Apr-2017 Version 9 Changed Modules updated on Configuration section
17-Feb-2017 Version 8 Changed Configuration section updated (Adding #B2B,

#B2C, and #B2E Options on SKUs JL428A;
JL429A and JL430A)

09-Jan-2017 Version 7 Added Models added: JL428A, JL429A, JL430A
07-Nov-2016 Version 6 Changed Product overview, Features and Benefits

updated
19-Aug-2016 Version 5 Changed Configuration section updated. Minor changes

made on Technical Specifications.
06-June-2016 Version 4 Changed Features and Benefits, Standards and

Protocols, Accessories updated.
SKU descriptions updated.

18-Mar-2016 Version 3 Changed Minor edits on Features and Benefits, Switch
family photo added.

11-Dec-2015 Version 2 Changed Standards and protocols and Configuration
Menu updated

01-Dec-2015 Version 1 Created Document creation
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This guide provides information on how to configure, manage, and monitor basic switch operation.

Applicable products
This guide applies to these products:

Aruba 3810 Switch Series (JL071A, JL072A, JL073A, JL074A, JL075A, JL076A)

Aruba 5400R zl2 Switch Series (J9821A, J9822A, J9850A, J9851A, JL001A, JL002A, JL003A, JL095A)

Switch prompts used in this guide
Examples in this guide are representative and may not match your particular switch/environment. Examples use
simplified prompts as follows:

Prompt Explanation

switch# # indicates manager context (authority).

switch> > indicates operator context (authority).

switch(config)# (config) indicates the config context.

switch(vlan-x)# (vlan-x) indicates the vlan context of config, where x
represents the VLAN ID. For example:
switch(vlan-128)#.

switch(eth-x)# (eth-x) indicates the interface context of config,
where x represents the interface. For example:
switch(eth-48)#.

switch-Stack# Stack indicates that stacking is enabled.

switch-Stack(config)# Stack(config) indicates the config context while
stacking is enabled.

switch-Stack(stacking)# Stack(stacking) indicates the stacking context of
config while stacking is enabled.

switch-Stack(vlan-x)# Stack(vlan-x) indicates the vlan context of config
while stacking is enabled, where x represents the
VLAN ID. For example: switch-
Stack(vlan-128)#.

switch-Stack(eth-x/y)# Stack(eth-x/y) indicates the interface context of
config, in the form (eth-<member-in-stack>/
<interface>). For example: switch(eth-1/48)#

Chapter 1
About this guide
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Using time synchronization ensures a uniform time among interoperating devices. This helps you to manage and
troubleshoot switch operation by attaching meaningful time data to event and error messages.

For successful time protocol setup and specific configuration details, contact your system administrator regarding
your local configuration. The ArubaOS-Switch utilizes the Network Time Protocol (NTP)

NTP
NTP synchronizes the time of day among a set of distributed time servers and clients in order to correlate events
when receiving system logs and other time-specific events from multiple network devices. NTP uses the User
Datagram Protocol (UDP) as its transport protocol.

All NTP communications use Coordinated Universal Time (UTC). An NTP server usually receives its time from an
authoritative time source, such as a radio clock or an atomic clock attached to a time server, and then distributes
this time across the network. NTP is extremely efficient; no more than one packet per minute is necessary to
synchronize two machines to within a millisecond of each other.

NTP uses a stratum to describe the distance between a network device and an authoritative time source:

• A stratum 1 time server is directly attached to an authoritative time source (such as a radio or atomic clock or a
GPS time source).

• A stratum 2 NTP server receives its time through NTP from a stratum 1 time server.

Before synchronizing, NTP compares the time reported by several network devices and does not synchronize
with one that is significantly different, even if it is a stratum 1.

You an use the security features of NTP to avoid the accidental or malicious setting of incorrect time. One such
mechanism is available: an encrypted authentication mechanism.

Though similar, the NTP algorithm is more complex and accurate than the Simple Network Time Protocol (SNTP).

IMPORTANT:

Enabling this feature results in synchronizing the system clock; therefore, it may affect all sub-
systems that rely on system time.

NTP related commands
The following commands allow the user to configure NTP or show NTP configurations.

timesync
Syntax
 [no]timesync [timep |sntp | timep-or-sntp | ntp]
Description

Use this command to configure the protocol for network time synchronization.

Parameters and options
no

Deletes all timesync configurations on the device.

Chapter 2
Time synchronization
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timep
Updates the system clock using TIMEP.

sntp
Updates the system clock using SNTP.

timep-or-sntp
Updates the system clock using TIMEP or SNTP (default).

ntp
Updates the system clock using NTP

timesync

Switch(config)# timesync
sntp                  Update the system clock using SNTP.
timep                 Update the system clock using TIMEP.
timep-or-sntp         Update the system clock using TIMEP or SNTP.
ntp                   Update the system clock using NTP.

timesync ntp
Syntax
 timesync ntp
Description

Use this command to update the system clock using NTP.

ntp
Syntax
[no] ntp [broadcast|unicast]
Description

This command selects the operating mode of the NTP client. Defaults to broadcast.

Parameters and options
no

Using no ntp disables NTP and removes all NTP configurations on the device.

no ntpExample

switch(config)# no ntp
This will delete all NTP configurations on this device. Continue [y/n]?

broadcast
Sets ntp client to operate in broadcast mode.

unicast
Sets ntp client to operate in unicast mode.

[no] ntp
This command disables NTP and removes all NTP configurations on the device.
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Syntax
[no] ntp [authentication <key-id>
 | broadcast | enable | max-association 
<integer> | server 
<IP-ADDR> | trap 
<trap-name> | unicast]
      
Description

Disable NTP and removes the entire NTP configuration.

Options

authentication

Configure NTP authentication.

broadcast

Operate in broadcast mode.

enable

Enable/disable NTP.

max-association

Maximum number of Network Time Protocol (NTP) associations.

server

Configure a NTP server to poll for time synchronization.

trap

Enable/disable NTP traps.

unicast

Operate in unicast mode.

Example
switch(config)# no ntp
This will delete all NTP configurations on this device. Continue [y/n]?

ntp enable
Syntax
ntp enable
Description

Use this command to enable or disable NTP on the switch.

Restrictions

Validation Error/Warning/Prompt

If timeSync is in SNTP or Timep when NTP is enabled. Timesync is not configured to NTP.

When timesync is NTP and ntp is enabled and we try to
change timesync to SNTP.

Disable NTP before changing timesync to
SNTP or TIMEP
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Enable ntp

switch(config)# ntp
enable       Enable/disable NTP.

ntp authentication
Syntax
ntp authentication key-id <KEY-ID> [authentication-mode <MODE> key-value <KEY-STRING>] [trusted]
        

Description

This command is used for authentication of NTP server by the NTP client.

Parameters and options
key-id <KEY-ID>

Sets the key-id for the authentication key.

authentication-mode
Sets the NTP authentication mode

key-value <KEY-STRING>
Sets the key-value for the authentication key.

[trusted]
Sets the authentication key as trusted.

ntp authentication

Switch(config)# ntp
Authentication      Configure NTP authentication.

Switch(config)# ntp authentication
key-id              Set the key-id for this authentication key.

Switch(config)# ntp authentication key-id 
<1-4294967295>      Set the authentication key-id.

Switch(config)# ntp authentication key-id 1
authentication-mode  Set the NTP authentication mode.
trusted              Set this authentication key as trusted.

Switch(config)# ntp authentication key-id 1 
authentication-mode|trusted md5
Authenticate using MD5.

Switch(config)# ntp authentication key-id 1 
authentication-mode|trusted md5key-value  Set the NTP authentication key.

Switch(config)# ntp authentication key-id 1
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authentication-mode|trusted md5 key-value 
KEY           Enter a string to be set as the NTP authentication key.

ntp max-associations
Syntax
ntp max-associations <number>
        
Description

Use this command to configure the maximum number of servers associated with this NTP client.

Parameters and options
<number>

Sets the maximum number of NTP associations, in the range of 1–8.

ntp max-associations

Switch(config)# ntp
max-associations      Maximum number of NTP associations.

Switch(config)# ntp max-associations
<1-8>                  Enter the number.
Restrictions

Validation Error/Warning/Prompt

When the number of configured NTP servers is more
than the max-associations value.

The maximum number of NTP servers
allowed is <number>.

When the max-associations value is less than the (n)
number of configured NTP servers.

Max-associations value cannot be less
than the number of NTP servers
configured.

ntp server

Syntax
ntp server [IP-ADDR|<IPv6-ADDR>] [<SERVER-NAME>] [key <KEY-ID>] [OOBM] 
[max-poll <MAX-POLL-VAL>][min-poll <MIN-POLL-VAL>][burst | iburst] [version <1-4>]

no ntp server [<IP-ADDR|IPv6-ADDR>] [server-name] [key <KEY-ID>] [oobm] [max-poll 
<MAX-POLL-VAL>][min-poll <MIN-POLL-VAL>][burst | iburst] [version <1-4>]
        

Description

This command is used to configure the NTP servers using a variety of parameters. A maximum of 8 NTP servers
may be configured.

The no version of this command removes parameters from the NTP servers.
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Parameters
IP-ADDR

Sets the IPv4 address of the NTP server.

IPv6-ADDR

Sets the IPv6 address of the NTP server.

SERVER-NAME

User configured host name will be saved in config. Hostname is resolved and IP address is updated to the
existing NTP protocol data structure.

KEY-ID

Specifies the authentication key.

OOBM

Specifies that the NTP Unicast server is accessible over an OOBM interface.

MIN-POLL-VAL

Configures the minimum time intervals in seconds. Range is 4–17.

MAX-POLL-VAL

Configures the maximum time intervals in power of 2 seconds. Range is 4–17 (e.g., 5 would translate to 2
raised to 5 or 32).

BURST

Enables burst mode.

iBURST

Enables initial burst mode.

VERSION NUMBER

Sets version 1–4.

ntp server configuration

Switch(config)# ntp
server          Allow the software clock to be synchronized by an NTP
time server.
broadcast       Operate in broadcast mode.
unicast         Operate in unicast mode.

Switch(config)# ntp server
IP-ADDR         IPv4 address of the NTP server. 
IPV6-ADDR       IPv6 address of the NTP server.
NAME            Server name of NTP servers.

Switch(config)# ntp server <IP-ADDR>
Key             Specify the authentication key.

Switch(config)# ntp server <IP-ADDR> key key-id
Max-poll        Configure the maximum time intervals in seconds.

Switch(config)# ntp server <IP-ADDR> key key-id max-poll
<4-17>          Enter an integer number.
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Switch(config)# ntp server <IP-ADDR> key key-id
Min-poll        Configure the minimum time intervals in seconds.

Switch(config)# ntp server <IP-ADDR> key key-id min-poll
<4-17>          Enter an integer number.

Switch(config)# ntp server <IP-ADDR> key key-id prefer max-poll 
<max-poll-val> min-poll <min-poll-val>
iburst          Enable initial burst (iburst) mode.
burst           Enable burst mode.

Switch(config)# ntp server IP-ADDR key key-id prefer maxpoll <number>
minpoll <number> iburst

ntp server key-id
Syntax
ntp server <IP-ADDR |IPV6-ADDR> 
key—id <key-id> [max-poll 
<max-poll-val>] [min-poll 
<min-poll-val>] [burst | iburst]
      
Description

Configure the NTP server. <IP-ADDR> indicates the IPv4 address of the NTP server. <IPV6-ADDR> indicates the
IPv6 address of the NTP server.

Options

burst

Enables burst mode.

iburst

Enables initial burst (iburst) mode.

key-id

Set the authentication key to use for this server.

max-poll <max-poll-val>

Configure the maximum time intervals in seconds.

min-poll <min-poll-val>

Configure the minimum time intervals in seconds.

ntp ipv6-multicast
Syntax
ntp ipv6-multicast
Description

Use this command to configure NTP multicast on a VLAN interface.

Restrictions
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Validation Error/Warning/Prompt

If ipv6 is not enabled on vlan interface IPv6 address not configured on the
VLAN.

ntp ipv6–multicast

Switch(vlan-2)# ntp
ipv6-multicast       Configure the interface to listen to the NTP multicast packets.

debug ntp
Syntax
debug ntp [event|packet]
Description

Use this command to display debug messages for NTP.

Parameters and options
event

Displays event log messages related to NTP.

packets
Displays NTP packet messages.

debug ntp

Switch(config)# debug ntp
event                 Display event log messages related to NTP.
packet                Display NTP packet messages.

ntp trap
Syntax
[no] ntp trap <TRAP-NAME>
Description

Use this command to configure NTP traps.

Parameters and options
no

Disables NTP traps.

TRAP-NAME

Specifies the NTP trap name.

Specifiers

Specify trap names as follows:

 ntp-mode-change
 ntp-stratum-change
 ntp-peer-change
 ntp-new-association
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 ntp-remove-association
 ntp-config-change
 ntp-leapsec-announced
 ntp-alive-heartbeat
Usage

The traps defined below are generated as the result of finding an unusual condition while parsing an NTP packet
or a processing a timer event. Note that if more than one type of unusual condition is encountered while parsing
the packet or processing an event, only the first one will generate a trap. Possible trap names are:

- 'ntpEntNotifModeChange' The notification to be sent when the NTP entity changes
mode, including starting and stopping (if possible).
- 'ntpEntNotifStratumChange' The notification to be sent when stratum level of NTP
changes.
- 'ntpEntNotifSyspeerChanged' The notification to be sent when a (new) syspeer has
been selected.
- 'ntpEntNotifAddAssociation' The notification to be sent when a new association is
mobilized.
- 'ntpEntNotifRemoveAssociation' The notification to be sent when an association is
demobilized.
- 'ntpEntNotifConfigChanged' The notification to be sent when the NTP configuration
has changed.
- 'ntpEntNotifLeapSecondAnnounced' The notification to be sent when a leap second
has been announced.
- 'ntpEntNotifHeartbeat' The notification to be sent periodically (as defined by
ntpEntHeartbeatInterval) to indicate that the NTP entity is still alive.

show ntp servers

Syntax
show ntp servers

Description

to display configured NTP server detail.

Command context
config

Examples

Shows NTP servers in detail.

switch# show ntp servers

show ntp statistics
Syntax
show ntp statistics
Description

Use this command to show NTP statistics.
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show ntp statistics

Switch(config)# show ntp statistics

NTP Global statistics information

NTP In Packets                : 100
NTP Out Packets               : 110
NTP Bad Version Packets       : 4
NTP Protocol Error Packets    : 0

show ntp status
Syntax
show ntp status
Description

Use this command to show the status of the NTP.

show ntp status

Switch(config)# show ntp status

NTP Status information
NTP Status             : Disabled             NTP Mode        : Broadcast
Synchronization Status : Synchronized         Peer Dispersion : 8.01 sec
Stratum Number         : 2                    Leap Direction  : 1
Reference Assoc Id     : 1                    Clock Offset    : 0.0000 sec
Reference              : 192.0.2.1            Root Delay      : 0.00 sec
Precision              : 2**7                 Root Dispersion : 15.91 sec
NTP Uptime             : 01d 09h 15m          Time Resolution : 1
Drift                  : 0.000000000 sec/sec

System Time            : Tue Aug 25 04:59:11 2015
Reference Time         : Mon Jan  1 00:00:00 1990

show ntp authentication
Syntax
show ntp authentication
Description

Use this command to show the authentication status of the NTP.

show ntp authentication

Switch(config)# show ntp authentication

NTP Authentication Information

Key-ID     Auth Mode   Trusted
--------   ----------  -------  
67            md5       yes 
7             md5       no
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show ntp associations
Syntax
show ntp associations
Description

Use this command to show the NTP associations configured for your system.

show ntp associations

Switch(config)# show ntp associations

                          NTP Associations Entries

Address          St   T  When Poll  Reach   Delay    Offset   Dispersion
--------------   ---  -- ---- ----- ------ -------   -------  ----------
121.0.23.1       16   u   -  1024    0      0.000     0.000    0.000
231.45.21.4      16   u   -  1024    0      0.000     0.000    0.000
55.21.56.2       16   u   -  1024    0      0.000     0.000    0.000
23.56.13.1        3   u 209  1024   377     54.936   -6.159    12.688
91.34.255.216     4   u 132  1024   377     1.391     0.978    3.860

show ntp associations detail
Syntax
show ntp associations detail <IP ADDR>
        
Description

Use this command to show the detailed status of NTP associations configured for your system.

Parameters and options
IP-ADDR

Specify the IPv4 address of the NTP server.

show ntp association detail

Switch(config)# show ntp association detail <IP ADDR>

NTP association information

IP address                : 172.31.32.2                 Peer Mode        : Server
Status                    : Configured, Insane, Invalid Peer Poll Intvl  : 64
Stratum                   : 5                           Root Delay       : 137.77 sec
Ref Assoc ID              : 0                           Root Dispersion  : 142.75
Association Name          : NTP Association 0           Reach            : 376
Reference ID              : 16.93.49.4                  Delay            : 4.23 sec
Our Mode                  : Client                      Offset           : -8.587 sec
Our Poll Intvl            : 1024                        Precision        : 2**19
Dispersion                : 1.62 sec
Association In Packets    : 60
Association Out Packets   : 60
Association Error Packets : 0
Origin Time               : Fri Jul  3 11:39:40 2015
Receive Time              : Fri Jul  3 11:39:44 2015
Transmit Time             : Fri Jul  3 11:39:44 2015

-----------------------------------------------------------------------------
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Filter Delay =   4.23    4.14    2.41    5.95    2.37    2.33    4.26    4.33
Filter Offset = -8.59   -8.82   -9.91   -8.42  -10.51  -10.77  -10.13  -10.11

FQDN support for NTP servers

FQDN support for NTP servers
Fully Qualified Domain Name (FQDN) for a NTP server allows for the configuration of server names. Support for
handling multiple IP addresses is resolved as part of a DNS resolution. NTP unicast server configuration with the
FQDN option can support up to 8 NTP servers including a NTP server configured using an IPv4 address. The
user configured host name will be saved in configuration and during NTP protocol updates, the hostname will
resolve and the IP address updated to the existing NTP protocol data structure. Actual NTP server request will
happen through IP address only.

NTP server configuration should allow sever name (FQDNs) to be configured without breaking backward
compatibility.

For more information on configuring NTP servers, refer to the Management and Configuration Guide for your
switch.

Usage

• When NTP server details are configured using 'server-name' option, it will postpone the NTP protocol update
until DNS resolution is completed or DNS resolution completes.

• If there is any failure or delay in DNS resolution, it can delay the usage of configured server for further NTP
process.

• If the user provided NTP server names fail to resolve, the show ntp servers output will show each server
name and the corresponding resolution status. The NTP server will not retry resolving any failed entries.
Retrying the same server name will attempt resolution without incrementing the total NTP server count.

Restrictions

• NTP server will not support resolving server hostname on every NTP poll sequence.

• NTP does not check for the directed broadcast IP.

ntp server

Syntax
ntp server [IP-ADDR|<IPv6-ADDR>] [<SERVER-NAME>] [key <KEY-ID>] [OOBM] 
[max-poll <MAX-POLL-VAL>][min-poll <MIN-POLL-VAL>][burst | iburst] [version <1-4>]

no ntp server [<IP-ADDR|IPv6-ADDR>] [server-name] [key <KEY-ID>] [oobm] [max-poll 
<MAX-POLL-VAL>][min-poll <MIN-POLL-VAL>][burst | iburst] [version <1-4>]
        

Description

This command is used to configure the NTP servers using a variety of parameters. A maximum of 8 NTP servers
may be configured.

The no version of this command removes parameters from the NTP servers.
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Parameters
IP-ADDR

Sets the IPv4 address of the NTP server.

IPv6-ADDR

Sets the IPv6 address of the NTP server.

SERVER-NAME

User configured host name will be saved in config. Hostname is resolved and IP address is updated to the
existing NTP protocol data structure.

KEY-ID

Specifies the authentication key.

OOBM

Specifies that the NTP Unicast server is accessible over an OOBM interface.

MIN-POLL-VAL

Configures the minimum time intervals in seconds. Range is 4–17.

MAX-POLL-VAL

Configures the maximum time intervals in power of 2 seconds. Range is 4–17 (e.g., 5 would translate to 2
raised to 5 or 32).

BURST

Enables burst mode.

iBURST

Enables initial burst mode.

VERSION NUMBER

Sets version 1–4.

ntp server configuration

Switch(config)# ntp
server          Allow the software clock to be synchronized by an NTP
time server.
broadcast       Operate in broadcast mode.
unicast         Operate in unicast mode.

Switch(config)# ntp server
IP-ADDR         IPv4 address of the NTP server. 
IPV6-ADDR       IPv6 address of the NTP server.
NAME            Server name of NTP servers.

Switch(config)# ntp server <IP-ADDR>
Key             Specify the authentication key.

Switch(config)# ntp server <IP-ADDR> key key-id
Max-poll        Configure the maximum time intervals in seconds.

Switch(config)# ntp server <IP-ADDR> key key-id max-poll
<4-17>          Enter an integer number.
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Switch(config)# ntp server <IP-ADDR> key key-id
Min-poll        Configure the minimum time intervals in seconds.

Switch(config)# ntp server <IP-ADDR> key key-id min-poll
<4-17>          Enter an integer number.

Switch(config)# ntp server <IP-ADDR> key key-id prefer max-poll 
<max-poll-val> min-poll <min-poll-val>
iburst          Enable initial burst (iburst) mode.
burst           Enable burst mode.

Switch(config)# ntp server IP-ADDR key key-id prefer maxpoll <number>
minpoll <number> iburst

show ntp servers

Syntax
show ntp servers

Description

to display configured NTP server detail.

Command context
config

Examples

Shows NTP servers in detail.

switch# show ntp servers

Elements of time synchronization
Time synchronization contains several elements. These include:

• Protocol — SNTP or TimeP. The switch offers TimeP and SNTP (Simple Network Time Protocol) and a
timesync command for changing the time protocol selection (or turning off time protocol operation.)

• Authentication modes — Broadcast or Unicast for SNTP, and DHCP or Manual for TimeP

• Status — Enabled or Disabled. Simply selecting a time synchronization protocol does not enable that protocol
on the switch. You must also enable the protocol itself by setting the appropriate parameter (enabled or
disabled).

Although you can create and save configurations for both time protocols without conflicts, the switch allows only
one active time protocol at any time. In addition, the switch retains the parameter settings for both time protocols,
even if you change from one protocol to the other. Thus, if you select a time protocol, the switch uses the
parameters you last configured for the selected protocol.

Time synchronization protocols
Use the timesync command to set the time synchronization protocol, either SNTP or TimeP.
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• SNTP—To run SNTP as the switch's time synchronization protocol, you must also select SNTP as the time
synchronization method using the CLI timesync command, or the menu interface Time Sync Method
parameter.

• TimeP—You can manually assign the switch to use a TimeP server or use DHCP to assign the TimeP server.
In either case, the switch can get its time synchronization updates from only one, designated TimeP server.
This option enhances security by specifying which time server to use.

timesync
Syntax
timesync [timep|sntp]
Description

The timesync command configures the network time protocol for sntp or timep.

Parameters and options
sntp

Sets the time protocol to SNTP.

TimeP
Sets the time protocol to TIMEP.

timesync [timep | sntp]

switch# timesync timep

switch# timesync sntp

Setting a time protocol on the switch
Procedure

1. Select a time synchronization protocol: SNTP or TimeP (the default). See timesync on page 48.

2. Enable the protocol. Choose one:

• SNTP: Broadcast or Unicast
• TimeP: DHCP or Manual

3. Configure the remaining parameters for the time protocol you selected.

4. View the configuration.

The SNTP protocol
SNTP provides the following operating modes:

• Broadcast mode

The switch acquires time updates by accepting the time value from the first SNTP time broadcast detected. (In
this case, the SNTP server must be configured to broadcast time updates to the network broadcast address;
see the documentation provided with your SNTP server application.) Once the switch detects a particular
server, it ignores time broadcasts from other SNTP servers unless the configurable Poll Interval expires three
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consecutive times without an update received from the first-detected server. If the Poll Interval (configurable up
to 720 seconds) expires three times without the switch detecting a time update from the original server, the
switch accepts a broadcast time update from the next server it detects.Directs the switch to acquire its time
synchronization from data broadcast by any SNTP server to the network broadcast address. The switch uses
the first server detected and ignores any others. However, if the Poll Interval (configurable up to 720 seconds)
expires three times without the switch detecting a time update from the original server, the switch accepts a
broadcast time update from the next server it detects.

NOTE: To use Broadcast mode, the switch and the SNTP server must be in the same subnet.

• Unicast mode

Directs the switch to poll a specific server periodically for SNTP time synchronization.The default value
between each polling request is 720 seconds, but can be configured.At least one manually configured server
IP address is required.

NOTE: At least one key-id must be configured as trusted, and it must be associated with one
of the SNTP servers. To edit or remove the associated key-id information or SNTP server
information, SNTP authentication must be disabled.

The switch periodically requests a time update, for the purposes of time synchronization, from the configured
SNTP server. (You can configure one server using the menu interface, or up to three servers using the CLI
sntp server command.) This option provides increased security over the Broadcast mode by specifying which
time server to use instead of using the first one detected through a broadcast. The default value between each
polling request is 720 seconds, but can be configured. At least one manually configured server IP address is
required.

When running SNTP unicast time polling as the time synchronization method, the switch requests a time
update from the server you configured, with either the server address parameter in the menu interface, or the
primary server in a list of up to three SNTP servers configured using the CLI. If the switch does not receive a
response from the primary server after three consecutive polling intervals, the switch tries the next server (if
any) in the list. If the switch tries all servers in the list without success, it sends an error message to the Event
Log and reschedules to try the address list again after the configured Poll Interval time has expired.

If there are already three SNTP server addresses configured on the switch, and you want to use the CLI to
replace one of the existing addresses with a new one, you must delete the unwanted address before you
configure the new one.

Selecting and configuring SNTP

Procedure

Use the SNTP command to specify whether the switch operates in broadcast or unicast mode. With no mode
specified, the setting defaults to broadcast.

Prerequisites

• Configure at least one key-id as trusted, and then associate it with one of the SNTP servers (see SNTP
authentication trusted keys on page 58

• Configure the appropriate parameters, such as poll interval, server address and version

• To edit or remove the associated key-id information or SNTP server information, disable SNTP
authentication
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sntp

IMPORTANT:

To enable authentication, you must configure either unicast or broadcast mode. After authentication
is enabled, changing the mode from unicast to broadcast or vice versa is not allowed; you must
disable authentication and then change the mode.

To set the SNTP mode or change from one mode to the other, enter the appropriate command.

Syntax
sntp
Description

This command configures SNTP, including specifying whether the switch operates in broadcast or unicast mode.

Parameters and options
 Disabled

The Default. SNTP does not operate, even if specified by the Menu interface Time Sync Method parameter
or the CLI timesync command.

 Unicast
Directs the switch to poll a specific server for SNTP time synchronization. Requires at least one server
address.

 Broadcast
Directs the switch to acquire its time synchronization from data broadcast by any SNTP server to the network
broadcast address. The switch uses the first server detected and ignores any others. However, if the Poll
Interval expires three times without the switch detecting a time update from the original server, the switch
accepts a broadcast time update from the next server it detects.

Poll interval (seconds)

In Unicast Mode: Specifies how often the switch polls the designated SNTP server for a time update.

In Broadcast Mode: Specifies how often the switch polls the network broadcast address for a time update.

Value is between 30 to 720 seconds.

Server Address

Used only when the SNTP Mode is set to Unicast. Specifies the IP address of the SNTP server that the
switch accesses for time synchronization updates. You can configure up to three servers; one using the menu
or CLI, and two more using the CLI.

Server Version

Specifies the SNTP software version to use and is assigned on a per-server basis. The version setting is
backwards-compatible. For example, using version 3 means that the switch accepts versions 1 through 3.
Default: 3; range: 1 to 7.

Priority

Specifies the order in which the configured servers are polled for getting the time.

Value is between 1 and 3.

oobm

For switches that have a separate out-of-band management port, specifies that SNTP traffic goes through that
port. (By default, SNTP traffic goes through the data ports.)
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sntp broadcast|unicast output

switch# sntp broadcast

switch# sntp unicast

Enabling SNTP in Broadcast mode
Because the switch provides an SNTP polling interval (default: 720 seconds), you need only timesync on page
48 and sntp on page 50 commands for minimal SNTP broadcast configuration.

Figure 1: SNTP in Broadcast Mode on page 51 shows time synchronization in the factory default
configuration, TimeP.

Procedure

1. To view the current time synchronization, enter show sntp.

2. Use the timesync command to set SNTP as the time synchronization mode:

timesync sntp
3. Use the SNTP command to enable SNTP for Broadcast mode:

sntp broadcast
4. View the SNTP configuration again to verify the configuration.

Figure 1: SNTP in Broadcast Mode

Configuring SNTP in unicast mode
As with broadcast mode, configuring SNTP for unicast mode enables SNTP. For unicast operation, however, you
must also specify the IP address of at least one SNTP server. The switch allows up to three unicast servers. You
can use the Menu interface or the CLI to configure one server or to replace an existing unicast server with
another. To add a second or third server, you must use the CLI.

The following is an example of a full SNTP unicast operation.

Procedure

1. Select the SNTP protocol:
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switch(config)# timesync sntp
2. Set the mode to unicast:

switch(config)# sntp unicast
3. Specify the SNTP server and set the server priority:

switch(config)# sntp server priority 1 10.28.227.141
This specifies the SNTP server and accepts the current SNTP server version (default: 3).

switch(config)# show sntp
SNTP Configuration
SNTP Authentication : Disabled
Time Sync Mode: Timep
SNTP Mode : disabled
Poll Interval (sec) [720] : 720
Source IP Selection: Outgoing Interface
switch(config)# timesync sntp
switch(config)# sntp broadcast
switch(config)# show sntp
SNTP Configuration
SNTP Authentication : Disabled
Time Sync Mode: Sntp
SNTP Mode : Broadcast
Poll Interval (sec) [720] : 720
Source IP Selection: Outgoing Interface
If the SNTP server you specify uses SNTP v4 or later, use the sntp server command to specify the correct
version number. For example, suppose you learned that SNTP v4 was in use on the server you specified above
(IP address 10.28.227.141.) You would use the following commands to delete the server IP address , re-enter it
with the correct version number for that server.

switch(config)# sntp server priority 1 10.28.227.141 4
switch(config)# show sntp
SNTP Configuration
SNTP Authentication : Disabled
Time Sync Mode: Sntp
SNTP Mode : Unicast
Poll Interval (sec) [720] : 720
Source IP Selection: Outgoing Interface
Priority SNTP Server Address  Version Key-id
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-------- -------------------  ------- ----------
1        10.28.227.141          4       0
Figure 2: SNTP in unicast mode

If the SNTP server you specify uses SNTP v4 or later, use the sntp server command to specify the correct
version number. For example, suppose SNTP v4 is in use on the server you specified above (IP address
10.28.227.141.) Use the SNTP commands shown in the following figure to delete the server IP address, and then
re-enter it with the correct version number for that server.

Figure 3: Specifying the SNTP protocol version number

Viewing SNTP parameters

Viewing SNTP server addresses using the CLI
The System Information screen in the menu interface displays only one SNTP server address, even if the switch
is configured for two or three servers.

show management
Syntax
show management
Description

Displays all configured SNTP servers on the switch.
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Viewing SNTP server addresses using the GUI

switch# show management
 
Status and Counters - Management Address Information
Time Server Address : fe80::215:60ff:fe7a:adc0%vlan10

Priority   SNTP Server Address Protocol Version
-------- ---------------------------------------------- ----------------
1       2001:db8::215:60ff:fe79:8980 7
2       10.255.5.24 3
3       fe80::123%vlan10 3

Default Gateway : 10.0.9.80

VLAN Name    MAC Address         | IP Address
------------ ------------------- + -------------------
DEFAULT_VLAN 001279-88a100       | Disabled
VLAN10       001279-88a100       | 10.0.10.17

Enabling SNTP client authentication
The command sntp authentication enables SNTP client authentication on the switch. If SNTP
authentication is not enabled, SNTP packets are not authenticated.

Enabling SNTP authentication allows network devices such as switches to validate the SNTP messages received
from an NTP or SNTP server before updating the network time. NTP or SNTP servers and clients must be
configured with the same set of authentication keys so that the servers can authenticate the messages they send
and clients (switches) can validate the received messages before updating the time.

This feature provides support for SNTP client authentication on switches, which addresses security
considerations when deploying SNTP in a network.

Requirements to enable SNTP client authentication
You must configure all of the the following items to enable SNTP client authentication on the switch.

SNTP client Authentication Support Requirements

• Timesync mode must be SNTP. Use the timesync sntp command. SNTP is disabled by default.

• SNTP must be in unicast or broadcast mode.

• The MD5 authentication mode must be selected.

• An SNTP authentication key-identifier (key-id) must be configured on the switch and a value (key-value)
must be provided for the authentication key. A maximum of 8 sets of key-id and key-value can be
configured on the switch.

• Among the keys that have been configured, one key or a set of keys must be configured as trusted. Only
trusted keys will be used for SNTP authentication.

• If the SNTP server requires authentication, one of the trusted keys has to be associated with the SNTP server.

• SNTP client authentication must be enabled on the switch. If client authentication is disabled, packets are
processed without authentication. All of the above steps are necessary to enable authentication on the client.

SNTP server authentication support

The following must be performed on the SNTP server:
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• The same authentication key-identifier, trusted key, authentication mode and key-value that were configured
on the SNTP client must also be configured on the SNTP server.

• SNTP server authentication must be enabled on the server. If any of the parameters on the server are
changed, the parameters have to be changed on all the SNTP clients in the network as well. The
authentication check will fail on the clients otherwise, and the SNTP packets will be dropped.

NOTE:

SNTP server is not supported on HPE products.

IMPORTANT:

If any of the parameters on the server are changed, the parameters have to be changed on all the
SNTP clients in the network as well. The authentication check fails on the clients otherwise, and the
SNTP packets are dropped.

Viewing all SNTP authentication keys that have been configured on the switch
Enter the show sntp authentication command.

Show SNTP authentication command output

switch(config)# show sntp authentication

  SNTP Authentication Information

  SNTP Authentication : Enabled

  Key-ID  Auth Mode  Trusted
  ------- ---------- --------
  55      MD5        Yes
  10      MD5        No

SNTP poll interval

IMPORTANT:

This parameter is different from the poll interval parameter used for the TimeP operation. Enabling
SNTP mode also enables the SNTP poll interval.

sntp poll-interval
Syntax
sntp poll-interval <30-720>
        
Description

Configures the poll interval to specify the amount of time between updates of the system clock using SNTP.
Defaults to 720 seconds, and the range is 30 to 720 seconds.

Changing an SNTP poll interval to 300 seconds

switch# sntp 300
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SNTP unicast time polling with multiple SNTP servers
When you use the Menu interface to configure an SNTP server IP address, the new address writes over the
current primary address, if one is configured.

When running SNTP unicast time polling as the time synchronization method, the switch requests a time update
from the server you configured with either the Server Address parameter in the menu interface, or the primary
server in a list of up to three SNTP servers configured using the CLI. If the switch does not receive a response
from the primary server after three consecutive polling intervals, the switch tries the next server (if any) in the list.
If the switch tries all servers in the list without success, it sends an error message to the Event Log and
reschedules to try the address list again after the configured Poll Interval time has expired.

If there are already three SNTP server addresses configured on the switch, and you want to use the CLI to
replace one of the existing addresses with a new one, you must delete the unwanted address before you
configure the new one.

SNTP server priority
Set the server priority to choose the order in which to poll configured servers.

sntp server priority
Syntax
[no] sntp server priority <ip-address>
        
Description

Polls for the current time among configured SNTP servers.

Parameters and options

no

Deletes a server address. If there are multiple addresses and you delete one of them, the switch re-orders the
address priority.

server priority <1-3>
Specifies the polling order of the configured SNTP servers. Value is between 1 and 3.

<IP-ADDRESS>

Supports bot IPv4 and IPv6 addresses.

Set the server priority

To set one server to priority 1 and another to priority 2:

switch# sntp server priority 1 10.28.22.141
switch# sntp server priority 2 2001:db8::215:60ff:fe79:8980

Delete a server address

To delete the primary address and automatically convert the secondary address to primary:

switch(config)# no sntp server 10.28.227.141
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SNTP software version

sntp server <version>
Syntax
sntp server [<IP-ADDRESS>] [<VERSION>]
        
Description

Specifies the SNTP software version to use. Assigned on a per-server basis.

Parameters and options

<IP-ADDRESS>

SNTP server ip-address

<VERSION>

The version setting is backwards-compatible. For example, using version 3 means that the switch accepts
versions 1 through 3. Default: 3; range: 1 to 7.

SNTP server address
Required only for unicast mode. Specifies the IP address of the SNTP server that the switch accesses for time
synchronization updates. You can configure up to three servers; one using the menu or CLI, and two more using
the CLI.

sntp server <ip-address>
Syntax
sntp server <ip-address>
Description

Specifies the IP address of the SNTP server for use in unicast mode.

Parameters and options

<ip-address>

An IPv4 or IPv6 address of an SNTP server.

Adding SNTP server addresses
You can configure one SNTP server address using either the Menu interface or the CLI. To configure a second
and third address, you must use the CLI. To configure these remaining two addresses, you would do the
following:

Creating additional SNTP server addresses with the CLI

Switch(config)# no sntp server priority 1 2001:db8::215:60ff:fe79:8980
Switch(config)# no sntp server priority 2 10.255.5.24

NOTE: If there are already three SNTP server addresses configured on the switch, and you want to
use the CLI to replace one of the existing addresses with a new one, you must delete the unwanted
address before you configure the new one.
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SNTP authentication trusted keys
Trusted keys are used in SNTP authentication. In unicast mode, you must associate a key with a specific NTP/
SNTP server. That key is used for authenticating the SNTP packet.

In unicast mode, a specific server is configured on the switch so that the SNTP client communicates with the
specified server to get the date and time.

In broadcast mode, the SNTP client switch checks the size of the received packet to determine if it is
authenticated. If the broadcast packet is authenticated, the key-id value is checked to see if the same key-id value
is configured on the SNTP client switch. If the switch is configured with the same key-id value, and the key-id
value is configured as "trusted," the authentication succeeds. Only trusted key-id value information is used for
SNTP authentication.

If the packet contains key-id value information that is not configured on the SNTP client switch, or if the received
packet contains no authentication information, it is discarded. The SNTP client switch expects packets to be
authenticated if SNTP authentication is enabled.

When authentication succeeds, the time in the packet is used to update the time on the switch.

trusted
Syntax
trusted
Description

Parameters and options

Configuration files and the include-credentials command
You can use the include-credentials command to store security information in the running-config file. This
allows you to upload the file to a TFTP server and then later download the file to the switches on which you want
to use the same settings.

The authentication key values are shown in the output of the show running-config and show config
commands only if the include-credentials command was executed.

When SNTP authentication is configured and include-credentials has not been executed, the SNTP
authentication configuration is not saved.

The following example shows an enabled SNTP authentication with a key-id of 55.

Configuration file with SNTP authentication information

 switch(config) # show config
Startup configuration:
timesync sntp
sntp broadcast
sntp 50
sntp authentication
sntp server priority 1 10.10.10.2.3 key-id 55
sntp server priority 2 fe80::200:24ff:fec8:4ca8 4 key-id 55
In this example, the include-credentials command has not been executed and is not present in the
configuration file. The configuration file is subsequently saved to a TFTP server for later use. The SNTP
authentication information is not saved and is not present in the retrieved configuration files, as shown in the
following example.
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Retrieved configuration file when include credentials is not configured

switch(config) # copy tftp startup-config 10.2.3.44 config1
Switch reboots ...
Startup configuration
timesync sntp
sntp broadcast
sntp 50 sntp server priority 1 10.10.10.2.3
sntp server priority 2 fe80::200:24ff:fec8:4ca8 4

IMPORTANT: The SNTP authentication line and the Key-ids are not displayed. Reconfigure SNTP
authentication.

If include-credentials is configured, the SNTP authentication configuration is saved in the configuration file.
When the show config command is entered, all of the information that has been configured for SNTP
authentication displays, including the key-values.

Figure 4: Saved SNTP Authentication information when include-credentials is configured

Configuring the key-identifier, authentication mode, and key-value
Configures the key-id, authentication-mode, and key-value, which are required for authentication. It is
executed in the global configuration context.

At least one key-id must be configured as trusted, and it must be associated with one of the SNTP servers.
To edit or remove the associated key-id information or SNTP server information, SNTP authentication must be
disabled.

A numeric key identifier in the range of 1-4,294,967,295 (232) that identifies the unique key value. It is sent in the
SNTP packet.

The secret key that is used to generate the message digest. Up to 32 characters are allowed for key-string .

sntp authentication
Syntax
sntp authentication key-id <KEY-ID> authentication-mode md5 key-value <key-string> trusted [encrypted-key <key-string>]
        

Description
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Configures a key-id, authentication-mode (MD5 only), and key-value, which are required for authentication.

Parameters and options

KEY-ID

A numeric key identifier in the range of 1-4,294,967,295 (232) that identifies the unique key value. It is sent in
the SNTP packet.

key-value <KEY-STRING>
The secret key that is used to generate the message digest. Up to 32 characters are allowed for key-
string .

Disabling key-id
sntp authentication key-id
Syntax
no sntp authentication key-id <KEY-ID>
        
Description

The no version of the command deletes the authentication key.

Default: No default keys are configured on the switch.

Setting parameters for SNTP authentication

switch# sntp authentication key-id 55 authentication-mode md5 key-value secretkey1

Configuring a key-id as trusted
Trusted keys are used during the authentication process. You can configure the switch with up to eight sets of
key-id/key-value pairs. Select one, specific set for authentication; this is done by configuring the set as trusted.
The key-id itself must already be configured on the switch. To enable authentication, at least one key-id must
be configured as trusted.

• Trusted keys are used in SNTP authentication.

• If the packet contains key-id value information that is not configured on the SNTP client switch, or if the
received packet contains no authentication information, it is discarded. The SNTP client switch expects
packets to be authenticated if SNTP authentication is enabled.

• When authentication succeeds, the time in the packet is used to update the time on the switch.

• In unicast mode: The trusted key is associated with a specific NTP/SNTP server, and configured on the switch
so that the SNTP client communicates with the server to get the date and time. The key is used for
authenticating the SNTP packet.

• In : The SNTP client switch checks the size of the received packet to determine if it is authenticated. If the
broadcast packet is authenticated, the key-id value is checked to see if the same key-id value is configured on
the SNTP client switch. If the switch is configured with the same key-id value, and the key-id value is
configured as "trusted," the authentication succeeds. Only trusted key-id value information is used for SNTP
authentication.
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sntp authentication key-id trusted
Syntax
[no] sntp authentication key-id <KEY-ID> trusted
        
Description

Trusted keys are used during the authentication process. You can configure the switch with up to eight sets of
key-id/key-value pairs. Select one, specific set for authentication; this is done by configuring the set as trusted.
The key-id itself must already be configured on the switch.

Parameters and options

no

The no version of the command indicates the key is unreliable (not trusted).

Default: No key is trusted by default.

key-id <KEY-ID>
trusted

To enable authentication, configure at least one key-id as trusted.

Associating a key with an SNTP server
sntp server
Syntax
[no] sntp server priority <1-3> <IP-ADDRESS> <VERSION-NUM> <KEY-ID>
<1-4,294,967,295>
Description

Configures a key-id to be associated with a specific server. The key itself must be configured on the switch.

The no version of the command disassociates the key from the server. This does not remove the authentication
key.

Default: No key is associated with any server by default.

Parameters and options
priority <1-3>

Specifies the order in which the configured servers are polled for getting the time.

<IP-ADDRESS>

The IP address of the server. Supports IPv4 or IPv6.

version-num
Specifies the SNTP software version to use and is assigned on a per-server basis. The version setting is
backwards-compatible. For example, using version 3 means that the switch accepts versions 1 through 3.
Default: 3; range: 1 - 7.

<KEY-ID>

Optional command. The key identifier sent in the SNTP packet. This key-id is associated with the SNTP
server specified in the command.
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Associating a key-id with a specific server

switch(config)# sntp server priority 1 10.10.19.5 2 key-id 55

sntp server priority
Syntax
[no] sntp server priority 1–3 [<IP-ADDRESS>]<VERSION-NUM>[<KEY-ID> <1–4,294,967,295>]
        
Description

Configures a key to be associated with a specific server. The key itself must already be configured on the switch.
Default: No key is associated with any server by default.

Parameters and options
no

Disassociates the key from the server. This does not remove the authentication key.

priority
Specifies the order in which the configured servers are polled for getting the time.

version-num
Specifies the SNTP software version to use and is assigned on a per-server basis. The version setting is
backwards-compatible. For example, using version 3 means that the switch accepts versions 1 through 3.
Default: 3; range: 1 - 7.

key-id
Optional command. The key identifier sent in the SNTP packet. This key-id is associated with the SNTP
server specified in the command.

Associating a key-id with a specific server

switch# sntp server priority 1 10.10.19.5 2 key-id 55

Enabling and disabling SNTP client authentication
The sntp authentication command enables SNTP client authentication on the switch. If SNTP
authentication is not enabled, SNTP packets are not authenticated.

sntp authentication
Syntax
[no] sntp authentication
Description

Enables the SNTP client authentication. SNTP client authentication defaults to disabled.:

Parameters and options
no

Disables authentication.

Viewing SNTP authentication configuration information
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show sntp
Syntax
show sntp authentication
Description

The show sntp command displays SNTP configuration information, including any SNTP authentication keys that
have been configured on the switch.

show sntp authentication
To display all the SNTP authentication keys that have been configured on the switch, enter the show sntp
authentication command.

switch(config) # show sntp authentication
SNTP Authentication Information
SNTP Authentication: Enabled
Key-ID                Auth Mode              Trusted
-------              -----------             -------
55                       MD5                  YES
10                       MD5                   NO

Show SNTP authentication command output

switch(config)# show sntp authentication

  SNTP Authentication Information

  SNTP Authentication : Enabled

  Key-ID  Auth Mode  Trusted
  ------- ---------- --------
  55      MD5        Yes
  10      MD5        No

Viewing all SNTP authentication keys that have been configured on the switch
SNTP configuration information

switch(config)# show sntp

 SNTP Configuration

  SNTP Authentication : Enabled
  Time Sync Mode: Sntp
  SNTP Mode : Unicast
  Poll Interval (sec) [720] : 720

  Priority SNTP Server Address                     Protocol Version KeyId
  -------- --------------------------------------- ---------------- -----
  1        10.10.10.2                              3                55
  2        fe80::200:24ff:fec8:4ca8                3                55

SNTP Statistics command output

To display the statistical information for each SNTP server, enter the sntp statistics command. The number
of SNTP packets that have failed autherntication is displayed for each SNTP server address.

Chapter 2 Time synchronization 63

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 3801



switch(config) # show sntp statistics
SNTP statistics
Received Packets:   0
Sent Packets:       3
Dropped Packets:    0

SNTP Server Address                   Auth Failed Pkts
-------------------                   ----------------
10.10.10.1                                0
fe80::200:24ff:fec8:4ca8                  0
The show sntp command displays SNTP configuration information, including any SNTP authentication keys that
have been configured on the switch.

SNTP configuration information

switch# show sntp

 SNTP Configuration

  SNTP Authentication : Enabled
  Time Sync Mode: Sntp
  SNTP Mode : Unicast
  Poll Interval (sec) [720] : 720

  Priority SNTP Server Address                     Protocol Version KeyId
  -------- --------------------------------------- ---------------- -----
  1        10.10.10.2                              3                55
  2        fe80::200:24ff:fec8:4ca8                3                55

show sntp authentication command output

To display all the SNTP authentication keys that have been configured on the switch, enter the show sntp
authentication command.

switch(config) # show sntp authentication
SNTP Authentication Information
SNTP Authentication: Enabled
Key-ID                Auth Mode              Trusted
-------              -----------             -------
55                       MD5                  YES
10                       MD5                   NO
Displays all SNTP authentication keys configured on the switch.

switch(config) # show sntp authentication
SNTP Authentication Information
SNTP Authentication: Enabled

Key-ID  Auth Mode  Trusted
-------  ----------- -------
55 MD5 YES
10 MD5 NO

Viewing statistical information for each SNTP server
To display the statistical information for each SNTP server, enter the show sntp statistics command.

The number of SNTP packets that have failed authentication is displayed for each SNTP server address.
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show sntp statistics

switch(config)# show sntp statistics
SNTP Statistics

  Received Packets : 0
  Sent Packets : 3
  Dropped Packets : 0

  SNTP Server Address                     Auth Failed Pkts
  --------------------------------------- ----------------
  10.10.10.1                                  0
  fe80::200:24ff:fec8:4ca8                    0
To display the statistical information for each SNTP server, enter the show sntp statistics command.

show sntp statistics
Syntax
show sntp statistics
Description

Shows the number of SNTP packets that have failed authentication for each SNTP server address.

SNTP authentication statistical information

Shows the statistical information for each SNTP server. The number of SNTP packets that have failed
authentication is displayed for each SNTP server address.

switch(config) # show sntp statistics
SNTP statistics
Received Packets: 0
Sent Packets: 3
Dropped Packets: 0
SNTP Server Address    Auth Failed Pkts
-------------------    ----------------
10.10.10.1          0
fe80::200:24ff:fec8:4ca8   0

switch# show sntp statistics
SNTP Statistics

  Received Packets : 0
  Sent Packets : 3
  Dropped Packets : 0

  SNTP Server Address                     Auth Failed Pkts
  --------------------------------------- ----------------
  10.10.10.1                                  0
  fe80::200:24ff:fec8:4ca8                    0

SNTP messages in the event log
If an SNTP time change of more than three seconds occurs, the switch's Event Log records the change. SNTP
time changes of less than three seconds do not appear in the Event Log.
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Storing security information in the running-config file
Enter the include-credentials command.

The TimeP Protocol
Enabling TimeP as the time protocol means configuring it for either DHCP or manual mode.

To run TimeP as the time synchronization protocol, you must also select TimeP as the time synchronization
method by using the CLI timesync command or the menu interface Time Sync Method parameter.

Procedure

1. To view the current time synchronization, enter show timep.

2. Use the timesync command to set TimeP as the time synchronization mode:

timesync timep
3. Use the ip timep command to enable timep for dhcp or manual mode:

ip timep dhcp|manual
4. View the SNTP configuration again to verify the configuration.

Enabling TimeP mode
Enabling the TimeP mode configures it for either broadcast or unicast. Run TimeP as the switch's time
synchronization protocol and select TimeP as the time synchronization method by using the CLI timesync
command (or the menu interface Time Sync Method parameter).

Procedure

1. View the current time synchronization using show sntp.

2. Set TimeP as the synchronization mode using timesync sntp.

3. Enable TimeP for DHCP mode using sntp broadcast.

4. View the TimeP configuration using show sntp.

Figure 5: Enabling TimeP operation in DHCP mode
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timesync timep
Syntax
timesync timep
Description

Selects TimeP as the time synchronization method.

TimeP in DHCP mode
Because the switch provides a TimeP polling interval (default: 720 minutes), you need the timesync timep on
page 67 and ip timep commands only, for a minimal TimeP DHCP configuration.

ip timep dhcp
Syntax
ip timep dhcp
Description

Configuring TimeP for DHCP operation

switch# show timep

Timep Configuration

Time Sync Mode: Sntp
TimeP Mode : Disabled
Poll Interval (min) [720] : 720

switch# timesync timep

switch# ip timep dhcp

switch# show timep

Timep Configuration
Time Sync Mode: Timep
TimeP Mode : DHCP Poll Interval (min): 720

Enabling TimeP for DHCP
Suppose time synchronization is configured for SNTP. Following this example to enable TimeP for DHCP.

Procedure

1. View the current time synchronization.

2. show timep displays the TimeP configuration and also shows that SNTP is the currently active time
synchronization mode.

3. Select TimeP as the time synchronization mode.

4. Enable TimeP for DHCP mode.

5. View the TimeP configuration.
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6. show timep again displays the TimeP configuration and shows that TimeP is now the currently active time
synchronization mode.

switch(config)# show timep

 Timep Configuration

  Time Sync Mode: Sntp
  TimeP Mode : Disabled
  Poll Interval (min) [720] : 720

switch(config)# timesync timep

switch(config)# ip timep dhcp

switch(config)# show timep

 Timep Configuration
  Time Sync Mode: Timep
  TimeP Mode : DHCP Poll Interval (min): 720

TimeP operation in manual mode
As with DHCP mode, configuring timep for Manual Mode enables timep; but for manual operation, you must
also specify the IP address of the timep server. (The switch allows only one timep server.)

timesync timep
Syntax
timesync timep
Description

Activates TimeP in manual mode with a specified TimeP server. By default, SNTP traffic goes through the data
ports.

ip timep
Syntax
ip timep manual<IP-ADDR>
      
Description

Activate TimeP in manual mode with a specified TimeP server. (By default, SNTP traffic goes through the data
ports.)

Parameters and options
manual
<IP-ADDR>

Enabling TimeP in manual mode
Select TimeP and configure it for manual operation using a TimeP server address of 10.28.227.141, and the
default poll interval (720 minutes, assuming the TimeP poll interval is already set to the default).
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Procedure

1. Select TimeP:

switch(config)# timesync timep
2. Activate TimeP in manual mode:

switch(config)# ip timep manual 10.28.227.141
3. Review the TimeP status:

switch(config)# show timep

show timep output

switch(config)# show timep
 Timep Configuration

  Time Sync Mode: Timep
  TimeP Mode :  Manual              Server Address : 10.28.227.141
  Poll Interval (min) : 720

Current TimeP configuration
Using different show commands, you can display either the full TimeP configuration or a combined listing of all
TimeP, SNTP, and VLAN IP addresses configured on the switch.

show timep
Syntax
show timep
Description

Lists both the time synchronization method (TimeP, SNTP, or None) and the TimeP configuration, even if SNTP is
not the selected time protocol. (If the TimeP Mode is set to Disabled or DHCP, the Server field does not appear.)

TimeP configuration when TimeP is the selected Time synchronization method

If you configure the switch with TimeP as the time synchronization method, then enable TimeP in DHCP mode
with the default poll interval, show timep lists the following:

switch(config)# show timep

 Timep Configuration

  Time Sync Mode: Timep
  TimeP Mode [Disabled] : DHCP    Server Address : 10.10.28.103
  Poll Interval (min) [720] : 720

TimeP configuration when TimeP is not the selected time synchronization method

If SNTP is the selected time synchronization method, show timep still lists the TimeP configuration even though
it is not currently in use. Even though, in this example, SNTP is the current time synchronization method, the
switch maintains the TimeP configuration.

switch(config)# show timep

 Timep Configuration
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  Time Sync Mode: Sntp
  TimeP Mode [Disabled] : Manual   Server Address : 10.10.28.100
  Poll Interval (min) [720] : 720

show management
Syntax
show management
Description

Examine and compare the IP addressing on the switch. It lists the IP addresses for all time servers configured on
the switch plus the IP addresses and default gateway for all VLANs configured on the switch.

Show IP addressing for all configured time servers and VLAN

switch(config)# show management

 Status and Counters - Management Address Information

  Time Server Address : 10.10.28.100

  Priority SNTP Server Address                            Protocol Version
  -------- ---------------------------------------------- ----------------
  1        10.10..28.101                                  3
  2        10.255.5.24                                    3
  3        fe80::123%vlan10                               3

  Default Gateway : 10.0.9.80
 
  VLAN Name    MAC Address         | IP Address
  ------------ ------------------- + -------------------
  DEFAULT_VLAN 001279-88a100       | 10.30.248.184
  VLAN10 001279-88a100             | 10.0.10.17

Change from one TimeP server to another
To change from one TimeP server to a different server, use the no ip timep command to disable TimeP mode
then reconfigure TimeP in manual mode with the new server IP address.

TimeP poll interval

ip timep
Syntax
ip timep [dhcp|manual] interval [1–9999]
Description

Specifies how long the switch waits between time polling intervals. The default is 720 minutes and the range is 1
to 9999 minutes. (This parameter is separate from the poll interval parameter used for SNTP operation.)

Disable time synchronization protocols

Disabling TimeP in manual mode
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no ip timep
Syntax
[no] ip timep
Description

Disables TimeP.

Parameters and options
no

To change from one TimeP server to another, you must use the no ip timep command to disable TimeP
mode, the reconfigure TimeP in manual mode with the new server IP address.

Disabling time synchronization
Either of these methods can be used to disable time synchronization without changing the Timep or SNTP
configuration.

no timesync
Syntax
[no] timesync
Description

Disables time synchronization by changing the Time Sync Mode configuration to Disabled. This halts time
synchronization without changing your TimeP configuration.The recommended method for disabling time
synchronization is to use the timesync command.

TimeP with time synchronization disabled

Suppose TimeP is running as the switch's time synchronization protocol, with DHCP as the TimeP mode, and the
factory-default polling interval. You would halt time synchronization with this command:

switch(config)# no timesync
If you then viewed the TimeP configuration, you would see the following:

switch(config)# show timep

 Timep Configuration
 Time Sync Mode: Disabled
 TimeP Mode : DHCP Poll Interval (min): 720

Disabling timsync using the GUI

Procedure

1. Set the Time Synch Method parameter to None.

2. Press [Enter], then [S] (for Save.)

Disabling the TimeP mode
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no ip timep
Syntax
no ip timep
Description

Disables TimeP by changing the TimeP mode configuration to Disabled and prevents the switch from using it as
the time synchronization protocol, even if it is the selected Time Sync Method option.

Disabling time synchronization by disabling the TimeP mode parameter

If the switch is running TimeP in DHCP mode, no ip timep changes the TimeP configuration as shown below
and disables time synchronization. Even though the TimeSync mode is set to TimeP, time synchronization is
disabled because no ip timep has disabled the TimeP mode parameter.

switch(config)# no ip timep

switch(config)# show timep

 Timep Configuration
  Time Sync Mode: Timep
  TimeP Mode : Disabled

Disabling time synchronization without changing the SNTP configuration

timesync
Syntax
[no] timesync
Description

Recommended method for disabling time synchronization. Halts time synchronization without changing your
SNTP configuration.

Halt time synchronization

Suppose SNTP is running as the switch's time synchronization protocol, with broadcast as the SNTP mode and
the factory-default polling interval. You would halt time synchronization with this command:

switch(config)# no timesync
If you then viewed the SNTP configuration, you would see the following:

SNTP with time synchronization disabled

switch(config)# show sntp
SNTP Configuration
SNTP Authentication : Disabled
Time Sync Mode: Sntp
SNTP Mode : Unicast
Poll Interval (sec) [720] : 720
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Disabling SNTP mode

Procedure

1. To view the current time synchronization, enter show sntp.

2. Use the sntp command to disable sntp mode:

no sntp
3. View the SNTP configuration again to verify the configuration.

Disabling SNTP Mode
If you want to prevent the SNTP from being used even if it is selected by timesync (or the Menu interface's Time
Sync Method parameter), configure the SNTP mode as disabled.

no sntp
Syntax
[no] sntp
Description

Disables SNTP by changing the SNTP mode configuration to Disabled.

Disabling time synchronization by disabling the SNTP mode

If the switch is running SNTP in unicast mode with an SNTP server at 10.28.227.141 and a server version of 3
(the default), no sntp changes the SNTP configuration as shown below and disables time synchronization on
the switch.

switch(config)# no sntp
switch(config)# show sntp

SNTP Configuration
SNTP Authentication : Disabled
Time Sync Mode: SNTP
SNTP Mode : disabled
Poll Interval (sec) [720] : 719
Source IP Selection: Outgoing Interface

Priority SNTP Server Address                      Version Key-id
-------- ---------------------------------------  ------- ----------
1        2001:db8::215:60ff:fe79:8980             7       0
2        10.255.5.24                              3       0

Deleting an SNTP server
Syntax
[no] sntp server priority <PRIORITY> <IP-ADDRESS>
Description

Deletes the specified SNTP server.
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IMPORTANT: Deleting an SNTP server when only one server is configured disables SNTP unicast
operation.

Disabling SNTP by deleting a server
sntp server priority
Syntax
[no] sntp server priority <PRIORITY> <IP-ADDRESS> version key-id <KEY_ID>
        
Description

Disabling SNTP by deleting the specified SNTP server. Uses the no version of the command to disable SNTP.

Disabling time synchronization in DHCP mode by disabling the TimeP
mode parameter
The [no] ip timep command changes the TimeP configuration for both DHCP and manual modes, as shown
below, and disables time synchronization. Even though the TimeSync mode is set to TimeP, time synchronization
is disabled because the no ip timep command has disabled the TimeP mode parameter.

ip timep
Syntax
[no] ip timep
Description

To change from one TimeP server to another, you must use the no ip timep command to disable TimeP mode,
then reconfigure TimeP in manual mode with the new server IP address.

Disabling TimeP in manual mode

Timep Configuration

Time Sync Mode: Sntp
TimeP Mode : Disabled
Poll Interval (min) [720] : 720

switch# timesync timep

switch# ip timep manual

switch# show timep

Timep Configuration
Time Sync Mode: Timep
TimeP Mode : DHCP Poll Interval (min): 720

Disabling TimeP in DHCP mode

switch# no ip timep

switch# show timep
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Timep Configuration
Time Sync Mode: Timep
TimeP Mode : Disabled

Other time protocol commands
Features that apply to both SNTP and TimeP protocols.

Show management command

show management
Syntax
show management
Description

This command shows the switch addresses available for management, and the time server if the switch uses one.
It can help you to easily examine and compare the IP addressing on the switch. It lists the IP addresses for all
time servers configured on the switch, plus the IP addresses and default gateway for all VLANs configured on the
switch.

Display showing IP addressing for all configured time servers and VLANs

switch(config)# show management
Status and Counters - Management Address Information

Time Server Address : 10.10.28.100

  Priority SNTP Server Address Protocol Version
  -------- ------------------- ----------------
  1        10.10.28.101             3
  2        10.255.5.24              3
  
  Default Gateway     : 10.0.9.80

  VLAN Name    MAC Address    | IP Address
  ------------ -------------- + --------------
  DEFAULT_VLAN 001871-c42f00  | 10.30.248.184
  VLAN10       001871-c42f00  | 10.0.10.17

 Internet (IPv6) Service

  Interface Name  : DEFAULT_VLAN
  IPv6 Status     : Disabled

  Interface Name  : VLAN10
  IPv6 Status     : Disabled

Show SNTP command
In the factory-default configuration (where TimeP is the selected time synchronization method), show sntp still
lists the SNTP configuration, even though it is not currently in use.

show sntp
Syntax
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show sntp [authentication|statistics]
Description

Shows configured time protocol and servers. Lists both the time synchronization method (TimeP, SNTP, or None)
and the SNTP configuration, even if SNTP is not the selected time protocol. Configure the switch with SNTP as
the time synchronization method, and then enable SNTP in broadcast mode with the default poll interval, show
sntp.

Parameters and options
Authentication

Displays all the configured SNTP authentication information.

Statistics
Displays SNTP protocol statistics.

Figure 6: SNTP configuration when SNTP is not the selected time synchronization method

show sntp authentication command with authentication disabled

To display all the SNTP authentication keys that have been configured on the switch, enter the show sntp
authentication command.

switch(config) # show sntp authentication
SNTP Authentication Information
SNTP Authentication: Enabled

Key-ID  Auth Mode  Trusted
------- ----------- -------
55     MD5     YES
10     MD5     NO
To display the statistical information for each SNTP server, enter the sntp statistics command. The number
of SNTP packets that have failed authentication is displayed for each SNTP server address.

switch(config) # show sntp statistics
SNTP statistics
Received Packets: 0
Sent Packets: 3
Dropped Packets: 0
SNTP Server Address    Auth Failed Pkts
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-------------------    ----------------
10.10.10.1           0
fe80::200:24ff:fec8:4ca8   0

Show TimeP command
Using different show commands, you can display either the full TimeP configuration or a combined listing of all
TimeP, SNTP, and VLAN IP addresses configured on the switch.

show
Syntax
show timep | management
Description

Displays the timep and management information for the switch.

Parameters and options
timep

Lists both the time synchronization method (TimeP, SNTP, or None) and the TimeP configuration, even if
SNTP is not the selected time protocol. (If the TimeP Mode is set to Disabled or DHCP, the Server field does
not appear.)

management
Helps you to easily examine and compare the IP addressing on the switch. It lists the IP addresses for all time
servers configured on the switch plus the IP addresses and default gateway for all VLANs configured on the
switch.

TimeP configuration when TimeP is the selected Time synchronization method

If you configure the switch with TimeP as the time synchronization method, then enable TimeP in DHCP mode
with the default poll interval, show timep lists the following:

switch# show timep

 Timep Configuration

 Time Sync Mode: Timep
 TimeP Mode [Disabled] : DHCP    Server Address : 10.10.28.103
 Poll Interval (min) [720] : 720

TimeP configuration when TimeP is not the selected time synchronization method

If SNTP is the selected time synchronization method, show timep still lists the TimeP configuration even though
it is not currently in use. Even though, in this example, SNTP is the current time synchronization method, the
switch maintains the TimeP configuration (see data in bold below):

switch# show timep

 Timep Configuration
 
  Time Sync Mode: Sntp
  TimeP Mode [Disabled] : Manual   Server Address : 10.10.28.100
  Poll Interval (min) [720] : 720
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Display showing IP addressing for all configured time servers and VLANs

switch# show management

 Status and Counters - Management Address Information

  Time Server Address : 10.10.28.100

  Priority SNTP Server Address                            Protocol Version
  -------- ---------------------------------------------- ----------------
  1        10.10..28.101                                  3
  2        10.255.5.24                                    3
  3        fe80::123%vlan10                               3

  Default Gateway : 10.0.9.80
 
  VLAN Name    MAC Address         | IP Address
  ------------ ------------------- + -------------------
  DEFAULT_VLAN 001279-88a100       | 10.30.248.184
  VLAN10 001279-88a100             | 10.0.10.17
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Viewing current resource usage

showquos
Syntax
showqos|access-list|policyresources
Description

Displays the resource usage of the policy enforcement engine on the switch by software feature. For each type of
resource, the amount still available and the amount used by each software feature is shown.

Parameters and options
show resources

This output allows you to view current resource usage and, if necessary, prioritize and reconfigure software
features to free resources reserved for less important features.

qos|access-list|openflow|policy
Display the same command output and provide different ways to access task-specific information. See the
OpenFlow administrators guide.

Unavailable resources

The resource usage on a switch configured for ACLs, QoS, RADIUS-based authentication, and other features:

• The "Rules Used" columns show that ACLs, VT, mirroring, and other features (for example, Management
VLAN) have been configured globally or per-VLAN, because identical resource consumption is displayed for
each port range in the switch. If ACLs were configured per-port, the number of rules used in each port range
would be different.

• The switch is also configured for VT and is either blocking or throttling routed traffic with a high rate-of-
connection requests.

Chapter 3
Resource usage
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• Varying ICMP rate-limiting configurations on ports 1 to 24, on ports 25 to 48, and on slot A, have resulted in
different meter usage and different rule usage listed under QoS. Global QoS settings would otherwise result in
identical resource consumption on each port range in the switch.

• There is authenticated client usage of IDM resources on ports 25 to 48.

Figure 7: Viewing current QoS resource usage on a series 3500yl switch

Viewing information on resource usage
Cause

The switch allows you to view information about the current usage and availability of resources in the Policy
Enforcement engine, including the following software features:

• Access control lists (ACL)

• Quality-of-service (QoS), including device and application port priority, ICMP rate-limiting, and QoS policies

• Dynamic assignment of per-port or per-user ACLs and QoS through RADIUS authentication designated as
“IDM”

• Virus throttling (VT) using connection-rate filtering

• Mirroring policies, including switch configuration as an endpoint for remote intelligent mirroring

• Other features, including:
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◦ Management VLAN

◦ DHCP snooping

◦ Dynamic ARP protection

◦ Jumbo IP-MTU

When insufficient resources are available

Cause

The switch has ample resources for configuring features and supporting:

• RADIUS-authenticated clients (with or without the optional IDMapplication)

• VT and blocking on individual clients.

NOTE: Virus throttling does not operate on IPv6 traffic.

If the resources supporting these features become fully subscribed:

• The current feature configuration, RADIUS-authenticated client sessions, and VT instances continue to
operate normally.

• The switch generates an event log notice to say that current resources are fully subscribed.

• Currently engaged resources must be released before any of the following actions are supported:
◦ Modifying currently configured ACLs, IDM, VT, and other software features, such as Management VLAN,

DHCP snooping, and dynamic ARP protection.

You can modify currently configured classifier-base QoS and mirroring policies if a policy has not been
applied to an interface. However, sufficient resources must be available when you apply a configured policy
to an interface.

◦ Acceptance of new RADIUS-based client authentication requests (displayed as a new resource entry for
IDM.)

Failure to authenticate a client that presents valid credentials may indicate that insufficient resources are
available for the features configured for the client in the RADIUS server. To troubleshoot, check the event
log.

◦ Throttling or blocking of newly detected clients with high rate-of-connection requests (as defined by the
current VT configuration.)

The switch continues to generate Event Log notifications (and SNMP trap notification, if configured) for new
instances of high-connection-rate behavior detected by the VT feature.

Policy enforcement engine

Cause

The policy enforcement engine is the hardware element in the switch that manages QoS, mirroring, and ACL
policies, as well as other software features, using the rules that you configure. Resource usage in the policy
enforcement engine is based on how these features are configured on the switch:

• Resource usage by dynamic port ACLs and VT is determined as follows:
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◦ Dynamic port ACLs configured by a RADIUS server for an authenticated client determine the current
resource consumption for this feature on a specified slot. When a client session ends, the resources in use
for that client become available for other uses.

◦ A VT configuration (connection-rate filtering) on the switch does not affect switch resources unless traffic
behavior has triggered either a throttling or blocking action on the traffic from one or more clients. When the
throttling action ceases or a blocked client is unblocked, the resources used for that action are released.

• When the following features are configured globally or per-VLAN, resource usage is applied across all port
groups or all slots with installed modules:
◦ ACLs

◦ QoS configurations that use the following commands:
– QoS device priority (IP address) through the CLI using the qos device-priority command

– QoS application port through the CLI using qos tcp-port or qos udp-port
– VLAN QoS policies through the CLI using service-policy

◦ Management VLAN configuration

◦ DHCP snooping

◦ Dynamic ARP protection

◦ Remote mirroring endpoint configuration

◦ Mirror policies per VLAN through the CLI using monitor service
◦ Jumbo IP-MTU

• When the following features are configured per-port, resource usage is applied only to the slot or port group on
which the feature is configured:
◦ ACLs or QoS applied per-port or per-user through RADIUS authentication

◦ ACLs applied per-port through the CLI using the ip access-group or ipv6 traffic-filter
commands

◦ QoS policies applied per port through the CLI using the service-policycommand

◦ Mirror policies applied per-port through the CLI using the monitor all service and service-
policycommands

◦ ICMP rate-limiting through the CLI using the rate-limit icmpcommand

◦ VT applied to any port (when a high-connection-rate client is being throttled or blocked)

Usage notes for show resources output

Cause

• A 1:1 mapping of internal rules to configured policies in the switch does not necessarily exist. As a result,
displaying current resource usage is the most reliable method for keeping track of available resources. Also,
because some internal resources are used by multiple features, deleting a feature configuration may not
increase the amount of available resources.

• Resource usage includes resources actually in use or reserved for future use by the listed features.

• "Internal dedicated-purpose resources" include the following features:
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◦ Per-port ingress and egress rate limiting through the CLI using rate-limit in/out
◦ Per-port ingress and egress broadcast rate limiting through the CLI using rate-limit bcast/mcast
◦ Per-port or per-VLAN priority or DSCP through the CLI using qos priority or qos dscp
◦ Per protocol priority through the CLI using qos protocol

• For chassis products (for example, the 5400zl or 8212zl switches), 'slots' are listed instead of 'ports,' with
resources shown for all installed modules on the chassis.

• The "Available" columns display the resources available for additional feature use.

• The "IDM" column shows the resources used for RADIUS-based authentication.

• "Meters" are used when applying either ICMP rate-limiting or a QoS policy with a rate-limit class action.
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Services
The services command requires a slot-name parameter followed by an option. Options permitted in this
command depend on the context (operator, manager, or configure).

Show services
Syntax
show services <SLOT-ID>[details | device]
      
Description

Show services modules information.

Parameters

Slot-id

Show services modules information

Options

<SLOT-ID> details

Display application information for the specified slot.

<SLOT-ID> device

Display the current configuration of the devices.

Show services

switch# show services

        Installed Services
Slot    Index Description                      Name
------  --------------------------------       ------------------
H,L       1. Services zl Module                  services-module
L         2. HP ProCurve MSM765 zl Int-Ctlr        msm765-applicati
H         3. Threat Management Services zl Module  tms-module

No parameters
This no parameters command lists only installed modules which have applications running that provide a pass-
through CLI feature.

show services
Syntax
show services
Description

Chapter 4
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Show services of only installed modules.

Show services

switch# show services

        Installed Services

Slot     Index Description                           Name
H,L        1. Services zl Module                       services-module
L         2. HP ProCurve MSM765 zl Int-Ctlr           msm765-applicati
H         3.Threat Management Services zl Module      tms-module

Show services locator
Syntax
show services <SLOT-ID>[details | device]
      
Description

Show services information.

Parameters

details

Display application information for the specified slot.

device

Display the current configuration of the devices.

Options

Slot-id

Display summary table for the specified slot.

Show services f

switch# show services f
Status and Counters - Services Module F Status
 HPE Services zl Module J9840A
Versions            :
 Current status      : running
For more information, use the show commands in services context

Show servers f details

switch# show services f details
 Status and Counters - Services Module F Status
 HPE Services zl Module J9840A
 Versions            :
 Current status      : running

Description                                Version             Status
------------------------------------------ ------------------- ---------
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Services zl Module                                             hardware
HPE MSM775 zl Premium Controller     J9840A                     installed

 For more information, use the show commands in services context

Show services f status

Status and Counters - Services Module F Status
HPE Services zl Module J9840A
Versions            :
Current status      : running
Description                                Version             Status
------------------------------------------ ------------------- ---------
Services zl Module                                             hardware
HPE Adv Services v2 zl Module w/ HDD         J9857A             installed

For more information, use the show commands in services context

Show services device
Adding the keyword “device” displays information about whether certain external devices are enabled or disabled.
This command is equivalent to the “services <slot> device” command with no additional parameters.

show services device
Syntax
show services slot-id device 
        
Description

• USB port (x86–side) May be one of:
◦ “disabled” (normal state)

◦ “enabled” – enabled once the x86 boots into the OS, but disabled before OS boot to prevent inadvertently
booting to an inserted USB key.

◦ “boot” – enabled all the time, both for and after x86 OS boot.

• ShutdownFront-panel shutdown/reset button:
◦ “enabled” – default state

◦ “disabled” – for increased physical security

• PXE (PXE-boot)Not displayed for all modules.

Show services device

switch# show services d device
Services Module Device Configuration
Device          |               State
----------------|--------------------
USB             |            disabled
Shutdown        |             enabled
PXE             |             enabled
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Requesting a reboot
Syntax
services <SLOT>boot[product|PXE|service|USB]
      
Description

This command requests a reboot (graceful shutdown and restart) of the x86.

Parameters

product

Boot to the Product OS.

PXE

Boot to the PXE or Product OS (if supported).

service

Boot to the Service OS.

USB

Boot to the USB or Product OS (if supported).

If no parameters are given, the switch attempts to boot to the same OS (product, service, or USB) that was
enabled before the command was given. If the services <slot> boot product|usb command is given on
a non-permitted module, one of the following error messages is returned:

Services b boot

switch# services b boot product
Command not supported for the Services module in slot B.

switch# services b boot pxe
Command not supported for the Services module in slot B.

switch# services b boot usb
Command not supported for the Services module in slot B.

Services in Operator/Manager/Configure context
This top-level command requires a slot-name parameter followed by a subcommand. Permitted subcommands
depend on one of the three contexts: operator, manager, or configure.

Services (operator)
Syntax
services <SLOT-ID>[<INDEX>| locator | name <NAME>]
Description

Displays applications installed and running for the services module in the Operator context.

Parameters
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Integer

Index of the services CLI to access.

Locator

Control services module locator LED.

Name

Name of the services CLI to access.

Options

<SLOT-ID>

Device slot identifier for the services module.

<SLOT-ID> <INDEX>

Configure parameters for the installed application.

<SLOT-ID> locator

Controls services module locator LED.

<SLOT-ID> name <NAME>

Configure parameters for the installed application.

Services (manager)
Syntax
services <SLOT-ID>[<INDEX> | boot | locator | name <NAME> | reload | serial | shutdown]
      
Description

Display applications installed and running for the services module or change the module's state (reload or
shutdown).

Parameters

Boot

Reboot the services module.

Integer

Index of the services CLI to access.

Locator

Control services module locator LED.

Name

Name of the services CLI to access.

Reload

Reset the services module.

Serial

Connect to application via serial port.

Shutdown

Shutdown (halt) the services module.

Options
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slot-id

Device slot identifier for the services module.

<slot-id> <index>

Configure parameters for the installed application.

<slot-id> boot

Reboot the services module.

<slot-id> locator

Controls services module locator LED.

<slot-id> name <name>

Configure parameters for the installed application.

<slot-id> reload

Reset the services module.

<slot-id> serial

Connect to services module via serial port.

<slot-id> shutdown

Shutdown (halt) the services module.

Services (configure)
Syntax
[no] services [<SLOT-ID> <INDEX> boot | locator | name <NAME> | reload | serial | shutdown] services <slot-id> device [shutdown | usb]
      

Description

Configure parameters for the services module or change the module's state (reload or shutdown).

Parameters and options
slot-id

Device slot identifier for the services module.

<SLOT-ID> <INDEX>

Configure parameters for the installed application.

<SLOT-ID> boot
Reboot the services module.

<SLOT-ID> locator
Controls services module locator LED.

<SLOT-ID> name<NAME>
Configure parameters for the installed application.

<SLOT-ID> reload
Reset the services module.

<SLOT-ID> serial
Connect to services module via serial port.
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<SLOT-ID> shutdown
Shutdown (halt) the services module.

Enable or disable devices.
Enable or disable devices. This command must be run from the configure context.

no services
Syntax
no services <SLOT> device [PXE|shutdown|USB|CF]
      
Parameters

PXE

Enable or disable booting from PXE (if supported).

shutdown

Enable or disable the shutdown or reset button.

USB

Enable or Disable the USB after boot.

CF

Enable or disable the Compact Flash or SD1 card.

Accessing CLI-passthrough
Accessing the CLI-passthrough feature on modules that support the feature. Feature can be reported by the show
services command given with no additional parameters.

services
Syntax
services <SLOT>[<INDEX>|<NAME>]
      
Description

Parameters

ASCII-STR

Enter an ASCII string.

Show services

switch# show services

Installed Services

Slot   Index   Description                               Name
H,L     1.    Services zl Module                        services-module
 L      2.    HPE ProCurve MSM765 zl Int-Ctlr            msm765-applicati
 H      3.    Threat Management Services zl Module      tms-module
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Show services set locator module
This command sets the Module Locator LED to either solid-on, off or slow-blink for a specified duration of time or
to turn it off before the previously-specified time has passed. Options are permitted in this command for the
Operator.

command name
Syntax
show services <SLOT>[blink <1–1440>|off|on]
      
Parameters

blink

Blink the locator LED. Default 30 mins. Range <1-1440>.

off

Turn the locate led off.

on

Turn the locate led on.

show services d

switch# show services d locator blink

Reloading services module

command name
Syntax
services <SLOT> reload
      
Description

Reloads the services module and is similar to the command services<slot> boot with no additional
parameters given.

Connection to the application via a serial port
WARNING:

You are entering a mode on this product that is Hewlett Packard Enterprise Confidential and
Proprietary. This mode, the commands and functionality specific to this mode, and all output from this
mode are Hewlett Packard Enterprise Confidential and Proprietary. You may use this mode only by
specific permission of, and under the direction of, an Hewlett Packard Enterprise support engineer or
Hewlett Packard Enterprise technical engineer. Unauthorized or improper use of this mode will be
considered by Hewlett Packard Enterprise to be unauthorized modification of the product, and any
resulting defects or issues are not eligible for coverage under the Hewlett Packard Enterprise product
warranty or any Hewlett Packard Enterprise support or service. UNAUTHORIZED OR IMPROPER
USE OF THIS MODE CAN MAKE THE PRODUCT COMPLETELY INOPERABLE.

SvcOS login: <CTRL-Z>
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command name
Syntax
services <SLOT>serial
      
Description

Starts a serial-passthrough session to the x86.

Shutdown the services module.

command name
Syntax
services <SLOT>shutdown
      
Description

Similar to services <slot>boot with no additional parameters given. This command is similar in that it
attempts a graceful shutdown of the x86 except that this command does not restart the x86. If the graceful-
shutdown attempt fails, no follow-up attempt is made to do a hard shutdown.

Transceiver status
The following information is displayed for each installed transceiver:

• Port number on which transceiver is installed.

• Type of transceiver.

• Product number — Includes revision letter, such as A, B, or C. If no revision letter follows a product number,
this means that no revision is available for the transceiver.

• Part number — Allows you to determine the manufacturer for a specified transceiver and revision number.

Operating notes
• For a non- switches installed transceiver (see line 23 Figure 8: Example of show tech transceivers

command on page 93), no transceiver type, product number, or part information is displayed. In the Serial
Number field, non-operational is displayed instead of a serial number.

• The following error messages may be displayed for a non-operational transceiver:
◦ Unsupported Transceiver. (SelfTest Err#060) 

Check: http://www.hpe.com/rnd/device_help/2_inform for more info.
              

◦ This switch only supports revision B and above transceivers. 
Check: http://www.hpe.com/rnd/device_help/2_inform for more info.
              

◦ Self test failure.
◦ Transceiver type not supported in this port.
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◦ Transceiver type not supported in this software version.
◦ Not a Switch Transceiver. 

Go to: http://www.hpe.com/rnd/device_help/2_inform for more info.
              

show interfaces transceivers
Syntax
show interfaces transceivers
Description

Figure 8: Example of show tech transceivers command on page 93 shows sample output from the show
tech transceivers command. The Part # column enables you to determine the manufacturer for a specified
transceiver and revision number.

• Remotely identify transceiver type and revision number without having to physically remove an installed
transceiver from its slot.

• Display real-timestatus information about all installed transceivers, including non-operational transceivers.

Figure 8: Example of show tech transceivers command

Configuring the type of a module

module type
Syntax
module <module-num> type <module-type>
      
Description

Allows you to configure the type of the module.
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Clearing the module configuration
Syntax
no module <SLOT>
    
Description

Allows removal of the module configuration in the configuration file after the module has been removed. Enter an
integer between 1 and 12 for slot.

• This command can be used to swap a module for a different type.

• This command will save the changes to both the running and startup configuration without a user issuing a
‘write memory’

Example

switch# no module 3

Configuring transceivers and modules that have not been
inserted

Transceivers
Previously, a port had to be valid and verified for the switch to allow it to be configured. Transceivers are
removable ports and considered invalid when not present in the switch, so they cannot be configured unless they
are already in the switch. For switches, the verification for allowable port configurations performed by the CLI is
removed and configuration of transceivers is allowed even if they are not yet inserted in the switch.

Modules
You can create or edit configuration files (as text files) that can be uploaded to the switch without the modules
having been installed yet. Additionally, you can pre-configure the modules with the CLI module command.

The same module command used in an uploaded configuration file is used to define a module that is being pre-
configured. The validation performed when issued through the CLI is still performed just as if the command was
executed on the switch, in other words, as if the module were actually present in the switch.

NOTE:

You cannot use this method to change the configuration of a module that has already been
configured. The slot must be empty and the configuration file must not have a configuration
associated with it.

Clearing the module configuration
Because of the hot-swap capabilities of the modules, when a module is removed from the chassis, the module
configuration remains in the configuration file. [no] module slot allows you to remove the module
configuration information from the configuration file.

This does not change how hot-swap works.
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Power consumption
NOTE: The show system power-supply detailed command is only supported on the 5400R
and 3810M switches.

show system power-supply
Syntax
show system power-supply [detailed | fahrenheit]

Description

Shows power supply information in either full detail or full detail in Fahrenheit only. Default temperature is
displayed in degrees Celsius.

Command context
manager and operator

Parameters
detailed

Shows detailed switch power supply sensor information.

fahrenheit
Shows detailed switch power supply sensor information with temperatures in degrees Fahrenheit.

Usage

• The show system power-supply detailed command shows detailed information for the local power
supplies only.

• The show system power-supply detailed command shows detailed information for power supplies in
the powered state only.

Examples

Use of the command show system power-supply shows the power supply status for all active switches.

Switch# show system power-supply

Power Supply Status:

 PS#    Model      Serial          State         AC/DC  + V    Wattage
 ---- --------- ------------ ----------------- -------------- ---------
   1   J9828A    IN30G4D009   Powered           AC 120V/240V      700
   2   J9828A    IN30G4D00C   Powered           AC 120V/240V      700
   3                          Not Present       -- ---------        0
   4   J9830A    IN43G4G05H   Powered           AC 120V/240V     2750

   3 /  4 supply bays delivering power.
   Total power: 4150 W

Use of the command show system power-supply detailed shows the power supply status in detail for all
active switches.
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Switch# show system power-supply detailed                        

 Status and Counters - Power Supply Detailed Information 

  PS# Model   Serial      State        Status
  --- ------- ----------- ------------ -------------------------------------
  1   J9828A  IN30G4D009  Powered      AC Power Consumption : 44 Watts      
                                       AC MAIN Voltage      : 209 Volts     
                                       Power Supplied       : 31 Watts      
                                       Power Capacity       : 700 Watts     
                                       Inlet Temp (C/F)     : 27.0C/80.6F   
                                       Internal Temp (C/F)  : 30.5C/86.0F   
                                       Fan 1 Speed          : 1600 RPM (47%) 
                                       Fan 2 Speed          : 1600 RPM (47%) 

  2   J9828A  IN30G4D00C  Powered      AC Power Consumption : 46 Watts
                                       AC MAIN Voltage      : 209 Volts
                                       Power Supplied       : 21 Watts
                                       Power Capacity       : 700 Watts
                                       Inlet Temp (C/F)     : 27.7C/80.6F
                                       Internal Temp (C/F)  : 32.5C/89.6F
                                       Fan 1 Speed          : 1600 RPM (47%)
                                       Fan 2 Speed          : 1600 RPM (47%)

  3                       Not Present

  4   J9830A  IN43G4G05H  Powered      AC Power Consumption : 90 Watts
                                       AC MAIN/AUX Voltage  : 210/118 Volts
                                       Power Supplied       : 16 Watts
                                       Power Capacity       : 2750 Watts
                                       Inlet Temp (C/F)     : 30.9C/86.0F
                                       Internal Temp (C/F)  : 65.6C/149.0F
                                       Fan 1 Speed          : 2000 RPM (37%)
                                       Fan 2 Speed          : 1950 RPM (36%)

   3 /  4 supply bays delivering power.
   Currently supplying 68 W / 4150 W total power.
Use of the command show system power-supply fahrenheit shows the power supply status in
Fahrenheit for all active switches.

Switch# show system power-supply detailed fahrenheit
Power Supply Status:
 Mem PS# Model   Serial      State        Status
 --- --- ------- ----------- ------------ -----------------------------------
 1   1   J9830A  IN5BGZ81KZ  Powered      Power Consumption   : 95 Watts
                                          AC MAIN/AUX Voltage : 118/208 Volts
                                          Inlet/Internal Temp : 85.6F/87.7F 
                                          Fan 1 Speed (util)  : 1650RPM (20%)
                                          Fan 2 Speed (util)  : 1600RPM (19%)     

 1   2   J9829A  IN5BGZ81KX  Powered      Power Consumption   : 51 Watts
                                          AC Input Voltage    : 208 Volts
                                          Inlet/Internal Temp : 85.6F/87.7F 
                                          Fan 1 Speed (util)  : 1650RPM (20%)
                                          Fan 2 Speed (util)  : 1600RPM (19%)

 1   3   J9828A  IN5BGZ81KY  Powered      Power Consumption   : 43 Watts
                                          AC Input Voltage    : 119 Volts
                                          Inlet/Internal Temp : 85.6F/87.7F 
                                          Fan 1 Speed (util)  : 1650RPM (20%)
                                          Fan 2 Speed (util)  : 1600RPM (19%)
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 1   4                       Not Present

 2   1   J9830A  IN5BGZ81KZ  Powered      Power Consumption   : 95 Watts
                                          AC MAIN/AUX Voltage : 118/208 Volts
                                          Inlet/Internal Temp : 85.6F/87.7F 
                                          Fan 1 Speed (util)  : 1650RPM (20%)
                                          Fan 2 Speed (util)  : 1600RPM (19%)

 2   2   J9829A  IN5BGZ81KX  Powered      Power Consumption   : 51 Watts
                                          AC Input Voltage    : 208 Volts
                                          Inlet/Internal Temp : 85.6F/87.7F 
                                          Fan 1 Speed (util)  : 1650RPM (20%)
                                          Fan 2 Speed (util)  : 1600RPM (19%)

 2   3   J9828A  IN5BGZ81KY  Powered      Power Consumption   : 43 Watts
                                          AC Input Voltage    : 119 Volts
                                          Inlet/Internal Temp : 85.6F/87.7F 
                                          Fan 1 Speed (util)  : 1650RPM (20%)
                                          Fan 2 Speed (util)  : 1600RPM (19%)
 2   4                       Not Present
------------------------------------------------------------------------------
   6 / 8 supply bays delivering power.
   Total Input Power: 378 Watts
Use of the command show system power-supply detailed shows the power supply status all active
switches including a nonpowered J9830A PSU.

switch# show system power-supply detailed                        

 Status and Counters - Power Supply Detailed Information 

  PS# Model   Serial      State        Status
  --- ------- ----------- ------------ -------------------------------------
  1   J9828A  IN30G4D009  Powered      AC Power Consumption : 44 Watts      
                                       AC MAIN Voltage      : 209 Volts     
                                       Power Supplied       : 31 Watts      
                                       Power Capacity       : 700 Watts     
                                       Inlet Temp (C/F)     : 27.0C/80.6F   
                                       Internal Temp (C/F)  : 30.5C/86.0F   
                                       Fan 1 Speed          : 1600 RPM 
                                       Fan 2 Speed          : 1600 RPM

  2   J9828A  IN30G4D00C  Powered      AC Power Consumption : 46 Watts
                                       AC MAIN Voltage      : 209 Volts
                                       Power Supplied       : 21 Watts
                                       Power Capacity       : 700 Watts
                                       Inlet Temp (C/F)     : 27.7C/80.6F
                                       Internal Temp (C/F)  : 32.5C/89.6F
                                       Fan 1 Speed          : 1600 RPM
                                       Fan 2 Speed          : 1600 RPM

  3                       Not Present

  4   J9830A  IN43G4G05H  Aux Not Powered 

   2 /  4 supply bays delivering power.
   Currently supplying 68 W / 4150 W total power.
Use of the command show system power-supply shows the power supply status all active switches with
power supply #2 showing permanent failure.
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switch# show system power-supply

Power Supply Status:

 PS#    Model      Serial          State         AC/DC  + V    Wattage
 ---- --------- ------------ ----------------- -------------- ---------
   1                          Not Present       -- ---------        0
   2   J9829A    IN30G4D00C   Permanent Failure  AC 120V/240V     1100
   3   J9829A    IN30G4D00D   Powered           -- ---------       1100
   4   J9829A    IN43G4G05H   Powered           AC 120V/240V      1100

   3 /  4 supply bays delivering power.
   Total power: 3300 W

Table 1: Field key for output of show system power-supply detailed

Field Description

AC Power
Consumption

Actual power consumed from AC input

AC MAIN/AUX
Voltage

Actual voltage measured on AC Input:
• Two voltages are displayed for PS#4, as the J9830A includes two

AC input IEC connectors.

• Most power-supplies contain a single AC Input IEC connector and
are labeled MAIN.

Power Supplied Actual voltage being supplied from the power-supply to the switch for
general power and PoE.

Power Capacity The maximum power that the power-supply can provide to the switch.

Inlet Temp (C/F) The thermal sensor at the inlet of the power-supply - shown in both
Celsius and Fahrenheit

Internal Temp
(C/F)

The thermal sensor internal to the power-supply (will vary depending
upon the model) - shown in both Celsius and Fahrenheit.

NOTE: There is no "Output Temperature Sensor" on
either the 5400R or 3810M switches.

Fan Speed Shows the current fan speed in RPM and the percent of total fan speed
utilization. For PSUs that contain more than one fan, a separate line
will be included for each.

Currently
Supplying

A summary of the total power being supplied and the total capacity
(same summary as seen on the command show system power-
supply).

Fans
There are three fan types:

• Power supply fans

• Fan-tray fans

• Stacking switch fans
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show system

Syntax
show system [chassislocate | information | temperature]

Description

Shows global system information and operational parameters for the switch.

Command context
manager and operator

Parameters
chassislocate

Shows the chassis locator LED status. Possible values are ON, Off, and Blink. When the status is On or Blink,
the number of minutes that the Locator LED will continue to be on or to blink is displayed.

information
Displays global system information and operational parameters for the switch.

temperature
Shows system temperature and settings.

Usage

• To show system fans, see show system fans

• To show chassis power supply and settings, see show system power-supply

• To show system fans for VSF members, see show system fans vsf

Examples

Locating the system chassis by LED blink using the show system chassislocate command.

Showing the general switch system information by using the show system command.
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show system fans
Syntax
show system fans

Description

Shows the state, status, and location of system fans.

Command context
manager and operator

Usage

Command can be executed using various command contexts. See examples for use of command context PoEP
and VSF.

Examples

The state of all system fans is shown by using the command show system fans.

Switch# show system fans

Fan Information
  Num  | State       | Failures | Location 
-------+-------------+----------+----------
Fan-1  | Fan OK      |   0      | Fan Tray
Fan-2  | Fan OK      |   0      | Fan Tray
Fan-3  | Fan OK      |   0      | Fan Tray
Fan-4  | Fan OK      |   0      | Fan Tray
Fan-5  | Fan OK      |   0      | Fan Tray
Fan-6  | Fan OK      |   0      | Fan Tray
Fan-7  | Fan Removed |   0      | PS 1
Fan-8  | Fan Failed  |   2      | PS 2
Fan-9  | Fan OK      |   0      | PS 3
Fan-10 | Fan OK      |   0      | PS 4
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1 / 10 Fans in Failure State
1 / 10 Fans have been in Failure State
The state of all system fans within the PoEP context is shown by using the command show system fans.

Switch(PoEP)# show system fans

Fan Information
  Num  | State       | Failures | Location
-------+-------------+---------------------
Fan-1  | Fan OK      |   0      | Chassis
Fan-2  | Fan OK      |   0      | Chassis
Fan-3  | Fan OK      |   0      | Chassis
Fan-4  | Fan Removed |   0      | PS 1
Fan-5  | Fan Failed  |   2      | PS 2

1 / 5 Fans in Failure State
1 / 5 Fans have been in Failure State
The state of all stacked switch system fans is shown by using the command show system fans within the
stacked context.

Switch(stacked)# show system fans                                          

Fan Information
Member  1

  Num  | State       | Failures | Location
-------+-------------+---------------------
Sys-1  | Fan OK      |   0      | Chassis
Sys-2  | Fan OK      |   0      | Chassis
Sys-3  | Fan OK      |   0      | Chassis
Sys-4  | Fan Removed |   0      | PS 1
Sys-5  | Fan Failed  |   2      | PS 2

0 / 5 Fans in Failure State
0 / 5 Fans have been in Failure State

Member  2

  Num  | State       | Failures | Location
-------+-------------+---------------------
Sys-1  | Fan OK      |   0      | Chassis
Sys-2  | Fan OK      |   0      | Chassis
Sys-3  | Fan OK      |   0      | Chassis
Sys-4  | Fan OK      |   0      | PS 1
Sys-5  | Fan OK      |   0      | PS 2

0 / 5 Fans in Failure State
0 / 5 Fans have been in Failure State
The state of all VSF switch members system fans is shown by using the command show system fans from
within the VSF context.

VSF-Switch# show system fans

Fan Information
VSF-Member  1

  Num  | State       | Failures | Location
-------+-------------+----------+---------
Sys-1  | Fan OK      |   0      | Fan Tray
Sys-2  | Fan OK      |   0      | Fan Tray

Chapter 4 Hardware components 101

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 3839



Sys-3  | Fan OK      |   0      | Fan Tray
Sys-4  | Fan OK      |   0      | Fan Tray
Sys-5  | Fan Removed |   0      | PS 1
Sys-6  | Fan Failed  |   2      | PS 2

1 / 6 Fans in Failure State
1 / 6 Fans have been in Failure State

VSF-Member  2

  Num  | State       | Failures | Location
-------+-------------+----------+---------
Sys-1  | Fan OK      |   0      | Fan Tray
Sys-2  | Fan OK      |   0      | Fan Tray
Sys-3  | Fan OK      |   0      | Fan Tray
Sys-4  | Fan OK      |   0      | Fan Tray
Sys-5  | Fan OK      |   0      | PS 1
Sys-6  | Fan OK      |   0      | PS 2

0 / 6 Fans in Failure State
0 / 6 Fans have been in Failure State

show system power-supply
Syntax
show system power-supply [detailed | fahrenheit]

Description

Shows power supply information in either full detail or full detail in Fahrenheit only. Default temperature is
displayed in degrees Celsius.

Command context
manager and operator

Parameters
detailed

Shows detailed switch power supply sensor information.

fahrenheit
Shows detailed switch power supply sensor information with temperatures in degrees Fahrenheit.

Usage

• The show system power-supply detailed command shows detailed information for the local power
supplies only.

• The show system power-supply detailed command shows detailed information for power supplies in
the powered state only.

Examples

Use of the command show system power-supply shows the power supply status for all active switches.

Switch# show system power-supply

Power Supply Status:
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 PS#    Model      Serial          State         AC/DC  + V    Wattage
 ---- --------- ------------ ----------------- -------------- ---------
   1   J9828A    IN30G4D009   Powered           AC 120V/240V      700
   2   J9828A    IN30G4D00C   Powered           AC 120V/240V      700
   3                          Not Present       -- ---------        0
   4   J9830A    IN43G4G05H   Powered           AC 120V/240V     2750

   3 /  4 supply bays delivering power.
   Total power: 4150 W

Use of the command show system power-supply detailed shows the power supply status in detail for all
active switches.

Switch# show system power-supply detailed                        

 Status and Counters - Power Supply Detailed Information 

  PS# Model   Serial      State        Status
  --- ------- ----------- ------------ -------------------------------------
  1   J9828A  IN30G4D009  Powered      AC Power Consumption : 44 Watts      
                                       AC MAIN Voltage      : 209 Volts     
                                       Power Supplied       : 31 Watts      
                                       Power Capacity       : 700 Watts     
                                       Inlet Temp (C/F)     : 27.0C/80.6F   
                                       Internal Temp (C/F)  : 30.5C/86.0F   
                                       Fan 1 Speed          : 1600 RPM (47%) 
                                       Fan 2 Speed          : 1600 RPM (47%) 

  2   J9828A  IN30G4D00C  Powered      AC Power Consumption : 46 Watts
                                       AC MAIN Voltage      : 209 Volts
                                       Power Supplied       : 21 Watts
                                       Power Capacity       : 700 Watts
                                       Inlet Temp (C/F)     : 27.7C/80.6F
                                       Internal Temp (C/F)  : 32.5C/89.6F
                                       Fan 1 Speed          : 1600 RPM (47%)
                                       Fan 2 Speed          : 1600 RPM (47%)

  3                       Not Present

  4   J9830A  IN43G4G05H  Powered      AC Power Consumption : 90 Watts
                                       AC MAIN/AUX Voltage  : 210/118 Volts
                                       Power Supplied       : 16 Watts
                                       Power Capacity       : 2750 Watts
                                       Inlet Temp (C/F)     : 30.9C/86.0F
                                       Internal Temp (C/F)  : 65.6C/149.0F
                                       Fan 1 Speed          : 2000 RPM (37%)
                                       Fan 2 Speed          : 1950 RPM (36%)

   3 /  4 supply bays delivering power.
   Currently supplying 68 W / 4150 W total power.
Use of the command show system power-supply fahrenheit shows the power supply status in
Fahrenheit for all active switches.

Switch# show system power-supply detailed fahrenheit
Power Supply Status:
 Mem PS# Model   Serial      State        Status
 --- --- ------- ----------- ------------ -----------------------------------
 1   1   J9830A  IN5BGZ81KZ  Powered      Power Consumption   : 95 Watts
                                          AC MAIN/AUX Voltage : 118/208 Volts
                                          Inlet/Internal Temp : 85.6F/87.7F 
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                                          Fan 1 Speed (util)  : 1650RPM (20%)
                                          Fan 2 Speed (util)  : 1600RPM (19%)     

 1   2   J9829A  IN5BGZ81KX  Powered      Power Consumption   : 51 Watts
                                          AC Input Voltage    : 208 Volts
                                          Inlet/Internal Temp : 85.6F/87.7F 
                                          Fan 1 Speed (util)  : 1650RPM (20%)
                                          Fan 2 Speed (util)  : 1600RPM (19%)

 1   3   J9828A  IN5BGZ81KY  Powered      Power Consumption   : 43 Watts
                                          AC Input Voltage    : 119 Volts
                                          Inlet/Internal Temp : 85.6F/87.7F 
                                          Fan 1 Speed (util)  : 1650RPM (20%)
                                          Fan 2 Speed (util)  : 1600RPM (19%)

 1   4                       Not Present

 2   1   J9830A  IN5BGZ81KZ  Powered      Power Consumption   : 95 Watts
                                          AC MAIN/AUX Voltage : 118/208 Volts
                                          Inlet/Internal Temp : 85.6F/87.7F 
                                          Fan 1 Speed (util)  : 1650RPM (20%)
                                          Fan 2 Speed (util)  : 1600RPM (19%)

 2   2   J9829A  IN5BGZ81KX  Powered      Power Consumption   : 51 Watts
                                          AC Input Voltage    : 208 Volts
                                          Inlet/Internal Temp : 85.6F/87.7F 
                                          Fan 1 Speed (util)  : 1650RPM (20%)
                                          Fan 2 Speed (util)  : 1600RPM (19%)

 2   3   J9828A  IN5BGZ81KY  Powered      Power Consumption   : 43 Watts
                                          AC Input Voltage    : 119 Volts
                                          Inlet/Internal Temp : 85.6F/87.7F 
                                          Fan 1 Speed (util)  : 1650RPM (20%)
                                          Fan 2 Speed (util)  : 1600RPM (19%)
 2   4                       Not Present
------------------------------------------------------------------------------
   6 / 8 supply bays delivering power.
   Total Input Power: 378 Watts
Use of the command show system power-supply detailed shows the power supply status all active
switches including a nonpowered J9830A PSU.

switch# show system power-supply detailed                        

 Status and Counters - Power Supply Detailed Information 

  PS# Model   Serial      State        Status
  --- ------- ----------- ------------ -------------------------------------
  1   J9828A  IN30G4D009  Powered      AC Power Consumption : 44 Watts      
                                       AC MAIN Voltage      : 209 Volts     
                                       Power Supplied       : 31 Watts      
                                       Power Capacity       : 700 Watts     
                                       Inlet Temp (C/F)     : 27.0C/80.6F   
                                       Internal Temp (C/F)  : 30.5C/86.0F   
                                       Fan 1 Speed          : 1600 RPM 
                                       Fan 2 Speed          : 1600 RPM

  2   J9828A  IN30G4D00C  Powered      AC Power Consumption : 46 Watts
                                       AC MAIN Voltage      : 209 Volts
                                       Power Supplied       : 21 Watts
                                       Power Capacity       : 700 Watts
                                       Inlet Temp (C/F)     : 27.7C/80.6F
                                       Internal Temp (C/F)  : 32.5C/89.6F
                                       Fan 1 Speed          : 1600 RPM
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                                       Fan 2 Speed          : 1600 RPM

  3                       Not Present

  4   J9830A  IN43G4G05H  Aux Not Powered 

   2 /  4 supply bays delivering power.
   Currently supplying 68 W / 4150 W total power.
Use of the command show system power-supply shows the power supply status all active switches with
power supply #2 showing permanent failure.

switch# show system power-supply

Power Supply Status:

 PS#    Model      Serial          State         AC/DC  + V    Wattage
 ---- --------- ------------ ----------------- -------------- ---------
   1                          Not Present       -- ---------        0
   2   J9829A    IN30G4D00C   Permanent Failure  AC 120V/240V     1100
   3   J9829A    IN30G4D00D   Powered           -- ---------       1100
   4   J9829A    IN43G4G05H   Powered           AC 120V/240V      1100

   3 /  4 supply bays delivering power.
   Total power: 3300 W

Table 2: Field key for output of show system power-supply detailed

Field Description

AC Power
Consumption

Actual power consumed from AC input

AC MAIN/AUX
Voltage

Actual voltage measured on AC Input:
• Two voltages are displayed for PS#4, as the J9830A includes two

AC input IEC connectors.

• Most power-supplies contain a single AC Input IEC connector and
are labeled MAIN.

Power Supplied Actual voltage being supplied from the power-supply to the switch for
general power and PoE.

Power Capacity The maximum power that the power-supply can provide to the switch.

Inlet Temp (C/F) The thermal sensor at the inlet of the power-supply - shown in both
Celsius and Fahrenheit

Internal Temp
(C/F)

The thermal sensor internal to the power-supply (will vary depending
upon the model) - shown in both Celsius and Fahrenheit.

NOTE: There is no "Output Temperature Sensor" on
either the 5400R or 3810M switches.

Table Continued
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Field Description

Fan Speed Shows the current fan speed in RPM and the percent of total fan speed
utilization. For PSUs that contain more than one fan, a separate line
will be included for each.

Currently
Supplying

A summary of the total power being supplied and the total capacity
(same summary as seen on the command show system power-
supply).

Fan failures and SNMP traps

Power supply fan-fault

Power supply events indicating an internal fan-fault are reported by SNMP traps issued up to 10 seconds after the
corresponding power supply fan fault occures.

For single event power supply fan faults, a corresponding SNMP trap is issued.

Single event and corresponding SNMP trap issued for a power supply fan-fault and recovery

Shown is a fan-fault (fan 1 of 2) and spontaneous recovery a few seconds after within power supply in bay
number 2. The event is issued as informative (I).

I 11/30/16 14:01:59 02778 chassis: AM1: Internal power supply 2: Fan 1 OK.

Fan-tray fan-fault events

For single event fan-tray fan-faults, the corresponding SNMP traps are issued only for fans within the fan-tray.

Single event and corresponding SNMP trap issued for a fan-tray fan-fault and recovery

Shown is a fan-tray fan-fault (fan number 3) and spontaneous recovery a few seconds after. The event is issued
as "Informative" (I).

I 11/30/16 14:03:08 00070 chassis: AM1: Fan OK: Fan: 3  Failures: 1
Shown is a fan-tray fan-fault (fan number 3) failure. The event is issued as a "Warning" (w).

W 11/30/16 14:02:38 00070 chassis: AM1: Fan failure: Fan: 3 Failures: 1

System boot diagnostics
Power-on self-test (POST) is the diagnostic testing sequence that runs on start-up to verify hardware functionality.
The command show system post provides information by slot or interface module, which aids in
troubleshooting issues at startup.

show system post
Syntax
show system post <SLOT>

Description

Shows detailed POST information by slot or interface module, which aids in troubleshooting issues at start-up.
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Command context
manager

Parameters
<SLOT>

Specifies the slot number for detailed POST information.

Example

Show the detailed POST information on slot 1.

switch#  show system post 1

Slot 1 POST results

Failed Results:

Timestamp         Test Type  Port  Error Code
----------------- ---------  ---- -----------
01/25/15 11:02:32  Loopback   2    0x1010060
01/25/15 11:02:50  Loopback   7    0x1032000
01/25/15 11:02:59  POE        10   0xFFFFFFF
01/25/15 11:02:50  MACSEC     21   0x1082000    

All Ports except the ones listed above have passed the following self-tests
1. Loopback
2. POE
3. MACSEC

Note: This is just a reference. POE and MACSEC tests may not show up in cases where there is no support.

Field descriptions

Table 3: Field descriptions

Field Description

Timestamp Time and date of the POST failure result

Test Type There are 3 types of tests:
Loopback

Packet loopback test

PoE

PoE controller test

MACSEC

Loopback test with MACSEC enabled

Port Slot port number

Error Code Reason behind failure

show system post member
Syntax
show system post member <MEMBER-ID>

Description

Shows the detailed POST results for the specified stack member.
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Command context
manager

Parameters
<MEMBER-ID>

Specifies the member ID for the stack.

Examples

Show the POST results for the stack member 1.

switch-stack# show system post member 1

POST results for member 1

Failed Results:

Timestamp         Test Type   Port   Error Code
----------------- ---------   ----   -----------
01/25/15 11:02:32  Loopback   1/2    0x1010060
01/25/15 11:02:50  Loopback   1/7    0x1032000
01/25/15 11:02:59  POE        1/10   0xFFFFFFF
01/25/15 11:02:50  MACSEC     1/21   0x1082000    

All Ports except the ones listed above have passed the following self-tests
1. Loopback
2. POE
3. MACSEC

Note: This is just a reference. POE and MACSEC tests may not show up in cases where there is no support.

show system post vsf member
Syntax
show system post vsf member <MEMBER-ID>

Description

Shows the detailed POST results for the specified VSF stack member.

Command context
manager

Parameters
<MEMBER-ID>

Specifies the member ID of the VSF stack.

Examples

Show the VSF member 1 detailed POST results.

switch-VSF# show system post vsf member 1

POST results for vsf member 1

Failed Results:

Timestamp         Test Type   Port   Error Code
----------------- ---------   ----   -----------
01/25/15 11:02:32  Loopback   1/2    0x1010060
01/25/15 11:02:50  Loopback   1/7    0x1032000
01/25/15 11:02:59  POE        1/10   0xFFFFFFF
01/25/15 11:02:50  MACSEC     1/21   0x1082000    
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All Ports except the ones listed above have passed the following self-tests
1. Loopback
2. POE
3. MACSEC

Note: This is just a reference. POE and MACSEC tests may not show up in cases where there is no support.

Chapter 4 Hardware components 109

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 3847



Viewing port status and configuration

show interfaces
Syntax
show interfaces [brief | config | <PORT-LIST>]

Description

Shows interface information for ports or trunk groups in brief or configuration detail.

Command context
operator or manager

Parameters
brief

Shows the current operating status for all ports or trunk groups on the switch in brief detail.

config
Shows the configuration data for all ports or trunk groups on the switch.

<PORT-LIST>

Specifies the list of ports for which status information will be shown.

<TRUNK-GROUP>

Specifies the trunk group for which status information will be shown. The status information shown consists of
total transmit and receive counters and weighted average rate for the trunk group specified. The weighted
average rate is calculated in 5 minute intervals.

Usage

Both external and internal ports are supported on the same module. Internal ports have an “I” suffix in the output
of the show command to indicate that they are internal ports.

• “10GbE-INT” – Internal 10G data-plane ports (1i-2i, 4i-5i)

• “1GbE-INT” – Internal 1G control-plane port (3i)

• Port 3i always shows as link-down.

Examples

Show brief information and status of all interfaces.

switch# show interfaces brief

Status and Counters - Port Status
                | Intrusion                            MDI   Flow  Bcast
Port  Type      | Alert     Enabled Status Mode        Mode  Ctrl  Limit
----- --------- + --------- ------- ------ ----------  ----- ----- ------
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B1    100/1000T | No        Yes     Down   Auto-10-100 Auto  off   0
B2    100/1000T | No        Yes     Down   1000FDx     Auto  off   0
B3    100/1000T | No        Yes     Down   1000FDx     Auto  off   0
B4    100/1000T | No        Yes     Down   1000FDx     Auto  off   0
B5    100/1000T | No        Yes     Down   1000FDx     Auto  off   0
B6    100/1000T | No        Yes     Down   1000FDx     Auto  off   0
Show the configuration of the interfaces currently available.

switch# show interfaces config

Port Settings
  Port  Type      | Enabled Mode         Flow Ctrl MDI
  ----- --------- + ------- ------------ --------- ----
  B1    100/1000T | Yes     Auto-10-100  Disable   Auto
  B2    100/1000T | Yes     Auto         Disable   Auto
  B3    100/1000T | Yes     Auto         Disable   Auto
  B4    100/1000T | Yes     Auto         Disable   Auto
  B5    100/1000T | Yes     Auto         Disable   Auto
  B6    100/1000T | Yes     Auto         Disable   Auto 
Show brief information and status of interfaces for ports D1i, D2i, and D3i.

switch# show interfaces brief d1i-d3i

Status and Counters - Port Status
                  | Intrusion                           MDI  Flow Bcast
Port   Type       | Alert     Enabled Status Mode       Mode Ctrl Limit
------ ---------- + --------- ------- ------ ---------- ---- ---- -----
D1i    10GbE-INT  | No        Yes     Up     10GigFD    NA   off  0
D2i    10GbE-INT  | No        Yes     Up     10GigFD    NA   off  0
D3i    1GbE-INT   | No        Yes     Down   1000FDx    NA   off  0
Show the brief information and status of interfaces for ports B1 through internal port B3i.

switch# show interfaces brief b1-b3i

Status and Counters - Port Status
                   | Intrusion                           MDI  Flow Bcast
 Port   Type       | Alert     Enabled Status Mode       Mode Ctrl Limit 
 ------ ---------- + --------- ------- ------ ---------- ---- ---- -----
 B1     100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B2     100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B3     100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B4     100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B5     100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B6     100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B7     100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B8     100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B9     100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B10    100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B11    100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B12    100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B1i    10GbE-INT  | No        Yes     Up     10GigFD    NA   off  0
 B2i    10GbE-INT  | No        Yes     Up     10GigFD    NA   off  0
 B3i    1GbE-INT   | No        Yes     Up     1000FDx    NA   off  0
Show detailed interface information for port trunk 1.

switch# show interface trk1

Status and Counters - Port Counters for port Trk1                      
  Name  :  Trk1
  MAC Address      : 3464a9-b1b8bf 
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  Link Status      : Up 
  Totals (Since boot or last clear) : 
   Bytes Rx        : 777,713,956          Bytes Tx        : 596,853,141   
   Unicast Rx      : 1,154,693            Unicast Tx      : 0             
   Bcast/Mcast Rx  : 48,563               Bcast/Mcast Tx  : 607,474,910   
  Errors (Since boot or last clear) : 
   FCS Rx          : 0                    Drops Tx        : 0             
   Alignment Rx    : 0                    Collisions Tx   : 0             
   Runts Rx        : 0                    Late Colln      : 0             
   Giants Rx       : 0                    Excessive Colln : 0             
   Total Rx Errors : 0                    Deferred Tx     : 0               
  Others (Since boot or last clear) : 
   Discard Rx      : 0                    Out Queue Len   : 0             
   Unknown Protos  : 0                  
  Rates (5 minute weighted average) :
   Total Rx(Kbps)  : 76,800                 Total Tx(Kbps): 76,800              
   Unicast Rx (Pkts/sec) : 21             Unicast Tx (Pkts/sec) : 0            
   B/Mcast Rx (Pkts/sec) : 114,878        B/Mcast Tx (Pkts/sec) : 114,900      
   Utilization Rx  : 00.76 %                                                  
Utilization Tx  : 00.76 % 

Viewing transceiver information
NOTE: 40G QSFP+ BIDI transceiver support is available only on switches running KB software.

This features provides the ability to view diagnostic monitoring information for transceivers with Diagnostic Optical
Monitoring (DOM) support. The following table indicates the support level for specific transceivers:

Product # Description Support1

J8436A 10GbE X2–SC SR
Optic

V

J8437A 10GbE X2–SC LR Optic V

J8440B 10GbE X2-CX4 Xcver NA

J8440C 10GbE X2-CX4 Xcver NA

J4858A Gigabit-SX-LC Mini-
GBIC

V

J4858B Gigabit-SX-LC Mini-
GBIC

V

J4858C Gigabit-SX-LC Mini-
GBIC

V (some)

J9054B 100-FX SFP-LC
Transceiver

N

J8177C Gigabit 1000Base-T
Mini-GBIC

NA

Table Continued
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Product # Description Support1

J9150A 10GbE SFP+ SR
Transceiver

D

J9151A 10GbE SFP+ LR
Transceiver

D

J9152A 10GbE SFP+ LRM
Transceiver

D

J9153A 10GbE SFP+ ER
Transceiver

D

J9144A 10GbE X2-SC LRM
Transceiver

D

J8438A 10Gbe X2-SC ER
Transceiver

D

JH233A 40G QSFP+ MPO
eSR4 Transceiver

V

JH232A 40G QSFP+ LC LR4
SM Transceiver

V

JL308A 40G QSFP+BIDI V

JH231A 40G QSFP+ MPO SR4
Transceiver

V

1 Support indicators:

• V - Validated to respond to DOM requests

• N - No support of DOM

• D - Documented by the component suppliers as supporting DOM

• NA - Not applicable to the transceiver (copper transceiver)

NOTE: Not all transceivers support Digital Optical Monitoring. If DOM appears in the Diagnostic
Support field of the show interfaces transceiver detail command, or the
hpicfTransceiverMIB hpicfXcvrDiagnostics MIB object, DOM is supported for that transceiver.

The port VLAN tagged status
The show interfaces status command displays port status, configuration mode, speed, type and tagged or
untagged information.

Tagged values can be:

Chapter 5 Port status and configuration 113

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 3851



• VLAN ID: When the VLAN number is displayed, the port is a member of a single tagged VLAN.

• multi: When “multi” is displayed, the port is a member of multiple tagged VLANs.

• no: When “no” is displayed, the port is not a member of any tagged VLAN.

Untagged values can be:

• VLAN-ID: When the VLAN number is displayed, the port is a member of a single untagged VLAN.

• multi: When “multi” is displayed, the port is added to multiple untagged VLANs.

• no: When “no” is displayed, the port is not a member of any tagged VLAN.

If the port is part of a trunk, then the trunk_VLAN membership is displayed in the Tagged and Untagged columns.

show interfaces

switch(config)# show interfaces status
Port Name Status Config-mode Speed Type Tagged Untagged
-------- -------- ------ ----------- ------- --------- ------ ---------
A1 Up Auto 1000FDx 100/1000T 2 1
A2 Down 10HDx 10HDx 100/1000T multi 2
A3 Down 100HDx 100HDx 100/1000T multi 3
A4 Down 10FDx 10FDx 100/1000T 5 4
A5-Trk1 Down 100FDx 100FDx 100/1000T No No
A6 Down Auto 1000FDx 100/1000T No 6
A7 Down Auto-10 10HDx 100/1000T No 7

Dynamically updating the show interfaces command

command name
Syntax
show interfaces display
Description

Uses the display option to initiate the dynamic update of the show interfaces command, with the output
being the same as the show interfaces command.

Usage

Select Back to exit the display.

show interfaces display

switch# show interfaces display
When using the display option in the CLI, the information stays on the screen and is updated every 3 seconds, as
occurs with the display using the menu feature. The update is terminated with CTRL-C.
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You can use the arrow keys to scroll through the screen when the output does not fit in one screen.

Figure 9: show interfaces display command with dynamically updating output

Customizing the show interfaces command
You can create show commands displaying the information that you want to see in any order you want by using
the option.

show interfaces custom
Syntax
show interfaces custom <PORT-LIST> <COLUMN-LIST>
      
Description

Select the information that you want to display. Supported columns are shown in the following section.

Parameters and options

port

port identifier, such as A2.

type

Port type, such as 100/1000T

status

Port status, up or down.

speed

Connection speed and duplex, such as 1000FDX

mode

Configured mode, auto, auto-100, 100FDX

mdi

MDI mode, auto, MDIX

flow

Flow control, on or off
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name

Friendly port name

vlanid

The vlan id this port belongs to, or “tagged” if it belongs to more than one vlan.

enabled

Port is or is not enabled, yes or no.

intrusion

Intrusion alert status, no.

bcast

Broadcast limit, 0

You can specify the column width by entering a colon after the column name, then indicating the number of
characters to display. In Example of the custom show interfaces command on page 116, the Name column
displays only the first four characters of the name. All remaining characters are truncated.

Each field has a fixed minimum width to be displayed. If you specify a field width smaller than the minimum width,
the information is displayed at the minimum width. For example, if the minimum width for the Name field is 4
characters and you specify Name:2, the Name field displays 4 characters.

You can enter parameters in any order. There is a limit of 80 characters per line; if you exceed this limit an error
displays.

Example of the custom show interfaces command

switch# show int custom 1-4 port name:4 type vlan intrusion speed enabled mdi

 Status and Counters - Custom Port Status

                                   Intrusion
  Port Name       Type       VLAN  Alert     Speed   Enabled MDI-mode
  ---- ---------- ---------- ----- --------- ------- ------- --------
  1    Acco       100/1000T  1     No        1000FDx Yes     Auto
  2    Huma       100/1000T  1     No        1000FDx Yes     Auto
  3    Deve       100/1000T  1     No        1000FDx Yes     Auto
  4    Lab1       100/1000T  1     No        1000FDx Yes     Auto

show interface smartrate
Syntax
show interface <PORT-LIST> smartrate
      
Description

The option smartrate has been added to the show interface <PORT-LIST> command. This option is used
to display port diagnostics on a Smart Rate port only. If the command is run on a non‐Smart Rate port, a
message similar to Port A1: This command is only applicable to Smart Rate ports will display.

show interface port utilization
Syntax
show interface port-utilization
Description
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Use the show interface port-utilization command to view a real-time rate display for all ports on the
switch. show interface port-utilization command on page 117 shows a sample output from this command.

• For each port on the switch, the command provides a real-time display of the rate at which data is received
(Rx) and transmitted (Tx) in terms of kilobits per second (KBits/s), number of packets per second (Pkts/s), and
utilization (Util) expressed as a percentage of the total bandwidth available.

• The show interfaces <PORT-LIST> command can be used to display the current link status and the port
rate average over a 5 minute period. Port rates are shown in bits per second (bps) for ports up to 1 Gigabit; for
10 Gigabit ports, port rates are shown in kilobits per second (Kbps.)

show interface port-utilization command

Enabling or disabling ports and configuring port mode
You can configure one or more of the following port parameters.

interface
Syntax
interface <PORT-LIST> [disable|enable]
      
Description

Disables or enables the port for network traffic. Does not use the no form of the command. Defaults to enable.
You can substitute int for interface (for example, int <PORT-LIST> .)

Parameters and options
speed-duplex [auto-10|10-full|10-half|100-full|100-half|auto|auto-100|1000-full]

Specifies the port's data transfer speed and mode. Does not use the no form of the command. Default: auto.

The 10/100 auto-negotiation feature allows a port to establish a link with a port at the other end at either 10
Mbps or 100 Mbps, using the highest mutual speed and duplex mode available. Only these speeds are
allowed with this setting.

Configure port C5 for auto-10-100

switch# int c5 speed-duplex auto-10-100
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Configure ports C1 through C3 and port C6 for 100Mbps full-duplex

switch# int c1-c3,c6 speed-duplex 100-full
Similarly, to configure a single port with the above command settings, you could either enter the same command
with only the one port identified or go to the context level for that port and then enter the command. For example,
to enter the context level for port C6 and then configure that port for 100FDx:

switch# int e c6 
switch(eth-C6#) speed-duplex 100-full
If port C8 was disabled, and you wanted to enable it and configure it for 100FDx with flow-control active, you
could do so with either of the following command sets:

Figure 10: Two methods for changing a port configuration

Basic USB port commands
This feature allows configuration of the USB port with either the CLI or SNMP.

Syntax
show usb-port
Description

To display the status of the USB port: Displays the status of the USB port. It can be enabled, disabled, or not
present.

show usb-port command output

switch# show usb-port

  USB port status: enabled
  USB port power status: power on    (USB device detected in port)
One of the following messages indicates the presence or absence of the USB device:

• Not able to sense device in USB port

• USB device detected in port

• no USB device detected in port
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usb-port
Syntax
usb-port

no usb-port
Description

Enables the USB port.

The no form of the command disables the USB port and any access to the device.

Command context
Config

show usb-port
Syntax
show usb-port

Description

Displays the status of the USB port. It can be enabled, disabled, or not present.

Command context
operator

Usage

One of the following messages indicates the presence or absence of a USB device:

• Not able to sense device in USB port
• USB device detected in port
• no USB device detected in port

Example

Display USB port status.

switch# show usb-port

  USB port status: enabled
  USB port power status: power on    (USB device detected in port)

Enabling or disabling flow control
You must enable flow control on both ports in a given link. Otherwise, flow control does not operate on the link
and appears as Off in the show interfaces brief port listing, even if flow control is configured as enabled
on the port in the switch. Also, the port (speed-duplex) mode must be set to Auto (the default).

To disable flow control on some ports, while leaving it enabled on other ports, just disable it on the individual ports
you want to exclude.
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interface flow-control
Syntax
interface <PORT-LIST> flow-control
      
Description

Enables or disables flow control packets on the port. Default: Disabled.

Parameters

no

The no form of the command disables flow control on the individual ports.

Examples
no interface <PORT-LIST> flow-control
      
Usage

1. You want to enable flow control on ports A1-A6.

2. Later, you decide to disable flow control on ports A5 and A6.

3. As a final step, you want to disable flow control on all ports.

Assuming that flow control is currently disabled on the switch, you would use these commands:

Configuring flow control for a series of ports

switch# int a1-a6 flow-control
switch# show interfaces brief

 Status and Counters - Port Status

                   | Intrusion                           MDI  Flow Bcast
  Port   Type      | Alert     Enabled Status Mode       Mode Ctrl Limit
  ------ --------- + --------- ------- ------ ---------- ---- ---- ----- 
  A1     10GbE-T   | No        Yes     Up     1000FDx    NA   on   0
  A2     10GbE-T   | No        Yes     Up     10GigFD    NA   on   0
  A3     10GbE-T   | No        Yes     Up     10GigFD    NA   on   0
  A4     10GbE-T   | No        Yes     Up     10GigFD    NA   on   0
  A5     10GbE-T   | No        Yes     Up     10GigFD    NA   on   0
  A6     10GbE-T   | No        Yes     Up     10GigFD    NA   on   0
  A7     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A8     10GbE-T   | No        Yes     Up     10GigFD    NA   off  0

Example continued from Configuring flow control for a series of ports

switch# no int a5-a6 flow-control
switch# show interfaces brief

 Status and Counters - Port Status

                   | Intrusion                           MDI  Flow Bcast
  Port   Type      | Alert     Enabled Status Mode       Mode Ctrl Limit
  ------ --------- + --------- ------- ------ ---------- ---- ---- ----- 
  A1     10GbE-T   | No        Yes     Up     1000FDx    NA   on   0
  A2     10GbE-T   | No        Yes     Down   10GigFD    NA   on   0
  A3     10GbE-T   | No        Yes     Down   10GigFD    NA   on   0
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  A4     10GbE-T   | No        Yes     Down   10GigFD    NA   on   0
  A5     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A6     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A7     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A8     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0

Example continued from Example continued from Configuring flow control for a series of ports

switch# no int a1-a4 flow-control
switch# show interfaces brief

 Status and Counters - Port Status

                   | Intrusion                           MDI  Flow Bcast
  Port   Type      | Alert     Enabled Status Mode       Mode Ctrl Limit
  ------ --------- + --------- ------- ------ ---------- ---- ---- ----- 
  A1     10GbE-T   | No        Yes     Down   1000FDx    NA   off  0
  A2     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A3     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A4     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A5     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A6     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A7     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A8     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0

Configuring auto-MDIX

interface mdix-mode
Syntax
interface <PORT-LIST> mdix-mode [auto-mdix|mdi|mdix]
      
Description

The auto-MDIX features apply only to copper port switches using twisted-pair copper Ethernet cables.

Parameters

auto-mdix

The automatic, default setting. This configures the port for automatic detection of the cable (either straight-
through or crossover.)

mdi

The manual mode setting that configures the port for connecting to either a PC or other MDI device with a
crossover cable, or to a switch, hub, or other MDI-X device with a straight-through cable.

mdix

The manual mode setting that configures the port for connecting to either a switch, hub, or other MDI-X device
with a crossover cable, or to a PC or other MDI device with a straight-through cable.

show interfaces config
Syntax
show interfaces config
Description
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Lists the current per-port Auto/MDI/MDI-X configuration.

show interfaces brief
Syntax
show interfaces brief
Description

• Where a port is linked to another device, this command lists the MDI mode the port is currently using.

• In the case of ports configured for Auto ( auto-mdix), the MDI mode appears as either MDI or MDIX,
depending upon which option the port has negotiated with the device on the other end of the link.

• In the case of ports configured for MDI or MDIX, the mode listed in this display matches the configured setting.

• If the link to another device was up, but has gone down, this command shows the last operating MDI mode the
port was using.

• If a port on a given switch has not detected a link to another device since the last reboot, this command lists
the MDI mode to which the port is currently configured.

show interfaces config displays the following data when port A1 is configured for auto-mdix, port A2 is
configured for mdi, and port A3 is configured for mdix:

Example of displaying the current MDI configuration

switch# show interfaces config

 Port Settings

  Port   Type      | Enabled Mode         Flow Ctrl MDI
  ------ --------- + ------- ------------ --------- ---- 
  A1     10GbE-T   | Yes     Auto         Disable   Auto 
  A2     10GbE-T   | Yes     Auto         Disable   MDI 
  A3     10GbE-T   | Yes     Auto         Disable   MDIX 
  A4     10GbE-T   | Yes     Auto         Disable   Auto 
  A5     10GbE-T   | Yes     Auto         Disable   Auto 
  A6     10GbE-T   | Yes     Auto         Disable   Auto 
  A7     10GbE-T   | Yes     Auto         Disable   Auto 
  A8     10GbE-T   | Yes     Auto         Disable   Auto

Example of displaying the current MDI operating mode

switch# show interfaces brief

 Status and Counters - Port Status

                   | Intrusion                           MDI  Flow Bcast
  Port   Type      | Alert     Enabled Status Mode       Mode Ctrl Limit
  ------ --------- + --------- ------- ------ ---------- ---- ---- ----- 
  A1     10GbE-T   | No        Yes     Up     1000FDx    MDIX off  0
  A2     10GbE-T   | No        Yes     Down   10GigFD    MDI  off  0
  A3     10GbE-T   | No        Yes     Down   10GigFD    MDIX off  0
  A4     10GbE-T   | No        Yes     Down   10GigFD    Auto off  0
  A5     10GbE-T   | No        Yes     Down   10GigFD    Auto off  0
  A6     10GbE-T   | No        Yes     Down   10GigFD    Auto off  0
  A7     10GbE-T   | No        Yes     Down   10GigFD    Auto off  0
  A8     10GbE-T   | No        Yes     Down   10GigFD    Auto off  0
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Configuring friendly port names

interface name
Syntax
interface <PORT-LIST> name <port-name-string>
    
Description

Assigns a port name to <PORT-LIST>.

Parameter

no

Deletes the port name from <PORT-LIST>.

Configuring a single port name
Suppose that you have connected port A3 on the switch to Bill Smith's workstation, and want to assign Bill's name
and workstation IP address (10.25.101.73) as a port name for port A3:

Example of configuring a friendly port name

switch# int A3 name Bill_Smith@10.25.101.73
switch# write mem
switch# show name A3

 Port Names
  Port : A3
   Type : 10/100TX
   Name : Bill_Smith@10.25.101.73

Configuring the same name for multiple ports
Suppose that you want to use ports A5 through A8 as a trunked link to a server used by a drafting group. In this
case you might configure ports A5 through A8 with the name "Draft-Server:Trunk."

Example of configuring one friendly port name on multiple ports

switch# int a5-a8 name Draft-Server:Trunk
switch# write mem
switch# show name a5-a8

 Port Names

  Port : A5
   Type : 10GbE-T
   Name : Draft-Server:Trunk
 Port : A6
   Type : 10GbE-T
   Name : Draft-Server:Trunk
 Port : A7
   Type : 10GbE-T
   Name : Draft-Server:Trunk
 Port : A8
   Type : 10GbE-T
   Name : Draft-Server:Trunk
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Viewing friendly port names with other port data

show name
Syntax
show name
Description

Displays a listing of port numbers with their corresponding friendly port names and also quickly shows you which
ports do not have friendly name assignments. (show name data comes from the running-config file.)

show interface
Syntax
show interface <PORT-NUMBER>
    
Displays the friendly port name, if any, along with the traffic statistics for that port. (The friendly port name data
comes from the running-config file.)

show config
Syntax
show config
Description

Includes friendly port names in the per-port data of the resulting configuration listing. (show config data comes
from the startup-config file.)

Listing all ports or selected ports with their friendly port
names

show name
Syntax
show name <PORT-LIST>
    
Description

Lists the friendly port name with its corresponding port number and port type. The show name command without
a port list shows this data for all ports on the switch.

Example of friendly port name data for all ports on the switch

switch# show name
Port Names

  Port   Type      Name
  ------ --------- ----------------------------------------------------------- 
  A1     10GbE-T
  A2     10GbE-T
  A3     10GbE-T   Bill_Smith@10.25.101.73
  A4     10GbE-T
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  A5     10GbE-T   Draft-Server:Trunk 
  A6     10GbE-T   Draft-Server:Trunk 
  A7     10GbE-T   Draft-Server:Trunk 
  A8     10GbE-T   Draft-Server:Trunk

Example of friendly port name data for specific ports on the switch

switch# show name A3-A5

 Port Names

  Port : A3
  Type : 10GbE-T
  Name : Bill_Smith@10.25.101.73
 Port : A4
  Type : 10GbE-T 
  Name :
 Port : A5
  Type : 10GbE-T
  Name : Draft-Server:Trunk

Including friendly port names in per-port statistics listings

show interface
Syntax
show interface <PORT-NUMBER>
      
Description

Includes the friendly port name with the port's traffic statistics listing. A friendly port name configured to a port is
automatically included when you display the port's statistics output.

If you configure port A1 with the name "O'Connor_10.25.101.43," the show interface output for this port
appears similar to the following:

Usage
switch(config)# show interfaces 1
switch(config)# show interface 1 hc
switch(config)# show int queues 1

Example show interfaces 1

switch(config)# show interfaces 1 

Status and Counters - Port Counters for port 1

  Name  :
  MAC Address      : 1cc1de-4d8d7f
  Link Status      : Up
  Port Enabled     : <Yes/No>
  Totals (Since boot or last clear) :
   Bytes Rx        : 218,939              Bytes Tx        : 99,019
   Unicast Rx      : 538                  Unicast Tx      : 290
   Bcast/Mcast Rx  : 1,132                Bcast/Mcast Tx  : 166
  Errors (Since boot or last clear) :
   FCS Rx          : 0                    Drops Tx        : 0
   Alignment Rx    : 0                    Collisions Tx   : 0
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   Runts Rx        : 0                    Late Colln Tx   : 0
   Giants Rx       : 0                    Excessive Colln : 0
   Total Rx Errors : 0                    Deferred Tx     : 0
  Others (Since boot or last clear) :
   Discard Rx      : 0                    Out Queue Len   : 0
   Unknown Protos  : 0
  Rates (5 minute weighted average) :
   Total Rx (bps) : 0                     Total Tx (bps) : 0
   Unicast Rx (Pkts/sec) : 0              Unicast Tx (Pkts/sec) : 0
   B/Mcast Rx (Pkts/sec) : 0              B/Mcast Tx (Pkts/sec) : 0
   Utilization Rx  :     0 %              Utilization Tx  :     0 %

Example show interface 1 hc

switch(config)# show interface 1 hc                             
Status and Counters - Port Counters for port 1

  Name  :
  MAC Address     : 1cc1de-4d8d7f
  Link Status     : Up
  Port Enabled    : <Yes/No>
  Totals (Since boot or last clear) :
   Bytes Rx        : 221,044              Bytes Tx        : 100,043
   Unicast Rx      : 545                  Unicast Tx      : 294
   Bcast/Mcast Rx  : 1,143                Bcast/Mcast Tx  : 168
  Errors (Since boot or last clear) :
   FCS Rx          : 0                    Drops Tx        : 0
   Alignment Rx    : 0                    Collisions Tx   : 0
   Runts Rx        : 0                    Late Colln Tx   : 0
   Giants Rx       : 0                    Excessive Colln : 0
   Total Rx Errors : 0                    Deferred Tx     : 0
  Others (Since boot or last clear) :
   Discard Rx      : 0                    Out Queue Len   : 0
   Unknown Protos  : 0
  Rates (5 minute weighted average) :
   Total Rx (bps) : 0                     Total Tx (bps) : 0
   Unicast Rx (Pkts/sec) : 0              Unicast Tx (Pkts/sec) : 0
   B/Mcast Rx (Pkts/sec) : 0              B/Mcast Tx (Pkts/sec) : 0
switch(config)#

Example show int queues 1

switch(config)# show int queues 1                                      
 Status and Counters - Port Counters for port 1

  Name  :
  MAC Address      : 1cc1de-4d8d7f
  Link Status      : Down
  Port Enabled     : <Yes/No>
  Port Totals (Since boot or last clear) :
   Rx Packets      : 1,754              Tx Packets      : 482
   Rx Bytes        : 229,698            Tx Bytes        : 103,963
   Rx Drop Packets : 0                  Tx Drop Packets : 0
   Rx Drop Bytes   : 0                  Tx Drop Bytes   : 0

  Egress Queue Totals (Since boot or last clear) :
     Tx Packets         Dropped Packets    Tx Bytes           Dropped Bytes
Q1  0                  0                  0                  0
Q2  0                  0                  0                  0
Q3  313                0                  59,681             0
Q4  0                  0                  0                  0
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Q5  0                  0                  0                  0
Q6  0                  0                  0                  0
Q7  0                  0                  0                  0
Q8  169                0                  44,282             0

NOTE: For a given port, if a friendly port name does not exist in the running-config file, the Name line
in the above command output appears as Name : not assigned.

Searching the configuration for ports with friendly port names
This option tells you which friendly port names have been saved to the startup-config file. (show config does
not include ports that have only default settings in the startup-config file.)

show config
Syntax
show config
Description

Includes friendly port names in a listing of all interfaces (ports) configured with non-default settings. Excludes
ports that have neither a friendly port name nor any other non-default configuration settings.

If you configure port A1 with a friendly port name:

Figure 11: Listing of the startup-config file with a friendly port name configured

Configuring uni-directional link detection

interface link-keepalive
Syntax
interface <PORT-LIST> link-keepalive
      
Description

Enables UDLD on a port or range of ports. Default: UDLD disabled

Parameters and options
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no

To disable this feature, enter the no form of the command.

link-keepalive interval <INTERVAL>

Determines the time interval to send UDLD control packets. The interval parameter specifies how often the
ports send a UDLD packet. You can specify from 10 to 100, in 100-ms increments, where 10 is 1 second, 11
is 1.1 seconds, and so on.

Default: 50 (5 seconds)

link-keepalive retries <NUM>

Determines the maximum number of retries to send UDLD control packets. The num parameter specifies the
maximum number of times the port will try the health check. You can specify a value from 3 to 10.

Default: 5

link-keepalive vlan <VID>

Assigns a VLAN ID to a UDLD-enabled port for sending tagged UDLD control packets.Under default settings,
untagged UDLD packets can still be transmitted and received on tagged only ports; however, a warning
message is logged.

The no form of the command disables UDLD on the specified ports.

Default: UDLD packets are untagged; tagged-only ports transmit and receive untagged UDLD control packets

Enabling UDLD
UDLD is enabled on a per-port basis.

When at least one port is UDLD-enabled, the switch will forward out UDLD packets that arrive on non-UDLD-
configured ports out of all other non-UDLD configured ports in the same vlan. That is, UDLD control packets will
“pass through” a port that is not configured for UDLD. However, UDLD packets will be dropped on any blocked
ports that are not configured for UDLD.

Enable UDLD on port a1

switch# interface al link-keepalive

Enter the appropriate port range to enable the feature on a trunk group

switch#interface al-a4 link-keepalive

Changing the keepalive interval
By default, ports enabled for UDLD send a link health-check packet once every 5 seconds. You can change the
interval to a value from 10 to 100 deciseconds, where 10 is 1 second, 11 is 1.1 seconds, and so on.

Change packet interval to seven seconds

switch# link-keepalive interval 70
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Changing the keepalive retries
By default, a port waits 5 seconds to receive a health-check reply packet from the port at the other end of the link.
If the port does not receive a reply, the port tries four more times by sending up to four more health-check
packets. If the port still does not receive a reply after the maximum number of retries, the port goes down.

You can change the maximum number of keepalive attempts to a value from 3 to 10.

Change the maximum number of attempts to four

switch# link-keepalive retries 4

Configuring UDLD for tagged ports
The default implementation of UDLD sends the UDLD control packets untagged, even across tagged ports. If an
untagged UDLD packet is received by a non-Hewlett Packard Enterprise switch, that switch may reject the
packet. To avoid such an occurrence, you can configure ports to send out UDLD control packets that are tagged
with a specified VLAN.

enable ports to receive and send UDLD control packets tagged with a specific VLAN ID

switch# interface llink-keepalive vlan 22

• You must configure the same VLANs that will be used for UDLD on all devices across the network; otherwise,
the UDLD link cannot be maintained.

• If a VLAN ID is not specified, UDLD control packets are sent out of the port as untagged packets.

• To re-assign a VLAN ID, re-enter the command with the new VLAN ID number. The new command overwrites
the previous command setting.

• When configuring UDLD for tagged ports, you may receive a warning message if there are any inconsistencies
with the VLAN configuration of the port. See Viewing port status and configuration on page 110 for potential
problems.

Viewing UDLD information

show link-keepalive
Syntax
show link-keepalive
Description

Displays all the ports that are enabled for link-keepalive.

Parameters

statistics

Displays detailed statistics for the UDLD-enabled ports on the switch.
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clear link-keepalive
Syntax
clear link-keepalive statistics
Description

Clears UDLD statistics. This command clears the packets sent, packets received, and transitions counters in the
show link-keepalive statistics display.

Parameters

statistics

Displays detailed statistics for the UDLD-enabled ports on the switch.

Viewing summary information on all UDLD-enabled ports
Enter the show link-keepalive command.

show link-keepalive command

Figure 12: show link-keepalive

Viewing detailed UDLD information for specific ports
Enter the show link-keepalive statistics command.
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show link-keepalive command

Figure 13: show link-keepalive statistics

Port status and Port parameters

Connecting transceivers to fixed-configuration devices

Cause

If the switch either fails to show a link between an installed transceiver and another device or demonstrates errors
or other unexpected behavior on the link, check the port configuration on both devices for a speed and/or duplex
(mode) mismatch.

• To check the mode setting for a port on the switch, use either the Port Status screen in the menu interface or
show interfaces brief in the CLI.

• To display information about the transceivers installed on a switch, enter the show tech receivers
command in the CLI.

Enabled

Yes (default): The port is ready for a network connection.

No: The port will not operate, even if properly connected in a network. Use this setting, for example, if the port
needs to be shut down for diagnostic purposes or while you are making topology changes.

Status (read-only

Up: The port senses a link beat.
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Mode

The port's speed and duplex (data transfer operation) setting.

10/100/1000Base-T Ports:
• Auto-MDIX (default): Senses speed and negotiates with the port at the other end of the link for port

operation (MDI-X or MDI.)

To see what the switch negotiates for the auto setting, use the CLI show interfaces brief command
or the 3. Port Status option under 1. Status and Counters in the menu interface.

• MDI: Sets the port to connect with a PC using a crossover cable (manual mode—applies only to copper
port switches using twisted-pair copper Ethernet cables)

• MDIX: Sets the port to connect with a PC using a straight-through cable (manual mode—applies only to
copper port switches using twisted-pair copper Ethernet cables)

• Auto-10: Allows the port to negotiate between half-duplex (HDx) and full-duplex (FDx) while keeping
speed at 10 Mbps. Also negotiates flow control (enabled or disabled.) Hewlett Packard Enterprise
recommends auto-10 for links between 10/100 auto-sensing ports connected with Cat 3 cabling. (Cat 5
cabling is required for 100 Mbps links.)

• 10HDx:10 Mbps, half-duplex

• 10FDx: 10 Mbps, full-duplex

• Auto-100: Uses 100 Mbps and negotiates with the port at the other end of the link for other port operation
features.

• Auto-10-100: Allows the port to establish a link with the port at the other end at either 10 Mbps or 100
Mbps, using the highest mutual speed and duplex mode available. Only these speeds are allowed with this
setting.

• Auto-1000: Uses 1000 Mbps and negotiates with the port at the other end of the link for other port
operation features.

• 100Hdx: Uses 100 Mbps, half-duplex.

• 100Fdx: Uses 100 Mbps, full-duplex

Gigabit Fiber-Optic Ports (Gigabit-SX, Gigabit-LX, and Gigabit-LH):

• 1000FDx: 1000 Mbps (1 Gbps), full-duplex only

• Auto (default): The port operates at 1000FDx and auto-negotiates flow control with the device connected
to the port.

Gigabit Copper Ports:

• 1000FDx: 1000 Mbps (1 Gbps), full-duplex only

• Auto (default): The port operates at 1000FDx and auto-negotiates flow control with the device connected
to the port.
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10-Gigabit CX4 Copper Ports:

Auto: The port operates at 10 gigabits FDx and negotiates flow control. Lower speed settings or half-duplex
are not allowed.

10-Gigabit SC Fiber-Optic Ports (10-GbE SR, 10-GbE LR, 10-GbE ER):

Auto: The port operates at 10 gigabits FDx and negotiates flow control. Lower speed settings or half-duplex
are not allowed.

NOTE: Conditioning patch cord cables are not supported on 10-GbE.

Auto-MDIX

The switch supports Auto-MDIX on 10Mb, 100Mb, and 1 Gb T/TX (copper) ports. (Fiber ports and 10-gigabit
ports do not use this feature.)

• Automdix: Configures the port for automatic detection of the cable type (straight-through or crossover.)

• MDI: Configures the port to connect to a switch, hub, or other MDI-X device with a straight-through cable.

• MDIX: Configures the port to connect to a PC or other MDI device with a straight-through cable.

flow-control

• Disabled (default): The port does not generate flow control packets, and drops any flow control packets it
receives.

• Enabled: The port uses 802.3x link layer flow control, generates flow-control packets, and processes
received flow-control packets.

With the port mode set to Auto (the default) and flow control enabled, the switch negotiates flow control on
the indicated port. If the port mode is not set to Auto, or if flow control is disabled on the port, flow control is
not used. Note that flow control must be enabled on both ends of a link.

Broadcast limit

Specifies the percentage of the theoretical maximum network bandwidth that can be used for broadcast traffic.
Any broadcast traffic exceeding that limit will be dropped. Zero (0) means the feature is disabled.

The broadcast-limit command operates at the port context level to set the broadcast limit for a port on the
switch.

NOTE: This feature is not appropriate for networks that require high levels of IPX or RIP
broadcast traffic.

Error messages associated with the show interfaces command
Requesting too many fields (total characters exceeds 80)

Total length of selected data exceeds one line

Field name is misspelled
Invalid input: input

Mistake in specifying the port list
Module not present for port or invalid port: input
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The port list is not specified
Incomplete input: custom

Using pattern matching with the show interfaces custom command

Cause

If you have included a pattern matching command to search for a field in the output of the show int custom
command, and the show int custom command produces an error, the error message may not be visible and
the output is empty. For example, if you enter a command that produces an error (such as vlan is misspelled) with
the pattern matching include option, the output may be empty:

switch# show int custom 1-3 name [vlun|include vlan1]
Try the show int custom command first to ensure there is output, and then enter the command again with the
pattern matching option.

You can substitute int for interface; that is: show int custom.

Auto-MDIX configurations
Copper ports on the switch can automatically detect the type of cable configuration (MDI or MDI-X) on a
connected device and adjust to operate appropriately.

This means you can use a "straight-through" twisted-pair cable or a "crossover" twisted-pair cable for any of the
connections—the port makes the necessary adjustments to accommodate either one for correct operation. The
following port types on your switch support the IEEE 802.3ab standard, which includes the "Auto MDI/MDI-X"
feature:

• 10/100-TX xl module ports

• 100/1000-T xl module ports

• 10/100/1000-T xl module ports

Using the above ports:

• If you connect a copper port using a straight-through cable on a switch to a port on another switch or hub that
uses MDI-X ports, the switch port automatically operates as an MDI port.

• If you connect a copper port using a straight-through cable on a switch to a port on an end node—such as a
server or PC—that uses MDI ports, the switch port automatically operates as an MDI-X port.

Switch auto-MDIX supports operation in forced speed and duplex modes.

For more information on this subject, see the IEEE 802.3ab standard reference. For more information on MDI-X,
see the installation and getting started guide.

Manual override
If you require control over the MDI/MDI-X feature, you can set the switch to either of these non-default modes:

• Manual MDI

• Manual MDI-X
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Table 4: Cable types for auto and manual MDI/MDI-X settings

Setting MDI/MDI-X device type

PC or other MDI device type Switch, hub, or other MDI-X
device

Manual MDI Crossover cable Straight-through cable

Manual MDI-X Straight-through cable Crossover cable

Auto-MDI-X (the default) Either crossover or straight-through cable

The AutoMDIX features apply only to copper port switches using twisted-pair copper Ethernet cables.

About using friendly port names
Optional: This feature enables you to assign alphanumeric port names of your choosing to augment automatically
assigned numeric port names. This means you can configure meaningful port names to make it easier to identify
the source of information listed by some show commands. (Note that this feature augments port numbering, but
does not replace it.)

Configuring and operating rules for friendly port names

• At either the global or context configuration level, you can assign a unique name to a port. You can also assign
the same name to multiple ports.

• The friendly port names you configure appear in the output of the show name<PORT-LIST>, show config,
and show interface port-number commands. They do not appear in the output of other show
commands or in Menu interface screens. (See Viewing friendly port names with other port data on page
124.)

• Friendly port names are not a substitute for port numbers in CLI commands or Menu displays.

• Trunking ports together does not affect friendly naming for the individual ports. (If you want the same name for
all ports in a trunk, you must individually assign the name to each port.)

• A friendly port name can have up to 64 contiguous alphanumeric characters.

• Blank spaces within friendly port names are not allowed, and if used, cause an invalid input error. (The switch
interprets a blank space as a name terminator.)

• In a port listing, not assigned indicates that the port does not have a name assignment other than its fixed
port number.

• To retain friendly port names across reboots, you must save the current running-configuration to the startup-
config file after entering the friendly port names. (In the CLI, use the write memory command.)
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Uni-directional link detection (UDLD)
Uni-directional link detection (UDLD) monitors a link between two switches and blocks the ports on both ends of
the link if the link fails at any point between the two devices. This feature is particularly useful for detecting failures
in fiber links and trunks. Figure 14: UDLD on page 136 shows an example.

Figure 14: UDLD

In this example, each switch load balances traffic across two ports in a trunk group. Without the UDLD feature, a
link failure on a link that is not directly attached to one of the switches remains undetected. As a result, each
switch continue to send traffic on the ports connected to the failed link. When UDLD is enabled on the trunk ports
on each switch, the switches detect the failed link, block the ports connected to the failed link, and use the
remaining ports in the trunk group to forward the traffic.

Similarly, UDLD is effective for monitoring fiber optic links that use two uni-direction fibers to transmit and receive
packets. Without UDLD, if a fiber breaks in one direction, a fiber port may assume the link is still good (because
the other direction is operating normally) and continue to send traffic on the connected ports. UDLD-enabled
ports; however, will prevent traffic from being sent across a bad link by blocking the ports in the event that either
the individual transmitter or receiver for that connection fails.

Ports enabled for UDLD exchange health-check packets once every five seconds (the link-keepalive interval.) If a
port does not receive a health-check packet from the port at the other end of the link within the keepalive interval,
the port waits for four more intervals. If the port still does not receive a health-check packet after waiting for five
intervals, the port concludes that the link has failed and blocks the UDLD-enabled port.

When a port is blocked by UDLD, the event is recorded in the switch log or via an SNMP trap (if configured); and
other port blocking protocols, like spanning tree or meshing, will not use the bad link to load balance packets. The
port will remain blocked until the link is unplugged, disabled, or fixed. The port can also be unblocked by disabling
UDLD on the port.

Configuring UDLD
Consult the release notes and current manuals for required software versions and to determine if your switch
model interoperates with UDLD.

When UDLD enabled on at least one port , UDLD packet received on UDLD disabled port will be re-forwarded out
on all other UDLD disabled ports on the same VLAN as per the below conditions.
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Procedure

1. If the incoming port itself is already blocked on the VLAN it will be dropped right away, and no re-forwarding
will be done.

2. UDLD packet will be re-forwarded to other UDLD disabled ports of the same VLAN that are in forwarding
state( non blocked ports).

Prerequisites

Procedure

1. When configuring UDLD, keep the following considerations in mind:

a. UDLD is configured on a per-port basis and must be enabled at both ends of the link. See the note below
for a list of switches that support UDLD.

b. To configure UDLD on a trunk group, you must configure the feature on each port of the group individually.
Configuring UDLD on a trunk group's primary port enables the feature on that port only.

c. Dynamic trunking is not supported. If you want to configure a trunk group that contains ports on which
UDLD is enabled, you must remove the UDLD configuration from the ports. After you create the trunk
group, you can re-add the UDLD configuration.

Uplink Failure Detection
Uplink Failure Detection (UFD) is a network path redundancy feature that works in conjunction with NIC teaming
functionality. UFD continuously monitors the link state of the ports configured as links-to-monitor (LtM), and when
these ports lose link with their partners, UFD will disable the set of ports configured as links-to-disable (LtD.)
When an uplink port goes down, UFD enables the switch to auto-disable the specific downlinks connected to the
NICs. This allows the NIC teaming software to detect link failure on the primary NIC port and fail over to the
secondary NIC in the team.

NIC teams must be configured for switch redundancy when used with UFD, that is, the team spans ports on both
Switch A and Switch B. The switch automatically enables the downlink ports when the uplink returns to service.
For an example of teamed NICs in conjunction with UFD, see Figure 15: Teamed NICs in conjunction with
UFD on page 138.) For an example of teamed NICs with a failed uplink, see Figure 16: Teamed NICs with a
failed uplink on page 138.
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For UFD functionality to work as expected, the NIC teaming must be in Network Fault Tolerance (NFT) mode.

Figure 15: Teamed NICs in conjunction with UFD

Figure 16: Teamed NICs with a failed uplink

NOTE: The state of the LtD is purely governed by the state of the LtM, and is independent of the
physical state of the ports in the LtD.
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Configuration Guidelines for UFD
Below is a list of configuration guidelines to be followed for UFD. These are applicable only to blade switches
where there is a clear distinction between downlink and uplink ports.

1. UFD is required only when uplink-path redundancy is not available on the blade switches.

2. An LtM can be either one or more uplink ports or one or more multi-link trunk group of uplink ports.

3. Ports that are already members of a trunk group are not allowed to be assigned to an LtM or LtD.

4. A trunk group configured as an LtM can contain multiple uplink ports, but no downlink ports or ISL (Inter-
Switch-Link) ports.

5. A port cannot be added to a trunk group if it already belongs to an LtM or LtD.

6. An LtD can contain one or more ports, and/or one or more trunks

7. A trunk group configured as an LtD can contain multiple downlink ports, but no uplink ports or ISL (Inter-
Switch-Link) ports.

A common API will be provided for higher layers, like CLI and SNMP, which will determine if a port-list can be an
LtM or LtD. The API will handle the platform specific details and ensure a uniform code flow for blade and other
switch families.

Switches do not have a clear distinction between uplink and downlink ports so some of the points listed above
may not be applicable.

UFD enable/disable

uplink-failure-detection
Syntax
uplink-failure-detection
Description

Used to globally enable UFD. The [no] option globally disables UFD.

UFD configuration

uplink-failure-detection track

Syntax
uplink-failure-detection track <track_ID> links-to-monitor <port-list> links-to-disable <port-list>
delay <delay_value>

no uplink-failure-detection track <track_ID> links-to-monitor <port-list> links-to-disable <port-list>
delay <delay_value>

Description

Configures LtM and LtD ports for track-id. UFD delay is configured in seconds until when uplink must remain in a
stable state before restoring the downlink. UFD delay is configurable between 0 to 300 seconds. The default
delay value is 0.

The no form of this command resets the parameter.
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Command context
config

Parameters
<track_ID>

Specifies the track id.

<Port-List>

Specifies the port list.

<delay_value>

Specifies the delay value.

Examples
Configure port A8 as LtM, port A6 as LtD, and delay value as 100 for track 1:

Switch(config)# uplink-failure-detection track 1 links-to-monitor A8 
links-to-disable A6 delay 100

switch(config)# show running-config

Running configuration:

; J9851A Configuration Editor; Created on release #KB.16.08.0001
; Ver #14:01.4f.f8.1d.fb.7f.bf.bb.ff.7c.59.fc.7b.ff.ff.fc.ff.ff.3f.ef:4e
hostname "switch"
module A type j9993a
module L type j9992a
snmp-server community "public" unrestricted
oobm
   ip address dhcp-bootp
   exit
uplink-failure-detection
uplink-failure-detection track 1 links-to-monitor A8 links-to-disable A6 delay 100
vlan 1
   name "DEFAULT_VLAN"
   untagged A1-A8,L1-L21
   ip address dhcp-bootp
   ipv6 enable
   ipv6 address dhcp full
   exit
To set delay value to 2:

switch(config)# uplink-failure-detection track 1 delay 2
To set delay value to 0:

switch(config)#no uplink-failure-detection track 1 delay 2
Alternately, to set delay value to 0, a user can also use the following command:

switch(config)#uplink-failure-detection track 1 delay 0

show uplink-failure-detection

Syntax
show uplink-failure-detection
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Description

Shows the uplink failure detection information.

Command context
manager

Examples

switch# show uplink-failure-detection

Uplink Failure Detection Information

  UFD Enabled   : Yes

  Track | Monitored   Links to    LtM      LtD      LtM       LtD        Delay
  ID    | Links       Disable     State    State    Lacp Key  Lacp Key   (sec)
  ------+----------   ----------- -------- -------  --------- ---------- ------
  1     | Dyn1        Dyn2        Up       Up       1         2          0
  32    | Trk1        Trk3        Up       Up                            300
  50    | Trk2        Trk4        Up       Up                            120
  64    | 2/12        2/14        Up       Up                            150
If there is a failure, and one track is in Down/Auto-Disabled state, the show uplink-failure-detection
command displays:

switch(config)# show uplink-failure-detection

Uplink Failure Detection Information

  UFD Enabled   : Yes

  Track | Monitored    Links to     LtM    LtD           LtM      LtD      Delay
  ID    | Links        Disable      State  State         Lacp Key Lacp Key (sec)
  ----- + ------------ ------------ ------ ------------- -------- -------- -----
  1     | Trk1         A4           Up     Up                              100
  2     | A5           A6           Down   Auto-Disabled                   0

Port Shutdown with Broadcast Storm
A LAN broadcast storm arises when an excessively high rate of broadcast packets flood the LAN. Occurrence of
LAN broadcast storm disrupts traffic and degrades network performance. To prevent LAN traffic from being
disrupted, the use of fault-finder commands trigger a port disablement when a broadcast storm is detected.
Commands can be used only to support broadcast traffic and not multicast and unicast types of traffic.

The waiting period range for re-enabling ports is 0 to 604800 seconds. The default waiting period to re-enable a
port is zero which prevents the port from automatic re-enabling.

IMPORTANT: Avoid port flapping when choosing the waiting period by considering the time to re-
enable carefully.

Configuration Commands

fault-finder broadcast-storm
Syntax
fault-finder broadcast-storm [ethernet] <PORT-LIST> action [warn|warn-and-disable <SECONDS>][percent <PERCENT>|pps <RATE>
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Descripton

Use the following commands to configure the broadcast-storm on a port.

Parameters and options
ethernet

—

action
—

warn
—

warn-and-disable
—

percent
—

pps
—

<PORT-LIST>

—

<SECONDS>

—

<PERCENT>

—

<RATE>

—

Usage

To remove the current configuration of broadcast-storm on a port, use:

no fault-finder broadcast-storm [ethernet] <PORT-LIST>
    

Configuration example 1

switch(config)# fault-finder broadcast-storm [ethernet] <AI> action [warn-and-disable <65535>]<percent 10>

Configuration example 2

switch(config)# fault-finder broadcast-storm [ethernet] <A2> action [warn-and-disable] pps <100>

Configuration example 3

switch(config)# fault-finder broadcast-storm [ethernet] <A22> action [warn] pps <100>

Viewing broadcast-storm configuration
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show fault-finder broadcast-storm
Syntax
show fault-finder broadcast-storm [ethernet <PORT-LIST>]
      
Description

Display the broadcast-storm-control configuration.

Parameters

broadcast-storm

Configure broadcast storm control.

pps

Rising threshold level in number of broadcast packets per second.

Percent

Rising threshold level as a percentage of bandwidth of the port. The percentage is calculated on 64 byte
packet size.

warn

Log the event only.

warn-and-disable

Log the event and disable the port.

seconds

Re-enable the port after waiting for the specified number of seconds. Default is not to re-enable.

show example 1
Port

A1

Bcast storm

Yes

Port status

Down

Rising threshold

10%

Action

warnanddisable

Disable timer

65535

Disable timer left

—

Show example 2
switch(config)# show fault-finder broadcast-storm
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Port

A1

Bcast storm

Yes

Port status

Down

Rising threshold

200 pps

Action

warnanddisable

Disable timer

10

Disable timer left

9

Show example 3
switch(config)# show fault-finder broadcast-storm A1
Port

A1

Bcast storm

No

Port status

Up

Rising threshold

—

Action

none

Disable timer

—

Disable timer left

—

Show example 4
switch(config)# show fault-finder broadcast-storm
Port

A1
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Bcast storm

Yes

Port status

Up

Rising threshold

75%

Action

warn

Disable timer

—

Disable timer left

—

Broadcast-storm event logs
Depending on the configuration of broadcast storm control, several of the following messages can be logged:

• FFI: port <ID>-Administrator action required to re-enable.

• FFI: port <ID>-Excessive Broadcasts. Broadcast-storm control threshold <configured value> percent
exceeded.

• FFI: port <ID>-Excessive Broadcasts. Broadcast-storm control threshold <configured value>pps exceeded.

• FFI: port <ID>-Port disabled by Fault-finder.

• ports:Fault-Finder(<FF ID>) has disabled port A1 for 100 Seconds.

The following messages can be logged after the port is enabled:

• ports: port <ID> timer (<FF ID>) has expired.

• ports: port <ID> is now on-line.

Event log

l 01/01/90 00:35:20 00025 ip: DEFAULT_VLAN: ip address 10.100.38.231/24 configured on vlan 1
l 01/01/90 00:35:20 00083 dhcp: updating IP address and subnet mask
l 01/01/90 00:35:05 00076 ports: port A1 is now on-line
l 01/01/90 00:35:02 00900 ports: port A1 timer (71) has expired
W 01/01/90 00:34:13 00026 ip: DEFAULT_VLAN: ip address 10.100.38.231/24 removed from vlan 1
l 01/01/90 00:34:12 00077 ports: port A1 is now off-line
l 01/01/90 00:34:12 00898 ports:Fault-Finder(71) has disabled port A1 for 5seconds
M 01/01/90 00:34:12 02673 FFI: port A1-Port disabled by Fault-finder.
W 01/01/90 00:34:12 02676 FFI: port A1-Excessive Broadcasts. Broadcast-storm control threshold 4 percent exceeded.
---- Reverse event Log listing: Events Since Boot ----
I 01/01/90 00:08:44 00025 ip: DEFAULT_VLAN: ip address 10.100.38.231/24 configured on vlan 1
I 01/01/90 00:08:44 00083 dhcp: updating IP address and subnet mask
I 01/01/90 00:08:11 00076 ports: port A1 is now on-line
I 01/01/90 00:08:08 00900 ports: port A1 timer (71) has expired
W 01/01/90 00:06:29 00026 ip: DEFAULT_VLAN: ip address 10.100.38.231/24 removed from vlan 1
I 01/01/90 00:06:28 00077 ports: port A1 is now off-line
I 01/01/90 00:06:28 00898 ports:Fault-Finder(71) has disabled port A1 for 100 seconds
M 01/01/90 00:06:28 02673 FFI: port A1-Port disabled by Fault-finder.
W 01/01/90 00:06:28 02675 FFI: port A1-Excessive Broadcasts. Broadcast-storm control threshold 10 pps exceeded.
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Multicast Storm Control
Overview
A multicast storm arises when excessive multicast traffic is exchanged on network ports. Excessive traffic
includes more than expected traffic, or which exceeds a limit value or some percentage of network traffic, or a
percentage of network channel capacity.

To prevent this, a warning message, along with port-shutdown option, is displayed to the user when the network
detects similar multicast packets. At this time, the user can disable the port temporarily and enable it again, or
permanently disable it.

fault-finder multicast-storm
Syntax
fault-finder multicast-storm <PORT-LIST> action {warn | warn-and-disable <Seconds>} {percent <Percent> | pps <Rate>}
no fault-finder multicast-storm <PORT-LIST> action {warn | warn-and-disable <Seconds>} {percent <Percent> | pps <Rate>}

Description

Per-port command to configure multicast-storm. The no form of the command disables multicast-storm
configuration on the port.

Parameters

PORT-LIST

Enable multicast storm control on a list of ports.

Seconds

Configure the number of seconds for which the port remains disabled.

Percent

Rising threshold level as a percentage of bandwidth of the port. The percentage is calculated on 64 byte
packet size.

Rate

Rising threshold level in number of multicast packets per second

Command context
config

Examples

switch(config)# fault-finder multicast-storm
action                Configure the action taken when a fault is detected.
[ethernet] PORT-LIST  The ports on which to enable Multicast Storm Control.
sensitivity           Configure the fault sensitivity level.

switch(config)# fault-finder multicast-storm ethernet
PORT-LIST             Enter a port number, a list of ports or 'all' for all
                      ports.

switch(config)# fault-finder multicast-storm ethernet 1/1
action                Configure the action taken when a multicast storm is
                      detected.
                                                                                   
switch(config)# fault-finder multicast-storm ethernet 1/1 action
warn                  Log an event only.
warn-and-disable      Log an event and disable the port.
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switch(config)# fault-finder multicast-storm ethernet 1/1 action warn-and-disable

SECONDS               Configure the number of seconds for which the port
                      remains disabled. A value of 0 means that the port will
                      remain disabled until manually re-enabled.

switch(config)# fault-finder multicast-storm ethernet 1/1 action warn-and-disable 10

percent               Configure the number of inbound multicast packets per
                      second that is considered a multicast storm. This
                      threshold is computed assuming a size of 64 bytes per
                      incoming multicast packet.
pps                   Configure the number of inbound multicast packets per
                      second that is considered a multicast storm.

switch(config)# fault-finder multicast-storm ethernet 1/1 action warn-and-disable 10 percent

<1-100>               The percentage that is considered a multicast storm.

switch(config)# fault-finder multicast-storm ethernet 1/1 action warn-and-disable 10 percent 40

Per port show fault-finder output:

switch(config)# show fault-finder multicast-storm 1/1

        Mcast | Port   Rising                     Disable    Disable Time
  Port  Storm | Status Threshold Action           Timer      Left
  ----- ----- + ------ --------- ---------------- ---------- ------------
  1/1   Yes   | Down   40%       warn-and-disable 10          -

switch(config)# show fault-finder multicast-storm

        Mcast | Port   Rising                     Disable    Disable Time
  Port  Storm | Status Threshold Action           Timer      Left
  ----- ----- + ------ --------- ---------------- ---------- ------------
  1/1   Yes   | Down   40%       warn-and-disable 10          -
  1/2   Yes   | Down   50%       warn-and-disable 10          -
  1/3   Yes   | Down   50%       warn-and-disable 10          -
  1/4   Yes   | Down   50%       warn-and-disable 10          -
  1/5   Yes   | Down   50%       warn-and-disable 10          -
  1/6   Yes   | Down   50%       warn-and-disable 10          -
  1/7   Yes   | Down   50%       warn-and-disable 10          -
  1/8   Yes   | Down   50%       warn-and-disable 10          -
  1/9   Yes   | Down   50%       warn-and-disable 10          -
  1/10  Yes   | Down   50%       warn-and-disable 10          -
  1/11  Yes   | Down   50%       warn-and-disable 10          -
  1/12  Yes   | Down   50%       warn-and-disable 10          -
Configure ports 1/1 to 1/5 for multicast storm control, and warn and disable the ports after 100 seconds, with a
rising threshold of 20%:

switch(config)# fault-finder multicast-storm ethernet 1/1-1/5 action
warn-and-disable 100 percent 20

switch(config)# show fault-finder multicast-storm ethernet 1/1-1/5

        Mcast | Port   Rising                      Disable    Disable Time
  Port  Storm | Status Threshold Action            Timer      Left
  ----- ----- + ------ --------- ----------------  ---------- ------------
  1/1   Yes   | Down   20%       warn-and-disable  100         -
  1/2   Yes   | Down   20%       warn-and-disable  100         -
  1/3   Yes   | Down   20%       warn-and-disable  100         -
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  1/4   Yes   | Down   20%       warn-and-disable  100         -
  1/5   Yes   | Down   20%       warn-and-disable  100         -
Disable multicast storm control on port 1/1:

switch(config)# no fault-finder multicast-storm ethernet 1/1
switch(config)# show fault-finder multicast-storm ethernet 1/1

        Mcast | Port   Rising                     Disable    Disable Time
  Port  Storm | Status Threshold Action           Timer      Left
  ----- ----- + ------ --------- ---------------- ---------- ------------
  1/1   No    | Down      -       none              -          -

fault-finder multicast-storm action
Syntax
fault-finder multicast-storm [action {warn | warn-and-disable}] [sensitivity {low | medium |high}]
no fault-finder multicast-storm [action {warn | warn-and-disable}] [sensitivity {low | medium |high}]

Description

Global command to configure multicast-storm. The no form of the command disables multicast-storm
configuration on the port. The default sensitivity is medium and the default action is warn.

Parameters

warn

Log an event only

warn-and-disable

Log an event and disable the port

low

Low sensitivity

medium

Medium sensitivity

high

High sensitivity

Command context
config

Examples

switch(config)# fault-finder multicast-storm action warn
sensitivity     Configure the fault sensitivity level.

switch(config)# fault-finder multicast-storm action warn sensitivity
low             Low sensitivity.
medium          Medium sensitivity.
high            High sensitivity.

switch(config)# fault-finder multicast-storm action warn-and-disable
sensitivity     Configure the fault sensitivity level.

switch(config)# fault-finder multicast-storm action warn-and-disable sensitivity
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low             Low sensitivity.
medium          Medium sensitivity.
high            High sensitivity.

switch(config)# fault-finder multicast-storm action warn-and-disable sensitivity high 
Global show command for auto-100 duplex Smart Rate port:

switch(config)# show fault-finder

Fault Finder

Fault ID              Sensitivity  Action
-------------------   -----------  ----------------
bad-driver            medium       warn
bad-transceiver       medium       warn
bad-cable             medium       warn
too-long-cable        medium       warn
over-bandwidth        medium       warn
broadcast-storm       medium       warn
loss-of-link          medium       warn
duplex-mismatch-hdx   medium       warn
duplex-mismatch-fdx   medium       warn
multicast-storm       high         warn-and-disable
link-flap             medium       warn

show running-config

Syntax
show running-config

Description

Displays information about the current configuration.

Command context

Manager

Example

switch(config)# show running-config

Running configuration:

; hpStack_WC Configuration Editor; Created on release #WC.16.06.0000x
; Ver #13:03.f8.1c.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:49

stacking
   member 1 type "JL320A" mac-address 941882-dccf00
   member 1 flexible-module A type JL081A
   exit
hostname "switch"
fault-finder multicast-storm sensitivity high action warn-and-disable
fault-finder multicast-storm 1/1 action warn-and-disable 100 percent 20
fault-finder multicast-storm 1/2 action warn-and-disable 100 percent 20
fault-finder multicast-storm 1/3 action warn-and-disable 100 percent 20
fault-finder multicast-storm 1/4 action warn-and-disable 100 percent 20
fault-finder multicast-storm 1/5 action warn-and-disable 100 percent 20
fault-finder multicast-storm 1/7 action warn-and-disable 10 pps 100
fault-finder multicast-storm 1/8 action warn-and-disable 10 percent 20
fault-finder multicast-storm 1/9 action warn-and-disable 10 percent 20
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snmp-server community "public" unrestricted
oobm
   ip address dhcp-bootp
   member 1
      ip address dhcp-bootp
      exit

show logging
Syntax
show logging

Description

Checks the FFI multicast-storm logging message.

Command context

Manager

Example

switch# show logging
Keys:   W=Warning   I=Information
        M=Major     D=Debug E=Error

----  Event Log listing: Events Since Boot  ----
I 01/07/90 20:22:55 00076 ports: port 3 is now on-line
M 01/07/90 20:22:52 02677 FFI: port 3-Port enabled by Fault-finder.
I 01/07/90 20:22:33 00077 ports: port 3 is now off-line
M 01/07/90 20:22:33 02676 FFI: port 3-Re-enable after 20 seconds.
M 01/07/90 20:22:33 02673 FFI: port 3-Port disabled by Fault-finder.
M 01/07/90 20:22:33 02675 FFI: port 3-Excessive Multicast-storm control threshold 10 % exceeded.

Restrictions
Multicast storm control is not supported in the following scenarios:

• Unicast packet traffic

• If the port is configured as a VSF port

• If the port is configured as a trunk port
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PoE
PoE technology allows IP telephones, wireless LAN access points, and other appliances to receive power and
transfer data over existing ethernet LAN cabling. For more information about PoE technology, see the PoE
planning and implementation guide, which is available on the Networking website at

http://www.hpe.com/networking/support.

PoE terminology
Power-over-ethernet (PoE) and Power-over-ethernet plus (PoE+ or POEP) operate similarly in most cases. The
CLI commands are the same for a PoE module or a PoE+ zl module. Any differences between PoE and PoE+
operation are noted; otherwise, the term "PoE" is used to designate both PoE and PoE+ functionality.

Planning and implementing a PoE configuration
This section provides an overview of some considerations for planning a PoE application. For additional
information on this topic, refer to the PoE planning and implementation guide which is available on the Networking
web site at http://www.hpe.com/networking/support.

Some of the elements you may want to consider for a PoE installation include:

• Port assignments to VLANs

• Use of security features

• Power requirements

This section can help you to plan your PoE installation. If you use multiple VLANs in your network, or if you have
concerns about network security, you should read the first two topics. If your PoE installation comes close to (or is
likely to exceed) the system’s ability to supply power to all devices that may request it, then you should also read
the third topic. (If it is unlikely that your installation will even approach a full utilization of the PoE power available,
then you may find it unnecessary to spend much time on calculating PoE power scenarios.)

Power requirements
To get the best PoE performance, you should provide enough PoE power to exceed the maximum amount of
power that is needed by all the PDs that are being used.

By connecting an external power supply you can optionally provision more PoE wattage per port and or supply
the switch with redundant 12V power to operate should an internal power supply fail.

By installing a second power supply in the 5406zl or a third power supply in a 5412zl chassis, depending on how
many PoE ports are being supplied with power, the switch can have redundant power if one power supply fails. A
Power Supply Shelf (external power supply) can also be connected to the 5400zl switches to provide extra or
redundant PoE power.

For example, if the 5406zl has two 24-port PoE modules (J8702A) installed, and all ports are using 15.4 watts,
then the total wattage used is 739.2 watts (48 x 15.4.) To supply the necessary PoE wattage a J8713A power
supply is installed in one of the power supply slots.

To gain redundant power, a second J8713A must be installed in the second power supply slot. If the first power
supply fails, then the second power supply can supply all necessary power.

Chapter 6
Power over ethernet (PoE/PoE+) operation
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See the PoE planning and implementation guide for detailed information about the PoE/PoE+ power
requirements.

Assigning PoE ports to VLANs
If your network includes VLANs, you may want to assign various PoE-configured ports to specific VLANs. For
example, if you are using PoE telephones in your network, you may want to assign ports used for telephone
access to a VLAN reserved for telephone traffic.

Applying security features to PoE configurations
You can utilize security features built into the switch to control device or user access to the network through PoE
ports in the same way as non-PoE ports.

Using Port Security, you can configure each switch port with a unique list of MAC addresses for devices that are
authorized to access the network through that port. For more information, see the Access security guide for your
switch.

Assigning priority policies to PoE traffic
You can use the configurable QoS (Quality of Service) features in the switch to create prioritization policies for
traffic moving through PoE ports.

Table 5: Classifiers for prioritizing outbound packets

Priority QoS classifier

1 UDP/TCP application type (port)

2 Device priority (destination or source IP address)

3 IP type of service (ToS) field (IP packets only)

4 VLAN priority

5 Incoming source-port on the switch

6 Incoming 802.1 priority (present in tagged VLAN environments)

For more on this topic, see the advanced traffic management guide.

PoE operation
Using the commands described in this chapter, you can:

• Enable or disable PoE operation on individual ports.

• Monitor PoE status and performance per module.

• Configure a non-default power threshold for SNMP and Event Log reporting of PoE consumption on either all
PoE ports on the switch or on all PoE ports in one or more PoE modules.

• Specify the port priority you want to use for provisioning PoE power in the event that the PoE resources
become oversubscribed.

Power-sourcing equipment (PSE) detects the power needed by a powered device (PD) before supplying that
power, a detection phase referred to as "searching." If the PSE cannot supply the required amount of power, it
does not supply any power. For PoE using a Type 1 device, a PSE will not supply any power to a PD unless the
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PSE has at least 17 watts available. For example, if a PSE has a maximum available power of 382 watts and is
already supplying 378 watts, and is then connected to a PD requiring 10 watts, the PSE will not supply power to
the PD.

For PoE+ using Type 2 devices, the PSE must have at least 33 watts available. A slot in a zl chassis can provide
a maximum of 370 watts of PoE/PoE+ power to a module.

PoE configuration options
In the default configuration, PoE support is enabled on the ports in a PoE module installed on the switch. The
default priority for all ports is low and the default power notification threshold is 80%. Using the CLI, you can:

• Disable or re-enable PoE operation on individual PoE ports

• Enable support for pre-standard devices

• Change the PoE priority level on individual PoE ports

• Change the threshold for generating a power level notice

• Manually allocate the amount of PoE power for a port by usage, value, or class

• Allocate PoE power based on the link-partner’s capabilities via LLDP

The ports support standard networking links and PoE links. You can connect either a non-PoE device or a PD to a
port enabled for PoE without reconfiguring the port.

PD support
To best utilize the allocated PoE power, spread your connected PoE devices as evenly as possible across
modules. Depending on the amount of power delivered to a PoE module, there may or may not always be enough
power available to connect and support PoE operation on all ports in the module. When a new PD connects to a
PoE module and the module does not have enough power left for that port, if the new PD connects to a port "X"
that has a:
Higher

PoE priority than another port "Y" that is already supporting another PD, the power is removed from port "Y"
and delivered to port "X." In this case the PD on port "Y" loses power and the PD on port "X" receives power.

Lower

priority than all other PoE ports currently providing power to PDs, power is not supplied to port "X" until one or
more PDs using higher priority ports are removed.

In the default configuration (usage), when a PD connects to a PoE port and begins operating, the port retains only
enough PoE power to support the PD's operation. Unused power becomes available for supporting other PD
connections. However, if you configure the poe-allocate-by option to either value or class, all of the power
configured is allocated to the port.

For PoE (not PoE+), while 17 watts must be available for a PoE module on the switch to begin supplying power to
a port with a PD connected, 17 watts per port is not continually required if the connected PD requires less power.
For example, with 20 watts of PoE power remaining available on a module, you can connect one new PD without
losing power to any connected PDs on that module. If that PD draws only 3 watts, 17 watts remain available, and
you can connect at least one more PD to that module without interrupting power to any other PoE devices
connected to the same module. If the next PD you connect draws 5 watts, only 12 watts remain unused. With only
12 unused watts available, if you then connect yet another PD to a higher-priority PoE port, the lowest-priority port
on the module loses PoE power and remains unpowered until the module once again has 17 or more watts
available.

For PoE+, there must be 33 watts available for the module to begin supplying power to a port with a PD
connected. A slot in a zl chassis can provide a maximum of 370 watts of PoE/PoE+ power to a module.
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Disconnecting a PD from a PoE port makes that power available to any other PoE ports with PDs waiting for
power. If the PD demand for power becomes greater than the PoE power available, power is transferred from the
lower-priority ports to the higher-priority ports. (Ports not currently providing power to PDs are not affected.)

PoE power priority
If a PSE can provide power for all connected PD demand, it does not use its power priority settings to allocate
power. However, if the PD power demand oversubscribes the available power, the power allocation is prioritized
to the ports that present a PD power demand. This causes the loss of power from one or more lower-priority ports
to meet the power demand on other, higher-priority ports. This operation occurs regardless of the order in which
PDs connect to the module's PoE-enabled ports.

Power allocation is prioritized according to the following methods:
Priority class

Assigns a power priority of low (the default), high, or criticalto each enabled PoE port.

Port-number priority

A lower-numbered port has priority over a higher-numbered port within the same configured priority class, for
example, port A1 has priority over port A5 if both are configured with high priority.

Assigning PoE priority with two or more modules
Ports across two or more modules can be assigned a class priority of low (the default), high, or critical. For
example, A5, B7, and C10 could all be assigned a priority class of Critical. When power is allocated to the ports
on a priority basis, the Critical priority power requests are allocated to module A first, then Module B, then C, and
so on. Next, the High priority power requests are allocated, starting with module A, then B, then C, and the
remaining modules in order. Any remaining power is allocated in the same manner for the Low priority ports,
beginning with module A though the remaining modules. If there is not enough PoE power for all the PDs
connected to PoE modules in the switch, power is allocated according to priority class across modules.

All ports on module C are prioritized as Critical.

switch# interface c1-c24 power-over-ethernet
    critical

All ports on module A are prioritized as Low.

switch# interface a1-a24 power-over-ethernet
    low
There are 48 PDs attached to all ports of modules A and C (24 ports each module); however, there is enough
PoE power for only 32 ports (8.5 watts × 32 ports=273 watts.) The result is that all the Critical priority ports on
module C receive power, but only 8 ports on module A receive power.

On module A, the port A1 has the highest priority of the ports in that module if all ports are in the same priority
class, which is the case for this example. Since a minimum 17 + 5 watts of power is allocated per PoE module for
PoE, port A1 will always receive PoE power. If another port on module A had a higher priority class than port A1,
that port would be allocated the power before port A1.

For PoE+ modules there must be a minimum of 33 + 5 watts of power allocated per PoE+ module.

About configuring PoE
In the default configuration,PoE support is enabled on the ports in a PoE module installed on the switch. The
default priority for all ports is low and the default power notification threshold is 80%.
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Using the CLI, you can:

• Disable or re-enable PoE operation on individual PoE ports.

• Enable support for pre-standard devices.

• Change PoE priority level on individual PoE ports.

• Change the threshold for generating a power level notice.

• Manually allocate the amount of PoE power for a port by usage, value, or class.

• Allocate PoE power based on the link-partner's capabilities via LLDP.

For a given level, ports are prioritized by port number in ascending order. For example, if ports A1 to A24 have a
priority level of critical, port A1 has priority over ports A2 to A24.

If there is not enough power available to provision all active PoE ports at a given priority level, the lowest-
numbered port at that level is provisioned first. For chassis switches, the lowest-numbered port at that level
starting with module A, then B, C, and so on is provisioned. PoE priorities are invoked only when all active PoE
ports cannot be provisioned (supplied with PoE power.)

In chassis switches, you can use one command to set the same priority level on PoE ports in multiple modules.
For example, to configure the priority to High for ports c5 to c10, C23 to C24, D1 to D10, and D12, you could use
this command:

switch# interface c5-c10,c23-c24,d1-d10,d12 power-over-ethernet high
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PoE priority example

Table 6: PoE priority operation on a PoE module

Port Priority setting Configuration command and resulting operation with PDs connected to
ports C3 through C24

C3 - C17 Critical In this example, the following CLI command sets ports C3 to C17 to Critical:

switch# interface c3-c17 power-over-ethernet
    critical
The critical priority class always receives power. If there is not enough power to
provision PDs on all ports configured for this class, no power goes to ports
configured for high and low priority. If there is enough power to provision PDs on
only some of the critical-priority ports, power is allocated to these ports in
ascending order, beginning with the lowest-numbered port in the class, which, in
this case, is port 3.

C18 - C21 high In this example, the following CLI command sets ports C19 to C22 to high:

switch# interface c19-c22 power-over-ethernet high
The high priority class receives power only if all PDs on ports with a critical
priority setting are receiving power. If there is not enough power to provision PDs
on all ports with a high priority, no power goes to ports with a low priority. If there
is enough power to provision PDs on only some of the high-priority ports, power
is allocated to these ports in ascending order, beginning, in this example, with
port 18, until all available power is in use.

C22 - C24 low In this example, the CLI command sets ports C23 to C24 to low1:

switch# interface c23-c24 power-over-ethernet low
This priority class receives power only if all PDs on ports with high and critical
priority settings are receiving power. If there is enough power to provision PDs
on only some low- priority ports, power is allocated to the ports in ascending
order, beginning with the lowest-numbered port in the class (port 22, in this
case), until all available power is in use.

C1 - C2 N/A In this example, the CLI command disables PoE power on ports C1 to C2:

switch# no interface c1-c2 power-over-ethernet
There is no priority setting for the ports in this example.

1 In the default PoE configuration, the ports are already set to low priority. In this case, the command is not necessary.

Disabling or re-enabling PoE port operation
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interface
Syntax
interface <PORT-LIST> power-over-ethernet
      
Description

Re-enables PoE operation on <PORT-LIST> and restores the priority setting in effect when PoE was disabled on
<PORT-LIST>.

Default: All PoE ports are initially enabled for PoE operation at Low priority. If you configure a higher priority, this
priority is retained until you change it.

For PoE, disabling all ports allows the 22 watts of minimum PoE power or the 38 watts for PoE+ power allocated
for the module to be recovered and used elsewhere. You must disable ALL ports for this to occur.

Options

no

The no form of the command disables PoE operation on <PORT-LIST>

<PORT-LIST>

—

Enabling support for pre-standard devices

power-over-ethernet
Syntax
power-over-ethernet pre-std-detect
Description

Detects and powers pre-802.3af standard devices. The switches covered in this guide also support some
pre-802.3af devices. The default setting for the pre-std-detect PoE parameter has changed. In earlier
software, the default setting is "on." In K.15.02 and later software, the default setting is "off."

Options
no

—

Configuring the PoE port priority

interface
Syntax
interface <PORT-LIST> power-over-ethernet [critical|high|low]
    
Description

Reconfigures the PoE priority level on <PORT-LIST>. For a given level, ports

Parameters
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critical

Specifies the highest-priority PoE support for <PORT-LIST>. The active PoE ports at this level are provisioned
before the PoE ports at any other level are provisioned.

high

Specifies the second priority PoE support for <PORT-LIST>. The active PoE ports at this level are provisioned
before the Low priority PoE ports are provisioned.

low

(Default) Specifies the third priority PoE support for <PORT-LIST>. The active PoE ports at this level are
provisioned only if there is power available after provisioning any active PoE ports at the higher priority levels.

Controlling PoE allocation

int
Syntax
int <PORT-LIST> poe-allocate-by [usage|class|value]
    
Description

Allows you to manually allocate the amount of PoE power for a port by either its class or a defined value.

The default option for PoE allocation is usage, which is what a PD attached to the port is allocated. You can
override this value by specifying the amount of power allocated to a port by using the class or value options.

Parameters
no
usage

(Default) The automatic allocation by a PD. The allowable PD requirements are lower than those specified for
PSEs to allow for power losses along the Cat-5 cable.

class
Uses the power ramp-up signature of the PD to identify the device power class.

value
A user-defined level of PoE power allocated for that port.

Table 7: Power classes and their values

Power class Value

0 Depends on cable type and PoE architecture. Maximum power level output of 15.4 watts at the
PSE.This is the default class; if there is not enough information about the load for a specific
classification, the PSE classifies the load as class 0 (zero.)

1 Requires at least 4 watts at the PSE.

2 Requires at least 7 watts at the PSE.

3 15.4 watts

4 For PoE+Maximum power level output of 30 watts at the PSE.
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PoE port allocation by class

To allocate by class for ports 6 to 8:

switch# int 6-8 PoE-allocate-by class

Manually configuring PoE power levels
You can specify a power level (in watts) allocated for a port by using the value option. This is the maximum
amount of power that will be delivered.

Procedure

1. To configure a port by value, first set the PoE allocation by entering the poe-allocate-by value
command:

switch(config) # int A6 poe-allocate-by value
or in interface context:

switch(eth-A6) # poe-allocate-by value
2. Then select a value:

switch(config) # int A6 poe-value 15
or in interface context:

switch(eth-A6) # poe-value 15
3. To view the settings, enter the show power-over-ethernet command, shown below.

Figure 17: Displaying PoE allocation by value and the maximum power delivered
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Detection status: fault

Symptom

A fault occurs, as shown in Figure Figure 18: Showing PoE power value set too low for the PD on page 160.

Figure 18: Showing PoE power value set too low for the PD

Cause

Setting the PoE maximum value to less than what the PD requires.

Action

Increase the PoE maximum value.

Configuring PoE redundancy (chassis switches only)
PoE redundancy occurs automatically when enabled. The switch keeps track of power use and does not supply
PoE power to additional PoE devices trying to connect if that results in the switch not having enough power in
reserve for redundancy.

power-over-ethernet redundancy
Syntax
power-over-ethernet rdundancy [n+1|full]
Description

Allows you to set the amount of power held in reserve for redundancy.

Parameters
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no Means that all available power can be allocated to PDs.

Default: No PoE redundancy enforced.

n+1 One of the power supplies is held in reserve for redundancy. If a single power
supply fails, no powered devices are shut down.

If power supplies with different ratings are used, the highest-rated power supply is
held in reserve to ensure full redundancy.

full Half of the available power supply is held in reserve for redundancy. If power
supplies with different ratings are used, the highest-rated power supply is held in
reserve to ensure full redundancy.

Changing the threshold for generating a power notice

power-over-ethernet slot
Syntax
power-over-ethernet [slot <SLOT-ID-RANGE> <threshold 1 - 99>]
      
Description

This command configures the notification threshold for PoE power usage on either a global or per-module (slot)
basis.

Parameters and options

slot <SLOT-ID-RANGE>

Specifies the PoE usage level (as a percentage of the PoE power available on a module) at which the switch
generates a power usage notice. This notice appears as an SNMP trap and a corresponding Event Log
message and occurs when a PoE module's power consumption crosses the configured threshold value. That
is, the switch generates a notice whenever the power consumption on a module either exceeds or drops
below the specified percentage of the total PoE power available on the module.

Without the slot PoE <SLOT-ID-RANGE> option, the switch applies one power threshold setting on all
PoE modules installed in the switch.

<THRESHOLD 1–99>

—

Enabling or disabling ports for allocating power using
LLDP

int poe-lldp-detect
Syntax
int <PORT-LIST> poe-lldp-detect [enabled|disabled]
      
Description

Enables or disables ports for allocating PoE power based on the link-partner's capabilities via LLDP.

Default: Enabled
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Enable LLDP detection

switch(config) # int A7 poe-lldp-detect enabled

Interface context

switch(eth-A7) # poe-lldp-detect enabled

Enabling PoE detection via LLDP TLV advertisement

lldp config
Syntax
lldp config <port-number>
    
Description

Configure the lldp for the desired port by number.

Parameter
basicTlvEnable

Enables the basic advertised TLV for each port by number.

Options

<management_addr>

Use the option <management_addr> to specify specific devices to enable TLV advertisement.

Usage
lldp config <port_num> basicTlvEnable <management_addr>

Negotiating power using the DLL
When a PD requests power on a PoE port, LLDP interacts with PoE to see if there is enough power to fulfill the
request. Power is set at the level requested. If the PD goes into power-saving mode, the power supplied is
reduced; if the need for power increases, the amount supplied increases. PoE and LLDP interact to meet the
current power demands.

int poe-lldp-detect
Syntax
int <PORT-LIST> poe-lldp-detect [enabled|disabled]
    
Description

Allows the data link layer to be used for power negotiation between a PD on a PoE port and LLDP.

Default: Disabled
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Enable LLDP

switch(config) # int 7 PoE-lldp-detect enabled

Interface context

switch(eth-7) # PoE-lldp-detect enabled

NOTE: Detecting PoE information via LLDP affects only power delivery; it does not affect normal
Ethernet connectivity.

Port with LLDP configuration information obtained from the device

switch(config)# show power-over-ethernet brief
Status and Counters - Port Power Status
System Power Status    : No redundancy
PoE Power Status       : No redundancy

Available: 273 W  Used: 0 W Remaining: 273 W

Module A Power
Available: 273 W  Used: 0 W Remaining: 273 W

PoE   | Power  Power     Alloc Alloc  Actual Configured Detection  Power
Port  | Enable Priority  By    Power  Power  Type       Status     Class
------  ------ --------- ----- ----- ------ ----------- ----------- ---
Pre-std
Detect
------
A1     | Yes    low      usage  17 W  0.0 W            Searching   0
off
A2     | Yes    low      usage  17 W  0.0 W            Searching   0
off
A3     | Yes    critical usage  17 W  0.0 W            Searching   0
off
A4     | Yes    critical usage  17 W  0.0 W            Searching   0
off
A5     | Yes    critical usage  17 W  0.0 W            Searching   0
off
A6     | Yes    high     usage  17 W  0.0 W            Searching   0
off
A7     | Yes    high     usage  17 W  0.0 W            Searching   0
off
A8     | Yes    high     usage  17 W  0.0 W            Searching   0
off
A9     | Yes    low      usage  17 W  0.0 W            Searching   0
off
A10    | Yes    low      usage  17 W  0.0 W            Searching   0
off
A11    | Yes    low      usage  17 W  0.0 W            Searching   0
off
A12    | Yes    low      usage  17 W  0.0 W            Searching   0
off
A13    | Yes    low      usage  17 W  0.0 W            Searching   0
off
A14    | Yes    low      usage  17 W  0.0 W            Searching   0
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off
A15    | Yes    low      usage  17 W  0.0 W            Searching   0
off
A16    | Yes    low      usage  17 W  0.0 W            Searching   0
Figure 19: Port with LLDP configuration

Initiating advertisement of PoE+ TLVs

lldp config
Syntax
lldp config <PORT-LIST>lldp config dot3TlvEnable poe_config
      
Description

Enables advertisement of data link layer power using PoE+ TLVs.The TLV is processed only after the physical
layer and the data link layer are enabled. The TLV informs the PSE about the actual power required by the device.

Default: Enabled

Temporary PoE+ power drop

Symptom

A temporary PoE+ power drop occurs.

Cause

If LLDP is disabled at runtime, and a PD is using PoE+ power that has been negotiated through LLDP, there is a
temporary power drop; the port begins using PoE+ power through the PLC. This event is recorded in the Event
Log.When LLDP is enabled again, it causes a temporary power drop. This event is also recorded in the Event
Log.

Sample event log messages:

W 08/04/10 13:35:50 02768 ports: Port A1 PoE power dropped.
Exceeded physical classification for a PoE Type1 device (LLDP process disabled)
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W 08/04/10 13:36:31 02771 ports: Port A1 PoE power dropped.
Exceeded physical classification due to change in classification type (LLDP process enabled)

Viewing PoE when using LLDP information

show lldp config
Syntax
show lldp config <PORT-LIST>
      
Description

Displays the LLDP port configuration information, including the TLVs advertised.
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LLDP port configuration information with PoE

Figure Figure 21: Local power information on page 166 shows an example of the local device power
information using the show lldp info local-device <PORT-LIST> command.

Figure 20: LLDP port configuration information with PoE

Figure 21: Local power information
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Figure Figure 22: Remote power information on page 167 shows an example of the remote device power
information using the show lldp info remote-device <PORT-LIST> command.

Figure 22: Remote power information

Viewing the global PoE power status of the switch

show power-over-ethernet
Syntax
show power-over-ethernet [brief] [ethernet <PORT-LIST>] [slot <SLOT-ID-RANGE>]
Description

Displays the switch's global PoE power status, including:

• Total Available Power
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Lists the maximum PoE wattage available to provision active PoE ports on the switch. This is the amount of
usable power for PDs.

• Total Failover Power

Lists the amount of PoE power available in the event of a single power supply failure. This is the amount of
power the switch can maintain without dropping any PDs.

• Total Redundancy Power

Indicates the amount of PoE power held in reserve for redundancy in case of a power supply failure.

• Total Remaining Power

The amount of PoE power still available.

Parameters

brief

Displays PoE information for each port.

Options

<PORT-LIST>

Displays PoE information for the ports in PORT-LIST.

<SLOT-ID-RANGE>

Displays PoE information for the selected slots. Enter the all option to display the PoE information for all
slots.

Show power-over-ethernet

The command show power-over-ethernet displays data similar to that shown in Figure 23: show power-
over-ethernet command output on page 168.

Figure 23: show power-over-ethernet command output

Viewing PoE status on all ports
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show power-over-ethernet
Syntax
show power-over-ethernet brief
Description

Displays the port power status.

• PoE Port

Lists all PoE-capable ports on the switch.

• Power Enable

Shows Yes for ports enabled to support PoE (the default) and No for ports on which PoE is disabled.

• Power Priority

Lists the power priority (Low, High, and Critical) configured on ports enabled for PoE.

• Alloc by

Displays how PoE is allocated (usage, class, value)

• Alloc Power

The maximum amount of PoE power allocated for that port (expressed in watts.)Default: 17 watts for PoE; 33
watts for PoE+.

• Actual Power

The power actually being used on that port.

• Configured Type

If configured, shows the user-specified identifier for the port. If not configured, this field is empty.

• Detection Status:
◦ Searching: The port is trying to detect a PD connection.

◦ Delivering: The port is delivering power to a PD.

◦ Disabled: On the indicated port, either PoE support is disabled or PoE power is enabled but the PoE
module does not have enough power available to supply the port's power needs.

◦ Fault: The switch detects a problem with the connected PD.

◦ Other Fault: The switch has detected an internal fault that prevents it from supplying power on that port.

• Power Class Shows the 802.3af power class of the PD detected on the indicated port.

Table 8: Power Classes

Power class Description

0 0.44 to 12.95 watts can be drawn by the PD. Default class.

1 0.44 to 3.84 watts

2 3.84 to 6.49 watts

Table Continued
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Power class Description

3 6.49 to 12.95 watts

4 For PoE+; up to 25.5 watts can be drawn by the PD

Show power-over-ethernet brief

show power-over-ethernet brief displays this output:

Figure 24: show power-over-ethernet brief command output

You can also show the PoE information by slot:

Figure 25: Showing the PoE information by slot

Viewing the PoE status on specific ports

show power-over-ethernet
Syntax
show power-over-ethernet <PORT-LIST>
    
Description

Displays the following PoE status and statistics (since the last reboot) for each port in <PORT-LIST>:
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Power Enable Shows Yes for ports enabled to support PoE (the default) and No for ports on which
PoE is disabled. For ports on which power is disabled, this is the only field displayed
by show power-over-ethernet <PORT-LIST> .

Priority Lists the power priority (Low, High, and Critical) configured on ports enabled for PoE.

Allocate by How PoE is allocated (usage, class, value.)

Detection Status Searching

The port is available to support a PD.

Delivering

The port is delivering power to a PD.

Disabled

PoE power is enabled on the port but the PoE module does not have enough
power available to supply the port's power needs.

Fault

The switch detects a problem with the connected PD.

Other Fault

The switch has detected an internal fault that prevents it from supplying power on
that port.

Over Current Cnt Shows the number of times a connected PD has attempted to draw more than 15.4
watts for PoE or 24.5 watts for PoE+. Each occurrence generates an Event Log
message.

Power Denied Cnt Shows the number of times PDs requesting power on the port have been denied
because of insufficient power available. Each occurrence generates an Event Log
message.

Voltage The total voltage, in volts, being delivered to PDs.

Power The total power, in watts, being delivered to PDs.

LLDP Detect Port is enabled or disabled for allocating PoE power, based on the link-partner's
capabilities via LLDP.

Configured Type If configured, shows the user-specified identifier for the port. If not configured, the field
is empty.

Value The maximum amount of PoE power allocated for that port (expressed in watts.)
Default: 17 watts for PoE; 33 watts for PoE+

Table Continued
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Power Class Shows the power class of the PD detected on the indicated port. Classes include:
0

0.44 to 12.95 watts

1

0.44 to 3.84 watts

2

3.84 to 6.49 watts

3

6.49 to 12.95 watts

4

For PoE+; up to 25.5 watts can be drawn by the PD

MPS Absent Cnt Shows the number of times a detected PD has no longer requested power from the
port. Each occurrence generates an Event Log message. ("MPS" refers to the
"maintenance power signature.")

Short Cnt Shows the number of times the switch provided insufficient current to a connected
PD.

Current The total current, in mA, being delivered to PDs.

PoE status of ports

If you want to view the PoE status of ports A6 and A7, you would use show power-over-ethernet A6-A7 to
display the data:

Figure 26: show power-over-ethernet PORT-LIST output
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Configuring thresholds for generating a power notice
You can configure one of the following thresholds:

A global power threshold that applies to all modules on the switch.

This setting acts as a trigger for sending a notice when the PoE power consumption on any PoE module
installed in the switch crosses the configured global threshold level. (Crossing the threshold level in either
direction—PoE power usage either increasing or decreasing—triggers the notice.) The default setting is 80%.

A per-slot power threshold that applies to an individual PoE module installed in the designated slot.

This setting acts as a trigger for sending a notice when the module in the specified slot exceeds or goes
below a specific level of PoE power consumption.

setting global notification

Suppose slots A, B, and C each have a PoE module installed. In this case, executing the following command sets
the global notification threshold to 70% of available PoE power.

switch# power-over-ethernet threshold
       70
With this setting, if module B is allocated 100 watts of PoE power and is using 68 watts, and then another PD is
connected to the module in slot B that uses 8 watts, the 70% threshold of 70 watts is exceeded. The switch sends
an SNMP trap and generates this Event Log message:

Slot B POE usage has exceeded threshold of 70%.
If the switch is configured for debug logging, it also sends the Event Log message to the configured debug
destinations.

On any PoE module, if an increasing PoE power load (1) exceeds the configured power threshold—which triggers
the log message and SNMP trap—and then (2) later decreases and drops below the threshold again, the switch
generates another SNMP trap, plus a message to the Event Log and any configured Debug destinations.

PoE/PoE+ allocation using LLDP

LLDP with PoE
When using PoE, enabling poe-lldp-detect allows automatic power configuration if the link partner supports
PoE. When LLDP is enabled, the information about the power usage of the PD is available, and the switch can
then comply with or ignore this information. You can configure PoE on each port according to the PD (IP phone,
wireless device, and so on) specified in the LLDP field. The default configuration is for PoE information to be
ignored if detected through LLDP.

Detecting PoE information via LLDP affects only power delivery; it does not affect normal Ethernet connectivity.

LLDP with PoE+

PoE+ with LLDP Overview
The DLC for PoE provides more exact control over the power requirement between a PSE and PD. The DLC
works in conjunction with the PLC and is mandatory for any Type-2 PD that requires more than 12.95 watts of
input power.
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NOTE:

DLC is defined as part of the IEEE 802.3at standard.

You can implement the power negotiation between a PSE and a PD at the physical layer or at the data link layer.
After the link is powered at the physical layer, the PSE can use LLDP to query the PD repeatedly to discover the
power needs of the PD. Communication over the data link layer allows finer control of power allotment, which
makes it possible for the PSE to supply dynamically the power levels needed by the PD. Using LLDP is optional
for the PSE but mandatory for a Type 2 PD that requires more than 12.95 watts of power.

If the power needed by the PD is not available, that port is shut off.

PoE allocation
There are two ways LLDP negotiates power with a PD:

• Using LLDP MED TLVs

Disabled by default. Enable using the int <PORT-LIST> PoE-lldp-detect [enabled|disabled]
command, as shown below.

LLDP MED TLVs sent by the PD are used to negotiate power only if the LLDP PoE+ TLV is disabled or
inactive; if the LLDP PoE+ TLV is sent as well (not likely), the LLDP MED TLV is ignored.

• Using LLDP PoE+ TLVs

Enabled by default. The LLDP PoE+ TLV is always advertised unless it has been disabled (enable it by using
the lldp config <PORT-LIST> dot3TlvEnable poeplus_config command.)

It always takes precedence over the LLDP MED TLV.

Enabling PoE-lldp-detect allows the data link layer to be used for power negotiation. When a PD requests
power on a PoE port, LLDP interacts with PoE to see if there is enough power to fulfill the request. Power is set at
the level requested. If the PD goes into power-saving mode, the power supplied is reduced; if the need for power
increases, the amount supplied is increased. PoE and LLDP interact to meet the current power demands.

Operation note
The advertisement of power with TLVs for LLDP PoE+ is enabled by default. If LLDP is disabled at runtime and a
PD is using PoE+ power that has been negotiated through LLDP, there will be a temporary power drop. The port
will begin using PoE+ power through the PLC. This event is recorded in the event log. An example message
would look like the following:
W 08/04/10 13:35:50 02768 ports: Port A1 PoE power dropped. Exceeded physical classification for a PoE Type1 device (LLDP process disabled)

When LLDP is enabled again, it causes a temporary power drop. This event is also recorded in the event log. An
example message looks like the following:

W 08/04/10 13:36:31 02771 ports: Port A1 PoE power dropped. Exceeded physical 
classification due to change in classification type (LLDP process enabled)
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Port trunking overview
Port trunking allows you to assign up to eight physical links to one logical link (trunk) that functions as a single,
higher-speed link providing dramatically increased bandwidth. This capability applies to connections between
backbone devices as well as to connections in other network areas where traffic bottlenecks exist. A trunk group
is a set of up to eight ports configured as members of the same port trunk. The ports in a trunk group do not have
to be consecutive. For example:

Figure 27: Conceptual example of port trunking

Port trunk connections and configuration
All port trunk links must be point-to-point connections between a switch and another switch, router, server, or
workstation configured for port trunking. No intervening, non-trunking devices are allowed. It is important to note
that ports on both ends of a port trunk group must have the same mode (speed and duplex) and flow control
settings.

Link connections

The switch does not support port trunking through an intermediate, non-trunking device such as a hub, or
using more than onemedia type in a port trunk group. Similarly, for proper trunk operation, all links in the same
trunk group must have the same speed, duplex, and flow control.

Port security restriction

Port security does not operate on a trunk group. If you configure port security on one or more ports that are
later added to a trunk group, the switch resets the port security parameters for those ports to the factory-
default configuration.

IMPORTANT:

To avoid broadcast storms or loops in your network while configuring a trunk, first disable or
disconnect all ports you want to add to or remove from the trunk. After you finish configuring the
trunk, enable or re-connect the ports.

Chapter 7
Port trunking
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Viewing and configuring port trunk groups
You can list the trunk type and group for all ports on the switch or for selected ports. You can also list LACP-only
status information for LACP-configured ports.

IMPORTANT:

To avoid broadcast storms or loops in your network while configuring a trunk, first disable or
disconnect all ports you want to add to or remove from the trunk. After you finish configuring the
trunk, enable or re-connect the ports.

Viewing static trunk type and group for all ports or for selected ports

show trunks
Syntax
show trunks <PORT-LIST>
      
Description

Omitting the <PORT-LIST> parameter results in a static trunk data listing for all LAN ports in the switch.

Static trunk group

In a switch where ports A4 and A5 belong to Trunk 1 and ports A7 and A8 belong to Trunk 2, you have the
options shown in Figure 28: Listing specific ports belonging to static trunks on page 176 and Example of a
show trunk listing without specifying ports on page 177 for displaying port data for ports belonging to static
trunks.

Using a port list specifies, for switch ports in a static trunk group, only the ports you want to view. In this case, the
command specifies ports A5 through A7. However, because port A6 is not in a static trunk group, it does not
appear in the resulting listing:

Figure 28: Listing specific ports belonging to static trunks

The show trunks <PORT-LIST> command in the above example includes a port list, and thus shows trunk
group information only for specific ports that have membership in a static trunk. In Example of a show trunk
listing without specifying ports on page 177, the command does not include a port list, so the switch lists all
ports having static trunk membership.
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Example of a show trunk listing without specifying ports

switch# show trunks

 Load Balancing

 Port | Name                    Type      | Group Type
 ---- + ----------------------- --------- + ----- -----
 4    | Print-Server-Trunk      10/100TX  | Trk1  Trunk
 5    | Print-Server-Trunk      10/100TX  | Trk1  Trunk
 7    |                         10/100TX  | Trk2  Trunk
 8    |                         10/100TX  | Trk2  Trunk

Viewing static LACP and dynamic LACP trunk data

show lacp
Syntax
show lacp
Description

Lists data for only the LACP-configured ports.

Example of a show LACP listing

Ports A1 and A2 have been previously configured for a static LACP trunk.

switch# show lacp

       LACP     Trunk    Port     LACP     LACP     Admin  Oper
Port   Enabled  Group    Status   Partner  Status   Key    Key
----   -------  -------  -------  -------  -------  ------ ------ 
Al     Active   Trkl     Up       Yes      Success  0      250
A2     Active   Trkl     Up       Yes      Success  0      250
A3     Active   A3       Down     No       Success  0      300
A4     Passive  A4       Down     No       Success  0      0
A5     Passive  A5       Down     No       Success  0      0
A6     Passive  A6       Down     No       Success  0      0

Configuring a static trunk or static LACP trunk group

IMPORTANT:

Configure port trunking before you connect the trunked links between switches. Otherwise, a
broadcast storm could occur. If you need to connect the ports before configuring them for trunking,
you can temporarily disable the ports until the trunk is configured.

trunk
Syntax
trunk <PORT-LIST> <trk1 | trk2 | ..... trkN> [trunk | lacp | dt-lacp | dt-trunk]
    
Description

Configures the specified static trunk type.
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Static trunk group

This example uses ports C4 to C6 to create a non-protocol static trunk group with the group name Trk2.

switch# trunk c4-c6 trk2 trunk

Removing ports from a static trunk group

IMPORTANT:

Removing a port from a trunk can create a loop and cause a broadcast storm. When you remove a
port from a trunk where spanning tree is not in use, Switch recommends that you first disable the port
or disconnect the link on that port.

no trunk
Syntax
no trunk <PORT-LIST> 
      
Description

Removes the specified ports from an existing trunk group.

remove ports from an existing trunk group

To remove ports C4 and C5 from an existing trunk group:

switch# no trunk c4-c5

Enabling dynamic LACP trunk groups
An individual trunk can have up to eight links, with additional standby links if you are using LACP.

interface lacp active
Syntax
interface <PORT-LIST> lacp active
        
Description

Configure trunk group types. Configures <PORT-LIST> as LACP active. If the ports at the other end of the links
on <PORT-LIST> are configured as LACP passive, this command enables a dynamic LACP trunk group on
<PORT-LIST>.

Enable a dynamic LACP trunk group

This example uses ports C4 and C5 to enable a dynamic LACP trunk group.

switch# interface c4-c5 lacp active
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Remove ports from a dynamic LACP trunk group
To remove a port from dynamic LACP trunk operation, you must turn off LACP on the port. (On a port in an
operating, dynamic LACP trunk, you cannot change between LACP Active and LACP passive without first
removing LACP operation from the port.)

IMPORTANT:

Unless spanning tree is running on your network, removing a port from a trunk can result in a loop.
To help prevent a broadcast storm when you remove a port from a trunk where spanning tree is not
in use, Hewlett Packard Enterprise recommends that you first disable the port or disconnect the link
on that port.

no interface lacp
Syntax
no interface <PORT-LIST> lacp
    
Description

Removes <PORT-LIST> from any dynamic LACP trunk and returns the ports in <PORT-LIST> to passive LACP.

Using no interface lacp

Port C6 belongs to an operating, dynamic LACP trunk. To remove port C6 from the dynamic trunk and return it to
passive LACP, do the following:

switch# no interface c6 lacp
switch# interface c6 lacp passive
If the port on the other end of the link is configured for active LACP or static LACP, the trunked link will be re-
established almost immediately.

Set the LACP key
During dynamic link aggregation using LACP, ports with the same key are aggregated as a single trunk.

lacp
Syntax
lacp [active|passive|key 0–65535]

Enable LACP and configure an LACP key

switch# int A2-A3 lacp active
switch# int A2-A3 lacp key 500

switch# show lacp

                                 LACP

         LACP      Trunk    Port               LACP     Admin  Oper
  Port   Enabled   Group    Status   Partner   Status   Key    Key
  ----   -------   -------  -------  -------   -------  ------ ------
  A2     Active    A2       Down     No        Success  500    500
  A3     Active    A3       Down     No        Success  500    500
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Interface configured with a different LACP key

switch# int A5 lacp active
switch# int A5 lacp key 250

switch# show lacp

LACP

      LACP      Trunk     Port              LACP      Admin  Oper
Port  Enabled   Group     Status   Partner  Status    Key    Key
----  -------   -------   -------  -------  -------   ------ ------ 
Al    Active    Dyn1      Up       Yes      Success   100    100
A2    Active    Dyn1      Up       Yes      Success   100    100
A3    Active    Dyn1      Up       Yes      Success   100    100
A4    Active    Dyn1      Up       Yes      Success   100    100
A5    Active    A5        Up       No       Success   250    250

Specifying Minimum Active Links for LACP
Link Aggregation Control Protocol (LACP) allows the operator to configure a minimum number of active member
links in a trunk group to remain operational. When the number of active member links in the trunk is less than the
configured threshold value, the LACP trunk will be shut down. An additional option is provided to configure an
enable-timer, on expiry of which the LACP trunk brought down by the min-active-links functionality, will
be re-enabled. Once the trunk member ports are re-enabled, the validation for the active links against the
configured threshold is performed after a minute and the trunk state will be decided accordingly. The trunk will be
up and the traffic will be forwarded though the LACP trunk during this period.

NOTE:

• If the minimum active links are configured without enable-timer configuration, the LACP trunk
disabled by the feature will remain down until the operator explicitly disables and re-enables the
port or triggers a port up indication by any alternative means.

• If the number of active links in a LACP trunk is less than the threshold value, the trunk will not be
functional and traffic will not pass through the respective trunk.

• If the number of active links in the trunk drops below the threshold, the entire trunk will be brought
down and complete traffic flowing through the same will be dropped. Hence, this configuration
must be used carefully in a topology where there is a redundant traffic path.

• It is recommended to configure the min-active-links on one side of the trunk.

lacp min-active-links

Syntax
lacp min-active-links <value>

no lacp min-active-links <value>

Description

Configures the minimum threshold value for the active member links in a LACP trunk group.

The no form of this command deletes the configured threshold and sets the threshold value to default.
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Command context
interface
Example: eth-Trk

Parameters

value

Sets the threshold value for LACP trunk. The value is an integer that ranges from zero to eight which
represents the number of minimum active links. The default value is zero which disables the minimum active
links.

Example

Switch(eth-Trk11)# lacp
enable-timer          Configure the time in seconds to wait before re-enabling 
                      the trunk disabled by LACP feature for minimum active links.
key                   Set the LACP key.
mad-passthrough       Enable or disable MAD passthrough on the LACP trunks.
min-active-links      Configure the threshold for the minimum number of active
                      member links in a LACP trunk group, for it to be operational.
active                Enable active LACP.
passive               Enable passive LACP.
static                Set the mode of a static LACP port to active or passive.
Switch(eth-Trk11)# lacp min-active-links
<0-8>                 Enter a number. 
Switch(eth-Trk11)# lacp min-active-links 5
WARNING: This configuration can result in disabling the trunk, if the
number of active links in the trunk drops below the configured threshold.
Continue (y/n)? y

lacp enable-timer

Syntax
lacp enable-timer <value>

no lacp enable-timer <value>

Description

Configures the timer on expiry of which the member links disabled by LACP min-active-links functionality,
will be re-enabled.

The no form of this command deletes the configured time and sets the time to default.

Command context
interface
Example: eth-Trk

Parameters

value

Sets the time duration to wait before enabling the disabled trunk. The time duration ranges from 0 to 604800
seconds. The default value is zero which disables the timer.
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Example

Switch(eth-Trk11)# lacp
enable-timer          Configure the time in seconds to wait before re-enabling 
                      the trunk disabled by LACP feature for minimum active links.
key                   Set the LACP key.
mad-passthrough       Enable or disable MAD passthrough on the LACP trunks.
min-active-links      Configure the threshold for the minimum number of active
                      member links in a LACP trunk group, for it to be operational.
active                Enable active LACP.
passive               Enable passive LACP.
static                Set the mode of a static LACP port to active or passive.
Switch(eth-Trk11)# lacp enable-timer
<0-604800>            Enter a number.
Switch(eth-Trk11)# lacp enable-timer 120

show lacp min-active-links

Syntax
show lacp min-active-links

Description

Shows the LACP minimum active links information for each trunk group.

Example

switch# show lacp min-active-links

Trunk   Minimum active  Enable-Time
Group   Links           (seconds)
------- --------------- ------------
Trk1    0               0
Trk3    0               0
Trk11   5               120
Trk12   3               356
show running-configuration

switch# show running-config
Running configuration:

; hpStack_KB Configuration Editor; Created on release #KB.16.08.0000x
; Ver #14:0f.6f.f8.1d.fb.7f.bf.bb.ff.7c.59.fc.7b.ff.ff.fc.ff.ff.3f.ef:60

stacking
   member 1 type "JL074A" mac-address ecebb8-117400
   member 1 flexible-module A type JL079A
   member 2 type "JL074A" mac-address ecebb8-1d1580
   member 2 flexible-module A type JL079A
   member 3 type "JL075A" mac-address 1c98ec-996c80
   member 3 flexible-module A type JL083A
   member 3 flexible-module B type JL081A
   exit
hostname "Switch-2"
mirror 1 port 1/16
mirror 2 port 1/32
trunk 1/35-1/36,2/35-2/36 trk1 lacp
trunk 1/A1,1/A2,2/A1,2/A2 trk3 lacp
trunk 1/1-1/2,2/1-2/2,3/1-3/3 trk11 lacp
trunk 3/13-3/14,3/A1-3/A2 trk12 lacp
interface Trk11
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   lacp min-active-links 5
   lacp enable-timer 120
   exit
interface Trk12
   lacp min-active-links 3
   lacp enable-timer 356
   exit

Limitations

• Dynamic LACP, static trunks, and distributed trunks will not support this feature.

• The command is not available for REST/next Gen UI.

• If the LACP trunk is down due to lack of active links with the timer enabled, a dynamic update to the enable-
timer by configuration will not take effect immediately as the current timer runs with the previously configured
value.

• When the LACP trunk is blocked by min-active-links and the enable-timer is running, the member
links will be prevented from becoming operational even if there is an external intervention caused by
configuration or topology changes.

• If the enable-timer is not configured, the operator must restore the member links of the LACP trunk which
are blocked by the minimum active links.

• If there is a flap in any member links, the LACP trunk disabled by min-active-links may end up flapping
when enable-timer is not configured.

• The min-active-links feature is not supported on the previous releases (that is prior to 16.08 version). On
downgrading the switch to the previous version, the configuration will be removed without any warning.

Viewing and configuring a static trunk group (Menu)

Prerequisites

To avoid a broadcast storm, configure port trunking before you connect the trunked links to another switch,
routing switch, or server.(If you need to connect the ports before configuring them for trunking, you can
temporarily disable the ports until the trunk is configured. See "Enabling or Disabling Ports and Configuring
Port_Mode".)

This procedure uses the Port/Trunk Settings screen to configure a static port trunk group on the switch.

Procedure

1. Review the Prerequisites.

2. From the Main Menu, select Switch Configuration ... , and then select Port/Trunk Settings.
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3. On the keyboard, press [E] (for Edit), and then use the arrow keys to access the port trunk parameters.

Figure 29: Menu screen for configuring a port trunk group

4. In the Group column, move the cursor to the port you want to configure.

5. Use the Space bar to choose a trunk group assignment (Trk1, Trk2, and so on) for the selected port.

a. For proper trunk operation, all ports in a trunk must have the same media type and mode (such as
10/100TX set to 100FDx, or 100FX set to 100FDx.) The flow control settings must also be the same for all
ports in a given trunk.

b. You can configure the trunk group with up to eight ports per trunk. If multiple VLANs are configured, all
ports within a trunk will be assigned to the same VLAN or set of VLANs. (With the 802.1Q VLAN capability
built into the switch, more than one VLAN can be assigned to a trunk. See the Advanced Traffic
Management Guide.

(To return a port to a non-trunk status, keep pressing the Space bar until a blank appears in the highlighted
Group value for that port.)

Figure 30: Configuration for a Two-Port Trunk Group

6. Move the cursor to the Type column for the selected port and use the Space bar to select the trunk type:

a. LACP

b. Trunk (the default type if you do not specify a type)

All ports in the same trunk group on the same switch must have the same Type (LACP or Trunk.)
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7. When you are finished assigning ports to the trunk group, press [Enter], then [S] (for Save) and return to the
Main Menu. (It is not necessary to reboot the switch.)

During the Save process, traffic on the ports configured for trunking is delayed for several seconds. If the
Spanning Tree Protocol is enabled, the delay may be up to 30 seconds.

8. Connect the trunked ports on the switch to the corresponding ports on the opposite device. If you previously
disabled any of the trunked ports on the switch, enable them now. (See "Viewing Port Status and Configuring
Port Parameters")

Check the Event Log to verify that the trunked ports are operating properly.

Enable L4-based trunk load balancing
Use this command with the L4-based option to enable load balancing on Layer 4 information when it is present.

trunk-load-balance
Syntax
trunk-load-balance [L3-based|L4-based]
Description

When the L4-based option is configured, enables load balancing based on Layer 4 information if it is present. If it
is not present, Layer 3 information is used if present; if Layer 3 information is not present, Layer 2 information is
used. The configuration is executed in global configuration context and applies to the entire switch.

Defaults to L3-based load balancing.

Parameters

L3–based

Load balance on Layer 3 information if present, or Layer 2 information.

L4–based

Load balance on Layer 4 port information if present, or Layer 3 if present, or Layer 2.
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Enabling L4-based trunk load balancing

Figure 31: Enabling L4-based trunk load balancing

Figure 32: 0utput when L4-based trunk load balancing is enabled

Figure 33: Running config file when L4-based trunk load balancing is enabled

Viewing trunk load balancing
The show trunks load-balance interface command displays the port on which the information will be
forwarded out for the specified traffic flow with the specified source and destination address.

show trunks
Syntax
show trunks load-balance interface <trunk-id> mac <src-addr> <dest-addr> [ip <src-
addr> <dest-addr> <src-tcp-port> <src-upd-port> <dest-tcp-port> <dest-udp-port> 
inbound-port <port-num>
      
Description

Displays the port on which the information will be forwarded out for the specified traffic flow with the specified
source and destination address.

Options
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trunk-id

The trunk id (trk1, trk2, etc.)

mac src-addr dest-addr
The source MAC address and the destination MAC address.

ip src-addr dest-addr
The source IPv4 /IPv6 address and the destination IPv4/IPv6 address.

[src-tcp-port|src-udp-port]
The source TCP port or the source UDP port.

[dest-tcp-port|dest-udp-port]
The destination TCP port or the destination UDP port.

inbound-port port-num
the port number of which the traffic is received.

Information about the forwarding port

switch# show trunks load-balance interface trk1 mac 424521-498421 534516-
795463 inbound-port a5
Traffic in this flow will be forwarded out port 23 based on the confiugred L2
load balancing.

Operating notes
The port cannot be determined if:

• All the ports in the trunk are down.

• The MAC address is all zeros.

• The source MAC address is broadcast or multicast.

Distributed trunking

Configure ISC ports
Configure the ISC ports before you configure the trunks for distributed trunking.

switch-interconnect
Syntax
[no] switch-interconnect <PORT-LIST>|<TRK1|TRK2|...TRKn>
        
Configures an InterSwitch-Connection (ISC) port. Override an ISC configuration by configuring the command with
a different value.

IMPORTANT:

A port that is already part of a trunk cannot be configured as an ISC interface.

Parameters
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no

Removes the ISC interface configuration.

<PORT-LIST>|<trk1|trk2|...trkN>

The interconnect interface that connects two distributed trunking switches. It can be a physical port, manual
LACP trunk, or manual non-protocol trunk.

Configuring distributed trunking ports
Distributed trunking ports must be configured manually.

trunk
Syntax
trunk <PORT-LIST> <trk1|trk2|...trkN> trunk <PORT-LIST>|lacp | dt-lacp | dt-trunk
      
Description

Configures distributed trunking on a switch. Use either the dt-lacp or dt-trunk option.

The trunk groups and trunk types must be identical in both switches. For example, if Switch Local is configured
with trk1 and uses the dt-lacp option, Switch Remote also must be configured with trk1 and use the dt-
lacp option to form a distributed trunk. Similarly, if Switch Local is configured with trk2 and uses the dt-trunk
option, Switch Remote must be configured with trk2 and use the dt-trunk option to form the distributed trunk.

DT requires that the platforms at both ends of the DT-link be the same and running the same software version.

Parameters

no

The no form of the command removes the distributed trunking configuration on the switch.

ISC port configuration

Figure 34: Configuring distributed trunking on page 188 shows an ISC port being configured for the local
switch and the remote switch.

Figure 34: Configuring distributed trunking

Configuring peer-keepalive links
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distributed-trunking
Syntax
distributed-trunking [hold-timer3-10|peer-keepalive <DESTINATION> ip-address|vlan 
<VID> [interval <400–10000>][timeout <3–20>] [udp-port <1024–49151>]
        
Description

Distributed trunking uses a VLAN interface between DT peers to transmit periodic peer-keepalive messages. This
command configures the peer-keepalive parameters for distributed trunking.

Parameters and options
no

The no form of the command removes the distributed trunking configuration on the switch.

hold-timer
Configures the hold time in seconds. The range is 3–10 seconds, and defaults to 3.

peer-keepalive
—

<DESTINATION>

The destination IPv4 address to be used by DT switches to send peer-keepalive messages to the peer DT
switch when the ISC is down.

vlan <VID>
The VID of the VLAN used exclusively for sending and receiving peer-keepalive messages.

interval
The interval between peer-keepalive messages (in milliseconds), in the range of 400–10000 milliseconds.
Defaults to 1000 milliseconds.

timeout
The peer-keepalive timeout in seconds, in the range of 3–10 seconds. Defaults to 5 seconds.

udp-port
The source UDP port to be used for transmitting peer-keepalive HELLO messages, in the range of 1024–
49151.

Viewing distributed trunking information

show lacp distributed
Syntax
show lacp disributed
Description

Displays information about distributed trunks and LACP status.

Example

Switch Local (config)#: show lacp distributed
                               Distributed LACP
Local Port Status:

         LACP        Trunk      Port       LACP        LACP      Admin     Oper
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Port     Enabled     Group      Status     Partner     Status    Key       Key
-----   ---------   -------   ---------   ---------    ------   -------    ---
A9       Active      Trk10        Up         Yes        Sucess    350      350
A10      Active      Trk10        Up         Yes        Sucess    350      350

Remote Port Status
         LACP        Trunk      Port       LACP        LACP      Oper
Port     Enabled     Group      Status     Partner     Status    Key
-----   ---------   -------   ---------   ---------    ------   -----  
A5       Active      Trk10       Up         Yes        Sucess     200
A6       Active      Trk10       Up         Yes        Sucess     200

show distributed-trunk
Syntax
show distributed‐trunk consistency‐parameters global
Description

This command displays configured features on VLANs that have dt‐lacp or dt‐trunk ports as member port. This
command also displays VLAN memberships and loop‐protect status of a given DT trunk. You can use this
command to determine if there is any mismatch in the configuration parameters on VLANs configured for DT ports
or on DT interfaces.

show distributed-trunk

show distributed-trunk consistency-parameters global

                              Local             Peer
                              -----             -----
Image Version                 K.15.XX           K.15.XX
IP Routing                    Enabled           Enabled
Peer-keepalive interval (ms)  1000              1000

IGMP enabled VLANs on Local : 1-10, 100-110, 501 ,600
610 ,800
IGMP enabled VLANs on Peer : 1-10, 100-110, 501 ,600

DHCP-snooping enabled VLANs on Local : 1,2
DHCP-snooping enabled VLANs on Peer : 1

Loop-protect enabled VLANs on Local : 1,4
Loop-protect enabled VLANs on Peer : 1,5

MLD enabled VLANs on Local : 1-10
MLD enabled VLANs on Peer : 1-10
Example

Show distributed-trunk 
consistency-parameters trunk <trk1...trkN>
Allowed VLANs on Local : 1-10, 100-110, 501 ,600
610 ,800
Allowed VLANs on Peer : 1-10, 100-110, 501 ,600
610 ,800

Name            Local Value             Peer Value
---------------------- --------------------------------- ------------------------
Loop-protect     Enabled                 Enabled
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Viewing peer-keepalive configuration

Viewing switch interconnect
Syntax
show switch-interconnect
Description

Displays information about switch interconnect settings.

Figure 35: Switch-interconnect settings

Port trunk operations
The switches covered in this guide offer these options for port trunking:

• LACP: IEEE 802.3ad—

• Trunk: Non-Protocol—

Up to 144 trunk groups are supported on the switches. The actual maximum depends on the number of ports
available on the switch and the number of links in each trunk. (Using the link aggregation control protocol—LACP
—option, you can include standby trunked ports in addition to the maximum of eight actively trunking ports.) The
trunks do not have to be the same size; for example, 100 two-port trunks and 11 eight-port trunks are supported.

LACP requires full-duplex (FDx) links of the same media type (10/100Base-T, 100FX, and so on) and the same
speed, and enforces speed and duplex conformance across a trunk group. For most installations, Switch
recommends that you leave the port Mode settings at Auto (the default.) LACP also operates with Auto-10,
Auto-100, and Auto-1000 (if negotiation selects FDx), and 10FDx, 100FDx, and 1000FDx
settings. (The 10-gigabit ports available for some switch models allow only the Auto setting.)

Fault tolerance
If a link in a port trunk fails, the switch redistributes traffic originally destined for that link to the remaining links in
the trunk. The trunk remains operable as long as there is at least one link in operation. If a link is restored, that
link is automatically included in the traffic distribution again. The LACP option also offers a standby link capability,
which enables you to keep links in reserve for service if one or more of the original active links fails. (See Trunk
group operation using LACP on page 200.)

Trunk configuration methods

Dynamic LACP trunk
The switch automatically negotiates trunked links between LACP-configured ports on separate devices, and offers
one dynamic trunk option: LACP. To configure the switch to initiate a dynamic LACP trunk with another device,
use the interface command in the CLI to set the default LACP option to active on the ports you want to use
for the trunk. For example, the following command sets ports C1 to C4 to LACP active:

switch(config) int c1-c4 lacp active
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The preceding example works if the ports are not already operating in a trunk. To change the LACP option on
ports already operating as a trunk, you must first remove them from the trunk. For example, if ports C1 to C4 are
LACP-active and operating in a trunk with another device, you would do the following to configure them to LACP-
passive:

switch# no int c1-c4 lacp
Removes the ports from the trunk:

switch# int c1-c4 lacp passive

Dynamic LACP Standby Links
Dynamic LACP trunking enables you to configure standby links for a trunk by including more than eight ports in a
dynamic LACP trunk configuration. When eight ports (trunk links) are up, the remaining link(s) will be held in
standby status. If a trunked link that is “Up” fails, it will be replaced by a standby link, which maintains your
intended bandwidth for the trunk. In this example, ports A1 through A9 have been configured for the same LACP
trunk. Notice that one of the links shows Standby status, while the remaining eight links are “Up”.

switch# show lacp
                              LACP
       LACP      Trunk    Port                LACP    Admin    Oper
Port   Enabled   Group    Status   Partner   Status   Key      Key
----   -------   -----    ------   -------   ------   ----    -----
Al     Active     Dyn1     Up        Yes     Success   100      100
A2     Active     Dyn1     Up        Yes     Success   100      100
A3     Active     Dyn1     Up        Yes     Success   100      100
A4     Active     Dyn1     Up        Yes     Success   100      100
A5     Active     Dyn1     Up        Yes     Success   100      100
A6     Active     Dyn1     Up        Yes     Success   100      100
A7     Active     Dyn1     Up        Yes     Success   100      100
A8     Active     Dyn1     Up        Yes     Success   100      100
A9     Active     Dyn1    Standby    Yes     Success   100      100

Viewing LACP Local Information

switch# show lacp local
LACP Local Information.
System ID: 001871-b98500
               LACP                Tx      Rx Timer
Port   Trunk   Mode   Aggregated   Timer   Expired
----- ------- ------- ----------- ------ ---------
A2       A2    Active    Yes       Fast    No
A3       A3    Active    Yes       Fast    No

Viewing LACP Peer Information
Use the show lacp peer command to display information about LACP peers. The System ID represents the
MAC address of a partner switch. It will be zero if a partner is not found.

switch# show lacp peer
LACP Peer Information.
System ID: 001871-b98500
Local  Local                         Port       Oper    LACP    Tx
Port   Trunk   System ID      Port   Priority   Key     Mode    Timer
------ ------ --------------  ----- --------- ------- -------- -----
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A2     A2      123456-654321   2       0       100    Passive   Fast
A3     A3      234567-456789   3       0       100    Passive   Fast

Viewing LACP Counters
Use the show lacp counters command to display statistical information about LACP ports.

Note on the Marker Protocol. Data traffic can be dynamically redistributed in port channels. This may occur when
a link is added or removed, or there is a change in load-balancing. Traffic that is redistributed in the middle of a
traffic flow could potentially cause mis-ordered data packets.

LACP uses the marker protocol to prevent data packets from being duplicated or reordered due to redistribution.
Marker PDUs are sent on each port-channel link. The remote system responds to the marker PDU by sending a
marker responder when it has received all the frames received on this link prior to the marker PDU. When the
marker responders are received by the local system on all member links of the port channel, the local system can
redistribute the packets in the traffic flow correctly.

For the switches covered in this guide, the marker BPDUs are not initiated, only forwarded when received,
resulting in the Marker fields in the output usually displaying zeros.

switch# show lacp counters
LACP Port Counters.
               LACP      LACP      Marker    Marker    Marker     Marker
Port   Trunk   PDUs Tx   PDUs Rx   Req. Tx   Req. Rx   Resp. Tx   Resp. Rx   Error
----   ------  -------   -------   -------   -------   --------   --------   -----
A2       A2    1234      1234       0          0         0         0           0
A3       A3    1234      1234       0          0         0         0           0

Using keys to control dynamic LACP trunk configuration
The lacp key option provides the ability to control dynamic trunk configuration. Ports with the same key will be
aggregated as a single trunk.

There are two types of keys associated with each port, the Admin key and the Operational key. The Operational
key is the key currently in use. The Admin key is used internally to modify the value of the Operational key. The
Admin and Operational key are usually the same, but using static LACP can alter the Operational key during
runtime, in which case the keys would differ.

The lacp key command configures both the Admin and Operational keys when using dynamic LACP trunks. It
only configures the Admin key if the trunk is a static LACP trunk. It is executed in the interface context.

Static trunk
The switch uses the links you configure with the Port/Trunk Settings screen in the menu interface or the trunk
command in the CLI to create a static port trunk. The switch offers two types of static trunks: LACP and Trunk.

Table 9: Trunk types used in static and dynamic trunk groups

Trunking method LACP Trunk

Dynamic Yes No

Static Yes Yes
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Table 10: Trunking options for LACP and Trunk protocols

Protocol Trunking Options

LACP
(802.3ad)

Provides dynamic and static LACP trunking options.

• Dynamic LACP — Use the switch-negotiated dynamic LACP trunk when:
◦ The port on the other end of the trunk link is configured for Active or Passive LACP.

◦ You want fault-tolerance for high-availability applications. If you use an eight-link trunk, you
can also configure one or more additional links to operate as standby links that will activate
only if another active link goes down.

• Static LACP — Use the manually configured static LACP trunk when:
◦ The port on the other end of the trunk link is configured for a static LACP trunk.

◦ You want to configure non-default spanning tree or IGMP parameters on an LACP trunk
group.

◦ You want an LACP trunk group to operate in a VLAN other than the default VLAN and
GVRP is disabled.

◦ You want to use a monitor port on the switch to monitor an LACP trunk.

Trunk(non-
protocol)

Provides manually configured, static-only trunking to:

• Most Switch and routing switches not running the 802.3ad LACP protocol.

• Windows NT and UX workstations and servers

Use the Trunk option when:

• The device to which you want to create a trunk link is using a non-802.3ad trunking protocol.

• You are unsure which type of trunk to use, or the device to which you want to create a trunk
link is using an unknown trunking protocol.

• You want to use a monitor port on the switch to monitor traffic on a trunk.

Operating port trunks
Media:

For proper trunk operation, all ports on both ends of a trunk group must have the same media type and mode
(speed and duplex.) (For the switches, Switch recommends leaving the port Mode setting at Auto or, in
networks using Cat 3 cabling, Auto-10.)

Port Configuration

The default port configuration is Auto, which enables a port to sense speed and negotiate duplex with an
auto-enabled port on another device. Switch recommends that you use the Auto setting for all ports you plan
to use for trunking. Otherwise, you must manually ensure that the mode setting for each port in a trunk is
compatible with the other ports in the trunk.

Recommended port mode setting for LACP

switch# show interfaces config
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 Port Settings

  Port  Type      | Enabled Mode         Flow Ctrl MDI
  ----- --------- + ------- ------------ --------- ----
  1     10/100TX  | Yes     Auto         Enable    Auto
  2     10/100TX  | Yes     Auto         Enable    MDI
All of the following operate on a per-port basis, regardless of trunk membership:

• Enable/Disable

• Flow control (Flow Ctrl)

LACP is a full-duplex protocol.

Trunk configuration:

All ports in the same trunk group must be the same trunk type (LACP or trunk.) All LACP ports in the same
trunk group must be either all static LACP or all dynamic LACP.

A trunk appears as a single port labeledDyn1(for an LACP dynamic trunk) or Trk1 (for a static trunk of type
LACP, Trunk) on various menu and CLI screens.

For spanning-tree or VLAN operation, configuration for all ports in a trunk is done at the trunk level. (You
cannot separately configure individual ports within a trunk for spanning-tree or VLAN operation.)

Traffic distribution:

All of the switch trunk protocols use the SA/DA (source address/destination address) method of distributing
traffic across the trunked links.

Spanning Tree:

802.1D (STP) and 802.1w (RSTP) Spanning Tree operate as a global setting on the switch (with one instance
of Spanning Tree per switch.) 802.1s (MSTP) Spanning Tree operates on a per-instance basis (with multiple
instances allowed per switch.) For each Spanning Tree instance, you can adjust Spanning Tree parameters
on a per-port basis.

A static trunk of any type appears in the Spanning Tree configuration display, and you can configure Spanning
Tree parameters for a static trunk in the same way that you would configure Spanning Tree parameters on a
non-trunked port. (Note that the switch lists the trunk by name—such as Trk1—and does not list the individual
ports in the trunk.) For example, if ports C1 and C2 are configured as a static trunk named Trk1, they are
listed in the Spanning Tree display as Trk1 and do not appear as individual ports in the Spanning Tree
displays.

When Spanning Tree forwards on a trunk, all ports in the trunk will be forwarding. Conversely, when Spanning
Tree blocks a trunk, all ports in the trunk are blocked.

NOTE:

A dynamic LACP trunk operates only with the default Spanning Tree settings. Also, this type of
trunk appears in the CLI show spanning-tree display, but not in the Spanning Tree
Operation display of the Menu interface.
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If you remove a port from a static trunk, the port retains the same Spanning Tree settings that were configured
for the trunk.

Figure 36: Example of a port trunk in a Spanning Tree listing

IP multicast protocol (IGMP):

A static trunk of any type appears in the IGMP configuration display, and you can configure IGMP for a static
trunk in the same way that you would configure IGMP on a non-trunked port. (Note that the switch lists the
trunk by name—such as Trk1—and does not list the individual ports in the trunk.) Also, creating a new trunk
automatically places the trunk in IGMP Auto status if IGMP is enabled for the default VLAN.

A dynamic LACP trunk operates only with the default IGMP settings and does not appear in the IGMP
configuration display or show ip igmp listing.

VLANs:

Creating a new trunk automatically places the trunk in the DEFAULT_VLAN, regardless of whether the ports in
the trunk were in another VLAN. Similarly, removing a port from a trunk group automatically places the port in
the default VLAN. You can configure a static trunk in the same way that you configure a port for membership
in any VLAN.

NOTE:

For a dynamic LACP trunk to operate in a VLAN other than the default VLAN
(DEFAULT_VLAN), GVRP must be enabled.

Port security

Trunk groups (and their individual ports) cannot be configured for port security, and the switch excludes
trunked ports from the show port-security listing. If you configure non-default port security settings for a
port, then subsequently try to place the port in a trunk, you see the following message and the command is
not executed:

<PORT-LIST> Command cannot operate over a logical port.

Monitor port

NOTE:

A trunk cannot be a monitor port. A monitor port can monitor a static trunk but cannot monitor a
dynamic LACP trunk.

Show port-security log
Syntax
show port-security intrusion-log
Description
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show port-security intrusion-log

switch(config)# sh port-security intrusion-log

Status and Counters - Intrusion Log

Port   MAC Address   Date / Time
------ ------------- --------------------------
23    000087-c78b49 11/19/14 11:09:30
23    000087-c78041 11/19/14 11:12:29
23    000087-c781c1 11/19/14 11:14:08

Static or dynamic trunk group overview
Configure port trunking before you connect the trunked links between switches.

IMPORTANT: Failure to configure port trunking before connecting the trunked links between
switches can result in a broadcast storm. If you need to connect the ports before configuring them for
trunking, you can temporarily disable the ports until after you have configured the trunk.

An individual trunk can have up to eight links, with additional standby links if you are using LACP. You can
configure trunk group types as follows:

Trunk Type Trunk Group Membership

TrkX (static) DynX (dynamic)

LACP Yes Yes

Trunk Yes No

Enabling a dynamic LACP trunk group
In the default port configuration, all ports on the switch are set to disabled. To enable the switch to automatically
form a trunk group that is dynamic on both ends of the link, the ports on one end of a set of links must be LACP
Active. The ports on the other end can be either LACP Active or LACP Passive. The active command enables
the switch to automatically establish a (dynamic) LACP trunk group when the device on the other end of the link is
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configured for LACP Passive. Figure 37: Criteria for automatically forming a dynamic LACP trunk on page
198 provides an example.

Figure 37: Criteria for automatically forming a dynamic LACP trunk

Dynamic LACP standby links
Dynamic LACP trunking enables you to configure standby links for a trunk by including more than eight ports in a
dynamic LACP trunk configuration. When eight ports (trunk links) are up, the remaining links are held in standby
status. If a trunked link that is "Up" fails, it is replaced by a standby link, which maintains your intended bandwidth
for the trunk. In this example, ports A1 through A9 have been configured for the same LACP trunk. Notice that
one of the links shows Standby port status, while the remaining eight links show Up port status.

A dynamic LACP trunk with one standby link

switch# show lacp

                              LACP

      LACP      Trunk     Port               LACP     Admin  Oper
Port  Enabled   Group     Status   Partner  Status    Key    Key
----  -------   -------   -------  -------  -------   ------ ------ 
Al    Active    Dyn1      Up       Yes      Success   100    100
A2    Active    Dyn1      Up       Yes      Success   100    100
A3    Active    Dyn1      Up       Yes      Success   100    100
A4    Active    Dyn1      Up       Yes      Success   100    100
A5    Active    Dyn1      Up       Yes      Success   100    100
A6    Active    Dyn1      Up       Yes      Success   100    100
A7    Active    Dyn1      Up       Yes      Success   100    100
A8    Active    Dyn1      Up       Yes      Success   100    100
A9    Active    Dyn1      Standby  Yes      Success   100    100

Viewing LACP local information
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Example of LACP local information

switch# show lacp local

LACP Local Information. 

System ID: 001871-b98500

              LACP                 Tx     Rx Timer
  Port Trunk  Mode     Aggregated  Timer  Expired
  ---- ------ -------- ----------- ------ --------
  A2   A2     Active   Yes         Fast   No
  A3   A3     Active   Yes         Fast   No

Viewing LACP peer information
Use the show lacp peer command to display information about LACP peers. The System ID represents the
MAC address of a partner switch. It will be zero if a partner is not found.

Example of LACP peer information

switch# show lacp peer

LACP Peer Information. 

System ID: 001871-b98500

  Local  Local                       Port      Oper    LACP     Tx
  Port   Trunk  System ID      Port  Priority  Key     Mode     Timer
  ------ ------ -------------- ----- --------- ------- -------- ----- 
  A2     A2     123456-654321  2     0         100     Passive  Fast
  A3     A3     234567-456789  3     0         100     Passive  Fast

Viewing LACP counters
Use the show lacp counters command to display statistical information about LACP ports.

NOTE:

Data traffic can be dynamically redistributed in port channels. This may occur when a link is added or
removed, or there is a change in load-balancing. Traffic that is redistributed in the middle of a traffic
flow could potentially cause mis-ordered data packets.

LACP uses the marker protocol to prevent data packets from being duplicated or reordered due to
redistribution. Marker PDUs are sent on each port-channel link. The remote system responds to the
marker PDU by sending a marker responder when it has received all the frames received on this link
prior to the marker PDU. When the marker responders are received by the local system on all
member links of the port channel, the local system can redistribute the packets in the traffic flow
correctly.

For the switches covered in this guide, the marker BPDUs are not initiated, only forwarded when received,
resulting in the Marker fields in the output usually displaying zeros.

Example of LACP counters output

switch# show lacp counters
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LACP Port Counters.

  LACP        LACP      Marker    Marker   Marker   Marker
  Port Trunk  PDUs Tx   PDUs Rx   Req. Tx  Req. Rx  Resp. Tx Resp. Rx Error
  ---- ------ --------- --------- -------- -------- -------- -------- --------
  A2   A2     1234      1234      0        0        0        0        0
  A3   A3     1234      1234      0        0        0        0        0

Trunk group operation using LACP
The switch can automatically configure a dynamic LACP trunk group, or you can manually configure a static
LACP trunk group.

NOTE: LACP requires full-duplex (FDx) links of the same media type (10/100Base-T, 100FX, and so
on) and the same speed and enforces speed and duplex conformance across a trunk group. For
most installations, Switch recommends that you leave the port mode settings at Auto (the default.)
LACP also operates with Auto-10, Auto-100, and Auto-1000 (if negotiation selects FDx), and
10FDx, 100FDx, and 1000FDx settings.

LACP trunk status commands include:

Trunk display method Static LACP trunk Dynamic LACP trunk

CLI show lacp command Included in listing. Included in listing.

CLI show trunk command Included in listing. Not included.

Port/Trunk Settings screen in menu
interface

Included in listing. Not included

Thus, to display a listing of dynamic LACP trunk ports, you must use the show lacp command.

In most cases, trunks configured for LACP on the switches operate as follows:
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Table 11: LACP trunk types

LACP port trunk configuration Operation

Dynamic LACP This option automatically establishes an 802.3ad-compliant trunk group, with
LACP for the port Type parameter and DynX for the port Group name, where
X is an automatically assigned value from 1 to 144, depending on how many
dynamic and static trunks are currently on the switch. (The switch allows a
maximum of 144 trunk groups in any combination of static and dynamic
trunks.)

NOTE: Dynamic LACP trunks operate only in the default VLAN
(unless GVRP is enabled and Forbid is used to prevent the
trunked ports from joining the default VLAN.) Thus, if an LACP
dynamic port forms using ports that are not in the default VLAN,
the trunk automatically moves to the default VLAN unless
GVRP operation is configured to prevent this from occurring. In
some cases, this can create a traffic loop in your network.

Under the following conditions, the switch automatically establishes a
dynamic LACP port trunk group and assigns a port Group name:

• The ports on both ends of each link have compatible mode settings
(speed and duplex.)

• The port on one end of each link must be configured for LACP Active and
the port on the other end of the same link must be configured for either
LACP Passive or LACP Active. For example:

Either of the above link configurations allows a dynamic LACP trunk link.

Backup Links: A maximum of eight operating links are allowed in the trunk,
but, with dynamic LACP, you can configure one or more additional (backup)
links that the switch automatically activates if a primary link fails. To configure
a link as a standby for an existing eight-port dynamic LACP trunk, ensure
that the ports in the standby link are configured as either active-to-active or
active-to-passive between switches.

Displaying dynamic LACP trunk data: To list the configuration and status for a
dynamic LACP trunk, use the CLI show lacp command.

NOTE: The dynamic trunk is automatically created by the
switch and is not listed in the static trunk listings available in the
menu interface or in the CLI show trunk listing.

Static LACP Provides a manually configured, static LACP trunk to accommodate these
conditions:
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LACP port trunk configuration Operation

• The port on the other end of the trunk link is configured for a static LACP
trunk.

• You want to configure non-default Spanning Tree or IGMP parameters on
an LACP trunk group.

• You want an LACP trunk group to operate in a VLAN other than the
default VLAN and GVRP is disabled.

• You want to use a monitor port on the switch to monitor an LACP trunk.

The trunk operates if the trunk group on the opposite device is running one of
the following trunking protocols:

• Active LACP

• Passive LACP

• Trunk

This option uses LACP for the port Type parameter and TrkX for the port
Group parameter, where X is an automatically assigned value in a range
corresponding to the maximum number of trunks the switch allows.

Displaying static LACP trunk data : To list the configuration and status for a
static LACP trunk, use the CLI show lacp command. To list a static LACP
trunk with its assigned ports, use the CLI show trunk command or display
the menu interface Port/Trunk Settings screen.Static LACP does not allow
standby ports.

Default port operation
In the default configuration, LACP is disabled for all ports. If LACP is not configured as Active on at least one end
of a link, the port does not try to detect a trunk configuration and operates as a standard, untrunked port. To
display this data for a switch, execute the following command in the CLI:

switch# show lacp
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Table 12: LACP port status data

Status name Meaning

Port Numb Shows the physical port number for each port configured for LACP operation (C1, C2, C3 ….)
Unlisted port numbers indicate that the missing ports that are assigned to a static trunk group
are not configured for any trunking.

LACP Enabled Active: The port automatically sends LACP protocol packets.

Passive: The port does not automatically send LACP protocol packets and responds only if it
receives LACP protocol packets from the opposite device. A link having either two active
LACP ports or one active port and one passive port can perform dynamic LACP trunking.

A link having two passive LACP ports does not perform LACP trunking because both ports are
waiting for an LACP protocol packet from the opposite device.

NOTE: In the default switch configuration, LACP is disabled for all ports.

Trunk Group TrkX: This port has been manually configured into a static LACP trunk.

Trunk group same as port number: The port is configured for LACP, but is not a member of a
port trunk.

Port Status Up: The port has an active LACP link and is not blocked or in standby mode.

Down: The port is enabled, but an LACP link is not established. This can indicate, for example,
a port that is not connected to the network or a speed mismatch between a pair of linked ports.

Disabled: The port cannot carry traffic.

Blocked: LACP, Spanning Tree has blocked the port. (The port is not in LACP standby mode.)
This may be caused by a (brief) trunk negotiation or a configuration error, such as differing port
speeds on the same link or trying to connect the switch to more trunks than it can support.

NOTE: Some older devices are limited to four ports in a trunk. When eight
LACP-enabled ports are connected to one of these older devices, four ports
connect, but the other four ports are blocked.

Standby: The port is configured for dynamic LACP trunking to another device, but the
maximum number of ports for the dynamic trunk to that device has already been reached on
either the switch or the other device. This port will remain in reserve, or "standby" unless
LACP detects that another, active link in the trunk has become disabled, blocked, or down. In
this case, LACP automatically assigns a standby port, if available, to replace the failed port.

LACP Partner Yes: LACP is enabled on both ends of the link.

No: LACP is enabled on the switch, but either LACP is not enabled or the link has not been
detected on the opposite device.

LACP Status Success: LACP is enabled on the port, detects and synchronizes with a device on the other
end of the link, and can move traffic across the link.

Failure: LACP is enabled on a port and detects a device on the other end of the link, but is not
able to synchronize with this device, and therefore is not able to send LACP packets across
the link. This can be caused, for example, by an intervening device on the link (such as a hub),
a bad hardware connection, or if the LACP operation on the opposite device does not comply
with the IEEE 802.3ad standard.
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LACP operating notes and restrictions

802.1X (Port-based access control) configured on a port
To maintain security, LACP is not allowed on ports configured for 802.1X authenticator operation. If you configure
port security on a port on which LACP (active or passive) is configured, the switch removes the LACP
configuration, displays a notice that LACP is disabled on the port, and enables 802.1X on that port.

switch# aaa port-access authenticator b1
LACP has been disabled on 802.1x port(s.) 
switch#
The switch does not allow you to configure LACP on a port on which port access (802.1X) is enabled. For
example:

switch# int b1 lacp passive 
Error configuring port  port-number  : LACP and 802.1x cannot 
be run together. 
switch#
To restore LACP to the port, you must first remove the 802.1X configuration of the port and then re-enable LACP
active or passive on the port.

Port security
To maintain security, LACP is not allowed on ports configured for port security. If you configure port security on a
port on which LACP (active or passive) is configured, the switch removes the LACP configuration, displays a
notice that LACP is disabled on the port, and enables port security on that port. For example:

switch# port-security a17 learn-mode static address-
limit 2 LACP has been disabled on secured port(s.)
switch#
The switch does not allow you to configure LACP on a port on which port security is enabled. For example:

switch# int a17 lacp passive
Error configuring port A17: LACP and port security cannot be
run together.
switch#
To restore LACP to the port, you must remove port security and re-enable LACP active or passive.

Changing trunking methods
To convert a trunk from static to dynamic, you must first eliminate the static trunk.

Static LACP trunks
When a port is configured for LACP (active or passive), but does not belong to an existing trunk group, you can
add that port to a static trunk. Doing so disables dynamic LACP on that port, which means you must manually
configure both ends of the trunk.

NOTE:

Static LACP allows ports with different speed to be part of the same trunk.
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Dynamic LACP trunks
You can configure a port for LACP-active or LACP-passive, but on a dynamic LACP trunk you cannot configure
the other options that you can on static trunks. If you want to manually configure a trunk, use the trunk
command. (See "Using the CLI To Configure a Static or Dynamic Trunk Group")

VLANs and dynamic LACP
A dynamic LACP trunk operates only in the default VLAN (unless you have enabled GVRP on the switch and use
Forbid to prevent the ports from joining the default VLAN.)

If you want to use LACP for a trunk on a non-default VLAN and GVRP is disabled, configure the trunk as a static
trunk.

Blocked ports with older devices.
Some older devices are limited to four ports in a trunk. When eight LACP-enabled ports are connected to one of
these older devices, four ports connect, but the other four ports are blocked. The LACP status of the blocked
ports is shown as "Failure."

If one of the other ports becomes disabled, a blocked port replaces it (Port Status becomes "Up".) When the other
port becomes active again, the replacement port goes back to blocked (Port Status is "Blocked".) It can take a few
seconds for the switch to discover the current status of the ports.

Figure 38: Blocked ports with LACP
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If there are ports that you do not want on the default VLAN, ensure that they cannot become dynamic LACP trunk
members. Otherwise a traffic loop can unexpectedly occur. For example:

Figure 39: A dynamic LACP trunk forming in a VLAN can cause a traffic loop

Easy control methods include either disabling LACP on the selected ports or configuring them to operate in static
LACP trunks.

Spanning Tree and IGMP
If Spanning Tree, IGMP, or both are enabled in the switch, a dynamic LACP trunk operates only with the default
settings for these features and does not appear in the port listings for these features.

Half-duplex, different port speeds, or both not allowed in LACP trunks
Theports on both sides of an LACP trunk must be configured for the same speed and for full-duplex (FDx.) The
802.3ad LACP standard specifies a full-duplex (FDx) requirement for LACP trunking. (10-gigabit ports operate
only at FDx.)

A port configured as LACP passive and not assigned to a port trunk can be configured to half-duplex (HDx.)
However, in any of the following cases, a port cannot be reconfigured to an HDx setting:

• If the port is a 10-gigabit port.

• If a port is set to LACP Active, you cannot configure it to HDx.

• If a port is already a member of a static or dynamic LACP trunk, you cannot configure it to HDx.

• If a port is already set to HDx, the switch does not allow you to configure it for a static or dynamic LACP trunk.

Dynamic/static LACP interoperation
A port configured for dynamic LACP can properly interoperate with a port configured for static (TrkX) LACP, but
any ports configured as standby LACP links are ignored.

Trunk group operation using the "trunk" option
This method creates a trunk group that operates independently of specific trunking protocols and does not use a
protocol exchange with the device on the other end of the trunk. With this choice, the switch simply uses the
SA/DA method of distributing outbound traffic across the trunked ports without regard for how that traffic is
handled by the device at the other end of the trunked links. Similarly, the switch handles incoming traffic from the
trunked links as if it were from a trunked source.

When a trunk group is configured with the trunk option, the switch automatically sets the trunk to a priority of "4"
for Spanning Tree operation (even if Spanning Tree is currently disabled.) This appears in the running-config file
as spanning-tree Trkn priority 4. Executing write memory after configuring the trunk places the same
entry in the startup-config file.
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Use the trunk option to establish a trunk group between a switch and another device, where the other device's
trunking operation fails to operate properly with LACP trunking configured on the switches.

Viewing trunk data on the switch
Static trunk group

Appears in the menu interface and the output from the CLI show trunk and show interfaces
commands.

Dynamic LACP trunk group

Appears in the output from the CLI show lacp command.

Interface option Dynamic LACP trunk
group

Static LACP trunk
group

Static non-protocol

Menu interface No Yes Yes

CLI show trunk No Yes Yes

CLI show interfaces No Yes Yes

CLI show lacp Yes Yes No

CLI show spanning-tree No Yes Yes

CLI show igmp No Yes Yes

CLI show config No Yes Yes

Outbound traffic distribution across trunked links
The two trunk group options (LACP and trunk) use SA/DA pairs for distributing outbound traffic over trunked links.
That is, the switch sends traffic from the same source address to the same destination address through the same
trunked link, and may also send traffic from the same source address to a different destination address through
the same link or a different link, depending on the mapping of path assignments among the links in the trunk.
Likewise, the switch distributes traffic for the same destination address but from different source addresses
through links depending on the path assignment.

The load-balancing is done on a per-communication basis. Otherwise, traffic is transmitted across the same path.
That is, if Client A attached to Switch 1 sends five packets of data to Server A attached to Switch 2, the same link
is used to send all five packets. The SA/DA address pair for the traffic is the same. The packets are not evenly
distributed across any other existing links between the two switches; they all take the same path.

Figure 40: Example of single path traffic through a trunk

The actual distribution of the traffic through a trunk depends on a calculation using bits from the SA/DA. When an
IP address is available, the calculation includes the last five bits of the IP source address and IP destination
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address; otherwise, the MAC addresses are used. The result of that process undergoes a mapping that
determines which link the traffic goes through. If you have only two ports in a trunk, it is possible that all the traffic
will be sent through one port even if the SA/DA pairs are different. The more ports you have in the trunk, the more
likely it is that the traffic will be distributed among the links.

When a new port is added to the trunk, the switch begins sending traffic, either new traffic or existing traffic,
through the new link. As links are added or deleted, the switch redistributes traffic across the trunk group.

Figure 41: Example of port-trunked network

Table 13: Example of link assignments in a trunk group (SA/DA distribution)

Source Destination Link

Node A Node W 1

Node B Node X 2

Node C Node Y 3

Node D Node Z 1

Node A Node Y 2

Node B Node W 3

Because the amount of traffic coming from or going to various nodes in a network can vary widely, it is possible
for one link in a trunk group to be fully utilized while other links in the same trunk have unused bandwidth capacity,
even if the assignments were evenly distributed across the links in a trunk.

Trunk load balancing using Layer 4 ports
Trunk load balancing using Layer 4 ports allows the use of TCP/UDP source and destination port number for trunk
load balancing. This is in addition to the current use of source and destination IP address and MAC addresses.
Configuration of Layer 4 load balancing would apply to all trunks on the switch. Only non-fragmented packets will
have their TCP/UDP port number used by load balancing. This ensures that all frames associated with a
fragmented IP packet are sent through the same trunk on the same physical link.

The priority for using Layer 4 packets when this feature is enabled is as follows:

1. If the packet protocol is an IP packet and has Layer 4 port information, use Layer 4.

2. If the packet protocol is an IP packet and does not have Layer 4 information, use Layer 3 information.

3. If the packet is not an IP packet, use Layer 2 information.

Distributed trunking overview
The IEEE standard 802.3ad requires that all links in a trunk group originate from the same switch. Distributed
trunking uses a proprietary protocol that allows two or more port trunk links distributed across two switches to
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create a trunk group. The grouped links appear to the downstream device as if they are from a single device. This
allows third party devices such as switches, servers, or any other networking device that supports trunking to
interoperate with the distributed trunking switches (DTSs) seamlessly. Distributed trunking provides device-level
redundancy in addition to link failure protection.

DTSs are connected by a special interface called the InterSwitch-Connect (ISC) port. This interface exchanges
information so that the DTSs appear as a single switch to a downstream device, as mentioned above. Each
distributed trunk (DT) switch in a DT pair must be configured with a separate ISC link and peer-keepalive link. The
peer-keepalive link is used to transmit keepalive messages when the ISC link is down to determine if the failure is
a link-level failure or the complete failure of the remote peer.

The downstream device is a distributed trunking device (DTD.) The DTD forms a trunk with the DTSs. The
connecting links are DT links and the ports are DT ports. A distributed trunk can span a maximum of two
switches.

IMPORTANT: Before you configure the switch, Hewlett Packard Enterprise recommends that you
review the Distributed trunking restrictions on page 217 for a complete list of operating notes and
restrictions.

NOTE: DT is not supported between different platforms. The generic application of the DT protocol
across series is not supported. For example:

DT is not supported between an Aruba 3810M switch and an Aruba 5400R switch.

You can group together distributed trunks by configuring two individual dt-lacp/dt-trunk trunks with the same trunk
group name in each switch. The DT ports are grouped dynamically after the configuration of distributed trunking.

NOTE: Before you configure the switch, Hewlett Packard Enterprise recommends that you review
the Distributed trunking restrictions on page 217 for a complete list of operating notes and
restrictions.

In Figure 42: Example of distributed trunking with three different distributed trunks with three servers on
page 209, three different distributed trunks with three different servers have one common ISC link. Each trunk
spans only two DTSs, which are connected at the ISC ports so they can exchange information that allows them to
appear as one device to the server.

Figure 42: Example of distributed trunking with three different distributed trunks with three servers
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An example of distributed trunking switch-to-switch in a square topology is shown in Figure 43: Distributed
trunking switch-to-switch square topology on page 210.

Figure 43: Distributed trunking switch-to-switch square topology

Distributed trunking interconnect protocol
Distributed trunking uses the distributed trunking interconnect protocol (DTIP) to transfer DT-specific configuration
information for the comparison process and to synchronize MAC and DHCP snooping binding data between the
two DT peer switches.

NOTE:

For DHCP snooping to function correctly in a DT topology, the system time must be the same on
both switches, and the ISC must be trusted for DHCP snooping.

Configuring distributed trunking
The following parameters must be configured identically on the peer devices or undesirable behavior in traffic flow
may occur:

• The ISC link must have a VLAN interface configured for the same VLAN on both DT switches.

• VLAN membership for all DT trunk ports should be the same on both DT switches in a DT pair.
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• IGMP-snooping or DHCP-snooping configuration on a DT VLAN should be the same on both DT switches. For
example, for a DT, if IGMP-snooping or DHCP-snooping is enabled on a VLAN that has a DT port as a
member port of the VLAN, the same must be configured on the peer DT on the same VLAN.

• Loop-protection configuration on a DT VLAN should be the same for both DT switches.

Configuring peer-keepalive links
Distributed trunking uses UDP-based peer-keepalive messages to determine if an ISC link failure is at the link
level or the peer has completely failed. The following operating rules must be followed to use peer-keepalive links:

• An IP address must be configured for a peer-keepalive VLAN interface and the same IP address must be
configured as a peer-keepalive destination on the peer DT switch.

• There must be logical Layer 3 connectivity between the two IP addresses configured for the peer-keepalive
VLAN interface.

• Only peer-keepalive messages are sent over the peer-keepalive VLAN (Layer 3 link.) These messages
indicate that the DT switch from which the message originates is up and running. No data or synchronization
traffic is sent over the peer-keepalive VLAN.

• STP cannot run on peer-keepalive links.

• The peer-keepalive VLAN can have only one member port. If you attempt to assign a second member port to
this VLAN, or if you attempt to configure a VLAN that has more than one member port as a peer-keepalive
VLAN, this message displays:

A keepalive VLAN can only have one member port.
• A port cannot be a member of a regular VLAN and a peer-keepalive VLAN. An error message displays:

A port cannot simultaneously be a member of a keepalive and a non-keepalive VLAN.

• The DEFAULT VLAN cannot be a peer-keepalive VLAN. An error message displays:

The default VLAN cannot be configured as a keepalive VLAN.

NOTE: If you are upgrading your software from a version prior to K.15.05.xxxxx with a configuration
that violates any of the above operating rules, the following message displays:

DT: Keepalive mis-configuration detected. Reconfigure the keepalive VLAN.
You must then manually correct the configuration.
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DT switches have an operational role that depends on the system MAC address. The bridge with the lowest
system MAC address acts as the DT primary device; the other device is the DT secondary device. These roles
are used to determine which device forwards traffic when the ISC link is down.

Figure 44: ISC link failure with peer-keepalive

Peer-keepalive messages are sent by both the DT switches as soon as the switches detect that the ISC link is
down. Peer-keepalive message transmission (sending and receiving) is suspended until the peer-keepalive hold
timer expires. When the hold timer expires, the DT switches begin sending peer-keepalive messages periodically
while receiving peer-keepalive messages from the peer switch. If the DT switch fails to receive any peer-keepalive
messages for the timeout period, it continues to forward traffic, assuming that the DT peer switch has completely
failed.

Conversely, if the failure is because the ISC link went down and the secondary DT switch receives even one peer-
keepalive message from the primary peer, the secondary switch disables all its DT ports. The primary switch
always forwards the traffic on its DT ports even if it receives peer-keepalive messages from the secondary DT
switch.

In both situations, if the ISC link or the DT switch becomes operational, both the DT peers sync the MAC
addresses learned during the failover and continue to forward traffic normally. The peer-keepalive timers and
operation is halted.

Maximum DT trunks and links supported
Table 14: Maximum supported DT trunks and links

Description Max number

Maximum number of groups (DT trunks) in a DT switch (that is, maximum number of
servers supported)

144

Maximum number of switches that can be aggregated 2

Maximum number of physical links that can be aggregated in a single switch from a
server (that is, maximum number of ports that can be in a trunk connected to a single
switch)

4
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From the server perspective, this means that there could be a maximum total of 60 servers connected to two DT
switches. Each server can have up to four physical links aggregated in a single switch, meaning that a single
server could have a maximum of eight links (that is, four on each DT switch) in a DT trunk.

Forwarding traffic with distributed trunking and spanning tree
Refer to Figure 45: Distributed trunking with STP forwarding unicast, broadcast, and multicast traffic on
page 213 for the following discussion about forwarding traffic when spanning tree is enabled. In this example, it is
assumed that traffic is sent from a host off switch B to a server, and from the server back to the host. STP can
block any one of the upstream links; in this example, STP has blocked all the links except the I1 link connected to
DT1.

NOTE:

STP is automatically disabled on the DT ports.

Figure 45: Distributed trunking with STP forwarding unicast, broadcast, and multicast traffic

Forwarding unicast traffic
Refer to Figure 46: Unicast traffic flow across DT switches on page 214 for the following discussion about
forwarding traffic with switch-to-switch distributed trunking. Traffic from Host X or Y that is destined for Host F is
always forwarded by Switch A over one of its standard 802.1AX trunk links to either Switch B or Switch C. When
either Switch B or Switch C receives incoming traffic from Switch A, the traffic is directly forwarded to Switch F
without traversing the ISC link.
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Traffic from Host Y to Host D may go over the ISC if Switch A sends it to Switch C instead of sending it to Switch
B.

Figure 46: Unicast traffic flow across DT switches

Forwarding broadcast, multicast, and unknown traffic
In the example shown in Figure 47: Broadcast/multicast/unknown traffic flow access DT switches on page
215, multicast/broadcast/unknown traffic from Host X or Y is always forwarded by Switch A over one of its
standard 802.3ad trunk links to either Switch B or C. Switch B or C forwards the traffic on all the links including the
ISC port, but not on the port that the traffic was received on. The peer DT switch (B or C) that receives broadcast/
multicast/unknown traffic over the ISC port does not forward the packets to any of the DT trunks; the packet is
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sent only over the non-DT ports. The one exception is if the DT trunk on the peer aggregation device is down,
then traffic received over the ISC is forwarded to the corresponding DT trunk.

Figure 47: Broadcast/multicast/unknown traffic flow access DT switches

IP routing and distributed trunking
In switch-to-switch distributed trunking, the peer DT switches behave like independent Layer 3 devices with their
own IP addresses in each active VLAN. If a DT switch receives a packet destined for the peer DT switch, it
switches the packet through the ISC link. Interfaces on a VLAN using DT typically use a single default gateway
pointing to only one of the DT switches in a DT pair.

The example in the following figure shows Layer 3 (IP unicast) forwarding in a DT topology. The packet is sent as
follows:
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1. Switch A selects the link (using the trunk hash) to the DT pair. The packet is sent to the selected link
DT_SW_1.

2. When DT_SW_1 receives the packet, it determines, based on the MAC address, that the packet must be sent
over the ISC link to DT_SW_2.

3. When the packet arrives, DT_SW_2 performs a lookup and determines that the packet needs to be sent to
Switch B.

Figure 48: Layer 3 forwarding (IP unicast) in DT topology

Another example in the next figure shows Layer 3 (IP unicast) forwarding in a DT topology. The packet is sent as
follows:

1. Host 2 sends a packet to Switch C.

2. Switch C performs a lookup in the routing table and determines that the default gateway IP address is
10.0.0.1.

3. Layer 2 lookup determines that the outgoing interface is the DT port.

4. Hashing determines that the trunk member chosen is DT_SW_2 and the packet is sent there.

5. DT_SW_2 determines that the packet needs to be sent over the ISC link to DT_SW_1 based on the MAC
address.

6. DT_SW_1 performs a lookup and determines that the packet goes to Switch A.
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The packet is only forwarded if the outgoing interface is not a DT port, or if the outgoing DT port does not have an
active interface on the peer switch.

Figure 49: Layer 3 forwarding (IP unicast) in DT topology

Distributed trunking restrictions
There are several restrictions with distributed trunking:

• Beginning with software version K.15.07, the switch will not allow both Distributed Trunking and MAC-based
mirroring to function simultaneously. The switch will respond as follows:

◦ If the user attempts to configure both, an error message will appear.

◦ When a switch is updated from older software to K.15.07, if the older config file has both Distributed
Trunking and MAC-based mirroring, the switch will automatically remove the MAC-based mirroring lines
from the config file, and will give an explanatory error message.

If a switch is running K.15.07 and an existing config file that has both Distributed Trunking and MAC-based
mirroring is loaded onto the switch, the switch will automatically remove the MAC-based mirroring lines from the
config file, and will give an explanatory error message.

• All DT linked switches must be running the same software version.

• The port trunk links should be configured manually (using manual LACP or manual trunks.) Dynamic linking
across switches is not supported.

• A distributed trunk can span a maximum of two switches.

• A maximum total of 144 servers can be connected to two DT switches. Each server can have up to four
physical links aggregated in a single switch, meaning that there can be a maximum of eight ports (four
aggregated links for each DT switch) included in a DT trunk.
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• Only one ISC link is supported per switch, with a maximum of 60 DT trunks supported on the switch. The ISC
link can be configured as a manual LACP trunk, non-protocol trunk, or as an individual link. Dynamic LACP
trunks are not supported as ISCs.

• An ISC port becomes a member of all VLANs that are configured on the switch. When a new VLAN is
configured, the ISC ports become members of that VLAN.

• Port trunk links can be done only on a maximum of two switches that are connected to a specific server.

• Any VLAN that is in a distributed trunk must be configured on both switches. By default, the distributed trunk
belongs to the default VLAN.

• There can be eight links in a distributed trunk grouped across two switches, with a limit of four links per
distributed trunking switch.

• The limit of 144 manual trunks per switch includes distributed trunks as well.

• ARP protection is not supported on the distributed trunks.

• Dynamic IP Lockdown protection is not supported on the distributed trunks.

• QinQ in mixed VLAN mode and distributed trunking are mutually exclusive.

• Source Port Filter cannot be configured on an InterSwitch Connect (ISC) port.

• Features not supported include:
◦ SVLANs in mixed mode on DT or ISC links

◦ Meshing

◦ IPv6 routing

Updating software versions with DT
For 15.14.x and later

Beginning with software release 15.14.x, when updating to a new software release on switches configured for DT
(Distributed Trunking) on LACP type trunks, you must update the DT partner with the lowest Base MAC address
first. When this partner returns to operation, then update the other partner. Use the show system command to
determine the base MAC address on a given switch.

From no DT Keepalive support to shared DT Keepalive support

When updating software from a version that does not support DT Keepalive (prior to version K.15.03) to a version
that supports shared DT keepalive (K.15.03 and greater), use the following procedure:

Procedure

1. Disable the ISC interface on both switches, and then upgrade the software. Assume a2 is configured as
switch-interconnect.

switch# int a2 disable
switch# write mem

2. Configure one of the existing uplink VLANs as a keepalive VLAN, and then configure the destination keepalive
IP address (peer’s keepalive IP address) on both switches at bootup.

switch# distributed-trunking
peer-keepalive vlan 2
switch# distributed-trunking
peer-keepalive destination 20.0.0.2
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3. Ping the keepalive destination address to make sure that there is connectivity between the two DT switches
(keepalive VLANs.)

4. Enable the ISC link on both switches and then execute write memory. Assume a2 is configured as switch-
interconnect.

switch# int a2 enable
switch# write mem

From no DT Keepalive support to dedicated point-to-point DT Keepalive support

When updating software from a software version that does not support DT keepalive (prior to version K.15.03) to
a version with dedicated point-to-point keepalive (K.15.03 and greater), use the following procedure:

• Disable the ISC interface on both switches, and then upgrade the software. Assume a2 is configured as
switch-interconnect.

switch# int a2 disable
switch# write mem

• At switch bootup, create a dedicated VLAN for keepalive, and assign only the keepalive link port as a member
port of the VLAN. Configure the keepalive destination IP address.

switch# distributed-trunking
peer-keepalive vlan 2
switch# distributed-trunking
peer-keepalive destination 20.0.0.2

• Ping the keepalive destination address to make sure that there is connectivity between the two DT switches
(keepalive VLANs.)

• Enable the ISC link on both switches, and then execute write memory. Assume a2 is configured as switch-
interconnect.

switch# int a2 enable
switch# write mem

From shared DT Keepalive support to point-to-point Keepalive support

When updating software from a software version that does support shared DT keepalive (K.15.03, K.15.04) to a
version that supports dedicated point-to-point keepalive (K.15.05), use the following procedure:

• Disable the ISC interface and undo the keepalive configuration on both switches. Ignore the warning message
that is displayed by the keepalive command while undoing the configuration. Upgrade the software. Assume
a2 is configured as switch-interconnect.

switch# int a2 disable
switch# no distributed-trunking
peer-keepalive vlan
switch# write mem

• At switch bootup, create a dedicated VLAN for keepalive and assign only the keepalive link port as a member
port of the VLAN. Configure the keepalive destination IP address.

switch# vlan 10 (dedicated point-to-point VLAN interface)
switch(vlan-10)#
switch(vlan-10)# untagged b2 (keepalive link port)
switch(vlan-10)# ip address 10.0.0.1/24
switch(vlan-10)# exit
switch# distributed-trunking
peer-keepalive vlan 10
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switch# distributed-trunking
peer-keepalive destination 10.0.0.2
            

• Ping the keepalive destination address to make sure that there is connectivity between the two DT switches
(keepalive VLANs.)

• Enable the ISC link on both switches, and then execute write memory. Assume a2 is configured as switch-
interconnect.

switch# int a2 enable
switch# write mem
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ICMP rate-limiting
In IP networks, ICMP messages are generated in response to either inquiries or requests from routing and
diagnostic functions. These messages are directed to the applications originating the inquiries. In unusual
situations, if the messages are generated rapidly with the intent of overloading network circuits, they can threaten
network availability. This problem is visible in denial-of-service (DoS) attacks or other malicious behaviors where a
worm or virus overloads the network with ICMP messages to an extent where no other traffic can get through.
(ICMP messages themselves can also be misused as virus carriers). Such malicious misuses of ICMP can
include a high number of ping packets that mimic a valid source IP address and an invalid destination IP address
(spoofed pings), and a high number of response messages (such as Destination Unreachable error messages)
generated by the network.

ICMP rate-limiting provides a method for limiting the amount of bandwidth that may be used for inbound ICMP
traffic on a switch port. This feature allows users to restrict ICMP traffic to percentage levels that permit necessary
ICMP functions, but throttle additional traffic that may be caused by worms or viruses (reducing their spread and
effect). In addition, ICMP rate-limiting preserves inbound port bandwidth for non-ICMP traffic.

CAUTION:

ICMP is necessary for routing, diagnostic, and error responses in an IP network. ICMP rate-limiting is
primarily used for throttling worm or virus-like behavior and should normally be configured to allow
one to five percent of available inbound bandwidth (at 10 Mbps or 100 Mbps speeds) or 100 to
10,000 kbps (1Gbps or 10 Gbps speeds) to be used for ICMP traffic. This feature should not be
used to remove all ICMP traffic from a network.

NOTE:

ICMP rate-limiting does not throttle non-ICMP traffic. In cases where you want to throttle both ICMP
traffic and all other inbound traffic on a given interface, you can separately configure both ICMP rate-
limiting and all-traffic rate-limiting.

The all-traffic rate-limiting command (rate-limit all) and the ICMP rate-limiting command
(rate-limit icmp) operate differently:

• All-traffic rate-limiting applies to both inbound and outbound traffic and can be specified either in
terms of a percentage of total bandwidth or in terms of bits per second;

• ICMP rate-limiting applies only to inbound traffic and can be specified as only a percentage of
total bandwidth.

Guidelines for configuring ICMP rate-limiting
Apply ICMP rate-limiting on all connected interfaces on the switch to effectively throttle excessive ICMP
messaging from any source. Figure 50: Example: of ICMP rate-limiting on page 222 shows an Example: of
how to configure this for a small to mid-sized campus though similar rate-limit thresholds are applicable to other
network environments. On edge interfaces, where ICMP traffic should be minimal, a threshold of 1% of available
bandwidth should be sufficient for most applications. On core interfaces, such as switch-to-switch and switch-to-
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router, a maximum threshold of 5% should be sufficient for normal ICMP traffic. ("Normal" ICMP traffic levels
should be the maximums that occur when the network is rebooting.)

Figure 50: Example: of ICMP rate-limiting

Configuring ICMP rate-limiting
For detailed information about ICMP rate-limiting, see ICMP rate-limiting on page 221.

The rate-limit icmp command controls inbound usage of a port by setting a limit on the bandwidth available
for inbound ICMP traffic.

Syntax:

[no] int <port-list> rate-limit icmp {< percent < 0-100 > | kbps < 0-10000000 > | [trap-clear>]}

Configures inbound ICMP traffic rate-limiting. You can configure a rate limit from either the global configuration
level (as shown above) or from the interface context level. The no form of the command disables ICMP rate-
limiting on the specified interfaces.

(Default: Disabled.)

percent <1-100> Values in this range allow ICMP traffic as a percentage of the bandwidth available
on the interface.

kbps <0-10000000> Specifies the rate at which to forward traffic in kilobits per second.

0 Causes an interface to drop all incoming ICMP traffic and is not recommended.
See the caution.

trap-clear Clears existing ICMP rate limiting trap condition.

Note: ICMP rate-limiting is not supported on meshed ports. (Rate-limiting can reduce the efficiency of paths
through a mesh domain).

Example:

Either of the following commands configures an inbound rate limit of 1% on ports A3 to A5, which are used as
network edge ports:

switch(config) # int a3-a5 rate-limit icmp 1
switch(eth-A3-A5) # rate-limit icmp 1
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NOTE: When using kbps-mode ICMP rate-limiting, the rate-limiting only operates on the IP payload
part of the ICMP packet (as required by metering RFC 2698). This means that effective metering is
at a rate greater than the configured rate, with the disparity increasing as the packet size decreases
(the packet to payload ratio is higher).

Also, in kbps mode, metering accuracy is limited at low values, For example, less than 45 Kbps. This
is to allow metering to function well at higher media speeds such as 10 Gbps.

For information on using ICMP rate-limiting and all-traffic rate-limiting on the same interface, seeUsing both
ICMP rate-limiting and all-traffic rate-limiting on the same interface on page 223.

Using both ICMP rate-limiting and all-traffic rate-limiting on the same
interface
ICMP and all-traffic rate-limiting can be configured on the same interface. All-traffic rate-limiting applies to all
inbound or outbound traffic (including ICMP traffic), while ICMP rate-limiting applies only to inbound ICMP traffic.

NOTE: If the all-traffic load on an interface meets or exceeds the currently configured all-traffic
inbound rate-limit while the ICMP traffic rate-limit on the same interface has not been reached, all
excess traffic is dropped, including any inbound ICMP traffic above the all-traffic limit (regardless of
whether the ICMP rate-limit has been reached).

Example:

Suppose:

• The all-traffic inbound rate-limit on port "X" is configured at 55% of the port's bandwidth.

• The ICMP traffic rate-limit on port "X" is configured at 2% of the port's bandwidth.

If at a given moment:

• Inbound ICMP traffic on port "X" is using 1% of the port's bandwidth, and

• Inbound traffic of all types on port "X" demands 61% of the ports's bandwidth,

all inbound traffic above 55% of the port's bandwidth, including any additional ICMP traffic, is dropped as long as
all inbound traffic combined on the port demands 55% or more of the port's bandwidth.

Viewing the current ICMP rate-limit configuration
The show rate-limit icmp command displays the per-interface ICMP rate-limit configuration in the running-
config file.

Syntax:

show rate-limit icmp [< port-list >]
Without [port-list], this command lists the ICMP rate-limit configuration for all ports on the switch.

With [port-list], this command lists the rate-limit configuration for the specified interfaces. This command operates
the same way in any CLI context

If you want to view the rate-limiting configuration on ports 1–6:
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Listing the rate-limit configuration

switch(config)# show rate-limit icmp 1-6

 Inbound ICMP Rate Limit Maximum Percentage

        |          Rate
  Port  | Mode     Limit
  ----- + -------- --------
  1     | Disabled Disabled
  2     | kbps     100
  3     | %        5
  4     | %        1
  5     | %        1
  6     | Disabled Disable
The show running command displays the currently applied setting for any interfaces in the switch configured for
all traffic rate-limiting and ICMP rate-limiting.

The show config command displays this information for the configuration currently stored in the startup-
config file. (Note that configuration changes performed with the CLI, but not followed by a write mem
command, do not appear in the startup-config file.)

Operating notes for ICMP rate-limiting
ICMP rate-limiting operates on an interface (per-port) basis to allow, on average, the highest expected amount of
legitimate, inbound ICMP traffic.

• Interface support: ICMP rate-limiting is available on all types of ports (other than trunk ports or mesh ports),
and at all port speeds configurable for the switch.

• Rate-limiting is not permitted on mesh ports: Either type of rate-limiting (all-traffic or ICMP) can reduce the
efficiency of paths through a mesh domain.

• ICMP percentage-based rate-limits are calculated as a percentage of the negotiated link speed: For
example, if a 100 Mbps port negotiates a link to another switch at 100 Mbps and is ICMP rate-limit configured
at 5%, the inbound ICMP traffic flow through that port is limited to 5 Mbps. Similarly, if the same port negotiates
a 10 Mbps link, it allows 0.5 Mbps of inbound traffic. If an interface experiences an inbound flow of ICMP traffic
in excess of its configured limit, the switch generates a log message and an SNMP trap (if an SNMP trap
receiver is configured).

• ICMP rate-limiting is port-based: ICMP rate-limiting reflects the available percentage of an interface's entire
inbound bandwidth. The rate of inbound flow for traffic of a given priority and the rate of flow from an ICMP
rate-limited interface to a particular queue of an outbound interface are not measures of the actual ICMP rate
limit enforced on an interface.

• Below-maximum rates: ICMP rate-limiting operates on a per-interface basis, regardless of traffic priority.
Configuring ICMP rate-limiting on an interface where other features affect inbound port queue behavior (such
as flow control) can result in the interface not achieving its configured ICMP rate-limiting maximum. For
example, in some situations with flow control configured on an ICMP rate-limited interface, there can be
enough "back pressure" to hold high-priority inbound traffic from the upstream device or application to a rate
that does not allow bandwidth for lower-priority ICMP traffic. In this case, the inbound traffic flow may not
permit the forwarding of ICMP traffic into the switch fabric from the rate-limited interface. (This behavior is
termed "head-of-line blocking" and is a well-known problem with flow-control.) In cases where both types of
rate-limiting (rate-limit all and rate-limit icmp) are configured on the same interface, this situation
is more likely to occur.

In another type of situation, an outbound interface can become oversubscribed by traffic received from multiple
ICMP rate-limited interfaces. In this case, the actual rate for traffic on the rate-limited interfaces may be lower
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than configured because the total traffic load requested to the outbound interface exceeds the interface's
bandwidth, and thus some requested traffic may be held off on inbound.

• Monitoring (mirroring) ICMP rate-limited interfaces: If monitoring is configured, packets dropped by ICMP
rate-limiting on a monitored interface are still forwarded to the designated monitor port. (Monitoring shows
what traffic is inbound on an interface, and is not affected by "drop" or "forward" decisions.)

• Optimum rate-limiting operation: Optimum rate-limiting occurs with 64-byte packet sizes. Traffic with larger
packet sizes can result in performance somewhat below the configured inbound bandwidth. This is to ensure
the strictest possible rate-limiting of all sizes of packets.

• Outbound traffic flow: Configuring ICMP rate-limiting on an interface does not control the rate of outbound
traffic flow on the interface.

ICMP rate-limiting trap and Event Log messages
If the switch detects a volume of inbound ICMP traffic on a port that exceeds the ICMP rate-limit configured for
that port, it generates one SNMP trap and one informational Event Log message to notify the system operator of
the condition. (The trap and Event Log message are sent within two minutes of when the event occurred on the
port.) For Example:

I 06/30/05 11:15:42 RateLim: ICMP traffic exceeded configured limit on port A1
These trap and Event Log messages provide an advisory that inbound ICMP traffic on a given interface has
exceeded the configured maximum. The additional ICMP traffic is dropped, but the excess condition may indicate
an infected host (or other traffic threat or network problem) on that interface. The system operator should
investigate the attached devices or network conditions further; the switch does not send more traps or Event Log
messages for excess ICMP traffic on the affected port until the system operator resets the port's ICMP trap
function.

The switch does not send more traps or Event Log messages for excess ICMP traffic on the affected port until the
system operator resets the port’s ICMP trap function. The reset can be done through SNMP from a network
management station or through the CLI with the trap-clear command option.

Syntax:

interface <port-list> rate-limit icmp trap-clear
On a port configured with ICMP rate-limiting, this command resets the ICMP trap function, which allows the switch
to generate a new SNMP trap and an Event Log message if ICMP traffic in excess of the configured limit is
detected on the port.

Example:

An operator noticing an ICMP rate-limiting trap or Event Log message originating with port 1 on a switch would
use the following command to reset the port to send a new message if the condition occurs again:

Switch(config)# interface 1 rate-limit icmp trap-clear

Determining the switch port number used in ICMP port reset commands
To enable excess ICMP traffic notification traps and Event Log messages, use the setmib command described
on ICMP rate-limiting trap and Event Log messages on page 225. The port number included in the command
corresponds to the internal number the switch maintains for the designated port and not the port's external
identity.

To match the port's external slot/number to the internal port number, use the walkmib ifDescr command, as
shown in the following example:
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Matching internal port numbers to external port numbers

switch# walkmib ifDescr
ifDescr.1 = 1
ifDescr.2 = 2
ifDescr.3 = 3
ifDescr.4 = 4
ifDescr.5 = 5
ifDescr.6 = 6
ifDescr.7 = 7
ifDescr.8 = 8
ifDescr.9 = 9
ifDescr.10 = 10
ifDescr.11 = 11
ifDescr.12 = 12
ifDescr.13 = 13
ifDescr.14 = 14
ifDescr.15 = 15
ifDescr.16 = 16
ifDescr.17 = 17
ifDescr.18 = 18
ifDescr.19 = 19
ifDescr.20 = 20
ifDescr.21 = 21
ifDescr.22 = 22
ifDescr.23 = 23
ifDescr.24 = 24
ifDescr.210 = Trk1
ifDescr.211 = Trk2
ifDescr.330 = DEFAULT_VLAN
ifDescr.4425 = Switch software loopback interface
ifDescr.4426 = Switch software loopback interface
.
.
.

Configuring inbound rate-limiting for broadcast and multicast traffic
You can configure rate-limiting (throttling) of inbound broadcast and multicast traffic on the switch, which helps
prevent the switch from being disrupted by traffic storms if they occur on the rate-limited port. The rate-limiting is
implemented as a percentage of the total available bandwidth on the port.

The rate-limit command can be executed from the global or interface context, for Example:

switch(config)# interface 3 rate-limit bcast in percent 10
or

switch(config)# interface 3
switch(eth-3)# rate-limit bcast in percent 10
Syntax:

rate-limit {< bcast | mcast >} in percent < 0-100 > 

Option
in percent <0-100>
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Also supports configuring limit in kbps

[no] rate-limit {<bcast | [mcast >]} in
Enables rate-limiting and sets limits for the specified inbound broadcast or multicast traffic. Only the amount of
traffic specified by the percent is forwarded.

Default: Disabled

If you want to set a limit of 50% on inbound broadcast traffic for port 3, you can first enter interface context for port
3 and then execute the rate-limit command, as shown in Inbound broadcast rate-limiting of 50% on port 3
on page 227. Only 50% of the inbound broadcast traffic will be forwarded.

Inbound broadcast rate-limiting of 50% on port 3

switch(config)# int 3
switch(eth-3)# rate-limit bcast in percent 50

switch(eth-3)# show rate-limit bcast
 Broadcast-Traffic Rate Limit Maximum %

  Port  | Inbound Limit Mode      Radius Override
  ----- + ------------- --------- ---------------
  1     | Disabled      Disabled  No-override
  2     | Disabled      Disabled  No-override
  3     | Disabled      %         No-override
  4     | Disabled      Disabled  No-override
  5     | Disabled      Disabled  No-override
If you rate-limit multicast traffic on the same port, the multicast limit is also in effect for that port, as shown in 
Inbound multicast rate-limiting of 20% on port 3 on page 227. Only 20% of the multicast traffic will be
forwarded.

Inbound multicast rate-limiting of 20% on port 3

switch(eth-3)# rate-limit mcast in percent 20
switch(eth-3)# show rate-limit mcast
 
 Multicast-Traffic Rate Limit Maximum %

  Port  | Inbound Limit Mode      Radius Override
  ----- + ------------- --------- ---------------
  1     | Disabled      Disabled  No-override
  2     | Disabled      Disabled  No-override
  3     | 20            %         No-override
  4     | Disabled      Disabled  No-override
To disable rate-limiting for a port enter the no form of the command, as shown in Disabling inbound multicast
rate-limiting for port 3 on page 227.

Disabling inbound multicast rate-limiting for port 3

switch(eth-3)# no rate-limit mcast in

switch(eth-3)# show rate-limit mcast
 
 Multicast-Traffic Rate Limit Maximum %

  Port  | Inbound Limit Mode      Radius Override
  ----- + ------------- --------- ---------------
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  1     | Disabled      Disabled  No-override
  2     | Disabled      Disabled  No-override
  3     | Disabled      Disabled  No-override
  4     | Disabled      Disabled  No-override

Operating Notes
The following information is displayed for each installed transceiver:

• Port number on which transceiver is installed.

• Type of transceiver.

• Product number — Includes revision letter, such as A, B, or C. If no revision letter follows a product number,
this means that no revision is available for the transceiver.

• Part number — Allows you to determine the manufacturer for a specified transceiver and revision number.

• For a non-Aruba switches installed transceiver, no transceiver type, product number, or part information is
displayed. In the Serial Number field, non-operational is displayed instead of a serial number.

• The following error messages may be displayed for a non-operational transceiver:

◦ Unsupported Transceiver. (SelfTest Err#060)
◦ This switch only supports revision B and above transceivers.
◦ Self test failure.
◦ Transceiver type not supported in this port.
◦ Transceiver type not supported in this software version.
◦ Not an Switch Transceiver.

Guaranteed minimum bandwidth (GMB)
GMB provides a method for ensuring that each of a given port's outbound traffic priority queues has a specified
minimum consideration for sending traffic out on the link to another device. This can prevent a condition where
applications generating lower-priority traffic in the network are frequently or continually "starved" by high volumes
of higher-priority traffic. You can configure GMB per-port and, in the case of the 2920 and 5400R switches, per
static trunk.

GMB operation
NOTE: Earlier software releases supported GMB configuration on a per-port basis. Beginning with
software release 15.18, the 2920 and 5400R switches also support GMB configuration on static
trunks. (GMB configuration is not supported on dynamic LACP or distributed (DT) trunks.

For application to static trunk interfaces (2920 and 5400r only), GMB enforcement is applied
individually to each port belonging to the trunk, and not to the trunk as a whole.

For any port, group of ports or, static trunks, you can use the default minimum bandwidth settings for each
outbound priority queue or a customized bandwidth profile. It is also possible to disable the feature entirely.

The switch services per-port outbound traffic in a descending order of priority; that is, from the highest priority to
the lowest priority. By default, each port (including each port in a static trunk) offers eight prioritized, outbound
traffic queues. Tagged VLAN traffic is prioritized according to the 802.1p priority the traffic carries. Untagged
VLAN traffic is assigned a priority of 0 (normal).
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Table 15: Per-port outbound priority queues

802.1p Priority settings in tagged VLAN packets1 Outbound priority queue for a given port

1 (low) 1

2 (low) 2

0 (normal) 3

3 (normal) 4

4 (medium) 5

5 (medium) 6

6 (high) 7

7 (high) 8

1 The switch processes outbound traffic from an untagged port at the "0" (normal) priority level.

You can use GMB to reserve a specific percentage of each port's available outbound bandwidth for each of the
eight priority queues. This means that regardless of the amount of high-priority outbound traffic on a port
(including each port in a static trunk), you can ensure that there will always be bandwidth reserved for lower-
priority traffic.

Since the switch services outbound traffic according to priority (highest to lowest), the highest-priority outbound
traffic on a given port automatically receives the first priority in servicing. Thus, in most applications, it is
necessary only to specify the minimum bandwidth you want to allocate to the lower priority queues. In this case,
the high-priority traffic automatically receives all unassigned bandwidth without starving the lower-priority queues.

Conversely, configuring a bandwidth minimum on only the high-priority outbound queue of a port or static trunk
(and not providing a bandwidth minimum for the lower-priority queues) is not recommended, because it may
"starve" the lower-priority queues.

NOTE: For a given port, when the demand on one or more outbound queues exceeds the minimum
bandwidth configured for those queues, the switch apportions unallocated bandwidth to these
queues on a priority basis. As a result, specifying a minimum bandwidth for a high-priority queue but
not specifying a minimum for lower-priority queues can starve the lower-priority queues during
periods of high demand on the high priority queue. For example, if a port or static trunk configured to
allocate a minimum bandwidth of 80% for outbound high-priority traffic experiences a demand above
this minimum, this burst starves lower-priority queues that do not have a minimum configured.
Normally, this will not altogether halt lower priority traffic on the network, but will likely cause delays
in the delivery of the lower-priority traffic.

The sum of the GMB settings for all outbound queues on a given port or static trunk cannot exceed
100%.

Impacts of QoS queue configuration on GMB operation
The section Configuring GMB for outbound traffic on page 230 assumes the ports on the switch offer eight
prioritized, outbound traffic queues. This may not always be the case, however, because the switch supports a
QoS queue configuration feature that allows you to reduce the number of outbound queues from eight (the
default) to four queues, or two.

Changing the number of queues affects the GMB commands (interface bandwidth-min and show
bandwidth output) such that they operate only on the number of queues currently configured. If the queues
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are reconfigured, the guaranteed minimum bandwidth per queue is automatically re-allocated according to the
following percentages:

Table 16: Default GMB percentage allocations per QoS queue configuration

802.1p priority 8 queues (default) 4 queues 2 queues

1 (lowest) 2% 10% 90%

2 3%

0 (normal) 30% 70%

3 10%

4 10% 10% 10%

5 10%

6 15% 10%

7 (highest) 20%

NOTE: For more information on queue configuration and the associated default minimum bandwidth
settings, see the "Quality of Service (QoS): managing bandwidth more effectively" in the advanced
traffic management guide for your switch.

Configuring GMB for outbound traffic
For any port, group of ports, or static trunk, you can configure either the default minimum bandwidth settings for
each outbound priority queue or a customized bandwidth allocation. For most applications, Hewlett Packard
Enterprise recommends configuring GMB with the same values on all ports on the switch so that the outbound
traffic profile is consistent for all outbound traffic. However, there may be instances where it may be advantageous
to configure special profiles on connections to servers or to the network infrastructure (such as links to routers,
other switches, or to the network core).

Syntax:

[no] int <port-list|trk_#> bandwidth-min output
Configures the default minimum bandwidth allocation for the outbound priority queue for each port or static trunk
in the <port-list|trk_#> . In the eight-queue configuration, the default values per priority queue are:

• Queue 1 (low priority): 2%

• Queue 2 (low priority): 3%

• Queue 3 (normal priority): 30%

• Queue 4 (normal priority): 10%

• Queue 5 (medium priority): 10%

• Queue 6 (medium priority): 10%

• Queue 7 (high priority): 15%

• Queue 8 (high priority): 20%

The no form of the command disables GMB for all ports and trunks in the <port-list> . In this state, which is
the equivalent of setting all outbound queues on a port or static trunk to 0 (zero), a high level of higher-priority
traffic can starve lower-priority queues, which can slow or halt lower-priority traffic in the network.
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You can configure bandwidth minimums from either the global configuration level (as shown above) or from the
port or static trunk context level. For information on outbound port queues, see Per-port outbound priority
queues.

Syntax:

[no] int <<port-list|trk_#>> bandwidth-min output [0-100|strict] [0-100]
Select a minimum bandwidth.

For ports and trunks in <port-list|trk_#> , specifies the minimum outbound bandwidth as a percent of the
total bandwidth for each outbound queue. The queues receive service in descending order of priority of each port.

NOTE: For application to static trunk interfaces (2920 and 5400R only), GMB enforcement is applied
individually to each port belonging to the trunk, and not to the trunk as a whole.

You must specify a bandwidth percent value for all except the highest priority queue, which may instead be set to
"strict" mode. The sum of the bandwidth percentages below the top queue cannot exceed 100%. (0 is a value for
a queue percentage setting.)

Configuring a total of less than 100% across the eight queues results in unallocated bandwidth that remains
harmlessly unused unless a given queue becomes oversubscribed. In this case, the unallocated bandwidth is
apportioned to oversubscribed queues in descending order of priority. For example, if you configure a minimum of
10% for queues 1 to 7 and 0% for queue 8, the unallocated bandwidth is available to all eight queues in the
following prioritized order:

Queue 8 (high priority)
Queue 7 (high priority)
Queue 6 (medium priority)
Queue 5 (medium priority)
Queue 4 (normal priority)
Queue 3 (normal priority)
Queue 2 (low priority)
Queue 1 (low priority)

A setting of 0 (zero percent) on a queue means that no bandwidth minimum is specifically reserved for that queue
for each of the ports (including trunked ports) in the <port-list|trk_#> .

Also, there is no benefit to setting the high-priority queue (queue 8) to 0 (zero) unless you want the medium
queue (queues 5 and 6) to be able to support traffic bursts above its guaranteed minimum.

[strict]: Provides the ability to configure the highest priority queue as strict. Per-queue values must be
specified in priority order, with queue 1 having the lowest priority and queue 8 (or 4, or 2) having the highest
priority (the highest queue is determined by how many queues are configured on the switch. Two, four, and eight
queues are permitted (see the qos queue-config command). The strict queue is provided all the bandwidth it
needs. Any remaining bandwidth is shared among the non-strict queues based on need and configured
bandwidth profiles (the profiles are applied to the leftover bandwidth in this case). The total sum of percentages
for non-strict queues must not exceed 100.

NOTE: Configuring 0% for a queue can result in that queue being starved if any higher queue
becomes over-subscribed and is then given all unused bandwidth.

The switch applies the bandwidth calculation to the link speed the port or trunk is currently using. For
example, if a 10/100 Mbs port negotiates to 10 Mbps on the link, it bases its GMB calculations on 10
Mbps, not 100 Mbps.

Use show bandwidth output <<port-list|trk_#>> to display the current GMB
configuration. (The show config and show running commands do not include GMB
configuration data.)
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Example:

For example, suppose you want to configure the following outbound minimum bandwidth availability for ports 1
and 2:

Priority of
outbound port
queue

Minimum
bandwidth %

Effect on outbound bandwidth allocation

8 20% Queue 8 has the first priority use of all outbound bandwidth not
specifically allocated to queues 1 to 7.

If, For example, bandwidth allocated to queue 5 is not being used
and queues 7 and 8 become oversubscribed, queue 8 has first-
priority use of the unused bandwidth allocated to queue 5.

7 15% Queue 7 has a GMB of 15% available for outbound traffic. If queue
7 becomes oversubscribed and queue 8 is not already using all of
the unallocated bandwidth, queue 7 can use the unallocated
bandwidth.

Also, any unused bandwidth allocated to queues 6 to queue 1 is
available to queue 7 if queue 8 has not already claimed it.

6 10% Queue 6 has a GMB of 10% and, if oversubscribed, is subordinate
to queues 8 and 7 in priority for any unused outbound bandwidth
available on the port.

5 10% Queue 5 has a GMB of 10% and, if oversubscribed, is subordinate
to queues 8, 7, and 6 for any unused outbound bandwidth
available on the port.

4 10% Queue 4 has a GMB of 10% and, if oversubscribed, is subordinate
to queues, 8, 7, 6, and 5 for any unused outbound bandwidth
available on the port.

3 30% Queue 3 has a GMB of 30% and, if oversubscribed, is subordinate
to queues, 8, 7, 6, 5, and 4 for any unused outbound bandwidth
available on the port.

2 3% Queue 2 has a GMB of 3% and, if oversubscribed, is subordinate
to queues, 8, 7, 6, 5, 4, and 3 for any unused outbound bandwidth
available on the port.

1 2% Queue 1 has a GMB of 2% and, if oversubscribed, is subordinate
to all the other queues for any unused outbound bandwidth
available on the port.

Either of the following commands configures ports 1 through 5 with bandwidth settings:

Switch(config) # int 1-5 bandwidth-min output 2 3 30 10 10 10 15 strict
Switch(interface 1–5) # bandwidth-min output 2 3 30 10 10 10 15 strict

Viewing the current GMB configuration
This command displays the per-port GMB configuration in the running-config file.
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Syntax:

show bandwidth output <port-list|trk_#>
Without <port-list|trk_#> , this command lists the GMB configuration for all ports and static trunks on the
switch.

With <port-list|trk_#> , this command lists the GMB configuration for the specified ports and static trunks.

This command operates the same way in any CLI context. If the command lists Disabled for a port or trunk,
there are no bandwidth minimums configured for any queue on the port or trunk. (See the description of the no
form of the bandwidth-min output command.)

Listing the GMB configuration on page 233 displays the GMB configuration resulting from either of the above
commands.

Listing the GMB configuration

switch(config)# show bandwidth output 1-5, trk1
 Outbound Guaranteed Minimum Bandwidth %
  Port   Q1  Q2     Q3  Q4     Q5  Q6  Q7  Q8
  ------ --- ------ --- ------ --- --- --- ------
  1      2   3      30  10     10  10  15  strict
  2      2   3      30  10     10  10  15  strict
  3      2   3      30  10     10  10  15  strict
  4      2   3      30  10     10  10  15  strict
  5      2   3      30  10     10  10  15  strict
  Trk1   2   3      30  10     10  10  15  strict

GMB operating notes

Impact of QoS queue configuration on GMB commands
Changing the number of queues causes the GMB commands (interface bandwidth-min and show
bandwidth output) to operate only on the number of queues currently configured. In addition, when the qos
queue-config command is executed, any previously configured bandwidth-min output settings are
removed from the startup configuration. For the default GMB percentage allocations per number of queues, see 
Default GMB percentage allocations per QoS queue configuration.

Rate-limiting Unknown Unicast Traffic
Unknown unicast traffic consists of unicast packets with unknown destination MAC addresses. The switch floods
the unicast packets to all interfaces that are members of the VLAN. An attacker can bring down the network by
sending out packets to random destination MAC addresses and hence it is important to rate limit traffic with
unknown destination addresses.

You can rate limit the unknown unicast traffic per port level in either percent or kbps mode.

rate-limit unknown-unicast in percent
Syntax
interface port-list rate-limit unknown-unicast in percent 0-100

Description

Sets a rate limit for unicast flood traffic.
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Command context
interface

Parameters
in

Sets a rate limit for incoming unicast flood traffic.

percent
Specifies the rate limit as a percentage of the total available bandwidth.

kbps
Specifies the rate limit in Kb/s.

Examples

switch(config)# int 2
switch(eth-2)# rate-limit
all                   Set a rate limit for all traffic.
bcast                 Set a rate limit for broadcast traffic.
icmp                  Set a rate limit for ICMP traffic.
mcast                 Set a rate limit for multicast traffic.
queues                Set a rate limit for each traffic queue.
unknown-unicast       Set a rate limit for unicast flood traffic.
switch(eth-2)# rate-limit unknown-unicast
in                    Set a rate limit for incoming unicast flood traffic.
switch(eth-2)# rate-limit unknown-unicast in
kbps
percent
switch(eth-2)# rate-limit unknown-unicast in percent 10
switch(eth-2)# show rate-limit
 bcast                 Show broadcast traffic rate limits.
 icmp                  Show ICMP traffic rate limits.
 mcast                 Show multicast traffic rate limits.
 queues                Show limits for outgoing queue traffic.
 unknown-unicast       Show unicast flood traffic rate limits.
switch(eth-2)# show rate-limit unknown-unicast
 [ethernet] PORT-LIST  The ports to show information for.

switch(eth-2)# show rate-limit unknown-unicast 2

 Unknown-Unicast Traffic Rate Limit Maximum %

  Port  | Inbound Limit Mode
  ----- + ------------- ---------
  2     | 10            %

rate-limit unknown-unicast in kbps
Syntax
interface port-list rate-limit unknown-unicast in kbps rate

Description

Sets a rate limit for unicast flood traffic.

Command context
interface
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Parameters
in

Sets a rate limit for incoming unicast flood traffic.

percent
Specifies the rate limit as a percentage of the total available bandwidth.

kbps
Specifies the rate limit in Kb/s.

Examples

switch(config)# int 1
switch(eth-1)# rate-limit
all                   Set a rate limit for all traffic.
bcast                 Set a rate limit for broadcast traffic.
icmp                  Set a rate limit for ICMP traffic.
mcast                 Set a rate limit for multicast traffic.
queues                Set a rate limit for each traffic queue.
unknown-unicast       Set a rate limit for unicast flood traffic.
switch(eth-1)# rate-limit unknown-unicast
in                    Set a rate limit for incoming unicast flood traffic.
switch(eth-1)# rate-limit unknown-unicast  in
kbps
percent
switch(eth-1)# rate-limit unknown-unicast  in kbps 100
switch(eth-1)# show rate-limit
all                   Show total traffic rate limits.
bcast                 Show broadcast traffic rate limits.
icmp                  Show ICMP traffic rate limits.
mcast                 Show multicast traffic rate limits.
queues                Show limits for outgoing queue traffic.
unknown-unicast       Show unicast flood traffic rate limits.
switch(eth-1)# show rate-limit unknown-unicast

Unknown-Unicast Traffic Rate Limit Maximum %

  Port  | Inbound Limit Mode
  ----- + ------------- ---------
  1     | 100            kbps
  2     | Disabled      Disabled
  3     | Disabled      Disabled
  4     | Disabled      Disabled
  5     | Disabled      Disabled
  6     | Disabled      Disabled
  7     | Disabled      Disabled
  8     | Disabled      Disabled
  9     | Disabled      Disabled
  10    | Disabled      Disabled
  11    | Disabled      Disabled
  12    | Disabled      Disabled
  13    | Disabled      Disabled
  14    | Disabled      Disabled
  15    | Disabled      Disabled
  16    | Disabled      Disabled

show rate-limit unknown-unicast
Syntax
show rate-limit unknown-unicast
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Description

Displays the per port rate limit configuration.

Command context
interface

Parameters
ethernet <port-list>

To view the rate limit configuration for the specified port.

Examples

switch(eth-2)# show rate-limit unknown-unicast

 Unknown-Unicast Traffic Rate Limit Maximum %

  Port  | Inbound Limit Mode
  ----- + ------------- ---------
  1     | 10            kbps
  2     | 10            %
  3     | Disabled      Disabled
  4     | Disabled      Disabled
  5     | Disabled      Disabled
  6     | Disabled      Disabled
  7     | Disabled      Disabled
  8     | Disabled      Disabled
  9     | Disabled      Disabled
  10    | Disabled      Disabled
  11    | Disabled      Disabled
  12    | Disabled      Disabled
  13    | Disabled      Disabled
  14    | Disabled      Disabled
  15    | Disabled      Disabled
  16    | Disabled      Disabled
  17    | Disabled      Disabled
  18    | Disabled      Disabled

Jumbo frames
The maximum transmission unit(MTU) is the maximum size IP frame the switch can receive for Layer 2 frames
inbound on a port. The switch drops any inbound frames larger than the MTU allowed on the port. Ports operating
at a minimum of 1 Gbps can accept forward frames of up to 9220 bytes (including four bytes for a VLAN tag)
when configured for jumbo traffic. You can enable inbound jumbo frames on a per-VLAN basis. That is, on a
VLAN configured for jumbo traffic, all ports belonging to that VLAN and operating at a minimum of 1 Gbps allow
inbound jumbo frames of up to 9220 bytes.

Operating rules
• Required port speed: This feature allows inbound and outbound jumbo frames on ports operating at a

minimum of 1 Gbps.

• GVRP operation: A VLAN enabled for jumbo traffic cannot be used to create a dynamic VLAN. A port
belonging to a statically configured, jumbo-enabled VLAN cannot join a dynamic VLAN.

• Port adds and moves: If you add a port to a VLAN that is already configured for jumbo traffic, the switch
enables that port to receive jumbo traffic. If you remove a port from a jumbo-enabled VLAN, the switch
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disables jumbo traffic capability on the port only if the port is not currently a member of another jumbo-enabled
VLAN. This same operation applies to port trunks.

• Jumbo traffic sources: A port belonging to a jumbo-enabled VLAN can receive inbound jumbo frames
through any VLAN to which it belongs, including non-jumbo VLANs. For example, if VLAN 10 (without jumbos
enabled) and VLAN 20 (with jumbos enabled) are both configured on a switch, and port 1 belongs to both
VLANs, port 1 can receive jumbo traffic from devices on either VLAN. For a method to allow only some ports in
a VLAN to receive jumbo traffic, see Configuring a maximum frame size on page 240.

Jumbo traffic-handling
• Configuring a voice VLAN to accept jumbo frames is not recommended. Voice VLAN frames are typically

small, and allowing a voice VLAN to accept jumbo frame traffic can degrade the voice transmission
performance.

• You can configure the default, primary, and/or (if configured) the management VLAN to accept jumbo frames
on all ports belonging to the VLAN.

• When the switch applies the default MTU (1522-bytes including 4 bytes for the VLAN tag) to a VLAN, all ports
in the VLAN can receive incoming frames of up to 1522 bytes. When the switch applies the jumbo MTU (9220
bytes including 4 bytes for the VLAN tag) to a VLAN, all ports in that VLAN can receive incoming frames of up
to 9220 bytes. A port receiving frames exceeding the applicable MTU drops such frames, causing the switch to
generate an Event Log message and increment the "Giant Rx" counter (displayed by show interfaces
<port-list> ).

• The switch allows flow control and jumbo frame capability to co-exist on a port.

• The default MTU is 1522 bytes (including 4 bytes for the VLAN tag). The jumbo MTU is 9220 bytes (including 4
bytes for the VLAN tag).

• When a port is not a member of any jumbo-enabled VLAN, it drops all jumbo traffic. If the port is receiving
"excessive"inbound jumbo traffic, the port generates an Event Log message to notify you of this condition. This
same condition also increments the switch's "Giant Rx" counter.

• If you do not want all ports in a given VLAN to accept jumbo frames, you can consider creating one or more
jumbo VLANs with a membership comprising only the ports you want to receive jumbo traffic. Because a port
belonging to one jumbo-enabled VLAN can receive jumbo frames through any VLAN to which it belongs, this
method enables you to include both jumbo-enabled and non-jumbo ports within the same VLAN.

For example, suppose you want to allow inbound jumbo frames only on ports 6, 7, 12, and 13. However, these
ports are spread across VLAN 100 and VLAN 200 and also share these VLANs with other ports you want
excluded from jumbo traffic. A solution is to create a third VLAN with the sole purpose of enabling jumbo traffic
on the desired ports, while leaving the other ports on the switch disabled for jumbo traffic. That is:

VLAN 100 VLAN 200 VLAN 300

Ports 6-10 11-15 6, 7, 12, and 13

Jumbo-enabled? No No Yes

If there are security concerns with grouping the ports as shown for VLAN 300, you can either use source-port
filtering to block unwanted traffic paths or create separate jumbo VLANs, one for ports 6 and 7, and another for
ports 12 and 13.

• Outbound jumbo traffic. Any port operating at 1 Gbps or higher can transmit outbound jumbo frames through
any VLAN, regardless of the jumbo configuration. The VLAN is not required to be jumbo-enabled, and the port
is not required to belong to any other, jumbo-enabled VLANs. This can occur in situations where a non-jumbo
VLAN includes some ports that do not belong to another, jumbo-enabled VLAN and some ports that do belong
to another, jumbo-enabled VLAN. In this case, ports capable of receiving jumbo frames can forward them to
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the ports in the VLAN that do not have jumbo capability, as shown in Figure 51: Forwarding jumbo frames
through non-jumbo ports on page 238.

Figure 51: Forwarding jumbo frames through non-jumbo ports

Jumbo frames can also be forwarded out non-jumbo ports when the jumbo frames received inbound on a
jumbo-enabled VLAN are routed to another, non-jumbo VLAN for outbound transmission on ports that have no
memberships in other, jumbo-capable VLANs. Where either of the above scenarios is a possibility, the
downstream device must be configured to accept the jumbo traffic. Otherwise, this traffic will be dropped by
the downstream device.

Configuring jumbo frame operation
For detailed information about jumbo frames, see Jumbo frames on page 236.

Overview

1. Determine the VLAN membership of the ports or trunks through which you want the switch to accept inbound
jumbo traffic. For operation with GVRP enabled, refer to the GVRP topic under “Operating Rules”, above.

2. Ensure that the ports through which you want the switch to receive jumbo frames are operating at least at
gigabit speed. (Check the Mode field in the output for the show interfaces brief <port-list>
command.)

3. Use the jumbo command to enable jumbo frames on one or more VLANs statically configured in the switch.
(All ports belonging to a jumbo-enabled VLAN can receive jumbo frames.

4. Execute write memory to save your configuration changes to the startupconfig file.

Viewing the current jumbo configuration
Syntax:

show vlans
Lists the static VLANs configured on the switch and includes a Jumbo column to indicate which VLANs are
configured to support inbound jumbo traffic. All ports belonging to a jumbo-enabled VLAN can receive jumbo
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traffic. (For more information, see Configuring a maximum frame size on page 240.) See Figure Figure 52:
Example: listing of static VLANs to show jumbo status per VLAN on page 239.

Figure 52: Example: listing of static VLANs to show jumbo status per VLAN

Syntax:

show vlans ports <port-list>
Lists the static VLANs to which the specified ports belong, including the Jumbo column to indicate which VLANs
are configured to support jumbo traffic.

Entering only one port in <port-list > results in a list of all VLANs to which that port belongs.

Entering multiple ports in <port-list > results in a superset list that includes the VLAN memberships of all
ports in the list, even though the individual ports in the list may belong to different subsets of the complete VLAN
listing.

Example:

If port 1 belongs to VLAN 1, port 2 belongs to VLAN 10, and port 3 belongs to VLAN 15, executing this command
with a port-list of 1 - 3 results in a listing of all three VLANs, even though none of the ports belong to all three
VLANS. (See Figure 53: Listing the VLAN memberships for a range of ports on page 239.)

Figure 53: Listing the VLAN memberships for a range of ports

Syntax:

show vlans <vid>
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Shows port membership and jumbo configuration for the specified vid . (See Figure 54: Example: of listing the
port membership and jumbo status for a VLAN on page 240.)

Figure 54: Example: of listing the port membership and jumbo status for a VLAN

Enabling or disabling jumbo traffic on a VLAN
Syntax:

vlan <vid> jumbo

[no] vlan <vid> jumbo
Configures the specified VLAN to allow jumbo frames on all ports on the switch that belong to that VLAN. If the
VLAN is not already configured on the switch, vlan <vid> jumbo also creates the VLAN.

A port belonging to one jumbo VLAN can receive jumbo frames through any other VLAN statically configured on
the switch, regardless of whether the other VLAN is enabled for jumbo frames.

The [no] form of the command disables inbound jumbo traffic on all ports in the specified VLAN that do not also
belong to another VLAN that is enabled for jumbo traffic. In a VLAN context, the command forms are jumbo and
no jumbo.

(Default: Jumbos disabled on the specified VLAN.)

Configuring a maximum frame size
You can globally set a maximum frame size for jumbo frames that will support values from 1518 bytes to 9216
bytes for untagged frames.

Syntax:

jumbo max-frame-size <size>
Sets the maximum frame size for jumbo frames. The range is from 1518 bytes to 9216 bytes. (Default: 9216
bytes)

NOTE:

The jumbo max-frame-size is set on a GLOBAL level.

Default: 9216 bytes
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Configuring IP MTU
NOTE:

The following feature is available on the switches covered in this guide. jumbos support is required
for this feature. On switches that do not support this command, the IP MTU value is derived from the
maximum frame size and is not configurable.

You can set the IP MTU globally by entering this command. The value of max-frame-size must be greater than
or equal to 18 bytes more than the value selected for ip-mtu. For example, if ip-mtu is set to 8964, the max-
frame-size is configured as 8982.

Syntax:

jumbo ip-mtu <size>
Globally sets the IP MTU size. Values range between 1500 and 9198 bytes. This value must be 18 bytes less
than the value of max-frame-size.

(Default: 9198 bytes)

SNMP implementation
Jumbo maximum frame size
The maximum frame size for jumbos is supported with the following proprietary MIB object:

hpSwitchMaxFrameSize OBJECT-TYPE
This is the value of the global max-frame-size supported by the switch. The default value is set to 9216 bytes.

Jumbo IP MTU
The IP MTU for jumbos is supported with the following proprietary MIB object:

hpSwitchIpMTU OBJECT-TYPE
This is the value of the global jumbos IP MTU (or L3 MTU) supported by the switch. The default value is set to
9198 bytes (a value that is 18 bytes less than the largest possible maximum frame size of 9216 bytes). This
object can be used only in switches that support max-frame-size and ip-mtu configuration.

Displaying the maximum frame size
Use the show jumbos command to display the globally configured untagged maximum frame size for the switch,
as shown in the following Example:.

switch(config)# show jumbos

 Jumbos Global Values

  Configured : MaxFrameSize : 9216   Ip-MTU : 9198
  In Use     : MaxFrameSize : 9216   Ip-MTU : 9198
For more information about frame size, see Jumbo frames on page 236.

Operating notes for maximum frame size
• When you set a maximum frame size for jumbo frames, it must be on a global level. You cannot use the

jumbo max-frame-size command on a per-port or per-VLAN basis.

• The original way to configure jumbo frames remains the same, which is per-VLAN, but you cannot set a
maximum frame size per-VLAN.

• Jumbo support must be enabled for a VLAN from the CLI or through SNMP.
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• Setting the maximum frame size does not require a reboot.

• When you upgrade to a version of software that supports setting the maximum frame size from a version that
did not, the max-frame-size value is set automatically to 9216 bytes.

• Configuring a jumbo maximum frame size on a VLAN allows frames up to max-frame-size even though
other VLANs of which the port is a member are not enabled for jumbo support.

Troubleshooting

A VLAN is configured to allow jumbo frames, but one or more ports drops all inbound
jumbo frames
The port may not be operating at a minimum of 1 Gbps on the other switches covered in this guide. Regardless of
a port's configuration, if it is actually operating at a speed lower than 1 Gbps for the other switches, it drops
inbound jumbo frames. For example, if a port is configured for Auto mode (speed-duplex auto), but has
negotiated a 7 Mbps speed with the device at the other end of the link, the port cannot receive inbound jumbo
frames. To determine the actual operating speed of one or more ports, view the Mode field in the output for the
following command:

show interfaces brief <port-list>

A non-jumbo port is generating "Excessive undersize/giant frames" messages in the
Event Log
The switches can transmit outbound jumbo traffic on any port, regardless of whether the port belongs to a jumbo
VLAN. In this case, another port in the same VLAN on the switch may be jumbo-enabled through membership in
a different, jumbo-enabled VLAN, and may be forwarding jumbo frames received on the jumbo VLAN to non-
jumbo ports.

Fault Finder
Fault Finder is a feature that helps administrators to debug unusual network activity such as flapping links or
transceivers or to troubleshoot issues such as multicast or broadcast storms. Fault Finder helps in preventing
network loops and taking care of situations that arise out of defective equipment and malicious attacks.

The following is the list of issues detected by the Fault Finder:

• Excessive CRC/alignment errors (bad cable)

• Excessive flapping of transceivers (bad transceiver)

• Too many undersized/giant packets (bad driver)

• Excessive late collisions (cable too long)

• High collision or drop rate (over bandwidth)

• Excessive broadcast packets (broadcast storm)

• Excessive multicast packets (multicast storm)

• Duplex mismatch (duplex mismatch HDx - reconfigure to Full Duplex)

• Duplex mismatch (duplex mismatch FDx - reconfigure port to Auto)

• Rapid detection of link faults and recoveries (link flap)

• Link loss detection (loss of link)
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NOTE: Fault finder is also known as FFI (find-fix-inform).

Fault Finder thresholds
Switches feature automatic fault detection, which helps protect against network loops and defective equipment.
The fault detection sensitivity setting determines the types of alerts reported to the Alert Log based on their level
of severity or sensitivity. The sensitivity levels are:

• High Sensitivity.

This policy directs the switch to send all alerts to the Alert Log. This setting is most effective on networks that
have none or few problems.

• Medium Sensitivity. This policy directs the switch to send alerts related to network problems to the Alert Log.
If you want to be notified of problems which cause a noticeable slowdown on the network, use this setting.

• Low Sensitivity. This policy directs the switch to send only the most severe alerts to the Alert Log. This policy
is most effective on a network where there are normally a lot of problems and you want to be informed of only
the most severe ones

• Disabled. Disables the Alert Log and transmission of alerts (traps) to the management server (in cases where
a network management tool such as ProCurve Manager is in use). Use this option when you don’t want to use
the Alert Log.

Enabling Fault Finder
Enter this CLI command to enable fault detection:

Syntax:

[no] fault-finder [fault][sensitivity <low|medium|high>][action <warn|warn-and-disable>]
Enables or disables Fault Finder and sets sensitivity.

When the warn-and-disable action option is configured, Fault Finder may also shut down a bad port in
addition to sending an alert to the Alert Log.

Default setting: fault-finder sensitivity medium action warn
[fault]: Supported values are:

• all: All fault types

• bad-driver: Too many undersized/giant packets

• bad-transceiver: Excessive jabbering

• bad-cable: Excessive CRC/alignment errors

• too-long-cable: Excessive late collisions

• over-bandwidth: High collision or drop rate

• broadcast-storm: Excessive broadcasts

• duplex-mismatch-HDx: Duplex mismatch. Reconfigure to Full Duplex

• duplex-mismatch-FDx: Duplex mismatch. Reconfigure port to Auto
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• link-flap: Rapid detection of link faults and recoveries

• loss-of-link: Link loss detected. (Sensitivity not applicable)

Examples:

To set Fault Finder with a high sensitivity to issue a warning and then disable a port on which there is a high
collision or drop rate, you could configure these options:

switch(config)# fault-finder over-bandwidth sensitivity 
high action warn-and-disable
To set Fault Finder with a medium sensitivity to issue a warning about excessive CRC or alignment errors on a
port, you could configure these options:

switch(config)# fault-finder bad-cable sensitivity 
medium action warn
To set Fault Finder with a low sensitivity to issue a warning about rapid detection of link faults, you could
configure these options:

switch(config)# fault-finder link-flap sensitivity 
low action warn
To disable Fault Finder, enter this command:

switch(config)# no fault-finder all

Table 17: Fault finder sensitivities for supported conditions

Condition
triggering
fault finder

Sensitivities Units (in
packets)

Time period Fault finder
reacts:

High Medium Low

Bad driver —
Too many
under-sized
packets or too
many giant
packets

6 21 36 1/10,000
Incoming

20 secs If (undersized/
total) >=
(sensitivity/
10,000)OrIf
(giant/total) >=
(sensitivity/
10,000)

Bad
transceiver —
Excessive
jabbering -
Jabbers:
(Jabbers are
packets
longer than
the MTU) -
Fragments:
(packets
shorter than
they should
be)

65 2110 3614 1/10,000
IncomingOne
Fragments

20 secs20
secs

If (jabbers/
total) >=
(sensitivity/
10,000)Or If
fragment
count in the
last 20
seconds >=
sensitivity

Table Continued
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Condition
triggering
fault finder

Sensitivities Units (in
packets)

Time period Fault finder
reacts:

Bad cable —
Excessive
CRC/
alignment
errors

6 21 36 1/10,000
Incoming

20 secs If (CRC and
alignment
errors/ total)
>= (sensitivity/
10,000)

Too Long
Cable —
Excessive late
collisions (a
late collision
error occurs
after the first
512 bit times)

6 21 36 1/10,000
Outgoing

20 secs If (late
collisions/
total) >=
(sensitivity/
10,000)

Over
bandwidth -
High collision
rate -High
drop rate

665 21257 36449 1/10,000
OutgoingOne
Packet

5 mins5 mins If (excessive
collisions/
total) >=
(sensitivity/
10,000)The
count of
dropped
packets >=
sensitivity
during the last
5 minutes.

Broadcast
storm —
Excessive
broadcasts

1475 5000 8525 One
Broadcast
Packet

1 sec If the average
per second of
broadcast
packets in the
last 20
seconds >=
sensitivity

Muticast
storm —
Excessive
multicasts

1475 5000 8525 One Multicast
Packet

1 sec If the average
per second of
multicast
packets in the
last 20
seconds >=
sensitivity

Duplex
mismatch
HDx

6 21 36 1/10,000
Outgoing

20 sec If (late
collisions/
total) >=
(sensitivity/
10,000)

Table Continued
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Condition
triggering
fault finder

Sensitivities Units (in
packets)

Time period Fault finder
reacts:

Duplex
mismatch FDx

6 21 36 1/10,000
Incoming

20 sec If (CRC and
alignment
errors/ total)
>= (sensitivity/
10,000)

Link flap —
Excessive
transitions
between link-
up and link-
down states.

4 7 11 One
Transitions

10 secs If the
Transition
count in the
last 10s >=
sensitivity.

Example: of sensitivity calculation:

If a sensitivity is set to High, and a bad cable is causing 15 CRC errors out of a total of 3500 packets transmitted
in a 20 second period:

1. CRC errors/total must be >= (sensitivity/10,000) to trigger an alert.

2. CRC errors/total = 15/3500 = .00043

3. Sensitivity/10,000 = 6/10,000 = .0006

4. .00043 is not greater than or equal to .0006, so an alert is not triggered.
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Configuring the switch to filter untagged traffic
Enter this command to configure the switch not to learn CDP, LLDP, or EAPOL traffic for a set of interfaces.

ignore-untagged-mac
Syntax
ignore-untagged-mac <PORT-LIST>
    
Description

Prevents MAC addresses from being learned on the specified ports when the VLAN is untagged and the
destination MAC address is one of the following:

• 01000C-CCCCCC (CDP)

• 0180c2- 00000e (LLDP)

• 0180c2-000003 (EAPOL)

ignore packet MAC

Configuring the switch to ignore packet MAC address learns for an untagged VLAN.

switch(config) ignore-untagged-mac 1-2

Viewing configuration file change information

show running-config
Syntax
show running-config [changes-history <1-32>] [detail]
Description

Displays the history of changes made to the running-configuration file.

Parameters

changes-history

Shows up to 32 events and displays changes in descending order ( the most recent change at the top of the
list). You can specify from 1 to 32 entries for display.

detail

Displays a more detailed amount of information for the configuration changes.

Chapter 9
Configuring for Network Management Applications
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Configuration change output

Figure 55: Output for running configuration changes history for all ports

Figure 56: Example of output for running config changes history with detail
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Current status of SNMP trap type

Figure 57: SNMP trap configuration status information

Minimal interval for successive data change notifications

setmib
Syntax
setmib lldpnotificationinterval.0 -i  1 - 3600 
      
Description

Change the minimum interval for successive data change notifications for the same neighbor. Globally changes
the interval between successive traps generated by the switch. If multiple traps are generated in the specified
interval, only the first trap is sent. The remaining traps are suppressed. (A network management application can
periodically check the switch MIB to detect any missed change notification traps. See IEEE P802.1AB or later for
more information.)

(Default: 5 seconds)

Limiting change notification traps

The following command limits change notification traps from a particular switch to one per minute.

switch# setmib lldpnotificationinterval.0 -i 60 lldpNotificationInterval.0=60

Viewing the current port speed and duplex configuration
on a switch port

Chapter 9 Configuring for Network Management Applications 249

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 3987



show interfaces
Syntax
show interfaces [brief | config | custom | display | port-utilization | transceiver | status |
tunnel | ethernet <PORT-LIST>]
      
Description

Show port configuration and status information.

Parameters

brief

Show port operational parameters.

config

Show port configuration information.

custom

Show port parameters in a customized table.

display

Show summary of network traffic handled by the ports.

internal-use

Show reserved or eligible internal ports.

[ethernet] <PORT-LIST>

Show summary of network traffic handled by the ports.

port-utilization

Show port bandwidth utilization.

status

Show interfaces tagged or untagged VLAN information.

transceiver

Show the transceiver information.

tunnel

Show tunnel configuration and status information.

Show interfaces

switch# show interfaces
Status and Counters - Port Counters
                                                                Flow Bcast
 Port   Total Bytes    Total Frames   Errors Rx    Drops Tx     Ctrl Limit
 ------ -------------- -------------- ------------ ------------ ---- -----
A1     419,179        1555           0            0            off  0
A2     4217           24             0            0            off  0
A3     0              0              0            0            off  0
A4     0              0              0            0            off  0
A5     0              0              0            0            off  0
A6     0              0              0            0            off  0
A7     0              0              0            0            off  0
A8     0              0              0            0            off  0
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A9     0              0              0            0            off  0
A10    0              0              0            0            off  0
A11    0              0              0            0            off  0
A12    0              0              0            0            off  0
A13    0              0              0            0            off  0
A14    0              0              0            0            off  0
A15    0              0              0            0            off  0
A16    0              0              0            0            off  0
A17    0              0              0            0            off  0
A18    0              0              0            0            off  0
A19    0              0              0            0            off  0
A20    0              0              0            0            off  0
A21    3846           21             0            0            off  0
A22    3855           19             0            0            off  0

MACsec Port Counters:
Port   Errors Rx    Drops Tx
------ ------------ ------------
A2     0            0  

Viewing the configuration

show running-config
Syntax
show running-config
Description

Displays information about the configuration.

Example

show running-config

Configuration showing interfaces to ignore packet MAC address learns.

switch(config) show running-config
Running configuration:
; J9627 Configuration Editor; Created on release K.15.XX
; Ver #03:03.1f.ef:f0
hostname “Switch”
interface 1
ignore-untagged-mac
exit
interface 2
ignore-untagged-mac
exit
...
vlan 1
name “DEFAULT_VLAN”
untagged 1-24
ip address dhcp-bootp
exit

RMON advanced management
The switch supports RMON (remote monitoring) on all connected network segments. This allows for
troubleshooting and optimizing your network.
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The following RMON groups are supported:

• Ethernet Statistics (except the numbers of packets of different frame sizes)

• Alarm

• History (of the supported Ethernet statistics)

• Event

The RMON agent automatically runs in the switch. Use the RMON management station on your network to
enable or disable specific RMON traps and events. Note that you can access the Ethernet statistics, Alarm, and
Event groups from the Switch Manager network management software.

The CLI supports the configuration of RMON alarm threshold settings. The settings can be saved in the
configuration file.

rmon alarm
Syntax
[no] rmon alarm  entry number alarm-variable sampling-interval  absolute | delta 
rising-threshold threshold-value1 falling-threshold2 threshold-value2  owner string
      
Description

This command configures RMON sampling periods and threshold parameters.

Parameters

no

Removes the alarm entry.

entry number <1–65535>

An alarm number that uniquely identifies the alarm threshold entry.

alarm-variable <object-string>

Object identifier of the particular variable to be sampled. Variables must be of type Integer in order to be
sampled.

sampling-interval <5-65535>

Time interval in seconds over which data is sampled and compared with the rising-threshold and the falling-
threshold.

absolute

The value of the selected variable is compared directly with the thresholds at the end of the sampling interval.

IMPORTANT:

If the absolute option is used for alarm variables of counter-type, an RMON trap is generated
only once, when the threshold limit is reached. The RMON trap is never generated again.
Hewlett Packard Enterprise recommends using the delta option instead when using a counter-
type alarm variable.

delta

The value of the selected variable at the last sample is subtracted from the current value, and the difference is
compared with the thresholds.
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rising-threshold <threshold-value>

An integer value for the upper threshold for the sampled statistic. A single event is generated when the
current sampled value of the specified statistic becomes greater than or equal to this threshold, and if the
value at the last sampling intervals was less than this threshold.

The value of the rising-threshold must be greater than the value of the falling-threshold.

falling-threshold <threshold-value2>

An integer value for the lower threshold for the sampled statistic. A single event is generated when the current
sampled value of the specified statistic becomes less than or equal to this threshold, and if the value at the
last sampling interval was greater than this threshold.

owner <string>

The name of the owner of this alarm.
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Using RMON alarm parameters

Figure 58: Configuring the RMON Alarm Parameters in the CLI

Figure 59: Removing an RMON Alarm

Figure 60: Show Command Output for a Specific Alarm

Figure 61: Display Command Output for a Specific Alarm

Figure 62: Output of the running-config File Displaying the Configured RMON Alarm Parameters
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Configuring UDLD verify before forwarding
When an UDLD enabled port transitions to link-up, the port will begin with a UDLD blocking state. UDLD will
probe via protocol packet exchange to determine the bidirectional state of the link. Until UDLD has completed the
probe, all data traffic will be blocked. If the link is found to be bidirectional, UDLD will unblock the port for data
traffic to pass. Once UDLD unblocks the port, other protocols will see the port as up and data traffic can be safely
forwarded.

The default mode of a switch is “forward first then verify’’. Enabling UDLD link-up will default to “forward first then
verify”. To change the mode to “verify then forward”, you need to configure using the commands found in section
6.72.

IMPORTANT:

Link-UP data traffic will resumed after probing the link partner completes. All other protocols running
will see the port as down.

UDLD time delay
UDLD protocol informs the link partner simultaneously as it detects a state change from unidirectional to
bidirectional traffic. Additional packet exchanges will be carried out by UDLD in addition to the existing UDLD
exchanges whenever state changes from unidirectional to bidirectional.

Interval 1

5 seconds

With triggered updates: State=blockedPeer; State=blocked

Without triggered updates: State=blockedPeer; State=blocked

Interval 1 + delta

5+(<5) seconds (delta is the time when the unblock event occurs on local side)

With triggered updates: Inform PeerState=unblockedPeer; State=unblocked

Without triggered updates: State=unblockedPeer; State=blocked

Interval 2

10 seconds

With triggered updates: Regular UDLD TX

Without triggered updates: Inform PeerState=unblocked; Peer State=unblocked

Interval 3

15 seconds

With triggered updates: Regular UDLD TX

Without triggered updates: Regular UDLD TX

Restrictions

• There is no support available when configuring this mode from the web and menu interface.

• There are no new packet types are introduced with UDLD.

• There are no new UDLD timers being introduced.

UDLD configuration commands
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link-keepalive mode
Syntax
link-keepalive mode [verify-then-forward | forward-then-verify]
Description

This command configures the link-keepalive mode.

Parameters

verify-then-forward

The port is in a blocking state until the link configured for UDLD establishes bidirectional communication.

forward-then-verify

The port forwards the data then verifies the status of the link-in state. When a unidirectional state is detected,
the port is moved to a blocked state. When a bidirectional state is detected, the data is forwarded without
interruption.

interval <DECISECONDS>

Configure the interval for link-keepalive. The link-keepalive interval is the time between sending two
UDLD packets. The time interval is entered in deciseconds (1/10 sec). For example, a value of 10 is 1
second; 11 is 1.1 seconds. The default keepalive interval is 50 deciseconds.

retries <NUMBER>

Maximum number of sending attempts for UDLD packets before declaring the link as faulty.

Default keepalive attempt is 4.

show link-keepalive
Syntax
show link-keepalive
Description

Sample output

Total link-keepalive enabled ports: 8
Keepalive Retries : 4
Keepalive Interval: 5 sec
Keepalive Mode : verify-then-forward
Physical Keepalive Adjacent UDLD

Port  Enabled Status     Status   Switch    VLAN
----- ------- ---------------- --------- ------------- ----------
1   Yes   down      off-line 000000-000000 untagged
2   Yes   down      off-line 000000-000000 untagged
3   Yes   down      off-line 000000-000000 untagged
4   Yes   down      off-line 000000-000000 untagged
5   Yes   down      off-line 000000-000000 untagged
6   Yes   down      off-line 000000-000000 untagged
7   Yes   down      off-line 000000-000000 untagged
8   Yes   down      off-line 000000-000000 untagged

256 Aruba 3810 / 5400R Management and Configuration Guide for
ArubaOS-Switch 16.08

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 3994



RMON generated when user changes UDLD mode
RMON events are generated when UDLD is configured. The first time you configure the mode, the UDLD states
will be re-initialized. An event log entry is initiated to include the reason for the initial UDLD blocking state during
link up.

UDLD mode [verify-then-forward | forward-then-verify] is configured

Severity: - Info.

MAC configurations

Configuring the MAC address count option
The MAC Address Count feature provides a way to notify the switch management system when the number of
MAC addresses learned on a switch port exceeds the permitted configurable number.

To enable the mac-count-notify option, enter this command in global config context.

snmp-server mac-count-notify
Syntax
[no] snmp-server enable traps mac-count-notify
Description

Sends a trap when the number of MAC addresses learned on the specified ports exceeds the configured
<learned-count> value.

Parameters

no

Disables mac-count-notify traps.

mac-count-notify

To configure the mac-count-notify option on a port or ports, enter this command. When the configured number
of MAC addresses is exceeded (the learned-count), a trap is sent.

traps <PORT-LIST>

Configures mac-count-notify traps on the specified ports for the entire switch. With no <PORT-LIST>
specified, confiures all ports.

<LEARNED-COUNT>

The number of MAC addresses learned before sending a trap. Values range between 1-128. Defaults to 32.

Usage
[no] mac-count-notify traps <PORT-LIST> [<learned-count>]

Configuring mac-count notify traps on ports 5–7

switch(config)# mac-count-notify traps 5-7 50

Configuring the MAC address table change option
When enabled, this feature allows the generation of SNMP traps for each MAC address table change.
Notifications can be generated for each device that connects to a port and for devices that are connected through
another device (daisy-chained.)
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The snmp-server enable traps mac-notify command globally enables the generation of SNMP trap
notifications upon MAC address table changes.

snmp-server mac-notify
Syntax
[no] snmp-server enable traps mac-notify [mac-move | trap-interval <0- 120>]
Description

Globally enables or disables generation of SNMP trap notifications.

Parameters

trap-interval

The time interval (in seconds) that trap notifications are sent. A value of zero disables the interval and traps
are sent as events occur. If the switch is busy, notifications can be sent prior to the configured interval.
Notifications may be dropped in extreme instances and a system warning is logged.The range is 0-120
seconds. Default: 30 seconds.

mac-move

Configures the switch to capture data for MAC addresses that are moved from one port to another port. The
snmp-server enable traps mac-notify command must have been enabled in order for this
information to be sent as an SNMP notification.

trap-interval

switch(config)# snmp-server enable traps mac-notify trap-interval 60

mac-move

switch(config)# snmp-server enable traps mac-notify mac-move

mac-notify at the interface context level

You can also execute the mac-notify traps command from the interface context.

switch# int 11
switch(int-11)# mac-notify traps learned

Per-port MAC change options for mac-notify

mac-notify traps
Syntax
[no] mac-notify traps <PORT-LIST>[learned | removed]
Description

Configure SNMP traps for learned or removed MAC addresses on a per-port basis.

The switch captures learned or removed events on the selected ports, but does not send an SNMP trap unless
you have enabled mac-notify with the snmp-server enable traps mac-notify command.
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IMPORTANT:

When this command is executed without the learned or removed option, it enables or disables the
capture of both learned and removed MAC address table changes for the selected ports in <PORT-
LIST>.

Parameters

learned

Enables the capture of learned MAC address table changes on the selected ports.

removed

Enables the capture of removed MAC address table changes table on the selected ports.

Options

<PORT-LIST>

Configures MAC address table changes capture on the specified ports. Use all to capture changes for all
ports on the switch.

Configuring traps on a per-port basis for learned MAC addresses

switch# mac-notify traps 5-6 learned
switch# show mac-notify traps 5-6
Mac Notify Trap Information
Mac-notify Enabled : Yes
Mac-move Enabled : Yes
Trap-interval : 60
Port    MAC Addresses    trap learned/removed
------ ----------------------------------
5       Learned
6       Learned

Configuring traps on a port-bases for removed MAC addresses

switch# mac-notify traps 3-4 removed
switch(config)# show mac-notify traps
Mac Notify Trap Information
Mac-notify Enabled : Yes
Mac-move Enabled : Yes
Trap-interval : 60
Port    MAC Addresses    trap learned/removed
------ ----------------------------------
1         None
2         None
3         Removed
4         Removed

Viewing the mac-count-notify option

show mac-count-notify
Syntax
show mac-count-notify traps [<PORT-LIST>]
Description
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Displays information about the configured value for sending a trap, the current count, and if a trap has been sent.

Command output

switch(config)# show mac-count-notify traps

Mac-count-notify Enabled: Yes

Port                Count for          Count            Trap Sent
                    sending Trap
-----------------------------------------------------------------
1
2
3
4
5                    50                   0              No
6                    50                   2              No
7                    50                   0              No
8
9
...

Configuring mac-count-notify traps from the interface context

The interface context can be used to configure the value for sending a trap.

switch(config)# interface 5

switch(eth-5)# mac-count-notify traps 35

View information about SNMP traps, including MAC address count being Enabled/Disabled

The show snmp-server traps command displays whether the MAC Address Count feature is enabled or
disabled.

switch# show snmp-server traps
Trap Receivers
Link-Change Traps Enabled on Ports [All] : All
Traps Category                Current Status
_____________________________ __________________
SNMP Authentication :             Extended
Password change :                 Enabled
Login failures :                  Enabled
Port-Security :                   Enabled
Authorization Server Contact :    Enabled
DHCP-Snooping :                   Enabled
Dynamic ARP Protection :          Enabled
Dynamic IP Lockdown :             Enabled
MAC address table changes :       Disabled
MAC Address Count :               Enabled

Address                  Community             Events   Type   Retry  Timeout
---------------------- ---------------------- -------- ------ ------- -------
15.146.194.77            public                 None    trap     3      15
15.255.134.252           public                 None    trap     3      15
16.181.49.167            public                 None    trap     3      15
16.181.51.14             public                 None    trap     3      15
Excluded MIBs
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Viewing mac-notify traps configuration

show mac-notify traps
Syntax
show mac-notify traps <PORT-LIST>
    
Description

Displays information about SNMP trap configuration for MAC Address Table changes.

Output of SNMP trap configuration

Displays SNMP trap information for all ports, or each port in the <PORT-LIST>.

switch# show mac-notify traps
Mac Notify Trap Information
Mac-notify Enabled : Yes
Mac-move Enabled : Yes
Trap-interval : 60
Port     MAC Addresses    trap learned/removed
------ ----------------------------------
1        None
2        None
3        Removed
4        Removed
5        Learned
6        Learned

Running config file with mac-notify parameters configured

The configured mac-notify commands are displayed in the show running-configuration output.

switch# show running-config
Running configuration:
; J9087A Configuration Editor; Created on release #R.11.XX
hostname "Switch"
snmp-server community "public" Unrestricted
snmp-server host 15.255.133.236 "public"
snmp-server host 15.255.133.222 "public"
snmp-server host 15.255.133.70 "public"
snmp-server host 15.255.134.235 "public"
vlan 1
  name "DEFAULT_VLAN"
  untagged 1-28
  ip address dhcp-bootp
  exit
snmp-server enable traps mac-notify mac-move
snmp-server enable traps mac-notify trap-interval 60
snmp-server enable traps mac-notify
mac-notify traps 5-6 learned
mac-notify traps 3-4 removed

Configuring sFlow
Under the multiple instance implementation, sFlow can be configured via the CLI or via SNMP. However, CLI-
owned sFlow configurations cannot be modified via SNMP, whereas SNMP-owned instances can be disabled via
the CLI using the no sflow <receiver-instance> command.
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sflow
Syntax
[no] sflow <RECEIVER-INSTANCE> destination [<UDP-PORT-NUM> <IP-ADDRESS> [ipv4 | 
ipv6 <UDP-PORT-NUM> oobm] sampling [<PORT-LIST> <SAMPLING RATE>] polling [<PORT-
LIST> <POLLING INTERVAL>]
Description

sFlow commands allow you to configure sFlow instances using the CLI.

Parameters and options

no

To disable an sFlow receiver/destination, enter no sflow <RECEIVER-INSTANCE> .

<RECEIVER-INSTANCE> destination

Enables an sFlow receiver/destination. The receiver-instance number must be a 1, 2, or 3.

oobm
A configurable option for sending sFlow packets to a destination through the OOBM port on the switch.
Use the OOBM port to reach the specified sFlow receiver.

ipv4 | ipv6
Supports both IPv4 and IPv6 addresses.

<UDP-PORT-NUM>

The sFlow collector collects sample packets through the OOBM port, allowing the monitoring of network
traffic. By default, the udp destination port number is 6343.

<IP-ADDRESS>
The IP address of a single destination.

<RECEIVER-INSTANCE> sampling
Once an sFlow receiver/destination has been enabled, this command enables flow sampling for that instance.
The receiver-instance number is 1, 2, or 3.

<PORT-LIST>

Port or list of ports on which to enable flow-sampling. To disable flow-sampling for the specified <PORT-
LIST> use a sampling rate of 0.

<SAMPLING-RATE>

The allowable non-zero skipcount for the specified port or ports.

<RECEIVER-INSTANCE> polling
Once an sFlow receiver/destination has been enabled, this command enables counter polling for that
instance. The receiver-instance number is 1, 2, or 3.

<PORT-LIST>

Port or list of ports on which to enable polling. To disable counter-polling for the specified <PORT-LIST>
use a polling interval of 0.

<POLLING INTERVAL>

An allowable non-zero value to enable polling on the specified port or ports.
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Usage
[no] sflow <RECEIVER-INSTANCE> destination <IP-ADDRESS> <UDP-PORT-NUM>
sflow <RECEIVER-INSTANCE> sampling <PORT-LIST> <SAMPLING RATE>
sflow <RECEIVER-INSTANCE> polling <PORT-LIST> <POLLING INTERVAL>
[no] sflow <RECEIVER-INSTANCE> destination [ipv4 | ipv6] <UDP-PORT-NUM> oobm

sFlow Destination is OOBM port

Switch (Config)# sflow 1 destination 192.168.2.3 6000 oobm 
Figure 63: Output showing OOBM Support Enabled

Figure 64: Output of the running-config File showing the sFlow Destination is the OOBM Port

sFlow Configuring multiple instances
In earlier software releases, sFlow was configured on the switch via SNMP using a single sFlow instance.
Beginning with software release K.11.34, sFlow can also be configured via the CLI for up to three distinct sFlow
instances: once enabled, an sFlow receiver/destination can be independently configured for full flow-sampling and
counter-polling. CLI-configured sFlow instances may be saved to the startup configuration to persist across a
switch reboot.

Viewing sFlow Configuration and Status

show sflow agent
The following sFlow commands allow you to display sFlow configuration and status via the CLI. Figure 66:
Viewing sFlow destination information on page 264 is an example of sflow agent information.
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Syntax
show sflow agent
Description

Displays sFlow agent information. The agent address is normally the IP address of the first VLAN configured.

The show sflow agent command displays read-only switch agent information. The version information shows
the sFlow version, MIB support, and software versions; the agent address is typically the IP address of the first
VLAN configured on the switch.

sflow agent

Figure 65: Viewing sflow agent information

show sflow destination
Syntax
show sflow <RECEIVER INSTANCE> destination
      
Description

Displays information about the management station to which the sFlow sampling-polling data is sent. Includes
management station information such as destination address, receiver port, and owner, as shown in Figure 66:
Viewing sFlow destination information on page 264

sflow destination

Figure 66: Viewing sFlow destination information

Note the following details:

• Destination Address remains blank unless it has been configured.

• Datagrams Sent shows the number of datagrams sent by the switch agent to the management station since
the switch agent was last enabled.

• Timeout displays the number of seconds remaining before the switch agent will automatically disable sFlow
(this is set by the management station and decrements with time.)

• Max Datagram Size shows the currently set value (typically a default value, but this can also be set by the
management station.)
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show sflow sampling-polling
Syntax
show sflow <RECEIVER INSTANCE> sampling-polling <PORT-LIST/RANGE>
        
Description

Displays status information about sFlow sampling and polling on the switch as shown in Figure 67: Viewing
sFlow sampling and polling information on page 265.

Options

<RECEIVER INSTANCE>

The receiver-instance number is 1, 2, or 3.

<PORT-LIST/RANGE>

You can specify a list or range of ports for which to view sampling information.

sflow sampling-polling

Figure 67: Viewing sFlow sampling and polling information

IMPORTANT: The sampling and polling instances (noted in parentheses) coupled to a specific
receiver instance are assigned dynamically, and so the instance numbers may not always match.
The key thing to note is whether sampling or polling is enabled on a port, and the sampling rates or
polling intervals for the receiver instance configured on each port.

show snmpv3 user
Syntax
show snmpv3 user
Description

Displays information about the management stations configured for SNMPv3

Management stations configured on VLAN 1 to access the switch

switch# configure terminal
switch# vlan 1
switch(vlan-1)# show snmpv3 user

Status and Counters - SNMPv3 Global Configuration Information

 User Name      Auth. Protocol   Privacy Protocol
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 -----------    --------------   -----------------
 initial        MD5              CFB AES-128
 NetworkAdmin   MD5              CBC-DES

Configuring SNMP

Network security notifications
By default, a switch is enabled to send the SNMP notifications listed in Supported Notifications on page 270
when a network security event (for example, authentication failure) occurs. However, before security notifications
can be sent, you must first configure one or more trap receivers or SNMPv3 management stations as described
in:

• SNMP trap receiver configuration on page 283

• Configuring SNMP notifications on page 270

You can manage the default configuration of the switch to disable and re-enable notifications to be sent for the
following types of security events:

• ARP protection events

• Inability to establish a connection with the RADIUS or TACACS+ authentication server

• DHCP snooping events

• Dynamic IP Lockdown hardware resources consumed

• Link change notification

• Invalid password entered in a login attempt through a direct serial, Telnet, or SSH connection

• Manager password changes

• Port-security (web, MAC, or 802.1X) authentication failure

• SNMP authentication failure

• Running configuration changes

SNMP traps on running configuration changes
You can send a specific SNMP trap for any configuration change made in the switch's running configuration file.
The trap will be generated for changes made from any of these interfaces:

• CLI

• Menu

• SNMP (remote SNMP set requests.)

The SNMP trap contains the following information.
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Information Description

Event ID An assigned number that identifies a specific running configuration
change event.

Method Method by which the change was made—CLI, Menu, or remote
SNMP.For configuration changes triggered by internal events, the term
"Internal-Event" is used as the source of the change.

IP Address Type Indicates the source address type of the network agent that made a
change. This is set to an address type of "unknown" when not
applicable.

IP address IP address of the remote system from which a user accessed the switch.
If not applicable, this is an empty string and nothing is displayed, for
example, if access is through a management console port.

User Name User name of the person who made the change. Null if not applicable.

Date and Time Date and time the change was made.

The SNMP trap alerts any interested parties that someone has changed the switch's configuration and provides
information about the source for that change. It does not specify what has been changed.

Source IP address for SNMP notifications
The switch uses an interface IP address as the source IP address in IP headers when sending SNMP
notifications (traps and informs) or responses to SNMP requests.

For multi-netted interfaces, the source IP address is the IP address of the outbound interface of the SNMP reply,
which may differ from the destination IP address in the IP header of the received request. For security reasons, it
may be desirable to send an SNMP reply with the IP address of the destination interface (or a specified IP
address) on which the corresponding SNMP request was received.

To configure the switch to use the source IP address on which an SNMP request was received in SNMP
notification/traps and replies, enter the snmp-server response-source and snmp-server trap-source
commands.

Listening mode
For switches that have a separate out-of-band management port, you can specify whether a configured SNMP
server listens for SNMP queries over the OOBM interface, the data interface, or both. By default, the switch
listens over both interfaces.

This option is not available for switches that do not have a separate OOBM port.

The listening mode is set with parameters to the snmp-server command.

Group access levels
The switch supports eight predefined group access levels. There are four levels for use by version 3 users and
four are used for access by version 2c or version 1 management applications.
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Table 18: Predefined group access levels

Group name Group access type Group read view Group write view

managerpriv Ver3 Must have
Authentication and
Privacy

ManagerReadView ManagerWriteView

managerauth Ver3 Must have
Authentication

ManagerReadView ManagerWriteView

operatorauth Ver3 Must have
Authentication

OperatorReadView DiscoveryView

operatornoauth Ver3 No Authentication OperatorReadView DiscoveryView

commanagerrw Ver2c or Ver1 ManagerReadView ManagerWriteView

commanagerr Ver2c or Ver1 ManagerReadView DiscoveryView

comoperatorrw Ver2c or Ver1 OperatorReadView OperatorReadView

comoperatorr Ver2c or Ver1 OperatorReadView DiscoveryView

Table 19: SNMPv3 Params and Group Configs Combinations

SNMPv3 Params SNMPv3 group Snmpv3 user config

noauth (no authentication and no
privacy)

operatornoauth snmpv3 user "user1"

auth (authentication and no privacy) managerpriv,
managerauth,operatorauth,
operatornoauth

snmpv3 user "user1" auth md5
"45800d22ccb8b485ab52fe2d8b92e
a85"

priv (authentication and privacy) managerpriv,
managerauth,operatorauth,
operatornoauth

snmpv3 user "user1" auth md5
"45800d22ccb8b485ab52fe2d8b92e
a85" priv des
"45800d22ccb8b485ab52fe2d8b92e
a85"

Each view allows you to view or modify a different set of MIBs:

• Manager Read View – access to all managed objects

• Manager Write View – access to all managed objects except the following:
◦ vacmContextTable

◦ vacmAccessTable

◦ vacmViewTreeFamilyTable

• OperatorReadView – no access to the following:
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◦ icfSecurityMIB

◦ hpSwitchIpTftpMode

◦ vacmContextTable

◦ vacmAccessTable

◦ vacmViewTreeFamilyTable

◦ usmUserTable

◦ snmpCommunityTable

• Discovery View – Access limited to samplingProbe MIB.

NOTE: All access groups and views are predefined on the switch. There is no method to modify or
add groups or views to those that are predefined on the switch.

SNMPv3 communities
SNMP commuities are supported by the switch to allow management applications that use version 2c or version 1
to access the switch. The communities are mapped to Group Access Levels that are used for version 2c or
version 1 support. This mapping happens automatically based on the communities access privileges, but special
mappings can be added with the snmpv3 community command.

SNMP community features
Use SNMP communities to restrict access to the switch by SNMP management stations by adding, editing, or
deleting SNMP communities. You can configure up to five SNMP communities, each with either an operator-level
or a manager-level view and either restricted or unrestricted write access.

Using SNMP requires that the switch have an IP address and subnet mask compatible with your network.

SNMPv2c informs
On a switch enabled for SNMPv2c, you can use the snmp-server host inform command (SNMPv2c inform
option on page 284) to send inform requests when certain events occur. When an SNMP Manager receives an
inform request, it can send an SNMP response back to the sending agent on the switch to let the agent know that
the inform request reached its destination.

If the sending agent on the switch does not receive an SNMP response back from the SNMP Manager within the
timeout period, the inform request may be resent, based on the retry count value.

When you enable SNMPv2c inform requests to be sent, you must specify the IP address and community name of
the management station that will receive the inform notification.

SNMP notifications
The switches:

• Default Traps: A switch automatically sends default traps to trap receivers using the configured community
name. You have to configure and supply the community name to use in the trap-receiver config, there is no
default. Use the snmp-server host <IP_ADDRESS> community "<COMMUNITY_NAME>" command to
configure a community name and the snmp-server host <IP_ADDRESS> community
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"<COMMUNITY_NAME>" trap-level [all | critical | not-info | debug | none] command
to set the level of traps to send to the community.

• SNMPv2c informs

• SNMP v3 notification process, including traps

This section describes how to configure a switch to send network security and link-change notifications to
configured trap receivers.

Supported Notifications
By default, the following notifications are enabled on a switch:

• Manager password changes

• SNMP authentication failure

• Link-change traps: when the link on a port changes from up to down (linkDown) or down to up (linkUp)

• Port-security (web, MAC, or 802.1X) authentication failure

• Invalid password entered in a login attempt through a direct serial, Telnet, or SSH connection

• Inability to establish a connection with the RADIUS or TACACS+ authentication server

• DHCP snooping events

• ARP protection events

Configuring SNMP notifications

Procedure

1. Determine the versions of SNMP notifications that you want to use in your network.

If you want to use SNMPv1 and SNMPv2c traps, you must also configure a trap receiver.

If you want to use SNMPv3 notifications (including traps), you must also configure an SNMPv3 management
station.

2. To reconfigure any of the SNMP notifications that are enabled by default to be sent to a management station
(trap receiver.)

3. (Optional) See the following sections to configure optional SNMP notification features and verify the current
configuration:

a. Source IP address for SNMP notifications on page 291

b. SNMP notification configuration on page 293

SNMPv1 and SNMPv2c Traps
The switches support the following functionality from earlier SNMP versions (SNMPv1 and SNMPv2c):

• Trap receivers: A trap receiver is a management station to which the switch sends SNMP traps and
(optionally) event log messages sent from the switch. From the CLI you can configure up to ten SNMP trap
receivers to receive SNMP traps from the switch.

• Default Traps: A switch automatically sends default traps to trap receivers using the configured community
name. You have to configure and supply the community name to use in the trap-receiver config, there is no
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default. Use the snmp-server host <IP_ADDRESS> community "<COMMUNITY_NAME>" command to
configure a community name and the snmp-server host <IP_ADDRESS> community
"<COMMUNITY_NAME>" trap-level [all | critical | not-info | debug | none] command
to set the level of traps to send to the community.

• Thresholds: A switch automatically sends all messages created when a system threshold is reached to the
network management station that configured the threshold, regardless of the trap receiver configuration.

SNMP trap receivers
Use the snmp-server host command to configure a trap receiver that can receive SNMPv1 and SNMPv2c
traps, and (optionally) Event Log messages. When you configure a trap receiver, you specify its community
membership, management station IP address, and (optionally) the type of Event Log messages to be sent.

If you specify a community name that does not exist—that is, has not yet been configured on the switch—the
switch still accepts the trap receiver assignment. However, no traps are sent to that trap receiver until the
community to which it belongs has been configured on the switch.

NOTE:

To replace one community name with another for the same IP address, you must first enter the

no snmp-server host <COMMUNITY-NAME> <IP-ADDRESS>
command to delete the unwanted community name. Otherwise, if you add a new community name
with an IP address that is already used with a different community name, two valid community name
entries are created for the same management station.

If you do not specify the event level ([ none | all | not-info | critical | debug ]),
the switch does not send Event Log messages as traps. However, "well-known" traps and threshold
traps (if configured) are still sent.

Overview
You can configure the threshold limit as a percentage for RMON event log memory. Range is between 1 to 100.
An RMON log message is generated when the RMON event logging memory reaches the configured threshold
percentage. If SNMP traps are enabled, then the same traps are generated for the RMON event.

Use the rmonlog-set-threshold command to set the threshold limit for RMON event log memory.

rmonlog-set-threshold

Syntax
rmonlog-set-threshold <percentage>

no rmonlog-set-threshold <percentage>

Description

Configures the threshold percentage for RMON event logging. The default value is 80.

The no form of this command resets RMON event logging threshold to default value.

Command context
config

Parameters
percentage

Specifies the threshold percentage value between 1 to 100.
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Examples

switch (config)# rmonlog-set-threshold 45

switch (config)# show running-config

Running configuration:

; JL071A Configuration Editor; Created on release #KB.16.06.0000x
; Ver #13:03.f8.1c.fb.7f.bf.bb.ff.7c.59.fc.7b.ff.ff.fc.ff.ff.3f.ef:05

hostname "switch"
module 1 type jl071x
flexible-module A type JL081A
interface A1
   speed-duplex auto-100
   exit
snmp-server community "public" unrestricted
oobm
   ip address dhcp-bootp
   exit
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-24,A1-A4
   ip address dhcp-bootp
   ipv6 enable
   ipv6 address dhcp full
   exit
rmonlog-set-threshold 45
The following event log message is logged when the RMON log memory reaches the threshold value.

W 03/25/18 07:44:51 03443 system:The event log buffer is 45% full.

SNMP trap when MAC address table changes
An SNMP trap is generated when a laptop/PC is removed from the back of an IP phone and the laptop/PC MAC
address ages out of the MAC table for the Switch 2920 and 5400 series switch.

The mac-notify trap feature globally enables the generation of SNMP trap notifications on MAC address table
changes (learns/moves/removes/ages.)

The following command enables trap for aged MAC addresses:

Show mac-notify traps
Syntax
show mac-notify traps
Description

Displays the different mac-notify traps configured on an interface.

Output of show mac-notify traps

Mac Notify Trap Information
Mac-notify Enabled : No
Mac-move Enabled : No
Trap-interval : 30
Port   MAC Addresses trap learned/removed/aged
------ ---------------------------------------
1       Learned, Removed & Aged
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2     Removed & Aged
3     Learned & Aged
4     Learned & Removed
5     Aged
6     Learned
7     Removed

show mac-notify for port 1
show mac-notify traps 1

1 Aged

Physical hardware removal/insertion trap generation
The specific events related to a physical module insertion or removal are being added to the default trap list.

Aruba 3810M Switch Series (JL071A, JL072A, JL073A, JL074A, JL075A, JL076A)
Aruba 5400Rzl2 Switch Series (J8698A, J8700A, J9823A-J9824A, J9825A, J9826A, J9868A, J9447A,
J9448A)
Aruba 5406R Switch Series (JL002A, JL003A, JL095A,J9850A)
Aruba 5412R Switch Series (J9851A, JL001A)

Current default traps
The default event scenarios for currently generated traps on ArubaOS-Switches are:

• Device cold start notifications

• Device warm start notifications

• Port down notifications

• Port up notifications

• Authentication failure notifications

• Enterprise change notifications

• Intrusion alarm notifications

Event scenario matrix
Different event scenarios for which traps are generated:

Event Id Severity Action Message

68 Info Slot Insertion I 06/20/16 09:18:43 00068 chassis: AM1: Slot C Inserted

67 Info Slot Removal I 06/20/16 09:18:50 00067 chassis: AM1: Slot C Removed

405 Info Transceiver Insertion I 06/20/16 09:18:56 00405 ports: AM1: port A23 xcvr hot-
swap insert

406 Info Transceiver Removal I 06/20/16 09:19:04 00406 ports: AM1: port A23 xcvr hot-
swap remove

Table Continued
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Event Id Severity Action Message

552 Warning Stacking module
Insertion

W 04/20/16 09:20:43 00552 chassis: ST1-CMDR: Stacking
Module insertion detected: Reboot required

552 Warning Stacking module
Removal

W 06/20/16 09:19:43 00552 chassis: ST1-CMDR: Stacking
Module removal detected: Reboot required

Enabling and disabling traps

Action Command

Disable both the log and
trap

setMib eventType.<event_Id> -i 1 – to disable both log & Trap

Enable log only setMib eventType.<event_Id> -i 2 – to allow only log

Enable both the log and
trap (Default)

setMib eventType.<event_Id> -i 4 – to allow both log & Trap

Enable trap only setMib eventType.<event_Id> -i 3 – to allow only trap

NOTE: If the event is configured to disable a trap, then the trap will not be sent for that particular
event. In all other scenarios, a trap is generated for the listed events.

SNMP trap captures examples

Inserting a slot module

Event Id: 68
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Removing a slot module

Event Id: 67

Inserting a transceiver

Event Id: 405
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Removing a transceiver
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SNMP trap when power supply is inserted or removed
SNMP traps generate while inserting or removing a powered up Power Supply Unit (PSU) without pulling out the
power cable and also when removing a powered down PSU from the Switch 5406 Series. RMON log events are
used to generate SNMP traps for PSU insertion and removal in both powered up and powered down states.

Log event

Chassis: Power Supply 1 inserted
Chassis: Power Supply 1 removed while powered
Chassis: Power Supply 2 removed while not powered

Power supply inserted while powered off

W 09/13/13 09:10:18 03834 chassis: AM1: Power Supply 1 inserted
W 09/13/13 09:10:19 00071 chassis: AM1: Power Supply failure: Supply: 1, Failures: 4

Power supply removed while powered off

W 09/13/13 09:08:57 03835 chassis: AM1: Power Supply 1 removed while not powered
W 09/13/13 09:08:57 00071 chassis: AM1: Power Supply failure: Supply: 1, Failures: 3

Power supply removed while powered on

WARNING: PSUs should never be inserted or removed while the PSU has power applied.

W 09/13/13 09:03:36 03835 chassis: AM1: Power Supply 1 removed while powered
W 09/13/13 09:03:36 00071 chassis: AM1: Power Supply failure: Supply: 1, Failures: 2

SNMP notification support
You can enable SNMP trap notification of LLDP data changes detected on advertisements received from neighbor
devices, and control the interval between successive notifications of data changes on the same neighbor.

SNMPv3 users
To create new users, most SNMPv3 management software requires an initial user record to clone. The initial user
record can be downgraded and provided with fewer features, but not upgraded by adding new features. For this
reason, Hewlett Packard Enterprise recommends that when you enable SNMPv3, you also create a second user
with SHA authentication and DES privacy.

To use SNMPv3 on the switch, you must configure the users that will be assigned to different groups:

Procedure

1. Configure users in the User Table with the snmpv3 user command.

To view the list of configured users, enter the show snmpv3 user command.

2. Assign users to Security Groups based on their security model with the snmpv3 group command.
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IMPORTANT: If you add an SNMPv3 user without authentication, privacy, or both, to a group that
requires either feature, the user will not be able to access the switch. Ensure that you add a user with
the appropriate security level to an existing security group.

Adding users
To configure an SNMPv3 user, you must first add the user name to the list of known users with the snmpv3 user
command, as shown in the following image.

Figure 68: Adding SNMPv3 users and displaying SNMPv3 configuration

SNMP tools for switch management
SNMP is a management protocol that allows an SNMP client application to retrieve device configuration and
status information and to configure the device (get and set.) You can manage the switch via SNMP from a
network management station.

To implement SNMP management, the switch must have an IP address configured either manually or dynamically
(using DHCP or Bootp.) If multiple VLANs are configured, each VLAN interface should have its own IP address.

IMPORTANT: If you use the switch's Authorized IP Managers and Management VLAN features,
ensure that the SNMP management station, the choice of switch port used for SNMP access to the
switch, or both, are compatible with the access controls enforced by these features. Otherwise,
SNMP access to the switch will be blocked.

SNMP management features
SNMP management features on the switch include:

• SNMP version 1, version 2c, or version 3 over IP

• Security via configuration of SNMP communities (SNMPv3 communities on page 269)

• Security via authentication and privacy for SNMPv3 access

• Event reporting via SNMP
◦ Version 1 traps

◦ RMON: groups 1, 2, 3, and 9
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• Flow sampling using sFlow

• Standard MIBs, such as the Bridge MIB (RFC 1493), Ethernet MAU MIB (RFC 1515), and others.

The switch SNMP agent also uses certain variables that are included in a Hewlett Packard Enterprise proprietary
MIB (management information base) file.

Downloading the latest MIB file

Procedure

1. Go to the Networking website at:

http://www.hpe.com/Networking/support

2. Enter the model number of your switch (for example, 8212) or the product number in the Auto Search text
box.

3. Select an appropriate product from the drop down list.

4. Click Display selected.

5. From the options that appear, select Software downloads.

6. Locate the list of MIBs with the switch software in the Other category.

7. Click software updates, and then click MIBs.

SNMPv1 and v2c access to the switch
SNMP access requires an IP address and subnet mask configured on the switch. If you are using DHCP/Bootp to
configure the switch, ensure that the DHCP/Bootp process provides the IP address.

Once an IP address is configured, the main steps for configuring SNMPv1 and v2c access management features
are:

Procedure

1. Configure the appropriate SNMP communities. (See SNMPv3 communities on page 269.)

2. Configure the appropriate trap receivers. (See SNMP notifications on page 269.)

In some networks, authorized IP manager addresses are not used. In this case, all management stations using
the correct community name may access the switch with the View and Access levels that have been set for that
community. If you want to restrict access to one or more specific nodes, you can use the switch's IP Authorized
Manager feature. (See the access security guide.)

SNMPv3 access to the switch
SNMPv3 access requires an IP address and subnet mask configured on the switch. If you are using DHCP/Bootp
to configure the switch, ensure that the DHCP/Bootp process provides the IP address.

Once you have configured an IP address, the main steps for configuring SNMPv3 access management features
are the following:

Procedure

1. Enable SNMPv3 for operation on the switch.

2. Configure the appropriate SNMP users.
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3. Configure the appropriate SNMP communities.

4. Configure the appropriate trap receivers.

In some networks, authorized IP manager addresses are not used. In this case, all management stations using
the correct User and community name may access the switch with the View and Access levels that have been set
for that community. If you want to restrict access to one or more specific nodes, you can use the IP Authorized
Manager feature for the switch. (See the access security guide.)

SNMP version 3 (SNMPv3) adds some new commands to the CLI for configuring SNMPv3 functions. To enable
SNMMPv3 operation on the switch, use the snmpv3 enable command. An initial user entry will be generated
with MD5 authentication and DES privacy.

You may (optionally) restrict access to only SNMPv3 agents by using the snmpv3 only command. To restrict
write-access to only SNMPv3 agents, use the snmpv3 restricted-access command.

IMPORTANT:

Restricting access to only version 3 messages will make the community named “public” inaccessible
to network management applications (such as autodiscovery, traffic monitoring, SNMP trap
generation, and threshold setting) from operating in the switch.

Enabling SNMPv3
The snmpv3 enable command allows the switch to:

• Receive SNMPv3 messages.

• Configure initial users.

• Restrict non-version 3 messages to "read only" (optional.)

IMPORTANT:

Restricting access to only version 3 messages makes the community named "public" inaccessible to
network management applications (such as autodiscovery, traffic monitoring, SNMP trap generation,
and threshold setting) from operating in the switch.

SNMP version 3 enable command
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Configuring users in SNMPv3

snmpv3 user
Syntax
[no] snmpv3 user <USER_NAME> [auth md5|sha] <AUTH_PASS> [priv des|aes] <PRIV_PASS>
    
[no] snmpv3 remote-engine-id <engineid> user <username> [auth {md5| sha}
         <authentication password>] [priv {des|aes} <privacy password>]
Description

Adds or deletes a user entry for SNMPv3. Authorization and privacy are optional, but to use privacy, you must use
authorization.

Parameters and options

no

Used to delete a user entry. When you delete a user, only the user name is required.

<AUTH_PASS>

With authorization, you can set either MD5 or SHA authentication. The authentication password auth_pass
must be 6 to 32 characters and is mandatory when you configure authentication.

priv des|aes

With privacy, the switch supports DES (56-bit) and AES (128-bit) encryption. Defaults to DES. Only AES 128-
bit and DES 56-bit encryption are supported as privacy protocols. Other non-standard encryption algorithms,
such as AES-172, AES-256, and 3-DES are not supported.

<PRIV_PASS>

The privacy password priv_pass must be 6 to 32 characters and is mandatory when you configure privacy.

remote-engine-id <engineid>

Sets the SNMPv3 remote engine ID in colon-separated hexadecimal notation.

Switch access from SNMPv3 agents

snmpv3 enable
Syntax
 snmpv3 enable
Description

Enables switch access from SNMPv3 agents, including the creation of the initial user record.

Restrict access from SNMPv3 agents

snmpv3 only
Syntax
[no] snmpv3 only
Description

When enabled, the switch rejects all non-SNMPv3 messages.
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Restrict non-SNMPv3 agents to read-only access

snmpv3 restricted-access
Syntax
[no] snmpv3 restricted-access
Description

Enable or disable restrictions from all non-SNMPv3 agents (read-only access).

Operating status of SNMPv3

show snmpv3
Syntax
show snmpv3 enable
Description

View the operating status of SNMPv3 (enabled or disabled).

Non-SNMPv3 message reception status

show snmpv3 only
Syntax
show snmpv3 only
Description

Shows the message reception status of non-SNMPv3 messages.

Non-SNMPv3 write message status

show snmpv3 restricted-access
Syntax
show snmpv3 restricted-access
Description

Shows the status of non-SNMPv3 write messages.

Viewing and configuring non-version-3 SNMP communities (Menu)

Procedure

1. From the Main Menu, select:

2. Switch Configuration…
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6. SNMP Community Names

Figure 69: SNMP Communities screen (default values)

2. Press [A] (for Add ) to display the following screen:

Figure 70: SNMP add or edit screen

If you need information on the options in each field, press [Enter] to move the cursor to the Actions line, then
select the Help option. When you are finished with Help, press [E] (for Edit) to return the cursor to the
parameter fields.

3. Enter the name you want in the Community Name field, and use the Space bar to select the appropriate value
in each of the other fields. (Use the [Tab] key to move from one field to the next.)

4. Press [Enter], then [S] (for Save.)

SNMP trap receiver configuration

snmp-server host
Syntax
snmp-server host [ipv4–addr|ipv6–addr] <community name>
      
Description

Configures a destination network management station to receive SNMPv1/v2c traps and (optionally) Event Log
messages sent as traps from the switch, using the specified community name and destination IPv4 or IPv6
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address. You can specify up to ten trap receivers (network management stations.) <COMMUNITY NAME>
defaults to public.

Parameters and options

Event log messages

Optional: Configures the security level of the Event Log messages you want to send as traps to a trap
receiver.

• The type of Event Log message that you specify applies only to Event Log messages, not to threshold
traps.

• For each configured event level, the switch continues to send threshold traps to all network management
stations that have the appropriate threshold level configured.

• If you do not specify an event level, the switch uses the default value (none) and sends no Event Log
messages as traps.

none

Sends no Event Log messages.

all

Sends all Event Log messages.

not info

Sends all Event Log messages that are not for information only.

critical

Sends only Event Log messages for critical error conditions.

debug

Sends only Event Log messages needed to troubleshoot network- and switch-level problems.

[inform]

Optional: Configures the switch to send SNMPv2 inform requests when certain events occur.

Configure a trap receiver

To configure a trap receiver in a community named "red-team" with an IP address of 10.28.227.130 to receive
only "critical" event log messages, you can enter the following command:

switch# snmp-server host 10.28.227.130 red-team critical

SNMPv2c inform option

snmp-server host
Syntax
[no] snmp-server host [ipv4–addr|ipv6–addr] <COMMUNITY NAME> inform [retries <COUNT>][timeout <INTERVAL>]
        

Description

Enables (or disables) the inform option for SNMPv2c on the switch and allows you to configure options for
sending SNMP inform requests.
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Parameters and options

IMPORTANT:

The retries and timeout values are not used to send trap requests.

retries

Maximum number of times to resend an inform request if no SNMP response is received. Defaults to 3.

timeout

Number of seconds to wait for an acknowledgement before resending the inform request. Defaults to 15
seconds.

Verify SNMPv2c inform configuration

switch# show snmp-server

 SNMP Communities

  Community Name   MIB View Write Access
  ---------------- -------- ------------ public          Manager  Unrestricted

 Trap Receivers

  Link-Change Traps Enabled on Ports [All] : All
  ...
  Address               Community       Events Sent Notify Type Retry Timeout
  --------------------- --------------- ----------- ----------- ----- --------
  15.28.333.456         guest           All         inform      3     15

 Excluded MIBs

 Snmp Response Pdu Source-IP Information

  Selection Policy   : Default rfc1517

 Trap Pdu Source-IP Information 
  Selection Policy   : Configured IP 
  Ip Address        : 10.10.10.10

Configuring SNMPv3 notifications (CLI)
The SNMPv3 notification process allows messages that are passed via SNMP between the switch and a network
management station to be authenticated and encrypted.

Procedure

1. Enable SNMPv3 operation on the switch by entering the snmpv3 enable command.

When SNMPv3 is enabled, the switch supports:

• Reception of SNMPv3 notification messages (traps and informs)

• Configuration of initial users

• (Optional) Restriction of non-SNMPv3 messages to "read only"

2. Configure SNMPv3 users by entering the snmpv3 user command. Each SNMPv3 user configuration is
entered in the User Table.
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3. Assign SNMPv3 users to security groups according to their level of access privilege by entering the snmpv3
group command.

4. Define the name of an SNMPv3 notification configuration by entering the snmpv3 notify command.

Syntax:
[no] snmpv3 notify <notify_name> tagvalue <tag_name> type {inform|trap}

Associates the name of an SNMPv3 notification configuration with a tag name used (internally) in SNMPv3
commands. To delete a notification-to-tag mapping, enter no snmpv3 notify notify_name .

notify <notify_name> Specifies the name of an SNMPv3 notification configuration.

tagvalue <tag_name> Specifies the name of a tag value used in other SNMPv3 commands, such as
snmpv3 targetaddress params taglist tag_name in Step 5.

type Specifies the notification type as inform or trap. By default, the notification
type is trap.

5. Configure the target address of the SNMPv3 management station to which SNMPv3 informs and traps are
sent by entering the snmpv3 targetaddress command.

Syntax:
[no] snmpv3 targetaddress <ASCII-STR> params <ASCII-STR> <IP-ADDR> taglist <ASCII-STR>
Configures the IPv4 or IPv6 address, name, and configuration filename of the SNMPv3 management station to
which notification messages are sent.

params <ASCII-STR> Name of the SNMPv3 station's parameters file. The
parameters filename configured with params <ASCII-
STR> must match the params <ASCII-STR> value
entered with the snmpv3 params command in Step 6.

The <IP-ADDR> sets the IP address of the destination.

taglist <ASCII-STR> [ASCII-STR] … Specifies the SNMPv3 notifications (identified by one or
more ASCII-STR values) to be sent to the IP address of
the SNMPv3 management station.

You can enter more than one ASCII-STR value. Each
ASCII-STR value must be already associated with the
name of an SNMPv3 notification configuration entered
with the snmpv3 notify command in Step 4.Use a
blank space to separate values.

ASCII-STR

You can enter up to 103 characters in ASCII-STR entries
following the taglist keyword.

[filter {<none | debug | all | not-
info | critical>}]

(Optional) Configures the type of messages sent to a
management station.(Default: none.)

[udp-port < port >] (Optional) Specifies the UDP port to use.(Default: 162.)

Table Continued
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[port-mask < mask >] (Optional) Specifies a range of UDP ports. (Default: 0.)

[addr-mask < mask >] (Optional) Specifies a range of IP addresses as
destinations for notification messages.(Default: 0.)

[retries < value >] (Optional) Number of times a notification is retransmitted if
no response is received. Range: 1-255.(Default: 3.)

[timeout < value >] (Optional) Time (in millisecond increments) allowed to
receive a response from the target before notification
packets are retransmitted. Range: 0-2147483647.[Default:
1500 (15 seconds).]

[max-msg-size < size >] (Optional) Maximum number of bytes supported in a
notification message to the specified target. (Default:
1472)

6. Create a configuration record for the target address with the snmpv3 params command.

Syntax:
[no] snmpv3 params <ASCII-STR> user <user_name> sec-model <security_model> 
message-processing <security_model> <security_service>
Applies the configuration parameters and IP address of an SNMPv3 management station (from the params
<ASCII-STR> value configured with the snmpv3 targetaddress command in Step 5) to a specified
SNMPv3 user (from the user <user_name> value configured with the snmpv3 user command in Step 2).

If you enter the snmpv3 params user command, you must also configure a security model ( sec_model)
and message processing algorithm ( message-processing).

{<sec_model [ver1 | ver2c | ver3>]} Configures the security model used for SNMPv3
notification messages sent to the management
station configured with the snmpv3
targetaddress command in Step 5.

If you configure the security model as ver3, you
must also configure the message processing value as
ver3.

{msg-processing {<ver1 | ver2c | ver3>}
[noaut | auth | priv]}

Configures the algorithm used to process messages
sent to the SNMPv3 target address.

If you configure the message processing value as
ver3 and the security model as ver3, you must also
configure a security services level ( noauth, auth, or
priv).

Example:
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An example to how to configure SNMPv3 notification in the following image:

Figure 71: Example: SNMPv3 notification configuration

SNMPv3 community mapping
SNMP communities are supported by the switch to allow management applications that use version 2c or version
1 to access the switch.

snmpv3 community
Syntax
[no] snmpv3 community
Description

Maps or removes a mapping of a community name to a group access level. To remove a mapping you need to
specify only the index_name parameter.

Parameters and options

index <INDEX_NAME>

An index number or title for the mapping. The values of 1 to 5 are reserved and can not be mapped.

name <COMMUNITY_NAME>

The community name that is being mapped to a group access level.

sec-name <SECURITY_NAME>

The group level to which the community is being mapped.

tag <TAG_VALUE>

This is used to specify which target address may have access by way of this index reference.
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Assign a community to a group

Figure 72: Assigning a community to a group access level on page 289 shows the assigning of the Operator
community on MgrStation1 to the CommunityOperatorReadWrite group. Any other Operator has an access level
of CommunityOperatorReadOnly.

Figure 72: Assigning a community to a group access level

Running configuration changes and SNMP traps
Syntax
[no] snmp-server enable trapsfig-change transmission-interval <0-4294967295>
        
Description

Enables SNMP traps on running configurations.

Parameters and options

running-con

Enables SNMP traps being sent when changes to the running configuration file are made. Defaults to
disabled.

transmission-interval <0-2147483647>

Controls the egress rate for generating SNMP traps for the running configuration file. The value configured
specifies the time interval in seconds that is allowed between the transmission of two consecutive traps.

None of the running configuration change events that occur within the specified interval generate SNMP traps,
although they are logged in the Configuration Changes History Table.

A value of 0 (zero) means there is no limit; traps can be sent for every running configuration change event.
Defaults to 0.

Startup configuration changes and SNMP traps
You can send a specific SNMP trap for any configuration change made in the switch’s startup configuration file
when the change is written to flash. Changes to the configuration file can occur when executing a CLI write
command, executing an SNMP set command directly using SNMP, or when using the WebAgent
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NOTE:

A log message is always generated when a startup configuration change occurs. An example log
entry is:

I 07/06/10 18:21:39 02617 mgr: Startup configuration changed by SNMP. New
seq. number 8

The corresponding trap message is sent if the snmp-server enable traps startupconfig- change command is
configured.

snmp-server enable traps startup-config-change
Syntax
snmp-server enable traps startup-config-change
Description

Enables notification of a change to the startup configuration. The change event is logged. Default: Disabled

Startup configuration changes

The number that displays when show config is executed is global for the switch and represents the startup
configuration sequence number.

Figure 73: Notification of changes to the Startup Configuration file
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Fields in the trap when making a change

Fields in the trap when a change is made via SNMP (station ip=0xAC161251 (172.22.18.81), no username is set,
and the new sequence number is 16.)

Figure 74: Fields when the SNMP trap is set

Source IP address for SNMP notifications
When you use the snmp-server response-source and snmp-server trap-source commands, note the
following behavior:

• The snmp-server response-source and snmp-server trap-source commands configure the source
IP address for IPv4 interfaces only.

• You must manually configure the snmp-server response-source value if you wish to change the default
user-defined interface IP address that is used as the source IP address in SNMP traps (RFC 1517.)

• The values configured with the snmp-server response-source and snmp-server trap-source
commands are applied globally to all interfaces that are sending SNMP responses or SNMP trap PDUs.

• Only the source IP address field in the IP header of the SNMP response PDU can be changed.

• Only the source IP address field in the IP header and the SNMPv1 Agent Address field of the SNMP trap PDU
can be changed.

snmp-server response-source
Syntax
[no] snmp-server response-source [dst-ip-of-request <ipv4–addr|ipv6–addr> loopback <0–7>]
Description

Specifies the source IP address of the SNMP response PDU. The default SNMP response PDU uses the IP
address of the active interface from which the SNMP response was sent as the source IP address. Defaults to
Interface IP address.

Parameters and options
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no

The no form of the command resets the switch to the default behavior (compliant with rfc-1517.)

dst-ip-of-request

Destination IP address of the SNMP request PDU that is used as the source IP address in an SNMP
response PDU.

ipv4–addr|ipv6–addr

User-defined interface IP address that is used as the source IP address in an SNMP response PDU. Both
IPv4 and IPv6 addresses are supported.

loopback 0-7
IP address configured for the specified loopback interface that is used as the source IP address in an SNMP
response PDU. If multiple loopback IP addresses are configured, the lowest alphanumeric address is used.

Destination interface IP as source IP

To use the IP address of the destination interface on which an SNMP request was received as the source IP
address in the IP header of SNMP traps and replies, enter the following command:

switch# snmp-server response-source dst-ip-of-request

snmp-server trap-source
Syntax
[no] snmp-server trap-source ipv4-addr loopback0-7
Description

Specifies the source IP address to be used for a trap PDU. To configure the switch to use a specified source IP
address in generated trap PDUs, enter the snmp-server trap-source command. Defaults to the interface IP
address in generated trap PDUs.

Parameters and options

no

The no form of the command resets the switch to the default behavior (compliant with rfc-1517.)

dst-ip-of-request

Destination IP address of the SNMP request PDU that is used as the source IP address in an SNMP
response PDU.

ipv4–addr

User-defined interface IPv4 address that is used as the source IP address in generated traps. IPv6 addresses
are not supported.

loopback 0-7
IP address configured for the specified loopback interface that is used as the source IP address in a
generated trap PDU. If multiple loopback IP addresses are configured, the lowest alphanumeric address is
used.
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SNMP replies and traps configuration
To verify the configuration of the interface IP address used as the source IP address in IP headers for SNMP
replies and traps sent from the switch, enter the show snmp-server command to display the SNMP policy
configuration, as shown in Figure 75: Display of source IP address configuration on page 293.

Figure 75: Display of source IP address configuration

SNMP notification configuration

show snmp-server
Syntax
show snmp-server
Description

Displays the currently configured notification settings for versions SNMPv1 and SNMPv2c traps, including SNMP
communities, trap receivers, link-change traps, and network security notifications.
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show snmp-server output

In the following example, the show snmp-server command output shows that the switch has been configured
to send SNMP traps and notifications to management stations that belong to the "public," "red-team," and "blue-
team" communities.

Figure 76: Display of SNMP notification configuration

Assign users to groups

snmpv3 group
Syntax
snmpv3 group
Description

Sets the group access level for the user by assigning the user to a group. Assigns or removes a user to a security
group for access rights to the switch. To delete an entry, include all parameters in the command.

Parameters and options

group <GROUP_NAME>

Identifies the group that has the privileges that will be assigned to the user.

user <USER_NAME>

Identifies the user to be added to the access group. This must match the user name added with the snmpv3
user command.
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sec-model <aver1|ver2|ver3>

Defines which security model to use for the added user. An SNMPv3 access group should use only the ver3
security model.

snmpv3 group

Figure 77: Using snmpv3 group

snmp-server community
Syntax
[no] snmp-server community  community-name 
      
Description

Configures a new community name.

• If you do not also specify operator or manager, the switch automatically assigns the community to the
operator MIB view.

• If you do not specify restricted or unrestricted, the switch automatically assigns the community to
restricted (read-only) access.

Parameters and options

no

The no form uses only the community-name variable and deletes the named community from the switch.

operator|manager

Optionally assigns an access level.

• At the operator level, the community can access all MIB objects except the CONFIG MIB.

• At the manager level, the community can access all MIB objects.
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restricted|unrestricted

Optionally assigns MIB access type.

• Assigning the restricted type allows the community to read MIB variables, but not to set them.

• Assigning the unrestricted type allows the community to read and set MIB variables.

snmp-server community

This example adds the following communities and access level/types:

Community Access Level Type of Access

red-team manager (Access to all MIB objects.) unrestricted (read/write)

blue-team operator (Access to all MIB objects except
the CONFIG MIB.)

restricted (read-only)

switch# snmp-server community red-team
  manager unrestricted
switch# snmp-server community blue-team
  operator restricted

no snmp-server community

Eliminates a previously configured community named "gold-team."

switch(config) # no snmp-server community gold-team

Community names and values
The snmp-server command enables you to add SNMP communities with either default or specific access
attributes, and to delete specific communities.

Syntax
show snmp-server <COMMUNITY-STRING>
        
Description

This command lists the data for currently configured SNMP community names along with trap receivers and the
setting for authentication traps.
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show snmp-server

Lists the data for all communities in a switch; that is, both the default "public" community name and another
community named "blue-team."

Figure 78: SNMP community listing with two communities

show snmp-server public

To list the data for only one community, such as the "public" community, use the above command with the
community name included. For example:

switch# show snmp-server public

Enabling or disabling notification/traps for network security failures and
other security events (CLI)
Syntax:
[no] snmp-server enable traps [arp-protect | auth-server-fail | dhcp-server 
| dhcp-snooping | dhcpv6-snooping | dyn-ip-lockdown | dyn-ipv6-lockdown | link-change 
| login-failure-mgr | mac-count-notify | mac-notify | macsec | nd-snooping | password-change-mgr 
| port-security | running-config-change | snmp-authentication | startup-config-change | vsf ]

Enables or disables sending one of the security notification types listed below to configured trap receivers.
(Unless otherwise stated, all of the following notifications are enabled in the default configuration.)

The notification sends a trap:

arp-protect Traps for Dynamic ARP Protection.

auth-server-fail Traps reporting authentication server unreachable.

dhcp-server Traps for DHCP-Server.

dhcp-snooping Traps for DHCP-Snooping.

dhcpv6-snooping Set the traps for DHCPv6 snooping.

Table Continued
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dyn-ip-lockdown Traps for Dynamic Ip Lockdown.

dyn-ipv6-lockdown Enable traps for Dynamic IPv6 Lockdown.

link-change Traps for link-up and link-down.

login-failure-mgr Traps for management interface login failure.

mac-count-notify Traps for MAC addresses learned on the specified
ports exceeds the threshold.

mac-notify Traps for (learned/removed) MAC address table
changes.

macsec Configure the traps for MACsec notifications.

nd-snooping Set the trap for nd snooping

password-change-mgr Traps for management interface password change.

port-security Traps for port access authentication failure.

running-config-change Traps for running config change.

snmp-authentication [extended |
standard]

Select RFC-1157 (standard) or ICF-SNMP (extended)
traps.

Startup-config-change Traps for changes to the startup configuration.

vsf Enable traps for the VSF functionality.

To determine the specific cause of a security event, check the Event Log in the console interface to see why a
trap was sent. For more information, see "Using the Event Log for Troubleshooting Switch Problems".

Viewing the current configuration for network security notifications (CLI)
Enter the show snmp-server traps command, as shown in the following example. Note that command output
is a subset of the information displayed with the show snmp-server command in Display of SNMP
notification configuration.

Display of configured network security notifications

switch(config)# show snmp-server traps

 Trap Receivers

  Link-Change Traps Enabled on Ports [All] : A1-A24

  Traps Category                  Current Status
  ------------------------------  --------------------------
  SNMP Authentication           : Extended
  Password change               : Enabled
  Login failures                : Enabled
  Port-Security                 : Enabled
  Authorization Server Contact  : Enabled
  DHCP Snooping                 : Enabled
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  Dynamic ARP Protection        : Enabled
  Dynamic IP Lockdown           : Enabled

  Address                Community  Events Sent Notify Type Retry Timeout
  ---------------------- ---------- ----------- ----------- ----- -------
  15.255.5.225           public     All         trap          3   15
  2001:0db8:0000:0001
    :0000:0000:0000:0121 user_1     All         trap          3   15

  Excluded MIBs

Link-Change Traps

snmp-server enable traps link-change
Syntax
[no] snmp-server enable traps link-change<PORT-LIST> [all]
        
Description

By default, a switch is enabled to send a trap when the link state on a port changes from up to down (linkDown) or
down to up (linkUp.) This command allows you to reconfigure the switch to send link-change traps to configured
trap receivers.

Parameters and options
all

Enables or disables link-change traps on all ports on the switch

Viewing SNMP notification configuration (CLI)
Syntax:

show snmp-server
Displays the currently configured notification settings for versions SNMPv1 and SNMPv2c traps, including SNMP
communities, trap receivers, link-change traps, and network security notifications.

Example:
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In the following Example:, the show snmp-server command output shows that the switch has been configured
to send SNMP traps and notifications to management stations that belong to the "public," "red-team," and "blue-
team" communities.

Figure 79: Display of SNMP notification configuration

Listening mode

snmp-server listen
Syntax
snmp-server listen [oobm|data|both]
Description

Enables or disables inbound SNMP access on a switch. The listen parameter is not available on switches that
do not have a separate out-of-band management port.

Parameters and options

no

Disables inbound SNMP access.

listen

Available only on switches that have a separate out-of-band management port. Defaults to both.

oobm

Inbound SNMP access is enabled only on the out-of-band management port.
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data

Inbound SNMP access is enabled only on the data ports.

both

Inbound SNMP access is enabled on both the out-of-band management port and on the data ports.

CDP configuration

CDP mode

cdp moden
Syntax
[no] cdp moden[pass-through|rxonly]
Description

Sets the selected mode of CDP processing. Use this command to set the CDP mode to pass-through or receive
only.

CDPv2 for voice transmission
Legacy Cisco VOIP phones only support manual configuration or using CDPv2 for voice VLAN auto-configuration.
LLDP-MED is not supported. CDPv2 exchanges information such as software version, device capabilities, and
voice VLAN information between directly connected devices such as a VOIP phone and a switch.

When the Cisco VOIP phone boots up (or sometimes periodically), it queries the switch and advertises
information about itself using CDPv2. The switch receives the VOIP VLAN Query TLV (type 0x0f) from the phone
and then immediately sends the voice VLAN ID in a reply packet to the phone using the VLAN Reply TLV (type
0x0e.) The phone then begins tagging all packets with the advertised voice VLAN ID.

Configure a voice VLAN

A voice VLAN must be configured before the voice VLAN can be advertised. For example, to configure VLAN 10
as a voice VLAN tagged for ports 1 through 10, enter these commands:

switch# vlan 10 

switch(vlan-10)# tagged 1-10

switch(vlan-10)# voice

switch(vlan-10)# exit
The switch CDP packet includes these TLVs:

• CDP Version: 2

• CDP TTL: 180 seconds

• Checksum

• Capabilities (type 0x04): 0x0008 (is a switch)

• Native VLAN: The PVID of the port

• VOIP VLAN Reply (type 0xe): voice VLAN ID (same as advertised by LLDPMED)
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• Trust Bitmap (type 0x12): 0x00

• Untrusted port COS (type 0x13): 0x00

CDP should be enabled and running on the interfaces to which the phones are connected. Use the cdp enable
and cdp run commands.

The pre-standard-voice option for the cdp mode command allows the configuration of CDP mode so that it
responds to received CDP queries from a VoIP phone.

cdp mode pre-standard-voice
Syntax
[no] cdp mode pre-standard-voice [admin-status <PORT-LIST> [tx_rx | rxonly]]
Description

Enable CDP-compatible voice VLAN discovery with pre-standard VoIP phones. In this mode, when a CDP VoIP
VLAN query is received on a port from pre-standard phones, the switch replies back with a CDP packet that
contains the VID of the voice VLAN associated with that port.

Not recommended for phones that support LLDP-MED.

Parameters and options
pre-standard-voice

Enables CDP-compatible voice VLAN discovery with pre-standard VoIP phones.

admin-status
Sets the port in either transmit and receive mode, or receive mode only.

Default: tx-rx.

<PORT-LIST>

Sets this port in transmit and receive mode, or receive mode only.

rxonly
Enable receive-only mode of CDP processing.

tx_rx
Enable transmit and receive mode.

cdp mode pre-standard-voice

Switch# cdp mode pre-standard-voice admin-status A5 rxonly

show cdp without cdp run

Show CDP output when CDP Run is disabled.

Switch(config)# show cdp
Global CDP information
Enable CDP [yes] : no

show cdp with cdp run and sdp

show cdp output when cdp run and sdp mode are enabled.
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Switch# show cdp
Global CDP Information
Enable CDP [Yes] : Yes
CDP mode [rxonly] : pre-standard-voice
CDP Hold Time [180] : 180
CDP Transmit Interval [60] : 60
Port CDP admin-status
---- --------- ------------
A1   enabled   rxonly
A2   enabled   tx_rx
A3   enabled   tx_rx

show cdp with cdp run and cdp mode rxonly

show cdp output when cdp run and cdp mode rxonly are enabled. When CDP mode is not pre-standard
voice, the admin-status column is note displayed.

switch# show cdp
Global CDP Information
Enable CDP [Yes} : Yes
CDP mode [rxonly] : rxonly
Port CDP
---- --------
A1   enabled
A2   enabled
A3   enabled

show running-config

show running-config when admin-status is configured.

switch# show running-config
Running configuration:
; J9477A Configuration Editor; Created on release #K.16.09.0000x
; Ver #03:01:1f:ef:f2
hostname “Switch”
module 1 type J9307A
cdp mode pre-standard-voice admin-status A5 RxOnly

CDP operation on individual ports
In the factory-default configuration, the switch has all ports enabled to receive CDP packets. Disabling CDP on a
port causes it to drop inbound CDP packets without recording their data in the CDP Neighbors table.

cdp enable
Syntax
[no] cdp enable [e] <PORT-LIST> 
        
Description

Enable or disable ports to receive CDP packets.

Disable CDP on port A1

switch# no cdp enable a1
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CDP Operation

cdp run
Syntax
[no] cdp run
Description

Enables or disables CDP read-only operation on the switch. Defaults to enabled.

Parameters and options

no

Disabling CDP operation clears the switch's CDP Neighbors table and causes the switch to drop inbound
CDP packets from other devices without entering the data in the CDP Neighbors table.

run

Enabling CDP operation (the default) on the switch causes the switch to add entries to its CDP Neighbors
table for any CDP packets it receives from other neighboring CDP devices.

Disable CDP read-only

switch# no cdp run
When CDP is disabled:

• show cdp neighbors displays an empty CDP Neighbors table

• show cdp displays

Global CDP information

Enable CDP [Yes]: No

CDP information filter
In some environments it is desirable to be able to configure a switch to handle CDP packets by filtering out the
MAC address learns from untagged VLAN traffic from IP phones. This means that normal protocol processing
occurs for the packets, but the addresses associated with these packets is not learned or reported by the software
address management components. This enhancement also filters out the MAC address learns from LLDP and
802.1x EAPOL packets on untagged VLANs.

The feature is configured per-port.

CDP switch configuration view

show cdp
Syntax
show cdp
Description

Lists the global and per-port CDP configuration of the switch. CDP is shown as enabled/disabled both globally on
the switch and on a per-port basis.
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Show CDP with the default CDP configuration

This example shows the default CDP configuration.

switch# show cdp

 Global CDP information

  Enable CDP [Yes] : Yes (Receive Only)

  Port CDP
  ---- --------
  1    enabled
  2    enabled
  3    enabled
  .      .
  .      .
  .      .

CDP neighbors switch table view

show cdp neighbors
Syntax
show cdp neighbors
Description

Lists the neighboring CDP devices the switch detects, with a subset of the information collected from the device's
CDP packet. Devices are listed by the port on which they were detected.

Parameters and options
[e] <PORT-NUM> [detail]

Lists the CDP device connected to the specified port (allows only one port at a time). Using detail provides
a longer list of details on the CDP device the switch detects on the specified port.

[detail [e] <PORT-NUM>]
Provides a list of the details for all of the CDP devices the switch detects. Using port-num produces a list of
details for the selected port.

CDP neighbors table listing

This example displays the CDP devices that the switch has detected by receiving their CDP packets.

Switch# show cdp neighbors

 CDP neighbors information

  Port Device ID                     | Platform                 Capability
  ---- ----------------------------- + ------------------------ -----------
  1    Accounting (0030c1-7fcc40)    | J4812A Switch. . .       S
  2    Resear¢1-1 (0060b0-889e43)    | J4121A Switch. . .       S
  4    Support (0060b0_761a45)       | J4121A Switch. . .       S
  7    Marketing (0030c5_33dc59)     | J4313A Switch. . .       S
  12   Mgmt NIC(099a05-09df9b        | NIC Model X666           H
  12   Mgmt NIC(099a05-09df11        | NIC Model X666           H
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LLDP configuration

LLDP and CDP data management
This section describes points to note regarding LLDP and CDP (Cisco Discovery Protocol) data received by the
switch from other devices. LLDP operation includes both transmitting LLDP packets to neighbor devices and
reading LLDP packets received from neighbor devices. CDP operation is limited to reading incoming CDP
packets from neighbor devices. ( switches do not generate CDP packets.)

Incoming CDP and LLDP packets tagged for VLAN 1 are processed even if VLAN 1 does not contain any ports.
VLAN 1 must be present, but it is typically present as the default VLAN for the switch.

IMPORTANT:

The switch may pick up CDP and LLDP multicast packets from VLAN 1 even when CDP- and /or
LLDP-enabled ports are not members of VLAN 1.

LLDP and CDP neighbor data
With both LLDP and (read-only) CDP enabled on a switch port, the port can read both LLDP and CDP
advertisements, and stores the data from both types of advertisements in its neighbor database. (The switch
stores only CDP data that has a corresponding field in the LLDP neighbor database.) The neighbor database
itself can be read by either LLDP or CDP methods or by using the show lldp commands. Take note of the
following rules and conditions:

• If the switch receives both LLDP and CDP advertisements on the same port from the same neighbor, the
switch stores this information as two separate entries if the advertisements have different chassis ID and port
ID information.

• If the chassis and port ID information are the same, the switch stores this information as a single entry. That is,
LLDP data overwrites the corresponding CDP data in the neighbor database if the chassis and port ID
information in the LLDP and CDP advertisements received from the same device is the same.

• Data read from a CDP packet does not support some LLDP fields, such as "System Descr,"
"SystemCapSupported," and "ChassisType." For such fields, LLDP assigns relevant default values. Also:
◦ The LLDP "System Descr" field maps to CDP's "Version" and "Platform" fields.

◦ The switch assigns "ChassisType" and "PortType" fields as "local" for both the LLDP and the CDP
advertisements it receives.

◦ Both LLDP and CDP support the "System Capability" TLV. However, LLDP differentiates between what a
device is capable of supporting and what it is actually supporting, and separates the two types of
information into subelements of the System Capability TLV. CDP has only a single field for this data. Thus,
when CDP System Capability data is mapped to LLDP, the same value appears in both LLDP System
Capability fields.

◦ System Name and Port Descr are not communicated by CDP, and thus are not included in the switch's
Neighbors database.

IMPORTANT: Because switches do not generate CDP packets, they are not represented in the CDP
data collected by any neighbor devices running CDP.

A switch with CDP disabled forwards the CDP packets it receives from other devices, but does not
store the CDP information from these packets in its own MIB.

LLDP data transmission/collection and CDP data collection are both enabled in the switch's default configuration.
In this state, an SNMP network management application designed to discover devices running either CDP or
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LLDP can retrieve neighbor information from the switch regardless of whether LLDP or CDP is used to collect the
device-specific information.

Protocol state Packet
generation

Inbound data
management

Inbound packet
forwarding

CDP Enabled N/A Store inbound CDP
data.

No forwarding of inbound
CDP packets.

CDP Disabled N/A No storage of CDP
data from neighbor
devices.

Floods inbound CDP
packets from connected
devices to outbound ports.

LLDP Enabled1 Generates and
transmits LLDP
packets out all
ports on the
switch.

Store inbound LLDP
data.

No forwarding of inbound
LLDP packets.

LLDP Disabled No packet
generation.

No storage of LLDP
data from neighbor
devices.

No forwarding of inbound
LLDP packets.

CDP operations
By default the switches have CDP enabled on each port. This is a read-only capability, meaning that the switch
can receive and store information about adjacent CDP devices but does not generate CDP packets.

When a CDP-enabled switch receives a CDP packet from another CDP device, it enters that device's data in the
CDP Neighbors table, along with the port number where the data was received—and does not forward the packet.
The switch also periodically purges the table of any entries that have expired. (The hold time for any data entry in
the switch's CDP Neighbors table is configured in the device transmitting the CDP packet and cannot be
controlled in the switch receiving the packet.) A switch reviews the list of CDP neighbor entries every three
seconds and purges any expired entries.

NOTE:

For details on how to use an SNMP utility to retrieve information from the switch's CDP Neighbors
table maintained in the switch's MIB, see the documentation provided with the particular SNMP utility.

LLDP
To standardize device discovery on all switches, LLDP will be implemented while offering limited read-only
support for CDP, as documented in this manual. For the latest information on your switch model, consult the
Release Notes (available on the Networking website.) If LLDP has not yet been implemented (or if you are
running an older version of software), consult a previous version of the Management and Configuration Guide for
device discovery details.

• LLDP (Link Layer Discovery Protocol): Provides a standards-based method for enabling the switches covered
in this guide to advertise themselves to adjacent devices and to learn about adjacent LLDP devices.

• LLDP-MED (LLDP Media Endpoint Discovery): Provides an extension to LLDP and is designed to support
VoIP deployments.

NOTE: LLDP-MED is an extension for LLDP, and the switch requires that LLDP be enabled as a
prerequisite to LLDP-MED operation.
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An SNMP utility can progressively discover LLDP devices in a network by:

1. Reading a given device's Neighbors table (in the Management Information Base, or MIB) to learn about other,
neighboring LLDP devices.

2. Using the information learned in step 1 to find and read the neighbor devices' Neighbors tables to learn about
additional devices, and so on.

Also, by using show commands to access the switch's neighbor database for information collected by an
individual switch, system administrators can learn about other devices connected to the switch, including device
type (capability) and some configuration information. In VoIP deployments using LLDP-MED on the switches,
additional support unique to VoIP applications is also available.

LLDP operations
An LLDP packet contains data about the transmitting switch and port. The switch advertises itself to adjacent
(neighbor) devices by transmitting LLDP data packets out all ports on which outbound LLDP is enabled and by
reading LLDP advertisements from neighbor devices on ports that are inbound LLDP-enabled. (LLDP is a one-
way protocol and does not include any acknowledgement mechanism.) An LLDP-enabled port receiving LLDP
packets inbound from neighbor devices stores the packet data in a Neighbor database (MIB.)

LLDP-MED
This capability is an extension to LLDP and is available on the switches. See LLDP-MED on page 314.

Packet boundaries in a network topology
• Where multiple LLDP devices are directly connected, an outbound LLDP packet travels only to the next LLDP

device. An LLDP-capable device does not forward LLDP packets to any other devices, regardless of whether
they are LLDP-enabled.

• An intervening hub or repeater forwards the LLDP packets it receives in the same manner as any other
multicast packets it receives. Thus, two LLDP switches joined by a hub or repeater handle LLDP traffic in the
same way that they would if directly connected.

• Any intervening 802.1D device or Layer-3 device that is either LLDP-unaware or has disabled LLDP operation
drops the packet.

LLDP operation configuration options
In the default configuration, LLDP is enabled and in both transmit and receive mode on all active ports. The LLDP
configuration includes global settings, which apply to all active ports on the switch, and per-port settings, which
affect only the operation of the specified ports.

The commands in the LLDP sections affect both LLDP and LLDP-MED operation.

LLDP on the switch
In the default configuration, LLDP is globally enabled on the switch. To prevent transmission or receipt of LLDP
traffic, you can disable LLDP operation.

LLDP-MED
In the default configuration for the switches, LLDP-MED is enabled by default which requires that LLDP is also
enabled.

LLDP packet transmissions to neighbor devices
On a global basis, you can increase or decrease the frequency of outbound LLDP advertisements.
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Time-To-Live for LLDP packets sent to neighbors
On a global basis, you can increase or decrease the time that the information in an LLDP packet outbound from
the switch will be maintained in a neighbor LLDP device.

Transmit and receive mode
With LLDP enabled, the switch periodically transmits an LLDP advertisement (packet) out each active port
enabled for outbound LLDP transmissions and receives LLDP advertisements on each active port enabled to
receive LLDP traffic (Configuring per-port transmit and receive modes on page 316.) Per-port configuration
options include four modes:

• Transmit and receive ( tx_rx): This is the default setting on all ports. It enables a given port to both transmit
and receive LLDP packets and to store the data from received (inbound) LLDP packets in the switch's MIB.

• Transmit only ( txonly): This setting enables a port to transmit LLDP packets that can be read by LLDP
neighbors. However, the port drops inbound LLDP packets from LLDP neighbors without reading them. This
prevents the switch from learning about LLDP neighbors on that port.

• Receive only ( rxonly): This setting enables a port to receive and read LLDP packets from LLDP neighbors
and to store the packet data in the switch's MIB. However, the port does not transmit outbound LLDP packets.
This prevents LLDP neighbors from learning about the switch through that port.

• Disable ( disable): This setting disables LLDP packet transmissions and reception on a port. In this state, the
switch does not use the port for either learning about LLDP neighbors or informing LLDP neighbors of its
presence.

SNMP notification
You can enable the switch to send a notification to any configured SNMP trap receiver(s) when the switch detects
a remote LLDP data change on an LLDP-enabled port (SNMP notification support on page 313.)

Per-port (outbound) data options
The following table lists the information the switch can include in the per-port, outbound LLDP packets it
generates. In the default configuration, all outbound LLDP packets include this information in the TLVs transmitted
to neighbor devices. However, you can configure LLDP advertisements on a per-port basis to omit some of this
information (Remote management address for outbound LLDP advertisements on page 317.)

Table 20: Data available for basic LLDP advertisements

Data type Configuration options Default Description

Time-to-Live 1. 120 Seconds The length of time an
LLDP neighbor retains the
advertised data before
discarding it.

Chassis Type2 N/A Always Enabled Indicates the type of
identifier used for Chassis
ID.

Chassis ID3 N/A Always Enabled Uses base MAC address
of the switch.

Table Continued
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Data type Configuration options Default Description

Port Type43 N/A Always Enabled Uses "Local," meaning
assigned locally by LLDP.

Port Id3 N/A Always Enabled Uses port number of the
physical port. This is an
internal number reflecting
the reserved slot/port
position in the chassis.

Remote Management Address

Type3 N/A Always Enabled Shows the network
address type.

Address5 Default or Configured Uses a default address selection method unless an
optional address is configured.

System Name3 Enable/Disable Enabled Uses the switch's
assigned name.

System Description3 Enable/Disable Enabled Includes switch model
name and running
software version, and
ROM version.

Port Description3 Enable/Disable Enabled Uses the physical port
identifier.

System capabilities
supported3

Enable/Disable Enabled Identifies the switch's
primary capabilities
(bridge, router.)

System capabilities
enabled6 3

Enable/Disable Enabled Identifies the primary
switch functions that are
enabled, such as routing.

1 The packet time-to-live value is included in LLDP data packets. (See Changing the time-to-live for transmitted
advertisements on page 322.)

2 Subelement of the Chassis ID TLV.
3 Populated with data captured internally by the switch. For more on these data types, refer to the IEEE P802.1AB Standard.
4 Subelement of the Port ID TLV.
5 Subelement of the Remote-Management-Address TLV.
6 Subelement of the System Capability TLV.

Remote management address
The switch always includes an IP address in its LLDP advertisements. This can be either an address selected by
a default process or an address configured for inclusion in advertisements.
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Debug logging
You can enable LLDP debug logging to a configured debug destination (Syslog server, a terminal device, or both)
by executing the debug lldp command. Note that the switch's Event Log does not record usual LLDP update
messages.

Options for reading LLDP information collected by the switch
You can extract LLDP information from the switch to identify adjacent LLDP devices. Options include:

• Using the switch's show lldp info command options to display data collected on adjacent LLDP devices—
as well as the local data the switch is transmitting to adjacent LLDP devices (Global LLDP, port admin, and
SNMP notification status on page 329.)

• Using an SNMP application that is designed to query the Neighbors MIB for LLDP data to use in device
discovery and topology mapping.

• Using the walkmib command to display a listing of the LLDP MIB objects

LLDP and LLDP-MED standards compatibility
The operation covered by this section is compatible with these standards:

• IEEE P802.1AB

• RFC 2922 (PTOPO, or Physical Topology MIB)

• RFC 2737 (Entity MIB)

• RFC 2863 (Interfaces MIB)

• ANSI/TIA-1057/D6 (LLDP-MED; refer to LLDP-MED on page 314.)

Port trunking
LLDP manages trunked ports individually. That is, trunked ports are configured individually for LLDP operation, in
the same manner as non-trunked ports. Also, LLDP sends separate advertisements on each port in a trunk, and
not on a per-trunk basis. Similarly, LLDP data received through trunked ports is stored individually, per-port.

IP address advertisements
In the default operation, the port uses the following preference order for IP advertisement:

IPv4:

1. IPV4 address of the Management VLAN

2. IPV4 address of first VLAN that the port is a member of (including tagged and untagged memberships)

3. IPV4 address configured on the primary VLAN

4. IPV4 address configured anywhere else in the device

IPv6:

1. Global unicast address (GUC), site local address (SL), and unique local address (UL) of the Management
VLAN

2. GUC, SL, and UL of first VLAN that the port is a member of (including tagged and untagged memberships)
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3. GUC, SL, and UL configured on the primary VLAN

4. GUC, SL, and UL configured anywhere else in the device

5. LinkLocal Address of a VLAN that the port is a member of

If no IP address is configured on any of the above, the port's MAC address will be advertised.

NOTE: This order is always overridden by the user configured lldp mgmt address on the port.

You can override the default operation by configuring the port to advertise any IP address that is manually
configured on the switch, even if the port does not belong to the VLAN configured with the selected IP address
(Remote management address for outbound LLDP advertisements on page 317.) (Note that LLDP cannot
be configured through the CLI to advertise an addresses acquired through DHCP or Bootp. However, as
mentioned above, in the default LLDP configuration, if the lowest-order IP address on the VLAN with the lowest
VID for a given port is a DHCP or Bootp address, the switch includes this address in its LLDP advertisements
unless another address is configured for advertisements on that port.) Also, although LLDP allows configuring
multiple remote management addresses on a port, only the lowest-order address configured on the port will be
included in outbound advertisements. Attempting to use the CLI to configure LLDP with an IP address that is
either not configured on a VLAN or has been acquired by DHCP or Bootp results in the following error message.

xxx.xxx.xxx.xxx: This IP address is not configured or is a DHCP address.

Spanning-tree blocking
Spanning tree does not prevent LLDP packet transmission or receipt on STP-blocked links.

802.1X blocking
Ports blocked by 802.1X operation do not allow transmission or receipt of LLDP packets.

LLDP operation on the switch
Enabling LLDP operation (the default) causes the switch to:

• Use active, LLDP-enabled ports to transmit LLDP packets describing itself to neighbor devices.

• Add entries to its neighbors table based on data read from incoming LLDP advertisements.

Time-to-Live for transmitted advertisements
The Time-to-Live value (in seconds) for all LLDP advertisements transmitted from a switch is controlled by the
switch that generates the advertisement and determines how long an LLDP neighbor retains the advertised data
before discarding it. The Time-to-Live value is the result of multiplying the refresh-interval by the
holdtime-multiplier.

Delay interval between advertisements
The switch uses a delay-interval setting to delay transmitting successive advertisements resulting from these
LLDP MIB changes. If a switch is subject to frequent changes to its LLDP MIB, lengthening this interval can
reduce the frequency of successive advertisements. You can change the delay-interval by using either an SNMP
network management application or the CLI setmib command.
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Re-initialize delay interval
In the default configuration, a port receiving a disable command followed immediately by a txonly, rxonly, or
tx_rx command delays re-initializing for two seconds, during which LLDP operation remains disabled. If an
active port is subjected to frequent toggling between the LLDP disabled and enabled states, LLDP advertisements
are more frequently transmitted to the neighbor device. Also, the neighbor table in the adjacent device changes
more frequently as it deletes, then replaces LLDP data for the affected port which, in turn, generates SNMP traps
(if trap receivers and SNMP notification are configured.) All of this can unnecessarily increase network traffic.
Extending the re-initialization-delay interval delays the ability of the port to re-initialize and generate LLDP traffic
following an LLDP disable/enable cycle.

SNMP notification support
You can enable SNMP trap notification of LLDP data changes detected on advertisements received from neighbor
devices and control the interval between successive notifications of data changes on the same neighbor.

Changing the minimum interval
If LLDP trap notification is enabled on a port, a rapid succession of changes in LLDP information received in
advertisements from one or more neighbors can generate a high number of traps. To reduce this effect, you can
globally change the interval between successive notifications of neighbor data change.

Basic LLDP per-port advertisement content
In the default LLDP configuration, outbound advertisements from each port on the switch include both mandatory
and optional data.

Mandatory Data
An active LLDP port on the switch always includes the mandatory data in its outbound advertisements. LLDP
collects the mandatory data, and, except for the Remote Management Address, you cannot use LLDP commands
to configure the actual data.

• Chassis Type (TLV subelement)

• Chassis ID (TLV)

• Port Type (TLV subelement)

• Port ID (TLV)

• Remote Management Address (TLV; actual IP address is a subelement that can be a default address or a
configured address)

Optional Data
You can configure an individual port or group of ports to exclude one or more of the following data types from
outbound LLDP advertisements.

• Port description (TLV)

• System name (TLV)

• System description (TLV)

• System capabilities (TLV)
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◦ System capabilities Supported (TLV subelement)

◦ System capabilities Enabled (TLV subelement)

• Port speed and duplex (TLV subelement)

Optional data types, when enabled, are populated with data internal to the switch; that is, you cannot use LLDP
commands to configure their actual content.

Support for port speed and duplex advertisements
This feature is optional for LLDP operation, but is required for LLDP-MED operation.

Port speed and duplex advertisements are supported on the switches to inform an LLDP endpoint and the switch
port of each other's port speed and duplex configuration and capabilities. Configuration mismatches between a
switch port and an LLDP endpoint can result in excessive collisions and voice quality degradation. LLDP enables
discovery of such mismatches by supporting SNMP access to the switch MIB for comparing the current switch
port and endpoint settings. (Changing a current device configuration to eliminate a mismatch requires intervention
by the system operator.)

An SNMP network management application can be used to compare the port speed and duplex data configured
in the switch and advertised by the LLDP endpoint. You can also use the CLI to display this information.

Port VLAN ID TLV support on LLDP
The port-vlan-id option enables advertisement of the port VLAN ID TLV as part of the regularly advertised
TLVs. This allows discovery of a mismatch in the configured native VLAN ID between LLDP peers. The
information is visible using show commands and is logged to the Syslog server.

SNMP support
The LLDP-EXT-DOT1-MIB has the corresponding MIB variables for the Port VLAN ID TLV. The TLV
advertisement can be enabled or disabled using the MIB object lldpXdot1ConfigPortVlanTxEnable in the
lldpXdot1ConfigPortVlanTable.

The port VLAN ID TLV local information can be obtained from the MIB object lldpXdot1LocPortVlanId in the
local information table lldpXdot1LocTable.

The port VLAN ID TLV information about all the connected peer devices can be obtained from the MIB object
lldpXdot1RemPortVlanId in the remote information table lldpXdot1RemTable.

LLDP-MED
LLDP-MED (ANSI/TIA-1057/D6) extends the LLDP (IEEE 802.1AB) industry standard to support advanced
features on the network edge for Voice Over IP (VoIP) endpoint devices with specialized capabilities and LLDP-
MED standards-based functionality. LLDP-MED in the switches uses the standard LLDP commands described
earlier in this section, with some extensions, and also introduces new commands unique to LLDP-MED operation.
The show commands described elsewhere in this section are applicable to both LLDP and LLDP-MED operation.
LLDP-MED benefits include:

• Plug-and-play provisioning for MED-capable, VoIP endpoint devices

• Simplified, vendor-independent management enabling different IP telephony systems to interoperate on one
network

• Automatic deployment of convergence network policies (voice VLANs, Layer 2/CoS priority, and Layer 3/QoS
priority)

• Configurable endpoint location data to support the Emergency Call Service (ECS) (such as Enhanced 911
service, 999, 112)
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• Detailed VoIP endpoint data inventory readable via SNMP from the switch

• Power over Ethernet (PoE) status and troubleshooting support via SNMP

• support for IP telephony network troubleshooting of call quality issues via SNMP

This section describes how to configure and use LLDP-MED features in the switches to support VoIP network
edge devices (media endpoint devices) such as:

• IP phones

• Voice/media gateways

• Media servers

• IP communications controllers

• Other VoIP devices or servers

LLDP-MED interoperates with directly connected IP telephony (endpoint) clients having these features and
services:

• Auto-negotiate speed and duplex configuration with the switch

• Use the following network policy elements configured on the client port

• Voice VLAN ID

• 802.1p (Layer 2) QoS

• Diffserv codepoint (DSCP) (Layer 3) QoS

• Discover and advertise device location data learned from the switch

• Support ECS (such as E911, 999, and 112)

• Advertise device information for the device data inventory collected by the switch, including:

◦ Hardware revision

◦ Firmware revision

◦ Software revision

◦ Serial number

◦ Manufacturer name

◦ Model name

Asset ID

• Provide information on network connectivity capabilities (for example, a multi-port VoIP phone with Layer 2
switch capability)

• Support the fast-start capability

IMPORTANT:

LLDP-MED is intended for use with VoIP endpoints and is not designed to support links between
network infrastructure devices, such as switch-to-switch or switch-to-router links.
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LLDP-MED network elements

Figure 80: LLDP-MED network elements

LLDP-MED classes
LLDP-MED endpoint devices are, by definition, located at the network edge and communicate using the LLDP-
MED framework. Any LLDP-MED endpoint device belongs to one of the following three classes:

• Class 1 (generic endpoint devices): These devices offer the basic LLDP discovery services, network policy
advertisement (VLAN ID, Layer 2/802.1p priority, and Layer 3/DSCP priority), and PoE management. This
class includes such devices as IP call controllers and communication-related servers.

• Class 2 (media endpoint devices): These devices offer all Class 1 features plus media-streaming capability,
and include such devices as voice/media gateways, conference bridges, and media servers.

• Class 3 (communication devices): These devices are typically IP phones or end-user devices that otherwise
support IP media and offer all Class 1 and Class 2 features, plus location identification and emergency 911
capability, Layer 2 switch support, and device information management.

LLDP-MED operational support
The switches offer two configurable TLVs supporting MED-specific capabilities:

• medTlvEnable (for per-port enabling or disabling of LLDP-MED operation)

• medPortLocation (for configuring per-port location or emergency call data)

IMPORTANT:

LLDP-MED operation also requires the port speed and duplex TLV (dot3TlvEnable; page 14-41),
which is enabled in the default configuration.

Topology change notifications provide one method for monitoring system activity. However, because
SNMP normally employs UDP, which does not guarantee datagram delivery, topology change
notification should not be relied upon as the sole method for monitoring critical endpoint device
connectivity.

Configuring per-port transmit and receive modes
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lldp admin-status
Syntax
lldp admin-status <PORT-LIST> [txonly|rxonly|tx_rx|disable]
        
Description

With LLDP enabled on the switch in the default configuration, each port is configured to transmit and receive
LLDP packets. The options allow you to control which ports participate in LLDP traffic and whether the
participating ports allow LLDP traffic in only one direction or in both directions. Defaults to tx_rx.

Parameters and options

txonly

Configures the specified ports to transmit LLDP packets, but block inbound LLDP packets from neighbor
devices.

rxonly

Configures the specified ports to receive LLDP packets from neighbors, but block outbound packets to
neighbors.

tx_rx

Configures the specified ports to both transmit and receive LLDP packets. (This is the default setting.)

disable

Disables LLDP packet transmit and receive on the specified ports.

Remote management address for outbound LLDP advertisements

lldp config ipAddrEnable
Syntax
[no] lldp config  <PORT-LIST>  ipAddrEnable  ip-address 
        
Description

This is an optional command you can use to include a specific IP address in the outbound LLDP advertisements
for specific ports. Replaces the default IP address for the port with an IP address you specify. This can be any IP
address configured in a static VLAN on the switch, even if the port does not belong to the VLAN configured with
the selected IP address.

Default: The port advertises the IP address of the lowest-numbered VLAN (VID) to which it belongs. If there is no
IP address configured on the VLANs to which the port belongs, and if the port is not configured to advertise an IP
address from any other (static) VLAN on the switch, the port advertises an address of 127.0.0.1.)

IMPORTANT: This command does not accept either IP addresses acquired through DHCP or Bootp,
or IP addresses that are not configured in a static VLAN on the switch.

Parameters and options

no

Deletes the specified IP address. If there are no IP addresses configured as management addresses, the IP
address selection method returns to the default operation.
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lldp config

If port 3 belongs to a subnetted VLAN that includes an IP address of 10.10.10.100 and you want port 3 to use this
secondary address in LLDP advertisements, you need to execute the following command:

switch# lldp config 3 ipAddrEnable 10.10.10.100

lldp config basicTlvEnable
Syntax
 lldp config  <PORT-LIST>  basicTlvEnable  <TLV-Type> 
      
Description

Enable basic TLV for LLDP by type and <PORT-LIST> .

Parameters and options

<PORT_DESC>

For outbound LLDP advertisements, this TLV includes an alphanumeric string describing the port. Defaults to
enabled.

<SYSTEM_NAME>

For outbound LLDP advertisements, this TLV includes an alphanumeric string showing the assigned name of
the system. Defaults to enabled.

<SYSTEM_DESCR>

For outbound LLDP advertisements, this TLV includes an alphanumeric string describing the full name and
version identification for the hardware type, software version, and networking application of the system.
Defaults to enabled.

<SYSTEM_CAP>

For outbound advertisements, this TLV includes a bitmask of supported system capabilities (device functions.)
Also includes information on whether the capabilities are enabled. Defaults to enabled.

no lldp config

To exclude the system name TLV from the outbound LLDP advertisements for all ports on a switch, use this
command:

switch# no lldp config 1-24 basicTlvEnable system_name

lldp config

To reinstate the system name TLV on ports 1-5, use this command:

switch# lldp config 1-5 basicTlvEnable system_name

Port speed and duplex advertisement support
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lldp config dot3TlvEnable
Syntax
[no] lldp config  <PORT-LIST>  dot3TlvEnable macphy_config
        
Description

For outbound advertisements, this TLV includes the (local) switch port's current speed and duplex settings, the
range of speed and duplex settings the port supports, and the method required for reconfiguring the speed and
duplex settings on the device (autonegotiation during link initialization, or manual configuration.)

Using SNMP to compare local and remote information can help in locating configuration mismatches. Defaults to
enabled.

IMPORTANT:

For LLDP operation, this TLV is optional. For LLDP-MED operation, this TLV is mandatory.

Location data for LLDP-MED devices

lldp config medPortLocation
Syntax
[no] lldp config  <PORT-LIST>  medPortLocation  Address-Type 
        
Description

Configures location of emergency call data the switch advertises per port in the location_id TLV. This TLV is
for use by LLDP-MED endpoints employing location-based applications. Enables configuration of a physical
address on a switch port and allows up to 75 characters of address information.

IMPORTANT:

The switch allows one medPortLocation entry per port (without regard to type.) Configuring a new
medPortLocation entry of any type on a port replaces any previously configured entry on that port.

Parameters and options

COUNTRY-STR

A two-character country code, as defined by ISO 3166. Some examples include FR (France), DE (Germany),
and IN (India.) This field is required in a civic-addr command. (For a complete list of country codes, see 
http://www.iso.org.)

WHAT

A single-digit number specifying the type of device to which the location data applies: 0: Location of DHCP
server 1: Location of switch 2: Location of LLDP-MED endpoint (recommended application) This field is
required in a civic-addr command.

Type/Value Pairs [CA-TYPE|CA-VALUE]

A series of data pairs, each composed of a location data "type" specifier and the corresponding location data
for that type. That is, the first value in a pair is expected to be the civic address "type" number (CA-TYPE), and
the second value in a pair is expected to be the corresponding civic address data (CA-VALUE.)

For example, if the CA-TYPE for "city name" is "3," the type/value pair to define the city of Paris is "3 Paris."
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Multiple type/value pairs can be entered in any order, although Hewlett Packard Enterprise recommends that
multiple pairs be entered in ascending order of the CA-TYPE.

When an emergency call is placed from a properly configured class 3 endpoint device to an appropriate
PSAP, the country code, device type, and type/value pairs configured on the switch port are included in the
transmission. The "type" specifiers are used by the PSAP to identify and organize the location data
components in an understandable format for response personnel to interpret.

A civic-addr command requires a minimum of one type/value pair, but typically includes multiple type/
value pairs as needed to configure a complete set of data describing a given location.

CA-TYPE: This is the first entry in a type/value pair and is a number defining the type of data contained in the
second entry in the type/value pair (CA-VALUE.) Some examples of CA-TYPE specifiers include:

• 3=city

• 6=street (name)

• 25=building name

(Range: 0 - 255)

CA-VALUE: This is the second entry in a type/value pair and is an alphanumeric string containing the location
information corresponding to the immediately preceding CA-TYPE entry.

Strings are delimited by either blank spaces, single quotes (' … '), or double quotes ("… ".)

Each string should represent a specific data type in a set of unique type/value pairs comprising the description
of a location, and each string must be preceded by a CA-TYPE number identifying the type of data in the
string.

NOTE:

A switch port allows one instance of any given CA-TYPE. For example, if a type/value pair of 6
Atlantic (to specify "Atlantic" as a street name) is configured on port A5 and later another type/
value pair of 6 Pacific is configured on the same port, Pacific replaces Atlantic in the civic
address location configured for port A5.

elin-addr emergency-number

This feature is intended for use in ECS applications to support class 3 LLDP-MED VoIP telephones connected
to a switch in an MLTS infrastructure.

An ELIN is a valid NANP format telephone number assigned to MLTS operators in North America by the
appropriate authority. The ELIN is used to route emergency (E911) calls to a PSAP.

(Range: 1-15 numeric characters)

Usage
civic-addr  <COUNTRY-STR>   <WHAT>   <CA-TYPE>   <CA-VALUE>  … <CA-TYPE>   <CA-VALUE> … <CA-TYPE>   <CA-VALUE> 
        

LLDP data change notification for SNMP trap receivers

lldp enable-notification
Syntax
[no] lldp enable-notification  <PORT-LIST> 
      
Description
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Enables or disables each port in <PORT-LIST> for sending notification to configured SNMP trap receivers if an
LLDP data change is detected in an advertisement received on the port from an LLDP neighbor. Defaults to
disabled.

Enable SNMP notification on ports 1 - 5

switch# lldp enable-notification 1-5

LLDP operation on the switch

lldp run
Syntax
[no] lldp run
Description

Enables or disables LLDP operation on the switch.

Parameters and options

no

Regardless of individual LLDP port configurations, prevents the switch from transmitting outbound LLDP
advertisements and causes the switch to drop all LLDP advertisements received from other devices.

The switch preserves the current LLDP configuration when LLDP is disabled. After LLDP is disabled, the
information in the LLDP neighbors database remains until it times-out. Defaults to enabled.

Disable lldp on the switch

switch# no lldp run

LLDP-MED fast start control

lldp fast-start-count
Syntax
lldp fast-start-count  <1 - 10> 
        
Description

An LLDP-MED device connecting to a switch port may use the data contained in the MED TLVs from the switch to
configure itself. However, the lldp refresh-interval setting (default: 30 seconds) for transmitting
advertisements can cause an unacceptable delay in MED device configuration.

To support rapid LLDP-MED device configuration, the lldp fast-start-count command temporarily
overrides the refresh-interval setting for the fast-start-count advertisement interval. This results in the
port initially advertising LLDP-MED at a faster rate for a limited time. Thus, when the switch detects a new LLDP-
MED device on a port, it transmits one LLDP-MED advertisement per second out the port for the duration of the
fast-start-count interval. In most cases, the default setting should provide an adequate fast-start-
count interval. Defaults to 5 seconds.
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This global command applies only to ports on which a new LLDP-MED device is detected. It does not override the
refresh-interval setting on ports where non-MED devices are detected.

Changing the packet transmission interval
This interval controls how often active ports retransmit advertisements to their neighbors.

lldp refresh-interval
Syntax
lldp refresh-interval <5 - 32768>
      
Description

Changes the interval between consecutive transmissions of LLDP advertisements on any given port. Defaults to
30 seconds.

The refresh-interval must be greater than or equal to (4 x delay-interval.) (The default delay-
interval is 2.) For example, with the default delay-interval, the lowest refresh-intervalyou can use is
8 seconds (4 x 2=8.) Thus, if you want a refresh-interval of 5 seconds, you must first change the delay
interval to 1 (that is, 4 x 1 5.) If you want to change the delay-interval, use the setmib command.

Changing the time-to-live for transmitted advertisements

lldp holdtime-multiplier
Syntax
lldp holdtime-multiplier <2 - 10>
        
Description

Changes the multiplier an LLDP switch uses to calculate the Time-to-Live for the LLDP advertisements it
generates and transmits to LLDP neighbors. When the Time-to-Live for a given advertisement expires, the
advertised data is deleted from the neighbor switch's MIB. Defaults to 4.

If the refresh-interval on the switch is 15 seconds and the holdtime-multiplier is at the default, the Time-to-
Live for advertisements transmitted from the switch is 60 seconds (4 x 15.)

Reduce time-to-live

To reduce the Time-to-Live, you could lower the holdtime-interval to 2, which would result in a Time-to-Live
of 30 seconds.

switch# lldp holdtime-multiplier 2

Delay interval
To change the delay interval between advertisements generated by value or status changes to the LLDP MIB, use
the following command.
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set mib lldpTxDelay.0
Syntax
setmib lldpTxDelay.0 -i <1 - 8192>
        
Uses setmib to change the minimum time (delay-interval) any LLDP port will delay advertising successive LLDP
advertisements because of a change in LLDP MIB content. Defaults to 2.

The LLDP refresh-interval (transmit interval) must be greater than or equal to (4 x delay-interval.) The switch does
not allow increasing the delay interval to a value that conflicts with this relationship. That is, the switch displays
Inconsistent value if (4 x delay-interval) exceeds the current transmit interval, and the command fails.
Depending on the current refresh-interval setting, it may be necessary to increase the refresh-interval before
using this command to increase the delay-interval.

Change the delay-interval

To change the delay-interval from 2 seconds to 8 seconds when the refresh-interval is at the default 30 seconds,
you must first set the refresh-interval to a minimum of 32 seconds (32 = 4 x 8.) (See Figure 81: Changing the
transmit-delay interval on page 323.)

Figure 81: Changing the transmit-delay interval

Changing the reinitialization delay interval

setmib lldpReinitDelay.0
Syntax
setmib lldpReinitDelay.0 -i <1-10>
        
Uses setmib to change the minimum time (reinitialization delay interval) an LLDP port will wait before
reinitializing after receiving an LLDP disable command followed closely by a txonly or tx_rx command. The delay
interval commences with execution of the lldp admin-status <PORT-LIST> disable command. Defaults
to 2.

Change the reinitialization delay interval

The following command changes the reinitialization delay interval to five seconds:

switch# setmib lldpreinitdelay.0 -i 5
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PVID mismatch log messages
PVID mismatches are logged when there is a difference in the PVID advertised by a neighboring switch and the
PVID of the switch port which receives the LLDP advertisement. Logging is an LLDP feature that allows detection
of possible vlan leakage between adjacent switches. However, if these events are logged too frequently, they can
overwhelm the log buffer and push relevant logging data out of log memory, making it difficult to troubleshoot
another issue.

Use the following command to enable or disable the logging of the PVID mismatch log messages:

logging filter
Syntax
logging filter [<filter-name> enable] [<filter-name><sub filter id><regularexpression> deny]
        
Description

Filters out PVID mismatch log messages on a per-port basis, allowing you to disable or enable logging using the
CLI. This includes displaying the Mac-Address in the PVID mismatch log message when the port ID is Mac-
Address instead of displaying garbage characters in the peer device port ID field.

Parameters and options

Regular-expression

The regular expression should match the message which is to be filtered.

Viewing port configuration details

show lldp config
Syntax
show lldp config <PORT-LIST>
      
Description

Displays the LLDP port-specific configuration for all ports in <PORT-LIST>, including which optional TLVs and any
non-default IP address that are included in the port's outbound advertisements.

324 Aruba 3810 / 5400R Management and Configuration Guide for
ArubaOS-Switch 16.08

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4062



show lldp config

Figure 82: Per-port configuration display

Available switch information available outbound advertisements

show lldp info local-device
Syntax
show lldp info local-device<PORT-LIST>
        
Description

Displays global switch information and per-port information currently available for populating outbound LLDP
advertisements. This command displays the information available on the switch. Use the lldp config <PORT-
LIST> command to change the selection of information that is included in actual outbound advertisements. In
the default LLDP configuration, all information displayed by this command is transmitted in outbound
advertisements.

Parameters and options

<PORT-LIST>

Without the <PORT-LIST> option, displays the global switch information and the per-port information
currently available for populating outbound LLDP advertisements.

With the <PORT-LIST> option, displays only the following port-specific information that is currently available
for outbound LLDP advertisements on the specified ports:
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• PortType
• PortId
• PortDesc

show lldp info local-device output

In the default configuration, the switch information currently available for outbound LLDP advertisements appears
similar to the display in Figure 83: Displaying the global and per-port information available for outbound
advertisements on page 326.

Figure 83: Displaying the global and per-port information available for outbound advertisements

Default per-port information content for ports 1 and 2

switch# show lldp info local 1-2

  LLDP Local Port Information Detail

   Port     : 1
   PortType : local
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   PortId   : 1
   PortDesc : 1

---------------------------------------- 
   Port     : 2
   PortType : local
   PortId   : 2
   PortDesc : 2

LLDP statistics

show lldp stats
Syntax
show lldp stats<PORT-LIST>
        
Description

Displays (globally) an overview of neighbor detection activity on the switch, plus data on the number of frames
sent, received, and discarded per-port. The per-port LLDP statistics command enhances the list of per-port
statistics provided by the global statistics command with some additional per-port LLDP statistics.

Parameters and options

Neighbor Entries List Last Updated

The elapsed time since a neighbor was last added or deleted.

New Neighbor Entries Count

The total of new LLDP neighbors detected since the last switch reboot. Disconnecting, and then reconnecting
a neighbor increments this counter.

Neighbor Entries Deleted Count

The number of neighbor deletions from the MIB for AgeOut Count and forced drops for all ports.

For example, if the admin status for port on a neighbor device changes from tx_rx or txonly to disabled
or rxonly, the neighbor device sends a "shutdown" packet out the port and ceases transmitting LLDP frames
out that port.

The device receiving the shutdown packet deletes all information about the neighbor received on the
applicable inbound port and increments the counter.

This can occur, for example, when a new neighbor is detected when the switch is already supporting the
maximum number of neighbors. See Neighbor maximum on page 339.

Neighbor Entries Dropped Count

The number of valid LLDP neighbors the switch detected, but could not add.

Neighbor Entries AgeOut Count

The number of LLDP neighbors dropped on all ports because of Time-to-Live expiring.

NumFramesRecvd

The total number of valid, inbound LLDP advertisements received from any neighbors on <PORT-LIST> .

Where multiple neighbors are connected to a port through a hub, this value is the total number of LLDP
advertisements received from all sources.
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NumFramesSent

The total number of LLDP advertisements sent from <PORT-LIST> .

NumFramesDiscarded

The total number of inbound LLDP advertisements discarded by <PORT-LIST> .

This can occur, for example, when a new neighbor is detected on the port, but the switch is already supporting
the maximum number of neighbors. See Neighbor maximum on page 339. This can also be an indication of
advertisement formatting problems in the neighbor device.

Frames Invalid

The total number of invalid LLDP advertisements received on the port.

An invalid advertisement can be caused by header formatting problems in the neighbor device.

TLVs Unrecognized

The total number of LLDP TLVs received on a port with a type value in the reserved range.

This can be caused by a basic management TLV from a later LLDP version than the one currently running on
the switch.

TLVs Discarded

The total number of LLDP TLVs discarded for any reason. In this case, the advertisement carrying the TLV
may be accepted, but the individual TLV is not usable.

Neighbor Ageouts

The number of LLDP neighbors dropped on the port because of Time-to-Live expiring.

A global LLDP statistics display

switch# show lldp stats

 LLDP Device Statistics

  Neighbor Entries List Last Updated : 2 hours
  New Neighbor Entries Count : 20
  Neighbor Entries Deleted Count : 20
  Neighbor Entries Dropped Count : 0
  Neighbor Entries AgeOut Count : 20

 LLDP Port Statistics
 
  Port   | NumFramesRecvd NumFramesSent NumFramesDiscarded
  ------ + -------------- ------------- ------------------ 
  A1     | 97317          97843         0
  A2     | 21             12            0
  A3     | 0              0             0
  A4     | 446            252           0
  A5     | 0              0             0
  A6     | 0              0             0
  A7     | 0              0             0
  A8     | 0              0             0

A per-port LLDP statistics display

switch# show lldp stats 1

 LLDP Port Statistics Detail
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  PortName : 1
  Frames Discarded  : 0
  Frames Invalid    : 0
  Frames Received   : 7309
  Frames Sent       : 7231
  TLVs Unrecognized : 0
  TLVs Discarded    : 0
  Neighbor Ageouts  : 0

Global LLDP, port admin, and SNMP notification status
In the default configuration, LLDP is enabled and in both transmit and receive mode on all active ports. The LLDP
configuration includes global settings that apply to all active ports on the switch, and per-port settings that affect
only the operation of the specified ports.

The commands in this section affect both LLDP and LLDP-MED operation.

show lldp config
Syntax
show lldp config
Displays the LLDP global configuration, LLDP port status, and SNMP notification status.

View default LLDP

show lldp config produces the following display when the switch is in the default LLDP configuration. The
values displayed in the LLDP column correspond to the lldp refresh-interval command.

switch# show lldp config

LLDP Global Configuration

LLDP Enabled [Yes] :             Yes
LLDP Transmit Interval [30] :    30
LLDP Hold time Multiplier [4] :  4
LLDP Delay Interval [2] :        2
LLDP Reinit Interval [2] :       2
LLDP Notification Interval [5] : 5
LLDP Fast Start Count [5] :      5

LLDP Port Configuration
Port | AdminStatus NotificationEnabled  Med Topology Trap Enabled
---- + ----------- -------------------  -------------------------
A1 |    Tx_Rx          False            False
A2 |    Tx_Rx          False            False
A3 |    Tx_Rx          False            False
A4 |    Tx_Rx          False            False
A5 |    Tx_Rx          False            False
A6 |    Tx_Rx          False            False
A7 |    Tx_Rx          False            False
A8 |    Tx_Rx          False            False

LLDP-MED connects and disconnects—topology change notification
This optional feature provides information an SNMP application can use to track LLDP-MED connects and
disconnects.
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lldp top-change-notify
Syntax
lldp top-change-notify <PORT-LIST>
        
Description

Defaults to disabled. When enabled on an LLDP port, topology change notification causes the switch to send an
SNMP trap if it detects LLDP-MED endpoint connection or disconnection activity on the port, or an age-out of the
LLDP-MED neighbor on the port.

The trap includes the following information:

• The port number (internal) on which the activity was detected.

• The LLDP-MED class of the device detected on the port.

To send traps, this feature requires access to at least one SNMP server.

If a detected LLDP-MED neighbor begins sending advertisements without LLDP-MED TLVs, the switch sends a
top-change-notify trap.

View topology change notification status

You can use the show running command shows whether the topology change notification feature is enabled or
disabled. For example, if ports A1 to A10 have topology change notification enabled, the following entry appears
in the show running output:

lldp top-change-notify A1-A10

Device capability, network policy, PoE status and location data
The medTlvEnable option on the switch is enabled in the default configuration and supports the following LLDP-
MED TLVs:

• LLDP-MED capabilities: This TLV enables the switch to determine:
◦ Whether a connected endpoint device supports LLDP-MED

◦ Which specific LLDP-MED TLVs the endpoint supports

◦ The device class (1, 2, or 3) for the connected endpoint

This TLV also enables an LLDP-MED endpoint to discover what LLDP-MED TLVs the switch port currently
supports.

• Network policy operating on the port to which the endpoint is connected (VLAN, Layer 2 QoS, Layer 3 QoS.)

• PoE (MED Power-over-Ethernet.)

• Physical location data.

LLDP-MED operation requires the macphy_config TLV subelement (enabled by default) that is optional for IEEE
802.1AB LLDP operation. For more information, see the dot3TlvEnable macphy_config command.

Network policy advertisements
Network policy advertisements are intended for real-time voice and video applications, and include these TLV
sub-elements:
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• Layer 2 (802.1p) QoS

• Layer 3 DSCP (diffserv code point) QoS

• Voice VLAN ID (VID)

VLAN operating rules
These rules affect advertisements of VLANs in network policy TLVs:

• The VLAN ID TLV subelement applies only to a VLAN configured for voice operation ( vlan vid voice .)

• If there are multiple voice VLANs configured on a port, LLDP-MED advertises the voice VLAN having the
lowest VID.

• The voice VLAN port membership configured on the switch can be tagged or untagged. However, if the LLDP-
MED endpoint expects a tagged membership when the switch port is configured for untagged, or the reverse,
a configuration mismatch results. (Typically, the endpoint expects the switch port to have a tagged voice VLAN
membership.)

• If a given port does not belong to a voice VLAN, the switch does not advertise the VLAN ID TLV through this
port.

Policy elements
These policy elements may be statically configured on the switch or dynamically imposed during an authenticated
session on the switch using a RADIUS server and 802.1X or MAC authentication. (Web authentication does not
apply to VoIP telephones and other telecommunications devices that are not capable of accessing the switch
through a Web browser.) The QoS and voice VLAN policy elements can be statically configured with the following
CLI commands:

vlan  <VID>  voice
        
vlan <VID> [tagged|untagged] <PORT-LIST>
int <PORT-LIST>  qos priority  0 - 7 
        
vlan  vid  qos dscp  codepoint 
        
A codepoint must have an 802.1p priority before you can configure it for use in prioritizing packets by VLAN-ID. If
a codepoint you want to use shows No Override in the Priority column of the DSCP policy table (display
with show qos-dscp map, then use qos-dscp map codepoint priority 0 - 7 to configure a priority
before proceeding.

For more information on this topic, see the advanced traffic management guide.

PoE advertisements
These advertisements inform an LLDP-MED endpoint of the power (PoE) configuration on switch ports. Similar
advertisements from an LLDP-MED endpoint inform the switch of the endpoint's power needs and provide
information that can be used to identify power priority mismatches.

PoE TLVs include the following power data:

Power type

Indicates whether the device is a power-sourcing entity (PSE) or a PD. Ports on the J8702A PoE zl module
are PSE devices. A MED-capable VoIP telephone is a PD.
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Power source

Indicates the source of power in use by the device. Power sources for PDs include PSE, local (internal), and
PSE/local. The switches advertise unknown.

Power priority

Indicates the power priority configured on the switch (PSE) port or the power priority configured on the MED-
capable endpoint.

Power value

Indicates the total power in watts that a switch port (PSE) can deliver at a particular time, or the total power in
watts that the MED endpoint (PD) requires to operate.

Location data for LLDP-MED devices
You can configure a switch port to advertise location data for the switch itself, the physical wall-jack location of the
endpoint (recommended), or the location of a DHCP server supporting the switch, endpoint, or both. You also
have the option of configuring these different address types:

Civic address

Physical address data such as city, street number, and building information.

ELIN (Emergency Location Identification Number)

An emergency number typically assigned to MLTS (Multiline Telephone System) Operators in North America.

Coordinate-based location

Attitude, longitude, and altitude information (Requires configuration via an SNMP application.)

Coordinate-based locations
Latitude, longitude, and altitude data can be configured per switch port using an SNMP management application.
For more information, see the documentation provided with the application. A further source of information on this
topic is the RFC 3825: Dynamic Host Configuration Protocol Option for Coordinate-based Location Configuration
Information.

IMPORTANT: Endpoint use of data from a medPortLocation TLV sent by the switch is device-
dependent. See the documentation provided with the endpoint device.

The code assignments in the following table are examples from a work-in-progress (the internet draft titled
"Dynamic Host Configuration Protocol (DHCPv4 and DHCPv6) Option for Civic Addresses Configuration
Information draft-ietf-geopriv-dhcp-civil-06" dated May 30, 2005.) For the actual codes to use, contact the PSAP
or other authority responsible for specifying the civic addressing data standard for your network.

Table 21: Some location codes used in CA-TYPE fields

Location element Code Location element Code

national subdivision 1 street number 19

regional subdivision 2 additional location data 22

city or township 3 unit or apartment 26

city subdivision 4 floor 27

Table Continued
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Location element Code Location element Code

street 6 room number 28

street suffix 18

Example

Suppose a system operator wants to configure the following information as the civic address for a telephone
connected to her company's network through port A2 of a switch at the following location:

Description CA-type CA-VALUE

national subdivision 1 CA

city 3 Widgitville

street 6 Main

street number 19 1433

unit 26 Suite 4-N

floor 27 4

room number 28 N4-3

Example of a civic address configuration on page 333 shows the commands for configuring and displaying
the above data.

Example of a civic address configuration

switch# lldp config 2 medportlocation civic-addr US 2 1 CA 3
Widgitville 6 Main 19 1433 26 Suite_4—N 27 4 28 N4—3

switch# show lldp config 2
 LLDP Port Configuration Detail
  Port : A2
  AdminStatus [Tx_Rx] : Tx_Rx
  NotificationEnabled [False] : False
  Med Topology Trap Enabled [False] : False
  Country Name          : US 
  What                  : 2
  Ca-Type               : 1
  Ca-Length             : 2
  Ca-Value              : CA 
  Ca-Type               : 3
  Ca-Length             : 11
  Ca-Value              : Widgitville
  Ca-Type               : 6
  Ca-Length             : 4
  Ca-Value              : Main
  Ca-Type               : 19
  Ca-Length             : 4
  Ca-Value              : 1433
  Ca-Type               : 26
  Ca-Length             : 9
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  Ca-Value              : Suite_4-N 
  Ca-Type               : 27
  Ca-Length             : 1
  Ca-Value              : 4
  Ca-Type               : 28
  Ca-Length             : 4
  Ca-Value              : N4-3

Viewing the current port speed and duplex configuration
You can compare port speed and duplex information for a switch port and a connected LLDP-MED endpoint for
configuration mismatches by using an SNMP application. You can also use the switch CLI to display this
information, if necessary. The show interfaces brief <PORT-LIST> and show lldp info remote-
device<PORT-LIST> commands provide methods for displaying speed and duplex information for switch ports.
For information on displaying the currently configured port speed and duplex on an LLDP-MED endpoint.

Viewing LLDP statistics
LLDP statistics are available on both a global and a per-port levels. Rebooting the switch resets the LLDP
statistics counters to zero. Disabling the transmit and/or receive capability on a port "freezes" the related port
counters at their current values.

LLDP over OOBM
The following commands enable the user to configure LLDP for OOBM ports.

lldp admin-status oobm
Syntax
lldp admin-status oobm [ txonly | rxonly | tx_rx | disable ]
Description

This command sets the OOBM port operational mode.

Parameters and options
txonly
Sets in transmit only mode.

rxonly
Sets in receive mode.

tx_rx
Sets in transmit and receive mode.

disable
Disables lldp on OOBM port.

lldp enable-notification oobm
Syntax
[no] lldp enable-notification oobm
Description

This command enables or disables notification on the OOBM port.

Parameters and options
oobm
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Enables notification on the OOBM port.

no
Disables notification.

Enable-notification

switch(config)#lldp enable-notification ?
oobm                  Enable or disable notification on the OOBM port.
[ethernet] PORT-LIST  Enable notification on the specified ports.

show lldp config
Syntax
show lldp config [[ethernet] PORT-LIST | oobm]
Description

This command shows LLDP configuration information.

Parameters and options
[ethernet] PORT-LIST
Shows port-list configuration information.

oobm
Shows oobm LLDP configuration information.

show lldp config

switch(config)#show lldp config

LLDP Global Configuration

  LLDP Enabled [Yes] : Yes
  LLDP Transmit Interval    [30] : 30
  LLDP Hold time Multiplier  [4] : 4
  LLDP Delay Interval        [2] : 2
  LLDP Reinit Interval       [2] : 2
  LLDP Notification Interval [5] : 5
  LLDP Fast Start Count      [5] : 5

 LLDP Port Configuration

  Port   | AdminStatus NotificationEnabled Med Topology Trap Enabled
  ------ + ----------- ------------------- -------------------------
  1      | Tx_Rx       False               False
  2      | Tx_Rx       False               False
  3      | Tx_Rx       False               False
  4      | Tx_Rx       False               False
  5      | Tx_Rx       False               False
  6      | Tx_Rx       False               False
  7      | Tx_Rx       False               False
  8      | Tx_Rx       False               False
  9      | Tx_Rx       False               False
 OOBM    | Tx_Rx       False               False
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show lldp config oobm
Syntax
show lldp config oobm
Description

This command shows oobm LLDP configuration information.

show lldp config oobm

switch(config)#show lldp config oobm

LLDP Port Configuration Detail

  Port : OOBM
  AdminStatus [Tx_Rx] : Tx_Rx
  NotificationEnabled [False] : False
  Med Topology Trap Enabled [False] : False

  TLVS Advertised:
   * port_descr
   * system_name
   * system_descr
   * system_cap

  IpAddress Advertised:
   * 10.0.0.1

show lldp info
Syntax
show lldp info <local-device | remote-device> [[ethernet] PORT-LIST | oobm]
Description

This command shows LLDP information about a local or remote device.

Parameters and options
local-device

Shows LLDP information about a local device.

remote-device
Shows LLDP information about a remote device.

Subcommands

The following are next level parameters of a local-or remote-device.

[ethernet] PORT-LIST
Shows port-list configuration information.

oobm
Shows oobm LLDP configuration information.

show lldp info local-device
Syntax
show lldp info local-device
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Description

This command shows LLDP information about a local device.

show lldp info local-device

Switch(config)# show lldp info local-device

LLDP Local Device Information

  Chassis Type : mac-address
  Chassis Id   : 08 2e 5f 69 8c 00
  System Name  : Switch
  System Description : Switch, revision XX.15.15.000...
  System Capabilities Supported: bridge, router
  System Capabilities Enabled: bridge

  Management Address  :
     Type: ipv4
     Address: 20.0.0.1

  OOBM Management Address:
     Type: ipv4
     Address: 100.0.0.1

 LLDP Port Information

  Port     PortType PortId   PortDesc
  -------- -------- -------- --------
  1        local    1        1
  2        local    2        2
  3        local    3        3
  4        local    4        4
  5        local    5        5
 OOBM      local    4000     OOBM
      

show lldp info local-device oobm
Syntax
show lldp info local-device oobm
Description

This command shows LLDP information about a local device for the specified oobm ports.

show lldp info local-device oobm

switch(config)# show lldp info local-device oobm
LLDP Local Port Information Detail

  Port     : OOBM
  PortType : local
  PortId   : 4000
  PortDesc : OOBM
  Pvid     : n/a

show lldp info remote-device oobm
Syntax
show lldp info remote-device oobm
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Description

This command shows LLDP information about a remote device for the specified oobm ports.

show lldp info remote-device oobm

switch(config)# show lldp info remote-device oobm

 LLDP Remote Device Information Detail

  Local Port   : OOBM
  ChassisType  : mac-address
  ChassisId    : b4 b5 2f a8 84 00
  PortType     : local
  PortId       : 21
  SysName      : Switch
  System Descr : Switch, revision XX.15.15.000...
  PortDescr    : 21
  Pvid         : 

  System Capabilities Supported  : bridge, router
  System Capabilities Enabled    : bridge

  Remote Management Address
     Type    : all802
     Address : b4 b5 2f a8 84 00

show lldp info remote-device 21

switch(config)# show lldp info remote-device 21

 LLDP Remote Device Information Detail

  Local Port   : 21
  ChassisType  : mac-address
  ChassisId    : b4 b5 2f a8 84 00
  PortType     : local
  PortId       : OOBM
  SysName      : Switch
  System Descr : Switch, revision XX.15.15.000...
  PortDescr    : OOBM
  Pvid         : 

  System Capabilities Supported  : bridge, router
  System Capabilities Enabled    : bridge

  Remote Management Address
     Type    : all802
     Address : b4 b5 2f a8 84 00

show lldp stats
Syntax
show lldp stats [[ethernet] PORT-LIST | oobm]
Description

This command shows LLDP statistics.

Parameters and options
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oobm
Shows statistics for the specified ports.

show lldp stats

switch(config)# show lldp stats

 LLDP Device Statistics

  Neighbor Entries List Last Updated : 45 mins
  New Neighbor Entries Count : 2
  Neighbor Entries Deleted Count : 0
  Neighbor Entries Dropped Count : 0
  Neighbor Entries AgeOut Count : 0

 LLDP Port Statistics

  Port   | NumFramesRecvd NumFramesSent NumFramesDiscarded
  ------ + -------------- ------------- ------------------
  1      | 91             96            0
  2      | 91             96            0
 OOBM    |  1              6            0

LLDP operating notes
Neighbor maximum
The neighbors table in the switch supports as many neighbors as there are ports on the switch. The switch can
support multiple neighbors connected through a hub on a given port, but if the switch neighbor maximum is
reached, advertisements from additional neighbors on the same or other ports will not be stored in the neighbors
table unless some existing neighbors time-out or are removed.

LLDP packet forwarding
An 802.1D-compliant switch does not forward LLDP packets, regardless of whether LLDP is globally enabled or
disabled on the switch.

One IP address advertisement per port
LLDP advertises only one IP address per port, even if multiple IP addresses are configured by lldp config
<PORT-LIST> ipAddrEnable on a given port.

802.1Q VLAN information
LLDP packets do not include 802.1Q header information and are always handled as untagged packets.

Effect of 802.1X operation
If 802.1X port security is enabled on a port, and a connected device is not authorized, LLDP packets are not
transmitted or received on that port. Any neighbor data stored in the neighbor MIB for that port prior to the
unauthorized device connection remains in the MIB until it ages out. If an unauthorized device later becomes
authorized, LLDP transmit and receive operation resumes.

Disconnecting a neighbor LLDP device
After disconnecting a neighbor LLDP device from the switch, the neighbor can continue to appear in the switch's
neighbor database for an extended period if the neighbor's holdtime-multiplier is high; especially if the
refresh-interval is large. See Changing the time-to-live for transmitted advertisements on page 322.

Chapter 9 Configuring for Network Management Applications 339

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4077



Mandatory TLVs
All mandatory TLVs required for LLDP operation are also mandatory for LLDP-MED operation.

Topology change notification
Enabling topology change notification on a switch port and then connecting or disconnecting an LLDP-MED
endpoint on that port causes the switch to send an SNMP trap to notify the designated management stations. The
port number included in the trap corresponds to the internal number the switch maintains for the designated port,
and not the port's external (slot/number) identity. To match the port's external slot/number to the internal port
number appearing in an SNMP trap, use the walkmib ifDescr command, as shown in Figure 84: Matching
internal port numbers to external slot/port numbers on page 340.

Figure 84: Matching internal port numbers to external slot/port numbers

Advertisements currently in the neighbors MIB

show lldp info remote-device
Syntax
show lldp info remote-device<PORT-LIST>
Description

Without the <PORT-LIST> option, provides a global list of the individual devices it has detected by reading LLDP
advertisements. Discovered devices are listed by the inbound port on which they were discovered.

Multiple devices listed for a single port indicates that such devices are connected to the switch through a hub.

Discovering the same device on multiple ports indicates that the remote device may be connected to the
switch in one of the following ways:
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• Through different VLANS using separate links. (This applies to switches that use the same MAC address for
all configured VLANs.)

• Through different links in the same trunk.

• Through different links using the same VLAN. (In this case, spanning-tree should be invoked to prevent a
network topology loop. Note that LLDP packets travel on links that spanning-tree blocks for other traffic types.)

With the <PORT-LIST> option, provides a listing of the LLDP data that the switch has detected in
advertisements received on the specified ports.

See also Table 20: Data available for basic LLDP advertisements on page 309.

A global listing of discovered devices

Switch# show lldp info remote

 LLDP Remote Devices Information

  LocalPort | ChassisId                 PortId PortDescr SysName
  --------- + ------------------------- ------ --------- -------------
  1         | 00 11 85 35 3b 80         6      6         Switch 3500yl
  2         | 00 11 85 cf 66 60         8      8         Switch 3500yl
Figure 85: An LLLDP-MED listing of an advertisement received from an LLDP-MED (VoIP telephone) source

PoE advertisements
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show lldp info remote-device
Syntax
show lldp info remote-device <PORT-LIST>
      
Description

Display the current power data for an LLDP-MED device connected to a port.

show power
show power <PORT-LIST>
      
Description

Display the current PoE configuration on the switch.

Overview
A command has been written to suppress the IPv4 / IPv6 management address transmission in outgoing LLDP
packets.

A local LAN device transmits organization-specific information in the form of type, length, and value (TLV). The
organization-associated values are stored in the LLDP organizationally defined local device LLDP MIB
extensions. Management address TLV in IPv4 and IPv6 environments is optional from the TLV basic management
set.

TLV basic management set

• Port description TLV — Describes the port in an alpha-numeric format. The value equals the ifDescr object,
if the LAN device supports RFC 2863.

• System name TLV — Assigns the system name in an alpha-numeric format. The value equals the sysName
object, if the LAN device supports RFC 3418.

• System description TLV — Describes the network entity in an alpha-numeric format. The system description
TLV includes the system name, versions of hardware, operating system, and networking software supported in
the device. The value equals the sysDescr object, if the LAN device supports RFC 3418.

• System capabilities TLV — Indicates primary functions of the device and if they are enabled in the device.

• Management address TLV — Indicates the addresses of the local LLDP agent. Other remote managers can
use this address to obtain information related to the local device.

The command lldp config <all> ipAddrEnable <IP_ADDR> is used to advertise specific IP address
through the port.

The command [no] lldp config <PORT NO> basicTlvEnable management_addr suppresses the IP
address to be advertised.

Commands

[no] lldp config basicTlvEnable management_addr
Syntax

In the configure context:

[no] lldp config <PORT_NUM> basicTlvEnable management_addr
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Description

The feature suppresses the IPv4 or IPv6 address as well as suppresses the MAC address if the [no] ip
address is configured. By default this management address TLV is enabled in switch. No other TLV (except
management address TLV) suppression will occur when this command is used.

Parameters

Management_addr

Management TLV

Example

[no] lldp config all basicTlvEnable management_addr

lldp config
Syntax
lldp config <port-number>
    
Description

Configure the lldp for the desired port by number.

Parameter
basicTlvEnable

Enables the basic advertised TLV for each port by number.

Options

<management_addr>

Use the option <management_addr> to specify specific devices to enable TLV advertisement.

Usage
lldp config <port_num> basicTlvEnable <management_addr>

Show commands
Use the command show running-config to view the lldp configuration.

Example

switch# show running-config

Running configuration:
...
no lldp config 1 basicTlvEnable management_addr
Example

switch# show lldp config 1

LLDP Port Configuration Detail

  Port : 1
  AdminStatus [Tx_Rx] : Tx_Rx
  NotificationEnabled [False] : False
  Med Topology Trap Enabled [False] : False
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  TLVS Advertised:
   
* management_addr 
   
   
  IpAddress Advertised:

TVL configuration

VLAN ID TLV

lldp config dot1T1vEnable
Syntax
[no] lldp config <PORT-LIST> dot1TlvEnable port-vlan-id
      
Description

Use this command to enable or disable the VLAN ID TLV advertisement. Defaults to enabled.

Parameters and options

no

Disables the TLV advertisement.

Enabling the VLAN ID TLV

switch# lldp config a1 dot1TlvEnable port-vlan-id

Advertised TLVs

show lldp config
Syntax
show lldp config <PORT_NAME>
      
Description
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The show commands display the configuration of the TLVs. The command show lldp config lists the TLVs
advertised for each port.

Figure 86: Displaying the TLVs for a port

Figure 87: Example of local device LLDP information

Figure 88: Example of remote device LLDP information
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TLVs controlled by medTLvEnable

lldp config medTlvEnable
Syntax
[no] lldp config <PORT-LIST>  medTlvEnable  <MEDTLV> 
      
Description

TLVs controlled by medTlvEnable in the LLDP-MED configuration default to enabled.

This command enables or disables advertisement of the following TLVs on the specified ports:

• Device capability TLV

• Configured network policy TLV

• Configured location data TLV

• Current PoE status TLV

Helps to locate configuration mismatches by allowing use of an SNMP application to compare the LLDP-MED
configuration on a port with the LLDP-MED TLVs advertised by a neighbor connected to that port.

Parameters and options
capabilities

This TLV enables the switch to determine:

• Which LLDP-MED TLVs a connected endpoint can discover

• The device class (1, 2, or 3) for the connected endpoint

This TLV also enables an LLDP-MED endpoint to discover what LLDP-MED TLVs the switch port currently
supports.

Defaults to enabled. Cannot be disabled unless the network_policy, poe, and location_id TLVs are
already disabled.

network-policy
This TLV enables the switch port to advertise its configured network policies (voice VLAN, Layer 2 QoS, Layer
3 QoS), and allows LLDP-MED endpoint devices to autoconfigure the voice network policy advertised by the
switch. This also enables the use of SNMP applications to troubleshoot statically configured endpoint network
policy mismatches.

Network policy is advertised only for ports that are configured as members of the voice VLAN. If the port
belongs to more than one voice VLAN, the voice VLAN with the lowest-numbered VID is selected as the
VLAN for voice traffic.

Defaults to enabled. If disabled, this TLV cannot be enabled unless the capability TLV is already enabled.

location_id
This TLV enables the switch port to advertise its configured location data (if any.)

Defaults to enabled. If disabled, this TLV cannot be enabled unless the capability TLV is already enabled.

poe
This TLV enables the switch port to advertise its current PoE state and to read the PoE requirements
advertised by the LLDP-MED endpoint device connected to the port.
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Defaults to enabled. If disabled, this TLV cannot be enabled unless the capability TLV is already enabled.

Generic header ID in configuration file

DHCP auto deployment
Auto deployment relies on DHCP options and the current DHCP auto-configuration function. Auto deployment is
platform independent, avoiding the J-number validation of the downloaded configuration file when downloaded
using DHCP option 66/67. The downloaded configuration file has an IGNORE tag immediately after the J-number
in its header.

An option to add an add-ignore-tag to an existing copy command will insert an ignore tag into the
configuration header. This insertion happens while transferring the configurations, (startup configuration
filesand running configuration files) from the switch to a configuration file setup on a remote server.
The process uses TFTP/SFTP or can be accomplished with a serially connected workstation using XMODEM.

Add-Ignore-Tag option
The add-ignore-tag option is used in conjunction with the copy command to transfer the startup
configuration or running configuration files from the switch to a remote server with IGNORE tag
inserted into it.

The IGNORE tag is inserted into the first line of the configuration file directly after the J-number.

Configuration file

; J9782A IGNORE Configuration Editor; Created on release #YB.15.14.0000x
; Ver #04:63.ff.37.27:88
hostname "Switch"
snmp-server community "public" unrestricted
vlan 1
name "DEFAULT_VLAN"
no untagged 2,20-25
untagged 1,3-19,26-28
ip address dhcp-bootp
The J-number validation is ignored only when configuration file that contains the IGNORE tag is downloaded to a
switch via DHCP option 66/67. When a configuration file containing the IGNORE tag is downloaded to a
switch using CLI, SNMP or WebUI, the downloaded configuration file is only accepted if the J-number in it
matches the J-number on the switch.

There is no change to the current switch configuration when executing the copy command with the add-ignore-
tag option. The IGNORE tag is only added to the configuration file being exported to the external server. The
configuration file stored on an external server is then downloaded to the switch using DHCP option 66 during
bootup. If the IGNORE tag is available in the downloaded configuration file then the switch will avoid the J-
number validation of the configuration file. The downloaded configuration file will then go through a line
by line validation. Once the configuration file passes this validation, it gets updated in the flash. Once the
configuration file has been updated, the switch will reboot automatically.

The J-number in the downloaded configuration file is replaced with that of the switch. The IGNORE tag is
removed from the downloaded configuration file before updating it to flash. The show running-
configuration command will not display the IGNORE tag but displays the switch’s J-number as part of the
output.
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Copy with add-ignore-tag

switch(config)# copy startup-config tftp <ip-addr> <filename> add-ignore-tag
switch(config)# copy running-config tftp <ip-addr> <filename> add-ignore-tag
switch(config)# copy startup-config sftp <ip-addr> <filename> add-ignore-tag
switch(config)# copy running-config sftp <ip-addr> <filename> add-ignore-tag
switch(config)# copy startup-config xmodem add-ignore-tag
switch(config)# copy running-config xmodem add-ignore-tag

Configuration commands for the add-ignore-tag option
Configuration files can be transferred to the switch from a server using the following copy commands:

• copy tftp
• copy xmodem
• copy sftp

Copy commands

copy tftp < startup-config | running-config > < ip-address > < remote-file >[ pc | unix ]
copy xmodem startup-config < pc | unix >
copy sftp < startup-config | running-config > < ip-address > < remote-file >
Configuration files that are downloaded using the copy commands as described in the example will be
accepted by the switch if they pass J-number validations and line by line validations after download. The
downloaded configuration file will be discarded by the switch if the validations fail. If the validations fail, the switch
will work with it’s previous configuration.

Show logging commands for the add-ignore-tag option
The show logging command is used to locate errors during a configuration validation process. The event log
catalogs entries with the ID#00158 and updates for each invalid entry found in the configuration file.

Show logging

-- Reverse event Log listing: Events Since Boot ----
W 01/07/14 00:29:31 00158 update: line 13. Module command missing for port or invalid port: 36
I 01/07/14 00:29:30 00131 tftp: Transfer completed
I 01/07/14 00:29:29 00090 dhcp: Trying to download Config File (using TFTP) received in DHCP from 192.168.1.1

NOTE:

Downloading manually edited configuration file is not encouraged.

Exclusions
The IGNORE tag is not an available option when using external SCP, SFTP or TFTP clients such as PuTTY, Open
SSH, WinSCP and SSH Secure Shell to transfer configuration files out of the switch.
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Overview
The Dynamic Host Configuration Protocol (DHCP) is a network protocol that enables a server to automate
assignment of IP addresses to hosts. A DHCP server can be configured to provide other network information like
IP addresses of TFTP servers, DNS server, boot file name and vendor specific options. Commonly there are two
types of address assignments, dynamic and manual. The lease of dynamic addresses is renewed periodically;
manual leases are permanently assigned to hosts. With this feature, you can configure multiple pools of IP
addresses for IP address assignment and tracking.

IP pools
A DHCP server is configured with IP pools. The server is then instructed to use IP addresses falling into the
specified range of IP while offering leases. Multiple IP pools are configured to not have duplicate or overlapping IP
subnets. You can also configure a DHCP server with multiple IP ranges within an IP subnet; this confines the
allocatable IP addresses within the configured IP pool.

An IP pool will be claimed valid only if it is either:

• Dynamic pool – Has a network address, subnet mask and IP range(s)

• Static pool – Should have a static IP-to-MAC binding.

The DHCP server will discard the invalid and incomplete pools and will only operate on the valid IP pools. The
DHCP server will require at least one valid pool to start.

DHCP options
On a DHCP server, an IP pool is configured with various options. These options signify additional information
about the network. Options are supported with explicit commands such as boot-file. Option codes that
correspond to explicit commands can not be configured with a generic option command; the generic option
command requires an option code and TLV.

NOTE:

RFC 2132 defines various network information that a client may request when trying to get the lease.

BootP support
The DHCP server also functions as BootP server. A manual binding configured in a static IP Pool may either
service a BootP client request or a DHCP client request.

Authoritative server and support for DHCP inform packets
The server message DHCPinformmay be received when the server is already configured for static IPv4
addresses so that the server can to get configuration parameters dynamically.

NOTE: RFC 2131 states that if a client has obtained a network address through some other means
(e.g., manual configuration), it may use a DHCPinform request message to obtain other local
configuration parameters. Servers receiving a DHCPinform message construct a DHCPACK
message with any local configuration parameters appropriate for the client without: allocating a new
address, checking for an existing binding, filling in yiaddr or including lease time parameters.

Chapter 10
DHCPv4 server
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Authoritative pools
To process the DHCPINFORM packets received from a client within the given IP pool, a DHCP server has to be
configured as authoritative for that IP pool. The server is the sole authority for this IP pool so when a client
requests an IP address lease where the server is authoritative, and the server has no record of that IP address,
the server will respond with DHCPNAK message which indicates that the client should no longer use that IP
address. Any DHCPINFORM packet received for a non-authoritative pool will be ignored by the DHCP server.

The authoritative command has no effect when configured on a static pool or an incomplete pool without a
network statement. In such cases, the server intentionally not send an error message.

A CLI toggle is provided under the pool context that will allow the authoritative configuration.

NOTE:

The authoritative command requires a network statement to be configured on a pool.

Authoritative dummy pools
A dummy pool, without the range statement, can be configured and made authoritative. A dummy pool allows
static-bind entries which do not have matching dynamic pools with network statements to be configured. By
creating a dummy pool on a DHCP server, the support for DHCPinform packets will not be actively serving the
client on this pool. No active leases or resource consumption will be sent to the DHCP server when this option is
used.

Dummy pools help the DHCP server learn the network topology.

Example

dhcp-server pool dummy192
network 192.168.10.0 255.255.255.255
option 1…
option 2…
:
option n…
authoritative
exit

Change in server behavior
Making the server authoritative for an IP pool changes how the server processes DHCP REQUEST packets.

The following table exhibits the behavior on the receiving DHCP REQUEST and DHCP inform packets from
DHCP clients residing on either authoritative and non-authoritative pools.
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Table 22: Authoritative and non-authoritative pools

Authoritative Pool Non-authoritative pool

When a
DHCP client
sending..

For Own IP For IP
belonging to
different
client

Unknown IP
falling outside
the range

For Own IP For IP belonging to
different client

Unknown IP
falling outside
the range

DHCP
INFORM

send ACK send ACK send ACK DROP DROP DROP

DHCP
REQUEST

send ACK send NACK send NACK send ACK DROP DROP

DHCPv4 configuration commands

DHCPv4 server

dhcp-server
Syntax
[no] dhcp-server [enable | disable]
Description

Use this command to nable/disable the DHCPv4 server in a switch. Defaults to disabled.

Parameters and options

no

Removes all DHCPv4 server configurations.

enable

Enables the DHCPv4 server on the device. The no form of this command

disable

Disables the DHCPv4 server on the device.

DHCP address pool name

dhcp-server pool
Syntax
[no] dhcp-server pool <POOL-NAME>
        
Description

Configure the DHCPv4 server IP address pool with either a static IP or a network IP range.

Parameters and options

Chapter 10 DHCPv4 server 351

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4089



pool

DHCPv4 server IP address pool.

ASCII-STR

Enter an ASCII string.

authoritative

Configure the DHCP server authoritative for a pool.

bootfile-name

Specify the boot file name which is used as a boot image.

default-router

List of IP addresses of the default routers.

dns-server

List of IP addresses of the DNS servers.

domain-name

Configure the DNS (Domain Name System) domain name for translation of hostnames to IP addresses.

lease

Lease period of an IP address.

netbios-name-server

List of IP addresses of the NetBIOS (WINS) name servers.

netbios-node-type

NetBIOS node type for a Microsoft DHCPv4 client.

network

Subnet IP and mask of the DHCPv4 server address pool.

option

Raw DHCPv4 server options.

range

Range of IP addresses for the DHCPv4 server address pool.

static-bind

Static binding information for the DHCPv4 server address pool.

tftp-server

Configure a TFTP server for the DHCPv4 server address pool.

Validations

Validation Error/Warning/Prompt

Configuring pool when maximum Number of pools
already configured.

Maximum number of pools (128) has already been
reached

Configuring Pool with a name that exceeds the
maximum length requirement.

String %s too long. Allowed length is 32 characters.

Table Continued
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Trying to delete non existing pool The specified address pool does not exist.

Only alphanumeric characters, numerals and
underscore is allowed in the pool name. Violating
this would throw the following error message.

Invalid name. Only alphanumeric characters and
hyphen are allowed.

Trying to delete existing pool or adding new pool
when DHCP server enabled.

DHCP server should be disabled before changing
the configuration.

Authoritative
Syntax
[no] authoritative
Description

The DHCP server is the sole authority for the network configured under this pool. When the DHCP server is
configured as authoritative, the server will respond with DHCP ACK or NACK as appropriate for all the received
DHCP REQUEST and DHCP INFORM packets belonging to the subnet.

Non-authoritative DHCP INFORM packets received from the clients on a non-authoritative pool will be ignored.

Parameters and options

authoritative

Configure the DHCP server authoritative for a pool.

DHCP client boot file

bootfile-name
Syntax
[no] bootfile-name <FILENAME>
      
Description

Specify the boot file name to be used as the boot image.

DHCP client default router

default-router
Syntax
[no] default-router <IP-ADDR-STR> [IP-ADDR2 IP-ADDR8]
Description

Configure the DHCP pool context to the default router for a DHCP client. List all of the IP addresses of the default
routers.

Two IP addresses must be separated by a comma.

Maximum of eight default routers can be configured.

DNS IP servers

Chapter 10 DHCPv4 server 353

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4091



dns-server
Syntax
[no] dns-server <IP-ADDR> [IP-ADDR2 IP-ADDR8]
Description

Configure the DHCP pool context to the DNS IP servers that are available to a DHCP client. List of IP addresses
of the DNS servers.

Two IP addresses must be separated by comma.

Maximum of eight DNS servers can be configured.

Configure a domain name

domain-name
Syntax
[no] domain-name <NAME>
Description

Configure the DNS domain name for translation of hostnames to IP addresses.

Configure lease time

lease
Syntax
[no] lease [DD:HH:MM | infinite]
Description

Configure the lease time for an IP address in the DHCP pool. Lease time is infinite for static pools.

The default lease period is one day.

Parameters and options

DD:HH:MM

Enter lease period.

Lease

Lease period of an IP address.

NetBIOS WINS servers
Syntax
[no] netbios-name-server <IP-ADDR-STR> [IP-ADDR2  IP-ADDR8]
Description

Configure the DHCP pool for the NetBIOS WINS servers that are available to a Microsoft DHCP client. List all IP
addresses of the NetBIOS(WINS) name servers. The Windows Internet Naming Service (WINS) is a name
resolution service that Microsoft DHCP clients use to correlate host names to IP addresses within a general
grouping of networks.

Two IP addresses must be separated by a comma.
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Maximum of 8 NetBIOS (WINS) name servers can be configured.

NetBIOS node type

net bios-ode-type
Syntax
[no] netbios-node-type [ broadcast | hybrid | mixed | peer-to-peer ]
Description

Configure the DHCP pool mode to the NetBIOS node type for a Microsoft DHCP. The NetBIOS node type for
Microsoft DHCP clients can be one of four settings: broadcast, peer-to-peer, mixed, or hybrid.

Parameters and options

broadcast

Broadcast node.

hybrid

Hybrid node.

mixed

Mixed node.

peer-to-peer

Peer to peer node.

Subnet and mask

network
Syntax
[no] network <ip-addr/mask-lenght>
Description

Configure the DHCPv4 server pool subnet and mask for the DHCP server address pool.

Range is configured to enable pool.

Parameters and options

ip-addr/mask-lenght

Interface IP address/mask.

DHCP server options

Configure DHCP server options
Syntax

[no] option <CODE> {ascii <ascii-string>|hex <hex-string>|ip <IP-ADDR-STR>[IP-ADDR2 … IP-ADDR8]}

ascii

Specify ASCII string as option code value.
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hex

Specify hexadecimal string as option code value.

ip

Specify one or more IP addresses as option code value.

ip-addr-str

Specify IP address.

ascii-str

Enter an ASCII string.

hex-str

Specify Hexadecimal string.

Configure the raw DHCP server options.

NOTE: Following DHCP options are not supported:

1,3,6,12,15,44,46,50,52,54,55,57,58,59,61,66,67,82.

You can use the following available CLIs for respective DHCP option codes:

DHCP
Option
code

CLI Syntax

1 [no] network <ip-addr/mask-lenght>
3 [no] default-router <IP-ADDR-STR> [IP-ADDR2 ... IP-ADDR8]
6 [no] dns-server <IP-ADDR> [IP-ADDR2 ... IP-ADDR8]
15 [no] domain-name <name>
44 [no] netbios-name-server <IP-ADDR-STR> [IP-ADDR2 ... IP-ADDR8]
43 [no] option 43 {ascii <ascii-string>|hex <hex-string>|ip <IP-

ADDR-STR>[IP-ADDR2 … IP-ADDR8]}
46 [no] netbios-node-type <broadcast | hybrid | mixed | peer-to-

peer>
60 [no] option 60 {ascii <ascii-string>|hex <hex-string>|ip <IP-

ADDR-STR>[IP-ADDR2 … IP-ADDR8]}
66 [no] tftp-server server-name < ASCII-STR>
67 [no] bootfile-name<filename>
138 [no] option 138 {ascii <ascii-string>|hex <hex-string>|ip <IP-

ADDR-STR>[IP-ADDR2 … IP-ADDR8]}
150 [no] tftp-server server-ip <ip-address> or [no] option 150 <IP-

ADDR-STR> [IP-ADDR2 ... IP-ADDR8]

NOTE: DHCP server raw Option 43 is supported and it is used for AirWave ZTP.

DHCP server raw Option 60 is supported from 16.06.

DHCP server raw Option 138 is supported and it is used for IPsec tunnel configuration in DHCP
client.
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IP address range

range
Syntax
[no] range <IP-ADDR>[<IP-ADDR>]
Description

Configure the DHCP pool to the range of IP address for the DHCP address pool.

Parameters and options

range

Range of IP addresses for the DHCPv4 server address pool.

ip-addr

Low IP address.

High IP address.

Static bindings

static-bind
Syntax
static-bind ip <IP-ADDR/MASK-LENGTH> mac <MAC-ADDR>
        
Description

Configure static binding information for the DHCPv4 server address pool. Manual bindings are IP addresses that
have been manually mapped to the MAC addresses of hosts that are found in the DHCP database. Manual
bindings are just special address pools. There is no limit on the number of manual bindings but you can only
configure one manual binding per host pool.

Parameters and options

ip

Specify client IP address.

static-bind

Static binding information for the DHCPv4 server address pool.

ip-addr / mask-length

Interface IP address or mask.

mac

Specify client MAC address.

mac-addr

Enter a MAC address.

TFTP server domain name
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tftp-server
Syntax

[no] tftp-server [server-name <server-name> | server-ip < ip-address >]
Description

Configure the TFTP server domain name for the DHCP address pool.

Parameters and options

tftp-server

Configure a TFTP server for the DHCPv4 server address pool.

server-name

TFTP server name for the DHCPv4 server address pool.

Configure the TFTP server address

tftp-server
Syntax
tftp-server server-ip <IP-ADDRESS>
        
Description

Configure the TFTP server address for the DHCP address pool.

Parameters and options

server-ip

TFTP server IP addresses for the DHCPv4 server address pool.

ip-addr

Specify TFTP server IP address.

Number of ping packets

dhcp-server ping
Syntax
[no] dhcp-server ping [packets <0-10>|timeout <0-10>]
Description

Specify, in the global configuration context, the number of ping packets the DHCP server will send to the pool
address before assigning the address. The default is two packets.

Parameters and options

ping

Specify DHCPv4 ping parameters.

packets <0-10>

Specify number of ping packets in the range of 0 to 10. 0 disables ping.
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timeout <1-10

Ping timeout in the range of 1–10 seconds. Indicates the amount of time the DHCPv4 server must wait before
timing out a ping packet. Defaults to one second.

Save DHCP server automatic bindings

dhcp-server database
Syntax
[no] dhcp-server database [file ASCII-STR] [delay<15-86400>][timeout <0-86400>]
Description

Specifies DHCPv4 database agent and the interval between database updates and database transfers.

Parameters and options

delay

Seconds to delay writing to the lease database file.

file

URL Format: "tftp://<ip-address>/<filename>".

database

Specifies DHCPv4 database agent and the interval between database updates and database transfers.

timeout

Seconds to wait for the transfer before failing.

ascii-str

Database URL.

<15-86400>

Delay in seconds.

<0-86400>

Timeout in seconds.

DHCP server and SNMP notifications

snmp-server enable traps
Syntax
[no] snmp-server enable traps dhcp-server
Description

Configure a DHCP server to send SNMP notifications to the SNMP entity. This command enables or disables
event traps sent by the switch.

Parameters and options

dhcp-server

Traps for DHCP-Server.

Conflict logging on a DHCP server
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dhcp-server conflict-logging
Syntax
[no] dhcp-server conflict-logging
Description

Enable conflict logging on a DHCP server. Default is disabled.

Parameters and options

conflict-logging

Enable DHCPv4 server address conflict logging.

Enable the DHCP server on a VLAN

dhcp-server
Syntax
dhcp-server
Description

Enable DHCPv4 server on a VLAN. DHCPv4 client or DHCPv4 relay cannot co-exist with DHCPv4 server on a
VLAN.

Parameters and options

dhcp-server

Enable DHCPv4 server on a VLAN.

Clear commands

clear dhcp-server conflicts
Syntax
clear dhcp-server conflicts <IP-ADDR>
        
Description

Reset DHCPv4 server conflicts database. If IP address is specified, reset only that conflict.

Parameters and options

dhcp-server

Clears theDHCPv4 server information.

ip-addr

Specify the IP address whose conflict is to be cleared.

Reset all DHCP server and BOOTP counters

clear dhcp-server statistics
Syntax
clear dhcp-server statistics
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Description

Reset all DHCP server and BOOTP counters

Parameters and options

statistics

Reset DHCPv4 server and BOOTP counters.

Delete an automatic address binding

clear dhcp-server statistics
Syntax
clear dhcp-server statistics
Description

Delete an automatic address binding from the DHCP server database.

Parameters and options

binding

Reset DHCPv4 server automatic address bindings.

ip-addr

Specify IP address of the binding is to be cleared.

Show commands

show dhcp-server
Syntax
show dhcp-server [binding|conflicts|database|statistics|pool <POOL-NAME>]
        
Description

Show DHCPv4 server global configuration information for the device.

Parameters and options

binding

Display the DHCPv4 server address bindings on the device..

conflicts

Display address conflicts found by a DHCPv4 server when addresses are offered by a client.

database

Display DHCPv4 server database agent information.

statistics

Display DHCPv4 server statistics.

pool <POOL-NAME>

Display the DHCPv4 server IP pool information.
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Event log

Event Log Messages

Cause

Table 23: Event Log Messages

Events Debug messages

DHCP server is enabled globally. DHCP server is enabled globally.

DHCP server is enabled globally. Warnings -
One or more incomplete pool configurations
are found during the server startup.

DHCP server is enabled globally.Warning -One or
more incomplete pool configurations are found
during the server startup.

A dynamic pool is considered invalid, if
network IP or subnet mask is not configured.
A static pool is considered incomplete, if
network IP, subnet mask or MAC address is
not configured.

DHCP server failed to start. The reason for
failure is printed as the argument.

DHCP server failed to start: %s "with a manual
binding.

DHCP server is disabled globally. DHCP server is disabled globally.

The DHCP server configurations are deleted. The DHCP server configurations are deleted

Decline from client when server assigns an
illegal Ipv6 address.

%s: Decline offer from %x (server) of %x because
the address is illegal.

DHCP server is enabled on a specific VLAN. DHCP server is enabled on VLAN %d

DHCP server is disabled on a specific VLAN. DHCP server is disabled on VLAN %d

Ping check is enabled and configured with
specified retry count and timeout values

Ping-check configured with retry count = %d,
timeout = %d

Ping check is disabled Ping-check is disabled

Conflict-logging is enabled Conflict-logging is enabled

Conflict-logging is disabled. Conflict-logging is disabled.

A specific IP address is removed from the
conflict logging database.

IP address %s is removed from the conflict-
logging database.

Table Continued
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Events Debug messages

All IP addresses are removed from the
conflict-logging database.

"All IP addresses are removed from the conflict-
logging database

Dynamic binding for a specific IP address is
freed.

Dynamic binding for IP address %s is freed

All the dynamic IP bindings are freed. All the dynamic IP bindings are freed

Remote binding database is configured for a
specific URL.

Remote binding database is configured at %s

Remote biding database is disabled. Remote binding database is disabled

Binding database is read from the specified
URL at the specified time

Binding database read from %s at %s

Failed to read the remote binding from the
specified URL.

Failed to read the remote binding database at %s

Binding database is written to the specified
URL at the specified time.

Binding database written to %s at %s

Failed to write the binding database to the
specified URL. The reason for failure is
printed as argument.

Failed to write the binding database to %s.
Error: %s

Invalid bindings are found in the database at
the specified URL.

Invalid binding database at %s

The specified VLAN does not have a
matching IP pool configured.This occurs
when the DHCP-server is enabled on the
specified VLAN, but no IP pool is configured
with a network IP matching the VLAN
network IP.

VLAN %d does not have a matching IP pool

Binding database is replicated to standby
management module.

Binding database is replicated to standby
management module

DHCP server is listening for DHCP
packetsThis message is displayed when
DHCP server is enabled globally and DHCP
server is enabled on at-least one VLAN.

DHCP server is listening for DHCP packets

DHCP server is disabled on all the VLANs.
Server is no longer listening for DHCP
packets.

DHCP server is disabled on all the VLANs. Server
is no longer listening for DHCP packets

The specified IP is not offered to the DHCP
client, as it is already in use.

IP address %s is not offered, as it is already
in use

Table Continued

Chapter 10 DHCPv4 server 363

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4101



Events Debug messages

No IP addresses available on the specified
pool.

No IP addresses to offer from pool %s

High threshold reached for the specified
pool. Count of Active bindings and Free
bindings are printed as arguments.

High threshold reached for pool %s. Active
bindings: %d, Free bindings: %d

Low threshold reached for the specified pool.
Count of Active bindings and Free bindings
are printed as arguments.

Low threshold reached for pool %s. Active
bindings: %d, Free bindings: %d

No active VLAN with an IP address is
available to read binding database from the
configured URL.

No active Vlan with an IP address available to
read binding database
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DHCPv6 hardware address
The incremental deployment of IPv6 to existing IPv4 networks results in dual-stacking network environments.
Some devices will act as both DHCPv4 and DHCPv6 clients. For these dual-stack situation, here is a need to
associate DHCPv4 and DHCPv6 messages with the same client interface. A DHCPv4 server uses the client link-
layer address as the customer identifier and a key for lookup in the client database. The DHCPv6 Relay-Forward
message carries the client link-layer address to the DHCPv6 server allowing the association of both DHCPv4 and
DHCPv6 messages with the same client interface.

As defined in RFC-6939, DHCPv6 relay agents receiving solicit and request messages that originate from
DHCPv6 clients include the link-layer source address of the received DHCPv6 message. This is accomplished in
the Client Link-Layer Address option within DHCPv6 Relay-Forward messages. The Client Link-Layer Address
enables the server to recognize and service specific clients. DHCPv6 relay agent behavior (as set by the
configuration) decides whether the Client Link-Layer Address option is included for each client.

DHCPv6 relays agents include Option–79 for all message types when enabled. The message types are: solicit,
request, confirm, decline, renew, rebind, release and information-request. DHCPv6 provides additional
information for event debugging and logging related to the client at the server.

NOTE:

All cascading relay-agents simply encapsulate the message received and relay-forward to the server.
The service function does not receive any message-types directly from the client even when the
feature is enabled.

DHCPv6 snooping and relay
Configuring DHCPv6 and DIPLDv6 through SNMP

NOTE: DHCPv6 snooping and Dynamic IPv6 Lockdown (DIPLDv6) are currently configurable
through SNMP using MIBs. For more information, see the MIB and Trap Matrix.

dhcpv6–snooping
Syntax
[no] dhcpv6-snooping [vlan <VLAN-ID-RANGE>]
      
Description

Enable or disable the global administrative status of DHCPv6 snooping. You must enable DHCP snooping
globally (dhcpv6-snooping) to enable snooping on any VLAN.

Parameters and options

no

Disabling global administrative status (no dhcpvt-snooping) disables snooping on all VLANs.

vlan <VLAN-ID-RANGE>]

Disables snooping on a VLAN or a range of VLANs. Requires enabling DHCP global snooping (dhcpv6-
snooping)

Chapter 11
DHCPv6 server

Chapter 11 DHCPv6 server 365

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4103



Validation rules for DHCPv6 global snooping

Validation Error/Warning/Prompt

Verify whether entered ipv6 address is valid Invalid Ipv6 address:< ipv6-address>

If an invalid server address is configured Invalid IP address. Only IPv6 unicast or link-
local addresses are supported.

If the limit on configuring the authorized servers had
reached.

Cannot configure the authorized server as
only 20 authorized servers can be configured.

Validation rules for DHCPv6–snooping VLAN

Validation Error/Warning/Prompt

if the VLAN is a SVLAN and the bridge mode is
mixed mode

DHCPv6-snooping is not supported on
SVLANs and SVLAN ports in QinQ mixed
VLAN mode

If number of snooped VLAN count is greater than
max_vlans_with_dipv6ld and also the max binding
limit has reached.

DHCPv6 snooping cannot be enabled on %s
VLANs. The switch will support only 8
DHCPv6 snooping enabled VLANs when
Dynamic IPv6 Lockdown feature is enabled.

If the VLAN which is being configured for DHCPv6
Snooping has a Smart Link enabled port.

Cannot configure DHCPv6 Snooping on a
VLAN containing Smart Link ports.

If a VLAN is being configured as a Smart Link
protected VLAN and DHCPv6 Snooping is enabled
on it.

Cannot configure a VLAN as a protected
VLAN when DHCPv6 Snooping is enabled on
it .

If Smart Link is being configured on a port which is a
part of DHCPv6 Snooping VLAN..

Cannot configure the Smart Link feature on a
port when DHCPv6 Snooping is enabled on
that port.

dhcpv6 snooping trust
Syntax
[no] dhcpv6-snooping trust ethernet <PORT-LIST>
        
Description

Configure trusted interfaces. The system forwards server packets received on trusted interfaces only.

Parameters and options

no

Marks the specified interfaces as untrusted. Port state defaults to untrusted.

Validation rules
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Validation Error/Warning/Prompt

Verify whether the port exist in the device. Module not present for port or invalid port: <PORT-
LIST>

If the port is a part of a SVLAN and the
bridge mode is mixed mode.

Port %s cannot be configured as trusted port as it is
part of a SVLAN in QinQ mixed VLAN mode.

If the port is not a part of a dsnoopv6
enabled VLAN

Port %s is not a part of a DHCPv6-snooping VLAN.

If trusted attribute is being configured on
a port on which max-binding has been
already configured.

Disable max-binding feature configured on the port
before configuring it as a trusted port.

If a Dynamic trunk is configured as a
trusted port.

Cannot configure a port as a DHCPv6 Snooping trusted
port when Dynamic Trunking is enabled on that port.

If a Smart Link port is being configured as
a trusted port

Cannot configure a Smart Link port as a DHCPv6
Snooping trusted port.

If a trusted port is being configured as a
Smart Link port

Cannot configure a DHCPv6 Snooping trusted port as a
Smart Link port

dhcpv6–snooping authorized-server
Syntax
[no] dhcpv6-snooping authorized-server <IPV6-ADDRESS>
        
Description

Configure authorized DHCPv6 servers. For DHCPv6 snooping to allow a server to client packet to be forwarded, it
must be received on a trusted port from an authorized server. If no authorized servers are configured, all server
addresses are valid.

ddhcpv6–snooping database file
Syntax
[no] dhcpv6-snooping database file [ASCII-STR|delay <15-86400>| timeout<0-86400>]
        
Description

Configure a lease entry file and its options for storing DHCPv6 snooping binding database.

Parameters and options

ASCII-STR

Copies the DHCPv6 snooping lease file to a TFTP server. The parameter ASCII-STR is a URL and is in the
format tftp://<IP-ADDR>/<FILENAME>. The TFTP address can be up to 255 characters. IP-ADDR can
be an IPv4 address or an IPv6 address. The IPv6 address must be enclosed in square brackets [].

timeout seconds

Configures the number of seconds to wait for the DSNOOPv6 lease file transfer to complete. An error
message is displayed if the file transfer is not completed within the timeout value. A value of zero indicates
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that the attempt to transfer the DHCPv6 lease file retries indefinitely. The default timeout value is 300
seconds.

database

Configure the parameters to copy the DHCPv6 Snooping lease file to a TFTP server.

delay

Configure the number of seconds to wait before copying the DSNOOPv6 lease file to a TFTP server.

file

Copy the DHCPv6 Snooping lease file to a TFTP server.

timeout

Configure the number of seconds to wait for the DSNOOPv6 lease file transfer to complete.

Validation rules

Validation Error/Warning/Prompt

Verify whether file name entered is in URL format database: Bad URL format.

Verify whether the timeout value is within the limit Invalid input: <value>

Verify whether the delay value is within the limit. Invalid input: <value>

If the URL format is not proper Bad URL format.

If the entered URL does not have a valid transfer
mode.

URL Transport mode is not supported.

dhcpv6–snooping max-bindings
Syntax
[no] dhcpv6-snooping max-bindings <PORT-LIST 1-8192>
Description

Configure the maximum number of binding addresses allowed per binding anchor. A binding anchor is a unique
attribute that can be associated with a client address.

Parameters and options

max-bindings

Configuring maximum number of binding addresses allowed per port.

• If the max-bindings value is configured before enabling dhcpv6-snooping the limit is immediately
applied and the bindings are not allowed to exceed the max-bindings value.

• The max-bindings value is setafter enabling dhcpv6-snooping.

• The current bindings are greater than the max-binding value, the configuration will be applied as and when
clients release their IPv6 addresses.

• Current bindings are lesser than that of the value entered, the configuration will be immediately applied.

<PORT-LIST 1-8192>

Specify the ports on which max-bindings need to be applied in the range of 1–8192.
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Validation rules

Validation Error/Warning/Prompt

Verify max-bindings value entered is in the range Invalid input: <value>

If DHCPv6-Snooping is already configured before
entering the command and current bindings are
greater than the value being set.

Existing bindings %d are more than the max-
bindings being configured, and the maximum
limit will be applied once the number of existing
bindings fall below this limit

If the value is being configured for a trusted port Cannot configure maximum binding for DHCPv6
snooping feature on a trusted port

If the value is being configured for a port which is
not a part of a dhcpv6-snooped vlan

Port %s is not a part of a DHCPv6-snooping
VLAN.

If the max-binding value is being set for a Dynamic
trunk.

Cannot configure DHCPv6 Snooping on a port
when Dynamic Trunking is enabled on that port.

If the number of static bindings is greater than the
max-binding value being set.

Cannot configure the maximum binding value
because the number of static bindings on the
port exceeds the maximum binding value.

If a port on which max-binding is enabled is being
put into a trunk.

Cannot add a port to a trunk group when
DHCPv6 Snooping Maxbinding is configured on
that port.

If a trunk has max-bindings configured on it. And the
trunk is being removed.

Cannot remove the port %s from the trunk group
because DHCPv6 Snooping max-binding is
configured on the trunk and removing the port
will delete the trunk.

If DT trunk is being configured on a max-binding
enabled port.

Cannot configure Distributed Trunking on a port
when DHCPv6 Snooping max-binding is
configured on that port.

IMPORTANT: DT trunks can use jumbo VLAN as usual, but user needs to ensure that jumbo is
configured on both the DT pairs, otherwise packet drops/fragmentations can be seen.

dhcpv6–relay option 79
Syntax
[no] dhcpv6-relay option 79
Description

Enabling option 79 will force the DHCPv6 Relay agent to forward the client Link-layer address. Defaults to
disabled.

snmp-server enable traps dhcpv6-snooping
Syntax
[no] snmp-server enable traps dhcpv6-snooping [out-of-resources|errant-reply]
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Description

Configure the traps for DHCPv6 snooping.

Parameters and options

out-of-resources

This trap is sent when the number of bindings exceed the maximum limit of 8192 bindings.

errant-reply

This trap is sent when a DHCPv6 reply packet is received on an untrusted port or from an un-authorized
server.

clear dhcpv6–snooping stats
Syntax
clear dhcpv6-snooping stats
Description

Clears dhcpv6 snooping statistics.

Validation rules

Validation Error/Warning/Prompt

If dhcp-snooping not enabled
globally

DHCPv6 snooping is disabled.

debug security dhcpv6–snooping
Syntax
debug security dhcpv6-snooping [config|event|packet]
Description

Enable debug for DHCPv6 snooping.

Parameters and options

config

Debug DHCPv6 snooping configuration.

event

Debug a DHCPv6 snooping event.

packet

Debug DHCPv6 snooping by packet.

ipv6 source-lockdown ethernet
Syntax
[no] ipv6 source-lockdown ethernet <PORT-LIST>
      
Description

Used to configure DIPv6LD lockdown globally and on specific ports which can be configured on per-port basis
using the PORT-LIST option.
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Parameters and options

[ethernet] PORT-LIST

Specify the ports being configured for Ipv6 source-lockdown.

source-lockdown

Enable IPv6 source lockdown for a specific port.

Validation rules

Validation Error/Warning/Prompt

Verify whether dhcpv6-snooping is enabled
globally

DHCPv6 snooping is disabled.

Verify whether port configured is in the VLAN
which is dhcpv6-snooping enabled.

Ports <PORT-LIST> are not in a DHCPv6
Snooping VLAN.

If lockdown is being configured on a trusted port Port %s is a trusted port.

If the HW resources are not available for changing
dipv6ld global or a port characteristic

Cannot enable DIPLDv6 as required resources are
unavailable.

If global GVRP is enabled DIPLDv6 cannot be enabled when GVRP is
enabled

If no of snooped VLAN count is greater than
max_vlans_with_dipv6ld

DHCPv6 snooping cannot be enabled on %s
VLANs. The switch support only 8 DhCPv6
snooping enabled VLANs when Dynamic Ipv6
lockdown is enabled.

If Binding limits are exceeded Cannot enable Dynamic Ipv6 Lockdown on ports
%s as manual binding limits are exceeded.

If lockdown is being enabled on an interface which
is part of a dynamic trunk (LACP)

Cannot configure Dynamic Ipv6 Lockdown on
interface %s, it is a Dynamic trunk.

If lock down is being configured on a mesh port Cannot configure Dynamic Ipv6 Lockdown on a
logical mesh port.

If trunk is being formed using a port which has
DIPLDv6 enabled on it.

Cannot add a port to a trunk group when Dynamic
IPv6 Lockdown is enabled on that port.

If DIPLDv6 is configured on a trunk and the trunk
is being removed.

Cannot remove the port %s from the trunk group
because Dynamic IPv6 Lockdown is configured on
the trunk and removing the port will delete the
trunk.

If DIPLDv6 is being is configured on a Smart Link
port

Cannot enable Dynamic IPv6 Lockdown feature on
a Smart Link port.

If Smart Link is being enabled on a DIPLDv6
enabled port

Cannot configure the Smart Link feature on a port
when the Dynamic IPv6 Lockdown feature is
enabled on that port.
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ipv6 source-binding
Syntax
[no] ipv6 source-binding VLAN-ID IPV6-ADDR MAC-ADDR PORT-NUM IPV6-ADDR
        
Description

Add a DHCPv6 static binding entry into the binding table. Static binding entries will have infinite lifetime.

Parameters and options

VLAN-ID

The VLAN ID of the static binding entry.

Ipv6-ADDRESS

The Ipv6 address of the static binding entry.

MAC-ADDRESS

The MAC address of the static binding entry.

[ethernet] PORT-NUM

Port number of the static binding entry.

IPV6-ADDR

The Ipv6 link-local address of the static binding entry.

Validation rules

Validation Error/Warning/Prompt

Verify whether the vlan id is proper Invalid input:%s

Verify whether the mac-address is valid Invalid input:%s

Verify whether the ipv6 address is valid Invalid input:%s

Verify whether the port number is valid on the
device

Module not present for port or invalid port: <port-
num>

If any other addresses other than global unicast
address are entered

Invalid Ipv6 address

If the ipv6 address entered is not a unicast. Only Ipv6 unicast addresses are supported.

If a multicast ipv6 address is entered to configure a
binding.

Cannot configure a binding using a multicast IPV6
address.

If an invalid MAC address is being added into the
binding table.

Cannot add a %s MAC address to the table.

If an invalid port is used for configuring a static
binding

Port %s is invalid.

Table Continued
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Validation Error/Warning/Prompt

If DSNOOPV6 is globally disabled when
configuring a static binding.

Cannot configure static binding whenDHCPv6
Snooping is disabled.

While configuring a static binding if the Ipv6
address is already present in the Binding table but
the entered vlanid and MAC address doesnot
match with the one present in the binding table.

%s has already been assigned to a VID/MAC.
Delete the existing binding first.

If a binding which does not exist in the binding
table is tried to be removed.

Binding for %s not found.

If DIPLDv6 limits are exceeded on the switch. Cannot add the IPv6 source binding because the
number of source bindings exceeds the maximum
limit of
“STR(DSNOOPV6_MAX_STATIC_LEASES)”.

If more than 4 IPv6 addresses are being assigned
to a VID/MAC pair

Cannot add the IPv6 source binding because only
“STR(DHCPV6_MAX_IAADDRS)”IPv6 addresses
can be bound to a VID-MAC pair.

If a VID-MAC pair is bound to a link-local address
and the same VID-MAC pair is being assigned
another link-local address.

%s is already bound to a link-local address. To
bind another link-local address, delete the existing
binding .

If a binding exists for a particular client in the BST
and the same binding is being configured for
another port.

The IPv6 source binding already exists for another
port.

If the switch total limit for bindings is exceeded. Cannot add the IPv6 source binding because the
number of source bindings exceeds the maximum
limit of
STR(DSNOOPV6_MAX_STATIC_LEASES).

If a trunk is being configured for a port which has
static binding configured on it.

Cannot add a port to a trunk group when IPv6
source binding is configured on that port.

If static binding is being configured on a Smart Link
enabled port

Cannot configure IPv6 source binding on a Smart
Link port.

If Smart Link is being configured on a port with
static binding.

Cannot configure Smart Link feature on a port
when IPv6 source binding is configured on that
port.

snmp-server enable traps dyn-ipv6-lockdown
Syntax
[no] snmp-server enable traps dyn-ipv6-lockdown [out-of-resources | violations]
Description

The Dynamic IPv6 Lockdown trap is sent when resources are unavailable for configuring. This trap is sent when a
source lockdown violation takes place.

Parameters and options
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out-of-resources

Dynamic IPv6 Lockdown out of resources.

violations

Dynamic IPv6 lockdown violations.

debug security dynamic-ipv6-lockdown
Syntax
debug security dynamic-ipv6-lockdown
Description

Enable debug for DIPLDv6

Show commands for DHCPv6–snooping

show dhcpv6-snooping
Syntax
show dhcpv6-snooping
Description

Show dhcpv6 snooping configuration.

Validaton rules

Validation Error/Warning/Prompt

If dhcpv6-snooping not enabled DHCPv6 snooping is disabled

show dhcpv6 snooping bindings
Syntax
show dhcpv6-snooping bindings
Description

Show dhcpv6 snooping binding entries. This would show both dynamic and static binding entries.

Validation rules

Validation Error/Warning/Prompt

If dhcpv6-snooping not enabled DHCPv6 snooping is disabled

show dhcpv6 snooping statistics
Syntax
show dhcpv6-snooping stats
Description

Show dhcpv6-snooping statistics.

374 Aruba 3810 / 5400R Management and Configuration Guide for
ArubaOS-Switch 16.08

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4112



show ipv6 source-lockdown
Syntax
show ipv6 source-lockdown [bindings | status]
        
Description

Shows IPv6 source bindings that are configured using the command IPv6 source-bindings.

Parameters and options

bindings

Show source bindings for Dynamic IPv6 Lockdown ports.

status

Show source bindings for Dynamic IPv6 Lockdown status.

Show source bindings Dynamic IPv6 Lockdown status

Dynamic IPv6 Lockdown Bindings

Port    IPv6 Address                             Vlan   MAC         Not 
Address                                                             in HW
---- ---------------------------------------- ----- ------------- -------
A1   3000:abbb:1234:3456:1234: 1234:1234:1234  1     123456-789101  Yes
F23  300:ab::2                                 4092  abcdef-123455  No

show ipv6 source-lockdown status
Syntax
show ipv6 source-lockdown status
Description

Used to show IPV6 source-lockdown status per port.

Parameters and options

source-lockdown

Show dynamic IPv6 Lockdown.

Show dynamic IPv6 Lockdown configuration

Dynamic IPv6 Lockdown information
Global State: Enabled
Port   Operational State
------ --------------------------
1    Active
2    Active
IPv6 Source Lockdown is disabled on Ports 3-24.
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show snmp-server traps
Syntax
show snmp-server traps <COMMUNITY-STR>
      
Description

Shows traps controlled. Shows all information on SNMP communities, trap receivers and SNMP response or trap
source-ip policy configured on the switch.

Parameters and options

traps

Show all configured traps.

<COMMUNITY-STR>

Displays information for the specified community only.

Show snmp-server traps

switch(config)# sh snmp-server traps

Trap Receivers
Link-Change Traps Enabled on Ports [All] : All

Traps Category                                             Current Status
_____________________________       __________________
SNMP Authentication                                   : Extended
Password change                                            : Enabled
Login failures                                              : Enabled
Port-Security                                                : Enabled
Authorization Server Contact                 : Enabled
DHCP-Snooping                                                : Enabled
DHCPv6-Snooping Out of Resource            : Enabled
DHCPv6-Snooping Errant Replies              : Enabled
Dynamic ARP Protection                              : Enabled
Dynamic IP Lockdown                                    : Enabled
Dynamic IPv6 Lockdown Out of Resource : Enabled
Dynamic IPv6 Lockdown Violations           : Enabled
Startup Config change                                : Disabled
Running Config Change                                : Disabled
MAC address table changes                        : Disabled
MAC Address Count                                        : Disabled

Address               Community             Events  Type  Retry  Timeout

Excluded MIBs
switch(config)#
Alignment change – right shifted

show distributed-trunking consistency-parameters
Syntax
show distributed-trunking consistency-parameters global feature
Description

Parameters and options
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dhcp-snooping

Display DHCP snooping peer consistency details.

IGMP

Display IGMP peer consistency details.

loop-protect

Display Loop protect peer consistency details.

MLD

Display MLD peer consistency details.

pim-dm

Display PIM-DM peer consistency details.

pim-sm

Display PIM-SM peer consistency details.

Display PIM-SM peer consistency details.

show distributed-trunking consistency-parameters global feature pim-sm

PIM-SM Enabled VLANs on Local : 20,30
PIM-SM Enabled VLANs on Peer : 20,30

show distributed-trunking consistency-parameters
Syntax
show distributed-trunking consistency-parameters global <PIM-SM>
Description

Display global peer consistency details. If the platforms do not match an error message similar to inconsistant
criteria is returned.

Parameters and options

global

Display global peer consistency details.

<PIM-SM>

Display PIM-SM peer consistency details.

Show distributed-trunking consistency-parameters global

switch# show distributed-trunking consistency-parameters global
Local Peer
----- ----
Peer config unavailable.
Image Version KB.15.18.0000x

IP Routing Disabled Disabled
Peer-keepalive interval 1000 0
PIM-DM Support Disabled Disabled
PIM-SM Support Disabled Disabled
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IGMP enabled VLANs on Local :
IGMP enabled VLANs on Peer :
PIM-DM Enabled VLANs on Local : <List of Vlans>
PIM-DM Enabled VLANs on Peer : <List of Vlans>
PIM-SM enabled VLANs on Local : <List of Vlans>
PIM-SM enabled VLANs on Peer : <List of Vlans>
DHCP-snooping Enabled on Local :
DHCP-Snooping Enabled on Peer                 : Yes
DHCP-Snooping Enabled VLANs on Local          : 1
DHCP-Snooping Enabled VLANs on Peer           : 1
DHCP-Snooping Max-Binding Configured on Local  : Yes

Ports  Max-Bindings
------- ------------
Trk2   6

DHCP-Snooping Max-Binding Configured on Peer   : No

Feature pim-sm

show distributed-trunking consistency-parameters global feature pim-sm

PIM-SM Enabled VLANs on Local : 20,30
PIM-SM Enabled VLANs on Peer : 20,30

show dhcpv6 relay
Syntax
show dhcpv6-relay
Description

Displays the DHCPv6 relay configuration. Cannot be configured from the WebUI or Menu.

Sample output

show dhcpv6-relay

DHCPV6 Relay Agent : Enabled
Option 79 : Disabled
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DHCPv6 event log
Cause

Event Message

RMON_DSNOOPV6_UNTRUSTED_PORT_SERVER_RELAY %s: %s message received on
the untrusted port %s from
%s.

RMON_DSNOOPV6_UNTRUSTED_PORT_SERVER_SUSP %s: Ceasing the log
messages for the server
packets received on an
untrusted port for %s.

RMON_DSNOOPV6_UNTRUSTED_PORT_CLIENT_DEST %s: Client packet destined to
the untrusted port %s is
dropped.

RMON_DSNOOPV6_UNTRUSTED_PORT_CLIENT_DEST_SUSP %s: Ceasing the log
messages for the client
packets destined to an
untrusted port for %s.

RMON_DSNOOPV6_UNAUTHORIZED_SERVER %s: Unauthorized server %s
detected on port %s

RMON_DSNOOPV6_UNAUTHORIZED_SERVER_SUSP %s: Ceasing unauthorized
server logs for %s

RMON_DSNOOPV6_BAD_RELEASE %s: Illegal IPv6 release from
%02X%02X%02X-%02X%02X
%02X on port %s; Address
leased to other client or not
leased. %s.

RMON_DSNOOPV6_BAD_RELEASE_SUSP %s: Ceasing the log
messages for the illegal IPv6
release messages received
from the clients for %s

RMON_DSNOOPV6_TABLE_FULL %s: Unable to add the
DHCPv6 lease because the
lease table is full.

RMON_DSNOOPV6_TABLE_FULL_SUSP %s: Ceasing the log
messages for the failed lease
table updates for %s.

Table Continued

Chapter 11 DHCPv6 server 379

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4117



Event Message

RMON_DSNOOPV6_MAX_BINDING_CROSSED %s: Droppped IPv6 request
from %02X%02X%02X-%02X
%02X%02X. The max-binding
limit has reached on the port
%s. %s

RMON_DSNOOPV6_MAX_BINDING_CROSSED_SUSP %s: Ceasing max-binding limit
crossed packet information
logs for %s.

RMON_DSNOOPV6_EVENT_MAXBINDING_REMOVED %s: The DHCPv6-Snooping
max-binding configured on
port %s is removed.

RMON_DSNOOPV6_EVENT_MAXBINDING_REMOVED_SUSP %s: Ceasing the log
messages for the removal of
DHCPv6-Snooping max-
binding from the ports for %s

RMON_DSNOOPV6_EVENT_BINDINGS_EQUALS_MAXBIND %s: The number of bindings
on the port %s equals the
maximum binding configured
on that port.

RMON_DSNOOPV6_EVENT_BINDINGS_EQUALS_MAXBIND_SUSP %s: Ceasing the log
messages for bindings on port
that equals max-binding value
for %s.

RMON_DSNOOPV6_EVENT_MAXBIND_BELOW_BINDINGS %s: The number of bindings
on the port %s exceeds the
maximum binding configured
on that port.

RMON_DSNOOPV6_EVENT_MAXBIND_BELOW_BINDINGS_SUSP %s: Ceasing the log
messages for bindings on port
that exceeds max-binding for
%s.

RMON_DSNOOPV6_READ_LEASES_ERROR %s: Reading %s/%s %s

RMON_DSNOOPV6_READ_LEASES_SUSP %s: Ceasing remote server
lease file read status logs for
%s

RMON_DSNOOPV6_WRITE_LEASES_ERROR %s: Writing %s/%s %s

RMON_DSNOOPV6_WRITE_LEASES_SUSP %s: Ceasing remote server
lease file write status logs for
%s

Table Continued
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Event Message

RMON_DSNOOPV6_TABLE_FULL_REM_LEASE %s: The dynamic binding for
%s on port %s was replaced
with a manual binding.

RMON_DSNOOPV6_TABLE_FULL_REM_LEASE_SUSP %s: Ceasing removed lease
logs for %s.

RMON_DSNOOPV6_BAD_IP_REQ %s: Illegal IPv6 request from
%02X%02X%02X-%02X%02X
%02X on port %s; %s.

RMON_DSNOOPV6_BAD_IP_REQ_SUSP %s: s: Ceasing the log
messages for illegal IPv6
requests for %s

RMON_DSNOOPV6_BAD_IP_OFFER %s: Offered lease from %s
conflicts other leases in BST.
%s.

RMON_DSNOOPV6_BAD_IP_OFFER_SUSP %s: Ceasing the log
messages for duplicate IPv6
offers for %s.

RMON_DSNOOPV6_ILLEGAL_LEASE %s: Dropped the IPv6 offer
from %s because the offered
address is illegal. %s.

RMON_DSNOOPV6_ILLEGAL_LEASE_SUSP %s: Ceasing the log
messages for illegal IPv6
offers for %s

RMON_DSNOOPV6_INVALID_PACKET %s: Invalid DHCPv6 packet
%s. %s.

RMON_DSNOOPV6_INVALID_PACKET_SUSP %s: Ceasing the log
messages for invalid DHCPv6
packets for %s

RMON_DSNOOPV6_DIPLDV6_PORT_REMOVED_VLAN Port %s removed from
dhcpv6-snooping enabled vlan
%d

RMON_DIPLDV6_DSNOOPV6_DISABLED_GLOBAL Dhcpv6-snooping disabled
globally, dynamic Ipv6
lockdown also disabled.

RMON_DIPLDV6_DSNOOPv6_DISABLED_VLAN Dhcpv6-snooping disabled on
vlan %d, dynamic Ipv6
lockdown also disabled.

Table Continued
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Event Message

RMON_DSNOOPV6_PORT_TRUSTED_TO_VALIDATING The port %s is configured as
an untrusted port.

RMON_DSNOOPV6_PORT_ADD_TO_TRUNK_ERROR Unable to add port %s to
trunk, insufficient HW
resources.

RMON_DIPLDV6_PORT_ADD_HW_RESOURCE_ERROR Unable to apply dynamic Ipv6
lockdown to port %s,
insufficient HW resources.

RMON_DIPLDV6_ADD_BINDING_OUT_OF_RESOURCES Unable to add binding for %x,
%02x%02x%02x-%02x%02x
%02x on port %s.

RMON_DIPLDV6_VLAN_DENY_OUT_OF_RESOURCES Unable to ipv6 lock-down
VLAN %d on port %s, not
enough HW resources.

RMON_DIPLDV6_VIOLATION Access denied %s -> %s port
%s, %d packets received
since last log

RMON_DIPLDV6_DHCPV6_REQUEST_DROPPED DHCPV6 REQUEST dropped
for %02x%02x%02x-%02x
%02x%02x port %s, unable to
add the binding; a port or
switch limit was reached.

RMON_DIPLDV6_VIOLATION_ON_VLAN Access was denied on VLAN
%d, %d packets received
since last log.

RMON_DSNOOPV6_CONFLICT_IN_BST %s: The IPv6 address %s
provided by the DHCPv6
server to the client %s is
already assigned to another
client %s.

RMON_DSNOOPV6_CONFLICT_IN_BST_SUSP %s: Ceasing status logs for
Conflicts in BST for %s
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DHCPv6 event messages
Cause

Events Debug messages

When the BST becomes full, to indicate that lease
bindings are being dropped.

Unable to add binding for %x, %02x%02x%02x-%02x
%02x%02x on port %s. BST is full.

When DHCPv6 packet validation fails (packets are
received on which they are not expected to).

Dropping packet as validation failed, reason %s

When a Dynamic binding is replaced with a static
binding on a particular port.

The dynamic binding for %s on port %s was replaced
with a manual binding.

While an attempt to release an Ipv6 address from port
which is leased to another port.

Unable to release. %02x%02x%02x-%02x%02x%02x
is bound not bound to port %u.

Decline from client to server when client finds the
address issued by server is already in use in the link
where the client is connected.

%s: Decline offer from %x (server)of %x because the
address is already assigned to another client.

Decline from client when server assigns an illegal Ipv6
address.

%s: Decline offer from %x (server) of %x because the
address is illegal.

When TFTP transfer of binding state table is a success
or failure.

TFTP of BST from the dsnoopv6 device is successful /
failed.

When a DIPLDv6 enabled port is removed from a
DsnoopV6 enabled vlan.

Port %u is removed from a dhcpv6-snooped VLAN

When DsnoopV6 is disabled globally which makes
DIPLDv6 no longer configured?

Dhcpv6-snooping disabled globally, dynamic Ipv6
lockdown also disabled.

When DsnoopV6 is disabled on a particular VLAN
which makes DIPLDv6 also disabled

Dhcpv6-snooping disabled on VLAN %s, dynamic Ipv6
lockdown also disabled.

When a port moved from SAVI-Trust to validating port. Port %u is validating.

While adding a port to a trunk for which DIPLDv6 is
already enabled.

Unable to add port %u to trunk, dynamic ipv6 lockdown
is enabled on it.

While enabling DIPLDv6 on a port which is added to a
trunk.

Unable to configure dynamic Ipv6 lockdown on port %u
which is a part of a trunk.

While enabling DIPLDv6 on a port for which ACL is
configured.

Unable to configure dynamic Ipv6 lockdown on port
%u, ACL is configured on port.

When it is unable to add a lock on a particular VLAN
for a particular port due to vlan deny rule.

Access was denied on VLAN %d, deny rule exists on
the VLAN

Table Continued
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Events Debug messages

When DIPLDv6 violations are detected on a VLAN Access was denied on VLAN %d, %d packets received
since last log.

When max-binding limit is reached on a Port Max-binding limit reached on Port %s.
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Aruba offers on-premise and cloud-based management solutions for switches, access points, and controllers.

AirWave is an award-winning on-premise Network Management Solution (NMS) that manages both Aruba and
third-party network devices. AirWave is ideal for Campus networks and for organizations which prefer to have
complete control over the hardware and software and have their NMS within premises (for example: either in the
head office or data center or one of the large campuses).

Aruba Central is a popular cloud-based management solution for Branch and Distributed Enterprises which prefer
simplicity, programmability, and integration with third-party cloud-based solutions for automation. Central offers
cloud portal subscriptions through which one can manage the entire network of Aruba devices, without having to
set up, upgrade, scale, or manage an NMS.

In this chapter, the focus is primarily on the Zero Touch Provisioning (ZTP) and connection to either AirWave or
Central using ZTP for check-in, configuration download, and management.

What is ZTP?

ZTP enables the auto-configuration of factory-default switches without requiring any manual setup process. It
helps the administrators to deploy their fleet of switches at multiple branches without requiring a technical expert
onsite. It is of use for distributed enterprises (for example: hotels, hospitals, retail stores, educational institutions,
and other enterprises) where an administrator is not available at every site.

Aruba offers ZTP solution which reduces the overall cost of ownership. Aruba ships infrastructure devices such as
switches, access points, and controllers directly to the site of usage. With ZTP, even a nontechnical user (for
example: store manager in a retail chain or a class teacher in a school) can deploy devices at site. When the
devices are connected to AirWave or Central, ZTP automatically sets up the required firmware and configurations,
and services without the need for technical expertise on site.

ZTP with AirWave
Aruba supports ZTP using:

• DHCP servers for on-premise management (see DHCP server configuration for DHCP based ZTP).

• Activate for cloud-based management. Activate is a cloud-based inventory management and provisioning
service (see Activate based ZTP with AirWave).

You can choose any of the ZTP methods based on your requirement. For example: If all the campuses and
branches which an Enterprise manages are reachable within a private network, it is recommended to use DHCP
based ZTP. If an Enterprise network spans multiple campuses and branches using WAN to communicate, use
Activate based ZTP.

DHCP-based ZTP with AirWave
IPv6 based ZTP is supported from 16.06 switch version. Switches can be connected to AirWave through IPv4 or
IPv6 addresses. To enable IPv6 ZTP provisioning, the ipv6 enable and ipv6 address dhcp full will be
enabled by default from 16.06 switch version. These commands also get enabled when the switch upgrades from
any older images to 16.06 with factory default configuration. From 16.06 release, the switch can act as DHCP
server for IPv4 ZTP. The switch supports DHCP option 60 and 43 which is required for ZTP. AirWave 8.2.6.1
supports IPv6 ZTP over data port and AirWave 8.2.8 will support IPv6 ZTP over OOBM port.

Chapter 12
Zero Touch Provisioning with AirWave and Central
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Configuring DHCP-based ZTP with AirWave
ZTP auto-configures your switches as follows:

Procedure

1. The switch boots up with the factory default configuration.

2. The switch sends out a DHCP discovery from data port/OOBM.

IPv4:

• The preferred configuration method uses DHCP option 43 value as a string to parse AirWave configuration.
Switch expects a DHCP option 60 with value ArubaInstantAP along with DHCP option 43 to parse
AirWave details.

• The alternative configuration method supports both encapsulated values from option 43 and direct value
from option 43. Encapsulated vendor-specific sub options, with suboption code 146 is for AirWave details.

NOTE: IPv4 DHCP sub option 146 is not supported to configure AMP information through OOBM.

IPv6:

• IPv6 uses DHCP option 17 with sub option 100 and vendor class Enterprise ID as 47196.

• DHCPv6 based ZTP on OOBM interface, ipv6 enable and ipv6 address dhcp full commands are
enabled by default on OOBM interface.

3. After the AirWave details are verified and configured, the switch initiates the check-in into the AirWave server
using the HTTPS communication. The AirWave configuration must be in the following format:

<Group>:<Topfolder>:<folder1>,<AMP IP >,<shared secret>
4. From 16.08, if AirWave is reachable through both OOBM and Data VLAN, switch tries to register only with

AirWave using OOBM.

5. After a successful registration, AirWave can monitor, configure, and troubleshoot the switches. Refer to Aruba
Networks and AirWave Switch Configuration Guide.

6. Check-in failure retry is done every 60 seconds for 10 retries.

7. If DHCP does not provide AirWave details, the switch connects to Activate (Activate ZTP starts) for AirWave or
Aruba Central details. If the DHCP options are not configured for AirWave, the switch is left in its default state
for manual configuration.
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In the preceding illustration, the workflow is as follows:

1. The switches being provisioned in the branches are booted obtaining the IP address from the DHCP server.

2. The DHCP servers provide information about the AirWave server in the Corporate Head Quarters.

3. The switches connect to the AirWave server through the Corporate Network (MPLS VPN or equivalent).

4. The AirWave server pushes the configuration to the switches based on the AirWave folder, switch model, and
branch location.

5. An optional IPsec tunnel can be established between the branches and the Corporate HQ to secure the
management traffic. For more information, refer the Activate-based ZTP with AirWave.

NOTE: If IPsec tunnel is required for AirWave, the switch requires Aruba Mobility Controller IP
address, which is provided through ZTP with DHCP Option 138 (CAPWAP).

DHCP server configuration for DHCP based ZTP
You can configure the DHCP server for AirWave using Windows DHCP server, Linux DHCP server, and ArubaOS
DHCP server.

Preferred Methods
The following methods are preferred to configure DHCP server for AirWave:

Configure AirWave details in Windows DHCP server for IPv4

NOTE: AirWave provisioning using IPv6 on Windows based DHCP server is not supported.

To configure the AirWave details in Windows DHCP server for IPv4, do the following steps:

Procedure

1. From the Start menu, select Server Manager.

Chapter 12 Zero Touch Provisioning with AirWave and Central 387

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4125



2. Select Roles -> DHCP -> Server -> w2k8 -> IPv4.

3. Right-click IPv4 and select Set Predefined Options...
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4. The Predefined Options and Values screen is displayed. Click Add....

5. Enter the Name (any), Data type (select String), Code (enter 60), and Description (any).
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6. Click OK.

7. From the Predefined Options and Values screen, under Value, enter the String ArubaInstantAP. The
string is case-sensitive and must be ArubaInstantAP.

8. Click OK.

9. Under IPv4, expand Scope. Right-click Scope Options and select Configure Options...
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10. Under the General tab, select 043 Vendor Specific Info. The Data entry data appears. Under ASCII, enter
hpeSwitch:hp2920,90.1.1.10, admin. The ASCII value has the following format:
<Group>:<Topfolder>,<AMP IP>,<shared secret>

11. To add subdirectories, use the following format: <Group>:<Topfolder>:<folder1>,<AMP
IP>,<shared secret>

12. Under the General tab, select 060 AirWave. Click OK.
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NOTE: No changes are required to the 060 option.

13. You can verify the AirWave details as follows:

switch# show amp-server
switch# show run

Configure AirWave details in Linux DHCP server for IPv4
To configure the AirWave details in Linux DHCP server for IPv4, enter the following information:

option CAPWAP code 138 = array of ip-address; 
ddns-update-style ad-hoc; 
subnet 192.168.20.0 netmask 255.255.255.0 { 
   option tftp-server-name "192.168.20.5"; 
   option routers 192.168.20.31; 
   option ntp-servers 192.168.20.5; 
   option domain-name "Airport"; 
   option domain-name-servers 192.168.20.5; 
   option CAPWAP 171.0.0.3; 
   
   #option 43 "171.0.0.100"; 
   range 192.168.20.10 192.168.20.30; 
}
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Configure AirWave details in Linux DHCP server for IPv6
To configure the AirWave details in Linux DHCP server for IPv6, enter the following information:
default-lease-time 900;
preferred-lifetime 600;
option dhcp-renewal-time 300;
option dhcp-rebinding-time 600;
allow leasequery;
option dhcp6.info-refresh-time 800;
dhcpv6-lease-file-name "/root/dhcpd6.leases";
host myclient {
        # The entry is looked up by this
        host-identifier option
                dhcp6.client-id 00:01:00:01:00:04:93:e0:00:00:00:00:a2:a2;

        # A fixed address
        fixed-address6 2001::1234;

        # A fixed prefix
        fixed-prefix6 2001::/64;

        # For debug (to see when the entry statements are executed)
        #  (log sol when a matching Solicitation is received)
        ##if packet(0,1) = 1 { log(debug,sol); }
}

# The subnet where the server is attached
subnet6 2001::/64 {
        range6 2001::5000 2001::5090;

        # Some /64 prefixes available for Prefix Delegation (RFC 3633)
#3ffe:501:ffff:100:: 3ffe:501:ffff:111:: /64;
        prefix6 2001::  2001:3:: /64;

        option dhcp6.name-servers 2001::6001,2001::6002;

        option dhcp6.vendor-opts
        00:00:B8:5C:   # HPE enterprise-number
        00:64:00:35:   # suboption (100) + length of AW string

#below hex values are for this ascii string : group:folder,2001::212,secret
67:72:6f:75:70:3a:66:6f:6c:64:65:72:2c:32:30:30:31:3a:3a:32:34:32:2c:73:65:63:72:65:74;
}

Configure AirWave details in ArubaOS-Switch DHCP server for IPv4

NOTE: AirWave provisioning using IPv6 on ArubaOS-Switch based DHCP server is not supported.

To configure the AirWave details in ArubaOS-Switch DHCP server for IPv4, enter the following information:

option 43 ascii "group:folder,192.168.240.242,secret1"
option 60 ascii "ArubaInstantAP"
Alternate Methods
The following are the alternate methods to configure DHCP server for AirWave:
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Configure AirWave details in Windows DHCP server for IPv4

NOTE: AirWave provisioning using IPv6 on Windows based DHCP server is not supported.

To configure the AirWave details in Windows DHCP server for IPv4, do the following steps:

NOTE:

• Use these steps to configure ZTP for every switch by selecting a different Vendor Class for each
type of switch.

• This method is not applicable for ZTP through OOBM.

Procedure

1. From the Start menu, select Server Manager.

2. Select Roles -> DHCP -> Server -> w2k8 -> IPv4.
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3. Right-click IPv4 and select Define Vendor Classes....

4. The DHCP Vendor Classes window is displayed. Click Add....
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5. To get the vendor-specific value of a switch, go to the switch console and enter:

switch# show dhcp client vendor-specific
          

6. The following is the sample command output: Processing of Vendor Specific Configuration is enabled.

    Vendor Class Id = J9729A 2920-24G-PoE+ Switch dslforum.org 
7. From the New Class window, enter the desired Display name (any) and the Description (any). For the

ASCII field, enter the exact value that you got by executing the show command performed in the previous
step. In this example, Hewlett Packard Enterprise J9729A 2920-24G-PoE+ Switch dslforum.org.
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8. Click OK.

9. Right-click IPv4 and select Set Predefined Options....

10. From the Predefined Options and Values window, select Option class. The Option Class displayed is the
one that you configured under DHCP Vendor Class. In this example, the Option Class is switch.
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11. Click Add....

12. From the Option Type window, enter the desired Class (any), the Data type (select string), the Code (enter
146), and the Description (any).

13. Click OK.

14. Under the Predefined Options and Values window, enter the Value String. In this example, enter
hpeSwitch:hp2920,90.1.1.10, admin. The String has the following format:

<Group>:<Topfolder>,<AMP IP>,<shared secret>
15. To add sub-folders, use the following format:

<Group>:<Topfolder>:<folder1>,<AMP IP>,<shared secret>
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16. Click OK.

17. Under IPv4, expand Scope. Right-click Scope Options and select Configure Options...

18. From the Scope Options window:

a. Select the Advanced tab.

b. Under Vendor class, select the desired switch. In this example, switch.

c. Select the 146 switch option.

d. Click OK.
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19. You can verify the AirWave details as follows:

switch# show amp-server
switch# show run

Configure AirWave details in Linux DHCP server for IPv4
To configure the AirWave details in Linux DHCP server for IPv4, enter the following information:

option space ArubaInstantAP;
option ArubaInstantAP.cfg code 144 = text;
option ArubaInstantAP.img code 145 = text;
option ArubaInstantAP.org code 146 = text;
option CAPWAP code 138 = array of ip-address;

ddns-update-style ad-hoc;

subnet 192.168.20.0 netmask 255.255.255.0 {
   option tftp-server-name "192.168.20.5";
   option routers 192.168.20.31;
   option ntp-servers 192.168.20.5;
   option domain-name "Airport";
   option domain-name-servers 192.168.20.5;

400 Aruba 3810 / 5400R Management and Configuration Guide for
ArubaOS-Switch 16.08

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4138



   option CAPWAP 171.0.0.3, 192.168.20.31;

   class "vendor-class" {
        match substring (option vendor-class-identifier,0,2);
        #match option vendor-class-identifier;
   }
   subclass "vendor-class" "HP" {
      vendor-option-space ArubaInstantAP;
      #option ArubaInstantAP.cfg "runningConfig_5400R.txt";
      #option ArubaInstantAP.img "KB_16_01_0004.swi";
      option ArubaInstantAP.org "aw_group:fold,171.0.0.100,secret1234";
   }
    subclass "vendor-class" "Ar" {
      vendor-option-space ArubaInstantAP;
      #option ArubaInstantAP.cfg "runningConfig_5400R.txt";
      #option ArubaInstantAP.img "KB_16_01_0004.swi";
      option ArubaInstantAP.org "aw_group:fold,171.0.0.100,secret1234";
   }
   range 192.168.20.10 192.168.20.30;
}

Limitations

• The HTTPS check-in to AirWave does not support HTTPS proxy.

• For non-ZTP cases, the AirWave check-in starts by validating the following condition:

Primary or Management VLAN must be configured with the IP address and one of the interfaces must be UP.
By default, VLAN 1 is the primary VLAN.

• OOBM redirection is not supported by VSF.

Best Practices

• Implement ZTP in a secure and private environment. Any public access may compromise the security of the
switch, as follows:
◦ Since ZTP is enabled only on the factory default configuration of the switch, DHCP snooping is not

enabled. The Rogue DHCP server must be manually managed.

◦ The DHCP offer is in plain data without encryption. Therefore, the offer can be listened by any device on
the network and they can in turn obtain the AirWave information.

◦ The TLS certificate of the server is not validated by the switch during the HTTPs check-in to AirWave. The
AirWave server must be hosted in a private and secure environment of the switch.

Configure AirWave details manually
This section focuses on configuring the switch manually to reach out to AirWave. Manual configuration may be
required, if ZTP is disabled due to the following scenarios or if AirWave credentials are not provided during the
DHCP offer:

• Switch with configuration that explicitly disables ZTP

• Switch with nondefault configuration

• Switches that have upgraded from older images to 16.xx
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In any of the above scenarios, you need to manually configure to reach the AirWave server using the amp-
server command. This command helps you configure the AirWave IP address, group, folder, and shared secret.
You must have the manager role to execute this command.

For example:

switch(config)# amp-server ip 192.168.1.1 group "group" folder "folder" secret "branch1024"
        

The show amp-server command shows the configuration details:

AirWave Configuration details
AMP Server IP : 192.168.1.1
AMP Server Group : GROUP
AMP Server Folder : folder
AMP Server Secret : branch1024
AMP Server Config Status: Configured
        

amp-server

Syntax
amp-server ip <IP-ADDR | IPv6-ADDR> group <GROUP> folder <FOLDER> secret <SECRET>

no amp-server

Description

The amp-server command configures AirWave Management Platform (AMP) IP address, group, folder, and
shared secret for triggering the device registration with AMP. The amp-server command supports both the IPv4
and IPv6 addresses. Switch cannot be provisioned simultaneously with IPv4 and IPv6 AirWave addresses.

NOTE: The amp-server with IPv6 address is supported from 16.06 switch version.

The no form of this command removes the configuration for the AMP server.

Command context
config

Parameters
IP-ADDR

AMP server IPv4 address.

IPv6-ADDR

AMP server IPv6 address.

GROUP

AMP server group name.

FOLDER

AMP server folder name.

SECRET

AMP server shared secret string.
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Example

Switch(config)# amp-server
 ip                    Configure AMP server IP address.
Switch(config)# amp-server ip
 IP-ADDR               Enter an IP address.
 IPV6-ADDR             Enter an IPv6 address.
Switch(config)# amp-server ip 192.168.1.1
 group                 AMP server group name.
Switch(config)# amp-server ip 192.168.1.1 group
 GROUPNAME-STR         AMP server group name.
Switch(config)# amp-server ip 192.168.1.1 group grp11
 folder                AMP server folder name.
Switch(config)# amp-server ip 192.168.1.1 group grp11 folder
 FOLDERNAME-STR        AMP server folder name.
Switch(config)# amp-server ip 192.168.1.1 group grp11 folder fld11
 secret                AMP server shared secret string.
Switch(config)# amp-server ip 192.168.1.1 group grp11 folder fld11 secret
 SECRET-STR            AMP server shared secret string.
Switch(config)# amp-server ip 192.168.1.1 group grp11 folder fld11 secret scrt11

Switch(config)# amp-server ip
 IP-ADDR               Enter an IP address.
 IPV6-ADDR             Enter an IPv6 address.
Switch(config)# amp-server ip 2001:1db8:3cd4:1115:1111:2222:1a2f:1a2b
 group                 AMP server group name.
Switch(config)# amp-server ip 2001:1db8:3cd4:1115:1111:2222:1a2f:1a2b 
group
 GROUPNAME-STR         AMP server group name.
Switch(config)# amp-server ip 2001:1db8:3cd4:1115:1111:2222:1a2f:1a2b 
group grp21
 folder                AMP server folder name.
Switch(config)# amp-server ip 2001:1db8:3cd4:1115:1111:2222:1a2f:1a2b 
group grp21 folder
 FOLDERNAME-STR        AMP server folder name.
Switch(config)# amp-server ip 2001:1db8:3cd4:1115:1111:2222:1a2f:1a2b 
group grp21 folder fld21
 secret                AMP server shared secret string.
Switch(config)# amp-server ip 2001:1db8:3cd4:1115:1111:2222:1a2f:1a2b 
group grp21 folder fld21 secret
 SECRET-STR            AMP server shared secret string.
Switch(config)# amp-server ip 2001:1db8:3cd4:1115:1111:2222:1a2f:1a2b 
group grp21 folder fld21 secret scrt21
To view the AirWave configuration details, use the show amp-server command.

show amp-server

AMP Server Configuration details

  AMP Server IP            : 2001:1db8:3cd4:1115:1111:2222:1a2f:1a2b
  AMP Server Group         : grp21
  AMP Server Folder        : fld21
  AMP Server Secret        : scrt21
  AMP Server Config Status : Configured
show running-configuration

switch# show running-config

; JL071A Configuration Editor; Created on release #KB.16.06.0000x
; Ver #13:03.f8.1c.fb.7f.bf.bb.ff.7c.59.fc.7b.ff.ff.fc.ff.ff.3f.ef:05

hostname "Switch"
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module 1 type jl071x
flexible-module A type JL081A
snmp-server community "public" unrestricted
oobm
   ip address dhcp-bootp
   exit
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-24,A1-A4
   ip address dhcp-bootp
   ipv6 enable
   ipv6 address dhcp full
   exit
amp-server ip 2001:1db8:3cd4:1115:1111:2222:1a2f:1a2b group "grp21" folder "fld21" 
   secret "scrt21"

NOTE: ipv6 enable and ipv6 address dhcp full are enabled by default on VLAN 1 from
16.06 switch version.

debug ztp
Syntax
debug ztp
no debug ztp
Description

Enables or disables ZTP debug logging.

Parameters and options
ztp

Zero Touch Provisioning.

no
The no debug ztp command disables ZTP debug logging.

Stacking support
The ZTP process for stacked switches with AirWave is similar to the one for the standalone switch, with the
exception that only the commander in the stack checks in with AirWave.

Disabling ZTP
ZTP is disabled if you make any of the following changes to the switch configuration:

• Enter the switch configuration mode using the configure terminal command.

• Enter into Menu and exit without doing any configuration

• Use CLI, SNMP, REST APIs, menu interface, or the web GUI to configure any settings. The change is shown
in the running-configuration of the switch.

• When device is upgraded from any 15.xx version to 16.01, see Image Upgrade.

• Once DHCP server or Activate offers Airwave/Central details, ZTP is disabled. If the details are offered again,
it is ignored.
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Image Upgrade
If you upgrade from any 15.xx version to version 16.xx, the following minimal set of configuration is validated to
enable or disable the ZTP process:

• If the switch has any other VLAN apart from the default VLAN, ZTP gets disabled.

• In default VLAN, if the IPv4 address is not set as DHCP (default option is DHCP), ZTP gets disabled.

• In default VLAN, if IPv6 is enabled or configured, ZTP gets disabled.

If you have any other configuration during the upgrade, ZTP will continue to be in the enabled state.

Troubleshooting

Cause

You can troubleshoot switches by using the SSH connection and the device logs available in AirWave. For a list of
all RMON message, refer to ArubaOS-Switch Event Log Message Reference Guide.

You can enable the debug logging with the debug ztp command, see debug ztp.

AMP server messages
To display the AMP server debug messages, enter:

switch# debug ztp
        
To print the debug messages to the terminal, enter:

switch# debug destination session
      

Activate based ZTP with AirWave
ZTP with Activate is used in the following scenarios to help switches check in through the Internet with public
facing instances of Airwave:

• Deployments where administrators do not have a DHCP server to configure Airwave options

• Absence of corporate network reaching every branch

NOTE:

• Activate based ZTP is not supported for IPv6.

• Activate based ZTP is not supported for both IPv4 and IPv6 through OOBM.

Configuring Activate-based ZTP with AirWave
For Activate-based ZTP, the switch connects to Aruba Activate service through the Internet and autoconfiguration
takes place based on the settings provided in Activate. For more information on how to set up an Activate
account, folder and their rules, refer to the Aruba Activate User Guide.
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In the preceding illustration, the workflow is as follows:

1. The switches being provisioned in the branches are booted and connect to the Activate on the cloud.

2. Based on the administrator’s provisioning (folder, rule), the device is placed in the appropriate folder before
getting redirected to the AirWave server in the Corporate HQ.

3. The switches connect to the AirWave server, and the server pushes the configuration to the switches based on
the AirWave folder, switch model, and branch location.

4. Optionally, an IPsec tunnel to the Controller in the HQ can be constructed to secure the management traffic to
AirWave. This configuration can be set as part of the initial configuration push from Activate.

IPsec for AirWave Connectivity

Overview
This feature supports secure communication between the switch and Aruba mobility controller (VPN concentrator)
for AirWave traffic. The switch also provides the necessary support for ZTP by establishing a secure tunnel
between the switch and AirWave, which are provided by a DHCP server or Activate.

IPsec ensures that communication between the switch and AirWave server (management traffic) is protected by
establishing a secure channel between the switches and the Aruba VPN Controller (connected to AirWave
server).

IPsec for Management Traffic
IPsec supports ZTP in deployment scenarios less restrictive than private LANs. ZTP enables switches to be
configured and managed automatically without administrator intervention. In a deployment scenario where a
switch and AirWave are located in different branches connected through an untrusted public network (the
Internet), the communication between the switch and AirWave server can be protected.

NOTE: 

• IPsec tunnel is not supported with IPv6.

• IPsec tunnel is not supported through OOBM.

You can configure IPsec tunnel using any of the following methods:
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• Activate ZTP

• DHCP ZTP with option 138

1. To assign controller IP addresses, select DHCP option 138.

2. Define the controller IP addresses for both the primary and secondary controllers.

• Manual configuration

IPsec Tunnel Establishment

• IPsec tunnel for AirWave is auto-configured. The switch decides to create IPsec tunnel only when an Aruba
controller IP is present in the device before establishing the connection to AirWave.

• If the controller IP is not provided, the switch will try to establish a direct connection to AirWave.

• If the controller IP is present, the switch auto configures and initiates an IPsec tunnel interface. Once the
tunnel is established, the Aruba controller provides an inner IP which the switch will then use as source IP to
send any AirWave bound traffic. The switch then creates a static route to AirWave with the IPsec tunnel
interface as the gateway.
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IPsec Tunnel Failures
The following behaviors can cause an IPsec tunnel creation failure:

• Time

The time in the switch has to be valid and correct. Ensure that NTP configuration is set up on switch and on
the controller where the tunnel is terminating.

• Authentication

The switch MAC addresses for both members must be added to the Aruba controller whitelist.

• Controller IP

The controller IP must be reachable from the switch.

• Inner IP pool

Ensure the inner IP pool is configured on the controller. Tunnel establishment is not successful, if the pool is
full.

• Static Route

There must not be any conflicting static route in the system for the AirWave IP configured.

• License

The controller must have sufficient license to support IPsec tunnels.

IPsec tunnel to secondary controller
ArubaOS-Switch assists support for IPsec tunnel between switch and the Aruba Controller (VPN concentrator) to
carry the switch generated traffic to multiple services behind the Aruba Controller. The services include AirWave
management station, ClearPass, DNS, Syslog, and so on.

IPsec tunnel needs a backup support for IPsec session failure. If the existing IPsec session is lost, the switch is
able to establish a new IPsec tunnel session with a backup controller (secondary controller).

Backup controller support for IPsec tunnel
The switch supports two controllers with all the services such as ClearPass, Syslog, DNS, and AirWave. In such
scenarios, a controller functions as a backup controller.

1. aruba-vpn is modified to support backup controller IP.

aruba-vpn type amp peer-ip <IP_addr> backup-peer-ip <IP_addr>

no aruba-vpn type amp peer-ip <IP_addr> backup-peer-ip <IP_addr>

switch(config)# aruba-vpn type amp peer-ip 171.0.0.1
backup-peer-ip        Configure the Aruba VPN backup IP address.
tos                   Configure the Aruba VPN tos value.
ttl                   Configure the Aruba VPN ttl value.
switch(config)# aruba-vpn type amp peer-ip 171.0.0.1 backup-peer-ip 171.0.0.3

2. When the switch is configured with both the primary and backup controllers, the switch will establish IPsec
tunnel connection with primary controller.

3. Switch initiates a new IPsec session with either primary or backup controller once "Dead Peer Detection" event
is triggered for existing IPsec session.

4. Switch retries establishing IPsec session with both primary and backup controllers alternatively until a
successful IPsec handshake.
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5. Switch tries to establish the IPsec tunnel with the same controller when the following events occur:

• Switch IP change

• Vlan ID change

• Redundancy switch over

6. If aruba-vpn type is amp, after five consecutive AirWave check-in failures, the existing tunnel is destroyed
and an IPsec tunnel is established with the other controller.

NOTE: ZTP continues to support existing DHCP options for AirWave or Controller IP discovery. You
can configure both the primary and backup controllers IP in DHCP.
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Switch reachability to the controllers

Figure 89: Controllers through same VLAN

Figure 90: Controllers through different VLANs

Restrictions

1. Priority based failover is not supported.

2. When there is a failover to backup controller, the primary controller will not try to re-establish the IPsec session
when it becomes active.

3. Failover to the other (either primary or secondary) controller results in data loss. All the existing application
sessions in the switch will be terminated.
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NOTE: The failover will take up to three minutes.

4. The events such as time change and port flap, breaks the existing IPsec session and triggers a failover. The
new IPsec session is established with a backup controller. In such scenario, switch does not perform any
reachability test before selecting a controller to retry.

AirWave IP after discovery
AirWave IP and Aruba Controller IP (either from the Activate Server or from a DHCP server) are established and
auto configured in an IPsec-IPv4 Tunnel. Once received, the IPsec tunnel is auto configured and established to
send AirWave traffic securely. The Aruba Controller provides an inner-ip to the switch which then can
communicate with AirWave.

Configuring the Aruba controller
On the Aruba Controller, configure through CLI:

Procedure

1. Add the switch MAC address to whitelist for authentication. For more information, refer http://
www.arubanetworks.com/techdocs/ArubaOS_63_Web_Help/Content/ArubaFrameStyles/Control_Plane/
Whitelists_on_Campus_and_Remote_APs.htm

2. Add an IP address pool that can be assigned to switch after tunnel creation. The IP range must not overlap
with the interfaces IP on the controller.

ip local pool "ipsec" 2.0.0.100 2.0.0.255
3. Create access lists that permit AirWave traffic and assign them to ap-roles. It is required only if the controller

version is less than 6.5.2.0 or 8.1.0.0. If required, you can add specific acls such as sys-switch-role.

ip access-list session acl
any any tcp 22 permit
any any tcp 443 permit
user-role sys-switch role
access-list session acl

4. View the whitelist.

AirWave Controller IP configuration commands

aruba-vpn type

Syntax
aruba-vpn type amp peer-ip <IP_addr> backup-peer-ip <IP_addr>

no aruba-vpn type amp peer-ip <IP_addr> backup-peer-ip <IP_addr>

aruba-vpn type any peer-ip <IP_addr> backup-peer-ip <IP_addr>

no aruba-vpn type any peer-ip <IP_addr> backup-peer-ip <IP_addr>
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Description

Configure the Aruba VPN type, peer IP address. When Aruba VPN type is any, the tunnel is established
independent of Airwave configuration.

The no form of the command removes the aruba-vpn type statement from the configuration.

Parameters
type

Configure the controller IP.

amp
Configure Remote Access VPN session to protect specific switch generated traffic. It also supports secure
ZTP of Airwave Management Platform (AMP) server.

any
Configure Remote Access VPN session to protect specific switch generated traffic. Secure ZTP is not
supported.

<IP_addr>

IP address of the VPN.

Usage
switch(config)# aruba-vpn type 

switch(config)# aruba-vpn type amp 

switch(config)# aruba-vpn type amp peer-ip

switch(config)# aruba-vpn type any

NOTE: 

• When you configure aruba-vpn type as any, the switch creates a tunnel and updates the
inner-ip.

• You can create routes using the ip route command for next hop as aruba-vpn sends
management traffic over the tunnel. For example: ip route 2.0.0.0 255.255.255.0
tunnel aruba-vpn

Show commands

show aruba-vpn
Syntax
show aruba-vpn type <VPN-TYPE>
Description

Show Aruba-VPN configuration information.

show aruba-vpn

show aruba-vpn

412 Aruba 3810 / 5400R Management and Configuration Guide for
ArubaOS-Switch 16.08

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4150



 Aruba VPN details

  Aruba VPN Type           : amp
  Aruba VPN Peer IP        : 171.0.0.1
  Aruba VPN Backup Peer IP : 171.0.0.3
  Aruba VPN Config Status  : Configured
  Aruba VPN tos            : Value from IPv4 header
  Aruba VPN ttl            : 64

show aruba-vpn type amp

show aruba-vpn type amp

 Aruba VPN details

  Aruba VPN Type           : amp
  Aruba VPN Peer IP        : 171.0.0.1
  Aruba VPN Backup Peer IP : 171.0.0.3
  Aruba VPN Config Status  : Configured
  Aruba VPN tos            : Value from IPv4 header
  Aruba VPN ttl            : 64

show ip route
Syntax
show ip route
Description

Show the IP route.

show ip route

show ip route

                                IP Route Entries

  Destination        Gateway         VLAN Type      Sub-Type   Metric     Dist.
  ------------------ --------------- ---- --------- ---------- ---------- -----
  0.0.0.0/0          192.168.20.31   1    static               250        1
**2.0.0.9/32         aruba-vpn            static               1          1
 *2.0.0.108/32       aruba-vpn            connected            1          0
  127.0.0.0/8        reject               static               0          0
  127.0.0.1/32       lo0                  connected            1          0
  192.168.20.0/24    DEFAULT_VLAN    1    connected            1          0
*The inner IP received from the Aruba Controller.

**Static Route for AirWave IP. Added automatically by the switch after tunnel establishment.

show interfaces tunnel aruba-vpn
Syntax
show interfaces tunnel aruba-vpn
Description
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Auto-configured tunnel interface before creating IPsec. The tunnel ID is auto generated and to avoid conflict with
user generated tunnel interface, the tunnel id is always the max tunnel supported by the switch + 1.

aruba-vpn

Display the configuration and status details of aruba-vpn tunnel.

brief

Display brief configuration and status for all tunnels.

Usage
show interfaces tunnel aruba-vpn
show interfaces tunnel brief
show interfaces [tunnel] [<TUNNEL-LIST> | <TUNNEL-NAME> | brief | type]
      

switch(config)# show interfaces tunnel aruba-vpn 

 Tunnel Configuration : 

  Tunnel               : tunnel-129
  Tunnel Name          : aruba-vpn-tunnel
  Tunnel Status        : Enabled
  Source Address       : 192.168.20.10
  Destination Address  : 171.0.0.3
  Mode                 : IPsec IPv4
  TOS                  : Value from IPv4 header
  TTL                  : 64
  IPv6                 : Disabled
  MTU                  : 1280

 Current Tunnel Status :

  Tunnel State               : Up
  Destination Address Route  : 0.0.0.0/0
  Next Hop IP                : 192.168.20.31
  Next Hop Interface         : vlan-1
  Next Hop IP Link Status    : Up
  Source Address             : Configured on vlan-1
  IP Datagrams Received      : 11
  IP Datagrams Transmitted   : 36  

switch(config)#  show interfaces tunnel brief
 Status - Tunnel Information Brief
  Tunnel                   : tunnel-129
  Mode                     : IPsec IPv4
  Source Address           : 192.168.20.10
  Destination Address      : 171.0.0.3
  Configured Tunnel Status : Enabled
  Current Tunnel State     : Up

show crypto-ipsec sa
Syntax
show crypto ipsec sa
Description
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Show crypto-IPsec statistics.

switch# show crypto ipsec sa

  Crypto IPSec Status 
  Interface              : 1         
  Source Address         : 192.168.20.10                           
  Destination Address    : 171.0.0.3                               
  Source Port            : 0              Destination Port   : 0              
  SPI                    : 3767553536                                         
  Encapsulation Protocol : ESP                                                
  Encryption             : AES            Hash               : SHA1           
  PFS                    : 0              PFS Group          :
  Mode                   : tunnel
  Key Life               : 3600           Remaining key Life : 3303
  Key Size               : 0              Remaining key Size : 0
  Interface              : 2
  Source Address         : 171.0.0.3
  Destination Address    : 192.168.20.10
  Source Port            : 0              Destination Port   : 0
  SPI                    : 4173307552
  Encapsulation Protocol : ESP
  Encryption             : AES            Hash               : SHA1
  PFS                    : 0              PFS Group          :
  Mode                   : tunnel
  Key Life               : 3600           Remaining key Life : 3301
  Key Size               : 0              Remaining key Size : 0
Usage
show crypto ipsec statistics

show running-configuration
Syntax
show running-configuration

NOTE: IP route or tunnel interface will not be displayed in show run as they are auto created.

show running-configuration

show running-config

Running configuration:

; JL258A Configuration Editor; Created on release #XX.XX.XX.XXXX
; Ver #11:10.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:bc
hostname "switch"
module 1 type jl258a
ip default-gateway 192.168.20.31
snmp-server community "public" unrestricted
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-10
   ip address 192.168.20.10 255.255.255.0
   exit
amp-server ip 2.0.0.9 group "aw_group" folder "fold" secret "secret123"
aruba-vpn type amp peer-ip 171.0.0.3
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ZTP with Aruba Central
Aruba Central does not require any configuration of local DHCP server or other network components but requires
a switch with Internet access.

Users with access to Aruba Central cloud portal must provision their switches and assign licenses accordingly.
Once complete, Aruba Central will automatically program the Activate portal with the required switch details and
the group to which the switch must check in.

NOTE:

• Aruba Central does not support IPv6 connectivity.

• Aruba Central is not applicable for connection through OOBM interface.

The following diagram illustrates the working of Aruba Central ZTP:

The workflow is as follows:

1. The switches being provisioned in branches boot and connect to the Activate on the cloud.

2. Based on administrator’s provisioning (such as folder, rule), the device is placed in the appropriate folder
before being redirected to the Aruba Central.

3. The switches check-in with Central and the server pushes the configuration to the switches based on the
group, switch model, and branch location.

For more information on Aruba Central configuration, refer to the Aruba Central Configuration Guide.

After the switch successfully checks-in with Aruba Central, the following management interfaces on the switch are
disabled:

• WebUI

• REST

• SNMP
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• TR-69

• Menu

There is a restriction on executing the following commands over CLI:

• boot

• recopy

• erase

• reload

• startup-default

• upgrade-software

• setup

• delete

• reboot

• restore

• menu

• write memory

• amp-server

LED Blink feature
Central connectivity loss is indicated by LEDs. If connectivity is broken and Aruba-Central is enabled, the
USR/FDX and Locator LEDs will blink. The LEDs will stop blinking once the switch is connected back to Central. 

Aruba Central Configuration manually
In factory default switches, ZTP with Central is turned ON. ZTP can be disabled in the following scenarios:

• Switches with edited configuration

• Switches where the administrator has explicitly turned off ZTP with Central

In any of the mentioned scenarios, an administrator can manually configure Aruba Central using the aruba-
central command.

Activating ArubaOS-Switch Firmware Integration
CLIs are available for Activate firmware updates which enables, update, checks and shows firmware upgrades.
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Operating Notes

Switch will periodically check with Activate every seven days for the latest image version.

Download the image from the URL provided by Activate and upgrade the switch with the new image.

Restrictions

When a switch is managed by either AirWave or Aruba Central, the automatic firmware check is disabled.

Activate upgrade from the non-supported build is disabled upon upgrading to version 16.03.

Upon upgrade from version 16.02 to version 16.03 with activate provision enabled, activate software update will
be enabled.

activate software-update enable

Syntax
activate software-update [enable | disable]

Description

Enables or disables the Activate software update.

Activate software-update is enabled by default.

Options
disable

Disables the Activate software update.
enable

Enables the Activate software update.

Example

Switch will check with activate for every seven days for latest image available and RMON logs will be generated:

I 10/25/16 14:04:27 05219 activate: 
A system software update is available to version WB.16.02.0012.

activate software-update check

Syntax
activate software-update check

Description

Check the Activate software update manually.

Example

switch(config)$# activate software-update check

 Configuration and Status - Activate Software Update
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  Activate Server Address      : device.arubanetworks.com
  Activate Server Polling      : Enabled
  Installed Software Version   : WB.16.04.0000x
  Server Software Version      : Not available - server communication error.
  Server Software Image URL    : Not available - server communication error.
switch(config)$

NOTE: This switch is not connected to Activate, hence communication error is shown in “Server
Software Version” and “Server Software Image URL” field.

activate software-update update
Syntax
switch#(config) activate software-update update
Description

Updates the software for Activate.

Options
primary

Update primary software image using the Aruba Activate server.

secondary

Update secondary software image using the Aruba Activate server.

Example

switch# activate software-update update

This command will save the current configuration,
update the selected software image, and reboot the
system to the selected partition.

Continue (y/n)? y

000M

show activate software-update

Syntax
show activate software-update

Description

Show the configuration and status of the Activate software update.

Example output

switch(config)$ show activate software-update 

Configuration and Status - Activate Software Update

  Activate Server Address      : device.arubanetworks.com
  Activate Server Polling      : Enabled
  Installed Software Version   : WB.16.04.0000x
  Server Software Version      : Not available - server communication error.
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  Server Software Image URL    : Not available - server communication error.
switch(config)$

Show activate provision

Syntax
show activate provision

Description

Show the configuration and status of the Activate Provision services.

Examples

switch(config)#show activate provision

 Configuration and Status - Activate Provision service
  Activate server address    : device.arubanetworks.com
  Activate server polling    : Enabled
  Activation key             : ABC-XYZ-123
Default status when Activate server polling is not started

switch(config)#show activate provision

 Configuration and Status - Activate Provision Service

  Activate Provision Service   : Enabled
  Activate Server Address      : device.arubanetworks.com
  Activation Key               : Not Available
  NTP/HTP Time Sync Status     : Not Updated
  Activate DNS Lookup          : NA
  Proxy Server DNS Lookup      : NA
  Activate Connection Status   : NA
  Error Reason                 : NA
Connected to Activate (post DNS resolution) and got Central URL

switch(config)#show activate provision
Configuration and Status - Activate Provision Service

  Activate Provision Service   : Enabled
  Activate Server Address      : device.arubanetworks.com
  Activation Key               : ZAELQSRB
  NTP/HTP Time Sync Status     : Time sync from NTP
  Activate DNS Lookup          : Success
  Proxy Server DNS Lookup      : NA
  Activate Connection Status   : Success
  Error Reason                 : NA
Disable the Activate polling, after getting the Central URL

switch(config)#show activate provision

 Configuration and Status - Activate Provision Service

  Activate Provision Service   : Disabled
  Activate Server Address      : device.arubanetworks.com
  Activation Key               : ZAELQSRB
  NTP/HTP Time Sync Status     : Time sync from NTP
  Activate DNS Lookup          : Success
  Proxy Server DNS Lookup      : NA
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  Activate Connection Status   : Success
  Error Reason                 : NA  
Unsuccessful Activate connection when device entry not present in Activate

switch(config)# show activate provision

 Configuration and Status - Activate Provision Service

  Activate Provision Service   : Enabled
  Activate Server Address      : device.arubanetworks.com
  Activation Key               : Not Available
  NTP/HTP Time Sync Status     : Time sync from NTP
  Activate DNS Resolution      : Success
  Proxy Server DNS Lookup      : NA
  Activate Connection Lookup   : Failure
  Error Reason                 : Failed response received. 
  Status code                  : not-authenticated
Activate pushing AirWave parameters to switch

switch(config)#show activate provision

 Configuration and Status - Activate Provision Service

  Activate Provision Service   : Enabled
  Activate Server Address      : device.arubanetworks.com
  Activation Key               : ZAELQSRB
  NTP/HTP Time Sync Status     : Time sync from NTP
  Activate DNS Lookup          : Success
  Proxy Server DNS Lookup      : NA
  Activate Connection Status   : Success
  Error Reason                 : NA 
Unsuccessful Activate connection due to unresolved Activate server address

switch(config)#show activate provision

 Configuration and Status - Activate Provision Service

  Activate Provision Service   : Enabled
  Activate Server Address      : device.arubanetworks.com
  Activation Key               : Not Available
  Time Sync Status             : Time sync from NTP pool
  Activate DNS Lookup          : Failure
  Proxy Server DNS Lookup      : NA
  Activate Connection Status   : NA
  Error Reason                 : NA  

NOTE: DNS resolution is a field in the WebUI (under Dependencies section), it will show DNS
resolution as failure .
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Fields added in 16.07. Status Validation

Time sync status • Time sync from NTP

• Time sync from HTTP

• Time sync from other source

• Not updated

• NA

• Default - Not updated, time is not
updated from NTP and HTTP.

• NA - In this case switch get the
time through SNTP/ CLI/time
server configuration before NTP/
HTTP.

Activate DNS Lookup. • Success

• Failure

• NA

• Default - NA

• Other outputs are based on
device.arubanetworks.com
DNS lookup.

Proxy Server DNS Lookup • Success

• Failure

• NA

• NA - If proxy is not configured.

• Other outputs are based on
proxy lookup.

Activate Connection Status. • Success

• Failure

• NA

Default - NA

Error Reason Default - NA

aruba-central
Syntax
aruba-central {enable | disable | support-mode {enable | disable}}
Description

Configure Aruba Central server support. When enabled, and when a server web address has been obtained using
Aruba Activate, the system will connect to an Aruba Central server. The system will obtain configuration updates
and most local configuration commands will be disabled. This mode is enabled by default.

Enter support mode to enable all configuration commands. Normally, when the system is connected to an Aruba
Central server, the configuration is updated from that server and most local configuration commands are disabled.
Support mode enables those commands for use in troubleshooting problems. Support mode is disabled by
default. When the system is not connected to Aruba Central server, the full command set is enabled for local
configuration.

Restrictions

• Switch communication to Aruba Central is not supported via OOBM.

• Aruba-central is not supported in FIPS switches and it will be disabled by default.

CAUTION: To avoid broadcast storm or loops in your network while configuring ZTP, do not have
redundant links after you complete ZTP and Airwave registration. Authorize the new switch and then
push the Golden Configuration template from Airwave.
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Example

Enable Aruba Central server support

switch(config)# aruba-central enable
Disable Aruba Central server support

switch(config)# aruba-central disable
Enter support mode to enable all CLI configuration commands

switch(config)# aruba-central support-mode enable

This mode will enable all CLI configuration commands, including those normally reserved by the Aruba Central
service. 
Use of this mode may invalidate the configuration provisioned through Aruba Central server.
Continue (y/n)?              

Troubleshooting
You can troubleshoot switches by using the SSH connection and the device logs available in AirWave. For a list of
all RMON message, refer to Event Log Messages Guide of your switch

You can enable the debug logging with the debug ztp command, see debug ztp .

Show aruba-central
Syntax
show aruba-central
Description

Shows Aruba Central server information.

Example

 switch#show aruba-central
 Configuration and Status - Aruba Central

  Server URL              : https://internal.central.arubanetworks.com/ws
  Connected               : Yes
  Mode                    : Managed
  Last Disconnect Time    : NA
  Server DNS Lookup       : Success
  Proxy Server DNS Lookup : NA
  Error Reason            : NA
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Fields added in 16.07. Status Validation

Server DNS Lookup • Success

• Failure

• NA

By default status is NA. Other status
is based on DNS resolution.

Proxy Server DNS Lookup • Success

• Failure

• NA

If proxy is not configured, status will
be NA. Otherwise Status will be set
based on proxy server DNS lookup.

Error Reason Default-NA

Error reason for Aruba Central
Error Reason field is added in the switch firmware as part of Aruba Central Onboarding Feature from 16.07. Error
reason log helps in debugging switch firmware for central connectivity failure.

Preprocessor Directive Mocana Error
Enum

Error Reason

1 CLOUD_TCP_ERR ERR_TCP TCP error. Check the
server reachability.

2 CLOUD_TCP_READ_ERR ERR_TCP_READ_ERR
OR

TCP read error.
Malformed packet
received or the SSL
socket is closed.

3 CLOUD_TCP_READ_TIMEOUT_ERR ERR_TCP_READ_TIM
EOUT

TCP timeout. Server
is taking longer time
to respond. Check
the server
reachability.

4 CLOUD_TLS_ERR ERR_SSL TLS error. Verify if
the device or system
certificate is valid.

5 CLOUD_TLS_CERT_VAL_ERR ERR_SSL_CERT_VAL
IDATION_FAILED

Certificate validation
failed. Verify if it is
correctly installed,
valid, and trusted.

6 CLOUD_TLS_MUTUAL_AUTH_FAIL_ERR ERR_SSL_MUTUAL_A
UTHENTICATION_FA
ILED

TLS mutual
authentication has
failed.

7 CLOUD_TLS_MUTUAL_AUTH_NOT_REQ_ERR ERR_SSL_MUTUAL_A
UTHENTICATION_NO
T_REQUESTED

Client authentication
is not requested by
server.

8 CLOUD_TLS_MUTUAL_AUTH_REQ_IGNORE_ERR ERR_SSL_MUTUAL_A
UTHENTICATION_RE
QUEST_IGNORED

TLS mutual
authentication
request is ignored.

Table Continued
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Preprocessor Directive Mocana Error
Enum

Error Reason

9 CLOUD_TLS_INVALID_SIG_ERR ERR_SSL_INVALID_
SIGNATURE

Unable to verify the
signature on a
certificate.

10 CLOUD_TLS_NO_DATA_RECV_ERR ERR_SSL_NO_DATA_
TO_RECEIVE

No data received
from server. Check
the server
reachability.

11 CLOUD_CERT_ERR ERR_CERT System certificate is
invalid.

12 CLOUD_CERT_EXPIRE_ERR ERR_CERT_EXPIRED System certificate
expired. Contact
Aruba support.

13 CLOUD_INVALID_TIME_ERR ERR_CERT_START_T
IME_VALID_IN_FUT
URE

Wrong system time.

14 CLOUD_TLS_MULTIPLE_CONN ERR_SSL_TOO_MANY
_CONNECTIONS

Too many
connections to
server. Disconnect
the device and
connect back.

15 CLOUD_TLS_NO_CIPHER_MATCH ERR_SSL_NO_CIPHE
R_MATCH

Cipher suites are not
common between
device and server.

16 CLOUD_TLS_UNKNOWN_CA ERR_SSL_UNKNOWN_
CERTIFICATE_AUTH
ORITY

Server certificate is
not issued by a
trusted CA.

17 CLOUD_TLS_NO_SELF_SIGNET_CERT ERR_SSL_NO_SELF_
SIGNED_CERTIFICA
TES

Server presented a
self-signed
certificate. This
certificate is not
supported for mutual
authentication.

18 CLOUD_GENERIC_ERR TLS generic error
(code: -XYZ)

19 CLOUD_HTTP_101_PROT_MISSNG Internal error:
HTTP/1.1 protocol
missing. Contact
Aruba support.

20 CLOUD_HTTP_UPGRADE_MISSNG_IN_RESP Internal error:
Missing Upgrade in
HTTP response.
Contact Aruba
support.

Table Continued
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Preprocessor Directive Mocana Error
Enum

Error Reason

21 CLOUD_HTTP_ACCEPT_KEY_MISSNG_IN_RESP Internal error:
Missing Sec-
WebSocket-Accept
in HTTP response.
Contact Aruba
support.

22 CLOUD_HTTP_MISMATCH_ACCEPT_KEY Internal error:
Mismatch Sec-
WebSocket-Accept
in HTTP response.
Contact Aruba
support.

23 CLOUD_URL_NOT_REACHABLE_VIA_PXY Central server is not
reachable through
proxy.

debug ztp
Syntax
debug ztp
no debug ztp
Description

Enables or disables ZTP debug logging.

Parameters and options
ztp

Zero Touch Provisioning.

no
The no debug ztp command disables ZTP debug logging.

Error Reason log for Activate Provision
Error Reason field is added in the switch firmware as part of Aruba Central Onboarding Feature from 16.07. Error
reason log helps in debugging switch firmware for central connectivity failure.

Following table shows the list of error reasons.

Preprocessor Directive Error Reason

ACTIVATE_RESP_FAIL_CODE Activate provision fails because of invalid response
received from server with status code: %s.

ACTIVATE_CURL_FAIL_CODE Device fails to reach Activate server with error: %s.

ACTIVATE_FAIL_PROV_NO_DEVICE_ENTRY Device is not registered with Activate server.

ACTIVATE_NON_TPM_CODE_MISSING EST provision with activate server fails because of
invalid response received from Activate server.
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Stacking support
The ZTP process for stacked switches with Central is similar to the one for a standalone switch, with the
exception that only the commander in the stack checks in with Central. For switches supported on Central when
stacking is ON, refer to the Aruba Central Switch Configuration Guide.

Fault finder switch events
Fault finder switch events supported by Aruba Central

EVENT_FF_BAD_DRIVER_NIC

EVENT_FF_BAD_XCVR_NIC

EVENT_FF_BAD_CABLE

EVENT_FF_CABLE_LEN_HOPS

EVENT_FF_LOOP_OVER_BAND

EVENT_FF_BCAST_STORM

EVENT_PPMGR_DMM_SET_FULL_WARN

EVENT_PPMGR_DMM_SET_AUTO_WARN

EVENT_FF_LINKFLAP

interface device-type network-device
Syntax
interface <PORT-LIST> device-type network-device

no interface <PORT-LIST> device-type network-device

Description

Configures the type of device and identifies a port connected with a network infrastructure device (such as switch,
AP, router). The switch will not report the client entries on the port to Central.

The no form of this command removes the configuration of type of the device connected to the ports.

Command context
config

Parameters
PORT-LIST

Specifies the port number for the device.

Usage
[no] device-type { network-device }

Example

Switch(config)# interface 2
device-type       Configures the type of device being connected to the port.

switch(config)# interface 2 device-type 
network-device    Marks a port being connected with a network infra 
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                  device (switch / AP / router).

switch(config)# interface 2 device-type network-device

Switch(config)# show running config
; JL074A Configuration Editor; Created on release #KB.16.04.0000x
; Ver #10:9b.7f.bf.bb.ff.7c.59.fc.7b.ff.ff.fc.ff.ff.3f.ef:81     

hostname "Aruba-3810M-48G-PoEP-1-slot"
module 1 type jl074x
module 2 type jl074y
flexible-module A type JL078A
interface 2
   device-type network-device
   exit
interface 3
   device-type network-device
   exit

HTTP Proxy support with ZTP overview
The Aruba switch connects through Public Cloud or infrastructure to access Aruba Activate and Aruba Central.
The switch can use a combination of the Public and Private networks to access Aruba AirWave, and Aruba
ClearPass. In this case, the switch is visible as an Internet asset that can cause data breaching. Routing
connections through the enterprise proxy servers prevents the data breaching.

The ArubaOS-Switch does not set up an HTTP/SSL connection with the public or private server directly. Instead,
the switch sets up a TCP connection with the proxy server.

If the public server is available and reachable through the proxy server, then the switch connection to the
destination server is successful. After establishing the connection, the proxy server behaves as a Network
Address Translation (NAT) device, in which case, the proxy server forwards the received packets to the intended
destinations.

Limitations:

• HTTPS proxy is not supported.

• Authenticating the HTTP proxy is not supported.

• HTTP proxy support is only for IPv4 endpoints.

Configuring ZTP:

When the switch is provisioned for Central or Controller, switch is managed once it is connected to the public
network. In case the user wants to reach the public network through the proxy, then the IP address of the proxy
server must be present in the switch before initiating the Activate or Central connectivity.

In ZTP mode, the proxy IP address can be received using the DHCP option. The ZTP mode works when the
switch is booted with a default configuration. For the switch to connect to public servers through proxy, the proxy
IP must be known through DHCP. The switch requests an IP address from the primary VLAN.

The proxy IP address is received through a vendor-specific DHCP option. The switch parses and uses the proxy
IP address to connect in ZTP mode. Aruba switches reserve suboption -148 under DHCP vendor-specific option
43 for configuring proxy URL.

After the switch is out of ZTP mode, the proxy IP address if configured through CLI takes precedence. Otherwise,
the Aruba OS switch may use the DHCP received proxy IP address for connectivity.

e Proxy Configuration
When configuring the proxy server, the following applications will be taking the proxy route to reach the
destination. You can configure the proxy server as indicated in DHCP or proxy server command.
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• Aruba AirWave

• Aruba Activate

• Firmware download through MNP

• Aruba ClearPass connectivity

• Aruba Central connectivity

• TR69 support

Support for Aruba AirWave

AirWave is used to manage the ArubaOS-Switches and its communication to the switch is over HTTPS. When
AirWave is deployed with Aruba controller, an IPsec tunnel is created between the switch and the controller. All
the communication between the switch and AirWave occurs through the tunnel. In this case, the proxy is
bypassed implicitly.

AirWave establishes ICMP, SNMP, and SSH connections to the switch for switch management. Since AirWave
does not have the visibility for the switch IP address, the ICMP, SNMP, and SSH connections will not be initiated
to the switch. So reverse NAT functionality must be enabled for ensuring these packets reach the switch. If
AirWave must work without proxy, then AirWave IP is bypassed explicitly.

Support for Aruba ClearPass

For downloading a user role from ClearPass, switch initiates HTTPS connection with ClearPass. If the proxy is
configured, proxy server is used to reach ClearPass. When ClearPass is deployed with Aruba controller,
ClearPass must be explicitly exempted from proxy. Add the ClearPass IP address in the exception list of the proxy
as the communication happens through the IPsec tunnel or normally.

Proxy Configuration using windows DHCP server

In the ZTP provisioning, you can push the Proxy server and exception configurations through a Windows DHCP
server using DHCP option 148.

Procedure

1. Add a new DHCP Server role. Navigate to Server Manager > Roles > DHCP sever > domain DHCP Server
> IPv4. In the master pane of the Server Manager window, click IPv4 and select Define Vendor classes.
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2. To get vendor-specific value of a switch, go to switch command prompt and enter show dhcp client
vendor-specific command. Vendor class identifier for the switch (VCI) appears as follows:

Switch# show dhcp client vendor-specific
Vendor Class Id = J9854A 2530-24G-PoE+-2SFP+ Switch
Processing of Vendor Specific Configuration is enabled.

3. Add Displayed name and Description for the New Vendor Class in the ASCII field, add J9854A
2530-24G-PoE+-2SFP+ Switch value exactly obtained from the switch, otherwise the option may not work.
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4. Right-click IPv4 and select Set Predefined Options. Select option class as the newly defined vendor class,
click ADD and enter the following information for Proxy details:

a. Name - Proxy

b. Data Type - String

c. Code - 148

d. Description - Proxy details.
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Now the new vendor class will have new suboption with code 148. Next is to add these vendor class and
suboptions to the scope. To add proxy server details to scope, navigate to Server Manager and select Server
Options in the IPv4 window.

5. Right click server options and select Configure options. Go to Advanced tab, select the vendor class from
the menu as the newly defined class. New suboptions that are added appears.

Check 148 and add Proxy details in string value field, in the format as mentioned:

<http://web-proxy.in.ABCcorp.net:8080> or <http://192.168.50.18:3128>

Check 144 and add configuration filename in string value field (optional).
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6. Click Apply and OK and the proxy option is added in the Server options.

7. Now restart the DHCP service and download new DHCP attributes in the switch, you can check that the proxy
details are correctly downloaded in the switch using the show proxy config command.
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proxy server
Syntax
proxy server <http://<ip-addr/FQDN>:port number>

no proxy server

Description

Configures the URL/IP address to reach the proxy server. Provide the correct proxy port number along with the
URL/IP address. Port number must be in the range of 1024 to 65535. HTTPS proxy server is not supported.

The no form of this command removes the proxy server.

Command context
config

Parameters
url:port number

Specifies the URL address with port number for the proxy server.

Parameters
ip-addr:port number

Specifies the IP address with port number for the proxy server.

Example

switch(config)# proxy server "http://web-proxy.au.abccorp.net:3128"
switch(config)# proxy server "http://192.168.0.6:8080"

proxy exception ip | host
Syntax
proxy exception ip | host {ip-addr/mask-length | hostname} 

no proxy exception ip | host {ip-addr/mask-length | hostname}

Description

Configures an IPv4 address/mask length and URL to the list of IP address and host, which can be reached
without the HTTP proxy server.

The no form of this command removes the proxy exception for the specified entry (IPv4 address/host name).

Command context
config

Parameters
ip-addr/mask-length | hostname

Specifies IPv4 address/mask length and host name.
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Example

switch(config)# proxy exception ip 192.168.0.10/12
switch(config)# proxy exception host "http://web-proxy.au.abdcorp.net:3128"

show proxy config
Syntax
show proxy config

Description

Shows the proxy configuration.

Command context
config

Examples

switch(config)# show proxy config

 Http Proxy Configuration details

  Server URL           : http://web-proxy.au.abccorp.net:3128

 Manually configured exceptions

  No      Exception
  ------- -----------------------------------------
  1       192.168.0.10/12
  2       http://web-proxy.au.abdcorp.net:3128

 Automatically added exceptions

  No      Exception
  ------- -----------------------------------------
        1                            2.0.0.9

NOTE: On configuring IPsec tunnel, Airwave IP is automatically added as an exception in the switch.
The IPsec tunnel is configured directly over the network bypassing the HTTP proxy server.
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File transfer methods
The switches support several methods for transferring files to and from a physically connected device or via the
network, including TFTP, Xmodem, and USB. This chapter explains how to download new switch software, upload
or download switch configuration files and software images, and upload command files for configuring ACLs.

TFTP
TFTP at the switch is allows for extensive use of scripts on various customer environments. Such environs, like
FW, configurations, backups, and restores all use the TFTP network service.

• SSH/SFTP is needed to secure access to network components.

• Users are allowed to re-enable TFTP and make both TFTP and SFTP work in parallel.

• SFTP support for database of DSNOOPv4, v6 and DHCP Server are also available. To provide a secure way
to transfer the database, the SFTP option has been added where the respective database can also be
transferred to a SFTP Server.

Prerequisites
Use of the commands in this section assumes that:

• A software version for the switch has been stored on a TFTP server accessible to the switch. (The software file
is typically available from the Switch Networking website at http://www.hpe.com/networking/support.)

• The switch is properly connected to your network and has already been configured with a compatible IP
address and subnet mask.

• The TFTP server is accessible to the switch via IP.

Before you proceed, complete the following:

• Obtain the IP address of the TFTP server in which the software file has been stored.

• If VLANs are configured on the switch, determine the name of the VLAN in which the TFTP server is operating.

• Determine the name of the software file stored in the TFTP server for the switch (for example, E0820.swi.)

NOTE:

If your TFTP server is a UNIX workstation, ensure that the case (upper or lower) that you specify for
the filename is the same case as the characters in the software filenames on the server.

Downloading switch software
To download a switch software file named K.0800.swi from a TFTP server with the IP address of 10.28.227.103 to
primary flash:

Chapter 13
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Procedure

1. Execute copy tftp flash on page 437 as shown below:

Figure 91: Download command for an OS (switch software)

2. When the switch finishes downloading the software file from the server, it displays this progress message:

3. Validating and Writing System Software to FLASH ...

4. When the download finishes, you must reboot the switch to implement the newly downloaded software image.
To do so, use either boot system flash on page 437 or reload on page 437.

5. To confirm that the software downloaded correctly, execute show system and check the Firmware revision
line.

For information on primary and secondary flash memory and the boot commands, see the basic operation guide.

IMPORTANT: If you use auto-tftp
to download a new image in a redundant management system, the active management module
downloads the new image to both the active and standby modules. Rebooting after the

auto-tftp
process completes reboots the entire system.

copy tftp flash
Syntax
copy tftp flash <IP-ADDRESS>  <REMOTE-FILE> [primary|secondary] [oobm]
        
Automatically downloads a switch software file to primary or secondary flash. If you do not specify the flash
destination, the TFTP download defaults to primary flash.

boot system flash
Syntax
boot system flash [primary|secondary]
Description

Boots from the selected flash.

reload
Syntax
reload
Description
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Boots from the flash image and startup-config file. A switch covered in this guide (with multiple configuration files),
also uses the current startup-config file.

Enabling tftp

Procedure

TFTP defaults to enabled on the switch. If TFTP operation has been disabled, you can re-enable it by specifying
TFTP client or server functionality with the following command.

IMPORTANT: For information on how to configure TFTP file transfers on an IPv6 network, see the
IPv6 configuration guide

.

tftp
Syntax
[no] tftp [client|server] listen [oobm|data|both]
Description

Disables/re-enables TFTP for client or server functionality.

Parameters and options
no

Disables all TFTP client or server operation on the switch except for the auto-TFTP feature. When you disable
TFTP, instances of TFTP in the CLI copy command and the Menu interface "Download OS" screen become
unavailable.

IMPORTANT: The no tftp [client|server] command does not disable auto-TFTP
operation. To disable an auto-TFTP command configured on the switch, use the no auto-
tftp command to remove the command entry from the switch's configuration.

client
Use TFTP client functionality to access TFTP servers in the network to receive downloaded files.

server
Use TFTP server functionality to upload files to other devices on the network.

listen
For switches that have a separate out-of-band management port, the listen parameter in a server
configuration allows you to specify whether transfers take place through the out-of-band management (oobm)
interface, the data interface, or both.

IMPORTANT: Using IP SSH file transfer to enable SCP and SFTP functionality on the switch
disables TFTP client and server functionality. After enabling ip ssh file transfer, you cannot re-
enable TFTP and auto-TFTP from the CLI.

show running-configuration

switch(config)# show running-config

Running configuration:
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; J8693A Configuration Editor; Created on release #K.15.15.0000x
; Ver #04:7f.ff.3f.ef:54
hostname "Switch"
no tftp client
no tftp server

Enable TFTP client

switch(config)# tftp client

ip ssh filetransfer

The command ip ssh filetransfer disables the TFTP Client and TFTP Server, and the user can re-enable
them. The command displays the following message.

ip ssh filetransfer
tftp and auto-tftp have been disabled.

Automatic software download from a TFTP server
The auto-tftp command lets you configure the switch to download software automatically from a TFTP server.

At switch startup, the auto-TFTP feature automatically downloads a specified software image to the switch from a
specified TFTP server and then reboots the switch. To implement the process, you must first reboot the switch
using one of the following methods:

• Enter the boot system flash primary command in the CLI.

• With the default flash boot image set to primary flash (the default), enter the boot or the reload command, or
use the reset button on the switch. (To reset the boot image to primary flash, use boot set-default
flash primary.)

auto-tftp
Syntax
auto-tftp <IP-ADDR> filename
        
Description

Configures the switch to automatically download the specified software file from the TFTP server at the specified
IP address. The file is downloaded into primary flash memory at switch startup, and then the switch automatically
reboots from primary flash. Defaults to disabled.

Parameters and options

no

Disables auto-TFTP operation by deleting the auto-tftp entry from the startup configuration. Does not
affect the current TFTP-enabled configuration on the switch. However, entering the ip ssh filetransfer
command automatically disables both auto-tftp and tftp operation.

Chapter 13 File transfers 439

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4177



IMPORTANT:

To enable auto-TFTP to copy a software image to primary flash memory, the version number of the
downloaded software file (for example, K_14_01.swi) must be different from the version number
currently in the primary flash image.

The current TFTP client status (enabled or disabled) does not affect auto-TFTP operation. (See 
Enabling tftp on page 438.)

Completion of the auto-TFTP process may require several minutes while the switch executes the
TFTP transfer to primary flash and then reboots again.

Downloading to primary flash using TFTP
The menu interface accesses only the primary flash.

Procedure

1. In the console Main Menu, select Download OS to display the screen in Figure 92: Download OS
(software) screen (default values) on page 440. (The term "OS" or "operating system" refers to the switch
software):

Figure 92: Download OS (software) screen (default values)

2. Press [E] (for Edit .)

3. Ensure that the Method field is set to TFTP (the default.)

4. In the TFTP Server field, enter the IP address of the TFTP server in which the software file has been stored.

5. In the Remote File Name field, enter the name of the software file (if you are using a UNIX system,
remember that the filename is case-sensitive.)

6. Press [Enter], then [X] (for eXecute ) to begin the software download.
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7. The screen shown in Figure 93: Download OS (software) screen during a download on page 441
appears:

Figure 93: Download OS (software) screen during a download

8. A "progress" bar indicates the progress of the download. When the entire software file has been received, all
activity on the switch halts and you will see Validating and writing system software to FLASH...

9. After the primary flash memory is updated with the new software, you must reboot the switch to implement
the newly downloaded software. Return to the Main Menu and press [6] (for Reboot Switch .)

10. You will see this prompt:

Continue reboot of system? : No
11. Press the space bar once to change No to Yes, then press [Enter] to begin the reboot.

IMPORTANT:

When you use the menu interface to download a switch software, the new image is always
stored in primary flash. Also, using the

Reboot Switch
command in the Main Menu always reboots the switch from primary flash. Rebooting the switch
from the CLI provides more options. See the

basic operation guide

.

12. After you reboot the switch, confirm that the software downloaded correctly:

a. From the Main Menu, select 2. Switch Configuration..., and then select 2. Port/Trunk Settings

b. Check the Firmware revision line.

Disabling TFTP and auto-TFTP for enhanced security
Disabling TFTP and auto-TFTP
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Using the ip ssh filetransfer command to enable SFTP automatically disables TFTP and auto-TFTP (if
either or both are enabled), as shown in Figure 94: Example of switch configuration with SFTP enabled on
page 442.

Figure 94: Example of switch configuration with SFTP enabled

If you enable SFTP and then later disable it, TFTP and auto-TFTP remain disabled unless they are explicitly re-
enabled.

Operating rules

Prerequisites

To enable SFTP by using an SNMP management application, you must first disable TFTP and, if configured,
auto-TFTP on the switch. You can use either an SNMP application or the CLI to disable TFTP, but you must use
the CLI to disable auto-TFTP. The following CLI commands disable TFTP and auto-TFTP on the switch.

Procedure

1. The TFTP feature is enabled by default, and can be enabled or disabled through the CLI, the Menu interface
(see
Figure 95: Using the Menu interface to disable TFTP on page 443
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), or an SNMP application. Auto-TFTP is disabled by default and must be configured through the CLI.

Figure 95: Using the Menu interface to disable TFTP

2. While SFTP is enabled, TFTP and auto-TFTP cannot be enabled from the CLI. Attempting to enable either
non-secure TFTP option while SFTP is enabled produces one of the following messages in the CLI:

SFTP must be disabled before enabling tftp.
SFTP must be disabled before enabling auto-tftp.
Similarly, while SFTP is enabled, TFTP cannot be enabled using an SNMP management application.
Attempting to do so generates an "inconsistent value" message. (An SNMP management application cannot
be used to enable or disable auto-TFTP.)

Enabling SSH V2 (required for SFTP)

IMPORTANT: As a matter of policy, administrators should not enable the SSH V1-only or the SSH
V1-or-V2 advertisement modes. SSHv1 is supported on only some legacy switches (such as the
Switch Series 2500 switches.)

Any attempts to use SCP or SFTP without using ip ssh filetransfer cause the SCP or SFTP session to
fail. Depending on the client software in use, you will receive an error message on the originating console, for
example:

IP file transfer not enabled on the switch

1. Enter the following command to enable SSH v2:

switch(config)# ip ssh version 2
2. Enter the show ip ssh command to confirm that you have enabled an SSH session:

switch(config)# show ip ssh
3. Enter the ip ssh filetransfer command so that SCP and/or SFTP can run.

4. Open your third-party software client application to being using the SCP or SFTP commands to safely transfer
files or issue commands to the switch.

Chapter 13 File transfers 443

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4181



Disabling secure file transfer

To disable SSH, enter the following command:

switch(config)# no ip ssh filetransfer

Authentication
Switch memory allows up to ten public keys. This means the authentication and encryption keys you use for your
third-party client SCP/SFTP software can differ from the keys you use for the SSH session, even though both
SCP and SFTP use a secure SSH tunnel.

NOTE:

SSH authentication is mutually exclusive with RADIUS servers.

Some clients, such as PSCP (PuTTY SCP), automatically compare switch host keys for you. Other clients require
you to manually copy and paste keys to the $HOME/.ssh/known_hosts file. Whatever SCP/SFTP software tool
you use, after installing the client software you must verify that the switch host keys are available to the client.

Because the third-party software utilities you may use for SCP/SFTP vary, you should refer to the documentation
provided with the utility you select before performing this process.

SCP/SFTP operating notes

• When an SFTP client connects, the switch provides a file system displaying all of its available files and folders.
No file or directory creation is permitted by the user. Files may be only uploaded or downloaded, according to
the permissions mask. All of the necessary files the switch needs are already in place on the switch. You do
not need to (nor can you) create new files.

• The switch supports one SFTP session or one SCP session at a time.

• All files have read-write permission. Several SFTP commands, such as create or remove, are not allowed
and return an error message. The switch displays the following files:

/
+---cfg
|   running-config
|   startup-config
+---log
|   crash-data
|   crash-data-a
|   crash-data-b 
|   crash-data-c 
|   crash-data-d 8212zl only
|   crash-data-e            "      "
|   crash-data-f  ""
|   crash-data-g  8212zl only
|   crash-data-h            "      "
|   crash-data-I  ""
|   crash-data-J  ""
|   crash-data-K  ""
|   crash-data-L  "    "
|   crash-log
|   crash-log-a
|   crash-log-b 
|   crash-log-c 
|   crash-log-d   8212zl only
|   crash-log-e  ""
|   crash-log-f  ""
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|   crash-log-g  8212zl only
|   crash-log-h  " "
|   crash-log-I  " "
|   crash-log-J  " "
|   crash-log-K  " "
|   crash-log-L  " "
|   event log
+---os
|   primary
|   secondary
\---ssh
    +---mgr_keys
    |   authorized_keys
    \---oper_keys
    |   authorized_keys
\---core   (this directory is not available on the 8212zl)
|   mm1.cor      management module or management function
|   im_a.cor     interface module (chassis switches only)
|   im_b.cor     interface module (chassis switches only)
|   im_1.cor     interface module (chassis switches only)
|   port_1-24.cor          core-dump for ports 1-24 (stackable switches only)
|   port_25-48.cor         core-dump for ports 25-48 (stackable switches only)

• When using SFTP to copy a software image onto the switch, the command return takes only a few seconds.
However, this does not mean that the transfer is complete, because the switch requires additional time
(typically more than one minute) to write the image to flash in the background. To verify the file transfer has
been completed, you can use the show flash command or look for a confirmation message in the log, as in
the following example:

I 01/09/09 16:17:07 00150 update: Primary Image updated.

Troubleshooting SSH, SFTP, and SCP operations

Cause

NOTE:

You can verify secure file transfer operations by checking the switch's event log, or by viewing the
error messages sent by the switch that most SCP and SFTP clients print out on their console.

Messages that are sent by the switch to the client depend on the client software in use to display
them on the user console.

Broken SSH connection

Symptom

Any of the following types of error messages are logged, according to the type of session that is running (SSH,
SCP, or SFTP):

ssh: read error Bad file number, session aborted I 01/01/90
00:06:11 00636 ssh: sftp session from ::ffff:10.0.12.35 W
01/01/90 00:06:26 00641 ssh:

sftp read error Bad file number, session aborted I 01/01/90
00:09:54 00637 ssh: scp session from ::ffff:10.0.12.35 W 01/01/90

ssh: scp read error Bad file number, session aborted
The Bad file number is from the system error value and may differ depending on the cause of the failure. In the
third example, the device file to read was closed as the device read was about to occur.
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Cause

If an ssh connection is broken at the wrong moment (for instance, the link goes away or spanning tree brings
down the link), a fatal exception occurs on the switch. If this happens, the switch gracefully exits the session and
produces an Event Log message indicating the cause of failure.

Attempt to start a session during a flash write

Symptom

With some client software, an error message similar to this appears on the client console:

Received disconnect from 10.0.12.31: 2: Flash access in progress
lost connection

Cause

If you attempt to start an SCP (or SFTP) session while a flash write is in progress, the switch does not allow the
SCP or SFTP session to start.

Action

Wait a few seconds for the flash writing to finish and then try again.

Failure to exit from a previous session
Symptom

Received disconnect from 10.0.12.31: 2: Wait for previous
session to complete

lost connection
Cause

The error message might appear on the client console if a new SCP (or SFTP) session is started from a client
before the previous client session has been closed (the switch requires approximately ten seconds to timeout the
previous session).

Action

Attempt to start a second session
Symptom

Received disconnect from 10.0.12.31: 2: Other SCP/SFTP
session running

lost connection
Cause

The switch supports only one SFTP session or one SCP session at a time. If a second session is initiated (for
example, an SFTP session is running and then an SCP session is attempted), the error message might appear on
the client console.

Action

Use USB to transfer files to and from the switch
The switch's USB port (labeled as Aux Port) allows the use of a USB flash drive for copying configuration files to
and from the switch.
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Operating rules and restrictions:

• Unformatted USB flash drives must first be formatted on a PC (Windows FAT format.) For devices with multiple
partitions, only the first partition is supported. Devices with secure partitions are not supported.

• If they already exist on the device, subdirectories are supported. When specifying a filename , you must enter
either the individual file name (if at the root) or the full path name (for example, /subdir/filename.)

• To view the contents of a USB flash drive, use the dir command. This lists all files and directories at the root.
To view the contents of a directory, you must specify the subdirectory name (that is, dir subdirectory.)

• The USB port supports a single USB device. USB hubs to add more ports are not supported.

NOTE: Some USB flash drives may not be supported on your switch. Consult the latest Release
Notes for information on supported devices.

SCP and SFTP

Enabling SCP and SFTP

Procedure

1. Open an SSH session as you normally would to establish a secure encrypted tunnel between your computer
and the switch. Please note that this is a one-time procedure for new switches or connections. If you have
already done it once you should not need to do it a second time.

2. For more detailed directions on how to open an SSH session, see the access security guide.

3. To enable secure file transfer on the switch (once you have an SSH session established between the switch
and your computer), open a terminal window and enter the following command:

switch(config)# ip ssh filetransfer

Using SCP and SFTP

IMPORTANT:

Using IP SSH file transfer to enable SCP and SFTP functionality on the switch disables TFTP client
and server functionality. After enabling

ip ssh
file transfer, you cannot re-enable TFTP and auto-TFTP from the CLI.

The general process for using SCP and SFTP involves three steps:

Procedure

1. Open an SSH tunnel between your computer and the switch if you have not already done so.

2. (This step assumes that you have already set up SSH on the switch.)

3. Execute ip ssh filetransfer to enable secure file transfer.

4. Use a third-party client application for SCP and SFTP commands.

For some situations you may want to use a secure method to issue commands or copy files to the switch. By
opening a secure, encrypted SSH session and enabling ip ssh file transfer, you can then use a third-party
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software application to take advantage of SCP and SFTP. SCP and SFTP provide a secure alternative to TFTP
for transferring information that may be sensitive (like switch configuration files) to and from the switch.
Essentially, you are creating a secure SSH tunnel as a way to transfer files with SFTP and SCP channels.

Once you have configured your switch to enable secure file transfers with SCP and SFTP, files can be copied to
or from the switch in a secure (encrypted) environment and TFTP is no longer necessary.

To use these commands, you must install on the administrator workstation a third-party application software client
that supports the SFTP and/or SCP functions. Some examples of software that supports SFTP and SCP are
PuTTY, Open SSH, WinSCP, and SSH Secure Shell. Most of these are freeware and may be downloaded without
cost or licensing from the internet. There are differences in the way these clients work, so be sure you also
download the documentation.

As described earlier in this chapter you can use a TFTP client on the administrator workstation to update software
images. This is a plain-text mechanism that connects to a standalone TFTP server or another switch acting as a
TFTP server to obtain the software image files. Using SCP and SFTP allows you to maintain your switches with
greater security. You can also roll out new software images with automated scripts that make it easier to upgrade
multiple switches simultaneously and securely.

SFTP is unrelated to FTP, although there are some functional similarities. Once you set up an SFTP session
through an SSH tunnel, some of the commands are the same as FTP commands. Certain commands are not
allowed by the SFTP server on the switch, such as those that create files or folders. If you try to issue commands
such as create or remove using SFTP, the switch server returns an error message.

You can use SFTP just as you would TFTP to transfer files to and from the switch, but with SFTP, your file
transfers are encrypted and require authentication, so they are more secure than they would be using TFTP.
SFTP works only with SSH version 2 (SSH v2.)

NOTE:

SFTP over SSH version 1 (SSH v1) is not supported. A request from either the client or the switch
(or both) using SSH v1 generates an error message. The actual text of the error message differs,
depending on the client software in use. Some examples are:

Protocol major versions differ: 2 vs. 1
Connection closed

Protocol major versions differ: 1 vs. 2
Connection closed

Received disconnect from  ip-addr : /usr/local/libexec/
sftp-server: command not supported
Connection closed

SCP is an implementation of the BSD rcp (Berkeley UNIX remote copy) command tunneled through an SSH
connection.

SCP is used to copy files to and from the switch when security is required. SCP works with both SSH v1 and SSH
v2. Be aware that the most third-party software application clients that support SCP use SSHv1.

Xmodem

Downloading software using Xmodem

448 Aruba 3810 / 5400R Management and Configuration Guide for
ArubaOS-Switch 16.08

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4186



Prerequisites

Procedure

1. Connect the switch via the Console RS-232 port to a PC operating as a terminal. (For information on
connecting a PC as a terminal and running the switch console interface, see the
installation and getting started guide

you received with the switch.)

2. Verify that the switch software is stored on a disk drive in the PC.

3. Verify that the terminal emulator you are using includes the Xmodem binary transfer feature. (For example, in
the HyperTerminal application included with Windows NT, you would use the
Send File

option in the

Transfer

drop-down menu.)

Downloading to Flash
The following procedure downloads a switch software file named E0822.swi from a PC (running a terminal
emulator program such as HyperTerminal) to primary flash.

Procedure

1. Execute the following command in the CLI:

2. Execute the terminal emulator commands to begin the Xmodem transfer. For example, using HyperTerminal:

a. Click on Transfer, then Send File.

b. Type the file path and name in the Filename field.

c. In the Protocol field, select Xmodem.

d. Click on the [Send] button. The download can take several minutes, depending on the baud rate used in
the transfer.

3. When the download finishes, you must reboot the switch to implement the newly downloaded software.

4. Use either boot system flash on page 449 or reload on page 450 commands.

5. To confirm that the software downloaded correctly:

Switch# show system
6. Check the Firmware revision line. It should show the software version that you downloaded in the preceding

steps.

boot system flash
Syntax
boot system flash [primary|secondary]
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Description

Reboots from the selected flash

reload
Syntax
reload
Description

Reboots from the flash image currently in use

copy xmodem flash
Syntax
copy xmodem flash [primary|secondary]
Description

Downloads a software file to primary or secondary flash. If you do not specify the flash destination, the Xmodem
download defaults to primary flash.

Downloading to primary flash using Xmodem (Menu)
The menu interface accesses only the primary flash.

Procedure

1. From the console Main Menu, select 7. Download OS

2. Press [E] (for Edit) on the keyboard.

3. Use the Space bar to select XMODEM in the Method field.

4. Press [Enter], then [X] (for eXecute) to begin the software download.

5. The following message appears:

6. Press enter and then initiate Xmodem transfer from the attached computer.....

7. Press [Enter] and then execute the terminal emulator commands to begin Xmodem binary transfer.

8. For example, using HyperTerminal:

a. Click on Transfer, then Send File.

b. Enter the file path and name in the Filename field.

c. In the Protocol field, select Xmodem.

d. Click on the [Send] button.

9. The download then commences. It can take several minutes, depending on the baud rate set in the switch
and in your terminal emulator.

10. After the primary flash memory has been updated with the new software, you must reboot the switch to
implement the newly downloaded software. Return to the Main Menu and press [6] (for Reboot Switch.) You
then see the following prompt:

11. Continue reboot of system? : No

12. Press the space bar once to change No to Yes, then press [Enter] to begin the reboot.

13. To confirm that the software downloaded correctly:
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a. From the Main Menu, select 1. Status and Counters, and the select 1. General System Information

b. Check the Firmware revision line.

USB

Downloading switch software using USB

Enable or disable the USB port
This feature allows configuration of the USB port using either the CLI or SNMP.

Prerequisites

Procedure

1. Store a software version for the switch on a USB flash drive. (The latest software file is typically available from
the Switch Networking website at http://www.hpe.com/networking/support.)

2. Insert the USB device into the switch's USB port.

3. Determine the name of the software file stored on the USB flash drive (for example, K.0800.swi).

4. Decide whether the image will be installed in the primary or secondary flash.

USB port status

show usb-port

Syntax
show usb-port

Description

Displays the status of the USB port. It can be enabled, disabled, or not present.

Command context
operator

Usage

One of the following messages indicates the presence or absence of a USB device:

• Not able to sense device in USB port
• USB device detected in port
• no USB device detected in port

Example

Display USB port status.
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switch# show usb-port

  USB port status: enabled
  USB port power status: power on    (USB device detected in port)

Copy a switch software file named K.0800.swi from a USB device to primary flash.

Procedure

1. Issue the copy usb flash command as shown below:

Figure 96: The command to copy switch software from USB

2. When the switch finishes copying the software file from the USB device, it displays this progress message:
Validating and Writing System Software to the Filesystem....

3. When the save finishes, you must reboot the switch to load the newly loaded software.

4. To confirm that the software downloaded correctly, execute show system and check the Software revision
line.

copy usb flash
Syntax
copy usb flash <FILENAME> [primary|secondary]
Description

This command automatically downloads a switch software file to primary or secondary flash. If you do not specify
the flash destination, the USB download defaults to primary flash.

Switch to Switch

Switch-to-switch download
You can use TFTP to transfer a software image between two switches of the same series. The CLI enables all
combinations of flash location options. The menu interface enables you to transfer primary-to-primary or
secondary-to-primary.

OS download from another switch
Where two switches in your network belong to the same series, you can download a software image between
them by initiating a copy tftp command from the destination switch. The options for this CLI feature include:

• Copy from primary flash in the source to either primary or secondary in the destination.

• Copy from either primary or secondary flash in the source to either primary or secondary flash in the
destination.
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copy tftp flash
Syntax
copy tftp flash <IP-ADDR>  flash [primary|secondary][oobm]
        
Description

When executed in the destination switch, downloads the software flash in the source switch's primary flash to
either the primary or secondary flash in the destination switch.

Parameters and options
primary

If you do not specify either a primary or secondary flash location for the destination, the download
automatically goes to primary flash.

secondary
If you do not specify either a primary or secondary flash location for the destination, the download
automatically goes to primary flash.

oobm
For switches that have a separate OOBM port, the oobm parameter specifies that the TFTP traffic must come
in through the OOBM interface. If this parameter is not specified, the TFTP traffic comes in through the data
interface. The oobm parameter is not available on switches that do not have a separate OOBM port.

Download from primary flash

To download a software file from primary flash in a switch with an IP address of 10.29.227.103 to the primary flash
in the destination switch, you would execute the following command in the destination switch's CLI:

Figure 97: Switch-to-switch, from primary in source to either flash in destination

copy tftp flash os
Syntax
copy tftp flash <IP-ADDR>  [/os/primary|/os/secondary][primary|secondary] [oobm]
        
Description

This command (executed in the destination switch) gives you the most options for downloading between switches.
If you do not specify either a primary or secondary flash location for the destination, the download automatically
goes to primary flash.

Parameters and options
oobm

For switches that have a separate out-of-band management port, the oobm parameter specifies that the TFTP
traffic must come in through the out-of-band management interface. If this parameter is not specified, the
TFTP traffic comes in through the data interface. The oobm parameter is not available on switches that do not
have a separate out-of-band management port.
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Switch-to-switch, from either flash in source to either flash in destination

To download a software file from secondary flash in a switch with an IP address of 10.28.227.103 to the
secondary flash in a destination switch, you would execute the following command in the destination switch's CLI:

switch# copy tftp flash 10.29.227.13 flash /os/secondary secondary
Device will be rebooted, do you want to continue [y/n]? y
00184K

Copying

Software images

copy flash tftp
Syntax
copy flash tftp <IP-ADDR> <FILENAME> [oobm]
        
Description

Copies the primary flash image to a TFTP server.

Parameters and options
oobm

For switches that have a separate OOBM port, the oobm parameter specifies that the transfer is through the
OOBM interface. If this parameter is not specified, the transfer is through the data interface.

The oobm parameter is not available on switches that do not have a separate OOBM port.

Copy primary flash to TFTP

To copy the primary flash to a TFTP server having an IP address of 10.28.227.105:

switch# copy flash tftp 10.28.227.105 K.0800.swi
where K.0800.swi is the filename given to the flash image being copied.

copy flash xmodem
Syntax
copy flash xmodem [pc|unix]
Description

Uses Xmodem to copy a designated configuration file from the switch to a PC or UNIX workstation.To use this
method, the switch must be connected via the serial port to a PC or UNIX workstation.

Copy primary flash

To copy the primary flash image to a serially connected PC, execute the copy xmodem flash command:

switch# copy xmodem flash
Press 'Enter' and start XMODEM on your host...
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At the prompt, press Enter on the keyboard, and then execute the terminal emulator commands to begin the file
transfer.

Copying using USB
To copy the primary image to a USB flash drive:

Procedure

1. Insert a USB device into the switch's USB port.

2. Execute the command: switch# copy flash usb K.0800.swi primary/secondary where K.
0800.swi is the name given to the primary flash image that is copied from the switch to the USB device.

copy flash usb
Syntax
copy flash usb <FILENAME>
        
Description

Uses the USB port to copy the specified flash image from the switch to a USB flash memory device. The default
setting will use the primary image.

Copying diagnostic data to a remote host, USB device, PC, or UNIX
workstation

copy command-output
Syntax
copy command-output <CLI-COMMAND> tftp <IP-ADDRESS> <FILEPATH-FILENAME> [oobm]
        
copy command-output <CLI-COMMAND> usb <FILENAME>
        
copy command-output <CLI-COMMAND> xmodem
        
Description

These commands direct the displayed output of a CLI command to a remote host, attached USB device, or to a
serially connected PC or UNIX workstation.

For switches that have a separate OOBM port, the oobm parameter specifies that the transfer is through the
OOBM interface. If this parameter is not specified, the transfer is through the data interface. The oobm parameter
is not available on switches that do not have a separate OOBM port.

Use Xmodem to copy the output of show config

The command you specify must be enclosed in double quotation marks.

Figure 98: Sending command output to a file on an attached PC
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copy command-log
Syntax
copy command-log [sftp | smm | tftp | usb | xmodem]
Description

This command copies the Command Log content to a remote host or to a serially-connected PC or UNIX
workstation.

• Use the sftp option to copy data to an SFTP server.

• Use the smm option to copy AMM and SMM log events.

• Use the tftp option to copy data to a TFTP server.

• Use the usb option to copy data to a USB flash drive.

• Use the xmodem option to copy data to the console using XMODEM.

copy event-log
Syntax
copy event-log [smm] [tftp <IP-ADDRESS> <FILEPATH_FILENAME> [oobm]] [usb <FILENAME>] [xmodem <FILENAME>]
        

Description

These commands copy the Event Log content to a remote host, attached USB device, or to a serially connected
PC or UNIX workstation.

Parameters and options
smm

Copies the entire Event Log, both active management module events and standby management module
events, to the selected host, USB device, or serially connected PC or UNIX workstation.

oobm
For switches that have a separate OOBM port, the oobm parameter specifies that the transfer is through the
OOBM interface. If this parameter is not specified, the transfer is through the data interface. The oobm
parameter is not available on switches that do not have a separate OOBM port.

Copy the event log to a PC connected to the switch

Figure 99: Sending event log content to a file on an attached PC
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copy crash-data
Syntax
copy crash-data [<SLOT-ID>|master] tftp <IP-ADDRESS> <FILENAME> [oobm]
        
copy crash-data [<SLOT-ID>|mm] usb <FILENAME>
        
copy crash-data [<SLOT-ID>|mm] xmodem
        
Description

These commands copy the crash data content to a remote host, attached USB device, or to a serially connected
PC or UNIX workstation using TFTP, USB, or Xmodem. You can copy individual slot information or the
management module’s switch information. If you do not specify either, the command defaults to the management
function’s data. You can copy individual slot information or the management module (mm) switch information. If
you do not specify either, the command defaults to the mm data.

Parameters and options
<SLOT-ID>

a - h—Retrieves the crash log or crash data from the processor on the module in the specified slot

mm
Retrieves crash log or crash data from the switch's chassis processor. When "mm" is specified, crash files
from both management modules are copied.

oobm
For switches that have a separate OOBM port, specifies that the transfer is through the OOBM interface.
(Default is transfer through the data interface.)

Copy crash data file to a PC

Figure 100: Copying switch crash data content to a PC

copy crash-data (redundant management)
Syntax
copy crash-data [<SLOT-ID>|mm] tftp <IP-ADDRESS> <FILENAME> [oobm]
        
Description

Copies the crash data of both the active and standby management modules to a user-specified file. With no
parameter specified, concatenates files from all modules (management and interface).

Parameters and options
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<SLOT-ID>
Retrieves the crash log or crash data from the module in the specified slot

mm
Retrieves the crash data from both management modules and concatenates them.

oobm
For switches that have a separate OOBM port, specifies that the transfer is through the OOBM interface.
(Default is transfer through the data interface.)

copy crash-log
Syntax
copy crash-log [<SLOT-ID>|mm] tftp <IP-ADDRESS> <FILEPATH\FILENAME> [oobm]
      
copy crash-log [<SLOT-ID>|mm] usb <FILENAME>
      
copy crash-log [<SLOT-ID>|mm] xmodem
      
Description

Copies the crash log content to a remote host, attached USB device, or to a serially connected PC or UNIX
workstation. You can copy individual slot information or the management module (mm) switch information. If you
do not specify either mm or oobm, the command defaults to mm data.

Parameters and options
<SLOT-ID>

a - h—Retrieves the crash log from the processor on the module in the specified slot.

mm
Retrieves the crash log from the switch's chassis processor. With mm specified, copies crash files from both
management modules.

oobm
For switches that have a separate OOBM port, specifies that the transfer is through the OOBM interface.
(Default is transfer through the data interface.)

Copy the crash log for slot C to a file in a PC connected to the switch

Figure 101: Sending a crash log for slot C to a file on an attached PC

copy crash-log (redundant management)
Syntax
copy crash-log [<SLOT-ID>|mm] tftp <IP-ADDRESS> <FILENAME> [oobm]
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Description

Copies the crash logs of both the active and standby management modules to a user-specified file. If no
parameter is specified, files from all modules (management and interface) are concatenated.

Parameters and options
<SLOT-ID>

Retrieves the crash log or crash log from the module in the specified slot.

mm
Retrieves the crash data from both management modules and concatenates them.

oobm
For switches with a separate OOBM port, specifies that the transfer is through the OOBM interface. (Default is
transfer through the data interface.)

copy core-dump (standby module)
Syntax
copy core-dump [mm usb <FILENAME>|standby flash|usb <FILENAME>]
Description

Copies the management module coredump, or the standby management module coredump, to the active
management module flash or to a USB flash drive, (see Figure 102: Copying the standby coredump to flash
on page 459.) During the copy, the system displays the number of bytes transferred and the percentage of the
total. Management module core files can be quite large. Use Cntl-C to cancel the transfer.

Make sure that the coredump files on the standby management module are accessible for diagnostic purposes.

Parameters and options
flash

Copies the core file of the standby management module to the flash of the active management module. The
destination file is fixed as dumpM1.cor or dumpM2.cor, depending on which module is the standby
management module.

usb <FILENAME>
Copies the management module's core file or the standby management module's core file to a USB flash
drive. The optional filename defaults to dumpM1.cor or dumpM2.cor, depending on which module is the
standby management module.

Copy the standby coredump to flash

Figure 102: Copying the standby coredump to flash

If there is no coredump on the standby management module, the following error message displays:

Standby MM coredump does not exist.
If there is not enough destination space before or during the transfer to flash or USB, the following error message
displays:

Insufficient FLASH space to complete the file copy.
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copy fdr-log
Syntax
copy fdr-log [slot <SLOT-LIST>|mm-active [current|previous]|mm-standby|all] tftp
[<HOSTNAME>|<IP-ADDR>] <FILENAME>
Description

Copies fdr-log files to a user-specified file. The FDR log collects information when the switch is not performing
correctly, but has not crashed. Writes runtime logs to FDR memory while the switch is running. Crashtime logs are
collected and stored in the FDR buffer during a switch crash.

Parameters and options
all

Copies all the log files from both management modules and all slots.

mn-active
Copies the active management module's log.

mn-standby
Copies the standby management module's log.

slot
Retrieves the crash log from the module in the identified slots.

Copy diagnostic data to a remote host, USB device, PC or UNIX
workstation
You can use the CLI to copy the following types of switch data to a text file on a destination device:

Command output

Sends the output of a switch CLI command as a file on the destination device.

Event log

Copies the switch's Event Log into a file on the destination device.

Crash data

Software-specific data useful for determining the reason for a system crash.

Crash log

Processor-specific operating data useful for determining the reason for a system crash.

Flight data recorder (FDR) logs

Information that is “interesting” at the time of the crash, as well as when the switch is not performing correctly
but has not crashed.

The destination device and copy method options include:

• Remote Host using TFTP.

• Physically connected USB flash drive using the USB port on the switch.

• Serially connected PC or UNIX workstation using Xmodem.

Transferring
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Switch configuration transfer
Using CLI commands you can copy switch configurations to and from a switch, or copy a software image to
configure or replace an ACL in the switch configuration.

For greater security, you can perform all TFTP operations using SFTP.

You can also use the include-credentials command to save passwords, secret keys, and other security
credentials in the running config file.

TFTP
copy [startup-config|running-config]
Syntax
copy [startup-config|running-config] tftp <IP-ADDR> <REMOTE-FILE> [pc|unix][oobm]
      
copy config  <FILENAME>  tftp  IP-ADDR <REMOTE-FILE> [pc|unix][oobm]
      
Description

Copy a designated config file in the switch to a TFTP server. For more information, see the basic operation guide.

Parameters and options

oobm

For switches that have a separate OOBM port, the oobm parameter specifies that the transfer is through the
OOBM interface. If this parameter is not specified, the transfer is through the data interface.

The oobm parameter is not available on switches that do not have a separate OOBM port.

Upload current startup configuration

To upload the current startup configuration to a file named sw8200 in the configs directory on drive "d" in a TFTP
server having an IP address of 10.28.227.105:

ProCurve# copy startup-config tftp 10.28.227.105
   d:\configs\sw8200

copy tftp
Syntax
copy tftp [startup-config|running-config] tftp <IP-ADDR> <REMOTE-FILE> [pc|unix][oobm]
      
copy tftp config <FILENAME> <IP-ADDR> <REMOTE-FILE> [pc|unix][oobm]
      
Description

Copies a configuration from a remote host to a designated config file in the switch.

Parameters and options
oobm

For switches that have a separate OOBM port, the oobm parameter specifies that the transfer is through the
OOBM interface. If this parameter is not specified, the transfer is through the data interface.

The oobm parameter is not available on switches that do not have a separate OOBM port.
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Download a configuration file

To download a configuration file named sw8200 in the configs directory on drive "d" in a remote host having an
IP address of 10.28.227.105:

switch# copy tftp startup-config 10.28.227.105
   d:\configs\sw8200

copy tftp show-tech
IMPORTANT:

Exit the global config mode (if needed) before executing show tech commands.

Syntax
copy tftp show-tech ipv4 or ipv6 address <filename> [oobm]
Copies a customized command file to the switch. Using the copy tftp command with the show-tech option
provides the ability to copy a customized command file to the switch.

Parameters and options
show-tech

Allows you to copy a customized command file to the switch.

oobm
For switches that have a separate OOBM port, the oobm parameter specifies that the transfer is through the
out-of-band management interface. If this parameter is not specified, the transfer is through the data interface.
The oobm parameter is not available on switches that do not have a separate OOBM port.

Upload a customized command file

switch(config)# copy tftp show-tech 10.10.10.3 commandfile1

show tech custom
Syntax
show tech custom
Description

Executes the commands found in a custom file instead of the hard-coded list. If no custom file is found, executes
the current hard-coded list. This list contains commands to display data, such as the image stamp, running
configuration, boot history, port settings, and so on. You can include show tech commands in the custom file,
with the exception of show tech custom. For example, you can include the command show tech all.

No show-tech file found

If no custom file is found, a message displays stating "No SHOW-TECH file found." (No custom file was uploaded
with the copy tftp show-tech command.)

switch# show tech custom
No SHOW-TECH file found.
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copy tftp config
Syntax
copy tftp config <SOURCE CONFIG FILE NAME> <DESTINATION_IP-ADDRESS>
           <DESTINATION CONFIG FILE> [detail|oobm|pc|unix]
        
Description

Displays the progress, in lines and percentages, of the configuration file copied to or from the switch. A large
configuration file takes several minutes to transfer. This feature allows the customer to watch the progress.

Parameters and options
detail

Display copy progress.

oobm
Use the OOBM interface to reach TFTP server.

pc
Change CR/LF to PC style.

unix
Change CR/LF to unix style

copy tftp config

Switch# copy tftp config myConfig 10.100.0.12 myConfig.cfg oobm detail
Processing line 4968 of 20740 (23%)

Xmodem

Prerequisites

• Connect the switch to a PC or UNIX workstation using the serial port

• Determine the filename.

• Know the directory path you will use to store the configuration file.

copy config xmodem
Syntax
copy [startup-config|running-config] xmodem [pc|unix][oobm]
copy config <FILENAME> xmodem [pc|unix]
      
Description

Uses xmodem to copy a designated configuration file from the switch to a PC or UNIX workstation.

Copy a configuration file to a PC

switch# copy startup-config xmodem pc
Press 'Enter' and start XMODEM on your host...
Execute the terminal emulator commands to begin the file transfer.
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copy xmodem startup-config
Syntax
copy xmodem startup-config [pc|unix]
copy xmodem config <FILENAME> [pc|unix]
      
Description

Copies a configuration file from a serially connected PC or UNIX workstation to a designated configuration file on
the switch.

IMPORTANT:

When the download finishes, you must reboot the switch to implement the newly downloaded
software (see boot system flash on page 464 and reload on page 464).

Copy a configuration file from a PC

switch# copy xmodem startup-config pc
Device will be rebooted, do you want to continue [y/n]? y
Press 'Enter' and start XMODEM on your host...
Execute the terminal emulator commands to begin the file transfer.

boot system flash
Syntax
boot system flash [primary|secondary]
boot system flash [config <FILENAME>]
        
Description

Used to boot switches from the designated configuration file.

reload
Syntax

reload
Description

Reboots from the flash image currently in use.

USB
Be sure to connect a USB flash memory device to the USB port on the switch.

copy startup-config
Syntax
copy startup-config usb <FILENAME>
copy running-config usb <FILENAME>
Description

Copies the startup configuration or the running configuration to a USB flash drive.
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copy startup-config

switch# copy startup-config usb Switch-config
Switch-config is the name given to the configuration file that you copy from the switch to the USB device.

copy usb startup-config
Syntax
copy usb startup-config <FILENAME>
Description

Copies a configuration file from a USB device to the startup configuration file on the switch. To execute the
command, you must know the name of the file to copy.

copy usb startup-config

switch# copy usb startup-config Switch-config

ACL command file transfer
This section describes how to upload and execute a command file to the switch for configuring or replacing an
ACL in the switch configuration. Such files should contain only access control entry (ACE) commands.

tftp
copy tftp command-file
Syntax
copy tftp command-file <IP-ADDR> <FILENAME.TXT> [unix|pc][oobm]
        
Description

Copies and executes the named text file from the specified TFTP server address and executes the ACL
commands in the file. Depending on the ACL commands used, this action does one of the following in the
running-config file:

• Creates a new ACL.

• Replaces an existing ACL.

• Adds to an existing ACL.

Parameters and options
<IP-ADDR>

The IP address of a TFTP server available to the switch.

<FILENAME.TXT>

A text file containing ACL commands and stored in the TFTP directory of the server identified by <IP-
ADDR> .

unix|pc
The type of workstation used for serial, Telnet, or SSH access to the switch CLI.
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oobm
For switches that have a separate out-of-band management port, specifies that the transfer will be through the
out-of-band management interface. (Default is transfer through the data interface.)

Upload an ACL command file from a PC

switch(config)# copy tftp command-file 18.38.124.16
vlan10_in.txt pc
The switch displays this message:

Running configuration may change, do you want to continue
[y/n]?
If the switch detects an illegal (non-ACL) command in the file, it bypasses the illegal command, displays a notice
(as shown in Figure 103: Using the copy command to download and configure an ACL on page 466), and
continues to implement the remaining ACL commands in the file.

Figure 103: Using the copy command to download and configure an ACL

Xmodem
copy xmodem command-file
Syntax
copy xmodem command-file [unix|pc]
Description

Uses Xmodem to copy and execute an ACL command from a PC or UNIX workstation. Depending on the ACL
commands used, this action does one of the following in the running-config file:
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• Creates a new ACL.

• Replaces an existing ACL.

• Adds to an existing ACL.

USB
copy usb command-file
Syntax
copy usb command-file <FILENAME.TXT> [unix|pc]
      
Description

Copies and executes the named text file from a USB flash drive and executes the ACL commands in the file.
Depending on the ACL commands used, this action does one of the following in the running-config file:

• Creates a new ACL.

• Replaces an existing ACL.

• Adds to an existing ACL.

Parameters
<FILENAME.TXT>

A text file containing ACL commands and stored in the USB flash drive.

unix|pc
The type of workstation used to create the text file.

Upload an ACL command file from USB

Using a PC workstation, execute the following from the CLI to upload the file to the switch and implement the ACL
commands it contains:

switch(config)# copy usb command-file vlan10_in.txt pc
The switch displays this message:

Running configuration may change, do you want to continue
[y/n]?
If the switch detects an illegal (non-ACL) command in the file, it bypasses the illegal command, displays a notice,
and continues to implement the remaining ACL commands in the file.

Switch software download
The terms switch software and software image refer to the downloadable software files the switch uses to
operate its networking features. Other terms sometimes include Operating System, or OS.

Switch periodically provides switch software updates through the Switch Networking website. For more
information, see the support and warranty booklet shipped with the switch, or visit http://www.hpe.Com/
Networking/Support.
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Switch software download rules
Downloading new switch software does not change the current switch configuration. The switch configuration is
contained in separate files that can also be transferred. See copy [startup-config|running-config] on page 461.

In most cases, if a power failure or other cause interrupts a flash image download, the switch reboots with the
image previously stored in primary flash. In the unlikely event that the primary image is corrupted (which may
occur if a download is interrupted by a power failure), the switch goes into boot ROM mode. In this case, use the
boot ROM console to download a new image to primary flash.

• Switch software that you download using the menu interface always goes to primary flash.

• After a software download, reboot the switch to implement the new software. Until a reboot occurs, the switch
continues to run on the software it was using before the download.

TFTP download failures

Symptom

When using the menu interface, if a TFTP download fails, the Download OS (Operating System, or software)
screen indicates the failure.

Figure 104: Example of message for download failure

Cause

Some of the causes of download failures include:

• Incorrect or unreachable address specified for the TFTP Server parameter. This may include network
problems.

• Incorrect VLAN.

• Incorrect name specified for the Remote File Name parameter, or the specified file cannot be found on the
TFTP server. This can also occur if the TFTP server is a UNIX machine and the case (upper or lower) for the
filename on the server does not match the case for the filename entered for the Remote File Name parameter
in the Download OS (Operating System, or software) screen.

• One or more of the switch's IP configuration parameters are incorrect.

• For a UNIX TFTP server, the file permissions for the software file do not allow the file to be copied.

• Another console session (through either a direct connection to a terminal device or through Telnet) was
already running when you started the session in which the download was attempted.
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Action

Single copy command
When a switch crashes, five files relating to the crash; core-dump, crash-data, crash-log, fdr-log, and event-log
are created and should be copied for review. All five files (core-dump, crash-data, crash-log, fdr-log, and event-
log) should be copied to a destination specified under a directory by file name.

TFTP

A destination directory and files can be created for all crash files (core-dump, crash-data, crash-log, fdr-log,
and event-log) on an TFTP server (with write permissions).

SFTP

Files are auto created on the SFTP server as a secured transfer. The destination directories however can be
manually created on the server.

You can use specified directories for the TFTP/SFTP transfers in the copy command. If you specify a directory,
the command copies all files under one directory. With no directory specified, the command copies all files to the
TFTP/SFTP server home directory. You must specify a directory name.

copy source
Syntax
copy <SOURCE> <DATA_FILE> <DESTINATION> <DATA_FILE> <OPTIONS>
        
Description

Copies data files to and from the switch.

Parameters and options

<SOURCE>

Specify the source of data using any of the following destinations.

Flash

N/A

SFTP

For transfer of crash-files via SFTP, the destination directory must exist on the SFTP server with write
permissions.

File creation is not mandatory as files are automatically created with the chassis serial number suffix to the
filename when using SFTP.See: example

TFTP

For transfer of crash-files via TFTP, the destination directory along with the file names (core-dump, crash-
data, crash-log, fdr-log, and event-log) must exist on the TFTP server with write permissions.

USB

For transfer of crash-files via USB, the destination directory along with the file names (core-dump, crash-
data, crash-log, fdr-log, and event-log) must exist on the device with write permissions.

Xmodem

N/A
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<DATA_FILES>
Specify the data file to be copied from the source.

command-output <COMMAND>
Specify a command to copy output. When using command-output, place the desired CLI command in
double-quotes. For example: "show system".

config <FILE-NAME>
Copy named configuration file. The file-name option is the source configuration file being copied.

core-dump
Copy core-dump file from flash.

crash-data

Copy the switch crash-data file.

crash-log

Copy the switch crash-log file.

crash-files <A|B|C|D|E|F|G|H|MASTER>
Copy core-dump, crash-data, crash-log, fdr-log, and event-log files to an SFTP/TFTP server, USB, or
xmodem terminal.

When using the crash-files option, the destination directory alone must be specified as the destination
path. Specifying the file names is not mandatory.

default-config

Copy custom default-config file.

event-log

Copy event-log file.

fdr-log

Copy FDR-og file from the switch to an SFTP/TFTP server, USB or xmodem terminal.

flash

Copy the switch system image file.

SFTP server

Copy data from a SFTP server.

startup-config

Copy in-flash configuration file.

ssh-client-known-hosts

Copy the known hosts file.

ssh-server-pub-key

Copy the switch's SSH server public key.

running-config

Copy running configuration file.

TFTP

Copy data from a TFTP server.
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USB

Copy data from a USB flash drive.

xmodem

Use xmodem on the terminal as the data source.

<DESTINATION >

Specify the copy target.

SFTP
TFTP
USB
xmodem

<DATA_FILES>
Specify the data file name at the target.

command file
config
default-config
flash
pub-key-file
show-tech
startup-config
ssh-client-key
ssh-client-known-hosts

<OPTIONS>
append

Add the keys for operator access.

directory

Directory name to upload. Required for TFTP, SFTP and USB transfers.

filename

File-name to upload/download. Required for TFTP, SFTP and USB transfers.

hostname

Hostname of the TFTP, SFTP server. Required for TFTP, SFTP transfers.

IPv4 address

TFTP, SFTP server IPv4 address. Required for TFTP, SFTP transfers.

IPv6 address

TFTP, SFTP server IPv6 address. Required for TFTP, SFTP transfers.

manager

Replace the keys for manager access; follow with the append option to add the keys.

operator

Replace the keys for operator access (default); follow with the append option to add the keys.

pc

N/A
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unix

N/A

The listed crash-files captured for 3500 switch for both MM and slot using SFTP are as follows:

MM crash-files:

M-SG238TF00K.cor
M-SG238TF00K.cdata
M-SG238TF00K.clog
M-SG238TF00K.evt
M-SG238TF00K.fdr

Slot crash-files:

I-SG238TF00K.cor
I-SG238TF00K.cdata
I-SG238TF00K.clog
I-SG238TF00K.evt
I-SG238TF00K.fdr

copy crash-files
Syntax
copy crash-files [slot-id|mm-active|mm-standby|member]
Description

Copies multiple management switches.

Parameters and options
slot-id

Copy interface management crash files to SFTP, TFTP, USB, and Xmodem.

mm-active
Copy active management module crash files to SFTP, TFTP, USB, and Xmodem.

mm-standby
Copy standby management module crash files to SFTP, TFTP, USB, and Xmodem.

copy crash-files member
Syntax
copy crash-files member [management|interfaces}
Description

Copies stacking or standalone switches.

Parameters and options
management

Copy stack member crash files to SFTP, TFTP, USB, and Xmodem.
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interfaces
Copy stack member crash files to SFTP, TFTP, USB, and Xmodem.

copy crash-files crash-file-options
Syntax
copy crash-files crash-file-options <HOST-NAME-STR> <IP-ADDR> <IPv6-ADDR> <SFTP>
<DIRNAME-STRX> [oobm] <DESTINATION>
Description

Copies crash files using various options.

Parameters and options
<HOST-NAME-STR>

Specify hostname of the SFTP server.

<IP-ADDR>
Specify SFTP server IPv4 address.

<IPv6–ADDR>
Specify SFTP server IPv6 address.

<USER>
Specify the username on the remote system.

<USERNAME@IP-STR>
Specify the username along with remote system. Information (hostname, IPv4 or IPv6 address).

<DIRNAME-STR>
Specify the destination directory name.

oobm
Use the OOBM interface to reach SFTP server.

<DESTINATION>
slot-id

Copy interface core-dump file.

mm-active
Copy active management module crash files.

mm-standby
Copy standby management module crash files.

member
Copy member crash files.

interfaces
Copy interfaces crash files.

management
Copy management crash files.
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Switch and network operations
The switches have several built-in tools for monitoring, analyzing, and troubleshooting switch and network
operation:

• Status Includes options for displaying general switch information, management address data, port status, port
and trunk group statistics, MAC addresses detected on each port or VLAN, and STP, IGMP, and VLAN data.

• Counters Display details of traffic volume on individual ports.

• Event Log Lists switch operating events. See the ProVision switch software troubleshooting guide for
troubleshooting information.

• Configurable trap receivers Uses SNMP to enable management stations on your network to receive SNMP
traps from the switch.

• Port monitoring (mirroring) Copy all traffic from the specified ports to a designated monitoring port .

NOTE: Link test and ping test—analysis tools in troubleshooting situations—are described in the
ProVision Switch Software Troubleshooting Guide.

Status and counters data
This section describes the status and counters screens available through the switch console interface and/or the
WebAgent.

NOTE:

You can access all console screens from the WebAgent via Telnet to the console. Telnet access to
the switch is available in the Device View window under the Configuration tab.

show system

Syntax
show system [chassislocate | information | temperature]

Description

Shows global system information and operational parameters for the switch.

Command context
manager and operator

Parameters
chassislocate

Shows the chassis locator LED status. Possible values are ON, Off, and Blink. When the status is On or Blink,
the number of minutes that the Locator LED will continue to be on or to blink is displayed.
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information
Displays global system information and operational parameters for the switch.

temperature
Shows system temperature and settings.

Usage

• To show system fans, see show system fans

• To show chassis power supply and settings, see show system power-supply

• To show system fans for VSF members, see show system fans vsf

Examples

Locating the system chassis by LED blink using the show system chassislocate command.

Showing the general switch system information by using the show system command.

chassislocate
Syntax

Description

Identifies the location of a specific switch by activating the blue locator LED on the front panel of the switch.

chassislocate [blink|on|off]
Parameters and options
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blink <1–1440>
Blinks the chassis locate LED for a specified number of minutes (Default: 30 min.)

on <1–1440>
Turns the chassis locate LED on for a specified number of minutes (Default: 20 min.)

off
Turns the chassis locate LED off.

Chassislocate at startup
The chassislocate command has an optional parameter that configures it to run in the future instead of
immediately.

Syntax
chassislocate [on|blink] <MINUTES> at [now|startup]
chassislocate off
Parameters and options
<MINUTES>

Specify the number of minutes for the chassis locate LED to remain on or blink.

at
Specify when the command is applied (default immediately.)

now
Turn on the chassis locate LED immediately.

startup
Turn on the chassis locate LED at switch startup.

off
Turn off the chassis locate LED switch

chassislocate at startup

chassislocate blink 10 at startup

show system chassislocate
Syntax
show system chassislocate
Description

Displays the current status of the chassislocate settings.

Display locator LED status

Locator LED Status
          Current    Time
Member    State      Remaining  Configuration
------    -------    ---------  -------------
1         blink      00:27:05   blink 30 at startup
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2         on         01:05:27
3         off

Collecting processor data with the task monitor
The task monitor feature allows you to enable or disable the collection of processor utilization data. The task-
monitor cpu command is equivalent to the existing debug mode command taskusage -d. (The
taskUsageShow command is also available.)

When the task-monitor command is enabled, the show cpu command summarizes the processor usage by
protocol and system functions.

task-monitor cpu
Syntax

[no] task-monitor cpu
Description

Enables or disables the collection of processor utilization data, and requires a manager log in. Settings are not
persistent; there are no changes to the configuration. Defaults to disabled.

task-monitor cpu command

Figure 105: The task-monitor cpu command and show cpu output

Switch management address information access

show management
Syntax
show management
Description

Displays switch management address information.

Component information views
The CLI show modules command displays additional component information for the following:
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• SSM—identification, including serial number

• Mini-GBICS—a list of installed mini-GBICs displaying the type, "J" number, and serial number (when available)

show modules
Syntax
show modules
Description

Displays information about the installed modules (Figure 106: The show modules command output on page
478), including:

• The slot in which the module is installed

• The module description

• The serial number

Additionally, this command displays the part number (J number) and serial number of the chassis. (See Figure
107: The show modules details command for the 8212zl, showing SSM and mini-GBIC information on page
479.)

show modules command

Figure 106: The show modules command output
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show modules details command

Figure 107: The show modules details command for the 8212zl, showing SSM and mini-GBIC information

Compatibility mode for v2 zl and zl modules
In the following context, v2 zl modules are the second version of the current zl modules. Both v2 zl and zl
modules are supported in the 5400zl series chassis switches.

Compatibility Mode allows the inter-operation of v2 zl modules with zl modules in a chassis switch. When in
Compatibility Mode, the switch accepts either v2 zl or zl modules. The default is Compatibility Mode enabled. If
Compatibility Mode is disabled by executing the no allow-v1-modules command, the switch will only power
up v2 zl modules.

allow-v1-modules
Syntax
[no] allow-v1-modules
Enables Compatibility Mode for interoperation of v2 zl and zl modules in the same chassis. (See Figure 108:
Enabling compatibility mode on page 479.) The no form of the command disables Compatibility Mode. Only
the v2 zl modules are powered up. (See Figure 109: Disabling compatibility mode on page 480.) Defaults to
enabled.

allow-v1–modules

Figure 108: Enabling compatibility mode
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no allow-v1–modules

Figure 109: Disabling compatibility mode

Port status
You can view port status using either the CLI or the menu.

show interfaces brief
Syntax
show interfaces brief
Description

View the port status.

Accessing port and trunk group statistics
Use the CLI to view port counter summary reports, and to view detailed traffic summary for specific ports.

Trunk bandwidth utilization
• Trunk interface counters display the accumulated statistics over the trunk members' ports since the time they

are added into trunk.

• Bandwidth utilization for trunks is calculated by averaging the value of the sum of bandwidth utilization for each
trunk member in the last 5 minute interval .

show interfaces

Syntax
show interfaces [brief | config | <PORT-LIST>]

Description

Shows interface information for ports or trunk groups in brief or configuration detail.

Command context
operator or manager

Parameters
brief

Shows the current operating status for all ports or trunk groups on the switch in brief detail.

config
Shows the configuration data for all ports or trunk groups on the switch.

<PORT-LIST>

Specifies the list of ports for which status information will be shown.
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<TRUNK-GROUP>

Specifies the trunk group for which status information will be shown. The status information shown consists of
total transmit and receive counters and weighted average rate for the trunk group specified. The weighted
average rate is calculated in 5 minute intervals.

Usage

Both external and internal ports are supported on the same module. Internal ports have an “I” suffix in the output
of the show command to indicate that they are internal ports.

• “10GbE-INT” – Internal 10G data-plane ports (1i-2i, 4i-5i)

• “1GbE-INT” – Internal 1G control-plane port (3i)

• Port 3i always shows as link-down.

Examples

Show brief information and status of all interfaces.

switch# show interfaces brief

Status and Counters - Port Status
                | Intrusion                            MDI   Flow  Bcast
Port  Type      | Alert     Enabled Status Mode        Mode  Ctrl  Limit
----- --------- + --------- ------- ------ ----------  ----- ----- ------
B1    100/1000T | No        Yes     Down   Auto-10-100 Auto  off   0
B2    100/1000T | No        Yes     Down   1000FDx     Auto  off   0
B3    100/1000T | No        Yes     Down   1000FDx     Auto  off   0
B4    100/1000T | No        Yes     Down   1000FDx     Auto  off   0
B5    100/1000T | No        Yes     Down   1000FDx     Auto  off   0
B6    100/1000T | No        Yes     Down   1000FDx     Auto  off   0
Show the configuration of the interfaces currently available.

switch# show interfaces config

Port Settings
  Port  Type      | Enabled Mode         Flow Ctrl MDI
  ----- --------- + ------- ------------ --------- ----
  B1    100/1000T | Yes     Auto-10-100  Disable   Auto
  B2    100/1000T | Yes     Auto         Disable   Auto
  B3    100/1000T | Yes     Auto         Disable   Auto
  B4    100/1000T | Yes     Auto         Disable   Auto
  B5    100/1000T | Yes     Auto         Disable   Auto
  B6    100/1000T | Yes     Auto         Disable   Auto 
Show brief information and status of interfaces for ports D1i, D2i, and D3i.

switch# show interfaces brief d1i-d3i

Status and Counters - Port Status
                  | Intrusion                           MDI  Flow Bcast
Port   Type       | Alert     Enabled Status Mode       Mode Ctrl Limit
------ ---------- + --------- ------- ------ ---------- ---- ---- -----
D1i    10GbE-INT  | No        Yes     Up     10GigFD    NA   off  0
D2i    10GbE-INT  | No        Yes     Up     10GigFD    NA   off  0
D3i    1GbE-INT   | No        Yes     Down   1000FDx    NA   off  0
Show the brief information and status of interfaces for ports B1 through internal port B3i.
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switch# show interfaces brief b1-b3i

Status and Counters - Port Status
                   | Intrusion                           MDI  Flow Bcast
 Port   Type       | Alert     Enabled Status Mode       Mode Ctrl Limit 
 ------ ---------- + --------- ------- ------ ---------- ---- ---- -----
 B1     100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B2     100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B3     100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B4     100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B5     100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B6     100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B7     100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B8     100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B9     100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B10    100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B11    100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B12    100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B1i    10GbE-INT  | No        Yes     Up     10GigFD    NA   off  0
 B2i    10GbE-INT  | No        Yes     Up     10GigFD    NA   off  0
 B3i    1GbE-INT   | No        Yes     Up     1000FDx    NA   off  0
Show detailed interface information for port trunk 1.

switch# show interface trk1

Status and Counters - Port Counters for port Trk1                      
  Name  :  Trk1
  MAC Address      : 3464a9-b1b8bf 
  Link Status      : Up 
  Totals (Since boot or last clear) : 
   Bytes Rx        : 777,713,956          Bytes Tx        : 596,853,141   
   Unicast Rx      : 1,154,693            Unicast Tx      : 0             
   Bcast/Mcast Rx  : 48,563               Bcast/Mcast Tx  : 607,474,910   
  Errors (Since boot or last clear) : 
   FCS Rx          : 0                    Drops Tx        : 0             
   Alignment Rx    : 0                    Collisions Tx   : 0             
   Runts Rx        : 0                    Late Colln      : 0             
   Giants Rx       : 0                    Excessive Colln : 0             
   Total Rx Errors : 0                    Deferred Tx     : 0               
  Others (Since boot or last clear) : 
   Discard Rx      : 0                    Out Queue Len   : 0             
   Unknown Protos  : 0                  
  Rates (5 minute weighted average) :
   Total Rx(Kbps)  : 76,800                 Total Tx(Kbps): 76,800              
   Unicast Rx (Pkts/sec) : 21             Unicast Tx (Pkts/sec) : 0            
   B/Mcast Rx (Pkts/sec) : 114,878        B/Mcast Tx (Pkts/sec) : 114,900      
   Utilization Rx  : 00.76 %                                                  
Utilization Tx  : 00.76 % 

show interfaces trunk-utilization

Syntax
show interfaces trunk-utilization

Description

Shows the bandwidth utilization calculations for all trunk members.

Command context

operator or manager
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Example

Show bandwidth utilization for trunks.

Switch(config)# show interfaces trunk-utilization

Status and Counters - Port Utilization

                         Rx                           Tx
 Port     | --------------------------- | ---------------------------
          | Kbits/sec   Pkts/sec  Util  | Kbits/sec  Pkts/sec   Util
 --------  ---------- ----- + ---------- ---------- ---------  -----
 Trk1     | 0          0          0     | 0          0          0
 Trk2     | 0          0          0     | 0          0          0
 Trk10    | 0          0          0     | 0          0          0

Statistic interactions of interface counters

Table 24: Statistic interactions

Interface counters are cleared using the command clear statistics. When certain actions are taken to ports
and trunks, the outcome of the clear command differs.

Action taken Trigger Interaction with interface counter

Adding Port
into trunk

CLI/SNMP • Interface counters for this port will be cleared across all sessions.

• Average rate counters are not cleared.

Removing
Port from
trunk

CLI/SNMP • Interface counters for this port will be cleared across all sessions.

• Average rate counters are not cleared.

Trunk port
coming Up

CLI enable • No change in counters.

• Interface counters for this port are not cleared.

• Average rate counters are not cleared. Counters will start from 0 when the
trunk port comes up.

Trunk port
coming Up

Cable connect • No change in counters.

• Interface counters for this port are not cleared.

• Average rate counters are not cleared. Counters will start from 0 when the
trunk port comes up.

Trunk port
going Down

CLI disable • Interface counters for this port are not cleared.

• Average rate counters are cleared.

Trunk port
going Down

Cable
disconnect

• Interface counters for this port are not cleared.

• Average rate counters are cleared.

Table Continued
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Action taken Trigger Interaction with interface counter

Trunk port
going Down

Module crash/
module reload

• Interface counters for this port are not cleared.

• Average rate counters are cleared.

Trunk port
going Down

Save power - off • Interface counters for this port are not cleared.

• Average rate counters are cleared.

Trunk port
going Down

Stacking
member reboot/
crash/shutdown.

• Interface counters for this port are not cleared.

• Average rate counters of this port is not cleared.

• Utilization for the port is cleared.

• Utilization for the trunk group is updated accordingly

Trunk port
going Down

Module remove/
member
remove.

• Statistics for removed trunk port can not be accessed as the port is
removed.

• Interface counters for the trunk group is updated.

• Utilization for the trunk group is updated.

Clear
statistics on
physical port
which is part
of trunk

CLI • Not allowed.

• The error message Module not present for port or invalid
port: <PORT-NUM> displays when the command clear statistics
is executed on a port which part of a trunk.

Clear
statistics on
trunk.

CLI • Interface counters for physical ports which are part of trunk will be cleared.

• Average rate counters are not cleared.

Reset port counters
When troubleshooting network issues, you can clear all counters and statistics without rebooting the switch using
the clear statistics global command or using the menu.

SNMP displays the counter and statistics totals accumulated since the last reboot, and it is not affected by the
clear statistics global command or the clear statistics <PORT-LIST> command. Clearing
statistics initiates an SNMP trap.

IMPORTANT: Once cleared, statistics cannot be reintroduced.

clear statics

Syntax
clear statistics [<PORT-LIST> | global | <TRUNK-LIST>]

Description

Clears all interface counters and statistics for specified ports, specified trunks or clears statistics globally for all.
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Command context
manager

Parameters
<PORT-LIST>

Specifies the list of ports.

global
Specifies all counters and statistics for all interfaces.

<TRUNK-LIST>]
Specifies the list of trunks.

Usage

The clear statistics command does not clear SNMP.

MAC address tables

MAC address views and searches
You can view and search MAC addresses using the CLI or the menu.

show mac-address

Syntax
show mac-address [vlan <VLAN-ID> ] [<PORT-LIST>] [<MAC-ADDR>] [TUNNEL-ID]

Description

Lists all MAC addresses on the switch and their corresponding port numbers. You can also choose to list specific
addresses and ports, or addresses and ports on a VLAN. The switches operate with a multiple forwarding
database architecture.

Command context
manager

Parameters
vlan <VLAN-ID>

Show MAC addresses learned on a specified VLAN.

PORT-LIST

Show MAC addresses learned on the specified ports.

<MAC-ADDR>
Show the specified port for a specified MAC address.

TUNNEL-ID

Show MAC addresses learned on the specified VXLAN tunnel.
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Usage
show mac-address

Lists all learned MAC addresses on the switch and their corresponding port numbers.

show mac-address a1-a4,a6
Lists all learned MAC addresses on one or more ports and their corresponding port numbers.

show mac-address vlan 100
Lists all learned MAC addresses on a VLAN and their corresponding port numbers.

show mac-add detail

Syntax
show mac-address detail

Description

Shows the age of the learned MAC addresses in the MAC table. The age of a specific MAC-address will be
displayed in dd:hr:min:sec.msec format.

Command context
manager

Examples
show mac-add detail on a specified switch.

switch# show mac-add detail

Status and Counters - Port Address Table

  MAC Address       Port                            VLAN Age (d:h:m:s.ms)
  ----------------- ------------------------------- ---- ----------------
  3c4a92-31c100     F23                             1    0000:00:00:00.34
  9cb654-ce6169     A2                              1    0000:00:02:37.93
  c09134-cd2740     F23                             1    0000:00:00:00.28
  c09134-cd277d     F23                             1    0000:00:00:23.62
  f0921c-85b0e0     F24                             1    0000:00:00:08.29
  f0921c-85b0e9     F24                             1    0000:00:00:09.47
show mac-add detail for Vxlan Tunnel supporting and non-supporting platforms.

switch# show mac-address detail
 
Status and Counters - Port Address Table
  MAC Address       Port                            VLAN Age (d:h:m:s.ms)
  ----------------- ------------------------------- ---- ----------------
  f0921c-b6e940     L22                             1    0000:00:23:26.93
  0180c2-00000f     A24                             50   0000:00:00:00.00
  d18cc2-00000f     A24                             50   0001:21:43:59.92
  e18dd2-00000f     A24                             50   0000:18:23:24.22
show mac-add detail for platforms not supporting Vxlan Tunnels.

stack-Switch# show mac-address detail 
 
Status and Counters - Port Address Table
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  MAC Address   Port   VLAN Age (d:h:m:s.ms)  
  ------------- ------ ---- ----------------
  009c02-d80f28 1/2    1    0000:00:00:30.18
  3464a9-abe500 1/2    1    0030:07:01:20.23

show mac-address <MAC-ADDRESS> detail

Syntax

Syntax
show mac-address <MAC-ADDRESS> detail

Description

Specifies the age and existing details of the specific mac address given.

manager

Parameters
<MAC-ADDRESS>

Specifies the mac-address being requested in detail.

Examples

Show mac-address detail for f0921c-b6e97e.

switch# show mac-address f0921c-b6e97e detail

 Status and Counters - Port Address Table
  MAC Address       Port                            VLAN Age (d:h:m:s.ms)
  ----------------- ------------------------------- ---- ----------------
  f0921c-b6e97e     L22                             1    0000:00:00:30.18
Show mac-address detail for a stacked switch.

switch-Stack# show mac-address 009c02-d80f28 detail
 Status and Counters - Port Address Table
  MAC Address   Port   VLAN Age (d:h:m:s.ms)  
  ------------- ------ ---- ----------------
  009c02-d80f28 1/2    1    0000:00:00:30.18

Using the menu to view and search MAC addresses
To determine which switch port on a selected VLAN the switch uses to communicate with a specific device on the
network:

Procedure

1. From the Main Menu, select 1. Status and Counters ... , and then select 5. VLAN Address Table.

2. Use the arrow keys to scroll to the VLAN you want, and then press Enter on the keyboard to select it.
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The switch then displays the MAC address table for that VLAN (Figure 110: Example of the address table
on page 488.)

Figure 110: Example of the address table

3. To page through the listing, use Next page and Prev page .

Finding the port connection for a specific device on a VLAN
This feature uses a device's MAC address that you enter to identify the port used by that device.

Procedure

1. Proceeding from Figure 110: Example of the address table on page 488, press [S] (for Search ), to display
the following prompt:

Enter MAC address: _
2. Enter the MAC address you want to locate and press [Enter].
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3. The address and port number are highlighted if found (Figure 111: Example of menu indicating located
MAC address on page 489.) If the switch does not find the MAC address on the currently selected VLAN, it
leaves the MAC address listing empty.

Figure 111: Example of menu indicating located MAC address

4. Press [P] (for Prev page ) to return to the full address table listing.

Viewing and searching port-level MAC addresses
This feature displays and searches for MAC addresses on the specified port instead of for all ports on the switch.

Procedure

1. From the Main Menu, select:

2. 1. Status and Counters ...

3. 7. Port Address Table

Figure 112: Listing MAC addresses for a specific port

4. Use the Space bar to select the port you want to list or search for MAC addresses, then press [Enter] to list
the MAC addresses detected on that port.
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Determining whether a specific device is connected to the selected port
Proceeding from 4, above:

Procedure

1. Press [S] (for Search ), to display the following prompt:

Enter MAC address: _
2. Enter the MAC address you want to locate and press [Enter].

3. The address is highlighted if found. If the switch does not find the address, it leaves the MAC address listing
empty.

4. Press [P] (for Prev page ) to return to the previous per-port listing.

MSTP data
show spanning-tree
Syntax
show spanning-tree
Description

Displays the global and regional spanning-tree status for the switch, and displays the per-port spanning-tree
operation at the regional level.

Values for the following parameters appear only for ports connected to active devices: Designated Bridge,
Hello Time, PtP, and Edge.
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show spanning-tree command output

Figure 113: show spanning-tree command output

IP IGMP status

show ip igmp
Syntax
show ip igmp <VLAN-ID> [config] [group <IP-ADDR>|groups] [statistics]
        
Description

Global command that lists IGMP status for all VLANs configured in the switch, including:
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• VLAN ID (VID) and name

• Querier address

• Active group addresses per VLAN

• Number of report and query packets per group

• Querier access port per VLAN

Parameters and options
config

Displays the IGMP configuration information, including VLAN ID, VLAN name, status, forwarding, and Querier
information.

vlan-id

Per-VLAN command listing above, IGMP status for specified VLAN (VID).

group <IP-ADDR>
Lists the ports currently participating in the specified group, with port type, Access type, Age Timer data and
Leave Timer data.

groups
Displays VLAN-ID, group address, uptime, expiration time, multicast filter type, and the last reporter for IGMP
groups.

statistics
Displays IGMP operational information, such as VLAN IDs and names, and filtered and flooding statistics.

Output from show ip igmp config command

IGMP statistical information

switch(vlan-2)# show ip igmp statistics

 IGMP Service Statistics

  Total VLANs with IGMP enabled               : 1
  Current count of multicast groups joined    : 1

 IGMP Joined Groups Statistics

  VLAN ID VLAN Name                        Filtered     Flood
  ------- -------------------------------- ------------ ------------
  2       VLAN2                            2            1
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VLAN information

show vlan
Syntax
show vlan <VLAN-ID>
        
Description

Lists the maximum number of VLANs to support, existing VLANS, VLAN status (static or dynamic), and primary
VLAN.

Parameters and options
<VLAN-ID>

Lists the following for the specified VLAN:

• Name, VID, and status (static/dynamic)

• Per-port mode (tagged, untagged, forbid, no/auto)

• "Unknown VLAN" setting (Learn, Block, Disable)

• Port status (up/down)

List data on specific VLANs

The next three figures show how you can list data for the following VLANs:

Ports VLAN VID

A1-A12 DEFAULT_VLAN 1

Table Continued
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A1, A2 VLAN-33 33

A3, A4 VLAN-44 44

Figure 114: Listing the VLAN ID (vid) and status for specific ports

Figure 115: Example of VLAN listing for the entire switch

Figure 116: Port listing for an individual VLAN

494 Aruba 3810 / 5400R Management and Configuration Guide for
ArubaOS-Switch 16.08

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4232



WebAgent status information
The WebAgent Status screen provides an overview of the status of the switch. Scroll down to view more details.
For information about this screen, click on ? in the upper right corner of the WebAgent screen.

Figure 117: Example of a WebAgent status screen

Configuring local mirroring
To configure a local mirroring session in which the mirroring source and destination are on the same switch, follow
these general steps:

Procedure

1. Determine the session and local destination port:

a. Session number (1-4) and (optional) alphanumeric name

b. Exit port (any port on the switch except a monitored interface used to mirror traffic)

IMPORTANT:

Hewlett Packard Enterprise strongly discourages connecting a mirroring exit port to a network
because doing so can result in serious network performance problems. Only connect an exit port
to a network analyzer, IDS, or other network edge device that has no connection to other network
resources.

2. Enter the mirror session-# [name session-name ] port port-# command to configure the
session.

3. Determine the traffic to be selected for mirroring by any of the following methods and the appropriate
configuration level (VLAN, port, mesh, trunk, switch):
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a. Direction: inbound, outbound, or both

b. Classifier-based mirroring policy: inbound only for IPv4 or IPv6 traffic

c. MAC source and/or destination address: inbound, outbound, or both

4. Enter the monitor command to assign one or more source interfaces to the session.

After you complete step 4, the switch begins mirroring traffic to the configured exit port.

The following commands configure mirroring for a local session in which the mirroring source and destination are
on the same switch.

• The mirror command identifies the destination in a mirroring session.

• The interface and vlan commands identify the mirroring source, including source interface, traffic
direction, and traffic-selection criteria for a specified session.

NOTE:

With no

allow-v2-modules

specified in the configuration of a switch with V3 modules on KB firmware, Egress VLAN ACLs do
not filter mirrored traffic. You must use a port ACL to filter mirrored traffic.

Local mirroring sessions
Syntax
[no] mirror-port <EXIT-PORT-#>
        
Description

Configure local mirroring sessions.

Parameters and options
mirror-port <EXIT-PORT-#>

When used with mirror-port <EXIT-PORT-#> command, removes the mirroring session and any
mirroring source previously assigned to that session by the following commands.

Traffic-direction criteria

interface monitor all
Syntax
[no] [interface <PORT> |<TRUNK>] monitor

ACL criteria for inbound traffic — deprecated

NOTE: 
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interface monitor ip
Syntax
[no] [interface <PORT> |<TRUNK> |<MESH>]|vlan <VID-#>] monitor ip access-group
<ACL-NAME> in mirror session [session ...]

Mirror policy for inbound traffic

class [ipv4|ipv6]
Syntax
class [ipv4|ipv6] <CLASSNAME> [no] [seq-number] [match|ignore] <IP-PROTOCOL>
<SOURCE-ADDRESS> <DESTINATION-ADDRESS>][precedence <PRECEDENCE-VALUE>][tos <TOS-
VALUE>][ip-dscp <CODEPOINTS>][vlan <VLAN-ID>]
Description

Configures the mirroring policy for inbound traffic on the switch.

Parameters and options

policy mirror
Syntax
policy mirror <POLICY-NAME> [no] <SEQ-NUMBER> [class [ipv4|ipv6] <CLASSNAME> action
mirror <SESSION>] [action mirror <SESSION>] [no] default-class action mirror
<SESSION> [no] [interface <PORT/TRUNK>| vlan <VID-#>] service-policy <MIRROR-
POLICY-NAME> in
Description

The [no] [interface <PORT/TRUNK>| vlan <VID-#>] service-policy <MIRROR-POLICY-NAME>
in command removes the mirroring policy from a port, VLAN, trunk, or mesh interface for a specified session,
but leaves the session available for other assignments.

Parameters and options
mirror <SESSION>

Accepts either a number (1 to 4) or a name. To use a name, you must first configure the name <NAME-STR>
parameter option for the specified mirroring session using the policy mirror command.

MAC-based criteria to select traffic

monitor mac
Syntax
[no] monitor mac  <MAC-ADDR> [src|dst|both] mirror session
      
Description

Configures traffic using MAC-based criteria.

Parameters and options
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no
Use the no form of the complete Command syntax (for example, no monitor mac 112233-445566 src
mirror 3) to remove a MAC address as mirroring criteria from an active session on the switch without
removing the session itself.

mirror
Enter the monitor mac mirror command at the global configuration level.

Remote mirroring destination on a remote switch
Syntax
mirror endpoint ip <SRC-IP> <SRC-UDP-PORT > <DST-IP> <EXIT-PORT> [truncation]
      
Description

Configures a remote mirroring destination on a remote switch.

Parameters and options

Remote mirroring destination on a local switch

mirror remote ip
Syntax
mirror <SESSION> remote ip <SRC-IP> <SRC-UDP-PORT> <DST-IP>
      
Description

Configures a remote mirroring destination on a local switch.

Parameters and options

Local mirroring destination on the local switch

mirror port
Syntax
mirror  <SESSION>  port  <EXIT-PORT> 
      
Description

Configures a local mirroring destination on a local switch.

Parameters and options

Monitored traffic
IMPORTANT:

In release K.14.01 and greater, the use of ACLs to select inbound traffic in a mirroring session
interface | vlan monitor ip access-group in mirror command has been deprecated
and is replaced with classifier-based mirroring policies.

498 Aruba 3810 / 5400R Management and Configuration Guide for
ArubaOS-Switch 16.08

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4236



interface
Syntax
interface <PORT/TRUNK/MESH>
Description

Parameters and options

monitor all
Syntax
monitor all [in|out|both] mirror <SESSION> [no-tag-added]
monitor ip access-group ACL-NAME in mirror <SESSION>
monitor mac <MAC-ADDR> [src|dest|both] mirror
show monitor [endpoint|<SESSION-NUMBER>|name <SESSION-NAME>

service-policy
Syntax
service-policy <mirror-policy-name> in

Configuring local mirroring (Menu)
If mirroring has already been enabled on the switch, the Menu screens appear different from the one shown in this
section.

Procedure

1. From the Main Menu, select 1. Switch Configuration ... , and then select 3. Network Monitoring Port.

Figure 118: The default network mirroring configuration screen

2. In the Actions menu, press [E] (for Edit.)

3. If mirroring is currently disabled for session 1 (the default), enable it by pressing the Space bar (or [Y]) to
select Yes.
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4. Press the down arrow key to display a screen similar to Figure 119: How to select a local exit port on page
500, and move the cursor to the Monitoring Port parameter.

Figure 119: How to select a local exit port

5. Use the Space bar to select the port to use for sending mirrored traffic to a locally connected traffic analyzer
or IDS.

6. (The selected interface must be a single port. It cannot be a trunk or mesh.) In this example, port 5 is
selected as the local exit port.

7. Highlight the Monitor field and use the Space bar to select the interfaces to mirror:

8. Ports: Use for mirroring ports, static trunks, or the mesh.

9. VLAN: Use for mirroring a VLAN.

10. Do one of the following:

a. If you are mirroring ports, static trunks, or the mesh, go to
11

.

b. If you are mirroring a VLAN:

I. Press [Tab] or the down arrow key to move to the VLAN field.

II. Use the Space bar to select the VLAN you want to mirror.

III. Go to 14.

11. Use the down arrow key to move the cursor to the Action column for the individual port interfaces and
position the cursor at a port, trunk, or mesh you want to mirror.
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12. Press the Space bar to select Monitor for the ports, trunks, mesh, or any combination of these that you want
mirrored.

13. Use the down arrow key to move from one interface to the next in the Action column. (If the mesh or any
trunks are configured, they appear at the end of the port listing.)

14. When you finish selecting interfaces to mirror, press [Enter], then press [S] (for Save ) to save your changes
and exit from the screen.

15. Return to the Main Menu.

You can also use the CLI to configure a mirroring session for a destination device connected to an exit port on
either:

• The same switch as the source interface (local mirroring.)

• A different switch (remote mirroring.) The remote switch must be an switch offering the full mirroring
capabilities described in this chapter.

After you configure a mirroring session with traffic-selection criteria and a destination, the switch immediately
starts to mirror traffic to each destination device connected to an exit port.

In a remote mirroring session that uses IPv4 encapsulation, if the exit switch is not already configured as the
destination for the session, its performance may be adversely affected by the stream of mirrored traffic.

For this reason, Switch strongly recommends that you configure the exit switch for a remote mirroring session
before configuring the source switch for the same session.

Destination mirror on a remote switch

mirror endpoint
Syntax
mirror endpoint ip  <SRC-IP-ADDR>   <SRC-UDP-PORT>  <DST-IP-ADDR>  port  <EXIT-PORT> 
      
Description

Enter this command on a remote switch to configure the exit port to use in a remote mirroring session. to
configure the mirroring source on the local switch.

The mirror endpoint ip command configures:
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• The unique UDP port number to be used for the mirroring session on the source switch. The recommended
port range is from 7933 to 65535.

• The IP address of the source switch to use in the session.

• The IP address and exit-port number on the remote (endpoint) switch.

In a remote mirroring endpoint, the IP address of exit port and the remote destination switch can belong to
different VLANs.

Source mirror on the local switch

mirror remote ip
Syntax
[no] mirror 1 - 4 [name <NAME-STR>] remote ip <SRC-IP> <SRC-UDP-PORT> <DST-IP>
[truncation]
Description

Configures the mirroring source on the local switch.

Parameters and options
no mirror 1–4

Removes both the mirroring session and any mirroring sources previously assigned to the session by the
following commands.

Traffic-direction criteria
Syntax
[no] [interface <PORT> <TRUNK> <MESH>|vlan <VID-#>] monitor all in|out|both mirror 1–4|<NAME-STR> [1 — 4|<NAME-STR . . .>]
        

Description

Configures traffic direction criteria for specific traffic

Configure ACL criteria to select inbound
NOTE:

interface monitor ip access-group
Syntax
[no] [interface <PORT> <TRUNK> <MESH>|vlan <VID-#>] monitor ip access—group <ACL—NAME> inmirror [1–4|<NAME-STR>] [1 — 4|<NAME-STR . . .>]
      

Mirror policy for inbound traffic

class [ipv4|ipv6]
Syntax
class [ipv4|ipv6] <CLASSNAME> [no] [seq-number] [match|ignore] <IP-PROTOCOL>
<SOURCE-ADDRESS> <DESTINATION-ADDRESS>][precedence <PRECEDENCE-VALUE>][tos <TOS-
VALUE>][ip-dscp <CODEPOINTS>][vlan <VLAN-ID>]
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Description

Configures the mirroring policy for inbound traffic on the switch.

Parameters and options

policy mirror
Syntax
policy mirror <POLICY-NAME> [no] <SEQ-NUMBER> [class [ipv4|ipv6] <CLASSNAME> action
mirror <SESSION>] [action mirror <SESSION>] [no] default-class action mirror
<SESSION> [no] [interface <PORT/TRUNK>| vlan <VID-#>] service-policy <MIRROR-
POLICY-NAME> in
Description

The [no] [interface <PORT/TRUNK>| vlan <VID-#>] service-policy <MIRROR-POLICY-NAME>
in command removes the mirroring policy from a port, VLAN, trunk, or mesh interface for a specified session,
but leaves the session available for other assignments.

Parameters and options
mirror <SESSION>

Accepts either a number (1 to 4) or a name. To use a name, you must first configure the name <NAME-STR>
parameter option for the specified mirroring session using the policy mirror command.

Configuring a destination switch in a remote mirroring
session

CAUTION: When configuring a remote mirroring session, always configure the destination switch
first. Configuring the source switch first can result in a large volume of mirrored, IPv4-encapsulated
traffic arriving at the destination without an exit path, which can slow switch performance.

Syntax

mirror endpoint ip src-ip src-udp-port dst-ip exit-port-# no mirror endpoint ip src-ip src-udp-port dst-ip

Used on a destination switch to configure the remote endpoint of a mirroring session. The command uniquely
associates the mirrored traffic from the desired session on a monitored source with a remote exit port on the
destination switch. You must use the same set of source and destination parameters used when you configure the
same session on both the source and destination switches.

For a given mirroring session, the same src-ip , src-udp-port and dst-ip values must be entered with
the mirror endpoint ip command on the destination switch, and later with the mirror remote ip
command on the source switch.

CAUTION: Do not remove the configuration of a remote mirroring endpoint support for a given
session if there are source switches currently configured to mirror traffic to the endpoint.
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src-ip Must exactly match the src-ip address you configure on the source switch for the
remote session.

src-udp-port Must exactly match the src-udp-port value you configure on the source switch
for the remote session. The recommended port range is 7933 to 65535.This setting
associates the monitored source with the desired remote endpoint in the remote
session by using the same, unique UDP port number to identify the session on the
source and remote switches.

dst-ip Must exactly match the dst-ip setting you configure on the source switch for the
remote session.

exit-port-# Exit port for mirrored traffic in the remote session, to which a traffic analyzer or IDS
is connected.

The no form of the command deletes the mirroring endpoint for the configured session on the remote destination
switch.

Configuring a source switch in a local mirroring session
Enter the mirror port command on the source switch to configure an exit port on the same switch. To create
the mirroring session, use the information gathered in High-level overview of the mirror configuration process
on page 528.

Syntax

mirror 1 port exit-port-# [name name-str] no mirror 1
Assigns the exit port to use for the specified mirroring session and must be executed from the global configuration
level.

1 Identifies the mirroring session created by this command. (Multiple
sessions on the switch can use the same exit port.)

name name-str Optional alphanumeric name string used to identify the session
( up to 15 characters)

port exit-port-
#

Exit port for mirrored traffic in the remote session. This is the port
to which a traffic analyzer or IDS is connected.

The no form of the command removes the mirroring session and any mirroring source previously assigned to that
session.

Configuring a source switch in a remote mirroring session
Syntax

[no] mirror 1 - 4 [name name-str] remote ip src-ip src-udp-port dst-ip [truncation]
Used on the source switch to uniquely associate the mirrored traffic in the specified session with a remote
destination switch. You must configure the same source and destination parameters when you configure the same
session on both the source and destination switches. (If multiple remote sessions use the same source and
destination IP addresses, each session must use a unique UDP port value.)

When you execute this command, the following message is displayed:
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Caution: Please configure destination switch first.
          Do you want to continue [y/n]?

      

• If you have not yet configured the session on the remote destination switch, follow the configuration procedure
in Configure a mirroring destination on a remote switch on page 528 before using this command.

• If you have already configured the session on the remote destination switch, enter y (for "yes") to complete this
command.

1 - 4 Identifies the mirroring session created by this command.

name name-str Optional alphanumeric name string used as an additional session
identifier (up to 15 characters.)

src-ip The IP address of the VLAN or subnet on which the traffic to be
mirrored enters or leaves the switch.

src-udp-port Associates the remote session with a UDP port number. When
multiple sessions have the same source IP address src-ip and
destination IP address dst-ip , the UDP port number must be
unique in each session. The UDP port number used for a given
session should be in the range of 7933 to 65535.

CAUTION: UDP port numbers below 7933 are reserved
for various IP applications. Using them for mirroring can
result in the interruption of other IP functions and in
non-mirrored traffic being received on the destination
switch and sent to a device connected to the remote
exit port.

The configured UDP port number is included in the frames mirrored
from the source switch to the remote destination switch (mirror
endpoint), and enables the remote switch to match the frames to
the exit port configured for the combined UDP port number, source IP
address, and destination IP address..

dst-ip For the remote session specified in the command, this is the IP
address of the VLAN or subnet on which the remote exit port exists.
(The exit port to which a traffic analyzer or IDS is connected is
configured on the remote switch in section.) .)

[truncation] Enables truncation of oversize frames, causing the part of the frame
in excess of the MTU size to be truncated. Unless truncation is
enabled, oversize frames are dropped. The frame size is truncated to
a multiple of 18 bytes—for example, if the MTU is 1000 bytes, the
frame is truncated to 990 bytes (55 * 18 bytes.)

The no form of the command removes the mirroring session and any mirroring source previously assigned to the
session. To preserve the session while deleting a monitored source assigned to it.
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Selecting all traffic on a port interface for mirroring
according to traffic direction
Syntax

[no] interface port/trunk/mesh monitor all [in | out | both] [mirror 1 - 4 | name-
str] [{1 - 4 | name-str} | {1 - 4 | name-str} | {1 - 4 | name-str}] [no-tag-added]
Assigns a mirroring source to a previously configured mirroring session on a source switch by specifying the port,
trunk, and/or mesh sources to use, the direction of traffic to mirror, and the session.

interface port/trunk/mesh Identifies the source ports, static trunks, and/or mesh on which to mirror
traffic.Use a hyphen for a range of consecutive ports or trunks (a5-a8,
Trk2-Trk4.)Use a comma to separate non-contiguous interfaces (b11,
b14, Trk4, Trk7.)

monitor all [in | out | 
both]

For the interface specified by port/trunk/mesh , selects traffic to mirror based
on whether the traffic is entering or leaving the switch on the interface:

• in:
Mirrors entering traffic.

• out:
Mirrors exiting traffic.

• both:
Mirrors traffic entering and exiting.

If you enter the monitor all command without selection criteria or a
session identifier, the command applies by default to session 1

mirror [1 - 4 | name-str]
Assigns the traffic specified by the interface and direction to a session by
number or—if configured—by name. The session must have been
previously configured.Depending on how many sessions are already
configured on the switch, you can use the same command to assign the
specified source to up to four sessions, for example, interface a1
monitor all in mirror 1 2 4.

• 1 - 4
: Configures the selected port traffic to be mirrored in the specified
session number.

• [ name name-str ]
Optional: configures the selected port traffic to be mirrored in the
specified session name. The string can be used interchangeably with the
session number when using this command to assign a mirroring source
to a session.

[no-tag-added] Prevents a VLAN tag from being added to the mirrored copy of an outbound
packet sent to a local or remote mirroring destination.
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The no form of the command removes a mirroring source assigned to the session, but does not remove the
session itself. This enables you to repurpose a session by removing an unwanted mirroring source and adding
another in its place.

Selecting all traffic on a VLAN interface for mirroring
according to traffic direction
Syntax

vlan vid-# monitor all [in | out | both] [mirror 1 - 4 | name-str] [{1 - 4 | name-str} | {1 - 4 | name-str} | {1 - 4 | name-str}]

This command assigns a monitored VLAN source to a previously configured mirroring session on a source switch
by specifying the VLAN ID, the direction of traffic to mirror, and the session.

vlan vid-# Identifies the VLAN on which to mirror traffic.

monitor all [in | out 
| both]

Uses the direction of traffic on the specified vid-# to select traffic to mirror.If
you enter the monitor all command without selection criteria or a session
identifier, the command applies by default to session 1.

mirror [1 - 4 | name-
str]

Assigns the VLAN traffic defined by the VLAN ID and traffic direction to a
session number or name.Depending on how many sessions are already
configured on the switch, you can use the same command to assign the
specified VLAN source to up to four sessions, for example, interface a1
monitor all in mirror 1 2 4.

• 1 - 4
: Configures the selected VLAN traffic to be mirrored in the specified session
number.

• [name name-str ]:
Optional; configures the selected port traffic to be mirrored in the specified
session name. The string can be used interchangeably with the session
number when using this command to assign a mirroring source to a session.
To configure an alphanumeric name for a mirroring session, see the
command description under Configuring a source switch in a remote
mirroring session on page 504.

Assigning a VLAN to a mirroring session precludes assigning any other mirroring sources to the same session. If
a VLAN is already assigned to a given mirroring session, using this command to assign another VLAN to the
same mirroring session results in the second assignment replacing the first. Also, if there are other (port, trunk, or
mesh) mirroring sources already assigned to a session, the switch displays a message similar to:

Mirror source port exists on session N. Can not add mirror
source VLAN.
The no form of the command removes a mirroring source assigned to the session, but does not remove the
session itself. This allows you to repurpose a session by removing an unwanted mirroring source and adding
another in its place.

Configuring a MAC address to filter mirrored traffic on an
interface
Enter the monitor mac mirror command at the global configuration level.
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Syntax

[no] monitor mac mac-addr [src | dest | both] {mirror 1 - 4 | name-str} [1 - 4 | name-str] [1 - 4 | name-str] [1 - 4 | name-str]

Use this command to configure a source and/or destination MAC address as criteria for selecting traffic in one or
more mirroring sessions on the switch. The MAC address you enter is configured to mirror inbound (src),
outbound (dest), or both inbound and outbound (both) traffic on any port or learned VLAN on the switch.

monitor mac mac-addr
Configures the MAC address as selection criteria for mirroring traffic on any port or learned VLAN on the switch.

{src | dest | both}
Specifies how the MAC address is used to filter and mirror packets in inbound
and/or outbound traffic on the interfaces on which the mirroring session is
applied:

• src:
Mirrors all packets in inbound traffic that contain the specified MAC address
as source address.

• dest:
Mirrors all packets in outbound traffic that contain the specified MAC address
as destination address.

NOTE: The MAC address of the switch is not supported as either
the source or destination MAC address used to select mirrored
traffic.

both:
Mirrors all packets in both inbound and outbound traffic that contain the
specified MAC address as either source or destination address.

mirror [1 - 4 | name-
str]

Assigns the inbound and/or outbound traffic filtered by the specified MAC
address to a previously configured mirroring session. The session is identified
by a number or (if configured) a name.Depending on how many sessions are
configured on the switch, you can use the same command to configure a MAC
address as mirroring criteria in up to four sessions. To identify a session, you
can enter either its name or number; for example: mirror 1 2 3 traffsrc4
1 - 4 : Specifies a mirroring session by number, for which the configured
MAC address is used to select and mirror inbound and/or outbound traffic.

Packets that are sent or received on an interface configured with a mirroring session and that contain the MAC
address as source and/or destination address are mirrored to a previously configured destination device.

To remove a MAC address as selection criteria in a mirroring session, you must enter the complete Command
syntax, for example, no monitor mac 998877-665544 dest mirror 4.

The no form of the command removes the MAC address as a mirroring criteria from an active session, but does
not remove the session itself. This enables you to repurpose a session by removing an unwanted mirroring
criteria and adding another in its place.

Configuring classifier-based mirroring
For more information and a list of general steps for the process beginning with this command, see the information
about restrictions on classifier-based mirroring.

508 Aruba 3810 / 5400R Management and Configuration Guide for
ArubaOS-Switch 16.08

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4246



Context: Global configuration

Syntax

[no] class [ipv4 | ipv6 classname]
Defines the name of a traffic class and specifies whether a policy is to be applied to IPv4 or IPv6 packets, where
classname is a text string (64 characters maximum.)

After you enter the class command, you enter the class configuration context to specify match criteria. A traffic
class contains a series of match and ignore commands, which specify the criteria used to classify packets.

To configure a default traffic class, use the default-class command as described below. A default class
manages the packets that do not match the match/ignore criteria in any other classes in a policy.

Context: Class configuration

Syntax

[no] seq-number
 [match | ignore ip-protocol source-address destination-address] [ip-dscp 
codepoint] [precedence precedence-value] [tos tos-value] [vlan vlan-id]
For detailed information about how to enter match and ignore commands to configure a traffic class, the
Advanced Traffic Management Guide.

Context: Global configuration

Syntax

[no] policy mirror policy-name
Defines the name of a mirroring policy and enters the policy configuration context.

A traffic policy consists of one or more classes and one or more mirroring actions configured for each class of
traffic. The configured actions are executed on packets that match a match statement in a class. No policy action
is performed on packets that match an ignore statement.

Context: Policy configuration

Syntax

[no] seq-number
 class [ipv4 | ipv6 classname] action mirror session
Defines the mirroring action to be applied on a pre-configured IPv4 or IPv6 traffic class when a packet matches
the match criteria in the traffic class. You can enter multiple class action mirror statements in a policy.

[seq-number] The (optional) seq-number parameter sequentially orders the mirroring actions
that you enter in a policy configuration. Actions are executed on matching
packets in numerical order.Default: Mirroring action statements are numbered in
increments of 10, starting at 10.

class [ipv4 | ipv6 
classname]

Defines the preconfigured traffic class on which the mirroring actions in the
policy are executed and specifies whether the mirroring policy is applied to IPv4
or IPv6 traffic in the class. The classname is a text string (64 characters
maximum.)

action mirror session Configures mirroring for the destination and session specified by the session
parameter.
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Context: Policy configuration

Syntax

[no] default-class action mirror session [action mirror session ...]
Configures a default class that allows packets that are not matched nor ignored by any of the class configurations
in a mirroring policy to be mirrored to the destination configured for the specified session.

Applying a mirroring policy on a port or VLAN interface
Enter one of the following service-policy commands from the global configuration context.

Context: Global configuration

Syntax

interface <PORT-LIST> service-policy policy-name in
Configures the specified ports with a mirroring policy that is applied to inbound traffic on each interface.

Separate individual port numbers in a series with a comma, for example, a1,b4,d3. Enter a range of ports by
using a dash, for example, a1-a5.

The mirroring policy name you enter must be the same as the policy name you configured with the policy
mirror command.

Syntax

vlan vlan-id service-policy policy-name in
Configures a mirroring policy on the specified VLAN that is applied to inbound traffic on the VLAN interface.

Valid VLAN ID numbers range from 1 to 4094.

The mirroring policy name you enter must be the same as the policy name you configured with the policy
mirror command in the syntax policy mirror.

Viewing a classifier-based mirroring configuration
To display information about a classifier-based mirroring configuration or statistics on one or more mirroring
policies, enter one of the following commands:

Syntax

show class [ipv4 class-name | ipv6 class-name | config]
Syntax

show policy [policy-name | config]
Syntax

show policy resources
Syntax

show statistics policy [policy-name] [interface port-num | vlan vid in]
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Viewing all mirroring sessions configured on the switch
Syntax

show monitor
If a monitored source for a remote session is configured on the switch, the following information is displayed.
Otherwise, the output displays: Mirroring is currently disabled.

Sessions Lists the four configurable sessions on the switch.

Status Displays the current status of each session:

• active: The session is configured.

• inactive: Only the destination has been configured; the mirroring source is not configured.

• not defined: Mirroring is not configured for this session.

Type Indicates whether the mirroring session is local (port), remote (IPv4), or MAC-based (mac) for
local or remote sessions.

Sources Indicates how many monitored source interfaces are configured for each mirroring session.

Policy Indicates whether the source is using a classifier-based mirroring policy to select inbound IPv4
or IPv6 traffic for mirroring.

If a remote mirroring endpoint is configured on the switch, the following information is displayed. Otherwise, the
output displays: There are no Remote Mirroring endpoints currently assigned.

Type Indicates whether the mirroring session is local (port), remote (IPv4), or MAC-based
(mac) for local or remote sessions.

UDP Source Addr The IP address configured for the source VLAN or subnet on which the monitored
source interface exists. In the configuration of a remote session, the same UDP source
address must be configured on the source and destination switches.

UDP port The unique UDP port number that identifies a remote session. In the configuration of a
remote session, the same UDP port number must be configured on the source and
destination switches.

Table Continued
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UDP Dest Addr The IP address configured for the destination VLAN or subnet on which the remote exit
port exists. In the configuration of a remote session, the same UDP destination address
must be configured on the source and destination switches.

Dest Port Identifies the exit port for a remote session on a remote destination switch.

Figure 120: Displaying the currently configured mirroring sessions on the switch

Viewing the remote endpoints configured on the switch
Syntax

show monitor endpoint
Displays the remote mirroring endpoints configured on the switch. Information on local sessions configured on the
switch is not displayed. (To view the configuration of a local session, use the

show monitor [1-4 | name name-str ]]
command, as described on page 74 and page 77.)

Type Indicates whether the session is a port (local) or IPv4 (remote) mirroring session.

show monitor
endpoint

The IP address configured for the source VLAN or subnet on which the monitored source
interface exists. In the configuration of a remote session, the same UDP source address
must be configured on the source and destination switches.

UDP port The unique UDP port number that identifies a remote session. In the configuration of a
remote session, the same UDP port number must be configured on the source and
destination switches.

UDP Dest Addr The IP address configured for the destination VLAN or subnet on which the remote exit port
exists. In the configuration of a remote session, the same UDP destination address must be
configured on the source and destination switches.

Dest Port fies the exit port for a remote session on a remote destination switch.

Example
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In Figure 121: Displaying the configuration of remote mirroring endpoints on the switch on page 513, the
show monitor endpoint output shows that the switch is configured as the remote endpoint (destination) for
two remote sessions from the same monitored source interface.

Figure 121: Displaying the configuration of remote mirroring endpoints on the switch

Viewing the mirroring configuration for a specific session
Syntax

show monitor [1 - 4 | name name-str]
Displays detailed configuration information for a specified local or remote mirroring session on a source switch.

Session Displays the number of the specified session.

Session Name Displays the name of the session, if configured.

Policy Indicates whether the source is using a classifier-based mirroring policy to select
inbound IPv4 or IPv6 traffic for mirroring.

Mirroring Destination For a local mirroring session, displays the port configured as the exit port on the source
switch. For a remote mirroring session, displays IPv4, which indicates mirroring to a
remote (endpoint) switch.

UDP Source Addr The IP address configured for the source VLAN or subnet on which the monitored
source interface exists. In the configuration of a remote session, the same UDP source
address must be configured on the source and destination switches.

UDP port The unique UDP port number that identifies a remote session. In the configuration of a
remote session, the same UDP port number must be configured on the source and
destination switches.

UDP Dest Addr The IP address configured for the destination VLAN or subnet on which the remote exit
port exists. In the configuration of a remote session, the same UDP destination address
must be configured on the source and destination switches.

Table Continued
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Status For a remote session, displays current session activity:

• active: The session is configured and is mirroring traffic. A remote path has been
discovered to the destination.

• inactive: The session is configured, but is not currently mirroring traffic. A remote
path has not been discovered to the destination.

• not defined: Mirroring is not configured for this session.

Monitoring Sources For the specified local or remote session, displays the source (port, trunk, or VLAN)
interface and the MAC address (if configured) used to select mirrored traffic.

Direction For the selected interface, indicates whether mirrored traffic is entering the switch (in),
leaving the switch (out), or both.

Viewing a remote mirroring session
After you configure session 2 for remote mirroring (Figure 122: Configuring a remote mirroring session and
monitored source on page 514), you can enter the show monitor 2 command to verify the configuration
(Figure 123: Displaying the Configuration of a Remote Mirroring Session on page 514.)

Figure 122: Configuring a remote mirroring session and monitored source

Figure 123: Displaying the Configuration of a Remote Mirroring Session
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Viewing a MAC-based mirroring session
After you configure a MAC-based mirroring session (Figure 124: Configuring a MAC-based mirroring session
on page 515), you can enter the show monitor 3 command to verify the configuration (Figure 125:
Displaying a MAC-based mirroring session on page 515.)

Figure 124: Configuring a MAC-based mirroring session

Figure 125: Displaying a MAC-based mirroring session

Viewing a local mirroring session
When used to display the configuration of a local session, the show monitor command displays a subset of the
information displayed for a remote mirroring session.

Example

Figure 126: Displaying the configuration of a local mirroring session on page 515 displays a local
mirroring configuration for a session configured as follows:

• Session number: 1

• Session name: Detail

• Classifier-based mirroring policy, "MirrorAdminTraffic", is used to select inbound traffic on port B1.

• Mirrored traffic is sent to exit port B3.

Figure 126: Displaying the configuration of a local mirroring session
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Viewing information on a classifier-based mirroring
session
In the following example, a classifier-based mirroring policy (mirrorAdminTraffic) mirrors selected inbound
IPv4 packets on VLAN 5 to the destination device configured for mirroring session 3.

Figure 127: Configuring a classifier-based mirroring policy in a local mirroring session

Displaying a classifier-based policy in a local mirroring session

switch(config)# show monitor 3

Network Monitoring

   Session: 3   Session Name: 
   Policy: MirrorAdminTraffic

     Mirror Destination:  C1   (Port) 

     Monitoring Sources  Direction
     ------------------  ---------
     VLAN: 5             Source

Viewing information about a classifier-based mirroring
configuration
Syntax

show class ipv4 classname show class ipv6 classname show class config

ipv4 classname Lists the statements that make up the IPv4 class identified by classname .

ipv6 classname Lists the statements that make up the IPv6 class identified by classname .

config Displays all classes, both IPv4 and IPv6, and lists the statements that make up
each class.
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Additional variants of the show class … command provide information on classes that are members of policies
that have been applied to ports or VLANs.

Figure 128: show class output for a mirroring policy

Viewing information about a classifier-based mirroring
configuration
Syntax

show policy policy-name show policy config

policy-name Lists the statements that make up the specified policy.

config Displays the names of all policies defined for the switch and lists the statements that
make up each policy.

Additional variants of the show policy command provide information on policies that have been applied to ports
or VLANs.

Figure 129: show policy output for a mirroring policy

Viewing information about statistics on one or more
mirroring policies
Syntax
[show | clear] statistics policy policy-name port port-num
[show | clear] statistics policy policy-name vlan vid in

show Displays the statistics for a specified policy applied to a specified port or VLAN.

clear Clears statistics for the specified policy and port or VLAN.

policy-name The name of the policy.

port-num The number of the port on which the policy is applied (single port only, not a
range.)

Table Continued
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vid The number or name of the vlan on which the policy is applied. VLAN ID
numbers range from 1 to 4094.

in Indicates that statistics are shown for inbound traffic only.

Figure 130: show statistics policy output for a mirroring policy on page 518 shows the number of packets
(in parentheses) that have been mirrored for each match/ignore statement in the mirroring policy.

Figure 130: show statistics policy output for a mirroring policy

Switch# show statistics policy MirrorAdminTraffic vlan 30 in

HitCounts for Policy MirrorAdminTraffic

10 class ipv4 "AdminTraffic" action mirror 3

(5244)  10 match ip 15.29.16.1 0.63.255.255 0.0.0.0 255.255.255.255 
(9466)  20 match ip 0.0.0.0 255.255.255.255 15.29.16.1 0.63.255.255

Viewing resource usage for mirroring policies
Syntax

show policy resources
Displays the number of hardware resources (rules, meters, and application port ranges) used by classifier-based
mirroring policies (local and remote) that are currently applied to interfaces on the switch, as well as QoS policies
and other software features.

518 Aruba 3810 / 5400R Management and Configuration Guide for
ArubaOS-Switch 16.08

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4256



NOTE:

The information displayed is the same as the output of the show qos resources and show
access-list resources commands.

Figure 131: Displaying the hardware resources used by currently configured mirroring policies

Viewing the mirroring configurations in the running
configuration file
Use the show run command to view the current mirroring configurations on the switch. In the show run
command output, information about mirroring sources in configured sessions begins with the mirror keyword;
monitored source interfaces are listed per-interface.
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Example

Figure 132: Displaying mirroring sources and sessions in the running configurations

Information about remote endpoints configured for remote sessions on the switch begin with the mirror
endpoint keywords. In the following example, two remote sessions use the same exit port:

Figure 133: Displaying remote mirroring endpoints in the running configuration

Compatibility mode
Table 25: Modules compatibility mode (enabled versus disabled)

Modules Compatibility mode enabled Compatibility mode disabled

v2 zl modules
only

Can insert zl module and the module will come
up. Any v2 zl modules are limited to the zl
configuration capacities.

v2 zl modules are at full capacity.ZL modules
are not allowed to power up.

Mixed v2 zl
and zl
modules

Can insert zl module and the module will come
up. Any v2 zl modules are limited to the zl
configuration capacities.If compatibility mode is
disabled, the zl modules go down.

ZL modules are not allowed to power up.

Table Continued
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Modules Compatibility mode enabled Compatibility mode disabled

ZL modules
only

Same as exists already.If a v2 zl module is
inserted, it operates in the same mode as the zl
module, but with performance increases.

The Management Module is the only module
that powers up.

In Compatibility Mode, no v2 zl features are
allowed, whether the modules are all v2 zl or
not.

If Compatibility Mode is disabled and then
enabled, the startup config is erased and the
chassis reboots.

Port and trunk group statistics and flow control status
The features described in this section enable you to determine the traffic patterns for each port since the last
reboot or reset of the switch. You can display:

• A general report of traffic on all LAN ports and trunk groups in the switch, along with the per-port flow control
status (On or Off.)

• A detailed summary of traffic on a selected port or trunk group.

You can also reset the counters for a specific port.

The menu interface provides a dynamic display of counters summarizing the traffic on each port. The CLI lets you
see a static "snapshot" of port or trunk group statistics at a particular moment.

As mentioned above, rebooting or resetting the switch resets the counters to zero. You can also reset the
counters to zero for the current session. This is useful for troubleshooting.

NOTE: The Reset action resets the counter display to zero for the current session, but does not
affect the cumulative values in the actual hardware counters. (In compliance with the SNMP
standard, the values in the hardware counters are not reset to zero unless you reboot the switch.)
Exiting from the console session and starting a new session restores the counter displays to the
accumulated values in the hardware counters.

Traffic mirroring overview
Starting in software release K.12.xx, traffic mirroring (Intelligent Mirroring) allows you to mirror (send a copy of)
network traffic received or transmitted on a switch interface to a local or remote destination, such as a traffic
analyzer or IDS.)

Traffic mirroring provides the following benefits:

• Allows you to monitor the traffic flow on specific source interfaces.

• Helps in analyzing and debugging problems in network operation resulting from a misbehaving network or an
individual client. The mirroring of selected traffic to an external device makes it easier to diagnose a network
problem from a centralized location in a topology spread across a campus.

• Supports remote mirroring to simultaneously mirror switch traffic on one or more interfaces to multiple remote
destinations. (In remote mirroring, you must first configure the remote mirroring endpoint—remote switch and
exit port—before you specify a mirroring source for a session.)

Mirroring overview
Figure 134: Local and remote sessions showing mirroring terms on page 522 shows an example of the
terms used to describe the configuration of a sample local and remote mirroring session:
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• In the local session, inbound traffic entering Switch A is monitored on port A2 and mirrored to a destination
(host), traffic analyzer 1, through exit port A15 on the switch.A local mirroring session means that the
monitored interface (A2) and exit port (A15) are on the same switch.

• In the remote session, inbound traffic entering Switch A is monitored on port A1. A mirrored copy of monitored
traffic is routed through the network to a remote mirroring endpoint: exit port B7 on Switch B. A destination
device, traffic analyzer 2, is connected to the remote exit port.A remote mirroring session means that:
◦ The monitored interface (A1) and exit port (B7) are on different switches.

◦ Mirrored traffic can be bridged or routed from a source switch to a remote switch.

Figure 134: Local and remote sessions showing mirroring terms

Mirroring destinations
Traffic mirroring supports destination devices that are connected to the local switch or to a remote switch:

Traffic can be copied to a destination (host) device connected to the same switch as the mirroring source in a
local mirroring session. You can configure up to four exit ports to which destination devices are connected.

Mirroring sources and sessions
Traffic mirroring supports the configuration of port in up to four mirroring sessions on a switch. Each session can
have one or more sources (ports and/or static trunks) that monitor traffic entering and/or leaving the switch.

NOTE: Using the CLI, you can make full use of the switch's local and remote mirroring capabilities.

Mirroring sessions
A mirroring session consists of a mirroring source and destination (endpoint.) Although a mirroring source can be
one of several interfaces, as mentioned above, for any session, the destination must be a single (exit) port. The
exit port cannot be a trunk.

You can map multiple mirroring sessions to the same exit port, which provides flexibility in distributing hosts, such
as traffic analyzers or an IDS. In a remote mirroring endpoint, the IP address of the exit port and the remote
destination switch.
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Mirroring sessions can have the same or a different destination. You can configure an exit port on the local
(source) switch and/or on a remote switch as the destination in a mirroring session. When configuring a mirroring
destination, consider the following options:

You can segregate traffic by type, direction, or source.

Mirroring session limits
A switch running software release K.12.xx or greater supports the following:

A maximum of one mirroring (local and remote) sessions.

Selecting mirrored traffic
You can use any of the following options to select the traffic to be mirrored on a port, trunk, mesh, or VLAN
interface in a local or remote session:

• All trafficMonitors all traffic entering or leaving the switch on one or more interfaces (inbound and outbound.)

• Direction-based traffic selectionMonitors traffic that is either entering or leaving the switch (inbound or
outbound.) Monitoring traffic in only one direction improves operation by reducing the amount of traffic sent to
a mirroring destination.

• MAC-based traffic selectionMonitors only traffic with a matching source and/or destination MAC address in
packet headers entering and/or leaving the switch on one or more interfaces (inbound and/or outbound.)

• Classifier-based service policyProvides a finer granularity of match criteria to zoom in on a subset of a
monitored port or VLAN traffic (IPv4 or IPv6) and select it for local or remote mirroring (inbound only.)

Deprecation of ACL-based traffic selection

In software release K.14.01 or greater, the use of ACLs for selecting traffic in a mirroring session has been
deprecated and is replaced by the use of advanced classifier-based service policies.

As with ACL criteria, classifier-based match/ignore criteria allow you to limit a mirroring session to selected
inbound packets on a given port or VLAN interface (instead of mirroring all inbound traffic on the interface.)

The following commands have been deprecated:

•
interface port/trunk/mesh monitor ip access-group acl-name in mirror [1 - 4 | name-str]

•
vlan vid-# monitor ip access-group acl-name in mirror [1 - 4 | name-str]

After you install and boot release K.14.01 or greater, ACL-based local and remote mirroring sessions configured
on a port or VLAN interface are automatically converted to classifier-based mirroring policies.

If you are running software release K.13.XX or earlier, ACL permit/deny criteria are supported to select IP traffic
entering a switch to mirror in a local or remote session, using specified source and/or destination criteria.

Mirrored traffic destinations

Local destinations
A local mirroring traffic destination is a port on the same switch as the source of the traffic being mirrored.
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Remote destinations
A remote mirroring traffic destination is an switch configured to operate as the exit switch for mirrored traffic
sessions originating on other switches.

CAUTION: After you configure a mirroring session with traffic-selection criteria and a destination, the
switch immediately starts to mirror traffic to each destination device connected to an exit port. In a
remote mirroring session that uses IPv4 encapsulation, if the intended exit switch is not already
configured as the destination for the session, its performance may be adversely affected by the
stream of mirrored traffic. For this reason, Switch strongly recommends that you configure the exit
switch for a remote mirroring session before configuring the source switch for the same session.

Monitored traffic sources
You can configure mirroring for traffic entering or leaving the switch on:

Ports and static trunks

Provides the flexibility for mirroring on individual ports, groups of ports, static port trunks, or any combination of
these..

Criteria for selecting mirrored traffic
On the monitored sources listed above, you can configure the following criteria to select the traffic you want to
mirror:

• Direction of traffic movement (entering or leaving the switch, or both.)

• Type of IPv4 or IPv6 traffic entering the switch, as defined by a classifier-based service policy.

• Source and/or destination MAC addresses in packet headers.

Mirroring configuration
The table below shows the different types of mirroring that you can configure using the CLI, Menu, and SNMP
interfaces.

Table 26: Mirroring configuration options

Monitoring
interface and
configuration
level

Traffic selection
criteria

Traffic direction

CLI config Menu and web i/f
config 1

Snmp config

Port(s) Trunk(s)
Mesh

All traffic Not Applicable Not Applicable Not Applicable

1 Configures only session 1, and only for local mirroring.

Configuration notes

Using the CLI, you can configure all mirroring options on a switch.

You can use the CLI can configure sessions 1 to 4 for local or remote mirroring in any combination, and override a
Menu configuration of session 1.
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You can also use SNMP configure sessions 1 to 4 for local or remote mirroring in any combination and override a
Menu configuration of session 1, except that SNMP cannot be used to configure a classifier-based mirroring
policy.

Remote mirroring endpoint and intermediate devices
The remote mirroring endpoint that is used in a remote mirroring session must be an switch that supports the
mirroring functions described in this chapter. (A remote mirroring endpoint consists of the remote switch and exit
port connected to a destination device.) Because remote mirroring on an switch uses IPv4 to encapsulate
mirrored traffic sent to a remote endpoint switch, the intermediate switches and routers in a layer 2/3 domain can
be from any vendor if they support IPv4.

The following restrictions apply to remote endpoint switches and intermediate devices in a network configured for
traffic mirroring:

• The exit port for a mirroring destination must be an individual port and not a trunk, mesh, or VLAN interface.

• A switch mirrors traffic on static trunks, but not on dynamic LACP trunks.

• A switch mirrors traffic at line rate. When mirroring multiple interfaces in networks with high-traffic levels, it is
possible to copy more traffic to a mirroring destination than the link supports. However, some mirrored traffic
may not reach the destination. If you are mirroring a high-traffic volume, you can reduce the risk of
oversubscribing a single exit port by:
◦ Directing traffic from different session sources to multiple exit ports.

◦ Configuring an exit port with a higher bandwidth than the monitored source port.

Migration to release K.12.xx
On a switch that is running a software release earlier than K.12.xx with one or more mirroring sessions
configured, when you download and boot release K.12.xx, the existing mirroring configurations are managed as
follows:

• A legacy mirroring configuration on a port or VLAN interface maps to session 1.

• Traffic-selection criteria for session 1 is set to both; both inbound and outbound traffic (traffic entering and
leaving the switch) on the configured interface is selected for mirroring.

• In a legacy mirroring configuration, a local exit port is applied to session 1.

Booting from software versions earlier than K.12.xx
If it is necessary to boot the switch from a legacy (pre-K.12.xx) software version after using version K.12.xx or
greater to configure mirroring, remove mirroring from the configuration before booting with the earlier software.

Maximum supported frame size
The IPv4 encapsulation of mirrored traffic adds a 54-byte header to each mirrored frame. If a resulting frame
exceeds the MTU allowed in the path from the mirroring source to the mirroring destination, the frame is dropped,
unless the optional [truncation] parameter is set in the mirror command.

Frame truncation
Mirroring does not truncate frames unless the truncation parameter in the mirror command is set. If that
parameter is not set, oversized mirroring frames are dropped. Also, remote mirroring does not allow downstream
devices in a mirroring path to fragment mirrored frames.
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Migration to release K.14.01 or greater
NOTE:

If a switch is running software release K.12.xx, you must first upgrade to release K.13.xx before
migrating the switch to release K.14.01 or greater.

When you download and boot software release K.14.01 or greater on a switch that is running release K.13.xx and
has one or more mirroring sessions configured, an ACL-based mirroring configuration on a port or VLAN interface
is mapped to a class and policy configuration based on the ACL.

The new mirroring policy is automatically configured on the same port or VLAN interface on which the mirroring
ACL was assigned. The behavior of the new class and mirroring-policy configuration exactly matches the traffic-
selection criteria and mirroring destination used in the ACL-based session.)

Figure 135: Mirroring configuration in show run output in release K.13.xx on page 526 and Figure 136:
Mirroring configuration in show run output in release K.14.01 or greater on page 526 show how ACL-
based selection criteria in a mirroring session are converted to a classifier-based policy and class configuration
when you install release K.14.01 or greater on a switch.

Figure 135: Mirroring configuration in show run output in release K.13.xx

Figure 136: Mirroring configuration in show run output in release K.14.01 or greater

Using the Menu to configure local mirroring

Menu and WebAgent limits
You can use the Menu and WebAgent to quickly configure or reconfigure local mirroring and allow one of the
following two mirroring source options:
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• Any combination of source ports, trunks, and a mesh.

• One static, source VLAN interface.

Remote mirroring overview
To configure a remote mirroring session in which the mirroring source and destination are on different switches,
follow these general steps:

After you complete 6.b on page 527, the switch begins mirroring traffic to the remote destination (endpoint)
configured for the session.

1. Determine the IP addressing, UDP port number, and destination (exit) port number for the remote session:

a. Source VLAN or subnet IP address on the source switch.

b. Destination VLAN or subnet IP address on the destination switch.

c. Random UDP port number for the session (7933-65535.)

d. Remote mirroring endpoint: Exit port and IP address of the remote destination switch (In a remote mirroring
endpoint, the IP address of the exit port and remote switch can belong to different VLANs. Any loopback IP
address can be used except the default loopback address 127.0.0.1.)

2. Requirement: For remote mirroring, the same IP addressing and UDP port number must be configured on both
the source and destination switches.

3. On the remote destination (endpoint) switch, enter the mirror endpoint command with the information
from 1 on page 527 to configure a mirroring session for a specific exit port.

4. Determine the session (1 to 4) and (optional) alphanumeric name to use on the source switch.

5. Determine the traffic to be filtered by any of the following selection methods and the appropriate configuration
level (VLAN, port, mesh, trunk, global):

a. Direction: inbound, outbound, or both.

b. Classifier-based mirroring policy: inbound only for IPv4 or IPv6 traffic.

c. MAC source and/or destination address: inbound, outbound, or both.

6. On the source switch:

a. Enter the mirror command with the session number (1 to 4) and the IP addresses and UDP port number
from 1 on page 527 to configure a mirroring session. If desired, enter the [truncation] parameter to
allow oversize packets to be truncated rather than dropped.

b. Enter one of the following commands to configure one or more of the traffic-selection methods in 5 on page
527 for the configured session:

interface port/trunk/mesh [monitor | service-policy policy-name in] vlan vid 
[monitor | service-policy policy-name in] monitor mac mac-addr

Quick reference to remote mirroring setup
The commands beginning with Destination mirror on a remote switch on page 501, configure mirroring for a
remote session in which the mirroring source and destination are on different switches:
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• The mirror command identifies the destination in a mirroring session.

• The interface and vlan commands identify the monitored interface, traffic direction, and traffic-selection
criteria for a specified session.

CAUTION:

When configuring a remote mirroring session, always configure the destination switch first.
Configuring the source switch first can result in a large volume of mirrored, IPv4-encapsulated traffic
arriving at the destination without an exit path, which can slow switch performance.

High-level overview of the mirror configuration process

Determine the mirroring session and destination

For a local mirroring session
Determine the port number for the exit port (such as A5, B10, and so forth).

For a remote mirroring session
Determine the following information and then go to "Configure a mirroring destination on a remote switch" on
page 498.

• The IP address of the VLAN or subnet on which the exit port exists on the destination switch.

• The port number of the remote exit port on the remote destination switch. (In a remote mirroring endpoint, the
IP address of the exit port and the remote destination switch can belong to different VLANs.)

• The IP address of the VLAN or subnet on which the mirrored traffic enters or leaves the source switch.

CAUTION: Although the switch supports the use of UDP port numbers from 1 to 65535, UDP port
numbers below 7933 are reserved for various IP applications. Using these port numbers for
mirroring can result in an interruption of other IP functions, and in non-mirrored traffic being
received on the destination (endpoint) switch and sent to the device connected to the remote exit
port.

• The unique UDP port number to use for the session on the source switch. (The recommended port range is
from 7933 to 65535.)

Configure a mirroring destination on a remote switch
This step is required only if you are configuring a remote mirroring session in which the exit port is on a different
switch than the monitored (source) interface. If you are configuring local mirroring, go to Configure a mirroring
session on the source switch on page 529.

For remote mirroring, you must configure the destination switch to recognize each mirroring session and forward
mirrored traffic to an exit port before you configure the source switch. Configure the destination switch with the
values you determined for remote mirroring in High-level overview of the mirror configuration process on
page 528.

NOTE:

A remote destination switch can support up to 32 remote mirroring endpoints (exit ports connected to
a destination device in a remote mirroring session.)
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Configure a destination switch in a remote mirroring session
Enter the mirror endpoint ip command on the remote switch to configure the switch as a remote endpoint
for a mirroring session with a different source switch.

Configure a mirroring session on the source switch
To configure local mirroring, only a session number and exit port number are required.

If the exit port for a mirroring destination is on a remote switch instead of the local (source) switch, you must enter
the source IP address, destination IP address, and UDP port number for the remote mirroring session. You may
also wish to enable frame truncation to allow oversize frames to be truncated rather than dropped.

Frames that exceed the maximum size (MTU) are either dropped or truncated, according to the setting of the
[truncation] parameter in the mirror command. Frames that are near the MTU size may become oversize
when the 54-byte remote mirroring tunnel header is added for transport between source switch and destination
switch. (The addition of the header is a frequent cause for frames becoming oversize, but note that all oversize
frames, whatever the cause of their excess size, are dropped or truncated.) If a frame is truncated, bytes are
removed from the end of the frame. This may cause the checksum in the original frame header to fail. Some
protocol analyzers may flag such a checksum mismatch as an alert.

NOTE:

Note that if you enable jumbo frames to allow large frames to be transmitted, you must enable jumbo
frames on all switches in the path between source and destination switches.

Configure a source switch in a remote mirroring session
Enter the mirror remote ip command on the source switch to configure a remote destination switch for a
mirroring session on the source switch. The source IP address, UDP port number, and destination IP address that
you enter must be the same values that you entered with the mirror endpoint ip command.

CAUTION: After you configure a mirroring session with traffic-selection criteria and a destination, the
switch immediately starts to mirror traffic to the destination device connected to each exit port. In a
remote mirroring session that uses IPv4 encapsulation, if the remote (endpoint) switch is not already
configured as the destination for the session, its performance may be adversely affected by the
stream of mirrored traffic. For this reason, Hewlett Packard Enterprise strongly recommends that you
configure the endpoint switch in a remote mirroring session, as described on the previous page in the
section titled "For a remote mirroring session", before using the mirror remote ip command in
this section to configure the mirroring source for the same session.

Configure the monitored traffic in a mirror session
This step configures one or more interfaces on a source switch with traffic-selection criteria to select the traffic to
be mirrored in a local or remote session configured in section.

Traffic selection options
To configure traffic mirroring, specify the source interface, traffic direction, and criteria to be used to select the
traffic to be mirrored by using the following options:

• Interface type
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◦ Port, trunk, and/or mesh

◦ VLAN

◦ Switch (global configuration level)

• Traffic direction and selection criteria
◦ All inbound and/or outbound traffic on a port or VLAN interface

◦ Only inbound IP traffic selected with an ACL (deprecated in software release K.14.01 and greater)

◦ Only inbound IPv4 or IPv6 traffic selected with a classifier-based mirroring policy

◦ All inbound and/or outbound traffic selected by MAC source and/or destination address

The different ways to configure traffic-selection criteria on a monitored interface are described in the following
sections.

Mirroring-source restrictions
In a mirroring session, you can configure any of the following sources of mirrored traffic:

• Multiple port and trunk, and/or mesh interfaces

• One VLAN

If you configure a VLAN as the source interface in a mirroring session and assign a second VLAN to the
session, the second VLAN overwrites the first VLAN as the source of mirrored traffic.

• One classifier-based policy

If you configure a mirroring policy on a port or VLAN interface to mirror inbound traffic in a session, you cannot
configure a port, trunk, mesh, ACL, or VLAN as an additional source of mirrored traffic in the session.

• Up to 320 MAC addresses (used to select traffic according to source, destination MAC address, or both) in all
mirroring sessions configured on a switch

About selecting all inbound/outbound traffic to mirror
If you have already configured session 1 with a local or remote destination, you can enter the vlan vid
monitor or interface port monitor command without additional parameters for traffic-selection criteria
and session number to configure mirroring for all inbound and outbound traffic on the specified VLAN or port
interfaces in session 1 with the preconfigured destination.

Untagged mirrored packets
Although a VLAN tag is added (by default) to the mirrored copy of untagged outbound packets to indicate the
source VLAN of the packet, it is sometimes desirable to have mirrored packets look exactly like the original
packet. The no-tag-added parameter gives you the option of not tagging mirrored copies of outbound packets,
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as shown in Figure 137: Mirroring commands with the no-tag-added option on page 531 and Figure 138:
Displaying a mirror session configuration with the no-tag-added option on page 531.

Figure 137: Mirroring commands with the no-tag-added option

Figure 138: Displaying a mirror session configuration with the no-tag-added option

About using SNMP to configure no-tag-added
The MIB object hpicfBridgeDontTagWithVlan is used to implement the no-tag-added option, as shown below:

hpicfBridgeDontTagWithVlan OBJECT-TYPE
   SYNTAX INTEGER
     {
     enabled(1),
     disabled(2)
    }
   MAX-ACCESS  read-write
   STATUS   current
   DESCRIPTION
    "This oid mentions whether VLAN tag is part of the
   mirror'ed copy of the packet. The value ‘enabled'
   denotes that the VLAN tag shouldn't be part
   of the mirror'ed copy; ‘disabled' does put
   the VLAN tag in the mirror'ed copy. Only one
   logical port is allowed.
   This object is persistent and when written
   the entity
     SHOULD save the change to non-volatile storage."
   DEFVAL { 2 }
  ::= { hpicfBridgeMirrorSessionEntry 2 }

Operating notes
The following conditions apply for the no-tag-added option:

• The specified port can be a physical port, trunk port, or mesh port.

• Only a single logical port (physical port or trunk) can be associated with a mirror session when the no-tag-
added option is specified. No other combination of ACL mirroring, VLAN mirroring, or port mirroring can be
associated with the mirror session. If more than one logical port is specified, the following error message is
displayed:
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Cannot monitor more than one logical port with no-tag-added option

• If a port changes its VLAN membership and/or untagged status within the VLAN, the "untagged port mirroring"
associated with that port is updated when the configuration change is processed.

• Only four ports or trunks can be monitored at one time when all four mirror sessions are in use (one logical
port per mirror session) without VLAN tags being added to a mirrored copy.

• The no-tag-added option can also be used when mirroring is configured with SNMP.

• A VLAN tag is still added to the copies of untagged packets obtained via VLAN-based mirroring.

About selecting inbound traffic using an ACL (deprecated)
Deprecation of ACL-based traffic selection

In release K.14.01 or greater, the use of ACLs to select inbound traffic in a mirroring session has been replaced
with classifier-based mirroring policies.

The following commands have been deprecated:

•
interface port/trunk/mesh monitor ip access-group acl-name in mirror {1 - 4 | name-str}

•
vlan vid-# monitor ip access-group <ACL-NAME> in mirror {1 - 4 | <NAME-STR>}

After you install and boot release K.14.01 or greater, ACL-based local and remote mirroring sessions configured
on a port or VLAN interface are automatically converted to classifier-based mirroring policies.

About selecting inbound/outbound traffic using a MAC address
Use the monitor mac mirror command at the global configuration level to apply a source and/or destination
MAC address as the selection criteria used in a local or remote mirroring session.

While classifier-based mirroring allows you to mirror traffic using a policy to specify IP addresses as selection
criteria, MAC-based mirroring allows you monitor switch traffic using a source and/or destination MAC address.
You can apply MAC-based mirroring in one or more mirroring sessions on the switch to monitor:

• Inbound traffic

• Outbound traffic

• Both inbound and outbound traffic

MAC-based mirroring is useful in Switch Network Immunity security solutions that provide detection and response
to malicious traffic at the network edge. After isolating a malicious MAC address, a security administrator can
mirror all traffic sent to and received from the suspicious address for troubleshooting and traffic analysis.

The MAC address that you enter with the monitor mac mirror command is configured to select traffic for
mirroring from all ports and learned VLANs on the switch. Therefore, a suspicions MAC address used in wireless
applications can be continuously monitored as it re-appears in switch traffic on different ports or VLAN interfaces.

You can configure MAC-based mirroring from the CLI or an SNMP management station and use it to mirror:

• All inbound and outbound traffic from a group of hosts to one destination device.

• Inbound and/or outbound traffic from each host to a different destination device.

• Inbound and outbound traffic from all monitored hosts separately on two destination devices: mirroring all
inbound traffic to one device and all outbound traffic to another device.
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Restrictions

The following restrictions apply to MAC-based mirroring:

• Up to 320 different MAC addresses are supported for traffic selection in all mirroring sessions configured on
the switch.

• A destination MAC address is not supported as mirroring criteria for routed traffic, because in routed packets,
the destination MAC address is changed to the next-hop address when the packet is forwarded. Therefore, the
destination MAC address that you want to mirror will not appear in routed packet headers.

This restriction also applies to the destination MAC address of a host that is directly connected to a routing
switch. (Normally, a host is connected to an edge switch, which is directly connected to the router.)

To mirror routed traffic, we recommend that you use classifier-based policies to select IPv4 or IPv6 traffic for
mirroring, as described in.

• On a switch, you can use a MAC address only once as a source MAC address and only once as a destination
MAC address to filter mirrored traffic.

For example, after you enter the following commands:

monitor mac 111111-222222 src mirror 1
monitor mac 111111-222222 dest mirror 2
The following commands are not supported:

monitor mac 111111-222222 src mirror 3
monitor mac 111111-222222 dest mirror 4
In addition, if you enter the monitor mac 111111-222222 both mirror 1 command, you cannot use
the MAC address 111111-222222 in any other monitor mac mirror configuration commands on the
switch.

• To re-use a MAC address that has already been configured as a source and/or destination address for traffic
selection in a mirror session, you must first remove the configuration by entering the no form of the command
and then re-enter the MAC address in a new monitor mac mirror command.

For example, if you have already configured MAC address 111111-222222 to filter inbound and outbound
mirrored traffic, and you decide to use it to filter only inbound traffic in a mirror session, you could enter the
following commands:

monitor mac 111111-222222 both mirror 1
no monitor mac 111111-222222 both mirror 1
monitor mac 111111-222222 src mirror 1

• A mirroring session in which you configure MAC-based mirroring is not supported on a port, trunk, mesh, or
VLAN interface on which a mirroring session with a classifier-based mirroring policy is configured.

About selecting inbound traffic using advanced classifier-based mirroring
In software release K.14.01 or greater, in addition to the traffic selection options described in Configure the
monitored traffic in a mirror session on page 529, traffic mirroring supports the use of advanced classifier-
based functions that provide:
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• A finer granularity for selecting the inbound IP traffic that you want to mirror on an individual port or VLAN
interface (instead of mirroring all inbound traffic on the interface)

• Support for mirroring both IPv4 and IPv6 traffic

• The ability to re-use the same traffic classes in different software-feature configurations; for example, you can
apply both a QoS rate-limiting and mirroring policy on the same class of traffic.

Deprecation of ACL-based traffic selection

In software release K.14.01 or greater, advanced classifier-based policies replace ACL-based traffic selection in
mirroring configurations.

Like ACL-based traffic-selection criteria, classifier-based service policies apply only to inbound traffic flows and
are configured on a per-port or per-VLAN basis. In a mirroring session, classifier-based service policies do not
support:

• The mirroring of outbound traffic exiting the switch

• The use of meshed ports as monitored (source) interfaces

Classifier-based mirroring is not designed to work with other traffic-selection methods in a mirroring session
applied to a port or VLAN interface:

• If a mirroring session is already configured with one or more traffic-selection criteria (MAC-based or all inbound
and/or outbound traffic), the session does not support the addition of a classifier-based policy.

• If a mirroring session is configured to use a classifier-based mirroring policy, no other traffic-selection criteria
(MAC-based or all inbound and/or outbound traffic) can be added to the session on the same or a different
interface.

Classifier-based mirroring policies provide greater precision when analyzing and debugging a network traffic
problem. Using multiple match criteria, you can finely select and define the classes of traffic that you want to
mirror on a traffic analyzer or IDS device.

Classifier-based mirroring configuration
1. Evaluate the types of traffic in your network and identify the traffic types that you want to mirror.
2. Create an IPv4 or IPv6 traffic class using the class command to select the packets that you want to mirror in

a session on a preconfigured local or remote destination device.

A traffic class consists of match criteria, which consist of match and ignore commands.

• match commands define the values that header fields must contain for a packet to belong to the class and
be managed by policy actions.

• ignore commands define the values which, if contained in header fields, exclude a packet from the policy
actions configured for the class.

NOTE: Be sure to enter match/ignore statements in the precise order in which you want their
criteria to be used to check packets.

The following match criteria are supported in match/ignore statements for inbound IPv4/IPv6 traffic:

a. IP source address (IPv4 and IPv6)

b. IP destination address (IPv4 and IPv6)
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c. IP protocol (such as ICMP or SNMP)

d. Layer 3 IP precedence bits

e. Layer 3 DSCP codepoint

f. Layer 4 TCP/UDP application port (including TCP flags)

g. VLAN ID

3. Enter one or more match or ignore commands from the class configuration context to filter traffic and
determine the packets on which policy actions will be performed.

4. Create a mirroring policy to configure the session and destination device to which specified classes of inbound
traffic are sent by entering the policy mirror command from the global configuration context.

NOTE: Be sure to enter each class and its associated mirroring actions in the precise order in
which you want packets to be checked and processed.

5. To configure the mirroring actions that you want to execute on packets that match the criteria in a specified
class, enter one or more class action mirror commands from the policy configuration context.

You can configure only one mirroring session (destination) for each class. However, you can configure the
same mirroring session for different classes.

A packet that matches the match criteria in a class is mirrored to the exit (local or remote) port that has been
previously configured for the session, where session is a value from 1 to 4 or a text string (if you configured the
session with a name when you entered the mirror command.)

Prerequisite: The local or remote exit port for a session must be already configured before you enter the
mirror session parameter in a class action statement:

• In a local mirroring session, the exit port is configured with the mirror <SESSION-NUMBER> port
command.

• In a remote mirroring session, the remote exit port is configured with the mirror endpoint ip and
mirror <SESSION-NUMBER> remote ip commands.

Restriction: In a policy, you can configure only one mirroring session per class. However, you can configure the
same session for different classes.

Mirroring is not executed on packets that match ignore criteria in a class.

The execution of mirroring actions is performed in the order in which the classes are numerically listed in the
policy.

The complete no form of the class action mirror command or the no <SEQ-NUMBER> command
removes a class and mirroring action from the policy configuration.

6. To manage packets that do not match the match or ignore criteria in any class in the policy, and therefore have
no mirroring actions performed on them, you can enter an optional default class. The default class is placed at
the end of a policy configuration and specifies the mirroring actions to perform on packets that are neither
matched nor ignored.

7. (Optional) To configure a default-class in a policy, enter the default-class command at the end of a policy
configuration and specify one or more actions to be executed on packets that are not matched and not
ignored.
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Prerequisite: The local or remote exit port for a session must be already configured with a destination device
before you enter the mirror <SESSION> parameter in a default-class action statement.

8. Apply the mirroring policy to inbound traffic on a port (interface service-policy in command) or VLAN
(vlan service-policy in command) interface.

CAUTION: After you apply a mirroring policy for one or more preconfigured sessions on a port or
VLAN interface, the switch immediately starts to use the traffic-selection criteria and exit port to
mirror traffic to the destination device connected to each exit port.

In a remote mirroring session that uses IPv4 encapsulation, if the remote switch is not already
configured as the destination for the session, its performance may be adversely affected by the
stream of mirrored traffic.

For this reason, Switch strongly recommends that you first configure the exit switch in a remote
mirroring session, as described in Configure a mirroring destination on a remote switch on
page 528 and Configure a mirroring session on the source switch on page 529, before you
apply a mirroring service policy on a port or VLAN interface.

Restrictions: The following restrictions apply to a mirroring service policy:

• Only one mirroring policy is supported on a port or VLAN interface.

• If you apply a mirroring policy to a port or VLAN interface on which a mirroring policy is already configured, the
new policy replaces the existing one.

• A mirroring policy is supported only on inbound traffic.

Because only one mirroring policy is supported on a port or VLAN interface, ensure that the policy you want to
apply contains all the required classes and actions for your configuration.

Classifier-based mirroring restrictions
The following restrictions apply to mirroring policies configured with the classifier-based model:

• A mirroring policy is supported only on inbound IPv4 or IPv6 traffic.

• A mirroring policy is not supported on a meshed port interface. (Classifier-based policies are supported only on
a port, VLAN, or trunk interface.)

• Only one classifier-based mirroring policy is supported on a port or VLAN interface. You can, however, apply a
classifier-based policy of a different type, such as QoS.

• You can enter multiple class action mirror statements in a policy.

◦ You can configure only one mirroring session (destination) for each class.

◦ You can configure the same mirroring session for different classes.
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• If a mirroring session is configured with a classifier-based mirroring policy on a port or VLAN interface, no
other traffic-selection criteria (MAC-based or all inbound and/or outbound traffic) can be added to the session.

Figure 139: Mirroring configuration in which only a mirroring policy is supported

• If a mirroring session is already configured with one or more traffic-selection criteria (MAC-based or all inbound
and/or outbound traffic), the session does not support the addition of a classifier-based policy.

Figure 140: Mirroring configuration in which only traffic-selection criteria are supported

About applying multiple mirroring sessions to an interface
You can apply a mirroring policy to an interface that is already configured with another traffic-selection method
(MAC-based or all inbound and/or outbound traffic) for a different mirroring session.

The classifier-based policy provides a finer level of granularity that allows you to zoom in on a subset of port or
VLAN traffic and select it for local or remote mirroring.

In the following example, traffic on Port b1 is used as the mirroring source for two different, local mirroring
sessions:
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• All inbound and outbound traffic on Ports b1, b2, and b3 is mirrored in session 4.

• Only selected voice traffic on Port b1 is mirrored in session 2.

Figure 141: Example of applying multiple sessions to the same interface

Mirroring configuration examples

Local mirroring using traffic-direction criteria

An administrator wants to mirror the inbound traffic from workstation "X" on port A5 and workstation "Y" on port
B17 to a traffic analyzer connected to port C24 (see Figure 142: Local mirroring topology on page 538.) In
this case, the administrator chooses "1" as the session number. (Any unused session number from 1 to 4 is valid.)
Because the switch provides both the source and destination for the traffic to monitor, local mirroring can be used.
In this case, the command sequence is:

• Configure the local mirroring session, including the exit port.

• Configure the monitored source interfaces for the session.

Figure 142: Local mirroring topology

Figure 143: Configuring a local mirroring session for all inbound and outbound port traffic
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Remote mirroring using a classifier-based policy

In the network shown in Figure 144: Sample topology in a remote mirroring session on page 539, an
administrator has connected a traffic analyzer to port A15 (in VLAN 30) on switch C to monitor the TCP traffic to
the server at 10.10.30.153 from workstations connected to switches A and B. Remote mirroring sessions are
configured on switches A and B, and a remote mirroring endpoint on switch C. TCP traffic is routed through the
network to the server from VLANs 10 and 20 on VLAN 30.

Figure 144: Sample topology in a remote mirroring session

To configure this remote mirroring session using a classifier-based policy to select inbound TCP traffic on two
VLAN interfaces, take the following steps:

1. On remote switch C, configure a remote mirroring endpoint using port A15 as the exit port (as described in 
Configure a mirroring destination on a remote switch on page 528.)

Figure 145: Configuring a remote mirroring endpoint: remote switch and exit port

2. On source switch A, configure an association between the remote mirroring endpoint on switch C and a
mirroring session on switch A (as described in Configure a mirroring session on the source switch on
page 529.)
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3. On switch A, configure a classifier-based mirroring policy to select inbound TCP traffic destined to the server at
10.10.30.153, and apply the policy to the interfaces of VLAN 10 (as described in About selecting inbound
traffic using advanced classifier-based mirroring on page 533.)

Figure 146: Configuring a classifier-based policy on source switch A

4. On source switch B, repeat steps 2 and 3:

a. Configure an association between the remote mirroring endpoint on switch C and a mirroring session on
switch B.

b. Configure a classifier-based mirroring policy to select inbound TCP traffic destined to the server at
10.10.30.153, and apply the policy to a VLAN interface for VLAN 20.
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Because the remote session has mirroring sources on different switches, you can use the same session
number (1) for both sessions.

Figure 147: Configuring a classifier-based policy on source switch B

Remote mirroring using traffic-direction criteria

In the network shown in Figure 148: Sample topology for remote mirroring from a port interface on page
541, the administrator connects another traffic analyzer to port B10 (in VLAN 40) on switch C to monitor all traffic
entering switch A on port C12. For this mirroring configuration, the administrator configures a mirroring destination
(with a remote exit port of B10) on switch C, and a remote mirroring session on switch A.

If the mirroring configuration in the proceeding example is enabled, it is necessary to use a different session
number (2) and UDP port number (9400.) (The IP address of the remote exit port [10.10.40.7] connected to traffic
analyzer 2 [exit port B10] can belong to a different VLAN than the destination IP address of the VLAN used to
reach remote switch C [10.20.40.1]).

Figure 148: Sample topology for remote mirroring from a port interface

To configure this remote mirroring session using a directional-based traffic selection on a port interface, the
operator must take the following steps:
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1. On remote switch C, configure the remote mirroring endpoint using port B10 as the exit port for a traffic
analyzer (as described in Configure a mirroring destination on a remote switch on page 528):

Figure 149: Configuring a remote mirroring endpoint

2. On source switch A, configure session 2 to use UDP port 9400 to reach the remote mirroring endpoint on
switch C (10.10.40.1):mirror 2 remote ip 10.10.10.119 9400 10.10.40.1

3. On source switch A, configure the local port C12 to select all inbound traffic to send to the preconfigured
mirroring destination for session 2:interface c12 monitor all in mirror 2
Figure 150: Configuring a remote mirroring session for inbound port traffic

Maximum supported frame size
The IPv4 encapsulation of mirrored traffic adds a 54-byte header to each mirrored frame. If a resulting frame
exceeds the MTU allowed in the network, the frame is dropped or truncated.

NOTE:

Oversized mirroring frames are dropped or truncated, according to the setting of the [truncation]
parameter in the mirror command. Also, remote mirroring does not allow downstream devices in a
mirroring path to fragment mirrored frames.

If jumbo frames are enabled on the mirroring source switch, the mirroring destination switch and all
downstream devices connecting the source switch to the mirroring destination must be configured to
support jumbo frames.

Enabling jumbo frames to increase the mirroring path MTU
On 1-Gbps and 10-Gbps ports in the mirroring path, you can reduce the number of dropped frames by enabling
jumbo frames on all intermediate switches and routers. (The MTU on the switches covered by this manual is 9220
bytes for frames having an 802.1Q VLAN tag, and 9216 bytes for untagged frames.)
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Table 27: Maximum frame sizes for mirroring

Frame type
configuration

Maximum
frame size

VLAN tag Frame
mirrored
to local
port

Frame mirrored to remote
port

Data Data IPv4 header

Untagged Non-jumbo (default
config.)

1518 0 1518 1464 54

Jumbo on all VLANs 9216 0 9216 9162 54

Jumbo11 On all but
source VLAN

1518 0 n/a 1464 54

Tagged Non-jumbo 1522 4 1522 1468 54

Jumbo11 on all VLANs 9220 4 9218 9164 54

Jumbo11 On all but
source VLAN

1522 4 n/a22 1468 54

1 Jumbo frames are allowed on ports operating at or above 1 Gbps
2 For local mirroring, a non-jumbo configuration on the source VLAN dictates an MTU of 1518 bytes for untagged frames, and

an MTU of 1522 for tagged frames, regardless of the jumbo configuration on any other VLANs on the switch.

Effect of downstream VLAN tagging on untagged,
mirrored traffic
In a remote mirroring application, if mirrored traffic leaves the switch without 802.1Q VLAN tagging, but is
forwarded through a downstream device that adds 802.1Q VLAN tags, the MTU for untagged mirrored frames
leaving the source switch is reduced below the values shown in Maximum frame sizes for mirroring.

For example, if the MTU on the path to the destination is 1522 bytes, untagged mirrored frames leaving the
source switch cannot exceed 1518 bytes. Likewise, if the MTU on the path to the destination is 9220 bytes,
untagged mirrored frames leaving the source switch cannot exceed 9216 bytes.

Figure 151: Effect of downstream VLAN tagging on the MTU for mirrored traffic

Operating notes for traffic mirroring
• Mirroring dropped traffic

Chapter 14 Monitoring and Analyzing Switch Operation 543

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4281



When an interface is configured to mirror traffic to a local or remote destination, packets are mirrored
regardless of whether the traffic is dropped while on the interface. For example, if an ACL is configured on a
VLAN with a deny ACE that eliminates packets from a Telnet application, the switch still mirrors the Telnet
packets that are received on the interface and subsequently dropped.

• Mirroring and spanning tree

Mirroring is performed regardless of the STP state of a port or trunk. This means, for example, that inbound
traffic on a port blocked by STP can still be monitored for STP packets during the STP setup phase.

• Tagged and untagged frames

For a frame entering or leaving the switch on a mirrored port, the mirrored copy retains the tagged or untagged
state the original frame carried when it entered into or exited from the switch. (The tagged or untagged VLAN
membership of ports in the path leading to the mirroring destination does not affect the tagged or untagged
status of the mirrored copy itself.)

Thus, if a tagged frame arrives on a mirrored port, the mirrored copy is also tagged, regardless of the status of
ports in the destination path. If a frame exits from the switch on a mirrored port that is a tagged member of a
VLAN, the mirrored copy is also tagged for the same reason.

To prevent a VLAN tag from being added to the mirrored copy of an outbound packet sent to a mirroring
destination, you must enter the no-tag-added parameter when you configure a port, trunk, or mesh interface
to select mirrored traffic.

• Effect of IGMP on mirroring

If both inbound and outbound mirroring is operating when IGMP is enabled on a VLAN, two copies of mirrored
IGMP frames may appear at the mirroring destination.

• Mirrored traffic not encrypted

Mirrored traffic undergoes IPv4 encapsulation, but mirrored encapsulated traffic is not encrypted.

• IPv4 header added

The IPv4 encapsulation of mirrored traffic adds a 54-byte header to each mirrored frame. If a resulting frame
exceeds the maximum MTU allowed in the network, it is dropped or truncated (according to the setting of the
[truncation] parameter in the mirror command.)

To reduce the number of dropped frames, enable jumbo frames in the mirroring path, including all intermediate
switches and/or routers. (The MTU on the switch is 9220 bytes, which includes 4 bytes for the 802.1Q VLAN
tag.)

• Intercepted or injected traffic

The mirroring feature does not protect against either mirrored traffic being intercepted or traffic being injected
into a mirrored stream by an intermediate host.

• Inbound mirrored IPv4-encapsulated frames are not mirrored

The switch does not mirror IPv4-encapsulated mirrored frames that it receives on an interface. This prevents
duplicate mirrored frames in configurations where the port connecting the switch to the network path for a
mirroring destination is also a port whose inbound or outbound traffic is being mirrored.

For example, if traffic leaving the switch through ports B5, B6, and B7 is being mirrored through port B7 to a
network analyzer, the mirrored frames from traffic on ports B5 and B6 will not be mirrored a second time as
they pass through port B7.

• Switch operation as both destination and source

A switch configured as a remote destination switch can also be configured to mirror traffic to one of its own
ports (local mirroring) or to a destination on another switch (remote mirroring.)

• Monitor command note
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If session 1 is already configured with a destination, you can enter the [no] vlan <VID>monitor or [no]
interface <PORT> monitor command without mirroring criteria and a mirror session number. In this
case, the switch automatically configures or removes mirroring for inbound and outbound traffic from the
specified VLAN or ports to the destination configured for session 1.

• Loss of connectivity suspends remote mirroring

When a remote mirroring session is configured on a source switch, the switch sends an ARP request to the
configured destination approximately every 60 seconds. If the source switch fails to receive the expected ARP
response from the destination for the session, transmission of mirrored traffic in the session halts. However,
because the source switch continues to send ARP requests for each configured remote session, link
restoration or discovery of another path to the destination enables the source switch to resume transmitting the
session's mirrored traffic after a successful ARP response cycle occurs.

Note that if a link's connectivity is repeatedly interrupted ("link toggling"), little or no mirrored traffic may be
allowed for sessions using that link. To verify the status of any mirroring session configured on the source
switch, use the show monitor command.

Troubleshooting traffic mirroring
Cause

If mirrored traffic does not reach the configured remote destination (endpoint) switch or remote exit port, check the
following configurations:

• In a remote mirroring session, the mirror remote ip command parameters configured on the source
switch for source IP address, source UDP port, and destination IP address must be identical to the same
parameters configured with the mirror endpoint ip command on the remote destination switch.

• The configured remote exit port must not be a member of a trunk or mesh.

• If the destination for mirrored traffic is on a different VLAN than the source, routing must be correctly
configured along the path from the source to the destination.

• On the remote destination (endpoint) switch, the IP addresses of the remote exit port and the switch can
belong to different VLANs.

• All links on the path from the source switch to the destination switch must be active.

CAUTION:

A mirroring exit port should be connected only to a network analyzer, IDS, or other network edge
device that has no connection to other network resources. Configuring a mirroring exit port
connection to a network can result in serious network performance problems, and is strongly
discouraged by Switch Networking.
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The Hewlett Packard Enterprise Virtual Technician is a set of tools aimed at aiding network switch administrators
in diagnosing and caring for their networks. VT provides tools for switch diagnoses when faced with unforeseen
issues.

To improve the Virtual Technician features of our devices, Hewlett Packard Enterprise has added the following
tools:

• Cisco Discovery Protocol

• Enabling Debug tracing for MOCANA code

• User diagnostic crash via front panel security button

• User diagnostic crash via the serial console

Cisco Discovery Protocol (CDP)

show cdp traffic
Syntax
show cdp traffic
Description

Displays the number of Cisco Discovery Protocol (CDP) packets transmitted, received and dropped.

CDP frame Statistics

Port No|Transmitted Frames|Received Frames|Discarded Frames|Error Frames
-------  -----------------  --------------   ---------------  ---------
A1               46                  26              6           7
A2               30                  35              7           9
A3              120                 420              670       670

clear cdp counters
Syntax
clear cdp counters
Description

Allows a user to clear CDP statistics.

Clear cdp counters

Port No|Transmitted Frames|Received Frames|Discarded Frames|Error Frames
-------  -----------------  --------------   ---------------  ---------
A1          46                   26                6              7

Chapter 15
Virtual Technician
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A2          30                   35                7              9
A3         120                  420               670            670

show cdp neighbors detail
Syntax
show cdp neighbors detail
Description

Shows CDP neighbors on specified port only.

show cdp neighbor detail

CDP neighbors information

  Port : 1/13
  Device ID : 0.0.0.0
  Address Type : IP
  Address      : 0.0.0.0
  Platform     :
  Capability   : Switch
  Device Port  : 00 1b 4f 49 e7 76
  Version      :

------------------------------------------------------------------------------

  Port : 2/25
  Device ID : 94 18 82 55 50 20
  Address Type : IP
  Address      : 172.31.99.143
  Platform     : Aruba JL356A 2540-24G-PoE+-4SFP+ Switch, revision YC.16....
  Capability   : Switch
  Device Port  : 3
  Version      : Aruba JL356A 2540-24G-PoE+-4SFP+ Switch, revision YC.16....

Enable/Disable debug tracing for MOCANA code

debug security
Syntax
debug security ssl
Description

Enables the debug tracing for MOCANA code.

Use the [no] parameter to disable debug tracing.

ssl
Display all SSL messages.

User diagnostic crash via Front Panel Security (FPS)
button
Allows the switch’s front panel Clear button to manually initiate a diagnostic reset. In the case of an application
hang, this feature allows you to perform reliable diagnostics by debugging via the front panel Clear button.
Diagnostic reset is controlled via Front Panel Security (FPS) options.
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front-panel-security password-clear
Syntax
[no] front-panel-security [password-clear <RESET-ON-CLEAR>| factory-reset | 
password-recovery | diagnostic-reset <CLEAR-BUTTON | SERIAL-CONSOLE>]
        
Description

Enables the ability to clear the passwords and/or configuration via the front panel buttons.

Parameters and options
no

Disables the password clear option.

password-clear
When disabled, you cannot reset the passwords using the clear button on the front panel of the device.

factory-reset
When disabled, you cannot reset the configuration/password using the clear and reset button combination at
boot time.

password-recovery
When enabled (and the front panel buttons disabled), contact Hewlett Packard Enterprise customer support to
recover a lost password. When disabled, there is no way to access a device after losing a password with the
front panel buttons disabled.

diagnostic-reset
When disabled, the user cannot perform a diagnostic switch reset on those rare events where the switch
becomes unresponsive to user input because of unknown reasons. When enabled, the user can perform a
diagnostic hard reset which will capture valuable diagnostic data and reset the switch.

factory-reset
Enable/Disable factory-reset ability.

password-clear
Enable/Disable password clear.

password-recovery
Enable/Disable password recovery.

diagnostic-reset
Enable/Disable diagnostic reset.

front-panel-security diagnostic-reset
Syntax
[no] front-panel-security diagnostic-reset <CLEAR-BUTTON | SERIAL-CONSOLE>
        
Description

Enables the diagnostic reset so that the switch can capture diagnostic data.

548 Aruba 3810 / 5400R Management and Configuration Guide for
ArubaOS-Switch 16.08

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4286



• To initiate diagnostic reset via the clear button, press the clear button for at least 30 seconds but not more than
40 seconds.

• To initiate diagnostic switch reset via the serial console, enter the diagnostic reset sequence on the serial
console.

Parameters and options
no

Disables the diagnostic reset feature so that the user is prevented from capturing diagnostic data and
performing a diagnostic reset on the switch. Disables both serial console and the clear button. This is
necessary if the switch becomes unresponsive (hangs) for unknown reasons.

<CLEAR BUTTON>
Enables diagnostic-reset using the clear button, allowing the user to perform diagnostic reset by pressing the
clear button for 30 seconds and not more than 40 seconds.

<SERIAL CONSOLE>
Enables the diagnostics by choosing the serial console option.

IMPORTANT:

Disabling the diagnostic reset prevents the switch from capturing diagnostic data on those rare
events where the switch becomes unresponsive to user input because of unknown reasons. Ensure
that you are familiar with the front panel security options before proceeding.

Front-panel-security diagnostic-rest clear-button

front-panel-security diagnostic-rest clear-button

Diagnostic Reset     - Enabled
clear-button        - Enabled
serial-console      -Disabled

No front-panel-security diagnostic-reset

no front-panel-security diagnostic-reset

Clear Password       - Enabled
Reset-on-clear     - Disabled
Factory Reset        - Enabled
Password Recovery    - Enabled
Diagnostic Reset     - Disabled

show front-panel-security
Syntax
show front-panel-security
Description

User initiated diagnostic reset defaults to enabled.
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Show front-panel-security

Clear Password    - Enabled
Reset –on-clear   - Disabled
Factory Reset     - Enabled
Password Recovery - Enabled
Diagnostic Reset  - Enabled

Diagnostic table
To accomplish this Do this Result

Soft Reset (Standalone
switch)

Press and release the Reset button The switch operating system is cleared
gracefully (such as data transfer
completion, temporary error conditions are
cleared), then reboots and runs self tests.

Hard Reset (Standalone
switch)

Press and hold the Reset button for
more than 5 seconds (until all LEDs
turn on), then release.

The switch reboots, similar to a power
cycle. A hard reset is used, for example,
when the switch CPU is in an unknown
state or not responding.

Soft Reset (Stacked
switch)

Press and release the Reset button Same as a standalone switch, except:

• If the Commander, the Standby switch
will become Commander.

• If the Standby, a new Standby will be
elected.

Hard Reset (Stacked
switch)

Press and hold the Reset button for
more than 5 seconds (until all LEDs
turn on), then release.

Same as a standalone switch, except:

• If the Commander, the Standby switch
will become Commander.

• If the Standby, a new Standby will be
elected.

Delete console and
management access
passwords

Press Clear for at least one second,
but not longer than 5 seconds.

The switch deletes all access password.

Restore the factory default
configuration

1. Press Clear and Reset
simultaneously.

2. While continuing to press Clear,
release Reset.

3. When the Test LED begins blinking
(after approximately 25 seconds),
release Clear.

The switch removes all configuration
changes, restores the factory default
configuration, and runs self test.

Table Continued
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To accomplish this Do this Result

Diagnostic reset 1. Press Clear to 30–40 seconds.

2. When the test LED begins blinking
(approximately after 30 seconds),
release Clear.

NOTE: Releasing the
Clear button when TEST
LED is not blinking
(approximately after 40
seconds ) will not honor
the diagnostic reset
request.

This initiates diagnostic reset, collects
diagnostic information, and reboots the
switch.

NOTE: These buttons are provided for the user’s convenience. If switch security is a concern,
ensure that the switch is installed in a secure location, such as a locked writing closet. To disable
the buttons, use the front-panel-security command.

Validation rules

Cause

Validation Error

Extra ‘token’ passed after diagnostic-reset. Invalid input: <token>.

FPS Error Log

Cause

Event Message

RMON_BOOT_CRASH_RECORD1 Diagnostic reset sequence detected on serial
console; user has initiated diagnostic reset.

NOTE: On detection on local
serial

RMON_BOOT_CRASH_RECORD1 SMM: Diagnostic reset sequence detected
on serial console; user has initiated
diagnostic reset.

NOTE: On detection on SMM
serial console and signaled to
AMM

Table Continued

Chapter 15 Virtual Technician 551

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4289



Event Message

RMON_BOOT_CRASH_RECORD1 STKM: Diagnostic reset sequence detected
on serial console; user has initiated
diagnostic reset.

NOTE: On detection on non-
commander serial console and
signaled to commander

RMON_BOOT_CRASH_RECORD1 User has initiated diagnostic reset via the
serial console.

NOTE: Sw_panic() message

RMON_BOOT_CRASH_RECORD1 SMM: User has initiated diagnostic reset via
the serial console.

NOTE: Sw_panic() message
when triggered via SMM

RMON_BOOT_CRASH_RECORD1 STKM: User has initiated diagnostic reset via
the serial console.

NOTE: Sw_panic() message
when triggered via non-
commander

Console print STKM: HA Sync in progress; user initiated
diagnostic request via the serial console
rejected. Retry after sometime.

NOTE: Printed on the device
console. When standby is in
sync state,we don’t want to
crash the commander. So we
report to the user to retry later

Console print STKM: Member is booting; user initiated
diagnostic request via the serial console
rejected. Retry after sometime.

NOTE: Printed on the device
console. When the member is
till booting, it doesn’t have the
commander member number,
thus we can’t issue UIDC on
the commander. So we report
to the user to retry later.
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User initiated diagnostic crash via the serial console
Remotely triggers a diagnostic reset of the switch via a serial console. This reset reboots the switch and collects
diagnostic data for debugging an application hang, a system hang or any other rare occurrence. Diagnostic reset
is controlled via FPS options.

The serial sequence to initiate the User Initiated Diagnostic Reset via Serial console is Ctrl+S, Ctrl+T, Ctrl+Q, Ctrl
+T, Ctrl+S.

front-panel-security diagnostic-reset serial-console
Syntax
[no] front-panel-security diagnostic-reset serial-console
Description

Enables the diagnostic-reset via serial console. Allows the user to perform diagnostic reset by keying-in
diagnostic reset sequence.

Parameters and options
no

Disables the diagnostic-reset via serial console.

Front-panel-security diagnostic-reset serial-console

front-panel-security diagnostic-reset serial-console

Diagnostic Reset     - Enabled
clear-button       - Disabled
serial-console     - Enabled

No front-panel-security diagnostic-reset serial-console

no front-panel-security diagnostic-reset serial-console

Diagnostic Reset     - Disabled

IMPORTANT:

Disabling the diagnostic reset prevents the switch from capturing diagnostic data on those rare
events where the switch becomes unresponsive to user input because of unknown reasons. Ensure
that you are familiar with the front panel security options before proceeding.
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Serial console error messages

Error Message

RMON_BOOT_CRASH_RECORD1 Diagnostic reset sequence detected on serial console;
user has initiated diagnostic reset.

RMON_BOOT_CRASH_RECORD1 SMM: Diagnostic reset sequence detected on serial
console; user has initiated diagnostic reset.

RMON_BOOT_CRASH_RECORD1 STKM: Diagnostic reset sequence detected on serial
console; user has initiated diagnostic reset.

RMON_BOOT_CRASH_RECORD1 User has initiated diagnostic reset via the serial
console.

RMON_BOOT_CRASH_RECORD1 SMM: User has initiated diagnostic reset via the serial
console.

RMON_BOOT_CRASH_RECORD1 STKM: User has initiated diagnostic reset via the serial
console.

Console print STKM: HA Sync in progress; user initiated diagnostic
request via the serial console rejected. Retry after
sometime.

Console print STKM: Member is booting; user initiated diagnostic
request via the serial console rejected. Retry after
sometime.
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Overview
This chapter addresses performance-related network problems that can be caused by topology, switch
configuration, and the effects of other devices or their configurations on switch operation. (For switch-specific
information on hardware problems indicated by LED behavior, cabling requirements, and other potential
hardware-related problems, see the installation guide you received with the switch.)

NOTE: Switch software updates are periodically places on the Switch Networking website. It is
recommended that you check this website for software updates that may have fixed a problem you
are experiencing.

For information on support and warranty provisions, see the Support and Warranty booklet shipped with the
switch.

Troubleshooting approaches
Cause

Use these approaches to diagnose switch problems:

• Check the HPE website for software updates that may have solved your problem: http://www.hpe.com/
networking

• Check the switch LEDs for indications of proper switch operation:
◦ Each switch port has a Link LED that should light whenever an active network device is connected to the

port.

◦ Problems with the switch hardware and software are indicated by flashing the Fault and other switch
LEDs.For a description of the LED behavior and information on using the LEDs for troubleshooting, see the
installation guide shipped with the switch.

• Check the network topology/installation. For topology information, see the installation guide shipped with the
switch.

• Check cables for damage, correct type, and proper connections. You should also use a cable tester to check
your cables for compliance to the relevant IEEE 802.3 specification. For correct cable types and connector pin-
outs, see the installation guide shipped with the switch.

• Use the Port Utilization Graph and Alert Log in the WebAgent included in the switch to help isolate problems.
These tools are available through the WebAgent:
◦ Port Utilization Graph

◦ Alert log

◦ Port Status and Port Counters screens

◦ Diagnostic tools (Link test, Ping test, configuration file browser)

• For help in isolating problems, use the easy-to-access switch console built into the switch or Telnet to the
switch console. For operating information on the Menu and CLI interfaces included in the console, see
chapters 3 and 4. These tools are available through the switch console:

Chapter 16
Troubleshooting
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◦ Status and Counters screens

◦ Event Log

◦ Diagnostics tools (Link test, Ping test, configuration file browser, and advanced user commands)

Browser or Telnet access problems

Cannot access the WebAgent
• Access may be disabled by the Web Agent Enabled parameter in the switch console. Check the setting on this

parameter by selecting:

2. Switch Configuration

1. System Information

• The switch may not have the correct IP address, subnet mask, or gateway. Verify by connecting a console to
the switch's Console port and selecting:

2. Switch Configuration

5. IP Configuration

Note: If DHCP/Bootp is used to configure the switch, the IP addressing can be verified by selecting:

1. Status and Counters...

2. Switch Management Address Information

Also check the DHCP/Bootp server configuration to verify correct IP addressing.

• If you are using DHCP to acquire the IP address for the switch, the IP address "lease time" may have expired
so that the IP address has changed. For more information on how to "reserve" an IP address, see the
documentation for the DHCP application that you are using.

• If one or more IP-authorized managers are configured, the switch allows inbound telnet access only to a
device having an authorized IP address. For more information on IP Authorized managers, see the access
security guide for your switch.

• Java™ applets may not be running on the web browser. They are required for the switch WebAgent to operate
correctly. Refer to the online Help on your web browser for how to run the Java applets.

Cannot Telnet into the switch console from a station on the network
• Off-subnet management stations can lose Telnet access if you enable routing without first configuring a static

(default) route. That is, the switch uses the IP default gateway only while operating as a Layer 2 device. While
routing is enabled on the switch, the IP default gateway is not used. You can avoid this problem by using the ip
route command to configure a static (default) route before enabling routing. For more information, see "IP
Routing Features" in the multicast and routing guide for your switch.

• Telnet access may be disabled by the Inbound Telnet Enabled parameter in the System Information
screen of the menu interface:

2. Switch Configuration

1. System Information

• The switch may not have the correct IP address, subnet mask, or gateway. Verify by connecting a console to
the switch's Console port and selecting:

2. Switch Configuration
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5. IP Configuration

• If you are using DHCP to acquire the IP address for the switch, the IP address "lease time" may have expired
so that the IP address has changed. For more information on how to "reserve" an IP address, see the
documentation for the DHCP application that you are using.

• If one or more IP-authorized managers are configured, the switch allows inbound telnet access only to a
device having an authorized IP address. For more information on IP Authorized managers, see the access
security guide for your switch.

Unusual network activity
Network activity that fails to meet accepted norms may indicate a hardware problem with one or more of the
network components, possibly including the switch. Such problems can also be caused by a network loop or
simply too much traffic for the network as it is currently designed and implemented. Unusual network activity is
usually indicated by the LEDs on the front of the switch or measured with the switchconsole interface or with a
network management tool. For information on using LEDs to identify unusual network activity, see the installation
guide you received with the switch.

A topology loop can also cause excessive network activity. The Event Log "FFI" messages can be indicative of
this type of problem.

General problems

The network runs slow; processes fail; users cannot access servers or other devices
Broadcast storms may be occurring in the network. These may be caused by redundant links between nodes.

• If you are configuring a port trunk, finish configuring the ports in the trunk before connecting the related cables.
Otherwise you may inadvertently create a number of redundant links (that is, topology loops) that will cause
broadcast storms.

• Turn on STP to block redundant links

• Check for FFI messages in the Event Log

Duplicate IP addresses
This is indicated by this Event Log message:

ip: Invalid ARP source: IP address on IP address
where both instances of IP address are the same address, indicating that the switch's IP address has been
duplicated somewhere on the network.

Duplicate IP addresses in a DHCP network
If you use a DHCP server to assign IP addresses in your network, and you find a device with a valid IP address
that does not appear to communicate properly with the server or other devices, a duplicate IP address may have
been issued by the server. This can occur if a client has not released a DHCP-assigned IP address after the
intended expiration time and the server "leases" the address to another device. This can also happen, For
example, if the server is first configured to issue IP addresses with an unlimited duration, and then is
subsequently configured to issue IP addresses that will expire after a limited duration. One solution is to configure
"reservations" in the DHCP server for specific IP addresses to be assigned to devices having specific MAC
addresses. For more information, see the documentation for the DHCP server.

One indication of a duplicate IP address in a DHCP network is this Event Log message:

ip: Invalid ARP source: <IP-address>
       on <IP-address>
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where both instances of IP-address are the same address, indicating that the IP address has been duplicated
somewhere on the network.

The switch has been configured for DHCP/Bootp operation, but has not received a
DHCP or Bootp reply
When the switch is first configured for DHCP/Bootp operation, or if it is rebooted with this configuration, it
immediately begins sending request packets on the network. If the switch does not receive a reply to its DHCP/
Bootp requests, it continues to periodically send request packets, but with decreasing frequency. Thus, if a DHCP
or Bootp server is not available or accessible to the switch when DHCP/Bootp is first configured, the switch may
not immediately receive the desired configuration.

After verifying that the server has become accessible to the switch, reboot the switch to re-start the process.

802.1Q Prioritization problems

Ports configured for non-default prioritization (level 1 to 7) are not performing the
specified action
If the ports were placed in a trunk group after being configured for non-default prioritization, the priority setting
was automatically reset to zero (the default). Ports in a trunk group operate only at the default priority setting.

Addressing ACL problems

ACLs are properly configured and assigned to VLANs, but the switch is not using the
ACLs to filter IP layer 3 packets

Procedure

1. The switch may be running with IP routing disabled. To ensure that IP routing is enabled, execute show
running and look for the IP routing statement in the resulting listing. For Example:
Indication that routing is enabled

switch(config)# show running
Running configuration:
; J9091A Configuration Editor; Created on release #XX.15.06
hostname "Switch"
ip default-gateway 10.33.248.1
ip routing 1
logging 10.28.227.2
snmp-server community "public" Unrestricted
ip access-list extended "Controls for VLAN 20"
permit tcp 0.0.0.0 255.255.255.255 10.10.20.98 0.0.0.0 eq 80
permit tcp 0.0.0.0 255.255.255.255 10.10.20.21 0.0.0.0 eq 80
deny tcp 0.0.0.0 255.255.255.255 10.10.20.1 0.0.0.255 eq 80
deny tcp 10.10.20.1? 0.0.0.0 10.10.10.100 0.0.0.0 eq 20 log
deny tcp 10.10.20.20 0.0.0.0 10.10.10.100 0.0.0.0 eq 20 log
deny tcp 10.10.20.43 0.0.0.0 10.10.10.100 0.0.0.0 eq 20 log
permit ip 10.10.20.1 0.0.0.255 10.10.10.100 0.0.0.0
deny ip 10.10.30.1 0.0.0.255 10.10.10.100 0.0.0.0
permit ip 10.10.30.1 0.0.0.255 10.10.10.1 0.0.0.255
exit

1
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Indicates that routing is enabled, a requirement for ACL operation. (There is an exception. Refer to the Note,
below.)

NOTE: If an ACL assigned to a VLAN includes an ACE referencing an IP address on the switch
itself as a packet source or destination, the ACE screens traffic to or from this switch address
regardless of whether IP routing is enabled. This is a security measure designed to help protect
the switch from unauthorized management access.

If you need to configure IP routing, execute the ip routing command.

2. ACL filtering on the switches applies only to routed packets and packets having a destination IP address (DA)
on the switch itself.

Also, the switch applies assigned ACLs only at the point where traffic enters or leaves the switch on a VLAN.
Ensure that you have correctly applied your ACLs ("in" and/or "out") to the appropriate VLANs.

The switch does not allow management access from a device on the same VLAN
The implicit deny any function that the switch automatically applies as the last entry in any ACL always blocks
packets having the same DA as the switch's IP address on the same VLAN. That is, bridged packets with the
switch itself as the destination are blocked as a security measure.

To preempt this action, edit the ACL to include an ACE that permits access to the switch's DA on that VLAN from
the management device.

Error (Invalid input) when entering an IP address
When using the "host" option in the Command syntax, ensure that you are not including a mask in either dotted
decimal or CIDR format. Using the "host" option implies a specific host device and therefore does not permit any
mask entry.

Correctly and incorrectly specifying a single host

Switch(config)# access-list 6 permit host 10.28.100.100 1

Switch(config)# access-list 6 permit host 10.28.100.100 255.255.255.2552 
Invalid input: 255.255.255.255

Switch(config)# access-list 6 permit host 10.28.100.100/32 3
Invalid input: 10.28.100.100/32

• 1Correct.

• 2Incorrect. No mask needed to specify a single host.

• 3Incorrect. No mask needed to specify a single host.

Apparent failure to log all "deny" matches
Where the log statement is included in multiple ACEs configured with a "deny" option, a large volume of "deny"
matches generating logging messages in a short period of time can impact switch performance. If it appears that
the switch is not consistently logging all "deny" matches, try reducing the number of logging actions by removing
the log statement from some ACEs configured with the "deny" action.
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The switch does not allow any routed access from a specific host, group of hosts, or
subnet
The implicit deny any function that the switch automatically applies as the last entry in any ACL may be blocking
all access by devices not specifically permitted by an entry in an ACL affecting those sources. If you are using the
ACL to block specific hosts, a group of hosts, or a subnet, but want to allow any access not specifically permitted,
insert permit any as the last explicit entry in the ACL.

The switch is not performing routing functions on a VLAN
Two possible causes of this problem are:

• Routing is not enabled. If show running indicates that routing is not enabled, use the ip routing
command to enable routing.

• An ACL may be blocking access to the VLAN (on a switch covered in this guide). Ensure that the switch's IP
address on the VLAN is not blocked by one of the ACE entries in an ACL applied to that VLAN. A common
mistake is to either not explicitly permit the switch's IP address as a DA or to use a wildcard ACL mask in a
deny statement that happens to include the switch's IP address. For an Example: of this problem, see section
"General ACL Operating Notes" in the "Access Control Lists (ACLs)" of the latest access security guide for
your switch.

Routing through a gateway on the switch fails
Configuring a "deny" ACE that includes a gateway address can block traffic attempting to use the gateway as a
next-hop.

Remote gateway case
Configuring ACL "101" (example below) and applying it outbound on VLAN 1 in the figure below includes the
router gateway (10.0.8.1) needed by devices on other networks. This can prevent the switch from sending ARP
and other routing messages to the gateway router to support traffic from authorized remote networks.

In Figure 152: Inadvertently blocking a gateway on page 560, this ACE (see data in bold below) denies
access to the 10 Net's 10.0.8.1 router gateway needed by the 20 Net (Subnet mask is 255.255.255.0).See:
example

Figure 152: Inadvertently blocking a gateway

To avoid inadvertently blocking the remote gateway for authorized traffic from another network (such as the 20
Net in this Example:):
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Procedure

1. Configure an ACE that specifically permits authorized traffic from the remote network.

2. Configure narrowly defined ACEs to block unwanted IP traffic that would otherwise use the gateway; such
ACEs might deny traffic for a particular application, particular hosts, or an entire subnet.

3. Configure a "permit any" ACE to specifically allow any IP traffic to move through the gateway.

ACE blocking an entire subnet

switch(config)# access-list config

ip access-list extended "101"
  deny ip 0.0.0.0 255.255.255.255 10.0.8.30 0.0.0.255
  permit ip 0.0.0.0 255.255.255.255 0.0.0.00 255.255.255.255
  exit
      

Local gateway case
If you use the switch as a gateway for traffic you want routed between subnets, use these general steps to avoid
blocking the gateway for authorized applications:

Procedure

1. Configure gateway security first for routing with specific permit and deny statements.

2. Permit authorized traffic.

3. Deny any unauthorized traffic that you have not already denied in step 1.

IGMP-related problems

IP multicast (IGMP) traffic that is directed by IGMP does not reach IGMP hosts or a
multicast router connected to a port
IGMP must be enabled on the switch and the affected port must be configured for "Auto" or "Forward" operation.

IP multicast traffic floods out all ports; IGMP does not appear to filter traffic
The IGMP feature does not operate if the switch or VLAN does not have an IP address configured manually or
obtained through DHCP/Bootp. To verify whether an IP address is configured for the switch or VLAN, do one of
the following:

• Try using the WebAgent: If you can access the WebAgent, then an IP address is configured.

• Try to telnet to the switch console: If you can Telnet to the switch, an IP address is configured.

• Use the switch console interface: From the Main Menu, check the Management Address Information screen
by clicking on:

1. Status and Counters

2. Switch Management Address Information

LACP-related problems
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Unable to enable LACP on a port with the interface <port-number> lacp
command
In this case, the switch displays the following message:

Operation is not allowed for a trunked port.
You cannot enable LACP on a port while it is configured as a static Trunk port. To enable LACP on a static-
trunked port:

Procedure

1. Use the no trunk <port-number> command to disable the static trunk assignment.

2. Execute interface <port-number> lacp .

CAUTION: Removing a port from a trunk without first disabling the port can create a traffic loop that
can slow down or halt your network. Before removing a port from a trunk, Hewlett Packard Enterprise
recommends that you either disable the port or disconnect it from the LAN.

Port-based access control (802.1X)-related problems
NOTE:

To list the 802.1X port-access Event Log messages stored on the switch, use show log 802.

See also Radius-related problems on page 564.

The switch does not receive a response to RADIUS authentication requests
In this case, the switch attempts authentication using the secondary method configured for the type of access you
are using (console, Telnet, or SSH).

There can be several reasons for not receiving a response to an authentication request. Do the following:

• Use ping to ensure that the switch has access to the configured RADIUS servers.

• Verify that the switch is using the correct encryption key (RADIUS secret key) for each server.

• Verify that the switch has the correct IP address for each RADIUS server.

• Ensure that the radius-server timeout period is long enough for network conditions.

The switch does not authenticate a client even though the RADIUS server is properly
configured and providing a response to the authentication request
If the RADIUS server configuration for authenticating the client includes a VLAN assignment, ensure that the
VLAN exists as a static VLAN on the switch. See "How 802.1X Authentication Affects VLAN Operation" in the
access security guide for your switch.

During RADIUS-authenticated client sessions, access to a VLAN on the port used for
the client sessions is lost
If the affected VLAN is configured as untagged on the port, it may be temporarily blocked on that port during an
802.1X session. This is because the switch has temporarily assigned another VLAN as untagged on the port to
support the client access, as specified in the response from the RADIUS server. See "How 802.1X Authentication
Affects VLAN Operation" in the access security guide for your switch.
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The switch appears to be properly configured as a supplicant, but cannot gain access
to the intended authenticator port on the switch to which it is connected
If aaa authentication port-access is configured for Local, ensure that you have entered the local login
(operator-level) username and password of the authenticator switch into the identity and secret parameters
of the supplicant configuration. If instead, you enter the enable (manager-level) username and password, access
will be denied.

The supplicant statistics listing shows multiple ports with the same authenticator MAC
address
The link to the authenticator may have been moved from one port to another without the supplicant statistics
having been cleared from the first port. See "Note on Supplicant Statistics" in the chapter on Port-Based and
User-Based Access Control in the access security guide for your switch.

The show port-access authenticator <port-list> command shows one or
more ports remain open after they have been configured with control unauthorized
802.1X is not active on the switch. After you execute aaa port-access authenticator active, all ports
configured with control unauthorized should be listed as Closed.

Authenticator ports remain "open" until activated

switch(config)# show port-access authenticator e 9
 Port Access Authenticator Status
  Port-access authenticator activated [No] : No
              Access Authenticator Authenticator
  Port Status Control  State Backend  State
  ---- ------ -------- -------------- --------------
  9    Open 1   FU       Force Auth     Idle

Switch(config)# show port-access authenticator active
Switch(config)# show port-access authenticator e 9
 Port Access Authenticator Status
  Port-access authenticator activated [No] : Yes
              Access Authenticator Authenticator
  Port Status Control  State Backend  State
  ---- ------ -------- -------------- --------------
  9    Closed FU       Force Unauth   Idle

1Port A9 shows an “Open” status even though Access Control is set to Unauthorized (Force Auth). This is
because the port-access authenticator has not yet been activated.

RADIUS server fails to respond to a request for service, even though the server's IP
address is correctly configured in the switch
Use show radius to verify that the encryption key (RADIUS secret key) the switch is using is correct for the
server being contacted. If the switch has only a global key configured, it either must match the server key or you
must configure a server-specific key. If the switch already has a server-specific key assigned to the server's IP
address, it overrides the global key and must match the server key.

Displaying encryption keys

switch(config)# show radius
 Status and Counters - General RADIUS Information
  Deadtime(min) : 0
  Timeout(secs) : 5
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  Retransmit Attempts : 3
  Global Encryption Key : My-Global-Key
  Dynamic Authorization UDP Port : 3799

                  Auth Acct DM/ Time
  Server IP Addr  Port Port CoA Window Encryption Key
  --------------- ---- ---- --- ------ ---------------
  10.33.18.119    1812 1813            119-only-key
Also, ensure that the switch port used to access the RADIUS server is not blocked by an 802.1X configuration on
that port. For example, show port-access authenticator <port-list> gives you the status for the
specified ports. Also, ensure that other factors, such as port security or any 802.1X configuration on the RADIUS
server are not blocking the link.

The authorized MAC address on a port that is configured for both 802.1X and port
security either changes or is re-acquired after execution of aaa port-access
authenticator <port-list> initialize
If the port is force-authorized with aaa port-access authenticator <port-list> control
authorized command and port security is enabled on the port, then executing initialize causes the port to
clear the learned address and learn a new address from the first packet it receives after you execute
initialize.

A trunked port configured for 802.1X is blocked
If you are using RADIUS authentication and the RADIUS server specifies a VLAN for the port, the switch allows
authentication, but blocks the port. To eliminate this problem, either remove the port from the trunk or reconfigure
the RADIUS server to avoid specifying a VLAN.

QoS-related problems

Loss of communication when using VLAN-tagged traffic
If you cannot communicate with a device in a tagged VLAN environment, ensure that the device either supports
VLAN tagged traffic or is connected to a VLAN port that is configured as Untagged.

Radius-related problems

The switch does not receive a response to RADIUS authentication requests
In this case, the switch attempts authentication using the secondary method configured for the type of access you
are using (console, Telnet, or SSH).

There can be several reasons for not receiving a response to an authentication request. Do the following:

• Use ping to ensure that the switch has access to the configured RADIUS server.

• Verify that the switch is using the correct encryption key for the designated server.

• Verify that the switch has the correct IP address for the RADIUS server.

• Ensure that the radius-server timeout period is long enough for network conditions.

• Verify that the switch is using the same UDP port number as the server.
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NOTE: Because of an inconsistency between the Windows XP 802.1x supplicant timeout value and
the switch default timeout value, which is 5, when adding a backup RADIUS server, set the switch
radius-server timeout value to 4. Otherwise, the switch may not failover properly to the backup
RADIUS server.

RADIUS server fails to respond to a request for service, even though the server's IP
address is correctly configured in the switch
Use show radius to verify that the encryption key the switch is using is correct for the server being contacted. If
the switch has only a global key configured, it either must match the server key or you must configure a server-
specific key. If the switch already has a server-specific key assigned to the server's IP address, it overrides the
global key and must match the server key.

Global and unique encryption keys

Switch(config)# show radius
 Status and Counters - General RADIUS Information
  Deadtime(min) : 0
  Timeout(secs) : 5
  Retransmit Attempts : 3
  Global Encryption Key : My-Global-Key 1
  Dynamic Authorization UDP Port : 3799

                  Auth Acct DM/ Time
  Server IP Addr  Port Port CoA Window Encryption Key
  --------------- ---- ---- --- ------ ---------------
  10.33.18.119    1812 1813            119-only-key 2

• 1

Global RADIUS Encryption Key

• 2

Unique RADIUS Encryption Key for the RADIUS server at 10.33.18.119

MSTP and fast-uplink problems
CAUTION:

If you enable MSTP, Hewlett Packard Enterprise recommends that you leave the remainder of the
MSTP parameter settings at their default values until you have had an opportunity to evaluate MSTP
performance in your network. Because incorrect MSTP settings can adversely affect network
performance, you should avoid making changes without having a strong understanding of how MSTP
operates. To learn the details of MSTP operation, see the IEEE802.1s standard.

Broadcast storms appearing in the network
This can occur when there are physical loops (redundant links) in the topology. Where this exists, you should
enable MSTP on all bridging devices in the topology to detect the loop.

STP blocks a link in a VLAN even though there are no redundant links in that VLAN
In 802.1Q-compliant switches, MSTP blocks redundant physical links even if they are in separate VLANs. A
solution is to use only one, multiple-VLAN (tagged) link between the devices. Also, if ports are available, you can
improve the bandwidth in this situation by using a port trunk. See "Spanning Tree Operation with VLANs" in
"Static Virtual LANs (VLANs)" in the advanced traffic management guide for your switch.
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Fast-uplink troubleshooting
Some of the problems that can result from incorrect use of fast-uplink MSTP include temporary loops and
generation of duplicate packets.

Problem sources can include:

• Fast-uplink is configured on a switch that is the MSTP root device.

• Either the Hello Time or the Max Age setting (or both) is too long on one or more switches. Return the
Hello Time and Max Age settings to their default values (2 seconds and 20 seconds, respectively, on a
switch).

• A "downlink" port is connected to a switch that is further away (in hop count) from the root device than the
switch port on which fast-uplink MSTP is configured.

• Two edge switches are directly linked to each other with a fast-uplink (Mode = Uplink) connection.

• Fast uplink is configured on both ends of a link.

• A switch serving as a backup MSTP root switch has ports configured for fast-uplink MSTP and has become
the root device because of a failure in the original root device.

SSH-related problems

Switch access refused to a client
Even though you have placed the client's public key in a text file and copied the file (using the copy tftp pub-
key-file command) into the switch, the switch refuses to allow the client to have access. If the source SSH
client is an SSHv2 application, the public key may be in the PEM format, which the switch (SSHv1) does not
interpret. Check the SSH client application for a utility that can convert the PEM-formatted key into an ASCII-
formatted key.

Executing IP SSH does not enable SSH on the switch
The switch does not have a host key. Verify by executing show ip host-public-key. If you see the message

ssh cannot be enabled until a host key is configured (use 'crypto' command).
you need to generate an SSH key pair for the switch. To do so, execute crypto key generate (see
"Generating the switch's public and private key pair" in the SSH chapter of the access security guide for your
switch.)

Switch does not detect a client's public key that does appear in the switch's public key
file (show ip client-public-key)
The client's public key entry in the public key file may be preceded by another entry that does not terminate with a
new line (CR). In this case, the switch interprets the next sequential key entry as simply a comment attached to
the preceding key entry. Where a public key file has more than one entry, ensure that all entries terminate with a
new line (CR). While this is optional for the last entry in the file, not adding a new line to the last entry creates an
error potential if you either add another key to the file at a later time or change the order of the keys in the file.

An attempt to copy a client public-key file into the switch has failed and the switch lists
one of the following messages
Download failed: overlength key in key file.
Download failed: too many keys in key file.
Download failed: one or more keys is not a valid RSA public key.

566 Aruba 3810 / 5400R Management and Configuration Guide for
ArubaOS-Switch 16.08

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4304



The public key file you are trying to download has one of the following problems:

• A key in the file is too long. The maximum key length is 1024 characters, including spaces. This could also
mean that two or more keys are merged together instead of being separated by a <CR> <LF>.

• There are more than ten public keys in the key file.

• One or more keys in the file is corrupted or is not a valid rsa public key.

Client ceases to respond ("hangs") during connection phase
The switch does not support data compression in an SSH session. Clients often have compression turned on by
default, but then disable it during the negotiation phase. A client that does not recognize the compression-request
FAILURE response may fail when attempting to connect. Ensure that compression is turned off before attempting
a connection to prevent this problem.

TACACS-related problems

Event Log
When troubleshooting TACACS+ operation, check the switch's Event Log for indications of problem areas.

All users are locked out of access to the switch
If the switch is functioning properly, but no username/password pairs result in console or Telnet access to the
switch, the problem may be caused by how the TACACS+ server and/or the switch are configured. Use one of the
following methods to recover:

• Access the TACACS+ server application and adjust or remove the configuration parameters controlling access
to the switch.

• If the above method does not work, try eliminating configuration changes in the switch that have not been
saved to flash (boot-up configuration) by causing the switch to reboot from the boot-up configuration (which
includes only the configuration changes made prior to the last write memory command.) If you did not use
write memory to save the authentication configuration to flash, pressing the Reset button reboots the
switch with the boot-up configuration.

• Disconnect the switch from network access to any TACACS+ servers and then log in to the switch using either
Telnet or direct console port access. Because the switch cannot access a TACACS+ server, it defaults to local
authentication. You can then use the switch's local Operator or Manager username/password pair to log on.

• As a last resort, use the Clear/Reset button combination to reset the switch to its factory default boot-up
configuration. Taking this step means you will have to reconfigure the switch to return it to operation in your
network.

No communication between the switch and the TACACS+ server application
If the switch can access the server device (that is, it can ping the server), a configuration error may be the
problem. Some possibilities include:

• The server IP address configured with the switch's tacacs-serverhost command may not be correct. (Use
the switch's show tacacs-server command to list the TACACS+ server IP address.)

• The encryption key configured in the server does not match the encryption key configured in the switch (by
using the tacacs-server key command). Verify the key in the server and compare it to the key configured
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in the switch. (Use show tacacs-server to list the global key. Use show config or show config
running to list any server-specific keys.)

• The accessible TACACS+ servers are not configured to provide service to the switch.

Access is denied even though the username/password pair is correct
Some reasons for denial include the following parameters controlled by your TACACS+ server application:

• The account has expired.

• The access attempt is through a port that is not allowed for the account.

• The time quota for the account has been exhausted.

• The time credit for the account has expired.

• The access attempt is outside of the time frame allowed for the account.

• The allowed number of concurrent logins for the account has been exceeded.

For more help, see the documentation provided with your TACACS+ server application.

Unknown users allowed to login to the switch
Your TACACS+ application may be configured to allow access to unknown users by assigning them the privileges
included in a default user profile. See the documentation provided with your TACACS+ server application.

System allows fewer login attempts than specified in the switch configuration
Your TACACS+ server application may be configured to allow fewer login attempts than you have configured in
the switch with the aaa authentication num-attempts command.

TimeP, SNTP, or Gateway problems

The switch cannot find the time server or the configured gateway
TimeP, SNTP, and Gateway access are through the primary VLAN, which in the default configuration is the
DEFAULT_VLAN. If the primary VLAN has been moved to another VLAN, it may be disabled or does not have
ports assigned to it.

VLAN-related problems

Monitor port
When using the monitor port in a multiple-VLAN environment, the switch handles broadcast, multicast, and
unicast traffic output from the monitor port as follows:

• If the monitor port is configured for tagged VLAN operation on the same VLAN as the traffic from monitored
ports, the traffic output from the monitor port carries the same VLAN tag.

• If the monitor port is configured for untagged VLAN operation on the same VLAN as the traffic from the
monitored ports, the traffic output from the monitor port is untagged.

• If the monitor port is not a member of the same VLAN as the traffic from the monitored ports, traffic from the
monitored ports does not go out the monitor port.
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None of the devices assigned to one or more VLANs on an 802.1Q-compliant switch are
being recognized
If multiple VLANs are being used on ports connecting 802.1Q-compliant devices, inconsistent VLAN IDs may
have been assigned to one or more VLANs. For a given VLAN, the same VLAN ID must be used on all connected
802.1Q-compliant devices.

Link configured for multiple VLANs does not support traffic for one or more VLANs
One or more VLANs may not be properly configured as "Tagged" or "Untagged." A VLAN assigned to a port
connecting two 802.1Q-compliant devices must be configured the same on both ports. For example, VLAN_1 and
VLAN_2 use the same link between switch "X" and switch "Y," as shown in Figure 153: Example: of correct
VLAN port assignments on a link on page 569.

Figure 153: Example: of correct VLAN port assignments on a link

• If VLAN_1 (VID=1) is configured as "Untagged" on port 3 on switch "X," it must also be configured as
"Untagged" on port 7 on switch "Y." Make sure that the VLAN ID (VID) is the same on both switches.

• Similarly, if VLAN_2 (VID=2) is configured as "Tagged" on the link port on switch "A," it must also be configured
as "Tagged" on the link port on switch "B." Make sure that the VLAN ID (VID) is the same on both switches.

Duplicate MAC addresses across VLANs
The switches operate with multiple forwarding databases. Thus, duplicate MAC addresses occurring on different
VLANs can appear where a device having one MAC address is a member of more than one 802.1Q VLAN, and
the switch port to which the device is linked is using VLANs (instead of MSTP or trunking) to establish redundant
links to another switch. If the other device sends traffic over multiple VLANs, its MAC address consistently
appears in multiple VLANs on the switch port to which it is linked.

Be aware that attempting to create redundant paths through the use of VLANs causes problems with some
switches. One symptom is that a duplicate MAC address appears in the Port Address Table of one port and then
later appears on another port. While the switches have multiple forwarding databases and thus do not have this
problem, some switches with a single forwarding database for all VLANs may produce the impression that a
connected device is moving among ports because packets with the same MAC address but different VLANs are
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received on different ports. You can avoid this problem by creating redundant paths using port trunks or spanning
tree.

Figure 154: Example: of duplicate MAC address

Fan failure

Mitigating flapping transceivers
In traditional switches, the state of a link is driven directly by the reported state of the port, which is required for
rapid detection of link faults. However, the consequence of this is that a marginal transceiver, optical, or wire
cabling, one that "flaps" up and down several times per second, can cause STP and other protocols to react
poorly, resulting in a network outage. The link-flap option expands the functionality of the existing fault finder
function to include a "link-flap" event and a new action of "warn-and-disable." Together, these additions allow the
errant condition to be detected, and the port in question can be optionally disabled.

Syntax:

fault-finder <link-flap> sensitivity {<low | medium | high} > action {<warn | warn-and-disable>}

Default settings: Sensitivity = Medium; Action = Warn

Sensitivity thresholds are static. In a 10-second window, if more than the threshold number of link state transitions
(up or down) are detected, the event is triggered. The 10-second window is statically determined, that is, the
counters are reset every 10 seconds, as opposed to being a sliding window. The counters are polled twice per
second (every 500 milliseconds), and the event is triggered if the sensitivity threshold is crossed at that time.

The sensitivity thresholds are:

High 3 transitions in 10 seconds

Medium 6 transitions in 10 seconds

Low 10 transitions in 10 seconds

Configuring the link-flap event and corresponding action applies to all ports and port types (it is a global setting
per FFI event type). Note that normal link transition protocols may prevent link state changes from occurring fast
enough to trigger the event for some port types, configurations, and sensitivity settings.

When the link-flap threshold is met for a port configured for warn (For example, fault-finder link-flap
sensitivity medium action warn), the following message is seen in the switch event log.

02672 FFI: port <number>-Excessive link state transitions
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When the link-flap threshold is met for a port configured for warn-and-disable (For example, fault-finder
linkflap sensitivity medium action warn-and-disable), the following messages are seen in the
switch event log.

02672 FFI: port <number>-Excessive link state transitions
02673 FFI: port <number>-Port disabled by Fault-finder.
02674 FFI: port <number>-Administrator action required to re-enable.
The warn-and-disable action is available for all fault-finder events on an individual basis. It may be used, For
example, to disable a port when excessive broadcasts are received. Because the fault-generated disabling of a
port requires operator intervention to re-enable the port, such configuration should be used with care. For
example, link-flap-initiated disablement is not desired on ports that are at the client edge of the network, because
link state changes there are frequent and expected.

Hewlett Packard Enterprise does not recommend automatic disabling of a port at the core or distribution layers
when excessive broadcasts are detected, because of the potential to disable large parts of the network that may
be uninvolved and for the opportunity to create a denial-of-service attack.

Fault Finder thresholds
Switches feature automatic fault detection, which helps protect against network loops and defective equipment.
The fault detection sensitivity setting determines the types of alerts reported to the Alert Log based on their level
of severity or sensitivity. The sensitivity levels are:

• High Sensitivity.

This policy directs the switch to send all alerts to the Alert Log. This setting is most effective on networks that
have none or few problems.

• Medium Sensitivity. This policy directs the switch to send alerts related to network problems to the Alert Log.
If you want to be notified of problems which cause a noticeable slowdown on the network, use this setting.

• Low Sensitivity. This policy directs the switch to send only the most severe alerts to the Alert Log. This policy
is most effective on a network where there are normally a lot of problems and you want to be informed of only
the most severe ones

• Disabled. Disables the Alert Log and transmission of alerts (traps) to the management server (in cases where
a network management tool such as ProCurve Manager is in use). Use this option when you don’t want to use
the Alert Log.

Enabling Fault Finder
Enter this CLI command to enable fault detection:

Syntax:

[no] fault-finder [fault][sensitivity <low|medium|high>][action <warn|warn-and-disable>]
Enables or disables Fault Finder and sets sensitivity.

When the warn-and-disable action option is configured, Fault Finder may also shut down a bad port in
addition to sending an alert to the Alert Log.

Default setting: fault-finder sensitivity medium action warn
[fault]: Supported values are:

• all: All fault types

• bad-driver: Too many undersized/giant packets
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• bad-transceiver: Excessive jabbering

• bad-cable: Excessive CRC/alignment errors

• too-long-cable: Excessive late collisions

• over-bandwidth: High collision or drop rate

• broadcast-storm: Excessive broadcasts

• duplex-mismatch-HDx: Duplex mismatch. Reconfigure to Full Duplex

• duplex-mismatch-FDx: Duplex mismatch. Reconfigure port to Auto

• link-flap: Rapid detection of link faults and recoveries

• loss-of-link: Link loss detected. (Sensitivity not applicable)

Examples:

To set Fault Finder with a high sensitivity to issue a warning and then disable a port on which there is a high
collision or drop rate, you could configure these options:

switch(config)# fault-finder over-bandwidth sensitivity 
high action warn-and-disable
To set Fault Finder with a medium sensitivity to issue a warning about excessive CRC or alignment errors on a
port, you could configure these options:

switch(config)# fault-finder bad-cable sensitivity 
medium action warn
To set Fault Finder with a low sensitivity to issue a warning about rapid detection of link faults, you could
configure these options:

switch(config)# fault-finder link-flap sensitivity 
low action warn
To disable Fault Finder, enter this command:

switch(config)# no fault-finder all

Table 28: Fault finder sensitivities for supported conditions

Condition
triggering
fault finder

Sensitivities Units (in
packets)

Time period Fault finder
reacts:

High Medium Low

Bad driver —
Too many
under-sized
packets or too
many giant
packets

6 21 36 1/10,000
Incoming

20 secs If (undersized/
total) >=
(sensitivity/
10,000)OrIf
(giant/total) >=
(sensitivity/
10,000)

Table Continued
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Condition
triggering
fault finder

Sensitivities Units (in
packets)

Time period Fault finder
reacts:

Bad
transceiver —
Excessive
jabbering -
Jabbers:
(Jabbers are
packets
longer than
the MTU) -
Fragments:
(packets
shorter than
they should
be)

65 2110 3614 1/10,000
IncomingOne
Fragments

20 secs20
secs

If (jabbers/
total) >=
(sensitivity/
10,000)Or If
fragment
count in the
last 20
seconds >=
sensitivity

Bad cable —
Excessive
CRC/
alignment
errors

6 21 36 1/10,000
Incoming

20 secs If (CRC and
alignment
errors/ total)
>= (sensitivity/
10,000)

Too Long
Cable —
Excessive late
collisions (a
late collision
error occurs
after the first
512 bit times)

6 21 36 1/10,000
Outgoing

20 secs If (late
collisions/
total) >=
(sensitivity/
10,000)

Over
bandwidth -
High collision
rate -High
drop rate

665 21257 36449 1/10,000
OutgoingOne
Packet

5 mins5 mins If (excessive
collisions/
total) >=
(sensitivity/
10,000)The
count of
dropped
packets >=
sensitivity
during the last
5 minutes.

Broadcast
storm —
Excessive
broadcasts

1475 5000 8525 One
Broadcast
Packet

1 sec If the average
per second of
broadcast
packets in the
last 20
seconds >=
sensitivity

Table Continued
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Condition
triggering
fault finder

Sensitivities Units (in
packets)

Time period Fault finder
reacts:

Muticast
storm —
Excessive
multicasts

1475 5000 8525 One Multicast
Packet

1 sec If the average
per second of
multicast
packets in the
last 20
seconds >=
sensitivity

Duplex
mismatch
HDx

6 21 36 1/10,000
Outgoing

20 sec If (late
collisions/
total) >=
(sensitivity/
10,000)

Duplex
mismatch FDx

6 21 36 1/10,000
Incoming

20 sec If (CRC and
alignment
errors/ total)
>= (sensitivity/
10,000)

Link flap —
Excessive
transitions
between link-
up and link-
down states.

4 7 11 One
Transitions

10 secs If the
Transition
count in the
last 10s >=
sensitivity.

Example: of sensitivity calculation:

If a sensitivity is set to High, and a bad cable is causing 15 CRC errors out of a total of 3500 packets transmitted
in a 20 second period:

1. CRC errors/total must be >= (sensitivity/10,000) to trigger an alert.

2. CRC errors/total = 15/3500 = .00043

3. Sensitivity/10,000 = 6/10,000 = .0006

4. .00043 is not greater than or equal to .0006, so an alert is not triggered.

Viewing transceiver information
This features provides the ability to view diagnostic monitoring information for transceivers with Diagnostic Optical
Monitoring (DOM) support. The following table indicates the support level for specific transceivers:
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Product # Description Support1

J8436A 10GbE X2–SC SR
Optic

V

J8437A 10GbE X2–SC LR Optic V

J8440B 10GbE X2-CX4 Xcver NA

J8440C 10GbE X2-CX4 Xcver NA

J4858A Gigabit-SX-LC Mini-
GBIC

V

J4858B Gigabit-SX-LC Mini-
GBIC

V

J4858C Gigabit-SX-LC Mini-
GBIC

V (some)

J9054B 100-FX SFP-LC
Transceiver

N

J8177C Gigabit 1000Base-T
Mini-GBIC

NA

J9150A 10GbE SFP+ SR
Transceiver

D

J9151A 10GbE SFP+ LR
Transceiver

D

J9152A 10GbE SFP+ LRM
Transceiver

D

J9153A 10GbE SFP+ ER
Transceiver

D

J9144A 10GbE X2-SC LRM
Transceiver

D

J8438A 10Gbe X2-SC ER
Transceiver

D

1 Support indicators:

• V - Validated to respond to DOM requests

• N - No support of DOM

• D - Documented by the component suppliers as supporting DOM

• NA - Not applicable to the transceiver (copper transceiver)
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NOTE: Not all transceivers support Digital Optical Monitoring. If DOM appears in the Diagnostic
Support field of the show interfaces transceiver detail command, or the
hpicfTransceiverMIB hpicfXcvrDiagnostics MIB object, DOM is supported for that transceiver.

Viewing information about transceivers (CLI)
Syntax:

show interfaces transceiver [port-list] [detail]
Displays information about the transceivers. If a port is specified, displays information for the transceiver in that
port.

[detail]
Displays detailed transceiver information.

MIB support
The hpicfTransceiver MIB is available for displaying transceiver information.

Viewing transceiver information
The transceiver information displayed depends on the show command executed.

The output for show interfaces transceiver [port-list] is shown below. You can specify multiple
ports, separated by commas, and the information for each transceiver will display.

Output for a specified transceiver

switch(config)# show interfaces transceiver 21

Transceiver Technical information:

                     Product      Serial             Part
 Port    Type        Number       Number             Number
 ------- ----------- ------------ ------------------ ----------
 21      1000SX      J4858C       MY050VM9WB         1990-3657
If there is no transceiver in the port specified in the command, the output displays as shown below.

Output when no transceiver is present in specified interface

switch(config)# show interfaces transceiver 22

 No Transceiver found on interface 22
When no ports are specified, information for all transceivers found is displayed.

Output when no ports are specified

switch(config)# show interfaces transceiver

 Transceiver Technical information:

                      Product      Serial             Part
  Port    Type        Number       Number             Number
  ------- ----------- ------------ ------------------ ----------
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  21      1000SX      J4858C       MY050VM9WB         1990-3657
  22      1000SX      J4858B       P834DIP2
You can specify all for port-list as shown below.

Output when “all” is specified

switch(config)# show interfaces transceiver all

 No Transceiver found on interface 1

 No Transceiver found on interface 2
.
.
.
 No Transceiver found on interface 24

 Transceiver Technical information:

                      Product      Serial             Part
  Port    Type        Number       Number             Number
  ------- ----------- ------------ ------------------ ----------
  21      1000SX      J4858C       MY050VM9WB         1990-3657
  22      1000SX      J4858B       P834DIP2

Information displayed with the detail parameter
When the show interfaces transceiver [port-list] detail command is executed, the following
information displays.

Table 29: General transceiver information

Parameter Description

Interface
Index

The switch interface number

Transceiver-
type

Pluggable transceiver type

Transceiver
model

Pluggable transceiver model

Connector-
type

Type of connector of the transceiver

Wavelength For an optical transceiver: the central wavelength of the laser sent, in nm. If the transceiver
supports multiple wavelengths, the values will be separated by a comma.

Transfer
Distance

Link-length supported by the transceiver in meters. The corresponding transfer medium is
shown in brackets following the transfer distance value, For example, 50um multimode fiber. If
the transceiver supports multiple transfer media, the values are separated by a comma.

Table Continued
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Parameter Description

Diagnostic
Support

Shows whether the transceiver supports diagnostics:
None

Supported

DOM

Supported

VCT

Supported

Serial Number Serial number of the transceiver

The information in the next three tables is only displayed when the transceiver supports DOM.

Table 30: DOM information

Parameter Description

Temperature Transceiver temperature (in degrees Centigrade)

Voltage Supply voltage in transceiver (Volts)

Bias Laser bias current (mA)

RX power Rx power (mW and dBm))

TX power Tx power (mW and dBm)

The alarm information for GBIC/SFP transceivers is shown in this table.

Table 31: Alarm and error information (GBIC/SFP transceivers only)

Alarm Description

RX loss of signal Incoming (RX) signal is lost

RX power high Incoming (RX) power level is high

RX power low Incoming (RX) power level is low

TX fault Transmit (TX) fault

TX bias high TX bias current is high

TX bias low TX bias current is low

TX power high TX power is high

Table Continued
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Alarm Description

TX power low TX power is low

Temp high Temperature is high

Temp low Temperature is low

Voltage High Voltage is high

Voltage Low Voltage is low

The alarm information for XENPAK transceivers is shown in this table.

Table 32: Alarm and error information (XENPAK transceivers)

Alarm Description

WIS local fault WAN Interface Sublayer local fault

Receive optical power fault Receive optical power fault

PMA/PMD receiver local fault Physical Medium Attachment/Physical Medium Dependent receiver local
fault

PCS receiver local fault Physical Coding Sublayer receiver local fault

PHY XS receive local fault PHY Extended Sublayer receive local fault

RX power high RX power is high

RX power low RX power is low

Laser bias current fault Laser bias current fault

Laser temperature fault Laser temperature fault

Laser output power fault Laser output power fault

TX fault TX fault

PMA/PMD transmitter local fault PMA/PMD transmitter local fault

PCS Transmit local fault PCS transmit local fault

PHY XS transmit local fault PHY SX transmit local fault

TX bias high TX bias current is high

TX bias low TX bias current is low

Table Continued
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Alarm Description

TX power high TX power is high

TX power low TX power is low

Temp high Temperature is high

Temp low Temperature is low

An Example: of the output for the show interfaces transceiver [port-list] detail for a 1000SX transceiver is shown
below.

Detailed information for a 1000SX Mini-GBIC transceiver

switch(config)# show interfaces transceiver 21 detail

 Transceiver in 21
  Interface index    : 21
  Type               : 1000SX 
  Model              : J4858C
  Connector type     : LC 
  Wavelength         : 850nm
  Transfer distance  : 300m (50um), 150m (62.5um),
  Diagnostic support : DOM
  Serial number      : MY050VM9WB

 Status
  Temperature : 50.111C 
  Voltage     : 3.1234V
  TX Bias     : 6mA
  TX Power    : 0.2650mW, -5.768dBm
  RX Power    : 0.3892mW, -4.098dBm

 Time stamp   :  Mon Mar 7 14:22:13 2011
An Example: of the output for a 10GbE-LR transceiver is shown below.

Detailed information for a 10GbE-LR transceiver

switch(config)# show interfaces transceiver 23 detail

 Transceiver in 23
  Interface Index   : 24
  Type              : 10GbE-LR 
  Model             : J8437A
  Connector type    : SC
  Wavelength        : Channel #0: 1310nm, #1:0nm, #2:0nm, #3:0nm
  Transfer distance : 10000m (SM)
  Diagnostic support: DOM
  Serial number     : ED456SS987

 Status
  Temperature : 32.754C 
  TX Bias     : 42.700mA
  TX Power    : 0.5192mW, -2.847dBm
  RX Power    : 0.0040mW, -23.979dBm

 Recent Alarms:
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  Rx power low alarm
  Rx power low warning

 Recent errors:
  Receive optical power fault
  PMA/PMD receiver local fault
  PMA/PMD transmitter local fault
  PCS receive local fault
  PHY XS transmit local fault

 Time stamp : Mon Mar 7 16:26:06 2013

Viewing transceiver information for copper transceivers with VCT support
This feature provides the ability to view diagnostic monitoring information for copper transceivers with Virtual
Cable Test (VCT) support. The cable quality of the copper cables connected between transceivers can be
ascertained using the transceiver cable diagnostics. Results of the diagnostics are displayed with the appropriate
CLI show commands and with SNMP using the hpicfTransceiver MIB.

The J8177C 1000Base-T Mini-GBIC is supported.

Testing the Cable
Enter the test cable-diagnostics command in any context to begin cable diagnostics for the transceiver.
The diagnostic attempts to identify cable faults. The tests may take a few seconds to complete for each interface.
There is the potential of link loss during the diagnostic.

Syntax:

test cable-diagnostics [port-list]
Invokes cable diagnostics and displays the results.

Output from test cable-diagnostics command

Switch # test cable-diagnostics a23-a24

 The ‘test cable-diagnostics’ command will cause a loss of link and will take a few seconds per 
 interface to complete.

 Continue (Y/N)? y

MDI  Cable     Distance  Pair  Pair      MDI 
 Port  Pair  Status     to Fault  Skew  Polarity  Mode
 ----- ----- ---------- --------- ----- --------- ------ 
 A23   1-2   OK         0 m       6 ns  Normal    MDIX
       3-6   OK         0 m       0 ns  Normal
       4-5   OK         0 m       6 ns  Normal    MDIX
       7-8   OK         0 m       6 ns  Normal
 A24   1-2   Short      2 m
       3-6   Impedance  3 m
       4-5   Impedance  3 m
       7-8   Open       1 m

Copper cable diagnostic test results

switch# show interfaces transceiver a23 detail

 Transceiver in A23
  Interface Index   : 23
  Type              : 1000T-sfp

Chapter 16 Troubleshooting 581

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4319



  Model             : J8177C 
  Connector Type    : RJ45
  Wavelength        : n/a
  Transfer Distance : 100m (copper), 
  Diagnostic Support : VCT
  Serial Number     : US051HF099

  Link Status       : Up
  Speed             : 1000
  Duplex            : Full

       MDI   Cable      Distance  Pair  Pair      MDI 
 Port  Pair  Status     to Fault  Skew  Polarity  Mode
 ----- ----- ---------- --------- ----- --------- ----- 
 A23   1-2   OK         0 m       6 ns  Normal    MDIX
       3-6   OK         0 m       0 ns  Normal
       4-5   OK         0 m       6 ns  Normal    MDIX
       7-8   OK         0 m       6 ns  Normal

   Test Last Run   : Fri Apr 22 20:33:23 2011

General transceiver information

Parameter Description

Interface Index The switch interface number

Transceiver-type Pluggable transceiver type

Transceiver
model

Pluggable transceiver model

Connector-type Type of connector of the transceiver

Wavelength For an optical transceiver: the central wavelength of the laser sent, in nm. If the transceiver
supports multiple wavelengths, the values will be separated by a comma. An electrical
transceiver value is displayed as N/A.

Transfer
Distance

Link-length supported by the transceiver in meters. The corresponding transfer medium is
shown in brackets following the transfer distance value, For example, 50um multimode fiber.
If the transceiver supports multiple transfer media, the values are separated by a comma.

Diagnostic
Support

Shows whether the transceiver supports diagnostics:
None

Supported

DOM

Supported

VCT

Supported

Serial Number Serial number of the transceiver

Link Status Link up or down

Table Continued
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Parameter Description

Speed Speed of transceiver in Mbps

Duplex Type of duplexing

Cable Status Values are OK, Open, Short, or Impedance

Distance to Fault The distance in meters to a cable fault (accuracy is +/- 2 meters); displays 0 (zero) if there is
no fault

Pair Skew Difference in propagation between the fastest and slowest wire pairs

Pair Polarity Signals on a wire pair are polarized, with one wire carrying the positive signal and one
carrying the negative signal.

MDI Mode The MDI crossover status of the two wire pairs (1&2, 3&6, 4&5, 7&8), will be either MDI or
MDIX

Using the Event Log for troubleshooting switch problems
The Event Log records operating events in single- or double-line entries and serves as a tool to isolate and
troubleshoot problems.

Once the log has received 2000 entries, it discards the oldest message each time a new message is received.
The Event Log window contains 14 log entry lines. You can scroll through it to view any part of the log.

Once the log has received 2000 entries, it discards the oldest message each time a new message is received.
The Event Log window contains 14 log-entry lines. You can scroll through it to view any part of the log.

NOTE:

The Event Log is erased if power to the switch is interruptedor if you enter the boot system
command. The contents of the Event Log are not erased if you:

• Reboot the switch by choosing the Reboot Switch option from the menu interface.

• Enter the reload command from the CLI.

Event Log entries
As shown in Figure 155: Format of an event log entry on page 583, each Event Log entry is composed of six
or seven fields, depending on whether numbering is turned on or not:

Figure 155: Format of an event log entry
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Item Description

Severity One of the following codes (from highest to lowest severity):

M—(major) indicates that a fatal switch error has occurred.

E—(error) indicates that an error condition occurred on the switch.

W—(warning) indicates that a switch service has behaved unexpectedly.I—(information)
provides information on normal switch operation.

D—(debug) is reserved for internal diagnostic information.

Date The date in the format mm/dd/yy when an entry is recorded in the log.

Time The time in the format hh:mm:ss when an entry is recorded in the log.

Event number The number assigned to an event. You can turn event numbering on and off with the [no]
log-number command.

System module The internal module (such as "ports:" for port manager) that generated a log entry. If VLANs
are configured, a VLAN name also appears for an event that is specific to an individual
VLAN.

Event message A brief description of the operating event.

Using the Menu
To display the Event Log from the Main Menu, select Event Log. The following example shows a sample event
log display.

An event log display

Switch 5406zl                                     25-Oct-2013  18:02:52
==========================-CONSOLE - MANAGER MODE -
=============================
M 10/25/13 16:30:02 sys: 'Operator cold reboot from CONSOLE session.'
I 10/25/13 17:42:51 00061 system: ------------------------------------------
-
I 10/25/13 17:42:51 00063 system: System went down : 10/25/13 16:30:02
I 10/25/13 17:42:51 00064 system: Operator cold reboot from CONSOLE session.
W 10/25/13 17:42:51 00374 chassis: WARNING: SSC is out of Date: Load 8.2 or
newer
I 10/25/13 17:42:51 00068 chassis: Slot D Inserted
I 10/25/13 17:42:51 00068 chassis: Slot E Inserted
I 10/25/13 17:42:51 00068 chassis: Slot F Inserted
I 10/25/13 17:42:51 00690 udpf: DHCP relay agent feature enabled
I 10/25/13 17:42:51 00433 ssh: Ssh server enabled
I 10/25/13 17:42:51 00400 stack: Stack Protocol disabled
I 10/25/13 17:42:51 00128 tftp: Enable succeeded
I 10/25/13 17:42:51 00417 cdp: CDP enabled

----  Log events stored in memory 1-751. Log events on screen 690-704.

  Actions->    Back    Next page    Prev page    End    Help

Return to previous screen.
Use up/down arrow to scroll one line, left/right arrow keys to
change action selection, and <Enter> to execute action.
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The log status line below the recorded entries states the total number of events stored in the event log and
which logged events are currently displayed.

To scroll to other entries in the Event Log, either preceding or following the currently visible portion, press the keys
indicated at the bottom of the display (Back,Nextpage, Prev page, or End) or the keys described in the
following table.

Event Log control keys

Key Action

[N] Advances the display by one page (next page).

[P] Rolls back the display by one page (previous page).

[v] Advances display by one event (down one line).

[ˆ] Rolls back display by one event (up one line).

[E] Advances to the end of the log.

[H] Displays Help for the Event Log.

Using the CLI
Syntax:

By default, the show logging command displays the log messages recorded since the last reboot in
chronological order:

-a Displays all recorded log messages, including those before the last reboot.

-b Displays log events as the time since the last reboot instead of in a date/time format.

-r Displays all recorded log messages, with themost recent entries listed first (reverse order).

-s Displays the active management module (AM) and standby management module (SM) log
events.

-t Displays the log events with a granularity of 10 milliseconds.

-m Displays only major log events.

-e Displays only error event class.

-p Displays only performance log events.

-w Displays only warning log events.

-i Displays only informational log events.

-d Displays only debug log events.

Table Continued
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filter Displays only log filter configuration and status information.

<option-
str>

Displays all Event Log entries that contain the specified text. Use an <option-str> value with -a or
-r to further filter show logging command output.

Example:

To display all Event Log messages that have "system" in the message text or module name, enter the following
command:

switch# show logging -a system
To display all Event Log messages recorded since the last reboot that have the word "system" in the message
text or module name, enter:

switch# show logging system

Clearing Event Log entries
Syntax:

Removes all entries from the event log display output.

Use the clear logging command to hide, but not erase, Event Log entries displayed in show logging
command output. Only new entries generated after you enter the command will be displayed.

To redisplay all hidden entries, including Event Log entries recorded prior to the last reboot, enter the show
logging -a command.

Turning event numbering on
Syntax:

[no] log-numbers
Turns event numbering on and off

Using log throttling to reduce duplicate Event Log and SNMP messages
A recurring event can generate a series of duplicate Event Log messages and SNMP traps in a relatively short
time. As a result, the Event Log and any configured SNMP trap receivers may be flooded with excessive, exactly
identical messages. To help reduce this problem, the switch uses log throttle periods to regulate (throttle)
duplicate messages for recurring events, and maintains a counter to record how many times it detects duplicates
of a particular event since the last system reboot.

When the first instance of a particular event or condition generates a message, the switch initiates a log throttle
period that applies to all recurrences of that event. If the logged event recurs during the log throttle period, the
switch increments the counter initiated by the first instance of the event, but does not generate a new message.

If the logged event repeats again after the log throttle period expires, the switch generates a duplicate of the first
message, increments the counter, and starts a new log throttle period during which any additional instances of the
event are counted, but not logged. Thus, for a particular recurring event, the switch displays only one message in
the Event Log for each log throttle period in which the event reoccurs. Also, each logged instance of the event
message includes counter data showing how many times the event has occurred since the last reboot. The switch
manages messages to SNMP trap receivers in the same way.

Log throttle periods
The length of the log throttle period differs according to an event's severity level:
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Severity level Log throttle period

I (Information) 6000 Seconds

W (Warning) 600 Seconds

D (Debug) 60 Seconds

M (Major) 6 Seconds

Example:

Suppose that you configure VLAN 100 on the switch to support PIM operation, but do not configure an IP
address. If PIM attempts to use VLAN 100, the switch generates the first instance of the following Event Log
message and counter.

NOTE:

In The first instance of an event message and counter on page 587 the counter (1) indicates
that this is the first instance of this event since the switch last rebooted.

The first instance of an event message and counter

W 10/01/12 09:00:33 PIM:No IP address configured on VID 100 (1)
If PIM operation causes the same event to occur six more times during the initial log throttle period, there are no
further entries in the Event Log. However, if the event occurs again after the log throttle period has expired, the
switch repeats the message (with an updated counter) and starts a new log throttle period.

Figure 156: Duplicate messages over multiple log throttling periods

Note that if the same type of event occurs under different circumstances, the switch handles these as unrelated
events for the purpose of Event Log messages. For example, if PIM operation simultaneously detects that VLANs
100 and 205 are configured without IP addresses, you see log messages similar to the following:

Figure 157: Example: of log messages generated by unrelated events of the same type
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Example: of event counter operation
Suppose the switch detects the following after a reboot:

• Three duplicate instances of the PIM "Send error" during the first log throttle period for this event

• Five more instances of the same Send error during the second log throttle period for this event

• Four instances of the same Send error during the third log throttle period for this event

In this case, the duplicate message appears three times in the Event Log (once for each log throttle period for the
event being described), and the duplicate message counter increments as shown in the following table. (The
same operation applies for messages sent to any configured SNMP trap receivers.)

Table 33: How the duplicate message counter increments

Instances during 1st log
throttle period

Instances during 2nd log
throttle period

Instances during 3rd log
throttle period

Duplicate message
counter1

3 1

5 4

4 9

1 This value always comprises the first instance of the duplicate message in the current log throttle period plus all previous
occurrences of the duplicate message occurring since the switch last rebooted.

Reporting information about changes to the running configuration
Syslog can be used for sending notifications to a remote syslog server about changes made to the running
configuration. The notifications in the syslog messages are sent in ASCII format and contain this information:

• Notice-Type: Describes the syslog notification as a “running config change”.

• Event-ID: Identifier for the running config change event that occurred on the switch.

• Config-Method: The source for the running config change.

• Device-Name: The managed device.

• User-Name: User who made the running config change.

• Remote-IP-Address: IP address of a remote host from which the user is connected.

Syntax:

[no] logging notify <running-config-change> [transmission-interval <0-4294967295>
Enables sending the running configuration change notifications to the syslog server.

The no form of the command disables sending the running configuration changes to the syslog server.

Default: Disabled
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<running-config-change > Mandatory option for the notify parameter. Specifies the type of
notification to send.

transmission-interval
<0-4294967295> Specifies the time interval (in seconds) between the

transmission of two consecutive notifications. Running config
changes occurring within the specified interval will not generate
syslog notifications.

A value of zero means there is no limit; a notification is sent for every running config change.

Default: Zero

Sending running config changes to the syslog server

switch(config)# logging notify running-config-change
transmission-interval 10

Debug/syslog operation
While the Event Log records switch-level progress, status, and warning messages on the switch, the debug/
system logging (syslog) feature provides a way to record Event Log and debug messages on a remote device.
For example, you can send messages about routing misconfigurations and other network protocol details to an
external device, and later use them to debug network-level problems.

Debug/syslog messaging
The debug/syslog feature allows you to specify the types of Event Log and debug messages that you want to
send to an external device. You can perform the following operations:

• Use the debug commandto configure messaging reports for the following event types:

◦ Events recorded in the switch's Event Log

◦ LLDP events

◦ SSH events

• Use the logging commandto select a subset of Event Log messages to send to an external device for
debugging purposes according to:
◦ Severity level

◦ System module

Hostname in syslog messages
The syslog now messages the sender identified by hostname.

The hostname field identifies the switch that originally sends the syslog message. Configurable through the CLI
and SNMP, the format of the hostname field supports the following formats:

• ip-address: The IP address of the sending interface will be used as the message origin identifier. This is the
default format for the origin identifier. The IP address of the sending interface (in dotted decimal notation) is the
default format.

• hostname: The hostname of the sending switch will be used as the message origin identifier.

• none: No origin identifier will be embedded in the syslog message. Nilvalue is used as defined by “-“.
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This configuration is system-wide, not per syslog server. There is no support for fully-qualified domain name.

Logging origin-id
Use the logging origin-id command to specify the content for the hostname field.

Syntax:

logging origin-id [ip-address|hostname|none]

[no] logging origin-id [ip-address|hostname|none]
To reset the hostname field content back to default (IP-address), use the no form of the command.

filter

Creates a filter to restrict which events are logged.

IP-ADDR

Adds an IPv4 address to the list of receiving syslog servers.

IPV6-ADDR

Adds an IPv6 address to the list of receiving syslog servers.

origin-id

Sends the Syslog messages with the specified origin-id.

notify

Notifies the specified type sent to the syslog server(s).

priority-descr

A text string associated with the values of facility, severity, and system-module.

severity

Event messages of the specified severity or higher sent to the syslog server.

system-module

Event messages of the specified system module (subsystem) sent to the syslog server.

hostname

Sets the hostname of the device as the origin-id.

none

Disables origin-id in the syslog message.

Add an IP address to the list of receiving syslog servers.

Use of no without an IP address specified will remove all IP addresses from the list of syslog receivers. If an IP
address is specified, that receiver will be removed. Both link-local with zone ID and global IPv6 addresses are
supported.

• Specify syslog server facility with the option <facility>. The command no logging <facility> sets
the facility back to defaults.

• Specify filtering rules.

• Specify severity for event messages to be filtered to the syslog server with the option <severity>. The
command no logging <severity> sets the severity back to default.
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• Event messages of specified system module will be sent to the syslog server. Using no sends messages from
all system modules. Messages are first filtered by selected severity.

• Specify syslog server transport layer with options [udp]|[tcp]|[tls].

• Specify syslog server port number with options [udp PORT-NUM]|[tcp PORT-NUM]|[tls PORT-NUM].

• Specify notification types to be sent to the syslog server.

• Use the option transmission-interval to control the egress rate limit for transmitting notifications, 0 value
means there is no rate limit. The values are in seconds. Only one syslog message is allowed for transmission
within specified time interval.

• Specify the origin information for the syslog messages with the option origin-id.

NOTE: When the syslog server receives messages from the switch, the IPv6 address of the switch is
partly displayed.

Example:

Configured Host Ipv6 Address: 2001::1

Expected Syslog message:

Syslog message: USER.INFO: Oct 11 02:40:02 2001::1 00025 ip:
ST1CMDR: VLAN60: ip address 30.1.1.1/24 configured on vlan 60
Actual Truncated syslog message:

Syslog message: USER.INFO: Oct 11 02:40:02 2001:: 00025 ip: ST1CMDR:
VLAN60: ip address 30.1.1.1/24 configured on vlan 60

Use the command in the following example to set the origin-id to the hostname.

Setting the origin-id to the hostname

switch(config)# logging origin-id hostname
The following syslog message will occur:

<14> Jan 1 00:15:35 2910al-24G 00076 ports: port 2 is now on-line
Use the command in the following example to set the origin-id to none (nilvalue).

Setting the origin-id to none (nilvalue)

switch(config)# logging origin-id none
The following syslog message will occur:

<14> Jan 1 00:15:35 - 00076 ports: port 2 is now on-line
Use any of the commands in the following example to set the origin-id to ip-address (default).

Setting the origin-id to ip-address (default)

switch(config)# logging origin-id ip-address

switch(config)# no logging origin-id hostname

switch(config)# no logging origin-id none
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The following syslog message will occur:

<14> Jan 1 00:15:35 169.254.230.236 00076 ports: port 2 is now on-line

Viewing the identification of the syslog message sender
Use the commands show debug or show running-config to display the identification of the syslog message
sender. The default option for origin-id is ip-address. The command show running-config will not
display the configured option when origin-id is set to the default value of ip address.

When hostname or none is configured using logging origin-id, the same displays as part of the show
running-config command.

Syntax:

show debug
Default option is ip-address.

The following shows the output of the show debug command when configured without loggin origin-id.

Output of the show debug command when configured without login origin-id

Debug Logging
  Origin identifier: Outgoing Interface IP
  Destination:     None

Enabled debug types:
  None are enabled.
The command logging origin-id hostname will produce the syslog message shown in the following
example.

Syslog message for logging origin-id hostname

Debug Logging
  Origin identifier: Hostname
  Destination:    None

Enabled debug types:
  None are enabled.
The command logging origin-id none will produce the syslog message shown in the following example.

Syslog message for logging origin-id none

Debug Logging
  Origin identifier: none
  Destination:    None

Enabled debug types:
  None are enabled.
Syntax:

show running-config
The following example shows the output of the show running-config command.
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Output of the show running-config command

The command logging origin-id hostname will display the 
following:
logging origin-id hostname
The command logging origin-id none will display as the following:

logging origin-id none

SNMP MIB
SNMP support will be provided through the following MIB objects.

HpicfSyslogOriginId = textual-convention

Description

This textual convention enumerates the origin identifier of syslog message.

Syntax: integer

ip-address

hostname

none

Status

current

hpicfSyslogOriginId OBJECT-TYPE

Description

Specifies the content of a Hostname field in the header of a syslog message.

Syntax:

HpicfSyslogOriginId

Max-access

read-write

Status

current

Default

ip-address

Debug/syslog destination devices
To use debug/syslog messaging, you must configure an external device as the logging destination by using the
logging and debug destination commands. For more information, see Debug destinations on page 598
and Configuring a syslog server on page 599.

A debug/syslog destination device can be a syslog server and/or a console session. You can configure debug and
logging messages to be sent to:

Chapter 16 Troubleshooting 593

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4331



• Up to six syslog servers

• A CLI session through a direct RS-232 console connection, or a Telnet or SSH session

Debug/syslog configuration commands
Using the Debug/Syslog feature, you can perform the following operations:

• Configure the switch to send Event Log messages to one or more Syslog servers. In addition, you can
configure the messages to be sent to the User log facility (default) or to another log facility on configured
Syslog servers.

• Configure the switch to send Event Log messages to the current management- access session (serial-connect
CLI, Telnet CLI, or SSH).

• Disable all Syslog debug logging while retaining the Syslog addresses from the switch configuration. This
allows you to configure Syslog messaging and then disable and re-enable it as needed.

• Display the current debug configuration. If Syslog logging is currently active, the list f configured Syslog
servers is displayed.

• Display the current Syslog server list when Syslog logging is disabled.

Configuring debug/syslog operation

Procedure

1. To use a syslog server as the destination device for debug messaging, follow these steps:

a. Enter the logging <syslog-ip-addr> command at the global configuration level to configure the
syslog server IP address and enable syslog logging. Optionally, you may also specify the destination
subsystem to be used on the syslog server by entering the logging facility command.If no other
syslog server IP addresses are configured, entering the logging command enables both debug
messaging to a syslog server and the event debug message type. As a result, the switch automatically
sends Event Log messages to the syslog server, regardless of other debug types that may be configured.

b. Re-enter the logging command in Step 1a to configure additional syslog servers. You can configure up to
a total of six servers. (When multiple server IP addresses are configured, the switch sends the debug
message types that you configure in Step 3 to all IP addresses.)

2. To use a CLI session on a destination device for debug messaging:

a. Set up a serial, Telnet, or SSH connection to access the switch's CLI.

b. Enter the debug destination session command at the manager level.

3. Enable the types of debug messages to be sent to configured syslog servers, the current session device, or
both by entering the debug <debug-type> command and selecting the desired options.

Repeat this step if necessary to enable multiple debug message types.

By default, Event Log messages are sent to configured debug destination devices. To block Event Log
messages from being sent, enter the no debug event command.
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4. If necessary, enable a subset of Event Log messages to be sent to configured syslog servers by specifying a
severity level, a system module, or both using the following commands:

switch(config)# logging severity <debug | major | error | warning | info>
switch(config)# logging system-module <system-module>

To display a list of valid values for each command, enter logging severity or logging system-module
followed by ? or pressing the Tab key.

5. If you configure system-module, severity-level values, or both to filter Event Log messages, when you finish
troubleshooting, you may want to reset these values to their default settings so that the switch sends all Event
Log messages to configured debug destinations (syslog servers, CLI session, or both).

To remove a configured setting and restore the default values that send all Event Log messages, enter one or
both of the following commands:

switch(config)# no logging severity <debug | major | error | warning | info>
switch(config)# no logging system-module <system-module>

CAUTION: If you configure a severity-level, system-module, logging destination, or logging facility
value and save the settings to the startup configuration (For example, by entering the write
memory command), the debug settings are saved after a system reboot (power cycle or reboot) and
re-activated on the switch. As a result, after switch startup, one of the following situations may occur:

• Only a partial set of Event Log messages may be sent to configured debug destinations.

• Messages may be sent to a previously configured syslog server used in an earlier debugging
session.

Viewing a debug/syslog configuration
Use the show debug command to display the currently configured settings for:

• Debug message types and Event Log message filters (severity level and system module) sent to debug
destinations

• Debug destinations (syslog servers or CLI session) and syslog server facility to be used

Syntax:

show debug
Displays the currently configured debug logging destinations and message types selected for debugging
purposes. (If no syslog server address is configured with the logging <syslog-ip-addr> command, no
show debug command output is displayed.)

Output of the show debug command

switch(config)# show debug

 Debug Logging
  Destination:
   Logging --
    10.28.38.164
    Facility=kern
    Severity=warning
    System module=all-pass
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   Enabled debug types:
    event
Example:

In the following Example:, no syslog servers are configured on the switch (default setting). When you configure a
syslog server, debug logging is enabled to send Event Log messages to the server. To limit the Event Log
messages sent to the syslog server, specify a set of messages by entering the logging severity and
logging system-module commands.

Figure 158: Syslog configuration to receive event log messages from specified system module and severity
levels

As shown at the top of Figure 158: Syslog configuration to receive event log messages from specified
system module and severity levels on page 596, if you enter the show debug command when no syslog
server IP address is configured, the configuration settings for syslog server facility, Event Log severity level, and
system module are not displayed. However, after you configure a syslog server address and enable syslog
logging, all debug and logging settings are displayed with the show debug command.

If you do not want Event Log messages sent to syslog servers, you can block the messages from being sent by
entering the no debug event command. (There is no effect on the normal logging of messages in the switch's
Event Log.)

Example:

The next Example: shows how to configure:

• Debug logging of ACL and IP-OSPF packet messages on a syslog server at 18.38.64.164 (with user as the
default logging facility).

• Display of these messages in the CLI session of your terminal device's management access to the switch.

• Blocking Event Log messages from being sent from the switch to the syslog server and a CLI session.
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To configure syslog operation in these ways with the debug/syslog feature disabled on the switch, enter the
commands shown in Figure 159: Debug/syslog configuration for multiple debug types and multiple
destinations on page 597.

Figure 159: Debug/syslog configuration for multiple debug types and multiple destinations

Debug command
At the manager level, use the debug command to perform two main functions:

• Specify the types of event messages to be sent to an external destination.

• Specify the destinations to which selected message types are sent.

By default, no debug destination is enabled and only Event Log messages are enabled to be sent.

NOTE:

To configure a syslog server, use the logging <syslog-ip-addr> command. For more
information, see Configuring a syslog server on page 599.
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Debug messages
Syntax:

[no] debug <debug-type>

Debug destinations
Use the debug destination command to enable (and disable)syslog messaging on a syslog server or to a CLI
session for specified types of debug and Event Log messages.

Syntax:

[no] debug destination {<logging | session | buffer>}

logging Enables syslog logging to configured syslog servers so that the debug message types
specified by the debug <debug-type> command (see Debug messages on page 598)
are sent.(Default: Logging disabled)To configure a syslog server IP address, see 
Configuring a syslog server on page 599.

NOTE: Debug messages from the switches covered in this guide have a
debug severity level. Because the default configuration of some syslog
servers ignores syslog messages with the debug severity level, ensure that
the syslog servers you want to use to receive debug messages are
configured to accept the debug level. For more information, see Operating
notes for debug and Syslog on page 604.

session Enables transmission of event notification messages to the CLI session that most recently
executed this command. The session can be on any one terminal emulation device with
serial, Telnet, or SSH access to the CLI at the Manager level prompt (switch#_).If more
than one terminal device has a console session with the CLI, you can redirect the
destination from the current device to another device. Do so by executing debug
destination session in the CLI on the terminal device on which you now want to
display event messages.Event message types received on the selected CLI session are
configured with the debug <debug-type> command.

buffer Enables syslog logging to send the debug message types specified by the debug
<debug-type> command to a buffer in switch memory.To view the debug messages
stored in the switch buffer, enter the show debug buffer command.

Logging command
At the global configuration level, the loggingcommand allows you to enable debug logging on specified syslog
servers and select a subset of Event Log messages to send for debugging purposes according to:

• Severity level

• System module

By specifying both a severity level and system module, you can use both configured settings to filter the Event
Log messages you want to use to troubleshoot switch or network error conditions.

598 Aruba 3810 / 5400R Management and Configuration Guide for
ArubaOS-Switch 16.08

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4336



CAUTION:

After you configure a syslog server and a severity level and/or system module to filter the Event Log
messages that are sent, if you save these settings to the startup configuration file by entering the
write memory command, these debug and logging settings are automatically re-activated after a
switch reboot or power recycle. The debug settings and destinations configured in your previous
troubleshooting session will then be applied to the current session, which may not be desirable.

After a reboot, messages remain in the Event Log and are not deleted. However, after a power
recycle, all Event Log messages are deleted.

If you configure a severity level, system module, or both to temporarily filter Event Log messages, be
sure to reset the values to their default settings by entering the no form of the following commands to
ensure that Event Log messages of all severity levels and from all system modules are sent to
configured syslog servers:

switch(config)# no logging severity <debug | major | error | warning | 
info>
switch(config)# no logging system-module <system-module>

Configuring a syslog server
Syslog is a client-server logging tool that allows a client switch to send event notification messages to a
networked device operating with syslog server software. Messages sent to a syslog server can be stored to a file
for later debugging analysis.

To use the syslog feature, you must install and configure a syslog server application on a networked host
accessible to the switch. For instructions, see the documentation for the syslog server application.

To configure a syslog service, use the logging <syslog-ip-addr> command as shown below.

When you configure a syslog server, Event Log messages are automatically enabled to be sent to the server. To
reconfigure this setting, use the following commands:

• debug
Specifies additional debug message types (see Debug messages on page 598).

• logging
Configures the system module or severity level used to filter the Event Log messages sent to configured
syslog servers. (See Configuring the severity level for Event Log messages sent to a syslog server on
page 603 and Configuring the system module used to select the Event Log messages sent to a
syslog server on page 603.)

To display the currently configured syslog servers as well as the types of debug messages and the severity-level
and system-module filters used to specify the Event Log messages that are sent, enter the show debug
command (See Debug/syslog configuration commands on page 594).

Syntax:

[no] logging <syslog-ip-addr>
Enables or disables syslog messaging to the specified IP address. You can configure up to six addresses. If you
configure an address when none are already configured, this command enables destination logging (syslog) and
the Event debug type. Therefore, at a minimum, the switch begins sending Event Log messages to configured
syslog servers. The ACL, IP-OSPF, and/or IP-RIP message types are also sent to the syslog servers if they are
currently enabled as debug types. (See Debug messages on page 598.)
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no logging Removes all currently configured syslog logging destinations from the
running configuration.Using this form of the command to delete the only
remaining syslog server address disables debug destination logging on the
switch, but the default Event debug type does not change.

no logging <syslog-ip-
address> Removes only the specified syslog logging destination from the running

configuration.Removing all configured syslog destinations with the no
logging command (or a specified syslog server destination with the no
logging <syslog-ip-address> command) does not delete the syslog
server IP addresses stored in the startup configuration.

Deleting syslog addresses in the startup configuration
Enter a no logging command followed by the write memory command.

Verifying the deletion of a syslog server address
Display the startup configuration by entering the show config command.

Blocking the messages sent to configured syslog servers from the currently configured
debug message type
Enter the no debug <debug-type> command. (See Debug messages on page 598.)

Disabling syslog logging on the switch without deleting configured server addresses
Enter the no debug destination logging command. Note that, unlike the case in which no syslog servers
are configured, if one or more syslog servers are already configured and syslog messaging is disabled,
configuring a new server address does not re-enable syslog messaging. To re-enable syslog messaging, you
must enter the debug destination logging command.

Sending logging messages using TCP
Syntax:

[no] logging <ip-addr> [udp 1024-49151 | tcp 1024-49151]
Allows the configuration of the UDP or TCP transport protocol for the transmission of logging messages to a
syslog server.

Specifying a destination port with UDP or TCP is optional.

Default ports: UDP port is 514

TCP port is 1470

Default Transport Protocol: UDP

Because TCP is a connection-oriented protocol, a connection must be present before the logging information is
sent. This helps ensure that the logging message will reach the syslog server. Each configured syslog server
needs its own connection. You can configure the destination port that is used for the transmission of the logging
messages.

Configuring TCP for logging message transmission using the default port

switch(config)# logging 192.123.4.5 tcp
(Default TCP port 1470 is used.)
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Configuring TCP for logging message transmission using a specified port

switch(config)# logging 192.123.4.5 9514
(TCP port 9514 is used.)

Configuring UDP for logging message transmission using the default port

switch(config)# logging 192.123.4.5 udp
(Default UDP port 514 is used.)

Configuring UDP for logging message transmission using a specified port

switch(config)# logging 192.123.4.5 9512
(UDP port 9512 is used.)

Syntax:

[no] logging facility <facility-name>
The logging facility specifies the destination subsystem used in a configured syslog server. (All configured syslog
servers must use the same subsystem.) Hewlett Packard Enterprise recommends the default (user) subsystem
unless your application specifically requires another subsystem. Options include:

user (default) Random user-level messages

kern Kernel messages

mail Mail system

daemon System daemons

auth Security/authorization messages

syslog Messages generated internally by syslog

lpr Line-printer subsystem

news Netnews subsystem

uucp uucp subsystem

cron cron/at subsystem

sys9 cron/at subsystem

sys10 - sys14 Reserved for system use

local10 - local17 Reserved for system use
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Use the no form of the command to remove the configured facility and reconfigure the default (user) value.

Adding a description for a Syslog server
You can associate a user-friendly description with each of the IP addresses (IPv4 only) configured for syslog
using the CLI or SNMP.

NOTE:

The Hewlett Packard Enterprise MIB hpicfSyslog.mib allows the configuration and monitoring of
syslog for SNMP (RFC 3164 supported).

CAUTION:

Entering the no logging command removes ALL the syslog server addresses without a verification
prompt.

The CLI command is:

Syntax:

logging <ip-addr> [control-descr ZZZZTRISHZZZZ <text_string>] 
 no logging <ip-addr> [control-descr]
An optional user-friendly description that can be associated with a server IP address. If no description is entered,
this is blank. If <text_string> contains white space, use quotes around the string. IPv4 addresses only.

Use the no form of the command to remove the description. Limit: 255 characters

NOTE:

To remove the description using SNMP, set the description to an empty string.

The logging command with a control description

switch(config)# logging 10.10.10.2 control-descr syslog_one

Adding a priority description
This description can be added with the CLI or SNMP. The CLI command is:

Syntax:

logging priority-descr <text_string> 
 no logging priority-descr
Provides a user-friendly description for the combined filter values of severity and system module. If no
description is entered, this is blank.

If text_string contains white space, use quotes around the string.

Use the no form of the command to remove the description.

Limit: 255 characters

The logging command with a priority description

switch(config)# logging priority-descr severe-pri
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NOTE:

A notification is sent to the SNMP agent if there are any changes to the syslog parameters, either
through the CLI or with SNMP.

Configuring the severity level for Event Log messages sent to a syslog
server
Event Log messages are entered with one of the following severity levels (from highest to lowest):

Major A fatal error condition has occurred on the switch.

Error An error condition has occurred on the switch.

Warning A switch service has behaved unexpectedly.

Information Information on a normal switch event.

Debug Reserved for switch internal diagnostic information.

Using the logging severity command, you can select a set of Event Log messages according to their
severity level and send them to a syslog server. Messages of the selected and higher severity will be sent. To
configure a syslog server, see Configuring a syslog server on page 599.

Syntax:

[no] logging severity {< major | error | warning | info | debug >}
Configures the switch to send all Event Log messages with a severity level equal to or higher than the specified
value to all configured Syslog servers.

Default: debug (Reports messages of all severity levels.)

Use the no form of the command to remove the configured severity level and reconfigure the default value, which
sends Event Log messages of all severity levels to syslog servers.

NOTE: The severity setting does not affect event notification messages that the switch normally
sends to the Event Log. All messages remain recorded in the Event Log.

Configuring the system module used to select the Event Log messages sent to a syslog
server
Event Log messages contain the name of the system module that reported the event. Using the logging
system-module command, you can select a set of Event Log messages according to the originating system
module and send them to a syslog server.

Syntax:

[no] logging system-module <system-module>
Configures the switch to send all Event Log messages being logged from the specified system module to
configured syslog servers. (To configure a syslog server, see Configuring a syslog server.)

Default: all-pass (Reports all Event Log messages.)

Use the no form of the command to remove the configured system module value and reconfigure the default
value, which sends Event Log messages from all system modules to syslog servers.
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You can select messages from only one system module to be sent to a syslog server; you cannot configure
messages from multiple system modules to be sent. If you re-enter the command with a different system module
name, the currently configured value is replaced with the new one.

NOTE: This setting has no effect on event notification messages that the switch normally sends to
the Event Log.

Enabling local command logging
Use this command to enable local command logging. This satisfies the NDcPP certification requirement that:

• All administrative actions (commands) are logged locally.

• Local command log storage can be enabled and disabled.

• The identity of the user causing an event is logged.

• When the command log is exhausted by 80% and wraparound occurs, the event is logged and a trap is
generated.

• Log messages have a maximum of 240 characters (the RMON event maximum string length) and are stored in
the command log buffer.

• Log messages greater than the maximum length are truncated and are not stored in the command log buffer.

Syntax:

[no] logging command 

Operating notes for debug and Syslog
• Rebooting the switch or pressing the Reset button resets the debug configuration.

Debug option Effect of a reboot or reset

logging (debug destination) If syslog server IP addresses are stored in the startup-config file, they are
saved across a reboot and the logging destination option remains enabled.
Otherwise, the logging destination is disabled.

session (debug destination) Disabled.

ACL (debug type) Disabled.

All (debug type) Disabled.

event (debug type) If a syslog server IP address is configured in the startup-config file, the
sending of Event Log messages is reset to enabled, regardless of the
last active setting.

If no syslog server is configured, the sending of Event Log messages is
disabled.

IP (debug type) Disabled.

• Debug commands do not affect normal message output to the Event Log.
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Using the debug event command, you can specify that Event Log messages are sent to the debug
destinations you configure (CLI session, syslog servers, or both) in addition to the Event Log.

• Ensure that your syslog servers accept debug messages.

All syslog messages resulting from a debug operation have a "debug" severity level. If you configure the switch
to send debug messages to a syslog server, ensure that the server's syslog application is configured to accept
the "debug" severity level. (The default configuration for some syslog applications ignores the "debug" severity
level.)

• Duplicate IP addresses are not stored in the list of syslog servers.

• If the default severity value is in effect, all messages that have severities greater than the default value are
passed to syslog. For example, if the default severity is "debug," all messages that have severities greater
than debug are passed to syslog.

• There is a limit of six syslog servers. All syslog servers are sent the same messages using the same filter
parameters. An error is generated for an attempt to add more than six syslog servers.

Diagnostic tools

Port auto-negotiation
When a link LED does not light (indicating loss of link between two devices), the most common reason is a failure
of port auto-negotiation between the connecting ports. If a link LED fails to light when you connect the switch to a
port on another device, do the following:

Procedure

1. Ensure that the switch port and the port on the attached end-node are both set to Auto mode.

2. If the attached end-node does not have an Auto mode setting, you must manually configure the switch port to
the same setting as the end-node port.

Ping and link tests
The ping test and the link test are point-to-point tests between your switch and another IEEE 802.3-compliant
device on your network. These tests can tell you whether the switch is communicating properly with another
device.

NOTE:

To respond to a ping test or a link test, the device you are trying to reach must be IEEE 802.3-
compliant.

Ping test
A test of the path between the switch and another device on the same or another IP network that can respond to
IP packets (ICMP Echo Requests). To use the ping (or traceroute) command with host names or fully
qualified domain names, see DNS resolver on page 617.

Link test
A test of the connection between the switch and a designated network device on the same LAN (or VLAN, if
configured). During the link test, IEEE 802.2 test packets are sent to the designated network device in the same
VLAN or broadcast domain. The remote device must be able to respond with an 802.2 Test Response Packet.
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Executing ping or link tests (WebAgent)
To start a ping or link test in the WebAgent:

1. In the navigation pane, click Troubleshooting.

2. Click Ping/Link Test.

3. Click Start.

4. To halt a link or ping test before it concludes, click Stop.

For an Example: of the text screens, see Figure 160: Ping test and link test screen on the WebAgent on page
606.

Figure 160: Ping test and link test screen on the WebAgent

Destination IP Address is the network address of the target, or destination, device to which you want to test a
connection with the switch. An IP address is in the X.X.X.X format where X is a decimal number between 0 and
255.

Number of Packets to Send is the number of times you want the switch to attempt to test a connection.

Timeout in Seconds is the number of seconds to allow per attempt to test a connection before determining that
the current attempt has failed.

Testing the path between the switch and another device on an IP network
The ping test uses ICMP echo requests and ICMP echo replies to determine if another device is alive. It also
measures the amount of time it takes to receive a reply from the specified destination. The ping command has
several extended commands that allow advanced checking of destination availability.

Syntax:

Sends ICMP echo requests to determine if another device is alive.

Ping tests

switch# ping 10.10.10.10
10.10.10.10 is alive, time = 15 ms

switch# ping 10.10.10.10 repetitions 3
10.10.10.10 is alive, iteration 1, time = 15 ms
10.10.10.10 is alive, iteration 1, time = 15 ms
10.10.10.10 is alive, iteration 1, time = 15 ms

switch# ping 10.10.10.10 timeout 2
10.10.10.10 is alive, time = 10 ms
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switch# ping 10.11.12.13
The destination address is unreachable.

Halting a ping test
To halt a ping test before it concludes, press [Ctrl] [C].

NOTE:

To use the ping (or traceroute) command with host names or fully qualified domain names, see 
DNS resolver on page 617.

Issuing single or multiple link tests
Single or multiple link tests can have varying repetitions and timeout periods. The defaults are:

• Repetitions: 1 (1 to 999)

• Timeout: 5 seconds (1 to 256 seconds)

Syntax:

link <mac-address> [repetitions <1-999>] [timeout <1-256>] [vlan < vlan-id >]
Example:

Figure 161: Link tests

Tracing the route from the switch to a host address
The traceroute command enables you to trace the route from the switch to a host address.

This command outputs information for each (router) hop between the switch and the destination address. Note
that every time you execute traceroute, it uses the same default settings unless you specify otherwise for that
instance of the command.

Syntax:

Lists the IP address or hostname of each hop in the route, plus the time in microseconds for the traceroute
packet reply to the switch for each hop.
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NOTE: For information about traceroute6, see the IPv6 configuration guide for your switch.

Halting an ongoing traceroute search
Press the [Ctrl] [C] keys.

A low maxttl causes traceroute to halt before reaching the destination address
Executing traceroute with its default values for a destination IP address that is four hops away produces a
result similar to this:

Figure 162: A completed traceroute enquiry

Continuing from the previous Example: (Figure 162: A completed traceroute enquiry on page 608), executing
traceroute with an insufficient maxttl for the actual hop count produces an output similar to this:

Figure 163: Incomplete traceroute because of low maxttl setting

If a network condition prevents traceroute from reaching the destination
Common reasons for traceroute failing to reach a destination include:

• Timeouts (indicated by one asterisk per probe, per hop)

• Unreachable hosts

• Unreachable networks

• Interference from firewalls

• Hosts configured to avoid responding
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Executing traceroute where the route becomes blocked or otherwise fails results in an output marked by
timeouts for all probes beyond the last detected hop. For example, with a maximum hop count of 7 (maxttl = 7),
where the route becomes blocked or otherwise fails, the output appears similar to this:

Figure 164: Traceroute failing to reach the destination address

Viewing switch configuration and operation
In some troubleshooting scenarios, you may need to view the switch configuration to diagnose a problem. The
complete switch configuration is contained in a file that you can browse from the CLI using the commands
described in this section.

Viewing the startup or running configuration file
Syntax:

write terminal
Displays the running configuration.

show config Displays the startup configuration.

show running-config Displays the running-config file.

For more information and examples of how to use these commands, see “Switch Memory and Configuration” in
the basic operation guide.

Viewing the configuration file (WebAgent)
To display the running configuration using the WebAgent:

1. In the navigation pane, click Troubleshooting.

2. Click Configuration Report.

3. Use the right-side scroll bar to scroll through the configuration listing.

Viewing a summary of switch operational data
Syntax:

show tech
By default, the show tech command displays a single output of switch operating and running-configuration data
from several internal switch sources, including:
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• Image stamp (software version data)

• Running configuration

• Event Log listing

• Boot history

• Port settings

• Status and counters — port status

• IP routes

• Status and counters — VLAN information

• GVRP support

• Load balancing (trunk and LACP)

The show tech command on page 610 shows sample output from the show tech command.

The show tech command

switch# show tech

 show system

  Status and Counters - General System Information

   System Name        : Switch
   System Contact     :
   System Location    :

   MAC Age Time (sec) : 300

   Time Zone          : 0
   Daylight Time Rule : None

   Software revision  : XX.14.xx     Base MAC Addr  : 001871-c42f00
   ROM Version        : XX.12.12     Serial Number  : SG641SU00L

   Up Time            : 23 hours    Memory - Total :
   CPU Util (%)       : 10                    Free :

   IP Mgmt - Pkts Rx  : 759         Packet - Total : 6750
              Pkts Tx : 2             Buffers Free : 5086
                                            Lowest : 4961
                                            Missed : 0

show flash
Image       Size(Bytes)   Date  Version
-----       -----------  ------ --------
To specify the data displayed by the show tech command, use the copy show tech command.

Saving show tech command output to a text file
When you enter the show tech command, a summary of switch operational data is sent to your terminal
emulator. You can use your terminal emulator's text capture features to save the show tech data to a text file for
viewing, printing, or sending to an associate to diagnose a problem.
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For example, if your terminal emulator is the Hyperterminal application available with Microsoft® Windows®
software, you can copy the show tech output to a file and then use either Microsoft Word or Notepad to display
the data. (In this case, Microsoft Word provides the data in an easier-to-read format.)

The following example uses the Microsoft Windows terminal emulator. If you are using a different terminal
emulator application, see the documentation provided with the application.

Procedure

1. In Hyperterminal, click on Transfer|Capture Text….

Figure 165: Capture text window of the Hyperterminal application

2. In the File field, enter the path and file name in which you want to store the show tech output.

Figure 166: Entering a path and filename for saving show tech output

3. Click [Start] to create and open the text file.

4. From the global configuration context, enter the show tech command:

switch# show tech
The show tech command output is copied into the text file and displayed on the terminal emulator screen.
When the command output stops and displays -- MORE --, press the Space bar to display and copy more
information. The CLI prompt appears when the command output finishes.

5. Click on Transfer|Capture Text|Stop in HyperTerminal to stop copying data and save the text file.

If you do not stop HyperTerminal from copying command output into the text file, additional unwanted data can
be copied from the HyperTerminal screen.

6. To access the file, open it in Microsoft Word, Notepad, or a similar text editor.

Viewing more information on switch operation
Use the following commands to display additional information on switch operation for troubleshooting purposes.

Syntax:

show boot-history
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Displays the crash information saved for each management module on the switch.

show history
Displays the current command history. This command output is used for reference or when you want to repeat a
command (See Displaying the information you need to diagnose problems on page 613).

show system-information
Displays globally configured parameters and information on switch operation.

show version
Displays the software version currently running on the switch and the flash image from which the switch booted
(primary or secondary). For more information, see "Displaying Management Information" in the "Redundancy
(Switch 8212zl)" .

show interfaces
Displays information on the activity on all switch ports (see "Viewing Port Status and Configuring Port
Parameters" in the "Port Status and Configuration" ).

show interfaces-display
Displays the same information as the show interfaces command and dynamically updates the output every
three seconds. Press Ctrl + C to stop the dynamic updates of system information. Use the Arrow keys to view
information that is off the screen.

Searching for text using pattern matching with show command
Selected portions of the output are displayed, depending on the parameters chosen.

Syntax:

show {< command option > | < include | exclude | begin >} <regular expression>
Uses matching pattern searches to display selected portions of the output from a show command. There is no
limit to the number of characters that can be matched. Only regular expressions are permitted; symbols such as
the asterisk cannot be substituted to perform more general matching.

include Only the lines that contain the matching pattern are displayed in the output.

exclude Only the lines that contain the matching pattern are not displayed in the output.

begin The display of the output begins with the line that contains the matching pattern.

NOTE: Pattern matching is case-sensitive.

Following are examples of what portions of the running config file display depending on the option chosen.

Pattern matching with include option

switch(config)# show run | include ipv6 1
   ipv6 enable
   ipv6 enable
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ipv6 access-list "EH-01"
switch(config)#

1Displays only lines that contain “ipv6”.

Pattern matching with begin option

switch(config)# show run | begin ipv6 1
   ipv6 enable
   no untagged 21-24
   exit
vlan 20
   name "VLAN20"
   untagged 21-24
   ipv6 enable
   no ip address
   exit
policy qos "michael"
   exit
ipv6 access-list "EH-01"
   sequence 10 deny tcp 2001:db8:255::/48 2001:db8:125::/48
   exit
no autorun
password manager

1Displays the running config beginning at the first line that contains “ipv6”.

The following is an Example: of the show arp command output, and then the output displayed when the
include option has the IP address of 15.255.128.1 as the regular expression.

The show arp command and pattern matching with the include option

switch(config)# show arp

 IP ARP table

  IP Address      MAC Address    Type    Port
  -------------   -------------- ------- ----
  15.255.128.1    00000c-07ac00  dynamic B1
  15.255.131.19   00a0c9-b1503d  dynamic
  15.255.133.150  000bcd-3cbeec  dynamic B1

switch(config)# show arp | include 15.255.128.1
  15.255.128.1    00000c-07ac00  dynamic B1

Displaying the information you need to diagnose problems
Use the following commands in a troubleshooting session to more accurately display the information you need to
diagnose a problem.

Syntax:

alias
Creates a shortcut alias name for commonly used commands and command options.
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Syntax:

kill
Terminates a currently running, remote troubleshooting session. Use the show ip ssh command to list the
current management sessions.

Syntax:

[no] page
Toggles the paging mode for show commands between continuous listing and per-page listing.

Syntax:

repeat
Repeatedly executes one or more commands so that you can see the results of multiple commands displayed
over a period of time. To halt the command execution, press any key on the keyboard.

Syntax:

setup
Displays the Switch Setup screen from the menu interface.

Restoring the factory-default configuration
As part of your troubleshooting process, it may become necessary to return the switch configuration to the factory
default settings. This process:

• Momentarily interrupts the switch operation

• Clears any passwords

• Clears the console Event Log

• Resets the network counters to zero

• Performs a complete self test

• Reboots the switch into its factory default configuration, including deleting an IP address

There are two methods for resetting to the factory-default configuration:

• CLI

• Clear/Reset button combination

NOTE: Hewlett Packard Enterprise recommends that you save your configuration to a TFTP server
before resetting the switch to its factory-default configuration. You can also save your configuration
via Xmodem to a directly connected PC.

Resetting to the factory-default configuration

Using the CLI
This command operates at any level except the Operator level.

614 Aruba 3810 / 5400R Management and Configuration Guide for
ArubaOS-Switch 16.08

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4352



Syntax:

erase startup-configuration
Deletes the startup-config file in flash so that the switch will reboot with its factory-default configuration.

NOTE:

The erase startup-config command does not clear passwords unless include-
credentials has been set, at which time this command does erase username/password
information and any other credentials stored in the config file. For more information, see the section
on "Saving Security Credentials in a Config File" in the access security guide for your switch.

Using Clear/Reset

Procedure

1. Using pointed objects, simultaneously press both the Reset and Clear buttons on the front of the switch.

2. Continue to press the Clear button while releasing the Reset button.

3. When the Self Test LED begins to flash, release the Clear button.

The switch then completes its self test and begins operating with the configuration restored to the factory
default settings.

Restoring a flash image
The switch can lose its operating system if either the primary or secondary flash image location is empty or
contains a corrupted OS file and an operator uses the erase flash command to erase a good OS image file
from the opposite flash location.

Recovering from an empty or corrupted flash state
Use the switch's console serial port to connect to a workstation or laptop computer that has the following:

• A terminal emulator program with Xmodem capability, such as the HyperTerminal program included in
Windows PC software.

• A copy of a good OS image file for the switch

NOTE: The following procedure requires the use of Xmodem and copies an OS image into primary
flash only.

This procedure assumes you are using HyperTerminal as your terminal emulator. If you use a
different terminal emulator, you may need to adapt this procedure to the operation of your particular
emulator.

1. Start the terminal emulator program.

Ensure that the terminal program is configured as follows:

• Baud rate: 9600

• No parity

• 8 Bits
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• 1 stop bit

• No flow control

2. Use the Reset button to reset the switch.

The following prompt should then appear in the terminal emulator:

Enter h or ? for help.

=>
3. Because the OS file is large, you can increase the speed of the download by changing the switch console and

terminal emulator baud rates to a high speed. For Example:

a. Change the switch baud rate to 115,200 Bps.

 => sp 115200
b. Change the terminal emulator baud rate to match the switch speed:

I. In HyperTerminal, select Call|Disconnect.

II. Select File|Properties.

III. Click on Configure.

IV. Change the baud rate to 115200.

V. Click on [OK], then in the next window, click on [OK] again.

VI. Select Call|Connect.

VII. Press [Enter] one or more times to display the => prompt.

4. Start the Console Download utility by entering do at the =prompt and pressing [Enter]:

 => do
5. You then see this prompt:

You have invoked the console download utility. 
Do you wish to continue? (Y/N)>_

6. At the above prompt:

a. Enter y (for Yes)

b. Select Transfer|File in HyperTerminal.

c. Enter the appropriate filename and path for the OS image.

d. Select the Xmodem protocol (and not the 1k Xmodem protocol).

e. Click on [Send].
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If you are using HyperTerminal, you will see a screen similar to the following to indicate that the download is in
progress:

Figure 167: Example: of Xmodem download in progress

When the download completes, the switch reboots from primary flash using the OS image you downloaded in
the preceding steps, plus the most recent startup-config file.

DNS resolver
The domain name system (DNS) resolver is designed for use in local network domains, where it enables the use
of a host name or fully qualified domain name with DNS-compatible switch CLI commands.

DNS operation supports both IPv4 and IPv6 DNS resolution and multiple, prioritized DNS servers. (For
information on IPv6 DNS resolution, see the latest IPv6 configuration guide for your switch.)

Basic operation
• When the switch is configured with only the IP address of a DNS server available to the switch, a DNS-

compatible command, executed with a fully qualified domain name, can reach a device found in any domain
accessible through the configured DNS server.

• When the switch is configured with both of the following:
◦ The IP address of a DNS server available to the switch

◦ The domain suffix of a domain available to the configured DNS serverthen:

◦ A DNS-compatible command that includes the host name of a device in the same domain as the configured
domain suffix can reach that device.

◦ A DNS-compatible command that includes a fully qualified domain name can reach a device in any domain
that is available to the configured DNS server.

Example:

Suppose the switch is configured with the domain suffix mygroup. Switch.net and the IP address for an
accessible DNS server. If an operator wants to use the switch to ping a target host in this domain by using the
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DNS name "leader" (assigned by a DNS server to an IP address used in that domain), the operator can use either
of the following commands:

Figure 168: Example: of using either a host name or a fully qualified domain name

In the proceeding Example:, if the DNS server's IP address is configured on the switch, but a domain suffix is
either not configured or is configured for a different domain than the target host, the fully qualified domain name
must be used.

Note that if the target host is in a domain other than the domain configured on the switch:

• The host's domain must be reachable from the switch. This requires that the DNS server for the switch must
be able to communicate with the DNS servers in the path to the domain in which the target host operates.

• The fully qualified domain name must be used, and the domain suffix must correspond to the domain in which
the target host operates, regardless of the domain suffix configured in the switch.

Example:

Suppose the switch is configured with the domain suffix mygroup. Switch.net and the IP address for an
accessible DNS server in this same domain. This time, the operator wants to use the switch to trace the route to a
host named "remote-01" in a different domain named common.group.net. Assuming this second domain is
accessible to the DNS server already configured on the switch, a traceroute command using the target's fully
qualified DNS name should succeed.

Figure 169: Example: using the fully qualified domain name for an accessible target in another domain

Configuring and using DNS resolution with DNS-compatible commands
The DNS-compatible commands include ping and traceroute.)

Procedure

1. Determine the following:

a. The IP address for a DNS server operating in a domain in your network.

b. The priority (1 to 3) of the selected server, relative to other DNS servers in the domain.

c. The domain name for an accessible domain in which there are hosts you want to reach with a DNS-
compatible command. (This is the domain suffix in the fully qualified domain name for a given host
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operating in the selected domain. See Basic operation on page 617.) Note that if a domain suffix is not
configured, fully qualified domain names can be used to resolve DNS-compatible commands.

d. The host names assigned to target IP addresses in the DNS server for the specified domain.

2. Use the data from the first three bullets in step1 to configure the DNS entry on the switch.

3. Use a DNS-compatible command with the host name to reach the target devices.

Configuring a DNS entry
The switch allows up to two DNS server entries (IP addresses for DNS servers). One domain suffix can also be
configured to support resolution of DNS names in that domain by using a host name only. Including the domain
suffix enables the use of DNS-compatible commands with a target's host name instead of the target's fully
qualified domain name.

Syntax:

[no] ip dns server-address priority <1-3> <ip-addr>
Configures the access priority and IP address of a DNS server accessible to the switch. These settings specify:

• The relative priority of the DNS server when multiple servers are configured

• The IP address of the DNS server

These settings must be configured before a DNS-compatible command can be executed with host name criteria.

The switch supports two prioritized DNS server entries. Configuring another IP address for a priority that has
already been assigned to an IP address is not allowed.

To replace one IP address at a given priority level with another address having the same priority, you must first
use the no form of the command to remove the unwanted address. Also, only one instance of a given server
address is allowed in the server list. Attempting to enter a duplicate of an existing entry at a different priority level
is not allowed .
To change the priority of an existing server address, use the no form of the command to remove the entry, then
re-enter the address with the new priority.

The no form of the command replaces the configured IP address with the null setting. (Default: null)

Syntax:

[no] ip dns domain-name <domain-name-suffix>
This optional DNS command configures the domain suffix that is automatically appended to the host name
entered with a DNS-compatible command. When the domain suffix and the IP address for a DNS server that can
access that domain are both configured on the switch, you can execute a DNS-compatible command using only
the host name of the desired target. (For an Example:, see Example: of using either a host name or a fully
qualified domain name.) In either of the following two instances, you must manually provide the domain
identification by using a fully qualified DNS name with a DNS-compatible command:

• If the DNS server IP address is configured on the switch, but the domain suffix is not configured (null).

• The domain suffix configured on the switch is not the domain in which the target host exists.

The switch supports one domain suffix entry and three DNS server IP address entries. (See the preceding
command description.)
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The no form of the command replaces the configured domain suffix with the null setting. (Default: null)

Using DNS names with ping and traceroute: Example:
In the network illustrated in Figure 170: Example: network domain on page 620, the switch at 10.28.192.1 is
configured to use DNS names for DNS-compatible commands in the pubs.outdoors.com domain. The DNS
server has been configured to assign the host name docservr to the IP address used by the document server
(10.28.229.219).

Figure 170: Example: network domain

Configuring switch "A" with the domain name and the IP address of a DNS server for the domain enables the
switch to use host names assigned to IP addresses in the domain to perform ping and traceroute actions on
the devices in the domain. To summarize:

Entity Identity

DNS server IP address 10.28.229.10

Domain name (and domain suffix for hosts in the
domain)

pubs.outdoors.com

Host name assigned to 10.28.229.219 by the DNS
server

docservr

Fully qualified domain name for the IP address used by
the document server (10.28.229.219)

docservr.pubs.outdoors.com

Switch IP address 10.28.192.1

Document server IP address 10.28.229.219

With the above already configured, the following commands enable a DNS-compatible command with the host
name docserver to reach the document server at 10.28.229.219.

Configuring switch "A" in Example: network domain to support DNS resolution

switch(config)# ip dns server-address 10.28.229.10
switch(config)# ip dns domain-name pbs.outdoors.com
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Ping and traceroute execution for the network in Example: network domain

switch(config)# ping docservr
10.28.229.219 is alive, time = 1 ms

switch# traceroute docservr
traceroute to 10.28.229.219
              1 hop min, 30 hops max, 5 sec. timeout, 3 probes
 1 10.28.192.2 1           1 ms       0 ms       0 ms
 2 10.28.229.219 2         0 ms       0 ms       0 ms

• 1First-Hop Router (“B”)

• 2Traceroute Target

As mentioned under the following example, if the DNS entry configured in the switch does not include the domain
suffix for the desired target, you must use the target host's fully qualified domain name with DNS-compatible
commands. For example, using the document server in Figure 170: Example: network domain on page 620 as
a target:

Figure 171: Example: of ping and traceroute execution when only the DNS server IP address is configured

Viewing the current DNS configuration
The show ip command displays the current domain suffix and the IP address of the highest priority DNS server
configured on the switch, along with other IP configuration information. If the switch configuration currently
includes a non-default (non-null) DNS entry, it will also appear in the show run command output.

Figure 172: Example: of viewing the current DNS configuration
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Operating notes
• Configuring another IP address for a priority that has already been assigned to an IP address is not allowed.

To replace one IP address at a given priority level with another address having the same priority, you must first
use the no form of the command to remove the unwanted address. Also, only one instance of a given server
address is allowed in the server list. Attempting to enter a duplicate of an existing entry at a different priority
level is not allowed. To change the priority of an existing server address, use the no form of the command to
remove the entry, then re-enter the address with the new priority.

• To change the position of an address already configured with priority x, you must first use no ip dns
server-address priority x <ip-addr> to remove the address from the configuration, then use ip
dns server-address priority <ip-addr> to reconfigure the address with the new priority. Also, if the
priority to which you want to move an address is already used in the configuration for another address, you
must first use the no form of the command to remove the current address from the target priority.

• The DNS servers and domain configured on the switch must be accessible to the switch, but it is not
necessary for any intermediate devices between the switch and the DNS server to be configured to support
DNS operation.

• When multiple DNS servers are configured on the switch, they can reside in the same domain or different
domains.

• A DNS configuration must include the IP address for a DNS server that is able to resolve host names for the
desired domain. If a DNS server has limited knowledge of other domains, its ability to resolve DNS-compatible
command requests is also limited.

• If the DNS configuration includes a DNS server IP address but does not also include a domain suffix, then any
DNS-compatible commands should include the target host’s fully qualified domain name.

• Switch-Initiated DNS packets go out through theVLAN having the best route to the DNS server, even if
aManagement VLAN has been configured.

• The DNS server address must be manually input. It is not automatically determined viaDHCP.

Event Log messages
Please see the Event Log Message Reference Guide for information about Event Log messages.
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Supported Platforms

Aruba 3810M Switch Series (JL071A, JL072A, JL073A, JL074A, JL075A, JL076A)
Aruba 5400Rzl2 Switch Series (J8698A, J8700A, J9823A-J9824A, J9825A, J9826A, J9868A, J9447A,
J9448A)
Aruba 5406R Switch Series (JL002A, JL003A, JL095A,J9850A)
Aruba 5406zl Switch Series (J9821A, J9822A) )
Aruba 5412R Switch Series (J9851A, JL001A)

Job Scheduler
The Job Scheduler feature enables the user to schedule commands or jobs on the switch for one time or multiple
times. This is similar in concept to the UNIX ‘cron’ utility. The user can schedule any CLI command that the user
would otherwise enter interactively. This includes commands to enable or disable ports, LEDs, and Power-Over-
Ethernet. Jobs can also be scheduled to be triggered by certain pre-defined events such as switch reboot. The
only major restriction on commands scheduled is that, it should not prompt/ask for any user inputs.

Commands

Job at | delay | enable | disable
Set schedule jobs using the options and set the count for the number of times the job is repeated.

Syntax

job <JOB NAME> at | delay | enable | disable
Description

Schedule a command to run automatically. Jobs can be scheduled to run once, multiple times on a recurring
basis, or after certain events such as reboots. All commands run with manager privilege in configuration context.

The [no] form of the command deletes a scheduled job.

By default, jobs will be repeated an infinite number of times.

Restrictions

Jobs scheduled at any event will not be counted.

Jobs that are scheduled at the event “reboot” will not work in some multi management switches.

Range

• <1-1000>: is the value range for the count option.

• ([[DD:]HH:]MM): is the format used for the specific delay.

Options

count

Specify the number of times the job should run.

Chapter 17
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delay

Specify the delay before running the job.

enable

Enable a job that is disabled or expired.

disable

Disable a job. By default, a job is enabled.

Usage

job <JOB NAME> at <([DD:]HH:]MM on <WEEKDAY-LIST>)> config-save <COMMAND> count <1-1000>

job <JOB NAME> at <[HH:]MM on [MM/]DD> config-save <COMMAND> count <1-1000>

job <JOB NAME> at <EVENT> config-save <COMMAND>

job <JOB NAME> delay <([DD:]HH:]MM> config-save <COMMAND> count <1-1000>

job <JOB NAME> enable | disable

[no] job <JOB NAME>

Show job
Syntax

show job
Description

Show the jobs scheduled.

Show job

switch# show job

 Job Scheduler Status and Configuration

  Scheduler Status : Waiting for the system time to be set

                     Event or            Repeat  Save 
  Name               Time                Count   Cfg  Command
  ------------------ ---------------- ------- ---- ------------
  Burrrrrrrrrrrr...  reboot              --    Yes chassislocate blink
  baz                reboot              --     No  show time
  foo                17:00 SxTWTxS       --     No  savepower led
  a1                 12:00               2      Yes sh time
  a2                 Every 2:14:30 days  75     Yes vlan 3
  a3                 Every 00:00:25 days 1      No  vlan 4

NOTE: Caution

The scheduler does not run until the system time is set.
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Show job <Name>
Syntax

show job <JOB NAME>
Description

Show the job by name.
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Overview
The traditional way of restoring a configuration from a backup configuration file required a switch reboot for the
new configurations to be effective. There were network outages and a planned downtime for even minor changes.
The switch configuration can now be restored from a backup configuration without reboot. It also provides hash of
the current running configuration, which can be used for auditing.

The backup configuration can be created using the new command cfg-backup. An existing method of copying a
configuration file from a remote location (for example, TFTP server) can also be used to backup a configuration or
copied from flash.

More information

show hash on page 646
cfg-backup on page 630
cfg-restore config_bkp on page 639

Benefits of configuration restore without reboot

• Restores a new or modified configuration without reboot, with minimal network outage. Any NMS can use this
method for configuration rebase workflows. Only configurations that were exported from the switch can be
imported or restored on the switch.

• Restores the configuration without reboot from a backup configuration when the running configuration has
functional issues, like misconfigurations from remote management stations.

Recommended scenarios
• Use the configuration restore feature for incremental configuration updates.

• Use the force option with cfg-restore, for commands which require reboot.

• Use the verbose option to get detailed progress on the configuration restore process.

More information

Force configuration restore on page 634
cfg-restore verbose on page 638

Use cases
• A user can switch to a new configuration without rebooting the switch.

• If a user loses connectivity after applying the new configuration, a job scheduler executes the job after a
specific time frame. This restores the current configuration to the switch, without rebooting it.

More information

Switching to a new configuration on page 627
Rolling back to a stable configuration using job scheduler on page 628

Chapter 18
Configuration backup and restore without reboot
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Switching to a new configuration

Procedure

1. Back up the configuration using cfg-backup running-config config <config_name> command. In
the following example, the configuration name used is “stable”.
cfg-backup running-config config stable

2. Check the backup configuration using show config files command.

switch(config)# show config files

Configuration files:

id | act pri sec | name
---+-------------+--------
1  |  *   *   *  | config
2  |             | stable
3  |             |
4  |             |
5  |             |

3. Change the running configuration as required, and backup the new configuration as “newfile”.

cfg-backup running-config config newfile

switch(config)# show config files

Configuration files:

 id | act pri sec | name
 ---+-------------+---------
  1 |  *   *   *  | config
  2 |             | stable
  3 |             | newfile
  4 |             |
  5 |             |

4. Check the difference between the “newfile” (running configuration) and “stable” (backed up configuration)
using cfg-restore flash stable diff command. Based on the difference, apply the backed-up
configuration using cfg-restore flash stable command.

5. Check the status of the configuration restore using show cfg-restore status command.

switch(config)# show cfg-restore status

 Status                 : Success
 Config File Name       : stable
 Source                 : Flash
 Time Taken             : 3 Seconds
 Last Run               : Tue Nov 28 18:24:09 2017

 Recovery Mode          : Enabled
 Failure Reason         : -

 Number of Add Commands    : 14
 Number of Remove Commands : 0

 Time Taken for Each Phase :
      Calculating diff     : 1 Seconds
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      Adding commands      : 2 Seconds
      Removing commands    : 0 Seconds

Rolling back to a stable configuration using job scheduler

Procedure

1. Configure the job using alias with the required configuration.

alias <name> <command-list>
job <name> delay [[DD:]HH:]MM <command>
To schedule a job execution with cfg-restore operation once after 15 minutes (00:00:15):

alias "cfg_rollback" "cfg-restore flash stable"
job "cfg_stable" delay 00:00:15 "cfg_rollback" count 1

2. Back up the current stable configuration using the command cfg-backup running-config config
<config_name>.

cfg-backup running-config config stable
3. Check the backup configuration using the command show config files.

switch(config)# show config files

Configuration files:

id | act pri sec | name
---+-------------+-------
1  |  *   *   *  | config
2  |             | stable
3  |             |
4  |             |
5  |             |

4. Edit the configuration as needed. If the user is still connected to the switch, the configuration is stable and the
job which reloads the older configuration can be cancelled using the command no job cfg_stable.

switch(config)# no job cfg_stable
5. If the user loses connectivity after applying the new configuration, the job scheduler executes the job after the

15-minute timer expires, and “stable” configuration is restored. Use the following commands to check the
output:

• switch(config)# show job cfg_stable
• switch(config)# show cfg-restore status

switch(config)# show job cfg_stable

 Job Information

  Job Name       : cfg_stable
  Runs At        : Every 00:00:15 days:hours:minutes
  Config Save    : No
  Repeat Count   : 1
  Job Status     : Enabled
  Running Status : Active
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  Run Count      : 0
  Error Count    : 0
  Skip Count     : 0
  Command        : cfg_rollback

switch(config)# show cfg-restore status
 Status                 : Success
 Config File Name       : stable
 Source                 : Flash
 Time Taken             : 9 Seconds
 Last Run               : Tue Nov 28 20:50:00 2017

 Recovery Mode          : Enabled
 Failure Reason         : -

 Number of Add Commands    : 27
 Number of Remove Commands : 0

 Time Taken for Each Phase :
      Calculating diff     : 4 Seconds
      Adding commands      : 1 Seconds
      Removing commands    : 0 Seconds

NOTE: If the configuration involves any sensitive information, backup and restore the
configuration by enabling the include-credentials command.

Commands used in switch configuration restore without
reboot
cfg-backup

Backs up the selected configuration to the flash file.

show config files details
Shows a detailed list of configuration files available in the flash.

cfg-restore
Restores the given configuration as the running configuration without reboot.

show cfg-restore status
Shows the status of latest restore performed.

show cfg-restore latest-diff
Views the list of configuration changes that are removed, modified, or added to the running configuration.

show hash
Shows the SHA ID of a startup or running configuration.

Configuration backup
The configuration backup creates a backup of the running or startup configuration of ArubaOS-Switch on-demand
to the flash storage on the switch. The maximum number of backup files supported has increased from three to
five.

NOTE: When you downgrade configuration backup files from five to three, and if the current number
of files is either a four or five, an error message Configuration file <name> stored in
config index 5 is not supported in lower image versions is displayed.
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cfg-backup
Syntax
cfg-backup {running-config | startup-config} config <FILE-NAME>

Description

Backs up the selected configuration to the flash file mentioned. When the firmware is downgraded to lower
versions, the details of only three configuration files appear in the show config files command.

Command context
config

Parameters
running-config

Copies the running configuration to switch flash file.
startup-config

Copies the startup configuration to switch flash file.

flash
Name of the configuration file in flash.

Usage
copy {startup-config | running-config} {sftp | tftp} <server address> <FILE-NAME>
The existing copy command copies the startup and running configuration to the TFTP or SFTP server.

Examples

switch(config)# cfg-backup
 running-config       Backup the running configuration to the flash file
                      mentioned.
 startup-config       Backup the startup configuration to the flash file
                      mentioned.

switch(config)# cfg-backup {running-config | startup-config}
 config                Backup the named configuration file.

switch(config)# cfg-backup {running-config | startup-config} config
 ASCII-STR             Enter an ASCII string.

show config files
Syntax
show config files

Description

Shows a list of configuration files available in the flash.

Command context
config
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Examples

switch# show config files
Configuration files:

 id | act pri sec | name
 ---+-------------+---------
  1 |  *   *   *  | config
  2 |             | add
  3 |             | modify
  4 |             | golden_config
  5 |             | poe2
To show the details of saved configuration files:

switch(config)# show config files
 details        Show details of saved configuration files.

switch(config)#show config files details

 Backup Configuration files:

 File Name      : config
 File ID        : 1
 File Size      : 35902 Bytes
 Last Modified  : Mon Jan 01 1990 00:09:28
 Version        : WC.16.05.0000x

 File Name      : add
 File ID        : 2
 File Size      : 35902 Bytes
 Last Modified  : Mon Oct 23 2017 03:42:38
 Version        : WC.16.05.0000x

 File Name      : modify
 File ID        : 3
 File Size      : 35902 Bytes
 Last Modified  : Mon Oct 23 2017 03:42:38
 Version        : WC.16.05.0000x
To view the contents of a configuration file in the flash:

switch# show config add

; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a
snmp-server community "public" unrestricted
vlan 1
   name "DEFAULT_VLAN"
   no untagged 3-10
   untagged 1-2,11-28
   ip address dhcp-bootp
   exit
vlan 100
   name "VLAN100"
   untagged 3-5
   no ip address
   exit
vlan 200
name "VLAN200"
   untagged 6-10
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   no ip address
   exit

Configuration restore without reboot
The cfg-restore without reboot command restores the configuration without reboot from a backup
configuration to the running configuration of the switch.

The details about the difference between a running and a backup configuration can be displayed using cfg-
restore {flash | tftp | sftp} <FILE-NAME> diff command.

More information

Configuration backup on page 629
Viewing the differences between a running configuration and a backup configuration on page 644

cfg-restore
Syntax
cfg-restore {flash | tftp <IP-ADDRESS> | sftp <IP-ADDRESS>} <FILE-NAME> [diff |
force | non-blocking | recovery-mode | verbose]

Description

Restores the given configuration as the running configuration without reboot. If the configuration is not suitable to
successfully restore without reboot, the command will return a failure message with details.

NOTE: The restored configuration commands will be executed on a running configuration, so the
name of the current active configuration does not change after configuration restore, except for the
force option.

Command context
config

Parameters
flash

Copies file from flash.
tftp

Copies file from TFTP server.

sftp
Copies file from SFTP server.

<IP-ADDRESS>

IP address of the TFTP server.

<FILE-NAME>

Name of the backup configuration file to restore into the running configuration.

diff
Provides the list of changes that will be applied on the running configuration.
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force
Forces a reboot if configuration in restored configuration requires a reboot. Applies the configuration with
reboot if the configuration has reboot required commands or system-wide change commands. After a forced
reboot, the name of the configuration changes.

non-blocking
Configuration restoration in non-blocking mode, where actual process happens in the background.

recovery-mode
Enables or disables recovery-mode. Recovery-mode is enabled by default and this retains the current running
configuration if configuration restoration fails.

verbose
Provides the details of configuration restore status and the list of commands to be added or deleted.

Usage

• cfg-restore flash <FILE-NAME> [non-blocking | diff | force | recovery-mode{enable
| disable}]] | [verbose [force | [recovery-mode{enable | disable}] | [diff |
force]

• cfg-restore tftp {<IPV4-ADDR> | <IPV6-ADDR> | <HOSTNAME-STR> <FILE-NAME> [non-
blocking | diff | force | recovery-mode{enable | disable}]] | [verbose [force |
[recovery-mode{enable | disable}]] | [diff |force]

• cfg-restore sftp {<IPV4-ADDR> | <IPV6-ADDR> | <HOSTNAME-STR> | user <name> {<IP-
ADDRESS|IPV6-ADDRESS|HOSTNAME-STR>} | <USERNAME@>{<HOST-NAME> | <IPV4-ADDR> |
<IPV6-ADDR>}} [port <1-65535>] <FILE-NAME> [non-blocking | diff | force |
recovery-mode{enable | disable}]] | [verbose [force | [recovery-mode{enable |
disable}]] | [diff |force]

Examples

switch# cfg-restore
 flash              Copy file from flash. 
 sftp               Copy file from SFTP Server. 
 tftp               Copy file from TFTP Server. 

switch# cfg-restore flash
 FILE-NAME          Name of the backup configuration file to restore into the running 
                       configuration. 

switch# cfg-restore flash config_file
 diff               Provide the list of changes that will be applied on the
                    running configuration.
 force              Apply the configuration with reboot if the
                    configuration has reboot required commands or
                    system-wide change commands present.
 non-blocking       Config restoration in non-blocking mode.
 recovery-mode      To enable/disable recovery-mode.
 verbose               Provide the details of config restore status and the list of commands to be added 
                    or deleted.        

switch# cfg-restore tftp
 HOSTNAME-STR       Specify hostname of TFTP Server.
 IP-ADDR            IP Address of the TFTP Server.
 IPV6-ADDR          IPV6 Address of the TFTP Server.

switch# cfg-restore tftp 10.100.0.12
 FILE-NAME          Name of the backup configuration file to restore into the running 
                       configuration. 

switch# cfg-restore tftp 10.100.0.12 config_file
 diff                Provide the list of changes that will be applied on the
                     running configuration.
 force               Apply the configuration with reboot if the
                     configuration has reboot required commands or

Chapter 18 Configuration backup and restore without reboot 633

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4371



                     system-wide change commands present.
 non-blocking        Config restoration in non-blocking mode.
 recovery-mode       To enable/disable recovery-mode.
 verbose                Provide the details of config restore status and the list of commands to be added 
                     or deleted.

switch(config)# cfg-restore flash add non-blocking
 diff                Provide the list of changes that will be applied on
                     the running configuration.
 force               Apply the configuration with reboot if the configuration has reboot required commands or
                     system-wide change commands present.
 recovery-mode       To enable/disable recovery-mode.

Force configuration restore
The cfg-restore command fails if a reboot is required. The Configuration restoration is not
allowed as the configuration has reboot required commands error is displayed, along with lines
requiring a reboot. The force option in the cfg-restore command allows a user to force a reboot. The
command is: cfg-restore {flash | tftp | sftp} <FILE-NAME> force.

Before reboot, config is the active configuration. After the device reboots, the backup file becomes the new
active configuration.

id | act pri sec | name
---+-------------+---------------
 1 |  *   *   *  | config
 2 |             | def
 3 |             | golden_config
 4 |             |
 5 |             | 

switch(config)# cfg-restore flash golden_config
Current running-configuration will be replaced with 'golden_config'.
Continue (y/n)? y
Configuration restore is in progress, configuration changes are temporarily
 disabled.
Configuration restoration is not allowed as the configuration has reboot required commands.

switch(config)# show cfg-restore status
 Status                 : Failed
 Config File Name       : golden_config
 Source                 : Flash
 Time Taken             : 5 Seconds
 Last Run               : Mon Oct 30 23:03:19 2017

 Recovery Mode          : Enabled
 Failure Reason         : Reboot required commands present.
 Command : console terminal none

 Number of Add Commands    : 0
 Number of Remove Commands : 1

Time Taken for Each Phase :
      Calculating diff     : 3 Seconds
      Adding commands      : 0 Seconds
      Removing commands    : 0 Seconds

switch# cfg-restore flash golden_config force
Device may be rebooted if the configuration file has reboot required or
system-wide change commands. Do you want to continue  (y/n)?
Current running-configuration will be replaced with 'golden_config'.
Continue (y/n)?
Configuration restore is in progress, configuration changes are temporarily
disabled.

Successfully applied configuration 'golden_config' to running configuration.

Rebooting switch...
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In the preceding output, Command : console terminal none shows that cfg-restore failed because a
reboot is required.

After the switch reboots and comes up, the golden_config becomes the active configuration.

NOTE: In case of a switch reboot, the switch comes up with the configuration associated with the
primary or secondary.

 id | act pri sec | name
 ---+-------------+------------------------------------------------
  1 |      *   *  | config
  2 |             | def
  3 |  *          | golden_config
  4 |             | 
  5 |             |

switch# show cfg-restore status
 Status                 : Success
 Config File Name       : default
 Source                 : Flash
 Time Taken             : 1 Seconds
 Last Run               : Mon Oct 23 07:17:03 2017

 Recovery Mode          : Enabled
 Failure Reason         : -

 Number of Add Commands    : 0
 Number of Remove Commands : 5

Time Taken for Each Phase :

      Calculating diff     : 1 Seconds
      Adding commands      : 0 Seconds
      Removing commands    : 0 Seconds

NOTE: Time taken for adding and deleting commands is zero, as the switch reboots. It is similar to
downloading a startup-configuration to the device.

cfg-restore non-blocking

Syntax
cfg-restore {flash | tftp | sftp} <FILE-NAME> non-blocking

Description

Performs restore in non-blocking mode.

Command context
config

Example

switch(config)# cfg-restore flash add non-blocking
Current running-configuration will be replaced with 'add'.
Continue (y/n)? y
Configuration restore is in progress, configuration changes are
temporarily disabled.
switch(config)#
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switch(config)# show cfg-restore status
 Status                 : Success
 Config File Name       : add
 Source                 : Flash
 Time Taken             : 2 Seconds
 Last Run               : Sun Oct 22 22:09:02 2017

 Recovery Mode          : Enabled
 Failure Reason         : -

 Number of Add Commands    : 7
 Number of Remove Commands : 10

Time Taken for Each Phase :                                               
      Calculating diff     : 1 Seconds
      Adding commands      : 0 Seconds
      Removing commands    : 0 Seconds

cfg-restore recovery-mode

Syntax
cfg-restore {flash | tftp | sftp} <FILE-NAME> recovery-mode {enable | disable}

Description

Restores the current running configuration, if a restore to the backup configuration fails. By default, recovery-
mode is enabled.

Command context
config

Usage

To disable recovery mode, use cfg-restore {flash | tftp | sftp} <FILE-NAME> recovery-mode
disable.

Example

With the following running configuration, a restore to the backup file modify fails, but this configuration will be
retained as recovery mode is enabled.

switch(config)# show running-config

Running configuration:

; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a
ip routing
snmp-server community "public" unrestricted
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-28
   ip address dhcp-bootp
   exit
vlan 10
   name "VLAN10"
   no ip address
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   exit

switch(config)# show config modify
; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a
ip default-gateway 172.20.0.1
ip routing
snmp-server community "public" unrestricted
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-28
   ip address dhcp-bootp
   exit
vlan 100
   name "VLAN100"
   no ip address
   exit

switch(config)# cfg-restore flash modify
Current running-configuration will be replaced with 'modify'.
Continue (y/n)? y
Configuration restore is in progress, configuration changes are
 temporarily disabled.

Configuration restore to config 'modify' failed, restored source
 configuration to running configuration.

switch(config)# show running-config

Running configuration:

; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a
ip routing
snmp-server community "public" unrestricted
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-28
   ip address dhcp-bootp
   exit
vlan 10
   name "VLAN10"
   no ip address
   exit

switch(config)# cfg-restore flash modify recovery-mode disable
Current running-configuration will be replaced with 'modify'.
Continue (y/n)? y
Configuration restore is in progress, configuration changes are
 temporarily disabled.

Partially applied configuration 'modify' to running configuration.
Aruba-2930F-24G-PoEP-4SFPP(config)# show running-config

Running configuration:

; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a

Chapter 18 Configuration backup and restore without reboot 637

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4375



ip routing
snmp-server community "public" unrestricted
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-28
   ip address dhcp-bootp
   exit
vlan 100
   name "VLAN100"
   no ip address
   exit

cfg-restore verbose

Syntax
cfg-restore {flash | tftp | sftp} <FILE-NAME> verbose

Description

Provides the details of configuration restore status and the list of commands to be added or deleted along with
cfg-restore.

Command context
config

Examples

switch(config)# cfg-restore flash config verbose
Current running-configuration will be replaced with 'config'.
Continue (y/n)? y

Configuration restore is in progress, configuration changes are temporarily disabled.

Configuration Restore Information: 

 Status                 : Success
 Config File Name       : config
 Source                 : Flash
 Time Taken             : 6 Seconds
 Last Run               : Tue Nov  7 03:43:07 2017

 Recovery Mode          : Enabled
 Failure Reason         : -

 Number of Add Commands    : 0
 Number of Remove Commands : 12

Time Taken for Each Phase :
      Calculating diff     : 2 Seconds
      Adding commands      : 0 Seconds
      Removing commands    : 0 Seconds

Configuration delete list:

vlan 2
   name "VLAN2"
   no ip address
   exit
vlan 3
   name "VLAN3"
   no ip address
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   exit
vlan 4
   name "VLAN4"
   no ip address
   exit
vlan 5
   name "VLAN5"
   no ip address
   exit

Successfully applied configuration 'config' to running configuration.

cfg-restore config_bkp

Syntax
cfg-restore {tftp <ip-address> | sftp <ip-address>} config_bkp

Description

Downloads and restores a configuration from the TFTP or SFTP server, without rebooting the switch.

NOTE: The commands from the restored configuration will be executed on the running configuration.
The name of the current active configuration will not change after a configuration restore.

Command context
config

Example

switch(config)# cfg-restore tftp
 HOSTNAME-STR          Specify hostname of TFTP Server.
 IP-ADDR               IP Address of the TFTP Server.
 IPV6-ADDR             IPV6 Address of the TFTP Server.

switch(config)# cfg-restore sftp
 HOSTNAME-STR          Specify hostname of the SFTP server.
 IP-ADDR               IP Address of the SFTP Server.
 IPV6-ADDR             IPV6 Address of the SFTP Server.
 user                  Specify username on the remote system information
 USER@IP-STR           Specify username along with remote system
                       information

switch(config)# cfg-restore tftp 10.100.0.12 pvos/tftp_2930_config_file
Current running-configuration will be replaced with 'tftp_2930_config_file'.
Continue (y/n)? y
Configuration restore is in progress, configuration changes are temporarily disabled.

Successfully applied configuration 'tftp_2930_config_file' to running configuration.

switch(config)# sh cfg-restore status
 Status                 : Success
 Config File Name       : tftp_2930_config_file
 Source                 : TFTP
 Time Taken             : 4 Seconds
 Last Run               : Wed Nov  8 21:11:10 2017

 Recovery Mode          : Enabled
 Failure Reason         : -

 Number of Add Commands    : 4
 Number of Remove Commands : 7
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Time Taken for Each Phase :
      Calculating diff     : 1 Seconds
      Adding commands      : 0 Seconds
      Removing commands    : 0 Seconds

switch(config)# show config files

Configuration files:

 id | act pri sec | name
 ---+-------------+---------
  1 |  *   *   *  | config
  2 |             |
  3 |             |
  4 |             |
  5 |             |

Configuration restore with force option

Prerequisites
Back up the configuration using traditional copy config or cfg-backup commands.

Procedure

1. Execute the show config files command. By default, the config file provides all the associations.

switch(config)# show config files

Configuration files:

 id | act pri sec | name
 ---+-------------+-------
  1 |  *   *   *  | config
  2 |             | file1
  3 |             | file2
  4 |             |
  5 |             |

2. Use cfg-restore flash file1 force command to see the configuration of file1.

switch(config)# cfg-restore flash file1 force
As the file1 configuration requires a reboot, a system reboot occurs. When the switch comes up, file1 is the
new active configuration.

switch(config)# sh config files

Configuration files:

 id | act pri sec | name
 ---+-------------+---------
  1 |      *   *  | config
  2 |  *          | file1
  3 |             | file2
  4 |             |
  5 |             |

NOTE: During a configuration restore with reboot, the association changes. To make the
configuration as a default configuration for subsequent system reboots, use startup-default
[<primary|secondary>] config FILENAME command.
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For startup-default config file1:

switch(config)# show config files

Configuration files:

id | act pri sec | name
 --+-------------+---------
 1 |             | config
 2 |  *   *   *  | file1
 3 |             | file2
 4 |             |
 5 |             |

System reboot commands
Following commands require a system reboot:

• secure-mode standard
• secure-mode enhanced
• mesh id [0-9]
• mesh [a-z | A-Z | 0-9]
• max-vlans <257-4094>
• no allow-v2-modules
• qinq (mixedvlan | svlan)
• qos queue-config
• terminal type (vt100 | ansi)
• console (flow-control | terminal)
• vsf member [0-9]
• vsf remove
• access-list grouping
• console baud-rate (speed-sense | 1200 | 2400 | 4800 | 9600 | 19200 | 38400 |

57600 | 115200)

Systemwide change commands
Following commands change the system configuration:

• module [0-9 | a-z | A-Z]
• module [0-9 | a-z | A-Z] type <type>
• igmp lookup-mode ip
• flexible-module [a-z | A-Z] type <type>
• stacking member [0-9] flexible-module [a-z | A-Z] type <type>
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Configuration restore without force option
If the two configuration files backed up are file1 and file2:

Prerequisites
Backup the configuration using either the traditional copy config or the cfg-backup commands.

Procedure

1. Execute the show config files command. By default, the config file provides all the associations.

switch(config)# show config files

Configuration files:

 id | act pri sec | name
 ---+-------------+-------
  1 |  *   *   *  | config
  2 |             | file1
  3 |             | file2
  4 |             |
  5 |             |

2. Use cfg-restore flash file1 command to see the configuration of file1.

switch(config)# cfg-restore flash file1
Even after executing the previous command, associations will remain the same, but the running configuration
is replaced by file1 configuration.

NOTE: In a configuration restore without reboot, the association remains the same. The default
config file is updated based on the configuration of the restored file.

show cfg-restore status
Syntax
show cfg-restore status

Description

Shows the status of latest restore performed. The running configuration is updated based on the configuration of
the restored file.

Command context
config

Usage
show cfg-restore {status | latest-diff}
This command provides information on:

• how a restore is performed

• whether a flash file was used from SFTP or TFTP server

• the total time taken to restore

• the time when last restore was initiated
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• whether a recovery-mode was enabled

• the number of add and delete commands

• reboot commands present (if any), and

• the split time taken for each phase

Examples

switch(config)# show cfg-restore
 latest-diff           Shows the difference between running and back-up
                       configuration.
 status                Show configuration restoration status.

switch(config)# show cfg-restore status
Status           : [Failed| In progress | Success | Not Started]
Config File name : def
Source           : [-|Tftp|sftp|Flash|REST]
Time taken       : [-|20 Seconds.]
Last Run         : [-|Tue March 07 22:12:16 2017.]

Recovery Mode          : Enabled
Failure Reason         : -

Number of Add Commands    : 0
Number of Remove Commands : 3

Time Taken for Each Phase :
      Calculating diff     : 1 Seconds
      Adding commands      : 0 Seconds
      Removing commands    : 0 Seconds
If the configuration restoration fails, the line number and the failed commands are displayed:

switch(config)# show cfg-restore status
Status           : Failed
Config File name : def
Source           : Flash
Time taken       : 20 Seconds
Last Run         : Sun Oct 22 20:22:54 2017

Recovery Mode          : Enabled
Failure Reason         : Add commands have been failed

Number of Add Commands    : 0
Number of Remove Commands : 3

Time Taken for Each Phase :
      Calculating diff     : 1 Seconds
      Adding commands      : 0 Seconds
      Removing commands    : 0 Seconds

Failed to remove commands:
 Line: 12 vlan 10
 Line: 15 no ipv6 nd snooping mac-check
Failed to add commands:
 Line: 10 icmp 10.100.0.12 source-inter vlan 1
 Line: 20 udp-echo 10.100.0.12 source vlan 1
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NOTE: The number of add and delete commands is calculated excluding the exit commands in the
configuration file.

Viewing the differences between a running configuration and a backup
configuration

Prerequisites
Use the cfg-restore {flash | tftp | sftp} <FILE-NAME> diff command to view the list of
configuration changes that are removed, modified, or added to the running configuration.

Procedure

1. Execute the show running-config command to show the running configuration of the switch.

switch(config)# show running-config

Running configuration:

; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a
snmp-server community "public" unrestricted
vlan 1
   name "DEFAULT_VLAN"
   no untagged 11-13,15-18
   untagged 1-10,14,19-28
   ip address dhcp-bootp
   exit
vlan 100
   name "VLAN100"
   untagged 11-13
   no ip address
   exit
vlan 300
   name "VLAN300"
   untagged 15-18
   no ip address
   exit

2. Execute the show config golden_config command to show the backup configuration of the switch.

switch(config)# show config golden_config
; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a
; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a

3. Execute the cfg-restore flash golden_config diff command to view the differences that will be
applied.

switch# cfg-restore flash golden_config diff 
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Configuration delete list:

vlan 1
   no untagged 11-13,15-18
   untagged 3-10
   exit
vlan 100
   untagged 11-13
   exit
vlan 300
   name "VLAN300"

   untagged 15-18
   no ip address
   exit

Configuration add list:

vlan 1
   no untagged 3-10
   untagged 11-13,15-18
   exit
vlan 100
   untagged 3-5
   exit
vlan 200
   name "VLAN200"
   untagged 6-10
   no ip address
   exit

NOTE: If the running and the backup configuration is the same, no difference will be displayed.

switch(config)# cfg-restore flash modify diff

Current config and backup config is identical.

4. Execute the show cfg restore latest-diff command to display the difference between the running
and the backup configuration.

switch(config)# show cfg-restore
 latest-diff           Shows the difference between running and back-up
                       configuration.
 status                Show configuration restoration status.

switch(config)# show cfg-restore latest-diff

Configuration delete list:

ip default-gateway 172.20.0.1
vlan 100
   name "VLAN100"
   no ip address
   exit

Configuration add list:

vlan 10
   name "VLAN10"
   no ip address
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   exit

switch(config)#

Show commands to show the SHA of a configuration
The show commands provide SHA details of the running and startup configurations.

show hash
Syntax
show {config | running-config} hash {recalculate}

Description

Shows SHA ID of startup or running configuration.

Command context
config

Examples

switch# show config
 config
 files                 List saved configuration files.
 hash                  Display the hash calculated for the startup
                       configuration.
 interface             Show the startup configuration for interfaces.
 oobm                  Show the startup configuration for OOBM.
 
To display the hash calculated for the startup configuration:

switch(config)# show config hash
The hash must be calculated.  This may take several minutes.

Continue (y/n)? y

Calculating hash...
Startup Configuration hash:

4f66 8b77 6b66 e5fb 0c12 f7fb 8ea6 b548 af2e 2e03

This hash is only valid for comparison to a baseline hash if
the configuration has not been explicitly changed (such as
with a CLI command) or implicitly changed (such as by the
removal of a hardware module).

switch(config)# show config hash
recalculate           Calculate hash (if needed) without prompting.

switch(config)# show config hash recalculate
Startup Configuration hash:

4f66 8b77 6b66 e5fb 0c12 f7fb 8ea6 b548 af2e 2e03

This hash is only valid for comparison to a baseline hash if
the configuration has not been explicitly changed (such as
with a CLI command) or implicitly changed (such as by the
removal of a hardware module).
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To display the hash calculated for the running configuration:

switch(config)# show running-config hash
The hash must be calculated.  This may take several minutes.

Continue (y/n)? y

Calculating hash...
Running configuration hash:

6d88 0880 98af e8a8 b564 15cd 368e 4269 9d61 4bfa

This hash is only valid for comparison to a baseline hash if
the configuration has not been explicitly changed (such as
with a CLI command) or implicitly changed (such as by the
removal of a hardware module).

Scenarios that block the configuration restoration process
The configuration restoration process is blocked in the following scenarios:

• If the restored configuration file requires a reboot.

• If the restored configuration changes the entire configuration (for example, module add or remove).

More information

cfg-restore on page 632

Limitations
Switch configuration restore without reboot feature does not support the following scenarios:

• Removing a physically present member through cfg-restore command

• Flex-module provisioning or removal on standalone or a stack

• Module provisioning or removal on standalone or a stack

• Adding a VLAN when the VLAN limit is already reached by having dynamic VLANs. Due to timing issues, ports
or dynamic VLANs take some time to become offline or be removed, even after applying a removal command.
In such a case, restore commands fail as normal CLI commands.

• The maximum number of backup configuration files has been increased from three to five. When the firmware
is downgraded to lower versions, the show config files command displays the details to only three
configuration files.

• Restore is allowed based on the available system resource factors.

Blocking of configuration from other sessions
All write operations are not allowed from other sessions (CLI/WebUI/SNMP/REST, and so on) during a
configuration restoration process. Only read operation is allowed. Attempts to use write operation results in the
Configuration restore is in progress, configuration changes are temporarily
disabled error. The following show commands are blocked during a configuration restoration process:

• show-tech
• show config
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• show running-config
• show startup-config

Troubleshooting and support
Switch configuration restore without reboot feature provides CLI support to:

• display the number of commands with line number that failed to restore.

• display the delta between running configuration and the configuration to be restored.

More information

Viewing the differences between a running configuration and a backup configuration on page 644
show cfg-restore status on page 642

debug cfg-restore
Syntax
debug cfg-restore

Description

Debug logs display the commands executed by cfg-restore.

Command context

config and manager

Example

switch(config)# debug cfg-restore
switch(config)# debug destination buffer
switch(config)# show debug buffer
0000:01:39:51.58 CFG mCfgRestoreMgr:cfg-restore to config file "backup_conif"
   started.
0000:01:39:56.45 CFG mCfgRestoreMgr:cfg-restore diff calculated, number of
   commands to add =0 number of commands to delete = 3.
0000:01:39:56.45 CFG mCfgRestoreMgr:cfg-restore iteration count = 1.
0000:01:39:56.51 CFG mCfgRestoreMgr:Command executed = no vlan 2 tagged 9,
   Status = Success.
0000:01:39:56.51 CFG mCfgRestoreMgr:Command deleted = vlan 2 tagged 9.
0000:01:39:56.58 CFG mCfgRestoreMgr:Command executed = no vlan 3 tagged 9,
   Status = Success.
0000:01:39:56.58 CFG mCfgRestoreMgr:Command deleted = vlan 3 tagged 9.
0000:01:39:56.64 CFG mCfgRestoreMgr:Command executed = no vlan 4 tagged 9,
   Status = Success.
0000:01:39:56.65 CFG mCfgRestoreMgr:Command deleted = vlan 4 tagged 9.
0000:01:39:56.65 CFG mCfgRestoreMgr:cfg-restore iteration count = 2.
0000:01:39:59.38 CFG mCfgRestoreMgr:Successfully applied configuration
   'backup_conif' to running configuration.
** Total debug messages = 22
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Supported devices

Code Switch

KB Aruba 5400R Switch Series

NOTE: VSF is supported only on V3 blades. Once VSF is enabled, the switch will reboot in V3-only
mode.

Overview of VSF
Aruba Virtual Switching Framework (VSF) technology virtualizes two physical devices in the same layer into one
Virtual Fabric which provides high availability and scalability. VSF allows supported switches connected to each
other through normal ethernet connections (copper or fiber) to behave like a single switch.

Figure 173: Two devices using VSF technology appearing as a single node to the upper-layer and lower-layer
devices

Chapter 19
Virtual Switching Framework (VSF)
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Benefits of VSF
Simplified topology and ease of management

A VSF fabric appears and behaves as one logical switch and is accessible by the network through a single IP
address.

NOTE: Spanning tree features are not necessary among VSF members.

1:1 redundancy

One member acts as the Commander to manage and control the entire VSF fabric. The other switch acts as a
Standby and backs up the commander, and takes over in case of commander failure.

VSF port aggregation

A VSF link can aggregate upto eight VSF ports with immediate neighboring member. This provides
redundancy till failure of seven VSF ports.

Distributed trunking

The Ethernet link aggregation feature can be used to aggregate physical links between the VSF and its
upstream or downstream devices across the VSF members. This eliminates the need for spanning tree and
also provides load balancing across across all ports of the link aggregate.

Network scalability

The processing power is equal to the Commander. The forwarding capacity is equal to both the Commander
and the Standby combined.

Member roles
VSF uses two member roles: Commander and Standby.

NOTE: All switches in the VSF stack will have the same software version. During stack formation,
switches which do not have the same software version as the commander, will be updated to the
commander's software. This will cause a reboot of the updated switch.

Commander
Control and management plane protocols run on the Commander, which is responsible for managing the
forwarding databases, synchronizing them with the Standby and controlling all line cards including that of the
Standby.

Standby
Standby is a stateful backup device for the Commander and is ready to take control of the VSF virtual chassis if
the Commander device fails. This enables the VSF virtual chassis to continue its operations seamlessly in the
event of a failure.

Management module
The switch can have two management modules (dual MM). In a VSF stack with dual MMs, both the Commander
and Standby of the VSF stack each have only one MM (say MM1) as Active and the second MM (say MM2) as
Offline.

If the Active MM (MM1) of the Commander fails, the Standby changes role and becomes the new Commander.
The Offline MM (MM2) of the old Commander boots to join the stack as the new Standby. MM2 of the new
Standby is now Active and MM1 is Offline
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VSF member ID
VSF uses member IDs to uniquely identify and manage its members. The first part of the interface module
number is the Member ID information, which identifies interfaces in a VSF fabric.

The device that wins election and becomes Commander will keep its member ID while the other will automatically
be assigned a different unassigned member ID from the pool and reboot.

NOTE: If the VSF member ID changes when joining a VSF virtual chassis it will cause a reboot of
that member not the whole VSF virtual chassis.

VSF link
A VSF link is a logical interface that connects VSF member devices. The VSF link is named I-Link<Member
ID>_1. To configure a VSF link, bind a minimum of one physical interface to it. The bound physical interfaces
automatically aggregate to form a VSF link. A VSF link goes down only if all its VSF physical interfaces are down.

I-Link<Member ID>_1 is the default name.

vsf member link
Syntax
[no] vsf member <MEMBER-ID> link <LINK-ID> [[ethernet] <PORT-LIST> | name <LINK-
NAME>]
Description

Create the VSF links. A set of physical ports between any 2 members, carrying VSF traffic, is collectively referred
to as a VSF link.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
2.

<LINK-ID>

VSF link ID value. For Aruba 5400R devices, allowed Link ID value is 1.

<PORT-LIST>

The port number or a list of ports. Upto 8 ports can be assigned into a VSF link.

<LINK-NAME>

The VSF link name. Upto 10 characters are allowed for link name.

Operating Notes

• A VSF link is a logical port dedicated to the internal connection of an VSF virtual device.

• A VSF link is effective only after it is bound to a physical port.

• When an Ethernet port is bound to a VSF link, it carries VSF data traffic and VSF protocol packets.
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Validation rules for VSF member

Validation Error/Warning/Prompt

When trunk static/manual and mesh is getting
configured as VSF port

• Cannot configure VSF on port “A1” because
that port is an LACP trunk.

• Cannot configure VSF on port “A1” because
that port is a Mesh.

• Cannot configure VSF on port “A1” because
that port is a Distributed LACP trunk.

• Cannot configure VSF on port “A1” because
that port is a Distributed trunk.

• Cannot configure VSF on port “A1” because
that port is a Dynamic trunk.

• Cannot configure VSF on port “A1” because
that port is an InterSwitch Connect (ISC)
portError configuring VSF on port “A1”: An
unsupported trunking mode is already
configured on this port.

Adding a 1G port to a VSF link Cannot enable VSF on a port operating at other
than 10G or 40G.

Adding both 10G and 40G ports to a VSF link Port 1/A1 does not support the current VSF port
speed of 10G and may not be activated. Use
compatible transceiver or reconfigure port speed
to utilize this port.

All configuration on this port has been removed
and port is placed in VSF mode.

Max 8 ports per link. Cannot configure more than 8 physical ports as
an VSF link.

For other than physical ports. VSF capabilities are not supported on port “A1”.

Cannot set a link name which is having more than
10 characters.

Cannot configure the VSF link name. The name is
not a valid UI display string, or is blank, or
exceeds 10 characters.

Direct VSF port removal case Cannot remove VSF link when it has physical
ports associated with it. First remove the
associated physical ports and then remove the
VSF link.

Removing the last VSF port in a VSF link that is
"Up" is forbidden.

Removing of binding between physical ports and
VSF link is not allowed since it would result in a
stack split.

Using a port reserved for internal use as a VSF
port.

Cannot use stolen/reserved ports as VSF ports.
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Physical VSF ports
VSF ports connect VSF member devices and must be assembled using a VSF link. These VSF ports forward VSF
protocol packets and data traffic.

VSF domain ID
VSF uses VSF domain IDs to uniquely identify VSF fabrics and prevent VSF fabrics from interfering with one
another. One VSF fabric forms one VSF domain.

Figure 174: Two VSF domains
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VSF split
A VSF split can occur due to a VSF link failure where all ports in the VSF link go down. This failure results in
independent VSF fabric fragments each having its own Commander role. Recommends configuring a Multiple
Active Detection (MAD) mechanism to avoid duplicate IP addresses, routing issues, and traffic forwarding
problems when a VSF split occurs.

Figure 175: VSF split

VSF merge
VSF merge happens on connecting two different VSF fragments having same domain-id via VSF links. One of the
VSF fragment will go for reboot to merge with the other fragment and forms one VSF fabric. VSF fabric can only
be formed among same type of devices. For example Aruba 5406R cannot form a VSF with Aruba 5412R.

Figure 176: VSF Merge

Member priority
Member priority determines the possibility of a member device to get elected as the Commander. A member with
higher priority is more likely to be elected as the Commander. The default priority is 128, and ranges from 1 to
255.

NOTE: Changing the priority does not affect the commander immediately. It is only used at the next
election, which will be at the next stack reboot

Interface naming conventions
An interface is named in the following format:

Interface name
<MEMBER-ID>/<interface-module><port-index>
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Example

1/A1, 2/L24

Parameters

<MEMBER-ID>

VSF member ID of the switch. The VSF member ID always takes effect, whether or not the device has formed
a VSF fabric with other devices. If the device is alone, the device is considered to be a standalone VSF fabric.

This argument defaults to 1.

<interface-module >

Slot letter of the front panel. Letter can be A-F for Aruba 5406R switch and A-L for Aruba 5412R switch.

<port-index >

Index of the port on the device. Port index depends on the number of ports available on the linecard (or
Interface Module).

Interface name

On VSF, an interface name would take this form:

<member ID>/<interface-module><port-index>
2/B4
where 2 is the member ID and B4 is the port-index.

Running-configuration synchronization
VSF uses a strict running-configuration synchronization mechanism. In a VSF fabric, a device obtains and runs
the configuration of the Commander. Commander manages and retains the configuration of all the devices.

VSF deployment methods
There are two ways to configure a VSF: Discovered Configuration Mode and Provisioned Configuration Mode.

Discovered configuration mode procedure
The following procedure configures devices into VSF members:

1. Configure VSF memberID and ports on one switch and enable VSF on that switch

2. After reboot, the device will come up as standalone VSF member. Connect a new device (with the factory
default configuration) to this VSF device. The commander should be connected to the VSF ports of the first
device.

3. The new device will reboot and join as standby.

Provisioned configuration mode procedure
The following procedure configures devices into VSF members:

Procedure

1. Configure VSF memberID and VSF links on one switch and enable VSF on that switch.

2. After reboot, the device will come up as standalone VSF commander. Provision the second device with its
memberID, J-Number, and, optionally, the MAC address.
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3. Provision the module with its J-Number. Then, provision VSF link and ports on that module.

4. Connect the new device (with the factory default configuration) to this VSF device. The new device should be
connected to the configured VSF ports.

5. The new device will reboot and join as standby.

Configuration commands

copy core-dump
Copy core-dump from the specified VSF member. User can copy available core-dump file from interface module
or management module.

Syntax

copy core-dump vsf member <MEMBER-ID> <SLOT-ID> | mm-active sftp | tftp | usb | 
xmodem <HOST-NAME-STR> | <IP-ADDR> | <IPV6-ADDR> <FILENAME-STR>
Description

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to 2.

Parameters

<MEMBER-ID>

Specify the VSF member.

<SLOT-ID>

Copy interface module core-dump file.

copy crash-data
Copy the crash data file of the switch.

Syntax
copy crash-data vsf member <MEMBER-ID> <SLOT-ID-RANGE> | mm | sftp | tftp | usb | 
xmodem sftp | tftp | usb | xmodem <HOST-NAME-STR> | <IP-ADDR> | <IPV6-ADDR> 
<FILENAME-STR>

Description

Copy the switch crash data file.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
2.

<SLOT-ID-RANGE>

Enter the single slot identifier.

copy crash-files
Syntax
copy crash-files vsf member <MEMBER-ID> [<SLOT-ID-RANGE> | mm-active sftp | tftp |
usb | xmodem] <HOST-NAME-STR> | <IP-ADDR> | <IPV6-ADDR> <FILENAME-STR>
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Description

Copy the switch crash files from the specific VSF member

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
2.

<SLOT-ID-RANGE>

Enter single slot identifier.

mm-active

Copy active management module crash files.

Usage
Switch(config)# copy crash-files vsf member
Switch(config)# copy crash-files vsf member 1

copy crash-log vsf-member
Syntax

copy crash-log vsf member <MEMBER-ID> | <SLOT-ID-RANGE> | mm | sftp | tftp | usb | 
xmodem sftp | tftp | usb | xmodem <HOST-NAME-STR> | <IP-ADDR> | <IPV6-ADDR> 
<FILENAME-STR>

Description

Copy the switch log file.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
2.

<SLOT-ID-RANGE>

Enter the single slot identifier.

copy fdr-log
Copy FDR (Flight data recorder) logs. User can either copy from management module or interface module or
both.

Syntax

copy fdr-log vsf member <MEMBER-ID> all | mm-active sftp | tftp | usb | xmodem <HOST-NAME-STR> | <IP-ADDR> | <IPV6-ADDR> <FILENAME-STR>

Description

Copy FDR logs from the switch to an SFTP/TFTP server, USB or xmodem terminal.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
2.
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erase fdr-log vsf
Erase FDR log from the specified member.

Syntax
erase fdr-log [vsf member <MEMBER-ID>] [slot | mm-active]
Description

Erase the FDR log files.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
2.

power-over-ethernet vsf-member
Syntax
[no] power-over-ethernet vsf member <MEMBER-ID> pre-std-detect [slot <SLOT-LIST>]
[ports <PORT-LIST>]
Description

Set Power Over Ethernet (PoE) configuration parameters. Pre-standard detection and redundancy can be
configured only at a per-member level when VSF is enabled.

Parameters

<MEMBER-ID>

The VSF member-ID for the 'member' command/parameter. Member ID value can be in the range from 1 to 2.

SLOT-ID-RANGE

Alphabetic device slot identifier or slot range.

<PORT-LIST>

Ethernet port number, a list of ethernet ports or 'all' for all ports.

<SLOT-ID-RANGE>

Enter an alphabetic device slot identifier or slot range preceded with the VSF member-ID [VSF-MEMBER/
SLOT].

n+1

One of the highest power supplies will be held inreserve. In the event of a simple power supply failure,no
powered devices will be shut down.

full

Half of the available power supplies will be held on reserve.

<THRESHOLD-LEVEL>

Threshold level in the range from 1 to 99.

Usage
power-over-ethernet vsf member <MEMBER-ID> redundancy [n+1 | full]
[no] power-over-ethernet vsf member <MEMBER-ID> redundancy [n+1 | full]
power-over-ethernet vsf member <MEMBER-ID> slot <SLOT-ID-RANGE> threshold
<THRESHOLD-LEVEL>
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redundancy switchover
Redundancy configuration for management modules.

Syntax
redundancy switchover
Description

The command causes the VSF Commander switch to immediately switch over to the standby switch.

snmp-server enable traps vsf
Syntax
[no] snmp-server enable traps vsf
Description

Enable traps for the VSF functionality.

Validation rules

Validation Error/Warning/Prompt

This command cannot be executed if VSF is not
enabled.

VSF is not enabled.

vsf domain
Syntax
vsf domain <DOMAIN-ID>
Description

Change domain ID for the VSF virtual chassis. Once VSF is enabled and virtual chassis is formed, VSF domain
ID can be changed using this command.

Parameters

<DOMAIN-ID>

The VSF virtual chassis domain ID. Domain ID value can be in the range from 1 to 4294967296.

Validation rules

Validation Error/Warning/Prompt

Domain ID must be a 32-bit
unsigned integer.

The domain ID cannot be zero.

vsf enable
From the config context:

Syntax
vsf enable domain <DOMAIN-ID>
Description

Enable VSF on the switch. Allows for switches to be stacked using Ethernet ports.
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Parameters

<DOMAIN-ID>

The VSF virtual chassis domain ID. Domain ID value can be in the range from 1 to 4294967296.

CAUTION: The command vsf enable domain reboots only one switch to form the VSF fabric.
Upon reboot, the switches come up in the “VSF enabled” mode. Port numbers are prefixed with
member numbers, such as “1/A1,”. The configuration on the switch becoming Commander will be
retained, but any pre-existing configuration on other switches will be over-written.

The switches will inherit the same switch software as the member becoming Commander. If the
software image of a switch needs to be updated, the switch will reboot twice.

vsf disable
Syntax
vsf disable
Description

Disable VSF on the virtual chassis.

Restriction

This command will not be available until VSF is enabled.

Validation rules

Validation Error/Warning/Prompt

When vsf enable is executed on an VSF
disabled switch following warning message will be
displayed.

This will save the current configuration and reboot
the switch. Continue [y/n]?

Run vsf enable on VSF virtual chassis.

Run VSF disable when VSF links is UP. VSF cannot be disabled when the VSF virtual
chassis is active.

Run vsf disable command on VSF disabled
switch.

vsf member reboot
Syntax
boot vsf member <MEMBER-ID>
Description

Reboot the VSF member and rejoin the virtual chassis with the current configuration.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
2.

Restriction

This command will not be available until VSF is enabled.

660 Aruba 3810 / 5400R Management and Configuration Guide for
ArubaOS-Switch 16.08

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4398



vsf member remove
This command removes the entire configuration for a specified member. After issuing the command, the specified
member-ID is available for re-use and may be provisioned or assigned to another device.

If the member physically exists, its configuration will be erased. It will then be powered down by default.

Syntax
vsf member <MEMBER-ID> remove
Description

This command erases the VSF member configuration and VSF member will be powered off.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
2.

Restriction

This command will not be available until VSF is enabled.

Validation rules

Validation Error/Warning/Prompt

If VSF not enabled, this command is not allowed. VSF is not enabled.

VSF member neither exists nor provisioned The specified VSF virtual chassis member either
does not exist or is not provisioned.

VSF standby syncing add remove member
blocked

VSF virtual chassis members cannot be added or
removed while the standby is booting.

VSF member remove causes VSF virtual chassis
split

Removing this member is not allowed since it
would result in a VSF virtual chassis split.

VSF missing member remove The specified VSF virtual chassis member will be
removed and its configuration will be erased. The
resulting configuration will be saved. Continue
[y/n]?

VSF VC member does not exist The specified VSF virtual chassis member does
not exist.

VSF provision member remove The specified VSF virtual chassis member
configuration will be erased. The resulting
configuration will be saved. Continue [y/n]?

VSF remove commander The VSF virtual chassis commander cannot be
removed. Please fail over to standby before trying
to remove the commander.

Table Continued
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Validation Error/Warning/Prompt

VSF member remove The specified VSF virtual chassis member will be
removed and its configuration will be erased. The
resulting configuration will be saved. The VSF
member will be shut down. Continue [y/n]?

VSF standby remove The specified VSF virtual chassis member will be
removed and its configuration will be erased. The
resulting configuration will be saved. The VSF
member will be shut down. Continue [y/n]?

vsf member shutdown
For a switch that physically exists, this command will cause the switch to shut down. shutdown is used in
preparation to remove the switch from the virtual chassis. The switch will not become a deciding member of the
virtual chassis again until it is rejoined.

The shutdown command can not be used on the Commander. The shutdown command will succeed only if the
switch physically exists and is an active member of the virtual chassis.

Syntax
vsf member <MEMBER-ID> shutdown
Description

Shut down the VSF virtual chassis member.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
2.

Restriction

Shutdown will not be available until VSF is enabled.

Validation rules

Validation Error/Warning/Prompt

If member switch physically exists The specified VSF virtual chassis member will be
shut down. Continue [y/n]?

If member switch physically exists and is the
commander

The VSF virtual chassis commander cannot be
shut down. Please fail over to the standby first.

If member switch does not physically exist The specified VSF virtual chassis member does
not exist.

If shutting down a member will cause a VC –split Shutting down this VSF virtual chassis member is
not allowed since it would result in a VSF virtual
chassis split.

If VSF not enabled, this command is not allowed. VSF is not enabled.
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vsf member priority
Syntax
[no] vsf member <MEMBER-ID> priority <PRIORITY>
Description

Assign a priority to the specified VSF virtual chassis member. The higher the priority, the more likely that the
virtual chassis member will become the commander at the next virtual chassis reboot. The default priority value is
128.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
2.

<PRIORITY>

The priority value for VSF member. Priority value can be in the range from 1 to 255.

vsf member type
Syntax
vsf member <MEMBER-ID> type <TYPE> [mac <MAC-ADDR>]
Description

Configure the family of the VSF member-switch being provisioned. After provisioning, the VSF member-switch
can be configured as if it were physically present. When an VSF member-switch matching the provisioned details
joins the VSF, it is provided this configuration. A new or missing VSF member can be configured as a provisioned
device by using this command.

Parameters

<MEMBER-ID >

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
2.

<TYPE>

Configure the family of the VSF member-switch being provisioned.

<MAC-ADDR >

Configure the MAC address of the VSF member switch being provisioned.

Restrictions

• If switch “N” physically exists, the command will fail.

• If switch “N” is provisioned, the command can be used to change the MAC or type.

• If the J-Number is known to not support stacking, or the J-Number is unknown, the command will fail.

• If the same MAC address is already provisioned or exists on another member ID, the command will fail.

Usage

vsf member <2> type <J9850A> mac <001122-334455>
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Updates the strict provisioning for VSF member 2, and changes the MAC address to 001122-334455.

vsf member <2> type <J9850A>
Changes the “strict” provisioning for VSF member 2 to “loose” provisioning. The configured MAC address is then
removed.

vsf member <2> type <J9850A> mac <00aabb-cceedd>
Changes “loose” provisioning for VSF member 2 to “strict” provisioning with MAC address 00aabb-cceedd.

Validation rules

Validation Error/Warning/Prompt

If the member-ID is not between 1 to 2 for 5400R,
then this command will return an error.

The VSF member-ID value is not in range.

The member-ID must physically exist or already
be provisioned.

The specified VSF virtual chassis member either
does not exist or is not provisioned.

When each time new member is configured, write
mem is called.

This will save the current configuration. Continue
[y/n]?

Show commands

show vsf
Shows the current status and all current configurations of the provisioned VSF configuration on a switch.

Syntax
show vsf [detail]
Description

Shows detailed information of VSF virtual chassis members that are provisioned.

Switch# show vsf
VSF Domain ID : 44444
MAC Address : 3464a9-b2533f
VSF Topology : Chain
VSF Status : Active
Uptime : 32d 4h 28m
VSF Oobm-MAD : Enabled
Software Version : KB.16.01.0004
Mbr
ID     Mac Address   Model                     Pri Status
----------------------------------------------------------
1      3464a9-b24300 J9850A Switch 5406Rzl2 255 Commander
2      288023-98ae00 J9850A Switch 5406Rzl2 100 Standby

Switch(config)# show vsf detail

 VSF Domain ID    : 44444                                               
 MAC Address      : 3464a9-b2533f
 VSF Topology     : Chain                                   
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 VSF Status       : Active                                  
 Uptime           : 32d 4h 28m   
 VSF Oobm-MAD     : Enabled                                 
 VSF Lldp-MAD     : Disabled                                
 Software Version : KB.16.01.0004

Name             : VSF-Switch
Contact          : 
Location         : 

Member ID        : 1 
MAC Address      : 3464a9-b2533f
Type             : J9850A
Model            : J9850A Switch 5406Rzl2                                   
Priority         : 255
Status           : Commander      
ROM Version      : KB.16.01.0006                                     
Serial Number    : ff ff ff ff ff ff ff ff ff ff                                
Uptime           : 32d 4h 28m   
CPU Utilization  : 0%  
Memory - Total   : 704,471,040 bytes 
Free             : 522,821,984 bytes 
VSF Links - 
#1 : Active, Peer member 2

Member ID        : 2 
MAC Address      : 288023-98ae00
Type             : J9850A
Model            : J9850A Switch 5406Rzl2                                   
Priority         : 100
Status           : Standby        
ROM Version      : KB.16.01.0006                                     
Serial Number    : SG46G4904K                                                   
Uptime           : 32d 4h 20m    
CPU Utilization  : 2%  
Memory - Total   : 704,471,040 bytes 
Free             : 536,014,360 bytes 
VSF Links - 
#1 : Active, Peer member 1

Validation rules

Validation Error/Warning/Prompt

If VSF is not enabled, this command is
not applicable.

VSF is not enabled.

show vsf link
Syntax
show vsf link [detail]
Description

Shows the VSF port state of the VSF links for each VSF member, in detail.
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show vsf link

Switch# show vsf link

 VSF Member 1
                 Link     Peer   Peer
 Link Link-Name  State    Member Link
 ---- ---------- -------- ------ ----
 1    I-Link1_1  Up       2      1

 

VSF Member 2
                 Link     Peer   Peer
 Link Link-Name  State    Member Link
 ---- ---------- -------- ------ ----
 1    I-Link2_1  Up       1      1

show vsf link detail

Switch# show vsf link detail
 vsf Member: 1     Link: 1
 Vsf-Port   Port-State
 --------   -------------------------
 1/E1       Up: Connected to port 2/E1

vsf Member: 2     Link: 1
 Vsf-Port   Port-State
 --------   -------------------------
 2/E1       Up: Connected to port 1/E1

show vsf member
Syntax
show vsf member <MEMBER-ID>
Description

Shows the virtual chassis information for member.

Parameters

<MEMBER ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
2.

show vsf member 1

Switch# show vsf member 1
Member ID        : 1 
MAC Address      : a01d48-8f6700
Type             : J9850A
Model            : J9850A Switch 5406Rzl2 
Priority         : 128
Status           : Standby        
ROM Version      : KB.16.01.0005
Serial Number    : SG4ZG95321    
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Uptime           : 21d 19h 5m  
CPU Utilization  : 2%  
Memory - Total   : 698,957,824 bytes 
Free             : 528,240,524 bytes 
VSF Links - 
#1 : Active, Peer member 2

show vsf member 2

Switch# show vsf member 2
Member ID        : 2 
Mac Address      : 288023-98ae00
Type             : J9850A
Model            : J9850A Switch 5406Rzl2 
Priority         : 100
Status           : Standby
ROM Version      : KB.16.01.0005
Serial Number    : SG46G4906P 
Uptime           : 32d 4h 11m  
CPU Utilization  : 0%
Memory - Total   : 709,357,568 bytes 
Free             : 546,939,520 bytes 
VSF Links - 
#1 : Active, Peer member 1

show system information vsf member
Syntax
show system information [vsf member <MEMBER-ID>]
Description

Show global configured and operational system parameters of the specified VSF members.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
2.

show system

Switch(config)# show system
 Status and Counters - General System Information
  System Name        : bolt-vsf-sws 
  System Contact     : 
  System Location    : 
  Allow V2 Modules   : No
  MAC Age Time (sec) : 300    
  Time Zone          : -480
  Daylight Time Rule : Continental-US-and-Canada 
  Software revision  : KB.16.01.0004
  Base MAC Addr      : 3464a9-b2533f

 VSF-Member :1
  ROM Version        : KB.16.01.0005 
 Up Time            : 32 days
  CPU Util (%)       : 2   
  MAC Addr           : 3464a9-b24300
  Serial Number      : SG4BG491BL 
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  Memory   - Total   : 709,357,568    Free    : 529,020,080 

 VSF-Member :2
  ROM Version        : KB.16.01.0005   
  Up Time            : 32 days 
  CPU Util (%)       : 0
  MAC Addr           : 288023-98ae00
  Serial Number      : SG46G4906P
  Memory   - Total   : 709,357,568    Free    : 546,939,520

show system information VSF member 2

Switch# show system information vsf member 1
 Status and Counters - General System Information
  System Name        : bolt-vsf-sws   
  System Contact     : 
  System Location    : 
  Allow V2 Modules   : No
  MAC Age Time (sec) : 300    
  Time Zone          : -480 
  Daylight Time Rule : Continental-US-and-Canada 
  Software revision  : KB.16.01.0004      
  Base MAC Addr      : 3464a9-b2533f

 VSF-Member :1
  ROM Version        : KB.16.01.0005                 
  Up Time            : 32 days        
  CPU Util (%)       : 0           
  MAC Addr           : 3464a9-b24300
  Serial Number      : SG4BG491BL
  Memory   - Total   : 709,357,568      Free    : 529,413,568 

Switch# show system information vsf member 2
 Status and Counters - General System Information
  System Name        : bolt-vsf-sws   
  System Contact     : 
  System Location    : 
  Allow V2 Modules   : No
  MAC Age Time (sec) : 300    
  Time Zone          : -480
  Daylight Time Rule : Continental-US-and-Canada 
  Software revision  : KB.16.01.0004
  Base MAC Addr      : 3464a9-b2533f

 VSF-Member :2
  ROM Version        : KB.16.01.0005    
  Up Time            : 32 days 
  CPU Util (%)       : 0   
  MAC Addr           : 288023-98ae00
  Serial Number      : SG46G4906P    
  Memory   - Total   : 709,357,568    Free    : 546,939,520

show system chassislocate
Syntax
show system chassislocate [vsf member <MEMBER-ID>]
Description

Show locator LED information. If VSF is enabled, this shows locator LED information for all the VSF members.

Parameters
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<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
2.

show system chassislocate

Switch# show system chassislocate
 Locator LED Status
  VSF     Current  Time
  Member  State    Remaining  Configuration
  ------  -------  ---------  -------------
  1       off
  2       blink    00:29:10

show system chassislocate vsf member 2

Switch# show system chassislocate vsf member 2
Locator LED Status
Switch# show system chassislocate vsf member 2
 Locator LED Status
  VSF     Current  Time
  Member  State    Remaining  Configuration
  ------  -------  ---------  -------------
  2       blink    00:29:45

show boot-history
Syntax
show boot-history [vsf member <MEMBER-ID>]
Description

Display the system boot log for VSF.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
2.

show system temperature
Syntax
show system temperature [vsf member <MEMBER-ID>]
Description

Show current temperature sensor information. If VSF is enabled, this shows the temperature sensor information
for all VSF members.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
2.
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show system temperature

Switch# show system temperature

System Air Temperatures
  VSF-Member  1
  Temp    Current  Max   Min                        Avg    
  Sensor  Temp     Temp  Temp  Threshold  OverTemp  Temp   
  ------- -------- ----- ----- ---------- --------- -------
  Chassis 31C      33C   27C   55C        NO         29.46C

  VSF-Member  2
  Temp    Current  Max   Min                        Avg    
  Sensor  Temp     Temp  Temp  Threshold  OverTemp  Temp   
  ------- -------- ----- ----- ---------- --------- -------
  Chassis 30C      32C   28C   55C        NO         29.08C

show system temperature vsf member 2

Switch# show system temperature vsf member 2

 System Air Temperatures
  VSF-Member  2
  Temp    Current  Max   Min                        Avg    
  Sensor  Temp     Temp  Temp  Threshold  OverTemp  Temp   
  ------- -------- ----- ----- ---------- --------- -------
  Chassis 30C      32C   28C   55C        NO         29.08C

show system fans
Syntax
show system fans [vsf member <MEMBER-ID>]
Description

Show system fan status. If VSF is enabled, this shows the system fan status for all VSF members.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
2.

show system fans

show system fans

 Fan Information
 VSF-Member  1
     Num  | State       | Failures
   -------+-------------+----------
   Sys-1  | Fan OK      |   0
   Sys-2  | Fan OK      |   0
   Sys-3  | Fan OK      |   0
   Sys-4  | Fan OK      |   0
 0 / 4 Fans in Failure state
 0 / 4 Fans have been in Failure state
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 VSF-Member  2
     Num  | State       | Failures
   -------+-------------+----------
   Sys-1  | Fan OK      |   0
   Sys-2  | Fan OK      |   0
   Sys-3  | Fan OK      |   0
   Sys-4  | Fan OK      |   0
 0 / 4 Fans in Failure state
 0 / 4 Fans have been in Failure state

show system fans vsf member 1

show system fans VSF member 1

Fan Information
 VSF-Member  1
     Num  | State       | Failures
   -------+-------------+----------
   Sys-1  | Fan OK      |   0
   Sys-2  | Fan OK      |   0
   Sys-3  | Fan OK      |   0
   Sys-4  | Fan OK      |   0
 0 / 4 Fans in Failure state
 0 / 4 Fans have been in Failure state

show CPU
Syntax
show cpu <SECONDS>
Description

Show average CPU utilization.

Parameters

<INTEGER>

Refresh time.

<SLOT-ID-RANGE>

Alphabetic device slot identifier or slot range.

Usage
show cpu slot process refresh <INTEGER>
show cpu process slot <SLOT-ID-RANGE> refresh <INTEGER>

show cpu slot all

Switch# show cpu slot all
  VSF slot 1/a:
  -------------
  12 percent busy, from 18 sec ago

  1 sec ave: 14 percent busy
  5 sec ave: 12 percent busy
  1 min ave: 12 percent busy
  VSF slot 1/f:
  -------------
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  16 percent busy, from 17 sec ago
  1 sec ave: 27 percent busy
  5 sec ave: 16 percent busy
  1 min ave: 15 percent busy

  VSF slot 2/a:
  -------------
  12 percent busy, from 18 sec ago
  1 sec ave: 14 percent busy
  5 sec ave: 12 percent busy
  1 min ave: 12 percent busy

  VSF slot 2/f:
  -------------
  16 percent busy, from 17 sec ago
  1 sec ave: 27 percent busy
  5 sec ave: 16 percent busy
  1 min ave: 15 percent busy

show cpu slot 1/A

Switch# show cpu slot 1/A

  VSF slot 1/a:
  -------------
  12 percent busy, from 18 sec ago
  1 sec ave: 14 percent busy
  5 sec ave: 12 percent busy
  1 min ave: 12 percent busy

show CPU process slot
Syntax

show cpu <SECONDS>
Description

Show average CPU utilization.

Parameters

<SECONDS >

The time in seconds over which to average CPU utilization.

Usage
show cpu slot <SLOT-LIST> <SECONDS>
show cpu process slot <SLOT-LIST> refresh <COUNT>

show cpu process slot all

Switch# show cpu process slot all

 VSF slot 1/A:
 -------------
 Process tracker state: ACTIVE
 Process tracking time: 30 seconds

                  Total      %            Time Since  Times   Max
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Process Name      Priority   Time   CPU   Last Ran    Ran     Time
----------------+----------+------+-----+-----------+-------+-------
Hardware Mgmt-3     192       3 s    6      234 ms    214     35 ms
System Services-2   156       3 s    5       55 ms    110     50 ms
Idle-3               1       12 s    24     731 us    245918  193 us
Idle-1              226      25 s    51     770 us    123627  319 us
Idle-0              226       5 s    10     459 us    122921  170 us

 VSF slot 2/F:
 -------------
 Process tracker state: ACTIVE
 Process tracking time: 30 seconds

                    Total       %           Time Since   Times  Max
Process Name        Priority   Time   CPU   Last Ran     Ran    Time
------------------+----------+------+-----+------------+-------+-----
Hardware Mgmt-3      192       3 s     8     54 ms      189    41 ms
System Services-2    156       3 s     8     2 s        131    50 ms
Idle-3                1        9 s     23    870 us     160197 199 us
Idle-0               226       4 s     10    926 us     80053  162 us
Idle-1               226      19 s     48    1 ms       80545  395 us

show cpu process slot 1/A

Switch# show cpu process slot 1/A

 VSF slot 1/A:
 -------------
 Process tracker state: ACTIVE
 Process tracking time: 30 seconds

                            Total    %     Time Since   Times   Max
Process Name     Priority   Time     CPU   Last Ran     Ran     Time
----------------+----------+--------+-----+-----------+-------+-----
Hardware Mgmt-3    192       3 s      6     234 ms      214    35 ms
System Services-2  156       3 s      5     55 ms       110    50 ms
Idle-3              1        12 s     24    731 us      245918 193 us
Idle-1             226       25 s     51    770 us      123627 319 us
Idle-0             226       5 s      10    459 us      122921 170 us

show modules
Syntax
show modules details vsf member <MEMBER-ID> MM1 | MM2 | slot <SLOT-LIST>
Description

Show module details for VSF members.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
2.

MM1

Show MM1 module information of the specified VSF member.
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MM2

Show MM2 module information of the specified VSF member.

slot

Show SLOT module information of the specified VSF member.

<SLOT-LIST>

Enter an alphabetic device slot identifier or a slot range.

show modules

Switch# show modules 

 Status and Counters - Module Information
  Chassis: 5406Rzl2 J9850A         Serial Number:   SG4BG491BL
  Allow V2 Modules:   No
                                                                       Core  Mod
  Slot  Module Description                     Serial Number  Status   Dump  Ver
  ----- -------------------------------------- -------------- -------- ----- ---
  1/MM1 J9827A Management Module 5400Rzl2      SG4BG4C0C0     Active   YES   1  
  1/MM2 J9827A Management Module 5400Rzl2      A123456789     Offline  YES   1  
  1/A   J9992A 20p PoE+ / 1p 40GbE QSFP+...    B123456789     Up       YES   3  
  1/F   J9991A 20p PoE+ / 4p 1/2.5/5/XGT...    SG5ZGPH190     Up       YES   3  
  2/MM1 J9827A Management Module 5400Rzl2      SG45G4C0VZ     Active   YES   1 
  2/A   J9992A 20p PoE+ / 1p 40GbE QSFP+...    c123456789     Up       YES   3  
  2/F   J9991A 20p PoE+ / 4p 1/2.5/5/XGT...    SG5ZGPH183     Up       YES   3  

Switch# show modules details vsf member 1
 MM1                   Show MM1 module information of the specified VSF member.
 MM2                   Show MM2 module information of the specified VSF member.
 slot                  Show SLOT module information of the specified VSF member.

Switch# show modules details vsf member 1
 Status and Counters - Module Information
  Chassis: 5406Rzl2 J9850A         Serial Number:   SG4BG491BL
  Allow V2 Modules:   No
                                                                       Core  Mod
  Slot  Module Description                     Serial Number  Status   Dump  Ver
  ----- -------------------------------------- -------------- -------- ----- ---
  1/MM1 J9827A Management Module 5400Rzl2      SG4BG4C0C0     Active   YES   1  

                                                                       Core  Mod
  Slot  Module Description                     Serial Number  Status   Dump  Ver
  ----- -------------------------------------- -------------- -------- ----- ---
  1/MM2 J9827A Management Module 5400Rzl2      D123456789     Offline  YES   1  

                                                                       Core  Mod
  Slot  Module Description                     Serial Number  Status   Dump  Ver
  ----- -------------------------------------- -------------- -------- ----- ---
  1/A   J9992A 20p PoE+ / 1p 40GbE QSFP+...    E123456789     Up       YES   3  

                                                                       Core  Mod
  Slot  Module Description                     Serial Number  Status   Dump  Ver
  ----- -------------------------------------- -------------- -------- ----- ---
  1/F   J9991A 20p PoE+ / 4p 1/2.5/5/XGT...    SG5ZGPH190     Up       YES   3  

Switch# show modules details vsf member 2
 Status and Counters - Module Information
  Chassis: 5406Rzl2 J9850A         Serial Number:   SG4BG491BL
  Allow V2 Modules:   No
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                                                                       Core  Mod
  Slot  Module Description                     Serial Number  Status   Dump  Ver
  ----- -------------------------------------- -------------- -------- ----- ---
  2/MM1 J9827A Management Module 5400Rzl2      SG45G4C0VZ     Active   YES   1 

                                                                       Core  Mod
  Slot  Module Description                     Serial Number  Status   Dump  Ver
  ----- -------------------------------------- -------------- -------- ----- ---
  2/A   J9992A 20p PoE+ / 1p 40GbE QSFP+...    H123456789      Up       YES   3  

                                                                       Core  Mod
  Slot  Module Description                     Serial Number  Status   Dump  Ver
  ----- -------------------------------------- -------------- -------- ----- ---
  2/F   J9991A 20p PoE+ / 4p 1/2.5/5/XGT...    SG5ZGPH183     Up       YES   3  

show modules details vsf member 1 slot 1/a

Switch# show modules details vsf member 1 slot 1/a
 Status and Counters - Module Information
  Chassis: 5406Rzl2 J9850A         Serial Number:   SG4BG491BL
  Allow V2 Modules:   No

                                                                       Core  Mod
  Slot  Module Description                     Serial Number  Status   Dump  Ver
  ----- -------------------------------------- -------------- -------- ----- ---
  1/A   J9992A 20p PoE+ / 1p 40GbE QSFP+...    A123456789      Up       YES   3  

show power-over-ethernet
Syntax
show power-over-ethernet vsf member <MEMBER-ID>
show power-over-ethernet slot all
Description

Show power-over-ethernet for named slots or specified VSF member switches.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
2.

show power-over-ethernet slot all

Switch# show power-over-ethernet slot all

Status and Counters - System Power Status for slot 1/A
Maximum Power       :   0 W           Operational Status  : On
Power In Use        :   0 W +/- 6 W   Usage Threshold (%) : 80

Status and Counters - System Power Status for slot 2/A
Maximum Power       :   0 W           Operational Status  : On
Power In Use        :   0 W +/- 6 W   Usage Threshold (%) : 80
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show power-over-ethernet slot 1/A

Switch# show power-over-ethernet slot 1/A

Maximum Power       :   0 W           Operational Status  : On
Power In Use        :   0 W +/- 6 W   Usage Threshold (%) : 80

show power-over-ethernet vsf member 1

Switch(config)# show power-over-ethernet vsf member 1
Status and Counters - System Power Status for member 1
      Maximum Operational                  Usage
Slot  Power   Status      Power In Use     Threshold (%)
----- ------- ----------- ---------------- -------------
1/A   266 W   On            0 W +/- 6 W      80
1/L     0 W   Faulty        0 W +/- 6 W      80

show power-over-ethernet vsf member 2

Switch# show power-over-ethernet vsf member 2
 Status and Counters - System Power Status for member 2
       Maximum Operational                  Usage        
 Slot  Power   Status      Power In Use     Threshold (%)
 ----- ------- ----------- ---------------- -------------
 2/A   266 W   On            0 W +/- 6 W       80        
 2/C     0 W   On            0 W +/- 6 W       80        

show system power-supply
Syntax
show system power-supply [detailed | fahrenheit]

Description

Shows power supply information in either full detail or full detail in Fahrenheit only. Default temperature is
displayed in degrees Celsius.

Command context
manager and operator

Parameters
detailed

Shows detailed switch power supply sensor information.

fahrenheit
Shows detailed switch power supply sensor information with temperatures in degrees Fahrenheit.
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Usage

• The show system power-supply detailed command shows detailed information for the local power
supplies only.

• The show system power-supply detailed command shows detailed information for power supplies in
the powered state only.

Examples

Use of the command show system power-supply shows the power supply status for all active switches.

Switch# show system power-supply

Power Supply Status:

 PS#    Model      Serial          State         AC/DC  + V    Wattage
 ---- --------- ------------ ----------------- -------------- ---------
   1   J9828A    IN30G4D009   Powered           AC 120V/240V      700
   2   J9828A    IN30G4D00C   Powered           AC 120V/240V      700
   3                          Not Present       -- ---------        0
   4   J9830A    IN43G4G05H   Powered           AC 120V/240V     2750

   3 /  4 supply bays delivering power.
   Total power: 4150 W

Use of the command show system power-supply detailed shows the power supply status in detail for all
active switches.

Switch# show system power-supply detailed                        

 Status and Counters - Power Supply Detailed Information 

  PS# Model   Serial      State        Status
  --- ------- ----------- ------------ -------------------------------------
  1   J9828A  IN30G4D009  Powered      AC Power Consumption : 44 Watts      
                                       AC MAIN Voltage      : 209 Volts     
                                       Power Supplied       : 31 Watts      
                                       Power Capacity       : 700 Watts     
                                       Inlet Temp (C/F)     : 27.0C/80.6F   
                                       Internal Temp (C/F)  : 30.5C/86.0F   
                                       Fan 1 Speed          : 1600 RPM (47%) 
                                       Fan 2 Speed          : 1600 RPM (47%) 

  2   J9828A  IN30G4D00C  Powered      AC Power Consumption : 46 Watts
                                       AC MAIN Voltage      : 209 Volts
                                       Power Supplied       : 21 Watts
                                       Power Capacity       : 700 Watts
                                       Inlet Temp (C/F)     : 27.7C/80.6F
                                       Internal Temp (C/F)  : 32.5C/89.6F
                                       Fan 1 Speed          : 1600 RPM (47%)
                                       Fan 2 Speed          : 1600 RPM (47%)

  3                       Not Present

  4   J9830A  IN43G4G05H  Powered      AC Power Consumption : 90 Watts
                                       AC MAIN/AUX Voltage  : 210/118 Volts
                                       Power Supplied       : 16 Watts
                                       Power Capacity       : 2750 Watts
                                       Inlet Temp (C/F)     : 30.9C/86.0F
                                       Internal Temp (C/F)  : 65.6C/149.0F
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                                       Fan 1 Speed          : 2000 RPM (37%)
                                       Fan 2 Speed          : 1950 RPM (36%)

   3 /  4 supply bays delivering power.
   Currently supplying 68 W / 4150 W total power.
Use of the command show system power-supply fahrenheit shows the power supply status in
Fahrenheit for all active switches.

Switch# show system power-supply detailed fahrenheit
Power Supply Status:
 Mem PS# Model   Serial      State        Status
 --- --- ------- ----------- ------------ -----------------------------------
 1   1   J9830A  IN5BGZ81KZ  Powered      Power Consumption   : 95 Watts
                                          AC MAIN/AUX Voltage : 118/208 Volts
                                          Inlet/Internal Temp : 85.6F/87.7F 
                                          Fan 1 Speed (util)  : 1650RPM (20%)
                                          Fan 2 Speed (util)  : 1600RPM (19%)     

 1   2   J9829A  IN5BGZ81KX  Powered      Power Consumption   : 51 Watts
                                          AC Input Voltage    : 208 Volts
                                          Inlet/Internal Temp : 85.6F/87.7F 
                                          Fan 1 Speed (util)  : 1650RPM (20%)
                                          Fan 2 Speed (util)  : 1600RPM (19%)

 1   3   J9828A  IN5BGZ81KY  Powered      Power Consumption   : 43 Watts
                                          AC Input Voltage    : 119 Volts
                                          Inlet/Internal Temp : 85.6F/87.7F 
                                          Fan 1 Speed (util)  : 1650RPM (20%)
                                          Fan 2 Speed (util)  : 1600RPM (19%)

 1   4                       Not Present

 2   1   J9830A  IN5BGZ81KZ  Powered      Power Consumption   : 95 Watts
                                          AC MAIN/AUX Voltage : 118/208 Volts
                                          Inlet/Internal Temp : 85.6F/87.7F 
                                          Fan 1 Speed (util)  : 1650RPM (20%)
                                          Fan 2 Speed (util)  : 1600RPM (19%)

 2   2   J9829A  IN5BGZ81KX  Powered      Power Consumption   : 51 Watts
                                          AC Input Voltage    : 208 Volts
                                          Inlet/Internal Temp : 85.6F/87.7F 
                                          Fan 1 Speed (util)  : 1650RPM (20%)
                                          Fan 2 Speed (util)  : 1600RPM (19%)

 2   3   J9828A  IN5BGZ81KY  Powered      Power Consumption   : 43 Watts
                                          AC Input Voltage    : 119 Volts
                                          Inlet/Internal Temp : 85.6F/87.7F 
                                          Fan 1 Speed (util)  : 1650RPM (20%)
                                          Fan 2 Speed (util)  : 1600RPM (19%)
 2   4                       Not Present
------------------------------------------------------------------------------
   6 / 8 supply bays delivering power.
   Total Input Power: 378 Watts
Use of the command show system power-supply detailed shows the power supply status all active
switches including a nonpowered J9830A PSU.

switch# show system power-supply detailed                        

 Status and Counters - Power Supply Detailed Information 
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  PS# Model   Serial      State        Status
  --- ------- ----------- ------------ -------------------------------------
  1   J9828A  IN30G4D009  Powered      AC Power Consumption : 44 Watts      
                                       AC MAIN Voltage      : 209 Volts     
                                       Power Supplied       : 31 Watts      
                                       Power Capacity       : 700 Watts     
                                       Inlet Temp (C/F)     : 27.0C/80.6F   
                                       Internal Temp (C/F)  : 30.5C/86.0F   
                                       Fan 1 Speed          : 1600 RPM 
                                       Fan 2 Speed          : 1600 RPM

  2   J9828A  IN30G4D00C  Powered      AC Power Consumption : 46 Watts
                                       AC MAIN Voltage      : 209 Volts
                                       Power Supplied       : 21 Watts
                                       Power Capacity       : 700 Watts
                                       Inlet Temp (C/F)     : 27.7C/80.6F
                                       Internal Temp (C/F)  : 32.5C/89.6F
                                       Fan 1 Speed          : 1600 RPM
                                       Fan 2 Speed          : 1600 RPM

  3                       Not Present

  4   J9830A  IN43G4G05H  Aux Not Powered 

   2 /  4 supply bays delivering power.
   Currently supplying 68 W / 4150 W total power.
Use of the command show system power-supply shows the power supply status all active switches with
power supply #2 showing permanent failure.

switch# show system power-supply

Power Supply Status:

 PS#    Model      Serial          State         AC/DC  + V    Wattage
 ---- --------- ------------ ----------------- -------------- ---------
   1                          Not Present       -- ---------        0
   2   J9829A    IN30G4D00C   Permanent Failure  AC 120V/240V     1100
   3   J9829A    IN30G4D00D   Powered           -- ---------       1100
   4   J9829A    IN43G4G05H   Powered           AC 120V/240V      1100

   3 /  4 supply bays delivering power.
   Total power: 3300 W

Table 34: Field key for output of show system power-supply detailed

Field Description

AC Power
Consumption

Actual power consumed from AC input

AC MAIN/AUX
Voltage

Actual voltage measured on AC Input:
• Two voltages are displayed for PS#4, as the J9830A includes two

AC input IEC connectors.

• Most power-supplies contain a single AC Input IEC connector and
are labeled MAIN.

Table Continued
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Field Description

Power Supplied Actual voltage being supplied from the power-supply to the switch for
general power and PoE.

Power Capacity The maximum power that the power-supply can provide to the switch.

Inlet Temp (C/F) The thermal sensor at the inlet of the power-supply - shown in both
Celsius and Fahrenheit

Internal Temp
(C/F)

The thermal sensor internal to the power-supply (will vary depending
upon the model) - shown in both Celsius and Fahrenheit.

NOTE: There is no "Output Temperature Sensor" on
either the 5400R or 3810M switches.

Fan Speed Shows the current fan speed in RPM and the percent of total fan speed
utilization. For PSUs that contain more than one fan, a separate line
will be included for each.

Currently
Supplying

A summary of the total power being supplied and the total capacity
(same summary as seen on the command show system power-
supply).

OOBM-MAD commands

vsf oobm-mad
Syntax
[no] vsf oobm-mad
Description

Enable OOBM-MAD (Multi-Active Detection) on the VSF device.

Validation rules

Validation Error/Warning/Prompt

This command cannot be executed if VSF is not
enabled.

invalid input: oobm-mad

oobm vsf member
Syntax

oobm vsf member <MEMBER-ID> ip address { <IP-ADDR>/<MASK-LENGTH> | dhcp-bootp }

Description

This command is used to configure the IPV4 address for the VSF OOBM.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
2.
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<IP-ADDR>/<MASK-LENGTH>

Interface IP address/mask.

oobm vsf member <MEMBER-ID> ip default-gateway IP-ADDR
Specify the default gateway using this form of the command. Configure the IPv4 default gateway address, which
will be used when routing is not enabled on the switch. The <IP-ADDR> must be specified if the command is not
preceded by [no]. Preceding the command with [no] deletes the default gateway address.The [no] form of
this command does not take effect on default gateway address obtained via DHCP.

Usage
oobm vsf member <VSF-MEMBER> ip
oobm vsf member <VSF-MEMBER> ip address

oobm vsf member interface speed-duplex
Syntax
oobm vsf member <MEMBER-ID> interface { disable | enable | <SPEED-DUPLEX> }
Description

Configure various interface parameters for OOBM. The interface command must be followed by a feature-
specific keyword. This is an OOBM context command. It can be called directly from the OOBM context.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
2.

enable

Enable OOBM port.

disable

Disable OOBM.

<SPEED-DUPLEX>

Define mode of operation for the oobm port.
10-half

10 Mbps, half duplex.

100-half

100 Mbps, half duplex.

10-full

10 Mbps, full duplex.

100-full

100 Mbps, full duplex.

1000-full

1000 Mbps, full duplex.

auto

Use Auto Negotiation for speed and duplex mode.

Usage
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oobm vsf member <VSF-MEMBER-ID> interface enable
oobm vsf member <VSF-MEMBER-ID> interface disable

show oobm vsf member
Syntax
show oobm vsf member <MEMBER-ID>
Description

Show OOBM VSF member.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
2.

show oobm vsf member 1

Switch# show oobm vsf member 1

 VSF Member 1 
  OOBM Port Type         : 100/1000T   
  OOBM Interface Status  : Up              
  OOBM Port              : Enabled     
  OOBM Port Speed        : Auto        

  MAC Address            : 3464a9-b24301

show oobm ip
Syntax
show oobm ip [vsf member <MEMBER-ID>]
Description

Show OOBM IP for specific members in VSF

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
2.

show oobm ip

Switch# show oobm ip

IPv4 Status    : Enabled
IPv4 Default Gateway : 120.93.49.1

            |                                     Address  Interface
 VSF-member | IP Config IP Address/Prefix Length  Status   Status
 ---------- + --------- ------------------------- -------- ---------
 Global     | dhcp      120.93.49.9/24            Active   Up
 1          | dhcp      120.93.49.9/24            Active   Up
 2          | disabled                            Inactive Down
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show oobm ip vsf member 1

Switch# show oobm ip vsf member 1
 IPv4 Status    : Enabled 
  IPv4 Default Gateway : 15.212.178.1 
            |                                     Address  Interface
 VSF-member | IP Config IP Address/Prefix Length  Status   Status   
 ---------- + --------- ------------------------- -------- ---------
 1          | dhcp      15.212.178.244/24         Active   Up       

show oobm ip vsf member 1,2

Switch(config)# show oobm ip vsf member 1,2
IPv4 Status : Enabled
IPv4 Default Gateway :                               
            |                                     Address  Interface
 VSF-member | IP Config IP Address/Prefix Length  Status   Status   
 ---------- + --------- ------------------------- -------- ---------
 1          | dhcp                                Active   Down       

Switch(config)# sho oobm ip detail
Internet (IP) Service for OOBM Interface
Global Configuration
IPv4 Status : Enabled
IPv6 Status : Disabled
IPv4 Default Gateway :
IPv6 Default Gateway :

Origin | IP Address/Prefix Length Status
----------------------------------------
dhcp   |

VIPv4 SF Member 1
Status : Enabled
IPv6 Status : Disabled
IPv4 Default Gateway :
IPv6 Default Gateway :

Origin | IP Address/Prefix Length Status
----------------------------------------
dhcp   |

show oobm discovery
Syntax
show oobm discovery
Description

Show the discovered virtual chassis information.

show oobm discovery

Switch# show oobm discovery

Chapter 19 Virtual Switching Framework (VSF) 683

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4421



Active Stack (This fragment)
 VSF-member Mac Address    Status
 ID
 ---------- -------------- ----------------
 2          10604b-b7a140  Global Commander
 1          10604b-b66980  Global Member

show running-config oobm
Syntax
show running-config oobm
Description

Show running-config OOBM.

show running-config oobm

Switch# show running-config oobm

Running configuration:
oobm
   ip address dhcp-bootp
   VSF-member 1
      ip address dhcp-bootp
      exit

   VSF-member 2
      ip address 192.168.10.1 255.255.255.0
      exit

   exit

show vsf trunk-designated-forwarder
Syntax
show vsf trunk-designated-forwarder
Description

Show the designated forwarders for each trunk.

For each trunk, only one member of the trunk will forward L2 flood traffic (unknown destination, Broadcast &
Multicast). Use the show vsf trunk-designated-forwarder command to know which member will forward
flood frames for a given trunk.

For known unicast traffic, trunks will always forward using local member links when possible and traffic will cross
the VSF links to the other member only when local links of a trunk are down.

show vsf trunk designated forwarder

Switch(config)# show vsf trunk-designated-forwarder 

 Trunk Designated Forwarders
  NAME  TYPE  Member
  ----- ----- ------
  Trk1  TRK   1 
  Trk2  LACP  0 
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  Trk3  TRK   0 
  Trk10 TRK   1 

Validation rules

Validation Error/Warning/Prompt

Downloading a non-VSF config on a VSF
switch or downloading an invalid VSF-
config for a current VSF must be blocked.

The configuration file for this VSF device is
incorrect.

Upon enabling VSF, the hostname of the
virtual chassis would change to a different
string than it is when VSF is disabled.

5406R-VSF

LLDP-MAD
LLDP-MAD is used to detect multiple-active VSF fragments.

VSF split and MAD operation
The following sequence explains a MAD scheme for a simple 2-member, VSF virtual chassis split scenario.

1. When the VSF link goes down and the VSF virtual chassis splits:

• The Commander member ( Fragment-A for this example) would continue to stay active.

• The Standby member (Fragment B) would failover and become another commander.

2. Fragment-B sends an SNMP request to the downstream device seeking port status information of all non-local
ports of the LACP Trunk. Non-local ports on Fragment-B refers to ports that are part of Fragment-A’s member.

• The downstream device responds to the SNMP request with the appropriate port status information.

• If Fragment-A receives an unsolicited response to the SNMP request, it is ignored. This is because
Fragment A has the pre-split Commander as part of its fragment and therefore will remain active.

3. Fragment-B sends 2 more SNMP queries downstream. If no response is received, the frontplane ports are
shut down and turned inactive.

4. Alternatively, if Fragment-B receives an SNMP response:

• If Fragment A links are UP, the frontplane ports will be shut down.

• If Fragment-A links are DOWN, Fragment-B would stay UP.

5. Consider that Fragment-A is actually DOWN which has caused the split:

• Request made to Fragment-B will be received by the downstream device and response will return to
Fragment-B.

• The downstream links to Fragment-A are DOWN therefore Fragment-B will remain UP.

• Alternately, if Fragment-B is DOWN and caused the split then Fragment-A will neither send a request or act
on an unsolicited response and will remain UP.
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MAD readiness check
The MAD assist device must be connected over a LACP trunk interface to the VSF device. Once you configure
the IP address of a MAD assist device, the VSF switch will perform a MAD readiness check to determine:

• If the MAD assist device is reachable.

• If a trunk interface is used to reach the device.

• If the trunk interface has at least one, linked —up, physical port on each member of the VSF switch.

If the above three conditions are not met, MAD will fail to detect dual active fragments in the event of a VSF split.
This error will create a log message.

NOTE:

The MAD readiness check is repeated periodically. If MAD-probe parameters have changed, an
appropriate log message will be created.

vsf lldp-mad ipv4
Syntax
[no] vsf lldp-mad ipv4 <IPV4_ADDR> v2c <COMMUNITY-STR>
Description

Enable LLDP-MAD on the VSF device.

NOTE: The command vsf lldp mad requires a peer switch to be configured as the “assist”
device. LLDP-MAD is applicable only for a two-member VSF stack.

Parameters

<IPV4_ADDR>

The IPv4 address of the MAD (Multi-Active Detection) device.

<COMMUNITY-STR>

The SNMP community string for the MAD (Multi-Active Detection) device.

Usage
Switch(config)# vsf lldp-mad ipv4
Switch(config)# vsf lldp-mad ipv4 <IPv4_ADDR>
Switch(config)# vsf lldp-mad ipv4 <MAD-IP-ADDRESS> v2c
Switch(config)# vsf lldp-mad ipv4 210.10.0.12 v2c <COMMUNITY-STR>
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Validation rules

Validation Error/Warning/Prompt

This command cannot be executed if VSF is not
enabled.

VSF is not enabled.

Cannot configure VSF LLDP MAD IP address
because the specified IP address is a multicast IP
address.

Cannot configure VSF LLDP MAD IP address
because the specified IP address is a link-local IP
address.

Cannot configure VSF LLDP MAD IP address
because the specified IP addressis configured on
the loopback interface.

Cannot configure VSF LLDP MAD IP address
because the specified IP address is configured on
a local interface.

The MAD assist device and the VSF device must
be on a common IP subnet for LLDP-MAD to
work.

The MAD (Multi-Active Detection) device and the
VSF device are not on the same network.

show vsf lldp-mad
Syntax
show vsf lldp-mad [parameters | status]
Description

Show the VSF LLDP-MAD information on the switch.

Parameters

parameters

Displays the MAD-assist configuration as well as the readiness state.

status

Displays the current state of the MAD probe.

Usage
show vsf lldp-mad parameters
show vsf lldp-mad status

show vsf lldp-mad parameters

Switch# show vsf lldp-mad parameters
    MAD device IP          : 210.10.0.12         
    MAD readiness status   : Success
    MAD device MAC         : 5065f3-128cc5
    Reachable via Vlan     : 916  
    Local LAG interface    : Trk10 
    MAD-probe portset      : 1/A21,2/A21,
    LAG connectivity       : Full
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show vsf lldp-mad status

Switch# show vsf lldp-mad status

    MAD device IP                         : 210.10.0.12         
    MAD-probe portset                     : 1/A21,2/A21,  
    VSF split                             : No 
    MAD probe originator                  : No 
    Number of probe requests sent         : 0         
    Number of probe responses received    : 0         
    MAD Active Fragment                   : Yes

VSF re-join after a split
If split fragment(s) re-join the VSF and become a single device, MAD readiness checks will be re-run and a fresh
set of readiness parameters determined.

NOTE: One of the devices will reboot to join the VSF.

Mad assist device requirements

Limitations of MAD
VSF restrictions
• VSF is mutually exclusive with distributed trunking, mesh, and Q-in-Q.

• VSF port restrictions:
◦ Must be 10Gbps/40Gbps. 1Gbps links are not supported.

◦ A VSF link can only comprise ports with the same speed; either all 10G or all 40G

◦ Maximum 8 ports in 1 VSF link.

◦ VSF ports must be directly connected and there should be no transit devices between members.

• In a VSF virtual chassis, flow-control is not supported between ports on different chassis across VSF links.

Updates for a VSF virtual chassis
To update the firmware on a VSF virtual chassis, copy the new firmware to the VSF virtual chassis and reboot the
VSF virtual chassis with the boot system flash <primary | secondary> command.

VSF Fast Software Upgrade
Fast Software Upgrade (FSU) is a feature in VSF stacking which enables users to upgrade switch software with
minimal down-time of links by rebooting the standby to boot with the upgraded image while the current
commander and its IMs are still intact and forwarding traffic. The traditional software upgrade of a VSF stack
consists of:

• Copying the switch software image through a CLI command on to the switch primary or secondary bank.

• Rebooting the entire stack for all members to boot with the newly upgraded SW image.

The down-time of links is longer because when the whole stack reboots, all IMs, on all members, are down during
the time of reboot and stack formation.

688 Aruba 3810 / 5400R Management and Configuration Guide for
ArubaOS-Switch 16.08

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4426



NOTE: FSU is supported only on two member VSF stacks based on 5400R devices.

Upgrading the VSF stack software
Upgrading the software on a VSF stack consists of two basic steps:

Procedure

1. Copy the new software image into primary or secondary bank in flash.

2. Reboot the stack with new image. See vsf sequenced-reboot on page 689

FSU differs from the normal software upgrade in the second step where only the standby of the VSF stack boots,
using the upgraded image. The current commander is intact, thus ensuring that the IMs and their ports on
commander switch are still available for traffic.

Following is the sequence used by FSU:

1. The user downloads new firmware into the primary or secondary bank and issues the CLI command to perform
FSU.

2. The standby switch reboots to the new firmware and boots up as a commander switch.

3. The old commander switch reboots to the new firmware when the VSF link is brought up and joins the other
switch as a new standby.

4. Traffic starts passing through the new commander as it comes up. However, the switchover is not stateful. L2
traffic is guaranteed to be within the timeline of 3 secs but not L3.

vsf sequenced-reboot
Syntax
vsf sequenced-reboot {primary|secondary}
Description

Initiates a reboot of the VSF virtual chassis. First the standby reboots and becomes the commander. Then, the
existing commander reboots and becomes the standby.

Example output

Switch# vsf

sequenced-reboot      Initiate a reboot of the VSF virtual chassis.

Switch# vsf sequenced-reboot
primary Reboot from the primary flash image.
secondary Reboot from the secondary flash image.

Chapter 19 Virtual Switching Framework (VSF) 689

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4427



Validation rules for VSF sequenced reboot

Validation Error/Warning/Prompt

Sequenced reboot is not allowed if the update version
is KB.16.02 or lower.

Sequenced reboot is supported only if the updated
software version is KB.16.03 or higher.

When software update is in progress, configuration
commands will be blocked.

Software update is in progress; configuration
commands are not allowed.

If the software image sync to standby is in progress
and if sequenced-reboot command is executed, the
command will fail with an error message.

Software image synchronization to the VSF standby is
in progress; try to execute the command later.

690 Aruba 3810 / 5400R Management and Configuration Guide for
ArubaOS-Switch 16.08

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4428



Overview
To simplify the deployment of mobility and IoT devices, Aruba switches have a mechanism to automatically detect
devices based on their LLDP signatures and apply configuration to the port to which they are connected. This
reduces the time needed to add, move, or change devices on the network and also eliminates potential
misconfigurations on the port.

Device Profiles allow an administrator to create configuration containers for different classes of devices and
associate them with certain device types. The configuration containers are stored as part of the config, but do not
come into effect until a device with the right LLDP signature is connected to a port on that switch. Device profiles
allow network administrators to apply port settings automatically, eliminating configuration mistakes as well as
reducing the time taken to connect wired devices.

Organization-specific TLVs and subtypes that come as part of LLDP messages are used to detect and apply
profiles to devices. A maximum of 16 devices can be detected and defined using Device Profiles. The following
sections talk about the operational steps that need to be followed to add Mobility and IoT devices as well as
features such as Rogue AP detection that can be used for mobile-first deployments with Aruba APs.

Auto configuring Aruba APs
The auto device detection and configuration detects a directly connected Aruba AP dynamically and applies
predefined configurations to ports on which the Aruba AP is detected.

You can create port configuration profiles, associate them to a device type, and enable or disable a device type.
One of the device types supported is aruba-ap and it is used to identify all the Aruba APs.

When a configured device type is connected on a port, the system automatically applies the corresponding port
profile. Connected devices are identified using LLDP. When the LLDP information on the port ages out, the device
profile is removed.

By default, the device profile feature is disabled. When you enable the device profile support for a device type, if
no other device profile is mapped to the device type, the default device profile default-ap-profile is
associated with the device type. You can modify the AP default device profile configuration but you cannot delete
it. The default-ap-profile command supports only the AP device type.

NOTE: Only APs which are connected directly will be detected.

Associating a device with a profile
To associate an Aruba access point (AP) device-type to a user-defined profile, use the context Switch(device-
aruba-ap)#. All Aruba access points use the identifier aruba-ap.

The [no] form of the command removes the device type association and disables the feature for the device type.

The feature is disabled by default.

device-profile name
Syntax

[no] device-profile name <PROFILE-NAME> [untagged-vlan <VLAN-ID> |
                           tagged-vlan <VLAN-LIST> | cos <COS-VALUE> |
                           ingress-bandwidth <Percentage> |
                           egress-bandwidth <Percentage> |
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                           {poe-priority {critical | high | low} |
                           speed-duplex {auto |auto-10 | auto-100 | ...} |
                           poe-max-power <Watts> |
                           allow-jumbo-frames | allow-tunneled-node]
Description

This command is used to create a user-defined profile. A profile is a named collection of port settings applied as a
group. You can modify the default profile, default-ap-profile, but you cannot delete it. You can create four
additional profiles.

The default-ap-profile has the following values:

• untagged-vlan: 1

• tagged-vlan: None

• ingress-bandwidth: 100

• egress-bandwidth: 100

• cos: 0

• speed-duplex: auto

• poe-max-power: class/LLDP

• poe-priority: critical

You can modify these parameters. For example, you can execute no untagged-vlan to create a device profile
with tagged only ports.

Parameters
name
Specifies the name of the profile to be configured. The profile names can be at most 32 characters long.

cos
The Class of Service (CoS) priority for traffic from the device.

untagged-vlan
The port is an untagged member of specified VLAN.

tagged-vlan
The port is a tagged member of the specified VLANs.

allow-tunneled node
Configuration to allow Tunneled Node when device profile is applied on port.

ingress-bandwidth
The ingress maximum bandwidth for the device port.

egress-bandwidth
The egress maximum bandwidth for the device port.

poe-priority
The PoE priority for the device port.

speed-duplex
The speed and duplex for the device port.
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poe-max-power
The maximum PoE power for the device port. The value is set based on PD Class detection and/or LLDP
negotiation. poe-max-power will have class appropriate value depending on the class of your AP. (Example:
class4 = 25.5W, class 3=13W, class2=6.49W, class1=3.84W, class0=13W)

Options
no
Removes the user-defined profiles.

Restrictions

• You can modify the configuration parameters of the default profile, default-ap-profile, but you cannot
delete it or change its name.

• The profile configuration is only applicable to access points.

device-profile type
From within the configure context:

Syntax

device-profile type <DEVICE> [associate <PROFILE-NAME> | enable | disable ]
Description

This command specifies an approved device type in order to configure and attach a profile to it. The profile’s
configuration is applied to any port where a device of this type is connected.

Approved device types

aruba-ap

Aruba access point device.

arubaos-switch

ArubaOS switch

Options

From within the device-aruba-ap context

associate <PROFILE-NAME>

Associated the specified device type by profile name.

enable

Enables the automatic profile association.

disable

Disables the automatic profile association.

Usage
[no] device-profile type <DEVICE> [associate <PROFILE-NAME> |enable | disable]
    

NOTE: The device types supported are aruba-ap and arubaos-switch.
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device-profile type device-name

Syntax
device-profile type [aruba-ap | aruba-switch | scs-wan-cpe | 
device-name <DEVICE-NAME> associate <PROFILE-NAME> | enable | disable]

no device-profile type [aruba-ap | aruba-switch | scs-wan-cpe | 
device-name <DEVICE-NAME> associate <PROFILE-NAME> | enable | disable]

Description

Associates the device profile with the type of device by identity.

The no form of this command removes the device profile from the device type.

Command context
config

Parameters
associate <PROFILE-NAME>

Selects the profile name associated with the device-type.

enable
Selects the profile of the device being enabled.

disable
Selects the profile of the device being disabled.

Usage

• The command device-profile type aruba-ap enable enables profile for Aruba-AP.

• Device Name is defined the same as Device Identity.

show device-profile
Syntax

Within the configure context:

show device-profile
Description

Show device profile configuration and status.

config

Show the device profile configuration details for a single, or all, profiles.

status

Show currently applied device profiles.

Usage
show device-profile config <PROFILE-NAME>
    
show device-profile status
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show device-profile config

Switch# Show device-profile config
Device Profile Configuration

  Configuration for device-profile : default-ap-profile
  untagged-vlan      : 1
  tagged-vlan        : None
  ingress-bandwidth  : 100%
  egress-bandwidth   : 100%
  cos                : None
  speed-duplex       : auto
  poe-max-power      : Class/LLDP
  poe-priority       : critical
  allow-jumbo-frames : Disabled
  allow-tunneled-node: Enabled
  

show device-profile config profile1

Switch(device-profile)# show device-p config test

 Device Profile Configuration

 Configuration for device-profile : profile1
  untagged-vlan      : 1
  tagged-vlan        : None
  ingress-bandwidth  : 100%
  egress-bandwidth   : 100%
  cos                : None
  speed-duplex       : auto
  poe-max-power      : Class/LLDP
  poe-priority       : critical
  allow-jumbo-frames : Disabled
  allow-tunneled-node: Enabled

show command device-profile status
Syntax
show device-profile [config | status]
Description

Displays the device-profile configuration or device-profile status.

Options

config

Show device profile configuration details for a single profile or all profiles.

status

Show currently applied device profiles status.

show device-profile status

Switch# show device-profile status
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 Device Profile Status
  Port          Device Type      Applied Device Profile
  ----          -----------      ----------------------
  5             aruba-ap         profile1
  10            aruba-ap         profile1

show device-profile config

Syntax
show device-profile config

Description

Shows the device profile configuration.

Command context
config

Examples

Use the command show device-profile config to display the device profile configuration.

switch(config)# show device-profile config

 Device Profile Configuration

 Configuration for device-profile : default-ap-profile
  untagged-vlan      : 1
  tagged-vlan        : None
  ingress-bandwidth  : 100%
  egress-bandwidth   : 100%
  cos                : None
  speed-duplex       : auto
  poe-max-power      : Class/LLDP
  poe-priority       : critical
  allow-jumbo-frames : Disabled
  allow-tunneled-node: Enabled

 Configuration for device-profile : test
  untagged-vlan      : 1
  tagged-vlan        : None
  ingress-bandwidth  : 100%
  egress-bandwidth   : 100%
  cos                : None
  speed-duplex       : auto
  poe-max-power      : Class/LLDP
  poe-priority       : critical
  allow-jumbo-frames : Disabled
  allow-tunneled-node: Enabled
  

 Configuration for device-profile : default-aos-profile
  untagged-vlan      : 1
  tagged-vlan        : None
  ingress-bandwidth  : 100%
  egress-bandwidth   : 100%
  cos                : None
  speed-duplex       : auto
  poe-max-power      : Class/LLDP
  poe-priority       : critical
  allow-jumbo-frames : Disabled
  allow-tunneled-node: Enabled
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 Configuration for device-profile : default-scs-profile
  untagged-vlan      : 1
  tagged-vlan        : None
  ingress-bandwidth  : 100%
  egress-bandwidth   : 100%
  cos                : None
  speed-duplex       : auto
  poe-max-power      : Class/LLDP
  poe-priority       : critical
  allow-jumbo-frames : Disabled
  allow-tunneled-node: Enabled
 

 Configuration for device-profile : default-device-profile
  untagged-vlan      : 1
  tagged-vlan        : None
  ingress-bandwidth  : 100%
  egress-bandwidth   : 100%
  cos                : None
  speed-duplex       : auto
  poe-max-power      : Class/LLDP
  poe-priority       : critical
  allow-jumbo-frames : Disabled
  allow-tunneled-node: Enabled

 Device Profile Association

  Device Type   : aruba-ap
  Profile Name  : default-ap-profile
  Device Status : Disabled

  Device Type   : aruba-switch
  Profile Name  : default-aos-profile
  Device Status : Disabled

  Device Type   : scs-wan-cpe
  Profile Name  : default-scs-profile
  Device Status : Disabled

show device-profile status

Syntax
show device-profile status

Description

Shows the profile status of the device.

Command context
config

Example

Use the show decive-profile status command to view status.

switch(confg)# show device-profile status
Port     Device-type          Applied device profile
 -------- -------------------- ----------------------
 A1         <device-name>           abc
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Default AP Profile
Creates a user-defined profile.

The profile name is a valid character string with the maximum permissible length of 32. The default profile is
named default-ap-profile and cannot be modified.

The default configuration parameters may be modified using the command device-<PROFILE NAME>
default-ap-profile . Up to four different profiles may be configured.

The [no] command removes the user-defined profiles.

allow-jumbo-frames
Syntax
allow-jumbo-frames
Description

Configure jumbo frame support for the device port. Jumbo frames are not enabled by default.

Validation rules

Validation Error/Warning/Prompt

Invalid jumbo command. Invalid input.

If jumbo frame support is configured on a VLAN for
which the device profile had overridden the
configuration, display the existing warning.

This configuration change will be delayed because a
device profile that enables jumbo frame support is
applied to a port in this VLAN.

Auto configuring IoT Devices
Wired IoT devices can also be automatically configured using device profiles. Since the market for IoT devices is
vast, with several hundred manufacturers and thousands of devices, instead of hardcoding the LLDP signatures,
Aruba switches provide a way for an administrator to create a device type for the IoT devices in their deployment.
By associating the custom device type that they create with a device profile, users can leverage the power profiles
not only for Aruba devices but also for other manufacturers. The requirement for automatic detection of IoT
devices is that they should support LLDP.

Creating a device identity and associating a device type

Procedure

1. Create a device identity using the command:

switch# device-identity name <DEVICE-NAME>
          

2. Specify the OUI used in LLDP's organization using specific TLV, (type =127). OUI should be in XXXXXX
format. The default OUI "000000" indicates that device-identity will not use LLDP to identify device:

switch(config)# device-identity name <DEVICE-NAME> lldp oui <MAC_OUI>
 sub-type <SUBTYPE>

To add new device on switch:

switch(config)# device-identity name abc lldp oui a1b2c3 sub 2
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To remove device from switch:

switch(config)# no device-identity name abc
3. Show device identity configuration:

switch(config)# show device-identity lldp

Device Identity Configuration

 Index  Device name            Oui        Subtype
 ------ ---------------------- ---------- -------
 1      abc                    a1b2c3     2     

NOTE: The maximum devices that can be configured using device-identity are 16. The
maximum devices that can be associated using device-profile are 19. The maximum profiles
that can be created using device-profile are 17.

show device-identity
Syntax
show device-identity

Description

Specify name of the device to be discovered.

Command context
config

Usage
device-identity name <device_name> lldp oui <mac_oui> subtype <subtype>
no device-identity name <device_name> lldp oui <mac_oui> subtype <subtype>

Example

device-identity name avayaPhone lldp oui 00096e sub-type 1

switch(device-profile)# show device-identity

 Device Identity Configuration

 Index  Device name            Protocol
 ------ ---------------------- --------------
 1      avayaPhone             LLDP

switch(device-profile)# show device-identity  lldp

 Device Identity Configuration

 Index  Device name            Oui        Subtype
 ------ ---------------------- ---------- -------
 1      avayaPhone             00096e     1
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device-profile type-device associate
From within the configure context:

Syntax

device-profile type-device <DEVICE_NAME> [associate <PROFILE-NAME> | enable | disable ]
Description

Specify device name defined in device-identity in order to configure and attach a profile to it. Device identity uses
discovery protocol like LLDP to identify device. LLDP makes use of OUI and sub type of organizational specific
TLV type 127 to detect device.

Approved device types

aruba-ap

Aruba access point device.

arubaos-switch

ArubaOS switch

Options

<DEVICE_NAME>

Defines in device-identity.

associate <PROFILE-NAME>

Associated the specified device type by profile name.

enable

Enables the automatic profile association.

disable

Disables the automatic profile association.

Usage

Use the following command to configure a device:

device-identity name <DEVICE_NAME> lldp oui <OUI> subtype <SUBTYPE>.
    
Example

device-p device-type avayaPhone associate avaya

NOTE: The device types supported are aruba-ap and arubaos-switch.

show device-profile config

Syntax
show device-profile config

Description

Shows the device profile configuration.
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Command context
config

Examples

Use the command show device-profile config to display the device profile configuration.

switch(device-profile)# show device-p con avaya

 Device Profile Configuration

 Configuration for device-profile : avaya
  untagged-vlan      : 1
  tagged-vlan        : None
  ingress-bandwidth  : 100%
  egress-bandwidth   : 100%
  cos                : None
  speed-duplex       : auto
  poe-max-power      : Class/LLDP
  poe-priority       : critical
  allow-jumbo-frames : Disabled
  allow-tunneled-node: Enabled

show device-profile status
Syntax
show device-profile [config | status]
Description

Displays the device-profile configuration or device-profile status.

Options

config

Show device profile configuration details for a single profile or all profiles.

status

Show currently applied device profiles status.

show device-profile status

Switch# show device-profile status

Device Profile Status
 
              Port     Device-type          Applied device profile
              -------- -------------------- ---------------------------
              A2        avayaPhone          avaya

Support for Aruba device types
The following Aruba device types are supported:

• Aruba-AP

• ArubaOS-Switch

• Any device that can be defined using LLDP OUI and subtype in the switch
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Isolating Rogue APs
One of the important features to turn on in a mobile-first deployment is the ability of the switches to detect and
quarantine rogue access points. Administrators would like to prevent unauthorized access to their networks and a
rogue AP can open up the network to unwanted users and traffic.

The Rogue AP Isolation feature detects and blocks any unauthorized APs in the network. You can either log or
block the rogue device. If the action requested is to log the rogue device, the MAC address of the rogue device is
logged in the system logs (RMON). If the action is to block the rogue device, the traffic to and from the MAC
address of the rogue device is blocked. The MAC is also logged in the system log.

When an Aruba AP detects a rogue AP on the network, it sends out the MAC address of the AP as well as the
MAC of the clients connected to the AP to the switch using the ArubaOS-Switch proprietary LLDP TLV protocol.
The switch then adds a rule in its hardware table to block all the traffic originating from the rogue AP’s MAC
address.

The rogue-ap-isolation command configures the rogue AP isolation for the switch and gives the option to
enable or disable the rogue AP isolation feature. The rogue-ap-isolation action command gives you the
ability to block the traffic to or from the rogue device or log the MAC of the rogue device. When the action is set to
block, the rogue MAC is logged as well. By default, the action is set to block.

The rogue-ap-isolation whitelist command lets you add devices detected as possible rogue APs to the
whitelist. A maximum of 128 MAC addresses are supported for the whitelist.

The clear rogue-aps command clears the detected rogue AP device MAC address.

Using the Rogue AP Isolation feature

Procedure

1. Check the feature state:

switch# show rogue-ap-isolation

 Rogue AP Isolation

  Rogue AP Status : Disabled
  Rogue AP Action : Block

  Rogue MAC Address Neighbour MAC Address
  ----------------- ---------------------
          

2. Enable the feature:

switch# rogue-ap-isolation enable
switch# show rogue-ap-isolation

 Rogue AP Isolation

  Rogue AP Status : Enabled
  Rogue AP Action : Block

  Rogue MAC Address Neighbour MAC Address
  ----------------- ---------------------
          

3. Change the action type from block to log:

switch# rogue-ap-isolation action log
switch# show rogue-ap-isolation
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 Rogue AP Isolation

  Rogue AP Status : Enabled
  Rogue AP Action : Log

  Rogue MAC Address Neighbour MAC Address
  ----------------- ---------------------
          

4. List the current whitelist entries:

switch# show rogue-ap-isolation whitelist

Rogue AP Whitelist Configuration

 Rogue AP MAC
 ------------------
          

5. Add a new whitelist entry:

switch# rogue-ap-isolation whitelist 005056-00326a
switch# show rogue-ap-isolation whitelist

Rogue AP Whitelist Configuration

 Rogue AP MAC
 ------------------
 00:50:56:00:32:6a
          

rogue-ap-isolation
syntax

rogue-ap-isolation {enable | disable}
Description

Configures the rogue AP isolation for the switch.

Parameters
enable
Enables the rogue AP isolation.

disable
Disables the rogue AP isolation.

rogue-ap-isolation action
syntax

rogue-ap-isolation action {log | block}
Description

Configures the action to take for the rogue AP packets. This function is disabled by default.

Parameters
action
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Configure the action to take for rogue AP packets. By default, the rogue AP packets are blocked.

Options
log
Logs traffic to or from any rogue access points.

block
Blocks and logs traffic to or from any rogue access points.

rogue-ap-isolation whitelist
syntax

[no] rogue-ap-isolation whitelist <MAC-ADDRESS>
Description

Configures the rogue AP Whitelist MAC addresses for the switch. Use this command to add to the whitelist the
MAC addresses of approved access points or MAC addresses of clients connected to the rogue access points.
These approved access points will not be added to the rogue AP list even if they are reported as rogue devices.

Parameters
MAC-ADDRESS
Specifies the MAC address of the device to be moved from the rogue AP list to the whitelist.

Options
no
Removes the MAC address individually by specifying the MAC.

Restrictions

You can add a maximum of 128 MAC addresses to the whitelist.

clear rogue-ap-isolation
syntax

clear rogue-ap-isolation { <MAC-ADDRESS> | all }
Description

Removes the MAC addresses from the rogue AP list.

Parameters
MAC-ADDRESS
Specifies the MAC address of the device to be moved from the rogue AP list.

all
Clears all MAC addresses from the rogue AP list.

Restrictions

The MAC addresses cleared using this option will be added back to the rogue list under the following cases:
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1. The LLDP administrator status of the port on which the AP that reported the MAC is disabled and enabled
back.

2. The data that is in the rogue AP TLV sent from the AP that informed the rogue MAC has changed.

3. To permanently ignore a MAC from being detected as rogue, add it to the whitelist.

Feature Interactions

L3 MAC
The Rogue AP isolation feature will not block a MAC configured as an IP receive MAC address on a VLAN
interface. This event will be logged in RMON if such MACs are detected as rogue.

Conversely, any MAC already blocked by Rogue AP isolation will not be allowed to be configured as an IP receive
MAC address of a VLAN interface.

For example:

switch# vlan 1 ip-recv-mac-address 247703-3effbb 
Cannot add an entry for the MAC address 247703-3effbb because it is already
blocked by rogue-ap-isolation. 
      

Limitations

• You can add a maximum of 128 MAC addresses to the whitelist.

• When a MAC is already authorized by any of the port security features such as LMA, WMA, or 802.1X, the
MAC is logged but you cannot block it using the rogue-ap-isolation feature. A RMON event is logged to
notify the user.

• When a MAC is already configured as an IP received MAC of a VLAN interface, the MAC is logged but you
cannot block it by using the rogue-ap-isolation feature. A RMON event is logged to notify the user.

• When a MAC is already locked out via lockout-mac or locked down using the static-mac configuration,
the MAC is logged but you cannot block it using the rogue-ap-isolation feature. A RMON event is logged
to notify the user.

• The number of rogue MACs supported on a switch is a function of the value of max-vlans at boot time. Since
the resources are shared with the lockout-mac feature, the scale is dependent on how many lockout
addresses have been configured on the switch using the lockout-mac feature. The following table lists the
scale when there are no lockout addresses configured on the switch:

Max VLAN Supported MACs

0 < VLAN <= 8 200

8 < VLAN <= 16 100

16 < VLAN <= 256 64

256 < VLAN <= 1024 16

1024 < VLAN <= 2048 8

2048 < VLAN <= 4094 4
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The switch will create an RMON log entry and the rogue MAC will be ignored when the limit is reached.

NOTE: If the max-vlans value is changed to a different value, the scale of rogue MACs
supported will not change until the next reboot.

Troubleshooting

Switch does not detect the rogue AP TLVs

Symptom

The switch does not detect the rogue AP TLVs that could be sent from the neighboring device.

Cause

The LLDP administrator status of a port is moved from txOnly to tx_rx or rx_only within 120 seconds of the
previous state change to txOnly.

Action

1. Wait for 120 seconds before moving from the state txOnly to the state tx_rx or rx_only. 

2. Move the administrator status to disable and then back to tx_rx or rx_only.

Show commands
Use the following show commands to view the various configurations and status.

Command Description

show rogue-ap-isolation Shows the following information:

• The status of the feature: enabled or disabled.

• The current action type for the rogue MACs detected.

• The list of MAC addresses detected as rogue and the MAC address
of the AP that reported them.

show rogue-ap-isolation
whitelist Shows the rogue AP whitelist configuration.

Requirements
Only APs directly connected to the switch will be detected.

Limitations
• Only one device type is supported, aruba-ap, and it is used to identify all the Aruba APs.

• You can modify the configuration parameters of the default profile, default-ap-profile, but you cannot
delete it or change its name.
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• If the port was part of any protocol VLANs prior to the device profile application, those VLANs will not be
removed while applying the device profile.

• Enabling jumbo frame support in a profile affects other ports with different profiles. When a profile has jumbo
frames enabled and is applied to any port, all other ports that are members of any VLAN listed in the profile will
also have jumbo frame support.

Feature Interactions

Profile Manager and 802.1X
Profile Manager interoperates with RADIUS when it is working in the client mode. When a port is blocked due to
802.1X authentication failure, the LLDP packets cannot come in on that port. Therefore, the Aruba AP cannot be
detected and the device profile cannot be applied. When the port gets authenticated, the LLDP packets comes in,
the AP is detected, and the device profile is applied.

You must ensure that the RADIUS server will not supply additional configuration such as VLAN or CoS during the
802.1X authentication as they will conflict with the configuration applied by the Profile Manager. If the RADIUS
server supplies any such configurations to a port, the device profile will not be applied on such ports.

Profile Manager and LMA/WMA/MAC-AUTH
If either LMA, WMA, or MAC-AUTH is enabled on an interface, all the MAC addresses reaching the port must be
authenticated. If LMA, WMA, or MAC-AUTH is configured on an interface, the user can have more granular
control and does not need the device profile configuration. Therefore, the device profile will not be applied on
such interface.

Profile manager and Private VLANs
When the device profile is applied, a check is performed to verify if the VLAN addition violates any PVLAN
requirements. The following PVLAN related checks are done before applying the VLANs configured in the device
profile to an interface:

• A port can be a member of only one VLAN from a given PVLAN instance.

• A promiscuous port cannot be a member of a secondary VLAN.

MAC lockout and lockdown
The Rogue AP isolation feature uses the MAC lockout feature to block MACs in hardware. Therefore, any MAC
blocked with the Rogue AP isolation feature cannot be added with the lockout-mac or static-mac command
if the action type is set to block. 

For example:

switch# lockout-mac 247703-7a8950 
Cannot add the entry for the MAC address 247703-7a8950 because it is already 
blocked by rogue-ap-isolation. 
      

switch# static-mac 247703-7a8950 vlan 1 interface 1 
Cannot add the entry for the MAC address 247703-7a8950 because it is already 
blocked by rogue-ap-isolation. 
      
Similarly, any MAC that was added with the lockout-mac or static-mac command and that is being detected
as rogue will be logged, but not blocked in hardware as it already is set to block. If the MAC is removed from
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lockout-mac or static-mac but is still in the rogue device list, it will be blocked back in hardware if the action
type is block.

LMA/WMA/802.1X/Port-Security
Any configuration using LMA, WMA, 802.1X, or Port-Security will not be blocked if the Rogue AP isolation feature
is enabled. All these features act only when a packet with the said MAC is received on a port.

If rogue-ap-isolation blocks a MAC before it is configured to be authorized, packets from such MACs will be
dropped until one of the following happens:

• Rogue action is changed to LOG.

• Rogue-AP isolation feature is disabled.

• The MAC is not detected as rogue anymore.

• LLDP is disabled on the port (or globally).

Once a MAC has been authorized by one of these features, it will not be blocked by Rogue AP isolation. A RMON
will be logged to indicate the failure to block.

The Rogue AP module will retry to block any such MACs periodically. In the event of the MAC no longer being
authorized, Rogue AP isolation will block the MAC again. No RMON is logged to indicate this event. 

Troubleshooting
Dynamic configuration not displayed when using “show running-config”

Symptom

The show running-config command does not display the dynamic configuration applied through the device
profile.

Cause

The show running-config command shows only the permanent user configuration and parameters
configured through device profile.

Action

Use the specific show device-profile command to display the parameters dynamically configured through
the device profile.

The show run command displays non-numerical value for untagged-vlan

Symptom

The show run command displays one of the following values for untagged-vlan:

• no untagged-vlan
• untagged-vlan : None

Cause

The no device-profile or the no rogue-ap-isolation whitelist command is executed to configure
untagged-vlan to 0.
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Action

No action is required.

Show commands
Use the following show commands to view the various configurations and status.

Command Description

show device-profile Shows the device profile configuration and status.

show device-profile config Shows the device profile configuration details for a
single profile or all profiles.

show device-profile status Shows currently applied device profiles.

show run Shows the running configuration.
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Overview
IP Service Level Agreement (IP SLA) is a feature that helps administrators collect information about network
performance in real time. With increasing pressure on maintaining agreed-upon Service Level Agreements on
Enterprises and ISPs alike, IP SLA serves as a useful tool.

Any IP SLA test involves a source node and a destination node. For all discussions in this document, the source
is always an ArubaOS-switch with IP SLA support. As shown in the diagram above, a destination can, in most
cases, be any IP-enabled device. For some SLA types that expect a nonstandard response to a test packet, an
“SLA responder” must be configured. An “SLA responder” is nothing but an ArubaOS-switch with IP SLA
configurations on it that enable it to respond to the test packet.

The IP SLA feature provides:

• Application-aware monitoring that simulates actual protocol packets.

• Predictable measures that aid in ease of deployment and help with assessment of existing network
performance.

• Accurate measures of delay and packet loss for time-sensitive applications.

• End-to-end measurements to represent actual user experience.

We support the following SLA types:

• UDP Echo, including connectivity testing of transport layer (UDP) services, Round-Trip-Time (RTT)
measurement, one-way delay, and packet loss details.

• ICMP Echo, including connectivity testing, RTT measurement, and packet loss details.

• TCP Connect, including connectivity testing of transport layer (TCP) services, and handshake time
measurement.

• DHCP, which measures the round-trip time taken to discover a DHCP Server and obtain a leased IP address
from it.

Chapter 21
IP Service Level Agreement
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• DNS, which measures the time taken for a DNS resolution. This measures the difference between the time
taken to send a request to the DNS server and the time the IP SLA source receives a reply.

• User Datagram Protocol (UDP) Jitter, which measures RTT, one way jitter and one way delays.

• UDP Jitter for VoIP, which measures RTT, one way jitter, one way delays, ICPIF (Impairment Calculated
Planning Impairment Factor) and MOS (Mean Opinion Score).

Limitations for IPSLA support on Aruba switches:

• IP SLA is not enabled for IPv6.

• DHCP SLA supports DHCPv4 only.

• IP SLA tests cannot be initiated over OOBM interfaces.

• History results for the configured IP SLAs will not be available after a switchover or a reboot.

• Maximum number of IP SLAs that can be configured varies based on the type of SLA test.

• When there are multiple IP SLAs configured with destination as hostname, the DNS resolution happens
serially. There can be a delay in sending the test probe (which will be sent only after successful DNS
resolution).

• For TCP Connect SLA type, the four-tuple (source IP/port, destination IP/port) must be unique.

• System clocks between the source and the responder must be synchronized with NTP if One Way Delay
parameters have to be calculated for UDP Echo tests.

• Timeout for probes is 3 seconds for all SLA types and is not configurable.

• Transient spikes in RTT occur during the tests (in the source and the responder) if processor usage is high.
Consider average result values over a period of time rather than point-in-time results. This is not applicable for
UDP Jitter nor Jitter for VoIP.

Entity Limit

Maximum number of SLAs enabled. 50

Maximum history bucket size per SLA.1 50

Number of responders that can be configured. 10

1 Not applicable for UDP Jitter and Jitter for VoIP.

The following are operational restrictions with respect to IP SLA jitter implementation:

• Feature is not supported on 2540.

• Feature is supported only on v3-based platforms (5400R, 3810, 2930F).

• No history results are stored.

• IPSLA Jitter and Jitter for VoIP initiator and responder is only supported on 5400R with v3 modules
(noncompatibility mode), 3810, and 2930F switches.

• The maximum number of Jitter responder sessions (UDP Jitter + Jitter For VoIP) supported is 10. The
maximum number of Jitter initiator sessions (UDP Jitter + Jitter For VoIP) supported is 5.

• Measurement of RTT and jitter values is in milliseconds.
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• IPv6 SLA for UDP jitter and VoIP is not supported.

• UDP jitter and UDP jitter for VoIP tests are not supported over Tunnel, Trunk, and OOBM interfaces.

• UDP jitter and UDP jitter for VoIP results are not carried forward across failover or a device reboot.

• History bucket size cannot be configured for UDP jitter and VoIP tests. Results are aggregated for the last 25
probes.

• System clocks between the source and the responder must be synchronized with NTP if One Way Delay
parameters have to be calculated for UDP Jitter & UDP Jitter for VoIP tests.

• The UDP jitter and UDP jitter for VoIP feature on ArubaOS-Switch has the following limited interoperability with
Comware 7 SLA v2 version:

◦ One Way packet drops (SD packet loss and DS packet loss) on the Comware Jitter initiator is not reported
when interoperating with Aruba Jitter Responder.

• IP SLA responder or initiator implementation is not interoperable with Cisco's IP SLA feature.

How IP SLA works
1. The source originates a test packet to the destination.

2. The destination responds to the test packet, at times embedding the needed information in the response
packet.

3. Upon receiving the response, the source calculates the test results based on the timestamp, other packet
parameters, and so on.

4. The source stores the results and updates the history records for the SLA.

5. The source reschedules the SLA for the next run.

NOTE: For one-way delay calculations, the IP SLA sender and IP SLA responder must be NTP Time
Synchronized.

Configuration commands

[no] ip-sla <ID>
Syntax
[no] ip-sla <ID>
Description

Configure the IP Service Level Agreement (SLA) parameters. The value of ID can range from 1-255.

Options

clear

Clear history records, message statistics, and threshold counters of particular SLA entry.

dhcp

Configure DHCP as the IP SLA test mechanism.

disable

Disable the IP SLA.
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dns

Configure DNS as the IP SLA test mechanism.

enable

Enable the IP SLA.

history-size

Configure the number of history records to be stored for the IP SLA.

icmp-echo

Configure ICMP echo as the IP SLA test mechanism.

monitor

Configure monitoring parameters and respective threshold-action values.

schedule

Configure the start time, stop time, lifetime, and frequency of run for the IP SLA.

tcp-connect

Configure TCP connect as the IP SLA test mechanism.

tos

Configure the Type of Service value to be set in the test packet for the IP SLA.

udp-echo

Configure UDP echo as the IP SLA test mechanism.

On platforms that support Jitter and VOIP, the following options are also provided:

udp-jitter

Configure UDP jitter as the IP SLA test mechanism.

udp-jitter-voip

Configure UDP jitter for VoIP as the IP SLA test mechanism.

ip-sla <ID> clear
Syntax
ip-sla <ID> clear
Description

Clear history records, message statistics, and threshold counters of a particular SLA entry.

Options

records

Clear history records, message statistics, and threshold counters of particular SLA entry.

[no] ip-sla <ID> history-size
Syntax
[no] ip-sla <ID> history-size
Description
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Configure the number of history records to be stored for the IP SLA. The maximum supported size is 50 and the
default value for history-size is 25.

[no] ip-sla <ID> icmp-echo
Syntax
[no] ip-sla <ID> icmp-echo [<IP-ADDR> | <HOST-NAME>] [source <IP-ADDR> 
| source-interface vlan <VLAN-ID>] [payload-size <SIZE>]
Description

Configure ICMP echo as the IP SLA test mechanism. Requires destination address/hostname and source
address/vlan id for the IP SLA of ICMP-Echo SLA type.

payload-size

: Value can range from 1-1440. By default, payload-size is not set.

[no] ip-sla <ID> udp-echo
Syntax
[no] ip-sla <ID> udp-echo [destination [<IP-ADDR> | <HOST-NAME>] 
<PORT-NUM>] [source <IP-ADDR> | <VLAN-ID>] [payload-size <SIZE>]
Description

Configure UDP echo as the IP SLA test mechanism. Requires destination address/hostname and source address/
VLAN ID for the IP SLA of UDP-Echo SLA type.

• PORT-NUM: Value can range from 1024–65535.

• payload-size: Value can range from 1-1440. By default, payload-size is not set.

[no] ip-sla <ID> tcp-connect
Syntax
[no] ip-sla <ID> tcp-connect [destination [<IP-ADDR> | <HOST-NAME>] 
<PORT-NUM>] [source [<IP-ADDR> | <VLAN-ID>] <PORT-NUM>]
Description

Configure TCP connect as the IP SLA test mechanism. Requires destination address/hostname and source
address/VLAN ID for the IP SLA of TCP connect SLA type. The value of PORT-NUM can range from 1024-65535.

[no] ip-sla <ID> monitor threshold-config
Syntax
[no] ip-sla <ID> monitor threshold-config [rtt | srcTodstTime | dstToSrcTime] 
threshold-type [immediate | consecutive <COUNT>] threshold-value <UPPER-LIMIT> 
<LOWER-LIMIT> action-type [trap | log | trap-log | none]
Description

Set upper and lower threshold parameters.
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• threshold-type immediate: Take action immediately when the monitored parameters cross the threshold
upper limit (subsequent notifications for upper thresholds are not generated until the parameter values go
lower than the configured lower threshold value).

• threshold-type consecutive: Take action after threshold is hit consecutively for number of times.

• action-type: Describes action to be taken when the upper threshold is crossed.

• trap: Send snmp-trap when configured threshold is hit.

• log: Only log the event when configured threshold is hit.

• trap-log: Send snmp-trap and log the event when configured threshold is hit.

• none: Take no action.

NOTE: The command option threshold-config can be individually set for rtt, srcTodstTime, and
dstToSrcTime.

[no] ip-sla <ID> monitor packet-loss
Syntax
[no] ip-sla <ID> monitor packet-loss threshold-type [immediate | consecutive 
<COUNT>] action-type [trap | log | trap-log | none]
Description

Configure threshold-action values when packet loss happens.

• threshold-type immediate: Take action immediately when the monitored parameters cross the threshold
upper limit (subsequent notifications for upper thresholds are not generated until the parameter values go
lower than the configured lower threshold value).

• threshold-type consecutive: Take action after threshold is hit consecutively for number of times.

• action-type: Describes action to be taken when the upper threshold is crossed.

• trap: Send snmp-trap when configured threshold is hit.

• log: Only log the event when configured threshold is hit.

• trap-log: Send snmp-trap and log the event when configured threshold is hit.

• none: Take no action.

[no] ip-sla <ID> monitor test-completion
Syntax
[no] ip-sla <ID> monitor test-completion action-type [trap | log | trap-log | none]
Description

Configure action to be taken when test gets completed.

• trap: Send snmp-trap when configured threshold is hit.

• log: Only log the event when configured threshold is hit.

• trap-log: Send snmp-trap and log the event when configured threshold is hit.

• none: Take no action.
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[no] ip-sla <ID> schedule
Syntax
[no] ip-sla <ID> schedule [[now | startTime <START-TIME>] [forever | stopTime <STOP-TIME> 
| repetitions <NUM>] [frequency <FREQUENCY>
Description

Configure the start time, stop time, lifetime, and frequency of run for the IP SLA. The default value for the
frequency of operation is 60 seconds.

[no] ip-sla <ID> tos
Syntax
[no] ip-sla <ID> tos <VALUE>
Description

Configure the Type of Service value to be set in the test packet for the IP SLA.

Valid values: 0–255

[no] ip-sla responder
Syntax
[no] ip-sla responder
Description

Configure SLA responder to respond to probe packets.

• IP address: local interface IP address

• port: takes L4 port numbers.

• SLA types supported: udp-echo, tcp-connect, UDP Jitter & Jitter For VoIP.

[no] ip-sla <ID> udp-jitter
Syntax
[no] ip-sla <ID> udp-jitter destination [<IP-ADDR> | <HOST-NAME>] <PORT-NUM> 
source [<IP-ADDR> | <VLAN-ID>] [payload-size <SIZE> num-of-packets <NUM> packet-
interval <PKT-INTERVAL>]
Description

Configures the UDP Jitter test.

• Payload-size: Payload size of the test packet. Value can range from 68-8100. Default value is 68.

• Num-of-packets: Number of packets sent in one probe. Default is 10. Allowed range: 10-1000.

• Packet-interval: Inter packet gap in milliseconds.Time between consecutive packets within a probe. Default is
20ms. Allowed range: 10-60000
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[no] ip-sla <ID> udp-jitter-voip
Syntax
[no] ip-sla <ID> udp-jitter-voip destination [<IP-ADDR> | <HOST-NAME>] <PORT-NUM> 
source [<IP-ADDR> | <VLAN-ID>] [codec-type <CODEC-TYPE> advantage-factor <ADV-
FACTOR>]
Description

Configures the UDP Jitter for VoIP test.

• Codec-type: Codec to be used to encode the test VoIP packets. Available codecs: g711a, g711u, g729a.
Default is g711a.

• Advantage-factor: Advantage factor to be configured for the test. Default is 0. Allowed range: 0-20.

Show commands

show ip-sla <ID>
Syntax
show ip-sla <ID>
Description

Show IP SLA configurations.

Options

history

Show the IP SLA results history.

message-statistics

Show the IP SLA message statistics.

results

Show the IP SLA results for UDP Jitter and UDP Jitter VoIP.

aggregated-results

Show the IP SLA aggregated results for UDP Jitter and UDP Jitter VOIP.

show ip-sla <ID>

SLA ID: 1
Status: [Enabled | Admin-disabled | Scheduled | Expired | Running]

SLA Type: [ICMP-echo | tcp-connect | UDP-echo | DHCP | DNS | udp-jitter | voip]

Destination Hostname: www.arubanetworks.com
Destination Address : 20.0.0.2
Source Address      : 20.0.0.1
History Bucket Size : 5
TOS: 32
Schedule:
      Frequency (seconds)       : 60
      Life                      : [Forever | 144 seconds]
      Start Time                : Tue Oct 27 22:12:16 2015
      Next Scheduled Run Time   : Tue Oct 27 22:43:16 2015
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Threshold-Monitor is    : Enabled
      Threshold Config: RTT
      Threshold Type  : immediate
      Upper Threshold : 500 ms
     Lower Threshold : 100 ms
     Action Type     : Trap and Log

     Threshold Config: packet-loss
     Threshold Type  : consecutive (5)
     Action Type     : Trap

     Threshold Config: test-completion
     Action Type: None

show ip-sla <ID> history
Syntax
show ip-sla <ID> history
Description

Show the IP SLA results history.

show ip-sla <ID> history

SLA ID : 1

SLA Type : UDP-Echo

Minimum RTT (ms)        : 1
Maximum RTT (ms)        : 4294967282
Average RTT (ms)        : 3
Total RTT (ms)          : 315
RTT2 (sum of RTT squared): 63681

Start Time               Status  RTT      Description
------------------------ -------- ----      ------------
Mon Jan 1 00:51:28 1990 Failed  -        DMA tail drop detected.
Mon Jan 1 00:51:30 1990 Failed  -        SLA disabled before probe response arrived.

show ip-sla <ID> message-statistics
Syntax
show ip-sla <ID> message-statistics
Description

Show the IP SLA message statistics.

show ip-sla <ID> message-statistics

SLA ID : 1 
Status : Running 
SLA Type : UDP-Echo 
Destination Address : 10.0.0.2
Source Address : 10.0.0.1 
Destination Port : 2000 
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History Bucket Size : 25 
Payload Size : 500 
TOS : 0 
Messages: 
Destination Address Unreachable : 0 
Probes Skipped Awaiting DNS Resolution : 0
DNS Resolution Failed : 0 
No Route to Target : 0 
Internal Error : 0 
Local Interface is Down : 0 
No Response from Target : 0 
Successful Probes Sent : 3 
Probe Response received : 3 
Possibly Tail Dropped : 0 

show ip-sla <ID> results
Syntax
show ip-sla <ID> results
Description

Shows the results for the last IPSLA UDP Jitter or UDP Jitter for VoIP test. Note this command is not valid for any
other SLA type.

Switch (config)# sh ip-sla 1 results

Test Results for SLA ID: 1
Probe Id               : 10
SLA Type               : UDP-Jitter
Destination IP Address     : 10.2.2.2  
Destination Port     : 4444
    Source IP Address     : 10.2.2.2  
    Source Port         : 5555

Number of Packets Sent             : 10
Number of Packets Received         : 10
Minimum Round Trip Time            : 15
Maximum Round Trip Time            : 32
Average Round Trip Time            : 17
Square-Sum of Round Trip Time      : 3235
Last Succeeded Probe Time          : 2008-05-29 13:56:17.6

Extended Results:
  Packet Loss in Test        : 0%

UDP-Jitter Results:
   RTT Number             : 10
   Min Positive SD        : 4        Min Positive DS        : 1
   Max Positive SD        : 21       Max Positive DS        : 28
   Positive SD Number     : 5        Positive DS Number        : 4
   Positive SD Sum        : 52       Positive DS Sum        : 38
   Positive SD Average    : 10       Positive DS Average    : 10
   Positive SD Square Sum : 754      Positive DS Square Sum    : 460
   Min Negative SD        : 1        Min Negative DS        : 6
   Max Negative SD        : 13       Max Negative DS        : 22
   Negative SD Number     : 4        Negative DS Number        : 5
   Negative SD Sum        : 38       Negative DS Sum        : 52
   Negative SD Average    : 10       Negative DS Average    : 10
   Negative SD Square Sum : 460      Negative DS Square Sum    : 754
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One-way Results:
   Max SD Delay           : 15       Max DS Delay        : 16
   Min SD Delay           : 7        Min DS Delay        : 7
   Number of SD Delays    : 10       Number of DS Delay    s    : 10
   Sum of SD Delays       : 78       Sum of DS Delays        : 85
   Square Sum of SD Delays: 666      Square Sum of DS Delays    : 787

     
   For UDP Jitter for VoIP SLA, the following parameters are additionally shown:

Voice Scores:
   ICPIF                                                            : 4        
MOS                                                : 4.38

show ip-sla <ID> aggregated-results
Syntax
show ip-sla <ID> aggregated-results
Description

Shows the aggregated results for the last 25 probes conducted for an IPSLA UDP Jitter or UDP Jitter For VoIP
SLA test. Note this command is not valid for any other SLA type.

Switch (config)# show ip-sla 1 aggregated-results

Test results for SLA ID: 1
SLA Type               : UDP-Jitter
Destination IP Address : 10.2.2.2  
Destination Port                         : 4444
Source IP Address      : 10.2.2.2  
Source Port                                             : 5555
First Probe Start Time    : 2008-05-29 13:56:17.6

Number of Packets Sent             : 10
Number of Packets Received         : 10
Minimum Round Trip Time            : 15
Maximum Round Trip Time            : 32
Average Round Trip Time            : 17
Square-Sum of Round Trip Time      : 3235

Aggregated Results for the Last 25 Probes

Extended Results:
  Packet Loss in Test        : 0%
  Probe Failure Reason       : 

UDP-Jitter Results:
   RTT Number             : 10
   Min Positive SD        : 4        Min Positive DS        : 1
   Max Positive SD        : 21       Max Positive DS        : 28
   Positive SD Number     : 5        Positive DS Number        : 4
   Positive SD Sum        : 52       Positive DS Sum        : 38
   Positive SD Average    : 10       Positive DS Average    : 10
   Positive SD Square Sum : 754      Positive DS Square Sum    : 460
   Min Negative SD        : 1        Min Negative DS        : 6
   Max Negative SD        : 13       Max Negative DS        : 22
   Negative SD Number     : 4        Negative DS Number        : 5
   Negative SD Sum        : 38       Negative DS Sum        : 52
   Negative SD Average    : 10       Negative DS Average    : 10
   Negative SD Square Sum : 460      Negative DS Square Sum    : 754
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One-way Results:
   Max SD Delay           : 15       Max DS Delay        : 16
   Min SD Delay           : 7        Min DS Delay        : 7
   Number of SD Delays    : 10       Number of DS Delay    s    : 10
   Sum of SD Delays       : 78       Sum of DS Delays        : 85
   Square Sum of SD Delays: 666      Square Sum of DS Delays    : 787

      For UDP Jitter for VoIP SLA, the following parameters are additionally shown:

Voice Scores:
   Max MOS Value        : 4.38     Min MOS Value                : 4.38
   Max ICPIF Value      : 0        Min ICPIF Value        : 0

show ip-sla responder
Syntax
show ip-sla responder
Description

Show the IP SLA responder details.

show ip-sla responder

SLA type         : UDP-echo
Listening Address: 1.1.1.1
Listening Port   : 5555

show ip-sla responder statistics
Syntax
show ip-sla responder statistics
Description

Show the IP SLA responder statistics details.

Options

udp-jitter

Show the IP SLA responder statistics for UDP Jitter SLA type.

udp-jitter-voip

Show the IP SLA responder statistics for UDP Jitter VoIP SLA type.

show ip-sla responder statistics

IP SLA Responder  : Active
Number of packets received       : 31
Number of error packets received : 0
Number of packets sent           : 0 

Recent Sources :  
 10.12.80.100 [07:23:49.085 UTC Sun Oct 25 2015] UDP 
 10.12.80.100 [07:22:49.003 UTC Sun Oct 25 2015] TCP
 10.12.80.100 [07:20:48.717 UTC Sun Oct 25 2015] TCP
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 10.12.80.100 [07:18:48.787 UTC Sun Oct 25 2015] TCP
 10.12.80.100 [07:17:48.871 UTC Sun Oct 25 2015] TCP

show tech ip-sla
Syntax
show tech ip-sla
Description

Display output of a predefined command sequence used by technical support.

show tech ip-sla

switch# sh tech ip-sla

ipslaShowTech

 ======== IP SLA show tech BEGIN ============ 

 GLOBALS: 
 Hash Handle:                      1e7bab20
 Struct Mem Handle for hash:       1e7ba2a8
 Struct Mem Handle for SLA ID LL:  1e7c9430
 Struct Mem Handle for FD List:    1e7bd690
 FastLog Handle:                   dfabf5c
 IPSLACtrl task ID:                1068091456
 IPSLA Sender ID:                  1068092544
 IPSLA Listener ID:                1068091840
 Number of enabled SLA's:          1
 SLA ID List Handle:               1ec1ffd4
 FD ID List Handle:                0
 Ring Full Counter:                0

 Details for SLA ID: 1

SLA ID: 1
Status: Running

SLA mechanism: ICMP-Echo

Destination address: 192.168.1.2
Source address: 192.168.1.1
History bucket size: 25
Payload size: 0
TOS: 0
Schedule:
      Frequency (seconds)       : 60
      Life                      : Forever
      Start Time                : Mon Jun 13 10:42:52 2016
      Next Scheduled Run Time   : Mon Jun 13 10:46:52 2016

Threshold-Monitor is  : Enabled
        Threshold Config     : RTT
        Threshold Type       : Immediate
        Upper Threshold      : 10
        Lower Threshold      : 2
        Action Type          : Log
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SLA ID: 1
Status: Running

SLA mechanism: ICMP-Echo

Destination address: 192.168.1.2
Source address: 192.168.1.1
History bucket size: 25
Payload size: 0
TOS: 0
Messages:
       Destination address unreachable        : 0
       Probes skipped awaiting DNS resolution : 0
       DNS resolution failed                  : 0
       No route to target                     : 0
       Internal error                         : 0
       Local interface is down                : 0
       No response from target                : 0
       Successful probes sent                 : 9
       Probe response received                : 9
       Possibly tail dropped                  : 0

Count of Threshold hits:
                RTT              : 0
                packetLoss       : 0

SLA ID: 1

Minimum RTT (ms)         : 1
Maximum RTT (ms)         : 1
Average RTT (ms)         : 1
Total RTT (ms)           : 9
RTT2 (sum of RTT squared): 9

     Start Time                  Status       RTT               Description
     ----------                  ------       ---               -----------
Tue Jun 14 10:43:12 2016        Passed          1
Mon Jun 13 10:39:05 2016        Passed          1
Mon Jun 13 10:40:05 2016        Passed          1
Mon Jun 13 10:41:05 2016        Passed          1
Mon Jun 13 10:42:05 2016        Passed          1
Mon Jun 13 10:42:52 2016        Passed          1
Mon Jun 13 10:43:52 2016        Passed          1
Mon Jun 13 10:44:52 2016        Passed          1
Mon Jun 13 10:45:52 2016        Passed          1

 ICMP ID hash walk: 

 ========== IP SLA show tech END ==============

 ======== IP SLA Server show tech BEGIN ============ 
Responder not active
IP SLA Responder: Inactive

 ======== IP SLA Server show tech END ============ 

=== The command has completed successfully. ===
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clear ip-sla responder statistics
Syntax
clear ip-sla responder statistics <SLA-TYPE> <LOCAL-IP-ADDR> <LOCAL-PORT-NUM>
             source <SOURCE-IP-ADDR>

Description

Clear IP SLA responder statistics for either UDP jitter or VoIP UDP jitter.

Command context
config

Parameters
<SLA-TYPE>

Specifies the SLA type.

udp-jitter
Selects standard UDP jitter.

udp-jitter-voip
Selects UDP VOIP jitter.

<LOCAL-IP-ADDR>

Specifies the local interface IP address

<LOCAL-PORT-NUM>

Specifies the local interface port number. Range: 1024 to 65535.

<SOURCE-IP-ADDR>

Specifies the Source IP address.

Examples

Clear IP SLA responder statistics for UDP jitter:

switch(config)# clear ip-sla responder statistics udp-jitter 1.1.1.1 1100 source 1.1.1.2

Validation rules
Validation Error/Warning/Prompt

Enabling SLA without configuring SLA type. Cannot enable IP SLA, no valid source/destination configured.

IP address given for source or destination is
multicast or broadcast.

Invalid IP address.

Configure the SLA type with a source IP which
is configured in the same switch.

Destination IP cannot be configured as the same as one of the
local interface IP addresses.

Table Continued
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Validation Error/Warning/Prompt

Configure threshold with invalid value. Invalid threshold count value. For threshold type 'Immediate',
count must be 1 and for 'Consecutive', count must be greater
than or equals to 2.

Configure threshold value for 'PacketLoss' or
'TestCompletion'

Configuration is not applicable when threshold is configured
for 'PacketLoss' or 'TestCompletion'.

Configure threshold type for TestCompletion. Configuration is not applicable when threshold is configured
for 'TestCompletion'.

Configure schedule with proper end time with a
frequency which is out of end time.

Invalid endtime. Endtime is not enough to run the tests for
configured frequency and repetitions.

Configuring ‘srcTodstTime’ or ‘dstTosrcTime’
threshold configuration for ‘icmp-echo’ or ‘tcp-
connect’.

Invalid threshold configuration for configured SLA type.

Enabling the IP SLA which is already in enabled
state.

IP SLA is already enabled.

Disabling the IP SLA which is already in
disabled state.

IP SLA is already disabled.

Show IP SLA history of un-configured SLA. IP SLA is not configured for this ID.

Enable more number (currently decided 50 as
limit) of IP SLA.

Maximum number of enabled IP SLAs at a time is limited to
50.

Removing IP SLA type/tos/history size/
schedule/ threshold configuration with un-
configured value.

IP SLA configuration does not exist.

Configuring scheduler with a frequency value
which is not satisfying the condition frequency >
number of packets per probe * packet interval.

Frequency value is insufficient to configure the scheduler.

Scheduler already configured and try to
configure SLA type with a value of ‘number of
packets per probe’ and ‘packet interval’ which is
not satisfying the condition frequency > number
of packets per probe * packet interval.

Number of packets/packet interval is insufficient to configure
IP SLA type.

Configuring IP SLA with invalid values. Invalid configuration for IP SLA.

Change the IP SLA configuration when the SLA
is enabled.

Configuration changes not allowed when IP SLA is enabled.

When IP address vs port number configured for
an SLA is already in use

Error: Socket for configured address, port is already in use,
choose different port number

When Source IP address given in SLA
configuration is not configured in the switch

Error: Source IP address is not configured in switch

Table Continued
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Validation Error/Warning/Prompt

Invalid SLA ID given in show command Error: Invalid IP SLA ID

Configure SLA more than allowed limit Warning: The maximum number of IP SLAs allowed is 50.

Configure Responder more than allowed limit Error: IP SLA Responder configurations reached max limit. No
more configurations accepted.

Configure inter-packet interval when number of
packets to be sent out is one.

Error Not applicable as Number of packets to be sent out is 1.

Upper threshold value is less than lower
threshold value.

Error: Upper threshold value X is less than lower threshold
value Y.

Configure schedule with start time greater than
stop time.

Error: Stop time must be greater than start time.

Configure schedule with past stop time. Error: Stop time must be greater than current time.

Configure schedule with invalid frequency
value.

Error: Schedule frequency is out of range. Valid range is 5 to
604800.

Configuring history size with invalid value. Error: IP SLA History size is out of range. Valid range is 1–50.

Configuring SLA type with invalid payload value. IP SLA Payload value is out of range. Valid range is 1–1440.

Configuring SLA type with invalid port number. Invalid port number. Valid range is 1024 to 65535.

Configure the IPSLA parameters without
configuring SLA type.

No valid IP SLA type configuration found.

Configuring the responder with existing details. IP SLA Responder with same configuration exist.

Configure management VLAN as source VLAN. Error: Not allowed to configure management VLAN as source
interface.

Enabling IP SLA without required configuration
parameters.

Configuration is incomplete to enable the entry.

Configure IPSLA UDP Jitter/VoIP session when
an OpenFlow custom match mode instance is
already enabled.

Cannot enable IP SLA: Initiator cannot co-exist with OpenFlow
custom Cannot enable IP SLA: Initiator cannot co-exist with
OpenFlow custom

Configure UDP Jitter/VoIP IPSLA Initiator
session with a source IP same as tunnel overlay
VLAN

Cannot enable IP SLA: The source VLAN cannot be a tunnel
overlay VLAN.

Configure UDP Jitter/VoIP IPSLA Initiator
session with a source IP same as a service
tunnel endpoint.

Cannot enable IP SLA: The source VLAN cannot be a service
tunnel endpoint.
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Event log messages
Cause

Event Message

User adds IP SLA endpoint configuration. I 10/28/15 02:47:12 05020 ipsla: The IP SLA 1 of
SLA Type: UDP-Echo, Source IPv4 Address:
10.0.0.1, Destination IPv4 Address: 10.0.0.5,
Destination Port: 54563 added.

User removes the endpoint configuration. I 10/28/15 02:47:12 05021 ipsla: The IP SLA 1 of
SLA Type: UDP-Echo, Source IPv4 Address:
10.0.0.1, Destination IPv4 Address: 10.0.0.5,
Destination Port: 54563 removed.

When the SLA state changes (can be either system
initiated or done by the user)

I 10/28/15 01:42:22 05027 ipsla: IP SLA 1 state
changed to Expired.I 10/28/15 01:42:22 05021 ipsla:
IP SLA 1 state changed to Enabled.I 10/28/15
01:42:22 05021 ipsla: IP SLA 1 state changed to
Scheduled.I 10/28/15 01:42:22 05021 ipsla: IP SLA
1 state changed to Admin-disabled.

User configures a responder I 10/28/15 01:42:22 05025 ipsla: IP SLA responder
configured for SLA Type: TCP-Connect, Listen
Address: 10.0.0.7, Listen Port: 38425

User removes a responder I 10/28/15 01:42:22 05026 ipsla: IP SLA responder
removed for SLA Type: TCP-Connect, Listen
Address: 10.0.0.7, Listen Port: 38425

SLA test results cross configured threshold I 10/28/15 01:42:22 05022 ipsla: IP SLA 1, threshold
is crossed. Monitored Param: RTT, Threshold Type:
immediate, Upper threshold: 500, Lower threshold:
100, Action Type: Trap and Log. Actual Threshold:
600

User adds DNS IP-SLA configuration I 08/09/16 02:47:12 05029 ipsla: The IP SLA 1 of
SLA Type: DNS, Name server IPv4 Address:
10.0.0.1, Target Hostname: a.hpe.com added

User removes DNS IP-SLA configuration I 08/09/16 02:47:12 05030 ipsla: The IP SLA 1 of
SLA Type: DNS, Name server IPv4 Address:
10.0.0.1, Target Hostname: a.hpe.com removed.

The packet loss threshold for the SLA has reached I 08/09/16 02:47:12 05023 ipsla: The IP SLA 1 of
SLA Type: DNS, Packet loss is observed. Threshold
type: immediate, Action type: Trap and Log

The SLA test has completed and the threshold
config for test completion is present

I 08/09/16 02:47:12 05024 ipsla: The IP SLA 1,
Probe for SLA Type: UDP-Echo, Source IPv4
Address:1.1.1.2, Destination IPv4 Address:1.1.1.3,
Destination Port:3000 Completed

Table Continued

Chapter 21 IP Service Level Agreement 727

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4465



Event Message

TCP-Connect Duplicate configuration is present W 08/09/16 02:47:12 05028 ipsla: Duplicate
configuration detected; the IP SLA 10 configuration
is the same as the IP SLA 1. For TCP, 4-tuple
combination has to be unique.

User adds DHCP SLA configuration I 08/09/16 02:47:12 05031 ipsla: The IP SLA 1 of
SLA Type: DHCP, Vlan: 1 added.

User removes DHCP SLA configuration I 08/09/16 02:47:12 05032 ipsla: The IP SLA 1 of
SLA Type: DHCP, Vlan: 1 removed.

DHCP SLA test has completed and the threshold
config for test completion is present

I 08/09/16 02:47:12 05033 ipsla: The IP SLA 1,
Probe for SLA Type: DHCP, Source Vlan : 1
Completed

Interoperability
NOTE: Packet loss is expected when H3C TCP-CONNECT source, with a frequency less than or
equal to 10 ms, interoperates with TCP-CONNECT responder.

IP SLA UDP Jitter and Jitter for VoIP

Overview
The UDP Jitter and Jitter for VoIP SLA types enable the user to assess the suitability of the network for voice &
video related traffic. These SLA's basically calculate parameters like RTT, one way delay, one way positive and
negative Jitter etc.

The above diagram shows a typical deployment, where voice & video traffic are exchanged between branch
offices of an enterprise over the backbone network. Assessment of the network readiness is always helpful for
hosting such services. Parameters like RTT, Jitter and one way delay are a good indicator of network health which
assist a network administrator to diagnose latency related issues in the network. VoIP traffic is generally sensitive
to delays in the network.
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Jitter stands for inter-packet delay variance. If the inter-packet delay increases between successive probe
packets, jitter is said to be positive. If the inter-packet delay decreases, jitter is said to be negative. Positive jitter
values are undesirable for a network as they indicate increased latencies. A value of 0 jitter is desirable.

Significance of jitter
Consider a media player which plays video streams from a server. Assume that packets take 1 second in flight to
reach the media player. This means the moment a user requests a video from the server, the very first packet will
arrive after one second and successive packets will be sent immediately (ideally). In real world scenarios,
intermediate node latencies, different return paths for different packets and network congestion can contribute to
varying delays. To counter such effects, packets are buffered at the media player. The amount of packet buffering
needed can be derived from the jitter values.

NOTE: The above analogy is applicable for other voice & video services and can be a good measure
to assess the possibility for hosting a service on a network.

Solution components

IP SLA responder

This device receives IP SLA probe packets from a configured initiator, timestamps the frame at a pre-defined
location in the packet upon receipt and sends the same frame back to the initiator.

IP SLA initiator

This device initiates IP SLA probe packets to multiple destinations each with a certain user configurable packet
content and periodicity.

The initiator timestamps the frame at a pre-defined location before sending the frame out to the configured
destinations and re-timestamps the frame at a different location once it receives the same back from the
responder.

IP SLA measurement engine

This is an application running on the initiator. It processes response frames received from the IP SLA responder
and computes one-way delay, jitter and RTT based on the timestamps present in the packet.

This application aggregates this computed information across multiple probe samples and stores this for
consumption by an NMS via SNMP or via the device CLI.

It also supports asynchronous user configurable threshold breach notification to an NMS (via SNMP Traps).

SLA Measurements
The following metrics are measured as part of this IP SLA jitter functionality.
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One way jitter

One way jitter is defined as the time difference between inter-packets transmit time and inter-packets arrival time
in a given direction. This is measured in both the Initiator to Responder direction (referred to as SD jitter) as well
as the Responder to initiator direction (referred to as DS jitter).

Ideally, the jitter in both directions should be 0. A positive value of jitter is bad for VOIP and higher values of jitter
will mean poor conversation quality. This is explained in the illustration below:

One way delay

One way delay is defined as the time difference between the Initiator transmitting the frame and the Responder
receiving the frame. This requires the Initiator and the Responder to be time synchronized with the same clock
server. This is explained in the illustration below:

Round trip time

RTT is measured at the initiator on a per packet basis and is as illustrated below:
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Definition of Terms
Term Definition

DCA Dynamic Configuration Arbiter

ClearPass ClearPass Policy Manager

GRE Generic Routing Encapsulation

SAC Switch Anchor Controller

S-SAC Standby Switch Anchor Controller

UAC User Anchor Controller

Switch Bootstrap Control plane protocol packets exchange process between a switch and an SAC to register
a switch with the configured SAC.

User Bootstrap Control plane protocol packets exchange process between a switch and a UAC to register
a user with the published UAC.

Secondary role This information is an indication to the controller that it has to enforce additional policies to
user traffic based on policy configuration associated with the secondary role.

Reserved VLAN
mode

A VLAN is automatically created and reserved for tunnels in this mode.

Overview
Dynamic Segmentation enables Aruba switches to tunnel traffic (all traffic or the traffic of particular clients) to
Aruba controllers.

Dynamic Segmentation includes the following:

• User-Based Tunneling tunnels client traffic on the basis of user roles. This ability to dynamically tunnel traffic is
powerful, and when used correctly, can help in solving several deployment problems that are prevalent in
legacy campus networks. The policies associated with the client can be driven through a RADIUS server, a
downloaded role from ClearPass, or by local MAC authentication in the switch. Many devices that require
power over Ethernet (PoE) and network access, such as security cameras, printers, payment card readers,
and medical devices, do not have built in security software such as those on desktop or laptop computers.
These devices can pose a risk to networks with the lack security on the device. User-Based Tunneling can
authenticate these devices using ClearPass, and tunnel the client traffic, utilizing the advanced firewall and
policy capabilities in the Aruba Mobility Controller. For providing secure access to IoT devices within the Aruba
Intelligent Edge wired network, controller clustering is available in ArubaOS 8.0.0.0. For more information, see 
User-Based Tunneling.

• Port-Based Tunneling allows the Aruba switch to tunnel traffic to an Aruba Mobility Controller on a per-port
basis. All traffic on a configured switch port is statically tunneled to an Aruba Mobility Controller. For more
information, see Port-Based Tunneling.

Tunneling is enabled in the Aruba user role and can be combined with the Downloadable User Role (DUR)
feature for dynamic and flexible policy enforcement and segmentation.

Chapter 22
Dynamic Segmentation
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NOTE: Maximum supported user tunnels per switch or stack: 1024

Maximum supported user tunnels per port: 32

Benefits of Dynamic Segmentation
The benefits of dynamic segmentation are:

• Colorless ports / client flexibility

• Client isolation

• Same policy for wired or wireless clients

• With ClearPass, no role preconfiguration is needed.

• Tunnel client traffic over core complexity

• Reduced switch configuration

• Traffic visibility

• Wired guest access

• Simple branch configuration

• Controller supplied client attributes visibility

Use Cases
Following are the common use cases for Dynamic Segmentation, apart from the common use case of segmenting
traffic based on user role policy:

• Create a wired guest capability.

• Provide a firewall at the Mobility Controller.

Wired Firewall Access:
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To restrict user access, firewall and policies can be implemented for users tunneled to an Aruba Mobility
Controller by using the built-in firewall capabilities of the Aruba Mobility Controller.

Figure 177: Wired Firewall Access

Wired Guest Traffic Segmentation:

The Dynamic Segmentation feature supports segmenting wired guest traffic on the network. This is achieved by
creating the secondary role as a guest role on the Mobility Controller and assigning a specific guest VLAN.
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Access and firewall policy is then implemented on the controller to isolate guest access to the rest of the campus
network.

Figure 178: Wired Guest Traffic Segmentation

Users/Devices and Policy Enforcement Recommendations
The following table calls out the enforcement recommendations for different type of users and devices. While it is
recommended to tunnel the traffic in some cases, other cases can be met by simply using local forwarding on the
switch.

Type Enforcement Description

Access Point Local Local infrastructure device.

Voice/Video Device Local Desk and conference phones, security cameras, and room media
systems.

Employee on Managed
Device

Local Users connecting from a healthy and managed device can stay
local to the Aruba switch.

Employee on Unmanaged
device

Tunnel Users connecting from an unmanaged or potentially untrusted
device can be tunneled.

New/Unknown Device Tunnel Tunnel new or unknown devices, potentially untrusted devices used
for profiling, potential onboarding, guest registration, and
quarantine.

Guest User Tunnel Guest users to DMZ guest network.

Table Continued
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Type Enforcement Description

Contractor Tunnel Contractors may need more access than a traditional guest user.

Change in User/Device
Posture

Tunnel User or device goes from a healthy to unhealthy state (OnGuard
checks, IntroSpect notification, Ingress Event Engine Notification)

Colorless Ports
Within a campus network with a few thousand switch access ports and numerous intermediate distribution frames
(IDFs), network admins must put in effort to assign VLAN IDs to the devices. It is also difficult to maintain switch
port to VLAN mapping, and a significant configuration effort to manage thousands of lines of configurations on the
switches is required.

With colorless ports, all the switches would have similar configuration with IP, credentials, authentication, VLANs,
and uplinks. All access ports need only a few lines of configuration common for all ports. No admin intervention is
needed to assign a VLAN to a user, since the user is automatically assigned a reserved VLAN ID.

The benefits of colorless ports are:

• Simplified user experience

• Increased visibility. It is easy to see what is on the network.

• Increased security. The network correctly applies the correct policy to a device.

• Simplified switch configuration. All access ports are configured the same.

For more details on the colorless ports, see User Roles in the Access Security Guide for your switch.

Port-Based Tunneling
In a traditional campus network, wireless traffic is encapsulated between the access point and controller using a
tunnel. With Port-Based Tunneling on the Aruba switches, a similar implementation is done using the same
mechanism with an Aruba Mobility Controller. In essence, a wired port becomes a “wired AP”. Each switch port
can then be individually configured to create a single tunnel to the Mobility Controller. However, at the Mobility
Controller, each tunneled node port is seen as separate tunnel to provide more granular visibility, as each tunnel
has a unique GRE key. By tunneling traffic to the Mobility Controller, in Port-Based Tunneling, authentication and
network policies are applied and enforced at the controller-side for tunneled, wired traffic. This simplifies
configuration on the switch and centralizes policies at the Mobility Controller. Port-Based Tunneling allows using
the same enforcement options for wired and wireless clients. This includes stateful session processing, deep
packet inspection, URL filtering, and bandwidth contracts.

The main purpose of Port-Based Tunneling is to use the Mobility Controller as a unified policy enforcement point
for traffic from both wired and wireless clients.

NOTE: If the Mobility Controller is not reached by the Aruba switch, the user can fall back to local
switching, which allows the tunneled ports to communicate with the other ports in the same VLAN.

IMPORTANT: 

• Port-Based Tunneling is configured on a per-port basis. Traffic to and from ports that
is not configured as tunneled is forwarded using the standard layer switching
technology.

• An ArubaOS-switch can be configured with a main and a backup tunnel termination
controller called “tunneled-node server”.

• Port-Based Tunneling does not support HA and load balancing over an Aruba
Mobility Controller Cluster compared to User-Based Tunneling.
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Configuring Port-Based Tunneling
Jumbo frames must be enabled on all devices between the access switch and the controller to support the L2
GRE tunnels.

Follow the steps below to configure port-based tunneling:

Prerequisites
It is recommended to create a specific VLAN for tunneled node operation. The VLAN:

• Must be configured as the only VLAN for tunneled node access ports (untagged)

• Cannot be assigned an IP address – No layer 3 interface

• Must exist on the controller

Procedure

1. Issue the following command to setup the IP address of the Aruba Mobility Controller (tunneled node server):

Switch(config)# tunneled-node-server controller-ip 10.2.10.11
Optional steps:

a. Setup backup controller IP by issuing the following command:

Switch(config)# tunneled-node-server backup-controller-ip 10.2.10.12
b. Set tunneling keepalive timer by issuing the following command. Ensure the time interval between

keepalive messages is set to the default value (8):

Switch(config)# tunneled-node-server keepalive interval
<1-8> Configure the time interval between two successive keepalive messages sent to the
controller

2. Issue the following commands to enable port-based tunneling on an interface or a range of interfaces:

Switch(config)# vlan 200 untagged 1/21-1/24
exit
Switch(config)#interface 1/21-1/24 tunneled-node-server

3. Issue the following commands to verify the state of the port-based tunnel(s):

Switch(config)# show tunneled-node server state
Tunneled Node Port State
Active Controller IP Address : 10.2.10.11
Port State
------ -------------------------
2/23 Complete
You can view the tunnel statistics by issuing the following command:

View tunnel statistics
Switch(config)# show tunneled-node-server statistics
Tunneled Node Statistics
Port : 2/23
Control Plane Statistics
Bootstrap packets sent : 1
Bootstrap packets received : 1
Bootstrap packets invalid : 0
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Tunnel Statistics
Rx Packets : 302
Tx Packets : 0
Rx 5 Minute Weighted Average Rate (Pkts/sec)
: 0 Tx 5 Minute Weighted Average Rate
(Pkts/sec) : 0
Aggregate Statistics
Heartbeat packets sent : 56607
Heartbeat packets received : 56607
Heartbeat packets invalid : 0
Fragmented Packets Dropped (Rx) : 0
Packets to Non-Existent Tunnel : 0
MTU Violation Drop : 0

Operating notes
• Tunneled node profile may be created using CLI and SNMP.

• The tunneled node profile supports configuring of:
◦ Primary controller (both IPv4 and IPv6).

◦ Backup controller (both IPv4 and IPv6).

◦ Heartbeat keepalive timeout – range 1-40 seconds.

• Only one tunneled node profile may be created.

• The tunneled-node profile may be applied to a physical port only via CLI and SNMP.

• The maximum number of physical ports to which the profile may be applied is:
◦ Aruba 5400R Switch Series (non-VSF): 256 physical ports.

◦ Aruba 5400R Switch Series (VSF): 512 physical ports.

• High availability (HA) will be supported for the tunneled-node related configuration.

• A tunnel, associated with a port, is “up” when both conditions are met. A tunnel is “down” when either of the
conditions are not met.
◦ Either the primary or backup controller is reachable.

◦ A boot strap message response is received from the controller.

• Heartbeat between the switch and controller has failed when the controller does not respond after five
attempts. All tunnels are brought down with a heartbeat failure.

• A tunnel “up or down” status will be logged for each tunnel node port in the event log.

• The show tech command dumps all user-mode and test-mode command outputs.

• To reach the Aruba controller, the VLAN must have a manual IP configured.

• With the exception of the 802.1x BPDU, the switch consumes all other BPDUs.

• The controller cluster cannot have mix of IPv4 and IPv6 nodes.

• IPv6 addresses are not allowed for both Primary and Backup controllers when in Port-Based Tunnels..

Interaction table
Features enabled with tunneled node:
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Feature

Mirrors (MAC, VLAN, port)

PVST/RPVST/STP

DLDP

UDLD

LLDP/CDP

GVRP/MVRP

LACP

Uplink Failure Detection

sFlow

Loop protect

Smartlink

Global QoS (VLAN, port, rate limit)

MAC lockout/lockdown

ACL/Classifiers (ingress/egress)

IGMP/MLD

GMB

Broadcast-limit

Energy Efficient Ethernet

Flow Control

PoE

• poe-allocate-by

• poe-lldp-detect

Rogue MAC detection

LLDP auto provisioning

Restrictions
• Once a tunneled-node profile is applied to a port, the controller IP (primary and backup) cannot be changed.

• IP address cannot be assigned to VLANs that contain ports with Port-Based Tunneling configured.

Chapter 22 Dynamic Segmentation 739

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4477



• No support for fragmentation and reassembly for encapsulated frames that result in an MTU violation. Such
frames will be dropped.

• Packets from ports configured with Port-Based Tunnels will not be bridged with locally switched ports.

Features that are blocked when Port-Based Tunnels are configured and the scope of the block (either globally, on
a port basis or on a VLAN basis):

Feature Blocked globally/per port/ VLAN with Port-
Based Tunneling

IP multicast routing Global

Openflow Global

Q-in-Q Global

Distributed Trunking Global

Mesh Global

VXLAN Global

IP address: manual and dhcp VLAN

802.1x, mac auth, webauth, LMA, port
security

Port

DIPLD (IPv4/IPv6) Port

DSNOOP (IPv4/IPv6) VLAN

ARP protect VLAN

RA guard Port

Virus throttling Port

BYOD VLAN

Trunk Profile cannot be applied to a trunk

PBR policies VLAN

VSF on a Port-Based Tunnel configured
port

Port

Source port/Multicast filters Port

DHCP client/Server/Relay VLAN

Preventing double tunneling of Aruba Access Points
When an Aruba Access Point (AP) is connected to a port on which Port-Based Tunneling is configured, there are
two tunnels from that port to the Controller - one for the AP and another for the tunneled node. To improve
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performance of APs connected to tunneled node ports, the following configuration parameter under the device
profile feature prevents double tunneling.

The parameter decides whether to allow or not, a tunneled node to be configured on the port on which the device-
profile is applied. Use the command switch(config)# device-profile name <device-profile-name>
[no] allow-tunneled-node.

NOTE: The default setting of device-profile allows tunneled node. Device profile is applied on
the port only by reading Organizational Specific TLV in LLDP packets.

Preventing double tunneling using device profile
device-profile name

Syntax
device-profile name <device-profile-name> [no] allow-tunneled-node

Description

Allows or disallows tunneled node when device profile is applied on that port.

Command context
config

Parameter
<device-profile-name>

Specifies the name of the device profile to be configured.

Usage

To create a device-profile named “test”, execute the following command:

switch(config)# device-profile name test
To allow tunneled-node by the configured device profile parameter, execute the following command:

switch(device-profile)# allow-tunneled-node

Examples

switch(config)# device-profile name <device-profile-name>
 switch(device-profile)# 
 allow-jumbo-frames    Configure jumbo frame support for the device port.
 allow-tunneled-node   Configure Tunneled Node support for the device port.
 cos                   Configure the Class of Service (CoS) priority for
                       traffic from the device.
 egress-bandwidth      Configure egress maximum bandwidth for the device port.
 ingress-bandwidth     Configure ingress maximum bandwidth for the device
                       port.
 poe-max-power         Configure the maximum PoE power for the device port.
 poe-priority          Configure the PoE priority for the device port.
 speed-duplex          Configure the speed and duplex for the device port.
 tagged-vlan           Configure this port as a tagged member of the specified
                       VLANs.
 untagged-vlan         Configure this port as an untagged member of specified
                       VLAN.
Execute show run command to display the tunneled mode configuration in an enabled or disabled state:
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switch(config)# show run
; J9625A Configuration Editor; Created on release #KB.16.05.0000x
; Ver #0f:02.43.18.82.34.61.1c.28.f3.84.9c.63.ff.37.2f:da
hostname "switch"
snmp-server community "public" unrestricted
device-identity name "cpe" lldp oui 33bbcc
device-identity name "cpe" lldp sub-type 1
device-identity name "phone" lldp oui 112233
 
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-28
   ip address dhcp-bootp
   exit
device-profile name "ram"
   exit
device-profile name "test"
   exit
device-profile type “scs-wan-cpe”
   associate "ram"
   enable
   exit
device-profile type-device "cpe"
   associate "ram"
   enable
   exit
device-profile type-device "phone"
   associate "default-device-profile"
   exit 
When allow-tunneled-node is disabled:

switch(config)# show run
; J9625A Configuration Editor; Created on release #KB.16.05.0000x
; Ver #0f:02.43.18.82.34.61.1c.28.f3.84.9c.63.ff.37.2f:da
hostname "switch"
snmp-server community "public" unrestricted
device-identity name "cpe" lldp oui 33bbcc
device-identity name "cpe" lldp sub-type 1
device-identity name "phone" lldp oui 112233
 
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-28
   ip address dhcp-bootp
   exit
device-profile name "ram"
   exit
device-profile name "test"
   no allow-tunneled-node
   exit
device-profile type “scs-wan-cpe”
   associate "ram"
   enable
   exit
device-profile type-device "cpe"
   associate "ram"
   enable
   exit
device-profile type-device "phone"
   associate "default-device-profile"
   exit 
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show device-profile config

Syntax
show device-profile config

Description

Displays device profile configuration.

Command context
config

Usage

To verify whether tunneled-node is allowed (when “test” is device-profile name):

switch(device-profile)# show device-profile config test
To verify the output when tunneled-node is disabled:

switch(device-profile)# no allow-tunneled-node
switch(device-profile)# show device-profile config test

Example

switch(config)# show device-profile config
 Device Profile Configuration

 Configuration for device-profile : default-ap-profile
  untagged-vlan      : 1
  tagged-vlan        : None
  ingress-bandwidth  : 100%
  egress-bandwidth   : 100%
  cos                : 0
  speed-duplex       : auto
  poe-max-power      : Class/LLDP
  poe-priority       : critical
  allow-jumbo-frames : Disabled
  allow-tunneled-node: Enabled

 Device Profile Configuration

  Configuration for device-profile : test
  untagged-vlan      : 1
  tagged-vlan        : None
  ingress-bandwidth  : 100%
  egress-bandwidth   : 100%
  cos                : None
  speed-duplex       : auto
  poe-max-power      : Class/LLDP
  poe-priority       : critical
  allow-jumbo-frames : Disabled
  allow-tunneled-node: Enabled
When tunneled-node is disabled:

switch(config)# show device-profile config
 Device Profile Configuration

 Configuration for device-profile : default-ap-profile
  untagged-vlan      : 1
  tagged-vlan        : None
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  ingress-bandwidth  : 100%
  egress-bandwidth   : 100%
  cos                : 0
  speed-duplex       : auto
  poe-max-power      : Class/LLDP
  poe-priority       : critical
  allow-jumbo-frames : Disabled
  allow-tunneled-node: Disabled

  Device Profile Configuration

  Configuration for device-profile : test
  untagged-vlan      : 1
  tagged-vlan        : None
  ingress-bandwidth  : 100%
  egress-bandwidth   : 100%
  cos                : None
  speed-duplex       : auto
  poe-max-power      : Class/LLDP
  poe-priority       : critical
  allow-jumbo-frames : Disabled
  allow-tunneled-node: Disabled

User-Based Tunneling
User-Based Tunneling gives Aruba switches the ability to tunnel specific client traffic to an Aruba controller.

Once User-Based Tunneling is enabled, the Aruba controller provides a centralized security policy, authentication,
and access control. The decision to tunnel client traffic is based on the user role. User roles redirect traffic to an
Aruba controller when the tunnel status is up. A secondary role, provided by the authentication subsystem, when
present in the user role authorizations, notifies the User-Based Tunnel and provides a secondary role. The
communication between a User-Based Tunneling switch and the ClearPass is supported only over IPv4.

User-Based Tunneling, combined with ClearPass/LMA policies, can be used to indicate if a client's traffic should
be tunneled to the controller.

User Authentication Workflow
The flowchart below depicts user authentication workflow for User-Based Tunneling:

1. Authenticate user

2. Apply user role to authenticated user

3. Redirect user traffic to controller

4. Apply secondary user role to user traffic on controller
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How it works
The functionality of User-Based Tunneling starts with the tunneled-node server information being discovered on
the Aruba switch. User-Based Tunneling module exchanges information with the tunneled-node server to
determine its reachability and discover the version details. Once the reachability is confirmed, the user-based
tunneling module in the Aruba switch sends a bootstrap message to the tunneled-node server, which replies with
an acknowledge message.

Creating a Tunnel

A GRE heartbeat is initiated between the Aruba switch and the managed device creating a tunnel. A GRE
heartbeat is exchanged with the managed device, which is the switch anchor controller (SAC). This is the
controller-IP in the tunneled-nodeserver command. A secondary heartbeat is also established with the
standby managed device and acts as a secondary switch anchor controller (s-SAC).

Authenticating the User

As a user connects to a secure port, the Aruba switch sends a request to the RADIUS server (in this case,
ClearPass), which authenticates the user and returns a user role attribute to the Aruba switch. Once the attribute
containing information on which user role the user will be placed in is received by the Aruba switch, the user role
that is configured locally on the Aruba switch or downloaded from the ClearPass.

Aruba User Role

A user role can contain policy, captive portal, and VLAN information. When the user role that is returned from the
RADIUS server is applied to the user, the tunneled-node-server-redirect command to redirect traffic to a
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managed device can be included within the user role. When this command is executed and the user-based
tunneling feature status is up, the authentication sub system notifies the user-based tunnel node module,
providing a secondary role. The secondary role is the user role on the managed device where policy generally
exists for tunneled users. This is where the firewall and security will be applied. This secondary-role information is
an indication to the managed device that it has to enforce additional policies to the user traffic based on policy
configuration associated with the secondary role and then from the tunnel.

Tunneling to a Controller Cluster

To ensure high availability, customers can tunnel traffic to a Controller Cluster instead of just to a standalone
controller. If users are tunneled to a controller cluster, the bucket map containing the mapping between a bucket
of clients to the active UAC and s-UAC is populated in the controller. A value based on the client MAC address is
assigned when a user is redirected to a controller. This value is then used to look up the bucket map and the
client device is then anchored to that particular controller node. This secondary-role information is an indication to
the controller that it has to enforce additional policies to user traffic based on policy configuration associated with
the secondary role. After this process, the per user tunneled node module creates a tunnel to this UAC, if not
already created, and forward user traffic to that UAC. If a user role does not contain an attribute to redirect traffic
to a controller, then the switch will forward the traffic locally.

Once user tunnels are established to the user anchor controllers, a PAPI (Process Application Programming
Interface)-based keepalive packet is exchanged with the controllers that have users anchored to them.

NOTE: Upgrading from earlier images to 16.08 or greater with the same user role configuration is
seamless and is supported. After upgrading to 16.08 or later, if Reserved VLAN mode is configured,
the VLAN IDs already configured in user roles will not be used for tunneling traffic to the controller.

Downgrading is not allowed when User-Based Tunneling is operating in Reserved VLAN mode. The
user cannot downgrade to pre-16.08 image if the user role lacks a VLAN configuration.

Licensing Requirements
A license is required to activate Dynamic Segmentation and if the license is not installed, controllers will not be
allowed to form tunnels to Aruba switches and the feature will not be functional. The AP/switch consumes the
following license types:

AP

PEFNG

RFP

WebCC

MC-VA (for VMC-MD)

The show license-usage ap command displays license usage for User-Based Tunnels. Licenses are
consumed per switch and User-Based Tunnels will show up alongside APs for license consumption.

switch# show ap license-usage 
 
AP Licenses
-----------
Type                      Number
----                      ------
AP Licenses               2048
RF Protect Licenses       2048
PEF Licenses              2048
MM Licenses               2048
Controller License        True
Overall AP License Limit  2048
 
AP Usage
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--------
Type             Count
----             -----
Active CAPs      0
Active RAPs      0
Remote-node APs  0
Active MUX       0
Active PUTN      1
Total APs        1
 
Remaining AP Capacity
---------------------                              
Type  Number
----  ------
CAPs  2047
RAPs  2047
show license client-table output on a Controller Cluster:

(cluster1)# show license client-table

Built-in limit: 0
License Client Table
--------------------
Service Type                                        System Limit  Server Lic.  Used Lic.  Remaining Lic.  FeatureBit
------------                                        ------------  -----------  ---------  --------------  ----------
Access Points                                       64            510          2          62              enabled
Next Generation Policy Enforcement Firewall Module  64            254          2          62              enabled
RF Protect                                          64            510          2          62              enabled
Advanced Cryptography                               4096          512          0          512             enabled
WebCC                                               64            0            0          0               disabled
MM-VA                                               65            494          3          62              enabled
MC-VA-RW                                            64            250          0          64              disabled
MC-VA-EG                                            64            0            0          0               disabled
MC-VA-IL                                            64            0            0          0               disabled
MC-VA-JP                                            64            0            0          0               disabled
MC-VA-US                                            64            0            0          0               disabled
VIA                                                 4096          0            0          0               enabled

show license server-table output on the Mobility Master:
(MM1) [mynode]# show license server-table

License Server Table for pool / profile root
--------------------------------------------
Service Type                                        PoolSize  ExpiredLic  ActualPoolSize  UsedLic  RemainingLic  Warnings  FeatureBit
------------                                        --------  ----------  --------------  -------  ------------  --------  ----------
Access Points                                       512       0           512             18       494           None      enabled
Next Generation Policy Enforcement Firewall Module  256       0           256             18       238           None      enabled
RF Protect                                          512       0           512             18       494           None      enabled
Advanced Cryptography                               512       0           512             0        512           None      enabled
WebCC                                               0         0           0               0        0             None      disabled
MM-VA                                               1000      0           1000            12       988           None      enabled
MC-VA-RW                                            250       0           250             0        250           None      enabled
MC-VA-EG                                            50        0           50              0        50            None      enabled
MC-VA-IL                                            50        0           50              0        50            None      enabled
MC-VA-JP                                            50        0           50              0        50            None      enabled
MC-VA-US                                            50        0           50              0        50            None      enabled
VIA                                                 0         0           0               0        0             None      enabled

(MM1) [mynode] # 

Dependencies
Dynamic Segmentation is supported on the following platforms and firmware versions:

Supported Deployments

• Standalone controller

• Clustered controller

Switch Platform and Firmware Support
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• Aruba 3810 Switch Series

• Aruba 2930F Switch Series and Aruba 2930M Switch Series

• Aruba 5400R Switch Series (v3 blades only)

• ArubaOS-Switch 16.04 or later

Controller Firmware Support

• Standalone controller - 7000 Series and 7200 Series running ArubaOS 8.1.0.0 or later

• Clustered controller - 7000 Series and 7200 Series running ArubaOS 8.1.0.0 or later

ClearPass

ClearPass version 6.7.

AirWave

AirWave version 8.2.6.

NOTE: Even though AirWave 8.2.6 or above will work, AirWave 8.2.8 has additional enhancements
to provide visibility to tunnels.

Simplifying User-Based Tunneling with Reserved VLAN
Prior to 16.08, authenticated clients were assigned to the VLANs provided by applied user role profile (configured
or downloadable). Then, the User-Based Tunnel would get established between the switch and controller, and
client traffic would be tunneled to the controller, provided the client VLAN imposed by the user role profile was
created previously in both switch and controller. Otherwise, User-Based Tunneling functionality would fail.

This created an overhead for network admins while configuring all possible client VLANs in each access switch
and controller, so that the client traffic could be tunneled and segregated properly. Since all client traffic was
tunneled to the controller, and controller segregated the traffic based on its configured policy (secondary user
role), there was no value added for maintaining multiple VLANs for various categories of clients.

ArubaOS-Switch 16.08 allows creation of a reserved VLAN through which all tunneled traffic is taken to the
controller and this simplifies deployment of User-Based Tunneling. A fixed/reserved VLAN is configured under
tunneled profile, which is assigned to all tunneled clients and the same VLAN is used while tunneling client traffic
to the controller. Thus, to use a reserved VLAN, it is not required to preconfigure VLANs configured under user
role in switch, prior to initiating client authentication. When a reserved VLAN is configured, if it is not already
present on the switch, it will be created and traffic from all clients on the switch will go through the reserved VLAN.
By adding a single line configuration to tunneled-node command, existing users can migrate to the Reserved
VLAN mode without changing any other configuration.

Differences between User-Based Tunnels with and without Reserved VLAN:

User-Based Tunnels without Reserved VLAN User-Based Tunnels with Reserved VLAN

Tunnel VLANs should be statically configured on all
switches.

Tunnel VLANs need not be statically configured on all
switches.

User role should have VLAN attribute configured. User role need not have VLAN attribute configured.

Multicast traffic is replicated on the switch. Multicast traffic is replicated on the controller.

VLANs need to be synchronized between the switch
and the controller.

VLANs need not be synchronized between the switch
and the controller.

Operating Notes:
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• The reserved VLAN is used exclusively for User-Based Tunneling feature. Deletion of this VLAN is not allowed
outside of tunneled profile configuration.

• The VLANs imposed by user role after successful client authentication is ignored, and the reserved VLAN is
used for on-boarding the tunneled clients.

• Controller segregates tunneled client traffic based on assigned secondary role and unicasts the multicast/
broadcast traffic to individual clients through UAC tunnel.

• SAC multicast tunnels are no longer used in reserved VLAN mode.

• The reserved VLAN configuration on the controller is optional.

• The default VLAN cannot be configured as a reserved VLAN.

• Migration from Port-Based Tunneling to User-Based Tunneling requires a disable and then, a re-enable of
tunneling.

• The user role for tunneled clients will not be allowed to contain untagged and tagged VLAN like normal clients.

Configuration and show commands

Commands to configure a tunneled node server on the switch
Tunneled node configuration
Commands necessary to configure a tunneled node server for a tunneled node Aruba switch:

• switch(config)#tunneled-node-server
• switch(tunneled-node-server)# controller-ip <IP-ADDR | IPV6-ADDR>
• Optional: switch(tunneled-node-server)# backup-controller-ip <IP-ADDR | IPV6-ADDR>
• Optional: switch(tunneled-node-server)# keepalive interval <Integer>
• switch(tunneled-node-server)# mode role-based reserved-vlan <vlan-id>
• switch(tunneled-node-server)# enable

NOTE: IPv6 configurations are only available when the switch is operating in role-based mode (User-
Based Tunneling).

tunneled-node-server
Syntax
tunneled-node-server [controller-ip <IP-ADDR|IPv6-ADDR> | backup-controller-ip 
<IP-ADDR|IPv6-ADDR> | [keepalive <TIMEOUT>] | enable | mode role-based {reversed-vlan <VLAN-ID>}]
    
no tunneled-node-server [controller-ip <IP-ADDR|IPv6-ADDR> | backup-controller-ip 
<IP-ADDR|IPv6-ADDR> | [keepalive <TIMEOUT>] | enable | mode role-based {reversed-vlan <VLAN-ID>}]

Description

Configure tunneled node server information.

The no form of the command removes the tunneled node server configuration.

Options

controller-IP

Configure the controller IP address for the tunneled node. Both IPv4 and iPv6 are supported.
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backup-controller-IP

Configure the backup controller IP address for the tunneled node. Both IPv4 and IPv6 are supported.

keepalive

Configure the keepalive timeout for the tunneled node in seconds [1-40]. The default is 8 seconds.

enable

Enter the manager command context.

mode role-based

Specifies the tunneled node server mode as role based.

mode role-based reserved-vlan

Specifies the VLAN used as tunneled node server reserved VLAN.

Examples
switch(config)# tunneled-node-server controller-ip 15.255.133.148
switch(config)# tunneled-node-server backup-controller-ip 15.255.133.148
switch(config)# tunneled-node-server keepalive 40
tunneled-node-server-redirect

Syntax
tunneled-node-server-redirect [secondary-role <ROLE-NAME>]

no tunneled-node-server-redirect [secondary-role <ROLE-NAME>]

Description

Configures traffic redirect to user-based tunnel. Secondary role is the new user role that will be applied to the
tunneled traffic by the controller.

The no form of this command stops the traffic re-direction to the controller. Secondary role is the new user role
that will be applied to the tunneled traffic by the controller.

Command context
user-role

Parameters
secondary-role <ROLE-NAME>

Specifies the secondary role applied on the user traffic by the controller.

Example

switch(config)# aaa authorization user-role name testrole

switch(user-role)#
 tunneled-node-server-redirect
 tunneled-node-server
The tunneled-node-server-redirect attribute instructs the switch to redirect all traffic with user-role “testrole” to the
controller. The secondary-role “authenticated” specified with the redirect attribute should be configured and
present on the controller. In versions 16.07 and earlier, the client VLAN on the switch needs to be present on the
Controller. With the Reserved VLAN mode introduced in 16.08, this is no longer necessary.
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class ipv4 "testclass"
     10 match ip 0.0.0.0 255.255.255.255 0.0.0.0 255.255.255.255
     20 match tcp 0.0.0.0 255.255.255.255 0.0.0.0 255.255.255.255
   exit
policy user "testpolicy"
     10 class ipv4 "testclass" action permit
   exit
aaa authorization user-role name "testrole"
   policy "testpolicy"
   vlan-id 100
   tunneled-node-server-redirect secondary-role "authenticated"
   exit

NOTE: When the reserved-vlan option is used, the applied VLAN ID under the user-role
"testrole" will not be considered. This is because the traffic will be redirected to the controller using
reserved-vlan, and not the one configured on the switch.

Show the tunneled-node-server status for all users.

switch-PoEP# show tunneled-node-users all

PORT    MAC-ADDRESS     TUNNEL-STATUS   SECONDARY-USERROLE      FAILURE-REASON
1       000ffe-c8ce92   UP              authenticated
5       082e5f-263518   UP              authenticated

NOTE: Starting from 16.08, The CLI constraint while configuring tunneled-node-server-
redirect attribute without configuring VLAN ID has been removed.

IP source interface

Syntax
switch(config)# ip source-interface tunneled-node-server 
[<IP_ADDRESS> | loopback <LOOPBACK_INTERFACE> | vlan <VLAN_ID>]

Description

Defines source IP address or interface for specified protocol.

NOTE: 

• If interface has multiple addresses, lowest address is used.

• Protocols not configured with a specific address will use the IP address of outbound interface as
source.

Command context
ip source-interface

Parameters
<IP_ADDRESS>

Specifies IP address.

<LOOPBACK_INTERFACE>

Specifies a loopback interface.
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<VLAN_ID>

Specifies VLAN ID.

Example

Running configuration:

NOTE: Requires (config)#show run context:

; J9850A Configuration Editor; Created on release #KB.16.05.0000x
; Ver #12:08.1f.fb.7f.bf.bb.ff.7c.59.fc.7b.ff.ff.fc.ff.ff.3f.ef:f4
hostname "Anay5400R"
module A type j9989a
module B type j9986a
module C type j9989a
module D type j9986a
module E type j9986a
module F type j9986a
class ipv4 "testclass"
    10 match ip 0.0.0.0 255.255.255.255 0.0.0.0 255.255.255.255
    20 match tcp 0.0.0.0 255.255.255.255 0.0.0.0 255.255.255.255
  exit
policy user "testpolicy"
    10 class ipv4 "testclass" action permit
  exit
radius-server host 90.90.90.1
ip routing
ip source-interface tunneled-node-server loopback 1
tunneled-node-server
    controller-ip 21.1.1.2
    mode role-based
  exit

Reserved VLAN
Syntax
tunneled-node-server mode role-based reserved-vlan <VLAN-ID>

[no] tunneled-node-server mode role-based reserved-vlan <VLAN-ID>
Description

Enable tunneled node server with a reserved VLAN on which all client traffic is sent to the controller.

Example

To configure a tunneled node server in role-based reserved VLAN mode:

switch(tunneled-node-server)# mode
port-based        Configure tunneled node server mode as port based.
role-based        Configure tunneled node server mode as role based.

switch(tunneled-node-server)# mode role-based
reserved-vlan    Configure VLAN Mode as No-VLAN, switch without tunneled-node client’s 
vlan.

switch(tunneled-node-server)# mode role-based reserved-vlan
VLAN-ID              Configure VLAN to be created and reserved for tunneled-node clients.
                               

switch(tunneled-node-server)# mode role-based reserved-vlan <VLAN-ID>
show tunneled-node-server output:
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switch(config)# show tunneled-node-server
 Tunneled Node Server Information
  State                                              : Enabled
  Primary Controller                                 : 10.0.0.1
  Backup Controller                                  : 
  Keepalive Interval (seconds)                       : 8
  Mode                                               : Role-based
  Vlan-Mode                                          : no-vlan/vlan-extend
  Reserved-VLAN                                         : reserved-VID/0

switch(config)# show vlan <reserved-vid>
VLAN ID    Name               | Status           | Voice    | Jumbo
--------------------------------------------------------------------
<VID>      PUTN-ReservedVLAN  | Port-based       | No       | No

Show commands
show user-role

Syntax
show user-role <role-name>

Description

Displays the user role information for the specified user role name.

Command context
manager or operator

Parameters
<role-name>

Specifies the user role name.

Examples

Shows the user role by specific name.

switch# show user-role testrole

 User Role Information

   Name                              : testrole
   Type                              : local
   Reauthentication Period (seconds) : 0
   Cached Reauth Period (seconds)    : 0
   Logoff Period (seconds)           : 300
   Untagged VLAN                     : 100
   Tagged VLAN                       :
   Captive Portal Profile            :
   Policy                            :
   Tunnelednode Server Redirect      : Enabled
   Secondary Role Name               : XYZ
   Device Attributes                 : Disabled

switch#

show vlan

Syntax
show vlan <reserved-vid>
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Description

Display the details of reserved VLAN ID.

Command context
manager

Parameters
<reserved-vid>

Specifies the reserved VLAN ID.

Examples

switch(config)# show vlan <reserved-vid>

Status and Counters - VLAN Information - VLAN <reserved-vid>

VLAN ID : <reserved-vid>
Name    : TUNNELED_NODE_SERVER_RESERVED
Status  : Port-based
Voice   : No
Jumbo   : No
Private VLAN : none
Associated Primary VID    : none
Associated Secondary VIDs : none

Port Information Mode     Unknown VLAN Status
---------------- -------- ------------ -----------------------

NOTE: The user will not be able to delete the reserved VLAN. Reserved VLAN will be automatically
removed once the reserved-vlan parameter is removed from tunneled-node configuration.

show tunneled-node-server

Syntax
show tunneled-node-server [information | statistics <controller> | state <controller>]

Description

Shows the tunneled-node-server information, statistics, or state.

NOTE: Information for SAC and SSAC Switch Anchor Controller (SAC), Standby Anchor Controller
(SSAC) and User Anchor Controller (UAC) is available in the ArubaOS-Switch Controller Guide at 
https://support.arubanetworks.com/.

Command context
manager or operator

Parameters
information

Specifies tunneled-node-server information, node-list, and the bucket map information.

statistics <controller>
Specifies the data plane statistics with respect to a controller for each port.
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state <controller>
Specifies the data plane state with respect to a controller.

Example

switch(config)# show tunneled-node-server

Tunneled Node Server Information

  State                        : Enabled
  Primary Controller           : 10.10.10.148
  Backup Controller            : 10.10.10.149
  Keepalive Interval (seconds) : 1
  Mode                         : Role-based
  Vlan-Mode                    : vlan-extend-disable
  Reserved-Vlan                : 1111

switch# show tunneled-node-server state

 Local Master Server (LMS) State

 LMS Type     IP Address       State        Capability Role
 Primary   :  10.10.10.148     Complete     Per User   Operational Primary
 Secondary :  10.10.10.149     Complete     Per User   Operational Secondary
 Switch Anchor Controller (SAC) State

               IP Address       Mac Address             State
 SAC         : 10.10.10.148     001a1e-037520           Registered

 User Anchor Controller (UAC) : 10.10.10.148
 User              Port       VLAN       State       Bucket ID
 00000f-000200     1/24       100        Registered  2

switch# show tunneled-node-server statistics

 Tunneled Node Statistics

 Control Plane Statistics

 SAC                  : 10.10.10.148
    Bootstrap Tx      : 1                 Bootstrap Rx         : 1
    Nodelist Rx       : 0                 Nodelist Ackd        : 0
    Bucketmap Rx      : 0                 Bucketmap Ackd       : 0
    Failover Tx       : 0                 Failover Ackd Tx     : 0
    Unbootstrap Tx    : 0                 Unbootstrap Ackd Tx  : 0
    Heartbeat Tx      : 102               Heartbeat Rx         : 102

    UAC               : 10.10.10.148
    Bootstrap Tx      : 1                 Bootstrap Ack        : 1
    Unbootstrap Tx    : 0                 Unbootstrap Ack      : 0
    Keepalive Tx      : 0                 Keepalive Ack        : 0

   Data Plane Statistics

    SAC tunnel Rx                   : 102
    MTU violation Drop              : 0
    Fragmented Packets Dropped (Rx) : 0
    Packets to Non-Existent Tunnel  : 0
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    UAC                                      Packets Tx     Packets Rx
    10.10.10.148                             5463693        331

    User Statistics

    UAC                                      User Count
    10.10.10.148                             1
When the controller is a standalone:

switch(eth-1/24)# show tunneled-node-server information

 SAC Information

  SAC : 10.10.10.148
  Standby-SAC :
UAC List Information

  Cluster Name :
  Cluster Status : Disabled

  [ 0] ::    10.10.10.148         0.0.0.0         0.0.0.0         0.0.0.0
  [ 4] ::         0.0.0.0         0.0.0.0         0.0.0.0         0.0.0.0
  [ 8] ::         0.0.0.0         0.0.0.0         0.0.0.0         0.0.0.0

 Bucket Map Information

  Bucket Name :
  Bucket Map Active : [0 .. 255]
  [  0] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [  6] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [ 12] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [ 18] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [ 24] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [ 30] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [ 36] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [ 42] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [ 48] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [ 54] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [ 60] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [ 66] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [ 72] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [ 78] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [ 84] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [ 90] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [ 96] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [102] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [108] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [114] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [120] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [126] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [132] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
When the controller is a cluster:

switch$ show tunneled-node-server information

SAC Information

  SAC : 10.10.10.147
  Standby-SAC : 10.10.10.146

UAC List Information
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  Cluster Name : 3NodeProfile
  Cluster Status : Enabled

  [0] ::    10.10.10.147    10.10.10.146         0.0.0.0         0.0.0.0
  [4] ::         0.0.0.0         0.0.0.0         0.0.0.0         0.0.0.0
  [8] ::         0.0.0.0         0.0.0.0         0.0.0.0         0.0.0.0

Bucket Map Information

  Bucket Name : TUNNELED_NODE_ESSID
  Bucket Map Active : [0 .. 255]
  [  0] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [  6] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [ 12] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [ 18] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [ 24] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [ 30] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [ 36] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [ 42] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [ 48] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [ 54] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [ 60] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [ 66] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [ 72] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [ 78] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [ 84] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [ 90] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [ 96] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [102] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [108] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [114] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [120] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [126] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [132] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [138] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [144] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [150] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [156] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [162] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)

show tunneled-node-users

Syntax
 show tunneled-node-users [all | count | down |  mac <MAC-ADDRESS> |  port <PORT-ADDR> | up ]

Description

Shows the status of a client after configuring and enabling tunneled-node-server-redirect.

Command context
manager or operator

Parameters
<ALL>

Specifies all clients and their status.
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<COUNT>

Specifies the total number of clients configured to tunnel their traffic to the controller.

<DOWN>

Specifies the clients which are not able to tunnel their traffic.

PORT <PORT-ADDR>

Specifies the port client status.

MAC <MAC-ADDRESS>

Specifies the client status based on the MAC address desired by the user.

<UP>

Specifies the status of clients with tunnels up.

Example

switch(config)# show tunneled-node-users 
 all                   Displays all the clients and their status.
 count                 Displays the total number of clients configured to 
                       tunnel their traffic to the controller.
 down                  Displays the clients which are not able to tunnel their
                       traffic.
 mac                   Displays the client status based on the MAC address 
                       desired by the user.
 port                  Displays the client status of the particular port 
                       desired by the user.
 up                    Displays the client status which are having their 
                       tunnels up and running

switch(config)# show tunneled-node-users all

PORT   MAC-ADDRESS  TUNNEL-STATUS   SECONDARY-USERROLE   FAILURE-REASON    
123      XYZ123       UP                 ROLE NAME1           
234      XYZ1234      DOWN               ROLE NAME2       UAC_DOWN
Show the total number of clients configured with the user-based tunneled-node.

switch(config)# show tunneled-node-users count

Total number of clients configured with user-based tunneled node: 2
Show the port access clients in detail.

switch# show port-access clients

Downloaded user roles are preceded by *
 Port Access Client Status

  Port  Client Name   MAC Address       IP Address      User Role         Type  VLAN
  ----- ------------- ----------------- --------------- ----------------- ----- ----
  1/7   2c41387f35b9  2c4138-7f35b9     n/a             Voice_HPE         MAC   171
  1/7   d48564940c46  d48564-940c46     n/a             *DUR_prof2_PUT... MAC   100
  1/16  dur1          001517-857121     n/a             *DUR_prof2_PUT... 8021X 100
  1/17  dur1          d48564-a8afa0     n/a             *DUR_prof2_PUT... 8021X 100
  3/7   2c41387fe7f8  2c4138-7fe7f8     n/a             Voice_HPE         MAC   171
  3/7   e8393537b4a5  e83935-37b4a5     n/a             *DUR_prof2_PUT... MAC   100
Show the detailed port-access clients for port 1/7.

switch# show port-access clients detailed 1/7
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 Port Access Client Status Detail

  Client Base Details :
   Port            : 1/7                   Authentication Type : mac-based
   Client Status   : authenticated         Session Time        : 18972 seconds
   Client Name     : 2c41387f35b9          Session Timeout     : 0 seconds
   MAC Address     : 2c4138-7f35b9
   IP              : n/a

Downloaded user roles are preceded by *
 User Role Information

   Name                              : Voice_HPE
   Type                              :
   Reauthentication Period (seconds) : 0
   Untagged VLAN                     : 171
   Tagged VLANs                      :
   Captive Portal Profile            :
   Policy                            :
   Tunnelednode Server Redirect      : Disabled
   Secondary Role Name               :

  Client Base Details :
   Port            : 1/7                   Authentication Type : mac-based
   Client Status   : authenticated         Session Time        : 18947 seconds
   Client Name     : d48564940c46          Session Timeout     : 0 seconds
   MAC Address     : d48564-940c46
   IP              : n/a

Downloaded user roles are preceded by *
 User Role Information

   Name                              : *DUR_prof2_PUTN-3037-12
   Type                              : downloaded
   Reauthentication Period (seconds) : 0
   Untagged VLAN                     : 100
   Tagged VLANs                      :
   Captive Portal Profile            :
   Policy                            : upol2_DUR_prof2_PUTN-3037-12

Statements for policy "upol2_DUR_prof2_PUTN-3037-12"
policy user "upol2_DUR_prof2_PUTN-3037-12"
     10 class ipv4 "remark2_DUR_prof2_PUTN-3037-12" action rate-limit kbps 1000000 action priority 2 action permit
   exit
Statements for class IPv4 "remark2_DUR_prof2_PUTN-3037-12"
class ipv4 "remark2_DUR_prof2_PUTN-3037-12"
     10 match ip 0.0.0.0 255.255.255.255 0.0.0.0 255.255.255.255
   exit

   Tunnelednode Server Redirect      : Enabled
   Secondary Role Name               : authenticated

Commands to configure VLAN ID in user role
Local user roles allow user-based policy configuration local to an Aruba switch. Within the user role configuration,
use the tunneled-node-server-redirect command to tunnel traffic to a Mobility Controller. When this
command is processed, the tunnel is formed and applied to the secondary role (user role) that exists on the
Mobility Controller.

switch(user-role)# vlan-id
Usage: [no] vlan-id <VLAN_ID>

Description: Set the untagged VLAN that users will be assigned to.
switch(user-role)$ tunneled-node-server-redirect
Usage: [no] tunneled-node-server-redirect [secondary-role <ROLE_NAME>]

Description: Configures traffic redirect to user-based tunnel. Secondary role is the new user role that 
will be applied to the tunneled traffic by the controller.

IMPORTANT: The authenticated secondary-role specified with the redirect attribute should be
configured and present on the Mobility Controller.

IMPORTANT: VLAN change for a current User-Based Tunneled client should be done by changing a
user role with a new untagged VLAN and doing a port bounce (to refresh client IP).
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Tunneled Node profile on a Mobility Controller and Cluster
Use the following commands to configure a secondary user role on the Mobility Controller:

switch(config)# user-role authenticated
access-list session global-sacl
access-list session apprf-authenticated-sacl
access-list session ra-guard
access-list session allowall
access-list session v6-allowall
If the managed device is in a cluster, deploy the following configuration on the Mobility Master:

lc-cluster group-profile "hp2node"
controller 10.0.102.6
controller 10.0.102.218
(ArubaMM) [mm] (config) #cd /md/00:1a:1e:02:a4:c0
(ArubaMM) [00:1a:1e:02:a4:c0] (config) #lc-cluster group-membership hp2node
(ArubaMM) [mm] (config) #cd /md/00:1a:1e:02:a6:40
(ArubaMM) [00:1a:1e:02:a6:40] (config) #lc-cluster group-membership hp2node
(ArubaMM) (config) #show configuration node-hierarchy
Default-node is not configured. Autopark is disabled.
Configuration node hierarchy
----------------------------
Config Node Type
----------- ----
/ System
/md System
/md/00:1a:1e:02:a4:c0 Device
/md/00:1a:1e:02:a6:40 Device
/mm System
/mm/mynode System

NOTE: Configure a cluster profile, specify the managed device IP addresses, and map the managed
devices to the cluster profile.

(ArubaMM) [mynode](config) #show switches
All Switches
------------
IP Address IPv6 Address Name Location Type Model Version Status Configuration State Config
Sync Time (sec) Config ID
---------- ------------ ---- -------- ---- ----- ------- ------ ------------------- ----------
------------ ---------
15.212.178.108 None ArubaMM Building1.floor1 master ArubaMM 8.0.0.0_55647 up UPDATE SUCCESSFUL
0 0
10.0.102.218 None C2 Building1.floor1 MD Aruba7210 8.0.0.0-hp-interop_0000 up UNK
(00:1a:1e:02:a6:40) N/A N/A
10.0.102.6 None C1 Building1.floor1 MD Aruba7210 8.0.0.0-hp-interop_0000 up UNK
(00:1a:1e:02:a4:c0) N/A N/A
Verify that all managed devices are added and the status is Update Successful.

Using User Roles with User-Based Tunneling
User-Based Tunnels can also be used with Local User Roles and any third-party RADIUS server. This requires
that the user roles be preconfigured on the switch. For truly colorless and dynamic policy management, Aruba
recommends the use of ClearPass to dynamically send policies to both the switch and controller using
Downloadable User Roles along with User-Based Tunneling.

• There are two roles required when using Downloadable User Roles with User-Based Tunneling:
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Primary user role: Configured on switch

Secondary user role: Configured on controller

• Both primary and secondary role can be either statically configured or downloaded from the ClearPass.

NOTE: This feature is only available for:

• ClearPass 6.7.0 onward

• Aruba Controller Version 8.3.0 onward

◦ To support Downloadable User Roles on controller, a new VSA (HP-CPPM-Seconday-Role)
is introduced in ClearPass 6.7.0, which contains the secondary user role name:

The Aruba switch downloads user policies from ClearPass using downloadable user roles. This makes the
ClearPass a centralized point to administer user policy to the access switch and minimize user configuration on
the Aruba switch. For downloadable user roles to work appropriately, the signing Certificate Authority (CA) of the
ClearPass HTTPS certificate must be added to the Aruba switch and marked as trusted. With ArubaOS-Switch
16.08, there is an automated way to download the CA certificate of ClearPass. Please refer to the Access
Security Guide on using this feature.

ClearPass Sample Configuration
aaa authorization user-role name "<role-name>" 
vlan-id <vlan id> tunneled-node-server-redirect VSA
When the primary user role is downloaded onto the switch and the secondary user role is downloaded onto the
controller:
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When the primary user role is downloaded onto the switch and the secondary user role is manually configured on
the controller (not sent through VSA):

NOTE: For more information on user roles, see Access Security Guide for ArubaOS-Switch for your
switch.

User-Based Tunneling in v6 networks
Starting with 16.08, User-Based Tunnels are supported in IPv6 environments where all the components forming
tunnels are reachable over IPv6. This is important for users who are in the process of migrating from IPv4 to IPv6-
only environments. To support those users, User-Based Tunnels will work not only in IPv6-only environments but
also hybrid environments where some components run IPv4 while others run IPv6.

The switch, controller, and AirWave can operate in an IPv6-only environment while ClearPass, as of 6.7, still has
to be reachable over IPv4 (but supports v4 and v6 clients). Mixed mode is also supported, where one controller
can be reachable through v4 and the backup controller can be reachable through IPv6, and the deployment
supports clients with dual stacks (v4/v6). Using User-Based Tunnels in a IPv6 network is similar in setup and the
configuration and show command covered in earlier sections work for IPv4 as well as IPv6 environments.

PAPI security

Protocol Application Programming Interface (PAPI)
The PAPI Enhanced Security configuration provides protection to Aruba devices, AirWave, and ALE against
malicious users sending fake messages that results in security challenges.

Starting from ArubaOS-Switch version 16.02, a minor security enhancement has been made to Protocol
Application Programming Interface (PAPI) messages. Protocol Application Programming Interface endpoint
authenticates the sender by performing a check of the incoming messages using MD5 (hash). All PAPI endpoints
— APs, Controllers, Mobility Access Switches, AirWave, and ALE — must use the same secret key. The switch
software currently uses a fixed key to calculate the MD5 digest and cooperate with the controller for PAPI
enhanced security.

NOTE: To use this functionality, the PAPI security profile must be configured on the controller. For
more information on the Aruba controller, see the Aruba Networks Controller Configuration
Manual.

PAPI configurable secret key
To support enhanced PAPI security, a command is available to configure a MD5 secret key.
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papi-security
Syntax
switch(config)# papi-security

Description

Configure MD5 key for enhanced PAPI security.

Parameters
enhanced-security

The enhanced-security CLI must be enabled in Aruba controller for the connection to be truly secured.

<KEY-STR>

Configure MD5 key for enhanced PAPI security using a key-string parameter.

<KEY-VALUE>

Configure MD5 key for enhanced papi security using a key-value parameter.

Restrictions

• To view the status of the PAPI security, using the show run command with the option include
credentials enabled, the PAPI security key will show in the output as an encrypted form.

• Key length has to be between 10-64.

• By default the enhanced-security is disabled.

• When enhanced-security mode is disabled, any AP can obtain the current shared secret key.

• When enhanced-security mode is enabled, an AP is not updated with the new shared secret key unless the AP
knows the previous key and the AP is updated with the new key within one hour of the key creation.

• Key length has to be between 10-64 or the following message will appear:

Minimum key-value length allowed is 10 characters and maximum allowed is 64 
characters.

Usage
Switch(config)# papi-security key-value <KEY-VALUE>
Switch(config)# [no] papi-security <KEY-VALUE>

papi-security key-value

Switch(config)# papi-security key-value TestKey12345678
Switch(config)# no papi-security key-value

Switch(config)# papi-security key-value Test
Minimum key-value length allowed is 10 characters and maximum allowed is 64 characters.

show run with encrypted key

 Switch(config)# show run
Running configuration:
;J9576A Configuration Editor
;Created on release #KA.16.02.0000x
;Ver #0e:01.f0.92.34.5f.3c.6b.fb.ff.fd.ff.ff.3f.ef:78
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;encrypt-cred +NXT3w7ky2IXNXadlJblS/1ZRi/o73Qq28XXcLkSCZq9PU30Kl+KMLMva8rQri5g

 hostname "Switch"
 module 1 type j9576y
 module 2 type j9576x
 encrypt-credentials
 papi-security encrypted-key <"encrypted-key">
 snmp-server community "public" unrestricted
 snmpv3 engineid "00:00:00:0b:00:00:50:65:f3:b4:a6:c0"
 oobm
 ip address dhcp-bootp
 exit

 vlan 1
 name "DEFAULT_VLAN"
 untagged 1-52
 ip address dhcp-bootp
 exit

 activate provision disable

show run with include key

show run
Running configuration:
; J9576A Configuration Editor
; Created on release #KA.16.02.0000x
; Ver#0e:01.f0.92.34.5f.3c.6b.fb.ff.fd.ff.ff.3f.ef:78

 hostname "Switch"
 module 1 type j9576y
 module 2 type j9576x
 include-credentials
 papi-security key-value <"key">
 snmp-server community "public" unrestricted
 snmpv3 engineid "00:00:00:0b:00:00:50:65:f3:b4:a6:c0"
 oobm
 ip address dhcp-bootp
 exit
 
 vlan 1
 name "DEFAULT_VLAN"
 untagged 1-52
 ip address dhcp-bootp
 exit
 
 activate provision disable

Frequently Asked Questions
Following is a list of frequently asked questions and answers relating to per user tunnel node.

In a controller cluster, how does the switch determine which controller to send the user traffic to?

The SAC sends a bucket-map to the switch during the switch bootstrap process. This map is an array of 256
entries with each entry containing the active and standby controller to use. A user’s MAC address is hashed into
this table to get the controller to tunnel the user traffic to.

When is the heartbeat started to SAC and S-SAC?

Heartbeat is over a GRE tunnel with a specific GRE key (0xDEED). This is initiated with SAC and S-SAC
immediately after a switch bootstrap is complete.

What happens when heartbeat to SAC fails?
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A heartbeat failure triggers the switch to:

• Remove users anchored to the SAC.

• Fail over to the S-SAC (Example: S-SAC now becomes the new SAC).

What happens when the keepalive to a UAC fails?

The users anchored to the UAC are removed and a message is logged to the same effect in the event log.

Why should jumbo frames be enabled at the switch?

Jumbo frames have to be enabled at the controller uplink VLAN as well as the client VLAN. The GRE tunnel adds
an effective 46 bytes to every user packet. The effective tunnel MTU = uplink VLAN MTU -46 bytes for a 1500
MTU, the tunnel MTU gets to be 1454 bytes. This means that a user can send up to only 1,454 bytes of frames. In
order for users to be able to send up to 1500 (default) MTU, jumbo frames need to be enabled.

What happens when a UAC controller goes down?

A node list update is sent by the SAC to the switch to inform that a controller went down. All users anchored to
that controller are removed (unbootstrapped). After some time, the controller sends a bucket map update to the
switch. The switch then processes the bucket map update and anchors users to the respective controller
(standby) as per the bucket map. The users will then be switched over to S-UAC The S-UAC becomes the new
UAC, and this new S-UAC is assigned after the bucket map update from SAC.

NOTE: It is important to verify that the bucket map on switch and controller is the same. Also, it
should be verified that users are anchored to the right controller identified in the bucket map on both
the switch and controller.

What happens when a SAC controller goes down?

A node list update is sent by S-SAC to switch. Since the node list is received from the S-SAC and not the SAC,
the switch considers that SAC is down and initiates a failover to S-SAC. Also, the switch removes all users
anchored to SAC. Once S-SAC acknowledges the failover request, the S-SAC becomes the new active SAC. The
new Active SAC then sends a node list update and bucket map update. In the node list update, the new S-SAC
will be provided. The switch will then bootstrap and initiate a heartbeat with new S-SAC. The switch then
processes the bucket map update and anchors users to respective controllers.

NOTE: It is important to verify that the bucket map on switch and controller is the same. Also, it
should be verified that users are anchored to the right controller identified in the bucket map on both
the switch and controller.

What happens when the S-SAC controller goes down?

A node list update is sent by the SAC to the switch. The switch stops the heartbeat with the S-SAC which has
gone down and removes all users anchored to it. The switch then initiates a bootstrap to a new S-SAC provided in
the node list update. Once a bootstrap acknowledgment is received, the switch starts a heartbeat to the new S-
SAC. After some time, the SAC will send a bucket map update. The switch then processes the update and
anchors users to their respective controllers.

NOTE: It is important to verify that the bucket map on the switch and controller is the same. Also, it
should be verified that users are anchored to the appropriate controller according to the bucket map
on both the switch and controller.

What do the states in show tunneled-node-server state mean?

• Registering - Bootstrapping

• Registered - Bootstrapped

• Unregistering – Unbootstrapping

What happens when user-role attributes change?
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A rebootstrap is initiated for users applied within that role containing updated role attributes in the bootstrap
packet. These users move to registering state. Once an acknowledgment is received from the controller, users
then move to registering state. This applies only to VLAN and secondary role changes.

What happens on a client “MAC address move”?

A rebootstrap is initiated for the client. Only after an acknowledgment from the controller is received, the client
traffic begins to be tunneled.

What is the recommendation for Per User Tunnel Node client VLAN configuration?

• Tunneled user client VLAN has to be present at the per user tunneled node switch.

• There is no need to specifically add tunneled user ports to this VLAN. Switch AAA takes care of this through
Mac-Based VLANs.

• The uplink to the controller port should NOT be part of this VLAN.

• The uplink to the controller VLAN and the tunneled users VLAN cannot be same.

A user is registered at the switch but does not respond to a ping. How do I debug?

• Check that the user roles and VLANs are correctly configured at the switch as well as the controller.

• Check that the IP MTU is set to >= (1500+46) at all the switches in the path from User-Based Tunneling switch
to the controller.

There are two parts to the solution, and the part that is not working right should be identified.

• To check if the switch is tunneling the traffic, run the show tunneled-node-server statistics
command to check if the user traffic is being received and transmitted. If the counters do not increment, then
the switch configuration needs to be investigated.

• To check if the Mobility Controller is tunneling traffic, run the show datapath tunnel to see if the Encaps
and Decaps counters increase.

A packet trace of traffic sent from and received at the switch uplink to the controller can also be useful, GRE
encapsulated packets are what will be of interest.
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The Time Domain Reflectometry (TDR) or Cable Diagnostics is a new port feature supported on Aruba 3810M
switches and Aruba 5400R v3 blades. TDR is introduced to detect cable faults on 100BASE-TX and 1000BASE-T
ports.

Supported Platforms

Aruba 2930F switches
Aruba 3810M switches
Aruba 5400R v3 blades (J9986A, J9987A, J9989A, J9990A, J9991A [applicable only for ports 1–20, rest of the
four ports are Smart Rate ports], and J9992A)

Virtual cable testing
The Virtual Cable Test (VCT) uses the same command as TDR. It is applicable only for GigT transceivers like
copper transceiver (J8177C–ProCurve Gigabit 1000Base-T Mini-GBIC). The VCT test results include distance to
the fault, but not the cable length.

Cable Diagnostics
Syntax

test cable-diagnostics <PORT-LIST>
Description

Use the command to test for cable faults.

Option
PORT-LIST

Specify copper port as a input port number.

Test cable-diagnostics C21

test cable-diagnostics C21

The 'test cable-diagnostics' command will cause a loss of link and will take a few seconds per interface to complete.
Continue [Y/N]? y

MDI         Cable    Distance    Pair   Pair        MDI
Port Pair   Status   to Fault    Skew   Polarity    Mode
---------   ------   --------    -----   ------   ------
C21 1-2       Open       0 m      0 ns
    3-6       Open       0 m      0 ns
    4-5       Open       0 m      0 ns
    7-8       Open       1 m      0 ns

Test cable-diagnostics 1/1-1/10

switch# test cable-diagnostics 1/1-1/10

This command will cause a loss of link on all tested ports and will take
several seconds per port to complete.  Use the ‘show cable-diagnostics’ command to view
 the results.

Chapter 23
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Continue (y/n)? Y

switch# show cable-diagnostics 1/1-1/10

Cable Diagnostic Status - Copper Ports

       MDI    Cable       Cable Length or
  Port Pair   Status      Distance to Fault
  ---- ------ ----------- ---------------------
  1/1  1-2    OK          5m
       3-6    OK          5m
       4-5    OK          7m
       7-8    OK          7m
  1/2  1-2    OK          7m
       3-6    OK          7m
       4-5    OK          7m
       7-8    OK          7m
  1/3  1-2    OK          5m
       3-6    OK          7m
       4-5    OK          5m
       7-8    OK          7m
  1/4  1-2    OK          7m
       3-6    OK          7m
       4-5    OK          7m
       7-8    OK          5m
  1/5  1-2    OK          4m
       3-6    OK          5m
       4-5    OK          5m
       7-8    OK          4m
  1/6  1-2    OK          4m
       3-6    OK          4m
       4-5    OK          4m
       7-8    OK          4m
  1/7  1-2    OK          5m
       3-6    OK          4m
       4-5    OK          5m
       7-8    OK          4m
  1/8  1-2    OK          4m
       3-6    OK          5m
       4-5    OK          4m
       7-8    OK          4m
  1/9  1-2    OK          5m
       3-6    OK          5m
       4-5    OK          5m
       7-8    OK          5m
  1/10 1-2    OK          7m
       3-6    OK          5m
       4-5    OK          5m
       7-8    OK          5m

Good cable tests

switch# test cable-diagnostics 51

This command will cause a loss of link on all tested ports and will take
several seconds per port to complete.  Use the 'show cable-diagnostics'
command to view the results.

Continue (y/n)? Y

switch# show cable-diagnostics 51

Cable Diagnostic Status - Transceiver Ports
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         MDI    Cable       Distance   Pair    Pair       MDI
  Port   Pair   Status      to Fault   Skew    Polarity   Mode
  ---- ------   ---------   --------   -----   -------   -----
  51     1-2      OK           0 m      8 ns   Normal     MDI
         3-6      OK           0 m      8 ns   Normal
         4-5      OK           0 m      8 ns   Normal     MDIX
         7-8      OK           0 m      0 ns   Normal

switch# test cable-diagnostics 52

This command will cause a loss of link on all tested ports and will take
several seconds per port to complete.  Use the 'show cable-diagnostics'
command to view the results.

Continue (y/n)?  Y

switch# show cable-diagnostics 52

Cable Diagnostic Status - Transceiver Ports

         MDI    Cable       Distance   Pair    Pair       MDI
  Port   Pair   Status      to Fault   Skew    Polarity   Mode
  ---- ------   ---------   --------   -----   -------   -----
  52    1-2       OK          0 m       0 ns   Normal     MDI
        3-6       OK          0 m       0 ns   Normal
        4-5       OK          0 m       0 ns   Normal     MDIX
        7-8       OK          0 m       0 ns   Normal

Faulty cable test

switch# test cable-diagnostics 51
This command will cause a loss of link on all tested ports and will take
several seconds per port to complete.  Use the 'show cable-diagnostics'
command to view the results.

Continue (y/n)?  y
switch# show cable-diagnostics 51

Cable Diagnostic Status - Transceiver Ports

       MDI    Cable       Distance   Pair   Pair       MDI
  Port Pair   Status      to Fault   Skew   Polarity   Mode
  ---- ------ ----------- ---------- ------ ---------- ------
  51    1-2    OK          0 m        0 ns
        3-6    Short       1 m        0 ns
        4-5    Short       1 m        0 ns
        7-8    OK          0 m        0 ns

switch# test cable-diagnostics 52

This command will cause a loss of link on all tested ports and will take
several seconds per port to complete.  Use the 'show cable-diagnostics'
command to view the results.

Continue (y/n)?  Y

switch# show cable-diagnostics 52
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Cable Diagnostic Status - Transceiver Ports

       MDI    Cable       Distance   Pair   Pair       MDI
  Port Pair   Status      to Fault   Skew   Polarity   Mode
  ---- ------ ----------- ---------- ------ ---------- ------
  52   1-2     Open        0 m        0 ns
       3-6     Open        0 m        0 ns
       4-5     Open        1 m        0 ns
       7-8     Open        0 m        0 ns
Error message

Error Message Cause

The transceiver on port 1/A1
does not support cable
diagnostics.

• usage of invalid(fiber-SFP+) port

• The selected range includes an entry for an invalid port.

show cable-diagnostics
Syntax
show cable-diagnostics <PORT-LIST>
Description

Use the command to generate results of completed tests on single or multiple ports. For incomplete tests, a
warning is displayed.

Option
PORT
Specify one copper port as an input port number.

clear cable-diagnostics
Syntax
clear cable-diagnostics
Description

Use the command to clear the result buffer.

Example

switch(config)# clear cable-diagnostics

Limitations
TDR has the following limitations:

• TDR length accuracy is ± 5 m

• Does not work on Smart Rate Interfaces with 10GBASE-T and NGBASE-T (2.5G, 5G copper) ports available
on:
◦ v3 blades
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– J9991A — Aruba 20-port 10/100/1000BASE-T PoE+ / 4-port 1/2.5/5/10GBASE-T PoE+ MACsec v3 zl2
Module

– J9995A — Aruba 8-port 1/2.5/5/10GBASE-T PoE+ MACsec v3 zl2 Module

◦ 3810M (JL076A — Aruba 3810M 40G 8 HPE Smart Rate PoE+ 1-slot Switch)

• Not supported on v2 zl modules

• Valid only on 100BASE-TX and 1000BASE-T ports
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An end client that gets IP address from a DHCP address will be included by default in RADIUS accounting
packets. Visibility of statically assigned IP addresses in RADIUS accounting is available with a command that
enables and disables static IP visibility for an authenticated client.

ip client-tracker
Syntax
ip client-tracker [trusted | untrusted]

no ip client-tracker [trusted | untrusted]

Description

Enables the visibility of statically and dynamically assigned IPv4 and IPv6 addresses for both authenticated and
unauthenticated clients.

The no form of this command disables the visibility of statically and dynamically assigned IPv4 and IPv6
addresses for both authenticated and unauthenticated client.

Command context
config

Parameters
trusted

Enables or disables the visibility of statically and dynamically assigned IPv4 and IPv6 addresses for
authenticated clients. The trusted option makes the feature track clients only on authentication enabled
ports (edge ports), excluding uplink ports which are not enabled for authentication with the server.

untrusted
Enables or disables the visibility of statically and dynamically assigned IPv4 and IPv6 addresses for
unauthenticated clients.

Usage

• Switch sends ARP probes when IP client tracker feature is enabled. This interval is determined by setting
arp-age timeout. By default arp-age timeout is 20 minutes however the default timeout can be
changed by using the command ip arp-age <timeout value in minutes>.

◦ The periodic ARP probe aids in detecting any change of IP addresses on end clients.

◦ Non-chatty clients that do not send packets within regular intervals get deauthenticated due to inactivity
after the logoff period. IP client tracker can be used to keep these clients in the network. The customer
must always configure the ip arp-age value to less than the configured logoff period, to avoid being de-
authenticated due to inactivity.

Chapter 24
Monitoring Static IP Devices
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• When the ip client-tracker command is executed more than once, it takes the last command's behavior.
For example when the command ip client-tracker trusted is run after the command ip client-
tracker, the behavior will follow the last command, ip client-tracker trusted.

◦ When the administrator tries to execute the no command that has not been configured (does not exist in
running configuration), an error will appear.

Example

Show port-access client with multiple addresses.

switch#  show port-access clients

Port Access Client Status

Port    Client Name    MAC Address           IP Address      User Role Type  VLAN
----   -------------- -------------- ---------------------- ---------- ----- ----
1       005056bd3ff7  005056-bd3ff7  3ffe:501:ffff:100::5e               MAC  1

Example

Show the port-access IPv4 client.

Switch-Stack(config)# show port-access clients             

 Port Access Client Status

  Port  Client Name   MAC Address   IP Address      User Role         Type  VLAN
  ----- ------------- ------------- --------------- ----------------- ----- ----
  1/3   000002b85001  000002-b85001 10.1.1.30                         MAC   10

Example

Show the port-access IPv6 client.

switch(config)# show port-access clients 22

Port Access Client Status

  Port  Client Name   MAC Address   IP Address      User Role         Type  VLAN
  ----- ------------- ------------- --------------- ----------------- ----- ----
  22    0000005daa34  000000-5daa34 n/a                               MAC   20

Example

Show the port-access client detail.

switch(config)# show port-access clients 22 detailed

Port Access Client Status Detail

  Client Base Details :
   Port            : 22                    Authentication Type : mac-based
   Client Status   : authenticated         Session Time        : 64 seconds
   Client Name     : 0000005daa34          Session Timeout     : 0 seconds
   MAC Address     : 000000-5daa34
   IP              : n/a

  Access Policy Details :
   COS Map         : Not Defined           In Limit Kbps       : Not Set
   Untagged VLAN   : 20                    Out Limit Kbps      : Not Set
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   Tagged VLANs    : No Tagged VLANs
   Port Mode       : 1000FDx
   RADIUS ACL List : No Radius ACL List
   IPV6 Address    : 2000::10

NOTE: If neither trusted nor untrusted option is configured, the feature is enabled for both
trusted (authentication enabled) and untrusted (authentication disabled) ports. Since uplink ports are
always authentication disabled, ip client-tracker command without any options starts tracking
these ports which result in tracking routed clients as well.

ip client-tracker probe-delay
Syntax
ip client-tracker probe-delay <INTERVAL>
no ip client-tracker probe-delay <INTERVAL>

Description

Enables the delay in the client tracking for static IP visibility. By default, ip client-tracker probe-delay is
disabled.

The no form of this command disables the delay in the client tracking for static IP visibility.

Command context
config

Parameter
<INTERVAL>

Specifies the delay time of static IP tracking probes from 15 to 300 seconds.

Default value is 15 seconds.

Examples

Configures the delay in the client tracking.

switch# ip client-tracker probe-delay
switch# show run
ip client-tracker
ip client-tracker probe-delay 15
exit
Configures the delay in the client tracking for 250 seconds.

switch# ip client-tracker probe-delay 250
switch# show run
ip client-tracker
ip client-tracker probe-delay 250
exit
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OOBM concepts
Management communications with a managed switch can be:

• In band—through the networked data ports of the switch

• Out of band—through a dedicated management port (or ports) separate from the data ports

Out-of-band ports have typically been serial console ports using DB-9 or specially wired 8-pin modular (RJ-style)
connectors. Some recent switches have added networked OOBM ports.

OOBM operates on a "management plane" that is separate from the "data plane" used by data traffic on the
switch and by in-band management traffic. That separation means that OOBM can continue to function even
during periods of traffic congestion, equipment malfunction, or attacks on the network. In addition, it can provide
improved switch security: a properly configured switch can limit management access to the management port
only, preventing malicious attempts to gain access via the data ports.

Network OOBM typically occurs on a management network that connects multiple switches. It has the added
advantage that it can be done from a central location and does not require an individual physical cable from the
management station to each switch's console port.

Table 35: Switch management ports

In band Out of band

Networked Directly connected Networked

Management interface Command line (CLI),
menu, Web

Command line (CLI),
menu

Command line (CLI),
menu

Communication plane Data plane Management plane Management plane

Connection port Any data port Dedicated serial or USB
console port

Dedicated networked
management port

Connector type Usually RJ-45; also CX4,
SFP, SFP+, and XFP

DB9 serial, serial-wired 8-
pin RJ

RJ-45

Advantages Allows centralized
management

Not affected by events on
data network, shows boot
sequence

Not affected by events on
data network, allows
centralized management,
allows improved security

Disadvantages Can be affected by events
on data network; does not
show boot sequence

Requires direct connection
to console port (can be
done via networked
terminal server)

Does not show boot
sequence

Chapter 25
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OOBM and switch applications
The table below shows the switch applications that are supported on the OOBM interface as well as on the data
interfaces. In this list, some applications are client-only, some are server-only, and some are both.

Application Inbound OOBM
(server)

Outbound OOBM
(client)

Inbound data plane
(server)

Outbound data
plane (client)

Telnet yes yes yes yes

SSH yes yes 1

SNMP yes yes yes yes

TFTP yes yes yes yes

HTTP yes 1 yes 1

SNTP 1 yes 1 yes

TIMEP 1 yes 1 yes

RADIUS 1 yes 1 yes

TACACS 1 yes 1 yes

DNS 1 yes 1 yes

Syslog 1 yes 1 yes

Ping yes yes yes4 yes

Traceroute yes4 yes yes4 yes

1 N/A = not applicable
2 ***=Ping and Traceroute do not have explicit servers. Ping and Traceroute responses are sent by the host stack.

For applications that have servers, oobm/data/both options have been added to listen mode. There is now a
listen keyword in the CLI commands to allow selection of those options. Default value is both for all servers.

Example
In a typical data center installation, top-of-rack switches connect servers to the data network, while the
management ports of those switches connect to a physically and logically separate management network. This
allows network administrators to manage the switches even if operation on the data network is disrupted.
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In Figure 179: Network OOBM in a data center on page 777, the switches face the hot aisle of the data
center, allowing easy connection to the network ports on the backs of the servers.

Figure 179: Network OOBM in a data center

For even more control, the serial console ports of the switches can be connected to the management network
through a serial console server (essentially, a networked serial switch), allowing the network administrators to
view the CLI activity of each switch at boot time and to control the switches through the console ports (as well as
through the management ports.)

OOBM Configuration
OOBM configuration commands can be issued from the global configuration context (config) or from a specific
OOBM configuration context (oobm.)

Entering the OOBM configuration context from the general configuration
context
Syntax

oobm
Enters the OOBM context from the general configuration context.

Example

switch(config)# oobm
Switch (oobm)#

Enabling and disabling OOBM
From the OOBM context:

Syntax

enable disable
From the general configuration context:
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Syntax

oobm enable oobm disable
Enables or disables networked OOBM on the switch.

OOBM is not compatible with either a management VLAN or stacking. If you attempt to enable OOBM when a
management VLAN is enabled or when stacking is enabled, the command will be rejected and you will receive an
error message.

If an OOBM IP address exists and you disable OOBM, the OOBM IP address configuration is maintained. If you
enable OOBM and there is a pre-existing OOBM IP address, it will be reinstated.

Network OOBM is enabled by default.

Examples

Switch (oobm)# enable
Switch (oobm)# disable
switch(config)# oobm enable
switch(config)# oobm disable

Enabling and disabling the OOBM port
The OOBM interface command enables or disables the OOBM interface (that is, the OOBM port, as opposed
to the OOBM function.)

From the OOBM context:

Syntax

interface [enable | disable]
From the general configuration context:

Syntax

oobm interface [enable | disable]
Enables or disables the networked OOBM interface (port.)

Examples

Switch (oobm)# interface enable
switch(config)# oobm interface disable

Setting the OOBM port speed
The OOBM port operates at 10 Mbps or 100 Mbps, half or full duplex. These can be set explicitly or they can be
automatically negotiated using the auto setting.

From the OOBM context:

Syntax

interface speed-duplex [10-half | 10-full | 100-half | 100-full | auto]
From the general configuration context:
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Syntax

oobm interface speed-duplex [10-half | 10-full | 100-half | 100-full | auto]
Enables or disables the networked OOBM interface (port.) Available settings are:

10-half 10 Mbps, half-duplex

10-full 10-Mbps, full-duplex

100-half 100-Mbps, half-duplex

100-full 100-Mbps, full-duplex

auto auto negotiate for speed and duplex

Example

Switch (oobm)# interface speed-duplex auto

Configuring an OOBM IPv4 address
Configuring an IPv4 address for the OOBM interface is similar to VLAN IP address configuration, but it is
accomplished within the OOBM context.

From the OOBM context:

Syntax

[no] ip address [dhcp-bootp | ip-address/mask-length]
From the general configuration context:

Syntax

[no] oobm ip address [dhcp-bootp | ip-address/mask-length]
Configures an IPv4 address for the switch's OOBM interface.

You can configure an IPv4 address even when global OOBM is disabled; that address will become effective when
OOBM is enabled.

Example

Switch (oobm)# ip address 10.1.1.17/24

Configuring an OOBM IPv4 default gateway
Configuring an IPv4 default gateway for the OOBM interface is similar to VLAN default gateway configuration, but
it is accomplished within the OOBM context.

From the OOBM context:

Syntax

[no] ip default-gateway ip-address
From the general configuration context:
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Syntax

[no] oobm ip default-gateway ip-address
Configures an IPv4 default gateway for the switch's OOBM interface.

Example

Switch (oobm)# ip default-gateway 10.1.1.1

Configuring an IPv6 default gateway for OOBM devices
An OOBM interface is used for managing devices from remote sites. OOBM devices must be given a default
gateway responsible to maintain a network connection when these devices are placed in an IPv6 network enabled
with RA suppression.

To configure and enable an IPv6 default gateway for OOBM interfaces, use the oobm ipv6 default-gateway
command.

oobm ipv6 default-gateway

Syntax
oobm ipv6 default-gateway <IPV6-ADDR>

no oobm ipv6 default-gateway

Description

Configures the IPv6 default gateway address for OOBM interfaces.

The no form of the command deletes the default gateway. It is imparative that an IPv6 address is specified when
the no form of the command is used.

Command context
config

Parameters
<IPV6-ADDR>

Specifies the IPv6 address when configuring the OOBM for a specific gateway.

Example

switch(config)# oobm ipv6 default-gateway 1001::1/64

oobm member ipv6 default-gateway

Syntax
oobm member <MEMBER-ID> ipv6 default-gateway <IPV6-ADDR>

no oobm member <MEMBER-ID> ipv6 default-gateway

Description

Configures the IPv6 default gateway address for an OOBM member using their unique identifier and the IPv6
address of the default gateway.
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When no proceeds the command, the default gateway address is deleted.

Command context
config

Parameters
<MEMBER-ID>

Specifies the unique member-id which allows the OOBM device access to the IPv6 default-gateway.
<IPV6-ADDR>

Specifies the IPv6 address of the default gateway for a member OOBM interface.

Example

Configuring and deleting the OOBM member from a specific IPv6 gateway.

switch(config)# oobm member 1 ipv6 default-gateway 1001::1

switch(config)# no oobm member 1 ipv6 default-gateway

IPv6 default router preferences
The command ipv6 nd ra router-preference {high | medium | low} provides an extension to the
Neighbor Discovery Router Advertisement messages for communicating default router preferences from routers
to hosts. The extension improves the ability of hosts to pick the appropriate router for an off-link destination. In
network topologies, where the host has multiple routers on its Default Router list, the choice of router for an off-
link destination is critical for making the communication more efficient. For example, one router may provide much
better performance than another for a destination while choosing a wrong router may result in failure to
communicate.

ipv6 nd ra router-preference

Syntax
ipv6 nd ra router-preference {low | medium | high}

no ipv6 nd ra router-preference

Description

Sets the router-preference configuration for communicating default router preferences from routers to hosts.
Improves the ability of hosts to pick the appropriate router for an off-link destination by providing options at the
operator level which set the router preference value as low, medium, or high. Depending on the router preference
value set, the host receives the value as part of the IPv6 neighbor discovery router advertisement and chooses
the best router for communication.

The no form of this command removes the router-preference configuration.

Command context
vlan

Parameters
low

Specifies the router-preference value to low.

medium
Specifies the router-preference value to medium. Medium is the default router-preference value.
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high
Specifies the router-preference value to high.

Usage

• When VRRP is configured, RA messages for Virtual IP are sent with configured router-preference values.

• This command complies with RFC 4191.

Example

Default router-preferences.

switch(vlan-1)# ipv6 nd ra router-preference
 low                   Set the Default Router Preference to low.
 medium                Set the Default Router Preference to medium (default).
 high                  Set the Default Router Preference to high.

switch(vlan-1)# ipv6 nd ra router-preference high

OOBM show commands
The show commands for OOBM are similar to the analogous commands for the data plane. Note that you must
always include the oobm parameter to see the information for the OOBM interface, regardless of the context. For
instance, even from the OOBM context, the show ip command displays the IP configuration for the data plane;
to see the IP configuration of the OOBM interface, you need to use show oobm ip.

Showing the global OOBM and OOBM port configuration
Syntax

show oobm
Summarizes OOBM configuration information. This command displays the global OOBM configuration (enabled
or disabled), the OOBM interface status (up or down), and the port status (enabled/disabled, duplex, and speed.)

You can issue this command from any context

Example

Switch# show oobm 

Global Configuration
  OOBM Enabled   : Yes
  OOBM Port Type  : 10/100TX
  OOBM Interface Status : Up
  OOBM Port   : Enabled
  OOBM Port Speed  : Auto

Showing OOBM IP configuration
Syntax

show oobm ip
Summarizes the IP configuration of the OOBM interface. This command displays the status of IPv4 (enabled/
disabled), the IPv4 default gateway, and the IPv4 address configured for the interface.
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You can issue this command from any context.

Example

Switch# show oobm ip

Showing OOBM ARP information
Syntax

show oobm arp
Summarizes the ARP table entries for the OOBM interface.

You can issue this command from any context.

Example

Switch# show oobm arp

show oobm ipv6
Syntax
show oobm ipv6

Description

Shows the IPv6 service status for OOBM interfaces.

Command context
operator

Example

Shows the IPv6 service status for OOBM interfaces.

switch# show oobm ipv6 

Internet (IPv6) Service for OOBM Interface

  IPv6 Status    : Enabled
  IPv6 Default Gateway : 1000::2

                                                               Address   Intf
 Member IP Config  IP Address/Prefix Length                    Status    Status
 ------ ---------- ------------------------------------------- --------- ------
 Global manual     1000::1/64                                            Up
 Global autoconfig fe80::42a8:f0ff:fe9e:901/64                           Up

show oobm ipv6 (for stacked switches)

Syntax
show oobm ipv6
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Description

Shows the OOBM IPv6 interface for a stacked switch.

Command context
operator

Example

Shows the OOBM IPv6 interface for a stacked switch.

stack-switch# show oobm ipv6

 Internet (IPv6) Service for OOBM Interface

  IPv6 Status    : Enabled
  IPv6 Default Gateway : 3000::2

                                                               Address   Intf
 Member IP Config  IP Address/Prefix Length                    Status    Status
 ------ ---------- ------------------------------------------- --------- ------
 Global manual     3000::1/64                                  Active    Down
 Global autoconfig fe80::42a8:f0ff:fe9b:a581/64                Active    Down
 1      manual     1000::1/64                                  Active    Down
 2      manual     2000::1/64                                  Active    Up

show oobm ipv6 member (for stacked switches)

Syntax

 show oobm ipv6 member <MEMBER-ID>
                

Description

Shows the OOBM IPv6 service detail for a specific member.

Command context
operator

Example

Shows the OOBM IPv6 service detail for a specific member.

stack-switch# show oobm ipv6 member 2

 Internet (IPv6) Service for OOBM Interface

  IPv6 Status    : Enabled
  IPv6 Default Gateway : 1000::1

                                                               Address   Intf
 Member IP Config  IP Address/Prefix Length                    Status    Status
 ------ ---------- ------------------------------------------- --------- ------
 2      manual     1000::2/64                                  Active    Up
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show oobm ip detail (for stacked switches)

Syntax
show oobm ip detail

Description

Shows the OOBM IP detail for a stacked switch.

Command context
operator

Example

Show the OOBM IP detail for a stacked switch.

stack-switch# show oobm ip detail

 Internet (IP) Service for OOBM Interface

Global Configuration

  IPv4 Status    : Enabled
  IPv6 Status    : Enabled

  IPv4 Default Gateway : 3.3.3.1
  IPv6 Default Gateway : 3000::1

 Origin     | IP Address/Prefix Length                    Status
 ---------- + ------------------------------------------- -----------
 manual     | 3.3.3.2/24                                  preferred
 manual     | 3000::2/64                                  preferred
 autoconfig | fe80::42a8:f0ff:fe9b:a581/64                preferred

Member 1

  IPv4 Status    : Enabled
  IPv6 Status    : Enabled

  IPv4 Default Gateway : 2.2.2.1
  IPv6 Default Gateway : 2000::1

 Origin     | IP Address/Prefix Length                    Status
 ---------- + ------------------------------------------- -----------
 manual     | 2.2.2.2/24                                  preferred
 manual     | 2000::2/64                                  preferred

Member 2

  IPv4 Status    : Enabled
  IPv6 Status    : Enabled

  IPv4 Default Gateway : 1.1.1.1
  IPv6 Default Gateway : 1000::1

 Origin     | IP Address/Prefix Length                    Status
 ---------- + ------------------------------------------- -----------
 manual     | 1.1.1.2/24                                  preferred
 manual     | 1000::2/64                                  preferred
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Application server commands
Application servers (as described in OOBM and server applications in OOBM concepts on page 775) have
added a listen keyword with oobm|data|both options to specify which interfaces are active.

Default value is both for all servers.

Syntax

telnet-server [listen {oobm | data | both}]
Syntax

ip ssh [listen {oobm | data | both}]
Syntax

snmp-server [listen {oobm | data | both}]
Syntax

tftp server [listen {oobm | data | both}]
Syntax

web-management [listen {oobm | data | both}]
In all cases, show running-config displays the server configurations.

Use the no form of the command to prevent the server from running on either interface.

Examples

Telnet: no telnet-server
SSH: no ip ssh …
SNMP: no snmp-server …
TFTP: no tftp server
HTTP: no web-management …
The show servers command shows the listen mode of the servers:

Switch# show servers
Server listen mode

Server   Listen mode
-----------------------------
Telnet        | both
Ssh         | both
Tftp        | both
Web-management | both
Snmp        | both

Application client commands
CLI commands for client applications have added the oobm keyword to allow you to specify that the outgoing
request be issued from the OOBM interface. If you do not specify the oobm keyword, the request will be issued
from the appropriate in-band data interface. Command syntax is:
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Telnet:

telnet ip-address [oobm]
TFTP:

copy tftp ... ip-address filename... [oobm]
SNTP:

[no] sntp server priority priority ip-address [oobm] [version]
TIMEP:

[no] ip timep [dhcp | manual ip-address | [oobm]]
RADIUS:

[no] radius-server host ip-address [oobm]
TACACS+:

[no] tacacs-server host ip-address [oobm]
DNS:

[no] ip dns server-address priority priority ip-address [oobm]
Syslog:

[no] logging ip-address [[control-descr] | [oobm]]
Ping:

ping [...] [source [ip-address | vlan-id | oobm]]
Traceroute:

traceroute [...][source [ip-address|vlan-id|oobm]] Management and Configuration Guide

Example

Figure 180: Example data center on page 788 shows setup and use of network OOBM using the commands
described above.
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Assume that the figure below describes how you want to set up your data center.

Figure 180: Example data center

Assume that you are configuring the switch in the left-hand rack to communicate on both the data and
management networks. You might do the following:

• Configure an IP address on the data network.

• Verify that out-of-band management is enabled. (It is enabled by default.)

• Configure an IP address on the management network.

• Verify that the switch can communicate on both networks.

The CLI commands that follow would accomplish those tasks. (The first time through the process you might easily
make the omission shown near the end of the example.)

Switch 41# config
Switch 41(config)# vlan 1
Switch 41(vlan-1)# ip address 10.1.129.7/20        Set up IP address on data network.
Switch 41(vlan-1)# end                                  Exit back to manager context.
Switch 41# show oobm                              Look at default OOBM configuration.

Global Configuration
  OOBM Enabled   : Yes
  OOBM Port Type  : 10/100TX
  OOBM Interface Status : Up                              Defaults look appropriate.
  OOBM Port   : Enabled
  OOBM Port Speed  : Auto

Switch 41# config
Switch 41(config)# oobm                                      Go to OOBM context and
Switch 41(oobm)# ip address 10.255.255.41/24                     add IP address and
Switch 41(oobm)# ip default-gateway 10.255.255.1                    default gateway.
Switch 41(oobm)# end                                   Exit back to manager context.
Switch 41# ping 10.1.131.44              Ping server in this rack (on data network.)
10.1.131.44 is alive, time = 19 ms
Switch 41# ping 10.1.131.51                            Ping server in adjacent rack.
10.1.131.51 is alive, time = 15 ms
Switch 41# ping 10.255.255.42                          Ping switch in adjacent rack.
The destination address is unreachable.        Oops! It’s on the management network.
Switch 41# ping source oobm 10.255.255.42             Go through the management port
10.255.255.42 is alive, time = 2 ms                               and it works fine.
Switch 41#
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Networking Websites
Hewlett Packard Enterprise Networking Information Library

www.hpe.com/networking/resourcefinder

Hewlett Packard Enterprise Networking Software

www.hpe.com/networking/software

Hewlett Packard Enterprise Networking website

www.hpe.com/info/networking

Hewlett Packard Enterprise My Networking website

www.hpe.com/networking/support

Hewlett Packard Enterprise My Networking Portal

www.hpe.com/networking/mynetworking

Hewlett Packard Enterprise Networking Warranty

www.hpe.com/networking/warranty

General websites
Hewlett Packard Enterprise Information Library

www.hpe.com/info/EIL

For additional websites, see Support and other resources.

Chapter 26
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Accessing Hewlett Packard Enterprise Support
• For live assistance, go to the Contact Hewlett Packard Enterprise Worldwide website:

http://www.hpe.com/assistance

• To access documentation and support services, go to the Hewlett Packard Enterprise Support Center website:

http://www.hpe.com/support/hpesc

Information to collect

• Technical support registration number (if applicable)

• Product name, model or version, and serial number

• Operating system name and version

• Firmware version

• Error messages

• Product-specific reports and logs

• Add-on products or components

• Third-party products or components

Accessing updates
• Some software products provide a mechanism for accessing software updates through the product interface.

Review your product documentation to identify the recommended software update method.

• To download product updates:

Hewlett Packard Enterprise Support Center
www.hpe.com/support/hpesc

Hewlett Packard Enterprise Support Center: Software downloads
www.hpe.com/support/downloads

Software Depot
www.hpe.com/support/softwaredepot

• To subscribe to eNewsletters and alerts:

www.hpe.com/support/e-updates

• To view and update your entitlements, and to link your contracts and warranties with your profile, go to the
Hewlett Packard Enterprise Support Center More Information on Access to Support Materials page:

www.hpe.com/support/AccessToSupportMaterials

Chapter 27
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IMPORTANT: Access to some updates might require product entitlement when accessed through
the Hewlett Packard Enterprise Support Center. You must have an HPE Passport set up with
relevant entitlements.

Customer self repair
Hewlett Packard Enterprise customer self repair (CSR) programs allow you to repair your product. If a CSR part
needs to be replaced, it will be shipped directly to you so that you can install it at your convenience. Some parts
do not qualify for CSR. Your Hewlett Packard Enterprise authorized service provider will determine whether a
repair can be accomplished by CSR.

For more information about CSR, contact your local service provider or go to the CSR website:

http://www.hpe.com/support/selfrepair

Remote support
Remote support is available with supported devices as part of your warranty or contractual support agreement. It
provides intelligent event diagnosis, and automatic, secure submission of hardware event notifications to Hewlett
Packard Enterprise, which will initiate a fast and accurate resolution based on your product's service level.
Hewlett Packard Enterprise strongly recommends that you register your device for remote support.

If your product includes additional remote support details, use search to locate that information.

Remote support and Proactive Care information
HPE Get Connected

www.hpe.com/services/getconnected
HPE Proactive Care services

www.hpe.com/services/proactivecare
HPE Proactive Care service: Supported products list

www.hpe.com/services/proactivecaresupportedproducts
HPE Proactive Care advanced service: Supported products list

www.hpe.com/services/proactivecareadvancedsupportedproducts

Proactive Care customer information
Proactive Care central

www.hpe.com/services/proactivecarecentral
Proactive Care service activation

www.hpe.com/services/proactivecarecentralgetstarted

Warranty information
To view the warranty information for your product, see the links provided below:

HPE ProLiant and IA-32 Servers and Options
www.hpe.com/support/ProLiantServers-Warranties

HPE Enterprise and Cloudline Servers
www.hpe.com/support/EnterpriseServers-Warranties

HPE Storage Products
www.hpe.com/support/Storage-Warranties

HPE Networking Products
www.hpe.com/support/Networking-Warranties
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Regulatory information
To view the regulatory information for your product, view the Safety and Compliance Information for Server,
Storage, Power, Networking, and Rack Products, available at the Hewlett Packard Enterprise Support Center:

www.hpe.com/support/Safety-Compliance-EnterpriseProducts

Additional regulatory information

Hewlett Packard Enterprise is committed to providing our customers with information about the chemical
substances in our products as needed to comply with legal requirements such as REACH (Regulation EC No
1907/2006 of the European Parliament and the Council). A chemical information report for this product can be
found at:

www.hpe.com/info/reach

For Hewlett Packard Enterprise product environmental and safety information and compliance data, including
RoHS and REACH, see:

www.hpe.com/info/ecodata

For Hewlett Packard Enterprise environmental information, including company programs, product recycling, and
energy efficiency, see:

www.hpe.com/info/environment

Documentation feedback
Hewlett Packard Enterprise is committed to providing documentation that meets your needs. To help us improve
the documentation, send any errors, suggestions, or comments to Documentation Feedback
(docsfeedback@hpe.com). When submitting your feedback, include the document title, part number, edition,
and publication date located on the front cover of the document. For online help content, include the product
name, product version, help edition, and publication date located on the legal notices page.
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Chassis Redundancy (5400R Switches)
Overview of chassis management redundancy
Some switches provide high availability through the use of hot-swappable, redundant management modules. In
the event of a failure on the active management module, management module redundancy allows a quick and
unattended transition from the active management module to the standby management module. The standby
management module now becomes the active management module. Management module redundancy keeps the
switch operating and reduces network downtime.

The advantages of redundant management are:

• Maintaining switch operation if a hardware failure occurs on the active management module

• Minimizing restart time caused by the failure of a management module

• Hotswapping a failed management module with no downtime

Nonstop switching with redundant management modules
Beginning with software version K.15.01, you can use either nonstop switching or warm-standby redundant
management.

The advantages of nonstop switching are:

• Quick, seamless transition to the standby management module; no reboot is necessary

• Switching of packets continues without interruption

How the management modules interact
When the switch boots up, the management modules run selftest to decide which is the active module and which
is the standby module. The module that becomes active finishes booting and then brings up the interface modules
and ports.

If you are using nonstop switching mode, the standby management module is synced continuously with the active
management module so that all features and config files are the same on both management modules. The
standby management module is ready to become the active management module. If the active management
module fails or if there is a manual switchover, switching continues without interruption.

If you are using warm-standby mode, the standby module boots to a certain point, syncs basic files such as the
config and security files, and finishes booting only if the active management module fails or you choose to change
which module is the active module.

The two management modules communicate by sending heartbeats back and forth.

About using redundant management
The CLI commands for redundant management are shown at the beginning of the chapter. Additionally, other
commands are affected by redundant management.
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Transition from no redundancy to nonstop switching
While the switch is transitioning from no redundancy mode to nonstop switching mode, no configuration changes
are allowed. The management modules are syncing information during the transition period.

About setting the rapid switchover stale timer
After a failover has occurred, use the rapid switchover stale timer to set the amount of time that you want route
and neighbor table entries to be re-added to the FIB on the active management module.

Layer 3 applications and protocols rely on existing routing information in the FIB. They restart and operate as if
the switch performed a quick reset.

When a failover occurs, the interface modules and the fabric modules continue forwarding Layer 3 traffic based on
the information in the FIB. The transitioning standby management module marks all routes in the FIB as "stale".
The routing protocols restart, reestablish their neighbors and reconverge. As a route is added in again, the route's
stale designation is removed. After the rapid switchover stale timer expires, the remaining stale route entries are
removed. Multicast flows are also removed; the multicast application re-adds the flows after failover completes.

About directing the standby module to become active
To make the standby management module become the active management module, use the redundancy
switchover command. The switch will switchover after all files have finished synchronizing.

In nonstop switching mode:

• The switchover occurs quickly and seamlessly; no reboot is needed.

• There is no interruption in switching operations.

In warm-standby mode:

• The switchover may take several minutes if there have been recent configuration file changes or if you have
downloaded a new operating system.

• The standby module finishes booting and becomes the active module.

The formerly active module becomes the standby module if it passes selftest.

Preferred management module
NOTE: ArubaOS-54XXR platform only

On a 54xxR chassis with the ability to support two management modules, one of the management modules can
be persistently set as Active management module through a redundancy preferred-management-module
command.

• A preferred-active-module may be configured by command to retain its role as an Active module under
both hard power cycle and soft reboot scenarios.

• In the case of a failure of a preferred-active-module, the Standby management module takes over and
becomes new Active management module.

• The preferred-active-module is seen as configured in the show running config command.
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redundancy active-management
Syntax
redundancy active-management {management-module1 | management-module2 | standby}

Description

Specifies the management module that will become active at the next boot.

Command context
config

Parameters
management-module <1> | <2>

Specifies the redundant management module to enable.

standby
Specifies the standby management module.

Restrictions

The redundancy active-management command will fail if the other module is in a failed state or if VSF is
enabled.

Usage
redundancy rapid-switchover <Seconds>

Specifies the rapid-switchover timer in seconds for L3 Hitless forwarding when used as a parameter for
redundancy.

management-module
The selected active management module will continue as the active management module on boot until the
user issues the command redundancy active-management which then changes the selected module.

redundancy switchover
Instructs the switch to immediately switch over to the standby management module.

Example

Show redundancy for management module.

Switch(config)# show redundancy

Configured Mode: Nonstop Switching 
Current Mode   : Nonstop Switching

Rapid Switchover Stale Timer : 90
Failovers     : 0
Last Failover : 
Preferred Active Management: management-module1

Slot Module Description                       State    SW Version    Boot Image
---- ---------------------------------------- -------- ------------- ----------
MM1  J9827A Management Module 5400Rzl2        Active   KB.16.02.0014 Primary  
MM2  J9827A Management Module 5400Rzl2        Standby  KB.16.02.0014 Primary
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redundancy preferred-active-management
Syntax
redundancy preferred-active-management {management-module1 | management-module2}

no redundancy preferred-active-management {management-module1 | management-module2}

Description

Configures priority to specified management-module to be active management module across multiple boots.
Command does not change management module roles instantaneously and would require a reboot for
configuration to come into effect.

The no form of this command removes the configuration for the preferred-active-management module.

NOTE: The command redundancy preferred-active-management requires a reboot for the
configuration to change.

Command context
config

Parameters
management-module <1> | <2>

Configures selected management module as an active management module across multiple reboots.

Restrictions

• The command redundancy preferred-active-management is mutually exclusive with VSF. The
preferred-management-module must be disabled to enable VSF on an ArubaOS-switch.

• When a preferred module taking over as an Active module fails, a fail-over to another management module will
occur. User intervention must rectify the cause for the failure or if a chassis reboot is attempted, the attempt
may fail. In the case of a boot, there will be an extra redundancy switchover.

Example

Configuring preferred active management module.

switch(config)# redundancy preferred-active-management management-module1

switch(config)# show running config

Running configuration

; J9851A Configuration Editor; Created on release #KB.16.03.0000x
; Ver #0f:7f.ff.bb.ff.7c.59.fc.7b.ff.ff.fc.ff.ff.3f.ef:45
hostname "Switch"
module B type j9993a
module G type j9987a
redundancy preferred-active-management management-module1
snmp-server community "public" unrestricted
oobm
   ip address dhcp-bootp
   exit
vlan 1
   name "DEFAULT_VLAN"
   untagged B1-B8,G1-G24
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   ip address dhcp-bootp
   exit

CLI warnings in response to preferred-active-management command

CLI Warnings Scenario

Active-management
cannot be set when
preferred-active-
management is enabled.
Unconfigure before
attempting to set active-
management.

The command active-management is mutually
exclusive with existing redundancy active-
management command.

Preferred-active-
management
configuration overrides
active-management
configuration.

If redundancy active-management is set and user
attempts to configure preferred-active-
management a warning message displays when
configuring redundancy preferred-active-
management.

NOTE: Once set, there is no way to
unconfigure active-management setting.

VSF cannot be enabled
when preferred-active-
management is enabled.
Un-configure before
attempting to enable
VSF.

The command preferred-active-management is
mutually exclusive with VSF configuration.

NOTE: No warning/error message would be
displayed upon ports being configured as
part of VSF.

show redunancy
Syntax
show redundancy

Description

Displays the status of the management and fabric modules.

Command context
config

Examples

Shows the redundancy of the switch for an active management module.

switch(config)# show redundancy

Configured Mode: Nonstop Switching 
Current Mode   : Nonstop Switching

Rapid Switchover Stale Timer : 90
Failovers     : 0
Last Failover : 
Preferred Active Management: management-module1
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Slot Module Description                       State    SW Version    Boot Image
---- ---------------------------------------- -------- ------------- ----------
MM1  J9827A Management Module 5400Rzl2        Active   KB.16.02.0014 Primary  
MM2  J9827A Management Module 5400Rzl2        Standby  KB.16.02.0014 Primary  

Determining active module
Both management modules run selftest routines to determine which module becomes the active management
module and which becomes the standby management module. The module that was last active in the chassis is
given precedence and becomes the "active" module. This module is the one that is booted going forward. If a
module fails selftest and is unable to communicate with the other module, it does not take control as the
management module. The other management module takes control and becomes the active module.

If both modules fail selftest, the fault LED flashes and neither module is operational.

NOTE:

You are not allowed to switchover to a management module that is not in standby mode. The module
must have passed selftest and be in standby mode.

The entire boot decision process works as follows:

1. If there is only one management module, that is the active management module.

2. If one module is already booted and operational, a newly inserted module or the other management module
booting always becomes the standby module. The standby module does not become active unless a
switchover occurs.

3. If there are two management modules and one fails selftest, the one that passes selftest becomes the active
management module.

4. If only one of two modules was ever booted in the chassis, that module is given precedence.

5. The module that was active on the last boot becomes the active management module. This guarantees that
the active module has the latest configuration data.

6. If both management modules have previously booted in this chassis and were "active" the last time booted, the
module that booted most recently becomes the active management module.

7. If none of the above conditions are applicable, the module in the lowest slot becomes the active management
module.
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Diagram of the decision process
Figure 181: Active module decision flow chart at boot

Hotswapping management modules
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Hotswapping out the active management module

1. On the management module to be hotswapped out, press the MM Shutdown button. It is located between the
Module Operation and Component Status LEDs. (See Figure 182: The MM Shutdown button on page
800.)

Figure 182: The MM Shutdown button

2. The Dwn LED to the right of the MM Shutdown button begins flashing green. File synchronization will
complete before shutdown occurs.

3. The standby module takes control and the switchover occurs. It is now the active management module.

4. The Dwn LED on the management module being hotswapped out turns green and all other LEDs go out when
it is OK to remove the module.

5. The module being hotswapped out goes into offline mode. In the offline mode, the module cannot take over
when the active module fails over.

NOTE:

If you remove the active management module without pressing the MM Shutdown button, any files
that may have been in the process of synchronizing will not finish synchronizing to the standby
module and all file transfer is aborted.

Management module switchover

Events that cause a switchover
There are a number of events that can cause the active management module to switchover to the standby
management module when management module redundancy is enabled:

• The active management module crashes

• The standby management module does not receive a heartbeat from the active management module

• The redundancy switchover command is executed

• The MM Reset button on the active management module is pressed

• The MM Shutdown button on the active management module is pressed

• The boot or boot active command is executed

• The reload command is executed

• There is a hardware failure on the active management module
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In all of these cases, the standby management module takes control and performs the actual switchover. The
reason for the switchover is entered in log messages on the newly active management module and to any
configured Syslog servers.

What happens when switchover occurs
When a switchover occurs, the features that support nonstop switching continue to operate in an uninterrupted
manner. See Nonstop switching features on page 828 for a list of the supported features.

The features that do not support nonstop switching perform as if the switch had just finished booting; however, no
actual boot time occurs.

NOTE:

When meshing configuration changes are made on a redundant management system, you must
execute write mem and then the boot system command to boot both management modules for
the changes to be activated.

Meshing is not supported by nonstop switching.

NOTE:

If the switch is a querier and a failover occurs, the querier continues to be the same on the standby
management module; no new querier election process occurs on the standby management module.

When switchover will not occur
There are some events for which a switchover is not triggered:

• When a boot system command is executed

• When the Clear button on the System Support module is pressed

• When management module redundancy is disabled, unless there is a hardware failure and the system is
rebooted.

When a management module crashes while the other management module is rebooting
If the uncommon situation occurs where the active management module (MM1) is trying to reboot and the
standby management module (MM2) also crashes, the switch attempts to recover from the crash and eventually
the standby management module becomes the active management module if it passes self-test. However, traffic
can be disrupted for as long as five minutes before the newly active management module (MM2) has finished
rebooting.

Hotswapping out the active management module
You can hotswap out the active management module and have switch operations taken over by the standby
management module by following the correct shutdown procedure on the active module using the MM Shutdown
button. When the MM Shutdown button is pressed, any file synchronization in progress completes before the
shutdown begins, and then a graceful shutdown of that management module occurs.

When the standby module is not available
If you have disabled management module redundancy with the no redundancy management-module
command, or the standby module failed selftest, the Dwn LED does not turn green to indicate it is OK to hotswap
out the active management module.
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NOTE:

If you remove the active management module without pressing the MM Shutdown button, any files
that may have been in the process of synchronizing will not finish synchronizing to the standby
module and all file transfer is aborted.

Hotswapping in a management module
If another management module is hotswapped in while there is an active management module booted up, the
newly hotswapped management module becomes the standby module.

No negotiating is needed as to which module becomes the active management module, because there is already
a functioning active management module. However, the following conditions must be met to determine if the
hotswapped module can become a standby management module:

• The hotswapped module must pass selftest

• Management module redundancy is not administratively disabled (using the no redundancy management-
module command.) If the active management module's config file has redundancy administratively disabled,
the hotswapped management module goes into "offline" mode.

In nonstop switching mode—The active management module's files and features are synced with the standby
management module. Heartbeats are sent back and forth, and the standby management module is ready to
quickly take over in the event of a switchover or a failure on the active management module.

In warm-standby mode—The standby management module partially boots up and heartbeats are sent back and
forth with the active management module.

Software version mismatch between active and hotswapped module
If the software version in the hotswapped module does not match the software version in the active module, the
following occurs:

Procedure

1. The active module sends the primary and secondary images in flash to the hotswapped module.

2. The module that was hotswapped in then reboots if necessary to primary or secondary flash, whichever
matches (if it does not already match.)

3. After the hotswapped management module finishes booting, it is sent the config and other critical files from the
active management module.

4. The hotswapped management module goes into standby mode and is ready to take over in case of a
switchover.

NOTE: After the boot standby
command is executed, if the software versions on the active management module and the standby
management module are not compatible, the standby module does not sync with the active
management module. The standby module then enters warm-standby redundancy mode.

Other software version mismatch conditions
The following steps describe the behavior that may when a new software image is installed in secondary flash of
the AMM and a redundancy switchover command is executed.
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1. A new software image, K.15.04.0002 containing ROM upgrade K.15.12 is installed in secondary flash of the
AMM/MM1.

2. The AMM/MM1 automatically syncs the images to the secondary flash in the SMM/MM2. Now both AMM/MM1
and SMM/MM2 have identical software and ROM in secondary flash.

3. The SMM/MM2 is booted from secondary. It boots into the new K.15.04.0002 software version. The new ROM
is applied and the SMM/ MM2 reboots.

4. After the SMM/MM2 finishes rebooting, it reconnects to the AMM/MM1 and prepares to take the standby role
by rebooting.

5. However, the AMM/MM1 is running software version K.15.03.0008 in its primary flash, and the SMM/MM2 is
running software version K.15.04.0002 in its secondary flash, so the SMM/MM2 pauses its reboot because of
the software mismatch.

6. If a redundancy switchover command is executed, the AMM/MM1 will give control to the SMM/MM2,
which can then finish booting and become the new AMM/MM2. This is the warm-start behavior.

7. The SMM/MM1 (former AMM/MM1) reboots, but unless the reboot is executed from secondary flash, it reboots
into primary flash, which contains the older software version K.15.03.0008 with no ROM upgrade.

8. If the SMM/MM1 is forced to boot from secondary before executing the redundancy switchover
command, it will boot into the new K.15.04.0002 software and upgrade the ROM. After the reboot that occurs
with the ROM upgrade, the SMM/MM1 connects to the new AMM/MM2 and takes the standby role.

About turning off redundant management

Disable management module redundancy with two modules present
To troubleshoot a suspect management module, you may want to operate the switch with redundant management
disabled by entering this command:

switch# no redundancy management-module
After executing this command, the second management module will not boot into standby mode—it is offline and
no longer receives configuration file changes from the active module. The active management module updates its
config file with the information that redundancy is disabled.

NOTE:

Even if redundancy has been disabled, the specified management module becomes the active
management module at the next system boot if you use the redundancy active-management
command. You are warned that you may not be using current configurations. See Setting the active
management module for next boot on page 812.

The second management module is enabled as the active management module in the event of a
hardware failure of the first management module.
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Figure 183: Results of disabling redundancy on page 804 shows that redundant management was disabled.

Figure 183: Results of disabling redundancy

Disable management module redundancy with only one module present
If you disable redundancy when there is only one management module in the switch, and then you insert a
second management module, the second module never goes into standby mode. You must re-enable redundant
management using this command:

switch# redundancy management-module
The currently active module remains active on boot (assuming no selftest failure) unless you make the newly
inserted management module active using this command:

switch# redundancy active-management standby
The standby management module becomes the active management module.

Active management module commands

Viewing modules
The show modules command displays information about all the modules in the switch, as well as additional
component information for the following:

• System Support Modules (SSM)—identification, including serial number

• Mini-GBICS—a list of installed mini-GBICs displaying the type, "J" number, and serial number (when available)

Syncing commands
The following CLI commands can be executed during initial syncing between the active management module and
the standby management module, which occurs when the standby module is inserted or after a reboot of the
system. All other CLI commands will not be executed until after the initial syncing completes.

During initial syncing, no SNMP set requests are executed, except the SNMP request for ping.
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Operator commands

dir menu traceroute6
enable ping dbgstack
exit ping6 wireless-services
link-test show services
logout traceroute

Manager commands

boot system copy running-config page
boot active copy startup-config print
boot standby copy event-log redo
configure copy core-dump reload
copy command-output recopy repeat
copy config tftp display task-monitor
copy config xmodem end telnet
copy crash-data getMIB terminal
copy crash-log kill walkMIB
copy flash tftp licenses write-terminal
copy flash xmodem log redundancy

Using the WebAgent for redundant management
The WebAgent can be used to display information about the active and standby management modules.

Online Help is available for the WebAgent, which you can open by clicking on the question mark (?) in the upper
right corner of any of the WebAgent screens. An example redundancy screen is shown in Figure 184: Example
of redundancy screen in the WebAgent on page 806.

To access the redundancy information in the WebAgent:
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1. In the WebAgent navigation panel, click System.

2. Click Redundancy. The following screen displays.

Figure 184: Example of redundancy screen in the WebAgent

Enabling or disabling redundant management
There are two modes for management module redundancy—warm standby mode (the default) and Nonstop
switching mode. In warm-standby mode, the active management module does not sync continuously with the
standby management module. The standby management module boots to a certain point, syncs basic files, and
only finishes booting if the active management module fails or you choose to change which module is the active
management module. The transition is not seamless or immediate.

In Nonstop switching mode, the standby management module is synced continuously with the active
management module so that all features and config files are the same on both management modules. The
standby management module is ready to become the active management module. The transition is quick and
seamless; switching continues without interruption.

Syntax

[no] redundancy management-module [nonstop-switching]
Allows enabling or disabling of redundant management. The current active module continues to be the active
module on boot unless you use the redundancy active-management command to enable redundant
behavior.

(Default: Warm-standby redundancy mode)

The nonstop-switching parameter sets the redundancy mode to Nonstop switching.

You are prompted with "All configuration files and software images on the off-line management module will be
overwritten with the data from the current active management module. During initial syncing from active to
standby management module configuration changes are disallowed. Do you want to continue [y/n]?"

When the nonstop-switching option is not selected, the switch enters warm-standby redundancy mode.

You are prompted with "All configuration files and software images on the off-line management module will be
overwritten with the data from the current active management module. Do you want to continue [y/n]?"

The no version of the command disables redundant management. You are prompted with this message: "The
other management module may reboot and it will no longer be used for system redundancy, except in the case of
a hardware failure of the active management module. Do you want to continue [y/n]?".
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Example

The redundancy management-module command in Figure 185: Enabling warm-standby redundancy on
page 807 shows warm-standby redundant management being enabled. The show redundancy command
displays "Mgmt Redundancy" as warm-standby redundancy enabled . Management Module 1 (MM1) is the
active management module and Management Module 2 (MM2) is the standby management module.

Figure 185: Enabling warm-standby redundancy

The redundancy management-module command in Figure Figure 186: Enabling nonstop-switching
redundancy on page 807 shows Non-stop switching redundant management being enabled. The show
redundancy command displays "Mgmt Redundancy" as Nonstop switching enabled . Management Module 1
(MM1) is the standby management module and Management Module 2 (MM2) is the active management module.

Figure 186: Enabling nonstop-switching redundancy

The no version of the redundancy management-module command is used to disable management module
redundancy on the switch, as seen in Figure 187: Disabling redundancy on page 808. The show
redundancy command displays "Mgmt Redundancy" as Nonstop switching disabled . The standby
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management module in slot MM1 is now offline. The management module in slot MM2 remains the active
management module.

NOTE: Hewlett Packard Enterprise recommends that you leave management module redundancy
enabled. If the active management module has a hardware failure, the standby module may take
over and may have an old configuration since file synchronization has not occurred when
management module redundancy was disabled.

The no redundancy management-module command allows you to shut down a management module that is
not functioning correctly without physically removing the module. If you want to remove the module, first perform
the shutdown procedure as explained in Hotswapping out the active management module on page 800 and
then remove the module.

Figure 187: Disabling redundancy

The redundancy management-module command shows Nonstop switching redundant management being
enabled. The show redundancy command displays “Mgmt Redundancy” as Nonstop switching enabled.
Management Module 1 (MM1) is the standby management module and Management Module 2 (MM2) is the
active management module.

Example

Enabling non-stop switching redundancy.

switch# redundancy management-module nonstop-switching
All configuration files and software images on the off-line management module
will be overwritten with the data from the current active management module.
During initial syncing from active to standby management module configuration
changes are disallowed. Do you want to continue [y/n]? y
switch# show redundancy
Settings
--------
Mgmt Redundancy : Nonstop switching enabled
Rapid Switchover Stale Timer : 0
Statistics
----------
Failovers : 0
Last Failover :
Slot Module    Description               Status   SW Version    Boot Image
---- ----------------------------------  ------   ----------    ------------
MM1  J9092A Management Module 8200zl     Standby  K.15.01.000x  Primary
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MM2  J9092A Management Module 8200zl     Active   K.15.01.000x  Primary
FM1  J9093A Fabric Module 8200zl         Enabled 
FM2  J9093A Fabric Module 8200zl         Enabled 
The no version of the redundancy management-module command is used to disable management module
redundancy on the switch, as seen in Figure 7-4. The show redundancy command displays “Mgmt Redundancy”
as Nonstop switching disabled. The standby management module in slot MM1 is now offline. The management
module in slot MM2 remains the active management module.

NOTE: Hewlett Packard Enterprise recommends that you leave management module redundancy
enabled. If the active management module has a hardware failure, the standby module may take
over and may have an old configuration since file synchronization has not occurred when
management module redundancy was disabled.

The no redundancy management-module command allows you to shut down a management module that is
not functioning correctly without physically removing the module. If you want to remove the module, first perform
the shutdown procedure as explained in “Hotswapping Out the Active Management Module” on page 7-25, and
then remove the module.

Example

Disabling redundancy:

switch# no redundancy management-module
The other management module may reboot and it will no longer be used for system
redundancy except in the case of a hardware failure of the active management
module. Do you want to continue[y/n]? y
switch# show redundancy
Settings
--------
Mgmt Redundancy : Nonstop switching disabled
Rapid Switchover Stale Timer : 0
Statistics
----------
Failovers : 1
Last Failover : Tue Mar 19 12:42:31 2009
Slot   Module     Description               Status   SW Version   Boot Image
----   ---------  ------------------------  -------  -----------   ------------
MM1    J9092A     Management Module 8200zl  Offline  K.15.01.000x  Primary
MM2    J9092A     Management Module 8200zl  Active   K.15.01.000x  Primary
FM1    J9093A     Fabric Module 8200zl      Enabled
FM2    J9093A     Fabric Module 8200zl      Enabled

Transitioning from no redundancy to nonstop switching
While the switch is transitioning from no redundancy mode to Nonstop switching mode, no configuration changes
are allowed. The management modules are syncing information during the transition period.

Setting the Rapid Switchover Stale Timer
Use the Rapid Switchover Stale Timer to set the amount of time that you want route and neighbor table entries to
be re-added to the Forwarding Information Base on the active management module after a failover has occurred.

Layer 3 applications and protocols rely on existing routing information in the FIB. They restart and operate as if
the switch performed a quick reset.

When a failover occurs, the interface modules and the fabric modules continue forwarding Layer 3 traffic based on
the information in the FIB. The transitioning standby management module marks all routes in the FIB as “stale”.
The routing protocols restart, reestablish their neighbors and reconverge. As the routes are added in again, the
route’s stale designation is removed. After the Rapid Switchover Stale Timer expires, the remaining stale route
entries are removed. Multicast flows are also removed; the multicast application re-adds the flows after failover
completes.
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Syntax

redundancy rapid-switchover <0-36000>
Allows configuration of a timer (in seconds) for Layer 3 forwarding of packets when Nonstop switching is
configured for redundancy. After failover, the route and neighbor entries in the Forwarding Information Base (FIB)
on the active management module are marked as stale. As new routes are added, the stale flag is reset. This
continues for the number of seconds indicated by the timer, after which all remaining stale entries (entries not re-
added) are removed.

A setting of zero indicates that no Layer 3 Nonstop switching behavior is wanted.

When the switch fails over, the FIB entries and corresponding hardware entries are removed. Default: 90 seconds

To display information about stale FIB routes, enter the show tech route stale command. The VLAN ID and
IP route are shown, as well as other information used only for technical support.

Directing the standby module to become active
To make the standby management module become the active management module, use the redundancy
switchover command. The switch will switchover after all files have finished synchronizing.

In Nonstop switching mode:

The switchover occurs quickly and seamlessly. No reboot is needed.

There is no interruption in switching operations.

In warm-standby mode:

• The switchover may take a couple of minutes if there have been recent configuration file changes or if you
have downloaded a new operating system.

• The standby module finishes booting and becomes the active module.

The formerly active module becomes the standby module if it passes selftest.

Syntax

redundancy switchover
Causes a switchover to the standby module.

For Nonstop switching, the warning displays:A nonstop switching failover will occur; L2
operations will not be interrupted. This management module will now reboot and will
become the standby module! You will need to use the other management module’s
console interface. Do you want to continue [y/n]?
In warm-standby mode the warning displays:A warm failover will occur; all networking
operations will be interrupted. This management module will now reboot and will
become the standby module! You will need to use the other management module’s
console interface. Do you want to continue [y/n]?
If management module redundancy has been disabled, or there is no standby module, or the standby module is
not in standby mode, this message displays:The other management module does not exist or is
not in standby mode An example of the

redundancy switchover
command when the switch is in Nonstop switching mode is shown in the example below.
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Example

Redundancy switchover command when in nonstop switching mode.

switch# redundancy switchover
A nonstop switching failover will occur; L2 operations will not be interrupted.
This management module will now reboot and will become the standby
module! You will need to use the other management module's console interface.
Do you want to continue [y/n]? y
This management module will now boot from the primary image and will
become the standby module! You will need to used the other management module’s
console interface. Do you want to continue [y/n]? y
ROM information:
Build directory: /sw/rom/build/bmrom(t2g)
Build date: Oct 15 2009
Build time: 08:24:27
Build version: K.15.01
Build number: 13040
Select profile (primary):
Booting Primary Software Image...
...
Standby Console>

Directing the standby module to become active
Syntax

redundancy switchover
Causes a switchover to the standby module.

For nonstop switching, the warning displays: "A nonstop switching failover will occur; L2 operations will not be
interrupted. This management module will now reboot and will become the standby module! You will need to use
the other management module's console interface. Do you want to continue [y/n]?"

In warm-standby mode the warning displays: "A warm failover will occur; all networking operations will be
interrupted. This management module will now reboot and will become the standby module! You will need to use
the other management module's console interface. Do you want to continue [y/n]?"

If management module redundancy has been disabled, or if there is no standby module, or if the standby module
is not in standby mode, this message displays:

The other management module does not exist or is not in standby mode
Example
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Figure 188: The redundancy switchover command when in nonstop switching mode on page 812 shows
an example of the redundancy switchover command when the switch is in nonstop switching mode.

Figure 188: The redundancy switchover command when in nonstop switching mode

Setting the active management module for next boot
Syntax

redundancy active-management [management-module1 | management-module2 | standby]
The specified module becomes the active management module at the next system boot. This message
displays:On the next system boot, the module specified will become active.
This command does not take effect if the standby management module has failed selftest.

management-module1 Configures management-module 1 as the active management module for
the next system boot.

management-module2 Configures management-module 2 as the active management module for
the next system boot.

standby Configures the current standby module as the active management module
for the next system boot if management module redundancy is enabled. If
redundancy is disabled, it becomes enabled as a standby module at the next
boot or failover event.

If the specified management module is not there or is in failed mode, this message displays:

The specified module is not present or is in failed state.
Example
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Figure 189: Setting a management module to be active on the next boot on page 813 shows an example of
setting management module 2 to be the active management module.

Figure 189: Setting a management module to be active on the next boot

If management module redundancy has been disabled and you specify the standby module with the active-
management command, upon rebooting, the offline module becomes the standby module. The state of
redundancy (enabled or disabled) is based on the value in the configuration file in the offline (now standby)
module. The configuration files have not been synchronized if management module redundancy has been
disabled. An example of making the offline management module become the standby management module when
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redundancy is disabled is shown in Figure 190: Showing the results of switching to standby module when
redundancy is disabled on page 814.

Figure 190: Showing the results of switching to standby module when redundancy is disabled

Resetting the management module
The MM Reset button, shown in Figure 191: The MM Reset button on the management module on page
815, found on each management module reboots its management module. If the management module is active
and management module redundancy is enabled, switchover occurs. The standby management module is
notified immediately. It then takes over and becomes the active management module. If the MM Reset button is
pressed on the standby management module, that module reboots but no other switch operations are affected.
The active management module remains in control.

If management module redundancy is disabled, the active management module reboots and remains in control,
as long as it passes selftest.

814 Aruba 3810 / 5400R Management and Configuration Guide for
ArubaOS-Switch 16.08

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4552



CAUTION:

Hewlett Packard Enterprise does not recommend using the MM Reset button to trigger a switchover.
Files being copied over at the time of the reset will be aborted.

Figure 191: The MM Reset button on the management module

Viewing management information
Syntax

show modules [details]
Displays information about the installed modules, including:

• The slot in which the module is installed

• The module description

• The serial number

• The status

• Core dump

• Model Version

Additionally, the part number (J number) and serial number of the chassis is displayed.

Example

Status and Counters - Module Information
Chassis: 8212zl J9091A         Serial Number:   LP713BX004
Allow V1 Modules:   Yes
                                   Core  Mod
 Slot Module Description                     Serial Number  Status   Dump  Ver
 ---- -------------------------------------- -------------- -------- ----- ---
MM1   J9092A Management Module 8200zl     sg844bp012     Active   NO    1
SSM   J9095A System Support Module        SG911BZ00N
FM1   J9093A Fabric Module 8200zl         SG911BQ015     Enabled  -     1
FM2   J9093A Fabric Module 8200zl         SG911BQ04T     Enabled  -     1
A     J9536A 20p GT PoE+/2p SFP+ v2 zl... SG0607T124     Up       YES   2
B            Enh Svs v2 zl Module                        Up       YES   2
C     J8702A 24p Gig-T zl Module                         Up       NO    1
D     J9840A Adv Svs v2 zl Module         ID3ZG6N008     Up       YES   2
E     J8705A Gig-T/SFP zl Module                         Up       NO    1
F     J9857A Adv Svs v2 zl Module         SG2ZFNX166     Up       YES   2
G     J8708A 4p 10G CX4 zl Module                        Up       NO    1
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H     J9154A Services zl Module           SG811GG01N     Up       NO    1
I     J9051A Wireless Edge Services zl... SG660ZB095     Up       NO    1
J     J9545A ONE Adv Svs zl Module        SG9604P933     Up       NO    1
K     J9051A Wireless Edge Services zl... 1111           Up       NO    1
L     J9154A Services zl Module           SG811GG01M     Up       NO    1

Viewing information about the management and fabric modules
The show redundancy command displays information about the management and fabric modules. It displays
the flash image last booted from, even if the boot set-default command has been set to change the flash
booted from on the next boot.

Example

Figure 192: show redundancy command

Viewing information about the redundancy role of each management
module
The show redundancy command with the detail option displays information about the redundancy role of
each management module, as well as statistical information such as how long the module has been up.

Example

Figure 193: show redundancy detail command
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Viewing which software version is in each flash image
The show flash command displays which software version is in each flash image. The Default Boot field
displays which flash image will be used for the next boot.

Example

Figure 194: show flash command

Viewing system software image information for both management modules
The show version command displays system software image information for both management modules, as
well as which module is the active management module and which is the standby management module. The Boot
Image field displays which flash image last booted from, even if the boot set-default command has been set
to change the flash booted from on the next boot. The output of the show version command when redundancy
is enabled is shown in Figure 195: show version command when redundancy is enabled on page 817.

Example

Figure 195: show version command when redundancy is enabled

When redundancy is disabled, the output of the show version command changes, as shown in Figure 196:
show version command when redundancy is disabled on page 817.

Example

Figure 196: show version command when redundancy is disabled
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Viewing the status of the switch and its management modules
The show logging command displays the status of the switch and its management modules. See Displaying
module events on page 825. To show log messages in reverse chronological order (most recent messages
displayed first), enter show log -r.

Example

Figure 197: show log command output

Standby management module commands
The standby management module, by design, has very little console capability. You can use three commands—
show flash, show version, and show redundancy. The show redundancy command displays when a
management module is in standby mode.

Viewing redundancy status on the standby module
Use the show redundancy command to display redundancy status on the standby module, as shown in Figure
198: show redundancy command for standby module on page 819. This command displays the flash image
last booted from, even if the boot set-default command has been set to change the flash booted from on the
next boot.
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Example

Figure 198: show redundancy command for standby module

Viewing the flash information on the standby module
Use the show flash command to display the flash information on the standby module, as shown in Figure 199:
show flash command for standby module on page 819. The Default Boot field displays which flash image
will be used for the next boot.

Example

Figure 199: show flash command for standby module

Viewing the version information on the standby module
Use the show version command to display the version information on the standby module, as shown in Figure
200: show version command for standby module on page 819. The Boot Image field displays which flash
image was last booted from, even if the boot set-default command has been set to change the flash booted
from on the next boot. Unlike executing the show version command on an active management module, this
command shows only the running version of software on the standby management module.

Example

Figure 200: show version command for standby module
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Setting the default flash for boot
You can set which flash image to boot from as the default image on boot by using this command:

Syntax

boot set-default flash [primary | secondary]
Sets the flash image to boot from on the next boot.

primary Boots the primary flash image.

secondary Boots the secondary flash image.

Example

Figure 201: boot set-default command defaulting to secondary flash on page 820 shows an example of the
output when the command is used to set the boot default to secondary flash.

Figure 201: boot set-default command defaulting to secondary flash

Booting the active management module from the current default flash
Use the reload command to boot the active management module from the current default flash (You can change
the default flash with the boot set-default command. See Setting the default flash for boot on page 820.)
Switchover occurs if redundancy is enabled and the standby management module is in standby mode. If
redundancy is disabled or the standby management module is not present, the reload command boots the
system.

NOTE: The reload command is a "warm" reboot; it skips the Power on Self Test routine.

Syntax

reload <cr>
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Boots (warm reboot) the active management module. Switchover to the standby management module occurs if
management module redundancy is enabled. If redundancy is disabled or if there is no standby management
module, the reload command boots the system.

NOTE: If the running config file is different from the stored config file, you are prompted to save
the config file. The reload at/after versions of this command do not display a prompt to save
configuration file changes: the changes are lost on the scheduled reload.

Example

Figure 202: reload command with redundancy enabled

boot command
In redundant management systems, the boot or boot active command causes a switchover to the standby
management module as long as the standby module is in standby mode. This message displays:

This management module will now reboot and will become the
standby module! You will need to use the other management
module's console interface. Do you want to continue [y/n]?
If you select y, switchover is initiated by the standby management module, which becomes the active
management module after boot completes.

If the standby module is not in standby mode (for example, it is in failed mode or offline mode), switchover to the
standby module does not occur. The system is rebooted and this message displays:

The other management module is not in standby mode and this
command will not cause a switchover, but will reboot the
system, do you want to continue [y/n]?
If the other management module is not present in the switch, the system simply reboots.

The boot command has these options.
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Command Action

boot cr Reboots the active management module from the flash image that is
specified for the default boot. This can be changed with the boot
set-default flash command. You can select which image to
boot from during the boot process itself. (See Figure 203: The
management module rebooting, showing boot profiles to select
on page 822.) The switch will switchover to the standby
management module.

NOTE: This is changed from always booting from
primary flash. You are prompted with a message, which
indicates the flash being booted from.

boot active Boots the active management module. The switch starts to boot from
the default flash image. You can select which image to boot from
during the boot process itself. (See Figure 203: The management
module rebooting, showing boot profiles to select on page
822.) The switch will switchover to the standby management
module. If a second management module is not present in the switch,
the system is rebooted.

boot standby Boots the standby management module. The switch does not
switchover.If the standby module is not present, this message
displays: "The other management module is not present."

boot system [flash [primary | 
secondary]]

Boots both the active and standby management modules. You can
specify the flash image to boot from.

boot set-default flash 
{primary | secondary}

Sets the default flash for the next boot to primary or secondary. You
see this message:"This command changes the location of the default
boot. This command will change the default flash image to boot from
flash chosen>. Hereafter, ‘reload' and ‘boot' commands will boot from
flash chosen>. Do you want to continue [y/n]?"

You can select a boot profile during the reboot process, as shown in Figure 203: The management module
rebooting, showing boot profiles to select on page 822. If you make no selection, the boot defaults to the
image displayed as the default choice (shown in parentheses.)

Figure 203: The management module rebooting, showing boot profiles to select
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An example of the boot command with the default flash set to secondary is shown in Figure 204: Showing
boot command with default flash set to secondary on page 823.

Figure 204: Showing boot command with default flash set to secondary

CAUTION:

For a given reboot, the switch automatically reboots from the startup-config file assigned to the
flash (primary or secondary) being used for the current reboot. The startup-default command
can be used to set a boot configuration policy. This means that both the flash image and one of the
three configuration files can be specified as the default boot policy.

Boot and reload commands with OSPFv2 or OSPFv3 enabled
It is now possible to gracefully shut down OSPFv2 or OSPFv3 routing on switches without losing packets that are
in transit. OSPF neighbors are informed that the router should not be used for forwarding traffic, which allows for
maintenance on the switch without interrupting traffic in the network. There is no effect on the saved switch
configuration

Prior to a switch shutdown, the CLI/SNMP reload command or the CLI boot command is executed to initiate
the sending of OSPF "empty Hello list" messages on the interfaces that are part of the OSPF routing
configuration. After a small delay (approximately 2 seconds) that allows the messages to be transmitted on all
applicable interfaces the boot or reload command continues.

Modules operating in nonstop mode
When a switch is in standalone mode and OSPF routing is enabled, the "empty Hello list" is transmitted whenever
the boot or reload command is executed.

When the switch is operating in nonstop switching mode (redundant), and a single module is being reloaded or
booted, the standby module notifies neighboring switches of the management module failover. If the failover fails,
the "empty Hello list" is transmitted before the switch is rebooted.

When a switch is operating with multiple management modules in warm standby mode, the "empty Hello list" is
sent when a reload or boot command is executed. The standby management module sends out OSPF Hello
packets after becoming the active management module.

Additional commands affected by redundant management
The other existing commands operate with redundant management as shown below.
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Command Action

auto-tftp If a new image is downloaded using auto-tftp, the active
management module downloads the new software version to both the
active and standby modules. Rebooting after the auto-tftp
completes reboots the entire system.

banner The banner will not been seen on the standby module, only the active
module.

chassislocate If the management module performs a switchover, the LED does not
remain lit.

clear The clear crypto command causes public keys to be deleted
from both modules when the second module is in standby mode.

console Console settings, such as mode, flow-control, and baud-rate, are the
same on both management modules. There cannot be individual
settings for each management module.

copy Files are automatically sync'd from the active management module to
the standby management module.When no parameter is specified
with the copy crash-data or copy crash-log command, files
from all modules (management and interface) are concatenated.

NOTE: If redundancy is disabled or the standby module
failed selftest, the copy command affects only the
active management module.

copy core-dump [mm | standby 
| flash | xmodem | usb 
filename]

The copy core-dump standby flash command copies the
standby management module's coredump to the active management
module's flash. The destination file is fixed as dumpM1.cor or
dumpM2.cor, depending on which module is the standby
management module.The

copy core-dump [mm | standby | flash | xmodem | 
usb <filename>]
command copies the core file of the active management module or
the standby management module to a USB flash drive or to an
xmodem host.

core-dump management-module Enables or disables a core dump on a management module.

crypto Authentication files for ssh or the https server are copied to the
standby management module. The clear crypto command
deletes the public keys from both modules when the second module
is in standby mode.

erase flash Erases the software version on the active and standby modules. If
redundancy has been disabled, or if the standby module has not
passed selftest, the flash is not erased on the standby module.

Table Continued
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Command Action

erase config Erases the config file on the active and standby modules. If
redundancy has been disabled, or if the standby module has not
passed selftest, the config file is not erased on the standby module.

erase startup-config Affects both modules if the second module is in standby mode. If
redundancy has been disabled, or if the standby module has not
passed selftest, the startup-config file is not erased on the
standby module.

fastboot When fastboot is enabled, this information is saved to the standby
management module when the config files are sync'd. The fastboot
value is used during the next boot on both modules.

front-panel-securityfactory-
reset password-clear password-
recovery

This command and its options affect only the active management
module.

kill Does not affect the console on the standby module.

log Log messages from a formerly active management module are
available on the current active management module after a
switchover.

password (set
or clear)

Affects only the active management module until a switchover occurs,
at which time it affects the new active module.

startup-default Affects both modules. The config file is immediately sent to the
standby module and also becomes the default on that module when
the next boot occurs.

update Affects only the active module. The standby may become the active
module when the updated active module is booted.

write A write memory updates the config file in flash on the active
module. The file is then sync'd to the standby module.

Displaying module events

Viewing log events
The log file displays messages about the activities and status of the management modules. Enter this command
to display the messages:

Syntax

show logging [-a, -b, -r, -s, -t, -m, -e, -p, -w, -i, -d, command, filter, option-str]
Displays log events.

The event messages are tagged with the management module state and the management module slot (AM1 or
AM2, SM1 or SM2.) Synchronization is maintained by syncing the standby management module log events with
the active management module. In this way, events are available for both management modules. Only the active
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management module events are shown unless you select the -s option. This option works like the -a option,
except that the events for both the active management module and standby management module are displayed.

Example

Figure 205: Log file listing

Copying crash file information to another file
Crash logs for all modules are always available on the active management module. You can use the copy
crash-log and copy crash-data commands to copy the information to a file of your choice.

Syntax

copy crash-log [slot-id | mm] tftp ip-address filename
Copies the crash logs of both the active and standby management modules to a user-specified file. If no
parameter is specified, files from all modules (management and interface) are concatenated.

slot-id Retrieves the crash log from the module in the specified slot.

mm Retrieves the crash logs from both management modules and
concatenates them.

Syntax

copy crash-data [slot-id | mm] tftp ip-address filename
Copies the crash data of both the active and standby management modules to a user-specified file. If no
parameter is specified, files from all modules (management and interface) are concatenated.
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slot-id Retrieves the crash data from the module in the specified slot.

mm Retrieves the crash data from both management modules and
concatenates them.

Viewing saved crash information
Syntax

show boot-history
Displays the system boot log.

Example

Figure 206: The system boot log file

Enabling and disabling fabric modules
The fabric modules can be enabled or disabled even if they are not present in the switch. You cannot disable both
fabric modules at the same time; one must be enabled.

Use this command to enable or disable the redundant fabric modules. Disabling one fabric module reduces the
overall switching capacity of the series switches. On some networks where network utilization is less than 50%,
you may not notice any degradation of performance.

Syntax

redundancy fabric-module [1 | 2] [enable | disable]
Allows enabling or disabling of fabric modules. (You cannot have both fabric modules disabled at the same time.)

Default: Both fabric modules are enabled.

NOTE:

The redundant fabric modules do not support nonstop switching.
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Example

Figure 207: Disabling a fabric module

Nonstop switching features
Nonstop switching features are synced at initialization of the standby management module.

802.1X and Web/MAC authenticationMAC Lockout/
LockdownACLs/Qos PoliciesPower over EthernetPort
SecurityDHCP SnoopingDynamic ARP
ProtectionDynamic IP Lockdown

Spanning Tree (MSTP)GVRPLoop
ProtectionLACPSyslogUDLDVirus ThrottlingLLDP

Nonstop switching with VRRP
When Nonstop VRRP is enabled, VRRP continues to operate in its current state when a failover from the AMM to
the SMM occurs. This provides an additional layer of redundancy in a switched network. VRRP state information
is maintained between MMs so that VRRP operations resume immediately after failover from the AMM to SMM.
Because of this quick resumption of operations there is no failover to the backup VRRP router in the network. The
Master VRRP router continues to be active and operate as is.

The command for enabling Nonstop mode for VRRP must be executed in VRRP context.

Syntax

(vrrp#) [no] nonstop
Enabling Nonstop VRRP allows the VRRP router to retain control of IP addresses when the AMM fails over. The
VRRP Backup router does not take control of the virtual IP addresses on the network.

The no version of the command disables Nonstop VRRP.

When Nonstop behavior is disabled, failure of the AMM on the VRRP Master results in the VRRP Backup router
taking control of the virtual IP addresses on the network.

The commands must be executed in VRRP context.

NOTE:

Before this command is executed, the command redundancy management nonstop-
switching should be configured. Any prerequisites required for VRRP configuration commands,
such as IP routing being enabled, remain as required prerequisites.

Default: Disabled
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Example

Example of enabling nonstop switching for VRRP and then displaying the output

This example shows nonstop VRRP being enabled. The show vrrp config command output displays the
enabled status (see bold line below.)

switch(vlan-10-vrid-1)# nonstop
switch(vlan-10-vrid-1)# show vrrp config

VRRP Global Configuration Information

VRRP Enabled  : Yes
Traps Enabled : Yes
Virtual Routers Respond to Ping Requests : Yes
VRRP Nonstop Enabled: Yes

VRRP Virtual Router Configuration Information

Vlan ID : 10
Virtual Router ID : 1

Administrative Status [Disabled] : Enabled
Mode [Uninitialized] : Backup
Priority [100] : 150
Advertisement Interval [1] : 1
Preempt Mode [True] : True
Preempt delay time : 0
Respond to Virtual IP Ping Requests [Yes] : Yes
Primary IP Address : Lowest

IP Address      Subnet Mask
--------------- ---------------
10.0.202.87     255.255.0.0

Example nonstop routing configuration

Example of configuring the owner routing switch

 Switch C(config#) ip routing
 Switch C(config#) router vrrp
 Switch C(vrrp)# enable
 Switch C(vrrp)# vlan 201
 Switch C(vlan-201)# untag a1-a10
 Switch C(vlan-201)# ip address 20.0.0.1/24
 Switch C(vlan-201)# vrrp vrid 1
 Switch C(vlan-201-vrid-1)# owner
 Switch C(vlan-201-vrid-1)# virtual-ip-address 20.0.0.1/24
 Switch C(vlan-201-vrid-1)# enable

Example of configuring the backup routing switch

 Switch D(config#) ip routing
 Switch D(config#) router vrrp
 Switch D(vrrp)# enable
 Switch D(vrrp)# vlan 201
 Switch D(vlan-201)# untag a1-a10
 Switch D(vlan-201)# ip address 20.0.0.2/24
 Switch D(vlan-201)# vrrp vrid 1
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 Switch D(vlan-201-vrid-1)# backup
 Switch D(vlan-201-vrid-1)# virtual-ip-address 2.1.1.1/24
 Switch D(vlan-201-vrid-1)# enable
The configuration is shown graphically in Figure 208: Example of nonstop routing configuration on page
830.

Figure 208: Example of nonstop routing configuration

Nonstop forwarding with RIP
On a Nonstop RIP router, the traffic does not get re-routed when the MM fails over. A request packet is sent on
failover that asks for the router’s peers to send routing updates to the requesting router. There is no loss of routed
traffic.

Nonstop forwarding with OSPFv2 and OSPFv3
On a Nonstop OSPFv2 router, failover of a MM does not result in the OSPF v2 router being removed from the
OSPFv2 domain. A restart request is sent by the Nonstop OSPFv2 router to the neighboring OSPFv2 routers,
after which the graceful restart process begins. This behavior applies to OSPFv3 as well.

A graceful restart allows an OSPF routing switch to stay on the forwarding path while being restarted. The routing
switch sends “grace LSAs” that notify its neighbors that it intends to perform a graceful restart. During the
configurable grace period, the restarting switch’s neighbors continue to announce the routing switch in their LSAs
as long as the network topology remains unchanged. The neighbors run in “helper mode” while the routing switch
restarts.

Graceful restart will fail under these conditions:

830 Aruba 3810 / 5400R Management and Configuration Guide for
ArubaOS-Switch 16.08

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4568



• There is a topology change during the graceful restart period. The helper switches exit helper mode and
adjacencies are lost until the restarting switch rebuilds the adjacencies.

• The neighbor switches do not support helper mode.

NOTE:

• Configure router-id or IPv4 loopback address for OSPFv3 Non-Stop Forwarding to work on the
switch.

• For OSPF nonstop switching to work without traffic loss (after switchover), redundancy rapid-
switchover time should be greater than(~10secs) restart interval time of OSPF.

For more information on OSPFv2 and OSPFv3 graceful restart, see RFC 3623 and RFC 5187.

Enabling nonstop forwarding for OSPFv2
The routing switch must be in ospf context when enabling Nonstop forwarding for OSPFv2. To enable Nonstop
forwarding, enter this command.

Syntax

(ospf)# [no] nonstop
Enables nonstop forwarding for OSPFv2.

The no version of the command disables nonstop forwarding.

The commands must be executed in ospf context.

Default: Disabled

Example of enabling nonstop forwarding for OSPFv2

switch(ospf)# nonstop

Configuring restart parameters for OSPFv2
Syntax

(ospf)# [no] restart interval 1-1800 [strict-lsa-checking]
Specify the graceful restart timeout interval in seconds.

The no version of the command sets the restart parameters to the default values.

Default: Disabled

interval 1–1800
The graceful restart timeout interval (grace period) in seconds. Default: 120 seconds

strict-lsa-checking
Used in OSFPv2 context to enable or disable strict LSA operation in a network segment for a neighboring
router that is attempting a graceful restart. When enabled, this operation halts Helper mode support if a
change in LSAs (topology change) is detected during the neighbor’s restart period.

The no form of this command disables strict LSA operation.

Default: Strict LSA operation enabled
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Viewing OSPFv2 nonstop forwarding information
To display the status of Nonstop forwarding information, enter the show ip ospf general command.

Example of output showing status of nonstop forwarding for OSPFv2

switch# show ip ospf general

OSPF General Status

OSPF protocol  :enabled
Router ID      :10.10.10.80
.
.
.
Nonstop forwarding : Enabled
Graceful Restart Interval : 500
Graceful Restart Helper Mode : Enabled
.
.
.

Enabling nonstop forwarding for OSPFv3
The routing switch must be in ospf3 context when enabling Nonstop forwarding for OSPFv3. To enable nonstop
forwarding, enter this command.

Syntax

(ospf3)# [no] nonstop
Enables nonstop forwarding for OSPFv3.

The no version of the command disables nonstop forwarding.

The commands must be executed in ospf3 context.

Default: Disabled

Example of enabling nonstop forwarding for OSPFv3

switch(ospf3)# nonstop

Configuring restart parameters for OSPFv3
Syntax

(ospf3)# [no] restart interval 1-1800 [strict-lsa-checking]
Specify the graceful restart timeout interval in seconds.

The no version of the command sets the restart parameters to the default values. Default: Disabled

interval 1-1800
The graceful restart timeout interval (grace period) in seconds. Default: 120 seconds

strict-lsa-checking
Used in OSFPv3 context to enable or disable strict LSA operation in a network segment for a neighboring
router that is attempting a graceful restart. When enabled, this operation halts Helper mode support if a
change in LSAs (topology change) is detected during the neighbor’s restart period.
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The no form of this command disables strict LSA operation.

Default: Strict LSA operation enabled

Viewing OSPFv3 nonstop forwarding information
To display the status of Nonstop forwarding information, enter the show ipv6 ospf3 general command.

Example of output showing status of nonstop forwarding for OSPFv3

switch# show ipv6 ospf3 general

OSPFv3 General Status

 OSPFv3 protocol  :enabled
 Router ID      :10.10.10.80
.
.
.
 Nonstop forwarding : Enabled
 Graceful Restart Interval : 500
 Graceful Restart Helper Mode : Enabled
.
.
.

About downloading a new software version

File synchronization after downloading
After downloading a new software version to either the primary or secondary flash of the active management
module, the software version is immediately copied to the corresponding flash (primary or secondary) of the
standby module, unless the standby module failed selftest or redundancy was disabled with the no redundancy
management-module command.

The configuration files, including which configuration file to use for that flash image, are synchronized. For
example, if the active management module is using config1, the standby module is also synchronized to use
config1.

Table 36: Example of upgrading software version K.15.01.0003 to version K.15.01.0004

Newer code to secondary flash New code to primary flash

Active MM Standby MM Active MM Standby MM

Software version
downloaded to
Primary flash image

K.15.01.0003 K.15.01.0003 K.15.01.0004 K.15.01.0004

Software version
downloaded to
Secondary flash
image

K.15.01.0004 K.15.01.0004 K.15.01.0003 K.15.01.0003

After installing the new software to the active management module, wait a few minutes, and then verify that the
standby management module has been synchronized with the new software as well (use the show flash
command.) If the default flash for boot is set correctly, you can start the standby management module on the new

Appendix A Chassis Redundancy (5400R Switches) 833

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4571



software by executing the boot standby command. This does not interrupt current switch operations yet. After
the standby management module has rebooted and is ready for takeover in standby mode (you can verify this
using the show redundancy command.) you can now switch over to the management module running the
newer software with this command:

Switch# redundancy switchover
This causes a switchover to the management module that received the new software version, which becomes the
active management module. This method incurs the least amount of network downtime for booting. If downtime is
not an issue, use the boot system command. Both management modules are then running the new software
version.

Potential software version mismatches after downloading
When a new software version is downloaded to the active management module, it is immediately copied to the
corresponding flash (primary or secondary) in the standby management module, unless redundancy has been
disabled. If the standby management module is rebooted, it will be running a different software version than the
active management module. You can direct the standby module to boot from the non-corresponding flash image
that has a different software version during the actual reboot process of the standby module when the prompt to
select the Boot Profile appears, as shown in Figure 209: Booting the standby management module to
secondary flash on page 834.

Figure 209: Booting the standby management module to secondary flash

CAUTION:

If you have booted one module out of primary flash and one module out of secondary flash, and the
secondary flash is running a prior software version because the latest version was never copied over
from the primary flash, you will have a software version mismatch. The configuration file may not
work with that software version.

The standby module enters warm-standby redundancy mode and boots to a certain point, syncs
basic files such as the config and security files, and finishes booting only if the active management
module fails or you choose to change which module is the active module..

Additionally, if a switchover occurs, or if you reboot to make the standby module become the active
module, any configuration file changes made may not work on the active module if it has a different
software version from the standby module.
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When you enter the show redundancy command and a software version mismatch exists, a warning message
is displayed, as shown at the bottom of Figure 210: Example of a software version mismatch between the
active and standby modules on page 835.

Figure 210: Example of a software version mismatch between the active and standby modules

Downloading a software version serially if the management module is
corrupted
If the software version on a management module becomes corrupted, you may need to do a serial download to
restore the affected module. The non-corrupted management module becomes the active module. You can then
use the serial port on the corrupted management module to download a new software version. When the
corrupted module is rebooted, the software version in the corrupted module is immediately overwritten by the
software version in the active management module. Both management modules should now operate on the same
software version.

Unsupported zl modules
ZL modules/controllers that do not support the nonstop switching feature include the following:

• HPE ONE Services zl Module (J9289A)

• HPE Threat Management Services zl Module (J9155A)

• HPE Threat Management Services zl Module with 1-year IDS/IPS subscription (J9156A)
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• HPE Wireless Edge Services zl Module (J9051A) and Redundant Wireless Services zl Module (J9052A)

• HPE MSM765zl Mobility Controller (J9370A)

During a nonstop switching failover, unsupported modules will not failover seamlessly to the standby module. A
nonstop switching failover causes a forced reboot on these modules. After rebooting, these modules then sync
with the newly active management module and begin operation again. Module traffic is disconnected until the
module completes the reboot process.

Hot swapping of management modules
Use the MM Shutdown button on the front of the management module before removal. The Shutdown button
ensures that the management module is shut down properly. If nonstop switching is enabled, using the Shutdown
button prior to removal ensures failover to the standby module will be successful.

Rapid routing switchover and stale timer
With K.15.01.0031, nonstop switching supports only Layer 2 functions on the switch. During a failover, traffic
routed through the switch at Layer 3 will see an interruption. When a failover from active to standby occurs, the
routing table is "frozen." All routes that existed at the time of the failover are marked as "stale." While dynamic
routing protocols running at the time may act as if the routing protocol has been restarted and rebuilds the table,
the switch on which the failover occurred continues to rout traffic using the ‘stale routes.'

The "stale timer" begins counting when the switchover occurs. When the "stale timer" expires, any routes that are
still marked as stale are purged from the routing table. Because of the nature of rapid routing switchover, if there
are multiple simultaneous failures, network loops could occur or traffic could flow through unpredictable paths.

Use caution if setting the "rapid-switchover" timer higher than the default. To disable "rapid routing switchover"
and to ensure that all routing is based on the most current routing protocol information, set the "rapid-switchover"
timer to 0.

Task Usage Reporting
The task usage reporting feature provides the ability to collect and display CPU usage data (with a refresh rate of
5 seconds) of running tasks on the switch. It includes the following commands:

• process-tracking
: Use this command to enable/disable the task-usage collecting capability for a specific module on the switch.

• show cpu process
: Use this command to display task-usage statistics for a specific module.

Help text

process-tracking help
Usage: [no] process-tracking [slot[SLOT-LIST] [<time>]] [<time>]
Description: Enable/disable module process-tracking functionality.

show cpu help
Usage: show cpu [<CHASSIS_MIN_CPU_UTIL_INDEX-CHASSIS_MAX_CPU_UTIL_INDEX>]
[slot <SLOT-LIST> [<CHASSIS_MIN_CPU_UTIL_INDEX-
CHASSIS_MODULE_MAX_CPU_UTIL_INDEX>] ]
[process [[slot <SLOT-LIST>] [refresh <iterations>]]
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[refresh <iterations>]
Description: Show average CPU utilization over the last 1, 5, and 60 seconds, or the number of seconds
specified.

Use the 'slot' argument to display CPU utilization for the specified modules, rather than the chassis CPU.

Use the 'process' argument to display module process usages.

show cpu process help
Usage: show cpu process [slot [SLOT-LIST][refresh <iterations>]]
[refresh <iterations>]
Description: Display module process usage.

Command tab

process-tracking
process-tracking <tab>
slot

Enable/disable process-tracking for a module

INTEGER
Specify time to track value between 1 second to 30 seconds

<cr>
process-tracking slot <tab>
SLOT-ID-RANGE

Enter an alphabetic device slot identifier or slot range

process-tracking slot A
INTEGER

Specify time to track value between 1 second to 30 seconds

<cr>
process-tracking slot A 10 <tab>
<cr>
process-tracking 10 <tab>
<cr>

show cpu process
show cpu <tab>
process

Display process usage

slot
Display module CPU statistics

<1-300>
Time (in seconds) over which to average CPU utilization
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<cr>
show cpu process <tab>
refresh

Number of times to refresh process usage display

slot
Display module process usage

<cr>
show cpu process refresh <tab>
INTEGER

Enter an integer number

show cpu process refresh 10 <tab>
<cr>
show cpu process slot <tab>
SLOT-ID-RANGE

Enter an alphabetic device slot identifier or slot range

show cpu process slot A <tab>
refresh

Number of times to refresh process usage display

<cr>
show cpu process slot A refresh <tab>
INTEGER

Enter an integer number

show cpu process slot A refresh 10 <tab>
<cr>

Command ouput

show cpu process
Switch# show cpu process

                             | Recent |  %  | Time Since|   Times  |   Max
Process Name      | Priority | Time   | CPU | Last Ran  |    Ran   |  Time
--------------------+----------+--------+-----+-----------+----------+-------
           Idle-1 |      226 |  10 s  |  41 |     57 us |   380986 |  69 us
           Idle-3 |        1 |   5 s  |  20 |     52 us |   761665 |  55 us
           Idle-0 |      226 |   8 s  |  33 |     19 us |   380867 |  66 us
Sessions & I/O-24 |      171 | 926 ms |   3 |      1 ms |      150 | 335 ms

show cpu process slot <SLOT-LIST>
Switch# show cpu process slot A

slot a:
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                             | Recent |  %  | Time Since|   Times  |   Max
Process Name      | Priority | Time   | CPU | Last Ran  |    Ran   |  Time
--------------------+----------+--------+-----+-----------+----------+-------
System Services-2 |      156 | 253 ms |   2 |    767 ms |       12 |  35 ms
           Idle-3 |        1 |   3 s  |  28 |     13 ms |   101309 | 150 us
  Hardware Mgmt-2 |      192 | 282 ms |   2 |    303 us |       44 |  12 ms
           Idle-1 |      226 |   6 s  |  55 |     13 ms |    50793 | 233 us
           Idle-0 |      226 |   1 s  |   9 |     14 ms |    50633 | 106 us
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LACP-MAD Passthrough
Overview
Link Aggregation Control Protocol-Multi-Active Detection (LACP-MAD) is a detection mechanism deployed by
HPE Comware switches to recover from a breakup of the Intelligent Resilient Framework (IRF) stack due to link or
other failure.

LACP-MAD is implemented by sending extended LACP data units (LACPDUs) with a type length value (TLV) that
conveys the active ID of an IRF device. The active ID is identical to the member ID of the master and is thus
unique to the device. When LACP MAD detection is enabled, the members exchange their active IDs by sending
extended LACPDUs.

• When the IRF device operates normally, the active IDs in the extended LACPDUs sent by all members are the
same, indicating that there is no multiactive collision.

• When there is a breakup in the IRF chassis, the active IDs in the extended LACPDUs sent by the members in
different IRF devices are different, indicating that there are multiactive collisions.

LACP-MAD passthrough helps IRF-capable devices detect multiaccess and take corrective action. These devices
do not initiate transmission of LACP-MAD frames or participate in any MAD decision-making process. These
devices forward LACP-MAD TLVs received on one interface to the other interfaces on the trunk. LACP-MAD
passthrough can be enabled for 24 LACP trunks. By default, LACP-MAD passthrough is disabled.

NOTE: This Appendix is applicable only if the customer is using a hybrid deployment of Comware
and ArubaOS-Switches.

LACP-MAD Passthrough Configuration
interface lacp
Syntax
[no] interface <PORT-LIST> lacp [mad-passthrough [enable|disable]|active|passive|key <KEY>]
Description

Defines whether LACP is enabled on a port, and whether it is in active or passive mode when enabled. When
LACP is enabled and active, the port sends LACP packets and listens to them. When LACP is enabled and
passive, the port sends LACP packets only if it is spoken to.

When LACP is disabled, the port ignores LACP packets. If the command is issued without a mode parameter,
'active' is assumed. During dynamic link aggregation using LACP, ports with the same key are aggregated as a
single trunk. MAD passthrough applies only to trunks and not to physical ports.

Parameters

mad-passthrough

Applies only to trunks and not to physical ports.
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enable

Allows the port to send LACP packets.

disable

When LACP is disabled, the port ignores LACP packets.

active

When LACP is enabled and active, the port sends LACP packets and listens to them. Defaults to active.

passive

When LACP is enabled and passive, the port sends LACP packets only if it is spoken to.

key <KEY>

During dynamic link aggregation using LACP, ports with the same key are aggregated as a single trunk.

show lacp
Syntax
show lacp [counters [<PORT-LIST>] | local [<PORT-LIST>] |peer [<PORT-LIST>] | distributed | mad-passthrough [counters [<PORT-LIST>]]]
        

Description

Show LACP-MAD passthrough configuration on LACP trunks, or show LACP-MAD passthough counters on ports.

Parameters

counters

Display the various counters related to LACP ports.

local

Display the various local information related to LACP ports.

peer

Display the LACP peer port information.

distributed

Show distributed LACP information.

mad-passthrough

Display the various counters related to LACP MAD passthrough ports.

Usage
show lacp mad-passthrough counters [<PORT-LIST>]

clear lacp statistics
Syntax
clear lacp statistics
Description

Clear all LACP statistics including MAD passthrough counters. Resets LACP packets sent and received on all
ports.
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Smart Rate Technology
Smart Rate is a new technology designed to enable higher port link speeds on legacy cabling where an Ethernet
RJ45 port type can link at 1Gbps, 2.5Gbps, 5Gbps, or 10Gbps.

When situations occur where a network link establishes at a lower than expected speed (or not at all) due to
marginal or bad cabling, the Smart Rate port technology allows administrators to triage cabling issues and
determine root causes of lower than expected performance.

Smart Rate Technology is available on the following products:

Switch 5400R v3 zl2 modules (J9991A, J9995A)
Switch 5400R chassis switch bundles (JL002A)

Show Smart Rate port
Syntax

show interface PORT-LIST smartrate
Displays port diagnostics on a Smart Rate port.

Unlinked Smart Rate port

show interface C5 smartrate

Status and Counters - Smart Rate information for Port C5

Model         : 0x03a1
Chip         : 0xb4b3
Firmware (major)      : 0x0002
Firmware (minor)      : 0x0003
Firmware (candidate)     : 0x0005
Firmware (provision)     : 0x0001

      Chan1   Chan2   Chan3   Chan4 (in db)
Current SNR  9.000000  6.700000  3.500000  9.200000
Minimum SNR  9.000000  6.700000  3.500000  9.200000

CRC8 errors:     0
LDPC errors:     0
LDPC 1 iteration:    27620089
LDPC 2 iterations:    954117
LDPC 3 iterations:    0
LDPC 4 iterations:    0
LDPC 5 iterations:    0
LDPC 6 iterations:    0
LDPC 7 iterations:    0
LDPC 8 iterations:    0

23  Number of fast retrains requested by Local Device.
32  Number of fast retrains requested by Link Partner.
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150 Accumulated time (ms) spent in fast retrain since last AN. 
9  Number of RFI Training Link Recovery Events since last AN.
3  Number of Link Recover Events since last AN.

Established link speed       : 5000Mbps
Number of attempts to establish link   : 5
Uptime since link was last established (ms) : 5099

Local port advertised speeds

1000Mbps 2500Mbps  5000Mbps  10Gbps
 No   Yes   Yes   No

Link partner speed capability

1000Mbps  2500Mbps  5000Mbps  10Gbps
 Yes   Yes   Yes   No

Link Partner matching vendor: Yes

Smart Rate port that is linked at 1Gbps

show interface C5 smartrate

Status and Counters - Smart Rate information for Port C5

Model         : 0x03a1
Chip          : 0xb4b3
Firmware (major)     : 0x0002
Firmware (minor)     : 0x0003
Firmware (candidate)    : 0x0005
Firmware (provision)    : 0x0001

Established link speed         :1000Mbps
Number of attempts to establish link    :5
Uptime since link was last established (ms)  : 5099

Local port advertised speeds

1000Mbps  2500Mbps  5000Mbps  10Gbps
 No     No     No     No

Link partner speed capability

1000Mbps  2500Mbps  5000Mbps  10Gbps
 Yes    Yes    Yes    Yes

Link Partner matching vendor: Yes

Rate-Limiting — GMB features when Fast-Connect SmartRate ports are
configured
When Rate-Limiting or Guaranteed Minimum Bandwidths are configured for 5Gbps ports, the granularity of
percentage-based rates for the 5Gbps speed is in steps of 2%. For example, a 1% rate-limit for a 5Gbps port will
function as a 2% limit while a 5% limit will function as a 6% limit.

The Guaranteed Minimum Bandwith profiles will show the same behavior. For example on an 8-queue system,
the actual default servicing profile will be 2%, 4%, 30%, 10%, 10%, 10%, 16%, and 20%. The CLI and SNMP
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values for these ports will show what the customer configured, but the actual hardware results will be in steps of
2%.

This limitation only applies to 5Gbps ports. Ports running at 2.5Gbps have the same 1% granularity as all
previously-offered port speeds.

Error messages
When the show interface PORT-LIST smartrate command is run on a non-Smart Rate port, the
command will fail with an error message similar to the following: Port A1: This command is only
applicable to Smart Rate ports.
When the show interface PORT-LIST smartrate command is run on a Smart Rate port, but is unable to
retrieve all results the command will fail with an error message similar to the following: Port A1: This
command did not complete successfully. Please try again.

Speed-duplex
Syntax

interface PORT-LIST speed-duplex
Options

auto Auto-negotiate link parameters.

auto-100 100 Mbps only, auto-negotiate link parameters.

auto-1000 1000 Mbps only, auto-negotiate link parameters.

auto-2500 2500 Mbps only, auto-negotiate link parameters.

auto-5000 5000 Mbps only, auto-negotiate link parameters.

auto-2500-5000 2500 or 5000 Mbps only, auto-negotiate link parameters.

auto-10g 10 Gbps only, auto-negotiate link parameters.

Limitations on 5Gbps ports
For 5Gbps ports, when the customer has Rate-Limiting or Guaranteed Minimum Bandwidths configured, the
granularity of percentage-based rates for the 5Gbps speed is in steps of 2%. For example a 1% rate-limit for a
5Gbps port will function as a 2% limit, a 5% limit will function as a 6% limit. The Guaranteed Minimum Bandwith
profiles will show the same behavior. On an 8-queue system, the actual default servicing profile will be 2% 4%
30% 10% 10% 10% 16% 20%. The CLI and SNMP values for these ports will show what the customer
configured, but the actual hardware results will be in steps of 2%.

NOTE:

This limitation only applies to the 5Gbps ports. Ports running at 2.5Gbps have a 1% granularity in
port speeds.
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Error messages
• On ports that do not support the respective speed-duplex option, the command will fail with an error message

similar to the following:
Value auto-10 is not applicable to port E1.

• The following speed-duplex options are not available on switch platforms that do not have Smart Rate ports.
◦ auto-2500

◦ auto-5000

◦ auto-2500-5000

100 Mbps Support on Smart Rate ports

Overview
Smart Rate ports are designed to link devices at 1 Gbps, 2.5 Gbps, 5 Gbps, and 10 Gbps. Older devices such as
legacy printers can run at maximum speed of 100 Mbps. To address this issue, the speed duplex auto-100
enhancement is introduced on Smart-Rate ports. Depending on the device model, Smart Rate ports can operate
on 100Mbps speed.

NOTE: If MACsec is configured on a port, we cannot configure speed duplex as auto-100 for that
particular port, and conversely.

100Mbps is supported on auto speed duplex mode by default.

100 Mbps support on Smart Rate ports is available for 5400R, 3810M and 2930M.

interface speed-duplex auto-100
Syntax
interface <PORT> speed-duplex auto-100

Description

Configures speed option to support Auto-100 on Smart Rate ports.

Command context
config

Parameter
PORT

Specify a port number.

Example

switch(config)#interface A1 speed-duplex auto-100  
switch(config)#show interface brief
 Status and Counters - Port Status

                          | Intrusion                           MDI  Flow Bcast
  Port         Type       | Alert     Enabled Status Mode       Mode Ctrl Limit
  ------------ ---------- + --------- ------- ------ ---------- ---- ---- -----
  A1           10GbE-T    | No        Yes     Up     100FDx     MDI  off  0
  A2           10GbE-T    | No        Yes     Up     100FDx     Auto off  0
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  A3           10GbE-T    | No        Yes     Down   10GigFD    Auto off  0
  A4           10GbE-T    | No        Yes     Down   10GigFD    Auto off  0                  

show interfaces smartrate
Syntax
show interfaces <PORT-LIST> smartrate

Description

Displays Smart Rate diagnostic information.

Parameter
PORT-LIST

Specify a port number or a list of ports.

Examples

switch(config)#show interfaces A1 smartrate

 Status and Counters – Smart Rate information for Port A1

  Model                   : 0x03a1
  Chip                    : 0xb582
  Firmware                : 3.3.e
  Provisioning            : 0x0002

  Established link speed                 : 100BASE-T
  Number of attempts to establish link   : 1
  Uptime since link was established      : 30 seconds

  Local Port advertised capabilities
  100MBT  | 1.0GBT  | 2.5G NBT | 5.0G NBT | 2.5GBT | 5.0GBT | 10GBT
   Yes    |  No     |   No     |   No     |  No    |  No    |  No

  Link Partner advertised capabilities
  100MBT  | 1.0GBT  | 2.5G NBT | 5.0G NBT | 2.5GBT | 5.0GBT | 10GBT
   Yes    |  Yes    |   Yes    |   Yes    |  No    |  No    | Yes

switch(config)# show interface A2 smartrate

 Status and Counters – Smart Rate information for Port A2

  Model                   : 0x03a1
  Chip                    : 0xb582
  Firmware                : 3.3.e
  Provisioning            : 0x0002

  Established link speed                 : 100BASE-T
  Number of attempts to establish link   : 1
  Uptime since link was established      : 30 seconds

  Local Port advertised capabilities
  100MBT  | 1.0GBT  | 2.5G NBT | 5.0G NBT | 2.5GBT | 5.0GBT | 10GBT
   Yes    |  Yes    |   Yes    |   Yes    |  Yes   |  Yes   |  Yes

  Link Partner advertised capabilities
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  100MBT  | 1.0GBT  | 2.5G NBT | 5.0G NBT | 2.5GBT | 5.0GBT | 10GBT
   Yes    |  No     |   No     |   No     |  No    |  No    |  N0

show interface config
Syntax
show interface config

Description

Displays port settings.

Example

switch#(config)show interface config
 Port Settings

  Port  Type       | Enabled Mode         Flow Ctrl MDI
  ----- ---------- + ------- ------------ --------- ----
  A1    10GbE-T    | Yes     Auto-100     Disable   Auto
  A2    10GbE-T    | Yes     Auto         Disable   Auto
  A3    10GbE-T    | Yes     Auto         Disable   Auto
  A4    10GbE-T    | Yes     Auto         Disable   Auto

show running-config
Syntax
show running-config

Description

The Smart Rate port auto-100 is part of the show running config output.

Example

switch(config)#show running-config
Running configuration:

; JL320A Configuration Editor; Created on release #WC.16.06.0000x
; Ver #13:03.f8.1c.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:49

module 1 type jl320a
flexible-module A type JL081A
interface A1
   speed-duplex auto-100
   exit

Downgrade with CLI reboot command

Procedure

1. If the Smart Rate port speed configuration is auto-100, boot system flash primary command will
prompt user to change the auto-100 to other configuration.

switch# boot system flash primary
This will reboot the system from the primary image.
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Continue (y/n)? y
2. To proceed, select y.

Firmware downgrade is not allowed when smartrate port is configured with
auto-100. Please change the speed-duplex to other configuration.

3. To reject, select n.

Downgrade without CLI reboot command (power cycle)

Procedure

1. Reboot with auto-100 mode configuration on Smart Rate port, the following events occur:

a. The speed duplex status is shown blank when you execute the show interface brief command.

b. The port status is displayed as down.

2. Save the configuration and again reboot. The preconfigured auto-100 restores the Smart Rate port to auto
mode, thus restoring its functionality.
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Networking 6th Generation Switch ASIC
Introduction
 The Networking 6th Generation Switch ASIC based module creates compatibility between v2 and v3 blades on
the 5400R Chassis Switches. When the 5400R Chassis Switch platform detects a mix of v2 and v3 blades, the v3
feature will default the platform to v2 behavior. The default behavior is v2.

The compatibility mode of v2 and v3 modules are controlled by configuration. When the compatibility mode is
disabled, v2 modules in the system will be disabled.

Commands
Configuration commands enable/disable the 5400R Chassis Switch platform v2/v3 interoperability.

Configuration setup
Syntax

[no] allow-v2-modules
Enables support for V2 modules. When enabled, V3 modules will operate in V2-compatiblity mode. When
disabled, V3 modules will have full functionality and the ports of any V2 modules will be non-operable. Enabling
the V2 module support erases the current configuration of the device and reboots the device. Whereas, disabling
the V2 module support clears all V2 module specific configuration from startup configuration and reboots the
device.

allow-v2-modules

Enable support for V2 modules.

Enabled/Disabled state

When V2 compatibility mode is disabled from an enabled state, the below message is displayed for user input.

Switch(config)# no allow-v2-modules
This command will disable all V2 modules and reboot the switch.
Continue (y/n)?
When V2 compatibility mode is enabled from disabled state, the below message is displayed for user input.

Switch(config)# allow-v2-modules
This command will erase the current configuration of the switch and reboot it.
Continue (y/n)?
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Networking 6th Generation Switch ASIC

Appendix D Networking 6th Generation Switch ASIC 849

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4587



V3 to V2 compatibility
On an Aruba 5400R switch loaded, when switching from v3 only mode to v2 compatibility mode, the V2 specific
module entries and related configuration options are retained. The switch erases the entire configuration when
moving from V3 only mode to V2 mode.

allow-v2-modules
Syntax
allow-v2-modules
Description

Enables the use of v2 modules in the switch. Before enabling v2 support, the command determines whether any
of the v3-native features are configured. This command is active only in v3–native mode.

V3 modules cannot be changed to v2-compatibility mode when there are v3-specific
configuration settings. Use the command 'show running-config v3-specific' to
display the settings that must be changed before enabling v2 module support.
Unconfigure all v3-only features before moving to compatibility mode.

If the v3-native configuration is not present, the device reboots with the non-v3 configuration and issues the
following message:This command will save the running configuration and reboot the
system with all V3 modules operating in v2-compatibility mode.Continue (y/n)?
Options

erase

Erases the entire configuration and reboots the switch with either the custom default configuration (if it is
available) or the factory default configuration. The command with the erase option is active only in v3–native
mode.

Usage
allow-v2-modules erase
More Information

To list the v3-native configurations present in the current configuration, see show running-config v3-specific on
page 850.

show running-config v3-specific
Syntax

show running-config v3-specific
Description

Provides a list of V3-native configurations present in the current configuration.

show running-config v3-specific

vsf
   enable domain 40
   member 1
      type "J9850A" mac-address 645106-8a0400
      priority 200
      link 1 1/A24
      link 1 name "I-Link1_1"
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      exit
   member 2
      type "J9850A" mac-address 40a8f0-9e6600
      priority 150
      link 1 2/A24
      link 1 name "I-Link2_1"
      exit
   exit
oobm
   vsf member 1
      ip address dhcp-bootp
      exit
   vsf member 2
      ip address dhcp-bootp
      exit
   exit
VSF-Switch#

Show commands
The show module command shows the configuration status of allowed V2 modules. The output will be available
only for the 5400R Chassis Switches.

Show system
Syntax

show system

Show system output

Status and Counters - General System Information

System Name        : 5406Rzl2
System Contact     :
System Location    :
Allow V2 Modules   : Yes
MAC Age Time (sec) : 300
Time Zone          : 0
Daylight Time Rule : None
Software revision  : KB.15.16.0000x       Base MAC Addr      : 40a8f0-9d6f00
ROM Version        : KB.15.Z1.0012       Serial Number      : SG44G490FZ
                   Opacity Shields    : Not Installed

Up Time            : 7 mins                   Memory   - Total   : 763,846,656
CPU Util (%)       : 0                              Free    : 646,757,632

IP Mgmt  - Pkts Rx : 106                      Packet   - Total   : 6750
     Pkts Tx : 111                      Buffers    Free    : 4830
                   Lowest  : 4828
                   Missed  : 0

Show system information
Syntax

show system information
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Show system information output

Status and Counters - General System Information

System Name        : 5406Rzl2
System Contact     :
System Location    :
Allow V2 Modules   : Yes
MAC Age Time (sec) : 300
Time Zone          : 0
Daylight Time Rule : None
Software revision  : KB.15.16.0000x       Base MAC Addr      : 40a8f0-9d6f00
ROM Version        : KB.15.Z1.0012       Serial Number      : SG44G490FZ
                   Opacity Shields    : Not Installed

Up Time            : 7 mins         Memory   - Total   : 763,846,656
CPU Util (%)       : 0           Free    : 646,757,632

IP Mgmt  -  Pkts Rx : 106          Packet   - Total   : 6750
     Pkts Tx : 111          Buffers    Free    : 4830
                   Lowest  : 4828
                   Missed  : 0

Show running configuration
The show running-config command shows the entry when disabled. This output will be available on 5400R
Chassis Switches only.

Syntax

show running-config

Show running configuration output

; J9850A Configuration Editor; Created on release #KB.15.16.0000x
; Ver #05:18.7f.ff.3f.ef:4d
hostname "Switch"
module A type j9987a
module F type j9993a
no allow-v2-modules
snmp-server community "public" unrestricted
oobm
  ip address dhcp-bootp
  exit
vlan 1
  name "DEFAULT_VLAN"
  untagged A1-A24,F1-F8
  ip address dhcp-bootp
  exit
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Event logging

Table 37: Interoperability messages

Event Message

When switch is rebooting after
a change in the interoperability
mode.

V2/V3 interoperability message M 05/23/14 05:50:15 00064 system:
Rebooting the device because the
module compatibility mode has
changed.

V1/V2 Interoperability message
for reference

M 05/23/14 05:50:15 00064 system:
Rebooting for
interOperabilityMode change

Modified V1/V2 interoperability
message ( same as V2/V3
message)

M 05/23/14 05:50:15 00064
system: : Rebooting the device
because the module compatibility
mode has changed.

Version 2 — version 3 blade compatibility on the 5400R
switch

Allow V2 command
The CLI commands allow-v2-modules and [no] allow-v2-modules enable the configuration for
compatibility of V3 and V2 modules to operate simultaneously. Disabling compatibility will disallow V3 and V2
modules from operating simultaneously, allowing only V3 modules to operate.

Syntax

[no] allow-v2-modules
Enable/disable support for V2 modules.

Validation rules

Validation Error/Warning/Prompt

Compatibility Mode enabled – ‘no allow-v2-modules’ Prompt: ‘All V2 modules will be disabled. Continue
[y/n] ?’

Compatibility Mode enabled – ‘allow-v2-modules’ No prompt

Compatibility Mode disabled – ‘no allow-v2-modules’ No prompt

Compatibility Mode disabled – ‘allow-v2-modules’ Prompt: ‘This will erase the configuration and reboot
the switch. Continue [y/n] ?’

Show commands
Syntax

show system
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Enable/disable support for V2 modules.

Show system

Status and Counters - General System Information
System Name        : 5406zl2
System Contact     :
System Location    :
Allow V2 Modules   : Yes

Event Log

Event Message

Compatibility Mode disabled – ‘allow-v2-modules’ Rebooting for interOperabilityMode change
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MAC Address Management
Overview
The switch assigns MAC addresses in these areas:

• For management functions, one Base MAC address is assigned to the default VLAN (VID = 1.) (All VLANs on
the switches covered in this guide use the same MAC address.)

• For internal switch operations: One MAC address per port.

MAC addresses are assigned at the factory. The switch automatically implements these addresses for VLANs and
ports as they are added to the switch.

NOTE:

The switch’s base MAC address is also printed on a label affixed to the switch.

Determining MAC addresses
Use the CLI to view the switch's port MAC addresses in hexadecimal format.

Use the menu interface to view the switch's base MAC address and the MAC address assigned to any
VLAN you have configured on the switch. (The same MAC address is assigned to VLAN1 and all other VLANs
configured on the switch.)

NOTE:

The switch's base MAC address is used for the default VLAN (VID =1) that is always available on the
switch. This is true for dynamic VLANs as well; the base MAC address is the same across all VLANs.

Viewing the MAC addresses of connected devices
Syntax

show mac-address [<PORT-LIST> | mac-addr | vlan vid]
Lists the MAC addresses of the devices the switch has detected, along with the number of the specific port on
which each MAC address was detected.

Appendix E
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[<PORT-LIST>]
Lists the MAC addresses of the devices the switch has detected,
on the specified ports.

[mac-addr]
Lists the port on which the switch detects the specified MAC
address.Returns the following message if the specified MAC
address is not detected on any port in the switch:

MAC address  mac-addr  not found.

[vlan vid]
Lists the MAC addresses of the devices the switch has detected
on ports belonging to the specified VLAN, along with the number
of the specific port on which each MAC address was detected.

Viewing the switch's MAC address assignments for VLANs
configured on the switch
The Management Address Information screen lists the MAC addresses for:

Procedure

1. Base switch (default VLAN; VID=1)

2. Any additional VLANs configured on the switch.

Also, the Base MAC address appears on a label on the back of the switch.

NOTE: The Base MAC address is used by the first (default) VLAN in the switch. This is usually the
VLAN named "DEFAULT_VLAN" unless the name has been changed (by using the VLAN Names
screen.) On the switches covered in this guide, the VID (VLAN identification number) for the default
VLAN is always "1," and cannot be changed

.

• From the Main Menu, select

• 1. Status and Counters

• 2. Switch Management Address Information

• If the switch has only the default VLAN, the following screen appears. If the switch has multiple static VLANs,
each is listed with its address data.

Figure 211: Example of the Management Address Information screen
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Viewing the port and VLAN MAC addresses
The MAC address assigned to each switch port is used internally by such features as Flow Control and the
spanning-tree protocol. Using the walkmib command to determine the MAC address assignments for individual
ports can sometimes be useful when diagnosing switch operation.

Table 38: Switch series' and their MAC address allocations

Switch series MAC address allocation

8212zl The switch allots 24 MAC addresses per slot. For a given slot, if a
four-port module is installed, the switch uses the first four MAC
addresses in the allotment for that slot, and the remaining 18 MAC
addresses are unused.If a 24-port module is installed, the switch
uses the first 24 MAC addresses in the allotment, and so on.

All Models The switch's base MAC address is assigned to VLAN (VID) 1 and
appears in the walkmib listing after the MAC addresses for the
ports. (All VLANs in the switch have the same MAC address.)

NOTE: This procedure displays the MAC addresses for all ports and existing VLANs in the switch,
regardless of which VLAN you select.

Example

A 8212zl switch with the following module configuration shows MAC address assignments similar to those shown
in Figure 212: Example of Port MAC address assignments on a switch on page 858:

Appendix E MAC Address Management 857

Anexo 02 ITEM 05 (0592590)         SEI 0008478-63.2018.6.02.8000 / pg. 4595



• A 4-port module in slot A, a 24-port module in slot C, and no modules in slots B and D

• Two non-default VLANs configured

Figure 212: Example of Port MAC address assignments on a switch

NOTE: When configuring an "out" monitor on a VLAN or an interface to a remote mirror, the mirrored
packet will always be untagged when the original packet arrives on a zlV2 module.

When configuring a "both" monitor on an interface to a remote mirror, tags will not be present in the
mirrored packet in these specific situations:

• For an interface monitor, packets transmitted by the monitored port that originally arrived on a
zlV2 module.

• For a VLAN monitor, packets routed onto the monitored VLAN that originally arrived on a zlV2
module.

1. If the switch is at the CLI Operator level, use the enable command to enter the Manager level of the CLI.

2. Enter the following command to display the MAC address for each port on the switch:

Switch# walkmib ifPhysAddress
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NOTE: The above command is not case-sensitive.
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Configuration backup and restore without
reboot

Beginning with switch software release 16.05, the configuration backup and restore without reboot supports the
following features:

Interface Access (Telnet, Console/Serial, web) Port Shutdown with Broadcast Storm

Access Control Lists (ACLs) Source-Port Filters

AAA Authentication TACACS+ Authentication

CoS (Class of Service) Time Protocols (TimeP, SNTP)

Network Management Applications (SNMP) Uni-directional Link Detection (UDLD)

Port Configuration Virus Throttling (Connection-Rate Filtering)

Port Security Web-based Authentication

Port-Based Access Control (802.1X) Backplane stacking

Quality of Service (QoS) Job Scheduler

Spanning Tree (STP, RSTP, MSTP, RPVST+) Authorized IP Managers

VLANs Authorized Manager List (Web, SSH, TFTP)

802.1Q VLAN Tagging Auto MDIX Configuration

802.1X Port-Based Priority DHCP Configuration

802.1X Multiple Authenticated Clients Per Port Flow Control (802.3x)

IGMP Friendly Port Names

LACP/Trunk Guaranteed Minimum Bandwidth (GMB)

MAC Lockdown IP Addressing

MAC-based Authentication IP Routing

MAC Lockout Jumbo Packets

LMA LLDP

Multicast Filtering LLDP-MED

Power over Ethernet (PoE and PoE+) Loop Protection

Protocol Filters MAC Address Management

RADIUS Authentication and Accounting Management VLAN

RADIUS-Based Configuration Passwords and Password Clear Protection/include-
credentials

Table Continued
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Encrypted-password QoS: Strict-Priority Queuing

Port Monitoring QoS: Turn on/off VLAN Precedence

Port Status QoS: Egress Queue Rate-limiting

Rate-Limiting CDP

Syslog System Parameters (hostname, Banner)

System Information Front-panel-security

Telnet Access DLDP

Traffic/Security Filters OOBM

VLAN Mirroring (1 static VLAN)/Port mirroring Switch interconnect

Voice VLAN Airwave Controller IP configuration

Web Authentication RADIUS Support Aruba Central integration

Web UI Captive portal commands

Log IP address of an ACL match Consolidated Client View

access-list logtimer IPsec for Zero Touch Provisioning

UFD: Uplink Failure Detection Local User roles

Wake-on-LAN for a Specific VLAN Port QoS Trust Mode

WebUI Inactivity Timer Per-port Tunneled node

Control Plane Protection Zero-touch provisioning - DHCP, Activate

Egress ACLs ClearPass support

Device profile - switch auto configuration HTTP redirection/Captive portal

Device profile: Auto configuration with Aruba AP
detection

Device profile: LLDP Authentication Bypass with AP

Tunneled Node enhancement: fallback to switching RADIUS Port Speed VSA

Rogue AP isolation Dynamic ARP Protection

DHCP Option 82 Dynamic IP Lockdown

DHCP snooping Eavesdrop Protection

Distributed Trunking GVRP

RMON 1,2,3,9 Private VLANs

SavePower Features IP SLA

sFlow sys-debug acl

VxLAN MAC Based VLANs (MBV)

Smartlink RBAC: Role Based Access Control

Fault Finder extended to cover Flapping Transceiver
Mitigation

RADIUS Service Tracking

Fault Finder (Per Port Enable) sys-debug destination

SNMP Trap Throttling Protocol VLANS
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DATA SHEET

PRODUCT OVERVIEW

The Aruba 3810 Switch Series provides performance and 

resiliency for enterprises, SMBs, and branch office networks. 
With HPE Smart Rate multi-gigabit ports for high speed access 

points and IoT devices, this advanced Layer 3 network switch 
delivers a better application experience with low latency, 

virtualization with resilient stacking technology, and line rate 
40GbE for plenty of back haul capacity.

A powerful Aruba ProVision ASIC delivers performance, 

robust feature support, and value with flexible 
programmability for the latest applications. The 3810 delivers 
resiliency and scalability via innovative backplane stacking 
technology and redundant, hot-swappable power supplies 

all in a convenient 1U form factor. It supports an advanced 
Layer 2 and 3 feature set with OSPF, IPv6, IPv4 BGP, Dynamic 

Segmentation, robust QoS, and policy-based routing are 

included with no software licensing.

Easy to deploy, use and manage using Aruba AirWave or 

Aruba Central. Aruba ClearPass offers centralized security and 
external captive portal support. The switches offer a limited 
lifetime warranty. 

ENHANCED CAPABILITIES

Software-defined networks
• Supports multiple programmatic interfaces, including REST 

APIs and Openflow 1.0 and 1.3, to enable automation of 
network operations, monitoring, and troubleshooting

Unified wired and wireless support
• Aruba ClearPass Policy Manager provides profiling, 

authentication, and policy management across multi-

vendor wired and wireless networks
• Switch auto-configuration automatically configures switch 

for different settings such as VLAN, CoS, PoE max power, 
and PoE priority when an Aruba access point is detected

• User Role defines a set of switch-based policies in areas 
such as security, authentication, and QoS. A user role can 
be assigned to a group of users or devices, using switch-

based local user role or download from ClearPass

ARUBA 3810 SWITCH SERIES

• Dynamic Segmentation provides a secure tunnel that 

transports network traffic on a per-port or per-user role 
basis to an Aruba Controller. In a per-user role Tunnel 
Node, users are authenticated by the ClearPass Policy 
Manager which directs traffic to be tunneled to an Aruba 
controller or switch locally

• Static IP Visibility allows ClearPass to do accounting for 

clients with static IP addresses

Quality of Service (QoS)
• Advanced classifier-based QoS classifies traffic using multiple 

match criteria based on Layer 2, 3, and 4 information; applies 

QoS policies such as setting priority level and rate limit to 

selected traffic on a per-port or per-VLAN basis
• Layer 4 prioritization based on TCP/UDP port numbers

• Class of Service (CoS) sets the IEEE 802.1p priority tag 
based on IP address, IP Type of Service (ToS), Layer 3 

protocol, TCP/UDP port number, source port, and DiffServ

KEY FEATURES

• Advanced Layer 3 switch series with backplane 
stacking, Dynamic Segmentation, low latency  
and resiliency

• Advanced security and network management via 
Aruba ClearPass Policy Manager, Aruba AirWave 

and Aruba Central

• Modular line rate 10GbE and 40GbE ports for 

wireless aggregation

• HPE Smart Rate for high-speed multi-gigabit 

bandwidth (IEEE 802.3bz) and PoE+ power
• Software defined ready with REST APIs and 

OpenFlow support
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• Bandwidth shaping

 - Port-based rate limiting provides per-port ingress-/

egress-enforced increased bandwidth

 - Classifier-based rate limiting uses an access control list 
(ACL) to enforce increased bandwidth for ingress traffic 
on each port

 - Supports per-port, per-queue egress-based  

reduced bandwidth

• Remote intelligent mirroring mirrors selected ingress/egress 

traffic based on an ACL, port, MAC address, or VLAN to a 
local or remote HPE 8200 zl, 6600, 6200 yl, 5400 zl, 5400R, 

or 3500 Switch anywhere on the network
• Remote monitoring (RMON), Extended RMON (XRMON), 

and sFlow provide advanced monitoring and reporting 

capabilities for statistics, history, alarms, and events

• Traffic prioritization allows real-time traffic classification 
into eight priority levels that are mapped to eight queues

• Unknown Unicast Rate Limiting throttles unicast packets 
with unknown destination addresses and limits flooding on 
the VLAN

Simplified management and configuration
• Flexible management – Supports both cloud-based Central 

and on-premise AirWave without ripping and replacing 

switching infrastructure

• Aruba Central cloud-based management platform offers 
simple, secure, and cost effective way to manage switches 

• Built-in programmable and easy to use REST API interface 

provides configuration automation for campus networks
• Friendly port names allows assignment of descriptive 

names to ports

• IEEE 802.1AB Link Layer Discovery Protocol (LLDP) 
advertises and receives management information from 

adjacent devices on a network, facilitating easy mapping 
by network management applications

• Command authorization leverages RADIUS to link a 
custom list of CLI commands to an individual network 
administrator’s login; an audit trail documents activity

• Multiple configuration files stores easily to the flash image
• Dual flash images provides independent primary and 

secondary operating system files for backup while upgrading
• Out-of-band Ethernet management port enables 

management over a separate physical management 

network; and keeps management traffic segmented from 
network data traffic

• Zero Touch Provisioning (ZTP) simplifies installation of the 
switch infrastructure using Aruba Activate-based  

or DHCP-based process with AirWave and Central 

Network Management
• Unidirectional link detection (UDLD) monitors the link 

between two switches and blocks the ports on both ends  
of the link if the link goes down at any point between the 
two devices

• IP SLA for Voice Monitor quality of voice traffic with UDP 
Jitter and UDP Jitter for VoIP tests

Connectivity
• Jumbo frames on Gigabit Ethernet and 10-Gigabit Ethernet 

ports allow high-performance remote backup and 
disaster-recovery services

• IEEE 802.3at Power over Ethernet (PoE+) provides up to 30 
W per port that allows support of the latest PoE+ capable 
devices such as IP phones, wireless access points, and 

security cameras, as well as any IEEE 802.3af compliant 
end device; eliminates the cost of additional electrical 

cabling and circuits that would otherwise be necessary in 

IP phone and WLAN deployments
• Support for pre-standard PoE detects and provides power 

to pre-standard PoE devices

• Choice of uplinks
 - SFP+ uplink models provide fiber-optic (up to 70 km) or 
direct-attach-cable (DAC) connectivity

 - 10GBASE-T uplink models offer 10GbE speeds, using 
standard RJ-45 connectors and standard twisted-pair 

cabling up to 100 m

• Auto-MDIX provides automatic adjustments for straight-
through or crossover cables on all RJ-45 ports

• IPv6

 - IPv6 host enables switch management in an IPv6 network
 - Dual stack (IPv4 and IPv6) transitions IPv4 to IPv6, 
supporting connectivity for both protocols

 - MLD snooping forwards IPv6 multicast traffic to the 
appropriate interface

 - IPv6 ACL/QoS supports ACL and QoS for IPv6 traffic
 - IPv6 routing supports static, RIPng, OSPFv3 routing 

protocols 

 - 6in4 tunneling supports encapsulation of IPv6 traffic in 
IPv4 packets

 - Security provides RA guard, DHCPv6 protection, dynamic 

IPv6 lockdown, and ND snooping
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Performance and efficiency
• Selectable queue configurations allows for increased 

performance by selecting the number of queues 

and associated memory buffering that best meet the 
requirements of the network applications

• Energy-efficient design
 - 80 PLUS Silver Certified Power Supply increases power 
efficiency and savings

 - Energy-efficient Ethernet (EEE) support reduces power 
consumption in accordance with IEEE 802.3az

• Meshed stacking technology
 - High-performance stacking provides up to 336 Gbps of 

stacking throughput; each 4-port stacking module can 
support up to 42 Gbps in each direction per stacking port

 - Ring, chain, and mesh topologies support up to a 

10-member ring or chain and 5-member fully meshed 

stacks; meshed topologies offer increased resiliency vs. a 
standard ring

 - Virtualized switching provides simplified management as 
the switches appear as a single chassis when stacked

• Aruba Provision ASIC provides very low latency, increased 

packet buffering, and adaptive power consumption

Resiliency and high availability
• Virtual Router Redundancy Protocol (VRRP) allows groups of 

two routers to back each other up dynamically to create highly 
available routed environments in IPv4 and IPv6 networks

• Nonstop switching and routing improves network 
availability to better support critical applications, such as 

unified communication and mobility; traffic will continue to 
be forwarded during failovers, when the backup member 
of the stack becomes the commander

• IEEE 802.3ad Link Aggregation Protocol (LACP) and Hewlett 
Packard Enterprise port trunking support up to 144 trunks, 
each with up to 8 links (ports) per trunk

• IEEE 802.1s Multiple Spanning Tree provides high link 
availability in multiple VLAN environments by allowing 
multiple spanning trees; provides legacy support for IEEE 

802.1d and IEEE 802.1w
• Dual hot-swappable power supplies

 - Increased resiliency with secondary power supply 

providing complete switch power redundancy in case of 

power line or supply failure

 - Secondary power supply increases available PoE+ power

• Distributed trunking enables loop-free and redundant 
network topology without using Spanning Tree Protocol; 
allows a server or switch to connect to two switches using 

one logical trunk for redundancy and load sharing
• SmartLink provides easy-to-configure link redundancy of 

active and standby links

Layer 2 switching
• IEEE 802.1ad QinQ increases the scalability of an Ethernet 

network by providing a hierarchical structure; connects 
multiple LANs on a high-speed campus or metro network

• VLAN support and tagging supports the IEEE 802.1Q 
standard and 4096 VLANs simultaneously

• IEEE 802.1v protocol VLANs isolate select non-IPv4 
protocols automatically into their own VLANs

• MAC-based VLAN provides granular control and security; 
uses RADIUS to map a MAC address/user to specific VLANs

• Rapid Per-VLAN Spanning Tree (RPVST+) allows each 
VLAN to build a separate spanning tree to improve link 
bandwidth usage; is compatible with PVST+

• Aruba 3810 switch meshing dynamically load balances 

across multiple active redundant links to increase available 
aggregate bandwidth; allows concurrent Layer 3 routing

• GVRP and MVRP allows automatic learning and dynamic 

assignment of VLANs

Layer 3 services
• Loopback interface address defines an address in Routing 

Information Protocol (RIP) and Open Shortest Path First 

(OSPF), improving diagnostic capability

• Route maps provide more control during route 

redistribution; allow filtering and altering of route metrics
• User datagram protocol (UDP) helper function allows 

UDP broadcasts to be directed across router interfaces to 

specific IP unicast or subnet broadcast addresses; and helps 
prevent server spoofing for UDP services such as DHCP

• DHCP server centralizes and reduces the cost of IPv4 

address management

• Bidirectional Forwarding Detection (BFD) enables link 
connectivity monitoring and reduces network convergence 
time for static route, OSPFv2, and VRRP
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Layer 3 routing
• Static IP routing provides manually configured routing for 

both IPv4 and IPv6 networks
• OSPF provides OSPFv2 for IPv4 routing and OSPFv3 for 

IPv6 routing

• Policy-based routing makes routing decisions based on 
policies set by the network administrator

• Border Gateway Protocol (BGP) provides IPv4 Border Gateway 

Protocol routing, which is scalable, robust, and flexible
• Routing Information Protocol (RIP) provides RIPv1, RIPv2, 

and RIPng

Security
• Control Plane Policing sets rate limit on control protocols 

to protect CPU overload from DOS attacks
• Source-port filtering allows only specified ports to 

communicate with each other

• RADIUS/TACACS+ eases switch management security 
administration by using a password authentication server

• Secure shell encrypts all transmitted data for secure 

remote CLI access over IP networks
• Secure Sockets Layer (SSL) encrypts all HTTP traffic, 

allowing secure access to the browser-based management 

GUI in the switch

• Port security allows access only to specified MAC addresses, 
which can be learned or specified by the administrator

• MAC address lockout prevents particular configured MAC 
addresses from connecting to the network

• Detection of malicious attacks monitors 10 types of 
network traffic and sends a warning when an anomaly that 
potentially can be caused by malicious attacks is detected

• Secure FTP allows secure file transfer to and from the 
switch; protects against unwanted file downloads or 
unauthorized copying of a switch configuration file

• Switch management logon security helps secure switch CLI 

logon by optionally requiring either RADIUS or TACACS+ 
authentication

• Secure management access delivers secure encryption of 

all access methods (CLI, GUI, or MIB) through SSHv2, SSL, 

and/or SNMPv3
• ICMP throttling defeats ICMP denial-of-service attacks  

by enabling any switch port to automatically throttle  

ICMP traffic automatically
• Identity-driven ACL enables implementation of a highly 

granular and flexible access security policy and VLAN 
assignment specific to each authenticated network user

• STP BPDU port protection blocks Bridge Protocol Data 
Units (BPDUs) on ports that do not require BPDUs, 

preventing forged BPDU attacks
• Dynamic IP lockdown works with DHCP protection to block 

traffic from unauthorized hosts, preventing IP source 
address spoofing

• DHCP protection blocks DHCP packets from unauthorized 
DHCP servers, preventing denial-of-service attacks

• Dynamic ARP protection blocks ARP broadcasts from 
unauthorized hosts, preventing eavesdropping or theft of 

network data
• STP root guard protects the root bridge from malicious 

attacks or configuration mistakes
• Management Interface Wizard helps secure management 

interfaces such as SNMP, telnet, SSH, SSL, Web, and USB at 
the desired level

• Security banner displays a customized security policy when 

users log in to the switch

• Switch CPU protection provides automatic protection against 

malicious network traffic trying to shut down the switch
• ACLs provide filtering based on the IP field, source/

destination IP address/subnet and source/destination 

TCP/UDP port number on a per-VLAN or per-port basis
• Multiple authentication methods

 - IEEE 802.1X authenticates multiple IEEE 802.1X users per 
port; prevents a user from “piggybacking” on another 
user’s authentication

 - Supports web-based authentication

 - MAC-based client authentication

 - Concurrent authentication modes enables a switch port 

to accept up to 32 sessions of 802.1X, Web, and MAC 
authentication

• Private VLAN provides network security by restricting peer-
to-peer communication to prevent a variety of malicious 

attacks; typically a switch port can only communicate with 
other ports in the same community and/or an uplink port, 
regardless of VLAN ID or destination MAC address

• IEEE 802.1AE MACsec provides security on a link between 
two switch ports (1Gbps or 10Gbps) using standard 

encryption and authentication

• Open Authentication Role simplifies first-time deployment 
of AAA in brownfield deployments by allowing full network 
access for failed clients and provides instant connectivity 

as soon as a client is plugged-in
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• Critical Authentication Role ensures that important 

infrastructure devices such as IP phones are allowed 

network access even in the absence of a RADIUS server
• MAC Pinning allows non-chatty legacy devices to stay 

authenticated by pinning client MAC addresses to the port 

until the clients logoff or get disconnected

Convergence
• IP multicast snooping (data-driven IGMP) prevents flooding 

of IP multicast traffic
• LLDP-MED (Media Endpoint Discovery) defines a standard 

extension of LLDP that stores values for parameters such 

as QoS and VLAN to configure network devices such as IP 
phones automatically

• PoE allocations supports multiple methods (automatic, 

IEEE 802.3af class, LLDP-MED, or user-specified) to allocate 
PoE power for more efficient energy savings

• Protocol Independent Multicast for IPv6 supports one-to-

many and many-to-many media casting use cases such as 

IPTV over IPv6 networks

• IP multicast routing includes PIM sparse and dense modes 

to route IP multicast traffic
• Auto VLAN configuration for voice

 - RADIUS VLAN uses a standard RADIUS attribute  
and LLDP-MED to configure a VLAN automatically for  
IP phones

 - CDPv2 uses CDPv2 to configure legacy IP phones
• Local MAC Authentication assigns attributes such as VLAN 

and QoS using locally configured profile that can be a list 
of MAC prefixes

Warranty and support
• Limited Lifetime Warranty 

See www.hpe.com/networking/warrantysummary for 

warranty and support information included with your 

product purchase.
• Software releases to find software for your product, refer 

to www.hpe.com/networking/support; for details on the 

software releases available with your product purchase, 

refer to www.hpe.com/networking/warrantysummary

SPECIFICATIONS

Aruba 3810M 24G 1-slot Switch 
(JL071A)

Aruba 3810M 48G 1-slot Switch 
(JL072A)

Aruba 3810M 24G PoE+ 1-slot 
Switch (JL073A)

Included accessories

1 Aruba 3810 Switch Fan Tray 
(JL088A)

1 Aruba 3810 Switch Fan Tray 
(JL088A)

1 Aruba 3810 Switch Fan Tray 
(JL088A)

I/O ports and slots

24 RJ-45 autosensing 10/100/1000 
ports (IEEE 802.3 Type 10BASE-T, 
IEEE 802.3u Type 100BASE-TX, IEEE 
802.3ab Type 1000BASE-T); Duplex: 
10BASE-T/100BASE-TX: half or full; 
1000BASE-T: full only; Ports 1 – 24 
support MACSec

1 open module slot 

Supports a maximum of 4 SFP+ 
ports or 1 40GbE ports, with optional 
module or 4 Smart Rate ports

48 RJ-45 autosensing 10/100/1000 
ports (IEEE 802.3 Type 10BASE-T, 
IEEE 802.3u Type 100BASE-TX, IEEE 
802.3ab Type 1000BASE-T); Duplex: 
10BASE-T/100BASE-TX: half or full; 
1000BASE-T: full only; Ports 1 – 48 
support MACSec

1 open module slot

Supports a maximum of 4 SFP+ 
ports or 2 40GbE ports, with optional 
module or 4 Smart Rate ports

24 RJ-45 autosensing 10/100/1000 
PoE+ ports (IEEE 802.3 Type 
10BASE-T, IEEE 802.3u Type 
100BASE-TX, IEEE 802.3ab Type 
1000BASE-T, IEEE 802.3at PoE+); 
Duplex: 10BASE-T/100BASE-TX: half 
or full; 1000BASE-T: full only; Ports 
1 – 24 support MACSec

1 open module slot 

Supports a maximum of 4 SFP+ 
ports or 1 40GbE ports, with optional 
module or 4 Smart Rate ports

Additional ports and slots

1 stacking module slot

1 RJ-45 serial console port

1 RJ-45 out-of-band management 
port

1 dual-personality (RJ-45 or USB 
micro-B)

1 stacking module slot

1 RJ-45 serial console port

1 RJ-45 out-of-band management 
port

1 dual-personality (RJ-45 or USB 
micro-B)

1 stacking module slot

1 RJ-45 serial console port

1 RJ-45 out-of-band management 
port

1 dual-personality (RJ-45 or USB 
micro-B)
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SPECIFICATIONS

Aruba 3810M 24G 1-slot Switch 
(JL071A)

Aruba 3810M 48G 1-slot Switch 
(JL072A)

Aruba 3810M 24G PoE+ 1-slot 
Switch (JL073A)

Power supplies

2 power supply slots

1 minimum power supply  
required (ordered separately)

2 power supply slots 

1 minimum power supply  
required (ordered separately)

2 power supply slots 

1 minimum power supply  
required (ordered separately)

Fan tray

Includes: 

1 x JL088A 

1 fan tray slot

Switch ships with 1 JL088A fan tray 
installed. Spares ordered separately.

Includes: 

1 x JL088A 

1 fan tray slot

Switch ships with 1 JL088A fan tray 
installed. Spares ordered separately.

Includes: 

1 x JL088A 

1 fan tray slot

Switch ships with 1 JL088A fan tray 
installed. Spares ordered separately.

Physical characteristics

Dimensions 17.42(w) x 16.98(d) x 1.73(h) in 
(44.25 x 43.13 x 4.39 cm)  
(1U height)

17.42(w) x 16.98(d) x 1.73(h) in 
(44.25 x 43.13 x 4.39 cm)  
(1U height)

17.42(w) x 16.98(d) x 1.73(h) in 
(44.25 x 43.13 x 4.39 cm)  
(1U height)

Weight 12.76 lb (5.79 kg) 13.20 lb (5.99 kg) 13.02 lb (5.91 kg)

Memory and processor

P2020 Dual Core @ 1.2 GHz, 4 GB 
DDR3 SDRAM, 1 GB SD Card

P2020 Dual Core @ 1.2 GHz, 4 GB 
DDR3 SDRAM, 1 GB SD Card

P2020 Dual Core @ 1.2 GHz, 4 GB 
DDR3 SDRAM, 1 GB SD Card

Dual ARM® Coretex A9 @ 1 GHz,  
2 GB DDR3 SDRAM; Packet buffer 
size: 13.5 MB Internal

Dual ARM® Coretex A9 @ 1 GHz,  
2 GB DDR3 SDRAM; Packet buffer 
size: 13.5 MB Internal

Dual ARM® Coretex A9 @ 1 GHz,  
2 GB DDR3 SDRAM; Packet buffer 
size: 13.5 MB Internal

Mounting and enclosure

Mounts in an EIA-standard 19 in. 
telco rack or equipment cabinet 
(hardware included); Horizontal 
surface mounting only

Mounts in an EIA-standard 19 in. 
telco rack or equipment cabinet 
(hardware included); Horizontal 
surface mounting only

Mounts in an EIA-standard 19 in. 
telco rack or equipment cabinet 
(hardware included); Horizontal 
surface mounting only

Performance

IPv6 Ready Certified IPv6 Ready Certified IPv6 Ready Certified

1000 Mb Latency < 2.8 µs (FIFO 64-byte packets) < 2.8 µs (FIFO 64-byte packets) < 2.8 µs (FIFO 64-byte packets)

10 Gbps Latency < 1.8 µs (FIFO 64-byte packets) < 1.8 µs (FIFO 64-byte packets) < 1.8 µs (FIFO 64-byte packets)

40 Gbps Latency < 1.5 µs (FIFO 64-byte packets) < 1.5 µs (FIFO 64-byte packets) < 1.5 µs (FIFO 64-byte packets)

Throughput up to 95.2 Mpps (64-byte packets) up to 190.5 Mpps (64-byte packets) up to 95.2 Mpps (64-byte packets)

Routing/Switching capacity 160 Gbps 320 Gbps 160 Gbps

Switch fabric speed 169 Gbps 338 Gbps 169 Gbps

Routing table size 10000 entries (IPv4),  
5000 entries (IPv6)

10000 entries (IPv4),  
5000 entries (IPv6)

10000 entries (IPv4),  
5000 entries (IPv6)

MAC address table size 64000 entries 64000 entries 64000 entries
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SPECIFICATIONS

Aruba 3810M 24G 1-slot Switch 
(JL071A)

Aruba 3810M 48G 1-slot Switch 
(JL072A)

Aruba 3810M 24G PoE+ 1-slot 
Switch (JL073A)

Environment

Operating temperature 32°F to 113°F (0°C to 45°C) 32°F to 113°F (0°C to 45°C). 32°F to 113°F (0°C to 45°C)

Operating relative  
humidity

15% to 95% @ 104°F (40°C),  
noncondensing

15% to 95% @ 104°F (40°C),  
noncondensing

15% to 95% @ 104°F (40°C),  
noncondensing

Nonoperating/Storage 
temperature

-40°F to 158°F (-40°C to 70°C) -40°F to 158°F (-40°C to 70°C) -40°F to 158°F (-40°C to 70°C)

Nonoperating/Storage 
relative humidity

15% to 90% @ 149°F (65°C),  
noncondensing

15% to 90% @ 149°F (65°C),  
noncondensing

15% to 90% @ 149°F (65°C),  
noncondensing

Altitude up to 10,000 ft (3 km) up to 10,000 ft (3 km) up to 10,000 ft (3 km)

Acoustic Power: 39 dB, Pressure: 22.8 dB Power: 38 dB, Pressure: 21.8 dB Power: 48 dB, Pressure: 30.7 dB

Primary Airflow Direction Front to Side and Front to Rear Front to Side and Front to Rear Front to Side and Front to Rear

Electrical characteristics

Frequency 50/60Hz 50/60Hz 50/60Hz

Voltage JL085A PSU: 100-127/200-240 VAC JL085A PSU: 100-127/200-240 VAC JL086A PSU: 100-127/200-240 VAC

JL087A PSU: 110-127/200-240 VAC

Current JL085A PSU (Each): 1A/0.5A JL085A PSU (Each): 1A/0.5A JL086A PSU (Each): 5A/2.5A

JL087A PSU (Each): 8.5A/5A

Max/Idle Power Rating 
(Switch+ 1 PSU)

70W/55W 95W/78W 95W/82W

Second PSU Power Adder 10W 10W 10W

Max/Idle Uplink  
Power Adder

JL078A: 4W/3W

JL079A: 7W/3W

JL081A: 4W/3W

JL083A: 11W/4W

JL078A: 4W/3W

JL079A: 7W/3W

JL081A: 4W/3W

JL083A: 11W/4W

JL078A: 4W/3W

JL079A: 7W/3W

JL081A: 4W/3W

JL083A: 11W/4W

Maximum Heat  
Dissipation *(Max Case)

310.31 395.56 395.56

PoE Power (Max Possible) N/A N/A 840W

Notes Idle power is the actual power 
consumption of the device with no 
ports connected. Maximum power 
rating and maximum heat dissipation 
are the worst case theoretical  
maximum numbers provide for 
planning the infrastructure with 
fully loaded PoE (if equipped),  
100% traffic, all ports plugged in, 
and all modules populated. This is a 
modular product. 

*Switch + 2 power supplies + one 
JL083A Uplink. For most accurate 
heat dissipation, idle and max  
power for any combination of  
chassis and accessories, please 
consult configurator.

Idle power is the actual power 
consumption of the device with no 
ports connected. Maximum power 
rating and maximum heat dissipation 
are the worst case theoretical  
maximum numbers provide for 
planning the infrastructure with 
fully loaded PoE (if equipped),  
100% traffic, all ports plugged in, 
and all modules populated. This is a 
modular product. 

*Switch + 2 power supplies + one 
JL083A Uplink. For most accurate 
heat dissipation, idle and max  
power for any combination of  
chassis and accessories, please 
consult configurator.

Idle power is the actual power 
consumption of the device with no 
ports connected. Maximum power 
rating and maximum heat dissipation 
are the worst case theoretical  
maximum numbers provide for 
planning the infrastructure with 
fully loaded PoE (if equipped),  
100% traffic, all ports plugged in, 
and all modules populated. This is a 
modular product. 

*Switch + 2 power supplies + one 
JL083A Uplink. For most accurate 
heat dissipation, idle and max  
power for any combination of  
chassis and accessories, please 
consult configurator.
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SPECIFICATIONS

Aruba 3810M 24G 1-slot Switch 
(JL071A)

Aruba 3810M 48G 1-slot Switch 
(JL072A)

Aruba 3810M 24G PoE+ 1-slot 
Switch (JL073A)

Safety

EN 60950/IEC 60950; UL 60950;  
UL 60950-1; CAN/CSA 22.2 No. 
60950; EN 60825; CSA 22.2  
60950-1; EN62479:2010; EN 
60950-1:2006 +A11:2009 +A1: 2010 
+A12:2011+A2:2013; EN 62368-1, 
Ed. 2; IEC 60950-1:2005 Ed.2; Am 
1:2009+A2:2013; IEC 60825:2007; 
EN60850-1:2007 / IEC 60825-1: 
2007 Class1 Class 1 Laser Products 
/Laser Klasse 1; UL 62368-1 Ed.2

EN 60950/IEC 60950; UL 60950;  
UL 60950-1; CAN/CSA 22.2 No. 
60950; EN 60825; CSA 22.2  
60950-1; EN62479:2010; EN 
60950-1:2006 +A11:2009 +A1: 2010 
+A12:2011+A2:2013; EN 62368-1, 
Ed. 2; IEC 60950-1:2005 Ed.2; Am 
1:2009+A2:2013; IEC 60825:2007; 
EN60850-1:2007 / IEC 60825-1: 
2007 Class1 Class 1 Laser Products 
/ Laser Klasse 1; UL 62368-1 Ed.2

EN 60950/IEC 60950; UL 60950; 
UL 60950-1; CAN/CSA 22.2 No. 
60950; EN 60825; CSA 22.2 
60950-1; EN62479:2010; EN 
60950-1:2006 +A11:2009 +A1:2010 
+A12:2011+A2:2013; EN 62368-1, 
Ed. 2; IEC 60950-1:2005 Ed.2; Am 
1:2009+A2:2013; IEC 60825:2007; 
EN60850-1:2007 / IEC 60825-1: 
2007 Class1 Class 1 Laser Products 
/ Laser Klasse 1; UL 62368-1 Ed.2

Emissions

FCC Class A; VCCI Class A; EN 
55022/CISPR 22 Class A; EN 60950-
1:2006  +A11:2009  +A1:2010  
+A12:2011+A2:2013

FCC Class A; VCCI Class A; EN 
55022/CISPR 22 Class A; EN 60950-
1:2006  +A11:2009  +A1:2010  
+A12:2011+A2:2013

FCC Class A; VCCI Class A; EN 
55022/CISPR 22 Class A; EN 60950-
1:2006  +A11:2009  +A1:2010  
+A12:2011+A2:2013

Immunity

Generic EN EN55022: 2010 EN55022: 2010 EN55022: 2010

ESD EN55024: 2010 EN55024: 2010 EN55024: 2010

Radiated IEC 61000-4-2 IEC 61000-4-2 IEC 61000-4-2

EFT/Burst IEC 61000-4-3; 3 V/m IEC 61000-4-3; 3 V/m IEC 61000-4-3; 3 V/m

Surge IEC 61000-4-4; 1.0 kV (power line), 
0.5 kV (signal line) IEC 61000-4-5; 1 
kV/2 kV AC

IEC 61000-4-4; 1.0 kV (power line), 
0.5 kV (signal line) IEC 61000-4-5; 1 
kV/2 kV AC

IEC 61000-4-4; 1.0 kV (power line), 
0.5 kV (signal line) IEC 61000-4-5; 1 
kV/2 kV AC

Conducted IEC 61000-4-6; 3 V IEC 61000-4-6; 3 V IEC 61000-4-6; 3 V

Power frequency  
magnetic field

IEC 61000-4-8; 1 A/m, 50 or 60 Hz IEC 61000-4-8; 1 A/m, 50 or 60 Hz IEC 61000-4-8; 1 A/m, 50 or 60 Hz

Voltage dips and  
interruptions

IEC 61000-4-11; >95% reductions, 0.5 
period; 30% reduction, 25 periods

IEC 61000-4-11; >95% reductions, 0.5 
period; 30% reduction, 25 periods

IEC 61000-4-11; >95% reductions,
0.5 period; 30% reduction, 25 periods

Harmonics EN61000-3-2:2006 +A1:2009
+A2:2009 Class A

EN61000-3-2:2006 +A1:2009
+A2:2009 Class A

EN61000-3-2:2006 +A1:2009
+A2:2009 Class A

Flicker EN61000-3-3:2008 EN61000-3-3:2008 EN61000-3-3:2008

Management

Aruba Central; Aruba AirWave Net-
work Management; IMC – Intelligent 
Management Center; Command-line 
interface; Web browser; Configuration 
menu; Out-of-band management  
(RJ-45 Ethernet); In-line and out-of-
band; Out-of-band management 
(serial RS-232c or micro usb)

Aruba Central; Aruba AirWave Net-
work Management; IMC – Intelligent 
Management Center; Command-line 
interface; Web browser; Configuration 
menu; Out-of-band management  
(RJ-45 Ethernet); In-line and out-of-
band; Out-of-band management 
(serial RS-232c or micro usb)

Aruba Central; Aruba AirWave Net-
work Management; IMC – Intelligent 
Management Center; Command-line 
interface; Web browser; Configuration 
menu; Out-of-band management  
(RJ-45 Ethernet); In-line and out-of-
band; Out-of-band management 
(serial RS-232c or micro usb)

Services

Refer to the Hewlett Packard  
Enterprise website at www.hpe.com/

networking/services for details on 
the service-level descriptions and 
product numbers. For details about 
services and response times in your 
area, please contact your local Hewlett 
Packard Enterprise sales office.

Refer to the Hewlett Packard  
Enterprise website at www.hpe.com/

networking/services for details on 
the service-level descriptions and 
product numbers. For details about 
services and response times in your 
area, please contact your local Hewlett 
Packard Enterprise sales office.

Refer to the Hewlett Packard  
Enterprise website at www.hpe.com/

networking/services for details on 
the service-level descriptions and 
product numbers. For details about 
services and response times in your 
area, please contact your local Hewlett 
Packard Enterprise sales office.
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ARUBA 3810 SWITCH SERIES

SPECIFICATIONS

Aruba 3810M 48G PoE+ 1-slot 
Switch (JL074A)

Aruba 3810M 16SFP+ 2-slot Switch 
(JL075A)

Aruba 3810M 40G 8 HPE Smart Rate 
PoE+ 1-slot Switch (JL076A)

Included accessories

1 Aruba 3810 Switch Fan Tray 
(JL088A)

1 Aruba 3810 Switch Fan Tray 
(JL088A)

1 Aruba 3810 Switch Fan Tray 
(JL088A)

I/O ports and slots

48 RJ-45 autosensing 10/100/1000 
PoE+ ports (IEEE 802.3 Type 
10BASE-T, IEEE 802.3u Type 
100BASE-TX, IEEE 802.3ab Type 
1000BASE-T, IEEE 802.3at PoE+); 
Duplex: 10BASE-T/100BASE-TX: half 
or full; 1000BASE-T: full only;  
Ports 1 – 48 support MACSec

1 open module slot 

Supports a maximum of 4 SFP+ 
ports or 2 40GbE ports, with optional 
module or 4 Smart Rate ports

16 SFP+ fixed 1000/10000 SFP+ 
ports; Duplex: 100BASE-TX: half or 
full; 1000BASE-T: full only;  
Ports 1 – 16 support MACSec

2 open module slots  

Supports a maximum of 8 SFP+ 
ports or 2 40GbE ports, with optional 
module or 4 Smart Rate ports

40 RJ-45 autosensing 10/100/1000 
PoE+ ports (IEEE 802.3 Type 
10BASE-T, IEEE 802.3u Type 
100BASE-TX, IEEE 802.3ab Type 
1000BASE-T, IEEE 802.3at PoE+); 
Duplex: 10BASE-T/100BASE-TX:  
half or full; 1000BASE-T: full only; 
Ports 1 – 40 support MACSec

8 RJ-45 HPE Smart Rate Multi- 
Gigabit ports; Ports 1 – 8 support 
MACSec

1 open module slot

Supports a maximum of 4 SFP+ 
ports or 2 40GbE ports, with optional 
module or 4 Smart Rate ports

Additional ports and slots

1 stacking module slot

1 RJ-45 serial console port

1 RJ-45 out-of-band management 
port

1 dual-personality (RJ-45 or  
USB micro-B)

1 stacking module slot

1 RJ-45 serial console port

1 RJ-45 out-of-band management 
port

1 dual-personality (RJ-45 or  
USB micro-B)

1 stacking module slot

1 RJ-45 serial console port

1 RJ-45 out-of-band management 
port

1 dual-personality (RJ-45 or  
USB micro-B)

Power supplies

2 power supply slots

1 minimum power supply  
required (ordered separately)

2 power supply slots 

1 minimum power supply  
required (ordered separately)

2 power supply slots 

1 minimum power supply  
required (ordered separately)

Fan tray

Includes: 

1 x JL088A 

1 fan tray slot

Switch ships with 1 JL088A fan tray 
installed. Spares ordered separately.

Includes: 

1 x JL088A 

1 fan tray slot

Switch ships with 1 JL088A fan tray 
installed. Spares ordered separately.

Includes: 

1 x JL088A 

1 fan tray slot

Switch ships with 1 JL088A fan tray 
installed. Spares ordered separately.

Physical characteristics

Dimensions 17.42(w) x 16.98(d) x 1.73(h) in  
(44.25 x 43.13 x 4.39 cm)  
(1U height)

17.42(w) x 16.98(d) x 1.73(h) in  
(44.25 x 43.13 x 4.39 cm)  
(1U height)

17.42(w) x 16.98(d) x 1.73(h) in  
(44.25 x 43.13 x 4.39 cm)  
(1U height)

Weight 13.62 lb (6.18 kg) 13.28 lb (6.02 kg) 13.61 lb (6.17 kg)

Memory and processor

P2020 Dual Core @ 1.2 GHz, 4 GB 
DDR3 SDRAM, 1 GB SD Card

P2020 Dual Core @ 1.2 GHz, 4 GB 
DDR3 SDRAM, 1 GB SD Card

P2020 Dual Core @ 1.2 GHz, 4 GB 
DDR3 SDRAM, 1 GB SD Card

Dual ARM Coretex A9 @ 1 GHz,  
2 GB DDR3 SDRAM; Packet buffer 
size: 13.5 MB Internal

Dual ARM Coretex A9 @ 1 GHz,  
2 GB DDR3 SDRAM; Packet buffer 
size: 13.5 MB Internal

Dual ARM Coretex A9 @ 1 GHz,  
2 GB DDR3 SDRAM; Packet buffer 
size: 13.5 MB Internal
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DATA SHEET 
ARUBA 3810 SWITCH SERIES

SPECIFICATIONS

Aruba 3810M 48G PoE+ 1-slot 
Switch (JL074A)

Aruba 3810M 16SFP+ 2-slot Switch 
(JL075A)

Aruba 3810M 40G 8 HPE Smart Rate 
PoE+ 1-slot Switch (JL076A)

Mounting and enclosure

Mounts in an EIA-standard 19 in. 
telco rack or equipment cabinet 
(hardware included); Horizontal 
surface mounting only

Mounts in an EIA-standard 19 in. 
telco rack or equipment cabinet 
(hardware included); Horizontal 
surface mounting only

Mounts in an EIA-standard 19 in. 
telco rack or equipment cabinet 
(hardware included); Horizontal 
surface mounting only

Performance

IPv6 Ready Certified IPv6 Ready Certified IPv6 Ready Certified

1000 Mb Latency < 2.8 µs (FIFO 64-byte packets) < 2.8 µs (FIFO 64-byte packets) < 2.8 µs (FIFO 64-byte packets)

10 Gbps Latency < 1.8 µs (FIFO 64-byte packets) < 1.8 µs (FIFO 64-byte packets) < 1.8 µs (FIFO 64-byte packets)

40 Gbps Latency < 1.5 µs (FIFO 64-byte packets) < 1.5 µs (FIFO 64-byte packets) < 1.5 µs (FIFO 64-byte packets)

Throughput up to 190.5 Mpps (64-byte packets) up to 285.7 Mpps (64-byte packets) up to 273.8 Mpps (64-byte packets)

Routing/Switching capacity 320 Gbps 480 Gbps 480 Gbps

Switch fabric speed 338 Gbps 508 Gbps 508 Gbps

Routing table size 10000 entries (IPv4),  
5000 entries (IPv6)

10000 entries (IPv4),  
5000 entries (IPv6)

10000 entries (IPv4),  
5000 entries (IPv6)

MAC address table size 64000 entries 64000 entries 64000 entries

Environment

Operating temperature 32°F to 113°F (0°C to 45°C) 32°F to 113°F (0°C to 45°C) 32°F to 113°F (0°C to 45°C)

Operating relative  
humidity

15% to 95% @ 104°F (40°C),  
noncondensing

15% to 95% @ 104°F (40°C),  
noncondensing

15% to 95% @ 104°F (40°C),  
noncondensing

Nonoperating/Storage 
temperature

-40°F to 158°F (-40°C to 70°C) -40°F to 158°F (-40°C to 70°C) -40°F to 158°F (-40°C to 70°C)

Nonoperating/Storage 
relative humidity

15% to 90% @ 149°F (65°C),  
noncondensing

15% to 90% @ 149°F (65°C),  
noncondensing

15% to 90% @ 149°F (65°C),  
noncondensing

Altitude up to 10,000 ft (3 km) up to 10,000 ft (3 km) up to 10,000 ft (3 km)

Acoustic Power: 42 dB, Pressure: 26 dB Power: 39 dB, Pressure: 22.3 dB Power: 45 dB, Pressure: 27.9 dB

Primary Airflow Direction Front to Side and Front to Rear Front to Side and Front to Rear Front to Side and Front to Rear
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DATA SHEET 
ARUBA 3810 SWITCH SERIES

SPECIFICATIONS

Aruba 3810M 48G PoE+ 1-slot 
Switch (JL074A)

Aruba 3810M 16SFP+ 2-slot Switch 
(JL075A)

Aruba 3810M 40G 8 HPE Smart Rate 
PoE+ 1-slot Switch (JL076A)

Electrical characteristics

Frequency 50/60Hz 50/60Hz 50/60Hz

Voltage JL086A PSU: 100-127/200-240 VAC

JL087A PSU: 110-127/200-240 VAC

JL085A PSU: 100-127/200-240 VAC JL086A PSU: 100-127/200-240 VAC

JL087A PSU: 110-127/200-240 VAC

Current JL086A PSU (Each): 5A/2.5A

JL087A PSU (Each): 8.5A/5A

JL085A PSU (Each): 1A/0.5A JL086A PSU (Each): 5A/2.5A

JL087A PSU (Each): 8.5A/5A

Max/Idle Power Rating 
(Switch+ 1 PSU)

135W/103W 120W/95W 190W/158W

Second PSU Power Adder 10W 10W 10W

Max/Idle Uplink  
Power Adder

JL078A: 4W/3W

JL079A: 7W/3W

JL081A: 4W/3W

JL083A: 11W/4W

JL078A: 4W/3W

JL079A: 7W/3W

JL081A: 4W/3W

JL083A: 11W/4W

JL078A: 4W/3W

JL079A: 7W/3W

JL081A: 4W/3W

JL083A: 11W/4W

Maximum Heat  
Dissipation *(Max Case)

531.96 480.81 719.51

PoE Power (Max Possible) 1440W N/A 1440W

Notes Idle power is the actual power 
consumption of the device with no 
ports connected. Maximum power 
rating and maximum heat dissipation 
are the worst case theoretical  
maximum numbers provide for 
planning the infrastructure with 
fully loaded PoE (if equipped),  
100% traffic, all ports plugged in, 
and all modules populated. This is a 
modular product. 

*Switch + 2 power supplies + one 
JL083A Uplink. For most accurate 
heat dissipation, idle and max  
power for any combination of  
chassis and accessories, please 
consult configurator.

Idle power is the actual power 
consumption of the device with no 
ports connected. Maximum power 
rating and maximum heat dissipation 
are the worst case theoretical  
maximum numbers provide for 
planning the infrastructure with 
fully loaded PoE (if equipped),  
100% traffic, all ports plugged in, 
and all modules populated. This is a 
modular product. 

*Switch + 2 power supplies + one 
JL083A Uplink. For most accurate 
heat dissipation, idle and max  
power for any combination of  
chassis and accessories, please 
consult configurator.

Idle power is the actual power 
consumption of the device with no 
ports connected. Maximum power 
rating and maximum heat dissipation 
are the worst case theoretical  
maximum numbers provide for 
planning the infrastructure with 
fully loaded PoE (if equipped),  
100% traffic, all ports plugged in, 
and all modules populated. This is a 
modular product. 

*Switch + 2 power supplies + one 
JL083A Uplink. For most accurate 
heat dissipation, idle and max  
power for any combination of  
chassis and accessories, please 
consult configurator.

Safety

EN 60950/IEC 60950; UL 60950; 
UL 60950-1; CAN/CSA 22.2 No. 
60950; EN 60825; CSA 22.2 
60950-1; EN62479:2010; EN 
60950-1:2006 +A11:2009 +A1:2010 
+A12:2011+A2:2013; EN 62368-1, 
Ed. 2; IEC 60950-1:2005 Ed.2; Am 
1:2009+A2:2013; IEC 60825:2007; 
EN60850-1:2007 / IEC 60825-1: 
2007 Class1 Class 1 Laser Products 
/ Laser Klasse 1; UL 62368-1 Ed.2

EN 60950/IEC 60950; UL 60950; 
UL 60950-1; CAN/CSA 22.2 No. 
60950; EN 60825; CSA 22.2 
60950-1; EN62479:2010; EN 
60950-1:2006 +A11:2009 +A1:2010 
+A12:2011+A2:2013; EN 62368-1, 
Ed. 2; IEC 60950-1:2005 Ed.2; Am 
1:2009+A2:2013; IEC 60825:2007; 
EN60850-1:2007 / IEC 60825-1: 
2007 Class1 Class 1 Laser Products 
/ Laser Klasse 1; UL 62368-1 Ed.2

EN 60950/IEC 60950; UL 60950; 
UL 60950-1; CAN/CSA 22.2 No. 
60950; EN 60825; CSA 22.2 
60950-1; EN62479:2010; EN 
60950-1:2006 +A11:2009 +A1:2010 
+A12:2011+A2:2013; EN 62368-1, 
Ed. 2; IEC 60950-1:2005 Ed.2; Am 
1:2009+A2:2013; IEC 60825:2007; 
EN60850-1:2007 / IEC 60825-1: 
2007 Class1 Class 1 Laser Products 
/ Laser Klasse 1; UL 62368-1 Ed.2
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DATA SHEET 
ARUBA 3810 SWITCH SERIES

SPECIFICATIONS

Aruba 3810M 48G PoE+ 1-slot 
Switch (JL074A)

Aruba 3810M 16SFP+ 2-slot Switch 
(JL075A)

Aruba 3810M 40G 8 HPE Smart Rate 
PoE+ 1-slot Switch (JL076A)

Emissions

FCC Class A; VCCI Class A; EN 
55022/CISPR 22 Class A; EN 60950-
1:2006  +A11:2009  +A1:2010  
+A12:2011+A2:2013

FCC Class A; VCCI Class A; EN 
55022/CISPR 22 Class A; EN 60950-
1:2006  +A11:2009  +A1:2010  
+A12:2011+A2:2013

FCC Class A; VCCI Class A; EN 
55022/CISPR 22 Class A; EN 60950-
1:2006  +A11:2009  +A1:2010  
+A12:2011+A2:2013

Immunity

Generic EN55022: 2010 EN55022: 2010 EN55022: 2010

EN EN55024: 2010 EN55024: 2010 EN55024: 2010

ESD IEC 61000-4-2 IEC 61000-4-2 IEC 61000-4-2

Radiated IEC 61000-4-3; 3 V/m IEC 61000-4-3; 3 V/m IEC 61000-4-3; 3 V/m

EFT/Burst IEC 61000-4-4; 1.0 kV (power line), 
0.5 kV (signal line)

IEC 61000-4-4; 1.0 kV (power line), 
0.5 kV (signal line)

IEC 61000-4-4; 1.0 kV (power line), 
0.5 kV (signal line)

Surge IEC 61000-4-5; 1 kV/2 kV AC IEC 61000-4-5; 1 kV/2 kV AC IEC 61000-4-5; 1 kV/2 kV AC

Conducted IEC 61000-4-6; 3 V IEC 61000-4-6; 3 V IEC 61000-4-6; 3 V

Power frequency  
magnetic field

IEC 61000-4-8; 1 A/m, 50 or 60 Hz IEC 61000-4-8; 1 A/m, 50 or 60 Hz IEC 61000-4-8; 1 A/m, 50 or 60 Hz

Voltage dips and  
interruptions

IEC 61000-4-11; >95% reductions, 0.5 
period; 30% reduction, 25 periods

IEC 61000-4-11; >95% reductions, 0.5 
period; 30% reduction, 25 periods

IEC 61000-4-11; >95% reductions, 0.5 
period; 30% reduction, 25 periods

Harmonics EN61000-3-2:2006 +A1:2009 
+A2:2009 Class A

EN61000-3-2:2006 +A1:2009 
+A2:2009 Class A

EN61000-3-2:2006 +A1:2009 
+A2:2009 Class A

Flicker EN61000-3-3:2008 EN61000-3-3:2008 EN61000-3-3:2008

Management

Aruba Central; Aruba AirWave  
Network Management; IMC –  
Intelligent Management Center; 
Command-line interface; Web 
browser; Configuration menu; 
Out-of-band management (RJ-45 
Ethernet); In-line and out-of-band; 
Out-of-band management (serial 
RS-232c or micro usb)

Aruba Central; Aruba AirWave  
Network Management; IMC –  
Intelligent Management Center; 
Command-line interface; Web 
browser; Configuration menu; 
Out-of-band management (RJ-45 
Ethernet); In-line and out-of-band; 
Out-of-band management (serial 
RS-232c or micro usb)

Aruba Central; Aruba AirWave  
Network Management; IMC –  
Intelligent Management Center; 
Command-line interface; Web 
browser; Configuration menu; 
Out-of-band management (RJ-45 
Ethernet); In-line and out-of-band; 
Out-of-band management (serial 
RS-232c or micro usb)

Services

Refer to the Hewlett Packard  
Enterprise website at  
www.hpe.com/networking/services 
for details on the service-level 
descriptions and product numbers. 
For details about services and 
response times in your area, please 
contact your local Hewlett Packard 
Enterprise sales office.

Refer to the Hewlett Packard  
Enterprise website at 
www.hpe.com/networking/services 
for details on the service-level 
descriptions and product numbers. 
For details about services and 
response times in your area, please 
contact your local Hewlett Packard 
Enterprise sales office.

Refer to the Hewlett Packard  
Enterprise website at  
www.hpe.com/networking/services 
for details on the service-level 
descriptions and product numbers. 
For details about services and 
response times in your area, please 
contact your local Hewlett Packard 
Enterprise sales office.
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DATA SHEET 
ARUBA 3810 SWITCH SERIES

SPECIFICATIONS

Aruba 3810M 48G PoE+ 4SFP+ 680W 
Switch (JL428A)

Aruba 3810M 48G PoE+ 4SFP+ 
1050W Switch (JL429A)

Aruba 3810M 24SFP+ 250W Switch 
(JL430A)

Included accessories

1 Aruba 3810 Switch Fan Tray 
(JL088A)

1 Aruba 3810M 4SFP+ Module 
(JL083A)

1 Aruba Aruba X372 54VDC 680W 
100-240VAC Power Supply (JL086A)

1 Aruba 3810 Switch Fan Tray 
(JL088A)

1 Aruba 3810M 4SFP+ Module 
(JL083A)

1 Aruba X372 54VDC 1050W 110-
240VAC Power Supply (JL087A)

1 Aruba 3810 Switch Fan Tray 
(JL088A)

2 Aruba 3810M 4SFP+ Module 
(JL083A)

1 Aruba X371 12VDC 250W 100-
240VAC Power Supply (JL085A)

I/O ports and slots

48 RJ-45 autosensing 10/100/1000 
PoE+ ports (IEEE 802.3 Type 
10BASE-T, IEEE 802.3u Type 
100BASE-TX, IEEE 802.3ab Type 
1000BASE-T, IEEE 802.3at PoE+); 
Duplex: 10BASE-T/100BASE-TX: half 
or full; 1000BASE-T: full only; Ports 
1-48 support MACSec

Supports a maximum of 4 SFP+ ports 
or 2 40 GbE ports, with optional  
module or 4 Smart Rate ports

48 RJ-45 autosensing 10/100/1000 
PoE+ ports (IEEE 802.3 Type 
10BASE-T, IEEE 802.3u Type 
100BASE-TX, IEEE 802.3ab Type 
1000BASE-T, IEEE 802.3at PoE+); 
Duplex: 10BASE-T/100BASE-TX: half 
or full; 1000BASE-T: full only; Ports 
1-48 support MACSec

Supports a maximum of 4 SFP+ ports 
or 2 40 GbE ports, with optional  
module or 4 Smart Rate ports

24 SFP+ fixed 1000/10000 SFP+ 
ports; Duplex: 100BASE-TX: half or 
full; 1000BASE-T: full only; Ports 
1-24 support MACSec

Supports a maximum of 24 SFP+ 
ports or 2 40 GbE ports, with  
optional module(s) or 4 Smart  
Rate ports

Additional ports and slots

1 stacking module slot

1 RJ-45 serial console port

1 RJ-45 out-of-band management port

1 dual-personality (RJ-45 or  
USB micro-B)

1 stacking module slot

1 RJ-45 serial console port

1 RJ-45 out-of-band management port

1 dual-personality (RJ-45 or  
USB micro-B)

1 stacking module slot

1 RJ-45 serial console port

1 RJ-45 out-of-band management port

1 dual-personality (RJ-45 or  
USB micro-B)

Power supplies

2 power supply slots

1 power supply included

1 minimum power supply required
(ordered separately)

2 power supply slots

1 power supply included

1 minimum power supply required
(ordered separately)

2 power supply slots

1 power supply included

1 minimum power supply required
(ordered separately)

Fan tray

Includes: 

1 x JL088A

1 fan tray slot

Switch ships with 1 JL088A fan tray 
installed. Spares ordered separately..

Includes: 

1 x JL088A

1 fan tray slot

Switch ships with 1 JL088A fan tray 
installed. Spares ordered separately..

Includes: 

1 x JL088A

1 fan tray slot

Switch ships with 1 JL088A fan tray 
installed. Spares ordered separately.

Physical characteristics

Dimensions 17.42(w) x 16.98(d) x 1.73(h) in. 
(44.25 x 43.13 x 4.39 cm)  
(1U height)

17.42(w) x 16.98(d) x 1.73(h) in. 
(44.25 x 43.13 x 4.39 cm)  
(1U height)

17.42(w) x 16.98(d) x 1.73(h) in. 
(44.25 x 43.13 x 4.39 cm)  
(1U height)

Weight 15.82 lb (7.18 kg) 15.94 lb (7.23 kg) 15.56 lb (7.06 kg)

Memory and processor

P2020 Dual Core @ 1.2 GHz, 4 GB 
DDR3 SDRAM, 1 GB SD Card

P2020 Dual Core @ 1.2 GHz, 4 GB 
DDR3 SDRAM, 1 GB SD Card

P2020 Dual Core @ 1.2 GHz, 4 GB 
DDR3 SDRAM, 1 GB SD Card

Dual ARM Coretex A9 @ 1 GHz,  
2 GB DDR3 SDRAM; Packet buffer 
size: 13.5 MB Internal

Dual ARM Coretex A9 @ 1 GHz,  
2 GB DDR3 SDRAM; Packet buffer 
size: 13.5 MB Internal

Dual ARM Coretex A9 @ 1 GHz,  
2 GB DDR3 SDRAM; Packet buffer 
size: 13.5 MB Internal
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DATA SHEET 
ARUBA 3810 SWITCH SERIES

SPECIFICATIONS

Aruba 3810M 48G PoE+ 4SFP+ 680W 
Switch (JL428A)

Aruba 3810M 48G PoE+ 4SFP+ 
1050W Switch (JL429A)

Aruba 3810M 24SFP+ 250W Switch 
(JL430A)

Mounting and enclosure

Mounts in an EIA-standard 19 in. 
telco rack or equipment cabinet 
(hardware included); Horizontal 
surface mounting only

Mounts in an EIA-standard 19 in. 
telco rack or equipment cabinet 
(hardware included); Horizontal 
surface mounting only

Mounts in an EIA-standard 19 in. 
telco rack or equipment cabinet 
(hardware included); Horizontal 
surface mounting only

Performance

IPv6 Ready Certified IPv6 Ready Certified IPv6 Ready Certified

1000 Mb Latency < 2.8 µs (FIFO 64-byte packets) < 2.8 µs (FIFO 64-byte packets) < 2.8 µs (FIFO 64-byte packets)

10 Gbps Latency < 1.8 µs (FIFO 64-byte packets) < 1.8 µs (FIFO 64-byte packets) < 1.8 µs (FIFO 64-byte packets)

40 Gbps Latency < 1.5 µs (FIFO 64-byte packets) < 1.5 µs (FIFO 64-byte packets) < 1.5 µs (FIFO 64-byte packets)

Throughput up to 190.5 Mpps (64-byte packets) up to 190.5 Mpps (64-byte packets) up to 285.7 Mpps (64-byte packets)

Routing/Switching capacity 320 Gbps 320 Gbps 480 Gbps

Switch fabric speed 338 Gbps 338 Gbps 508 Gbps

Routing table size 10000 entries (IPv4),  
5000 entries (IPv6)

10000 entries (IPv4),  
5000 entries (IPv6)

10000 entries (IPv4),  
5000 entries (IPv6)

MAC address table size 64000 entries 64000 entries 64000 entries

Environment

Operating temperature 32°F to 113°F (0°C to 45°C) 32°F to 113°F (0°C to 45°C) 32°F to 113°F (0°C to 45°C)

Operating relative  
humidity

15% to 95% @ 104°F (40°C),  
noncondensing

15% to 95% @ 104°F (40°C),  
noncondensing

15% to 95% @ 104°F (40°C),  
noncondensing

Nonoperating/Storage 
temperature

-40°F to 158°F (-40°C to 70°C) -40°F to 158°F (-40°C to 70°C) -40°F to 158°F (-40°C to 70°C)

Nonoperating/Storage 
relative humidity

15% to 90% @ 149°F (65°C),  
noncondensing

15% to 90% @ 149°F (65°C),  
noncondensing

15% to 90% @ 149°F (65°C),  
noncondensing

Altitude up to 10,000 ft (3 km) up to 10,000 ft (3 km) up to 10,000 ft (3 km)

Acoustic Power: 47 dB, Pressure: 29.4 dB Power: 47 dB, Pressure: 29.4 dB Power: 39 dB, Pressure: 22.3 dB

Primary Airflow Direction Front to Side and Front to Rear Front to Side and Front to Rear Front to Side and Front to Rear
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DATA SHEET 
ARUBA 3810 SWITCH SERIES

SPECIFICATIONS

Aruba 3810M 48G PoE+ 4SFP+ 680W 
Switch (JL428A)

Aruba 3810M 48G PoE+ 4SFP+ 
1050W Switch (JL429A)

Aruba 3810M 24SFP+ 250W Switch 
(JL430A)

Electrical  characteristics

Frequency 50/60Hz 50/60Hz 50/60Hz

Voltage JL086A PSU: 100-127/200-240 VAC

JL087A PSU: 110-127/200-240 VAC

JL086A PSU: 100-127/200-240 VAC

JL087A PSU: 110-127/200-240 VAC

JL085A PSU: 100-127/200-240 VAC

Current JL086A PSU (Each): 5A/2.5A

JL087A PSU (Each): 8.5A/5A

JL086A PSU (Each): 5A/2.5A

JL087A PSU (Each): 8.5A/5A

JL085A PSU (Each): 1A/0.5A

Max/Idle Power Rating 
(Switch+ 1 PSU)

146W/107W 146W/107W 142W/103W

Second PSU Power Adder 10W 10W 10W

Max/Idle Uplink  
Power Adder

JL078A: 4W/3W

JL079A: 7W/3W

JL081A: 4W/3W

JL083A: 11W/4W

JL078A: 4W/3W

JL079A: 7W/3W

JL081A: 4W/3W

JL083A: 11W/4W

JL078A: 4W/3W

JL079A: 7W/3W

JL081A: 4W/3W

JL083A: 11W/4W

Maximum Heat  
Dissipation *(Max Case)

531.96 531.96 480.81

PoE Power (Max Possible) 1440W 1440W N/A

Notes Idle power is the actual power  
consumption of the device with  
no ports connected. Maximum 
power rating and maximum heat 
dissipation are the worst case  
theoretical maximum numbers  
provide for planning the infrastructure 
with fully loaded PoE (if equipped), 
100% traffic, all ports plugged in, 
and all modules populated. This is a 
modular product. 

*Switch + 2 power supplies + one 
JL083A Uplink. For most accurate 
heat dissipation, idle and max  
power for any combination of  
chassis and accessories, please 
consult configurator.

Idle power is the actual power  
consumption of the device with  
no ports connected. Maximum 
power rating and maximum heat 
dissipation are the worst case  
theoretical maximum numbers  
provide for planning the infrastructure 
with fully loaded PoE (if equipped), 
100% traffic, all ports plugged in, 
and all modules populated. This is a 
modular product. 

*Switch + 2 power supplies + one 
JL083A Uplink. For most accurate 
heat dissipation, idle and max  
power for any combination of  
chassis and accessories, please 
consult configurator.

Idle power is the actual power  
consumption of the device with  
no ports connected. Maximum 
power rating and maximum heat 
dissipation are the worst case  
theoretical maximum numbers  
provide for planning the infrastructure 
with fully loaded PoE (if equipped), 
100% traffic, all ports plugged in, 
and all modules populated. This is a 
modular product. 

*Switch + 2 power supplies + one 
JL083A Uplink. For most accurate 
heat dissipation, idle and max  
power for any combination of  
chassis and accessories, please 
consult configurator.

Safety

EN 60950/IEC 60950; UL 60950; 
UL 60950-1; CAN/CSA 22.2 No. 
60950; EN 60825; CSA 22.2 
60950-1; EN62479:2010; EN 
60950-1:2006 +A11:2009 +A1:2010 
+A12:2011+A2:2013; EN 62368-1, 
Ed. 2; IEC 60950-1:2005 Ed.2; Am 
1:2009+A2:2013; IEC 60825:2007; 
EN60850-1:2007 / IEC 60825-1: 
2007 Class1 Class 1 Laser Products 
/ Laser Klasse 1; UL 62368-1 Ed.2

EN 60950/IEC 60950; UL 60950; 
UL 60950-1; CAN/CSA 22.2 No. 
60950; EN 60825; CSA 22.2 
60950-1; EN62479:2010; EN 
60950-1:2006 +A11:2009 +A1:2010 
+A12:2011+A2:2013; EN 62368-1, 
Ed. 2; IEC 60950-1:2005 Ed.2; Am 
1:2009+A2:2013; IEC 60825:2007; 
EN60850-1:2007 / IEC 60825-1: 
2007 Class1 Class 1 Laser Products 
/ Laser Klasse 1; UL 62368-1 Ed.2

EN 60950/IEC 60950; UL 60950; 
UL 60950-1; CAN/CSA 22.2 No. 
60950; EN 60825; CSA 22.2 
60950-1; EN62479:2010; EN 
60950-1:2006 +A11:2009 +A1:2010 
+A12:2011+A2:2013; EN 62368-1, 
Ed. 2; IEC 60950-1:2005 Ed.2; Am 
1:2009+A2:2013; IEC 60825:2007; 
EN60850-1:2007 / IEC 60825-1: 
2007 Class1 Class 1 Laser Products 
/ Laser Klasse 1; UL 62368-1 Ed.2
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SPECIFICATIONS

Aruba 3810M 48G PoE+ 4SFP+ 680W 
Switch (JL428A)

Aruba 3810M 48G PoE+ 4SFP+ 
1050W Switch (JL429A)

Aruba 3810M 24SFP+ 250W Switch 
(JL430A)

Emissions

FCC Class A; VCCI Class A; EN 
55022/CISPR 22 Class A; EN 60950-
1:2006  +A11:2009  +A1:2010  
+A12:2011+A2:2013

FCC Class A; VCCI Class A; EN 
55022/CISPR 22 Class A; EN 60950-
1:2006  +A11:2009  +A1:2010  
+A12:2011+A2:2013

FCC Class A; VCCI Class A; EN 
55022/CISPR 22 Class A; EN 60950-
1:2006  +A11:2009  +A1:2010  
+A12:2011+A2:2013

Immunity

Generic EN55022: 2010 EN55022: 2010 EN55022: 2010

EN EN55024: 2010 EN55024: 2010 EN55024: 2010

ESD IEC 61000-4-2 IEC 61000-4-2 IEC 61000-4-2

Radiated IEC 61000-4-3; 3 V/m IEC 61000-4-3; 3 V/m IEC 61000-4-3; 3 V/m

EFT/Burst IEC 61000-4-4; 1.0 kV (power line), 
0.5 kV (signal line)

IEC 61000-4-4; 1.0 kV (power line), 
0.5 kV (signal line)

IEC 61000-4-4; 1.0 kV (power line), 
0.5 kV (signal line)

Surge IEC 61000-4-5; 1 kV/2 kV AC IEC 61000-4-5; 1 kV/2 kV AC IEC 61000-4-5; 1 kV/2 kV AC

Conducted IEC 61000-4-6; 3 V IEC 61000-4-6; 3 V IEC 61000-4-6; 3 V

Power frequency  
magnetic field

IEC 61000-4-8; 1 A/m, 50 or 60 Hz IEC 61000-4-8; 1 A/m, 50 or 60 Hz IEC 61000-4-8; 1 A/m, 50 or 60 Hz

Voltage dips and  
interruptions

IEC 61000-4-11; >95% reductions, 0.5 
period; 30% reduction, 25 periods

IEC 61000-4-11; >95% reductions, 0.5 
period; 30% reduction, 25 periods

IEC 61000-4-11; >95% reductions, 0.5 
period; 30% reduction, 25 periods

Harmonics EN61000-3-2:2006 +A1:2009 
+A2:2009 Class A

EN61000-3-2:2006 +A1:2009 
+A2:2009 Class A

EN61000-3-2:2006 +A1:2009 
+A2:2009 Class A

Flicker EN61000-3-3:2008 EN61000-3-3:2008 EN61000-3-3:2008

Management

Aruba Central; Aruba AirWave  
Network Management; IMC –  
Intelligent Management Center; 
Command-line interface; Web 
browser; Configuration menu; 
Out-of-band management (RJ-45 
Ethernet); In-line and out-of-band; 
Out-of-band management (serial 
RS-232c or micro usb)

Aruba Central; Aruba AirWave  
Network Management; IMC –  
Intelligent Management Center; 
Command-line interface; Web 
browser; Configuration menu; 
Out-of-band management (RJ-45 
Ethernet); In-line and out-of-band; 
Out-of-band management (serial 
RS-232c or micro usb)

Aruba Central; Aruba AirWave  
Network Management; IMC –  
Intelligent Management Center; 
Command-line interface; Web 
browser; Configuration menu; 
Out-of-band management (RJ-45 
Ethernet); In-line and out-of-band; 
Out-of-band management (serial 
RS-232c or micro usb)

Services

Refer to the Hewlett Packard  
Enterprise website at  
www.hpe.com/networking/services 
for details on the service-level 
descriptions and product numbers. 
For details about services and 
response times in your area, please 
contact your local Hewlett Packard 
Enterprise sales office.

Refer to the Hewlett Packard  
Enterprise website at 
www.hpe.com/networking/services 
for details on the service-level 
descriptions and product numbers. 
For details about services and 
response times in your area, please 
contact your local Hewlett Packard 
Enterprise sales office.

Refer to the Hewlett Packard  
Enterprise website at  
www.hpe.com/networking/services 
for details on the service-level 
descriptions and product numbers. 
For details about services and 
response times in your area, please 
contact your local Hewlett Packard 
Enterprise sales office.
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STANDARDS AND PROTOCOLS  

(APPLIES TO ALL PRODUCTS IN SERIES)

BGP
• RFC 1997 BGP Communities Attribute
• RFC 2918 Route Refresh Capability

• RFC 4271 A Border Gateway Protocol 4 (BGP-4)
• RFC 4456 BGP Route Reflection: An Alternative to Full 

Mesh Internal BGP (IBGP)

• RFC 4724 Graceful Restart Mechanism for BGP
• RFC 5492 Capabilities Advertisement with BGP-4

Denial of service protection  
• CPU DoS Protection

Device management 
• RFC 1591 DNS (client)
• RFC 2576 (Coexistence between SNMP V1, V2, V3)
• RFC 2579 (SMIv2 Text Conventions)
• RFC 2580 (SMIv2 Conformance)

• RFC 3416 (SNMP Protocol Operations v2)
• RFC 3417 (SNMP Transport Mappings)
• HTML and telnet management

General protocols
• IEEE 802.1ad Q-in-Q
• IEEE 802.1AX-2008 Link Aggregation
• IEEE 802.1D MAC Bridges
• IEEE 802.1p Priority
• IEEE 802.1Q VLANs
• IEEE 802.1s Multiple Spanning Trees
• IEEE 802.1v VLAN classification by Protocol and Port
• IEEE 802.1w Rapid Reconfiguration of Spanning Tree
• IEEE 802.3ad Link Aggregation Control Protocol (LACP)
• IEEE 802.3af Power over Ethernet
• IEEE 802.3az Energy Efficient Ethernet
• IEEE 802.3x Flow Control
• IEEE 802.3bz 2.5 Gbps and 5 Gbps interfaces
• RFC 768 UDP
• RFC 783 TFTP Protocol (revision 2)
• RFC 792 ICMP
• RFC 793 TCP
• RFC 826 ARP

• RFC 854 TELNET
• RFC 868 Time Protocol

• RFC 951 BOOTP

• RFC 1058 RIPv1

• RFC 1350 TFTP Protocol (revision 2)

• RFC 1519 CIDR

• RFC 1542 BOOTP Extensions

• RFC 1918 Address Allocation for Private Internet

• RFC 2030 Simple Network Time Protocol (SNTP) v4
• RFC 2131 DHCP

• RFC 2453 RIPv2

• RFC 2548 (MS-RAS-Vendor only)

• RFC 3046 DHCP Relay Agent Information Option

• RFC 3575 IANA Considerations for RADIUS
• RFC 3576 Ext to RADIUS (CoA only)
• RFC 3768 VRRP
• RFC 4675 RADIUS VLAN & Priority
• RFC 5798 VRRP (exclude Accept Mode and sub-sec timer)
• RFC 5880 Bidirectional Forwarding Detection

• RFC 5905 Network Time Protocol Version 4: Protocol and 
Algorithms Specification

• UDLD (Uni-directional Link Detection)

IP multicast
• RFC 3376 IGMPv3
• RFC 3973 PIM Dense Mode
• RFC 4601 PIM 

IPv6
• RFC 1981 IPv6 Path MTU Discovery

• RFC 2080 RIPng for IPv6

• RFC 2081 RIPng Protocol Applicability Statement

• RFC 2082 RIP-2 MD5

• RFC 2375 IPv6 Multicast Address Assignments
• RFC 2460 IPv6 Specification
• RFC 2464 Transmission of IPv6 over Ethernet Networks
• RFC 2710 Multicast Listener Discovery (MLD) for IPv6
• RFC 2925 Definitions of Managed Objects for Remote 

Ping, Traceroute, and Lookup Operations (Ping only)
• RFC 3019 MLDv1 MIB

• RFC 3315 DHCPv6 (client only)

• RFC 3484 Default Address Selection for IPv6

• RFC 3587 IPv6 Global Unicast Address Format
• RFC 3596 DNS Extension for IPv6
• RFC 3810 MLDv2 (host joins only)

• RFC 4022 MIB for TCP

• RFC 4087 IP Tunnel MIB
• RFC 4113 MIB for UDP

• RFC 4213 Basic Transition Mechanisms for IPv6 Hosts  

and Routers

• RFC 4251 SSHv6 Architecture

• RFC 4252 SSHv6 Authentication

• RFC 4253 SSHv6 Transport Layer

• RFC 4254 SSHv6 Connection

• RFC 4291 IP Version 6 Addressing Architecture
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• RFC 4293 MIB for IP

• RFC 4294 IPv6 Node Requirements
• RFC 4419 Key Exchange for SSH

• RFC 4443 ICMPv6

• RFC 4541 IGMP & MLD Snooping Switch
• RFC 4861 IPv6 Neighbor Discovery
• RFC 4862 IPv6 Stateless Address Auto-configuration
• RFC 5095 Deprecation of Type 0 Routing Headers in IPv6

• RFC 5340 OSPFv3 for IPv6

• RFC 5453 Reserved IPv6 Interface Identifiers
• RFC 5519 Multicast Group Membership Discovery MIB 

(MLDv2 only)

• RFC 5722 Handling of Overlapping IPv6 Fragments
• RFC 6620 FCFS SAVI

• draft-ietf-savi-mix

MIBs
• IEEE 802.1ap (MSTP and STP MIB’s only)
• IEEE 8021-Bridge-MIB (2008)

• IEEE 8021-Q-Bridge-MIB (2008)

• RFC 1155 Structure & ID of Mgmt Info for TCP/IP Internets
• RFC 1213 MIB II

• RFC 1493 Bridge MIB

• RFC 1724 RIPv2 MIB
• RFC 1850 OSPFv2 MIB

• RFC 2021 RMONv2 MIB
• RFC 2096 IP Forwarding Table MIB

• RFC 2578 Structure of Management Information  
Version 2 (SMIv2)

• RFC 2613 SMON MIB
• RFC 2618 RADIUS Client MIB

• RFC 2620 RADIUS Accounting MIB

• RFC 2665 Ethernet-Like-MIB
• RFC 2668 802.3 MAU MIB
• RFC 2674 802.1p and IEEE 802.1Q Bridge MIB
• RFC 2737 Entity MIB (Version 2)
• RFC 2787 VRRP MIB
• RFC 2863 The Interfaces Group MIB

• RFC 2925 Ping MIB

• RFC 2932 IP (Multicast Routing MIB)

• RFC 2933 IGMP MIB

• RFC 3411 SNMP Management Frameworks
• RFC 3412 Message Processing and Dispatching for the 

Simple Network Management Protocol (SNMP) 
• RFC 3413 Simple Network Management Protocol (SNMP) 

Applications 

• RFC 3414 User-based Security Model (USM) for version 3 

of the Simple Network Management Protocol (SNMPv3) 
• RFC 3415 View-based Access Control Model (VACM) for 

the Simple Network Management Protocol (SNMP) 
• RFC 3418 Management Information Base (MIB) for the 

Simple Network Management Protocol (SNMP)
• RFC 4836 Managed Objects for 802.3 Medium Attachment 

Units (MAU)

• RFC 7331 BFD MIB

Network management
• IEEE 802.1AB Link Layer Discovery Protocol (LLDP)
• RFC 2819 Four groups of RMON: 1 (statistics), 2 (history),  

3 (alarm) and 9 (events)

• RFC 3176 sFlow
• RFC 5424 Syslog Protocol

• ANSI/TIA-1057 LLDP Media Endpoint Discovery (LLDP-MED)
• SNMPv1/v2c/v3
• XRMON

OSPF
• RFC 2328 OSPFv2

• RFC 3101 OSPF NSSA
• RFC 3623 Graceful OSPF Restart (Unplanned Outages only)

• RFC 5340 OSPFv3 for IPv6

QoS/CoS

• RFC 2474 DiffServ Precedence, including 8 queues/port
• RFC 2475 DiffServ Architecture
• RFC 2597 DiffServ Assured Forwarding (AF)
• RFC 2598 DiffServ Expedited Forwarding (EF)

Security
• IEEE 802.1X Port Based Network Access Control
• RFC 1321 The MD5 Message-Digest Algorithm

• RFC 2698 A Two Rate Three Color Marker
• RFC 2818 HTTP Over TLS RFC 1492 TACACS+
• RFC 2865 RADIUS (client only)

• RFC 2866 RADIUS Accounting

• RFC 3579 RADIUS Support For Extensible Authentication 
Protocol (EAP)

• Secure Sockets Layer (SSL)
• SSHv2 Secure Shell
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ARUBA 3810 SWITCH SERIES ACCESSORIES

Modules
• Aruba 3810M/2930M 4 1/2.5/5/10 GbE HPE Smart Rate 

Module (JL081A)

• Aruba 3810M 4-port Stacking Module (JL084A) 
• Aruba 3810M/2930M 1QSFP+ 40GbE Module (JL078A)
• Aruba 3810M/2930M 4SFP+ MACsec Module (JL083A)
• Aruba 3810M 2QSFP+ 40GbE Module (JL079A)

Transceivers   
• Aruba 100M SFP LC FX 2km MMF XCVR (J9054D)  
• Aruba 1G SFP RJ45 T 100m Cat5e XCVR (J8177D)  
• Aruba 1G SFP LC SX 500m MMF XCVR (J4858D)  
• Aruba 1G SFP LC LX 10km SMF XCVR (J4859D)  
• Aruba 1G SFP LC LH 70km SMF XCVR (J4860D)  
• Aruba 10G SFP+ LC SR 300m MMF XCVR (J9150D)  
• Aruba 10G SFP+ LC LR 10km SMF XCVR (J9151D)  
• Aruba 10G SFP+ LC LRM 220m MMF XCVR (J9152D)  
• Aruba 10G SFP+ LC ER 40km SMF XCVR (J9153D)  
• Aruba 10G SFP+ to SFP+ 1m DAC Cable (J9281D)  
• Aruba 10G SFP+ to SFP+ 3m DAC Cable (J9283D)  
• Aruba 10G SFP+ to SFP+ 7m DAC Cable (J9285D)  
• Aruba 40G QSFP+ LC BiDi 150m MMF XCVR (JL308A)  
• HPE X142 40G QSFP+ MPO SR4 Transceiver (JH231A)  
• HPE X142 40G QSFP+ LC LR4 SM Transceiver (JH232A)  
• HPE X142 40G QSFP+ MPO eSR4 300M XCVR (JH233A)  
• HPE X242 40G QSFP+ to QSFP+ 1m DAC Cable (JH234A)  
• HPE X242 40G QSFP+ to QSFP+ 3m DAC Cable (JH235A)  
• HPE X242 40G QSFP+ to QSFP+ 5m DAC Cable (JH236A) 

 Cables
• Aruba X2C2 RJ45 to DB9 Console Cable (JL448A)
• HPE 3800 0.5m Stacking Cable (J9578A)
• HPE 3800 1m Stacking Cable (J9665A)
• HPE 3800 3m Stacking Cable (J9579A)

Power Supply
• Aruba X371 12VDC 250W 100-240VAC Power Supply 

(JL085A) 

• Aruba X372 54VDC 680W 100-240VAC Power Supply 
(JL086A) 

• Aruba X372 54VDC 1050W 110-240VAC Power Supply 
(JL087A)

Fan Tray
• Aruba 3810 Switch Fan Tray (JL088A)

Mounting Kit
• HPE X410 1U Universal 4-post Rack Mounting Kit (J9583A)
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PROTOCOLS AND FEATURES ARUBA 5400R ARUBA 3810M ARUBA 3800 ARUBA 2930M ARUBA 2930F ARUBA 2920 ARUBA 2540 ARBUA 2530
Max_Vlan 4094 4094 4094 2048 2048 1022 512 512

Max_Vlan_IPv4 1024 1024 1024 1024 512 512 512 512

Max_Vlan_IPV6 512 512 512 512 512 256 512 512

Max_Vlan_mixed IPv4 & IPV6(dual stack) 1024 1024 1024 512 512 512 512 512

Multinetting per Vlan for   IPV4 or IPV6 32 32 32 32 32 32 32 32

Max_IPV4 and IPv6 Multinetting 2048 2048 2048 2048 2048 2048 2048 2048

DHCP Server Vlans 512 512 512 512 512 256 256 N/S

DHCP Pool limit 512 512 128 128 128 128 64 N/S

Maximum DHCP Relay helper address for 

IPV4

16 16 16 16 16 16 16 16

Maximum DHCP Relay helper address for  

IPV6 and Mixed (IPV4 & IPV6)

Per   Vlan 32 Per   Vlan 32 Per   Vlan 32 Per Vlan 32 Per   Vlan 32 Per   Vlan 32 per vlan 32 Per   Vlan 32

DHCP Snooping and DHCP V6 Snooping Max   binding 8192 Max   binding 8192 Max   binding 8192 Max binding 8192 Max binding 8192 Max   binding 8192 max binding 8192 Max binding 8192

IPV6_ND_Snooping clients Max   binding  16384 (Global 

IPv6 address + Link local 

Ipv6 address)

Max   binding  16384 (Global IPv6 

address + Link local Ipv6 address)

Max   binding  16384 (Global 

IPv6 address + Link local Ipv6 

address)

Max   binding  16384 

(Global IPv6 address + 

Link local Ipv6 address)

Max   binding  16384 

(Global IPv6 address + Link 

local Ipv6 address)

Max   binding  16384 

(Global IPv6 address + 

Link local Ipv6 address)

Max   binding  16384 

(Global IPv6 address + 

Link local Ipv6 address)

NS

IPv6-ND Snooping Per   Vlan 32 Prefixlist Per   Vlan 32 Prefixlist Per   Vlan 32 Prefixlist Per Vlan 32 Prefixlist Per Vlan 32 Prefixlist Per   Vlan 32 Prefixlist Per   Vlan 32 Prefixlist NS

DIPLD and DIPLD V6 64   Lock down entries per 

hardware

64   Lock down entries per hardware 64   Lock down entries per 

hardware

64 Lock down entries per 

hardware

64 Lock down entries per 

hardware

64   Lock down entries per 

hardware

64   Lock down entries 

per hardware

64   Lock down entries per 

hardware

DLDP 5406R - up to 144 ports

5412R - up to 288 ports

Based   on switchport Based   on switchport Based on switchport Based on switchport Based   on switchport Based   on switchport Based   on switchport

UDLD 5406R - up to 144 ports

5412R - up to 288 ports

Based   on switchport Based   on switchport Based on switchport Based   on switchport Based   on switchport Based   on switchport Based   on switchport

LLDP over OOBM 128   neigbours 128   neigbours 128   neigbours 128 neighbors Not Supported 128   neigbours Not Supported Not Supported

ACL & ACE IPv4 2048   ACL &8192 ACE 2048   ACL &8192 ACE 2048   ACL &8192 ACE 1024 ACL & 4096 ACE 1024 ACL & 4096 ACE 256 ACL & 512 ACE 256 ACL & 2048   ACE 256 ACL (YA), 255 ACL (YB) & 

2150 ACE (YA), 1638 (YB)

ACL & ACE IPv6 2048   ACL &8192 ACE 2048   ACL &8192 ACE 2048   ACL &8192 ACE 1024 ACL & 4096 ACE 1024 ACL & 4096 ACE 256 ACL & 512 ACE 256 ACL & 2048   ACE 128 ACL (YA), 1075 ACE (YA) & 

Not supported (YB)

Mac ACL 2048   ACL & 8192 ACE 2048   ACL & 8192 ACE 2048   ACL & 8192 ACE 1024 ACL & 4096 ACE 1024 ACL & 4096   ACE NS 256 ACL & 2150   ACE NS

Dot1x 32   Clients per port 32   Clients per port 32   Clients per port user based 32 Clients per port 32   Clients per port 32   Clients per port 32   Clients per port 32   Clients per port

Port Based   MAC Authentication 64K 64K 64K 64K 64K 16K 16K 16K

Mac-auth 256 address per   port 256   address per port 256   address per port user 

based

256 address per port 256 address per port 32   address per port 32   address per port 32   address per port

Web-auth 256   Clients per port 256   Clients per port 256   Clients per port user based 256 Clients per port 256 Clients per port 32   Clients per port 32   Clients per port 32   Clients per port

Port-security 64   address per port 64   address per port 64   address per port 64 address per port 64   address per port 64   address per port 64   address per port 64   address per port

PVST Instances 400 400 400 128 128 64 32 32

MSTP Instances for stacking devices N/A 4 4 4 N/A 4 N/S N/S

MSTP Instances 64 64 64 16 16 16 16 16

ARP Throttle blacklist limit 8192 8192 8192 8192 8192 8192 8192 NS

ARP protection 8192 8192 8192 8192 8192 8192 8192 8192

ARP Throttle exclude Mac address limit 10 10 10 10 10 10 10 NS

Static Route Interface based 256 256 256 256 256 256 256 256

Static Route gateway based 1024 1024 1024 256 256 256 256 256

OSPFv2 routes 10000 10000 10000 200 200 200 NS NS

OSPFv2 Area ID 16 16 16 1 1 1 NS NS

OSPFv2 interface 128 128 128 8 8 8 NS NS

OSPFv3 routes 5000 5000 5000 200 200 200 NS NS

OSPFv3 Area ID 16 16 16 1 1 1 NS NS

OSPFv2 peers 128 128 128 128 128 128 NS NS

OSPFv3 peers 128 128 128 128 128 128 NS NS

OSPFv3 Interface 128 128 128 8 8 8 NS NS

VRRP - VR's per Vlan 32 32 32 16 NS NS NS NS

VRRP - VR's 512 512 512 128 NS NS NS NS

VRRP-IPv6 VR's per Vlan 32 32 32 16 NS NS NS NS

VRRP - IPv6 VR's 512 512 512 128 NS NS NS NS

Static-Mac 500 500 500 500 500 500 500 500

RIP routes 10000 10000 10000 10000 10000 10000 2000 NS

RIP peers 128 128 128 128 128 128 32 NS

RIP interface 128 128 128 128 128 128 32 NS

RIPng routes 5000 5000 5000 5000 5000 NS 2000 NS

BGP routes 10000 10000 10000 NS NS NS NS NS

BGP max Peers 10000 32 32 NS NS NS NS NS

sflow instances 3 3 3 3 3 3 3 3

local mirror Session 4 4 4 4 4 1 1 1

remote mirror session 4 4 4 4 4 NS NS NS

remote mirror end point 32 32 32 32 32 NS NS NS

NTP Server 8 8 8 8 8 8 8 8

PVLAN 32 32 32 32 32 16 NS NS

PIM Interface 128 128 128 16 NS NS NS NS

OpenFlow Instance 128 128 128 16 16 16 NS NS

OpenFlow Rules 65535 65535 65535 16000 16000 16000 NS NS

Cert Manager TA Prfile numbers 10 10 10 10 10 10 10 10

Telnet/SSH-Sessions 5 5 5 5 5 5 5 5

RBAC Authorization Groups 64 64 64 64 64 64 64 64

MVRP 512Vlan's/128Ports 512Vlan's/128Ports 512Vlan's/128Ports 512Vlan's/128Ports 512Vlan's/128Ports 512Vlan's/128Ports 512Vlan's/128Ports 512Vlan's/128Ports

VSF 8   x 10G(V3 only) NS NS NS Not Supported for   

spokane

NS NS NS

2   x 40G(V3 only) Not Supported for Ukiah Not Supported for   

spokane

NS NS

ZTP 1   NMS 1   NMS 1   NMS 1 NMS 1   NMS 1   NMS 1   NMS 1   NMS

IGMP dynamic filter (IGMP multicast groups) 2038 2038 2038 1023 1023 1023 1013   dynamic filters + 

10 static filters

502

MLD dynamic filter 2037 2037  2037 1023 1023 1023 502 

BFD Sessions 128 128 128 NS NS NS NS NS

RBAC Rules Per Group 1000 1000 1000 1000 1000 1000 1000 1000

Schedule Job 1000 1000 1000 1000 1000 1000 1000 1000

MDNS Max Vlans per profile 10 10 10 10 10 10 5 5

MDNS Max Profiles 50 50 50 50 50 50 25 25

MDNS Max Rules per profile 15 15 15 15 15 15 15 15

MDNS Max gateway vlans 4094 4094 4094 2048 2048 1022 512 512

IPSLA Responder 10 10 10 10 10 10 N/S N/S

IPSLA sessions 50 50 50 50 50 50 N/S N/S

Stacking NS 10   Members 10   Members 10 Members NS 4   Members NS NS

SNMP Community Strings 5 5 5 5 5 5 5 5

SNMP Trap Receivers 10 10 10 10 10 10 10 10

MAS Device profiles 5 5 5 5 5 5 5 5

MAC address table entries 64K 64K 64K 64K 64K 16K 16K 16K

 ARP table entries for IPv4 and IPv6  25000  25000  25000 25000  25000  25000  1000

REST API Sessions 5 5 5 5 5 5 5 5

Classifiers (qos Policies ) 3072   Policies 3072   Policies 1024   Policies 1152  Policies 1152  Policies 256 Policies NS NS

Classifiers (user Policies ) NS NS NS 1152  Policies NS 256 256 256

Classifiers (Classes ) 3072  IPv4 and IPv6 Classes 3072  IPv4 and IPv6 Classes 1024  IPv4 and IPv6 Classes 1151  IPv4 and IPv6 

Classes

1151  IPv4 and IPv6 

Classes

256    IPv4 and IPv6 

Classes, total

255 255

Classifiers (Class entriess ) 8192   Class entries 8192   Class entries 3072   Class entries 3070 entries 3070 entries 254   class entries 2046 2046

TrustQOS 5406R - up to 144 ports

5412R - up to 288 ports

Based   on switchport Based   on switchport Based   on switchport Based   on switchport Based   on switchport Based   on switchport Based   on switchport (YA only)

8k   entries shared per line 

card

8k   entries shared per line card 8k   entries shared per line card 8K entries shared per line 

card

8k   entries shared per line 

card

2k   entries shared per line 

card

2k   entries shared per 

line card

2k   entries shared per line card

Service Insertion intercept tunnel 16 16 16 16 16 16 16 NS

Service Insertion tap tunnel 4 4 4 4 4 4 4 NS

VXLAN tunnel 64 64 N/A 64 64(V3 only) N/A NS NS

VxLAN Virtual network 64 64 N/A 64 64(V3 only) N/A NS NS

Tunnel node 5406R - up to 144 ports

5412R - up to 288 ports

512 -  VSF

32 clients per port 

1024 clients per switch

 512 stacked

32 clients per port 

1024 clinents per switch

 512 stacked

32 clients per port 

1024 clinents per switch

520 stacked

32 clients per port 

1024 clinents per switch

 192 stacked

32 clients per port 

1024 clinents per switch

 208 stacked

32 clients per port 

1024 clinents per switch

NS NS
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Certificate No. / Nº do Certificado 

 
NCC 13159/16 

 

Issued Date / Data de emissão: 26/04/2016 
Valid until / Válido até: Indeterminado 
Product certified since / Produto certificado desde: 22/03/2016 
Maintenance Date / Data de Manutenção: N/A 
Revision / Revisão: 1 

Associação NCC Certificações do Brasil 
OCD pelo Ato nº 16.955 (08/01/2001) 

www.ncc.org.br 
Brasil 

Page / Página: 1 / 3 
 

CONFORMITY CERTIFICATE ISSUED BY A 
CERTIFICATION BODY DESIGNATED BY ANATEL 

CERTIFICADO DE CONFORMIDADE EMITIDO POR 
ORGANISMO DE CERTIFICAÇÃO DESIGNADO PELA 

ANATEL 

CONFORMITY CERTIFICATE CERTIFICADO DE CONFORMIDADE 

Product 
Produto 

Equipamento de Rede de Dados 

Model / Type Ref. 
Modelo / Tipo de referência 

RSVLC-1407 e RSVLC-1408 (*) 

Name and address of the applicant 
Nome e endereço do solicitante 

Hewlett-Packard Brasil Ltda.  
Alameda Rio Negro, 750 – 2º Andar, Sala 3 - Alphaville  
CEP: 06454-000 – Barueri – SP 
CNPJ: 61.797.924/0003-17 

Name and address of the manufacturer (technology owner) 
Nome e endereço do fabricante (detentor da tecnologia) 

Hewlett Packard Enterprise. 
8000 Foothills Boulevard, MS5502, Roseville, California 95747-
5502, Estados Unidos. 

Name and address of the factory 
Nome e endereço da fábrica 

Unidades Fabris – Vide item 4) – Informações Adicionais 

Ratings and principal characteristics 
Especificações e principais características 

Vide item 1) Especificações e principais características.*/ 

Additional information 
Informações adicionais 

Categoria: III 
 
Serviço/Aplicação: Redes Locais 

Process identification number 
Número de identificação de processo 

36936/16.1.Re1 

One or more samples of the product were tested and found to be in 
conformity with 
Uma ou mais amostras do produto foram ensaiadas e encontraram-
se em conformidade com 

Resolução Nº 442 

This certificate is only valid with all pages, which has the complementary information for this certification. 

Este certificado é apenas válido com todas as páginas, que contêm as informações complementares para esta certificação. 

  

This Conformity Certificate is issued by a Certification Body Designated by Anatel. 
Este Certificado de Conformidade foi emitido por um Organismo de Certificação Designado pela Anatel. 

 Technical Manager / Gerente Técnico  
 

Digitally signed by ANDRE LUIZ 
ROCHA CARLETTI:04381601777
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Certificate No. / Nº do Certificado 

 
NCC 13159/16 

 

Issued Date / Data de emissão: 26/04/2016 
Valid until / Válido até: Indeterminado 
Product certified since / Produto certificado desde: 22/03/2016 
Maintenance Date / Data de Manutenção: N/A 
Revision / Revisão: 1 

Associação NCC Certificações do Brasil 
OCD pelo Ato nº 16.955 (08/01/2001) 

www.ncc.org.br 
Brasil 

Page / Página: 2 / 3 
 

1) Especificações e Principais Características 
 
Equipamento de rede de dados com características de comutador (switch) para aplicações em redes Ethernet. Modelos testados:  
RSVLC-1407 (part-number JL076A) e RSVLC-1408 (part-numbers JL075A e JL072A). 
 

2) Relatório(s) de Testes e Laboratório(s) 
 

Laboratórios Nacionais Relatório de Ensaio Norma Aplicável Data de Emissão 

INPE / LIT - Laboratório de Integração 
e Testes (www.lit.inpe.br) 

Endereço: Av. dos Astronautas, 1758  
 São José dos Campos-SP  

CEP: 12227-010 
Telefone: (12) 3208-6000 

Contato: Marco Antonio Strobino. 

HPBL38-R01 Resolução Nº 442 11/03/2016 

HPBL38-R02 Resolução Nº 442 11/03/2016 

HPBL38-R03 Resolução Nº 442 11/03/2016 

HPBL38-R04 Resolução Nº 442 15/04/2016 

Justificativa Laboratorial: (   ) Sim (vide campo “Informações Adicionais no RACT”) 
                                                               (X)  Não  
 

3) Documentação descritiva do equipamento 
 

Documento Descrição Revisão 

Relatório de Análise de 
Conformidade Técnica (RACT) 

RACT do Processo Nº 36936/16.1.Re1 0 

Manual do Usuário / Técnico Manual do usuário  N/A 
Especificação Técnica Especificação Técnica  N/A 

Fotos Internas Fotos internas  N/A 
Fotos Externas Fotos externas  N/A 

Esquema Elétrico Declaração Esquema elétrico N/A 
Certificado ISO 9001 Certificado ISO 9001 Nº: 951 12 6203-N2 / TL10972/84 N/A 

 

4) Informações Adicionais 

 
Este Certificado substitui o de mesmo número emitido em 22/03/2016. 
Motivo: Inclusão da fonte modelo: JL086A. 
 
(*) Os modelos RSVLC-1407 e RSVLC-1408 descritos na tabela abaixo pertencem à família Aruba 3810M Switch Series, 
diferenciando-se pelo Part Numbers abaixo: 

 

Modelo: Part Numbers Descrição: 

RSVLC-1408 JL071A 24 portas RJ-45 10/100/1000 com 1 slot de expansão 
RSVLC-1408 JL072A 48 portas RJ-45 10/100/1000 com 1 slot de expansão 
RSVLC-1407 JL073A 24 portas RJ-45 10/100/1000 com PoE+ e 1 slot de expansão 
RSVLC-1407 JL074A 48 portas RJ-45 10/100/1000 com PoE+ e 1 slot de expansão 
RSVLC-1408 JL075A 16 portas SFP+ com 2 slots de expansão 

RSVLC-1407 JL076A 
40 portas RJ-45 10/100/1000 com PoE+, 8 portas RJ-45 HP Smart Rate (1 / 2.5 / 5 / 
10 GbE) com PoE+ e 1 slot de expansão 
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Os equipamentos serão comercializados com as fontes de alimentação conforme descritas abaixo: 
 Modelo JL087A (Delta Electronics, Inc.) com tensão de entrada igual a 110 – 240 V (60 Hz / 5-12A) e tensão de saída igual a 

52,6 V (19,97 A). A fonte modelo JL087A também pode ser identificada como DPS-1050EB A. 

 Modelo JL085A (Delta Electronics, Inc.) com tensão de entrada igual a 110 – 240 V (60 Hz / 1,2 -3 A) e tensão de saída igual a 
12 V (20,83 A). A fonte modelo JL085A também pode ser identificada como DPS-240AB-7 A. 

 Modelo JL086A (Delta Electronics, Inc.) com tensão de entrada igual a 100 – 240 V (60 Hz / 3,5 - 8 A) e tensão de saída igual a 
52,6 V (12,93 A). A fonte modelo JL086A também pode ser identificada como DPS-650AB-5 A. 

 
Transceptores ópticos utilizados nos ensaios: 

 J4859C - HP  1G - 1310 nm (SFP); 
 J9151A - HP  10G - 1310 nm (SFP+). 

 
Unidades Fabris Terceirizadas 
 

1. Flextronics Manufacturing (Singapore) Pte Ltd. 
                2, Changi South Lane, 486123, Singapura. 
 

2. Sanmina Plant 5545 
                2 Chai Chee Drive, 469044, Singapura, Republica de Singapura. 
 

5) Observações 
 
Este Certificado é baseado em ensaio de tipo e é válido apenas para os equipamentos de modelos idênticos aos equipamentos 
efetivamente ensaiados e demais modelos descritos neste documento. Quaisquer modificações nos projetos, bem como a utilização 
de componentes e/ou materiais diferentes daqueles definidos pela documentação descritiva dos equipamentos, sem a prévia 
autorização da NCC, invalidarão este Certificado. 
 
O usuário tem a responsabilidade de assegurar que os produtos serão instalados em atendimento às instruções do fabricante e as 
normas e regulamentos aplicados a este. 
 
Conforme os termos do Ato de Designação nº 16.955 e do Termo de Responsabilidade 002/RFGCT/RFCE/SRF de 08/06/2001, o 
produto acima especificado atende as normas e resoluções da ANATEL sendo que o mesmo deverá obrigatoriamente, ser 
homologado por esta Agência e portar Etiqueta Anatel para fins de comercialização e uso. 

 

6) Histórico da Revisão 
 

Revisão Nº do processo Certificado Data da emissão Descrição 

0 36936/16.1 NCC 13159/16 22/03/2016 Emissão inicial 
1 36936/16.1.Re1 NCC 13159/16 26/04/2016 1ª Reemissão 
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Resumo da garantia e suporte do produto da HPE Networking
 
(outubro de 

2018) 
 

A versão mais atual deste documento está disponível em www.hpe.com/networking/warrantysummary 
Detalhes da política de garantia do produto de rede da HPE estão disponíveis em www.hpe.com/networking/warranty 

Informações sobre os serviços para produtos HPE Networking podem ser encontradas em www.hpe.com/networking/services  
 As informações contidas neste documento estão sujeitas a alterações sem aviso prévio. As garantias para produtos e serviços da HPE são as estabelecidas nas 

declarações de garantia expressa que acompanham tais produtos e serviços. Além disso, nossos produtos já vêm com garantias que não podem ser excluídas sob as leis 
do consumidor da Austrália e Nova Zelândia. Sujeitas às informações anteriores, nenhuma informação aqui descrita deve ser interpretada como parte de uma garantia 

adicional. A HPE não se responsabiliza por erros técnicos ou editoriais ou omissões contidos neste documento. 

 
 

 

 

Produtos 
Duração da 

garantia
1
 

Substituição de 
hardware

2
 

Suporte técnico 
em horário 
comercial

3
 

Suporte técnico 24h 
por dia, 7 dias por 

semana
3
 

(Após 1º de dezembro de 2015) 

Versões de 
software/sistem
a operacional

4
 

S
w

it
c
h

e
s

 

Modular      

 129xx, 125xx, 119xx 1 ano 10 dias 1 ano N/A Desde que sejam 
de propriedade4 

 105xx, 75xx 1 ano 10 dias 1 ano 90 dias Desde que sejam 
de propriedade4 

 84xx, 83xx 5 anos 10 dias 90 dias N/A 5 anos4 

 82xxzl, 54xxzl/R, 42xxvl 
Vida útil

5
 Envio no PDU 

Desde que sejam de 
propriedade5 

90 dias 
Desde que sejam 
de propriedade4 

Configuração fixa      

 79xx, 59xx/AF, 583x/AF, 582x/AF, 57xx 1 ano 10 dias 1 ano N/A Desde que sejam 
de propriedade4 

 Switches Altoline 9xxx, 6xxx (adquiridos após 31 de março de 

2016) 
1 ano 10 dias 1 ano N/A N/A 

 Switches Arista (Consulte 

http://www.arista.com/assets/data/pdf/Warranty.pdf para obter 
detalhes) 

1 ano15 10 dias15 1 ano15 N/A N/A 

 580x/AF 
Vida útil

5
 Envio no PDU 

Desde que sejam de 
propriedade5 

N/A 
Desde que sejam 
de propriedade4 

 55xx, 513x, 512x, 38xx, 36xx, 35xx/yl, 31xx, 29xx/al, 281x, 
26xx, 25xx/G 

Vida útil
5
 Envio no PDU 

Desde que sejam de 
propriedade5 

90 dias 
Desde que sejam 
de propriedade4 

Gerenciamento Inteligente       

 195x, 192x, 191x, 18xx, 17xx, 1620 (Adquiridos após 1º de 

outubro de 2017) 
Vida útil

14 
 Envio no PDU 

90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia14 

90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia14 

Desde que sejam 
de propriedade4 

Não gerenciado       

 1420, 1410 (Adquiridos após 1º de outubro de 2017) 

Vida útil
14 

 Envio no PDU 

90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia 14 

90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia 14 

N/A 

 1405 (Adquiridos após 1º de outubro de 2017) 3 anos
14

 Envio no PDU 90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia

 14
 

90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia

14
 

N/A 

L
A

N
 s

e
m

 f
io

 

Pontos de acesso internos      

 Pontos de acesso gerenciados por controlador (APs) Aruba 
Vida útil

10
 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A 90 dias (somente 

para correção de bug) 

 3WN/P, 155/P, pontos de acesso remoto Aruba 108/109 
(RAPs)  Vida útil

10
 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A 

Imagem 
atualizada 

periodicamente
13

 

 Pontos de acesso instantâneo Aruba (IAPs) 
Vida útil

10
 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A 

Imagem 
atualizada 

periodicamente
13

 

 M330, M2xx 
Vida útil

5
 Envio no PDU 

Desde que sejam de 
propriedade5 

90 dias 
Desde que sejam 
de propriedade4 

 Ponto de Acesso OfficeConnect 20 

3 anos
14

 Envio no PDU 

90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia

14
 

90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia

14
 

Desde que sejam 
de propriedade4 

Controladores      

 Controladores Aruba
 

1 ano 
30 dias 

PDU/Devolução 
à fábrica

11
 

90 dias
12

 N/A N/A 

 Switches de acesso a mobilidade Aruba 
Vida útil

10
 Envio no PDU 90 dias 90 dias 

Desde que sejam 
de propriedade4 

Outros produtos de WLAN       

 Pontos de acesso externos Gerenciados pelo Controlador 
Aruba Série 2xx Vida útil

10
 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A 90 dias (somente 

para correção de bug) 

 Pontos de acesso instantâneo externos Aruba Série 2xx 
(IAPs) Vida útil

10
 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A 

Imagem 
atualizada 

periodicamente
13

 

 Dispositivos AirWave, Dispositivos ClearPass, Dispositivos 
IntroSpect 1 ano 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias

12
 

N/A 
90 dias (somente 

para correção de bug) 

 Roteadores de malha sem fio para ambiente externo 
MST2HP, MST2HAC, MSR2KP, MSR4KP Aruba 1 ano 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias

12
 N/A 90 dias (somente 

para correção de bug) 

 Beacons Aruba 
90 dias 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A 90 dias (somente 

para correção de bug) 

 Sensores de capa 
90 dias 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A 90 dias (somente 

para correção de bug) 

 Fontes de alimentação, antenas e acessórios Aruba 
1 ano 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A N/A 
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Resumo da garantia e suporte do produto da HPE Networking
 
(outubro de 

2018) 
 

A versão mais atual deste documento está disponível em www.hpe.com/networking/warrantysummary 
Detalhes da política de garantia do produto de rede da HPE estão disponíveis em www.hpe.com/networking/warranty 

Informações sobre os serviços para produtos HPE Networking podem ser encontradas em www.hpe.com/networking/services  
 As informações contidas neste documento estão sujeitas a alterações sem aviso prévio. As garantias para produtos e serviços da HPE são as estabelecidas nas 

declarações de garantia expressa que acompanham tais produtos e serviços. Além disso, nossos produtos já vêm com garantias que não podem ser excluídas sob as leis 
do consumidor da Austrália e Nova Zelândia. Sujeitas às informações anteriores, nenhuma informação aqui descrita deve ser interpretada como parte de uma garantia 

adicional. A HPE não se responsabiliza por erros técnicos ou editoriais ou omissões contidos neste documento. 

 
 

 

 

R
o

te
a
d

o
re

s
 

Roteadores      

 
88xx, HSR68xx 1 ano 10 dias 1 ano 

N/A Desde que sejam de 
propriedade4 

 
HSR66xx, 66xx, MSR50, MSR4xxx, MSR3xxx, MSR30 1 ano 10 dias 1 ano 

90 dias Desde que sejam de 
propriedade4 

 
MSR2xxx, MSR20, MSR1xxx, MSR9xx 1 ano Envio no PDU 1 ano 

90 dias Desde que sejam de 
propriedade4 

 ALU 77xx 
1 ano

9
 

Devolução para 
a fábrica

9
 

1 ano
9
 N/A 

Todas as 
atualizações de 

licença adquiridas9 

 Roteadores VSR  
90 dias 

(Somente mídia) 
N/A 90 dias N/A 

Todas as 
atualizações de 

licença adquiridas8 

G
e

re
n

c
ia

m
e

n
to

 

Gerenciamento de rede      

 Centro de gerenciamento inteligente (detalhes do suporte em 

www.hpe.com/networking/IMCSupport) 
90 dias 

 (Somente mídia) 
N/A 90 dias N/A 90 dias (somente para 

correção de bug) 

 AirWave, ALE, Aruba Central, ClearPass, Meridian, VIA, Visual RF 90 dias 
 (Somente mídia) 

N/A 90 dias N/A 90 dias (somente para 

correção de bug) 

 Controlador HPE VAN SDN e aplicativos HPE SDN 90 dias 
 (Somente mídia) 

N/A 90 dias N/A Todas as 
atualizações de 

licença adquiridas8
 

 Rede em nuvem distribuída HPE  90 dias 
 (Somente mídia) 

N/A N/A N/A Nenhum 

 Dispositivos controladores da Big Switch Networks (Consulte 

www.bigswitch.com/support para detalhes sobre garantia e suporte) 
N/D

16
 N/D

16
 N/D

16
 N/D

16
 N/D

16
 

P
ro

d
u

to
s
 d

e
 r

e
d

e
 a

d
ic

io
n

a
is

 

Transceptores      

 Transceptores Aruba (Números dos produtos transceptores JWxxxx para 
Controladores e Switches MAS) 1 ano  

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A N/A 

 Transceptores da marca Aruba (exceto os números dos produtos 
transceptores JWxxxx) 
 e 
HPE X244, X242, X142, X132, X131, X129, X122, X121, X119, X112, X111 

Vida útil
5
 Envio no PDU Desde que 

sejam de 
propriedade5 

N/A N/A 

 Transceptores Aruba 100G 1 ano 10 dias 1 ano N/A N/A 

 HPE X2A0, X240, X190, X180, X170, X160, X150, X140, X135, X130, 
X125, X124, X120, X115, X114, X110 

1 ano 30 dias 1 ano N/A N/A 

 

1) Fontes de alimentação, módulos e acessórios removíveis, como antenas, ventiladores, cabos 
de alimentação, etc., podem ter cobertura de garantia diferente do dispositivo de host. 
Consulte a referência rápida de cobertura de garantia do HPE Networking em 
www.hpe.com/networking/warrantyquickref para obter mais detalhes.  

2) O tempo de resposta baseia-se em um esforço comercialmente razoável e está sujeito a um 
tempo de corte de envio diário. Em alguns países e regiões e de acordo com determinadas 
restrições do fornecedor o tempo de resposta pode variar. Entre em contato com a sua 
organização de serviço HPE local para obter a disponibilidade de tempo de resposta em sua 
área. Envio PDU = Envio no próximo dia útil. 

3) O suporte técnico da garantia por telefone ou meio eletrônico é fornecido durante o horário 
comercial da HPE local para todo o período de garantia para os fins de diagnóstico de 
defeitos de hardware ou software. Muitos produtos adquiridos após 1º de dezembro de 2015 
incluem 90 dias de suporte técnico 24 horas por dia, 7 dias por semana, conforme indicado. 
Consulte a declaração de garantia limitada Hewlett-Packard do produto para obter detalhes 
adicionais da cobertura. Serviços de cobertura estendida estão disponíveis. 

4) Inclui todas as versões de software/OS geralmente disponíveis oferecidas para os produtos 
específicos listados, quando e se disponíveis, enquanto o cliente possuir o produto, exceto 
onde observado. Algumas versões do software podem exigir hardware adicional ou novo. 
Clientes que desejem que atualizações, correções e ajustes de recurso específicos sejam 
priorizados em versões futuras, devem adquirir os serviços de suporte apropriados da HPE. 

5) Para os produtos adquiridos após 1º de dezembro de 2014, a garantia se estende somente 
enquanto o usuário final original possuir o produto. Inclui a cobertura de qualquer ventilador e 
fonte de alimentação incorporados por todo o período de garantia. Um comprovante de 
aquisição ou de arrendamento pode ser exigido como condição para que exista direito ao 
serviço de garantia.  

6) Garantia de hardware, suporte técnico e todas as versões de software fornecidas para 
hardware e apenas UM OS de serviço, quando e se disponíveis, enquanto o usuário final 
original possuir o produto. Consulte documentação específica do produto para suporte ao 
aplicativo. 5 anos de garantia na unidade de disco nos módulos de zl de serviços avançados 
HPE Alliance One. 

7) Produtos comprados antes de 1º de agosto de 2013 incluem 1 ano de suporte técnico e 1 
ano (somente correção de bugs).  

8) Inclui todas as atualizações de software oferecidas para a versão licenciada, quando e se 
disponível. Atualizações de software vão requerer a compra de SKU, pacote de serviços de 
suporte ou contrato apropriado. 

9) Todo o suporte técnico, de hardware e de software para produtos de ALU 77xx é fornecido 
diretamente somente pela Alcatel-Lucent e não pela HPE. Para suporte da Alcatel-Lucent, 
selecione o país do qual o cliente está ligando no link a seguir e ele mostrará as informações 
de contato de suporte da ALU apropriadas: https://Services.support.Alcatel-
Lucent.com/product_support/. A garantia de hardware requer o envio de produtos com falha 
para a ALU para o reparo ou reposição. O custo de logística para o envio de produto no local 
do cliente para o local da ALU para reparo ou reposição será coberto pelo cliente. Versões de 
manutenção de software estão incluídas para a principal versão do software adquirida. As 
principais atualizações de versão do software não estão incluídas. Serviços podem ser 
adquiridos na HPE ou na Alcatel-Lucent para expandir sua cobertura de suporte e upgrades 
de software. O suporte será fornecido pela Alcatel Lucent para esses serviços. 

10) Para os produtos adquiridos depois de 1º de dezembro de 2015, o hardware tem garantia 
estendida somente enquanto o usuário final original possuir o produto e está limitada a cinco 
(5) anos a partir da data de término da venda. 

11) Para os primeiros 30 dias a partir do envio, a HPE fornecerá a substituição 
antecipada de envio no mesmo dia para os produtos de hardware cobertos. Depois 
de trinta (30) dias a partir do envio e durante o período de garantia restante, a HPE 
substituirá ou reparará qualquer produto fora de conformidade e o devolverá em 
condição de operação, enviando após o recebimento da HPE do produto fora de 
conformidade por meio do procedimento RMA da HPE, com recebimento pelo 
cliente em até dez (10) dias em uma base comercialmente razoável. 

12) A HPE fornecerá uma resposta por e-mail no próximo dia útil com o propósito de 
diagnosticar defeitos de hardware ou software durante o horário comercial no 
Horário do Pacífico para os primeiros 90 dias após a compra.  

13) A HPE disponibilizará uma imagem de versão de software de OS instantânea 
recente no portal de software. Essa imagem também está disponível para pontos de 
acesso remoto (RAPs) que estejam executando o OS instantâneo. 

14) Esses produtos são cobertos por 90 dias de suporte telefônico 24x7. 
Posteriormente, apenas suporte por bate-papo estará disponível para o período 
restante da garantia. A garantia de vida útil limitada (quando aplicável) é estendida 
somente enquanto o usuário final original possuir o produto e está limitada a 5 
(cinco) anos a partir do final da data de venda.  Esta garantia inclui a cobertura de 
qualquer ventilador embutido e fonte de alimentação por todo o período de garantia. 
Um comprovante de aquisição ou de arrendamento pode ser exigido como condição 
para que exista direito ao serviço de garantia. Consulte 
www.hpe.com/OfficeConnect/support/ para mais informações sobre o novo 
processo de suporte do OfficeConnect.  

15) Todo o suporte técnico de hardware e de software para produtos Arista é fornecido 
diretamente pela Arista e não pela HPE. Consulte a página de suporte ao cliente da 
Arista para informações de contato: https://www.arista.com/en/support/customer-
support. Os custos de transporte, se houver, relacionados à devolução de um 
hardware defeituoso para um centro de reparos Arista será custeado pelo cliente. A 
Arista irá pagar quaisquer custos de transporte relacionados a uma nova entrega de 
um Hardware reparado ou substituído. Serviços podem ser adquiridos na HPE ou 
na Arista para expandir sua cobertura de suporte e upgrades de software. O suporte 
será fornecido pela Arista para esses serviços. Para obter detalhes sobre a garantia 
e suporte da Arista, consulte: http://www.arista.com/assets/data/pdf/Warranty.pdf. 

16) Todo o suporte técnico de hardware e de software para produtos Big Switch 
Networks é fornecido diretamente pela BSN e não pela HPE. Consulte a página de 
atendimento ao cliente da Big Switch Networks para informações de contato: 
www.bigswitch.com/support. Para detalhes sobre opções de garantia e suporte da 
Big Switch Networks, consulte: 
http://bigswitch.com/sites/default/files/bsn_support_and_maintenance_policy.v2.2.20
16.11.14.pdf. 
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Declaration of Conformity  
based on ISO/IEC 17050-1 and EN 17050-1 

 

1 / 2 

 

DoC #: RSVLC-1408 R4 / en 
Manufacturer's Name: Hewlett Packard Enterprise Company 
Manufacturer's Address: 8000 Foothills Blvd, Roseville, CA 95747, USA 

declare, under its sole responsibility that the product: 

Product Name and/or Model: Please refer to ANNEX I 
Regulatory Model Number: RSVLC-1408 

Product Options: JL078A, JL079A, JL083A, JL084A, JL085A 

conforms to the following product specifications and regulations: 

Safety Electromagnetic Compatibility 
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 62368:2014  
EN 62479:2010  

EN 55032:2012  
EN 55024:2010  
EN 61000-3-2:2006 +A1:2009 +A2:2009  
EN 61000-3-3:2013  

Restriction of the use of certain hazardous substances 
EN 50581:2012 

The product herewith complies with the requirements of Directive 2014/35/EU relating to electrical equipment designed for 
use within certain voltage limits, Directive 2014/30/EU relating to electromagnetic compatibility, Directive 2011/65/EU on the 
restriction of the use of certain hazardous substances in electrical and electronic equipment and carries the CE marking 
accordingly. 

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: 
(1) This device may not cause harmful interference, and (2) this device must accept any interference received, including 
interference that may cause undesired operation. 

Additional Information 

This product is assigned a Regulatory Model Number which stays with the regulatory aspects of the design. The Regulatory 
Model Number is the main product identifier in the regulatory documentation and test reports, this number should not be 
confused with the marketing name or the product numbers. 

This product was tested in a typical HPE environment. 

 

 
Roseville, CA Brent Ford, Manager 
21.03.2017 HPE Networking, CEB Business Organization 

Local contact for regulatory topics only 
EU: HPE, Postfach 0001, 1122 Wien, Austria 
U.S.:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Declaration of Conformity  
based on ISO/IEC 17050-1 and EN 17050-1 

 

2 / 2 

 

Product Name and/or Model 

JL071A Aruba 3810M 24p GT1s Switch 
Aruba 3810M 24G 1-slot Swch 

JL072A Aruba 3810M 48p GT1s Switch 
Aruba 3810M 48G 1-slot Swch 

JL075A Aruba 3810M 16p SFP+ 2s Switch 
Aruba 3810M 16SFP+ 2-slot Swch 

JL430A Aruba 3810M 24SFP+250W Swch  

ANNEX I 

Regulatory Model Number: RSVLC-1408 

Anexo 03 A 12 - ITEM 05 (0592596)         SEI 0008478-63.2018.6.02.8000 / pg. 4626



 

Декларация за Cъответствие  
съгласно ISO/IEC 17050-1 и EN 17050-1 

 

1 / 2 

 

ДзC #: RSVLC-1408 R4 / bg 

Име на производителя: Hewlett Packard Enterprise Company 
Адрес на производителя: 8000 Foothills Blvd, Roseville, CA 95747, USA 

декларира на собствена отговорност, че продуктът: 

име и/или модел на продукта: Моля, направете справка Приложение I 
нормативен номер на модела: RSVLC-1408 

опции на продукта: JL078A, JL079A, JL083A, JL084A, JL085A 

съответства на следните спецификации на продукта и регламенти: 

безопасност Eлектромагнитната Cъвместимост 
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 62368:2014  
EN 62479:2010  

EN 55032:2012  
EN 55024:2010  
EN 61000-3-2:2006 +A1:2009 +A2:2009  
EN 61000-3-3:2013  

Oграничението за употребата на определени опасни вещества 
EN 50581:2012 

Този продукт отговаря на изискванията на Директива 2014/35/ЕС относно електрически съоръжения, 
предназначени за използване при някои ограничения на напрежението, Директива 2014/30/ЕС относно 
електромагнитната съвместимост, Директива 2011/65/ЕС относно ограничението за употребата на определени 
опасни вещества в електрическото и електронното оборудване и носи съответната маркировка CE. 

Допълнителна информация 

Този продукт има нормативен номер на модела, който съответства на нормативните аспекти на дизайна. 
Нормативният номер на модела е основният идентификатор на продукта в нормативната документация и 
протоколите от тестовете, като този номер не трябва да се бърка с търговското име или номерата на продукта. 

Този продукт е изпитван в типична среда на HPE. 

 

 
Roseville, CA Brent Ford, Управител 
21.03.2017 HPE Networking, CEB Business Organization 

Информация за връзка в съответния регион само по правни въпроси 
ЕС: HPE, Postfach 0001, 1122 Wien, Austria 
САЩ:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Декларация за Cъответствие  
съгласно ISO/IEC 17050-1 и EN 17050-1 

 

2 / 2 

 

име и/или модел на продукта 

JL071A Aruba 3810M 24p GT1s Switch 
Aruba 3810M 24G 1-slot Swch 

JL072A Aruba 3810M 48p GT1s Switch 
Aruba 3810M 48G 1-slot Swch 

JL075A Aruba 3810M 16p SFP+ 2s Switch 
Aruba 3810M 16SFP+ 2-slot Swch 

JL430A Aruba 3810M 24SFP+250W Swch  

Приложение I 

нормативен номер на модела: RSVLC-1408 
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Prohlášení o Shodě  
na základě ISO/IEC 17050-1 a EN 17050-1 

 

1 / 2 

 

PoS #: RSVLC-1408 R4 / cs 
Název výrobce: Hewlett Packard Enterprise Company 
Adresa výrobce: 8000 Foothills Blvd, Roseville, CA 95747, USA 

prohlašuje na svou odpovědnost, že výrobek: 

Název Produktu a/nebo model: Podívejte se prosím DODATEK I 
Regulační číslo modelu: RSVLC-1408 

Možnosti výrobku: JL078A, JL079A, JL083A, JL084A, JL085A 

je v souladu s následující specializací výrobků a nařízeními: 

Bezpečnost Elektromagnetické Kompatibility 
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 62368:2014  
EN 62479:2010  

EN 55032:2012  
EN 55024:2010  
EN 61000-3-2:2006 +A1:2009 +A2:2009  
EN 61000-3-3:2013  

Omezení používání některých nebezpečných látek 
EN 50581:2012 

Tento výrobek splňuje požadavky Směrnice 2014/35/EU týkajících se elektrických zařízení určených pro používání v určitých 
mezích napětí, Směrnice 2014/30/EU týkajících se elektromagnetické kompatibility, Směrnice 2011/65/EU o omezení 
používání některých nebezpečných látek v elektrických a elektronických zařízeních a je správně CE označený. 

Další informace 

Výrobek má přidělené regulační číslo modelu, které je v souladu s regulačními aspekty designu. Regulační číslo modelu je 
hlavní identifikátor výrobku v regulační dokumentaci a v protokolu o zkoušce a není možné ho zaměňovat s obchodním 
názvem nebo číslem výrobku. 

Tento výrobek byl testovaný v typickém HPE prostředí. 

 

 
Roseville, CA Brent Ford, Manažer 
21.03.2017 HPE Networking, CEB Business Organization 

Místní kontakt výhradně pro regulační záležitosti 
EU: HPE, Postfach 0001, 1122 Wien, Austria 
USA:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Prohlášení o Shodě  
na základě ISO/IEC 17050-1 a EN 17050-1 

 

2 / 2 

 

Název Produktu a/nebo model 

JL071A Aruba 3810M 24p GT1s Switch 
Aruba 3810M 24G 1-slot Swch 

JL072A Aruba 3810M 48p GT1s Switch 
Aruba 3810M 48G 1-slot Swch 

JL075A Aruba 3810M 16p SFP+ 2s Switch 
Aruba 3810M 16SFP+ 2-slot Swch 

JL430A Aruba 3810M 24SFP+250W Swch  

DODATEK I 

Regulační číslo modelu: RSVLC-1408 
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Overensstemmelseserklæring  
baseret på ISO/IEC 17050-1 og EN 17050-1 

 

1 / 2 

 

OE #: RSVLC-1408 R4 / da 
Producents navn: Hewlett Packard Enterprise Company 
Producents adresse: 8000 Foothills Blvd, Roseville, CA 95747, USA 

erklærer under eget ansvar, at produktet: 

Produktnavn og/eller model: Der henvises TILLÆG I 
Lovpligtigt modelnummer: RSVLC-1408 

Produktmuligheder: JL078A, JL079A, JL083A, JL084A, JL085A 

opfylder følgende produktspecifikationer og bestemmelser: 

Sikkerhed Elektromagnetisk Kompatibilitet 
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 62368:2014  
EN 62479:2010  

EN 55032:2012  
EN 55024:2010  
EN 61000-3-2:2006 +A1:2009 +A2:2009  
EN 61000-3-3:2013  

Begrænsning af anvendelsen af visse farlige stoffer 
EN 50581:2012 

Produktet overholder hermed kravene i Direktiv 2014/35/EF lovgivning om elektrisk materiel bestemt til anvendelse inden for 
visse spændingsgrænser, Direktiv 2014/30/EF lovgivning om elektromagnetisk kompatibilitet, Direktiv 2011/65/EF om 
begrænsning af anvendelsen af visse farlige stoffer i elektrisk og elektronisk udstyr og bærer CE mærkningen i 
overensstemmelse hermed. 

Yderligere information 

Dette produkt er tildelt et lovpligtigt modelnummer, som forbliver ved de lovgivningsmæssige aspekter af designet. Det 
lovpligtige modelnummer er den primære produktidentifkator i den lovgivningsmæssige dokumentation og testrapporter, 
dette nummer bør ikke forveksles med markedsføringsnavnet eller produktnumrene. 

Dette produkt blev testet I et typisk HPE-miljø. 

 

 
Roseville, CA Brent Ford, Leder 
21.03.2017 HPE Networking, CEB Business Organization 

Lokal kontakt, kun til lovgivningsmæssige spørgsmål 
EU: HPE, Postfach 0001, 1122 Wien, Austria 
U.S.:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Overensstemmelseserklæring  
baseret på ISO/IEC 17050-1 og EN 17050-1 

 

2 / 2 

 

Produktnavn og/eller model 

JL071A Aruba 3810M 24p GT1s Switch 
Aruba 3810M 24G 1-slot Swch 

JL072A Aruba 3810M 48p GT1s Switch 
Aruba 3810M 48G 1-slot Swch 

JL075A Aruba 3810M 16p SFP+ 2s Switch 
Aruba 3810M 16SFP+ 2-slot Swch 

JL430A Aruba 3810M 24SFP+250W Swch  

TILLÆG I 

Lovpligtigt modelnummer: RSVLC-1408 
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Konformitätserklärung  
basierend auf ISO/IEC 17050-1 und EN 17050-1 

 

1 / 2 

 

KE #: RSVLC-1408 R4 / de 
Name des Herstellers: Hewlett Packard Enterprise Company 
Adresse des Herstellers: 8000 Foothills Blvd, Roseville, CA 95747, USA 

erklärt in alleiniger Verantwortung, dass das Produkt: 

Produktbezeichnung und/oder Modell: Siehe ANHANG I 
Behördliche Modellnummer: RSVLC-1408 

Produktoptionen: JL078A, JL079A, JL083A, JL084A, JL085A 

den folgenden Produktspezifikationen und Richtlinien entspricht: 

Sicherheit Elektromagnetische Verträglichkeit 
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 62368:2014  
EN 62479:2010  

EN 55032:2012  
EN 55024:2010  
EN 61000-3-2:2006 +A1:2009 +A2:2009  
EN 61000-3-3:2013  

Beschränkung der Verwendung bestimmter gefährlicher Stoffe 
EN 50581:2012 

Das Produkt entspricht hiermit den Anforderungen von Richtlinie 2014/35/EU betreffend elektrische Betriebsmittel zur 
Verwendung innerhalb bestimmter Spannungsgrenzen, Richtlinie 2014/30/EU über die elektromagnetische Verträglichkeit, 
Richtlinie 2011/65/EU zur Beschränkung der Verwendung bestimmter gefährlicher Stoffe in Elektro- und Elektronikgeräten 
und trägt dementsprechend die CE Kennzeichnung. 

Zusatzinformation 

Diesem Produkt wird eine behördliche Modellnummer zugeordnet, welche an die behördlichen Aspekte des Designs 
gebunden ist. Die behördliche Modellnummer ist das Hauptproduktkennzeichen in der behördlichen Dokumentation und in 
Prüfberichten; diese Nummer ist nicht mit dem Marketingnamen oder den Produktnummern zu verwechseln. 

Dieses Produkt wurde in einer typischen HPE-Umgebung getestet. 

 

 
Roseville, CA Brent Ford, Leiter 
21.03.2017 HPE Networking, CEB Business Organization 

Lokaler Ansprechpartner ausschließlich für behördliche Themen 
EU: HPE, Postfach 0001, 1122 Wien, Austria 
U.S.:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Konformitätserklärung  
basierend auf ISO/IEC 17050-1 und EN 17050-1 
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Produktbezeichnung und/oder Modell 

JL071A Aruba 3810M 24p GT1s Switch 
Aruba 3810M 24G 1-slot Swch 

JL072A Aruba 3810M 48p GT1s Switch 
Aruba 3810M 48G 1-slot Swch 

JL075A Aruba 3810M 16p SFP+ 2s Switch 
Aruba 3810M 16SFP+ 2-slot Swch 

JL430A Aruba 3810M 24SFP+250W Swch  

ANHANG I 

Behördliche Modellnummer: RSVLC-1408 
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ΔΗΛΩΣΗ ΣΥΜΜΟΡΦΩΣΗΣ  
σύμφωνα με  τ α πρότ υπα ISO/IEC 17050-1 και  EN 17050-1 

 

1 / 2 

 

Δσ #: RSVLC-1408 R4 / el 

Επωνυμία κατασκευαστή: Hewlett Packard Enterprise Company 
Διεύθυνση κατασκευαστή: 8000 Foothills Blvd, Roseville, CA 95747, USA 

δηλώνει, μεαποκλειστική του ευθύνη, ότι το προϊόν: 

Όνομα ή/και μοντέλο προϊόντος: Παρακαλώ αναφερθείτε ΠΑΡΑΡΤΗΜΑ I 
Αριθμός μοντέλου σύμφωνα με τη 
νομοθεσία: 

RSVLC-1408 

Προαιρετικά χαρακτηριστικάπροϊόντος: JL078A, JL079A, JL083A, JL084A, JL085A 

Συμμορφώνεται προς τις ακόλουθες προδιαγραφές και κανονισμούς: 

ασφάλεια ηλεκτρομαγνητική συμβατότητα 
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 62368:2014  
EN 62479:2010  

EN 55032:2012  
EN 55024:2010  
EN 61000-3-2:2006 +A1:2009 +A2:2009  
EN 61000-3-3:2013  

τον περιορισμό της χρήσης ορισμένων επικίνδυνων ουσιών 
EN 50581:2012 

Το παρόν προϊόν συμμορφώνεται προς τις απαιτήσεις της Οδηγία 2014/35/ΕΕ των αναφερομένων στο ηλεκτρολογικό 
υλικό που προορίζεται να χρησιμοποιηθεί εντός ορισμένων ορίων τάσεως, Οδηγία 2014/30/ΕΕ σχετικά με την 
ηλεκτρομαγνητική συμβατότητα, Οδηγία 2011/65/ΕΕ για τον περιορισμό της χρήσης ορισμένων επικίνδυνων ουσιών 
σε ηλεκτρικό και ηλεκτρονικό εξοπλισμό και φέρει την ανάλογη σήμανση CE. 

Πρόσθετεςπληροφορίες 

Τοπαρόν προϊόν συνοδεύεται από τον αριθμό μοντέλου που προβλέπεται από τη νομοθεσία σχετικά με τον 
σχεδιασμό του. Ο εν λόγω κανονιστικός αριθμός μοντέλου είναι ο κύριος αναγνωριστικός αριθμός του προϊόντος στα 
έγγραφα ρυθμιστικού χαρακτήρα και στις εκθέσεις δοκιμών, και δεν πρέπει να συγχέεται με την εμπορική ονομασία 
ή τους αριθμούς προϊόντος για σκοπούς εμπορικής διάθεσης. 

Το παρόν προϊόν δοκιμάστηκε σε πρότυπο περιβάλλον της Hewlett Packard Enterprise. 

 

 
Roseville, CA Brent Ford, διαχειριστής 
21.03.2017 HPE Networking, CEB Business Organization 

Στοιχεία επικοινωνίας αποκλειστικά για κανονιστικά ζητήματα 
ΕΕ: HPE, Postfach 0001, 1122 Wien, Austria 
ΗΠΑ:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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ΔΗΛΩΣΗ ΣΥΜΜΟΡΦΩΣΗΣ  
σύμφωνα με  τ α πρότ υπα ISO/IEC 17050-1 και  EN 17050-1 

 

2 / 2 

 

Όνομα ή/και μοντέλο προϊόντος 

JL071A Aruba 3810M 24p GT1s Switch 
Aruba 3810M 24G 1-slot Swch 

JL072A Aruba 3810M 48p GT1s Switch 
Aruba 3810M 48G 1-slot Swch 

JL075A Aruba 3810M 16p SFP+ 2s Switch 
Aruba 3810M 16SFP+ 2-slot Swch 

JL430A Aruba 3810M 24SFP+250W Swch  

ΠΑΡΑΡΤΗΜΑ I 

Αριθμός μοντέλου σύμφωνα με τη νομοθεσία: RSVLC-1408 
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Declaración de Conformidad  
basada en las normas ISO/IEC 17050-1 y EN 17050-1 

 

1 / 2 

 

DdC #: RSVLC-1408 R4 / es 
Nombre del fabricante: Hewlett Packard Enterprise Company 
Dirección del fabricante: 8000 Foothills Blvd, Roseville, CA 95747, USA 

declara bajo su sola responsabilidad que el producto: 

Nombre del producto y/o modelo: Por favor, consulte ANEXO I 
Número de modelo reglamentario: RSVLC-1408 

Opciones del producto: JL078A, JL079A, JL083A, JL084A, JL085A 

cumple con las siguientes especificaciones y regulaciones de productos: 

Seguridad  Compatibilidad Electromagnética 
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 62368:2014  
EN 62479:2010  

EN 55032:2012  
EN 55024:2010  
EN 61000-3-2:2006 +A1:2009 +A2:2009  
EN 61000-3-3:2013  

Restricciones a la utilización de determinadas sustancias peligrosas 
EN 50581:2012 

El producto adjunto cumple con los requisitos de la Directiva 2014/35/UE sobre el material eléctrico destinado a utilizarse con 
determinados límites de tensión, Directiva 2014/30/UE en materia de compatibilidad electromagnética, Directiva 2011/65/UE 
sobre restricciones a la utilización de determinadas sustancias peligrosas en aparatos eléctricos y electrónicos y porta el 
marcado CE correspondiente. 

Información adicional 

Este producto tiene asignado un número de modelo reglamentario en consonancia con los aspectos normativos del diseño. El 
número de modelo reglamentario es el principal identificador del producto en la documentación reglamentaria y en los 
informes de ensayo. No se debería confundir este número con el nombre comercial ni con los números comerciales del 
producto. 

Este producto ha sido testado en un entorno típico de HPE. 

 

 
Roseville, CA Brent Ford, Manager 
21.03.2017 HPE Networking, CEB Business Organization 

Contactos nacionales solo para temas normativos 
UE: HPE, Postfach 0001, 1122 Wien, Austria 
USA.:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Declaración de Conformidad  
basada en las normas ISO/IEC 17050-1 y EN 17050-1 

 

2 / 2 

 

Nombre del producto y/o modelo 

JL071A Aruba 3810M 24p GT1s Switch 
Aruba 3810M 24G 1-slot Swch 

JL072A Aruba 3810M 48p GT1s Switch 
Aruba 3810M 48G 1-slot Swch 

JL075A Aruba 3810M 16p SFP+ 2s Switch 
Aruba 3810M 16SFP+ 2-slot Swch 

JL430A Aruba 3810M 24SFP+250W Swch  

ANEXO I 

Número de modelo reglamentario: RSVLC-1408 
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Vastavusdeklaratsioon  
vastab standarditele ISO/IEC 17050-1 ja EN 17050-1 

 

1 / 2 

 

VD #: RSVLC-1408 R4 / et 
Tootja nimetus: Hewlett Packard Enterprise Company 
Tootja aadress: 8000 Foothills Blvd, Roseville, CA 95747, USA 

deklareerib oma ainuvastutusel, et toode: 

Toote nimetus ja/või mudel: Palun vaadake LISA I 
Normatiivse mudeli number: RSVLC-1408 

Toote variandid: JL078A, JL079A, JL083A, JL084A, JL085A 

vastab järgmistele toote kohta käivatele spetsifikatsioonidele ja regulatiivsetele dokumentidele: 

Ohutus Elektromagnetilise Ühilduvuse 
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 62368:2014  
EN 62479:2010  

EN 55032:2012  
EN 55024:2010  
EN 61000-3-2:2006 +A1:2009 +A2:2009  
EN 61000-3-3:2013  

Teatavate ohtlike ainete kasutamise piiramise kohta 
EN 50581:2012 

Käesolev toode vastab Direktiiv 2014/35/EL teatavates pingevahemikes kasutatavaid elektriseadmeid käsitlevate, Direktiiv 
2014/30/EL mis käsitleb elektromagnetilise ühilduvuse, Direktiiv 2011/65/EL teatavate ohtlike ainete kasutamise piiramise 
kohta elektri- ja elektroonikaseadmetes ja on tähistatud vastavalt CE tähisega. 

Lisateave 

Tootele on omistatud normatiivse mudeli number, mis vastab konstruktsiooni normatiivsetele aspektidele. Normatiivse 
mudeli number on normatiivsetes dokumentides ja katsetuste aruannetes toote peamiseks identifikaatoriks, seda numbrit ei 
tohi segamini ajada turundusnumbri või toote numbriga. 

Toodet on katsetatud HPE keskkonnas. 

 

 
Roseville, CA Brent Ford, Juhataja 
21.03.2017 HPE Networking, CEB Business Organization 

Kohalik kontakt üksnes normatiivsetes küsimustes 
EU: HPE, Postfach 0001, 1122 Wien, Austria 
U.S.:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Vastavusdeklaratsioon  
vastab standarditele ISO/IEC 17050-1 ja EN 17050-1 

 

2 / 2 

 

Toote nimetus ja/või mudel 

JL071A Aruba 3810M 24p GT1s Switch 
Aruba 3810M 24G 1-slot Swch 

JL072A Aruba 3810M 48p GT1s Switch 
Aruba 3810M 48G 1-slot Swch 

JL075A Aruba 3810M 16p SFP+ 2s Switch 
Aruba 3810M 16SFP+ 2-slot Swch 

JL430A Aruba 3810M 24SFP+250W Swch  

LISA I 

Normatiivse mudeli number: RSVLC-1408 
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Vaatimustenmukaisuusvakuutus  
standardien ISO/IEC 17050-1 ja EN 17050-1 

 

1 / 2 

 

Vaatimustenmukaisuusvakuutus #: RSVLC-1408 R4 / fi 
Valmistajan nimi: Hewlett Packard Enterprise Company 
Valmistajan osoite: 8000 Foothills Blvd, Roseville, CA 95747, USA 

vakuuttaa yksinomaisella vastuullaan, että tuote: 

Tuotteen nimi ja/tai malli: Opit luvussa LIITE I 
Lainsäädännön edellyttämä mallinumero: RSVLC-1408 

Tuotevaihtoehdot: JL078A, JL079A, JL083A, JL084A, JL085A 

noudattavat seuraavia tuotemäärityksiä ja määräyksiä: 

Turvallisuus Sähkömagneettista Yhteensopivuutta 
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 62368:2014  
EN 62479:2010  

EN 55032:2012  
EN 55024:2010  
EN 61000-3-2:2006 +A1:2009 +A2:2009  
EN 61000-3-3:2013  

Tiettyjen vaarallisten aineiden käytön rajoittamisesta 
EN 50581:2012 

Tuote noudattaa täten Direktiivi 2014/35/EU sähkölaitteita tietyllä jännitealueella koskevan, Direktiivi 2014/30/EU 
sähkömagneettista yhteensopivuutta koskevan, Direktiivi 2011/65/EU tiettyjen vaarallisten aineiden käytön rajoittamisesta 
sähkö- ja elektroniikkalaitteissa vaatimuksia, ja näin ollen sillä on CE merkintä. 

Lisätietoja 

Tälle tuotteelle on osoitettu lainsäädännön edellyttämä mallinumero, joka pysyy samana mallin lainsäädännöllisten 
näkökulmien mukaisesti. Lainsäädännön edellyttämä mallinumero on tuotteen päätunniste lainsäädännöllisissä asiakirjoissa 
ja testiraporteissa, ja tätä numeroa ei saa sekoittaa markkinointinimeen tai tuotenumeroihin. 

Tämä tuote testattiin tyypillisessä HPE-ympäristössä. 

 

 
Roseville, CA Brent Ford, Johtaja 
21.03.2017 HPE Networking, CEB Business Organization 

Paikallinen yhteyshenkilö vain lainsäädännöllisille aiheille 
EU: HPE, Postfach 0001, 1122 Wien, Austria 
U.S.:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Vaatimustenmukaisuusvakuutus  
standardien ISO/IEC 17050-1 ja EN 17050-1 

 

2 / 2 

 

Tuotteen nimi ja/tai malli 

JL071A Aruba 3810M 24p GT1s Switch 
Aruba 3810M 24G 1-slot Swch 

JL072A Aruba 3810M 48p GT1s Switch 
Aruba 3810M 48G 1-slot Swch 

JL075A Aruba 3810M 16p SFP+ 2s Switch 
Aruba 3810M 16SFP+ 2-slot Swch 

JL430A Aruba 3810M 24SFP+250W Swch  

LIITE I 

Lainsäädännön edellyttämä mallinumero: RSVLC-1408 
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Déclaration de Conformité  
basée sur ISO/IEC 17050-1 et EN 17050-1 

 

1 / 2 

 

DdC #: RSVLC-1408 R4 / fr 
Nom du fabricant: Hewlett Packard Enterprise Company 
Adresse du fabricant: 8000 Foothills Blvd, Roseville, CA 95747, USA 

déclare, sous sa seule responsabilité, que le produit: 

Nom du produit et/ou modèle: Se il vous plaît se référer ANNEXE I 
Numéro de modèle de règlementation: RSVLC-1408 

Options de produit: JL078A, JL079A, JL083A, JL084A, JL085A 

est conforme aux règlementations et spécifications de produit suivantes: 

Sécurité Compatibilité électromagnétique 
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 62368:2014  
EN 62479:2010  

EN 55032:2012  
EN 55024:2010  
EN 61000-3-2:2006 +A1:2009 +A2:2009  
EN 61000-3-3:2013  

Limitation de l’utilisation de certaines substances dangereuses 
EN 50581:2012 

Le présent produit satisfait aux exigences de la Directive 2014/35/EU relatives au matériel électrique destiné à être employé 
dans certaines limites de tension, Directive 2014/30/EU concernant la compatibilité électromagnétique, Directive 2011/65/EU 
relative à la limitation de l’utilisation de certaines substances dangereuses dans les équipements électriques et électroniques 
et arbore la marque CE en conséquence. 

Renseignements complémentaires 

Un numéro de modèle de règlementation, qui demeure avec les aspects règlementaires de conception, est attribué à ce 
produit. Le numéro de modèle de règlementation est le principal élément d’identification du produit dans la documentation 
sur la documentation réglementaire et les rapports d’essai, ce numéro ne doit pas être confondu avec le nom commercial ou 
les numéros de produit. 

Ce produit a été testé dans un environnement HPE caractéristique. 

 

 
Roseville, CA Brent Ford, Responsable 
21.03.2017 HPE Networking, CEB Business Organization 

Contact local pour les sujets de réglementation uniquement 
UE: HPE, Postfach 0001, 1122 Wien, Austria 
USA:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Déclaration de Conformité  
basée sur ISO/IEC 17050-1 et EN 17050-1 

 

2 / 2 

 

Nom du produit et/ou modèle 

JL071A Aruba 3810M 24p GT1s Switch 
Aruba 3810M 24G 1-slot Swch 

JL072A Aruba 3810M 48p GT1s Switch 
Aruba 3810M 48G 1-slot Swch 

JL075A Aruba 3810M 16p SFP+ 2s Switch 
Aruba 3810M 16SFP+ 2-slot Swch 

JL430A Aruba 3810M 24SFP+250W Swch  

ANNEXE I 

Numéro de modèle de règlementation: RSVLC-1408 
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Izjava o Sukladnosti  
na temelju norme ISO/IEC 17050-1 i EN 17050-1 

 

1 / 2 

 

IoS #: RSVLC-1408 R4 / hr 
Naziv proizvođača: Hewlett Packard Enterprise Company 
Adresa proizvođača: 8000 Foothills Blvd, Roseville, CA 95747, USA 

izjavljujem, pod punom odgovornošću, da je proizvod: 

Naziv i/ili model proizvoda: Molimo pogledajte ANNEX I 
Regulatorna oznaka modela: RSVLC-1408 

Opcije proizvoda: JL078A, JL079A, JL083A, JL084A, JL085A 

u skladu sa sljedećim Specifikacijama proizvoda i propisima: 

Osigurač Elektromagnetsku Kompatibilnost 
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 62368:2014  
EN 62479:2010  

EN 55032:2012  
EN 55024:2010  
EN 61000-3-2:2006 +A1:2009 +A2:2009  
EN 61000-3-3:2013  

Ograničenje uporabe određenih opasnih tvari 
EN 50581:2012 

Navedeni proizvod u skladu je sa zahtjevima Direktiva 2014/35/EU u odnosu na električnu opremu namijenjenu za uporabu 
unutar određenih naponskih granica, Direktiva 2014/30/EU u odnosu na elektromagnetsku kompatibilnost, Direktiva 
2011/65/EU o ograničenju uporabe određenih opasnih tvari u električnoj i elektroničkoj opremi i sukladno tome sadrži oznaku 
CE. 

Dodatni podaci 

Ovom proizvodu dodijeljena je Regulatorna oznaka modela, koja je u skladu s regulatornim aspektima konstrukcije proizvoda. 
Regulatorna oznaka modela glavna je identifikacijska oznaka proizvoda u regulatornoj dokumentaciji i izvještajima o 
ispitivanju i tu se oznaku ne smije zabunom zamijeniti za tržišno ime ili brojeve  proizvoda. 

Ovaj proizvod je ispitan u tipičnom HPE okruženju. 

 

 
Roseville, CA Brent Ford, Voditelj 
21.03.2017 HPE Networking, CEB Business Organization 

Lokalni podaci za kontakt isključivo za regulatorna pitanja 
EU: HPE, Postfach 0001, 1122 Wien, Austria 
SAD:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Izjava o Sukladnosti  
na temelju norme ISO/IEC 17050-1 i EN 17050-1 

 

2 / 2 

 

Naziv i/ili model proizvoda 

JL071A Aruba 3810M 24p GT1s Switch 
Aruba 3810M 24G 1-slot Swch 

JL072A Aruba 3810M 48p GT1s Switch 
Aruba 3810M 48G 1-slot Swch 

JL075A Aruba 3810M 16p SFP+ 2s Switch 
Aruba 3810M 16SFP+ 2-slot Swch 

JL430A Aruba 3810M 24SFP+250W Swch  

ANNEX I 

Regulatorna oznaka modela: RSVLC-1408 
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Megfelelőségi Nyilatkozat  
az ISO/IEC és 17050-1 EN 17050-1 

 

1 / 2 

 

MN #: RSVLC-1408 R4 / hu 
Gyártó neve: Hewlett Packard Enterprise Company 
Gyártó címe: 8000 Foothills Blvd, Roseville, CA 95747, USA 

teljes felelősséggel kijelenti hogy az alábbi termék: 

Termék neve és/vagy modellje: Kérlek hivatkozz MELLÉKLET I 
Hatósági típusszám: RSVLC-1408 

Termékopciók: JL078A, JL079A, JL083A, JL084A, JL085A 

megfelel az alábbi termékspecifikációknak és előírásoknak: 

Biztonság Elektromágneses Összeférhetőségre 
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 62368:2014  
EN 62479:2010  

EN 55032:2012  
EN 55024:2010  
EN 61000-3-2:2006 +A1:2009 +A2:2009  
EN 61000-3-3:2013  

Korlátozásáról egyes veszélyes anyagok való alkalmazásának 
EN 50581:2012 

A termék a jelen nyilatkozat szerint megfelel a 2014/35/EU irányelve elektromos berendezésekre a meghatározott 
feszültséghatáron belüli használatra tervezett vonatkozó, 2014/30/EU irányelve az elektromágneses összeférhetőségre 
vonatkozó, 2011/65/EU irányelve egyes veszélyes anyagok elektromos és elektronikus berendezésekben való alkalmazásának 
korlátozásáról irányelv követelményeinek és ennek alapján található rajta a jelölés. 

További információk 

A termékhez meghatározott hatósági típusszám a kivitel szabályozási szempontjaihoz kapcsolódik. A hatósági típusszám 
szerepel a hatósági dokumentumokban és vizsgálati jelentésekben a termék fő azonosítójaként. Nem összetévesztendő a 
piaci névvel vagy a termék azonosítószámaival. 

A terméket tipikus HPE vállalati környezetben vizsgálták. 

 

 
Roseville, CA Brent Ford, Igazgató 
21.03.2017 HPE Networking, CEB Business Organization 

Helyi elérhetőség hatósági témákhoz 
EU: HPE, Postfach 0001, 1122 Wien, Austria 
U.S.:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Megfelelőségi Nyilatkozat  
az ISO/IEC és 17050-1 EN 17050-1 

 

2 / 2 

 

Termék neve és/vagy modellje 

JL071A Aruba 3810M 24p GT1s Switch 
Aruba 3810M 24G 1-slot Swch 

JL072A Aruba 3810M 48p GT1s Switch 
Aruba 3810M 48G 1-slot Swch 

JL075A Aruba 3810M 16p SFP+ 2s Switch 
Aruba 3810M 16SFP+ 2-slot Swch 

JL430A Aruba 3810M 24SFP+250W Swch  

MELLÉKLET I 

Hatósági típusszám: RSVLC-1408 
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Dichiarazione di Conformità  
ai sensi della norma ISO/IEC 17050-1 e EN 17050-1 

 

1 / 2 

 

DdC #: RSVLC-1408 R4 / it 
Nome del fabbricante: Hewlett Packard Enterprise Company 
Indirizzo del fabbricante: 8000 Foothills Blvd, Roseville, CA 95747, USA 

dichiara, sotto la propria esclusiva responsabilità, che il prodotto: 

Nome del prodotto e/o modello: Per favore, riferisci ALLEGATO I 
Numero di matricola: RSVLC-1408 

Opzioni del prodotto: JL078A, JL079A, JL083A, JL084A, JL085A 

è conforme alle seguenti Specifiche del prodotto e ai seguenti regolamenti: 

Sicurezza Compatibilità Elettromagnetica 
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 62368:2014  
EN 62479:2010  

EN 55032:2012  
EN 55024:2010  
EN 61000-3-2:2006 +A1:2009 +A2:2009  
EN 61000-3-3:2013  

Restrizione dell’uso di determinate sostanze pericolose 
EN 50581:2012 

Il prodotto è conforme ai requisiti della Direttiva 2014/35/UE relative al materiale elettrico destinato ad essere adoperato 
entro taluni limiti di tensione, Direttiva 2014/30/UE relative alla compatibilità elettromagnetica, Direttiva 2011/65/UE sulla 
restrizione dell’uso di determinate sostanze pericolose nelle apparecchiature elettriche ed elettroniche e pertanto reca il 
marchio CE. 

Informazioni aggiuntive 

A questo prodotto viene assegnato un numero di matricola secondo gli aspetti normativi della progettazione. Il numero di 
matricola normativo è il codice principale di identificazione del prodotto nella documentazione prevista dalla normativa e nei 
verbali di prova, questo numero non deve essere confuso con il nome commerciale o con il codice articolo del prodotto. 

Questo prodotto è stato testato in un tipico ambiente HPE. 

 

 
Roseville, CA Brent Ford, Responsabile 
21.03.2017 HPE Networking, CEB Business Organization 

Contatti locali solo per gli aspetti normativi 
UE: HPE, Postfach 0001, 1122 Wien, Austria 
USA:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Dichiarazione di Conformità  
ai sensi della norma ISO/IEC 17050-1 e EN 17050-1 

 

2 / 2 

 

Nome del prodotto e/o modello 

JL071A Aruba 3810M 24p GT1s Switch 
Aruba 3810M 24G 1-slot Swch 

JL072A Aruba 3810M 48p GT1s Switch 
Aruba 3810M 48G 1-slot Swch 

JL075A Aruba 3810M 16p SFP+ 2s Switch 
Aruba 3810M 16SFP+ 2-slot Swch 

JL430A Aruba 3810M 24SFP+250W Swch  

ALLEGATO I 

Numero di matricola: RSVLC-1408 
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Atitikties Deklaracija  
pagal ISO/IEC 17050-1 ir EN 17050-1 

 

1 / 2 

 

AD #: RSVLC-1408 R4 / lt 
Gamintojo pavadinimas: Hewlett Packard Enterprise Company 
Gamintojo adresas: 8000 Foothills Blvd, Roseville, CA 95747, USA 

Atsakingai pareiškia, kad produktas: 

Produkto pavadinimas ir / ar modelis: Prašome kreiptis PRIEDAS I 
Reglamentinis modelio numeris: RSVLC-1408 

Produkto parinktys: JL078A, JL079A, JL083A, JL084A, JL085A 

atitinka tokias produkto specifikacijas ir reglamentus: 

Saugumas Elektromagnetiniu Suderinamumu 
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 62368:2014  
EN 62479:2010  

EN 55032:2012  
EN 55024:2010  
EN 61000-3-2:2006 +A1:2009 +A2:2009  
EN 61000-3-3:2013  

apribojimas naudojimo dėl tam tikrų pavojingų medžiagų  
EN 50581:2012 

Produktas atitinka Žemos įtampos direktyvos Direktyva 2014/35/ES susijusių su elektrotechniniais gaminiais, skirtais naudoti 
tam tikrose įtampos ribose, suderinimo, Direktyva 2014/30/ES susijusių su elektromagnetiniu suderinamumu, Direktyva 
2011/65/ES dėl tam tikrų pavojingų medžiagų naudojimo elektros ir elektroninėje įrangoje apribojimo reikalavimus ir turi 
atitinkamą CE ženklinimą. 

Papildoma informacija 

Šiam produktui yra priskirtas Reglamentinis modelio numeris, kuris priklauso nuo projekto reglamentavimo aspektų. 
Reglamentinis numeris yra pagrindinis produkto identifikatorius reglamentavimo dokumentuose ir bandymų ataskaitose, šis 
numeris neturėtų būti painiojamas su rinkodaros pavadinimu ar produkto numeriais. 

Šis produktas buvo išbandytas įprastoje HPE aplinkoje. 

 

 
Roseville, CA Brent Ford, Menedžeris 
21.03.2017 HPE Networking, CEB Business Organization 

Vietiniai kontaktai tik reglamentavimo klausimais 
ES: HPE, Postfach 0001, 1122 Wien, Austria 
JAV:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Atitikties Deklaracija  
pagal ISO/IEC 17050-1 ir EN 17050-1 

 

2 / 2 

 

Produkto pavadinimas ir / ar modelis 

JL071A Aruba 3810M 24p GT1s Switch 
Aruba 3810M 24G 1-slot Swch 

JL072A Aruba 3810M 48p GT1s Switch 
Aruba 3810M 48G 1-slot Swch 

JL075A Aruba 3810M 16p SFP+ 2s Switch 
Aruba 3810M 16SFP+ 2-slot Swch 

JL430A Aruba 3810M 24SFP+250W Swch  

PRIEDAS I 

Reglamentinis modelio numeris: RSVLC-1408 
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Atbilstības Deklarācija  
pamatojoties uz ISO/IEC 17050-1 un EN 17050-1 

 

1 / 2 

 

AD #: RSVLC-1408 R4 / lv 
Ražotāja nosaukums: Hewlett Packard Enterprise Company 
Ražotāja adrese: 8000 Foothills Blvd, Roseville, CA 95747, USA 

kā vienīgais atbildīgais par produkta kvalitāti paziņo, ka produkts: 

Produkta nosaukums un/vai modelis: Lūdzu, skatiet PIELIKUMS I 
Tehniskais modeļa numurs: RSVLC-1408 

Produkta komplektācija: JL078A, JL079A, JL083A, JL084A, JL085A 

atbilst šādām produkta specifikācijām un noteikumiem: 

Drošība Elektromagnētisko Savietojamību 
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 62368:2014  
EN 62479:2010  

EN 55032:2012  
EN 55024:2010  
EN 61000-3-2:2006 +A1:2009 +A2:2009  
EN 61000-3-3:2013  

Izmantošanas ierobežošanu par dažu bīstamu vielu 
EN 50581:2012 

Šis produkts atbilst šādu tiesību aktu prasībām: Direktīva 2014/35/ES saskaņošanu attiecībā uz elektroiekārtām, kas 
paredzētas lietošanai noteiktās sprieguma robežās, Direktīva 2014/30/ES kas attiecas uz elektromagnētisko savietojamību, 
Direktīva 2011/65/ES par dažu bīstamu vielu izmantošanas ierobežošanu elektriskās un elektroniskās iekārtās un tam ir 
atbilstošs CE marķējums. 

Papildinformācija 

Šim produktam ir piešķirts tehniskais modeļa numurs, kas norāda uz produkta dizaina normatīvajiem aspektiem. Tehniskais 
modeļa numurs ir galvenais produkta identifikators normatīvajos dokumentos un testēšanas ziņojumos. Šo numuru nedrīkst 
sajaukt ar produkta tirdzniecības nosaukumu vai numuru. 

Šis produkts tika testēts standarta HPE vidē. 

 

 
Roseville, CA Brent Ford, Menedžeris 
21.03.2017 HPE Networking, CEB Business Organization 

Vietējo pārstāvniecību kontaktinformācija tikai jautājumiem par normatīvajiem produkta aspektiem 
ES: HPE, Postfach 0001, 1122 Wien, Austria 
ASV:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Atbilstības Deklarācija  
pamatojoties uz ISO/IEC 17050-1 un EN 17050-1 

 

2 / 2 

 

Produkta nosaukums un/vai modelis 

JL071A Aruba 3810M 24p GT1s Switch 
Aruba 3810M 24G 1-slot Swch 

JL072A Aruba 3810M 48p GT1s Switch 
Aruba 3810M 48G 1-slot Swch 

JL075A Aruba 3810M 16p SFP+ 2s Switch 
Aruba 3810M 16SFP+ 2-slot Swch 

JL430A Aruba 3810M 24SFP+250W Swch  

PIELIKUMS I 

Tehniskais modeļa numurs: RSVLC-1408 
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Dikjarazzjoni ta 'Konformità  
bbażata fuq ISO/IEC 17050-1 u EN 17050-1 

 

1 / 2 

 

Dt'K #: RSVLC-1408 R4 / mt 
Isem il-manifattur: Hewlett Packard Enterprise Company 
Indirizz tal-manifattur: 8000 Foothills Blvd, Roseville, CA 95747, USA 

jiddikjaraw, taħt ir-responsabbiltà unika tagħhom li l-prodott: 

Isem il-prodott u/jew mudell: Jekk jogħġbok irreferi ANNESS I 
Numru tal-Mudell Regolatorju: RSVLC-1408 

Għażliet tal-prodott: JL078A, JL079A, JL083A, JL084A, JL085A 

jikkonforma mal-ispeċifikazzjonijiet u r-regolamenti li ġejjin: 

Sigurtà Kompatibilità Elettromanjetika 
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 62368:2014  
EN 62479:2010  

EN 55032:2012  
EN 55024:2010  
EN 61000-3-2:2006 +A1:2009 +A2:2009  
EN 61000-3-3:2013  

Restrizzjoni tal-użu ta’ ċerti sustanzi perikolużi 
EN 50581:2012 

Dan il-prodott jikkonforma mar-rekwiżiti tad- Direttiva 2014/35/UE dwar mat-tagħmir elettriku ddisinjat għall-użu fi ħdan 
ċerti limiti tal-voltaġġ, Direttiva 2014/30/UE x'jaqsmu mal-kompatibilità elettromanjetika, Direttiva 2011/65/UE dwar ir-
restrizzjoni tal-użu ta’ ċerti sustanzi perikolużi fit-tagħmir elettriku u elettroniku u jġorr il-marka korrispondenti CE. 

Aktar informazzjoni 

Dan il-prodott għandu Numru tal-Mudell Regolatorju li jinżamm mal-aspetti regolatorji tad-disinn. In-Numru tal-Mudell 
Regolatorju huwa l-identifikatur prinċipali fid-dokumentazzjoni regolatorja u r-rapporti tat-testijiet. Dan in-numru m'għandux 
jiġi konfuż mal-isem kummerċjali jew in-numri tal-prodott. 

Dan il-prodott ġie ttestjat f'ambjent tipiku ta' HPE. 

 

 
Roseville, CA Brent Ford, Maniġer 
21.03.2017 HPE Networking, CEB Business Organization 

Kuntatt lokali għal suġġetti regolatorji biss 
EU: HPE, Postfach 0001, 1122 Wien, Austria 
U.S.:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
 

  

Anexo 03 A 12 - ITEM 05 (0592596)         SEI 0008478-63.2018.6.02.8000 / pg. 4655

http://www.hpe.com/eu/certificates


 

Dikjarazzjoni ta 'Konformità  
bbażata fuq ISO/IEC 17050-1 u EN 17050-1 

 

2 / 2 

 

Isem il-prodott u/jew mudell 

JL071A Aruba 3810M 24p GT1s Switch 
Aruba 3810M 24G 1-slot Swch 

JL072A Aruba 3810M 48p GT1s Switch 
Aruba 3810M 48G 1-slot Swch 

JL075A Aruba 3810M 16p SFP+ 2s Switch 
Aruba 3810M 16SFP+ 2-slot Swch 

JL430A Aruba 3810M 24SFP+250W Swch  

ANNESS I 

Numru tal-Mudell Regolatorju: RSVLC-1408 
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Conformiteitsverklaring  
op basis van ISO/IEC 17050-1 en EN 17050-1 

 

1 / 2 

 

CV #: RSVLC-1408 R4 / nl 
Naam producent: Hewlett Packard Enterprise Company 
Adres producent: 8000 Foothills Blvd, Roseville, CA 95747, USA 

verklaart, onder haar eigen verantwoordelijkheid, dat het product: 

Productnaam en/of model: Raadpleeg BIJLAGE I 
Wettelijk modelnummer: RSVLC-1408 

Productopties: JL078A, JL079A, JL083A, JL084A, JL085A 

voldoet aan de volgende productspecificaties en reguleringen: 

Veiligheid Elektromagnetische Compatibiliteit 
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 62368:2014  
EN 62479:2010  

EN 55032:2012  
EN 55024:2010  
EN 61000-3-2:2006 +A1:2009 +A2:2009  
EN 61000-3-3:2013  

Beperking van het gebruik van bepaalde gevaarlijke stoffen 
EN 50581:2012 

Het product voldoet hierbij aan de vereisten van Richtlijn 2014/35/EU inzake elektrisch materiaal bestemd voor gebruik 
binnen bepaalde spanningsgrenzen, Richtlijn 2014/30/EU inzake elektromagnetische compatibiliteit, Richtlijn 2011/65/EU 
betreffende beperking van het gebruik van bepaalde gevaarlijke stoffen in elektrische en elektronische apparatuur en is 
voorzien van het bijbehorende keurmerk. 

Aanvullende informatie 

Aan dit product is een wettelijk modelnummer toegekend dat de wettelijke aspecten van het ontwerp betreft. Het wettelijk 
modelnummer is de belangrijkste identificatie van het product in de wettelijke documentatie en testberichten. Dit nummer 
mag niet worden verwisseld met de marketingnaam of de productnummers. 

Dit product is getested in een specifieke HPE-omgeving. 

 

 
Roseville, CA Brent Ford, Manager 
21.03.2017 HPE Networking, CEB Business Organization 

Lokaal contact, uitsluitend voor wettelijke kwesties 
EU: HPE, Postfach 0001, 1122 Wien, Austria 
U.S.:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Conformiteitsverklaring  
op basis van ISO/IEC 17050-1 en EN 17050-1 

 

2 / 2 

 

Productnaam en/of model 

JL071A Aruba 3810M 24p GT1s Switch 
Aruba 3810M 24G 1-slot Swch 

JL072A Aruba 3810M 48p GT1s Switch 
Aruba 3810M 48G 1-slot Swch 

JL075A Aruba 3810M 16p SFP+ 2s Switch 
Aruba 3810M 16SFP+ 2-slot Swch 

JL430A Aruba 3810M 24SFP+250W Swch  

BIJLAGE I 

Wettelijk modelnummer: RSVLC-1408 
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Deklaracja Zgodności  
oparta na ISO/IEC 17050-1 oraz EN 17050-1 
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DZ #: RSVLC-1408 R4 / pl 
Nazwa producenta: Hewlett Packard Enterprise Company 
Adres producenta: 8000 Foothills Blvd, Roseville, CA 95747, USA 

deklaruje z pełną odpowiedzialnością, że produkt: 

Nazwa produktu i/lub model: Proszę odnieś się ZAŁĄCZNIK I 
Numer modelu regulacyjnego: RSVLC-1408 

Opcje produktu: JL078A, JL079A, JL083A, JL084A, JL085A 

jest dostosowany do następujących specyfikacji produktu i regulacji: 

Bezpieczeństwo Kompatybilności Elektromagnetycznej 
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 62368:2014  
EN 62479:2010  

EN 55032:2012  
EN 55024:2010  
EN 61000-3-2:2006 +A1:2009 +A2:2009  
EN 61000-3-3:2013  

Ograniczenia stosowania niektórych niebezpiecznych substancji 
EN 50581:2012 

Niniejszy produkt jest zgodny z wymaganiami dyrektywy Dyrektywa 2014/35/WE odnoszących się do sprzętu elektrycznego 
przewidzianego do stosowania w określonych granicach napięcia, Dyrektywa 2014/30/WE odnoszących się 
do kompatybilności elektromagnetycznej, Dyrektywa 2011/65/WE w sprawie ograniczenia stosowania niektórych 
niebezpiecznych substancji w sprzęcie elektrycznym i elektronicznym posiada odpowiednie oznaczenie CE. 

Dodatkowe informacje 

Produkt ma przypisany numer modelu regulacyjnego, który wiąże się z aspektami regulacyjnymi jego wzornictwa. Numer 
modelu regulacyjnego jest głównym identyfikatorem produktu w dokumentacji regulacyjnej i raportach z testów, nie wolno 
mylić tego numeru z nazwą marketingową lub numerami produktu. 

Produkt został przetestowany w typowym środowisku Firmy Hewlett Packard Enterprise (HPE). 

 

 
Roseville, CA Brent Ford, Menażer 
21.03.2017 HPE Networking, CEB Business Organization 

Lokalny adres kontaktowy – tylko w sprawach regulacyjnych 
UE: HPE, Postfach 0001, 1122 Wien, Austria 
USA:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Deklaracja Zgodności  
oparta na ISO/IEC 17050-1 oraz EN 17050-1 

 

2 / 2 

 

Nazwa produktu i/lub model 

JL071A Aruba 3810M 24p GT1s Switch 
Aruba 3810M 24G 1-slot Swch 

JL072A Aruba 3810M 48p GT1s Switch 
Aruba 3810M 48G 1-slot Swch 

JL075A Aruba 3810M 16p SFP+ 2s Switch 
Aruba 3810M 16SFP+ 2-slot Swch 

JL430A Aruba 3810M 24SFP+250W Swch  

ZAŁĄCZNIK I 

Numer modelu regulacyjnego: RSVLC-1408 

Anexo 03 A 12 - ITEM 05 (0592596)         SEI 0008478-63.2018.6.02.8000 / pg. 4660



 

Declaração de Conformidade  
com base na ISO/IEC 17050-1 e EN 17050-1 

 

1 / 2 

 

DdC #: RSVLC-1408 R4 / pt 
Nome do fabricante: Hewlett Packard Enterprise Company 
Endereço do fabricante: 8000 Foothills Blvd, Roseville, CA 95747, USA 

declara, sob sua exclusiva responsabilidade, que o produto: 

Nome e/ou Modelo do Produto: Por favor, consulte ANEXO I 
Número de Modelo Regulamentar: RSVLC-1408 

Opções de produto: JL078A, JL079A, JL083A, JL084A, JL085A 

Em conformidade com as seguintes especificações de produto e diretivas: 

Segurança Compatibilidade Electromagnética 
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 62368:2014  
EN 62479:2010  

EN 55032:2012  
EN 55024:2010  
EN 61000-3-2:2006 +A1:2009 +A2:2009  
EN 61000-3-3:2013  

Restrição do uso de determinadas substâncias perigosas 
EN 50581:2012 

O produto está em conformidade com os requisitos da Directiva 2014/35/UE no domínio do material eléctrico destinado a ser 
utilizado dentro de certos limites de tensão, Directiva 2014/30/UE respeitantes à compatibilidade electromagnética, Directiva 
2011/65/UE relativa à restrição do uso de determinadas substâncias perigosas em equipamentos eléctricos e electrónicos , 
bem como detém a respetiva marcação CE. 

Informação adicional 

O presente produto detém um Número de Modelo Regulamentar, correspondente aos aspetos regulamentares do design. O 
Número de Modelo regulamentar é o principal identificador do produto presente na documentação regulamentar e nos 
relatórios de teste; este número não deve ser confundido com o nome de marketing ou os números do produto. 

O presente produto foi testado num ambiente tipicamente HPE. 

 

 
Roseville, CA Brent Ford, Manager 
21.03.2017 HPE Networking, CEB Business Organization 

Contato local apenas para assuntos regulamentares 
UE: HPE, Postfach 0001, 1122 Wien, Austria 
EUA:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
 

  

Anexo 03 A 12 - ITEM 05 (0592596)         SEI 0008478-63.2018.6.02.8000 / pg. 4661

http://www.hpe.com/eu/certificates


 

Declaração de Conformidade  
com base na ISO/IEC 17050-1 e EN 17050-1 

 

2 / 2 

 

Nome e/ou Modelo do Produto 

JL071A Aruba 3810M 24p GT1s Switch 
Aruba 3810M 24G 1-slot Swch 

JL072A Aruba 3810M 48p GT1s Switch 
Aruba 3810M 48G 1-slot Swch 

JL075A Aruba 3810M 16p SFP+ 2s Switch 
Aruba 3810M 16SFP+ 2-slot Swch 

JL430A Aruba 3810M 24SFP+250W Swch  

ANEXO I 

Número de Modelo Regulamentar: RSVLC-1408 
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Declaratie de Conformitate  
conform ISO/IEC 17050-1 si EN 17050-1 

 

1 / 2 

 

DdC #: RSVLC-1408 R4 / ro 
Numele producătorului: Hewlett Packard Enterprise Company 
Adresa producatorului: 8000 Foothills Blvd, Roseville, CA 95747, USA 

declară, pe proprie răspundere că produsul: 

Nume produs și/sau Model: Vă rugăm să consultați ANEXA I 
Cod de reglementare model: RSVLC-1408 

Opțiuni produs: JL078A, JL079A, JL083A, JL084A, JL085A 

este conform următoarelor specificații și reglementări ale produsului: 

Siguranță Compatibilitatea Electromagnetică 
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 62368:2014  
EN 62479:2010  

EN 55032:2012  
EN 55024:2010  
EN 61000-3-2:2006 +A1:2009 +A2:2009  
EN 61000-3-3:2013  

Restricțiile de utilizare a anumitor substanțe periculoase în echipamentele 
EN 50581:2012 

Produsul se conformează cerințelor Directiva 2014/35/EU privind echipamentele electrice destinate utilizării în cadrul unor 
anumite limite de tensiune, Directiva 2014/30/EU cu privire la compatibilitatea electromagnetică, Directiva 2011/65/EU 
privind restricțiile de utilizare a anumitor substanțe periculoase în echipamentele electrice și electronice E și poartă în mod 
corespunzător marca . 

Informații adiționale 

Acestui produs îi este atribuit un cod de reglementare al modelului care se referă la aspectele de reglementare ale designului. 
Codul de reglementare al produsului este principalul cod de identificare al produsului în documentele de reglementare și 
rapoartele de testare, acest cod nu trebuie confundat cu denumirea de marketing sau codurile produsului. 

Acest produs a fost testat într-un mediu standard HPE. 

 

 
Roseville, CA Brent Ford, Manager 
21.03.2017 HPE Networking, CEB Business Organization 

Date de contact locale privind numai probleme de reglementare 
EU: HPE, Postfach 0001, 1122 Wien, Austria 
U.S.:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Declaratie de Conformitate  
conform ISO/IEC 17050-1 si EN 17050-1 

 

2 / 2 

 

Nume produs și/sau Model 

JL071A Aruba 3810M 24p GT1s Switch 
Aruba 3810M 24G 1-slot Swch 

JL072A Aruba 3810M 48p GT1s Switch 
Aruba 3810M 48G 1-slot Swch 

JL075A Aruba 3810M 16p SFP+ 2s Switch 
Aruba 3810M 16SFP+ 2-slot Swch 

JL430A Aruba 3810M 24SFP+250W Swch  

ANEXA I 

Cod de reglementare model: RSVLC-1408 
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Vyhlásenie o Zhode  
na základe ISO/IEC 17050-1 a EN 17050-1 

 

1 / 2 

 

VoZ #: RSVLC-1408 R4 / sk 
Názov výrobcu: Hewlett Packard Enterprise Company 
Adresa výrobcu: 8000 Foothills Blvd, Roseville, CA 95747, USA 

na svoju výlučnú zodpovednosť prehlasuje, že výrobok: 

Názov výrobku a/alebo model: Pozrite sa prosím DODATOK I 
Regulačné číslo modelu: RSVLC-1408 

Možnosti výrobku: JL078A, JL079A, JL083A, JL084A, JL085A 

je v súlade s nasledujúcou špecializáciou výrokov a nariadeniami: 

Bezpečnosť Elektromagnetickú Kompatibilitu 
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 62368:2014  
EN 62479:2010  

EN 55032:2012  
EN 55024:2010  
EN 61000-3-2:2006 +A1:2009 +A2:2009  
EN 61000-3-3:2013  

Obmedzení používania určitých nebezpečných látok 
EN 50581:2012 

Tento výrobok spĺňa požiadavky Smernica 2014/35/EÚ týkajúcich sa elektrického zariadenia určeného na používanie v rámci 
určitých limitov napätia, Smernica 2014/30/EÚ vzťahujúcich sa na elektromagnetickú kompatibilitu, Smernica 2011/65/EÚ o 
obmedzení používania určitých nebezpečných látok v elektrických a elektronických zariadeniach a je správne CE označený. 

Ďalšie informácie 

Výrobok má pridelené regulačné číslo modelu, ktorý je v súlade s regulačnými aspektami dizajnu. Regulačné číslo modelu je 
hlavný identifikátor výrobku v regulačnej dokumentácii a v protokole o skúške a nemožno ho zamieňať s obchodným názvom 
alebo číslom výrobku. 

Tento výrobok bol testovaný v typickom HPE prostredí. 

 

 
Roseville, CA Brent Ford, Manažér 
21.03.2017 HPE Networking, CEB Business Organization 

Miestny kontakt výhradne pre regulačné záležitosti 
EU: HPE, Postfach 0001, 1122 Wien, Austria 
USA:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Vyhlásenie o Zhode  
na základe ISO/IEC 17050-1 a EN 17050-1 

 

2 / 2 

 

Názov výrobku a/alebo model 

JL071A Aruba 3810M 24p GT1s Switch 
Aruba 3810M 24G 1-slot Swch 

JL072A Aruba 3810M 48p GT1s Switch 
Aruba 3810M 48G 1-slot Swch 

JL075A Aruba 3810M 16p SFP+ 2s Switch 
Aruba 3810M 16SFP+ 2-slot Swch 

JL430A Aruba 3810M 24SFP+250W Swch  

DODATOK I 

Regulačné číslo modelu: RSVLC-1408 

Anexo 03 A 12 - ITEM 05 (0592596)         SEI 0008478-63.2018.6.02.8000 / pg. 4666



 

Izjava o Skladnosti  
na osnovi ISO/IEC 17050-1 ter EN 17050-1 

 

1 / 2 

 

IoS #: RSVLC-1408 R4 / sl 
Ime proizvajalca: Hewlett Packard Enterprise Company 
Naslov proizvajalca: 8000 Foothills Blvd, Roseville, CA 95747, USA 

Izjavlja z vso odgovornostjo, da je izdelek: 

Ime izdelka in/ali model: Za več informacij glej ANEKS I 
Odobritvena številka modela: RSVLC-1408 

Možnosti izdelka: JL078A, JL079A, JL083A, JL084A, JL085A 

ustreza sledečim specifikacijam izdelka ter predpisom: 

Varnost Elektromagnetno Združljivostjo 
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 62368:2014  
EN 62479:2010  

EN 55032:2012  
EN 55024:2010  
EN 61000-3-2:2006 +A1:2009 +A2:2009  
EN 61000-3-3:2013  

Omejevanje uporabe nekaterih nevarnih snovi 
EN 50581:2012 

Proizvod je skladen z zahtevami Direktiva 2014/35/EU zvezi z električno opremo, konstruirano za uporabo znotraj določenih 
napetostnih mej, Direktiva 2014/30/EU v zvezi z elektromagnetno združljivostjo, Direktiva 2011/65/EU o omejevanju uporabe 
nekaterih nevarnih snovi v električni in elektronski opremi  in temu primerno nosi oznako CE. 

Dodatne informacije 

Temu izdelku je dodeljena odobritvena številka modela, ki izhaja iz regulativnega stališča oblikovanja. Odobritvena številka 
modela je glavni identifikator izdelka v dokumentaciji predpisov in testnih poročilih, te številke ne gre zamešati z 
marketinškim imenom ali številkami izdelka. 

Ta izdelek je bil testiran v tipičnem HPE okolju. 

 

 
Roseville, CA Brent Ford, Manager 
21.03.2017 HPE Networking, CEB Business Organization 

Lokalni stik – izključno za zadeve glede predpisov 
EU: HPE, Postfach 0001, 1122 Wien, Austria 
U.S.:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Izjava o Skladnosti  
na osnovi ISO/IEC 17050-1 ter EN 17050-1 

 

2 / 2 

 

Ime izdelka in/ali model 

JL071A Aruba 3810M 24p GT1s Switch 
Aruba 3810M 24G 1-slot Swch 

JL072A Aruba 3810M 48p GT1s Switch 
Aruba 3810M 48G 1-slot Swch 

JL075A Aruba 3810M 16p SFP+ 2s Switch 
Aruba 3810M 16SFP+ 2-slot Swch 

JL430A Aruba 3810M 24SFP+250W Swch  

ANEKS I 

Odobritvena številka modela: RSVLC-1408 
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Försäkran om Överensstämmelse  
i enlighet med ISO/IEC 17050-1 och EN 17050-1 

 

1 / 2 

 

FoÖ #: RSVLC-1408 R4 / sv 
Tillverkarens namn: Hewlett Packard Enterprise Company 
Tillverkarens adress: 8000 Foothills Blvd, Roseville, CA 95747, USA 

deklarerar under eget ansvar att produkten: 

Produktnamn och/eller modell: Var god hänvisa BILAGA I 
Föreskriftenligt modellnummer: RSVLC-1408 

Produktalternativ: JL078A, JL079A, JL083A, JL084A, JL085A 

överensstämmer med följande produktspecifikationer och föreskrifter: 

Säkerhet Elektromagnetisk Kompatibilitet 
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 62368:2014  
EN 62479:2010  

EN 55032:2012  
EN 55024:2010  
EN 61000-3-2:2006 +A1:2009 +A2:2009  
EN 61000-3-3:2013  

Begränsning av användning av vissa farliga ämnen 
EN 50581:2012 

Produkten överensstämmer med kraven i Direktiv 2014/35/EU lagstiftning om elektrisk utrustning avsedd för användning 
inom vissa spänningsgränser, Direktiv 2014/30/EU lagstiftning om elektromagnetisk kompatibilitet, Direktiv 2011/65/EU om 
begränsning av användning av vissa farliga ämnen i elektrisk och elektronisk utrustning och bär CE markeringen i enlighet 
därmed. 

Tilläggsinformation 

Den här produkten har tilldelats ett föreskriftsenligt modellnummer som följer de föreskriftsenliga aspekterna av 
konstruktionen. Det föreskriftsenliga modellnumret är en identifikator för huvudprodukten i föreskriftsenlig dokumentation 
och testrapporter, detta nummer skall inte blandas samman med marknadsföringsnamnet eller produktnumret. 

Den här produkten har testats i en typisk HPE miljö. 

 

 
Roseville, CA Brent Ford, Manager 
21.03.2017 HPE Networking, CEB Business Organization 

Lokal kontakt, endast för föreskiftsenliga ärenden 
EU: HPE, Postfach 0001, 1122 Wien, Austria 
U.S.:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Försäkran om Överensstämmelse  
i enlighet med ISO/IEC 17050-1 och EN 17050-1 

 

2 / 2 

 

Produktnamn och/eller modell 

JL071A Aruba 3810M 24p GT1s Switch 
Aruba 3810M 24G 1-slot Swch 

JL072A Aruba 3810M 48p GT1s Switch 
Aruba 3810M 48G 1-slot Swch 

JL075A Aruba 3810M 16p SFP+ 2s Switch 
Aruba 3810M 16SFP+ 2-slot Swch 

JL430A Aruba 3810M 24SFP+250W Swch  

 

BILAGA I 

Föreskriftenligt modellnummer: RSVLC-1408 
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Hewlett Packard Enterprise (HPE) is committed to compliance with all 
applicable laws and regulations, including material restriction 
requirements under the European Union Recast RoHS Directive, 
otherwise known as EU RoHS 2, applicable restrictions under Annex 
XVII of the EU REACH Regulation and China’s Management Methods 
for Restricted Use of Hazardous Substances in Electrical and 
Electronic Products, otherwise known as China RoHS 2.  
 
Hewlett Packard Enterprise believes that legislation, like the EU RoHS 
2 Directive, plays an important role in promoting industry-wide 
transition to restrict substances of concern. In general, the restriction 
of any substance should take into account the following key items:  
 
• Global harmonization of the legislation content and implementation 

requirements 
• Substance risk assessment, including a clear understanding of the 

environmental impacts of alternative substances 
• Clear identification of what substances (vs. broad classes or 

categories) are to be restricted 
• Clear identification of when alternative technologies are proven and 

readily available 
• Appropriate lead time to allow the industry to transition 
• Substances that are not used or found in final products should not 

be included in the restrictions 
• Material application exemptions should be allowed for the use of 

restricted substances in applications where current substitution is 
not technically feasible 

• Inclusion of maximum concentration values setting de minimis 
levels below which the relevant substances may be present 

 

Hewlett Packard Enterprise’s 
Compliance with Restriction of 
Hazardous Substances (RoHS) 
Legislation 
(rev 14.0 Oct 2016) 

 

Hewlett Packard Enterprise 

3000 Hanover Street 

Palo Alto, CA 94304 

www.hpe.com 
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Hewlett Packard Enterprise fully supports the restriction of the four 
substances incorporated into EU RoHS 2 by Commission Delegated 
Directive 2015/863/EU, specifically:  
 
• Diisobutyl Phthalate (DIBP) 
• Bis (2-ethylhexyl) phthalate (DEHP) 
• Butyl benzyl phthalate (BBP) 
• Dibutylphthalate (DBP) 
 
Hewlett Packard Enterprise believes other substances should be 
considered for inclusion in future RoHS legislation. This includes the 
restriction of polyvinyl chloride (PVC) and brominated flame retardants 
(BFRs) from electrical and electronic equipment (EEE). HPE believes 
PVC and BFRs should be the focus for the restriction of chlorine (Cl) 
and bromine (Br) from electrical and electronic equipment, where 
technically feasible. HPE’s reasons for focusing on PVC and BFRs 
are: 
 
• PVC and BFRs cover 99% of the uses for Cl and Br in electronics; 
• Given the high percentage usage, these substances have the 

highest impact; 
• Restriction of these substances where technically feasible would 

substantially accomplish the goal to eliminate Cl and Br from 
electronic products. 

 
By July 2007, all PVC and BFRs were restricted[1] from the external 
case plastics in HPE branded products. When technically feasible, we 
will continue to phase out other uses of brominated flame retardants 
(BFRs), polyvinyl chloride (PVC), and phthalates to meet market 
demands and customer expectations, taking into account product life 
cycles. 
 
Hewlett Packard Enterprise is taking a proactive approach to 
evaluating materials in its products to assess environmental, health or 
safety risks. HPE may restrict substances because of customer or 
legal requirements, or because HPE believes it is appropriate based 
on a precautionary approach. HPE strives to replace legally permitted 
materials when scientific data have established a potential health or 
environmental risk and lower-risk, commercially and technically viable 
alternatives are available. At HPE the evaluation of alternative 
materials is a continuous process.  
 
Our continued internal voluntary goal is to meet the substance 
restrictions of the EU RoHS legislation outside the EU (and EFTA) 
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within 6 months of each of the EU’s various legal compliance dates on 
a worldwide basis for virtually all Hewlett Packard Enterprise branded 
new products in scope of the Directive, except where it is widely 
recognized that there is no technically feasible alternative (as 
indicated by an exemption under the EU RoHS Directive).  
 
In early 2003, a company-wide RoHS team was formed to manage all 
aspects of Hewlett Packard Company’s global response to all the 
RoHS legislations around the world.  Since the separation of Hewlett 
Packard Company and the creation of Hewlett Packard Enterprise, 
HPE has continued this approach. HPE’s initiative to address the 
RoHS legislations is part of the company’s Design for Environment 
program, which includes using materials more efficiently, finding 
alternatives for designated materials, designing for energy efficiency, 
and designing products that can be easily recycled. 
 
Hewlett Packard Enterprise continues to plan for further “RoHS-like” 
legislation in other jurisdictions and will meet any additional 
requirements that arise. HPE complies with the requirements of all the 
RoHS legislations currently in effect (including those specifically listed 
under Compliance Status below). HPE’s Compliance Verification is 
based on our risk analysis of restricted substances entering the 
supply chain and includes technical documentation outlined in the 
European Union’s EN 50581:2012 standard. 
 
More detailed information can be found at 
www.hpe.com/info/environment 
Living Progress Report 

Design for environment 
Compliance Verification 
General Specifications for the Environment 
Eco Declarations 
 

 
Hewlett Packard Enterprise’s Compliance Status to EXISTING 
RoHS Legislation:  

 

European Union  

HPE products in-scope and put on the market in the EU and EFTA 
Member States comply with the requirements of EU RoHS Directive 
(2011/65/EU) including Commission Decisions withdrawing 
exemptions.  
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Serbia 
HPE products[2] comply with Serbia's WEEE and RoHS "Regulations 
on the List of Electrical and Electronic Products, Measures Banning 
and Restricting the Recovery of Electrical and Electronic Equipment 
Containing Hazardous Materials, and the Methods and Procedures for 
Managing Waste from Electrical and Electronic Products", which 
entered into force on January 4, 2011. RoHS restrictions apply to 
equipment placed on the market on or after July 1, 2011. 
 
Turkey 
HPE products[2] comply with Turkey’s “Regulation on the Restriction of 
the use of Certain Hazardous Substance in Electrical and Electronic 
Equipment”, otherwise known as Turkey RoHS which came into effect 
on March 30, 2009. 
 
Ukraine 
HPE products[2] comply with the substance restrictions in Ukraine’s 
“Technical Regulation on restrictions as to the use of some dangerous 
substances in electric and electronic devices”, otherwise known as 
Ukraine RoHS which came into effect on 1 January 2011. 
 
China 
HPE products[2] comply with China’s, “Management Methods for 
Restricted Use of Hazardous Substances in Electrical and Electronic 
Products”, otherwise known as China RoHS 2 which came into effect 
on July 1, 2016. 
 
India  
HPE products[2] comply with the material restrictions of India’s 
legislation “India E-waste (Management) Rules, 2016”, otherwise 
known as India RoHS, which came into effect on October 1, 2016 and 
will replace the E-Waste (Management and Handling) Rules, 2011. 
 
Japan  
Japan’s “The Marking of Presence of the Specific Chemical 
Substances for Electrical and Electronic Equipment” (JIS-C-0950), 
otherwise known as J-MOSS came into effect on July 1, 2006. At 
present, no HPE-brand products are in scope of J-MOSS.  
 

Korea  
In Korea, “The Act for Resource Recycling of Electrical/Electronic 
Products and Automobiles”, otherwise known as Korean RoHS came 
into effect on January 1, 2008. Korea’s RoHS 2 came into effect on 
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January 1, 2013. At present, no HPE-brand products are in scope of 
Korea RoHS 2. 
 
Taiwan (BSMI) RoHS 
HPE products[2] will comply with Taiwan’s CNS 15663 standard, 
otherwise known as BSMI RoHS, which is a Guidance to reduce the 
restricted chemical substances used in electrical and electronic 
products. This standard was released on July 30, 2013 and applies to 
servers placed on the market on or after July 1, 2017 and other 
products placed on the market on or after January 1, 2018. 
 
Vietnam 
HPE products[2] comply with Vietnam’s legislation “Circular 
30/2011/TT-BCT: Temporarily regulating the permitted limits for a 
number of hazardous substances in electric and electronic products”, 
otherwise known as Vietnam RoHS which came into effect on 
December 1, 2012. You can find HPE’s Vietnam RoHS declarations 
at: http://www8.hp.com/us/en/hpe/hp-
information/livingprogress/environmentalprogress/msds-specs-
more.html 
 
California 
California’s, “Electronic Waste Recycling Act of 2003 (Senate Bill 20) 
substance restrictions”, otherwise known as California RoHS came 
into effect on January 1, 2007. At present, no HPE-brand products are 
in scope of California RoHS. 
 
New Jersey 
New Jersey’s “Electronic Waste Recycling Act” (Senate Bill 2144), 
otherwise known as New Jersey RoHS came into effect on 1 January 
2011. At present, no HPE-brand products are in scope of New Jersey 
RoHS. 
 
Worldwide  
HPE has an internal voluntary goal to meet the substance restrictions 
of the EU RoHS legislation outside the EU (and EFTA) within 6 
months of each of the EU’s various legal compliance dates on a 
worldwide basis for virtually all HPE branded new products in scope of 
the Directive, except where it is widely recognized that there is no 
technically feasible alternative (as indicated by an exemption under 
the EU RoHS Directive). 
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Notes:  
[1] See HPE’s General Specification for the Environment Identification 
Numbers: 041210-80 and 070905-88.  
[2] HPE products that are both in scope and put on the market in the given 
jurisdiction. 
 

 

© Copyright 2016 Hewlett Packard Enterprise Development LP  
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Certificate of Registration
ENVIRONMENTAL MANAGEMENT SYSTEM - ISO 14001:2015

This is to certify that: Hewlett Packard Enterprise Company
11445 Compaq Center Drive W.
Building CCM07
Houston
Texas
77070
USA

Holds Certificate No: EMS 670053
and operates an Environmental Management System which complies with the requirements of ISO 14001:2015 for
the following scope:

The management of environmental risks associated with the development, manufacturing,
sales and support of Hewlett Packard Enterprise products, services, and solutions.

For and on behalf of BSI:
Carlos Pitanga, Chief Operating Officer Assurance – Americas

Original Registration Date: 2017-03-31 Effective Date: 2017-03-31
Latest Revision Date: 2018-11-16 Expiry Date: 2019-09-03

Page: 1 of 3

This certificate remains the property of BSI and shall be returned immediately upon request.
An electronic certificate can be authenticated online. Printed copies can be validated at www.bsigroup.com/ClientDirectory
To be read in conjunction with the scope above or the attached appendix.
Information and Contact: BSI, Kitemark Court, Davy Avenue, Knowlhill, Milton Keynes MK5 8PP. Tel: + 44 345 080 9000
BSI Assurance UK Limited, registered in England under number 7805321 at 389 Chiswick High Road, London W4 4AL, UK.
A Member of the BSI Group of Companies.Anexo 03 A 12 - ITEM 05 (0592596)         SEI 0008478-63.2018.6.02.8000 / pg. 4677
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Hewlett Packard Enterprise
11445 Compaq Center Drive W
Building CCA5450-58
Houston
Texas
77070
USA

Management and oversight of the EMS; sales and support of
Hewlett Packard Enterprise products, services, and solutions.

Hewlett Packard Italiana s.r.l.
Giuseppe di Vittorio 9,
Cernusco sul Naviglio (MI)
20063
Italy

Sales and support of services and solutions for the following
products: integrated systems, servers, storage, networking
and software.

Hewlett Packard Enterprise
Galvaniho 7
Bratislava
820 02
Slovakia

Sales and support of services and solutions for the following
products: integrated systems, servers, storage, networking
and software.

Hewlett Packard Enterprise
5 Fabrica de Glucoza Street
Bucharest
20331
Romania

Sales and support of services and solutions for the following
products: integrated systems, servers, storage, networking
and software.

Hewlett Packard Enterprise - Campinas,
Brazil CAM02
Highway SP 340, Guisepina Vianelli di Napolim Street, km118,
5, Barao Geraldo,Global Tech Condom
Campinas
São Paulo
13083-903
Brasil

Enterprise group supply chain operations manufacturing site.

Hewlett Packard Servicios España SLU
Spain ESM01
Calle Vicente Aleixandre 1
Las Rozas
Madrid
28232
Spain

Sales and Service office employees.

Certificate No: EMS 670053

Location Registered Activities

Original Registration Date: 2017-03-31 Effective Date: 2017-03-31
Latest Revision Date: 2018-11-16 Expiry Date: 2019-09-03

Page: 2 of 3
This certificate remains the property of BSI and shall be returned immediately upon request.
An electronic certificate can be authenticated online. Printed copies can be validated at www.bsigroup.com/ClientDirectory
To be read in conjunction with the scope above or the attached appendix.
Information and Contact: BSI, Kitemark Court, Davy Avenue, Knowlhill, Milton Keynes MK5 8PP. Tel: + 44 345 080 9000
BSI Assurance UK Limited, registered in England under number 7805321 at 389 Chiswick High Road, London W4 4AL, UK.
A Member of the BSI Group of Companies.
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Hewlett packard Enterprise Company -
Singapore HPAM 1
452 Alexandra Rd
Singapore
119961
Singapore

Enterprise group supply chain operations manufacturing site.

Hewlett Packard Caribe, BV LLC
Highway 110 North Hm 28 PO Box 4048
Aguadilla
00605
Puerto Rico

Enterprise group supply chain operations manufacturing site.

Hewlett Packard Enterprise Company -
Johannesburg, South Africa JNB01
12 Autumn Street
Sandton
Gauteng
2128
South Africa

Sales and Service office.

Hewlett Packard Enterprise
Chippewa Falls Manufacturing
100 North Cashman Drive
Chippewa
Wisconsin
54729
USA

Manufacturing of server products.

Certificate No: EMS 670053

Location Registered Activities

Original Registration Date: 2017-03-31 Effective Date: 2017-03-31
Latest Revision Date: 2018-11-16 Expiry Date: 2019-09-03

Page: 3 of 3
This certificate remains the property of BSI and shall be returned immediately upon request.
An electronic certificate can be authenticated online. Printed copies can be validated at www.bsigroup.com/ClientDirectory
To be read in conjunction with the scope above or the attached appendix.
Information and Contact: BSI, Kitemark Court, Davy Avenue, Knowlhill, Milton Keynes MK5 8PP. Tel: + 44 345 080 9000
BSI Assurance UK Limited, registered in England under number 7805321 at 389 Chiswick High Road, London W4 4AL, UK.
A Member of the BSI Group of Companies.
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HPE Networking Product Warranty & Support Summary (October 2018)

The most current version of this document is available at www.hpe.com/networking/warrantysummary
HPE Networking product warranty policy details are available at www.hpe.com/networking/warranty

Information on services for HPE Networking products can be found at www.hpe.com/networking/services
The information contained herein is subject to change without notice.  Warranties for HPE products and services are set forth in the express warranty statements 

accompanying such products and services.   In addition, our goods come with guarantees that cannot be excluded under Australian and New Zealand consumer laws.  
Subject to the foregoing, nothing herein should be construed as constituting an additional warranty.  HPE shall not be liable for technical or editorial errors or omissions 

contained herein.

 

Products
Warranty 
duration1

Hardware 
replacement2

Business 
Hours 

Technical 
Support3

24x7
Technical 
Support3

(After Dec. 1, 2015)

Software/OS 
Releases4

S
w

it
c

h
e

s

Modular

129xx, 125xx, 119xx 1 year 10 days 1 year N/A As long as owned4

105xx, 75xx 1 year 10 days 1 year 90 days As long as owned4

84xx, 83xx 5 years 10 days 90 days N/A 5 years4

82xxzl, 54xxzl/R, 42xxvl
Lifetime5 NBD Ship

As long as 
owned5 90 days As long as owned4

Fixed-configuration

79xx, 59xx/AF, 583x/AF, 582x/AF, 57xx 1 year 10 days 1 year N/A As long as owned4

Altoline 9xxx, 6xxx Switches (Purchased after March 31, 2016) 1 year 10 days 1 year N/A N/A

Arista switches (See http://www.arista.com/assets/data/pdf/Warranty.pdf for details) 1 year15 10 days15 1 year15 N/A N/A

580x/AF
Lifetime5 NBD Ship

As long as 
owned5 N/A As long as owned4

55xx, 513x, 512x, 38xx, 36xx, 35xx/yl, 31xx, 29xx/al, 281x, 26xx, 25xx/G
Lifetime5 NBD Ship

As long as 
owned5 90 days As long as owned4

Smart Managed 

195x, 192x, 191x, 18xx, 1620 (Purchased after October 1, 2017)

Lifetime14 NBD Ship

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14

As long as owned4

Unmanaged 

1420, 1410 (Purchased after October 1, 2017)

Lifetime14 NBD Ship

90 days 
Phone 

support-Chat 
support entire 

warranty 
period 14

90 days 
Phone 

support-Chat 
support entire 

warranty 
period 14

N/A

1405 (Purchased after October 1, 2017) 3 years14 NBD Ship 90 days 
Phone 

support-Chat 
support entire 

warranty 
period 14

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14

N/A

W
ir

e
le

s
s
 L

A
N

Indoor Access Points

Aruba Controller-Managed Access Points (APs)
Lifetime10

30 day 
NBD/Return-to-

factory11

90 days N/A 90 days (bug fix only)

3WN/P, 155/P, 108/109 Aruba Remote Access points (RAPs) 
Lifetime10

30 day 
NBD/Return-to-

factory11

90 days N/A
Periodic updated 

image13

Aruba Instant Access Points (IAPs)
Lifetime10

30 day 
NBD/Return-to-

factory11

90 days N/A
Periodic updated 

image13

M330, M2xx
Lifetime5 NBD Ship

As long as 
owned5 90 days

As long as owned4

OfficeConnect 20 Access Point

3 years14 NBD Ship

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14

As long as owned4

Controllers

Aruba controllers
1 year

30 day 
NBD/Return-to-

factory11

90 days12 N/A N/A

Aruba Mobility Access Switches Lifetime10 NBD Ship 90 days 90 days As long as owned4

Other WLAN products 

Aruba Controller-Managed 2xx Series Outdoor Access Points
Lifetime10

30 day 
NBD/Return-to-

factory11

90 days N/A 90 days (bug fix only)

Aruba Instant 2xx Series Outdoor Access Points (IAPs)
Lifetime10

30 day 
NBD/Return-to-

factory11

90 days N/A
Periodic updated 

image13

AirWave Appliances, ClearPass Appliances, IntroSpect Appliances
1 year

30 day 
NBD/Return-to-

factory11

90 days12

N/A
90 days (bug fix only)

MST2HP, MST2HAC, MSR2KP, MSR4KP Aruba Outdoor Wireless Mesh 
Routers 1 year

30 day 
NBD/Return-to-

factory11

90 days12 N/A 90 days (bug fix only)

Aruba Beacons
90 days

30 day 
NBD/Return-to-

factory11

90 days N/A 90 days (bug fix only)

Cape Sensors
90 days

30 day 
NBD/Return-to-

factory11

90 days N/A 90 days (bug fix only)

Aruba Power Supplies, Antennae, Accessories
1 year

30 day 
NBD/Return-to-

factory11

90 days N/A N/A
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HPE Networking Product Warranty & Support Summary (October 2018)

The most current version of this document is available at www.hpe.com/networking/warrantysummary
HPE Networking product warranty policy details are available at www.hpe.com/networking/warranty

Information on services for HPE Networking products can be found at www.hpe.com/networking/services
The information contained herein is subject to change without notice.  Warranties for HPE products and services are set forth in the express warranty statements 

accompanying such products and services.   In addition, our goods come with guarantees that cannot be excluded under Australian and New Zealand consumer laws.  
Subject to the foregoing, nothing herein should be construed as constituting an additional warranty.  HPE shall not be liable for technical or editorial errors or omissions 

contained herein.

 

R
o

u
te

rs

Routers

88xx, HSR68xx 1 year 10 days 1 year N/A As long as owned4

HSR66xx, 66xx, MSR50, MSR4xxx, MSR3xxx, MSR30 1 year 10 days 1 year 90 days As long as owned4

MSR2xxx, MSR20, MSR1xxx, MSR9xx 1 year NBD Ship 1 year 90 days As long as owned4

ALU 77xx
1 year9 Return-to-

factory9 1 year9 N/A
All updates for 

purchased license9

VSR routers 90 days
(Media only)

N/A 90 days N/A
All updates for 

purchased license8

M
a

n
a

g
e

m
e
n

t

Network Management

Intelligent Management Center (support details at www.hpe.com/networking/IMCSupport) 90 days
(Media only)

N/A 90 days N/A 90 days (bug fix only)

AirWave, ALE, ArubaCentral, ClearPass, Meridian, VIA, Visual RF 90 days
(Media only)

N/A 90 days N/A 90 days (bug fix only)

HPE VAN SDN controller and HPE SDN applications 90 days
(Media only)

N/A 90 days N/A All updates for 
purchased license8

HPE Distributed Cloud Networking 90 days
(Media only)

N/A N/A N/A None

Big Switch Networks controller appliances (See www.bigswitch.com/support for 

warranty & support details)
N/A16 N/A16 N/A16 N/A16 N/A16

A
d

d
it

io
n

a
l 

N
e
tw

o
rk

in
g

 

P
ro

d
u

c
ts

Transceivers

Aruba Transceivers (Transceiver product numbers JWxxxx for Controllers 
and MAS Switches) 1 year 

30 day 
NBD/Return-to-

factory11

90 days N/A N/A

Aruba branded transceivers (except transceiver product numbers JWxxxx)
and

HPE X244, X242, X142, X132, X131, X129, X122, X121, X119, X112, X111

Lifetime5 NBD Ship As long as 
owned5

N/A N/A

Aruba 100G transceivers 1 year 10 days 1 year N/A N/A

HPE X2A0, X240, X190, X180, X170, X160, X150, X140, X135, X130, 
X125, X124, X120, X115, X114, X110

1 year 30 days 1 year N/A N/A

1) Removable power supplies, modules and accessories such as antennas, fans, power cords, 
etc. may have different warranty coverage than the host device.  See the HPE Networking 
Warranty Coverage Quick Reference at www.hpe.com/networking/warrantyquickref for more 
details. 

2) Response time is based on commercially reasonable effort and subject to a daily shipment 
cutoff time.  In some countries and regions and under certain supplier constraints, response 

time may vary.  Contact your local HPE service organization for response time availability in 
your area.  NBD Ship = Next Business Day shipment.

3) Warranty phone and electronic case technical support is provided during local HPE business 
hours for the entire warranty period for the purposes of diagnosing hardware or software 
defects.  Many products purchased after December 1, 2015 include 90 days of 24x7 technical 
support as noted.  See product’s Hewlett-Packard Limited Warranty Statement for additional 
coverage details.  Extended coverage services are available.

4) Includes all generally available software/OS releases offered for the specific products listed, 
when and if available, for as long as the customer owns the product, except where noted.  
Some software releases may require additional or new hardware.  Customers who desire 
specific feature updates, patches and fixes to be prioritized into future releases should 
purchase the appropriate support services from HPE.

5) For products purchased after December 1, 2014, the warranty extends only for as long as the 
original end user owns the product. Includes coverage of any built-in fans and power supplies 
for the entire warranty period. You may be required to provide proof of purchase or lease as a 
condition of receiving warranty service.  

6) Hardware warranty, technical support and all software releases provided for hardware and the 
ONE Service OS only, when and if available, for as long as the original end user owns the 
product.  See product specific documentation for application support.  5 year warranty on the 
disk drive in the HPE Alliance One Advanced Services zl Modules.

7) Products purchased before August 1, 2013 include 1 year of technical support and 1 year 
(bug fix only). 

8) Includes all software updates offered for the licensed version, when and if available.  Software 
upgrades will require purchase of appropriate SKU, packaged support services or contract.

9) All technical, hardware and software support for ALU 77xx products is provided directly by 
Alcatel-Lucent only and not HPE.  For support from Alcatel-Lucent, select the country from 
which the customer is calling in the following link and it will present the appropriate ALU 
support contact information: https://services.support.alcatel-lucent.com/product_support/.  
Hardware warranty requires shipping failed product to ALU for repair or replacement.  
Logistics cost for shipment of product from customer’s site to ALU site for repair or 
replacement will be covered by the customer.  Software maintenance releases are included 
for the major software release purchased.  Major software release upgrades are NOT 
included.  Services may be purchased from HPE or Alcatel-Lucent to extend your support 
coverage and software upgrades.  Support will be provided by Alcatel Lucent for these 
services.

10) For products purchased after December 1, 2015, the warranty extends only for as long as the 
original end user owns the product and is limited to five (5) years from the end of sale date.

11) For the first 30 days from shipment, HPE will provide same day ship advanced 
replacement for the covered hardware products.  After thirty (30) days from shipment 
through the remaining warranty period, HPE will replace or repair any non-compliant 
Product and return it in operable condition, shipping after HPE’s receipt of the non-
compliant Product via HPE’s RMA procedure, with receipt by customer within ten 
(10) days on a commercially reasonable basis.

12) HPE will provide next business day email response for the purposes of diagnosing 
hardware or software defects during standard Pacific Time Zone business hours for 
the first 90 days after purchase. 

13) HPE will make one recent Instant OS software release image available on the 
software portal.  This image is also available for Remote Access Points (RAPs) 
running Instant OS.

14) These products are covered by 90 days of 24x7 phone support.  Thereafter, only 
chat support would be available for the remaining warranty period.  Limited lifetime 
warranty (where applicable) extends only for as long as the original end user owns 
the product and is limited to five (5) years from the end of sale date. This warranty 
includes coverage of any built-in fans and power supplies for the entire warranty 
period. You may be required to provide proof of purchase or lease as a condition of 
receiving warranty service. See www.hpe.com/OfficeConnect/support/ for more 
information on the new OfficeConnect support process. 

15) All technical, hardware and software support for Arista products is provided directly 
by Arista and not HPE.   Consult the Arista customer support page for contact 
information: https://www.arista.com/en/support/customer-support.  Transportation 
costs, if any, incurred in connection with the return of a defective Hardware to an 
Arista repair center shall be borne by Customer. Arista shall pay any transportation 
costs incurred with the redelivery of a repaired or replaced Hardware. Services may 
be purchased from HPE or Arista to extend your support coverage and software 
upgrades.  Support will be provided by Arista for these services.  For details on 
Arista warranty and support, see: 
http://www.arista.com/assets/data/pdf/Warranty.pdf.

16) All technical, hardware and software support for Big Switch Networks products is 
provided directly by BSN and not HPE.  Consult the Big Switch Networks customer 
support page for contact information: www.bigswitch.com/support.  For details on 
Big Switch Networks warranty and support options, see: 
http://bigswitch.com/sites/default/files/bsn_support_and_maintenance_policy.v2.2.20
16.11.14.pdf.
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Worldwide support numbers for these product 

families:*

 – Aruba products

 – HPE Nimble Storage products

Support matrix

Technical Support Phone Numbers

Country Support type Support phone number Hours of operations

Aland Contract +358 20 320 300 24x7

Warranty and Out of Warranty +358 20 353 232 M–F 8:00–17:00

Albania Contract & Warranty/Out of Warranty +355 42 322 411 24x7

Algeria Contract & Warranty/Out of Warranty +216 23 92 5000 24x7

Andorra Contract +34 902 220 030 24x7

Warranty and Out of Warranty +34 902 010 333 M–F 8:30–17:30

Angola Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Anguilla Contract & Warranty 1-800-225-5288 then 

844 692-8150

24x7

Antigua and Barbuda Contract & Warranty #1 then 844 692-8151 24x7

Argentina Contratos 0 800 444 7867

+52 55 5258 4500

24x7

Garantías 0 800 333 4857

+52 55 1500 3155

M–F 8:00–17:00

Armenia Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Aruba Contract & Warranty +1 844 264 1328 24x7

Australia Contract & Warranty/Out of Warranty 13 11 47

+61 2 8031 8315

24x7

Azerbaijan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

* For all other product types, please call the support number for your country listed in this document.
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Support matrix Page 2

Country Support type Support phone number Hours of operations

Bahamas Contract & Warranty 1-800-872-2881 then 

844 692-8152

24x7

Bahrain Contract & Warranty/Out of Warranty +973 1 619 82 94 24x7

Barbados Contract & Warranty 1-800-225-5288 then 

844 692-8153

24x7

Belarus Contract & Warranty/Out of Warranty 8 8200 073 01 01

+7 495 411 69 07

24x7

Belgium Contract 078 250 144

+32 26 200 055

24x7

Warranty and Out of Warranty 078 600 600

+32 26 200 099

M–F 8:00–17:00

Belize Contract & Warranty 811 then 844 692-8148 24x7

Benin Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Bermuda Contract & Warranty 1-800-225-5288 then 

844 692-8154

24x7

Bolivia Contratos 800 110 348

+52 55 5258 4500

24x7

Garantías 800 110 348

+52 55 1500 3155

M–F 8:00–17:00

Bonaire (Sint Eustatius, Saba) Contract & Warranty 001-800-872-2881 then 

844 752-2839

24x7

Bosnia and Herzegovina Contract & Warranty/Out of Warranty +387 338 219 22 24x7

Botswana Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Bouvet Island Contract & Warranty/Out of Warranty 800 56 044 24x7

Brasil Contract 0800 55 6405

+55 11 3173 8802 

+55 11 4688 5102

24x7

Warranty 0800 710 2029

+55 11 2377 1002 

+55 11 2377 0002

M–F 8:00–17:00
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Support matrix Page 3

Country Support type Support phone number Hours of operations

British Indian Ocean Territory Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

British Virgin Islands Contract & Warranty 1-800-872-2881 then 

844 692-8156

24x7

Bulgaria Contract & Warranty/Out of Warranty 0700-1-47-47 24x7

Burkina Faso Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Burundi Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Cameroon Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Canada Contract

Contrat

1-800-633-3600 24x7

Warranty and Out of Warranty

Produits garantis et hors garantie

1-844-806-3425 24x7 for most products

Cape Verde Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Cayman Islands Contract & Warranty 1-800-225-5288 then 

844 692-8157

24x7

Central African Republic Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Chad Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Chile Contratos 800 362 365

+52 55 5258 4500

24x7

Garantías 800 123 605

+52 55 1500 3155

M–F 8:00–17:00

Collectivity of Saint Martin Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Colombia Contratos 01 800 051 4747

+57 1 6004150

24x7

Garantías 800 051 7127

+52 55 1500 3155

M–F 9:00–18:00

Comoros Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7
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Support matrix Page 4

Country Support type Support phone number Hours of operations

Costa Rica Contratos 800 794 4401

+52 55 5258 4500

24x7

Garantías 800 794 4401

+52 55 1500 3155

M–F 8:00–17:00

Croatia Contract & Warranty/Out of Warranty 0800 303 556 24x7

Curaçao Contract & Warranty 001-800-872-2881 then 

844 264-1326

24x7

Cyprus Contract & Warranty/Out of Warranty 801 11 47 22 73

+30 211 181 3846

24x7

Czech Republic Contract & Warranty/Out of Warranty 239 018 791 24x7

Denmark Contract +45 70 10 80 25 24x7

Warranty and Out of Warranty +45 70 11 77 00 M–F 8:00–17:00

Deutschland Dienstleistungsverträge/Contracts +49 69 380 789 143 24x7

Produkte innerhalb und außerhalb der Herstellergarantie +49 69 380 789 142 Montag–Freitag

8:00–17:00

(außer an bundeseinheitlichen Feiertagen)

Djibouti Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Dominica Contract & Warranty 1-800-225-5288 then 

844 264-1327

24x7

Dominican Republic Contract & Warranty 1-888-225-5288 then 

844 264-1328

+52 55 5258 4500

24x7

Ecuador Contratos 1-800-225-528 then 

844 845-8165

+52 55 5258 4500

24x7

Garantías 1-800-225-528 then 

844 845-8165

+52 55 1500 3155 

M–F 8:00–17:00

Egypt Contract & Warranty/Out of Warranty 0800 000 0814

+20 2 353 131 62

24x7
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Support matrix Page 5

Country Support type Support phone number Hours of operations

El Salvador Contratos 800-1785 then 

844 845-8167

+52 55 5258 4500

24x7

Garantías 800-1785 then 

844 845-8167

+52 55 1500 3155 

M–F 8:00–17:00

Equatorial Guinea Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Eritrea Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

España Contrato de Mantenimiento +34 902 220 030

+34 913496569

24x7

Garantía y fuera de garantía +34 902 010 333

+34 913496559

Lunes a viernes, 8:30 a 17:30 de julio y agosto,  

8:30 a 14:30

Estonia Contract & Warranty/Out of Warranty +372 686 88 71 24x7

Ethiopia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Falkland Islands Contract & Warranty/Out of Warranty +44 845 161 0050 24x7

Faroe Islands Contract +45 70 10 80 25 24x7

Warranty and Out of Warranty +45 70 11 77 00 M–F 8:00–17:00

Finland Contract +358 20 320 300 24x7

Warranty and Out of Warranty +358 20 353 232 M–F 8:00–17:00

France Contrat 0825 00 41 23

+33 173018471

24x7

Ligne payante au tarif local en France

Garantie et Hors Garantie 0826 10 49 49

+33 173018475

Lundi–Vendredi 

8:30–18:00

(à l’exception des jours fériés et jours de fermeture d’HPE)

French Guiana Contract & Warranty 0800 99 00 11 then 

844 264-1329

24x7

French Polynesia Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

French Southern Territories Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Gabon Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7
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Support matrix Page 6

Country Support type Support phone number Hours of operations

Gambia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Georgia Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Ghana Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Gibraltar Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

Greece Contract & Warranty/Out of Warranty 801 11 47 22 73

+30 211 181 3846

24x7

Greenland Contract +45 70 10 80 25 24x7

Warranty and Out of Warranty +45 70 11 77 00 M–F 8:00–17:00

Grenada Contract & Warranty 1-800-225-5288 then 

844 264-1330

24x7

Guadeloupe Contract & Warranty 0-800-99-0011 then 

844 264-1331

24x7

Guatemala Contratos 999-9190 then 

844 845-8169

+52 55 5258 4500

24x7

Garantías 999-9190 then 

844 845-8169

+52 55 1500 3155

M–F 8:00–17:00

Guernsey Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

Guinea Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Guinea-Bissau Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Guyana Contract & Warranty 159 then 844 752-2835 24x7

Haiti Contract & Warranty +1 844 264 1328 24x7
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Country Support type Support phone number Hours of operations

Honduras Contratos 800-0-123 then 

844 752-2837

+52 55 5258 4500

24x7

Garantías 800-0-123 then 

844 752-2837

+52 55 1500 3155 

M–F 8:00–17:00

Hong Kong Contract +852 2292 3333 24x7

Alpha, ProLiant, and attached HPE Storage Systems

Warranty +852 3071 3873 M–F 8:30–17:30

HPE Networking, UNIX® system, NetServer, and attached 

HPE Storage systems 

Warranty +852 2904 8338 24x7

ProLiant & attached 

HPE Storage Systems 

Value line (need PIN code during AOH)

Hungary Contract 1 778 9670 24x7

Warranty and Out of Warranty 1 778 9669 M–F 9:00–17:00

Iceland Contract +47 800 56 044 24x7

Warranty and Out of Warranty +47 800 62 800 M–F 8:00–17:00

India Warranty 1800 419 8080 (Callers in India)

+91 806 703 7209 (International Callers)

M–F 9:00–18:00

Indonesia Contract & Warranty 0018 0385 20668

+62 21 5799 4050

24x7

Iran Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Iraq Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Ireland Contract 1850 924 590

+ 353 1 4118915

24x7

Warranty and Out of Warranty 1890 946 500

+ 353 1 4118912

M–F 8:00–18:00

(except Bank Holidays)

Isle of Man Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00
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Country Support type Support phone number Hours of operations

Israel Contract & Warranty/Out of Warranty 1-809-400-300

+972 3-3726489

24x7

Italia Contratti 02 452 790 50 24x7

In garanzia o fuori garanzia 02 385 912 12 Lunedì–Venerdì 8:00–17:00

Ivory Coast Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Jamaica Contract & Warranty 1-800-872-2881 then 

844 264-1332

24x7

日本 Warranty support.hpe.com/hpsc/doc/public/display?docId=emr_

na-c04770344

Jersey Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

Jordan Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Kazakhstan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Kenya Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Kosovo Contract & Warranty/Out of Warranty 0800 300 003/0800 190 038 (Serbia)

035 542 322 411 (Albania)

24x7

Kuwait Contract & Warranty/Out of Warranty 632 9930 24x7

Kyrgyzstan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Latvia Contract & Warranty/Out of Warranty 678 521 84 24x7

Lebanon Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Lesotho Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Liberia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Libya Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Liechtenstein Contract +41 0848 800 724 24x7

Warranty and Out of Warranty +41 0848 80 20 20 M–F 8:00–18:00

Lithuania Contract & Warranty/Out of Warranty +370 521 415 92 24x7
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Luxembourg Contract +352 27 303 111 24x7

Warranty and Out of Warranty +352 27 303 303 M–F 8:00–17:00

Macedonia Contract & Warranty/Out of Warranty 0800 90 472 24x7

Madagascar Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Malawi Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Malaysia Contract & Warranty 1800 88 1811 (Callers in Malaysia)

+60 3 6207 4533 (International Callers)

24x7

Mali Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Malta Contract & Warranty/Out of Warranty +356 27 781 269 24x7

Martinique Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Mauritania Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Mauritius Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Mayotte Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

México Contratos 800 501 9800

+52 55 5258 4500

24x7

Garantías 800 890 6348

+52 55 1500 3155

M–F 8:00–17:00

Moldova Contract & Warranty/Out of Warranty +7 499 272 37 82 24x7

Monaco Contrat +33 1 73 01 84 71 24x7

Ligne payante au tarif local en France

Garantie et Hors Garantie +33 1 73 01 84 75 Lundi–Vendredi 

8:30–18:00

(à l’exception des jours fériés et jours de fermeture d’HPE)

Montenegro Contract & Warranty/Out of Warranty 0800 300 003 24x7

Montserrat Contract & Warranty 1-800-225-5288 then 

844 264-1333

24x7

Morocco Contract & Warranty/Out of Warranty 00 212 5 22 24 87 70

+44 1793 794886

24x7
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Mozambique Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Namibia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Netherlands Contract 0900 115 0000

+31 205 040 666

24x7

Warranty and Out of Warranty 0900 117 0000 M–F 8:00–17:00

New Caledonia Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

New Zealand Contract & Warranty/Out of Warranty 0800 664 747

+61 2 8031 8316

24x7

Nicaragua Contratos 1-800-0164 then 

844 752-2840

+52 55 5258 4500

24x7

Garantías 1-800-0164 then 

844 752-2840

+52 55 1500 3155

M–F 8:00–17:00

Niger Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Nigeria Contract & Warranty/Out of Warranty 01 27 14 777

+44 203 564 4148

24x7

Norway Contract 800 56 044 24x7

Warranty and Out of Warranty 800 62 800 M–F 8:00–17:00

Oman Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Österreich Dienstleistungsverträge/Contracts 08 1000 2000 24x7

Produkte innerhalb und ausserhalb der

Herstellergarantie

08 1000 1000 M–F 8:00–18:00

Palestinian Territory Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Panama Contratos 800-2288 then 

844 845-8163

+52 55 5258 4500

24x7

Garantías 800-2288 then 

844 845-8163

+52 55 1500 3155 

M–F 8:00–17:00
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Paraguay Contratos 008-11-800 then 

844 752-2842

+52 55 5258 4500

24x7

Garantías 008-11-800 then 

844 752-2842

+52 55 1500 3155 

M–F 8:00–17:00

Perú Contratos 0 800 1 9703

+52 55 5258 4500

24x7

Garantías 0800 44 366

+52 55 1500 3155 

M–F 8:00–17:00

Philippines Contract & Warranty 1800 1441 0669

 1800 8908 6404

+63 2395 3565

24x7

Poland Contract & Warranty/Out of Warranty 0 800 702 284

(22) 306 04 84

24x7

Portugal Contract 808 203 203 24x7

Warranty and Out of Warranty 213 164 164 M–F 9:00–18:00

Puerto Rico Contratos 844 752-2843

+52 55 5258 4500

24x7

Garantías 844 752-2843

+52 55 1500 3155 

M–F 8:00–17:00

Qatar Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Republic of Congo Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Réunion Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Romania Contract & Warranty/Out of Warranty +40 317 305 020 24x7

Россия Поддержка 8 800 500 92 55

+7 495 411 69 07

24x7

Rwanda Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Saint Barthélemy Contract 0-800-990-011 then 

844 845-8168

24x7

Warranty and Out of Warranty +212 5 22 24 87 70 24x7
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Saint Helena (Ascension and Tristan da Cunha) Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Saint Kitts and Nevis Contract & Warranty 1-800-225-5288 then 

844 264-1334

24x7

Saint Lucia Contract & Warranty/Out of Warranty 1 844 231 8954 24x7

Saint Pierre and Miquelon Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Saint Vincent and the Grenadines Contract & Warranty 1-800-225-5288 then 

844 845-8160

24x7

San Marino Contract 02 452 790 50 24x7

Warranty and Out of Warranty 02 385 912 12 M–F 8:00–17:00

Sao Tome and Principe Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Saudi Arabia Contract & Warranty/Out of Warranty 800 844 4611 24x7

Schweiz
Suisse

Dienstleistungsvertrag/

Contrat de services

0848 800 724

+41 43 557 9021

24x7

8Rp./Min*

Herstellergarantie/

Produits garantis

0848 80 20 20

+41 44 200 4115

Montag–Freitag

Lundi–Vendredi

8:00–17:00

(außer Feiertage) 

8Rp./Min*

*aus dem schweizerischen Festnetz; abweichende Preise aus 

Mobilfunknetzen sind je nach Anbieter möglich.

Senegal Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Serbia Contract & Warranty/Out of Warranty 0800 300 003

0800 190 038 

24x7

Seychelles Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Sierra Leone Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Singapore Contract & Warranty 1800 272 4333 (Callers in Singapore)

+65 6272 4333 (International Callers)

24x7

Sint Maarten Contract & Warranty 800-99-0011 then 

844 264-1335

24x7
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Slovakia Contract & Warranty/Out of Warranty 02 686 221 79 24x7

Slovenia Contract & Warranty/Out of Warranty 0800 80 745 24x7

Somalia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

South Africa Contract 0860 001 020 24x7

Warranty and Out of Warranty 0860 001 030 M–F 8:00–17:00

(except public Holidays)

South Georgia and the South Sandwich Islands Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

대한민국 Contract & Warranty +82 1577 3270 M–F 09:00–18:00

Server & Storage

Contract & Warranty +82 1588 0142 M–F 09:00–18:00

Networking

South Sudan Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Sudan Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Suriname Contract & Warranty/Out of Warranty 156 then 844 231-8955 24x7

Svalbard and Jan Mayen Contract +47 800 56 044 24x7

Warranty and Out of Warranty +47 800 62 800 M–F 8:00–17:00

Swaziland Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Sweden Contract 0771 30 30 50 24x7

Warranty and Out of Warranty 0771 30 30 00 M–F 8:00–17:00

Syria Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Taiwan Contract & Warranty 0800 211 666

+886 2 2656 7204

M–F 8:30–17:30

Tajikistan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7
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Tanzania Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Thailand Contract 1800 441 4048

+66 2 118 6000

24x7

Warranty 1800 441 4085

+66 2 118 6300

M–F 8:30–17:30

The Democratic Republic of Congo Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Togo Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Trinidad and Tobago Contract & Warranty/Out of Warranty 1-800-872-2881 then 

844 845-8161

24x7

Tunisia Contract & Warranty/Out of Warranty +216 23 92 5000 24x7

Turkey Contract 850 759 0 724

+90 850 759 0 724

24x7

Warranty and Out of Warranty 850 759 0 473

+90 850 759 0 473

08:30–17:30 GMT+3

Turkmenistan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Turks and Caicos Islands Contract & Warranty 1-800-225-5288 then 

844 845-8162

24x7

Uganda Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Ukraine Contract & Warranty/Out of Warranty 0 800 501 526 24x7

United Arab Emirates Contract & Warranty/Out of Warranty 800 0444 1477 24x7

United Kingdom Contract 0845 161 0050 24x7

Warranty and Out of Warranty 0845 161 0030 M–F 8:00–18:00

United States Contract 1-800-633-3600 24x7

Warranty and Out of Warranty 1-844-806-3425 24x7

Uruguay Contratos 0004 110 032 632

+52 55 5258 4500

24x7

Garantías 0004 110 032 632

+52 55 1500 3155 

M–F 8:00–17:00
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US Virgin Islands Contract & Warranty +1 844 845-8164 24x7

Uzbekistan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Vatican City Contract 02 45279050 24x7

Warranty and Out of Warranty 02 38591212 M–F 8:00–17:00

Venezuela Contratos & Garantías +58 212 7102103 24x7

Vietnam Contract & Warranty +84 28 4458 2390 24x7

Wallis and Futuna Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Western Sahara Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Yemen Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Zambia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Zimbabwe Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7
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Aruba 3810M Switch Series
 

 
Models
Aruba 3810M 24G 1-slot Switch JL071A
Aruba 3810M 48G 1-slot Switch JL072A
Aruba 3810M 24G PoE+ 1-slot Switch JL073A
Aruba 3810M 48G PoE+ 1-slot Switch JL074A
Aruba 3810M 16SFP+ 2-slot Switch JL075A
Aruba 3810M 40G 8 HPE Smart Rate PoE+ 1-slot Switch JL076A
Aruba 3810M 48G PoE+ 4SFP+ 680W Switch JL428A
Aruba 3810M 48G PoE+ 4SFP+ 1050W Switch JL429A
Aruba 3810M 24SFP+ 250W Switch JL430A

Key features
Advanced Layer 3 switch series with backplane stacking, dynamic segmentation, low latency and
resiliency
Advanced security and network management via Aruba ClearPass Policy Manager, Aruba AirWave and
Aruba Central
Modular 10GbE and 40GbE uplinks for wireless aggregation
HPE Smart Rate for high-speed multi-gigabit capacity and PoE+ power
Software-defined ready with REST APIs and OpenFlow support

 

QuickSpecs Aruba 3810M Switch Series

Overview
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The Aruba 3810 Switch Series provides performance and resiliency for enterprises, SMBs, and branch office
networks. With HPE Smart Rate multi-gigabit ports for high speed access points and IoT devices, this
advanced Layer 3 network switch delivers a better application experience with low latency, virtualization with
resilient stacking technology, and line rate 40GbE for plenty of back haul capacity. 
A powerful Aruba ProVision ASIC delivers performance, robust feature support, and value with flexible
programmability for the latest applications.  The 3810 delivers resiliency and scalability via innovative
backplane stacking technology and redundant, hot-swappable power supplies all in a convenient 1U form
factor.  It supports an advanced Layer 2 and 3 feature set with OSPF, IPv6, IPv4 BGP, Dynamic
Segmentation, robust QoS, and policy-based routing are included with no software licensing. 
The 3810M is easy to deploy, use and manage using Aruba AirWave or Aruba Central. Aruba ClearPass
offers centralized security and external captive portal support.  The switches offer a limited lifetime warranty.

QuickSpecs Aruba 3810M Switch Series

Overview
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Enhanced Capabilities and benefits
 
Software-defined networks

Supports multiple programmatic interfaces
Including REST APIs and Openflow 1.0 and 1.3, to enable automation of network operations,
monitoring, and troubleshooting.

Unified Wired and Wireless Support

ClearPass Policy Manager support
unified wired and wireless policies using Aruba ClearPass Policy Manager
Switch auto-configuration
Automatically configures switch for different settings such as VLAN, CoS, PoE max power, and PoE
priority when an Aruba access point is detected.
User role
Defines a set of switch-based policies in areas such as security, authentication, and QoS. A user role
can be assigned to a group of users or devices, using switch-based local user role or download from
ClearPass
Dynamic segmentation
Provides a secured tunnel to transport network traffic on a per-port or per-user-role basis to an Aruba
Controller.  In per-user-role Tunneled Node, users are authenticated with ClearPass Policy Manager
which can direct the traffic to be tunneled to Aruba controller or switch locally.
Static IP visibility
provides a way for ClearPass to do accounting for clients with static IP addresses

Quality of Service (QoS)
Advanced classifier-based QoS

classifies traffic using multiple match criteria based on Layer 2, 3, and 4 information; applies QoS
policies such as setting priority level and rate limit to selected traffic on a per-port or per-VLAN basis

Layer 4 prioritization
based on TCP/UDP port numbers

Class of Service (CoS)
sets the IEEE 802.1p priority tag based on IP address, IP Type of Service (ToS), Layer 3 protocol,
TCP/UDP port number, source port, and DiffServ

Bandwidth shaping:
- Port-based rate limiting: provides per-port ingress-/egress-enforced increased bandwidth
- Classifier-based rate limiting: uses an access control list (ACL) to enforce increased bandwidth

for ingress traffic on each port
- Reduced bandwidth: provides per-port, per-queue egress-based reduced bandwidth

Remote intelligent mirroring
mirrors selected ingress/egress traffic based on an ACL, port, MAC address, or VLAN to a local or
remote HPE 8200 zl, 6600, 6200 yl, 5400 zl, or 3500 switch anywhere on the network

Remote monitoring (RMON), Extended RMON (XRMON), and sFlow v5
provide advanced monitoring and reporting capabilities for statistics, history, alarms, and events

Traffic prioritization
allows real-time traffic classification into eight priority levels that are mapped to eight queues

Unknown Unicast Rate Limiting
throttles unicast packets with unknown destination addresses and limits flooding on the VLAN

 
 
 
Simplified management and configuration

Flexible management
supports both cloud-based Central and on-premise AirWave without ripping and replacing switching
infrastructure

QuickSpecs Aruba 3810M Switch Series

Standard Features
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Aruba Central cloud-based management platform
offers simple, secure, and cost effective way to manage switches

Built-in programmable and easy to use REST API interface
provides configuration automation for campus networks

Friendly port names
allows assignment of descriptive names to ports

IEEE 802.1AB Link Layer Discovery Protocol (LLDP)
advertises and receives management information from adjacent devices on a network, facilitating
easy mapping by network management applications

Command authorization
leverages RADIUS to link a custom list of CLI commands to an individual network administrator's
login; an audit trail documents activity

Multiple configuration files
stores easily to the flash image

Dual flash images
provides independent primary and secondary operating system files for backup while upgrading

Out-of-band Ethernet management port
enables management over a separate physical management network; and keeps management traffic
segmented from network data traffic

Zero Touch ProVisioning (ZTP)
simplifies installation of the switch infrastructure using the Aruba Activate-based or a DHCP-based
process with AirWave and Central Network Management

Unidirectional Link Detection (UDLD)
monitors the link between two switches and blocks the ports on both ends of the link if the link goes
down at any point between the two devices

IP service level agreements (SLA) for voice
monitor quality of voice traffic using the UDP jitter and UDP jitter for VoIP tests

J

Connectivity
Jumbo frames on Gigabit Ethernet and 10-Gigabit Ethernet ports

allow high-performance remote backup and disaster-recovery services
IEEE 802.3at Power over Ethernet (PoE+)

provides up to 30 W per port that allows support of the latest PoE+ capable devices such as IP
phones, wireless access points, and security cameras, as well as any IEEE 802.3af compliant end
device; eliminates the cost of additional electrical cabling and circuits that would otherwise be
necessary in IP phone and WLAN deployments

Support for pre-standard PoE
detects and provides power to pre-standard PoE devices

Choice of uplinks:
- SFP+ uplink models: provide fiber-optic (up to 70 km) or direct-attach-cable (DAC) connectivity
- 10GBASE-T uplink models: offer 10GbE speeds, using standard RJ-45 connectors and

standard twisted-pair cabling up to 100 m
Auto-MDIX

provides automatic adjustments for straight-through or crossover cables on all RJ-45 ports
IPv6:

- IPv6 host: enables switch management in an IPv6 network
- Dual stack (IPv4 and IPv6): transitions IPv4 to IPv6, supporting connectivity for both protocols
- MLD snooping: forwards IPv6 multicast traffic to the appropriate interface
- IPv6 ACL/QoS: supports ACL and QoS for IPv6 traffic
- IPv6 routing: supports static, RIPng, OSPFv3 routing protocols
- 6in4 tunneling: supports encapsulation of IPv6 traffic in IPv4 packets
- Security: provides RA guard, DHCPv6 protection, dynamic IPv6 lockdown, and ND snooping
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Performance and efficiency
Selectable queue configurations

allows for increased performance by selecting the number of queues and associated memory
buffering that best meet the requirements of the network applications

Energy-efficient design:
- 80 PLUS Silver Certified power supply: increases power efficiency and savings
- Energy-efficient Ethernet (EEE) support: reduces power consumption in accordance with

IEEE 802.3az
Meshed stacking technology:

- High-performance stacking: provides up to 336 Gb/s of stacking throughput; each 4-port
stacking module can support up to 42 Gb/s in each direction per stacking port

- Ring, chain, and mesh topologies: support up to a 10-member ring or chain and 5-member
fully meshed stacks; meshed topologies offer increased resiliency vs. a standard ring

- Virtualized switching: provides simplified management as the switches appear as a single
chassis when stacked

Aruba ProVision ASIC
provides very low latency, increased packet buffering, and adaptive power consumption

Resiliency and high availability
Virtual Router Redundancy Protocol (VRRP)

allows groups of two routers to dynamically back each other up to create highly available routed
environments in IPv4 and IPv6 networks

Nonstop switching and routing
improves network availability to better support critical applications, such as unified communication
and mobility; traffic will continue to be forwarded during failovers, when the backup member of the
stack becomes the commander

IEEE 802.3ad Link Aggregation Protocol (LACP) and Hewlett Packard Enterprise port trunking
support up to 144 trunks, each with up to 8 links (ports) per trunk

IEEE 802.1s Multiple Spanning Tree
provides high link availability in multiple VLAN environments by allowing multiple spanning trees;
provides legacy support for IEEE 802.1d and IEEE 802.1w

Dual hot-swappable power supplies
- Increased resiliency: with secondary power supply to enable complete switch power redundancy

in case of power line or supply failure
- Secondary power supply increases available PoE+ power

Distributed trunking
enables loop-free and redundant network topology without using Spanning Tree Protocol; allows a
server or switch to connect to two switches using one logical trunk for redundancy and load sharing

SmartLink
provides easy-to-configure link redundancy of active and standby links

Layer 2 switching
IEEE 802.1ad QinQ

increases the scalability of an Ethernet network by providing a hierarchical structure; connects
multiple LANs on a high-speed campus or metro network

VLAN support and tagging
supports the IEEE 802.1Q standard and 4096 VLANs simultaneously

IEEE 802.1v protocol VLANs
isolate select non-IPv4 protocols automatically into their own VLANs

MAC-based VLAN
provides granular control and security; uses RADIUS to map a MAC address/user to specific VLANs

Rapid Per-VLAN Spanning Tree (RPVST+)
allows each VLAN to build a separate spanning tree to improve link bandwidth usage; is compatible
with PVST+

Aruba 3810M switch meshing
dynamically load balances across multiple active redundant links to increase available aggregate
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bandwidth; allows concurrent Layer 3 routing
GVRP and MVRP

allows automatic learning and dynamic assignment of VLANs
 
 
Layer 3 services

Loopback interface address
defines an address in Routing Information Protocol (RIP) and Open Standard Path First (OSPF),
improving diagnostic capability

Route maps
provide more control during route redistribution; allow filtering and altering of route metrics

User datagram protocol (UDP) helper function
allows UDP broadcasts to be directed across router interfaces to specific IP unicast or subnet
broadcast addresses; and helps prevent server spoofing for UDP services such as DHCP

DHCP server
centralizes and reduces the cost of IPv4 address management

Bidirectional Forwarding Detection (BFD)
enables link connectivity monitoring and reduces network convergence time for static routing,
OSPFv2, and VRRP

Layer 3 routing
Static IP routing

provides manually configured routing for both IPv4 and IPv6 networks
OSPF

provides OSPFv2 for IPv4 routing and OSPFv3 for IPv6 routing
Policy-based routing

makes routing decisions based on policies set by the network administrator
Border Gateway Protocol (BGP)

provides IPv4 Border Gateway Protocol routing, which is scalable, robust, and flexible
Routing Information Protocol (RIP)

provides RIPv1, RIPv2, and RIPng routing
 
Security

Control plane policing
sets rate limit on control protocols to protect CPU overload from DOS attacks

Source-port filtering
allows only specified ports to communicate with each other

RADIUS/TACACS+
eases switch management security administration by using a password authentication server

Secure shell
encrypts all transmitted data for secure remote CLI access over IP networks

Secure Sockets Layer (SSL)
encrypts all HTTP traffic, allowing secure access to the browser-based management GUI in the
switch

Port security
allows access only to specified MAC addresses, which can be learned or specified by the
administrator

MAC address lockout
prevents particular configured MAC addresses from connecting to the network

Detection of malicious attacks
monitors 10 types of network traffic and sends a warning when an anomaly that potentially can be
caused by malicious attacks is detected

Secure FTP
allows secure file transfer to and from the switch; protects against unwanted file downloads or
unauthorized copying of a switch configuration file
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Switch management logon security
helps secure switch CLI logon by optionally requiring either RADIUS or TACACS+ authentication

Secure management access
delivers secure encryption of all access methods (CLI, GUI, or MIB) through SSHv2, SSL, and/or
SNMPv3

ICMP throttling
defeats ICMP denial-of-service attacks by enabling any switch port to automatically throttle ICMP
traffic

 
 

Identity-driven ACL
enables implementation of a highly granular and flexible access security policy and VLAN assignment
specific to each authenticated network user

STP BPDU port protection
blocks Bridge Protocol Data Units (BPDUs) on ports that do not require BPDUs, preventing forged
BPDU attacks

Dynamic IP lockdown
works with DHCP protection to block traffic from unauthorized hosts, preventing IP source address
spoofing

DHCP protection
blocks DHCP packets from unauthorized DHCP servers, preventing denial-of-service attacks

Dynamic ARP protection
blocks ARP broadcasts from unauthorized hosts, preventing eavesdropping or theft of network data

STP root guard
protects the root bridge from malicious attacks or configuration mistakes

Management Interface Wizard
helps secure management interfaces such as SNMP, Telnet, SSH, SSL, Web, and USB at the
desired level

Security banner
displays a customized security policy when users log in to the switch

Switch CPU protection
provides automatic protection against malicious network traffic trying to shut down the switch

ACLs
provide filtering based on the IP field, source/destination IP address/subnet and source/destination
TCP/UDP port number on a per-VLAN or per-port basis

Multiple authentication methods
- IEEE 802.1X

authenticates multiple IEEE 802.1X users per port; prevents a user from "piggybacking" on
another user's authentication

- Supports web-based authentication
- MAC-based client authentication
- Concurrent authentication modes

enables a switch port to accept up to 32 sessions of 802.1X, Web, and MAC authentication
Private VLAN

provides network security by restricting peer-to-peer communication to prevent a variety of malicious
attacks; typically a switch port can only communicate with other ports in the same community and/or
an uplink port, regardless of VLAN ID or destination MAC address

IEEE 802.1AE MACsec
provides security on a link between two switch ports (1Gbps or 10Gbps) using standard encryption
and authentication

Open authentication role
simplifies first-time deployment of AAA in brownfield deployments by allowing full network access for
failed clients and provides instant connectivity as soon as a client is plugged-in

Critical authentication role
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ensures that important infrastructure devices such as IP phones are allowed network access even in
the absence of a RADIUS server

MAC pinning
allows non-chatty legacy devices to stay authenticated by pinning client MAC addresses to the port until the clients
logoff or get disconnected

 
Convergence

IP multicast snooping (data-driven IGMP)
prevents flooding of IP multicast traffic

LLDP-MED (Media Endpoint Discovery)
defines a standard extension of LLDP that stores values for parameters such as QoS and VLAN to
configure automatically network devices such as IP phones

PoE allocations
supports multiple methods (automatic, IEEE 802.3af class, LLDP-MED, or user-specified) to allocate
PoE power for more efficient energy savings

Protocol Independent Multicast for IPv6
supports one-to-many and many-to-many media casting use cases such as IPTV over IPv6 networks

IP multicast routing
includes PIM sparse and dense modes to route IP multicast traffic

Auto VLAN configuration for voice
- RADIUS VLAN

uses a standard RADIUS attribute and LLDP-MED to automatically configure a VLAN for IP
phones

- CDPv2
uses CDPv2 to configure legacy IP phones

Local MAC Authentication
assigns attributes such as VLAN and QoS using locally configured profile that can be a list of MAC
prefixes

Warranty and support
Limited Lifetime Warranty

see http://www.hpe.com/networking/warrantysummary for warranty and support information
included with your product purchase.

Software releases
to find software for your product, refer to http://www.hpe.com/networking/support; for details on the software releases
available with your product purchase, refer to http://www.hpe.com/networking/warrantysummary
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Build To Order:
BTO is a standalone unit with no integration. BTO products ship standalone are not part of a CTO or Rack-
Shippable solution.
Aruba 3810M 24G 1-slot Switch JL071A

24 RJ-45 autosensing 10/100/1000 ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

 

Aruba 3810M 48G 1-slot Switch JL072A
48 RJ-45 autosensing 10/100/1000 ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

 

Aruba 3810M 24G PoE+ 1-slot Switch JL073A
24 RJ-45 autosensing 10/100/1000 PoE+ ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

 

Aruba 3810M 48G PoE+ 1-slot Switch JL074A
48 RJ-45 autosensing 10/100/1000 PoE+ ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

 

Aruba 3810M 16SFP+ 2-slot Switch JL075A
16 fixed 1000/10000 SFP/SFP+ ports
min=0 \ max=16 SFP/SFP+  Transceivers
1 open stacking module slot
2 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

See
Configuration

RULE: 1

Aruba 3810M 40G 8 HPE Smart Rate PoE+ 1-slot Switch JL076A
40 RJ-45 autosensing 10/100/1000 PoE+ ports
8 RJ-45 1/2.5/5/XGT PoE+ ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height
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Aruba 3810M 48G PoE+ 4SFP+ 680W Switch JL428A
Includes 1 3810M 48 Port PoE+ Switch (JL074A)
48 RJ-45 autosensing 10/100/1000 PoE+ ports
4 fixed 1000/10000 SFP/SFP+ ports
min=0 \ max=4 SFP/SFP+  Transceivers
1 open stacking module slot
Includes 1 uplink module (JL083A)
Includes 1 680W Power Supply (JL086A, Max 2)
1U - Height

See
Configuration
RULE: 1, 2

PDU Cable NA/MEX/TW/JP JL428A#B2B
C15 PDU Jumper Cord (NA/MEX/TW/JP)  

PDU Cable ROW JL428A#B2C
C15 PDU Jumper Cord (ROW)  

High Volt Power Supply to Wall Power Cord JL428A#B2E
NEMA L6-20P Cord (NA/MEX/JP/TW)  

No Power Cord JL428A#AC3
No Localized Power Cord Selected  

Aruba 3810M 48G PoE+ 4SFP+ 1050W Switch JL429A
Includes 1 3810M 48 Port PoE+ Switch (JL074A)
48 RJ-45 autosensing 10/100/1000 PoE+ ports
4 fixed 1000/10000 SFP/SFP+ ports
min=0 \ max=4 SFP/SFP+  Transceivers
1 open stacking module slot
Includes 1 uplink module (JL083A)
Includes 1 1050W Power Supply (JL087A, Max 2)
1U - Height

See
Configuration
RULE: 1, 2

PDU Cable NA/MEX/TW/JP JL429A#B2B
C15 PDU Jumper Cord (NA/MEX/TW/JP)  

PDU Cable ROW JL429A#B2C
C15 PDU Jumper Cord (ROW)  

High Volt Power Supply to Wall Power Cord JL429A#B2E
NEMA L6-20P Cord (NA/MEX/JP/TW)  

No Power Cord JL429A#AC3
No Localized Power Cord Selected  

Aruba 3810M 24SFP+ 250W Switch JL430A
Includes 1 3810M 16 Port SFP+ Switch (JL075A)
16 fixed 1000/10000 SFP/SFP+ ports
8 port SFP+ ports on the included modules
min=0 \ max=24 SFP/SFP+  Transceivers
1 open stacking module slot
Includes 2 uplink modules (JL083A)
Includes 1 250W Power Supply (JL085A, Max 2)
1U - Height

See
Configuration
RULE: 1, 2

PDU Cable NA/MEX/TW/JP JL430A#B2B
C15 PDU Jumper Cord (NA/MEX/TW/JP)  

PDU Cable ROW JL430A#B2C
C15 PDU Jumper Cord (ROW)  
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High Volt Power Supply to Wall Power Cord JL430A#B2E
NEMA L6-20P Cord (NA/MEX/JP/TW)  

No Power Cord JL430A#AC3
No Localized Power Cord Selected  

Configuration Rules:  
RULE 1 The following Transceivers install into this Switch (For the 1000/10000 SFP+ Ports):  

Aruba 1G SFP LC SX 500m OM2 MMF Transceiver J4858D
Aruba 1G SFP LC LX 10km SMF Transceiver J4859D
Aruba 1G SFP LC LH 70km SMF Transceiver J4860D
Aruba 1G SFP RJ45 T 100m Cat5e Transceiver J8177D
Aruba 100M SFP LC FX 2km MMF Transceiver J9054D
Aruba 10G SFP+ LC SR 300m OM3 MMF Transceiver J9150D
Aruba 10G SFP+ LC LR 10km SMF Transceiver J9151E
Aruba 10G SFP+ LC LRM 220m OM2 MMF Transceiver J9152D
Aruba 10G SFP+ LC ER 40km SMF Transceiver J9153D
Aruba 10G SFP+ to SFP+ 1m Direct Attach Copper Cable J9281D
Aruba 10G SFP+ to SFP+ 3m Direct Attach Copper Cable J9283D
Aruba 10G SFP+ to SFP+ 7m Direct Attach Copper Cable J9285D

   
RULE 2 Localization required on orders without #B2B, #B2C, #B2E options.  

Rack Level Integration CTO Models  
Aruba 3810M 24G 1-slot Switch JL071A

24 RJ-45 autosensing 10/100/1000 ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

See
Configuration
RULE: 10, 11

Aruba 3810M 48G 1-slot Switch JL072A
48 RJ-45 autosensing 10/100/1000 ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

See
Configuration
RULE: 10, 11

Aruba 3810M 24G PoE+ 1-slot Switch JL073A
24 RJ-45 autosensing 10/100/1000 PoE+ ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

See
Configuration
RULE: 10, 11

Aruba 3810M 48G PoE+ 1-slot Switch JL074A
48 RJ-45 autosensing 10/100/1000 PoE+ ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

See
Configuration
RULE: 10, 11
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Aruba 3810M 16SFP+ 2-slot Switch JL075A

16 fixed 1000/10000 SFP/SFP+ ports
min=0 \ max=16 SFP/SFP+  Transceivers
1 open stacking module slot
2 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

See
Configuration
RULE: 1, 10,

11

Aruba 3810M 40G 8 HPE Smart Rate PoE+ 1-slot Switch JL076A
40 RJ-45 autosensing 10/100/1000 PoE+ ports
8 RJ-45 1/2.5/5/XGT PoE+ ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

See
Configuration
RULE: 10, 11

Aruba 3810M 48G PoE+ 4SFP+ 680W Switch JL428A
Includes 1 3810M 48 Port PoE+ Switch (JL074A)
48 RJ-45 autosensing 10/100/1000 PoE+ ports
4 fixed 1000/10000 SFP/SFP+ ports
min=0 \ max=4 SFP/SFP+  Transceivers
1 open stacking module slot
Includes 1 uplink module (JL083A)
Includes 1 680W Power Supply (JL086A, Max 2)
1U - Height

See
Configuration
RULE: 1, 3,

4, 10, 11

PDU Cable NA/MEX/TW/JP JL428A #B2B
C15 PDU Jumper Cord (NA/MEX/TW/JP)  

PDU Cable ROW JL428A #B2C
C15 PDU Jumper Cord (ROW)  

High Volt Power Supply to Wall Power Cord JL428A #B2E
NEMA L6-20P Cord (NA/MEX/JP/TW)  

No Power Cord JL428A#AC3
No Localized Power Cord Selected  

Aruba 3810M 48G PoE+ 4SFP+ 1050W Switch JL429A
Includes 1 3810M 48 Port PoE+ Switch (JL074A)
48 RJ-45 autosensing 10/100/1000 PoE+ ports
4 fixed 1000/10000 SFP/SFP+ ports
min=0 \ max=4 SFP/SFP+  Transceivers
1 open stacking module slot
Includes 1 uplink module (JL083A)
Includes 1 1050W Power Supply (JL087A, Max 2)
1U - Height

See
Configuration
RULE: 1, 3,

4, 10, 11

PDU Cable NA/MEX/TW/JP JL429A #B2B
C15 PDU Jumper Cord (NA/MEX/TW/JP)  

PDU Cable ROW JL429A #B2C
C15 PDU Jumper Cord (ROW)  

High Volt Power Supply to Wall Power Cord JL429A #B2E
NEMA L6-20P Cord (NA/MEX/JP/TW)  

No Power Cord JL429A #AC3
No Localized Power Cord Selected  
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Aruba 3810M 24SFP+ 250W Switch JL430A
Includes 1 3810M 16 Port SFP+ Switch (JL075A)
16 fixed 1000/10000 SFP/SFP+ ports
8 port SFP+ ports on the included modules
min=0 \ max=24 SFP/SFP+  Transceivers
1 open stacking module slot
Includes 2 uplink modules (JL083A)
Includes 1 250W Power Supply (JL085A, Max 2)
1U - Height

See
Configuration
RULE: 1, 3,

4, 10, 11

PDU Cable NA/MEX/TW/JP JL430A #B2B
C15 PDU Jumper Cord (NA/MEX/TW/JP)  

PDU Cable ROW JL430A #B2C
C15 PDU Jumper Cord (ROW)  

High Volt Power Supply to Wall Power Cord JL430A #B2E
NEMA L6-20P Cord (NA/MEX/JP/TW)  

No Power Cord JL430A #AC3
No Localized Power Cord Selected  

Configuration Rules:  
RULE 1 The following Transceivers install into this Switch (For the 1000/10000 SFP+ Ports):  

Aruba 1G SFP LC SX 500m OM2 MMF Transceiver J4858D
Aruba 1G SFP LC LX 10km SMF Transceiver J4859D
Aruba 1G SFP LC LH 70km SMF Transceiver J4860D
Aruba 1G SFP RJ45 T 100m Cat5e Transceiver J8177D
Aruba 100M SFP LC FX 2km MMF Transceiver J9054D
Aruba 10G SFP+ LC SR 300m OM3 MMF Transceiver J9150D
Aruba 10G SFP+ LC LR 10km SMF Transceiver J9151E
Aruba 10G SFP+ LC LRM 220m OM2 MMF Transceiver J9152D
Aruba 10G SFP+ LC ER 40km SMF Transceiver J9153D
Aruba 10G SFP+ to SFP+ 1m Direct Attach Copper Cable J9281D
Aruba 10G SFP+ to SFP+ 3m Direct Attach Copper Cable J9283D
Aruba 10G SFP+ to SFP+ 7m Direct Attach Copper Cable J9285D

RULE 3 Localization required on orders without #B2B, #B2C, #B2E options.  
RULE 4 When Switches are Factory Racked with this power supply, Then #B2B, or

#B2C should be the Defaulted Power Cable option on the Power Supplies.
(See Drop down remark in "Internal Power Supplies"? section.)

 

RULE 10 If switch is 0D1 to Racks, then the J9583A#0D1 is also required.   
RULE 11 If the CTO Switch Chassis needs to be racked, Then the CTO Base Model

needs to integrate (with #0D1) to the HPE Network Rack. 
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Remarks: Drop down under power supply should offer the following options and
results:
Switch/Router/Power Supply to PDU Power Cord -  #B2B in North America,
Mexico, Taiwan, and Japan or #B2C ROW. (Watson Default B2B or B2C
for Rack Level CTO)
Switch/Router/Power Supply to Wall Power Cord - Localized Option
(Watson Default for BTO and Box Level CTO)
High Volt Switch/Router/Power Supply to Wall Power Cord -  #B2E Option.
(Offered only in North America, Mexico, Taiwan, and  Japan)
Watson Blue NOTE: It is recommended that both power supplies match for
full redundancy in the case of a fully populated switch, but not required.
Clic UNB - If an option is ordered with #0D1/#B01, then the switch must
have #0D1 option.

 

 

 

 

 

 

Enter the following menu selections as integrated to the CTO Model X switch above if order is
factory built. 

 

Modules  
Stacking Modules  
 System (std 0 // max=1) User Selection (min 0 / max=1) per Chassis  
Aruba 3810M 4-port Stacking Module JL084A

min=1 \ max=4 Stacking cables See
Configuration

RULE: 1
Configuration Rules:  
RULE 1 One of the following Stacking Cables must be selected:  
  Aruba 3800/3810M 0.5m Stacking Cable J9578A
  Aruba 3800/3810M 1m Stacking Cable J9665A
  Aruba 3800/3810M 3m Stacking Cable J9579A
Uplink Modules  
JL071A, JL072A, JL073A, JL074A, JL076A Only System (std 0 // max 1) User Selection (min 0 / max 1) per
Chassis
JL075A Only System (std 0 // max 2) User Selection (min 0 / max 2) per Chassis  
JL428A, JL429A Only System (std 1 // max 1) User Selection (min 0 / max 0) per Chassis  
JL430A Only System (std 2 // max 2) User Selection (min 0 / max 0) per Chassis  
Aruba 3810M/2930M 1-port QSFP+ 40GbE Module JL078A

min=0 \ max=1 QSFP+  Transceiver See
Configuration

RULE: 1
Aruba 3810M 2QSFP+ 40GbE Module JL079A

min=0 \ max=2 QSFP+  Transceiver See
Configuration
RULE: 1, 3

Aruba 3810M 4 HPE Smart Rate PoE+ Module JL081A
4 x HPE Smart Rate Ports  

Aruba 3810M/2930M 4-port 100M/1G/10G SFP+ MACsec Module JL083A
min=0 \ max=4 SFP/SFP+  Transceivers See

Configuration
RULE: 2
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Configuration Rules:  
RULE 1 The following Transceivers install into this Module: (Use #0D1 or #B01 if switch is

CTO) - if applicable
 

HPE X142 40G QSFP+ MPO SR4 Transceiver JH231A
HPE X142 40G QSFP+ LC LR4 SM Transceiver JH232A
HPE X142 40G QSFP+ MPO eSR4 300M Transceiver JH233A
HPE X242 40G QSFP+ to QSFP+ 1m Direct Attach Copper Cable JH234A

HPE X242 40G QSFP+ to QSFP+ 3m Direct Attach Copper Cable JH235A
HPE X242 40G QSFP+ to QSFP+ 5m Direct Attach Copper Cable JH236A
Aruba 40G QSFP+ LC Bidirectional 150m MMF 2-strand Transceiver JL308A

RULE 2 The following Transceivers install into this Switch (For the 1000/10000 SFP+ Ports):

Aruba 1G SFP LC SX 500m OM2 MMF Transceiver J4858D
Aruba 1G SFP LC LX 10km SMF Transceiver J4859D
Aruba 1G SFP LC LH 70km SMF Transceiver J4860D
Aruba 1G SFP RJ45 T 100m Cat5e Transceiver J8177D
Aruba 100M SFP LC FX 2km MMF Transceiver J9054D
Aruba 10G SFP+ LC SR 300m OM3 MMF Transceiver J9150D
Aruba 10G SFP+ LC LR 10km SMF Transceiver J9151E
Aruba 10G SFP+ LC LRM 220m OM2 MMF Transceiver J9152D
Aruba 10G SFP+ LC ER 40km SMF Transceiver J9153D
Aruba 10G SFP+ to SFP+ 1m Direct Attach Copper Cable J9281D
Aruba 10G SFP+ to SFP+ 3m Direct Attach Copper Cable J9283D
Aruba 10G SFP+ to SFP+ 7m Direct Attach Copper Cable J9285D

RULE 3 This module is only available for the following switches:  
Aruba 3810M 48G 1-slot Switch JL072A
Aruba 3810M 48G PoE+ 1-slot Switch JL074A
Aruba 3810M 40G 8 HPE Smart Rate PoE+ 1-slot Switch JL076A

Remarks: Watson Only Blue NOTE Although all 3810M/2930M Switches are
compatible with the 4 Port HPE Smart Rate module, non PoE switches do
not provide PoE power to the HPE Smart Rate Module.

 

Transceivers  
SFP Transceivers  
HPE X121 1G SFP LC LH Transceiver J4860C
HPE X121 1G SFP LC LX Transceiver J4859C
HPE X121 1G SFP LC SX Transceiver J4858C
HPE X122 1G SFP LC BX-D Transceiver J9142B
HPE X122 1G SFP LC BX-U Transceiver J9143B
HPE X111 100M SFP LC FX Transceiver J9054C
Aruba 100M SFP LC FX 2km MMF Transceiver J9054D
Aruba 1G SFP LC SX 500m OM2 MMF Transceiver J4858D
Aruba 1G SFP LC LX 10km SMF Transceiver J4859D
Aruba 1G SFP LC LH 70km SMF Transceiver J4860D
Aruba 1G SFP RJ45 T 100m Cat5e Transceiver J8177D
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SFP+ Transceivers  
HPE X132 10G SFP+ LC ER Transceiver J9153A
HPE X132 10G SFP+ LC SR Transceiver J9150A
HPE X132 10G SFP+ LC LR Transceiver J9151A
HPE X132 10G SFP+ LC LRM Transceiver J9152A
Aruba 10G SFP+ LC SR 300m OM3 MMF Transceiver J9150D
Aruba 10G SFP+ LC LR 10km SMF Transceiver J9151E
Aruba 10G SFP+ LC LRM 220m OM2 MMF Transceiver J9152D
Aruba 10G SFP+ LC ER 40km SMF Transceiver J9153D
Aruba 10G SFP+ to SFP+ 1m Direct Attach Copper Cable J9281D
Aruba 10G SFP+ to SFP+ 3m Direct Attach Copper Cable J9283D
Aruba 10G SFP+ to SFP+ 7m Direct Attach Copper Cable J9285D
HPE X242 10G SFP+ to SFP+ 1m Direct Attach Copper Cable J9281B
HPE X242 10G SFP+ to SFP+ 3m Direct Attach Copper Cable J9283B
HPE X242 10G SFP+ to SFP+ 7m Direct Attach Copper Cable J9285B
QSFP+ Transceivers  
HPE X142 40G QSFP+ MPO SR4 Transceiver JH231A
HPE X142 40G QSFP+ LC LR4 SM Transceiver JH232A
HPE X142 40G QSFP+ MPO eSR4 300M Transceiver JH233A
Aruba 40G QSFP+ LC Bidirectional 150m MMF 2-strand Transceiver JL308A
HPE X242 40G QSFP+ to QSFP+ 1m Direct Attach Copper Cable JH234A
HPE X242 40G QSFP+ to QSFP+ 3m Direct Attach Copper Cable JH235A
HPE X242 40G QSFP+ to QSFP+ 5m Direct Attach Copper Cable JH236A

Internal Power Supplies  
System (std 0 // max=2) User Selection (min 1 / max=2) per Switch  
For JL428A, JL429A, JL430A System (std 1 // max=2) User Selection (min 0 / max=1) per
Switch

 

Aruba X371 12VDC 250W 100-240VAC Power Supply JL085A
  See

Configuration
RULE: 1, 3, 4

PDU Cable NA/MEX/TW/JP JL085A #B2B
C15 PDU Jumper Cord (NA/MEX/TW/JP)  

PDU Cable ROW JL085A #B2C
C15 PDU Jumper Cord (ROW)  

High Volt Power Supply to Wall Power Cord JL085A #B2E
NEMA L6-20P Cord (NA/MEX/JP/TW)  

No Power Cord JL085A #AC3
No Localized Power Cord Selected  

Aruba X372 54VDC 680W 100-240VAC Power Supply JL086A
  See

Configuration
RULE: 2, 3, 4

PDU Cable NA/MEX/TW/JP JL086A #B2B
C15 PDU Jumper Cord (NA/MEX/TW/JP)  

QuickSpecs Aruba 3810M Switch Series

Configuration Information

DA - 15438   Worldwide QuickSpecs — Version 19 — 3/4/2019 Page  16
Anexo 01 ITEM 06 (0592605)         SEI 0008478-63.2018.6.02.8000 / pg. 4714



PDU Cable ROW JL086A #B2C
C15 PDU Jumper Cord (ROW)  

High Volt Power Supply to Wall Power Cord JL086A #B2E
NEMA L6-20P Cord (NA/MEX/JP/TW)  

   
 
No Power Cord JL086A #AC3

No Localized Power Cord Selected  
Aruba X372 54VDC 1050W 110-240VAC Power Supply JL087A

  See
Configuration
RULE: 2, 3, 4

PDU Cable NA/MEX/TW/JP JL087A #B2B
C15 PDU Jumper Cord (NA/MEX/TW/JP)  

PDU Cable ROW JL087A #B2C
C15 PDU Jumper Cord (ROW)  

High Volt Power Supply to Wall Power Cord JL087A #B2E
NEMA L6-20P Cord (NA/MEX/JP/TW)  

No Power Cord JL087A #AC3
No Localized Power Cord Selected  

Configuration Rules:  
RULE 1 If this Power supply is selected, Then  JL071A, JL072A, JL075A, JL430A 

must be the switch its installed into.
 

     
RULE 2 If this Power supply is selected, Then JL073A, JL074A, JL076A, JL428A,

JL429A must be the switch its installed into.
 

     
RULE 3 Localization required on orders without #B2B or #B2C options.  
     
RULE 4 When Switches are Factory Racked with this power supply, Then #B2B, or

#B2C should be the Defaulted Power Cable option on the Power Supplies.
(See Drop down remark in "Internal Power Supplies"? section.)

 

     
Remarks: Drop down under power supply should offer the following options and

results:
Switch/Router/Power Supply to PDU Power Cord -  #B2B in North America,
Mexico, Taiwan, and Japan or #B2C ROW. (Watson Default B2B or B2C
for Rack Level CTO)
Switch/Router/Power Supply to Wall Power Cord - Localized Option
(Watson Default for BTO and Box Level CTO)
High Volt Switch/Router/Power Supply to Wall Power Cord -  #B2E Option.
(Offered only in North America, Mexico, Taiwan, and  Japan)
No Localized Power Cord Selected - #AC3 Option

 

  Watson Blue NOTE: It is recommended that both power supplies match for
full redundancy in the case of a fully populated switch, but not required.
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Cables  
Stacking Cables  
(std 0 // max 99) User Selection (min 0 // max 99) per switch  
Aruba 3800/3810M 0.5m Stacking Cable J9578A
Aruba 3800/3810M 1m Stacking Cable J9665A
Aruba 3800/3810M 3m Stacking Cable J9579A
Console Cables  
(std 0 // max 99) User Selection (min 0 // max 99) per switch  
Aruba X2C2 RJ45 to DB9 Console Cable JL448A
Multi-Mode Cables  
(std 0 // max 99) User Selection (min 0 // max 99) per switch  
HPE LC to LC Multi-mode OM3 2-Fiber 0.5m 1-Pack Fiber Optic Cable AJ833A
HPE LC to LC Multi-mode OM3 2-Fiber 1.0m 1-Pack Fiber Optic Cable AJ834A
HPE LC to LC Multi-mode OM3 2-Fiber 2.0m 1-Pack Fiber Optic Cable AJ835A
HPE LC to LC Multi-mode OM3 2-Fiber 5.0m 1-Pack Fiber Optic Cable AJ836A
HPE LC to LC Multi-mode OM3 2-Fiber 15.0m 1-Pack Fiber Optic Cable AJ837A
HPE LC to LC Multi-mode OM3 2-Fiber 30.0m 1-Pack Fiber Optic Cable AJ838A
HPE LC to LC Multi-mode OM3 2-Fiber 50.0m 1-Pack Fiber Optic Cable AJ839A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 1m Cable QK732A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 2m Cable QK733A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 5m Cable QK734A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 15m Cable QK735A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 30m Cable QK736A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 50m Cable QK737A

Switch Enclosure Options  
Rack Mount Kit  
(std 0 // max 1) User Selection (min 0 // max 1) per switch  
HPE X410 1U Universal 4-post Rackmount Kit J9583A

  See
Configuration

RULE: 1

Configuration Rules:  
RULE 1 If this switch is factory installed in HPE Network Racks, Then the

J9583A#0D1 is required.
 

Fan Tray  
Aruba 3810 Switch Fan Tray JL088A

This is a Spare Only  
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Aruba 3810M 24G 1-slot Switch (JL071A)

Included
accessories

1 Aruba 3810 Switch Fan Tray (JL088A)

I/O ports and slots 24 RJ-45 autosensing 10/100/1000 ports (IEEE 802.3 Type 10BASE-T, IEEE 802.3u
Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T); Duplex: 10BASE-
T/100BASE-TX: half or full; 1000BASE-T: full only; Ports 1 - 24 support MACSec
Supports a maximum of 4 SFP+ ports or 1 40GbE ports, with optional module

1 open module slot

Supports a maximum of 4 SFP+ ports or 1 40GbE ports, with optional module

Additional ports and
slots

1 stacking module slot

1 RJ-45 serial console port

1 RJ-45 out-of-band management port

1 dual-personality (RJ-45 or USB micro-B)

Power supplies 2 power supply slots
1 minimum power supply required (ordered separately)

Fan tray includes: 1 x JL088A
1 fan tray slot
Switch ships with 1 JL088A fan tray installed. Spares ordered separately.

Physical
characteristics

Dimensions 17.42(w) x 16.98(d) x 1.73(h) in (44.25 x 43.13 x 4.39 cm)
(1U height)

Weight 12.76 lb (5.79 kg)

Memory and
processor

P2020 Dual Core @ 1.2 GHz, 4 GB DDR3 SDRAM, 1 GB SD Card

Dual ARM Coretex A9 @ 1 GHz, 2 GB DDR3 SDRAM; Packet buffer size: 13.5 MB
Internal

Mounting and
enclosure

Mounts in an EIA-standard 19 in. telco rack or equipment cabinet (hardware
included); Horizontal surface mounting only

Performance IPv6 Ready Certified  

1000 Mb Latency < 2.8 µs (FIFO 64-byte packets)

10 Gbps Latency < 1.8 µs (FIFO 64-byte packets)

40 Gbps Latency < 1.5 µs (FIFO 64-byte packets)

Throughput up to 95.2 Mpps (64-byte packets)

Routing/Switching
capacity

160 Gbps

Switch fabric speed 169 Gbps

Routing table size 10000 entries (IPv4), 5000 entries (IPv6)

MAC address table
size

64000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C)
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Nonoperating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 39 dB, Pressure: 22.8 dB

Primary Airflow
Direction

Front-to-side and front-to-rear

 
 
Electrical
Characteristics

Frequency 50/60Hz

Voltage JL085A PSU: 100-127/200-240 VAC 

Current JL085A PSU (Each): 1A/0.5A 

Max/Idle Power
Rating (Switch+ 1
PSU)

JL078A: 4W/3W
JL079A: 7W/3W
JL081A: 4W/3W
JL083A: 11W/4W

Maximum Heat
Dissipation *(Max
Case)

310.31 

PoE Power (Max
Possible)

N/A

Notes Idle power is the actual power consumption of the device with
no ports connected. Maximum power rating and maximum
heat dissipation are the worst case theoretical maximum
numbers provide for planning the infrastructure with fully
loaded PoE (if equipped), 100% traffic, all ports plugged in,
and all modules populated. This is a modular product.
 
*Switch + 2 power supplies + one JL083A Uplink. For most
accurate heat dissipation, idle and max power for any
combination of chassis and accessories, please consult
configurator. 

Safety EN 60950/IEC 60950; UL 60950; UL 60950-1; CAN/CSA 22.2 No. 60950; EN 60825;
CSA 22.2 60950-1; EN62479:2010; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; EN 62368-1, Ed. 2; IEC 60950-1:2005 Ed.2; Am
1:2009+A2:2013; IEC 60825:2007; EN60850-1:2007 / IEC 60825-1: 2007 Class1
Class 1 Laser Products / Laser Klasse 1; UL 62368-1 Ed.2

Emissions FCC Class A; VCCI Class A; EN 55022/CISPR 22 Class A; EN 60950-1:2006
+A11:2009 +A1:2010 +A12:2011+A2:2013

Immunity Generic EN55022: 2010

EN EN55024: 2010

ESD IEC 61000-4-2

Radiated IEC 61000-4-3; 3 V/m

EFT/Burst IEC 61000-4-4; 1.0 kV (power line), 0.5 kV (signal line)

Surge IEC 61000-4-5; 1 kV/2 kV AC

Conducted IEC 61000-4-6; 3 V

Power frequency
magnetic field

IEC 61000-4-8; 1 A/m, 50 or 60 Hz
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Voltage dips and
interruptions

IEC 61000-4-11; >95% reductions, 0.5 period; 30% reduction,
25 periods

Harmonics EN61000-3-2:2006 +A1:2009 +A2:2009 Class A

Flicker EN61000-3-3:2008

Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; Out-of-band
management (RJ-45 Ethernet); In-line and out-of-band; Out-of-band management
(serial RS-232c or micro usb)

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services for
details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
 
 
Aruba 3810M 48G 1-slot Switch (JL072A)

Included
accessories

1 Aruba 3810 Switch Fan Tray (JL088A)

I/O ports and slots 48 RJ-45 autosensing 10/100/1000 ports (IEEE 802.3 Type 10BASE-T, IEEE 802.3u
Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T); Duplex: 10BASE-
T/100BASE-TX: half or full; 1000BASE-T: full only; Ports 1 - 48 support MACSec

1 open module slot

Supports a maximum of 4 SFP+ ports or 2 40GbE ports, with optional module

Additional ports and
slots

1 stacking module slot

1 RJ-45 serial console port

1 RJ-45 out-of-band management port

1 dual-personality (RJ-45 or USB micro-B)

Power supplies 2 power supply slots
1 minimum power supply required (ordered separately)

Fan tray includes: 1 x JL088A
1 fan tray slot
Switch ships with 1 JL088A fan tray installed. Spares ordered separately.

Physical
characteristics

Dimensions 17.42(w) x 16.98(d) x 1.73(h) in (44.25 x 43.13 x 4.39 cm)
(1U height)

Weight 13.20 lb (5.99 kg)

Memory and
processor

P2020 Dual Core @ 1.2 GHz, 4 GB DDR3 SDRAM, 1 GB SD Card

Dual ARM Coretex A9 @ 1 GHz, 2 GB DDR3 SDRAM; Packet buffer size: 13.5 MB
Internal

Mounting and
enclosure

Mounts in an EIA-standard 19 in. telco rack or equipment cabinet (hardware
included); Horizontal surface mounting only

Performance IPv6 Ready Certified  

1000 Mb Latency < 2.8 µs (FIFO 64-byte packets)

10 Gbps Latency < 1.8 µs (FIFO 64-byte packets)

40 Gbps Latency < 1.5 µs (FIFO 64-byte packets)

Throughput up to 190.5 Mpps (64-byte packets)
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Routing/Switching
capacity

320 Gbps

Switch fabric speed 338 Gbps

Routing table size 10000 entries (IPv4), 5000 entries (IPv6)

MAC address table
size

64000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Nonoperating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 38 dB, Pressure: 21.8 dB

Primary Airflow
Direction

Front-to-side and front-to-rear

 
 
 
Electrical
Characteristics

Frequency 50/60Hz

Voltage JL085A PSU: 100-127/200-240 VAC

Current JL085A PSU (Each): 1A/0.5A

Max/Idle Power
Rating (Switch+ 1
PSU)

95W/78W

Second PSU Power
Adder

10W

Max/Idle Uplink
Power Adder

JL078A: 4W/3W
JL079A: 7W/3W
JL081A: 4W/3W
JL083A: 11W/4W

Maximum Heat
Dissipation *(Max
Case)

395.56

PoE Power (Max
Possible)

N/A

Notes Idle power is the actual power consumption of the device with
no ports connected. Maximum power rating and maximum
heat dissipation are the worst case theoretical maximum
numbers provide for planning the infrastructure with fully
loaded PoE (if equipped), 100% traffic, all ports plugged in,
and all modules populated. This is a modular product.
 
*Switch + 2 power supplies + one JL083A Uplink. For most
accurate heat dissipation, idle and max power for any
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combination of chassis and accessories, please consult
configurator.

Safety EN 60950/IEC 60950; UL 60950; UL 60950-1; CAN/CSA 22.2 No. 60950; EN 60825;
CSA 22.2 60950-1; EN62479:2010; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; EN 62368-1, Ed. 2; IEC 60950-1:2005 Ed.2; Am
1:2009+A2:2013; IEC 60825:2007; EN60850-1:2007 / IEC 60825-1: 2007 Class1
Class 1 Laser Products / Laser Klasse 1; UL 62368-1 Ed.2

Emissions FCC Class A; VCCI Class A; EN 55022/CISPR 22 Class A; EN 60950-1:2006
+A11:2009 +A1:2010 +A12:2011+A2:2013

Immunity Generic EN55022: 2010

EN EN55024: 2010

ESD IEC 61000-4-2

Radiated IEC 61000-4-3; 3 V/m

EFT/Burst IEC 61000-4-4; 1.0 kV (power line), 0.5 kV (signal line)

Surge IEC 61000-4-5; 1 kV/2 kV AC

Conducted IEC 61000-4-6; 3 V

Power frequency
magnetic field

IEC 61000-4-8; 1 A/m, 50 or 60 Hz

Voltage dips and
interruptions

IEC 61000-4-11; >95% reductions, 0.5 period; 30% reduction,
25 periods

Harmonics EN61000-3-2:2006 +A1:2009 +A2:2009 Class A

Flicker EN61000-3-3:2008

 
 
 
Management Aruba AirWave Network Management; IMC - Intelligent Management Center;

Command-line interface; Web browser; Configuration menu; Out-of-band
management (RJ-45 Ethernet); In-line and out-of-band; Out-of-band management
(serial RS-232c or micro usb)

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services for
details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

Aruba 3810M 24G PoE+ 1-slot Switch (JL073A)

Included
accessories

1 Aruba 3810 Switch Fan Tray (JL088A)

I/O ports and slots 24 RJ-45 autosensing 10/100/1000 PoE+ ports (IEEE 802.3 Type 10BASE-T, IEEE
802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T, IEEE 802.3at PoE+);
Duplex: 10BASE-T/100BASE-TX: half or full; 1000BASE-T: full only; Ports 1 - 24
support MACSec

1 open module slot

Supports a maximum of 4 SFP+ ports or 1 40GbE ports, with optional module

Additional ports and
slots

1 stacking module slot

1 RJ-45 serial console port

1 RJ-45 out-of-band management port

1 dual-personality (RJ-45 or USB micro-B)
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Power supplies 2 power supply slots
1 minimum power supply required (ordered separately)

Fan tray includes: 1 x JL088A
1 fan tray slot
Switch ships with 1 JL088A fan tray installed. Spares ordered separately

Physical
characteristics

Dimensions 17.42(w) x 16.98(d) x 1.73(h) in (44.25 x 43.13 x 4.39 cm) (1U
height)

Weight 13.02 lb (5.91 kg)

Memory and
processor

P2020 Dual Core @ 1.2 GHz, 4 GB DDR3 SDRAM, 1 GB SD Card

Dual ARM Coretex A9 @ 1 GHz, 2 GB DDR3 SDRAM; Packet buffer size: 13.5 MB
Internal

Mounting and
enclosure

Mounts in an EIA-standard 19 in. telco rack or equipment cabinet (hardware
included); Horizontal surface mounting only

Performance IPv6 Ready Certified  

1000 Mb Latency < 2.8 µs (FIFO 64-byte packets)

10 Gbps Latency < 1.8 µs (FIFO 64-byte packets)

40 Gbps Latency < 1.5 µs (FIFO 64-byte packets)

Throughput up to 95.2 Mpps (64-byte packets)

Routing/Switching
capacity

160 Gbps

Switch fabric speed 169 Gbps

Routing table size 10000 entries (IPv4), 5000 entries (IPv6)

MAC address table
size

64000 entries

 
Environment Operating

temperature
32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Nonoperating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 44 dB, Pressure: 27.6 dB

Primary Airflow
Direction

Front-to-side and front-to-rear

Electrical
Characteristics

Frequency 50/60Hz

Voltage JL086A PSU: 100-127/200-240 VAC
JL087A PSU: 110-127/200-240 VAC

Current JL086A PSU (Each): 5A/2.5A
JL087A PSU (Each): 8.5A/5A

Max/Idle Power
Rating (Switch+ 1
PSU)

95W/82W
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Second PSU Power
Adder

10W

Max/Idle Uplink
Power Adder

JL078A: 4W/3W
JL079A: 7W/3W
JL081A: 4W/3W
JL083A: 11W/4W

Maximum Heat
Dissipation *(Max
Case)

395.56

PoE Power (Max
Possible)

840W

Notes Idle power is the actual power consumption of the device with
no ports connected. Maximum power rating and maximum
heat dissipation are the worst case theoretical maximum
numbers provide for planning the infrastructure with fully
loaded PoE (if equipped), 100% traffic, all ports plugged in,
and all modules populated. This is a modular product.
 
*Switch + 2 power supplies + one JL083A Uplink. For most
accurate heat dissipation, idle and max power for any
combination of chassis and accessories, please consult
configurator.

Safety EN 60950/IEC 60950; UL 60950; UL 60950-1; CAN/CSA 22.2 No. 60950; EN 60825;
CSA 22.2 60950-1; EN62479:2010; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; EN 62368-1, Ed. 2; IEC 60950-1:2005 Ed.2; Am
1:2009+A2:2013; IEC 60825:2007; EN60850-1:2007 / IEC 60825-1: 2007 Class1
Class 1 Laser Products / Laser Klasse 1; UL 62368-1 Ed.2

Emissions FCC Class A; VCCI Class A; EN 55022/CISPR 22 Class A; EN 60950-1:2006
+A11:2009 +A1:2010 +A12:2011+A2:2013

 
 
 
Immunity Generic EN55022: 2010

EN EN55024: 2010

ESD IEC 61000-4-2

Radiated IEC 61000-4-3; 3 V/m

EFT/Burst IEC 61000-4-4; 1.0 kV (power line), 0.5 kV (signal line)

Surge IEC 61000-4-5; 1 kV/2 kV AC

Conducted IEC 61000-4-6; 3 V

Power frequency
magnetic field

IEC 61000-4-8; 1 A/m, 50 or 60 Hz

Voltage dips and
interruptions

IEC 61000-4-11; >95% reductions, 0.5 period; 30% reduction,
25 periods

Harmonics EN61000-3-2:2006 +A1:2009 +A2:2009 Class A

Flicker EN61000-3-3:2008
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Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; Out-of-band
management (RJ-45 Ethernet); In-line and out-of-band; Out-of-band management
(serial RS-232c or micro usb)

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services for
details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

Aruba 3810M 48G PoE+ 1-slot Switch (JL074A)

Included
accessories

1 Aruba 3810 Switch Fan Tray (JL088A)

I/O ports and slots 48 RJ-45 autosensing 10/100/1000 PoE+ ports (IEEE 802.3 Type 10BASE-T, IEEE
802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T, IEEE 802.3at PoE+);
Duplex: 10BASE-T/100BASE-TX: half or full; 1000BASE-T: full only; Ports 1 - 48
support MACSec

1 open module slot

Supports a maximum of 4 SFP+ ports or 2 40GbE ports, with optional module

Additional ports and
slots

1 stacking module slot

1 RJ-45 serial console port

1 RJ-45 out-of-band management port

1 dual-personality (RJ-45 or USB micro-B)

Power supplies 2 power supply slots
1 minimum power supply required (ordered separately)

Fan tray includes: 1 x JL088A
1 fan tray slot
Switch ships with 1 JL088A fan tray installed. Spares ordered separately.

Physical
characteristics

Dimensions 17.42(w) x 16.98(d) x 1.73(h) in (44.25 x 43.13 x 4.39 cm) (1U
height)

Weight 13.62 lb (6.18 kg)

Memory and
processor

P2020 Dual Core @ 1.2 GHz, 4 GB DDR3 SDRAM, 1 GB SD Card

Dual ARM Coretex A9 @ 1 GHz, 2 GB DDR3 SDRAM; Packet buffer size: 13.5 MB
Internal

Mounting and
enclosure

Mounts in an EIA-standard 19 in. telco rack or equipment cabinet (hardware
included); Horizontal surface mounting only

 
 
 
Performance IPv6 Ready Certified  

1000 Mb Latency < 2.8 µs (FIFO 64-byte packets)

10 Gbps Latency < 1.8 µs (FIFO 64-byte packets)

40 Gbps Latency < 1.5 µs (FIFO 64-byte packets)

Throughput up to 190.5 Mpps (64-byte packets)

Routing/Switching
capacity

320 Gbps

Switch fabric speed 338 Gbps

Routing table size 10000 entries (IPv4), 5000 entries (IPv6)
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MAC address table
size

64000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Nonoperating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 47 dB, Pressure: 29.4 dB

 
Primary Airflow
Direction

Front-to-side and front-to-rear

Electrical
Characteristics

Frequency 50/60Hz

Voltage JL086A PSU: 100-127/200-240 VAC
JL087A PSU: 110-127/200-240 VAC

Current JL086A PSU (Each): 5A/2.5A
JL087A PSU (Each): 8.5A/5A

Max/Idle Power
Rating (Switch+ 1
PSU)

135W/103W

Second PSU Power
Adder

10W

Max/Idle Uplink
Power Adder

JL078A: 4W/3W
JL079A: 7W/3W
JL081A: 4W/3W
JL083A: 11W/4W

Maximum Heat
Dissipation *(Max
Case)

531.96

PoE Power (Max
Possible)

1440W

Notes Idle power is the actual power consumption of the device with
no ports connected. Maximum power rating and maximum
heat dissipation are the worst case theoretical maximum
numbers provide for planning the infrastructure with fully
loaded PoE (if equipped), 100% traffic, all ports plugged in,
and all modules populated. This is a modular product.
 
*Switch + 2 power supplies + one JL083A Uplink. For most
accurate heat dissipation, idle and max power for any
combination of chassis and accessories, please consult
configurator.
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Safety EN 60950/IEC 60950; UL 60950; UL 60950-1; CAN/CSA 22.2 No. 60950; EN 60825;
CSA 22.2 60950-1; EN62479:2010; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; EN 62368-1, Ed. 2; IEC 60950-1:2005 Ed.2; Am
1:2009+A2:2013; IEC 60825:2007; EN60850-1:2007 / IEC 60825-1: 2007 Class1
Class 1 Laser Products / Laser Klasse 1; UL 62368-1 Ed.2

Emissions FCC Class A; VCCI Class A; EN 55022/CISPR 22 Class A; EN 60950-1:2006
+A11:2009 +A1:2010 +A12:2011+A2:2013

Immunity Generic EN55022: 2010

EN EN55024: 2010

ESD IEC 61000-4-2

Radiated IEC 61000-4-3; 3 V/m

EFT/Burst IEC 61000-4-4; 1.0 kV (power line), 0.5 kV (signal line)

Surge IEC 61000-4-5; 1 kV/2 kV AC

Conducted IEC 61000-4-6; 3 V

Power frequency
magnetic field

IEC 61000-4-8; 1 A/m, 50 or 60 Hz

Voltage dips and
interruptions

IEC 61000-4-11; >95% reductions, 0.5 period; 30% reduction,
25 periods

Harmonics EN61000-3-2:2006 +A1:2009 +A2:2009 Class A

Flicker EN61000-3-3:2008

Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; Out-of-band
management (RJ-45 Ethernet); In-line and out-of-band; Out-of-band management
(serial RS-232c or micro usb)

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services for
details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

Aruba 3810M 16SFP+ 2-slot Switch (JL075A)

Included
accessories

1 Aruba 3810 Switch Fan Tray (JL088A)

I/O ports and slots 16 SFP+ fixed 1000/10000 SFP+ ports; Duplex: 100BASE-TX: half or full;
1000BASE-T: full only; Ports 1 - 16 support MACSec

2 open module slots

Supports a maximum of 8 SFP+ ports or 2 40GbE ports, with optional module

Additional ports and
slots

1 stacking module slot

1 RJ-45 serial console port

1 RJ-45 out-of-band management port

1 dual-personality (RJ-45 or USB micro-B)

Power supplies 2 power supply slots
1 minimum power supply required (ordered separately)

Fan tray includes: 1 x JL088A
1 fan tray slot
Switch ships with 1 JL088A fan tray installed. Spares ordered separately.
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Physical
characteristics

Dimensions 17.42(w) x 16.98(d) x 1.73(h) in (44.25 x 43.13 x 4.39 cm) (1U
height)

Weight 13.28 lb (6.02 kg)

Memory and
processor

P2020 Dual Core @ 1.2 GHz, 4 GB DDR3 SDRAM, 1 GB SD Card

Dual ARM Coretex A9 @ 1 GHz, 2 GB DDR3 SDRAM; Packet buffer size: 13.5 MB
Internal

 
 
Mounting and
enclosure

Mounts in an EIA-standard 19 in. telco rack or equipment cabinet (hardware
included); Horizontal surface mounting only

Performance IPv6 Ready Certified  

1000 Mb Latency < 2.8 µs (FIFO 64-byte packets)

10 Gbps Latency < 1.8 µs (FIFO 64-byte packets)

40 Gbps Latency < 1.5 µs (FIFO 64-byte packets)

Throughput up to 285.7 Mpps (64-byte packets)

Routing/Switching
capacity

480 Gbps

Switch fabric speed 508 Gbps

Routing table size 10000 entries (IPv4), 5000 entries (IPv6)

MAC address table
size

64000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Nonoperating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 39 dB, Pressure: 22.3 dB

 
Primary Airflow
Direction

Front-to-side and front-to-rear

Electrical
Characteristics

Frequency 50/60Hz

Voltage JL085A PSU: 100-127/200-240 VAC

Current JL085A PSU (Each): 1A/0.5A

Max/Idle Power
Rating (Switch+ 1
PSU)

120W/95W

Second PSU Power
Adder

10W

Max/Idle Uplink
Power Adder

JL078A: 4W/3W
JL079A: 7W/3W
JL081A: 4W/3W
JL083A: 11W/4W
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Maximum Heat
Dissipation *(Max
Case)

480.81

PoE Power (Max
Possible)

N/A

Notes Idle power is the actual power consumption of the device with
no ports connected. Maximum power rating and maximum
heat dissipation are the worst case theoretical maximum
numbers provide for planning the infrastructure with fully
loaded PoE (if equipped), 100% traffic, all ports plugged in,
and all modules populated. This is a modular product.
 
*Switch + 2 power supplies + one JL083A Uplink. For most
accurate heat dissipation, idle and max power for any
combination of chassis and accessories, please consult
configurator

 
Safety EN 60950/IEC 60950; UL 60950; UL 60950-1; CAN/CSA 22.2 No. 60950; EN 60825;

CSA 22.2 60950-1; EN62479:2010; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; EN 62368-1, Ed. 2; IEC 60950-1:2005 Ed.2; Am
1:2009+A2:2013; IEC 60825:2007; EN60850-1:2007 / IEC 60825-1: 2007 Class1
Class 1 Laser Products / Laser Klasse 1; UL 62368-1 Ed.2

Emissions FCC Class A; VCCI Class A; EN 55022/CISPR 22 Class A; EN 60950-1:2006
+A11:2009 +A1:2010 +A12:2011+A2:2013

Immunity Generic EN55022: 2010

EN EN55024: 2010

ESD IEC 61000-4-2

Radiated IEC 61000-4-3; 3 V/m

EFT/Burst IEC 61000-4-4; 1.0 kV (power line), 0.5 kV (signal line)

Surge IEC 61000-4-5; 1 kV/2 kV AC

Conducted IEC 61000-4-6; 3 V

Power frequency
magnetic field

IEC 61000-4-8; 1 A/m, 50 or 60 Hz

Voltage dips and
interruptions

IEC 61000-4-11; >95% reductions, 0.5 period; 30% reduction,
25 periods

Harmonics EN61000-3-2:2006 +A1:2009 +A2:2009 Class A

Flicker EN61000-3-3:2008

Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; Out-of-band
management (RJ-45 Ethernet); In-line and out-of-band; Out-of-band management
(serial RS-232c or micro usb)

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services for
details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

Aruba 3810M 40G 8 HPE Smart Rate PoE+ 1-slot Switch (JL076A)
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Included
accessories

1 Aruba 3810 Switch Fan Tray (JL088A)

I/O ports and slots 40 RJ-45 autosensing 10/100/1000 PoE+ ports (IEEE 802.3 Type 10BASE-T, IEEE
802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T, IEEE 802.3at PoE+);
Duplex: 10BASE-T/100BASE-TX: half or full; 1000BASE-T: full only; Ports 1 - 40
support MACSec

8 RJ-45 HPE Smart Rate Multi-Gigabit ports; Ports 1 - 8 support MACSec

1 open module slot

Supports a maximum of 4 SFP+ ports or 2 40GbE ports, with optional module

Additional ports and
slots

1 stacking module slot

1 RJ-45 serial console port

1 RJ-45 out-of-band management port

1 dual-personality (RJ-45 or USB micro-B)

Power supplies 2 power supply slots
1 minimum power supply required (ordered separately)

Fan tray includes: 1 x JL088A
1 fan tray slot
Switch ships with 1 JL088A fan tray installed. Spares ordered separately.

 

Physical
characteristics

Dimensions 17.42(w) x 16.98(d) x 1.73(h) in (44.25 x 43.13 x 4.39 cm)
(1U height)

 

Weight 13.61 lb (6.17 kg)  

 
 
 
Memory and
processor

P2020 Dual Core @ 1.2 GHz, 4 GB DDR3 SDRAM, 1 GB SD Card

Dual ARM Coretex A9 @ 1 GHz, 2 GB DDR3 SDRAM; Packet buffer size: 13.5 MB
Internal

Mounting and
enclosure

Mounts in an EIA-standard 19 in. telco rack or equipment cabinet (hardware
included); Horizontal surface mounting only

Performance IPv6 Ready Certified  

1000 Mb Latency < 2.8 µs (FIFO 64-byte packets)

10 Gbps Latency < 1.8 µs (FIFO 64-byte packets)

40 Gbps Latency < 1.5 µs (FIFO 64-byte packets)

Throughput up to 273.8 Mpps (64-byte packets)

Routing/Switching
capacity

480 Gbps

Switch fabric speed 508 Gbps

Routing table size 10000 entries (IPv4), 5000 entries (IPv6)

MAC address table
size

64000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C)
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Nonoperating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 49 dB, Pressure: 31.5 dB

 
Primary Airflow
Direction

Front-to-side and front-to-rear

 
 
 
Electrical
Characteristics

Frequency 50/60Hz

Voltage JL086A PSU: 100-127/200-240 VAC
JL087A PSU: 110-127/200-240 VAC

Current JL086A PSU (Each): 5A/2.5A
JL087A PSU (Each): 8.5A/5A

Max/Idle Power
Rating (Switch+ 1
PSU)

190W/158W

Second PSU Power
Adder

10W

Max/Idle Uplink
Power Adder

JL078A: 4W/3W
JL079A: 7W/3W
JL081A: 4W/3W
JL083A: 11W/4W

Maximum Heat
Dissipation *(Max
Case)

719.51

PoE Power (Max
Possible)

1440W

Notes Idle power is the actual power consumption of the device with
no ports connected. Maximum power rating and maximum
heat dissipation are the worst case theoretical maximum
numbers provide for planning the infrastructure with fully
loaded PoE (if equipped), 100% traffic, all ports plugged in,
and all modules populated. This is a modular product.
 
*Switch + 2 power supplies + one JL083A Uplink. For most
accurate heat dissipation, idle and max power for any
combination of chassis and accessories, please consult
configurator.

Safety EN 60950/IEC 60950; UL 60950; UL 60950-1; CAN/CSA 22.2 No. 60950; EN 60825;
CSA 22.2 60950-1; EN62479:2010; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; EN 62368-1, Ed. 2; IEC 60950-1:2005 Ed.2; Am
1:2009+A2:2013; IEC 60825:2007; EN60850-1:2007 / IEC 60825-1: 2007 Class1
Class 1 Laser Products / Laser Klasse 1; UL 62368-1 Ed.2

Emissions FCC Class A; VCCI Class A; EN 55022/CISPR 22 Class A; EN 60950-1:2006
+A11:2009 +A1:2010 +A12:2011+A2:2013

Immunity Generic EN55022: 2010

EN EN55024: 2010

ESD IEC 61000-4-2

QuickSpecs Aruba 3810M Switch Series

Technical Specifications

DA - 15438   Worldwide QuickSpecs — Version 19 — 3/4/2019 Page  32
Anexo 01 ITEM 06 (0592605)         SEI 0008478-63.2018.6.02.8000 / pg. 4730



Radiated IEC 61000-4-3; 3 V/m

EFT/Burst IEC 61000-4-4; 1.0 kV (power line), 0.5 kV (signal line)

Surge IEC 61000-4-5; 1 kV/2 kV AC

Conducted IEC 61000-4-6; 3 V

Power frequency
magnetic field

IEC 61000-4-8; 1 A/m, 50 or 60 Hz

Voltage dips and
interruptions

IEC 61000-4-11; >95% reductions, 0.5 period; 30% reduction,
25 periods

Harmonics EN61000-3-2:2006 +A1:2009 +A2:2009 Class A

Flicker EN61000-3-3:2008

 
 
 
Management Aruba AirWave Network Management; IMC - Intelligent Management Center;

Command-line interface; Web browser; Configuration menu; Out-of-band
management (RJ-45 Ethernet); In-line and out-of-band; Out-of-band management
(serial RS-232c or micro usb)

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services for
details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
Aruba 3810M 48G PoE+ 4SFP+ 680W Switch (JL428A)

Included
accessories

1 Aruba 3810M 48G PoE+ 1-slot Switch (JL074A)
1 Aruba X372 54VDC 680W Power Supply (JL086A)
1 Aruba 3810M 4SFP+ Module (JL083A)
1 Aruba 3810 Switch Fan Tray (JL088A)

I/O ports and slots 48 RJ-45 autosensing 10/100/1000 PoE+ ports (IEEE 802.3 Type 10BASE-T, IEEE
802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T, IEEE 802.3at PoE+);
Duplex: 10BASE-T/100BASE- TX: half or full; 1000BASE-T: full only; Ports 1 - 48
support MACSec

1 open module slot

Supports a maximum of 4 SFP+ ports or 2 40GbE ports, with optional module

Additional ports and
slots

1 stacking module slot
1 RJ-45 serial console port
1 RJ-45 out-of-band management port
1 dual-personality (RJ-45 or USB micro-B)

Power supplies 2 power supply slots
1 minimum power supply required (ordered separately)

Fan tray includes: 1 x JL088A
1 fan tray slot
Switch ships with 1 JL088A fan tray installed. Spares ordered separately.

Physical
characteristics

Dimensions 17.42(w) x 16.98(d) x 1.73(h) in (44.25 x 43.13 x 4.39 cm) (1U
height)

Weight 13.62 lb (6.18 kg)
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Memory and
processor

P2020 Dual Core @ 1.2 GHz, 4 GB DDR3 SDRAM, 1 GB SD Card

Dual ARM Coretex A9 @ 1 GHz, 2 GB DDR3 SDRAM; Packet buffer size: 13.5 MB
Internal

Mounting and
enclosure

Mounts in an EIA-standard 19 in. telco rack or equipment cabinet (hardware
included); Horizontal surface mounting only

Performance IPv6 Ready Certified  

1000 Mb Latency < 2.8 µs (FIFO 64-byte packets)

10 Gbps Latency < 1.8 µs (FIFO 64-byte packets)

40 Gbps Latency < 1.5 µs (FIFO 64-byte packets)

Throughput up to 190.5 Mpps (64-byte packets)

Routing/Switching
capacity

320 Gbps

Switch fabric speed 338 Gbps

Routing table size 10000 entries (IPv4), 5000 entries (IPv6)

MAC address table
size

64000 entries

 
 
 
Environment Operating

temperature
32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Nonoperating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 47 dB, Pressure: 29.4 dB

Primary Airflow
Direction

Front-to-side and front-to-rear

Electrical
Characteristics

Frequency 50/60Hz

Voltage JL085A PSU: 100-127/200-240 VAC

Current JL085A PSU (Each): 1A/0.5A

Max/Idle Power
Rating (Switch+ 1
PSU)

70W/55W

Second PSU Power
Adder

10W 

Max/Idle Uplink
Power Adder

JL078A: 4W/3W
JL079A: 7W/3W
JL081A: 4W/3W
JL083A: 11W/4W 
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Maximum Heat
Dissipation *(Max
Case)

310.31

PoE Power (Max
Possible)

N/A

Notes Idle power is the actual power consumption of the device with
no ports connected. Maximum power rating and maximum
heat dissipation are the worst case theoretical maximum
numbers provide for planning the infrastructure with fully
loaded PoE (if equipped), 100% traffic, all ports plugged in,
and all modules populated. This is a modular product.
 
*Switch + 2 power supplies + one JL083A Uplink. For most
accurate heat dissipation, idle and max power for any
combination of chassis and accessories, please consult
configurator.

Safety EN 60950/IEC 60950; UL 60950; UL 60950-1; CAN/CSA 22.2 No. 60950; EN 60825;
CSA 22.2 60950-1; EN62479:2010; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; EN 62368-1, Ed. 2; IEC 60950-1:2005 Ed.2; Am
1:2009+A2:2013; IEC 60825:2007; EN60850-1:2007 / IEC 60825-1: 2007 Class1
Class 1 Laser Products / Laser Klasse 1; UL 62368-1 Ed.2

Emissions FCC Class A; VCCI Class A; EN 55022/CISPR 22 Class A; EN 60950-1:2006
+A11:2009 +A1:2010 +A12:2011+A2:2013

 
 
 
Immunity Generic EN55022: 2010

EN EN55024: 2010

ESD IEC 61000-4-2

Radiated IEC 61000-4-3; 3 V/m

EFT/Burst IEC 61000-4-4; 1.0 kV (power line), 0.5 kV (signal line)

Surge IEC 61000-4-5; 1 kV/2 kV AC

Conducted IEC 61000-4-6; 3 V

Power frequency
magnetic field

IEC 61000-4-8; 1 A/m, 50 or 60 Hz

Voltage dips and
interruptions

IEC 61000-4-11; >95% reductions, 0.5 period; 30% reduction,
25 periods

Harmonics EN61000-3-2:2006 +A1:2009 +A2:2009 Class A

Flicker EN61000-3-3:2008

Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; Out-of-band
management (RJ-45 Ethernet); In-line and out-of- band; Out-of-band management
(serial RS-232c or micro usb)

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services for
details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.
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Aruba 3810M 48G PoE+ 4SFP+ 1050W Switch (JL429A)

Included
accessories

1 Aruba 3810M 48G PoE+ 1-slot Switch (JL074A)
1 Aruba X372 54VDC 1050W Power Supply (JL087A)
1 Aruba 3810M 4SFP+ Module (JL083A)
1 Aruba 3810 Switch Fan Tray (JL088A)

I/O ports and slots 48 RJ-45 autosensing 10/100/1000 PoE+ ports (IEEE 802.3 Type 10BASE-T, IEEE
802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T, IEEE 802.3at PoE+);
Duplex: 10BASE-T/100BASE- TX: half or full; 1000BASE-T: full only; Ports 1 - 48
support MACSec

1 open module slot

Supports a maximum of 4 SFP+ ports or 2 40GbE ports, with optional module

Additional ports and
slots

1 stacking module slot
1 RJ-45 serial console port
1 RJ-45 out-of-band management port
1 dual-personality (RJ-45 or USB micro-B)

Power supplies 2 power supply slots
1 minimum power supply required (ordered separately)

Fan tray includes: 1 x JL088A 1 fan tray slot
Switch ships with 1 JL088A fan tray installed. Spares ordered separately.

Physical
characteristics

Dimensions 17.42(w) x 16.98(d) x 1.73(h) in (44.25 x 43.13 x 4.39 cm)
(1U height)

Weight 13.62 lb (6.18 kg)

Memory and
processor

P2020 Dual Core @ 1.2 GHz, 4 GB DDR3 SDRAM, 1 GB SD Card

Dual ARM Coretex A9 @ 1 GHz, 2 GB DDR3 SDRAM; Packet buffer size: 13.5 MB
Internal

Mounting and
enclosure

Mounts in an EIA-standard 19 in. telco rack or equipment cabinet (hardware
included); Horizontal surface mounting only

Performance IPv6 Ready Certified  

1000 Mb Latency < 2.8 µs (FIFO 64-byte packets)

10 Gbps Latency < 1.8 µs (FIFO 64-byte packets)

40 Gbps Latency < 1.5 µs (FIFO 64-byte packets)

Throughput up to 190.5 Mpps (64-byte packets)

Routing/Switching
capacity

320 Gbps

Switch fabric speed 338 Gbps

Routing table size 10000 entries (IPv4), 5000 entries (IPv6)

MAC address table
size

64000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C)
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Nonoperating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 47 dB, Pressure: 29.4 dB

 
Primary Airflow
Direction

Front-to-side and front-to-rear

 
 
 
Electrical
Characteristics

Frequency 50/60Hz

Voltage JL085A PSU: 100-127/200-240 VAC 

Current JL085A PSU (Each): 1A/0.5A

Max/Idle Power
Rating (Switch+ 1
PSU)

70W/55W

Second PSU Power
Adder

10W 

Max/Idle Uplink
Power Adder

JL078A: 4W/3W
JL079A: 7W/3W
JL081A: 4W/3W
JL083A: 11W/4W 

Maximum Heat
Dissipation *(Max
Case)

310.31 

PoE Power (Max
Possible)

N/A

Notes Idle power is the actual power consumption of the device with
no ports connected. Maximum power rating and maximum
heat dissipation are the worst case theoretical maximum
numbers provide for planning the infrastructure with fully
loaded PoE (if equipped), 100% traffic, all ports plugged in,
and all modules populated. This is a modular product.
 
*Switch + 2 power supplies + one JL083A Uplink. For most
accurate heat dissipation, idle and max power for any
combination of chassis and accessories, please consult
configurator. 

Safety EN 60950/IEC 60950; UL 60950; UL 60950-1; CAN/CSA 22.2 No. 60950; EN 60825;
CSA 22.2 60950-1; EN62479:2010; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; EN 62368-1, Ed. 2; IEC 60950-1:2005 Ed.2; Am
1:2009+A2:2013; IEC 60825:2007; EN60850-1:2007 / IEC 60825-1: 2007 Class1
Class 1 Laser Products / Laser Klasse 1; UL 62368-1 Ed.2

Emissions FCC Class A; VCCI Class A; EN 55022/CISPR 22 Class A; EN 60950-1:2006
+A11:2009 +A1:2010 +A12:2011+A2:2013

Immunity Generic EN55022: 2010

EN EN55024: 2010

ESD IEC 61000-4-2

Radiated IEC 61000-4-3; 3 V/m
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EFT/Burst IEC 61000-4-4; 1.0 kV (power line), 0.5 kV (signal line)

Surge IEC 61000-4-5; 1 kV/2 kV AC

Conducted IEC 61000-4-6; 3 V

Power frequency
magnetic field

IEC 61000-4-8; 1 A/m, 50 or 60 Hz

Voltage dips and
interruptions

IEC 61000-4-11; >95% reductions, 0.5 period; 30% reduction,
25 periods

Harmonics EN61000-3-2:2006 +A1:2009 +A2:2009 Class A

Flicker EN61000-3-3:2008

 
 
 
Management Aruba AirWave Network Management; IMC - Intelligent Management Center;

Command-line interface; Web browser; Configuration menu; Out-of-band
management (RJ-45 Ethernet); In-line and out-of- band; Out-of-band management
(serial RS-232c or micro usb)

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services for
details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
Aruba 3810M 24SFP+ 250W Switch (JL430A)

Included
accessories

1 Aruba 3810M 16SFP+ 2-slot Switch (JL075A)
1 Aruba X371 12VDC 250W Power Supply (JL085A)
2 Aruba 3810M 4SFP+ Module (JL083A)
1 Aruba 3810 Switch Fan Tray (JL088A)

I/O ports and slots 16 SFP+ fixed 1000/10000 SFP+ ports; Duplex: 100BASE-TX: half or full;
1000BASE-T: full only; Ports

1 - 16 support MACSec

2 open module slots

Supports a maximum of 8 SFP+ ports or 2 40GbE ports, with optional module

Additional ports and
slots

1 stacking module slot
1 RJ-45 serial console port
1 RJ-45 out-of-band management port
1 dual-personality (RJ-45 or USB micro-B)

Power supplies 2 power supply slots
1 minimum power supply required (ordered separately)

Fan tray includes: 1 x JL088A
1 fan tray slot
Switch ships with 1 JL088A fan tray installed. Spares ordered separately.

Physical
characteristics

Dimensions 17.42(w) x 16.98(d) x 1.73(h) in (44.25 x 43.13 x 4.39 cm) (1U
height)

Weight 13.28 lb (6.02 kg)

Memory and
processor

P2020 Dual Core @ 1.2 GHz, 4 GB DDR3 SDRAM, 1 GB SD Card

Dual ARM Coretex A9 @ 1 GHz, 2 GB DDR3 SDRAM; Packet buffer size: 13.5 MB
Internal
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Mounting and
enclosure

Mounts in an EIA-standard 19 in. telco rack or equipment cabinet (hardware
included); Horizontal surface mounting only

Performance IPv6 Ready Certified  

1000 Mb Latency < 2.8 µs (FIFO 64-byte packets)

10 Gbps Latency < 1.8 µs (FIFO 64-byte packets)

40 Gbps Latency < 1.5 µs (FIFO 64-byte packets)

Throughput up to 285.7 Mpps (64-byte packets)

Routing/Switching
capacity

480 Gbps

Switch fabric speed 508 Gbps

Routing table size 10000 entries (IPv4), 5000 entries (IPv6)

MAC address table
size

64000 entries

 
 
 
Environment Operating

temperature
32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Nonoperating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 39 dB, Pressure: 22.3 dB

Primary Airflow
Direction

Front-to-side and front-to-rear

Electrical
Characteristics

Frequency 50/60Hz

Voltage JL085A PSU: 100-127/200-240 VAC 

Current JL085A PSU (Each): 1A/0.5A

Max/Idle Power
Rating (Switch+ 1
PSU)

142W/103W

Second PSU Power
Adder

10W 

Max/Idle Uplink
Power Adder

JL078A: 4W/3W
JL079A: 7W/3W
JL081A: 4W/3W
JL083A: 11W/4W 

Maximum Heat
Dissipation *(Max
Case)

310.31 

PoE Power (Max
Possible)

N/A
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Notes Idle power is the actual power consumption of the device with
no ports connected. Maximum power rating and maximum
heat dissipation are the worst case theoretical maximum
numbers provide for planning the infrastructure with fully
loaded PoE (if equipped), 100% traffic, all ports plugged in,
and all modules populated. This is a modular product.
 
*Switch + 2 power supplies + one JL083A Uplink. For most
accurate heat dissipation, idle and max power for any
combination of chassis and accessories, please consult
configurator. 

Safety EN 60950/IEC 60950; UL 60950; UL 60950-1; CAN/CSA 22.2 No. 60950; EN 60825;
CSA 22.2 60950-1; EN62479:2010; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; EN 62368-1, Ed. 2; IEC 60950-1:2005 Ed.2; Am
1:2009+A2:2013; IEC 60825:2007; EN60850-1:2007 / IEC 60825-1: 2007 Class1
Class 1 Laser Products / Laser Klasse 1; UL 62368-1 Ed.2

Emissions FCC Class A; VCCI Class A; EN 55022/CISPR 22 Class A; EN 60950-1:2006
+A11:2009 +A1:2010 +A12:2011+A2:2013

 
 
 
Immunity Generic EN55022: 2010

EN EN55024: 2010

ESD IEC 61000-4-2

Radiated IEC 61000-4-3; 3 V/m

EFT/Burst IEC 61000-4-4; 1.0 kV (power line), 0.5 kV (signal line)

Surge IEC 61000-4-5; 1 kV/2 kV AC

Conducted IEC 61000-4-6; 3 V

Power frequency
magnetic field

IEC 61000-4-8; 1 A/m, 50 or 60 Hz

Voltage dips and
interruptions

IEC 61000-4-11; >95% reductions, 0.5 period; 30% reduction,
25 periods

Harmonics EN61000-3-2:2006 +A1:2009 +A2:2009 Class A

Flicker EN61000-3-3:2008

Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; Out-of-band
management (RJ-45 Ethernet); In-line and out-of- band; Out-of-band management
(serial RS-232c or micro usb)

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services for
details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

Standards and protocols (applies to all products in series)
BGP
RFC 1997 BGP Communities Attribute
RFC 2918 Route Refresh Capability
RFC 4271 A Border Gateway Protocol 4 (BGP-4)
RFC 4456 BGP Route Reflection: An Alternative to Full Mesh Internal BGP (IBGP)
RFC 4724 Graceful Restart Mechanism for BGP

QuickSpecs Aruba 3810M Switch Series

Technical Specifications

DA - 15438   Worldwide QuickSpecs — Version 19 — 3/4/2019 Page  40
Anexo 01 ITEM 06 (0592605)         SEI 0008478-63.2018.6.02.8000 / pg. 4738

http://www.hpe.com/networking/services


RFC 5492 Capabilities Advertisement with BGP-4

Denial of service protection
CPU DoS Protection

Device Management
RFC 1591 DNS (client)
RFC 2576 (Coexistence between SNMP V1, V2, V3)
RFC 2579 (SMIv2 Text Conventions)
RFC 2580 (SMIv2 Conformance)
RFC 3416 (SNMP Protocol Operations v2)
RFC 3417 (SNMP Transport Mappings)
HTML and telnet management

 
 
 
General Protocols
IEEE 802.1ad Q-in-Q
IEEE 802.1AX-2008 Link Aggregation
IEEE 802.1D MAC Bridges
IEEE 802.1p Priority
IEEE 802.1Q VLANs
IEEE 802.1s Multiple Spanning Trees
IEEE 802.1v VLAN classification by Protocol and Port
IEEE 802.1w Rapid Reconfiguration of Spanning Tree
IEEE 802.3ad Link Aggregation Control Protocol (LACP)
IEEE 802.3af Power over Ethernet
IEEE 802.3az Energy Efficient Ethernet
IEEE 802.3x Flow Control
IEEE 802.3bz 2.5Gb/s and 5Gb/s interfaces
RFC 768 UDP
RFC 783 TFTP Protocol (revision 2)
RFC 792 ICMP
RFC 793 TCP
RFC 826 ARP
RFC 854 TELNET
RFC 868 Time Protocol
RFC 951 BOOTP
RFC 1058 RIPv1
RFC 1350 TFTP Protocol (revision 2)
RFC 1519 CIDR
RFC 1542 BOOTP Extensions
RFC 1918 Address Allocation for Private Internet
RFC 2030 Simple Network Time Protocol (SNTP) v4
RFC 2131 DHCP
RFC 2453 RIPv2
RFC 2548 (MS-RAS-Vendor only)
RFC 3046 DHCP Relay Agent Information Option
RFC 3575 IANA Considerations for RADIUS
RFC 3576 Ext to RADIUS (CoA only)
RFC 3768 VRRP
RFC 4675 RADIUS VLAN & Priority
RFC 5798 VRRP (exclude Accept Mode and sub-sec timer)
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RFC 5880 Bidirectional Forwarding Detection
RFC 5905 Network Time Protocol Version 4: Protocol and Algorithms Specification
UDLD (Uni-directional Link Detection)

IP Multicast
RFC 3376 IGMPv3
RFC 3973 PIM Dense Mode
RFC 4601 PIM Sparse Mode

 
 
 
IPv6
RFC 1981 IPv6 Path MTU Discovery
RFC 2080 RIPng for IPv6
RFC 2081 RIPng Protocol Applicability Statement
RFC 2082 RIP-2 MD5
RFC 2375 IPv6 Multicast Address Assignments
RFC 2460 IPv6 Specification
RFC 2464 Transmission of IPv6 over Ethernet Networks
RFC 2710 Multicast Listener Discovery (MLD) for IPv6
RFC 2925 Definitions of Managed Objects for Remote Ping, Traceroute, and Lookup Operations (Ping only)
RFC 3019 MLDv1 MIB
RFC 3315 DHCPv6 (client only)
RFC 3484 Default Address Selection for IPv6
RFC 3587 IPv6 Global Unicast Address Format
RFC 3596 DNS Extension for IPv6
RFC 3810 MLDv2 for IPv6
RFC 4022 MIB for TCP
RFC 4087 IP Tunnel MIB
RFC 4113 MIB for UDP
RFC 4213 Basic Transition Mechanisms for IPv6 Hosts and Routers
RFC 4251 SSHv6 Architecture
RFC 4252 SSHv6 Authentication
RFC 4253 SSHv6 Transport Layer
RFC 4254 SSHv6 Connection
RFC 4291 IP Version 6 Addressing Architecture
RFC 4293 MIB for IP
RFC 4294 IPv6 Node Requirements
RFC 4419 Key Exchange for SSH
RFC 4443 ICMPv6
RFC 4541 IGMP & MLD Snooping Switch
RFC 4861 IPv6 Neighbor Discovery
RFC 4862 IPv6 Stateless Address Auto-configuration
RFC 5095 Deprecation of Type 0 Routing Headers in IPv6
RFC 5340 OSPFv3 for IPv6
RFC 5453 Reserved IPv6 Interface Identifiers
RFC 5519 Multicast Group Membership Discovery MIB (MLDv2 only)
RFC 5722 Handling of Overlapping IPv6 Fragments
RFC 6620 FCFS SAVI
draft-ietf-savi-mix
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MIBs
IEEE 802.1ap (MSTP and STP MIB's only)
IEEE 8021-Bridge-MIB (2008)
IEEE 8021-Q-Bridge-MIB (2008)
RFC 1155 Structure & ID of Mgmt Info for TCP/IP Internets
RFC 1213 MIB II
RFC 1493 Bridge MIB
RFC 1724 RIPv2 MIB
RFC 1850 OSPFv2 MIB
RFC 2021 RMONv2 MIB
RFC 2096 IP Forwarding Table MIB
RFC 2578 Structure of Management Information Version 2 (SMIv2)
RFC 2613 SMON MIB
RFC 2618 RADIUS Client MIB
RFC 2620 RADIUS Accounting MIB
RFC 2665 Ethernet-Like-MIB
RFC 2668 802.3 MAU MIB
RFC 2674 802.1p and IEEE 802.1Q Bridge MIB
RFC 2737 Entity MIB (Version 2)
RFC 2787 VRRP MIB
RFC 2863 The Interfaces Group MIB
RFC 2925 Ping MIB
RFC 2932 IP (Multicast Routing MIB)
RFC 2933 IGMP MIB
RFC 4836 Managed Objects for 802.3 Medium Attachment Units (MAU)
RFC 7331 BFD MIB

Network Management
IEEE 802.1AB Link Layer Discovery Protocol (LLDP)
RFC 2819 Four groups of RMON: 1 (statistics), 2 (history), 3 (alarm) and 9 (events)
RFC 3176 sFlow
RFC 3411 SNMP Management Frameworks
RFC 3412 Message Processing and Dispatching for the Simple Network Management Protocol (SNMP)
RFC 3413 Simple Network Management Protocol (SNMP) Applications
RFC 3414 User-based Security Model (USM) for version 3 of the Simple Network Management Protocol
(SNMPv3)
RFC 3415 View-based Access Control Model (VACM) for the Simple Network Management Protocol
(SNMP)
RFC 3418 Management Information Base (MIB) for the Simple Network Management Protocol (SNMP)
RFC 5424 Syslog Protocol
ANSI/TIA-1057 LLDP Media Endpoint Discovery (LLDP-MED)
SNMPv1/v2c/v3
XRMON

OSPF
RFC 2328 OSPFv2
RFC 3101 OSPF NSSA
RFC 3623 Graceful OSPF Restart (Unplanned Outages only)
RFC 5340 OSPFv3 for IPv6

 
 
 

QuickSpecs Aruba 3810M Switch Series

Technical Specifications

DA - 15438   Worldwide QuickSpecs — Version 19 — 3/4/2019 Page  43
Anexo 01 ITEM 06 (0592605)         SEI 0008478-63.2018.6.02.8000 / pg. 4741



QoS/CoS
RFC 2474 DiffServ Precedence, including 8 queues/port
RFC 2475 DiffServ Architecture
RFC 2597 DiffServ Assured Forwarding (AF)
RFC 2598 DiffServ Expedited Forwarding (EF)

Security
IEEE 802.1X Port Based Network Access Control
RFC 1321 The MD5 Message-Digest Algorithm
RFC 2698 A Two Rate Three Color Marker
RFC 2818 HTTP Over TLS
RFC 2865 RADIUS (client only)
RFC 2866 RADIUS Accounting
RFC 3579 RADIUS Support For Extensible Authentication Protocol (EAP)
Secure Sockets Layer (SSL)
SSHv2 Secure Shell
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Aruba 3810M Switch Series accessories  
Modules  
Aruba 3810M 4-port Stacking Module JL084A
Aruba 3810M/2930M 4-port 100M/1G/10G SFP+ MACsec Module JL083A
Aruba 3810M/2930M 1-port QSFP+ 40GbE Module JL078A
Aruba 3810M 2QSFP+ 40GbE Module JL079A
Transceivers  
Aruba 100M SFP LC FX 2km MMF Transceiver J9054D
Aruba 1G SFP RJ45 T 100m Cat5e Transceiver J8177D
Aruba 1G SFP LC SX 500m OM2 MMF Transceiver J4858D
Aruba 1G SFP LC LX 10km SMF Transceiver J4859D
Aruba 1G SFP LC LH 70km SMF Transceiver J4860D
Aruba 10G SFP+ LC SR 300m OM3 MMF Transceiver J9150D
Aruba 10G SFP+ LC LR 10km SMF Transceiver J9151E
Aruba 10G SFP+ LC LRM 220m OM2 MMF Transceiver J9152D
Aruba 10G SFP+ LC ER 40km SMF Transceiver J9153D
Aruba 10G SFP+ to SFP+ 1m Direct Attach Copper Cable J9281D
Aruba 10G SFP+ to SFP+ 3m Direct Attach Copper Cable J9283D
Aruba 10G SFP+ to SFP+ 7m Direct Attach Copper Cable J9285D
Aruba 40G QSFP+ LC Bidirectional 150m MMF 2-strand Transceiver JL308A
HPE X142 40G QSFP+ MPO SR4 Transceiver JH231A
HPE X142 40G QSFP+ LC LR4 SM Transceiver JH232A
HPE X142 40G QSFP+ MPO eSR4 300M Transceiver JH233A
HPE X242 40G QSFP+ to QSFP+ 1m Direct Attach Copper Cable JH234A
HPE X242 40G QSFP+ to QSFP+ 3m Direct Attach Copper Cable JH235A
HPE X242 40G QSFP+ to QSFP+ 5m Direct Attach Copper Cable JH236A
Cables  
Aruba X2C2 RJ45 to DB9 Console Cable JL448A
Aruba 3800/3810M 0.5m Stacking Cable J9578A
Aruba 3800/3810M 1m Stacking Cable J9665A
Aruba 3800/3810M 3m Stacking Cable J9579A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 1m Cable QK732A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 2m Cable QK733A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 5m Cable QK734A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 15m Cable QK735A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 30m Cable QK736A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 50m Cable QK737A
Power Supply  
Aruba X371 12VDC 250W 100-240VAC Power Supply JL085A
Aruba X372 54VDC 680W 100-240VAC Power Supply JL086A
Aruba X372 54VDC 1050W 110-240VAC Power Supply JL087A
Fan Tray  
Aruba 3810 Switch Fan Tray JL088A
Mounting Kit  
HPE X410 1U Universal 4-post Rackmount Kit J9583A
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Date Version
History

Action Description of Change

04-Mar-2019 Version 19 Changed SKU J9151D was replaced with J9151E
CTO models were removed.
Obsolete SKUs were removed.

03-Dec-2018 Version 18 Changed Software feature update: Key features, Product
overview and Enhanced Capabilities updated

02-Jul-2018 Version 17 Changed Software feature update
07-May-2018 Version 16 Added Edits made on Configuration section and Technical

Specifications
05-Mar-2018 Version 15 Changed Configuration section updated.
05-Feb-2018 Version 14 Changed Configuration section updated.

Document name updated to match Product Master.
08-Jan-2018 Version 13 Changed Software feature update
07-Aug-2017 Version 12 Added SKU added: JL308A
03-Jul-2017 Version 11 Added SKU added: JL448A
08-May-2017 Version 10 Changed Configuration section updated
03-Apr-2017 Version 9 Changed Modules updated on Configuration section
17-Feb-2017 Version 8 Changed Configuration section updated (Adding #B2B, #B2C,

and #B2E Options on SKUs JL428A; JL429A and
JL430A)

09-Jan-2017 Version 7 Added Models added: JL428A, JL429A, JL430A
07-Nov-2016 Version 6 Changed Product overview, Features and Benefits updated
19-Aug-2016 Version 5 Changed Configuration section updated. Minor changes made on

Technical Specifications.
06-June-2016 Version 4 Changed Features and Benefits, Standards and Protocols,

Accessories updated.
SKU descriptions updated.

18-Mar-2016 Version 3 Changed Minor edits on Features and Benefits, Switch family
photo added.

11-Dec-2015 Version 2 Changed Standards and protocols and Configuration Menu
updated

01-Dec-2015 Version 1 Created Document creation
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Sign up for updates

 

 
  © Copyright 2019 Hewlett Packard Enterprise Development LP. The information

contained herein is subject to change without notice. The only warranties for
Hewlett Packard Enterprise products and services are set forth in the express
warranty statements accompanying such products and services. Nothing herein
should be construed as constituting an additional warranty. Hewlett Packard
Enterprise shall not be liable for technical or editorial errors or omissions
contained herein.

 

To learn more, visit: http://www.hpe.com/networking
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HPE Networking Product Warranty & Support Summary (October 2018)

The most current version of this document is available at www.hpe.com/networking/warrantysummary
HPE Networking product warranty policy details are available at www.hpe.com/networking/warranty

Information on services for HPE Networking products can be found at www.hpe.com/networking/services
The information contained herein is subject to change without notice.  Warranties for HPE products and services are set forth in the express warranty statements 

accompanying such products and services.   In addition, our goods come with guarantees that cannot be excluded under Australian and New Zealand consumer laws.  
Subject to the foregoing, nothing herein should be construed as constituting an additional warranty.  HPE shall not be liable for technical or editorial errors or omissions 

contained herein.

 

Products Warranty 
duration1

Hardware 
replacement2

Business 
Hours 

Technical 
Support3

24x7
Technical 
Support3

(After Dec. 1, 2015)

Software/OS 
Releases4

Sw
itc

he
s

Modular
129xx, 125xx, 119xx 1 year 10 days 1 year N/A As long as owned4

105xx, 75xx 1 year 10 days 1 year 90 days As long as owned4

84xx, 83xx 5 years 10 days 90 days N/A 5 years4

82xxzl, 54xxzl/R, 42xxvl Lifetime5 NBD Ship As long as 
owned5 90 days As long as owned4

Fixed-configuration
79xx, 59xx/AF, 583x/AF, 582x/AF, 57xx 1 year 10 days 1 year N/A As long as owned4

Altoline 9xxx, 6xxx Switches (Purchased after March 31, 2016) 1 year 10 days 1 year N/A N/A

Arista switches (See http://www.arista.com/assets/data/pdf/Warranty.pdf for details) 1 year15 10 days15 1 year15 N/A N/A

580x/AF Lifetime5 NBD Ship As long as 
owned5 N/A As long as owned4

55xx, 513x, 512x, 38xx, 36xx, 35xx/yl, 31xx, 29xx/al, 281x, 26xx, 25xx/G Lifetime5 NBD Ship As long as 
owned5 90 days As long as owned4

Smart Managed 
195x, 192x, 191x, 18xx, 1620 (Purchased after October 1, 2017)

Lifetime14 NBD Ship

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14

As long as owned4

Unmanaged 
1420, 1410 (Purchased after October 1, 2017)

Lifetime14 NBD Ship

90 days 
Phone 

support-Chat 
support entire 

warranty 
period 14

90 days 
Phone 

support-Chat 
support entire 

warranty 
period 14

N/A

1405 (Purchased after October 1, 2017) 3 years14 NBD Ship 90 days 
Phone 

support-Chat 
support entire 

warranty 
period 14

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14

N/A

W
ire

le
ss

 L
A

N

Indoor Access Points
Aruba Controller-Managed Access Points (APs)

Lifetime10
30 day 

NBD/Return-to-
factory11

90 days N/A 90 days (bug fix only)

3WN/P, 155/P, 108/109 Aruba Remote Access points (RAPs) 
Lifetime10

30 day 
NBD/Return-to-

factory11
90 days N/A Periodic updated 

image13

Aruba Instant Access Points (IAPs)
Lifetime10

30 day 
NBD/Return-to-

factory11
90 days N/A Periodic updated 

image13

M330, M2xx Lifetime5 NBD Ship As long as 
owned5 90 days As long as owned4

OfficeConnect 20 Access Point

3 years14 NBD Ship

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14

As long as owned4

Controllers
Aruba controllers

1 year
30 day 

NBD/Return-to-
factory11

90 days12 N/A N/A

Aruba Mobility Access Switches Lifetime10 NBD Ship 90 days 90 days As long as owned4

Other WLAN products 
Aruba Controller-Managed 2xx Series Outdoor Access Points

Lifetime10
30 day 

NBD/Return-to-
factory11

90 days N/A 90 days (bug fix only)

Aruba Instant 2xx Series Outdoor Access Points (IAPs)
Lifetime10

30 day 
NBD/Return-to-

factory11
90 days N/A Periodic updated 

image13

AirWave Appliances, ClearPass Appliances, IntroSpect Appliances
1 year

30 day 
NBD/Return-to-

factory11
90 days12

N/A
90 days (bug fix only)

MST2HP, MST2HAC, MSR2KP, MSR4KP Aruba Outdoor Wireless Mesh 
Routers 1 year

30 day 
NBD/Return-to-

factory11
90 days12 N/A 90 days (bug fix only)

Aruba Beacons
90 days

30 day 
NBD/Return-to-

factory11
90 days N/A 90 days (bug fix only)

Cape Sensors
90 days

30 day 
NBD/Return-to-

factory11
90 days N/A 90 days (bug fix only)

Aruba Power Supplies, Antennae, Accessories
1 year

30 day 
NBD/Return-to-

factory11
90 days N/A N/A
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HPE Networking Product Warranty & Support Summary (October 2018)

The most current version of this document is available at www.hpe.com/networking/warrantysummary
HPE Networking product warranty policy details are available at www.hpe.com/networking/warranty

Information on services for HPE Networking products can be found at www.hpe.com/networking/services
The information contained herein is subject to change without notice.  Warranties for HPE products and services are set forth in the express warranty statements 

accompanying such products and services.   In addition, our goods come with guarantees that cannot be excluded under Australian and New Zealand consumer laws.  
Subject to the foregoing, nothing herein should be construed as constituting an additional warranty.  HPE shall not be liable for technical or editorial errors or omissions 

contained herein.

 

R
ou

te
rs

Routers
88xx, HSR68xx 1 year 10 days 1 year N/A As long as owned4

HSR66xx, 66xx, MSR50, MSR4xxx, MSR3xxx, MSR30 1 year 10 days 1 year 90 days As long as owned4

MSR2xxx, MSR20, MSR1xxx, MSR9xx 1 year NBD Ship 1 year 90 days As long as owned4

ALU 77xx 1 year9 Return-to-
factory9 1 year9 N/A All updates for 

purchased license9

VSR routers 90 days
(Media only) N/A 90 days N/A All updates for 

purchased license8

M
an

ag
em

en
t

Network Management
Intelligent Management Center (support details at www.hpe.com/networking/IMCSupport) 90 days

(Media only)
N/A 90 days N/A 90 days (bug fix only)

AirWave, ALE, ArubaCentral, ClearPass, Meridian, VIA, Visual RF 90 days
(Media only)

N/A 90 days N/A 90 days (bug fix only)

HPE VAN SDN controller and HPE SDN applications 90 days
(Media only)

N/A 90 days N/A All updates for 
purchased license8

HPE Distributed Cloud Networking 90 days
(Media only)

N/A N/A N/A None

Big Switch Networks controller appliances (See www.bigswitch.com/support for 
warranty & support details) N/A16 N/A16 N/A16 N/A16 N/A16

A
dd

iti
on

al
 N

et
w

or
ki

ng
 

Pr
od

uc
ts

Transceivers
Aruba Transceivers (Transceiver product numbers JWxxxx for Controllers 
and MAS Switches) 1 year 

30 day 
NBD/Return-to-

factory11
90 days N/A N/A

Aruba branded transceivers (except transceiver product numbers JWxxxx)
and

HPE X244, X242, X142, X132, X131, X129, X122, X121, X119, X112, X111

Lifetime5 NBD Ship As long as 
owned5

N/A N/A

Aruba 100G transceivers 1 year 10 days 1 year N/A N/A
HPE X2A0, X240, X190, X180, X170, X160, X150, X140, X135, X130, 
X125, X124, X120, X115, X114, X110

1 year 30 days 1 year N/A N/A

1) Removable power supplies, modules and accessories such as antennas, fans, power cords, 
etc. may have different warranty coverage than the host device.  See the HPE Networking 
Warranty Coverage Quick Reference at www.hpe.com/networking/warrantyquickref for more 
details. 

2) Response time is based on commercially reasonable effort and subject to a daily shipment 
cutoff time.  In some countries and regions and under certain supplier constraints, response 
time may vary.  Contact your local HPE service organization for response time availability in 
your area.  NBD Ship = Next Business Day shipment.

3) Warranty phone and electronic case technical support is provided during local HPE business 
hours for the entire warranty period for the purposes of diagnosing hardware or software 
defects.  Many products purchased after December 1, 2015 include 90 days of 24x7 technical 
support as noted.  See product’s Hewlett-Packard Limited Warranty Statement for additional 
coverage details.  Extended coverage services are available.

4) Includes all generally available software/OS releases offered for the specific products listed, 
when and if available, for as long as the customer owns the product, except where noted.  
Some software releases may require additional or new hardware.  Customers who desire 
specific feature updates, patches and fixes to be prioritized into future releases should 
purchase the appropriate support services from HPE.

5) For products purchased after December 1, 2014, the warranty extends only for as long as the 
original end user owns the product. Includes coverage of any built-in fans and power supplies 
for the entire warranty period. You may be required to provide proof of purchase or lease as a 
condition of receiving warranty service.  

6) Hardware warranty, technical support and all software releases provided for hardware and the 
ONE Service OS only, when and if available, for as long as the original end user owns the 
product.  See product specific documentation for application support.  5 year warranty on the 
disk drive in the HPE Alliance One Advanced Services zl Modules.

7) Products purchased before August 1, 2013 include 1 year of technical support and 1 year 
(bug fix only). 

8) Includes all software updates offered for the licensed version, when and if available.  Software 
upgrades will require purchase of appropriate SKU, packaged support services or contract.

9) All technical, hardware and software support for ALU 77xx products is provided directly by 
Alcatel-Lucent only and not HPE.  For support from Alcatel-Lucent, select the country from 
which the customer is calling in the following link and it will present the appropriate ALU 
support contact information: https://services.support.alcatel-lucent.com/product_support/.  
Hardware warranty requires shipping failed product to ALU for repair or replacement.  
Logistics cost for shipment of product from customer’s site to ALU site for repair or 
replacement will be covered by the customer.  Software maintenance releases are included 
for the major software release purchased.  Major software release upgrades are NOT 
included.  Services may be purchased from HPE or Alcatel-Lucent to extend your support 
coverage and software upgrades.  Support will be provided by Alcatel Lucent for these 
services.

10) For products purchased after December 1, 2015, the warranty extends only for as long as the 
original end user owns the product and is limited to five (5) years from the end of sale date.

11) For the first 30 days from shipment, HPE will provide same day ship advanced 
replacement for the covered hardware products.  After thirty (30) days from shipment 
through the remaining warranty period, HPE will replace or repair any non-compliant 
Product and return it in operable condition, shipping after HPE’s receipt of the non-
compliant Product via HPE’s RMA procedure, with receipt by customer within ten 
(10) days on a commercially reasonable basis.

12) HPE will provide next business day email response for the purposes of diagnosing 
hardware or software defects during standard Pacific Time Zone business hours for 
the first 90 days after purchase. 

13) HPE will make one recent Instant OS software release image available on the 
software portal.  This image is also available for Remote Access Points (RAPs) 
running Instant OS.

14) These products are covered by 90 days of 24x7 phone support.  Thereafter, only 
chat support would be available for the remaining warranty period.  Limited lifetime 
warranty (where applicable) extends only for as long as the original end user owns 
the product and is limited to five (5) years from the end of sale date. This warranty 
includes coverage of any built-in fans and power supplies for the entire warranty 
period. You may be required to provide proof of purchase or lease as a condition of 
receiving warranty service. See www.hpe.com/OfficeConnect/support/ for more 
information on the new OfficeConnect support process. 

15) All technical, hardware and software support for Arista products is provided directly 
by Arista and not HPE.   Consult the Arista customer support page for contact 
information: https://www.arista.com/en/support/customer-support.  Transportation 
costs, if any, incurred in connection with the return of a defective Hardware to an 
Arista repair center shall be borne by Customer. Arista shall pay any transportation 
costs incurred with the redelivery of a repaired or replaced Hardware. Services may 
be purchased from HPE or Arista to extend your support coverage and software 
upgrades.  Support will be provided by Arista for these services.  For details on 
Arista warranty and support, see: 
http://www.arista.com/assets/data/pdf/Warranty.pdf.

16) All technical, hardware and software support for Big Switch Networks products is 
provided directly by BSN and not HPE.  Consult the Big Switch Networks customer 
support page for contact information: www.bigswitch.com/support.  For details on 
Big Switch Networks warranty and support options, see: 
http://bigswitch.com/sites/default/files/bsn_support_and_maintenance_policy.v2.2.20
16.11.14.pdf.
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Aruba 3810M Switch Series
 

 
Models
Aruba 3810M 24G 1-slot Switch JL071A
Aruba 3810M 48G 1-slot Switch JL072A
Aruba 3810M 24G PoE+ 1-slot Switch JL073A
Aruba 3810M 48G PoE+ 1-slot Switch JL074A
Aruba 3810M 16SFP+ 2-slot Switch JL075A
Aruba 3810M 40G 8 HPE Smart Rate PoE+ 1-slot Switch JL076A
Aruba 3810M 48G PoE+ 4SFP+ 680W Switch JL428A
Aruba 3810M 48G PoE+ 4SFP+ 1050W Switch JL429A
Aruba 3810M 24SFP+ 250W Switch JL430A

Key features
Advanced Layer 3 switch series with backplane stacking, dynamic segmentation, low latency and
resiliency
Advanced security and network management via Aruba ClearPass Policy Manager, Aruba AirWave and
Aruba Central
Modular 10GbE and 40GbE uplinks for wireless aggregation
HPE Smart Rate for high-speed multi-gigabit capacity and PoE+ power
Software-defined ready with REST APIs and OpenFlow support

 

QuickSpecs Aruba 3810M Switch Series

Overview
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The Aruba 3810 Switch Series provides performance and resiliency for enterprises, SMBs, and branch office
networks. With HPE Smart Rate multi-gigabit ports for high speed access points and IoT devices, this
advanced Layer 3 network switch delivers a better application experience with low latency, virtualization with
resilient stacking technology, and line rate 40GbE for plenty of back haul capacity. 
A powerful Aruba ProVision ASIC delivers performance, robust feature support, and value with flexible
programmability for the latest applications.  The 3810 delivers resiliency and scalability via innovative
backplane stacking technology and redundant, hot-swappable power supplies all in a convenient 1U form
factor.  It supports an advanced Layer 2 and 3 feature set with OSPF, IPv6, IPv4 BGP, Dynamic
Segmentation, robust QoS, and policy-based routing are included with no software licensing. 
The 3810M is easy to deploy, use and manage using Aruba AirWave or Aruba Central. Aruba ClearPass
offers centralized security and external captive portal support.  The switches offer a limited lifetime warranty.

QuickSpecs Aruba 3810M Switch Series

Overview
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Enhanced Capabilities and benefits
 
Software-defined networks

Supports multiple programmatic interfaces
Including REST APIs and Openflow 1.0 and 1.3, to enable automation of network operations,
monitoring, and troubleshooting.

Unified Wired and Wireless Support

ClearPass Policy Manager support
unified wired and wireless policies using Aruba ClearPass Policy Manager
Switch auto-configuration
Automatically configures switch for different settings such as VLAN, CoS, PoE max power, and PoE
priority when an Aruba access point is detected.
User role
Defines a set of switch-based policies in areas such as security, authentication, and QoS. A user role
can be assigned to a group of users or devices, using switch-based local user role or download from
ClearPass
Dynamic segmentation
Provides a secured tunnel to transport network traffic on a per-port or per-user-role basis to an Aruba
Controller.  In per-user-role Tunneled Node, users are authenticated with ClearPass Policy Manager
which can direct the traffic to be tunneled to Aruba controller or switch locally.
Static IP visibility
provides a way for ClearPass to do accounting for clients with static IP addresses

Quality of Service (QoS)
Advanced classifier-based QoS

classifies traffic using multiple match criteria based on Layer 2, 3, and 4 information; applies QoS
policies such as setting priority level and rate limit to selected traffic on a per-port or per-VLAN basis

Layer 4 prioritization
based on TCP/UDP port numbers

Class of Service (CoS)
sets the IEEE 802.1p priority tag based on IP address, IP Type of Service (ToS), Layer 3 protocol,
TCP/UDP port number, source port, and DiffServ

Bandwidth shaping:
- Port-based rate limiting: provides per-port ingress-/egress-enforced increased bandwidth
- Classifier-based rate limiting: uses an access control list (ACL) to enforce increased bandwidth

for ingress traffic on each port
- Reduced bandwidth: provides per-port, per-queue egress-based reduced bandwidth

Remote intelligent mirroring
mirrors selected ingress/egress traffic based on an ACL, port, MAC address, or VLAN to a local or
remote HPE 8200 zl, 6600, 6200 yl, 5400 zl, or 3500 switch anywhere on the network

Remote monitoring (RMON), Extended RMON (XRMON), and sFlow v5
provide advanced monitoring and reporting capabilities for statistics, history, alarms, and events

Traffic prioritization
allows real-time traffic classification into eight priority levels that are mapped to eight queues

Unknown Unicast Rate Limiting
throttles unicast packets with unknown destination addresses and limits flooding on the VLAN

 
 
 
Simplified management and configuration

Flexible management
supports both cloud-based Central and on-premise AirWave without ripping and replacing switching
infrastructure

QuickSpecs Aruba 3810M Switch Series

Standard Features
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Aruba Central cloud-based management platform
offers simple, secure, and cost effective way to manage switches

Built-in programmable and easy to use REST API interface
provides configuration automation for campus networks

Friendly port names
allows assignment of descriptive names to ports

IEEE 802.1AB Link Layer Discovery Protocol (LLDP)
advertises and receives management information from adjacent devices on a network, facilitating
easy mapping by network management applications

Command authorization
leverages RADIUS to link a custom list of CLI commands to an individual network administrator's
login; an audit trail documents activity

Multiple configuration files
stores easily to the flash image

Dual flash images
provides independent primary and secondary operating system files for backup while upgrading

Out-of-band Ethernet management port
enables management over a separate physical management network; and keeps management traffic
segmented from network data traffic

Zero Touch ProVisioning (ZTP)
simplifies installation of the switch infrastructure using the Aruba Activate-based or a DHCP-based
process with AirWave and Central Network Management

Unidirectional Link Detection (UDLD)
monitors the link between two switches and blocks the ports on both ends of the link if the link goes
down at any point between the two devices

IP service level agreements (SLA) for voice
monitor quality of voice traffic using the UDP jitter and UDP jitter for VoIP tests

J

Connectivity
Jumbo frames on Gigabit Ethernet and 10-Gigabit Ethernet ports

allow high-performance remote backup and disaster-recovery services
IEEE 802.3at Power over Ethernet (PoE+)

provides up to 30 W per port that allows support of the latest PoE+ capable devices such as IP
phones, wireless access points, and security cameras, as well as any IEEE 802.3af compliant end
device; eliminates the cost of additional electrical cabling and circuits that would otherwise be
necessary in IP phone and WLAN deployments

Support for pre-standard PoE
detects and provides power to pre-standard PoE devices

Choice of uplinks:
- SFP+ uplink models: provide fiber-optic (up to 70 km) or direct-attach-cable (DAC) connectivity
- 10GBASE-T uplink models: offer 10GbE speeds, using standard RJ-45 connectors and

standard twisted-pair cabling up to 100 m
Auto-MDIX

provides automatic adjustments for straight-through or crossover cables on all RJ-45 ports
IPv6:

- IPv6 host: enables switch management in an IPv6 network
- Dual stack (IPv4 and IPv6): transitions IPv4 to IPv6, supporting connectivity for both protocols
- MLD snooping: forwards IPv6 multicast traffic to the appropriate interface
- IPv6 ACL/QoS: supports ACL and QoS for IPv6 traffic
- IPv6 routing: supports static, RIPng, OSPFv3 routing protocols
- 6in4 tunneling: supports encapsulation of IPv6 traffic in IPv4 packets
- Security: provides RA guard, DHCPv6 protection, dynamic IPv6 lockdown, and ND snooping
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Performance and efficiency
Selectable queue configurations

allows for increased performance by selecting the number of queues and associated memory
buffering that best meet the requirements of the network applications

Energy-efficient design:
- 80 PLUS Silver Certified power supply: increases power efficiency and savings
- Energy-efficient Ethernet (EEE) support: reduces power consumption in accordance with

IEEE 802.3az
Meshed stacking technology:

- High-performance stacking: provides up to 336 Gb/s of stacking throughput; each 4-port
stacking module can support up to 42 Gb/s in each direction per stacking port

- Ring, chain, and mesh topologies: support up to a 10-member ring or chain and 5-member
fully meshed stacks; meshed topologies offer increased resiliency vs. a standard ring

- Virtualized switching: provides simplified management as the switches appear as a single
chassis when stacked

Aruba ProVision ASIC
provides very low latency, increased packet buffering, and adaptive power consumption

Resiliency and high availability
Virtual Router Redundancy Protocol (VRRP)

allows groups of two routers to dynamically back each other up to create highly available routed
environments in IPv4 and IPv6 networks

Nonstop switching and routing
improves network availability to better support critical applications, such as unified communication
and mobility; traffic will continue to be forwarded during failovers, when the backup member of the
stack becomes the commander

IEEE 802.3ad Link Aggregation Protocol (LACP) and Hewlett Packard Enterprise port trunking
support up to 144 trunks, each with up to 8 links (ports) per trunk

IEEE 802.1s Multiple Spanning Tree
provides high link availability in multiple VLAN environments by allowing multiple spanning trees;
provides legacy support for IEEE 802.1d and IEEE 802.1w

Dual hot-swappable power supplies
- Increased resiliency: with secondary power supply to enable complete switch power redundancy

in case of power line or supply failure
- Secondary power supply increases available PoE+ power

Distributed trunking
enables loop-free and redundant network topology without using Spanning Tree Protocol; allows a
server or switch to connect to two switches using one logical trunk for redundancy and load sharing

SmartLink
provides easy-to-configure link redundancy of active and standby links

Layer 2 switching
IEEE 802.1ad QinQ

increases the scalability of an Ethernet network by providing a hierarchical structure; connects
multiple LANs on a high-speed campus or metro network

VLAN support and tagging
supports the IEEE 802.1Q standard and 4096 VLANs simultaneously

IEEE 802.1v protocol VLANs
isolate select non-IPv4 protocols automatically into their own VLANs

MAC-based VLAN
provides granular control and security; uses RADIUS to map a MAC address/user to specific VLANs

Rapid Per-VLAN Spanning Tree (RPVST+)
allows each VLAN to build a separate spanning tree to improve link bandwidth usage; is compatible
with PVST+

Aruba 3810M switch meshing
dynamically load balances across multiple active redundant links to increase available aggregate
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bandwidth; allows concurrent Layer 3 routing
GVRP and MVRP

allows automatic learning and dynamic assignment of VLANs
 
 
Layer 3 services

Loopback interface address
defines an address in Routing Information Protocol (RIP) and Open Standard Path First (OSPF),
improving diagnostic capability

Route maps
provide more control during route redistribution; allow filtering and altering of route metrics

User datagram protocol (UDP) helper function
allows UDP broadcasts to be directed across router interfaces to specific IP unicast or subnet
broadcast addresses; and helps prevent server spoofing for UDP services such as DHCP

DHCP server
centralizes and reduces the cost of IPv4 address management

Bidirectional Forwarding Detection (BFD)
enables link connectivity monitoring and reduces network convergence time for static routing,
OSPFv2, and VRRP

Layer 3 routing
Static IP routing

provides manually configured routing for both IPv4 and IPv6 networks
OSPF

provides OSPFv2 for IPv4 routing and OSPFv3 for IPv6 routing
Policy-based routing

makes routing decisions based on policies set by the network administrator
Border Gateway Protocol (BGP)

provides IPv4 Border Gateway Protocol routing, which is scalable, robust, and flexible
Routing Information Protocol (RIP)

provides RIPv1, RIPv2, and RIPng routing
 
Security

Control plane policing
sets rate limit on control protocols to protect CPU overload from DOS attacks

Source-port filtering
allows only specified ports to communicate with each other

RADIUS/TACACS+
eases switch management security administration by using a password authentication server

Secure shell
encrypts all transmitted data for secure remote CLI access over IP networks

Secure Sockets Layer (SSL)
encrypts all HTTP traffic, allowing secure access to the browser-based management GUI in the
switch

Port security
allows access only to specified MAC addresses, which can be learned or specified by the
administrator

MAC address lockout
prevents particular configured MAC addresses from connecting to the network

Detection of malicious attacks
monitors 10 types of network traffic and sends a warning when an anomaly that potentially can be
caused by malicious attacks is detected

Secure FTP
allows secure file transfer to and from the switch; protects against unwanted file downloads or
unauthorized copying of a switch configuration file

QuickSpecs Aruba 3810M Switch Series

Standard Features

DA - 15438   Worldwide QuickSpecs — Version 19 — 3/4/2019 Page  6
Anexo 01 ITEM 07 (0592609)         SEI 0008478-63.2018.6.02.8000 / pg. 4754



Switch management logon security
helps secure switch CLI logon by optionally requiring either RADIUS or TACACS+ authentication

Secure management access
delivers secure encryption of all access methods (CLI, GUI, or MIB) through SSHv2, SSL, and/or
SNMPv3

ICMP throttling
defeats ICMP denial-of-service attacks by enabling any switch port to automatically throttle ICMP
traffic

 
 

Identity-driven ACL
enables implementation of a highly granular and flexible access security policy and VLAN assignment
specific to each authenticated network user

STP BPDU port protection
blocks Bridge Protocol Data Units (BPDUs) on ports that do not require BPDUs, preventing forged
BPDU attacks

Dynamic IP lockdown
works with DHCP protection to block traffic from unauthorized hosts, preventing IP source address
spoofing

DHCP protection
blocks DHCP packets from unauthorized DHCP servers, preventing denial-of-service attacks

Dynamic ARP protection
blocks ARP broadcasts from unauthorized hosts, preventing eavesdropping or theft of network data

STP root guard
protects the root bridge from malicious attacks or configuration mistakes

Management Interface Wizard
helps secure management interfaces such as SNMP, Telnet, SSH, SSL, Web, and USB at the
desired level

Security banner
displays a customized security policy when users log in to the switch

Switch CPU protection
provides automatic protection against malicious network traffic trying to shut down the switch

ACLs
provide filtering based on the IP field, source/destination IP address/subnet and source/destination
TCP/UDP port number on a per-VLAN or per-port basis

Multiple authentication methods
- IEEE 802.1X

authenticates multiple IEEE 802.1X users per port; prevents a user from "piggybacking" on
another user's authentication

- Supports web-based authentication
- MAC-based client authentication
- Concurrent authentication modes

enables a switch port to accept up to 32 sessions of 802.1X, Web, and MAC authentication
Private VLAN

provides network security by restricting peer-to-peer communication to prevent a variety of malicious
attacks; typically a switch port can only communicate with other ports in the same community and/or
an uplink port, regardless of VLAN ID or destination MAC address

IEEE 802.1AE MACsec
provides security on a link between two switch ports (1Gbps or 10Gbps) using standard encryption
and authentication

Open authentication role
simplifies first-time deployment of AAA in brownfield deployments by allowing full network access for
failed clients and provides instant connectivity as soon as a client is plugged-in

Critical authentication role
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ensures that important infrastructure devices such as IP phones are allowed network access even in
the absence of a RADIUS server

MAC pinning
allows non-chatty legacy devices to stay authenticated by pinning client MAC addresses to the port until the clients
logoff or get disconnected

 
Convergence

IP multicast snooping (data-driven IGMP)
prevents flooding of IP multicast traffic

LLDP-MED (Media Endpoint Discovery)
defines a standard extension of LLDP that stores values for parameters such as QoS and VLAN to
configure automatically network devices such as IP phones

PoE allocations
supports multiple methods (automatic, IEEE 802.3af class, LLDP-MED, or user-specified) to allocate
PoE power for more efficient energy savings

Protocol Independent Multicast for IPv6
supports one-to-many and many-to-many media casting use cases such as IPTV over IPv6 networks

IP multicast routing
includes PIM sparse and dense modes to route IP multicast traffic

Auto VLAN configuration for voice
- RADIUS VLAN

uses a standard RADIUS attribute and LLDP-MED to automatically configure a VLAN for IP
phones

- CDPv2
uses CDPv2 to configure legacy IP phones

Local MAC Authentication
assigns attributes such as VLAN and QoS using locally configured profile that can be a list of MAC
prefixes

Warranty and support
Limited Lifetime Warranty

see http://www.hpe.com/networking/warrantysummary for warranty and support information
included with your product purchase.

Software releases
to find software for your product, refer to http://www.hpe.com/networking/support; for details on the software releases
available with your product purchase, refer to http://www.hpe.com/networking/warrantysummary
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Build To Order:
BTO is a standalone unit with no integration. BTO products ship standalone are not part of a CTO or Rack-
Shippable solution.
Aruba 3810M 24G 1-slot Switch JL071A

24 RJ-45 autosensing 10/100/1000 ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

 

Aruba 3810M 48G 1-slot Switch JL072A
48 RJ-45 autosensing 10/100/1000 ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

 

Aruba 3810M 24G PoE+ 1-slot Switch JL073A
24 RJ-45 autosensing 10/100/1000 PoE+ ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

 

Aruba 3810M 48G PoE+ 1-slot Switch JL074A
48 RJ-45 autosensing 10/100/1000 PoE+ ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

 

Aruba 3810M 16SFP+ 2-slot Switch JL075A
16 fixed 1000/10000 SFP/SFP+ ports
min=0 \ max=16 SFP/SFP+  Transceivers
1 open stacking module slot
2 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

See
Configuration

RULE: 1

Aruba 3810M 40G 8 HPE Smart Rate PoE+ 1-slot Switch JL076A
40 RJ-45 autosensing 10/100/1000 PoE+ ports
8 RJ-45 1/2.5/5/XGT PoE+ ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height
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Aruba 3810M 48G PoE+ 4SFP+ 680W Switch JL428A
Includes 1 3810M 48 Port PoE+ Switch (JL074A)
48 RJ-45 autosensing 10/100/1000 PoE+ ports
4 fixed 1000/10000 SFP/SFP+ ports
min=0 \ max=4 SFP/SFP+  Transceivers
1 open stacking module slot
Includes 1 uplink module (JL083A)
Includes 1 680W Power Supply (JL086A, Max 2)
1U - Height

See
Configuration
RULE: 1, 2

PDU Cable NA/MEX/TW/JP JL428A#B2B
C15 PDU Jumper Cord (NA/MEX/TW/JP)  

PDU Cable ROW JL428A#B2C
C15 PDU Jumper Cord (ROW)  

High Volt Power Supply to Wall Power Cord JL428A#B2E
NEMA L6-20P Cord (NA/MEX/JP/TW)  

No Power Cord JL428A#AC3
No Localized Power Cord Selected  

Aruba 3810M 48G PoE+ 4SFP+ 1050W Switch JL429A
Includes 1 3810M 48 Port PoE+ Switch (JL074A)
48 RJ-45 autosensing 10/100/1000 PoE+ ports
4 fixed 1000/10000 SFP/SFP+ ports
min=0 \ max=4 SFP/SFP+  Transceivers
1 open stacking module slot
Includes 1 uplink module (JL083A)
Includes 1 1050W Power Supply (JL087A, Max 2)
1U - Height

See
Configuration
RULE: 1, 2

PDU Cable NA/MEX/TW/JP JL429A#B2B
C15 PDU Jumper Cord (NA/MEX/TW/JP)  

PDU Cable ROW JL429A#B2C
C15 PDU Jumper Cord (ROW)  

High Volt Power Supply to Wall Power Cord JL429A#B2E
NEMA L6-20P Cord (NA/MEX/JP/TW)  

No Power Cord JL429A#AC3
No Localized Power Cord Selected  

Aruba 3810M 24SFP+ 250W Switch JL430A
Includes 1 3810M 16 Port SFP+ Switch (JL075A)
16 fixed 1000/10000 SFP/SFP+ ports
8 port SFP+ ports on the included modules
min=0 \ max=24 SFP/SFP+  Transceivers
1 open stacking module slot
Includes 2 uplink modules (JL083A)
Includes 1 250W Power Supply (JL085A, Max 2)
1U - Height

See
Configuration
RULE: 1, 2

PDU Cable NA/MEX/TW/JP JL430A#B2B
C15 PDU Jumper Cord (NA/MEX/TW/JP)  

PDU Cable ROW JL430A#B2C
C15 PDU Jumper Cord (ROW)  
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High Volt Power Supply to Wall Power Cord JL430A#B2E
NEMA L6-20P Cord (NA/MEX/JP/TW)  

No Power Cord JL430A#AC3
No Localized Power Cord Selected  

Configuration Rules:  
RULE 1 The following Transceivers install into this Switch (For the 1000/10000 SFP+ Ports):  

Aruba 1G SFP LC SX 500m OM2 MMF Transceiver J4858D
Aruba 1G SFP LC LX 10km SMF Transceiver J4859D
Aruba 1G SFP LC LH 70km SMF Transceiver J4860D
Aruba 1G SFP RJ45 T 100m Cat5e Transceiver J8177D
Aruba 100M SFP LC FX 2km MMF Transceiver J9054D
Aruba 10G SFP+ LC SR 300m OM3 MMF Transceiver J9150D
Aruba 10G SFP+ LC LR 10km SMF Transceiver J9151E
Aruba 10G SFP+ LC LRM 220m OM2 MMF Transceiver J9152D
Aruba 10G SFP+ LC ER 40km SMF Transceiver J9153D
Aruba 10G SFP+ to SFP+ 1m Direct Attach Copper Cable J9281D
Aruba 10G SFP+ to SFP+ 3m Direct Attach Copper Cable J9283D
Aruba 10G SFP+ to SFP+ 7m Direct Attach Copper Cable J9285D

   
RULE 2 Localization required on orders without #B2B, #B2C, #B2E options.  

Rack Level Integration CTO Models  
Aruba 3810M 24G 1-slot Switch JL071A

24 RJ-45 autosensing 10/100/1000 ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

See
Configuration
RULE: 10, 11

Aruba 3810M 48G 1-slot Switch JL072A
48 RJ-45 autosensing 10/100/1000 ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

See
Configuration
RULE: 10, 11

Aruba 3810M 24G PoE+ 1-slot Switch JL073A
24 RJ-45 autosensing 10/100/1000 PoE+ ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

See
Configuration
RULE: 10, 11

Aruba 3810M 48G PoE+ 1-slot Switch JL074A
48 RJ-45 autosensing 10/100/1000 PoE+ ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

See
Configuration
RULE: 10, 11
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Aruba 3810M 16SFP+ 2-slot Switch JL075A

16 fixed 1000/10000 SFP/SFP+ ports
min=0 \ max=16 SFP/SFP+  Transceivers
1 open stacking module slot
2 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

See
Configuration
RULE: 1, 10,

11

Aruba 3810M 40G 8 HPE Smart Rate PoE+ 1-slot Switch JL076A
40 RJ-45 autosensing 10/100/1000 PoE+ ports
8 RJ-45 1/2.5/5/XGT PoE+ ports
1 open stacking module slot
1 open uplink module slot
1 Power Supply required (Max 2)
1U - Height

See
Configuration
RULE: 10, 11

Aruba 3810M 48G PoE+ 4SFP+ 680W Switch JL428A
Includes 1 3810M 48 Port PoE+ Switch (JL074A)
48 RJ-45 autosensing 10/100/1000 PoE+ ports
4 fixed 1000/10000 SFP/SFP+ ports
min=0 \ max=4 SFP/SFP+  Transceivers
1 open stacking module slot
Includes 1 uplink module (JL083A)
Includes 1 680W Power Supply (JL086A, Max 2)
1U - Height

See
Configuration
RULE: 1, 3,

4, 10, 11

PDU Cable NA/MEX/TW/JP JL428A #B2B
C15 PDU Jumper Cord (NA/MEX/TW/JP)  

PDU Cable ROW JL428A #B2C
C15 PDU Jumper Cord (ROW)  

High Volt Power Supply to Wall Power Cord JL428A #B2E
NEMA L6-20P Cord (NA/MEX/JP/TW)  

No Power Cord JL428A#AC3
No Localized Power Cord Selected  

Aruba 3810M 48G PoE+ 4SFP+ 1050W Switch JL429A
Includes 1 3810M 48 Port PoE+ Switch (JL074A)
48 RJ-45 autosensing 10/100/1000 PoE+ ports
4 fixed 1000/10000 SFP/SFP+ ports
min=0 \ max=4 SFP/SFP+  Transceivers
1 open stacking module slot
Includes 1 uplink module (JL083A)
Includes 1 1050W Power Supply (JL087A, Max 2)
1U - Height

See
Configuration
RULE: 1, 3,

4, 10, 11

PDU Cable NA/MEX/TW/JP JL429A #B2B
C15 PDU Jumper Cord (NA/MEX/TW/JP)  

PDU Cable ROW JL429A #B2C
C15 PDU Jumper Cord (ROW)  

High Volt Power Supply to Wall Power Cord JL429A #B2E
NEMA L6-20P Cord (NA/MEX/JP/TW)  

No Power Cord JL429A #AC3
No Localized Power Cord Selected  
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Aruba 3810M 24SFP+ 250W Switch JL430A
Includes 1 3810M 16 Port SFP+ Switch (JL075A)
16 fixed 1000/10000 SFP/SFP+ ports
8 port SFP+ ports on the included modules
min=0 \ max=24 SFP/SFP+  Transceivers
1 open stacking module slot
Includes 2 uplink modules (JL083A)
Includes 1 250W Power Supply (JL085A, Max 2)
1U - Height

See
Configuration
RULE: 1, 3,

4, 10, 11

PDU Cable NA/MEX/TW/JP JL430A #B2B
C15 PDU Jumper Cord (NA/MEX/TW/JP)  

PDU Cable ROW JL430A #B2C
C15 PDU Jumper Cord (ROW)  

High Volt Power Supply to Wall Power Cord JL430A #B2E
NEMA L6-20P Cord (NA/MEX/JP/TW)  

No Power Cord JL430A #AC3
No Localized Power Cord Selected  

Configuration Rules:  
RULE 1 The following Transceivers install into this Switch (For the 1000/10000 SFP+ Ports):  

Aruba 1G SFP LC SX 500m OM2 MMF Transceiver J4858D
Aruba 1G SFP LC LX 10km SMF Transceiver J4859D
Aruba 1G SFP LC LH 70km SMF Transceiver J4860D
Aruba 1G SFP RJ45 T 100m Cat5e Transceiver J8177D
Aruba 100M SFP LC FX 2km MMF Transceiver J9054D
Aruba 10G SFP+ LC SR 300m OM3 MMF Transceiver J9150D
Aruba 10G SFP+ LC LR 10km SMF Transceiver J9151E
Aruba 10G SFP+ LC LRM 220m OM2 MMF Transceiver J9152D
Aruba 10G SFP+ LC ER 40km SMF Transceiver J9153D
Aruba 10G SFP+ to SFP+ 1m Direct Attach Copper Cable J9281D
Aruba 10G SFP+ to SFP+ 3m Direct Attach Copper Cable J9283D
Aruba 10G SFP+ to SFP+ 7m Direct Attach Copper Cable J9285D

RULE 3 Localization required on orders without #B2B, #B2C, #B2E options.  
RULE 4 When Switches are Factory Racked with this power supply, Then #B2B, or

#B2C should be the Defaulted Power Cable option on the Power Supplies.
(See Drop down remark in "Internal Power Supplies"? section.)

 

RULE 10 If switch is 0D1 to Racks, then the J9583A#0D1 is also required.   
RULE 11 If the CTO Switch Chassis needs to be racked, Then the CTO Base Model

needs to integrate (with #0D1) to the HPE Network Rack. 
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Remarks: Drop down under power supply should offer the following options and
results:
Switch/Router/Power Supply to PDU Power Cord -  #B2B in North America,
Mexico, Taiwan, and Japan or #B2C ROW. (Watson Default B2B or B2C
for Rack Level CTO)
Switch/Router/Power Supply to Wall Power Cord - Localized Option
(Watson Default for BTO and Box Level CTO)
High Volt Switch/Router/Power Supply to Wall Power Cord -  #B2E Option.
(Offered only in North America, Mexico, Taiwan, and  Japan)
Watson Blue NOTE: It is recommended that both power supplies match for
full redundancy in the case of a fully populated switch, but not required.
Clic UNB - If an option is ordered with #0D1/#B01, then the switch must
have #0D1 option.

 

 

 

 

 

 

Enter the following menu selections as integrated to the CTO Model X switch above if order is
factory built. 

 

Modules  
Stacking Modules  
 System (std 0 // max=1) User Selection (min 0 / max=1) per Chassis  
Aruba 3810M 4-port Stacking Module JL084A

min=1 \ max=4 Stacking cables See
Configuration

RULE: 1
Configuration Rules:  
RULE 1 One of the following Stacking Cables must be selected:  
  Aruba 3800/3810M 0.5m Stacking Cable J9578A
  Aruba 3800/3810M 1m Stacking Cable J9665A
  Aruba 3800/3810M 3m Stacking Cable J9579A
Uplink Modules  
JL071A, JL072A, JL073A, JL074A, JL076A Only System (std 0 // max 1) User Selection (min 0 / max 1) per
Chassis
JL075A Only System (std 0 // max 2) User Selection (min 0 / max 2) per Chassis  
JL428A, JL429A Only System (std 1 // max 1) User Selection (min 0 / max 0) per Chassis  
JL430A Only System (std 2 // max 2) User Selection (min 0 / max 0) per Chassis  
Aruba 3810M/2930M 1-port QSFP+ 40GbE Module JL078A

min=0 \ max=1 QSFP+  Transceiver See
Configuration

RULE: 1
Aruba 3810M 2QSFP+ 40GbE Module JL079A

min=0 \ max=2 QSFP+  Transceiver See
Configuration
RULE: 1, 3

Aruba 3810M 4 HPE Smart Rate PoE+ Module JL081A
4 x HPE Smart Rate Ports  

Aruba 3810M/2930M 4-port 100M/1G/10G SFP+ MACsec Module JL083A
min=0 \ max=4 SFP/SFP+  Transceivers See

Configuration
RULE: 2
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Configuration Rules:  
RULE 1 The following Transceivers install into this Module: (Use #0D1 or #B01 if switch is

CTO) - if applicable
 

HPE X142 40G QSFP+ MPO SR4 Transceiver JH231A
HPE X142 40G QSFP+ LC LR4 SM Transceiver JH232A
HPE X142 40G QSFP+ MPO eSR4 300M Transceiver JH233A
HPE X242 40G QSFP+ to QSFP+ 1m Direct Attach Copper Cable JH234A

HPE X242 40G QSFP+ to QSFP+ 3m Direct Attach Copper Cable JH235A
HPE X242 40G QSFP+ to QSFP+ 5m Direct Attach Copper Cable JH236A
Aruba 40G QSFP+ LC Bidirectional 150m MMF 2-strand Transceiver JL308A

RULE 2 The following Transceivers install into this Switch (For the 1000/10000 SFP+ Ports):

Aruba 1G SFP LC SX 500m OM2 MMF Transceiver J4858D
Aruba 1G SFP LC LX 10km SMF Transceiver J4859D
Aruba 1G SFP LC LH 70km SMF Transceiver J4860D
Aruba 1G SFP RJ45 T 100m Cat5e Transceiver J8177D
Aruba 100M SFP LC FX 2km MMF Transceiver J9054D
Aruba 10G SFP+ LC SR 300m OM3 MMF Transceiver J9150D
Aruba 10G SFP+ LC LR 10km SMF Transceiver J9151E
Aruba 10G SFP+ LC LRM 220m OM2 MMF Transceiver J9152D
Aruba 10G SFP+ LC ER 40km SMF Transceiver J9153D
Aruba 10G SFP+ to SFP+ 1m Direct Attach Copper Cable J9281D
Aruba 10G SFP+ to SFP+ 3m Direct Attach Copper Cable J9283D
Aruba 10G SFP+ to SFP+ 7m Direct Attach Copper Cable J9285D

RULE 3 This module is only available for the following switches:  
Aruba 3810M 48G 1-slot Switch JL072A
Aruba 3810M 48G PoE+ 1-slot Switch JL074A
Aruba 3810M 40G 8 HPE Smart Rate PoE+ 1-slot Switch JL076A

Remarks: Watson Only Blue NOTE Although all 3810M/2930M Switches are
compatible with the 4 Port HPE Smart Rate module, non PoE switches do
not provide PoE power to the HPE Smart Rate Module.

 

Transceivers  
SFP Transceivers  
HPE X121 1G SFP LC LH Transceiver J4860C
HPE X121 1G SFP LC LX Transceiver J4859C
HPE X121 1G SFP LC SX Transceiver J4858C
HPE X122 1G SFP LC BX-D Transceiver J9142B
HPE X122 1G SFP LC BX-U Transceiver J9143B
HPE X111 100M SFP LC FX Transceiver J9054C
Aruba 100M SFP LC FX 2km MMF Transceiver J9054D
Aruba 1G SFP LC SX 500m OM2 MMF Transceiver J4858D
Aruba 1G SFP LC LX 10km SMF Transceiver J4859D
Aruba 1G SFP LC LH 70km SMF Transceiver J4860D
Aruba 1G SFP RJ45 T 100m Cat5e Transceiver J8177D
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SFP+ Transceivers  
HPE X132 10G SFP+ LC ER Transceiver J9153A
HPE X132 10G SFP+ LC SR Transceiver J9150A
HPE X132 10G SFP+ LC LR Transceiver J9151A
HPE X132 10G SFP+ LC LRM Transceiver J9152A
Aruba 10G SFP+ LC SR 300m OM3 MMF Transceiver J9150D
Aruba 10G SFP+ LC LR 10km SMF Transceiver J9151E
Aruba 10G SFP+ LC LRM 220m OM2 MMF Transceiver J9152D
Aruba 10G SFP+ LC ER 40km SMF Transceiver J9153D
Aruba 10G SFP+ to SFP+ 1m Direct Attach Copper Cable J9281D
Aruba 10G SFP+ to SFP+ 3m Direct Attach Copper Cable J9283D
Aruba 10G SFP+ to SFP+ 7m Direct Attach Copper Cable J9285D
HPE X242 10G SFP+ to SFP+ 1m Direct Attach Copper Cable J9281B
HPE X242 10G SFP+ to SFP+ 3m Direct Attach Copper Cable J9283B
HPE X242 10G SFP+ to SFP+ 7m Direct Attach Copper Cable J9285B
QSFP+ Transceivers  
HPE X142 40G QSFP+ MPO SR4 Transceiver JH231A
HPE X142 40G QSFP+ LC LR4 SM Transceiver JH232A
HPE X142 40G QSFP+ MPO eSR4 300M Transceiver JH233A
Aruba 40G QSFP+ LC Bidirectional 150m MMF 2-strand Transceiver JL308A
HPE X242 40G QSFP+ to QSFP+ 1m Direct Attach Copper Cable JH234A
HPE X242 40G QSFP+ to QSFP+ 3m Direct Attach Copper Cable JH235A
HPE X242 40G QSFP+ to QSFP+ 5m Direct Attach Copper Cable JH236A

Internal Power Supplies  
System (std 0 // max=2) User Selection (min 1 / max=2) per Switch  
For JL428A, JL429A, JL430A System (std 1 // max=2) User Selection (min 0 / max=1) per
Switch

 

Aruba X371 12VDC 250W 100-240VAC Power Supply JL085A
  See

Configuration
RULE: 1, 3, 4

PDU Cable NA/MEX/TW/JP JL085A #B2B
C15 PDU Jumper Cord (NA/MEX/TW/JP)  

PDU Cable ROW JL085A #B2C
C15 PDU Jumper Cord (ROW)  

High Volt Power Supply to Wall Power Cord JL085A #B2E
NEMA L6-20P Cord (NA/MEX/JP/TW)  

No Power Cord JL085A #AC3
No Localized Power Cord Selected  

Aruba X372 54VDC 680W 100-240VAC Power Supply JL086A
  See

Configuration
RULE: 2, 3, 4

PDU Cable NA/MEX/TW/JP JL086A #B2B
C15 PDU Jumper Cord (NA/MEX/TW/JP)  

QuickSpecs Aruba 3810M Switch Series

Configuration Information

DA - 15438   Worldwide QuickSpecs — Version 19 — 3/4/2019 Page  16
Anexo 01 ITEM 07 (0592609)         SEI 0008478-63.2018.6.02.8000 / pg. 4764



PDU Cable ROW JL086A #B2C
C15 PDU Jumper Cord (ROW)  

High Volt Power Supply to Wall Power Cord JL086A #B2E
NEMA L6-20P Cord (NA/MEX/JP/TW)  

   
 
No Power Cord JL086A #AC3

No Localized Power Cord Selected  
Aruba X372 54VDC 1050W 110-240VAC Power Supply JL087A

  See
Configuration
RULE: 2, 3, 4

PDU Cable NA/MEX/TW/JP JL087A #B2B
C15 PDU Jumper Cord (NA/MEX/TW/JP)  

PDU Cable ROW JL087A #B2C
C15 PDU Jumper Cord (ROW)  

High Volt Power Supply to Wall Power Cord JL087A #B2E
NEMA L6-20P Cord (NA/MEX/JP/TW)  

No Power Cord JL087A #AC3
No Localized Power Cord Selected  

Configuration Rules:  
RULE 1 If this Power supply is selected, Then  JL071A, JL072A, JL075A, JL430A 

must be the switch its installed into.
 

     
RULE 2 If this Power supply is selected, Then JL073A, JL074A, JL076A, JL428A,

JL429A must be the switch its installed into.
 

     
RULE 3 Localization required on orders without #B2B or #B2C options.  
     
RULE 4 When Switches are Factory Racked with this power supply, Then #B2B, or

#B2C should be the Defaulted Power Cable option on the Power Supplies.
(See Drop down remark in "Internal Power Supplies"? section.)

 

     
Remarks: Drop down under power supply should offer the following options and

results:
Switch/Router/Power Supply to PDU Power Cord -  #B2B in North America,
Mexico, Taiwan, and Japan or #B2C ROW. (Watson Default B2B or B2C
for Rack Level CTO)
Switch/Router/Power Supply to Wall Power Cord - Localized Option
(Watson Default for BTO and Box Level CTO)
High Volt Switch/Router/Power Supply to Wall Power Cord -  #B2E Option.
(Offered only in North America, Mexico, Taiwan, and  Japan)
No Localized Power Cord Selected - #AC3 Option

 

  Watson Blue NOTE: It is recommended that both power supplies match for
full redundancy in the case of a fully populated switch, but not required.
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Cables  
Stacking Cables  
(std 0 // max 99) User Selection (min 0 // max 99) per switch  
Aruba 3800/3810M 0.5m Stacking Cable J9578A
Aruba 3800/3810M 1m Stacking Cable J9665A
Aruba 3800/3810M 3m Stacking Cable J9579A
Console Cables  
(std 0 // max 99) User Selection (min 0 // max 99) per switch  
Aruba X2C2 RJ45 to DB9 Console Cable JL448A
Multi-Mode Cables  
(std 0 // max 99) User Selection (min 0 // max 99) per switch  
HPE LC to LC Multi-mode OM3 2-Fiber 0.5m 1-Pack Fiber Optic Cable AJ833A
HPE LC to LC Multi-mode OM3 2-Fiber 1.0m 1-Pack Fiber Optic Cable AJ834A
HPE LC to LC Multi-mode OM3 2-Fiber 2.0m 1-Pack Fiber Optic Cable AJ835A
HPE LC to LC Multi-mode OM3 2-Fiber 5.0m 1-Pack Fiber Optic Cable AJ836A
HPE LC to LC Multi-mode OM3 2-Fiber 15.0m 1-Pack Fiber Optic Cable AJ837A
HPE LC to LC Multi-mode OM3 2-Fiber 30.0m 1-Pack Fiber Optic Cable AJ838A
HPE LC to LC Multi-mode OM3 2-Fiber 50.0m 1-Pack Fiber Optic Cable AJ839A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 1m Cable QK732A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 2m Cable QK733A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 5m Cable QK734A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 15m Cable QK735A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 30m Cable QK736A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 50m Cable QK737A

Switch Enclosure Options  
Rack Mount Kit  
(std 0 // max 1) User Selection (min 0 // max 1) per switch  
HPE X410 1U Universal 4-post Rackmount Kit J9583A

  See
Configuration

RULE: 1

Configuration Rules:  
RULE 1 If this switch is factory installed in HPE Network Racks, Then the

J9583A#0D1 is required.
 

Fan Tray  
Aruba 3810 Switch Fan Tray JL088A

This is a Spare Only  

QuickSpecs Aruba 3810M Switch Series

Configuration Information

DA - 15438   Worldwide QuickSpecs — Version 19 — 3/4/2019 Page  18
Anexo 01 ITEM 07 (0592609)         SEI 0008478-63.2018.6.02.8000 / pg. 4766



Aruba 3810M 24G 1-slot Switch (JL071A)

Included
accessories

1 Aruba 3810 Switch Fan Tray (JL088A)

I/O ports and slots 24 RJ-45 autosensing 10/100/1000 ports (IEEE 802.3 Type 10BASE-T, IEEE 802.3u
Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T); Duplex: 10BASE-
T/100BASE-TX: half or full; 1000BASE-T: full only; Ports 1 - 24 support MACSec
Supports a maximum of 4 SFP+ ports or 1 40GbE ports, with optional module

1 open module slot

Supports a maximum of 4 SFP+ ports or 1 40GbE ports, with optional module

Additional ports and
slots

1 stacking module slot

1 RJ-45 serial console port

1 RJ-45 out-of-band management port

1 dual-personality (RJ-45 or USB micro-B)

Power supplies 2 power supply slots
1 minimum power supply required (ordered separately)

Fan tray includes: 1 x JL088A
1 fan tray slot
Switch ships with 1 JL088A fan tray installed. Spares ordered separately.

Physical
characteristics

Dimensions 17.42(w) x 16.98(d) x 1.73(h) in (44.25 x 43.13 x 4.39 cm)
(1U height)

Weight 12.76 lb (5.79 kg)

Memory and
processor

P2020 Dual Core @ 1.2 GHz, 4 GB DDR3 SDRAM, 1 GB SD Card

Dual ARM Coretex A9 @ 1 GHz, 2 GB DDR3 SDRAM; Packet buffer size: 13.5 MB
Internal

Mounting and
enclosure

Mounts in an EIA-standard 19 in. telco rack or equipment cabinet (hardware
included); Horizontal surface mounting only

Performance IPv6 Ready Certified  

1000 Mb Latency < 2.8 µs (FIFO 64-byte packets)

10 Gbps Latency < 1.8 µs (FIFO 64-byte packets)

40 Gbps Latency < 1.5 µs (FIFO 64-byte packets)

Throughput up to 95.2 Mpps (64-byte packets)

Routing/Switching
capacity

160 Gbps

Switch fabric speed 169 Gbps

Routing table size 10000 entries (IPv4), 5000 entries (IPv6)

MAC address table
size

64000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C)
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Nonoperating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 39 dB, Pressure: 22.8 dB

Primary Airflow
Direction

Front-to-side and front-to-rear

 
 
Electrical
Characteristics

Frequency 50/60Hz

Voltage JL085A PSU: 100-127/200-240 VAC 

Current JL085A PSU (Each): 1A/0.5A 

Max/Idle Power
Rating (Switch+ 1
PSU)

JL078A: 4W/3W
JL079A: 7W/3W
JL081A: 4W/3W
JL083A: 11W/4W

Maximum Heat
Dissipation *(Max
Case)

310.31 

PoE Power (Max
Possible)

N/A

Notes Idle power is the actual power consumption of the device with
no ports connected. Maximum power rating and maximum
heat dissipation are the worst case theoretical maximum
numbers provide for planning the infrastructure with fully
loaded PoE (if equipped), 100% traffic, all ports plugged in,
and all modules populated. This is a modular product.
 
*Switch + 2 power supplies + one JL083A Uplink. For most
accurate heat dissipation, idle and max power for any
combination of chassis and accessories, please consult
configurator. 

Safety EN 60950/IEC 60950; UL 60950; UL 60950-1; CAN/CSA 22.2 No. 60950; EN 60825;
CSA 22.2 60950-1; EN62479:2010; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; EN 62368-1, Ed. 2; IEC 60950-1:2005 Ed.2; Am
1:2009+A2:2013; IEC 60825:2007; EN60850-1:2007 / IEC 60825-1: 2007 Class1
Class 1 Laser Products / Laser Klasse 1; UL 62368-1 Ed.2

Emissions FCC Class A; VCCI Class A; EN 55022/CISPR 22 Class A; EN 60950-1:2006
+A11:2009 +A1:2010 +A12:2011+A2:2013

Immunity Generic EN55022: 2010

EN EN55024: 2010

ESD IEC 61000-4-2

Radiated IEC 61000-4-3; 3 V/m

EFT/Burst IEC 61000-4-4; 1.0 kV (power line), 0.5 kV (signal line)

Surge IEC 61000-4-5; 1 kV/2 kV AC

Conducted IEC 61000-4-6; 3 V

Power frequency
magnetic field

IEC 61000-4-8; 1 A/m, 50 or 60 Hz
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Voltage dips and
interruptions

IEC 61000-4-11; >95% reductions, 0.5 period; 30% reduction,
25 periods

Harmonics EN61000-3-2:2006 +A1:2009 +A2:2009 Class A

Flicker EN61000-3-3:2008

Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; Out-of-band
management (RJ-45 Ethernet); In-line and out-of-band; Out-of-band management
(serial RS-232c or micro usb)

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services for
details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
 
 
Aruba 3810M 48G 1-slot Switch (JL072A)

Included
accessories

1 Aruba 3810 Switch Fan Tray (JL088A)

I/O ports and slots 48 RJ-45 autosensing 10/100/1000 ports (IEEE 802.3 Type 10BASE-T, IEEE 802.3u
Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T); Duplex: 10BASE-
T/100BASE-TX: half or full; 1000BASE-T: full only; Ports 1 - 48 support MACSec

1 open module slot

Supports a maximum of 4 SFP+ ports or 2 40GbE ports, with optional module

Additional ports and
slots

1 stacking module slot

1 RJ-45 serial console port

1 RJ-45 out-of-band management port

1 dual-personality (RJ-45 or USB micro-B)

Power supplies 2 power supply slots
1 minimum power supply required (ordered separately)

Fan tray includes: 1 x JL088A
1 fan tray slot
Switch ships with 1 JL088A fan tray installed. Spares ordered separately.

Physical
characteristics

Dimensions 17.42(w) x 16.98(d) x 1.73(h) in (44.25 x 43.13 x 4.39 cm)
(1U height)

Weight 13.20 lb (5.99 kg)

Memory and
processor

P2020 Dual Core @ 1.2 GHz, 4 GB DDR3 SDRAM, 1 GB SD Card

Dual ARM Coretex A9 @ 1 GHz, 2 GB DDR3 SDRAM; Packet buffer size: 13.5 MB
Internal

Mounting and
enclosure

Mounts in an EIA-standard 19 in. telco rack or equipment cabinet (hardware
included); Horizontal surface mounting only

Performance IPv6 Ready Certified  

1000 Mb Latency < 2.8 µs (FIFO 64-byte packets)

10 Gbps Latency < 1.8 µs (FIFO 64-byte packets)

40 Gbps Latency < 1.5 µs (FIFO 64-byte packets)

Throughput up to 190.5 Mpps (64-byte packets)
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Routing/Switching
capacity

320 Gbps

Switch fabric speed 338 Gbps

Routing table size 10000 entries (IPv4), 5000 entries (IPv6)

MAC address table
size

64000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Nonoperating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 38 dB, Pressure: 21.8 dB

Primary Airflow
Direction

Front-to-side and front-to-rear

 
 
 
Electrical
Characteristics

Frequency 50/60Hz

Voltage JL085A PSU: 100-127/200-240 VAC

Current JL085A PSU (Each): 1A/0.5A

Max/Idle Power
Rating (Switch+ 1
PSU)

95W/78W

Second PSU Power
Adder

10W

Max/Idle Uplink
Power Adder

JL078A: 4W/3W
JL079A: 7W/3W
JL081A: 4W/3W
JL083A: 11W/4W

Maximum Heat
Dissipation *(Max
Case)

395.56

PoE Power (Max
Possible)

N/A

Notes Idle power is the actual power consumption of the device with
no ports connected. Maximum power rating and maximum
heat dissipation are the worst case theoretical maximum
numbers provide for planning the infrastructure with fully
loaded PoE (if equipped), 100% traffic, all ports plugged in,
and all modules populated. This is a modular product.
 
*Switch + 2 power supplies + one JL083A Uplink. For most
accurate heat dissipation, idle and max power for any
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combination of chassis and accessories, please consult
configurator.

Safety EN 60950/IEC 60950; UL 60950; UL 60950-1; CAN/CSA 22.2 No. 60950; EN 60825;
CSA 22.2 60950-1; EN62479:2010; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; EN 62368-1, Ed. 2; IEC 60950-1:2005 Ed.2; Am
1:2009+A2:2013; IEC 60825:2007; EN60850-1:2007 / IEC 60825-1: 2007 Class1
Class 1 Laser Products / Laser Klasse 1; UL 62368-1 Ed.2

Emissions FCC Class A; VCCI Class A; EN 55022/CISPR 22 Class A; EN 60950-1:2006
+A11:2009 +A1:2010 +A12:2011+A2:2013

Immunity Generic EN55022: 2010

EN EN55024: 2010

ESD IEC 61000-4-2

Radiated IEC 61000-4-3; 3 V/m

EFT/Burst IEC 61000-4-4; 1.0 kV (power line), 0.5 kV (signal line)

Surge IEC 61000-4-5; 1 kV/2 kV AC

Conducted IEC 61000-4-6; 3 V

Power frequency
magnetic field

IEC 61000-4-8; 1 A/m, 50 or 60 Hz

Voltage dips and
interruptions

IEC 61000-4-11; >95% reductions, 0.5 period; 30% reduction,
25 periods

Harmonics EN61000-3-2:2006 +A1:2009 +A2:2009 Class A

Flicker EN61000-3-3:2008

 
 
 
Management Aruba AirWave Network Management; IMC - Intelligent Management Center;

Command-line interface; Web browser; Configuration menu; Out-of-band
management (RJ-45 Ethernet); In-line and out-of-band; Out-of-band management
(serial RS-232c or micro usb)

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services for
details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

Aruba 3810M 24G PoE+ 1-slot Switch (JL073A)

Included
accessories

1 Aruba 3810 Switch Fan Tray (JL088A)

I/O ports and slots 24 RJ-45 autosensing 10/100/1000 PoE+ ports (IEEE 802.3 Type 10BASE-T, IEEE
802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T, IEEE 802.3at PoE+);
Duplex: 10BASE-T/100BASE-TX: half or full; 1000BASE-T: full only; Ports 1 - 24
support MACSec

1 open module slot

Supports a maximum of 4 SFP+ ports or 1 40GbE ports, with optional module

Additional ports and
slots

1 stacking module slot

1 RJ-45 serial console port

1 RJ-45 out-of-band management port

1 dual-personality (RJ-45 or USB micro-B)
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Power supplies 2 power supply slots
1 minimum power supply required (ordered separately)

Fan tray includes: 1 x JL088A
1 fan tray slot
Switch ships with 1 JL088A fan tray installed. Spares ordered separately

Physical
characteristics

Dimensions 17.42(w) x 16.98(d) x 1.73(h) in (44.25 x 43.13 x 4.39 cm) (1U
height)

Weight 13.02 lb (5.91 kg)

Memory and
processor

P2020 Dual Core @ 1.2 GHz, 4 GB DDR3 SDRAM, 1 GB SD Card

Dual ARM Coretex A9 @ 1 GHz, 2 GB DDR3 SDRAM; Packet buffer size: 13.5 MB
Internal

Mounting and
enclosure

Mounts in an EIA-standard 19 in. telco rack or equipment cabinet (hardware
included); Horizontal surface mounting only

Performance IPv6 Ready Certified  

1000 Mb Latency < 2.8 µs (FIFO 64-byte packets)

10 Gbps Latency < 1.8 µs (FIFO 64-byte packets)

40 Gbps Latency < 1.5 µs (FIFO 64-byte packets)

Throughput up to 95.2 Mpps (64-byte packets)

Routing/Switching
capacity

160 Gbps

Switch fabric speed 169 Gbps

Routing table size 10000 entries (IPv4), 5000 entries (IPv6)

MAC address table
size

64000 entries

 
Environment Operating

temperature
32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Nonoperating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 44 dB, Pressure: 27.6 dB

Primary Airflow
Direction

Front-to-side and front-to-rear

Electrical
Characteristics

Frequency 50/60Hz

Voltage JL086A PSU: 100-127/200-240 VAC
JL087A PSU: 110-127/200-240 VAC

Current JL086A PSU (Each): 5A/2.5A
JL087A PSU (Each): 8.5A/5A

Max/Idle Power
Rating (Switch+ 1
PSU)

95W/82W
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Second PSU Power
Adder

10W

Max/Idle Uplink
Power Adder

JL078A: 4W/3W
JL079A: 7W/3W
JL081A: 4W/3W
JL083A: 11W/4W

Maximum Heat
Dissipation *(Max
Case)

395.56

PoE Power (Max
Possible)

840W

Notes Idle power is the actual power consumption of the device with
no ports connected. Maximum power rating and maximum
heat dissipation are the worst case theoretical maximum
numbers provide for planning the infrastructure with fully
loaded PoE (if equipped), 100% traffic, all ports plugged in,
and all modules populated. This is a modular product.
 
*Switch + 2 power supplies + one JL083A Uplink. For most
accurate heat dissipation, idle and max power for any
combination of chassis and accessories, please consult
configurator.

Safety EN 60950/IEC 60950; UL 60950; UL 60950-1; CAN/CSA 22.2 No. 60950; EN 60825;
CSA 22.2 60950-1; EN62479:2010; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; EN 62368-1, Ed. 2; IEC 60950-1:2005 Ed.2; Am
1:2009+A2:2013; IEC 60825:2007; EN60850-1:2007 / IEC 60825-1: 2007 Class1
Class 1 Laser Products / Laser Klasse 1; UL 62368-1 Ed.2

Emissions FCC Class A; VCCI Class A; EN 55022/CISPR 22 Class A; EN 60950-1:2006
+A11:2009 +A1:2010 +A12:2011+A2:2013

 
 
 
Immunity Generic EN55022: 2010

EN EN55024: 2010

ESD IEC 61000-4-2

Radiated IEC 61000-4-3; 3 V/m

EFT/Burst IEC 61000-4-4; 1.0 kV (power line), 0.5 kV (signal line)

Surge IEC 61000-4-5; 1 kV/2 kV AC

Conducted IEC 61000-4-6; 3 V

Power frequency
magnetic field

IEC 61000-4-8; 1 A/m, 50 or 60 Hz

Voltage dips and
interruptions

IEC 61000-4-11; >95% reductions, 0.5 period; 30% reduction,
25 periods

Harmonics EN61000-3-2:2006 +A1:2009 +A2:2009 Class A

Flicker EN61000-3-3:2008
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Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; Out-of-band
management (RJ-45 Ethernet); In-line and out-of-band; Out-of-band management
(serial RS-232c or micro usb)

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services for
details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

Aruba 3810M 48G PoE+ 1-slot Switch (JL074A)

Included
accessories

1 Aruba 3810 Switch Fan Tray (JL088A)

I/O ports and slots 48 RJ-45 autosensing 10/100/1000 PoE+ ports (IEEE 802.3 Type 10BASE-T, IEEE
802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T, IEEE 802.3at PoE+);
Duplex: 10BASE-T/100BASE-TX: half or full; 1000BASE-T: full only; Ports 1 - 48
support MACSec

1 open module slot

Supports a maximum of 4 SFP+ ports or 2 40GbE ports, with optional module

Additional ports and
slots

1 stacking module slot

1 RJ-45 serial console port

1 RJ-45 out-of-band management port

1 dual-personality (RJ-45 or USB micro-B)

Power supplies 2 power supply slots
1 minimum power supply required (ordered separately)

Fan tray includes: 1 x JL088A
1 fan tray slot
Switch ships with 1 JL088A fan tray installed. Spares ordered separately.

Physical
characteristics

Dimensions 17.42(w) x 16.98(d) x 1.73(h) in (44.25 x 43.13 x 4.39 cm) (1U
height)

Weight 13.62 lb (6.18 kg)

Memory and
processor

P2020 Dual Core @ 1.2 GHz, 4 GB DDR3 SDRAM, 1 GB SD Card

Dual ARM Coretex A9 @ 1 GHz, 2 GB DDR3 SDRAM; Packet buffer size: 13.5 MB
Internal

Mounting and
enclosure

Mounts in an EIA-standard 19 in. telco rack or equipment cabinet (hardware
included); Horizontal surface mounting only

 
 
 
Performance IPv6 Ready Certified  

1000 Mb Latency < 2.8 µs (FIFO 64-byte packets)

10 Gbps Latency < 1.8 µs (FIFO 64-byte packets)

40 Gbps Latency < 1.5 µs (FIFO 64-byte packets)

Throughput up to 190.5 Mpps (64-byte packets)

Routing/Switching
capacity

320 Gbps

Switch fabric speed 338 Gbps

Routing table size 10000 entries (IPv4), 5000 entries (IPv6)
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MAC address table
size

64000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Nonoperating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 47 dB, Pressure: 29.4 dB

 
Primary Airflow
Direction

Front-to-side and front-to-rear

Electrical
Characteristics

Frequency 50/60Hz

Voltage JL086A PSU: 100-127/200-240 VAC
JL087A PSU: 110-127/200-240 VAC

Current JL086A PSU (Each): 5A/2.5A
JL087A PSU (Each): 8.5A/5A

Max/Idle Power
Rating (Switch+ 1
PSU)

135W/103W

Second PSU Power
Adder

10W

Max/Idle Uplink
Power Adder

JL078A: 4W/3W
JL079A: 7W/3W
JL081A: 4W/3W
JL083A: 11W/4W

Maximum Heat
Dissipation *(Max
Case)

531.96

PoE Power (Max
Possible)

1440W

Notes Idle power is the actual power consumption of the device with
no ports connected. Maximum power rating and maximum
heat dissipation are the worst case theoretical maximum
numbers provide for planning the infrastructure with fully
loaded PoE (if equipped), 100% traffic, all ports plugged in,
and all modules populated. This is a modular product.
 
*Switch + 2 power supplies + one JL083A Uplink. For most
accurate heat dissipation, idle and max power for any
combination of chassis and accessories, please consult
configurator.
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Safety EN 60950/IEC 60950; UL 60950; UL 60950-1; CAN/CSA 22.2 No. 60950; EN 60825;
CSA 22.2 60950-1; EN62479:2010; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; EN 62368-1, Ed. 2; IEC 60950-1:2005 Ed.2; Am
1:2009+A2:2013; IEC 60825:2007; EN60850-1:2007 / IEC 60825-1: 2007 Class1
Class 1 Laser Products / Laser Klasse 1; UL 62368-1 Ed.2

Emissions FCC Class A; VCCI Class A; EN 55022/CISPR 22 Class A; EN 60950-1:2006
+A11:2009 +A1:2010 +A12:2011+A2:2013

Immunity Generic EN55022: 2010

EN EN55024: 2010

ESD IEC 61000-4-2

Radiated IEC 61000-4-3; 3 V/m

EFT/Burst IEC 61000-4-4; 1.0 kV (power line), 0.5 kV (signal line)

Surge IEC 61000-4-5; 1 kV/2 kV AC

Conducted IEC 61000-4-6; 3 V

Power frequency
magnetic field

IEC 61000-4-8; 1 A/m, 50 or 60 Hz

Voltage dips and
interruptions

IEC 61000-4-11; >95% reductions, 0.5 period; 30% reduction,
25 periods

Harmonics EN61000-3-2:2006 +A1:2009 +A2:2009 Class A

Flicker EN61000-3-3:2008

Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; Out-of-band
management (RJ-45 Ethernet); In-line and out-of-band; Out-of-band management
(serial RS-232c or micro usb)

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services for
details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

Aruba 3810M 16SFP+ 2-slot Switch (JL075A)

Included
accessories

1 Aruba 3810 Switch Fan Tray (JL088A)

I/O ports and slots 16 SFP+ fixed 1000/10000 SFP+ ports; Duplex: 100BASE-TX: half or full;
1000BASE-T: full only; Ports 1 - 16 support MACSec

2 open module slots

Supports a maximum of 8 SFP+ ports or 2 40GbE ports, with optional module

Additional ports and
slots

1 stacking module slot

1 RJ-45 serial console port

1 RJ-45 out-of-band management port

1 dual-personality (RJ-45 or USB micro-B)

Power supplies 2 power supply slots
1 minimum power supply required (ordered separately)

Fan tray includes: 1 x JL088A
1 fan tray slot
Switch ships with 1 JL088A fan tray installed. Spares ordered separately.
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Physical
characteristics

Dimensions 17.42(w) x 16.98(d) x 1.73(h) in (44.25 x 43.13 x 4.39 cm) (1U
height)

Weight 13.28 lb (6.02 kg)

Memory and
processor

P2020 Dual Core @ 1.2 GHz, 4 GB DDR3 SDRAM, 1 GB SD Card

Dual ARM Coretex A9 @ 1 GHz, 2 GB DDR3 SDRAM; Packet buffer size: 13.5 MB
Internal

 
 
Mounting and
enclosure

Mounts in an EIA-standard 19 in. telco rack or equipment cabinet (hardware
included); Horizontal surface mounting only

Performance IPv6 Ready Certified  

1000 Mb Latency < 2.8 µs (FIFO 64-byte packets)

10 Gbps Latency < 1.8 µs (FIFO 64-byte packets)

40 Gbps Latency < 1.5 µs (FIFO 64-byte packets)

Throughput up to 285.7 Mpps (64-byte packets)

Routing/Switching
capacity

480 Gbps

Switch fabric speed 508 Gbps

Routing table size 10000 entries (IPv4), 5000 entries (IPv6)

MAC address table
size

64000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Nonoperating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 39 dB, Pressure: 22.3 dB

 
Primary Airflow
Direction

Front-to-side and front-to-rear

Electrical
Characteristics

Frequency 50/60Hz

Voltage JL085A PSU: 100-127/200-240 VAC

Current JL085A PSU (Each): 1A/0.5A

Max/Idle Power
Rating (Switch+ 1
PSU)

120W/95W

Second PSU Power
Adder

10W

Max/Idle Uplink
Power Adder

JL078A: 4W/3W
JL079A: 7W/3W
JL081A: 4W/3W
JL083A: 11W/4W
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Maximum Heat
Dissipation *(Max
Case)

480.81

PoE Power (Max
Possible)

N/A

Notes Idle power is the actual power consumption of the device with
no ports connected. Maximum power rating and maximum
heat dissipation are the worst case theoretical maximum
numbers provide for planning the infrastructure with fully
loaded PoE (if equipped), 100% traffic, all ports plugged in,
and all modules populated. This is a modular product.
 
*Switch + 2 power supplies + one JL083A Uplink. For most
accurate heat dissipation, idle and max power for any
combination of chassis and accessories, please consult
configurator

 
Safety EN 60950/IEC 60950; UL 60950; UL 60950-1; CAN/CSA 22.2 No. 60950; EN 60825;

CSA 22.2 60950-1; EN62479:2010; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; EN 62368-1, Ed. 2; IEC 60950-1:2005 Ed.2; Am
1:2009+A2:2013; IEC 60825:2007; EN60850-1:2007 / IEC 60825-1: 2007 Class1
Class 1 Laser Products / Laser Klasse 1; UL 62368-1 Ed.2

Emissions FCC Class A; VCCI Class A; EN 55022/CISPR 22 Class A; EN 60950-1:2006
+A11:2009 +A1:2010 +A12:2011+A2:2013

Immunity Generic EN55022: 2010

EN EN55024: 2010

ESD IEC 61000-4-2

Radiated IEC 61000-4-3; 3 V/m

EFT/Burst IEC 61000-4-4; 1.0 kV (power line), 0.5 kV (signal line)

Surge IEC 61000-4-5; 1 kV/2 kV AC

Conducted IEC 61000-4-6; 3 V

Power frequency
magnetic field

IEC 61000-4-8; 1 A/m, 50 or 60 Hz

Voltage dips and
interruptions

IEC 61000-4-11; >95% reductions, 0.5 period; 30% reduction,
25 periods

Harmonics EN61000-3-2:2006 +A1:2009 +A2:2009 Class A

Flicker EN61000-3-3:2008

Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; Out-of-band
management (RJ-45 Ethernet); In-line and out-of-band; Out-of-band management
(serial RS-232c or micro usb)

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services for
details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

Aruba 3810M 40G 8 HPE Smart Rate PoE+ 1-slot Switch (JL076A)
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Included
accessories

1 Aruba 3810 Switch Fan Tray (JL088A)

I/O ports and slots 40 RJ-45 autosensing 10/100/1000 PoE+ ports (IEEE 802.3 Type 10BASE-T, IEEE
802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T, IEEE 802.3at PoE+);
Duplex: 10BASE-T/100BASE-TX: half or full; 1000BASE-T: full only; Ports 1 - 40
support MACSec

8 RJ-45 HPE Smart Rate Multi-Gigabit ports; Ports 1 - 8 support MACSec

1 open module slot

Supports a maximum of 4 SFP+ ports or 2 40GbE ports, with optional module

Additional ports and
slots

1 stacking module slot

1 RJ-45 serial console port

1 RJ-45 out-of-band management port

1 dual-personality (RJ-45 or USB micro-B)

Power supplies 2 power supply slots
1 minimum power supply required (ordered separately)

Fan tray includes: 1 x JL088A
1 fan tray slot
Switch ships with 1 JL088A fan tray installed. Spares ordered separately.

 

Physical
characteristics

Dimensions 17.42(w) x 16.98(d) x 1.73(h) in (44.25 x 43.13 x 4.39 cm)
(1U height)

 

Weight 13.61 lb (6.17 kg)  

 
 
 
Memory and
processor

P2020 Dual Core @ 1.2 GHz, 4 GB DDR3 SDRAM, 1 GB SD Card

Dual ARM Coretex A9 @ 1 GHz, 2 GB DDR3 SDRAM; Packet buffer size: 13.5 MB
Internal

Mounting and
enclosure

Mounts in an EIA-standard 19 in. telco rack or equipment cabinet (hardware
included); Horizontal surface mounting only

Performance IPv6 Ready Certified  

1000 Mb Latency < 2.8 µs (FIFO 64-byte packets)

10 Gbps Latency < 1.8 µs (FIFO 64-byte packets)

40 Gbps Latency < 1.5 µs (FIFO 64-byte packets)

Throughput up to 273.8 Mpps (64-byte packets)

Routing/Switching
capacity

480 Gbps

Switch fabric speed 508 Gbps

Routing table size 10000 entries (IPv4), 5000 entries (IPv6)

MAC address table
size

64000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C)

QuickSpecs Aruba 3810M Switch Series

Technical Specifications

DA - 15438   Worldwide QuickSpecs — Version 19 — 3/4/2019 Page  31
Anexo 01 ITEM 07 (0592609)         SEI 0008478-63.2018.6.02.8000 / pg. 4779



Nonoperating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 49 dB, Pressure: 31.5 dB

 
Primary Airflow
Direction

Front-to-side and front-to-rear

 
 
 
Electrical
Characteristics

Frequency 50/60Hz

Voltage JL086A PSU: 100-127/200-240 VAC
JL087A PSU: 110-127/200-240 VAC

Current JL086A PSU (Each): 5A/2.5A
JL087A PSU (Each): 8.5A/5A

Max/Idle Power
Rating (Switch+ 1
PSU)

190W/158W

Second PSU Power
Adder

10W

Max/Idle Uplink
Power Adder

JL078A: 4W/3W
JL079A: 7W/3W
JL081A: 4W/3W
JL083A: 11W/4W

Maximum Heat
Dissipation *(Max
Case)

719.51

PoE Power (Max
Possible)

1440W

Notes Idle power is the actual power consumption of the device with
no ports connected. Maximum power rating and maximum
heat dissipation are the worst case theoretical maximum
numbers provide for planning the infrastructure with fully
loaded PoE (if equipped), 100% traffic, all ports plugged in,
and all modules populated. This is a modular product.
 
*Switch + 2 power supplies + one JL083A Uplink. For most
accurate heat dissipation, idle and max power for any
combination of chassis and accessories, please consult
configurator.

Safety EN 60950/IEC 60950; UL 60950; UL 60950-1; CAN/CSA 22.2 No. 60950; EN 60825;
CSA 22.2 60950-1; EN62479:2010; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; EN 62368-1, Ed. 2; IEC 60950-1:2005 Ed.2; Am
1:2009+A2:2013; IEC 60825:2007; EN60850-1:2007 / IEC 60825-1: 2007 Class1
Class 1 Laser Products / Laser Klasse 1; UL 62368-1 Ed.2

Emissions FCC Class A; VCCI Class A; EN 55022/CISPR 22 Class A; EN 60950-1:2006
+A11:2009 +A1:2010 +A12:2011+A2:2013

Immunity Generic EN55022: 2010

EN EN55024: 2010

ESD IEC 61000-4-2
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Radiated IEC 61000-4-3; 3 V/m

EFT/Burst IEC 61000-4-4; 1.0 kV (power line), 0.5 kV (signal line)

Surge IEC 61000-4-5; 1 kV/2 kV AC

Conducted IEC 61000-4-6; 3 V

Power frequency
magnetic field

IEC 61000-4-8; 1 A/m, 50 or 60 Hz

Voltage dips and
interruptions

IEC 61000-4-11; >95% reductions, 0.5 period; 30% reduction,
25 periods

Harmonics EN61000-3-2:2006 +A1:2009 +A2:2009 Class A

Flicker EN61000-3-3:2008

 
 
 
Management Aruba AirWave Network Management; IMC - Intelligent Management Center;

Command-line interface; Web browser; Configuration menu; Out-of-band
management (RJ-45 Ethernet); In-line and out-of-band; Out-of-band management
(serial RS-232c or micro usb)

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services for
details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
Aruba 3810M 48G PoE+ 4SFP+ 680W Switch (JL428A)

Included
accessories

1 Aruba 3810M 48G PoE+ 1-slot Switch (JL074A)
1 Aruba X372 54VDC 680W Power Supply (JL086A)
1 Aruba 3810M 4SFP+ Module (JL083A)
1 Aruba 3810 Switch Fan Tray (JL088A)

I/O ports and slots 48 RJ-45 autosensing 10/100/1000 PoE+ ports (IEEE 802.3 Type 10BASE-T, IEEE
802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T, IEEE 802.3at PoE+);
Duplex: 10BASE-T/100BASE- TX: half or full; 1000BASE-T: full only; Ports 1 - 48
support MACSec

1 open module slot

Supports a maximum of 4 SFP+ ports or 2 40GbE ports, with optional module

Additional ports and
slots

1 stacking module slot
1 RJ-45 serial console port
1 RJ-45 out-of-band management port
1 dual-personality (RJ-45 or USB micro-B)

Power supplies 2 power supply slots
1 minimum power supply required (ordered separately)

Fan tray includes: 1 x JL088A
1 fan tray slot
Switch ships with 1 JL088A fan tray installed. Spares ordered separately.

Physical
characteristics

Dimensions 17.42(w) x 16.98(d) x 1.73(h) in (44.25 x 43.13 x 4.39 cm) (1U
height)

Weight 13.62 lb (6.18 kg)
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Memory and
processor

P2020 Dual Core @ 1.2 GHz, 4 GB DDR3 SDRAM, 1 GB SD Card

Dual ARM Coretex A9 @ 1 GHz, 2 GB DDR3 SDRAM; Packet buffer size: 13.5 MB
Internal

Mounting and
enclosure

Mounts in an EIA-standard 19 in. telco rack or equipment cabinet (hardware
included); Horizontal surface mounting only

Performance IPv6 Ready Certified  

1000 Mb Latency < 2.8 µs (FIFO 64-byte packets)

10 Gbps Latency < 1.8 µs (FIFO 64-byte packets)

40 Gbps Latency < 1.5 µs (FIFO 64-byte packets)

Throughput up to 190.5 Mpps (64-byte packets)

Routing/Switching
capacity

320 Gbps

Switch fabric speed 338 Gbps

Routing table size 10000 entries (IPv4), 5000 entries (IPv6)

MAC address table
size

64000 entries

 
 
 
Environment Operating

temperature
32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Nonoperating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 47 dB, Pressure: 29.4 dB

Primary Airflow
Direction

Front-to-side and front-to-rear

Electrical
Characteristics

Frequency 50/60Hz

Voltage JL085A PSU: 100-127/200-240 VAC

Current JL085A PSU (Each): 1A/0.5A

Max/Idle Power
Rating (Switch+ 1
PSU)

70W/55W

Second PSU Power
Adder

10W 

Max/Idle Uplink
Power Adder

JL078A: 4W/3W
JL079A: 7W/3W
JL081A: 4W/3W
JL083A: 11W/4W 
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Maximum Heat
Dissipation *(Max
Case)

310.31

PoE Power (Max
Possible)

N/A

Notes Idle power is the actual power consumption of the device with
no ports connected. Maximum power rating and maximum
heat dissipation are the worst case theoretical maximum
numbers provide for planning the infrastructure with fully
loaded PoE (if equipped), 100% traffic, all ports plugged in,
and all modules populated. This is a modular product.
 
*Switch + 2 power supplies + one JL083A Uplink. For most
accurate heat dissipation, idle and max power for any
combination of chassis and accessories, please consult
configurator.

Safety EN 60950/IEC 60950; UL 60950; UL 60950-1; CAN/CSA 22.2 No. 60950; EN 60825;
CSA 22.2 60950-1; EN62479:2010; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; EN 62368-1, Ed. 2; IEC 60950-1:2005 Ed.2; Am
1:2009+A2:2013; IEC 60825:2007; EN60850-1:2007 / IEC 60825-1: 2007 Class1
Class 1 Laser Products / Laser Klasse 1; UL 62368-1 Ed.2

Emissions FCC Class A; VCCI Class A; EN 55022/CISPR 22 Class A; EN 60950-1:2006
+A11:2009 +A1:2010 +A12:2011+A2:2013

 
 
 
Immunity Generic EN55022: 2010

EN EN55024: 2010

ESD IEC 61000-4-2

Radiated IEC 61000-4-3; 3 V/m

EFT/Burst IEC 61000-4-4; 1.0 kV (power line), 0.5 kV (signal line)

Surge IEC 61000-4-5; 1 kV/2 kV AC

Conducted IEC 61000-4-6; 3 V

Power frequency
magnetic field

IEC 61000-4-8; 1 A/m, 50 or 60 Hz

Voltage dips and
interruptions

IEC 61000-4-11; >95% reductions, 0.5 period; 30% reduction,
25 periods

Harmonics EN61000-3-2:2006 +A1:2009 +A2:2009 Class A

Flicker EN61000-3-3:2008

Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; Out-of-band
management (RJ-45 Ethernet); In-line and out-of- band; Out-of-band management
(serial RS-232c or micro usb)

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services for
details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.
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Aruba 3810M 48G PoE+ 4SFP+ 1050W Switch (JL429A)

Included
accessories

1 Aruba 3810M 48G PoE+ 1-slot Switch (JL074A)
1 Aruba X372 54VDC 1050W Power Supply (JL087A)
1 Aruba 3810M 4SFP+ Module (JL083A)
1 Aruba 3810 Switch Fan Tray (JL088A)

I/O ports and slots 48 RJ-45 autosensing 10/100/1000 PoE+ ports (IEEE 802.3 Type 10BASE-T, IEEE
802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T, IEEE 802.3at PoE+);
Duplex: 10BASE-T/100BASE- TX: half or full; 1000BASE-T: full only; Ports 1 - 48
support MACSec

1 open module slot

Supports a maximum of 4 SFP+ ports or 2 40GbE ports, with optional module

Additional ports and
slots

1 stacking module slot
1 RJ-45 serial console port
1 RJ-45 out-of-band management port
1 dual-personality (RJ-45 or USB micro-B)

Power supplies 2 power supply slots
1 minimum power supply required (ordered separately)

Fan tray includes: 1 x JL088A 1 fan tray slot
Switch ships with 1 JL088A fan tray installed. Spares ordered separately.

Physical
characteristics

Dimensions 17.42(w) x 16.98(d) x 1.73(h) in (44.25 x 43.13 x 4.39 cm)
(1U height)

Weight 13.62 lb (6.18 kg)

Memory and
processor

P2020 Dual Core @ 1.2 GHz, 4 GB DDR3 SDRAM, 1 GB SD Card

Dual ARM Coretex A9 @ 1 GHz, 2 GB DDR3 SDRAM; Packet buffer size: 13.5 MB
Internal

Mounting and
enclosure

Mounts in an EIA-standard 19 in. telco rack or equipment cabinet (hardware
included); Horizontal surface mounting only

Performance IPv6 Ready Certified  

1000 Mb Latency < 2.8 µs (FIFO 64-byte packets)

10 Gbps Latency < 1.8 µs (FIFO 64-byte packets)

40 Gbps Latency < 1.5 µs (FIFO 64-byte packets)

Throughput up to 190.5 Mpps (64-byte packets)

Routing/Switching
capacity

320 Gbps

Switch fabric speed 338 Gbps

Routing table size 10000 entries (IPv4), 5000 entries (IPv6)

MAC address table
size

64000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C)
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Nonoperating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 47 dB, Pressure: 29.4 dB

 
Primary Airflow
Direction

Front-to-side and front-to-rear

 
 
 
Electrical
Characteristics

Frequency 50/60Hz

Voltage JL085A PSU: 100-127/200-240 VAC 

Current JL085A PSU (Each): 1A/0.5A

Max/Idle Power
Rating (Switch+ 1
PSU)

70W/55W

Second PSU Power
Adder

10W 

Max/Idle Uplink
Power Adder

JL078A: 4W/3W
JL079A: 7W/3W
JL081A: 4W/3W
JL083A: 11W/4W 

Maximum Heat
Dissipation *(Max
Case)

310.31 

PoE Power (Max
Possible)

N/A

Notes Idle power is the actual power consumption of the device with
no ports connected. Maximum power rating and maximum
heat dissipation are the worst case theoretical maximum
numbers provide for planning the infrastructure with fully
loaded PoE (if equipped), 100% traffic, all ports plugged in,
and all modules populated. This is a modular product.
 
*Switch + 2 power supplies + one JL083A Uplink. For most
accurate heat dissipation, idle and max power for any
combination of chassis and accessories, please consult
configurator. 

Safety EN 60950/IEC 60950; UL 60950; UL 60950-1; CAN/CSA 22.2 No. 60950; EN 60825;
CSA 22.2 60950-1; EN62479:2010; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; EN 62368-1, Ed. 2; IEC 60950-1:2005 Ed.2; Am
1:2009+A2:2013; IEC 60825:2007; EN60850-1:2007 / IEC 60825-1: 2007 Class1
Class 1 Laser Products / Laser Klasse 1; UL 62368-1 Ed.2

Emissions FCC Class A; VCCI Class A; EN 55022/CISPR 22 Class A; EN 60950-1:2006
+A11:2009 +A1:2010 +A12:2011+A2:2013

Immunity Generic EN55022: 2010

EN EN55024: 2010

ESD IEC 61000-4-2

Radiated IEC 61000-4-3; 3 V/m
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EFT/Burst IEC 61000-4-4; 1.0 kV (power line), 0.5 kV (signal line)

Surge IEC 61000-4-5; 1 kV/2 kV AC

Conducted IEC 61000-4-6; 3 V

Power frequency
magnetic field

IEC 61000-4-8; 1 A/m, 50 or 60 Hz

Voltage dips and
interruptions

IEC 61000-4-11; >95% reductions, 0.5 period; 30% reduction,
25 periods

Harmonics EN61000-3-2:2006 +A1:2009 +A2:2009 Class A

Flicker EN61000-3-3:2008

 
 
 
Management Aruba AirWave Network Management; IMC - Intelligent Management Center;

Command-line interface; Web browser; Configuration menu; Out-of-band
management (RJ-45 Ethernet); In-line and out-of- band; Out-of-band management
(serial RS-232c or micro usb)

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services for
details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
Aruba 3810M 24SFP+ 250W Switch (JL430A)

Included
accessories

1 Aruba 3810M 16SFP+ 2-slot Switch (JL075A)
1 Aruba X371 12VDC 250W Power Supply (JL085A)
2 Aruba 3810M 4SFP+ Module (JL083A)
1 Aruba 3810 Switch Fan Tray (JL088A)

I/O ports and slots 16 SFP+ fixed 1000/10000 SFP+ ports; Duplex: 100BASE-TX: half or full;
1000BASE-T: full only; Ports

1 - 16 support MACSec

2 open module slots

Supports a maximum of 8 SFP+ ports or 2 40GbE ports, with optional module

Additional ports and
slots

1 stacking module slot
1 RJ-45 serial console port
1 RJ-45 out-of-band management port
1 dual-personality (RJ-45 or USB micro-B)

Power supplies 2 power supply slots
1 minimum power supply required (ordered separately)

Fan tray includes: 1 x JL088A
1 fan tray slot
Switch ships with 1 JL088A fan tray installed. Spares ordered separately.

Physical
characteristics

Dimensions 17.42(w) x 16.98(d) x 1.73(h) in (44.25 x 43.13 x 4.39 cm) (1U
height)

Weight 13.28 lb (6.02 kg)

Memory and
processor

P2020 Dual Core @ 1.2 GHz, 4 GB DDR3 SDRAM, 1 GB SD Card

Dual ARM Coretex A9 @ 1 GHz, 2 GB DDR3 SDRAM; Packet buffer size: 13.5 MB
Internal
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Mounting and
enclosure

Mounts in an EIA-standard 19 in. telco rack or equipment cabinet (hardware
included); Horizontal surface mounting only

Performance IPv6 Ready Certified  

1000 Mb Latency < 2.8 µs (FIFO 64-byte packets)

10 Gbps Latency < 1.8 µs (FIFO 64-byte packets)

40 Gbps Latency < 1.5 µs (FIFO 64-byte packets)

Throughput up to 285.7 Mpps (64-byte packets)

Routing/Switching
capacity

480 Gbps

Switch fabric speed 508 Gbps

Routing table size 10000 entries (IPv4), 5000 entries (IPv6)

MAC address table
size

64000 entries

 
 
 
Environment Operating

temperature
32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Nonoperating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 39 dB, Pressure: 22.3 dB

Primary Airflow
Direction

Front-to-side and front-to-rear

Electrical
Characteristics

Frequency 50/60Hz

Voltage JL085A PSU: 100-127/200-240 VAC 

Current JL085A PSU (Each): 1A/0.5A

Max/Idle Power
Rating (Switch+ 1
PSU)

142W/103W

Second PSU Power
Adder

10W 

Max/Idle Uplink
Power Adder

JL078A: 4W/3W
JL079A: 7W/3W
JL081A: 4W/3W
JL083A: 11W/4W 

Maximum Heat
Dissipation *(Max
Case)

310.31 

PoE Power (Max
Possible)

N/A
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Notes Idle power is the actual power consumption of the device with
no ports connected. Maximum power rating and maximum
heat dissipation are the worst case theoretical maximum
numbers provide for planning the infrastructure with fully
loaded PoE (if equipped), 100% traffic, all ports plugged in,
and all modules populated. This is a modular product.
 
*Switch + 2 power supplies + one JL083A Uplink. For most
accurate heat dissipation, idle and max power for any
combination of chassis and accessories, please consult
configurator. 

Safety EN 60950/IEC 60950; UL 60950; UL 60950-1; CAN/CSA 22.2 No. 60950; EN 60825;
CSA 22.2 60950-1; EN62479:2010; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; EN 62368-1, Ed. 2; IEC 60950-1:2005 Ed.2; Am
1:2009+A2:2013; IEC 60825:2007; EN60850-1:2007 / IEC 60825-1: 2007 Class1
Class 1 Laser Products / Laser Klasse 1; UL 62368-1 Ed.2

Emissions FCC Class A; VCCI Class A; EN 55022/CISPR 22 Class A; EN 60950-1:2006
+A11:2009 +A1:2010 +A12:2011+A2:2013

 
 
 
Immunity Generic EN55022: 2010

EN EN55024: 2010

ESD IEC 61000-4-2

Radiated IEC 61000-4-3; 3 V/m

EFT/Burst IEC 61000-4-4; 1.0 kV (power line), 0.5 kV (signal line)

Surge IEC 61000-4-5; 1 kV/2 kV AC

Conducted IEC 61000-4-6; 3 V

Power frequency
magnetic field

IEC 61000-4-8; 1 A/m, 50 or 60 Hz

Voltage dips and
interruptions

IEC 61000-4-11; >95% reductions, 0.5 period; 30% reduction,
25 periods

Harmonics EN61000-3-2:2006 +A1:2009 +A2:2009 Class A

Flicker EN61000-3-3:2008

Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; Out-of-band
management (RJ-45 Ethernet); In-line and out-of- band; Out-of-band management
(serial RS-232c or micro usb)

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services for
details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

Standards and protocols (applies to all products in series)
BGP
RFC 1997 BGP Communities Attribute
RFC 2918 Route Refresh Capability
RFC 4271 A Border Gateway Protocol 4 (BGP-4)
RFC 4456 BGP Route Reflection: An Alternative to Full Mesh Internal BGP (IBGP)
RFC 4724 Graceful Restart Mechanism for BGP
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RFC 5492 Capabilities Advertisement with BGP-4

Denial of service protection
CPU DoS Protection

Device Management
RFC 1591 DNS (client)
RFC 2576 (Coexistence between SNMP V1, V2, V3)
RFC 2579 (SMIv2 Text Conventions)
RFC 2580 (SMIv2 Conformance)
RFC 3416 (SNMP Protocol Operations v2)
RFC 3417 (SNMP Transport Mappings)
HTML and telnet management

 
 
 
General Protocols
IEEE 802.1ad Q-in-Q
IEEE 802.1AX-2008 Link Aggregation
IEEE 802.1D MAC Bridges
IEEE 802.1p Priority
IEEE 802.1Q VLANs
IEEE 802.1s Multiple Spanning Trees
IEEE 802.1v VLAN classification by Protocol and Port
IEEE 802.1w Rapid Reconfiguration of Spanning Tree
IEEE 802.3ad Link Aggregation Control Protocol (LACP)
IEEE 802.3af Power over Ethernet
IEEE 802.3az Energy Efficient Ethernet
IEEE 802.3x Flow Control
IEEE 802.3bz 2.5Gb/s and 5Gb/s interfaces
RFC 768 UDP
RFC 783 TFTP Protocol (revision 2)
RFC 792 ICMP
RFC 793 TCP
RFC 826 ARP
RFC 854 TELNET
RFC 868 Time Protocol
RFC 951 BOOTP
RFC 1058 RIPv1
RFC 1350 TFTP Protocol (revision 2)
RFC 1519 CIDR
RFC 1542 BOOTP Extensions
RFC 1918 Address Allocation for Private Internet
RFC 2030 Simple Network Time Protocol (SNTP) v4
RFC 2131 DHCP
RFC 2453 RIPv2
RFC 2548 (MS-RAS-Vendor only)
RFC 3046 DHCP Relay Agent Information Option
RFC 3575 IANA Considerations for RADIUS
RFC 3576 Ext to RADIUS (CoA only)
RFC 3768 VRRP
RFC 4675 RADIUS VLAN & Priority
RFC 5798 VRRP (exclude Accept Mode and sub-sec timer)
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RFC 5880 Bidirectional Forwarding Detection
RFC 5905 Network Time Protocol Version 4: Protocol and Algorithms Specification
UDLD (Uni-directional Link Detection)

IP Multicast
RFC 3376 IGMPv3
RFC 3973 PIM Dense Mode
RFC 4601 PIM Sparse Mode

 
 
 
IPv6
RFC 1981 IPv6 Path MTU Discovery
RFC 2080 RIPng for IPv6
RFC 2081 RIPng Protocol Applicability Statement
RFC 2082 RIP-2 MD5
RFC 2375 IPv6 Multicast Address Assignments
RFC 2460 IPv6 Specification
RFC 2464 Transmission of IPv6 over Ethernet Networks
RFC 2710 Multicast Listener Discovery (MLD) for IPv6
RFC 2925 Definitions of Managed Objects for Remote Ping, Traceroute, and Lookup Operations (Ping only)
RFC 3019 MLDv1 MIB
RFC 3315 DHCPv6 (client only)
RFC 3484 Default Address Selection for IPv6
RFC 3587 IPv6 Global Unicast Address Format
RFC 3596 DNS Extension for IPv6
RFC 3810 MLDv2 for IPv6
RFC 4022 MIB for TCP
RFC 4087 IP Tunnel MIB
RFC 4113 MIB for UDP
RFC 4213 Basic Transition Mechanisms for IPv6 Hosts and Routers
RFC 4251 SSHv6 Architecture
RFC 4252 SSHv6 Authentication
RFC 4253 SSHv6 Transport Layer
RFC 4254 SSHv6 Connection
RFC 4291 IP Version 6 Addressing Architecture
RFC 4293 MIB for IP
RFC 4294 IPv6 Node Requirements
RFC 4419 Key Exchange for SSH
RFC 4443 ICMPv6
RFC 4541 IGMP & MLD Snooping Switch
RFC 4861 IPv6 Neighbor Discovery
RFC 4862 IPv6 Stateless Address Auto-configuration
RFC 5095 Deprecation of Type 0 Routing Headers in IPv6
RFC 5340 OSPFv3 for IPv6
RFC 5453 Reserved IPv6 Interface Identifiers
RFC 5519 Multicast Group Membership Discovery MIB (MLDv2 only)
RFC 5722 Handling of Overlapping IPv6 Fragments
RFC 6620 FCFS SAVI
draft-ietf-savi-mix
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MIBs
IEEE 802.1ap (MSTP and STP MIB's only)
IEEE 8021-Bridge-MIB (2008)
IEEE 8021-Q-Bridge-MIB (2008)
RFC 1155 Structure & ID of Mgmt Info for TCP/IP Internets
RFC 1213 MIB II
RFC 1493 Bridge MIB
RFC 1724 RIPv2 MIB
RFC 1850 OSPFv2 MIB
RFC 2021 RMONv2 MIB
RFC 2096 IP Forwarding Table MIB
RFC 2578 Structure of Management Information Version 2 (SMIv2)
RFC 2613 SMON MIB
RFC 2618 RADIUS Client MIB
RFC 2620 RADIUS Accounting MIB
RFC 2665 Ethernet-Like-MIB
RFC 2668 802.3 MAU MIB
RFC 2674 802.1p and IEEE 802.1Q Bridge MIB
RFC 2737 Entity MIB (Version 2)
RFC 2787 VRRP MIB
RFC 2863 The Interfaces Group MIB
RFC 2925 Ping MIB
RFC 2932 IP (Multicast Routing MIB)
RFC 2933 IGMP MIB
RFC 4836 Managed Objects for 802.3 Medium Attachment Units (MAU)
RFC 7331 BFD MIB

Network Management
IEEE 802.1AB Link Layer Discovery Protocol (LLDP)
RFC 2819 Four groups of RMON: 1 (statistics), 2 (history), 3 (alarm) and 9 (events)
RFC 3176 sFlow
RFC 3411 SNMP Management Frameworks
RFC 3412 Message Processing and Dispatching for the Simple Network Management Protocol (SNMP)
RFC 3413 Simple Network Management Protocol (SNMP) Applications
RFC 3414 User-based Security Model (USM) for version 3 of the Simple Network Management Protocol
(SNMPv3)
RFC 3415 View-based Access Control Model (VACM) for the Simple Network Management Protocol
(SNMP)
RFC 3418 Management Information Base (MIB) for the Simple Network Management Protocol (SNMP)
RFC 5424 Syslog Protocol
ANSI/TIA-1057 LLDP Media Endpoint Discovery (LLDP-MED)
SNMPv1/v2c/v3
XRMON

OSPF
RFC 2328 OSPFv2
RFC 3101 OSPF NSSA
RFC 3623 Graceful OSPF Restart (Unplanned Outages only)
RFC 5340 OSPFv3 for IPv6
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QoS/CoS
RFC 2474 DiffServ Precedence, including 8 queues/port
RFC 2475 DiffServ Architecture
RFC 2597 DiffServ Assured Forwarding (AF)
RFC 2598 DiffServ Expedited Forwarding (EF)

Security
IEEE 802.1X Port Based Network Access Control
RFC 1321 The MD5 Message-Digest Algorithm
RFC 2698 A Two Rate Three Color Marker
RFC 2818 HTTP Over TLS
RFC 2865 RADIUS (client only)
RFC 2866 RADIUS Accounting
RFC 3579 RADIUS Support For Extensible Authentication Protocol (EAP)
Secure Sockets Layer (SSL)
SSHv2 Secure Shell
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Aruba 3810M Switch Series accessories  
Modules  
Aruba 3810M 4-port Stacking Module JL084A
Aruba 3810M/2930M 4-port 100M/1G/10G SFP+ MACsec Module JL083A
Aruba 3810M/2930M 1-port QSFP+ 40GbE Module JL078A
Aruba 3810M 2QSFP+ 40GbE Module JL079A
Transceivers  
Aruba 100M SFP LC FX 2km MMF Transceiver J9054D
Aruba 1G SFP RJ45 T 100m Cat5e Transceiver J8177D
Aruba 1G SFP LC SX 500m OM2 MMF Transceiver J4858D
Aruba 1G SFP LC LX 10km SMF Transceiver J4859D
Aruba 1G SFP LC LH 70km SMF Transceiver J4860D
Aruba 10G SFP+ LC SR 300m OM3 MMF Transceiver J9150D
Aruba 10G SFP+ LC LR 10km SMF Transceiver J9151E
Aruba 10G SFP+ LC LRM 220m OM2 MMF Transceiver J9152D
Aruba 10G SFP+ LC ER 40km SMF Transceiver J9153D
Aruba 10G SFP+ to SFP+ 1m Direct Attach Copper Cable J9281D
Aruba 10G SFP+ to SFP+ 3m Direct Attach Copper Cable J9283D
Aruba 10G SFP+ to SFP+ 7m Direct Attach Copper Cable J9285D
Aruba 40G QSFP+ LC Bidirectional 150m MMF 2-strand Transceiver JL308A
HPE X142 40G QSFP+ MPO SR4 Transceiver JH231A
HPE X142 40G QSFP+ LC LR4 SM Transceiver JH232A
HPE X142 40G QSFP+ MPO eSR4 300M Transceiver JH233A
HPE X242 40G QSFP+ to QSFP+ 1m Direct Attach Copper Cable JH234A
HPE X242 40G QSFP+ to QSFP+ 3m Direct Attach Copper Cable JH235A
HPE X242 40G QSFP+ to QSFP+ 5m Direct Attach Copper Cable JH236A
Cables  
Aruba X2C2 RJ45 to DB9 Console Cable JL448A
Aruba 3800/3810M 0.5m Stacking Cable J9578A
Aruba 3800/3810M 1m Stacking Cable J9665A
Aruba 3800/3810M 3m Stacking Cable J9579A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 1m Cable QK732A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 2m Cable QK733A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 5m Cable QK734A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 15m Cable QK735A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 30m Cable QK736A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 50m Cable QK737A
Power Supply  
Aruba X371 12VDC 250W 100-240VAC Power Supply JL085A
Aruba X372 54VDC 680W 100-240VAC Power Supply JL086A
Aruba X372 54VDC 1050W 110-240VAC Power Supply JL087A
Fan Tray  
Aruba 3810 Switch Fan Tray JL088A
Mounting Kit  
HPE X410 1U Universal 4-post Rackmount Kit J9583A
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Date Version
History

Action Description of Change

04-Mar-2019 Version 19 Changed SKU J9151D was replaced with J9151E
CTO models were removed.
Obsolete SKUs were removed.

03-Dec-2018 Version 18 Changed Software feature update: Key features, Product
overview and Enhanced Capabilities updated

02-Jul-2018 Version 17 Changed Software feature update
07-May-2018 Version 16 Added Edits made on Configuration section and Technical

Specifications
05-Mar-2018 Version 15 Changed Configuration section updated.
05-Feb-2018 Version 14 Changed Configuration section updated.

Document name updated to match Product Master.
08-Jan-2018 Version 13 Changed Software feature update
07-Aug-2017 Version 12 Added SKU added: JL308A
03-Jul-2017 Version 11 Added SKU added: JL448A
08-May-2017 Version 10 Changed Configuration section updated
03-Apr-2017 Version 9 Changed Modules updated on Configuration section
17-Feb-2017 Version 8 Changed Configuration section updated (Adding #B2B, #B2C,

and #B2E Options on SKUs JL428A; JL429A and
JL430A)

09-Jan-2017 Version 7 Added Models added: JL428A, JL429A, JL430A
07-Nov-2016 Version 6 Changed Product overview, Features and Benefits updated
19-Aug-2016 Version 5 Changed Configuration section updated. Minor changes made on

Technical Specifications.
06-June-2016 Version 4 Changed Features and Benefits, Standards and Protocols,

Accessories updated.
SKU descriptions updated.

18-Mar-2016 Version 3 Changed Minor edits on Features and Benefits, Switch family
photo added.

11-Dec-2015 Version 2 Changed Standards and protocols and Configuration Menu
updated

01-Dec-2015 Version 1 Created Document creation
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Sign up for updates

 

 
  © Copyright 2019 Hewlett Packard Enterprise Development LP. The information

contained herein is subject to change without notice. The only warranties for
Hewlett Packard Enterprise products and services are set forth in the express
warranty statements accompanying such products and services. Nothing herein
should be construed as constituting an additional warranty. Hewlett Packard
Enterprise shall not be liable for technical or editorial errors or omissions
contained herein.

 

To learn more, visit: http://www.hpe.com/networking
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HPE Networking Product Warranty & Support Summary (October 2018)

The most current version of this document is available at www.hpe.com/networking/warrantysummary
HPE Networking product warranty policy details are available at www.hpe.com/networking/warranty

Information on services for HPE Networking products can be found at www.hpe.com/networking/services
The information contained herein is subject to change without notice.  Warranties for HPE products and services are set forth in the express warranty statements 

accompanying such products and services.   In addition, our goods come with guarantees that cannot be excluded under Australian and New Zealand consumer laws.  
Subject to the foregoing, nothing herein should be construed as constituting an additional warranty.  HPE shall not be liable for technical or editorial errors or omissions 

contained herein.

 

Products Warranty 
duration1

Hardware 
replacement2

Business 
Hours 

Technical 
Support3

24x7
Technical 
Support3

(After Dec. 1, 2015)

Software/OS 
Releases4

Sw
itc

he
s

Modular
129xx, 125xx, 119xx 1 year 10 days 1 year N/A As long as owned4

105xx, 75xx 1 year 10 days 1 year 90 days As long as owned4

84xx, 83xx 5 years 10 days 90 days N/A 5 years4

82xxzl, 54xxzl/R, 42xxvl Lifetime5 NBD Ship As long as 
owned5 90 days As long as owned4

Fixed-configuration
79xx, 59xx/AF, 583x/AF, 582x/AF, 57xx 1 year 10 days 1 year N/A As long as owned4

Altoline 9xxx, 6xxx Switches (Purchased after March 31, 2016) 1 year 10 days 1 year N/A N/A

Arista switches (See http://www.arista.com/assets/data/pdf/Warranty.pdf for details) 1 year15 10 days15 1 year15 N/A N/A

580x/AF Lifetime5 NBD Ship As long as 
owned5 N/A As long as owned4

55xx, 513x, 512x, 38xx, 36xx, 35xx/yl, 31xx, 29xx/al, 281x, 26xx, 25xx/G Lifetime5 NBD Ship As long as 
owned5 90 days As long as owned4

Smart Managed 
195x, 192x, 191x, 18xx, 1620 (Purchased after October 1, 2017)

Lifetime14 NBD Ship

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14

As long as owned4

Unmanaged 
1420, 1410 (Purchased after October 1, 2017)

Lifetime14 NBD Ship

90 days 
Phone 

support-Chat 
support entire 

warranty 
period 14

90 days 
Phone 

support-Chat 
support entire 

warranty 
period 14

N/A

1405 (Purchased after October 1, 2017) 3 years14 NBD Ship 90 days 
Phone 

support-Chat 
support entire 

warranty 
period 14

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14

N/A

W
ire

le
ss

 L
A

N

Indoor Access Points
Aruba Controller-Managed Access Points (APs)

Lifetime10
30 day 

NBD/Return-to-
factory11

90 days N/A 90 days (bug fix only)

3WN/P, 155/P, 108/109 Aruba Remote Access points (RAPs) 
Lifetime10

30 day 
NBD/Return-to-

factory11
90 days N/A Periodic updated 

image13

Aruba Instant Access Points (IAPs)
Lifetime10

30 day 
NBD/Return-to-

factory11
90 days N/A Periodic updated 

image13

M330, M2xx Lifetime5 NBD Ship As long as 
owned5 90 days As long as owned4

OfficeConnect 20 Access Point

3 years14 NBD Ship

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14

As long as owned4

Controllers
Aruba controllers

1 year
30 day 

NBD/Return-to-
factory11

90 days12 N/A N/A

Aruba Mobility Access Switches Lifetime10 NBD Ship 90 days 90 days As long as owned4

Other WLAN products 
Aruba Controller-Managed 2xx Series Outdoor Access Points

Lifetime10
30 day 

NBD/Return-to-
factory11

90 days N/A 90 days (bug fix only)

Aruba Instant 2xx Series Outdoor Access Points (IAPs)
Lifetime10

30 day 
NBD/Return-to-

factory11
90 days N/A Periodic updated 

image13

AirWave Appliances, ClearPass Appliances, IntroSpect Appliances
1 year

30 day 
NBD/Return-to-

factory11
90 days12

N/A
90 days (bug fix only)

MST2HP, MST2HAC, MSR2KP, MSR4KP Aruba Outdoor Wireless Mesh 
Routers 1 year

30 day 
NBD/Return-to-

factory11
90 days12 N/A 90 days (bug fix only)

Aruba Beacons
90 days

30 day 
NBD/Return-to-

factory11
90 days N/A 90 days (bug fix only)

Cape Sensors
90 days

30 day 
NBD/Return-to-

factory11
90 days N/A 90 days (bug fix only)

Aruba Power Supplies, Antennae, Accessories
1 year

30 day 
NBD/Return-to-

factory11
90 days N/A N/A
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HPE Networking Product Warranty & Support Summary (October 2018)

The most current version of this document is available at www.hpe.com/networking/warrantysummary
HPE Networking product warranty policy details are available at www.hpe.com/networking/warranty

Information on services for HPE Networking products can be found at www.hpe.com/networking/services
The information contained herein is subject to change without notice.  Warranties for HPE products and services are set forth in the express warranty statements 

accompanying such products and services.   In addition, our goods come with guarantees that cannot be excluded under Australian and New Zealand consumer laws.  
Subject to the foregoing, nothing herein should be construed as constituting an additional warranty.  HPE shall not be liable for technical or editorial errors or omissions 

contained herein.

 

R
ou

te
rs

Routers
88xx, HSR68xx 1 year 10 days 1 year N/A As long as owned4

HSR66xx, 66xx, MSR50, MSR4xxx, MSR3xxx, MSR30 1 year 10 days 1 year 90 days As long as owned4

MSR2xxx, MSR20, MSR1xxx, MSR9xx 1 year NBD Ship 1 year 90 days As long as owned4

ALU 77xx 1 year9 Return-to-
factory9 1 year9 N/A All updates for 

purchased license9

VSR routers 90 days
(Media only) N/A 90 days N/A All updates for 

purchased license8

M
an

ag
em

en
t

Network Management
Intelligent Management Center (support details at www.hpe.com/networking/IMCSupport) 90 days

(Media only)
N/A 90 days N/A 90 days (bug fix only)

AirWave, ALE, ArubaCentral, ClearPass, Meridian, VIA, Visual RF 90 days
(Media only)

N/A 90 days N/A 90 days (bug fix only)

HPE VAN SDN controller and HPE SDN applications 90 days
(Media only)

N/A 90 days N/A All updates for 
purchased license8

HPE Distributed Cloud Networking 90 days
(Media only)

N/A N/A N/A None

Big Switch Networks controller appliances (See www.bigswitch.com/support for 
warranty & support details) N/A16 N/A16 N/A16 N/A16 N/A16

A
dd

iti
on

al
 N

et
w

or
ki

ng
 

Pr
od

uc
ts

Transceivers
Aruba Transceivers (Transceiver product numbers JWxxxx for Controllers 
and MAS Switches) 1 year 

30 day 
NBD/Return-to-

factory11
90 days N/A N/A

Aruba branded transceivers (except transceiver product numbers JWxxxx)
and

HPE X244, X242, X142, X132, X131, X129, X122, X121, X119, X112, X111

Lifetime5 NBD Ship As long as 
owned5

N/A N/A

Aruba 100G transceivers 1 year 10 days 1 year N/A N/A
HPE X2A0, X240, X190, X180, X170, X160, X150, X140, X135, X130, 
X125, X124, X120, X115, X114, X110

1 year 30 days 1 year N/A N/A

1) Removable power supplies, modules and accessories such as antennas, fans, power cords, 
etc. may have different warranty coverage than the host device.  See the HPE Networking 
Warranty Coverage Quick Reference at www.hpe.com/networking/warrantyquickref for more 
details. 

2) Response time is based on commercially reasonable effort and subject to a daily shipment 
cutoff time.  In some countries and regions and under certain supplier constraints, response 
time may vary.  Contact your local HPE service organization for response time availability in 
your area.  NBD Ship = Next Business Day shipment.

3) Warranty phone and electronic case technical support is provided during local HPE business 
hours for the entire warranty period for the purposes of diagnosing hardware or software 
defects.  Many products purchased after December 1, 2015 include 90 days of 24x7 technical 
support as noted.  See product’s Hewlett-Packard Limited Warranty Statement for additional 
coverage details.  Extended coverage services are available.

4) Includes all generally available software/OS releases offered for the specific products listed, 
when and if available, for as long as the customer owns the product, except where noted.  
Some software releases may require additional or new hardware.  Customers who desire 
specific feature updates, patches and fixes to be prioritized into future releases should 
purchase the appropriate support services from HPE.

5) For products purchased after December 1, 2014, the warranty extends only for as long as the 
original end user owns the product. Includes coverage of any built-in fans and power supplies 
for the entire warranty period. You may be required to provide proof of purchase or lease as a 
condition of receiving warranty service.  

6) Hardware warranty, technical support and all software releases provided for hardware and the 
ONE Service OS only, when and if available, for as long as the original end user owns the 
product.  See product specific documentation for application support.  5 year warranty on the 
disk drive in the HPE Alliance One Advanced Services zl Modules.

7) Products purchased before August 1, 2013 include 1 year of technical support and 1 year 
(bug fix only). 

8) Includes all software updates offered for the licensed version, when and if available.  Software 
upgrades will require purchase of appropriate SKU, packaged support services or contract.

9) All technical, hardware and software support for ALU 77xx products is provided directly by 
Alcatel-Lucent only and not HPE.  For support from Alcatel-Lucent, select the country from 
which the customer is calling in the following link and it will present the appropriate ALU 
support contact information: https://services.support.alcatel-lucent.com/product_support/.  
Hardware warranty requires shipping failed product to ALU for repair or replacement.  
Logistics cost for shipment of product from customer’s site to ALU site for repair or 
replacement will be covered by the customer.  Software maintenance releases are included 
for the major software release purchased.  Major software release upgrades are NOT 
included.  Services may be purchased from HPE or Alcatel-Lucent to extend your support 
coverage and software upgrades.  Support will be provided by Alcatel Lucent for these 
services.

10) For products purchased after December 1, 2015, the warranty extends only for as long as the 
original end user owns the product and is limited to five (5) years from the end of sale date.

11) For the first 30 days from shipment, HPE will provide same day ship advanced 
replacement for the covered hardware products.  After thirty (30) days from shipment 
through the remaining warranty period, HPE will replace or repair any non-compliant 
Product and return it in operable condition, shipping after HPE’s receipt of the non-
compliant Product via HPE’s RMA procedure, with receipt by customer within ten 
(10) days on a commercially reasonable basis.

12) HPE will provide next business day email response for the purposes of diagnosing 
hardware or software defects during standard Pacific Time Zone business hours for 
the first 90 days after purchase. 

13) HPE will make one recent Instant OS software release image available on the 
software portal.  This image is also available for Remote Access Points (RAPs) 
running Instant OS.

14) These products are covered by 90 days of 24x7 phone support.  Thereafter, only 
chat support would be available for the remaining warranty period.  Limited lifetime 
warranty (where applicable) extends only for as long as the original end user owns 
the product and is limited to five (5) years from the end of sale date. This warranty 
includes coverage of any built-in fans and power supplies for the entire warranty 
period. You may be required to provide proof of purchase or lease as a condition of 
receiving warranty service. See www.hpe.com/OfficeConnect/support/ for more 
information on the new OfficeConnect support process. 

15) All technical, hardware and software support for Arista products is provided directly 
by Arista and not HPE.   Consult the Arista customer support page for contact 
information: https://www.arista.com/en/support/customer-support.  Transportation 
costs, if any, incurred in connection with the return of a defective Hardware to an 
Arista repair center shall be borne by Customer. Arista shall pay any transportation 
costs incurred with the redelivery of a repaired or replaced Hardware. Services may 
be purchased from HPE or Arista to extend your support coverage and software 
upgrades.  Support will be provided by Arista for these services.  For details on 
Arista warranty and support, see: 
http://www.arista.com/assets/data/pdf/Warranty.pdf.

16) All technical, hardware and software support for Big Switch Networks products is 
provided directly by BSN and not HPE.  Consult the Big Switch Networks customer 
support page for contact information: www.bigswitch.com/support.  For details on 
Big Switch Networks warranty and support options, see: 
http://bigswitch.com/sites/default/files/bsn_support_and_maintenance_policy.v2.2.20
16.11.14.pdf.
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Aruba 2530 Switch Series
 

 

Models
Aruba 2530 48G PoE+ Switch J9772A
Aruba 2530 24G PoE+ Switch J9773A
Aruba 2530 8G PoE+ Switch J9774A
Aruba 2530 48 PoE+ Switch J9778A
Aruba 2530 24 PoE+ Switch J9779A
Aruba 2530 8 PoE+ Switch J9780A
Aruba 2530 48G Switch J9775A
Aruba 2530 24G Switch J9776A
Aruba 2530 8G Switch J9777A
Aruba 2530 48 Switch J9781A
Aruba 2530 24 Switch J9782A
Aruba 2530 8 Switch J9783A
Aruba 2530 8 PoE+ Internal PS Switch JL070A
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Key features
Cost-effective, reliable and secure Aruba Layer 2 switch series
Security and network management via Aruba ClearPass Policy Manager, Aruba AirWave and Aruba
Central
Right size deployment with choice of 8, 24 and 48 port Gigabit and Fast Ethernet models
Up to 370W PoE+ to power IoT, APs and cameras
Software defined ready with REST API support
Simple deployment with Zero Touch Provisioning

 

Introduction
The Aruba 2530 Switch Series provides cost-effective, reliable and secure access layer connectivity for enterprises, branch
offices and small and midsize businesses.

These fully managed switches deliver Layer 2 capabilities with enhanced access security, traffic prioritization, sFlow, and
IPv6 host support.  Right size deployment is available with a range of Gigabit and Fast Ethernet models including compact
and fanless models which are ideal for use in quiet work spaces. PoE+ models deliver up 370W to power access points, IP
phones and cameras.

The Aruba 2530 Switch Series is easy to deploy, use and manage using Aruba AirWave or Aruba Central. Aruba ClearPass
offers centralized security and external captive portal support. The switches include a Limited Lifetime Warranty.

 

Features
Unified Wired and Wireless

Software-defined networking support
leverages REST APIs to enable automation of network operations, monitoring, and troubleshooting
Supports unified wired and wireless policies
using Aruba ClearPass Policy Manager
Switch auto-configuration
automatically configures switch for different settings such as VLAN, CoS, PoE max power, and PoE
priority when an Aruba access point is detected
User role
defines a set of switch-based policies in areas such as security, authentication, and QoS. A user role
can be assigned to a group of users or devices, using local switch configuration (YA releases only).

Quality of Service (QoS)

Traffic prioritization (IEEE 802.1p)
allows for real-time traffic classification. Supports eight priority levels mapped to either two or four
queues, and uses weighted deficit round robin (WDRR) or strict priority
Simplified QoS configuration

- Port-based
traffic prioritization by specifying a port and priority level

- VLAN-based
traffic prioritization by specifying a VLAN and priority level

Class of Service (CoS)
sets the IEEE 802.1p priority tag based on IP address, IP Type of Service (ToS), Layer 3 protocol,
TCP/UDP port number, source port, and DiffServ
Rate limiting
establishes per-port ingress-enforced maximums for all traffic or for broadcast, multicast, or unknown
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destination traffic
Layer 4 prioritization
enables priorities based on TCP/UDP port numbers
Flow control
delivers reliable communication during full-duplex operation

 

Simplified Configuration and Management

Aruba Central cloud-based management platform
offers a simple, secure and cost effective way to manage switches. Complies with RFC 7030 for
encryption key enrollment
Zero-Touch ProVisioning (ZTP)
simplifies installation of the switch infrastructure using DHCP-based process with AirWave
Choice of management interfaces

- HTML-based easy-to-use Web GUI
allows configuration of the switch from any Web browser

- Robust CLI
provides advanced configuration and diagnostics

- Simple network management protocol (SNMPv1/v2c/v3)
allows the switch to be managed with a variety of third-party network management
applications

Flexible management
supports both cloud-based Central and on-premise AirWave without ripping and replacing switching
infrastructure
Virtual stacking
provides single IP address management for up to 16 switches
sFlow (RFC 3176)
delivers wire-speed traffic accounting and monitoring, configured by SNMP and CLI with three terminal
encrypted receivers
IEEE 802.1AB Link Layer Discovery Protocol (LLDP)
automates device discovery protocol for easy mapping by network management applications
Provides local and remote logging of events
via SNMP (v2c and v3) and syslog; provides log throttling and log filtering to reduce the number of log
events generated
Port mirroring
allows traffic to be mirrored on any port or a network analyzer to assist with diagnostics or detecting
network attacks
Remote monitoring (RMON)
provides advanced monitoring and reporting capabilities for statistics, history, alarms, and events
Find, fix, and inform
finds and fixes common network problems automatically, and then informs the administrator
Friendly port names
allows assignment of descriptive names to ports
Dual flash images
provides independent primary and secondary operating system files for backup while upgrading
Multiple configuration files
are easily stored with a flash image
Front-panel LEDs

- Locator LEDs
allows users to set the locator LED on a specific switch to turn on, blink, or turn off; and
simplifies troubleshooting by making it easy to locate a particular switch within a rack of
similar switches
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- Per-port LEDs
provides an at-a-glance view of the status, activity, speed, and full-duplex operation

- Power and fault LEDs
display issues, if any

 

Connectivity

Compact and fanless 8-port models
offer quiet operation for acoustically sensitive areas and uplink flexibility with two dual-personality ports
that can be used as either RJ-45 Gigabit Ethernet or SFP ports.
Four built-in Gigabit Ethernet uplinks on 24- and 48- port models
Gigabit models have small form factor pluggable (SFP) for fiber connectivity and Fast Ethernet models
have two SFP and two RJ-45 Gigabit uplinks.
IPv6

- IPv6 host
allows the switch to be deployed and managed at the edge of an IPv6 network

- Dual stack (IPv4/IPv6)
supports connectivity for both protocols; provides a transition mechanism from IPv4 to IPv6

- MLD snooping
forwards IPv6 multicast traffic to appropriate interface; prevents IPv6 multicast traffic from
flooding the network

- IPv6 ACL/QoS
supports ACL & QoS for IPv6 network traffic on Gigabit & 48 port 10/100 models

- Security
RA Guard, DHCPv6 Protection, Dynamic IPv6 Lockdown (YA only)

IEEE 802.3at Power over Ethernet (PoE+)
provides up to 30 W per port that allows support of the latest PoE+ capable devices such as IP
phones, wireless access points, and security cameras, as well as any IEEE 802.3af compliant end
device; eliminates the cost of additional electrical cabling and circuits that would otherwise be
necessary in IP phone and WLAN deployments
Auto-MDIX
adjusts automatically for straight-through or crossover cables on all ports
Pre-standard PoE support
detects and provides power to pre-standard PoE devices
SFP slots
provides fiber connectivity such as Gigabit-SX, -LX, -LH, and -BX with four SFP slots on all 24- and 48-
port Gigabit Ethernet models. Fast Ethernet 24- and 48-port models have two SFP slots and two RJ-45
Gigabit uplinks; 8-port models have two dual-personality ports supporting either SFP or RJ-45 Gigabit
uplinks
Dual-personality (RJ-45 or USB micro-B) serial console port
gives easy access to switch CLI with front-of-switch location and the flexibility of using either an RJ-45
or USB micro-B serial console port

Layer 2 switching

VLANs
supports 512 VLANs and 4,094 VLAN IDs
Jumbo packet support
improves the performance of large data transfers; supports frame size of up to 9,220 bytes
16K MAC address table
provides access to many Layer 2 devices
GARP VLAN Registration Protocol
allows automatic learning and dynamic assignment of VLANs
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Rapid Per-VLAN Spanning Tree (RPVST+)
allows each VLAN to build a separate spanning tree to improve link bandwidth usage; is compatible
with PVST+

Security

Access control lists (ACLs)
accommodate IPv4/IPv6 port and VLAN-based ACLs (IPv6 ACL is supported only on Gigabit Ethernet
and 48-port models.)
Source-port filtering
allows only specified ports to communicate with each other
RADIUS/TACACS+
eases switch management security administration by using a password authentication server
Secure Sockets Layer (SSL)
encrypts all HTTP traffic, allowing secure access to the browser-based management GUI in the switch
Port security
allows access only to specified MAC addresses, which can be learned or specified by the administrator
MAC address lockout
prevents particular configured MAC addresses from connecting to the network
Multiple user authentication methods

- IEEE 802.1X
uses an IEEE 802.1X supplicant on the client in conjunction with a RADIUS server to
authenticate in accordance with industry standards

- Web-based authentication
provides a browser-based environment, similar to IEEE 802.1X, to authenticate clients that
do not support the IEEE 802.1X supplicant

- Supports MAC-based authentication
using the client's MAC address

Secure shell (SSH) v2
encrypts all transmitted data for secure remote CLI access over IP networks
STP BPDU port protection
blocks Bridge Protocol Data Units (BPDUs) on ports that do not require BPDUs, preventing forged
BPDU attacks
STP root guard
protects the root bridge from malicious attacks or configuration mistakes
Secure management access
delivers secure encryption of all access methods (CLI, GUI, or MIB) through SSHv2 and SNMPv3
Custom banner
displays security policy when users log in to the switch
Secure FTP
allows secure file transfer to and from the switch; protects against unwanted file downloads or
unauthorized copying of a switch configuration file
Protected ports CLI
offers intuitive CLI to configure the source-port filter feature, by allowing specified ports to be isolated
from all other ports on the switch; the protected port or ports can communicate only with the uplink or
shared resources
Authentication flexibility

- Multiple IEEE 802.1X users per port
provides authentication for up to eight IEEE 802.1X users per port; prevents a user from
"piggybacking" on another user's IEEE 802.1X authentication

- Concurrent IEEE 802.1X, Web or MAC authentication schemes per port
allows a switch port to accept IEEE 802.1X and either Web or MAC authentications

QuickSpecs Aruba 2530 Switch Series

Overview

DA - 14447   Worldwide QuickSpecs — Version 18 — 12/3/2018 Page  5

Anexo 01 ITEM 10 (0592611)         SEI 0008478-63.2018.6.02.8000 / pg. 4803



Switch management logon security
helps secure switch CLI logon by optionally requiring either RADIUS or TACACS+ authentication
DHCP protection
blocks DHCP packets from unauthorized DHCP servers, preventing denial-of-service attacks
Dynamic ARP protection:
blocks ARP broadcasts from unauthorized hosts, preventing eavesdropping or theft of network data
Dynamic IP lockdown
works with DHCP protection to block traffic from unauthorized hosts, preventing IP source address
spoofing
MAC Pinning
allows non-chatty legacy devices to stay authenticated by pinning client MAC addresses to the port
until the clients logoff or get disconnected

Convergence

LLDP-MED (Media Endpoint Discovery)
defines a standard extension of LLDP that stores values for parameters such as QoS and VLAN to
automatically configure network devices such as IP phones
IEEE 802.1AB Link Layer Discovery Protocol (LLDP)
facilitates easy mapping using network management applications with LLDP automated device
discovery protocol
PoE and PoE+ allocations
support multiple methods (automatic, IEEE 802.3at dynamic, LLDP-MED fine grain, IEEE 802.3af
device class or user-specified), to allocate and manage PoE/PoE+ power for more energy savings
Voice VLAN
uses LLDP-MED to automatically configure a VLAN for IP phones
IP multicast (IGMP)
prevents flooding of IP multicast traffic
LLDP-CDP compatibility
receives and recognizes CDP packets from Cisco's IP phones for seamless interoperation
Local MAC Authentication
assigns attributes such as VLAN and QoS using locally configured profile that can be a list of MAC
prefixes

Resiliency and high availability

Port trunking and link aggregation
- Trunking

supports up to eight links per trunk to increase bandwidth and create redundant connections;
and supports L2, L3, and L4 trunk load-balancing algorithm (L4 trunk load balancing is
supported only on Gigabit Ethernet and 48-port models.)

- IEEE 802.3ad Link Aggregation Control Protocol (LACP)
eases configuration of trunks through automatic configuration

IEEE 802.1s Multiple Spanning Tree
provides high link availability in multiple VLAN environments by allowing multiple spanning trees;
provides legacy support for IEEE 802.1d and IEEE 802.1w
SmartLink
provides easy-to-configure link redundancy of active and standby links

Product Architecture

Power savings with energy-efficient design
- IEEE 802.3az

reduces power consumption during periods of low data activity on Gigabit Ethernet switches
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- Port low power mode
enables the port to automatically go into low-power mode to conserve energy when no link is
detected

- Fanless and variable-speed fans
decrease power consumption in fanless (all 8-port, 2530-24, and 2530-48 PoE+ switches) as
well as variable-speed fan switches

- Port LEDs
conserves energy by optionally turning off port link and activity LEDs

Switch on a chip
provides a highly integrated, high-performance switch design with a non-blocking architecture

Flexibility

Flexible mounting
- Rack mountable

allows the switch to be mounted on a standard 19-inch rack, with the hardware included
- Wall mountable

allows the switch to be mounted on a wall, using the hardware included
- Surface mountable

allows the switch to be mounted above or below a surface (such as a desk or table), using
the hardware included

Quiet operation
lowers noise, making it suitable for deployments in acoustically sensitive environments such as
conference rooms and office spaces
Compact size
reduces space requirements (refer to the product specifications for the exact dimensions)

Warranty and support

Limited Lifetime Warranty
see http://www.hpe.com/networking/warrantysummary for warranty and support information
included with your product purchase.
Software releases
to find software for your product, refer to http://www.hpe.com/networking/support; for details on the
software releases available with your product purchase, refer to
http://www.hpe.com/networking/warrantysummary
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Build To Order: BTO is a standalone unit with no integration. BTO products
ship standalone are not part of a CTO or Rack-Shippable solution.
   
Aruba 2530 8 Switch J9783A

8 RJ-45 autosensing 10/100 ports
2 dual-personality ports; RJ-45 10/100/1000 or SFP slot (Min 0 // Max 2 SFP)
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 3

   
No Power Cord J9783A#AC3

No Localized Power Cord Selected  
   
   
Aruba 2530 8 PoE+ Switch J9780A

8 RJ-45 autosensing 10/100 PoE+ports
2 dual-personality ports; RJ-45 10/100/1000 or SFP slot (Min 0 // Max 2 SFP)
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 3

   
No Power Cord J9780A#AC3

No Localized Power Cord Selected  
   
   
Aruba 2530 8 PoE+ Internal PS Switch JL070A

8 RJ-45 autosensing 10/100 PoE+ports
2 dual-personality ports; RJ-45 10/100/1000 or SFP slot (Min 0 // Max 2 SFP)
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2

   
PDU Cable NA/MEX/TW/JP JL070A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL070A#B2C

C15 PDU Jumper Cord (ROW)  
   
Aruba 2530 8G Switch J9777A

8 RJ-45 autosensing 10/100/1000 ports
2 dual-personality ports; RJ-45 10/100/1000 or SFP slot (Min 0 // Max 2 SFP)
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 3

   
No Power Cord J9777A#AC3

No Localized Power Cord Selected  
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Aruba 2530 8G PoE+ Switch J9774A

8 RJ-45 autosensing 10/100/1000 PoE+ ports
2 dual-personality ports; RJ-45 10/100/1000 or SFP slot (Min 0 // Max 2 SFP)
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 3

   
No Power Cord J9774A#AC3

No Localized Power Cord Selected  
   

Aruba 2530 24 Switch J9782A

24 RJ-45 autosensing 10/100 ports
2 fixed Gigabit Ethernet SFP ports (Min 0 // Max 2 SFP)
2 RJ-45 autosensing 10/100/1000 ports
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2

   
PDU CABLE NA/MEX/TW/JP J9782A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)
   
PDU CABLE ROW J9782A#B2C

C15 PDU Jumper Cord (ROW)
   
No Power Cord J9782A#AC3

No Localized Power Cord Selected  
   
Aruba 2530 24 PoE+ Switch J9779A

24 RJ-45 autosensing 10/100 PoE+ ports
2 fixed Gigabit Ethernet SFP ports (Min 0 // Max 2 SFP)
2 RJ-45 autosensing 10/100/1000 ports
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2

   
PDU CABLE NA/MEX/TW/JP J9779A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)
   
PDU CABLE ROW J9779A#B2C

C15 PDU Jumper Cord (ROW)
   
No Power Cord J9779A#AC3

No Localized Power Cord Selected  
   
Aruba 2530 24G Switch J9776A

24 RJ-45 autosensing 10/100/1000 ports
4 fixed Gigabit Ethernet SFP ports (Min 0 // Max 4 SFP)
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2
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PDU CABLE NA/MEX/TW/JP J9776A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)
 
PDU CABLE ROW J9776A#B2C

C15 PDU Jumper Cord (ROW)
   
Aruba 2530 24G PoE+ Switch J9773A

24 RJ-45 autosensing 10/100/1000 PoE+ ports
4 fixed Gigabit Ethernet SFP ports (Min 0 // Max 4 SFP)
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2

   
PDU CABLE NA/MEX/TW/JP J9773A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)
   
PDU CABLE ROW J9773A#B2C

C15 PDU Jumper Cord (ROW)
   
Aruba 2530 48 Switch J9781A

48 RJ-45 autosensing 10/100 ports
2 fixed Gigabit Ethernet SFP ports (Min 0 // Max 2 SFP)
2 RJ-45 autosensing 10/100/1000 ports
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2

   
PDU CABLE NA/MEX/TW/JP J9781A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)
   
PDU CABLE ROW J9781A#B2C

C15 PDU Jumper Cord (ROW)
   
No Power Cord J9781A#AC3

No Localized Power Cord Selected  
   
Aruba 2530 48 PoE+ Switch J9778A

48 RJ-45 autosensing 10/100 PoE+ ports
2 fixed Gigabit Ethernet SFP ports (Min 0 // Max 2 SFP)
2 RJ-45 autosensing 10/100/1000 ports
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2

   
PDU CABLE NA/MEX/TW/JP J9778A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)
   
PDU CABLE ROW J9778A#B2C

C15 PDU Jumper Cord (ROW)
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No Power Cord J9778A#AC3
No Localized Power Cord Selected  

   
Aruba 2530 48G Switch J9775A

48 RJ-45 autosensing 10/100/1000 ports
4 fixed Gigabit Ethernet SFP ports (Min 0 // Max 4 SFP)
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2

   
PDU CABLE NA/MEX/TW/JP J9775A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)
   
PDU CABLE ROW J9775A#B2C

C15 PDU Jumper Cord (ROW)
   
Aruba 2530 48G PoE+ Switch J9772A

48 RJ-45 autosensing 10/100/1000 PoE+ ports
4 fixed Gigabit Ethernet SFP ports (Min 0 // Max 4 SFP)
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2

   
PDU CABLE NA/MEX/TW/JP J9772A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)
   
PDU CABLE ROW J9772A#B2C

C15 PDU Jumper Cord (ROW)
   
 
 
Configuration Rules:
     
NOTE 1 The following Transceivers install into this switch:  

Aruba 1G SFP LC SX 500m OM2 MMF Transceiver J4858D
Aruba 1G SFP LC LX 10km SMF Transceiver J4859D
Aruba 1G SFP LC LH 70km SMF Transceiver J4860D
Aruba 1G SFP RJ45 T 100m Cat5e Transceiver J8177D
Aruba 100M SFP LC FX 2km MMF Transceiver J9054D

   
NOTE 2 Localization required on orders without #B2B, #B2C or #B2E options.

   
NOTE 3 Localization cable required. No B2x options

   

Remarks: Drop down under power supply should offer the following options and results:

Switch/Router/Power Supply to PDU Power Cord - #B2B in North America, Mexico, Taiwan, and Japan or
#B2C ROW. (Watson Default B2B or B2C for Rack Level CTO)
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Switch/Router/Power Supply to Wall Power Cord - Localized Option (Watson Default for BTO and Box
Level CTO)

 
   

Rack Level Integration CTO Models  

     
Aruba 2530 24 Switch J9782A  

24 RJ-45 autosensing 10/100 ports
2 fixed Gigabit Ethernet SFP ports (Min 0 // Max 2 SFP)
2 RJ-45 autosensing 10/100/1000 ports
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2, 3, 4

 

     
PDU CABLE NA/MEX/TW/JP J9782A#B2B  

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
     
PDU CABLE ROW J9782A#B2C  

C15 PDU Jumper Cord (ROW)  
   
No Power Cord J9782A#AC3

No Localized Power Cord Selected  
   
Aruba 2530 24 PoE+ Switch J9779A  

24 RJ-45 autosensing 10/100 PoE+ ports
2 fixed Gigabit Ethernet SFP ports (Min 0 // Max 2 SFP)
2 RJ-45 autosensing 10/100/1000 ports
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2, 3, 4

 

     
PDU CABLE NA/MEX/TW/JP J9779A#B2B  

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
     
PDU CABLE ROW J9779A#B2C  

C15 PDU Jumper Cord (ROW)  
   
No Power Cord J9779A#AC3

No Localized Power Cord Selected  
   
Aruba 2530 24G Switch J9776A  

24 RJ-45 autosensing 10/100/1000 ports
4 fixed Gigabit Ethernet SFP ports (Min 0 // Max 4 SFP)
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2, 3, 4

 

     
PDU CABLE NA/MEX/TW/JP J9776A#B2B  

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
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PDU CABLE ROW J9776A#B2C  
C15 PDU Jumper Cord (ROW)  

     
Aruba 2530 24G PoE+ Switch J9773A  

24 RJ-45 autosensing 10/100/1000 PoE+ ports
4 fixed Gigabit Ethernet SFP ports (Min 0 // Max 4 SFP)
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2, 3, 4

 

     
PDU CABLE NA/MEX/TW/JP J9773A#B2B  

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
     
PDU CABLE ROW J9773A#B2C  

C15 PDU Jumper Cord (ROW)  
     
Aruba 2530 48 Switch J9781A  

48 RJ-45 autosensing 10/100 ports
2 fixed Gigabit Ethernet SFP ports (Min 0 // Max 2 SFP)
2 RJ-45 autosensing 10/100/1000 ports
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2, 3, 4

 

     
PDU CABLE NA/MEX/TW/JP J9781A#B2B  

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
     
PDU CABLE ROW J9781A#B2C  

C15 PDU Jumper Cord (ROW)  
   
No Power Cord J9781A#AC3

No Localized Power Cord Selected  
   
Aruba 2530 48 PoE+ Switch J9778A  

48 RJ-45 autosensing 10/100 PoE+ ports
2 fixed Gigabit Ethernet SFP ports (Min 0 // Max 2 SFP)
2 RJ-45 autosensing 10/100/1000 ports
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2, 3, 4

 

     
PDU CABLE NA/MEX/TW/JP J9778A#B2B  

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
     
PDU CABLE ROW J9778A#B2C  

C15 PDU Jumper Cord (ROW)  
   
No Power Cord J9778A#AC3

No Localized Power Cord Selected  
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Aruba 2530 48G Switch J9775A  
48 RJ-45 autosensing 10/100/1000 ports
4 fixed Gigabit Ethernet SFP ports (Min 0 // Max 4 SFP)
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2, 3, 4

 

     
PDU CABLE NA/MEX/TW/JP J9775A#B2B  

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
     
PDU CABLE ROW J9775A#B2C  

C15 PDU Jumper Cord (ROW)  
     
Aruba 2530 48G PoE+ Switch J9772A  

48 RJ-45 autosensing 10/100/1000 PoE+ ports
4 fixed Gigabit Ethernet SFP ports (Min 0 // Max 4 SFP)
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2, 3, 4

 

     
PDU CABLE NA/MEX/TW/JP J9772A#B2B  

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
     
PDU CABLE ROW J9772A#B2C  

C15 PDU Jumper Cord (ROW)  
     

 
 
Configuration
Rules:
   
NOTE 1 The following Transceivers install into this switch:

Aruba 1G SFP LC SX 500m OM2 MMF Transceiver J4858D

Aruba 1G SFP LC LX 10km SMF Transceiver J4859D

Aruba 1G SFP LC LH 70km SMF Transceiver J4860D

Aruba 1G SFP RJ45 T 100m Cat5e Transceiver J8177D

Aruba 100M SFP LC FX 2km MMF Transceiver J9054D

   
NOTE 2 If this switch is factory installed in any HPE Universal Racks, Then the J9583A#0D1 is required.

   
NOTE 3 Localization (Wall Power Cord) required on orders without #B2B, #B2C (PDU Power Cord) . (See

Localization Menu)

REMARK: When Switches/Routers are Factory Racked, Then #B2B, or #B2C should be the
Defaulted Power Cable option on the Switches/Routers.

   
NOTE 4 If HPE CTO Switch Chassis is selected forRack Level Integration, Then the CTO Switch Chassis

needs to integrate (with #0D1) to the HPE Networking Universal Rack.
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 Remarks: Drop down under power supply should offer the following options and results:

Switch/Router/Power Supply to PDU Power Cord - #B2B in North America, Mexico, Taiwan, and
Japan or #B2C ROW. (Watson Default B2B or B2C for Rack Level CTO)

Switch/Router/Power Supply to Wall Power Cord - Localized Option (Watson Default for BTO and
Box Level CTO)

 
   

Internal Power Supplies  
   
Internal Power supplies included  
   
Enter the following menu selections as integrated to the CTO Model X server above if order is
factory built.

   

Transceivers  
   
SFP Transceivers  

   
Aruba 100M SFP LC FX 2km MMF Transceiver J9054D

Aruba 1G SFP LC SX 500m OM2 MMF Transceiver J4858D

Aruba 1G SFP LC LX 10km SMF Transceiver J4859D

Aruba 1G SFP LC LH 70km SMF Transceiver J4860D

Aruba 1G SFP RJ45 T 100m Cat5e Transceiver J8177D

   

Cables
   
Console Cables

(std 0 // max 99) User Selection (min 0 // max 99) per switch  
   
Aruba X2C2 RJ45 to DB9 Console Cable JL448A

   

Switch Enclosure Options
 
Cable Guard

   
Aruba X510 1U Cable Guard J9700A

See Configuration
NOTE: 1

 
Configuration Rules:

   
NOTE 1 This Cable Guard is supported only on the J9783A, J9780A, JL070A, J9777A and J9774A.
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Option Mounting Kit

Aruba 2530 8-port Switch Pwr Adptr Shelf J9820A

See Configuration
NOTE: 1

 
Configuration Rules:
   
NOTE 1 This Power Adapter Shelf is supported only on the J9783A, J9780A, J9777A and J9774A.

 
Rack Mount Kit

HPE X410 1U Universal 4-post Rackmount Kit J9583A

See Configuration
NOTE: 1

 
Configuration Rules:
   
NOTE 1 If this Mounting Kit is order with #0D1 then it integrates to the HPE Network Rack. (not the switch)
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Aruba 2530 48G PoE+ Switch (J9772A)

I/O ports and slots 48 RJ-45 autosensing 10/100/1000 PoE+ ports (IEEE 802.3 Type 10BASE-T, IEEE
802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T, IEEE 802.3at PoE+);
Media Type: Auto-MDIX; Duplex: 10BASE-T/100BASE-TX: half or full; 1000BASE-T:
full only
4 fixed Gigabit Ethernet SFP ports

Additional ports
and slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 17.44(w) x 13.00(d) x 1.75(h) in (44.3 x 32.26 x 4.45 cm)
(1U height)

Weight 10.4 lb (4.72 kg)

Memory and
processor

Processor ARM9E @ 800 MHz, 128 MB flash; Packet buffer size: 3
MB dynamically allocated, 256 MB DDR3 DIMM

Mounting and
enclosure

Mounts in an EIA-standard 19-inch telco rack or equipment cabinet (rack-mounting kit
available); Horizontal surface mounting; Wall mounting

Performance IPv6 Ready Certified

100 Mb Latency < 7.4 µs (LIFO 64-byte packets)

1000 Mb Latency < 2.3 µs (LIFO 64-byte packets)

Throughput up to 77.3 Mpps (64-byte packets)

Switching capacity 104 Gbps

MAC address table size 16000 entries

Environment Operating temperature 32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Non-operating/
Storage temperature

-40°F to 158°F (-40°C to 70°C)

Non-operating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 43.6 dB, Pressure: 33.6 dB

Electrical
characteristics

Frequency 50/60 Hz

Maximum heat
dissipation

236 BTU/hr (248.98 kJ/hr), (switch only: 236 BTU/hr;
combined switch + max. PoE devices: 1624 BTU/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current 5.8/2.9 A

Maximum power rating 476 W

Idle power 40.1 W

PoE power 382 W

NOTES Idle power is the actual power consumption of the device
with no ports connected. Maximum power rating and
maximum heat dissipation are the worst-case theoretical
maximum numbers provided for planning the
infrastructure with fully loaded PoE (if equipped), 100%
traffic, all ports plugged in, and all modules populated.
PoE power is the total power budget available to all PoE
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ports.
Safety UL 60950-1; CAN/CSA 22.2 No. 60950-1; EN 60825; IEC 60950-1; EN 60950-1

Emissions FCC Class A; EN 55022/CISPR-22 Class A; VCCI Class A

Immunity Generic EN 55024, CISPR 24

EN EN 55024, CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

Harmonics EN 61000-3-2, IEC 61000-3-2

Flicker EN 61000-3-3, IEC 61000-3-3

Management IMC - Intelligent Management Center; command-line interface; Web browser;
configuration menu; out-of-band management (serial RS-232C or Micro USB); IEEE
802.3 Ethernet MIB; Repeater MIB; Ethernet Interface MIB

NOTES IEEE 802.3az applies to Gigabit models only; IEEE 802.3at and IEEE 802.3af apply
to PoE+ models only. When using SFPs with this product, SFPs with revision "B" or
later (product number ends with the letter "B" or later, e.g., J4858B, J4859C) are
required.

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services for
details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
 
Aruba 2530 24G PoE+ Switch (J9773A)

I/O ports and slots 24 RJ-45 autosensing 10/100/1000 PoE+ ports (IEEE 802.3 Type 10BASE-T, IEEE
802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T, IEEE 802.3at PoE+);
Media Type: Auto-MDIX; Duplex: 10BASE-T/100BASE-TX: half or full; 1000BASE-
T: full only
4 fixed Gigabit Ethernet SFP ports

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 17.44(w) x 13.00(d) x 1.75(h) in (44.3 x 33.02 x 4.45 cm) (1U
height)

Weight 8.7 lb (3.95 kg)

Memory and
processor

Processor ARM9E @ 800 MHz, 128 MB flash; Packet buffer size: 1.5
MB dynamically allocated, 256 MB DDR3 DIMM

Mounting and
enclosure

Mounts in an EIA-standard 19-inch telco rack or equipment cabinet (rack-mounting
kit available); Horizontal surface mounting; Wall mounting

Performance IPv6 Ready Certified

100 Mb Latency < 7.4 µs (LIFO 64-byte packets)
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1000 Mb Latency < 2.3 µs (LIFO 64-byte packets)

Throughput up to 41.6 Mpps (64-byte packets)

Switching capacity 56 Gbps

MAC address table
size

16000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Non-operating/
Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Non-
operating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 43.9 dB, Pressure: 39.6 dB

Electrical
characteristics

Frequency 50/60 Hz

Maximum heat
dissipation

135 BTU/hr (142.42 kJ/hr), (switch only: 135 BTU/hr;
combined switch + max. PoE devices: 843 BTU/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current 3.2/1.6 A

Maximum power
rating

247 W

Idle power 25.2 W

PoE power 195 W

NOTES Idle power is the actual power consumption of the device
with no ports connected.
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided for
planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all modules
populated.
PoE power is the total power budget available to all PoE
ports.

Safety UL 60950-1; CAN/CSA 22.2 No. 60950-1; EN 60825; IEC 60950-1; EN 60950-1

Emissions FCC Class A; EN 55022/CISPR-22 Class A; VCCI Class A

Immunity Generic EN 55024, CISPR 24

EN EN 55024, CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

QuickSpecs Aruba 2530 Switch Series

Technical Specifications

DA - 14447   Worldwide QuickSpecs — Version 18 — 12/3/2018 Page  19

Anexo 01 ITEM 10 (0592611)         SEI 0008478-63.2018.6.02.8000 / pg. 4817



Voltage dips and
interruptions

IEC 61000-4-11

Harmonics EN 61000-3-2, IEC 61000-3-2

Flicker EN 61000-3-3, IEC 61000-3-3

Management IMC - Intelligent Management Center; command-line interface; Web browser;
configuration menu; out-of-band management (serial RS-232C or Micro USB);
IEEE 802.3 Ethernet MIB; Repeater MIB; Ethernet Interface MIB

NOTES IEEE 802.3az applies to Gigabit models only; IEEE 802.3at and IEEE 802.3af apply
to PoE+ models only. When using SFPs with this product, SFPs with revision "B" or
later (product number ends with the letter "B" or later, e.g., J4858B, J4859C) are
required.

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services
for details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
Aruba 2530 8G PoE+ Switch (J9774A)

I/O ports and slots 8 RJ-45 autosensing 10/100/1000 PoE+ ports (IEEE 802.3 Type 10BASE-T, IEEE
802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T, IEEE 802.3at PoE+);
Media Type: Auto-MDIX; Duplex: 10BASE-T/100BASE-TX: half or full; 1000BASE-
T: full only
2 dual-personality ports; each port can be used as either an RJ-45 10/100/1000
port (IEEE 802.3 Type 10Base-T; IEEE 802.3u Type 100Base-Tx; IEEE 802.3ab
1000Base-T Gigabit Ethernet) or as a SFP slot (for use with SFP transceivers)

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 10.00(w) x 6.28(d) x 1.75(h) in (25.4 x 15.95 x 4.45 cm) (1U
height)

Weight 2.2 lb (1 kg)

Memory and
processor

Processor ARM9E @ 800 MHz, 128 MB flash; Packet buffer size: 1.5
MB dynamically allocated, 256 MB DDR3 DIMM

Mounting and
enclosure

Mounts in an EIA-standard 19-inch telco rack or equipment cabinet (rack-mounting
kit available); horizontal surface mounting; wall mounting

Performance IPv6 Ready Certified

100 Mb Latency < 7.4µs (LIFO 64-byte packets)

1000 Mb Latency < 2.6 µs (LIFO 64-byte packets)

Throughput up to 14.8 Mpps (64-byte packets)

Switching capacity 20 Gbps

MAC address table
size

16000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), non-condensing

Non-operating/
Storage
temperature

-40°F to 158°F (-40°C to 70°C)
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Non-operating/
Storage relative
humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 0 dB, Pressure: 0 dB

Electrical
characteristics

Frequency 50/60 Hz

Maximum heat
dissipation

65 BTU/hr (68.58 kJ/hr), (switch only: 65 BTU/hr; combined
switch + max. PoE devices: 293 BTU/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current 1.4 A

Maximum power
rating

86 W

Idle power 13.4 W

PoE power 67 W

NOTES Idle power is the actual power consumption of the device
with no ports connected.
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided for
planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all modules
populated.
PoE power is the total power budget available to all PoE
ports.

Safety UL 60950-1; CAN/CSA 22.2 No. 60950-1; EN 60825; IEC 60950-1; EN 60950-1

Emissions FCC Class A; EN 55022/CISPR-22 Class A; VCCI Class A

Immunity Generic EN 55024, CISPR 24

EN EN 55024, CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

Harmonics EN 61000-3-2, IEC 61000-3-2

Flicker EN 61000-3-3, IEC 61000-3-3

Management IMC - Intelligent Management Center; command-line interface; Web browser;
configuration menu; out-of-band management (serial RS-232C or Micro USB);
IEEE 802.3 Ethernet MIB; Repeater MIB; Ethernet Interface MIB

NOTES IEEE 802.3az applies to Gigabit models only; IEEE 802.3at and IEEE 802.3af apply
to PoE+ models only. When using SFPs with this product, SFPs with revision "B" or
later (product number ends with the letter "B" or later, e.g., J4858B, J4859C) are
required.
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Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services
for details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
 
Aruba 2530 48 PoE+ Switch (J9778A)

I/O ports and slots 48 RJ-45 autosensing 10/100 PoE+ ports (IEEE 802.3 Type 10BASE-T, IEEE
802.3u Type 100BASE-TX, IEEE 802.3at PoE+) Media Type: Auto-MDIX Duplex:
half or full
2 autosensing 10/100/1000 ports (IEEE 802.3 Type 10BASE-T, IEEE 802.3u Type
100BASE-TX, IEEE 802.3ab Type 1000BASE-T) Duplex: 10BASE-T/100BASE-TX:
half or full; 1000BASE-T: full only
2 fixed Gigabit Ethernet SFP ports

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 17.40(w) x 12.70(d) x 1.75(h) in (44.2 x 32.26 x 4.45 cm) (1U
height)

Weight 10.1 lb (4.58 kg)

Memory and
processor

Processor ARM9E @ 800 MHz, 128 MB flash; Packet buffer size: 3 MB
dynamically allocated, 256 MB DDR3 DIMM

Mounting and
enclosure

Mounts in an EIA-standard 19-inch telco rack or equipment cabinet (rack-mounting
kit available); Horizontal surface mounting; Wall mounting

Performance IPv6 Ready Certified

100 Mb Latency < 6.6 µs (LIFO 64-byte packets)

1000 Mb Latency < 2.2 µs (LIFO 64-byte packets)

Throughput up to 13 Mpps (64-byte packets)

Switching capacity 17.6 Gbps

MAC address table
size

16000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Non-operating/
Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Non-
operating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 37.9 dB, Pressure: 31.8 dB

Electrical
characteristics

Frequency 50/60 Hz

Maximum heat
dissipation

170 BTU/hr (179.35 kJ/hr), (switch only: 170 BTU/hr;
combined switch + max. PoE devices: 1505 BTU/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated
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Current 5.2/2.6 A

Maximum power
rating

441 W

Idle power 37.5 W

PoE power 382 W

NOTES Idle power is the actual power consumption of the device
with no ports connected.
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided for
planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all modules
populated.
PoE power is the total power budget available to all PoE
ports.

Safety UL 60950-1; CAN/CSA 22.2 No. 60950-1; EN 60825; IEC 60950-1; EN 60950-1

Emissions FCC Class A; EN 55022/CISPR-22 Class A; VCCI Class A

Immunity Generic EN 55024, CISPR 24

EN EN 55024, CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

Harmonics EN 61000-3-2, IEC 61000-3-2

Flicker EN 61000-3-3, IEC 61000-3-3

Management IMC - Intelligent Management Center; command-line interface; Web browser;
configuration menu; out-of-band management (serial RS-232C or Micro USB);
IEEE 802.3 Ethernet MIB; Repeater MIB; Ethernet Interface MIB

NOTES IEEE 802.3az applies to Gigabit models only; IEEE 802.3at and IEEE 802.3af apply
to PoE+ models only. When using SFPs with this product, SFPs with revision "B" or
later (product number ends with the letter "B" or later, e.g., J4858B, J4859C) are
required.

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services
for details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
Aruba 2530 24 PoE+ Switch (J9779A)

I/O ports and slots 24 RJ-45 autosensing 10/100 PoE+ ports (IEEE 802.3 Type 10BASE-T, IEEE
802.3u Type 100BASE-TX, IEEE 802.3at PoE+); Media Type: Auto-MDIX; Duplex:
half or full
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2 autosensing 10/100/1000 ports (IEEE 802.3 Type 10BASE-T, IEEE 802.3u Type
100BASE-TX, IEEE 802.3ab Type 1000BASE-T); Duplex: 10BASE-T/100BASE-
TX: half or full; 1000BASE-T: full only
2 fixed Gigabit Ethernet SFP ports

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 17.40(w) x 12.70(d) x 1.75(h) in (44.2 x 32.26 x 4.45 cm) (1U
height)

Weight 8.4 lb (3.81 kg)

Memory and
processor

Processor ARM9E @ 800 MHz, 128 MB flash; Packet buffer size: 1.5
MB dynamically allocated, 256 MB DDR3 DIMM

Mounting and
enclosure

Mounts in an EIA-standard 19-inch telco rack or equipment cabinet (rack-mounting
kit available); Horizontal surface mounting; Wall mounting

Performance IPv6 Ready Certified

100 Mb Latency < 1.7 µs (LIFO 64-byte packets)

1000 Mb Latency < 1.1µs (LIFO 64-byte packets)

Throughput up to 9.5 Mpps (64-byte packets)

Switching capacity 12.8 Gbps

MAC address table
size

16000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Non-operating/
Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Non-
operating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 40.4 dB, Pressure: 31.7 dB

Electrical
characteristics

Frequency 50/60 Hz

Maximum heat
dissipation

99 BTU/hr (104.45 kJ/hr), (switch only: 99 BTU/hr; combined
switch + max. PoE devices: 809 BTU/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current 2.8/1.4 A

Maximum power
rating

237 W

Idle power 21.8 W

PoE power 195 W

NOTES Idle power is the actual power consumption of the device
with no ports connected.
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided for
planning the infrastructure with fully loaded PoE (if
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equipped), 100% traffic, all ports plugged in, and all modules
populated.
PoE power is the total power budget available to all PoE
ports.

Safety UL 60950-1; CAN/CSA 22.2 No. 60950-1; EN 60825; IEC 60950-1; EN 60950-1

Emissions FCC Class A; EN 55022/CISPR-22 Class A; VCCI Class A

Immunity Generic EN 55024, CISPR 24

EN EN 55024, CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

Harmonics EN 61000-3-2, IEC 61000-3-2

Flicker EN 61000-3-3, IEC 61000-3-3

Management IMC - Intelligent Management Center; command-line interface; Web browser;
configuration menu; out-of-band management (serial RS-232C or Micro USB);
IEEE 802.3 Ethernet MIB; Repeater MIB; Ethernet Interface MIB

NOTES IEEE 802.3az applies to Gigabit models only; IEEE 802.3at and IEEE 802.3af apply
to PoE+ models only. When using SFPs with this product, SFPs with revision "B" or
later (product number ends with the letter "B" or later, e.g., J4858B, J4859C) are
required.

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services
for details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
 
Aruba 2530 8 PoE+ Switch (J9780A)

I/O ports and slots 8 RJ-45 autosensing 10/100 PoE+ ports (IEEE 802.3 Type 10BASE-T, IEEE 802.3u
Type 100BASE-TX, IEEE 802.3at PoE+); Media Type: Auto-MDIX; Duplex: half or
full
2 dual-personality ports; each port can be used as either an RJ-45 10/100/1000 port
(IEEE 802.3 Type 10Base-T; IEEE 802.3u Type 100Base-Tx; IEEE 802.3ab
1000Base-T Gigabit Ethernet) or as a SFP slot (for use with SFP transceivers) ports

Additional ports
and slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 10.00(w) x 6.28(d) x 1.75(h) in (25.4 x 15.95 x 4.45 cm) (1U
height)

Weight 2.0 lb (0.91 kg)

Memory and
processor

Processor ARM9E @ 800 MHz, 128 MB flash; Packet buffer size: 1.5
MB dynamically allocated, 256 MB DDR3 DIMM
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Mounting and
enclosure

Mounts in an EIA-standard 19-inch telco rack or equipment cabinet (rack-mounting
kit available); horizontal surface mounting; wall mounting

Performance IPv6 Ready Certified

100 Mb Latency < 1.3 µs (LIFO 64-byte packets)

1000 Mb Latency < 1.3 µs (LIFO 64-byte packets)

Throughput up to 4.1 Mpps (64-byte packets)

Switching capacity 5.6 Gbps

MAC address table
size

16000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Non-operating/
Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Non-
operating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 0 dB, Pressure: 0 dB

Electrical
characteristics

Frequency 50/60 Hz

Maximum heat
dissipation

29 BTU/hr (30.6 kJ/hr), (switch only: 29 BTU/hr;
combined switch + max. PoE devices: 262 TU/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current 1.4 A

Maximum power
rating

76.7 W

Idle power 5.8 W

PoE power 67 W

NOTES Idle power is the actual power consumption of the device with
no ports connected.
Maximum power rating and maximum heat dissipation are the
worst-case theoretical maximum numbers provided for
planning the infrastructure with fully loaded PoE (if equipped),
100% traffic, all ports plugged in, and all modules populated.
PoE power is the total power budget available to all PoE
ports.

Safety UL 60950-1; CAN/CSA 22.2 No. 60950-1; EN 60825; IEC 60950-1; EN 60950-1

Emissions FCC Class A; EN 55022/CISPR-22 Class A; VCCI Class A

Immunity Generic EN 55024, CISPR 24

EN EN 55024, CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5
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Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

Harmonics EN 61000-3-2, IEC 61000-3-2

Flicker EN 61000-3-3, IEC 61000-3-3

Management IMC - Intelligent Management Center; command-line interface; Web browser;
configuration menu; out-of-band management (serial RS-232C or Micro USB);
IEEE 802.3 Ethernet MIB; Repeater MIB; Ethernet Interface MIB

NOTES IEEE 802.3az applies to Gigabit models only; IEEE 802.3at and IEEE 802.3af apply
to PoE+ models only. When using SFPs with this product, SFPs with revision "B" or
later (product number ends with the letter "B" or later, e.g., J4858B, J4859C) are
required.

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the service-level
descriptions and product numbers. For details about services and response times in
your area, please contact your local Hewlett Packard Enterprise sales office.

 
Aruba 2530 48G Switch (J9775A)

I/O ports and slots 48 RJ-45 autosensing 10/100/1000 ports (IEEE 802.3 Type 10BASE-T, IEEE
802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T); Duplex: 10BASE-
T/100BASE-TX: half or full; 1000BASE-T: full only
4 fixed Gigabit Ethernet SFP ports

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 17.44(w) x 10.00(d) x 1.75(h) in (44.3 x 25.4 x 4.45 cm) (1U
height)

Weight 6.8 lb (3.08 kg)

Memory and
processor

Processor ARM9E @ 800 MHz, 128 MB flash; Packet buffer size: 3 MB
dynamically allocated, 256 MB DDR3 DIMM

Mounting and
enclosure

Mounts in an EIA-standard 19-inch telco rack or equipment cabinet (rack-mounting
kit available); Horizontal surface mounting; Wall mounting

Performance IPv6 Ready Certified

100 Mb Latency < 7.4 µs (LIFO 64-byte packets)

1000 Mb Latency < 2.3 µs (LIFO 64-byte packets)

Throughput up to 77.3 Mpps (64-byte packets)

Switching capacity 104 Gbps

MAC address table
size

16000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing
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Non-operating/
Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Non-
operating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 34.5 dB, Pressure: 31.0 dB

Electrical
characteristics

Frequency 50/60 Hz
Achieved Miercom Certified Green Award

Maximum heat
dissipation

203 BTU/hr (214.17 kJ/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current 1.2/0.7 A

Maximum power
rating

59.5 W

Idle power 29.5 W

NOTES Idle power is the actual power consumption of the device
with no ports connected.
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided for
planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all modules
populated.

Safety UL 60950-1; CAN/CSA 22.2 No. 60950-1; EN 60825; IEC 60950-1; EN 60950-1

Emissions FCC Class A; EN 55022/CISPR-22 Class A; VCCI Class A

Immunity Generic EN 55024, CISPR 24

EN EN 55024, CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

Harmonics EN 61000-3-2, IEC 61000-3-2

Flicker EN 61000-3-3, IEC 61000-3-3

Management IMC - Intelligent Management Center; command-line interface; Web browser;
configuration menu; out-of-band management (serial RS-232C or Micro USB);
IEEE 802.3 Ethernet MIB; Repeater MIB; Ethernet Interface MIB

NOTES IEEE 802.3az applies to Gigabit models only; IEEE 802.3at and IEEE 802.3af apply
to PoE+ models only. When using SFPs with this product, SFPs with revision "B" or
later (product number ends with the letter "B" or later, e.g., J4858B, J4859C) are
required.
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Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services
for details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
Aruba 2530 24G Switch (J9776A)

I/O ports and slots 24 RJ-45 autosensing 10/100/1000 ports (IEEE 802.3 Type 10BASE-T, IEEE
802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T)
Duplex: 10BASE-T/100BASE-TX: half or full; 1000BASE-T: full only
4 fixed Gigabit Ethernet SFP ports

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 17.44(w) x 10.00(d) x 1.75(h) in (44.3 x 25.4 x 4.45 cm) (1U
height)

Weight 6.1 lb (2.77 kg)

Memory and
processor

Processor ARM9E @ 800 MHz, 128 MB flash; Packet buffer size: 1.5
MB dynamically allocated, 256 MB DDR3 DIMM

Mounting and
enclosure

Mounts in an EIA-standard 19-inch telco rack or equipment cabinet (rack-mounting
kit available); Horizontal surface mounting; Wall mounting

Performance IPv6 Ready Certified

100 Mb Latency < 7.4 µs (LIFO 64-byte packets)

1000 Mb Latency < 2.3 µs (LIFO 64-byte packets)

Throughput up to 41.6 Mpps (64-byte packets)

Switching capacity 56 Gbps

MAC address table
size

16000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Non-operating/
Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Non-
operating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 34.0 dB, Pressure: 26.4 dB

Electrical
characteristics

Frequency 50/60 Hz

Maximum heat
dissipation

164 BTU/hr (173.02 kJ/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current .6/.4 A

Maximum power
rating

48.0 W

Idle power 28.8 W
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NOTES Idle power is the actual power consumption of the device
with no ports connected.
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided for
planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all modules
populated.

Safety UL 60950-1; CAN/CSA 22.2 No. 60950-1; EN 60825; IEC 60950-1; EN 60950-1

Emissions FCC Class A; EN 55022/CISPR-22 Class A; VCCI Class A

Immunity Generic EN 55024, CISPR 24

EN EN 55024, CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

Harmonics EN 61000-3-2, IEC 61000-3-2

Flicker EN 61000-3-3, IEC 61000-3-3

Management IMC - Intelligent Management Center; command-line interface; Web browser;
configuration menu; Out-of-band management (serial RS-232C or MicroUSB);
IEEE 802.3 Ethernet MIB; Repeater MIB; Ethernet Interface MIB

NOTES IEEE 802.3az applies to Gigabit models only; IEEE 802.3at and IEEE 802.3af apply
to PoE+ models only. When using SFPs with this product, SFPs with revision "B" or
later (product number ends with the letter "B" or later, e.g., J4858B, J4859C) are
required.

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services
for details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
Aruba 2530 8G Switch (J9777A)

I/O ports and slots 8 RJ-45 autosensing 10/100/1000 ports (IEEE 802.3 Type 10BASE-T, IEEE 802.3u
Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T); Media Type: Auto-MDIX;
Duplex: 10BASE-T/100BASE-TX: half or full;
1000BASE-T: full only
2 dual-personality ports; each port can be used as either an RJ-45 10/100/1000
port (IEEE 802.3 Type 10Base-T; IEEE 802.3u Type 100Base-Tx; IEEE 802.3ab
1000Base-T Gigabit Ethernet) or as a SFP slot (for use with SFP transceivers)
ports

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 10(w) x 6.28(d) x 1.75(h) in (25.4 x 15.95 x 4.45 cm) (1U
height)

Weight 2.0 lb (0.91 kg)
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Memory and
processor

Processor ARM9E @ 800 MHz, 128 MB flash; Packet buffer size: 1.5
MB dynamically allocated, 256 MB DDR3 DIMM

Mounting and
enclosure

Mounts in an EIA-standard 19-inch telco rack or equipment cabinet (rack-mounting
kit available); horizontal surface mounting; wall mounting

Performance IPv6 Ready Certified

100 Mb Latency < 7.4 µs (LIFO 64-byte packets)

1000 Mb Latency < 2.6 µs (LIFO 64-byte packets)

Throughput up to 14.8 Mpps (64-byte packets)

Switching capacity 20 Gbps

MAC address table
size

16000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Non-operating/
Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Non-
operating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 0 dB, Pressure: 0 dB

Electrical
characteristics

Frequency 50/60 Hz

Maximum heat
dissipation

63 BTU/hr (66.46 kJ/hr), (switch only: 63 BTU/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current 0.5 A

Maximum power
rating

18.6 W

Idle power 13.6 W

 

NOTES Idle power is the actual power consumption of the device
with no ports connected.
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided for
planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all modules
populated

Safety UL 60950-1; CAN/CSA 22.2 No. 60950-1; EN 60825; IEC 60950-1; EN 60950-1

Emissions FCC Class A; EN 55022/CISPR-22 Class A; VCCI Class A

Immunity Generic EN 55024, CISPR 24

EN EN 55024, CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5
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Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

Harmonics EN 61000-3-2, IEC 61000-3-2

Flicker EN 61000-3-3, IEC 61000-3-3

Management IMC - Intelligent Management Center; command-line interface; Web browser;
configuration menu; Out-of-band management (serial RS-232C or MicroUSB);
IEEE 802.3 Ethernet MIB; Repeater MIB; Ethernet Interface MIB

NOTES IEEE 802.3az applies to Gigabit models only; IEEE 802.3at and IEEE 802.3af apply
to PoE+ models only. When using SFPs with this product, SFPs with revision "B" or
later (product number ends with the letter "B" or later, e.g., J4858B, J4859C) are
required.

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services
for details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
Aruba 2530 48 Switch (J9781A)

I/O ports and slots 48 RJ-45 autosensing 10/100 ports (IEEE 802.3 Type 10BASE-T, IEEE 802.3u
Type 100BASE-TX); Duplex: half or full
2 autosensing 10/100/1000 ports (IEEE 802.3 Type 10BASE-T, IEEE 802.3u Type
100BASE-TX, IEEE 802.3ab Type 1000BASE-T); Duplex: 10BASE-T/100BASE-
TX: half or full; 1000BASE-T: full only
2 fixed Gigabit Ethernet SFP ports

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 17.40(w) x 9.70(d) x 1.75(h) in (44.2 x 24.64 x 4.45 cm) (1U
height)

Weight 6.3 lb (2.86 kg)

Memory and
processor

Processor ARM9E @ 800 MHz, 128 MB flash; Packet buffer size: 3 MB
dynamically allocated, 256 MB DDR3 DIMM

Mounting and
enclosure

Mounts in an EIA-standard 19-inch telco rack or equipment cabinet (rack-mounting
kit available); Horizontal surface mounting; Wall mounting

Performance IPv6 Ready Certified

100 Mb Latency < 6.6 µs (LIFO 64-byte packets)

1000 Mb Latency < 2.2 µs (LIFO 64-byte packets)

Throughput up to 13 Mpps (64-byte packets)

Switching capacity 17.6 Gbps

MAC address table
size

16000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing
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Non-operating/
Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Non-
operating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 0 dB, Pressure: 0 dB

Electrical
characteristics

Frequency 50/60 Hz

Maximum heat
dissipation

102 BTU/hr (107.61 kJ/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current 0.7/0.4 A

Maximum power
rating

29.9 W

Idle power 17.1 W

 

NOTES Idle power is the actual power consumption of the device
with no ports connected.
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided for
planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all modules
populated.

Safety UL 60950-1; CAN/CSA 22.2 No. 60950-1; EN 60825; IEC 60950-1; EN 60950-1

Emissions FCC Class A; EN 55022/CISPR-22 Class A; VCCI Class A

Immunity Generic EN 55024, CISPR 24

EN EN 55024, CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

Harmonics EN 61000-3-2, IEC 61000-3-2

Flicker EN 61000-3-3, IEC 61000-3-3

Management IMC - Intelligent Management Center; command-line interface; Web browser;
configuration menu; Out-of-band management (serial RS-232C or MicroUSB);
IEEE 802.3 Ethernet MIB; Repeater MIB; Ethernet Interface MIB

NOTES IEEE 802.3az applies to Gigabit models only; IEEE 802.3at and IEEE 802.3af apply
to PoE+ models only. When using SFPs with this product, SFPs with revision "B" or
later (product number ends with the letter "B" or later, e.g., J4858B, J4859C) are
required.
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Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services
for details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
Aruba 2530 24 Switch (J9782A)

I/O ports and slots 24 RJ-45 autosensing 10/100 ports (IEEE 802.3 Type 10BASE-T, IEEE 802.3u
Type 100BASE-TX); Duplex: half or full
2 autosensing 10/100/1000 ports (IEEE 802.3 Type 10BASE-T, IEEE 802.3u Type
100BASE-TX, IEEE 802.3ab Type 1000BASE-T); Duplex: 10BASE-T/100BASE-
TX: half or full; 1000BASE-T: full only
2 fixed Gigabit Ethernet SFP ports

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 17.40(w) x 9.70(d) x 1.75(h) in (44.2 x 24.64 x 4.45 cm) (1U
height)

Weight 5.7 lb (2.59 kg)

Memory and
processor

Processor ARM9E @ 800 MHz, 128 MB flash; Packet buffer size: 1.5
MB dynamically allocated, 256 MB DDR3 DIMM

Mounting and
enclosure

Mounts in an EIA-standard 19-inch telco rack or equipment cabinet (rack-mounting
kit available); Horizontal surface mounting; Wall mounting

Performance IPv6 Ready Certified

100 Mb Latency < 1.7 µs (LIFO 64-byte packets)

1000 Mb Latency < 1.1 µs (LIFO 64-byte packets)

Throughput up to 9.5 Mpps (64-byte packets)

Switching capacity 12.8 Gbps

MAC address table
size

16000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Non-operating/
Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Non-
operating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 0 dB, Pressure: 0 dB

Electrical
characteristics

Frequency 50/60 Hz

Maximum heat
dissipation

50 BTU/hr (52.75 kJ/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current 0.3/0.2 A
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Maximum power
rating

14.7 W

Idle power 8.4 W

 

NOTES Idle power is the actual power consumption of the device
with no ports connected.
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided for
planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all modules
populated.

Safety UL 60950-1; CAN/CSA 22.2 No. 60950-1; EN 60825; IEC 60950-1; EN 60950-1

Emissions FCC Class A; EN 55022/CISPR-22 Class A; VCCI Class A

Immunity Generic EN 55024, CISPR 24

EN EN 55024, CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

Harmonics EN 61000-3-2, IEC 61000-3-2

Flicker EN 61000-3-3, IEC 61000-3-3

Management IMC - Intelligent Management Center; command-line interface; Web browser;
configuration menu; Out-of-band management (serial RS-232C or MicroUSB);
IEEE 802.3 Ethernet MIB; Repeater MIB; Ethernet Interface MIB

NOTES IEEE 802.3az applies to Gigabit models only; IEEE 802.3at and IEEE 802.3af apply
to PoE+ models only. When using SFPs with this product, SFPs with revision "B" or
later (product number ends with the letter "B" or later, e.g., J4858B, J4859C) are
required.

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services
for details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
Aruba 2530 8 Switch (J9783A)

I/O ports and slots 8 RJ-45 autosensing 10/100 ports (IEEE 802.3 Type 10BASE-T, IEEE 802.3u Type
100BASE-TX); Media Type: Auto-MDIX; Duplex: half or full
2 dual-personality ports; each port can be used as either an RJ-45 10/100/1000
port (IEEE 802.3 Type 10Base-T; IEEE 802.3u Type 100Base-Tx; IEEE 802.3ab
1000Base-T Gigabit Ethernet) or as a SFP slot (for use with SFP transceivers)
ports

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

QuickSpecs Aruba 2530 Switch Series

Technical Specifications

DA - 14447   Worldwide QuickSpecs — Version 18 — 12/3/2018 Page  35

Anexo 01 ITEM 10 (0592611)         SEI 0008478-63.2018.6.02.8000 / pg. 4833

http://www.hpe.com/networking/services


Physical
characteristics

Dimensions 10.00(w) x 6.28(d) x 1.75(h) in (25.4 x 15.95 x 4.45 cm) (1U
height)

Weight 1.8 lb (0.82 kg)

Memory and
processor

Processor ARM9E @ 800 MHz, 128 MB flash; Packet buffer size: 1.5
MB dynamically allocated, 256 MB DDR3 DIMM

Mounting and
enclosure

Mounts in an EIA-standard 19-inch telco rack or equipment cabinet (rack-mounting
kit available); horizontal surface mounting; wall mounting

Performance IPv6 Ready Certified

100 Mb Latency < 1.3 µs (LIFO 64-byte packets)

1000 Mb Latency < 1.3 µs (LIFO 64-byte packets)

Throughput up to 4.1 Mpps (64-byte packets)

Switching capacity 5.6 Gbps

MAC address table
size

16000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Non-operating/
Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Non-
operating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 0 dB, Pressure: 0 dB

Electrical
characteristics

Frequency 50/60 Hz

Maximum heat
dissipation

25 BTU/hr (26.38 kJ/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current 0.5 A

Maximum power
rating

7.2 W

Idle power 4.5 W

 

NOTES Idle power is the actual power consumption of the device
with no ports connected.
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided for
planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all modules
populated.

Safety UL 60950-1; CAN/CSA 22.2 No. 60950-1; EN 60825; IEC 60950-1; EN 60950-1

Emissions FCC Class A; EN 55022/CISPR-22 Class A; VCCI Class A

Immunity Generic EN 55024, CISPR 24

EN EN 55024, CISPR 24

ESD IEC 61000-4-2
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Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

Harmonics EN 61000-3-2, IEC 61000-3-2

Flicker EN 61000-3-3, IEC 61000-3-3

Management IMC - Intelligent Management Center; command-line interface; Web browser;
configuration menu; Out-of-band management (serial RS-232C or MicroUSB);
IEEE 802.3 Ethernet MIB; Repeater MIB; Ethernet Interface MIB

NOTES IEEE 802.3az applies to Gigabit models only; IEEE 802.3at and IEEE 802.3af apply
to PoE+ models only. When using SFPs with this product, SFPs with revision "B" or
later (product number ends with the letter "B" or later, e.g., J4858B, J4859C) are
required.

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services
for details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
Aruba 2530 8 PoE+ Internal PS Switch (JL070A)

I/O ports and slots 8 RJ-45 autosensing 10/100 PoE+ ports (IEEE 802.3 Type 10BASE-T, IEEE
802.3u Type 100BASE-TX, IEEE 802.3at PoE+); Media Type: Auto-MDIX; Duplex:
half or full
2 dual-personality ports; each port can be used as either an RJ-45 10/100/1000
port (IEEE 802.3 Type 10Base-T; IEEE 802.3u Type 100Base-Tx; IEEE 802.3ab
1000Base-T Gigabit Ethernet) or as a SFP slot (for use with SFP transceivers)
ports

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 10(w) x 9.68(d) x 1.75(h) in (25.4 x 24.59 x 4.45 cm) (1U
height)

Weight 4.65 lb (2.11 kg)

Memory and
processor

Processor ARM9E @ 800 MHz, 128 MB flash; Packet buffer size: 1.5
MB dynamically allocated, 256 MB DDR3 DIMM

Mounting and
enclosure

Mounts in an EIA-standard 19-inch telco rack or equipment cabinet (rack-mounting
kit available); Horizontal surface mounting; Wall mounting

Performance IPv6 Ready Certified

100 Mb Latency < 1.3 µs (LIFO 64-byte packets)

1000 Mb Latency < 1.3 µs (LIFO 64-byte packets)

10 Gbps Latency  

Throughput up to 4.1 Mpps (64-byte packets)

Switching capacity 5.6 Gbps

MAC address table
size

16000 entries
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Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Non-operating/
Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Non-
operating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 0 dB, Pressure: 0 dB

Electrical
characteristics

Frequency 50/60 Hz

Maximum heat
dissipation

29 BTU/hr (30.6 kJ/hr), (switch only: 29 BTU/hr; combined
switch + max. PoE devices: 239 BTU/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current 0.9/0.5 A

Maximum power
rating

70.2 W

Idle power 5.3 W

PoE Power 67 W PoE

NOTES Idle power is the actual power consumption of the device
with no ports connected.
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided for
planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all modules
populated.
PoE power is the total power budget available to all PoE
ports.

Safety UL 60950-1; CAN/CSA 22.2 No. 60950-1; EN 60825; IEC 60950-1; EN 60950-1

Emissions FCC Class A; EN 55022/CISPR-22 Class A; VCCI Class A

Immunity Generic EN 55024, CISPR 24

EN EN 55024, CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

Harmonics EN 61000-3-2, IEC 61000-3-2

Flicker EN 61000-3-3, IEC 61000-3-3
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Management Imc - intelligent management center; Command-line interface; Web browser;
Configuration menu; Out-of-band management (serial rs-232c or micro usb); Ieee
802.3 ethernet mib; Repeater mib; Ethernet interface mib

NOTES IEEE 802.3az applies to Gigabit models only; IEEE 802.3at and IEEE 802.3af apply
to PoE+ models only.
When using SFPs with this product, SFPs with revision "B" or later (product number
ends with the letter "B" or later, e.g., J4858B, J4859C) are required.

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services
for details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
Standards and protocols (applies to all products in series)

Denial of service protection Network DoS Filter

Device Management RFC 1591 DNS (client)
RFC 2576 (Coexistence between SNMP V1, V2, V3)
RFC 2579 (SMIv2 Text Conventions)
RFC 2580 (SMIv2 Conformance)
RFC 3416 (SNMP Protocol Operations v2)
RFC 3417 (SNMP Transport Mappings)
SSHv1/SSHv2 Secure Shell

General Protocols IEEE 802.1D MAC Bridges
IEEE 802.1p Priority
IEEE 802.1Q VLANs
IEEE 802.1s Multiple Spanning Trees
IEEE 802.1w Rapid Reconfiguration of Spanning Tree
IEEE 802.3 Type 10BASE-T
IEEE 802.3ab 1000BASE-T
IEEE 802.3ad Link Aggregation Control Protocol (LACP)
IEEE 802.3af Power over Ethernet
IEEE 802.3at Power over Ethernet Plus
IEEE 802.3az Energy Efficient Ethernet
IEEE 802.3x Flow Control
RFC 768 UDP
RFC 783 TFTP Protocol (revision 2)
RFC 792 ICMP
RFC 793 TCP
RFC 826 ARP
RFC 854 TELNET
RFC 868 Time Protocol
RFC 951 BOOTP
RFC 1350 TFTP Protocol (revision 2)
RFC 1542 BOOTP Extensions
RFC 1918 Address Allocation for Private Internet
RFC 2030 Simple Network Time Protocol (SNTP) v4
RFC 2131 DHCP
RFC 3411 An Architecture for Describing Simple Network Management
Protocol (SNMP) Management Frameworks
RFC 3412 Message Processing and Dispatching for the Simple Network
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Management Protocol (SNMP)
RFC 3413 Simple Network Management Protocol (SNMP) Applications
RFC 3414 User-based Security Model (USM) for version 3 of the Simple
Network Management Protocol (SNMPv3)
RFC 3415 View-based Access Control Model (VACM) for the Simple
Network Management Protocol (SNMP)
RFC 3416 Protocol Operations for SNMP
RFC 3575 IANA Considerations for RADIUS
RFC 5905 Network Time Protocol Version 4: Protocol and Algorithms
Specification

IP Multicast RFC 2236 IGMPv2

IPv6 RFC 1981 IPv6 Path MTU Discovery
RFC 2460 IPv6 Specification
RFC 2464 Transmission of IPv6 over Ethernet Networks
RFC 2925 Remote Operations MIB (Ping only)
RFC 3315 DHCPv6 (client only)
RFC 3484 Default Address Selection for IPv6
RFC 3513 IPv6 Addressing Architecture
RFC 3596 DNS Extension for IPv6
RFC 3810 Multicast Listener Discovery Version 2 (MLDv2) for IPv6
RFC 4022 MIB for TCP
RFC 4113 MIB for UDP
RFC 4251 SSHv6 Architecture
RFC 4252 SSHv6 Authentication
RFC 4252 SSHv6 Transport Layer
RFC 4254 SSHv6 Connection
RFC 4291 IP Version 6 Addressing Architecture
RFC 4293 MIB for IP
RFC 4419 Key Exchange for SSH
RFC 4443 ICMPv6
RFC 4861 IPv6 Neighbor Discovery
RFC 4862 IPv6 Stateless Address Auto-configuration
RFC 5095 Deprecation of Type 0 Routing Headers in IPv6

MIBs RFC 1155 Structure & ID of Mgmt Info for TCP/IP Internets
RFC 1212 Concise MIB Definitions
RFC 1213 MIB II
RFC 1493 Bridge MIB
RFC 2021 RMONv2 MIB
RFC 2578 Structure of Management Information Version 2 (SMIv2)
RFC 2579 Textual Conventions for SMIv2
RFC 2613 SMON MIB
RFC 2618 RADIUS Client MIB
RFC 2620 RADIUS Accounting Client MIB
RFC 2665 Ethernet-Like-MIB
RFC 2668 802.3 MAU MIB
RFC 2674 802.1p and IEEE 802.1Q Bridge MIB
RFC 2737 Entity MIB (Version 2)
RFC 2863 The Interfaces Group MIB
RFC 4836 Managed Objects for 802.3 Medium Attachment Units (MAU)
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Network Management IEEE 802.1AB Link Layer Discovery Protocol (LLDP)
RFC 1098 A Simple Network Management Protocol (SNMP)
RFC 1155 Structure of Management Information
RFC 2819 Four groups of RMON: 1 (statistics), 2 (history), 3 (alarm) and 9
(events)
RFC 3411 SNMP Management Frameworks
RFC 3412 Message Processing and Dispatching for the Simple Network
Management Protocol (SNMP)
RFC 3413 Simple Network Management Protocol (SNMP) Applications
RFC 3414 User-based Security Model (USM) for version 3 of the Simple
Network Management Protocol (SNMPv3)
RFC 3415 View-based Access Control Model (VACM) for the Simple
Network Management Protocol (SNMP)
RFC 3418 Management Information Base (MIB) for the Simple Network
Management Protocol (SNMP)
RFC 5424 Syslog Protocol
ANSI/TIA-1057 LLDP Media Endpoint Discovery (LLDP-MED)
SNMPv1/v2c/v3

QoS/CoS RFC 2474 DiffServ precedence, with 4 queues per port
RFC 2475 DiffServ Architecture
RFC 2597 DiffServ Assured Forwarding (AF)
RFC 2598 DiffServ Expedited Forwarding (EF)

Security IEEE 802.1X Port Based Network Access Control
RFC 1492 TACACS+
RFC 2138 RADIUS Authentication
RFC 2866 RADIUS Accounting
Secure Sockets Layer (SSL)
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Aruba 2530 Switch Series accessories  
   

Transceivers

Aruba 100M SFP LC FX 2km MMF Transceiver J9054D
Aruba 1G SFP RJ45 T 100m Cat5e Transceiver J8177D
Aruba 1G SFP LC SX 500m OM2 MMF Transceiver J4858D
Aruba 1G SFP LC LX 10km SMF Transceiver J4859D
Aruba 1G SFP LC LH 70km SMF Transceiver J4860D
   
Cables  

Aruba X2C2 RJ45 to DB9 Console Cable JL448A
   
Mounting Kit  

HPE X410 1U Universal 4-post Rackmount Kit J9583A
   
Aruba 2530 8G PoE+ Switch (J9774A)  

Aruba 2530 8-port Switch Pwr Adptr Shelf J9820A
Aruba X510 1U Cable Guard J9700A
   
Aruba 2530 8 PoE+ Switch (J9780A)  

Aruba 2530 8-port Switch Pwr Adptr Shelf J9820A
Aruba X510 1U Cable Guard J9700A
   
Aruba 2530 8G Switch (J9777A)  

Aruba 2530 8-port Switch Pwr Adptr Shelf J9820A
Aruba X510 1U Cable Guard J9700A
   
Aruba 2530 8 Switch (J9783A)  

Aruba 2530 8-port Switch Pwr Adptr Shelf J9820A
Aruba X510 1U Cable Guard J9700A
   
Aruba 2530 8 PoE+ Internal PS Switch (JL070A)  

Aruba X510 1U Cable Guard J9700A
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NOTE:  Details are not available for all accessories. The following specifications were available at the time
of publication.

 
HPE X111 100M SFP LC
FX Transceiver
(J9054C)

 

Ports 1 LC 100BASE-FX port (IEEE 802.3u Type 100BASE-FX);
Duplex: half or full

Physical
characteristics

Dimensions: 2.7(d) x 0.54(w) x 0.48(h) in. (6.86 x 1.38 x 1.22
cm)
Weight: 0.06 lb. (0.03 kg)

Environment Operating temperature: 32ºF to 158ºF (0ºC to 70ºC)
Operating relative humidity: 5% to 95%
Nonoperating/Storage temperature: -40ºF to 185ºF (-40ºC to
85ºC)
Nonoperating/Storage relative humidity: 5% to 85%
Altitude: up to 10,000 ft. (3 km)

Cabling Type:

62.5/125 µm or 50/125 µm (core/cladding) diameter,
graded-index, low metal content, multimode fiber optic,
complying with ITU-T G.651 and ISO/IEC 793-2 Type
A1b or A1a, respectively

Maximum distance:

2 km (full duplex) or 412 m (half duplex)
NOTES Transmitter wavelength: 1310nm

Power consumption is 1.1 watt maximum.

For supported platforms and minimum software requirements to support
this product, see the document titled "Support for the J9054C 100-FX
SFP-LC Transceiver" on the "HPE Mini-GBICs and SFPs" Manuals Web
page.

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the
service-level descriptions and product numbers. For details
about services and response times in your area, please
contact your local Hewlett Packard Enterprise sales office.
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HPE X112 100M SFP
LC BX-D Transceiver
(J9099B)

A small form-factor
pluggable (SFP) 100-
Megabit BX (bi-
directional)
"downstream"
transceiver that
provides 100 Mbps full-
duplex connectivity up
to 10 km on one strand
of singlemode fiber.
The J9099B connects
to the J9100B
"upstream" transceiver,
or to any IEEE-standard
100BASE-BX10-U
("upstream") device.

Ports 1 LC 100BASE-BX10 port (IEEE 802.3ah Type 100BASE-
BX10-D); Duplex: full only

Physical
characteristics

Dimensions 2.7(d) x 0.55(w) x 0.48(h) in. (6.86 x
1.39 x 1.22 cm)

Weight 0.04 lb. (0.03 kg)

Environment Operating temperature 32ºF to 158ºF (0ºC to 70ºC)

Operating relative
humidity

0% to 95%, noncondensing

Nonoperating/Storage
temperature

-40ºF to 185ºF (-40ºC to 85ºC)

Cabling Type:

Single-mode fiber optic, complying with ITU-T G.652;

Maximum distance:

0.5-10,000 m (single-mode fiber)
NOTES Transmit wavelength: 1550 nm. Receive wavelength: 1310 nm.

Power consumption is 1.1 watt maximum.
For supported platforms and minimum software requirements to
support this product, see the document titled "Support for the
HPE BX Transceivers" on the "HPE Mini-GBICs and SFPs"
Manuals Web page.
The J9099B connects to the J9100B "upstream" transceiver, or
to any IEEE-standard 100BASE-BX10-U ("upstream") device. (A
100-BX-D transceiver can only connect to a 100-BX-U product.
You cannot connect two 100-BX-D transceivers together.)

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the
service-level descriptions and product numbers. For details
about services and response times in your area, please contact
your local Hewlett Packard Enterprise sales office.

 
HPE X112 100M SFP
LC BX-U Transceiver
(J9100B)

A small form-factor
pluggable (SFP) 100-
Megabit BX (bi-
directional) "upstream"
transceiver that
provides 100 Mbps full-
duplex connectivity up
to 10 km on one strand
of singlemode fiber.
The J9100B connects
to the J9099B
"downstream"
transceiver, or to any
IEEE-standard
100BASE-BX10-D

Ports 1 LC 100BASE-BX10 port (IEEE 802.3ah Type 100BASE-
BX10-U); Duplex: full only

Physical
characteristics

Dimensions 2.7(d) x 0.55(w) x 0.48(h) in. (6.86 x
1.39 x 1.22 cm)

Weight 0.07 lb. (.03 kg)

Environment Operating temperature 32ºF to 158ºF (0ºC to 70ºC)

Operating relative
humidity

0% to 95%, noncondensing

Nonoperating/Storage
temperature

-40ºF to 185ºF (-40ºC to 85ºC)

Cabling Type:

Single-mode fiber optic, complying with ITU-T G.652;

Maximum distance:
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("downstream")
device.

0.5-10,000 m (single-mode fiber)
NOTES For supported platforms and minimum software requirements to

support this product, see the document titled "Support for the
HPE BX Transceivers" on the "HPE Mini-GBICs and SFPs"
Manuals Web page.
The J9100B connects to the J9099B "downstream" transceiver,
or to any IEEE-standard 100BASE-BX10- D ("downstream")
device. (A 100-BX-U transceiver can only connect to a 100-BX-
D product. You cannot connect two 100-BX-U transceivers
together.)
Transmit wavelength: 1310 nm. Receive wavelength: 1550 nm.
Power consumption is 1.1 watts maximum.

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the
service-level descriptions and product numbers. For details
about services and response times in your area, please contact
your local Hewlett Packard Enterprise sales office.

 
HPE X121 1G SFP LC
SX Transceiver
(J4858C)

A small form-factor
pluggable (SFP) Gigabit
SX
transceiver that provides
a full-duplex Gigabit
solution
up to 550 m on
multimode fiber.

Ports 1 LC 1000BASE-SX port; Duplex: full only
Physical
characteristics

Dimensions: 2.24(d) x 0.54(w) x 0.48(h) in. (5.69 x 1.37 x 1.22
cm)
Weight: 0.04 lb. (0.02 kg)
Transceiver form factor: SFP

Environment Operating temperature: 32°F to 158°F (0°C to 70°C)
Operating relative humidity: 5% to 85%, noncondensing
Nonoperating/Storage temperature: -40°F to 203°F (-40°C to
85°C)
Altitude: up to 10,000 ft. (3 km)

Electrical
characteristics

Power consumption typical: 0.4 W
Power consumption maximum: 0.7 W

Cabling Type:

62.5/125 µm or 50/125 µm (core/cladding) diameter,
graded-index, low metal content, multimode fiber optic,
complying with ITU-T G.651 and ISO/IEC 793-2 Type
A1b or A1a, respectively;

Maximum distance:

2-220 m (62.5 µm core diameter, 160 MHz*km bandwidth
2-275 m (62.5 µm core diameter, 200 MHz*km bandwidth
2-500 m (50 µm core diameter, 400 MHz*km bandwidth)
2-550 m (50 µm core diameter, 500 MHz*km bandwidth)

Cable length: 2-550m
Fiber type: Multi Mode

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the
service-level descriptions and product numbers. For details
about services and response times in your area, please
contact your local Hewlett Packard Enterprise sales office.
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HPE X121 1G SFP LC
LX Transceiver
(J4859C)

HP X121 1G SFP LC LX
Transceiver: An SFP
format
gigabit transceiver with
LC connectors using LX
technology.

Ports 1 LC 1000BASE-LX port (IEEE 802.3z Type 1000BASE-LX);
Duplex: full only

Physical
characteristics

Dimensions: 2.24(d) x 0.54(w) x 0.486(h) in. (5.69 x 1.37 x
1.23 cm)
Weight:0.04 lb. (0.02 kg)

Environment Operating temperature: 32°F to 158°F (0°C to 70°C)
Operating relative humidity: 0% to 85%, noncondensing
Nonoperating/Storage temperature: -40°F to 212°F (-40°C to
100°C)
Altitude: up to 10,000 ft. (3 km)

Cabling Type:

Either single mode or multimode; 62.5/125 µm or 50/125
µm (core/cladding) diameter, graded-index, low metal
content, multimode fiber optic, complying with ITU-T
G.651 and ISO/IEC 793-2 Type A1b or A1a, respectively;
Low metal content, single-mode fiber-optic, complying
with ITU-T G.652 and ISO/IEC 793-2 Type B1;

Maximum distance:

2-550 m (multimode 62.5 µm core diameter, 500 MHz*km
bandwidth)
2-550 m (multimode 50 µm core diameter, 400 MHz*km
bandwidth)
2-550 m (multimode 50 µm core diameter, 500 MHz*km
bandwidth)
2-10,000 m (single-mode fiber)

NOTES A mode conditioning patch cord may be needed in some
multimode fiber installations.
Wavelength: 1310nm
Power Consumption: < 500mW Typical

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the
service-level descriptions and product numbers. For details
about services and response times in your area, please
contact your local Hewlett Packard Enterprise sales office.
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HPE X121 1G SFP LC
LH Transceiver
(J4860C)

A small form-factor
pluggable (SFP) Gigabit
LH transceiver that
provides a full-duplex
Gigabit solution up to 70
km on single-mode fiber.

Ports 1 LC 1000BASE-LH port (no IEEE standard exists for 1550 nm
optics); Duplex: full only

Physical
characteristics

Dimensions: 2.17(d) x 0.60(w) x 0.46(h) in. (5.5 x 1.53 x 1.18
cm)
Weight: 0.04 lb. (0.02 kg)

Environment Operating temperature: -40°F to 185°F (-40°C to 85°C)
Operating relative humidity: 0% to 95% @ 77°F (25°C),
noncondensing
Nonoperating/Storage temperature: -40°F to 185°F (-40°C to
85°C)
Altitude: up to 10,000 ft. (3 km)

Cabling Cable type:

Low metal content, single-mode fiber-optic, complying
with ITU-T G.652 and ISO/IEC 793-2 Type B1;

Maximum distance:

10-70,000 m (single-mode fiber)
NOTES Power consumption is 0.8 watts typical with 1 watt maximum at

100% utilization.
For distances less than 20 km, a 10 dB attenuator must be
used.
For distances between 20 km and 40 km, a 5 dB attenuator
must be used.
Attenuators can be purchased from most cable vendors.

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the
service-level descriptions and product numbers. For details
about services and response times in your area, please
contact your local Hewlett Packard Enterprise sales office.

 
 
HPE X121 1G SFP
RJ45 T Transceiver
(J8177C)

A small form-factor
pluggable (SFP) Gigabit
copper transceiver that
provides a full-duplex
Gigabit solution up to
100 m on Category 5 or
better cable

Ports 1 RJ-45 1000BASE-T port (IEEE 802.3ab Type 1000BASE-T);
Duplex: full only

Physical
characteristics

Dimensions: 0.54(w) x 2.71(d) x 0.55(h) in (1.37 x 6.88 x 1.4
cm)
Weight: 0.06 lb (0.03 kg)

Environment Operating temperature: 32°F to 158°F (0°C to 70°C); with 100
LFM airflow over the SFP module
Operating relative humidity: 0% to 95% @ 75°F (25°C),
noncondensing
Nonoperating/Storage temperature: -40°F to 185°F (-40°C to
85°C)
Nonoperating/Storage relative humidity: 0% to 95% @ 77°F
(25°C), noncondensing
Altitude: up to 10,000 ft. (3000 km)

Cabling Cable type:
1000BASE-T: Category 5 (5E or better recommended), 100 ' differential
4-pair unshielded twisted pair (UTP) or shielded twisted pair (STP)
balanced, complying with IEEE 802.3ab 1000BASE-T;
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Maximum distance:

100 m
NOTES Power consumption is nominally 1 watt.

For supported platforms and minimum software requirements to support
this product, see the document titled "Support for the J8177C
1000Base-T Mini-GBIC" on the "HPE Mini-GBICs and SFPs" Manuals
Web page.
The J8177C Gigabit copper mini-GBIC is not supported on dual-
personality ports.
The J8177C is capable of 100 Mb operation. This is supported on only
the HPE ProCurve Switch 8200zl, 5400zl, and 6200yl Series using
software version K.12.21 or later. Use the "auto-100" port setting to
enable 100 Mb operation.
Important: Important: The earlier J8177B does not support 100 Mb
operation.
When used in the ProCurve Switch gl 20-Port 10/100/1000 Module
(J4908A), the J8177C mini-GBIC can be installed in either the upper or
lower mini-GBIC port, but will block access to the other port.

 
HPE X410 1U Universal 4-post Rackmount Kit (J9583A)

NOTES The rack mounting kit supports the 1U, full width switches in the following switch series and the
power supply: V1810 Series, E2510 Series, E2520 Series, E2610 Series, E2810 Series, E2910
Series, E3500 Series, and the E620 Power Supply
This universal rack mounting kit is design to fit the following racks: HPE 10K 10642, HPE 10K
10842, Panduit CN, Panduit CS, Wrightline Vantage S2, APC Netshelter 600mm, and APC
Netshelter 800mm. It may well fit many other brands and models too.

Services Refer to the Hewlett Packard Enterprise website at:
http://www.hpe.com/networking/services for details on the service-level
descriptions and product numbers. For details about services and response times in
your area, please contact your local Hewlett Packard Enterprise sales office.

 
Aruba 2530 8-port
Switch Pwr Adptr Shelf
(J9820A)

Physical
characteristics

  6.75(w) x 5.25(d) x 1.75(h) in (17.15 x
13.34 x 4.45 cm) (1U height)

Weight 0.6 lb (0.27 kg)
NOTES The HPE 2530 8-Port Switch Power Adapter Shelf is an accessory for

the HPE 2530 8-port switches. The shelf mounts on the back of the
switch providing a place to hold the external power adapter.

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the
service-level descriptions and product numbers. For details
about services and response times in your area, please
contact your local Hewlett Packard Enterprise sales office.
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Date Version History Action Description of Change
03-Dec-2018 Version 18 Changed Features and Benefits updated
02-Jul-2018 Version 17 Changed Software feature update
05-Feb-2018 Version 16 Changed Updates made on Technical Specifications and

Configuration
08-Jan-2018 Version 15 Changed Software feature update
03-Jul-2017 Version 14 Added SKU added: JL448A
01-Aug-2016 Version 13 Changed Adding #AC3 Option on Configuration Menu
06-June-2016 Version 12 Changed Overview, Features and Benefits, Technical

Specifications, and Accessories updated. SKU
descriptions updated.

08-Jan-2016 Version 11 Changed URLs updated
01-Dec-2015 Version 10 Changed QuickSpecs name changed to Aruba 2530

Switch Series
Overview, Features and Benefits, Accessories
updated

30-Mar-2015 Version 9 Added Added new SKU:
JL070A

Changed Changes made in the Overview, Technical
Specifications, and Accessories sections.

01-Dec-2014 Version 8 Changed Updated Warranty and support, updated
technical specifications

18-Aug-2014 Version 7 Added Added 4 new models: J9856A, J9854A,
J9855A, J9853A

Changed Changes made on the entire QS.
09-Dec-2013 Version 6 Changed Changes made in the Overview, Technical

Specifications, and Accessories sections.
12-Nov-2013 Version 5 Changed Build to Order, Rack Level Integration CTO

Models, and Cables were revised.
27-Sep-2013 Version 4 Changed Change made to the Configuration Section -

Rack Mount Kit
17-Sep-2013 Version 3 Changed Corrected an issue with the EMEA HTML file.
10-Jun-2013 Version 2 Changed Changes made to the following:

Added several new models
Updated Accessories
Added the new Configuration section
Updated Features and Benefits
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This guide provides information on how to use the switch interfaces and introduces basic operations.

Applicable products
This guide applies to these products:

Aruba 2530 Switch Series (J9772A, J9773A, J9774A, J9775A, J9776A, J9777A, J9778A, J9779A, J9780A,
J9781A, J9782A, J9783A, J9853A, J9854A, J9855A, J9856A, JL070A)

Aruba 2540 Switch Series (JL354A, JL355A, JL356A, JL357A)

Aruba 2920 Switch Series (J9726A, J9727A, J9728A, J9729A, J9836A)

Aruba 2930F Switch Series (JL253A, JL254A, JL255A, JL256A, JL258A, JL259A, JL260A, JL261A, JL262A,
JL263A, JL264A, JL557A, JL558A, JL559A)

Aruba 2930M Switch Series (JL319A, JL320A, JL321A, JL322A, JL323A, JL324A)

Aruba 3810 Switch Series (JL071A, JL072A, JL073A, JL074A, JL075A, JL076A)

Aruba 5400R zl2 Switch Series (J9821A, J9822A, J9850A, J9851A, JL001A, JL002A, JL003A, JL095A)

Switch prompts used in this guide
Examples in this guide are representative and may not match your particular switch/environment. Examples use
simplified prompts as follows:

Prompt Explanation

switch# # indicates manager context (authority).

switch> > indicates operator context (authority).

switch(config)# (config) indicates the config context.

switch(vlan-x)# (vlan-x) indicates the vlan context of config, where x
represents the VLAN ID. For example:
switch(vlan-128)#.

switch(eth-x)# (eth-x) indicates the interface context of config,
where x represents the interface. For example:
switch(eth-48)#.

switch-Stack# Stack indicates that stacking is enabled.

switch-Stack(config)# Stack(config) indicates the config context while
stacking is enabled.

switch-Stack(stacking)# Stack(stacking) indicates the stacking context of
config while stacking is enabled.

Table Continued

Chapter 1
About this guide
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Prompt Explanation

switch-Stack(vlan-x)# Stack(vlan-x) indicates the vlan context of config
while stacking is enabled, where x represents the
VLAN ID. For example: switch-
Stack(vlan-128)#.

switch-Stack(eth-x/y)# Stack(eth-x/y) indicates the interface context of
config, in the form (eth-<member-in-stack>/
<interface>). For example: switch(eth-1/48)#

10 Aruba Basic Operation Guide for ArubaOS-Switch 16.05
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Using the switch setup screen
The quickest and easiest way to minimally configure the switch for management and password protection is to
use a direct console connection to the switch, start a console session and access the Switch Setup screen.

Procedure

1. Using the method described in the Installation and Getting Started Guide for your switch, connect a terminal
device to the switch and display the switch console command (CLI) prompt (the default display).

2. The CLI prompt appears displaying the switch model number, for example: HPE switch#

3. Screen. The following illustration is an example of a Setup screen with default settings. Your screen may vary
slightly.

Figure 1: Example Switch Setup screen

4. Use the [Tab] key to select the Manager Password field and enter a manager password of up to 16
characters and press [Tab].

5. Tab to the IP Config (DHCP/Bootp) field and use the Space bar to select the Manual option and press [Tab].

6. Tab to the IP Address field and enter the IP address that is compatible with your network and press Enter.

Chapter 2
Getting Started
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7. Tab to the Subnet Mask field and enter the subnet mask used for your network.

8. Press S (for Save).

After editing, pressing Enter and then selecting Save will also save the configuration.

Table 1: Setup screen field descriptions

Parameter Default

System
Name

blank Optional; up to 255 characters, including spaces

System
Contact

blank Optional; up to 255 characters, including spaces

Manager
Password

blank Recommended; up to 16 characters (no blank spaces)

Logon
Default

CLI The default setting selects the command-line interface for console access. The
alternative is the Menu interface.

Time Zone 0 (none) Optional: 1440 to -1440. The number of minutes your location is to the West (-) or
East (+) of GMT.

Community
Name

public Default setting recommended.

Spanning
Tree Enabled

No Default setting recommended unless STP is already running on your network or the
switch will be used in complex network topologies.

Default
Gateway

blank Recommended. Enter the IP address of the next-hop gateway node if network traffic
has to reach off-subnet destinations.

Time Sync
Method

TimeP Optional: The protocol the switch uses to acquire a time signal. The options are
SNTP and TimeP.

TimeP Mode Disabled Synchronizes the time kept on the switch to the TimeP server1.

IP Config DHCP/
Bootp

Set to Manual unless a DHCP/Bootp server is used on your network to configure IP
addressing.

IP Address xxx.xxx.xx
x.xxx

Recommended. If you set IP Config to Manual, then enter an IP address compatible
with your network2.

Subnet Mask xxx.xxx.xx
x.xxx

Recommended. If you entered an IP address, then enter a subnet mask compatible
with your network2.

1For more on this topic, see the "Time Protocols" chapter in the latest Management and Configuration Guide for
your switch.
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2The IP address and subnet mask assigned for the switch must be compatible with the IP addressing used in your
network. For more on IPv4 addressing, see Configuring IP Addressing on page 128. For IPv6 addressing
topics, see the latest IPv6 configuration guide for your switch.

Recommended minimal configuration
In the factory default configuration, the switch has no IP (Internet Protocol) address and subnet mask, and no
passwords. In this state, it can be managed only through a direct console connection. To manage the switch
through in-band (networked) access, you must configure the switch with an IP address and subnet mask
compatible with your network. Also, you must configure a Manager password to control access privileges from the
console and web browser interface. Other parameters in the Switch Setup screen can be left at their default
settings or you can configure them with values you enter.

For more information on IP addressing, see Configuring IP Addressing on page 128.

By default, the switch is configured to acquire an IPv4 address configuration from a DHCP or Bootp
server. To use DHCP/Bootp instead of the manual method described in this chapter, see DHCP/
Bootp Operation in the Management and Configuration Guide for your switch.

For information on configuring IPv6 addressing, see to the latest IPv6 Configuration Guide for your
switch.

Login banners

Custom log in banners
You can configure the switch to display a login banner of up to 3070 characters. An operator initiates a
management session with the switch through any of the following methods:

• Telnet

• Serial connection

• SSHv2

• WebAgent

The default banner displays product registration information.

If a banner is configured, the banner page is displayed when you access the WebAgent. The default product
registration information is not displayed as there is already a product registration prompt displayed in the
WebAgent.

Banner operation with telnet, serial, or SSHv2 access
When a system operator begins a login session, the switch displays the banner above the prompts for local
password and Press any key to continue. Entering a correct password or, if no password is configured, pressing
any key clears the banner from the CLI and displays the CLI prompt.

Banner operation with the WebAgent
When a system operator uses the WebAgent to access the switch, the text of a nondefault banner configured on
the switch appears in a dedicated banner window with a link to the next page. Click Continue to display either the
Registration page or the switch’s home page. If the banner feature is disabled or if the switch is using the factory-
default banner, then the banner page does not appear in the WebAgent screen when an operator initiates a login
session with the switch.

Chapter 2 Getting Started 13
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Banner operating notes

• The default banner appears only when the switch is in the factory default configuration. Using the command
no banner motd deletes the currently configured banner text and blocks display of the default banner. The
default banner is restored only if the switch is reset to its factory default configuration.

• The switch supports one banner at any time. Configuring a new banner replaces any former banner configured
on the switch.

• If the switch is configured with ssh version 1 or ssh version 1-or-2, configuring the banner sets the
SSH configuration to ssh version 2 and displays the message Warning: SSH version has been
set to v2.

• If a banner is configured, the switch does not allow configuration with ssh version 1 or ssh version 1-
or-2. Attempting to do so produces the error message Banner has to be disabled first..

• If a banner is enabled on the switch, the WebAgent displays Notice to all users on the banner page.

banner motd command with non-interactive mode
The use of escape characters allows the banner motd command to be used in non-interactive mode for multiple
message lines. In non-interactive mode, you can create a banner message enclosed in double quotes or other
delimiter that uses escape characters within the delimiters. Other existing CLI commands do not support the
escape characters. For more information on interactive and non-interactive mode, see Enabling and disabling
CLI interactive command mode on page 60 in this guide.

Table 2: Supported escape characters

Character

\" double quote

\’ single quote

\` forward quote

\\ backslash

\f form feed

\n newline

\r carriage return

\t horizontal tab

\v vertical tab

Configuring the banner message using escape characters within double quote delimiters

switch(config)# banner motd 
"You can use the \’banner motd\’ CLI command in non-interactive mode.\n\n\tThe banner
motd command will support escape characters."
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switch(config)# show banner motd

Banner Information

Banner status: Enabled

Configured Banner:

You can use the ‘banner motd’ CLI command in non-interactive mode.

     The banner motd command will support escape characters."

The running configuration file with banner motd configured in non-interactive mode

switch(config)# show running-config

Running configuration:

;J8693A Configuration Editor; Created on release #K.15.10.0002
;Ver #01:01:00

hostname "switch"
vlan 1
  name "DEFAULT_VLAN"
  untagged 1-48, a1-a4
  ip address dhcp-bootp
  exit
banner motd "You can use the \’banner motd\’ CLI command in
non-interactive mode.\n\n\tThe banner motd command will support
escape characters."

Configuring the banner message using an alternate delimiter of ‘#’

switch(config)# banner motd #
Enter TEXT message.

End with the character ‘#’.

You can use the banner motd CLI command in non-interactive mode. The banner motd command \n\n\t
will support escape characters #.

Chapter 2 Getting Started 15
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Starting a menu interface session
Starting the session

In its factory default configuration, the switch console starts with the CLI prompt. To use the menu interface with
Manager privileges, go to the Manager level prompt and enter the menu command.

Prerequisites

Before you start a menu interface session, you must complete the following tasks:

1. Configure and connect to the switch. See the Installation and Getting Started Guide for your switch.

2. Access the menu interface using any of the following methods.

• A direct serial connection to the switch console port, as described in the installation guide you received with
the switch.

• A Telnet connection to the switch console from a networked PC or the switch web interface. To use Telnet,
your switch must first be configured with an IP address and subnet mask compatible with your network.

Procedure

1. Use one of these methods to connect to the switch:

a. A PC terminal emulator or terminal

b. Telnet

2. Do one of the following:

a. If you are using Telnet, go to step 3.

b. If you are using a PC terminal emulator, press [Enter] one or more times until a prompt appears.

3. When the switch screen appears, do one of the following:

a. If a password has been configured, the password prompt appears.

Password: _
Type the Manager password and press [Enter]. Entering the Manager password gives you manager-level
access to the switch. (Entering the Operator password gives you operator-level access to the switch. See
the Access Security Guide for your switch.)

b. If no password has been configured, the CLI prompt appears. Go to the next step.

Chapter 3
Using the Menu Interface
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4. When the CLI prompt appears, display the Menu interface by entering the menu command. For example:
switch# menu [Enter] results in the following display:

Figure 2: Example of the Main Menu with Manager Privileges

For a description of Main Menu features, see Main Menu features on page 20.

To configure the switch using the menu interface instead of the CLI, go to the Manager level prompt
in the CLI, enter the setup command, and in the resulting display, change the Logon Default
parameter to Menu. For more information, see the Installation and Getting Started Guide of your
switch.

Ending a menu session and exiting the console
The method for ending a menu session and exiting the console depends on whether, during the session, any
changes made to the switch configuration requires a switch reboot to activate. (Most changes via the menu
interface need only a Save, and do not require a switch reboot.) Configuration changes that need a reboot are
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marked with an asterisk (*) next to the configured item in the menu and also next to the Switch Configuration
item in the Main Menu.

Figure 3: Example indication of a configuration change requiring a reboot

Procedure

1. In the current session, if you have not made configuration changes that require a switch reboot to activate,
return to the Main Menu and press [0] (zero) to logout. Then, exit the terminal program, turn off the terminal, or
quit the Telnet session.

2. If you have made configuration changes that require a switch reboot— that is, if an asterisk (*) appears next to
a configured item or next to Switch Configuration in the Main Menu:

a. Return to the Main Menu.

b. Press [6] to select Reboot Switch and follow the instructions on the reboot screen.

3. Rebooting the switch terminates the menu session, and if you are using Telnet, disconnects the Telnet session.
(See Rebooting the switch on page 93).

4. Exit from the terminal program, turn off the terminal, or close the Telnet application program.

Rebooting the switch
Rebooting the switch from the menu interface:

Procedure

1. Terminates all current sessions and performs a reset of the operating system

2. Activates any menu interface configuration changes that require a reboot

3. Resets statistical counters to zero

(Note that statistical counters can be reset to zero without rebooting the switch.)
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To Reboot the switch, use the Reboot Switch option in the Main Menu. (Note that Reboot Switch is not available
if you log on in Operator mode; that is, if you enter an Operator password instead of a manager password at the
password prompt.)

Figure 4: The Reboot Switch option in the Main Menu

Rebooting to activate configuration changes. Configuration changes for most parameters in the menu
interface become effective as soon as you save them. However, you must reboot the switch to implement a
change in the Maximum VLANs to support parameter. To access this parameter, go to the Main Menu and
select:

    2. Switch Configuration

         8. VLAN Menu

             1. VLAN Support.
      
If you make configuration changes in the menu interface that require a reboot, the switch displays an asterisk (*)
next to the menu item in which the change has been made. For example, if you change and save the value for the
Maximum VLANs to support parameter, an asterisk appears next to the VLAN Support entry in the VLAN Menu
screen, and also next to the Switch Configuration entry in the Main Menu.

To activate changes indicated by the asterisk, go to the Main Menu and select the Reboot Switch option.

Executing the write memory command in the CLI does not affect pending configuration changes
indicated by an asterisk in the menu interface. That is, only a reboot from the menu interface or a
boot or reload command from the CLI will activate a pending configuration change indicated by an
asterisk.

Configuring ports on HPE 3800 switches with stacking
enabled
When stacking is enabled on an HPE 3800 switch, the procedures for configuring specific switch ports are the
same as for 3800 switches without stacking enabled. However, the port designations for the ports in the stack are
modified. That is, each port is identified by its switch’s stack member ID followed by a slash and then the port
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number, as it is shown on the switch. For example, for a switch with stack member ID 3, port 10 on that switch is
identified as port 3/10 for CLI command input and output. Entering a CLI command on a 3800 switch configured
for stacking without using the modified port designation results in the message ”Module not present for port or
invalid port”.

For more on this topic, see "Interaction with Other Switch Features" in the "Stack Management" chapter of the
latest Management and Configuration Guide for 3800 switches.

Using individual features of the menu interface.
To use the individual features of the menu interface, see the references listed in the following table.

Option: Turn to:

To use the Run Setup option See the Installation and Getting Started Guide shipped with the
switch.

To view and monitor switch status and
counters

Appendix B, "Monitoring and Analyzing Switch Operation" in the
Management and Configuration Guide for your switch.

To learn how to configure and use
passwords and other security features

See the Access Security Guide for your switch.

To learn how to use the Event Log Appendix C, "Using the Event Log for Troubleshooting Switch
Problems" in the Management and Configuration Guide for your
switch.

To learn how the CLI operates Using the Command Line Interface (CLI) on page 57

To download switch software Appendix A, "File Transfers" in the Management and Configuration
Guide for your switch.

For a description of how switch memory
handles configuration changes

Configuring the switch on page 76

Main Menu features
The Main Menu gives you access to these Menu interface features:

• Status and Counters:

Provides access to display screens showing switch information, port status and counters, and port and VLAN
address tables. (See the Management and Configuration Guide for your switch.) All of the items that are
included in Status and Counters are stated in the following list:

◦ Address Table

◦ General System Information

◦ Module Information

◦ Port Address Table

◦ Port Counters

◦ Port Status
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◦ Spanning Tree Information

◦ Switch Management Address Information

◦ VLAN Address Table

• Switch Configuration:

Provides access to configuration screens for displaying and changing the current configuration settings. (See
the contents listing at the front of this manual.) For an index of the features covered in the software manuals
for your switch, see the Software feature index-extended manual for your switch. All of the items that are
included in Switch Configuration are stated in the following list:

◦ System Information

◦ Port/Trunk Settings

◦ Network Monitoring Port

◦ IP Configuration

◦ SNMP Community Names

◦ IP authorized Managers

◦ VLAN Menu

◦ Spanning Tree Operation

• Console Passwords:

Provides access to the screen used to set or change Manager-level and Operator-level passwords, and to
delete Manager and Operator password protection. (See the Access Security Guide for your switch.)

• Event Log:

Enables you to read progress and error messages that are useful for checking and troubleshooting switch
operation. (See the Management and Configuration Guide for your switch.)

• Command Line (CLI):

Selects the Command Line Interface at the same level (Manager or Operator) that you are accessing in the
Menu interface.

• Reboot Switch:

Performs a "warm" reboot of the switch, which clears most temporary error conditions, resets the network
activity counters to zero, and resets the system up-time to zero. A reboot is required to activate a change in
the VLAN Support parameter.

• Download OS:

Enables you to download a new software version to the switch. (See Appendix A, "File Transfers" in the
Management and Configuration Guide for your switch.)

• Run Setup:

Displays the Switch Setup screen for quickly configuring basic switch parameters such as IP addressing,
default gateway, logon default interface, and others. (See the Installation and Getting Started Guide for your
switch.)

• Logout:

Closes the Menu interface and console session, and disconnects Telnet access to the switch.

Chapter 3 Using the Menu Interface 21

Anexo 02 ITEM 10 (0592613)         SEI 0008478-63.2018.6.02.8000 / pg. 4869



Overview of the Menu Interface
The menu interface operates through the switch console to provide you with a subset of switch commands in an
easy-to-use menu format.

• Performs a "quick configuration" of basic parameters, such as the IP addressing required to provide
management access through your network

• Configures these features:

◦ Manager and Operator passwords

◦ System parameters

◦ IP addressing

◦ Time protocol

◦ Ports

◦ Trunk groups

◦ A network monitoring port

◦ SNMP community names

◦ IP authorized managers

◦ VLANs (Virtual LANs) and GVRP

• View status, counters, and Event Log information

• Update switch software

• Reboot the switch

For a detailed list of menu features, see the Main Menu features on page 20.

Screen structure and navigation
Menu interface screens include these three elements:

• Parameter fields and/or read-only information such as statistics

• Navigation and configuration actions, such as Save, Edit, and Cancel

• Help line to describe navigation options, individual parameters, and read-only data
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For example, in the following System Information screen:

Figure 5: Elements of the screen structure

"Forms" design. The configuration screens, in particular, operate similarly to a number of PC applications that
use forms for data entry. When you first enter these screens, you see the current configuration for the item you
have selected. To change the configuration, the basic operation is to:

1. Press [E] to select the Edit action.

2. Navigate through the screen making all the necessary configuration changes.

3. Press [Enter] to return to the Actions line. From there, you can save the configuration changes or cancel the
changes. Cancel returns the configuration to the values you saw when you first entered the screen.
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Table 3: How to navigate the Menu interface

Task: Actions:

Execute an
action from the
"Actions –>" list
at the bottom of
the screen:

Reconfigure
(edit) a
parameter
setting or a field:

1. Select a configuration item, such as System Name.

2. Press [E](for Edit on the Actions line).

3. Use [[Tab]] or the arrow keys ([←], [→], [↑], or [↓]) to highlight the item or field.

4. Do one of the following:

• If the parameter has preconfigured values, either use the Space bar to select a new
option or enter the first part of your selection and the rest of the selection appears
automatically. (The help line instructs you to "Select" a value.)

• If there are no preconfigured values, type in a value (the Help line instructs you to
"Enter" a value).

5. If you want to change another parameter value, return to step 3.

6. If you are finished editing parameters in the displayed screen, press [Enter] to return to
the Actions line and do one of the following:

• To save and activate configuration changes, press [S] (for the Save action). This saves
the changes in the startup configuration and also implements the change in the
currently running configuration. (See, "Switch Memory and Configuration".)

• To exit from the screen without saving any changes that you have made (or if no
changes are done), press [C] (for the Cancel action).

Note: In the menu interface, executing Save activates most parameter changes and saves
them in the startup configuration (or flash) memory, and it is therefore not necessary to
reboot the switch after making these changes. But, if an asterisk appears next to any menu
item you reconfigure, the switch will not activate or save the change for that item until you
reboot the switch. In this case, rebooting must be done after you have made all desired
changes and then returned to the Main Menu.

7. When you finish editing parameters, return to the Main Menu.

8. If necessary, reboot the switch by highlighting Reboot Switch in the Main Menu and
pressing [Enter]. (See the Note in Step 6.)

Exit from a
read-only
screen.

Press [B] (for the Back action).

To get Help on individual parameter descriptions. In most screens, there is a Help option in the Actions line.
Whenever any of the items in the Actions line are highlighted, press [H], and a separate help screen is displayed.

24 Aruba Basic Operation Guide for ArubaOS-Switch 16.05

Anexo 02 ITEM 10 (0592613)         SEI 0008478-63.2018.6.02.8000 / pg. 4872



To get Help on the actions or data fields in each screen: Use the arrow keys ([←], [→], [↑], or [↓]) to select an
action or data field. The help line under the Actions items describes the currently selected action or data field.

For guidance on how to navigate in a screen: See the instructions provided at the bottom of the screen, or See 
Screen structure and navigation on page 22.)

Privilege levels and password security
Hewlett Packard Enterprise strongly recommends that you configure a Manager password to help prevent
unauthorized access to your network. A Manager password grants full read/write access to the switch. An
Operator password grants access to status and counter, Event Log, and the Operator level in the CLI. After you
configure passwords on the switch and log off of the interface, access to the menu interface (and the CLI and web
browser interface) requires entries of either the Manager or Operator password.

• If the switch does not have Manager or an Operator password, anyone having access to the
console interface can operate the console with full manager privileges.

• If you configure only an Operator password, entering the Operator password enables full
manager privileges.

• If the switch only has a Manager password someone without a password can still gain read-only
access.

For more information on passwords, see the Access Security Guide for your switch.

Menu interaction with other interfaces
The menu interface displays the current running-config parameter settings. From the running config, use the
menu interface to save configuration changes made in the CLI. A configuration change made through any switch
interface overwrites earlier changes made through any other interface.

The Menu Interface and the CLI both use the switch console. Use the menu command to enter the menu from the
CLI and the CLI option from the menu interface to enter the CLI.

For more on how switch memory manages configuration changes, see the Switch Memory and Configuration.
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Management and configuration of ArubaOS-Switch can occur through its web interface. Two interfaces are
available, the Legacy UI and the Next Generation UI.

• The Legacy UI provides full functionality for the monitoring and configuration of switches running ArubaOS.

• The Next Generation UI provides a subset of the Legacy UI functionality. Additional functionality will be added
in future releases and it will eventually replace the Legacy UI.

Accessing the ArubaOS-Switch Next Generation UI
Access the ArubaOS-Switch Improved UI by clicking the Access Improved GUI link displayed in the upper right
corner of the Traditional UI.

Figure 6: Traditional UI

Using HTTPS secure connection
ArubaOS-Switch devices can be configured and monitored using a web browser based HTTP interface, which is
enabled by default. However, this connection method is unencrypted, thus making it vulnerable to credential
interception by devices connected to the network in the path between the user and the switch being configured.
To secure connections to the web management UI, it is recommended to enable HTTPS and disable HTTP
access to the switch. HTTPS is HTTP traffic running on a Secure Sockets Layer (SSL)/Transport Layer Security
(TLS) connection, which requires a certificate to be present on the switch. To generate a certificate; enable
HTTPS, and disable HTTP, the steps are as follows:

Procedure

1. Open a switch console session and enter the configuration context using the command:

Chapter 4
ArubaOS-Switch UI
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switch# configure
2. Create a self-signed SSL/TLS certificate.

switch(config)# crypto pki enroll-self-signed certificate-name <name of certificate> subject common-name <common name of device>

a. View the SSL/TLS certificate information.

switch(config)# show crypto pki local-certificate web-mgmt
Certificate Detail:
Version: 3 (0x2)
Serial Number:
   56:12:69:dd:3d:91:c1:8a:4e:2c:f4:62:a3:0a:96:76:b5:f0:b4:31
Signature Algorithm: sha256withRSAEncryption
Issuer: CN=5400R
Validity
   Not Before: Aug 14 13:33:32 2017 GMT
   Not After : Aug 14 23:59:59 2018 GMT
Subject: CN=5400R
Subject Public Key Info:
   Public Key Algorithm: rsaEncryption
   RSA Public Key: (1024 bit)
      Modulus (1024 bit):
          30:0d:06:09:2a:86:48:86:f7:0d:01:01:01:05:00:
          03:81:8d:00:30:81:89:02:81:81:00:b0:90:f9:d8:
          88:f0:d5:eb:31:1e:aa:06:3b:30:5a:5b:d2:ed:eb:
          ff:12:ff:9d:52:55:98:cd:2a:c2:72:8e:94:69:47:
          a3:29:0f:f7:47:c3:c9:57:fa:11:d8:9a:8d:2f:e4:
          84:5e:3d:67:b2:fc:59:81:53:83:12:6a:68:6b:a5:
          4d:20:8f:b5:be:a2:23:b9:aa:e5:9a:55:ac:4a:fb:
          20:4b:71:6d:74:db:ab:89:4f:ed:27:c0:aa:31:fa:
          4b:64:76:be:f8:11:de:0e:5e:1e:17:b2:ba:a2:13:
          ce:2e:aa:31:d6:51:ad:e5:ed:23:93:42:27:d2:44:
          bd:2f:83:9d:02:03:01:00:01
      Exponent: 65537 (0x10001)
X509v3 extensions:
   X509v3 Key Usage: critical
      Digital Signature, Key Encipherment, Key Agreement
   X509v3 Extended Key Usage:
      TLS Web Server Authentication

Signature Algorithm: sha256withRSAEncryption
   5c:00:9e:b2:8a:98:49:f3:e5:11:51:a8:2b:23:07:0c:f8:e8:
   26:bf:09:98:8a:9a:45:22:57:5b:af:ab:2f:ed:34:50:4d:ac:
   d9:59:18:e1:52:68:7f:20:ae:14:e7:d9:97:1b:91:5f:ae:ba:
   cd:b5:d3:7b:14:b6:da:99:fa:4f:2b:ed:65:96:59:fc:87:45:
   1c:49:93:2b:8c:47:3e:08:ae:7f:85:c3:31:58:17:32:d5:13:
   60:a3:c1:d2:4c:69:d5:54:7e:3d:e2:67:64:ba:38:6e:cb:c5:
   9e:17:9e:0b:30:52:8f:47:5d:59:2b:0e:c3:14:07:8f:f0:71:
   97:9d
MD5 Fingerprint: cbdc 5288 60e1 9576 4fd8 1f1d cae7 4edc
SHA1 Fingerprint: 6ea3 7708 a6dd cd6d 065b 1b34 1734 f385 42d6 0121

3. Enable HTTPS web management.

switch(config)# web-management ssl
4. (Recommended) Disable HTTP web management.
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switch(config)# no web-management
5. Verify the web-management configuration.

switch(config)# show web-management

 Web Management - Server Configuration

  HTTP Access    : Disabled
  HTTPS Access   : Enabled
  SSL Port       : 443
  Idle Timeout   : 600 seconds
  Management URL : http://h17007.www1.hpe.com/device_help
  Support URL    : http://www.arubanetworks.com/products/networking/
  User Interface : Improved
  Listen Mode    : bot

6. To log into the web management UI, open a browser and enter an IP address configured on the switch .

For example, https://X.X.X.X

IP addresses are configured on the switch by the VLAN. Use show ip command to view the configured IP
addresses.

For more information about SSL/TLS configuration, see the ArubaOS-Switch Access Security Guide of your
switch.
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Improved UI functionality
Overview

The Improved UI includes four major elements that are common across all views within the UI. The dashboard
view, which provides an at-a-glance overview of system performance, is displayed here as an example. All four
elements are described below the dashboard image.

Figure 7: Improved UI dashboard

Header panel

This is the panel in the upper right corner of the screen. It includes the following icons and fields, from left to right:

• Search: Enter a search term in this field and press Enter to view results.

Reboot: Click this icon to reboot the switch. You will be asked to confirm before the switch is rebooted.

• Refresh: Click this icon to reload the components and refresh the page.

• Toggle locator LED: Click this icon to identify a physical device.

• Notifications: Click this icon to see a list of recent events.

• Help: Click this icon to see the help text associated with the current screen.

• User details: Click this icon to see a list of user roles. You can also launch the Traditional user interface by
clicking Launch Traditional GUI.

• Settings: Click this icon to modify the web interface settings for the current screen.

Navigation pane

This is the gray bar on the left side of the screen. It contains a series of drop-down menus, each representing an
area of functionality, that allow you to navigate through the Improved UI. The drop-down menus include:
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• General: Includes the Dashboard submenu.

• System: Includes the Status, Events, Monitor, SNMP, Firmware Update, and Stack (supported only for BPS/
VSF) submenus.

• Interfaces: Includes the Ports, PoE, Monitor, VLANs, and Trunks submenus.

• Traffic: Includes the Spanning Tree submenu.

• Security: Includes the Clients, User Roles, Intrusion Log, Port Security, and IP Authorization submenus.

• Configurations: Includes the Config Report and Management submenus.

View pane

The view pane is a series of viewing options to the right of the navigation pane. It is broken into two sections:

Status panels - These panels display the status of the following elements.

Click on the ... icon in each status panel to navigate to the detailed view associated with the selected
panel. For example, if you click on ... in th PoE view option, you will jump to the PoE page.

• PoE: Displays PoE port status.

◦ Green: No PoE ports have a fault or have been denied power.

◦ Yellow: One or more PoE ports have been denied power.

◦ Red: One or more PoE ports have a fault.

• Storage: Displays system storage status.

◦ Green: The current system storage use is within normal range.

◦ Yellow: The current system storage use exceeds the warning threshold of 70%.

◦ Red: The current system storage use exceeds the critical threshold of 90%.

• Fans: Displays system fan status.

◦ Green: All fans are operating normally.

◦ Yellow: One or more fans have failed but the number of failures does not exceed 50% of all system fans.

◦ Red: At least 50% of the system fans have failed.

• Security: Displays security status based on the Intrusion Log flags.

◦ Green: No intrusion events have occurred since acknowledgement.

◦ Yellow: This status has no warning state.

◦ Red: At least one new intrusion event has occurred.

• Spanning Tree: Displays spanning tree status.
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◦ Green: Spanning tree is disabled or no loop/root inconsistent ports were detected.

◦ Yellow: Either loop or root inconsistent ports were detected.

◦ Red: Both loop and root inconsistent ports were detected.

• Clients: Displays the summarized status of clients connected to the switch.

◦ Green: All switch clients successfully authenticated/No Clients Connected.

◦ Yellow: At least one client is not properly authenticated.

◦ Red: Client authentication attempts were rejected.

• Ports: Displays ports with warning or critical events.

◦ Green: Only info/debug events occurred on device ports.

◦ Yellow: Warning events have occurred on one or more ports.

◦ Red: Error/major events have occurred on one or more ports.

• Power Supplies: Displays system power supply status.

◦ Green: All power supplies are operating normally.

◦ Yellow: One or more power supplies have failed but the number of failures does not exceed 40% of all
system power supplies.

◦ Red: At least 40% of the system power supplies have failed.

• Temperatures: Displays system temperature status.

◦ Green: The current system temperature is within normal range.

◦ Yellow: The current system temperature exceeds the warning threshold of <variable>. The threshold is
based on a user-controlled setting on the switch.

◦ Red: The current system temperature exceeds the critical threshold of <variable>. The threshold is based
on a user-controlled setting on the switch.

• Uptime: Displays the device system uptime.

Gauges - These gauges display information about:

• CPU: Displays the current CPU usage of the device.

◦ The outer ring of the gauge indicates regions of normal, warning, and critical values.

◦ The peak value shown on the inner ring indicates the highest CPU usage reached for the device.

◦ Green: CPU usage is within normal range.

◦ Yellow: CPU usage exceeds the warning threshold of 75%.

◦ Red: CPU usage exceeds the critical threshold of 90%.

• Memory: Displays the current memory usage of the device.
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◦ The outer ring of the gauge indicates regions of normal, warning, and critical values.

◦ The peak value shown on the inner ring indicates the highest memory usage reached for the device.

◦ Green: Memory usage is within normal range.

◦ Yellow: Memory usage exceeds the warning threshold of 75%.

◦ Red: Memory usage exceeds the critical threshold of 90%.

• Packet Buffers: Displays the current packet buffer usage of the device.

◦ The outer ring of the gauge indicates regions of normal, warning, and critical values.

◦ The peak value shown on the inner ring indicates the highest packet buffer usage reached for the device.

◦ Green: Packet buffer usage is within normal range.

◦ Yellow: Packet buffer usage exceeds the warning threshold of 85%.

◦ Red: Packet buffer usage exceeds the critical threshold of 95%.

• Tx Drops: Displays the current transmit drop rate of the device.

◦ The outer ring of the gauge indicates regions of normal, warning, and critical values.

◦ The peak value shown on the inner ring indicates the highest transmit drop rate reached for the device.

◦ Green: Transmit drop rate is within normal range.

◦ Yellow: Transmit drop rate exceeds the warning threshold of 3% of transmit attempts.

◦ Red: Transmit drop rate exceeds the critical threshold of 5% of transmit attempts.

• Message Buffers: Displays the current message buffer usage of the device.

◦ The outer ring of the gauge indicates regions of normal, warning, and critical values.

◦ The peak value shown on the inner ring indicates the highest message buffer usage reached for the device.

◦ Green: Message buffer usage is within normal range.

◦ Yellow: Message buffer usage exceeds the warning threshold of 75%.

◦ Red: Message buffer usage exceeds the critical threshold of 90%.

• Rx Errors: Displays the current receive error rate of the device.

◦ The outer ring of the gauge indicates regions of normal, warning, and critical values.

◦ The peak value shown on the inner ring indicates the highest receive error rate reached for the device.
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◦ Green: Receive error rate is within normal range.

◦ Yellow: Receive error rate exceeds the warning threshold of 2% of received frames.

◦ Red: Receive error rate exceeds the critical threshold of 5% of received frames.

• Top Interfaces: Displays the top ten ports with any one of 25 user-selected metrics (RX Total Frames in this
example). Only ports that are enabled and up will be shown.

Right pane

Also called the events pane, this section displays:

• The latest events on the system

• User settings per page

• User roles across the system

• Help information

System — Status
Figure 8: System–Status

IP Info: Displays the basic IP configuration of the default VLAN. It is also possible to specify an IP configuration
mode and associated settings.

Hardware: Displays basic hardware information for the device or stack commander. The MAC address and serial
number of the device or stack commander are shown.

System Info: Displays general system information including:
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• Product name

• Configured values for the device name

• Contact

• Location

• Uptime since the device was last rebooted

For a stack, this information pertains to the stack commander. It is also possible to edit the values for device
name, contact, and location.

Software Versions: Displays the primary software, secondary software, and ROM versions for the device or, for a
stack, the stack commander. In a stack, the commander's active software version is propagated to all stack
members.

Storage: Displays system storage details for the device or, for a stack, summary data for each stack member.

• For a standalone device, a breakout of storage use per volume is shown.

• For a stack member, clicking the icon in its summary will navigate to the Stack page for the member where its
breakout data can be viewed.

• This panel can be swapped to the top of the page by clicking the icon in the top right corner.

Fans: Displays system fan details for the device or, for a stack, summary data for each stack member.

• For a standalone device, a breakout of fan details is shown.

• For a stack member, clicking the icon in its summary will navigate to the stack page where its breakout data
may be viewed.

• This panel can be swapped to the top of the page by clicking the icon in the top right corner.

Power Supplies: Displays system power supply status regarding the presence of removable supplies and their
status in a device. For a stack, summary data is displayed for each stack member.

• For a standalone device, a breakout of power supply details is shown.

• For a stack member, clicking the icon in its summary will navigate to the stack page where its breakout data
may be viewed.

• This panel can be swapped to the top of the page by clicking the icon in the top right corner.

Temperature: Displays system thermal status for the device or, for a stack, summary data for each stack
member.

• For a standalone device, a breakout of temperature details is shown.

• For a stack member, clicking the icon in its summary will navigate to the stack page where its breakout data
may be viewed.

• This panel can be swapped to the top of the page by clicking the icon in the top right corner.
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System — Events
Figure 9: System–Events

Events List: Displays a list of the current system events. Available information includes event severity, time of
occurrence, member information, and description.

Filter Events: The display dropdown and filter icon can be used to show/hide table columns and filter the results
based on the user-specified options. Select either tool to begin filtering.

Chapter 4 ArubaOS-Switch UI 35

Anexo 02 ITEM 10 (0592613)         SEI 0008478-63.2018.6.02.8000 / pg. 4883



System — Stack
Figure 10: System–Stack

This view is only present on switch stacks.

Box Graphic: Displays each stack member physically.

• Used to view member information.

• The switch outlined in orange is the currently selected member.

• Data on the page reflects the selected member.

• The Box Graphic can be flipped to show either the front or back of the switch.

Fans: Displays member fan status.

Status:

• Green: The current system storage use is within normal range.

• Yellow: The current system storage use exceeds the warning threshold of 70%.

• Red: The current system storage use exceeds the critical threshold of 90%.

Storage: Displays system storage status.

Status:
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• Green: All fans are operating normally.

• Yellow: One or more fans have failed but the number of failures does not exceed 50% of all system fans.

• Red: At least 50% of the system fans have failed.

Temperature: Displays system temperature status.

Status:

• Green: The current system temperature is within normal range.

• Yellow: The current system temperature exceeds the warning threshold of <variable>. The threshold is based
on a user-controlled setting on the switch.

• Red: The current system temperature exceeds the critical threshold of <variable>. The threshold is based on
a user-controlled setting on the switch.

Power Supplies: Displays system power supply status.

Status:

• Green: All power supplies are operating normally.

• Yellow: One or more power supplies have failed but the number of failures does not exceed 40% of all system
power supplies.

• Red: At least 40% of the system power supplies have failed.

Stack Details: Displays system information regarding the stack including stack topology/configuration and
software version on all members.

Member Details: Displays status, MAC address, location and stack name.

CPU: Displays the current CPU usage of the selected stack member.

• The outer ring of the gauge indicates regions of normal, warning, and critical values.

• The peak value shown on the inner ring indicates the highest CPU usage reached for the device.

Status:

• Green: CPU usage is within normal range.

• Yellow: CPU usage exceeds the warning threshold of 75%.

• Red: CPU usage exceeds the critical threshold of 90%.

Memory: Displays current memory usage of the selected stack member.

• The outer ring of the gauge indicates regions of normal, warning, and critical values.

• The peak value shown on the inner ring indicates the highest memory usage reached for the device.

Status:
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• Green: Memory usage is within normal range.

• Yellow: Memory usage exceeds the warning threshold of 75%.

• Red: Memory usage exceeds the critical threshold of 90%.

Packet Buffers: Displays current packet buffer usage.

• The outer ring of the gauge indicates regions of normal, warning, and critical values.

• The peak value shown on the inner ring indicates the highest packet buffer usage reached for the device.

Status:

• Green: Packet buffer usage is within normal range.

• Yellow: Packet buffer usage exceeds the warning threshold of 85%.

• Red: Packet buffer usage exceeds the critical threshold of 95%.

Tx Drops: Displays current transmit drop rate.

• The outer ring of the gauge indicates regions of normal, warning, and critical values.

• The peak value shown on the inner ring indicates the highest transmit drop rate reached for the device.

Status:

• Green: Transmit drop rate is within normal range.

• Yellow: Transmit drop rate exceeds the warning threshold of 3% of transmit attempts.

• Red: Transmit drop rate exceeds the critical threshold of 5% of transmit attempts.

Message Buffers: Displays current message buffer usage.

• The outer ring of the gauge indicates regions of normal, warning, and critical values.

• The peak value shown on the inner ring indicates the highest message buffer usage reached for the device.

Status:

• Green: Message buffer usage is within normal range.

• Yellow: Message buffer usage exceeds the warning threshold of 75%.

• Red: Message buffer usage exceeds the critical threshold of 90%.

Rx Errors: Displays the current receive error rate.

• The outer ring of the gauge indicates regions of normal, warning, and critical values.

• The peak value shown on the inner ring indicates the highest receive error rate reached for the device.

Status:
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• Green: Receive error rate is within normal range.

• Yellow: Receive error rate exceeds the warning threshold of 2% of received frames.

• Red: Receive error rate exceeds the critical threshold of 5% of received frames.

System — Monitor
Figure 11: System–Monitor

Monitors up to six system metrics at a given time.

• Metrics include:

◦ CPU usage

◦ Memory usage

◦ Packet buffer usage

◦ Transmit drop rate

◦ Message buffer usage

◦ Receive error rate

• Metrics can be hidden from the graph by selecting the corresponding graph icon in the toolbar at the top of the
graph.

• Select and slide the minimap (the gray box at the bottom of the graph) to zoom in and out of the graph. You
can also focus in on a specific portion of the graph.

• Zooming in will provide a finer granularity of displayed data points, while zooming out will display fewer data
points.

Pause and Play Graph: Use the pause and play icons in the toolbar in the upper right corner of the graph to start
and stop the display of data points on the current graph.

• Pausing the graph will not pause the collection of system monitor data.

• Upon restarting the graph, the data points collected while the graph was paused will be filled in.
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Graph options: Select the Graph Settings icon in the upper right corner of the graph to:

• View system monitor graph options

• Select metrics to graph

• Show/hide system alerts

• Show/hide summary lines (maximum, minimum, and average)

The Metrics Statistics: Displays statistics for each of the currently graphed metrics. Statistics include average,
maximum, and minimum values for the metric.

System – SNMP
Figure 12: System–SNMP

Trap receivers: Displays all the trap receivers configured.

• Each card represents a trap receiver configured.

• To add a trap receiver, click the Add Trap Receiver (+) icon on the left side of the black panel.

• To edit a trap receiver, select the Edit Trap Receiver icon on the receiver card.

• To delete a trap receiver, select the Delete Trap Receiver icon on the receiver card.

• The interface offers different sorting options, which can be viewed by hovering over the sort icons. Select one
to apply the sort. Select the arrow next to the sort icons to switch between ascending and descending sorting.

• Different sorting options are available, which can be viewed by hovering over the sort icons. Select one to
apply the sort.

• Select the arrow next to the sort icons to switch between ascending and descending sort order.

IP Configuration: Displays the IP Configuration for the Trap Source and Trap Response. To edit either the Trap
Source or Trap Response, select the Edit Configuration icon in the upper right corner of the IP Configuration
panel.

40 Aruba Basic Operation Guide for ArubaOS-Switch 16.05

Anexo 02 ITEM 10 (0592613)         SEI 0008478-63.2018.6.02.8000 / pg. 4888



Community Names: Displays a list of all community names. To add a community name, select the Add
Community Name icon (+) in the upper right corner of the Community Names panel.

Community Info: Select a community name in the table to display it in the Community Info tile.

• To edit the community name, select the Edit Community Name icon in the upper right corner of the Community
Info tile.

• To delete a community name, select the Delete Community Name icon in the upper right corner of the
Community Info tile.

General Traps: Displays the traps supported and indicates whether each is enabled or disabled. To enable or
disable a trap:

1. Select the Edit General Traps icon in the upper right corner of the General Traps tile.

2. Check or clear the box to the right of the trap to enable or disable that trap.

3. Click Save or Cancel.

Link Status Change Trap: Select the Expand icon on the left of the panel to view a table of ports and their link
status change trap configurations.

• Use the page controls at the bottom of the table to navigate all the ports.

• If the Expand icon was previously selected, select the Collapse icon at the upper left of the panel to hide the
table.

• To edit the link status change trap configuration for a port, select the Edit Link Status Change Trap icon in the
upper right corner of the panel.

System – Firmware Update
Figure 13: System–Firmware Update

This functionality updates the device firmware with a file from the local system where the browser is being used.
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1. Select which image to update: primary or secondary.

2. Drag and drop a file onto the indicated area or click Choose File to browse for a file.

3. Click Upload File to initiate the upload.

Interfaces — Ports
Figure 14: Interfaces–Ports

Port List: Displays a list of all physical ports on the device. Use the pagination control at the bottom of the table to
page though the port list.

Box View: Visual representation of the physical view of the device including hardware status and ports.

• Active and disabled ports display the corresponding status indicator inside the port image.

• If a back of the box view is available, the option to view the back of the box displays in the toolbar at the top of
the page.

Filter Port Table: The display dropdown and filter icon can be used to show/hide table columns and filter the table
results based on the user-specified options. Select either tool to begin filtering.

Port Configuration: Configure a port by selecting the Edit Ports icon in the upper right corner of the toolbar at the
top of the table. The configuration panel opens to allow for port selection and option configuration.
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Interfaces — PoE
Figure 15: Interfaces–PoE

This view displays the PoE information for the switch. In a stack, the power information will not be displayed for
non-PoE switches.

• The box view and port table data is updated every 30 seconds.

• The detail view is updated every 3 seconds.

PoE Port List: Displays a list of all PoE physical ports on the device. Non-PoE ports are not shown. Use the
pagination control at the bottom of the table to page though the port list.

PoE Box View: Visual representation of the physical view of the device including hardware status and ports.
Active and disabled ports display the corresponding status indicator inside the port image.

PoE Port Details: The PoE Port Details panel provides detailed information on the configuration, power usage,
and statistics of a selected port. A port can be selected using the Box View or the port table.

Filter PoE Port Table: The display dropdown and filter icon can be used to show/hide table columns and filter the
table results based on the user-specified options. Select either tool to begin filtering.

PoE Port Configuration: Configure a port by selecting the Edit Ports icon in the upper right corner of the toolbar
at the top of the table. The configuration panel opens to allow for port selection and option configuration. By
default, the selected port will be edited.
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Interfaces — Monitor
Figure 16: Interfaces–Monitor

Interface Monitor Graph: Monitors up to six interface metrics at a given time.

• There are approximately two dozen metrics to choose from on any interface; all except utilization are
expressed as per-second rates (for example, frames/second).

• Metrics may be monitored on a single interface or across multiple interfaces. The total number monitored at
any juncture is limited to six or fewer.

• Only interfaces that are enabled and up may be selected.

• Metrics can be hidden from the graph by selecting the corresponding graph icon in the toolbar at the top of the
graph.

• Metric collection is started anew each time this view is entered.

Pause and Play Graph: Use the pause and play icons in the upper right corner of the graph to start and stop the
display of data points on the graph.

• Pausing the graph will not pause the collection of interface monitor data.

• Upon restarting the graph, the data points collected while the graph was paused will be filled in.

Graph Options: Select the Graph Settings icon in the upper right corner of the graph to select interfaces and
metrics to graph data for.
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Interfaces — VLANs
Figure 17: Interfaces–VLANs

VLAN Box View: Indicates which ports are members of the selected VLAN. Color and shape indicators are used
to differentiate between port types and membership. Editing port membership can also be done through the box
view.

Device VLAN Info: Displays the general VLAN information pertaining to the device.

VLAN Details: Displays a range of details regarding the selected VLAN. Select a VLAN by clicking it in the table.

All VLANs: Displays all configured VLANs on the device including information regarding each of the configured
VLANs. This information includes:

• Status

• IP information

• Port membership

Select a VLAN in the table to view more information.

Edit General VLAN Info: Configure VLAN properties on the device. Configuration options include:

• Setting the primary and management VLAN

• Enabling or disabling GVRP

• Setting the maximum number of VLANs

Edit VLAN: Edit the properties and port membership of an existing VLAN.

Create VLAN: Create a VLAN.

Delete VLAN: Delete an existing VLAN.
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Edit VLAN via Box View: Select Ports in the box view to add or remove that port from the currently selected
VLAN. Use the dropdown option in the header to change the port type.

Magnify Box View: Magnify the box view to display up to six VLANs in a single port to view VLAN membership.
Double-click in the magnifier to cycle to the next VLAN if more than six are present. Press the Esc key to exit the
magnifier.

Interfaces — Trunks
Figure 18: Interfaces–Trunks

Trunk Table: Displays a list of active trunks on the device or the configured trunk groups.

• Active trunks are trunk groups that have ports assigned to them.

• Toggle between the active trunks and trunk groups by using the labeled button in the upper right corner of the
table.

Trunk Details: Displays details about a selected trunk. Select a trunk in the table to see its details.

Load Balancing: Displays the current load balancing algorithm configured on the switch.

• L2 - Uses the best MAC Source Address (MAC-SA) and MAC Destination Address (MAC-DA) information to
load balance traffic.

• L3 - Uses the best IP Source Address (IPSA) and IP Destination Address (IPDA) method to load balance IP
traffic, and MAC Source Address (MAC-SA) and MAC Destination Address (MAC-DA) to load balance non-IP
traffic.

• L4 - Uses the best L4 information (if present) or L3 information for IP traffic, or MAC Source Address (MAC-
SA) and MAC Destination Address (MAC-DA) for non-IP traffic.

Edit Load Balancing: Edit the configured load balancing algorithm on the device.
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Edit Trunks: Configure trunks on this device.

Traffic — Spanning Tree
Figure 19: Traffic–Spanning Tree

Spanning Tree Status: Displays whether spanning tree is enabled or disabled on the device.

Spanning Tree Mode: Displays the current spanning tree mode on the device:

• MSTP (Multiple Spanning Tree)

• RPVST (Rapid Per-VLAN Spanning Tree)

Loop Inconsistent Ports: Displays the list of loop inconsistent ports on the device detected by Loop Guard.

Root Inconsistent Ports: Displays the list of root inconsistent ports on the device detected by Root Guard.

Root Change History: Displays the last 10 root change events on the device.

• By default, a scatter plot chart will be shown representing the data on an hourly basis broken out per day.

• Use the icon in the upper right corner of this component to view the data in a standard table format.

Assigned Ports: Displays the ports assigned to a variety of spanning tree port types that are configurable
through the CLI. Types include:

• Loop Guard

• Root Guard

• TCN Guard

• BPDU Protected Ports

• BPDU Filtered ports

Topology Change Count: Displays the current topology change count on the device.

Time Since Last Change: Displays the time since that last topology change detected on the device.

MSTP Details: Displays the MSTP configuration identifiers on the device including the name, revision, and digest.
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Security — Clients
Figure 20: Security–Clients

Authentication Type Graph: Displays a graph that summarizes the use of authentication types used for client
authorization. Displays statistics like most used and least used authentication types.

User Role Graph: Displays a graph that summarizes the use of user roles associated with the connected clients.

Client Status Summary: Displays the total number of clients connected to the switch. Also displays client status
summary.

Client Details: Displays client-specific information such as:

• Physical port ID

• MAC address

• IP address

• Untagged and tagged VLANs

• User role session time

Connected Clients: Displays a list of all clients connected to the switch. Use the pagination controls at the
bottom of the page to move through the client list.

Filter Clients Table: The display dropdown and filter icon can be used to show/hide table columns and filter the
table results based on user-specified options. Select either tool to begin filtering.
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Security — User Roles
Figure 21: Security–User Roles

User Roles: Displays all user roles configured on the switch.

• Each card represents a user role configured.

• User role cards are clickable.

• You can sort the role cards by name or type.

• Click Apply the sort.

• Click the arrow to switch between ascending and descending sort orders.

User Role Information: Indicates whether the user role is enabled or disabled. Also displays the initial user role
configured on the switch.

User Role Card: Displays user role details such as:

• Name

• Type

• Policy

• VLAN

• Captive portal profile

• Reauthentication period
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Security — Intrusion Log
Figure 22: Security–Intrusion Log

Intrusion Log: Displays a list of the 20 most recent violation attempts detected on the device regardless of
whether the alert flags for these attempts have been reset.

Ports With Intrusion Flag: Displays a list of ports that have the intrusion flag set. The flag gets set when the
device detects a violation attempt on the listed port.

Reset Intrusion Flags: Reset all intrusion flags using the Reset Intrusion Flag button located in the upper right
corner of the log table.

Security — Port Security
Figure 23: Security–Port Security
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Port Security Table: Displays security properties for all ports on the device.

Properties include:

• Learn mode

• Address limit

• Violation action

Select a row in the table to see additional details about the port.

Learn Mode: Displays the selected ports learn mode.

Mode options include:

• Continuous

• Static

• Configured

• Port Access

• Limited

Additional information about what the assigned mode means can be seen following the mode type.

Authorized Address Limit: Displays the number of authorized addresses allowed on the port.

Authorized MAC Addresses: Displays the authorized MAC addresses allowed on the port.

Filter Port Table: Filter the port table by any of the available table columns.

Edit Port: Configure the port security properties on the selected port.

Security — IP Authorization
Figure 24: Security–IP Authorization
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IP Authorization Info: Displays the IP Authorization Info from the row selected in the IP Authorization Table. You
can edit the entry by selecting the drawing icon in the top right corner. You can also delete the entry by selecting
the garbage icon in the top right corner.

Total Single Station Entries with Manager Access: Displays the total number of entries in the IP Authorization
Table that have Manager Access Level and only apply to one computer. This is essentially all entries with a
subnet mask of 255.255.255.255 or 32 prefix length and have Manager Access Level.

Total Multiple Station Entries with Manager Access: Displays the total number of entries in the IP
Authorization Table that have Manager Access Level and apply to multiple computers. This is essentially all
entries with a subnet mask different from 255.255.255.255 or 32 prefix length and have Manager Access Level.

Total Single Station Entries with Operator Access: Displays the total number of entries in the IP Authorization
Table that have Operator Access Level and only apply to one computer. This is essentially all entries with a
subnet mask of 255.255.255.255 or 32 prefix length and have Operator Access Level.

Total Multiple Station Entries with Operator Access: Displays the total number of entries in the IP
Authorization Table that have Operator Access Level and apply to multiple computers. This is essentially all
entries with a subnet mask different from 255.255.255.255 or 32 prefix length and have Operator Access Level.

IP Authorized Management: Displays a table of all IP Authorized entries. You can add an entry by selecting the
add icon in the top right corner. To edit or delete an entry, use the icons in the IP Authorization Info tile.

Configurations — Config Report
Figure 25: Configurations–Config Report

Running Configuration: Displays the current running configuration as shown in the show running-config
CLI command.

Expand and collapse nodes in the running configuration by selecting the + and - icons next to a node that has
content underneath it.
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Configurations — Management
Figure 26: Configurations–Management

Download: Downloads the selected configuration file from the device to the local system where the browser is
being used.

Delete: Deletes the selected configuration file from the device. A confirmation window is displayed because after
a file is deleted it cannot be recovered.

Rename: Renames the selected configuration file to a new name. A field is displayed in which the new name may
be entered. When done, Click Save or Cancel.

Update: Updates an existing device configuration file or uploads a new configuration file from the local system
where the browser is being used. A confirmation window is displayed because after the upload begins it cannot
be aborted.

Procedure

1. Drag and drop a file onto the indicated area or click the button to browse for a file to be uploaded.

2. Specify which configuration file is to be updated (existing or new). If using a new file, the name of the file on
the local system will be used.

3. Click Update to initiate the upload.

4. A confirmation window displays because after the upload begins, it cannot be aborted.
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Overview of Preview Mode
Preview mode feature is available only when preview mode is enabled on a switch. The intent of having features
in preview mode is to allow users to experiment the features and solicit early feedback from them.

Use the features in a preview mode at your own risk. When you enable preview mode on a switch, you are
prompted before entering the preview mode. On confirmation, the prev-mode is prefixed with the switch
configuration prompt.

For example:

(Prev-mode) switch(config)#

The existing configuration for a switch continues even after you enable preview mode.

When you exit the preview mode, you are prompted to reboot the switch. Rebooting the switch reverts the switch
to a configuration that existed prior to enabling preview mode.

Supported Platforms

Aruba 2930F
Aruba 5400R
Aruba 3810M

Enabling Preview Mode
Procedure

Use the CLI command to enable the preview mode on the switch.

Syntax
preview-mode
Description

Enter preview mode on the switch. You can now configure the features in preview mode. Exiting the preview
mode reboots the switch to a configuration, that existed prior to enabling the preview mode.

Example output
switch(config)# preview-mode
ATTENTION: You are entering preview mode on this product. This mode, the
commands, features and functionality specific to this mode, and all output
from this mode are Hewlett Packard Enterprise Confidential and Proprietary.
You may use this mode at your own risk. Any defects or issues encountered
in this mode will be addressed per Hewlett Packard Enterprise's discretion.

Chapter 5
Operating in Preview Mode
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Continue (y/n)? y
Prev-mode)switch(config)#

Viewing features in Preview Mode
Procedure

Use the CLI command to view the features in a preview mode.

Syntax
show preview-mode
Description

Displays the list of features in preview mode.

Parameters
features
Displays the features in a preview mode.

Example output
(Prev-mode)switch(config)# show preview-mode
 features              Show the features under preview mode.
(Prev-mode)switch(config)# show preview-mode features
 Features in Preview Mode:
 Multicast Offload Engine  Enable/Disable multicast offload engine for routed
                           multicast IPv4 traffic.
                           Usage:
                           fabric-offload multicast ipv4 route

Multicast Offload Engine
In the current release, enabling Multicast Offload Engine (MOE) to route multicast IPv4 traffic is the only feature
supported on the switch in a preview mode.

Procurve switches without MOE enabled, use ingress replication to send multicast traffic to multiple destinations.
The processes such as request, reply, or forward are repeated for every destination node chip. Thus, it results in
sending the packet over the ingress node’s fabric interface once for each destination node. To overcome this
problem, MOE is enabled.

There is a significant improvement in the performance, as enabling MOE prevents sending multiple copies of the
packet across the ingress node chip’s fabric interface. When you enable MOE, the request or reply process to
each destination node chip still occurs, but the packet is forwarded once to the fabric chip, and the fabric chip
replicates the packet to all other destination nodes that has to receive the packet.

In the current release, MOE is enabled only to route multicast IPv4 packets.

As the feature is available for experiment purpose, it has the following limitations:

• You cannot use MOE with VSF.

• You cannot enable MOE on jumbo-enabled VLANs.
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Supported Platform

Aruba 5400R v3 standalone

Enabling MOE
Procedure

Use the CLI command to enable MOE for IPv4 multicast traffic. The running-config file displays the MOE
enabled for IPv4 traffic.

Syntax
fabric-offload multicast ipv4 route {enable|disable}
Description

Enable or disable multicast offload engine for routed multicast IPv4 traffic.

Usage
fabric-offload multicast ipv4 route {enable|disable}
Example output
(Prev-mode)switch# show running-config

Running configuration:

; J9851A Configuration Editor; Created on release #KB.16.01.0000x
; Ver #0a:19.f4.7b.ff.ff.fc.ff.ff.3f.ef:b0 
hostname "HP-5412Rzl2" 
module A type j9992a
module L type j9987a
fabric-offload multicast ipv4 route enable
ip routing
ip multicast-routing
snmp-server community "public" unrestricted
oobm
ip address dhcp-bootp
exit
vlan 1
name "DEFAULT_VLAN"
untagged A1-A21,L1-L24
ip address dhcp-bootp
exit
no allow-v2-modules
preview-mode 
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Listing available commands

Procedure

1. Type ? to list available commands. Typing the ? symbol lists the commands you can execute at the current
privilege level.

2. The commands that are available to a user depend on the user’s privilege level. At a given privilege level, you
can list and execute the commands that the privilege level offers, plus all commands available at preceding
levels.

3. When - - MORE - - appears, there are more commands in the listing. Do one of the following:

a. To list the next screen of commands, press the Space bar.

b. To list the remaining commands one-by-one, repeatedly press [Enter].

The following example shows the result of typing? at the Operator level. You can list and execute only the
Operator-level commands at the Operator level.

Figure 27: The Operator-level command listing

switch> ?
 chassislocate         Control the chassis locate led.
 dir                   Display a list of the files and subdirectories in a
                       directory on a USB device.
 display               Display current system information.
 enable                Enter the Manager Exec context.
 exit                  Return to the previous context or terminate current
                       console/telnet session if you are in the Operator
                       context level.
 link-test             Test the connection to a MAC address on the LAN.
 logout                Terminate this console/telnet session.
 menu                  Change console user interface to menu system.
 page                  Toggle paging mode.
 ping                  Send IPv4 ping request(s) to a device on the network.
 ping6                 Send IPv6 ping request(s) to a device on the network.
 quit                  Exit from current command view
 services              Display parameters for the services module.
 show                  Display switch operation information.
 traceroute            Trace the IPv4 route to a device on the network.
 traceroute6           Trace the IPv6 route to a device on the network.
 verify                Verify the signature of a switch firmware image.
 wireless-services     Display parameters for the wireless-services module.
-- MORE --, next page: Space, next line: Enter, quit: Control-C

Chapter 6
Using the Command Line Interface (CLI)
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The following example shows the result of typing? at the Manager level. At this level, you can list and execute
commands that are available at both the Operator and Manager levels. Typing ? at the Global Configuration level
or the Context Configuration level produces similar results.

Figure 28: The Manager-level command listing

switch# ?
 backup                Backup next startup-configuration file to TFTP server
 boot                  Reboot the device.
 clear                 Clear table/statistics.
 clock                 Display/set current time, date, and local time
                       parameters.
 command-alias         Specify command alias
 configure             Enter the Configuration context.
 copy                  Copy datafiles to/from the switch.
 debug                 Enable/disable debug logging.
 delete                Delete a file
 diagnostic-level      Set the diagnostic level.
 end                   Return to the Manager Exec context.
 erase                 Erase stored data files.
 getMIB                Retrieve and display the value of the MIB objects
                       specified.
 getNextMIB            Retrieve and display the value of the next MIB object
                       for each OID specified
 kill                  Kill other active console, Telnet, or SSH sessions.
 licenses              Manage premium features.
 log                   Display log events.
 print                 Execute a command and redirect its output to the device
                       channel for current session.
-- MORE --, next page: Space, next line: Enter, quit: Control-C
  

Listing command options
Procedure

Enter command keywords followed by ? to display command options.

For example, suppose you want to see the command options for configuring the console settings:

switch(config)# console ?
 baud-rate             Set the data transmission speed for the device connect
                       sessions initiated through the Console port.
 events                Set level of the events displayed in the device's Events
                       Log.
 flow-control          Set the Flow Control Method; default is xon-xoff.
 idle-timeout          The number of seconds of no activity detected before the
                       switch terminates a session.
 inactivity-timer      [Deprecated] Set the number of minutes of no activity
                       detected before the switch terminates a communication
                       session.
 local-terminal        Set type of terminal being used for the current console
                       or Telnet session (default is vt100).
 screen-refresh        Set refresh time for menu status and counters in
                       seconds.
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 terminal              Set type of terminal being used for all console and
                       Telnet sessions (default is vt100).

Displaying CLI “Help”
Do one of the following:

Procedure

1. Type “help” to display a list of commands that includes a brief summary of each command’s purpose.
The list includes all commands available at the current privilege level. That is, at the Operator level, executing
help displays the Help summaries only for Operator-Level commands. At the Manager level, executing help

displays the Help summaries for both the Operator and Manager levels, and so on.

2. Type a command string followed by “help” to display detailed information about how to use an individual
command. Use the following syntax:

<command-string> help
Help is displayed for any command that is available at the current privilege level. An “Invalid input” message is
displayed if you try to list the help for an individual command from a privilege level that does not include that
command.

The following example shows the result of typing “help” at the Operator privilege level. The Operator-Level
commands are listed with their purposes.

Figure 29: Help for Operator-Level commands

switch> help

 chassislocate         Control the chassis locate led.
 dir                   Display a list of the files and subdirectories in a
                       directory on a USB device.
 display               Display current system information.
 enable                Enter the Manager Exec context.
 exit                  Return to the previous context or terminate current
                       console/telnet session if you are in the Operator
                       context level.
 link-test             Test the connection to a MAC address on the LAN.
 logout                Terminate this console/telnet session.

The following example shows Help for the interface command at the Global Configuration privilege level:

Figure 30: Detailed Help for a specific command

switch(config)# interface help
Usage: no interface < [ethernet] PORT-LIST [...] | loopback <num> >

Description: Enter the Interface Configuration Level, or execute one
             command for that level. Without optional parameters
             specified, the 'interface' command changes the context to
             the Interface Configuration Context Level for execution of 
             configuration changes to the port or ports in the PORT-LIST
             or with loopback keywork it will change context to loopback
             mode. Use 'interface ?' to get a list of all valid commands.
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Note that trying to list the help for an individual command from a privilege level that does not include that
command results in an error message. For example, trying to list the help for the interface command while at the
global configuration level produces this result:

switch# speed-duplex help
Invalid input: speed-duplex

Enabling and disabling CLI message prefixes
When message prefixes are enabled, a CLI command returns a message that is prefixed with “Error”, “Warning”,
or “Information” to indicate the type of message.

Procedure

1. Type “session show-message-type enable” to enable the display of prefixes with the returned message.

2. Type “session show-message-type disable” to disable the display of prefixes with the returned message.

The syntax is as follows:

session show-message-type [enable|disable]
The message prefixes setting is not saved when the switch is rebooted. The message prefixes are disabled on all
CLI sessions by default.

The following example shows returned messages of each of the three message types.

Figure 31: Message prefixes

switch(config)# router rip
Error: IP Routing support must be enabled first.

switch(config)# qinq mixed vlan
Warning: This command will reboot the device. Any prior configuration
on this config file will be erased and the device will boot up with a
default configuration
for the new qinq mode.
Do you want to continue [y/n]? n

switch(config)# snmp-server mib hpSwitchAuthMIB included
Information: For security reasons, network administrators are
encouraged to disable SNMPv2 before using the MIB.
To determine if message labeling is enabled, enter the show session command.

Figure 32: The label cli-return-message command enabled

switch(config)# show session
show message type   : Enabled
cli interactive mode: Enabled

Enabling and disabling CLI interactive command mode
When the CLI interactive command mode is enabled, you must explicitly enter the choice of yes (‘y’) or no (‘n’) for
interactive commands. When interactive command mode is disabled, you are not prompted to explicitly enter the
choice of yes (‘y’) or no (‘n’) unless you are saving a configuration.
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Procedure

1. Type “session interactive-mode enable” to enable the CLI interactive command mode.

2. Type “session interactive-mode disable” to disable the CLI interactive command mode.

The syntax is as follows:

session interactive-mode [enable|disable]
The interactive–mode setting is not saved when the switch is rebooted. The interactive mode is enabled on all CLI
sessions by default.

The following example shows some commands used with the CLI interactive command mode disabled.

Figure 33: CLI interactive mode when disabled

switch(config)# no password all
Password protection for all will be deleted, continue [y/n]? y

switch(config)# boot system flash secondary
System will be rebooted from secondary image.
Do you want to continue [y/n]? y
Do you want to save current configuration [y/n]? n

To determine if the CLI interactive mode is enabled or disabled, enter the show session command.

Figure 34: CLI interactive mode enabled

switch(config)# show session
show message type   : Enabled
cli interactive mode: Enabled

Interactive commands requiring additional options
Interactive commands that require input other than yes or no are not affected when CLI interactive mode is
disabled. A warning message is displayed when these commands are executed, for example:

Interactive mode is disabled; This command will be ignored. 
Enable cli-interactive-mode to use this command.
The following commands will issue this warning when interactive mode is disabled. An alternate way to enter the
command (when one is available) is shown.

Command Non-Interactive Alternate Command

setup mgmt-interfaces
No equivalent non-interactive command

aaa port-access supplicant 
<port-list> secret

aaa port-access supplicant <port-list> secret 
<secret-string>

password manager password manager plaintext <password-string>

password operator password operator plaintext <password-string>

Table Continued
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Command Non-Interactive Alternate Command

aaa port-access supplicant 
<port-list> secret

aaa port-access supplicant <port-list> secret 
<secret-string>

crypto host-cert generate 
self-signed

crypto host-cert generate self-signed <start-date> <end-date> <CNAME-STR> <ORG-
UNIT-STR> <ORGANIZATION-STR> <CITY-STR> <STATE-STR> <CODE>

Menu commands
When CLI interactive mode is disabled, all CLI commands that launch the menu interface are not affected by the
interactive mode. A warning message is displayed, for example:

switch(config)# menu
Interactive mode is disabled; This command will be ignored.
Enable cli-interactive-mode to use this command.

Other menu-based commands that will not be affected are:

• setup

• show interfaces display

SNMPv3 special cases
The following are special cases when using SNMPv3 with interactive mode.

• snmpv3 user:

In interactive mode, the command snmpv3 user will create snmpv3 users, even if snmpv3 has not been
enabled.

• snmpv3 user:

When interactive mode is disabled, this command only enables snmpv3. It does not prompt for an
authentication password. When the command is first executed, a default initial user is created. A message
displays:

User ‘initial’ has been created.

Simplifying entry of commands at the command line
Do one or more of the following to simplify entry of commands:

Procedure

1. To find or complete a command, use the [TAB] key.

See Finding or completing a command on page 63

2. To re-execute a command, use the redocommand.

See redo on page 64

3. To repeatedly re-execute one or more commands, use the repeat command.
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See repeat on page 64

4. To create a shortcut name for a command to simplify keystrokes, use the alias command.

See alias on page 65

5. To simplify movement or placement of your cursor at the command line, use the shortcut keystrokes. See
CLI shortcut keystrokes on page 67

Finding or completing a command

Procedure

1. Type one or more consecutive characters of a command and then press
[Tab] (with no spaces allowed) to find a CLI command or to quickly complete a CLI command name. The CLI
completes the current command name, including hyphenated extensions, if you have typed enough characters
for the CLI to distinguish it from other possibilities.

2. The following example shows the result when you press
[Tab] immediately after typing “t” at the Global Configuration level. The CLI displays the available command
options that begin with “t”.

switch(config)# t
 tacacs-server
 telnet-server
 tftp
 time
 timesync
 trunk
 trunk-load-balance
 task-monitor
 telnet
 terminal
 test
 traceroute
 traceroute6

3. The following example shows the result when you press
[Tab] immediately after typing “port-”.

switch (config)# port-
switch (config)# port-security

4. The following example shows the result of pressing
[Tab] after a completed command word lists the further options for that command. In this example, entering

switch(config)# qos[Tab]
          
displays the following:

switch (config)# qos
 udp-port              Set UDP port-based priority.
 tcp-port              Set TCP port-based priority.
 device-priority       Configure device-based priority for a particular IP
                       address.
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 dscp-map              Define mapping between a DSCP (Differentiated-Services
                       Codepoint) value and an 802.1p priority.
 protocol              Configure protocol-based priority.
 queue-config          Configure the number of egress priority queues for each
                       port.
 type-of-service       Configure the Type-of-Service method the device uses to
                       prioritize IP traffic.
 watch-queue           Enables monitoring of per-queue dropped packets due to
                       outbound congestion on the given port.

redo
Syntax
redo [ <number> | <command-str> ]
Description

Parameters/Options/Flags/Strings/...

The redo command re-executes a command. The last command that was used is executed by default.

Specifiers
<number>

Specifies the position of the command in the history list. When the position is specified, the nth command
starting from the most recent command in the history is executed.

<command-str>
Specifies the name of a previously executed command. The most recently executed command whose name
matches the specified string is executed.

Example

This example shows the use of the redo command.

switch(config)# show history
2       show arp
1       show flash

switch(config)# redo 2

  IP ARP table

   IP Address     MAC Address     Type      Port
   -------------  --------------  --------  ----
   15.255.128.1   00000c-07ac00   dynamic   A11 

repeat
Syntax
repeat [cmdlist] [count] [delay]
Description

The repeat command repeatedly re-executes one or more commands. By default, the most recent command in
the history is executed until a key is pressed.

Options
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[cmdlist]
Specifies the position of a command, or range of positions of multiple commands, in the history list. The nth
most recent commands in the history, where "n" is the position in the history list, are re-executed.

[count]
Specifies number of times to execute the command or commands.

[delay]
Specifies a delay. The execution of the command is delayed for the number of seconds specified.

Usage
switch(config)# repeat 1-4,7-8,10 count 2 delay 3
Example

This demonstrates the use of the repeat command to re-execute commands that are at positions 1 through 2 in
the command history.

switch(config)# show history
3        show ver
2        show ip
1        show arp

switch(config)# repeat 1-2

  IP ARP table

   IP Address      MAC Address       Type      Port
   --------------  ----------------  --------  ----
   15.255.128.1    000000-000000     dynamic

Internet (IP) Service

IP Routing : Disabled

Default Gateway :
Default TTL     : 64
Arp Age         : 20
Domain Suffix   :
DNS server      :

VLAN               | IP Config   IP Address      Subnet Mask    Proxy ARP
------------------ + ----------- --------------- -------------- ---------
DEFAULT_VLAN       | DHCP/Bootp  15.255.131.90   255.255.248.0  No No

alias
Syntax
alias <name> <command>
no alias <name> <command>
Description

The alias command creates a shortcut alias name that can be used in place of a CLI command to simplify
keystrokes and aid memory. The alias command is executed from the current configuration context.
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Options
no

Specifies that the alias for the command is to be removed.

Specifiers
<name>

Specifies the alias for the CLI command. The alias name must not be an existing CLI command.

<command>
Specifies an existing CLI command for which to create the alias. The command must be enclosed in quotes.

It is recommended that you use an alias that does not have an existing tab completion in the CLI. For
example, using an alias that starts with "show" or "int" would complete to "show" and "interface" respectively
when you use the tab completion function.

Privilege

The alias command is executed from the current configuration context (operator, manager, or global). If the
command that is aliased has to be executed in the global configuration context, you must execute the alias for
that command in the global configuration context. This prevents bypassing the security for a particular context.

Restrictions

• The alias name must not be an existing CLI command. Existing CLI commands are searched before looking
for an alias command; an alias that is identical to an existing command will not be executed.

• Hewlett Packard Enterprise recommends that you configure no more than 128 aliases.

Example

This example shows the creation and use of an alias for the show int custom command to demonstrate how a
command alias can simplify keystrokes when entering a command. The actual show int custom command is
used first and then an alias is created for it and then used.

switch(config)# show int custom 1-4 port name:4 type vlan intrusion speed
enabled mdi

 Status and Counters - Custom Port Status

                               Intrusion
Port Name     Type       VLAN  Alert     Speed   Enabled MDI-mode
---- -------- ---------- ----- --------- ------- ------- -------
1    Acco     100/1000T  1     No        1000FDx Yes     Auto
2    Huma     100/1000T  1     No        1000FDx Yes     Auto
3    Deve     100/1000T  1     No        1000FDx Yes     Auto
4    Lab1     100/1000T  1     No        1000FDx Yes     Auto

switch(config)# alias sic "show int custom 1-4 port name:4 type vlan intrusion
speed enabled mdi"
switch(config)#

switch(config)# sic 

Status and Counters - Custom Port Status

                               Intrusion
Port Name     Type       VLAN  Alert     Speed   Enabled MDI-mode
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---- -------- ---------- ----- --------- ------- ------- -------
1    Acco     100/1000T  1     No        1000FDx Yes     Auto
2    Huma     100/1000T  1     No        1000FDx Yes     Auto
3    Deve     100/1000T  1     No        1000FDx Yes     Auto
4    Lab1     100/1000T  1     No        1000FDx Yes     Auto

CLI shortcut keystrokes

Keystrokes Functions

[Ctrl] [A] Jumps to the first character of the command line.

[Ctrl] [B] or ‘←’ Moves the cursor back one character.

[Ctrl] [C] Terminates a task and displays the command prompt.

[Ctrl] [D] Deletes the character at the cursor.

[Ctrl] [E] Jumps to the end of the current command line.

[Ctrl] [F] or ‘→’ Moves the cursor forward one character.

[Ctrl] [K] Deletes from the cursor to the end of the command line.

[Ctrl] [L] or [Ctrl] [R] Repeats current command line on a new line.

[Ctrl] [N] or ‘↓’ Enters the next command line in the history buffer.

[Ctrl] [P] or ‘↑’ Enters the previous command line in the history buffer.

[Ctrl] [U] or [Ctrl] [X] Deletes from the cursor to the beginning of the command line.

[Ctrl] [W] Deletes the last word typed.

[Esc] [B] Moves the cursor backward one word.

[Esc] [D] Deletes from the cursor to the end of the word.

[Esc] [F] Moves the cursor forward one word.

[Backspace] Deletes the first character to the left of the curser in the command line.

[Spacebar] Moves the cursor forward one character.

Overview of the CLI
The CLI is a text-based command interface for configuring and monitoring the switch. The CLI gives you access
to the switch’s full set of commands while providing the same password protection that is used in the web browser
interface (WebAgent) and the menu interface.

Access

Like the menu interface, the CLI is accessed through the switch console, and in the switch’s factory default state,
is the default interface when you start a console session. You can access the console out-of-band by directly
connecting a terminal device to the switch, or in-band by using Telnet either from a terminal device or through the
WebAgent.
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Also, if you are using the menu interface, you can access the CLI by selecting the Command Line (CLI) option in
the Main Menu.

Privilege levels

The CLI offers these privilege levels to help protect the switch from unauthorized access:

1. Operator

2. Manager

3. Global Configuration

4. Context Configuration

CLI commands are not case-sensitive.

When you use the CLI to make a configuration change, the switch writes the change to the Running-Config file in
volatile memory. This allows you to test your configuration changes before making them permanent. To make
changes permanent, you must use the write memory command to save them to the Startup-Config file in non-
volatile memory. If you reboot the switch without first using write memory, all changes made since the last reboot
or write memory (whichever is later) will be lost.

More information

Configuring the switch on page 76.

Privilege levels for CLI access

Privilege levels at log on
Privilege levels control the type of access to the CLI. To implement this control, you must set at least a Manager
password. Without a Manager password configured, anyone having serial port, Telnet, or web browser
access to the switch can reach all CLI levels. (For more on setting passwords, See the usernames and
passwords in the Access Security Guide for your switch.)

When you use the CLI to log on to the switch, and passwords are set, you will be prompted to enter a password.
For example:

CLI log-on screen with password(s) set

switch
Software revision K.15.12.0001

Copyright (C) 1991-2013 Hewlett-Packard Development Company, L.P.

                      RESTRICTED RIGHTS LEGEND
Confidential computer software.  Valid license from HP required for possession,
use or copying. Consistent with FAR 12.211 and 12.212, Commercial Computer
Software, Computer Software Documentation, and Technical Data for Commercial
Items are licensed to the U.S. Government under vendor's standard commercial
license.
                     HEWLETT-PACKARD DEVELOPMENT COMPANY, L.P.
                   20555 State Highway 249, Houston, TX 77070

We'd like to keep you up to date about:
  * Software feature updates
  * New product announcements
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  * Special events
Please register your products now at:  www.hp.com/networking/register

Username:
In the above case, you will enter the CLI at the level corresponding to the password you provide (operator or
manager).

If no passwords are set when you log on to the CLI, you will enter at the Manager level. For example:

switch# _

Hewlett Packard Enterprise strongly recommends that you configure a Manager password. If a
Manager password is not configured, then the Manager level is not password-protected, and anyone
having in-band or out-of-band access to the switch may be able to reach the Manager level and
compromise switch and network security. Note that configuring only an Operator password does not
prevent access to the Manager level by intruders who have the Operator password.

Pressing the Clear button on the front of the switch removes password protection. For this reason,
it is recommended that you protect the switch from physical access by unauthorized persons.
If you are concerned about switch security and operation, you must install the switch in a secure
location, such as a locked wiring closet.

Privilege level operation
The access sequence for the various privilege levels is shown in Figure 35: Access sequence for privilege
levels on page 69.

Figure 35: Access sequence for privilege levels

You can move between the privilege levels. The following table lists examples and results of movement between
the privilege levels.
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Change in Levels Example of Prompt, Command, and Result

Operator level to Manager level
switch> enable

Password:_

switch#_

After you enter enable, the
Password prompt appears. After
you enter the Manager
password, the system prompt
appears with the # symbol:

Manager level to Global
configuration level switch# config

switch(config)#

Global configuration level to a
Context configuration level switch(config)# vlan 10

switch(vlan-10)#

Context configuration level to
another Context configuration
level

switch(vlan-10)# interface e 3

switch(int-3)#

The CLI accepts "e" as the
abbreviated form of "ethernet".

Move from any level to the
preceding level switch(int-3)# exit

switch(config)# exit

switch# exit

switch>

Move from any level to the
Manager level switch(int-3)# end

switch#
-or-

switch(config)# end

switch#

Moving between the CLI and the Menu interface. When moving between interfaces, the switch retains the
current privilege level (Manager or Operator). That is, if you are at the Operator level in the menu and select the
Command Line Interface (CLI) option from the Main Menu, the CLI prompt appears at the Operator level.

Changing parameter settings. Regardless of which interface is used (CLI, menu interface, or WebAgent), the
most recently configured version of a parameter setting overrides any earlier settings for that parameter. For
example, if you use the menu interface to configure an IP address of "X" for VLAN 1 and later use the CLI to
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configure a different IP address of "Y" for VLAN 1, then "Y" replaces "X" as the IP address for VLAN 1 in the
running-config file. If you subsequently execute write memory in the CLI, then the switch also stores "Y" as the
IP address for VLAN 1 in the startup-config file. (For more on the startup-config and running config files, see
"Switch Memory and Configuration".)

Operator privileges
At the Operator level, you can examine the current configuration and move between interfaces without being able
to change the configuration. A ">" character delimits the Operator-level prompt. For example:

switch>_

(Example of the Operator prompt.)

When using enable to move to the Manager level, the switch prompts you for the Manager password if one has
already been configured.

Manager privileges
Manager privileges give you three additional levels of access: Manager, Global Configuration, and Context
Configuration. A "#" character delimits any Manager prompt. For example:

switch#_

(Example of the Manager prompt.)

Manager level:

Provides all Operator level privileges plus the ability to perform system-level actions that do not require saving
changes to the system configuration file. The prompt for the Manager level contains only the system name and
the "#" delimiter, as shown above. To select this level, enter the enable command at the Operator prompt and
enter the Manager password, when prompted. For example:

switch> enable
Password:
switch# _ 

Enter enable at the Operator prompt. CLI prompt for the
Manager password. The Manager prompt appears after the
correct Manager password is entered.

Global configuration level:

Provides all Operator and Manager level privileges, and enables you to make configuration changes to any of the
switch’s software features. The prompt for the Global Configuration level includes the system name and "(config)".
To select this level, enter the config command at the Manager prompt. For example:

switch# config
switch(config)#_

Enter config at the Manager prompt. The Global Config
prompt.

Context configuration level:

Provides all Operator and Manager privileges, and enables you to make configuration changes in a specific
context, such as one or more ports or a VLAN. The prompt for the Context Configuration level includes the
system name and the selected context. For example:

switch(eth-1)#
switch(vlan-10)#
The Context level is useful, for example, for executing several commands directed at the same port or VLAN, or if
you want to shorten the command strings for a specific context area. To select this level, enter the specific context
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at the Global Configuration level prompt. For example, to select the context level for an existing VLAN with the
VLAN ID of 10, you would enter the following command and see the indicated result:

switch(config)# vlan 10
switch(vlan-10)#

Table 4: Privilege level hierarchy — Operator Privilege

Privilege Level Example of Prompt and Permitted Operations

Operator Level
switch> show <command> setup

View status and configuration
information.

ping <argument>

link-test <argument>

Perform connectivity tests.

enable
Move from the CLI interface to the menu
interface.

Use enable at the
Operator level to move to
the Manager level.

menu
Move from the CLI interface to the menu
interface.

logout
Exit from the CLI interface and terminate
the console session.

exit
Terminate the current session (same as
logout).
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Table 5: Privilege level hierarchy — Manager Privilege

Privilege Level Example of Prompt and Permitted Operations

Manager Level
switch#

Perform system-level actions such as system
control, monitoring, and diagnostic commands,
plus any of the Operator-level commands. For a
list of available commands, enter ? at the
prompt.

Global Configuration Level
switch(config)#

Execute configuration commands, plus all
Operator and manager commands. For a list of
available commands, enter ? at the prompt.

Context Configuration Level
switch(eth-5)#

switch(vlan-100)#

Execute context-specific configuration
commands, such as a particular VLAN or switch
port. This is useful for shortening the command
strings you type, and for entering a series of
commands for the same context. For a list of
available commands, enter ? at the prompt.

Configuration commands and context configuration
modes
You can execute any configuration command in the global configuration mode or in selected context modes.
However, using a context mode enables you to execute context-specific commands faster, with shorter command
strings.

The switch offers interface (port or trunk group) and VLAN context configuration modes:

Port or trunk-group context. Includes port-or trunk-specific commands that apply only to the selected port(s) or
trunk group, plus the global configuration, Manager, and Operator commands. The prompt for this mode includes
the identity of the selected port(s):

switch(config)# interface c3-c6
switch(eth-C5-C8)#
switch(config)# interface trk1
switch(eth-Trk1)#
Commands executed at configuration level for entering port and trk1static trunk-group contexts, and
resulting prompts showing port or static trunk contexts.

switch(eth-C5-C8)#
switch(eth-Trk1)#
switch(eth-C5-C8)# ?
switch(eth-C5-C8)# ?
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Lists the commands you can use in the port or static trunk context, plus the Manager, Operator, and
context commands you can execute at this level.

Figure 36: Context-specific commands affecting port context

VLAN context. Includes VLAN-specific commands that apply only to the selected VLAN, plus Manager and
Operator commands. The prompt for this mode includes the VLAN ID of the selected VLAN. For example, if you
had already configured a VLAN with an ID of 100 in the switch:

switch(config)# vlan 100
Command executed at configuration level to enter VLAN 100 context.

switch(vlan-100)#
Resulting prompt showing VLAN 100 context.

switch(vlan-100)# ?
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Lists commands you can use in the VLAN context, plus Manager, Operator, and context commands you
can execute at this level.

Figure 37: Context-specific commands affecting VLAN context
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Using the CLI to implement configuration changes
The CLI offers these capabilities for implementing configuration changes:

Procedure

1. Access to the full set of switch configuration features

2. The option of testing configuration changes before making them permanent

How to use the CLI to view the current configuration files. Use show commands to view the configuration for
individual features, such as port status or Spanning Tree Protocol. However, to view either the entire startup-
config file or the entire running-config file, use the following commands:

• show config

Displays a listing of the current startup-config file.

• show running–config

Displays a listing of the current running-config file.

• write terminal

Displays a listing of the current running-config file.

• show default–config

Displays a listing of a custom default config file.

• show config status

Compares the startup-config file to the running-config file and lists one of the following results:

◦ If the two configurations are the same, you will see:

Running configuration is the same as the startup configuration.

◦ If the two configurations are different, you will see:

Running configuration has been changed and saved.

show config, show running–config, and write terminal commands display the configuration
settings that differ from the switch’s factory default configuration.

How to use the CLI to reconfigure switch features. Use this procedure to permanently change the switch
configuration (that is, to enter a change in the startup-config file).

Chapter 7
Configuring the switch
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1. Use the appropriate CLI commands to reconfigure the desired switch parameters. This updates the selected
parameters in the running-config file.

2. Use the appropriate show commands to verify that you have correctly made the desired changes.

3. Observe the switch’s performance with the new parameter settings to verify the effect of your changes.

4. When you are satisfied that you have the correct parameter settings, use the write memory command to copy
the changes to the startup-config file.

The write memory command saves the running configuration file to the startup-config. The saved configuration
becomes the boot-up configuration of the switch on the next boot.

When using redundant management, saves the running configuration of the switch to flash on the active
management module. The saved configuration becomes the boot-up configuration of the switch the next time it is
booted. The saved configuration file is synchronised to the standby management module.

Note: If the active management module and the standby management module are running on different operating
systems because the boot set-default command was executed and then the standby module was rebooted, the
write memory command displays this warning: "Warning: The next reboot or failover is set to boot from a
different software image. These config changes may be incompatible or not used after a reboot or failover."

For example, the default port mode setting is auto. Suppose that your network uses Cat 3 wiring and you want to
connect the switch to another autosensing device capable of 100 Mbps operation. Because 100 Mbps over Cat 3
wiring can introduce transmission problems, the recommended port mode is auto-10, which allows the port to
negotiate full- or half-duplex, but restricts speed to 10 Mbps. The following command configures port A5 to
auto-10 mode in the running-config file, allowing you to observe performance on the link without making the mode
change permanent.

switch(config)# interface e a5 speed-duplex auto-10
After you are satisfied that the link is operating properly, you can save the change to the switch’s permanent
configuration (the startup-config file) by executing the following command:

switch(config)# write memory
The new mode (auto-10) on port A5 is now saved in the startup-config file, and the startup-config and running-
config files are identical. If you subsequently reboot the switch, the auto-10 mode configuration on port A5 will
remain because it is included in the startup-config file.

Beginning with K.15.01.0031, configuration changes to ports may require up to 10 seconds to take
effect, especially on switches with high CPU utilization. After a configuration command, perform an
appropriate show or show running-config command to confirm the configuration change. If
configuration scripts are used, the script must be modified either to check for successful completion
of the previous command before executing the next command, or to sleep for 10 seconds after the
configuration command is executed.

How to cancel changes you have made to the running-config file. If you use the CLI to change parameter
settings in the running-config file, and then decide that you do not want those changes to remain, you can use
either of the following methods to remove them:

• Manually enter the earlier values you had for the changed settings. (This is recommended if you want to
restore a small number of parameter settings to their previous boot-up values.)

• Update the running-config file to match the startup-config file by rebooting the switch. (This is recommended if
you want to restore a larger number of parameter settings to their previous boot-up values.)
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If you use the CLI to change a parameter setting, and then execute the boot command without first executing the
write memory command to save the change, the switch prompts you to specify whether to save the changes in
the current running-config file. For example:

Figure 38: Boot prompt for an unsaved configuration

The above prompt means that one or more parameter settings in the running-config file differ from their
counterparts in the startup-config file and you can choose which config file to retain and which to discard.

• If you want to update the startup-config file to match the running-config file, press [Y] for “yes”. (This means
that the changes you entered in the running-config file will be saved in the startup-config file.)

• If you want to discard the changes you made to the running-config file so that it will match the startup-config
file, then select [N] for “no”. (This means that the switch will discard the changes you entered in the running-
config file and will update the running-config file to match the startup-config file.)

If you use the CLI to make a change to the running-config file, you can either use the write memory
command or select the save option allowed during a reboot (see Figure 38: Boot prompt for an
unsaved configuration on page 78) to save the change to the startup-config file. That is, if you use
the CLI to change a parameter setting, but then reboot the switch from either the CLI or the menu
interface without first executing the write memory command in the CLI, the current startup-config file
will replace the running-config file, and any changes in the running-config file will be lost.

Using the Save command in the menu interface does not save a change made to the running config
by the CLI unless you have also made a configuration change in the menu interface. Also, the menu
interface displays the current running-config values. Thus, where a parameter setting is accessible
from both the CLI and the menu interface, if you change the setting in the CLI, the new value will
appear in the menu interface display for that parameter. However, as indicated above, unless you
also make a configuration change in the menu interface, only the write memory command in
the CLI will actually save the change to the startup-config file.

How to reset the startup-config and running-config files to the factory default configuration. Use the erase
startup-config command to reboot the switch, which replaces the contents of the current startup-config and
running-config files with the factory-default startup configuration.

Figure 39: The erase startup-config command

switch(config)# erase startup-config
Configuration will be deleted and device rebooted, continue [y/n]?
Press [y] to replace the current configuration with the factory default configuration and reboot the switch. Press [n]
to retain the current configuration and prevent a reboot.
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In a redundant management system, this command erases the startup config file on both the active and the
standby management modules as long as redundancy has not been disabled. If the standby management module
is not in standby mode or has failed selftest, the startup config file is not erased.

Creating a custom default configuration
The custom default configuration feature provides the ability to initialize a switch to a different state from the
factory default state when you delete the active configuration file. The factory default configuration is not changed.
If a custom configuration file has been created and the active configuration file is deleted, the switch will boot up
using the custom configuration file.

The feature provides the ability to:

Procedure

1. Use a customized configuration file as a default configuration file

2. Enable the switch to start up with the specified default configuration

The existence of a custom default configuration file does not affect the results of loading a remotely stored
configuration file onto the switch.

Using a custom default configuration, you can configure the features you want to be in the default configuration.
When the active configuration is deleted using the erase startup command, the active configuration is removed
and the custom default configuration file will be used upon bootup. The standard default configuration file remains
and is used if there is no custom default configuration.

This feature does not change the system defaults. The custom default configuration file is
automatically used when the startup configuration file is erased. It has no effect on what is loaded
onto the switch when a remotely stored configuration file is restored.

The default configuration file can be customized using commands at the CLI prompt or by copying a configuration
file with the desired configuration using TFTP, USB, or XMODEM copy commands. The existing default
configuration file also can be transferred from the switch using these commands.

To start creating the configuration file to be used as the custom default configuration file, enter the commands that
configure the features desired and then save the configuration file using the write memory command. The
following example is as shown.

Figure 40: Creating a config file with the desired features

switch(config)# spanning-tree
switch(config)# interface 4 flow-control

switch(config)# write memory
This configuration, which enables flow control on interface 4, and also spanning tree on the switch, is stored in the
startup configuration file.

To save this configuration as the custom default configuration, the startup configuration file is copied to the default
configuration file, as shown following.

Figure 41: Copying the startup configuration file to the custom default configuration file

switch(config)# copy startup-config default-config
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Copying an existing configuration file to the custom default configuration
file
Use the following command to copy a configuration file that exists in flash memory to the custom default
configuration file:

copy config <source-filename> default-config
The switch can have up to three different configuration files stored in flash memory. (For more information about
multiple configuration files, see "Multiple Configuration Files" in the Management and Configuration Guide for your
switch.)

switch(config)# copy abc.cfg default-config

HPE does not support issues that arise from a configuration file that was manually edited and
downloaded to the switch.

Copying the custom default config file onto the switch
The custom default config file can be copied onto the switch using TFTP, XMODEM, or USB.

• TFTP

Use thecopy tftp default-config command to copy a configuration file stored on a TFTP server to the custom
default configuration file:

copy tftp default-config <ip-addr> <stored config file name>
Copying a stored config file to the default config file using TFTP

switch(config)# copy tftp default-config 10.10.10.1 stored_config.cfg
• XMODEM

Use thecopy xmodem default-config command to copy a configuration file to the custom default
configuration file using XMODEM:

copy xmodem default-config
Copying a stored config file to the custom default config file using XMODEM

switch(config)# copy xmodem default-config
• USB

Use thecopy usb default-config command to copy a configuration file to the custom default configuration file
using USB:

copy usb default-config <stored config file name>
Copying a stored config file to the custom default config file using USB

switch# copy usb default-config stored_config.cfg

Copying the custom default config file off the switch
The following sections explains how to copy the custom default config file off the switch using TFTP, XMODEM, or
USB.
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Procedure

1. TFTP—Enter the following command to copy the custom default configuration file to the stored_config.cfg file
on the TFTP server.

copy default-config tftp <server ip-address> stored_config.cfg
2. XMODEM—Enter the following command to copy the custom default configuration file to the configuration file

specified by the XMODEM server device.

copy default-config xmodem
3. USB—Enter the following command to copy a custom default configuration file from the switch to the

stored_config.cfg file on the USB device.

copy default-config usb stored_config.cfg

Using SFTP and SCP to transfer the custom configuration
To transfer the default custom configuration file to or from the switch, you must connect to the switch’s SSH server
using any SCP or SFTP client. Instead of the actual name of the custom default configuration file, an alias name
of "default-config" is displayed in the file listings and for get/store functions.

When you use an SCP client to connect to the switch, you must know the name of the file you wish
to get or store. When you use SFTP client to connect to the switch, you are provided with a list of
filenames which are accessed by the switch.

While the switch supports an SSH server with SCP and/or SFTP running on it, the switch is not an
SCP or SFTP client. You must have an SCP/SFTP client implemented in order to execute copy scp
or copy sftp commands on the switch.

The following example shows the output from running puTTY psftp on a remote PC.

C:\PuTTY> psftp 10.1.243.209

We'd like to keep you up to date about:
  * Software feature updates
  * New product announcements
  * Special events

Please register your product at: www.register.hp.com

Remote working directory is /
psftp> ls
Listing directory /
drwxr-xr-x    2 J9145A   J9145A   0 Jan 01 00:01 cfg
drwxr-xr-x    2 J9145A   J9145A   0 Jan 01 00:01 core
drwxr-xr-x    2 J9145A   J9145A   0 Jan 01 00:01 log
drwxrwxrwx    2 J9145A   J9145A   0 Jan 01 00:01 os 
drwxrwxrwx    3 J9145A   J9145A   0 Jan 01 00:01 ssh

psftp> ls /cfg
Listing directory /cfg

-rwxrw-r--  1 J9145A  J9145A  1749 Jan 01 00:01 default-config 
-rw-r--r--  1 J9145A  J9145A   745 Jan 01 01:19 running-config
-rwxrw-r--  1 J9145A  J9145A   360 Jan 01 01:19 startup-config

psftp>
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Erasing a configuration file
To erase a configuration file:

Procedure

1. To erase the startup configuration file, use the erase startup-config command.
If a custom default configuration file exists and the erase startup-config command is executed, the current
active configuration is erased and the switch is booted with the custom default configuration. If a custom
default configuration file does not exist and the erase startup-config command is executed, the current active
configuration is erased and the switch is booted with the system default configuration.

2. To erase the custom default configuration file, use the erase default-config command.

The following example shows how to erase the startup config file when a default custom config file exists

switch(config)# erase startup-config
Configuration will be deleted, and existing login passwords
removed, and device rebooted (using the custom default
configuration), continue [y/n]?

The following example shows how to erase the startup config file when a default custom config file does not exist

switch(config)# erase startup-config
Configuration will be deleted, and existing login passwords removed,
and device rebooted, continue [y/n]?

The following example shows how to erase the custom default config file.

switch(config)# erase default-config
The custom default configuration will be erased. The "erase
startup-config" command will now use system generated default
configuration. Continue [y/n]?

Displaying the configuration files
To display configuration files:

• Use the show config files command to display the existing configuration files. This command also indicates
whether a custom default configuration file exists.

• Use either the command show default config or the command show running-config to display the custom
default configuration.

If a custom default configuration file exists and you erase the current active config file (using the erase
startup-config command), use the show running-configcommand to display the custom default
configuration, which is loaded upon bootup.
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When the show default config command is executed in enhanced secure mode the following
prompt displays:

Do you want to show sensitive information (y/n)?
If "Y/y" is entered, the normal command output is displayed on the console. If "N/n" is entered, all the
sensitive information is hidden and will be displayed as asterisks ("*****"). The default option is "N/n"
when interactive mode is disabled. For more information, see the "Secure Mode" in the Access
Security Guide for your switch.

Output displaying three configuration files
switch(config)# show config files

Configuration files:

id | act pri sec | name
---+-------------+--------------------------
 1    *   *      | config
 2               | secondaryconfig
 3            *  | Kconfig
==================
A Custom default configuration file exists.

Output for custom default configuration file
switch(config)# show default-config

Custom default configuration:

; J8693A Configuration Editor; Created on release #K.15.14.0001

; Ver #02:0b:ef:e6
hostname "switch"
module 1 type J93x7
module 2 type J93x7
vlan 1
  name "DEFAULT-VLAN"
  untagged 1-24
  ip address dhcp-bootp
  exit
interface 4
  flow-control
  exit snmp-server community "public" unrestricted
spanning-tree

Output of custom default config file when current active config file erased
switch(config)# show running-config

Custom default configuration:

; J8693A Configuration Editor; Created on release #K.15.12.0001
; Ver #02:0b:ef:e6
hostname "switch"
module 1 type J93x7
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module 2 type J93x7
vlan 1
  name "DEFAULT-VLAN"
  untagged 1-24
  ip address dhcp-bootp
  exit
interface 4
  flow-control
  exit
snmp-server community "public" unrestricted
spanning-tree

Troubleshooting custom default configuration files

Symptom

Switch cannot boot due to custom default configuration files.

Cause

Problem with the custom configuration file.

Action

1. Remove the custom configuration file from the ROM mode interface.

2. Use the erase default-config command to remove the custom default configuration file.

The custom default configuration files cannot be erased using the front panel buttons on the switch.

Using the menu and WebAgent to implement configuration
changes configuration file
The menu and WebAgent offer these advantages:

Procedure

1. Quick, easy menu or window access to a subset of switch configuration features

2. Viewing several related configuration parameters in the same screen, with their default and current settings

3. Immediately changing both the running-config file and the startup-config file with a single command

Menu: implementing configuration changes

You can use the menu interface to simultaneously save and implement a subset of switch configuration changes
without having to reboot the switch. That is, when you save a configuration change in the menu interface, you
simultaneously change both the running-config file and the startup-config file.

The only exception to this operation is two VLAN-related parameter changes that require a reboot as
described in this section.

Using Save and Cancel in the menu interface

For any configuration screen in the menu interface, the save command:
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1. Implements the changes in the running-config file

2. Saves your changes to the startup-config file

If you decide not to save and implement the changes in the screen, select Cancel to discard them and continue
switch operation with the current operation. For example, suppose that you have made the changes as shown in
the following System Information screen:

Figure 42: Example of pending configuration changes you can save or cancel

If you reconfigure a parameter in the CLI and then go to the menu interface without executing a write
memory command, those changes are stored only in the running configuration (even if you execute a
Save operation in the menu interface). If you then execute a switch boot command in the menu
interface, the switch discards the configuration changes made while using the CLI. To ensure that
changes made while using the CLI are saved, execute write memory in the CLI before rebooting the
switch.

Rebooting from the menu interface

Rebooting from the menu interface does the following:

• Terminates the current session and performs a reset of the operating system

• Activates any configuration changes that require a reboot

• Resets statistical counters to zero
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To Reboot the switch, use the Reboot Switch option in the Main Menu. (Note that the Reboot Switch option is not
available if you log on in Operator mode; that is, if you enter an Operator password instead of a manager
password at the password prompt.)

Figure 43: The Reboot Switch option in the Main Menu

Rebooting To Activate Configuration Changes. Configuration changes for most parameters become effective
as soon as you save them. However, you must reboot the switch in order to implement a change in the Maximum
VLANs to support parameter.

(To access these parameters, go to the Main menu and select 2. Switch Configuration, then 8. VLAN Menu,
then 1. VLAN Support.)

If configuration changes requiring a reboot have been made, the switch displays an asterisk (*) next to the menu
item in which the change has been made. For example, if you change and save parameter values for the
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Maximum VLANs to support parameter, an asterisk appears next to the VLAN Support entry in the VLAN
Menu screen, and also next to the Switch Configuration … entry in the Main menu:

Figure 44: Indication of a configuration change requiring a reboot

WebAgent: implementing configuration changes

You can use the WebAgent to simultaneously save and implement a subset of switch configuration changes
without having to reboot the switch. That is, when you save a configuration change, you simultaneously change
both the running-config file and the startup-config file. For online help with configuring changes in the WebAgent,
click the "?" in the WebAgent screen.

If you reconfigure a parameter in the CLI and then go to the WebAgent without executing a write
memory command, those changes will be saved to the startupconfig file if you click Save in the
WebAgent.

Zeroizing the file storage of the management module

Zeroizing the management module files

Procedure

Use the erase all to erase all management module files, including configuration files, core dumps, password files,
crypto-key files, and so on.
Software images are not erased.

erase all zeroize

When executed without the zeroize option, files are removed, but the flash storage is not zeroized.
The data is still physically present in the flash. The flash can be removed from the switch and the
data recovered with file recovery tools.

It is recommended that zeroization be performed from the serial console so that the status
information can be viewed during the zeroization process.
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switch(config)# erase all zeroize

The system will be rebooted and all management module files
except software images will be erased and zeroized. This will
take up to 60 minutes and the switch will not be usable during
that time. Continue (y/n)? y

Zeroizing from the ROM console
Use the erase-all zeroize command at the prompt to zeroize the file storage from the ROM console of the switch.
This is typically done during a switch recovery process. The warning messages are the same as for the CLI
command.

Zeroizing the management module files from the ROM console

=> erase-all zeroize

The system will be rebooted and all management module files
except software images will be erased and zeroized. This will
take up to 60 minutes and the switch will not be usable during
that time. Continue (y/n)? y

Zeroization
Sometimes it is desirable to completely remove the information stored in user files from flash storage. The
zeroization feature will remove and "zeroize" all the files from flash storage except software images. Information
removed includes the following:

• switch configurations

• system generated private keys

• user installed private keys

• legacy manager/operator password files

• crypto-key files

• fdr logs

• core dumps

Zeroization can be initiated in these ways:

• CLI command erase all

• ROM console command

• During Secure Mode transition, initiated through the secure-mode CLI command executed in a serial session

The zeroization process takes some time, so it is performed during the initial process of a switch reboot. After
zeroization, the configuration file is rebuilt from the default config file, which is similar to the config rebuilding
process performed by the erase startup-config command.

When zeroization is triggered by a secure mode transition, HA handles zeroization on the AMM and SMM
automatically.

When the CLI command (erase all zeroize) is used to start zeroization, the AMM syncs with the SMM and
ensures that the SMM performs the same level of zeroization before the AMM starts the zeroization process on
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itself. The AMM before the zeroization process occurs remains the AMM, unless it takes over a minute for the
AMM to boot up, in which case the prior SMM becomes the AMM.

When zeroization is started from the ROM console, there is no synchronization performed between the AMM and
SMM, as zeroization from the ROM console is treated as a recovery facility. Each MM has to be zeroized
individually.

For information about Secure Mode and zeroization, see the "Secure Mode (5400zl and 3800)" in the Access
Security Guide for your switch.

Using Primary and Secondary flash image options
The switches covered in this guide feature two flash memory locations for storing switch software image files:

Procedure

1. Primary Flash:

The default storage for a switch software image.

2. Secondary Flash:

The additional storage for either a redundant or an alternate switch software image.

With the Primary/Secondary flash option, you can test a new image in your system without having to replace a
previously existing image. You can also use the image options for troubleshooting. For example, you can copy a
problem image into Secondary flash for later analysis and place another, proven image in Primary flash to run
your system. The switch can use only one image at a time.

The following tasks involve primary/secondary flash options:

• Displaying the current flash image data and determining which switch software versions are available

• Switch software downloads

• Replacing and removing (erasing) a local switch software version

• System booting

Displaying the current flash image data
Use the commands in this section to:

• Determine whether there are flash images in both primary and secondary flash

• Determine whether the images in primary and secondary flash are the same

• Identify which switch software version is currently running

Viewing the currently active flash image version. Use the show version command to identify the software
version on which the switch is currently running, and whether the active version was booted from the primary or
secondary flash image.
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For example, if the switch is using a software version of X.X.XX stored in Primary flash, show version produces
the following:

Figure 45: The identity of the current flash image

switch(config)# show version

Image stamp:  /su/code/build/info(s01)
              Dec 01 2006 10:50:26
              X.X.XX
              1223
Boot Image:   Primary
Determining whether the flash images are different versions. If the flash image sizes in primary and
secondary are the same, then in almost every case, the primary and secondary images are identical. This
command provides a comparison of flash image sizes, plus the boot ROM version and from which flash image the
switch booted. For example, in the following case, the images are different versions of the switch software, and
the switch is running on the version stored in the secondary flash image:

switch(config)# show flash
Image            Size(Bytes)   Date   Version
-----            ----------  -------- -------------
Primary Image    : 7493854   03/21/10 K.15.01.0001
Secondary Image  : 7463821   03/23/10 K.15.01.0001

Boot Rom Version: K.15.08
Default Boot    : Primary
Determining which flash image versions are installed. The show version command displays which software
version the switch is currently running and whether that version booted from primary or secondary flash. Thus, if
the switch booted from primary flash, you will see the version number of the software version stored in primary
flash, and if the switch booted from secondary flash, you will see the version number of the software version
stored in secondary flash. Thus, by using show version, then rebooting the switch from the opposite flash
image and using show version again, you can determine the version(s) of switch software in both flash
sources. For example: Determining the software version in Primary and Secondary flash

switch(config)# show version
Management Module 1: Active
Image stamp:    /sw/code/build/btm(ec_K_15)
                Aug 2 2012 09:06:58
                K.15.12.001
                152
Boot Image:     Primary
switch(config)# boot system flash secondary
Device will be rebooted, do you want to continue [y/n]? y
  .
  .
  .

switch(config)# show version
Management Module 1: Active
Image stamp:    /sw/code/build/btm(ec_K_15)
                Aug 2 2012 09:06:58
                K.15.12.001
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                1753
Boot Image:     Secondary

Switch software downloads
The following table shows the switch’s options for downloading a software version to flash and booting the switch
from flash.

Table 6: Primary/Secondary memory access

Action Menu CLI Web Agent SNMP

Download to Primary Yes Yes Yes Yes

Download to Secondary No Yes No Yes

Boot from Primary Yes Yes Yes Yes

Boot from Secondary No Yes No Yes

The different software download options involve different copy commands, plus xmodem, usb, and tftp.

Download interruptions. In most cases, if a power failure or other cause interrupts a flash image download, the
switch reboots with the image previously stored in primary flash. In the unlikely event that the primary image is
corrupted, as a result of an interruption, the switch will reboot from secondary flash and you can either copy the
secondary image into primary or download another image to primary from an external source.

Replacing or removing local switch software
This section describes commands for erasing a software version and copying an existing software version
between primary and secondary flash.

It is not necessary to erase the content of a flash location before downloading another software file.
The process automatically overwrites the previous file with the new file. If you want to remove an
unwanted software version from flash, Hewlett Packard Enterprise recommends that you do so by
overwriting it with the same software version that you are using to operate the switch, or with another
acceptable software version. To copy a software file between the primary and secondary flash
locations, See "Copying a switch software image from one flash location to another", below.

The local commands described here are for flash image management within the switch. To download
a software image file from an external source, see "File Transfers" in the Management and
Configuration Guide for your switch.

Copying a switch software image from one flash location to another. When you copy the flash image from
primary to secondary or the reverse, the switch overwrites the file in the destination location with a copy of the file
from the source location. This means you do not have to erase the current image at the destination location
before copying in a new image.
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Verify that there is an acceptable software version in the source flash location from which you are
going to copy. Use the show flash command or, if necessary, the procedure under Displaying the
current flash image data to verify an acceptable software version. Attempting to copy from a source
image location that has a corrupted flash image overwrites the image in the destination flash
location. In this case, the switch will not have a valid flash image in either flash location, but will
continue running on a temporary flash image in RAM. Do not reboot the switch. Instead,
immediately download another valid flash image to primary or secondary flash. Otherwise, if the
switch is rebooted without a software image in either primary or secondary flash, the temporary flash
image in RAM will be cleared and the switch will go down. To recover, see "Restoring a Flash Image"
in the Management and Configuration Guide for your switch.

Syntax
copy flash flash <destination flash>
where: destination flash = primary or secondary:

For example, to copy the image in secondary flash to primary flash:

Verify that there is a valid flash image in the secondary flash location. The following figure indicates that a
software image is present in secondary flash. (If you are unsure whether the image is secondary flash is valid, try
booting from it before you proceed by using boot system flash secondary

The following example indicates two different software versions in Primary and Secondary flash:

switch(config)# show flash
Image             Size (bytes) Date     Version
----------------- ------------ -------- --------------------
Primary Image     : 10167529    10/14/11 K.14.89
Secondary Image   : 15085139    08/17/12 K.15.10.0001

Boot ROM Version : K.15.28
Default Boot     : Primary

Syntax

Execute the copy command as follows:

switch(config)# copy flash flash primary
Erasing the contents of Primary or Secondary flash. This command deletes the software image file from the

No undo! Before using this command in one flash image location (primary or secondary), ensure that
you have a valid software file in the other flash image location (secondary or primary). If the switch
has only one flash image loaded (in either primary or secondary flash) and you erase that image,
then the switch does not have a software image stored in flash. In this case, if you do not reboot or
power cycle the switch, you can recover by using xmodem or tftp to download another software
image.

erase flash [primary | secondary]

For example, to erase the software image in primary flash, do the following:

1. First verify that a usable flash image exists in secondary flash. The most reliable way to ensure this is to reboot
the switch from the flash image you want to retain. For example, if you are planning to erase the primary
image, then first reboot from the secondary image to verify that the secondary image is present and
acceptable for your system:

92 Aruba Basic Operation Guide for ArubaOS-Switch 16.05

Anexo 02 ITEM 10 (0592613)         SEI 0008478-63.2018.6.02.8000 / pg. 4940



switch# boot system flash secondary
2. Then erase the software image in the selected flash (in this case, primary):

switch# erase flash primary
The Primary OS Image will be deleted, continue [y/n]?

3. Type ‘y’ at the prompt to complete the flash erase.

4. Use show flash to verify erasure of the selected software flash image. The “0” shows that the primary flash has
been erased.

The following example shows flash listing after erasing Primary flash

switch# show flash
Compressed Primary Code size = 0
Compressed Secondary code size = 2555802
Boot ROM Version : K.15.19
Default Boot : Secondary

In redundant management systems, this command will erase the selected flash in both the active and the standby
management modules. If redundancy has been disabled or the standby module has failed self-test, this command
only affects the active management module.

Rebooting the switch

Setting the default flash for bootup
To specify the default flash (primary or secondary) to boot from on the next boot, use the boot set-default flash
command. The syntax is as follows:

boot set-default flash [ primary|secondary ]

switch(config)# boot set-default flash secondary
switch(config)# show flash
Image           Size(Bytes)   Date    Version
------          ----------   -------  -------------
Primary Image   : 7476770    03/15/10 K.15.01.0001
Secondary Image : 7476770    03/15/10 K.15.01.0001

Boot Rom Version: K.15.08
Default Boot    : Secondary

switch(config)# boot
This management module will now reboot from secondary
and will become the standby module! You will need to 
use the other management module's console interface.
Do you want to continue [y/n]?

Booting from the default flash or configuration file

Procedure

1. To boot the switch from the default flash (primary or secondary) image, use the boot command.

This command allows a boot sequence that includes the complete set of self-tests.

The switch is booted either from the flash (primary or secondary) that you are currently booted on or from the
flash image that was set by the boot set-default command or by the last executed boot system flash
<primary | secondary> command. You can select which image to boot from during the boot process itself
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(you are prompted with a message which will indicate the flash being booted from). When using redundant
management, the switch will fail over to the standby management module.

2. To boot from a configuration file, use the boot config <filename> command.

This command allows a boot sequence that includes the complete set of self-tests.

The following example shows the Boot command (default Primary flash) with redundant management

switch(config)# boot
This management module will now reboot from primary image
and will become the standby module! You will need to use
the other management module's console interface.
Do you want to continue [y/n]? y

Do you want to save current configuration [y/n]? n
In the above example, typing either a ‘y’ or ‘n’ at the second prompt initiates the reboot operation. (Entering ‘y’
saves any configuration changes from the running-config file to the startup-config file; entering ‘n’ discards them.)

The following example shows the Boot command booting from a different flash than the current flash (with
redundant management module present)

switch(config)# show flash
Image Size(Bytes) Date Version
Primary Image : 7497114 03/29/10 K.15.01.0001
Secondary Image : 7497114 03/29/10 K.15.01.0001
Boot Rom Version: K.15.08
Default Boot : Primary

switch(config)# boot set-default flash secondary
This command changes the location of the default boot.
This command will change the default flash image to boot from 
secondary. Hereafter, 'reload' 'boot' commands will boot from
secondary. Do you want to continue [y/n]? y

switch(config)# boot
This management module will now reboot from secondary image
and will become the standby module! You will need to use the
other management module's console interface.
Do you want to continue [y/n]? n

Booting from a specified flash

Procedure

1. To reboot from primary flash, use the boot system flash primary command.

This command allows a boot sequence that includes the complete set of self-tests.

2. To reboot from secondary flash, use the boot system flash secondary command.

This command allows a boot sequence that includes the complete set of self-tests.

The following example shows use of the command to reboot the switch from secondary flash when there are no
pending configuration changes in the running-config file. Typing either a [y] or [n] at the second prompt initiates
the reboot operation.
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Boot command with secondary flash option
switch(config)# boot system flash secondary
System will be rebooted from secondary image. Do you want to continue [y/n]?

Enabling and disabling the fastboot option

Procedure

1. To enable the fastboot option, use the fastboot command.

When this option is enabled, the bootup sequence does not include the internal power-on self-tests, resulting
in a faster boot time.

2. To disable the fastboot option, use the no fastboot command.

When this option is disabled, the bootup sequence includes the complete set of self-tests.

3. To display the status of the fastboot feature, either enabled or disabled, use the show fastbootcommand.

When using redundant management and fastboot is enabled, it is saved to the standby management module
when the config files are synchronized. Fastboot is used during the next bootup on either management module.

Enabling the fastboot option
switch(config)# fastboot

Using reload
The reload command reboots the switch from the flash image that you are currently booted on (primary or
secondary) or the flash image that was set either by the boot set-default command or by the last executed boot
system flash <primary | secondary> command. Because reload bypasses some subsystem self-tests, the
switch reboots faster than if you use either of the boot command options. If you are using redundant
management and redundancy is enabled, the switch will failover to the other management module.

Syntax
reload
For example, if you change the number of VLANs the switch supports, you must reboot the switch in order to
implement the change. The reload command prompts you to save or discard the configuration changes.

The following example shows how to use reload with redundant management and pending configuration changes:

switch(config)# max-vlans 12
Command will take effect after saving configuration and reboot.

switch(config)# reload
This command will cause a switchover to the other management
module which may not be running the same software image and
configurations. Do you want to continue [y/n]? y
Scheduled reload. Beginning with software release K.11.34, additional parameters have been added to the
reload command to allow for a scheduled reboot of the switch via the CLI.

Syntax
reload [after <[dd:]hh:] [mm>] | [at <hh:mm[:ss]>] [<mm/dd[/[yy]yy]>]
no reload [after <[dd:]hh:] [mm>] | [at <hh:mm[:ss]>] [<mm/dd[/[yy]yy]>]
Enables a scheduled warm reboot of the switch. The switch boots up with the same startup config file and using
the same flash image as before the reload.
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When using redundant management, the reload at/after command causes a switch over at the
scheduled time to the other management module, which may not be running the same software
image or have the same configurations.

Parameters include:

• after

Schedules a warm reboot of the switch after a given amount of time has passed.

• at

Schedules a warm reboot of the switch at a given time.

The no form of the command removes a pending reboot request.

For more details and examples, see the following.

The scheduled reload feature removes the requirement to physically reboot the switch at inconvenient times (for
example, at 1:00 in the morning). Instead, a reload at 1:00 mm/dd command can be executed (where mm/dd is
the date the switch is scheduled to reboot).

Configuration changes are not saved with reload at or reload after commands. No prompt to save
configuration file changes is displayed. See Boot and reload command comparison.

Examples of scheduled reload commands:

• To schedule a reload in 15 minutes:

switch# reload after 15
• To schedule a reload in 3 hours:

switch# reload after 03:00
• To schedule a reload for the same time the following day:

switch# reload after 01:00:00
• To schedule a reload for the same day at 12:05:

switch# reload at 12:05
• To schedule a reload for some future date:

switch# reload at 12:05 01/01/2008

The following example shows the reload command with a redundant management system

switch(config)# reload after 04:14:00
    Reload scheduled in 4 days, 14 hours, 0 minutes
This command will cause a switchover at the scheduled
time to the other management module which may not be
running the same software image and configurations.
Do you want to continue [y/n]?
Module reload. The module reload feature allows you to reset a module by initiating a warm reboot of a specified
module or modules. This saves time over rebooting the entire switch, which can take several minutes to complete
and disrupts all users on the switch. The specified module has its power turned off, and then turned on again. This
causes the module to reset to a known good state and reload its software.
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Syntax
reload [[after <[[DD:]HH:]MM>] | [[at HH:MM[:SS] [MM/DD[/[YY]YY]]]]
| [[module <slot-id-range>]]]
no reload [[after <[[DD:]HH:]MM>] | [[at HH:MM[:SS] [MM/DD[/[YY]YY]]]]
| [[module <slot-id-range>]]]
When specified with the module parameter, initiates a reload of the module in the specified slot or slots by turning
the slot power off, then on again. A valid slot or range of slots must be specified. The at and after parameters are
not allowed with the module option. The no version of the command is not valid with the module option.

When the reload command is executed without any parameters, an immediate switch reload occurs.

This feature is not supported for HPE One modules.

module: Powers the module on or off, forcing a software reload of the specified module or modules.

The following example shows reloading a specified module:

switch(config)# reload module C
The ‘reload module’ command will shutdown the specified
modules. Ports on specified modules will no longer pass
traffic. Any management traffic to the switch which
passes through the affected modules will be interrupted
(e.g. ssh, telnet, snmp). This command may take up to 2
minutes to power down all specified modules. Please check 
the event log for current status of module power down,
power up cycle. Continue [y/n]?
Displaying reload information. Use the show reload command to display the reload information. This can
include:

• A scheduled, pending reload of the entire switch

• A statement that no reload is scheduled

• The time of the last reload of each module on the system

The following example shows the scheduled reload at information:

switch(config)# reload at 23:45
Reload scheduled at 23:45:47 6/16/2012
(in 0 days, 1 hours, 41 minutes

switch(config)# show reload at
Reload scheduled for 23:45:47 06/16/2012
(in 0 days, 1 hours, 40 minutes)

switch(config)# show reload after
Reload scheduled for 23:45:47 6/16/2012
(in 0 days, 1 hours, 40 minutes)
The following example shows the scheduled reload after information:

switch(config)# reload after 35
Reload scheduled in 0 days, 0 hours, 35 minutes

switch(config)# show reload at
Reload scheduled in 0 days, 0 hours, 34 minutes
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switch(config)# show reload after
Reload scheduled in 0 days, 0 hours, 34 minutes
The following example shows the module reload information:

switch(config)# show reload module

Module Reload information:

Module | Last reload date
-------+---------------------
  C      10:50:51 01/13/2012

Boot and reload command comparison
The switch offers reboot options through the boot and reload commands, plus the options inherent in a dual-flash
image system. Generally, using boot provides more comprehensive self-testing; using reload gives you a faster
reboot time.

Table 7: Comparing the boot and reload commands

Actions Included in Boot? Included in Reload Note

Save all configuration
changes since the last
boot or reload

Optional, with prompt Optional with reload <cr>,
when prompt displays. Not
saved with reload at/after
commands; No prompt is
displayed.

Config changes saved to
the startup-config file if "y"
is selected (reload
command).

Perform all system self-
tests

Yes No The reload command
provides a faster system
reboot.

Choice of primary or
secondary flash image

Yes No—Uses the current flash
image.

Perform a scheduled
reboot

No Yes Use the reload command
with after/at parameters
(see for Using reload
details).

Operating notes about booting
Default boot source. The switch reboots from primary flash by default unless you specify the secondary flash by
entering either the boot system flash [primary | secondary] or boot set-default flash [primary | secondary]
command. Both the boot command and the reload command will reboot based on how these options have been
selected.

Boot attempts from an empty flash location. In this case, the switch aborts the attempt and displays:

Image does not exist
Operation aborted.
Interaction of Primary and Secondary flash images with the current configuration. The switch has one
startup-config file (see Configuration file management on page 115), which it always uses for reboots,
regardless of whether the reboot is from primary or secondary flash. Also, for rebooting purposes, it is not
necessary for the software image and the startup-config file to support identical software features. For example,
suppose that you have just downloaded a software upgrade that includes new features that are not supported in
the software you used to create the current startup-config file. In this case, the software simply assigns factory-
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default values to the parameters controlling the new features. Similarly, If you create a startup-config file while
using a version "Y" of the switch software, and then reboot the switch with an earlier software version "X" that
does not include all the features found in "Y", the software simply ignores the parameters for any features that it
does not support.

Scheduled reload. If no parameters are entered after the reload command, an immediate reboot is executed.
The reload at and reload after command information is not saved across reboots. If the switch is rebooted before
a scheduled reload command is executed, the command is effectively canceled. When entering a reload at or
reload after command, a prompt will appear to confirm the command before it can be processed by the switch.
For the reload at command, if mm/dd/yy are left blank, the current day is assumed.

The scheduled reload feature removes the requirement to physically reboot the switch at inconvenient times (for
example, at 1:00 in the morning). Instead, a reload at 1:00 mm/dd command can be executed (where mm/dd is
the date the switch is scheduled to reboot).

Managing multiple configuration files

Viewing the status and content of startup-config files

Procedure

1. To view a list of the available startup-config files on the switch and the current use of each file, use the show
config files command.

2. To view the content of the default startup-config file, use the show config command.

The default startup-config file is the startup-config file that is currently active on the switch.

3. To view the content of a specific startup-config file, use the show config <filename> command.
The filename argument specifies the file.With Multiple Configuration enabled, the switch can have up to three
startup-config files. This command can display the content of any of the startup-config files stored in the
switch, whereas the show config command always displays the content of the default startup-config file.

Changing or overriding the reboot configuration policy
To change the reboot configuration policy, do one of the following:

• Use the startup-default primary config <filename> command to change the current policy so that the switch
automatically reboots from the primary flash using the specified startup-config file. The filename argument
specifies the startup-config file to use.

• Use the startup-default secondary config <filename> command to change the current policy so that the
switch automatically reboots from the secondary flash using the specified startup-config file. The filename
argument specifies the startup-config file to use.

To override the default reboot configuration policy for a single reboot instance, do one of the following:

• Use the boot system flash primary config <filename> command to override the current policy so that the
switch automatically reboots from the primary flash using the specified startup-config file. The filename
argument specifies the startup-config file to use.

• Use the boot system flash secondary config <filename> command to override the current policy so that the
switch automatically reboots from the secondary flash using the specified startup-config file. The filename
argument specifies the startup-config file to use.
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Reboot configuration policy that uses different startup-config files for different software versions

Suppose that you have the following situation:

• Software release “A” is stored in primary flash and a later software release is stored in secondary flash.

• Memory slot 1 stores a reliable, minimal configuration (named minconfig) to be used with the software
version in the primary flash.

• Memory slot 2 stores a modified startup-config file (named newconfig) to be used with the software version
in secondary flash. This startup-config file includes untested changes for improved network operation.

The operator wants to ensure that in case of a need to reboot by pressing the Reset button, or if a power failure
occurs, the switch will automatically reboot with the minimal startup-config file in memory slot 1. Since a reboot
due to pressing the Reset button or to a power cycle always uses the software version in primary flash, the
operator has to configure the switch to always boot from primary flash with the startup-config file named
minconfig (in memory slot 1). Also, whenever the switch boots from secondary flash, the operator also wants
the startup-config named newconfig to be used. The following two commands configure the desired behavior.

switch(config)# startup-default primary config minconfig
switch(config) # startup-default secondary config newconfig

Managing startup-config files in the switch
Managing the startup-config files involves renaming, copying, and erasing startup-config files.

• Use the rename config <current-filename> <new-filename> command to change the name of an existing
startup-config file. The current-filename argument specifies the existing startup-config file and the new-
filename argument specifies the new name for the file.

A file name can include up to 63, alphanumeric characters. Blanks are allowed in a file name enclosed in
quotes (" " or ‘ ‘). File names are not case-sensitive.

A file name can include up to 63, alphanumeric characters. Blanks are allowed in a file name enclosed in
quotes (" " or ‘ ‘). File names are not case-sensitive.

For redundant management systems, renaming a config file affects both the active management module and
the standby management module, unless redundancy is disabled or the standby module failed selftest.

• Use the copy config <source-filename> config <target-filename> command to create a new startup-config
file or to replace an existing startup-config file with a new one.

This command copies the contents of an existing startup-config file in one memory slot to a new startup-config
file in another, empty memory slot.

If the target startup-config file already exists, it is overwritten by the content of the source startup-config file
otherwise, it will be created in the first empty configuration memory slot on the switch. If the destination
startup-config file does not already exist and there are no empty configuration memory slots on the switch,
then a new startup-config file is not created.

• Do one of the following to erase any of the startup-config files in the switches memory slots:

◦ Use the erase config <filename> command to erase the specified startup-config file. filename argument

specifies the file to be erased.

◦ Use the erase startup-config command to erase the currently active startup-config file.
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In some cases, erasing a file causes the switch to generate a new, default-configuration file for the affected
memory slot. Where a file is assigned to either the primary or the secondary flash, but is not the currently active
startup config file, erasing the file does not remove the flash assignment from the memory slot for that file. Thus, if
the switch boots using a flash location that does not have an assigned startup-config, then the switch creates a
new, default startup-config file and uses this file in the reboot. (This new startup-config file contains only the
default configuration for the software version used in the reboot.) Executing write memory after the reboot
causes a switch-generated filename of config x to appear in the show config files display for the new file,
where x corresponds to the memory slot number.

In a redundant management system, these commands erase the startup config file on both the active and the
standby management modules as long as redundancy has not been disabled. If the standby management module
is not in standby mode or has failed selftest, the startup config file is not erased.

The following example shows how to create and assign a new startup config file

If you wanted to experiment with configuration changes to the software version in secondary flash, you could
create and assign a separate starup-config file for this purpose, as shown in the following command sequence.

switch(config)# copy config config1 config config2
switch(config)# startup-default secondary config config2
switch(config)# show config files

Configuration files:

id | act pri sec | name
---+-------------+-----------------------------------------------
 1 |  *   *      | Config1
 2 |          *  | Config2
 3 |             | 

The following example shows how to erase a non-active startup-config file. The memory configuration has a non-
active configuration file named “config3”, which you want to erase.

switch(config)# show config files

Configuration files:

id | act pri sec | name
---+-------------+-----------------------------------------------
 1 |  *   *      | minconfig
 2 |          *  | config2
 3 |             | config3

switch(config)# erase config config3
switch(config)# show config files

Configuration files:

id | act pri sec | name
---+-------------+-----------------------------------------------
 1 |  *   *      | minconfig
 2 |          *  | config2
 3 |             | 

Uploading a configuration file to a remote TFTP host
Uploading a configuration file from a remote TFTP host
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To upload a configuration file to a remote TFTP host through the out-of-band management interface, do one of the
following:

Prerequisites

Before you upload a configuration file to a remote TFTP host, you must insure that the switch has a separate out-
of-band management port if the traffic is being transmitted through the out-of-band management interface.

Procedure

1. Use the copy config <src-file> tftp <ip-addr> <remote-file> pc oobm command to upload
a configuration file to a remote TFTP PC host.

2. Use the copy config <src-file> tftp <ip-addr> <remote-file> unix oobm command to
upload a configuration file to a remote TFTP UNIX host.

To upload a configuration file to a remote TFTP host through the data interface, do one of the following:

• Use the copy config <src-file> tftp <ip-addr> <remote-file> pc command to upload a
configuration file to a remote TFTP PC host.

• Use the copy config <src-file> tftp <ip-addr> <remote-file> unix command to upload a
configuration file to a remote TFTP UNIX host.

For more information on using TFTP to upload a file to a remote server, see "TFTP: Copying a Configuration File
to a Remote Host" in Appendix A of the Management and Configuration Guide for your switch.

Example

The following command uploads a startup-config file named test01 from the switch to a (UNIX) TFTP server at IP
address 10.10.28.14:

switch(config)# copy config test-01 tftp 10.10.28.14 test-01.txt unix

Downloading a configuration file from a remote TFTP host
Downloading a configuration file from a remote TFTP host

To download a configuration file from a remote TFTP host through the out-of-band management interface, do one
of the following:

Prerequisites

Before you download a configuration file from a remote TFTP host, you must insure that the switch has the
following:

• An empty memory slot.

• A separate out-of-band management port, if the traffic is being transmitted through the out-of-band
management interface.

Procedure

1. Use the copy tftp config <dest-file> <ip-addr> <remote-file> pc oobm command to
download a configuration file from a remote TFTP PC host.

2. Use the copy tftp config <dest-file> <ip-addr> <remote-file> UNIX oobm command to
download a configuration file from a remote TFTP UNIX host.
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To download a configuration file from a remote TFTP host through the data interface, do one of the following:

• Use the copy tftp config <dest-file> <ip-addr> <remote-file> pc command to download a
configuration file from a remote TFTP PC host.

• Use the copy tftp config <dest-file> <ip-addr> <remote-file> UNIX command to download
a configuration file from a remote TFTP UNIX host.

For more on using TFTP to download a file from a remote host, see "TFTP: Copying a Configuration File from a
Remote Host" in Appendix A of the Management and Configuration Guide for your switch.

Example

The following command downloads a startup-config file named test01.txt from a (UNIX) TFTP server at IP
address 10.10.28.14 to the first empty memory slot in the switch:

switch(config)# copy tftp config test-01 10.10.28.14 test-01.txt unix

Uploading a configuration file to a serially connected host
To upload a configuration file to a serially connected host, do one of the following:

Procedure

1. Use the copy config <filename> xmodem pc command to upload a configuration file to a serially
connected PC host.

2. Use the copy config <filename> xmodem unix command to upload a configuration file to a serially
connected UNIX host.

For more on using Xmodem to upload a file to a serially connected host, see "Xmodem: Copying a Configuration
File to a Serially Connected PC or UNIX Workstation" in Appendix A of the Management and Configuration Guide
for your switch.

Downloading a configuration file from a serially connected host
To download a configuration file from a serially connected host, do one of the following:

Procedure

1. Use the copy xmodem config <dest-file> pc command to download a configuration file from a
serially connected PC host.

2. Use the copy xmodem config <dest-file> unix command to download a configuration file from a
serially connected UNIX host.

For more on using Xmodem to copy a file from a serially connected host, see "Xmodem: Copying a Configuration
File from a Serially Connected PC or UNIX Workstation" in Appendix A of the Management and Configuration
Guide for your switch.

Multiple configuration files
In this mode of operation, you cannot preserve different startupconfig files across a reboot without using remote
storage.

The switch allows up to three startup-config files with options for selecting which startup-config file to use for:
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• A fixed reboot policy using a specific startup-config file for a specific boot path (primary or secondary flash)

• Overriding the current reboot policy on a per-instance basis

Figure 46: Optional reboot process

While you can still use remote storage for startup-config files, you can now maintain multiple startup-config files
on the switch and choose which version to use for a reboot policy or an individual reboot.

This choice of which configuration file to use for the startup-config at reboot provides the following new options:

• The switch can reboot with different configuration options without having to exchange one configuration file for
another from a remote storage location.

• Transitions from one software release to another can be performed while maintaining a separate configuration
for the different software release versions.

• By setting a reboot policy using a known good configuration and then overriding the policy on a per-instance
basis, you can test a new configuration with the provision that if an unattended reboot occurs, the switch will
come up with the known, good configuration instead of repeating a reboot with a misconfiguration.

Operating notes for multiple configuration files
Multiple configuration storage in the switch. The switch uses three memory "slots", with identity (id) numbers
of 1, 2, and 3, as shown by the following output of the show config files command.

switch(config)# show config files
Configuration files:

id | act pri sec | name
---+-------------+-----------------------------------------------
 1 |             | oldConfig 
 2 |  *   *   *  | workingConfig 
 3 |             | 

A startup-config file stored in a memory slot has a unique, changeable file name. The switches covered in this
guide can use the startup-config in any of the memory slots (if the software version supports the configured
features). In the default configuration, if the switch was shipped from the factory with software installed in both the
primary and secondary boot paths, then one startup-config file named “config1” is used for both paths and is
stored in memory slot 1. Memory slots 2 and 3 are empty in this default configuration.

An asterisk ( * ) in the act, pri, or sec column has the following meaning:
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• act column: The corresponding startup-config file is currently in use.

• pri column: The corresponding startup-config file is currently assigned to the primary boot path.

• sec column: The corresponding startup-config file is currently assigned to the secondary boot path.

Reboot policy. With multiple startup-config files in the switch you can specify a policy for the switch to use upon
reboot. The options include:

• Use the designated startup-config file with either or both reboot paths (primary or secondary flash)

• Override the current reboot policy for one reboot instance by specifying a boot path (primary or secondary
flash) and the startup-config file to use.

For a given reboot, the switch automatically reboots from the startup-config file assigned to the flash location
(primary or secondary) being used for the current reboot. For example, when you first download a software
version that supports multiple configuration files and boot from the flash location of this version, the switch copies
the existing startup-config file (named oldConfig) into memory slot 2, renames this file to workingConfig, and
assigns workingConfig as:

• The active configuration file

• The configuration file to use when booting from either primary or secondary flash

In this case, the switch is configured to automatically use the workingConfig file in memory slot 2 for all
reboots.

Changes to the startup-config file. When the switch reboots, the startupconfig file supplies the configuration for
the running-config file the switch uses to operate. Changes to the running-config file are written back to the
startup-config file that was used at the last reboot. The changes are written when the write-mem command (or, in
the Menu interface, the Save command) is executed. For example, suppose that a system administrator performs
the following on a switch that has two startup-config files (workingconfig and backupconfig):

1. Reboot the switch through the Primary boot path using the startup-config file named backupconfig.

2. Use the CLI to make configuration changes in the running-config file, and then execute write-mem.
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The result is that the startup-config file used to reboot the switch is modified by the actions in step 2.

Figure 47: Reboot process and making changes to the startup-config file

An alternate startup-config file. A new configuration file can be created for an alternate startup-config file. There
are two methods for creating a new configuration file:

• Copy an existing startup-config file to a new filename, then reboot the switch, make the desired changes to the
running-config file, then execute write memory.

• Erase the active startup-config file. This generates a new, default startupconfig file that always results when
the switch automatically reboots after deletion of the currently active startup-config file.

The transition to multiple configuration files. At the first reboot with a software release supporting multiple
configuration, the switch:

• Assigns the filename oldConfig to the existing startup-config file (which is stored in memory slot 1).

• Saves a copy of the existing startup-config file in memory slot 2 with the filename workingConfig.

• Assigns the workingConfig file as the active configuration and the default configuration for all subsequent
reboots using either primary or secondary flash.

The following output of the show config files command shows the switch memory assignments after the first
reboot from software that supports multiple configuration. In this state, the switch always uses the
workingConfig file to reboot.

switch(config)# show config files
Configuration files:
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id | act pri sec | name
---+-------------+-----------------------------------------------
 1 |             | oldConfig 
 2 |  *   *   *  | workingConfig 
 3 |             | 

Viewing the configuration of interfaces

Viewing the running configuration of interfaces
To view the running configuration of interfaces, do one of the following:

Procedure

1. Use the show running-config [structured]command to view the running configuration of all
interfaces. Include the structured option to group the information in a logical manner.

2. Use the show running-config interface port-listcommand to view the running configuration of the
specified port interfaces. Include the structuredoption to group the information in a logical manner.

3. Use the show running-config interface loopback <0-7> command to view the running
configuration of the specified loopback interfaces. Include the structuredoption to group the information in a
logical manner.

4. Use the show running-config interface vlan <vlan-id-list>
command to view the running configuration of the specified VLAN interfaces. Include the structured option to
group the information in a logical manner.

Examples

The following example shows Running configuration output in preview mode.

switch(config)# preview-mode 
ATTENTION: You are entering preview mode on this product. This mode, the 
commands, features and functionality specific to this mode, and all output
from this mode are Hewlett Packard Enterprise Confidential and Proprietary.
You may use this mode at your own risk. Any defects or issues encountered  
in this mode will be addressed per Hewlett Packard Enterprise's discretion.
Continue (y/n)? y                                                           
(Prev-mode)switch(config)# show running-config

Running configuration:

; JL075A Configuration Editor; Created on release #KB.16.01.0000x
; Ver #0c:01.7c.59.f4.7b.ff.ff.fc.ff.ff.3f.ef:

hostname "Aruba-3810M-16SFPP-2s"
module 1 type jl075x
module 2 type jl075y
module 3 type jl075z
snmp-server community "public" unrestricted
oobm
   ip address dhcp-bootp
   exit
vlan 1
   name "DEFAULT_VLAN"
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   untagged 1-16
   ip address dhcp-bootp
   exit
preview-mode
The following example shows Running configuration output for interfaces A2 - A4

switch(eth-A2-A4)# show running-config

Running configuration:

; J8698A Configuration Editor; Created on release #K.15.10.0001
; Ver #02:0b:ef:e6
hostname "switch"
interface A2
   disable
   name "test1"
   flow-control
   broadcast-limit 80
   speed-duplex 100-full
   unknown-vlans Block 
   qos priority 4 
   lacp Passive
   gvrp join-timer 30
   gvrp leave-timer 60
   gvrp leaveall-timer 700
exit
interface A3
   disable name "test1"
   flow-control
   broadcast-limit 80
   speed-duplex 100-full
   unknown-vlans Block
   qos priority 4
   lacp Passive
   gvrp join-timer 30
   gvrp leave-timer 60
   gvrp leaveall-timer 700
exit
vlan 1
   name "DEFAULT_VLAN"
   untagged A1-A4,C1-C24,F1-F4
   ip address dhcp-bootp
   exit
interface A2
   dhcp-snooping trust
   bandwidth-min output 20 10 10 10 20 10 10 10
   rate-limit bcast in percent 75
   ipv6 access-group "check" in
   exit
interface A3
   dhcp-snooping trust
   bandwidth-min output 20 10 10 10 20 10 10 10
   rate-limit bcast in percent 75
   ipv6 access-group "check" in
   exit
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The following example shows an example of the running config for a range of interfaces. The configuration
information for interfaces A2 and A3 is now displayed together.

switch(config)# show running-config interface A2-A3

Running configuration:

interface A2
   disable
   name "test1"
   flow-control
   broadcast-limit 80
   speed-duplex 100-full
   unknown-vlans block
   qos priority 4
   gvrp join-timer 30 leave-timer 60 leaveall-timer 700
   dhcp-snooping trust
   lacp passive
   bandwidth-min output 20 10 10 10 20 10 10 10
   rate-limit bcast in percent 75
   ipv6 access-group "check" in
   untagged vlan 1
   exit
interface A3
   disable
   name "test1"
   flow-control
   broadcast-limit 80
   speed-duplex 100-full
   unknown-vlans block
   qos priority 4
   gvrp join-timer 30 leave-timer 60 leaveall-timer 700
   dhcp-snooping trust
   lacp passive
   bandwidth-min output 20 10 10 10 20 10 10 10
   rate-limit bcast in percent 75
   ipv6 access-group "check" in
   untagged vlan 1
   exit
The following example shows an example of the running config file for a range of interfaces after some
configuration changes have been made.

switch(config)# no stack
switch(config)# mesh 2-3
Command will take effect after saving configuration and reboot.

switch(config)# write memory
switch(config)# reload

switch# show running-config interface 2-3

Running configuration:

interface 2
   untagged vlan 1
   mesh
   exit
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interface 3
   flow-control
   untagged vlan 1
   mesh
   exit
The following example is an example of the running config output showing VLAN information.

switch(config)# show running-config

Running configuration:
; J8698A Configuration Editor; Created on release #K.15.10.0001
; Ver #02:0b:ef:e6
hostname "switch"
module 1 type J9309A
module 3 type J8702A
module 6 type J8702A
ip routing
vlan 1
   name "DEFAULT_VLAN"
   untagged A1-A4,C1-C24,F1-F24
   ip address dhcp-bootp
   exit
vlan 2
   name "test-vlan-2"
   ip helper-address 4.1.1.1
   ip helper-address 5.1.1.1
   ip address 1.1.1.1 255.255.255.0
   ipv6 address 2001::/64 anycast
   ipv6 enable
   exit
vlan 3
   name "VLAN3"
   ip helper-address 7.1.1.1
   ip forward-protocol udp 7.1.1.1 snmp
   ip forward-protocol udp 11.1.1.2 dns
   no ip address
   exit
vlan 4
   name "VLAN4"
   ip address 5.1.1.1 255.255.255.0
   ip bootp-gateway 5.1.1.1
   exit
logging 10.0.102.90
logging system-module ospf
ip route 5.1.1.0 255.255.255.0 vlan 4 distance 3
In the following example, the configuration information for VLAN 4 is now displayed in one place.

switch(config)# show running-config vlan 3-4

Running configuration:

vlan 3
   name "VLAN3"
   ip helper-address 7.1.1.1
   ip forward-protocol udp 7.1.1.1 snmp
   ip forward-protocol udp 11.1.1.2 dns
   no ip address
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   exit
vlan 4
   name "VLAN4"
   ip address 5.1.1.1 255.255.255.0
   ip bootp-gateway 5.1.1.1
   ip route 5.1.1.0 255.255.255.0 distance 3
   exit
Below is an example of the running config for a range of VLANs after configuration changes have been made to
selected VLANs.

switch(config)# dhcp-snooping
switch(config)# vlan 14
switch(vlan-14)# exit
switch(config)# vlan 15
switch(vlan-15)# exit
switch(config)# vlan 23
switch(vlan-23)# exit
switch(config)# dhcp-snooping vlan 14-15
switch(config)# static-mac 00:11:22:33:44:55 vlan 23 interface A3
switch(config)# spanning-tree instance 2 vlan 15

switch(config)# show running-config vlan 14-15

Running configuration:

vlan 14
   name "VLAN14"
   no ip address
   dhcp-snooping
   exit
vlan 15
   name "VLAN15"
   no ip address
   dhcp-snooping
   spanning-tree instance 2
   exit

Viewing the startup configuration of interfaces
To view the startup configuration of interfaces, do one of the following:

• Use the show config command to view the startup configuration of all interfaces.

• Use the show config interface port-listcommand to view the startup configuration of the specified
port interfaces.

• Use the show config interface loopback <0-7>command to view the startup configuration of the
specified VLAN interfaces.

Examples

The following example shows startup configuration output.

switch(config)# show config

Startup configuration:

; J8698A Configuration Editor; Created on release #K.14.54C
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; Ver #02:0b:ef:e6
hostname "switch"
module 1 type J9309A
module 3 type J8702A
module 6 type J8702A
vlan 1
   name "DEFAULT_VLAN"
   untagged A1-A4,C1-C9,C15-C24,F1-F24
   ip address dhcp-bootp
   no untagged C10-C14
   exit
vlan 5
   name "VLAN5"
   untagged C10-C14
   ip address 5.1.1.1 255.255.255.128
   exit
interface loopback 5
   ip address 7.1.1.1
   exit
interface loopback 7
   ip address 12.1.1.1
   exit
snmp-server community "public" unrestricted
Following is an example of the startup config output for a selected VLAN.

switch(vlan-5)# show config vlan 5

Startup configuration:

vlan 5
   name "VLAN5"
   untagged C10-C14
   ip address 5.1.1.1 255.255.255.128
   exit

The following shows an example of the startup config output for a range of interfaces for a specific VLAN.

Figure 48: Startup config output for a range of interfaces for a specific VLAN

switch(vlan-5)# show config interface C10-C13

Startup configuration:

interface C10
   untagged vlan 5
   exit
interface C11
   untagged vlan 5
   exit
interface C12
   untagged vlan 5
   exit
interface C13
   untagged vlan 5
   exit
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Using automatic configuration update with DHCP Option
66
Prerequisites

To use automatic configuration update with DHCP Option 66, you must do the following:

• Enable one or more DHCP servers with Option 66.

• Insure that one or more TFTP servers have the desired configuration file.

• Insure that the configuration files to be updated were generated on the switch.

• Enable the configuration file to update with Option 66, as described in Enabling and disabling the
configuration file update using Option 66 on page 113.

HPE switches are initially booted up with the factory-shipped configuration file. The automatic configuration
update provides a way to automatically download a different configuration file from a TFTP server using DHCP
Option 66.

Enabling and disabling the configuration file update using Option 66

Procedure

1. Use the dhcp config-file-update command to enable the configuration update using Option 66.

2. Use the no dhcp config-file-update command to disable the configuration update using Option 66.

The configuration file update using Option 66 is enabled by default.

Possible scenarios for updating the configuration file
The following table shows various network configurations and how Option 66 is handled.

Scenario Behavior

Single Server serving
Multiple VLANs • Each DHCP-enabled VLAN interface initiates DHCPDISCOVER message,

receives DHCPOFFER from the server, and send DHCPREQUEST to obtain the
offered parameters.

• If multiple interfaces send DHCPREQUESTs, it is possible that more than one
DHCPACK is returned with a valid Option 66.

• Evaluating and updating the configuration file occurs only on the primary VLAN.

• Option 66 is ignored by any interfaces not belonging to the primary VLAN.

Multiple Servers serving a
Single VLAN • Each DHCP-enabled VLAN interface initiates one DHCPDISCOVER and

receives one or more DHCPOFFER messages.

• Each interface accepts the best offer.

• Option 66 is processed only for the interface belonging to the primary VLAN.

Table Continued
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Scenario Behavior

Multiple Servers serving
Multiple VLANs • Each DHSP-enabled VLAN interface initiates DHCPDISCOVER and receives

one or more DHCPOFFER messages.

• Each interface accepts the best offer.

• Option 66 is processed only for the interface belonging to the primary VLAN.

Multi-homed Server
serving Multiple VLANs • The switch perceives the multi-homed server as multiple separate servers.

• Each DHCP-enabled VLAN interface initiates DHCPDISCOVER and receives
one DHCPOFFER message.

• Each interface accepts the offer.

• Option 66 is processed only for the interface belonging to the primary VLAN.

Operating notes about automatic configuration
Replacing the existing configuration file: After the switch has completed the DHCP transaction on the Primary
VLAN, the two options will cause the switch to download the configuration file from the TFTP server. After the
DHCP client downloads the configuration file, the switch compares the contents of that file with the existing
configuration file. If the content is different, the new configuration file replaces the existing file and the switch
reboots.

Option 66 and the IP address of a TFTP server: Option 66 includes the IP address of the TFTP server from
which the configuration file is downloaded.

Option 67 and the configuration file name: Option 67 includes the name of the configuration file. If the
DHCPACK contains this option, it overrides the default name for the configuration file (switch.cfg)

Global DHCP parameters: Global parameters are processed only if received on the primary VLAN.

Best Offer: The "Best Offer" is the best DHCP or BootP offer sent by the DHCP server in response to the
DHCPREQUEST sent by the switch. The criteria for selecting the "Best Offer" are:

• DHCP is preferred over BootP

• If two BootP offers are received, the first one is selected

• For two DHCP offers:

◦ The offer from an authoritative server is selected

◦ If there is no authoritative server, the offer with the longest lease is selected

Log messages: The file transfer is implemented by the existing TFTP module. The system logs the following
message if an incorrect IP address is received for Option 66: "Invalid IP address <ip-address> received for
DHCP Option 66".

Overview of switch configuration
Switch configuration involves:
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• How switch memory manages configuration changes

• How the CLI implements configuration changes

• How the menu interface and WebAgent implement configuration changes

• How the switch provides software options through primary/secondary flash images

• How to use the switch’s primary and secondary flash options, including displaying flash information, booting or
restarting the switch, and other topics

Configuration file management
The switch maintains two configuration files, the running-config file and the startup-config file.

Table 8: Switch memory operation

Running Config File Startup-config File

Volatile Memory Flash (Non-Volatile Memory)

Controls switch operation. When the switch boots, the
contents of this file are erased and replaced by the
contents of the startup-config file. If no configuration
changes have been made in the CLI since the switch
was last booted, the running-config file is identical to
the startup-config file.

Preserves the most recently saved configuration
through any subsequent reboot.

CLI configuration changes are written to this file. To
use the CLI to save the latest version of the file to the
startup-config file, you must execute the write memory
command.

*NOTE: Menu interface configuration changes are simultaneously written to both the running-config and the
startup-config file.

Booting the switch replaces the current running-config file with a new running-config file that is an exact copy of
the current startup-config file.

Any of the following actions boots the switch:

• Executing the boot or the reload command in the CLI

• Executing the boot command in the menu interface

• Pressing the Reset button on the front of the switch

• Removing, then restoring power to the switch

For more on reboots and the switch’s dual-flash images, See Using Primary and Secondary flash
image options on page 89.

Options for saving a new configuration. Making one or more changes to the running-config file creates a new
operating configuration. Saving a new configuration means to overwrite (replace) the current startup-config file
with the current running-config file. This means that if the switch subsequently reboots for any reason, it will
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resume operation using the new configuration instead of the configuration previously defined in the startup-config
file. There are three ways to save a new configuration:

• In the CLI:

Use the write memory command. This overwrites the current startup-config file with the contents of the
current running-config file.

• In the menu interface:

Use the Save command. This overwrites both the running-config file and the startup-config file with the
changes you have specified in the menu interface screen.

• In the WebAgent:

Click Save. This overwrites both the running-config file and the startup-config file with the changes you have
specified in the WebAgent screen.

Note that using the CLI instead of the menu or WebAgent gives you the option of changing the running
configuration without affecting the startup configuration. This allows you to test the change without making it
"permanent". When you are satisfied that the change is satisfactory, you can make it permanent by executing the
write memory command. For example, suppose that you use the following command to disable port 5:

switch(config)# interface ethernet 5 disable
The above command disables port 5 in the running-config file, but not in the startup-config file. Port 5 remains
disabled only until the switch reboots. If you want port 5 to remain disabled through the next reboot, use write
memory to save the current running-config file to the startup-config file in flash memory.

switch(config)# write memory
If you use the CLI to make a configuration change and then change from the CLI to the Menu interface without
first using write memory to save the change to the startup-config file, then the switch prompts you to save the
change. For example, if you use the CLI to create VLAN 20, and then select the menu interface, VLAN 20 is
configured in the running-config file, but not in the startup-config file. In this case you will see:

switch(config)# vlan 20
switch(config)# menu
Do you want to save current configuration [y/n]?
If you type ‘y’, the switch overwrites the startup-config file with the running-config file, and your configuration
change(s) will be preserved across reboots. If you type ‘n’, your configuration change(s) will remain only in the
running-config file. In this case, if you do not subsequently save the running-config file, your unsaved
configuration changes will be lost if the switch reboots for any reason.

Storage and retrieval of configuration files. You can store or retrieve a backup copy of the startup-config file on
another device. For more information, see "Transferring Switch Configurations" in the Management and
Configuration Guide for your switch.

116 Aruba Basic Operation Guide for ArubaOS-Switch 16.05

Anexo 02 ITEM 10 (0592613)         SEI 0008478-63.2018.6.02.8000 / pg. 4964



Managing interface access

Listing the current console/serial link configuration
Use the show console command to list the current console/serial link configuration.

Use of show console command

This example demonstrates the use of the show console command.

switch (config)# show console

Console/Serial Link

Inbound Telnet Enabled [Yes] : Yes
Web Agent Enabled [Yes] : Yes

Terminal Type [VT100] : VT100
Screen Refresh Interval (sec) [3] : 3
Displayed Events [All] : All
Baud Rate [speed-sense] : speed-sense
Flow Control [XON/XOFF] : XON/XOFF
Global Session Idle Timeout (sec) [0] : 0
Serial/USB Console Idle Timeout (sec) [not set] : not set
Current Session Idle Timeout (sec) : 0

Enabling and disabling inbound Telnet access
In the default configuration, inbound Telnet access is enabled.

Enabling and disabling inbound Telnet access

To enable inbound Telnet access, do one of the following:

Prerequisites

Before you enable or disable inbound Telnet access on a switch, you must insure that the switch has a separate
out-of-band management port if you want to use an out-of-band management port for Telnet access. See
Appendix I, "Network Out-of-Band Management" in this guide for more information about out-of-band
management.

Procedure

1. Use the telnet-server command to enable inbound Telnet access through the data ports.

2. Use the following command to enable inbound Telnet access through specific ports: telnet-server
[ listen < oobm | data | both > ]
Data ports ( listen data option), out-of-band management ports (listen oobm option), or both data and out-of-
band management ports (listen both) can be specified.
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To disable inbound Telnet access, do one of the following:

• Use the no telnet-server command to disable inbound Telnet access through the data ports.

• Use the following command to disable inbound Telnet access through specific ports:no telnet-server
[ listen < oobm | data | both > ]Data ports (listen data option), out-of-band management ports
(listen oobm option), or both data and out-of-band management ports (listen both) can be specified.

Examples

To disable inbound Telnet access:

switch(config)# no telnet-server
To re-enable inbound Telnet access:

switch(config)# telnet-server

Initiating an outbound Telnet session to another device
Initiating an outbound Telnet session to another network device

To initiate an outbound Telnet session, do one of the following:

Prerequisites

Before you initiate an outbound Telnet session to another network device, you must insure that:

• The switch has a separate out-of-band management port, if you want to use an out-of-band management port
for the outbound Telnet traffic. See Appendix I, "Network Out-of-Band Management" in this guide for more
information about out-of-band management.

• Stacking is enabled, if you want to initiate an outbound Telnet session to a member switch that is a
commander in a stack.

Procedure

1. Use the following command to initiate an outbound Telnet session through a data port:
telnet <ipv4-addr | ipv6-addr | hostname | switch-num>

2. Use the following command to initiate an outbound Telnet session through an out-of-band management port:
telnet < ipv4-addr | ipv6-addr | hostname | switch-num > oobm

In these commands, the destination device for the outbound Telnet session is specified as an IPv4 address, IPv6
address, hostname, or stack number (1-16) of a member switch.

Examples

If the host "Labswitch" is in the domain abc.com, you can enter the following command and the destination is
resolved to "Labswitch.abc.com":

switch(config)# telnet Labswitch
You can also enter the full domain name of the host in the command:

switch(config)# telnet Labswitch.abc.com
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You can use the show telnet command to display the resolved IP address.

Figure 49: The show telnet command displaying resolved IP addresses

switch(config)# show telnet

  Telnet Activity

  -------------------------------------------------------
  Session  : **  1
  Privilege: Manager
  From     : Console
  To       :

  -------------------------------------------------------
  Session  : **  2
  Privilege: Manager
  From     : 12.13.14.10
  To       : 15.33.66.20

  -------------------------------------------------------
  Session  : **  3
  Privilege: Operator
  From     : 2001:db7:5:0:203:4ff:fe0a:251
  To       : 2001:db7:5:0:203:4ff1:fddd:12

Web-management interface configuration for idle timeout
An administrator sets the idle timeout for the WebUI management interface and specifies a session timeout page
that is displayed to the user when the WebUI management session ends.

Use the following command to configure the Web-management interface for idle timeout:

web-management [management-url <URL>] [support-url <URL>] [plaintext] [ssl<TCP-
PORT>] [idle-timeout <300-7200>]

The following parameters are specified to configure the Web-management interface for idle timeout:
Management-url

Specify URL to load when the [?] button is clicked on the device's web interface.

Support-url

Specify URL to load when the Support tab is clicked on the device's web interface.

Plaintext

Indicates that the http server has to be enabled with no security. If no parameters are specified, plaintext
is implied. The plaintext server always listens on the well-known port 80.

SSL

Indicates that the http server has to be enabled with Secure Sockets Layer support. TCP port on which the
https server must listen for connections. If the TCP port is not specified, the default is port 443.

The ssl and plaintext variants of the command function independently of each other. Enabling http+ssl
does not automatically prevent the device from accepting plaintext connections; you must explicitly disable
plaintext connections with the command [no] web-management plaintext.

Idle-timeout

Specifies the idle timeout for web management sessions. This ranges from 300 seconds to 7200 seconds.
The default value is 600 seconds.

Chapter 8 Managing interface access and System Information 119

Anexo 02 ITEM 10 (0592613)         SEI 0008478-63.2018.6.02.8000 / pg. 4967



The following example shows WebUI Idle timeout

switch(config)# web-management
idle-timeout Set the idle timeout for web management sessions.
management-url Specify URL for web interface [?] button.
plaintext Enable or disable the http server (insecure).
ssl Enable or disable the https server (secure).
support-url Specify URL for web interface support page.
switch(config)# web-management idle-timeout
<300-7200> Enter an integer number.

Enabling and disabling inbound WebAgent access
In the default configuration, inbound WebAgent (web browser) access, that is, inbound HTTP access, is enabled.

Enabling and disabling inbound WebAgent access

To enable inbound WebAgent access, do one of the following:

Prerequisites

Before you enable or disable inbound WebAgent access on a switch, you must insure that the switch has a
separate out-of-band management port if you want to use an out-of-band management port for WebAgent
access. See Appendix I, "Network Out-of-Band Management" in this guide for more information about out-of-band
management.

Procedure

1. Use the web-management command to enable inbound WebAgent access through the data ports.

2. Use the following command to enable inbound WebAgent access through specific ports:
web-management [ listen < oobm | data | both > ] Data ports (listen data option), out-of-band
management ports (listen oobm option), or both data and out-of-band management ports (listen both) can
be specified.

To disable inbound WebAgent access, do one of the following:

• Use the no web-management command to disable inbound WebAgent access through the data ports.

• Use the following command to disable inbound WebAgent access through specific ports:no web-
management [ listen < oobm | data | both > ]Data ports (listen data option), out-of-band
management ports (listen oobm option), or both data and out-of-band management ports (listen both) can
be specified.

Examples

To disable inbound WebAgent access:

switch(config)# no web-management
To re-enable inbound WebAgent access:

switch(config)# web-management

Reconfiguring the console/serial link settings
Use the following command to reconfigure the console/serial link settings:

console
[terminal <vt100|ansi|none>]
[screen-refresh <1|3|5|10|20|30|45|60]
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[baud-rate <speed-sense|1200|2400|4800|9600|19200|38400|57600|1155200>]
[flow-control <xon/xoff|none>]
[idle-timeout <0-7200>]
[events [<none]|all|not-info|critical|debug>]
[local-terminal <vt100|none|ansi>]
Considerations for setting idle-timeout, baud rate, and flow control settings:

• If the console idle-timeoutexpires, any outbound Telnet or SSH sessions open on the switch are terminated.

• If you change the baud rate or flow control settings, you must make the corresponding changes in your
console access device. Otherwise, you may lose connectivity between the switch and your terminal emulator
due to differences between terminal and switch settings for these two parameters.

All console parameter changes except events require that you save the configuration with write memory and
then execute boot before the new console configuration will take effect.

Switch models supporting redundant management, console settings, such as mode, flow-control, and baud-rate,
are the same on both management modules. There cannot be individual settings for each management module.

This example (Executing a series of console commands) shows how to configure the switch with the following:

• VT100 operation

• 19,200 baud

• No flow control

• 600 second (10 minutes) idle timeout

• Critical log events

switch(config)# console terminal vt100
This command will take effect after saving the
configuration and rebooting the system.

switch(config)# console baud-rate 19200
This command will take effect after saving the
configuration and rebooting the system.

switch(config)# console flow-control none
This command will take effect after saving the
configuration and rebooting the system.

switch(config)# console idle-timeout 600
switch(config)# console events critical
switch(config)# write memory
switch(config)# reload

Software version support of console/serial link settings
In software release versions K.15.12 and greater, the console inactivity-timer <minutes> command has been
deprecated and replaced by the console idle-timeout <seconds> command. As an example:

switch(config)#console inactivity-timer 2
is now equivalent to:

switch(config)#console idle-timeout 120
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In addition, the serial or USB console idle timeout can be controlled separately if needed. The console idle-
timeout serial-usb seconds command allows for this behavior. As an example:

switch(config)#console idle-timeout 120
switch(config)#console idle-timeout serial-usb 15
This sequence of commands will set the Telnet/SSH idle timeout to 120 seconds and the serial-usb idle timeout to
15 seconds. Another example:

switch(config)#console idle-timeout 120
switch(config)#console idle-timeout serial-usb 0
This sequence of commands will set the Telnet/SSH idle timeout to 120 seconds and the serial-usb idle timeout to
0, or, in other words, to never time out.

The console inactivity-timer minutes command will continue to be accepted in version, but it will be converted
to the new command format in the running configuration. This command conversion will also happen on a
software update to version if the console inactivity-timer minutes command was part of the previous
configuration.

These settings can be displayed using show console.

Interface-access parameters
The interface access in the switch operates properly by default. However, you can modify interface-access
parameters to suit your particular needs.

The following table lists the interface-access parameters that are modifiable and their default values. In most
cases, the default values are acceptable for standard operation.

Parameter Default value

Idle-Timeout 10 Minutes (disabled)

Inbound Telnet Access Enabled

Outbound Telnet Access n/a

WebAgent Access Enabled

Terminal type VT-100

Event Log event types to list (Displayed Events) All

Baud Rate Speed Sense

Flow Control XON/XOFF

Basic switch security is through passwords. You can gain additional security by using the security
features described in the Access Security Guide for your switch. You can also simply block
unauthorized access via the WebAgent or Telnet (as described in this section) and installing the
switch in a locked environment.

Terminal line width and length settings
For console/serial link and inbound telnet sessions, the switch output:
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• Uses whatever width is set by the terminal program. If width is not specified, 80 characters is the default.

• Automatically wraps on word boundaries (such as spaces) for non-columnar output

• Automatically wraps on column boundaries for columnar output

Hewlett Packard Enterprise recommends that you do not set your terminal width (terminal width <y>) above
150 columns. (Windows telnet displays up to 156 characters on 1280 pixelwide display, so 150 is comfortably
within this).

Window size negotiation for a telnet session
When a telnet connection is established with a switch, the switch always uses the default values of 80 columns by
24 lines for the window dimensions. The window can be resized by either dragging the corner of the window, or by
executing the terminal length <x> width <y> CLI command and then configuring the telnet client with
those dimensions. The new window dimensions are lost after that telnet session ends.

When the telnet connection is established with a switch, either the switch or the telnet client needs to initiate the
inquiry about the availability of NAWS. If NAWS is available, you can resize the window by dragging the corner of
the window to the desired size. The telnet software uses NAWS to tell the switch what the new window
dimensions are. If the switch supports the requested window dimensions, it uses them for all future interactions. If
the switch does not support those window dimensions, it refuses them and the telnet client requests an alternate
set of window dimensions. The negotiation continues until the telnet client and the switch agree on the window
dimensions.

The switch currently responds to a request from the remote telnet client to negotiate window size. However, some
telnet clients do not request to negotiate window size unless the switch’s telnet server suggests that NAWS is
available.

This feature allows window size negotiation to occur with telnet clients that support NAWS but do not try to use it
unless it is suggested by the switch’s telnet server. The switch’s telnet server will suggest to the telnet client that
NAWS is available.

Denying interface access
Use the kill [<session-number command to terminate a currently running remote session. Interface access
is denied when a remote session terminates.

The following example shows how to terminate a remote session using the kill command:

The switch supports up to five management sessions. The show ip ssh command lists the current management
sessions. If you are using the switch’s serial port for a console session and want to terminate an active Telnet
session, you would do the following:
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Viewing and setting system information

Viewing system information
Use the show system information command to list the current system information.

Examples

This example demonstrates the use of the show command to list the current system information.

switch# show system information

  Status and Counters - General System Information

   System Name        : switch
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   System Contact     :
   System Location    :

   MAC Age Time (sec) : 300

   Time Zone          : 0
   Daylight Time Rule : None

Setting system information
Do one of the following to set system information:

Procedure

1. Use the following command to set a plain-language identity for the switch, which helps to distinguish one
switch from another:
hostname <name-string> snmp-server [contact <system-contact>][location <system-
location>]
Each field allows up to 255 characters. To help simplify administration, it is recommended that you set
hostname to a character string that is meaningful within your system.

2. Use the mac-age-time <10-1000000>
command to set the MAC age time for learned MAC addresses. The default value is 300 seconds.

The MAC age time corresponds to the MAC Age Interval in the menu interface.

3. Use the following command to set the time zone and daylight-time rule:
time timezone <-720 - 840> time daylight-time-rule [ alaska | continental-us-and-
canada | middle-europe-and-portugal | southern-hemisphere | western-europe |
<user-defined> ]
The default daylight-time rule is none. For the time zone: east of the 0 meridian, the sign is "+"; west of the 0
meridian, the sign is "-". For example, the time zone setting for Berlin, Germany is +60 (zone + 1, or 60
minutes) and the time zone setting for Vancouver, Canada is –480 (zone – 8, or –480 minutes).

4. Use the time [<hh>:<mm>[:<ss>]][<mm>/<dd>/[<yy>]<yy>]command to set the time and
date.
The CLI uses a 24-hour clock scheme; that is, hour (hh) values from 1 p.m. to midnight are input as 13 - 24,
respectively.

Examples

Example

This example shows the use of the time command to set the switch to 9:45 a.m. on November 17, 2012:

switch(config)# time 9:45 11/17/12
This example shows the use of the time command to set the time zone and daylight time rule for Vancouver,
Canada:

switch(config)# time timezone -480 daylight-time-rule
continental-us-and-canada
This example shows the use of the mac-age-time command to set the age time to seven minutes:

switch(config)# mac-age-time 420
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This example shows the system information listing after executing the hostname command to name the switch
"Blue" with "Next-4474" as the system contact, and "North-Data-Room" as the location:

System parameters
The following table lists the system parameters that are modifiable and their default values. Configuration of
system information is optional, but recommended.

System parameter Default value

System Name switch product name

System Contact n/a

System Location n/a

300 seconds

Time Sync Method None

Time Zone 0

Daylight Time Rule None

Time January 1, 1990 at 00:00:00 at last power reset

MAC Age Time

Descriptions of the system parameters:

• System Name:

Using a unique name helps you to identify individual devices where you are using an SNMP network
management tool.

• System Contact and Location:
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This information is helpful for identifying the person administratively responsible for the switch and for
identifying the locations of individual switches.

• MAC Age Time:

The number of seconds a MAC address the switch has learned remains in the switch’s address table before
being aged out (deleted). Aging out occurs when there has been no traffic from the device belonging to that
MAC address for the configured interval.

• Time Sync Method:

Selects the method (TimeP or SNTP) the switch will use for time synchronization. For more on this topic, see
the "Time Protocols" chapter in the latest Management and Configuration Guide.

• Time Zone:

The number of minutes your time zone location is to the West (+) or East (-) of Coordinated Universal Time
(formerly GMT). The default 0 means that no time zone is configured. For example, the time zone for Berlin,
Germany is + 60 (minutes) and the time zone for Vancouver, Canada is - 480 (minutes).

• Daylight Time Rule:

Specifies the daylight savings time rule to apply for your location. The default is None. (For more on this topic,
See Appendix D, "Daylight Savings Time on switches.)

• Time:

Used in the CLI to specify the time of day, the date, and other system parameters.
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Using the menu or WebAgent to configure IP addressing

Using the Switch Setup screen to quickly setup IP addressing
If you just want to give the switch an IP address so that it can communicate on your network, or if you are not
using VLANs, Hewlett Packard Enterprise recommends that you use the Switch Setup screen to quickly configure
IP addressing.

To use the Switch Setup screen for quickly configuring IP addressing, do one of the following:

Procedure

1. Enter the setup command at the CLI Manager level prompt:

switch# setup
2. Select 8. Run Setup in the Main Menu of the menu interface.

For more on using the Switch Setup screen, See the Installation and Getting Started Guide you received with the
switch.

Using the menu to configure IP address, Gateway, and Time-To-Live (TTL)

Procedure

1. From the Main Menu, select:

  2. Switch Configuration...

      5. IP Configuration

          
2. If multiple VLANs are configured, a screen showing all VLANs appears. The Menu interface displays the IP

address for any VLAN. If you use the CLI to configure the IP address on a VLAN, use the CLI show ip
command to list them.

3. Press [E] (for Edit).

4. If the switch needs to access a router, for example, to reach off-subnet destinations, select the Default
Gateway field and enter the IP address of the gateway router.

5. If you need to change the packet Time-To-Live (TTL) setting, select Default TTL and type in a value between 2
and 255.

6. To configure IP addressing, select IP Config and do one of the following:

a. If you want to have the switch retrieve its IP configuration from a DHCP or Bootp server, at the

Chapter 9
Configuring IP Addressing
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IP Config

field, keep the value as

DHCP/ Bootp

and go to step 8.

b. If you want to manually configure the IP information, use the Space bar to select
Manual

and use the

[Tab]

key to move to the other IP configuration fields.

7. Select the IP Address field and enter the IP address for the switch.

8. Select the Subnet Mask field and enter the subnet mask for the IP address.

9. Press [Enter], then [S](for Save).

Using the WebAgent to configure IP addressing
Using the WebAgent to configure IP addressing

To configure IP addressing on the switch:

Prerequisites

Before you use the WebAgent to configure IP addressing, you must insure the switch has an IP address that is
reachable through your network.

Procedure

1. In the navigation pane, click Home.

2. Click Quick Setup.

3. In the Switch Quick Setup Parameters box, click Change.

4. Enter the IP address and any other information such as the Subnet mask and Gateway.

5. Click Save to save your changes.

6. If you need further information on using the WebAgent, click [?] to access the web-based help available for the
switch.

Using the CLI to configure IP Addressing, Gateway, and
Time-To-Live (TTL)

Viewing the current IP configuration
Do one of the following:

• Use the show ip command to view the IP addressing for each VLAN that is configured in the switch.
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If only the DEFAULT_VLAN exists, then its IP configuration applies to all ports in the switch. Where multiple
VLANs are configured, the IP addressing is listed per VLAN. The display includes switch-wide packet time-to-
live, and (if configured) the switch’s default gateway and Timep configuration.

• Use the show management
command to view the IP addressing and time server IP addressing that is configured on the switch.

Examples

The following example shows the switch's default IP addressing. In the factory default configuration (no IP
addressing assigned), the switch’s IP addressing appears as:

switch(config)# show ip

 Internet (IP) Service

   IP Routing : Disabled

   Default Gateway :
   Default TTL     : 64
   Arp Age         : 20
   Domain Suffix   :
   DNS server      :

                      |                                           Proxy ARP
VLAN                  | IP Config  IP Address      Subnet Mask    Std Local
--------------------- + ---------- --------------- -------------- ----------
DEFAULT_VLAN          | DHCP/Bootp
With multiple VLANs and some other features configured, show ip provides additional information. The following
example shows IP listing with non-default IP addressing configured

switch(config)# show ip

 Internet (IP) Service

   IP Routing : Disabled

   Default Gateway : 10.20.227.1
   Default TTL     : 64
   Arp Age         : 20
   Domain Suffix   :
   DNS server      :

                      |                                           Proxy ARP
VLAN                  | IP Config  IP Address      Subnet Mask    Std Local
--------------------- + ---------- --------------- -------------- ----------
DEFAULT_VLAN          | Manual     10.28.227.101   255.255.248.0   No   No
VLAN22                | Disabled

Configuring an IP address and subnet mask on a VLAN
Use one of the following forms of the vlan command to configure an IP address and subnet mask:
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• vlan <vlan-id> ip address <ip-address>/<mask-length>
• vlan <vlan-id> ip address <ip-address> <mask-bits>
• vlan <vlan-id> ip address <dhcp-bootp>

You must either include the ID of the VLAN for which you are configuring IP addressing or go to the context
configuration level for that VLAN. (If you are not using VLANs on the switch—that is, if the only VLAN is the
default VLAN—then the VLAN ID is always "1".)

The default IP address setting for the DEFAULT_VLAN is DHCP/Bootp. On additional VLANs you create, the
default IP address setting is disabled.

Examples

The following example configures IP addressing on the default VLAN with the subnet mask specified in mask bits.

switch(config)# vlan 1 ip address 10.28.227.103 255.255.255.0
The following example configures the same IP addressing as the preceding example, but specifies the subnet
mask by mask length.

switch(config)# vlan 1 ip address 10.28.227.103/24

Removing an IP address that is configured on a VLAN
Use one of the following forms of the vlan command to delete an IP address that is configured on a VLAN:

Procedure

1. no vlan <vlan-id> ip address <ip-address>/<mask-length>
2. no vlan <vlan-id> ip address <ip-address> <mask-bits>

Examples

The following example deletes an IP address configured on VLAN 1.

switch (config) no vlan 1 ip address 10.28.227.103/24

Multiple IP addresses configuration on a VLAN (multinetting)
Use one of the following forms of the vlan command to configure multiple IP addresses on a VLAN (multinetting).

• vlan <vlan-id> ip address <ip-address>/<mask-length>
• vlan <vlan-id> ip address <ip-address> <mask-bits>

The following is supported:

• Up to 2000 IP addresses for the switch.

• Up to 32 IP addresses for the same VLAN

• Up to 512 IP VLANs, that is, VLANs on which you can configure IP addresses

• Each IP address on a VLAN must be for a separate subnet, whether on the same VLAN or different VLANs.

The Internet (IP) Service screen in the Menu interface displays the first IP address for each VLAN. You must use
the CLI show ip command to display the full IP address listing for multinetted VLANs.
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Configuring and displaying multi netted VLAN

If you wanted to multinet VLAN_20 (VID = 20) with the IP addresses shown below, you would perform steps
similar to the following. For this example, assume that the first IP address is already configured.

IP Address VID IP Address Subnet Mask

1st address 20 10.25.33.101 255.255.240.0

2nd address 20 10.26.33.101 255.255.240.0

3rd address 20 10.27.33.101 255.255.240.0

switch(config)# vlan 20
switch(vlan-20)# ip address 10.26.33.101/20
switch(vlan-20)# ip address 10.27.33.101/20

switch(config)# show ip

 Internet (IP) Service

   IP Routing      : Disabled

   Default Gateway : 10.20.227.1
   Default TTL     : 64
   Arp Age         : 20
   Domain Suffix   : 
   DNS server      :

                       |                                           Proxy ARP
   VLAN                | IP Config  IP Address      Subnet Mask    Std Local
   ------------------- + ---------- --------------- -------------- ----------
   DEFAULT_VLAN        | Manual     10.20.30.100   255.255.240.0   No   No
   VLAN_20             | Manual     10.25.33.101   255.255.240.0   No   No
                       | Manual     10.26.33.101   255.255.240.0   No   No
                       | Manual     10.27.33.101   255.255.240.0   No   No

Multinetting on the default VLAN

To multinet the default VLAN, you would do the following:

switch(vlan-20)# vlan 1
switch(vlan-1)# ip address 10.21.30.100/20

switch(config)# show ip

 Internet (IP) Service

   IP Routing      : Disabled

   Default Gateway : 10.20.227.1
   Default TTL     : 64
   Arp Age         : 20
   Domain Suffix   : 
   DNS server      :
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                       |                                           Proxy ARP
   VLAN                | IP Config  IP Address      Subnet Mask    Std Local
   ------------------- + ---------- --------------- -------------- ----------
   DEFAULT_VLAN        | Manual     10.20.30.100   255.255.240.0   No   No
                       | Manual     10.21.30.100   255.255.240.0   No   No
   VLAN_20             | Manual     10.25.33.101   255.255.240.0   No   No
                       | Manual     10.26.33.101   255.255.240.0   No   No
                       | Manual     10.27.33.101   255.255.240.0   No   No

Removing IP addresses from a multinetted VLAN
Use one of the following forms of the vlan command to delete an IP address that is configured on a multinetted
VLAN:

Procedure

1. no vlan <vlan-id> ip address <ip-address>/<mask-length>
2. no vlan <vlan-id> ip address <ip-address> <mask-bits>

Configuring the optional default gateway

Prerequisites

Before you use the CLI to configure the optional default gateway, you must be at the global configuration level.

One default gateway can be manually assigned to the switch. The switch does not allow IP addressing received
from a DHCP or Bootp server to replace a manually configured default gateway.

Configuring the optional default gateway

Use the ip default-gateway <ip-address> command to configure the optional default gateway:

Examples

The following example shows the configuration of the default gateway with the IP address 10.28.227.115.

switch(config)# ip default-gateway 10.28.227.115

Setting the Time-To-Live (TTL)

Prerequisites

Before you use the CLI to set the TTL, you must be at the global configuration level.

The Time-To-Live (TTL) is the maximum number of routers (hops) through which a packet can pass before being
discarded. Each router decreases a packet’s TTL by 1 before forwarding the packet. If a router decreases the TTL
to 0, the router drops the packet instead of forwarding it.

Setting the TTL

Use the ip ttl <number-of-hops> command to set the TTL. The default value for the TTL is 64 and the
range is 2 - 255.

Examples

The following example sets the TTL to 60.

switch(config)# ip ttl 60

Managing loopback interfaces
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Adding a loopback interface

This task is not support by Switch 2530 (J9772A–J9783A) products.

Adding a loopback interface

To add a loopback interface on the switch:

Prerequisites

Before you use the CLI to add a loopback interface, you must be at the global configuration level.

Procedure

1. Use the interface loopback <number> command to create the loopback interface. The number
argument is a value from 1 to 7.

2. Use the ip address <ip address> command to configure an IP address for the loopback interface.

3. You can configure up to 32 IP addresses on a loopback interface. You do not need to specify a network mask.
A loopback interface uses the default subnet mask 255.255.255.255.

Examples

Figure 50: A loopback interface configured with one IP address

switch(config)# interface loopback 1
switch(config)# ip address 10.1.1.1
Figure 51: Loopback interfaces configured with multiple IP addresses

This example shows the addition of two loopback interfaces, each with two IP addresses configured.

switch(config)# interface loopback 0
switch(lo0)# ip address 172.16.101.8
switch(lo0)# ip address 172.16.101.9
switch(lo0)# exit
switch(config)# interface loopback 1
switch(lol)# ip address 172.16.102.1
switch(lol)# ip address 172.16.102.2

Removing a loopback interface

Prerequisites

Before you use the CLI to remove a loopback interface, you must be at the global configuration level.

This task is not support by Switch 2530 (J9772A–J9783A) products.

Removing a loopback interface

Use the no interface loopback <number> command to remove a loopback interface. The number
argument is a value from 1 to 7, specifying the loopback interface to be removed.
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You cannot remove the default loopback interface (number 0) with IP address 127.0.0.1.

Displaying loopback interface configurations
Do one of the following:

• Use the show ip command to display a list of the loopback interfaces, which are sorted according to the
loopback number.

The list of loopback interfaces is displayed below other IP configuration parameters, such as packet TTL and
ARP age-out values, and VLAN IP configurations. The default loopback interface (

• Use the show ip route command to display the loopback interfaces in a list of IP routing entries. The list is
sorted according to the destination IP address.

Examples

The following example displays the IP addresses configured for two user-defined loopback interfaces(lo1 and
lo2).

switch# show ip

 IP Routing : Enabled

   Default Gateway : 15.255.128.1
   Default TTL     : 64
   Arp Age         : 20
   Domain Suffix   :
   DNS server      : 

                    |                                           Proxy ARP
   VLAN             | IP Config  IP Address      Subnet Mask    Std Local
   ---------------- + ---------- --------------- -------------- ----------
   DEFAULT_VLAN     | Manual     10.0.8.121     255.255.0.0     No   No
   VLAN2              Manual     192.168.12.1   255.255.255.0   No   No
   VLAN3              Disabled

                           Loopback Addresses
   Loopback   IP Config    IP Address           Subnet Mask
   --------   ----------   ------------------   ---------------
   lol        Manual       172.16.110.2         255.255.255.255 
   lo2        Manual       172.16.112.2         255.255.255.255 
   lo2        Manual       172.16.114.1         255.255.255.255
The following example displays the configuration of the default loopback interface (lo0) and one user-defined
loopback interface (lo2).

switch# show ip route

                                IP Route Entries

Destination        Gateway         VLAN Type      Sub-Type   Metric    Dist.
------------------ --------------- ---- --------- ---------- --------- ----
10.0.0.0/16        DEFAULT_VLAN    1    connected             1         0
127.0.0.0/8        reject               static                0         0
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127.0.0.1/32       lo0                  connected             1         0
172.16.10.121/32   lo2                  static                1         0
172.16.100.0/24    10.0.8.11       1    ospf       IntraArea  1         1
172.16.102.0/24    VLAN2           2    connected             1         0

Summary of loopback interface configuration
Summary of loopback interface configuration:

• You can configure a loopback interface only from the CLI; you cannot configure a loopback interface from the
WebAgent or Menu interface.

• Loopback interfaces share the same IP address space with VLAN configurations. The maximum number of IP
addresses supported on a switch is 2048, which includes all IP addresses configured for both VLANs and
loopback interfaces (except for the default loopback IP address 127.0.0.1).

• Each IP address that you configure on a loopback interface must be unique in the switch. This means that the
address cannot be used by a VLAN interface or another loopback interface.

• For example, if you configure a VLAN with IP address 172.16.100.8/24, you cannot configure a loopback
interface with IP address 172.16.100.8. In the same way, if you configure a loopback interface (lo1) with IP
address 172.16.101.8, you cannot configure another loopback interface (lo2) with IP address 172.16.101.8.

• You can configure multiple IP addresses on a loopback interface (lo0 to lo7). Up to 32 IP addresses are
supported on a loopback interface.

Overview of loopback interfaces
By default, each switch has an internal loopback interface (lo0) with the IP address 127.0.0.1. This IP address is
used only for internal traffic transmitted within the switch and is not used in packet headers in egress traffic sent to
network devices.

You can configure up to seven other loopback interfaces (lo1, lo2, lo3, and so on) on the switch to use to
transmit network across the network. Each loopback interface can have multiple IP addresses. Routing protocols,
such as RIP and OSPF, advertise the configured loopback addresses throughout a network or autonomous
system.

User-defined loopback addresses provide the following benefits:

• A loopback interface is a virtual interface that is always up and reachable as long as at least one of the IP
interfaces on the switch is operational. As a result, a loopback interface is useful for debugging tasks since its
IP address can always be pinged if any other switch interface is up.

• You can use a loopback interface to establish a Telnet session, ping the switch, and access the switch through
SNMP, SSH, and HTTP (WebAgent).

• A loopback IP address can be used by routing protocols. For example, you can configure the loopback IP
address as the router ID used to identify the switch in an OSPF area. Because the loopback interface is
always up, you ensure that the switch's router ID remains constant and that the OSPF network is protected
from changes caused by downed interfaces.

OSPF does not require that you use an IP address as the router ID. OSPF only requires the router ID to be a
unique value within the autonomous system (AS). However, if you configure the loopback IP address as the router
ID, OSPF can reach the switch if any switch interface is up. (Normally, OSPF automatically configures the router
ID with the IP address of a switch interface. The disadvantage is that if the interface goes down, OSPF can no
longer ping the switch using the router ID even if other interfaces are operational.)

For more information about how to configure a loopback IP address to participate in an OSPF broadcast area,
see the titled "(Optional) Assigning Loopback Addresses to an Area" in the Multicast and Routing Guide.
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Retaining VLAN-1 IP addressing across configuration file
downloads

Enabling IP preserve to retain VLAN-1 IP addressing

Procedure

1. IP Preserve retains VLAN-1 IP addressing across configuration file downloads.

2. To set up IP Preserve, insert the “ip preserve“ at the end of a configuration file, as shown in the following
example. Note that you do not execute IP Preserve by entering a command in the CLI.

; J9091A Configuration Editor; Created on release #K.15.14.0001
hostname "switch"
time daylight-time-rule None
.
.
.
password manager
password operator
ip preserve

Operating rules for IP preserve
When ip preserve is entered as the last line in a configuration file stored on a TFTP server:

• If the switch’s current IP address for VLAN 1 was not configured by DHCP/ Bootp, IP Preserve retains the
switch’s current IP address, subnet mask, and IP gateway address when the switch downloads the file and
reboots. The switch adopts all other configuration parameters in the configuration file into the startup-config
file.

• If the switch’s current IP addressing for VLAN 1 is from a DHCP server, IP Preserve is suspended. In this
case, whatever IP addressing the configuration file specifies is implemented when the switch downloads the
file and reboots. If the file includes DHCP/Bootp as the IP addressing source for VLAN 1, the switch will
configure itself accordingly and use DHCP/ Bootp. If instead, the file includes a dedicated IP address and
subnet mask for VLAN 1 and a specific gateway IP address, then the switch will implement these settings in
the startup-config file.

• The ip preserve statement does not appear in show config listings. To verify IP Preserve in a
configuration file, open the file in a text editor and view the last line.

Overview of IP preserve
For the switches covered in this guide, IP Preserve enables you to copy a configuration file to multiple switches
while retaining the individual IP address and subnet mask on VLAN 1 in each switch, and the Gateway IP address
assigned to the switch. This enables you to distribute the same configuration file to multiple switches without
overwriting their individual IP addresses.

To summarize the IP Preserve effect on IP addressing:
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• If the switch received its most recent VLAN 1 IP addressing from a DHCP/ Bootp server, it ignores the ip
preserve command when it downloads the configuration file, and implements whatever IP addressing
instructions are in the configuration file.

• If the switch did not receive its most recent VLAN 1 IP addressing from a DHCP/Bootp server, it retains its
current IP addressing when it downloads the configuration file.

• The content of the downloaded configuration file determines the IP addresses and subnet masks for other
VLANs.

The following examples demonstrate the operation of IP Preserve:

Figure 52: Example of IP Preserve operation with multiple series switches

If you apply the following configuration file to the scenario that is shown in Figure 52: Example of IP Preserve
operation with multiple series switches on page 138, switches 1 - 3 will retain their manually assigned IP
addressing and switch 4 will be configured to acquire its IP addressing from a DHCP server.

Configuration file in TFTP server with DHCP/Bootp specified as the IP addressing source

switch(config)# show run

Running configuration:

; J9091A Configuration Editor; Created on release #K.15.10.0001

hostname "switch"
module 1 type J8702A
module 2 type J8705A
trunk A11-A12 Trk1 Trunk
ip default-gateway 10.10.10.115
snmp-server community "public" Unrestricted
vlan 1
   name "DEFAULT_VLAN"
   untagged A1-A10,A13-A24,B1-B24,Trk1
   ip address dhcp-bootp
   exit
spanning-tree Trk1 priority 4
password manager
password operator
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If you apply the following configuration file to the scenario that is shown in Figure 52: Example of IP Preserve
operation with multiple series switches on page 138, switches 1 - 3 will still retain their manually assigned IP
addressing. However, switch 4 will be configured with the IP addressing included in the file.

Configuration file in TFTP server with dedicated IP addressing, instead of DHCP/Bootp

switch# show run

Running configuration:

; J9091A Configuration Editor; Created on release #K.15.10.0001

hostname "switch"
module 1 type J8702A
module 2 type J8705A
trunk A11-A12 Trk1 Trunk
ip default-gateway 10.10.10.115
snmp-server community "public" Unrestricted
vlan 1
   name "DEFAULT_VLAN"
   untagged A1,A7-A10,A13-A24,B1-B24,Trk1
   ip address 10.12.17.175 255.255.255.0
   tagged A4-A6
   no untagged A2-A3
   exit
vlan 2
   name "VLAN2"
   untagged A2-A3
   no ip address
   exit
spanning-tree Trk1 priority 4
password manager
password operator

Configuring a single source IP address for software
applications

Specifying the source IP address
Only one source IP address can be specified for each software application.

Do one of the following:

• Use the following command to specify the source IP address for the specified software application.

ip source-interface
< radius | sflow | sntp | syslog | tacacs | telnet | tftp >
< loopback <id> | vlan <vlan-id> | address <ip-address> >

• Use the following command to specify the source IP address for all software applications.

ip source-interface all
< loopback <id> | vlan <vlan-id> | address <ip-address> >

• loopback <id> :

Specifies that the IP address of the loopback interface is used as the source IP address in outgoing packets. If
the loopback interface has no IP address, then the application reverts to the default behavior. If more than one
IP address is configured, then the lowest IP address is used.
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• vlan <vlan-id> :

Specifies that the IP address of the indicated VLAN interface is used as the source IP address of outgoing
packets. If the specified VLAN interface has no IP address configured, or is down, then the application reverts
to the default behavior. If more than one IP address is configured, then the lowest IP address is used.

• address <ip-address> :

Specifies the IP address that should be used as the source IP address of outgoing packets. The IP address
must be a valid IP address configured on one of the switch’s VLAN or loopback interfaces. If the interface is
down, then the application reverts to the default behavior.

Canceling the source IP address assignment
When the source IP address assignment for a software application is canceled, the application reverts to its
default behavior and the system determines the source IP address of outgoing application-specific IP packets at
packet transmission time.

Do one of the following:

• Use the following command to cancel the source IP address assignment for the specified software application.

no ip source-interface 
< radius | sflow | sntp | syslog | tacacs | telnet | tftp >

• Use the following command to cancel the source IP address assignment for all software applications.

no ip source-interface all

Viewing source IP address configurations
Do one of the following:

• Use the following command to view the source IP address configuration for the specified protocol.

show ip source-interface
[ radius | sflow | sntp | tacacs | telnet | tftp | syslog ]

• Use the following command to view the source IP address configuration for all protocols.

show ip source-interface

Examples

The following example shows a specific IP address assigned for the RADIUS application protocol

switch(config)# ip source-interface radius address 10.10.10.2

switch(config)# show ip source-interface radius

  Source-IP Configuration Information

  Protocol | Admin Selection Policy  IP Interface   IP Address
  -------- + ----------------------- -------------- --------------
  Radius   | Configured IP Address   vlan 3         10.10.10.2 
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The following example shows a VLAN interface assigned as the source IP address for the TACACS application
protocol

switch(config)# ip source-interface tacacs vlan 22

switch(config)# show ip source-interface tacacs

  Source-IP Configuration Information

   Protocol | Admin Selection Policy  IP Interface   IP Address
   -------- + ----------------------- -------------- --------------
   Tacacs   | Configured IP Interface vlan 22        10.10.10.4 
The following example shows Source IP address configurations for all application protocols

switch(config)# show ip source-interface

 Source-IP Configuration Information

  Protocol | Admin Selection Policy  IP Interface  IP Address
  -------- + ----------------------- ------------- ---------------
  Tacacs   | Configured IP Interface vlan 22
  Radius   | Configured IP Address                 10.10.10.2
  Syslog   | Configured IP Interface vlan 10
  Telnet   | Outgoing Interface
  Tftp     | Outgoing Interface
  Sntp     | Outgoing Interface
  Sflow    | Outgoing Interface

Viewing source IP selection policy status
Do one of the following:

• Use the following command to view the source IP selection policy status for the specified protocol.

show ip source-interface status
[ radius | sflow | sntp | tacacs | telnet | tftp | syslog ]

• Use the following command to view the source IP selection policy status for all protocols.

show ip source-interface status

The following example shows Source IP selection policy status for all application protocols

switch(config)# show ip source-interface status

 Source-IP Status Information

  Protocol | Admin Selection Policy  Oper Selection Policy
  -------- + ----------------------- ----------------------
  Tacacs   | Configured IP Interface Configured IP Interface
  Radius   | Configured IP Address   Configured IP Address
  Syslog   | Configured IP Interface Outgoing Interface
  Telnet   | Outgoing Interface      Outgoing Interface
  Tftp     | Outgoing Interface      Outgoing Interface
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  Sntp     | Outgoing Interface      Outgoing Interface
  Sflow    | Configured IP Address   Configured IP Address

Viewing full source IP details
The full source IP details for an application protocol include the source IP selection policy status, the source IP
address configuration, and the state of the source IP interface.

Do one of the following:

• Use the following command to view the full source IP details for the specified protocol.

show ip source-interface detail
[ radius | sflow | sntp | tacacs | telnet | tftp | syslog ]

• Use the following command to view the full source IP details for all protocols.

show ip source-interface detail

Examples

The following example shows detailed information displayed for the Tacacs application protocol.

switch(config)# show ip source-interface detail tacacs

 Source-IP Detailed Information

  Protocol : Tacacs
  Admin Policy           : Configured IP Interface
  Oper Policy            : Outgoing Interface
  Source IP Interface    : Vlan 22
  Source IP Address      : 10.10.10.4
  Source Interface State : Down
The following example shows detailed information displayed for each application protocol.

switch(config)# show ip source-interface detail

  Source-IP Detailed Information

   Protocol : Tacacs
   Admin Policy           : Configured IP Interface
   Oper Policy            : Configured IP Interface
   Source IP Interface    : vlan 22
   Source IP Address      : 10.10.10.4
   Source Interface State : Up

   Protocol : Radius
   Admin Policy           : Configured IP Address
   Oper Policy            : Configured IP Address
   Source IP Interface    : vlan 3
   Source IP Address      : 10.10.10.2
   Source Interface State : Up

   Protocol : Syslog
   Admin Policy           : Configured IP Interface
   Oper Policy            : Configured IP Interface
   Source IP Interface    : vlan 10
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   Source IP Address      : 10.10.10.10
   Source Interface State : Up

   Protocol : Telnet
   Admin Policy           : Configured IP Interface
   Oper Policy            : Configured IP Interface
   Source IP Interface    : loopback 1
   Source IP Address      : 10.10.10.11
   Source Interface State : Up

   Protocol : Tftp
   Admin Policy           : Outgoing Interface
   Oper Policy            : Outgoing Interface
   Source IP Interface    : N/A
   Source IP Address      : N/A
   Source Interface State : N/A

   Protocol : Sntp
   Admin Policy           : Outgoing Interface
   Oper Policy            : Outgoing Interface
   Source IP Interface    : N/A
   Source IP Address      : N/A
   Source Interface State : N/A

   Protocl : Sflow
   Admin Policy           : Outgoing Interface
   Oper Policy            : Outgoing Interface
   Source IP Interface    : N/A
   Source IP Address      : N/A
   Source Interface State : N/A

Viewing protocol configuration and status information
Use the following command to view configuration and status information for the specified application protocol. The
displayed information includes the operational source IP selection policy.

show [ radius | sflow | sntp | tacacs | telnet | tftp | syslog ]
Examples

The following example shows the details for the Radius application protocol

switch(config)# show radius

Status and Counters - General RADIUS Information

  Deadtime(min) : 0
  Timeout(secs) : 5
  Retransmit Attempts : 3
  Global Encryption Key :
  Dynamic Authorization UDP Port : 3799
  Source IP Selection : Configured IP address
The following example shows the details for the Telnet application protocol

switch(config)# show telnet

  Telnet Activity
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  Source IP Selection: 10.10.10.11

  -------------------------------------------------------
  Session  : **  1
  Privilege: Manager
  From     : Console
  To       : 
The following example shows details for the SNTP application protocol

switch(config)# show sntp

SNTP Configuration

SNTP Authentication : Disabled
Time Sync Mode: Timep
SNTP Mode : disabled
Poll Interval (sec) [720] : 720
Source IP Selection: Outgoing Interface

Configuration error messages
The following error messages may appear when configuring source IP selection if the interface does not exist, is
not configured for IP, or is down.

Error Message Description

Warning: Specified IP address is not configured
on any interface

The IP address specified has not been assigned to any
interface on the switch.

Warning: Specified IP interface is not configured The IP interface has not been configured.

Warning: Specified IP interface is not configured
for IP

An IP address has not been assigned to this interface.

Warning: Specified IP interface is down The interface on the switch associated with this IP address is
down.

Warning: Specified IP interface is configured for
DHCP

The IP address has not been configured specifically
(manually) for this interface and may change.

Overview of single source IP addresses for software applications
A single source IP address can be configured for the following software applications:

• RADIUS

• SFlow

• SNTP

• System Logging applications

• TACACS

• Telnet

• TFTP
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The above IP-based software applications use a client-server communication model, that is, the client’s source IP
address is used for unique client identification. The source IP address is determined by the system and is usually
the IP address of the outgoing interface in the routing table. However, routing switches may have multiple routing
interfaces due to load balancing or routing redundancy, and outgoing packets can potentially be sent by different
paths at different times. This results in different source IP addresses, which creates a client identification problem
on the server site. For example, there is no way to designate a fixed IP address for outgoing packets for RADIUS
or TACACS, so it is necessary to configure in the RADIUS or TACACS database all possible IP addresses that
are configured on the switch as valid clients. When using system logging, it can be difficult to interpret the logging
and accounting data on the server site as the same client can be logged with different IP addresses.

To decrease the amount of administrative work involved, a configuration model is provided that allows the
selection of an IP address to use as the source address for all outgoing traffic generated by a specified software
application on the switch. This allows unique identification of the software application on the server site regardless
of which local interface has been used to reach the destination server.

The source IP selection policy
The source IP address selection for the application protocols is defined through assignment of one of the
following policies:

• Outgoing Interface—the IP address of the outgoing IP interface is used as the source IP address. This is the
default policy and the default behavior of applications.

• Configured IP Address—the specific IP address that is used as the source IP address. This address is
configured on one of the switch’s IP interfaces, either a VLAN interface or a Loopback interface.

• Configured IP Interface—the IP address from the specific IP interface (VLAN or Loopback) is used as the
source IP address. If there are multiple IP addresses assigned (multinetting, for example), the lowest IP
address is used.

If the selection policy cannot be executed because the interface does not have an IP address configured, does
not exist, or is down, the application protocol uses the default Outgoing Interface policy. A warning message is
displayed, but the configuration changes are accepted. When using the show ip source-interface status
command to display information about the source IP address selection policy, the administratively-assigned
source IP selection policy and the actual (operational) source IP selection policy in effect are displayed.

The operational source IP selection policy may be different from the assigned source selection policy if the IP
interface does not exist or is down. In this case, the default of Outgoing Interface appears as the operational
policy, as shown in the following example.

The administratively-assigned source IP selection policy differing from the operational policy

switch(config)# show ip source-interface detail tacacs

 Source-IP Detailed Information

  Protocol : Tacacs
  Admin Policy           : Configured IP Interface
  Oper Policy            : Outgoing Interface
  Source IP Interface    : Vlan 22
  Source IP Address      : 10.10.10.4
  Source Interface State : Down
Below is an example of assigning a specific source IP address for a RADIUS application. The administrative
policy is Configured IP Address.
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A specific IP address assigned for the RADIUS application protocol

switch(config)# ip source-interface radius address 10.10.10.2

switch(config)# show ip source-interface radius

  Source-IP Configuration Information

  Protocol | Admin Selection Policy  IP Interface   IP Address
  -------- + ----------------------- -------------- --------------
  Radius   | Configured IP Address   vlan 3         10.10.10.2 
In the example below, a VLAN interface (VLAN 22) is specified as the source IP address for TACACS. The
administrative policy is Configured IP Interface.

Using a VLAN interface as the source IP address for TACACS

switch(config)# ip source-interface tacacs vlan 22

switch(config)# show ip source-interface tacacs

  Source-IP Configuration Information

   Protocol | Admin Selection Policy  IP Interface   IP Address
   -------- + ----------------------- -------------- --------------
   Tacacs   | Configured IP Interface vlan 22        10.10.10.4 
The next example shows a VLAN interface being specified as the source IP address for logging. The
administrative policy is Configured IP Interface.

Using a VLAN interface as the source IP Address for logging (Syslog)

switch(config)# ip source-interface syslog vlan 10

switch(config)# show ip source-interface syslog

  Source-IP Configuration Information

   Protocol | Admin Selection Policy  IP Interface   IP Address
   -------- + ----------------------- -------------- --------------
   Syslog   | Configured IP Interface vlan 10        10.10.10.10

IP configuration features
IP configuration features:

Feature Default

IP Address and Subnet Mask DHCP/Bootp

Multiple IP Addresses on a VLAN n/a

Default Gateway Address none

Packet Time-To-Live (TTL) 64 seconds

Table Continued
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Feature Default

Time Server (Timep)1 DHCP

Single Source IP Addressing outgoing IP address

1 For more on this topic, see the "Time Protocols" chapter in the latest Management and Configuration Guide.

IP address and subnet mask. Configuring the switch with an IP address expands your ability to manage the
switch and use its features. By default, the switch is configured to automatically receive IP addressing on the
default VLAN from a DHCP/Bootp server that has been configured correctly with information to support the
switch. (See DHCP/Bootp operation on page 150 for information on setting up automatic configuration from a
server.) However, if you are not using a DHCP/Bootp server to configure IP addressing, use the menu interface or
the CLI to manually configure the initial IP values. After you have network access to a device, you can use the
WebAgent to modify the initial IP configuration if needed.

For information on how IP addressing affects switch operation, See Effects of IP addressing on switch
operation on page 147.

Multinetting: assigning multiple IP addresses to a VLAN. For a given VLAN you can assign up to 32 IP
addresses. This allows you to combine two or more subnets on the same VLAN, which enables devices in the
combined subnets to communicate normally through the network without needing to reconfigure the IP addressing
in any of the combined subnets.

Default gateway operation. The default gateway is required when a router is needed for tasks such as reaching
off-subnet destinations or forwarding traffic across multiple VLANs. The gateway value is the IP address of the
next-hop gateway node for the switch, which is used if the requested destination address is not on a local subnet/
VLAN. If the switch does not have a manually-configured default gateway and DHCP/Bootp is configured on the
primary VLAN, then the default gateway value provided by the DHCP or Bootp server will be used. If the switch
has a manually configured default gateway, then the switch uses his gateway, even if a different gateway is
received via DHCP or Bootp on the primary VLAN. This is also true for manually configured TimeP, SNTP, and
Time-To-Live(TTL). (In the default configuration, VLAN 1 is the Primary VLAN.)

For more information on Primary VLANs, see the Advanced Traffic Management Guide.

For more information on TimeP and SNTP, see the “Time Protocols” chapter in the Management and
Configuration Guide.

Packet Time-To-Live (TTL). This parameter specifies the maximum number of routers (hops) through which a
packet can pass before being discarded. Each router decreases a packet’s TTL by 1 before forwarding the
packet. If decreasing the TTL causes the TTL to be 0, the router drops the packet instead of forwarding it. In most
cases, the default setting (64) is adequate.

Effects of IP addressing on switch operation
Without an IP address and subnet mask compatible with your network, the switch can be managed only through a
direct terminal device connection to the Console RS-232 port. You can use direct-connect console access to take
advantage of features that do not depend on IP addressing. However, to realize the full capabilities HPE proactive
networking offers through the switch, configure the switch with an IP address and subnet mask compatible with
your network. The following table lists the general features available with and without a network-compatible IP
address configured.
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Table 9: Features available with and without IP addressing on the switch

Features available without an IP Address Additional features available with an IP Address
and subnet mask

• Direct-connect access to the CLI and the menu
interface

• DHCP or Bootp support for automatic IP address
configuration, and DHCP support for automatic
Timep server IP address configuration

• Multiple Spanning Tree Protocol

• Port settings and port trunking

• Switch meshing

• Console-based status and counters information for
monitoring switch operation and diagnosing
problems through the CLI or menu interface

• VLANs and GVRP

• Serial downloads of software updates and
configuration files (Xmodem)

• Link test

• Port monitoring

• Password authentication

• Quality of Service (QoS)

• Authorized IP manager security

• WebAgent access, with configuration, security, and
diagnostic tools, plus the Alert Log for discovering
problems detected in the switch along with
suggested solutions

• SNMP network management access for network
configuration, monitoring, problem-finding, and
reporting, analysis, and recommendations for
changes to increase control and uptime

• TACACS+, RADIUS, SSH, SSL, and 802.1X
authentication

• Multinetting on VLANs

• Telnet access to the CLI or the menu interface

• IGMP

• TimeP and SNTP server configuration1

• TFTP download of configurations and software
updates

• Access Control Lists (ACLs)

• IP routing, Multicast Routing

• VRRP router redundancy

• PIM-DM and PIM-SM

• Radius

• Ping test

1 For more information on TimeP and SNTP, see the “Time Protocols” chapter in the Management and Configuration Guide.

Network preparations for configuring DHCP/Bootp
In its default configuration, the switch is configured for DHCP/Bootp operation. However, the DHCP/Bootp feature
will not acquire IP addressing for the switch unless the following tasks have already been completed:

• For Bootp operation

◦ A Bootp database record has already been entered into an appropriate Bootp server

◦ The necessary network connections are in place

◦ The Bootp server is accessible from the switch

• For DHCP operation
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◦ A DHCP scope has been configured on the appropriate DHCP server

◦ The necessary network connections are in place

◦ A DHCP server is accessible from the switch

Designating a primary VLAN other than the default VLAN affects the switch’s use of information
received via DHCP/Bootp. For more on this topic, See the describing VLANs in the Advanced Traffic
Management Guide for your switch.

After you reconfigure or reboot the switch with DHCP/Bootp enabled in a network providing DHCP/Bootp service,
the switch does the following:

• Receives an IP address and subnet mask and, if configured in the server, a gateway IP address and the
address of a Timep server.

• If the DHCP/Bootp reply provides information for downloading a configuration file, the switch uses TFTP to
download the file from the designated source, then reboots itself. (This assumes that the switch or VLAN has
connectivity to the TFTP file server specified in the reply, that the configuration file is correctly named, and that
the configuration file exists in the TFTP directory.)

Overview of IP Addressing
You can configure IP addressing through all the switch’s interfaces. You can also:

• Easily edit a switch configuration file to allow downloading the file to multiple switches without overwriting each
switch’s unique gateway and VLAN 1 IP addressing.

• Assign up to 32 IP addresses to a VLAN (multinetting).

• Select an IP address to use as the source address for all outgoing traffic generated by a specified software
application on the switch. This allows unique identification of the software application on the server site
regardless of which local interface has been used to reach the destination server.

Why configure IP addressing? In its factory default configuration, the switch operates as a multiport learning
bridge with network connectivity provided by the ports on the switch. However, to enable specific management
access and control through your network, you will need IP addressing. Effects of IP addressing on switch
operation on page 147 shows the switch features that depend on IP addressing to operate.

IP addressing with multiple VLANs
In the factory default configuration, the switch has one, permanent default VLAN (named DEFAULT_VLAN) that
includes all ports on the switch. Thus, when only the default VLAN exists in the switch, if you assign an IP
address and subnet mask to the switch, you are actually assigning the IP addressing to the DEFAULT_VLAN.
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• If multiple VLANs are configured, then each VLAN can have its own IP address. This is because
each VLAN operates as a separate broadcast domain and requires a unique IP address and
subnet mask. A default gateway (IP) address for the switch is optional, but recommended.

• In the factory default configuration, the default VLAN (named DEFAULT_VLAN) is the switch’s
primary VLAN. The switch uses the primary VLAN for learning the default gateway address. The
switch can also learn other settings from a DHCP or Bootp server, such as (packet) Time-To-Live
(TTL), and Timep or SNMP settings. (Other VLANs can also use DHCP or BootP to acquire IP
addressing. However, the switch’s gateway, TTL, and TimeP or SNTP values, which are applied
globally, and not per-VLAN, will be acquired through the primary VLAN only, unless manually set
by using the CLI, Menu, or WebAgent. (If these parameters are manually set, they will not be
overwritten by alternate values received from a DHCP or Bootp server.) For more on VLANs, see
the titled “Static Virtual LANs” in the Advanced Traffic Management Guide for your switch.

• The IP addressing used in the switch must be compatible with your network. That is, the IP
address must be unique and the subnet mask must be appropriate for your IP network.

• If you change the IP address through either Telnet access or the WebAgent, the connection to the
switch will be lost. You can reconnect by either restarting Telnet with the new IP address or
entering the new address as the URL in your web browser.

DHCP/Bootp operation
Overview. DHCP/Bootp is used to provide configuration data from a DHCP or Bootp server to the switch. This
data can be the IP address, subnet mask, default gateway, Timep Server address, and TFTP server address. If a
TFTP server address is provided, this allows the switch to TFTP a previously saved configuration file from the
TFTP server to the switch. With either DHCP or Bootp, the servers must be configured prior to the switch being
connected to the network.

The switches covered in this guide are compatible with both DHCP and Bootp servers.

The DHCP/Bootp process. Whenever the IP Config parameter in differences the switch or in an individual
VLAN in the switch is configured to DHCP/Bootp (the default), or when the switch is rebooted with this
configuration:

1. DHCP/Bootp requests are automatically broadcast on the local network. (The switch sends one type of request
to which either a DHCP or Bootp server can respond.)

2. When a DHCP or Bootp server receives the request, it replies with a previously configured IP address and
subnet mask for the switch. The switch also receives an IP Gateway address if the server has been configured
to provide one. In the case of Bootp, the server must first be configured with an entry that has the switch’s
MAC address. (To determine the switch’s MAC address, See Appendix D, “MAC Address Management”.) The
switch properly handles replies from either type of server. If multiple replies are returned, the switch tries to use
the first reply.)

If you manually configure default gateway, TTL, TimeP, and/or SNTP parameters on the switch, it
ignores any values received for the same parameters via DHCP or Bootp.

If the switch is initially configured for DHCP/Bootp operation (the default), or if it reboots with this configuration, it
begins sending request packets on the network. If the switch does not receive a reply to its DHCP/Bootp
requests, it continues to periodically send request packets, but with decreasing frequency. Thus, if a DHCP or
Bootp server is not available or accessible to the switch when DHCP/Bootp is first configured, the switch may not
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immediately receive the desired configuration. After verifying that the server has become accessible to the switch,
reboot the switch to restart the process immediately.

DHCP operation. A significant difference between a DHCP configuration and a Bootp configuration is that an IP
address assignment from a DHCP server is automatic. Depending on how the DHCP server is configured, the
switch may receive an IP address that is temporarily leased. Periodically the switch may be required to renew its
lease of the IP configuration. Thus, the IP addressing provided by the server may be different each time the
switch reboots or renews its configuration from the server. However, you can fix the address assignment for the
switch by doing either of the following:

• Configure the server to issue an “infinite” lease.

• Using the switch’s MAC address as an identifier, configure the server with a “Reservation” so that it will always
assign the same IP address to the switch. (For MAC address information, See Appendix D, “MAC Address
Management”.)

For more information on either of these procedures, See the documentation provided with the DHCP server.

Bootp operation. When a Bootp server receives a request, it searches its Bootp database for a record entry that
matches the MAC address in the Bootp request from the switch. If a match is found, the configuration data in the
associated database record is returned to the switch. For many Unix systems, the Bootp database is contained in
the /etc/bootptab file. In contrast to DHCP operation, Bootp configurations are always the same for a specific
receiving device. That is, the Bootp server replies to a request with a configuration previously stored in the server
and designated for the requesting device.

Bootp Database Record Entries. A minimal entry in the Bootp table file /etc/bootptab to update an IP
address and subnet mask to the switch or a VLAN configured in the switch would be similar to this entry:

8212switch:\
   ht=ether:\
   ha=0030c1123456:\
   ip=10.66.77.88:\
   sm=255.255.248.0:\
   gw=10.66.77.1:\
   hn:\
   vm=rfc1048
An entry in the Bootp table file /etc/bootptab to tell the switch or VLAN where to obtain a configuration file
download would be similar to this entry:

8212switch:\
    ht=ether:\
    ha=0030c1123456:\
    ip=10.66.77.88:\
    sm=255.255.248.0:\
    gw=10.66.77.1:\
    lg=10.22.33.44:\
    T144="switch.cfg":\
    vm=rfc1048
where:

8212swi
tch

is a user-defined symbolic name to help you find the correct section of the bootptab file. If you have
multiple switches that will be using Bootp to get their IP configuration, you must use a unique symbolic
name for each switch.

ht is the "hardware type". For the switches covered in this guide, enter ether (for Ethernet). This tag
must precede the ha tag.

Table Continued

Chapter 9 Configuring IP Addressing 151

Anexo 02 ITEM 10 (0592613)         SEI 0008478-63.2018.6.02.8000 / pg. 4999



ha is the "hardware address". Use the switch's (or VLAN's) 12-digit MAC address.

ip is the IP address to be assigned to the switch (or VLAN).

sm is the subnet mask of the subnet in which the switch (or VLAN) is installed.

gw is the IP address of the default gateway.

lg TFTP server address (source of final configuration file)

T144 is the vendor-specific "tag" identifying the configuration file to download.

vm is a required entry that specifies the Bootp report format. Use rfc1048 for the switches covered in
this guide.

The above Bootp table entry is a sample that will work for the switch when the appropriate addresses
and file names are used.
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Viewing or downloading the software manual set
Procedure

Go to the Networking website http://www.hpe.com/networking/support to view or download product
documentation.

Updating the switch software to a new version

Updating the switch software
Process overview:

Procedure

1. Go to the Networking website (http://www.hpe.com/networking/support) to download the new switch
software file.

HPE periodically provides switch software updates through the Networking website. Check the website
frequently for the latest software version available for your switch.

2. Review the Best practices, recommendations, and precautions on page 158.

3. Backup your configuration, as specified in Backing up your current configuration and image on page 154.

4. Do one of the following to download and install the new switch software:

a. For a TFTP transfer from a server, do either of the following:

• Select Download OS in the Main Menu of the switch’s menu interface and use the (default) TFTP
option. For more information about using the switch’s menu interface, see Using the Menu Interface on
page 16.

• In the switch’s CLI, complete the Downloading and installing software from a TFTP server on page
155 task. Use the copy tftp command in the switch’s CLI (see below).

b. For an Xmodem transfer from a PC or Unix workstation, do either of the following:

• Select Download OS in the Main Menu of the switch’s menu interface and select the XMODEM option.
For more information about using the switch’s menu interface, see Using the Menu Interface on page
16.

• In the switch’s CLI, complete the Downloading and installing software from a PC or Unix
workstation on page 156 task.

c. For a transfer from a USB flash drive: In the switch’s CLI, complete the
Downloading and installing software from a USB flash drive on page 157task.
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Downloading new software does not change the current switch configuration. The switch
configuration is contained in a separate file that can also be transferred, for example, to archive or to
be used in another switch of the same model.

Backing up your current configuration and image

Procedure

1. Save your current configuration (Config1) to backup configuration file (Config2).

a. Before copying the config, verify the current state of your system using the show version, show flash and
show config files commands. For example:

Switch1# show version
Image stamp:   /sw/code/build/btm(t4a)
               Nov 6 2009 13:20:26
               K.14.47
               188
Boot Image:    Primary

Switch1# show flash
Image           Size(Bytes)   Date    Version
------          -----------  -------  -------
Primary Image   : 9839140    11/06/09 K.14.47
Secondary Image : 0
Boot Rom Version: K.12.20
Default Boot    : Primary

Switch1# show config files

Configuration files:

 id | act pri sec | name
 ---+-------------+-----------------------------
  1 | *    *   *  | config1
  2 |             | 
  3 |             | 

b. Create a backup configuration file and verify the change.

Switch1# copy config config1 config config2
Switch1# show config files

Configuration files:

 id | act pri sec | name
 ---+-------------+-----------------------------
  1 | *    *   *  | config1
  2 |             | config2
  3 |             | 

2. Save the current config to a tftp server using the copy tftp command. For example:

Switch1# copy startup-config tftp 10.1.1.60
Switch1_config_K_14_47.cfg

This step is necessary because switches do not support roll back (going from a newer software
version to an older software version) without the ability to copy a backup config file onto the
device.
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3. Back up your current running image (primary) to the secondary image.

Switch1# copy flash flash secondary

Switch1# show flash
Image           Size(Bytes)   Date    Version
------          -----------  -------  -------
Primary Image   :  9839140   11/06/09 K.14.47
Secondary Image :  9839140   11/06/09 K.14.47
Boot Rom Version: K.12.20
Default Boot    : Primary
 

4. Set your secondary image to boot with Config2.

Switch1# startup-default secondary config config2 

Switch1# show config files

Configuration files:

 id | act pri sec | name
 ---+-------------+-----------------------------
  1 | *    *      | config1
  2 |          *  | config2
  3 |             | 
This step will enable you to revert from the new software version to your previous software version (K.14.47 in
the examples shown in steps 1 through 3) with your previous configuration just by invoking the command boot
system flash secondary.

Downloading and installing software from a TFTP server

Procedure

1. Use the following command, specifying the filename and the primary or secondary flash destination:

copy tftp flash <ip-address> <remote-os-file> [ primary | secondary ]
Note that if you do not specify the flash destination, the TFTP download defaults to the primary flash.

For example, to download a software file named K_15_10_0001.swi from a TFTP server with the IP address of
10.28.227.103 to the primary flash destination, execute the copy command as shown below:

switch# copy tftp flash 10.28.227.103 K_15_10_0001.swi
The primary OS image will be deleted. continue
continue[y/n]? Y
03125K

2. When the switch finishes downloading the software file from the server, it displays the progress message

Validating and Writing System Software to FLASH...
3. When the CLI prompt reappears, the switch is ready to reboot to activate the downloaded software:

a. Use the show flash command to verify that the new software version is in the expected flash area (primary
or secondary).

b. Reboot the switch from the flash area (primary or secondary) that holds the new software, using the
following command:

boot system flash [ primary | secondary ]
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After the switch reboots, it displays the CLI or Main Menu, depending on the Logon Default setting last
configured in the menu’s Switch Setup screen.

4. Verify the software version by displaying the system information for the switch (for example, through the show
system-information command), and viewing the Software revision field.

Downloading and installing software from a PC or Unix workstation
Downloading and installing software from a PC or Unix workstation

To download software from a PC or Unix workstation:

Prerequisites

Before you download and install software from a PC or Unix workstation, insure that:

• The switch is connected via the Console RS-232 port to a PC operating as a terminal. (See your switch
Installation and Getting Started Guide for information on connecting a PC as a terminal and running the switch
console interface.)

• The switch software is stored on a disk drive in the PC.

• The terminal emulator you are using includes the Xmodem binary transfer feature. (For example, in the
HyperTerminal application included with most Windows systems, the Send File option in the Transfer drop-
down menu supports the Xmodem protocol.)

Procedure

1. To reduce the download time, you may want to increase the baud rate in your terminal emulator and in the
switch to a value such as 115,200 bits per second. (The baud rate must be the same in both devices.) For
example, to change the baud rate in the switch to 115200, execute this command:

switch(config)# console baud-rate 115200
(If you use this option, be sure to set your terminal emulator to the same baud rate.)

Changing the console baud-rate requires saving to the Startup Config with the write memory command.
Alternatively, you can log out of the switch and change your terminal emulator speed and allow the switch to
Auto-Detect your new higher baud rate (that is, 115,200 bps)

2. Use the following CLI command, specifying the primary or secondary flash destination:

copy xmodem flash [ primary | secondary ]
For example, the following command specifies the primary flash destination:

switch# copy xmodem flash primary
The primary OS image will be deleted. continue [y/n]? Y
Press ‘Enter’ and start XMODEM on your host...

3. Execute the terminal emulator commands to begin the Xmodem transfer. For example, using HyperTerminal:

a. Click Transfer, then Send File.

b. Type the file path and name in the Filename field.

c. In the Protocol field, select Xmodem.

d. Click Send button.

The download can take several minutes, depending on the baud rate used in the transfer.
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4. If you increased the baud rate on the switch (1), use the same command to return it to its previous setting. (A
baud rate of 9600 bits per second is recommended for most applications.) Remember to return your terminal
emulator to the same baud rate as the switch.

5. Use the show flash command to verify that the new software version is in the expected flash area (primary or
secondary).

6. Reboot the switch from the flash area (primary or secondary) that holds the new software, using the following
command:

boot system flash [ primary | secondary ]
After the switch reboots, it displays the CLI or Main Menu, depending on the Logon Default setting last
configured in the menu’s Switch Setup screen.

Downloading and installing software from a USB flash drive
Downloading and installing software from a USB flash drive

To download software from a USB flash drive:

Prerequisites

Before you download and install software from a USB flash drive, insure that:

• The software version is stored on the USB flash drive and you know the file name (such as
K_15_10_0001.swi).

• The USB flash drive is properly installed in the USB port on the switch.

• The USB flash drive is supported. Some USB flash drives may not be supported on your switch. For
information on USB device compatibility, see the networking support (http://www.hpe.com/networking/
support).

Procedure

1. Use the following CLI command, specifying the filename and the primary or secondary flash destination:

copy usb flash <filename> [ primary | secondary ]
For example, to download a software file named K_15_10_0001.swi from a USB flash drive to the secondary
flash destination, execute the command as shown below:

switch# copy usb flash K_15_10_0001.swi secondary
The secondary OS image will be deleted. continue
[y/n]? Y
03125K

2. When the switch finishes downloading the software file from the server, it displays the progress message:

Validating and Writing System Software to FLASH...
3. When the CLI prompt reappears, the switch is ready to reboot to activate the downloaded software:

a. Use the show flash command to verify that the new software version is in the expected flash area (primary
or secondary).

b. Reboot the switch from the flash area (primary or secondary) that holds the new software, using the
following command:

boot system flash [ primary | secondary ]
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After the switch reboots, it displays the CLI or Main Menu, depending on the Logon Default setting last
configured in the menu’s Switch Setup screen.

4. Verify the software version by displaying the system information for the switch (for example, through the show
system-information command), and viewing the Software revision field.

Best practices, recommendations, and precautions
Best practices for software updates

There is a slight change in the versioning system.

Software updates that contain significant new features and enhancements may be designated by an increment to
both the major and minor release version numbers. That is, K.15.01.0031 represents a major update to software
version(s) K.14.xx, and K.14.xx represents a major update to K.13.xx, and so forth. In addition, a future version
(such as K.15.02.xxxx) may represent a minor release to version K.15.01.xxxx, but may still contain significant
changes. To mitigate against potential migration issues when performing such updates, this section documents
best practices for updating the switch, including contingency procedures for rolling back to previous software
versions and saved configurations.

Recommendations and precautions for software updates

Before you update the switch software to a new version:

• We strongly recommend that you save a copy of your config file to an external location.

• We advise against rolling back (going from a newer software version to an older software version) without
copying a backup config file to the device.

If you do choose to downgrade software using your existing config file, unpredictable changes in the config file
and switch behavior may occur. If booting a K.15.01.0031 or later config file into a K.14.xx or earlier versions of
software, the following commands may be removed from your config file:

• Any commands that are present in K.15.01.0031 (or later) but are not present in earlier versions of software

• logging

• snmp-server

• mirror-session

• auto-tftp

• filter source-port

• fault-finder

• interface loopback

After following these steps, you end up with the following results:

• Primary image will hold the new software image you want to install

• Secondary image will hold the image you are currently running

• Primary image will boot with Config1 (config file corresponding to new software version)

• Secondary image will boot with Config2* (config file corresponding to previous software version)
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* The current config file must be copied to Config2, or you will be unable to revert if the need arises.

You might opt to use a different methodology in which the new software will be installed as the
secondary and not the primary image, in which case you would use the commands boot system
flash secondary, and/or boot set-default flash secondary to change the location of the default
boot. However, since you will still need to take precautions to allow you to revert to your previous
configuration. We strongly recommend that you follow the methods that are proposed in our update
process. This will ensure that you can use our proposed rollback procedures if the need arise.

Validating switch software

Validating a software image
A software is valid if it has a valid digital signature, which is generated by HPE Code Signing Service (HPECSS).
Switches that support digital signature verification will generate an error message if you attempt to download an
image that is not digitally signed.

• To manually verify the software’s digital signature when the switch does not support digital signature
verification, use the following command:

verify signature flash {primary|secondary}
If the signature is valid, the following message is displayed:

Signature is valid.

• To bypass signature verification, use the allow-no-signatureoption in the copycommand as follows:

copy {tftp|sftp|usb|xmodem} flash [<hostname/IP>]
[<filename>] {primary|secondary} allow-no-signatures

Theallow-no-signature option is available on switches that support non-signed legacy software releases and
must be used with caution. To determine support for your switch, go to: http://www.hpe.com/networking/
swvalidation.

Software signing and verification
As an enhanced security feature, you can verify whether a software image being downloaded to or stored in your
switch has, in fact, been provided by Networking without any modification or corruption.

Validation is based on the image signature that is generated and attached to the switch software by HPE Code
Signing Service (HPECSS). Networking implemented digital signature validation starting with specific switch
software versions. For a list of these software versions, go to: http://www.hpe.com/networking/swvalidation.

Once a switch software image has been digitally signed on a specific version, all later versions will
also be signed.

Switches supporting digital signature verification will generate an error message if you attempt to download an
image that is not digitally signed. For example, using the CLI commands described above to revert back to an
image that is not signed from an image that is signed and supports verification would result in the following
message:

This software image does
not contain a digital signature and
cannot be validated as originating
from HP. You may bypass this

Chapter 10 Managing switch software 159

Anexo 02 ITEM 10 (0592613)         SEI 0008478-63.2018.6.02.8000 / pg. 5007

http://www.hpe.com/networking/swvalidation
http://www.hpe.com/networking/swvalidation
http://www.hpe.com/networking/swvalidation


validation by using the
'allow no-signature’ option. Please
see www.hp.com/networking/swvalidation
for information about which versions
of software contain digital signatures.
When you use the copy command to download a properly signed image, the CLI logs the following syslog
message:

Update: Firmware image contains valid signature.
Errors related to signature validation will generate one of the following log messages:

Update: Aborted. Downloaded file invalid.
Update: Aborted. Firmware image does not contain a signature. 
Update: Aborted. Firmware image signature is not valid.

Rolling back switch software
If you are downgrading to a software version that supports long user names and passwords, ignore the
prerequisite. Software versions K.15.01.0032 and later support the longer user names and passwords

Prerequisite

Before downgrading to a software version that does not support long user names and passwords from a software
version that supports them, complete one of the following tasks.

• Use the passwordCLI command or the Web browser interface, change usernames or passwords to be no
more than 16 characters in length, and without any special characters. Then execute a CLI write
memorycommand (required if the include-credentialsfeature has ever been enabled).

• Clear the values using the no password all CLI command. Then execute a CLI, write memorycommand
(required if the include-credentialsfeature has ever been enabled).

• Clear password values by using the "Clear" button on the switch. Then execute a CLI, write
memorycommand (required if the include-credentialsfeature has ever been enabled).

Rolling back switch software

To roll back your switch from K.15.01.0031 to K.14.47, for example, follow the steps below:

1. Verify that your images and configuration are set correctly using the show version, show flash and show
config files commands.

Switch1# show version
Image stamp:   /sw/code/build/btm(t5a)
               Apr 23 2010 05:43:42
               K.15.01.0031
               67
Boot Image:    Primary

Switch1# show flash
Image           Size(Bytes)   Date    Version
------          -----------  -------  -------
Primary Image   : 11537788   04/23/10 K.15.01.0031
Secondary Image :  9839140   11/06/09 K.14.47
Boot Rom Version: K.15.09
Default Boot    : Primary

Switch1# show config files
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Configuration files:

 id | act pri sec | name
 ---+-------------+-----------------------------
  1 | *    *      | config1
  2 |          *  | config2
  3 |             | 

2. Boot the switch using the secondary image (with config2).

Switch1# boot system flash secondary
System will be rebooted from secondary image. Do
you want to continue [y/n]? y
Enter ‘y’ for yes, and the switch will boot from the secondary image (K.14.47, in this example) with the
corresponding configuration for that software version (Config2).

Managing scheduled jobs

Schedule a job to run automatically
A job, that is command, can be scheduled to run on a recurring basis or after certain events. Use the following
command to schedule a job:

job <name> at
job <Name> at [HH:]MM [on [MM/]DD] [config-save] <Command-str>
job <Name> at <Event> [config-save] <Command-str>
job

Schedule a command to run automatically in the future.

Name

The name of the job to add or delete.

at

Schedule when the job runs.

reboot

Run the job as soon as possible after every switch boot.

[HH:]MM

The time when the job has to run.

on

Schedule the job to run on specified days.

MM/DD

The date when the job has to run.

<31-1>

The day relative to the end of the month when the job has to run.

<1-31>

The day of the month when the job has to run.
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WEEKDAY-LIST

The days of the week when the job has to run.

config-save

Save configuration changes made by the job.

Command-str

The command to execute when this job runs.

This command uses a new “weekday list” token type. A weekday list represents one or more days of
the week and is stored internally. It allows users to specify a list of individual days or a range of days
and use abbreviations. Examples of this weekday list are:

• Monday, Friday

• Mon-Wed

• mo,we-fr,su

Examples

The following example shows a pair of jobs that disable PoE during non-working hours
Switch(config)# job poe-on at 8:00 on mon-fri config-save "interface 1-24 power-over-ethernet"
Switch(config)# job poe-off at 17:00 on mon-fri config-save "no interface 1-24 power-over-ethernet"

The following example shows a job that block access to a server during weekends
Switch(config)# ip access-list extended block-server
Switch(config-ext-nacl)# deny ip any host 10.0.1.80
Switch(config-ext-nacl)# permit ip any any
Switch(config-ext-nacl)# exit
Switch(config)# job allow at 8:00 on mon config-save "no interface 1-24 ip access-group block-server in"
Switch(config)# job deny at 17:00 on fri config-save " interface 1-24 ip access-group block-server in"

The following example shows a job that blinks the Chassis Locate LED when the switch reboots

Switch(config)# job reboot-led at reboot "chassislocate blink"
The following example shows a job that reboots the switch on the first day of each year

Switch(config)# job annual-reboot at 2:00 on 1/1 boot

Deleting a scheduled job
Use the command no job <name> to delete a scheduled job. The name argument specifies the job to be
deleted.

Delete a scheduled job named “baz”

switch# show job

Job Scheduler Status and Configuration
Scheduler Status : Waiting for the system time to be set

                       Event or     Save 
Name                   Time         Cfg    Command
-------------------- ------------- ----   -------------------------------------
Burrrrrrrrrrrrrrr... reboot        Yes  chassislocate blink
baz                  reboot        No   show time 
foo                  17:00 SxTWTxS No   savepower led
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switch# no job baz

Viewing scheduled jobs
Do one of the following:

• Use the command show job <Name> to view details of a specific scheduled job.

• Use the command show job to view a list of all the scheduled jobs.

Names and commands that are longer than their column width are truncated with an ellipsis in the display. To
assist administrators in diagnosing problems with jobs, there is a detail view for a single job. If the last job run
produced any output, the first 255 characters of that output will be shown from the last job run whether that job
was successful or not. A successful run will overwrite the error output from a previous failed run.

Examples

The following example displays the list of the scheduled jobs

switch# show job

Job Scheduler Status and Configuration
Scheduler Status : Waiting for the system time to be set

                       Event or     Save 
Name                   Time         Cfg    Command
-------------------- ------------- ----   -------------------------------------
Burrrrrrrrrrrrrrr... reboot        Yes  chassislocate blink
baz                  reboot        No   show time 
foo                  17:00 SxTWTxS No   savepower led
The following example displays the details of a specific scheduled job

switch# show job baz

Job Information
Job Name    : baz
Runs At     : reboot
Config Save : No
Run Count   : 1
Error Count : 0
Command     : show time
Output from Last Run
--------------------
Mon Jan  1 00:00:44 1990

Time adjustments and scheduling jobs
Daylight savings time adjustments

When daylight savings time (DST) begins (“spring forward”), the local time jumps from 0200 to 0300. The Job
Scheduler “catches up” by running all jobs scheduled between 0200 and 0300 the next time it wakes up. This
prevents jobs from being skipped when they appear in the 0200 to 0300 time frame.
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When daylight savings time (DST) ends (“fall back”), the local time jumps from 0200 to 0100. The Job Scheduler
skips all jobs scheduled between 0100 and 0200 to allow local time to catch up. Those jobs already ran once
before DST ended will not repeat.

If an administrator configures a new job during the repeat of the 0100 to 0200 hour on the day DST
ends, the new job will not be run because the Job Scheduler skips that hour.

External adjustments

External adjustments to the system time can happen to correct for clock drift or for other administrative reasons.
The new time update can come from SNTP, from a configuration command at the CLI, or from an SNMP SET of
the system time MIB object. When a time adjustment takes place, the Job Scheduler task is called with the new
clock value. Jobs scheduled during a time clock jump forward are run while any jobs scheduled during a time
clock jump back are skipped.

Adjustment of more than 10 minutes are considered a major change and reset the Job Scheduler. Any jobs
scheduled during a time clock jump forward are skipped while any jobs scheduled during a time clock jump back
are repeated.

Calendar conflicts

Because the Job Scheduler MIB is more flexible than the CLI scheduling grammar, it is possible to create job
schedules via SNMP that cannot be displayed by the CLI. The following rules are imposed on MIB values to limit
them to what the CLI can display.

• If any bits are set in hpicfJobSchedulerEvent, all Calendar values are ignored. They may be set with SNMP,
but are ignored when looking for jobs to run. The Calendar values are also ignored by the command show
running-config.

• If any bit is set in CalendarDayOfWeek, then CalendarMonth and CalendarDayOfMonth are ignored.

• If no bits are set in CalendarDayOfWeek or CalendarDayOfMonth, then CalendarMonth is ignored.

• Only 1 bit may be set in the CalendarMonth, CalendarDayOfMonth, CalendarHour, and CalendarMinute
objects. Attempting to set a value with more than 1 bit returns an InconsistentValue error.

• If no bits are set in CalendarHour and CalendarMinute, the job is considered to be in a transition state and not
valid. This could happen when an SNMP management application is creating a job one object at a time. Jobs
in this state are ignored by the scheduler and by the command show running-config.

The Job Scheduler
The Job Scheduler provides administrators the ability to schedule recurring commands or “jobs” on their switch. A
feature of the Job Scheduler is the ability to schedule a command to run on a recurring basis or after certain
events. For example, a command can be triggered to run by certain predefined events such as switch reboot.

There is no prompt for user input with this feature. Administrators using this feature can schedule commands such
as enabling or disabling ports, turning on or off LEDs and Power-Over-Ethernet commands. All commands run
with manager privilege in configuration context.

Jobs that are scheduled can be viewed or deleted.

Alternate configuration files
An alternate configuration that is saved to the switch is viewed or copied through the software currently running
on the switch. This may result in a misleading portrayal of the configuration. For example, if a configuration is
created on K.14.47 and saved as config2, and if it is then viewed or transferred while the switch is running K.
15.01.0031, it will appear as though K.15.01.0031 has converted the configuration. However, the alternate
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configuration file, config2, will still be intact on the switch and load properly when the switch is booted into the
same software version from which the configuration file originated.

When an enhancement introduces a feature that did not previously exist in the switch, it may present several
challenges to the user.

Backwards compatibility of the configuration created with a version of software that supports a new feature or
parameter is not guaranteed. Software versions that did not recognize or support a particular command or
parameter will not be able to interpret that line in the configuration. For this reason, it is strongly recommended
that network administrators always save their configuration while still running the switch with the original
software version, and with a notation indicating the software version on which the configuration was saved. For
example, a user might save a configuration for a switch running K.14.47 to a TFTP server with an IP address of
10.10.10.15 as follows:

switch-onK1447# copy running-config tftp
10.10.10.15 5406onK1447
If, for example, the user deems it necessary to revert to the use of K.14.47, the user can boot into it and then
restore the saved config from the TFTP server.

Viewing or copying an alternate configuration that is saved to the switch flash can be accomplished only with the
software that is currently running on the switch.

Here, for example, a configuration is created on K.14.47 and then saved to flash:

switch-onK1447# copy config config2 config
K1447config <cr>
And later, the configuration that was created on K.14.47 is viewed while the switch is running K.15.01.0031:

switch-onK1501# show config K1447config <cr>
The command output will show how the K.14.47 config would be interpreted if it were to be used by the K.
15.01.0031 software. Copying the K1447config file to a TFTP server would similarly trigger an interpretation by
the software performing the file transfer. Note, however, that this does not actually change the configuration. If the
version is rolled back from K.15.01.0031 to K.14.47 with a command like the following (given that K.14.47 is
stored in secondary flash), the K.14.xx formatted config is still intact and valid.

switch# boot system flash secondary config
K1447config
This "interpretation" during a TFTP or show command execution is inherent in the architecture of the switch.
When switch features change significantly (such as the move from IPv4 support to IPv6 support), there may be
configuration parameters from the previous config that cannot be translated by the switch for viewing while it is
running the new software. This necessitates storing configurations for each version of software to an external
location, if the user would like to view the stored config prior to reloading it.
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Switches provide a way to automatically adjust the system clock for Daylight Saving Time (DST) changes. To use
this feature, define the month and date to begin and to end the change from standard time. In addition to the
value "none" (no time changes), there are five predefined settings named:

• Alaska

• Canada and Continental US

• Middle Europe and Portugal

• Southern Hemisphere

• Western Europe

The predefined settings follow these rules:

Alaska:

• Begin DST at 2 am on the second Sunday in March.

• End DST at 2 am on the first Sunday in November.

Canada and Continental US:

• Begin DST at 2 am on the second Sunday in March.

• End DST at 2 am on the first Sunday in November.

Middle Europe and Portugal:

• Begin DST at 2 am the first Sunday on or after March 25th.

• End DST at 2 am the first Sunday on or after September 24th.

Southern Hemisphere:

• Begin DST at 2 am the first Sunday on or after October 25th.

• End DST at 2 am the first Sunday on or after March 1st.

Western Europe:

• Begin DST at 2 am the first Sunday on or after March 23rd.

• End DST at 2 am the first Sunday on or after October 23rd.

Chapter 11
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A sixth option named "User defined" allows you to customize the DST configuration by entering the beginning
month and date plus the ending month and date for the time change. The menu interface screen looks like the
following: (all month/date entries are at their default values):

Figure 53: Menu interface with "user-defined" daylight time rule option

Before configuring a "User defined" daylight time rule, it is important to understand how the switch treats the
entries. Given the "Beginning day" and "Ending day", based on an algorithm from Sunday, the switch determines
the date to change the system clock :

• If the configured day is a Sunday, the time changes at 2 am on that day.

• If the configured day is not a Sunday, the time changes at 2 am on the first Sunday after the configured day.

This is true for both the "Beginning day" and the "Ending day."

With that algorithm, you can use the value "1" to represent "first Sunday of the month," and a value equal to
"number of days in the month minus 6" to represent "last Sunday of the month." This allows a single configuration
for every year, no matter what date is the appropriate Sunday to change the clock.

Chapter 11 Daylight Saving Time 167

Anexo 02 ITEM 10 (0592613)         SEI 0008478-63.2018.6.02.8000 / pg. 5015



Configuring the module power-saving option
Do one of the following:

• Use the command savepower module <slot-list> to turn off power for the modules in the specified
slots.

• Use the command savepower module all to turn off power for all the modules.

The following example shows how to turn off power for the module in slot "c".

If a savepower module <slot-list> or a savepower module all command is immediately
followed by a no savepower module <slot-list> or a no savepower module all
command, the first slot in the list is powered down and then brought up.

Configuring the LED power-saving option
Do one of the following:

• Use the following command to turn off the chassis LEDs for the specified slots.

savepower led <slot-list>
[timer [MM/DD[/[YY]YY] HH:MM|now|duration [HH:MM[recur]]]

• Use the following command to turn off all the chassis LEDs.

savepower led all
[timer [MM/DD[/[YY]YY] HH:MM|now|duration [HH:MM[recur]]]

Each of these commands includes a timer option. When the timer is configured, the LEDs are turned off for the
specified time period and duration. There is one system-wide timer.

Chapter 12
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The following example shows how to turn off LEDs beginning on 6/1 at 12:01 for 12 hours and repeat daily

Configuring the slot low-power option
Do one of the following:

• Use the command savepower port-low-pwr <slot-list> to put the specified slots into low-power
mode.

• Use the command savepower port-low-pwr all to put the all the slots into low-power mode.

Slots will go into lower-power mode only if they are not linked. The slots that have the low-power option
configured periodically monitor connections to determine if the link has become active. If a LAN cable is
connected to one of the slots, that slot will come out of the low-power mode state after approximately two seconds
(the monitoring period) and enter into normal power mode. The remaining slots continue to be in low-power mode.

The following example shows how to put slot "c" into low-power mode.
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Disabling power-saving options
Do one of the following to disable the power-saving option for modules. A module is powered on when its power-
saving option is disabled.

• Use the command no savepower module <slot-list> to disable the power-saving option for the
modules in the specified slots.

• Use the command no savepower module all to disable the power-saving option for all the modules.

Do one of the following to disable the power-saving option on chassis LEDs. An LED returns to its original state
and any scheduled or running timer is canceled when the power-saving option is disabled on the LED.

• Use the command no savepower led <slot-list> to disable the power-saving option on the chassis
LEDs for the specified slots.

• Use the command no savepower led all to disable the power-saving option on all the chassis LEDs.

Do one of the following to disable the low-power mode for slots. A slot returns to normal power mode when its
low-power mode is disabled.

• Use the command no savepower port-low-pwr <slot-list> to disable the low-power mode for the
specified slots.

• Use the command no savepower port-low-pwr all to disable the low-power mode for all the slots.

Enabling energy-efficient-ethernet (EEE)
Prerequisites

Before you enable energy-efficient-ethernet (EEE), you must insure that both sides of the link are EEE-capable to
support the power-saving idle mode.

Energy-efficient-ethernet follows the 802.3az standard, which provides support for a system to operate in low-
power idle mode during low-link use.

Enabling energy-efficient-ethernet (EEE)

To enable EEE on the specified port or a range of ports, use the following command:
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int <port-list> energy-efficient-ethernet

Enable EEE on ports B5 through B7

Enabling advertisement of EEE TLVs
The layer 2 (data link layer) Energy-efficient-ethernet (EEE) capability is a feature that allows ports to negotiate
the best optimizations for energy efficiency.Use the following command to enable the advertisement of Layer 2
EEE TLVs for a specified port or a range of ports.

lldp config <port-list> dot3TlvEnable eee_config
The following example shows how to enable the advertisement of Layer 2 EEE TLV for port B5.
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Disabling EEE or advertisement of EEE TLV
To disable enable Energy-efficient-ethernet(EEE) on the specified port or a range of ports, use the following
command:

no int <port-list> energy-efficient-ethernet
To disable the advertisement of Layer 2 EEE TLVs for a specified port or a range of ports, use the following
command:

no lldp config <port-list> dot3TlvEnable eee_config

Hibernate mode

hibernate
Syntax
hibernate <seconds>

Description

Hibernate the system. This command saves the current configuration and powers off the system for the specified
period. When the hibernation period expires, the switch will power up and boot using the normal boot process. A
typical use case is to have the job scheduler execute the hibernate command. For example, put the switch into
hibernate mode from midnight until 5 a.m.
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During hibernation, the system will not respond to any network traffic and the console will be inaccessible. The
only way to reboot the switch before the hibernation period expires is to press the Mode button on the front panel
or cycle power, thus disabling the hibernate job and timer.

The system prompts for y or n confirmation before putting the system into hibernate mode.

This feature is available on the 2930M and only in standalone. It is disabled for stacks.

Command context

Manager

Parameters
<seconds>

Specifies the length of time, in seconds, that the system will remain in hibernate mode. Duration: 0 to
2147483647 seconds.

Example

Hibernate the switch for 8 minutes.

switch# hibernate 480

This command will save the current configuration and then power off the
system for the specified period. During that time the system will not
respond to any network traffic and the console will be inaccessible. The
only way to reboot the switch before the hibernation period expires will
be to press the Mode button on the front panel or cycle power.

Continue(y/n)?

Viewing settings for power-saving and energy efficiency
Various versions of the show command are used to display current settings for power-saving options, Energy-
efficient-ethernet (EEE), and EEE TLV.

Do one of the following to view settings:

• Use the command show savepower module to view the current settings for the module power-saving
option.

• Use the command show savepower led to view the current settings for the LED power-saving option.

• Use the command show savepower port-low-pwr to view the current settings for the slot low-power
option.

• Use the command show energy-efficient-ethernet to view the current settings for Energy-efficient-
ethernet (EEE).

• Use the command show lldp info local-device <port-list> to view the current settings for EEE
TLV on the specified local ports.

• Use the command show lldp info remote-device <port-list> to view the current settings for EEE
TLV on the link partner of the specified port.

Display of the current settings for EEE TLV on the link partner of port B6
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Display of the current settings for EEE TLV on the local port B5

Display of the current settings for the slot low-power option

Display of the current settings for the LED power-saving option
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Display of the current settings for the module power-saving option

Displayed values for Energy-efficient-ethernet (EEE)
The displayed values for the energy efficient Energy-efficient-ethernet (EEE) status are explained in the following
table.

Parameter Description

EEE Config The EEE configuration status, read from the
configuration database.

Enabled
EEE mode is enabled.

Disabled
EEE mode is disabled.

Current Status Current EEE operational status.

Active
The port is advertised and auto-negotiated EEE with
link partner (an EEE-capable partner.) EEE mode is
enabled.

Table Continued
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Parameter Description

Inactive
Set to one of the following conditions:

• EEE configuration is disabled on the local port.

• Local port advertises EEE capabilities with "EEE
disabled" link partner or non-EEE link partner.

• Auto-negotiation is mandatory for EEE to work. EEE
configuration will not be applied if the port is in
forced/manual (speed-duplex) mode. The current
status will be ‘inactive" for forced/manual mode port
configuration.

• EEE is not supported for 10Base-T. The current
status will be ‘inactive' if the link is operating in
10Base-T mode.

Unsupported
The local physical interface does not have EEE
capability.

txWake Current value of transmit wake-up time (in
microseconds.)

The interface modules do not support adjustment of both transmit and receive wake-up times.
Therefore, txWake is constant.

Power-saving features supported by modules
The modules support the power-saving features as indicated in the table below:

Product number Description LED power on/off Slot auto low-
power mode

Slot power on/off

J8702A Switch zl 24
10/100/1000 PoE
Module

Yes Yes Yes

J8705A Switch zl 20 Gig-T
+ 4 mGBIC Module

Yes Yes Yes

J8706A Switch zl 24-Port
Mini-GBIC Module

Yes No Yes

J8707A Switch zl 4-Port
10GbE X2 Module

Yes No Yes

J8708A Switch zl 4-Port
10GbE CX4 Module

Yes No Yes

Table Continued
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Product number Description LED power on/off Slot auto low-
power mode

Slot power on/off

J9307A Switch 24-Port
10/100/1000 PoE+ zl
Module

Yes Yes Yes

J9308A Switch 20-Port
10/100/1000 PoE+/4-
Port MiniGBIC zl
Module

Yes Yes Yes

J9309A Switch 4-Port 10Gbe
SFP+ zl Module

Yes No Yes

J9478A Switch 24-Port
10/100 PoE+ zl
Module

Yes Yes Yes

Overview of power-saving features
There are several power-saving features that can be configured for the indicated switches and modules. The
power-saving features include:

• Turn slot power on or off

• Turn LED power on or off

• Turn slot auto low-power mode on or off

• Use LLDP for Energy-Efficient-Ethernet

Slot power

The savepower module option shuts down the slot power for the specified modules in the order specified in the
command. The ports on these modules no longer pass traffic. Any management traffic (SNMP, SSH, Telnet) that
passes through these modules is interrupted. It can take up to two minutes to power down all the specified
modules. Check the Event Log to see the current status of the module power down. This command applies to
PoE/PoE+ modules as well as non-PoE/PoE+ modules.

LED power

The savepower LED option provides the ability to turn off specified slot LEDs or all LEDs. You can also configure
a timer for turning off the chassis LEDs or the specified slot LEDs. There is one system-wide timer; all the
selected slots will have the chassis LEDs turned off for the same amount of time.

When the timer option is configured, a timer for turning off the chassis LEDs or configured slot LEDs. The LEDs
are turned off for the configured time period and duration.

MM/DD[/[YY]YY] HH:MM Specifies the date and time to start the timer.

now Instantaneously turns off the LEDs. The configured
timer is canceled and all the configured modules go
into power-saving mode immediately.

Table Continued
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duration [HH:]MM: The amount of time the LEDs
remain turned off. (Optional)If the duration value is
zero, when the timer starts, the LEDs are turned off
indefinitely until the timer is canceled or the command
is overridden with another command.Default: 0 (zero)

recur: (Optional) If specified, the LEDs are turned off
on a daily basis at the configured time. The recur
option is ignored if the duration is configured as
zero.Default: disabled.

A new command overrides the previous command, regardless of the current state. For example, if a timer is
active and new command is given, the currently running timer is canceled and the new timer is scheduled.

Slot auto low-power mode

The auto low-power mode option puts the slots into auto low-power mode if they are not linked. If a particular slot
is specified, only that slot goes into auto low-power mode. Specifying savepower port-low-pwr all puts all
the slots into auto low-power mode.

The ports in low-power mode periodically monitor to determine if the link has become active. If a LAN cable is
connected to one of the ports, that port will come out of the low-power mode state after approximately 2 seconds
(the monitor period) and enter into normal power mode. The remaining ports continue to be in low-power mode.

Energy-efficient-ethernet

Energy-efficient-ethernet (EEE) follows the 802.3az standard, which provides support for a system to operate in
low-power idle mode during low-link use. This allows both sides of a link to disable or turn off a portion of the
system's transmit/receive circuitry, saving power. When traffic is ready for transmission, the interface sends a
"wake-up" message to the link partner to prepare to receive the traffic. The circuitry is returned to "normal" mode.
Both sides of the link must be EEE-capable to support the power-saving idle mode.

Layer 2 (data link layer) EEE capability is a feature that allows fine-tuning for EEE that uses LLDP TLVs for the
negotiation of physical link partners' wake-up time values. An EEE-capable port notifies its link partner about the
EEE capabilities supported. The ports then negotiate how to best optimize energy efficiency.

178 Aruba Basic Operation Guide for ArubaOS-Switch 16.05

Anexo 02 ITEM 10 (0592613)         SEI 0008478-63.2018.6.02.8000 / pg. 5026



Networking Websites
Hewlett Packard Enterprise Networking Information Library

www.hpe.com/networking/resourcefinder

Hewlett Packard Enterprise Networking Software

www.hpe.com/networking/software

Hewlett Packard Enterprise Networking website

www.hpe.com/info/networking

Hewlett Packard Enterprise My Networking website

www.hpe.com/networking/support

Hewlett Packard Enterprise My Networking Portal

www.hpe.com/networking/mynetworking

Hewlett Packard Enterprise Networking Warranty

www.hpe.com/networking/warranty

General websites
Hewlett Packard Enterprise Information Library

www.hpe.com/info/EIL

For additional websites, see Support and other resources.

Chapter 13
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Accessing Hewlett Packard Enterprise Support
• For live assistance, go to the Contact Hewlett Packard Enterprise Worldwide website:

http://www.hpe.com/assistance

• To access documentation and support services, go to the Hewlett Packard Enterprise Support Center website:

http://www.hpe.com/support/hpesc

Information to collect

• Technical support registration number (if applicable)

• Product name, model or version, and serial number

• Operating system name and version

• Firmware version

• Error messages

• Product-specific reports and logs

• Add-on products or components

• Third-party products or components

Accessing updates
• Some software products provide a mechanism for accessing software updates through the product interface.

Review your product documentation to identify the recommended software update method.

• To download product updates:

Hewlett Packard Enterprise Support Center
www.hpe.com/support/hpesc

Hewlett Packard Enterprise Support Center: Software downloads
www.hpe.com/support/downloads

Software Depot
www.hpe.com/support/softwaredepot

• To subscribe to eNewsletters and alerts:

www.hpe.com/support/e-updates

• To view and update your entitlements, and to link your contracts and warranties with your profile, go to the
Hewlett Packard Enterprise Support Center More Information on Access to Support Materials page:

Chapter 14
Support and other resources
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www.hpe.com/support/AccessToSupportMaterials

Access to some updates might require product entitlement when accessed through the Hewlett
Packard Enterprise Support Center. You must have an HPE Passport set up with relevant
entitlements.

Customer self repair
Hewlett Packard Enterprise customer self repair (CSR) programs allow you to repair your product. If a CSR part
needs to be replaced, it will be shipped directly to you so that you can install it at your convenience. Some parts
do not qualify for CSR. Your Hewlett Packard Enterprise authorized service provider will determine whether a
repair can be accomplished by CSR.

For more information about CSR, contact your local service provider or go to the CSR website:

http://www.hpe.com/support/selfrepair

Remote support
Remote support is available with supported devices as part of your warranty or contractual support agreement. It
provides intelligent event diagnosis, and automatic, secure submission of hardware event notifications to Hewlett
Packard Enterprise, which will initiate a fast and accurate resolution based on your product's service level.
Hewlett Packard Enterprise strongly recommends that you register your device for remote support.

If your product includes additional remote support details, use search to locate that information.

Remote support and Proactive Care information
HPE Get Connected

www.hpe.com/services/getconnected
HPE Proactive Care services

www.hpe.com/services/proactivecare
HPE Proactive Care service: Supported products list

www.hpe.com/services/proactivecaresupportedproducts
HPE Proactive Care advanced service: Supported products list

www.hpe.com/services/proactivecareadvancedsupportedproducts

Proactive Care customer information
Proactive Care central

www.hpe.com/services/proactivecarecentral
Proactive Care service activation

www.hpe.com/services/proactivecarecentralgetstarted

Warranty information
To view the warranty for your product or to view the Safety and Compliance Information for Server, Storage,
Power, Networking, and Rack Products reference document, go to the Enterprise Safety and Compliance website:

www.hpe.com/support/Safety-Compliance-EnterpriseProducts

Additional warranty information
HPE ProLiant and x86 Servers and Options

www.hpe.com/support/ProLiantServers-Warranties
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HPE Enterprise Servers
www.hpe.com/support/EnterpriseServers-Warranties

HPE Storage Products
www.hpe.com/support/Storage-Warranties

HPE Networking Products
www.hpe.com/support/Networking-Warranties

Regulatory information
To view the regulatory information for your product, view the Safety and Compliance Information for Server,
Storage, Power, Networking, and Rack Products, available at the Hewlett Packard Enterprise Support Center:

www.hpe.com/support/Safety-Compliance-EnterpriseProducts

Additional regulatory information

Hewlett Packard Enterprise is committed to providing our customers with information about the chemical
substances in our products as needed to comply with legal requirements such as REACH (Regulation EC No
1907/2006 of the European Parliament and the Council). A chemical information report for this product can be
found at:

www.hpe.com/info/reach

For Hewlett Packard Enterprise product environmental and safety information and compliance data, including
RoHS and REACH, see:

www.hpe.com/info/ecodata

For Hewlett Packard Enterprise environmental information, including company programs, product recycling, and
energy efficiency, see:

www.hpe.com/info/environment

Documentation feedback
Hewlett Packard Enterprise is committed to providing documentation that meets your needs. To help us improve
the documentation, send any errors, suggestions, or comments to Documentation Feedback
(docsfeedback@hpe.com). When submitting your feedback, include the document title, part number, edition,
and publication date located on the front cover of the document. For online help content, include the product
name, product version, help edition, and publication date located on the legal notices page.
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Finding and Maintaining Networking Devices
To find and maintain Networking devices, Hewlett Packard Enterprise recommends using the Network Discovery
Tool. Note that this tool does not replace or augment full-featured Network Management software.

To install the Network Discovery Tool, follow these steps:

Procedure

1. From a PC (running Windows Vista SP2, Windows 7 SP1, 8, 2008 SP2 or R1 SP1, or later), type in the URL*
for the Network Discovery Tool into a browser’s address field and press Enter.

2. When asked, open the file. In the resulting folder, double-click the file setup. Accept running the install.

3. Upon completion, the tool runs automatically. (Note: If .NET is not installed on your system, you may be
prompted to install it. Follow the installation instructions.)

*For additional information, contact http://www.hpe.com/networking/support.

When updating the Network Discovery Tool software, you must first uninstall the old version before
installing the new one.

Run the Network Discovery Tool shortly after powering on newly installed devices. By default, only new
Networking devices will display. Use the filter drop-downs to specify device age, type, and so on, Double-click on
a device to start its web user interface.

For additional information, visit the Network Discovery Tool’s internal help page.

Appendix A
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Compliance

RFC 4292
Switch families indicted in the Abstract section of the Basic Operations Guide enjoy full conformance of the RFC
4292.

RFC defines a portion of the Management Information Base (MIB) for use in managing objects related to the
forwarding of Internet Protocol (IP) packets in an IP version-independent manner. It is to be noted that the MIB
definition described herein does not support multiple instances based on the same address family type. However,
it does support an instance of the MIB per address family.

RFC 4292 supported operations
Both GET and SET operations are now supported on switches. RFC 4292 is supported in the following ways:

1. The set operation can create IPv4 and IPv6 static routes which include the functions for Reject, Remote, and
Blackhole.

2. A column of any existing row with RowStatus “Active” will not be allowed for modification.

3. Rowstatus will not support “Create-and-wait”.

4. There is an existing HPE proprietary MIB, hpicfIpStaticRouteTable, which is used to configure IPv4 and
IPv6 static routes. Currently CLI commands use this proprietary MIB for configuration. This will remain
unchanged.

5. The SET functions for inetCidrRouteTable (k_test, k_ready, k_setDefaults and k_set) are implemented.
The implementation maps to the existing SET routines of hpicfIpStaticRouteTable with the necessary
changes. Index of InetCidrRouteTable has RoutePolicy whereas hpicfIpStaticRouteTable has
IfIndex. Both MIBs have 6 objects as index.

6. The current GET implementation of inetCidrRouteTable is directly accessing the Gated Routing table to
retrieve all the routes which include Static and Dynamic. The SET routines will have to go through the
hpicfIpStaticRouteTable SET functions as these routes are of type Static.

Appendix B
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7. Creation, modification, or deletion of Dynamic route entry is not allowed. This can be achieved by validating
the MIB column inetCidrRouteProto for Static or Dynamic protocol.

8. gateD(routing stack) does not discard any routes, so the value of inetCidrRouteDiscards MIB will always
be 0.

Figure 54: MIB mapping

RFC 4292 MIB operations
To make the switch software fully compliant to RFC 4292, both GET and SET operations are supported as
indicated in the table below.

Table 10: GET and SET operations

inetCidrRouteTable Type Access

inetCidrRouteDestType* InetAddressType, Not-accessible

inetCidrRouteDest* InetAddress, Not-accessible

inetCidrRoutePfxLen* InetAddressPrefixLength, Not-accessible

inetCidrRoutePolicy* OBJECT IDENTIFIER, Not-accessible

inetCidrRouteNextHopType* InetAddressType, Not-accessible

inetCidrRouteNextHop* InetAddress Not-accessible

Table Continued
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inetCidrRouteTable Type Access

inetCidrRouteIfIndex InterfaceIndexOrZero, Read-Create

inetCidrRouteType INTEGER, Read-Create

inetCidrRouteProto IANAipRouteProtocol, Read-Only

inetCidrRouteAge Gauge32, Read-Only

inetCidrRouteNextHopAS InetAutonomousSystemNumber, Read-Create

inetCidrRouteMetric1 Integer32, Read-Create

inetCidrRouteMetric2 Integer32, Read-Create

inetCidrRouteMetric3 Integer32, Read-Create

inetCidrRouteMetric4 Integer32, Read-Create

inetCidrRouteMetric5 Integer32, Read-Create

inetCidrRouteStatus RowStatus Read-Create

* INDEX OBJECTS

JITC authorization requirements
The Joint Interoperability Test Command (JITC) conducts testing of national security systems and information
technology systems hardware, software, and components. Hewlett Packard Enterprise is in compliance with JITC
which provides the following.

• Logs of security-related events with new login credentials separate from operator or manager credentials.

• Log message when the event log wraps.

• Configuration commands that allow users to set the maximum number of concurrent sessions.

• Configuration commands which allow users to set the maximum number of concurrent sessions per user.

• Increase the delay between failed login attempts.

The HPE 3800 Switch and HPE 2920 Switch are currently UC APL certified.

Local authentication and authorization
JITC requires that access to security logs be provided through security user authentication and authorization. For
more information about JITC security authentication and authorization, see the Access Security Guide for your
switch.
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Security user log access
Security user logs are accessible when both the authentication and authorization are local. A default group called
the default-security-group is available in manager mode and has the privileges to execute the commands copy
security-log, show security-logging, and clear security-logging. When a security user is
attached to the group, they will only be able to execute these three commands. Other users will not be able to
execute the commands, no matter whether they are an operator or manager.

For more information about JITC security user log creation and access, see the Access Security Guide for your
switch.

Authentication and Authorization through RADIUS
For RADIUS authentication and authorization, the security user will be able to access to security log by
configuring the file located on RADIUS server. For more information about JITC authentication and authorization
through RADIUS, see the Access Security Guide for your switch.

Authentication and Authorization through TACACS
For TACACS authentication and authorization, the user can access to security log by configuring the file located
on TACACS server. For more information about JITC security authentication and authorization, see the Access
Security Guide for your switch.

Common access card (two-factor) authentication

Overview
A common access card (CAC) is a United States Department of Defense (DoD) smart card for multifactor
authentication. CACs are issued as standard identification for active-duty military personnel, reserve personnel,
civilian employees, non-DoD government employees, state employees of the National Guard, and eligible
contractor personnel. In addition to its use as an ID card, a CAC is required for access to government buildings
and computer networks.

Two-factor authentication
Part of the requirement necessary to satisfy the Federal Government Certification is two-factor authentication.
Two-factor authentication is the redundant authentication of the CAC. For example, the CAC satisfies two-factor
authentication by mandating that you have both the physical card and know the pin number associated with the
card.

To provide support for CAC authentication, the requirement for the network is the establishment of SSH
connections. Two-factor authentication constitutes authentication based on public key or certificate and
username/password on the switch.

Restrictions
The following are some of the restrictions when working with CAC authentication:

• Support is not provided for any other management connections other than SSH.

• Support is not provided for any switch acting as CAC SSH client.

• Support is not provided for public-key authentication based on DSA and ECDSA public keys.

• The maximum number of client public keys that can be installed is 10.

• When there is failure in any one of the authentication methods, the SSH connection will not be established.

• The following table lists the invalid authentication methods for SSH.
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login enable

public-key certificate

public-key two-factor-certificate

certificate public-key

certificate two-factor-public-key

two-factor-public-key certificate

two-factor-public-key two-factor-certificate

two-factor-certificate public-key

two-factor-certificate two-factor-public-key

Expected behaviors
With include-credentials command

• When the command include-credentials is enabled, public keys are stored both in configuration and
flash files.

• When the command no include-credentials is executed, the client public key is stored only in the flash.

• When the command no include-credentials store-in-config is executed, behavior is then based
on the user entry made with the pop-up message.

The command switch(config)# no include-credentials store-in-config will display a
message similar to:

This will remove any switch passwords and inactive SSH 
authorized keys from all configuration files.  This will also restore
 the functionality to store only a single set of passwords and authorized 
keys on the switch.

Continue (y/n)?  y
The SSH authorized keys associated with the active configuration will be 
deleted.

Would you like to retain these as the switch global SSH authorized keys 
(y/n)?  y

If the above option entered is “y”, then the client public key will be 
available in the flash but not in the config.

If the above option entered is “n”, then the client public key is neither 
available in the flash nor in the config.

Zeroization

When the zeroization command switch(config)# crypto key zeroize ssh-client-key is executed,
the client public keys will be zeroized in the flash.
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switch(config)# crypto key zeroize ssh-client-key

The manager key pair will be deleted, continue (y/n)? y 

The command erase all zeroize will also perform the 
zeroization of the key files in the flash.

The command erase all will only delete the key files from 
flash.
      
Switch is moved to/from enhanced security mode

Since the secure mode change goes through zeroization, the client keys are deleted and the switch will revert to
the default configuration without any client keys on the switch.

Attempting to configure a two-factor authentication method with no public key or username configured

If, during the download of the configuration file, the username and/or public key is not configured, then no action
will be taken. A warning message will display similar to:

username and/or public key is not configured.
An RMON will be logged with the message that the authentication method is set to two-factor with some
configuration missing.

When the user tries to connect using SSH, the connection will fail.

Deletion of the public key and/or username when the authentication method is set to two-factor
authentication

For the following three scenarios:

• After the authentication method is set to two-factor, if the client public keys are deleted while the usernames
still exists on the switch...

• After the authentication method being set to two-factor, if the username is deleted the public key exists on the
switch...

• When both the public key and usernames are deleted while the authentication method is being set to two-
factor authentication...

The new SSH connection will fail at either the public key authentication and/or username/password
authentication. RMON will be logged with appropriate message on the switch.

An alternative solution is to block the deletion of the public key and/or username when the
authentication method is set as two-factor authentication. With this approach, the impact of many
configurations need to be taken care cautiously since the username/password can be configured
through many interfaces such as SNMP, REST, WebUI, Menu, setup mgmt.-interfaces, and include-
credentials.

Authentication method re-configured at run time

If the authentication method is reconfigured at run time, the modified authentication method will be applied when
the new connection will be established.
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Secure Mode
With this release, the 3810M switch in secure mode is in compliance with the Federal Information Processing
Standards (FIPS). For more information, see the Access Security Guide of your switch.

Federal government certification
The following phase 3 certification features are included in the 16.03 release.

Local command audit logging

The logging of all administrative actions on a device is a requirement for NDcPP certification:

• All administrative actions (commands) must be logged locally.

• Enabling and disabling of command log storage is required.

• The identity of a user causing an event must be logged.

• When the command log is exhausted by 80% and wraparound occurs, the event must be logged and a trap
must be generated.

• The logs have a maximum of 240 characters and are stored in the command log buffer. If the log message
exceeds this maximum length, it is truncated and is not stored in the command log buffer.

Password storage in SHA-256 format

On Aruba switches, passwords can be configured either in plaintext or SHA-1 format. You can now configure the
passwords in SHA-256 format as well. For more information, see the Access Security Guide of your switch.

SSH Re-keying

To comply with RFC 4251, session re-keying ensures that either the SSH server or the SSH client initiates a re-
key. This results in a new set of encryption and integrity keys to be exchanged between them. Once the re-key is
complete, new keys are used for further communication, which ensures that the same key is not used for a long
duration and the security of the session is maintained. For more information, see the Access Security Guide of
your switch.

OSPFv3 RFC compliance

This feature supports authentication for OSPFv3 routing traffic on Aruba devices via IPsec. The authentication
support for OSPFv3 is provided in compliance with RFC 4552. Authentication is supported using AH protocol.
Authentication and confidentiality support using ESP is not supported in this release. For more information, see
the IPv6 Configuration Guide of your switch.

X.509v3 certificate extension RSA minimum key support

There are three requirements for NDcPP certification:

• Minimum secure RSA key size.

• Enforcement of TLS 1.1/TLS 1.2 for all TLS connections.

• Validation of extended key usage extension for X509v3 certificates.

As part of the minimum secure RSA key size requirement, an option has been added to the existing tls
configuration command to support minimum TLS version support for cloud application requirement.
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X.509v3 certificate authentication for SSH

This feature supports user-authentication in SSH using X.509v3-based certificates. For more information, see the
Access Security Guide of your switch.
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Managing the device link detection protocol
(DLDP)

Enabling or disabling DLDP
Device Link Detection Protocol (DLDP) must be enabled globally and on one or more interfaces to begin
monitoring. DLDP is disabled by default.

• To enable DLDP on the switch, use the command dldp enable.

• To disable DLDP on the switch, use the command dldp disable.

• To disable DLDP globally, use the command no dldp enable.

Setting the DLDP advertisement interval
Setting the DLDP advertisement interval appropriately for your network environment assures that DLDP can
detect unidirectional links before network performance deteriorates. Hewlett Packard Enterprise recommends
keeping the advertisement interval the same across the link partners.

• To set the advertisement interval, use the command dldp interval <1-100>, specifying a value between
1 and 100 seconds.

• To reset the advertisement interval to the default value of 5 seconds, use the command no dldp interval.

Enabling and disabling types of DLDP debugging
• To enable specific types of debugging for DLDP on the specified ports, use the following command:

debug dldp all|error|event| packet|state-machine|timer <port-list>
• To disable specific types of debugging for DLDP on the specified ports, use the following command:

no debug dldp all|error|event| packet|state-machine|timer <port-list>

Arguments:

all

Display all DLDP debug messages.

error

Display all DLDP error messages.

event

Display all the DLDP event messages.

Appendix C
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packet

Display all DLDP packet messages.

stat-machine

Display all DLDP state machine messages.

timer

Display all DLDP timer messages.

port-list

Display all DLDP debug messages for the listed port.

Clearing statistics on DLDP packets
Procedure

1. To clear statistics on DLDP packets that pass through the specified ports, use the following command:

clear statistics dldp <port-list>
2. To clear statistics on DLDP packets that pass through all ports, use the following command:

clear statistics dldp all

Viewing DLDP configuration information and statistics
• To view the DLDP statistics for the specified ports, use the command show dldp statistics <port-

list>. The port-list argument specifies a single port, a list of ports, or a range of ports.

• To view the DLDP statistics for all ports, use the command show dldp statistics all
• To view the DLDP configuration information and statistics for the specified ports, use the command show

dldp <port-list>. The port-list argument specifies a single port, a list of ports, or a range of ports.

• To view the DLDP configuration information and statistics for all ports, use the command show dldp all.

The following examples shows the DLDP statistics for port number a1.

show dldp statistics a1 

Status and Counters - Device Link Detection Protocol
Port : a1 
Packets Sent                           : 256
Packets Received                       : 255
Invalid Packets Received               : 0
Authentication Failed Packets Received : 0
Valid Packets Received                 : 255
The following example shows the DLDP statistics for ports a1 through a3.

show dldp statistics a1-a3

Status and Counters - Device Link Detection Protocol
Port : a1
Packets Sent                           : 256
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Packets Received                       : 255
Invalid Packets Received               : 0
Authentication Failed Packets Received : 0
Valid Packets Received                 : 255
Port : a2
Packets Sent                           : 256
Packets Received                       : 255
Invalid Packets Received               : 0
Authentication Failed Packets Received : 0
Valid Packets Received                 : 255
Port : a3 
Packets Sent                           : 0
Packets Received                       : 0
Invalid Packets Received               : 0
Authentication Failed Packets Received : 0
Valid Packets Received                 : 0
The following example shows the DLDP configuration information and statistics for port number a1.

show dldp a1
The output will display sensitive information. Continue (y/n)?

Status and Configuration - Device Link Detection Protocol
Global Status         : Enabled
Advertisement Interval (Sec) : 5 
Authentication Mode          : None
Authentication Password      : Password
Unidirectional Shutdown Mode : Auto
DelayDown Timer Value (Sec)  : 1
Number of DLDP Enabled Ports : 2
Interface A1
DLDP Port State     : Bidirectional
Number of Neighbors : 1 (Maximum number ever detected: 2)

Port      Port        Link     Neighbor MAC  Neighbor    Neighbor      Neighbor
        State        State    Address       Port Index               Aged Time
----- --------------- -------- ------------- ------------ ------------   ------- 
A1    Unidirectional    up      010fe2-000004     5       unconfirmed    0
The following example shows the DLDP configuration information and statistics for ports a1 through a3.

show dldp a1-a3
The output will display sensitive information. Continue (y/n)?

Status and Configuration - Device Link Detection Protocol
Global Status         : Enabled
Advertisement Interval (Sec) : 5 
Authentication Mode          : None
Authentication Password      : Password
Unidirectional Shutdown Mode : Auto
DelayDown Timer Value (Sec)  : 1
Number of DLDP Enabled Ports : 2
Interface A1
DLDP Port State     : Unidirectional
Number of Neighbors : 1 (Maximum number ever detected: 2)
Interface A2
DLDP Port State     : Bidirectional
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Number of Neighbors : 1 (Maximum number ever detected: 2)
Interface A3
DLDP Disabled

Port        Port      Link     Neighbor MAC   Neighbor    Neighbor     Neighbor
          State       State    Address        Port Index             Aged Time
----- ---------------   ------- ------------- ---------- ------------ -------- 
 A1     Unidirectional   up      40a8f0-9e2100     2      unconfirmed    0
 A2     Bidirectional    down     010fe2-000004     3      unconfirmed    0 

Setting the DLDP delaydown timer
The DLDP DelayDown timer specifies the delay, in seconds, before down ports are rechecked.

• To set the DLDP DelayDown timer, use the command dldp delaydown-timer <1-5> , specifying a value
between 1 and 5 seconds.

• To reset the DLDP DelayDown timer to the default value of 1 second, use the command no dldp
delaydown-timer.

Setting DLDP unidirectional-shutdown mode
On the detection of a unidirectional link, the port can be shut down either automatically or manually. This setting
controls whether the shutdown is automatic or manual.

Procedure

1. To set the DLDP unidirectional-shutdown mode, use the following command:

dldp unidirectional-shutdown auto|manual
2. To reset the DLDP unidirectional-shutdown mode to the default value (automatic shutdown), use the following

command:

no dldp unidirectional-shutdown

When DLDP detects a unidirectional port, an event is logged and the port must be shut down
manually by an administrator. In the event that the link state is restored to bidirectional and the
shutdown mode is manual, the user must manually bring up the port. Any dynamic change of the
shutdown mode (that is, auto to manual) will take effect only when DLDP is disabled globally and
enabled again. Likewise, When the link state is restored to Bidirectional and the shutdown mode is
manual, the user must manually bring up the port.

Also, any dynamic change of the shutdown mode (that is, auto->manual/vice versa) will be taken into
effect only when DLDP is disabled globally and enabled back again

Setting the DLDP authentication-mode
The authentication mode determines the type of authentication that DLDP uses. By default, no authentication is
used. Hewlett Packard Enterprise recommends keeping the authentication mode the same between link partners
or it will fail and log errors.
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• To set the DLDP authentication mode, use the following command:

dldp authentication-mode none|md5|simple
• To reset the DLDP authentication mode to the default value (no authentication), use the following command:

no dldp authentication-mode

This is equivalent to specifying none when setting the authentication mode.

Authentication modes:

none

Do not perform DLDP authentication (default).

md5

Authenticate using MD5.

simple

Authenticate using a plain text password.

Setting or removing a DLDP authentication password
• To set the DLDP authentication password to a plain text value, use the following command:

dldp authentication-password simple
• To set the DLDP authentication password to an encrypted value (a base64-encoded aes-256 encrypted string),

use the following command:

dldp authentication-password encrypted
• To remove the DLDP authentication password, use the following command:

no dldp authentication-password

When encrypt-credentials is enabled, the encrypted parameter is displayed. When configuring the
authentication password after configuring the authentication mode, the authentication mode defaults
to none (advertised in PDUs) regardless of which authentication mode you attempt to configure.

If you do not configure the authentication password after you configure the authentication mode, the
authentication mode will be none (advertised in PDUs) no matter which authentication mode you
configure.

The following example shows disabled encrypt-credentials.

dldp authentication-password
simple

Set the authentication password to plain text.

The following example shows enabled encrypt-credentials.

dldp authentication-password
simple

Set the authentication password to plain text.

encrypted

Global encryption key, specified using a base64-encoded aes-256 encrypted string.
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The following example shows both in secure mode.

dldp authentication-password simple
Password will be prompted interactively as above and sets the entered value in the configuration.

Enter Password:
Re-Enter Password:
In Download mode, the authentication password must be accepted as inline parameter only, and not be prompted
interactively.

Include-credentials and encrypt-credentials
considerations
The output of show running-config will be modified if encrypt-credentials is enabled or disabled. The
running-config output changes when include-credentials or encrypt-credentials is enabled or
disabled.

Table 11: Include/exclude credentials

Include
credentials

Encrypt
credentials

show run output Reboot with Saved
Config

Download config file

Disabled Disabled DLDP authentication-
password will not be
displayed.

The plain-text
password in the
Config will be used
to update the
protocol data
structure.

Mis-Configuration (Password
cannot be configured in this
case because password is
not available in downloaded
config.)

Disabled Enabled DLDP authentication-
password will not be
displayed.

The encrypted
password in the
Config will be
decrypted and used
to update the
protocol data
structure.

Mis-Configuration (Password
cannot be configured in this
case because password is
not available in downloaded
config.)

Enabled Disabled DLDP authentication-
password will be
displayed in plain-
text.

The plain-text
password in the
Config will be used
to update the
protocol data
structure.

DLDP authentication-
password stored as plain-
text.

Enabled Enabled DLDP authentication-
password will be
displayed in
encrypted form.

The encrypted
password in the
Config will be
decrypted and used
to update the
protocol data
structure.

DLDP authentication-
password stored as
encrypted.
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dldp authentication-password

dldp authentication-password simple

Enter Password: ****
Re-Enter Password: ****

include-credentials and encrypt-credentials are disabled

show running-config

Running configuration:

encrypt-credentials is enabled and include-credentials is disabled

encrypt-credentials

show running-config

Running configuration:

include-credentials is enabled and encrypt-credentials is disabled

include-credentials

show running-config

Running configuration:

dldp authentication-password simple test
      

encrypt-credentials and include-credentials are enabled

encrypt-credentials

include-credentials

show running-config

Running configuration:
dldp authentication-password encrypted “QFg8OTxYyLMEnFvQt6o542tAmbk4RrH4dO0C60oFokI=”
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Restrictions for DLDP
• DLDP is mutually exclusive with UDLD running on the port and some of the other protocol running on the

switch.

• DLDP is not supported on Distributed trunks that is, cannot be enabled on individual port of a DT trunk.

• DLDP is not supported on DYN trunk

• DLDP PKT received on a DLDP disabled port will not be forwarded and will be dropped by the switch. If DLDP
is globally disabled on the switch, DLDP pkts received will be reforward on the same VLAN.

Overview of device link detection protocol (DLDP)
DLDP is active on the following switches:

Aruba 2530 Switches
Aruba 2920 Switch
Aruba 2930F Switches
Aruba 2930M Switches
Aruba 3810 Switches
HPE 2620 Switch
HPE 3800 Switches
HPE 5400R Switches (both v2 and v3 blades)

Device link detection protocol (DLDP) is switch technology that detects any unidirectional link failures that can
occur in a network. Typically these unidirectional link failures occur among devices connected through fiber-optic
or copper twisted pair (such as category 5 twisted pair) cables. Upon detecting a link failure, the link PHY will be
kept UP and will be blocked in the hardware. All the upper layer protocols of the switch software (STP, LACP, and
so on) will see the interface as DOWN.

Enabling and disabling DLDP: Enable or disable the Device Link Detection Protocol (DLDP) to monitor link
status. DLDP must be enabled globally and on one or more interfaces to begin monitoring. DLDP is disabled by
default.

Advertisement interval: This is the interval between sending DLDP advertisement packets. Setting the DLDP
advertisement interval appropriately for your network environment assures that DLDP can detect unidirectional
links before network performance deteriorates. Hewlett Packard Enterprise recommends keeping the
advertisement interval the same across the link partners or DLDP can fail and produce an error log.
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DLDPDUs are sent as untagged PKTs on default VLAN. No support for tagged advertisements.

Figure 55: Link

DLDP can be enabled on a maximum of 128 ports with each DLDP enabled port can have up to 4
neighbors (with the exception of the switch 2530.

On the Switch 2530, DLDP can be enables on a maximum of 12 ports with each DLDP enabled port
allowed up to 4 neighborhoods.

Figure 56: Broken link
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Mobile web interface
Mobile web interface is available on the following switches:

Switch 2530
Switch 2620

The Mobile Web Interface feature provides a subset of functionality currently available in the existing web
interface but designed for use on mobile devices such as smart phone or tablet.

Viewing web management-to-server configurations
Use the command Show web-management to view the web management-to-server configuration.

The SSL Port is displayed only if HTTPS Access is enabled. The Idle Timeout and Support URL are displayed if
either HTTP or HTTPS is enabled.

The following example shows the display of web management-to-server configuration.

show web-management

Web Management - Server Configuration 
HTTP Access           : Enabled
HTTPS Access          : Enabled
SSL Port              : 433
Idle Timeout          : 7200 seconds

Appendix D
Mobile web interface
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ArubaOS‐Switch Software Feature Support Matrix 16.07 
YA-YB/YC/WC/YC/KB Switches (minimum firmware versions)

Software Features
Firmware Prefix

2530
YA/YB

2540
YC

2930F
WC

2930M
WC

3810M
KB

5400R 
KB

Bridging
Data Link Detection Protocol (DLDP) YA.15.17/YB.15.17 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.17
Distributed Trunking PIM-DM n/a n/a n/a n/a KB.16.01 KB.15.17
Distributed Trunking PIM-SM n/a n/a n/a n/a KB.16.01 KB.15.18
Distributed Trunking Primary/Secondary Configuration n/a n/a n/a n/a KB.16.01 KB.15.15
Distributed Trunking Switch to Server n/a n/a n/a n/a KB.16.01 KB.15.15
Distributed Trunking Switch to Switch n/a n/a n/a n/a KB.16.01 KB.15.16
GVRP YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
LACP (802.3ad) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
LACP Key for Controlling Dynamic Trunk Configuration YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
LACP MAD n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
LACP Trunk Load Balancing Information Output YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
LLDP (802.1ab) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
LLDP MED (Media Endpoint Discovery) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
LLDP PoE+ Support YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
LLDP over OOBM n/a n/a n/a WC.16.04.0004 KB.16.01 KB.16.01
LLDP TLV YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Loop Protection YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
MAX VLANs: 512 YA.15.10/YB.15.12 YC.16.02.0012 n/a n/a n/a n/a
MAX VLANs: 1K n/a n/a n/a n/a n/a n/a
MAX VLANs: 2K n/a n/a WC.16.02.0003 WC.16.04.0004 n/a n/a
MAX VLANs: 4K n/a n/a n/a n/a KB.16.01 KB.16.01
Meshing: Concurrent Meshing and Routing n/a n/a n/a n/a KB.16.01 KB.15.15
Meshing: Mesh ID Configuration n/a n/a n/a n/a KB.16.01 KB.15.15
Meshing: Switch Meshing n/a n/a n/a n/a KB.16.01 KB.15.15
MVRP: Multiple VLAN Registration Protocol YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Q-in-Q n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Single Instance (802.1d-1998) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SmartLink YA.15.14/YB.15.14 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Spanning tree: BPDU Filtering YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Spanning tree: BPDU Protection YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Spanning tree: Fast Mode YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Spanning tree: Loop Guard YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Spanning tree: Multiple STP (802.1s Standards Compliant) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

Spanning tree: 64 MSTP instances n/a n/a   n/a n/a KB.16.01 KB.16.01
Spanning tree: PVST Protection and Filtering YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Spanning tree: PVST+ Compatibility YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Spanning tree: Rapid STP (802.1w Standards Compliant) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Spanning tree: Root Guard YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Trunking: Enable using TCP/UDP Port Numbers for Trunk Load-
Balancing YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Trunking: Link Aggregation YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
UDLD: Uni-Directional Link Detection YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
UDLD: Verify Before Forwarding YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.16
UFD: Uplink Failure Detection n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

VxLAN n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Wake-on-LAN for a Specific VLAN n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

Management
802.1ap Std MIB Support YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

802.3bz compliance (2.5 Gbps and 5.0 Gbps) for Smart Rate ports n/a n/a n/a WC.16.04.0008 KB.16.04.0008
KB.16.04.0008 (V3 
only)

100Mbps support on SmartRate ports n/a n/a n/a WC.16.06 KB.16.06 KB.16.06
IPSec to Controller for Management Traffic n/a YC.16.02 WC.16.02 WC.16.02 KB.16.02 KB.16.02

IPSec for Management Traffic (with secondary controller support) n/a YC.16.06 WC.16.06 WC.16.06 KB.16.06 KB.16.06
ARP Attack Detection n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Aruba Central on-boarding YA.16.07/YB.16.07 YC.16.07 WC.16.07 WC.16.07 KB.16.07 KB.16.07
Auto-MDI-X YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Banner: Post-Logon User-Configurable Banner Display YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Bidirectional Secure Copying Between Switch and SFTP Server YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
BOOTP/DHCP Relay Gateway YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
BPDU-Throttle n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.16
BYOD Redirect YA.15.16 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.16
Captive Portal for ClearPass YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.16.01
Chassislocate LED at Boot YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Clarify Port VLAN Tagged Status YA.15.12/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Clear Module Configuration n/a YC.16.02.0012 n/a n/a n/a KB.15.15
CLI Return Message Category (Error; Warning; Information) YA.15.10/YB.15.12 n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Compliance with IEEE Standard for MIB Object ieee8021MstpMib YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Comware CLI Support YA.15.11/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Config Backup and Restore without Reboot YA.16.05/YB.16.05 YC.16.05 WC.16.05 WC.16.05 KB.16.05 KB.16.05
Config Menu YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Control Plane Protection n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Control Plane Policing (CoPP) n/a n/a WC.16.04.0008 WC.16.04.0008 KB.16.04.0008 KB.16.04.0008
Custom Default Switch Configuration YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Customized Commands for Local User Accounts YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Device Profile: Auto configuration for Aruba APs/Switches YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Device Profile: Auto configuration for Custom device types YA.16.01/YB.16.01 YC.16.02.0012 WC.16.04.0008 WC.16.04.0008 KB.16.04.0008 KB.16.04.0008
DHCP Client DNS Support YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
DHCPv6 Client Options YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
DHCP Option 82 YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
DHCP Option 60 and 150 n/a YC.16.06 WC.16.06 WC.16.06 KB.16.06 KB.16.06

DHCP Relay YA.15.14/YB.15.14 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
DHCPv6 Relay n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
DHCPv6 Relay Option 79 n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.16
Disable IP Address on a VLAN Without Deleting the Address YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

Disable Username Prompt for Management Interface Authentication YA.15.15/YB.15.15 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Display Configuration of Selected Interface YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Display Transceiver YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
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Display Transceiver Information for Transceiver Cable Diagnostics YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
DNS Capabilities for Telnet YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Dual Flash Images YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Encoded Version Info Added to Config Files YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Encrypt Passwords and Authentication Keys in the Config File YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Event Log: Severity Change YA.15.12/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Event Log Buffer: Configurable threshold for SNMP traps YA.16.06/YB.16.06 YC.16.06 WC.16.06 WC.16.06 KB.16.06 KB.16.06
Fastboot YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Fault Finder Extended to Cover Flapping Transceiver Mitigation YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Fault Finder (Per Port Enable) n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 n/a
Filtering PVID Mismatch Log Message YA.15.14/YB.15.14 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Find-Fix-and-Inform YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Flow Control (802.3x) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Generic Header ID in Config File YA.15.16/YB.15.16 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.16
Grouped Config File Display per Interface YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
ICMP Throttling YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
IP Forwarding MIB YA.15.17/YB.15.17 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.17
IP Service Level Agreement (SLA) n/a YC.16.02.0012 WC.16.02.0008 WC.16.04.0004 KB.16.02 KB.16.02
IP Stacking YA.15.10/YB.15.12 n/a n/a n/a n/a n/a
IPv6 DNS via RA Options n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
IPv6 Host (Dual Stack) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Local Management Privilege Groups YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
MAC Limit Notify YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Management Interface Wizard YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Minimum Password Length YA.15.15/YB.15.15 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Module Reload n/a n/a n/a n/a n/a KB.15.15
MS-CHAPv2 for Switch Management Interface YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Multiple Configuration Files YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
NTP: Network Time Protocol YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
OOBM: IPv6 Host Function n/a n/a n/a WC.16.04.0004 KB.16.01 KB.15.15
Avoid double tunneling of Aruba APs on Tunneled Node n/a n/a WC.16.05 WC.16.05 KB.16.05 KB.16.05
PTP (Precision Time Protocol) IEEE 1588 n/a n/a n/a WC.16.04.0004 n/a n/a
Readable Interface Names in Traps YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Reinterpret CDP Info when Using IP Phones YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Report Config Changes Per-User Per-Session YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
REST APIs YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 K.16.01 KB.16.01
Retain configuration on 5400R 
when switching from v3-only to v-2 compatible mode n/a n/a n/a n/a n/a KB.16.02
RMON YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RMON: Extended RMON YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RMON: Local Alarm Threshold YA.15.13/YB.15.13 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Save Running Configuration to TFTP via SNMP YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Saving Security Credentials in a Configuration File YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Scheduled Reload YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Secure FTP YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Secure Shell v2 (SSHv2) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Secure Sockets Layer (SSL) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Send syslog Messages via TCP YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
sFlow YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
sFlow Data over OOBM n/a n/a n/a WC.16.04.0004 KB.16.01 KB.15.15
sFlow Set Agent Address YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
sFlow Using IPv6 YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Single Source IP Identity YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SNMP v1/v2c/v3/v3 with AES YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SNMP: Enable SNMP Trap when Switch Config Changes YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SNMP: MIB to Check Load of Module Slots n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SNMP: Password Set via SNMP YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SNMP: Server Source IP Commands YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SNMP: Trap if MAC Address Add to or Delete from a Port YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SNMP: Trap on MAC Address Table Changes YA.15.14/YB.15.14 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SNMP: Trap on Power Supply Removal YA.15.14/YB.15.14 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SNMP: Trap Throttling YA.15.13/YB.15.13 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SNTP: Simple Network Time Protocol YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Syslog Config Change Reporting YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Syslog over TLS YA.15.15/YB.15.15 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Syslog: Disable Debug without Affecting Syslog YA.15.13/YB.15.13 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Syslog: Per-Interface Syslog Event Enable-Disable YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Sysname in Syslog Messages YA.15.15/YB.15.15 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
TFTP & SSH Concurrent Usage YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.18
TFTP Uploadable Configuration YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Transceivers - Diagnostic Optical Monitoring 
(show interface transceiver detail) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Username and Password Length Increase YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
VLAN information added to 'show mac-address' Output YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
VSF: Virtual Switch Framework n/a n/a WC.16.03.0003 n/a n/a KB.16.01 (V3 only)
VSF 8-member Stack (2930F only) n/a n/a WC.16.06 n/a n/a n/a
Web GUI YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Web GUI Inactivity Timer YA.15.15/YB.15.15 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Next-Gen Web GUI YB.16.03 YC.16.02.0012 WC.16.02.0008 WC.16.04.0004 KB.16.03.0003 KB.16.03.0003
ZTP with TR-69 YA.15.16/YB.15.16 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 n/a n/a
ZTP with DHCP YA.16.01/YB.16.01 YC.16.01 WC.16.01 WC.16.01 KB.16.01 KB.16.01
ZTP with DHCPv6 n/a YC.16.06 WC.16.06 WC.16.06 KB.16.06 KB.16.06
ZTP for Activate YA.16.04/YB.16.04 YC.16.02.0012 WC.16.02.0010 WC.16.04.0004 KB.16.02 KB.16.02
HTTP Proxy Support YA.16.06/YB.16.06 YC.16.06 WC.16.06 WC.16.06 KB.16.06 KB.16.06
Job Scheduler YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
DHCPv4 Server n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.16
DHCPv6 Server n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.16
Console Lockout n/a YC.16.06 WC.16.06 WC.16.06 KB.16.06 KB.16.06

OpenFlow
OpenFlow 1.0 n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
OpenFlow 1.3 n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Openflow: Custom Matches n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.02 KB.16.02
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OpenFlow: L4 Match n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.18
OpenFlow: MacGroups n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.18
Openflow: Source IP specification YA.16.05/YB.16.05 YC.16.05 WC.16.05 WC.16.05 KB.16.05 KB.16.05

OpenFlow: TCP Flags and L4 port ranges in Custom Match Mode n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01(V3 ONLY)

Power
Energy Efficient Ethernet (EEE) YA.15.12/n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
External Power Support  (EPS) n/a n/a n/a n/a n/a n/a
Hibernate mode n/a n/a n/a WC.16.04.0004 n/a n/a
Power over Ethernet (POE) (802.3af) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Power over Ethernet Plus (POE+) (802.3at) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Redundant Power Support n/a n/a n/a WC.16.04.0004 KB.16.01 KB.15.15

Priority/Quality of Service (QoS)
Broadcast Control YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Broadcast Storm Control n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Classifier-Based QoS and Rate Limiting n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Egress Port Monitoring (Outbound) n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
ICMP Rate Limiting YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Inbound Rate-Limiting for Broadcast and Multicast Traffic YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Layer 4 TCP/UDP Packet Priority YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Mirroring: MAC based Mirroring n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Mirroring: MAC based Remote Mirroring n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Mirroring: no VLAN Tag added n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Mirroring: Port YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Mirroring: Remote n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Multicast Storm Control YA.16.06/YB.16.06 YC.16.06 WC.16.06 WC.16.06 KB.16.06 KB.16.06
QoS: Class of Service (CoS) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
QoS: Egress Queue Rate-limiting n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
QoS: Guaranteed Minimum Bandwidth n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
QoS: IPv6 QoS YA.15.14/YB.15.14 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

QoS: Monitor Egress Queues for Dropped Packets if QoS Configured YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
QoS: Netdestinations and Netservices YA.16.03 YC.16.03.0003 WC.16.03.0003 WC.16.04.0004 KB.16.03.0003 KB.16.03.0003
QoS: Packet Priority (802.1p) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
QoS: Per Port Trust YA.16.02 YC.16.02.0012 WC.16.02.0008 WC.16.04.0004 KB.16.02 KB.16.02
QoS: Port and Priority-based Rate Limiting YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
QoS: Priority Queuing YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
QoS: Selectable Queuing Configurations YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
QoS: Strict Priority Queuing n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
QoS: TCP/UDP Port Ranges YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
QoS: Traffic Template YA/YB. 16.01.0004 n/a WC.16.04.0008 WC.16.04.0008 KB.16.05 KB.16.05
QoS: Turn on/off VLAN Precedence YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.16
QoS: VLAN Port-Based Prioritization (802.1p) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Rate Limiting YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Rate Limiting Unknown Unicast Traffic n/a n/a WC.16.05 WC.16.05 KB.16.05 KB.16.05
Traffic Policing (with two rate three color marker) n/a n/a WC.16.06 WC.16.06 KB.16.06 KB.16.06

Routing and Multicast
ARP Age Timer Increase YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
BFD: Bidirectional Forwarding Detection (OSPF/VRRP) n/a n/a n/a n/a KB.16.01 KB.16.01 (V3 only)

BFD: Bidirectional Forwarding Detection (Static Routes) n/a n/a n/a n/a KB.16.04.0008
KB.16.04.0008 (V3 
only)

BGP: Border Gateway Protocol n/a n/a n/a n/a KB.16.01 KB.15.15
BGP: MD5 Authentication n/a n/a n/a n/a KB.16.01 KB.15.15
BGP: Route Filtering and Peer Restart Time Display n/a n/a n/a n/a KB.16.01 KB.15.15
BGP: Route Maps n/a n/a n/a n/a KB.16.01 KB.15.15
BGP: BGP-4 n/a n/a n/a n/a KB.16.01 KB.15.16
mDNS (Bonjour and Chromecast) Gateway YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Disable Overlapping Subnet Configuration YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
ECMP (Equal Cost Multipath) n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
ECMP with Static Routes n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Identification Field in Static Route Config YA.15.13/YB.15.13 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
IGMP v3 and MLD v2 Capabilities  (YA only supports MLD v1) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

Improved Log Commands and Output for OSPFv2 Troubleshooting n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.15.15
IPv6 Default gateway for OOBM n/a n/a n/a WC.16.04.0008 KB.16.04.0008 KB.16.04.0008
IPv6 Default Router Preference n/a n/a WC.16.04.0008 WC.16.04.0008 KB.16.04.0008 KB.16.04.0008

IPv6 over IPv4 Tunneling n/a n/a n/a n/a KB.16.01 KB.15.15
IPv6 Static Route Tag n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KA.15.16
IRDP n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Multicast: Block Unknown Multicast YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Multicast: IP Multicast snooping (Data Driven IGMP) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Multicast: IGMP v3 n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Multicast: IPv6 MLD Multicast Snooping YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Multi-Netting YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
OSPF (2930F & 2930M only support single-area OSPF) n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.15.15
OSPF ECMP n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.15.15
OSPF Global Cost Setting n/a n/a WC.16.05 WC.16.05 KB.16.05 KB.16.05

OSPF LSA Type 3 Summarized Prefix Cost n/a n/a n/a n/a KB.16.01 KB.15.15

OSPF LSA Type 3 Summarized Prefix Cost for OSPF v3 n/a n/a n/a n/a KB.16.01 KB.15.15
OSPF Neighbor Shutdown Notification n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.15.15
OSPF Neighbor Timer Information Display n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.15.15
OSPF NSSA Range Metrics added to OSPFv2 n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.15.15
OSPF/VRRP Nonstop Routing added to Management Failover n/a n/a WC.16.03.0003 WC.16.04.0004 KB.16.01 KB.15.15
OSPFv2 config Metric Cost/Range n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.15.15
OSPFv3 n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.15.15
OSPFv3 over 6-in-4 Tunnels n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.15.15
OSPFv3 Trap Global Enable/Disable n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.15.16
PIM: Override Reverse Path Forward (RPF) Lookup n/a n/a WC.16.03.0003 WC.16.04.0004 KB.16.01 KB.15.15
PIM: 'router pim' Command Enhancements n/a n/a WC.16.03.0003 WC.16.04.0004 KB.16.01 KB.15.15
PIM-DM n/a n/a WC.16.03.0003 WC.16.04.0004 KB.16.01 KB.15.15
PIM-SM n/a n/a WC.16.03.0003 WC.16.04.0004 KB.16.01 KB.15.15
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PIMv6 SM and DM n/a n/a WC.16.05 WC.16.05 KB.16.05 KB.16.05
Policy-Based Routing (PBR) n/a n/a WC.16.03.0003 WC.16.04.0004 KB.16.01 KB.15.15
RIP v1/v2 n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RIP v2 with MD5 Authentication n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.18
RIPng n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Router Advertisement (RA) Guard n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Service Insertion: Intercept Tunnels n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Service Insertion: Mirror Tunnels n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.17
Show IP Route Summary n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Static Blackhole or Reject Routes Redistribution into RIP n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Static Routes n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Tunneled Node (per port) n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.02 KB.16.02
Tunneled Node (per user) n/a n/a WC.16.04.0008 WC.16.04.0008 KB.16.04.0008 KB.16.04.0008
Tunneled Node: Fallback to local switching n/a n/a WC.16.02.0011 WC.16.04.0004 KB.16.02.0011 KB.16.02.0011
UDP Broadcast Forwarding n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Virtual Router Redundancy Protocol (VRRP) n/a n/a WC.16.03.0003 WC.16.04.0004 KB.16.01 KB.15.15
VRRP Preemptive Delay Timer n/a n/a WC.16.03.0003 WC.16.04.0004 KB.16.01 KB.15.15
VRRP Track Ports & Dynamic Priority Change n/a n/a WC.16.03.0003 WC.16.04.0004 KB.16.01 KB.15.15
VRRPv3 n/a n/a WC.16.03.0003 WC.16.04.0004 KB.16.01 KB.15.15
VRRP: Support for Self-Ping, Telnet, SSH, Web GUI n/a n/a WC.16.06 WC.16.06 KB.16.06 KB.16.06

Security
802.1v Protocol VLANs YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
802.1X and RADIUS Login (Port-Based Access) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
AAA Authorization on HTTPS (T5) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
ACL Grouping n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
ACL: Access Control List YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
ACL: Logging Match YA.15.15/YB.15.15 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
ACL: MAC ACLs n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.18
ACL: Rule added to IP Directed Broadcast n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.18
Advanced Threat Detection YA.16.05/YB.16.05 YC.16.05 WC.16.05 WC.16.05 KB.16.05 KB.16.05
Device Fingerprinting with ClearPass n/a n/a WC.16.06 WC.16.06 KB.16.06 KB.16.06

Cached Re-authentication (Hold State if RADIUS Server Unavailable) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Concurrent 802.1x, WebAuth, and MacAuth YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Concurrent TACACS+ and SFTP YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
DHCP Snooping YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

DHCP Snooping: CLI to clear DSnoop Counter
YA 16_03_001.SWI/YB 
16_03_001.SWI YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

DHCP Snooping: DHCPv4 Snooping Max Binding YA.15.14/YB.15.14 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

DHCP Snooping: DHCPv6 Snooping
YA.15.16/YB.15.16

YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.16
Dynamic ARP Protection YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Dynamic IP Lockdown YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Egress ACLs n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.18
IPv6 Protocol VLANs YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Local MAC Authentication YA.15.16/YB.15.16 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Local User Roles YA.16.02 YC.16.02.0012 WC.16.02.0008 WC.16.04.0004 KB.16.02 KB.16.02
Downloadable User Roles n/a YC.16.04 WC.16.04 WC.16.04 KB.16.04 KB.16.04
Downloadable User Roles 
with Secondary Role Pushed to Controller n/a n/a WC.16.05 WC.16.05 KB.16.05 KB.16.05
MAC Authentication YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
MAC Authentication: Client Limit Increased to 256 n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
MAC Authentication: Hitless Re-Authentication YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
MAC Authentication:  Port-based YA.16.02/YB.16.02 YC.16.02.0012 WC.16.02.0008 WC.16.04.0004 KB.16.02 KB.16.02
MAC Authentication Toggle YA.16.02/YB.16.02 YC.16.02.0012 WC.16.02.0008 WC.16.04.0004 KB.16.02 KB.16.02
MAC Authentication: Unauth-Redirect YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
MAC-based VLANs (MBV) YA.15.14 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
MAC-based VLANs: Controlling MBV via CLI for NAC n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.16
MAC Pinning YA.16.05/YB.16.05 n/a WC.16.05 WC.16.05 KB.16.05 KB.16.05
MACSec: SmartRate Modules n/a n/a n/a WC.16.04.0004 KB.16.01 KB.15.18
MACSec: V3 only n/a n/a n/a WC.16.04.0004 KB.16.01 KB.15.17
Multiple 802.1X Clients Per Port YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
ND Snooping n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Open Authentication Roles n/a n/a WC.16.05 WC.16.05 KB.16.05 KB.16.05
Critical Authentication Roles n/a n/a WC.16.05 WC.16.05 KB.16.05 KB.16.05
Password Complexity YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Port Monitoring YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Port Security (MAC Lockdown) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Port Security (MAC Lockout) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Port Security Auto Recovery n/a n/a WC.16.06 WC.16.06 KB.16.06 KB.16.06
Protocol Based VLANs YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Private VLAN n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
RBAC: Role Based Access Control n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
RADIUS YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RADIUS Assigned ACLs YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RADIUS Assigned GVRP VLANs YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RADIUS Attributes for QoS and Rate-Limiting YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RADIUS Authenticated mgr Level Login YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RADIUS Authentication for Browser Access YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RADIUS Configuration via SNMP YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RADIUS for 802.1X Accounting YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RADIUS IPv6 YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RADIUS Port Speed VSA n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RADIUS Service Tracking YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Source Port Filter YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SSH Client YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

SSH Re-key (Government Certification) n/a n/a WC.16.04.0008 WC.16.04.0008 KB.16.04.0008 KB.16.04.0008
Static IP Lockdown n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

Anexo 03 ITEM 10 (0592643)         SEI 0008478-63.2018.6.02.8000 / pg. 5053



Software Features
Firmware Prefix

2530
YA/YB

2540
YC

2930F
WC

2930M
WC

3810M
KB

5400R 
KB

Synchronization for 802.1X Supplicants  (for Nonstop Switching) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
TACACS+ YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

User Lockout (Government Certification) n/a n/a WC.16.04.0008 WC.16.04.0008 KB.16.04.0008 KB.16.04.0008
Virus Throttling (Connection Rate Filtering) n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Web-based Authentication YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

Supportability
Debug Command for PIM Packet Events Added n/a n/a n/a n/a KB.16.01 KB.15.15
Flight Data Recorder Log n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.02 KB.15.15
LACP Debug Logging and Show Commands YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.02 KB.15.15
Preview Mode n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01

Time Domain Reflectometry (SmartRate modules not supported) n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.02
KB.16.01
(V3 only)

Supportability Infrastructure: 
User Initiated Diagnostic Reset via Clear button YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Supportability Infrastructure: 
User Initiated Diagnostic Reset via Serial Console YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
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ArubaOS‐Switch Software Feature Support Matrix 16.07 
WB/RA/KA Switches (minimum firmware versions)

Software Features
Firmware Prefix

2920
WB

2620
RA

3800
KA

Bridging
Data Link Detection Protocol (DLDP) WB.15.17 RA.15.17 KA.15.17
Distributed Trunking PIM-DM n/a n/a KA.15.17
Distributed Trunking PIM-SM n/a n/a KA.15.18
Distributed Trunking Primary/Secondary Configuration n/a n/a KA.15.11
Distributed Trunking Switch to Server n/a n/a KA.15.09
Distributed Trunking Switch to Switch n/a n/a KA.15.16
GVRP WB.15.11 RA.15.05 KA.15.03
LACP (802.3ad) WB.15.11 RA.15.05 KA.15.03
LACP Key for Controlling Dynamic Trunk Configuration WB.15.11 RA.15.05 KA.15.09
LACP MAD WB.15.14 n/a KA.15.14
LACP Trunk Load Balancing Information Output WB.15.11 RA.15.05 KA.15.09
LLDP (802.1ab) WB.15.11 RA.15.05 KA.15.03
LLDP MED (Media Endpoint Discovery) WB.15.11 RA.15.05 KA.15.03
LLDP PoE+ Support WB.15.11 RA.15.05 KA.15.03
LLDP over OOBM WB.16.01 n/a KA.16.01
LLDP TLV WB.15.11 RA.15.05 KA.15.03
Loop Protection WB.15.11 RA.15.05 KA.15.03
MAX VLANs: 512 n/a RA.15.05 n/a
MAX VLANs: 1K WB.16.01 n/a n/a
MAX VLANs: 2K n/a n/a n/a
MAX VLANs: 4K n/a n/a KA.16.01
Meshing: Concurrent Meshing and Routing n/a n/a KA.15.09
Meshing: Mesh ID Configuration n/a n/a KA.15.07
Meshing: Switch Meshing n/a n/a KA.15.03
MVRP: Multiple VLAN Registration Protocol WB.16.01 RA.16.01 KA.16.01
Q-in-Q n/a n/a KA.15.03
Single Instance (802.1d-1998) WB.15.11 RA.15.05 KA.15.03
SmartLink WB.15.14 RA.15.14 KA.15.14
Spanning tree: BPDU Filtering WB.15.11 RA.15.05 KA.15.03
Spanning tree: BPDU Protection WB.15.11 RA.15.05 KA.15.03
Spanning tree: Fast Mode WB.15.11 RA.15.05 KA.15.03
Spanning tree: Loop Guard WB.15.11 RA.15.05 KA.15.09
Spanning tree: Multiple STP (802.1s Standards Compliant) WB.15.11 RA.15.05 KA.15.03
Spanning tree: 64 MSTP instances n/a n/a KA.16.01
Spanning tree: PVST Protection and Filtering WB.15.11 RA.15.05 KA.15.03
Spanning tree: PVST+ Compatibility WB.15.11 RA.15.05 KA.15.03
Spanning tree: Rapid STP (802.1w Standards Compliant) WB.15.11 RA.15.05 KA.15.03
Spanning tree: Root Guard WB.15.11 RA.15.05 KA.15.03
Trunking: Enable using TCP/UDP Port Numbers for Trunk Load-
Balancing WB.15.11 RA.15.05 KA.15.09
Trunking: Link Aggregation WB.15.11 RA.15.05 KA.15.03
UDLD: Uni-Directional Link Detection WB.15.11 RA.15.05 KA.15.03
UDLD: Verify Before Forwarding WB.15.16 RA.15.05 KA.15.16
UFD: Uplink Failure Detection WB.15.11 n/a KA.15.09
VxLAN n/a n/a n/a
Wake-on-LAN for a Specific VLAN WB.15.11 RA.15.05 KA.15.09
Management
802.1ap Std MIB Support WB.15.11 RA.15.09 KA.15.09

802.3bz compliance (2.5 Gbps and 5.0 Gbps) for Smart Rate ports n/a n/a n/a
100Mbps support on SmartRate ports n/a n/a n/a
IPSec to Controller for Management Traffic WB.16.02 n/a KA.16.02

IPSec for Management Traffic (with secondary controller support) WB.16.06 n/a n/a
ARP Attack Detection WB.16.01 n/a KA.16.01
Auto-MDI-X WB.15.11 RA.15.05 KA.15.03
Banner: Post-Logon User-Configurable Banner Display WB.15.11 RA.15.05 KA.15.03
Bidirectional Secure Copying Between Switch and SFTP Server WB.15.11 RA.15.05 KA.15.09
BOOTP/DHCP Relay Gateway WB.15.11 RA.15.05 KA.15.03
BPDU-Throttle WB.15.16 n/a KA.15.16
BYOD Redirect WB.15.16 RA.15.16 KA.15.16
Captive Portal for ClearPass WB.16.01 RA.16.01 KA.16.01
Chassislocate LED at Boot WB.15.11 RA.15.05 KA.15.14
Clarify Port VLAN Tagged Status WB.15.12 RA.15.12 KA.15.12
Clear Module Configuration n/a n/a n/a
CLI Return Message Category (Error; Warning; Information) WB.15.11 RA.15.05 KA.15.03
Compliance with IEEE Standard for MIB Object ieee8021MstpMib WB.15.11 RA.15.06 KA.15.06
Comware CLI Support WB.15.13 RA.15.11 KA.15.08
Config Backup and Restore without Reboot WB.16.05
Config Menu WB.15.11 RA.15.05 KA.15.03
Control Plane Protection WB.15.18 n/a KA.15.14
Control Plane Policing (CoPP) n/a n/a n/a
Custom Default Switch Configuration WB.15.11 RA.15.05 KA.15.12
Customized Commands for Local User Accounts WB.15.11 RA.15.05 KA.15.09
Device Profile: Auto configuration for Aruba APs/Switches WB.16.01 RA.16.01 KA.16.01
Device Profile: Auto configuration for Custom device types WB.16.01 n/a n/a
DHCP Client DNS Support WB.15.11 RA.15.07 KA.15.07
DHCPv6 Client Options WB.15.11 RA.15.05 KA.15.09
DHCP Option 82 WB.15.11 RA.15.05 KA.15.03
DHCP Option 60 and 150 n/a n/a n/a
DHCP Relay WB.15.11 RA.15.05 KA.15.03
DHCPv6 Relay WB.15.11  RA.15.05 KA.15.03
DHCPv6 Relay Option 79 WB.15.16  RA.16.01 KA.15.16
Disable IP Address on a VLAN Without Deleting the Address WB.15.11 RA.15.10 KA.15.09

Disable Username Prompt for Management Interface Authentication
WB.15.15 RA.15.15 KA.15.15

Display Configuration of Selected Interface WB.15.11 RA.15.05 KA.15.03
Display Transceiver WB.15.11 RA.15.07 KA.15.09
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Software Features
Firmware Prefix

2920
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2620
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3800
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Display Transceiver Information for Transceiver Cable Diagnostics
WB.15.11 RA.15.07 KA.15.06

DNS Capabilities for Telnet WB.15.11 RA.15.05 KA.15.03
Dual Flash Images WB.15.11 RA.15.05 KA.15.03
Encoded Version Info Added to Config Files WB.15.11 RA.15.05 KA.15.09
Encrypt Passwords and Authentication Keys in the Config File WB.15.11 RA.15.06 KA.15.09
Event Log: Severity Change WB.15.11 RA.15.12 KA.15.12
Event Log Buffer: Configurable threshold for SNMP traps n/a n/a n/a
Fastboot WB.15.11 RA.15.05 KA.15.03
Fault Finder Extended to Cover Flapping Transceiver Mitigation WB.15.11 RA.15.05 KA.15.03
Fault Finder (Per Port Enable) n/a n/a KA.16.01
Filtering PVID Mismatch Log Message WB.15.15 RA.15.14 KA.15.14
Find-Fix-and-Inform WB.15.11 RA.15.05 KA.15.03
Flow Control (802.3x) WB.15.11 RA.15.05 KA.15.03
Generic Header ID in Config File WB.15.16 RA.15.16 KA.15.16
Grouped Config File Display per Interface WB.15.11 RA.15.08 KA.15.08
ICMP Throttling WB.15.11 RA.15.05 KA.15.03
IP Forwarding MIB WB.15.17 RA.15.17 KA.15.17
IP Service Level Agreement (SLA) WB.16.02 n/a KA.16.02
IP Stacking n/a RA.15.05 n/a
IPv6 DNS via RA Options WB.15.11 RA.15.10 KA.15.10
IPv6 Host (Dual Stack) WB.15.11 RA.15.05 KA.15.03
Local Management Privilege Groups WB.15.11 RA.15.05 KA.15.09
MAC Limit Notify WB.15.11 RA.15.10 KA.15.09
Management Interface Wizard WB.15.11 RA.15.05 KA.15.03
Minimum Password Length WB.15.15 RA.15.15 KA.15.15
Module Reload n/a n/a n/a
MS-CHAPv2 for Switch Management Interface WB.15.11 RA.15.05 KA.15.03
Multiple Configuration Files WB.15.11 RA.15.05 KA.15.03
NTP: Network Time Protocol WB.16.01 RA.16.01 KA.16.01
OOBM: IPv6 Host Function WB.15.11 n/a KA.15.03
Avoid double tunneling of Aruba APs on Tunneled Node n/a
PTP (Precision Time Protocol) IEEE 1588 n/a n/a n/a
Readable Interface Names in Traps WB.15.11 RA.15.05 KA.15.12
Reinterpret CDP Info when Using IP Phones WB.15.11 RA.15.05 KA.15.10
Report Config Changes Per-User Per-Session WB.15.11 RA.15.05 KA.15.07
REST APIs WB.16.01 RA.16.01 KA.16.01
Retain configuration on 5400R 
when switching from v3-only to v-2 compatible mode

n/a n/a n/a

RMON WB.15.11 RA.15.05 KA.15.03
RMON: Extended RMON WB.15.11 RA.15.05 KA.15.03
RMON: Local Alarm Threshold WB.15.13 RA.15.13 KA.15.13
Save Running Configuration to TFTP via SNMP WB.15.11 RA.15.05 KA.15.03
Saving Security Credentials in a Configuration File WB.15.11 RA.15.05 KA.15.03
Scheduled Reload WB.15.11 RA.15.05 KA.15.03
Secure FTP WB.15.11 RA.15.05 KA.15.03
Secure Shell v2 (SSHv2) WB.15.11 RA.15.05 KA.15.03
Secure Sockets Layer (SSL) WB.15.11 RA.15.05 KA.15.03
Send syslog Messages via TCP WB.15.11 RA.15.10 KA.15.09
sFlow WB.15.11 RA.15.05 KA.15.03
sFlow Data over OOBM WB.15.11 n/a KA.15.13
sFlow Set Agent Address WB.15.11 RA.15.10 KA.15.07
sFlow Using IPv6 n/a RA.15.10 KA.15.07
Single Source IP Identity WB.15.11 RA.15.10 KA.15.03
SNMP v1/v2c/v3/v3 with AES WB.15.11 RA.15.05 KA.15.03
SNMP: Enable SNMP Trap when Switch Config Changes WB.15.11 RA.15.05 KA.15.09
SNMP: MIB to Check Load of Module Slots WB.15.11 n/a KA.15.10
SNMP: Password Set via SNMP WB.15.11 RA.15.05 KA.15.03
SNMP: Server Source IP Commands WB.15.11 RA.15.05 KA.15.03
SNMP: Trap if MAC Address Add to or Delete from a Port WB.15.11 RA.15.05 KA.15.09
SNMP: Trap on MAC Address Table Changes WB.15.14 RA.15.14 KA.15.14
SNMP: Trap on Power Supply Removal WB.15.14 RA.15.14 KA.15.14
SNMP: Trap Throttling WB.15.13 RA.15.13 KA.15.13
SNTP: Simple Network Time Protocol WB.15.11 RA.15.05 KA.15.03
Syslog Config Change Reporting WB.15.11 RA.15.10 KA.15.09
Syslog over TLS WB.15.15 RA.15.16 KA.15.15
Syslog: Disable Debug without Affecting Syslog WB.15.13 RA.15.13 KA.15.13
Syslog: Per-Interface Syslog Event Enable-Disable WB.15.11 RA.15.05 KA.15.13
Sysname in Syslog Messages WB.15.15 RA.15.15 KA.15.15
TFTP & SSH Concurrent Usage WB.15.15 RA.15.05 KA.15.18
TFTP Uploadable Configuration WB.15.11 RA.15.05 KA.15.03
Transceivers - Diagnostic Optical Monitoring 
(show interface transceiver detail) WB.15.11 RA.15.07 KA.15.07
Username and Password Length Increase WB.15.11 RA.15.05 KA.15.03
VLAN information added to 'show mac-address' Output WB.15.11 RA.15.05 KA.15.09
VSF: Virtual Switch Framework n/a n/a n/a
VSF 8-member Stack (2930F only) n/a n/a n/a
Web GUI WB.15.11 RA.15.05 KA.15.03
Web GUI Inactivity Timer WB.15.15 RA.15.15 KA.15.15
Next-Gen Web GUI WB.16.03.0003 RA.16.03 KA.16.03.0003
ZTP with TR-69 WB.15.18 RA.15.16 n/a
ZTP with DHCP WB.16.01 n/a KA.16.01
ZTP with DHCPv6 n/a n/a n/a
ZTP for Activate WB.16.02 n/a KA.16.02
HTTP Proxy Support WB.16.06 n/a n/a
Job Scheduler WB.16.01 RA.16.01 KA.16.01
DHCPv4 Server WB.15.16 RA.15.16 KA.15.16
DHCPv6 Server WB.15.16 RA.15.16 KA.15.16
Console Lockout n/a n/a n/a
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OpenFlow
OpenFlow 1.0 WB.15.12 n/a KA.15.10
OpenFlow 1.3 WB.15.14 n/a KA.15.14
Openflow: Custom Matches n/a n/a n/a
OpenFlow: L4 Match WB.15.18 n/a KA.15.18
OpenFlow: MacGroups WB.15.18 n/a KA.15.18
Openflow: Source IP specification WB.16.05
OpenFlow: TCP Flags and L4 port ranges in Custom Match Mode n/a n/a n/a
Power
Energy Efficient Ethernet (EEE) WB.15.11 n/a KA.15.03
External Power Support  (EPS) WB.15.13 RA.15.05 n/a
Hibernate mode n/a n/a n/a
Power over Ethernet (POE) (802.3af) WB.15.11 RA.15.05 KA.15.03
Power over Ethernet Plus (POE+) (802.3at) WB.15.11 n/a KA.15.03
Redundant Power Support WB.15.13 RA.15.05 KA.15.03
Priority/Quality of Service (QoS)
Broadcast Control WB.15.11 RA.15.05 KA.15.03
Broadcast Storm Control WB.15.15 n/a KA.15.15
Classifier-Based QoS and Rate Limiting WB.15.11 n/a KA.15.03
Egress Port Monitoring (Outbound) n/a n/a KA.15.03
ICMP Rate Limiting WB.15.11 RA.15.05 KA.15.03
Inbound Rate-Limiting for Broadcast and Multicast Traffic WB.15.11 RA.15.05 KA.15.03
Layer 4 TCP/UDP Packet Priority WB.15.11 RA.15.05 KA.15.03
Mirroring: MAC based Mirroring n/a n/a KA.15.03
Mirroring: MAC based Remote Mirroring n/a n/a KA.15.03
Mirroring: no VLAN Tag added n/a n/a KA.15.03
Mirroring: Port WB.15.11 RA.15.05 KA.15.03
Mirroring: Remote n/a n/a KA.15.03
Multicast Storm Control n/a n/a n/a
QoS: Class of Service (CoS) WB.15.11 RA.15.05 KA.15.03
QoS: Egress Queue Rate-limiting WB.15.15 n/a KA.15.15
QoS: Guaranteed Minimum Bandwidth WB.15.11 n/a KA.15.03
QoS: IPv6 QoS WB.15.11 RA.15.14 KA.15.03

QoS: Monitor Egress Queues for Dropped Packets if QoS Configured WB.15.11 RA.15.05 KA.15.09
QoS: Netdestinations and Netservices WB.16.03 n/a n/a
QoS: Packet Priority (802.1p) WB.15.11 RA.15.05 KA.15.03
QoS: Per Port Trust WB.16.02 RA.16.02 KA.16.02
QoS: Port and Priority-based Rate Limiting WB.15.11 RA.15.05 KA.15.03
QoS: Priority Queuing WB.15.11 RA.15.05 KA.15.03
QoS: Selectable Queuing Configurations WB.15.11 RA.15.05 KA.15.03
QoS: Strict Priority Queuing WB.15.11 n/a KA.15.12
QoS: TCP/UDP Port Ranges WB.15.11 RA.15.05 KA.15.03
QoS: Traffic Template n/a n/a n/a
QoS: Turn on/off VLAN Precedence WB.15.11 RA.15.05 KA.15.16
QoS: VLAN Port-Based Prioritization (802.1p) WB.15.11 RA.15.05 KA.15.03
Rate Limiting WB.15.11 RA.15.05 KA.15.03
Rate Limiting Unknown Unicast Traffic n/a n/a n/a
Traffic Policing (with two rate three color marker) n/a n/a n/a
Routing and Multicast
ARP Age Timer Increase WB.15.11 RA.15.05 KA.15.03
BFD: Bidirectional Forwarding Detection (OSPF/VRRP) n/a n/a n/a
BFD: Bidirectional Forwarding Detection (Static Routes) n/a n/a n/a
BGP: Border Gateway Protocol n/a n/a KA.15.09
BGP: MD5 Authentication n/a n/a KA.15.09
BGP: Route Filtering and Peer Restart Time Display n/a n/a KA.15.09
BGP: Route Maps n/a n/a KA.15.09
BGP: BGP-4 n/a n/a KA.15.16
mDNS (Bonjour and Chromecast) Gateway WB.16.01  RA.15.09 KA.16.01
Disable Overlapping Subnet Configuration WB.15.11 RA.15.09 KA.15.09
ECMP (Equal Cost Multipath) WB.15.11 RA.15.05 KA.15.03
ECMP with Static Routes WB.15.11 RA.15.05 KA.15.03
Identification Field in Static Route Config WB.15.13 RA.15.13 KA.15.13
IGMP v3 and MLD v2 Capabilities  (YA only supports MLD v1) WB.15.11  n/a KA.15.09

Improved Log Commands and Output for OSPFv2 Troubleshooting WB.16.02 n/a KA.15.09
IPv6 Default gateway for OOBM WB.16.04.0008 n/a KA.16.04.0008
IPv6 Default Router Preference WB.16.04.0008 n/a KA.16.04.0008
IPv6 over IPv4 Tunneling n/a n/a KA.15.06
IPv6 Static Route Tag WB.15.16 n/a KA.15.16
IRDP WB.15.11 RA.15.05 KA.15.03
Multicast: Block Unknown Multicast WB.15.11 RA.15.05 KA.15.09
Multicast: IP Multicast snooping (Data Driven IGMP) WB.15.11 RA.15.05 KA.15.03
Multicast: IGMP v3 WB.16.01 n/a KA.16.01
Multicast: IPv6 MLD Multicast Snooping WB.15.11 RA.15.05 KA.15.03
Multi-Netting WB.15.11 RA.15.05 KA.15.03
OSPF (2930F & 2930M only support single-area OSPF) WB.16.02 n/a KA.15.03
OSPF ECMP WB.16.02 n/a KA.15.03
OSPF Global Cost Setting n/a
OSPF LSA Type 3 Summarized Prefix Cost n/a n/a KA.15.09
OSPF LSA Type 3 Summarized Prefix Cost for OSPF v3 n/a n/a KA.15.09
OSPF Neighbor Shutdown Notification WB.16.02 n/a KA.15.09
OSPF Neighbor Timer Information Display WB.16.02 n/a KA.15.09
OSPF NSSA Range Metrics added to OSPFv2 WB.16.02 n/a KA.15.09
OSPF/VRRP Nonstop Routing added to Management Failover WB.16.02 n/a KA.15.09
OSPFv2 config Metric Cost/Range WB.16.02 n/a KA.15.09
OSPFv3 WB.16.02 n/a KA.15.03
OSPFv3 over 6-in-4 Tunnels n/a n/a KA.15.09
OSPFv3 Trap Global Enable/Disable WB.16.02 n/a KA.15.16
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PIM: Override Reverse Path Forward (RPF) Lookup n/a n/a KA.15.09
PIM: 'router pim' Command Enhancements n/a n/a KA.15.09
PIM-DM n/a n/a KA.15.03
PIM-SM n/a n/a KA.15.03
PIMv6 SM and DM n/a
Policy-Based Routing (PBR) n/a n/a KA.15.09
RIP v1/v2 WB.15.11 RA.15.05 KA.15.03
RIP v2 with MD5 Authentication WB.15.18 RA.15.18 KA.15.18
RIPng WB.16.01 n/a KA.16.01
Router Advertisement (RA) Guard WB.15.11 n/a KA.15.09
Service Insertion: Intercept Tunnels WB.15.15 n/a KA.15.15
Service Insertion: Mirror Tunnels WB.15.17 n/a KA.15.17
Show IP Route Summary WB.15.11 RA.15.07 KA.15.09
Static Blackhole or Reject Routes Redistribution into RIP WB.15.11 n/a KA.15.09
Static Routes WB.15.11 RA.15.05 KA.15.03
Tunneled Node (per port) WB.16.02 n/a KA.16.02
Tunneled Node (per user) n/a n/a n/a
Tunneled Node: Fallback to local switching WB.16.02.0011 n/a KA.16.02.0011
UDP Broadcast Forwarding WB.15.11 RA.15.05 KA.15.03
Virtual Router Redundancy Protocol (VRRP) n/a n/a KA.15.03
VRRP Preemptive Delay Timer n/a n/a KA.15.03
VRRP Track Ports & Dynamic Priority Change n/a n/a KA.15.03
VRRPv3 n/a n/a KA.15.13
VRRP: Support for Self-Ping, Telnet, SSH, Web GUI n/a n/a n/a
Security
802.1v Protocol VLANs WB.15.11 RA.15.05 KA.15.03
802.1X and RADIUS Login (Port-Based Access) WB.15.11 RA.15.05 KA.15.03
AAA Authorization on HTTPS (T5) WB.15.11 RA.15.05 KA.15.03
ACL Grouping  n/a n/a KA.16.01
ACL: Access Control List WB.15.11 RA.15.05 KA.15.03
ACL: Logging Match WB.15.11 RA.15.05 KA.15.09
ACL: MAC ACLs n/a n/a n/a
ACL: Rule added to IP Directed Broadcast WB.15.18 RA.15.18 KA.15.18
Advanced Threat Detection WB.16.05 n/a n/a
Device Fingerprinting with ClearPass n/a n/a n/a

Cached Re-authentication (Hold State if RADIUS Server Unavailable) WB.15.11 RA.15.05 KA.15.03
Concurrent 802.1x, WebAuth, and MacAuth WB.15.11 RA.15.05 KA.15.03
Concurrent TACACS+ and SFTP WB.15.11 RA.15.05 KA.15.03
DHCP Snooping WB.15.11 RA.15.05 KA.15.03
DHCP Snooping: CLI to clear DSnoop Counter WB.15.13  RA.16.03.0001 KA.15.13
DHCP Snooping: DHCPv4 Snooping Max Binding WB.15.14  RA.15.14 KA.15.14
DHCP Snooping: DHCPv6 Snooping WB.15.16 RA.15.16 KA.15.16
Dynamic ARP Protection WB.15.11 RA.15.05 KA.15.03
Dynamic IP Lockdown WB.15.11 RA.15.05 KA.15.03
Egress ACLs WB.15.18 n/a KA.15.18
IPv6 Protocol VLANs WB.15.11 RA.15.05 KA.15.03
Local MAC Authentication WB.15.14 RA.15.16 KA.15.14
Local User Roles WB.16.02 RA.16.02 KA.16.02
Downloadable User Roles WB.16.04 n/a n/a
Downloadable User Roles 
with Secondary Role Pushed to Controller n/a n/a n/a
MAC Authentication WB.15.11 RA.15.05 KA.15.03
MAC Authentication: Client Limit Increased to 256 n/a n/a KA.15.03
MAC Authentication: Hitless Re-Authentication WB.15.11 RA.15.05 KA.15.03
MAC Authentication:  Port-based WB.16.02 RA.16.02 KA.16.02
MAC Authentication Toggle WB.16.02 RA.16.02 KA.16.02
MAC Authentication: Unauth-Redirect WB.15.11 RA.15.05 KA.15.03
MAC-based VLANs (MBV) WB.15.14 RA.15.10 KA.15.09
MAC-based VLANs: Controlling MBV via CLI for NAC WB.15.16 n/a KA.15.16
MAC Pinning WB.16.05
MACSec: SmartRate Modules n/a n/a n/a
MACSec: V3 only n/a n/a n/a
Multiple 802.1X Clients Per Port WB.15.11 RA.15.05 KA.15.03
ND Snooping WB.16.01 n/a KA.16.01
Open Authentication Roles n/a
Critical Authentication Roles n/a
Password Complexity WB.16.01 RA.16.01 KA.16.01
Port Monitoring WB.15.11 RA.15.05 KA.15.03
Port Security (MAC Lockdown) WB.15.11 RA.15.05 KA.15.03
Port Security (MAC Lockout) WB.15.11 RA.15.05 KA.15.03
Port Security Auto Recovery n/a n/a n/a
Protocol Based VLANs WB.15.11 RA.15.05 KA.15.03
Private VLAN WB.16.01 n/a KA.16.01
RBAC: Role Based Access Control WB.16.01 n/a KA.16.01
RADIUS WB.15.11 RA.15.05 KA.15.03
RADIUS Assigned ACLs WB.15.11 RA.15.05 KA.15.03
RADIUS Assigned GVRP VLANs WB.15.11 RA.15.05 KA.15.03
RADIUS Attributes for QoS and Rate-Limiting WB.15.11 RA.15.05 KA.15.03
RADIUS Authenticated mgr Level Login WB.15.11 RA.15.05 KA.15.03
RADIUS Authentication for Browser Access WB.15.11 RA.15.05 KA.15.03
RADIUS Configuration via SNMP WB.15.11 RA.15.05 KA.15.03
RADIUS for 802.1X Accounting WB.15.11 RA.15.05 KA.15.03
RADIUS IPv6 WB.15.12 RA.15.12 KA.15.12
RADIUS Port Speed VSA WB.15.13 n/a KA.15.13
RADIUS Service Tracking WB.16.01 RA.16.01 KA.16.01
Source Port Filter WB.15.11 RA.15.05 KA.15.03
SSH Client WB.15.11 RA.15.05 KA.15.09
SSH Re-key (Government Certification)  n/a  n/a  n/a
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Software Features
Firmware Prefix

2920
WB

2620
RA

3800
KA

Static IP Lockdown WB.15.11 RA.15.05 KA.15.03

Synchronization for 802.1X Supplicants  (for Nonstop Switching) WB.15.11 RA.15.05 KA.15.03
TACACS+ WB.15.11 RA.15.05 KA.15.03
User Lockout (Government Certification) WB.16.04.0008  n/a n/a
Virus Throttling (Connection Rate Filtering) n/a n/a KA.15.03
Web-based Authentication WB.15.11 RA.15.05 KA.15.03
Supportability
Debug Command for PIM Packet Events Added n/a n/a KA.15.09
Flight Data Recorder Log WB.15.12 n/a KA.15.09
LACP Debug Logging and Show Commands WB.15.11 RA.15.06 KA.15.09
Preview Mode WB.16.04 n/a n/a
Time Domain Reflectometry  (SmartRate modules not supported) WB.16.04.0008 n/a n/a
Supportability Infrastructure: 
User Initiated Diagnostic Reset via Clear button WB.16.01 RA.16.01 KA.16.01
Supportability Infrastructure: 
User Initiated Diagnostic Reset via Serial Console WB.16.01 RA.16.01 KA.16.01

Software Support
Minimum

SW Version 

AirWave (ZTP, configuration, software update) 8.2.1

AirWave over IPSec 8.2.1

Aruba Central n/a

Aruba Activate n/a

Aruba Activate Firmware Upgrade n/a

Aruba Controller (70xx & 72xx series) 6.5

VAN Controller (SDN) 2.8.8.0366
Network Optimizer 1.5.4.109
Network Protector 1.5.5.39
Network Visualizer 1.2.7.164

IMC 7.2

ClearPass (CoA Port Bounce, Captive Portal) 6.6.0

All software version references to 16.07 are for 16.07.0001

HPE Part Number 5200-5376 
Published: October 2018
Edition: 1

To help us improve the documentation, send any errors, suggestions, 
or comments to docsfeedback@hpe.com.

© Copyright 2015-2018 Hewlett Packard Enterprise Development LP 

The information contained herein is subject to change without notice. 
The only warranties for Hewlett Packard Enterprise products and 
services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be 
construed as constituting an  additional warranty. Hewlett Packard 
Enterprise shall not be liable for technical or editorial errors or 
omissions contained herein.

ClearPass version 6.7.0 is required for 
Advanced Threat Detection 

2920, 2930F, 2930M, 3800, 3810, 5400R v2/v3
2530, 2540, 2620, 2920, 2930F, 2930M, 3800, 3810, 
5400R 2930M requires at least 7.3 E0503

2920, 2930F, 2930M, 3800, 3810, 5400R v2/v3

2530, 2540, 2620, 2920, 2930F, 2930M, 3800, 3810, 
5400R v2/v3

2920, 2930F, 2930M, 3800, 3810, 5400R v2/v3
2920, 2930F, 2930M, 3800, 3810, 5400R v2/v3

2920, 2930F, 2930M, 3800, 3810, 5400R

Switches manufactured as of February 2016.

2530, 2540, 2920, 2930F, 2930M, 3800, 3810, 
5400Rzl

Switches manufactured as of February 2016 
except 5400R zl2, which is as of June 2016.

2530,2920, 2930F, 2930M, 2540, 3800, 3810, 5400R 
zl

2530, 2540, 2920, 2930F, 2930M, 3810,5400R(only 
Template),2920-Stk(16.04), 2930M-
Stk(16.06), 5400R_VSF(16.06.0008)

Comments

2530, 2540, 2620, 2920, 2930F, 2930M, 3800, 3810, 
5400R v2/v3 2530 >=8.2.1.1,  2930M >=8.2.4

2540, 2920, 2930F, 2930M, 3800,5400R, 3810
Controller firmware version must be at least 
6.5.

Supported Switch Platforms
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This guide provides information on how to configure, manage, and monitor basic switch operation.

Applicable products
This guide applies to these products:

Aruba 2530 Switch Series (J9772A, J9773A, J9774A, J9775A, J9776A, J9777A, J9778A, J9779A, J9780A,
J9781A, J9782A, J9783A, J9853A, J9854A, J9855A, J9856A, JL070A)

Switch prompts used in this guide
Examples in this guide are representative and may not match your particular switch/environment. Examples use
simplified prompts as follows:

Prompt Explanation

switch# # indicates manager context (authority).

switch> > indicates operator context (authority).

switch(config)# (config) indicates the config context.

switch(vlan-x)# (vlan-x) indicates the vlan context of config, where x
represents the VLAN ID. For example:
switch(vlan-128)#.

switch(eth-x)# (eth-x) indicates the interface context of config,
where x represents the interface. For example:
switch(eth-48)#.

switch-Stack# Stack indicates that stacking is enabled.

switch-Stack(config)# Stack(config) indicates the config context while
stacking is enabled.

switch-Stack(stacking)# Stack(stacking) indicates the stacking context of
config while stacking is enabled.

switch-Stack(vlan-x)# Stack(vlan-x) indicates the vlan context of config
while stacking is enabled, where x represents the
VLAN ID. For example: switch-
Stack(vlan-128)#.

switch-Stack(eth-x/y)# Stack(eth-x/y) indicates the interface context of
config, in the form (eth-<member-in-stack>/
<interface>). For example: switch(eth-1/48)#

Chapter 1
About this guide
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For successful time protocol setup and specific configuration details, you may need to contact your
system administrator regarding your local configuration.

General steps for running a time protocol on the switch
Using time synchronization ensures a uniform time among interoperating devices. This helps you to manage and
troubleshoot switch operation by attaching meaningful time data to event and error messages.

The switch offers TimeP, SNTP (Simple Network Time Protocol), NTP, and a timesync command for changing
the time protocol selection (or turning off time protocol operation).

Although you can create and save configurations for all time protocols without conflicts, the switch
allows only one active time protocol at any time.

In the factory-default configuration, time synchronization is disabled by default.

Because the Aruba 2530 Switch Series does not contain an RTC (real time clock) chip, Hewlett
Packard Enterprise recommends configuring one of the time synchronization protocols supported.
Failure to do so could result in the switch time being reset to the factory default of 01/01/1990
00:00:00 in the case of a switch reload, software upgrade, or power cycle.

TimeP time synchronization
You can either manually assign the switch to use a TimeP server or use DHCP to assign the TimeP server. In
either case, the switch can get its time synchronization updates from only one designated TimeP server. This
option enhances security by specifying which time server to use.

SNTP time synchronization
SNTP provides three operating modes:

• Broadcast mode

The switch acquires time updates by accepting the time value from the first SNTP time broadcast detected. (In
this case, the SNTP server must be configured to broadcast time updates to the network broadcast address;
see the documentation provided with your SNTP server application.) Once the switch detects a particular
server, it ignores time broadcasts from other SNTP servers unless the configurable Poll Interval expires three
consecutive times without an update received from the first-detected server.

To use Broadcast mode, the switch and the SNTP server must be in the same subnet.

• DHCP mode

DHCP mode is enabled by default. In DHCP mode, the SNTP server address and the timezone are provided in
the DHCP address reply.

• Unicast mode

Chapter 2
Time Protocols
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The switch requests a time update from the configured SNTP server. (You can configure one server using the
menu interface, or up to three servers using the CLI sntp server command.) This option provides increased
security over the Broadcast mode by specifying which time server to use instead of using the first one detected
through a broadcast.

Selecting a time synchronization protocol
Procedure

1. Select the time synchronization protocol: TimeP, SNTP, or NTP.

2. Enable the protocol; the choices are:

a. TimeP: DHCP or Manual
b. SNTP: Broadcast or Unicast
c. NTP: Broadcast or Unicast

3. Configure the remaining parameters for the time protocol you selected.

The switch retains the parameter settings for both time protocols even if you change from one protocol to the
other. Thus, if you select a time protocol, the switch uses the parameters you last configured for the selected
protocol.

Simply selecting a time synchronization protocol does not enable that protocol on the switch unless you also
enable the protocol itself (step 2, above). For example, in the factory-default configuration, TimeP is the selected
time synchronization method. However, because TimeP is disabled in the factory-default configuration, no time
synchronization protocol is running.

Disabling time synchronization
You can use either of the following methods to disable time synchronization without changing the TimeP, SNTP, or
NTP configuration:

• Global config level of the CLI

Execute no timesync.

• System Information screen of the Menu interface

1. Set the Time Synch Method parameter to None.

2. Press [Enter] , then [S] (for Save ).

SNTP: Selecting and configuring
The following table shows the SNTP parameters and their operations.
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Table 1: SNTP parameters

SNTP parameter Operation

Time Sync Method Used to select either SNTP, TIMEP, NTP, or None as the time synchronization method.

SNTP Mode

 Disabled The Default. SNTP does not operate, even if specified by the Menu interface Time Sync
Method parameter or the CLI timesync command.

 Unicast Directs the switch to poll a specific server for SNTP time synchronization. Requires at
least one server address.

Broadcast Directs the switch to acquire its time synchronization from data broadcast by any SNTP
server to the network broadcast address. The switch uses the first server detected and
ignores any others. However, if the Poll Interval expires three times without the switch
detecting a time update from the original server, the switch accepts a broadcast time
update from the next server it detects.

Poll Interval
(seconds)

In Unicast Mode: Specifies how often the switch polls the designated SNTP server for a
time update.In Broadcast Mode: Specifies how often the switch polls the network
broadcast address for a time update.Value is between 30 to 720 seconds.

Server Address Used only when the SNTP Mode is set to Unicast. Specifies the IP address of the SNTP
server that the switch accesses for time synchronization updates. You can configure up to
three servers; one using the menu or CLI, and two more using the CLI.

Server Version Specifies the SNTP software version to use and is assigned on a per-server basis. The
version setting is backwards-compatible. For example, using version 3 means that the
switch accepts versions 1 through 3. Default: 3; range: 1 to 7.

Priority Specifies the order in which the configured servers are polled for getting the time. Value is
between 1 and 3.

Viewing and configuring SNTP (Menu)

Procedure

1. From the Main Menu, select:
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a. 2. Switch Configuration…

b. 1. System Information

Figure 1: System Information screen (default values)

2. Press [E] (for Edit ).

Move the cursor to the System Name field.

3. Use the Space bar to move the cursor to the Time Sync Method field.

4. Use the Space bar to select SNTP, then move to the SNTP Mode field.

5. Complete one of the following options.

Option 1

a. Use the Space bar to select the Broadcast mode.

b. Move the cursor to the Poll Interval field.

c. Go to 6. (For Broadcast mode details, see SNTP time synchronization)

Figure 2: Time configuration fields for SNTP with broadcast mode

Option 2

d. Use the Space bar to select the Unicast mode.

e. Move the cursor to the Server Address field.

f. Enter the IP address of the SNTP server you want the switch to use for time synchronization.

This step replaces any previously configured server IP address. If you will be using backup
SNTP servers (requires use of the CLI), see SNTP unicast time polling with multiple SNTP
servers.
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g. Move the cursor to the Server Version field. Enter the value that matches the SNTP server version running
on the device you specified in the preceding step.

If you are unsure which version to use, Hewlett Packard Enterprise recommends leaving this value at the
default setting of 3 and testing SNTP operation to determine whether any change is necessary.

Using the menu to enter the IP address for an SNTP server when the switch already has one
or more SNTP servers configured, the switch deletes the primary SNTP server from the server
list. The switch then selects a new primary SNTP server from the IP addresses in the updated
list. For more on this topic, see SNTP unicast time polling with multiple SNTP servers.

h. Move the cursor to the Poll Interval field, then go to step 6.

Figure 3: SNTP configuration fields for SNTP configured with unicast mode

6. In the Poll Interval field, enter the time in seconds that you want for a Poll Interval.

(For Poll Interval operation, see SNTP parameters)

7. Press Enter to return to the Actions line, then S (for Save) to enter the new time protocol configuration in both
the startup-config and running-config files.

Viewing and configuring SNTP (CLI)
Syntax:

show sntp
Lists both the time synchronization method (TimeP, SNTP, or None) and the SNTP configuration, even if SNTP is
not the selected time protocol.

If you configure the switch with SNTP as the time synchronization method, then enable SNTP in broadcast mode
with the default poll interval, show sntp lists the following:

SNTP configuration when SNTP is the selected time synchronization method

switch(config)# show sntp

 SNTP Configuration

  Time Sync Mode: Sntp
  SNTP Mode : Unicast
  Poll Interval (sec) [720] : 719

  Priority SNTP Server Address            Protocol Version
  -------- ------------------------------ ----------------
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  1        2001:db8::215:60ff:fe79:8980   7
  2        10.255.5.24                    3
  3        fe80::123%vlan10               3
In the factory-default configuration (where TimeP is the selected time synchronization method), show sntp still
lists the SNTP configuration, even though it is not currently in use. In SNTP configuration when SNTP is not
the selected time synchronization method on page 25, even though TimeP is the current time synchronous
method, the switch maintains the SNTP configuration.

SNTP configuration when SNTP is not the selected time synchronization method

switch(config)# show sntp

 SNTP Configuration

  Time Sync Mode: Timep
  SNTP Mode : Unicast
  Poll Interval (sec) [720] : 719

  Priority SNTP Server Address            Protocol Version
  -------- ------------------------------ ----------------
  1        2001:db8::215:60ff:fe79:8980   7
  2        10.255.5.24                    3
  3        fe80::123%vlan10               3
Syntax:

show management
This command can help you to easily examine and compare the IP addressing on the switch. It lists the IP
addresses for all time servers configured on the switch, plus the IP addresses and default gateway for all VLANs
configured on the switch.

Display showing IP addressing for all configured time servers and VLANs

switch(config)# show management

 Status and Counters - Management Address Information

  Time Server Address : fe80::215:60ff:fe7a:adc0%vlan10

  Priority  SNTP Server Address            Protocol Version
  --------- ------------------------------ ----------------
  1         2001:db8::215:60ff:fe79:8980   7
  2         10.255.5.24                    3
  3         fe80::123%vlan10               3

  Default Gateway   :10.0.9.80

  VLAN Name    MAC Address     | IP address
  ------------ --------------- + ---------------
  DEFAULT_VLAN 001279-88a100   | Disabled
  VLAN10       001279-88a100   | 10.0.10.17
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Configuring (enabling or disabling) the SNTP mode
Enabling the SNTP mode means to configure it for either broadcast or unicast mode. Remember that to run SNTP
as the switch's time synchronization protocol, you must also select SNTP as the time synchronization method by
using the CLI timesync command (or the menu interface Time Sync Method parameter.)

Syntax:

timesync sntp
Selects SNTP as the time protocol.

sntp {<broadcast | unicast>}
Enables the SNTP mode.

Syntax:

sntp server <ip-addr>
Required only for unicast mode.

Syntax:

sntp server priority <1-3>
Specifies the order in which the configured servers are polled for getting the time. Value is between 1 and 3.

Syntax:

sntp <30-720>
Configures the amount of time between updates of the system clock via SNTP.

Default: 720 seconds

Enabling SNTP in Broadcast Mode
Because the switch provides an SNTP polling interval (default: 720 seconds), you need only these two commands
for minimal SNTP broadcast configuration:

Syntax:

timesync sntp
Selects SNTP as the time synchronization method.

Syntax:

sntp broadcast
Configures broadcast as the SNTP mode.

Example:

Suppose that time synchronization is in the factory-default configuration (TimeP is the currently selected time
synchronization method.) Complete the following:
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Procedure

1. View the current time synchronization.

2. Select SNTP as the time synchronization mode.

3. Enable SNTP for Broadcast mode.

4. View the SNTP configuration again to verify the configuration.

The commands and output would appear as follows:

Figure 4: Enabling SNTP operation in Broadcast Mode

switch(config)# show sntp 1
 SNTP Configuration
  Time Sync Mode: Timep
  SNTP Mode : disabled
  Poll Interval (sec) [720] :720

switch(config)# timesync sntp

switch(config)# sntp broadcast

switch(config)# show sntp 2
 SNTP Configuration
  Time Sync Mode: Sntp
  SNTP Mode : Broadcast
  Poll Interval (sec) [720] :720

• 1show sntp displays the SNTP configuration and also shows that TimeP is the currently

active time synchronization mode.

• 2show sntp again displays the SNTP configuration and shows that SNTP is now the

currently active time synchronization mode and is configured for broadcast operation.

Enabling SNTP in unicast mode (CLI)
Like broadcast mode, configuring SNTP for unicast mode enables SNTP. However, for unicast operation, you
must also specify the IP address of at least one SNTP server. The switch allows up to three unicast servers. You
can use the Menu interface or the CLI to configure one server or to replace an existing unicast server with
another. To add a second or third server, you must use the CLI. For more on SNTP operation with multiple
servers, see SNTP unicast time polling with multiple SNTP servers on page 37

Syntax:

timesync sntp
Selects SNTP as the time synchronization method.

Syntax:

sntp unicast
Configures the SNTP mode for unicast operation.
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Syntax:

[no] sntp server priority < 1-3 > < ip-address > [version]
Use the no version of the command to disable SNTP.

priority
Specifies the order in which the configured SNTP servers are polled for the time.

ip-address
An IPv4 or IPv6 address of an SNTP server.

version
The protocol version of the SNTP server. Allowable values are 1 through 7; default is 3.

Syntax:

no sntp server priority <1-3> <ip-addr>
Deletes the specified SNTP server.

priority <1-3>
value must match what server is configured with. Deleting an SNTP server when only one is
configured disables SNTP unicast operation.

Example:

To select SNTP and configure it with unicast mode and an SNTP server at 10.28.227.141 with the default server
version (3) and default poll interval (720 seconds):

switch(config)# timesync sntp
Selects SNTP.

switch(config)# sntp unicast
Activates SNTP in unicast mode.

switch(config)# sntp server priority 1 10.28.227.141
Specifies the SNTP server and accepts the current SNTP server version (default: 3).

Configuring SNTP for unicast operation

switch(config)# show sntp

 SNTP Configuration

  Time Sync Mode: Sntp
  SNTP Mode : Unicast
  Poll Interval (sec) [720] : 720

  Priority SNTP Server Address                            Protocol Version
  -------- ---------------------------------------------- ----------------
  1        2001:db8::215:60ff:fe79:8980 7
  2        10.255.5.24 3
  3        fe80::123%vlan10 3
In this Example:, the Poll Interval and the Protocol Version appear at their default settings.
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Both IPv4 and IPv6 addresses are displayed.

Note: Protocol Version appears only when there is an IP address configured for an SNTP server.

If the SNTP server you specify uses SNTP v4 or later, use the sntp server command to specify the correct
version number. For example, suppose you learned that SNTP v4 was in use on the server you specified above
(IP address 10.28.227.141). You would use the following commands to delete the server IP address , re-enter it
with the correct version number for that server.

Specifying the SNTP protocol version number

switch(config)# no sntp server 10.28.227.141 1
switch(config)# sntp server 10.28.227.141 4 2
switch(config)# show sntp
 
 SNTP Configuration

  Time Sync Mode: Sntp
  SNTP Mode : Broadcast
  Poll Interval (sec) [720] : 600

  IP Address     Protocol Version
  -------------  -----------------
  10.28.227.141  4 3
      

• 1Deletes unicast SNTP server entry.

• 2Re-enters the unicast server with a non-default protocol version.

• 3show sntp displays the result.

Changing the SNTP poll interval (CLI)
Syntax:

sntp <30..720>
Specifies the amount of time between updates of the system clock via SNTP. The default is 720 seconds and the
range is 30 to 720 seconds. (This parameter is separate from the poll interval parameter used for Timep
operation.)

Example:

To change the poll interval to 300 seconds:

switch(config)# sntp 300
Changing the SNTP server priority (CLI)
You can choose the order in which configured servers are polled for getting the time by setting the server priority.

Syntax:

sntp server priority <1-3> <ip-address>
Specifies the order in which the configured servers are polled for getting the time Value is between 1 and 3.

You can enter both IPv4 and IPv6 addresses. For more information about IPv6 addresses, see the
IPv6 configuration guide for your switch.
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Example:

To set one server to priority 1 and another to priority 2:

switch(config)# sntp server priority 1 10.28.22.141

switch(config)# sntp server priority 2
                 2001:db8::215:60ff:fe79:8980

Disabling time synchronization without changing the SNTP configuration (CLI)
The recommended method for disabling time synchronization is to use the timesync command.

Syntax:

no timesync
Halts time synchronization without changing your SNTP configuration.

Example:

Suppose SNTP is running as the switch's time synchronization protocol, with broadcast as the SNTP mode and
the factory-default polling interval. You would halt time synchronization with this command:

switch(config)# no timesync
If you then viewed the SNTP configuration, you would see the following:

SNTP with time synchronization disabled

switch(config)# show sntp
 SNTP Configuration
  Time Sync Mode: Disabled
  SNTP Mode : Broadcast
  Poll Interval (sec) [720] : 720

Disabling the SNTP Mode
If you want to prevent SNTP from being used even if it is selected by timesync (or the Menu interface's Time
Sync Method parameter), configure the SNTP mode as disabled.

Syntax:

no sntp
Disables SNTP by changing the SNTP mode configuration to Disabled.

Example:

If the switch is running SNTP in unicast mode with an SNTP server at 10.28.227.141 and a server version of 3
(the default), no sntp changes the SNTP configuration as shown below and disables time synchronization on
the switch.

Disabling time synchronization by disabling the SNTP mode

switch(config)# no sntp
switch(config)# show sntp

 SNTP Configuration

  Time Sync Mode: Sntp
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  SNTP Mode : disabled
  Poll Interval (sec) [720] : 600

  IP Address     Protocol Version
  -------------  -----------------
  10.28.227.141  3
Note that even though the Time Sync Mode is set to Sntp, time synchronization is disabled because no sntp
has disabled the SNTP Mode parameter.

TimeP: Selecting and configuring
The following table shows TimeP parameters and their operations.

Table 2: TimeP parameters

TimeP
parameter

Operation

Time Sync
Method

Used to select either TIMEP, SNTP, NTP, or None as the time synchronization method.

TimeP Mode

 Disabled TimeP does not operate, even if specified by the Menu interface Time Sync Method
parameter or the CLI timesync command.

 DHCP When TimeP is selected as the time synchronization method, the switch attempts to acquire a
TimeP server IP address via DHCP. If the switch receives a server address, it polls the server
for updates according to the TimeP poll interval. If the switch does not receive a TimeP server
IP address, it cannot perform time synchronization updates.

 Manual When TimeP is selected as the time synchronization method, the switch attempts to poll the
specified server for updates according to the TimeP poll interval. If the switch fails to receive
updates from the server, time synchronization updates do not occur.

 Server
Address

Used only when the TimeP Mode is set to Manual. Specifies the IP address of the TimeP
server that the switch accesses for time synchronization updates. You can configure one
server.

Viewing, enabling, and modifying the TimeP protocol (Menu)

Procedure

1. From the Main Menu, select:

2. Switch Configuration
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1. System Information

Figure 5: System Information screen (default values)

2. Press [E] (for Edit).

The cursor moves to the System Name field.

3. Move the cursor to the Time Sync Method field.

4. If TIMEP is not already selected, use the Space bar to select TIMEP, then move to the TIMEP Mode field.

5. Do one of the following:

• Use the Space bar to select the DHCP mode.

◦ Move the cursor to the Poll Interval field.

◦ Go to step 6.

Enabling TIMEP or DHCP

Time Sync Method [None] :   TIMEP
TimeP Mode [Disabled] :     DHCP
Poll Interval (min) [720] : 720
Time Zone [0] :             0
Daylight Time Rule [None] : None

• Use the Spacebar to select the Manual mode.

◦ Move the cursor to the Server Address field.

◦ Enter the IP address of the TimeP server you want the switch to use for time synchronization.

This step replaces any previously configured TimeP server IP address.

◦ Move the cursor to the Poll Interval field, then go to step 6.
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6. In the Poll Interval field, enter the time in minutes that you want for a TimeP Poll Interval.

7. Select [Enter] to return to the Actions line, then select [S] (for Save) to enter the new time protocol
configuration in both the startup-config and running-config files.

Viewing the current TimeP configuration (CLI)
Using different show commands, you can display either the full TimeP configuration or a combined listing of all
TimeP, SNTP, and VLAN IP addresses configured on the switch.

Syntax:

show timep
Lists both the time synchronization method (TimeP, SNTP, or None) and the TimeP configuration, even if SNTP is
not the selected time protocol. (If the TimeP Mode is set to Disabled or DHCP, the Server field does not appear.)

If you configure the switch with TimeP as the time synchronization method, then enable TimeP in DHCP mode
with the default poll interval, show timep lists the following:

TimeP configuration when TimeP is the selected Time synchronization method

switch(config)# show timep

 Timep Configuration

  Time Sync Mode: Timep
  TimeP Mode [Disabled] : DHCP    Server Address : 10.10.28.103
  Poll Interval (min) [720] : 720
If SNTP is the selected time synchronization method, show timep still lists the TimeP configuration even though
it is not currently in use. Even though, in this Example:, SNTP is the current time synchronization method, the
switch maintains the TimeP configuration:

TimeP configuration when TimeP is not the selected time synchronization method

switch(config)# show timep

 Timep Configuration
 
  Time Sync Mode: Sntp
  TimeP Mode [Disabled] : Manual   Server Address : 10.10.28.100
  Poll Interval (min) [720] : 720
Syntax:

show management
Helps you to easily examine and compare the IP addressing on the switch. It lists the IP addresses for all time
servers configured on the switch plus the IP addresses and default gateway for all VLANs configured on the
switch.

Display showing IP addressing for all configured time servers and VLANs

switch(config)# show management

 Status and Counters - Management Address Information
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  Time Server Address : 10.10.28.100

  Priority SNTP Server Address                            Protocol Version
  -------- ---------------------------------------------- ----------------
  1        10.10..28.101                                  3
  2        10.255.5.24                                    3
  3        fe80::123%vlan10                               3

  Default Gateway : 10.0.9.80
 
  VLAN Name    MAC Address         | IP Address
  ------------ ------------------- + -------------------
  DEFAULT_VLAN 001279-88a100       | 10.30.248.184
  VLAN10 001279-88a100             | 10.0.10.17

Configuring (enabling or disabling) the TimeP mode
Enabling the TimeP mode means to configure it for either broadcast or unicast mode. Remember to run TimeP as
the switch's time synchronization protocol, you must also select TimeP as the time synchronization method by
using the CLI timesync command (or the menu interface Time Sync Method parameter.

Syntax:

timesync timep
Selects TimeP as the time synchronization method.

Syntax:

ip timep {<dhcp | manual>}
Enables the selected TimeP mode.

Syntax:

[no] ip timep
Disables the TimeP mode.

Syntax:

[no] timesync
Disables the time protocol.

Enabling TimeP in manual mode (CLI)
Like DHCP mode, configuring TimeP for manual mode enables TimeP. However, for manual operation, you must
also specify the IP address of the TimeP server. (The switch allows only one TimeP server.)

Syntax:

timesync timep
Selects TimeP.

Syntax:

ip timep manual <ip-addr>
Activates TimeP in manual mode with a specified TimeP server.
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Syntax:

no ip timep
Disables TimeP.

Enabling TimeP in DHCP Mode
Because the switch provides a TimeP polling interval (default:720 minutes), you need only these two commands
for a minimal TimeP DHCP configuration:

Syntax:

timesync timep
Selects TimeP as the time synchronization method.

Syntax:

ip timep dhcp
Configures DHCP as the TimeP mode.

For example, suppose:

• Time Synchronization is configured for SNTP.

• You want to:

◦ View the current time synchronization.

◦ Select TimeP as the synchronization mode.

◦ Enable TimeP for DHCP mode.

◦ View the TimeP configuration.

Enabling TimeP in Manual Mode
Like DHCP mode, configuring TimeP for Manual Mode enables TimeP. However, for manual operation, you must
also specify the IP address of the TimeP server. (The switch allows only one TimeP server.) To enable the TimeP
protocol:

Syntax:

timesync timep
Selects TimeP.

Syntax:

ip timep manual <ip-addr>
Activates TimeP in manual mode with a specified TimeP server.

Syntax:

[no] ip timep
Disables TimeP.
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To change from one TimeP server to another, you must use the no ip timep command to disable
TimeP mode, the reconfigure TimeP in manual mode with the new server IP address.

Example:

To select TimeP and configure it for manual operation using a TimeP server address of 10.28.227.141 and the
default poll interval (720 minutes, assuming the TimeP poll interval is already set to the default):

switch(config)# timesync time
Selects TimeP.

switch(config)# ip timep manual 10.28.227.141
Activates TimeP in Manual mode.

Configuring TimeP for manual operation

switch(config)# timesync timep
switch(config)# ip timep manual 10.28.227.141
switch(config)# show timep
 Timep Configuration
  Time Sync Mode: Timep
  TimeP Mode :  Manual              Server Address : 10.28.227.141
  Poll Interval (min) : 720

Changing from one TimeP server to another (CLI)

Procedure

1. Use the no ip timep command to disable TimeP mode.

2. Reconfigure TimeP in Manual mode with the new server IP address.

Changing the TimeP poll interval (CLI)
Syntax:

ip timep {< dhcp | manual >} interval <1-9999>
Specifies how long the switch waits between time polling intervals. The default is 720 minutes and the range is 1
to 9999 minutes. (This parameter is separate from the poll interval parameter used for SNTP operation.)

Example:

To change the poll interval to 60 minutes:

switch(config)# ip timep interval 60

Disabling time synchronization without changing the TimeP configuration (CLI)
Syntax:

no timesync
Disables time synchronization by changing the Time Sync Mode configuration to Disabled. This halts time
synchronization without changing your TimeP configuration. The recommended method for disabling time
synchronization is to use the timesync command.
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Example:

Suppose TimeP is running as the switch's time synchronization protocol, with DHCP as the TimeP mode, and the
factory-default polling interval. You would halt time synchronization with this command:

switch(config)# no timesync
If you then viewed the TimeP configuration, you would see the following:

TimeP with time synchronization disabled

switch(config)# show timep

 Timep Configuration
  Time Sync Mode: Disabled
  TimeP Mode : DHCP Poll Interval (min): 720

Disabling the TimeP mode
Syntax:

no ip timep
Disables TimeP by changing the TimeP mode configuration to Disabled and prevents the switch from using it as
the time synchronization protocol, even if it is the selected Time Sync Method option.

Example:

If the switch is running TimeP in DHCP mode, no ip timep changes the TimeP configuration as shown below
and disables time synchronization. Even though the TimeSync mode is set to TimeP, time synchronization is
disabled because no ip timep has disabled the TimeP mode parameter.

Disabling time synchronization by disabling the TimeP mode parameter

switch(config)# no ip timep

switch(config)# show timep

 Timep Configuration
  Time Sync Mode: Timep
  TimeP Mode : Disabled

SNTP unicast time polling with multiple SNTP servers
When running SNTP unicast time polling as the time synchronization method, the switch requests a time update
from the server you configured with either the Server Address parameter in the menu interface, or the primary
server in a list of up to three SNTP servers configured using the CLI. If the switch does not receive a response
from the primary server after three consecutive polling intervals, the switch tries the next server (if any) in the list.
If the switch tries all servers in the list without success, it sends an error message to the Event Log and
reschedules to try the address list again after the configured Poll Interval time has expired.

If there are already three SNTP server addresses configured on the switch, and you want to use the CLI to
replace one of the existing addresses with a new one, you must delete the unwanted address before you
configure the new one.
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Displaying all SNTP server addresses configured on the switch (CLI)
The System Information screen in the menu interface displays only one SNTP server address, even if the switch
is configured for two or three servers. The CLI show management command displays all configured SNTP
servers on the switch.

How to list all SNTP servers configured on the switch

switch(config)# show management
 
 Status and Counters - Management Address Information

  Time Server Address : fe80::215:60ff:fe7a:adc0%vlan10

  Priority SNTP Server Address                            Protocol Version
  -------- ---------------------------------------------- ----------------
  1 2001:db8::215:60ff:fe79:8980                          7
  2 10.255.5.24                                           3
  3 fe80::123%vlan10                                      3

  Default Gateway : 10.0.9.80

  VLAN Name    MAC Address         | IP Address
  ------------ ------------------- + -------------------
  DEFAULT_VLAN 001279-88a100       | Disabled
  VLAN10       001279-88a100       | 10.0.10.17

Adding and deleting SNTP server addresses

Adding addresses
As mentioned earlier, you can configure one SNTP server address using either the Menu interface or the CLI. To
configure a second and third address, you must use the CLI. To configure the remaining two addresses, you
would do the following:

Creating additional SNTP server addresses with the CLI

switch(config)# sntp server priority <1-3> 2001:db8::215:60ff:fe79:8980
switch(config)# sntp server 10.255.5.24

If there are already three SNTP server addresses configured on the switch, and you want to use the
CLI to replace one of the existing addresses with a new one, you must delete the unwanted address
before you configure the new one.

Deleting addresses
Syntax:

no sntp server <ip-addr>
Deletes a server address. If there are multiple addresses and you delete one of them, the switch re-orders the
address priority.

Example:

To delete the primary address in the above Example: and automatically convert the secondary address to primary:
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switch(config)# no sntp server 10.28.227.141

Operating with multiple SNTP server addresses
configured (Menu)
When you use the Menu interface to configure an SNTP server IP address, the new address writes over the
current primary address, if one is configured.

SNTP messages in the Event Log
If an SNTP time change of more than three seconds occurs, the switch's Event Log records the change. SNTP
time changes of less than three seconds do not appear in the Event Log.

Network Time Protocol (NTP)
All NTP communications use Coordinated Universal Time (UTC). An NTP server usually receives its time from an
authoritative time source, such as a radio clock or an atomic clock attached to a time server, and then distributes
this time across the network. NTP is extremely efficient; no more than one packet per minute is necessary to
synchronize two machines to within a millisecond of each other.

NTP uses a stratum to describe the distance between a network device and an authoritative time source:

• A stratum 1 time server is directly attached to an authoritative time source (such as a radio or atomic clock or a
GPS time source).

• A stratum 2 NTP server receives its time through NTP from a stratum 1 time server.

Before synchronizing, NTP compares the time reported by several network devices and does not synchronize
with one that is significantly different, even if it is a stratum 1.

The security features of NTP can be used to avoid the accidental or malicious setting of incorrect time. One such
mechanism is available: an encrypted authentication mechanism.

Though similar, the NTP algorithm is more complex and accurate than the Simple Network Time Protocol (SNTP).

Enabling this feature results in synchronizing the system clock; therefore, it may affect all sub-
systems that rely on system time.

Commands
The following commands allow the user to configure NTP or show NTP configurations.

timesync Command
This command is used to configure the protocol used for network time synchronization.

Syntax

[no] timesync { timep | sntp | timep-or-sntp | ntp }
Options
no
Deletes all timesync configurations on the device.

timep
Updates the system clock using TIMEP.
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sntp
Updates the system clock using SNTP.

timep-or-sntp
Updates the system clock using TIMEP or SNTP (default).

ntp
Updates the system clock using NTP

Example
switch(config)# timesync
sntp                  Update the system clock using SNTP.
timep                 Update the system clock using TIMEP.
timep-or-sntp         Update the system clock using TIMEP or SNTP.
ntp                   Update the system clock using NTP.

timesync ntp
This command is used to update the system clock using NTP.

Syntax

timesync ntp
Description

Update the system clock using NTP.

ntp
This command selects the operating mode of the NTP client.

Syntax

ntp [broadcast|unicast]
Options
broadcast
Sets ntp client to operate in broadcast mode.

unicast
Sets ntp client to operate in unicast mode.

Usage

The default mode is broadcast.

[no] ntp
This command disables NTP and removes all NTP configurations on the device.

Syntax
[no] ntp [authentication <key-id>
 | broadcast | enable | max-association 
<integer> | server 
<IP-ADDR> | trap 
<trap-name> | unicast]
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Description

Disable NTP and removes the entire NTP configuration.

Options

authentication

Configure NTP authentication.

broadcast

Operate in broadcast mode.

enable

Enable/disable NTP.

max-association

Maximum number of Network Time Protocol (NTP) associations.

server

Configure a NTP server to poll for time synchronization.

trap

Enable/disable NTP traps.

unicast

Operate in unicast mode.

Example
switch(config)# no ntp
This will delete all NTP configurations on this device. Continue [y/n]?

ntp enable
This command is used to enable or disable NTP on the switch.

Syntax

ntp enable
Example
switch(config)# ntp
enable       Enable/disable NTP.
Description

Enable or disable NTP. Use [no] to disable NTP.

Restrictions

Validation Error/Warning/Prompt

If timeSync is in SNTP or Timep when NTP is enabled. Timesync is not configured to NTP.

When timesync is NTP and ntp is enabled and we try to
change timesync to SNTP.

Disable NTP before changing timesync to
SNTP or TIMEP

ntp authentication
This command is used for authentication of NTP server by the NTP client.
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Syntax
ntp authentication key-id <KEY-ID> [authentication-mode <MODE> key-value <KEY-
STRING>] [trusted]
Parameters/Options
key-id <id>
Sets the key-id for the authentication key.

Subcommands
authentication-mode
Sets the NTP authentication mode

key-value <KEY-STRING>
Sets the key-value for the authentication key.

[trusted]
Sets the authentication key as trusted.
Example
Switch(config)# ntp
Authentication      Configure NTP authentication.

Switch(config)# ntp authentication
key-id              Set the key-id for this authentication key.

Switch(config)# ntp authentication key-id 
<1-4294967295>      Set the authentication key-id.

Switch(config)# ntp authentication key-id 1
authentication-mode  Set the NTP authentication mode.
trusted              Set this authentication key as trusted.

Switch(config)# ntp authentication key-id 1 
authentication-mode|trusted md5
Authenticate using MD5.

Switch(config)# ntp authentication key-id 1 
authentication-mode|trusted md5key-value  Set the NTP authentication key.

Switch(config)# ntp authentication key-id 1
authentication-mode|trusted md5 key-value 
KEY           Enter a string to be set as the NTP authentication key.

ntp authentication key-id
Syntax
ntp authentication key-id 
<key-id> [authentication-mode [md5 | sha1]
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 key-value <key-value>] [trusted]
      
Description

The NTP client authenticates the NTP server.

Options

authentication-mode

Set the NTP authentication mode.

• md5: Authenticate using MD5.

• sha1: Authenticate using SHA1.

trusted

Set this authentication key as trusted.

ntp max-association
This command is used to configure the maximum number of servers associated with this NTP client.

Syntax
ntp max-association 
<number>
      
Options
max-association <number>
Sets the maximum number of NTP associations.

Description

Configure maximum number of servers associated with the client. Up to eight servers can be configured as the
maximum.

Restrictions

The range for a maximum number of NTP associations is 1–8.

Example
Switch(config)# ntp
max-associations      Maximum number of NTP associations.

Switch(config)# ntp max-associations
<1-8>                  Enter the number.
Restrictions

Validation Error/Warning/Prompt

When the number of configured NTP servers is more
than the max-associations value.

The maximum number of NTP servers
allowed is <number>.

When the max-associations value is less than the (n)
number of configured NTP servers.

Max-associations value cannot be less
than the number of NTP servers
configured.
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ntp server
This command is used to configure the NTP servers.

Syntax

[no] ntp server

ntp server <IP-ADDR|IPv6-ADDR> [key <key-id>] [oobm] [max-poll <max-poll-val>][min-poll <min-poll-val>][burst | iburst] [version <1-4>]

Parameters/Options
[no]
Removes the unicast NTP configurations on the device.

Subcommands
IP-ADDR
Sets the IPv4 address of the NTP server.

IPV6-ADDR
Sets the IPv6 address of the NTP server.

oobm
Specifies that the NTP Unicast server is accessible over an OOBM interface.

key <key-id>
Specifies the authentication key.

max-poll <max-poll-val>
Configures the maximum time intervals in power of 2 seconds. Range is 4–17 (e.g., 5 would translate to 2 raised
to 5 or 32).

min-poll <min-poll-val>
Configures the minimum time intervals in seconds. Range is 4–17.

burst
Enables burst mode.

iburst
Enables initial burst mode.

version
Sets version 1–4.

Usage

A maximum of 8 NTP servers can be configured.

Example
switch(config)# ntp
server          Allow the software clock to be synchronized by an NTP
time server.
broadcast       Operate in broadcast mode.
unicast         Operate in unicast mode.

switch(config)# ntp server
IP-ADDR         IPv4 address of the NTP server. 
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IPV6-ADDR       IPv6 address of the NTP server.

switch(config)# ntp server <IP-ADDR>
Key             Specify the authentication key.

switch(config)# ntp server <IP-ADDR> key key-id
Max-poll        Configure the maximum time intervals in seconds.

switch(config)# ntp server <IP-ADDR> key key-id max-poll
<4-17>          Enter an integer number.

Switch(config)# ntp server <IP-ADDR> key key-id
Min-poll        Configure the minimum time intervals in seconds.

switch(config)# ntp server <IP-ADDR> key key-id min-poll
<4-17>          Enter an integer number.

switch(config)# ntp server <IP-ADDR> key key-id prefer max-poll 
<max-poll-val> min-poll <min-poll-val>
iburst          Enable initial burst (iburst) mode.
burst           Enable burst mode.

Switch(config)# ntp server IP-ADDR key key-id prefer maxpoll <number>
minpoll <number> iburst
Restrictions

Validation Error/Warning/Prompt

If authentication key-id not configured Authentication key-id has not been
configured.

If Key-id is not marked as trusted Key-id is not trusted.

When min poll value is more than max poll value NTP max poll value should be more than
min poll value.

ntp server key-id
Syntax
ntp server <IP-ADDR |IPV6-ADDR> 
key—id <key-id> [max-poll 
<max-poll-val>] [min-poll 
<min-poll-val>] [burst | iburst]
      
Description

Configure the NTP server. <IP-ADDR> indicates the IPv4 address of the NTP server. <IPV6-ADDR> indicates the
IPv6 address of the NTP server.

Options
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burst

Enables burst mode.

iburst

Enables initial burst (iburst) mode.

key-id

Set the authentication key to use for this server.

max-poll <max-poll-val>

Configure the maximum time intervals in seconds.

min-poll <min-poll-val>

Configure the minimum time intervals in seconds.

ntp ipv6-multicast
This command is used to configure NTP multicast on a VLAN interface.

Syntax
ntp ipv6-multicast
Description

Configure the interface to listen to the NTP multicast packets.

Example
Switch(vlan-2)# ntp
ipv6-multicast       Configure the interface to listen to the NTP multicast packets.
Restrictions

Validation Error/Warning/Prompt

If ipv6 is not enabled on vlan interface IPv6 address not configured on the
VLAN.

debug ntp
This command is used to display debug messages for NTP.

Syntax
debug ntp <event | 
packet>
      
Options
event
Displays event log messages related to NTP.

packets
Displays NTP packet messages.

Description

Enable debug logging. Use [no] to disable debug logging.
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Example
Switch(config)# debug ntp
event                 Display event log messages related to NTP.
packet                Display NTP packet messages.

ntp trap
This command is used to configure NTP traps.

Syntax
ntp trap <trap-name>
      
Description

Enable NTP traps. Use [no] to disable NTP traps.

Options

ntp-mode-change

Trap name resulting in send notification when the NTP entity changes mode, including
starting and stopping (if possible).

ntp-stratum-change

Trap name resulting in send notification when stratum level of NTP changes.

ntp-peer-change

Trap name resulting in send notification when a (new) syspeer has been selected.

ntp-new-association

Trap name resulting in send notification when a new association is mobilized.

ntp-remove-association

Trap name resulting in send notification when an association is demobilized.

ntp-config-change

Trap name resulting in send notification when the NTP configuration has changed.

ntp-leapsec-announced

Trap name resulting in send notification when a leap second has been announced.

ntp-alive-heartbeat

Trap name resulting in send notification periodically (as defined by
ntpEntHeartbeatInterval) to indicate that the NTP entity is still alive.

all

Enable all traps.

Usage

The traps defined below are generated as the result of finding an unusual condition while parsing an NTP packet
or a processing a timer event. Note that if more than one type of unusual condition is encountered while parsing
the packet or processing an event, only the first one will generate a trap. Possible trap names are:

- 'ntpEntNotifModeChange' The notification to be sent when the NTP entity changes
mode, including starting and stopping (if possible).
- 'ntpEntNotifStratumChange' The notification to be sent when stratum level of NTP
changes.
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- 'ntpEntNotifSyspeerChanged' The notification to be sent when a (new) syspeer has
been selected.
- 'ntpEntNotifAddAssociation' The notification to be sent when a new association is
mobilized.
- 'ntpEntNotifRemoveAssociation' The notification to be sent when an association is
demobilized.
- 'ntpEntNotifConfigChanged' The notification to be sent when the NTP configuration
has changed.
- 'ntpEntNotifLeapSecondAnnounced' The notification to be sent when a leap second
has been announced.
- 'ntpEntNotifHeartbeat' The notification to be sent periodically (as defined by
ntpEntHeartbeatInterval) to indicate that the NTP entity is still alive.
- 'ntpEntNotifAll' The notification to be sent when all traps have been enabled

show ntp statistics
This command is used to show NTP statistics.

Syntax
show ntp statistics
Description

Show information about NTP packets.

Examples
Switch(config)# show ntp statistics

NTP Global statistics information

NTP In Packets                : 100
NTP Out Packets               : 110
NTP Bad Version Packets       : 4
NTP Protocol Error Packets    : 0

switch(config)# show ntp statistics

NTP Global statistics information

NTP In Packets             : 100
NTP Out Packets            : 110
NTP Bad Version Packets    : 4    
NTP Protocol Error Packets : 0

show ntp status
Syntax

Description

Show the status of NTP.

show ntp status
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Example
Switch(config)# show ntp status

NTP Status information
NTP Status             : Disabled             NTP Mode        : Broadcast
Synchronization Status : Synchronized         Peer Dispersion : 8.01 sec
Stratum Number         : 2                    Leap Direction  : 1
Reference Assoc Id     : 1                    Clock Offset    : 0.0000 sec
Reference              : 192.0.2.1            Root Delay      : 0.00 sec
Precision              : 2**7                 Root Dispersion : 15.91 sec
NTP Uptime             : 01d 09h 15m          Time Resolution : 1
Drift                  : 0.000000000 sec/sec

System Time            : Tue Aug 25 04:59:11 2015
Reference Time         : Mon Jan  1 00:00:00 1990

show ntp associations
Syntax
show ntp associations [detail 
<IP-ADDR>]
      
Description

Show the status of configured NTP associations.

Options

detail

Show the detailed status of NTP associations configured for the system.

Switch(config)# show ntp associations

                    NTP Associations Entries

Address          St   T  When Poll  Reach   Delay    Offset   Dispersion   
--------------   ---  -- ---- ----- ------ -------   -------  ----------
121.0.23.1       16   u   -  1024    0     0.000     0.000     0.000
231.45.21.4      16   u   -  1024    0     0.000     0.000     0.000
55.21.56.2       16   u   -  1024    0     0.000     0.000     0.000
23.56.13.1        3   u 209  1024  377     54.936   -6.159     12.688
91.34.255.216     4   u 132  1024  377     1.391     0.978     3.860

Switch(config)# show ntp associations detail <IP ADDR>

NTP association information

IP address       : 172.31.32.2                  Peer Mode       : Server  
Status           : Configured, Insane, Invalid  Peer Poll Intvl : 64 
Stratum          : 5                            Root Delay      : 137.77 sec
Ref Assoc ID     : 0                            Root Dispersion : 142.75
Association Name : NTP Association 0            Reach           : 376
Reference ID     : 16.93.49.4                   Delay           : 4.23 sec
Our Mode         : Client                       Offset          : -8.587 sec 
Our Poll Intvl   : 1024                         Precision       : 2**19  
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Dispersion       : 1.62 sec
Association In Packets    : 60
Association Out Packets   : 60
Association Error Packets : 0
Origin Time      : Fri Jul 3 11:39:40 2015
Receive Time     : Fri Jul 3 11:39:44 2015
Transmit Time    : Fri Jul 3 11:39:44 2015

-----------------------------------------------------------------------------
Filter Delay =   4.23    4.14    2.41    5.95    2.37    2.33    4.26    4.33
Filter Offset = -8.59   -8.82   -9.91   -8.42  -10.51  -10.77  -10.13  -10.11

show ntp authentication
Syntax

Description

Show the authentication status and other information about the authentication key.

show ntp authentication

Switch(config)# show ntp authentication

NTP Authentication Information

Key-ID     Auth Mode   Trusted
--------   ----------  -------
67            md5        yes 
7             md5        no  
1             sha1       yes 
2             sha1       no
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Validation rules

Validation Error/Warning/Prompt

If access-list name is not valid. Please enter a valid access-list name.

If the authentication method is being set to
two-factor authentication, various messages
display.

If both the public key and username/password are not
configured: Public key and username/password should
be configured for a successful two-factor
authentication.

If public key is configured and username is not
configured:

Username and password should be configured for a
successful two-factor authentication.

If the username is configured and public key is not
configured:

Public key should be configured for a successful two-
factor authentication.

If “ssh-server” certificate is not installed at the time of
enabling certificate-password authentication:

The “ssh-server” certificate should be installed for a
successful two-factor authentication.

If the authentication method is set to two-
factor while installing the public key, a
message displays.

The client public keys without username will not be
considered for the two-factor authentication for the SSH
session.

If the username and the key installation user
for that privilege do not match, a message
displays and installation is not allowed.

This will also happen when the
authentication method is set for two-factor.

The username in the key being installed does not
match the username configured on the switch.

If the maximum number of <username : TA
profile> associations is reached for a given
TA profile, a message displays.

Maximum number of username associations with a TA
profile is 10.

If secondary authentication type for two-
factor authentication chosen is not "none", a
message displays.

Not legal combination of authentication methods.

If the authentication method is anything other
than two-factor and the two-factor
authentication method options are set, a
message displays.

Not legal combination of authentication methods.

If two-factor authentication is set and user
tries to SSH into another system using ssh
<ip | hostname> command, a message
displays.

SSH client is not supported when the two-factor
authentication is enabled.

Table Continued
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Validation Error/Warning/Prompt

If timeSync is in SNTP or Timep when NTP
is enabled.

Timesync is not configured to NTP.

If timesync is NTP and NTP is enabled and
we try to change timesync to SNTP.

Disable NTP before changing timesync to SNTP or
TIMEP.

If we try to configure NTP servers more than
the configured max-associations value.

The maximum number of NTP servers allowed is 2.

If we have ‘n’ NTP servers configured and
we try to configure a max-associations value
less than (n) number of NTP servers already
configured.

Max-associations value cannot be less than the
number of NTP servers configured.

If authentication key-id is not configured. Authentication key-id %d has not been configured.

If key-id is not marked as trusted. Key-id %d is not trusted.

If min poll value is more than max poll value. NTP max poll value should be more than min poll
value.

If ipv6 is not enabled on vlan interface. IPv6 address not configured on the VLAN.
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Event log messages

Cause

Event Message

RMON_AUTH_TWO_FACTOR_AUTHEN_STATUS W 01/01/15 18:24:03 03397: auth: %s.

Examples:

W 01/01/15 18:24:03 03397: auth: Public key and
username/password should be configured for the
successful two-factor authentication.

W 01/01/15 18:24:03 03397: auth: Username and
password should be configured for the successful
two-factor authentication.

W 01/01/15 18:24:03 03397: auth: Public key should
be configured for the successful two-factor
authentication.

I 01/01/15 18:24:03 03397: auth: The validation of
certificate of SSH user ‘user1’ is successful.

RMON_SSH_KEY_TWO_FACTOR_EN W 01/01/15 18:24:03 03399: ssh: %s.

Examples:

W 01/01/15 18:24:03 03399: ssh: The client public
keys without username will not be considered for the
two-factor authentication for SSH session.

W 01/01/15 18:24:03 03399: ssh: The privilege level
for the user with the SSH key conflicts with the user
configured.

RMON_SSH_TWO_FACTOR_AUTH_FAIL W 01/01/15 18:24:03 03398: ssh: %s.

Examples:

W 01/01/15 18:24:03 03398: ssh: The two-factor
authentication for SSH session failed due to the
failure in public key authentication.

W 01/01/15 18:24:03 03398: ssh: The two-factor
authentication for SSH session failed due to the
failure in username/password authentication.

W 01/01/15 18:24:03 03398: ssh: The two-factor
authentication for SSH session failed due to the
failure in validating the client certificate.

W 01/01/15 18:24:03 03398: ssh: The two-factor
authentication for SSH session failed as “ssh-server”
certificate is not installed.

When NTP client enabled. NTP client is enabled.

When NTP client disabled. NTP client is disabled.
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Event Message

When NTP found a new broadcast server. A new broadcast server at %s.

When system clock was updated with new time. The system clock time was changed by %ld sec %lu
nsec. The new time is %s.

When NTP stratum was updated. The NTP Stratum was changed from %d to %d.

When all NTP associations are cleared. All the NTP server associations are reset.

When server is not reachable. The NTP Server 10.1.1.2 is unreachable. (2 times in
60 seconds)

When MD5/SHA1 authentication failed. The MD5 authentication on the NTP packet failed.

The SHA1 authentication on the NTP packet failed.
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Viewing port status and configuring port parameters

Connecting transceivers to fixed-configuration devices
If the switch either fails to show a link between an installed transceiver and another device or demonstrates errors
or other unexpected behavior on the link, check the port configuration on both devices for a speed and/or duplex
(mode) mismatch.

• To check the mode setting for a port on the switch, use either the Port Status screen in the menu interface or
show interfaces brief in the CLI (see Viewing port status and configuration (CLI)).

• To display information about the transceivers installed on a switch, enter the show tech receivers
command in the CLI (The show tech transceivers command on page 63).

Viewing port configuration (Menu)
The menu interface displays the configuration for ports and (if configured) any trunk groups.

From the Main Menu, select:

1. Status and Counters 4. Port Status

A switch port status screen

==========================- CONSOLE - MANAGER MODE -==========================
                       Status and Counters - Port Status

                  Intrusion                           MDI   Flow  Bcast
  Port     Type     Alert   Enabled Status     Mode   Mode  Ctrl  Limit
  ----- --------- --------- ------- ------ ---------- ----- ----- ------
  1     100/1000T No        Yes     Down   100FDx     Auto  off   0
  2     100/1000T No        Yes     Down   1000FDx    Auto  off   0
  3     100/1000T No        Yes     Down   1000FDx    Auto  off   0
  4     100/1000T No        Yes     Down   1000FDx    Auto  off   0
  5     100/1000T No        Yes     Down   1000FDx    Auto  off   0
  6     100/1000T No        Yes     Down   1000FDx    Auto  off   0
  7     100/1000T No        Yes     Down   1000FDx    Auto  off   0
  8     100/1000T No        Yes     Down   1000FDx    Auto  off   0
  9     100/1000T No        Yes     Down   1000FDx    Auto  off   0
  10    100/1000T No        Yes     Down   1000FDx    Auto  off   0
  11    100/1000T No        Yes     Down   1000FDx    Auto  off   0

 Actions->   Back   Intrusion log   Help

Return to previous screen.
Use up/down arrow keys to scroll to other entries, left/right arrow keys to
change action selection, and <Enter> to execute action.

Chapter 3
Port Status and Configuration
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Port Type The port Type field represents the IEEE or other industry protocol in operation on that port. For
example, 1000Base-SX is a gigabit protocol for gigabit operation over fiber optic cable.

Status of
Ports

A port can be enabled or disabled:

• Yes: Enabled, the default. This indicates the port is ready for a network connection.

• No: Disabled, the port will not operate, even if properly connected to a network. Use the setting,
For example, to shut the port down for diagnostic purposes or while you are making topology
changes.

The status of a port can be up or down (Read-only):

Up: The port senses a link beat.

Down: The port is not enabled, has no cables connected, or is experiencing a network error. For
troubleshooting information, see the installation and getting started guide for your switch.

Flow
Control

With the port mode set to Auto (the default) and flow control on (enabled), the switch negotiates
flow control on the indicated port. If the port mode is not set to Auto, or if flow control is off
(disabled) on the port, then flow control is not used. Flow control must be enabled on both ends of
a link.

• On: Enabled. The port uses 802.3x Link Layer Flow Control, generates flow control packets,
and processes received flow control packets.

• Off: Disabled (default).The port does not generate flow control packets, and drops any flow
control packets it receives.

Broadcast
Limit

The broadcast limit specifies the percentage of the theoretical maximum network bandwidth that
can be used for broadcast and multicast traffic. Any broadcast or multicast traffic exceeding that
limit will be dropped. Zero (0) means the feature is disabled.

The broadcast-limit command operates at the port context level to set the broadcast limit for a
port on a switch.

This feature is not appropriate for networks that require high levels of IPX or RIP
broadcast traffic.

Modes The mode is the port’s speed and duplex (date transfer operation) setting. The following table
shows possible modes available, depending on the port type (copper or fiber) and port speed.

Table 3: Supported Modes

Mode Speed and Duplex Settings

Auto-MDIX Senses speed and negotiates with the port at the other end of the link for port operation (MDI-X
or MDI). To see what the switch negotiates for the Auto setting, use the CLI show interfaces
brief command or the menu commands “1. Status and Counters”, “3. Port Status”.This
features applies only to copper port switches using twisted-pair copper Ethernet cables.

MDI Sets the port to connect with a PC using a crossover cable (Manual mode— applies only to
copper port switches using twisted-pair copper Ethernet cables).

Table Continued
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Mode Speed and Duplex Settings

MDIX Sets the port to connect with a PC using a straight-through cable (Manual mode—applies only to
copper port switches using twisted-pair copper Ethernet cables).

Auto-10 Allows the port to negotiate between half-duplex (HDx) and full-duplex (FDx) while keeping
speed at 10Mbps. Also negotiates flow control (enabled or disabled). Hewlett Packard
Enterprise recommends Auto-10 for links between 10/100 auto-sensing ports connected with
Cat 3 cabling. (Cat 5 cabling is required for 100 Mbps links.)

Auto-100 Uses 100 Mbps and negotiates with the port at the other end of the link for other port operation
features.

Auto-10-100 Allows the port to establish a link with the port at the other end at either 10 Mbps or 100 Mbps,
using the highest mutual speed and duplex mode available. Only these speeds are allowed with
this setting.

Auto-1000 Uses 1000 Mbps and negotiates with the port at the other end of the link for other port operation
features.

10HDx Uses 10 Mbps, Half-Duplex

100HDx Uses 100 Mbps, Half-Duplex

10FDX Uses 10 Mbps, Full-Duplex

100FDx Uses 100 Mbps, Full-Duplex

1000FDx Uses 1000 Mbps, Full-Duplex

10 GbE FDx Uses 10 Gigabits/sec Full-Duplex

The next two tables display the protocols and modes supported for copper ports and fiber optic ports, respectively.

Table 4: Protocols and modes supported for copper ports

10/100 Mbps Gigabit 10 Gigabit

10/100 TX 10/100/1000-T 10GBASE-CX4

Modes Settings Modes Settings Modes Settings

Auto

10HDx

100HDx

10FDx

100FDx

100FDx

10HDx

100HDx

10FDx

100FDX

Auto

Auto-10

Auto-100

Auto-10-100

Auto-1000

10HDx

100HDX

1000FDx

10HDx

100FDx

100FDx

1000FDx

10HDx

100HDx

Auto 10 Gigabit FDx
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Table 5: Protocols and modes supported for fiber optic ports

100 Mbps Gigabit 10 Gigabit

Protocols 100BASE-FX

100BASE-BX10

1000BASE-SX

1000BASE-LX

1000BASE-BX

101000BASE-LH

10GBASE-SR

10GBASE-LR

10GBASE-LRM

Modes 100HDx

100FDx

Auto1000FDx Auto

Configuring ports (Menu)
The menu interface uses the same screen for configuring both individual ports and port trunk groups. For
information on port trunk groups, see the chapter on "Port Trunking".

Procedure

1. From the Main Menu, select:

2. Switch Configuration…

2. Port/Trunk Settings

Port/trunk settings with a trunk group configured

=====================- TELNET - MANAGER MODE -=====================
              Switch Configuration - Port/Trunk Settings

  Port     Type     Enabled      Mode      Flow Ctrl  Group  Type
  ----   -------- + --------  -----------  ---------  -----  -----
  A1     1000T    | Yes       Auto-10-100  Disable
  A2     1000T    | Yes       Auto-10-100  Disable
  A3     1000T    | Yes       Auto         Disable
  A3     1000T    | Yes       Auto         Disable
  A4     1000T    | Yes       Auto         Disable
  A5     1000T    | Yes       Auto         Disable
  A6     1000T    | Yes       Auto         Disable
  A7     1000T    | Yes       Auto         Disable    Trk1   Trunk
  A8     1000T    | Yes       Auto         Disable    Trk2   Trunk

 Actions->   Cancel    Edit    Save    Help

Cancel changes and return to previous screen.
Use arrow keys to change action selection and <Enter> to execute
action.

2. Press [E] (for Edit).

The cursor moves to the Enabled field for the first port.

For further information on configuration options for these features, see the online help provided with this
screen.

3. When you have finished making changes to the above parameters, press [Enter], then press [S] (for
Save).
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Viewing port status and configuration (CLI)
Use the following commands to display port status and configuration data.

Syntax:

show interfaces [brief | config | < port-list >]
brief

Lists the current operating status for all ports on the switch.

config
Lists a subset of configuration data for all ports on the switch; that is, for each port, the display shows whether
the port is enabled, the operating mode, and whether it is configured for flow control.

<port-list>
Shows a summary of network traffic handled by the specified ports.

The show interfaces brief command listing

switch(config)# show interfaces brief
Status and Counters - Port Status

                | Intrusion                            MDI   Flow  Bcast
Port  Type      | Alert     Enabled Status Mode        Mode  Ctrl  Limit
----- --------- + --------- ------- ------ ----------  ----- ----- ------
B1    100/1000T | No        Yes     Down   Auto-10-100 Auto  off   0
B2    100/1000T | No        Yes     Down   1000FDx     Auto  off   0
B3    100/1000T | No        Yes     Down   1000FDx     Auto  off   0
B4    100/1000T | No        Yes     Down   1000FDx     Auto  off   0
B5    100/1000T | No        Yes     Down   1000FDx     Auto  off   0
B6    100/1000T | No        Yes     Down   1000FDx     Auto  off   0

The show interfaces config command listing

switch(config)# show interfaces config

 Port Settings

  Port  Type      | Enabled Mode         Flow Ctrl MDI
  ----- --------- + ------- ------------ --------- ----
  B1    100/1000T | Yes     Auto-10-100  Disable   Auto
  B2    100/1000T | Yes     Auto         Disable   Auto
  B3    100/1000T | Yes     Auto         Disable   Auto
  B4    100/1000T | Yes     Auto         Disable   Auto
  B5    100/1000T | Yes     Auto         Disable   Auto
  B6    100/1000T | Yes     Auto         Disable   Auto

Dynamically updating the show interfaces command (CLI/Menu)
Syntax:

show interfaces display
Uses the display option to initiate the dynamic update of the show interfaces command, with the output
being the same as the show interfaces command.
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Select Back to exit the display.

Example:

switch# show interfaces display
When using the display option in the CLI, the information stays on the screen and is updated every 3 seconds, as
occurs with the display using the menu feature. The update is terminated with Cntl-C.

You can use the arrow keys to scroll through the screen when the output does not fit in one screen.

Figure 6: show interfaces display command with dynamically updating output

Customizing the show interfaces command (CLI)
You can create show commands displaying the information that you want to see in any order you want by using
the custom option.

Syntax:
show interfaces custom [port-list] column-list
Select the information that you want to display. Supported columns are shown in the table below.

Table 6: Supported columns, what they display, and examples:

Parameter column Displays Examples

port Port identifier A2

type Port type 100/1000T

status Port status up or down

Table Continued
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Parameter column Displays Examples

speed Connection speed and duplex 1000FDX

mode Configured mode auto, auto-100, 100FDX

mdi MDI mode auto, MDIX

flow Flow control on or off

name Friendly port name

vlanid The vlan id this port belongs to, or "tagged" if it
belongs to more than one vlan

4tagged

enabled port is or is not enabled yes or nointrusion

intrusion Intrusion alert status no

bcast Broadcast limit 0

The custom show interfaces command

switch(config)# show int custom 1-4 port name:4 type vlan intrusion speed enabled mdi

 Status and Counters - Custom Port Status

                                   Intrusion
  Port Name       Type       VLAN  Alert     Speed   Enabled MDI-mode
  ---- ---------- ---------- ----- --------- ------- ------- --------
  1    Acco       100/1000T  1     No        1000FDx Yes     Auto
  2    Huma       100/1000T  1     No        1000FDx Yes     Auto
  3    Deve       100/1000T  1     No        1000FDx Yes     Auto
  4    Lab1       100/1000T  1     No        1000FDx Yes     Auto
You can specify the column width by entering a colon after the column name, then indicating the number of
characters to display. In the above example, the Name column displays only the first four characters of the name.
All remaining characters are truncated.

Each field has a fixed minimum width to be displayed. If you specify a field width smaller than the
minimum width, the information is displayed at the minimum width. For example, if the minimum
width for the Name field is 4 characters and you specify Name:2, the Name field displays 4
characters.

You can enter parameters in any order. There is a limit of 80 characters per line; if you exceed this limit an error
displays.

Error messages associated with the show interfaces command
The following table provides information on error messages associated with the show interfaces custom
command.

Chapter 3 Port Status and Configuration 61

Anexo 04 ITEM 10 (0592646)         SEI 0008478-63.2018.6.02.8000 / pg. 5120



Error Error message

Requesting too many fields (total characters exceeds
80)

Total length of selected data exceeds one line

Field name is misspelled Invalid input: <input>

Mistake in specifying the port list Module not present for port or invalid port: <input>

The port list is not specified Incomplete input: custom

Note on using pattern matching with the show interfaces custom command
If you have included a pattern matching command to search for a field in the output of the show int custom
command, and the show int custom command produces an error, the error message may not be visible and
the output is empty. For example, if you enter a command that produces an error (such as vlan is misspelled) with
the pattern matching include option, the output may be empty:

HP Switch(config)# show int custom 1-3 name vlun  |  include vlan1
It is advisable to try the show int custom command first to ensure there is output, and then enter the
command again with the pattern matching option.

Note that in the above command, you can substitute int for interface; that is: show int custom.

Viewing port utilization statistics (CLI)
Use the show interface port-utilization command to view a real-time rate display for all ports on the
switch. The example below shows a sample output from this command.

A show interface port-utilization command listing

switch(config)# show interfaces port-utilization
 Status and Counters - Port Utilization

                             Rx                            Tx
 Port  Mode     | -------------------------- | --------------------------
                | Kbits/sec  Pkts/sec  Util  | Kbits/sec  Pkts/sec  Util
 ----- -------- + ---------- --------- ----- + ---------- --------- -----
 B1    1000FDx  | 0          0         0     | 0          0         0 
 B2    1000FDx  | 0          0         0     | 0          0         0 
 B3    1000FDx  | 0          0         0     | 0          0         0 
 B4    1000FDx  | 0          0         0     | 0          0         0 
 B5    1000FDx  | 0          0         0     | 0          0         0 
 B6    1000FDx  | 0          0         0     | 0          0         0 
 B7     100FDx  | 624        86        00.62 | 496        0         00.49 
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Operating notes for viewing port utilization statistics

• For each port on the switch, the command provides a real-time display of the rate at which data is received
(Rx) and transmitted (Tx) in terms of kilobits per second (KBits/s), number of packets per second (Pkts/s), and
utilization (Util) expressed as a percentage of the total bandwidth available.

• The show interfaces <port-list> command can be used to display the current link status and the port
rate average over a 5 minute period. Port rates are shown in bits per second (bps) for ports up to 1 Gigabit; for
10 Gigabit ports, port rates are shown in kilobits per second (Kbps).

Viewing transceiver status (CLI)
The show interfaces transceivers command allows you to:

• Remotely identify transceiver type and revision number without having to physically remove an installed
transceiver from its slot.

• Display real-timestatus information about all installed transceivers, including non-operational transceivers.

The example shows sample output from the show tech transceivers command.

Part # column below enables you to determine the manufacturer for a specified transceiver and
revision number.

The show tech transceivers command

switch# show tech transceivers

Transceiver Technical Information:
 Port # |   Type    | Prod # | Serial #         | Part #
 -------+-----------+--------+------------------+----------
 21     | 1000SX    | J4858B | CN605MP23K       |
 22     | 1000LX    | J4859C | H11E7X           | 2157-2345
 23     | ??        | ??     | non operational  | 
 25     | 10GbE-CX4 | J8440A | US509RU079       | 
 26     | 10GbE-CX4 | J8440A | US540RU002       | 
 27     | 10GbE-LR  | J8437B | PPA02-2904:0017  | 2157-2345
 28     | 10GbE-SR  | J8436B | 01591602         | 2158-1000
 29     | 10GbE-ER  | J8438A | PPA03-2905:0001  | 

The following transceivers may not function correctly:
 Port #         Message
 --------       ------------------------
 Port 23        Self test failure.

Operating Notes
The following information is displayed for each installed transceiver:

• Port number on which transceiver is installed.

• Type of transceiver.

• Product number — Includes revision letter, such as A, B, or C. If no revision letter follows a product number,
this means that no revision is available for the transceiver.

• Part number — Allows you to determine the manufacturer for a specified transceiver and revision number.
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• For a non-HPE switches installed transceiver (see line 23 of "The show tech transceivers command"
example), no transceiver type, product number, or part information is displayed. In the Serial Number field,
non-operational is displayed instead of a serial number.

• The following error messages may be displayed for a non-operational transceiver:

◦ Unsupported Transceiver. (SelfTest Err#060)
◦ This switch only supports revision B and above transceivers.
◦ Self test failure.
◦ Transceiver type not supported in this port.
◦ Transceiver type not supported in this software version.
◦ Not an HPE Switch Transceiver.

Enabling or disabling ports and configuring port mode (CLI)
You can configure one or more of the following port parameters.

Syntax:

[no] interface <port-list> [<disable|enable>]
Disables or enables the port for network traffic. Does not use the no form of the command. (Default: enable.)

speed-duplex [<auto-10|10-full|10-half|100-full|100-half|auto|auto-100|1000-full>]
Note that in the above Syntax:, you can substitute int for interface (for example, int <port-list> ).

Specifies the port's data transfer speed and mode. Does not use the no form of the command. (Default: auto.)

The 10/100 auto-negotiation feature allows a port to establish a link with a port at the other end at either 10 Mbps
or 100 Mbps, using the highest mutual speed and duplex mode available. Only these speeds are allowed with this
setting.

Examples:

To configure port C5 for auto-10-100, enter this command:

switch(config)# int c5 speed-duplex auto-10-100
To configure ports C1 through C3 and port C6 for 100Mbps full-duplex, enter these commands:

switch(config)# int c1-c3,c6 speed-duplex 100-full
Similarly, to configure a single port with the above command settings, you could either enter the same command
with only the one port identified or go to the context level for that port and then enter the command. For example,
to enter the context level for port C6 and then configure that port for 100FDx:

switch(config)# int e c6
switch(eth-C6)# speed-duplex 100-full
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If port C8 was disabled, and you wanted to enable it and configure it for 100FDx with flow-control active, you
could do so with either of the following command sets:

Figure 7: Two methods for changing a port configuration

For more on flow control, see Enabling or disabling flow control (CLI) on page 65.

Enabling or disabling flow control (CLI)

You must enable flow control on both ports in a given link. Otherwise, flow control does not operate
on the link and appears as Off in the show interfaces brief port listing, even if flow control is
configured as enabled on the port in the switch. (See The show interfaces brief command
listing example.) Also, the port (speed-duplex) mode must be set to Auto (the default).

To disable flow control on some ports, while leaving it enabled on other ports, just disable it on the individual ports
you want to exclude.

Syntax:

[no] interface <port-list> flow-control
Enables or disables flow control packets on the port. The no form of the command disables flow control on the
individual ports. (Default: Disabled.)

Examples:

Suppose that:

1. You want to enable flow control on ports A1-A6.

2. Later, you decide to disable flow control on ports A5 and A6.

3. As a final step, you want to disable flow control on all ports.
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Assuming that flow control is currently disabled on the switch, you would use these commands:

Figure 8: Configuring flow control for a series of ports

switch(config)# int a1-a6 flow-control

switch(config)# show interfaces brief

 Status and Counters - Port Status

                   | Intrusion                           MDI  Flow Bcast
  Port   Type      | Alert     Enabled Status Mode       Mode Ctrl Limit
  ------ --------- + --------- ------- ------ ---------- ---- ---- ----- 
  A1     10GbE-T   | No        Yes     Up     1000FDx    NA   on   0
  A2     10GbE-T   | No        Yes     Up     10GigFD    NA   on   0
  A3     10GbE-T   | No        Yes     Up     10GigFD    NA   on   0
  A4     10GbE-T   | No        Yes     Up     10GigFD    NA   on   0
  A5     10GbE-T   | No        Yes     Up     10GigFD    NA   on   0
  A6     10GbE-T   | No        Yes     Up     10GigFD    NA   on   0
  A7     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A8     10GbE-T   | No        Yes     Up     10GigFD    NA   off  0

switch(config)# no int a5-a6 flow-control

switch(config)# show interfaces brief

 Status and Counters - Port Status

                   | Intrusion                           MDI  Flow Bcast
  Port   Type      | Alert     Enabled Status Mode       Mode Ctrl Limit
  ------ --------- + --------- ------- ------ ---------- ---- ---- ----- 
  A1     10GbE-T   | No        Yes     Up     1000FDx    NA   on   0
  A2     10GbE-T   | No        Yes     Down   10GigFD    NA   on   0
  A3     10GbE-T   | No        Yes     Down   10GigFD    NA   on   0
  A4     10GbE-T   | No        Yes     Down   10GigFD    NA   on   0
  A5     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A6     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A7     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A8     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0

switch(config)# no int a1-a4 flow-control

switch(config)# show interfaces brief

 Status and Counters - Port Status

                   | Intrusion                           MDI  Flow Bcast
  Port   Type      | Alert     Enabled Status Mode       Mode Ctrl Limit
  ------ --------- + --------- ------- ------ ---------- ---- ---- ----- 
  A1     10GbE-T   | No        Yes     Down   1000FDx    NA   off  0
  A2     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A3     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A4     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A5     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A6     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A7     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A8     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
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Configuring a broadcast limit
Broadcast-Limit on switches covered in this guide is configured on a per-port basis. You must be at the port
context level for this command to work, for example:

switch(config)#int 1
switch(int 1)# broadcast-limit 1

Broadcast-limit
Syntax:

broadcast-limit <0-99>
Enables or disables broadcast limiting for outbound broadcasts on a selected port on the switch. The value
selected is the percentage of traffic allowed, for example, broadcast-limit 5 allows 5% of the maximum
amount of traffic for that port. A value of zero disables broadcast limiting for that port.

You must switch to port context level before issuing the broadcast-limit command.

This feature is not appropriate for networks requiring high levels of IPX or RIP broadcast traffic.

Syntax:

show config
Displays the startup-config file. The broadcast limit setting appears here if enabled and saved to the startup-config
file.

Syntax:

show running-config
Displays the running-config file. The broadcast limit setting appears here if enabled. If the setting is not also saved
to the startup-config file, rebooting the switch returns broadcast limit to the setting currently in the startup-config
file.

For example, the following command enables broadcast limiting of 1 percent of the traffic rate on the selected port
on the switch:

switch(int 1)# broadcast-limit 1
For a one Gbps port this results in a broadcast traffic rate of ten Mbps.

Port shutdown with broadcast storm
A LAN broadcast storm arises when an excessively high rate of broadcast packets flood the LAN. Occurrence of
LAN broadcast storm disrupts traffic and degrades network performance. To prevent LAN traffic from being
disrupted, an enhancement of fault-finder commands adds new options, and the corresponding MIBs, that trigger
a port disablement when a broadcast storm is detected on that port.

Under this enhancement, the CLI commands given only supports broadcast traffic and not multicast and unicast
types of traffic.

The waiting period range for re-enabling ports is 0 to 604800 seconds. The default waiting period to re-enable a
port is zero which prevents the port from automatic re-enabling.

Avoid port flapping when choosing the waiting period by considering the time to re-enable carefully.
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Use the following commands to configure the broadcast-storm on a port.

Syntax:

[no] fault-finder broadcast-storm [ethernet] <port-list> action [warn|warn-and-disable <seconds>] [percent <percent>|pps <rate>]

To remove the current configuration of broadcast-storm on a port, use:

Syntax:

no fault-finder broadcast-storm [ethernet] <port-list>
broadcast-storm

Configure broadcast storm control.

pps
Rising threshold level in number of broadcast packets per second.

percent
Rising threshold level as a percentage of bandwidth of the port. The percentage is calculated on 64 byte
packet size.

warn
Log the event only.

warn-and-disable
Log the event and disable the port.

seconds
Re-enable the port after waiting for the specified number of seconds. Default is not to re-enable.

Configuration examples:
switch(config)# fault-finder broadcast-storm [ethernet] <A1> action [warn-and-disable <65535>]< percent 10>
switch(config)# fault-finder broadcast-storm [ethernet] <A2> action [warn-and-disable <pps 100>
switch(config)# fault-finder broadcast-storm [ethernet] <A22> action [warn] <pps 100>

Viewing broadcast storm
Use the following command to display the broadcast-storm-control configuration.

Syntax:

show fault-finder broadcast-storm [[ethernet] port-list]
Examples:
switch# show fault-finder broadcast-storm [A1]

Port Bcast Storm Port Status Rising
Threshold

Action Disable
Timer

Disable
Timer Left

A1 Yes Down 10% warn-and-
disable

65535 —

switch (config)# show fault-finder broadcast-storm
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Port Bcast Storm Port Status Rising
Threshold

Action Disable
Timer

Disable
Timer Left

A1 Yes Down 200 pps warn-and-
disable

10 9

switch (config)# show fault-finder broadcast-storm A1

Port Bcast Storm Port Status Rising
Threshold

Action Disable
Timer

Disable
Timer Left

A1 No Up — none — —

switch (config)# show fault-finder broadcast-storm

Port Bcast Storm Port Status Rising
Threshold

Action Disable
Timer

Disable
Timer Left

A1 Yes Up 75% warn — —

SNMP MIB
SNMP support will be provided through the following MIB objects:

hpicfFfBcastStormControlPortConfig OBJECT IDENTIFIER

:: = { hpicfFaultFinder 5 }

hpicfFfBcastStormControlPortConfigTable OBJECT-TYPE

• syntax sequence: HpicfFfBcastStormControlPortConfigEntry

• max-access: not-accessible

• status: current

• description: This table provides information about broadcast storm control configuration of all ports.::=
{hpicfFfBcastStormControlPortConfig 1}

hpicfFfBcastStormControlPortConfigEntry OBJECT-TYPE

• syntax HpicfFfBcastStormControlPortConfigEntry

• max-access: not-accessible

• status: current

• description: This object provides information about broadcast storm control configuration of each port.

• index: {hpicfffbcaststormcontrolportindex}::= {hpicfFfBcastStormControlPortConfigTable 1}

hpicfFfBcastStormControlPortConfigEntry ::=

Syntax sequence:hpicfFfBcastStormControlPortIndex InterfaceIndex,

hpicfFfBcastStormControlMode Integer,

hpicfFfBcastStormControlRisingpercent Integer32,

hpicfFfBcastStormControlRisingpps Integer32,
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hpicfFfBcastStormControlAction Integer,

hpicfFfBcastStormControlPortDisableTimer Unsigned32

hpicfFfBcastStormControlPortIndex OBJECT-TYPE

• Syntax: Interfaceindex

• max-access: not-accessible

• status: current

• description: The Index Value Which Uniquely Identifies A Row In The Interfaces Table.

::= {hpicfFfBcastStormControlPortConfigEntry 1}

hpicfFfBcastStormControlMode OBJECT-TYPE

• Syntax Integer: disabled(1), Bcastrisinglevelpercent(2), Bcastrisinglevelpps(3)

• max-access: read-write

• status: current

• description: The broadcast storm control mode of a port. A value of disable (1) indicates that no rising
threshold value is set for broadcast storm traffic on this port. A value of bcastrisinglevelpercent (2) indicates
that the rising threshold rate for broadcast storm traffic is configured in percentage of port bandwidth. A value
of bcastrisinglevelpps (3) indicates that the rising threshold rate for broadcast storm traffic is configured in
packets per second.

• DEFVAL: disabled

::= {hpicfFfBcastStormControlPortConfigEntry 2}

hpicfFfBcastStormControlRisingpercent OBJECT-TYPE

• Syntax Integer32 (1..100)

• max-access: read-write

• status: current

• description: This Is The Rising Threshold Level in percent of bandwidth of the port.
hpicfFfBcastStormControlAction occurs when broadcast traffic reaches this level.

::= {hpicfFfBcastStormControlPortConfigEntry 3}

hpicfFfBcastStormControlRisingpps OBJECT-TYPE

• Syntax Integer32 (1..10000000)

• max-access: read-write

• status: current

• description: This object indicates the rising threshold for broadcast storm control. This value is in packets-per-
second of received broadcast traffic. hpicfffbcaststormcontrolaction object takes action when broadcast
traffic reaches this level.
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::= {hpicfFfBcastStormControlPortConfigEntry 4}

hpicfFfBcastStormControlAction OBJECT-TYPE

• Syntax integer: none(1), warn(2), warnanddisable(3)

• max-access: read-write

• status: current

• Description: This object defines the action taken by the switch when a broadcast storm occurs on a port. A
value of none (1) indicates that no action is performed. A value of warn (2) indicates that an event is logged
when broadcast traffic crosses the threshold value set on that port. A value of warn-and-disable (3) indicates
that the port is disabled and an event is logged as soon as the broadcast traffic reaches the threshold value
set on that port.

• DEFVAL: none

::= {hpicfFfBcastStormControlPortConfigEntry 5}

hpicfFfBcastStormControlPortDisableTimer OBJECT-TYPE

• Syntax Unsigned32 (0..604800)

• Units: seconds

• max-access: read-write

• status: current

• Description: This object specifies the time period for which the port remains in disabled state. A port is disabled
when broadcast traffic reaches the threshold value set on that port. This time period is specified in seconds.
The default value is zero which means that the port remains disabled and is not enabled again.

• DEFVAL {0}

::= {hpicfFfBcastStormControlPortConfigEntry 6}

Configuring auto-MDIX
Copper ports on the switch can automatically detect the type of cable configuration (MDI or MDI-X) on a
connected device and adjust to operate appropriately.

This means you can use a "straight-through" twisted-pair cable or a "crossover" twisted-pair cable for any of the
connections—the port makes the necessary adjustments to accommodate either one for correct operation. The
following port types on your switch support the IEEE 802.3ab standard, which includes the "Auto MDI/MDI-X"
feature:

• 10/100-TX xl module ports

• 100/1000-T xl module ports

• 10/100/1000-T xl module ports

Using the above ports:
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• If you connect a copper port using a straight-through cable on a switch to a port on another switch or hub that
uses MDI-X ports, the switch port automatically operates as an MDI port.

• If you connect a copper port using a straight-through cable on a switch to a port on an end node—such as a
server or PC—that uses MDI ports, the switch port automatically operates as an MDI-X port.

Auto-MDIX was developed for auto-negotiating devices, and was shared with the IEEE for the development of the
IEEE 802.3ab standard. Auto-MDIX and the IEEE 802.3ab Auto MDI/MID-X feature are completely compatible.
Additionally, Auto-MDIX supports operation in forced speed and duplex modes.

For more information on this subject, see the IEEE 802.3ab standard reference. For more information on MDI-X,
the installation and getting started guide for your switch.

Manual override
If you require control over the MDI/MDI-X feature, you can set the switch to either of these non-default modes:

• Manual MDI

• Manual MDI-X

The table below shows the cabling requirements for the MDI/MDI-X settings.

Table 7: Cable types for auto and manual MDI/MDI-X settings

Setting MDI/MDI-X device type

PC or other MDI device type Switch, hub, or other MDI-X device

Manual MDI Crossover cable Straight-through cable

Manual MDI-X Straight-through cable Crossover cable

Auto-MDI-X (the default) Either crossover or straight-through cable

The AutoMDIX features apply only to copper port switches using twisted-pair copper Ethernet cables.

Configuring auto-MDIX (CLI)
The auto-MDIX features apply only to copper port switches using twisted-pair copper Ethernet cables. For
information about auto-MDIX, see Configuring auto-MDIX on page 71.

Syntax:

interface <port-list> mdix-mode < {auto-mdix | mdi | mdix>}

auto-mdix The automatic,default setting. This configures the port for automatic detection of the cable
(either straight-through or crossover).

mdi The manual mode setting that configures the port for connecting to either a PC or other MDI
device with a crossover cable, or to a switch, hub, or other MDI-X device with a straight-
through cable.

mdix The manual mode setting that configures the port for connecting to either a switch, hub, or
other MDI-X device with a crossover cable, or to a PC or other MDI device with a straight-
through cable.
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Syntax:

show interfaces config
Lists the current per-port Auto/MDI/MDI-X configuration.

Syntax:

show interfaces brief

• Where a port is linked to another device, this command lists the MDI mode the port is currently using.

• In the case of ports configured for Auto ( auto-mdix), the MDI mode appears as either MDI or MDIX,
depending upon which option the port has negotiated with the device on the other end of the link.

• In the case of ports configured for MDI or MDIX, the mode listed in this display matches the configured setting.

• If the link to another device was up, but has gone down, this command shows the last operating MDI mode the
port was using.

• If a port on a given switch has not detected a link to another device since the last reboot, this command lists
the MDI mode to which the port is currently configured.

The show interfaces config displays the following data when port A1 is configured for auto-mdix, port A2
is configured for mdi, and port A3 is configured for mdix:

Displaying the current MDI configuration

switch(config)# show interfaces config

 Port Settings

  Port   Type      | Enabled Mode         Flow Ctrl MDI
  ------ --------- + ------- ------------ --------- ---- 
  A1     10GbE-T   | Yes     Auto         Disable   Auto 
  A2     10GbE-T   | Yes     Auto         Disable   MDI 
  A3     10GbE-T   | Yes     Auto         Disable   MDIX 
  A4     10GbE-T   | Yes     Auto         Disable   Auto 
  A5     10GbE-T   | Yes     Auto         Disable   Auto 
  A6     10GbE-T   | Yes     Auto         Disable   Auto 
  A7     10GbE-T   | Yes     Auto         Disable   Auto 
  A8     10GbE-T   | Yes     Auto         Disable   Auto

Displaying the current MDI operating mode

switch(config)# show interfaces brief

 Status and Counters - Port Status

                   | Intrusion                           MDI  Flow Bcast
  Port   Type      | Alert     Enabled Status Mode       Mode Ctrl Limit
  ------ --------- + --------- ------- ------ ---------- ---- ---- ----- 
  A1     10GbE-T   | No        Yes     Up     1000FDx    MDIX off  0
  A2     10GbE-T   | No        Yes     Down   10GigFD    MDI  off  0
  A3     10GbE-T   | No        Yes     Down   10GigFD    MDIX off  0
  A4     10GbE-T   | No        Yes     Down   10GigFD    Auto off  0
  A5     10GbE-T   | No        Yes     Down   10GigFD    Auto off  0
  A6     10GbE-T   | No        Yes     Down   10GigFD    Auto off  0
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  A7     10GbE-T   | No        Yes     Down   10GigFD    Auto off  0
  A8     10GbE-T   | No        Yes     Down   10GigFD    Auto off  0

Using friendly (optional) port names
This feature enables you to assign alphanumeric port names of your choosing to augment automatically assigned
numeric port names. This means you can configure meaningful port names to make it easier to identify the source
of information listed by some show commands. (Note that this feature augments port numbering, but does not
replace it.)

Configuring and operating rules for friendly port names

• At either the global or context configuration level, you can assign a unique name to a port. You can also assign
the same name to multiple ports.

• The friendly port names you configure appear in the output of the show name [port-list], show config, and
show interface <port-number > commands. They do not appear in the output of other show
commands or in Menu interface screens. (See Displaying friendly port names with other port data (CLI) on
page 75.)

• Friendly port names are not a substitute for port numbers in CLI commands or Menu displays.

• Trunking ports together does not affect friendly naming for the individual ports. (If you want the same name for
all ports in a trunk, you must individually assign the name to each port.)

• A friendly port name can have up to 64 contiguous alphanumeric characters.

• Blank spaces within friendly port names are not allowed, and if used, cause an invalid input error. (The switch
interprets a blank space as a name terminator.)

• In a port listing, not assigned indicates that the port does not have a name assignment other than its fixed
port number.

• To retain friendly port names across reboots, you must save the current running-configuration to the startup-
config file after entering the friendly port names. (In the CLI, use the write memory command.)

Configuring friendly port names (CLI)
For detailed information about friendly port names, see Using friendly (optional) port names on page 74.

Syntax:

interface <port-list> name <port-name-string>
Assigns a port name to port-list.

Syntax:

no interface <port-list> name
Deletes the port name from <port-list>.

Configuring a single port name (CLI)
Suppose that you have connected port A3 on the switch to Bill Smith's workstation, and want to assign Bill's name
and workstation IP address (10.25.101.73) as a port name for port A3:
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Configuring a friendly port name

switch(config)# int A3 name
Bill_Smith@10.25.101.73
switch(config)# write mem
switch(config)# show name A3

 Port Names
  Port : A3
   Type : 10/100TX

Configuring the same name for multiple ports (CLI)
Suppose that you want to use ports A5 through A8 as a trunked link to a server used by a drafting group. In this
case you might configure ports A5 through A8 with the name "Draft-Server:Trunk."

Configuring one friendly port name on multiple ports

switch(config)# int a5-a8 name Draft-Server:Trunk
switch(config)# write mem
switch(config)# show name a5-a8
 
 Port Names

  Port : A5
   Type : 10GbE-T
   Name : Draft-Server:Trunk
 
 Port : A6
   Type : 10GbE-T
   Name : Draft-Server:Trunk
 
 Port : A7
   Type : 10GbE-T
   Name : Draft-Server:Trunk

  Port : A8
   Type : 10GbE-T
   Name : Draft-Server:Trunk

Displaying friendly port names with other port data (CLI)
You can display friendly port name data in the following combinations:

Syntax:

show name
Displays a listing of port numbers with their corresponding friendly port names and also quickly shows you which
ports do not have friendly name assignments. (show name data comes from the running-config file.)

Syntax:

show interface <port-number>
Displays the friendly port name, if any, along with the traffic statistics for that port. (The friendly port name data
comes from the running-config file.)
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Syntax:

show config
Includes friendly port names in the per-port data of the resulting configuration listing. (show config data comes
from the startup-config file.)

Listing all ports or selected ports with their friendly port names (CLI)
Syntax:

show name [port-list]
Lists the friendly port name with its corresponding port number and port type. The show name command without
a port list shows this data for all ports on the switch.

Friendly port name data for all ports on the switch

switch(config)# show name
Port Names
  Port   Type      Name
  ------ --------- ---------------------------- 
  A1     10GbE-T
  A2     10GbE-T
  A3     10GbE-T   Bill_Smith@10.25.101.73
  A4     10GbE-T
  A5     10GbE-T   Draft-Server:Trunk 
  A6     10GbE-T   Draft-Server:Trunk 
  A7     10GbE-T   Draft-Server:Trunk 
  A8     10GbE-T   Draft-Server:Trunk

Friendly port name data for specific ports on the switch

switch(config)# show name A3-A5
 Port Names
  Port : A3
  Type : 10GbE-T
  Name : Bill_Smith@10.25.101.73
 Port : A4
  Type : 10GbE-T 
  Name :
 Port : A5
  Type : 10GbE-T
  Name : Draft-Server:Trunk

Including friendly port names in per-port statistics listings (CLI)
Syntax:

show interface <port-number>
Includes the friendly port name with the port's traffic statistics listing. A friendly port name configured to a port is
automatically included when you display the port's statistics output.

If you configure port A1 with the name "O'Connor_10.25.101.43," the show interface output for this port
appears similar to the following:
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A friendly port name in a per-port statistics listing

switch(config)# show interface a1
 Status and Counters - Port Counters for port A1

  Name  : O’Connor@10.25.101.43
  MAC Address     : 001871-b995ff
  Link Status     : Up
  Totals (Since boot or last clear) :
   Bytes Rx       : 2,763,197          Bytes Tx       : 22,972
   Unicast Rx     : 2044               Unicast Tx     : 128
   Bcast/Mcast Rx  : 23,456            Bcast/Mcast Tx : 26
  Errors (Since boot or last clear) :
   FCS Rx         : 0                  Drops Tx       : 0
   Alignment Rx    : 0                 Collisions Tx  : 0
   Runts Rx       : 0                  Late Colln Tx  : 0
   Giants Rx      : 0                  Excessive Colln : 0
   Total Rx Errors : 0                 Deferred Tx    : 0
  Others (Since boot or last clear) :
   Discard Rx     : 0                  Out Queue Len  : 0
   Unknown Protos  : 0
  Rates (5 minute weighted average) :
   Total Rx (bps) : 3,028,168          Total Tx  (bps) : 1,918,384
   Unicast Rx (Pkts/sec) : 5           Unicast Tx (Pkts/sec) : 0
   B/Mcast Rx (Pkts/sec) : 71          B/Mcast Tx (Pkts/sec) : 0
   Utilization Rx  : 00.30 %           Utilization Tx : 00.19 %
For a given port, if a friendly port name does not exist in the running-config file, the Name line in the above
command output appears as:

Name : 

Searching the configuration for ports with friendly port names (CLI)
This option tells you which friendly port names have been saved to the startup-config file. (show config does
not include ports that have only default settings in the startup-config file.)

Syntax:

show config
Includes friendly port names in a listing of all interfaces (ports) configured with non-default settings. Excludes
ports that have neither a friendly port name nor any other non-default configuration settings.

See Listing of the startup-config file with a friendly port name configured (and saved) on page 77 to
configure port A1 with a friendly port name. Notice that the command sequence saves the friendly port name for
port A1 in the startup-config file. The name entered for port A2 is not saved because it was executed after write
memory.

Listing of the startup-config file with a friendly port name configured (and saved)

switch(config)# int A1 name Print_Server@10.25.101.43
switch(config)# write mem
switch(config)# int A2 name Herbert's_PC

switch(config)# show config

 Startup configuration:
; J9091A Configuration Editor; Created on release xx.15.05.xxxx
hostname "HPSwitch"
 interface AQ
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  name "Print_Server@10.25.101.43
 exit

snmp-server community "public" Unrestricted
.
.
.

Uni-directional link detection (UDLD)
Uni-directional link detection (UDLD) monitors a link between two switches and blocks the ports on both ends of
the link if the link fails at any point between the two devices. This feature is particularly useful for detecting failures
in fiber links and trunks. Figure 9: UDLD Example: on page 78 shows an Example:.

Figure 9: UDLD Example:

In this Example:, each switch load balances traffic across two ports in a trunk group. Without the UDLD feature, a
link failure on a link that is not directly attached to one of the HPE switches remains undetected. As a result, each
switch continue to send traffic on the ports connected to the failed link. When UDLD is enabled on the trunk ports
on each switch, the switches detect the failed link, block the ports connected to the failed link, and use the
remaining ports in the trunk group to forward the traffic.

Similarly, UDLD is effective for monitoring fiber optic links that use two uni-direction fibers to transmit and receive
packets. Without UDLD, if a fiber breaks in one direction, a fiber port may assume the link is still good (because
the other direction is operating normally) and continue to send traffic on the connected ports. UDLD-enabled
ports; however, will prevent traffic from being sent across a bad link by blocking the ports in the event that either
the individual transmitter or receiver for that connection fails.

Ports enabled for UDLD exchange health-check packets once every five seconds (the link-keepalive interval). If a
port does not receive a health-check packet from the port at the other end of the link within the keepalive interval,
the port waits for four more intervals. If the port still does not receive a health-check packet after waiting for five
intervals, the port concludes that the link has failed and blocks the UDLD-enabled port.

When a port is blocked by UDLD, the event is recorded in the switch log or via an SNMP trap (if configured); and
other port blocking protocols, like spanning tree or meshing, will not use the bad link to load balance packets. The
port will remain blocked until the link is unplugged, disabled, or fixed. The port can also be unblocked by disabling
UDLD on the port.

Configuring UDLD
When configuring UDLD, keep the following considerations in mind:
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• UDLD is configured on a per-port basis and must be enabled at both ends of the link. See the note below for a
list of switches that support UDLD.

• To configure UDLD on a trunk group, you must configure the feature on each port of the group individually.
Configuring UDLD on a trunk group's primary port enables the feature on that port only.

• Dynamic trunking is not supported. If you want to configure a trunk group that contains ports on which UDLD is
enabled, you must remove the UDLD configuration from the ports. After you create the trunk group, you can
re-add the UDLD configuration.

Configuring uni-directional link detection (UDLD) (CLI)
For detailed information about UDLD, see Uni-directional link detection (UDLD) on page 78.

Syntax:

[no] interface <port-list> link-keepalive
Enables UDLD on a port or range of ports.

To disable this feature, enter the no form of the command.

Default: UDLD disabled

Syntax:

link-keepalive interval <interval>
Determines the time interval to send UDLD control packets. The interval parameter specifies how often the ports
send a UDLD packet. You can specify from 10 to 100, in 100-ms increments, where 10 is 1 second, 11 is 1.1
seconds, and so on.

Default: 50 (5 seconds)

Syntax:

link-keepalive retries <num>
Determines the maximum number of retries to send UDLD control packets. The num parameter specifies the
maximum number of times the port will try the health check. You can specify a value from 3 to 10.

Default: 5

Syntax:

[no] interface <port-list> link-keepalive vlan <vid>
Assigns a VLAN ID to a UDLD-enabled port for sending tagged UDLD control packets.Under default settings,
untagged UDLD packets can still be transmitted and received on tagged only ports; however, a warning message
is logged.

The no form of the command disables UDLD on the specified ports.

Default: UDLD packets are untagged; tagged-only ports transmit and receive untagged UDLD control packets

Enabling UDLD (CLI)
UDLD is enabled on a per-port basis.

Example:
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To enable UDLD on port a1, enter:

switch(config)#interface al link-keepalive
To enable the feature on a trunk group, enter the appropriate port range. For example:

switch(config)#interface al-a4 link-keepalive

When at least one port is UDLD-enabled, the switch will forward out UDLD packets that arrive on
non-UDLD-configured ports out of all other non-UDLDconfigured ports in the same vlan. That is,
UDLD control packets will “pass through” a port that is not configured for UDLD. However, UDLD
packets will be dropped on any blocked ports that are not configured for UDLD.

Changing the keepalive interval (CLI)
By default, ports enabled for UDLD send a link health-check packet once every 5 seconds. You can change the
interval to a value from 10 to 100 deciseconds, where 10 is 1 second, 11 is 1.1 seconds, and so on.

Example:

To change the packet interval to seven seconds, enter the following command at the global configuration level:

switch(config)# link-keepalive interval 70

Changing the keepalive retries (CLI)
By default, a port waits 5 seconds to receive a health-check reply packet from the port at the other end of the link.
If the port does not receive a reply, the port tries four more times by sending up to four more health-check
packets. If the port still does not receive a reply after the maximum number of retries, the port goes down.

You can change the maximum number of keepalive attempts to a value from 3 to 10.

Example:

To change the maximum number of attempts to four, enter the following command at the global configuration
level:

switch(config)# link-keepalive retries 4

Configuring UDLD for tagged ports
The default implementation of UDLD sends the UDLD control packets untagged, even across tagged ports. If an
untagged UDLD packet is received by a non-HPE switch, that switch may reject the packet. To avoid such an
occurrence, you can configure ports to send out UDLD control packets that are tagged with a specified VLAN.

To enable ports to receive and send UDLD control packets tagged with a specific VLAN ID, enter a command
such as the following at the interface configuration level:

switch(config)#interface link-keepalive vlan 22

• You must configure the same VLANs that will be used for UDLD on all devices across the
network; otherwise, the UDLD link cannot be maintained.

• If a VLAN ID is not specified, UDLD control packets are sent out of the port as untagged packets.

• To re-assign a VLAN ID, re-enter the command with the new VLAN ID number. The new
command overwrites the previous command setting.

• When configuring UDLD for tagged ports, you may receive a warning message if there are any
inconsistencies with the VLAN configuration of the port.
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Viewing UDLD information (CLI)
Syntax:

show link-keepalive
Displays all the ports that are enabled for link-keepalive.

Syntax:

show link-keepalive statistics
Displays detailed statistics for the UDLD-enabled ports on the switch.

Syntax:

clear link-keepalive statistics
Clears UDLD statistics. This command clears the packets sent, packets received, and transitions counters in the
show link-keepalive statistics display.

Viewing summary information on all UDLD-enabled ports (CLI)
Enter the show link-keepalive command.

Example:

Figure 10: Example: of show link-keepalive command

Viewing detailed UDLD information for specific ports (CLI)
Enter the show link-keepalive statistics command.
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Example:

Figure 11: Example: of show link-keepalive statistics command

Clearing UDLD statistics (CLI)
Enter the following command:

switch# clear link-keepalive statistics
This command clears the packets sent, packets received, and transitions counters in the show link
keepalive statistics display (see Figure 11: Example: of show link-keepalive statistics command on
page 82 for an Example:).
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Introduction to PoE
PoE technology allows IP telephones, wireless LAN access points, and other appliances to receive power and
transfer data over existing ethernet LAN cabling. For more information about PoE technology, see the PoE/PoE+
planning and implementation guide, which is available on the HPE Networking website at http://www.hpe.com/
networking. Enter your Switch number.

Additionally, PoE+ provides more power-management capability, allowing the switch to have more power
available for more PDs. Power can be allocated exactly and automatically according to what the PD actually
requires at a given time.

PoE terminology
Power-over-ethernet (PoE) and Power-over-ethernet plus (PoE+ or POEP) operate similarly in most cases. Any
differences between PoE and PoE+ operation are noted; otherwise, the term "PoE" is used to designate both PoE
and PoE+ functionality.

Planning and implementing a PoE configuration
This section provides an overview of some considerations for planning a PoE application. For additional
information on this topic, refer to the HPE PoE/PoE+ planning and implementation guide which is available on the
HPE Networking web site at http://www.hpe.com/networking.

Some of the elements you may want to consider for a PoE installation include:

• Port assignments to VLANs

• Use of security features

• Power requirements

This section can help you to plan your PoE installation. If you use multiple VLANs in your network, or if you have
concerns about network security, you should read the first two topics. If your PoE installation comes close to (or is
likely to exceed) the system’s ability to supply power to all devices that may request it, then you should also read
the third topic. (If it is unlikely that your installation will even approach a full utilization of the PoE power available,
then you may find it unnecessary to spend much time on calculating PoE power scenarios.)

Power requirements
To get the best PoE performance, you should provide enough PoE power to exceed the maximum amount of
power that is needed by all the PDs that are being used.

By connecting an external power supply you can optionally provision more PoE wattage per port and or supply
the switch with redundant 12V power to operate should an internal power supply fail. A Power Supply Shelf
(external power supply) can also be connected to these switches to provide extra or redundant PoE power.

See the HPE PoE/PoE+ planning and implementation guide for detailed information about the PoE/PoE+ power
requirements for your switch.
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Assigning PoE ports to VLANs
If your network includes VLANs, you may want to assign various PoE-configured ports to specific VLANs. For
example, if you are using PoE telephones in your network, you may want to assign ports used for telephone
access to a VLAN reserved for telephone traffic.

Applying security features to PoE configurations
You can utilize security features built into the switch to control device or user access to the network through PoE
ports in the same way as non-PoE ports.

MAC Address Security: Using Port Security, you can configure each switch port with a unique list of MAC
addresses for devices that are authorized to access the network through that port. For more information, refer to
the titled “Configuring and Monitoring Port Security” in the access security guide for your switch.

Assigning priority policies to PoE traffic
You can use the configurable QoS (Quality of Service) features in the switch to create prioritization policies for
traffic moving through PoE ports. The available classifiers and their order of precedence are show in the table
below.

Table 8: Classifiers for prioritizing outbound packets

Priority QoS classifier

1 UDP/TCP application type (port)

2 Device priority (destination or source IP address)

3 IP type of service (ToS) field (IP packets only)

4 VLAN priority

5 Incoming source-port on the switch

6 Incoming 802.1 priority (present in tagged VLAN environments)

For more on this topic, refer to the titled “Quality of Service: Managing Bandwidth More Effectively” in the
Advanced Traffic Management Guide for your switch.

PoE Event Log messages
Please see the event log message reference guide for information about Event Log messages. To see these
manuals, go to http://www.hpe.com/networking. Auto search the model number for your switch, for Example:
“HPE Switch 2530”, then select the device from the list and click on Product manuals. Click on the “User guide”
link under Manuals.

About PoE operation
Using the commands described in this chapter, you can:

• Enable or disable PoE operation on individual ports.

• Monitor PoE status and performance per module.
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• Configure a non-default power threshold for SNMP and Event Log reporting of PoE consumption on either all
PoE ports on the switch or on all PoE ports in one or more PoE modules.

• Specify the port priority you want to use for provisioning PoE power in the event that the PoE resources
become oversubscribed.

Power-sourcing equipment (PSE) detects the power needed by a powered device (PD) before supplying that
power, a detection phase referred to as "searching." If the PSE cannot supply the required amount of power, it
does not supply any power. For PoE using a Type 1 device, a PSE will not supply any power to a PD unless the
PSE has at least 17 watts available. For example, if a PSE has a maximum available power of 382 watts and is
already supplying 378 watts, and is then connected to a PD requiring 10 watts, the PSE will not supply power to
the PD.

For PoE+ using Type 2 devices, the PSE must have at least 33 watts available.

Configuration options
In the default configuration, PoE support is enabled on the ports in a PoE module installed on the switch. The
default priority for all ports is low and the default power notification threshold is 80%. Using the CLI, you can:

• Disable or re-enable PoE operation on individual PoE ports

• Enable support for pre-standard devices

• Change the PoE priority level on individual PoE ports

• Change the threshold for generating a power level notice

• Manually allocate the amount of PoE power for a port by usage, value, or class

• Allocate PoE power based on the link-partner’s capabilities via LLDP

The ports support standard networking links and PoE links. You can connect either a non-PoE device
or a PD to a port enabled for PoE without reconfiguring the port.

PD support
To best utilize the allocated PoE power, spread your connected PoE devices as evenly as possible across
modules. Depending on the amount of power delivered to a PoE module, there may or may not always be enough
power available to connect and support PoE operation on all ports in the module. When a new PD connects to a
PoE module and the module does not have enough power left for that port, if the new PD connects to a port "X"
that has a:

• Higher

PoEpriority than another port "Y" that is already supporting another PD, the power is removed from port "Y"
and delivered to port "X." In this case the PD on port "Y" loses power and the PD on port "X" receives power.

• Lower

priority than all other PoE ports currently providing power to PDs, power is not supplied to port "X" until one or
more PDs using higher priority ports are removed.

In the default configuration (usage), when a PD connects to a PoE port and begins operating, the port retains
only enough PoE power to support the PD's operation. Unused power becomes available for supporting other PD
connections. However, if you configure the poe-allocate-by option to either value or class, all of the power
configured is allocated to the port.
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For PoE (not PoE+), while 17 watts must be available for a PoE module on the switch to begin supplying power to
a port with a PD connected, 17 watts per port is not continually required if the connected PD requires less power.
For example, with 20 watts of PoE power remaining available on a module, you can connect one new PD without
losing power to any connected PDs on that module. If that PD draws only 3 watts, 17 watts remain available, and
you can connect at least one more PD to that module without interrupting power to any other PoE devices
connected to the same module. If the next PD you connect draws 5 watts, only 12 watts remain unused. With only
12 unused watts available, if you then connect yet another PD to a higher-priority PoE port, the lowest-priority port
on the module loses PoE power and remains unpowered until the module once again has 17 or more watts
available. (For information on power priority, see Power priority operation on page 86.)

For PoE+, there must be 33 watts available for the module to begin supplying power to a port with a PD
connected.

Disconnecting a PD from a PoE port makes that power available to any other PoE ports with PDs waiting for
power. If the PD demand for power becomes greater than the PoE power available, power is transferred from the
lower-priority ports to the higher-priority ports. (Ports not currently providing power to PDs are not affected.)

Power priority operation
If a PSE can provide power for all connected PD demand, it does not use its power priority settings to allocate
power. However, if the PD power demand oversubscribes the available power, the power allocation is prioritized
to the ports that present a PD power demand. This causes the loss of power from one or more lower-priority ports
to meet the power demand on other, higher-priority ports. This operation occurs regardless of the order in which
PDs connect to the module's PoE-enabled ports.

Power allocation is prioritized according to the following methods:

• Priority class methodAssigns a power priority of low (the default), high, or critical to each enabled PoE port.

• Port-number priority methodA lower-numbered port has priority over a higher-numbered port within the same
configured priority class, for example, port A1 has priority over port A5 if both are configured with high priority.

Configuring PoE operation

Disabling or re-enabling PoE port operation
Syntax:

[no] interface <port-list> power-over-ethernet
Re-enables PoE operation on <port-list> and restores the priority setting in effect when PoE was disabled on
<port-list>.

The no form of the command disables PoE operation on <port-list>.

Default: All PoE ports are initially enabled for PoE operation at Low priority. If you configure a higher priority, this
priority is retained until you change it.

For PoE, disabling all ports allows the 22 watts of minimum PoE power or the 38 watts for PoE+
power allocated for the module to be recovered and used elsewhere. You must disable ALL ports for
this to occur.

Enabling support for pre-standard devices
The HPE switches covered in this guide also support some pre-802.3af devices. For a list of the supported
devices, see the FAQ for your switch model.
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Syntax:

[no] power-over-ethernet pre-std-detect
Detects and powers pre-802.3af standard devices.

The default setting for the pre-std-detect PoE parameter has changed.

Configuring the PoE port priority
Syntax:

interface <port-list> power-over-ethernet [critical | high | low]
Reconfigures the PoE priority level on <port-list>. For a given level, ports are prioritized by port number in
ascending order. For example, if ports 1-24 have a priority level of critical, port 1 has priority over ports 2-24.

If there is not enough power available to provision all active PoE ports at a given priority level, the lowest-
numbered port at that level is provisioned first. For chassis switches, the lowest-numbered port at that level
starting with module A, then B, C, and so on is provisioned. PoE priorities are invoked only when all active PoE
ports cannot be provisioned (supplied with PoE power)

Critical Specifies the highest-priority PoE support for <port-list>. The active PoE ports at this level are
provisioned before the PoE ports at any other level are provisioned.

High Specifies the second priority PoE support for <port-list>. The active PoE ports at this level are
provisioned before the Low priority PoE ports are provisioned.

Low (Default) Specifies the third priority PoE support for <port-list>. The active PoE ports at this level
are provisioned only if there is power available after provisioning any active PoE ports at the
higher priority levels.

The following table shows some examples of PoE priority configuration.
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Table 9: PoE priority operation on a PoE module

Port Priority setting Configuration command1 and resulting operation with PDs connected
to ports C3 through C24

C3 - C17 Critical In this Example:, the following CLI command sets ports C3 to C17 to
Critical:

switch(config)# interface c3-c17 power-over-ethernet
     critical
The critical priority class always receives power. If there is not enough
power to provision PDs on all ports configured for this class, no power goes
to ports configured for high and low priority. If there is enough power to
provision PDs on only some of the critical-priority ports, power is allocated to
these ports in ascending order, beginning with the lowest-numbered port in
the class, which, in this case, is port 3.

C18 - C21 high In this Example:, the following CLI command sets ports C19 to C22 to high:

switch(config)# interface c19-c22 power-over-ethernet 
high
The high priority class receives power only if all PDs on ports with a critical
priority setting are receiving power. If there is not enough power to provision
PDs on all ports with a high priority, no power goes to ports with a low
priority. If there is enough power to provision PDs on only some of the high-
priority ports, power is allocated to these ports in ascending order, beginning,
in this Example:, with port 18, until all available power is in use.

C22 - C24 low In this Example:, the CLI command sets ports C23 to C24 to low2:

switch(config)# interface c23-c24 power-over-ethernet 
low
This priority class receives power only if all PDs on ports with high and
critical priority settings are receiving power. If there is enough power to
provision PDs on only some low- priority ports, power is allocated to the ports
in ascending order, beginning with the lowest-numbered port in the class
(port 22, in this case), until all available power is in use.

C1 - C2 N/A In this Example:, the CLI command disables PoE power on ports C1 to C2:

switch(config)# no interface c1-c2 power-over-ethernet
There is no priority setting for the ports in this Example:.

1 For a listing of PoE configuration commands with descriptions, see Configuring PoE operation.
2 In the default PoE configuration, the ports are already set to low priority. In this case, the command is not necessary.

Controlling PoE allocation
Syntax:

[no] int <port-list> poe-allocate-by [usage | class | value]
Allows you to manually allocate the amount of PoE power for a port by either its class or a defined value.
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The default option for PoE allocation is usage, which is what a PD attached to the port is allocated. You can
override this value by specifying the amount of power allocated to a port by using the class or value options.

usage (Default) The automatic allocation by a PD.

class Uses the power ramp-up signature of the PD to identify which power class the device will be in.
Classes and their ranges are shown in the following table.

value A user-defined level of PoE power allocated for that port.

The allowable PD requirements are lower than those specified for PSEs to allow for power losses
along the Cat-5 cable.

Table 10: Power classes and their values

Power class Value

0 Depends on cable type and PoE architecture. Maximum power level output of 15.4 watts at the
PSE.This is the default class; if there is not enough information about the load for a specific
classification, the PSE classifies the load as class 0 (zero).

1 Requires at least 4 watts at the PSE.

2 Requires at least 7 watts at the PSE.

3 15.4 watts

4 For PoE+Maximum power level output of 30 watts at the PSE.

Example:

To allocate by class for ports 6 to 8:

switch(config)# int 6-8 PoE-allocate-by class

Manually configuring PoE power levels
You can specify a power level (in watts) allocated for a port by using the value option. This is the maximum
amount of power that will be delivered.

To configure a port by value:

Procedure

1. Set the PoE allocation by entering the poe-allocate-by value command:

switch(config) # int A6 poe-allocate-by value
2. or in interface context:

switch(eth-A6) # poe-allocate-by value
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3. Select a value:

switch(config) # int A6 poe-value 15
4. or in interface context:

switch(eth-A6) # poe-value 15
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To view the settings, enter the show power-over-ethernet command, shown in Figure 12: PoE allocation
by value and the maximum power delivered on page 91.

Figure 12: PoE allocation by value and the maximum power delivered

switch(config)# show power-over-ethernet A6

 Status and Counters - Port Power Status for port A7

  Power Enable     : Yes
                                       LLDP Detect     : enabled
  Priority         : low               Configured Type :
  AllocateBy       : value             Value           : 15 W 
  Detection Status : Delivering        Power Class     : 2

  Over Current Cnt : 0                 MPS Absent Cnt  : 0
  Power Denied Cnt : 0                 Short Cnt       : 0

  Voltage          : 55.1 V            Current         : 154 mA
  Power            : 8.4 W

Maximum power delivered.

If you set the PoE maximum value to less than what the PD requires, a fault occurs, as shown in Figure 13: PoE
power value set too low for the PD on page 91.

Figure 13: PoE power value set too low for the PD

switch(config)# int A7 poe-value 4

switch(config)# show power-over-ethernet A7

 Status and Counters - Port Power Status for port A7

  Power Enable     : Yes
                                       LLDP Detect     : enabled
  Priority         : low               Configured Type :
  AllocateBy       : value             Value           : 4 W
  Detection Status : fault             Power Class     : 2

  Over Current Cnt : 1                 MPS Absent Cnt  : 0
  Power Denied Cnt : 2                 Short Cnt       : 0

  Voltage          : 55.1 V            Current         : 154 mA
  Power            : 8.4 W

‘Fault’ appears when the PoE power value is set too low.

Changing the threshold for generating a power notice
By default, PoE support is enabled on the switch’s 10/100Base-TX ports, with the power priority set to Low and
the power threshold set to 80 (%). The following commands allow you to adjust these settings.

Syntax:

power threshold <1-99>
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The power threshold is a configurable percentage of the total PoE power available on the switch. When PoE
consumption exceeds the threshold, the switch automatically generates an SNMP trap and also sends a message
to the Event Log. For example, if the power threshold is set to 80% (the default), and an increasing PoE power
demand crosses this threshold, the switch sends an SNMP trap and generates this Event Log message:

PoE usage has exceeded threshold of 80 %.
If the switch is configured for debug logging, it also sends the same message to the configured debug
destination(s).

The switch automatically invokes the power threshold at the global configuration level with a default setting of
80%. You can configure the power threshold to a value in the range of 1% to 99%.

If an increasing PoE power load (1) exceeds the configured power threshold (which triggers the log message and
SNMP trap), and then (2) later begins decreasing and drops below the threshold again, the switch generates
another SNMP trap, plus a message to the Event Log and any configured Debug destinations. To continue the
above Example:

PoE usage is below configured threshold of 80 %.

Cycling power on a port
Simply disabling a PoE port does not affect power delivery through that port. To cycle the power on a PD receiving
power from a PoE port on the switch, disable, then re-enable the power to that port.

Syntax:

[no] interface [e] <port-list> power
Re-enables PoE operation on <port-list> and restores the priority setting in effect when PoE was disabled on
<port-list>. The [no] form of the command disables PoE operation on <port-list>. (Default: All 10/100Base-TX
ports on the switch enabled for PoE operation at Low priority.)

For example, to cycle the power on a PoE device connected to port 1 on a switch covered in this guide:

switch(config)# no interface 1 power
switch(config)# interface 1 power

PoE/PoE+ allocation using LLDP information

LLDP with PoE
When using PoE, enabling poe-lldp-detect allows automatic power configuration if the link partner supports
PoE. When LLDP is enabled, the information about the power usage of the PD is available, and the switch can
then comply with or ignore this information. You can configure PoE on each port according to the PD (IP phone,
wireless device, and so on) specified in the LLDP field. The default configuration is for PoE information to be
ignored if detected through LLDP.

Detecting PoE information via LLDP affects only power delivery; it does not affect normal Ethernet
connectivity.

Enabling or disabling ports for allocating power using LLDP
Syntax:

int <port-list> poe-lldp-detect [enabled | disabled]
Enables or disables ports for allocating PoE power based on the link-partner's capabilities via LLDP.
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Default: Disabled

Example:

You can enter this command to enable LLDP detection:

switch(config) # int A7 poe-lldp-detect enabled
or in interface context:

switch(eth-A7) # poe-lldp-detect enabled
For more information on PoE/PoE+ and LLDP, see PoE/PoE+ allocation using LLDP information on page 92.

Enabling PoE detection via LLDP TLV advertisement
Use this command and insert the desired port or ports:

switch(config) # lldp config <port-number> medTlvenable poe
    
For more information on LLDP, see PoE/PoE+ allocation using LLDP information on page 92.

LLDP with PoE+

Overview
The DLC for PoE provides more exact control over the power requirement between a PSE and PD. The DLC
works in conjunction with the PLC and is mandatory for any Type-2 PD that requires more than 12.95 watts of
input power.

DLC is defined as part of the IEEE 802.3at standard.

You can implement the power negotiation between a PSE and a PD at the physical layer or at the data link layer.
After the link is powered at the physical layer, the PSE can use LLDP to query the PD repeatedly to discover the
power needs of the PD. Communication over the data link layer allows finer control of power allotment, which
makes it possible for the PSE to supply dynamically the power levels needed by the PD. Using LLDP is optional
for the PSE but mandatory for a Type 2 PD that requires more than 12.95 watts of power.

If the power needed by the PD is not available, that port is shut off.

PoE allocation
There are two ways LLDP can negotiate power with a PD:

• Using LLDP MED TLVs

Disabled by default. Can be enabled using the int <port-list> PoE-lldp-detect [enable|
disable] command, as shown below.LLDP MED TLVs sent by the PD are used to negotiate power only if
the LLDP PoE+ TLV is disabled or inactive; if the LLDP PoE+ TLV is sent as well (not likely), the LLDP MED
TLV is ignored.

• Using LLDP PoE+ TLVs

Enabled by default. The LLDP PoE+ TLV is always advertised unless it has been disabled (enable it by using
the lldp config <port-list> dot3TlvEnable poe_config command.)For the Command syntax,
see Initiating advertisement of PoE+ TLVs on page 94. It always takes precedence over the LLDP MED
TLV.
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Enabling PoE-lldp-detect allows the data link layer to be used for power negotiation. When a PD requests
power on a PoE port, LLDP interacts with PoE to see if there is enough power to fulfill the request. Power is set at
the level requested. If the PD goes into power-saving mode, the power supplied is reduced; if the need for power
increases, the amount supplied is increased. PoE and LLDP interact to meet the current power demands.

Syntax:

int <port-list> poe-lldp-detect [enabled | disabled]
Allows the data link layer to be used for power negotiation between a PD on a PoE port and LLDP.

Default: Disabled

Example:

You can enter this command to enable LLDP detection:

switch(config) # int 7 PoE-lldp-detect enabled
or in interface context:

switch(eth-7) # PoE-lldp-detect enabled

Detecting PoE information via LLDP affects only power delivery; it does not affect normal Ethernet
connectivity.

You can view the settings by entering the show power-over-ethernet brief command, as shown in Port
with LLDP configuration information obtained from the device on page 94.

Port with LLDP configuration information obtained from the device

switch(config)# show power-over-ethernet brief

 Status and Counters - Port Power Status

  POE   | Power   Power     Alloc Alloc  Actual Configured  Detection   Power
  Port  | Enable  Priority  By    Power  Power  Type        Status      Class
  ----- + ------- --------- ----- ------ ------ ----------- ----------- ----
  A1    | Yes     low       usage 17 W   0.0 W  Phone1      Delivering  1
  A2    | Yes     low       usage 17 W   0.0 W              Searching   0
  A3    | Yes     low       usage 17 W   0.0 W              Searching   0
  A4    | Yes     low       usage 17 W   0.0 W              Searching   0
  A5    | Yes     low       usage 17 W   0.0 W              Searching   0
  A6    | Yes     low       usage 17 W   8.4 W              Delivering  0
  

Initiating advertisement of PoE+ TLVs
Syntax:

lldp config <port-list> dot3TlvEnable poe_config
Enables advertisement of data link layer power using PoE+ TLVs. The TLV is processed only after the physical
layer and the data link layer are enabled. The TLV informs the PSE about the actual power required by the device.

Default: Enabled
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If LLDP is disabled at runtime, and a PD is using PoE+ power that has been negotiated through
LLDP, there is a temporary power drop; the port begins using PoE+ power through the PLC. This
event is recorded in the Event Log. An Example: message would look like the following:

W 08/04/13 13:35:50 02768 ports: Port A1 PoE power dropped.
Exceeded physical classification for a PoE Type1 device (LLDP process 
disabled)
When LLDP is enabled again, it causes a temporary power drop. This event is also recorded in the
Event Log. An Example: message looks like the following:

W 08/04/13 13:36:31 02771 ports: Port A1 PoE power dropped.
Exceeded physical classification due to change in classification type (LLDP 
process enabled)

Viewing PoE when using LLDP information
Syntax:

show lldp config <port-list>
Displays the LLDP port configuration information, including the TLVs advertised.

LLDP port configuration information with PoE

switch(config)# show lldp config 4

 LLCP Port Configuration Detail

  Port : 4
  AdminStatus [Tx_Rx] : Tx_Rx
  NotificationsEnabled [False] : False
  Med Topology Trap Enabled [False] : False

  TLVS Advertised:
   * port_descr
   * system_name
   * system_descr
   * system_cap

   * capabilities
   * network_policy
   * location_id
   * poe

   * macphy_config
   * poeplus_config

  IpAddress Advertised:
Local power information on page 95 shows an Example: of the local device power information using the show
lldp info local-device <port-list> command.

Local power information

switch(config)# show lldp info local-device A1

 LLCP Local Port Information Detail
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  Port     : A1
  PortType : local
  PortId   : 1
  PortDesc : A1
  Pvid     : 1

 Poe Plus Information Detail

     Poe Device Type           : Type2 PSE
     Power Source              : Primary
     Power Priority            : low
     PD Requested Power Value  : 20 Watts
     PSE Actual Power Value    : 20 Watts
Remote power information on page 96 shows the remote device power information using the show lldp
info remote-device <port-list> command.

Remote power information

switch(config)# show lldp info remote-device A3

 LLCP Remote Device Information Detail

  Local Port   : A3
  ChassisType  : mac-address
  ChassisId    : 00 16 35 ff 2d 40
  PortType     : local
  PortId       : 23
  SysName      : HPSwitch
  System Descr : HP Switch, revision YA.14.xx
  PortDescr    : 23
  Pvid         : 55

  System Capabilities Supported  : bridge, router
  System Capabilities Enabled    : bridge

  Remote Management Address
     Type    : ipv4
     Address : 10.0.102.198

  Poe Plus Information Detail

     Poe Device Type           : Type2 PD
     Power Source              : Only PSE
     Power Priority            : low
     PD Requested Power Value  : 20 Watts
     PSE Actual Power Value    : 20 Watts

Operation note
The advertisement of power with TLVs for LLDP PoE+ is enabled by default. If LLDP is disabled at runtime and a
PD is using PoE+ power that has been negotiated through LLDP, there will be a temporary power drop. The port
will begin using PoE+ power through the PLC. This event is recorded in the event log. An Example: message
would look like the following:

W 08/04/13 13:35:50 02768 ports: Port A1 PoE power dropped.
Exceeded physical classification for a PoE Type1 device
(LLDP process disabled)
When LLDP is enabled again, it causes a temporary power drop. This event is also recorded in the event log. An
Example: message looks like the following:
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W 08/04/13 13:36:31 02771 ports: Port A1 PoE power dropped.
Exceeded physical classification due to change in
classification type (LLDP process enabled)

Viewing the global PoE power status of the switch
Syntax:

show power-over-ethernet
Displays the switch's global PoE power status, including:

• Pre-standard Detect

Shows whether PoE for pre-802.3af-standard powered devices is enabled on the switch. (Default: Off; shows
On when PoE for pre-802.3af-standard powered devices has been enabled.)

• Operational Status

Indicates whether PoE power is available on the switch. (Default: On; shows Off if PoE power is not available.
Shows Faulty if internal or external PoE power is oversubscribed or faulty.)

• Usage Threshold (%)

Lists the configured percentage of available PoE power provisioning the switch must exceed to generate a
usage notice in the form of an Event Log message and an SNMP trap. If this event is followed by a drop in
power provisioning below the threshold, the switch generates another SNMP trap and Event Log message.
Event Log messages are also sent to any optionally configured debug destinations. (Default: 80%)

• Total Available Power

Lists the maximum PoE wattage available to provision active PoE ports on the switch. This is the amount of
usable power for PDs.

• Total Failover Power

Lists the amount of PoE power available in the event of a single power supply failure. This is the amount of
power the switch can maintain without dropping any PDs.

• Total Redundancy Power

Indicates the amount of PoE power held in reserve for redundancy in case of a power supply failure.

• Total Remaining Power

The amount of PoE power still available.

brief Displays PoE information for each port. See Viewing PoE status on all ports on page 98.

<port-
list>

Displays PoE information for the ports in port-list. See Viewing the PoE status on specific
ports on page 100.

The show power-over-ethernet displays data similar to that shown in Output for the show power-over-
ethernet command on page 97.

Output for the show power-over-ethernet command

switch(config)# show power-over-ethernet

 Status and Counters - System Power Status
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  Pre-standard Detect  : On
  System Power Status  : No redundancy
  PoE Power Status     : No redundancy

 Chassis power-over-ethernet

  Total Available Power  :  600 W
  Total Failover Power   :  300 W
  Total Redundancy Power :    0 W
  Total Used Power       :    9 W +/- 6W
  Total Remaining Power  :  591 W

 Internal Power
        1  300W/POE  /Connected.
        2  300W/POE  /Connected.
        3  Not Connected.
        4  Not Connected.
 External Power
        EPS1  /Not Connected.
        EPS2  /Not Connected.

Viewing PoE status on all ports
Syntax:

show power-over-ethernet brief
Displays the port power status:

PoE Port Lists all PoE-capable ports on the switch.

Power Enable Shows Yes for ports enabled to support PoE (the default) and No for ports on which PoE is
disabled.

Power Priority Lists the power priority (Low, High, and Critical) configured on ports enabled for PoE. (For
more information on this topic, see Configuring PoE operation on page 86.)

Alloc by Displays how PoE is allocated (usage, class, value).

Alloc Power The maximum amount of PoE power allocated for that port (expressed in watts).Default: 17
watts for PoE; 33 watts for PoE+.

Actual Power The power actually being used on that port.

Configured Type If configured, shows the user-specified identifier for the port. If not configured, this field is
empty.

Table Continued
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Detection Status
• Searching: The port is trying to detect a PD connection.

• Delivering: The port is delivering power to a PD.

• Disabled: On the indicated port, either PoE support is disabled or PoE power is enabled
but the PoE module does not have enough power available to supply the port's power
needs.

• Fault: The switch detects a problem with the connected PD.

• Other Fault: The switch has detected an internal fault that prevents it from supplying
power on that port.

Power Class Shows the 802.3af power class of the PD detected on the indicated port. Classes include:

0: 0.44 to 12.95 watts can be drawn by the PD. Default class.

1: 0.44 to 3.84 watts

2: 3.84 to 6.49 watts

3: 6.49 to 12.95 watts

4: For PoE+; up to 25.5 watts can be drawn by the PD

The show power-over-ethernet brief displays this output:

Output for the show power-over-ethernet brief command

switch(config)# show power-over-ethernet brief

 Status and Counters - System Power Status

  System Power Status  : No redundancy
  PoE Power Status     : No redundancy

  Available: 600 W Used: 9 W Remaining: 591 W

  Module A Power
  Available: 408 W Used: 9 W Remaining: 399 W

  POE   | Power   Power     Alloc Alloc  Actual Configured  Detection  Power
  Port  | Enable  Priority  By    Power  Power  Type        Status     Class
  ----- + ------- --------- ----- ------ ------ ----------- ---------- ----
  A1    | Yes     low       usage 17 W   0.0 W              Searching  0
  A2    | Yes     low       usage 17 W   0.0 W              Searching  0
  A3    | Yes     low       usage 17 W   0.0 W              Searching  0
  A4    | Yes     low       usage 17 W   0.0 W              Searching  0
  A5    | Yes     low       usage 17 W   0.0 W              Searching  0
  A6    | Yes     low       usage 17 W   8.4 W              Delivering 2
  A7    | Yes     low       usage 17 W   0.0 W              Searching  0
  A8    | Yes     low       usage 17 W   0.0 W              Searching  0
  A9    | Yes     low       usage 17 W   0.0 W              Searching  0
You can also show the PoE information by slot:

Showing the PoE information by slot

switch(config)# show power-over-ethernet slot A

 Status and Counters - System Power Status for slot A
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  Maximum Power      : 408 W           Operational Status   : On
  Power In Use       :   9 W +/- 6 W   Usage Threshold (%) : 80

Viewing the PoE status on specific ports
Syntax:

show power-over-ethernet <port-list>
Displays the following PoE status and statistics (since the last reboot) for each port in <port-list>:

Power Enable Shows Yes for ports enabled to support PoE (the
default) and No for ports on which PoE is disabled. For
ports on which power is disabled, this is the only field
displayed by show power-over-ethernet port-
list .

Priority Lists the power priority (Low, High, and Critical)
configured on ports enabled for PoE. (For more on this
topic, see Configuring PoE operation on page 86.)

Allocate by How PoE is allocated (usage, class, value).

Detection Status
• Searching: The port is trying to detect a PD

connection.

• Delivering: The port is delivering power to a PD.

• Disabled: On the indicated port, either PoE support
is disabled or PoE power is enabled but the PoE
module does not have enough power available to
supply the port's power needs.

• Fault: The switch detects a problem with the
connected PD.

• Other Fault: The switch has detected an internal
fault that prevents it from supplying power on that
port.

Over Current Cnt Shows the number of times a connected PD has
attempted to draw more than 15.4 watts for PoE or
24.5 watts for PoE+. Each occurrence generates an
Event Log message.

Power Denied Cnt Shows the number of times PDs requesting power on
the port have been denied because of insufficient
power available. Each occurrence generates an Event
Log message.

Voltage The total voltage, in volts, being delivered to PDs.

Power The total power, in watts, being delivered to PDs.

Table Continued
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LLDP Detect Port is enabled or disabled for allocating PoE power,
based on the link-partner's capabilities via LLDP.

Configured Type If configured, shows the user-specified identifier for the
port. If not configured, the field is empty.

Value The maximum amount of PoE power allocated for that
port (expressed in watts). Default: 17 watts for PoE; 33
watts for PoE+

Power Class Shows the power class of the PD detected on the
indicated port. Classes include:

0: 0.44 to 12.95 watts

1: 0.44 to 3.84 watts

2: 3.84 to 6.49 watts

3: 6.49 to 12.95 watts

4: For PoE+; up to 25.5 watts can be drawn by the PD

MPS Absent Cnt Shows the number of times a detected PD has no
longer requested power from the port. Each
occurrence generates an Event Log message. ("MPS"
refers to the "maintenance power signature.")

Short Cnt Shows the number of times the switch provided
insufficient current to a connected PD.

Current The total current, in mA, being delivered to PDs.

If you want to view the PoE status of ports A6 and A7, you would use show power-over-ethernet A6-A7 to
display the data:

Output for the show power-over-ethernet <port-list> command

switch(config)# show power-over-ethernet slot A6-A7

 Status and Counters - Port Power Status for port A6

  Power Enable      : Yes
                                        LLDP Detect     : enabled
  Priority          : low               Configured Type : 
  AllocateBy        : value             Value           : 17 W
  Detection Status  : Delivering        Power Class     : 2

  Over Current Cnt  :0                  MPS Absent Cnt  : 0
  Power Denied Cnt  :0                  Short Cnt       : 0

  Voltage           : 55.1 V            Current         : 154 mA
  Power             : 8.4 W

 Status and Counters - Port Power Status for port A7

  Power Enable      : Yes
                                        LLDP Detect     : disabled
  Priority          : low               Configured Type : 
  AllocateBy        : value             Value           : 17 W
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  Detection Status  : Searching         Power Class     : 0

  Over Current Cnt  :0                  MPS Absent Cnt  : 0
  Power Denied Cnt  :0                  Short Cnt       : 0

  Voltage           : 0 V               Current         : 0 mA
  Power             : 0 W
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Overview of port trunking
Port trunking allows you to assign up to eight physical links to one logical link (trunk) that functions as a single,
higher-speed link providing dramatically increased bandwidth. This capability applies to connections between
backbone devices as well as to connections in other network areas where traffic bottlenecks exist. A trunk group
is a set of up to eight ports configured as members of the same port trunk. The ports in a trunk group do not have
to be consecutive. For Example:

Figure 14: Conceptual Example: of port trunking

With full-duplex operation in a eight-port trunk group, trunking enables the following bandwidth capabilities:

Port connections and configuration
All port trunk links must be point-to-point connections between a switch and another switch, router, server, or
workstation configured for port trunking. No intervening, non-trunking devices are allowed. It is important to note
that ports on both ends of a port trunk group must have the same mode (speed and duplex) and flow control
settings.

Link connections

The switch does not support port trunking through an intermediate, non-trunking device such as
a hub, or using more than onemedia type in a port trunk group. Similarly, for proper trunk
operation, all links in the same trunk group must have the samespeed, duplex, and flow control.

Port security restriction

Port security does not operate on a trunk group. If you configure port security on one or more
ports that are later added to a trunk group, the switch resets the port security parameters for
those ports to the factory-default configuration.

To avoid broadcast storms or loops in your network while configuring a trunk, first disable or
disconnect all ports you want to add to or remove from the trunk. After you finish configuring the
trunk, enable or re-connect the ports.

Chapter 5
Port Trunking
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Port trunk features and operation
The switches covered in this guide offer these options for port trunking:

• LACP: IEEE 802.3ad—Trunk group operation using LACP on page 114

• Trunk: Non-Protocol—Trunk group operation using the "trunk" option on page 120

Up to 144 trunk groups are supported on the switches. The actual maximum depends on the number of ports
available on the switch and the number of links in each trunk. (Using the link aggregation control protocol—LACP
—option, you can include standby trunked ports in addition to the maximum of eight actively trunking ports.) The
trunks do not have to be the same size; For example, 100 two-port trunks and 11 eight-port trunks are supported.

LACP requires full-duplex (FDx) links of the same media type (10/100Base-T, 100FX, and so on) and
the same speed, and enforces speed and duplex conformance across a trunk group. For most
installations, Hewlett Packard Enterprise Switch recommends that you leave the port Mode settings
at Auto (the default). LACP also operates with Auto-10, Auto-100, and Auto-1000 (if
negotiation selects FDx), and 10FDx, 100FDx, and 1000FDx settings. (The 10-gigabit ports
available for some switch models allow only the Auto setting.)

Fault tolerance
If a link in a port trunk fails, the switch redistributes traffic originally destined for that link to the remaining links in
the trunk. The trunk remains operable as long as there is at least one link in operation. If a link is restored, that
link is automatically included in the traffic distribution again. The LACP option also offers a standby link capability,
which enables you to keep links in reserve for service if one or more of the original active links fails. (See Trunk
group operation using LACP on page 114.)

Trunk configuration methods

Dynamic LACP trunk
The switch automatically negotiates trunked links between LACP-configured ports on separate devices, and offers
one dynamic trunk option: LACP. To configure the switch to initiate a dynamic LACP trunk with another device,
use the interface command in the CLI to set the default LACP option to active on the ports you want to use
for the trunk. For example, the following command sets ports C1 to C4 to LACP active:

switch(config) int c1-c4 lacp active
The preceding Example: works if the ports are not already operating in a trunk. To change the LACP option on
ports already operating as a trunk, you must first remove them from the trunk. For example, if ports C1 to C4 are
LACP-active and operating in a trunk with another device, you would do the following to change them to LACP-
passive:

switch(config)# no int c1-c4 lacp
Removes the ports from the trunk.

switch(config)# int c1-c4 lacp passive
Configures LACP passive.

Static trunk
The switch uses the links you configure with the Port/Trunk Settings screen in the menu interface or the trunk
command in the CLI to create a static port trunk. The switch offers two types of static trunks: LACP and Trunk.
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Table 11: Trunk types used in static and dynamic trunk groups

Trunking method LACP Trunk

Dynamic Yes No

Static Yes Yes

The following table describes the trunking options for LACP and Trunk protocols.

Table 12: Trunk configuration protocols

Protocol Trunking Options

LACP (802.3ad) Provides dynamic and static LACP trunking options.

• Dynamic LACP — Use the switch-negotiated dynamic LACP trunk when:

◦ The port on the other end of the trunk link is configured for Active or Passive LACP.

◦ You want fault-tolerance for high-availability applications. If you use an eight-link
trunk, you can also configure one or more additional links to operate as standby
links that will activate only if another active link goes down.

• Static LACP — Use the manually configured static LACP trunk when:

◦ The port on the other end of the trunk link is configured for a static LACP trunk.

◦ You want to configure non-default spanning tree or IGMP parameters on an LACP
trunk group.

◦ You want an LACP trunk group to operate in a VLAN other than the default VLAN
and GVRP is disabled. (See VLANs and dynamic LACP on page 118.)

◦ You want to use a monitor port on the switch to monitor an LACP trunk.

For more information, see Trunk group operation using LACP on page 114.

Trunk

(non-protocol)

Provides manually configured, static-only trunking to:

• Most HPE Switch and routing switches not running the 802.3ad LACP protocol.

• Windows NT and HP-UX workstations and servers

Use the Trunk option when:

• The device to which you want to create a trunk link is using a non-802.3ad trunking
protocol.

• You are unsure which type of trunk to use, or the device to which you want to create a
trunk link is using an unknown trunking protocol.

• You want to use a monitor port on the switch to monitor traffic on a trunk.

See Trunk group operation using the "trunk" option on page 120.
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Table 13: General operating rules for port trunks

Media: For proper trunk operation, all ports on both ends of a trunk group must have
the same media type and mode (speed and duplex). (For the switches, HPE
Switch recommends leaving the port Mode setting at Auto or, in networks
using Cat 3 cabling, Auto-10.)

Port Configuration: The default port configuration is Auto, which enables a port to sense speed
and negotiate duplex with an auto-enabled port on another device. HPE
recommends that you use the Auto setting for all ports you plan to use for
trunking. Otherwise, you must manually ensure that the mode setting for each
port in a trunk is compatible with the other ports in the trunk. See:
Recommended port mode setting for LACP example

All of the following operate on a per-port basis, regardless of trunk
membership:

• Enable/Disable

• Flow control (Flow Ctrl)

LACP is a full-duplex protocol. See Trunk group operation using LACP on
page 114.

Trunk configuration: All ports in the same trunk group must be the same trunk type (LACP or trunk).
All LACP ports in the same trunk group must be either all static LACP or all
dynamic LACP.A trunk appears as a single port labeledDyn1(for an LACP
dynamic trunk) or Trk1 (for a static trunk of type LACP, Trunk) on various
menu and CLI screens. For a listing of which screens show which trunk types,
see How the switch lists trunk data on page 120.For spanning-tree or
VLAN operation, configuration for all ports in a trunk is done at the trunk level.
(You cannot separately configure individual ports within a trunk for spanning-
tree or VLAN operation.)

Traffic distribution: All of the switch trunk protocols use the SA/DA (source address/destination
address) method of distributing traffic across the trunked links. See Outbound
traffic distribution across trunked links on page 121.

Table Continued
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Spanning Tree: 802.1D (STP) and 802.1w (RSTP) Spanning Tree operate as a global setting
on the switch (with one instance of Spanning Tree per switch). 802.1s (MSTP)
Spanning Tree operates on a per-instance basis (with multiple instances
allowed per switch). For each Spanning Tree instance, you can adjust
Spanning Tree parameters on a per-port basis.A static trunk of any type
appears in the Spanning Tree configuration display, and you can configure
Spanning Tree parameters for a static trunk in the same way that you would
configure Spanning Tree parameters on a non-trunked port. (Note that the
switch lists the trunk by name—such as Trk1—and does not list the individual
ports in the trunk.) For example, if ports C1 and C2 are configured as a static
trunk named Trk1, they are listed in the Spanning Tree display as Trk1 and do
not appear as individual ports in the Spanning Tree displays. See A port trunk
in a Spanning Tree listing on page 108.When Spanning Tree forwards on a
trunk, all ports in the trunk will be forwarding. Conversely, when Spanning Tree
blocks a trunk, all ports in the trunk are blocked.

A dynamic LACP trunk operates only with the default Spanning Tree settings.
Also, this type of trunk appears in the CLI show spanning-tree display, but
not in the Spanning Tree Operation display of the Menu interface.

If you remove a port from a static trunk, the port retains the same Spanning
Tree settings that were configured for the trunk.In the below Example:, ports
C1 and C2 are members of TRK1 and do not appear as individual ports in the
port configuration part of the listing.See: A port trunk in a Spanning Tree
listing example

IP multicast protocol (IGMP): A static trunk of any type appears in the IGMP configuration display, and you
can configure IGMP for a static trunk in the same way that you would
configure IGMP on a non-trunked port. (Note that the switch lists the trunk by
name—such as Trk1—and does not list the individual ports in the trunk.) Also,
creating a new trunk automatically places the trunk in IGMP Auto status if
IGMP is enabled for the default VLAN.A dynamic LACP trunk operates only
with the default IGMP settings and does not appear in the IGMP configuration
display or show ip igmp listing.

VLANs: Creating a new trunk automatically places the trunk in the DEFAULT_VLAN,
regardless of whether the ports in the trunk were in another VLAN. Similarly,
removing a port from a trunk group automatically places the port in the default
VLAN. You can configure a static trunk in the same way that you configure a
port for membership in any VLAN.

For a dynamic LACP trunk to operate in a VLAN other than the default VLAN
(DEFAULT_VLAN), GVRP must be enabled. See Trunk group operation
using LACP on page 114.

Port security: Trunk groups (and their individual ports) cannot be configured for port security,
and the switch excludes trunked ports from the show port-security
listing. If you configure non-default port security settings for a port, then
subsequently try to place the port in a trunk, you see the following message
and the command is not executed:< port-list> Command cannot operate
over a logical port.

Monitor port: A trunk cannot be a monitor port. A monitor port can monitor a static trunk but
cannot monitor a dynamic LACP trunk.
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Recommended port mode setting for LACP

switch(config)# show interfaces config

 Port Settings

  Port  Type      | Enabled Mode         Flow Ctrl MDI
  ----- --------- + ------- ------------ --------- ----
  1     10/100TX  | Yes     Auto         Enable    Auto
  2     10/100TX  | Yes     Auto         Enable    MDI

A port trunk in a Spanning Tree listing

Port  Type      Cost Priority State      | Designated Bridge
----- --------- ---- -------- ---------- + -----------------
C3    100/1000T 5    12B      Forwarding | 0020c1-b27ac0
C4    100/1000T 5    12B      Forwarding | 0060b0-889e00
C5    100/1000T 5    12B      Disabled   | 
C6    100/1000T 5    12B      Disabled   | 
Trk1            1    64       Forwarding | 0001e7-a0ec00
 

Viewing and configuring a static trunk group (Menu)
Configure port trunking before you connect the trunked links to another switch, routing switch, or
server. Otherwise, a broadcast storm could occur. (If you need to connect the ports before
configuring them for trunking, you can temporarily disable the ports until the trunk is configured. See
"Enabling or Disabling Ports and Configuring Port Mode".)

This procedure uses the Port/Trunk Settings screen to configure a static port trunk group on the switch.

Procedure

1. Follow the procedures in the preceding IMPORTANT note.

2. From the Main Menu, select:

2. Switch Configuration…

2. Port/Trunk Settings
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3. Press [E] (for Edit) and then use the arrow keys to access the port trunk parameters.

Figure 15: Example: of the menu screen for configuring a port trunk group

4. In the Group column, move the cursor to the port you want to configure.

5. Use the Space bar to choose a trunk group assignment (Trk1, Trk2, and so on) for the selected port.

a. For proper trunk operation, all ports in a trunk must have the same media type and mode (such as
10/100TX set to 100FDx, or 100FX set to 100FDx). The flow control settings must also be the same for all
ports in a given trunk. To verify these settings, see "Viewing Port Status and Configuring Port Parameters".

b. You can configure the trunk group with up to eight ports per trunk. If multiple VLANs are configured, all
ports within a trunk will be assigned to the same VLAN or set of VLANs. (With the 802.1Q VLAN capability
built into the switch, more than one VLAN can be assigned to a trunk. See the "Static Virtual LANs
(VLANs)" in the advanced traffic management guide for your switch.)

(To return a port to a non-trunk status, keep pressing the Space bar until a blank appears in the highlighted
Group value for that port.)

Figure 16: Example: of the Configuration for a Two-Port Trunk Group

6. Move the cursor to the Type column for the selected port and use the Space bar to select the trunk type:

a. LACP

b. Trunk (the default type if you do not specify a type)

All ports in the same trunk group on the same switch must have the same Type (LACP or Trunk).
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7. When you are finished assigning ports to the trunk group, press [Enter] , then [S] (for Save) and return to the
Main Menu. (It is not necessary to reboot the switch.)

During the Save process, traffic on the ports configured for trunking is delayed for several seconds. If the
Spanning Tree Protocol is enabled, the delay may be up to 30 seconds.

8. Connect the trunked ports on the switch to the corresponding ports on the opposite device. If you previously
disabled any of the trunked ports on the switch, enable them now. (See "Viewing Port Status and Configuring
Port Parameters")

Check the Event Log ("Using the Event Log for Troubleshooting Switch Problems") to verify that the trunked ports
are operating properly.

Viewing and configuring port trunk groups (CLI)
You can list the trunk type and group for all ports on the switch or for selected ports. You can also list LACP-only
status information for LACP-configured ports.

Viewing static trunk type and group for all ports or for selected ports
Syntax:

show trunks [< port-list >]
Omitting the <port-list> parameter results in a static trunk data listing for all LAN ports in the switch.

Example:

In a switch where ports A4 and A5 belong to Trunk 1 and ports A7 and A8 belong to Trunk 2, you have the
options shown in Listing specific ports belonging to static trunks on page 110 and A show trunk listing
without specifying ports on page 110 for displaying port data for ports belonging to static trunks.

Using a port list specifies, for switch ports in a static trunk group, only the ports you want to view. In this case, the
command specifies ports A5 through A7. However, because port A6 is not in a static trunk group, it does not
appear in the resulting listing:

Listing specific ports belonging to static trunks

switch# show trunks e 5-7

 Load Balancing

  Port | Name                    Type      | Group Type
  ---- + ----------------------- --------- + ----- -----
  5    | Print-Server-Trunk      10/100TX  | Trk1  Trunk
  7    |                         10/100TX  | Trk2  Trunk
The show trunks <port-list> command in the above Example: includes a port list, and thus shows trunk
group information only for specific ports that have membership in a static trunk. In A show trunk listing without
specifying ports on page 110, the command does not include a port list, so the switch lists all ports having static
trunk membership.

A show trunk listing without specifying ports

switch# show trunks

 Load Balancing

 Port | Name                    Type      | Group Type
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 ---- + ----------------------- --------- + ----- -----
 4    | Print-Server-Trunk      10/100TX  | Trk1  Trunk
 5    | Print-Server-Trunk      10/100TX  | Trk1  Trunk
 7    |                         10/100TX  | Trk2  Trunk
 8    |                         10/100TX  | Trk2  Trunk

Viewing static LACP and dynamic LACP trunk data
Syntax:

show lacp
Lists data for only the LACP-configured ports.

Example:

Ports A1 and A2 have been previously configured for a static LACP trunk. (For more on the Active parameter,
see table "LACP port status data".)

A show LACP listing

switch# show lacp

                          LACP
       LACP     Trunk    Port              LACP     Admin  Oper
Port   Enabled  Group    Status   Partner  Status   Key    Key
----   -------  -------  -------  -------  -------  ------ ------ 
Al     Active   Trkl     Up       Yes      Success  0      250
A2     Active   Trkl     Up       Yes      Success  0      250
A3     Active   A3       Down     No       Success  0      300
A4     Passive  A4       Down     No       Success  0      0
A5     Passive  A5       Down     No       Success  0      0
A6     Passive  A6       Down     No       Success  0      0
For a description of each of the above-listed data types, see table "LACP port status data".

Dynamic LACP Standby Links
Dynamic LACP trunking enables you to configure standby links for a trunk by including more than eight ports in a
dynamic LACP trunk configuration. When eight ports (trunk links) are up, the remaining link(s) will be held in
standby status. If a trunked link that is “Up” fails, it will be replaced by a standby link, which maintains your
intended bandwidth for the trunk. (Refer to also the “Standby” entry under “Port Status” in "Table 4-5. LACP Port
Status Data".) In the next Example:, ports A1 through A9 have been configured for the same LACP trunk. Notice
that one of the links shows Standby status, while the remaining eight links are “Up”.

A Dynamic LACP trunk with one standby link

switch# show lacp
                              LACP
       LACP      Trunk    Port                LACP    Admin    Oper
Port   Enabled   Group    Status   Partner   Status   Key      Key
----   -------   -----    ------   -------   ------   ----    -----
Al     Active     Dyn1     Up        Yes     Success   100      100
A2     Active     Dyn1     Up        Yes     Success   100      100
A3     Active     Dyn1     Up        Yes     Success   100      100
A4     Active     Dyn1     Up        Yes     Success   100      100
A5     Active     Dyn1     Up        Yes     Success   100      100
A6     Active     Dyn1     Up        Yes     Success   100      100
A7     Active     Dyn1     Up        Yes     Success   100      100
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A8     Active     Dyn1     Up        Yes     Success   100      100
A9     Active     Dyn1    Standby    Yes     Success   100      100

Configuring a static trunk or static LACP trunk group
Configure port trunking before you connect the trunked links between switches. Otherwise, a
broadcast storm could occur. (If you need to connect the ports before configuring them for trunking,
you can temporarily disable the ports until the trunk is configured. See "Enabling or Disabling Ports
and Configuring Port Mode".)

The "Port trunk features and operation" section describes the maximum number of trunk groups you can
configure on the switch. An individual trunk can have up to eight links, with additional standby links if you’re using
LACP. You can configure trunk group types as follows:

Trunk Type Trunk Group Membership

TrkX (Static) DynX (Dynamic)

LACP Yes Yes

Trunk Yes No

The following examples show how to create different types of trunk groups.

Syntax:

trunk < port-list > < trk1 ... trk144 > {<trunk | lacp>}
Configures the specified static trunk type.

Example:

This Example: uses ports C4 to C6 to create a non-protocol static trunk group with the group name Trk2.

switch(config)# trunk c4-c6 trk2 trunk

Removing ports from a static trunk group
Removing a port from a trunk can create a loop and cause a broadcast storm. When you remove a
port from a trunk where spanning tree is not in use, HPE Switch recommends that you first disable
the port or disconnect the link on that port.

Syntax:

no trunk <port-list>
Removes the specified ports from an existing trunk group.

Example:

To remove ports C4 and C5 from an existing trunk group:

switch(config)# no trunk c4-c5

Enabling a dynamic LACP trunk group
In the default port configuration, all ports on the switch are set to disabled. To enable the switch to automatically
form a trunk group that is dynamic on both ends of the link, the ports on one end of a set of links must be LACP
Active. The ports on the other end can be either LACP Activeor LACP Passive. The active command enables
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the switch to automatically establish a (dynamic) LACP trunk group when the device on the other end of the link is
configured for LACP Passive.

Example:

Figure 17: Criteria for automatically forming a dynamic LACP trunk

Syntax:

interface <port-list> lacp active
Configures <port-list> as LACP active. If the ports at the other end of the links on <port-list> are
configured as LACP passive, this command enables a dynamic LACP trunk group on <port-list> .

Example:

This Example: uses ports C4 and C5 to enable a dynamic LACP trunk group.

switch(config)# interface c4-c5 lacp active

Removing ports from a dynamic LACP trunk group
To remove a port from dynamic LACP trunk operation, you must turn off LACP on the port. (On a port in an
operating, dynamic LACP trunk, you cannot change between LACP Active and LACP passive without first
removing LACP operation from the port.)

Unless spanning tree is running on your network, removing a port from a trunk can result in a loop.
To help prevent a broadcast storm when you remove a port from a trunk where spanning tree is not
in use, Hewlett Packard Enterprise recommends that you first disable the port or disconnect the link
on that port.

Syntax:

no interface <port-list> lacp
Removes <port-list> from any dynamic LACP trunk and returns the ports in <port-list> to passive
LACP.

Example:
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Port C6 belongs to an operating, dynamic LACP trunk. To remove port C6 from the dynamic trunk and return it to
passive LACP, do the following:

switch(config)# no interface c6 lacp
switch(config)# interface c6 lacp passive
In the above Example:, if the port on the other end of the link is configured for active LACP or static LACP, the
trunked link will be re-established almost immediately.

Viewing existing port trunk groups (WebAgent)
While the WebAgent does not enable you to configure a port trunk group, it does provide a view of an existing
trunk group.

To view any port trunk groups:

1. In the navigation pane, click Interface.

2. Click Port Info/Config. The trunk information for the port displays in the Port Properties box.

Trunk group operation using LACP
The switch can automatically configure a dynamic LACP trunk group, or you can manually configure a static
LACP trunk group.

LACP requires full-duplex (FDx) links of the same media type (10/100Base-T, 100FX, and so on) and
the same speed and enforces speed and duplex conformance across a trunk group. For most
installations, HPE Switch recommends that you leave the port mode settings at Auto (the default).
LACP also operates with Auto-10, Auto-100, and Auto-1000 (if negotiation selects FDx), and
10FDx, 100FDx, and 1000FDx settings.

LACP trunk status commands include:

Trunk display method Static LACP trunk Dynamic LACP trunk

CLI show lacp command Included in listing. Included in listing.

CLI show trunk command Included in listing. Not included.

Port/Trunk Settings screen in menu interface Included in listing. Not included

Thus, to display a listing of dynamic LACP trunk ports, you must use the show lacp command.

In most cases, trunks configured for LACP on the switches operate as described in the following table.
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Table 14: LACP trunk types

LACP port trunk
configuration

Operation

Dynamic LACP This option automatically establishes an 802.3ad-compliant trunk group, with
LACP for the port Type parameter and DynX for the port Group name, where X is
an automatically assigned value from 1 to 144, depending on how many dynamic
and static trunks are currently on the switch. (The switch allows a maximum of
144 trunk groups in any combination of static and dynamic trunks.)

Dynamic LACP trunks operate only in the default VLAN (unless GVRP is enabled
and Forbid is used to prevent the trunked ports from joining the default VLAN).
Thus, if an LACP dynamic port forms using ports that are not in the default VLAN,
the trunk automatically moves to the default VLAN unless GVRP operation is
configured to prevent this from occurring. In some cases, this can create a traffic
loop in your network. For more information on this topic, see VLANs and
dynamic LACP on page 118 .

Under the following conditions, the switch automatically establishes a dynamic
LACP port trunk group and assigns a port Group name:

• The ports on both ends of each link have compatible mode settings (speed and
duplex).

• The port on one end of each link must be configured for LACP Active and the
port on the other end of the same link must be configured for either LACP
Passive or LACP Active. For Example:

Either of the above link configurations allows a dynamic LACP trunk link.

Backup Links: A maximum of eight operating links are allowed in the trunk, but,
with dynamic LACP, you can configure one or more additional (backup) links that
the switch automatically activates if a primary link fails. To configure a link as a
standby for an existing eight-port dynamic LACP trunk, ensure that the ports in the
standby link are configured as either active-to-active or active-to-passive between
switches.

Displaying dynamic LACP trunk data: To list the configuration and status for a
dynamic LACP trunk, use the CLI show lacp command.

The dynamic trunk is automatically created by the switch and is not listed in the
static trunk listings available in the menu interface or in the CLI show trunk
listing.

Static LACP Provides a manually configured, static LACP trunk to accommodate these
conditions:

Chapter 5 Port Trunking 115

Anexo 04 ITEM 10 (0592646)         SEI 0008478-63.2018.6.02.8000 / pg. 5174



LACP port trunk
configuration

Operation

• The port on the other end of the trunk link is configured for a static LACP trunk.

• You want to configure non-default Spanning Tree or IGMP parameters on an
LACP trunk group.

• You want an LACP trunk group to operate in a VLAN other than the default
VLAN and GVRP is disabled. (See VLANs and dynamic LACP on page
118.)

• You want to use a monitor port on the switch to monitor an LACP trunk.

The trunk operates if the trunk group on the opposite device is running one of the
following trunking protocols:

• Active LACP

• Passive LACP

• Trunk

This option uses LACP for the port Type parameter and TrkX for the port Group
parameter, where X is an automatically assigned value in a range corresponding
to the maximum number of trunks the switch allows. (See Port trunk features
and operation for the maximum number of trunk groups allowed on the
switches.)

Displaying static LACP trunk data : To list the configuration and status for a
static LACP trunk, use the CLI show lacp command. To list a static LACP trunk
with its assigned ports, use the CLI show trunk command or display the menu
interface Port/Trunk Settings screen.Static LACP does not allow standby ports.

Default port operation
In the default configuration, LACP is disabled for all ports. If LACP is not configured as Active on at least one end
of a link, the port does not try to detect a trunk configuration and operates as a standard, untrunked port. The
following table lists the elements of per-port LACP operation. To display this data for a switch, execute the
following command in the CLI:

switch# show lacp
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Table 15: LACP port status data

Status
name

Meaning

Port Numb Shows the physical port number for each port configured for LACP operation (C1, C2, C3 …).
Unlisted port numbers indicate that the missing ports that are assigned to a static trunk group are
not configured for any trunking.

LACP
Enabled

Active: The port automatically sends LACP protocol packets.

Passive: The port does not automatically send LACP protocol packets and responds only if it
receives LACP protocol packets from the opposite device.A link having either two active LACP
ports or one active port and one passive port can perform dynamic LACP trunking. A link having
two passive LACP ports does not perform LACP trunking because both ports are waiting for an
LACP protocol packet from the opposite device.

In the default switch configuration, LACP is disabled for all ports.

Trunk
Group

TrkX: This port has been manually configured into a static LACP trunk.

Trunk group same as port number: The port is configured for LACP, but is not a member of a
port trunk.

Port Status Up: The port has an active LACP link and is not blocked or in standby mode.

Down: The port is enabled, but an LACP link is not established. This can indicate, For example, a
port that is not connected to the network or a speed mismatch between a pair of linked ports.

Disabled: The port cannot carry traffic.

Blocked: LACP, Spanning Tree has blocked the port. (The port is not in LACP standby mode.) This
may be caused by a (brief) trunk negotiation or a configuration error, such as differing port speeds
on the same link or trying to connect the switch to more trunks than it can support. (See Trunk
configuration protocols.)

Some older devices are limited to four ports in a trunk. When eight LACP-enabled ports are
connected to one of these older devices, four ports connect, but the other four ports are blocked.

Standby: The port is configured for dynamic LACP trunking to another device, but the maximum
number of ports for the dynamic trunk to that device has already been reached on either the switch
or the other device. This port will remain in reserve, or "standby" unless LACP detects that another,
active link in the trunk has become disabled, blocked, or down. In this case, LACP automatically
assigns a standby port, if available, to replace the failed port.

LACP
Partner

Yes: LACP is enabled on both ends of the link.

No: LACP is enabled on the switch, but either LACP is not enabled or the link has not been
detected on the opposite device.

LACP
Status

Success: LACP is enabled on the port, detects and synchronizes with a device on the other end of
the link, and can move traffic across the link.

Failure: LACP is enabled on a port and detects a device on the other end of the link, but is not able
to synchronize with this device, and therefore is not able to send LACP packets across the link.
This can be caused, For example, by an intervening device on the link (such as a hub), a bad
hardware connection, or if the LACP operation on the opposite device does not comply with the
IEEE 802.3ad standard.

LACP notes and restrictions
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802.1X (Port-based access control) configured on a port
To maintain security, LACP is not allowed on ports configured for 802.1X authenticator operation. If you configure
port security on a port on which LACP (active or passive) is configured, the switch removes the LACP
configuration, displays a notice that LACP is disabled on the port, and enables 802.1X on that port.

switch(config)# aaa port-access authenticator b1
LACP has been disabled on 802.1x port(s). 
switch(config)#
The switch does not allow you to configure LACP on a port on which port access (802.1X) is enabled. For
Example:

switch(config)# int b1 lacp passive 
Error configuring port < port-number > : LACP and 802.1x cannot 
be run together. 
switch(config)#
To restore LACP to the port, you must first remove the 802.1X configuration of the port and then re-enable LACP
active or passive on the port.

Port security configured on a port
To maintain security, LACP is not allowed on ports configured for port security. If you configure port security on a
port on which LACP (active or passive) is configured, the switch removes the LACP configuration, displays a
notice that LACP is disabled on the port, and enables port security on that port. For example:

switch(config)# port-security a17 learn-mode static address-
limit 2 LACP has been disabled on secured port(s).
switch(config)#
The switch does not allow you to configure LACP on a port on which port security is enabled. For example:

switch(config)# int a17 lacp passive
Error configuring port A17: LACP and port security cannot be
run together.
switch(config)#
To restore LACP to the port, you must remove port security and re-enable LACP active or passive.

Changing trunking methods
To convert a trunk from static to dynamic, you must first eliminate the static trunk.

Static LACP trunks
When a port is configured for LACP (active or passive), but does not belong to an existing trunk group, you can
add that port to a static trunk. Doing so disables dynamic LACP on that port, which means you must manually
configure both ends of the trunk.

Dynamic LACP trunks
You can configure a port for LACP-active or LACP-passive, but on a dynamic LACP trunk you cannot configure
the other options that you can on static trunks. If you want to manually configure a trunk, use the trunk
command.

VLANs and dynamic LACP
A dynamic LACP trunk operates only in the default VLAN (unless you have enabled GVRP on the switch and use
Forbid to prevent the ports from joining the default VLAN).
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If you want to use LACP for a trunk on a non-default VLAN and GVRP is disabled, configure the trunk as a static
trunk.

Blocked ports with older devices
Some older devices are limited to four ports in a trunk. When eight LACP-enabled ports are connected to one of
these older devices, four ports connect, but the other four ports are blocked. The LACP status of the blocked
ports is shown as "Failure."

If one of the other ports becomes disabled, a blocked port replaces it (Port Status becomes "Up"). When the other
port becomes active again, the replacement port goes back to blocked (Port Status is "Blocked"). It can take a few
seconds for the switch to discover the current status of the ports.

Blocked ports with LACP

switch(eth-B1-B8)# show lacp

                         LACP

  PORT   LACP      TRUNK   PORT     LACP      LACP
  NUMB   ENABLED   GROUP   STATUS   PARTNER   STATUS
  ----   -------   ------  ------   -------   ------
  B1     Active    Dyn1    Up       Yes       Success
  B2     Active    Dyn1    Up       Yes       Success
  B3     Active    Dyn1    Up       Yes       Success
  B4     Active    Dyn1    Up       Yes       Success
  B5     Active    Dyn1    Blocked  Yes       Failure
  B6     Active    Dyn1    Blocked  Yes       Failure
  B7     Active    B7      Down     No        Success
  B8     Active    B8      Down     No        Success
If there are ports that you do not want on the default VLAN, ensure that they cannot become dynamic LACP trunk
members. Otherwise a traffic loop can unexpectedly occur. For Example:

Figure 18: A dynamic LACP trunk forming in a VLAN can cause a traffic loop

Easy control methods include either disabling LACP on the selected ports or configuring them to operate in static
LACP trunks.

Spanning Tree and IGMP
If Spanning Tree, IGMP, or both are enabled in the switch, a dynamic LACP trunk operates only with the default
settings for these features and does not appear in the port listings for these features.
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Half-duplex, different port speeds, or both not allowed in LACP trunks
Theports on both sides of an LACP trunk must be configured for the same speed and for full-duplex (FDx). The
802.3ad LACP standard specifies a full-duplex (FDx) requirement for LACP trunking. (10-gigabit ports operate
only at FDx.)

A port configured as LACP passive and not assigned to a port trunk can be configured to half-duplex (HDx).
However, in any of the following cases, a port cannot be reconfigured to an HDx setting:

• If the port is a 10-gigabit port.

• If a port is set to LACP Active, you cannot configure it to HDx.

• If a port is already a member of a static or dynamic LACP trunk, you cannot configure it to HDx.

• If a port is already set to HDx, the switch does not allow you to configure it for a static or dynamic LACP trunk.

Dynamic/static LACP interoperation
A port configured for dynamic LACP can properly interoperate with a port configured for static (TrkX) LACP, but
any ports configured as standby LACP links are ignored.

Trunk group operation using the "trunk" option
This method creates a trunk group that operates independently of specific trunking protocols and does not use a
protocol exchange with the device on the other end of the trunk. With this choice, the switch simply uses the
SA/DA method of distributing outbound traffic across the trunked ports without regard for how that traffic is
handled by the device at the other end of the trunked links. Similarly, the switch handles incoming traffic from the
trunked links as if it were from a trunked source.

When a trunk group is configured with the trunk option, the switch automatically sets the trunk to a priority of "4"
for Spanning Tree operation (even if Spanning Tree is currently disabled). This appears in the running-config file
as spanning-tree Trkn priority 4. Executing write memory after configuring the trunk places the same
entry in the startup-config file.

Use the trunk option to establish a trunk group between a switch and another device, where the other device's
trunking operation fails to operate properly with LACP trunking configured on the switches.

How the switch lists trunk data
Static trunk group

Appears in the menu interface and the output from the CLI show trunk and show interfaces
commands.

Dynamic LACP trunk group

Appears in the output from the CLI show lacp command.

Interface option Dynamic LACP trunk
group

Static LACP trunk group Static non-protocol

Menu interface No Yes Yes

CLI show trunk No Yes Yes

CLI show interfaces No Yes Yes

Table Continued

120 Aruba 2530 Management and Configuration Guide for ArubaOS-Switch 16.05

Anexo 04 ITEM 10 (0592646)         SEI 0008478-63.2018.6.02.8000 / pg. 5179



Interface option Dynamic LACP trunk
group

Static LACP trunk group Static non-protocol

CLI show lacp Yes Yes No

CLI show spanning-
tree

No Yes Yes

CLI show igmp No Yes Yes

CLI show config No Yes Yes

Outbound traffic distribution across trunked links
The two trunk group options (LACP and trunk) use SA/DA pairs for distributing outbound traffic over trunked links.
That is, the switch sends traffic from the same source address to the same destination address through the same
trunked link, and may also send traffic from the same source address to a different destination address through
the same link or a different link, depending on the mapping of path assignments among the links in the trunk.
Likewise, the switch distributes traffic for the same destination address but from different source addresses
through links depending on the path assignment.

The load-balancing is done on a per-communication basis. Otherwise, traffic is transmitted across the same path
as shown in the figure below. That is, if Client A attached to Switch 1 sends five packets of data to Server A
attached to Switch 2, the same link is used to send all five packets. The SA/DA address pair for the traffic is the
same. The packets are not evenly distributed across any other existing links between the two switches; they all
take the same path.

Figure 19: Example: of single path traffic through a trunk

The actual distribution of the traffic through a trunk depends on a calculation using bits from the SA/DA. When an
IP address is available, the calculation includes the last five bits of the IP source address and IP destination
address; otherwise, the MAC addresses are used. The result of that process undergoes a mapping that
determines which link the traffic goes through. If you have only two ports in a trunk, it is possible that all the traffic
will be sent through one port even if the SA/DA pairs are different. The more ports you have in the trunk, the more
likely it is that the traffic will be distributed among the links.
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When a new port is added to the trunk, the switch begins sending traffic, either new traffic or existing traffic,
through the new link. As links are added or deleted, the switch redistributes traffic across the trunk group. For
example, in the figure below showing a three-port trunk, traffic could be assigned as shown in the following table.

Figure 20: Example: of port-trunked network

Table 16: Example: of link assignments in a trunk group (SA/DA distribution)

Source Destination Link

Node A Node W 1

Node B Node X 2

Node C Node Y 3

Node D Node Z 1

Node A Node Y 2

Node B Node W 3

Because the amount of traffic coming from or going to various nodes in a network can vary widely, it is possible
for one link in a trunk group to be fully utilized while other links in the same trunk have unused bandwidth capacity,
even if the assignments were evenly distributed across the links in a trunk.
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VLAN-based rate-limiting
VLAN-based rate-limiting provides specific bandwidth for a specific VLAN for the inbound traffic on the VLAN. It
allows the user to specify the maximum number of kilobits per second (kbps) a VLAN can receive. The specified
VLAN drops all traffic that exceeds the configured rate. Unused bandwidth is not carried over from one interval to
the next.

VLAN-based rate limiting and rate limiting per interface/port are supported together on the same port. If applying
any of these rate-limit configurations results in blocking the inbound traffic on that port, further packets on that port
are dropped. Any VLAN-based rate limiting applies to all traffic on that VLAN.

Global QoS priority policies and rate limit policies cannot be configured at the same time.

VLAN-based rate limiting is disabled by default.

VLAN-based rate limiting does not work on broadcast traffic. The hardware design lowers the priority
of broadcast traffic to avoid flooding the CPU.

The HPE Switch supports data rate in multiples of 64 kbps. If the configured value is between 1-63, it
is rounded off to 64. For all other non-zero values, it is rounded off to the nearest lower multiple of
64, and the rate-limit is applied

Setting limits for inbound traffic on a specific VLAN

switch(vlan-1)# rate-limit all in kbps <rate>

Usage: rate-limit all in kbps <rate>
       no rate-limit all in

all: Set limits for all traffic
in : Set limits for all inbound traffic

ICMP rate-limiting
In IP networks, ICMP messages are generated in response to either inquiries or requests from routing and
diagnostic functions. These messages are directed to the applications originating the inquiries. In unusual
situations, if the messages are generated rapidly with the intent of overloading network circuits, they can threaten
network availability. This problem is visible in denial-of-service (DoS) attacks or other malicious behaviors where a
worm or virus overloads the network with ICMP messages to an extent where no other traffic can get through.
(ICMP messages themselves can also be misused as virus carriers). Such malicious misuses of ICMP can
include a high number of ping packets that mimic a valid source IP address and an invalid destination IP address
(spoofed pings), and a high number of response messages (such as Destination Unreachable error messages)
generated by the network.

ICMP rate-limiting provides a method for limiting the amount of bandwidth that may be used for inbound ICMP
traffic on a switch port. This feature allows users to restrict ICMP traffic to percentage levels that permit necessary
ICMP functions, but throttle additional traffic that may be caused by worms or viruses (reducing their spread and
effect). In addition, ICMP rate-limiting preserves inbound port bandwidth for non-ICMP traffic.

Chapter 6
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ICMP is necessary for routing, diagnostic, and error responses in an IP network. ICMP rate-limiting is
primarily used for throttling worm or virus-like behavior and should normally be configured to allow
one to five percent of available inbound bandwidth (at 10 Mbps or 100 Mbps speeds) or 100 to
10,000 kbps (1Gbps or 10 Gbps speeds) to be used for ICMP traffic. This feature should not be
used to remove all ICMP traffic from a network.

ICMP rate-limiting does not throttle non-ICMP traffic. In cases where you want to throttle both ICMP
traffic and all other inbound traffic on a given interface, you can separately configure both ICMP rate-
limiting and all-traffic rate-limiting.

The all-traffic rate-limiting command (rate-limit all) and the ICMP rate-limiting command
(rate-limit icmp) operate differently:

• All-traffic rate-limiting applies to both inbound and outbound traffic and can be specified either in
terms of a percentage of total bandwidth or in terms of bits per second;

• ICMP rate-limiting applies only to inbound traffic and can be specified as only a percentage of
total bandwidth.

Guidelines for configuring ICMP rate-limiting
Apply ICMP rate-limiting on all connected interfaces on the switch to effectively throttle excessive ICMP
messaging from any source. Figure 21: Example: of ICMP rate-limiting on page 124 shows an Example: of
how to configure this for a small to mid-sized campus though similar rate-limit thresholds are applicable to other
network environments. On edge interfaces, where ICMP traffic should be minimal, a threshold of 1% of available
bandwidth should be sufficient for most applications. On core interfaces, such as switch-to-switch and switch-to-
router, a maximum threshold of 5% should be sufficient for normal ICMP traffic. ("Normal" ICMP traffic levels
should be the maximums that occur when the network is rebooting.)

Figure 21: Example: of ICMP rate-limiting

Configuring ICMP rate-limiting
For detailed information about ICMP rate-limiting, see ICMP rate-limiting on page 123.

The rate-limit icmp command controls inbound usage of a port by setting a limit on the bandwidth available
for inbound ICMP traffic.

Syntax:

[no] int <port-list> rate-limit icmp {< percent < 0-100 > | kbps < 0-10000000 > | [trap-clear>]}
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Configures inbound ICMP traffic rate-limiting. You can configure a rate limit from either the global configuration
level (as shown above) or from the interface context level. The no form of the command disables ICMP rate-
limiting on the specified interfaces.

(Default: Disabled.)

percent <1-100> Values in this range allow ICMP traffic as a percentage of the bandwidth available
on the interface.

kbps <0-10000000> Specifies the rate at which to forward traffic in kilobits per second.

0 Causes an interface to drop all incoming ICMP traffic and is not recommended.
See the caution.

trap-clear Clears existing ICMP rate limiting trap condition.

Note: ICMP rate-limiting is not supported on meshed ports. (Rate-limiting can reduce the efficiency of paths
through a mesh domain).

Example:

Either of the following commands configures an inbound rate limit of 1% on ports A3 to A5, which are used as
network edge ports:

switch(config) # int a3-a5 rate-limit icmp 1
switch(eth-A3-A5) # rate-limit icmp 1

When using kbps-mode ICMP rate-limiting, the rate-limiting only operates on the IP payload part of
the ICMP packet (as required by metering RFC 2698). This means that effective metering is at a rate
greater than the configured rate, with the disparity increasing as the packet size decreases (the
packet to payload ratio is higher).

Also, in kbps mode, metering accuracy is limited at low values, For example, less than 45 Kbps. This
is to allow metering to function well at higher media speeds such as 10 Gbps.

For information on using ICMP rate-limiting and all-traffic rate-limiting on the same interface, seeUsing both
ICMP rate-limiting and all-traffic rate-limiting on the same interface on page 125.

Using both ICMP rate-limiting and all-traffic rate-limiting on the same
interface
ICMP and all-traffic rate-limiting can be configured on the same interface. All-traffic rate-limiting applies to all
inbound or outbound traffic (including ICMP traffic), while ICMP rate-limiting applies only to inbound ICMP traffic.

If the all-traffic load on an interface meets or exceeds the currently configured all-traffic inbound rate-
limit while the ICMP traffic rate-limit on the same interface has not been reached, all excess traffic is
dropped, including any inbound ICMP traffic above the all-traffic limit (regardless of whether the
ICMP rate-limit has been reached).

Example:

Suppose:

• The all-traffic inbound rate-limit on port "X" is configured at 55% of the port's bandwidth.

• The ICMP traffic rate-limit on port "X" is configured at 2% of the port's bandwidth.

If at a given moment:
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• Inbound ICMP traffic on port "X" is using 1% of the port's bandwidth, and

• Inbound traffic of all types on port "X" demands 61% of the ports's bandwidth,

all inbound traffic above 55% of the port's bandwidth, including any additional ICMP traffic, is dropped as long as
all inbound traffic combined on the port demands 55% or more of the port's bandwidth.

Viewing the current ICMP rate-limit configuration
The show rate-limit icmp command displays the per-interface ICMP rate-limit configuration in the running-
config file.

Syntax:

show rate-limit icmp [< port-list >]
Without [port-list], this command lists the ICMP rate-limit configuration for all ports on the switch.

With [port-list], this command lists the rate-limit configuration for the specified interfaces. This command operates
the same way in any CLI context

If you want to view the rate-limiting configuration on ports 1–6:

Listing the rate-limit configuration

switch(config)# show rate-limit icmp 1-6

 Inbound ICMP Rate Limit Maximum Percentage

        |          Rate
  Port  | Mode     Limit
  ----- + -------- --------
  1     | Disabled Disabled
  2     | kbps     100
  3     | %        5
  4     | %        1
  5     | %        1
  6     | Disabled Disable
The show running command displays the currently applied setting for any interfaces in the switch configured for
all traffic rate-limiting and ICMP rate-limiting.

The show config command displays this information for the configuration currently stored in the startup-
config file. (Note that configuration changes performed with the CLI, but not followed by a write mem
command, do not appear in the startup-config file.)

Operating notes for ICMP rate-limiting
ICMP rate-limiting operates on an interface (per-port) basis to allow, on average, the highest expected amount of
legitimate, inbound ICMP traffic.

• Interface support: ICMP rate-limiting is available on all types of ports (other than trunk ports or mesh ports),
and at all port speeds configurable for the switch.

• Rate-limiting is not permitted on mesh ports: Either type of rate-limiting (all-traffic or ICMP) can reduce the
efficiency of paths through a mesh domain.

• Rate-limiting is not supported on port trunks: Neither all-traffic nor ICMP rate-limiting are supported on
ports configured in a trunk group.
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• ICMP percentage-based rate-limits are calculated as a percentage of the negotiated link speed: For
example, if a 100 Mbps port negotiates a link to another switch at 100 Mbps and is ICMP rate-limit configured
at 5%, the inbound ICMP traffic flow through that port is limited to 5 Mbps. Similarly, if the same port negotiates
a 10 Mbps link, it allows 0.5 Mbps of inbound traffic. If an interface experiences an inbound flow of ICMP traffic
in excess of its configured limit, the switch generates a log message and an SNMP trap (if an SNMP trap
receiver is configured).

• ICMP rate-limiting is port-based: ICMP rate-limiting reflects the available percentage of an interface's entire
inbound bandwidth. The rate of inbound flow for traffic of a given priority and the rate of flow from an ICMP
rate-limited interface to a particular queue of an outbound interface are not measures of the actual ICMP rate
limit enforced on an interface.

• Below-maximum rates: ICMP rate-limiting operates on a per-interface basis, regardless of traffic priority.
Configuring ICMP rate-limiting on an interface where other features affect inbound port queue behavior (such
as flow control) can result in the interface not achieving its configured ICMP rate-limiting maximum. For
example, in some situations with flow control configured on an ICMP rate-limited interface, there can be
enough "back pressure" to hold high-priority inbound traffic from the upstream device or application to a rate
that does not allow bandwidth for lower-priority ICMP traffic. In this case, the inbound traffic flow may not
permit the forwarding of ICMP traffic into the switch fabric from the rate-limited interface. (This behavior is
termed "head-of-line blocking" and is a well-known problem with flow-control.) In cases where both types of
rate-limiting (rate-limit all and rate-limit icmp) are configured on the same interface, this situation
is more likely to occur.

In another type of situation, an outbound interface can become oversubscribed by traffic received from multiple
ICMP rate-limited interfaces. In this case, the actual rate for traffic on the rate-limited interfaces may be lower
than configured because the total traffic load requested to the outbound interface exceeds the interface's
bandwidth, and thus some requested traffic may be held off on inbound.

• Monitoring (mirroring) ICMP rate-limited interfaces: If monitoring is configured, packets dropped by ICMP
rate-limiting on a monitored interface are still forwarded to the designated monitor port. (Monitoring shows
what traffic is inbound on an interface, and is not affected by "drop" or "forward" decisions.)

• Optimum rate-limiting operation: Optimum rate-limiting occurs with 64-byte packet sizes. Traffic with larger
packet sizes can result in performance somewhat below the configured inbound bandwidth. This is to ensure
the strictest possible rate-limiting of all sizes of packets.

• Outbound traffic flow: Configuring ICMP rate-limiting on an interface does not control the rate of outbound
traffic flow on the interface.

Notes on testing ICMP rate-limiting
ICMP rate-limiting is applied to the available bandwidth on an interface. If the total bandwidth requested by all
ICMP traffic is less than the available, configured maximum rate, no ICMP rate-limit can be applied. That is, an
interface must be receiving more inbound ICMP traffic than the configured bandwidth limit allows. If the interface
is configured with both rate-limit all and rate-limit icmp, the ICMP limit can be met or exceeded only
if the rate limit for all types of inbound traffic has not already been met or exceeded. Also, to test the ICMP limit
you need to generate ICMP traffic that exceeds the configured ICMP rate limit. Using the recommended settings
—1% for edge interfaces and 5% maximum for core interfaces—it is easy to generate sufficient traffic. However, if
you are testing with higher maximums, you need to ensure that the ICMP traffic volume exceeds the configured
maximum.

When testing ICMP rate-limiting where inbound ICMP traffic on a given interface has destinations on multiple
outbound interfaces, the test results must be based on the received outbound ICMP traffic.

ICMP rate-limiting is not reflected in counters monitoring inbound traffic because inbound packets are counted
before the ICMP rate-limiting drop action occurs.
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ICMP rate-limiting trap and Event Log messages
If the switch detects a volume of inbound ICMP traffic on a port that exceeds the ICMP rate-limit configured for
that port, it generates one SNMP trap and one informational Event Log message to notify the system operator of
the condition. (The trap and Event Log message are sent within two minutes of when the event occurred on the
port.) For Example:

I 06/30/05 11:15:42 RateLim: ICMP traffic exceeded configured limit on port A1
These trap and Event Log messages provide an advisory that inbound ICMP traffic on a given interface has
exceeded the configured maximum. The additional ICMP traffic is dropped, but the excess condition may indicate
an infected host (or other traffic threat or network problem) on that interface. The system operator should
investigate the attached devices or network conditions further; the switch does not send more traps or Event Log
messages for excess ICMP traffic on the affected port until the system operator resets the port's ICMP trap
function.

The switch does not send more traps or Event Log messages for excess ICMP traffic on the affected port until the
system operator resets the port’s ICMP trap function. The reset can be done through SNMP from a network
management station or through the CLI with the trap-clear command option.

Syntax:

interface <port-list> rate-limit icmp trap-clear
On a port configured with ICMP rate-limiting, this command resets the ICMP trap function, which allows the switch
to generate a new SNMP trap and an Event Log message if ICMP traffic in excess of the configured limit is
detected on the port.

Example:

An operator noticing an ICMP rate-limiting trap or Event Log message originating with port 1 on a switch would
use the following command to reset the port to send a new message if the condition occurs again:

HP Switch(config)# interface 1 rate-limit icmp trap-clear

Determining the switch port number used in ICMP port reset commands
To enable excess ICMP traffic notification traps and Event Log messages, use the setmib command described
on ICMP rate-limiting trap and Event Log messages on page 128. The port number included in the command
corresponds to the internal number the switch maintains for the designated port and not the port's external
identity.

To match the port's external slot/number to the internal port number, use the walkmib ifDescr command, as
shown in the following example:

Matching internal port numbers to external port numbers

switch# walkmib ifDescr
ifDescr.1 = 1
ifDescr.2 = 2
ifDescr.3 = 3
ifDescr.4 = 4
ifDescr.5 = 5
ifDescr.6 = 6
ifDescr.7 = 7
ifDescr.8 = 8
ifDescr.9 = 9
ifDescr.10 = 10
ifDescr.11 = 11
ifDescr.12 = 12
ifDescr.13 = 13
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ifDescr.14 = 14
ifDescr.15 = 15
ifDescr.16 = 16
ifDescr.17 = 17
ifDescr.18 = 18
ifDescr.19 = 19
ifDescr.20 = 20
ifDescr.21 = 21
ifDescr.22 = 22
ifDescr.23 = 23
ifDescr.24 = 24
ifDescr.210 = Trk1
ifDescr.211 = Trk2
ifDescr.330 = DEFAULT_VLAN
ifDescr.4425 = HP Switch software loopback interface
ifDescr.4426 = HP Switch software loopback interface
.
.
.

Configuring inbound rate-limiting for broadcast and multicast traffic
You can configure rate-limiting (throttling) of inbound broadcast and multicast traffic on the switch, which helps
prevent the switch from being disrupted by traffic storms if they occur on the rate-limited port. The rate-limiting is
implemented as a percentage of the total available bandwidth on the port.

The rate-limit command can be executed from the global or interface context, for Example:

switch(config)# interface 3 rate-limit bcast in percent 10
or

switch(config)# interface 3
switch(eth-3)# rate-limit bcast in percent 10
Syntax:

rate-limit {< bcast | mcast >} in percent < 0-100 > 

Option
in percent <0-100>
Also supports configuring limit in kbps

[no] rate-limit {<bcast | [mcast >]} in
Enables rate-limiting and sets limits for the specified inbound broadcast or multicast traffic. Only the amount of
traffic specified by the percent is forwarded.

Default: Disabled

If you want to set a limit of 50% on inbound broadcast traffic for port 3, you can first enter interface context for port
3 and then execute the rate-limit command, as shown in Inbound broadcast rate-limiting of 50% on port 3
on page 130. Only 50% of the inbound broadcast traffic will be forwarded.
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Inbound broadcast rate-limiting of 50% on port 3

switch(config)# int 3
switch(eth-3)# rate-limit bcast in percent 50

switch(eth-3)# show rate-limit bcast
 Broadcast-Traffic Rate Limit Maximum %

  Port  | Inbound Limit Mode      Radius Override
  ----- + ------------- --------- ---------------
  1     | Disabled      Disabled  No-override
  2     | Disabled      Disabled  No-override
  3     | Disabled      %         No-override
  4     | Disabled      Disabled  No-override
  5     | Disabled      Disabled  No-override
If you rate-limit multicast traffic on the same port, the multicast limit is also in effect for that port, as shown in 
Inbound multicast rate-limiting of 20% on port 3 on page 130. Only 20% of the multicast traffic will be
forwarded.

Inbound multicast rate-limiting of 20% on port 3

switch(eth-3)# rate-limit mcast in percent 20
switch(eth-3)# show rate-limit mcast
 
 Multicast-Traffic Rate Limit Maximum %

  Port  | Inbound Limit Mode      Radius Override
  ----- + ------------- --------- ---------------
  1     | Disabled      Disabled  No-override
  2     | Disabled      Disabled  No-override
  3     | 20            %         No-override
  4     | Disabled      Disabled  No-override
To disable rate-limiting for a port enter the no form of the command, as shown in Disabling inbound multicast
rate-limiting for port 3 on page 130.

Disabling inbound multicast rate-limiting for port 3

switch(eth-3)# no rate-limit mcast in

switch(eth-3)# show rate-limit mcast
 
 Multicast-Traffic Rate Limit Maximum %

  Port  | Inbound Limit Mode      Radius Override
  ----- + ------------- --------- ---------------
  1     | Disabled      Disabled  No-override
  2     | Disabled      Disabled  No-override
  3     | Disabled      Disabled  No-override
  4     | Disabled      Disabled  No-override

Operating Notes
The following information is displayed for each installed transceiver:

• Port number on which transceiver is installed.

• Type of transceiver.
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• Product number — Includes revision letter, such as A, B, or C. If no revision letter follows a product number,
this means that no revision is available for the transceiver.

• Part number — Allows you to determine the manufacturer for a specified transceiver and revision number.

• For a non-HPE switches installed transceiver (see line 23 of "The show tech transceivers command"
example), no transceiver type, product number, or part information is displayed. In the Serial Number field,
non-operational is displayed instead of a serial number.

• The following error messages may be displayed for a non-operational transceiver:

◦ Unsupported Transceiver. (SelfTest Err#060)
◦ This switch only supports revision B and above transceivers.
◦ Self test failure.
◦ Transceiver type not supported in this port.
◦ Transceiver type not supported in this software version.
◦ Not an HPE Switch Transceiver.

Jumbo frames
The maximum transmission unit(MTU) is the maximum size IP frame the switch can receive for Layer 2 frames
inbound on a port. The switch drops any inbound frames larger than the MTU allowed on the port. Ports operating
at a minimum of 1 Gbps can accept forward frames of up to 9220 bytes (including four bytes for a VLAN tag)
when configured for jumbo traffic. You can enable inbound jumbo frames on a per-VLAN basis. That is, on a
VLAN configured for jumbo traffic, all ports belonging to that VLAN and operating at a minimum of 1 Gbps allow
inbound jumbo frames of up to 9220 bytes.

Operating rules

• Required port speed: This feature allows inbound and outbound jumbo frames on ports operating at a
minimum of 1 Gbps.

• GVRP operation: A VLAN enabled for jumbo traffic cannot be used to create a dynamic VLAN. A port
belonging to a statically configured, jumbo-enabled VLAN cannot join a dynamic VLAN.

• Port adds and moves: If you add a port to a VLAN that is already configured for jumbo traffic, the switch
enables that port to receive jumbo traffic. If you remove a port from a jumbo-enabled VLAN, the switch
disables jumbo traffic capability on the port only if the port is not currently a member of another jumbo-enabled
VLAN. This same operation applies to port trunks.

• Jumbo traffic sources: A port belonging to a jumbo-enabled VLAN can receive inbound jumbo frames
through any VLAN to which it belongs, including non-jumbo VLANs. For example, if VLAN 10 (without jumbos
enabled) and VLAN 20 (with jumbos enabled) are both configured on a switch, and port 1 belongs to both
VLANs, port 1 can receive jumbo traffic from devices on either VLAN. For a method to allow only some ports in
a VLAN to receive jumbo traffic, see Configuring a maximum frame size on page 135.
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Jumbo traffic-handling

• HPE does not recommend configuring a voice VLAN to accept jumbo frames. Voice VLAN frames are typically
small, and allowing a voice VLAN to accept jumbo frame traffic can degrade the voice transmission
performance.

• You can configure the default, primary, and/or (if configured) the management VLAN to accept jumbo frames
on all ports belonging to the VLAN.

• When the switch applies the default MTU (1522-bytes including 4 bytes for the VLAN tag) to a VLAN, all ports
in the VLAN can receive incoming frames of up to 1522 bytes. When the switch applies the jumbo MTU (9220
bytes including 4 bytes for the VLAN tag) to a VLAN, all ports in that VLAN can receive incoming frames of up
to 9220 bytes. A port receiving frames exceeding the applicable MTU drops such frames, causing the switch to
generate an Event Log message and increment the "Giant Rx" counter (displayed by show interfaces
<port-list> ).

• The switch allows flow control and jumbo frame capability to co-exist on a port.

• The default MTU is 1522 bytes (including 4 bytes for the VLAN tag). The jumbo MTU is 9220 bytes (including 4
bytes for the VLAN tag).

• When a port is not a member of any jumbo-enabled VLAN, it drops all jumbo traffic. If the port is receiving
"excessive"inbound jumbo traffic, the port generates an Event Log message to notify you of this condition. This
same condition also increments the switch's "Giant Rx" counter.

• If you do not want all ports in a given VLAN to accept jumbo frames, you can consider creating one or more
jumbo VLANs with a membership comprising only the ports you want to receive jumbo traffic. Because a port
belonging to one jumbo-enabled VLAN can receive jumbo frames through any VLAN to which it belongs, this
method enables you to include both jumbo-enabled and non-jumbo ports within the same VLAN.

For example, suppose you want to allow inbound jumbo frames only on ports 6, 7, 12, and 13. However, these
ports are spread across VLAN 100 and VLAN 200 and also share these VLANs with other ports you want
excluded from jumbo traffic. A solution is to create a third VLAN with the sole purpose of enabling jumbo traffic
on the desired ports, while leaving the other ports on the switch disabled for jumbo traffic. That is:

VLAN 100 VLAN 200 VLAN 300

Ports 6-10 11-15 6, 7, 12, and 13

Jumbo-enabled? No No Yes

If there are security concerns with grouping the ports as shown for VLAN 300, you can either use source-port
filtering to block unwanted traffic paths or create separate jumbo VLANs, one for ports 6 and 7, and another for
ports 12 and 13.

• Outbound jumbo traffic. Any port operating at 1 Gbps or higher can transmit outbound jumbo frames through
any VLAN, regardless of the jumbo configuration. The VLAN is not required to be jumbo-enabled, and the port
is not required to belong to any other, jumbo-enabled VLANs. This can occur in situations where a non-jumbo
VLAN includes some ports that do not belong to another, jumbo-enabled VLAN and some ports that do belong
to another, jumbo-enabled VLAN. In this case, ports capable of receiving jumbo frames can forward them to
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the ports in the VLAN that do not have jumbo capability, as shown in Figure 22: Forwarding jumbo frames
through non-jumbo ports on page 133.

Figure 22: Forwarding jumbo frames through non-jumbo ports

Jumbo frames can also be forwarded out non-jumbo ports when the jumbo frames received inbound on a
jumbo-enabled VLAN are routed to another, non-jumbo VLAN for outbound transmission on ports that have no
memberships in other, jumbo-capable VLANs. Where either of the above scenarios is a possibility, the
downstream device must be configured to accept the jumbo traffic. Otherwise, this traffic will be dropped by
the downstream device.

Configuring jumbo frame operation
For detailed information about jumbo frames, see Jumbo frames on page 131.

Overview

1. Determine the VLAN membership of the ports or trunks through which you want the switch to accept inbound
jumbo traffic. For operation with GVRP enabled, refer to the GVRP topic under “Operating Rules”, above.

2. Ensure that the ports through which you want the switch to receive jumbo frames are operating at least at
gigabit speed. (Check the Mode field in the output for the show interfaces brief <port-list>
command.)

3. Use the jumbo command to enable jumbo frames on one or more VLANs statically configured in the switch.
(All ports belonging to a jumbo-enabled VLAN can receive jumbo frames.

4. Execute write memory to save your configuration changes to the startupconfig file.

Viewing the current jumbo configuration
Syntax:

show vlans
Lists the static VLANs configured on the switch and includes a Jumbo column to indicate which VLANs are
configured to support inbound jumbo traffic. All ports belonging to a jumbo-enabled VLAN can receive jumbo
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traffic. (For more information, see Configuring a maximum frame size on page 135.) See Figure Figure 23:
Example: listing of static VLANs to show jumbo status per VLAN on page 134.

Figure 23: Example: listing of static VLANs to show jumbo status per VLAN

Syntax:

show vlans ports <port-list>
Lists the static VLANs to which the specified ports belong, including the Jumbo column to indicate which VLANs
are configured to support jumbo traffic.

Entering only one port in <port-list > results in a list of all VLANs to which that port belongs.

Entering multiple ports in <port-list > results in a superset list that includes the VLAN memberships of all
ports in the list, even though the individual ports in the list may belong to different subsets of the complete VLAN
listing.

Example:

If port 1 belongs to VLAN 1, port 2 belongs to VLAN 10, and port 3 belongs to VLAN 15, executing this command
with a port-list of 1 - 3 results in a listing of all three VLANs, even though none of the ports belong to all three
VLANS. (See Figure 24: Listing the VLAN memberships for a range of ports on page 134.)

Figure 24: Listing the VLAN memberships for a range of ports

Syntax:

show vlans <vid>
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Shows port membership and jumbo configuration for the specified vid . (See Figure 25: Example: of listing the
port membership and jumbo status for a VLAN on page 135.)

Figure 25: Example: of listing the port membership and jumbo status for a VLAN

Enabling or disabling jumbo traffic on a VLAN
Syntax:

vlan <vid> jumbo

[no] vlan <vid> jumbo
Configures the specified VLAN to allow jumbo frames on all ports on the switch that belong to that VLAN. If the
VLAN is not already configured on the switch, vlan <vid> jumbo also creates the VLAN.

A port belonging to one jumbo VLAN can receive jumbo frames through any other VLAN statically configured on
the switch, regardless of whether the other VLAN is enabled for jumbo frames.

The [no] form of the command disables inbound jumbo traffic on all ports in the specified VLAN that do not also
belong to another VLAN that is enabled for jumbo traffic. In a VLAN context, the command forms are jumbo and
no jumbo.

(Default: Jumbos disabled on the specified VLAN.)

Configuring a maximum frame size
You can globally set a maximum frame size for jumbo frames that will support values from 1518 bytes to 9216
bytes for untagged frames.

Syntax:

jumbo max-frame-size <size>
Sets the maximum frame size for jumbo frames. The range is from 1518 bytes to 9216 bytes. (Default: 9216
bytes)

The jumbo max-frame-size is set on a GLOBAL level.

Default: 9216 bytes
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Configuring IP MTU
The following feature is available on the switches covered in this guide. jumbos support is required
for this feature. On switches that do not support this command, the IP MTU value is derived from the
maximum frame size and is not configurable.

You can set the IP MTU globally by entering this command. The value of max-frame-size must be greater than
or equal to 18 bytes more than the value selected for ip-mtu. For example, if ip-mtu is set to 8964, the max-
frame-size is configured as 8982.

Syntax:

jumbo ip-mtu <size>
Globally sets the IP MTU size. Values range between 1500 and 9198 bytes. This value must be 18 bytes less
than the value of max-frame-size.

(Default: 9198 bytes)

SNMP implementation
Jumbo maximum frame size
The maximum frame size for jumbos is supported with the following proprietary MIB object:

hpSwitchMaxFrameSize OBJECT-TYPE
This is the value of the global max-frame-size supported by the switch. The default value is set to 9216 bytes.

Jumbo IP MTU
The IP MTU for jumbos is supported with the following proprietary MIB object:

hpSwitchIpMTU OBJECT-TYPE
This is the value of the global jumbos IP MTU (or L3 MTU) supported by the switch. The default value is set to
9198 bytes (a value that is 18 bytes less than the largest possible maximum frame size of 9216 bytes). This
object can be used only in switches that support max-frame-size and ip-mtu configuration.

Displaying the maximum frame size
Use the show jumbos command to display the globally configured untagged maximum frame size for the switch,
as shown in the following Example:.

switch(config)# show jumbos

 Jumbos Global Values

  Configured : MaxFrameSize : 9216   Ip-MTU : 9198
  In Use     : MaxFrameSize : 9216   Ip-MTU : 9198
For more information about frame size, see Jumbo frames on page 131.

Operating notes for maximum frame size

• When you set a maximum frame size for jumbo frames, it must be on a global level. You cannot use the
jumbo max-frame-size command on a per-port or per-VLAN basis.

• The original way to configure jumbo frames remains the same, which is per-VLAN, but you cannot set a
maximum frame size per-VLAN.

• Jumbo support must be enabled for a VLAN from the CLI or through SNMP.
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• Setting the maximum frame size does not require a reboot.

• When you upgrade to a version of software that supports setting the maximum frame size from a version that
did not, the max-frame-size value is set automatically to 9216 bytes.

• Configuring a jumbo maximum frame size on a VLAN allows frames up to max-frame-size even though
other VLANs of which the port is a member are not enabled for jumbo support.

Troubleshooting

A VLAN is configured to allow jumbo frames, but one or more ports drops all inbound
jumbo frames
The port may not be operating at a minimum of 1 Gbps on the other switches covered in this guide. Regardless of
a port's configuration, if it is actually operating at a speed lower than 1 Gbps for the other switches, it drops
inbound jumbo frames. For example, if a port is configured for Auto mode (speed-duplex auto), but has
negotiated a 7 Mbps speed with the device at the other end of the link, the port cannot receive inbound jumbo
frames. To determine the actual operating speed of one or more ports, view the Mode field in the output for the
following command:

show interfaces brief <port-list>

A non-jumbo port is generating "Excessive undersize/giant frames" messages in the
Event Log
The switches can transmit outbound jumbo traffic on any port, regardless of whether the port belongs to a jumbo
VLAN. In this case, another port in the same VLAN on the switch may be jumbo-enabled through membership in
a different, jumbo-enabled VLAN, and may be forwarding jumbo frames received on the jumbo VLAN to non-
jumbo ports.
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Overview
Detection of link-flap and taking action on the port is done via fault-finder command at 3 different sensitivity levels
(low, medium and high). The configuration in fault-finder for link-flap is a global configuration affecting all ports on
the switch/stack. To provide further granularity to link-flap detection and action which provides different link-flap
detection and action configuration for each port rather than the same configuration for all ports on the switch/
stack. The per-port configuration will supersede the global configuration for fault-finder link-flap.

A configurable option to re-enable ports disabled by link-flap after a waiting period is also been added. The
waiting period time is expressed in unit of seconds in the range 0 to 604800. Maximum allowed waiting period is
one week. Zero is the default value, meaning that the port will not be re-enabled automatically.

A very important point is the wording of “link-flap” itself – i.e. the word “link”. This condition should be
at the link/port-level granular, allowing alerts and actions only on those certain links/ports where the
functionality is needed.

Fault-finder link-flap
Syntax

In the config context:

[no] fault-finder link-flap [ethernet] PORT-LIST action warn | warn-and-disable SECONDS sensitivity low | medium | high

Description

Configures the link-flap on a port. The default value is warn.

Options

link-flap

Configure link-flap control.

warn

Log the event only.

warn-and-disable

Log the event and disable the port.

seconds

Re-enable the port after waiting for the specified number of seconds. The default value is 0, which indicates
that the port will not be automatically enabled.

sensitivity

Indicate the sensitivity of the link-flap control threshold within a 10-second interval.

Chapter 7
Fault-Finder port-level link-flap
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• Low indicates 10 link-flaps.

• Medium indicates 6 link-flaps.

• High indicates 3 link-flaps.

Parameters

action

Configure the action taken when a fault is detected.

ethernet PORT-LIST
Enable link-flap control on a list of ports.

warn

Warn about faults found.

warn-and-disable

Warn and disable faulty component.

seconds

Configure the number of seconds for which the port remains disabled. A value of 0 means that the port will
remain disabled until manually re-enabled.

sensitivity

Configure the fault sensitivity level.

low

Low sensitivity.

medium

Medium sensitivity

high

High sensitivity.

Subcommand Syntax

[no] fault-finder link-flap ethernet PORT-LIST
Description

To remove the current configuration of link-flap on a port

Usage

Enable a linkFault-Finder check and set parameters for it. These commands may be repeated to enable additional
checks. The default sensitivity is medium and the default action is warn.

[no] fault-finder all | fault sensitivity low | medium | high action warn | warn-and-disable

[no] fault-finder broadcast-storm sensitivity low | medium | high action warn | warn-and-disable SECONDS

[no] fault-finder link-flap sensitivity low | medium | high action warn | warn-and-disable

[no] fault-finder link-flap PORT-LIST action warn | warn-and-disable SECONDS sensitivity low | medium | high
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Configure ports for link-flap detection with high sensitivity

Configure ports A1 to A5 for link-flap detection with sensitivity of high (3 flaps over 10s) and to log and disable
port for 65535s if the link-flap threshold is exceeded.

switch(config)# fault-finder link-flap ethernet A1-A5 action warn-and-disable 65535 
sensitivity high

Configure ports for link-flap detection with medium sensitivity

Configure ports A8 for link-flap detection with sensitivity of medium (6 flaps over 10s) and to log and disable port if
the link-flap threshold is exceeded. User will need to re-enable the port if disabled.

switch(config)# fault-finder link-flap ethernet A8 action warn-and-disable 0 sensitivity medium

Configure ports for link-flap detection with low sensitivity

Configure ports A22 for link-flap detection with sensitivity of low (10 flaps over 10s) and to log if the link-flap
threshold is exceeded

switch(config)# fault-finder link-flap ethernet A22 action warn sensitivity low

Disable link-flap detection

Disable link-flap detection for port A5

switch(config)# no fault-finder link-flap ethernet A5

Show fault-finder link-flap
Syntax

show fault-finder link-flap ethernet PORT-LIST
Description

Display the link-flap control configuration.

Show fault-finder link-flap

switch# show fault-finder link-flap A1

         Link  | Port                                  Disable    Disable Time
  Port   Flap  | Status Sensitivity Action             Timer      Left        
  ------ ----- + ------ ----------- ------------------ ---------- ------------
  A1     Yes     Down      Low        warn-and-disable 65535      45303

switch# show fault-finder link-flap
         Link  | Port                                    Disable    Disable Time
  Port   Flap  | Status Sensitivity Action               Timer      Left        
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  ------ ----- + ------ ----------- ------------------- ---------- ------------
  A1     Yes     Down      Low         warn-and-disable  65535      45303
  A5     No      Up        None        None                -          -
  A22    Yes     Down      Low         warn-and-disable    -          -
  A23    Yes     Down      High        warn-and-disable   100         -

This example displays only the list of ports configured via the above per-port config commands, does
not include the global configuration ports.

Event Log
Cause

Message Cause

FFI: port <ID>- Excessive link state transitions. Link-flap is detected by fault-finder per the sensitivity
configured.

FFI: port <ID>- Excessive link state
transitions.FFI: port <ID>-Port disabled by
Fault-finder.FFI: port <ID>-Administrator action
is required to re-enable.ports: Fault-finder (71)
has disabled port <ID>.ports: port <ID> is now
offline.vlan: VLAN<VLAN-ID> virtual LAN is
disabled.

Link-flap is detected and the action is to disable the port with
no disable timer.

FFI: port <ID>- Excessive link state
transitions.FFI: port <ID>-Port disabled by
Fault-finder.ports: Fault-finder(71) has disabled
port <ID> for <SECONDS> seconds.ports: port
<ID> is now off-line.vlan: VLAN<VLAN-ID>
virtual LAN is disabled.

Link-flap is detected and the action is to disable the port with
disable timer.

port <ID> timer (71) has expired.ports: port
<ID> is now on-line.vlan: VLAN<VLAN-ID>
virtual LAN is enabled.

The port is enabled when the disable timer expires.

Restrictions
• Per port configuration for options – link-flap only. Global settings for other options.

• No support for menu interface.

• No support for Web UI.

• No support for trunks.
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Using SNMP tools to manage the switch
SNMP is a management protocol that allows an SNMP client application to retrieve device configuration and
status information and to configure the device (get and set). You can manage the switch via SNMP from a
network management station.

To implement SNMP management, the switch must have an IP address configured either manually or dynamically
(using DHCP or Bootp). If multiple VLANs are configured, each VLAN interface should have its own IP address.
For DHCP use with multiple VLANs, see section "The Primary VLAN" in the "Static Virtual LANs (VLANs)" of the
advanced traffic management guide for your switch.

If you use the switch's Authorized IP Managers and Management VLAN features, ensure that the
SNMP management station, the choice of switch port used for SNMP access to the switch, or both,
are compatible with the access controls enforced by these features. Otherwise, SNMP access to the
switch will be blocked.

For more information on Authorized IP Managers, see the access security guide for your switch. (The
latest version of this guide is available on the HPE Networking website.) For information on the
Management VLAN feature, see the section "The Secure Management VLAN" in the "Static Virtual
LANs (VLANs)" chapter of the advanced traffic management guide for your switch.

SNMP management features
SNMP management features on the switch include:

• SNMP version 1, version 2c, or version 3 over IP

• Security via configuration of SNMP communities (SNMPv3 communities on page 149)

• Security via authentication and privacy for SNMPv3 access

• Event reporting via SNMP

◦ Version 1 traps

◦ RMON: groups 1, 2, 3, and 9

• Flow sampling using sFlow

• Standard MIBs, such as the Bridge MIB (RFC 1493), Ethernet MAU MIB (RFC 1515), and others.

The switch SNMP agent also uses certain variables that are included in an HPE proprietary MIB (management
information base) file.

1. Type a model number of your switch (For example, 8212) or product number in the Auto Search text box.

2. Select an appropriate product from the drop down list.

3. Click the Display selected button.

Chapter 8
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4. From the options that appear, select Software downloads.

5. MIBs are available with switch software in the Other category.

Click on software updates, then MIBs.

SNMPv1 and v2c access to the switch
SNMP access requires an IP address and subnet mask configured on the switch. If you are using DHCP/Bootp to
configure the switch, ensure that the DHCP/Bootp process provides the IP address.

Once an IP address is configured, the main steps for configuring SNMPv1 and v2c access management features
are:

Procedure

1. Configure the appropriate SNMP communities. (See SNMPv3 communities on page 149.)

2. Configure the appropriate trap receivers.

In some networks, authorized IP manager addresses are not used. In this case, all management stations using
the correct community name may access the switch with the View and Access levels that have been set for that
community. If you want to restrict access to one or more specific nodes, you can use the switch's IP Authorized
Manager feature. (See the access security guide for your switch.)

If network management security is a concern, Hewlett Packard Enterprise recommends that you
change the write access for the "public" community to "Restricted."

SNMPv3 access to the switch
SNMPv3 access requires an IP address and subnet mask configured on the switch. (See "IP Configuration" on
page 8-2.) If you are using DHCP/Bootp to configure the switch, ensure that the DHCP/Bootp process provides
the IP address. (See "DHCP/Bootp Operation".)

Once you have configured an IP address, the main steps for configuring SNMPv3 access management features
are the following:

Procedure

1. Enable SNMPv3 for operation on the switch (see Enabling SNMPv3 on page 144).

2. Configure the appropriate SNMP users (see SNMPv3 users on page 145).

3. Configure the appropriate SNMP communities (see SNMPv3 communities on page 149).

4. Configure the appropriate trap receivers (see SNMP notifications on page 152).

In some networks, authorized IP manager addresses are not used. In this case, all management stations using
the correct User and community name may access the switch with the View and Access levels that have been set
for that community. If you want to restrict access to one or more specific nodes, you can use the IP Authorized
Manager feature for the switch. (See the access security guide for your switch.)

SNMP version 3 (SNMPv3) adds some new commands to the CLI for configuring SNMPv3 functions. To enable
SNMMPv3 operation on the switch, use the snmpv3 enable command. An initial user entry will be generated
with MD5 authentication and DES privacy.

You may (optionally) restrict access to only SNMPv3 agents by using the snmpv3 only command. To restrict
write-access to only SNMPv3 agents, use the snmpv3 restricted-access command.
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Restricting access to only version 3 messages will make the community named “public” inaccessible
to network management applications (such as autodiscovery, traffic monitoring, SNMP trap
generation, and threshold setting) from operating in the switch.

Enabling and disabling switch for access from SNMPv3 agents
This includes the creation of the initial user record.

Syntax:

[no] snmpv3 enable

Enabling or disabling restrictions to access from only SNMPv3 agents
When enabled, the switch rejects all non-SNMPv3 messages.

Syntax:

[no] snmpv3 only

Enabling or disabling restrictions from all non-SNMPv3 agents to read-only access
Syntax:

[no] snmpv3 restricted-access

Viewing the operating status of SNMPv3
Syntax:

show snmpv3 enable

Viewing status of message reception of non-SNMPv3 messages
Syntax:

show snmpv3 only

Viewing status of write messages of non-SNMPv3 messages
Syntax:

show snmpv3 restricted-access

Enabling SNMPv3
The snmpv3 enable command allows the switch to:

• Receive SNMPv3 messages.

• Configure initial users.

• Restrict non-version 3 messages to "read only" (optional).
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Restricting access to only version 3 messages makes the community named "public" inaccessible to
network management applications (such as autodiscovery, traffic monitoring, SNMP trap generation,
and threshold setting) from running on the switch.

Example:

SNMP version 3 enable command

SNMPv3 users

To create new users, most SNMPv3 management software requires an initial user record to clone.
The initial user record can be downgraded and provided with fewer features, but not upgraded by
adding new features. For this reason, Hewlett Packard Enterprise recommends that when you
enable SNMPv3, you also create a second user with SHA authentication and DES privacy.

To use SNMPv3 on the switch, you must configure the users that will be assigned to different groups:

Procedure

1. Configure users in the User Table with the snmpv3 user command.

To view the list of configured users, enter the show snmpv3 user command (see Adding users on page
146)

2. Assign users to Security Groups based on their security model with the snmpv3 group command (see 
Assigning users to groups (CLI) on page 147).

If you add an SNMPv3 user without authentication, privacy, or both, to a group that requires either
feature, the user will not be able to access the switch. Ensure that you add a user with the
appropriate security level to an existing security group.
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Adding users
To configure an SNMPv3 user, you must first add the user name to the list of known users with the snmpv3 user
command, as shown in Figure 26: Adding SNMPv3 users and displaying SNMPv3 configuration on page
146.

Figure 26: Adding SNMPv3 users and displaying SNMPv3 configuration

SNMPv3 user commands
Syntax:
[no] snmpv3 user <USER_NAME> [auth md5|sha] <AUTH_PASS> [priv des|aes] <PRIV_PASS>
    
[no] snmpv3 remote-engine-id <engineid> user <username> [auth {md5| sha}
         <authentication password>] [priv {des|aes} <privacy password>]
Parameters and options

no

Used to delete a user entry. When you delete a user, only the user name is required.

<AUTH_PASS>

With authorization, you can set either MD5 or SHA authentication. The authentication password auth_pass
must be 6 to 32 characters and is mandatory when you configure authentication.

priv des|aes

With privacy, the switch supports DES (56-bit) and AES (128-bit) encryption. Defaults to DES. Only AES 128-
bit and DES 56-bit encryption are supported as privacy protocols. Other non-standard encryption algorithms,
such as AES-172, AES-256, and 3-DES are not supported.

<PRIV_PASS>

The privacy password priv_pass must be 6 to 32 characters and is mandatory when you configure privacy.

remote-engine-id <engineid>

Sets the SNMPv3 remote engine ID in colon-separated hexadecimal notation.

Listing Users
To display the management stations configured to access the switch with SNMPv3 and view the authentication
and privacy protocols that each station uses, enter the show snmpv3 user command.
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Syntax:

show snmpv3 user
Display of the management stations configured on VLAN 1 on page 147 displays information about the
management stations configured on VLAN 1 to access the switch.

Display of the management stations configured on VLAN 1

switch# configure terminal
switch(config)# vlan 1
switch(vlan-1)# show snmpv3 user

Status and Counters - SNMPv3 Global Configuration Information

 User Name      Auth. Protocol   Privacy Protocol
 -----------    --------------   -----------------
 initial        MD5              CFB AES-128
 NetworkAdmin   MD5              CBC-DES

Assigning users to groups (CLI)
Next you must set the group access level for the user by assigning the user to a group. This is done with the
snmpv3 group command, as shown in Figure 27: Example: of assigning users to groups on page 147. For
more details on the MIBs access for a given group, see Group access levels on page 148.

Figure 27: Example: of assigning users to groups

Syntax:

[no] snmpv3 group
Assigns or removes a user to a security group for access rights to the switch. To delete an entry, all of the
following three parameters must be included in the command:
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group <group_name> Identifies the group that has the privileges that will be assigned to the user.
For more details, see Group access levels on page 148.

user <user_name> Identifies the user to be added to the access group. This must match the
user name added with the snmpv3 user command.

sec-model {<ver1 | ver2c |
ver3>

Defines which security model to use for the added user. An SNMPv3
access group should use only the ver3 security model.

Group access levels
The switch supports eight predefined group access levels, shown in the following table. There are four levels for
use by version 3 users and four are used for access by version 2c or version 1 management applications.

Table 17: Predefined group access levels

Group name Group access type Group read view Group write view

managerpriv Ver3 Must have
Authentication and Privacy

ManagerReadView ManagerWriteView

managerauth Ver3 Must have
Authentication

ManagerReadView ManagerWriteView

operatorauth Ver3 Must have
Authentication

OperatorReadView DiscoveryView

operatornoauth Ver3 No Authentication OperatorReadView DiscoveryView

commanagerrw Ver2c or Ver1 ManagerReadView ManagerWriteView

commanagerr Ver2c or Ver1 ManagerReadView DiscoveryView

comoperatorrw Ver2c or Ver1 OperatorReadView OperatorReadView

comoperatorr Ver2c or Ver1 OperatorReadView DiscoveryView

Each view allows you to view or modify a different set of MIBs:

• Manager Read View – access to all managed objects

• Manager Write View – access to all managed objects except the following:

◦ vacmContextTable

◦ vacmAccessTable

◦ vacmViewTreeFamilyTable

• OperatorReadView – no access to the following:

◦ icfSecurityMIB

◦ hpSwitchIpTftpMode

◦ vacmContextTable
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◦ vacmAccessTable

◦ vacmViewTreeFamilyTable

◦ usmUserTable

◦ snmpCommunityTable

• Discovery View – Access limited to samplingProbe MIB.

All access groups and views are predefined on the switch. There is no method to modify or add
groups or views to those that are predefined on the switch.

SNMPv3 communities
SNMP commuities are supported by the switch to allow management applications that use version 2c or version 1
to access the switch. The communities are mapped to Group Access Levels that are used for version 2c or
version 1 support. This mapping happens automatically based on the communities access privileges, but special
mappings can be added with the snmpv3 community command (see Mapping SNMPv3 communities (CLI) on
page 149).

Mapping SNMPv3 communities (CLI)
SNMP commuities are supported by the switch to allow management applications that use version 2c or version 1
to access the switch. For more details, see SNMPv3 communities on page 149.

Syntax:

[no] snmpv3 community
Maps or removes a mapping of a community name to a group access level. To remove a mapping you need to
specify only the index_name parameter.

index <index_name> An index number or title for the mapping. The values of 1 to 5 are reserved and can
not be mapped.

name
<community_name>

The community name that is being mapped to a group access level.

sec-name
<security_name>

The group level to which the community is being mapped.

tag <tag_value> This is used to specify which target address may have access by way of this index
reference.

Example:
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Figure 28: Assigning a community to a group access level on page 150 shows the assigning of the Operator
community on MgrStation1 to the CommunityOperatorReadWrite group. Any other Operator has an access level
of CommunityOperatorReadOnly.

Figure 28: Assigning a community to a group access level

SNMP community features
Use SNMP communities to restrict access to the switch by SNMP management stations by adding, editing, or
deleting SNMP communities. You can configure up to five SNMP communities, each with either an operator-level
or a manager-level view and either restricted or unrestricted write access.

Using SNMP requires that the switch have an IP address and subnet mask compatible with your network.

Viewing and configuring non-version-3 SNMP communities (Menu)

Procedure

1. From the Main Menu, select:

2. Switch Configuration…

6. SNMP Community Names

Figure 29: The SNMP Communities screen (default values)

2. Press [A] (for Add ).

If you need information on the options in each field, press [Enter] to move the cursor to the Actions line, then
select the Help option. When you are finished with Help, press [E] (for Edit) to return the cursor to the
parameter fields.
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3. Enter the name you want in the Community Name field, and use the Space bar to select the appropriate value
in each of the other fields. (Use the [Tab] key to move from one field to the next.)

4. Press [Enter] , then [S] (for Save ).

Listing community names and values (CLI)
This command lists the data for currently configured SNMP community names (along with trap receivers and the
setting for authentication traps—see SNMP notifications on page 152).

Syntax:

show snmp-server [< community-string >]
Example:

Lists the data for all communities in a switch; that is, both the default "public" community name and another
community named "blue-team."

Figure 30: Example: of the SNMP community listing with two communities

To list the data for only one community, such as the "public" community, use the above command with the
community name included. For Example:

switch# show snmp-server public

Configuring community names and values (CLI)
The snmp-server command enables you to add SNMP communities with either default or specific access
attributes, and to delete specific communities.

Syntax:

[no] snmp-server community <community-name>
Configures a new community name.

• If you do not also specify operator or manager, the switch automatically assigns the community to the
operator MIB view.

• If you do not specify restricted or unrestricted, the switch automatically assigns the community to
restricted (read-only) access.

The no form uses only the <community-name> variable and deletes the named community from the switch.
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[operator | manager] Optionally assigns an access level.

• At the operator level, the community can access all MIB objects
except the CONFIG MIB.

• At the manager level, the community can access all MIB objects.

[restricted |
unrestricted] Optionally assigns MIB access type.

• Assigning the restricted type allows the community to read MIB
variables, but not to set them.

• Assigning the unrestricted type allows the community to read and
set MIB variables.

Example:

To add the following communities:

Community Access Level Type of Access

red-team manager (Access to all MIB
objects.)

unrestricted (read/write)

blue-team operator (Access to all MIB
objects except the CONFIG MIB.)

restricted (read-only)

switch(config)# snmp-server community red-team
   manager unrestricted
switch(config)# snmp-server community blue-team
   operator restricted
To eliminate a previously configured community named "gold-team":

switch(config) # no snmp-server community gold-team

SNMP notifications
The switches:

• Default Traps: A switch automatically sends default traps to trap receivers using the configured community
name. You have to configure and supply the community name to use in the trap-receiver config, there is no
default. Use the snmp-server host <IP_ADDRESS> community "<COMMUNITY_NAME>" command to
configure a community name and the snmp-server host <IP_ADDRESS> community
"<COMMUNITY_NAME>" trap-level [all | critical | not-info | debug | none] command
to set the level of traps to send to the community.

• SNMPv2c informs

• SNMP v3 notification process, including traps

This section describes how to configure a switch to send network security and link-change notifications to
configured trap receivers.
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Supported Notifications
By default, the following notifications are enabled on a switch:

• Manager password changes

• SNMP authentication failure

• Link-change traps: when the link on a port changes from up to down (linkDown) or down to up (linkUp)

• Port-security (web, MAC, or 802.1X) authentication failure

• Invalid password entered in a login attempt through a direct serial, Telnet, or SSH connection

• Inability to establish a connection with the RADIUS or TACACS+ authentication server

• DHCP snooping events

• ARP protection events

General steps for configuring SNMP notifications

Procedure

1. Determine the versions of SNMP notifications that you want to use in your network.

If you want to use SNMPv1 and SNMPv2c traps, you must also configure a trap receiver. See the following
sections and follow the required configuration procedures:

• SNMPv1 and SNMPv2c Traps on page 153

• Configuring an SNMP trap receiver (CLI) on page 154

• Enabling SNMPv2c informs (CLI) on page 155

If you want to use SNMPv3 notifications (including traps), you must also configure an SNMPv3 management
station. Follow the required configuration procedure in Configuring SNMPv3 notifications (CLI) on page
156.

2. To reconfigure any of the SNMP notifications that are enabled by default to be sent to a management station
(trap receiver), see Enabling Link-Change Traps (CLI) on page 161.

3. (Optional) See the following sections to configure optional SNMP notification features and verify the current
configuration:

• Configuring the source IP address for SNMP notifications (CLI) on page 162

• Viewing SNMP notification configuration (CLI) on page 164

SNMPv1 and SNMPv2c Traps
The switches support the following functionality from earlier SNMP versions (SNMPv1 and SNMPv2c):

• Trap receivers: A trap receiver is a management station to which the switch sends SNMP traps and
(optionally) event log messages sent from the switch. From the CLI you can configure up to ten SNMP trap
receivers to receive SNMP traps from the switch.

• Default Traps: A switch automatically sends default traps to trap receivers using the configured community
name. You have to configure and supply the community name to use in the trap-receiver config, there is no
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default. Use the snmp-server host <IP_ADDRESS> community "<COMMUNITY_NAME>" command to
configure a community name and the snmp-server host <IP_ADDRESS> community
"<COMMUNITY_NAME>" trap-level [all | critical | not-info | debug | none] command
to set the level of traps to send to the community.

• Thresholds: A switch automatically sends all messages created when a system threshold is reached to the
network management station that configured the threshold, regardless of the trap receiver configuration.

SNMP trap receivers
Use the snmp-server host command to configure a trap receiver that can receive SNMPv1 and SNMPv2c
traps, and (optionally) Event Log messages. When you configure a trap receiver, you specify its community
membership, management station IP address, and (optionally) the type of Event Log messages to be sent.

If you specify a community name that does not exist—that is, has not yet been configured on the switch—the
switch still accepts the trap receiver assignment. However, no traps are sent to that trap receiver until the
community to which it belongs has been configured on the switch.

To replace one community name with another for the same IP address, you must first enter the

no snmp-server host <community-name> {< ipv4-address | ipv6-address >}
command to delete the unwanted community name. Otherwise, if you add a new community name
with an IP address that is already used with a different community name, two valid community name
entries are created for the same management station.

If you do not specify the event level ([none|all|not-info|critical|debug]), the switch does
not send Event Log messages as traps. However, "well-known" traps and threshold traps (if
configured) are still sent.

Configuring an SNMP trap receiver (CLI)
Syntax:

snmp-server host {< ipv4-addr | ipv6-addr >} < community name>
Configures a destination network management station to receive SNMPv1/v2c traps and (optionally) Event Log
messages sent as traps from the switch, using the specified community name and destination IPv4 or IPv6
address. You can specify up to ten trap receivers (network management stations). (The default community name
is public.)
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[{<none | all | not-info | 
critical | debug>}]

(Optional) Configures the security level of the Event Log
messages you want to send as traps to a trap receiver (see
the following table).

• The type of Event Log message that you specify applies
only to Event Log messages, not to threshold traps.

• For each configured event level, the switch continues to
send threshold traps to all network management stations
that have the appropriate threshold level configured.

• If you do not specify an event level, the switch uses the
default value (none) and sends no Event Log messages as
traps.

[<inform>]
(Optional) Configures the switch to send SNMPv2 inform
requests when certain events occur. For more information, see 
Enabling SNMPv2c informs (CLI).

Table 18: Security levels for Event Log messages sent as traps

Security Level Action

None (default) Sends no Event Log messages.

All Sends all Event Log messages.

Not-Info Sends all Event Log messages that are not for information only.

Critical Sends only Event Log messages for critical error conditions.

Debug Sends only Event Log messages needed to troubleshoot network- and switch-level problems.

Example:

To configure a trap receiver in a community named "red-team" with an IP address of 10.28.227.130 to receive
only "critical" event log messages, you can enter the following command:

switch(config)# snmp-server host 10.28.227.130 red-team critical

SNMPv2c informs
On a switch enabled for SNMPv2c, you can use the snmp-server host inform command (Enabling
SNMPv2c informs (CLI) on page 155) to send inform requests when certain events occur. When an SNMP
Manager receives an inform request, it can send an SNMP response back to the sending agent on the switch to
let the agent know that the inform request reached its destination.

If the sending agent on the switch does not receive an SNMP response back from the SNMP Manager within the
timeout period, the inform request may be resent, based on the retry count value.

When you enable SNMPv2c inform requests to be sent, you must specify the IP address and community name of
the management station that will receive the inform notification.

Enabling SNMPv2c informs (CLI)
For information about enabling SNMPv2c informs, see SNMPv2c informs on page 155.
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Syntax:

[no] snmp-server host {< ipv4-addr | ipv6-addr >} <community name> inform [retries < count >] [timeout < interval >]

Enables (or disables) the inform option for SNMPv2c on the switch and allows you to configure options for
sending SNMP inform requests.

retries Maximum number of times to resend an inform request if no SNMP response is received.
(Default: 3)

timeout Number of seconds to wait for an acknowledgement before resending the inform request.
(Default: 15 seconds)

The retries and timeout values are not used to send trap requests.

To verify the configuration of SNMPv2c informs, enter the show snmp-server command, as shown in Display
of SNMPv2c inform configuration on page 156 (note indication of inform Notify Type in bold below):

Display of SNMPv2c inform configuration

switch(config)# show snmp-server

 SNMP Communities

  Community Name   MIB View Write Access
  ---------------- -------- ------------ public          Manager  Unrestricted

 Trap Receivers

  Link-Change Traps Enabled on Ports [All] : All
  ...
  Address               Community       Events Sent Notify Type Retry Timeout
  --------------------- --------------- ----------- ----------- ----- --------
  15.28.333.456         guest           All         inform      3     15

 Excluded MIBs

 Snmp Response Pdu Source-IP Information

  Selection Policy   : Default rfc1517

 Trap Pdu Source-IP Information 
  Selection Policy   : Configured IP 
  Ip Address        : 10.10.10.10

Configuring SNMPv3 notifications (CLI)
The SNMPv3 notification process allows messages that are passed via SNMP between the switch and a network
management station to be authenticated and encrypted.

Procedure

1. Enable SNMPv3 operation on the switch by entering the snmpv3 enable command (See "SNMP Version 3
Commands" on page N-7).
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When SNMPv3 is enabled, the switch supports:

• Reception of SNMPv3 notification messages (traps and informs)

• Configuration of initial users

• (Optional) Restriction of non-SNMPv3 messages to "read only"

2. Configure SNMPv3 users by entering the snmpv3 user command (see SNMPv3 users on page 145). Each
SNMPv3 user configuration is entered in the User Table.

3. Assign SNMPv3 users to security groups according to their level of access privilege by entering the snmpv3
group command (see Assigning users to groups (CLI) on page 147).

4. Define the name of an SNMPv3 notification configuration by entering the snmpv3 notify command.

Syntax:

[no] snmpv3 notify <notify_name> tagvalue <tag_name> type {inform|trap}

Associates the name of an SNMPv3 notification configuration with a tag name used (internally) in SNMPv3
commands. To delete a notification-to-tag mapping, enter no snmpv3 notify notify_name .

notify <notify_name> Specifies the name of an SNMPv3 notification configuration.

tagvalue <tag_name> Specifies the name of a tag value used in other SNMPv3 commands, such as
snmpv3 targetaddress params taglist tag_name in Step 5.

type Specifies the notification type as inform or trap. By default, the notification
type is trap.

5. Configure the target address of the SNMPv3 management station to which SNMPv3 informs and traps are
sent by entering the snmpv3 targetaddress command.

Syntax:

[no] snmpv3 targetaddress {< ipv4-addr | ipv6-addr >} <name>
Configures the IPv4 or IPv6 address, name, and configuration filename of the SNMPv3 management station to
which notification messages are sent.
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params <parms_name> Name of the SNMPv3 station's parameters file.The
parameters filename configured with params
params_name must match the params params_name
value entered with the snmpv3 params command in
Step 6.

taglist <tag_name> [tag_name] … Specifies the SNMPv3 notifications (identified by one or
more tag_name values) to be sent to the IP address of the
SNMPv3 management station.

You can enter more than one tag_name value. Each
tag_name value must be already associated with the
name of an SNMPv3 notification configuration entered
with the snmpv3 notify command in Step 4.Use a
blank space to separate tag_name values.

You can enter up to 103 characters in tag_name entries
following the taglist keyword.

[filter {<none | debug | all | not-
info | critical>}]

(Optional) Configures the type of messages sent to a
management station.(Default: none.)

[udp-port < port >] (Optional) Specifies the UDP port to use.(Default: 162.)

[port-mask < mask >] (Optional) Specifies a range of UDP ports. (Default: 0.)

[addr-mask < mask >] (Optional) Specifies a range of IP addresses as
destinations for notification messages.(Default: 0.)

[retries < value >] (Optional) Number of times a notification is retransmitted if
no response is received. Range: 1-255.(Default: 3.)

[timeout < value >] (Optional) Time (in millisecond increments) allowed to
receive a response from the target before notification
packets are retransmitted. Range: 0-2147483647.[Default:
1500 (15 seconds).]

[max-msg-size < size >] (Optional) Maximum number of bytes supported in a
notification message to the specified target. (Default:
1472)

6. Create a configuration record for the target address with the snmpv3 params command.

Syntax:

[no] snmpv3 params <params_name> user <user_name>
Applies the configuration parameters and IP address of an SNMPv3 management station (from the params
params_name value configured with the snmpv3 targetaddress command in Step 5) to a specified
SNMPv3 user (from the user user_name value configured with the snmpv3 user command in Step 2).

If you enter the snmpv3 params user command, you must also configure a security model ( sec-model)
and message processing algorithm ( msg-processing).
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{<sec-model [ver1 | ver2c | ver3>]} Configures the security model used for SNMPv3
notification messages sent to the management
station configured with the snmpv3
targetaddress command in Step 5.

If you configure the security model as ver3, you
must also configure the message processing value as
ver3.

{msg-processing {<ver1 | ver2c | ver3>}
[noaut | auth | priv]}

Configures the algorithm used to process messages
sent to the SNMPv3 target address.

If you configure the message processing value as
ver3 and the security model as ver3, you must also
configure a security services level ( noauth, auth, or
priv).

Example:

An Example: of how to configure SNMPv3 notification is shown here:

Figure 31: Example: of an SNMPv3 notification configuration

Network security notifications
By default, a switch is enabled to send the SNMP notifications listed in Supported Notifications on page 153
when a network security event (For example, authentication failure) occurs. However, before security notifications
can be sent, you must first configure one or more trap receivers or SNMPv3 management stations as described
in:

• Configuring an SNMP trap receiver (CLI) on page 154

• Configuring SNMPv3 notifications (CLI) on page 156

You can manage the default configuration of the switch to disable and re-enable notifications to be sent for the
following types of security events:

• ARP protection events

• Inability to establish a connection with the RADIUS or TACACS+ authentication server

• DHCP snooping events

• Dynamic IP Lockdown hardware resources consumed

• Link change notification
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• Invalid password entered in a login attempt through a direct serial, Telnet, or SSH connection

• Manager password changes

• Port-security (web, MAC, or802.1X) authentication failure

• SNMP authentication failure

• Running configuration changes

Enabling or disabling notification/traps for network security failures and other security
events (CLI)
For more information, see Network security notifications on page 159.

Syntax:

[no] snmp-server enable traps [snmp-auth | password-change-mgr | login-failure-mgr 
| port-security | auth-server-fail | dhcp-snooping | arp-protect | running-config-
change]
Enables or disables sending one of the security notification types listed below to configured trap receivers.
(Unless otherwise stated, all of the following notifications are enabled in the default configuration.)

The notification sends a trap:

arp-protect If ARP packets are received with an invalid source or
destination MAC address, an invalid IP address, or an
invalid IP-to-MAC binding.

auth-server-fail If the connection with a RADIUS or TACACS+
authentication server fails.

dhcp-snooping If DHCP packets are received from an untrusted
source or if DHCP packets contain an invalid IP-to-
MAC binding.

dhcpv6-snooping Set the traps for DHCPv6 snooping.

dyn-ip-lockdown If the switch is out of hardware resources needed to
program a dynamic IP lockdown rule

dyn-ipv6-lockdown Enable traps for Dynamic IPv6 lockdown..

link-change <port-list> When the link state on a port changes from up to
down, or the reverse.

login-failure-mgr For a failed login with a manager password.

password-change-mgr When a manager password is reset.

mac-notify Globally enables the generation of SNMP trap
notifications upon MAC address table changes.

nd-snooping Set the trap for nd snooping

Table Continued
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port-security For a failed authentication attempt through a web,
MAC, or 801.X authentication session.

running-config-change When changes to the running configuration file are
made.

snmp-authentication [extended |
standard]

For a failed authentication attempt via SNMP.(Default:
extended.)

Startup-config-change Sends a trap when changes to the startup
configuration file are made. See “Enabling SNMP
Traps on Startup Configuration Changes” on page 6–
34. (Default: Disabled)

To determine the specific cause of a security event, check the Event Log in the console interface to see why a
trap was sent. For more information, see "Using the Event Log for Troubleshooting Switch Problems".

Viewing the current configuration for network security notifications (CLI)
Enter the show snmp-server traps command, as shown in Display of configured network security
notifications on page 161. Note that command output is a subset of the information displayed with the show
snmp-server command in Display of SNMP notification configuration.

Display of configured network security notifications

switch(config)# show snmp-server traps

 Trap Receivers

  Link-Change Traps Enabled on Ports [All] : A1-A24

  Traps Category                  Current Status
  ------------------------------  --------------------------
  SNMP Authentication           : Extended
  Password change               : Enabled
  Login failures                : Enabled
  Port-Security                 : Enabled
  Authorization Server Contact  : Enabled
  DHCP Snooping                 : Enabled
  Dynamic ARP Protection        : Enabled
  Dynamic IP Lockdown           : Enabled

  Address                Community  Events Sent Notify Type Retry Timeout
  ---------------------- ---------- ----------- ----------- ----- -------
  15.255.5.225           public     All         trap          3   15
  2001:0db8:0000:0001
    :0000:0000:0000:0121 user_1     All         trap          3   15

  Excluded MIBs

Enabling Link-Change Traps (CLI)
By default, a switch is enabled to send a trap when the link state on a port changes from up to down (linkDown) or
down to up (linkUp). To reconfigure the switch to send link-change traps to configured trap receivers, enter the
snmp-server enable traps link-change command.

Chapter 8 Configuring for Network Management Applications 161

Anexo 04 ITEM 10 (0592646)         SEI 0008478-63.2018.6.02.8000 / pg. 5220



Syntax:

[no] snmp-server enable traps link-change <port-list> [all]
Enables or disables the switch to send a link-change trap to configured trap receivers when the link state on a
port goes from up to down or down to up.

Enter all to enable or disable link-change traps on all ports on the switch.

Readable interface names in traps
The SNMP trap notification messages for linkup and linkdown events on an interface includes IfDesc and IfAlias
var-bind information.

Source IP address for SNMP notifications
The switch uses an interface IP address as the source IP address in IP headers when sending SNMP
notifications (traps and informs) or responses to SNMP requests.

For multi-netted interfaces, the source IP address is the IP address of the outbound interface of the SNMP reply,
which may differ from the destination IP address in the IP header of the received request. For security reasons, it
may be desirable to send an SNMP reply with the IP address of the destination interface (or a specified IP
address) on which the corresponding SNMP request was received.

To configure the switch to use the source IP address on which an SNMP request was received in SNMP
notification/traps and replies, enter the snmp-server response-source and snmp-server trap-source
commands (Configuring the source IP address for SNMP notifications (CLI)).

Configuring the source IP address for SNMP notifications (CLI)
For more information, see Source IP address for SNMP notifications on page 162.

Syntax:

[no] snmp-server response-source [dst-ip-of-request | [ipv4-addr | ipv6-addr] | loopback <0-7>]
Specifies the source IP address of the SNMP response PDU. The default SNMP response PDU uses the IP
address of the active interface from which the SNMP response was sent as the source IP address.

The no form of the command resets the switch to the default behavior (compliant with rfc-1517).

(Default: Interface IP address)

dst-ip-of-request Destination IP address of the SNMP request PDU that is used as the
source IP address in an SNMP response PDU.

[ipv4-addr | ipv6-addr] User-defined interface IP address that is used as the source IP address
in an SNMP response PDU. Both IPv4 and IPv6 addresses are
supported.

loopback <0-7> IP address configured for the specified loopback interface that is used as
the source IP address in an SNMP response PDU. If multiple loopback IP
addresses are configured, the lowest alphanumeric address is used.

To use the IP address of the destination interface on which an SNMP request was received as the source IP
address in the IP header of SNMP traps and replies, enter the following command:

switch(config)# snmp-server response-source dst-ip-of-request
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Syntax:

[no] snmp-server trap-source [ipv4-addr | loopback <0-7>]
Specifies the source IP address to be used for a trap PDU. To configure the switch to use a specified source IP
address in generated trap PDUs, enter the snmp-server trap-source command.

The no form of the command resets the switch to the default behavior (compliant with rfc-1517).

(Default: Use the interface IP address in generated trap PDUs)

ipv4-addr User-defined interface IPv4 address that is used as the source IP address in generated
traps. IPv6 addresses are not supported.

loopback <0-7> P address configured for the specified loopback interface that is used as the source IP
address in a generated trap PDU. If multiple loopback IP addresses are configured, the
lowest alphanumeric address is used.

When you use the snmp-server response-source and snmp-server trap-source
commands, note the following behavior:

• The snmp-server response-source and snmp-server trap-source commands
configure the source IP address for IPv4 interfaces only.

• You must manually configure the snmp-server response-source value if you wish to change
the default user-defined interface IP address that is used as the source IP address in SNMP traps
(RFC 1517).

• The values configured with the snmp-server response-source and snmp-server trap-
source commands are applied globally to all interfaces that are sending SNMP responses or
SNMP trap PDUs.

• Only the source IP address field in the IP header of the SNMP response PDU can be changed.

• Only the source IP address field in the IP header and the SNMPv1 Agent Address field of the
SNMP trap PDU can be changed.

Verifying the configuration of the interface IP address used as the source IP address in IP
headers for SNMP replies and traps sent from the switch (CLI)
Enter the show snmp-server command to display the SNMP policy configuration, as shown in Display of
source IP address configuration on page 163.

Display of source IP address configuration

switch(config)# show snmp-server
 
 SNMP Communities
  
  Community Name   MIB View Write Access
  ---------------- -------- ------------
  public           Manager  Unrestricted

 Trap Receivers
  Link-Change Traps Enabled on Ports [All] : All

  ...
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 Excluded MIBs
 Snmp Response Pdu Source-IP Information
  Selection Policy : dstIpOfRequest 1

 Trap Pdu Source-IP Information
  Selection Policy : Configured IP
1 dstIpOfRequest: The destination IP address of the interface on which an SNMP request is received i s used as
the source IP address in SNMP replies.

Viewing SNMP notification configuration (CLI)
Syntax:

show snmp-server
Displays the currently configured notification settings for versions SNMPv1 and SNMPv2c traps, including SNMP
communities, trap receivers, link-change traps, and network security notifications.

Example:

In the following Example:, the show snmp-server command output shows that the switch has been configured
to send SNMP traps and notifications to management stations that belong to the "public," "red-team," and "blue-
team" communities.

Figure 32: Display of SNMP notification configuration

Advanced management: RMON
The switch supports RMON (remote monitoring) on all connected network segments. This allows for
troubleshooting and optimizing your network.

The following RMON groups are supported:
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• Ethernet Statistics (except the numbers of packets of different frame sizes)

• Alarm

• History (of the supported Ethernet statistics)

• Event

The RMON agent automatically runs in the switch. Use the RMON management station on your network to
enable or disable specific RMON traps and events. Note that you can access the Ethernet statistics, Alarm and
Event groups from the HPE Switch Manager network management software.

CLI-configured sFlow with multiple instances
sFlow can also be configured via the CLI for up to three distinct sFlow instances: once enabled, an sFlow
receiver/destination can be independently configured for full flow-sampling and counter-polling. CLI-configured
sFlow instances may be saved to the startup configuration to persist across a switch reboot.

Configuring sFlow (CLI)
The following sFlow commands allow you to configure sFlow instances via the CLI. For more information, see 
Advanced management: RMON on page 164.

Syntax:

[no] sflow <receiver-instance> destination <ip-address> [< udp-port-num >]
Enables an sFlow receiver/destination. The receiver-instance number must be a 1, 2, or 3.

By default, the udp destination port number is 6343.

To disable an sFlow receiver/destination, enter no sflow receiver-instance .

Syntax:

sflow <receiver-instance> sampling <port-list> <sampling rate>
Once an sFlow receiver/destination has been enabled, this command enables flow sampling for that instance.
The receiver-instance number is 1, 2, or 3, and the sampling rate is the allowable non-zero skipcount for the
specified port or ports.

To disable flow-sampling for the specified port-list, repeat the above command with a sampling rate of 0.

Syntax:

sflow <receiver-instance> polling <port-list> <polling interval>
Once an sFlow receiver/destination has been enabled, this command enables counter polling for that instance.
The receiver-instance number is 1, 2, or 3, and the polling interval may be set to an allowable non-zero value to
enable polling on the specified port or ports.

To disable counter-polling for the specified port-list, repeat the above command with a polling interval of 0.

Under the multiple instance implementation, sFlow can be configured via the CLI or via SNMP.
However, CLI-owned sFlow configurations cannot be modified via SNMP, whereas SNMP-owned
instances can be disabled via the CLI using the no sflow <receiver-instance> command.
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Viewing sFlow Configuration and Status (CLI)
The following sFlow commands allow you to display sFlow configuration and status via the CLI. Viewing sFlow
destination information on page 166 is an Example: of sflow agent information.

Syntax:

show sflow agent
Displays sFlow agent information. The agent address is normally the IP address of the first VLAN configured.

The show sflow agent command displays read-only switch agent information. The version information shows
the sFlow version, MIB support, and software versions; the agent address is typically the IP address of the first
VLAN configured on the switch.

Viewing sflow agent information

switch# show sflow agent

  Version          1.3;HP;XX.11.40
  Agent Address    10.0.10.228
Syntax:

show sflow <receiver instance> destination
Displays information about the management station to which the sFlow sampling-polling data is sent.

The show sflow instance destination command includes information about the management-station's
destination address, receiver port, and owner, as shown in Viewing sFlow destination information on page
166.

Viewing sFlow destination information

switch# show sflow 2 destination

  Destination Instance        2
  sflow                       Enabled
  Datagrams Sent              221
  Destination Address         10.0.10.41
  Receiver Port               6343
  Owner                       Administrator, CLI-owned, Instance 2
  Timeout (seconds)           99995530
  Max Datagram Size           1400
  Datagram Version Support    5
Note the following details:

• Destination Address remains blank unless it has been configured.

• Datagrams Sent shows the number of datagrams sent by the switch agent to the management station since
the switch agent was last enabled.

• Timeout displays the number of seconds remaining before the switch agent will automatically disable sFlow
(this is set by the management station and decrements with time).

• Max Datagram Size shows the currently set value (typically a default value, but this can also be set by the
management station).
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Syntax:

show sflow <receiver instance> sampling-polling <port-list/range>
Displays status information about sFlow sampling and polling.

The show sflow instance sampling-polling [port-list] command displays information about
sFlow sampling and polling on the switch, as shown in Figure 33: Example: of viewing sFlow sampling and
polling information on page 167. You can specify a list or range of ports for which to view sampling information.

Figure 33: Example: of viewing sFlow sampling and polling information

The sampling and polling instances (noted in parentheses) coupled to a specific receiver instance
are assigned dynamically, and so the instance numbers may not always match. The key thing to note
is whether sampling or polling is enabled on a port, and the sampling rates or polling intervals for the
receiver instance configured on each port.

Configuring UDLD Verify before forwarding
When an UDLD enabled port transitions to link-up, the port will begin with a UDLD blocking state. UDLD will
probe via protocol packet exchange to determine the bidirectional state of the link. Until UDLD has completed the
probe, all data traffic will be blocked. If the link is found to be bidirectional, UDLD will unblock the port for data
traffic to pass. Once UDLD unblocks the port, other protocols will see the port as up and data traffic can be safely
forwarded.

The default mode of a switch is “forward first then verify’’. Enabling UDLD link-up will default to “forward first then
verify”. To change the mode to “verify then forward”, you need to configure using the commands found in section
6.72.

Link-UP data traffic will resumed after probing the link partner completes. All other protocols running
will see the port as down.

UDLD time delay
UDLD protocol informs the link partner simultaneously as it detects a state change from unidirectional to
bidirectional traffic. Additional packet exchanges will be carried out by UDLD in addition to the existing UDLD
exchanges whenever state changes from unidirectional to bidirectional.
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Table 19: Peer state transition timings

Interval Time Interval 1 Interval 1 + delta Interval 2 Interval 3

5 sec 5+(<5) sec* 10 sec 15 sec

With triggered
updates

State = blockedPeer
State = blocked

Inform PeerState =
unblockedPeer State
= unblocked

Regular UDLD TX Regular UDLD TX

Without triggered
updates

State = blockedPeer
State = blocked

State =
unblockedPeer State
= blocked

Inform PeerState =
unblockedPeer State
= unblocked

Regular UDLD TX

*delta is the time when the unblock event occurs on local side

Restrictions

• There is no support available when configuring this mode from the web and menu interface.

• There are no new packet types are introduced with UDLD.

• There are no new UDLD timers being introduced.

UDLD configuration commands
Syntax:

HP Switch(config)# link-keepalive mode [verify-then-forward | forward-then-verify]
This command configures the link-keepalive mode.

Link-keepalive provides two modes of operation; verify-then-forward and forward-then-verify.

When using the verify-then-forward mode, the port is in a blocking state until the link configured for UDLD
establishes bidirectional communication. When using the forward-then-verify mode, the port forwards the
data then verifies the status of the link-in state.

When a unidirectional state is detected, the port is moved to a blocked state.

When a bidirectional state is detected, the data is forwarded without interruption.

Syntax:

HP Switch(config)# link-keepalive mode verify-then-forward
Keeps the port in a logically blocked state until the link configured for UDLD has been successfully established in
bi-directional communication.

Syntax:

HP Switch(config)# link-keepalive mode forward-then-verify
Forwards the data then verifies the status of the link. If a unidirectional state is detected, the port is then moved to
a blocked state.
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Syntax:

HP Switch(config)# link-keepalive interval <deciseconds>
Configure the interval for link-keepalive. The link-keepalive interval is the time between sending two
UDLD packets. The time interval is entered in deciseconds (1/10 sec). The default keepalive interval is 50
deciseconds.

Example:

A value of 10 is 1 sec., 11 is 1.1 sec.

Syntax:

HP Switch(config)# link-keepalive retries <number>
Maximum number of sending attempts for UDLD packets before declaring the link as faulty.

Default keepalive attempt is 4.

Show commands
Syntax:

switch(config)# show link-keepalive
Sample output:

Total link-keepalive enabled ports: 8
Keepalive Retries : 4
Keepalive Interval: 5 sec
Keepalive Mode : verify-then-forward
Physical Keepalive Adjacent UDLD

Port  Enabled Status           Status    Switch       VLAN
----- ------- ---------------- --------- ------------- ----------
1     Yes     down             off-line  000000-000000 untagged
2     Yes     down             off-line  000000-000000 untagged
3     Yes     down             off-line  000000-000000 untagged
4     Yes     down             off-line  000000-000000 untagged
5     Yes     down             off-line  000000-000000 untagged
6     Yes     down             off-line  000000-000000 untagged
7     Yes     down             off-line  000000-000000 untagged
8     Yes     down             off-line  000000-000000 untagged

RMON generated when user changes UDLD mode
RMON events are generated when UDLD is configured. The first time you configure the mode, the UDLD states
will be re-initialized. An event log entry is initiated to include the reason for the initial UDLD blocking state during
link up.

Example:

UDLD mode [verify-then-forward | forward-then-verify] is configured

Severity: - Info.

LLDP
To standardize device discovery on all HPE switches, LLDP is implemented while offering limited read-only
support for CDP, as documented in this manual. For the latest information on your switch model, consult the
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Release Notes (available on the HPE Networking website). If LLDP has not yet been implemented (or if you are
running an older version of software), consult a previous version of the Management and Configuration Guide for
device discovery details.

LLDP (Link Layer Discovery Protocol): provides a standards-based method for enabling the switches covered
in this guide to advertise themselves to adjacent devices and to learn about adjacent LLDP devices.

LLDP-MED (LLDP Media Endpoint Discovery): Provides an extension to LLDP and is designed to support VoIP
deployments.

LLDP-MED is an extension for LLDP, and the switch requires that LLDP be enabled as a prerequisite
to LLDP-MED operation.

An SNMP utility can progressively discover LLDP devices in a network by:

Procedure

1. Reading a given device's Neighbors table (in the Management Information Base, or MIB) to learn about other,
neighboring LLDP devices.

2. Using the information learned in step 1 to find and read the neighbor devices' Neighbors tables to learn about
additional devices, and so on.

Also, by using show commands to access the switch's neighbor database for information collected by an
individual switch, system administrators can learn about other devices connected to the switch, including device
type (capability) and some configuration information. In VoIP deployments using LLDP-MED on the switches,
additional support unique to VoIP applications is also available. See LLDP-MED (media-endpoint-discovery) on
page 185.

General LLDP operation
An LLDP packet contains data about the transmitting switch and port. The switch advertises itself to adjacent
(neighbor) devices by transmitting LLDP data packets out all ports on which outbound LLDP is enabled and by
reading LLDP advertisements from neighbor devices on ports that are inbound LLDP-enabled. (LLDP is a one-
way protocol and does not include any acknowledgement mechanism.) An LLDP-enabled port receiving LLDP
packets inbound from neighbor devices stores the packet data in a Neighbor database (MIB).

LLDP-MED
This capability is an extension to LLDP and is available on the switches. See LLDP-MED (media-endpoint-
discovery) on page 185.

Packet boundaries in a network topology

• Where multiple LLDP devices are directly connected, an outbound LLDP packet travels only to the next LLDP
device. An LLDP-capable device does not forward LLDP packets to any other devices, regardless of whether
they are LLDP-enabled.

• An intervening hub or repeater forwards the LLDP packets it receives in the same manner as any other
multicast packets it receives. Thus, two LLDP switches joined by a hub or repeater handle LLDP traffic in the
same way that they would if directly connected.

• Any intervening 802.1D device or Layer-3 device that is either LLDP-unaware or has disabled LLDP operation
drops the packet.
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LLDP operation configuration options
In the default configuration, LLDP is enabled and in both transmit and receive mode on all active ports. The LLDP
configuration includes global settings, which apply to all active ports on the switch, and per-port settings, which
affect only the operation of the specified ports.

The commands in the LLDP sections affect both LLDP and LLDP-MED operation. For information on operation
and configuration unique to LLDP-MED, see LLDP-MED (media-endpoint-discovery) on page 185.

Enable or disable LLDP on the switch
In the default configuration, LLDP is globally enabled on the switch. To prevent transmission or receipt of LLDP
traffic, you can disable LLDP operation.

Enable or disable LLDP-MED
In the default configuration for the switches, LLDP-MED is enabled by default. (Requires that LLDP is also
enabled.) For more information, see LLDP-MED (media-endpoint-discovery) on page 185.

Change the frequency of LLDP packet transmission to neighbor devices
On a global basis, you can increase or decrease the frequency of outbound LLDP advertisements.

Change the Time-To-Live for LLDP packets sent to neighbors
On a global basis, you can increase or decrease the time that the information in an LLDP packet outbound from
the switch will be maintained in a neighbor LLDP device.

Transmit and receive mode
With LLDP enabled, the switch periodically transmits an LLDP advertisement (packet) out each active port
enabled for outbound LLDP transmissions and receives LLDP advertisements on each active port enabled to
receive LLDP traffic (Configuring per-port transmit and receive modes (CLI) on page 179). Per-port
configuration options include four modes:

• Transmit and receive (tx_rx): This is the default setting on all ports. It enables a given port to both transmit
and receive LLDP packets and to store the data from received (inbound) LLDP packets in the switch's MIB.

• Transmit only (txonly): This setting enables a port to transmit LLDP packets that can be read by LLDP
neighbors. However, the port drops inbound LLDP packets from LLDP neighbors without reading them. This
prevents the switch from learning about LLDP neighbors on that port.

• Receive only (rxonly): This setting enables a port to receive and read LLDP packets from LLDP neighbors
and to store the packet data in the switch's MIB. However, the port does not transmit outbound LLDP packets.
This prevents LLDP neighbors from learning about the switch through that port.

• Disable (disable): This setting disables LLDP packet transmissions and reception on a port. In this state, the
switch does not use the port for either learning about LLDP neighbors or informing LLDP neighbors of its
presence.

SNMP notification
You can enable the switch to send a notification to any configured SNMP trap receiver(s) when the switch detects
a remote LLDP data change on an LLDP-enabled port (Configuring SNMP notification support on page 179).

Per-port (outbound) data options
The following table lists the information the switch can include in the per-port, outbound LLDP packets it
generates. In the default configuration, all outbound LLDP packets include this information in the TLVs transmitted
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to neighbor devices. However, you can configure LLDP advertisements on a per-port basis to omit some of this
information (Configuring a remote management address for outbound LLDP advertisements (CLI) on page
180).

Table 20: Data available for basic LLDP advertisements

Data type Configuration options Default Description

Time-to-Live 1 120 Seconds The length of time an
LLDP neighbor retains the
advertised data before
discarding it.

Chassis Type2, N/A Always Enabled Indicates the type of
identifier used for Chassis
ID.

Chassis ID33 N/A Always Enabled Uses base MAC address
of the switch.

Port Type4,33 N/A Always Enabled Uses "Local," meaning
assigned locally by LLDP.

Port Id33 N/A Always Enabled Uses port number of the
physical port. This is an
internal number reflecting
the reserved slot/port
position in the chassis. For
more information on this
numbering scheme, see
the appendix "MAC
Address Management".

Remote Management Address

Type3,3 N/A Always Enabled Shows the network
address type.

Address55 Default or Configured Uses a default address selection method unless an
optional address is configured. See Remote
management address on page 173.

System Name33 Enable/Disable Enabled Uses the switch's
assigned name.

System Description33 Enable/Disable Enabled Includes switch model
name and running
software version, and
ROM version.

Port Description33 Enable/Disable Enabled Uses the physical port
identifier.

Table Continued
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Data type Configuration options Default Description

System capabilities
supported3,3

Enable/Disable Enabled Identifies the switch's
primary capabilities
(bridge, router).

System capabilities
enabled3,66 3

Enable/Disable Enabled Identifies the primary
switch functions that are
enabled, such as routing.

1 The Packet Time-to-Live value is included in LLDP data packets.
2 Subelement of the Chassis ID TLV.
3 Populated with data captured internally by the switch. For more on these data types, refer to the IEEE P802.1AB Standard.
4 Subelement of the Port ID TLV.
5 Subelement of the Remote-Management-Address TLV.
6 Subelement of the System Capability TLV.

Remote management address
The switch always includes an IP address in its LLDP advertisements. This can be either an address selected by
a default process or an address configured for inclusion in advertisements. See IP address advertisements on
page 174.

Debug logging
You can enable LLDP debug logging to a configured debug destination (Syslog server, a terminal device, or both)
by executing the debug lldp command. (For more information on Debug and Syslog, see the "Troubleshooting"
appendix in this guide.) Note that the switch's Event Log does not record usual LLDP update messages.

Options for reading LLDP information collected by the switch
You can extract LLDP information from the switch to identify adjacent LLDP devices. Options include:

• Using the switch's show lldp info command options to display data collected on adjacent LLDP devices—
as well as the local data the switch is transmitting to adjacent LLDP devices (Displaying the global LLDP,
port admin, and SNMP notification status (CLI) on page 174).

• Using an SNMP application that is designed to query the Neighbors MIB for LLDP data to use in device
discovery and topology mapping.

• Using thewalkmib command to display a listing of the LLDP MIB objects

LLDP and LLDP-MED standards compatibility
The operation covered by this section is compatible with these standards:

• IEEE P802.1AB

• RFC 2922 (PTOPO, or Physical Topology MIB)

• RFC 2737 (Entity MIB)

• RFC 2863 (Interfaces MIB)

• ANSI/TIA-1057/D6 (LLDP-MED; refer to LLDP-MED (media-endpoint-discovery) on page 185.)
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LLDP operating rules
For additional information specific to LLDP-MED operation, see LLDP-MED (media-endpoint-discovery) on
page 185.

Port trunking
LLDP manages trunked ports individually. That is, trunked ports are configured individually for LLDP operation, in
the same manner as non-trunked ports. Also, LLDP sends separate advertisements on each port in a trunk, and
not on a per-trunk basis. Similarly, LLDP data received through trunked ports is stored individually, per-port.

IP address advertisements
In the default operation, if a port belongs to only one static VLAN, the port advertises the lowest-order IP address
configured on that VLAN. If a port belongs to multiple VLANs, the port advertises the lowest-order IP address
configured on the VLAN with the lowest VID. If the qualifying VLAN does not have an IP address, the port
advertises 127.0.0.1 as its IP address. For example, if the port is a member of the default VLAN (VID=1), and
there is an IP address configured for the default VLAN, the port advertises this IP address. In the default
operation, the IP address that LLDP uses can be an address acquired by DHCP or Bootp.

You can override the default operation by configuring the port to advertise any IP address that is manually
configured on the switch, even if the port does not belong to the VLAN configured with the selected IP address
(Configuring a remote management address for outbound LLDP advertisements (CLI) on page 180). (Note
that LLDP cannot be configured through the CLI to advertise an addresses acquired through DHCP or Bootp.
However, as mentioned above, in the default LLDP configuration, if the lowest-order IP address on the VLAN with
the lowest VID for a given port is a DHCP or Bootp address, the switch includes this address in its LLDP
advertisements unless another address is configured for advertisements on that port.) Also, although LLDP allows
configuring multiple remote management addresses on a port, only the lowest-order address configured on the
port will be included in outbound advertisements. Attempting to use the CLI to configure LLDP with an IP address
that is either not configured on a VLAN or has been acquired by DHCP or Bootp results in the following error
message.

xxx.xxx.xxx.xxx: This IP address is not configured or is a DHCP address.

Spanning-tree blocking
Spanning tree does not prevent LLDP packet transmission or receipt on STP-blocked links.

802.1X blocking
Ports blocked by 802.1X operation do not allow transmission or receipt of LLDP packets.

Configuring LLDP operation

Displaying the global LLDP, port admin, and SNMP notification status (CLI)
In the default configuration, LLDP is enabled and in both transmit and receive mode on all active ports. The LLDP
configuration includes global settings that apply to all active ports on the switch, and per-port settings that affect
only the operation of the specified ports.

The commands in this section affect both LLDP and LLDP-MED operation. for information on operation and
configuration unique to LLDP-MED, refer to “LLDP-MED (Media-Endpoint-Discovery)”.

Syntax:

show lldp config
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Displays the LLDP global configuration, LLDP port status, and SNMP notification status. For information on port
admin status, see Configuring per-port transmit and receive modes (CLI) on page 179.

show lldp config produces the following display when the switch is in the default LLDP configuration:

Viewing the general LLDP configuration

switch(config)# show lldp config

 LLDP Global Configuration

  LLDP Enabled [Yes] : Yes
  LLDP Transmit Interval     [30] : 30
  LLDP Hold time Multiplier   [4] : 4
  LLDP Delay Interval         [2] : 2
  LLDP Reinit Interval        [2] : 2
  LLDP Notification Interval  [5] : 5
  LLDP Fast Start Count       [5] : 5

 LLDP Port Configuration

  Port | AdminStatus NotificationEnabled  Med Topology Trap Enabled
  ---- + ----------- -------------------  -------------------------
  A1   | Tx_Rx       False                False
  A2   | Tx_Rx       False                False
  A3   | Tx_Rx       False                False
  A4   | Tx_Rx       False                False
  A5   | Tx_Rx       False                False
  A6   | Tx_Rx       False                False
  A7   | Tx_Rx       False                False
  A8   | Tx_Rx       False                False

The values displayed in the LLDP column correspond to the lldp refresh-interval command

Viewing port configuration details (CLI)
Syntax:

show lldp config <port-list>
Displays the LLDP port-specific configuration for all ports in <port-list>, including which optional TLVs and any
non-default IP address that are included in the port's outbound advertisements.
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For information on the notification setting, see Configuring SNMP notification support on page 179. For
information on the other configurable settings displayed by this command, see Configuring per-port transmit
and receive modes (CLI) on page 179.

Figure 34: Per-port configuration display

Configuring Global LLDP Packet Controls
The commands in this section configure the aspects of LLDP operation that apply the same to all ports in the
switch.

LLDP operation on the switch
Enabling LLDP operation (the default) causes the switch to:

• Use active, LLDP-enabled ports to transmit LLDP packets describing itself to neighbor devices.

• Add entries to its neighbors table based on data read from incoming LLDP advertisements.

Enabling or disabling LLDP operation on the switch (CLI)
For more information, see LLDP operation on the switch on page 176.

Syntax:

[no] lldp run
Enables or disables LLDP operation on the switch.

The no form of the command, regardless of individual LLDP port configurations, prevents the switch from
transmitting outbound LLDP advertisements and causes the switch to drop all LLDP advertisements received
from other devices.

The switch preserves the current LLDP configuration when LLDP is disabled. After LLDP is disabled, the
information in the LLDP neighbors database remains until it times-out.

(Default: Enabled)
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Disabling LLDP

switch(config)# no lldp run

Changing the packet transmission interval (CLI)
This interval controls how often active ports retransmit advertisements to their neighbors.

Syntax:

lldp refresh-interval <5-32768>
Changes the interval between consecutive transmissions of LLDP advertisements on any given port.

(Default: 30 seconds)

The refresh-interval must be greater than or equal to (4 x delay-interval). (The default
delay-interval is 2). For example, with the default delay-interval, the lowest refresh-
interval you can use is 8 seconds (4 x 2=8). Thus, if you want a refresh-interval of 5
seconds, you must first change the delay interval to 1 (that is, 4 x 1 5). If you want to change the
delay-interval, use the setmib command.

Time-to-Live for transmitted advertisements
The Time-to-Live value (in seconds) for all LLDP advertisements transmitted from a switch is controlled by the
switch that generates the advertisement and determines how long an LLDP neighbor retains the advertised data
before discarding it. The Time-to-Live value is the result of multiplying the refresh-interval by the
holdtime-multiplier.

Changing the time-to-live for transmitted advertisements (CLI)
For more information, see Time-to-Live for transmitted advertisements on page 177.

Syntax:

lldp holdtime-multiplier <2-10>
Changes the multiplier an LLDP switch uses to calculate the Time-to-Live for the LLDP advertisements it
generates and transmits to LLDP neighbors. When the Time-to-Live for a given advertisement expires, the
advertised data is deleted from the neighbor switch's MIB.

(Default: 4; Range 2–10)

Example:

If the refresh-interval on the switch is 15 seconds and the holdtime-multiplier is at the default, the Time-to-
Live for advertisements transmitted from the switch is 60 seconds (4 x 15).

To reduce the Time-to-Live, you could lower the holdtime-interval to 2, which would result in a Time-to-Live
of 30 seconds.

switch(config)# lldp holdtime-multiplier 2

Delay interval between advertisements generated by value or status changes to the
LLDP MIB
The switch uses a delay-interval setting to delay transmitting successive advertisements resulting from these
LLDP MIB changes. If a switch is subject to frequent changes to its LLDP MIB, lengthening this interval can
reduce the frequency of successive advertisements. You can change the delay-interval by using either an SNMP
network management application or the CLI setmib command.
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Changing the delay interval between advertisements generated by value or status changes to
the LLDP MIB (CLI)
Syntax:

setmib lldpTxDelay.0 -i <1-8192>
Uses setmib to change the minimum time (delay-interval) any LLDP port will delay advertising successive LLDP
advertisements because of a change in LLDP MIB content.

(Default: 2; Range 1–8192)

The LLDP refresh-interval (transmit interval) must be greater than or equal to (4 x delay-interval).
The switch does not allow increasing the delay interval to a value that conflicts with this relationship.
That is, the switch displays Inconsistent value if (4 x delay-interval) exceeds the current
transmit interval, and the command fails. Depending on the current refresh-interval setting, it may be
necessary to increase the refresh-interval before using this command to increase the delay-interval.

Example:

To change the delay-interval from 2 seconds to 8 seconds when the refresh-interval is at the default 30 seconds,
you must first set the refresh-interval to a minimum of 32 seconds (32 = 4 x 8). (See Figure 35: Changing the
transmit-delay interval on page 178.)

Figure 35: Changing the transmit-delay interval

Reinitialization delay interval
In the default configuration, a port receiving a disable command followed immediately by a txonly, rxonly, or
tx_rx command delays reinitializing for two seconds, during which LLDP operation remains disabled. If an active
port is subjected to frequent toggling between the LLDP disabled and enabled states, LLDP advertisements are
more frequently transmitted to the neighbor device. Also, the neighbor table in the adjacent device changes more
frequently as it deletes, then replaces LLDP data for the affected port which, in turn, generates SNMP traps (if
trap receivers and SNMP notification are configured). All of this can unnecessarily increase network traffic.
Extending the reinitialization-delay interval delays the ability of the port to reinitialize and generate LLDP traffic
following an LLDP disable/enable cycle.

Changing the reinitialization delay interval (CLI)
Syntax:

setmib lldpReinitDelay.0 -i <1-10>
Uses setmib to change the minimum time (reinitialization delay interval) an LLDP port will wait before
reinitializing after receiving an LLDP disable command followed closely by a txonly or tx_rx command. The delay
interval commences with execution of the lldp admin-status port-list disable command.

(Default: 2 seconds; Range 1–10 seconds)
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Example:

The following command changes the reinitialization delay interval to five seconds:

switch(config)# setmib lldpreinitdelay.0 -i 5

Configuring SNMP notification support
You can enable SNMP trap notification of LLDP data changes detected on advertisements received from neighbor
devices, and control the interval between successive notifications of data changes on the same neighbor.

Enabling LLDP data change notification for SNMP trap receivers (CLI)
Syntax:

[no] lldp enable-notification <port-list>
Enables or disables each port in port-list for sending notification to configured SNMP trap receivers if an LLDP
data change is detected in an advertisement received on the port from an LLDP neighbor.

(Default: Disabled)

For information on configuring trap receivers in the switch, see SNMP notifications on page 152.

Example:

This command enables SNMP notification on ports 1 - 5:

switch(config)# lldp enable-notification 1-5

Changing the minimum interval for successive data change notifications for the same
neighbor
If LLDP trap notification is enabled on a port, a rapid succession of changes in LLDP information received in
advertisements from one or more neighbors can generate a high number of traps. To reduce this effect, you can
globally change the interval between successive notifications of neighbor data change.

Syntax:

setmib lldpnotificationinterval.0 -i <1-3600>
Globally changes the interval between successive traps generated by the switch. If multiple traps are generated in
the specified interval, only the first trap is sent. The remaining traps are suppressed. (A network management
application can periodically check the switch MIB to detect any missed change notification traps. See IEEE
P802.1AB or later for more information.)

(Default: 5 seconds)

Example:

The following command limits change notification traps from a particular switch to one per minute.

switch(config)# setmib lldpnotificationinterval.0 -i 60 lldpNotificationInterval.0=60

Configuring per-port transmit and receive modes (CLI)
Syntax:

lldp admin-status <port-list> {<txonly | rxonly | tx_rx | disable>}

Chapter 8 Configuring for Network Management Applications 179

Anexo 04 ITEM 10 (0592646)         SEI 0008478-63.2018.6.02.8000 / pg. 5238



With LLDP enabled on the switch in the default configuration, each port is configured to transmit and receive
LLDP packets. These options enable you to control which ports participate in LLDP traffic and whether the
participating ports allow LLDP traffic in only one direction or in both directions.

txonly Configures the specified ports to transmit LLDP packets, but block inbound LLDP packets from
neighbor devices.

rxonly Configures the specified ports to receive LLDP packets from neighbors, but block outbound packets
to neighbors.

tx_rx Configures the specified ports to both transmit and receive LLDP packets. (This is the default
setting.)

disable Disables LLDP packet transmit and receive on the specified ports.

Basic LLDP per-port advertisement content
In the default LLDP configuration, outbound advertisements from each port on the switch include both mandatory
and optional data.

Mandatory Data
An active LLDP port on the switch always includes the mandatory data in its outbound advertisements. LLDP
collects the mandatory data, and, except for the Remote Management Address, you cannot use LLDP commands
to configure the actual data.

• Chassis Type (TLV subelement)

• Chassis ID (TLV)

• Port Type (TLV subelement)

• Port ID (TLV)

• Remote Management Address (TLV; actual IP address is a subelement that can be a default address or a
configured address)

Configuring a remote management address for outbound LLDP advertisements (CLI)
This is an optional command you can use to include a specific IP address in the outbound LLDP advertisements
for specific ports. For more information, see Basic LLDP per-port advertisement content on page 180.

Syntax:

[no] lldp config <port-list> ipAddrEnable <ip-address>
Replaces the default IP address for the port with an IP address you specify. This can be any IP address
configured in a static VLAN on the switch, even if the port does not belong to the VLAN configured with the
selected IP address.

The no form of the command deletes the specified IP address.

If there are no IP addresses configured as management addresses, the IP address selection method returns to
the default operation.

Default: The port advertises the IP address of the lowest-numbered VLAN (VID) to which it belongs. If there is no
IP address configured on the VLANs to which the port belongs, and if the port is not configured to advertise an IP
address from any other (static) VLAN on the switch, the port advertises an address of 127.0.0.1.)
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This command does not accept either IP addresses acquired through DHCP or Bootp, or IP
addresses that are not configured in a static VLAN on the switch.

Example:

If port 3 belongs to a subnetted VLAN that includes an IP address of 10.10.10.100 and you want port 3 to use this
secondary address in LLDP advertisements, you need to execute the following command:

switch(config)# lldp config 3 ipAddrEnable 10.10.10.100
Syntax:

[no] lldp config <port-list> basicTlvEnable <TLV-Type>

port_descr For outbound LLDP advertisements, this TLV includes an alphanumeric string describing
the port.(Default: Enabled)

system_name For outbound LLDP advertisements, this TLV includes an alphanumeric string showing the
assigned name of the system.(Default: Enabled)

system_descr For outbound LLDP advertisements, this TLV includes an alphanumeric string describing
the full name and version identification for the hardware type, software version, and
networking application of the system.(Default: Enabled)

system_cap For outbound advertisements, this TLV includes a bitmask of supported system capabilities
(device functions). Also includes information on whether the capabilities are enabled.
(Default: Enabled)

Example:

If you want to exclude the system name TLV from the outbound LLDP advertisements for all ports on a switch,
use this command:

switch(config)# no lldp config 1-24 basicTlvEnable system_name
If you later decide to reinstate the system name TLV on ports 1-5, use this command:

switch(config)# lldp config 1-5 basicTlvEnable system_name

Optional Data
You can configure an individual port or group of ports to exclude one or more of the following data types from
outbound LLDP advertisements.

• Port description (TLV)

• System name (TLV)

• System description (TLV)

• System capabilities (TLV)

◦ System capabilities Supported (TLV subelement)

◦ System capabilities Enabled (TLV subelement)

• Port speed and duplex (TLV subelement)
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Optional data types, when enabled, are populated with data internal to the switch; that is, you cannot use LLDP
commands to configure their actual content.

Support for port speed and duplex advertisements
This feature is optional for LLDP operation, but is required for LLDP-MED operation.

Port speed and duplex advertisements are supported on the switches to inform an LLDP endpoint and the switch
port of each other's port speed and duplex configuration and capabilities. Configuration mismatches between a
switch port and an LLDP endpoint can result in excessive collisions and voice quality degradation. LLDP enables
discovery of such mismatches by supporting SNMP access to the switch MIB for comparing the current switch
port and endpoint settings. (Changing a current device configuration to eliminate a mismatch requires intervention
by the system operator.)

An SNMP network management application can be used to compare the port speed and duplex data configured
in the switch and advertised by the LLDP endpoint. You can also use the CLI to display this information. For more
information on using the CLI to display port speed and duplex information, seeViewing the current port speed
and duplex configuration on a switch port on page 196.

Configuring support for port speed and duplex advertisements (CLI)
For more information, see Support for port speed and duplex advertisements on page 182.

Syntax:

[no] lldp config <port-list> dot3TlvEnable macphy_config
Options
macphy_config

MAC Physical Config TLV

poeplus_config
Power Via MDI Config TLV

eee_config
EEE Config TLV

For outbound advertisements, this TLV includes the (local) switch port's current speed and duplex settings, the
range of speed and duplex settings the port supports, and the method required for reconfiguring the speed and
duplex settings on the device (autonegotiation during link initialization, or manual configuration).

Using SNMP to compare local and remote information can help in locating configuration mismatches.

(Default: Enabled)

For LLDP operation, this TLV is optional. For LLDP-MED operation, this TLV is mandatory.

Port VLAN ID TLV support on LLDP
The port-vlan-id option enables advertisement of the port VLAN ID TLV as part of the regularly advertised
TLVs. This allows discovery of a mismatch in the configured native VLAN ID between LLDP peers. The
information is visible using show commands and is logged to the Syslog server.

Configuring the VLAN ID TLV
This TLV advertisement is enabled by default. To enable or disable the TLV, use this command. For more
information, see Port VLAN ID TLV support on LLDP Port VLAN ID TLV support on LLDP on page 182.
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Syntax:

[no] lldp config <port-list> dot1TlvEnable port-vlan-id
Enables the VLAN ID TLV advertisement.

The no form of the command disables the TLV advertisement.

Default: Enabled.

Options
port-vlan-id

Specifies the 802.1 TLV list to advertise.

vlan-name
Specifies that the VLAN name TLV is to be advertised.

Enabling the VLAN ID TLV

HP Switch(config)# lldp config a1 dot1TlvEnable port-vlan-id

Viewing the TLVs advertised
The show commands display the configuration of the TLVs. The command show lldp config lists the TLVs
advertised for each port, as shown in the following examples.

Displaying the TLVs for a port

switch(config)# show lldp config a1

 LLDP Port Configuration Detail

  Port   : A1
  AdminStatus [Tx_Rx] : Tx_Rx
  NotificationEnabled [False] : False
  Med Topology Trap Enabled [False] : False

  TLVS Advertised:
  * port_descr
  * system_name
  * system_descr
  * system_cap

  * capabilities
  * network_policy
  * location_id
  * poe

  * macphy_config

  * port_vlan_id 1

 IpAddress Advertised:
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  :
  :

1The VLAN ID TLV is being advertised.

Local device LLDP information

switch(config)# show lldp config info local-device a1

 LLDP Port Configuration Information Detail

  Port     : A1
  PortType : local
  PortId   : 1
  PortDesc : A1

  Port VLAN ID : 1 1

1The information that LLDP used in its advertisement.

Remote device LLDP information

switch(config)# show lldp info remote-device a1

LLDP Remote Device Information Detail

  Local Port   : A1
  ChassisType  : mac-address
  ChassisId    : 00 16 35 22 ca 40
  PortType     : local
  PortID       : 1
  SysName      : esp-dback
  System Descr : HP J8693A Switch 3500yl-48G, revision XX.13.03, ROM...
  PortDescr    : A1

  System Capabilities Supported : bridge, router
  System Capabilities Enabled   : bridge, router

  Port VLAN ID : 200

  Remote Management Address
     Type    : ipv4
     Address : 192.168.1.1

SNMP support
The LLDP-EXT-DOT1-MIB has the corresponding MIB variables for the Port VLAN ID TLV. The TLV
advertisement can be enabled or disabled using the MIB object lldpXdot1ConfigPortVlanTxEnable in the
lldpXdot1ConfigPortVlanTable.

The port VLAN ID TLV local information can be obtained from the MIB object lldpXdot1LocPortVlanId in the
local information table lldpXdot1LocTable.

The port VLAN ID TLV information about all the connected peer devices can be obtained from the MIB object
lldpXdot1RemPortVlanId in the remote information table lldpXdot1RemTable.
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LLDP-MED (media-endpoint-discovery)
LLDP-MED (ANSI/TIA-1057/D6) extends the LLDP (IEEE 802.1AB) industry standard to support advanced
features on the network edge for Voice Over IP (VoIP) endpoint devices with specialized capabilities and LLDP-
MED standards-based functionality. LLDP-MED in the switches uses the standard LLDP commands described
earlier in this section, with some extensions, and also introduces new commands unique to LLDP-MED operation.
The show commands described elsewhere in this section are applicable to both LLDP and LLDP-MED operation.
LLDP-MED benefits include:

• Plug-and-play provisioning for MED-capable, VoIP endpoint devices

• Simplified, vendor-independent management enabling different IP telephony systems to interoperate on one
network

• Automatic deployment of convergence network policies (voice VLANs, Layer 2/CoS priority, and Layer 3/QoS
priority)

• Configurable endpoint location data to support the Emergency Call Service (ECS) (such as Enhanced 911
service, 999, 112)

• Detailed VoIP endpoint data inventory readable via SNMP from the switch

• Power over Ethernet (PoE) status and troubleshooting support via SNMP

• support for IP telephony network troubleshooting of call quality issues via SNMP

This section describes how to configure and use LLDP-MED features in the switches to support VoIP network
edge devices (media endpoint devices) such as:

• IP phones

• Voice/media gateways

• Media servers

• IP communications controllers

• Other VoIP devices or servers

Figure 36: Example: of LLDP-MED network elements

LLDP-MED endpoint support
LLDP-MED interoperates with directly connected IP telephony (endpoint) clients having these features and
services:
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• Autonegotiate speed and duplex configuration with the switch

• Use the following network policy elements configured on the client port

◦ Voice VLAN ID

◦ 802.1p (Layer 2) QoS

◦ Diffserv codepoint (DSCP) (Layer 3) QoS

• Discover and advertise device location data learned from the switch

• Support ECS (such as E911, 999, and 112)

• Advertise device information for the device data inventory collected by the switch, including:

◦ Hardware revision

◦ Firmware revision

◦ Software revision

◦ Serial number

◦ Manufacturer name

◦ Model name

Asset ID

• Provide information on network connectivity capabilities (For example, a multi-port VoIP phone with Layer 2
switch capability)

• Support the fast-start capability

LLDP-MED is intended for use with VoIP endpoints and is not designed to support links between
network infrastructure devices, such as switch-to-switch or switch-to-router links.

LLDP-MED endpoint device classes
LLDP-MED endpoint devices are, by definition, located at the network edge and communicate using the LLDP-
MED framework. Any LLDP-MED endpoint device belongs to one of the following three classes:

• Class 1 (generic endpoint devices): These devices offer the basic LLDP discovery services, network policy
advertisement (VLAN ID, Layer 2/802.1p priority, and Layer 3/DSCP priority), and PoE management. This
class includes such devices as IP call controllers and communication-related servers.

• Class 2 (media endpoint devices): These devices offer all Class 1 features plus media-streaming capability,
and include such devices as voice/media gateways, conference bridges, and media servers.

• Class 3 (communication devices): These devices are typically IP phones or end-user devices that otherwise
support IP media and offer all Class 1 and Class 2 features, plus location identification and emergency 911
capability, Layer 2 switch support, and device information management.

LLDP-MED operational support
The switches offer two configurable TLVs supporting MED-specific capabilities:

• medTlvEnable (for per-port enabling or disabling of LLDP-MED operation)

• medPortLocation (for configuring per-port location or emergency call data)

186 Aruba 2530 Management and Configuration Guide for ArubaOS-Switch 16.05

Anexo 04 ITEM 10 (0592646)         SEI 0008478-63.2018.6.02.8000 / pg. 5245



LLDP-MED operation also requires the port speed and duplex TLV (dot3TlvEnable), which is enabled
in the default configuration.

Topology change notifications provide one method for monitoring system activity. However, because
SNMP normally employs UDP, which does not guarantee datagram delivery, topology change
notification should not be relied upon as the sole method for monitoring critical endpoint device
connectivity.

LLDP-MED fast start control
Syntax:

lldp fast-start-count <1-10>
An LLDP-MED device connecting to a switch port may use the data contained in the MED TLVs from the switch to
configure itself. However, the lldp refresh-interval setting (default: 30 seconds) for transmitting
advertisements can cause an unacceptable delay in MED device configuration.

To support rapid LLDP-MED device configuration, the lldp fast-start-count command temporarily
overrides the refresh-interval setting for the fast-start-count advertisement interval. This results in the
port initially advertising LLDP-MED at a faster rate for a limited time. Thus, when the switch detects a new LLDP-
MED device on a port, it transmits one LLDP-MED advertisement per second out the port for the duration of the
fast-start-count interval. In most cases, the default setting should provide an adequate fast-start-
count interval.

(Default: 5 seconds)

This global command applies only to ports on which a new LLDP-MED device is detected. It does not
override the refresh-interval setting on ports where non-MED devices are detected.

Advertising device capability, network policy, PoE status and location data
The medTlvEnable option on the switch is enabled in the default configuration and supports the following LLDP-
MED TLVs:

• LLDP-MED capabilities: This TLV enables the switch to determine:

◦ Whether a connected endpoint device supports LLDP-MED

◦ Which specific LLDP-MED TLVs the endpoint supports

◦ The device class (1, 2, or 3) for the connected endpoint

This TLV also enables an LLDP-MED endpoint to discover what LLDP-MED TLVs the switch port currently
supports.

• Network policy operating on the port to which the endpoint is connected (VLAN, Layer 2 QoS, Layer 3 QoS)

• PoE (MED Power-over-Ethernet)

• Physical location data (see Configuring location data for LLDP-MED devices on page 190)

LLDP-MED operation requires the macphy_config TLV subelement (enabled by default) that is
optional for IEEE 802.1AB LLDP operation. For more information, see the dot3TlvEnable
macphy_config command (Configuring support for port speed and duplex advertisements
(CLI) on page 182).
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Network policy advertisements
Network policy advertisements are intended for real-time voice and video applications, and include these TLV
subelements:

• Layer 2 (802.1p) QoS

• Layer 3 DSCP (diffserv code point) QoS

• Voice VLAN ID (VID)

VLAN operating rules
These rules affect advertisements of VLANs in network policy TLVs:

• The VLAN ID TLV subelement applies only to a VLAN configured for voice operation (vlan <vid> voice ).

• If there are multiple voice VLANs configured on a port, LLDP-MED advertises the voice VLAN having the
lowest VID.

• The voice VLAN port membership configured on the switch can be tagged or untagged. However, if the LLDP-
MED endpoint expects a tagged membership when the switch port is configured for untagged, or the reverse,
a configuration mismatch results. (Typically, the endpoint expects the switch port to have a tagged voice VLAN
membership.)

• If a given port does not belong to a voice VLAN, the switch does not advertise the VLAN ID TLV through this
port.

Policy elements
These policy elements may be statically configured on the switch or dynamically imposed during an authenticated
session on the switch using a RADIUS server and 802.1X or MAC authentication. (Web authentication does not
apply to VoIP telephones and other telecommunications devices that are not capable of accessing the switch
through a Web browser.) The QoS and voice VLAN policy elements can be statically configured with the following
CLI commands:

vlan <vid> voice
vlan <vid> {<tagged | untagged> <port-list>}
int <port-list> qos priority <0-7>
vlan <vid> qos dscp <codepoint>

A codepoint must have an 802.1p priority before you can configure it for use in prioritizing packets by
VLAN-ID. If a codepoint you want to use shows No Override in the Priority column of the
DSCP policy table (display with show qos-dscp map, then use qos-dscp map <codepoint>
priority <0-7> to configure a priority before proceeding. For more information on this topic, see
the "Quality of Service (QoS): Managing Bandwidth More Effectively" in the advanced traffic
management guide for your switch.

Enabling or Disabling medTlvEnable
In the default LLDP-MED configuration, the TLVs controlled by medTlvEnable are enabled. For more information,
see Advertising device capability, network policy, PoE status and location data on page 187.

Syntax:

[no] lldp config <port-list> medTlvEnable <medTlv>
Enables or disables advertisement of the following TLVs on the specified ports:
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• Device capability TLV

• Configured network policy TLV

• Configured location data TLV (see Configuring location data for LLDP-MED devices on page 190.)

• Current PoE status TLV

(Default: All of the above TLVs are enabled.)

Helps to locate configuration mismatches by allowing use of an SNMP application to compare the LLDP-MED
configuration on a port with the LLDP-MED TLVs advertised by a neighbor connected to that port.

capabilities This TLV enables the switch to determine:

• Which LLDP-MED TLVs a connected endpoint can discover

• The device class (1, 2, or 3) for the connected endpoint

This TLV also enables an LLDP-MED endpoint to discover what LLDP-MED TLVs
the switch port currently supports.(Default: enabled)

This TLV cannot be disabled unless the network_policy, poe, and location_id
TLVs are already disabled.

network_policy This TLV enables the switch port to advertise its configured network policies (voice
VLAN, Layer 2 QoS, Layer 3 QoS), and allows LLDP-MED endpoint devices to
autoconfigure the voice network policy advertised by the switch. This also enables
the use of SNMP applications to troubleshoot statically configured endpoint network
policy mismatches.(Default: Enabled)

Network policy is advertised only for ports that are configured as members of the
voice VLAN. If the port belongs to more than one voice VLAN, the voice VLAN with
the lowest-numbered VID is selected as the VLAN for voice traffic. Also, this TLV
cannot be enabled unless the capability TLV is already enabled.

For more information, see Network policy advertisements on page 188.

location_id This TLV enables the switch port to advertise its configured location data (if any). For
more information on configuring location data, see Configuring location data for
LLDP-MED devices on page 190.(Default: Enabled)

When disabled, this TLV cannot be enabled unless the capability TLV is already
enabled.

poe This TLV enables the switch port to advertise its current PoE state and to read the
PoE requirements advertised by the LLDP-MED endpoint device connected to the
port.(Default: Enabled)

When disabled, this TLV cannot be enabled unless the capability TLV is already
enabled.

For more on this topic, see PoE advertisements on page 189.

PoE advertisements
These advertisements inform an LLDP-MED endpoint of the power (PoE) configuration on switch ports. Similar
advertisements from an LLDP-MED endpoint inform the switch of the endpoint's power needs and provide
information that can be used to identify power priority mismatches.

Chapter 8 Configuring for Network Management Applications 189

Anexo 04 ITEM 10 (0592646)         SEI 0008478-63.2018.6.02.8000 / pg. 5248



PoE TLVs include the following power data:

• Power type: indicates whether the device is a power-sourcing entity (PSE) or a PD. Ports on the J8702A PoE
zl module are PSE devices. A MED-capable VoIP telephone is a PD.

• Power source: indicates the source of power in use by the device. Power sources for PDs include PSE, local
(internal), and PSE/local. The switches advertise Unknown.

• Power priority: indicates the power priority configured on the switch (PSE) port or the power priority
configured on the MED-capable endpoint.

• Power value: indicates the total power in watts that a switch port (PSE) can deliver at a particular time, or the
total power in watts that the MED endpoint (PD) requires to operate.

Viewing PoE advertisements
To display the current power data for an LLDP-MED device connected to a port, use the following command:

show lldp info remote-device <port-list>
For more information on this command, see page A-60.

To display the current PoE configuration on the switch, use the following commands:

show power brief <port-list>
show power <port-list>
For more information on PoE configuration and operation, see Power Over Ethernet (PoE/PoE+) Operation.

Location data for LLDP-MED devices
You can configure a switch port to advertise location data for the switch itself, the physical wall-jack location of the
endpoint (recommended), or the location of a DHCP server supporting the switch, endpoint, or both. You also
have the option of configuring these different address types:

• Civic address: physical address data such as city, street number, and building information

• ELIN (Emergency Location Identification Number): an emergency number typically assigned to MLTS
(Multiline Telephone System) Operators in North America

• Coordinate-based location: attitude, longitude, and altitude information (Requires configuration via an SNMP
application.)

Configuring location data for LLDP-MED devices
Syntax:

[no] lldp config <port-list> medPortLocation <Address-Type>
Configures location of emergency call data the switch advertises per port in the location_id TLV. This TLV is
for use by LLDP-MED endpoints employing location-based applications.

The switch allows one medPortLocation entry per port (without regard to type). Configuring a new
medPortLocation entry of any type on a port replaces any previously configured entry on that port.

civic-addr <COUNTRY-STR> <WHAT> <CA-TYPE> <CA-VALUE> … [< CA-TYPE > < CA-VALUE >] … [< CA-TYPE > < CA-VALUE >]

Enables configuration of a physical address on a switch port and allows up to 75 characters of address
information.
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COUNTRY-STR A two-character country code, as defined by ISO 3166. Some examples include FR
(France), DE (Germany), and IN (India). This field is required in a civic-addr
command. (For a complete list of country codes, visit http://www.iso.org.)

WHAT A single-digit number specifying the type of device to which the location data
applies:

0: Location of DHCP server

1: Location of switch

2: Location of LLDP-MED endpoint (recommended application)

This field is required in a civic-addr command.

Table Continued
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Type/Value Pairs
(CA-TYPE and CA-
VALUE)

A series of data pairs, each composed of a location data "type" specifier and the
corresponding location data for that type. That is, the first value in a pair is expected
to be the civic address "type" number ( CA-TYPE), and the second value in a pair is
expected to be the corresponding civic address data ( CA-VALUE).

For example, if the CA-TYPE for "city name" is "3," the type/value pair to define the
city of Paris is "3 Paris."

Multiple type/value pairs can be entered in any order, although Hewlett Packard
Enterprise recommends that multiple pairs be entered in ascending order of the CA-
TYPE.

When an emergency call is placed from a properly configured class 3 endpoint
device to an appropriate PSAP, the country code, device type, and type/value pairs
configured on the switch port are included in the transmission. The "type" specifiers
are used by the PSAP to identify and organize the location data components in an
understandable format for response personnel to interpret.

A civic-addr command requires a minimum of one type/value pair, but typically
includes multiple type/value pairs as needed to configure a complete set of data
describing a given location.

CA-TYPE: This is the first entry in a type/value pair and is a number defining the
type of data contained in the second entry in the type/value pair ( CA-VALUE).
Some examples of CA-TYPE specifiers include:

• 3=city

• 6=street (name)

• 25=building name

(Range: 0 - 255)For a sample listing of CA-TYPE specifiers, see Some location
codes used in CA-TYPE fields.

CA-VALUE:This is the second entry in a type/value pair and is an alphanumeric
string containing the location information corresponding to the immediately
preceding CA-TYPE entry.

Strings are delimited by either blank spaces, single quotes (' … '), or double quotes
("… ").

Each string should represent a specific data type in a set of unique type/value pairs
comprising the description of a location, and each string must be preceded by a CA-
TYPE number identifying the type of data in the string.

A switch port allows one instance of any given CA-TYPE. For example, if a type/
value pair of 6 Atlantic (to specify "Atlantic" as a street name) is configured on port
A5 and later another type/value pair of 6 Pacific is configured on the same port,
Pacific replaces Atlantic in the civic address location configured for port A5.

elin-addr
<emergency-number>

This feature is intended for use in ECS applications to support class 3 LLDP-MED
VoIP telephones connected to a switch in an MLTS infrastructure.

An ELIN is a valid NANP format telephone number assigned to MLTS operators in
North America by the appropriate authority. The ELIN is used to route emergency
(E911) calls to a PSAP.

(Range: 1-15 numeric characters)
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Configuring coordinate-based locations
Latitude, longitude, and altitude data can be configured per switch port using an SNMP management application.
For more information, see the documentation provided with the application. A further source of information on this
topic is RFC 3825-Dynamic host configuration protocol option for coordinate-based location configuration
information.

Endpoint use of data from a medPortLocation TLV sent by the switch is device-dependent. See the
documentation provided with the endpoint device.

Table 21: Some location codes used in CA-TYPE fields

Location element Code1 Location element Code

national subdivision 1 street number 19

regional subdivision 2 additional location data 22

city or township 3 unit or apartment 26

city subdivision 4 floor 27

street 6 room number 28

street suffix 18

1 The code assignments in this table are examples from a work-in-progress (the internet draft titled "Dynamic Host Configuration
Protocol (DHCPv4 and DHCPv6) Option for Civic Addresses Configuration Information draft-ietf-geopriv-dhcp-civil-06" dated
May 30, 2005.) For the actual codes to use, contact the PSAP or other authority responsible for specifying the civic addressing
data standard for your network.

Example:

Suppose a system operator wants to configure the following information as the civic address for a telephone
connected to her company's network through port A2 of a switch at the following location:

CA-type CA-type CA-VALUE

national subdivision 1 CA

city 3 Widgitville

street 6 Main

street number 19 1433

unit 26 Suite 4-N

floor 27 4

room number 28 N4-3

The following example shows the commands for configuring and displaying the above data.
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A civic address configuration

switch(config)# lldp config 2 medportlocation civic-addr US 2 1 CA 3
Widgitville 6 Main 19 1433 26 Suite_4—N 27 4 28 N4—3

switch(config)# show lldp config 2
 LLDP Port Configuration Detail
  Port : A2
  AdminStatus [Tx_Rx] : Tx_Rx
  NotificationEnabled [False] : False
  Med Topology Trap Enabled [False] : False
  Country Name          : US 
  What                  : 2
  Ca-Type               : 1
  Ca-Length             : 2
  Ca-Value              : CA 
  Ca-Type               : 3
  Ca-Length             : 11
  Ca-Value              : Widgitville
  Ca-Type               : 6
  Ca-Length             : 4
  Ca-Value              : Main
  Ca-Type               : 19
  Ca-Length             : 4
  Ca-Value              : 1433
  Ca-Type               : 26
  Ca-Length             : 9
  Ca-Value              : Suite_4-N 
  Ca-Type               : 27
  Ca-Length             : 1
  Ca-Value              : 4
  Ca-Type               : 28
  Ca-Length             : 4
  Ca-Value              : N4-3

Viewing switch information available for outbound advertisements
Syntax:

show lldp info local-device [port-list]
Without the [port-list] option, displays the global switch information and the per-port information currently
available for populating outbound LLDP advertisements.

With the [port-list] option, displays only the following port-specific information that is currently available for
outbound LLDP advertisements on the specified ports:

• PortType
• PortId
• PortDesc

This command displays the information available on the switch. Use the lldp config <port-
list> command to change the selection of information that is included in actual outbound
advertisements. In the default LLDP configuration, all information displayed by this command is
transmitted in outbound advertisements.
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In the default configuration, the switch information currently available for outbound LLDP advertisements appears
similar to the display in the following example.

Displaying the global and per-port information available for outbound advertisements

switch(config)# show lldp info local-device

 LLDP Local Device Information

  Chassis Type : mac-address
  Chassis Id : 00 23 47 4b 68 DD
  System Name : HP Switch1
  System Description : HP J9091A Switch 3500yl, revision XX.15.06...
  System Capabilities Supported:bridge
  System Capabilities Enabled:bridge

  Management Address 1
     Type:ipv4
     Address:

  LLDP Port Information

   Port  | PortType  PortId  PortDesc
   ----- + --------- ------- ---------
   1     | local     1       1
   2     | local     2       2
   3     | local     3       3
   4     | local     4       4
   5     | local     5       5

1

The Management Address field displays only the LLDP-configurable IP addresses on the switch. (Only manually-
configured IP addresses are LLDP-configurable.) If the switch has only an IP address from a DHCP or Bootp
server, then the Management Address field is empty (because there are no LLDP-configurable IP addresses
available.

The default per-port information content for ports 1 and 2

switch(config)# show lldp info local 1-2

  LLDP Local Port Information Detail

   Port     : 1
   PortType : local
   PortId   : 1
   PortDesc : 1

---------------------------------------- 
   Port     : 2
   PortType : local
   PortId   : 2
   PortDesc : 2

Displaying the current port speed and duplex configuration on a switch port
You can compare port speed and duplex information for a switch port and a connected LLDP-MED endpoint for
configuration mismatches by using an SNMP application. You can also use the switch CLI to display this
information, if necessary. The show interfaces brief <port-list> and show lldp info remote-
device [port-list] commands provide methods for displaying speed and duplex information for switch
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ports. For information on displaying the currently configured port speed and duplex on an LLDP-MED endpoint,
see Viewing the current port speed and duplex configuration on a switch port on page 196.

Viewing the current port speed and duplex configuration on a switch port
Syntax:

show interfaces brief <port-list>
Includes port speed and duplex configuration in the Mode column of the resulting display.

Viewing advertisements currently in the neighbors MIB
Syntax:

show lldp info remote-device [port-list]
Without the [port-list] option, provides a global list of the individual devices it has detected by reading LLDP
advertisements. Discovered devices are listed by the inbound port on which they were discovered.

Multiple devices listed for a single port indicates that such devices are connected to the switch through a hub.

Discovering the same device on multiple ports indicates that the remote device may be connected to the
switch in one of the following ways:

• Through different VLANS using separate links. (This applies to switches that use the same MAC address for
all configured VLANs.)

• Through different links in the same trunk.

• Through different links using the same VLAN. (In this case, spanning-tree should be invoked to prevent a
network topology loop. Note that LLDP packets travel on links that spanning-tree blocks for other traffic types.)

With the [port-list] option, provides a listing of the LLDP data that the switch has detected in advertisements
received on the specified ports.

For descriptions of the various types of information displayed by these commands, see Data available for basic
LLDP advertisements.

A global listing of discovered devices

switch(config)# show lldp info remote

 LLDP Remote Devices Information

  LocalPort | ChassisId                 PortId PortDescr SysName
  --------- + ------------------------- ------ --------- -------------
  1         | 00 11 85 35 3b 80         6      6         HP Switch
  2         | 00 11 85 cf 66 60         8      8         HP Switch

An LLLDP-MED listing of an advertisement received from an LLDP-MED (VoIP telephone) source

switch(config)# show lldp info remote-device 1

 LLDP Remote Device Information Detail

  Local Port   : A2
  ChassisType  : network-address
  ChassisId    : 0f ff 7a 5c
  PortType     : mac-address
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  PortId       : 08 00 0f 14 de f2
  SysName      : HP Switch
  System Descr : HP Switch, revision xx.15.06.0000x
  PortDescr    : LAN Port

  System Capabilities Supported : bridge, telephone
  System Capabilities Enabled   : bridge, telephone

  Remote Management Address

  MED Information Detail 1
    EndpointClass          :Class3
    Media Policy Vlan id   :10
    Media Policy Priority  :7
    Media Policy Dscp      :44
    Media Policy Tagged    :False
    Poe Device Type        :PD
    Power Requested        :47
    Power Source           :Unknown
    Power Priority         :High

1Indicates the policy configured on the telephone. A configuration mismatch occurs if the supporting port is
configured differently.

Displaying LLDP statistics
LLDP statistics are available on both a global and a per-port levels. Rebooting the switch resets the LLDP
statistics counters to zero. Disabling the transmit and/or receive capability on a port "freezes" the related port
counters at their current values.

Viewing LLDP statistics
For more information, see Displaying LLDP statistics on page 197.

Syntax:

show lldp stats [port-list]
The global LLDP statistics command displays an overview of neighbor detection activity on the switch, plus data
on the number of frames sent, received, and discarded per-port.

The per-port LLDP statistics command enhances the list of per-port statistics provided by the global statistics
command with some additional per-port LLDP statistics.

Global LLDP Counters:

Neighbor Entries List Last
Updated

The elapsed time since a neighbor was last added or deleted.

New Neighbor Entries Count The total of new LLDP neighbors detected since the last switch reboot.
Disconnecting, and then reconnecting a neighbor increments this
counter.

Table Continued
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Neighbor Entries Deleted
Count

The number of neighbor deletions from the MIB for AgeOut Count and
forced drops for all ports.For example, if the admin status for port on a
neighbor device changes from tx_rx or txonly to disabled or
rxonly, the neighbor device sends a "shutdown" packet out the port
and ceases transmitting LLDP frames out that port.The device receiving
the shutdown packet deletes all information about the neighbor received
on the applicable inbound port and increments the counter.

Neighbor Entries Dropped
Count

The number of valid LLDP neighbors the switch detected, but could not
add.This can occur, For example, when a new neighbor is detected when
the switch is already supporting the maximum number of neighbors. See 
Neighbor maximum on page 199.

Neighbor Entries AgeOut
Count

The number of LLDP neighbors dropped on all ports because of Time-to-
Live expiring.

Per-Port LLDP Counters:

NumFramesRecvd The total number of valid, inbound LLDP advertisements received from
any neighbors on port-list .Where multiple neighbors are connected
to a port through a hub, this value is the total number of LLDP
advertisements received from all sources.

NumFramesSent The total number of LLDP advertisements sent from port-list.

NumFramesDiscarded The total number of inbound LLDP advertisements discarded by port-
list.This can occur, For example, when a new neighbor is detected on the
port, but the switch is already supporting the maximum number of
neighbors. See Neighbor maximum on page 199. This can also be an
indication of advertisement formatting problems in the neighbor device.

Frames Invalid The total number of invalid LLDP advertisements received on the port.An
invalid advertisement can be caused by header formatting problems in
the neighbor device.

TLVs Unrecognized The total number of LLDP TLVs received on a port with a type value in
the reserved range.This can be caused by a basic management TLV
from a later LLDP version than the one currently running on the switch.

TLVs Discarded The total number of LLDP TLVs discarded for any reason. In this case,
the advertisement carrying the TLV may be accepted, but the individual
TLV is not usable.

Neighbor Ageouts The number of LLDP neighbors dropped on the port because of Time-to-
Live expiring.

Examples:

A global LLDP statistics display

switch(config)# show lldp stats

 LLDP Device Statistics

  Neighbor Entries List Last Updated : 2 hours
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  New Neighbor Entries Count : 20
  Neighbor Entries Deleted Count : 20
  Neighbor Entries Dropped Count : 0
  Neighbor Entries AgeOut Count : 20

 LLDP Port Statistics
 
  Port   | NumFramesRecvd NumFramesSent NumFramesDiscarded
  ------ + -------------- ------------- ------------------ 
  A1     | 97317          97843         0
  A2     | 21             12            0
  A3     | 0              0             0
  A4     | 446            252           0
  A5     | 0              0             0
  A6     | 0              0             0
  A7     | 0              0             0
  A8     | 0              0             0

A per-port LLDP statistics display

switch(config)# show lldp stats 1

 LLDP Port Statistics Detail

  PortName : 1
  Frames Discarded  : 0
  Frames Invalid    : 0
  Frames Received   : 7309
  Frames Sent       : 7231
  TLVs Unrecognized : 0
  TLVs Discarded    : 0
  Neighbor Ageouts  : 0

LLDP Operating Notes

Neighbor maximum
The neighbors table in the switch supports as many neighbors as there are ports on the switch. The switch can
support multiple neighbors connected through a hub on a given port, but if the switch neighbor maximum is
reached, advertisements from additional neighbors on the same or other ports will not be stored in the neighbors
table unless some existing neighbors time-out or are removed.

LLDP packet forwarding
An 802.1D-compliant switch does not forward LLDP packets, regardless of whether LLDP is globally enabled or
disabled on the switch.

One IP address advertisement per port
LLDP advertises only one IP address per port, even if multiple IP addresses are configured by lldp config
port-list ipAddrEnable on a given port.

802.1Q VLAN Information
LLDP packets do not include 802.1Q header information and are always handled as untagged packets.

Effect of 802.1X Operation
If 802.1X port security is enabled on a port, and a connected device is not authorized, LLDP packets are not
transmitted or received on that port. Any neighbor data stored in the neighbor MIB for that port prior to the
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unauthorized device connection remains in the MIB until it ages out. If an unauthorized device later becomes
authorized, LLDP transmit and receive operation resumes.

Neighbor data can remain in the neighbor database after the neighbor is disconnected
After disconnecting a neighbor LLDP device from the switch, the neighbor can continue to appear in the switch's
neighbor database for an extended period if the neighbor's holdtime-multiplier is high; especially if the
refresh-interval is large. See Changing the time-to-live for transmitted advertisements (CLI) on page
177.

Mandatory TLVs
All mandatory TLVs required for LLDP operation are also mandatory for LLDP-MED operation.

LLDP and CDP data management
This section describes points to note regarding LLDP and CDP (Cisco Discovery Protocol) data received by the
switch from other devices. LLDP operation includes both transmitting LLDP packets to neighbor devices and
reading LLDP packets received from neighbor devices. CDP operation is limited to reading incoming CDP
packets from neighbor devices. (HPE switches do not generate CDP packets.)

Incoming CDP and LLDP packets tagged for VLAN 1 are processed even if VLAN 1 does not contain any ports.
VLAN 1 must be present, but it is typically present as the default VLAN for the switch.

The switch may pick up CDP and LLDP multicast packets from VLAN 1 even when CDP- and /or
LLDP-enabled ports are not members of VLAN 1.

LLDP and CDP neighbor data
With both LLDP and (read-only) CDP enabled on a switch port, the port can read both LLDP and CDP
advertisements, and stores the data from both types of advertisements in its neighbor database. (The switch
stores only CDP data that has a corresponding field in the LLDP neighbor database.) The neighbor database
itself can be read by either LLDP or CDP methods or by using the show lldp commands. Take note of the
following rules and conditions:

• If the switch receives both LLDP and CDP advertisements on the same port from the same neighbor, the
switch stores this information as two separate entries if the advertisements have different chassis ID and port
ID information.

• If the chassis and port ID information are the same, the switch stores this information as a single entry. That is,
LLDP data overwrites the corresponding CDP data in the neighbor database if the chassis and port ID
information in the LLDP and CDP advertisements received from the same device is the same.

• Data read from a CDP packet does not support some LLDP fields, such as "System Descr,"
"SystemCapSupported," and "ChassisType." For such fields, LLDP assigns relevant default values. Also:

◦ The LLDP "System Descr" field maps to CDP's "Version" and "Platform" fields.

◦ The switch assigns "ChassisType" and "PortType" fields as "local" for both the LLDP and the CDP
advertisements it receives.

◦ Both LLDP and CDP support the "System Capability" TLV. However, LLDP differentiates between what a
device is capable of supporting and what it is actually supporting, and separates the two types of
information into subelements of the System Capability TLV. CDP has only a single field for this data. Thus,
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when CDP System Capability data is mapped to LLDP, the same value appears in both LLDP System
Capability fields.

◦ System Name and Port Descr are not communicated by CDP, and thus are not included in the switch's
Neighbors database.

Because HPE switches do not generate CDP packets, they are not represented in the CDP data
collected by any neighbor devices running CDP.

A switch with CDP disabled forwards the CDP packets it receives from other devices, but does not
store the CDP information from these packets in its own MIB.

LLDP data transmission/collection and CDP data collection are both enabled in the switch's default configuration.
In this state, an SNMP network management application designed to discover devices running either CDP or
LLDP can retrieve neighbor information from the switch regardless of whether LLDP or CDP is used to collect the
device-specific information.

Protocol state Packet generation Inbound data
management

Inbound packet
forwarding

CDP Enabled N/A Store inbound CDP data. No forwarding of inbound
CDP packets.

CDP Disabled N/A No storage of CDP data
from neighbor devices.

Floods inbound CDP
packets from connected
devices to outbound ports.

LLDP Enabled1 Generates and
transmits LLDP
packets out all ports
on the switch.

Store inbound LLDP data. No forwarding of inbound
LLDP packets.

LLDP Disabled No packet
generation.

No storage of LLDP data
from neighbor devices.

No forwarding of inbound
LLDP packets.

CDP operation and commands
By default the switches have CDP enabled on each port. This is a read-only capability, meaning that the switch
can receive and store information about adjacent CDP devices but does not generate CDP packets.

When a CDP-enabled switch receives a CDP packet from another CDP device, it enters that device's data in the
CDP Neighbors table, along with the port number where the data was received—and does not forward the packet.
The switch also periodically purges the table of any entries that have expired. (The hold time for any data entry in
the switch's CDP Neighbors table is configured in the device transmitting the CDP packet and cannot be
controlled in the switch receiving the packet.) A switch reviews the list of CDP neighbor entries every three
seconds and purges any expired entries.

For details on how to use an SNMP utility to retrieve information from the switch's CDP Neighbors
table maintained in the switch's MIB, see the documentation provided with the particular SNMP utility.

Viewing the current CDP configuration of the switch
CDP is shown as enabled/disabled both globally on the switch and on a per-port basis.
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Syntax:

show cdp
Lists the global and per-port CDP configuration of the switch.

The following example shows the default CDP configuration.

Default CDP configuration

switch(config)# show cdp

 Global CDP information

  Enable CDP [Yes] : Yes (Receive Only)

  Port CDP
  ---- --------
  1    enabled
  2    enabled
  3    enabled
  .      .
  .      .
  .      .

Viewing the current CDP neighbors table of the switch
Devices are listed by the port on which they were detected.

Syntax:

show cdp neighbors
Lists the neighboring CDP devices the switch detects, with a subset of the information collected from the device's
CDP packet.

[[e] port-numb [detail]]
Lists the CDP device connected to the specified port. (Allows
only one port at a time.)Using detail provides a longer list of
details on the CDP device the switch detects on the specified
port.

[detail [[e] port-numb]]
Provides a list of the details for all of the CDP devices the
switch detects.Using port-num produces a list of details for
the selected port.

The following example displays the CDP devices that the switch has detected by receiving their CDP packets.

CDP neighbors table listing

switch(config)# show cdp neighbors

 CDP neighbors information

  Port Device ID                     | Platform                     Capability
  ---- ----------------------------- + ---------------------------- -----------
  1    Accounting (0030c1-7fcc40)    | J4812A HP Switch. . .        S
  2    Resear¢1-1 (0060b0-889e43)    | J4121A HP Switch. . .        S
  4    Support (0060b0_761a45)       | J4121A HP Switch. . .        S
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  7    Marketing (0030c5_33dc59)     | J4313A HP Switch. . .        S
  12   Mgmt NIC(099a05-09df9b        | NIC Model X666               H
  12   Mgmt NIC(099a05-09df11        | NIC Model X666               H

Enabling and Disabling CDP Operation
Enabling CDP operation (the default) on the switch causes the switch to add entries to its CDP Neighbors table
for any CDP packets it receives from other neighboring CDP devices.

Disabling CDP operation clears the switch's CDP Neighbors table and causes the switch to drop inbound CDP
packets from other devices without entering the data in the CDP Neighbors table.

Syntax:

[no] cdp run
Enables or disables CDP read-only operation on the switch.

(Default: Enabled)

Example:

To disable CDP read-only on the switch:

switch(config)# no cdp run
When CDP is disabled:

• show cdp neighbors
displays an empty CDP Neighbors table

• show cdp
displaysGlobal CDP informationEnable CDP [Yes]: No

Enabling or disabling CDP operation on individual ports
In the factory-default configuration, the switch has all ports enabled to receive CDP packets. Disabling CDP on a
port causes it to drop inbound CDP packets without recording their data in the CDP Neighbors table.

Syntax:

[no] cdp enable {< [e] port-list >}
Example:

To disable CDP on port A1:

switch(config)# no cdp enable a1

Filtering CDP information
In some environments it is desirable to be able to configure a switch to handle CDP packets by filtering out the
MAC address learns from untagged VLAN traffic from IP phones. This means that normal protocol processing
occurs for the packets, but the addresses associated with these packets is not learned or reported by the software
address management components. This enhancement also filters out the MAC address learns from LLDP and
802.1x EAPOL packets on untagged VLANs.

The feature is configured per-port.
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Configuring the switch to filter untagged traffic
Enter this command to configure the switch not to learn CDP, LLDP, or EAPOL traffic for a set of interfaces.

Syntax:

[no] ignore-untagged-mac <port-list>
Prevents MAC addresses from being learned on the specified ports when the VLAN is untagged and the
destination MAC address is one of the following:

• 01000C-CCCCCC (CDP)

• 0180c2- 00000e (LLDP)

• 0180c2-000003 (EAPOL)

Configuring the switch to ignore packet MAC address learns for an untagged VLAN

switch(config) ignore-untagged-mac 1-2

Displaying the configuration
Enter the show running-config command to display information about the configuration.

Configuration showing interfaces to ignore packet MAC address learns

switch(config) show running-config

Running configuration:

; J9627 Configuration Editor; Created on release XX.15.XX
; Ver #03:03.1f.ef:f0

hostname “HP Switch”
interface 1
   ignore-untagged-mac
   exit
interface 2
   ignore-untagged-mac
   exit
.
.
.
vlan 1
   name “DEFAULT_VLAN”
   untagged 1-24
   ip address dhcp-bootp
   exit
.
.
.

Filtering PVID mismatch log messages
This enhancement filters out PVID mismatch log messages on a per-port basis. PVID mismatches are logged
when there is a difference in the PVID advertised by a neighboring switch and the PVID of the switch port which
receives the LLDP advertisement. Logging is an LLDP feature that allows detection of possible vlan leakage
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between adjacent switches. However, if these events are logged too frequently, they can overwhelm the log buffer
and push relevant logging data out of log memory, making it difficult to troubleshoot another issue.

Logging is disabled and enabled with the support of CLI commands.

This enhancement also includes displaying the Mac-Address in the PVID mismatch log message when the port ID
is Mac-Address instead of displaying garbage characters in the peer device port ID field.

Use the following command to disable the logging of the PVID mismatch log messages:

Syntax:

logging filter [filter-name][sub filter id] <regularexpression> deny
Regular-expression

The regular expression should match the message which is to be filtered.

Syntax:

logging filter [filter-name] enable

Generic header ID in configuration file

Introduction
Auto deployment relies on DHCP options and the current DHCP auto-configuration function. Auto deployment is
platform independent, avoiding the J-number validation of the downloaded configuration file when downloaded
using DHCP option 66/67. The downloaded configuration file has an IGNORE tag immediately after the J-number
in its header.

An option to add an add-ignore-tag to an existing copy command will insert an ignore tag into the
configuration header. This insertion happens while transferring the configurations, (startup configuration
filesand running configuration files) from the switch to a configuration file setup on a remote server.
The process uses TFTP/SFTP or can be accomplished with a serially connected workstation using XMODEM.

Add-Ignore-Tag option
The add-ignore-tag option is used in conjunction with the copy command to transfer the startup
configuration or running configuration files from the switch to a remote server with IGNORE tag
inserted into it.

The IGNORE tag is inserted into the first line of the configuration file directly after the J-number.

Configuration file

; J9782A IGNORE Configuration Editor; Created on release #YB.15.14.0000x
; Ver #04:63.ff.37.27:88
hostname "HP-2530-24"
snmp-server community "public" unrestricted
vlan 1
name "DEFAULT_VLAN"
no untagged 2,20-25
untagged 1,3-19,26-28
ip address dhcp-bootp
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The J-number validation is ignored only when configuration file that contains the IGNORE tag is
downloaded to a switch via DHCP option 66/67. When a configuration file containing the
IGNORE tag is downloaded to a switch using CLI, SNMP or WebUI, the downloaded
configuration file is only accepted if the J-number in it matches the J-number on the switch.

There is no change to the current switch configuration when executing the copy command with the add-ignore-
tag option. The IGNORE tag is only added to the configuration file being exported to the external server. The
configuration file stored on an external server is then downloaded to the switch using DHCP option 66 during
bootup. If the IGNORE tag is available in the downloaded configuration file then the switch will avoid the J-
number validation of the configuration file. The downloaded configuration file will then go through a line
by line validation. Once the configuration file passes this validation, it gets updated in the flash. Once the
configuration file has been updated, the switch will reboot automatically.

The J-number in the downloaded configuration file is replaced with that of the switch. The
IGNORE tag is removed from the downloaded configuration file before updating it to flash. The
show running-configuration command will not display the IGNORE tag but displays the
switch’s J-number as part of the output.

Copy with add-ignore-tag

switch(config)# copy startup-config tftp <ip-addr> <filename> add-ignore-tag
switch(config)# copy running-config tftp <ip-addr> <filename> add-ignore-tag
switch(config)# copy startup-config sftp <ip-addr> <filename> add-ignore-tag
switch(config)# copy running-config sftp <ip-addr> <filename> add-ignore-tag
switch(config)# copy startup-config xmodem add-ignore-tag
switch(config)# copy running-config xmodem add-ignore-tag

Configuration commands for the add-ignore-tag option
Configuration files can be transferred to the switch from a server using the following copy commands:

• copy tftp
• copy xmodem
• copy sftp

Copy commands

copy tftp < startup-config | running-config > < ip-address > < remote-file >[ pc | unix ]
copy xmodem startup-config < pc | unix >
copy sftp < startup-config | running-config > < ip-address > < remote-file >
Configuration files that are downloaded using the copy commands as described in the example will be
accepted by the switch if they pass J-number validations and line by line validations after download. The
downloaded configuration file will be discarded by the switch if the validations fail. If the validations fail, the switch
will work with it’s previous configuration.

Show logging commands for the add-ignore-tag option
The show logging command is used to locate errors during a configuration validation process. The event log
catalogs entries with the ID#00158 and updates for each invalid entry found in the configuration file.
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Show logging

-- Reverse event Log listing: Events Since Boot ----
W 01/07/14 00:29:31 00158 update: line 13. Module command missing for port or invalid port: 36
I 01/07/14 00:29:30 00131 tftp: Transfer completed
I 01/07/14 00:29:29 00090 dhcp: Trying to download Config File (using TFTP) received in DHCP from 192.168.1.1

Downloading manually edited configuration file is not encouraged.

Exclusions
The IGNORE tag is not an available option when using external SCP, SFTP or TFTP clients such as PuTTY, Open
SSH, WinSCP and SSH Secure Shell to transfer configuration files out of the switch.
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The Captive Portal feature allows the support of the ClearPass Policy Manager (CPPM) into the ArubaOS-Switch
product line. The switch provides configuration to allow you to enable or disable the Captive Portal feature. By
default, Captive Portal is disabled to avoid impacting existing installations as this feature is mutually exclusive with
the following web-based authentication mechanisms: Web Authentication, EWA, MAFR, and BYOD Redirect.

Captive Portal is user-based, rather than port or VLAN-based, therefore the configuration is on a switch global
basis. ArubaOS-Switch supports the following authentication types on the switch with RADIUS for Captive Portal:

• Media Access Control (MAC)

• 802.1X

Once you enable Captive Portal, the redirect functionality is triggered only if a redirect URL attribute is provided
as part of the RADIUS Access-Accept response from an authentication request of type 802.1X or MAC. The
redirect enables the client to self-register or directly login with valid credentials via the CPPM. Upon subsequent
re-authentication, it provides access to the network per the CPPM configured policies that are communicated via
the RADIUS attributes.

The redirect feature offers:

• Client self-registration

• Client direct login with valid credentials via CPPM Captive Portal

• On-boarding

• Ability to quarantine devices to remedy their status

Requirements
• HTTPS support requires a certificate to be configured on the switch with a usage type of all or captive-

portal.

• If you are running HPE 5400 Series v2 modules, you must turn off the compatibility mode with the following
command:

switch(config)# no allow-v1-modules
This will ensure that the switch will only power up with the v2 modules.

Chapter 9
Captive Portal for ClearPass
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Best Practices
• Use the Port Bounce VSA via a CoA message, instead of the Disconnect message, to cause the second

RADIUS authentication to occur during the Captive Portal exchange. This is the more reliable method for
forcing a re-DHCP for the client.

• Configure Captive Portal such that the first ACCESS_ACCEPT returns a rate limit VSA to reduce the risk of DoS
attacks. This configuration enables rate limiting for the HTTP/HTTPS ACL for traffic sent to CPPM. 

• Do not use the keyword cpy in any other NAS-Filter-Rules. The keyword cpy in the enforcement profile
attributes is specific to CPPM use. It is only supported with the deny attribute. If you configure the cpy
keyword to permit, no ACL will be applied.

Limitations
• Captive Portal will not work with RADIUS configured on a loopback port or on the Out-of-Band Management

(OOBM) port.

• Captive Portal is supported in CPPM versions 6.5.5 and later. However, by manually modifying the RADIUS
dictionary files, any CPPM version 6.5.* can be used.

• Captive Portal does not support v1 modules, and will not work unless compatibility mode is turned off.

• Captive Portal does not support IPv6.

• Simultaneous Captive Portal client connections: maximum of 512

• Captive Portal does not support web proxy. The permit CPPM ACLs and the steal ACLs only use port 80 and
443. Non-standard ports for HTTP and HTTPS are not supported.

• Captive Portal is mutually exclusive with the following web-based authentication mechanisms: Web
Authentication, EWA, MAFR, and BYOD.

• URL-string limitation of 253 characters.

Features

High Availability
Captive Portal includes support for High Availability (HA). The Captive Portal configurations (such as enablement,
authenticated clients, and redirect URLs) are replicated to standby or other members.

If the feature is enabled and a failover occurs, clients in the process of onboarding are still redirected to Captive
Portal, and authenticated clients continue to have the same access to the network.

Clients that are in the process of authenticating via MAC or 802.1X authentication will not be replicated to the
standby. Replication of client data is only done when MAC or 802.1X authentication has resulted in a successful
authentication.

Load balancing and redundancy
The following options are available to create load balancing and provide redundancy for CPPM:
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• Virtual IP use for a CPPM server cluster

• CPPM servers configured in the switch RADIUS server group 

• External load balancer

Captive Portal when disabled
By default, Captive Portal is disabled. If the Captive Portal feature is disabled and the switch receives a redirect
URL attribute from the RADIUS server as part of the Access-Accept, it will view the redirect as an error. The
authentication success will be overridden, the session will be flushed, and the switch will send the Accounting
Start and Accounting Stop messages to indicate the client is no longer authenticated.

The Captive Portal feature may be disabled while there are in flight authentication requests. These are
authentication sessions that have not finished the final authentication with the switch. The switch flushes all
sessions with a redirect URL associated with them when Captive Portal is disabled.

Fully authenticated sessions are not impacted when Captive Portal is disabled. If CPPM deems these sessions to
be invalid, a RADIUS Disconnect can be sent to flush all these sessions.

Disabling Captive Portal
To disable Captive Portal, enter one of the following:

switch(config)# aaa authentication captive-portal disable
        

switch(config)# no aaa authentication captive-portal enable
        

Configuring Captive Portal on CPPM
Procedure

1. Importing the HP RADIUS dictionary

2. Creating enforcement profiles

3. Creating a ClearPass guest self-registration

4. Configuring the login delay

Import the HP RADIUS dictionary
For CPPM versions 6.5.*, you must update the HP RADIUS dictionary. To import the dictionary in CPPM, follow
these steps:

Procedure

1. Go to Administration -> Dictionaries -> RADIUS and click Import.

2. Select the XML HP RADIUS Dictionary from your Hard Drive.

3. Click Import.
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Create enforcement profiles

Create the HPE Bounce Host-Port profile and the Guest Login profile only if they do not already
exist.

For the HPE Bounce Host-Port profile, configure Captive Portal so that the RADIUS CoA message that includes
the Port Bounce VSA is sent to force the second RADIUS re-authentication after the user registers their device
and makes it known.

Procedure

1. In CPPM, go to Configuration -> Enforcement -> Profiles

2. Click Add.

3. Enter the Profile Name: HPE Bounce Host-Port

4. Enter the Description: Custom-defined profile to bounce host port (HPE).

5. Select the type RADIUS_CoA.

6. Select the action CoA.

7. Add all of the attributes required for a CoA message, and specify the port bounce duration (valid values are
between 0 and 60). This is the amount of time in seconds the port will be held in the down state. The
recommended setting is 12 seconds.

8. Repeat Step 2 to Step 6 to configure the Guest Login profile that will be sent as part of the first RADIUS
Access-Accept and enforce the redirect to the Captive Portal on CPPM. For this profile, select RADIUS as the
type and Accept as the action.

9. Add all of the NAS-Filter-Rule attributes specified below, replacing the IP address in the first two NAS-Filter-
Rule attributes with your CPPM address. Add the HPE-Captive-Portal-URL attribute to specify the redirect
URL, replacing the IP address with your CPPM address. This will cause the client to be redirected to the
Captive Portal on CPPM. You can add other attributes, such as a VLAN to isolate onboarding clients, or a rate
limit to help prevent DoS attacks.
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The HPE-Captive-Portal-URL value must be a URL normalized string. The scheme and host
must be in lower case, for example http://www.example.com/.

Create a ClearPass guest self-registration

Procedure

1. From the Customize Guest Registration window, select Server-initiated as the Login Method.

2. Optionally, under Security Hash, select the level of checking to apply to the redirect URL.
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Configure the login delay
Enter the Login Delay value. The value must be greater than the HPE-Port-Bounce-Host attribute. In this
example, we set the login delay value to 20 seconds.

Configuring the switch
Once you have configured Captive Portal, you can configure the switch. To configure the switch, you must first
configure the switch as a RADIUS client, then configure the ports that will be used for Captive Portal, as follows:

Procedure

1. Configure the switch as a RADIUS client. In this example, the CPPM IP address is 10.73.4.136 and
secret is the secret key shared with the RADIUS server:

a. switch(config)# radius-server host 10.73.4.136 key "secret"
b. switch(config)# radius-server host 10.73.4.136 dyn-authorization
c. switch(config)# radius-server host 10.73.4.136 time-window 0

Make sure to set your time-window to 0. See Event Timestamp not working.

2. Configure the ports that will be used for Captive Portal. In this example, the commands enable ports B3-B5 for
MAC Authentication:

a. switch(config)# aaa authentication port-access chap-radius
b. switch(config)# aaa port-access mac-based B3-B5

3. If you configured the Security Hash to Deny login on validation error in Create a ClearPass
guest self-registration on page 212, configure the URL key.

See Configure the URL key on page 214.

4. Configure the certificate. See Configuring a certificate for Captive Portal usage on page 214

5. Enable Captive portal:

switch(config)# aaa authentication captive-portal enable

By default, Captive Portal is disabled. Once enabled, you are redirected to the URL supplied via the HPE-
Captive-Portal-URL VSA. Captive Portal is enabled on a global/switch wide basis.
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Configure the URL key
You can optionally configure a URL hash key to provide some security for the Captive Portal exchange with
CPPM. The key is a shared secret between CPPM and the switch. When configured, the switch generates a
HMAC-SHA1 hash of the entire redirect URL, and appends the hash to the URL to be sent to CPPM as part of the
HTTP redirect. If CPPM is configured to check the hash, it will generate the hash of the URL using its version of
the URL hash key and compare against the value provided by the switch. The action taken by CPPM upon a
match or mismatch is determined by what is configured on CPPM.

CPPM provides the following options: 

• Do not check - login will always be permitted 

• Deny login on validation error - login will not be permitted

The URL hash key is globally configured and will be used for all redirects to Captive Portal. This key is not
configured on a per CPPM or RADIUS server basis. If the key is not specified, the hash is not added to the URL.
The URL hash key is an ASCII string with a maximum length of 64 characters.

The URL key supports the FIPS certification feature encrypt-credentials and can optionally be encrypted for more
robust security. This option is only available when the global encrypt-credentials is enabled.

To configure a plain text captive-portal URL key: 

switch(config)# aaa authentication captive-portal url-hash-key plaintext <KEY>
        
 

To configure an encrypted captive-portal URL key when encrypt-credentials is enabled:

switch(config)# aaa authentication captive-portal url-hash-key encrypted <ENCRYPTED-
KEY> 
        
To clear a captive-portal URL key: 

switch(config)# no aaa authentication captive-portal url-hash-key
        

Configuring a certificate for Captive Portal usage
HTTPS support requires the use of a certificate. If a certificate for Captive Portal does not exist, the certificate
designated for all use is used instead. 

To create a certificate signing request for Captive Portal, enter:

switch(config)# crypto pki create-csr certificate-name <cert-name> usage captive-
portal
        
To create a self-signed certificate for Captive Portal, enter: 

switch(config)# crypto pki enroll-self-signed certificate-name
        

Display Captive Portal configuration
To display the Captive Portal configuration settings, enter the show captive-portal command: 
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switch(config)# show captive-portal 

Captive Portal Configuration 
 Redirection Enabled    : Yes
 URL Hash Key Configured : No 
      

Show certificate information
To view the certificate information, enter: 

switch(config)# show crypto pki local-certificate 
        
  Name                Usage            Expiration    Parent / Profile 

  -------------------- ---------------  -------------- -------------------- 

   cp                  Captive Portal   2016/08/14    default 

Troubleshooting
Event Timestamp not working

Symptom

The client gets a credentials request on the web browser even though the valid credentials were already provided,
or the client is not redirected to the Captive Portal.

Cause

• ClearPass 6.5.x does not support the sending of Event Timestamp in automated workflows (manual via
Access Tracker works).

• The switch will reject CoA requests when the time on CPPM is ahead of the switch time by even a second.

Action

Set the time-window security feature in PVOS to 0:

radius-server host<CLEARPASS-IP> time-window 0

Cannot enable Captive Portal

Symptom

When running the aaa authentication captive-portal enable command, getting the following error
message:

Captive portal cannot be enabled when BYOD redirect, MAC authentication failure 
redirect, or web-based authentication are enabled.

Cause

The failure is due to a mutual exclusion restriction.
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Action

1. Check which one of the following are enabled: BYOD redirect, MAC authentication failure redirect, or web-
based authentication.

2. Disabled the enabled authentication method found in step 1.

3. Run the aaa authentication captive-portal enable command.

Unable to enable feature

Symptom

One of the following messages is displayed:

• BYOD redirect cannot be enabled when captive portal is enabled.
• MAC authentication failure redirect cannot be enabled when captive 

portal is enabled.
• Web-based authentication cannot be enabled when captive portal 

is enabled.
• V1 compatibility mode cannot be enabled when captive portal 

is enabled.

Cause

You cannot enable these features when Captive Portal is already enabled. They are mutually exclusive.

Action

You can either disable Captive Portal or avoid enabling these features.

Authenticated user redirected to login page

Symptom

User is redirected back to the login page to submit credentials even after getting fully authenticated.

Solution 1

Cause

The status is not changed to Known. 

Action

After the client submits the credentials, the CPPM service must change the Endpoint Status to Known.

Solution 2

Cause

The cache value is set.
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Action

Clear the CPPM Cache Timeout of the Endpoint Repository.

Unable to configure a URL hash key

Symptom

The following message is displayed:

Key exceeds the maximum length of 64 characters.

Cause

The URL hash key is not valid.

Action

Select a key that is 64 or less ASCII text. For example:

switch(config)# aaa authentication captive-portal url-hash-key plaintext
“8011A89FEAE0234BCCA”

authentication command
Use the following authentication commands to configure ClearPass Captive Portal.

Command Description

aaa authentication captive-portal enable Enables redirection to a Captive Portal server for
additional client authentication.

aaa authentication captive-portal
disable
or

no aaa authentication captive-portal
enable

Disables redirection to a Captive Portal server for
additional client authentication.

aaa authentication captive-portal url-
hash-key

Configures a hash key used to verify the integrity of the
portal URL.

show command
Use the following show commands to view the various configurations and certificates.

Command Description

show running-config Shows the running configuration.

show config Shows the saved configuration.

show ip Shows the switch IP addresses.

Table Continued
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Command Description

show captive-portal Captive portal configuration.

show port-access clients [port]
[detailed]

Consolidated client view; the detailed option shows
the Access Policy that is applied. The IP address is
only displayed if dhcp-snooping is enabled.

For the summary view (without the detailed option),
only the untagged VLAN is displayed.

show radius authentication Displays NAS identifier and data on the configured
RADIUS server and switch interactions with this server.

show radius dyn-authorization Statistics for Radius CoA and Disconnect.

show radius accounting Statistics for Radius accounting.

show crypto pki local-certificate
[summary]

Installed certificates.

Debug command
Use the debug command to help you debug your issues.

Command Description

debug security captive-portal Enables debug logging for the Captive Portal sub-
system.

debug security port-access mac-based Enables debug logging for the MAC-auth sub-system.

debug security port-access authenticator Enables debug logging for the 802.1X authenticator
sub-system.

debug security radius-server Enables debug logging for the Radius sub-system.

debug destination session Prints debug messages to terminal.

debug destination logging Sends debug messages to the syslog server.

debug destination buffer Prints debug messages to a buffer in memory.
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AirWave is a Network Management Solution (NMS) tool. Once connected to AirWave using the WebUI and CLI
interfaces, you can:

• Configure your switches using Zero Touch Provisioning (ZTP)

• Configure your switches using the CLI

• Troubleshoot your switches

• Monitor your switches

• Upgrade your firmware for your switches

Once you have configured your switch, you can monitor, manage, and upgrade your hardware using the AirWave
Management Platform.

Requirements
• DHCP server

• AirWave NMS

• HPE Aruba switches

Best Practices
• Implement ZTP in a secure and private environment. Any public access may compromise the security of the

switch, as follows:

◦ ZTP is enabled only on the factory default configuration of the switch. DHCP snooping is not enabled. You
must manage the Rogue DHCP server.

◦ The DHCP offer is in plain data without encryption. Therefore, the offer can be listened by any device on
the network and they can in turn obtain the AirWave information.

◦ The TLS certificate of the server is not validated by the switch during the HTTPs check-in to AirWave. The
AirWave server is in the private environment of the switch.

Limitations
• ZTP is not supported through OOBM.

• The DNS/hostname in option 66 is not supported, only the IPv4 address.

• The switch does not validate peer certificate of the AirWave server as part of the TLS handshake.

Chapter 10
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• The HTTPS check-in to AirWave does not support HTTPS proxy.

• For non-ZTP cases, the AirWave check-in starts by validating the following condition: Primary or Management
VLAN must be configured with the IP address and one of the interface must be UP. By default, VLAN 1 is the
primary VLAN.

Switch configuration
To configure your switch, follow these steps:

1. Configure AirWave details in DHCP (preferred method) on page 220.

If you are using existing HPE switches and using the DHCP server for the configuration or
firmware management, you can configure the AirWave details in DHCP using this method: 
Configure AirWave details in DHCP (alternate method) on page 225

2. If you are configuring the switch using a CLI, see Configure a switch using the CLI on page 234.

If you are using ZTP, the configuration is automatic and does not require any user interaction, see Zero Touch
Provisioning

The switch contacts the AirWave server that is configured on the switch and initiates the check-in process.

Once you have configured the DHCP server, the AirWave details received from the DHCP options are stored in
the switch configuration. This assures that the configuration is retained across reboots.

Once AirWave completes the switch check-in, it lists the first switch as New Devices. The first switch is used to
create a new configuration template for the specific group and device type. With this new template, the required
configuration is generated for the group. Subsequent switch of the specific type and joining the same group as the
first device are added directly to the group and the configuration is pushed using the configuration template via a
SSH connection.

Configure AirWave details in DHCP (preferred method)
To configure a DHCP server for AirWave, from a Windows Server 2008, do the following steps:

Procedure

1. From the Start menu, select Server Manager.
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2. Select Roles -> DHCP -> Server -> w2k8 -> IPv4.

3. Right click on IPv4 and select Set Predefined Options...
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4. The Predefined Options and Values screen is displayed. Click Add....

5. Enter the desired Name (any), Data type (select String), Code (enter 60), and Description (any).
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6. Click OK.

7. From the Predefined Options and Values screen, under Value, enter the String ArubaInstantAP. The string
is case sensitive and must be ArubaInstantAP.

8. Click OK.

9. Under IPv4, expand Scope. Right click on Scope Options and select Configure Options...
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10. Under the General tab, select 043 Vendor Specific Info. The Data entry data appears. Under ASCII, enter
hpeSwitch:hp2920,90.1.1.10,admin. The ASCII value has the following format:
<Group>:<Topfolder>,<AMP IP>,<shared secret>
If you need to add sub-folders, use the following format:

<Group>:<Topfolder>:<folder1>,<AMP IP>,<shared secret>
11.

12. Under the General tab, select 060 Airwave. Click OK.
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No changes are required to the 060 option.

13. You can verify the AirWave details as follows:

switch# show amp-server
switch# show run
          

Configure AirWave details in DHCP (alternate method)
To configure a DHCP server for ZTP and AirWave, from a Windows Server 2008, do the following steps:

You must repeat these steps for every type of switch that needs to be configured for ZTP, selecting a
different Vendor Class for each type of switch.

Procedure

1. From the Start menu, select Server Manager.
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2. Select Roles -> DHCP -> Server -> w2k8 -> IPv4.

3. Right click on IPv4 and select Define Vendor Classes...
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4. The DHCP Vendor Classes window is displayed. Click Add....

5. To get the vendor-specific value of a switch, go to the switch console and enter:

switch# show dhcp client vendor-specific
          
In our example, the command returns the following value:

    Vendor Class Id = HP J9729A 2920-24G-PoE+ Switch dslforum.org 
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Processing of Vendor Specific Configuration is enabled

6. From the New Class window, enter the desired Display name (any) and the Description (any). For the
ASCII field, enter the exact value that you got by executing the show command performed in the previous
step. In this example, HP J9729A 2920-24G-PoE+ Switch dslforum.org.

7. Click OK.

8. Right click on IPv4 and select Set Predefined Options....
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9. From the Predefined Options and Values window, select Option class. The Option Class displayed is the
one that you configured under DHCP Vendor Class. In this example, the Option Class is switch.

10. Click Add....
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11. From the Option Type window, enter the desired Class (any), the Data type (select string), the Code (enter
146), and the Description (any).

12. Click OK.

13. Under the Predefined Options and Values window, enter the Value String. In this example, we enter
hpeSwitch:hp2920,90.1.1.10,admin. The String has the following format: <Group>:<Topfolder>,<AMP
IP>,<shared secret>
If you need to add sub-folders, use the following format:<Group>:<Topfolder>:<folder1>,<AMP
IP>,<shared secret>

230 Aruba 2530 Management and Configuration Guide for ArubaOS-Switch 16.05

Anexo 04 ITEM 10 (0592646)         SEI 0008478-63.2018.6.02.8000 / pg. 5289



14. Click OK.

15. Under IPv4, expand Scope. Right click on Scope Options and select Configure Options...

16. From the Scope Options window:

a. Select the Advanced tab.

b. Under Vendor class, select the desired switch. In this example, switch.

c. Select the 146 hpswitch option.

d. Click OK.
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17. You can verify the AirWave details as follows:

switch# show amp-server
switch# show run
          

Zero Touch Provisioning
The Zero Touch Provisioning (ZTP) solution enables the auto-configuration of your switches on the first boot
without requiring any administrator’s intervention at the switch. The switches use DHCP server option
configurations to support ZTP.

If the switch does not contain the minimal configuration set, ZTP will get disabled. See Image
Upgrade

Auto-configuration using ZTP
ZTP auto-configures your switches as follows:
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Procedure

1. The switch boots up with the factory default configuration.

2. The switch sends out a DHCP discovery from the primary VLAN interface.

a. The preferred configuration method uses DHCP option 43 value as a string to parse Airwave configuration.
Switch would expect a DHCP option 60 with value ArubaInstantAP along with DHCP option 43 to parse
Airwave details

b. The alternate configuration method supports both encapsulated values from option 43 and direct value from
option 43.  Encapsulated vendor-specific sub options, with sub-option code 146 is for Airwave details.

3. After the AirWave details are verified and configured, the switch initiates the check-in into the AirWave server
using the HTTPS communication.

The AirWave configuration must be in the following format:

<Group>:<Topfolder>:<folder1>,<AMP IP >,<shared secret>

4. After a successful registration, AirWave can monitor, configure, and troubleshoot the switches. Refer to Aruba
Networks and AirWave Switch Configuration Guide.

5. Check-in failure retry is done every 60 seconds for 10 retries.

6. If the DHCP options are not configured for AirWave, the switch is left in its default state for manual
configuration.

Disabling ZTP
Zero touch provisioning is disabled if you make any of the following changes to the switch’s configuration:

• Enter the switch configuration mode using the configure terminal command.

• Enter into Menu and exit without doing any configuration

• Make any successful configuration that changes the running-configuration of the switch using a CLI, SNMP,
REST APIs, menu interface, or the web GUI.

• If you upgrade with non-minimal configuration set from any 15.xx version to version 16.01, see Image
Upgrade

Image Upgrade
If you upgrade from any 15.xx version to version 16.01, the following minimal set of configuration is validated to
enable or disable the ZTP process:

• If the switch has any other VLAN apart from the default VLAN, ZTP gets disabled.

• In default VLAN, if the IPv4 address is not set as DHCP (default option is DHCP), ZTP gets disabled.

• In default VLAN, if IPv6 is enabled or configured, ZTP gets disabled.

If you have any other configuration during the upgrade, ZTP will be in the enabled state only.
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Configure a switch using the CLI
Use the amp-server command to configure the AirWave IP address, group, folder, and shared secret. You must
have the manager role to execute this command.

For example:

HP switch(config)# amp-server ip 172.16.185.23 group 2530 folder 2530 secret secret
      
The show amp-server command shows the configuration details:

switch# show amp-server
Airwave Configuration details
  AMP Server IP           : 172.16.185.23
  AMP Server Group        : 2530
  AMP Server Folder       : 2530
  AMP Server Secret       : secret
  AMP Server Config status: Configured
      

Stacking and chassis switches
The ZTP and AirWave interaction for stacked switches is similar to the one for the standalone switch, with the
exception that only the commander in the stack processes the ZTP and AirWave interaction.

Stacking supports the following features:

• Backplane Stacking (BPS) running on:

◦ HPE Aruba 2920 Switch Series

◦ HPE Aruba 3810M Series

• Virtual Switching Framework (VSF) running on HPE Aruba 5400R Switch Series v3 modules

• Chassis running on HPE Aruba 5400R Switch Series v3 modules

Troubleshooting
Cause

You can troubleshoot switches by using the SSH connection and the device logs available in AirWave. For a list of
all RMON message, refer to ArubaOS-Switch Event Log Message Reference Guide.

You can enable the debug logging with the debug ztp command, see debug ztp

View AMP server messages
To display the AMP server debug messages, enter:

switch# debug ztp
        
To print the debug messages to the terminal, enter:

switch# debug destination session
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Validation Rules

Validation Error/Warning

Invalid AirWave IP address Invalid input: 300.300.300.300

Group name exceeds max length String %s too long. Allowed length is 32 characters.

Folder name exceeds max length String %s too long. Allowed length is 128 characters.

Secret name exceeds max length String %s too long. Allowed length is 32 characters.

AirWave IP address or Group or folder or secret is not
configured.

Incomplete input: amp-server

View configuration details
to view the AirWave configuration details, use the show amp-server command. For example:

Airwave Configuration details

  AMP Server IP           : 192.168.1.1
  AMP Server Group        : HP_GROUP
  AMP Server Folder       : folder
  AMP Server Secret       : secret123
  AMP Server Config Status: Configured
The show amp-server command displays the following values for the above configuration details. The show
running command also displays the AirWave configuration details.

For example, to show details of the running configuration:

switch# show running-config
hostname "Aruba-2930F-24G"
module 1 type j9726a
snmp-server community "public" unrestricted
oobm
   ip address dhcp-bootp
   exit
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-24
   ip address dhcp-bootp
   exit
amp-server ip 192.168.1.1 group "group" folder "folder" secret "secret123"

amp-server
Syntax
[no] amp-server ip <IP ADDRESS> group <GROUP> folder <FOLDER> secret <SECRET>
Description

The amp-server command configures the AirWave Management Platform (AMP) IP address, group, folder, and
shared secret and triggers the device registration with AMP.

Only the manager role can execute this command.
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Parameters
ip
AMP server IP address.

group
AMP server group name.

folder
AMP server folder name.

secret
AMP server shared secret string.

Options
no
The no amp-server command removes the configuration for the AMP server.

Permissions

Only the manager role can execute this command.

debug ztp
Syntax
[no] debug ztp
Description

Enables or disables ZTP debug logging.

Parameters
ztp
Zero Touch Provisioning.

Options
no
The no debug ztp command disables the ZTP debug logging.
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Auto device detection and configuration
The auto device detection and configuration detects a directly connected Aruba AP dynamically and applies
predefined configurations to ports on which the Aruba AP is detected.

You can create port configuration profiles, associate them to a device type, and enable or disable a device type.
The only device type supported is aruba-ap and it is used to identify all the Aruba APs.

When a configured device type is connected on a port, the system automatically applies the corresponding port
profile. Connected devices are identified using LLDP. When the LLDP information on the port ages out, the device
profile is removed.

By default, the device profile feature is disabled. When you enable the device profile support for a device type, if
no other device profile is mapped to the device type, the default device profile default-ap-profile is
associated with the device type. You can modify the AP default device profile configuration but you cannot delete
it. The default-ap-profile command supports only the AP device type.

Requirements

Only APs directly connected to the switch will be detected.

Limitations

• Only one device type is supported, aruba-ap, and it is used to identify all the Aruba APs.

• You can modify the configuration parameters of the default profile, default-ap-profile, but you cannot
delete it or change its name.

• The maximum value for poe-max-power is 33 W.

• If the port was part of any protocol VLANs prior to the device profile application, those VLANs will not be
removed while applying the device profile.

• Egress rate limiting is not supported on the Aruba 2530 Switch Series.

• The egress-bandwidth is only supported for devices running on:

◦ Aruba 2920 Switch Series

◦ Aruba 2930F Switch Series

◦ Aruba 5400R zl2 Switch Series v2 & v3 modules

• The egress-bandwidth option is not supported and not displayed in the CLI running on:

Aruba 2530 Switch Series

Feature Interactions

Chapter 11
Auto configuration upon Aruba AP detection
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Profile Manager and 802.1X
Profile Manager interoperates with RADIUS when it is working in the client mode. When a port is blocked due to
802.1X authentication failure, the LLDP packets cannot come in on that port. Therefore, the Aruba AP cannot be
detected and the device profile cannot be applied. When the port gets authenticated, the LLDP packets comes in,
the AP is detected, and the device profile is applied.

You must ensure that the RADIUS server will not supply additional configuration such as VLAN or CoS during the
802.1X authentication as they will conflict with the configuration applied by the Profile Manager. If the RADIUS
server supplies any such configurations to a port, the device profile will not be applied on such ports.

Profile Manager and LMA/WMA/MAC-AUTH
If either LMA, WMA, or MAC-AUTH is enabled on an interface, all the MAC addresses reaching the port must be
authenticated. If LMA, WMA, or MAC-AUTH is configured on an interface, the user can have more granular
control and does not need the device profile configuration. Therefore, the device profile will not be applied on
such interface.

Profile manager and Private VLANs
When the device profile is applied, a check is performed to verify if the VLAN addition violates any PVLAN
requirements. The following PVLAN related checks are done before applying the VLANs configured in the device
profile to an interface:

• A port can be a member of only one VLAN from a given PVLAN instance.

• A promiscuous port cannot be a member of a secondary VLAN.

Procedure for creating a device identity and associating a device type

Procedure

1. Create a device identity using the command:

switch# device-identity name <DEVICE-NAME>
          

2. Specify the OUI used in LLDP's organization using specific TLV, (type =127). OUI should be in XXXXXX
format. The default OUI "000000" indicates that device-identity will not use LLDP to identify device:

switch(config)# device-identity name <DEVICE-NAME> lldp oui <MAC_OUI>
 sub-type <SUBTYPE>

To add new device on switch:

switch(config)# device-identity name abc lldp oui a1b2c3 sub 2
To remove device from switch:

switch(config)# no device-identity name abc
3. Show device identity configuration:

switch(config)# show device-identity lldp

Device Identity Configuration

 Index  Device name            Oui        Subtype
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 ------ ---------------------- ---------- -------
 1      abc                    a1b2c3     2     

device-profile name
Syntax

[no] device-profile name <PROFILE-NAME> [untagged-vlan <VLAN-ID> | 
             tagged-vlan <VLAN-LIST> |
             cos <COS-VALUE> | 
             ingress-bandwidth <Percentage> | 
             egress-bandwidth <Percentage> | 
             {poe-priority {critical | high | low} | 
             speed-duplex {auto | auto-10 | auto-100 | ...} |
             poe-max-power <Watts>]
Description

This command is used to create an user-defined profile. A profile is a named collection of port settings applied as
a group. You can modify the default profile, default-ap-profile, but you cannot delete it. You can create four
additional profiles.

The default-ap-profile has the following values:

• untagged-vlan: 1

• tagged-vlan: None

• ingress-bandwidth: 100

• egress-bandwidth: 100

• cos: 0

• speed-duplex: auto

• poe-max-power: 33

• poe-priority: critical

You can modify these parameters. For example, you can execute no untagged-vlan to create a device profile
with tagged only ports.

Parameters
name
Specifies the name of the profile to be configured. The profile names can be at most 32 characters long.

cos
The Class of Service (CoS) priority for traffic from the device.

untagged-vlan
The port is an untagged member of specified VLAN.

tagged-vlan
The port is a tagged member of the specified VLANs.

ingress-bandwidth
The ingress maximum bandwidth for the device port.

egress-bandwidth
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The egress maximum bandwidth for the device port.

poe-priority
The PoE priority for the device port.

speed-duplex
The speed and duplex for the device port.

poe-max-power
The maximum PoE power for the device port.

Options
no
Removes the user-defined profiles.

Restrictions

• You can modify the configuration parameters of the default profile, default-ap-profile, but you cannot
delete it or change its name.

• For Aruba 5400R Switch Series and Aruba 2930F Switch Series devices, the maximum value for poe-max-
power is 30 W. For all other devices, the maximum value for poe-max-power is 33 W.

• Egress rate limiting is not supported for devices running on:

◦ Aruba 2530 Switch Series

◦ Aruba 2540 Switch Series

◦ Aruba 2930F Switch Series

• The egress-bandwidth is only supported for Aruba 2920 and Aruba 5400R Switch Series v2 & v3.

• The egress-bandwidth option is not supported and not displayed in the CLI for the Aruba 2530 switch.

• The profile configuration is only applicable to access points.

device-profile type
Syntax

device-profile type <DEVICE> [associate <PROFILE-NAME> | enable | disable ]
Description

This command specifies an approved device type in order to configure and attach a profile to it. The profile’s
configuration is applied to any port where a device of this type is connected.

Parameters
type
An approved device type in order to configure and attach a profile to it. The only device type supported is aruba-
ap and it is used to identify all the Aruba APs.

APs.

associate
Associates a profile with a device type.

enable
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Enables automatic profile association.

disable
Disables automatic profile association.

Options
no
Removes the device type association and disables the feature for the device type. By default, this feature is
disabled.

Restrictions

Only one device type is supported, aruba-ap, and it is used to identify all the Aruba access points.

Rogue AP Isolation
The Rogue AP Isolation feature detects and blocks any unauthorized APs in the network. You can either log or
block the rogue device. If the action requested is to log the rogue device, the MAC address of the rogue device is
logged in the system logs (RMON). If the action is to block the rogue device, the traffic to and from the MAC
address of the rogue device is blocked. The MAC is also logged in the system log.

When an Aruba AP detects a rogue AP on the network, it sends out the MAC address of the AP as well as the
MAC of the clients connected to the AP to the switch using the ArubaOS-Switch proprietary LLDP TLV protocol.
The switch then adds a rule in its hardware table to block all the traffic originating from the rogue AP’s MAC
address.

The rogue-ap-isolation command configures the rogue AP isolation for the switch and gives the option to
enable or disable the rogue AP isolation feature. The rogue-ap-isolation action command gives you the
ability to block the traffic to or from the rogue device or log the MAC of the rogue device. When the action is set to
block, the rogue MAC is logged as well. By default, the action is set to block.

The rogue-ap-isolation whitelist command lets you add devices detected as possible rogue APs to the
whitelist. A maximum of 128 MAC addresses are supported for the whitelist.

The clear rogue-aps command clears the detected rogue AP device MAC address.

Limitations

• You can add a maximum of 128 MAC addresses to the whitelist.

• When a MAC is already authorized by any of the port security features such as LMA, WMA, or 802.1X, the
MAC is logged but you cannot block it using the rogue-ap-isolation feature. A RMON event is logged to
notify the user.

• When a MAC is already configured as an IP received MAC of a VLAN interface, the MAC is logged but you
cannot block it by using the rogue-ap-isolation feature. A RMON event is logged to notify the user.

• When a MAC is already locked out via lockout-mac or locked down using the static-mac configuration,
the MAC is logged but you cannot block it using the rogue-ap-isolation feature. A RMON event is logged
to notify the user.

• The number of rogue MACs supported on a switch is a function of the value of max-vlans at boot time. Since
the resources are shared with the lockout-mac feature, the scale is dependent on how many lockout
addresses have been configured on the switch using the lockout-mac feature. The following table lists the
scale when there are no lockout addresses configured on the switch:
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Max VLAN Supported MACs

0 < VLAN <= 8 200

8 < VLAN <= 16 100

16 < VLAN <= 256 64

256 < VLAN <= 1024 16

1024 < VLAN <= 2048 8

2048 < VLAN <= 4094 4

The switch will create an RMON log entry and the rogue MAC will be ignored when the limit is reached.

If the max-vlans value is changed to a different value, the scale of rogue MACs supported will
not change until the next reboot.

Feature Interactions

MAC lockout and lockdown
The Rogue AP isolation feature uses the MAC lockout feature to block MACs in hardware. Therefore, any MAC
blocked with the Rogue AP isolation feature cannot be added with the lockout-mac or static-mac command
if the action type is set to block. 

For example:

switch# lockout-mac 247703-7a8950 
Cannot add the entry for the MAC address 247703-7a8950 because it is already 
blocked by rogue-ap-isolation. 
      

switch# static-mac 247703-7a8950 vlan 1 interface 1 
Cannot add the entry for the MAC address 247703-7a8950 because it is already 
blocked by rogue-ap-isolation. 
      
Similarly, any MAC that was added with the lockout-mac or static-mac command and that is being detected
as rogue will be logged, but not blocked in hardware as it already is set to block. If the MAC is removed from
lockout-mac or static-mac but is still in the rogue device list, it will be blocked back in hardware if the action
type is block.

LMA/WMA/802.1X/Port-Security
Any configuration using LMA, WMA, 802.1X, or Port-Security will not be blocked if the Rogue AP isolation feature
is enabled. All these features act only when a packet with the said MAC is received on a port.

If rogue-ap-isolation blocks a MAC before it is configured to be authorized, packets from such MACs will be
dropped until one of the following happens:

• Rogue action is changed to LOG.

• Rogue-AP isolation feature is disabled.
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• The MAC is not detected as rogue anymore.

• LLDP is disabled on the port (or globally).

Once a MAC has been authorized by one of these features, it will not be blocked by Rogue AP isolation. A RMON
will be logged to indicate the failure to block.

The Rogue AP module will retry to block any such MACs periodically. In the event of the MAC no longer being
authorized, Rogue AP isolation will block the MAC again. No RMON is logged to indicate this event. 

L3 MAC
The Rogue AP isolation feature will not block a MAC configured as an IP receive MAC address on a VLAN
interface. This event will be logged in RMON if such MACs are detected as rogue.

Conversely, any MAC already blocked by Rogue AP isolation will not be allowed to be configured as an IP receive
MAC address of a VLAN interface.

For example:

switch# vlan 1 ip-recv-mac-address 247703-3effbb 
Cannot add an entry for the MAC address 247703-3effbb because it is already
blocked by rogue-ap-isolation. 
      

Using the Rogue AP Isolation feature

Procedure

1. Check the feature state:

switch# show rogue-ap-isolation

 Rogue AP Isolation

  Rogue AP Status : Disabled
  Rogue AP Action : Block

  Rogue MAC Address Neighbour MAC Address
  ----------------- ---------------------
          

2. Enable the feature:

switch# rogue-ap-isolation enable
switch# show rogue-ap-isolation

 Rogue AP Isolation

  Rogue AP Status : Enabled
  Rogue AP Action : Block

  Rogue MAC Address Neighbour MAC Address
  ----------------- ---------------------
          

3. Change the action type from block to log:

switch# rogue-ap-isolation action log
switch# show rogue-ap-isolation

 Rogue AP Isolation
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  Rogue AP Status : Enabled
  Rogue AP Action : Log

  Rogue MAC Address Neighbour MAC Address
  ----------------- ---------------------
          

4. List the current whitelist entries:

switch# show rogue-ap-isolation whitelist

Rogue AP Whitelist Configuration

 Rogue AP MAC
 ------------------
          

5. Add a new whitelist entry:

switch# rogue-ap-isolation whitelist 005056-00326a
switch# show rogue-ap-isolation whitelist

Rogue AP Whitelist Configuration

 Rogue AP MAC
 ------------------
 00:50:56:00:32:6a
          

rogue-ap-isolation
syntax

rogue-ap-isolation {enable | disable}
Description

Configures the rogue AP isolation for the switch.

Parameters
enable
Enables the rogue AP isolation.

disable
Disables the rogue AP isolation.

rogue-ap-isolation action
syntax

rogue-ap-isolation action {log | block}
Description

Configures the action to take for the rogue AP packets. This function is disabled by default.

Parameters
action
Configure the action to take for rogue AP packets. By default, the rogue AP packets are blocked.
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Options
log
Logs traffic to or from any rogue access points.

block
Blocks and logs traffic to or from any rogue access points.

rogue-ap-isolation whitelist
syntax

[no] rogue-ap-isolation whitelist <MAC-ADDRESS>
Description

Configures the rogue AP Whitelist MAC addresses for the switch. Use this command to add to the whitelist the
MAC addresses of approved access points or MAC addresses of clients connected to the rogue access points.
These approved access points will not be added to the rogue AP list even if they are reported as rogue devices.

Parameters
MAC-ADDRESS
Specifies the MAC address of the device to be moved from the rogue AP list to the whitelist.

Options
no
Removes the MAC address individually by specifying the MAC.

Restrictions

You can add a maximum of 128 MAC addresses to the whitelist.

clear rogue-ap-isolation
syntax

clear rogue-ap-isolation { <MAC-ADDRESS> | all }
Description

Removes the MAC addresses from the rogue AP list.

Parameters
MAC-ADDRESS
Specifies the MAC address of the device to be moved from the rogue AP list.

all
Clears all MAC addresses from the rogue AP list.

Restrictions

The MAC addresses cleared using this option will be added back to the rogue list under the following cases:

1. The LLDP administrator status of the port on which the AP that reported the MAC is disabled and enabled
back.

2. The data that is in the rogue AP TLV sent from the AP that informed the rogue MAC has changed.

3. To permanently ignore a MAC from being detected as rogue, add it to the whitelist.
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Troubleshooting
Dynamic configuration not displayed when using “show running-config”

Symptom

The show running-config command does not display the dynamic configuration applied through the device
profile.

Cause

The show running-config command shows only the permanent user configuration and parameters
configured through device profile.

Action

Use the specific show device-profile command to display the parameters dynamically configured through
the device profile.

Switch does not detect the rogue AP TLVs

Symptom

The switch does not detect the rogue AP TLVs that could be sent from the neighboring device.

Cause

The LLDP administrator status of a port is moved from txOnly to tx_rx or rx_only within 120 seconds of the
previous state change to txOnly.

Action

1. Wait for 120 seconds before moving from the state txOnly to the state tx_rx or rx_only. 

2. Move the administrator status to disable and then back to tx_rx or rx_only.

The show run command displays non-numerical value for untagged-vlan

Symptom

The show run command displays one of the following values for untagged-vlan:

• no untagged-vlan
• untagged-vlan : None

Cause

The no device-profile or the no rogue-ap-isolation whitelist command is executed to configure
untagged-vlan to 0.
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Action

No action is required.

Show commands
Use the following show commands to view the various configurations and status.

Command Description

show device-profile Shows the device profile configuration and status.

show device-profile config Shows the device profile configuration details for a
single profile or all profiles.

show device-profile status Shows currently applied device profiles.

show rogue-ap-isolation Shows the following information:

• The status of the feature: enabled or disabled.

• The current action type for the rogue MACs
detected.

• The list of MAC addresses detected as rogue and
the MAC address of the AP that reported them.

show rogue-ap-isolation whitelist Shows the rogue AP whitelist configuration.

show run Shows the running configuration.

Validation Rules

Validation Error/Warning/Prompt

device-profile profile-name default-ap-
profile

Maximum tagged VLANs that can be associated with a
device-profile is 256.

device-profile profile-name creation. String too long. Allowed length is 32 characters.

device-profile profile-name creation. Device profile <> already exists.

device-profile profile-name creation. The maximum number of device profiles allowed is 5.

device-profile profile-name deletion. Device profile <> does not exist.

device-profile profile-name deletion. Cannot delete profile <> when associated with a device
type.

device-profile profile-name deletion. Default profile cannot be deleted.

Table Continued
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Validation Error/Warning/Prompt

device-profile profile-name modification via
SNMP.

Default profile name cannot be changed.

device-profileprofile-name creation/
modification via SNMP.

Device profile index cannot be greater than 5.

untagged-vlan Invalid VLAN.

untagged-vlan Cannot configure the VLAN <> as an untagged VLAN
because this is already used as a tagged VLAN.

tagged-vlan 1-1000 The maximum number of tagged VLANs in a profile is
less than 512 or the maximum VLANs, MAX_VLANs,
configurable in the system.

tagged-vlan Cannot configure the VLAN <> as a tagged VLAN
because this is already used as an untagged VLAN.

ingress-bandwidth SNMP should return WRONG_VALUE_ERROR.

egress-bandwidth SNMP should return WRONG_VALUE_ERROR.

cos SNMP should return WRONG_VALUE_ERROR.

speed-duplex SNMP should return WRONG_VALUE_ERROR.

poe-max-power SNMP should return WRONG_VALUE_ERROR.

poe-priority SNMP should return WRONG_VALUE_ERROR.

device-profile type aruba-ap profile-
name

String <> too long. Allowed length is 32 characters.

device-profile type aruba-ap profile-
name

Device profile <> does not exist.

device-profile type aruba-switch-router Device type is not supported.

rogue-ap-whitelist Whitelist MAC address already exists in the list.

rogue-ap-whitelist Whitelist MAC address does not exist in the list.

rogue-ap-whitelist The maximum number of whitelist MACs allowed is
128.

rogue-ap-whitelist <MAC> Cannot add the whitelist entry because the specified
MAC address is already configured as a lock-out MAC.

Table Continued
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Validation Error/Warning/Prompt

lock-out <MAC> Cannot add the lock-out entry because the specified
MAC address is already configured as a whitelist MAC.

lockout-mac <MAC-ADDRESS>ORstatic-mac
<MAC-ADDRESS> vlan <vlan-id> interface
<interface>ORvlan <vlan-id> ip-recv-mac-
address <MAC-ADDRESS

Cannot add an entry for the MAC address <MAC-
ADDRESS> because it is already blocked by rogue-
ap-isolation.
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Aruba Central Network Management Solution Overview
The Aruba Central network management solution, a software-as-a-service subscription in the cloud, provides
streamlined management of multiple network devices. Aruba switches are able to talk to Aruba Central and utilize
cloud-based management functionality. Cloud-based management functionality allows for the deployment of
network devices at sites with no IT personnel (branch offices, retail stores, and so forth). The communication
channel used to connect the devices with the cloud portal is outside the control of end users. It adheres to
corporate standards like the use of firewalls.

This feature provides:

• Zero-touch provisioning

• Network Management/Remote monitoring

• Events/alerts notification

• Configuration

• Firmware management

Table 22: Features supported by Aruba Central

Configuration

VLANS Create VLANs

IP address assignment

Tag/Untag

Ports Admin status [Up/Down]

PoE [ Enable/Disable for an interface]

User
Management

Create/delete Operator User

Create Manager user

IP address assignment to Uplink Vlan [ Static to DHCP and vice versa ]

Name server configuration

RCD

Establish a remote console session to Switch

Monitoring

Events

Statistics

Chapter 12
Aruba Central integration
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Firmware Management

Update the switch firmware

Troubleshooting

Execute troubleshooting commands from central

Restricted commands in switch when connected to Central

boot
recopy
erase
reload
startup-default
upgrade-software
setup
delete
reboot
restore
menu
write memory
amp-server

Limited Management Interface on switch

WebUI
REST
SNMP
TR-69
Menu

You can provision the switch in Aruba Activate. For more information about provisioning, See Aruba Networks and
AirWave Switch Configuration Guide.

LED behavior during connectivity loss
For the 2530, the FDX LED does not blink. It remains on during connectivity loss.

Configuration commands

aruba-central
Syntax
aruba-central {enable | disable | support-mode {enable | disable}}
Description

Configure Aruba Central server support. When enabled, and when a server web address has been obtained using
Aruba Activate, the system will connect to an Aruba Central server. The system will obtain configuration updates
and most local configuration commands will be disabled. This mode is enabled by default.

Enter support mode to enable all configuration commands. Normally, when the system is connected to an Aruba
Central server, the configuration is updated from that server and most local configuration commands are disabled.
Support mode enables those commands for use in troubleshooting problems. Support mode is disabled by
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default. When the system is not connected to Aruba Central server, the full command set is enabled for local
configuration.

Restrictions

• Switch communication to Aruba Central is not supported via OOBM.

• Aruba-central is not supported in FIPS switches and it will be disabled by default.

• Aruba-central is not supported in Stack switches and it will be disabled by default.

To avoid broadcast storm or loops in your network while configuring ZTP, do not have redundant links
after you complete ZTP and Airwave registration. Authorize the new switch and then push the
Golden Configuration template from Airwave.

Example

Enable Aruba Central server support

switch(config)# aruba-central enable
Disable Aruba Central server support

switch(config)# aruba-central disable
Enter support mode to enable all CLI configuration commands

switch(config)# aruba-central support-mode enable

This mode will enable all CLI configuration commands, including those normally reserved by the Aruba Central
service. 
Use of this mode may invalidate the configuration provisioned through Aruba Central server.
Continue (y/n)?              

Show commands

show aruba-central
Syntax
show aruba-central
Description

Show Aruba Central server information.

show aruba-central

switch# show aruba-central

 Configuration and Status - Aruba Central
  Server URL           : https://hpsw-jenkins-soa-qa-build-1404-250.test.pdt1.arubathena.com/ws
  Connected            : Yes
  Mode                 : Managed
  Last Disconnect Time : Tue Jun 14 16:01:15 2016
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LACP-MAD commands

Configuration command
The following command defines whether LACP is enabled on a port, and whether it is in active or passive mode
when enabled. When LACP is enabled and active, the port sends LACP packets and listens to them. When LACP
is enabled and passive, the port sends LACP packets only if it is spoken to. When LACP is disabled, the port
ignores LACP packets. If the command is issued without a mode parameter, 'active' is assumed. During dynamic
link aggregation using LACP, ports with the same key are aggregated as a single trunk. MAD passthrough applies
only to trunks and not to physical ports.

switch# [no] interface <port-list> lacp [mad-passthrough <enable|disable>|active|passive|key <key>]

show commands
LACP-MAD supports the following show commands:

• show LACP-MAD passthrough configuration on LACP trunks

switch# show lacp [counters [<port-list>] | local [<port-list>] |peer [<port-
list>] | distributed | mad-passthrough [counters [<port-list>]]]

• show LACP-MAD passthough counters on ports

switch# show lacp mad-passthrough counters [<port-list>]

clear command
Clear all LACP statistics including MAD passthrough counters. Resets LACP packets sent and received on all
ports.

switch# clear lacp statistics

LACP-MAD overview
Link Aggregation Control Protocol-Multi-Active Detection (LACP-MAD) is a detection mechanism deployed by
switches to recover from a breakup of the Virtual Switching Framework (VSF) stack due to link or other failure.

LACP-MAD is implemented by sending extended LACP data units (LACPDUs) with a type length value (TLV) that
conveys the active ID of an VSF virtual device. The active ID is identical to the member ID of the master and is
thus unique to the VSF virtual device. When LACP MAD detection is enabled, the members exchange their active
IDs by sending extended LACPDUs.

Chapter 13
LACP-MAD
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• When the VSF virtual device operates normally, the active IDs in the extended LACPDUs sent by all members
are the same, indicating that there is no multi-active collision.

• When there is a breakup in the VSF stack, the active IDs in the extended LACPDUs sent by the members in
different VSF virtual devices are different, indicating that there are multi-active collisions.

LACP-MAD passthrough helps VSF-capable devices detect multi-access and take corrective action. These
devices do not initiate transmission of LACP-MAD frames or participate in any MAD decision making process.
These devices simply forward LACP-MAD TLVs received on one interface to the other interfaces on the trunk.
LACP-MAD passthrough can be enabled for 24 LACP trunks. By default, LACP-MAD passthrough is disabled.
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The following table lists the switch scalability values for the areas of VLANs, ACLs, hardware, ARP, and routing.

Subject Maximum

IPv4 ACLs

total named (extended or standard) Up to 2048 (minus any IPv4 numeric standard or extended ACL
assignments and any RADIUS-assigned ACLs)11

total numbered standard Up to 99

total numbered extended Up to 10011

total ACEs in all IPv4 ACLs Up to 307211

Layer-3

VLANs with at least one IP Address 512

IP addresses per system 2048 IPv4

2048 IPv6

IP addresses per VLAN 32

Static routes (IPv4 and IPv6
combined)

256

IPv4 host hardware table 72 K (8K internal, 64K external)

IPv4 BMP hardware table 2 K

ARP

ARP entries 25,000

Packets held for ARP resolution 25

Dynamic Routing

Total routes supported IPv4 only: 10,000 (including ARP)

IPv4 and IPv6: 10 K (IPv4) and 3 K

(IPv6)

IPv6 only: 5 K

IPv4 Routing Protocol

RIP interfaces 128

Table Continued
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Subject Maximum

IPv6 Routing Protocol

DHCPv6 Helper Addresses 32 unique addresses; multiple instances of same address counts as 1
towards maximum

1 
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Overview
The switches support several methods for transferring files to and from a physically connected device, or via the
network, including TFTP and Xmodem. This appendix explains how to download new switch software, upload or
download switch configuration files and software images, and upload command files for configuring ACLs.

Downloading switch software
HPE Switch periodically provides switch software updates through the Switch Networking website. For more
information, see the support and warranty booklet shipped with the switch, or visit http://www.hpe.com/
networking and click on software updates.

This manual uses the terms switch software and software image to refer to the downloadable
software files the switch uses to operate its networking features. Other terms sometimes include
Operating System, or OS.

General software download rules

• Switch software that you download via the menu interface always goes to primary flash.

• After a software download, you must reboot the switch to implement the new software. Until a reboot occurs,
the switch continues to run on the software it was using before the download.

Downloading new switch software does not change the current switch configuration. The switch
configuration is contained in separate files that can also be transferred. See Transferring switch
configurations on page 273.

In most cases, if a power failure or other cause interrupts a flash image download, the switch reboots
with the image previously stored in primary flash. In the unlikely event that the primary image is
corrupted (which may occur if a download is interrupted by a power failure), the switch goes into boot
ROM mode. In this case, use the boot ROM console to download a new image to primary flash.

Using TFTP to download software from a server
This procedure assumes that:

• A software version for the switch has been stored on a TFTP server accessible to the switch. (The software file
is typically available from the HPE Switch Networking website at http://www.hpe.com/networking.)

• The switch is properly connected to your network and has already been configured with a compatible IP
address and subnet mask.

• The TFTP server is accessible to the switch via IP.

Before you use the procedure, do the following:
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• Obtain the IP address of the TFTP server in which the software file has been stored.

• If VLANs are configured on the switch, determine the name of the VLAN in which the TFTP server is operating.

• Determine the name of the software file stored in the TFTP server for the switch (For example, E0820.swi).

If your TFTP server is a UNIX workstation, ensure that the case (upper or lower) that you specify for
the filename is the same case as the characters in the software filenames on the server.

Downloading from a server to primary flash using TFTP (Menu)
Note that the menu interface accesses only the primary flash.

Procedure

1. In the console Main Menu, select Download OS to display the screen in Figure 37: Example: of a download
OS (software) screen (default values) on page 258. (The term "OS" or "operating system" refers to the
switch software):

Figure 37: Example: of a download OS (software) screen (default values)

2. Press [E] (for Edit ).

3. Ensure that the Method field is set to TFTP (the default).

4. In the TFTP Server field, enter the IP address of the TFTP server in which the software file has been stored.

5. In the Remote File Name field, enter the name of the software file (if you are using a UNIX system, remember
that the filename is case-sensitive).

6. Press [Enter], then [X] (for eXecute ) to begin the software download.
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The following screen appears:

Figure 38: Example: of the download OS (software) screen during a download

A "progress" bar indicates the progress of the download. When the entire software file has been received, all
activity on the switch halts and you will see Validating and writing system software to FLASH...

7. After the primary flash memory is updated with the new software, you must reboot the switch to implement the
newly downloaded software. Return to the Main Menu and press [6] (for Reboot Switch ).

You will see this prompt:

Continue reboot of system? : No

Press the space bar once to change No to Yes, then press [Enter] to begin the reboot.

When you use the menu interface to download a switch software, the new image is always stored
in primary flash. Also, using the Reboot Switch command in the Main Menu always reboots the
switch from primary flash. Rebooting the switch from the CLI provides more options. See
"Rebooting the Switch" in the basic operation guide.

8. After you reboot the switch, confirm that the software downloaded correctly:

a. From the Main Menu, select

2. Switch Configuration...

2. Port/Trunk Settings

b. Check the Firmware revision line.

For troubleshooting information on download failures, see Troubleshooting TFTP download failures on page
260.
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Troubleshooting TFTP download failures

Cause

When using the menu interface, if a TFTP download fails, the Download OS (Operating System, or software)
screen indicates the failure as seen in the following figure.

Figure 39: Example: of message for download failure

Some of the causes of download failures include:

• Incorrect or unreachable address specified for the TFTP Server parameter. This may include network
problems.

• Incorrect VLAN.

• Incorrect name specified for the Remote File Name parameter, or the specified file cannot be found on the
TFTP server. This can also occur if the TFTP server is a UNIX machine and the case (upper or lower) for the
filename on the server does not match the case for the filename entered for the Remote File Name parameter
in the Download OS (Operating System, or software) screen.

• One or more of the switch's IP configuration parameters are incorrect.

• For a UNIX TFTP server, the file permissions for the software file do not allow the file to be copied.

• Another console session (through either a direct connection to a terminal device or through Telnet) was
already running when you started the session in which the download was attempted.

To find more information on the cause of a download failure:

• Examine the messages in the switch's Event Log by executing the show log tftp command from the CLI.

• For descriptions of individual Event Log messages, see the latest version of the event log message reference
guide for your switch, available on the HPE Switch website. (See "Getting Documentation From the Web".)

If an error occurs in which normal switch operation cannot be restored, the switch automatically
reboots itself, and an appropriate message is displayed after the reboot.
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Downloading from a server to flash using TFTP (CLI)
Syntax:

copy tftp flash <ip-address> <remote-file> [<primary | secondary>]
Automatically downloads a switch software file to primary or secondary flash. If you do not specify the flash
destination, the TFTP download defaults to primary flash.

Example:

To download a switch software file named k0800.swi from a TFTP server with the IP address of 10.28.227.103 to
primary flash:

Procedure

1. Execute copy as shown below:
The command to download an OS (switch software)

switch# copy tftp flash 10.28.227.103 k0800.swi
The primary OS Image will be deleted, continue [y/n]? y 1
01431K 2

• 1This message means that the image you want to upload will replace the image currently in primary flash.

• 2Dynamic counter continually displays the number of bytes transferred.

When the switch finishes downloading the software file from the server, it displays this progress message:

Validating and Writing System Software to FLASH ...
2. When the download finishes, you must reboot the switch to implement the newly downloaded software image.

To do so, use one of the following commands:

Syntax:

boot system flash {<primary | secondary>}
Boots from the selected flash.

Syntax:

reload
Boots from the flash image and startup-config file. A switch covered in this guide (with multiple configuration
files), also uses the current startup-config file.

For more information on these commands, see "Rebooting the Switch" in the basic operation guide for your
switch.

3. To confirm that the software downloaded correctly, execute show system and check the Firmware revision
line.

For information on primary and secondary flash memory and the boot commands, see "Using Primary and
Secondary Flash Image Options" in the basic operation guide for your switch.

If you use auto-tftp to download a new image in a redundant management system, the active
management module downloads the new image to both the active and standby modules. Rebooting
after the auto-tftp process completes reboots the entire system.

Chapter 15 File Transfers 261

Anexo 04 ITEM 10 (0592646)         SEI 0008478-63.2018.6.02.8000 / pg. 5320



Using SCP and SFTP
For some situations you may want to use a secure method to issue commands or copy files to the switch. By
opening a secure, encrypted SSH session and enabling ip ssh file transfer, you can then use a third-party
software application to take advantage of SCP and SFTP. SCP and SFTP provide a secure alternative to TFTP
for transferring information that may be sensitive (like switch configuration files) to and from the switch.
Essentially, you are creating a secure SSH tunnel as a way to transfer files with SFTP and SCP channels.

Once you have configured your switch to enable secure file transfers with SCP and SFTP, files can be copied to
or from the switch in a secure (encrypted) environment and TFTP is no longer necessary.

To use these commands, you must install on the administrator workstation a third-party application software client
that supports the SFTP and/or SCP functions. Some examples of software that supports SFTP and SCP are
PuTTY, Open SSH, WinSCP, and SSH Secure Shell. Most of these are freeware and may be downloaded without
cost or licensing from the internet. There are differences in the way these clients work, so be sure you also
download the documentation.

As described earlier in this chapter you can use a TFTP client on the administrator workstation to update software
images. This is a plain-text mechanism that connects to a standalone TFTP server or another HPE switch acting
as a TFTP server to obtain the software image files. Using SCP and SFTP allows you to maintain your switches
with greater security. You can also roll out new software images with automated scripts that make it easier to
upgrade multiple switches simultaneously and securely.

SFTP is unrelated to FTP, although there are some functional similarities. Once you set up an SFTP session
through an SSH tunnel, some of the commands are the same as FTP commands. Certain commands are not
allowed by the SFTP server on the switch, such as those that create files or folders. If you try to issue commands
such as create or remove using SFTP, the switch server returns an error message.

You can use SFTP just as you would TFTP to transfer files to and from the switch, but with SFTP, your file
transfers are encrypted and require authentication, so they are more secure than they would be using TFTP.
SFTP works only with SSH version 2 (SSH v2).

SFTP over SSH version 1 (SSH v1) is not supported. A request from either the client or the switch
(or both) using SSH v1 generates an error message. The actual text of the error message differs,
depending on the client software in use. Some examples are:

Protocol major versions differ: 2 vs. 1
Connection closed

Protocol major versions differ: 1 vs. 2
Connection closed

Received disconnect from <ip-addr> : /usr/local/libexec/
sftp-server: command not supported
Connection closed

SCP is an implementation of the BSD rcp (Berkeley UNIX remote copy) command tunneled through an SSH
connection.

SCP is used to copy files to and from the switch when security is required. SCP works with both SSH v1 and SSH
v2. Be aware that the most third-party software application clients that support SCP use SSHv1.

The general process for using SCP and SFTP involves three steps:

Procedure

1. Open an SSH tunnel between your computer and the switch if you have not already done so.
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(This step assumes that you have already set up SSH on the switch.)

2. Execute ip ssh filetransfer to enable secure file transfer.

3. Use a third-party client application for SCP and SFTP commands.

Enabling SCP and SFTP
For more information about secure copy and SFTP, see Using SCP and SFTP on page 262.

Procedure

1. Open an SSH session as you normally would to establish a secure encrypted tunnel between your computer
and the switch.

For more detailed directions on how to open an SSH session, see "Configuring secure shell (SSH)" in the
access security guide for your switch. Please note that this is a one-time procedure for new switches or
connections. If you have already done it once you should not need to do it a second time.

2. To enable secure file transfer on the switch (once you have an SSH session established between the switch
and your computer), open a terminal window and enter the following command:

switch(config)# ip ssh filetransfer

For information on disabling TFTP and auto-TFTP, see Disabling TFTP and auto-TFTP for enhanced security
on page 263.

Disabling TFTP and auto-TFTP for enhanced security
Using the ip ssh filetransfer command to enable SFTP automatically disables TFTP and auto-TFTP (if
either or both are enabled), as shown in Switch configuration with SFTP enabled on page 263.

Switch configuration with SFTP enabled

switch(config)# ip ssh filetransfer
Tftp and auto-tftp have been disabled. 1
switch(config)# sho run

Running configuration:

; J9091A Configuration Editor; Created on release #xx.15.xx

hostname "HP Switch"
module 1 type J8702A
module 2 type J702A
vlan 1
   name "DEFAULT_VLAN"
   untagged A1-A24,B1-B24
   ip address 10.28.234.176 255.255.240.0
   exit
ip ssh filetransfer 2
no tftp-enable
password manager
password operator
1 Enabling SFTP automatically disables TFTP and auto-tftp and displays this message.
2 Viewing the configuration shows that SFTP is enabled and TFTP is disabled.

If you enable SFTP and then later disable it, TFTP and auto-TFTP remain disabled unless they are explicitly re-
enabled.

Chapter 15 File Transfers 263

Anexo 04 ITEM 10 (0592646)         SEI 0008478-63.2018.6.02.8000 / pg. 5322



Operating rules are:

• The TFTP feature is enabled by default, and can be enabled or disabled through the CLI, the Menu interface
(see Figure 40: Using the Menu interface to disable TFTP on page 264), or an SNMP application. Auto-
TFTP is disabled by default and must be configured through the CLI.

Figure 40: Using the Menu interface to disable TFTP

• While SFTP is enabled, TFTP and auto-TFTP cannot be enabled from the CLI. Attempting to enable either
non-secure TFTP option while SFTP is enabled produces one of the following messages in the CLI:

SFTP must be disabled before enabling tftp.

SFTP must be disabled before enabling auto-tftp.
Similarly, while SFTP is enabled, TFTP cannot be enabled using an SNMP management application.
Attempting to do so generates an "inconsistent value" message. (An SNMP management application cannot
be used to enable or disable auto-TFTP.)

• To enable SFTP by using an SNMP management application, you must first disable TFTP and, if configured,
auto-TFTP on the switch. You can use either an SNMP application or the CLI to disable TFTP, but you must
use the CLI to disable auto-TFTP.

The following CLI commands disable TFTP and auto-TFTP on the switch.

Syntax:

no tftp-enable
This command disables all TFTP operation on the switch except for the auto-TFTP feature. To re-enable TFTP
operation, use the tftp-enable command. When TFTP is disabled, the instances of tftp in the CLI copy
command and the Menu interface “Download OS” screen become unavailable.

This command does not disable auto-TFTP operation. To disable an auto- TFTP command
configured on the switch, use the no auto-tftp command described below to remove the
command entry from the switch’s configuration.
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Syntax:

no auto-tftp
If auto-TFTP is configured on the switch, this command deletes the auto-tftp entry from the switch
configuration, thus preventing auto-tftp operation if the switch reboots.

This command does not affect the current TFTP-enable configuration on the switch.

Enabling SSH V2 (required for SFTP)

switch(config)# ip ssh version 2

As a matter of policy, administrators should not enable the SSH V1-only or the SSH V1-or-V2
advertisement modes. SSHv1 is supported on only some legacy switches (such as the HPE Switch
Series 2500 switches).

Confirming that SSH is enabled

switch(config)# show ip ssh
Once you have confirmed that you have enabled an SSH session (with the show ip ssh command), enter ip
ssh filetransfer so that SCP and/or SFTP can run. You can then open your third-party software client
application to begin using the SCP or SFTP commands to safely transfer files or issue commands to the switch.

Any attempts to use SCP or SFTP without using ip ssh filetransfer cause the SCP or SFTP
session to fail. Depending on the client software in use, you will receive an error message on the
originating console, for Example:

IP file transfer not enabled on the switch
Disabling secure file transfer

switch(config)# no ip ssh filetransfer

Authentication
Switch memory allows up to ten public keys. This means the authentication and encryption keys you use for your
third-party client SCP/SFTP software can differ from the keys you use for the SSH session, even though both
SCP and SFTP use a secure SSH tunnel.

SSH authentication is mutually exclusive with RADIUS servers.

Some clients, such as PSCP (PuTTY SCP), automatically compare switch host keys for you. Other clients require
you to manually copy and paste keys to the $HOME/.ssh/known_hosts file. Whatever SCP/SFTP software tool
you use, after installing the client software you must verify that the switch host keys are available to the client.

Because the third-party software utilities you may use for SCP/SFTP vary, you should refer to the documentation
provided with the utility you select before performing this process.
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SCP/SFTP operating notes

• Any attempts to use SCP or SFTP without using ip ssh filetransfer will cause the SCP or SFTP session to fail.
Depending on the client software in use, you will receive an error message on the originating console, for
Example:

IP file transfer not enabled on the switch
• There is a delay when SFTP is copying an image onto the switch, and although the command prompt returns

in a couple of seconds, the switch may take approximately a minute and half writing the image to flash. You
can keep entering the show flash command to see when the copy is complete and the flash is updated. You
can also check the log for an entry similar to the following:

I 01/09/13 16:17:07 00150 update: Primary Image updated.

I 01/09/13 16:13:22 00636 ssh: sftp session from 15.22.22.03
• When an SFTP client connects, the switch provides a file system displaying all of its available files and folders.

No file or directory creation is permitted by the user. Files may be only uploaded or downloaded, according to
the permissions mask. All of the necessary files the switch needs are already in place on the switch. You do
not need to (nor can you) create new files.

• The switch supports one SFTP session or one SCP session at a time.

• All files have read-write permission. Several SFTP commands, such as create or remove, are not allowed
and return an error message. The switch displays the following files:

/
+---cfg
|   running-config
|   startup-config
+---log
|   crash-data
|   crash-data-a
|   crash-data-b 
|   crash-data-c 
|   crash-data-d 
|   crash-data-e            "      "
|   crash-data-f ""
|   crash-data-g
|   crash-data-h            "      "
|   crash-data-I ""
|   crash-data-J ""
|   crash-data-K ""
|   crash-data-L "    "
|   crash-log
|   crash-log-a
|   crash-log-b 
|   crash-log-c 
|   crash-log-d
|   crash-log-e""
|   crash-log-f""
|   crash-log-g
|   crash-log-h" "
|   crash-log-I" "
|   crash-log-J" "
|   crash-log-K" "
|   crash-log-L" "
|   event log
+---os
|   primary
|   secondary
\---ssh
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    +---mgr_keys
    |   authorized_keys
    \---oper_keys
    |   authorized_keys
\---core
|   port_1-24.cor    core-dump for ports 1-24 (stackable switches only)
|   port_25-48.cor   core-dump for ports 25-48 (stackable switches only)

Once you have configured your switch for secure file transfers with SCP and SFTP, files can be copied to or from
the switch in a secure (encrypted) environment and TFTP is no longer necessary.

Troubleshooting SSH, SFTP, and SCP operations

Cause

You can verify secure file transfer operations by checking the switch's event log, or by viewing the error messages
sent by the switch that most SCP and SFTP clients print out on their console.

Messages that are sent by the switch to the client depend on the client software in use to display
them on the user console.

Broken SSH connection
If an ssh connection is broken at the wrong moment (for instance, the link goes away or spanning tree brings
down the link), a fatal exception occurs on the switch. If this happens, the switch gracefully exits the session and
produces an Event Log message indicating the cause of failure. The following three examples show the error
messages that may appear in the log, depending on the type of session that is running (SSH, SCP, or SFTP):

ssh: read error Bad file number, session aborted I 01/01/90
00:06:11 00636 ssh: sftp session from ::ffff:10.0.12.35 W
01/01/90 00:06:26 00641 ssh:

sftp read error Bad file number, session aborted I 01/01/90
00:09:54 00637 ssh: scp session from ::ffff:10.0.12.35 W 01/
01/90

ssh: scp read error Bad file number, session aborted

The Bad file number is from the system error value and may differ depending on the cause of
the failure. In the third Example:, the device file to read was closed as the device read was about to
occur.

Attempt to start a session during a flash write
If you attempt to start an SCP (or SFTP) session while a flash write is in progress, the switch does not allow the
SCP or SFTP session to start. Depending on the client software in use, the following error message may appear
on the client console:

Received disconnect from 10.0.12.31: 2: Flash access in
progress

lost connection

Failure to exit from a previous session
This next Example: shows the error message that may appear on the client console if a new SCP (or SFTP)
session is started from a client before the previous client session has been closed (the switch requires
approximately ten seconds to timeout the previous session):
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Received disconnect from 10.0.12.31: 2: Wait for previous
session to complete

lost connection

Attempt to start a second session
The switch supports only one SFTP session or one SCP session at a time. If a second session is initiated (For
example, an SFTP session is running and then an SCP session is attempted), the following error message may
appear on the client console:

Received disconnect from 10.0.12.31: 2: Other SCP/SFTP
session running

lost connection

Using Xmodem to download switch software from a PC or UNIX
workstation
This procedure assumes that:

• The switch is connected via the Console RS-232 port to a PC operating as a terminal. (For information on
connecting a PC as a terminal and running the switch console interface, see the installation and getting started
guide you received with the switch.)

• The switch software is stored on a disk drive in the PC.

• The terminal emulator you are using includes the Xmodem binary transfer feature. (For example, in the
HyperTerminal application included with Windows NT, you would use the Send File option in the Transfer
drop-down menu.)

Downloading to primary flash using Xmodem (Menu)

The menu interface accesses only the primary flash.

Procedure

1. From the console Main Menu, select

7. Download OS

2. Press [E] (for Edit).

3. Use the Space bar to select XMODEM in the Method field.

4. Press [Enter], then [X] (for eXecute) to begin the software download.

The following message appears:

Press enter and then initiate Xmodem transfer from the attached computer.....

5. Press [Enter] and then execute the terminal emulator commands to begin Xmodem binary transfer.

For example, using HyperTerminal:
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a. Click on Transfer, then Send File.

b. Enter the file path and name in the Filename field.

c. In the Protocol field, select Xmodem.

d. Click on the [Send] button.

The download then commences. It can take several minutes, depending on the baud rate set in the switch and
in your terminal emulator.

6. After the primary flash memory has been updated with the new software, you must reboot the switch to
implement the newly downloaded software. Return to the Main Menu and press [6] (for Reboot Switch). You
then see the following prompt:

Continue reboot of system? : No

Press the space bar once to change No to Yes, then press [Enter] to begin the reboot.

7. To confirm that the software downloaded correctly:

a. From the Main Menu, select

1. Status and Counters

1. General System Information

b. Check the Firmware revision line.

Downloading to primary or secondary flash using Xmodem and a terminal emulator
(CLI)
Syntax:

copy xmodem flash [<primary | secondary>]
Downloads a software file to primary or secondary flash. If you do not specify the flash destination, the Xmodem
download defaults to primary flash.

Example:

To download a switch software file named E0822.swi from a PC (running a terminal emulator program such as
HyperTerminal) to primary flash:

Procedure

1. Execute the following command in the CLI:

switch# copy xmodem flash
Press 'Enter and start XMODEM on your host...

2. Execute the terminal emulator commands to begin the Xmodem transfer. For example, using HyperTerminal:

a. Click on Transfer, then Send File.

b. Type the file path and name in the Filename field.
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c. In the Protocol field, select Xmodem.

d. Click on the [Send] button.

The download can take several minutes, depending on the baud rate used in the transfer.

3. When the download finishes, you must reboot the switch to implement the newly downloaded software. To do
so, use one of the following commands:
Syntax:

boot system flash {<primary | secondary>}
Reboots from the selected flash

Syntax:

reload
Reboots from the flash image currently in use

For more information on these commands, see “Rebooting the Switches” in the basic operation guide for your
switch.

4. To confirm that the software downloaded correctly:

switch# show system
Check the Firmware revision line. It should show the software version that you downloaded in the preceding
steps.

If you need information on primary/secondary flash memory and the boot commands, see "Using Primary and
Secondary Flash Image Options" in the basic operation guide for your switch.

Switch-to-switch download
You can use TFTP to transfer a software image between two switches of the same series. The CLI enables all
combinations of flash location options. The menu interface enables you to transfer primary-to-primary or
secondary-to-primary.

Switch-to-switch download to primary flash (Menu)
Using the menu interface, you can download a switch software file from either the primary or secondary flash of
one switch to the primary flash of another switch of the same series.

Procedure

1. From the switch console Main Menu in the switch to receive the download, select 7. Download OS screen.

2. Ensure that the Method parameter is set to TFTP (the default).

3. In the TFTP Server field, enter the IP address of the remote switch containing the software file you want to
download.

4. For the Remote File Name , enter one of the following:

a. To download the software in the primary flash of the source switch, enter
flash
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in lowercase characters.

b. To download the software in the secondary flash of the source switch, enter
/os/secondary
.

5. Press [Enter], and then [X] (for eXecute ) to begin the software download.

A "progress" bar indicates the progress of the download. When the entire switch software download has been
received, all activity on the switch halts and the following messages appear:

Validating and writing system software to FLASH...

6. After the primary flash memory has been updated with the new software, you must reboot the switch to
implement the newly downloaded software. Return to the Main Menu and press [6] (for Reboot Switch ). You
then see this prompt:

Continue reboot of system? : No

Press the space bar once to change No to Yes, then press [Enter] to begin the reboot.

7. To confirm that the software downloaded correctly:

a. From the Main Menu, select

Status and Counters

General System Information

b. Check the Firmware revision line.

Downloading the OS from another switch (CLI)
Where two switches in your network belong to the same series, you can download a software image between
them by initiating a copy tftp command from the destination switch. The options for this CLI feature include:

• Copy from primary flash in the source to either primary or secondary in the destination.

• Copy from either primary or secondary flash in the source to either primary or secondary flash in the
destination.

Downloading from primary only (CLI)
Syntax:

copy tftp flash <ip-addr> flash [primary | secondary]
When executed in the destination switch, downloads the software flash in the source switch's primary flash to
either the primary or secondary flash in the destination switch.

If you do not specify either a primary or secondary flash location for the destination, the download automatically
goes to primary flash.

To download a software file from primary flash in a switch with an IP address of 10.29.227.103 to the primary flash
in the destination switch, you would execute the following command in the destination switch's CLI:
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Switch-to-switch, from primary in source to either flash in destination

switch# copy tftp flash 10.29.227.13 flash
Device will be rebooted, do you want to continue [y/n]? y
00107K 1

1Running Total of Bytes Downloaded

Downloading from either flash in the source switch to either flash in the destination
switch (CLI)
Syntax:

copy tftp flash <ip-addr> {</os/primary> | </os/secondary>} [primary | secondary]
This command (executed in the destination switch) gives you the most options for downloading between switches.
If you do not specify either a primary or secondary flash location for the destination, the download automatically
goes to primary flash.

To download a software file from secondary flash in a switch with an IP address of 10.28.227.103 to the
secondary flash in a destination switch, you would execute the following command in the destination switch's CLI:

Switch-to-switch, from either flash in source to either flash in destination

switch# copy tftp flash 10.29.227.13 flash /os/secondary secondary
Device will be rebooted, do you want to continue [y/n]? y
00184K

Using AirWave to update switch software
AirWave can be used to update HPE switch products. For further information, refer to the ZTP with Airwave
network Management chapter in this manual.

Using IMC to update switch software
IMC includes a software update utility for updating on HPE switch products. For further information, refer to the
getting started guide and the administrator’s guide, provided electronically with the application.

Copying software images
For details on how switch memory operates, including primary and secondary flash, see “Switch
Memory and Configuration” in the basic operation guide for your switch.

TFTP: Copying a software image to a remote host (CLI)
Syntax:

copy flash tftp <ip-addr> <filename>
Copies the primary flash image to a TFTP server.

Example:

To copy the primary flash to a TFTP server having an IP address of 10.28.227.105:
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switch# copy flash tftp 10.28.227.105 k0800.swi
where k0800.swi is the filename given to the flash image being copied.

Xmodem: Copying a software image from the switch to a serially connected
PC or UNIX workstation (CLI)
To use this method, the switch must be connected via the serial port to a PC or UNIX workstation.

Syntax:

copy flash xmodem {[<pc] | unix>}
Uses Xmodem to copy a designated configuration file from the switch to a PC or UNIX workstation.

Example:

To copy the primary flash image to a serially connected PC:

Procedure

1. Execute the following command:

switch# copy xmodem flash
Press 'Enter' and start XMODEM on your host...

2. After you see the above prompt, press [Enter].

3. Execute the terminal emulator commands to begin the file transfer.

Transferring switch configurations
Using the CLI commands described in the section beginning with TFTP: Copying a configuration file to a
remote host (CLI) on page 273, you can copy switch configurations to and from a switch, or copy a software
image to configure or replace an ACL in the switch configuration.

For greater security, you can perform all TFTP operations using SFTP, as described in the section 
Using SCP and SFTP on page 262.

You can also use the include-credentials command to save passwords, secret keys, and other
security credentials in the running config file. For more information, see the section on "Saving
Security Credentials in a Config File" in the access security guide for your switch.

TFTP: Copying a configuration file to a remote host (CLI)
Syntax:

copy {<startup-config | running-config>} tftp < ip-addr > < remote-file > [pc | unix]

copy config <filename> tftp <ip-addr> <remote-file> [pc | unix]
This command can copy a designated config file in the switch to a TFTP server. For more information, see
"Multiple Configuration Files" in the basic operation guide for your switch.

Example:

To upload the current startup configuration to a file named sw8200 in the configs directory on drive "d" in a TFTP
server having an IP address of 10.28.227.105:
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switch# copy startup-config tftp 10.28.227.105
   d:\configs\sw8200

TFTP: Copying a configuration file from a remote host (CLI)
Syntax:

copy tftp {<startup-config | running-config> < ip-address > < remote-file >} [pc | unix]

copy tftp config <filename> <ip-address> <remote-file> [pc | unix]
This command can copy a configuration from a remote host to a designated config file in the switch. For more
information, see "Multiple Configuration Files" in the basic operation guide for your switch.

For more information on flash image use, see "Using Primary and Secondary Flash Image Options" in the basic
operation guide for your switch.

Example:

To download a configuration file named sw8200 in the configs directory on drive "d" in a remote host having an
IP address of 10.28.227.105:

switch# copy tftp startup-config 10.28.227.105
   d:\configs\sw8200

TFTP: Copying a customized command file to a switch (CLI)
Using the copy tftp command with the show-tech option provides the ability to copy a customized command
file to the switch. When the show tech custom command is executed, the commands in the custom file are
executed instead of the hard-coded list of commands. If no custom file is found, the current hard-coded list is
executed. This list contains commands to display data, such as the image stamp, running configuration, boot
history, port settings, and so on.

Syntax:

copy tftp show-tech <ipv4 or ipv6 address> <filename>
Copies a customized command file to the switch (see Using the copy tftp show-tech command to upload a
customized command file on page 274).

Using the copy tftp show-tech command to upload a customized command file

switch(config)# copy tftp show-tech 10.10.10.3 commandfile1
Syntax:

show tech custom
Executes the commands found in a custom file instead of the hard-coded list.

Exit the global config mode (if needed) before executing show tech commands.

You can include show tech commands in the custom file, with the exception of show tech custom. For
example, you can include the command show tech all.

If no custom file is found, a message displays stating "No SHOW-TECH file found." (No custom file was uploaded
with the copy tftp show-tech command.)
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The show tech custom command

switch# show tech custom
No SHOW-TECH file found.

Xmodem: Copying a configuration file to a serially connected PC or UNIX
workstation (CLI)
To use this method, the switch must be connected via the serial port to a PC or UNIX workstation. You will need
to:

• Determine a filename to use

• Know the directory path you will use to store the configuration file.

Syntax:

copy {<startup-config | running-config>} xmodem {<pc | unix>}

copy config <filename> xmodem {<pc | unix>}
Uses Xmodem to copy a designated configuration file from the switch to a PC or UNIX workstation. For more
information, see "Multiple Configuration Files" in the basic operation guide for your switch.

Example:

To copy a configuration file to a PC serially connected to the switch:

1. Determine the file name and directory location on the PC.

2. Execute the following command:

switch# copy startup-config xmodem pc
Press 'Enter' and start XMODEM on your host...

3. After you see the above prompt, press [Enter].

4. Execute the terminal emulator commands to begin the file transfer.

Xmodem: Copying a configuration file from a serially connected PC or
UNIX workstation (CLI)
To use this method, the switch must be connected via the serial port to a PC or UNIX workstation on which is
stored the configuration file you want to copy. To complete the copying, you need to know the name of the file to
copy and the drive and directory location of the file.

Syntax:

copy xmodem startup-config {<pc | unix>}

copy xmodem config <filename> < {pc | unix>}
Copies a configuration file from a serially connected PC or UNIX workstation to a designated configuration file on
the switch.

For more information, see "Multiple Configuration Files" in the basic operation guide for your switch.
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Example:

To copy a configuration file from a PC serially connected to the switch:

Procedure

1. Execute the following command:

switch# copy xmodem startup-config pc
Device will be rebooted, do you want to continue [y/n]? y
Press 'Enter' and start XMODEM on your host...

2. After you see the above prompt, press [Enter].

3. Execute the terminal emulator commands to begin the file transfer.

4. When the download finishes, you must reboot the switch to implement the newly downloaded software. To do
so, use one of the following commands:

Syntax:

boot system flash [primary | secondary]

boot system flash [config < filename >]
Switches boot from the designated configuration file. For more information, see "Multiple Configuration Files"
in the basic operation guide for your switch.

Syntax:

reload

Reboots from the flash image currently in use.

(For more on these commands, see "Rebooting the Switch" in the basic operation guide for your switch.)

Copying diagnostic data to a remote host, PC or UNIX
workstation
You can use the CLI to copy the following types of switch data to a text file in a destination device:

Command output

Sends the output of a switch CLI command as a file on the destination device.

Event log

Copies the switch's Event Log into a file on the destination device.

Crash data

Software-specific data useful for determining the reason for a system crash.

Crash log

Processor-specific operating data useful for determining the reason for a system crash.

Flight data recorder (FDR) logs

Information that is “interesting” at the time of the crash, as well as when the switch is not performing correctly
but has not crashed.

The destination device and copy method options are as follows (CLI keyword is in bold):
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• Remote Host via TFTP.

• Serially connected PC or UNIX workstation via Xmodem.

Copying command output to a destination device (CLI)
Syntax:

copy command-output <"cli-command"> tftp <ip-address> <filepath-filename>

copy command-output <"cli-command"> xmodem
Example:

To use Xmodem to copy the output of show config to a serially connected PC:

Figure 41: Sending command output to a file on an attached PC

The command you specify must be enclosed in double quotation marks.

Copying Event Log output to a destination device (CLI)
Syntax:

copy event-log tftp <ip-address> <filepath_filename>

copy event-log xmodem <filename>
Example:

To copy the event log to a PC connected to the switch:

Figure 42: Sending event log content to a file on an attached PC

Copying crash data content to a destination device (CLI)
This command uses TFTP, USB or Xmodem to copy the Crash Data content to a destination device.

Syntax:

copy crash-data tftp <ip-address> <filename>

copy crash-data xmodem
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These commands copy the crash data content to a remote host, attached USB device, or to a serially connected
PC or UNIX workstation.

slot-id a - h—Retrieves the crash log or crash data from the processor on the module in the specified
slot

mm Retrieves crash log or crash data from the switch's chassis processor. When "mm" is specified,
crash files from both management modules are copied.

oobm For switches that have a separate OOBM port, specifies that the transfer is through the OOBM
interface. (Default is transfer through the data interface.)

You can copy individual slot information or the management module (mm) switch information. If you do not specify
either, the command defaults to the mm data.

To copy the switch's crash data to a file in a PC:

Copying switch crash data content to a PC

switch(config)# copy crash-data xmodem pc
Press 'Enter' and start XMODEM on your host... 

Transfer complete

At this point press [Enter] and start the Xmodem command sequence in your terminal emulator.
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Overview
The switches have several built-in tools for monitoring, analyzing, and troubleshooting switch and network
operation:

• Status: Includes options for displaying general switch information, management address data, port status, port
and trunk group statistics, MAC addresses detected on each port or VLAN, and STP, IGMP, and VLAN data.

• Counters: Display details of traffic volume on individual ports.

• Event Log: Lists switch operating events (Using the Event Log for troubleshooting switch problems on
page 327 ).

• Alert Log: Lists network occurrences detected by the switch—in the System > Logging screen of the
WebAgent.

• Configurable trap receivers: Uses SNMP to enable management stations on your network to receive SNMP
traps from the switch.

• Port monitoring (mirroring): Copy all traffic from the specified ports to a designated monitoring port.

• Chassis Locator LED: The blue Locator LED lights up when you enter the chassislocate command.

Link test and ping test—analysis tools in troubleshooting situations—are described in 
Troubleshooting on page 303. See Diagnostic tools on page 365.

Accessing port and trunk group statistics
Use the CLI to view port counter summary reports, and to view detailed traffic summary for specific ports.

show interfaces
Syntax
show interfaces <PORT-LIST>
        
Description

Provides an overview of port activity for all ports on the switch or for the ports you specify. Displays the totals
accumulated since the last boot or the last execution of the clear statistics command.

Parameters and options
<PORT-LIST>

View port activity for specific ports.

Reset port counters
When troubleshooting network issues, you can clear all counters and statistics without rebooting the switch using
the clear statistics global command or using the menu.

Chapter 16
Monitoring and Analyzing Switch Operation
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SNMP displays the counter and statistics totals accumulated since the last reboot, and it is not affected by the
clear statistics global command or the clear statistics <PORT-LIST> command. Clearing
statistics initiates an SNMP trap.

Once cleared, statistics cannot be reintroduced.

clear statistics
Syntax
clear statistics [<PORT-LIST>|global]
      
Description

This command clears all counters and statistics for all interfaces except SNMP.

Parameters and options
<PORT-LIST>

Clears the counters and statistics for specific ports.

global
Clears all counters and statistics for all interfaces except SNMP.
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Accessing port and trunk statistics (Menu)

Procedure

1. From the Main Menu, select 1. Status and Counters ... , and then select 4. Port Counters.

Figure 43: Example of port counters on the menu interface

2. To view details about the traffic on a particular port, use the ↓ key to highlight that port number, and then select
Show Details . For example, selecting port A2 displays a screen similar to the example below.

Figure 44: Example of the display for Show Details on a selected port

This screen also includes the Reset action for the current session.

MAC address tables

MAC address views and searches
You can view and search MAC addresses using the CLI or the menu.

show mac-address
Syntax
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show mac-address [vlan <VLAN-ID>] [<PORT-LIST>] [<MAC-ADDR>]
Description

Lists all MAC addresses on the switch and their corresponding port numbers. You can also choose to list specific
addresses and ports, or addresses and ports on a VLAN. The switches operate with a multiple forwarding
database architecture.

List all learned MAC addresses on the switch and corresponding port numbers

switch# show mac-address

List all learned MAC addresses on one or more ports and corresponding port numbers

switch# show mac-address a1-a4,a6

List all learned MAC addresses on a VLAN and corresponding port numbers

switch# show mac-address vlan 100

List the port on which the switch learned a specific MAC address

To find the port on which the switch learns a MAC address of 080009-21ae84:

Using the menu to view and search MAC addresses
To determine which switch port on a selected VLAN the switch uses to communicate with a specific device on the
network:

Procedure

1. From the Main Menu, select 1. Status and Counters ... , and then select 5. VLAN Address Table.

2. Use the arrow keys to scroll to the VLAN you want, and then press Enter on the keyboard to select it.
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The switch then displays the MAC address table for that VLAN (Figure 45: Example of the address table on
page 283.)

Figure 45: Example of the address table

3. To page through the listing, use Next page and Prev page .

Finding the port connection for a specific device on a VLAN
This feature uses a device's MAC address that you enter to identify the port used by that device.

Procedure

1. Proceeding from Figure 45: Example of the address table on page 283, press [S] (for Search ), to display
the following prompt:

Enter MAC address: _
2. Enter the MAC address you want to locate and press [Enter].
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3. The address and port number are highlighted if found (Figure 46: Example of menu indicating located MAC
address on page 284.) If the switch does not find the MAC address on the currently selected VLAN, it leaves
the MAC address listing empty.

Figure 46: Example of menu indicating located MAC address

4. Press [P] (for Prev page ) to return to the full address table listing.

Viewing and searching port-level MAC addresses
This feature displays and searches for MAC addresses on the specified port instead of for all ports on the switch.

Procedure

1. From the Main Menu, select:

1. Status and Counters ...

7. Port Address Table

2. Use the Space bar to select the port you want to list or search for MAC addresses, then press [Enter] to list
the MAC addresses detected on that port.

Determining whether a specific device is connected to the selected port
Proceeding from Step 2, above:

Procedure

1. Press [S] (for Search), to display the following prompt:

Enter MAC address: _
2. Enter the MAC address you want to locate and press [Enter].

The address is highlighted if found. If the switch does not find the address, it leaves the MAC address listing
empty.

3. Press [P] (for Prev page) to return to the previous per-port listing.

MSTP data
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show spanning-tree
Syntax
show spanning-tree
Description

Displays the global and regional spanning-tree status for the switch, and displays the per-port spanning-tree
operation at the regional level.

Values for the following parameters appear only for ports connected to active devices: Designated Bridge,
Hello Time, PtP, and Edge.

show spanning-tree command output

Figure 47: show spanning-tree command output

IP IGMP status

Chapter 16 Monitoring and Analyzing Switch Operation 285

Anexo 04 ITEM 10 (0592646)         SEI 0008478-63.2018.6.02.8000 / pg. 5344



show ip igmp
Syntax
show ip igmp <VLAN-ID> [config] [group <IP-ADDR>|groups] [statistics]
        
Description

Global command that lists IGMP status for all VLANs configured in the switch, including:

• VLAN ID (VID) and name

• Querier address

• Active group addresses per VLAN

• Number of report and query packets per group

• Querier access port per VLAN

Parameters and options
config

Displays the IGMP configuration information, including VLAN ID, VLAN name, status, forwarding, and Querier
information.

vlan-id

Per-VLAN command listing above, IGMP status for specified VLAN (VID).

group <IP-ADDR>
Lists the ports currently participating in the specified group, with port type, Access type, Age Timer data and
Leave Timer data.

groups
Displays VLAN-ID, group address, uptime, expiration time, multicast filter type, and the last reporter for IGMP
groups.

statistics
Displays IGMP operational information, such as VLAN IDs and names, and filtered and flooding statistics.

Output from show ip igmp config command

IGMP statistical information

switch(vlan-2)# show ip igmp statistics

 IGMP Service Statistics
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  Total VLANs with IGMP enabled               : 1
  Current count of multicast groups joined    : 1

 IGMP Joined Groups Statistics

  VLAN ID VLAN Name                        Filtered     Flood
  ------- -------------------------------- ------------ ------------
  2       VLAN2                            2            1

VLAN information

show vlan
Syntax
show vlan <VLAN-ID>
        
Description

Lists the maximum number of VLANs to support, existing VLANS, VLAN status (static or dynamic), and primary
VLAN.

Parameters and options
<VLAN-ID>

Lists the following for the specified VLAN:

• Name, VID, and status (static/dynamic)

• Per-port mode (tagged, untagged, forbid, no/auto)

• "Unknown VLAN" setting (Learn, Block, Disable)

• Port status (up/down)

List data on specific VLANs

The next three figures show how you can list data for the following VLANs:

Ports VLAN VID

A1-A12 DEFAULT_VLAN 1

Table Continued
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A1, A2 VLAN-33 33

A3, A4 VLAN-44 44

Figure 48: Listing the VLAN ID (vid) and status for specific ports

Figure 49: Example of VLAN listing for the entire switch

Figure 50: Port listing for an individual VLAN

Configuring a source switch in a local mirroring session
Enter the mirror port command on the source switch to configure an exit port on the same switch. To create
the mirroring session, use the information gathered in High-level overview of the mirror configuration process
on page 292.

288 Aruba 2530 Management and Configuration Guide for ArubaOS-Switch 16.05

Anexo 04 ITEM 10 (0592646)         SEI 0008478-63.2018.6.02.8000 / pg. 5347



Syntax

mirror 1 - 4 port exit-port-# [name name-str] no mirror 1- 4
Assigns the exit port to use for the specified mirroring session and must be executed from the global configuration
level.

1 - 4 Identifies the mirroring session created by this command. (Multiple
sessions on the switch can use the same exit port.)

name name-str Optional alphanumeric name string used to identify the session
( up to 15 characters)

port exit-port-
#

Exit port for mirrored traffic in the remote session. This is the port
to which a traffic analyzer or IDS is connected.

The no form of the command removes the mirroring session and any mirroring source previously assigned to that
session.

Selecting all traffic on a port interface for mirroring
according to traffic direction
Syntax

[no] interface port/trunk/mesh monitor [in | out | both] [mirror 1 - 4 | name-str] 
[{1 - 4 | name-str} | {1 - 4 | name-str} | {1 - 4 | name-str}] [no-tag-added]
Assigns a mirroring source to a previously configured mirroring session on a source switch by specifying the port,
trunk, and/or mesh sources to use, the direction of traffic to mirror, and the session.

interface port/trunk/mesh Identifies the source ports, static trunks, and/or mesh on which to mirror
traffic.

Use a hyphen for a range of consecutive ports or trunks (a5-a8, Trk2-
Trk4.)

Use a comma to separate non-contiguous interfaces (b11, b14, Trk4,
Trk7.)

monitor all [in | out | 
both]

For the interface specified by port/trunk/mesh , selects traffic to mirror based
on whether the traffic is entering or leaving the switch on the interface:

• in: Mirrors entering traffic.

• out: Mirrors exiting traffic.

• both: Mirrors traffic entering and exiting.

If you enter the monitor all command without selection criteria or a
session identifier, the command applies by default to session 1

Table Continued
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mirror [1 - 4 | name-str]
Assigns the traffic specified by the interface and direction to a session by
number or—if configured—by name. The session must have been
previously configured.

Depending on how many sessions are already configured on the switch, you
can use the same command to assign the specified source to up to four
sessions, for example, interface a1 monitor all in mirror 1 2
4.

• 1 - 4: Configures the selected port traffic to be mirrored in the specified
session number.

• [ name name-str]: Optional; configures the selected port traffic to be
mirrored in the specified session name. The string can be used
interchangeably with the session number when using this command to
assign a mirroring source to a session.

[no-tag-added] Prevents a VLAN tag from being added to the mirrored copy of an outbound
packet sent to a local or remote mirroring destination.

The no form of the command removes a mirroring source assigned to the session, but does not remove the
session itself. This enables you to repurpose a session by removing an unwanted mirroring source and adding
another in its place.

Viewing all mirroring sessions configured on the switch
Syntax

show monitor
If a monitored source for a remote session is configured on the switch, the following information is displayed.
Otherwise, the output displays: Mirroring is currently disabled.

Sessions Lists the four configurable sessions on the switch.

Status Displays the current status of each session:

• active: The session is configured.

• inactive: Only the destination has been configured; the mirroring source is not configured.

• not defined: Mirroring is not configured for this session.

Type Indicates whether the mirroring session is local (port), remote (IPv4), or MAC-based (mac) for
local or remote sessions.

Sources Indicates how many monitored source interfaces are configured for each mirroring session.

Policy Indicates whether the source is using a classifier-based mirroring policy to select inbound IPv4
or IPv6 traffic for mirroring.

If a remote mirroring endpoint is configured on the switch, the following information is displayed. Otherwise, the
output displays: There are no Remote Mirroring endpoints currently assigned.
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Type Indicates whether the mirroring session is local (port), remote (IPv4), or MAC-based
(mac) for local or remote sessions.

UDP Source Addr The IP address configured for the source VLAN or subnet on which the monitored
source interface exists. In the configuration of a remote session, the same UDP source
address must be configured on the source and destination switches.

UDP port The unique UDP port number that identifies a remote session. In the configuration of a
remote session, the same UDP port number must be configured on the source and
destination switches.

UDP Dest Addr The IP address configured for the destination VLAN or subnet on which the remote exit
port exists. In the configuration of a remote session, the same UDP destination address
must be configured on the source and destination switches.

Dest Port Identifies the exit port for a remote session on a remote destination switch.

Figure 51: Displaying the currently configured mirroring sessions on the switch

Viewing the mirroring configuration for a specific session
Syntax

show monitor [1 - 4 | name name-str]
Displays detailed configuration information for a specified local mirroring session on a source switch.

Session Displays the number of the specified session.

Session Name Displays the name of the session, if configured.

Policy Indicates whether the source is using a classifier-based mirroring policy to select
inbound IPv4 or IPv6 traffic for mirroring.

Mirroring Destination For a local mirroring session, displays the port configured as the exit port on the source
switch.

Table Continued
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Monitoring Sources For the specified local session, displays the source (port, trunk, or VLAN) interface and
the MAC address (if configured) used to select mirrored traffic.

Direction For the selected interface, indicates whether mirrored traffic is entering the switch (in),
leaving the switch (out), or both.

Using the Menu to configure local mirroring

Menu and WebAgent limits
You can use the Menu and WebAgent to quickly configure or reconfigure local mirroring on session 1 and allow
one of the following two mirroring source options:

• Any combination of source ports, trunks, and a mesh.

• One static, source VLAN interface.

The Menu and WebAgent also has these limits:

• Configure and display only session 1 and only as a local mirroring session for traffic in both directions on the
specified interface. (Selecting inbound-only or outbound-only is not an option.)

• If session 1 has been configured in the CLI for local mirroring for inbound-only or outbound-only traffic on one
or more interfaces, using the Menu to change the session 1 configuration automatically reconfigures the
session to monitor both inbound and outbound traffic on the designated interface(s.)

• If session 1 has been configured in the CLI with an ACL/classifier-based mirroring policy or as a remote
mirroring session, the Menu is not available for changing the session 1 configuration.

• The CLI (and SNMP) can be used to override any Menu configuration of session 1.

High-level overview of the mirror configuration process

Determine the mirroring session and destination

For a local mirroring session
Determine the port number for the exit port (such as A5, B10, and so forth), then go to Configure the monitored
traffic in a mirror session.

Configure the monitored traffic in a mirror session
This step configures one or more interfaces on a source switch with traffic-selection criteria to select the traffic to
be mirrored in a local session configured in section.

Classifier-based mirroring configuration
1. Evaluate the types of traffic in your network and identify the traffic types that you want to mirror.

2. Create an IPv4 or IPv6 traffic class using the class command to select the packets that you want to mirror in
a session on a preconfigured local or remote destination device.

A traffic class consists of match criteria, which consist of match and ignore commands.
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• match commands define the values that header fields must contain for a packet to belong to the class and
be managed by policy actions.

• ignore commands define the values which, if contained in header fields, exclude a packet from the policy
actions configured for the class.

Be sure to enter match/ignore statements in the precise order in which you want their criteria to
be used to check packets.

The following match criteria are supported in match/ignore statements for inbound IPv4/IPv6 traffic:

• IP source address (IPv4 and IPv6)

• IP destination address (IPv4 and IPv6)

• IP protocol (such as ICMP or SNMP)

• Layer 3 IP precedence bits

• Layer 3 DSCP codepoint

• Layer 4 TCP/UDP application port (including TCP flags)

• VLAN ID

Enter one or more match or ignore commands from the class configuration context to filter traffic and
determine the packets on which policy actions will be performed.

3. Create a mirroring policy to configure the session and destination device to which specified classes of inbound
traffic are sent by entering the policy mirror command from the global configuration context.

Be sure to enter each class and its associated mirroring actions in the precise order in which you
want packets to be checked and processed.

To configure the mirroring actions that you want to execute on packets that match the criteria in a specified
class, enter one or more class action mirror commands from the policy configuration context.

You can configure only one mirroring session (destination) for each class. However, you can configure the
same mirroring session for different classes.

A packet that matches the match criteria in a class is mirrored to the exit (local or remote) port that has been
previously configured for the session, where session is a value from 1 to 4 or a text string (if you configured the
session with a name when you entered the mirror command.)

Prerequisite: The local or remote exit port for a session must be already configured before you enter the
mirror session parameter in a class action statement:

• In a local mirroring session, the exit port is configured with the mirror <session-number> port
command

• In a remote mirroring session, the remote exit port is configured with the mirror endpoint ip and
mirror <session-number> remote ip commands.

Restriction: In a policy, you can configure only one mirroring session per class. However, you can configure the
same session for different classes.

Mirroring is not executed on packets that match ignore criteria in a class.
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The execution of mirroring actions is performed in the order in which the classes are numerically listed in the
policy.

The complete no form of the class action mirror command or the no <seq-number> command
removes a class and mirroring action from the policy configuration.

To manage packets that do not match the match or ignore criteria in any class in the policy, and therefore have
no mirroring actions performed on them, you can enter an optional default class. The default class is placed at
the end of a policy configuration and specifies the mirroring actions to perform on packets that are neither
matched nor ignored.

4. (Optional) To configure a default-class in a policy, enter the default-class command at the end of a policy
configuration and specify one or more actions to be executed on packets that are not matched and not
ignored.

Prerequisite: The local or remote exit port for a session must be already configured with a destination device
before you enter the mirror <session> parameter in a default-class action statement.

5. Apply the mirroring policy to inbound traffic on a port (interface service-policy in command) or VLAN
(vlan service-policy in command) interface.

After you apply a mirroring policy for one or more preconfigured sessions on a port or VLAN
interface, the switch immediately starts to use the traffic-selection criteria and exit port to mirror
traffic to the destination device connected to each exit port.

In a remote mirroring session that uses IPv4 encapsulation, if the remote switch is not already
configured as the destination for the session, its performance may be adversely affected by the
stream of mirrored traffic.

For this reason, Hewlett Packard Enterprise strongly recommends that you first configure the exit
switch in a remote mirroring session before you apply a mirroring service policy on a port or VLAN
interface.

Restrictions: The following restrictions apply to a mirroring service policy:

• Only one mirroring policy is supported on a port or VLAN interface.

• If you apply a mirroring policy to a port or VLAN interface on which a mirroring policy is already configured,
the new policy replaces the existing one.

• A mirroring policy is supported only on inbound traffic.

Because only one mirroring policy is supported on a port or VLAN interface, ensure that the policy you want to
apply contains all the required classes and actions for your configuration.

Classifier-based mirroring restrictions
The following restrictions apply to mirroring policies configured with the classifier-based model:

• A mirroring policy is supported only on inbound IPv4 or IPv6 traffic.

• A mirroring policy is not supported on a meshed port interface. (Classifier-based policies are supported only on
a port, VLAN, or trunk interface.)

• Only one classifier-based mirroring policy is supported on a port or VLAN interface. You can, however, apply a
classifier-based policy of a different type, such as QoS.

• You can enter multiple class action mirror statements in a policy.
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◦ You can configure only one mirroring session (destination) for each class.

◦ You can configure the same mirroring session for different classes.

• If a mirroring session is configured with a classifier-based mirroring policy on a port or VLAN interface, no
other traffic-selection criteria (MAC-based or all inbound and/or outbound traffic) can be added to the session.

Figure 52: Mirroring configuration in which only a mirroring policy is supported

• If a mirroring session is already configured with one or more traffic-selection criteria (MAC-based or all inbound
and/or outbound traffic), the session does not support the addition of a classifier-based policy.

Figure 53: Mirroring configuration in which only traffic-selection criteria are supported

Mirroring configuration examples

Local mirroring using traffic-direction criteria

An administrator wants to mirror the inbound traffic from workstation "X" on port A5 and workstation "Y" on port
B17 to a traffic analyzer connected to port C24 (see Figure 54: Local mirroring topology on page 296.) In this
case, the administrator chooses "1" as the session number. (Any unused session number from 1 to 4 is valid.)
Because the switch provides both the source and destination for the traffic to monitor, local mirroring can be used.
In this case, the command sequence is:
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• Configure the local mirroring session, including the exit port.

• Configure the monitored source interfaces for the session.

Figure 54: Local mirroring topology

Figure 55: Configuring a local mirroring session for all inbound and outbound port traffic

Maximum supported frame size
The IPv4 encapsulation of mirrored traffic adds a 54-byte header to each mirrored frame. If a resulting frame
exceeds the MTU allowed in the network, the frame is dropped or truncated.

Oversized mirroring frames are dropped or truncated, according to the setting of the [truncation]
parameter in the mirror command. Also, remote mirroring does not allow downstream devices in a
mirroring path to fragment mirrored frames.

If jumbo frames are enabled on the mirroring source switch, the mirroring destination switch and all
downstream devices connecting the source switch to the mirroring destination must be configured to
support jumbo frames.

Enabling jumbo frames to increase the mirroring path MTU
On 1-Gbps and 10-Gbps ports in the mirroring path, you can reduce the number of dropped frames by enabling
jumbo frames on all intermediate switches and routers. (The MTU on the switches covered by this manual is 9220
bytes for frames having an 802.1Q VLAN tag, and 9216 bytes for untagged frames.)
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Table 23: Maximum frame sizes for mirroring

Frame type
configuration

Maximum
frame size

VLAN tag Frame
mirrored
to local
port

Frame mirrored to remote
port

Data Data IPv4 header

Untagged Non-jumbo (default
config.)

1518 0 1518 1464 54

Jumbo on all VLANs 9216 0 9216 9162 54

Jumbo11 On all but
source VLAN

1518 0 n/a 1464 54

Tagged Non-jumbo 1522 4 1522 1468 54

Jumbo11 on all VLANs 9220 4 9218 9164 54

Jumbo11 On all but
source VLAN

1522 4 n/a22 1468 54

1 Jumbo frames are allowed on ports operating at or above 1 Gbps
2 For local mirroring, a non-jumbo configuration on the source VLAN dictates an MTU of 1518 bytes for untagged frames, and

an MTU of 1522 for tagged frames, regardless of the jumbo configuration on any other VLANs on the switch.

Effect of downstream VLAN tagging on untagged,
mirrored traffic
In a remote mirroring application, if mirrored traffic leaves the switch without 802.1Q VLAN tagging, but is
forwarded through a downstream device that adds 802.1Q VLAN tags, the MTU for untagged mirrored frames
leaving the source switch is reduced below the values shown in Maximum frame sizes for mirroring.
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For example, if the MTU on the path to the destination is 1522 bytes, untagged mirrored frames leaving the
source switch cannot exceed 1518 bytes. Likewise, if the MTU on the path to the destination is 9220 bytes,
untagged mirrored frames leaving the source switch cannot exceed 9216 bytes.

Figure 56: Effect of downstream VLAN tagging on the MTU for mirrored traffic

Operating notes for traffic mirroring

• Mirroring dropped traffic

When an interface is configured to mirror traffic to a local or remote destination, packets are mirrored
regardless of whether the traffic is dropped while on the interface. For example, if an ACL is configured on a
VLAN with a deny ACE that eliminates packets from a Telnet application, the switch still mirrors the Telnet
packets that are received on the interface and subsequently dropped.

• Mirroring and spanning tree

Mirroring is performed regardless of the STP state of a port or trunk. This means, for example, that inbound
traffic on a port blocked by STP can still be monitored for STP packets during the STP setup phase.

• Tagged and untagged frames

For a frame entering or leaving the switch on a mirrored port, the mirrored copy retains the tagged or untagged
state the original frame carried when it entered into or exited from the switch. (The tagged or untagged VLAN
membership of ports in the path leading to the mirroring destination does not affect the tagged or untagged
status of the mirrored copy itself.)

Thus, if a tagged frame arrives on a mirrored port, the mirrored copy is also tagged, regardless of the status of
ports in the destination path. If a frame exits from the switch on a mirrored port that is a tagged member of a
VLAN, the mirrored copy is also tagged for the same reason.

To prevent a VLAN tag from being added to the mirrored copy of an outbound packet sent to a mirroring
destination, you must enter the no-tag-added parameter when you configure a port, trunk, or mesh interface
to select mirrored traffic.

• Effect of IGMP on mirroring

If both inbound and outbound mirroring is operating when IGMP is enabled on a VLAN, two copies of mirrored
IGMP frames may appear at the mirroring destination.
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• Mirrored traffic not encrypted

Mirrored traffic undergoes IPv4 encapsulation, but mirrored encapsulated traffic is not encrypted.

• IPv4 header added

The IPv4 encapsulation of mirrored traffic adds a 54-byte header to each mirrored frame. If a resulting frame
exceeds the maximum MTU allowed in the network, it is dropped or truncated (according to the setting of the
[truncation] parameter in the mirror command.)

To reduce the number of dropped frames, enable jumbo frames in the mirroring path, including all intermediate
switches and/or routers. (The MTU on the switch is 9220 bytes, which includes 4 bytes for the 802.1Q VLAN
tag.)

• Intercepted or injected traffic

The mirroring feature does not protect against either mirrored traffic being intercepted or traffic being injected
into a mirrored stream by an intermediate host.

• Inbound mirrored IPv4-encapsulated frames are not mirrored

The switch does not mirror IPv4-encapsulated mirrored frames that it receives on an interface. This prevents
duplicate mirrored frames in configurations where the port connecting the switch to the network path for a
mirroring destination is also a port whose inbound or outbound traffic is being mirrored.

For example, if traffic leaving the switch through ports B5, B6, and B7 is being mirrored through port B7 to a
network analyzer, the mirrored frames from traffic on ports B5 and B6 will not be mirrored a second time as
they pass through port B7.

• Switch operation as both destination and source

A switch configured as a remote destination switch can also be configured to mirror traffic to one of its own
ports (local mirroring) or to a destination on another switch (remote mirroring.)

• Monitor command note

If session 1 is already configured with a destination, you can enter the [no] vlan <VID>monitor or [no]
interface <PORT> monitor command without mirroring criteria and a mirror session number. In this
case, the switch automatically configures or removes mirroring for inbound and outbound traffic from the
specified VLAN or ports to the destination configured for session 1.

• Loss of connectivity suspends remote mirroring

When a remote mirroring session is configured on a source switch, the switch sends an ARP request to the
configured destination approximately every 60 seconds. If the source switch fails to receive the expected ARP
response from the destination for the session, transmission of mirrored traffic in the session halts. However,
because the source switch continues to send ARP requests for each configured remote session, link
restoration or discovery of another path to the destination enables the source switch to resume transmitting the
session's mirrored traffic after a successful ARP response cycle occurs.

Note that if a link's connectivity is repeatedly interrupted ("link toggling"), little or no mirrored traffic may be
allowed for sessions using that link. To verify the status of any mirroring session configured on the source
switch, use the show monitor command.
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Troubleshooting traffic mirroring
Cause

If mirrored traffic does not reach the configured remote destination (endpoint) switch or remote exit port, check the
following configurations:

• If the destination for mirrored traffic is on a different VLAN than the source, routing must be correctly
configured along the path from the source to the destination.

• All links on the path from the source switch to the destination switch must be active.

A mirroring exit port should be connected only to a network analyzer, IDS, or other network edge
device that has no connection to other network resources. Configuring a mirroring exit port
connection to a network can result in serious network performance problems, and is strongly
discouraged by HPE Aruba.

Interface monitoring features
You can designate monitoring of inbound and outbound traffic on ports and static trunks. This allows the
monitoring of individual ports, groups of contiguous ports, and static port trunks.

The switch monitors network activity by copying all traffic inbound and outbound on the specified interfaces to the
designated monitoring port, to which a network analyzer can be attached.

If a tagged packet arrives on a monitored port, the packet will remain tagged when it goes out a monitored port
even if that port is configured as untagged. If the packet is untagged, it will remain untagged going out the monitor
port. The monitor port state (tagged or untagged) does not affect the tagging of the packet. However, egress
mirroring does not reflect the tagged or untagged characteristic to the mirror port, instead it reflects the tagged or
untagged characteristic of the mirror port.

When both inbound and outbound monitoring is done, and IGMP is enabled on any VLAN, you may
get two copies of IGMP packets on the monitored port.

VLANs and port trunks cannot be used as a monitoring port.

The switch can monitor static LACP trunks, but not dynamic LACP trunks.

It is possible, when monitoring multiple interfaces in networks with high traffic levels, to copy more
traffic to a monitor port than the link can support. In this case, some packets may not be copied to
the monitor port.

Configuring port and static trunk monitoring (Menu)
This procedure describes configuring the switch for monitoring when monitoring is disabled. (If monitoring has
already been enabled, the screens will appear differently than shown in this procedure.)

1. From the console Main Menu, select:2. Switch Configuration... 3. Network Monitoring Port

2. In the Actions menu, press [E] (for Edit).

3. If monitoring is currently disabled (the default) then enable it by pressing the Space bar (or [Y]) to select Yes.

4. Press the down arrow key to display a screen similar to the following and move the cursor to the Monitoring
Port parameter.

5. Use the Space bar to select the port to use for monitoring.
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6. Use the down arrow key to move the cursor to the Action column for the individual ports and position the
cursor at a port you want to monitor.

7. Press the Space bar to select Monitor for each port and trunk that you want monitored. (Use the down arrow
key to move from one interface to the next in the Action column.)

8. When you finish selecting ports to monitor, press [Enter], then press [S] (for Save ) to save your changes and
exit from the screen.

9. Return to the Main Menu.

Configuring port and static trunk monitoring (CLI)
You must use the following configuration sequence to configure port and static trunk monitoring in the CLI:

1. Assign a monitoring (mirror) port.

2. Designate the port(s) and/or static trunk(s) to monitor.

Displaying the monitoring configuration
Syntax:

show monitor
This command lists the port assigned to receive monitored traffic and the ports and/or trunks being monitored.

For example, if you assign port 5 as the monitoring port and configure the switch to monitor ports 2-4, show
monitor displays the following:

Monitored port listing

switch(config)# show monitor

 Network Monitoring Port

  Mirror Port: 4

  Monitoring sources 
  ------------------
  2
  3
  4

• Port receiving monitored traffic.

• Monitored ports

Configuring the monitor port
Syntax:
[no] mirror-port [ <port-num> ]
    
This command assigns or removes a monitoring port, and must be executed from the global configuration level.
Removing the monitor port disables port monitoring and resets the monitoring parameters to their factory-default
settings.
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For example, to assign port 6 as the monitoring port:

switch(config)# mirror-port 6
To turn off monitoring:

switch(config)# no mirror-port

Selecting or removing monitoring source interfaces
After you configure a monitor port you can use either the global configuration level or the interface context level to
select ports or static trunks as monitoring sources. You can also use either level to remove monitoring sources.

Syntax:
[no] interface <monitor-list> monitor
    
<monitor-list>

Includes port numbers and static trunk names such as 4, 7, 5-8, trk1

Identifies the switch elements to monitor through the currently configured monitor port. You can monitor the ports
and static trunks available on the switch.

Elements in the monitor list can include port numbers and static trunk names at the same time.

For example, with a port such as port 6 configured as the monitoring (mirror) port, you would use either of the
following commands to select these interfaces for monitoring:

• 1–3, and 5

• Trunk 2

Selecting ports and static trunks as monitoring sources

switch(config)# int 1-3, 5, trk2, monitor

Disabling monitoring at the interface context and the global config level

switch(eth-1-3, 5)# no int 5 monitor 
switch(eth-1-3, 5)# no monitor

switch(config)# no int 5 monitor 
switch(config)# no int 1-3, 5 monitor

• These two commands show how to disable monitoring at the interface context level for a single port or all ports
in an interface context level.

• These two commands show how to disable monitoring at the global config level for a single port or a group of
ports.
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Overview
This chapter addresses performance-related network problems that can be caused by topology, switch
configuration, and the effects of other devices or their configurations on switch operation. (For switch-specific
information on hardware problems indicated by LED behavior, cabling requirements, and other potential
hardware-related problems, see the installation guide you received with the switch.)

HPE periodically places switch software updates on the HPE Switch Networking website. HPE
recommends that you check this website for software updates that may have fixed a problem you are
experiencing.

For information on support and warranty provisions, see the Support and Warranty booklet shipped with the
switch.

Troubleshooting approaches
Cause

Use these approaches to diagnose switch problems:

• Check the HPE website for software updates that may have solved your problem: http://www.hpe.com/
networking

• Check the switch LEDs for indications of proper switch operation:

◦ Each switch port has a Link LED that should light whenever an active network device is connected to the
port.

◦ Problems with the switch hardware and software are indicated by flashing the Fault and other switch
LEDs.For a description of the LED behavior and information on using the LEDs for troubleshooting, see the
installation guide shipped with the switch.

• Check the network topology/installation. For topology information, see the installation guide shipped with the
switch.

• Check cables for damage, correct type, and proper connections. You should also use a cable tester to check
your cables for compliance to the relevant IEEE 802.3 specification. For correct cable types and connector pin-
outs, see the installation guide shipped with the switch.

• Use the Port Utilization Graph and Alert Log in the WebAgent included in the switch to help isolate problems.
These tools are available through the WebAgent:

◦ Port Utilization Graph

◦ Alert log
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Troubleshooting

Chapter 17 Troubleshooting 303

Anexo 04 ITEM 10 (0592646)         SEI 0008478-63.2018.6.02.8000 / pg. 5362

http://www.hpe.com/networking
http://www.hpe.com/networking


◦ Port Status and Port Counters screens

◦ Diagnostic tools (Link test, Ping test, configuration file browser)

• For help in isolating problems, use the easy-to-access switch console built into the switch or Telnet to the
switch console. For operating information on the Menu and CLI interfaces included in the console, see
chapters 3 and 4. These tools are available through the switch console:

◦ Status and Counters screens

◦ Event Log

◦ Diagnostics tools (Link test, Ping test, configuration file browser, and advanced user commands)

Browser or Telnet access problems

Cannot access the WebAgent

• Access may be disabled by the Web Agent Enabled parameter in the switch console. Check the setting on this
parameter by selecting:

2. Switch Configuration

1. System Information

• The switch may not have the correct IP address, subnet mask, or gateway. Verify by connecting a console to
the switch's Console port and selecting:

2. Switch Configuration

5. IP Configuration

Note: If DHCP/Bootp is used to configure the switch, the IP addressing can be verified by selecting:

1. Status and Counters...

2. Switch Management Address Information

Also check the DHCP/Bootp server configuration to verify correct IP addressing.

• If you are using DHCP to acquire the IP address for the switch, the IP address "lease time" may have expired
so that the IP address has changed. For more information on how to "reserve" an IP address, see the
documentation for the DHCP application that you are using.

• If one or more IP-authorized managers are configured, the switch allows inbound telnet access only to a
device having an authorized IP address. For more information on IP Authorized managers, see the access
security guide for your switch.

• Java™ applets may not be running on the web browser. They are required for the switch WebAgent to operate
correctly. Refer to the online Help on your web browser for how to run the Java applets.

Cannot Telnet into the switch console from a station on the network

• Off-subnet management stations can lose Telnet access if you enable routing without first configuring a static
(default) route. That is, the switch uses the IP default gateway only while operating as a Layer 2 device. While
routing is enabled on the switch, the IP default gateway is not used. You can avoid this problem by using the ip
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route command to configure a static (default) route before enabling routing. For more information, see "IP
Routing Features" in the multicast and routing guide for your switch.

• Telnet access may be disabled by the Inbound Telnet Enabled parameter in the System Information
screen of the menu interface:

2. Switch Configuration

1. System Information

• The switch may not have the correct IP address, subnet mask, or gateway. Verify by connecting a console to
the switch's Console port and selecting:

2. Switch Configuration

5. IP Configuration

• If you are using DHCP to acquire the IP address for the switch, the IP address "lease time" may have expired
so that the IP address has changed. For more information on how to "reserve" an IP address, see the
documentation for the DHCP application that you are using.

• If one or more IP-authorized managers are configured, the switch allows inbound telnet access only to a
device having an authorized IP address. For more information on IP Authorized managers, see the access
security guide for your switch.

Unusual network activity
Network activity that fails to meet accepted norms may indicate a hardware problem with one or more of the
network components, possibly including the switch. Such problems can also be caused by a network loop or
simply too much traffic for the network as it is currently designed and implemented. Unusual network activity is
usually indicated by the LEDs on the front of the switch or measured with the switchconsole interface or with a
network management tool. For information on using LEDs to identify unusual network activity, see the installation
guide you received with the switch.

A topology loop can also cause excessive network activity. The Event Log "FFI" messages can be indicative of
this type of problem.

General problems

The network runs slow; processes fail; users cannot access servers or other devices
Broadcast storms may be occurring in the network. These may be caused by redundant links between nodes.

• If you are configuring a port trunk, finish configuring the ports in the trunk before connecting the related cables.
Otherwise you may inadvertently create a number of redundant links (that is, topology loops) that will cause
broadcast storms.

• Turn on STP to block redundant links

• Check for FFI messages in the Event Log

Duplicate IP addresses
This is indicated by this Event Log message:

ip: Invalid ARP source: IP address on IP address
where both instances of IP address are the same address, indicating that the switch's IP address has been
duplicated somewhere on the network.
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Duplicate IP addresses in a DHCP network
If you use a DHCP server to assign IP addresses in your network, and you find a device with a valid IP address
that does not appear to communicate properly with the server or other devices, a duplicate IP address may have
been issued by the server. This can occur if a client has not released a DHCP-assigned IP address after the
intended expiration time and the server "leases" the address to another device. This can also happen, For
example, if the server is first configured to issue IP addresses with an unlimited duration, and then is
subsequently configured to issue IP addresses that will expire after a limited duration. One solution is to configure
"reservations" in the DHCP server for specific IP addresses to be assigned to devices having specific MAC
addresses. For more information, see the documentation for the DHCP server.

One indication of a duplicate IP address in a DHCP network is this Event Log message:

ip: Invalid ARP source: <IP-address>
       on <IP-address>
where both instances of IP-address are the same address, indicating that the IP address has been duplicated
somewhere on the network.

The switch has been configured for DHCP/Bootp operation, but has not received a
DHCP or Bootp reply
When the switch is first configured for DHCP/Bootp operation, or if it is rebooted with this configuration, it
immediately begins sending request packets on the network. If the switch does not receive a reply to its DHCP/
Bootp requests, it continues to periodically send request packets, but with decreasing frequency. Thus, if a DHCP
or Bootp server is not available or accessible to the switch when DHCP/Bootp is first configured, the switch may
not immediately receive the desired configuration.

After verifying that the server has become accessible to the switch, reboot the switch to re-start the process.

802.1Q Prioritization problems

Ports configured for non-default prioritization (level 1 to 7) are not performing the
specified action
If the ports were placed in a trunk group after being configured for non-default prioritization, the priority setting
was automatically reset to zero (the default). Ports in a trunk group operate only at the default priority setting.

Addressing ACL problems

ACLs are properly configured and assigned to VLANs, but the switch is not using the
ACLs to filter IP layer 3 packets

Procedure

1. The switch may be running with IP routing disabled. To ensure that IP routing is enabled, execute show
running and look for the IP routing statement in the resulting listing. For Example:
Indication that routing is enabled

switch(config)# show running
Running configuration:
; J9091A Configuration Editor; Created on release #XX.15.06
hostname " HPswitch "
ip default-gateway 10.33.248.1
ip routing 1
logging 10.28.227.2
snmp-server community "public" Unrestricted
ip access-list extended "Controls for VLAN 20"
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permit tcp 0.0.0.0 255.255.255.255 10.10.20.98 0.0.0.0 eq 80
permit tcp 0.0.0.0 255.255.255.255 10.10.20.21 0.0.0.0 eq 80
deny tcp 0.0.0.0 255.255.255.255 10.10.20.1 0.0.0.255 eq 80
deny tcp 10.10.20.1? 0.0.0.0 10.10.10.100 0.0.0.0 eq 20 log
deny tcp 10.10.20.20 0.0.0.0 10.10.10.100 0.0.0.0 eq 20 log
deny tcp 10.10.20.43 0.0.0.0 10.10.10.100 0.0.0.0 eq 20 log
permit ip 10.10.20.1 0.0.0.255 10.10.10.100 0.0.0.0
deny ip 10.10.30.1 0.0.0.255 10.10.10.100 0.0.0.0
permit ip 10.10.30.1 0.0.0.255 10.10.10.1 0.0.0.255
exit

1

Indicates that routing is enabled, a requirement for ACL operation. (There is an exception. Refer to the Note,
below.)

If an ACL assigned to a VLAN includes an ACE referencing an IP address on the switch itself as
a packet source or destination, the ACE screens traffic to or from this switch address regardless
of whether IP routing is enabled. This is a security measure designed to help protect the switch
from unauthorized management access.

If you need to configure IP routing, execute the ip routing command.

2. ACL filtering on the switches applies only to routed packets and packets having a destination IP address (DA)
on the switch itself.

Also, the switch applies assigned ACLs only at the point where traffic enters or leaves the switch on a VLAN.
Ensure that you have correctly applied your ACLs ("in" and/or "out") to the appropriate VLANs.

The switch does not allow management access from a device on the same VLAN
The implicit deny any function that the switch automatically applies as the last entry in any ACL always blocks
packets having the same DA as the switch's IP address on the same VLAN. That is, bridged packets with the
switch itself as the destination are blocked as a security measure.

To preempt this action, edit the ACL to include an ACE that permits access to the switch's DA on that VLAN from
the management device.

Error (Invalid input) when entering an IP address
When using the "host" option in the Command syntax, ensure that you are not including a mask in either dotted
decimal or CIDR format. Using the "host" option implies a specific host device and therefore does not permit any
mask entry.

Correctly and incorrectly specifying a single host

Switch(config)# access-list 6 permit host 10.28.100.100 1

Switch(config)# access-list 6 permit host 10.28.100.100 255.255.255.2552 
Invalid input: 255.255.255.255

Switch(config)# access-list 6 permit host 10.28.100.100/32 3
Invalid input: 10.28.100.100/32
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• 1Correct.

• 2Incorrect. No mask needed to specify a single host.

• 3Incorrect. No mask needed to specify a single host.

Apparent failure to log all "deny" matches
Where the log statement is included in multiple ACEs configured with a "deny" option, a large volume of "deny"
matches generating logging messages in a short period of time can impact switch performance. If it appears that
the switch is not consistently logging all "deny" matches, try reducing the number of logging actions by removing
the log statement from some ACEs configured with the "deny" action.

The switch does not allow any routed access from a specific host, group of hosts, or
subnet
The implicit deny any function that the switch automatically applies as the last entry in any ACL may be blocking
all access by devices not specifically permitted by an entry in an ACL affecting those sources. If you are using the
ACL to block specific hosts, a group of hosts, or a subnet, but want to allow any access not specifically permitted,
insert permit any as the last explicit entry in the ACL.

The switch is not performing routing functions on a VLAN
Two possible causes of this problem are:

• Routing is not enabled. If show running indicates that routing is not enabled, use the ip routing
command to enable routing.

• An ACL may be blocking access to the VLAN (on a switch covered in this guide). Ensure that the switch's IP
address on the VLAN is not blocked by one of the ACE entries in an ACL applied to that VLAN. A common
mistake is to either not explicitly permit the switch's IP address as a DA or to use a wildcard ACL mask in a
deny statement that happens to include the switch's IP address. For an Example: of this problem, see section
"General ACL Operating Notes" in the "Access Control Lists (ACLs)" of the latest access security guide for
your switch.

Routing through a gateway on the switch fails
Configuring a "deny" ACE that includes a gateway address can block traffic attempting to use the gateway as a
next-hop.

Remote gateway case
Configuring ACL "101" (example below) and applying it outbound on VLAN 1 in the figure below includes the
router gateway (10.0.8.1) needed by devices on other networks. This can prevent the switch from sending ARP
and other routing messages to the gateway router to support traffic from authorized remote networks.
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In Figure 57: Inadvertently blocking a gateway on page 309, this ACE (see data in bold below) denies access
to the 10 Net's 10.0.8.1 router gateway needed by the 20 Net (Subnet mask is 255.255.255.0).See: example

Figure 57: Inadvertently blocking a gateway

To avoid inadvertently blocking the remote gateway for authorized traffic from another network (such as the 20
Net in this Example:):

Procedure

1. Configure an ACE that specifically permits authorized traffic from the remote network.

2. Configure narrowly defined ACEs to block unwanted IP traffic that would otherwise use the gateway; such
ACEs might deny traffic for a particular application, particular hosts, or an entire subnet.

3. Configure a "permit any" ACE to specifically allow any IP traffic to move through the gateway.

ACE blocking an entire subnet

switch(config)# access-list config

ip access-list extended "101"
  deny ip 0.0.0.0 255.255.255.255 10.0.8.30 0.0.0.255
  permit ip 0.0.0.0 255.255.255.255 0.0.0.00 255.255.255.255
  exit
      

Local gateway case
If you use the switch as a gateway for traffic you want routed between subnets, use these general steps to avoid
blocking the gateway for authorized applications:

Procedure

1. Configure gateway security first for routing with specific permit and deny statements.

2. Permit authorized traffic.

3. Deny any unauthorized traffic that you have not already denied in step 1 on page 309.

IGMP-related problems
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IP multicast (IGMP) traffic that is directed by IGMP does not reach IGMP hosts or a
multicast router connected to a port
IGMP must be enabled on the switch and the affected port must be configured for "Auto" or "Forward" operation.

IP multicast traffic floods out all ports; IGMP does not appear to filter traffic
The IGMP feature does not operate if the switch or VLAN does not have an IP address configured manually or
obtained through DHCP/Bootp. To verify whether an IP address is configured for the switch or VLAN, do one of
the following:

• Try using the WebAgent: If you can access the WebAgent, then an IP address is configured.

• Try to telnet to the switch console: If you can Telnet to the switch, an IP address is configured.

• Use the switch console interface: From the Main Menu, check the Management Address Information screen
by clicking on:

1. Status and Counters

2. Switch Management Address Information

LACP-related problems

Unable to enable LACP on a port with the interface <port-number> lacp
command
In this case, the switch displays the following message:

Operation is not allowed for a trunked port.
You cannot enable LACP on a port while it is configured as a static Trunk port. To enable LACP on a static-
trunked port:

Procedure

1. Use the no trunk <port-number> command to disable the static trunk assignment.

2. Execute interface <port-number> lacp .

Removing a port from a trunk without first disabling the port can create a traffic loop that can slow
down or halt your network. Before removing a port from a trunk, Hewlett Packard Enterprise
recommends that you either disable the port or disconnect it from the LAN.

Port-based access control (802.1X)-related problems
To list the 802.1X port-access Event Log messages stored on the switch, use show log 802.

See also Radius-related problems on page 313.

The switch does not receive a response to RADIUS authentication requests
In this case, the switch attempts authentication using the secondary method configured for the type of access you
are using (console, Telnet, or SSH).
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There can be several reasons for not receiving a response to an authentication request. Do the following:

• Use ping to ensure that the switch has access to the configured RADIUS servers.

• Verify that the switch is using the correct encryption key (RADIUS secret key) for each server.

• Verify that the switch has the correct IP address for each RADIUS server.

• Ensure that the radius-server timeout period is long enough for network conditions.

The switch does not authenticate a client even though the RADIUS server is properly
configured and providing a response to the authentication request
If the RADIUS server configuration for authenticating the client includes a VLAN assignment, ensure that the
VLAN exists as a static VLAN on the switch. See "How 802.1X Authentication Affects VLAN Operation" in the
access security guide for your switch.

During RADIUS-authenticated client sessions, access to a VLAN on the port used for
the client sessions is lost
If the affected VLAN is configured as untagged on the port, it may be temporarily blocked on that port during an
802.1X session. This is because the switch has temporarily assigned another VLAN as untagged on the port to
support the client access, as specified in the response from the RADIUS server. See "How 802.1X Authentication
Affects VLAN Operation" in the access security guide for your switch.

The switch appears to be properly configured as a supplicant, but cannot gain access
to the intended authenticator port on the switch to which it is connected
If aaa authentication port-access is configured for Local, ensure that you have entered the local login
(operator-level) username and password of the authenticator switch into the identity and secret parameters
of the supplicant configuration. If instead, you enter the enable (manager-level) username and password, access
will be denied.

The supplicant statistics listing shows multiple ports with the same authenticator MAC
address
The link to the authenticator may have been moved from one port to another without the supplicant statistics
having been cleared from the first port. See "Note on Supplicant Statistics" in the chapter on Port-Based and
User-Based Access Control in the access security guide for your switch.

The show port-access authenticator <port-list> command shows one or
more ports remain open after they have been configured with control unauthorized
802.1X is not active on the switch. After you execute aaa port-access authenticator active, all ports
configured with control unauthorized should be listed as Closed.

Authenticator ports remain "open" until activated

switch(config)# show port-access authenticator e 9
 Port Access Authenticator Status
  Port-access authenticator activated [No] : No
              Access Authenticator Authenticator
  Port Status Control  State Backend  State
  ---- ------ -------- -------------- --------------
  9    Open 1   FU       Force Auth     Idle

Switch(config)# show port-access authenticator active
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Switch(config)# show port-access authenticator e 9
 Port Access Authenticator Status
  Port-access authenticator activated [No] : Yes
              Access Authenticator Authenticator
  Port Status Control  State Backend  State
  ---- ------ -------- -------------- --------------
  9    Closed FU       Force Unauth   Idle

1Port A9 shows an “Open” status even though Access Control is set to Unauthorized (Force Auth). This is
because the port-access authenticator has not yet been activated.

RADIUS server fails to respond to a request for service, even though the server's IP
address is correctly configured in the switch
Use show radius to verify that the encryption key (RADIUS secret key) the switch is using is correct for the
server being contacted. If the switch has only a global key configured, it either must match the server key or you
must configure a server-specific key. If the switch already has a server-specific key assigned to the server's IP
address, it overrides the global key and must match the server key.

Displaying encryption keys

switch(config)# show radius
 Status and Counters - General RADIUS Information
  Deadtime(min) : 0
  Timeout(secs) : 5
  Retransmit Attempts : 3
  Global Encryption Key : My-Global-Key
  Dynamic Authorization UDP Port : 3799

                  Auth Acct DM/ Time
  Server IP Addr  Port Port CoA Window Encryption Key
  --------------- ---- ---- --- ------ ---------------
  10.33.18.119    1812 1813            119-only-key
Also, ensure that the switch port used to access the RADIUS server is not blocked by an 802.1X configuration on
that port. For example, show port-access authenticator <port-list> gives you the status for the
specified ports. Also, ensure that other factors, such as port security or any 802.1X configuration on the RADIUS
server are not blocking the link.

The authorized MAC address on a port that is configured for both 802.1X and port
security either changes or is re-acquired after execution of aaa port-access
authenticator <port-list> initialize
If the port is force-authorized with aaa port-access authenticator <port-list> control
authorized command and port security is enabled on the port, then executing initialize causes the port to
clear the learned address and learn a new address from the first packet it receives after you execute
initialize.

A trunked port configured for 802.1X is blocked
If you are using RADIUS authentication and the RADIUS server specifies a VLAN for the port, the switch allows
authentication, but blocks the port. To eliminate this problem, either remove the port from the trunk or reconfigure
the RADIUS server to avoid specifying a VLAN.

QoS-related problems
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Loss of communication when using VLAN-tagged traffic
If you cannot communicate with a device in a tagged VLAN environment, ensure that the device either supports
VLAN tagged traffic or is connected to a VLAN port that is configured as Untagged.

Radius-related problems

The switch does not receive a response to RADIUS authentication requests
In this case, the switch attempts authentication using the secondary method configured for the type of access you
are using (console, Telnet, or SSH).

There can be several reasons for not receiving a response to an authentication request. Do the following:

• Use ping to ensure that the switch has access to the configured RADIUS server.

• Verify that the switch is using the correct encryption key for the designated server.

• Verify that the switch has the correct IP address for the RADIUS server.

• Ensure that the radius-server timeout period is long enough for network conditions.

• Verify that the switch is using the same UDP port number as the server.

Because of an inconsistency between the Windows XP 802.1x supplicant timeout value and the
switch default timeout value, which is 5, when adding a backup RADIUS server, set the switch
radius-server timeout value to 4. Otherwise, the switch may not failover properly to the backup
RADIUS server.

RADIUS server fails to respond to a request for service, even though the server's IP
address is correctly configured in the switch
Use show radius to verify that the encryption key the switch is using is correct for the server being contacted. If
the switch has only a global key configured, it either must match the server key or you must configure a server-
specific key. If the switch already has a server-specific key assigned to the server's IP address, it overrides the
global key and must match the server key.

Global and unique encryption keys

Switch(config)# show radius
 Status and Counters - General RADIUS Information
  Deadtime(min) : 0
  Timeout(secs) : 5
  Retransmit Attempts : 3
  Global Encryption Key : My-Global-Key 1
  Dynamic Authorization UDP Port : 3799

                  Auth Acct DM/ Time
  Server IP Addr  Port Port CoA Window Encryption Key
  --------------- ---- ---- --- ------ ---------------
  10.33.18.119    1812 1813            119-only-key 2

• 1

Global RADIUS Encryption Key

• 2
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Unique RADIUS Encryption Key for the RADIUS server at 10.33.18.119

MSTP and fast-uplink problems
If you enable MSTP, Hewlett Packard Enterprise recommends that you leave the remainder of the
MSTP parameter settings at their default values until you have had an opportunity to evaluate MSTP
performance in your network. Because incorrect MSTP settings can adversely affect network
performance, you should avoid making changes without having a strong understanding of how MSTP
operates. To learn the details of MSTP operation, see the IEEE802.1s standard.

Broadcast storms appearing in the network
This can occur when there are physical loops (redundant links) in the topology. Where this exists, you should
enable MSTP on all bridging devices in the topology to detect the loop.

STP blocks a link in a VLAN even though there are no redundant links in that VLAN
In 802.1Q-compliant switches, MSTP blocks redundant physical links even if they are in separate VLANs. A
solution is to use only one, multiple-VLAN (tagged) link between the devices. Also, if ports are available, you can
improve the bandwidth in this situation by using a port trunk. See "Spanning Tree Operation with VLANs" in
"Static Virtual LANs (VLANs)" in the advanced traffic management guide for your switch.

Fast-uplink troubleshooting
Some of the problems that can result from incorrect use of fast-uplink MSTP include temporary loops and
generation of duplicate packets.

Problem sources can include:

• Fast-uplink is configured on a switch that is the MSTP root device.

• Either the Hello Time or the Max Age setting (or both) is too long on one or more switches. Return the
Hello Time and Max Age settings to their default values (2 seconds and 20 seconds, respectively, on a
switch).

• A "downlink" port is connected to a switch that is further away (in hop count) from the root device than the
switch port on which fast-uplink MSTP is configured.

• Two edge switches are directly linked to each other with a fast-uplink (Mode = Uplink) connection.

• Fast uplink is configured on both ends of a link.

• A switch serving as a backup MSTP root switch has ports configured for fast-uplink MSTP and has become
the root device because of a failure in the original root device.

SSH-related problems

Switch access refused to a client
Even though you have placed the client's public key in a text file and copied the file (using the copy tftp pub-
key-file command) into the switch, the switch refuses to allow the client to have access. If the source SSH
client is an SSHv2 application, the public key may be in the PEM format, which the switch (SSHv1) does not
interpret. Check the SSH client application for a utility that can convert the PEM-formatted key into an ASCII-
formatted key.
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Executing IP SSH does not enable SSH on the switch
The switch does not have a host key. Verify by executing show ip host-public-key. If you see the message

ssh cannot be enabled until a host key is configured (use 'crypto' command).
you need to generate an SSH key pair for the switch. To do so, execute crypto key generate (see
"Generating the switch's public and private key pair" in the SSH chapter of the access security guide for your
switch.)

Switch does not detect a client's public key that does appear in the switch's public key
file (show ip client-public-key)
The client's public key entry in the public key file may be preceded by another entry that does not terminate with a
new line (CR). In this case, the switch interprets the next sequential key entry as simply a comment attached to
the preceding key entry. Where a public key file has more than one entry, ensure that all entries terminate with a
new line (CR). While this is optional for the last entry in the file, not adding a new line to the last entry creates an
error potential if you either add another key to the file at a later time or change the order of the keys in the file.

An attempt to copy a client public-key file into the switch has failed and the switch lists
one of the following messages
Download failed: overlength key in key file.
Download failed: too many keys in key file.
Download failed: one or more keys is not a valid RSA public key.
The public key file you are trying to download has one of the following problems:

• A key in the file is too long. The maximum key length is 1024 characters, including spaces. This could also
mean that two or more keys are merged together instead of being separated by a <CR> <LF>.

• There are more than ten public keys in the key file.

• One or more keys in the file is corrupted or is not a valid rsa public key.

Client ceases to respond ("hangs") during connection phase
The switch does not support data compression in an SSH session. Clients often have compression turned on by
default, but then disable it during the negotiation phase. A client that does not recognize the compression-request
FAILURE response may fail when attempting to connect. Ensure that compression is turned off before attempting
a connection to prevent this problem.

TACACS-related problems

Event Log
When troubleshooting TACACS+ operation, check the switch's Event Log for indications of problem areas.

All users are locked out of access to the switch
If the switch is functioning properly, but no username/password pairs result in console or Telnet access to the
switch, the problem may be caused by how the TACACS+ server and/or the switch are configured. Use one of the
following methods to recover:
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• Access the TACACS+ server application and adjust or remove the configuration parameters controlling access
to the switch.

• If the above method does not work, try eliminating configuration changes in the switch that have not been
saved to flash (boot-up configuration) by causing the switch to reboot from the boot-up configuration (which
includes only the configuration changes made prior to the last write memory command.) If you did not use
write memory to save the authentication configuration to flash, pressing the Reset button reboots the
switch with the boot-up configuration.

• Disconnect the switch from network access to any TACACS+ servers and then log in to the switch using either
Telnet or direct console port access. Because the switch cannot access a TACACS+ server, it defaults to local
authentication. You can then use the switch's local Operator or Manager username/password pair to log on.

• As a last resort, use the Clear/Reset button combination to reset the switch to its factory default boot-up
configuration. Taking this step means you will have to reconfigure the switch to return it to operation in your
network.

No communication between the switch and the TACACS+ server application
If the switch can access the server device (that is, it can ping the server), a configuration error may be the
problem. Some possibilities include:

• The server IP address configured with the switch's tacacs-serverhost command may not be correct. (Use
the switch's show tacacs-server command to list the TACACS+ server IP address.)

• The encryption key configured in the server does not match the encryption key configured in the switch (by
using the tacacs-server key command). Verify the key in the server and compare it to the key configured
in the switch. (Use show tacacs-server to list the global key. Use show config or show config
running to list any server-specific keys.)

• The accessible TACACS+ servers are not configured to provide service to the switch.

Access is denied even though the username/password pair is correct
Some reasons for denial include the following parameters controlled by your TACACS+ server application:

• The account has expired.

• The access attempt is through a port that is not allowed for the account.

• The time quota for the account has been exhausted.

• The time credit for the account has expired.

• The access attempt is outside of the time frame allowed for the account.

• The allowed number of concurrent logins for the account has been exceeded.

For more help, see the documentation provided with your TACACS+ server application.

Unknown users allowed to login to the switch
Your TACACS+ application may be configured to allow access to unknown users by assigning them the privileges
included in a default user profile. See the documentation provided with your TACACS+ server application.
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System allows fewer login attempts than specified in the switch configuration
Your TACACS+ server application may be configured to allow fewer login attempts than you have configured in
the switch with the aaa authentication num-attempts command.

TimeP, SNTP, or Gateway problems

The switch cannot find the time server or the configured gateway
TimeP, SNTP, and Gateway access are through the primary VLAN, which in the default configuration is the
DEFAULT_VLAN. If the primary VLAN has been moved to another VLAN, it may be disabled or does not have
ports assigned to it.

VLAN-related problems

Monitor port
When using the monitor port in a multiple-VLAN environment, the switch handles broadcast, multicast, and
unicast traffic output from the monitor port as follows:

• If the monitor port is configured for tagged VLAN operation on the same VLAN as the traffic from monitored
ports, the traffic output from the monitor port carries the same VLAN tag.

• If the monitor port is configured for untagged VLAN operation on the same VLAN as the traffic from the
monitored ports, the traffic output from the monitor port is untagged.

• If the monitor port is not a member of the same VLAN as the traffic from the monitored ports, traffic from the
monitored ports does not go out the monitor port.

None of the devices assigned to one or more VLANs on an 802.1Q-compliant switch are
being recognized
If multiple VLANs are being used on ports connecting 802.1Q-compliant devices, inconsistent VLAN IDs may
have been assigned to one or more VLANs. For a given VLAN, the same VLAN ID must be used on all connected
802.1Q-compliant devices.

Link configured for multiple VLANs does not support traffic for one or more VLANs
One or more VLANs may not be properly configured as "Tagged" or "Untagged." A VLAN assigned to a port
connecting two 802.1Q-compliant devices must be configured the same on both ports. For example, VLAN_1 and
VLAN_2 use the same link between switch "X" and switch "Y," as shown in Figure 58: Example: of correct
VLAN port assignments on a link on page 317.

Figure 58: Example: of correct VLAN port assignments on a link
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• If VLAN_1 (VID=1) is configured as "Untagged" on port 3 on switch "X," it must also be configured as
"Untagged" on port 7 on switch "Y." Make sure that the VLAN ID (VID) is the same on both switches.

• Similarly, if VLAN_2 (VID=2) is configured as "Tagged" on the link port on switch "A," it must also be configured
as "Tagged" on the link port on switch "B." Make sure that the VLAN ID (VID) is the same on both switches.

Duplicate MAC addresses across VLANs
The switches operate with multiple forwarding databases. Thus, duplicate MAC addresses occurring on different
VLANs can appear where a device having one MAC address is a member of more than one 802.1Q VLAN, and
the switch port to which the device is linked is using VLANs (instead of MSTP or trunking) to establish redundant
links to another switch. If the other device sends traffic over multiple VLANs, its MAC address consistently
appears in multiple VLANs on the switch port to which it is linked.

Be aware that attempting to create redundant paths through the use of VLANs causes problems with some
switches. One symptom is that a duplicate MAC address appears in the Port Address Table of one port and then
later appears on another port. While the switches have multiple forwarding databases and thus do not have this
problem, some switches with a single forwarding database for all VLANs may produce the impression that a
connected device is moving among ports because packets with the same MAC address but different VLANs are
received on different ports. You can avoid this problem by creating redundant paths using port trunks or spanning
tree.

Figure 59: Example: of duplicate MAC address

Fan failure
When two or more fans fail, a two-minute timer starts. After two minutes, the switch is powered down and must be
rebooted to restart it. This protects the switch from possible overheating.

Hewlett Packard Enterprise recommends that you replace a failed fan tray assembly within one minute of
removing it.

Viewing transceiver information
This features provides the ability to view diagnostic monitoring information for transceivers with Diagnostic Optical
Monitoring (DOM) support. The following table indicates the support level for specific transceivers:
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Product # Description Support1

J8436A 10GbE X2–SC SR
Optic

V

J8437A 10GbE X2–SC LR Optic V

J8440B 10GbE X2-CX4 Xcver NA

J8440C 10GbE X2-CX4 Xcver NA

J4858A Gigabit-SX-LC Mini-
GBIC

V

J4858B Gigabit-SX-LC Mini-
GBIC

V

J4858C Gigabit-SX-LC Mini-
GBIC

V (some)

J9054B 100-FX SFP-LC
Transceiver

N

J8177C Gigabit 1000Base-T
Mini-GBIC

NA

J9150A 10GbE SFP+ SR
Transceiver

D

J9151A 10GbE SFP+ LR
Transceiver

D

J9152A 10GbE SFP+ LRM
Transceiver

D

J9153A 10GbE SFP+ ER
Transceiver

D

J9144A 10GbE X2-SC LRM
Transceiver

D

J8438A 10Gbe X2-SC ER
Transceiver

D

1 Support indicators:

• V - Validated to respond to DOM requests

• N - No support of DOM

• D - Documented by the component suppliers as supporting DOM

• NA - Not applicable to the transceiver (copper transceiver)
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Not all transceivers support Digital Optical Monitoring. If DOM appears in the Diagnostic Support field
of the show interfaces transceiver detail command, or the hpicfTransceiverMIB
hpicfXcvrDiagnostics MIB object, DOM is supported for that transceiver.

Viewing information about transceivers (CLI)
Syntax:

show interfaces transceiver [port-list] [detail]
Displays information about the transceivers. If a port is specified, displays information for the transceiver in that
port.

[detail]
Displays detailed transceiver information.

MIB support
The hpicfTransceiver MIB is available for displaying transceiver information.

Viewing transceiver information
The transceiver information displayed depends on the show command executed.

The output for show interfaces transceiver [port-list] is shown below. You can specify multiple
ports, separated by commas, and the information for each transceiver will display.

Output for a specified transceiver

switch(config)# show interfaces transceiver 21

Transceiver Technical information:

                     Product      Serial             Part
 Port    Type        Number       Number             Number
 ------- ----------- ------------ ------------------ ----------
 21      1000SX      J4858C       MY050VM9WB         1990-3657
If there is no transceiver in the port specified in the command, the output displays as shown below.

Output when no transceiver is present in specified interface

switch(config)# show interfaces transceiver 22

 No Transceiver found on interface 22
When no ports are specified, information for all transceivers found is displayed.

Output when no ports are specified

switch(config)# show interfaces transceiver

 Transceiver Technical information:

                      Product      Serial             Part
  Port    Type        Number       Number             Number
  ------- ----------- ------------ ------------------ ----------
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  21      1000SX      J4858C       MY050VM9WB         1990-3657
  22      1000SX      J4858B       P834DIP2
You can specify all for port-list as shown below.

Output when “all” is specified

switch(config)# show interfaces transceiver all

 No Transceiver found on interface 1

 No Transceiver found on interface 2
.
.
.
 No Transceiver found on interface 24

 Transceiver Technical information:

                      Product      Serial             Part
  Port    Type        Number       Number             Number
  ------- ----------- ------------ ------------------ ----------
  21      1000SX      J4858C       MY050VM9WB         1990-3657
  22      1000SX      J4858B       P834DIP2

Information displayed with the detail parameter
When the show interfaces transceiver [port-list] detail command is executed, the following
information displays.

Table 24: General transceiver information

Parameter Description

Interface
Index

The switch interface number

Transceiver-
type

Pluggable transceiver type

Transceiver
model

Pluggable transceiver model

Connector-
type

Type of connector of the transceiver

Wavelength For an optical transceiver: the central wavelength of the laser sent, in nm. If the transceiver
supports multiple wavelengths, the values will be separated by a comma.

Transfer
Distance

Link-length supported by the transceiver in meters. The corresponding transfer medium is
shown in brackets following the transfer distance value, For example, 50um multimode fiber. If
the transceiver supports multiple transfer media, the values are separated by a comma.

Table Continued
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Parameter Description

Diagnostic
Support

Shows whether the transceiver supports diagnostics:
None

Supported

DOM

Supported

VCT

Supported

Serial Number Serial number of the transceiver

The information in the next three tables is only displayed when the transceiver supports DOM.

Table 25: DOM information

Parameter Description

Temperature Transceiver temperature (in degrees Centigrade)

Voltage Supply voltage in transceiver (Volts)

Bias Laser bias current (mA)

RX power Rx power (mW and dBm))

TX power Tx power (mW and dBm)

The alarm information for GBIC/SFP transceivers is shown in this table.

Table 26: Alarm and error information (GBIC/SFP transceivers only)

Alarm Description

RX loss of signal Incoming (RX) signal is lost

RX power high Incoming (RX) power level is high

RX power low Incoming (RX) power level is low

TX fault Transmit (TX) fault

TX bias high TX bias current is high

TX bias low TX bias current is low

TX power high TX power is high

Table Continued
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Alarm Description

TX power low TX power is low

Temp high Temperature is high

Temp low Temperature is low

Voltage High Voltage is high

Voltage Low Voltage is low

The alarm information for XENPAK transceivers is shown in this table.

Table 27: Alarm and error information (XENPAK transceivers)

Alarm Description

WIS local fault WAN Interface Sublayer local fault

Receive optical power fault Receive optical power fault

PMA/PMD receiver local fault Physical Medium Attachment/Physical Medium Dependent receiver local
fault

PCS receiver local fault Physical Coding Sublayer receiver local fault

PHY XS receive local fault PHY Extended Sublayer receive local fault

RX power high RX power is high

RX power low RX power is low

Laser bias current fault Laser bias current fault

Laser temperature fault Laser temperature fault

Laser output power fault Laser output power fault

TX fault TX fault

PMA/PMD transmitter local fault PMA/PMD transmitter local fault

PCS Transmit local fault PCS transmit local fault

PHY XS transmit local fault PHY SX transmit local fault

TX bias high TX bias current is high

TX bias low TX bias current is low

Table Continued
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Alarm Description

TX power high TX power is high

TX power low TX power is low

Temp high Temperature is high

Temp low Temperature is low

An Example: of the output for the show interfaces transceiver [port-list] detail for a 1000SX transceiver is shown
below.

Detailed information for a 1000SX Mini-GBIC transceiver

switch(config)# show interfaces transceiver 21 detail

 Transceiver in 21
  Interface index    : 21
  Type               : 1000SX 
  Model              : J4858C
  Connector type     : LC 
  Wavelength         : 850nm
  Transfer distance  : 300m (50um), 150m (62.5um),
  Diagnostic support : DOM
  Serial number      : MY050VM9WB

 Status
  Temperature : 50.111C 
  Voltage     : 3.1234V
  TX Bias     : 6mA
  TX Power    : 0.2650mW, -5.768dBm
  RX Power    : 0.3892mW, -4.098dBm

 Time stamp   :  Mon Mar 7 14:22:13 2011
An Example: of the output for a 10GbE-LR transceiver is shown below.

Detailed information for a 10GbE-LR transceiver

switch(config)# show interfaces transceiver 23 detail

 Transceiver in 23
  Interface Index   : 24
  Type              : 10GbE-LR 
  Model             : J8437A
  Connector type    : SC
  Wavelength        : Channel #0: 1310nm, #1:0nm, #2:0nm, #3:0nm
  Transfer distance : 10000m (SM)
  Diagnostic support: DOM
  Serial number     : ED456SS987

 Status
  Temperature : 32.754C 
  TX Bias     : 42.700mA
  TX Power    : 0.5192mW, -2.847dBm
  RX Power    : 0.0040mW, -23.979dBm

 Recent Alarms:
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  Rx power low alarm
  Rx power low warning

 Recent errors:
  Receive optical power fault
  PMA/PMD receiver local fault
  PMA/PMD transmitter local fault
  PCS receive local fault
  PHY XS transmit local fault

 Time stamp : Mon Mar 7 16:26:06 2013

Viewing transceiver information for copper transceivers with VCT support
This feature provides the ability to view diagnostic monitoring information for copper transceivers with Virtual
Cable Test (VCT) support. The cable quality of the copper cables connected between transceivers can be
ascertained using the transceiver cable diagnostics. Results of the diagnostics are displayed with the appropriate
CLI show commands and with SNMP using the hpicfTransceiver MIB.

The J8177C 1000Base-T Mini-GBIC is supported.

Testing the Cable
Enter the test cable-diagnostics command in any context to begin cable diagnostics for the transceiver.
The diagnostic attempts to identify cable faults. The tests may take a few seconds to complete for each interface.
There is the potential of link loss during the diagnostic.

Syntax:

test cable-diagnostics [port-list]
Invokes cable diagnostics and displays the results.

Output from test cable-diagnostics command

HP Switch # test cable-diagnostics a23-a24

 The ‘test cable-diagnostics’ command will cause a loss of link and will take a few seconds per 
 interface to complete.

 Continue (Y/N)? y

MDI  Cable     Distance  Pair  Pair      MDI 
 Port  Pair  Status     to Fault  Skew  Polarity  Mode
 ----- ----- ---------- --------- ----- --------- ------ 
 A23   1-2   OK         0 m       6 ns  Normal    MDIX
       3-6   OK         0 m       0 ns  Normal
       4-5   OK         0 m       6 ns  Normal    MDIX
       7-8   OK         0 m       6 ns  Normal
 A24   1-2   Short      2 m
       3-6   Impedance  3 m
       4-5   Impedance  3 m
       7-8   Open       1 m

Copper cable diagnostic test results

switch# show interfaces transceiver a23 detail

 Transceiver in A23
  Interface Index   : 23
  Type              : 1000T-sfp
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  Model             : J8177C 
  Connector Type    : RJ45
  Wavelength        : n/a
  Transfer Distance : 100m (copper), 
  Diagnostic Support : VCT
  Serial Number     : US051HF099

  Link Status       : Up
  Speed             : 1000
  Duplex            : Full

       MDI   Cable      Distance  Pair  Pair      MDI 
 Port  Pair  Status     to Fault  Skew  Polarity  Mode
 ----- ----- ---------- --------- ----- --------- ----- 
 A23   1-2   OK         0 m       6 ns  Normal    MDIX
       3-6   OK         0 m       0 ns  Normal
       4-5   OK         0 m       6 ns  Normal    MDIX
       7-8   OK         0 m       6 ns  Normal

   Test Last Run   : Fri Apr 22 20:33:23 2011

General transceiver information

Parameter Description

Interface Index The switch interface number

Transceiver-type Pluggable transceiver type

Transceiver
model

Pluggable transceiver model

Connector-type Type of connector of the transceiver

Wavelength For an optical transceiver: the central wavelength of the laser sent, in nm. If the transceiver
supports multiple wavelengths, the values will be separated by a comma. An electrical
transceiver value is displayed as N/A.

Transfer
Distance

Link-length supported by the transceiver in meters. The corresponding transfer medium is
shown in brackets following the transfer distance value, For example, 50um multimode fiber.
If the transceiver supports multiple transfer media, the values are separated by a comma.

Diagnostic
Support

Shows whether the transceiver supports diagnostics:
None

Supported

DOM

Supported

VCT

Supported

Serial Number Serial number of the transceiver

Link Status Link up or down

Table Continued
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Parameter Description

Speed Speed of transceiver in Mbps

Duplex Type of duplexing

Cable Status Values are OK, Open, Short, or Impedance

Distance to Fault The distance in meters to a cable fault (accuracy is +/- 2 meters); displays 0 (zero) if there is
no fault

Pair Skew Difference in propagation between the fastest and slowest wire pairs

Pair Polarity Signals on a wire pair are polarized, with one wire carrying the positive signal and one
carrying the negative signal.

MDI Mode The MDI crossover status of the two wire pairs (1&2, 3&6, 4&5, 7&8), will be either MDI or
MDIX

Using the Event Log for troubleshooting switch problems
The Event Log records operating events in single- or double-line entries and serves as a tool to isolate and
troubleshoot problems.

Once the log has received 2000 entries, it discards the oldest message each time a new message is received.
The Event Log window contains 14 log entry lines. You can scroll through it to view any part of the log.

Once the log has received 2000 entries, it discards the oldest message each time a new message is received.
The Event Log window contains 14 log-entry lines. You can scroll through it to view any part of the log.

The Event Log is erased if power to the switch is interruptedor if you enter the boot system
command. The contents of the Event Log are not erased if you:

• Reboot the switch by choosing the Reboot Switch option from the menu interface.

• Enter the reload command from the CLI.

Event Log entries
As shown in Figure 60: Format of an event log entry on page 327, each Event Log entry is composed of six or
seven fields, depending on whether numbering is turned on or not:

Figure 60: Format of an event log entry
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Item Description

Severity One of the following codes (from highest to lowest severity):

M—(major) indicates that a fatal switch error has occurred.

E—(error) indicates that an error condition occurred on the switch.

W—(warning) indicates that a switch service has behaved unexpectedly.I—(information)
provides information on normal switch operation.

D—(debug) is reserved for HPE internal diagnostic information.

Date The date in the format mm/dd/yy when an entry is recorded in the log.

Time The time in the format hh:mm:ss when an entry is recorded in the log.

Event number The number assigned to an event. You can turn event numbering on and off with the [no]
log-number command.

System module The internal module (such as "ports:" for port manager) that generated a log entry. If VLANs
are configured, a VLAN name also appears for an event that is specific to an individual
VLAN.

Event message A brief description of the operating event.

Table 28: Event Log system modules

System module Description Documented in HPE Switch
hardware/software guide

802.1x 802.1X authentication: Provides
access control on a per-client or
per-port basis:

• Client-level security that allows
LAN access to 802.1X clients
(up to 32 per port) with valid user
credentials

• Port-level security that allows
LAN access only on ports on
which a single 802.1X-capable
client (supplicant) has entered
valid RADIUS user credentials

Access Security Guide

addrmgr Address Table Manager: Manages
MAC addresses that the switch has
learned and are stored in the
switch's address table.

Management and Configuration
Guide

Table Continued
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System module Description Documented in HPE Switch
hardware/software guide

auth Authorization: A connected client
must receive authorization through
web, AMC, RADIUS-based,
TACACS+-based, or 802.1X
authentication before it can send
traffic to the switch.

Access Security Guide

cdp Cisco Discovery Protocol: Supports
reading CDP packets received from
neighbor devices, enabling a switch
to learn about adjacent CDP
devices. HPE does not support the
transmission of CDP packets to
neighbor devices.

Management and Configuration
Guide

console Console interface used to monitor
switch and port status, reconfigure
the switch, and read the event log
through an in-band Telnet or out-of-
band connection.

Installation and Getting Started
Guide

cos Class of Service (CoS): Provides
priority handling of packets
traversing the switch, based on the
IEEE 802.1p priority carried by each
packet.CoS messages also include
QoS events. The QoS feature
classifies and prioritizes traffic
throughout a network, establishing
an end-to-end traffic priority policy
to manage available bandwidth and
improve throughput of important
data.

Advanced Traffic Management
Guide

dhcp Dynamic Host Configuration
Protocol (DHCP) server
configuration: Switch is
automatically configured from a
DHCP (Bootp) server, including IP
address, subnet mask, default
gateway, Timep Server address,
and TFTP server address.

Management and Configuration
Guide

dhcp v6c DHCP for IPv6 prefix assignment IPv6 Configuration Guide

dhcpr DHCP relay: Forwards client-
originated DHCP packets to a
DHCP network server.

Advanced Traffic Management
Guide

Table Continued
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System module Description Documented in HPE Switch
hardware/software guide

download Download operation for copying a
software version or files to the
switch.

Management and Configuration
Guide

dma Direct Access Memory (DMA):
Transmits and receives packets
between the CPU and the switch.

—

fault Fault Detection facility, including
response policy and the sensitivity
level at which a network problem
should generate an alert.

Management and Configuration
Guide

ffi Find, Fix, and Inform: Event or alert
log messages indicating a possible
topology loop that causes excessive
network activity and results in the
network running slow. FFI
messages include events on
transceiver connections with other
network devices.

Installation and Getting Started
Guide

Management and Configuration
Guide

garp Generic Attribute Registration
Protocol (GARP), defined in the
IEEE 802.1D-1998 standard.

Advanced Traffic Management
Guide

gvrp GARP VLAN Registration Protocol
(GVRP): Manages dynamic 802.1Q
VLAN operations, in which the
switch creates temporary VLAN
membership on a port to provide a
link to another port in the same
VLAN on another device.

Advanced Traffic Management
Guide

hpesp Management module that maintains
communication between switch
ports.

Installation and Getting Started
Guide

igmp Internet Group Management
Protocol: Reduces unnecessary
bandwidth usage for multicast traffic
transmitted from multimedia
applications on a per-port basis.

Multicast and Routing Guide

Table Continued
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System module Description Documented in HPE Switch
hardware/software guide

ip IP addressing: Configures the
switch with an IP address and
subnet mask to communicate on the
network and support remote
management access; configures
multiple IP addresses on a VLAN;
enables IP routing on the switch.

Management and Configuration
Guide

iplock IP Lockdown: Prevents IP source
address spoofing on a per-port and
per-VLAN basis by forwarding only
the IP packets in VLAN traffic that
contain a known source IP address
and MAC address binding for the
port.

Access Security Guide

ipx Novell Netware protocol filtering: On
the basis of protocol type, the
switch can forward or drop traffic to
a specific set of destination ports on
the switch.

Access Security Guide

lacp LACP trunks: The switch can either
automatically establish an 802.3ad-
compliant trunk group or provide a
manually configured, static LACP
trunk.

Management and Configuration
Guide

ldbal Load balancing in LACP port trunks
or 802.1s Multiple Spanning Tree
protocol (MSTP) that uses VLANs in
a network to improve network
resource utilization and maintain a
loop-free environment.Load-
balancing messages also include
switch meshing events. The switch
meshing feature provides redundant
links, improved bandwidth use, and
support for different port types and
speeds.

Management and Configuration
Guide

Advanced Traffic Management
Guide

lldp Link-Layer Discovery Protocol:
Supports transmitting LLDP packets
to neighbor devices and reading
LLDP packets received from
neighbor devices, enabling a switch
to advertise itself to adjacent
devices and to learn about adjacent
LLDP devices.

Management and Configuration
Guide

Table Continued
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System module Description Documented in HPE Switch
hardware/software guide

macauth Web and MAC authentication: Port-
based security employed on the
network edge to protect private
networks and the switch itself from
unauthorized access using one of
the following interfaces:

• Web page login to authenticate
users for access to the network

• RADIUS server that uses a
device's MAC address for
authentication

Access Security Guide

maclock MAC lockdown and MAC lockout

• MAC lockdown prevents station
movement and MAC address
"hijacking" by requiring a MAC
address to be used only on an
assigned port on the switch.
MAC Lockdown also restricts the
client device to a specific VLAN.

• MAC lockout blocks a specific
MAC address so that the switch
drops all traffic to or from the
specified address.

Access Security Guide

mgr Windows-based network
management solutions for
managing and monitoring
performance of HPE switches.

Management and Configuration
Guide

netinet Network Internet: Monitors the
creation of a route or an Address
Resolution Protocol (ARP) entry
and sends a log message in case of
failure.

Advanced Traffic Management
Guide

pagp Ports Aggregation Protocol (PAgP):
Obsolete. Replaced by LACP
(802.3ad).

—

Table Continued
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System module Description Documented in HPE Switch
hardware/software guide

ports Port status and port configuration
features, including mode (speed
and duplex), flow control, broadcast
limit, jumbo packets, and security
settings.

Port messages include events on
POE operation and transceiver
connections with other network
devices.

Installation and Getting Started
Guide

Management and Configuration
Guide

Access Security Guide

radius RADIUS (Remote Authentication
Dial-In User Service) authentication
and accounting: A network server is
used to authenticate user-
connection requests on the switch
and collect accounting information
to track network resource usage.

Access Security Guide

snmp Simple Network Management
Protocol: Allows you to manage the
switch from a network management
station, including support for
security features, event reporting,
flow sampling, and standard MIBs.

Management and Configuration
Guide

sntp Simple Network Time Protocol:
Synchronizes and ensures a
uniform time among interoperating
devices.

Management and Configuration
Guide

ssh Secure Shell version 2 (SSHv2):
Provides remote access to
management functions on a switch
via encrypted paths between the
switch and management station
clients capable of SSH operation.

SSH messages also include events
from the Secure File Transfer
Protocol (SFTP) feature. SFTP
provides a secure alternative to
TFTP for transferring sensitive
information, such as switch
configuration files, to and from the
switch in an SSH session.

Access Security Guide

Table Continued
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System module Description Documented in HPE Switch
hardware/software guide

ssl Secure Socket Layer Version 3
(SSLv3), including Transport Layer
Security (TLSv1) support: Provides
remote web access to a switch via
encrypted paths between the switch
and management station clients
capable of SSL/TLS operation.

Access Security Guide

stack Stack management: Uses a single
IP address and standard network
cabling to manage a group (up to
16) of switches in the same IP
subnet (broadcast domain),
resulting in a reduced number of IP
addresses and simplified
management of small workgroups
for scaling your network to handle
increased bandwidth demand.

Advanced Traffic Management
Guide

stp Multiple-instance spanning tree
protocol/MSTP (802.1s): Ensures
that only one active path exists
between any two nodes in a group
of VLANs in the network. MSTP
operation is designed to avoid loops
and broadcast storms of duplicate
messages that can bring down the
network.

Advanced Traffic Management
Guide

system Switch management, including
system configuration, switch
bootup, activation of boot ROM
image, memory buffers, traffic and
security filters.

System messages also include
events from management interfaces
(menu and CLI) used to reconfigure
the switch and monitor switch status
and performance.

Management and Configuration
Guide

Access Security Guide

tacacs TACACS+ authentication: A central
server is used to control access to
the switches (and other TACACS-
aware devices) in the network
through a switch's console port
(local access) or Telnet (remote
access).

Access Security Guide

Table Continued
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System module Description Documented in HPE Switch
hardware/software guide

tcp Transmission Control Protocol: A
transport protocol that runs on IP
and is used to set up connections.

Advanced Traffic Management
Guide

telnet Session established on the switch
from a remote device through the
Telnet virtual terminal protocol.

Management and Configuration
Guide

tftp Trivial File Transfer Protocol:
Supports the download of files to
the switch from a TFTP network
server.

Management and Configuration
Guide

timep Time Protocol: Synchronizes and
ensures a uniform time among
interoperating devices.

Management and Configuration
Guide

update Updates (TFTP or serial) to HPE
switch software and updates to
running-config and start-up config
files

Management and Configuration
Guide

vlan Static 802.1Q VLAN operations,
including port-and protocol-based
configurations that group users by
logical function instead of physical
location

A port-based VLAN creates a
layer-2 broadcast domain
comprising member ports that
bridge IPv4 traffic among
themselves.

VLAN messages include events
from management interfaces (menu
and CLI) used to reconfigure the
switch and monitor switch status
and performance.

Advanced Traffic Management
Guide

xmodem Xmodem: Binary transfer feature
that supports the download of
software files from a PC or UNIX
workstation.

Management and Configuration
Guide

Using the Menu
To display the Event Log from the Main Menu, select Event Log. The following example shows a sample event
log display.

Chapter 17 Troubleshooting 335

Anexo 04 ITEM 10 (0592646)         SEI 0008478-63.2018.6.02.8000 / pg. 5394



An event log display

Switch 5406zl                                     25-Oct-2013  18:02:52
==========================-CONSOLE - MANAGER MODE -
=============================
M 10/25/13 16:30:02 sys: 'Operator cold reboot from CONSOLE session.'
I 10/25/13 17:42:51 00061 system: ------------------------------------------
-
I 10/25/13 17:42:51 00063 system: System went down : 10/25/13 16:30:02
I 10/25/13 17:42:51 00064 system: Operator cold reboot from CONSOLE session.
W 10/25/13 17:42:51 00374 chassis: WARNING: SSC is out of Date: Load 8.2 or
newer
I 10/25/13 17:42:51 00068 chassis: Slot D Inserted
I 10/25/13 17:42:51 00068 chassis: Slot E Inserted
I 10/25/13 17:42:51 00068 chassis: Slot F Inserted
I 10/25/13 17:42:51 00690 udpf: DHCP relay agent feature enabled
I 10/25/13 17:42:51 00433 ssh: Ssh server enabled
I 10/25/13 17:42:51 00400 stack: Stack Protocol disabled
I 10/25/13 17:42:51 00128 tftp: Enable succeeded
I 10/25/13 17:42:51 00417 cdp: CDP enabled

----  Log events stored in memory 1-751. Log events on screen 690-704.

  Actions->    Back    Next page    Prev page    End    Help

Return to previous screen.
Use up/down arrow to scroll one line, left/right arrow keys to
change action selection, and <Enter> to execute action.
The log status line below the recorded entries states the total number of events stored in the event log and
which logged events are currently displayed.

To scroll to other entries in the Event Log, either preceding or following the currently visible portion, press the keys
indicated at the bottom of the display (Back,Nextpage, Prev page, or End) or the keys described in the
following table.

Event Log control keys

Key Action

[N] Advances the display by one page (next page).

[P] Rolls back the display by one page (previous page).

[v] Advances display by one event (down one line).

[ˆ] Rolls back display by one event (up one line).

[E] Advances to the end of the log.

[H] Displays Help for the Event Log.

Using the CLI
Syntax:

By default, the show logging command displays the log messages recorded since the last reboot in
chronological order:
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-a Displays all recorded log messages, including those before the last reboot.

-b Displays log events as the time since the last reboot instead of in a date/time format.

-r Displays all recorded log messages, with themost recent entries listed first (reverse order).

-s Displays the active management module (AM) and standby management module (SM) log
events.

-t Displays the log events with a granularity of 10 milliseconds.

-m Displays only major log events.

-e Displays only error event class.

-p Displays only performance log events.

-w Displays only warning log events.

-i Displays only informational log events.

-d Displays only debug log events.

filter Displays only log filter configuration and status information.

<option-
str>

Displays all Event Log entries that contain the specified text. Use an <option-str> value with -a or
-r to further filter show logging command output.

Example:

To display all Event Log messages that have "system" in the message text or module name, enter the following
command:

switch# show logging -a system
To display all Event Log messages recorded since the last reboot that have the word "system" in the message
text or module name, enter:

switch# show logging system

Clearing Event Log entries
Syntax:

Removes all entries from the event log display output.

Use the clear logging command to hide, but not erase, Event Log entries displayed in show logging
command output. Only new entries generated after you enter the command will be displayed.

To redisplay all hidden entries, including Event Log entries recorded prior to the last reboot, enter the show
logging -a command.
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Turning event numbering on
Syntax:

[no] log-numbers
Turns event numbering on and off

Using log throttling to reduce duplicate Event Log and SNMP messages
A recurring event can generate a series of duplicate Event Log messages and SNMP traps in a relatively short
time. As a result, the Event Log and any configured SNMP trap receivers may be flooded with excessive, exactly
identical messages. To help reduce this problem, the switch uses log throttle periods to regulate (throttle)
duplicate messages for recurring events, and maintains a counter to record how many times it detects duplicates
of a particular event since the last system reboot.

When the first instance of a particular event or condition generates a message, the switch initiates a log throttle
period that applies to all recurrences of that event. If the logged event recurs during the log throttle period, the
switch increments the counter initiated by the first instance of the event, but does not generate a new message.

If the logged event repeats again after the log throttle period expires, the switch generates a duplicate of the first
message, increments the counter, and starts a new log throttle period during which any additional instances of the
event are counted, but not logged. Thus, for a particular recurring event, the switch displays only one message in
the Event Log for each log throttle period in which the event reoccurs. Also, each logged instance of the event
message includes counter data showing how many times the event has occurred since the last reboot. The switch
manages messages to SNMP trap receivers in the same way.

Log throttle periods
The length of the log throttle period differs according to an event's severity level:

Severity level Log throttle period

I (Information) 6000 Seconds

W (Warning) 600 Seconds

D (Debug) 60 Seconds

M (Major) 6 Seconds

Example:

Suppose that you configure VLAN 100 on the switch to support PIM operation, but do not configure an IP
address. If PIM attempts to use VLAN 100, the switch generates the first instance of the following Event Log
message and counter.

In The first instance of an event message and counter on page 338 the counter (1) indicates that
this is the first instance of this event since the switch last rebooted.

The first instance of an event message and counter

W 10/01/12 09:00:33 PIM:No IP address configured on VID 100 (1)
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If PIM operation causes the same event to occur six more times during the initial log throttle period, there are no
further entries in the Event Log. However, if the event occurs again after the log throttle period has expired, the
switch repeats the message (with an updated counter) and starts a new log throttle period.

Figure 61: Duplicate messages over multiple log throttling periods

Note that if the same type of event occurs under different circumstances, the switch handles these as unrelated
events for the purpose of Event Log messages. For example, if PIM operation simultaneously detects that VLANs
100 and 205 are configured without IP addresses, you see log messages similar to the following:

Figure 62: Example: of log messages generated by unrelated events of the same type

Example: of event counter operation
Suppose the switch detects the following after a reboot:

• Three duplicate instances of the PIM "Send error" during the first log throttle period for this event

• Five more instances of the same Send error during the second log throttle period for this event

• Four instances of the same Send error during the third log throttle period for this event

In this case, the duplicate message appears three times in the Event Log (once for each log throttle period for the
event being described), and the duplicate message counter increments as shown in the following table. (The
same operation applies for messages sent to any configured SNMP trap receivers.)

Table 29: How the duplicate message counter increments

Instances during 1st log
throttle period

Instances during 2nd log
throttle period

Instances during 3rd log
throttle period

Duplicate message
counter1

3 1

5 4

4 9

Chapter 17 Troubleshooting 339

Anexo 04 ITEM 10 (0592646)         SEI 0008478-63.2018.6.02.8000 / pg. 5398



1 This value always comprises the first instance of the duplicate message in the current log throttle period plus all previous
occurrences of the duplicate message occurring since the switch last rebooted.

Reporting information about changes to the running configuration
Syslog can be used for sending notifications to a remote syslog server about changes made to the running
configuration. The notifications in the syslog messages are sent in ASCII format and contain this information:

• Notice-Type: Describes the syslog notification as a “running config change”.

• Event-ID: Identifier for the running config change event that occurred on the switch.

• Config-Method: The source for the running config change.

• Device-Name: The managed device.

• User-Name: User who made the running config change.

• Remote-IP-Address: IP address of a remote host from which the user is connected.

Syntax:

[no] logging notify <running-config-change> [transmission-interval <0-4294967295>
Enables sending the running configuration change notifications to the syslog server.

The no form of the command disables sending the running configuration changes to the syslog server.

Default: Disabled

<running-config-change > Mandatory option for the notify parameter. Specifies the type of
notification to send.

transmission-interval
<0-4294967295> Specifies the time interval (in seconds) between the

transmission of two consecutive notifications. Running config
changes occurring within the specified interval will not generate
syslog notifications.

A value of zero means there is no limit; a notification is sent for every running config change.

Default: Zero

Sending running config changes to the syslog server

switch(config)# logging notify running-config-change
transmission-interval 10

Debug/syslog operation
While the Event Log records switch-level progress, status, and warning messages on the switch, the debug/
system logging (syslog) feature provides a way to record Event Log and debug messages on a remote device.
For example, you can send messages about routing misconfigurations and other network protocol details to an
external device, and later use them to debug network-level problems.

Debug/syslog messaging
The debug/syslog feature allows you to specify the types of Event Log and debug messages that you want to
send to an external device. You can perform the following operations:
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• Use the debug commandto configure messaging reports for the following event types:

◦ Events recorded in the switch's Event Log

◦ LLDP events

◦ SSH events

• Use the logging commandto select a subset of Event Log messages to send to an external device for
debugging purposes according to:

◦ Severity level

◦ System module

Hostname in syslog messages
The syslog now messages the sender identified by hostname.

The hostname field identifies the switch that originally sends the syslog message. Configurable through the CLI
and SNMP, the format of the hostname field supports the following formats:

• ip-address: The IP address of the sending interface will be used as the message origin identifier. This is the
default format for the origin identifier. The IP address of the sending interface (in dotted decimal notation) is the
default format.

• hostname: The hostname of the sending switch will be used as the message origin identifier.

• none: No origin identifier will be embedded in the syslog message. Nilvalue is used as defined by “-“.

This configuration is system-wide, not per syslog server. There is no support for fully-qualified domain name.

Logging origin-id
Use the logging origin-id command to specify the content for the hostname field.

Syntax:

logging origin-id [ip-address|hostname|none]

[no] logging origin-id [ip-address|hostname|none]
To reset the hostname field content back to default (IP-address), use the no form of the command.

filter

Creates a filter to restrict which events are logged.

IP-ADDR

Adds an IPv4 address to the list of receiving syslog servers.

IPV6-ADDR

Adds an IPv6 address to the list of receiving syslog servers.

origin-id

Sends the Syslog messages with the specified origin-id.
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notify

Notifies the specified type sent to the syslog server(s).

priority-descr

A text string associated with the values of facility, severity, and system-module.

severity

Event messages of the specified severity or higher sent to the syslog server.

system-module

Event messages of the specified system module (subsystem) sent to the syslog server.

hostname

Sets the hostname of the device as the origin-id.

none

Disables origin-id in the syslog message.

Add an IP address to the list of receiving syslog servers.

Use of no without an IP address specified will remove all IP addresses from the list of syslog receivers. If an IP
address is specified, that receiver will be removed. Both link-local with zone ID and global IPv6 addresses are
supported.

• Specify syslog server facility with the option <facility>. The command no logging <facility> sets
the facility back to defaults.

• Specify filtering rules.

• Specify severity for event messages to be filtered to the syslog server with the option <severity>. The
command no logging <severity> sets the severity back to default.

• Event messages of specified system module will be sent to the syslog server. Using no sends messages from
all system modules. Messages are first filtered by selected severity.

• Specify syslog server transport layer with options [udp]|[tcp]|[tls].

• Specify syslog server port number with options [udp PORT-NUM]|[tcp PORT-NUM]|[tls PORT-NUM].

• Specify notification types to be sent to the syslog server.

• Use the option transmission-interval to control the egress rate limit for transmitting notifications, 0 value
means there is no rate limit. The values are in seconds. Only one syslog message is allowed for transmission
within specified time interval.

• Specify the origin information for the syslog messages with the option origin-id.
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When the syslog server receives messages from the switch, the IPv6 address of the switch is partly
displayed.

Example:

Configured Host Ipv6 Address: 2001::1

Expected Syslog message:

Syslog message: USER.INFO: Oct 11 02:40:02 2001::1 00025 ip:
ST1CMDR: VLAN60: ip address 30.1.1.1/24 configured on vlan 60
Actual Truncated syslog message:

Syslog message: USER.INFO: Oct 11 02:40:02 2001:: 00025 ip: ST1CMDR:
VLAN60: ip address 30.1.1.1/24 configured on vlan 60

Use the command in the following example to set the origin-id to the hostname.

Setting the origin-id to the hostname

switch(config)# logging origin-id hostname
The following syslog message will occur:

<14> Jan 1 00:15:35 HP-2910al-24G 00076 ports: port 2 is now on-line
Use the command in the following example to set the origin-id to none (nilvalue).

Setting the origin-id to none (nilvalue)

switch(config)# logging origin-id none
The following syslog message will occur:

<14> Jan 1 00:15:35 - 00076 ports: port 2 is now on-line
Use any of the commands in the following example to set the origin-id to ip-address (default).

Setting the origin-id to ip-address (default)

switch(config)# logging origin-id ip-address

switch(config)# no logging origin-id hostname

switch(config)# no logging origin-id none
The following syslog message will occur:

<14> Jan 1 00:15:35 169.254.230.236 00076 ports: port 2 is now on-line

Viewing the identification of the syslog message sender
Use the commands show debug or show running-config to display the identification of the syslog message
sender. The default option for origin-id is ip-address. The command show running-config will not
display the configured option when origin-id is set to the default value of ip address.

When hostname or none is configured using logging origin-id, the same displays as part of the show
running-config command.
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Syntax:

show debug
Default option is ip-address.

The following shows the output of the show debug command when configured without loggin origin-id.

Output of the show debug command when configured without login origin-id

Debug Logging
  Origin identifier: Outgoing Interface IP
  Destination:     None

Enabled debug types:
  None are enabled.
The command logging origin-id hostname will produce the syslog message shown in the following
example.

Syslog message for logging origin-id hostname

Debug Logging
  Origin identifier: Hostname
  Destination:    None

Enabled debug types:
  None are enabled.
The command logging origin-id none will produce the syslog message shown in the following example.

Syslog message for logging origin-id none

Debug Logging
  Origin identifier: none
  Destination:    None

Enabled debug types:
  None are enabled.
Syntax:

show running-config
The following example shows the output of the show running-config command.

Output of the show running-config command

The command logging origin-id hostname will display the 
following:
logging origin-id hostname
The command logging origin-id none will display as the following:

logging origin-id none
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SNMP MIB
SNMP support will be provided through the following MIB objects.

HpicfSyslogOriginId = textual-convention

Description

This textual convention enumerates the origin identifier of syslog message.

Syntax: integer

ip-address

hostname

none

Status

current

hpicfSyslogOriginId OBJECT-TYPE

Description

Specifies the content of a Hostname field in the header of a syslog message.

Syntax:

HpicfSyslogOriginId

Max-access

read-write

Status

current

Default

ip-address

Debug/syslog destination devices
To use debug/syslog messaging, you must configure an external device as the logging destination by using the
logging and debug destination commands. For more information, see Debug destinations on page 353
and Configuring a syslog server on page 355.

A debug/syslog destination device can be a syslog server and/or a console session. You can configure debug and
logging messages to be sent to:

• Up to six syslog servers

• A CLI session through a direct RS-232 console connection, or a Telnet or SSH session
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Debug/syslog configuration commands

Event notification logging — Automatically sends switch-level
event messages to the switch's
Event Log. Debug and syslog do
not affect this operation, but add the
capability of directing Event Log
messaging to an external device.

logging command <syslog-ip-addr> Enables syslog messaging to be
sent to the specified IP address.
IPv4 and IPv6 are supported.

facility (Optional) The logging
facility command specifies the
destination (facility) subsystem used
on a syslog server for debug
reports.

priority-desc A text string associated with the
values of facility, severity, and
system-module.

severity Sends Event Log messages of
equal or greater severity than the
specified value to configured debug
destinations. (The default setting is
to send Event Log messages from
all severity levels.)

system-module Sends Event Log messages from
the specified system module to
configured debug destinations. The
severity filter is also applied to the
system-module messages you
select.

The default setting is to send Event
Log messages from all system
modules. To restore the default
setting, enter the no logging
system-module <system-
module> or logging system-
module all-pass commands.

all Sends debug logging to configured
debug destinations for all ACL,
Event Log, IP-OSPF, and IP-RIP
options.

Table Continued
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destination logging: Disables or re-enables
syslog logging on one or more
syslog servers configured with the
logging syslog-ip-addr
command.session: Assigns or re-
assigns destination status to the
terminal device that was most
recently used to request debug
output.buffer: Enables syslog
logging to send the debug message
types specified by the debug
<debug-type> command to a
buffer in switch memory.

event Sends standard Event Log
messages to configured debug
destinations. (The same messages
are also sent to the switch's Event
Log, regardless of whether you
enable this option.)

ip forwarding: Sends IPv4
forwarding messages to the debug
destinations.packet: Sends IPv4
packet messages to the debug
destinations.rip: Sends RIP event
logging to the debug destinations.

ipv6 dhcpv6-client: Sends DHCPv6
client debug messages to the
configured debug
destination.forwarding: Sends
IPv6 forwarding messages to the
debug destination(s)nd: Sends IPv6
debug messages for IPv6 neighbor
discovery to the configured debug
destinations.packet: Sends IPv6
packet messages to the debug
destinations.

lldp Sends LLDP debug messages to
the debug destinations.

ssh Sends SSH debug messages at the
specified level to the debug
destination. The levels are fatal,
error, info, verbose, debug, debug2,
and debug3.

Using the Debug/Syslog feature, you can perform the following operations:
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• Configure the switch to send Event Log messages to one or more Syslog servers. In addition, you can
configure the messages to be sent to the User log facility (default) or to another log facility on configured
Syslog servers.

• Configure the switch to send Event Log messages to the current management- access session (serial-connect
CLI, Telnet CLI, or SSH).

• Disable all Syslog debug logging while retaining the Syslog addresses from the switch configuration. This
allows you to configure Syslog messaging and then disable and re-enable it as needed.

• Display the current debug configuration. If Syslog logging is currently active, the list f configured Syslog
servers is displayed.

• Display the current Syslog server list when Syslog logging is disabled.

Configuring debug/syslog operation

Procedure

1. To use a syslog server as the destination device for debug messaging, follow these steps:

a. Enter the logging <syslog-ip-addr> command at the global configuration level to configure the
syslog server IP address and enable syslog logging. Optionally, you may also specify the destination
subsystem to be used on the syslog server by entering the logging facility command.If no other
syslog server IP addresses are configured, entering the logging command enables both debug
messaging to a syslog server and the event debug message type. As a result, the switch automatically
sends Event Log messages to the syslog server, regardless of other debug types that may be configured.

b. Re-enter the logging command in Step 1a to configure additional syslog servers. You can configure up to
a total of six servers. (When multiple server IP addresses are configured, the switch sends the debug
message types that you configure in Step 3 to all IP addresses.)

2. To use a CLI session on a destination device for debug messaging:

a. Set up a serial, Telnet, or SSH connection to access the switch's CLI.

b. Enter the debug destination session command at the manager level.

3. Enable the types of debug messages to be sent to configured syslog servers, the current session device, or
both by entering the debug <debug-type> command and selecting the desired options.

Repeat this step if necessary to enable multiple debug message types.

By default, Event Log messages are sent to configured debug destination devices. To block Event Log
messages from being sent, enter the no debug event command.

4. If necessary, enable a subset of Event Log messages to be sent to configured syslog servers by specifying a
severity level, a system module, or both using the following commands:

switch(config)# logging severity <debug | major | error | warning | info>
switch(config)# logging system-module <system-module>

To display a list of valid values for each command, enter logging severity or logging system-module
followed by ? or pressing the Tab key.
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The severity levels in order from the highest to lowest severity are major, error, warning, info, and debug. For a
list of valid values for the logging system-module <system-module> command, see Event Log
system modules.

5. If you configure system-module, severity-level values, or both to filter Event Log messages, when you finish
troubleshooting, you may want to reset these values to their default settings so that the switch sends all Event
Log messages to configured debug destinations (syslog servers, CLI session, or both).

To remove a configured setting and restore the default values that send all Event Log messages, enter one or
both of the following commands:

switch(config)# no logging severity <debug | major | error | warning | info>
switch(config)# no logging system-module <system-module>

If you configure a severity-level, system-module, logging destination, or logging facility value and
save the settings to the startup configuration (For example, by entering the write memory
command), the debug settings are saved after a system reboot (power cycle or reboot) and re-
activated on the switch. As a result, after switch startup, one of the following situations may occur:

• Only a partial set of Event Log messages may be sent to configured debug destinations.

• Messages may be sent to a previously configured syslog server used in an earlier debugging
session.

Viewing a debug/syslog configuration
Use the show debug command to display the currently configured settings for:

• Debug message types and Event Log message filters (severity level and system module) sent to debug
destinations

• Debug destinations (syslog servers or CLI session) and syslog server facility to be used

Syntax:

show debug
Displays the currently configured debug logging destinations and message types selected for debugging
purposes. (If no syslog server address is configured with the logging <syslog-ip-addr> command, no
show debug command output is displayed.)

Output of the show debug command

switch(config)# show debug

 Debug Logging
  Destination:
   Logging --
    10.28.38.164
    Facility=kern
    Severity=warning
    System module=all-pass
   Enabled debug types:
    event
Example:
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In the following Example:, no syslog servers are configured on the switch (default setting). When you configure a
syslog server, debug logging is enabled to send Event Log messages to the server. To limit the Event Log
messages sent to the syslog server, specify a set of messages by entering the logging severity and
logging system-module commands.

Figure 63: Syslog configuration to receive event log messages from specified system module and severity levels

As shown at the top of Figure 63: Syslog configuration to receive event log messages from specified
system module and severity levels on page 350, if you enter the show debug command when no syslog
server IP address is configured, the configuration settings for syslog server facility, Event Log severity level, and
system module are not displayed. However, after you configure a syslog server address and enable syslog
logging, all debug and logging settings are displayed with the show debug command.

If you do not want Event Log messages sent to syslog servers, you can block the messages from being sent by
entering the no debug event command. (There is no effect on the normal logging of messages in the switch's
Event Log.)

Example:

The next Example: shows how to configure:

• Debug logging of ACL and IP-OSPF packet messages on a syslog server at 18.38.64.164 (with user as the
default logging facility).

• Display of these messages in the CLI session of your terminal device's management access to the switch.

• Blocking Event Log messages from being sent from the switch to the syslog server and a CLI session.
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To configure syslog operation in these ways with the debug/syslog feature disabled on the switch, enter the
commands shown in Figure 64: Debug/syslog configuration for multiple debug types and multiple
destinations on page 351.

Figure 64: Debug/syslog configuration for multiple debug types and multiple destinations

Debug command
At the manager level, use the debug command to perform two main functions:

• Specify the types of event messages to be sent to an external destination.

• Specify the destinations to which selected message types are sent.

By default, no debug destination is enabled and only Event Log messages are enabled to be sent.

To configure a syslog server, use the logging <syslog-ip-addr> command. For more
information, see Configuring a syslog server on page 355.

Debug messages
Syntax:

[no] debug <debug-type>
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all Configures the switch to send all debug message
types to configured debug destinations.(Default:
Disabled—No debug messages are sent.)

cdp Sends CDP information to configured debug
destinations.

destination logging—Disables or re-enables syslog logging on
one or more syslog servers configured with the
logging <syslog-ip-addr>
command.session—Assigns or re-assigns
destination status to the terminal device that was
most recently used to request debug output.buffer
—Enables syslog logging to send the debug
message types specified by the debug <debug-
type> command to a buffer in switch memory.

event Configures the switch to send Event Log messages
to configured debug destinations.

This value does not affect the reception
of event notification messages in the
Event Log on the switch.

Event Log messages are automatically enabled to
be sent to debug destinations in these conditions:

• If no syslog server address is configured and you
enter the logging <syslog-ip-addr>
command to configure a destination address.

• If at least one syslog server address is configured
in the startup configuration, and the switch is
rebooted or reset.

Event log messages are the default type of debug
message sent to configured debug destinations.

ip [fib | packet] Sends IP messages to configured destinations.

ip [fib [events]] For the configured debug destinations:events—
Sends IP forwarding information base events.

ip [packet] Enables the specified PIM message type.

Table Continued
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ipv6 [dhcpv6-client | nd | packet] See the "IPv6 Diagnostic and
Troubleshooting" in the IPv6
configuration guide for your switch for
more detailed IPv6 debug options.

When no debug options are included, displays
debug messages for all IPv6 debug options.
dhcpv6-client [events | packet]—Displays
DHCPv6 client event and packet data.nd—Displays
debug messages for IPv6 neighbor
discovery.packet—Displays IPv6 packet messages.

lldp Enables all LLDP message types for the configured
destinations.

security [port-access | port-security |
radius-server | ssh | tacacs-server |
user-profile-mib]

port-access—Sends port-access debug
messages to the debug destination.radius-
server—Sends RADIUS debug messages to the
debug destination.ssh—Sends SSH debug
messages at the specified level to the debug
destination. The levels are fatal, error, info, verbose,
debug, debug2, and debug3.tacacs-server—
Sends TACACS debug messages to the debug
destination.user-profile-mib—Sends user
profile MIB debug messages to the debug
destination.

snmp <pdu> Displays the SNMP debug messages.pdu—Displays
SNMP pdu debug messages.

Debug destinations
Use the debug destination command to enable (and disable)syslog messaging on a syslog server or to a CLI
session for specified types of debug and Event Log messages.

Syntax:

[no] debug destination {<logging | session | buffer>}
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logging Enables syslog logging to configured syslog servers so that the debug message types
specified by the debug <debug-type> command (see Debug messages on page 351)
are sent.(Default: Logging disabled)To configure a syslog server IP address, see 
Configuring a syslog server on page 355.

Debug messages from the switches covered in this guide have a debug
severity level. Because the default configuration of some syslog servers
ignores syslog messages with the debug severity level, ensure that the
syslog servers you want to use to receive debug messages are configured to
accept the debug level. For more information, see Operating notes for
debug and Syslog on page 364.

session Enables transmission of event notification messages to the CLI session that most recently
executed this command. The session can be on any one terminal emulation device with
serial, Telnet, or SSH access to the CLI at the Manager level prompt (switch#_).If more
than one terminal device has a console session with the CLI, you can redirect the
destination from the current device to another device. Do so by executing debug
destination session in the CLI on the terminal device on which you now want to
display event messages.Event message types received on the selected CLI session are
configured with the debug <debug-type> command.

buffer Enables syslog logging to send the debug message types specified by the debug
<debug-type> command to a buffer in switch memory.To view the debug messages
stored in the switch buffer, enter the show debug buffer command.

Logging command
At the global configuration level, the loggingcommand allows you to enable debug logging on specified syslog
servers and select a subset of Event Log messages to send for debugging purposes according to:

• Severity level

• System module

By specifying both a severity level and system module, you can use both configured settings to filter the Event
Log messages you want to use to troubleshoot switch or network error conditions.

After you configure a syslog server and a severity level and/or system module to filter the Event Log
messages that are sent, if you save these settings to the startup configuration file by entering the
write memory command, these debug and logging settings are automatically re-activated after a
switch reboot or power recycle. The debug settings and destinations configured in your previous
troubleshooting session will then be applied to the current session, which may not be desirable.

After a reboot, messages remain in the Event Log and are not deleted. However, after a power
recycle, all Event Log messages are deleted.

If you configure a severity level, system module, or both to temporarily filter Event Log messages, be
sure to reset the values to their default settings by entering the no form of the following commands to
ensure that Event Log messages of all severity levels and from all system modules are sent to
configured syslog servers:

switch(config)# no logging severity <debug | major | error | warning | 
info>
switch(config)# no logging system-module <system-module>
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Configuring a syslog server
Syslog is a client-server logging tool that allows a client switch to send event notification messages to a
networked device operating with syslog server software. Messages sent to a syslog server can be stored to a file
for later debugging analysis.

To use the syslog feature, you must install and configure a syslog server application on a networked host
accessible to the switch. For instructions, see the documentation for the syslog server application.

To configure a syslog service, use the logging <syslog-ip-addr> command as shown below.

When you configure a syslog server, Event Log messages are automatically enabled to be sent to the server. To
reconfigure this setting, use the following commands:

• debug
Specifies additional debug message types (see Debug messages on page 351).

• logging
Configures the system module or severity level used to filter the Event Log messages sent to configured
syslog servers. (See Configuring the severity level for Event Log messages sent to a syslog server on
page 363 and Configuring the system module used to select the Event Log messages sent to a syslog
server on page 364.)

To display the currently configured syslog servers as well as the types of debug messages and the severity-level
and system-module filters used to specify the Event Log messages that are sent, enter the show debug
command (See Debug/syslog configuration commands on page 346).

Syntax:

[no] logging <syslog-ip-addr>
Enables or disables syslog messaging to the specified IP address. You can configure up to six addresses. If you
configure an address when none are already configured, this command enables destination logging (syslog) and
the Event debug type. Therefore, at a minimum, the switch begins sending Event Log messages to configured
syslog servers. The ACL, IP-OSPF, and/or IP-RIP message types are also sent to the syslog servers if they are
currently enabled as debug types. (See Debug messages on page 351.)

no logging Removes all currently configured syslog logging destinations from the
running configuration.Using this form of the command to delete the only
remaining syslog server address disables debug destination logging on the
switch, but the default Event debug type does not change.

no logging <syslog-ip-
address> Removes only the specified syslog logging destination from the running

configuration.Removing all configured syslog destinations with the no
logging command (or a specified syslog server destination with the no
logging <syslog-ip-address> command) does not delete the syslog
server IP addresses stored in the startup configuration.

Deleting syslog addresses in the startup configuration
Enter a no logging command followed by the write memory command.

Verifying the deletion of a syslog server address
Display the startup configuration by entering the show config command.
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Blocking the messages sent to configured syslog servers from the currently configured
debug message type
Enter the no debug <debug-type> command. (See Debug messages on page 351.)

Disabling syslog logging on the switch without deleting configured server addresses
Enter the no debug destination logging command. Note that, unlike the case in which no syslog servers
are configured, if one or more syslog servers are already configured and syslog messaging is disabled,
configuring a new server address does not re-enable syslog messaging. To re-enable syslog messaging, you
must enter the debug destination logging command.

Sending logging messages using TCP
Syntax:

[no] logging <ip-addr> [udp 1024-49151 | tcp 1024-49151]
Allows the configuration of the UDP or TCP transport protocol for the transmission of logging messages to a
syslog server.

Specifying a destination port with UDP or TCP is optional.

Default ports: UDP port is 514

TCP port is 1470

Default Transport Protocol: UDP

Because TCP is a connection-oriented protocol, a connection must be present before the logging information is
sent. This helps ensure that the logging message will reach the syslog server. Each configured syslog server
needs its own connection. You can configure the destination port that is used for the transmission of the logging
messages.

Configuring TCP for logging message transmission using the default port

switch(config)# logging 192.123.4.5 tcp
(Default TCP port 1470 is used.)

Configuring TCP for logging message transmission using a specified port

switch(config)# logging 192.123.4.5 9514
(TCP port 9514 is used.)

Configuring UDP for logging message transmission using the default port

switch(config)# logging 192.123.4.5 udp
(Default UDP port 514 is used.)

Configuring UDP for logging message transmission using a specified port

switch(config)# logging 192.123.4.5 9512
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(UDP port 9512 is used.)

Syntax:

[no] logging facility <facility-name>
The logging facility specifies the destination subsystem used in a configured syslog server. (All configured syslog
servers must use the same subsystem.) Hewlett Packard Enterprise recommends the default (user) subsystem
unless your application specifically requires another subsystem. Options include:

user (default) Random user-level messages

kern Kernel messages

mail Mail system

daemon System daemons

auth Security/authorization messages

syslog Messages generated internally by syslog

lpr Line-printer subsystem

news Netnews subsystem

uucp uucp subsystem

cron cron/at subsystem

sys9 cron/at subsystem

sys10 - sys14 Reserved for system use

local10 - local17 Reserved for system use

Use the no form of the command to remove the configured facility and reconfigure the default (user) value.

Disable LinkUp/Down Syslog messages based on port
This feature provides a per-port basis filter that can restrict the logging of events that are associated with a link
status change. Unimportant linkup/linkdown events can be filtered out, avoiding unwanted messages in the event
log and reducing troubleshooting time.

The specific port-based events to be controlled are:

RMON_PMGR_PORT_UP—Indicates that the port has changed from and off-line to an on-line state. To be online
the port must be both connected to the LAN and enabled through configuration.

RMON_PMGR_PORT_DOWN—Indicates that the port has changed from an on-line state to an offline state. For
this state to occur, the port is physically disconnected from the LAN, disabled through the configuration, or both.

The following rules apply:

• Only one filter can be enabled at a time.

• The maximum number of configured filters is 10.

• A filter is identified by a unique name of up to 16 printable ASCII characters.
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• Filters can be dynamically replaced; the newly enabled filter automatically disables the previous filter.

• A filter always contains a default sub-filter that functions as the filtering rules terminator.

• To apply filtering to an event logging process, the filter must be explicitly enabled from the CLI.

• Enabled filter modules can be dynamically modified; the changes will take effect immediately.

A filter module may include up to 19 option sub-filters and a default sub-filter. The sub-filter types are:

• Severity—checks the severity level of the event log message. The severity values are:

◦ major

◦ warning

◦ error

◦ info

◦ debug

• Event number—Checks the event number of the event log message.

• Regular expression—Checks everything beyond the date/time portion of the event log message.

A sub-filter has a sequence number, criteria to be matched, and a resulting action when a match occurs. All of the
parameters must be specified in order to create the sub-filter.

• Sequence number: Used for the ordering of sub-filters. Range 1-98.

• Matching criteria: Can be the severity level, event number, or a regular expression.

• Action to execute: When a match occurs, the resulting action is either permit the logging of the event, or deny
the logging of the event.

The following sub-filter rules apply:

• Up to 19 optional sub-filters and a default sub-filter are allowed in a filter module.

• Sub-filters in the filter module can be of the same or different types.

• Sub-filter entries can be modified with new criteria and action definitions.

• Sub-filters are executed from the lowest sequence number to the highest. As soon as a match is found the log
event is immediately accepted or rejected and no further matching operation is performed.

• The default sub-filter must always be the last entry in a filter module. It functions as the rules terminator when
the criteria matching performed by the prior sub-filters in a filter does not produce an action.

• The default sub-filter cannot be deleted, re-ordered, or changed. The only parameter that can be modified is
the action parameter of permit or deny. The default is permit.

Creating a filter
Syntax:

[no] logging filter <name> <sequence> [severity <severity>|event-num <num>|<regexp>] [permit|deny]
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Creates a logging filter to restrict which events are logged. The no form of the command removes the logging
filter.

<name>: The name that identifies the filter.

severity <severity>: Specifies the severity of an event—major, warning, error, info, or debug.

event-num <num>: Specifies an event number to match.

deny: If the log entry matches the specified criteria, do not log the event message. No further criteria are
evaluated for a match.

permit: If the log entry matches the specified criteria, log the event message. No further criteria are evaluated for
a match.

Enabling a Filter after Creation
Syntax:

[no] logging filter <name> enable | disable
Enables a log filter. Only one filter can be enabled at a time. An enabled filter automatically disables a previously
enabled filter.

<name>: The name that identifies the filter.

Clearing a Filter
Syntax:

[no] clear logging filter <name|all>
Clears statistics counters for the named logging filter or for all filters.

Viewing Filter Configuration Information
Syntax:

show logging filter name
Displays the logging filter’s configuration information. The Matches column indicates the number of times that
criteria has matched.

Specifying the criteria for a filter and then enabling the filter

switch(config)# logging filter SevWarnFatal 10 severity warning permit
switch(config)# logging filter SevWarnFatal 20 severity major permit
switch(config)# logging filter SevWarnFatal default deny

switch(config)# logging filter SevWarnFatal enable

1. The filter named SevWarnFatal adds a sub-filter of the severity type, with a sequence number of 10. The sub-
filter specifies that a match for an event log message with a severity of “warning” will be logged.

2. The second sub-filter has a sequence number of 20 and a severity type of major. The sub-filter specifies that a
match for an event log message with a severity of “major” will be logged.
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3. The default sub-filter, which is created automatically at the time of filter creation, is always the last entry in the
filter module. It matches “anything” and cannot be changed. You can change the actions to either permit or
deny. This example specifies that any message that did not meet the prior matching criteria will not be logged.

4. The last command enables the filter named SevWarnFatal. If there was another filter enabled, this filter
automatically replaces it and the other filter is disabled.

Specifying the criteria for a filter named noUpDownEvents and then enabling the filter

switch(config)# logging filter noUpDownEvent 10 event-num 76 deny
switch(config)# logging filter noUpDownEvent 20 event-num 77 deny
switch(config)# logging filter noUpDownEvent default permit

switch(config)# logging filter noUpDownEvent enable

1. The filter named noUpDownEvents adds a sub-filter with a type of event-num, and a sequence number of 10.
The sub-filter specifies that a match for an event log message with an event number of “76” will not be logged.

2. The second sub-filter has a sequence number of 20 and a type of event-num. The sub-filter specifies that a
match for an event log message with an event number of “77” will not be logged.

3. The default sub-filter, which is created automatically at the time of filter creation, is always the last entry in the
filter module. It matches “anything” and cannot be changed. You can change the actions to either permit or
deny. This example specifies that any message that did not meet the prior matching criteria will be logged.

4. The last command enables the filter named noUpDownEvents. If there was another filter enabled, this filter
automatically replaces it and the other filter is disabled.

Specifying the criteria for a match using a regular expression and then enabling the filter

switch(config)# logging filter noUpPorts 10 "(A10|A22|B5) is now on-line" deny
switch(config)# logging filter noUpPorts default permit

switch(config)# logging filter noUpPorts enable
This example denies logging of the matching regular expression “port <port-num> is now on-line” for ports A10,
A22, and B5.

1. The filter named noUpPorts adds a sub-filter with a type of regular expression for ports A10, A22, and B5. The
sub-filter specifies the matching criteria for the regular expression and if there is a match, the event log
message is not logged.

2. The default sub-filter specifies that any message that did not meet the prior matching criteria will be logged.

3. The last command enables the filter named noUpPorts.

Specifying the criteria for a match using a regular expression for specific ports

switch(config)# logging filter noStpBlockPorts 10 "(A[1-9]|A10|B[1-4])
.*Blocked by STP" permit
switch(config)# logging filter noStpBlockPorts 20 " .*Blocked by STP" deny
switch(config)# logging filter noStpBlockPorts default permit

switch(config)# logging filter noStpBlockPorts enable
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1. The filter named noStpBlockPorts adds a sub-filter with a type of regular expression with a sequence number
of 10. This rule specifies that event messages from ports A1-A10, and B1-B4 with the “.*Blocked by STP”
expression pattern in the message body are logged.

2. The second command adds a sub-filter with a type of regular expression and a sequence number of 20. This
rule specifies that event messages generated from any ports with the “.*Blocked by STP” expression pattern in
the message body are not logged.

3. The default sub-filter specifies that any message that did not meet the prior matching criteria will be logged.

4. The last command enables the filter named noStpBlockPorts.

Output examples:

The configured logging filters

HP Switch# show logging filter

 Status and Counters - Log Filters Information

  Name            Enabled
  --------------- -------
  noUpPorts       No
  SevWarnFatal    No
  noUpDownEvents  No
  noStpBlockPorts Yes

Output for specified logging filters

HP Switch# show logging filter sevWarnFatal

 Status and Counters - Log Filters Information

  Name             : Enabled
  Enabled          : Yes
  Messages Dropped : 0

  Seq Type      Value                               Action Matches
  --- --------  ----------------------------------  ------ -------
  10  Severity  warning                             Permit 2
  20  Severity  major                               Permit 2
  def          (any)                                Deny   0

switch(config)# show logging filter noStpBlockPorts

 Status and Counters - Log Filters Information

  Name             : noStpBlockPorts
  Enabled          : Yes
  Messages Dropped : 0

  Seq Type      Value                                Action Matches
  --- --------  -----------------------------------  ------ -------
  10  RegExp    (A[1-9]|A10|B[1-4]).*Blocked by STP  Permit 2
  20  RegExp    .*Blocked by STP                     Deny   2
  def           (any)                                Permit 0
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Output of running-config file

HP Switch# show running-config

Running configuration:

; J9470A Configuration Editor; Created on release #XX.15.13.0000x
; Ver #04:0f.ff.3f.ef:24
hostname "HP Switch"
module 1 type j94dda
logging filter "noUpPorts" 10 "(A10|A22|B5) is now on-line" deny
logging filter "noUpPorts" default permit
logging filter "SevWarnFatal" 10 severity warning permit
logging filter "SevWarnFatal" 20 severity major permit
logging filter "SevWarnFatal" default deny
logging filter "noUpDownEvent" 10 event-num 76 deny
logging filter "noUpDownEvent" 20 event-num 77 deny
logging filter "noUpDownEvent" default permit
logging filter "noStpBlockPorts" 10 "(A[1-9]|A10|B[1-4]) .*Blocked by STP" permit
logging filter "noStpBlockPorts" 20 " .*Blocked by STP" deny
logging filter "noStpBlockPorts" default permit
logging filter "noStpBlockPorts" enable
snmp-server community "public" unrestricted
snmp-server host 15.255.133.156 community "public"
snmp-server host 15.255.133.146 community "public"
vlan 1
.
.
.

Adding a description for a Syslog server
You can associate a user-friendly description with each of the IP addresses (IPv4 only) configured for syslog
using the CLI or SNMP.

The Hewlett Packard Enterprise MIB hpicfSyslog.mib allows the configuration and monitoring of
syslog for SNMP (RFC 3164 supported).

Entering the no logging command removes ALL the syslog server addresses without a verification
prompt.

The CLI command is:

Syntax:

logging <ip-addr> [control-descr ZZZZTRISHZZZZ <text_string>] 
 no logging <ip-addr> [control-descr]
An optional user-friendly description that can be associated with a server IP address. If no description is entered,
this is blank. If <text_string> contains white space, use quotes around the string. IPv4 addresses only.

Use the no form of the command to remove the description. Limit: 255 characters

To remove the description using SNMP, set the description to an empty string.
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The logging command with a control description

switch(config)# logging 10.10.10.2 control-descr syslog_one

Adding a priority description
This description can be added with the CLI or SNMP. The CLI command is:

Syntax:

logging priority-descr <text_string> 
 no logging priority-descr
Provides a user-friendly description for the combined filter values of severity and system module. If no
description is entered, this is blank.

If text_string contains white space, use quotes around the string.

Use the no form of the command to remove the description.

Limit: 255 characters

The logging command with a priority description

switch(config)# logging priority-descr severe-pri

A notification is sent to the SNMP agent if there are any changes to the syslog parameters, either
through the CLI or with SNMP.

Configuring the severity level for Event Log messages sent to a syslog
server
Event Log messages are entered with one of the following severity levels (from highest to lowest):

Major A fatal error condition has occurred on the switch.

Error An error condition has occurred on the switch.

Warning A switch service has behaved unexpectedly.

Information Information on a normal switch event.

Debug Reserved for HPE switch internal diagnostic information.

Using the logging severity command, you can select a set of Event Log messages according to their
severity level and send them to a syslog server. Messages of the selected and higher severity will be sent. To
configure a syslog server, see Configuring a syslog server on page 355.

Syntax:

[no] logging severity {< major | error | warning | info | debug >}
Configures the switch to send all Event Log messages with a severity level equal to or higher than the specified
value to all configured Syslog servers.

Default: debug (Reports messages of all severity levels.)
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Use the no form of the command to remove the configured severity level and reconfigure the default value, which
sends Event Log messages of all severity levels to syslog servers.

The severity setting does not affect event notification messages that the switch normally sends to the
Event Log. All messages remain recorded in the Event Log.

Configuring the system module used to select the Event Log messages sent to a syslog
server
Event Log messages contain the name of the system module that reported the event. Using the logging
system-module command, you can select a set of Event Log messages according to the originating system
module and send them to a syslog server.

Syntax:

[no] logging system-module <system-module>
Configures the switch to send all Event Log messages being logged from the specified system module to
configured syslog servers. (To configure a syslog server, see Configuring a syslog server.)

See Event Log system modules for the correct value to enter for each system module.

Default: all-pass (Reports all Event Log messages.)

Use the no form of the command to remove the configured system module value and reconfigure the default
value, which sends Event Log messages from all system modules to syslog servers.

You can select messages from only one system module to be sent to a syslog server; you cannot configure
messages from multiple system modules to be sent. If you re-enter the command with a different system module
name, the currently configured value is replaced with the new one.

This setting has no effect on event notification messages that the switch normally sends to the Event
Log.

Operating notes for debug and Syslog

• Rebooting the switch or pressing the Reset button resets the debug configuration.

Debug option Effect of a reboot or reset

logging (debug destination) If syslog server IP addresses are stored in the startup-config file, they are
saved across a reboot and the logging destination option remains enabled.
Otherwise, the logging destination is disabled.

session (debug destination) Disabled.

ACL (debug type) Disabled.

All (debug type) Disabled.

Table Continued
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Debug option Effect of a reboot or reset

event (debug type) If a syslog server IP address is configured in the startup-config file, the
sending of Event Log messages is reset to enabled, regardless of the
last active setting.

If no syslog server is configured, the sending of Event Log messages is
disabled.

IP (debug type) Disabled.

• Debug commands do not affect normal message output to the Event Log.

Using the debug event command, you can specify that Event Log messages are sent to the debug
destinations you configure (CLI session, syslog servers, or both) in addition to the Event Log.

• Ensure that your syslog servers accept debug messages.

All syslog messages resulting from a debug operation have a "debug" severity level. If you configure the switch
to send debug messages to a syslog server, ensure that the server's syslog application is configured to accept
the "debug" severity level. (The default configuration for some syslog applications ignores the "debug" severity
level.)

• Duplicate IP addresses are not stored in the list of syslog servers.

• If the default severity value is in effect, all messages that have severities greater than the default value are
passed to syslog. For example, if the default severity is "debug," all messages that have severities greater
than debug are passed to syslog.

• There is a limit of six syslog servers. All syslog servers are sent the same messages using the same filter
parameters. An error is generated for an attempt to add more than six syslog servers.

Diagnostic tools

Port auto-negotiation
When a link LED does not light (indicating loss of link between two devices), the most common reason is a failure
of port auto-negotiation between the connecting ports. If a link LED fails to light when you connect the switch to a
port on another device, do the following:

Procedure

1. Ensure that the switch port and the port on the attached end-node are both set to Auto mode.

2. If the attached end-node does not have an Auto mode setting, you must manually configure the switch port to
the same setting as the end-node port. See Port Status and Configuration on page 55.

Ping and link tests
The ping test and the link test are point-to-point tests between your switch and another IEEE 802.3-compliant
device on your network. These tests can tell you whether the switch is communicating properly with another
device.
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To respond to a ping test or a link test, the device you are trying to reach must be IEEE 802.3-
compliant.

Ping test
A test of the path between the switch and another device on the same or another IP network that can respond to
IP packets (ICMP Echo Requests). To use the ping (or traceroute) command with host names or fully
qualified domain names, see DNS resolver on page 380.

Link test
A test of the connection between the switch and a designated network device on the same LAN (or VLAN, if
configured). During the link test, IEEE 802.2 test packets are sent to the designated network device in the same
VLAN or broadcast domain. The remote device must be able to respond with an 802.2 Test Response Packet.

Executing ping or link tests (WebAgent)
To start a ping or link test in the WebAgent:

1. In the navigation pane, click Troubleshooting.

2. Click Ping/Link Test.

3. Click Start.

4. To halt a link or ping test before it concludes, click Stop.

For an Example: of the text screens, see Figure 65: Ping test and link test screen on the WebAgent on page
366.

Figure 65: Ping test and link test screen on the WebAgent

Destination IP Address is the network address of the target, or destination, device to which you want to test a
connection with the switch. An IP address is in the X.X.X.X format where X is a decimal number between 0 and
255.

Number of Packets to Send is the number of times you want the switch to attempt to test a connection.

Timeout in Seconds is the number of seconds to allow per attempt to test a connection before determining that
the current attempt has failed.
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Testing the path between the switch and another device on an IP network
The ping test uses ICMP echo requests and ICMP echo replies to determine if another device is alive. It also
measures the amount of time it takes to receive a reply from the specified destination. The ping command has
several extended commands that allow advanced checking of destination availability.

Syntax:

ping {<ip-address | hostname | switch-num>} [repetitions <1-10000>] [timeout 
<1-60>] [{source <ip-address> | <vlan-id>}] [data-size <0-65471>] [data-fill 
<0-1024>]

ping6 {<ip-address | hostname | [switch-num>]} [repetitions <1-10000>] [timeout 
<1-60>] [{source <ip-address> | <vlan-id>}] [data-size <0-65471>] [data-fill 
<0-1024>]
Sends ICMP echo requests to determine if another device is alive.

{< ip-address | hostname >} Target IP address or hostname of the destination node
being pinged

repetitions <1-10000> Number of ping packets sent to the destination
address.

Default: 1

timeout <1-60> Timeout interval in seconds; the ECHO REPLY must
be received before this time interval expires for the
ping to be successful.

Default: 5

source {<ip-addr | hostname>} Source IP address or hostname. The source IP
address must be owned by the router. If a VLAN is
specified, the IP address associated with the specified
VLAN is used.

data-size <0-65471> Size of packet sent.

Default: 0 (zero)

data-fill <0-1024> The data pattern in the packet.

Default: Zero length string

Ping tests

switch# ping 10.10.10.10
10.10.10.10 is alive, time = 15 ms

switch# ping 10.10.10.10 repetitions 3
10.10.10.10 is alive, iteration 1, time = 15 ms
10.10.10.10 is alive, iteration 1, time = 15 ms
10.10.10.10 is alive, iteration 1, time = 15 ms

switch# ping 10.10.10.10 timeout 2
10.10.10.10 is alive, time = 10 ms
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switch# ping 10.11.12.13
The destination address is unreachable.

Halting a ping test
To halt a ping test before it concludes, press [Ctrl] [C].

To use the ping (or traceroute) command with host names or fully qualified domain names, see 
DNS resolver on page 380.

Issuing single or multiple link tests
Single or multiple link tests can have varying repetitions and timeout periods. The defaults are:

• Repetitions: 1 (1 to 999)

• Timeout: 5 seconds (1 to 256 seconds)

Syntax:

link <mac-address> [repetitions <1-999>] [timeout <1-256>] [vlan < vlan-id >]
Example:

Figure 66: Link tests

Tracing the route from the switch to a host address
The traceroute command enables you to trace the route from the switch to a host address.

This command outputs information for each (router) hop between the switch and the destination address. Note
that every time you execute traceroute, it uses the same default settings unless you specify otherwise for that
instance of the command.
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Syntax:

traceroute {<ip-address | hostname>}

traceroute6 {<ip-address | hostname>}
Lists the IP address or hostname of each hop in the route, plus the time in microseconds for the traceroute
packet reply to the switch for each hop.

{< ip-address | 
hostname >}

The IP address or hostname of the device to which to send the traceroute.

[minttl < 1-255 >]
For the current instance of traceroute, changes the minimum number of hops
allowed for each probe packet sent along the route.

• If minttl is greater than the actual number of hops, the output includes only the
hops at and above the minttl threshold. (The hops below the threshold are not
listed.)

• If minttl matches the actual number of hops, only that hop is shown in the
output.

• If minttl is less than the actual number of hops, all hops are listed.

For any instance of traceroute, if you want a minttl value other than the default,
you must specify that value.(Default: 1)

[maxttl < 1-255 >]
For the current instance of traceroute, changes the maximum number of hops
allowed for each probe packet sent along the route.If the destination address is
further from the switch than maxttl allows, traceroute lists the IP addresses for
all hops it detects up to the maxttl limit.For any instance of traceroute, if you
want a maxttl value other than the default, you must specify that value.(Default: 30)

[timeout < 1-120 
>]

For the current instance of traceroute, changes the timeout period the switch waits
for each probe of a hop in the route. For any instance of traceroute, if you want a
timeout value other than the default, you must specify that value.Default: 5 seconds

[probes < 1-5 >]
For the current instance of traceroute, changes the number of queries the switch
sends for each hop in the route.For any instance of traceroute, if you want a
probes value other than the default, you must specify that value.(Default: 3)

[[source <ip-
addr] | [vlan-
id>]]

The source IP address or VLAN. The source IP address must be owned by the
router. If a VLAN is specified, the IP address associated with the specified VLAN is
used.

For information about traceroute6, see the IPv6 configuration guide for your switch.
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Halting an ongoing traceroute search
Press the [Ctrl] [C] keys.

A low maxttl causes traceroute to halt before reaching the destination address
Executing traceroute with its default values for a destination IP address that is four hops away produces a
result similar to this:

Figure 67: A completed traceroute enquiry

Continuing from the previous Example: (Figure 67: A completed traceroute enquiry on page 370), executing
traceroute with an insufficient maxttl for the actual hop count produces an output similar to this:

Figure 68: Incomplete traceroute because of low maxttl setting

If a network condition prevents traceroute from reaching the destination
Common reasons for traceroute failing to reach a destination include:

• Timeouts (indicated by one asterisk per probe, per hop)

• Unreachable hosts

• Unreachable networks

• Interference from firewalls

• Hosts configured to avoid responding
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Executing traceroute where the route becomes blocked or otherwise fails results in an output marked by
timeouts for all probes beyond the last detected hop. For example, with a maximum hop count of 7 (maxttl = 7),
where the route becomes blocked or otherwise fails, the output appears similar to this:

Figure 69: Traceroute failing to reach the destination address

Viewing switch configuration and operation
In some troubleshooting scenarios, you may need to view the switch configuration to diagnose a problem. The
complete switch configuration is contained in a file that you can browse from the CLI using the commands
described in this section.

Viewing the startup or running configuration file
Syntax:

write terminal
Displays the running configuration.

show config Displays the startup configuration.

show running-config Displays the running-config file.

For more information and examples of how to use these commands, see “Switch Memory and Configuration” in
the basic operation guide.

Viewing the configuration file (WebAgent)
To display the running configuration using the WebAgent:

1. In the navigation pane, click Troubleshooting.

2. Click Configuration Report.

3. Use the right-side scroll bar to scroll through the configuration listing.

Viewing a summary of switch operational data
Syntax:

show tech
By default, the show tech command displays a single output of switch operating and running-configuration data
from several internal switch sources, including:
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• Image stamp (software version data)

• Running configuration

• Event Log listing

• Boot history

• Port settings

• Status and counters — port status

• IP routes

• Status and counters — VLAN information

• GVRP support

• Load balancing (trunk and LACP)

The show tech command on page 372 shows sample output from the show tech command.

The show tech command

switch# show tech

 show system

  Status and Counters - General System Information

   System Name        : Switch
   System Contact     :
   System Location    :

   MAC Age Time (sec) : 300

   Time Zone          : 0
   Daylight Time Rule : None

   Software revision  : XX.14.xx     Base MAC Addr  : 001871-c42f00
   ROM Version        : XX.12.12     Serial Number  : SG641SU00L

   Up Time            : 23 hours    Memory - Total :
   CPU Util (%)       : 10                    Free :

   IP Mgmt - Pkts Rx  : 759         Packet - Total : 6750
              Pkts Tx : 2             Buffers Free : 5086
                                            Lowest : 4961
                                            Missed : 0

show flash
Image       Size(Bytes)   Date  Version
-----       -----------  ------ --------
To specify the data displayed by the show tech command, use the copy show tech command.

Saving show tech command output to a text file
When you enter the show tech command, a summary of switch operational data is sent to your terminal
emulator. You can use your terminal emulator's text capture features to save the show tech data to a text file for
viewing, printing, or sending to an associate to diagnose a problem.
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For example, if your terminal emulator is the Hyperterminal application available with Microsoft® Windows®
software, you can copy the show tech output to a file and then use either Microsoft Word or Notepad to display
the data. (In this case, Microsoft Word provides the data in an easier-to-read format.)

The following example uses the Microsoft Windows terminal emulator. If you are using a different terminal
emulator application, see the documentation provided with the application.

Procedure

1. In Hyperterminal, click on Transfer|Capture Text….

Figure 70: Capture text window of the Hyperterminal application

2. In the File field, enter the path and file name in which you want to store the show tech output.

Figure 71: Entering a path and filename for saving show tech output

3. Click [Start] to create and open the text file.

4. From the global configuration context, enter the show tech command:

switch# show tech
The show tech command output is copied into the text file and displayed on the terminal emulator screen.
When the command output stops and displays -- MORE --, press the Space bar to display and copy more
information. The CLI prompt appears when the command output finishes.

5. Click on Transfer|Capture Text|Stop in HyperTerminal to stop copying data and save the text file.

If you do not stop HyperTerminal from copying command output into the text file, additional unwanted data can
be copied from the HyperTerminal screen.

6. To access the file, open it in Microsoft Word, Notepad, or a similar text editor.

Viewing more information on switch operation
Use the following commands to display additional information on switch operation for troubleshooting purposes.

Syntax:

show boot-history
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Displays the crash information saved for each management module on the switch.

show history
Displays the current command history. This command output is used for reference or when you want to repeat a
command (See Displaying the information you need to diagnose problems on page 376).

show system-information
Displays globally configured parameters and information on switch operation.

show version
Displays the software version currently running on the switch and the flash image from which the switch booted
(primary or secondary). For more information, see "Displaying Management Information" in the "Redundancy
(Switch 8212zl)" .

show interfaces
Displays information on the activity on all switch ports (see "Viewing Port Status and Configuring Port
Parameters" in the "Port Status and Configuration" ).

show interfaces-display
Displays the same information as the show interfaces command and dynamically updates the output every
three seconds. Press Ctrl + C to stop the dynamic updates of system information. Use the Arrow keys to view
information that is off the screen.

Searching for text using pattern matching with show command
Selected portions of the output are displayed, depending on the parameters chosen.

Syntax:

show {< command option > | < include | exclude | begin >} <regular expression>
Uses matching pattern searches to display selected portions of the output from a show command. There is no
limit to the number of characters that can be matched. Only regular expressions are permitted; symbols such as
the asterisk cannot be substituted to perform more general matching.

include Only the lines that contain the matching pattern are displayed in the output.

exclude Only the lines that contain the matching pattern are not displayed in the output.

begin The display of the output begins with the line that contains the matching pattern.

Pattern matching is case-sensitive.

Following are examples of what portions of the running config file display depending on the option chosen.

Pattern matching with include option

switch(config)# show run | include ipv6 1
   ipv6 enable
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   ipv6 enable
ipv6 access-list "EH-01"
switch(config)#

1Displays only lines that contain “ipv6”.

Pattern matching with exclude option

switch(config)# show run | exclude ipv6 1

Running configuration:

; J9299A Configuration Editor; Created on release #YA.15.XX
; Ver #01:01:00

hostname "HP Switch"
mirror-port 4
qos dscp-map 000000 priority 0
qos dscp-map 001000 priority 1
...
interface 1
  lacp Active
exit
interface 6
  name "Print_Server"
exit
...
vlan 1
  name "DEFAULT_VLAN"
  untagged 1-24
  ip address dhcp-bootp
  exit
...
port-security 17 learn-mode static address-limit 3 action send-alarm
power-over-ethernet pre-std-detect
no ip ssh cipher 3des-cbc
ip timep dhcp
snmp-server community "public" unrestricted
snmp-server community "public" unrestricted
...
vlan 1
  exit

1Displays all lines that do not contain “ipv6”.

Pattern matching with begin option

switch(config)# show run | begin ipv6 1
   ipv6 enable
   no untagged 21-24
   exit
vlan 20
   name "VLAN20"
   untagged 21-24
   ipv6 enable
   no ip address
   exit
policy qos "michael"
   exit
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ipv6 access-list "EH-01"
   sequence 10 deny tcp 2001:db8:255::/48 2001:db8:125::/48
   exit
no autorun
password manager

1Displays the running config beginning at the first line that contains “ipv6”.

The following is an Example: of the show arp command output, and then the output displayed when the
include option has the IP address of 15.255.128.1 as the regular expression.

The show arp command and pattern matching with the include option

switch(config)# show arp

 IP ARP table

  IP Address      MAC Address    Type    Port
  -------------   -------------- ------- ----
  15.255.128.1    00000c-07ac00  dynamic B1
  15.255.131.19   00a0c9-b1503d  dynamic
  15.255.133.150  000bcd-3cbeec  dynamic B1

switch(config)# show arp | include 15.255.128.1
  15.255.128.1    00000c-07ac00  dynamic B1

Displaying the information you need to diagnose problems
Use the following commands in a troubleshooting session to more accurately display the information you need to
diagnose a problem.

Syntax:

alias
Creates a shortcut alias name for commonly used commands and command options.

Syntax:

kill
Terminates a currently running, remote troubleshooting session. Use the show ip ssh command to list the
current management sessions.

Syntax:

[no] page
Toggles the paging mode for show commands between continuous listing and per-page listing.

Syntax:

repeat
Repeatedly executes one or more commands so that you can see the results of multiple commands displayed
over a period of time. To halt the command execution, press any key on the keyboard.
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Syntax:

setup
Displays the Switch Setup screen from the menu interface.

Restoring the factory-default configuration
As part of your troubleshooting process, it may become necessary to return the switch configuration to the factory
default settings. This process:

• Momentarily interrupts the switch operation

• Clears any passwords

• Clears the console Event Log

• Resets the network counters to zero

• Performs a complete self test

• Reboots the switch into its factory default configuration, including deleting an IP address

There are two methods for resetting to the factory-default configuration:

• CLI

• Clear/Reset button combination

Hewlett Packard Enterprise recommends that you save your configuration to a TFTP server before
resetting the switch to its factory-default configuration. You can also save your configuration via
Xmodem to a directly connected PC.

Resetting to the factory-default configuration

Using the CLI
This command operates at any level except the Operator level.

Syntax:

erase startup-configuration
Deletes the startup-config file in flash so that the switch will reboot with its factory-default configuration.

The erase startup-config command does not clear passwords unless include-
credentials has been set, at which time this command does erase username/password
information and any other credentials stored in the config file. For more information, see the section
on "Saving Security Credentials in a Config File" in the access security guide for your switch.
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Using Clear/Reset

Procedure

1. Using pointed objects, simultaneously press both the Reset and Clear buttons on the front of the switch.

2. Continue to press the Clear button while releasing the Reset button.

3. When the Self Test LED begins to flash, release the Clear button.

The switch then completes its self test and begins operating with the configuration restored to the factory
default settings.

Restoring a flash image
The switch can lose its operating system if either the primary or secondary flash image location is empty or
contains a corrupted OS file and an operator uses the erase flash command to erase a good OS image file
from the opposite flash location.

Recovering from an empty or corrupted flash state
Use the switch's console serial port to connect to a workstation or laptop computer that has the following:

• A terminal emulator program with Xmodem capability, such as the HyperTerminal program included in
Windows PC software.

• A copy of a good OS image file for the switch

The following procedure requires the use of Xmodem and copies an OS image into primary flash
only.

This procedure assumes you are using HyperTerminal as your terminal emulator. If you use a
different terminal emulator, you may need to adapt this procedure to the operation of your particular
emulator.

1. Start the terminal emulator program.

Ensure that the terminal program is configured as follows:

• Baud rate: 9600

• No parity

• 8 Bits

• 1 stop bit

• No flow control

2. Use the Reset button to reset the switch.

The following prompt should then appear in the terminal emulator:

Enter h or ? for help.

=>
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3. Because the OS file is large, you can increase the speed of the download by changing the switch console and
terminal emulator baud rates to a high speed. For Example:

a. Change the switch baud rate to 115,200 Bps.

 => sp 115200
b. Change the terminal emulator baud rate to match the switch speed:

I. In HyperTerminal, select Call|Disconnect.

II. Select File|Properties.

III. Click on Configure.

IV. Change the baud rate to 115200.

V. Click on [OK], then in the next window, click on [OK] again.

VI. Select Call|Connect.

VII. Press [Enter] one or more times to display the => prompt.

4. Start the Console Download utility by entering do at the =prompt and pressing [Enter]:

 => do
5. You then see this prompt:

You have invoked the console download utility. 
Do you wish to continue? (Y/N)>_

6. At the above prompt:

a. Enter y (for Yes)

b. Select Transfer|File in HyperTerminal.

c. Enter the appropriate filename and path for the OS image.

d. Select the Xmodem protocol (and not the 1k Xmodem protocol).

e. Click on [Send].
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If you are using HyperTerminal, you will see a screen similar to the following to indicate that the download is in
progress:

Figure 72: Example: of Xmodem download in progress

When the download completes, the switch reboots from primary flash using the OS image you downloaded in
the preceding steps, plus the most recent startup-config file.

DNS resolver
The domain name system (DNS) resolver is designed for use in local network domains, where it enables the use
of a host name or fully qualified domain name with DNS-compatible switch CLI commands.

DNS operation supports both IPv4 and IPv6 DNS resolution and multiple, prioritized DNS servers. (For
information on IPv6 DNS resolution, see the latest IPv6 configuration guide for your switch.)

Basic operation

• When the switch is configured with only the IP address of a DNS server available to the switch, a DNS-
compatible command, executed with a fully qualified domain name, can reach a device found in any domain
accessible through the configured DNS server.

• When the switch is configured with both of the following:

◦ The IP address of a DNS server available to the switch

◦ The domain suffix of a domain available to the configured DNS serverthen:

◦ A DNS-compatible command that includes the host name of a device in the same domain as the configured
domain suffix can reach that device.

◦ A DNS-compatible command that includes a fully qualified domain name can reach a device in any domain
that is available to the configured DNS server.

Example:

Suppose the switch is configured with the domain suffix mygroup.HP Switch.net and the IP address for an
accessible DNS server. If an operator wants to use the switch to ping a target host in this domain by using the
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DNS name "leader" (assigned by a DNS server to an IP address used in that domain), the operator can use either
of the following commands:

Figure 73: Example: of using either a host name or a fully qualified domain name

In the proceeding Example:, if the DNS server's IP address is configured on the switch, but a domain suffix is
either not configured or is configured for a different domain than the target host, the fully qualified domain name
must be used.

Note that if the target host is in a domain other than the domain configured on the switch:

• The host's domain must be reachable from the switch. This requires that the DNS server for the switch must
be able to communicate with the DNS servers in the path to the domain in which the target host operates.

• The fully qualified domain name must be used, and the domain suffix must correspond to the domain in which
the target host operates, regardless of the domain suffix configured in the switch.

Example:

Suppose the switch is configured with the domain suffix mygroup.HP Switch.net and the IP address for an
accessible DNS server in this same domain. This time, the operator wants to use the switch to trace the route to a
host named "remote-01" in a different domain named common.group.net. Assuming this second domain is
accessible to the DNS server already configured on the switch, a traceroute command using the target's fully
qualified DNS name should succeed.

Figure 74: Example: using the fully qualified domain name for an accessible target in another domain

Configuring and using DNS resolution with DNS-compatible commands
The DNS-compatible commands include ping and traceroute.)

Procedure

1. Determine the following:

a. The IP address for a DNS server operating in a domain in your network.

b. The priority (1 to 3) of the selected server, relative to other DNS servers in the domain.

c. The domain name for an accessible domain in which there are hosts you want to reach with a DNS-
compatible command. (This is the domain suffix in the fully qualified domain name for a given host
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operating in the selected domain. See Basic operation on page 380.) Note that if a domain suffix is not
configured, fully qualified domain names can be used to resolve DNS-compatible commands.

d. The host names assigned to target IP addresses in the DNS server for the specified domain.

2. Use the data from the first three bullets in step1 to configure the DNS entry on the switch.

3. Use a DNS-compatible command with the host name to reach the target devices.

Configuring a DNS entry
The switch allows up to two DNS server entries (IP addresses for DNS servers). One domain suffix can also be
configured to support resolution of DNS names in that domain by using a host name only. Including the domain
suffix enables the use of DNS-compatible commands with a target's host name instead of the target's fully
qualified domain name.

Syntax:

[no] ip dns server-address priority <1-3> <ip-addr>
Configures the access priority and IP address of a DNS server accessible to the switch. These settings specify:

• The relative priority of the DNS server when multiple servers are configured

• The IP address of the DNS server

These settings must be configured before a DNS-compatible command can be executed with host name criteria.

The switch supports two prioritized DNS server entries. Configuring another IP address for a priority that has
already been assigned to an IP address is not allowed.

To replace one IP address at a given priority level with another address having the same priority, you must first
use the no form of the command to remove the unwanted address. Also, only one instance of a given server
address is allowed in the server list. Attempting to enter a duplicate of an existing entry at a different priority level
is not allowed .
To change the priority of an existing server address, use the no form of the command to remove the entry, then
re-enter the address with the new priority.

The no form of the command replaces the configured IP address with the null setting. (Default: null)

Syntax:

[no] ip dns domain-name <domain-name-suffix>
This optional DNS command configures the domain suffix that is automatically appended to the host name
entered with a DNS-compatible command. When the domain suffix and the IP address for a DNS server that can
access that domain are both configured on the switch, you can execute a DNS-compatible command using only
the host name of the desired target. (For an Example:, see Example: of using either a host name or a fully
qualified domain name.) In either of the following two instances, you must manually provide the domain
identification by using a fully qualified DNS name with a DNS-compatible command:

• If the DNS server IP address is configured on the switch, but the domain suffix is not configured (null).

• The domain suffix configured on the switch is not the domain in which the target host exists.

The switch supports one domain suffix entry and three DNS server IP address entries. (See the preceding
command description.)
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The no form of the command replaces the configured domain suffix with the null setting. (Default: null)

Using DNS names with ping and traceroute: Example:
In the network illustrated in Figure 75: Example: network domain on page 383, the switch at 10.28.192.1 is
configured to use DNS names for DNS-compatible commands in the pubs.outdoors.com domain. The DNS
server has been configured to assign the host name docservr to the IP address used by the document server
(10.28.229.219).

Figure 75: Example: network domain

Configuring switch "A" with the domain name and the IP address of a DNS server for the domain enables the
switch to use host names assigned to IP addresses in the domain to perform ping and traceroute actions on
the devices in the domain. To summarize:

Entity Identity

DNS server IP address 10.28.229.10

Domain name (and domain suffix for hosts in the
domain)

pubs.outdoors.com

Host name assigned to 10.28.229.219 by the DNS
server

docservr

Fully qualified domain name for the IP address used by
the document server (10.28.229.219)

docservr.pubs.outdoors.com

Switch IP address 10.28.192.1

Document server IP address 10.28.229.219

With the above already configured, the following commands enable a DNS-compatible command with the host
name docserver to reach the document server at 10.28.229.219.

Configuring switch "A" in Example: network domain to support DNS resolution

switch(config)# ip dns server-address 10.28.229.10
switch(config)# ip dns domain-name pbs.outdoors.com
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Ping and traceroute execution for the network in Example: network domain

switch(config)# ping docservr
10.28.229.219 is alive, time = 1 ms

switch# traceroute docservr
traceroute to 10.28.229.219
              1 hop min, 30 hops max, 5 sec. timeout, 3 probes
 1 10.28.192.2 1           1 ms       0 ms       0 ms
 2 10.28.229.219 2         0 ms       0 ms       0 ms

• 1First-Hop Router (“B”)

• 2Traceroute Target

As mentioned under the following example, if the DNS entry configured in the switch does not include the domain
suffix for the desired target, you must use the target host's fully qualified domain name with DNS-compatible
commands. For example, using the document server in Figure 75: Example: network domain on page 383 as a
target:

Figure 76: Example: of ping and traceroute execution when only the DNS server IP address is configured

Viewing the current DNS configuration
The show ip command displays the current domain suffix and the IP address of the highest priority DNS server
configured on the switch, along with other IP configuration information. If the switch configuration currently
includes a non-default (non-null) DNS entry, it will also appear in the show run command output.

Figure 77: Example: of viewing the current DNS configuration
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Operating notes

• Configuring another IP address for a priority that has already been assigned to an IP address is not allowed.
To replace one IP address at a given priority level with another address having the same priority, you must first
use the no form of the command to remove the unwanted address. Also, only one instance of a given server
address is allowed in the server list. Attempting to enter a duplicate of an existing entry at a different priority
level is not allowed. To change the priority of an existing server address, use the no form of the command to
remove the entry, then re-enter the address with the new priority.

• To change the position of an address already configured with priority x, you must first use no ip dns
server-address priority x <ip-addr> to remove the address from the configuration, then use ip
dns server-address priority <ip-addr> to reconfigure the address with the new priority. Also, if the
priority to which you want to move an address is already used in the configuration for another address, you
must first use the no form of the command to remove the current address from the target priority.

• The DNS servers and domain configured on the switch must be accessible to the switch, but it is not
necessary for any intermediate devices between the switch and the DNS server to be configured to support
DNS operation.

• When multiple DNS servers are configured on the switch, they can reside in the same domain or different
domains.

• A DNS configuration must include the IP address for a DNS server that is able to resolve host names for the
desired domain. If a DNS server has limited knowledge of other domains, its ability to resolve DNS-compatible
command requests is also limited.

• If the DNS configuration includes a DNS server IP address but does not also include a domain suffix, then any
DNS-compatible commands should include the target host’s fully qualified domain name.

• Switch-Initiated DNS packets go out through theVLAN having the best route to the DNS server, even if
aManagement VLAN has been configured.

• The DNS server address must be manually input. It is not automatically determined viaDHCP.

Event Log messages
Please see the Event Log Message Reference Guide for information about Event Log messages.
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Overview
The switch assigns MAC addresses in these areas:

• For management functions, one Base MAC address is assigned to the default VLAN (VID = 1). (All VLANs on
the switches covered in this guide use the same MAC address.)

• For internal switch operations: One MAC address per port (see Viewing the port and VLAN MAC addresses
on page 388.

MAC addresses are assigned at the factory. The switch automatically implements these addresses for VLANs and
ports as they are added to the switch.

The switch’s base MAC address is also printed on a label affixed to the switch.

Determining MAC addresses
Use the CLI to view the switch's port MAC addresses in hexadecimal format.

Use the menu interface to view the switch's base MAC address and the MAC address assigned to any VLAN
you have configured on the switch. (The same MAC address is assigned to VLAN1 and all other VLANs
configured on the switch.)

The switch's base MAC address is used for the default VLAN (VID =1) that is always available on the
switch. This is true for dynamic VLANs as well; the base MAC address is the same across all VLANs.

Viewing the MAC addresses of connected devices
Syntax:

show mac-address [port-list | mac-addr | vlan < vid>]
Lists the MAC addresses of the devices the switch has detected, along with the number of the specific port on
which each MAC address was detected.

Chapter 18
MAC Address Management
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[port-list]
Lists the MAC addresses of the devices the switch has detected, on the specified
ports.

[mac-addr]
Lists the port on which the switch detects the specified MAC address.Returns the
following message if the specified MAC address is not detected on any port in the
switch:

MAC address <mac-addr> not found.
                

[vlan <vid>]
Lists the MAC addresses of the devices the switch has detected on ports belonging
to the specified VLAN, along with the number of the specific port on which each MAC
address was detected.

Viewing the switch's MAC address assignments for VLANs
configured on the switch
The Management Address Information screen lists the MAC addresses for:

• Base switch (default VLAN; VID=1)

• Any additional VLANs configured on the switch.

Also, the Base MAC address appears on a label on the back of the switch.

The Base MAC address is used by the first (default) VLAN in the switch. This is usually the VLAN
named "DEFAULT_VLAN" unless the name has been changed (by using the VLAN Names screen).
On the switches covered in this guide, the VID (VLAN identification number) for the default VLAN is
always "1," and cannot be changed.

From the Main Menu, select

1. Status and Counters

2. Switch Management Address Information
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If the switch has only the default VLAN, the following screen appears. If the switch has multiple static VLANs,
each is listed with its address data.

Figure 78: Example: of the Management Address Information screen

Viewing the port and VLAN MAC addresses
The MAC address assigned to each switch port is used internally by such features as Flow Control and the
spanning-tree protocol. Using the walkmib command to determine the MAC address assignments for individual
ports can sometimes be useful when diagnosing switch operation.

This procedure displays the MAC addresses for all ports and existing VLANs in the switch,
regardless of which VLAN you select.

Procedure

1. If the switch is at the CLI Operator level, use the enable command to enter the Manager level of the CLI.

2. Enter the following command to display the MAC address for each port on the switch:

switch# walkmib ifPhysAddress
(The above command is not case-sensitive.)

Example:

A switch with the following module configuration shows MAC address assignments similar to those shown in the
example below:
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• A 4-port module in slot A, a 24-port module in slot C, and no modules in slots B and D

• Two non-default VLANs configured

Figure 79: Example: of Port MAC address assignments on a switch
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Configuring the savepower LED option
The savepower led command provides the ability to turn off port LEDs even when a link exists. If power-saving
is enabled, it can be temporarily overridden by the LED Mode button on the front panel. If the LED Mode button is
pressed, the LEDs will behave normally (turn on) for a period of 10 minutes, and then turn off again.

Syntax:

[no] savepower led
Turns power-saving option on or off for the LEDs.

The savepower led command

switch(config)# savepower led
The no form of the savepower led command cancels power saving mode and the LEDs are returned to their
original state.

To display the configured status of the LED power-saving option, use the show savepower led command.

Output of the show savepower led command

switch(config)# show savepower led

 LED Save Power Information

Configuration Status : Enabled

Configuring the savepower port-low-pwr option
The port-low-pwr option puts all the ports on the switch into auto low power mode if they are not linked.

Syntax:

[no] savepower port-low-pwr
Puts ports in low power mode.

When a link is detected, the ports return to normal power mode.

The no form of the command puts the ports into normal power mode.

The savepower port-low-power command

switch(config)# savepower port-low-pwr
To display the status of the power-down feature, use the show savepower portlow-pwr command. The
output shows if the feature is enabled or not enabled.

Chapter 19
Power-Saving Features
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Output for the show savepower port-low-pwr command

switch(config)# show savepower port-low-pwr

  Port Save Power Status: Enabled
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Job Scheduler
The Job Scheduler feature enables the user to schedule commands or jobs on the switch for one time or multiple
times. This is similar in concept to the UNIX ‘cron’ utility. The user can schedule any CLI command that the user
would otherwise enter interactively. This includes commands to enable or disable ports, LEDs, and Power-Over-
Ethernet. Jobs can also be scheduled to be triggered by certain pre-defined events such as switch reboot. The
only major restriction on commands scheduled is that, it should not prompt/ask for any user inputs.

Commands

Job at | delay | enable | disable
Set schedule jobs using the options and set the count for the number of times the job is repeated.

Syntax

job JOB NAME at | delay | enable | disable
Description

Schedule a command to run automatically. Jobs can be scheduled to run once, multiple times on a recurring
basis, or after certain events such as reboots. All commands run with manager privilege in configuration context.

The [no] form of the command deletes a scheduled job.

By default, jobs will be repeated an infinite number of times.

Restrictions

Jobs scheduled at any event will not be counted.

Jobs that are scheduled at the event “reboot” will not work in some multi management switches.

Range

• <1-1000>: is the value range for the count option.

• ([[DD:]HH:]MM): is the format used for the specific delay.

Options

count

Specify the number of times the job should run.

delay

Specify the delay before running the job.

enable

Enable a job that is disabled or expired.

disable

Disable a job. By default, a job is enabled.

Chapter 20
Job Scheduler
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Usage

job <JOB NAME> at <([DD:]HH:]MM on <WEEKDAY-LIST>)> config-save <COMMAND> count <1-1000>

job <JOB NAME> at <[HH:]MM on [MM/]DD> config-save <COMMAND> count <1-1000>

job <JOB NAME> at <EVENT> config-save <COMMAND>

job <JOB NAME> delay <([DD:]HH:]MM> config-save <COMMAND> count <1-1000>

job <JOB NAME> enable | disable

[no] job <JOB NAME>

Show job
Syntax

show job
Description

Show the jobs scheduled.

Show job

switch# show job

 Job Scheduler Status and Configuration

  Scheduler Status : Waiting for the system time to be set

                     Event or            Repeat  Save 
  Name               Time                Count   Cfg  Command
  ------------------ ---------------- ------- ---- ------------
  Burrrrrrrrrrrr...  reboot              --    Yes chassislocate blink
  baz                reboot              --     No  show time
  foo                17:00 SxTWTxS       --     No  savepower led
  a1                 12:00               2      Yes sh time
  a2                 Every 2:14:30 days  75     Yes vlan 3
  a3                 Every 00:00:25 days 1      No  vlan 4

Caution

The scheduler does not run until the system time is set.

Show job <Name>
Syntax

show job JOB NAME
Description

Show the job by name.
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Show job <JOB NAME>

switch# show job a1

Job Information

Job Name    : a1
Runs At     : 01:24
Config Save : No
Repeat Count: --
Job Status  : Enabled
Run Count   : 1
Error Count : 0
Command     : show time
Job Status  : Enabled

 Output from Last Run
 --------------------
 Tue Dec 15 01:24:00 2015
 

switch# show job a2

Job Information

Job Name    : a2
Runs At     : Every 2:14:30 days
Config Save : Yes
Repeat Count: 75
Run Count   : 0
Error Count : 0
Command     : vlan 3
Job Status  : Disabled

switch# show job foo

Job Information

Job Name    : foo
Runs At     : 17:00 SxTWTxS
Config Save : Yes
Repeat Count: --
Run Count   : 0
Error Count : 0
Command     : savepower led
Job Status  : Enabled

394 Aruba 2530 Management and Configuration Guide for ArubaOS-Switch 16.05

Anexo 04 ITEM 10 (0592646)         SEI 0008478-63.2018.6.02.8000 / pg. 5453



Overview
The traditional way of restoring a configuration from a backup configuration file required a switch reboot for the
new configurations to be effective. There were network outages and a planned downtime for even minor changes.
The switch configuration can now be restored from a backup configuration without reboot. It also provides hash of
the current running configuration, which can be used for auditing.

The backup configuration can be created using the new command cfg-backup. An existing method of copying a
configuration file from a remote location (for example, TFTP server) can also be used to backup a configuration or
copied from flash.

More information

show hash on page 415
cfg-backup on page 399
cfg-restore config_bkp on page 408

Benefits of configuration restore without reboot

• Restores a new or modified configuration without reboot, with minimal network outage. Any NMS can use this
method for configuration rebase workflows. Only configurations that were exported from the switch can be
imported or restored on the switch.

• Restores the configuration without reboot from a backup configuration when the running configuration has
functional issues, like misconfigurations from remote management stations.

Recommended scenarios
• Use the configuration restore feature for incremental configuration updates.

• Use the force option with cfg-restore, for commands which require reboot.

• Use the verbose option to get detailed progress on the configuration restore process.

More information

Force configuration restore on page 403
cfg-restore verbose on page 407

Use cases
• A user can switch to a new configuration without rebooting the switch.

• If a user loses connectivity after applying the new configuration, a job scheduler executes the job after a
specific time frame. This restores the current configuration to the switch, without rebooting it.

More information

Switching to a new configuration on page 396

Chapter 21
Configuration backup and restore without reboot
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Rolling back to a stable configuration using job scheduler on page 397

Switching to a new configuration

Procedure

1. Back up the configuration using cfg-backup running-config config <config_name> command. In
the following example, the configuration name used is “stable”.
cfg-backup running-config config stable

2. Check the backup configuration using show config files command.

switch(config)# show config files

Configuration files:

id | act pri sec | name
---+-------------+--------
1  |  *   *   *  | config
2  |             | stable
3  |             |
4  |             |
5  |             |

3. Change the running configuration as required, and backup the new configuration as “newfile”.

cfg-backup running-config config newfile

switch(config)# show config files

Configuration files:

 id | act pri sec | name
 ---+-------------+---------
  1 |  *   *   *  | config
  2 |             | stable
  3 |             | newfile
  4 |             |
  5 |             |

4. Check the difference between the “newfile” (running configuration) and “stable” (backed up configuration)
using cfg-restore flash stable diff command. Based on the difference, apply the backed-up
configuration using cfg-restore flash stable command.

5. Check the status of the configuration restore using show cfg-restore status command.

switch(config)# show cfg-restore status

 Status                 : Success
 Config File Name       : stable
 Source                 : Flash
 Time Taken             : 3 Seconds
 Last Run               : Tue Nov 28 18:24:09 2017

 Recovery Mode          : Enabled
 Failure Reason         : -

 Number of Add Commands    : 14
 Number of Remove Commands : 0
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 Time Taken for Each Phase :
      Calculating diff     : 1 Seconds
      Adding commands      : 2 Seconds
      Removing commands    : 0 Seconds

Rolling back to a stable configuration using job scheduler

Procedure

1. Configure the job using alias with the required configuration.

alias <name> <command-list>
job <name> delay [[DD:]HH:]MM <command>
To schedule a job execution with cfg-restore operation once after 15 minutes (00:00:15):

alias "cfg_rollback" "cfg-restore flash stable"
job "cfg_stable" delay 00:00:15 "cfg_rollback" count 1

2. Back up the current stable configuration using the command cfg-backup running-config config
<config_name>.

cfg-backup running-config config stable
3. Check the backup configuration using the command show config files.

switch(config)# show config files

Configuration files:

id | act pri sec | name
---+-------------+-------
1  |  *   *   *  | config
2  |             | stable
3  |             |
4  |             |
5  |             |

4. Edit the configuration as needed. If the user is still connected to the switch, the configuration is stable and the
job which reloads the older configuration can be cancelled using the command no job cfg_stable.

switch(config)# no job cfg_stable
5. If the user loses connectivity after applying the new configuration, the job scheduler executes the job after the

15-minute timer expires, and “stable” configuration is restored. Use the following commands to check the
output:

• switch(config)# show job cfg_stable
• switch(config)# show cfg-restore status

switch(config)# show job cfg_stable

 Job Information

  Job Name       : cfg_stable
  Runs At        : Every 00:00:15 days:hours:minutes
  Config Save    : No
  Repeat Count   : 1
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  Job Status     : Enabled
  Running Status : Active
  Run Count      : 0
  Error Count    : 0
  Skip Count     : 0
  Command        : cfg_rollback

switch(config)# show cfg-restore status
 Status                 : Success
 Config File Name       : stable
 Source                 : Flash
 Time Taken             : 9 Seconds
 Last Run               : Tue Nov 28 20:50:00 2017

 Recovery Mode          : Enabled
 Failure Reason         : -

 Number of Add Commands    : 27
 Number of Remove Commands : 0

 Time Taken for Each Phase :
      Calculating diff     : 4 Seconds
      Adding commands      : 1 Seconds
      Removing commands    : 0 Seconds

If the configuration involves any sensitive information, backup and restore the configuration by
enabling the include-credentials command.

Commands used in switch configuration restore without
reboot
cfg-backup

Backs up the selected configuration to the flash file.

show config files details
Shows a detailed list of configuration files available in the flash.

cfg-restore
Restores the given configuration as the running configuration without reboot.

show cfg-restore status
Shows the status of latest restore performed.

show cfg-restore latest-diff
Views the list of configuration changes that are removed, modified, or added to the running configuration.

show hash
Shows the SHA ID of a startup or running configuration.

Configuration backup
The configuration backup creates a backup of the running or startup configuration of ArubaOS-Switch on-demand
to the flash storage on the switch.

You can now back up the configuration for ArubaOS-Switch feature on the flash storage of the switch. The
maximum number of backup files supported has increased from three to five.
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When you downgrade configuration backup files from five to three, and if the current number of files
is either a four or five, an error message Configuration file <name> stored in config
index 5 is not supported in lower image versions is displayed.

cfg-backup
Syntax
cfg-backup {running-config | startup-config} config <FILE-NAME>

Description

Backs up the selected configuration to the flash file mentioned. When the firmware is downgraded to lower
versions, the details of only three configuration files appear in the show config files command.

Command context
config

Parameters
running-config

Copies the running configuration to switch flash file.
startup-config

Copies the startup configuration to switch flash file.

flash
Name of the configuration file in flash.

Usage
copy {startup-config | running-config} {sftp | tftp} <server address> <FILE-NAME>
The existing copy command copies the startup and running configuration to the TFTP or SFTP server.

Examples

switch(config)# cfg-backup
 running-config       Backup the running configuration to the flash file
                      mentioned.
 startup-config       Backup the startup configuration to the flash file
                      mentioned.

switch(config)# cfg-backup {running-config | startup-config}
 config                Backup the named configuration file.

switch(config)# cfg-backup {running-config | startup-config} config
 ASCII-STR             Enter an ASCII string.

show config files
Syntax
show config files

Description

Shows a list of configuration files available in the flash.
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Command context
config

Examples

switch# show config files
Configuration files:

 id | act pri sec | name
 ---+-------------+---------
  1 |  *   *   *  | config
  2 |             | add
  3 |             | modify
  4 |             | golden_config
  5 |             | poe2
To show the details of saved configuration files:

switch(config)# show config files
 details        Show details of saved configuration files.

switch(config)#show config files details

 Backup Configuration files:

 File Name      : config
 File ID        : 1
 File Size      : 35902 Bytes
 Last Modified  : Mon Jan 01 1990 00:09:28
 Version        : WC.16.05.0000x

 File Name      : add
 File ID        : 2
 File Size      : 35902 Bytes
 Last Modified  : Mon Oct 23 2017 03:42:38
 Version        : WC.16.05.0000x

 File Name      : modify
 File ID        : 3
 File Size      : 35902 Bytes
 Last Modified  : Mon Oct 23 2017 03:42:38
 Version        : WC.16.05.0000x
To view the contents of a configuration file in the flash:

switch# show config add

; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a
snmp-server community "public" unrestricted
vlan 1
   name "DEFAULT_VLAN"
   no untagged 3-10
   untagged 1-2,11-28
   ip address dhcp-bootp
   exit
vlan 100
   name "VLAN100"
   untagged 3-5
   no ip address
   exit
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vlan 200
name "VLAN200"
   untagged 6-10
   no ip address
   exit

Configuration restore without reboot
The cfg-restore without reboot command restores the configuration without reboot from a backup
configuration to the running configuration of the switch.

The details about the difference between a running and a backup configuration can be displayed using cfg-
restore {flash | tftp | sftp} <FILE-NAME> diff command.

More information

Configuration backup on page 398
Viewing the differences between a running configuration and a backup configuration on page 413

cfg-restore
Syntax
cfg-restore {flash | tftp <IP-ADDRESS> | sftp <IP-ADDRESS>} <FILE-NAME> [diff |
force | non-blocking | recovery-mode | verbose]

Description

Restores the given configuration as the running configuration without reboot. If the configuration is not suitable to
successfully restore without reboot, the command will return a failure message with details.

The restored configuration commands will be executed on a running configuration, so the name of
the current active configuration does not change after configuration restore, except for the force
option.

Command context
config

Parameters
flash

Copies file from flash.
tftp

Copies file from TFTP server.

sftp
Copies file from SFTP server.

<IP-ADDRESS>

IP address of the TFTP server.

<FILE-NAME>

Name of the backup configuration file to restore into the running configuration.

diff
Provides the list of changes that will be applied on the running configuration.

Chapter 21 Configuration backup and restore without reboot 401

Anexo 04 ITEM 10 (0592646)         SEI 0008478-63.2018.6.02.8000 / pg. 5460



force
Forces a reboot if configuration in restored configuration requires a reboot. Applies the configuration with
reboot if the configuration has reboot required commands or system-wide change commands. After a forced
reboot, the name of the configuration changes.

non-blocking
Configuration restoration in non-blocking mode, where actual process happens in the background.

recovery-mode
Enables or disables recovery-mode. Recovery-mode is enabled by default and this retains the current running
configuration if configuration restoration fails.

verbose
Provides the details of configuration restore status and the list of commands to be added or deleted.

Usage

• cfg-restore flash <FILE-NAME> [non-blocking | diff | force | recovery-mode{enable
| disable}]] | [verbose [force | [recovery-mode{enable | disable}] | [diff |
force]

• cfg-restore tftp {<IPV4-ADDR> | <IPV6-ADDR> | <HOSTNAME-STR> <FILE-NAME> [non-
blocking | diff | force | recovery-mode{enable | disable}]] | [verbose [force |
[recovery-mode{enable | disable}]] | [diff |force]

• cfg-restore sftp {<IPV4-ADDR> | <IPV6-ADDR> | <HOSTNAME-STR> | user <name> {<IP-
ADDRESS|IPV6-ADDRESS|HOSTNAME-STR>} | <USERNAME@>{<HOST-NAME> | <IPV4-ADDR> |
<IPV6-ADDR>}} [port <1-65535>] <FILE-NAME> [non-blocking | diff | force |
recovery-mode{enable | disable}]] | [verbose [force | [recovery-mode{enable |
disable}]] | [diff |force]

Examples

switch# cfg-restore
 flash              Copy file from flash. 
 sftp               Copy file from SFTP Server. 
 tftp               Copy file from TFTP Server. 

switch# cfg-restore flash
 FILE-NAME          Name of the backup configuration file to restore into the running 
                       configuration. 

switch# cfg-restore flash config_file
 diff               Provide the list of changes that will be applied on the
                    running configuration.
 force              Apply the configuration with reboot if the
                    configuration has reboot required commands or
                    system-wide change commands present.
 non-blocking       Config restoration in non-blocking mode.
 recovery-mode      To enable/disable recovery-mode.
 verbose               Provide the details of config restore status and the list of commands to be added 
                    or deleted.        

switch# cfg-restore tftp
 HOSTNAME-STR       Specify hostname of TFTP Server.
 IP-ADDR            IP Address of the TFTP Server.
 IPV6-ADDR          IPV6 Address of the TFTP Server.

switch# cfg-restore tftp 10.100.0.12
 FILE-NAME          Name of the backup configuration file to restore into the running 
                       configuration. 

switch# cfg-restore tftp 10.100.0.12 config_file
 diff                Provide the list of changes that will be applied on the
                     running configuration.
 force               Apply the configuration with reboot if the
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                     configuration has reboot required commands or
                     system-wide change commands present.
 non-blocking        Config restoration in non-blocking mode.
 recovery-mode       To enable/disable recovery-mode.
 verbose                Provide the details of config restore status and the list of commands to be added 
                     or deleted.

switch(config)# cfg-restore flash add non-blocking
 diff                Provide the list of changes that will be applied on
                     the running configuration.
 force               Apply the configuration with reboot if the configuration has reboot required commands or
                     system-wide change commands present.
 recovery-mode       To enable/disable recovery-mode.

Force configuration restore
The cfg-restore command fails if a reboot is required. The Configuration restoration is not
allowed as the configuration has reboot required commands error is displayed, along with lines
requiring a reboot. The force option in the cfg-restore command allows a user to force a reboot. The
command is: cfg-restore {flash | tftp | sftp} <FILE-NAME> force.

Before reboot, config is the active configuration. After the device reboots, the backup file becomes the new
active configuration.

id | act pri sec | name
---+-------------+---------------
 1 |  *   *   *  | config
 2 |             | def
 3 |             | golden_config
 4 |             |
 5 |             | 

switch(config)# cfg-restore flash golden_config
Current running-configuration will be replaced with 'golden_config'.
Continue (y/n)? y
Configuration restore is in progress, configuration changes are temporarily
 disabled.
Configuration restoration is not allowed as the configuration has reboot required commands.

switch(config)# show cfg-restore status
 Status                 : Failed
 Config File Name       : golden_config
 Source                 : Flash
 Time Taken             : 5 Seconds
 Last Run               : Mon Oct 30 23:03:19 2017

 Recovery Mode          : Enabled
 Failure Reason         : Reboot required commands present.
 Command : console terminal none

 Number of Add Commands    : 0
 Number of Remove Commands : 1

Time Taken for Each Phase :
      Calculating diff     : 3 Seconds
      Adding commands      : 0 Seconds
      Removing commands    : 0 Seconds

switch# cfg-restore flash golden_config force
Device may be rebooted if the configuration file has reboot required or
system-wide change commands. Do you want to continue  (y/n)?
Current running-configuration will be replaced with 'golden_config'.
Continue (y/n)?
Configuration restore is in progress, configuration changes are temporarily
disabled.

Successfully applied configuration 'golden_config' to running configuration.

Rebooting switch...
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In the preceding output, Command : console terminal none shows that cfg-restore failed because a
reboot is required.

After the switch reboots and comes up, the golden_config becomes the active configuration.

In case of a switch reboot, the switch comes up with the configuration associated with the primary or
secondary.

 id | act pri sec | name
 ---+-------------+------------------------------------------------
  1 |      *   *  | config
  2 |             | def
  3 |  *          | golden_config
  4 |             | 
  5 |             |

switch# show cfg-restore status
 Status                 : Success
 Config File Name       : default
 Source                 : Flash
 Time Taken             : 1 Seconds
 Last Run               : Mon Oct 23 07:17:03 2017

 Recovery Mode          : Enabled
 Failure Reason         : -

 Number of Add Commands    : 0
 Number of Remove Commands : 5

Time Taken for Each Phase :

      Calculating diff     : 1 Seconds
      Adding commands      : 0 Seconds
      Removing commands    : 0 Seconds

Time taken for adding and deleting commands is zero, as the switch reboots. It is similar to
downloading a startup-configuration to the device.

cfg-restore non-blocking

Syntax
cfg-restore {flash | tftp | sftp} <FILE-NAME> non-blocking

Description

Performs restore in non-blocking mode.

Command context
config

Example

switch(config)# cfg-restore flash add non-blocking
Current running-configuration will be replaced with 'add'.
Continue (y/n)? y
Configuration restore is in progress, configuration changes are
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temporarily disabled.
switch(config)#

switch(config)# show cfg-restore status
 Status                 : Success
 Config File Name       : add
 Source                 : Flash
 Time Taken             : 2 Seconds
 Last Run               : Sun Oct 22 22:09:02 2017

 Recovery Mode          : Enabled
 Failure Reason         : -

 Number of Add Commands    : 7
 Number of Remove Commands : 10

Time Taken for Each Phase :                                               
      Calculating diff     : 1 Seconds
      Adding commands      : 0 Seconds
      Removing commands    : 0 Seconds

cfg-restore recovery-mode

Syntax
cfg-restore {flash | tftp | sftp} <FILE-NAME> recovery-mode {enable | disable}

Description

Restores the current running configuration, if a restore to the backup configuration fails. By default, recovery-
mode is enabled.

Command context
config

Usage

To disable recovery mode, use cfg-restore {flash | tftp | sftp} <FILE-NAME> recovery-mode
disable.

Example

With the following running configuration, a restore to the backup file modify fails, but this configuration will be
retained as recovery mode is enabled.

switch(config)# show running-config

Running configuration:

; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a
ip routing
snmp-server community "public" unrestricted
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-28
   ip address dhcp-bootp
   exit
vlan 10
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   name "VLAN10"
   no ip address
   exit

switch(config)# show config modify
; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a
ip default-gateway 172.20.0.1
ip routing
snmp-server community "public" unrestricted
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-28
   ip address dhcp-bootp
   exit
vlan 100
   name "VLAN100"
   no ip address
   exit

switch(config)# cfg-restore flash modify
Current running-configuration will be replaced with 'modify'.
Continue (y/n)? y
Configuration restore is in progress, configuration changes are
 temporarily disabled.

Configuration restore to config 'modify' failed, restored source
 configuration to running configuration.

switch(config)# show running-config

Running configuration:

; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a
ip routing
snmp-server community "public" unrestricted
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-28
   ip address dhcp-bootp
   exit
vlan 10
   name "VLAN10"
   no ip address
   exit

switch(config)# cfg-restore flash modify recovery-mode disable
Current running-configuration will be replaced with 'modify'.
Continue (y/n)? y
Configuration restore is in progress, configuration changes are
 temporarily disabled.

Partially applied configuration 'modify' to running configuration.
Aruba-2930F-24G-PoEP-4SFPP(config)# show running-config

Running configuration:

; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
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hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a
ip routing
snmp-server community "public" unrestricted
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-28
   ip address dhcp-bootp
   exit
vlan 100
   name "VLAN100"
   no ip address
   exit

cfg-restore verbose

Syntax
cfg-restore {flash | tftp | sftp} <FILE-NAME> verbose

Description

Provides the details of configuration restore status and the list of commands to be added or deleted along with
cfg-restore.

Command context
config

Examples

switch(config)# cfg-restore flash config verbose
Current running-configuration will be replaced with 'config'.
Continue (y/n)? y

Configuration restore is in progress, configuration changes are temporarily disabled.

Configuration Restore Information: 

 Status                 : Success
 Config File Name       : config
 Source                 : Flash
 Time Taken             : 6 Seconds
 Last Run               : Tue Nov  7 03:43:07 2017

 Recovery Mode          : Enabled
 Failure Reason         : -

 Number of Add Commands    : 0
 Number of Remove Commands : 12

Time Taken for Each Phase :
      Calculating diff     : 2 Seconds
      Adding commands      : 0 Seconds
      Removing commands    : 0 Seconds

Configuration delete list:

vlan 2
   name "VLAN2"
   no ip address
   exit
vlan 3
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   name "VLAN3"
   no ip address
   exit
vlan 4
   name "VLAN4"
   no ip address
   exit
vlan 5
   name "VLAN5"
   no ip address
   exit

Successfully applied configuration 'config' to running configuration.

cfg-restore config_bkp

Syntax
cfg-restore {tftp <ip-address> | sftp <ip-address>} config_bkp

Description

Downloads and restores a configuration from the TFTP or SFTP server, without rebooting the switch.

The commands from the restored configuration will be executed on the running configuration. The
name of the current active configuration will not change after a configuration restore.

Command context
config

Example

switch(config)# cfg-restore tftp
 HOSTNAME-STR          Specify hostname of TFTP Server.
 IP-ADDR               IP Address of the TFTP Server.
 IPV6-ADDR             IPV6 Address of the TFTP Server.

switch(config)# cfg-restore sftp
 HOSTNAME-STR          Specify hostname of the SFTP server.
 IP-ADDR               IP Address of the SFTP Server.
 IPV6-ADDR             IPV6 Address of the SFTP Server.
 user                  Specify username on the remote system information
 USER@IP-STR           Specify username along with remote system
                       information

switch(config)# cfg-restore tftp 10.100.0.12 pvos/tftp_2930_config_file
Current running-configuration will be replaced with 'tftp_2930_config_file'.
Continue (y/n)? y
Configuration restore is in progress, configuration changes are temporarily disabled.

Successfully applied configuration 'tftp_2930_config_file' to running configuration.

switch(config)# sh cfg-restore status
 Status                 : Success
 Config File Name       : tftp_2930_config_file
 Source                 : TFTP
 Time Taken             : 4 Seconds
 Last Run               : Wed Nov  8 21:11:10 2017

 Recovery Mode          : Enabled
 Failure Reason         : -

408 Aruba 2530 Management and Configuration Guide for ArubaOS-Switch 16.05

Anexo 04 ITEM 10 (0592646)         SEI 0008478-63.2018.6.02.8000 / pg. 5467



 Number of Add Commands    : 4
 Number of Remove Commands : 7

Time Taken for Each Phase :
      Calculating diff     : 1 Seconds
      Adding commands      : 0 Seconds
      Removing commands    : 0 Seconds

switch(config)# show config files

Configuration files:

 id | act pri sec | name
 ---+-------------+---------
  1 |  *   *   *  | config
  2 |             |
  3 |             |
  4 |             |
  5 |             |

Configuration restore with force option

Prerequisites
Back up the configuration using traditional copy config or cfg-backup commands.

Procedure

1. Execute the show config files command. By default, the config file provides all the associations.

switch(config)# show config files

Configuration files:

 id | act pri sec | name
 ---+-------------+-------
  1 |  *   *   *  | config
  2 |             | file1
  3 |             | file2
  4 |             |
  5 |             |

2. Use cfg-restore flash file1 force command to see the configuration of file1.

switch(config)# cfg-restore flash file1 force
As the file1 configuration requires a reboot, a system reboot occurs. When the switch comes up, file1 is the
new active configuration.

switch(config)# sh config files

Configuration files:

 id | act pri sec | name
 ---+-------------+---------
  1 |      *   *  | config
  2 |  *          | file1
  3 |             | file2
  4 |             |
  5 |             |
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During a configuration restore with reboot, the association changes. To make the configuration as
a default configuration for subsequent system reboots, use startup-default [<primary|
secondary>] config FILENAME command.

For startup-default config file1:

switch(config)# show config files

Configuration files:

id | act pri sec | name
 --+-------------+---------
 1 |             | config
 2 |  *   *   *  | file1
 3 |             | file2
 4 |             |
 5 |             |

System reboot commands
Following commands require a system reboot:

• secure-mode standard
• secure-mode enhanced
• mesh id [0-9]
• mesh [a-z | A-Z | 0-9]
• max-vlans <257-4094>
• no allow-v2-modules
• qinq (mixedvlan | svlan)
• qos queue-config
• terminal type (vt100 | ansi)
• console (flow-control | terminal)
• vsf member [0-9]
• vsf remove
• access-list grouping
• console baud-rate (speed-sense | 1200 | 2400 | 4800 | 9600 | 19200 | 38400 |

57600 | 115200)

Systemwide change commands
Following commands change the system configuration:

• module [0-9 | a-z | A-Z]
• module [0-9 | a-z | A-Z] type <type>
• igmp lookup-mode ip
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• flexible-module [a-z | A-Z] type <type>
• stacking member [0-9] flexible-module [a-z | A-Z] type <type>

Configuration restore without force option
If the two configuration files backed up are file1 and file2:

Prerequisites
Backup the configuration using either the traditional copy config or the cfg-backup commands.

Procedure

1. Execute the show config files command. By default, the config file provides all the associations.

switch(config)# show config files

Configuration files:

 id | act pri sec | name
 ---+-------------+-------
  1 |  *   *   *  | config
  2 |             | file1
  3 |             | file2
  4 |             |
  5 |             |

2. Use cfg-restore flash file1 command to see the configuration of file1.

switch(config)# cfg-restore flash file1
Even after executing the previous command, associations will remain the same, but the running configuration
is replaced by file1 configuration.

In a configuration restore without reboot, the association remains the same. The default config
file is updated based on the configuration of the restored file.

show cfg-restore status
Syntax
show cfg-restore status

Description

Shows the status of latest restore performed. The running configuration is updated based on the configuration of
the restored file.

Command context
config

Usage
show cfg-restore {status | latest-diff}
This command provides information on:
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• how a restore is performed

• whether a flash file was used from SFTP or TFTP server

• the total time taken to restore

• the time when last restore was initiated

• whether a recovery-mode was enabled

• the number of add and delete commands

• reboot commands present (if any), and

• the split time taken for each phase

Examples

switch(config)# show cfg-restore
 latest-diff           Shows the difference between running and back-up
                       configuration.
 status                Show configuration restoration status.

switch(config)# show cfg-restore status
Status           : [Failed| In progress | Success | Not Started]
Config File name : def
Source           : [-|Tftp|sftp|Flash|REST]
Time taken       : [-|20 Seconds.]
Last Run         : [-|Tue March 07 22:12:16 2017.]

Recovery Mode          : Enabled
Failure Reason         : -

Number of Add Commands    : 0
Number of Remove Commands : 3

Time Taken for Each Phase :
      Calculating diff     : 1 Seconds
      Adding commands      : 0 Seconds
      Removing commands    : 0 Seconds
If the configuration restoration fails, the line number and the failed commands are displayed:

switch(config)# show cfg-restore status
Status           : Failed
Config File name : def
Source           : Flash
Time taken       : 20 Seconds
Last Run         : Sun Oct 22 20:22:54 2017

Recovery Mode          : Enabled
Failure Reason         : Add commands have been failed

Number of Add Commands    : 0
Number of Remove Commands : 3

Time Taken for Each Phase :
      Calculating diff     : 1 Seconds
      Adding commands      : 0 Seconds
      Removing commands    : 0 Seconds

Failed to remove commands:
 Line: 12 vlan 10
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 Line: 15 no ipv6 nd snooping mac-check
Failed to add commands:
 Line: 10 icmp 10.100.0.12 source-inter vlan 1
 Line: 20 udp-echo 10.100.0.12 source vlan 1

The number of add and delete commands is calculated excluding the exit commands in the
configuration file.

Viewing the differences between a running configuration and a backup
configuration

Prerequisites
Use the cfg-restore {flash | tftp | sftp} <FILE-NAME> diff command to view the list of
configuration changes that are removed, modified, or added to the running configuration.

Procedure

1. Execute the show running-config command to show the running configuration of the switch.

switch(config)# show running-config

Running configuration:

; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a
snmp-server community "public" unrestricted
vlan 1
   name "DEFAULT_VLAN"
   no untagged 11-13,15-18
   untagged 1-10,14,19-28
   ip address dhcp-bootp
   exit
vlan 100
   name "VLAN100"
   untagged 11-13
   no ip address
   exit
vlan 300
   name "VLAN300"
   untagged 15-18
   no ip address
   exit

2. Execute the show config golden_config command to show the backup configuration of the switch.

switch(config)# show config golden_config
; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a
; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a

3. Execute the cfg-restore flash golden_config diff command to view the differences that will be
applied.
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switch# cfg-restore flash golden_config diff 

Configuration delete list:

vlan 1
   no untagged 11-13,15-18
   untagged 3-10
   exit
vlan 100
   untagged 11-13
   exit
vlan 300
   name "VLAN300"

   untagged 15-18
   no ip address
   exit

Configuration add list:

vlan 1
   no untagged 3-10
   untagged 11-13,15-18
   exit
vlan 100
   untagged 3-5
   exit
vlan 200
   name "VLAN200"
   untagged 6-10
   no ip address
   exit

If the running and the backup configuration is the same, no difference will be displayed.

switch(config)# cfg-restore flash modify diff

Current config and backup config is identical.

4. Execute the show cfg restore latest-diff command to display the difference between the running
and the backup configuration.

switch(config)# show cfg-restore
 latest-diff           Shows the difference between running and back-up
                       configuration.
 status                Show configuration restoration status.

switch(config)# show cfg-restore latest-diff

Configuration delete list:

ip default-gateway 172.20.0.1
vlan 100
   name "VLAN100"
   no ip address
   exit

Configuration add list:

vlan 10
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   name "VLAN10"
   no ip address
   exit

switch(config)#

Show commands to show the SHA of a configuration
The show commands provide SHA details of the running and startup configurations.

show hash
Syntax
show {config | running-config} hash {recalculate}

Description

Shows SHA ID of startup or running configuration.

Command context
config

Examples

switch# show config
 config
 files                 List saved configuration files.
 hash                  Display the hash calculated for the startup
                       configuration.
 interface             Show the startup configuration for interfaces.
 oobm                  Show the startup configuration for OOBM.
 
To display the hash calculated for the startup configuration:

switch(config)# show config hash
The hash must be calculated.  This may take several minutes.

Continue (y/n)? y

Calculating hash...
Startup Configuration hash:

4f66 8b77 6b66 e5fb 0c12 f7fb 8ea6 b548 af2e 2e03

This hash is only valid for comparison to a baseline hash if
the configuration has not been explicitly changed (such as
with a CLI command) or implicitly changed (such as by the
removal of a hardware module).

switch(config)# show config hash
recalculate           Calculate hash (if needed) without prompting.

switch(config)# show config hash recalculate
Startup Configuration hash:

4f66 8b77 6b66 e5fb 0c12 f7fb 8ea6 b548 af2e 2e03

This hash is only valid for comparison to a baseline hash if
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the configuration has not been explicitly changed (such as
with a CLI command) or implicitly changed (such as by the
removal of a hardware module).
To display the hash calculated for the running configuration:

switch(config)# show running-config hash
The hash must be calculated.  This may take several minutes.

Continue (y/n)? y

Calculating hash...
Running configuration hash:

6d88 0880 98af e8a8 b564 15cd 368e 4269 9d61 4bfa

This hash is only valid for comparison to a baseline hash if
the configuration has not been explicitly changed (such as
with a CLI command) or implicitly changed (such as by the
removal of a hardware module).

Scenarios that block the configuration restoration process
The configuration restoration process is blocked in the following scenarios:

• If the restored configuration file requires a reboot.

• If the restored configuration changes the entire configuration (for example, module add or remove).

More information

cfg-restore on page 401

Limitations
Switch configuration restore without reboot feature does not support the following scenarios:

• Removing a physically present member through cfg-restore command

• Flex-module provisioning or removal on standalone or a stack

• Module provisioning or removal on standalone or a stack

• Adding a VLAN when the VLAN limit is already reached by having dynamic VLANs. Due to timing issues, ports
or dynamic VLANs take some time to become offline or be removed, even after applying a removal command.
In such a case, restore commands fail as normal CLI commands.

• The maximum number of backup configuration files has been increased from three to five. When the firmware
is downgraded to lower versions, the show config files command displays the details to only three
configuration files.

• Restore is allowed based on the available system resource factors.

Blocking of configuration from other sessions
All write operations are not allowed from other sessions (CLI/WebUI/SNMP/REST, and so on) during a
configuration restoration process. Only read operation is allowed. Attempts to use write operation results in the
Configuration restore is in progress, configuration changes are temporarily
disabled error. The following show commands are blocked during a configuration restoration process:
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• show-tech
• show config
• show running-config
• show startup-config

Troubleshooting and support
Switch configuration restore without reboot feature provides CLI support to:

• display the number of commands with line number that failed to restore.

• display the delta between running configuration and the configuration to be restored.

More information

Viewing the differences between a running configuration and a backup configuration on page 413
show cfg-restore status on page 411

debug cfg-restore
Syntax
debug cfg-restore

Description

Debug logs display the commands executed by cfg-restore.

Command context

config and manager

Example

switch(config)# debug cfg-restore
switch(config)# debug destination buffer
switch(config)# show debug buffer
0000:01:39:51.58 CFG mCfgRestoreMgr:cfg-restore to config file "backup_conif"
   started.
0000:01:39:56.45 CFG mCfgRestoreMgr:cfg-restore diff calculated, number of
   commands to add =0 number of commands to delete = 3.
0000:01:39:56.45 CFG mCfgRestoreMgr:cfg-restore iteration count = 1.
0000:01:39:56.51 CFG mCfgRestoreMgr:Command executed = no vlan 2 tagged 9,
   Status = Success.
0000:01:39:56.51 CFG mCfgRestoreMgr:Command deleted = vlan 2 tagged 9.
0000:01:39:56.58 CFG mCfgRestoreMgr:Command executed = no vlan 3 tagged 9,
   Status = Success.
0000:01:39:56.58 CFG mCfgRestoreMgr:Command deleted = vlan 3 tagged 9.
0000:01:39:56.64 CFG mCfgRestoreMgr:Command executed = no vlan 4 tagged 9,
   Status = Success.
0000:01:39:56.65 CFG mCfgRestoreMgr:Command deleted = vlan 4 tagged 9.
0000:01:39:56.65 CFG mCfgRestoreMgr:cfg-restore iteration count = 2.
0000:01:39:59.38 CFG mCfgRestoreMgr:Successfully applied configuration
   'backup_conif' to running configuration.
** Total debug messages = 22

Chapter 21 Configuration backup and restore without reboot 417

Anexo 04 ITEM 10 (0592646)         SEI 0008478-63.2018.6.02.8000 / pg. 5476



HPE’s Virtual Technician is a set of tools aimed at aiding network switch administrators in diagnosing and caring
for their networks. VT provides tools for switch diagnoses when faced with unforeseen issues.

To improve the Virtual Technician features of our devices, HPE has added the following tools:

• Cisco Discovery Protocol

• Enabling Debug tracing for MOCANA code

• User diagnostic crash via front panel security button

• User diagnostic crash via the serial console

Cisco Discovery Protocol (CDP)

Show cdp traffic
Syntax

show cdp traffic
Description

Displays the number of Cisco Discovery Protocol (CDP) packets transmitted, received and dropped.

CDP frame Statistics

Port No|Transmitted Frames|Received Frames|Discarded Frames|Error Frames
-------  -----------------  --------------   ---------------  ---------
A1               46                  26              6           7
A2               30                  35              7           9
A3              120                 420              670       670

Clear cdp counters
Syntax

clear cdp counters
Description

Allows a user to clear CDP statistics.

Clear cdp counters

Port No|Transmitted Frames|Received Frames|Discarded Frames|Error Frames
-------  -----------------  --------------   ---------------  ---------
A1          46                   26                6              7

Chapter 22
Virtual Technician
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A2          30                   35                7              9
A3         120                  420               670            670

Enable/Disable debug tracing for MOCANA code

Debug security
Syntax

debug security ssl
Description

Enables the debug tracing for MOCANA code.

Use the [no] parameter to disable debug tracing.

ssl

Display all SSL messages.

User diagnostic crash via Front Panel Security (FPS)
button
Allows the switch’s front panel Clear button to manually initiate a diagnostic reset. In the case of an application
hang, this feature allows you to perform reliable diagnostics by debugging via the front panel Clear button.
Diagnostic reset is controlled via Front Panel Security (FPS) options.

Front panel security password-clear
From the configure context:

Syntax

[no] front-panel-security password-clear <RESET-ON-CLEAR> | factory-reset | 
password-recovery | diagnostic-reset <CLEAR-BUTTON | SERIAL-CONSOLE>
Description

Enable the ability to clear the password(s) and/or configuration via the front panel buttons.

[no] disables the password clear option.

Parameters

• If password-clear is disabled, the password(s) cannot be reset using the clear button on the front panel of
the device.

• If factory-reset is disabled, the configuration/password(s) can not be reset using the clear and reset
button combination at boot time.

• When password-recovery is enabled (and the front panel buttons disabled), a lost password can be
recovered by contacting HPE customer support.

• When password-recovery is disabled, there is no way to access a device after losing a password with the
front panel buttons disabled.
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• If diagnostic-reset is disabled, the user cannot perform a diagnostic switch reset on those rare events
where the switch becomes unresponsive to user input because of unknown reason(s).

• If diagnostic-reset is enabled, the user can perform a diagnostic hard reset which will capture valuable
diagnostic data and reset the switch.

Options

factory-reset

Enable/Disable factory-reset ability.

password-clear

Enable/Disable password clear.

password-recovery

Enable/Disable password recovery.

diagnostic-reset

Enable/Disable diagnostic reset.

Front-panel-security diagnostic-reset
From the configure context:

Syntax

front-panel-security diagnostic-reset <CLEAR-BUTTON | SERIAL-CONSOLE>
Description

Enables the diagnostic reset so that the switch can capture diagnostic data.

• To initiate diagnostic reset via the clear button, press the clear button for at least 30 seconds but not more than
40 seconds.

• To initiate diagnostic switch reset via the serial console, enter the diagnostic reset sequence on the serial
console.

Options

Clear button

Enables the diagnostics by choosing the clear button option.

Serial console

Enables the diagnostics by choosing the serial console option.

[no] front-panel-security diagnostic-reset
From the configure context:

Syntax

[no] front-panel-security diagnostic-reset
Description

Disables the diagnostic reset feature so that the user is prevented from capturing diagnostic data and performing
a diagnostic reset on the switch. Both the sub-options reset-via-serial-console and reset-via-clear-
button will be disabled. This is necessary if the switch becomes unresponsive (hangs) for unknown reasons.
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No front-panel-security diagnostic-reset

no front-panel-security diagnostic-reset

Clear Password       - Enabled
Reset-on-clear     - Disabled
Factory Reset        - Enabled
Password Recovery    - Enabled
Diagnostic Reset     - Disabled

Disabling the diagnostic reset prevents the switch from capturing diagnostic data on those rare
events where the switch becomes unresponsive to user input because of unknown reasons. Ensure
that you are familiar with the front panel security options before proceeding.

Front-panel-security diagnostic-reset clear-button
From the configure context:

Syntax

front-panel-security diagnostic-reset clear-button
Description

This command will enable diagnostic-reset via clear button. The user will be allowed to perform diagnostic reset
by depressing the clear button for 30 seconds and not more than 40 seconds.

Front-panel-security diagnostic-rest clear-button

front-panel-security diagnostic-rest clear-button

Diagnostic Reset     - Enabled
clear-button        - Enabled
serial-console      -Disabled

Disabling the diagnostic reset prevents the switch from capturing diagnostic data on those rare
events where the switch becomes unresponsive to user input because of unknown reasons. Ensure
that you are familiar with the front panel security options before proceeding.

[No] front-panel-security diagnostic-reset clear-button
From the configure context:

Syntax

[no] front-panel-security diagnostic-reset clear-button
Description

Disables the diagnostic-reset via clear button.

Disabling the diagnostic reset prevents the switch from capturing diagnostic data on those rare
events where the switch becomes unresponsive to user input because of unknown reasons. Ensure
that you are familiar with the front panel security options before proceeding.
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Show front-panel-security
Syntax

show front-panel-security
Options

Show front-panel-security

Clear Password    - Enabled
Reset –on-clear   - Disabled
Factory Reset     - Enabled
Password Recovery - Enabled
Diagnostic Reset  - Enabled

By default, user initiated diagnostic reset is enabled.

Diagnostic table

Validation rules

Validation Error

Extra ‘token’ passed after diagnostic-reset. Invalid input: <token>.

FPS Error Log

Event Message

RMON_BOOT_CRASH_RECORD1 Diagnostic reset sequence detected on serial
console; user has initiated diagnostic reset.

On detection on local serial

RMON_BOOT_CRASH_RECORD1 SMM: Diagnostic reset sequence detected
on serial console; user has initiated
diagnostic reset.

On detection on SMM serial console and
signaled to AMM

RMON_BOOT_CRASH_RECORD1 STKM: Diagnostic reset sequence detected
on serial console; user has initiated
diagnostic reset.

On detection on non-commander serial
console and signaled to commander

Table Continued
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Event Message

RMON_BOOT_CRASH_RECORD1 User has initiated diagnostic reset via the
serial console.

Sw_panic() message

RMON_BOOT_CRASH_RECORD1 SMM: User has initiated diagnostic reset via
the serial console.

Sw_panic() message when triggered via
SMM

RMON_BOOT_CRASH_RECORD1 STKM: User has initiated diagnostic reset via
the serial console.

Sw_panic() message when triggered via non-
commander

Console print STKM: HA Sync in progress; user initiated
diagnostic request via the serial console
rejected. Retry after sometime.

Printed on the device console. When standby
is in sync state, we don’t want to crash the
commander. So we report to the user to retry
later

Console print STKM: Member is booting; user initiated
diagnostic request via the serial console
rejected. Retry after sometime.

Printed on the device console. When the
member is till booting, it doesn’t have the
commander member number, thus we can’t
issue UIDC on the commander. So we report
to the user to retry later.

User initiated diagnostic crash via the serial console
Remotely triggers a diagnostic reset of the switch via a serial console. This reset reboots the switch and collects
diagnostic data for debugging an application hang, a system hang or any other rare occurrence. Diagnostic reset
is controlled via FPS options.

The serial sequence to initiate the User Initiated Diagnostic Reset via Serial console is Ctrl+S, Ctrl+T, Ctrl+Q, Ctrl
+T, Ctrl+S.

Front-panel-security diagnostic-reset serial-console
In the configure context:

Syntax

front-panel-security diagnostic-reset serial-console
Enables the diagnostic-reset via serial console. Allows the user to perform diagnostic reset by keying-in
diagnostic reset sequence.
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Front-panel-security diagnostic-reset serial-console

front-panel-security diagnostic-reset serial-console

Diagnostic Reset     - Enabled
clear-button       - Disabled
serial-console     - Enabled

[No] front-panel-security diagnostic-reset serial-console
In the configure context:

Syntax

[no] front-panel-security diagnostic-reset serial-console
Description

Disables the diagnostic-reset via serial console.

No front-panel-security diagnostic-reset serial-console

no front-panel-security diagnostic-reset serial-console

Diagnostic Reset     - Disabled

Disabling the diagnostic reset prevents the switch from capturing diagnostic data on those rare
events where the switch becomes unresponsive to user input because of unknown reasons. Ensure
that you are familiar with the front panel security options before proceeding.

Serial console error messages

Error Message

RMON_BOOT_CRASH_RECORD1 Diagnostic reset sequence detected on serial console;
user has initiated diagnostic reset.

RMON_BOOT_CRASH_RECORD1 SMM: Diagnostic reset sequence detected on serial
console; user has initiated diagnostic reset.

RMON_BOOT_CRASH_RECORD1 STKM: Diagnostic reset sequence detected on serial
console; user has initiated diagnostic reset.

RMON_BOOT_CRASH_RECORD1 User has initiated diagnostic reset via the serial
console.

RMON_BOOT_CRASH_RECORD1 SMM: User has initiated diagnostic reset via the serial
console.

RMON_BOOT_CRASH_RECORD1 STKM: User has initiated diagnostic reset via the serial
console.

Table Continued
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Error Message

Console print STKM: HA Sync in progress; user initiated diagnostic
request via the serial console rejected. Retry after
sometime.

Console print STKM: Member is booting; user initiated diagnostic
request via the serial console rejected. Retry after
sometime.

Chapter 22 Virtual Technician 425

Anexo 04 ITEM 10 (0592646)         SEI 0008478-63.2018.6.02.8000 / pg. 5484



Overview
Auto device detection

The command device-profile enables the user to define profiles and configure the associations of profiles to
each device type. By creating a device profile, parameters will be defined for a connection interface by device
type. To configure each parameter under a profile name, a context level is provided.

The command device-profile name <PROFILE NAME> configures for the default values. The default value
is permissible when no user-defined profile is created.

To associate each device type with a device profile, a context level is created which authorizes the user to enable
or disable the profile by device-type. Only the device type aruba-ap is supported.

Rogue AP isolation

The command rogue-ap-isolation configures each device and blocks, logs, or allows a rogue AP when
detected. The command enables or disables rogue AP isolation.

The command clear rogue-ap-isolation is provided to clear the detected rogue AP device MAC address.

Show commands are provided to display the configuration and status of the profiles. Another show command will
display the list of rogue APs detected.

Jumbo frames on a device port

Configure jumbo frame support for the device port. Jumbo frames are not permissible by default.

Enabling jumbo frame support in a profile might affect other ports with different profiles. When a profile has jumbo
frame enabled and is applied to any port, all other ports that are members of any VLAN listed in the profile will
also have jumbo frame support.

Configuration commands

allow-jumbo-frames
Syntax
allow-jumbo-frames
Description

Configure jumbo frame support for the device port. Jumbo frames are not enabled by default.

Enabling jumbo frame support in a profile affects other ports with different profiles. When a profile has jumbo
frames enabled and is applied to any port, all other ports that are members of any VLAN listed in the profile will
also have jumbo frame support.

Chapter 23
Easing Wired/Wireless Deployment feature integration
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Validation rules

Validation Error/Warning/Prompt

Invalid jumbo command. Invalid input.

If jumbo frame support is configured on a VLAN for
which the device profile had overridden the
configuration, display the existing warning.

This configuration change will be delayed because a
device profile that enables jumbo frame support is
applied to a port in this VLAN.

Default AP Profile
Creates a user-defined profile.

The profile name is a valid character string with the maximum permissible length of 32. The default profile is
named default-ap-profile and cannot be modified.

The default configuration parameters may be modified using the command device-<PROFILE NAME>
default-ap-profile . Up to four different profiles may be configured.

The [no] command removes the user-defined profiles.

device-profile
From within the configure context:

Syntax
device-profile <PROFILE-NAME> <DEVICE-TYPE>
    
Description

Create port configuration profiles and associate them with devices. When a configured device type is connected
on a port, the system will automatically apply the corresponding port profile. When the device is disconnected, the
profile is removed after a 2 minute delay. Connected devices are identified using LLDP.

Options

<PROFILE-NAME>

Specify the name of the profile to be configured.

<DEVICE-TYPE>

Specify an approved device-type to configure and attach a profile to.

Parameters

allow-jumbo-frames

Configure jumbo frame support for the device port.

untagged-vlan <VLAN-ID>

Configure this port as an untagged member of specified VLAN.

tagged-vlan <VLAN-LIST>

Configure this port as a tagged member of the specified VLANs.

cos <COS-VALUE>

Configure the Class of Service (CoS) priority for traffic from the device.
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ingress-bandwidth <PERCENTAGE>

Configure ingress maximum bandwidth for the device port.

egress-bandwidth <PERCENTAGE>

Configure egress maximum bandwidth for the device port.

poe-max-power <WATTS>

Configure the maximum PoE power for the device port (in watts).

poe-priority

Configure the PoE priority for the device port.

Usage
[no] device-profile name <PROFILE-NAME>
    
[no] device-profile type <DEVICE>
    

Associating a device with a profile
To associate an Aruba access point (AP) device-type to a user-defined profile, use the context HPE
Switch(device-aruba-ap)#. All Aruba access points use the identifier aruba-ap.

The [no] form of the command removes the device type association and disables the feature for the device type.

The feature is disabled by default.

device-profile type
From within the configure context:

Syntax

device-profile type <DEVICE> [associate <PROFILE-NAME> | enable | disable ]
Description

This command specifies an approved device type in order to configure and attach a profile to it. The profile’s
configuration is applied to any port where a device of this type is connected.

Approved device types

aruba-ap

Aruba access point device.

Options

From within the device-aruba-ap context

associate <PROFILE-NAME>

Associated the specified device type by profile name.

enable

Enables the automatic profile association.

disable

Disables the automatic profile association.
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Usage
[no] device-profile type <DEVICE> [associate <PROFILE-NAME> |enable | disable]
    
Restrictions

Only one device type is supported, aruba-ap, and it is used to identify all the Aruba access points.

Configuring the rogue-ap-isolation command
Used to configure the rogue-ap-isolation command. A block/log option may be configured for when a rogue
AP is identified by the switch. The block/log option may be enabled or disabled. The default action is to block a
rogue AP.

The whitelist command is used to configure any specific MAC addresses excluded from the rogue AP list. The
whitelist configuration is saved in the configuration. The whitelist supports 128 MACs.

The [no] form the command is used to remove the MAC address individually by specifying the MAC.

rogue-ap-isolation
Within the configure context:

Syntax
rogue-ap-isolation
Description

Configure rogue AP isolation and rogue AP Whitelist MAC addresses for the switch. When enabled, the system
detects the MAC address of rogue access points and takes the specified action for traffic or from that address.
The whitelist is used to add MAC addresses of approved access points to the whitelist.

Options

action

Configure the action to take for rogue AP packets. Actions available are enable, disable, block, log, and
whitelist.

block

Block and logs traffic to or from any rogue access points.

log

Log traffic to or from any rogue access points.

enable

Enable the rogue AP Isolation.

disable

Disable the rogue AP Isolation.

whitelist <MAC-ADDRESS>

Configures rogue AP Whitelist MAC addresses for the switch. This option is used to add MAC addresses of
approved access points to the whitelist.

<MAC-ADDR>

Specify the MAC address of the device to be moved from the Rogue AP list to the whitelist.
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Usage
rogue-ap-isolation [enable | disable]
rogue-ap-isolation action [log | block]
[no] rogue-ap-isolation whitelist <MAC-ADDRESS>
    

VXLAN show commands
VXLAN show commands include commands to display the status of a VXLAN feature, tunnels, and tunnel
statistics.

show device-profile
Syntax

Within the configure context:

show device-profile
Description

Show device profile configuration and status.

config

Show the device profile configuration details for a single, or all, profiles.

status

Show currently applied device profiles.

Usage
show device-profile config <PROFILE-NAME>
    
show device-profile status

show device-profile config

Switch# Show device-profile config
 Device Profile Configuration
  Configuration for device profile : default-ap-profile
   untagged-vlan    : 1
   tagged-vlan      : None
   ingress-bandwith : 100%
   egress-bandwith  : 100%
   cos       : 0
   speed-duplex     : auto
   poe-max-power    : 33W
   poe-priority     : High
   allow-jumbo-frames: Enabled

  Configuration for device profile : profile1
   untagged-vlan    : 10
   tagged-vlan      : 40,50,60
   ingress-bandwith : 10%
   egress-bandwith  : 95%
   cos       : 4
   speed-duplex     : auto-10
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   poe-max-power    : 20W
   poe-priority     : Low

show device-profile config profile1

Switch# Show device-profile config profile1
 Device Profile Configuration
  Configuration for device profile : profile1
   untagged-vlan    : 10
   tagged-vlan      : 40,50,60
   ingress-bandwith : 10%
   egress-bandwith  : 95%
   cos       : 4
   speed-duplex     : auto-10
   poe-max-power    : 20W
   poe-priority     : Low

show command device-profile status
Syntax
show device-profile [config | status]
Description

Displays the device-profile configuration or device-profile status.

Options

config

Show device profile configuration details for a single profile or all profiles.

status

Show currently applied device profiles status.

show device-profile status

Switch# show device-profile status

 Device Profile Status
  Port          Device Type      Applied Device Profile
  ----          -----------      ----------------------
  5             aruba-ap         profile1
  10            aruba-ap         profile1

Show rogue-ap-isolation
Syntax
show rogue-ap-isolation
Description

Show rogue access point information.

Options

whitelist

Show rogue access point whitelist information.
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Usage
show rogue-ap-isolation whitelist

show rogue-ap-isolation

Switch# show rogue-ap-isolation

 Rogue AP Isolation 
  Rogue AP Status : Enable
  Rogue AP Action : Block
   Rogue AP MAC                    Neighbor Device 
   -----------------               -----------------
   11:22:33:44:55:66               00:12:34:56:67:89
   aa:bb:cc:dd:ee:ff               00:98:45:56:67:89

show rogue-ap-isolation whitelist

Switch# show rogue-ap-isolation whitelist 

 Rogue AP Whitelist Configuration
  Rogue AP MAC                    
  -----------------             
  11:22:33:44:55:66               
  aa:bb:cc:dd:ee:ff  

432 Aruba 2530 Management and Configuration Guide for ArubaOS-Switch 16.05

Anexo 04 ITEM 10 (0592646)         SEI 0008478-63.2018.6.02.8000 / pg. 5491



Overview
Every client is associated with a user role. User roles associate a set of attributes for authenticated clients (clients
with authentication configuration) and unauthenticated clients, applied to each user session. User roles must be
enabled globally.

Local user roles are only supported when running YA software.

Examples of user roles are:

• Employee = All access

• Contractor = Limited access to resources

• Guest = Browse Internet

Each user role determines the client network privileges, frequency of reauthentication, applicable bandwidth
contracts, and other permissions. There are a maximum of 32 administratively configurable user roles available
with one predefined and read-only user role called denyall.

A user role consists of optional parameters such as:

• Captive portal profileSpecifies the URL via:

◦ captive-portal profile

or

◦ Vendor Specific Attribute (VSA). RADIUS: HP HP-Captive-Portal-URL = <http://...>

• Ingress user policy

L3 (IPv4 and/or IPv6) ordered list of Classes with actions, with an implicit deny all for IPv4 and IPv6.

• Reauthentication period

The time that the session is valid for. The default is 0 unless the user role is overridden. The default means
that the reauthentication is disabled.

Reauthentication period is required to override the default of 0.

• Untagged VLAN (either VLAN ID or VLAN-name)

VLAN precedence order behavior:

Chapter 24
Local user roles
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◦ If configured, untagged VLAN specified in the user role (VSA Derived Role, UDR, or Initial Role).

◦ Statically configured untagged and/or tagged VLANs of the port the user is on.

Operational notes

• When user roles are enabled, all users that are connecting on ports where authentication is configured will
have a user role applied. User role application happens even if the user fails to authenticate. If the user cannot
be authenticated, the “Initial Role” will be applied to that user.

• The user role may be applied in one of two ways:

◦ Vendor Specific Attribute (VSA)

Type: RADIUS: Hewlett-Packard-Enterprise

Name: HPE-User-Role

ID: 25

Value: <myUserRole>

The RADIUS server (ClearPass Policy Manager) determines application of the VSA Derived Role. The role
is sent to the switch via a RADIUS VSA. The VSA Derived Role will have the same precedence order as
the authentication type (802.1x, WMA).

◦ User Derived Role (UDR

)The User Derived Role is part of Local MAC authentication (LMA) and is applied when user roles are
enabled and LMA is configured.

UDR will have the same precedence as LMA. Precedence behavior of the authentication types will be
maintained, (802.1x -> LMA -> WMA (highest to lowest)).

Restrictions

• User roles cannot be enabled when BYOD redirect, MAC authentication failure redirect, or enhanced web-
based authentication are enabled.

• Web-based authentication is not supported on the same port with other authentication methods when user
roles are enabled.

• show port-access <AUTH-TYPE> commands are not supported when user-roles are enabled. The
command show port-access clients [detail] is the only way to see authenticated clients with their
associated roles.

• aaa port-access auth <port> control commands are not supported when user roles are enabled.

• unauth-vid commands are not supported when user roles are enabled.

• auth-vid commands are not supported when user roles are enabled.

Limitations for web-based authentication

Cannot be combined with other authentication types on same port.

Limitations for LMA

Reauthentication period and captive portal profile are not supported.
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Error messages

Action Error message

Attempting to enable BYOD Redirect when user roles
are enabled.

BYOD redirect cannot be enabled when user roles are
enabled.

Attempting to enable MAFR when user roles are
enabled.

MAC authentication failure redirect cannot be enabled
when user roles are enabled.

Attempting to enable enhanced web-based
authentication when user roles are enabled.

Enhanced web-based authentication cannot be
enabled when user roles are enabled.

Attempting to enable web-based authentication when
other authentication types are enabled for the same
port, and user roles are enabled.

Web-based authentication cannot be enabled with
other authentication types on this port when user roles
are enabled.

switch (config)# show port-access mac-
based clients User roles are enabled. Use show port-access

clients to view client information.

switch (config)# aaa port-access
authenticator e8 control autho 802.1x control mode, Force Authorized/

Unauthorized, cannot be set when user roles are
enabled.

Attempting to enable local user role
when MAFR, BYOD, or EWA are enabled. User roles cannot be enabled when BYOD redirect,

MAC authentication failure redirect, or enhanced web-
based authentication are enabled.

Captive-portal commands

Overview
The Captive Portal profile defines the web address that a user is redirected to for Captive Portal authentication. If
the url is blank, a RADIUS VSA will be used.

There is a predefined profile called use-radius-vsa that is already configured to use the RADIUS
VSA.

Two captive portal profiles are supported:

• Predefined and read-only

Predefined and read-only profile name is use-radius-vsa.

• Customized

[no] aaa authentication captive-portal profile
Syntax
[no] aaa authentication captive-portal profile <PROFILE-STR> [url <URL-STR>]
    
Description
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Create a captive-portal profile. Profiles are used in user roles to direct the user to a designated captive portal
server. When the profile includes a web address, that web address is always used to contact the server. When no
web address is specified, it is obtained from the RADIUS VSA.

A profile does not have to be pre-existing in the switch for it to be configured to a user role.

Options

profile

Configure a captive portal profile.

<PROFILE-STR>

Configure a captive portal profile string 64 characters long.

url

Configure the captive portal server web address.

<URL-STR>

Configure the captive portal server web address string.

Usage
Switch# aaa authentication captive-portal profile <NAME>
    
Switch# aaa authentication captive-portal profile <NAME> url <URL>

Validation rules

Validation Error/Message/Prompt

Attempts made to remove a nonexisting profile will
return an error:

switch# no aaa authentication captive-
portal profile NON_EXISTING_PROFILE

Captive portal profile
NON_EXISTING_PROFILE not found.

When including the configured web address after the
web address parameter:

[no] aaa authentication captive-portal
profile myCaptivePortalProfile url
http://myCPPM.local/guest/
captive_portal_login.php

Invalid input: http://blablabla.com

A profile name with invalid syntax produces an error:

Switch# aaa authentication captive-
portal-profile “this is an invalid name”

#aaa authentication captive-portal-
profile “this is an invalid name”
Invalid character ' ' in name.

When trying to modify a profile that is predefined,
switch# aaa authentication captive-
portal-profile name use-radius-vsa

Captive portal profile use-radius-vsa is read only
and cannot be modified

Table Continued
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Validation Error/Message/Prompt

A profile name that is too long produces an error:

switch# aaa authentication captive-
portal-
profiletest342...;ldklsdjflkdsjflk

The name must be fewer than 64 characters.

When attempting to configure more than the number of
admin configured profiles,switch# aaa
authentication captive-portal-profile
profileNumber2

No more captive portal profiles may be created.

Policy commands

Overview
These commands create a context that may be used to classify the policy. From the existing policy command, a
new policy type called user was added. The new actions are specific to policy user:

• redirect

• permit

• deny

Only L3 classes (IPv4 and IPv6) are currently supported.

The user policy includes “implicit deny all rules” for both IPv4 and IPv6 traffic.

policy user
Syntax
policy user <POLICY-NAME>
    
Description

Create and enter newly created user policy context.

Usage
Switch (config)# policy user employee

[no] policy user
Syntax
[no] policy user <POLICYNAME>
    
Description

Delete and remove specified user policy from switch configuration.

Operating notes

Chapter 24 Local user roles 437

Anexo 04 ITEM 10 (0592646)         SEI 0008478-63.2018.6.02.8000 / pg. 5496



• The user policy will include implicit “deny all” rules for both IPv4 and IPv6 traffic.

• ipv4 or ipv6 classes must specify source address as any. Specifying host addresses or subnets will result in
the following error message:

Switch (policy-user)# class ipv4 class25 action priority 0 
User policies cannot use classes that have a source IP address specified.

• permit and deny are mutually exclusive.

• ip-precedence and dscp are mutually exclusive.

Usage
switch (config)# no policy user employee

policy resequence
Syntax
policy resequence <POLICYNAME> <START><INCREMENT>
    
Description

Resequence classes and remarks configured within specified user policy. The usage shows resequencing classes
and remarks within user policy “employee” starting at 200 and incrementing by 2.

Usage
Switch (config)# policy user employee 200 2

Commands in the policy-user context
Create classes inside of the policy context before you apply actions to them.

(policy-user)# class
Within the policy-user context:

Syntax
(policy-user)# [no] [<SEQUENCE-NUMBER>] class ipv4 | ipv6 <CLASS-NAME> [action 
permit | deny | redirect captive portal] | [action dscp | ip—precedence <CODEPOINT 
| PRECEDENCE>] [action priority <PRIORITY>] | [action rate-limit kbps <RATE>]
    
Description

Associate a class with ACL or QoS actions for this policy.

Options

Options

deny

Deny all traffic.

DSCP

Specify an IP DSCP.

IP-precedence

Specify the IP precedence.
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permit

Permit all traffic.

priority

Specify the priority.

rate-limit

Configure rate limiting for all traffic.

redirect

Specify a redirect destination.

Usage
Switch(policy-user)# class ipv6 employeeIpv6Http action deny
Switch(policy-user)# class ipv4 http action redirect captive-portal
Switch(policy-user)# class ipv4 dnsDhcp action permit

User role configuration

aaa authorization user-role
Syntax
aaa authorization user-role [enable | disable| [initial-role <ROLE-STR>] |[name <ROLE>]]
    
Description

Configure user roles. A user role determines the client network privileges, the frequency of reauthentication,
applicable bandwidth contracts, along with other permissions. Every client is associated with a user role or the
client is blocked from access to the network.

Options

enable

Enable authorization using user roles.

disable

Disable authorization using user roles.

initial-role

The default initial role “denyall” is used when no other role applies. If a client connects to the switch and does
not have a user role associated, then the initial role is used. Any role can be configured as initial role using
this option. Can be configured at per port level. The per port initial role takes priority over global initial role.

The initial role may be assigned if:

• captive-portal profile is configured with a web address, but the Captive Portal VSA is sent from RADIUS

• captive-portal profile is configured to use the RADIUS VSA but no Captive Portal VSA is sent.

• captive-portal feature is disabled when the captive-portal profile is referenced in the applied user role to the
client.

• The user role feature is enabled with RADIUS authentication, but no user role VSA is returned.

• User role does not exist.
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• Not enough TCAM resource available.

• Access-Reject from RADIUS.

• User role VSA is sent along with invalid attributes.

• RADIUS not reachable.

• VLAN configured on the user role does not exist.

• Captive Portal profile does not exist.

• User policy configured on the user role does not exist.

• Reauthentication period is enabled (nonzero) in the user role for LMA.

• Captive Portal profile is included in the user role for LMA.

name <NAME-STR>

Create or modify a user-role. Role name identifies a user-role. When adding a user-role, a new context will be
created. The context prompt will be named “user-role” (user-role)#.

Usage
Switch# aaa authorization user-role enable
Switch# aaa authorization user-role disable
Switch# aaa authorization user-role name <ROLE1>
    
Switch# [no] aaa authorization user-role enable
Switch# [no] aaa authorization user-role name <ROLE1>
    
Switch# aaa authorization user-role initial-role <ROLE1>
    
Switch# aaa authorization user-role name <MYUSERROLE> policy <MYUSERPOLICY>
    
Switch# aaa authorization user-role name <MYUSERROLE> captive-portal-profile <MYCAPTPORTPROFILE>
    
Switch# aaa authorization user-role name <MYUSERROLE> vlan-id <VID>
    
Switch# aaa authorization user-role name <MYUSERROLE> reauth-period <0-999999999>
    

Error log

Scenario Error Message

If the user tries to delete a user-role
configured as the initial role

User role <INITIAL_ROLE_NAME> is configured as the initial role and
cannot be deleted.

If the user attempts to configure more
than the number of administrator
configured roles

#aaa authorization user-role name roleNumber33. No
more user roles can be created.

Table Continued
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Scenario Error Message

If the user enters a role name that is too
long

switch# aaa authorization user-role
test342....jflkdsjflk. The name must be fewer than 64
characters long.

If the user enters a role name with
invalid syntax

switch# aaa authorization user-role name “this is an
invalid name”. Invalid character ' ' in name.

If the user tries to delete a nonexisting
user-role

User role <NON_EXISTING_ROLE_NAME> not found.

Switch# aaa authorization
user-role name <DENYALL> User role <DENYALL> is read only and cannot be modified.

captive-portal-profile
From within the user-role context:

Syntax
captive-portal-profile <PROFILE_NAME>
    
Description

Assigns a captive portal profile to the user role. The predefined captive portal profile, use-radius-vsa,
indicates that the redirect web address must be sent via RADIUS.

To clear a captive portal profile from the user role, use the [no] version of the command.

policy
From within the user-role context:

Syntax
policy <POLICY_NAME>
    
Description

Assigns a user policy to the user role. To clear a policy from the user role, use the [no] version of the command.

Modification of the user policy, or class contained in a user policy, will force users consuming that
user policy via a user role to be deauthenticated.

reauth-period
From within the user-role context:

Syntax
reauth-period <VALUE>
    
Description

Set the reauthentication period for the user role. Use [0] to disable reauthentication. For RADIUS-based
authentication methods, it will override the RADIUS session timeout. It also overrides any port-based reauth-
period configuration with the exception that LMA does not support a reauth-period.
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Options

<VALUE>

Valid values are 0 – 999,999,999; a required configuration in user roles and it defaults to 0.

(user-role)# reauth-period 100

Set the reauthentication value for the current user role:

(user-role)# reauth-period 100

(user-role)# reauth-period 0

0 is used to disable reauthentication, and it is the default value.

(user-role)# reauth-period 0

Validation rules

Validation Error/Warning/Prompt

(user-role)# reauth-period 10000000 Invalid input: 100000000000000000

VLAN commands
The VLAN must be configured on the switch at the time the user role is applied. Only one of VLAN-
name or VLAN-ID is allowed for any user role.

Modification of the VLAN will force users assigned to that VLAN via a user role to be
deauthenticated.

vlan-id
From within the user-role context:

Subcommand syntax
vlan-id <VLAN-ID>
    
Description

Create a VLAN with id VLAN-ID.

Use the [no] version of the command when clearing the VLAN-ID from the user role:

Usage
(user-role)# no vlan-id

vlan-name
From within the user-role context:

Subcommand syntax
vlan-name <VLAN-NAME>
    
Description

Create a VLAN with the name VLAN-NAME. Only one of VLAN-NAME or VLAN-ID is allowed for any user role.
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Use the [no] version of the command when clearing the VLAN from the user role, by name:

Usage
(user-role)# no vlan-name

vlan-id 100

(user-role)# vlan-id 100

vlan-name vlan100

(user-role)#vlan-name VLAN100

VLAN range commands
This command is executed from a global configuration context.

VLANs specified by VLAN-ID-LIST

Syntax
[no] vlan <VLAN-ID-LIST>

Description

Creates VLANs specified by the VLAN-ID-LIST and returns to the global configuration context. Use the [no]
version of the command to delete the VLANs specified by the VLAN-ID-LIST.

Examples
config# vlan 2-15
config# vlan 5,10,13-20,25
config# no vlan 2-10
config# no vlan 2,5,15-18,25

VLANs specified by VLAN-ID-LIST and tag specified ports specified by PORT-LIST

Syntax
[no] vlan <VLAN-ID-LIST> tagged <PORT-LIST>

Description

Creates VLANs specified by the VLAN-ID-LIST and tags the ports specified by the PORT-LIST to the VLAN-ID-
LIST. If VLANs already exist, the tagging of ports specified by the PORT-LIST is performed.

Use the [no] version of the command to remove the tagged PORT-LIST from a range of VLANs specified by the
VLAN-ID-LIST. After command execution, CLI returns to the global configuration context.

Examples
config# vlan 2-15 tagged A1-A20
config# vlan 5,10,13-20,25 tagged A1-A5,L2,L5-L10
config# vlan 2-20 tagged all
config# no vlan 2-15 tagged A1-A5
config# no vlan 5,10,13-20 tagged A1-A5,L6
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Applying a UDR
UDR can be used to assign user roles locally (that is, without RADIUS). LMA has been extended to allow applying
a user role to a MAC address, MAC group, MAC mask, or MAC OUI.

aaa port-access local-mac apply user-role
Syntax
[no] aaa port-access local-mac apply user-role <Role-Name> [ mac-oui <MAC-OUI> | 
mac-mask <MAC-MASK> |mac-addr <MAC-ADDR> | mac-group <MAC-GROUP-NAME>]
Description

Apply user roles.

Options

mac-addr

To apply user role with MAC address.

mac-group

To apply user role with MAC group.

mac-mask

To apply user role with MAC Mask.

mac-oui

To apply user role with MAC OUI.

Usage
[no] aaa port-access local-mac apply user-role <MYUSERROLE> [mac-oui <MAC-OUI>]
    
[no] aaa port-access local-mac apply user-role <MYUSERROLE> [mac-mask <MAC-MASK>]
    
[no] aaa port-access local-mac apply user-role <MYUSERROLE> [mac-addr <MAC-ADDR>]
    
[no] aaa port-access local-mac apply user-role <MYUSERROLE> [mac-group <MAC-GROUP-NAME>]
    

VXLAN show commands
VXLAN show commands include commands to display the status of a VXLAN feature, tunnels, and tunnel
statistics.

show captive-portal profile
Syntax
show captive-portal profile
Description

Show Captive Portal profile configuration.
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show captive-portal profile

(config)# show captive-portal profile

 Captive Portal Profile Configuration
  Name : use-radius-vsa
  Type : predefined
  URL  :
  
  Name : myCaptivePortalProfile
  Type : custom
  URL  : http://mycppm.local/guest/captive_portal_login.php

show user-role
Syntax
show user-role [<ROLE-NAME>] [detailed]
    
Description

Show users role configuration.

Options

<ROLE-NAME>

Show user roles by role-name.

<ROLE-NAME> detailed

Show user roles in detail by role-name.

show user-role

Switch# show user-role 

 User Roles

  Enabled      : <Yes/No>
  Initial Role : denyall

  Type          Name
  ----------    ------------
  local         Employee
  local         Guest
  predefined    denyall

show user-role <ROLE-NAME>

Switch# show user-role captivePortalwithVSA

User Role Information

Name                              : captivePortalwithVSA
  Type                              : local
  Reauthentication Period (seconds) : 0
  Untagged VLAN                     : 610
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  Captive Portal Profile            : use-radius-vsa
  Policy                            : cppolicy

show user-role detailed

The example shows how to configure user roles to use Clearpass as a Captive Portal. The Captive Portal URL is
specified in a RADIUS VSA.

Switch# show user-role captivePortalwithVSA detailed

User Role Information
   Name                              : captivePortalwithVSA
   Type                              : local
   Reauthentication Period (seconds) : 0
   VLAN                              : 610
   Captive Portal Profile            : use-radius-vsa
     URL                             : (use RADIUS VSA)
   Policy                            : cppolicy

Statements for policy "cppolicy"
policy user "cppolicy"
     10 class ipv4 "cppm" action permit
     20 class ipv4 "steal" action redirect captive-portal
     30 class ipv4 "other" action permit
   exit

Statements for class IPv4 "cppm"
class ipv4 "cppm"
     10 match tcp 0.0.0.0 255.255.255.255 1.0.9.15 0.0.0.0 eq 80
     20 match tcp 0.0.0.0 255.255.255.255 1.0.9.15 0.0.0.0 eq 443
   exit

Statements for class IPv4 "steal"
class ipv4 "steal"
     10 match tcp 0.0.0.0 255.255.255.255 0.0.0.0 255.255.255.255 eq 80
     20 match tcp 0.0.0.0 255.255.255.255 0.0.0.0 255.255.255.255 eq 443
   exit

Statements for class IPv4 "other"
class ipv4 "other"
     10 match udp 0.0.0.0 255.255.255.255 0.0.0.0 255.255.255.255 eq 53
     20 match udp 0.0.0.0 255.255.255.255 0.0.0.0 255.255.255.255 eq 67
     30 match icmp 0.0.0.0 255.255.255.255 0.0.0.0 255.255.255.255
   exit

show port-access clients
Syntax
show port-access clients [detailed]
Description

Use this command to display the status of active authentication sessions.

show port-access clients

Port Access Client Status

Port  Client Name   MAC Address   IP Address      User Role       Type VLAN
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----- ------------- ------------- --------------- -------------------- ------
1/A18 001517581ec4  001517-581ec4 10.108.1.201    ixia1           MAC   108
A7                  000c29-5121fc n/a             denyall         LOCAL
A8                  000c29-d12996 n/a             myrole          LOCAL 42

show port-access clients detailed

Switch (config)# show port-access clients detailed

 Port Access Client Status Detail
  Client Base Details :
   Port            : 1/A18                 Authentication Type : mac-based
   Client Status   : authenticated         Session Time        : 11 seconds
   Client Name     : 001517581ec4          Session Timeout     : 60 seconds
   MAC Address     : 001517-581ec4
   IP              : 10.108.1.201

 User Role Information
   Name                              : ixia1
   Type                              : local
   Reauthentication Period (seconds) : 60
   Untagged VLAN                     : 108
   Tagged VLANs                      :
   Captive Portal Profile            :
   Policy                            : policyIxia1

Statements for policy "policyIxia1"
policy user "policyIxia1"
     10 class ipv4 "classIxia1" action rate-limit kbps 11000
   exit

Statements for class IPv4 "classIxia1"
class ipv4 "classIxia1"
     10 match ip 0.0.0.0 255.255.255.255 0.0.0.0 255.255.255.255
   exit
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Overview
The Port QoS Trust feature restricts which packet QoS information may be used to determine inbound queue
servicing and any priority information to be permitted into the local hop.

Port QoS Trust Mode configuration allows preservation or removal of the inbound QoS priorities carried in Layer 2
(the VLAN cos or Priority CodePoint (PCP) value, known as the 802.1p priority tag) and/or in Layer 3 (the IP-ToS
byte, in IP-Precedence or IP-Diffserv mode). The different modes let the customer trust all, some, or no packet
priority fields.

The per-port configuration enables the customer to trust some sources or devices and not others. This feature is
mutually exclusive with any active port-priority configuration.

Configuration commands
qos trust
Syntax
qos trust [default|dot1p|dscp|ip-prec|none|device [none|<DEVICE-TYPE>]]
      
Description

Set the QoS Trust Mode configuration for the port.

Options

default

Trust 802.1p priority and preserve DSCP or IP-ToS.

device <DEVICE-TYPE>

On approved devices, trust IP-ToS Differentiated-Services in IP packets, and use the DSCP-MAP to remark
the 802.1p priority. If the DSCP codepoint does not have an associated priority, the priority will be remarked to
0. On unapproved devices, trust 802.1p priority and preserve any IP- ToS values.

dot1p

Trust 802.1p priority and preserve DSCP or IP-ToS.

dscp

Trust IP-ToS Differentiated-Services in IP packets, and use the DSCP-MAP to remark the 802.1p priority. If
the DSCP codepoint does not have an associated 802.1p priority, the priority will be remarked to 0.

ip-precedence

Trust IP-ToS IP-Precedence mode in IP packets and remark the 802.1p priority.

none

Do not trust either the 802.1p priority or the IP-ToS values.

QoS trust devices

Chapter 25
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aruba-ap

Aruba Access point device.

none

Clear all trusted devices from port.

Both SNMP and the CLI will verify that the current QoS Port Priority and desired QoS Trust Mode
configuration are not mutually exclusive (and conversely).

qos dscp-map
Syntax
qos dscp-map <CODEPOINT> priority <PRIORITY> [name <NAME> | default | legacy]
      
Description

Modifies DSCP mapping.

Options

default

Returns switch to the fully mapped factory-default configuration.

legacy

Restore the legacy default behavior (partial mapping) used in earlier code releases.

Show commands

show qos trust
Syntax
show qos trust [device] <PORT>
    
Description

Shows port-based QoS trust configuration

Options

device

Show list of trusted devices per-port.

<port>

Show trusted devices on a single port.

Usage
show qos trust [device | [ethernet <PORT-LIST> ]
    

show qos trust

switch# show qos trust
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Port-based qos Trust Configuration

  Port    Trust Mode   | Device Trust State ---- --- ----
  A1      Default      |    
  A2      Default      |     
  A3      Device**     | Trusted
  A4      IP-Prec      |
  A5      Dot1p        |
  A5      None         |
  A5      DSCP         |
  A5      Device**     | 
  A5      Dot1p        |

** For a list of trusted devices per-port, use the command show qos trust device.
To show trusted devices on a single port, use the command show qos trust device <PORT>.
      

show qos trust device

switch# show qos trust device

Port-Based QoS Trust Configuration

  Port    Trusted Devices
  ------- ---------------
  A1      aruba-ap
  A2      aruba-ap
  A4      aruba-ap

show qos trust device <PORT>

switch# show qos trust device <PORT>

Port A4 QoS Trust Configuration
   Current state: Trusted

   Trusted Devices: aruba-ap

Validation rules
Validation Error/Warning/Prompt

qos trust 
<UNSUPPORTEDDEVICETYPE>
                

Invalid input: %s

no qos trust <ANYVALUE>
                

Invalid command. To disable trust for a port, use
qos trust none. To return to the default
configuration and leave priority information
unchanged, use qos trust default.

QoS priority when trust mode is
anything other than <NONE> or
<DEFAULT>.

The port QoS trust mode must be <DEFAULT>
or <NONE> to configure the QoS port priority
feature.

Table Continued
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Validation Error/Warning/Prompt

QoS DSCP when trust mode is
anything other than <NONE> or
<DEFAULT>.

The port QoS trust mode must be <DEFAULT>
or <NONE> to configure the QoS port priority
feature.

QoS trust dot1.p when any port
QoS priority is enabled.

The port QoS priority feature must be disabled
before configuring this port QoS trust mode.

QoS trust ip-prec when any port QoS
priority is enabled.

The port QoS priority feature must be disabled
before configuring this port QoS trust mode.

QoS trust DSCP when any port QoS
priority is enabled.

The port QoS priority feature must be disabled
before configuring this port QoS trust mode.

QoS trust device when any port QoS
priority is enabled.

The port QoS priority feature must be disabled
before configuring this port QoS trust mode.
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Net-service Overview
Net-service names are used as alias in defining ACL rules for defined lists. An alias of net-service will configure a
list of hosts, networks, or subnets.

Extended ACL can have both source IP, destination IP and port number along with protocol in its ACE. An alias-
based ACE for an extended ACL therefore allows the use of an alias of net-service protocol and destination port.

Limitations

• Alias-based ACE will not support access-control based on source port which is a limitation of the net-service
command. The use of net-service will also restrict operators specified for port number to equals and range.

◦ Operators lt, gt, equal,negative, and range for the source port in the ACL rule are not specified using
the options available in net-service.

◦ Operators lt, gt, negative are not specified for destination port using the options available in net-
service.

◦ Only the ACL will be affected when changes are made to an existing net-service. Either the rule must be
reapplied to the ACL or the switch must be rebooted to affect the service.

netservice [tcp | udp | port]
Syntax
[no] netservice <NAME-STR> [tcp | udp | <PROTOCOL>] 
 port <PORT-LIST>
Description

Configures net-service.

Parameters

protocol

IP protocol number.

Range: 0-255

TCP

Configure an alias for a TCP protocol.

UDP

Configure an alias for a UDP protocol.

port

Specify a single port or a list of noncontiguous port numbers, by entering up to six port numbers, separated by
commas or range of ports.

Range: 0-65535

Chapter 26
Net-destination and Net-service

452 Aruba 2530 Management and Configuration Guide for ArubaOS-Switch 16.05

Anexo 04 ITEM 10 (0592646)         SEI 0008478-63.2018.6.02.8000 / pg. 5511



Example net-service tcp-service tcp 100

     net-destination src-ip
      host 10.120.0.1
      host 10.91.1.1
      host 10.0.100.12   

   net-destination destn-ip 
      host 16.90.51.12
      host 10.93.24.1

   net-service tcp-service tcp 100
   ip access-list extended “acl1”
      permit alias src-ip alias destn-ip alias tcp-service

Net-destination overview
The use of net-destination and net-service helps reduce effort required to configure ACL rules.

Net-destination is a list of hosts, networks, or subnets that are used to configure an ACL rules.

There are two types of ACLs supported and configured on the switch:

• Standard

• Extended

Standard

The standard ACL can have an IP source or network in the ACE. Defining the alias-based ACE for standard ACL,
only use an alias of net-destination for the source.

Example - standard

net-destination src-ip
      host 10.120.0.1
      host 10.91.1.1
      host 10.0.100.12   

   net-destination destn-ip 
      host 16.90.51.12
      host 10.93.24.1

   net-service tcp-service tcp 100
   ip access-list extended “acl1”
      permit alias src-ip alias destn-ip 
         alias tcp-service
Extended

The extended ACL can have both source IP, destination IP and port number along with protocol in its ACE.
Defining an alias-based ACE for an extended ACL can use an alias of net-destination for the source and
destination and an alias of net-service for the protocol and destination port. Alias-based ACE will not support
access-control based on source port which is a limitation of the net-service command. The use of net-service will
also restrict the operators that can be specified for port number to equalsand range.

Example - extended

HP-Switch-5406Rzl2(config)# ip access-list extended aext1
HP-Switch-5406Rzl2(config-ext-nacl)#
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   permit tcp host 10.100.12.1 gt 23 16.90.0.0 /16 range 200 400
HP-Switch-5406Rzl2(config-ext-nacl)# exit 
Limitations

• Limited to IPv4 addresses per syntax.

• Any changes made to an existing net-destination that is used by an ACL, will be applied on the ACL only when
the rule is reapplied to it or when switch is rebooted.

• The number of entries for a single net-destination is limited. The number of net-destinations configurable on a
switch is also limited.

• A considerable amount of memory (for global structures) will be allocated when alias-based ACEs are
configured which may cause issues on a switch with low memory.

• The Host or Domain name cannot be specified as an entry in a net-destination.

• Application level gateway will not be supported as the existing ACL infra does not support ALG.

• SNMP support to configure and delete net-destination, net-service, and the alias-based rules will not be
provided.

• The ‘invert’ and ‘range’ option have been deprecated as per ArubaOS-Switch 7.4 CLI Reference Guide and
hence will not be supported. However, the functionality of ‘invert’ option can be achieved through the ‘deny’
rule.

• RADIUS server-based ACL application to interface/VLAN will not be supported for ACLs with alias-based
rules.

net-destination host |position | network
Syntax
[no] netdestination <NAME-STR> [host <IP-ADDR>
 [position <NUM>] network <IP-ADDR/MASK-LENGTH>
 [position <NUM>]]
Description

Net-destination is a list of hosts, networks, or subnets that are used to configure an ACL rule.

Parameters

host

Configures a single IPv4 host.

network

An IPv4 subnet consisting of an IP address and netmask.

no

Removes any configured item in list or an entire net-destination.

position

Specifies the position of a host, network, or range in the net-destination. This optional parameter is specific to
a net-destination and may only be used to sort entries in a list.
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show net-destination
Syntax
show net-destination <NAME-STR>
Description

Show a host-specific net-destination.
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Networking Websites
Hewlett Packard Enterprise Networking Information Library

www.hpe.com/networking/resourcefinder

Hewlett Packard Enterprise Networking Software

www.hpe.com/networking/software

Hewlett Packard Enterprise Networking website

www.hpe.com/info/networking

Hewlett Packard Enterprise My Networking website

www.hpe.com/networking/support

Hewlett Packard Enterprise My Networking Portal

www.hpe.com/networking/mynetworking

Hewlett Packard Enterprise Networking Warranty

www.hpe.com/networking/warranty

General websites
Hewlett Packard Enterprise Information Library

www.hpe.com/info/EIL

For additional websites, see Support and other resources.

Chapter 27
Websites
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Accessing Hewlett Packard Enterprise Support
• For live assistance, go to the Contact Hewlett Packard Enterprise Worldwide website:

http://www.hpe.com/assistance

• To access documentation and support services, go to the Hewlett Packard Enterprise Support Center website:

http://www.hpe.com/support/hpesc

Information to collect

• Technical support registration number (if applicable)

• Product name, model or version, and serial number

• Operating system name and version

• Firmware version

• Error messages

• Product-specific reports and logs

• Add-on products or components

• Third-party products or components

Accessing updates
• Some software products provide a mechanism for accessing software updates through the product interface.

Review your product documentation to identify the recommended software update method.

• To download product updates:

Hewlett Packard Enterprise Support Center
www.hpe.com/support/hpesc

Hewlett Packard Enterprise Support Center: Software downloads
www.hpe.com/support/downloads

Software Depot
www.hpe.com/support/softwaredepot

• To subscribe to eNewsletters and alerts:

www.hpe.com/support/e-updates

• To view and update your entitlements, and to link your contracts and warranties with your profile, go to the
Hewlett Packard Enterprise Support Center More Information on Access to Support Materials page:

Chapter 28
Support and other resources
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www.hpe.com/support/AccessToSupportMaterials

Access to some updates might require product entitlement when accessed through the Hewlett
Packard Enterprise Support Center. You must have an HPE Passport set up with relevant
entitlements.

Customer self repair
Hewlett Packard Enterprise customer self repair (CSR) programs allow you to repair your product. If a CSR part
needs to be replaced, it will be shipped directly to you so that you can install it at your convenience. Some parts
do not qualify for CSR. Your Hewlett Packard Enterprise authorized service provider will determine whether a
repair can be accomplished by CSR.

For more information about CSR, contact your local service provider or go to the CSR website:

http://www.hpe.com/support/selfrepair

Remote support
Remote support is available with supported devices as part of your warranty or contractual support agreement. It
provides intelligent event diagnosis, and automatic, secure submission of hardware event notifications to Hewlett
Packard Enterprise, which will initiate a fast and accurate resolution based on your product's service level.
Hewlett Packard Enterprise strongly recommends that you register your device for remote support.

If your product includes additional remote support details, use search to locate that information.

Remote support and Proactive Care information
HPE Get Connected

www.hpe.com/services/getconnected
HPE Proactive Care services

www.hpe.com/services/proactivecare
HPE Proactive Care service: Supported products list

www.hpe.com/services/proactivecaresupportedproducts
HPE Proactive Care advanced service: Supported products list

www.hpe.com/services/proactivecareadvancedsupportedproducts

Proactive Care customer information
Proactive Care central

www.hpe.com/services/proactivecarecentral
Proactive Care service activation

www.hpe.com/services/proactivecarecentralgetstarted

Warranty information
To view the warranty for your product or to view the Safety and Compliance Information for Server, Storage,
Power, Networking, and Rack Products reference document, go to the Enterprise Safety and Compliance website:

www.hpe.com/support/Safety-Compliance-EnterpriseProducts

Additional warranty information
HPE ProLiant and x86 Servers and Options

www.hpe.com/support/ProLiantServers-Warranties
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HPE Enterprise Servers
www.hpe.com/support/EnterpriseServers-Warranties

HPE Storage Products
www.hpe.com/support/Storage-Warranties

HPE Networking Products
www.hpe.com/support/Networking-Warranties

Regulatory information
To view the regulatory information for your product, view the Safety and Compliance Information for Server,
Storage, Power, Networking, and Rack Products, available at the Hewlett Packard Enterprise Support Center:

www.hpe.com/support/Safety-Compliance-EnterpriseProducts

Additional regulatory information

Hewlett Packard Enterprise is committed to providing our customers with information about the chemical
substances in our products as needed to comply with legal requirements such as REACH (Regulation EC No
1907/2006 of the European Parliament and the Council). A chemical information report for this product can be
found at:

www.hpe.com/info/reach

For Hewlett Packard Enterprise product environmental and safety information and compliance data, including
RoHS and REACH, see:

www.hpe.com/info/ecodata

For Hewlett Packard Enterprise environmental information, including company programs, product recycling, and
energy efficiency, see:

www.hpe.com/info/environment

Documentation feedback
Hewlett Packard Enterprise is committed to providing documentation that meets your needs. To help us improve
the documentation, send any errors, suggestions, or comments to Documentation Feedback
(docsfeedback@hpe.com). When submitting your feedback, include the document title, part number, edition,
and publication date located on the front cover of the document. For online help content, include the product
name, product version, help edition, and publication date located on the legal notices page.
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Remote Device Deployment (TR-069)

Introduction
TR-069 is a technical specification created by the Broadband Forum. The TR-069 protocol specifies client and
server requirements to manage devices across the Internet by using a client server architecture to provide
communication between the CPE (Customer Premises Equipment) and the ACS (Auto Configuration Server). A
protocol helps to manage complex networks where many devices such as modems, routers, gateways, VoIP
phones and mobile tablets compete for resources. TR-069 defines the CPE WAN Management Protocol (CWMP)
protocol necessary to remotely manage end-user devices. ACS provides automatic configuration for these
devices.

CWMP is automatically enabled. To conserve resources, reconfigure this setting using the cwmp
disable command.

TR-069 defines an auto-configuration architecture which provides the following primary capabilities:

• Auto-configuration and dynamic service provisioning

• Software/firmware image management

• Status and performance monitoring

• Diagnostics

• Bidirectional SOAP/HTTP based protocol

Appendix A
Remote Device Deployment (TR-069)
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Advantages of TR-069

• TR-069 can manage devices with dynamic IP addresses.

TR-069 use Organization Unique ID (OUI) and serial number rather than IP to identify a device.

• TR-069 can manage devices in a private network.

The HPE ACS BIMS (an iMC module) uses HTTP to communicate with the device, and the session is initiated
by the device, so BIMS can pass through NAT to manage the device.

• TR-069 is secure.

TR-069 can use HTTPS to communicate with or transfer files to/from the device; it is more secure than TFTP,
FTP or Telnet.

• TR-069 is suitable for WAN management across internet.

• TR-069 is suitable for zero-touch configuration.

The zero-configuration mechanism is defined in the TR-069 specification.

• TR-069 is suitable for large-scale device management.

TR-069 support distributed architecture. The ACS can be distributed to multiple servers, each ACS can
manage part of devices.
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Zero-touch configuration process
Auto configuration or “zero-touch” deployment is a recurring customer requirement, especially for remote-office
deployments. New devices introduced inside a private network require management tools be co-located to
configure them or update firmware, or require manual intervention to do configuration. TR-069 allows managing
devices that reside in a private network via HTTP(S), enabling a new set of deployment and management models
today, not possible using SNMP.

The client side, when configured, will contact the server at a predefined URL, using HTTP or HTTPS as protocol.
After authentication, the ACS is able to perform the following basic operations:

• Update CPE Configuration.

• Update CPE TR-069 parameters.

• Update CPE firmware.

• Reboot CPE (backup, startup, and running configurations)

• Run CPE ping diagnostics.

• Reset CPE to factory default.

• Get periodic Status (several parameters can be retrieved depending on what is supported).

Since TR-069 uses HTTP, it can be used across a WAN. If the CPE can reach the URL, it can be managed.
TR-069 is mostly a push protocol where the client periodically sends information without server requests. This
allows for greater scalability over traditional SNMP based tools, which are also bounded to work within the LAN,
while TR-069 can offer management to remote offices.
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Zero-touch configuration for Campus networks

In this example, the following steps to configure CPEs for a Campus Network environment.

1. Pre-configuration for all CPEs in BIMS.

2. CPEs get BIMS parameters from DHCP server.

3. CPEs initiate a connection to BIMS, then BIMS deploys the pre-configuration to CPEs.
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Zero-touch configuration for Branch networks

In this example, the following steps to configure CPEs for a Branch network environment.

1. Create the basic configuration for your spoke device manually, using the username/password from ISP and
BIMS URL.

2. The IPSec VPN configuration is generated by IVM and deployed by BIMS.

3. The IPSec VPN tunnel is automatically created.

4. The device in the branch private network can DHCP relay to HQ to continue the zero touch configuration.
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Zero-touch configuration setup and execution
1. DHCP configuration

2. BIMS configuration

3. Execution

CLI commands

Configuration setup
Within the configure mode:

Syntax:

cwmp
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acs

Configure Auto Configuration Server (ACS) access.

cpe

Configure Customer Premises Equipment (CPE) access.

disable

Disable the CPE WAN Management Protocol.

CWMP is automatically enabled. To conserve resources, reconfigure this setting using the cwmp
disable command.

enable

Enable the CPE WAN Management Protocol.

Syntax:

[no] cwmp
acs

Configure Auto Configuration Server (ACS) access.

cpe

Configure Customer Premises Equipment (CPE) access.

enable

Enable the CPE WAN Management Protocol.

ACS password configuration
Syntax:

cwmp acs
password

Configure the password used for authentication when the switch connects to the ACS.

url

Configure the URL of the ACS.

username

Configure the username used for authentication when the switch connects to the ACS.

When encrypt-credentials is off
Syntax:

cwmp acs password
plaintext

Configure the password used for authentication when the switch connects to the ACS.
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When encrypt-credentials is on
Syntax:

cwmp acs password
encrypted-key

An encrypted password generated with the encrypt-credentials command.

plaintext

Configure the password used for authentication when the switch connects to the ACS.

Encrypt-credential on

cwmp acs password encrypted-key
ASCII-STR

Enter an ASCII string (maximum length: 384 characters).

Plaintext password

cwmp acs password plaintext
PASSWORD-STR

A plaintext password used for ACS authentication (maximum length: 256 characters).

ACS URL configuration
Syntax:

cwmp acs url
URL-STR

The URL of the ACS (maximum length: 256 characters).

ACS username configuration
Syntax:

cwmp acs username
USERNAME-STR

A username for ACS authentication (maximum length: 256 characters).

CPE configuration
Syntax:

cwmp cpe
password

Configure the password used for authentication when the ACS connects to the switch.
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username

Configure the username used for authentication when the ACS connects to the switch.

CPE password configuration

When encrypt-credentials is on
Syntax:

cwmp cpe password
encrypted-key

An encrypted password generated with the 'encrypt-credentials' command.

plaintext

Configure the password used for authentication when the ACS connects to the switch.

Syntax:

cwmp cpe password encrypted-key
ASCII-STR

Enter an ASCII string (maximum length: 384 characters).

When encrypt-credentials is off
Syntax:

cwmp cpe [password]
plaintext

Configure the password used for authentication when the ACS connects to the switch

Syntax:

cwmp cpe
PASSWORD-STR

A plaintext password used for ACS authentication (maximum length: 256 characters).

CPE username configuration
Syntax:

cwmp cpe [username]
USERNAME-STR

A username for ACS authentication (maximum length: 256 characters).
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Enable/disable CWMP
Syntax:

cwmp [enable|disable]

Show commands

CWMP configuration and status query
Syntax:

show cwmp
configuration

Show current CWMP configuration.

status

Show current CWMP status.

When CWMP is enabled
Syntax:

show cwmp configuration

CWMP configuration

CWMP Configuration
CWMP Status          : Enabled
ACS URL              : http://16.93.62.32:9090
ACS Username         : bims
Inform Enable Status : Enabled
Inform Interval      : 60
Inform Time          : 2014-04-08T06:00:00
Reconnection Timeout : 30

CWMP status

CWMP Status
CWMP Status              : Enabled
ACS URL                  : http://16.93.62.32:9090
ACS URL Origin           : Config
ACS Username             : bims
Connection Status        : Disconnected
Data Transfer Status     : None
Last ACS Connection Time : Wed Apr  9 16:56:00 2014
Time to Next Connection  : 00:00:36

When CWMP is disabled
Syntax:

show cwmp status
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CWMP status

CWMP Status
CWMP Status              : Disabled

CWMP configuration

show cwmp configuration
CWMP Configuration
CWMP Status          : Disabled

Event logging
The TR-069 client offers some tools to diagnose problems:

• System logging

• Status/control commands

System logging
The CPE implements the following system log notification codes and sample messages:

• RMON_TR69_INFORM_COMPLETE

◦ INFORM to http://15.29.20.50:9090/ from (IP address not set yet) completed with error.

◦ INFORM to http://15.29.20.50:9090/ from 10.0.10.212 completed with error.

◦ INFORM to http://15.29.20.50:9090/ from 10.0.10.212 completed successfully.

• RMON_TR69_AUTH_FAILED

◦ Authentication on ACS http://15.29.20.50:9090/ failed.

• RMON_TR69_CONN_FAILED

◦ Connection attempts with ACS http://15.29.20.50:9090/ from 10.0.10.212 failed.

To avoid flooding the system log on frequent attempts to connect with the ACS, the following criteria are used with
both successful and failed attempts:

1. The very first event is always logged.

2. Any change from success to failure or vice versa is always logged.

3. Repeat success or failure events are logged only once every five minutes.

The HTTP file transfer component supports these system log notification codes and sample messages:

• RMON_HTTP_XFER_COMPLETE
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◦ I 11/19/13 08:06:13 04185 http: Download of http://10.0.11.240:9876/path to DestinationFile completed
successfully.

◦ I 11/19/13 08:06:13 04185 http: Upload of SourceFile to http://10.0.11.240:9876/path completed
successfully.

• RMON_HTTP_CONN_FAILED

◦ W 11/19/13 08:06:13 04186 http: Connection to http://10.0.11.240:9876/path failed.

• RMON_HTTP_TIMED_OUT

◦ W 11/19/13 08:06:13 04192 http: Download of http://10.0.11.240:9876/path to DestinationFile timed out.

◦ W 02/20/14 00:32:17 04192 http: Upload of SourceFile to http://10.0.11.240:9876/path timed out.

• RMON_HTTP_NO_SPACE

◦ W 11/19/13 08:06:13 04189 http: Upload of SourceFile to http://10.0.11.240:9876/path canceled because of
insufficient memory.

• RMON_HTTP_REQ_FAILED

◦ W 11/19/13 08:06:13 04190 http: Upload of SourceFile to http://10.0.11.240:9876/path failed (errno 13).

◦ W 11/19/13 08:06:13 04190 http: Upload of SourceFile to http://10.0.11.240:9876/path failed (errno 1).

◦ W 11/19/13 08:06:13 04190 http: Download of http://10.0.11.240:9876/path to DestinationFile failed (errno
13).

◦ W 11/19/13 08:06:13 04190 http: Download of http://10.0.11.240:9876/path to DestinationFile failed (errno
1).

◦ W 11/19/13 08:06:13 04190 http: Download of http://10.0.11.240:9876/path to DestinationFile failed (errno
17).

• RMON_HTTP_WRONG_FILE

◦ W 11/19/13 08:06:13 04191 http: Download canceled because file http://10.0.11.240:9876/path is
malformed or incompatible.

◦ W 11/19/13 08:06:13 04191 http: Download canceled because file http://10.0.11.240:9876/path is
malformed or incompatible.

• RMON_HTTP_FILE_NOT_FOUND

◦ W 11/19/13 08:06:13 04200 http: Upload of SourceFile to http://10.0.11.240:9876/path canceled because of
inexistent file.

Status/control commands
The following commands help assess the general state of TR–069 and control the source of the ACS
configuration record:
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Table 30: Status/control commands

Command Result

show cwmp status
CWMP is Enabled  ACS URL           : https://16.93.62.32:9443
ACS URL is set by                  : Config
ACS Username                       : bims
Connection status                  : Disconnected
Data transfer status               : None
Time of last successful connection : Thu Feb 20 01:16:59 2014
Interval upon to next connection   : Null

show cwmp
configuration CWMP is Enabled  ACS URL          : https://16.93.62.32:9443

ACS Username                      : bims 
Inform Enable Status              : Disabled
Inform Interval                   : 3559 
Inform Time                       :  
Reconnection times                : 30

[no] dhcp tr69-
acs-url Prevents using any ACS information from DHCP
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Configuration backup and restore without
reboot

Beginning with switch software release 16.05, the configuration backup and restore without reboot supports the
following features:

Interface Access (Telnet, Console/Serial, web) Port Shutdown with Broadcast Storm

Access Control Lists (ACLs) Source-Port Filters

AAA Authentication TACACS+ Authentication

CoS (Class of Service) Time Protocols (TimeP, SNTP)

Network Management Applications (SNMP) Uni-directional Link Detection (UDLD)

Port Configuration Virus Throttling (Connection-Rate Filtering)

Port Security Web-based Authentication

Port-Based Access Control (802.1X) Backplane stacking

Quality of Service (QoS) Job Scheduler

Spanning Tree (STP, RSTP, MSTP, RPVST+) Authorized IP Managers

VLANs Authorized Manager List (Web, SSH, TFTP)

802.1Q VLAN Tagging Auto MDIX Configuration

802.1X Port-Based Priority DHCP Configuration

802.1X Multiple Authenticated Clients Per Port Flow Control (802.3x)

IGMP Friendly Port Names

LACP/Trunk Guaranteed Minimum Bandwidth (GMB)

MAC Lockdown IP Addressing

MAC-based Authentication IP Routing

MAC Lockout Jumbo Packets

LMA LLDP

Multicast Filtering LLDP-MED

Power over Ethernet (PoE and PoE+) Loop Protection

Protocol Filters MAC Address Management

RADIUS Authentication and Accounting Management VLAN

RADIUS-Based Configuration Passwords and Password Clear Protection/include-
credentials

Table Continued

Appendix B
Configuration backup and restore without reboot
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Encrypted-password QoS: Strict-Priority Queuing

Port Monitoring QoS: Turn on/off VLAN Precedence

Port Status QoS: Egress Queue Rate-limiting

Rate-Limiting CDP

Syslog System Parameters (hostname, Banner)

System Information Front-panel-security

Telnet Access DLDP

Traffic/Security Filters OOBM

VLAN Mirroring (1 static VLAN)/Port mirroring Switch interconnect

Voice VLAN Airwave Controller IP configuration

Web Authentication RADIUS Support Aruba Central integration

Web UI Captive portal commands

Log IP address of an ACL match Consolidated Client View

access-list logtimer IPsec for Zero Touch Provisioning

UFD: Uplink Failure Detection Local User roles

Wake-on-LAN for a Specific VLAN Port QoS Trust Mode

WebUI Inactivity Timer Per-port Tunneled node

Control Plane Protection Zero-touch provisioning - DHCP, Activate

Egress ACLs CPPM support

Device profile - switch auto configuration HTTP redirection/Captive portal

Device profile: Auto configuration with Aruba AP
detection

Device profile: LLDP Authentication Bypass with AP

Tunneled Node enhancement: fallback to switching RADIUS Port Speed VSA

Rogue AP isolation Dynamic ARP Protection

DHCP Option 82 Dynamic IP Lockdown

DHCP snooping Eavesdrop Protection

Distributed Trunking GVRP

RMON 1,2,3,9 Private VLANs

SavePower Features IP SLA

sFlow sys-debug acl

VxLAN MAC Based VLANs (MBV)

Smartlink RBAC: Role Based Access Control

Fault Finder extended to cover Flapping Transceiver
Mitigation

RADIUS Service Tracking

Fault Finder (Per Port Enable) sys-debug destination

SNMP Trap Throttling Protocol VLANS
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Glossary
Acronym Definition

ACL Access Control List

AMP AirWave Management Platform

AP Access Point

BYOD Bring Your Own Device

BPS Backplane Stacking

CoA Change of Authorization

CLI Command Line Interface

CPPM ClearPass Policy Manager

DHCP Dynamic Host Configuration Protocol

DoS Denial-of-Service

EWA Enhanced Web Authentication

IP Internet Protocol

HA High Availability

HMAC-SHA1 Hash-based Message Authentication Code used with
the SHA-1 cryptographic hash function.

HTTP Hypertext Transfer Protocol

HTTPS Secure Hypertext Transfer Protocol

ID Identifier

IP Internet Protocol

Table Continued

Appendix C
Glossary
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Acronym Definition

L3 The third, or routing, layer of the open systems
interconnection (OSI) model. The network layer routes
data to different LANs and Wide Area Networks
(WANs) based on network addresses.

LAN Local Area Network

MAC Media Access Control

MAFR MAC Authentication Failure Redirect

MAS Management Interface Specification

NMS Network Management System

PVOS ArubaOS-Switch Operating System

RADIUS Remote Authentication Dial In User Service

SNMP Simple Network Management Protocol

VLAN Virtual Local Area Network

VSA Vendor Specific Attribute

VSF Virtual Switching Framework

ZTP Zero Touch Provisioning
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Resumo da garantia e suporte do produto da HPE Networking
 
(outubro de 

2018) 
 

A versão mais atual deste documento está disponível em www.hpe.com/networking/warrantysummary 
Detalhes da política de garantia do produto de rede da HPE estão disponíveis em www.hpe.com/networking/warranty 

Informações sobre os serviços para produtos HPE Networking podem ser encontradas em www.hpe.com/networking/services  
 As informações contidas neste documento estão sujeitas a alterações sem aviso prévio. As garantias para produtos e serviços da HPE são as estabelecidas nas 

declarações de garantia expressa que acompanham tais produtos e serviços. Além disso, nossos produtos já vêm com garantias que não podem ser excluídas sob as leis 
do consumidor da Austrália e Nova Zelândia. Sujeitas às informações anteriores, nenhuma informação aqui descrita deve ser interpretada como parte de uma garantia 

adicional. A HPE não se responsabiliza por erros técnicos ou editoriais ou omissões contidos neste documento. 

 
 

 

 

Produtos 
Duração da 

garantia
1
 

Substituição de 
hardware

2
 

Suporte técnico 
em horário 
comercial

3
 

Suporte técnico 24h 
por dia, 7 dias por 

semana
3
 

(Após 1º de dezembro de 2015) 

Versões de 
software/sistem
a operacional

4
 

S
w

it
c
h

e
s

 

Modular      

 129xx, 125xx, 119xx 1 ano 10 dias 1 ano N/A Desde que sejam 
de propriedade4 

 105xx, 75xx 1 ano 10 dias 1 ano 90 dias Desde que sejam 
de propriedade4 

 84xx, 83xx 5 anos 10 dias 90 dias N/A 5 anos4 

 82xxzl, 54xxzl/R, 42xxvl 
Vida útil

5
 Envio no PDU 

Desde que sejam de 
propriedade5 

90 dias 
Desde que sejam 
de propriedade4 

Configuração fixa      

 79xx, 59xx/AF, 583x/AF, 582x/AF, 57xx 1 ano 10 dias 1 ano N/A Desde que sejam 
de propriedade4 

 Switches Altoline 9xxx, 6xxx (adquiridos após 31 de março de 

2016) 
1 ano 10 dias 1 ano N/A N/A 

 Switches Arista (Consulte 

http://www.arista.com/assets/data/pdf/Warranty.pdf para obter 
detalhes) 

1 ano15 10 dias15 1 ano15 N/A N/A 

 580x/AF 
Vida útil

5
 Envio no PDU 

Desde que sejam de 
propriedade5 

N/A 
Desde que sejam 
de propriedade4 

 55xx, 513x, 512x, 38xx, 36xx, 35xx/yl, 31xx, 29xx/al, 281x, 
26xx, 25xx/G 

Vida útil
5
 Envio no PDU 

Desde que sejam de 
propriedade5 

90 dias 
Desde que sejam 
de propriedade4 

Gerenciamento Inteligente       

 195x, 192x, 191x, 18xx, 17xx, 1620 (Adquiridos após 1º de 

outubro de 2017) 
Vida útil

14 
 Envio no PDU 

90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia14 

90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia14 

Desde que sejam 
de propriedade4 

Não gerenciado       

 1420, 1410 (Adquiridos após 1º de outubro de 2017) 

Vida útil
14 

 Envio no PDU 

90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia 14 

90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia 14 

N/A 

 1405 (Adquiridos após 1º de outubro de 2017) 3 anos
14

 Envio no PDU 90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia

 14
 

90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia

14
 

N/A 

L
A

N
 s

e
m

 f
io

 

Pontos de acesso internos      

 Pontos de acesso gerenciados por controlador (APs) Aruba 
Vida útil

10
 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A 90 dias (somente 

para correção de bug) 

 3WN/P, 155/P, pontos de acesso remoto Aruba 108/109 
(RAPs)  Vida útil

10
 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A 

Imagem 
atualizada 

periodicamente
13

 

 Pontos de acesso instantâneo Aruba (IAPs) 
Vida útil

10
 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A 

Imagem 
atualizada 

periodicamente
13

 

 M330, M2xx 
Vida útil

5
 Envio no PDU 

Desde que sejam de 
propriedade5 

90 dias 
Desde que sejam 
de propriedade4 

 Ponto de Acesso OfficeConnect 20 

3 anos
14

 Envio no PDU 

90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia

14
 

90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia

14
 

Desde que sejam 
de propriedade4 

Controladores      

 Controladores Aruba
 

1 ano 
30 dias 

PDU/Devolução 
à fábrica

11
 

90 dias
12

 N/A N/A 

 Switches de acesso a mobilidade Aruba 
Vida útil

10
 Envio no PDU 90 dias 90 dias 

Desde que sejam 
de propriedade4 

Outros produtos de WLAN       

 Pontos de acesso externos Gerenciados pelo Controlador 
Aruba Série 2xx Vida útil

10
 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A 90 dias (somente 

para correção de bug) 

 Pontos de acesso instantâneo externos Aruba Série 2xx 
(IAPs) Vida útil

10
 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A 

Imagem 
atualizada 

periodicamente
13

 

 Dispositivos AirWave, Dispositivos ClearPass, Dispositivos 
IntroSpect 1 ano 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias

12
 

N/A 
90 dias (somente 

para correção de bug) 

 Roteadores de malha sem fio para ambiente externo 
MST2HP, MST2HAC, MSR2KP, MSR4KP Aruba 1 ano 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias

12
 N/A 90 dias (somente 

para correção de bug) 

 Beacons Aruba 
90 dias 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A 90 dias (somente 

para correção de bug) 

 Sensores de capa 
90 dias 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A 90 dias (somente 

para correção de bug) 

 Fontes de alimentação, antenas e acessórios Aruba 
1 ano 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A N/A 
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Resumo da garantia e suporte do produto da HPE Networking
 
(outubro de 

2018) 
 

A versão mais atual deste documento está disponível em www.hpe.com/networking/warrantysummary 
Detalhes da política de garantia do produto de rede da HPE estão disponíveis em www.hpe.com/networking/warranty 

Informações sobre os serviços para produtos HPE Networking podem ser encontradas em www.hpe.com/networking/services  
 As informações contidas neste documento estão sujeitas a alterações sem aviso prévio. As garantias para produtos e serviços da HPE são as estabelecidas nas 

declarações de garantia expressa que acompanham tais produtos e serviços. Além disso, nossos produtos já vêm com garantias que não podem ser excluídas sob as leis 
do consumidor da Austrália e Nova Zelândia. Sujeitas às informações anteriores, nenhuma informação aqui descrita deve ser interpretada como parte de uma garantia 

adicional. A HPE não se responsabiliza por erros técnicos ou editoriais ou omissões contidos neste documento. 

 
 

 

 

R
o

te
a
d

o
re
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Roteadores      

 
88xx, HSR68xx 1 ano 10 dias 1 ano 

N/A Desde que sejam de 
propriedade4 

 
HSR66xx, 66xx, MSR50, MSR4xxx, MSR3xxx, MSR30 1 ano 10 dias 1 ano 

90 dias Desde que sejam de 
propriedade4 

 
MSR2xxx, MSR20, MSR1xxx, MSR9xx 1 ano Envio no PDU 1 ano 

90 dias Desde que sejam de 
propriedade4 

 ALU 77xx 
1 ano

9
 

Devolução para 
a fábrica

9
 

1 ano
9
 N/A 

Todas as 
atualizações de 

licença adquiridas9 

 Roteadores VSR  
90 dias 

(Somente mídia) 
N/A 90 dias N/A 

Todas as 
atualizações de 

licença adquiridas8 

G
e

re
n

c
ia

m
e

n
to

 

Gerenciamento de rede      

 Centro de gerenciamento inteligente (detalhes do suporte em 

www.hpe.com/networking/IMCSupport) 
90 dias 

 (Somente mídia) 
N/A 90 dias N/A 90 dias (somente para 

correção de bug) 

 AirWave, ALE, Aruba Central, ClearPass, Meridian, VIA, Visual RF 90 dias 
 (Somente mídia) 

N/A 90 dias N/A 90 dias (somente para 

correção de bug) 

 Controlador HPE VAN SDN e aplicativos HPE SDN 90 dias 
 (Somente mídia) 

N/A 90 dias N/A Todas as 
atualizações de 

licença adquiridas8
 

 Rede em nuvem distribuída HPE  90 dias 
 (Somente mídia) 

N/A N/A N/A Nenhum 

 Dispositivos controladores da Big Switch Networks (Consulte 

www.bigswitch.com/support para detalhes sobre garantia e suporte) 
N/D

16
 N/D

16
 N/D

16
 N/D

16
 N/D

16
 

P
ro

d
u

to
s
 d

e
 r

e
d

e
 a

d
ic

io
n

a
is

 

Transceptores      

 Transceptores Aruba (Números dos produtos transceptores JWxxxx para 
Controladores e Switches MAS) 1 ano  

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A N/A 

 Transceptores da marca Aruba (exceto os números dos produtos 
transceptores JWxxxx) 
 e 
HPE X244, X242, X142, X132, X131, X129, X122, X121, X119, X112, X111 

Vida útil
5
 Envio no PDU Desde que 

sejam de 
propriedade5 

N/A N/A 

 Transceptores Aruba 100G 1 ano 10 dias 1 ano N/A N/A 

 HPE X2A0, X240, X190, X180, X170, X160, X150, X140, X135, X130, 
X125, X124, X120, X115, X114, X110 

1 ano 30 dias 1 ano N/A N/A 

 

1) Fontes de alimentação, módulos e acessórios removíveis, como antenas, ventiladores, cabos 
de alimentação, etc., podem ter cobertura de garantia diferente do dispositivo de host. 
Consulte a referência rápida de cobertura de garantia do HPE Networking em 
www.hpe.com/networking/warrantyquickref para obter mais detalhes.  

2) O tempo de resposta baseia-se em um esforço comercialmente razoável e está sujeito a um 
tempo de corte de envio diário. Em alguns países e regiões e de acordo com determinadas 
restrições do fornecedor o tempo de resposta pode variar. Entre em contato com a sua 
organização de serviço HPE local para obter a disponibilidade de tempo de resposta em sua 
área. Envio PDU = Envio no próximo dia útil. 

3) O suporte técnico da garantia por telefone ou meio eletrônico é fornecido durante o horário 
comercial da HPE local para todo o período de garantia para os fins de diagnóstico de 
defeitos de hardware ou software. Muitos produtos adquiridos após 1º de dezembro de 2015 
incluem 90 dias de suporte técnico 24 horas por dia, 7 dias por semana, conforme indicado. 
Consulte a declaração de garantia limitada Hewlett-Packard do produto para obter detalhes 
adicionais da cobertura. Serviços de cobertura estendida estão disponíveis. 

4) Inclui todas as versões de software/OS geralmente disponíveis oferecidas para os produtos 
específicos listados, quando e se disponíveis, enquanto o cliente possuir o produto, exceto 
onde observado. Algumas versões do software podem exigir hardware adicional ou novo. 
Clientes que desejem que atualizações, correções e ajustes de recurso específicos sejam 
priorizados em versões futuras, devem adquirir os serviços de suporte apropriados da HPE. 

5) Para os produtos adquiridos após 1º de dezembro de 2014, a garantia se estende somente 
enquanto o usuário final original possuir o produto. Inclui a cobertura de qualquer ventilador e 
fonte de alimentação incorporados por todo o período de garantia. Um comprovante de 
aquisição ou de arrendamento pode ser exigido como condição para que exista direito ao 
serviço de garantia.  

6) Garantia de hardware, suporte técnico e todas as versões de software fornecidas para 
hardware e apenas UM OS de serviço, quando e se disponíveis, enquanto o usuário final 
original possuir o produto. Consulte documentação específica do produto para suporte ao 
aplicativo. 5 anos de garantia na unidade de disco nos módulos de zl de serviços avançados 
HPE Alliance One. 

7) Produtos comprados antes de 1º de agosto de 2013 incluem 1 ano de suporte técnico e 1 
ano (somente correção de bugs).  

8) Inclui todas as atualizações de software oferecidas para a versão licenciada, quando e se 
disponível. Atualizações de software vão requerer a compra de SKU, pacote de serviços de 
suporte ou contrato apropriado. 

9) Todo o suporte técnico, de hardware e de software para produtos de ALU 77xx é fornecido 
diretamente somente pela Alcatel-Lucent e não pela HPE. Para suporte da Alcatel-Lucent, 
selecione o país do qual o cliente está ligando no link a seguir e ele mostrará as informações 
de contato de suporte da ALU apropriadas: https://Services.support.Alcatel-
Lucent.com/product_support/. A garantia de hardware requer o envio de produtos com falha 
para a ALU para o reparo ou reposição. O custo de logística para o envio de produto no local 
do cliente para o local da ALU para reparo ou reposição será coberto pelo cliente. Versões de 
manutenção de software estão incluídas para a principal versão do software adquirida. As 
principais atualizações de versão do software não estão incluídas. Serviços podem ser 
adquiridos na HPE ou na Alcatel-Lucent para expandir sua cobertura de suporte e upgrades 
de software. O suporte será fornecido pela Alcatel Lucent para esses serviços. 

10) Para os produtos adquiridos depois de 1º de dezembro de 2015, o hardware tem garantia 
estendida somente enquanto o usuário final original possuir o produto e está limitada a cinco 
(5) anos a partir da data de término da venda. 

11) Para os primeiros 30 dias a partir do envio, a HPE fornecerá a substituição 
antecipada de envio no mesmo dia para os produtos de hardware cobertos. Depois 
de trinta (30) dias a partir do envio e durante o período de garantia restante, a HPE 
substituirá ou reparará qualquer produto fora de conformidade e o devolverá em 
condição de operação, enviando após o recebimento da HPE do produto fora de 
conformidade por meio do procedimento RMA da HPE, com recebimento pelo 
cliente em até dez (10) dias em uma base comercialmente razoável. 

12) A HPE fornecerá uma resposta por e-mail no próximo dia útil com o propósito de 
diagnosticar defeitos de hardware ou software durante o horário comercial no 
Horário do Pacífico para os primeiros 90 dias após a compra.  

13) A HPE disponibilizará uma imagem de versão de software de OS instantânea 
recente no portal de software. Essa imagem também está disponível para pontos de 
acesso remoto (RAPs) que estejam executando o OS instantâneo. 

14) Esses produtos são cobertos por 90 dias de suporte telefônico 24x7. 
Posteriormente, apenas suporte por bate-papo estará disponível para o período 
restante da garantia. A garantia de vida útil limitada (quando aplicável) é estendida 
somente enquanto o usuário final original possuir o produto e está limitada a 5 
(cinco) anos a partir do final da data de venda.  Esta garantia inclui a cobertura de 
qualquer ventilador embutido e fonte de alimentação por todo o período de garantia. 
Um comprovante de aquisição ou de arrendamento pode ser exigido como condição 
para que exista direito ao serviço de garantia. Consulte 
www.hpe.com/OfficeConnect/support/ para mais informações sobre o novo 
processo de suporte do OfficeConnect.  

15) Todo o suporte técnico de hardware e de software para produtos Arista é fornecido 
diretamente pela Arista e não pela HPE. Consulte a página de suporte ao cliente da 
Arista para informações de contato: https://www.arista.com/en/support/customer-
support. Os custos de transporte, se houver, relacionados à devolução de um 
hardware defeituoso para um centro de reparos Arista será custeado pelo cliente. A 
Arista irá pagar quaisquer custos de transporte relacionados a uma nova entrega de 
um Hardware reparado ou substituído. Serviços podem ser adquiridos na HPE ou 
na Arista para expandir sua cobertura de suporte e upgrades de software. O suporte 
será fornecido pela Arista para esses serviços. Para obter detalhes sobre a garantia 
e suporte da Arista, consulte: http://www.arista.com/assets/data/pdf/Warranty.pdf. 

16) Todo o suporte técnico de hardware e de software para produtos Big Switch 
Networks é fornecido diretamente pela BSN e não pela HPE. Consulte a página de 
atendimento ao cliente da Big Switch Networks para informações de contato: 
www.bigswitch.com/support. Para detalhes sobre opções de garantia e suporte da 
Big Switch Networks, consulte: 
http://bigswitch.com/sites/default/files/bsn_support_and_maintenance_policy.v2.2.20
16.11.14.pdf. 
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Hewlett Packard Enterprise (HPE) is committed to compliance with all 
applicable laws and regulations, including material restriction 
requirements under the European Union Recast RoHS Directive, 
otherwise known as EU RoHS 2, applicable restrictions under Annex 
XVII of the EU REACH Regulation and China’s Management Methods 
for Restricted Use of Hazardous Substances in Electrical and 
Electronic Products, otherwise known as China RoHS 2.  
 
Hewlett Packard Enterprise believes that legislation, like the EU RoHS 
2 Directive, plays an important role in promoting industry-wide 
transition to restrict substances of concern. In general, the restriction 
of any substance should take into account the following key items:  
 
• Global harmonization of the legislation content and implementation 

requirements 
• Substance risk assessment, including a clear understanding of the 

environmental impacts of alternative substances 
• Clear identification of what substances (vs. broad classes or 

categories) are to be restricted 
• Clear identification of when alternative technologies are proven and 

readily available 
• Appropriate lead time to allow the industry to transition 
• Substances that are not used or found in final products should not 

be included in the restrictions 
• Material application exemptions should be allowed for the use of 

restricted substances in applications where current substitution is 
not technically feasible 

• Inclusion of maximum concentration values setting de minimis 
levels below which the relevant substances may be present 

 

Hewlett Packard Enterprise’s 
Compliance with Restriction of 
Hazardous Substances (RoHS) 
Legislation 
(rev 14.0 Oct 2016) 

 

Hewlett Packard Enterprise 

3000 Hanover Street 

Palo Alto, CA 94304 

www.hpe.com 
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Hewlett Packard Enterprise fully supports the restriction of the four 
substances incorporated into EU RoHS 2 by Commission Delegated 
Directive 2015/863/EU, specifically:  
 
• Diisobutyl Phthalate (DIBP) 
• Bis (2-ethylhexyl) phthalate (DEHP) 
• Butyl benzyl phthalate (BBP) 
• Dibutylphthalate (DBP) 
 
Hewlett Packard Enterprise believes other substances should be 
considered for inclusion in future RoHS legislation. This includes the 
restriction of polyvinyl chloride (PVC) and brominated flame retardants 
(BFRs) from electrical and electronic equipment (EEE). HPE believes 
PVC and BFRs should be the focus for the restriction of chlorine (Cl) 
and bromine (Br) from electrical and electronic equipment, where 
technically feasible. HPE’s reasons for focusing on PVC and BFRs 
are: 
 
• PVC and BFRs cover 99% of the uses for Cl and Br in electronics; 
• Given the high percentage usage, these substances have the 

highest impact; 
• Restriction of these substances where technically feasible would 

substantially accomplish the goal to eliminate Cl and Br from 
electronic products. 

 
By July 2007, all PVC and BFRs were restricted[1] from the external 
case plastics in HPE branded products. When technically feasible, we 
will continue to phase out other uses of brominated flame retardants 
(BFRs), polyvinyl chloride (PVC), and phthalates to meet market 
demands and customer expectations, taking into account product life 
cycles. 
 
Hewlett Packard Enterprise is taking a proactive approach to 
evaluating materials in its products to assess environmental, health or 
safety risks. HPE may restrict substances because of customer or 
legal requirements, or because HPE believes it is appropriate based 
on a precautionary approach. HPE strives to replace legally permitted 
materials when scientific data have established a potential health or 
environmental risk and lower-risk, commercially and technically viable 
alternatives are available. At HPE the evaluation of alternative 
materials is a continuous process.  
 
Our continued internal voluntary goal is to meet the substance 
restrictions of the EU RoHS legislation outside the EU (and EFTA) 
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within 6 months of each of the EU’s various legal compliance dates on 
a worldwide basis for virtually all Hewlett Packard Enterprise branded 
new products in scope of the Directive, except where it is widely 
recognized that there is no technically feasible alternative (as 
indicated by an exemption under the EU RoHS Directive).  
 
In early 2003, a company-wide RoHS team was formed to manage all 
aspects of Hewlett Packard Company’s global response to all the 
RoHS legislations around the world.  Since the separation of Hewlett 
Packard Company and the creation of Hewlett Packard Enterprise, 
HPE has continued this approach. HPE’s initiative to address the 
RoHS legislations is part of the company’s Design for Environment 
program, which includes using materials more efficiently, finding 
alternatives for designated materials, designing for energy efficiency, 
and designing products that can be easily recycled. 
 
Hewlett Packard Enterprise continues to plan for further “RoHS-like” 
legislation in other jurisdictions and will meet any additional 
requirements that arise. HPE complies with the requirements of all the 
RoHS legislations currently in effect (including those specifically listed 
under Compliance Status below). HPE’s Compliance Verification is 
based on our risk analysis of restricted substances entering the 
supply chain and includes technical documentation outlined in the 
European Union’s EN 50581:2012 standard. 
 
More detailed information can be found at 
www.hpe.com/info/environment 
Living Progress Report 

Design for environment 
Compliance Verification 
General Specifications for the Environment 
Eco Declarations 
 

 
Hewlett Packard Enterprise’s Compliance Status to EXISTING 
RoHS Legislation:  

 

European Union  

HPE products in-scope and put on the market in the EU and EFTA 
Member States comply with the requirements of EU RoHS Directive 
(2011/65/EU) including Commission Decisions withdrawing 
exemptions.  
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Serbia 
HPE products[2] comply with Serbia's WEEE and RoHS "Regulations 
on the List of Electrical and Electronic Products, Measures Banning 
and Restricting the Recovery of Electrical and Electronic Equipment 
Containing Hazardous Materials, and the Methods and Procedures for 
Managing Waste from Electrical and Electronic Products", which 
entered into force on January 4, 2011. RoHS restrictions apply to 
equipment placed on the market on or after July 1, 2011. 
 
Turkey 
HPE products[2] comply with Turkey’s “Regulation on the Restriction of 
the use of Certain Hazardous Substance in Electrical and Electronic 
Equipment”, otherwise known as Turkey RoHS which came into effect 
on March 30, 2009. 
 
Ukraine 
HPE products[2] comply with the substance restrictions in Ukraine’s 
“Technical Regulation on restrictions as to the use of some dangerous 
substances in electric and electronic devices”, otherwise known as 
Ukraine RoHS which came into effect on 1 January 2011. 
 
China 
HPE products[2] comply with China’s, “Management Methods for 
Restricted Use of Hazardous Substances in Electrical and Electronic 
Products”, otherwise known as China RoHS 2 which came into effect 
on July 1, 2016. 
 
India  
HPE products[2] comply with the material restrictions of India’s 
legislation “India E-waste (Management) Rules, 2016”, otherwise 
known as India RoHS, which came into effect on October 1, 2016 and 
will replace the E-Waste (Management and Handling) Rules, 2011. 
 
Japan  
Japan’s “The Marking of Presence of the Specific Chemical 
Substances for Electrical and Electronic Equipment” (JIS-C-0950), 
otherwise known as J-MOSS came into effect on July 1, 2006. At 
present, no HPE-brand products are in scope of J-MOSS.  
 

Korea  
In Korea, “The Act for Resource Recycling of Electrical/Electronic 
Products and Automobiles”, otherwise known as Korean RoHS came 
into effect on January 1, 2008. Korea’s RoHS 2 came into effect on 

Anexo 05 A 10 ITEM 10 (0592650)         SEI 0008478-63.2018.6.02.8000 / pg. 5542



 

 

  

January 1, 2013. At present, no HPE-brand products are in scope of 
Korea RoHS 2. 
 
Taiwan (BSMI) RoHS 
HPE products[2] will comply with Taiwan’s CNS 15663 standard, 
otherwise known as BSMI RoHS, which is a Guidance to reduce the 
restricted chemical substances used in electrical and electronic 
products. This standard was released on July 30, 2013 and applies to 
servers placed on the market on or after July 1, 2017 and other 
products placed on the market on or after January 1, 2018. 
 
Vietnam 
HPE products[2] comply with Vietnam’s legislation “Circular 
30/2011/TT-BCT: Temporarily regulating the permitted limits for a 
number of hazardous substances in electric and electronic products”, 
otherwise known as Vietnam RoHS which came into effect on 
December 1, 2012. You can find HPE’s Vietnam RoHS declarations 
at: http://www8.hp.com/us/en/hpe/hp-
information/livingprogress/environmentalprogress/msds-specs-
more.html 
 
California 
California’s, “Electronic Waste Recycling Act of 2003 (Senate Bill 20) 
substance restrictions”, otherwise known as California RoHS came 
into effect on January 1, 2007. At present, no HPE-brand products are 
in scope of California RoHS. 
 
New Jersey 
New Jersey’s “Electronic Waste Recycling Act” (Senate Bill 2144), 
otherwise known as New Jersey RoHS came into effect on 1 January 
2011. At present, no HPE-brand products are in scope of New Jersey 
RoHS. 
 
Worldwide  
HPE has an internal voluntary goal to meet the substance restrictions 
of the EU RoHS legislation outside the EU (and EFTA) within 6 
months of each of the EU’s various legal compliance dates on a 
worldwide basis for virtually all HPE branded new products in scope of 
the Directive, except where it is widely recognized that there is no 
technically feasible alternative (as indicated by an exemption under 
the EU RoHS Directive). 
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Notes:  
[1] See HPE’s General Specification for the Environment Identification 
Numbers: 041210-80 and 070905-88.  
[2] HPE products that are both in scope and put on the market in the given 
jurisdiction. 
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HPE Networking Product Warranty & Support Summary (October 2018)

The most current version of this document is available at www.hpe.com/networking/warrantysummary
HPE Networking product warranty policy details are available at www.hpe.com/networking/warranty

Information on services for HPE Networking products can be found at www.hpe.com/networking/services
The information contained herein is subject to change without notice.  Warranties for HPE products and services are set forth in the express warranty statements 

accompanying such products and services.   In addition, our goods come with guarantees that cannot be excluded under Australian and New Zealand consumer laws.  
Subject to the foregoing, nothing herein should be construed as constituting an additional warranty.  HPE shall not be liable for technical or editorial errors or omissions 

contained herein.

 

Products
Warranty 
duration1

Hardware 
replacement2

Business 
Hours 

Technical 
Support3

24x7
Technical 
Support3

(After Dec. 1, 2015)

Software/OS 
Releases4

S
w

it
c

h
e

s

Modular

129xx, 125xx, 119xx 1 year 10 days 1 year N/A As long as owned4

105xx, 75xx 1 year 10 days 1 year 90 days As long as owned4

84xx, 83xx 5 years 10 days 90 days N/A 5 years4

82xxzl, 54xxzl/R, 42xxvl
Lifetime5 NBD Ship

As long as 
owned5 90 days As long as owned4

Fixed-configuration

79xx, 59xx/AF, 583x/AF, 582x/AF, 57xx 1 year 10 days 1 year N/A As long as owned4

Altoline 9xxx, 6xxx Switches (Purchased after March 31, 2016) 1 year 10 days 1 year N/A N/A

Arista switches (See http://www.arista.com/assets/data/pdf/Warranty.pdf for details) 1 year15 10 days15 1 year15 N/A N/A

580x/AF
Lifetime5 NBD Ship

As long as 
owned5 N/A As long as owned4

55xx, 513x, 512x, 38xx, 36xx, 35xx/yl, 31xx, 29xx/al, 281x, 26xx, 25xx/G
Lifetime5 NBD Ship

As long as 
owned5 90 days As long as owned4

Smart Managed 

195x, 192x, 191x, 18xx, 1620 (Purchased after October 1, 2017)

Lifetime14 NBD Ship

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14

As long as owned4

Unmanaged 

1420, 1410 (Purchased after October 1, 2017)

Lifetime14 NBD Ship

90 days 
Phone 

support-Chat 
support entire 

warranty 
period 14

90 days 
Phone 

support-Chat 
support entire 

warranty 
period 14

N/A

1405 (Purchased after October 1, 2017) 3 years14 NBD Ship 90 days 
Phone 

support-Chat 
support entire 

warranty 
period 14

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14

N/A

W
ir

e
le

s
s
 L

A
N

Indoor Access Points

Aruba Controller-Managed Access Points (APs)
Lifetime10

30 day 
NBD/Return-to-

factory11

90 days N/A 90 days (bug fix only)

3WN/P, 155/P, 108/109 Aruba Remote Access points (RAPs) 
Lifetime10

30 day 
NBD/Return-to-

factory11

90 days N/A
Periodic updated 

image13

Aruba Instant Access Points (IAPs)
Lifetime10

30 day 
NBD/Return-to-

factory11

90 days N/A
Periodic updated 

image13

M330, M2xx
Lifetime5 NBD Ship

As long as 
owned5 90 days

As long as owned4

OfficeConnect 20 Access Point

3 years14 NBD Ship

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14

As long as owned4

Controllers

Aruba controllers
1 year

30 day 
NBD/Return-to-

factory11

90 days12 N/A N/A

Aruba Mobility Access Switches Lifetime10 NBD Ship 90 days 90 days As long as owned4

Other WLAN products 

Aruba Controller-Managed 2xx Series Outdoor Access Points
Lifetime10

30 day 
NBD/Return-to-

factory11

90 days N/A 90 days (bug fix only)

Aruba Instant 2xx Series Outdoor Access Points (IAPs)
Lifetime10

30 day 
NBD/Return-to-

factory11

90 days N/A
Periodic updated 

image13

AirWave Appliances, ClearPass Appliances, IntroSpect Appliances
1 year

30 day 
NBD/Return-to-

factory11

90 days12

N/A
90 days (bug fix only)

MST2HP, MST2HAC, MSR2KP, MSR4KP Aruba Outdoor Wireless Mesh 
Routers 1 year

30 day 
NBD/Return-to-

factory11

90 days12 N/A 90 days (bug fix only)

Aruba Beacons
90 days

30 day 
NBD/Return-to-

factory11

90 days N/A 90 days (bug fix only)

Cape Sensors
90 days

30 day 
NBD/Return-to-

factory11

90 days N/A 90 days (bug fix only)

Aruba Power Supplies, Antennae, Accessories
1 year

30 day 
NBD/Return-to-

factory11

90 days N/A N/A
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HPE Networking Product Warranty & Support Summary (October 2018)

The most current version of this document is available at www.hpe.com/networking/warrantysummary
HPE Networking product warranty policy details are available at www.hpe.com/networking/warranty

Information on services for HPE Networking products can be found at www.hpe.com/networking/services
The information contained herein is subject to change without notice.  Warranties for HPE products and services are set forth in the express warranty statements 

accompanying such products and services.   In addition, our goods come with guarantees that cannot be excluded under Australian and New Zealand consumer laws.  
Subject to the foregoing, nothing herein should be construed as constituting an additional warranty.  HPE shall not be liable for technical or editorial errors or omissions 

contained herein.

 

R
o

u
te

rs

Routers

88xx, HSR68xx 1 year 10 days 1 year N/A As long as owned4

HSR66xx, 66xx, MSR50, MSR4xxx, MSR3xxx, MSR30 1 year 10 days 1 year 90 days As long as owned4

MSR2xxx, MSR20, MSR1xxx, MSR9xx 1 year NBD Ship 1 year 90 days As long as owned4

ALU 77xx
1 year9 Return-to-

factory9 1 year9 N/A
All updates for 

purchased license9

VSR routers 90 days
(Media only)

N/A 90 days N/A
All updates for 

purchased license8

M
a

n
a

g
e

m
e
n

t

Network Management

Intelligent Management Center (support details at www.hpe.com/networking/IMCSupport) 90 days
(Media only)

N/A 90 days N/A 90 days (bug fix only)

AirWave, ALE, ArubaCentral, ClearPass, Meridian, VIA, Visual RF 90 days
(Media only)

N/A 90 days N/A 90 days (bug fix only)

HPE VAN SDN controller and HPE SDN applications 90 days
(Media only)

N/A 90 days N/A All updates for 
purchased license8

HPE Distributed Cloud Networking 90 days
(Media only)

N/A N/A N/A None

Big Switch Networks controller appliances (See www.bigswitch.com/support for 

warranty & support details)
N/A16 N/A16 N/A16 N/A16 N/A16

A
d

d
it

io
n

a
l 

N
e
tw

o
rk

in
g

 

P
ro

d
u

c
ts

Transceivers

Aruba Transceivers (Transceiver product numbers JWxxxx for Controllers 
and MAS Switches) 1 year 

30 day 
NBD/Return-to-

factory11

90 days N/A N/A

Aruba branded transceivers (except transceiver product numbers JWxxxx)
and

HPE X244, X242, X142, X132, X131, X129, X122, X121, X119, X112, X111

Lifetime5 NBD Ship As long as 
owned5

N/A N/A

Aruba 100G transceivers 1 year 10 days 1 year N/A N/A

HPE X2A0, X240, X190, X180, X170, X160, X150, X140, X135, X130, 
X125, X124, X120, X115, X114, X110

1 year 30 days 1 year N/A N/A

1) Removable power supplies, modules and accessories such as antennas, fans, power cords, 
etc. may have different warranty coverage than the host device.  See the HPE Networking 
Warranty Coverage Quick Reference at www.hpe.com/networking/warrantyquickref for more 
details. 

2) Response time is based on commercially reasonable effort and subject to a daily shipment 
cutoff time.  In some countries and regions and under certain supplier constraints, response 

time may vary.  Contact your local HPE service organization for response time availability in 
your area.  NBD Ship = Next Business Day shipment.

3) Warranty phone and electronic case technical support is provided during local HPE business 
hours for the entire warranty period for the purposes of diagnosing hardware or software 
defects.  Many products purchased after December 1, 2015 include 90 days of 24x7 technical 
support as noted.  See product’s Hewlett-Packard Limited Warranty Statement for additional 
coverage details.  Extended coverage services are available.

4) Includes all generally available software/OS releases offered for the specific products listed, 
when and if available, for as long as the customer owns the product, except where noted.  
Some software releases may require additional or new hardware.  Customers who desire 
specific feature updates, patches and fixes to be prioritized into future releases should 
purchase the appropriate support services from HPE.

5) For products purchased after December 1, 2014, the warranty extends only for as long as the 
original end user owns the product. Includes coverage of any built-in fans and power supplies 
for the entire warranty period. You may be required to provide proof of purchase or lease as a 
condition of receiving warranty service.  

6) Hardware warranty, technical support and all software releases provided for hardware and the 
ONE Service OS only, when and if available, for as long as the original end user owns the 
product.  See product specific documentation for application support.  5 year warranty on the 
disk drive in the HPE Alliance One Advanced Services zl Modules.

7) Products purchased before August 1, 2013 include 1 year of technical support and 1 year 
(bug fix only). 

8) Includes all software updates offered for the licensed version, when and if available.  Software 
upgrades will require purchase of appropriate SKU, packaged support services or contract.

9) All technical, hardware and software support for ALU 77xx products is provided directly by 
Alcatel-Lucent only and not HPE.  For support from Alcatel-Lucent, select the country from 
which the customer is calling in the following link and it will present the appropriate ALU 
support contact information: https://services.support.alcatel-lucent.com/product_support/.  
Hardware warranty requires shipping failed product to ALU for repair or replacement.  
Logistics cost for shipment of product from customer’s site to ALU site for repair or 
replacement will be covered by the customer.  Software maintenance releases are included 
for the major software release purchased.  Major software release upgrades are NOT 
included.  Services may be purchased from HPE or Alcatel-Lucent to extend your support 
coverage and software upgrades.  Support will be provided by Alcatel Lucent for these 
services.

10) For products purchased after December 1, 2015, the warranty extends only for as long as the 
original end user owns the product and is limited to five (5) years from the end of sale date.

11) For the first 30 days from shipment, HPE will provide same day ship advanced 
replacement for the covered hardware products.  After thirty (30) days from shipment 
through the remaining warranty period, HPE will replace or repair any non-compliant 
Product and return it in operable condition, shipping after HPE’s receipt of the non-
compliant Product via HPE’s RMA procedure, with receipt by customer within ten 
(10) days on a commercially reasonable basis.

12) HPE will provide next business day email response for the purposes of diagnosing 
hardware or software defects during standard Pacific Time Zone business hours for 
the first 90 days after purchase. 

13) HPE will make one recent Instant OS software release image available on the 
software portal.  This image is also available for Remote Access Points (RAPs) 
running Instant OS.

14) These products are covered by 90 days of 24x7 phone support.  Thereafter, only 
chat support would be available for the remaining warranty period.  Limited lifetime 
warranty (where applicable) extends only for as long as the original end user owns 
the product and is limited to five (5) years from the end of sale date. This warranty 
includes coverage of any built-in fans and power supplies for the entire warranty 
period. You may be required to provide proof of purchase or lease as a condition of 
receiving warranty service. See www.hpe.com/OfficeConnect/support/ for more 
information on the new OfficeConnect support process. 

15) All technical, hardware and software support for Arista products is provided directly 
by Arista and not HPE.   Consult the Arista customer support page for contact 
information: https://www.arista.com/en/support/customer-support.  Transportation 
costs, if any, incurred in connection with the return of a defective Hardware to an 
Arista repair center shall be borne by Customer. Arista shall pay any transportation 
costs incurred with the redelivery of a repaired or replaced Hardware. Services may 
be purchased from HPE or Arista to extend your support coverage and software 
upgrades.  Support will be provided by Arista for these services.  For details on 
Arista warranty and support, see: 
http://www.arista.com/assets/data/pdf/Warranty.pdf.

16) All technical, hardware and software support for Big Switch Networks products is 
provided directly by BSN and not HPE.  Consult the Big Switch Networks customer 
support page for contact information: www.bigswitch.com/support.  For details on 
Big Switch Networks warranty and support options, see: 
http://bigswitch.com/sites/default/files/bsn_support_and_maintenance_policy.v2.2.20
16.11.14.pdf.
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Worldwide support numbers for these product 

families:*

 – Aruba products

 – HPE Nimble Storage products

Support matrix

Technical Support Phone Numbers

Country Support type Support phone number Hours of operations

Aland Contract +358 20 320 300 24x7

Warranty and Out of Warranty +358 20 353 232 M–F 8:00–17:00

Albania Contract & Warranty/Out of Warranty +355 42 322 411 24x7

Algeria Contract & Warranty/Out of Warranty +216 23 92 5000 24x7

Andorra Contract +34 902 220 030 24x7

Warranty and Out of Warranty +34 902 010 333 M–F 8:30–17:30

Angola Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Anguilla Contract & Warranty 1-800-225-5288 then 

844 692-8150

24x7

Antigua and Barbuda Contract & Warranty #1 then 844 692-8151 24x7

Argentina Contratos 0 800 444 7867

+52 55 5258 4500

24x7

Garantías 0 800 333 4857

+52 55 1500 3155

M–F 8:00–17:00

Armenia Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Aruba Contract & Warranty +1 844 264 1328 24x7

Australia Contract & Warranty/Out of Warranty 13 11 47

+61 2 8031 8315

24x7

Azerbaijan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

* For all other product types, please call the support number for your country listed in this document.
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Support matrix Page 2

Country Support type Support phone number Hours of operations

Bahamas Contract & Warranty 1-800-872-2881 then 

844 692-8152

24x7

Bahrain Contract & Warranty/Out of Warranty +973 1 619 82 94 24x7

Barbados Contract & Warranty 1-800-225-5288 then 

844 692-8153

24x7

Belarus Contract & Warranty/Out of Warranty 8 8200 073 01 01

+7 495 411 69 07

24x7

Belgium Contract 078 250 144

+32 26 200 055

24x7

Warranty and Out of Warranty 078 600 600

+32 26 200 099

M–F 8:00–17:00

Belize Contract & Warranty 811 then 844 692-8148 24x7

Benin Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Bermuda Contract & Warranty 1-800-225-5288 then 

844 692-8154

24x7

Bolivia Contratos 800 110 348

+52 55 5258 4500

24x7

Garantías 800 110 348

+52 55 1500 3155

M–F 8:00–17:00

Bonaire (Sint Eustatius, Saba) Contract & Warranty 001-800-872-2881 then 

844 752-2839

24x7

Bosnia and Herzegovina Contract & Warranty/Out of Warranty +387 338 219 22 24x7

Botswana Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Bouvet Island Contract & Warranty/Out of Warranty 800 56 044 24x7

Brasil Contract 0800 55 6405

+55 11 3173 8802 

+55 11 4688 5102

24x7

Warranty 0800 710 2029

+55 11 2377 1002 

+55 11 2377 0002

M–F 8:00–17:00
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Support matrix Page 3

Country Support type Support phone number Hours of operations

British Indian Ocean Territory Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

British Virgin Islands Contract & Warranty 1-800-872-2881 then 

844 692-8156

24x7

Bulgaria Contract & Warranty/Out of Warranty 0700-1-47-47 24x7

Burkina Faso Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Burundi Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Cameroon Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Canada Contract

Contrat

1-800-633-3600 24x7

Warranty and Out of Warranty

Produits garantis et hors garantie

1-844-806-3425 24x7 for most products

Cape Verde Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Cayman Islands Contract & Warranty 1-800-225-5288 then 

844 692-8157

24x7

Central African Republic Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Chad Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Chile Contratos 800 362 365

+52 55 5258 4500

24x7

Garantías 800 123 605

+52 55 1500 3155

M–F 8:00–17:00

Collectivity of Saint Martin Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Colombia Contratos 01 800 051 4747

+57 1 6004150

24x7

Garantías 800 051 7127

+52 55 1500 3155

M–F 9:00–18:00

Comoros Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7
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Support matrix Page 4

Country Support type Support phone number Hours of operations

Costa Rica Contratos 800 794 4401

+52 55 5258 4500

24x7

Garantías 800 794 4401

+52 55 1500 3155

M–F 8:00–17:00

Croatia Contract & Warranty/Out of Warranty 0800 303 556 24x7

Curaçao Contract & Warranty 001-800-872-2881 then 

844 264-1326

24x7

Cyprus Contract & Warranty/Out of Warranty 801 11 47 22 73

+30 211 181 3846

24x7

Czech Republic Contract & Warranty/Out of Warranty 239 018 791 24x7

Denmark Contract +45 70 10 80 25 24x7

Warranty and Out of Warranty +45 70 11 77 00 M–F 8:00–17:00

Deutschland Dienstleistungsverträge/Contracts +49 69 380 789 143 24x7

Produkte innerhalb und außerhalb der Herstellergarantie +49 69 380 789 142 Montag–Freitag

8:00–17:00

(außer an bundeseinheitlichen Feiertagen)

Djibouti Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Dominica Contract & Warranty 1-800-225-5288 then 

844 264-1327

24x7

Dominican Republic Contract & Warranty 1-888-225-5288 then 

844 264-1328

+52 55 5258 4500

24x7

Ecuador Contratos 1-800-225-528 then 

844 845-8165

+52 55 5258 4500

24x7

Garantías 1-800-225-528 then 

844 845-8165

+52 55 1500 3155 

M–F 8:00–17:00

Egypt Contract & Warranty/Out of Warranty 0800 000 0814

+20 2 353 131 62

24x7
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Support matrix Page 5

Country Support type Support phone number Hours of operations

El Salvador Contratos 800-1785 then 

844 845-8167

+52 55 5258 4500

24x7

Garantías 800-1785 then 

844 845-8167

+52 55 1500 3155 

M–F 8:00–17:00

Equatorial Guinea Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Eritrea Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

España Contrato de Mantenimiento +34 902 220 030

+34 913496569

24x7

Garantía y fuera de garantía +34 902 010 333

+34 913496559

Lunes a viernes, 8:30 a 17:30 de julio y agosto,  

8:30 a 14:30

Estonia Contract & Warranty/Out of Warranty +372 686 88 71 24x7

Ethiopia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Falkland Islands Contract & Warranty/Out of Warranty +44 845 161 0050 24x7

Faroe Islands Contract +45 70 10 80 25 24x7

Warranty and Out of Warranty +45 70 11 77 00 M–F 8:00–17:00

Finland Contract +358 20 320 300 24x7

Warranty and Out of Warranty +358 20 353 232 M–F 8:00–17:00

France Contrat 0825 00 41 23

+33 173018471

24x7

Ligne payante au tarif local en France

Garantie et Hors Garantie 0826 10 49 49

+33 173018475

Lundi–Vendredi 

8:30–18:00

(à l’exception des jours fériés et jours de fermeture d’HPE)

French Guiana Contract & Warranty 0800 99 00 11 then 

844 264-1329

24x7

French Polynesia Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

French Southern Territories Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Gabon Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7
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Country Support type Support phone number Hours of operations

Gambia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Georgia Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Ghana Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Gibraltar Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

Greece Contract & Warranty/Out of Warranty 801 11 47 22 73

+30 211 181 3846

24x7

Greenland Contract +45 70 10 80 25 24x7

Warranty and Out of Warranty +45 70 11 77 00 M–F 8:00–17:00

Grenada Contract & Warranty 1-800-225-5288 then 

844 264-1330

24x7

Guadeloupe Contract & Warranty 0-800-99-0011 then 

844 264-1331

24x7

Guatemala Contratos 999-9190 then 

844 845-8169

+52 55 5258 4500

24x7

Garantías 999-9190 then 

844 845-8169

+52 55 1500 3155

M–F 8:00–17:00

Guernsey Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

Guinea Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Guinea-Bissau Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Guyana Contract & Warranty 159 then 844 752-2835 24x7

Haiti Contract & Warranty +1 844 264 1328 24x7
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Country Support type Support phone number Hours of operations

Honduras Contratos 800-0-123 then 

844 752-2837

+52 55 5258 4500

24x7

Garantías 800-0-123 then 

844 752-2837

+52 55 1500 3155 

M–F 8:00–17:00

Hong Kong Contract +852 2292 3333 24x7

Alpha, ProLiant, and attached HPE Storage Systems

Warranty +852 3071 3873 M–F 8:30–17:30

HPE Networking, UNIX® system, NetServer, and attached 

HPE Storage systems 

Warranty +852 2904 8338 24x7

ProLiant & attached 

HPE Storage Systems 

Value line (need PIN code during AOH)

Hungary Contract 1 778 9670 24x7

Warranty and Out of Warranty 1 778 9669 M–F 9:00–17:00

Iceland Contract +47 800 56 044 24x7

Warranty and Out of Warranty +47 800 62 800 M–F 8:00–17:00

India Warranty 1800 419 8080 (Callers in India)

+91 806 703 7209 (International Callers)

M–F 9:00–18:00

Indonesia Contract & Warranty 0018 0385 20668

+62 21 5799 4050

24x7

Iran Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Iraq Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Ireland Contract 1850 924 590

+ 353 1 4118915

24x7

Warranty and Out of Warranty 1890 946 500

+ 353 1 4118912

M–F 8:00–18:00

(except Bank Holidays)

Isle of Man Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00
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Israel Contract & Warranty/Out of Warranty 1-809-400-300

+972 3-3726489

24x7

Italia Contratti 02 452 790 50 24x7

In garanzia o fuori garanzia 02 385 912 12 Lunedì–Venerdì 8:00–17:00

Ivory Coast Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Jamaica Contract & Warranty 1-800-872-2881 then 

844 264-1332

24x7

日本 Warranty support.hpe.com/hpsc/doc/public/display?docId=emr_

na-c04770344

Jersey Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

Jordan Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Kazakhstan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Kenya Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Kosovo Contract & Warranty/Out of Warranty 0800 300 003/0800 190 038 (Serbia)

035 542 322 411 (Albania)

24x7

Kuwait Contract & Warranty/Out of Warranty 632 9930 24x7

Kyrgyzstan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Latvia Contract & Warranty/Out of Warranty 678 521 84 24x7

Lebanon Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Lesotho Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Liberia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Libya Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Liechtenstein Contract +41 0848 800 724 24x7

Warranty and Out of Warranty +41 0848 80 20 20 M–F 8:00–18:00

Lithuania Contract & Warranty/Out of Warranty +370 521 415 92 24x7
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Luxembourg Contract +352 27 303 111 24x7

Warranty and Out of Warranty +352 27 303 303 M–F 8:00–17:00

Macedonia Contract & Warranty/Out of Warranty 0800 90 472 24x7

Madagascar Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Malawi Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Malaysia Contract & Warranty 1800 88 1811 (Callers in Malaysia)

+60 3 6207 4533 (International Callers)

24x7

Mali Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Malta Contract & Warranty/Out of Warranty +356 27 781 269 24x7

Martinique Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Mauritania Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Mauritius Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Mayotte Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

México Contratos 800 501 9800

+52 55 5258 4500

24x7

Garantías 800 890 6348

+52 55 1500 3155

M–F 8:00–17:00

Moldova Contract & Warranty/Out of Warranty +7 499 272 37 82 24x7

Monaco Contrat +33 1 73 01 84 71 24x7

Ligne payante au tarif local en France

Garantie et Hors Garantie +33 1 73 01 84 75 Lundi–Vendredi 

8:30–18:00

(à l’exception des jours fériés et jours de fermeture d’HPE)

Montenegro Contract & Warranty/Out of Warranty 0800 300 003 24x7

Montserrat Contract & Warranty 1-800-225-5288 then 

844 264-1333

24x7

Morocco Contract & Warranty/Out of Warranty 00 212 5 22 24 87 70

+44 1793 794886

24x7
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Mozambique Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Namibia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Netherlands Contract 0900 115 0000

+31 205 040 666

24x7

Warranty and Out of Warranty 0900 117 0000 M–F 8:00–17:00

New Caledonia Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

New Zealand Contract & Warranty/Out of Warranty 0800 664 747

+61 2 8031 8316

24x7

Nicaragua Contratos 1-800-0164 then 

844 752-2840

+52 55 5258 4500

24x7

Garantías 1-800-0164 then 

844 752-2840

+52 55 1500 3155

M–F 8:00–17:00

Niger Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Nigeria Contract & Warranty/Out of Warranty 01 27 14 777

+44 203 564 4148

24x7

Norway Contract 800 56 044 24x7

Warranty and Out of Warranty 800 62 800 M–F 8:00–17:00

Oman Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Österreich Dienstleistungsverträge/Contracts 08 1000 2000 24x7

Produkte innerhalb und ausserhalb der

Herstellergarantie

08 1000 1000 M–F 8:00–18:00

Palestinian Territory Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Panama Contratos 800-2288 then 

844 845-8163

+52 55 5258 4500

24x7

Garantías 800-2288 then 

844 845-8163

+52 55 1500 3155 

M–F 8:00–17:00
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Paraguay Contratos 008-11-800 then 

844 752-2842

+52 55 5258 4500

24x7

Garantías 008-11-800 then 

844 752-2842

+52 55 1500 3155 

M–F 8:00–17:00

Perú Contratos 0 800 1 9703

+52 55 5258 4500

24x7

Garantías 0800 44 366

+52 55 1500 3155 

M–F 8:00–17:00

Philippines Contract & Warranty 1800 1441 0669

 1800 8908 6404

+63 2395 3565

24x7

Poland Contract & Warranty/Out of Warranty 0 800 702 284

(22) 306 04 84

24x7

Portugal Contract 808 203 203 24x7

Warranty and Out of Warranty 213 164 164 M–F 9:00–18:00

Puerto Rico Contratos 844 752-2843

+52 55 5258 4500

24x7

Garantías 844 752-2843

+52 55 1500 3155 

M–F 8:00–17:00

Qatar Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Republic of Congo Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Réunion Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Romania Contract & Warranty/Out of Warranty +40 317 305 020 24x7

Россия Поддержка 8 800 500 92 55

+7 495 411 69 07

24x7

Rwanda Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Saint Barthélemy Contract 0-800-990-011 then 

844 845-8168

24x7

Warranty and Out of Warranty +212 5 22 24 87 70 24x7
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Saint Helena (Ascension and Tristan da Cunha) Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Saint Kitts and Nevis Contract & Warranty 1-800-225-5288 then 

844 264-1334

24x7

Saint Lucia Contract & Warranty/Out of Warranty 1 844 231 8954 24x7

Saint Pierre and Miquelon Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Saint Vincent and the Grenadines Contract & Warranty 1-800-225-5288 then 

844 845-8160

24x7

San Marino Contract 02 452 790 50 24x7

Warranty and Out of Warranty 02 385 912 12 M–F 8:00–17:00

Sao Tome and Principe Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Saudi Arabia Contract & Warranty/Out of Warranty 800 844 4611 24x7

Schweiz
Suisse

Dienstleistungsvertrag/

Contrat de services

0848 800 724

+41 43 557 9021

24x7

8Rp./Min*

Herstellergarantie/

Produits garantis

0848 80 20 20

+41 44 200 4115

Montag–Freitag

Lundi–Vendredi

8:00–17:00

(außer Feiertage) 

8Rp./Min*

*aus dem schweizerischen Festnetz; abweichende Preise aus 

Mobilfunknetzen sind je nach Anbieter möglich.

Senegal Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Serbia Contract & Warranty/Out of Warranty 0800 300 003

0800 190 038 

24x7

Seychelles Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Sierra Leone Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Singapore Contract & Warranty 1800 272 4333 (Callers in Singapore)

+65 6272 4333 (International Callers)

24x7

Sint Maarten Contract & Warranty 800-99-0011 then 

844 264-1335

24x7
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Slovakia Contract & Warranty/Out of Warranty 02 686 221 79 24x7

Slovenia Contract & Warranty/Out of Warranty 0800 80 745 24x7

Somalia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

South Africa Contract 0860 001 020 24x7

Warranty and Out of Warranty 0860 001 030 M–F 8:00–17:00

(except public Holidays)

South Georgia and the South Sandwich Islands Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

대한민국 Contract & Warranty +82 1577 3270 M–F 09:00–18:00

Server & Storage

Contract & Warranty +82 1588 0142 M–F 09:00–18:00

Networking

South Sudan Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Sudan Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Suriname Contract & Warranty/Out of Warranty 156 then 844 231-8955 24x7

Svalbard and Jan Mayen Contract +47 800 56 044 24x7

Warranty and Out of Warranty +47 800 62 800 M–F 8:00–17:00

Swaziland Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Sweden Contract 0771 30 30 50 24x7

Warranty and Out of Warranty 0771 30 30 00 M–F 8:00–17:00

Syria Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Taiwan Contract & Warranty 0800 211 666

+886 2 2656 7204

M–F 8:30–17:30

Tajikistan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7
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Tanzania Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Thailand Contract 1800 441 4048

+66 2 118 6000

24x7

Warranty 1800 441 4085

+66 2 118 6300

M–F 8:30–17:30

The Democratic Republic of Congo Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Togo Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Trinidad and Tobago Contract & Warranty/Out of Warranty 1-800-872-2881 then 

844 845-8161

24x7

Tunisia Contract & Warranty/Out of Warranty +216 23 92 5000 24x7

Turkey Contract 850 759 0 724

+90 850 759 0 724

24x7

Warranty and Out of Warranty 850 759 0 473

+90 850 759 0 473

08:30–17:30 GMT+3

Turkmenistan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Turks and Caicos Islands Contract & Warranty 1-800-225-5288 then 

844 845-8162

24x7

Uganda Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Ukraine Contract & Warranty/Out of Warranty 0 800 501 526 24x7

United Arab Emirates Contract & Warranty/Out of Warranty 800 0444 1477 24x7

United Kingdom Contract 0845 161 0050 24x7

Warranty and Out of Warranty 0845 161 0030 M–F 8:00–18:00

United States Contract 1-800-633-3600 24x7

Warranty and Out of Warranty 1-844-806-3425 24x7

Uruguay Contratos 0004 110 032 632

+52 55 5258 4500

24x7

Garantías 0004 110 032 632

+52 55 1500 3155 

M–F 8:00–17:00
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US Virgin Islands Contract & Warranty +1 844 845-8164 24x7

Uzbekistan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Vatican City Contract 02 45279050 24x7

Warranty and Out of Warranty 02 38591212 M–F 8:00–17:00

Venezuela Contratos & Garantías +58 212 7102103 24x7

Vietnam Contract & Warranty +84 28 4458 2390 24x7

Wallis and Futuna Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Western Sahara Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Yemen Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Zambia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Zimbabwe Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7
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Aruba 2530 Switch Series
 

 

Models
Aruba 2530 48G PoE+ Switch J9772A
Aruba 2530 24G PoE+ Switch J9773A
Aruba 2530 8G PoE+ Switch J9774A
Aruba 2530 48 PoE+ Switch J9778A
Aruba 2530 24 PoE+ Switch J9779A
Aruba 2530 8 PoE+ Switch J9780A
Aruba 2530 48G Switch J9775A
Aruba 2530 24G Switch J9776A
Aruba 2530 8G Switch J9777A
Aruba 2530 48 Switch J9781A
Aruba 2530 24 Switch J9782A
Aruba 2530 8 Switch J9783A
Aruba 2530 8 PoE+ Internal PS Switch JL070A

 

QuickSpecs Aruba 2530 Switch Series

Overview
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Key features
Cost-effective, reliable and secure Aruba Layer 2 switch series
Security and network management via Aruba ClearPass Policy Manager, Aruba AirWave and Aruba
Central
Right size deployment with choice of 8, 24 and 48 port Gigabit and Fast Ethernet models
Up to 370W PoE+ to power IoT, APs and cameras
Software defined ready with REST API support
Simple deployment with Zero Touch Provisioning

 

Introduction
The Aruba 2530 Switch Series provides cost-effective, reliable and secure access layer connectivity for enterprises, branch
offices and small and midsize businesses.

These fully managed switches deliver Layer 2 capabilities with enhanced access security, traffic prioritization, sFlow, and
IPv6 host support.  Right size deployment is available with a range of Gigabit and Fast Ethernet models including compact
and fanless models which are ideal for use in quiet work spaces. PoE+ models deliver up 370W to power access points, IP
phones and cameras.

The Aruba 2530 Switch Series is easy to deploy, use and manage using Aruba AirWave or Aruba Central. Aruba ClearPass
offers centralized security and external captive portal support. The switches include a Limited Lifetime Warranty.

 

Features
Unified Wired and Wireless

Software-defined networking support
leverages REST APIs to enable automation of network operations, monitoring, and troubleshooting
Supports unified wired and wireless policies
using Aruba ClearPass Policy Manager
Switch auto-configuration
automatically configures switch for different settings such as VLAN, CoS, PoE max power, and PoE
priority when an Aruba access point is detected
User role
defines a set of switch-based policies in areas such as security, authentication, and QoS. A user role
can be assigned to a group of users or devices, using local switch configuration (YA releases only).

Quality of Service (QoS)

Traffic prioritization (IEEE 802.1p)
allows for real-time traffic classification. Supports eight priority levels mapped to either two or four
queues, and uses weighted deficit round robin (WDRR) or strict priority
Simplified QoS configuration

- Port-based
traffic prioritization by specifying a port and priority level

- VLAN-based
traffic prioritization by specifying a VLAN and priority level

Class of Service (CoS)
sets the IEEE 802.1p priority tag based on IP address, IP Type of Service (ToS), Layer 3 protocol,
TCP/UDP port number, source port, and DiffServ
Rate limiting
establishes per-port ingress-enforced maximums for all traffic or for broadcast, multicast, or unknown

QuickSpecs Aruba 2530 Switch Series

Overview
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destination traffic
Layer 4 prioritization
enables priorities based on TCP/UDP port numbers
Flow control
delivers reliable communication during full-duplex operation

 

Simplified Configuration and Management

Aruba Central cloud-based management platform
offers a simple, secure and cost effective way to manage switches. Complies with RFC 7030 for
encryption key enrollment
Zero-Touch ProVisioning (ZTP)
simplifies installation of the switch infrastructure using DHCP-based process with AirWave
Choice of management interfaces

- HTML-based easy-to-use Web GUI
allows configuration of the switch from any Web browser

- Robust CLI
provides advanced configuration and diagnostics

- Simple network management protocol (SNMPv1/v2c/v3)
allows the switch to be managed with a variety of third-party network management
applications

Flexible management
supports both cloud-based Central and on-premise AirWave without ripping and replacing switching
infrastructure
Virtual stacking
provides single IP address management for up to 16 switches
sFlow (RFC 3176)
delivers wire-speed traffic accounting and monitoring, configured by SNMP and CLI with three terminal
encrypted receivers
IEEE 802.1AB Link Layer Discovery Protocol (LLDP)
automates device discovery protocol for easy mapping by network management applications
Provides local and remote logging of events
via SNMP (v2c and v3) and syslog; provides log throttling and log filtering to reduce the number of log
events generated
Port mirroring
allows traffic to be mirrored on any port or a network analyzer to assist with diagnostics or detecting
network attacks
Remote monitoring (RMON)
provides advanced monitoring and reporting capabilities for statistics, history, alarms, and events
Find, fix, and inform
finds and fixes common network problems automatically, and then informs the administrator
Friendly port names
allows assignment of descriptive names to ports
Dual flash images
provides independent primary and secondary operating system files for backup while upgrading
Multiple configuration files
are easily stored with a flash image
Front-panel LEDs

- Locator LEDs
allows users to set the locator LED on a specific switch to turn on, blink, or turn off; and
simplifies troubleshooting by making it easy to locate a particular switch within a rack of
similar switches

QuickSpecs Aruba 2530 Switch Series

Overview
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- Per-port LEDs
provides an at-a-glance view of the status, activity, speed, and full-duplex operation

- Power and fault LEDs
display issues, if any

 

Connectivity

Compact and fanless 8-port models
offer quiet operation for acoustically sensitive areas and uplink flexibility with two dual-personality ports
that can be used as either RJ-45 Gigabit Ethernet or SFP ports.
Four built-in Gigabit Ethernet uplinks on 24- and 48- port models
Gigabit models have small form factor pluggable (SFP) for fiber connectivity and Fast Ethernet models
have two SFP and two RJ-45 Gigabit uplinks.
IPv6

- IPv6 host
allows the switch to be deployed and managed at the edge of an IPv6 network

- Dual stack (IPv4/IPv6)
supports connectivity for both protocols; provides a transition mechanism from IPv4 to IPv6

- MLD snooping
forwards IPv6 multicast traffic to appropriate interface; prevents IPv6 multicast traffic from
flooding the network

- IPv6 ACL/QoS
supports ACL & QoS for IPv6 network traffic on Gigabit & 48 port 10/100 models

- Security
RA Guard, DHCPv6 Protection, Dynamic IPv6 Lockdown (YA only)

IEEE 802.3at Power over Ethernet (PoE+)
provides up to 30 W per port that allows support of the latest PoE+ capable devices such as IP
phones, wireless access points, and security cameras, as well as any IEEE 802.3af compliant end
device; eliminates the cost of additional electrical cabling and circuits that would otherwise be
necessary in IP phone and WLAN deployments
Auto-MDIX
adjusts automatically for straight-through or crossover cables on all ports
Pre-standard PoE support
detects and provides power to pre-standard PoE devices
SFP slots
provides fiber connectivity such as Gigabit-SX, -LX, -LH, and -BX with four SFP slots on all 24- and 48-
port Gigabit Ethernet models. Fast Ethernet 24- and 48-port models have two SFP slots and two RJ-45
Gigabit uplinks; 8-port models have two dual-personality ports supporting either SFP or RJ-45 Gigabit
uplinks
Dual-personality (RJ-45 or USB micro-B) serial console port
gives easy access to switch CLI with front-of-switch location and the flexibility of using either an RJ-45
or USB micro-B serial console port

Layer 2 switching

VLANs
supports 512 VLANs and 4,094 VLAN IDs
Jumbo packet support
improves the performance of large data transfers; supports frame size of up to 9,220 bytes
16K MAC address table
provides access to many Layer 2 devices
GARP VLAN Registration Protocol
allows automatic learning and dynamic assignment of VLANs
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Rapid Per-VLAN Spanning Tree (RPVST+)
allows each VLAN to build a separate spanning tree to improve link bandwidth usage; is compatible
with PVST+

Security

Access control lists (ACLs)
accommodate IPv4/IPv6 port and VLAN-based ACLs (IPv6 ACL is supported only on Gigabit Ethernet
and 48-port models.)
Source-port filtering
allows only specified ports to communicate with each other
RADIUS/TACACS+
eases switch management security administration by using a password authentication server
Secure Sockets Layer (SSL)
encrypts all HTTP traffic, allowing secure access to the browser-based management GUI in the switch
Port security
allows access only to specified MAC addresses, which can be learned or specified by the administrator
MAC address lockout
prevents particular configured MAC addresses from connecting to the network
Multiple user authentication methods

- IEEE 802.1X
uses an IEEE 802.1X supplicant on the client in conjunction with a RADIUS server to
authenticate in accordance with industry standards

- Web-based authentication
provides a browser-based environment, similar to IEEE 802.1X, to authenticate clients that
do not support the IEEE 802.1X supplicant

- Supports MAC-based authentication
using the client's MAC address

Secure shell (SSH) v2
encrypts all transmitted data for secure remote CLI access over IP networks
STP BPDU port protection
blocks Bridge Protocol Data Units (BPDUs) on ports that do not require BPDUs, preventing forged
BPDU attacks
STP root guard
protects the root bridge from malicious attacks or configuration mistakes
Secure management access
delivers secure encryption of all access methods (CLI, GUI, or MIB) through SSHv2 and SNMPv3
Custom banner
displays security policy when users log in to the switch
Secure FTP
allows secure file transfer to and from the switch; protects against unwanted file downloads or
unauthorized copying of a switch configuration file
Protected ports CLI
offers intuitive CLI to configure the source-port filter feature, by allowing specified ports to be isolated
from all other ports on the switch; the protected port or ports can communicate only with the uplink or
shared resources
Authentication flexibility

- Multiple IEEE 802.1X users per port
provides authentication for up to eight IEEE 802.1X users per port; prevents a user from
"piggybacking" on another user's IEEE 802.1X authentication

- Concurrent IEEE 802.1X, Web or MAC authentication schemes per port
allows a switch port to accept IEEE 802.1X and either Web or MAC authentications
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Switch management logon security
helps secure switch CLI logon by optionally requiring either RADIUS or TACACS+ authentication
DHCP protection
blocks DHCP packets from unauthorized DHCP servers, preventing denial-of-service attacks
Dynamic ARP protection:
blocks ARP broadcasts from unauthorized hosts, preventing eavesdropping or theft of network data
Dynamic IP lockdown
works with DHCP protection to block traffic from unauthorized hosts, preventing IP source address
spoofing
MAC Pinning
allows non-chatty legacy devices to stay authenticated by pinning client MAC addresses to the port
until the clients logoff or get disconnected

Convergence

LLDP-MED (Media Endpoint Discovery)
defines a standard extension of LLDP that stores values for parameters such as QoS and VLAN to
automatically configure network devices such as IP phones
IEEE 802.1AB Link Layer Discovery Protocol (LLDP)
facilitates easy mapping using network management applications with LLDP automated device
discovery protocol
PoE and PoE+ allocations
support multiple methods (automatic, IEEE 802.3at dynamic, LLDP-MED fine grain, IEEE 802.3af
device class or user-specified), to allocate and manage PoE/PoE+ power for more energy savings
Voice VLAN
uses LLDP-MED to automatically configure a VLAN for IP phones
IP multicast (IGMP)
prevents flooding of IP multicast traffic
LLDP-CDP compatibility
receives and recognizes CDP packets from Cisco's IP phones for seamless interoperation
Local MAC Authentication
assigns attributes such as VLAN and QoS using locally configured profile that can be a list of MAC
prefixes

Resiliency and high availability

Port trunking and link aggregation
- Trunking

supports up to eight links per trunk to increase bandwidth and create redundant connections;
and supports L2, L3, and L4 trunk load-balancing algorithm (L4 trunk load balancing is
supported only on Gigabit Ethernet and 48-port models.)

- IEEE 802.3ad Link Aggregation Control Protocol (LACP)
eases configuration of trunks through automatic configuration

IEEE 802.1s Multiple Spanning Tree
provides high link availability in multiple VLAN environments by allowing multiple spanning trees;
provides legacy support for IEEE 802.1d and IEEE 802.1w
SmartLink
provides easy-to-configure link redundancy of active and standby links

Product Architecture

Power savings with energy-efficient design
- IEEE 802.3az

reduces power consumption during periods of low data activity on Gigabit Ethernet switches
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- Port low power mode
enables the port to automatically go into low-power mode to conserve energy when no link is
detected

- Fanless and variable-speed fans
decrease power consumption in fanless (all 8-port, 2530-24, and 2530-48 PoE+ switches) as
well as variable-speed fan switches

- Port LEDs
conserves energy by optionally turning off port link and activity LEDs

Switch on a chip
provides a highly integrated, high-performance switch design with a non-blocking architecture

Flexibility

Flexible mounting
- Rack mountable

allows the switch to be mounted on a standard 19-inch rack, with the hardware included
- Wall mountable

allows the switch to be mounted on a wall, using the hardware included
- Surface mountable

allows the switch to be mounted above or below a surface (such as a desk or table), using
the hardware included

Quiet operation
lowers noise, making it suitable for deployments in acoustically sensitive environments such as
conference rooms and office spaces
Compact size
reduces space requirements (refer to the product specifications for the exact dimensions)

Warranty and support

Limited Lifetime Warranty
see http://www.hpe.com/networking/warrantysummary for warranty and support information
included with your product purchase.
Software releases
to find software for your product, refer to http://www.hpe.com/networking/support; for details on the
software releases available with your product purchase, refer to
http://www.hpe.com/networking/warrantysummary

QuickSpecs Aruba 2530 Switch Series

Overview

DA - 14447   Worldwide QuickSpecs — Version 18 — 12/3/2018 Page  7

Anexo 01 ITEM 11 (0592657)         SEI 0008478-63.2018.6.02.8000 / pg. 5570

http://www.hpe.com/networking/warrantysummary
http://www.hpe.com/networking/support
http://www.hpe.com/networking/warrantysummary


 

Build To Order: BTO is a standalone unit with no integration. BTO products
ship standalone are not part of a CTO or Rack-Shippable solution.
   
Aruba 2530 8 Switch J9783A

8 RJ-45 autosensing 10/100 ports
2 dual-personality ports; RJ-45 10/100/1000 or SFP slot (Min 0 // Max 2 SFP)
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 3

   
No Power Cord J9783A#AC3

No Localized Power Cord Selected  
   
   
Aruba 2530 8 PoE+ Switch J9780A

8 RJ-45 autosensing 10/100 PoE+ports
2 dual-personality ports; RJ-45 10/100/1000 or SFP slot (Min 0 // Max 2 SFP)
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 3

   
No Power Cord J9780A#AC3

No Localized Power Cord Selected  
   
   
Aruba 2530 8 PoE+ Internal PS Switch JL070A

8 RJ-45 autosensing 10/100 PoE+ports
2 dual-personality ports; RJ-45 10/100/1000 or SFP slot (Min 0 // Max 2 SFP)
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2

   
PDU Cable NA/MEX/TW/JP JL070A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL070A#B2C

C15 PDU Jumper Cord (ROW)  
   
Aruba 2530 8G Switch J9777A

8 RJ-45 autosensing 10/100/1000 ports
2 dual-personality ports; RJ-45 10/100/1000 or SFP slot (Min 0 // Max 2 SFP)
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 3

   
No Power Cord J9777A#AC3

No Localized Power Cord Selected  
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Aruba 2530 8G PoE+ Switch J9774A

8 RJ-45 autosensing 10/100/1000 PoE+ ports
2 dual-personality ports; RJ-45 10/100/1000 or SFP slot (Min 0 // Max 2 SFP)
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 3

   
No Power Cord J9774A#AC3

No Localized Power Cord Selected  
   

Aruba 2530 24 Switch J9782A

24 RJ-45 autosensing 10/100 ports
2 fixed Gigabit Ethernet SFP ports (Min 0 // Max 2 SFP)
2 RJ-45 autosensing 10/100/1000 ports
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2

   
PDU CABLE NA/MEX/TW/JP J9782A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)
   
PDU CABLE ROW J9782A#B2C

C15 PDU Jumper Cord (ROW)
   
No Power Cord J9782A#AC3

No Localized Power Cord Selected  
   
Aruba 2530 24 PoE+ Switch J9779A

24 RJ-45 autosensing 10/100 PoE+ ports
2 fixed Gigabit Ethernet SFP ports (Min 0 // Max 2 SFP)
2 RJ-45 autosensing 10/100/1000 ports
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2

   
PDU CABLE NA/MEX/TW/JP J9779A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)
   
PDU CABLE ROW J9779A#B2C

C15 PDU Jumper Cord (ROW)
   
No Power Cord J9779A#AC3

No Localized Power Cord Selected  
   
Aruba 2530 24G Switch J9776A

24 RJ-45 autosensing 10/100/1000 ports
4 fixed Gigabit Ethernet SFP ports (Min 0 // Max 4 SFP)
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2
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PDU CABLE NA/MEX/TW/JP J9776A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)
 
PDU CABLE ROW J9776A#B2C

C15 PDU Jumper Cord (ROW)
   
Aruba 2530 24G PoE+ Switch J9773A

24 RJ-45 autosensing 10/100/1000 PoE+ ports
4 fixed Gigabit Ethernet SFP ports (Min 0 // Max 4 SFP)
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2

   
PDU CABLE NA/MEX/TW/JP J9773A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)
   
PDU CABLE ROW J9773A#B2C

C15 PDU Jumper Cord (ROW)
   
Aruba 2530 48 Switch J9781A

48 RJ-45 autosensing 10/100 ports
2 fixed Gigabit Ethernet SFP ports (Min 0 // Max 2 SFP)
2 RJ-45 autosensing 10/100/1000 ports
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2

   
PDU CABLE NA/MEX/TW/JP J9781A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)
   
PDU CABLE ROW J9781A#B2C

C15 PDU Jumper Cord (ROW)
   
No Power Cord J9781A#AC3

No Localized Power Cord Selected  
   
Aruba 2530 48 PoE+ Switch J9778A

48 RJ-45 autosensing 10/100 PoE+ ports
2 fixed Gigabit Ethernet SFP ports (Min 0 // Max 2 SFP)
2 RJ-45 autosensing 10/100/1000 ports
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2

   
PDU CABLE NA/MEX/TW/JP J9778A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)
   
PDU CABLE ROW J9778A#B2C

C15 PDU Jumper Cord (ROW)
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No Power Cord J9778A#AC3
No Localized Power Cord Selected  

   
Aruba 2530 48G Switch J9775A

48 RJ-45 autosensing 10/100/1000 ports
4 fixed Gigabit Ethernet SFP ports (Min 0 // Max 4 SFP)
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2

   
PDU CABLE NA/MEX/TW/JP J9775A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)
   
PDU CABLE ROW J9775A#B2C

C15 PDU Jumper Cord (ROW)
   
Aruba 2530 48G PoE+ Switch J9772A

48 RJ-45 autosensing 10/100/1000 PoE+ ports
4 fixed Gigabit Ethernet SFP ports (Min 0 // Max 4 SFP)
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2

   
PDU CABLE NA/MEX/TW/JP J9772A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)
   
PDU CABLE ROW J9772A#B2C

C15 PDU Jumper Cord (ROW)
   
 
 
Configuration Rules:
     
NOTE 1 The following Transceivers install into this switch:  

Aruba 1G SFP LC SX 500m OM2 MMF Transceiver J4858D
Aruba 1G SFP LC LX 10km SMF Transceiver J4859D
Aruba 1G SFP LC LH 70km SMF Transceiver J4860D
Aruba 1G SFP RJ45 T 100m Cat5e Transceiver J8177D
Aruba 100M SFP LC FX 2km MMF Transceiver J9054D

   
NOTE 2 Localization required on orders without #B2B, #B2C or #B2E options.

   
NOTE 3 Localization cable required. No B2x options

   

Remarks: Drop down under power supply should offer the following options and results:

Switch/Router/Power Supply to PDU Power Cord - #B2B in North America, Mexico, Taiwan, and Japan or
#B2C ROW. (Watson Default B2B or B2C for Rack Level CTO)
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Switch/Router/Power Supply to Wall Power Cord - Localized Option (Watson Default for BTO and Box
Level CTO)

 
   

Rack Level Integration CTO Models  

     
Aruba 2530 24 Switch J9782A  

24 RJ-45 autosensing 10/100 ports
2 fixed Gigabit Ethernet SFP ports (Min 0 // Max 2 SFP)
2 RJ-45 autosensing 10/100/1000 ports
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2, 3, 4

 

     
PDU CABLE NA/MEX/TW/JP J9782A#B2B  

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
     
PDU CABLE ROW J9782A#B2C  

C15 PDU Jumper Cord (ROW)  
   
No Power Cord J9782A#AC3

No Localized Power Cord Selected  
   
Aruba 2530 24 PoE+ Switch J9779A  

24 RJ-45 autosensing 10/100 PoE+ ports
2 fixed Gigabit Ethernet SFP ports (Min 0 // Max 2 SFP)
2 RJ-45 autosensing 10/100/1000 ports
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2, 3, 4

 

     
PDU CABLE NA/MEX/TW/JP J9779A#B2B  

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
     
PDU CABLE ROW J9779A#B2C  

C15 PDU Jumper Cord (ROW)  
   
No Power Cord J9779A#AC3

No Localized Power Cord Selected  
   
Aruba 2530 24G Switch J9776A  

24 RJ-45 autosensing 10/100/1000 ports
4 fixed Gigabit Ethernet SFP ports (Min 0 // Max 4 SFP)
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2, 3, 4

 

     
PDU CABLE NA/MEX/TW/JP J9776A#B2B  

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
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PDU CABLE ROW J9776A#B2C  
C15 PDU Jumper Cord (ROW)  

     
Aruba 2530 24G PoE+ Switch J9773A  

24 RJ-45 autosensing 10/100/1000 PoE+ ports
4 fixed Gigabit Ethernet SFP ports (Min 0 // Max 4 SFP)
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2, 3, 4

 

     
PDU CABLE NA/MEX/TW/JP J9773A#B2B  

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
     
PDU CABLE ROW J9773A#B2C  

C15 PDU Jumper Cord (ROW)  
     
Aruba 2530 48 Switch J9781A  

48 RJ-45 autosensing 10/100 ports
2 fixed Gigabit Ethernet SFP ports (Min 0 // Max 2 SFP)
2 RJ-45 autosensing 10/100/1000 ports
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2, 3, 4

 

     
PDU CABLE NA/MEX/TW/JP J9781A#B2B  

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
     
PDU CABLE ROW J9781A#B2C  

C15 PDU Jumper Cord (ROW)  
   
No Power Cord J9781A#AC3

No Localized Power Cord Selected  
   
Aruba 2530 48 PoE+ Switch J9778A  

48 RJ-45 autosensing 10/100 PoE+ ports
2 fixed Gigabit Ethernet SFP ports (Min 0 // Max 2 SFP)
2 RJ-45 autosensing 10/100/1000 ports
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2, 3, 4

 

     
PDU CABLE NA/MEX/TW/JP J9778A#B2B  

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
     
PDU CABLE ROW J9778A#B2C  

C15 PDU Jumper Cord (ROW)  
   
No Power Cord J9778A#AC3

No Localized Power Cord Selected  
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Aruba 2530 48G Switch J9775A  
48 RJ-45 autosensing 10/100/1000 ports
4 fixed Gigabit Ethernet SFP ports (Min 0 // Max 4 SFP)
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2, 3, 4

 

     
PDU CABLE NA/MEX/TW/JP J9775A#B2B  

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
     
PDU CABLE ROW J9775A#B2C  

C15 PDU Jumper Cord (ROW)  
     
Aruba 2530 48G PoE+ Switch J9772A  

48 RJ-45 autosensing 10/100/1000 PoE+ ports
4 fixed Gigabit Ethernet SFP ports (Min 0 // Max 4 SFP)
Power Supply Included
1U - Height

See Configuration
NOTE: 1, 2, 3, 4

 

     
PDU CABLE NA/MEX/TW/JP J9772A#B2B  

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
     
PDU CABLE ROW J9772A#B2C  

C15 PDU Jumper Cord (ROW)  
     

 
 
Configuration
Rules:
   
NOTE 1 The following Transceivers install into this switch:

Aruba 1G SFP LC SX 500m OM2 MMF Transceiver J4858D

Aruba 1G SFP LC LX 10km SMF Transceiver J4859D

Aruba 1G SFP LC LH 70km SMF Transceiver J4860D

Aruba 1G SFP RJ45 T 100m Cat5e Transceiver J8177D

Aruba 100M SFP LC FX 2km MMF Transceiver J9054D

   
NOTE 2 If this switch is factory installed in any HPE Universal Racks, Then the J9583A#0D1 is required.

   
NOTE 3 Localization (Wall Power Cord) required on orders without #B2B, #B2C (PDU Power Cord) . (See

Localization Menu)

REMARK: When Switches/Routers are Factory Racked, Then #B2B, or #B2C should be the
Defaulted Power Cable option on the Switches/Routers.

   
NOTE 4 If HPE CTO Switch Chassis is selected forRack Level Integration, Then the CTO Switch Chassis

needs to integrate (with #0D1) to the HPE Networking Universal Rack.
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 Remarks: Drop down under power supply should offer the following options and results:

Switch/Router/Power Supply to PDU Power Cord - #B2B in North America, Mexico, Taiwan, and
Japan or #B2C ROW. (Watson Default B2B or B2C for Rack Level CTO)

Switch/Router/Power Supply to Wall Power Cord - Localized Option (Watson Default for BTO and
Box Level CTO)

 
   

Internal Power Supplies  
   
Internal Power supplies included  
   
Enter the following menu selections as integrated to the CTO Model X server above if order is
factory built.

   

Transceivers  
   
SFP Transceivers  

   
Aruba 100M SFP LC FX 2km MMF Transceiver J9054D

Aruba 1G SFP LC SX 500m OM2 MMF Transceiver J4858D

Aruba 1G SFP LC LX 10km SMF Transceiver J4859D

Aruba 1G SFP LC LH 70km SMF Transceiver J4860D

Aruba 1G SFP RJ45 T 100m Cat5e Transceiver J8177D

   

Cables
   
Console Cables

(std 0 // max 99) User Selection (min 0 // max 99) per switch  
   
Aruba X2C2 RJ45 to DB9 Console Cable JL448A

   

Switch Enclosure Options
 
Cable Guard

   
Aruba X510 1U Cable Guard J9700A

See Configuration
NOTE: 1

 
Configuration Rules:

   
NOTE 1 This Cable Guard is supported only on the J9783A, J9780A, JL070A, J9777A and J9774A.
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Option Mounting Kit

Aruba 2530 8-port Switch Pwr Adptr Shelf J9820A

See Configuration
NOTE: 1

 
Configuration Rules:
   
NOTE 1 This Power Adapter Shelf is supported only on the J9783A, J9780A, J9777A and J9774A.

 
Rack Mount Kit

HPE X410 1U Universal 4-post Rackmount Kit J9583A

See Configuration
NOTE: 1

 
Configuration Rules:
   
NOTE 1 If this Mounting Kit is order with #0D1 then it integrates to the HPE Network Rack. (not the switch)
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Aruba 2530 48G PoE+ Switch (J9772A)

I/O ports and slots 48 RJ-45 autosensing 10/100/1000 PoE+ ports (IEEE 802.3 Type 10BASE-T, IEEE
802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T, IEEE 802.3at PoE+);
Media Type: Auto-MDIX; Duplex: 10BASE-T/100BASE-TX: half or full; 1000BASE-T:
full only
4 fixed Gigabit Ethernet SFP ports

Additional ports
and slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 17.44(w) x 13.00(d) x 1.75(h) in (44.3 x 32.26 x 4.45 cm)
(1U height)

Weight 10.4 lb (4.72 kg)

Memory and
processor

Processor ARM9E @ 800 MHz, 128 MB flash; Packet buffer size: 3
MB dynamically allocated, 256 MB DDR3 DIMM

Mounting and
enclosure

Mounts in an EIA-standard 19-inch telco rack or equipment cabinet (rack-mounting kit
available); Horizontal surface mounting; Wall mounting

Performance IPv6 Ready Certified

100 Mb Latency < 7.4 µs (LIFO 64-byte packets)

1000 Mb Latency < 2.3 µs (LIFO 64-byte packets)

Throughput up to 77.3 Mpps (64-byte packets)

Switching capacity 104 Gbps

MAC address table size 16000 entries

Environment Operating temperature 32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Non-operating/
Storage temperature

-40°F to 158°F (-40°C to 70°C)

Non-operating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 43.6 dB, Pressure: 33.6 dB

Electrical
characteristics

Frequency 50/60 Hz

Maximum heat
dissipation

236 BTU/hr (248.98 kJ/hr), (switch only: 236 BTU/hr;
combined switch + max. PoE devices: 1624 BTU/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current 5.8/2.9 A

Maximum power rating 476 W

Idle power 40.1 W

PoE power 382 W

NOTES Idle power is the actual power consumption of the device
with no ports connected. Maximum power rating and
maximum heat dissipation are the worst-case theoretical
maximum numbers provided for planning the
infrastructure with fully loaded PoE (if equipped), 100%
traffic, all ports plugged in, and all modules populated.
PoE power is the total power budget available to all PoE

QuickSpecs Aruba 2530 Switch Series

Technical Specifications

DA - 14447   Worldwide QuickSpecs — Version 18 — 12/3/2018 Page  17

Anexo 01 ITEM 11 (0592657)         SEI 0008478-63.2018.6.02.8000 / pg. 5580



ports.
Safety UL 60950-1; CAN/CSA 22.2 No. 60950-1; EN 60825; IEC 60950-1; EN 60950-1

Emissions FCC Class A; EN 55022/CISPR-22 Class A; VCCI Class A

Immunity Generic EN 55024, CISPR 24

EN EN 55024, CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

Harmonics EN 61000-3-2, IEC 61000-3-2

Flicker EN 61000-3-3, IEC 61000-3-3

Management IMC - Intelligent Management Center; command-line interface; Web browser;
configuration menu; out-of-band management (serial RS-232C or Micro USB); IEEE
802.3 Ethernet MIB; Repeater MIB; Ethernet Interface MIB

NOTES IEEE 802.3az applies to Gigabit models only; IEEE 802.3at and IEEE 802.3af apply
to PoE+ models only. When using SFPs with this product, SFPs with revision "B" or
later (product number ends with the letter "B" or later, e.g., J4858B, J4859C) are
required.

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services for
details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
 
Aruba 2530 24G PoE+ Switch (J9773A)

I/O ports and slots 24 RJ-45 autosensing 10/100/1000 PoE+ ports (IEEE 802.3 Type 10BASE-T, IEEE
802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T, IEEE 802.3at PoE+);
Media Type: Auto-MDIX; Duplex: 10BASE-T/100BASE-TX: half or full; 1000BASE-
T: full only
4 fixed Gigabit Ethernet SFP ports

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 17.44(w) x 13.00(d) x 1.75(h) in (44.3 x 33.02 x 4.45 cm) (1U
height)

Weight 8.7 lb (3.95 kg)

Memory and
processor

Processor ARM9E @ 800 MHz, 128 MB flash; Packet buffer size: 1.5
MB dynamically allocated, 256 MB DDR3 DIMM

Mounting and
enclosure

Mounts in an EIA-standard 19-inch telco rack or equipment cabinet (rack-mounting
kit available); Horizontal surface mounting; Wall mounting

Performance IPv6 Ready Certified

100 Mb Latency < 7.4 µs (LIFO 64-byte packets)
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1000 Mb Latency < 2.3 µs (LIFO 64-byte packets)

Throughput up to 41.6 Mpps (64-byte packets)

Switching capacity 56 Gbps

MAC address table
size

16000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Non-operating/
Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Non-
operating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 43.9 dB, Pressure: 39.6 dB

Electrical
characteristics

Frequency 50/60 Hz

Maximum heat
dissipation

135 BTU/hr (142.42 kJ/hr), (switch only: 135 BTU/hr;
combined switch + max. PoE devices: 843 BTU/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current 3.2/1.6 A

Maximum power
rating

247 W

Idle power 25.2 W

PoE power 195 W

NOTES Idle power is the actual power consumption of the device
with no ports connected.
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided for
planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all modules
populated.
PoE power is the total power budget available to all PoE
ports.

Safety UL 60950-1; CAN/CSA 22.2 No. 60950-1; EN 60825; IEC 60950-1; EN 60950-1

Emissions FCC Class A; EN 55022/CISPR-22 Class A; VCCI Class A

Immunity Generic EN 55024, CISPR 24

EN EN 55024, CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8
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Voltage dips and
interruptions

IEC 61000-4-11

Harmonics EN 61000-3-2, IEC 61000-3-2

Flicker EN 61000-3-3, IEC 61000-3-3

Management IMC - Intelligent Management Center; command-line interface; Web browser;
configuration menu; out-of-band management (serial RS-232C or Micro USB);
IEEE 802.3 Ethernet MIB; Repeater MIB; Ethernet Interface MIB

NOTES IEEE 802.3az applies to Gigabit models only; IEEE 802.3at and IEEE 802.3af apply
to PoE+ models only. When using SFPs with this product, SFPs with revision "B" or
later (product number ends with the letter "B" or later, e.g., J4858B, J4859C) are
required.

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services
for details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
Aruba 2530 8G PoE+ Switch (J9774A)

I/O ports and slots 8 RJ-45 autosensing 10/100/1000 PoE+ ports (IEEE 802.3 Type 10BASE-T, IEEE
802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T, IEEE 802.3at PoE+);
Media Type: Auto-MDIX; Duplex: 10BASE-T/100BASE-TX: half or full; 1000BASE-
T: full only
2 dual-personality ports; each port can be used as either an RJ-45 10/100/1000
port (IEEE 802.3 Type 10Base-T; IEEE 802.3u Type 100Base-Tx; IEEE 802.3ab
1000Base-T Gigabit Ethernet) or as a SFP slot (for use with SFP transceivers)

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 10.00(w) x 6.28(d) x 1.75(h) in (25.4 x 15.95 x 4.45 cm) (1U
height)

Weight 2.2 lb (1 kg)

Memory and
processor

Processor ARM9E @ 800 MHz, 128 MB flash; Packet buffer size: 1.5
MB dynamically allocated, 256 MB DDR3 DIMM

Mounting and
enclosure

Mounts in an EIA-standard 19-inch telco rack or equipment cabinet (rack-mounting
kit available); horizontal surface mounting; wall mounting

Performance IPv6 Ready Certified

100 Mb Latency < 7.4µs (LIFO 64-byte packets)

1000 Mb Latency < 2.6 µs (LIFO 64-byte packets)

Throughput up to 14.8 Mpps (64-byte packets)

Switching capacity 20 Gbps

MAC address table
size

16000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), non-condensing

Non-operating/
Storage
temperature

-40°F to 158°F (-40°C to 70°C)
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Non-operating/
Storage relative
humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 0 dB, Pressure: 0 dB

Electrical
characteristics

Frequency 50/60 Hz

Maximum heat
dissipation

65 BTU/hr (68.58 kJ/hr), (switch only: 65 BTU/hr; combined
switch + max. PoE devices: 293 BTU/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current 1.4 A

Maximum power
rating

86 W

Idle power 13.4 W

PoE power 67 W

NOTES Idle power is the actual power consumption of the device
with no ports connected.
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided for
planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all modules
populated.
PoE power is the total power budget available to all PoE
ports.

Safety UL 60950-1; CAN/CSA 22.2 No. 60950-1; EN 60825; IEC 60950-1; EN 60950-1

Emissions FCC Class A; EN 55022/CISPR-22 Class A; VCCI Class A

Immunity Generic EN 55024, CISPR 24

EN EN 55024, CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

Harmonics EN 61000-3-2, IEC 61000-3-2

Flicker EN 61000-3-3, IEC 61000-3-3

Management IMC - Intelligent Management Center; command-line interface; Web browser;
configuration menu; out-of-band management (serial RS-232C or Micro USB);
IEEE 802.3 Ethernet MIB; Repeater MIB; Ethernet Interface MIB

NOTES IEEE 802.3az applies to Gigabit models only; IEEE 802.3at and IEEE 802.3af apply
to PoE+ models only. When using SFPs with this product, SFPs with revision "B" or
later (product number ends with the letter "B" or later, e.g., J4858B, J4859C) are
required.
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Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services
for details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
 
Aruba 2530 48 PoE+ Switch (J9778A)

I/O ports and slots 48 RJ-45 autosensing 10/100 PoE+ ports (IEEE 802.3 Type 10BASE-T, IEEE
802.3u Type 100BASE-TX, IEEE 802.3at PoE+) Media Type: Auto-MDIX Duplex:
half or full
2 autosensing 10/100/1000 ports (IEEE 802.3 Type 10BASE-T, IEEE 802.3u Type
100BASE-TX, IEEE 802.3ab Type 1000BASE-T) Duplex: 10BASE-T/100BASE-TX:
half or full; 1000BASE-T: full only
2 fixed Gigabit Ethernet SFP ports

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 17.40(w) x 12.70(d) x 1.75(h) in (44.2 x 32.26 x 4.45 cm) (1U
height)

Weight 10.1 lb (4.58 kg)

Memory and
processor

Processor ARM9E @ 800 MHz, 128 MB flash; Packet buffer size: 3 MB
dynamically allocated, 256 MB DDR3 DIMM

Mounting and
enclosure

Mounts in an EIA-standard 19-inch telco rack or equipment cabinet (rack-mounting
kit available); Horizontal surface mounting; Wall mounting

Performance IPv6 Ready Certified

100 Mb Latency < 6.6 µs (LIFO 64-byte packets)

1000 Mb Latency < 2.2 µs (LIFO 64-byte packets)

Throughput up to 13 Mpps (64-byte packets)

Switching capacity 17.6 Gbps

MAC address table
size

16000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Non-operating/
Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Non-
operating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 37.9 dB, Pressure: 31.8 dB

Electrical
characteristics

Frequency 50/60 Hz

Maximum heat
dissipation

170 BTU/hr (179.35 kJ/hr), (switch only: 170 BTU/hr;
combined switch + max. PoE devices: 1505 BTU/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated
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Current 5.2/2.6 A

Maximum power
rating

441 W

Idle power 37.5 W

PoE power 382 W

NOTES Idle power is the actual power consumption of the device
with no ports connected.
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided for
planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all modules
populated.
PoE power is the total power budget available to all PoE
ports.

Safety UL 60950-1; CAN/CSA 22.2 No. 60950-1; EN 60825; IEC 60950-1; EN 60950-1

Emissions FCC Class A; EN 55022/CISPR-22 Class A; VCCI Class A

Immunity Generic EN 55024, CISPR 24

EN EN 55024, CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

Harmonics EN 61000-3-2, IEC 61000-3-2

Flicker EN 61000-3-3, IEC 61000-3-3

Management IMC - Intelligent Management Center; command-line interface; Web browser;
configuration menu; out-of-band management (serial RS-232C or Micro USB);
IEEE 802.3 Ethernet MIB; Repeater MIB; Ethernet Interface MIB

NOTES IEEE 802.3az applies to Gigabit models only; IEEE 802.3at and IEEE 802.3af apply
to PoE+ models only. When using SFPs with this product, SFPs with revision "B" or
later (product number ends with the letter "B" or later, e.g., J4858B, J4859C) are
required.

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services
for details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
Aruba 2530 24 PoE+ Switch (J9779A)

I/O ports and slots 24 RJ-45 autosensing 10/100 PoE+ ports (IEEE 802.3 Type 10BASE-T, IEEE
802.3u Type 100BASE-TX, IEEE 802.3at PoE+); Media Type: Auto-MDIX; Duplex:
half or full
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2 autosensing 10/100/1000 ports (IEEE 802.3 Type 10BASE-T, IEEE 802.3u Type
100BASE-TX, IEEE 802.3ab Type 1000BASE-T); Duplex: 10BASE-T/100BASE-
TX: half or full; 1000BASE-T: full only
2 fixed Gigabit Ethernet SFP ports

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 17.40(w) x 12.70(d) x 1.75(h) in (44.2 x 32.26 x 4.45 cm) (1U
height)

Weight 8.4 lb (3.81 kg)

Memory and
processor

Processor ARM9E @ 800 MHz, 128 MB flash; Packet buffer size: 1.5
MB dynamically allocated, 256 MB DDR3 DIMM

Mounting and
enclosure

Mounts in an EIA-standard 19-inch telco rack or equipment cabinet (rack-mounting
kit available); Horizontal surface mounting; Wall mounting

Performance IPv6 Ready Certified

100 Mb Latency < 1.7 µs (LIFO 64-byte packets)

1000 Mb Latency < 1.1µs (LIFO 64-byte packets)

Throughput up to 9.5 Mpps (64-byte packets)

Switching capacity 12.8 Gbps

MAC address table
size

16000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Non-operating/
Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Non-
operating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 40.4 dB, Pressure: 31.7 dB

Electrical
characteristics

Frequency 50/60 Hz

Maximum heat
dissipation

99 BTU/hr (104.45 kJ/hr), (switch only: 99 BTU/hr; combined
switch + max. PoE devices: 809 BTU/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current 2.8/1.4 A

Maximum power
rating

237 W

Idle power 21.8 W

PoE power 195 W

NOTES Idle power is the actual power consumption of the device
with no ports connected.
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided for
planning the infrastructure with fully loaded PoE (if
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equipped), 100% traffic, all ports plugged in, and all modules
populated.
PoE power is the total power budget available to all PoE
ports.

Safety UL 60950-1; CAN/CSA 22.2 No. 60950-1; EN 60825; IEC 60950-1; EN 60950-1

Emissions FCC Class A; EN 55022/CISPR-22 Class A; VCCI Class A

Immunity Generic EN 55024, CISPR 24

EN EN 55024, CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

Harmonics EN 61000-3-2, IEC 61000-3-2

Flicker EN 61000-3-3, IEC 61000-3-3

Management IMC - Intelligent Management Center; command-line interface; Web browser;
configuration menu; out-of-band management (serial RS-232C or Micro USB);
IEEE 802.3 Ethernet MIB; Repeater MIB; Ethernet Interface MIB

NOTES IEEE 802.3az applies to Gigabit models only; IEEE 802.3at and IEEE 802.3af apply
to PoE+ models only. When using SFPs with this product, SFPs with revision "B" or
later (product number ends with the letter "B" or later, e.g., J4858B, J4859C) are
required.

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services
for details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
 
Aruba 2530 8 PoE+ Switch (J9780A)

I/O ports and slots 8 RJ-45 autosensing 10/100 PoE+ ports (IEEE 802.3 Type 10BASE-T, IEEE 802.3u
Type 100BASE-TX, IEEE 802.3at PoE+); Media Type: Auto-MDIX; Duplex: half or
full
2 dual-personality ports; each port can be used as either an RJ-45 10/100/1000 port
(IEEE 802.3 Type 10Base-T; IEEE 802.3u Type 100Base-Tx; IEEE 802.3ab
1000Base-T Gigabit Ethernet) or as a SFP slot (for use with SFP transceivers) ports

Additional ports
and slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 10.00(w) x 6.28(d) x 1.75(h) in (25.4 x 15.95 x 4.45 cm) (1U
height)

Weight 2.0 lb (0.91 kg)

Memory and
processor

Processor ARM9E @ 800 MHz, 128 MB flash; Packet buffer size: 1.5
MB dynamically allocated, 256 MB DDR3 DIMM
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Mounting and
enclosure

Mounts in an EIA-standard 19-inch telco rack or equipment cabinet (rack-mounting
kit available); horizontal surface mounting; wall mounting

Performance IPv6 Ready Certified

100 Mb Latency < 1.3 µs (LIFO 64-byte packets)

1000 Mb Latency < 1.3 µs (LIFO 64-byte packets)

Throughput up to 4.1 Mpps (64-byte packets)

Switching capacity 5.6 Gbps

MAC address table
size

16000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Non-operating/
Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Non-
operating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 0 dB, Pressure: 0 dB

Electrical
characteristics

Frequency 50/60 Hz

Maximum heat
dissipation

29 BTU/hr (30.6 kJ/hr), (switch only: 29 BTU/hr;
combined switch + max. PoE devices: 262 TU/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current 1.4 A

Maximum power
rating

76.7 W

Idle power 5.8 W

PoE power 67 W

NOTES Idle power is the actual power consumption of the device with
no ports connected.
Maximum power rating and maximum heat dissipation are the
worst-case theoretical maximum numbers provided for
planning the infrastructure with fully loaded PoE (if equipped),
100% traffic, all ports plugged in, and all modules populated.
PoE power is the total power budget available to all PoE
ports.

Safety UL 60950-1; CAN/CSA 22.2 No. 60950-1; EN 60825; IEC 60950-1; EN 60950-1

Emissions FCC Class A; EN 55022/CISPR-22 Class A; VCCI Class A

Immunity Generic EN 55024, CISPR 24

EN EN 55024, CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5
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Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

Harmonics EN 61000-3-2, IEC 61000-3-2

Flicker EN 61000-3-3, IEC 61000-3-3

Management IMC - Intelligent Management Center; command-line interface; Web browser;
configuration menu; out-of-band management (serial RS-232C or Micro USB);
IEEE 802.3 Ethernet MIB; Repeater MIB; Ethernet Interface MIB

NOTES IEEE 802.3az applies to Gigabit models only; IEEE 802.3at and IEEE 802.3af apply
to PoE+ models only. When using SFPs with this product, SFPs with revision "B" or
later (product number ends with the letter "B" or later, e.g., J4858B, J4859C) are
required.

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the service-level
descriptions and product numbers. For details about services and response times in
your area, please contact your local Hewlett Packard Enterprise sales office.

 
Aruba 2530 48G Switch (J9775A)

I/O ports and slots 48 RJ-45 autosensing 10/100/1000 ports (IEEE 802.3 Type 10BASE-T, IEEE
802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T); Duplex: 10BASE-
T/100BASE-TX: half or full; 1000BASE-T: full only
4 fixed Gigabit Ethernet SFP ports

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 17.44(w) x 10.00(d) x 1.75(h) in (44.3 x 25.4 x 4.45 cm) (1U
height)

Weight 6.8 lb (3.08 kg)

Memory and
processor

Processor ARM9E @ 800 MHz, 128 MB flash; Packet buffer size: 3 MB
dynamically allocated, 256 MB DDR3 DIMM

Mounting and
enclosure

Mounts in an EIA-standard 19-inch telco rack or equipment cabinet (rack-mounting
kit available); Horizontal surface mounting; Wall mounting

Performance IPv6 Ready Certified

100 Mb Latency < 7.4 µs (LIFO 64-byte packets)

1000 Mb Latency < 2.3 µs (LIFO 64-byte packets)

Throughput up to 77.3 Mpps (64-byte packets)

Switching capacity 104 Gbps

MAC address table
size

16000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

QuickSpecs Aruba 2530 Switch Series

Technical Specifications

DA - 14447   Worldwide QuickSpecs — Version 18 — 12/3/2018 Page  27

Anexo 01 ITEM 11 (0592657)         SEI 0008478-63.2018.6.02.8000 / pg. 5590

http://www.hpe.com/networking/services


Non-operating/
Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Non-
operating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 34.5 dB, Pressure: 31.0 dB

Electrical
characteristics

Frequency 50/60 Hz
Achieved Miercom Certified Green Award

Maximum heat
dissipation

203 BTU/hr (214.17 kJ/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current 1.2/0.7 A

Maximum power
rating

59.5 W

Idle power 29.5 W

NOTES Idle power is the actual power consumption of the device
with no ports connected.
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided for
planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all modules
populated.

Safety UL 60950-1; CAN/CSA 22.2 No. 60950-1; EN 60825; IEC 60950-1; EN 60950-1

Emissions FCC Class A; EN 55022/CISPR-22 Class A; VCCI Class A

Immunity Generic EN 55024, CISPR 24

EN EN 55024, CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

Harmonics EN 61000-3-2, IEC 61000-3-2

Flicker EN 61000-3-3, IEC 61000-3-3

Management IMC - Intelligent Management Center; command-line interface; Web browser;
configuration menu; out-of-band management (serial RS-232C or Micro USB);
IEEE 802.3 Ethernet MIB; Repeater MIB; Ethernet Interface MIB

NOTES IEEE 802.3az applies to Gigabit models only; IEEE 802.3at and IEEE 802.3af apply
to PoE+ models only. When using SFPs with this product, SFPs with revision "B" or
later (product number ends with the letter "B" or later, e.g., J4858B, J4859C) are
required.
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Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services
for details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
Aruba 2530 24G Switch (J9776A)

I/O ports and slots 24 RJ-45 autosensing 10/100/1000 ports (IEEE 802.3 Type 10BASE-T, IEEE
802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T)
Duplex: 10BASE-T/100BASE-TX: half or full; 1000BASE-T: full only
4 fixed Gigabit Ethernet SFP ports

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 17.44(w) x 10.00(d) x 1.75(h) in (44.3 x 25.4 x 4.45 cm) (1U
height)

Weight 6.1 lb (2.77 kg)

Memory and
processor

Processor ARM9E @ 800 MHz, 128 MB flash; Packet buffer size: 1.5
MB dynamically allocated, 256 MB DDR3 DIMM

Mounting and
enclosure

Mounts in an EIA-standard 19-inch telco rack or equipment cabinet (rack-mounting
kit available); Horizontal surface mounting; Wall mounting

Performance IPv6 Ready Certified

100 Mb Latency < 7.4 µs (LIFO 64-byte packets)

1000 Mb Latency < 2.3 µs (LIFO 64-byte packets)

Throughput up to 41.6 Mpps (64-byte packets)

Switching capacity 56 Gbps

MAC address table
size

16000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Non-operating/
Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Non-
operating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 34.0 dB, Pressure: 26.4 dB

Electrical
characteristics

Frequency 50/60 Hz

Maximum heat
dissipation

164 BTU/hr (173.02 kJ/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current .6/.4 A

Maximum power
rating

48.0 W

Idle power 28.8 W

QuickSpecs Aruba 2530 Switch Series

Technical Specifications

DA - 14447   Worldwide QuickSpecs — Version 18 — 12/3/2018 Page  29

Anexo 01 ITEM 11 (0592657)         SEI 0008478-63.2018.6.02.8000 / pg. 5592

http://www.hpe.com/networking/services


 

NOTES Idle power is the actual power consumption of the device
with no ports connected.
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided for
planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all modules
populated.

Safety UL 60950-1; CAN/CSA 22.2 No. 60950-1; EN 60825; IEC 60950-1; EN 60950-1

Emissions FCC Class A; EN 55022/CISPR-22 Class A; VCCI Class A

Immunity Generic EN 55024, CISPR 24

EN EN 55024, CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

Harmonics EN 61000-3-2, IEC 61000-3-2

Flicker EN 61000-3-3, IEC 61000-3-3

Management IMC - Intelligent Management Center; command-line interface; Web browser;
configuration menu; Out-of-band management (serial RS-232C or MicroUSB);
IEEE 802.3 Ethernet MIB; Repeater MIB; Ethernet Interface MIB

NOTES IEEE 802.3az applies to Gigabit models only; IEEE 802.3at and IEEE 802.3af apply
to PoE+ models only. When using SFPs with this product, SFPs with revision "B" or
later (product number ends with the letter "B" or later, e.g., J4858B, J4859C) are
required.

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services
for details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
Aruba 2530 8G Switch (J9777A)

I/O ports and slots 8 RJ-45 autosensing 10/100/1000 ports (IEEE 802.3 Type 10BASE-T, IEEE 802.3u
Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T); Media Type: Auto-MDIX;
Duplex: 10BASE-T/100BASE-TX: half or full;
1000BASE-T: full only
2 dual-personality ports; each port can be used as either an RJ-45 10/100/1000
port (IEEE 802.3 Type 10Base-T; IEEE 802.3u Type 100Base-Tx; IEEE 802.3ab
1000Base-T Gigabit Ethernet) or as a SFP slot (for use with SFP transceivers)
ports

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 10(w) x 6.28(d) x 1.75(h) in (25.4 x 15.95 x 4.45 cm) (1U
height)

Weight 2.0 lb (0.91 kg)
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Memory and
processor

Processor ARM9E @ 800 MHz, 128 MB flash; Packet buffer size: 1.5
MB dynamically allocated, 256 MB DDR3 DIMM

Mounting and
enclosure

Mounts in an EIA-standard 19-inch telco rack or equipment cabinet (rack-mounting
kit available); horizontal surface mounting; wall mounting

Performance IPv6 Ready Certified

100 Mb Latency < 7.4 µs (LIFO 64-byte packets)

1000 Mb Latency < 2.6 µs (LIFO 64-byte packets)

Throughput up to 14.8 Mpps (64-byte packets)

Switching capacity 20 Gbps

MAC address table
size

16000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Non-operating/
Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Non-
operating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 0 dB, Pressure: 0 dB

Electrical
characteristics

Frequency 50/60 Hz

Maximum heat
dissipation

63 BTU/hr (66.46 kJ/hr), (switch only: 63 BTU/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current 0.5 A

Maximum power
rating

18.6 W

Idle power 13.6 W

 

NOTES Idle power is the actual power consumption of the device
with no ports connected.
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided for
planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all modules
populated

Safety UL 60950-1; CAN/CSA 22.2 No. 60950-1; EN 60825; IEC 60950-1; EN 60950-1

Emissions FCC Class A; EN 55022/CISPR-22 Class A; VCCI Class A

Immunity Generic EN 55024, CISPR 24

EN EN 55024, CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5
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Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

Harmonics EN 61000-3-2, IEC 61000-3-2

Flicker EN 61000-3-3, IEC 61000-3-3

Management IMC - Intelligent Management Center; command-line interface; Web browser;
configuration menu; Out-of-band management (serial RS-232C or MicroUSB);
IEEE 802.3 Ethernet MIB; Repeater MIB; Ethernet Interface MIB

NOTES IEEE 802.3az applies to Gigabit models only; IEEE 802.3at and IEEE 802.3af apply
to PoE+ models only. When using SFPs with this product, SFPs with revision "B" or
later (product number ends with the letter "B" or later, e.g., J4858B, J4859C) are
required.

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services
for details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
Aruba 2530 48 Switch (J9781A)

I/O ports and slots 48 RJ-45 autosensing 10/100 ports (IEEE 802.3 Type 10BASE-T, IEEE 802.3u
Type 100BASE-TX); Duplex: half or full
2 autosensing 10/100/1000 ports (IEEE 802.3 Type 10BASE-T, IEEE 802.3u Type
100BASE-TX, IEEE 802.3ab Type 1000BASE-T); Duplex: 10BASE-T/100BASE-
TX: half or full; 1000BASE-T: full only
2 fixed Gigabit Ethernet SFP ports

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 17.40(w) x 9.70(d) x 1.75(h) in (44.2 x 24.64 x 4.45 cm) (1U
height)

Weight 6.3 lb (2.86 kg)

Memory and
processor

Processor ARM9E @ 800 MHz, 128 MB flash; Packet buffer size: 3 MB
dynamically allocated, 256 MB DDR3 DIMM

Mounting and
enclosure

Mounts in an EIA-standard 19-inch telco rack or equipment cabinet (rack-mounting
kit available); Horizontal surface mounting; Wall mounting

Performance IPv6 Ready Certified

100 Mb Latency < 6.6 µs (LIFO 64-byte packets)

1000 Mb Latency < 2.2 µs (LIFO 64-byte packets)

Throughput up to 13 Mpps (64-byte packets)

Switching capacity 17.6 Gbps

MAC address table
size

16000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing
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Non-operating/
Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Non-
operating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 0 dB, Pressure: 0 dB

Electrical
characteristics

Frequency 50/60 Hz

Maximum heat
dissipation

102 BTU/hr (107.61 kJ/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current 0.7/0.4 A

Maximum power
rating

29.9 W

Idle power 17.1 W

 

NOTES Idle power is the actual power consumption of the device
with no ports connected.
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided for
planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all modules
populated.

Safety UL 60950-1; CAN/CSA 22.2 No. 60950-1; EN 60825; IEC 60950-1; EN 60950-1

Emissions FCC Class A; EN 55022/CISPR-22 Class A; VCCI Class A

Immunity Generic EN 55024, CISPR 24

EN EN 55024, CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

Harmonics EN 61000-3-2, IEC 61000-3-2

Flicker EN 61000-3-3, IEC 61000-3-3

Management IMC - Intelligent Management Center; command-line interface; Web browser;
configuration menu; Out-of-band management (serial RS-232C or MicroUSB);
IEEE 802.3 Ethernet MIB; Repeater MIB; Ethernet Interface MIB

NOTES IEEE 802.3az applies to Gigabit models only; IEEE 802.3at and IEEE 802.3af apply
to PoE+ models only. When using SFPs with this product, SFPs with revision "B" or
later (product number ends with the letter "B" or later, e.g., J4858B, J4859C) are
required.
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Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services
for details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
Aruba 2530 24 Switch (J9782A)

I/O ports and slots 24 RJ-45 autosensing 10/100 ports (IEEE 802.3 Type 10BASE-T, IEEE 802.3u
Type 100BASE-TX); Duplex: half or full
2 autosensing 10/100/1000 ports (IEEE 802.3 Type 10BASE-T, IEEE 802.3u Type
100BASE-TX, IEEE 802.3ab Type 1000BASE-T); Duplex: 10BASE-T/100BASE-
TX: half or full; 1000BASE-T: full only
2 fixed Gigabit Ethernet SFP ports

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 17.40(w) x 9.70(d) x 1.75(h) in (44.2 x 24.64 x 4.45 cm) (1U
height)

Weight 5.7 lb (2.59 kg)

Memory and
processor

Processor ARM9E @ 800 MHz, 128 MB flash; Packet buffer size: 1.5
MB dynamically allocated, 256 MB DDR3 DIMM

Mounting and
enclosure

Mounts in an EIA-standard 19-inch telco rack or equipment cabinet (rack-mounting
kit available); Horizontal surface mounting; Wall mounting

Performance IPv6 Ready Certified

100 Mb Latency < 1.7 µs (LIFO 64-byte packets)

1000 Mb Latency < 1.1 µs (LIFO 64-byte packets)

Throughput up to 9.5 Mpps (64-byte packets)

Switching capacity 12.8 Gbps

MAC address table
size

16000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Non-operating/
Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Non-
operating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 0 dB, Pressure: 0 dB

Electrical
characteristics

Frequency 50/60 Hz

Maximum heat
dissipation

50 BTU/hr (52.75 kJ/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current 0.3/0.2 A
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Maximum power
rating

14.7 W

Idle power 8.4 W

 

NOTES Idle power is the actual power consumption of the device
with no ports connected.
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided for
planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all modules
populated.

Safety UL 60950-1; CAN/CSA 22.2 No. 60950-1; EN 60825; IEC 60950-1; EN 60950-1

Emissions FCC Class A; EN 55022/CISPR-22 Class A; VCCI Class A

Immunity Generic EN 55024, CISPR 24

EN EN 55024, CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

Harmonics EN 61000-3-2, IEC 61000-3-2

Flicker EN 61000-3-3, IEC 61000-3-3

Management IMC - Intelligent Management Center; command-line interface; Web browser;
configuration menu; Out-of-band management (serial RS-232C or MicroUSB);
IEEE 802.3 Ethernet MIB; Repeater MIB; Ethernet Interface MIB

NOTES IEEE 802.3az applies to Gigabit models only; IEEE 802.3at and IEEE 802.3af apply
to PoE+ models only. When using SFPs with this product, SFPs with revision "B" or
later (product number ends with the letter "B" or later, e.g., J4858B, J4859C) are
required.

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services
for details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
Aruba 2530 8 Switch (J9783A)

I/O ports and slots 8 RJ-45 autosensing 10/100 ports (IEEE 802.3 Type 10BASE-T, IEEE 802.3u Type
100BASE-TX); Media Type: Auto-MDIX; Duplex: half or full
2 dual-personality ports; each port can be used as either an RJ-45 10/100/1000
port (IEEE 802.3 Type 10Base-T; IEEE 802.3u Type 100Base-Tx; IEEE 802.3ab
1000Base-T Gigabit Ethernet) or as a SFP slot (for use with SFP transceivers)
ports

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port
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Physical
characteristics

Dimensions 10.00(w) x 6.28(d) x 1.75(h) in (25.4 x 15.95 x 4.45 cm) (1U
height)

Weight 1.8 lb (0.82 kg)

Memory and
processor

Processor ARM9E @ 800 MHz, 128 MB flash; Packet buffer size: 1.5
MB dynamically allocated, 256 MB DDR3 DIMM

Mounting and
enclosure

Mounts in an EIA-standard 19-inch telco rack or equipment cabinet (rack-mounting
kit available); horizontal surface mounting; wall mounting

Performance IPv6 Ready Certified

100 Mb Latency < 1.3 µs (LIFO 64-byte packets)

1000 Mb Latency < 1.3 µs (LIFO 64-byte packets)

Throughput up to 4.1 Mpps (64-byte packets)

Switching capacity 5.6 Gbps

MAC address table
size

16000 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Non-operating/
Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Non-
operating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 0 dB, Pressure: 0 dB

Electrical
characteristics

Frequency 50/60 Hz

Maximum heat
dissipation

25 BTU/hr (26.38 kJ/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current 0.5 A

Maximum power
rating

7.2 W

Idle power 4.5 W

 

NOTES Idle power is the actual power consumption of the device
with no ports connected.
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided for
planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all modules
populated.

Safety UL 60950-1; CAN/CSA 22.2 No. 60950-1; EN 60825; IEC 60950-1; EN 60950-1

Emissions FCC Class A; EN 55022/CISPR-22 Class A; VCCI Class A

Immunity Generic EN 55024, CISPR 24

EN EN 55024, CISPR 24

ESD IEC 61000-4-2
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Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

Harmonics EN 61000-3-2, IEC 61000-3-2

Flicker EN 61000-3-3, IEC 61000-3-3

Management IMC - Intelligent Management Center; command-line interface; Web browser;
configuration menu; Out-of-band management (serial RS-232C or MicroUSB);
IEEE 802.3 Ethernet MIB; Repeater MIB; Ethernet Interface MIB

NOTES IEEE 802.3az applies to Gigabit models only; IEEE 802.3at and IEEE 802.3af apply
to PoE+ models only. When using SFPs with this product, SFPs with revision "B" or
later (product number ends with the letter "B" or later, e.g., J4858B, J4859C) are
required.

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services
for details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
Aruba 2530 8 PoE+ Internal PS Switch (JL070A)

I/O ports and slots 8 RJ-45 autosensing 10/100 PoE+ ports (IEEE 802.3 Type 10BASE-T, IEEE
802.3u Type 100BASE-TX, IEEE 802.3at PoE+); Media Type: Auto-MDIX; Duplex:
half or full
2 dual-personality ports; each port can be used as either an RJ-45 10/100/1000
port (IEEE 802.3 Type 10Base-T; IEEE 802.3u Type 100Base-Tx; IEEE 802.3ab
1000Base-T Gigabit Ethernet) or as a SFP slot (for use with SFP transceivers)
ports

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 10(w) x 9.68(d) x 1.75(h) in (25.4 x 24.59 x 4.45 cm) (1U
height)

Weight 4.65 lb (2.11 kg)

Memory and
processor

Processor ARM9E @ 800 MHz, 128 MB flash; Packet buffer size: 1.5
MB dynamically allocated, 256 MB DDR3 DIMM

Mounting and
enclosure

Mounts in an EIA-standard 19-inch telco rack or equipment cabinet (rack-mounting
kit available); Horizontal surface mounting; Wall mounting

Performance IPv6 Ready Certified

100 Mb Latency < 1.3 µs (LIFO 64-byte packets)

1000 Mb Latency < 1.3 µs (LIFO 64-byte packets)

10 Gbps Latency  

Throughput up to 4.1 Mpps (64-byte packets)

Switching capacity 5.6 Gbps

MAC address table
size

16000 entries
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Environment Operating
temperature

32°F to 113°F (0°C to 45°C)

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Non-operating/
Storage
temperature

-40°F to 158°F (-40°C to 70°C)

Non-
operating/Storage
relative humidity

15% to 90% @ 149°F (65°C), noncondensing

Altitude up to 10,000 ft (3 km)

Acoustic Power: 0 dB, Pressure: 0 dB

Electrical
characteristics

Frequency 50/60 Hz

Maximum heat
dissipation

29 BTU/hr (30.6 kJ/hr), (switch only: 29 BTU/hr; combined
switch + max. PoE devices: 239 BTU/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current 0.9/0.5 A

Maximum power
rating

70.2 W

Idle power 5.3 W

PoE Power 67 W PoE

NOTES Idle power is the actual power consumption of the device
with no ports connected.
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided for
planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all modules
populated.
PoE power is the total power budget available to all PoE
ports.

Safety UL 60950-1; CAN/CSA 22.2 No. 60950-1; EN 60825; IEC 60950-1; EN 60950-1

Emissions FCC Class A; EN 55022/CISPR-22 Class A; VCCI Class A

Immunity Generic EN 55024, CISPR 24

EN EN 55024, CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

Harmonics EN 61000-3-2, IEC 61000-3-2

Flicker EN 61000-3-3, IEC 61000-3-3
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Management Imc - intelligent management center; Command-line interface; Web browser;
Configuration menu; Out-of-band management (serial rs-232c or micro usb); Ieee
802.3 ethernet mib; Repeater mib; Ethernet interface mib

NOTES IEEE 802.3az applies to Gigabit models only; IEEE 802.3at and IEEE 802.3af apply
to PoE+ models only.
When using SFPs with this product, SFPs with revision "B" or later (product number
ends with the letter "B" or later, e.g., J4858B, J4859C) are required.

Services Refer to the Hewlett Packard Enterprise website at http://www.hpe.com/networking/services
for details on the service-level descriptions and product numbers. For details about services and
response times in your area, please contact your local Hewlett Packard Enterprise sales office.

 
Standards and protocols (applies to all products in series)

Denial of service protection Network DoS Filter

Device Management RFC 1591 DNS (client)
RFC 2576 (Coexistence between SNMP V1, V2, V3)
RFC 2579 (SMIv2 Text Conventions)
RFC 2580 (SMIv2 Conformance)
RFC 3416 (SNMP Protocol Operations v2)
RFC 3417 (SNMP Transport Mappings)
SSHv1/SSHv2 Secure Shell

General Protocols IEEE 802.1D MAC Bridges
IEEE 802.1p Priority
IEEE 802.1Q VLANs
IEEE 802.1s Multiple Spanning Trees
IEEE 802.1w Rapid Reconfiguration of Spanning Tree
IEEE 802.3 Type 10BASE-T
IEEE 802.3ab 1000BASE-T
IEEE 802.3ad Link Aggregation Control Protocol (LACP)
IEEE 802.3af Power over Ethernet
IEEE 802.3at Power over Ethernet Plus
IEEE 802.3az Energy Efficient Ethernet
IEEE 802.3x Flow Control
RFC 768 UDP
RFC 783 TFTP Protocol (revision 2)
RFC 792 ICMP
RFC 793 TCP
RFC 826 ARP
RFC 854 TELNET
RFC 868 Time Protocol
RFC 951 BOOTP
RFC 1350 TFTP Protocol (revision 2)
RFC 1542 BOOTP Extensions
RFC 1918 Address Allocation for Private Internet
RFC 2030 Simple Network Time Protocol (SNTP) v4
RFC 2131 DHCP
RFC 3411 An Architecture for Describing Simple Network Management
Protocol (SNMP) Management Frameworks
RFC 3412 Message Processing and Dispatching for the Simple Network
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Management Protocol (SNMP)
RFC 3413 Simple Network Management Protocol (SNMP) Applications
RFC 3414 User-based Security Model (USM) for version 3 of the Simple
Network Management Protocol (SNMPv3)
RFC 3415 View-based Access Control Model (VACM) for the Simple
Network Management Protocol (SNMP)
RFC 3416 Protocol Operations for SNMP
RFC 3575 IANA Considerations for RADIUS
RFC 5905 Network Time Protocol Version 4: Protocol and Algorithms
Specification

IP Multicast RFC 2236 IGMPv2

IPv6 RFC 1981 IPv6 Path MTU Discovery
RFC 2460 IPv6 Specification
RFC 2464 Transmission of IPv6 over Ethernet Networks
RFC 2925 Remote Operations MIB (Ping only)
RFC 3315 DHCPv6 (client only)
RFC 3484 Default Address Selection for IPv6
RFC 3513 IPv6 Addressing Architecture
RFC 3596 DNS Extension for IPv6
RFC 3810 Multicast Listener Discovery Version 2 (MLDv2) for IPv6
RFC 4022 MIB for TCP
RFC 4113 MIB for UDP
RFC 4251 SSHv6 Architecture
RFC 4252 SSHv6 Authentication
RFC 4252 SSHv6 Transport Layer
RFC 4254 SSHv6 Connection
RFC 4291 IP Version 6 Addressing Architecture
RFC 4293 MIB for IP
RFC 4419 Key Exchange for SSH
RFC 4443 ICMPv6
RFC 4861 IPv6 Neighbor Discovery
RFC 4862 IPv6 Stateless Address Auto-configuration
RFC 5095 Deprecation of Type 0 Routing Headers in IPv6

MIBs RFC 1155 Structure & ID of Mgmt Info for TCP/IP Internets
RFC 1212 Concise MIB Definitions
RFC 1213 MIB II
RFC 1493 Bridge MIB
RFC 2021 RMONv2 MIB
RFC 2578 Structure of Management Information Version 2 (SMIv2)
RFC 2579 Textual Conventions for SMIv2
RFC 2613 SMON MIB
RFC 2618 RADIUS Client MIB
RFC 2620 RADIUS Accounting Client MIB
RFC 2665 Ethernet-Like-MIB
RFC 2668 802.3 MAU MIB
RFC 2674 802.1p and IEEE 802.1Q Bridge MIB
RFC 2737 Entity MIB (Version 2)
RFC 2863 The Interfaces Group MIB
RFC 4836 Managed Objects for 802.3 Medium Attachment Units (MAU)
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Network Management IEEE 802.1AB Link Layer Discovery Protocol (LLDP)
RFC 1098 A Simple Network Management Protocol (SNMP)
RFC 1155 Structure of Management Information
RFC 2819 Four groups of RMON: 1 (statistics), 2 (history), 3 (alarm) and 9
(events)
RFC 3411 SNMP Management Frameworks
RFC 3412 Message Processing and Dispatching for the Simple Network
Management Protocol (SNMP)
RFC 3413 Simple Network Management Protocol (SNMP) Applications
RFC 3414 User-based Security Model (USM) for version 3 of the Simple
Network Management Protocol (SNMPv3)
RFC 3415 View-based Access Control Model (VACM) for the Simple
Network Management Protocol (SNMP)
RFC 3418 Management Information Base (MIB) for the Simple Network
Management Protocol (SNMP)
RFC 5424 Syslog Protocol
ANSI/TIA-1057 LLDP Media Endpoint Discovery (LLDP-MED)
SNMPv1/v2c/v3

QoS/CoS RFC 2474 DiffServ precedence, with 4 queues per port
RFC 2475 DiffServ Architecture
RFC 2597 DiffServ Assured Forwarding (AF)
RFC 2598 DiffServ Expedited Forwarding (EF)

Security IEEE 802.1X Port Based Network Access Control
RFC 1492 TACACS+
RFC 2138 RADIUS Authentication
RFC 2866 RADIUS Accounting
Secure Sockets Layer (SSL)
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Aruba 2530 Switch Series accessories  
   

Transceivers

Aruba 100M SFP LC FX 2km MMF Transceiver J9054D
Aruba 1G SFP RJ45 T 100m Cat5e Transceiver J8177D
Aruba 1G SFP LC SX 500m OM2 MMF Transceiver J4858D
Aruba 1G SFP LC LX 10km SMF Transceiver J4859D
Aruba 1G SFP LC LH 70km SMF Transceiver J4860D
   
Cables  

Aruba X2C2 RJ45 to DB9 Console Cable JL448A
   
Mounting Kit  

HPE X410 1U Universal 4-post Rackmount Kit J9583A
   
Aruba 2530 8G PoE+ Switch (J9774A)  

Aruba 2530 8-port Switch Pwr Adptr Shelf J9820A
Aruba X510 1U Cable Guard J9700A
   
Aruba 2530 8 PoE+ Switch (J9780A)  

Aruba 2530 8-port Switch Pwr Adptr Shelf J9820A
Aruba X510 1U Cable Guard J9700A
   
Aruba 2530 8G Switch (J9777A)  

Aruba 2530 8-port Switch Pwr Adptr Shelf J9820A
Aruba X510 1U Cable Guard J9700A
   
Aruba 2530 8 Switch (J9783A)  

Aruba 2530 8-port Switch Pwr Adptr Shelf J9820A
Aruba X510 1U Cable Guard J9700A
   
Aruba 2530 8 PoE+ Internal PS Switch (JL070A)  

Aruba X510 1U Cable Guard J9700A
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NOTE:  Details are not available for all accessories. The following specifications were available at the time
of publication.

 
HPE X111 100M SFP LC
FX Transceiver
(J9054C)

 

Ports 1 LC 100BASE-FX port (IEEE 802.3u Type 100BASE-FX);
Duplex: half or full

Physical
characteristics

Dimensions: 2.7(d) x 0.54(w) x 0.48(h) in. (6.86 x 1.38 x 1.22
cm)
Weight: 0.06 lb. (0.03 kg)

Environment Operating temperature: 32ºF to 158ºF (0ºC to 70ºC)
Operating relative humidity: 5% to 95%
Nonoperating/Storage temperature: -40ºF to 185ºF (-40ºC to
85ºC)
Nonoperating/Storage relative humidity: 5% to 85%
Altitude: up to 10,000 ft. (3 km)

Cabling Type:

62.5/125 µm or 50/125 µm (core/cladding) diameter,
graded-index, low metal content, multimode fiber optic,
complying with ITU-T G.651 and ISO/IEC 793-2 Type
A1b or A1a, respectively

Maximum distance:

2 km (full duplex) or 412 m (half duplex)
NOTES Transmitter wavelength: 1310nm

Power consumption is 1.1 watt maximum.

For supported platforms and minimum software requirements to support
this product, see the document titled "Support for the J9054C 100-FX
SFP-LC Transceiver" on the "HPE Mini-GBICs and SFPs" Manuals Web
page.

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the
service-level descriptions and product numbers. For details
about services and response times in your area, please
contact your local Hewlett Packard Enterprise sales office.
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HPE X112 100M SFP
LC BX-D Transceiver
(J9099B)

A small form-factor
pluggable (SFP) 100-
Megabit BX (bi-
directional)
"downstream"
transceiver that
provides 100 Mbps full-
duplex connectivity up
to 10 km on one strand
of singlemode fiber.
The J9099B connects
to the J9100B
"upstream" transceiver,
or to any IEEE-standard
100BASE-BX10-U
("upstream") device.

Ports 1 LC 100BASE-BX10 port (IEEE 802.3ah Type 100BASE-
BX10-D); Duplex: full only

Physical
characteristics

Dimensions 2.7(d) x 0.55(w) x 0.48(h) in. (6.86 x
1.39 x 1.22 cm)

Weight 0.04 lb. (0.03 kg)

Environment Operating temperature 32ºF to 158ºF (0ºC to 70ºC)

Operating relative
humidity

0% to 95%, noncondensing

Nonoperating/Storage
temperature

-40ºF to 185ºF (-40ºC to 85ºC)

Cabling Type:

Single-mode fiber optic, complying with ITU-T G.652;

Maximum distance:

0.5-10,000 m (single-mode fiber)
NOTES Transmit wavelength: 1550 nm. Receive wavelength: 1310 nm.

Power consumption is 1.1 watt maximum.
For supported platforms and minimum software requirements to
support this product, see the document titled "Support for the
HPE BX Transceivers" on the "HPE Mini-GBICs and SFPs"
Manuals Web page.
The J9099B connects to the J9100B "upstream" transceiver, or
to any IEEE-standard 100BASE-BX10-U ("upstream") device. (A
100-BX-D transceiver can only connect to a 100-BX-U product.
You cannot connect two 100-BX-D transceivers together.)

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the
service-level descriptions and product numbers. For details
about services and response times in your area, please contact
your local Hewlett Packard Enterprise sales office.

 
HPE X112 100M SFP
LC BX-U Transceiver
(J9100B)

A small form-factor
pluggable (SFP) 100-
Megabit BX (bi-
directional) "upstream"
transceiver that
provides 100 Mbps full-
duplex connectivity up
to 10 km on one strand
of singlemode fiber.
The J9100B connects
to the J9099B
"downstream"
transceiver, or to any
IEEE-standard
100BASE-BX10-D

Ports 1 LC 100BASE-BX10 port (IEEE 802.3ah Type 100BASE-
BX10-U); Duplex: full only

Physical
characteristics

Dimensions 2.7(d) x 0.55(w) x 0.48(h) in. (6.86 x
1.39 x 1.22 cm)

Weight 0.07 lb. (.03 kg)

Environment Operating temperature 32ºF to 158ºF (0ºC to 70ºC)

Operating relative
humidity

0% to 95%, noncondensing

Nonoperating/Storage
temperature

-40ºF to 185ºF (-40ºC to 85ºC)

Cabling Type:

Single-mode fiber optic, complying with ITU-T G.652;

Maximum distance:
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("downstream")
device.

0.5-10,000 m (single-mode fiber)
NOTES For supported platforms and minimum software requirements to

support this product, see the document titled "Support for the
HPE BX Transceivers" on the "HPE Mini-GBICs and SFPs"
Manuals Web page.
The J9100B connects to the J9099B "downstream" transceiver,
or to any IEEE-standard 100BASE-BX10- D ("downstream")
device. (A 100-BX-U transceiver can only connect to a 100-BX-
D product. You cannot connect two 100-BX-U transceivers
together.)
Transmit wavelength: 1310 nm. Receive wavelength: 1550 nm.
Power consumption is 1.1 watts maximum.

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the
service-level descriptions and product numbers. For details
about services and response times in your area, please contact
your local Hewlett Packard Enterprise sales office.

 
HPE X121 1G SFP LC
SX Transceiver
(J4858C)

A small form-factor
pluggable (SFP) Gigabit
SX
transceiver that provides
a full-duplex Gigabit
solution
up to 550 m on
multimode fiber.

Ports 1 LC 1000BASE-SX port; Duplex: full only
Physical
characteristics

Dimensions: 2.24(d) x 0.54(w) x 0.48(h) in. (5.69 x 1.37 x 1.22
cm)
Weight: 0.04 lb. (0.02 kg)
Transceiver form factor: SFP

Environment Operating temperature: 32°F to 158°F (0°C to 70°C)
Operating relative humidity: 5% to 85%, noncondensing
Nonoperating/Storage temperature: -40°F to 203°F (-40°C to
85°C)
Altitude: up to 10,000 ft. (3 km)

Electrical
characteristics

Power consumption typical: 0.4 W
Power consumption maximum: 0.7 W

Cabling Type:

62.5/125 µm or 50/125 µm (core/cladding) diameter,
graded-index, low metal content, multimode fiber optic,
complying with ITU-T G.651 and ISO/IEC 793-2 Type
A1b or A1a, respectively;

Maximum distance:

2-220 m (62.5 µm core diameter, 160 MHz*km bandwidth
2-275 m (62.5 µm core diameter, 200 MHz*km bandwidth
2-500 m (50 µm core diameter, 400 MHz*km bandwidth)
2-550 m (50 µm core diameter, 500 MHz*km bandwidth)

Cable length: 2-550m
Fiber type: Multi Mode

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the
service-level descriptions and product numbers. For details
about services and response times in your area, please
contact your local Hewlett Packard Enterprise sales office.
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HPE X121 1G SFP LC
LX Transceiver
(J4859C)

HP X121 1G SFP LC LX
Transceiver: An SFP
format
gigabit transceiver with
LC connectors using LX
technology.

Ports 1 LC 1000BASE-LX port (IEEE 802.3z Type 1000BASE-LX);
Duplex: full only

Physical
characteristics

Dimensions: 2.24(d) x 0.54(w) x 0.486(h) in. (5.69 x 1.37 x
1.23 cm)
Weight:0.04 lb. (0.02 kg)

Environment Operating temperature: 32°F to 158°F (0°C to 70°C)
Operating relative humidity: 0% to 85%, noncondensing
Nonoperating/Storage temperature: -40°F to 212°F (-40°C to
100°C)
Altitude: up to 10,000 ft. (3 km)

Cabling Type:

Either single mode or multimode; 62.5/125 µm or 50/125
µm (core/cladding) diameter, graded-index, low metal
content, multimode fiber optic, complying with ITU-T
G.651 and ISO/IEC 793-2 Type A1b or A1a, respectively;
Low metal content, single-mode fiber-optic, complying
with ITU-T G.652 and ISO/IEC 793-2 Type B1;

Maximum distance:

2-550 m (multimode 62.5 µm core diameter, 500 MHz*km
bandwidth)
2-550 m (multimode 50 µm core diameter, 400 MHz*km
bandwidth)
2-550 m (multimode 50 µm core diameter, 500 MHz*km
bandwidth)
2-10,000 m (single-mode fiber)

NOTES A mode conditioning patch cord may be needed in some
multimode fiber installations.
Wavelength: 1310nm
Power Consumption: < 500mW Typical

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the
service-level descriptions and product numbers. For details
about services and response times in your area, please
contact your local Hewlett Packard Enterprise sales office.
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HPE X121 1G SFP LC
LH Transceiver
(J4860C)

A small form-factor
pluggable (SFP) Gigabit
LH transceiver that
provides a full-duplex
Gigabit solution up to 70
km on single-mode fiber.

Ports 1 LC 1000BASE-LH port (no IEEE standard exists for 1550 nm
optics); Duplex: full only

Physical
characteristics

Dimensions: 2.17(d) x 0.60(w) x 0.46(h) in. (5.5 x 1.53 x 1.18
cm)
Weight: 0.04 lb. (0.02 kg)

Environment Operating temperature: -40°F to 185°F (-40°C to 85°C)
Operating relative humidity: 0% to 95% @ 77°F (25°C),
noncondensing
Nonoperating/Storage temperature: -40°F to 185°F (-40°C to
85°C)
Altitude: up to 10,000 ft. (3 km)

Cabling Cable type:

Low metal content, single-mode fiber-optic, complying
with ITU-T G.652 and ISO/IEC 793-2 Type B1;

Maximum distance:

10-70,000 m (single-mode fiber)
NOTES Power consumption is 0.8 watts typical with 1 watt maximum at

100% utilization.
For distances less than 20 km, a 10 dB attenuator must be
used.
For distances between 20 km and 40 km, a 5 dB attenuator
must be used.
Attenuators can be purchased from most cable vendors.

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the
service-level descriptions and product numbers. For details
about services and response times in your area, please
contact your local Hewlett Packard Enterprise sales office.

 
 
HPE X121 1G SFP
RJ45 T Transceiver
(J8177C)

A small form-factor
pluggable (SFP) Gigabit
copper transceiver that
provides a full-duplex
Gigabit solution up to
100 m on Category 5 or
better cable

Ports 1 RJ-45 1000BASE-T port (IEEE 802.3ab Type 1000BASE-T);
Duplex: full only

Physical
characteristics

Dimensions: 0.54(w) x 2.71(d) x 0.55(h) in (1.37 x 6.88 x 1.4
cm)
Weight: 0.06 lb (0.03 kg)

Environment Operating temperature: 32°F to 158°F (0°C to 70°C); with 100
LFM airflow over the SFP module
Operating relative humidity: 0% to 95% @ 75°F (25°C),
noncondensing
Nonoperating/Storage temperature: -40°F to 185°F (-40°C to
85°C)
Nonoperating/Storage relative humidity: 0% to 95% @ 77°F
(25°C), noncondensing
Altitude: up to 10,000 ft. (3000 km)

Cabling Cable type:
1000BASE-T: Category 5 (5E or better recommended), 100 ' differential
4-pair unshielded twisted pair (UTP) or shielded twisted pair (STP)
balanced, complying with IEEE 802.3ab 1000BASE-T;
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Maximum distance:

100 m
NOTES Power consumption is nominally 1 watt.

For supported platforms and minimum software requirements to support
this product, see the document titled "Support for the J8177C
1000Base-T Mini-GBIC" on the "HPE Mini-GBICs and SFPs" Manuals
Web page.
The J8177C Gigabit copper mini-GBIC is not supported on dual-
personality ports.
The J8177C is capable of 100 Mb operation. This is supported on only
the HPE ProCurve Switch 8200zl, 5400zl, and 6200yl Series using
software version K.12.21 or later. Use the "auto-100" port setting to
enable 100 Mb operation.
Important: Important: The earlier J8177B does not support 100 Mb
operation.
When used in the ProCurve Switch gl 20-Port 10/100/1000 Module
(J4908A), the J8177C mini-GBIC can be installed in either the upper or
lower mini-GBIC port, but will block access to the other port.

 
HPE X410 1U Universal 4-post Rackmount Kit (J9583A)

NOTES The rack mounting kit supports the 1U, full width switches in the following switch series and the
power supply: V1810 Series, E2510 Series, E2520 Series, E2610 Series, E2810 Series, E2910
Series, E3500 Series, and the E620 Power Supply
This universal rack mounting kit is design to fit the following racks: HPE 10K 10642, HPE 10K
10842, Panduit CN, Panduit CS, Wrightline Vantage S2, APC Netshelter 600mm, and APC
Netshelter 800mm. It may well fit many other brands and models too.

Services Refer to the Hewlett Packard Enterprise website at:
http://www.hpe.com/networking/services for details on the service-level
descriptions and product numbers. For details about services and response times in
your area, please contact your local Hewlett Packard Enterprise sales office.

 
Aruba 2530 8-port
Switch Pwr Adptr Shelf
(J9820A)

Physical
characteristics

  6.75(w) x 5.25(d) x 1.75(h) in (17.15 x
13.34 x 4.45 cm) (1U height)

Weight 0.6 lb (0.27 kg)
NOTES The HPE 2530 8-Port Switch Power Adapter Shelf is an accessory for

the HPE 2530 8-port switches. The shelf mounts on the back of the
switch providing a place to hold the external power adapter.

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the
service-level descriptions and product numbers. For details
about services and response times in your area, please
contact your local Hewlett Packard Enterprise sales office.
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Date Version History Action Description of Change
03-Dec-2018 Version 18 Changed Features and Benefits updated
02-Jul-2018 Version 17 Changed Software feature update
05-Feb-2018 Version 16 Changed Updates made on Technical Specifications and

Configuration
08-Jan-2018 Version 15 Changed Software feature update
03-Jul-2017 Version 14 Added SKU added: JL448A
01-Aug-2016 Version 13 Changed Adding #AC3 Option on Configuration Menu
06-June-2016 Version 12 Changed Overview, Features and Benefits, Technical

Specifications, and Accessories updated. SKU
descriptions updated.

08-Jan-2016 Version 11 Changed URLs updated
01-Dec-2015 Version 10 Changed QuickSpecs name changed to Aruba 2530

Switch Series
Overview, Features and Benefits, Accessories
updated

30-Mar-2015 Version 9 Added Added new SKU:
JL070A

Changed Changes made in the Overview, Technical
Specifications, and Accessories sections.

01-Dec-2014 Version 8 Changed Updated Warranty and support, updated
technical specifications

18-Aug-2014 Version 7 Added Added 4 new models: J9856A, J9854A,
J9855A, J9853A

Changed Changes made on the entire QS.
09-Dec-2013 Version 6 Changed Changes made in the Overview, Technical

Specifications, and Accessories sections.
12-Nov-2013 Version 5 Changed Build to Order, Rack Level Integration CTO

Models, and Cables were revised.
27-Sep-2013 Version 4 Changed Change made to the Configuration Section -

Rack Mount Kit
17-Sep-2013 Version 3 Changed Corrected an issue with the EMEA HTML file.
10-Jun-2013 Version 2 Changed Changes made to the following:

Added several new models
Updated Accessories
Added the new Configuration section
Updated Features and Benefits

       

QuickSpecs Aruba 2530 Switch Series

Summary of Changes

DA - 14447   Worldwide QuickSpecs — Version 18 — 12/3/2018 Page  49

Anexo 01 ITEM 11 (0592657)         SEI 0008478-63.2018.6.02.8000 / pg. 5612



     

Sign up for updates

 

 
  © Copyright 2018 Hewlett Packard Enterprise Development LP. The

information contained herein is subject to change without notice. The only
warranties for Hewlett Packard Enterprise products and services are set forth
in the express warranty statements accompanying such products and services.
Nothing herein should be construed as constituting an additional warranty.
Hewlett Packard Enterprise shall not be liable for technical or editorial errors or
omissions contained herein.

To learn more, visit http://www.hpe.com/networking

Microsoft is a U.S. registered trademark of the Microsoft group of companies.

c04111414 - 14447 - Worldwide  - V18 - 3-December-2018

 

QuickSpecs Aruba 2530 Switch Series

Summary of Changes

DA - 14447   Worldwide QuickSpecs — Version 18 — 12/3/2018 Page  50

Anexo 01 ITEM 11 (0592657)         SEI 0008478-63.2018.6.02.8000 / pg. 5613

http://www.facebook.com/sharer.php?u=https://www.hpe.com/h20195/V2/GetDocument.aspx?docname=c04111414
http://twitter.com/home/?status=Aruba%202530%20Switch%20Series+@+https://www.hpe.com/h20195/V2/GetDocument.aspx?docname=c04111414
http://www.linkedin.com/shareArticle?mini=true&ro=true&url=https://www.hpe.com/h20195/V2/GetDocument.aspx?docname=c04111414&title=Aruba%202530%20Switch%20Series+&armin=armin
http://h41370.www4.hpe.com/quickspecs/contact-us.html
http://www.hpe.com/info/getupdated
http://www.hpe.com/networking


Aruba Basic Operation Guide for
ArubaOS-Switch 16.05

Part Number: 5200-4194
Published: December 2017
Edition: 1

Anexo 02 ITEM 11 (0592659)         SEI 0008478-63.2018.6.02.8000 / pg. 5614



© Copyright 2017 Hewlett Packard Enterprise Development LP

Notices
The information contained herein is subject to change without notice. The only warranties for Hewlett Packard
Enterprise products and services are set forth in the express warranty statements accompanying such products
and services. Nothing herein should be construed as constituting an additional warranty. Hewlett Packard
Enterprise shall not be liable for technical or editorial errors or omissions contained herein.

Confidential computer software. Valid license from Hewlett Packard Enterprise required for possession, use, or
copying. Consistent with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software
Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government under vendor's
standard commercial license.

Links to third-party websites take you outside the Hewlett Packard Enterprise website. Hewlett Packard Enterprise
has no control over and is not responsible for information outside the Hewlett Packard Enterprise website.

Acknowledgments
Intel®, Itanium®, Pentium®, Intel Inside®, and the Intel Inside logo are trademarks of Intel Corporation in the United
States and other countries.

Microsoft® and Windows® are either registered trademarks or trademarks of Microsoft Corporation in the United
States and/or other countries.

Adobe® and Acrobat® are trademarks of Adobe Systems Incorporated.

Java® and Oracle® are registered trademarks of Oracle and/or its affiliates.

UNIX® is a registered trademark of The Open Group.

Anexo 02 ITEM 11 (0592659)         SEI 0008478-63.2018.6.02.8000 / pg. 5615



Chapter 1 About this guide............................................................................. 9
Applicable products....................................................................................................................................9
Switch prompts used in this guide............................................................................................................. 9

Chapter 2 Getting Started.............................................................................. 11
Using the switch setup screen..................................................................................................................11
Recommended minimal configuration......................................................................................................13
Login banners.......................................................................................................................................... 13

Custom log in banners.................................................................................................................. 13
Banner operation with telnet, serial, or SSHv2 access................................................................. 13
Banner operation with the WebAgent............................................................................................13
Banner operating notes.................................................................................................................14
banner motd command with non-interactive mode ...................................................................14

Chapter 3 Using the Menu Interface............................................................. 16
Starting a menu interface session............................................................................................................16
Ending a menu session and exiting the console......................................................................................17
Rebooting the switch................................................................................................................................18
Configuring ports on HPE 3800 switches with stacking enabled............................................................. 19
Using individual features of the menu interface....................................................................................... 20
Main Menu features................................................................................................................................. 20
Overview of the Menu Interface............................................................................................................... 22
Screen structure and navigation.............................................................................................................. 22
Privilege levels and password security.................................................................................................... 25
Menu interaction with other interfaces..................................................................................................... 25

Chapter 4 ArubaOS-Switch UI.......................................................................26
Accessing the ArubaOS-Switch Next Generation UI............................................................................... 26
Using HTTPS secure connection.............................................................................................................26
Improved UI functionality......................................................................................................................... 29

System — Status.......................................................................................................................... 33
System — Events..........................................................................................................................35
System — Stack............................................................................................................................36
System — Monitor.........................................................................................................................39
System – SNMP............................................................................................................................40
System – Firmware Update...........................................................................................................41
Interfaces — Ports........................................................................................................................ 42
Interfaces — PoE.......................................................................................................................... 43
Interfaces — Monitor.....................................................................................................................44
Interfaces — VLANs......................................................................................................................45
Interfaces — Trunks......................................................................................................................46
Traffic — Spanning Tree............................................................................................................... 47
Security — Clients.........................................................................................................................48
Security — User Roles..................................................................................................................49
Security — Intrusion Log...............................................................................................................50
Security — Port Security............................................................................................................... 50
Security — IP Authorization.......................................................................................................... 51

Contents

Contents 3

Anexo 02 ITEM 11 (0592659)         SEI 0008478-63.2018.6.02.8000 / pg. 5616



Configurations — Config Report................................................................................................... 52
Configurations — Management.................................................................................................... 53

Chapter 5 Operating in Preview Mode..........................................................54
Overview of Preview Mode...................................................................................................................... 54
Enabling Preview Mode........................................................................................................................... 54
Viewing features in Preview Mode...........................................................................................................55
Multicast Offload Engine.......................................................................................................................... 55
Enabling MOE..........................................................................................................................................56

Chapter 6 Using the Command Line Interface (CLI)................................... 57
Listing available commands.....................................................................................................................57
Listing command options......................................................................................................................... 58
Displaying CLI “Help”............................................................................................................................... 59
Enabling and disabling CLI message prefixes......................................................................................... 60
Enabling and disabling CLI interactive command mode.......................................................................... 60

Interactive commands requiring additional options....................................................................... 61
Menu commands...........................................................................................................................62
SNMPv3 special cases................................................................................................................. 62

Simplifying entry of commands at the command line...............................................................................62
Finding or completing a command................................................................................................ 63
redo............................................................................................................................................... 64
repeat............................................................................................................................................ 64
alias...............................................................................................................................................65
CLI shortcut keystrokes.................................................................................................................67

Overview of the CLI................................................................................................................................. 67
Privilege levels for CLI access................................................................................................................. 68

Privilege levels at log on............................................................................................................... 68
Privilege level operation................................................................................................................ 69
Operator privileges........................................................................................................................71
Manager privileges........................................................................................................................71

Configuration commands and context configuration modes.................................................................... 73

Chapter 7 Configuring the switch.................................................................76
Using the CLI to implement configuration changes................................................................................. 76
Creating a custom default configuration.................................................................................................. 79

Copying an existing configuration file to the custom default configuration file.............................. 80
Copying the custom default config file onto the switch................................................................. 80
Copying the custom default config file off the switch.....................................................................80
Using SFTP and SCP to transfer the custom configuration.......................................................... 81
Erasing a configuration file............................................................................................................82
Displaying the configuration files...................................................................................................82
Troubleshooting custom default configuration files....................................................................... 84

Using the menu and WebAgent to implement configuration changes configuration file.......................... 84
Zeroizing the file storage of the management module.............................................................................87

Zeroizing the management module files....................................................................................... 87
Zeroizing from the ROM console.................................................................................................. 88
Zeroization.................................................................................................................................... 88

Using Primary and Secondary flash image options................................................................................. 89
Displaying the current flash image data........................................................................................ 89
Switch software downloads...........................................................................................................91
Replacing or removing local switch software................................................................................ 91
Rebooting the switch.....................................................................................................................93

4 Aruba Basic Operation Guide for ArubaOS-Switch 16.05

Anexo 02 ITEM 11 (0592659)         SEI 0008478-63.2018.6.02.8000 / pg. 5617



Setting the default flash for bootup.....................................................................................93
Booting from the default flash or configuration file............................................................. 93
Booting from a specified flash............................................................................................ 94
Enabling and disabling the fastboot option.........................................................................95
Using reload....................................................................................................................... 95
Boot and reload command comparison..............................................................................98
Operating notes about booting........................................................................................... 98

Managing multiple configuration files.......................................................................................................99
Viewing the status and content of startup-config files................................................................... 99
Changing or overriding the reboot configuration policy.................................................................99
Managing startup-config files in the switch................................................................................. 100
Uploading a configuration file to a remote TFTP host.................................................................101
Downloading a configuration file from a remote TFTP host........................................................ 102
Uploading a configuration file to a serially connected host......................................................... 103
Downloading a configuration file from a serially connected host................................................ 103
Multiple configuration files...........................................................................................................103
Operating notes for multiple configuration files........................................................................... 104

Viewing the configuration of interfaces.................................................................................................. 107
Viewing the running configuration of interfaces.......................................................................... 107
Viewing the startup configuration of interfaces............................................................................ 111

Using automatic configuration update with DHCP Option 66.................................................................113
Enabling and disabling the configuration file update using Option 66.........................................113
Possible scenarios for updating the configuration file................................................................. 113
Operating notes about automatic configuration...........................................................................114

Overview of switch configuration............................................................................................................114
Configuration file management.............................................................................................................. 115

Chapter 8 Managing interface access and System Information.............. 117
Managing interface access.....................................................................................................................117

Listing the current console/serial link configuration.....................................................................117
Enabling and disabling inbound Telnet access............................................................................117
Initiating an outbound Telnet session to another device..............................................................118
Web-management interface configuration for idle timeout..........................................................119
Enabling and disabling inbound WebAgent access.................................................................... 120
Reconfiguring the console/serial link settings............................................................................. 120
Software version support of console/serial link settings..............................................................121
Interface-access parameters.......................................................................................................122
Terminal line width and length settings....................................................................................... 122
Window size negotiation for a telnet session.............................................................................. 123

Denying interface access.......................................................................................................................123
Viewing and setting system information.................................................................................................124

Viewing system information.........................................................................................................124
Setting system information..........................................................................................................125
System parameters..................................................................................................................... 126

Chapter 9 Configuring IP Addressing........................................................ 128
Using the menu or WebAgent to configure IP addressing..................................................................... 128

Using the Switch Setup screen to quickly setup IP addressing.................................................. 128
Using the menu to configure IP address, Gateway, and Time-To-Live (TTL)..............................128
Using the WebAgent to configure IP addressing.........................................................................129

Using the CLI to configure IP Addressing, Gateway, and Time-To-Live (TTL).......................................129
Viewing the current IP configuration............................................................................................129
Configuring an IP address and subnet mask on a VLAN............................................................130
Removing an IP address that is configured on a VLAN.............................................................. 131

Contents 5

Anexo 02 ITEM 11 (0592659)         SEI 0008478-63.2018.6.02.8000 / pg. 5618



Multiple IP addresses configuration on a VLAN (multinetting).................................................... 131
Removing IP addresses from a multinetted VLAN......................................................................133
Configuring the optional default gateway.................................................................................... 133
Setting the Time-To-Live (TTL)....................................................................................................133

Managing loopback interfaces............................................................................................................... 133
Adding a loopback interface........................................................................................................134
Removing a loopback interface...................................................................................................134
Displaying loopback interface configurations.............................................................................. 135
Summary of loopback interface configuration............................................................................. 136
Overview of loopback interfaces................................................................................................. 136

Retaining VLAN-1 IP addressing across configuration file downloads.................................................. 137
Enabling IP preserve to retain VLAN-1 IP addressing................................................................ 137
Operating rules for IP preserve................................................................................................... 137
Overview of IP preserve..............................................................................................................137

Configuring a single source IP address for software applications......................................................... 139
Specifying the source IP address................................................................................................139
Canceling the source IP address assignment.............................................................................140
Viewing source IP address configurations.................................................................................. 140
Viewing source IP selection policy status....................................................................................141
Viewing full source IP details.......................................................................................................142
Viewing protocol configuration and status information................................................................143
Configuration error messages.....................................................................................................144
Overview of single source IP addresses for software applications............................................. 144
The source IP selection policy.................................................................................................... 145

IP configuration features........................................................................................................................ 146
Effects of IP addressing on switch operation......................................................................................... 147
Network preparations for configuring DHCP/Bootp............................................................................... 148
Overview of IP Addressing.....................................................................................................................149
IP addressing with multiple VLANs........................................................................................................ 149
DHCP/Bootp operation.......................................................................................................................... 150

Chapter 10 Managing switch software....................................................... 153
Viewing or downloading the software manual set..................................................................................153
Updating the switch software to a new version......................................................................................153

Updating the switch software...................................................................................................... 153
Backing up your current configuration and image.......................................................................154
Downloading and installing software from a TFTP server...........................................................155
Downloading and installing software from a PC or Unix workstation.......................................... 156
Downloading and installing software from a USB flash drive......................................................157
Best practices, recommendations, and precautions................................................................... 158

Validating switch software......................................................................................................................159
Validating a software image........................................................................................................ 159
Software signing and verification................................................................................................ 159

Rolling back switch software..................................................................................................................160
Managing scheduled jobs...................................................................................................................... 161

Schedule a job to run automatically............................................................................................ 161
Deleting a scheduled job.............................................................................................................162
Viewing scheduled jobs...............................................................................................................163
Time adjustments and scheduling jobs....................................................................................... 163
The Job Scheduler...................................................................................................................... 164

Alternate configuration files....................................................................................................................164

Chapter 11 Daylight Saving Time................................................................166

6 Aruba Basic Operation Guide for ArubaOS-Switch 16.05

Anexo 02 ITEM 11 (0592659)         SEI 0008478-63.2018.6.02.8000 / pg. 5619



Chapter 12 Managing power-saving features............................................168
Configuring the module power-saving option.........................................................................................168
Configuring the LED power-saving option............................................................................................. 168
Configuring the slot low-power option....................................................................................................169
Disabling power-saving options............................................................................................................. 170
Enabling energy-efficient-ethernet (EEE)...............................................................................................170
Enabling advertisement of EEE TLVs.................................................................................................... 171
Disabling EEE or advertisement of EEE TLV.........................................................................................172
Hibernate mode..................................................................................................................................... 172

hibernate.................................................................................................................................172
Viewing settings for power-saving and energy efficiency.......................................................................173

Displayed values for Energy-efficient-ethernet (EEE).................................................................175
Power-saving features supported by modules.......................................................................................176
Overview of power-saving features........................................................................................................177

Chapter 13 Websites.................................................................................... 179

Chapter 14 Support and other resources.................................................. 180
Accessing Hewlett Packard Enterprise Support.................................................................................... 180
Accessing updates.................................................................................................................................180
Customer self repair...............................................................................................................................181
Remote support..................................................................................................................................... 181
Warranty information..............................................................................................................................181
Regulatory information...........................................................................................................................182
Documentation feedback....................................................................................................................... 182

Finding and Maintaining Networking Devices...........................................183

Compliance................................................................................................... 184
RFC 4292...............................................................................................................................................184

RFC 4292 supported operations................................................................................................. 184
RFC 4292 MIB operations...........................................................................................................185

JITC authorization requirements............................................................................................................186
Local authentication and authorization........................................................................................186
Security user log access............................................................................................................. 187
Authentication and Authorization through RADIUS.....................................................................187
Authentication and Authorization through TACACS....................................................................187

Common access card (two-factor) authentication..................................................................................187
Overview..................................................................................................................................... 187

Two-factor authentication................................................................................................. 187
Restrictions.......................................................................................................................187
Expected behaviors..........................................................................................................188

Secure Mode..........................................................................................................................................190
Federal government certification............................................................................................................190

Managing the device link detection protocol (DLDP)............................... 192
Enabling or disabling DLDP................................................................................................................... 192

Setting the DLDP advertisement interval.................................................................................... 192
Enabling and disabling types of DLDP debugging.................................................................................192

Contents 7

Anexo 02 ITEM 11 (0592659)         SEI 0008478-63.2018.6.02.8000 / pg. 5620



Clearing statistics on DLDP packets......................................................................................................193
Viewing DLDP configuration information and statistics..........................................................................193
Setting the DLDP delaydown timer........................................................................................................ 195
Setting DLDP unidirectional-shutdown mode........................................................................................ 195
Setting the DLDP authentication-mode..................................................................................................195
Setting or removing a DLDP authentication password.......................................................................... 196
Include-credentials and encrypt-credentials considerations.................................................................. 197
Restrictions for DLDP............................................................................................................................ 199
Overview of device link detection protocol (DLDP)................................................................................199

Mobile web interface.................................................................................... 201
Viewing web management-to-server configurations.............................................................................. 201

8 Aruba Basic Operation Guide for ArubaOS-Switch 16.05

Anexo 02 ITEM 11 (0592659)         SEI 0008478-63.2018.6.02.8000 / pg. 5621



This guide provides information on how to use the switch interfaces and introduces basic operations.

Applicable products
This guide applies to these products:

Aruba 2530 Switch Series (J9772A, J9773A, J9774A, J9775A, J9776A, J9777A, J9778A, J9779A, J9780A,
J9781A, J9782A, J9783A, J9853A, J9854A, J9855A, J9856A, JL070A)

Aruba 2540 Switch Series (JL354A, JL355A, JL356A, JL357A)

Aruba 2920 Switch Series (J9726A, J9727A, J9728A, J9729A, J9836A)

Aruba 2930F Switch Series (JL253A, JL254A, JL255A, JL256A, JL258A, JL259A, JL260A, JL261A, JL262A,
JL263A, JL264A, JL557A, JL558A, JL559A)

Aruba 2930M Switch Series (JL319A, JL320A, JL321A, JL322A, JL323A, JL324A)

Aruba 3810 Switch Series (JL071A, JL072A, JL073A, JL074A, JL075A, JL076A)

Aruba 5400R zl2 Switch Series (J9821A, J9822A, J9850A, J9851A, JL001A, JL002A, JL003A, JL095A)

Switch prompts used in this guide
Examples in this guide are representative and may not match your particular switch/environment. Examples use
simplified prompts as follows:

Prompt Explanation

switch# # indicates manager context (authority).

switch> > indicates operator context (authority).

switch(config)# (config) indicates the config context.

switch(vlan-x)# (vlan-x) indicates the vlan context of config, where x
represents the VLAN ID. For example:
switch(vlan-128)#.

switch(eth-x)# (eth-x) indicates the interface context of config,
where x represents the interface. For example:
switch(eth-48)#.

switch-Stack# Stack indicates that stacking is enabled.

switch-Stack(config)# Stack(config) indicates the config context while
stacking is enabled.

switch-Stack(stacking)# Stack(stacking) indicates the stacking context of
config while stacking is enabled.

Table Continued

Chapter 1
About this guide
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Prompt Explanation

switch-Stack(vlan-x)# Stack(vlan-x) indicates the vlan context of config
while stacking is enabled, where x represents the
VLAN ID. For example: switch-
Stack(vlan-128)#.

switch-Stack(eth-x/y)# Stack(eth-x/y) indicates the interface context of
config, in the form (eth-<member-in-stack>/
<interface>). For example: switch(eth-1/48)#
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Using the switch setup screen
The quickest and easiest way to minimally configure the switch for management and password protection is to
use a direct console connection to the switch, start a console session and access the Switch Setup screen.

Procedure

1. Using the method described in the Installation and Getting Started Guide for your switch, connect a terminal
device to the switch and display the switch console command (CLI) prompt (the default display).

2. The CLI prompt appears displaying the switch model number, for example: HPE switch#

3. Screen. The following illustration is an example of a Setup screen with default settings. Your screen may vary
slightly.

Figure 1: Example Switch Setup screen

4. Use the [Tab] key to select the Manager Password field and enter a manager password of up to 16
characters and press [Tab].

5. Tab to the IP Config (DHCP/Bootp) field and use the Space bar to select the Manual option and press [Tab].

6. Tab to the IP Address field and enter the IP address that is compatible with your network and press Enter.

Chapter 2
Getting Started
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7. Tab to the Subnet Mask field and enter the subnet mask used for your network.

8. Press S (for Save).

After editing, pressing Enter and then selecting Save will also save the configuration.

Table 1: Setup screen field descriptions

Parameter Default

System
Name

blank Optional; up to 255 characters, including spaces

System
Contact

blank Optional; up to 255 characters, including spaces

Manager
Password

blank Recommended; up to 16 characters (no blank spaces)

Logon
Default

CLI The default setting selects the command-line interface for console access. The
alternative is the Menu interface.

Time Zone 0 (none) Optional: 1440 to -1440. The number of minutes your location is to the West (-) or
East (+) of GMT.

Community
Name

public Default setting recommended.

Spanning
Tree Enabled

No Default setting recommended unless STP is already running on your network or the
switch will be used in complex network topologies.

Default
Gateway

blank Recommended. Enter the IP address of the next-hop gateway node if network traffic
has to reach off-subnet destinations.

Time Sync
Method

TimeP Optional: The protocol the switch uses to acquire a time signal. The options are
SNTP and TimeP.

TimeP Mode Disabled Synchronizes the time kept on the switch to the TimeP server1.

IP Config DHCP/
Bootp

Set to Manual unless a DHCP/Bootp server is used on your network to configure IP
addressing.

IP Address xxx.xxx.xx
x.xxx

Recommended. If you set IP Config to Manual, then enter an IP address compatible
with your network2.

Subnet Mask xxx.xxx.xx
x.xxx

Recommended. If you entered an IP address, then enter a subnet mask compatible
with your network2.

1For more on this topic, see the "Time Protocols" chapter in the latest Management and Configuration Guide for
your switch.
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2The IP address and subnet mask assigned for the switch must be compatible with the IP addressing used in your
network. For more on IPv4 addressing, see Configuring IP Addressing on page 128. For IPv6 addressing
topics, see the latest IPv6 configuration guide for your switch.

Recommended minimal configuration
In the factory default configuration, the switch has no IP (Internet Protocol) address and subnet mask, and no
passwords. In this state, it can be managed only through a direct console connection. To manage the switch
through in-band (networked) access, you must configure the switch with an IP address and subnet mask
compatible with your network. Also, you must configure a Manager password to control access privileges from the
console and web browser interface. Other parameters in the Switch Setup screen can be left at their default
settings or you can configure them with values you enter.

For more information on IP addressing, see Configuring IP Addressing on page 128.

By default, the switch is configured to acquire an IPv4 address configuration from a DHCP or Bootp
server. To use DHCP/Bootp instead of the manual method described in this chapter, see DHCP/
Bootp Operation in the Management and Configuration Guide for your switch.

For information on configuring IPv6 addressing, see to the latest IPv6 Configuration Guide for your
switch.

Login banners

Custom log in banners
You can configure the switch to display a login banner of up to 3070 characters. An operator initiates a
management session with the switch through any of the following methods:

• Telnet

• Serial connection

• SSHv2

• WebAgent

The default banner displays product registration information.

If a banner is configured, the banner page is displayed when you access the WebAgent. The default product
registration information is not displayed as there is already a product registration prompt displayed in the
WebAgent.

Banner operation with telnet, serial, or SSHv2 access
When a system operator begins a login session, the switch displays the banner above the prompts for local
password and Press any key to continue. Entering a correct password or, if no password is configured, pressing
any key clears the banner from the CLI and displays the CLI prompt.

Banner operation with the WebAgent
When a system operator uses the WebAgent to access the switch, the text of a nondefault banner configured on
the switch appears in a dedicated banner window with a link to the next page. Click Continue to display either the
Registration page or the switch’s home page. If the banner feature is disabled or if the switch is using the factory-
default banner, then the banner page does not appear in the WebAgent screen when an operator initiates a login
session with the switch.

Chapter 2 Getting Started 13
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Banner operating notes

• The default banner appears only when the switch is in the factory default configuration. Using the command
no banner motd deletes the currently configured banner text and blocks display of the default banner. The
default banner is restored only if the switch is reset to its factory default configuration.

• The switch supports one banner at any time. Configuring a new banner replaces any former banner configured
on the switch.

• If the switch is configured with ssh version 1 or ssh version 1-or-2, configuring the banner sets the
SSH configuration to ssh version 2 and displays the message Warning: SSH version has been
set to v2.

• If a banner is configured, the switch does not allow configuration with ssh version 1 or ssh version 1-
or-2. Attempting to do so produces the error message Banner has to be disabled first..

• If a banner is enabled on the switch, the WebAgent displays Notice to all users on the banner page.

banner motd command with non-interactive mode
The use of escape characters allows the banner motd command to be used in non-interactive mode for multiple
message lines. In non-interactive mode, you can create a banner message enclosed in double quotes or other
delimiter that uses escape characters within the delimiters. Other existing CLI commands do not support the
escape characters. For more information on interactive and non-interactive mode, see Enabling and disabling
CLI interactive command mode on page 60 in this guide.

Table 2: Supported escape characters

Character

\" double quote

\’ single quote

\` forward quote

\\ backslash

\f form feed

\n newline

\r carriage return

\t horizontal tab

\v vertical tab

Configuring the banner message using escape characters within double quote delimiters

switch(config)# banner motd 
"You can use the \’banner motd\’ CLI command in non-interactive mode.\n\n\tThe banner
motd command will support escape characters."
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switch(config)# show banner motd

Banner Information

Banner status: Enabled

Configured Banner:

You can use the ‘banner motd’ CLI command in non-interactive mode.

     The banner motd command will support escape characters."

The running configuration file with banner motd configured in non-interactive mode

switch(config)# show running-config

Running configuration:

;J8693A Configuration Editor; Created on release #K.15.10.0002
;Ver #01:01:00

hostname "switch"
vlan 1
  name "DEFAULT_VLAN"
  untagged 1-48, a1-a4
  ip address dhcp-bootp
  exit
banner motd "You can use the \’banner motd\’ CLI command in
non-interactive mode.\n\n\tThe banner motd command will support
escape characters."

Configuring the banner message using an alternate delimiter of ‘#’

switch(config)# banner motd #
Enter TEXT message.

End with the character ‘#’.

You can use the banner motd CLI command in non-interactive mode. The banner motd command \n\n\t
will support escape characters #.

Chapter 2 Getting Started 15
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Starting a menu interface session
Starting the session

In its factory default configuration, the switch console starts with the CLI prompt. To use the menu interface with
Manager privileges, go to the Manager level prompt and enter the menu command.

Prerequisites

Before you start a menu interface session, you must complete the following tasks:

1. Configure and connect to the switch. See the Installation and Getting Started Guide for your switch.

2. Access the menu interface using any of the following methods.

• A direct serial connection to the switch console port, as described in the installation guide you received with
the switch.

• A Telnet connection to the switch console from a networked PC or the switch web interface. To use Telnet,
your switch must first be configured with an IP address and subnet mask compatible with your network.

Procedure

1. Use one of these methods to connect to the switch:

a. A PC terminal emulator or terminal

b. Telnet

2. Do one of the following:

a. If you are using Telnet, go to step 3.

b. If you are using a PC terminal emulator, press [Enter] one or more times until a prompt appears.

3. When the switch screen appears, do one of the following:

a. If a password has been configured, the password prompt appears.

Password: _
Type the Manager password and press [Enter]. Entering the Manager password gives you manager-level
access to the switch. (Entering the Operator password gives you operator-level access to the switch. See
the Access Security Guide for your switch.)

b. If no password has been configured, the CLI prompt appears. Go to the next step.

Chapter 3
Using the Menu Interface

16 Aruba Basic Operation Guide for ArubaOS-Switch 16.05

Anexo 02 ITEM 11 (0592659)         SEI 0008478-63.2018.6.02.8000 / pg. 5629



4. When the CLI prompt appears, display the Menu interface by entering the menu command. For example:
switch# menu [Enter] results in the following display:

Figure 2: Example of the Main Menu with Manager Privileges

For a description of Main Menu features, see Main Menu features on page 20.

To configure the switch using the menu interface instead of the CLI, go to the Manager level prompt
in the CLI, enter the setup command, and in the resulting display, change the Logon Default
parameter to Menu. For more information, see the Installation and Getting Started Guide of your
switch.

Ending a menu session and exiting the console
The method for ending a menu session and exiting the console depends on whether, during the session, any
changes made to the switch configuration requires a switch reboot to activate. (Most changes via the menu
interface need only a Save, and do not require a switch reboot.) Configuration changes that need a reboot are
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marked with an asterisk (*) next to the configured item in the menu and also next to the Switch Configuration
item in the Main Menu.

Figure 3: Example indication of a configuration change requiring a reboot

Procedure

1. In the current session, if you have not made configuration changes that require a switch reboot to activate,
return to the Main Menu and press [0] (zero) to logout. Then, exit the terminal program, turn off the terminal, or
quit the Telnet session.

2. If you have made configuration changes that require a switch reboot— that is, if an asterisk (*) appears next to
a configured item or next to Switch Configuration in the Main Menu:

a. Return to the Main Menu.

b. Press [6] to select Reboot Switch and follow the instructions on the reboot screen.

3. Rebooting the switch terminates the menu session, and if you are using Telnet, disconnects the Telnet session.
(See Rebooting the switch on page 93).

4. Exit from the terminal program, turn off the terminal, or close the Telnet application program.

Rebooting the switch
Rebooting the switch from the menu interface:

Procedure

1. Terminates all current sessions and performs a reset of the operating system

2. Activates any menu interface configuration changes that require a reboot

3. Resets statistical counters to zero

(Note that statistical counters can be reset to zero without rebooting the switch.)
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To Reboot the switch, use the Reboot Switch option in the Main Menu. (Note that Reboot Switch is not available
if you log on in Operator mode; that is, if you enter an Operator password instead of a manager password at the
password prompt.)

Figure 4: The Reboot Switch option in the Main Menu

Rebooting to activate configuration changes. Configuration changes for most parameters in the menu
interface become effective as soon as you save them. However, you must reboot the switch to implement a
change in the Maximum VLANs to support parameter. To access this parameter, go to the Main Menu and
select:

    2. Switch Configuration

         8. VLAN Menu

             1. VLAN Support.
      
If you make configuration changes in the menu interface that require a reboot, the switch displays an asterisk (*)
next to the menu item in which the change has been made. For example, if you change and save the value for the
Maximum VLANs to support parameter, an asterisk appears next to the VLAN Support entry in the VLAN Menu
screen, and also next to the Switch Configuration entry in the Main Menu.

To activate changes indicated by the asterisk, go to the Main Menu and select the Reboot Switch option.

Executing the write memory command in the CLI does not affect pending configuration changes
indicated by an asterisk in the menu interface. That is, only a reboot from the menu interface or a
boot or reload command from the CLI will activate a pending configuration change indicated by an
asterisk.

Configuring ports on HPE 3800 switches with stacking
enabled
When stacking is enabled on an HPE 3800 switch, the procedures for configuring specific switch ports are the
same as for 3800 switches without stacking enabled. However, the port designations for the ports in the stack are
modified. That is, each port is identified by its switch’s stack member ID followed by a slash and then the port
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number, as it is shown on the switch. For example, for a switch with stack member ID 3, port 10 on that switch is
identified as port 3/10 for CLI command input and output. Entering a CLI command on a 3800 switch configured
for stacking without using the modified port designation results in the message ”Module not present for port or
invalid port”.

For more on this topic, see "Interaction with Other Switch Features" in the "Stack Management" chapter of the
latest Management and Configuration Guide for 3800 switches.

Using individual features of the menu interface.
To use the individual features of the menu interface, see the references listed in the following table.

Option: Turn to:

To use the Run Setup option See the Installation and Getting Started Guide shipped with the
switch.

To view and monitor switch status and
counters

Appendix B, "Monitoring and Analyzing Switch Operation" in the
Management and Configuration Guide for your switch.

To learn how to configure and use
passwords and other security features

See the Access Security Guide for your switch.

To learn how to use the Event Log Appendix C, "Using the Event Log for Troubleshooting Switch
Problems" in the Management and Configuration Guide for your
switch.

To learn how the CLI operates Using the Command Line Interface (CLI) on page 57

To download switch software Appendix A, "File Transfers" in the Management and Configuration
Guide for your switch.

For a description of how switch memory
handles configuration changes

Configuring the switch on page 76

Main Menu features
The Main Menu gives you access to these Menu interface features:

• Status and Counters:

Provides access to display screens showing switch information, port status and counters, and port and VLAN
address tables. (See the Management and Configuration Guide for your switch.) All of the items that are
included in Status and Counters are stated in the following list:

◦ Address Table

◦ General System Information

◦ Module Information

◦ Port Address Table

◦ Port Counters

◦ Port Status
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◦ Spanning Tree Information

◦ Switch Management Address Information

◦ VLAN Address Table

• Switch Configuration:

Provides access to configuration screens for displaying and changing the current configuration settings. (See
the contents listing at the front of this manual.) For an index of the features covered in the software manuals
for your switch, see the Software feature index-extended manual for your switch. All of the items that are
included in Switch Configuration are stated in the following list:

◦ System Information

◦ Port/Trunk Settings

◦ Network Monitoring Port

◦ IP Configuration

◦ SNMP Community Names

◦ IP authorized Managers

◦ VLAN Menu

◦ Spanning Tree Operation

• Console Passwords:

Provides access to the screen used to set or change Manager-level and Operator-level passwords, and to
delete Manager and Operator password protection. (See the Access Security Guide for your switch.)

• Event Log:

Enables you to read progress and error messages that are useful for checking and troubleshooting switch
operation. (See the Management and Configuration Guide for your switch.)

• Command Line (CLI):

Selects the Command Line Interface at the same level (Manager or Operator) that you are accessing in the
Menu interface.

• Reboot Switch:

Performs a "warm" reboot of the switch, which clears most temporary error conditions, resets the network
activity counters to zero, and resets the system up-time to zero. A reboot is required to activate a change in
the VLAN Support parameter.

• Download OS:

Enables you to download a new software version to the switch. (See Appendix A, "File Transfers" in the
Management and Configuration Guide for your switch.)

• Run Setup:

Displays the Switch Setup screen for quickly configuring basic switch parameters such as IP addressing,
default gateway, logon default interface, and others. (See the Installation and Getting Started Guide for your
switch.)

• Logout:

Closes the Menu interface and console session, and disconnects Telnet access to the switch.
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Overview of the Menu Interface
The menu interface operates through the switch console to provide you with a subset of switch commands in an
easy-to-use menu format.

• Performs a "quick configuration" of basic parameters, such as the IP addressing required to provide
management access through your network

• Configures these features:

◦ Manager and Operator passwords

◦ System parameters

◦ IP addressing

◦ Time protocol

◦ Ports

◦ Trunk groups

◦ A network monitoring port

◦ SNMP community names

◦ IP authorized managers

◦ VLANs (Virtual LANs) and GVRP

• View status, counters, and Event Log information

• Update switch software

• Reboot the switch

For a detailed list of menu features, see the Main Menu features on page 20.

Screen structure and navigation
Menu interface screens include these three elements:

• Parameter fields and/or read-only information such as statistics

• Navigation and configuration actions, such as Save, Edit, and Cancel

• Help line to describe navigation options, individual parameters, and read-only data
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For example, in the following System Information screen:

Figure 5: Elements of the screen structure

"Forms" design. The configuration screens, in particular, operate similarly to a number of PC applications that
use forms for data entry. When you first enter these screens, you see the current configuration for the item you
have selected. To change the configuration, the basic operation is to:

1. Press [E] to select the Edit action.

2. Navigate through the screen making all the necessary configuration changes.

3. Press [Enter] to return to the Actions line. From there, you can save the configuration changes or cancel the
changes. Cancel returns the configuration to the values you saw when you first entered the screen.
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Table 3: How to navigate the Menu interface

Task: Actions:

Execute an
action from the
"Actions –>" list
at the bottom of
the screen:

Reconfigure
(edit) a
parameter
setting or a field:

1. Select a configuration item, such as System Name.

2. Press [E](for Edit on the Actions line).

3. Use [[Tab]] or the arrow keys ([←], [→], [↑], or [↓]) to highlight the item or field.

4. Do one of the following:

• If the parameter has preconfigured values, either use the Space bar to select a new
option or enter the first part of your selection and the rest of the selection appears
automatically. (The help line instructs you to "Select" a value.)

• If there are no preconfigured values, type in a value (the Help line instructs you to
"Enter" a value).

5. If you want to change another parameter value, return to step 3.

6. If you are finished editing parameters in the displayed screen, press [Enter] to return to
the Actions line and do one of the following:

• To save and activate configuration changes, press [S] (for the Save action). This saves
the changes in the startup configuration and also implements the change in the
currently running configuration. (See, "Switch Memory and Configuration".)

• To exit from the screen without saving any changes that you have made (or if no
changes are done), press [C] (for the Cancel action).

Note: In the menu interface, executing Save activates most parameter changes and saves
them in the startup configuration (or flash) memory, and it is therefore not necessary to
reboot the switch after making these changes. But, if an asterisk appears next to any menu
item you reconfigure, the switch will not activate or save the change for that item until you
reboot the switch. In this case, rebooting must be done after you have made all desired
changes and then returned to the Main Menu.

7. When you finish editing parameters, return to the Main Menu.

8. If necessary, reboot the switch by highlighting Reboot Switch in the Main Menu and
pressing [Enter]. (See the Note in Step 6.)

Exit from a
read-only
screen.

Press [B] (for the Back action).

To get Help on individual parameter descriptions. In most screens, there is a Help option in the Actions line.
Whenever any of the items in the Actions line are highlighted, press [H], and a separate help screen is displayed.
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To get Help on the actions or data fields in each screen: Use the arrow keys ([←], [→], [↑], or [↓]) to select an
action or data field. The help line under the Actions items describes the currently selected action or data field.

For guidance on how to navigate in a screen: See the instructions provided at the bottom of the screen, or See 
Screen structure and navigation on page 22.)

Privilege levels and password security
Hewlett Packard Enterprise strongly recommends that you configure a Manager password to help prevent
unauthorized access to your network. A Manager password grants full read/write access to the switch. An
Operator password grants access to status and counter, Event Log, and the Operator level in the CLI. After you
configure passwords on the switch and log off of the interface, access to the menu interface (and the CLI and web
browser interface) requires entries of either the Manager or Operator password.

• If the switch does not have Manager or an Operator password, anyone having access to the
console interface can operate the console with full manager privileges.

• If you configure only an Operator password, entering the Operator password enables full
manager privileges.

• If the switch only has a Manager password someone without a password can still gain read-only
access.

For more information on passwords, see the Access Security Guide for your switch.

Menu interaction with other interfaces
The menu interface displays the current running-config parameter settings. From the running config, use the
menu interface to save configuration changes made in the CLI. A configuration change made through any switch
interface overwrites earlier changes made through any other interface.

The Menu Interface and the CLI both use the switch console. Use the menu command to enter the menu from the
CLI and the CLI option from the menu interface to enter the CLI.

For more on how switch memory manages configuration changes, see the Switch Memory and Configuration.
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Management and configuration of ArubaOS-Switch can occur through its web interface. Two interfaces are
available, the Legacy UI and the Next Generation UI.

• The Legacy UI provides full functionality for the monitoring and configuration of switches running ArubaOS.

• The Next Generation UI provides a subset of the Legacy UI functionality. Additional functionality will be added
in future releases and it will eventually replace the Legacy UI.

Accessing the ArubaOS-Switch Next Generation UI
Access the ArubaOS-Switch Improved UI by clicking the Access Improved GUI link displayed in the upper right
corner of the Traditional UI.

Figure 6: Traditional UI

Using HTTPS secure connection
ArubaOS-Switch devices can be configured and monitored using a web browser based HTTP interface, which is
enabled by default. However, this connection method is unencrypted, thus making it vulnerable to credential
interception by devices connected to the network in the path between the user and the switch being configured.
To secure connections to the web management UI, it is recommended to enable HTTPS and disable HTTP
access to the switch. HTTPS is HTTP traffic running on a Secure Sockets Layer (SSL)/Transport Layer Security
(TLS) connection, which requires a certificate to be present on the switch. To generate a certificate; enable
HTTPS, and disable HTTP, the steps are as follows:

Procedure

1. Open a switch console session and enter the configuration context using the command:

Chapter 4
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switch# configure
2. Create a self-signed SSL/TLS certificate.

switch(config)# crypto pki enroll-self-signed certificate-name <name of certificate> subject common-name <common name of device>

a. View the SSL/TLS certificate information.

switch(config)# show crypto pki local-certificate web-mgmt
Certificate Detail:
Version: 3 (0x2)
Serial Number:
   56:12:69:dd:3d:91:c1:8a:4e:2c:f4:62:a3:0a:96:76:b5:f0:b4:31
Signature Algorithm: sha256withRSAEncryption
Issuer: CN=5400R
Validity
   Not Before: Aug 14 13:33:32 2017 GMT
   Not After : Aug 14 23:59:59 2018 GMT
Subject: CN=5400R
Subject Public Key Info:
   Public Key Algorithm: rsaEncryption
   RSA Public Key: (1024 bit)
      Modulus (1024 bit):
          30:0d:06:09:2a:86:48:86:f7:0d:01:01:01:05:00:
          03:81:8d:00:30:81:89:02:81:81:00:b0:90:f9:d8:
          88:f0:d5:eb:31:1e:aa:06:3b:30:5a:5b:d2:ed:eb:
          ff:12:ff:9d:52:55:98:cd:2a:c2:72:8e:94:69:47:
          a3:29:0f:f7:47:c3:c9:57:fa:11:d8:9a:8d:2f:e4:
          84:5e:3d:67:b2:fc:59:81:53:83:12:6a:68:6b:a5:
          4d:20:8f:b5:be:a2:23:b9:aa:e5:9a:55:ac:4a:fb:
          20:4b:71:6d:74:db:ab:89:4f:ed:27:c0:aa:31:fa:
          4b:64:76:be:f8:11:de:0e:5e:1e:17:b2:ba:a2:13:
          ce:2e:aa:31:d6:51:ad:e5:ed:23:93:42:27:d2:44:
          bd:2f:83:9d:02:03:01:00:01
      Exponent: 65537 (0x10001)
X509v3 extensions:
   X509v3 Key Usage: critical
      Digital Signature, Key Encipherment, Key Agreement
   X509v3 Extended Key Usage:
      TLS Web Server Authentication

Signature Algorithm: sha256withRSAEncryption
   5c:00:9e:b2:8a:98:49:f3:e5:11:51:a8:2b:23:07:0c:f8:e8:
   26:bf:09:98:8a:9a:45:22:57:5b:af:ab:2f:ed:34:50:4d:ac:
   d9:59:18:e1:52:68:7f:20:ae:14:e7:d9:97:1b:91:5f:ae:ba:
   cd:b5:d3:7b:14:b6:da:99:fa:4f:2b:ed:65:96:59:fc:87:45:
   1c:49:93:2b:8c:47:3e:08:ae:7f:85:c3:31:58:17:32:d5:13:
   60:a3:c1:d2:4c:69:d5:54:7e:3d:e2:67:64:ba:38:6e:cb:c5:
   9e:17:9e:0b:30:52:8f:47:5d:59:2b:0e:c3:14:07:8f:f0:71:
   97:9d
MD5 Fingerprint: cbdc 5288 60e1 9576 4fd8 1f1d cae7 4edc
SHA1 Fingerprint: 6ea3 7708 a6dd cd6d 065b 1b34 1734 f385 42d6 0121

3. Enable HTTPS web management.

switch(config)# web-management ssl
4. (Recommended) Disable HTTP web management.
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switch(config)# no web-management
5. Verify the web-management configuration.

switch(config)# show web-management

 Web Management - Server Configuration

  HTTP Access    : Disabled
  HTTPS Access   : Enabled
  SSL Port       : 443
  Idle Timeout   : 600 seconds
  Management URL : http://h17007.www1.hpe.com/device_help
  Support URL    : http://www.arubanetworks.com/products/networking/
  User Interface : Improved
  Listen Mode    : bot

6. To log into the web management UI, open a browser and enter an IP address configured on the switch .

For example, https://X.X.X.X

IP addresses are configured on the switch by the VLAN. Use show ip command to view the configured IP
addresses.

For more information about SSL/TLS configuration, see the ArubaOS-Switch Access Security Guide of your
switch.
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Improved UI functionality
Overview

The Improved UI includes four major elements that are common across all views within the UI. The dashboard
view, which provides an at-a-glance overview of system performance, is displayed here as an example. All four
elements are described below the dashboard image.

Figure 7: Improved UI dashboard

Header panel

This is the panel in the upper right corner of the screen. It includes the following icons and fields, from left to right:

• Search: Enter a search term in this field and press Enter to view results.

Reboot: Click this icon to reboot the switch. You will be asked to confirm before the switch is rebooted.

• Refresh: Click this icon to reload the components and refresh the page.

• Toggle locator LED: Click this icon to identify a physical device.

• Notifications: Click this icon to see a list of recent events.

• Help: Click this icon to see the help text associated with the current screen.

• User details: Click this icon to see a list of user roles. You can also launch the Traditional user interface by
clicking Launch Traditional GUI.

• Settings: Click this icon to modify the web interface settings for the current screen.

Navigation pane

This is the gray bar on the left side of the screen. It contains a series of drop-down menus, each representing an
area of functionality, that allow you to navigate through the Improved UI. The drop-down menus include:
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• General: Includes the Dashboard submenu.

• System: Includes the Status, Events, Monitor, SNMP, Firmware Update, and Stack (supported only for BPS/
VSF) submenus.

• Interfaces: Includes the Ports, PoE, Monitor, VLANs, and Trunks submenus.

• Traffic: Includes the Spanning Tree submenu.

• Security: Includes the Clients, User Roles, Intrusion Log, Port Security, and IP Authorization submenus.

• Configurations: Includes the Config Report and Management submenus.

View pane

The view pane is a series of viewing options to the right of the navigation pane. It is broken into two sections:

Status panels - These panels display the status of the following elements.

Click on the ... icon in each status panel to navigate to the detailed view associated with the selected
panel. For example, if you click on ... in th PoE view option, you will jump to the PoE page.

• PoE: Displays PoE port status.

◦ Green: No PoE ports have a fault or have been denied power.

◦ Yellow: One or more PoE ports have been denied power.

◦ Red: One or more PoE ports have a fault.

• Storage: Displays system storage status.

◦ Green: The current system storage use is within normal range.

◦ Yellow: The current system storage use exceeds the warning threshold of 70%.

◦ Red: The current system storage use exceeds the critical threshold of 90%.

• Fans: Displays system fan status.

◦ Green: All fans are operating normally.

◦ Yellow: One or more fans have failed but the number of failures does not exceed 50% of all system fans.

◦ Red: At least 50% of the system fans have failed.

• Security: Displays security status based on the Intrusion Log flags.

◦ Green: No intrusion events have occurred since acknowledgement.

◦ Yellow: This status has no warning state.

◦ Red: At least one new intrusion event has occurred.

• Spanning Tree: Displays spanning tree status.
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◦ Green: Spanning tree is disabled or no loop/root inconsistent ports were detected.

◦ Yellow: Either loop or root inconsistent ports were detected.

◦ Red: Both loop and root inconsistent ports were detected.

• Clients: Displays the summarized status of clients connected to the switch.

◦ Green: All switch clients successfully authenticated/No Clients Connected.

◦ Yellow: At least one client is not properly authenticated.

◦ Red: Client authentication attempts were rejected.

• Ports: Displays ports with warning or critical events.

◦ Green: Only info/debug events occurred on device ports.

◦ Yellow: Warning events have occurred on one or more ports.

◦ Red: Error/major events have occurred on one or more ports.

• Power Supplies: Displays system power supply status.

◦ Green: All power supplies are operating normally.

◦ Yellow: One or more power supplies have failed but the number of failures does not exceed 40% of all
system power supplies.

◦ Red: At least 40% of the system power supplies have failed.

• Temperatures: Displays system temperature status.

◦ Green: The current system temperature is within normal range.

◦ Yellow: The current system temperature exceeds the warning threshold of <variable>. The threshold is
based on a user-controlled setting on the switch.

◦ Red: The current system temperature exceeds the critical threshold of <variable>. The threshold is based
on a user-controlled setting on the switch.

• Uptime: Displays the device system uptime.

Gauges - These gauges display information about:

• CPU: Displays the current CPU usage of the device.

◦ The outer ring of the gauge indicates regions of normal, warning, and critical values.

◦ The peak value shown on the inner ring indicates the highest CPU usage reached for the device.

◦ Green: CPU usage is within normal range.

◦ Yellow: CPU usage exceeds the warning threshold of 75%.

◦ Red: CPU usage exceeds the critical threshold of 90%.

• Memory: Displays the current memory usage of the device.

Chapter 4 ArubaOS-Switch UI 31

Anexo 02 ITEM 11 (0592659)         SEI 0008478-63.2018.6.02.8000 / pg. 5644



◦ The outer ring of the gauge indicates regions of normal, warning, and critical values.

◦ The peak value shown on the inner ring indicates the highest memory usage reached for the device.

◦ Green: Memory usage is within normal range.

◦ Yellow: Memory usage exceeds the warning threshold of 75%.

◦ Red: Memory usage exceeds the critical threshold of 90%.

• Packet Buffers: Displays the current packet buffer usage of the device.

◦ The outer ring of the gauge indicates regions of normal, warning, and critical values.

◦ The peak value shown on the inner ring indicates the highest packet buffer usage reached for the device.

◦ Green: Packet buffer usage is within normal range.

◦ Yellow: Packet buffer usage exceeds the warning threshold of 85%.

◦ Red: Packet buffer usage exceeds the critical threshold of 95%.

• Tx Drops: Displays the current transmit drop rate of the device.

◦ The outer ring of the gauge indicates regions of normal, warning, and critical values.

◦ The peak value shown on the inner ring indicates the highest transmit drop rate reached for the device.

◦ Green: Transmit drop rate is within normal range.

◦ Yellow: Transmit drop rate exceeds the warning threshold of 3% of transmit attempts.

◦ Red: Transmit drop rate exceeds the critical threshold of 5% of transmit attempts.

• Message Buffers: Displays the current message buffer usage of the device.

◦ The outer ring of the gauge indicates regions of normal, warning, and critical values.

◦ The peak value shown on the inner ring indicates the highest message buffer usage reached for the device.

◦ Green: Message buffer usage is within normal range.

◦ Yellow: Message buffer usage exceeds the warning threshold of 75%.

◦ Red: Message buffer usage exceeds the critical threshold of 90%.

• Rx Errors: Displays the current receive error rate of the device.

◦ The outer ring of the gauge indicates regions of normal, warning, and critical values.

◦ The peak value shown on the inner ring indicates the highest receive error rate reached for the device.
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◦ Green: Receive error rate is within normal range.

◦ Yellow: Receive error rate exceeds the warning threshold of 2% of received frames.

◦ Red: Receive error rate exceeds the critical threshold of 5% of received frames.

• Top Interfaces: Displays the top ten ports with any one of 25 user-selected metrics (RX Total Frames in this
example). Only ports that are enabled and up will be shown.

Right pane

Also called the events pane, this section displays:

• The latest events on the system

• User settings per page

• User roles across the system

• Help information

System — Status
Figure 8: System–Status

IP Info: Displays the basic IP configuration of the default VLAN. It is also possible to specify an IP configuration
mode and associated settings.

Hardware: Displays basic hardware information for the device or stack commander. The MAC address and serial
number of the device or stack commander are shown.

System Info: Displays general system information including:
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• Product name

• Configured values for the device name

• Contact

• Location

• Uptime since the device was last rebooted

For a stack, this information pertains to the stack commander. It is also possible to edit the values for device
name, contact, and location.

Software Versions: Displays the primary software, secondary software, and ROM versions for the device or, for a
stack, the stack commander. In a stack, the commander's active software version is propagated to all stack
members.

Storage: Displays system storage details for the device or, for a stack, summary data for each stack member.

• For a standalone device, a breakout of storage use per volume is shown.

• For a stack member, clicking the icon in its summary will navigate to the Stack page for the member where its
breakout data can be viewed.

• This panel can be swapped to the top of the page by clicking the icon in the top right corner.

Fans: Displays system fan details for the device or, for a stack, summary data for each stack member.

• For a standalone device, a breakout of fan details is shown.

• For a stack member, clicking the icon in its summary will navigate to the stack page where its breakout data
may be viewed.

• This panel can be swapped to the top of the page by clicking the icon in the top right corner.

Power Supplies: Displays system power supply status regarding the presence of removable supplies and their
status in a device. For a stack, summary data is displayed for each stack member.

• For a standalone device, a breakout of power supply details is shown.

• For a stack member, clicking the icon in its summary will navigate to the stack page where its breakout data
may be viewed.

• This panel can be swapped to the top of the page by clicking the icon in the top right corner.

Temperature: Displays system thermal status for the device or, for a stack, summary data for each stack
member.

• For a standalone device, a breakout of temperature details is shown.

• For a stack member, clicking the icon in its summary will navigate to the stack page where its breakout data
may be viewed.

• This panel can be swapped to the top of the page by clicking the icon in the top right corner.
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System — Events
Figure 9: System–Events

Events List: Displays a list of the current system events. Available information includes event severity, time of
occurrence, member information, and description.

Filter Events: The display dropdown and filter icon can be used to show/hide table columns and filter the results
based on the user-specified options. Select either tool to begin filtering.
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System — Stack
Figure 10: System–Stack

This view is only present on switch stacks.

Box Graphic: Displays each stack member physically.

• Used to view member information.

• The switch outlined in orange is the currently selected member.

• Data on the page reflects the selected member.

• The Box Graphic can be flipped to show either the front or back of the switch.

Fans: Displays member fan status.

Status:

• Green: The current system storage use is within normal range.

• Yellow: The current system storage use exceeds the warning threshold of 70%.

• Red: The current system storage use exceeds the critical threshold of 90%.

Storage: Displays system storage status.

Status:
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• Green: All fans are operating normally.

• Yellow: One or more fans have failed but the number of failures does not exceed 50% of all system fans.

• Red: At least 50% of the system fans have failed.

Temperature: Displays system temperature status.

Status:

• Green: The current system temperature is within normal range.

• Yellow: The current system temperature exceeds the warning threshold of <variable>. The threshold is based
on a user-controlled setting on the switch.

• Red: The current system temperature exceeds the critical threshold of <variable>. The threshold is based on
a user-controlled setting on the switch.

Power Supplies: Displays system power supply status.

Status:

• Green: All power supplies are operating normally.

• Yellow: One or more power supplies have failed but the number of failures does not exceed 40% of all system
power supplies.

• Red: At least 40% of the system power supplies have failed.

Stack Details: Displays system information regarding the stack including stack topology/configuration and
software version on all members.

Member Details: Displays status, MAC address, location and stack name.

CPU: Displays the current CPU usage of the selected stack member.

• The outer ring of the gauge indicates regions of normal, warning, and critical values.

• The peak value shown on the inner ring indicates the highest CPU usage reached for the device.

Status:

• Green: CPU usage is within normal range.

• Yellow: CPU usage exceeds the warning threshold of 75%.

• Red: CPU usage exceeds the critical threshold of 90%.

Memory: Displays current memory usage of the selected stack member.

• The outer ring of the gauge indicates regions of normal, warning, and critical values.

• The peak value shown on the inner ring indicates the highest memory usage reached for the device.

Status:
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• Green: Memory usage is within normal range.

• Yellow: Memory usage exceeds the warning threshold of 75%.

• Red: Memory usage exceeds the critical threshold of 90%.

Packet Buffers: Displays current packet buffer usage.

• The outer ring of the gauge indicates regions of normal, warning, and critical values.

• The peak value shown on the inner ring indicates the highest packet buffer usage reached for the device.

Status:

• Green: Packet buffer usage is within normal range.

• Yellow: Packet buffer usage exceeds the warning threshold of 85%.

• Red: Packet buffer usage exceeds the critical threshold of 95%.

Tx Drops: Displays current transmit drop rate.

• The outer ring of the gauge indicates regions of normal, warning, and critical values.

• The peak value shown on the inner ring indicates the highest transmit drop rate reached for the device.

Status:

• Green: Transmit drop rate is within normal range.

• Yellow: Transmit drop rate exceeds the warning threshold of 3% of transmit attempts.

• Red: Transmit drop rate exceeds the critical threshold of 5% of transmit attempts.

Message Buffers: Displays current message buffer usage.

• The outer ring of the gauge indicates regions of normal, warning, and critical values.

• The peak value shown on the inner ring indicates the highest message buffer usage reached for the device.

Status:

• Green: Message buffer usage is within normal range.

• Yellow: Message buffer usage exceeds the warning threshold of 75%.

• Red: Message buffer usage exceeds the critical threshold of 90%.

Rx Errors: Displays the current receive error rate.

• The outer ring of the gauge indicates regions of normal, warning, and critical values.

• The peak value shown on the inner ring indicates the highest receive error rate reached for the device.

Status:
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• Green: Receive error rate is within normal range.

• Yellow: Receive error rate exceeds the warning threshold of 2% of received frames.

• Red: Receive error rate exceeds the critical threshold of 5% of received frames.

System — Monitor
Figure 11: System–Monitor

Monitors up to six system metrics at a given time.

• Metrics include:

◦ CPU usage

◦ Memory usage

◦ Packet buffer usage

◦ Transmit drop rate

◦ Message buffer usage

◦ Receive error rate

• Metrics can be hidden from the graph by selecting the corresponding graph icon in the toolbar at the top of the
graph.

• Select and slide the minimap (the gray box at the bottom of the graph) to zoom in and out of the graph. You
can also focus in on a specific portion of the graph.

• Zooming in will provide a finer granularity of displayed data points, while zooming out will display fewer data
points.

Pause and Play Graph: Use the pause and play icons in the toolbar in the upper right corner of the graph to start
and stop the display of data points on the current graph.

• Pausing the graph will not pause the collection of system monitor data.

• Upon restarting the graph, the data points collected while the graph was paused will be filled in.
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Graph options: Select the Graph Settings icon in the upper right corner of the graph to:

• View system monitor graph options

• Select metrics to graph

• Show/hide system alerts

• Show/hide summary lines (maximum, minimum, and average)

The Metrics Statistics: Displays statistics for each of the currently graphed metrics. Statistics include average,
maximum, and minimum values for the metric.

System – SNMP
Figure 12: System–SNMP

Trap receivers: Displays all the trap receivers configured.

• Each card represents a trap receiver configured.

• To add a trap receiver, click the Add Trap Receiver (+) icon on the left side of the black panel.

• To edit a trap receiver, select the Edit Trap Receiver icon on the receiver card.

• To delete a trap receiver, select the Delete Trap Receiver icon on the receiver card.

• The interface offers different sorting options, which can be viewed by hovering over the sort icons. Select one
to apply the sort. Select the arrow next to the sort icons to switch between ascending and descending sorting.

• Different sorting options are available, which can be viewed by hovering over the sort icons. Select one to
apply the sort.

• Select the arrow next to the sort icons to switch between ascending and descending sort order.

IP Configuration: Displays the IP Configuration for the Trap Source and Trap Response. To edit either the Trap
Source or Trap Response, select the Edit Configuration icon in the upper right corner of the IP Configuration
panel.
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Community Names: Displays a list of all community names. To add a community name, select the Add
Community Name icon (+) in the upper right corner of the Community Names panel.

Community Info: Select a community name in the table to display it in the Community Info tile.

• To edit the community name, select the Edit Community Name icon in the upper right corner of the Community
Info tile.

• To delete a community name, select the Delete Community Name icon in the upper right corner of the
Community Info tile.

General Traps: Displays the traps supported and indicates whether each is enabled or disabled. To enable or
disable a trap:

1. Select the Edit General Traps icon in the upper right corner of the General Traps tile.

2. Check or clear the box to the right of the trap to enable or disable that trap.

3. Click Save or Cancel.

Link Status Change Trap: Select the Expand icon on the left of the panel to view a table of ports and their link
status change trap configurations.

• Use the page controls at the bottom of the table to navigate all the ports.

• If the Expand icon was previously selected, select the Collapse icon at the upper left of the panel to hide the
table.

• To edit the link status change trap configuration for a port, select the Edit Link Status Change Trap icon in the
upper right corner of the panel.

System – Firmware Update
Figure 13: System–Firmware Update

This functionality updates the device firmware with a file from the local system where the browser is being used.
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1. Select which image to update: primary or secondary.

2. Drag and drop a file onto the indicated area or click Choose File to browse for a file.

3. Click Upload File to initiate the upload.

Interfaces — Ports
Figure 14: Interfaces–Ports

Port List: Displays a list of all physical ports on the device. Use the pagination control at the bottom of the table to
page though the port list.

Box View: Visual representation of the physical view of the device including hardware status and ports.

• Active and disabled ports display the corresponding status indicator inside the port image.

• If a back of the box view is available, the option to view the back of the box displays in the toolbar at the top of
the page.

Filter Port Table: The display dropdown and filter icon can be used to show/hide table columns and filter the table
results based on the user-specified options. Select either tool to begin filtering.

Port Configuration: Configure a port by selecting the Edit Ports icon in the upper right corner of the toolbar at the
top of the table. The configuration panel opens to allow for port selection and option configuration.
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Interfaces — PoE
Figure 15: Interfaces–PoE

This view displays the PoE information for the switch. In a stack, the power information will not be displayed for
non-PoE switches.

• The box view and port table data is updated every 30 seconds.

• The detail view is updated every 3 seconds.

PoE Port List: Displays a list of all PoE physical ports on the device. Non-PoE ports are not shown. Use the
pagination control at the bottom of the table to page though the port list.

PoE Box View: Visual representation of the physical view of the device including hardware status and ports.
Active and disabled ports display the corresponding status indicator inside the port image.

PoE Port Details: The PoE Port Details panel provides detailed information on the configuration, power usage,
and statistics of a selected port. A port can be selected using the Box View or the port table.

Filter PoE Port Table: The display dropdown and filter icon can be used to show/hide table columns and filter the
table results based on the user-specified options. Select either tool to begin filtering.

PoE Port Configuration: Configure a port by selecting the Edit Ports icon in the upper right corner of the toolbar
at the top of the table. The configuration panel opens to allow for port selection and option configuration. By
default, the selected port will be edited.
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Interfaces — Monitor
Figure 16: Interfaces–Monitor

Interface Monitor Graph: Monitors up to six interface metrics at a given time.

• There are approximately two dozen metrics to choose from on any interface; all except utilization are
expressed as per-second rates (for example, frames/second).

• Metrics may be monitored on a single interface or across multiple interfaces. The total number monitored at
any juncture is limited to six or fewer.

• Only interfaces that are enabled and up may be selected.

• Metrics can be hidden from the graph by selecting the corresponding graph icon in the toolbar at the top of the
graph.

• Metric collection is started anew each time this view is entered.

Pause and Play Graph: Use the pause and play icons in the upper right corner of the graph to start and stop the
display of data points on the graph.

• Pausing the graph will not pause the collection of interface monitor data.

• Upon restarting the graph, the data points collected while the graph was paused will be filled in.

Graph Options: Select the Graph Settings icon in the upper right corner of the graph to select interfaces and
metrics to graph data for.
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Interfaces — VLANs
Figure 17: Interfaces–VLANs

VLAN Box View: Indicates which ports are members of the selected VLAN. Color and shape indicators are used
to differentiate between port types and membership. Editing port membership can also be done through the box
view.

Device VLAN Info: Displays the general VLAN information pertaining to the device.

VLAN Details: Displays a range of details regarding the selected VLAN. Select a VLAN by clicking it in the table.

All VLANs: Displays all configured VLANs on the device including information regarding each of the configured
VLANs. This information includes:

• Status

• IP information

• Port membership

Select a VLAN in the table to view more information.

Edit General VLAN Info: Configure VLAN properties on the device. Configuration options include:

• Setting the primary and management VLAN

• Enabling or disabling GVRP

• Setting the maximum number of VLANs

Edit VLAN: Edit the properties and port membership of an existing VLAN.

Create VLAN: Create a VLAN.

Delete VLAN: Delete an existing VLAN.
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Edit VLAN via Box View: Select Ports in the box view to add or remove that port from the currently selected
VLAN. Use the dropdown option in the header to change the port type.

Magnify Box View: Magnify the box view to display up to six VLANs in a single port to view VLAN membership.
Double-click in the magnifier to cycle to the next VLAN if more than six are present. Press the Esc key to exit the
magnifier.

Interfaces — Trunks
Figure 18: Interfaces–Trunks

Trunk Table: Displays a list of active trunks on the device or the configured trunk groups.

• Active trunks are trunk groups that have ports assigned to them.

• Toggle between the active trunks and trunk groups by using the labeled button in the upper right corner of the
table.

Trunk Details: Displays details about a selected trunk. Select a trunk in the table to see its details.

Load Balancing: Displays the current load balancing algorithm configured on the switch.

• L2 - Uses the best MAC Source Address (MAC-SA) and MAC Destination Address (MAC-DA) information to
load balance traffic.

• L3 - Uses the best IP Source Address (IPSA) and IP Destination Address (IPDA) method to load balance IP
traffic, and MAC Source Address (MAC-SA) and MAC Destination Address (MAC-DA) to load balance non-IP
traffic.

• L4 - Uses the best L4 information (if present) or L3 information for IP traffic, or MAC Source Address (MAC-
SA) and MAC Destination Address (MAC-DA) for non-IP traffic.

Edit Load Balancing: Edit the configured load balancing algorithm on the device.

46 Aruba Basic Operation Guide for ArubaOS-Switch 16.05

Anexo 02 ITEM 11 (0592659)         SEI 0008478-63.2018.6.02.8000 / pg. 5659



Edit Trunks: Configure trunks on this device.

Traffic — Spanning Tree
Figure 19: Traffic–Spanning Tree

Spanning Tree Status: Displays whether spanning tree is enabled or disabled on the device.

Spanning Tree Mode: Displays the current spanning tree mode on the device:

• MSTP (Multiple Spanning Tree)

• RPVST (Rapid Per-VLAN Spanning Tree)

Loop Inconsistent Ports: Displays the list of loop inconsistent ports on the device detected by Loop Guard.

Root Inconsistent Ports: Displays the list of root inconsistent ports on the device detected by Root Guard.

Root Change History: Displays the last 10 root change events on the device.

• By default, a scatter plot chart will be shown representing the data on an hourly basis broken out per day.

• Use the icon in the upper right corner of this component to view the data in a standard table format.

Assigned Ports: Displays the ports assigned to a variety of spanning tree port types that are configurable
through the CLI. Types include:

• Loop Guard

• Root Guard

• TCN Guard

• BPDU Protected Ports

• BPDU Filtered ports

Topology Change Count: Displays the current topology change count on the device.

Time Since Last Change: Displays the time since that last topology change detected on the device.

MSTP Details: Displays the MSTP configuration identifiers on the device including the name, revision, and digest.
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Security — Clients
Figure 20: Security–Clients

Authentication Type Graph: Displays a graph that summarizes the use of authentication types used for client
authorization. Displays statistics like most used and least used authentication types.

User Role Graph: Displays a graph that summarizes the use of user roles associated with the connected clients.

Client Status Summary: Displays the total number of clients connected to the switch. Also displays client status
summary.

Client Details: Displays client-specific information such as:

• Physical port ID

• MAC address

• IP address

• Untagged and tagged VLANs

• User role session time

Connected Clients: Displays a list of all clients connected to the switch. Use the pagination controls at the
bottom of the page to move through the client list.

Filter Clients Table: The display dropdown and filter icon can be used to show/hide table columns and filter the
table results based on user-specified options. Select either tool to begin filtering.
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Security — User Roles
Figure 21: Security–User Roles

User Roles: Displays all user roles configured on the switch.

• Each card represents a user role configured.

• User role cards are clickable.

• You can sort the role cards by name or type.

• Click Apply the sort.

• Click the arrow to switch between ascending and descending sort orders.

User Role Information: Indicates whether the user role is enabled or disabled. Also displays the initial user role
configured on the switch.

User Role Card: Displays user role details such as:

• Name

• Type

• Policy

• VLAN

• Captive portal profile

• Reauthentication period
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Security — Intrusion Log
Figure 22: Security–Intrusion Log

Intrusion Log: Displays a list of the 20 most recent violation attempts detected on the device regardless of
whether the alert flags for these attempts have been reset.

Ports With Intrusion Flag: Displays a list of ports that have the intrusion flag set. The flag gets set when the
device detects a violation attempt on the listed port.

Reset Intrusion Flags: Reset all intrusion flags using the Reset Intrusion Flag button located in the upper right
corner of the log table.

Security — Port Security
Figure 23: Security–Port Security
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Port Security Table: Displays security properties for all ports on the device.

Properties include:

• Learn mode

• Address limit

• Violation action

Select a row in the table to see additional details about the port.

Learn Mode: Displays the selected ports learn mode.

Mode options include:

• Continuous

• Static

• Configured

• Port Access

• Limited

Additional information about what the assigned mode means can be seen following the mode type.

Authorized Address Limit: Displays the number of authorized addresses allowed on the port.

Authorized MAC Addresses: Displays the authorized MAC addresses allowed on the port.

Filter Port Table: Filter the port table by any of the available table columns.

Edit Port: Configure the port security properties on the selected port.

Security — IP Authorization
Figure 24: Security–IP Authorization
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IP Authorization Info: Displays the IP Authorization Info from the row selected in the IP Authorization Table. You
can edit the entry by selecting the drawing icon in the top right corner. You can also delete the entry by selecting
the garbage icon in the top right corner.

Total Single Station Entries with Manager Access: Displays the total number of entries in the IP Authorization
Table that have Manager Access Level and only apply to one computer. This is essentially all entries with a
subnet mask of 255.255.255.255 or 32 prefix length and have Manager Access Level.

Total Multiple Station Entries with Manager Access: Displays the total number of entries in the IP
Authorization Table that have Manager Access Level and apply to multiple computers. This is essentially all
entries with a subnet mask different from 255.255.255.255 or 32 prefix length and have Manager Access Level.

Total Single Station Entries with Operator Access: Displays the total number of entries in the IP Authorization
Table that have Operator Access Level and only apply to one computer. This is essentially all entries with a
subnet mask of 255.255.255.255 or 32 prefix length and have Operator Access Level.

Total Multiple Station Entries with Operator Access: Displays the total number of entries in the IP
Authorization Table that have Operator Access Level and apply to multiple computers. This is essentially all
entries with a subnet mask different from 255.255.255.255 or 32 prefix length and have Operator Access Level.

IP Authorized Management: Displays a table of all IP Authorized entries. You can add an entry by selecting the
add icon in the top right corner. To edit or delete an entry, use the icons in the IP Authorization Info tile.

Configurations — Config Report
Figure 25: Configurations–Config Report

Running Configuration: Displays the current running configuration as shown in the show running-config
CLI command.

Expand and collapse nodes in the running configuration by selecting the + and - icons next to a node that has
content underneath it.
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Configurations — Management
Figure 26: Configurations–Management

Download: Downloads the selected configuration file from the device to the local system where the browser is
being used.

Delete: Deletes the selected configuration file from the device. A confirmation window is displayed because after
a file is deleted it cannot be recovered.

Rename: Renames the selected configuration file to a new name. A field is displayed in which the new name may
be entered. When done, Click Save or Cancel.

Update: Updates an existing device configuration file or uploads a new configuration file from the local system
where the browser is being used. A confirmation window is displayed because after the upload begins it cannot
be aborted.

Procedure

1. Drag and drop a file onto the indicated area or click the button to browse for a file to be uploaded.

2. Specify which configuration file is to be updated (existing or new). If using a new file, the name of the file on
the local system will be used.

3. Click Update to initiate the upload.

4. A confirmation window displays because after the upload begins, it cannot be aborted.
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Overview of Preview Mode
Preview mode feature is available only when preview mode is enabled on a switch. The intent of having features
in preview mode is to allow users to experiment the features and solicit early feedback from them.

Use the features in a preview mode at your own risk. When you enable preview mode on a switch, you are
prompted before entering the preview mode. On confirmation, the prev-mode is prefixed with the switch
configuration prompt.

For example:

(Prev-mode) switch(config)#

The existing configuration for a switch continues even after you enable preview mode.

When you exit the preview mode, you are prompted to reboot the switch. Rebooting the switch reverts the switch
to a configuration that existed prior to enabling preview mode.

Supported Platforms

Aruba 2930F
Aruba 5400R
Aruba 3810M

Enabling Preview Mode
Procedure

Use the CLI command to enable the preview mode on the switch.

Syntax
preview-mode
Description

Enter preview mode on the switch. You can now configure the features in preview mode. Exiting the preview
mode reboots the switch to a configuration, that existed prior to enabling the preview mode.

Example output
switch(config)# preview-mode
ATTENTION: You are entering preview mode on this product. This mode, the
commands, features and functionality specific to this mode, and all output
from this mode are Hewlett Packard Enterprise Confidential and Proprietary.
You may use this mode at your own risk. Any defects or issues encountered
in this mode will be addressed per Hewlett Packard Enterprise's discretion.

Chapter 5
Operating in Preview Mode
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Continue (y/n)? y
Prev-mode)switch(config)#

Viewing features in Preview Mode
Procedure

Use the CLI command to view the features in a preview mode.

Syntax
show preview-mode
Description

Displays the list of features in preview mode.

Parameters
features
Displays the features in a preview mode.

Example output
(Prev-mode)switch(config)# show preview-mode
 features              Show the features under preview mode.
(Prev-mode)switch(config)# show preview-mode features
 Features in Preview Mode:
 Multicast Offload Engine  Enable/Disable multicast offload engine for routed
                           multicast IPv4 traffic.
                           Usage:
                           fabric-offload multicast ipv4 route

Multicast Offload Engine
In the current release, enabling Multicast Offload Engine (MOE) to route multicast IPv4 traffic is the only feature
supported on the switch in a preview mode.

Procurve switches without MOE enabled, use ingress replication to send multicast traffic to multiple destinations.
The processes such as request, reply, or forward are repeated for every destination node chip. Thus, it results in
sending the packet over the ingress node’s fabric interface once for each destination node. To overcome this
problem, MOE is enabled.

There is a significant improvement in the performance, as enabling MOE prevents sending multiple copies of the
packet across the ingress node chip’s fabric interface. When you enable MOE, the request or reply process to
each destination node chip still occurs, but the packet is forwarded once to the fabric chip, and the fabric chip
replicates the packet to all other destination nodes that has to receive the packet.

In the current release, MOE is enabled only to route multicast IPv4 packets.

As the feature is available for experiment purpose, it has the following limitations:

• You cannot use MOE with VSF.

• You cannot enable MOE on jumbo-enabled VLANs.
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Supported Platform

Aruba 5400R v3 standalone

Enabling MOE
Procedure

Use the CLI command to enable MOE for IPv4 multicast traffic. The running-config file displays the MOE
enabled for IPv4 traffic.

Syntax
fabric-offload multicast ipv4 route {enable|disable}
Description

Enable or disable multicast offload engine for routed multicast IPv4 traffic.

Usage
fabric-offload multicast ipv4 route {enable|disable}
Example output
(Prev-mode)switch# show running-config

Running configuration:

; J9851A Configuration Editor; Created on release #KB.16.01.0000x
; Ver #0a:19.f4.7b.ff.ff.fc.ff.ff.3f.ef:b0 
hostname "HP-5412Rzl2" 
module A type j9992a
module L type j9987a
fabric-offload multicast ipv4 route enable
ip routing
ip multicast-routing
snmp-server community "public" unrestricted
oobm
ip address dhcp-bootp
exit
vlan 1
name "DEFAULT_VLAN"
untagged A1-A21,L1-L24
ip address dhcp-bootp
exit
no allow-v2-modules
preview-mode 
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Listing available commands

Procedure

1. Type ? to list available commands. Typing the ? symbol lists the commands you can execute at the current
privilege level.

2. The commands that are available to a user depend on the user’s privilege level. At a given privilege level, you
can list and execute the commands that the privilege level offers, plus all commands available at preceding
levels.

3. When - - MORE - - appears, there are more commands in the listing. Do one of the following:

a. To list the next screen of commands, press the Space bar.

b. To list the remaining commands one-by-one, repeatedly press [Enter].

The following example shows the result of typing? at the Operator level. You can list and execute only the
Operator-level commands at the Operator level.

Figure 27: The Operator-level command listing

switch> ?
 chassislocate         Control the chassis locate led.
 dir                   Display a list of the files and subdirectories in a
                       directory on a USB device.
 display               Display current system information.
 enable                Enter the Manager Exec context.
 exit                  Return to the previous context or terminate current
                       console/telnet session if you are in the Operator
                       context level.
 link-test             Test the connection to a MAC address on the LAN.
 logout                Terminate this console/telnet session.
 menu                  Change console user interface to menu system.
 page                  Toggle paging mode.
 ping                  Send IPv4 ping request(s) to a device on the network.
 ping6                 Send IPv6 ping request(s) to a device on the network.
 quit                  Exit from current command view
 services              Display parameters for the services module.
 show                  Display switch operation information.
 traceroute            Trace the IPv4 route to a device on the network.
 traceroute6           Trace the IPv6 route to a device on the network.
 verify                Verify the signature of a switch firmware image.
 wireless-services     Display parameters for the wireless-services module.
-- MORE --, next page: Space, next line: Enter, quit: Control-C

Chapter 6
Using the Command Line Interface (CLI)
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The following example shows the result of typing? at the Manager level. At this level, you can list and execute
commands that are available at both the Operator and Manager levels. Typing ? at the Global Configuration level
or the Context Configuration level produces similar results.

Figure 28: The Manager-level command listing

switch# ?
 backup                Backup next startup-configuration file to TFTP server
 boot                  Reboot the device.
 clear                 Clear table/statistics.
 clock                 Display/set current time, date, and local time
                       parameters.
 command-alias         Specify command alias
 configure             Enter the Configuration context.
 copy                  Copy datafiles to/from the switch.
 debug                 Enable/disable debug logging.
 delete                Delete a file
 diagnostic-level      Set the diagnostic level.
 end                   Return to the Manager Exec context.
 erase                 Erase stored data files.
 getMIB                Retrieve and display the value of the MIB objects
                       specified.
 getNextMIB            Retrieve and display the value of the next MIB object
                       for each OID specified
 kill                  Kill other active console, Telnet, or SSH sessions.
 licenses              Manage premium features.
 log                   Display log events.
 print                 Execute a command and redirect its output to the device
                       channel for current session.
-- MORE --, next page: Space, next line: Enter, quit: Control-C
  

Listing command options
Procedure

Enter command keywords followed by ? to display command options.

For example, suppose you want to see the command options for configuring the console settings:

switch(config)# console ?
 baud-rate             Set the data transmission speed for the device connect
                       sessions initiated through the Console port.
 events                Set level of the events displayed in the device's Events
                       Log.
 flow-control          Set the Flow Control Method; default is xon-xoff.
 idle-timeout          The number of seconds of no activity detected before the
                       switch terminates a session.
 inactivity-timer      [Deprecated] Set the number of minutes of no activity
                       detected before the switch terminates a communication
                       session.
 local-terminal        Set type of terminal being used for the current console
                       or Telnet session (default is vt100).
 screen-refresh        Set refresh time for menu status and counters in
                       seconds.
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 terminal              Set type of terminal being used for all console and
                       Telnet sessions (default is vt100).

Displaying CLI “Help”
Do one of the following:

Procedure

1. Type “help” to display a list of commands that includes a brief summary of each command’s purpose.
The list includes all commands available at the current privilege level. That is, at the Operator level, executing
help displays the Help summaries only for Operator-Level commands. At the Manager level, executing help

displays the Help summaries for both the Operator and Manager levels, and so on.

2. Type a command string followed by “help” to display detailed information about how to use an individual
command. Use the following syntax:

<command-string> help
Help is displayed for any command that is available at the current privilege level. An “Invalid input” message is
displayed if you try to list the help for an individual command from a privilege level that does not include that
command.

The following example shows the result of typing “help” at the Operator privilege level. The Operator-Level
commands are listed with their purposes.

Figure 29: Help for Operator-Level commands

switch> help

 chassislocate         Control the chassis locate led.
 dir                   Display a list of the files and subdirectories in a
                       directory on a USB device.
 display               Display current system information.
 enable                Enter the Manager Exec context.
 exit                  Return to the previous context or terminate current
                       console/telnet session if you are in the Operator
                       context level.
 link-test             Test the connection to a MAC address on the LAN.
 logout                Terminate this console/telnet session.

The following example shows Help for the interface command at the Global Configuration privilege level:

Figure 30: Detailed Help for a specific command

switch(config)# interface help
Usage: no interface < [ethernet] PORT-LIST [...] | loopback <num> >

Description: Enter the Interface Configuration Level, or execute one
             command for that level. Without optional parameters
             specified, the 'interface' command changes the context to
             the Interface Configuration Context Level for execution of 
             configuration changes to the port or ports in the PORT-LIST
             or with loopback keywork it will change context to loopback
             mode. Use 'interface ?' to get a list of all valid commands.
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Note that trying to list the help for an individual command from a privilege level that does not include that
command results in an error message. For example, trying to list the help for the interface command while at the
global configuration level produces this result:

switch# speed-duplex help
Invalid input: speed-duplex

Enabling and disabling CLI message prefixes
When message prefixes are enabled, a CLI command returns a message that is prefixed with “Error”, “Warning”,
or “Information” to indicate the type of message.

Procedure

1. Type “session show-message-type enable” to enable the display of prefixes with the returned message.

2. Type “session show-message-type disable” to disable the display of prefixes with the returned message.

The syntax is as follows:

session show-message-type [enable|disable]
The message prefixes setting is not saved when the switch is rebooted. The message prefixes are disabled on all
CLI sessions by default.

The following example shows returned messages of each of the three message types.

Figure 31: Message prefixes

switch(config)# router rip
Error: IP Routing support must be enabled first.

switch(config)# qinq mixed vlan
Warning: This command will reboot the device. Any prior configuration
on this config file will be erased and the device will boot up with a
default configuration
for the new qinq mode.
Do you want to continue [y/n]? n

switch(config)# snmp-server mib hpSwitchAuthMIB included
Information: For security reasons, network administrators are
encouraged to disable SNMPv2 before using the MIB.
To determine if message labeling is enabled, enter the show session command.

Figure 32: The label cli-return-message command enabled

switch(config)# show session
show message type   : Enabled
cli interactive mode: Enabled

Enabling and disabling CLI interactive command mode
When the CLI interactive command mode is enabled, you must explicitly enter the choice of yes (‘y’) or no (‘n’) for
interactive commands. When interactive command mode is disabled, you are not prompted to explicitly enter the
choice of yes (‘y’) or no (‘n’) unless you are saving a configuration.
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Procedure

1. Type “session interactive-mode enable” to enable the CLI interactive command mode.

2. Type “session interactive-mode disable” to disable the CLI interactive command mode.

The syntax is as follows:

session interactive-mode [enable|disable]
The interactive–mode setting is not saved when the switch is rebooted. The interactive mode is enabled on all CLI
sessions by default.

The following example shows some commands used with the CLI interactive command mode disabled.

Figure 33: CLI interactive mode when disabled

switch(config)# no password all
Password protection for all will be deleted, continue [y/n]? y

switch(config)# boot system flash secondary
System will be rebooted from secondary image.
Do you want to continue [y/n]? y
Do you want to save current configuration [y/n]? n

To determine if the CLI interactive mode is enabled or disabled, enter the show session command.

Figure 34: CLI interactive mode enabled

switch(config)# show session
show message type   : Enabled
cli interactive mode: Enabled

Interactive commands requiring additional options
Interactive commands that require input other than yes or no are not affected when CLI interactive mode is
disabled. A warning message is displayed when these commands are executed, for example:

Interactive mode is disabled; This command will be ignored. 
Enable cli-interactive-mode to use this command.
The following commands will issue this warning when interactive mode is disabled. An alternate way to enter the
command (when one is available) is shown.

Command Non-Interactive Alternate Command

setup mgmt-interfaces
No equivalent non-interactive command

aaa port-access supplicant 
<port-list> secret

aaa port-access supplicant <port-list> secret 
<secret-string>

password manager password manager plaintext <password-string>

password operator password operator plaintext <password-string>

Table Continued
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Command Non-Interactive Alternate Command

aaa port-access supplicant 
<port-list> secret

aaa port-access supplicant <port-list> secret 
<secret-string>

crypto host-cert generate 
self-signed

crypto host-cert generate self-signed <start-date> <end-date> <CNAME-STR> <ORG-
UNIT-STR> <ORGANIZATION-STR> <CITY-STR> <STATE-STR> <CODE>

Menu commands
When CLI interactive mode is disabled, all CLI commands that launch the menu interface are not affected by the
interactive mode. A warning message is displayed, for example:

switch(config)# menu
Interactive mode is disabled; This command will be ignored.
Enable cli-interactive-mode to use this command.

Other menu-based commands that will not be affected are:

• setup

• show interfaces display

SNMPv3 special cases
The following are special cases when using SNMPv3 with interactive mode.

• snmpv3 user:

In interactive mode, the command snmpv3 user will create snmpv3 users, even if snmpv3 has not been
enabled.

• snmpv3 user:

When interactive mode is disabled, this command only enables snmpv3. It does not prompt for an
authentication password. When the command is first executed, a default initial user is created. A message
displays:

User ‘initial’ has been created.

Simplifying entry of commands at the command line
Do one or more of the following to simplify entry of commands:

Procedure

1. To find or complete a command, use the [TAB] key.

See Finding or completing a command on page 63

2. To re-execute a command, use the redocommand.

See redo on page 64

3. To repeatedly re-execute one or more commands, use the repeat command.
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See repeat on page 64

4. To create a shortcut name for a command to simplify keystrokes, use the alias command.

See alias on page 65

5. To simplify movement or placement of your cursor at the command line, use the shortcut keystrokes. See
CLI shortcut keystrokes on page 67

Finding or completing a command

Procedure

1. Type one or more consecutive characters of a command and then press
[Tab] (with no spaces allowed) to find a CLI command or to quickly complete a CLI command name. The CLI
completes the current command name, including hyphenated extensions, if you have typed enough characters
for the CLI to distinguish it from other possibilities.

2. The following example shows the result when you press
[Tab] immediately after typing “t” at the Global Configuration level. The CLI displays the available command
options that begin with “t”.

switch(config)# t
 tacacs-server
 telnet-server
 tftp
 time
 timesync
 trunk
 trunk-load-balance
 task-monitor
 telnet
 terminal
 test
 traceroute
 traceroute6

3. The following example shows the result when you press
[Tab] immediately after typing “port-”.

switch (config)# port-
switch (config)# port-security

4. The following example shows the result of pressing
[Tab] after a completed command word lists the further options for that command. In this example, entering

switch(config)# qos[Tab]
          
displays the following:

switch (config)# qos
 udp-port              Set UDP port-based priority.
 tcp-port              Set TCP port-based priority.
 device-priority       Configure device-based priority for a particular IP
                       address.
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 dscp-map              Define mapping between a DSCP (Differentiated-Services
                       Codepoint) value and an 802.1p priority.
 protocol              Configure protocol-based priority.
 queue-config          Configure the number of egress priority queues for each
                       port.
 type-of-service       Configure the Type-of-Service method the device uses to
                       prioritize IP traffic.
 watch-queue           Enables monitoring of per-queue dropped packets due to
                       outbound congestion on the given port.

redo
Syntax
redo [ <number> | <command-str> ]
Description

Parameters/Options/Flags/Strings/...

The redo command re-executes a command. The last command that was used is executed by default.

Specifiers
<number>

Specifies the position of the command in the history list. When the position is specified, the nth command
starting from the most recent command in the history is executed.

<command-str>
Specifies the name of a previously executed command. The most recently executed command whose name
matches the specified string is executed.

Example

This example shows the use of the redo command.

switch(config)# show history
2       show arp
1       show flash

switch(config)# redo 2

  IP ARP table

   IP Address     MAC Address     Type      Port
   -------------  --------------  --------  ----
   15.255.128.1   00000c-07ac00   dynamic   A11 

repeat
Syntax
repeat [cmdlist] [count] [delay]
Description

The repeat command repeatedly re-executes one or more commands. By default, the most recent command in
the history is executed until a key is pressed.

Options
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[cmdlist]
Specifies the position of a command, or range of positions of multiple commands, in the history list. The nth
most recent commands in the history, where "n" is the position in the history list, are re-executed.

[count]
Specifies number of times to execute the command or commands.

[delay]
Specifies a delay. The execution of the command is delayed for the number of seconds specified.

Usage
switch(config)# repeat 1-4,7-8,10 count 2 delay 3
Example

This demonstrates the use of the repeat command to re-execute commands that are at positions 1 through 2 in
the command history.

switch(config)# show history
3        show ver
2        show ip
1        show arp

switch(config)# repeat 1-2

  IP ARP table

   IP Address      MAC Address       Type      Port
   --------------  ----------------  --------  ----
   15.255.128.1    000000-000000     dynamic

Internet (IP) Service

IP Routing : Disabled

Default Gateway :
Default TTL     : 64
Arp Age         : 20
Domain Suffix   :
DNS server      :

VLAN               | IP Config   IP Address      Subnet Mask    Proxy ARP
------------------ + ----------- --------------- -------------- ---------
DEFAULT_VLAN       | DHCP/Bootp  15.255.131.90   255.255.248.0  No No

alias
Syntax
alias <name> <command>
no alias <name> <command>
Description

The alias command creates a shortcut alias name that can be used in place of a CLI command to simplify
keystrokes and aid memory. The alias command is executed from the current configuration context.
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Options
no

Specifies that the alias for the command is to be removed.

Specifiers
<name>

Specifies the alias for the CLI command. The alias name must not be an existing CLI command.

<command>
Specifies an existing CLI command for which to create the alias. The command must be enclosed in quotes.

It is recommended that you use an alias that does not have an existing tab completion in the CLI. For
example, using an alias that starts with "show" or "int" would complete to "show" and "interface" respectively
when you use the tab completion function.

Privilege

The alias command is executed from the current configuration context (operator, manager, or global). If the
command that is aliased has to be executed in the global configuration context, you must execute the alias for
that command in the global configuration context. This prevents bypassing the security for a particular context.

Restrictions

• The alias name must not be an existing CLI command. Existing CLI commands are searched before looking
for an alias command; an alias that is identical to an existing command will not be executed.

• Hewlett Packard Enterprise recommends that you configure no more than 128 aliases.

Example

This example shows the creation and use of an alias for the show int custom command to demonstrate how a
command alias can simplify keystrokes when entering a command. The actual show int custom command is
used first and then an alias is created for it and then used.

switch(config)# show int custom 1-4 port name:4 type vlan intrusion speed
enabled mdi

 Status and Counters - Custom Port Status

                               Intrusion
Port Name     Type       VLAN  Alert     Speed   Enabled MDI-mode
---- -------- ---------- ----- --------- ------- ------- -------
1    Acco     100/1000T  1     No        1000FDx Yes     Auto
2    Huma     100/1000T  1     No        1000FDx Yes     Auto
3    Deve     100/1000T  1     No        1000FDx Yes     Auto
4    Lab1     100/1000T  1     No        1000FDx Yes     Auto

switch(config)# alias sic "show int custom 1-4 port name:4 type vlan intrusion
speed enabled mdi"
switch(config)#

switch(config)# sic 

Status and Counters - Custom Port Status

                               Intrusion
Port Name     Type       VLAN  Alert     Speed   Enabled MDI-mode
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---- -------- ---------- ----- --------- ------- ------- -------
1    Acco     100/1000T  1     No        1000FDx Yes     Auto
2    Huma     100/1000T  1     No        1000FDx Yes     Auto
3    Deve     100/1000T  1     No        1000FDx Yes     Auto
4    Lab1     100/1000T  1     No        1000FDx Yes     Auto

CLI shortcut keystrokes

Keystrokes Functions

[Ctrl] [A] Jumps to the first character of the command line.

[Ctrl] [B] or ‘←’ Moves the cursor back one character.

[Ctrl] [C] Terminates a task and displays the command prompt.

[Ctrl] [D] Deletes the character at the cursor.

[Ctrl] [E] Jumps to the end of the current command line.

[Ctrl] [F] or ‘→’ Moves the cursor forward one character.

[Ctrl] [K] Deletes from the cursor to the end of the command line.

[Ctrl] [L] or [Ctrl] [R] Repeats current command line on a new line.

[Ctrl] [N] or ‘↓’ Enters the next command line in the history buffer.

[Ctrl] [P] or ‘↑’ Enters the previous command line in the history buffer.

[Ctrl] [U] or [Ctrl] [X] Deletes from the cursor to the beginning of the command line.

[Ctrl] [W] Deletes the last word typed.

[Esc] [B] Moves the cursor backward one word.

[Esc] [D] Deletes from the cursor to the end of the word.

[Esc] [F] Moves the cursor forward one word.

[Backspace] Deletes the first character to the left of the curser in the command line.

[Spacebar] Moves the cursor forward one character.

Overview of the CLI
The CLI is a text-based command interface for configuring and monitoring the switch. The CLI gives you access
to the switch’s full set of commands while providing the same password protection that is used in the web browser
interface (WebAgent) and the menu interface.

Access

Like the menu interface, the CLI is accessed through the switch console, and in the switch’s factory default state,
is the default interface when you start a console session. You can access the console out-of-band by directly
connecting a terminal device to the switch, or in-band by using Telnet either from a terminal device or through the
WebAgent.

Chapter 6 Using the Command Line Interface (CLI) 67

Anexo 02 ITEM 11 (0592659)         SEI 0008478-63.2018.6.02.8000 / pg. 5680



Also, if you are using the menu interface, you can access the CLI by selecting the Command Line (CLI) option in
the Main Menu.

Privilege levels

The CLI offers these privilege levels to help protect the switch from unauthorized access:

1. Operator

2. Manager

3. Global Configuration

4. Context Configuration

CLI commands are not case-sensitive.

When you use the CLI to make a configuration change, the switch writes the change to the Running-Config file in
volatile memory. This allows you to test your configuration changes before making them permanent. To make
changes permanent, you must use the write memory command to save them to the Startup-Config file in non-
volatile memory. If you reboot the switch without first using write memory, all changes made since the last reboot
or write memory (whichever is later) will be lost.

More information

Configuring the switch on page 76.

Privilege levels for CLI access

Privilege levels at log on
Privilege levels control the type of access to the CLI. To implement this control, you must set at least a Manager
password. Without a Manager password configured, anyone having serial port, Telnet, or web browser
access to the switch can reach all CLI levels. (For more on setting passwords, See the usernames and
passwords in the Access Security Guide for your switch.)

When you use the CLI to log on to the switch, and passwords are set, you will be prompted to enter a password.
For example:

CLI log-on screen with password(s) set

switch
Software revision K.15.12.0001

Copyright (C) 1991-2013 Hewlett-Packard Development Company, L.P.

                      RESTRICTED RIGHTS LEGEND
Confidential computer software.  Valid license from HP required for possession,
use or copying. Consistent with FAR 12.211 and 12.212, Commercial Computer
Software, Computer Software Documentation, and Technical Data for Commercial
Items are licensed to the U.S. Government under vendor's standard commercial
license.
                     HEWLETT-PACKARD DEVELOPMENT COMPANY, L.P.
                   20555 State Highway 249, Houston, TX 77070

We'd like to keep you up to date about:
  * Software feature updates
  * New product announcements
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  * Special events
Please register your products now at:  www.hp.com/networking/register

Username:
In the above case, you will enter the CLI at the level corresponding to the password you provide (operator or
manager).

If no passwords are set when you log on to the CLI, you will enter at the Manager level. For example:

switch# _

Hewlett Packard Enterprise strongly recommends that you configure a Manager password. If a
Manager password is not configured, then the Manager level is not password-protected, and anyone
having in-band or out-of-band access to the switch may be able to reach the Manager level and
compromise switch and network security. Note that configuring only an Operator password does not
prevent access to the Manager level by intruders who have the Operator password.

Pressing the Clear button on the front of the switch removes password protection. For this reason,
it is recommended that you protect the switch from physical access by unauthorized persons.
If you are concerned about switch security and operation, you must install the switch in a secure
location, such as a locked wiring closet.

Privilege level operation
The access sequence for the various privilege levels is shown in Figure 35: Access sequence for privilege
levels on page 69.

Figure 35: Access sequence for privilege levels

You can move between the privilege levels. The following table lists examples and results of movement between
the privilege levels.
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Change in Levels Example of Prompt, Command, and Result

Operator level to Manager level
switch> enable

Password:_

switch#_

After you enter enable, the
Password prompt appears. After
you enter the Manager
password, the system prompt
appears with the # symbol:

Manager level to Global
configuration level switch# config

switch(config)#

Global configuration level to a
Context configuration level switch(config)# vlan 10

switch(vlan-10)#

Context configuration level to
another Context configuration
level

switch(vlan-10)# interface e 3

switch(int-3)#

The CLI accepts "e" as the
abbreviated form of "ethernet".

Move from any level to the
preceding level switch(int-3)# exit

switch(config)# exit

switch# exit

switch>

Move from any level to the
Manager level switch(int-3)# end

switch#
-or-

switch(config)# end

switch#

Moving between the CLI and the Menu interface. When moving between interfaces, the switch retains the
current privilege level (Manager or Operator). That is, if you are at the Operator level in the menu and select the
Command Line Interface (CLI) option from the Main Menu, the CLI prompt appears at the Operator level.

Changing parameter settings. Regardless of which interface is used (CLI, menu interface, or WebAgent), the
most recently configured version of a parameter setting overrides any earlier settings for that parameter. For
example, if you use the menu interface to configure an IP address of "X" for VLAN 1 and later use the CLI to
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configure a different IP address of "Y" for VLAN 1, then "Y" replaces "X" as the IP address for VLAN 1 in the
running-config file. If you subsequently execute write memory in the CLI, then the switch also stores "Y" as the
IP address for VLAN 1 in the startup-config file. (For more on the startup-config and running config files, see
"Switch Memory and Configuration".)

Operator privileges
At the Operator level, you can examine the current configuration and move between interfaces without being able
to change the configuration. A ">" character delimits the Operator-level prompt. For example:

switch>_

(Example of the Operator prompt.)

When using enable to move to the Manager level, the switch prompts you for the Manager password if one has
already been configured.

Manager privileges
Manager privileges give you three additional levels of access: Manager, Global Configuration, and Context
Configuration. A "#" character delimits any Manager prompt. For example:

switch#_

(Example of the Manager prompt.)

Manager level:

Provides all Operator level privileges plus the ability to perform system-level actions that do not require saving
changes to the system configuration file. The prompt for the Manager level contains only the system name and
the "#" delimiter, as shown above. To select this level, enter the enable command at the Operator prompt and
enter the Manager password, when prompted. For example:

switch> enable
Password:
switch# _ 

Enter enable at the Operator prompt. CLI prompt for the
Manager password. The Manager prompt appears after the
correct Manager password is entered.

Global configuration level:

Provides all Operator and Manager level privileges, and enables you to make configuration changes to any of the
switch’s software features. The prompt for the Global Configuration level includes the system name and "(config)".
To select this level, enter the config command at the Manager prompt. For example:

switch# config
switch(config)#_

Enter config at the Manager prompt. The Global Config
prompt.

Context configuration level:

Provides all Operator and Manager privileges, and enables you to make configuration changes in a specific
context, such as one or more ports or a VLAN. The prompt for the Context Configuration level includes the
system name and the selected context. For example:

switch(eth-1)#
switch(vlan-10)#
The Context level is useful, for example, for executing several commands directed at the same port or VLAN, or if
you want to shorten the command strings for a specific context area. To select this level, enter the specific context
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at the Global Configuration level prompt. For example, to select the context level for an existing VLAN with the
VLAN ID of 10, you would enter the following command and see the indicated result:

switch(config)# vlan 10
switch(vlan-10)#

Table 4: Privilege level hierarchy — Operator Privilege

Privilege Level Example of Prompt and Permitted Operations

Operator Level
switch> show <command> setup

View status and configuration
information.

ping <argument>

link-test <argument>

Perform connectivity tests.

enable
Move from the CLI interface to the menu
interface.

Use enable at the
Operator level to move to
the Manager level.

menu
Move from the CLI interface to the menu
interface.

logout
Exit from the CLI interface and terminate
the console session.

exit
Terminate the current session (same as
logout).
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Table 5: Privilege level hierarchy — Manager Privilege

Privilege Level Example of Prompt and Permitted Operations

Manager Level
switch#

Perform system-level actions such as system
control, monitoring, and diagnostic commands,
plus any of the Operator-level commands. For a
list of available commands, enter ? at the
prompt.

Global Configuration Level
switch(config)#

Execute configuration commands, plus all
Operator and manager commands. For a list of
available commands, enter ? at the prompt.

Context Configuration Level
switch(eth-5)#

switch(vlan-100)#

Execute context-specific configuration
commands, such as a particular VLAN or switch
port. This is useful for shortening the command
strings you type, and for entering a series of
commands for the same context. For a list of
available commands, enter ? at the prompt.

Configuration commands and context configuration
modes
You can execute any configuration command in the global configuration mode or in selected context modes.
However, using a context mode enables you to execute context-specific commands faster, with shorter command
strings.

The switch offers interface (port or trunk group) and VLAN context configuration modes:

Port or trunk-group context. Includes port-or trunk-specific commands that apply only to the selected port(s) or
trunk group, plus the global configuration, Manager, and Operator commands. The prompt for this mode includes
the identity of the selected port(s):

switch(config)# interface c3-c6
switch(eth-C5-C8)#
switch(config)# interface trk1
switch(eth-Trk1)#
Commands executed at configuration level for entering port and trk1static trunk-group contexts, and
resulting prompts showing port or static trunk contexts.

switch(eth-C5-C8)#
switch(eth-Trk1)#
switch(eth-C5-C8)# ?
switch(eth-C5-C8)# ?
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Lists the commands you can use in the port or static trunk context, plus the Manager, Operator, and
context commands you can execute at this level.

Figure 36: Context-specific commands affecting port context

VLAN context. Includes VLAN-specific commands that apply only to the selected VLAN, plus Manager and
Operator commands. The prompt for this mode includes the VLAN ID of the selected VLAN. For example, if you
had already configured a VLAN with an ID of 100 in the switch:

switch(config)# vlan 100
Command executed at configuration level to enter VLAN 100 context.

switch(vlan-100)#
Resulting prompt showing VLAN 100 context.

switch(vlan-100)# ?

74 Aruba Basic Operation Guide for ArubaOS-Switch 16.05

Anexo 02 ITEM 11 (0592659)         SEI 0008478-63.2018.6.02.8000 / pg. 5687



Lists commands you can use in the VLAN context, plus Manager, Operator, and context commands you
can execute at this level.

Figure 37: Context-specific commands affecting VLAN context
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Using the CLI to implement configuration changes
The CLI offers these capabilities for implementing configuration changes:

Procedure

1. Access to the full set of switch configuration features

2. The option of testing configuration changes before making them permanent

How to use the CLI to view the current configuration files. Use show commands to view the configuration for
individual features, such as port status or Spanning Tree Protocol. However, to view either the entire startup-
config file or the entire running-config file, use the following commands:

• show config

Displays a listing of the current startup-config file.

• show running–config

Displays a listing of the current running-config file.

• write terminal

Displays a listing of the current running-config file.

• show default–config

Displays a listing of a custom default config file.

• show config status

Compares the startup-config file to the running-config file and lists one of the following results:

◦ If the two configurations are the same, you will see:

Running configuration is the same as the startup configuration.

◦ If the two configurations are different, you will see:

Running configuration has been changed and saved.

show config, show running–config, and write terminal commands display the configuration
settings that differ from the switch’s factory default configuration.

How to use the CLI to reconfigure switch features. Use this procedure to permanently change the switch
configuration (that is, to enter a change in the startup-config file).

Chapter 7
Configuring the switch
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1. Use the appropriate CLI commands to reconfigure the desired switch parameters. This updates the selected
parameters in the running-config file.

2. Use the appropriate show commands to verify that you have correctly made the desired changes.

3. Observe the switch’s performance with the new parameter settings to verify the effect of your changes.

4. When you are satisfied that you have the correct parameter settings, use the write memory command to copy
the changes to the startup-config file.

The write memory command saves the running configuration file to the startup-config. The saved configuration
becomes the boot-up configuration of the switch on the next boot.

When using redundant management, saves the running configuration of the switch to flash on the active
management module. The saved configuration becomes the boot-up configuration of the switch the next time it is
booted. The saved configuration file is synchronised to the standby management module.

Note: If the active management module and the standby management module are running on different operating
systems because the boot set-default command was executed and then the standby module was rebooted, the
write memory command displays this warning: "Warning: The next reboot or failover is set to boot from a
different software image. These config changes may be incompatible or not used after a reboot or failover."

For example, the default port mode setting is auto. Suppose that your network uses Cat 3 wiring and you want to
connect the switch to another autosensing device capable of 100 Mbps operation. Because 100 Mbps over Cat 3
wiring can introduce transmission problems, the recommended port mode is auto-10, which allows the port to
negotiate full- or half-duplex, but restricts speed to 10 Mbps. The following command configures port A5 to
auto-10 mode in the running-config file, allowing you to observe performance on the link without making the mode
change permanent.

switch(config)# interface e a5 speed-duplex auto-10
After you are satisfied that the link is operating properly, you can save the change to the switch’s permanent
configuration (the startup-config file) by executing the following command:

switch(config)# write memory
The new mode (auto-10) on port A5 is now saved in the startup-config file, and the startup-config and running-
config files are identical. If you subsequently reboot the switch, the auto-10 mode configuration on port A5 will
remain because it is included in the startup-config file.

Beginning with K.15.01.0031, configuration changes to ports may require up to 10 seconds to take
effect, especially on switches with high CPU utilization. After a configuration command, perform an
appropriate show or show running-config command to confirm the configuration change. If
configuration scripts are used, the script must be modified either to check for successful completion
of the previous command before executing the next command, or to sleep for 10 seconds after the
configuration command is executed.

How to cancel changes you have made to the running-config file. If you use the CLI to change parameter
settings in the running-config file, and then decide that you do not want those changes to remain, you can use
either of the following methods to remove them:

• Manually enter the earlier values you had for the changed settings. (This is recommended if you want to
restore a small number of parameter settings to their previous boot-up values.)

• Update the running-config file to match the startup-config file by rebooting the switch. (This is recommended if
you want to restore a larger number of parameter settings to their previous boot-up values.)
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If you use the CLI to change a parameter setting, and then execute the boot command without first executing the
write memory command to save the change, the switch prompts you to specify whether to save the changes in
the current running-config file. For example:

Figure 38: Boot prompt for an unsaved configuration

The above prompt means that one or more parameter settings in the running-config file differ from their
counterparts in the startup-config file and you can choose which config file to retain and which to discard.

• If you want to update the startup-config file to match the running-config file, press [Y] for “yes”. (This means
that the changes you entered in the running-config file will be saved in the startup-config file.)

• If you want to discard the changes you made to the running-config file so that it will match the startup-config
file, then select [N] for “no”. (This means that the switch will discard the changes you entered in the running-
config file and will update the running-config file to match the startup-config file.)

If you use the CLI to make a change to the running-config file, you can either use the write memory
command or select the save option allowed during a reboot (see Figure 38: Boot prompt for an
unsaved configuration on page 78) to save the change to the startup-config file. That is, if you use
the CLI to change a parameter setting, but then reboot the switch from either the CLI or the menu
interface without first executing the write memory command in the CLI, the current startup-config file
will replace the running-config file, and any changes in the running-config file will be lost.

Using the Save command in the menu interface does not save a change made to the running config
by the CLI unless you have also made a configuration change in the menu interface. Also, the menu
interface displays the current running-config values. Thus, where a parameter setting is accessible
from both the CLI and the menu interface, if you change the setting in the CLI, the new value will
appear in the menu interface display for that parameter. However, as indicated above, unless you
also make a configuration change in the menu interface, only the write memory command in
the CLI will actually save the change to the startup-config file.

How to reset the startup-config and running-config files to the factory default configuration. Use the erase
startup-config command to reboot the switch, which replaces the contents of the current startup-config and
running-config files with the factory-default startup configuration.

Figure 39: The erase startup-config command

switch(config)# erase startup-config
Configuration will be deleted and device rebooted, continue [y/n]?
Press [y] to replace the current configuration with the factory default configuration and reboot the switch. Press [n]
to retain the current configuration and prevent a reboot.
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In a redundant management system, this command erases the startup config file on both the active and the
standby management modules as long as redundancy has not been disabled. If the standby management module
is not in standby mode or has failed selftest, the startup config file is not erased.

Creating a custom default configuration
The custom default configuration feature provides the ability to initialize a switch to a different state from the
factory default state when you delete the active configuration file. The factory default configuration is not changed.
If a custom configuration file has been created and the active configuration file is deleted, the switch will boot up
using the custom configuration file.

The feature provides the ability to:

Procedure

1. Use a customized configuration file as a default configuration file

2. Enable the switch to start up with the specified default configuration

The existence of a custom default configuration file does not affect the results of loading a remotely stored
configuration file onto the switch.

Using a custom default configuration, you can configure the features you want to be in the default configuration.
When the active configuration is deleted using the erase startup command, the active configuration is removed
and the custom default configuration file will be used upon bootup. The standard default configuration file remains
and is used if there is no custom default configuration.

This feature does not change the system defaults. The custom default configuration file is
automatically used when the startup configuration file is erased. It has no effect on what is loaded
onto the switch when a remotely stored configuration file is restored.

The default configuration file can be customized using commands at the CLI prompt or by copying a configuration
file with the desired configuration using TFTP, USB, or XMODEM copy commands. The existing default
configuration file also can be transferred from the switch using these commands.

To start creating the configuration file to be used as the custom default configuration file, enter the commands that
configure the features desired and then save the configuration file using the write memory command. The
following example is as shown.

Figure 40: Creating a config file with the desired features

switch(config)# spanning-tree
switch(config)# interface 4 flow-control

switch(config)# write memory
This configuration, which enables flow control on interface 4, and also spanning tree on the switch, is stored in the
startup configuration file.

To save this configuration as the custom default configuration, the startup configuration file is copied to the default
configuration file, as shown following.

Figure 41: Copying the startup configuration file to the custom default configuration file

switch(config)# copy startup-config default-config

Chapter 7 Configuring the switch 79

Anexo 02 ITEM 11 (0592659)         SEI 0008478-63.2018.6.02.8000 / pg. 5692



Copying an existing configuration file to the custom default configuration
file
Use the following command to copy a configuration file that exists in flash memory to the custom default
configuration file:

copy config <source-filename> default-config
The switch can have up to three different configuration files stored in flash memory. (For more information about
multiple configuration files, see "Multiple Configuration Files" in the Management and Configuration Guide for your
switch.)

switch(config)# copy abc.cfg default-config

HPE does not support issues that arise from a configuration file that was manually edited and
downloaded to the switch.

Copying the custom default config file onto the switch
The custom default config file can be copied onto the switch using TFTP, XMODEM, or USB.

• TFTP

Use thecopy tftp default-config command to copy a configuration file stored on a TFTP server to the custom
default configuration file:

copy tftp default-config <ip-addr> <stored config file name>
Copying a stored config file to the default config file using TFTP

switch(config)# copy tftp default-config 10.10.10.1 stored_config.cfg
• XMODEM

Use thecopy xmodem default-config command to copy a configuration file to the custom default
configuration file using XMODEM:

copy xmodem default-config
Copying a stored config file to the custom default config file using XMODEM

switch(config)# copy xmodem default-config
• USB

Use thecopy usb default-config command to copy a configuration file to the custom default configuration file
using USB:

copy usb default-config <stored config file name>
Copying a stored config file to the custom default config file using USB

switch# copy usb default-config stored_config.cfg

Copying the custom default config file off the switch
The following sections explains how to copy the custom default config file off the switch using TFTP, XMODEM, or
USB.
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Procedure

1. TFTP—Enter the following command to copy the custom default configuration file to the stored_config.cfg file
on the TFTP server.

copy default-config tftp <server ip-address> stored_config.cfg
2. XMODEM—Enter the following command to copy the custom default configuration file to the configuration file

specified by the XMODEM server device.

copy default-config xmodem
3. USB—Enter the following command to copy a custom default configuration file from the switch to the

stored_config.cfg file on the USB device.

copy default-config usb stored_config.cfg

Using SFTP and SCP to transfer the custom configuration
To transfer the default custom configuration file to or from the switch, you must connect to the switch’s SSH server
using any SCP or SFTP client. Instead of the actual name of the custom default configuration file, an alias name
of "default-config" is displayed in the file listings and for get/store functions.

When you use an SCP client to connect to the switch, you must know the name of the file you wish
to get or store. When you use SFTP client to connect to the switch, you are provided with a list of
filenames which are accessed by the switch.

While the switch supports an SSH server with SCP and/or SFTP running on it, the switch is not an
SCP or SFTP client. You must have an SCP/SFTP client implemented in order to execute copy scp
or copy sftp commands on the switch.

The following example shows the output from running puTTY psftp on a remote PC.

C:\PuTTY> psftp 10.1.243.209

We'd like to keep you up to date about:
  * Software feature updates
  * New product announcements
  * Special events

Please register your product at: www.register.hp.com

Remote working directory is /
psftp> ls
Listing directory /
drwxr-xr-x    2 J9145A   J9145A   0 Jan 01 00:01 cfg
drwxr-xr-x    2 J9145A   J9145A   0 Jan 01 00:01 core
drwxr-xr-x    2 J9145A   J9145A   0 Jan 01 00:01 log
drwxrwxrwx    2 J9145A   J9145A   0 Jan 01 00:01 os 
drwxrwxrwx    3 J9145A   J9145A   0 Jan 01 00:01 ssh

psftp> ls /cfg
Listing directory /cfg

-rwxrw-r--  1 J9145A  J9145A  1749 Jan 01 00:01 default-config 
-rw-r--r--  1 J9145A  J9145A   745 Jan 01 01:19 running-config
-rwxrw-r--  1 J9145A  J9145A   360 Jan 01 01:19 startup-config

psftp>
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Erasing a configuration file
To erase a configuration file:

Procedure

1. To erase the startup configuration file, use the erase startup-config command.
If a custom default configuration file exists and the erase startup-config command is executed, the current
active configuration is erased and the switch is booted with the custom default configuration. If a custom
default configuration file does not exist and the erase startup-config command is executed, the current active
configuration is erased and the switch is booted with the system default configuration.

2. To erase the custom default configuration file, use the erase default-config command.

The following example shows how to erase the startup config file when a default custom config file exists

switch(config)# erase startup-config
Configuration will be deleted, and existing login passwords
removed, and device rebooted (using the custom default
configuration), continue [y/n]?

The following example shows how to erase the startup config file when a default custom config file does not exist

switch(config)# erase startup-config
Configuration will be deleted, and existing login passwords removed,
and device rebooted, continue [y/n]?

The following example shows how to erase the custom default config file.

switch(config)# erase default-config
The custom default configuration will be erased. The "erase
startup-config" command will now use system generated default
configuration. Continue [y/n]?

Displaying the configuration files
To display configuration files:

• Use the show config files command to display the existing configuration files. This command also indicates
whether a custom default configuration file exists.

• Use either the command show default config or the command show running-config to display the custom
default configuration.

If a custom default configuration file exists and you erase the current active config file (using the erase
startup-config command), use the show running-configcommand to display the custom default
configuration, which is loaded upon bootup.
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When the show default config command is executed in enhanced secure mode the following
prompt displays:

Do you want to show sensitive information (y/n)?
If "Y/y" is entered, the normal command output is displayed on the console. If "N/n" is entered, all the
sensitive information is hidden and will be displayed as asterisks ("*****"). The default option is "N/n"
when interactive mode is disabled. For more information, see the "Secure Mode" in the Access
Security Guide for your switch.

Output displaying three configuration files
switch(config)# show config files

Configuration files:

id | act pri sec | name
---+-------------+--------------------------
 1    *   *      | config
 2               | secondaryconfig
 3            *  | Kconfig
==================
A Custom default configuration file exists.

Output for custom default configuration file
switch(config)# show default-config

Custom default configuration:

; J8693A Configuration Editor; Created on release #K.15.14.0001

; Ver #02:0b:ef:e6
hostname "switch"
module 1 type J93x7
module 2 type J93x7
vlan 1
  name "DEFAULT-VLAN"
  untagged 1-24
  ip address dhcp-bootp
  exit
interface 4
  flow-control
  exit snmp-server community "public" unrestricted
spanning-tree

Output of custom default config file when current active config file erased
switch(config)# show running-config

Custom default configuration:

; J8693A Configuration Editor; Created on release #K.15.12.0001
; Ver #02:0b:ef:e6
hostname "switch"
module 1 type J93x7
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module 2 type J93x7
vlan 1
  name "DEFAULT-VLAN"
  untagged 1-24
  ip address dhcp-bootp
  exit
interface 4
  flow-control
  exit
snmp-server community "public" unrestricted
spanning-tree

Troubleshooting custom default configuration files

Symptom

Switch cannot boot due to custom default configuration files.

Cause

Problem with the custom configuration file.

Action

1. Remove the custom configuration file from the ROM mode interface.

2. Use the erase default-config command to remove the custom default configuration file.

The custom default configuration files cannot be erased using the front panel buttons on the switch.

Using the menu and WebAgent to implement configuration
changes configuration file
The menu and WebAgent offer these advantages:

Procedure

1. Quick, easy menu or window access to a subset of switch configuration features

2. Viewing several related configuration parameters in the same screen, with their default and current settings

3. Immediately changing both the running-config file and the startup-config file with a single command

Menu: implementing configuration changes

You can use the menu interface to simultaneously save and implement a subset of switch configuration changes
without having to reboot the switch. That is, when you save a configuration change in the menu interface, you
simultaneously change both the running-config file and the startup-config file.

The only exception to this operation is two VLAN-related parameter changes that require a reboot as
described in this section.

Using Save and Cancel in the menu interface

For any configuration screen in the menu interface, the save command:
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1. Implements the changes in the running-config file

2. Saves your changes to the startup-config file

If you decide not to save and implement the changes in the screen, select Cancel to discard them and continue
switch operation with the current operation. For example, suppose that you have made the changes as shown in
the following System Information screen:

Figure 42: Example of pending configuration changes you can save or cancel

If you reconfigure a parameter in the CLI and then go to the menu interface without executing a write
memory command, those changes are stored only in the running configuration (even if you execute a
Save operation in the menu interface). If you then execute a switch boot command in the menu
interface, the switch discards the configuration changes made while using the CLI. To ensure that
changes made while using the CLI are saved, execute write memory in the CLI before rebooting the
switch.

Rebooting from the menu interface

Rebooting from the menu interface does the following:

• Terminates the current session and performs a reset of the operating system

• Activates any configuration changes that require a reboot

• Resets statistical counters to zero
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To Reboot the switch, use the Reboot Switch option in the Main Menu. (Note that the Reboot Switch option is not
available if you log on in Operator mode; that is, if you enter an Operator password instead of a manager
password at the password prompt.)

Figure 43: The Reboot Switch option in the Main Menu

Rebooting To Activate Configuration Changes. Configuration changes for most parameters become effective
as soon as you save them. However, you must reboot the switch in order to implement a change in the Maximum
VLANs to support parameter.

(To access these parameters, go to the Main menu and select 2. Switch Configuration, then 8. VLAN Menu,
then 1. VLAN Support.)

If configuration changes requiring a reboot have been made, the switch displays an asterisk (*) next to the menu
item in which the change has been made. For example, if you change and save parameter values for the
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Maximum VLANs to support parameter, an asterisk appears next to the VLAN Support entry in the VLAN
Menu screen, and also next to the Switch Configuration … entry in the Main menu:

Figure 44: Indication of a configuration change requiring a reboot

WebAgent: implementing configuration changes

You can use the WebAgent to simultaneously save and implement a subset of switch configuration changes
without having to reboot the switch. That is, when you save a configuration change, you simultaneously change
both the running-config file and the startup-config file. For online help with configuring changes in the WebAgent,
click the "?" in the WebAgent screen.

If you reconfigure a parameter in the CLI and then go to the WebAgent without executing a write
memory command, those changes will be saved to the startupconfig file if you click Save in the
WebAgent.

Zeroizing the file storage of the management module

Zeroizing the management module files

Procedure

Use the erase all to erase all management module files, including configuration files, core dumps, password files,
crypto-key files, and so on.
Software images are not erased.

erase all zeroize

When executed without the zeroize option, files are removed, but the flash storage is not zeroized.
The data is still physically present in the flash. The flash can be removed from the switch and the
data recovered with file recovery tools.

It is recommended that zeroization be performed from the serial console so that the status
information can be viewed during the zeroization process.
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switch(config)# erase all zeroize

The system will be rebooted and all management module files
except software images will be erased and zeroized. This will
take up to 60 minutes and the switch will not be usable during
that time. Continue (y/n)? y

Zeroizing from the ROM console
Use the erase-all zeroize command at the prompt to zeroize the file storage from the ROM console of the switch.
This is typically done during a switch recovery process. The warning messages are the same as for the CLI
command.

Zeroizing the management module files from the ROM console

=> erase-all zeroize

The system will be rebooted and all management module files
except software images will be erased and zeroized. This will
take up to 60 minutes and the switch will not be usable during
that time. Continue (y/n)? y

Zeroization
Sometimes it is desirable to completely remove the information stored in user files from flash storage. The
zeroization feature will remove and "zeroize" all the files from flash storage except software images. Information
removed includes the following:

• switch configurations

• system generated private keys

• user installed private keys

• legacy manager/operator password files

• crypto-key files

• fdr logs

• core dumps

Zeroization can be initiated in these ways:

• CLI command erase all

• ROM console command

• During Secure Mode transition, initiated through the secure-mode CLI command executed in a serial session

The zeroization process takes some time, so it is performed during the initial process of a switch reboot. After
zeroization, the configuration file is rebuilt from the default config file, which is similar to the config rebuilding
process performed by the erase startup-config command.

When zeroization is triggered by a secure mode transition, HA handles zeroization on the AMM and SMM
automatically.

When the CLI command (erase all zeroize) is used to start zeroization, the AMM syncs with the SMM and
ensures that the SMM performs the same level of zeroization before the AMM starts the zeroization process on

88 Aruba Basic Operation Guide for ArubaOS-Switch 16.05

Anexo 02 ITEM 11 (0592659)         SEI 0008478-63.2018.6.02.8000 / pg. 5701



itself. The AMM before the zeroization process occurs remains the AMM, unless it takes over a minute for the
AMM to boot up, in which case the prior SMM becomes the AMM.

When zeroization is started from the ROM console, there is no synchronization performed between the AMM and
SMM, as zeroization from the ROM console is treated as a recovery facility. Each MM has to be zeroized
individually.

For information about Secure Mode and zeroization, see the "Secure Mode (5400zl and 3800)" in the Access
Security Guide for your switch.

Using Primary and Secondary flash image options
The switches covered in this guide feature two flash memory locations for storing switch software image files:

Procedure

1. Primary Flash:

The default storage for a switch software image.

2. Secondary Flash:

The additional storage for either a redundant or an alternate switch software image.

With the Primary/Secondary flash option, you can test a new image in your system without having to replace a
previously existing image. You can also use the image options for troubleshooting. For example, you can copy a
problem image into Secondary flash for later analysis and place another, proven image in Primary flash to run
your system. The switch can use only one image at a time.

The following tasks involve primary/secondary flash options:

• Displaying the current flash image data and determining which switch software versions are available

• Switch software downloads

• Replacing and removing (erasing) a local switch software version

• System booting

Displaying the current flash image data
Use the commands in this section to:

• Determine whether there are flash images in both primary and secondary flash

• Determine whether the images in primary and secondary flash are the same

• Identify which switch software version is currently running

Viewing the currently active flash image version. Use the show version command to identify the software
version on which the switch is currently running, and whether the active version was booted from the primary or
secondary flash image.
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For example, if the switch is using a software version of X.X.XX stored in Primary flash, show version produces
the following:

Figure 45: The identity of the current flash image

switch(config)# show version

Image stamp:  /su/code/build/info(s01)
              Dec 01 2006 10:50:26
              X.X.XX
              1223
Boot Image:   Primary
Determining whether the flash images are different versions. If the flash image sizes in primary and
secondary are the same, then in almost every case, the primary and secondary images are identical. This
command provides a comparison of flash image sizes, plus the boot ROM version and from which flash image the
switch booted. For example, in the following case, the images are different versions of the switch software, and
the switch is running on the version stored in the secondary flash image:

switch(config)# show flash
Image            Size(Bytes)   Date   Version
-----            ----------  -------- -------------
Primary Image    : 7493854   03/21/10 K.15.01.0001
Secondary Image  : 7463821   03/23/10 K.15.01.0001

Boot Rom Version: K.15.08
Default Boot    : Primary
Determining which flash image versions are installed. The show version command displays which software
version the switch is currently running and whether that version booted from primary or secondary flash. Thus, if
the switch booted from primary flash, you will see the version number of the software version stored in primary
flash, and if the switch booted from secondary flash, you will see the version number of the software version
stored in secondary flash. Thus, by using show version, then rebooting the switch from the opposite flash
image and using show version again, you can determine the version(s) of switch software in both flash
sources. For example: Determining the software version in Primary and Secondary flash

switch(config)# show version
Management Module 1: Active
Image stamp:    /sw/code/build/btm(ec_K_15)
                Aug 2 2012 09:06:58
                K.15.12.001
                152
Boot Image:     Primary
switch(config)# boot system flash secondary
Device will be rebooted, do you want to continue [y/n]? y
  .
  .
  .

switch(config)# show version
Management Module 1: Active
Image stamp:    /sw/code/build/btm(ec_K_15)
                Aug 2 2012 09:06:58
                K.15.12.001
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                1753
Boot Image:     Secondary

Switch software downloads
The following table shows the switch’s options for downloading a software version to flash and booting the switch
from flash.

Table 6: Primary/Secondary memory access

Action Menu CLI Web Agent SNMP

Download to Primary Yes Yes Yes Yes

Download to Secondary No Yes No Yes

Boot from Primary Yes Yes Yes Yes

Boot from Secondary No Yes No Yes

The different software download options involve different copy commands, plus xmodem, usb, and tftp.

Download interruptions. In most cases, if a power failure or other cause interrupts a flash image download, the
switch reboots with the image previously stored in primary flash. In the unlikely event that the primary image is
corrupted, as a result of an interruption, the switch will reboot from secondary flash and you can either copy the
secondary image into primary or download another image to primary from an external source.

Replacing or removing local switch software
This section describes commands for erasing a software version and copying an existing software version
between primary and secondary flash.

It is not necessary to erase the content of a flash location before downloading another software file.
The process automatically overwrites the previous file with the new file. If you want to remove an
unwanted software version from flash, Hewlett Packard Enterprise recommends that you do so by
overwriting it with the same software version that you are using to operate the switch, or with another
acceptable software version. To copy a software file between the primary and secondary flash
locations, See "Copying a switch software image from one flash location to another", below.

The local commands described here are for flash image management within the switch. To download
a software image file from an external source, see "File Transfers" in the Management and
Configuration Guide for your switch.

Copying a switch software image from one flash location to another. When you copy the flash image from
primary to secondary or the reverse, the switch overwrites the file in the destination location with a copy of the file
from the source location. This means you do not have to erase the current image at the destination location
before copying in a new image.
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Verify that there is an acceptable software version in the source flash location from which you are
going to copy. Use the show flash command or, if necessary, the procedure under Displaying the
current flash image data to verify an acceptable software version. Attempting to copy from a source
image location that has a corrupted flash image overwrites the image in the destination flash
location. In this case, the switch will not have a valid flash image in either flash location, but will
continue running on a temporary flash image in RAM. Do not reboot the switch. Instead,
immediately download another valid flash image to primary or secondary flash. Otherwise, if the
switch is rebooted without a software image in either primary or secondary flash, the temporary flash
image in RAM will be cleared and the switch will go down. To recover, see "Restoring a Flash Image"
in the Management and Configuration Guide for your switch.

Syntax
copy flash flash <destination flash>
where: destination flash = primary or secondary:

For example, to copy the image in secondary flash to primary flash:

Verify that there is a valid flash image in the secondary flash location. The following figure indicates that a
software image is present in secondary flash. (If you are unsure whether the image is secondary flash is valid, try
booting from it before you proceed by using boot system flash secondary

The following example indicates two different software versions in Primary and Secondary flash:

switch(config)# show flash
Image             Size (bytes) Date     Version
----------------- ------------ -------- --------------------
Primary Image     : 10167529    10/14/11 K.14.89
Secondary Image   : 15085139    08/17/12 K.15.10.0001

Boot ROM Version : K.15.28
Default Boot     : Primary

Syntax

Execute the copy command as follows:

switch(config)# copy flash flash primary
Erasing the contents of Primary or Secondary flash. This command deletes the software image file from the

No undo! Before using this command in one flash image location (primary or secondary), ensure that
you have a valid software file in the other flash image location (secondary or primary). If the switch
has only one flash image loaded (in either primary or secondary flash) and you erase that image,
then the switch does not have a software image stored in flash. In this case, if you do not reboot or
power cycle the switch, you can recover by using xmodem or tftp to download another software
image.

erase flash [primary | secondary]

For example, to erase the software image in primary flash, do the following:

1. First verify that a usable flash image exists in secondary flash. The most reliable way to ensure this is to reboot
the switch from the flash image you want to retain. For example, if you are planning to erase the primary
image, then first reboot from the secondary image to verify that the secondary image is present and
acceptable for your system:
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switch# boot system flash secondary
2. Then erase the software image in the selected flash (in this case, primary):

switch# erase flash primary
The Primary OS Image will be deleted, continue [y/n]?

3. Type ‘y’ at the prompt to complete the flash erase.

4. Use show flash to verify erasure of the selected software flash image. The “0” shows that the primary flash has
been erased.

The following example shows flash listing after erasing Primary flash

switch# show flash
Compressed Primary Code size = 0
Compressed Secondary code size = 2555802
Boot ROM Version : K.15.19
Default Boot : Secondary

In redundant management systems, this command will erase the selected flash in both the active and the standby
management modules. If redundancy has been disabled or the standby module has failed self-test, this command
only affects the active management module.

Rebooting the switch

Setting the default flash for bootup
To specify the default flash (primary or secondary) to boot from on the next boot, use the boot set-default flash
command. The syntax is as follows:

boot set-default flash [ primary|secondary ]

switch(config)# boot set-default flash secondary
switch(config)# show flash
Image           Size(Bytes)   Date    Version
------          ----------   -------  -------------
Primary Image   : 7476770    03/15/10 K.15.01.0001
Secondary Image : 7476770    03/15/10 K.15.01.0001

Boot Rom Version: K.15.08
Default Boot    : Secondary

switch(config)# boot
This management module will now reboot from secondary
and will become the standby module! You will need to 
use the other management module's console interface.
Do you want to continue [y/n]?

Booting from the default flash or configuration file

Procedure

1. To boot the switch from the default flash (primary or secondary) image, use the boot command.

This command allows a boot sequence that includes the complete set of self-tests.

The switch is booted either from the flash (primary or secondary) that you are currently booted on or from the
flash image that was set by the boot set-default command or by the last executed boot system flash
<primary | secondary> command. You can select which image to boot from during the boot process itself
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(you are prompted with a message which will indicate the flash being booted from). When using redundant
management, the switch will fail over to the standby management module.

2. To boot from a configuration file, use the boot config <filename> command.

This command allows a boot sequence that includes the complete set of self-tests.

The following example shows the Boot command (default Primary flash) with redundant management

switch(config)# boot
This management module will now reboot from primary image
and will become the standby module! You will need to use
the other management module's console interface.
Do you want to continue [y/n]? y

Do you want to save current configuration [y/n]? n
In the above example, typing either a ‘y’ or ‘n’ at the second prompt initiates the reboot operation. (Entering ‘y’
saves any configuration changes from the running-config file to the startup-config file; entering ‘n’ discards them.)

The following example shows the Boot command booting from a different flash than the current flash (with
redundant management module present)

switch(config)# show flash
Image Size(Bytes) Date Version
Primary Image : 7497114 03/29/10 K.15.01.0001
Secondary Image : 7497114 03/29/10 K.15.01.0001
Boot Rom Version: K.15.08
Default Boot : Primary

switch(config)# boot set-default flash secondary
This command changes the location of the default boot.
This command will change the default flash image to boot from 
secondary. Hereafter, 'reload' 'boot' commands will boot from
secondary. Do you want to continue [y/n]? y

switch(config)# boot
This management module will now reboot from secondary image
and will become the standby module! You will need to use the
other management module's console interface.
Do you want to continue [y/n]? n

Booting from a specified flash

Procedure

1. To reboot from primary flash, use the boot system flash primary command.

This command allows a boot sequence that includes the complete set of self-tests.

2. To reboot from secondary flash, use the boot system flash secondary command.

This command allows a boot sequence that includes the complete set of self-tests.

The following example shows use of the command to reboot the switch from secondary flash when there are no
pending configuration changes in the running-config file. Typing either a [y] or [n] at the second prompt initiates
the reboot operation.
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Boot command with secondary flash option
switch(config)# boot system flash secondary
System will be rebooted from secondary image. Do you want to continue [y/n]?

Enabling and disabling the fastboot option

Procedure

1. To enable the fastboot option, use the fastboot command.

When this option is enabled, the bootup sequence does not include the internal power-on self-tests, resulting
in a faster boot time.

2. To disable the fastboot option, use the no fastboot command.

When this option is disabled, the bootup sequence includes the complete set of self-tests.

3. To display the status of the fastboot feature, either enabled or disabled, use the show fastbootcommand.

When using redundant management and fastboot is enabled, it is saved to the standby management module
when the config files are synchronized. Fastboot is used during the next bootup on either management module.

Enabling the fastboot option
switch(config)# fastboot

Using reload
The reload command reboots the switch from the flash image that you are currently booted on (primary or
secondary) or the flash image that was set either by the boot set-default command or by the last executed boot
system flash <primary | secondary> command. Because reload bypasses some subsystem self-tests, the
switch reboots faster than if you use either of the boot command options. If you are using redundant
management and redundancy is enabled, the switch will failover to the other management module.

Syntax
reload
For example, if you change the number of VLANs the switch supports, you must reboot the switch in order to
implement the change. The reload command prompts you to save or discard the configuration changes.

The following example shows how to use reload with redundant management and pending configuration changes:

switch(config)# max-vlans 12
Command will take effect after saving configuration and reboot.

switch(config)# reload
This command will cause a switchover to the other management
module which may not be running the same software image and
configurations. Do you want to continue [y/n]? y
Scheduled reload. Beginning with software release K.11.34, additional parameters have been added to the
reload command to allow for a scheduled reboot of the switch via the CLI.

Syntax
reload [after <[dd:]hh:] [mm>] | [at <hh:mm[:ss]>] [<mm/dd[/[yy]yy]>]
no reload [after <[dd:]hh:] [mm>] | [at <hh:mm[:ss]>] [<mm/dd[/[yy]yy]>]
Enables a scheduled warm reboot of the switch. The switch boots up with the same startup config file and using
the same flash image as before the reload.
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When using redundant management, the reload at/after command causes a switch over at the
scheduled time to the other management module, which may not be running the same software
image or have the same configurations.

Parameters include:

• after

Schedules a warm reboot of the switch after a given amount of time has passed.

• at

Schedules a warm reboot of the switch at a given time.

The no form of the command removes a pending reboot request.

For more details and examples, see the following.

The scheduled reload feature removes the requirement to physically reboot the switch at inconvenient times (for
example, at 1:00 in the morning). Instead, a reload at 1:00 mm/dd command can be executed (where mm/dd is
the date the switch is scheduled to reboot).

Configuration changes are not saved with reload at or reload after commands. No prompt to save
configuration file changes is displayed. See Boot and reload command comparison.

Examples of scheduled reload commands:

• To schedule a reload in 15 minutes:

switch# reload after 15
• To schedule a reload in 3 hours:

switch# reload after 03:00
• To schedule a reload for the same time the following day:

switch# reload after 01:00:00
• To schedule a reload for the same day at 12:05:

switch# reload at 12:05
• To schedule a reload for some future date:

switch# reload at 12:05 01/01/2008

The following example shows the reload command with a redundant management system

switch(config)# reload after 04:14:00
    Reload scheduled in 4 days, 14 hours, 0 minutes
This command will cause a switchover at the scheduled
time to the other management module which may not be
running the same software image and configurations.
Do you want to continue [y/n]?
Module reload. The module reload feature allows you to reset a module by initiating a warm reboot of a specified
module or modules. This saves time over rebooting the entire switch, which can take several minutes to complete
and disrupts all users on the switch. The specified module has its power turned off, and then turned on again. This
causes the module to reset to a known good state and reload its software.
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Syntax
reload [[after <[[DD:]HH:]MM>] | [[at HH:MM[:SS] [MM/DD[/[YY]YY]]]]
| [[module <slot-id-range>]]]
no reload [[after <[[DD:]HH:]MM>] | [[at HH:MM[:SS] [MM/DD[/[YY]YY]]]]
| [[module <slot-id-range>]]]
When specified with the module parameter, initiates a reload of the module in the specified slot or slots by turning
the slot power off, then on again. A valid slot or range of slots must be specified. The at and after parameters are
not allowed with the module option. The no version of the command is not valid with the module option.

When the reload command is executed without any parameters, an immediate switch reload occurs.

This feature is not supported for HPE One modules.

module: Powers the module on or off, forcing a software reload of the specified module or modules.

The following example shows reloading a specified module:

switch(config)# reload module C
The ‘reload module’ command will shutdown the specified
modules. Ports on specified modules will no longer pass
traffic. Any management traffic to the switch which
passes through the affected modules will be interrupted
(e.g. ssh, telnet, snmp). This command may take up to 2
minutes to power down all specified modules. Please check 
the event log for current status of module power down,
power up cycle. Continue [y/n]?
Displaying reload information. Use the show reload command to display the reload information. This can
include:

• A scheduled, pending reload of the entire switch

• A statement that no reload is scheduled

• The time of the last reload of each module on the system

The following example shows the scheduled reload at information:

switch(config)# reload at 23:45
Reload scheduled at 23:45:47 6/16/2012
(in 0 days, 1 hours, 41 minutes

switch(config)# show reload at
Reload scheduled for 23:45:47 06/16/2012
(in 0 days, 1 hours, 40 minutes)

switch(config)# show reload after
Reload scheduled for 23:45:47 6/16/2012
(in 0 days, 1 hours, 40 minutes)
The following example shows the scheduled reload after information:

switch(config)# reload after 35
Reload scheduled in 0 days, 0 hours, 35 minutes

switch(config)# show reload at
Reload scheduled in 0 days, 0 hours, 34 minutes
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switch(config)# show reload after
Reload scheduled in 0 days, 0 hours, 34 minutes
The following example shows the module reload information:

switch(config)# show reload module

Module Reload information:

Module | Last reload date
-------+---------------------
  C      10:50:51 01/13/2012

Boot and reload command comparison
The switch offers reboot options through the boot and reload commands, plus the options inherent in a dual-flash
image system. Generally, using boot provides more comprehensive self-testing; using reload gives you a faster
reboot time.

Table 7: Comparing the boot and reload commands

Actions Included in Boot? Included in Reload Note

Save all configuration
changes since the last
boot or reload

Optional, with prompt Optional with reload <cr>,
when prompt displays. Not
saved with reload at/after
commands; No prompt is
displayed.

Config changes saved to
the startup-config file if "y"
is selected (reload
command).

Perform all system self-
tests

Yes No The reload command
provides a faster system
reboot.

Choice of primary or
secondary flash image

Yes No—Uses the current flash
image.

Perform a scheduled
reboot

No Yes Use the reload command
with after/at parameters
(see for Using reload
details).

Operating notes about booting
Default boot source. The switch reboots from primary flash by default unless you specify the secondary flash by
entering either the boot system flash [primary | secondary] or boot set-default flash [primary | secondary]
command. Both the boot command and the reload command will reboot based on how these options have been
selected.

Boot attempts from an empty flash location. In this case, the switch aborts the attempt and displays:

Image does not exist
Operation aborted.
Interaction of Primary and Secondary flash images with the current configuration. The switch has one
startup-config file (see Configuration file management on page 115), which it always uses for reboots,
regardless of whether the reboot is from primary or secondary flash. Also, for rebooting purposes, it is not
necessary for the software image and the startup-config file to support identical software features. For example,
suppose that you have just downloaded a software upgrade that includes new features that are not supported in
the software you used to create the current startup-config file. In this case, the software simply assigns factory-
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default values to the parameters controlling the new features. Similarly, If you create a startup-config file while
using a version "Y" of the switch software, and then reboot the switch with an earlier software version "X" that
does not include all the features found in "Y", the software simply ignores the parameters for any features that it
does not support.

Scheduled reload. If no parameters are entered after the reload command, an immediate reboot is executed.
The reload at and reload after command information is not saved across reboots. If the switch is rebooted before
a scheduled reload command is executed, the command is effectively canceled. When entering a reload at or
reload after command, a prompt will appear to confirm the command before it can be processed by the switch.
For the reload at command, if mm/dd/yy are left blank, the current day is assumed.

The scheduled reload feature removes the requirement to physically reboot the switch at inconvenient times (for
example, at 1:00 in the morning). Instead, a reload at 1:00 mm/dd command can be executed (where mm/dd is
the date the switch is scheduled to reboot).

Managing multiple configuration files

Viewing the status and content of startup-config files

Procedure

1. To view a list of the available startup-config files on the switch and the current use of each file, use the show
config files command.

2. To view the content of the default startup-config file, use the show config command.

The default startup-config file is the startup-config file that is currently active on the switch.

3. To view the content of a specific startup-config file, use the show config <filename> command.
The filename argument specifies the file.With Multiple Configuration enabled, the switch can have up to three
startup-config files. This command can display the content of any of the startup-config files stored in the
switch, whereas the show config command always displays the content of the default startup-config file.

Changing or overriding the reboot configuration policy
To change the reboot configuration policy, do one of the following:

• Use the startup-default primary config <filename> command to change the current policy so that the switch
automatically reboots from the primary flash using the specified startup-config file. The filename argument
specifies the startup-config file to use.

• Use the startup-default secondary config <filename> command to change the current policy so that the
switch automatically reboots from the secondary flash using the specified startup-config file. The filename
argument specifies the startup-config file to use.

To override the default reboot configuration policy for a single reboot instance, do one of the following:

• Use the boot system flash primary config <filename> command to override the current policy so that the
switch automatically reboots from the primary flash using the specified startup-config file. The filename
argument specifies the startup-config file to use.

• Use the boot system flash secondary config <filename> command to override the current policy so that the
switch automatically reboots from the secondary flash using the specified startup-config file. The filename
argument specifies the startup-config file to use.
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Reboot configuration policy that uses different startup-config files for different software versions

Suppose that you have the following situation:

• Software release “A” is stored in primary flash and a later software release is stored in secondary flash.

• Memory slot 1 stores a reliable, minimal configuration (named minconfig) to be used with the software
version in the primary flash.

• Memory slot 2 stores a modified startup-config file (named newconfig) to be used with the software version
in secondary flash. This startup-config file includes untested changes for improved network operation.

The operator wants to ensure that in case of a need to reboot by pressing the Reset button, or if a power failure
occurs, the switch will automatically reboot with the minimal startup-config file in memory slot 1. Since a reboot
due to pressing the Reset button or to a power cycle always uses the software version in primary flash, the
operator has to configure the switch to always boot from primary flash with the startup-config file named
minconfig (in memory slot 1). Also, whenever the switch boots from secondary flash, the operator also wants
the startup-config named newconfig to be used. The following two commands configure the desired behavior.

switch(config)# startup-default primary config minconfig
switch(config) # startup-default secondary config newconfig

Managing startup-config files in the switch
Managing the startup-config files involves renaming, copying, and erasing startup-config files.

• Use the rename config <current-filename> <new-filename> command to change the name of an existing
startup-config file. The current-filename argument specifies the existing startup-config file and the new-
filename argument specifies the new name for the file.

A file name can include up to 63, alphanumeric characters. Blanks are allowed in a file name enclosed in
quotes (" " or ‘ ‘). File names are not case-sensitive.

A file name can include up to 63, alphanumeric characters. Blanks are allowed in a file name enclosed in
quotes (" " or ‘ ‘). File names are not case-sensitive.

For redundant management systems, renaming a config file affects both the active management module and
the standby management module, unless redundancy is disabled or the standby module failed selftest.

• Use the copy config <source-filename> config <target-filename> command to create a new startup-config
file or to replace an existing startup-config file with a new one.

This command copies the contents of an existing startup-config file in one memory slot to a new startup-config
file in another, empty memory slot.

If the target startup-config file already exists, it is overwritten by the content of the source startup-config file
otherwise, it will be created in the first empty configuration memory slot on the switch. If the destination
startup-config file does not already exist and there are no empty configuration memory slots on the switch,
then a new startup-config file is not created.

• Do one of the following to erase any of the startup-config files in the switches memory slots:

◦ Use the erase config <filename> command to erase the specified startup-config file. filename argument

specifies the file to be erased.

◦ Use the erase startup-config command to erase the currently active startup-config file.
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In some cases, erasing a file causes the switch to generate a new, default-configuration file for the affected
memory slot. Where a file is assigned to either the primary or the secondary flash, but is not the currently active
startup config file, erasing the file does not remove the flash assignment from the memory slot for that file. Thus, if
the switch boots using a flash location that does not have an assigned startup-config, then the switch creates a
new, default startup-config file and uses this file in the reboot. (This new startup-config file contains only the
default configuration for the software version used in the reboot.) Executing write memory after the reboot
causes a switch-generated filename of config x to appear in the show config files display for the new file,
where x corresponds to the memory slot number.

In a redundant management system, these commands erase the startup config file on both the active and the
standby management modules as long as redundancy has not been disabled. If the standby management module
is not in standby mode or has failed selftest, the startup config file is not erased.

The following example shows how to create and assign a new startup config file

If you wanted to experiment with configuration changes to the software version in secondary flash, you could
create and assign a separate starup-config file for this purpose, as shown in the following command sequence.

switch(config)# copy config config1 config config2
switch(config)# startup-default secondary config config2
switch(config)# show config files

Configuration files:

id | act pri sec | name
---+-------------+-----------------------------------------------
 1 |  *   *      | Config1
 2 |          *  | Config2
 3 |             | 

The following example shows how to erase a non-active startup-config file. The memory configuration has a non-
active configuration file named “config3”, which you want to erase.

switch(config)# show config files

Configuration files:

id | act pri sec | name
---+-------------+-----------------------------------------------
 1 |  *   *      | minconfig
 2 |          *  | config2
 3 |             | config3

switch(config)# erase config config3
switch(config)# show config files

Configuration files:

id | act pri sec | name
---+-------------+-----------------------------------------------
 1 |  *   *      | minconfig
 2 |          *  | config2
 3 |             | 

Uploading a configuration file to a remote TFTP host
Uploading a configuration file from a remote TFTP host
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To upload a configuration file to a remote TFTP host through the out-of-band management interface, do one of the
following:

Prerequisites

Before you upload a configuration file to a remote TFTP host, you must insure that the switch has a separate out-
of-band management port if the traffic is being transmitted through the out-of-band management interface.

Procedure

1. Use the copy config <src-file> tftp <ip-addr> <remote-file> pc oobm command to upload
a configuration file to a remote TFTP PC host.

2. Use the copy config <src-file> tftp <ip-addr> <remote-file> unix oobm command to
upload a configuration file to a remote TFTP UNIX host.

To upload a configuration file to a remote TFTP host through the data interface, do one of the following:

• Use the copy config <src-file> tftp <ip-addr> <remote-file> pc command to upload a
configuration file to a remote TFTP PC host.

• Use the copy config <src-file> tftp <ip-addr> <remote-file> unix command to upload a
configuration file to a remote TFTP UNIX host.

For more information on using TFTP to upload a file to a remote server, see "TFTP: Copying a Configuration File
to a Remote Host" in Appendix A of the Management and Configuration Guide for your switch.

Example

The following command uploads a startup-config file named test01 from the switch to a (UNIX) TFTP server at IP
address 10.10.28.14:

switch(config)# copy config test-01 tftp 10.10.28.14 test-01.txt unix

Downloading a configuration file from a remote TFTP host
Downloading a configuration file from a remote TFTP host

To download a configuration file from a remote TFTP host through the out-of-band management interface, do one
of the following:

Prerequisites

Before you download a configuration file from a remote TFTP host, you must insure that the switch has the
following:

• An empty memory slot.

• A separate out-of-band management port, if the traffic is being transmitted through the out-of-band
management interface.

Procedure

1. Use the copy tftp config <dest-file> <ip-addr> <remote-file> pc oobm command to
download a configuration file from a remote TFTP PC host.

2. Use the copy tftp config <dest-file> <ip-addr> <remote-file> UNIX oobm command to
download a configuration file from a remote TFTP UNIX host.
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To download a configuration file from a remote TFTP host through the data interface, do one of the following:

• Use the copy tftp config <dest-file> <ip-addr> <remote-file> pc command to download a
configuration file from a remote TFTP PC host.

• Use the copy tftp config <dest-file> <ip-addr> <remote-file> UNIX command to download
a configuration file from a remote TFTP UNIX host.

For more on using TFTP to download a file from a remote host, see "TFTP: Copying a Configuration File from a
Remote Host" in Appendix A of the Management and Configuration Guide for your switch.

Example

The following command downloads a startup-config file named test01.txt from a (UNIX) TFTP server at IP
address 10.10.28.14 to the first empty memory slot in the switch:

switch(config)# copy tftp config test-01 10.10.28.14 test-01.txt unix

Uploading a configuration file to a serially connected host
To upload a configuration file to a serially connected host, do one of the following:

Procedure

1. Use the copy config <filename> xmodem pc command to upload a configuration file to a serially
connected PC host.

2. Use the copy config <filename> xmodem unix command to upload a configuration file to a serially
connected UNIX host.

For more on using Xmodem to upload a file to a serially connected host, see "Xmodem: Copying a Configuration
File to a Serially Connected PC or UNIX Workstation" in Appendix A of the Management and Configuration Guide
for your switch.

Downloading a configuration file from a serially connected host
To download a configuration file from a serially connected host, do one of the following:

Procedure

1. Use the copy xmodem config <dest-file> pc command to download a configuration file from a
serially connected PC host.

2. Use the copy xmodem config <dest-file> unix command to download a configuration file from a
serially connected UNIX host.

For more on using Xmodem to copy a file from a serially connected host, see "Xmodem: Copying a Configuration
File from a Serially Connected PC or UNIX Workstation" in Appendix A of the Management and Configuration
Guide for your switch.

Multiple configuration files
In this mode of operation, you cannot preserve different startupconfig files across a reboot without using remote
storage.

The switch allows up to three startup-config files with options for selecting which startup-config file to use for:
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• A fixed reboot policy using a specific startup-config file for a specific boot path (primary or secondary flash)

• Overriding the current reboot policy on a per-instance basis

Figure 46: Optional reboot process

While you can still use remote storage for startup-config files, you can now maintain multiple startup-config files
on the switch and choose which version to use for a reboot policy or an individual reboot.

This choice of which configuration file to use for the startup-config at reboot provides the following new options:

• The switch can reboot with different configuration options without having to exchange one configuration file for
another from a remote storage location.

• Transitions from one software release to another can be performed while maintaining a separate configuration
for the different software release versions.

• By setting a reboot policy using a known good configuration and then overriding the policy on a per-instance
basis, you can test a new configuration with the provision that if an unattended reboot occurs, the switch will
come up with the known, good configuration instead of repeating a reboot with a misconfiguration.

Operating notes for multiple configuration files
Multiple configuration storage in the switch. The switch uses three memory "slots", with identity (id) numbers
of 1, 2, and 3, as shown by the following output of the show config files command.

switch(config)# show config files
Configuration files:

id | act pri sec | name
---+-------------+-----------------------------------------------
 1 |             | oldConfig 
 2 |  *   *   *  | workingConfig 
 3 |             | 

A startup-config file stored in a memory slot has a unique, changeable file name. The switches covered in this
guide can use the startup-config in any of the memory slots (if the software version supports the configured
features). In the default configuration, if the switch was shipped from the factory with software installed in both the
primary and secondary boot paths, then one startup-config file named “config1” is used for both paths and is
stored in memory slot 1. Memory slots 2 and 3 are empty in this default configuration.

An asterisk ( * ) in the act, pri, or sec column has the following meaning:
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• act column: The corresponding startup-config file is currently in use.

• pri column: The corresponding startup-config file is currently assigned to the primary boot path.

• sec column: The corresponding startup-config file is currently assigned to the secondary boot path.

Reboot policy. With multiple startup-config files in the switch you can specify a policy for the switch to use upon
reboot. The options include:

• Use the designated startup-config file with either or both reboot paths (primary or secondary flash)

• Override the current reboot policy for one reboot instance by specifying a boot path (primary or secondary
flash) and the startup-config file to use.

For a given reboot, the switch automatically reboots from the startup-config file assigned to the flash location
(primary or secondary) being used for the current reboot. For example, when you first download a software
version that supports multiple configuration files and boot from the flash location of this version, the switch copies
the existing startup-config file (named oldConfig) into memory slot 2, renames this file to workingConfig, and
assigns workingConfig as:

• The active configuration file

• The configuration file to use when booting from either primary or secondary flash

In this case, the switch is configured to automatically use the workingConfig file in memory slot 2 for all
reboots.

Changes to the startup-config file. When the switch reboots, the startupconfig file supplies the configuration for
the running-config file the switch uses to operate. Changes to the running-config file are written back to the
startup-config file that was used at the last reboot. The changes are written when the write-mem command (or, in
the Menu interface, the Save command) is executed. For example, suppose that a system administrator performs
the following on a switch that has two startup-config files (workingconfig and backupconfig):

1. Reboot the switch through the Primary boot path using the startup-config file named backupconfig.

2. Use the CLI to make configuration changes in the running-config file, and then execute write-mem.
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The result is that the startup-config file used to reboot the switch is modified by the actions in step 2.

Figure 47: Reboot process and making changes to the startup-config file

An alternate startup-config file. A new configuration file can be created for an alternate startup-config file. There
are two methods for creating a new configuration file:

• Copy an existing startup-config file to a new filename, then reboot the switch, make the desired changes to the
running-config file, then execute write memory.

• Erase the active startup-config file. This generates a new, default startupconfig file that always results when
the switch automatically reboots after deletion of the currently active startup-config file.

The transition to multiple configuration files. At the first reboot with a software release supporting multiple
configuration, the switch:

• Assigns the filename oldConfig to the existing startup-config file (which is stored in memory slot 1).

• Saves a copy of the existing startup-config file in memory slot 2 with the filename workingConfig.

• Assigns the workingConfig file as the active configuration and the default configuration for all subsequent
reboots using either primary or secondary flash.

The following output of the show config files command shows the switch memory assignments after the first
reboot from software that supports multiple configuration. In this state, the switch always uses the
workingConfig file to reboot.

switch(config)# show config files
Configuration files:
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id | act pri sec | name
---+-------------+-----------------------------------------------
 1 |             | oldConfig 
 2 |  *   *   *  | workingConfig 
 3 |             | 

Viewing the configuration of interfaces

Viewing the running configuration of interfaces
To view the running configuration of interfaces, do one of the following:

Procedure

1. Use the show running-config [structured]command to view the running configuration of all
interfaces. Include the structured option to group the information in a logical manner.

2. Use the show running-config interface port-listcommand to view the running configuration of the
specified port interfaces. Include the structuredoption to group the information in a logical manner.

3. Use the show running-config interface loopback <0-7> command to view the running
configuration of the specified loopback interfaces. Include the structuredoption to group the information in a
logical manner.

4. Use the show running-config interface vlan <vlan-id-list>
command to view the running configuration of the specified VLAN interfaces. Include the structured option to
group the information in a logical manner.

Examples

The following example shows Running configuration output in preview mode.

switch(config)# preview-mode 
ATTENTION: You are entering preview mode on this product. This mode, the 
commands, features and functionality specific to this mode, and all output
from this mode are Hewlett Packard Enterprise Confidential and Proprietary.
You may use this mode at your own risk. Any defects or issues encountered  
in this mode will be addressed per Hewlett Packard Enterprise's discretion.
Continue (y/n)? y                                                           
(Prev-mode)switch(config)# show running-config

Running configuration:

; JL075A Configuration Editor; Created on release #KB.16.01.0000x
; Ver #0c:01.7c.59.f4.7b.ff.ff.fc.ff.ff.3f.ef:

hostname "Aruba-3810M-16SFPP-2s"
module 1 type jl075x
module 2 type jl075y
module 3 type jl075z
snmp-server community "public" unrestricted
oobm
   ip address dhcp-bootp
   exit
vlan 1
   name "DEFAULT_VLAN"
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   untagged 1-16
   ip address dhcp-bootp
   exit
preview-mode
The following example shows Running configuration output for interfaces A2 - A4

switch(eth-A2-A4)# show running-config

Running configuration:

; J8698A Configuration Editor; Created on release #K.15.10.0001
; Ver #02:0b:ef:e6
hostname "switch"
interface A2
   disable
   name "test1"
   flow-control
   broadcast-limit 80
   speed-duplex 100-full
   unknown-vlans Block 
   qos priority 4 
   lacp Passive
   gvrp join-timer 30
   gvrp leave-timer 60
   gvrp leaveall-timer 700
exit
interface A3
   disable name "test1"
   flow-control
   broadcast-limit 80
   speed-duplex 100-full
   unknown-vlans Block
   qos priority 4
   lacp Passive
   gvrp join-timer 30
   gvrp leave-timer 60
   gvrp leaveall-timer 700
exit
vlan 1
   name "DEFAULT_VLAN"
   untagged A1-A4,C1-C24,F1-F4
   ip address dhcp-bootp
   exit
interface A2
   dhcp-snooping trust
   bandwidth-min output 20 10 10 10 20 10 10 10
   rate-limit bcast in percent 75
   ipv6 access-group "check" in
   exit
interface A3
   dhcp-snooping trust
   bandwidth-min output 20 10 10 10 20 10 10 10
   rate-limit bcast in percent 75
   ipv6 access-group "check" in
   exit
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The following example shows an example of the running config for a range of interfaces. The configuration
information for interfaces A2 and A3 is now displayed together.

switch(config)# show running-config interface A2-A3

Running configuration:

interface A2
   disable
   name "test1"
   flow-control
   broadcast-limit 80
   speed-duplex 100-full
   unknown-vlans block
   qos priority 4
   gvrp join-timer 30 leave-timer 60 leaveall-timer 700
   dhcp-snooping trust
   lacp passive
   bandwidth-min output 20 10 10 10 20 10 10 10
   rate-limit bcast in percent 75
   ipv6 access-group "check" in
   untagged vlan 1
   exit
interface A3
   disable
   name "test1"
   flow-control
   broadcast-limit 80
   speed-duplex 100-full
   unknown-vlans block
   qos priority 4
   gvrp join-timer 30 leave-timer 60 leaveall-timer 700
   dhcp-snooping trust
   lacp passive
   bandwidth-min output 20 10 10 10 20 10 10 10
   rate-limit bcast in percent 75
   ipv6 access-group "check" in
   untagged vlan 1
   exit
The following example shows an example of the running config file for a range of interfaces after some
configuration changes have been made.

switch(config)# no stack
switch(config)# mesh 2-3
Command will take effect after saving configuration and reboot.

switch(config)# write memory
switch(config)# reload

switch# show running-config interface 2-3

Running configuration:

interface 2
   untagged vlan 1
   mesh
   exit
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interface 3
   flow-control
   untagged vlan 1
   mesh
   exit
The following example is an example of the running config output showing VLAN information.

switch(config)# show running-config

Running configuration:
; J8698A Configuration Editor; Created on release #K.15.10.0001
; Ver #02:0b:ef:e6
hostname "switch"
module 1 type J9309A
module 3 type J8702A
module 6 type J8702A
ip routing
vlan 1
   name "DEFAULT_VLAN"
   untagged A1-A4,C1-C24,F1-F24
   ip address dhcp-bootp
   exit
vlan 2
   name "test-vlan-2"
   ip helper-address 4.1.1.1
   ip helper-address 5.1.1.1
   ip address 1.1.1.1 255.255.255.0
   ipv6 address 2001::/64 anycast
   ipv6 enable
   exit
vlan 3
   name "VLAN3"
   ip helper-address 7.1.1.1
   ip forward-protocol udp 7.1.1.1 snmp
   ip forward-protocol udp 11.1.1.2 dns
   no ip address
   exit
vlan 4
   name "VLAN4"
   ip address 5.1.1.1 255.255.255.0
   ip bootp-gateway 5.1.1.1
   exit
logging 10.0.102.90
logging system-module ospf
ip route 5.1.1.0 255.255.255.0 vlan 4 distance 3
In the following example, the configuration information for VLAN 4 is now displayed in one place.

switch(config)# show running-config vlan 3-4

Running configuration:

vlan 3
   name "VLAN3"
   ip helper-address 7.1.1.1
   ip forward-protocol udp 7.1.1.1 snmp
   ip forward-protocol udp 11.1.1.2 dns
   no ip address
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   exit
vlan 4
   name "VLAN4"
   ip address 5.1.1.1 255.255.255.0
   ip bootp-gateway 5.1.1.1
   ip route 5.1.1.0 255.255.255.0 distance 3
   exit
Below is an example of the running config for a range of VLANs after configuration changes have been made to
selected VLANs.

switch(config)# dhcp-snooping
switch(config)# vlan 14
switch(vlan-14)# exit
switch(config)# vlan 15
switch(vlan-15)# exit
switch(config)# vlan 23
switch(vlan-23)# exit
switch(config)# dhcp-snooping vlan 14-15
switch(config)# static-mac 00:11:22:33:44:55 vlan 23 interface A3
switch(config)# spanning-tree instance 2 vlan 15

switch(config)# show running-config vlan 14-15

Running configuration:

vlan 14
   name "VLAN14"
   no ip address
   dhcp-snooping
   exit
vlan 15
   name "VLAN15"
   no ip address
   dhcp-snooping
   spanning-tree instance 2
   exit

Viewing the startup configuration of interfaces
To view the startup configuration of interfaces, do one of the following:

• Use the show config command to view the startup configuration of all interfaces.

• Use the show config interface port-listcommand to view the startup configuration of the specified
port interfaces.

• Use the show config interface loopback <0-7>command to view the startup configuration of the
specified VLAN interfaces.

Examples

The following example shows startup configuration output.

switch(config)# show config

Startup configuration:

; J8698A Configuration Editor; Created on release #K.14.54C
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; Ver #02:0b:ef:e6
hostname "switch"
module 1 type J9309A
module 3 type J8702A
module 6 type J8702A
vlan 1
   name "DEFAULT_VLAN"
   untagged A1-A4,C1-C9,C15-C24,F1-F24
   ip address dhcp-bootp
   no untagged C10-C14
   exit
vlan 5
   name "VLAN5"
   untagged C10-C14
   ip address 5.1.1.1 255.255.255.128
   exit
interface loopback 5
   ip address 7.1.1.1
   exit
interface loopback 7
   ip address 12.1.1.1
   exit
snmp-server community "public" unrestricted
Following is an example of the startup config output for a selected VLAN.

switch(vlan-5)# show config vlan 5

Startup configuration:

vlan 5
   name "VLAN5"
   untagged C10-C14
   ip address 5.1.1.1 255.255.255.128
   exit

The following shows an example of the startup config output for a range of interfaces for a specific VLAN.

Figure 48: Startup config output for a range of interfaces for a specific VLAN

switch(vlan-5)# show config interface C10-C13

Startup configuration:

interface C10
   untagged vlan 5
   exit
interface C11
   untagged vlan 5
   exit
interface C12
   untagged vlan 5
   exit
interface C13
   untagged vlan 5
   exit
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Using automatic configuration update with DHCP Option
66
Prerequisites

To use automatic configuration update with DHCP Option 66, you must do the following:

• Enable one or more DHCP servers with Option 66.

• Insure that one or more TFTP servers have the desired configuration file.

• Insure that the configuration files to be updated were generated on the switch.

• Enable the configuration file to update with Option 66, as described in Enabling and disabling the
configuration file update using Option 66 on page 113.

HPE switches are initially booted up with the factory-shipped configuration file. The automatic configuration
update provides a way to automatically download a different configuration file from a TFTP server using DHCP
Option 66.

Enabling and disabling the configuration file update using Option 66

Procedure

1. Use the dhcp config-file-update command to enable the configuration update using Option 66.

2. Use the no dhcp config-file-update command to disable the configuration update using Option 66.

The configuration file update using Option 66 is enabled by default.

Possible scenarios for updating the configuration file
The following table shows various network configurations and how Option 66 is handled.

Scenario Behavior

Single Server serving
Multiple VLANs • Each DHCP-enabled VLAN interface initiates DHCPDISCOVER message,

receives DHCPOFFER from the server, and send DHCPREQUEST to obtain the
offered parameters.

• If multiple interfaces send DHCPREQUESTs, it is possible that more than one
DHCPACK is returned with a valid Option 66.

• Evaluating and updating the configuration file occurs only on the primary VLAN.

• Option 66 is ignored by any interfaces not belonging to the primary VLAN.

Multiple Servers serving a
Single VLAN • Each DHCP-enabled VLAN interface initiates one DHCPDISCOVER and

receives one or more DHCPOFFER messages.

• Each interface accepts the best offer.

• Option 66 is processed only for the interface belonging to the primary VLAN.

Table Continued
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Scenario Behavior

Multiple Servers serving
Multiple VLANs • Each DHSP-enabled VLAN interface initiates DHCPDISCOVER and receives

one or more DHCPOFFER messages.

• Each interface accepts the best offer.

• Option 66 is processed only for the interface belonging to the primary VLAN.

Multi-homed Server
serving Multiple VLANs • The switch perceives the multi-homed server as multiple separate servers.

• Each DHCP-enabled VLAN interface initiates DHCPDISCOVER and receives
one DHCPOFFER message.

• Each interface accepts the offer.

• Option 66 is processed only for the interface belonging to the primary VLAN.

Operating notes about automatic configuration
Replacing the existing configuration file: After the switch has completed the DHCP transaction on the Primary
VLAN, the two options will cause the switch to download the configuration file from the TFTP server. After the
DHCP client downloads the configuration file, the switch compares the contents of that file with the existing
configuration file. If the content is different, the new configuration file replaces the existing file and the switch
reboots.

Option 66 and the IP address of a TFTP server: Option 66 includes the IP address of the TFTP server from
which the configuration file is downloaded.

Option 67 and the configuration file name: Option 67 includes the name of the configuration file. If the
DHCPACK contains this option, it overrides the default name for the configuration file (switch.cfg)

Global DHCP parameters: Global parameters are processed only if received on the primary VLAN.

Best Offer: The "Best Offer" is the best DHCP or BootP offer sent by the DHCP server in response to the
DHCPREQUEST sent by the switch. The criteria for selecting the "Best Offer" are:

• DHCP is preferred over BootP

• If two BootP offers are received, the first one is selected

• For two DHCP offers:

◦ The offer from an authoritative server is selected

◦ If there is no authoritative server, the offer with the longest lease is selected

Log messages: The file transfer is implemented by the existing TFTP module. The system logs the following
message if an incorrect IP address is received for Option 66: "Invalid IP address <ip-address> received for
DHCP Option 66".

Overview of switch configuration
Switch configuration involves:
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• How switch memory manages configuration changes

• How the CLI implements configuration changes

• How the menu interface and WebAgent implement configuration changes

• How the switch provides software options through primary/secondary flash images

• How to use the switch’s primary and secondary flash options, including displaying flash information, booting or
restarting the switch, and other topics

Configuration file management
The switch maintains two configuration files, the running-config file and the startup-config file.

Table 8: Switch memory operation

Running Config File Startup-config File

Volatile Memory Flash (Non-Volatile Memory)

Controls switch operation. When the switch boots, the
contents of this file are erased and replaced by the
contents of the startup-config file. If no configuration
changes have been made in the CLI since the switch
was last booted, the running-config file is identical to
the startup-config file.

Preserves the most recently saved configuration
through any subsequent reboot.

CLI configuration changes are written to this file. To
use the CLI to save the latest version of the file to the
startup-config file, you must execute the write memory
command.

*NOTE: Menu interface configuration changes are simultaneously written to both the running-config and the
startup-config file.

Booting the switch replaces the current running-config file with a new running-config file that is an exact copy of
the current startup-config file.

Any of the following actions boots the switch:

• Executing the boot or the reload command in the CLI

• Executing the boot command in the menu interface

• Pressing the Reset button on the front of the switch

• Removing, then restoring power to the switch

For more on reboots and the switch’s dual-flash images, See Using Primary and Secondary flash
image options on page 89.

Options for saving a new configuration. Making one or more changes to the running-config file creates a new
operating configuration. Saving a new configuration means to overwrite (replace) the current startup-config file
with the current running-config file. This means that if the switch subsequently reboots for any reason, it will
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resume operation using the new configuration instead of the configuration previously defined in the startup-config
file. There are three ways to save a new configuration:

• In the CLI:

Use the write memory command. This overwrites the current startup-config file with the contents of the
current running-config file.

• In the menu interface:

Use the Save command. This overwrites both the running-config file and the startup-config file with the
changes you have specified in the menu interface screen.

• In the WebAgent:

Click Save. This overwrites both the running-config file and the startup-config file with the changes you have
specified in the WebAgent screen.

Note that using the CLI instead of the menu or WebAgent gives you the option of changing the running
configuration without affecting the startup configuration. This allows you to test the change without making it
"permanent". When you are satisfied that the change is satisfactory, you can make it permanent by executing the
write memory command. For example, suppose that you use the following command to disable port 5:

switch(config)# interface ethernet 5 disable
The above command disables port 5 in the running-config file, but not in the startup-config file. Port 5 remains
disabled only until the switch reboots. If you want port 5 to remain disabled through the next reboot, use write
memory to save the current running-config file to the startup-config file in flash memory.

switch(config)# write memory
If you use the CLI to make a configuration change and then change from the CLI to the Menu interface without
first using write memory to save the change to the startup-config file, then the switch prompts you to save the
change. For example, if you use the CLI to create VLAN 20, and then select the menu interface, VLAN 20 is
configured in the running-config file, but not in the startup-config file. In this case you will see:

switch(config)# vlan 20
switch(config)# menu
Do you want to save current configuration [y/n]?
If you type ‘y’, the switch overwrites the startup-config file with the running-config file, and your configuration
change(s) will be preserved across reboots. If you type ‘n’, your configuration change(s) will remain only in the
running-config file. In this case, if you do not subsequently save the running-config file, your unsaved
configuration changes will be lost if the switch reboots for any reason.

Storage and retrieval of configuration files. You can store or retrieve a backup copy of the startup-config file on
another device. For more information, see "Transferring Switch Configurations" in the Management and
Configuration Guide for your switch.
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Managing interface access

Listing the current console/serial link configuration
Use the show console command to list the current console/serial link configuration.

Use of show console command

This example demonstrates the use of the show console command.

switch (config)# show console

Console/Serial Link

Inbound Telnet Enabled [Yes] : Yes
Web Agent Enabled [Yes] : Yes

Terminal Type [VT100] : VT100
Screen Refresh Interval (sec) [3] : 3
Displayed Events [All] : All
Baud Rate [speed-sense] : speed-sense
Flow Control [XON/XOFF] : XON/XOFF
Global Session Idle Timeout (sec) [0] : 0
Serial/USB Console Idle Timeout (sec) [not set] : not set
Current Session Idle Timeout (sec) : 0

Enabling and disabling inbound Telnet access
In the default configuration, inbound Telnet access is enabled.

Enabling and disabling inbound Telnet access

To enable inbound Telnet access, do one of the following:

Prerequisites

Before you enable or disable inbound Telnet access on a switch, you must insure that the switch has a separate
out-of-band management port if you want to use an out-of-band management port for Telnet access. See
Appendix I, "Network Out-of-Band Management" in this guide for more information about out-of-band
management.

Procedure

1. Use the telnet-server command to enable inbound Telnet access through the data ports.

2. Use the following command to enable inbound Telnet access through specific ports: telnet-server
[ listen < oobm | data | both > ]
Data ports ( listen data option), out-of-band management ports (listen oobm option), or both data and out-of-
band management ports (listen both) can be specified.

Chapter 8
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To disable inbound Telnet access, do one of the following:

• Use the no telnet-server command to disable inbound Telnet access through the data ports.

• Use the following command to disable inbound Telnet access through specific ports:no telnet-server
[ listen < oobm | data | both > ]Data ports (listen data option), out-of-band management ports
(listen oobm option), or both data and out-of-band management ports (listen both) can be specified.

Examples

To disable inbound Telnet access:

switch(config)# no telnet-server
To re-enable inbound Telnet access:

switch(config)# telnet-server

Initiating an outbound Telnet session to another device
Initiating an outbound Telnet session to another network device

To initiate an outbound Telnet session, do one of the following:

Prerequisites

Before you initiate an outbound Telnet session to another network device, you must insure that:

• The switch has a separate out-of-band management port, if you want to use an out-of-band management port
for the outbound Telnet traffic. See Appendix I, "Network Out-of-Band Management" in this guide for more
information about out-of-band management.

• Stacking is enabled, if you want to initiate an outbound Telnet session to a member switch that is a
commander in a stack.

Procedure

1. Use the following command to initiate an outbound Telnet session through a data port:
telnet <ipv4-addr | ipv6-addr | hostname | switch-num>

2. Use the following command to initiate an outbound Telnet session through an out-of-band management port:
telnet < ipv4-addr | ipv6-addr | hostname | switch-num > oobm

In these commands, the destination device for the outbound Telnet session is specified as an IPv4 address, IPv6
address, hostname, or stack number (1-16) of a member switch.

Examples

If the host "Labswitch" is in the domain abc.com, you can enter the following command and the destination is
resolved to "Labswitch.abc.com":

switch(config)# telnet Labswitch
You can also enter the full domain name of the host in the command:

switch(config)# telnet Labswitch.abc.com
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You can use the show telnet command to display the resolved IP address.

Figure 49: The show telnet command displaying resolved IP addresses

switch(config)# show telnet

  Telnet Activity

  -------------------------------------------------------
  Session  : **  1
  Privilege: Manager
  From     : Console
  To       :

  -------------------------------------------------------
  Session  : **  2
  Privilege: Manager
  From     : 12.13.14.10
  To       : 15.33.66.20

  -------------------------------------------------------
  Session  : **  3
  Privilege: Operator
  From     : 2001:db7:5:0:203:4ff:fe0a:251
  To       : 2001:db7:5:0:203:4ff1:fddd:12

Web-management interface configuration for idle timeout
An administrator sets the idle timeout for the WebUI management interface and specifies a session timeout page
that is displayed to the user when the WebUI management session ends.

Use the following command to configure the Web-management interface for idle timeout:

web-management [management-url <URL>] [support-url <URL>] [plaintext] [ssl<TCP-
PORT>] [idle-timeout <300-7200>]

The following parameters are specified to configure the Web-management interface for idle timeout:
Management-url

Specify URL to load when the [?] button is clicked on the device's web interface.

Support-url

Specify URL to load when the Support tab is clicked on the device's web interface.

Plaintext

Indicates that the http server has to be enabled with no security. If no parameters are specified, plaintext
is implied. The plaintext server always listens on the well-known port 80.

SSL

Indicates that the http server has to be enabled with Secure Sockets Layer support. TCP port on which the
https server must listen for connections. If the TCP port is not specified, the default is port 443.

The ssl and plaintext variants of the command function independently of each other. Enabling http+ssl
does not automatically prevent the device from accepting plaintext connections; you must explicitly disable
plaintext connections with the command [no] web-management plaintext.

Idle-timeout

Specifies the idle timeout for web management sessions. This ranges from 300 seconds to 7200 seconds.
The default value is 600 seconds.
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The following example shows WebUI Idle timeout

switch(config)# web-management
idle-timeout Set the idle timeout for web management sessions.
management-url Specify URL for web interface [?] button.
plaintext Enable or disable the http server (insecure).
ssl Enable or disable the https server (secure).
support-url Specify URL for web interface support page.
switch(config)# web-management idle-timeout
<300-7200> Enter an integer number.

Enabling and disabling inbound WebAgent access
In the default configuration, inbound WebAgent (web browser) access, that is, inbound HTTP access, is enabled.

Enabling and disabling inbound WebAgent access

To enable inbound WebAgent access, do one of the following:

Prerequisites

Before you enable or disable inbound WebAgent access on a switch, you must insure that the switch has a
separate out-of-band management port if you want to use an out-of-band management port for WebAgent
access. See Appendix I, "Network Out-of-Band Management" in this guide for more information about out-of-band
management.

Procedure

1. Use the web-management command to enable inbound WebAgent access through the data ports.

2. Use the following command to enable inbound WebAgent access through specific ports:
web-management [ listen < oobm | data | both > ] Data ports (listen data option), out-of-band
management ports (listen oobm option), or both data and out-of-band management ports (listen both) can
be specified.

To disable inbound WebAgent access, do one of the following:

• Use the no web-management command to disable inbound WebAgent access through the data ports.

• Use the following command to disable inbound WebAgent access through specific ports:no web-
management [ listen < oobm | data | both > ]Data ports (listen data option), out-of-band
management ports (listen oobm option), or both data and out-of-band management ports (listen both) can
be specified.

Examples

To disable inbound WebAgent access:

switch(config)# no web-management
To re-enable inbound WebAgent access:

switch(config)# web-management

Reconfiguring the console/serial link settings
Use the following command to reconfigure the console/serial link settings:

console
[terminal <vt100|ansi|none>]
[screen-refresh <1|3|5|10|20|30|45|60]
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[baud-rate <speed-sense|1200|2400|4800|9600|19200|38400|57600|1155200>]
[flow-control <xon/xoff|none>]
[idle-timeout <0-7200>]
[events [<none]|all|not-info|critical|debug>]
[local-terminal <vt100|none|ansi>]
Considerations for setting idle-timeout, baud rate, and flow control settings:

• If the console idle-timeoutexpires, any outbound Telnet or SSH sessions open on the switch are terminated.

• If you change the baud rate or flow control settings, you must make the corresponding changes in your
console access device. Otherwise, you may lose connectivity between the switch and your terminal emulator
due to differences between terminal and switch settings for these two parameters.

All console parameter changes except events require that you save the configuration with write memory and
then execute boot before the new console configuration will take effect.

Switch models supporting redundant management, console settings, such as mode, flow-control, and baud-rate,
are the same on both management modules. There cannot be individual settings for each management module.

This example (Executing a series of console commands) shows how to configure the switch with the following:

• VT100 operation

• 19,200 baud

• No flow control

• 600 second (10 minutes) idle timeout

• Critical log events

switch(config)# console terminal vt100
This command will take effect after saving the
configuration and rebooting the system.

switch(config)# console baud-rate 19200
This command will take effect after saving the
configuration and rebooting the system.

switch(config)# console flow-control none
This command will take effect after saving the
configuration and rebooting the system.

switch(config)# console idle-timeout 600
switch(config)# console events critical
switch(config)# write memory
switch(config)# reload

Software version support of console/serial link settings
In software release versions K.15.12 and greater, the console inactivity-timer <minutes> command has been
deprecated and replaced by the console idle-timeout <seconds> command. As an example:

switch(config)#console inactivity-timer 2
is now equivalent to:

switch(config)#console idle-timeout 120
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In addition, the serial or USB console idle timeout can be controlled separately if needed. The console idle-
timeout serial-usb seconds command allows for this behavior. As an example:

switch(config)#console idle-timeout 120
switch(config)#console idle-timeout serial-usb 15
This sequence of commands will set the Telnet/SSH idle timeout to 120 seconds and the serial-usb idle timeout to
15 seconds. Another example:

switch(config)#console idle-timeout 120
switch(config)#console idle-timeout serial-usb 0
This sequence of commands will set the Telnet/SSH idle timeout to 120 seconds and the serial-usb idle timeout to
0, or, in other words, to never time out.

The console inactivity-timer minutes command will continue to be accepted in version, but it will be converted
to the new command format in the running configuration. This command conversion will also happen on a
software update to version if the console inactivity-timer minutes command was part of the previous
configuration.

These settings can be displayed using show console.

Interface-access parameters
The interface access in the switch operates properly by default. However, you can modify interface-access
parameters to suit your particular needs.

The following table lists the interface-access parameters that are modifiable and their default values. In most
cases, the default values are acceptable for standard operation.

Parameter Default value

Idle-Timeout 10 Minutes (disabled)

Inbound Telnet Access Enabled

Outbound Telnet Access n/a

WebAgent Access Enabled

Terminal type VT-100

Event Log event types to list (Displayed Events) All

Baud Rate Speed Sense

Flow Control XON/XOFF

Basic switch security is through passwords. You can gain additional security by using the security
features described in the Access Security Guide for your switch. You can also simply block
unauthorized access via the WebAgent or Telnet (as described in this section) and installing the
switch in a locked environment.

Terminal line width and length settings
For console/serial link and inbound telnet sessions, the switch output:
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• Uses whatever width is set by the terminal program. If width is not specified, 80 characters is the default.

• Automatically wraps on word boundaries (such as spaces) for non-columnar output

• Automatically wraps on column boundaries for columnar output

Hewlett Packard Enterprise recommends that you do not set your terminal width (terminal width <y>) above
150 columns. (Windows telnet displays up to 156 characters on 1280 pixelwide display, so 150 is comfortably
within this).

Window size negotiation for a telnet session
When a telnet connection is established with a switch, the switch always uses the default values of 80 columns by
24 lines for the window dimensions. The window can be resized by either dragging the corner of the window, or by
executing the terminal length <x> width <y> CLI command and then configuring the telnet client with
those dimensions. The new window dimensions are lost after that telnet session ends.

When the telnet connection is established with a switch, either the switch or the telnet client needs to initiate the
inquiry about the availability of NAWS. If NAWS is available, you can resize the window by dragging the corner of
the window to the desired size. The telnet software uses NAWS to tell the switch what the new window
dimensions are. If the switch supports the requested window dimensions, it uses them for all future interactions. If
the switch does not support those window dimensions, it refuses them and the telnet client requests an alternate
set of window dimensions. The negotiation continues until the telnet client and the switch agree on the window
dimensions.

The switch currently responds to a request from the remote telnet client to negotiate window size. However, some
telnet clients do not request to negotiate window size unless the switch’s telnet server suggests that NAWS is
available.

This feature allows window size negotiation to occur with telnet clients that support NAWS but do not try to use it
unless it is suggested by the switch’s telnet server. The switch’s telnet server will suggest to the telnet client that
NAWS is available.

Denying interface access
Use the kill [<session-number command to terminate a currently running remote session. Interface access
is denied when a remote session terminates.

The following example shows how to terminate a remote session using the kill command:

The switch supports up to five management sessions. The show ip ssh command lists the current management
sessions. If you are using the switch’s serial port for a console session and want to terminate an active Telnet
session, you would do the following:
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Viewing and setting system information

Viewing system information
Use the show system information command to list the current system information.

Examples

This example demonstrates the use of the show command to list the current system information.

switch# show system information

  Status and Counters - General System Information

   System Name        : switch
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   System Contact     :
   System Location    :

   MAC Age Time (sec) : 300

   Time Zone          : 0
   Daylight Time Rule : None

Setting system information
Do one of the following to set system information:

Procedure

1. Use the following command to set a plain-language identity for the switch, which helps to distinguish one
switch from another:
hostname <name-string> snmp-server [contact <system-contact>][location <system-
location>]
Each field allows up to 255 characters. To help simplify administration, it is recommended that you set
hostname to a character string that is meaningful within your system.

2. Use the mac-age-time <10-1000000>
command to set the MAC age time for learned MAC addresses. The default value is 300 seconds.

The MAC age time corresponds to the MAC Age Interval in the menu interface.

3. Use the following command to set the time zone and daylight-time rule:
time timezone <-720 - 840> time daylight-time-rule [ alaska | continental-us-and-
canada | middle-europe-and-portugal | southern-hemisphere | western-europe |
<user-defined> ]
The default daylight-time rule is none. For the time zone: east of the 0 meridian, the sign is "+"; west of the 0
meridian, the sign is "-". For example, the time zone setting for Berlin, Germany is +60 (zone + 1, or 60
minutes) and the time zone setting for Vancouver, Canada is –480 (zone – 8, or –480 minutes).

4. Use the time [<hh>:<mm>[:<ss>]][<mm>/<dd>/[<yy>]<yy>]command to set the time and
date.
The CLI uses a 24-hour clock scheme; that is, hour (hh) values from 1 p.m. to midnight are input as 13 - 24,
respectively.

Examples

Example

This example shows the use of the time command to set the switch to 9:45 a.m. on November 17, 2012:

switch(config)# time 9:45 11/17/12
This example shows the use of the time command to set the time zone and daylight time rule for Vancouver,
Canada:

switch(config)# time timezone -480 daylight-time-rule
continental-us-and-canada
This example shows the use of the mac-age-time command to set the age time to seven minutes:

switch(config)# mac-age-time 420
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This example shows the system information listing after executing the hostname command to name the switch
"Blue" with "Next-4474" as the system contact, and "North-Data-Room" as the location:

System parameters
The following table lists the system parameters that are modifiable and their default values. Configuration of
system information is optional, but recommended.

System parameter Default value

System Name switch product name

System Contact n/a

System Location n/a

300 seconds

Time Sync Method None

Time Zone 0

Daylight Time Rule None

Time January 1, 1990 at 00:00:00 at last power reset

MAC Age Time

Descriptions of the system parameters:

• System Name:

Using a unique name helps you to identify individual devices where you are using an SNMP network
management tool.

• System Contact and Location:

126 Aruba Basic Operation Guide for ArubaOS-Switch 16.05

Anexo 02 ITEM 11 (0592659)         SEI 0008478-63.2018.6.02.8000 / pg. 5739



This information is helpful for identifying the person administratively responsible for the switch and for
identifying the locations of individual switches.

• MAC Age Time:

The number of seconds a MAC address the switch has learned remains in the switch’s address table before
being aged out (deleted). Aging out occurs when there has been no traffic from the device belonging to that
MAC address for the configured interval.

• Time Sync Method:

Selects the method (TimeP or SNTP) the switch will use for time synchronization. For more on this topic, see
the "Time Protocols" chapter in the latest Management and Configuration Guide.

• Time Zone:

The number of minutes your time zone location is to the West (+) or East (-) of Coordinated Universal Time
(formerly GMT). The default 0 means that no time zone is configured. For example, the time zone for Berlin,
Germany is + 60 (minutes) and the time zone for Vancouver, Canada is - 480 (minutes).

• Daylight Time Rule:

Specifies the daylight savings time rule to apply for your location. The default is None. (For more on this topic,
See Appendix D, "Daylight Savings Time on switches.)

• Time:

Used in the CLI to specify the time of day, the date, and other system parameters.
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Using the menu or WebAgent to configure IP addressing

Using the Switch Setup screen to quickly setup IP addressing
If you just want to give the switch an IP address so that it can communicate on your network, or if you are not
using VLANs, Hewlett Packard Enterprise recommends that you use the Switch Setup screen to quickly configure
IP addressing.

To use the Switch Setup screen for quickly configuring IP addressing, do one of the following:

Procedure

1. Enter the setup command at the CLI Manager level prompt:

switch# setup
2. Select 8. Run Setup in the Main Menu of the menu interface.

For more on using the Switch Setup screen, See the Installation and Getting Started Guide you received with the
switch.

Using the menu to configure IP address, Gateway, and Time-To-Live (TTL)

Procedure

1. From the Main Menu, select:

  2. Switch Configuration...

      5. IP Configuration

          
2. If multiple VLANs are configured, a screen showing all VLANs appears. The Menu interface displays the IP

address for any VLAN. If you use the CLI to configure the IP address on a VLAN, use the CLI show ip
command to list them.

3. Press [E] (for Edit).

4. If the switch needs to access a router, for example, to reach off-subnet destinations, select the Default
Gateway field and enter the IP address of the gateway router.

5. If you need to change the packet Time-To-Live (TTL) setting, select Default TTL and type in a value between 2
and 255.

6. To configure IP addressing, select IP Config and do one of the following:

a. If you want to have the switch retrieve its IP configuration from a DHCP or Bootp server, at the

Chapter 9
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IP Config

field, keep the value as

DHCP/ Bootp

and go to step 8.

b. If you want to manually configure the IP information, use the Space bar to select
Manual

and use the

[Tab]

key to move to the other IP configuration fields.

7. Select the IP Address field and enter the IP address for the switch.

8. Select the Subnet Mask field and enter the subnet mask for the IP address.

9. Press [Enter], then [S](for Save).

Using the WebAgent to configure IP addressing
Using the WebAgent to configure IP addressing

To configure IP addressing on the switch:

Prerequisites

Before you use the WebAgent to configure IP addressing, you must insure the switch has an IP address that is
reachable through your network.

Procedure

1. In the navigation pane, click Home.

2. Click Quick Setup.

3. In the Switch Quick Setup Parameters box, click Change.

4. Enter the IP address and any other information such as the Subnet mask and Gateway.

5. Click Save to save your changes.

6. If you need further information on using the WebAgent, click [?] to access the web-based help available for the
switch.

Using the CLI to configure IP Addressing, Gateway, and
Time-To-Live (TTL)

Viewing the current IP configuration
Do one of the following:

• Use the show ip command to view the IP addressing for each VLAN that is configured in the switch.
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If only the DEFAULT_VLAN exists, then its IP configuration applies to all ports in the switch. Where multiple
VLANs are configured, the IP addressing is listed per VLAN. The display includes switch-wide packet time-to-
live, and (if configured) the switch’s default gateway and Timep configuration.

• Use the show management
command to view the IP addressing and time server IP addressing that is configured on the switch.

Examples

The following example shows the switch's default IP addressing. In the factory default configuration (no IP
addressing assigned), the switch’s IP addressing appears as:

switch(config)# show ip

 Internet (IP) Service

   IP Routing : Disabled

   Default Gateway :
   Default TTL     : 64
   Arp Age         : 20
   Domain Suffix   :
   DNS server      :

                      |                                           Proxy ARP
VLAN                  | IP Config  IP Address      Subnet Mask    Std Local
--------------------- + ---------- --------------- -------------- ----------
DEFAULT_VLAN          | DHCP/Bootp
With multiple VLANs and some other features configured, show ip provides additional information. The following
example shows IP listing with non-default IP addressing configured

switch(config)# show ip

 Internet (IP) Service

   IP Routing : Disabled

   Default Gateway : 10.20.227.1
   Default TTL     : 64
   Arp Age         : 20
   Domain Suffix   :
   DNS server      :

                      |                                           Proxy ARP
VLAN                  | IP Config  IP Address      Subnet Mask    Std Local
--------------------- + ---------- --------------- -------------- ----------
DEFAULT_VLAN          | Manual     10.28.227.101   255.255.248.0   No   No
VLAN22                | Disabled

Configuring an IP address and subnet mask on a VLAN
Use one of the following forms of the vlan command to configure an IP address and subnet mask:
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• vlan <vlan-id> ip address <ip-address>/<mask-length>
• vlan <vlan-id> ip address <ip-address> <mask-bits>
• vlan <vlan-id> ip address <dhcp-bootp>

You must either include the ID of the VLAN for which you are configuring IP addressing or go to the context
configuration level for that VLAN. (If you are not using VLANs on the switch—that is, if the only VLAN is the
default VLAN—then the VLAN ID is always "1".)

The default IP address setting for the DEFAULT_VLAN is DHCP/Bootp. On additional VLANs you create, the
default IP address setting is disabled.

Examples

The following example configures IP addressing on the default VLAN with the subnet mask specified in mask bits.

switch(config)# vlan 1 ip address 10.28.227.103 255.255.255.0
The following example configures the same IP addressing as the preceding example, but specifies the subnet
mask by mask length.

switch(config)# vlan 1 ip address 10.28.227.103/24

Removing an IP address that is configured on a VLAN
Use one of the following forms of the vlan command to delete an IP address that is configured on a VLAN:

Procedure

1. no vlan <vlan-id> ip address <ip-address>/<mask-length>
2. no vlan <vlan-id> ip address <ip-address> <mask-bits>

Examples

The following example deletes an IP address configured on VLAN 1.

switch (config) no vlan 1 ip address 10.28.227.103/24

Multiple IP addresses configuration on a VLAN (multinetting)
Use one of the following forms of the vlan command to configure multiple IP addresses on a VLAN (multinetting).

• vlan <vlan-id> ip address <ip-address>/<mask-length>
• vlan <vlan-id> ip address <ip-address> <mask-bits>

The following is supported:

• Up to 2000 IP addresses for the switch.

• Up to 32 IP addresses for the same VLAN

• Up to 512 IP VLANs, that is, VLANs on which you can configure IP addresses

• Each IP address on a VLAN must be for a separate subnet, whether on the same VLAN or different VLANs.

The Internet (IP) Service screen in the Menu interface displays the first IP address for each VLAN. You must use
the CLI show ip command to display the full IP address listing for multinetted VLANs.
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Configuring and displaying multi netted VLAN

If you wanted to multinet VLAN_20 (VID = 20) with the IP addresses shown below, you would perform steps
similar to the following. For this example, assume that the first IP address is already configured.

IP Address VID IP Address Subnet Mask

1st address 20 10.25.33.101 255.255.240.0

2nd address 20 10.26.33.101 255.255.240.0

3rd address 20 10.27.33.101 255.255.240.0

switch(config)# vlan 20
switch(vlan-20)# ip address 10.26.33.101/20
switch(vlan-20)# ip address 10.27.33.101/20

switch(config)# show ip

 Internet (IP) Service

   IP Routing      : Disabled

   Default Gateway : 10.20.227.1
   Default TTL     : 64
   Arp Age         : 20
   Domain Suffix   : 
   DNS server      :

                       |                                           Proxy ARP
   VLAN                | IP Config  IP Address      Subnet Mask    Std Local
   ------------------- + ---------- --------------- -------------- ----------
   DEFAULT_VLAN        | Manual     10.20.30.100   255.255.240.0   No   No
   VLAN_20             | Manual     10.25.33.101   255.255.240.0   No   No
                       | Manual     10.26.33.101   255.255.240.0   No   No
                       | Manual     10.27.33.101   255.255.240.0   No   No

Multinetting on the default VLAN

To multinet the default VLAN, you would do the following:

switch(vlan-20)# vlan 1
switch(vlan-1)# ip address 10.21.30.100/20

switch(config)# show ip

 Internet (IP) Service

   IP Routing      : Disabled

   Default Gateway : 10.20.227.1
   Default TTL     : 64
   Arp Age         : 20
   Domain Suffix   : 
   DNS server      :
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                       |                                           Proxy ARP
   VLAN                | IP Config  IP Address      Subnet Mask    Std Local
   ------------------- + ---------- --------------- -------------- ----------
   DEFAULT_VLAN        | Manual     10.20.30.100   255.255.240.0   No   No
                       | Manual     10.21.30.100   255.255.240.0   No   No
   VLAN_20             | Manual     10.25.33.101   255.255.240.0   No   No
                       | Manual     10.26.33.101   255.255.240.0   No   No
                       | Manual     10.27.33.101   255.255.240.0   No   No

Removing IP addresses from a multinetted VLAN
Use one of the following forms of the vlan command to delete an IP address that is configured on a multinetted
VLAN:

Procedure

1. no vlan <vlan-id> ip address <ip-address>/<mask-length>
2. no vlan <vlan-id> ip address <ip-address> <mask-bits>

Configuring the optional default gateway

Prerequisites

Before you use the CLI to configure the optional default gateway, you must be at the global configuration level.

One default gateway can be manually assigned to the switch. The switch does not allow IP addressing received
from a DHCP or Bootp server to replace a manually configured default gateway.

Configuring the optional default gateway

Use the ip default-gateway <ip-address> command to configure the optional default gateway:

Examples

The following example shows the configuration of the default gateway with the IP address 10.28.227.115.

switch(config)# ip default-gateway 10.28.227.115

Setting the Time-To-Live (TTL)

Prerequisites

Before you use the CLI to set the TTL, you must be at the global configuration level.

The Time-To-Live (TTL) is the maximum number of routers (hops) through which a packet can pass before being
discarded. Each router decreases a packet’s TTL by 1 before forwarding the packet. If a router decreases the TTL
to 0, the router drops the packet instead of forwarding it.

Setting the TTL

Use the ip ttl <number-of-hops> command to set the TTL. The default value for the TTL is 64 and the
range is 2 - 255.

Examples

The following example sets the TTL to 60.

switch(config)# ip ttl 60

Managing loopback interfaces
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Adding a loopback interface

This task is not support by Switch 2530 (J9772A–J9783A) products.

Adding a loopback interface

To add a loopback interface on the switch:

Prerequisites

Before you use the CLI to add a loopback interface, you must be at the global configuration level.

Procedure

1. Use the interface loopback <number> command to create the loopback interface. The number
argument is a value from 1 to 7.

2. Use the ip address <ip address> command to configure an IP address for the loopback interface.

3. You can configure up to 32 IP addresses on a loopback interface. You do not need to specify a network mask.
A loopback interface uses the default subnet mask 255.255.255.255.

Examples

Figure 50: A loopback interface configured with one IP address

switch(config)# interface loopback 1
switch(config)# ip address 10.1.1.1
Figure 51: Loopback interfaces configured with multiple IP addresses

This example shows the addition of two loopback interfaces, each with two IP addresses configured.

switch(config)# interface loopback 0
switch(lo0)# ip address 172.16.101.8
switch(lo0)# ip address 172.16.101.9
switch(lo0)# exit
switch(config)# interface loopback 1
switch(lol)# ip address 172.16.102.1
switch(lol)# ip address 172.16.102.2

Removing a loopback interface

Prerequisites

Before you use the CLI to remove a loopback interface, you must be at the global configuration level.

This task is not support by Switch 2530 (J9772A–J9783A) products.

Removing a loopback interface

Use the no interface loopback <number> command to remove a loopback interface. The number
argument is a value from 1 to 7, specifying the loopback interface to be removed.
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You cannot remove the default loopback interface (number 0) with IP address 127.0.0.1.

Displaying loopback interface configurations
Do one of the following:

• Use the show ip command to display a list of the loopback interfaces, which are sorted according to the
loopback number.

The list of loopback interfaces is displayed below other IP configuration parameters, such as packet TTL and
ARP age-out values, and VLAN IP configurations. The default loopback interface (

• Use the show ip route command to display the loopback interfaces in a list of IP routing entries. The list is
sorted according to the destination IP address.

Examples

The following example displays the IP addresses configured for two user-defined loopback interfaces(lo1 and
lo2).

switch# show ip

 IP Routing : Enabled

   Default Gateway : 15.255.128.1
   Default TTL     : 64
   Arp Age         : 20
   Domain Suffix   :
   DNS server      : 

                    |                                           Proxy ARP
   VLAN             | IP Config  IP Address      Subnet Mask    Std Local
   ---------------- + ---------- --------------- -------------- ----------
   DEFAULT_VLAN     | Manual     10.0.8.121     255.255.0.0     No   No
   VLAN2              Manual     192.168.12.1   255.255.255.0   No   No
   VLAN3              Disabled

                           Loopback Addresses
   Loopback   IP Config    IP Address           Subnet Mask
   --------   ----------   ------------------   ---------------
   lol        Manual       172.16.110.2         255.255.255.255 
   lo2        Manual       172.16.112.2         255.255.255.255 
   lo2        Manual       172.16.114.1         255.255.255.255
The following example displays the configuration of the default loopback interface (lo0) and one user-defined
loopback interface (lo2).

switch# show ip route

                                IP Route Entries

Destination        Gateway         VLAN Type      Sub-Type   Metric    Dist.
------------------ --------------- ---- --------- ---------- --------- ----
10.0.0.0/16        DEFAULT_VLAN    1    connected             1         0
127.0.0.0/8        reject               static                0         0
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127.0.0.1/32       lo0                  connected             1         0
172.16.10.121/32   lo2                  static                1         0
172.16.100.0/24    10.0.8.11       1    ospf       IntraArea  1         1
172.16.102.0/24    VLAN2           2    connected             1         0

Summary of loopback interface configuration
Summary of loopback interface configuration:

• You can configure a loopback interface only from the CLI; you cannot configure a loopback interface from the
WebAgent or Menu interface.

• Loopback interfaces share the same IP address space with VLAN configurations. The maximum number of IP
addresses supported on a switch is 2048, which includes all IP addresses configured for both VLANs and
loopback interfaces (except for the default loopback IP address 127.0.0.1).

• Each IP address that you configure on a loopback interface must be unique in the switch. This means that the
address cannot be used by a VLAN interface or another loopback interface.

• For example, if you configure a VLAN with IP address 172.16.100.8/24, you cannot configure a loopback
interface with IP address 172.16.100.8. In the same way, if you configure a loopback interface (lo1) with IP
address 172.16.101.8, you cannot configure another loopback interface (lo2) with IP address 172.16.101.8.

• You can configure multiple IP addresses on a loopback interface (lo0 to lo7). Up to 32 IP addresses are
supported on a loopback interface.

Overview of loopback interfaces
By default, each switch has an internal loopback interface (lo0) with the IP address 127.0.0.1. This IP address is
used only for internal traffic transmitted within the switch and is not used in packet headers in egress traffic sent to
network devices.

You can configure up to seven other loopback interfaces (lo1, lo2, lo3, and so on) on the switch to use to
transmit network across the network. Each loopback interface can have multiple IP addresses. Routing protocols,
such as RIP and OSPF, advertise the configured loopback addresses throughout a network or autonomous
system.

User-defined loopback addresses provide the following benefits:

• A loopback interface is a virtual interface that is always up and reachable as long as at least one of the IP
interfaces on the switch is operational. As a result, a loopback interface is useful for debugging tasks since its
IP address can always be pinged if any other switch interface is up.

• You can use a loopback interface to establish a Telnet session, ping the switch, and access the switch through
SNMP, SSH, and HTTP (WebAgent).

• A loopback IP address can be used by routing protocols. For example, you can configure the loopback IP
address as the router ID used to identify the switch in an OSPF area. Because the loopback interface is
always up, you ensure that the switch's router ID remains constant and that the OSPF network is protected
from changes caused by downed interfaces.

OSPF does not require that you use an IP address as the router ID. OSPF only requires the router ID to be a
unique value within the autonomous system (AS). However, if you configure the loopback IP address as the router
ID, OSPF can reach the switch if any switch interface is up. (Normally, OSPF automatically configures the router
ID with the IP address of a switch interface. The disadvantage is that if the interface goes down, OSPF can no
longer ping the switch using the router ID even if other interfaces are operational.)

For more information about how to configure a loopback IP address to participate in an OSPF broadcast area,
see the titled "(Optional) Assigning Loopback Addresses to an Area" in the Multicast and Routing Guide.
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Retaining VLAN-1 IP addressing across configuration file
downloads

Enabling IP preserve to retain VLAN-1 IP addressing

Procedure

1. IP Preserve retains VLAN-1 IP addressing across configuration file downloads.

2. To set up IP Preserve, insert the “ip preserve“ at the end of a configuration file, as shown in the following
example. Note that you do not execute IP Preserve by entering a command in the CLI.

; J9091A Configuration Editor; Created on release #K.15.14.0001
hostname "switch"
time daylight-time-rule None
.
.
.
password manager
password operator
ip preserve

Operating rules for IP preserve
When ip preserve is entered as the last line in a configuration file stored on a TFTP server:

• If the switch’s current IP address for VLAN 1 was not configured by DHCP/ Bootp, IP Preserve retains the
switch’s current IP address, subnet mask, and IP gateway address when the switch downloads the file and
reboots. The switch adopts all other configuration parameters in the configuration file into the startup-config
file.

• If the switch’s current IP addressing for VLAN 1 is from a DHCP server, IP Preserve is suspended. In this
case, whatever IP addressing the configuration file specifies is implemented when the switch downloads the
file and reboots. If the file includes DHCP/Bootp as the IP addressing source for VLAN 1, the switch will
configure itself accordingly and use DHCP/ Bootp. If instead, the file includes a dedicated IP address and
subnet mask for VLAN 1 and a specific gateway IP address, then the switch will implement these settings in
the startup-config file.

• The ip preserve statement does not appear in show config listings. To verify IP Preserve in a
configuration file, open the file in a text editor and view the last line.

Overview of IP preserve
For the switches covered in this guide, IP Preserve enables you to copy a configuration file to multiple switches
while retaining the individual IP address and subnet mask on VLAN 1 in each switch, and the Gateway IP address
assigned to the switch. This enables you to distribute the same configuration file to multiple switches without
overwriting their individual IP addresses.

To summarize the IP Preserve effect on IP addressing:
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• If the switch received its most recent VLAN 1 IP addressing from a DHCP/ Bootp server, it ignores the ip
preserve command when it downloads the configuration file, and implements whatever IP addressing
instructions are in the configuration file.

• If the switch did not receive its most recent VLAN 1 IP addressing from a DHCP/Bootp server, it retains its
current IP addressing when it downloads the configuration file.

• The content of the downloaded configuration file determines the IP addresses and subnet masks for other
VLANs.

The following examples demonstrate the operation of IP Preserve:

Figure 52: Example of IP Preserve operation with multiple series switches

If you apply the following configuration file to the scenario that is shown in Figure 52: Example of IP Preserve
operation with multiple series switches on page 138, switches 1 - 3 will retain their manually assigned IP
addressing and switch 4 will be configured to acquire its IP addressing from a DHCP server.

Configuration file in TFTP server with DHCP/Bootp specified as the IP addressing source

switch(config)# show run

Running configuration:

; J9091A Configuration Editor; Created on release #K.15.10.0001

hostname "switch"
module 1 type J8702A
module 2 type J8705A
trunk A11-A12 Trk1 Trunk
ip default-gateway 10.10.10.115
snmp-server community "public" Unrestricted
vlan 1
   name "DEFAULT_VLAN"
   untagged A1-A10,A13-A24,B1-B24,Trk1
   ip address dhcp-bootp
   exit
spanning-tree Trk1 priority 4
password manager
password operator
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If you apply the following configuration file to the scenario that is shown in Figure 52: Example of IP Preserve
operation with multiple series switches on page 138, switches 1 - 3 will still retain their manually assigned IP
addressing. However, switch 4 will be configured with the IP addressing included in the file.

Configuration file in TFTP server with dedicated IP addressing, instead of DHCP/Bootp

switch# show run

Running configuration:

; J9091A Configuration Editor; Created on release #K.15.10.0001

hostname "switch"
module 1 type J8702A
module 2 type J8705A
trunk A11-A12 Trk1 Trunk
ip default-gateway 10.10.10.115
snmp-server community "public" Unrestricted
vlan 1
   name "DEFAULT_VLAN"
   untagged A1,A7-A10,A13-A24,B1-B24,Trk1
   ip address 10.12.17.175 255.255.255.0
   tagged A4-A6
   no untagged A2-A3
   exit
vlan 2
   name "VLAN2"
   untagged A2-A3
   no ip address
   exit
spanning-tree Trk1 priority 4
password manager
password operator

Configuring a single source IP address for software
applications

Specifying the source IP address
Only one source IP address can be specified for each software application.

Do one of the following:

• Use the following command to specify the source IP address for the specified software application.

ip source-interface
< radius | sflow | sntp | syslog | tacacs | telnet | tftp >
< loopback <id> | vlan <vlan-id> | address <ip-address> >

• Use the following command to specify the source IP address for all software applications.

ip source-interface all
< loopback <id> | vlan <vlan-id> | address <ip-address> >

• loopback <id> :

Specifies that the IP address of the loopback interface is used as the source IP address in outgoing packets. If
the loopback interface has no IP address, then the application reverts to the default behavior. If more than one
IP address is configured, then the lowest IP address is used.
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• vlan <vlan-id> :

Specifies that the IP address of the indicated VLAN interface is used as the source IP address of outgoing
packets. If the specified VLAN interface has no IP address configured, or is down, then the application reverts
to the default behavior. If more than one IP address is configured, then the lowest IP address is used.

• address <ip-address> :

Specifies the IP address that should be used as the source IP address of outgoing packets. The IP address
must be a valid IP address configured on one of the switch’s VLAN or loopback interfaces. If the interface is
down, then the application reverts to the default behavior.

Canceling the source IP address assignment
When the source IP address assignment for a software application is canceled, the application reverts to its
default behavior and the system determines the source IP address of outgoing application-specific IP packets at
packet transmission time.

Do one of the following:

• Use the following command to cancel the source IP address assignment for the specified software application.

no ip source-interface 
< radius | sflow | sntp | syslog | tacacs | telnet | tftp >

• Use the following command to cancel the source IP address assignment for all software applications.

no ip source-interface all

Viewing source IP address configurations
Do one of the following:

• Use the following command to view the source IP address configuration for the specified protocol.

show ip source-interface
[ radius | sflow | sntp | tacacs | telnet | tftp | syslog ]

• Use the following command to view the source IP address configuration for all protocols.

show ip source-interface

Examples

The following example shows a specific IP address assigned for the RADIUS application protocol

switch(config)# ip source-interface radius address 10.10.10.2

switch(config)# show ip source-interface radius

  Source-IP Configuration Information

  Protocol | Admin Selection Policy  IP Interface   IP Address
  -------- + ----------------------- -------------- --------------
  Radius   | Configured IP Address   vlan 3         10.10.10.2 
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The following example shows a VLAN interface assigned as the source IP address for the TACACS application
protocol

switch(config)# ip source-interface tacacs vlan 22

switch(config)# show ip source-interface tacacs

  Source-IP Configuration Information

   Protocol | Admin Selection Policy  IP Interface   IP Address
   -------- + ----------------------- -------------- --------------
   Tacacs   | Configured IP Interface vlan 22        10.10.10.4 
The following example shows Source IP address configurations for all application protocols

switch(config)# show ip source-interface

 Source-IP Configuration Information

  Protocol | Admin Selection Policy  IP Interface  IP Address
  -------- + ----------------------- ------------- ---------------
  Tacacs   | Configured IP Interface vlan 22
  Radius   | Configured IP Address                 10.10.10.2
  Syslog   | Configured IP Interface vlan 10
  Telnet   | Outgoing Interface
  Tftp     | Outgoing Interface
  Sntp     | Outgoing Interface
  Sflow    | Outgoing Interface

Viewing source IP selection policy status
Do one of the following:

• Use the following command to view the source IP selection policy status for the specified protocol.

show ip source-interface status
[ radius | sflow | sntp | tacacs | telnet | tftp | syslog ]

• Use the following command to view the source IP selection policy status for all protocols.

show ip source-interface status

The following example shows Source IP selection policy status for all application protocols

switch(config)# show ip source-interface status

 Source-IP Status Information

  Protocol | Admin Selection Policy  Oper Selection Policy
  -------- + ----------------------- ----------------------
  Tacacs   | Configured IP Interface Configured IP Interface
  Radius   | Configured IP Address   Configured IP Address
  Syslog   | Configured IP Interface Outgoing Interface
  Telnet   | Outgoing Interface      Outgoing Interface
  Tftp     | Outgoing Interface      Outgoing Interface
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  Sntp     | Outgoing Interface      Outgoing Interface
  Sflow    | Configured IP Address   Configured IP Address

Viewing full source IP details
The full source IP details for an application protocol include the source IP selection policy status, the source IP
address configuration, and the state of the source IP interface.

Do one of the following:

• Use the following command to view the full source IP details for the specified protocol.

show ip source-interface detail
[ radius | sflow | sntp | tacacs | telnet | tftp | syslog ]

• Use the following command to view the full source IP details for all protocols.

show ip source-interface detail

Examples

The following example shows detailed information displayed for the Tacacs application protocol.

switch(config)# show ip source-interface detail tacacs

 Source-IP Detailed Information

  Protocol : Tacacs
  Admin Policy           : Configured IP Interface
  Oper Policy            : Outgoing Interface
  Source IP Interface    : Vlan 22
  Source IP Address      : 10.10.10.4
  Source Interface State : Down
The following example shows detailed information displayed for each application protocol.

switch(config)# show ip source-interface detail

  Source-IP Detailed Information

   Protocol : Tacacs
   Admin Policy           : Configured IP Interface
   Oper Policy            : Configured IP Interface
   Source IP Interface    : vlan 22
   Source IP Address      : 10.10.10.4
   Source Interface State : Up

   Protocol : Radius
   Admin Policy           : Configured IP Address
   Oper Policy            : Configured IP Address
   Source IP Interface    : vlan 3
   Source IP Address      : 10.10.10.2
   Source Interface State : Up

   Protocol : Syslog
   Admin Policy           : Configured IP Interface
   Oper Policy            : Configured IP Interface
   Source IP Interface    : vlan 10
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   Source IP Address      : 10.10.10.10
   Source Interface State : Up

   Protocol : Telnet
   Admin Policy           : Configured IP Interface
   Oper Policy            : Configured IP Interface
   Source IP Interface    : loopback 1
   Source IP Address      : 10.10.10.11
   Source Interface State : Up

   Protocol : Tftp
   Admin Policy           : Outgoing Interface
   Oper Policy            : Outgoing Interface
   Source IP Interface    : N/A
   Source IP Address      : N/A
   Source Interface State : N/A

   Protocol : Sntp
   Admin Policy           : Outgoing Interface
   Oper Policy            : Outgoing Interface
   Source IP Interface    : N/A
   Source IP Address      : N/A
   Source Interface State : N/A

   Protocl : Sflow
   Admin Policy           : Outgoing Interface
   Oper Policy            : Outgoing Interface
   Source IP Interface    : N/A
   Source IP Address      : N/A
   Source Interface State : N/A

Viewing protocol configuration and status information
Use the following command to view configuration and status information for the specified application protocol. The
displayed information includes the operational source IP selection policy.

show [ radius | sflow | sntp | tacacs | telnet | tftp | syslog ]
Examples

The following example shows the details for the Radius application protocol

switch(config)# show radius

Status and Counters - General RADIUS Information

  Deadtime(min) : 0
  Timeout(secs) : 5
  Retransmit Attempts : 3
  Global Encryption Key :
  Dynamic Authorization UDP Port : 3799
  Source IP Selection : Configured IP address
The following example shows the details for the Telnet application protocol

switch(config)# show telnet

  Telnet Activity
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  Source IP Selection: 10.10.10.11

  -------------------------------------------------------
  Session  : **  1
  Privilege: Manager
  From     : Console
  To       : 
The following example shows details for the SNTP application protocol

switch(config)# show sntp

SNTP Configuration

SNTP Authentication : Disabled
Time Sync Mode: Timep
SNTP Mode : disabled
Poll Interval (sec) [720] : 720
Source IP Selection: Outgoing Interface

Configuration error messages
The following error messages may appear when configuring source IP selection if the interface does not exist, is
not configured for IP, or is down.

Error Message Description

Warning: Specified IP address is not configured
on any interface

The IP address specified has not been assigned to any
interface on the switch.

Warning: Specified IP interface is not configured The IP interface has not been configured.

Warning: Specified IP interface is not configured
for IP

An IP address has not been assigned to this interface.

Warning: Specified IP interface is down The interface on the switch associated with this IP address is
down.

Warning: Specified IP interface is configured for
DHCP

The IP address has not been configured specifically
(manually) for this interface and may change.

Overview of single source IP addresses for software applications
A single source IP address can be configured for the following software applications:

• RADIUS

• SFlow

• SNTP

• System Logging applications

• TACACS

• Telnet

• TFTP

144 Aruba Basic Operation Guide for ArubaOS-Switch 16.05

Anexo 02 ITEM 11 (0592659)         SEI 0008478-63.2018.6.02.8000 / pg. 5757



The above IP-based software applications use a client-server communication model, that is, the client’s source IP
address is used for unique client identification. The source IP address is determined by the system and is usually
the IP address of the outgoing interface in the routing table. However, routing switches may have multiple routing
interfaces due to load balancing or routing redundancy, and outgoing packets can potentially be sent by different
paths at different times. This results in different source IP addresses, which creates a client identification problem
on the server site. For example, there is no way to designate a fixed IP address for outgoing packets for RADIUS
or TACACS, so it is necessary to configure in the RADIUS or TACACS database all possible IP addresses that
are configured on the switch as valid clients. When using system logging, it can be difficult to interpret the logging
and accounting data on the server site as the same client can be logged with different IP addresses.

To decrease the amount of administrative work involved, a configuration model is provided that allows the
selection of an IP address to use as the source address for all outgoing traffic generated by a specified software
application on the switch. This allows unique identification of the software application on the server site regardless
of which local interface has been used to reach the destination server.

The source IP selection policy
The source IP address selection for the application protocols is defined through assignment of one of the
following policies:

• Outgoing Interface—the IP address of the outgoing IP interface is used as the source IP address. This is the
default policy and the default behavior of applications.

• Configured IP Address—the specific IP address that is used as the source IP address. This address is
configured on one of the switch’s IP interfaces, either a VLAN interface or a Loopback interface.

• Configured IP Interface—the IP address from the specific IP interface (VLAN or Loopback) is used as the
source IP address. If there are multiple IP addresses assigned (multinetting, for example), the lowest IP
address is used.

If the selection policy cannot be executed because the interface does not have an IP address configured, does
not exist, or is down, the application protocol uses the default Outgoing Interface policy. A warning message is
displayed, but the configuration changes are accepted. When using the show ip source-interface status
command to display information about the source IP address selection policy, the administratively-assigned
source IP selection policy and the actual (operational) source IP selection policy in effect are displayed.

The operational source IP selection policy may be different from the assigned source selection policy if the IP
interface does not exist or is down. In this case, the default of Outgoing Interface appears as the operational
policy, as shown in the following example.

The administratively-assigned source IP selection policy differing from the operational policy

switch(config)# show ip source-interface detail tacacs

 Source-IP Detailed Information

  Protocol : Tacacs
  Admin Policy           : Configured IP Interface
  Oper Policy            : Outgoing Interface
  Source IP Interface    : Vlan 22
  Source IP Address      : 10.10.10.4
  Source Interface State : Down
Below is an example of assigning a specific source IP address for a RADIUS application. The administrative
policy is Configured IP Address.
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A specific IP address assigned for the RADIUS application protocol

switch(config)# ip source-interface radius address 10.10.10.2

switch(config)# show ip source-interface radius

  Source-IP Configuration Information

  Protocol | Admin Selection Policy  IP Interface   IP Address
  -------- + ----------------------- -------------- --------------
  Radius   | Configured IP Address   vlan 3         10.10.10.2 
In the example below, a VLAN interface (VLAN 22) is specified as the source IP address for TACACS. The
administrative policy is Configured IP Interface.

Using a VLAN interface as the source IP address for TACACS

switch(config)# ip source-interface tacacs vlan 22

switch(config)# show ip source-interface tacacs

  Source-IP Configuration Information

   Protocol | Admin Selection Policy  IP Interface   IP Address
   -------- + ----------------------- -------------- --------------
   Tacacs   | Configured IP Interface vlan 22        10.10.10.4 
The next example shows a VLAN interface being specified as the source IP address for logging. The
administrative policy is Configured IP Interface.

Using a VLAN interface as the source IP Address for logging (Syslog)

switch(config)# ip source-interface syslog vlan 10

switch(config)# show ip source-interface syslog

  Source-IP Configuration Information

   Protocol | Admin Selection Policy  IP Interface   IP Address
   -------- + ----------------------- -------------- --------------
   Syslog   | Configured IP Interface vlan 10        10.10.10.10

IP configuration features
IP configuration features:

Feature Default

IP Address and Subnet Mask DHCP/Bootp

Multiple IP Addresses on a VLAN n/a

Default Gateway Address none

Packet Time-To-Live (TTL) 64 seconds

Table Continued
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Feature Default

Time Server (Timep)1 DHCP

Single Source IP Addressing outgoing IP address

1 For more on this topic, see the "Time Protocols" chapter in the latest Management and Configuration Guide.

IP address and subnet mask. Configuring the switch with an IP address expands your ability to manage the
switch and use its features. By default, the switch is configured to automatically receive IP addressing on the
default VLAN from a DHCP/Bootp server that has been configured correctly with information to support the
switch. (See DHCP/Bootp operation on page 150 for information on setting up automatic configuration from a
server.) However, if you are not using a DHCP/Bootp server to configure IP addressing, use the menu interface or
the CLI to manually configure the initial IP values. After you have network access to a device, you can use the
WebAgent to modify the initial IP configuration if needed.

For information on how IP addressing affects switch operation, See Effects of IP addressing on switch
operation on page 147.

Multinetting: assigning multiple IP addresses to a VLAN. For a given VLAN you can assign up to 32 IP
addresses. This allows you to combine two or more subnets on the same VLAN, which enables devices in the
combined subnets to communicate normally through the network without needing to reconfigure the IP addressing
in any of the combined subnets.

Default gateway operation. The default gateway is required when a router is needed for tasks such as reaching
off-subnet destinations or forwarding traffic across multiple VLANs. The gateway value is the IP address of the
next-hop gateway node for the switch, which is used if the requested destination address is not on a local subnet/
VLAN. If the switch does not have a manually-configured default gateway and DHCP/Bootp is configured on the
primary VLAN, then the default gateway value provided by the DHCP or Bootp server will be used. If the switch
has a manually configured default gateway, then the switch uses his gateway, even if a different gateway is
received via DHCP or Bootp on the primary VLAN. This is also true for manually configured TimeP, SNTP, and
Time-To-Live(TTL). (In the default configuration, VLAN 1 is the Primary VLAN.)

For more information on Primary VLANs, see the Advanced Traffic Management Guide.

For more information on TimeP and SNTP, see the “Time Protocols” chapter in the Management and
Configuration Guide.

Packet Time-To-Live (TTL). This parameter specifies the maximum number of routers (hops) through which a
packet can pass before being discarded. Each router decreases a packet’s TTL by 1 before forwarding the
packet. If decreasing the TTL causes the TTL to be 0, the router drops the packet instead of forwarding it. In most
cases, the default setting (64) is adequate.

Effects of IP addressing on switch operation
Without an IP address and subnet mask compatible with your network, the switch can be managed only through a
direct terminal device connection to the Console RS-232 port. You can use direct-connect console access to take
advantage of features that do not depend on IP addressing. However, to realize the full capabilities HPE proactive
networking offers through the switch, configure the switch with an IP address and subnet mask compatible with
your network. The following table lists the general features available with and without a network-compatible IP
address configured.
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Table 9: Features available with and without IP addressing on the switch

Features available without an IP Address Additional features available with an IP Address
and subnet mask

• Direct-connect access to the CLI and the menu
interface

• DHCP or Bootp support for automatic IP address
configuration, and DHCP support for automatic
Timep server IP address configuration

• Multiple Spanning Tree Protocol

• Port settings and port trunking

• Switch meshing

• Console-based status and counters information for
monitoring switch operation and diagnosing
problems through the CLI or menu interface

• VLANs and GVRP

• Serial downloads of software updates and
configuration files (Xmodem)

• Link test

• Port monitoring

• Password authentication

• Quality of Service (QoS)

• Authorized IP manager security

• WebAgent access, with configuration, security, and
diagnostic tools, plus the Alert Log for discovering
problems detected in the switch along with
suggested solutions

• SNMP network management access for network
configuration, monitoring, problem-finding, and
reporting, analysis, and recommendations for
changes to increase control and uptime

• TACACS+, RADIUS, SSH, SSL, and 802.1X
authentication

• Multinetting on VLANs

• Telnet access to the CLI or the menu interface

• IGMP

• TimeP and SNTP server configuration1

• TFTP download of configurations and software
updates

• Access Control Lists (ACLs)

• IP routing, Multicast Routing

• VRRP router redundancy

• PIM-DM and PIM-SM

• Radius

• Ping test

1 For more information on TimeP and SNTP, see the “Time Protocols” chapter in the Management and Configuration Guide.

Network preparations for configuring DHCP/Bootp
In its default configuration, the switch is configured for DHCP/Bootp operation. However, the DHCP/Bootp feature
will not acquire IP addressing for the switch unless the following tasks have already been completed:

• For Bootp operation

◦ A Bootp database record has already been entered into an appropriate Bootp server

◦ The necessary network connections are in place

◦ The Bootp server is accessible from the switch

• For DHCP operation
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◦ A DHCP scope has been configured on the appropriate DHCP server

◦ The necessary network connections are in place

◦ A DHCP server is accessible from the switch

Designating a primary VLAN other than the default VLAN affects the switch’s use of information
received via DHCP/Bootp. For more on this topic, See the describing VLANs in the Advanced Traffic
Management Guide for your switch.

After you reconfigure or reboot the switch with DHCP/Bootp enabled in a network providing DHCP/Bootp service,
the switch does the following:

• Receives an IP address and subnet mask and, if configured in the server, a gateway IP address and the
address of a Timep server.

• If the DHCP/Bootp reply provides information for downloading a configuration file, the switch uses TFTP to
download the file from the designated source, then reboots itself. (This assumes that the switch or VLAN has
connectivity to the TFTP file server specified in the reply, that the configuration file is correctly named, and that
the configuration file exists in the TFTP directory.)

Overview of IP Addressing
You can configure IP addressing through all the switch’s interfaces. You can also:

• Easily edit a switch configuration file to allow downloading the file to multiple switches without overwriting each
switch’s unique gateway and VLAN 1 IP addressing.

• Assign up to 32 IP addresses to a VLAN (multinetting).

• Select an IP address to use as the source address for all outgoing traffic generated by a specified software
application on the switch. This allows unique identification of the software application on the server site
regardless of which local interface has been used to reach the destination server.

Why configure IP addressing? In its factory default configuration, the switch operates as a multiport learning
bridge with network connectivity provided by the ports on the switch. However, to enable specific management
access and control through your network, you will need IP addressing. Effects of IP addressing on switch
operation on page 147 shows the switch features that depend on IP addressing to operate.

IP addressing with multiple VLANs
In the factory default configuration, the switch has one, permanent default VLAN (named DEFAULT_VLAN) that
includes all ports on the switch. Thus, when only the default VLAN exists in the switch, if you assign an IP
address and subnet mask to the switch, you are actually assigning the IP addressing to the DEFAULT_VLAN.
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• If multiple VLANs are configured, then each VLAN can have its own IP address. This is because
each VLAN operates as a separate broadcast domain and requires a unique IP address and
subnet mask. A default gateway (IP) address for the switch is optional, but recommended.

• In the factory default configuration, the default VLAN (named DEFAULT_VLAN) is the switch’s
primary VLAN. The switch uses the primary VLAN for learning the default gateway address. The
switch can also learn other settings from a DHCP or Bootp server, such as (packet) Time-To-Live
(TTL), and Timep or SNMP settings. (Other VLANs can also use DHCP or BootP to acquire IP
addressing. However, the switch’s gateway, TTL, and TimeP or SNTP values, which are applied
globally, and not per-VLAN, will be acquired through the primary VLAN only, unless manually set
by using the CLI, Menu, or WebAgent. (If these parameters are manually set, they will not be
overwritten by alternate values received from a DHCP or Bootp server.) For more on VLANs, see
the titled “Static Virtual LANs” in the Advanced Traffic Management Guide for your switch.

• The IP addressing used in the switch must be compatible with your network. That is, the IP
address must be unique and the subnet mask must be appropriate for your IP network.

• If you change the IP address through either Telnet access or the WebAgent, the connection to the
switch will be lost. You can reconnect by either restarting Telnet with the new IP address or
entering the new address as the URL in your web browser.

DHCP/Bootp operation
Overview. DHCP/Bootp is used to provide configuration data from a DHCP or Bootp server to the switch. This
data can be the IP address, subnet mask, default gateway, Timep Server address, and TFTP server address. If a
TFTP server address is provided, this allows the switch to TFTP a previously saved configuration file from the
TFTP server to the switch. With either DHCP or Bootp, the servers must be configured prior to the switch being
connected to the network.

The switches covered in this guide are compatible with both DHCP and Bootp servers.

The DHCP/Bootp process. Whenever the IP Config parameter in differences the switch or in an individual
VLAN in the switch is configured to DHCP/Bootp (the default), or when the switch is rebooted with this
configuration:

1. DHCP/Bootp requests are automatically broadcast on the local network. (The switch sends one type of request
to which either a DHCP or Bootp server can respond.)

2. When a DHCP or Bootp server receives the request, it replies with a previously configured IP address and
subnet mask for the switch. The switch also receives an IP Gateway address if the server has been configured
to provide one. In the case of Bootp, the server must first be configured with an entry that has the switch’s
MAC address. (To determine the switch’s MAC address, See Appendix D, “MAC Address Management”.) The
switch properly handles replies from either type of server. If multiple replies are returned, the switch tries to use
the first reply.)

If you manually configure default gateway, TTL, TimeP, and/or SNTP parameters on the switch, it
ignores any values received for the same parameters via DHCP or Bootp.

If the switch is initially configured for DHCP/Bootp operation (the default), or if it reboots with this configuration, it
begins sending request packets on the network. If the switch does not receive a reply to its DHCP/Bootp
requests, it continues to periodically send request packets, but with decreasing frequency. Thus, if a DHCP or
Bootp server is not available or accessible to the switch when DHCP/Bootp is first configured, the switch may not
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immediately receive the desired configuration. After verifying that the server has become accessible to the switch,
reboot the switch to restart the process immediately.

DHCP operation. A significant difference between a DHCP configuration and a Bootp configuration is that an IP
address assignment from a DHCP server is automatic. Depending on how the DHCP server is configured, the
switch may receive an IP address that is temporarily leased. Periodically the switch may be required to renew its
lease of the IP configuration. Thus, the IP addressing provided by the server may be different each time the
switch reboots or renews its configuration from the server. However, you can fix the address assignment for the
switch by doing either of the following:

• Configure the server to issue an “infinite” lease.

• Using the switch’s MAC address as an identifier, configure the server with a “Reservation” so that it will always
assign the same IP address to the switch. (For MAC address information, See Appendix D, “MAC Address
Management”.)

For more information on either of these procedures, See the documentation provided with the DHCP server.

Bootp operation. When a Bootp server receives a request, it searches its Bootp database for a record entry that
matches the MAC address in the Bootp request from the switch. If a match is found, the configuration data in the
associated database record is returned to the switch. For many Unix systems, the Bootp database is contained in
the /etc/bootptab file. In contrast to DHCP operation, Bootp configurations are always the same for a specific
receiving device. That is, the Bootp server replies to a request with a configuration previously stored in the server
and designated for the requesting device.

Bootp Database Record Entries. A minimal entry in the Bootp table file /etc/bootptab to update an IP
address and subnet mask to the switch or a VLAN configured in the switch would be similar to this entry:

8212switch:\
   ht=ether:\
   ha=0030c1123456:\
   ip=10.66.77.88:\
   sm=255.255.248.0:\
   gw=10.66.77.1:\
   hn:\
   vm=rfc1048
An entry in the Bootp table file /etc/bootptab to tell the switch or VLAN where to obtain a configuration file
download would be similar to this entry:

8212switch:\
    ht=ether:\
    ha=0030c1123456:\
    ip=10.66.77.88:\
    sm=255.255.248.0:\
    gw=10.66.77.1:\
    lg=10.22.33.44:\
    T144="switch.cfg":\
    vm=rfc1048
where:

8212swi
tch

is a user-defined symbolic name to help you find the correct section of the bootptab file. If you have
multiple switches that will be using Bootp to get their IP configuration, you must use a unique symbolic
name for each switch.

ht is the "hardware type". For the switches covered in this guide, enter ether (for Ethernet). This tag
must precede the ha tag.

Table Continued
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ha is the "hardware address". Use the switch's (or VLAN's) 12-digit MAC address.

ip is the IP address to be assigned to the switch (or VLAN).

sm is the subnet mask of the subnet in which the switch (or VLAN) is installed.

gw is the IP address of the default gateway.

lg TFTP server address (source of final configuration file)

T144 is the vendor-specific "tag" identifying the configuration file to download.

vm is a required entry that specifies the Bootp report format. Use rfc1048 for the switches covered in
this guide.

The above Bootp table entry is a sample that will work for the switch when the appropriate addresses
and file names are used.

152 Aruba Basic Operation Guide for ArubaOS-Switch 16.05

Anexo 02 ITEM 11 (0592659)         SEI 0008478-63.2018.6.02.8000 / pg. 5765



Viewing or downloading the software manual set
Procedure

Go to the Networking website http://www.hpe.com/networking/support to view or download product
documentation.

Updating the switch software to a new version

Updating the switch software
Process overview:

Procedure

1. Go to the Networking website (http://www.hpe.com/networking/support) to download the new switch
software file.

HPE periodically provides switch software updates through the Networking website. Check the website
frequently for the latest software version available for your switch.

2. Review the Best practices, recommendations, and precautions on page 158.

3. Backup your configuration, as specified in Backing up your current configuration and image on page 154.

4. Do one of the following to download and install the new switch software:

a. For a TFTP transfer from a server, do either of the following:

• Select Download OS in the Main Menu of the switch’s menu interface and use the (default) TFTP
option. For more information about using the switch’s menu interface, see Using the Menu Interface on
page 16.

• In the switch’s CLI, complete the Downloading and installing software from a TFTP server on page
155 task. Use the copy tftp command in the switch’s CLI (see below).

b. For an Xmodem transfer from a PC or Unix workstation, do either of the following:

• Select Download OS in the Main Menu of the switch’s menu interface and select the XMODEM option.
For more information about using the switch’s menu interface, see Using the Menu Interface on page
16.

• In the switch’s CLI, complete the Downloading and installing software from a PC or Unix
workstation on page 156 task.

c. For a transfer from a USB flash drive: In the switch’s CLI, complete the
Downloading and installing software from a USB flash drive on page 157task.

Chapter 10
Managing switch software
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Downloading new software does not change the current switch configuration. The switch
configuration is contained in a separate file that can also be transferred, for example, to archive or to
be used in another switch of the same model.

Backing up your current configuration and image

Procedure

1. Save your current configuration (Config1) to backup configuration file (Config2).

a. Before copying the config, verify the current state of your system using the show version, show flash and
show config files commands. For example:

Switch1# show version
Image stamp:   /sw/code/build/btm(t4a)
               Nov 6 2009 13:20:26
               K.14.47
               188
Boot Image:    Primary

Switch1# show flash
Image           Size(Bytes)   Date    Version
------          -----------  -------  -------
Primary Image   : 9839140    11/06/09 K.14.47
Secondary Image : 0
Boot Rom Version: K.12.20
Default Boot    : Primary

Switch1# show config files

Configuration files:

 id | act pri sec | name
 ---+-------------+-----------------------------
  1 | *    *   *  | config1
  2 |             | 
  3 |             | 

b. Create a backup configuration file and verify the change.

Switch1# copy config config1 config config2
Switch1# show config files

Configuration files:

 id | act pri sec | name
 ---+-------------+-----------------------------
  1 | *    *   *  | config1
  2 |             | config2
  3 |             | 

2. Save the current config to a tftp server using the copy tftp command. For example:

Switch1# copy startup-config tftp 10.1.1.60
Switch1_config_K_14_47.cfg

This step is necessary because switches do not support roll back (going from a newer software
version to an older software version) without the ability to copy a backup config file onto the
device.
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3. Back up your current running image (primary) to the secondary image.

Switch1# copy flash flash secondary

Switch1# show flash
Image           Size(Bytes)   Date    Version
------          -----------  -------  -------
Primary Image   :  9839140   11/06/09 K.14.47
Secondary Image :  9839140   11/06/09 K.14.47
Boot Rom Version: K.12.20
Default Boot    : Primary
 

4. Set your secondary image to boot with Config2.

Switch1# startup-default secondary config config2 

Switch1# show config files

Configuration files:

 id | act pri sec | name
 ---+-------------+-----------------------------
  1 | *    *      | config1
  2 |          *  | config2
  3 |             | 
This step will enable you to revert from the new software version to your previous software version (K.14.47 in
the examples shown in steps 1 through 3) with your previous configuration just by invoking the command boot
system flash secondary.

Downloading and installing software from a TFTP server

Procedure

1. Use the following command, specifying the filename and the primary or secondary flash destination:

copy tftp flash <ip-address> <remote-os-file> [ primary | secondary ]
Note that if you do not specify the flash destination, the TFTP download defaults to the primary flash.

For example, to download a software file named K_15_10_0001.swi from a TFTP server with the IP address of
10.28.227.103 to the primary flash destination, execute the copy command as shown below:

switch# copy tftp flash 10.28.227.103 K_15_10_0001.swi
The primary OS image will be deleted. continue
continue[y/n]? Y
03125K

2. When the switch finishes downloading the software file from the server, it displays the progress message

Validating and Writing System Software to FLASH...
3. When the CLI prompt reappears, the switch is ready to reboot to activate the downloaded software:

a. Use the show flash command to verify that the new software version is in the expected flash area (primary
or secondary).

b. Reboot the switch from the flash area (primary or secondary) that holds the new software, using the
following command:

boot system flash [ primary | secondary ]
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After the switch reboots, it displays the CLI or Main Menu, depending on the Logon Default setting last
configured in the menu’s Switch Setup screen.

4. Verify the software version by displaying the system information for the switch (for example, through the show
system-information command), and viewing the Software revision field.

Downloading and installing software from a PC or Unix workstation
Downloading and installing software from a PC or Unix workstation

To download software from a PC or Unix workstation:

Prerequisites

Before you download and install software from a PC or Unix workstation, insure that:

• The switch is connected via the Console RS-232 port to a PC operating as a terminal. (See your switch
Installation and Getting Started Guide for information on connecting a PC as a terminal and running the switch
console interface.)

• The switch software is stored on a disk drive in the PC.

• The terminal emulator you are using includes the Xmodem binary transfer feature. (For example, in the
HyperTerminal application included with most Windows systems, the Send File option in the Transfer drop-
down menu supports the Xmodem protocol.)

Procedure

1. To reduce the download time, you may want to increase the baud rate in your terminal emulator and in the
switch to a value such as 115,200 bits per second. (The baud rate must be the same in both devices.) For
example, to change the baud rate in the switch to 115200, execute this command:

switch(config)# console baud-rate 115200
(If you use this option, be sure to set your terminal emulator to the same baud rate.)

Changing the console baud-rate requires saving to the Startup Config with the write memory command.
Alternatively, you can log out of the switch and change your terminal emulator speed and allow the switch to
Auto-Detect your new higher baud rate (that is, 115,200 bps)

2. Use the following CLI command, specifying the primary or secondary flash destination:

copy xmodem flash [ primary | secondary ]
For example, the following command specifies the primary flash destination:

switch# copy xmodem flash primary
The primary OS image will be deleted. continue [y/n]? Y
Press ‘Enter’ and start XMODEM on your host...

3. Execute the terminal emulator commands to begin the Xmodem transfer. For example, using HyperTerminal:

a. Click Transfer, then Send File.

b. Type the file path and name in the Filename field.

c. In the Protocol field, select Xmodem.

d. Click Send button.

The download can take several minutes, depending on the baud rate used in the transfer.
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4. If you increased the baud rate on the switch (1), use the same command to return it to its previous setting. (A
baud rate of 9600 bits per second is recommended for most applications.) Remember to return your terminal
emulator to the same baud rate as the switch.

5. Use the show flash command to verify that the new software version is in the expected flash area (primary or
secondary).

6. Reboot the switch from the flash area (primary or secondary) that holds the new software, using the following
command:

boot system flash [ primary | secondary ]
After the switch reboots, it displays the CLI or Main Menu, depending on the Logon Default setting last
configured in the menu’s Switch Setup screen.

Downloading and installing software from a USB flash drive
Downloading and installing software from a USB flash drive

To download software from a USB flash drive:

Prerequisites

Before you download and install software from a USB flash drive, insure that:

• The software version is stored on the USB flash drive and you know the file name (such as
K_15_10_0001.swi).

• The USB flash drive is properly installed in the USB port on the switch.

• The USB flash drive is supported. Some USB flash drives may not be supported on your switch. For
information on USB device compatibility, see the networking support (http://www.hpe.com/networking/
support).

Procedure

1. Use the following CLI command, specifying the filename and the primary or secondary flash destination:

copy usb flash <filename> [ primary | secondary ]
For example, to download a software file named K_15_10_0001.swi from a USB flash drive to the secondary
flash destination, execute the command as shown below:

switch# copy usb flash K_15_10_0001.swi secondary
The secondary OS image will be deleted. continue
[y/n]? Y
03125K

2. When the switch finishes downloading the software file from the server, it displays the progress message:

Validating and Writing System Software to FLASH...
3. When the CLI prompt reappears, the switch is ready to reboot to activate the downloaded software:

a. Use the show flash command to verify that the new software version is in the expected flash area (primary
or secondary).

b. Reboot the switch from the flash area (primary or secondary) that holds the new software, using the
following command:

boot system flash [ primary | secondary ]
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After the switch reboots, it displays the CLI or Main Menu, depending on the Logon Default setting last
configured in the menu’s Switch Setup screen.

4. Verify the software version by displaying the system information for the switch (for example, through the show
system-information command), and viewing the Software revision field.

Best practices, recommendations, and precautions
Best practices for software updates

There is a slight change in the versioning system.

Software updates that contain significant new features and enhancements may be designated by an increment to
both the major and minor release version numbers. That is, K.15.01.0031 represents a major update to software
version(s) K.14.xx, and K.14.xx represents a major update to K.13.xx, and so forth. In addition, a future version
(such as K.15.02.xxxx) may represent a minor release to version K.15.01.xxxx, but may still contain significant
changes. To mitigate against potential migration issues when performing such updates, this section documents
best practices for updating the switch, including contingency procedures for rolling back to previous software
versions and saved configurations.

Recommendations and precautions for software updates

Before you update the switch software to a new version:

• We strongly recommend that you save a copy of your config file to an external location.

• We advise against rolling back (going from a newer software version to an older software version) without
copying a backup config file to the device.

If you do choose to downgrade software using your existing config file, unpredictable changes in the config file
and switch behavior may occur. If booting a K.15.01.0031 or later config file into a K.14.xx or earlier versions of
software, the following commands may be removed from your config file:

• Any commands that are present in K.15.01.0031 (or later) but are not present in earlier versions of software

• logging

• snmp-server

• mirror-session

• auto-tftp

• filter source-port

• fault-finder

• interface loopback

After following these steps, you end up with the following results:

• Primary image will hold the new software image you want to install

• Secondary image will hold the image you are currently running

• Primary image will boot with Config1 (config file corresponding to new software version)

• Secondary image will boot with Config2* (config file corresponding to previous software version)
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* The current config file must be copied to Config2, or you will be unable to revert if the need arises.

You might opt to use a different methodology in which the new software will be installed as the
secondary and not the primary image, in which case you would use the commands boot system
flash secondary, and/or boot set-default flash secondary to change the location of the default
boot. However, since you will still need to take precautions to allow you to revert to your previous
configuration. We strongly recommend that you follow the methods that are proposed in our update
process. This will ensure that you can use our proposed rollback procedures if the need arise.

Validating switch software

Validating a software image
A software is valid if it has a valid digital signature, which is generated by HPE Code Signing Service (HPECSS).
Switches that support digital signature verification will generate an error message if you attempt to download an
image that is not digitally signed.

• To manually verify the software’s digital signature when the switch does not support digital signature
verification, use the following command:

verify signature flash {primary|secondary}
If the signature is valid, the following message is displayed:

Signature is valid.

• To bypass signature verification, use the allow-no-signatureoption in the copycommand as follows:

copy {tftp|sftp|usb|xmodem} flash [<hostname/IP>]
[<filename>] {primary|secondary} allow-no-signatures

Theallow-no-signature option is available on switches that support non-signed legacy software releases and
must be used with caution. To determine support for your switch, go to: http://www.hpe.com/networking/
swvalidation.

Software signing and verification
As an enhanced security feature, you can verify whether a software image being downloaded to or stored in your
switch has, in fact, been provided by Networking without any modification or corruption.

Validation is based on the image signature that is generated and attached to the switch software by HPE Code
Signing Service (HPECSS). Networking implemented digital signature validation starting with specific switch
software versions. For a list of these software versions, go to: http://www.hpe.com/networking/swvalidation.

Once a switch software image has been digitally signed on a specific version, all later versions will
also be signed.

Switches supporting digital signature verification will generate an error message if you attempt to download an
image that is not digitally signed. For example, using the CLI commands described above to revert back to an
image that is not signed from an image that is signed and supports verification would result in the following
message:

This software image does
not contain a digital signature and
cannot be validated as originating
from HP. You may bypass this
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validation by using the
'allow no-signature’ option. Please
see www.hp.com/networking/swvalidation
for information about which versions
of software contain digital signatures.
When you use the copy command to download a properly signed image, the CLI logs the following syslog
message:

Update: Firmware image contains valid signature.
Errors related to signature validation will generate one of the following log messages:

Update: Aborted. Downloaded file invalid.
Update: Aborted. Firmware image does not contain a signature. 
Update: Aborted. Firmware image signature is not valid.

Rolling back switch software
If you are downgrading to a software version that supports long user names and passwords, ignore the
prerequisite. Software versions K.15.01.0032 and later support the longer user names and passwords

Prerequisite

Before downgrading to a software version that does not support long user names and passwords from a software
version that supports them, complete one of the following tasks.

• Use the passwordCLI command or the Web browser interface, change usernames or passwords to be no
more than 16 characters in length, and without any special characters. Then execute a CLI write
memorycommand (required if the include-credentialsfeature has ever been enabled).

• Clear the values using the no password all CLI command. Then execute a CLI, write memorycommand
(required if the include-credentialsfeature has ever been enabled).

• Clear password values by using the "Clear" button on the switch. Then execute a CLI, write
memorycommand (required if the include-credentialsfeature has ever been enabled).

Rolling back switch software

To roll back your switch from K.15.01.0031 to K.14.47, for example, follow the steps below:

1. Verify that your images and configuration are set correctly using the show version, show flash and show
config files commands.

Switch1# show version
Image stamp:   /sw/code/build/btm(t5a)
               Apr 23 2010 05:43:42
               K.15.01.0031
               67
Boot Image:    Primary

Switch1# show flash
Image           Size(Bytes)   Date    Version
------          -----------  -------  -------
Primary Image   : 11537788   04/23/10 K.15.01.0031
Secondary Image :  9839140   11/06/09 K.14.47
Boot Rom Version: K.15.09
Default Boot    : Primary

Switch1# show config files
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Configuration files:

 id | act pri sec | name
 ---+-------------+-----------------------------
  1 | *    *      | config1
  2 |          *  | config2
  3 |             | 

2. Boot the switch using the secondary image (with config2).

Switch1# boot system flash secondary
System will be rebooted from secondary image. Do
you want to continue [y/n]? y
Enter ‘y’ for yes, and the switch will boot from the secondary image (K.14.47, in this example) with the
corresponding configuration for that software version (Config2).

Managing scheduled jobs

Schedule a job to run automatically
A job, that is command, can be scheduled to run on a recurring basis or after certain events. Use the following
command to schedule a job:

job <name> at
job <Name> at [HH:]MM [on [MM/]DD] [config-save] <Command-str>
job <Name> at <Event> [config-save] <Command-str>
job

Schedule a command to run automatically in the future.

Name

The name of the job to add or delete.

at

Schedule when the job runs.

reboot

Run the job as soon as possible after every switch boot.

[HH:]MM

The time when the job has to run.

on

Schedule the job to run on specified days.

MM/DD

The date when the job has to run.

<31-1>

The day relative to the end of the month when the job has to run.

<1-31>

The day of the month when the job has to run.
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WEEKDAY-LIST

The days of the week when the job has to run.

config-save

Save configuration changes made by the job.

Command-str

The command to execute when this job runs.

This command uses a new “weekday list” token type. A weekday list represents one or more days of
the week and is stored internally. It allows users to specify a list of individual days or a range of days
and use abbreviations. Examples of this weekday list are:

• Monday, Friday

• Mon-Wed

• mo,we-fr,su

Examples

The following example shows a pair of jobs that disable PoE during non-working hours
Switch(config)# job poe-on at 8:00 on mon-fri config-save "interface 1-24 power-over-ethernet"
Switch(config)# job poe-off at 17:00 on mon-fri config-save "no interface 1-24 power-over-ethernet"

The following example shows a job that block access to a server during weekends
Switch(config)# ip access-list extended block-server
Switch(config-ext-nacl)# deny ip any host 10.0.1.80
Switch(config-ext-nacl)# permit ip any any
Switch(config-ext-nacl)# exit
Switch(config)# job allow at 8:00 on mon config-save "no interface 1-24 ip access-group block-server in"
Switch(config)# job deny at 17:00 on fri config-save " interface 1-24 ip access-group block-server in"

The following example shows a job that blinks the Chassis Locate LED when the switch reboots

Switch(config)# job reboot-led at reboot "chassislocate blink"
The following example shows a job that reboots the switch on the first day of each year

Switch(config)# job annual-reboot at 2:00 on 1/1 boot

Deleting a scheduled job
Use the command no job <name> to delete a scheduled job. The name argument specifies the job to be
deleted.

Delete a scheduled job named “baz”

switch# show job

Job Scheduler Status and Configuration
Scheduler Status : Waiting for the system time to be set

                       Event or     Save 
Name                   Time         Cfg    Command
-------------------- ------------- ----   -------------------------------------
Burrrrrrrrrrrrrrr... reboot        Yes  chassislocate blink
baz                  reboot        No   show time 
foo                  17:00 SxTWTxS No   savepower led
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switch# no job baz

Viewing scheduled jobs
Do one of the following:

• Use the command show job <Name> to view details of a specific scheduled job.

• Use the command show job to view a list of all the scheduled jobs.

Names and commands that are longer than their column width are truncated with an ellipsis in the display. To
assist administrators in diagnosing problems with jobs, there is a detail view for a single job. If the last job run
produced any output, the first 255 characters of that output will be shown from the last job run whether that job
was successful or not. A successful run will overwrite the error output from a previous failed run.

Examples

The following example displays the list of the scheduled jobs

switch# show job

Job Scheduler Status and Configuration
Scheduler Status : Waiting for the system time to be set

                       Event or     Save 
Name                   Time         Cfg    Command
-------------------- ------------- ----   -------------------------------------
Burrrrrrrrrrrrrrr... reboot        Yes  chassislocate blink
baz                  reboot        No   show time 
foo                  17:00 SxTWTxS No   savepower led
The following example displays the details of a specific scheduled job

switch# show job baz

Job Information
Job Name    : baz
Runs At     : reboot
Config Save : No
Run Count   : 1
Error Count : 0
Command     : show time
Output from Last Run
--------------------
Mon Jan  1 00:00:44 1990

Time adjustments and scheduling jobs
Daylight savings time adjustments

When daylight savings time (DST) begins (“spring forward”), the local time jumps from 0200 to 0300. The Job
Scheduler “catches up” by running all jobs scheduled between 0200 and 0300 the next time it wakes up. This
prevents jobs from being skipped when they appear in the 0200 to 0300 time frame.
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When daylight savings time (DST) ends (“fall back”), the local time jumps from 0200 to 0100. The Job Scheduler
skips all jobs scheduled between 0100 and 0200 to allow local time to catch up. Those jobs already ran once
before DST ended will not repeat.

If an administrator configures a new job during the repeat of the 0100 to 0200 hour on the day DST
ends, the new job will not be run because the Job Scheduler skips that hour.

External adjustments

External adjustments to the system time can happen to correct for clock drift or for other administrative reasons.
The new time update can come from SNTP, from a configuration command at the CLI, or from an SNMP SET of
the system time MIB object. When a time adjustment takes place, the Job Scheduler task is called with the new
clock value. Jobs scheduled during a time clock jump forward are run while any jobs scheduled during a time
clock jump back are skipped.

Adjustment of more than 10 minutes are considered a major change and reset the Job Scheduler. Any jobs
scheduled during a time clock jump forward are skipped while any jobs scheduled during a time clock jump back
are repeated.

Calendar conflicts

Because the Job Scheduler MIB is more flexible than the CLI scheduling grammar, it is possible to create job
schedules via SNMP that cannot be displayed by the CLI. The following rules are imposed on MIB values to limit
them to what the CLI can display.

• If any bits are set in hpicfJobSchedulerEvent, all Calendar values are ignored. They may be set with SNMP,
but are ignored when looking for jobs to run. The Calendar values are also ignored by the command show
running-config.

• If any bit is set in CalendarDayOfWeek, then CalendarMonth and CalendarDayOfMonth are ignored.

• If no bits are set in CalendarDayOfWeek or CalendarDayOfMonth, then CalendarMonth is ignored.

• Only 1 bit may be set in the CalendarMonth, CalendarDayOfMonth, CalendarHour, and CalendarMinute
objects. Attempting to set a value with more than 1 bit returns an InconsistentValue error.

• If no bits are set in CalendarHour and CalendarMinute, the job is considered to be in a transition state and not
valid. This could happen when an SNMP management application is creating a job one object at a time. Jobs
in this state are ignored by the scheduler and by the command show running-config.

The Job Scheduler
The Job Scheduler provides administrators the ability to schedule recurring commands or “jobs” on their switch. A
feature of the Job Scheduler is the ability to schedule a command to run on a recurring basis or after certain
events. For example, a command can be triggered to run by certain predefined events such as switch reboot.

There is no prompt for user input with this feature. Administrators using this feature can schedule commands such
as enabling or disabling ports, turning on or off LEDs and Power-Over-Ethernet commands. All commands run
with manager privilege in configuration context.

Jobs that are scheduled can be viewed or deleted.

Alternate configuration files
An alternate configuration that is saved to the switch is viewed or copied through the software currently running
on the switch. This may result in a misleading portrayal of the configuration. For example, if a configuration is
created on K.14.47 and saved as config2, and if it is then viewed or transferred while the switch is running K.
15.01.0031, it will appear as though K.15.01.0031 has converted the configuration. However, the alternate
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configuration file, config2, will still be intact on the switch and load properly when the switch is booted into the
same software version from which the configuration file originated.

When an enhancement introduces a feature that did not previously exist in the switch, it may present several
challenges to the user.

Backwards compatibility of the configuration created with a version of software that supports a new feature or
parameter is not guaranteed. Software versions that did not recognize or support a particular command or
parameter will not be able to interpret that line in the configuration. For this reason, it is strongly recommended
that network administrators always save their configuration while still running the switch with the original
software version, and with a notation indicating the software version on which the configuration was saved. For
example, a user might save a configuration for a switch running K.14.47 to a TFTP server with an IP address of
10.10.10.15 as follows:

switch-onK1447# copy running-config tftp
10.10.10.15 5406onK1447
If, for example, the user deems it necessary to revert to the use of K.14.47, the user can boot into it and then
restore the saved config from the TFTP server.

Viewing or copying an alternate configuration that is saved to the switch flash can be accomplished only with the
software that is currently running on the switch.

Here, for example, a configuration is created on K.14.47 and then saved to flash:

switch-onK1447# copy config config2 config
K1447config <cr>
And later, the configuration that was created on K.14.47 is viewed while the switch is running K.15.01.0031:

switch-onK1501# show config K1447config <cr>
The command output will show how the K.14.47 config would be interpreted if it were to be used by the K.
15.01.0031 software. Copying the K1447config file to a TFTP server would similarly trigger an interpretation by
the software performing the file transfer. Note, however, that this does not actually change the configuration. If the
version is rolled back from K.15.01.0031 to K.14.47 with a command like the following (given that K.14.47 is
stored in secondary flash), the K.14.xx formatted config is still intact and valid.

switch# boot system flash secondary config
K1447config
This "interpretation" during a TFTP or show command execution is inherent in the architecture of the switch.
When switch features change significantly (such as the move from IPv4 support to IPv6 support), there may be
configuration parameters from the previous config that cannot be translated by the switch for viewing while it is
running the new software. This necessitates storing configurations for each version of software to an external
location, if the user would like to view the stored config prior to reloading it.
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Switches provide a way to automatically adjust the system clock for Daylight Saving Time (DST) changes. To use
this feature, define the month and date to begin and to end the change from standard time. In addition to the
value "none" (no time changes), there are five predefined settings named:

• Alaska

• Canada and Continental US

• Middle Europe and Portugal

• Southern Hemisphere

• Western Europe

The predefined settings follow these rules:

Alaska:

• Begin DST at 2 am on the second Sunday in March.

• End DST at 2 am on the first Sunday in November.

Canada and Continental US:

• Begin DST at 2 am on the second Sunday in March.

• End DST at 2 am on the first Sunday in November.

Middle Europe and Portugal:

• Begin DST at 2 am the first Sunday on or after March 25th.

• End DST at 2 am the first Sunday on or after September 24th.

Southern Hemisphere:

• Begin DST at 2 am the first Sunday on or after October 25th.

• End DST at 2 am the first Sunday on or after March 1st.

Western Europe:

• Begin DST at 2 am the first Sunday on or after March 23rd.

• End DST at 2 am the first Sunday on or after October 23rd.

Chapter 11
Daylight Saving Time
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A sixth option named "User defined" allows you to customize the DST configuration by entering the beginning
month and date plus the ending month and date for the time change. The menu interface screen looks like the
following: (all month/date entries are at their default values):

Figure 53: Menu interface with "user-defined" daylight time rule option

Before configuring a "User defined" daylight time rule, it is important to understand how the switch treats the
entries. Given the "Beginning day" and "Ending day", based on an algorithm from Sunday, the switch determines
the date to change the system clock :

• If the configured day is a Sunday, the time changes at 2 am on that day.

• If the configured day is not a Sunday, the time changes at 2 am on the first Sunday after the configured day.

This is true for both the "Beginning day" and the "Ending day."

With that algorithm, you can use the value "1" to represent "first Sunday of the month," and a value equal to
"number of days in the month minus 6" to represent "last Sunday of the month." This allows a single configuration
for every year, no matter what date is the appropriate Sunday to change the clock.

Chapter 11 Daylight Saving Time 167

Anexo 02 ITEM 11 (0592659)         SEI 0008478-63.2018.6.02.8000 / pg. 5780



Configuring the module power-saving option
Do one of the following:

• Use the command savepower module <slot-list> to turn off power for the modules in the specified
slots.

• Use the command savepower module all to turn off power for all the modules.

The following example shows how to turn off power for the module in slot "c".

If a savepower module <slot-list> or a savepower module all command is immediately
followed by a no savepower module <slot-list> or a no savepower module all
command, the first slot in the list is powered down and then brought up.

Configuring the LED power-saving option
Do one of the following:

• Use the following command to turn off the chassis LEDs for the specified slots.

savepower led <slot-list>
[timer [MM/DD[/[YY]YY] HH:MM|now|duration [HH:MM[recur]]]

• Use the following command to turn off all the chassis LEDs.

savepower led all
[timer [MM/DD[/[YY]YY] HH:MM|now|duration [HH:MM[recur]]]

Each of these commands includes a timer option. When the timer is configured, the LEDs are turned off for the
specified time period and duration. There is one system-wide timer.

Chapter 12
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The following example shows how to turn off LEDs beginning on 6/1 at 12:01 for 12 hours and repeat daily

Configuring the slot low-power option
Do one of the following:

• Use the command savepower port-low-pwr <slot-list> to put the specified slots into low-power
mode.

• Use the command savepower port-low-pwr all to put the all the slots into low-power mode.

Slots will go into lower-power mode only if they are not linked. The slots that have the low-power option
configured periodically monitor connections to determine if the link has become active. If a LAN cable is
connected to one of the slots, that slot will come out of the low-power mode state after approximately two seconds
(the monitoring period) and enter into normal power mode. The remaining slots continue to be in low-power mode.

The following example shows how to put slot "c" into low-power mode.
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Disabling power-saving options
Do one of the following to disable the power-saving option for modules. A module is powered on when its power-
saving option is disabled.

• Use the command no savepower module <slot-list> to disable the power-saving option for the
modules in the specified slots.

• Use the command no savepower module all to disable the power-saving option for all the modules.

Do one of the following to disable the power-saving option on chassis LEDs. An LED returns to its original state
and any scheduled or running timer is canceled when the power-saving option is disabled on the LED.

• Use the command no savepower led <slot-list> to disable the power-saving option on the chassis
LEDs for the specified slots.

• Use the command no savepower led all to disable the power-saving option on all the chassis LEDs.

Do one of the following to disable the low-power mode for slots. A slot returns to normal power mode when its
low-power mode is disabled.

• Use the command no savepower port-low-pwr <slot-list> to disable the low-power mode for the
specified slots.

• Use the command no savepower port-low-pwr all to disable the low-power mode for all the slots.

Enabling energy-efficient-ethernet (EEE)
Prerequisites

Before you enable energy-efficient-ethernet (EEE), you must insure that both sides of the link are EEE-capable to
support the power-saving idle mode.

Energy-efficient-ethernet follows the 802.3az standard, which provides support for a system to operate in low-
power idle mode during low-link use.

Enabling energy-efficient-ethernet (EEE)

To enable EEE on the specified port or a range of ports, use the following command:
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int <port-list> energy-efficient-ethernet

Enable EEE on ports B5 through B7

Enabling advertisement of EEE TLVs
The layer 2 (data link layer) Energy-efficient-ethernet (EEE) capability is a feature that allows ports to negotiate
the best optimizations for energy efficiency.Use the following command to enable the advertisement of Layer 2
EEE TLVs for a specified port or a range of ports.

lldp config <port-list> dot3TlvEnable eee_config
The following example shows how to enable the advertisement of Layer 2 EEE TLV for port B5.
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Disabling EEE or advertisement of EEE TLV
To disable enable Energy-efficient-ethernet(EEE) on the specified port or a range of ports, use the following
command:

no int <port-list> energy-efficient-ethernet
To disable the advertisement of Layer 2 EEE TLVs for a specified port or a range of ports, use the following
command:

no lldp config <port-list> dot3TlvEnable eee_config

Hibernate mode

hibernate
Syntax
hibernate <seconds>

Description

Hibernate the system. This command saves the current configuration and powers off the system for the specified
period. When the hibernation period expires, the switch will power up and boot using the normal boot process. A
typical use case is to have the job scheduler execute the hibernate command. For example, put the switch into
hibernate mode from midnight until 5 a.m.
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During hibernation, the system will not respond to any network traffic and the console will be inaccessible. The
only way to reboot the switch before the hibernation period expires is to press the Mode button on the front panel
or cycle power, thus disabling the hibernate job and timer.

The system prompts for y or n confirmation before putting the system into hibernate mode.

This feature is available on the 2930M and only in standalone. It is disabled for stacks.

Command context

Manager

Parameters
<seconds>

Specifies the length of time, in seconds, that the system will remain in hibernate mode. Duration: 0 to
2147483647 seconds.

Example

Hibernate the switch for 8 minutes.

switch# hibernate 480

This command will save the current configuration and then power off the
system for the specified period. During that time the system will not
respond to any network traffic and the console will be inaccessible. The
only way to reboot the switch before the hibernation period expires will
be to press the Mode button on the front panel or cycle power.

Continue(y/n)?

Viewing settings for power-saving and energy efficiency
Various versions of the show command are used to display current settings for power-saving options, Energy-
efficient-ethernet (EEE), and EEE TLV.

Do one of the following to view settings:

• Use the command show savepower module to view the current settings for the module power-saving
option.

• Use the command show savepower led to view the current settings for the LED power-saving option.

• Use the command show savepower port-low-pwr to view the current settings for the slot low-power
option.

• Use the command show energy-efficient-ethernet to view the current settings for Energy-efficient-
ethernet (EEE).

• Use the command show lldp info local-device <port-list> to view the current settings for EEE
TLV on the specified local ports.

• Use the command show lldp info remote-device <port-list> to view the current settings for EEE
TLV on the link partner of the specified port.

Display of the current settings for EEE TLV on the link partner of port B6
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Display of the current settings for EEE TLV on the local port B5

Display of the current settings for the slot low-power option

Display of the current settings for the LED power-saving option
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Display of the current settings for the module power-saving option

Displayed values for Energy-efficient-ethernet (EEE)
The displayed values for the energy efficient Energy-efficient-ethernet (EEE) status are explained in the following
table.

Parameter Description

EEE Config The EEE configuration status, read from the
configuration database.

Enabled
EEE mode is enabled.

Disabled
EEE mode is disabled.

Current Status Current EEE operational status.

Active
The port is advertised and auto-negotiated EEE with
link partner (an EEE-capable partner.) EEE mode is
enabled.

Table Continued
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Parameter Description

Inactive
Set to one of the following conditions:

• EEE configuration is disabled on the local port.

• Local port advertises EEE capabilities with "EEE
disabled" link partner or non-EEE link partner.

• Auto-negotiation is mandatory for EEE to work. EEE
configuration will not be applied if the port is in
forced/manual (speed-duplex) mode. The current
status will be ‘inactive" for forced/manual mode port
configuration.

• EEE is not supported for 10Base-T. The current
status will be ‘inactive' if the link is operating in
10Base-T mode.

Unsupported
The local physical interface does not have EEE
capability.

txWake Current value of transmit wake-up time (in
microseconds.)

The interface modules do not support adjustment of both transmit and receive wake-up times.
Therefore, txWake is constant.

Power-saving features supported by modules
The modules support the power-saving features as indicated in the table below:

Product number Description LED power on/off Slot auto low-
power mode

Slot power on/off

J8702A Switch zl 24
10/100/1000 PoE
Module

Yes Yes Yes

J8705A Switch zl 20 Gig-T
+ 4 mGBIC Module

Yes Yes Yes

J8706A Switch zl 24-Port
Mini-GBIC Module

Yes No Yes

J8707A Switch zl 4-Port
10GbE X2 Module

Yes No Yes

J8708A Switch zl 4-Port
10GbE CX4 Module

Yes No Yes

Table Continued
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Product number Description LED power on/off Slot auto low-
power mode

Slot power on/off

J9307A Switch 24-Port
10/100/1000 PoE+ zl
Module

Yes Yes Yes

J9308A Switch 20-Port
10/100/1000 PoE+/4-
Port MiniGBIC zl
Module

Yes Yes Yes

J9309A Switch 4-Port 10Gbe
SFP+ zl Module

Yes No Yes

J9478A Switch 24-Port
10/100 PoE+ zl
Module

Yes Yes Yes

Overview of power-saving features
There are several power-saving features that can be configured for the indicated switches and modules. The
power-saving features include:

• Turn slot power on or off

• Turn LED power on or off

• Turn slot auto low-power mode on or off

• Use LLDP for Energy-Efficient-Ethernet

Slot power

The savepower module option shuts down the slot power for the specified modules in the order specified in the
command. The ports on these modules no longer pass traffic. Any management traffic (SNMP, SSH, Telnet) that
passes through these modules is interrupted. It can take up to two minutes to power down all the specified
modules. Check the Event Log to see the current status of the module power down. This command applies to
PoE/PoE+ modules as well as non-PoE/PoE+ modules.

LED power

The savepower LED option provides the ability to turn off specified slot LEDs or all LEDs. You can also configure
a timer for turning off the chassis LEDs or the specified slot LEDs. There is one system-wide timer; all the
selected slots will have the chassis LEDs turned off for the same amount of time.

When the timer option is configured, a timer for turning off the chassis LEDs or configured slot LEDs. The LEDs
are turned off for the configured time period and duration.

MM/DD[/[YY]YY] HH:MM Specifies the date and time to start the timer.

now Instantaneously turns off the LEDs. The configured
timer is canceled and all the configured modules go
into power-saving mode immediately.

Table Continued
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duration [HH:]MM: The amount of time the LEDs
remain turned off. (Optional)If the duration value is
zero, when the timer starts, the LEDs are turned off
indefinitely until the timer is canceled or the command
is overridden with another command.Default: 0 (zero)

recur: (Optional) If specified, the LEDs are turned off
on a daily basis at the configured time. The recur
option is ignored if the duration is configured as
zero.Default: disabled.

A new command overrides the previous command, regardless of the current state. For example, if a timer is
active and new command is given, the currently running timer is canceled and the new timer is scheduled.

Slot auto low-power mode

The auto low-power mode option puts the slots into auto low-power mode if they are not linked. If a particular slot
is specified, only that slot goes into auto low-power mode. Specifying savepower port-low-pwr all puts all
the slots into auto low-power mode.

The ports in low-power mode periodically monitor to determine if the link has become active. If a LAN cable is
connected to one of the ports, that port will come out of the low-power mode state after approximately 2 seconds
(the monitor period) and enter into normal power mode. The remaining ports continue to be in low-power mode.

Energy-efficient-ethernet

Energy-efficient-ethernet (EEE) follows the 802.3az standard, which provides support for a system to operate in
low-power idle mode during low-link use. This allows both sides of a link to disable or turn off a portion of the
system's transmit/receive circuitry, saving power. When traffic is ready for transmission, the interface sends a
"wake-up" message to the link partner to prepare to receive the traffic. The circuitry is returned to "normal" mode.
Both sides of the link must be EEE-capable to support the power-saving idle mode.

Layer 2 (data link layer) EEE capability is a feature that allows fine-tuning for EEE that uses LLDP TLVs for the
negotiation of physical link partners' wake-up time values. An EEE-capable port notifies its link partner about the
EEE capabilities supported. The ports then negotiate how to best optimize energy efficiency.
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Networking Websites
Hewlett Packard Enterprise Networking Information Library

www.hpe.com/networking/resourcefinder

Hewlett Packard Enterprise Networking Software

www.hpe.com/networking/software

Hewlett Packard Enterprise Networking website

www.hpe.com/info/networking

Hewlett Packard Enterprise My Networking website

www.hpe.com/networking/support

Hewlett Packard Enterprise My Networking Portal

www.hpe.com/networking/mynetworking

Hewlett Packard Enterprise Networking Warranty

www.hpe.com/networking/warranty

General websites
Hewlett Packard Enterprise Information Library

www.hpe.com/info/EIL

For additional websites, see Support and other resources.

Chapter 13
Websites
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Accessing Hewlett Packard Enterprise Support
• For live assistance, go to the Contact Hewlett Packard Enterprise Worldwide website:

http://www.hpe.com/assistance

• To access documentation and support services, go to the Hewlett Packard Enterprise Support Center website:

http://www.hpe.com/support/hpesc

Information to collect

• Technical support registration number (if applicable)

• Product name, model or version, and serial number

• Operating system name and version

• Firmware version

• Error messages

• Product-specific reports and logs

• Add-on products or components

• Third-party products or components

Accessing updates
• Some software products provide a mechanism for accessing software updates through the product interface.

Review your product documentation to identify the recommended software update method.

• To download product updates:

Hewlett Packard Enterprise Support Center
www.hpe.com/support/hpesc

Hewlett Packard Enterprise Support Center: Software downloads
www.hpe.com/support/downloads

Software Depot
www.hpe.com/support/softwaredepot

• To subscribe to eNewsletters and alerts:

www.hpe.com/support/e-updates

• To view and update your entitlements, and to link your contracts and warranties with your profile, go to the
Hewlett Packard Enterprise Support Center More Information on Access to Support Materials page:

Chapter 14
Support and other resources
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www.hpe.com/support/AccessToSupportMaterials

Access to some updates might require product entitlement when accessed through the Hewlett
Packard Enterprise Support Center. You must have an HPE Passport set up with relevant
entitlements.

Customer self repair
Hewlett Packard Enterprise customer self repair (CSR) programs allow you to repair your product. If a CSR part
needs to be replaced, it will be shipped directly to you so that you can install it at your convenience. Some parts
do not qualify for CSR. Your Hewlett Packard Enterprise authorized service provider will determine whether a
repair can be accomplished by CSR.

For more information about CSR, contact your local service provider or go to the CSR website:

http://www.hpe.com/support/selfrepair

Remote support
Remote support is available with supported devices as part of your warranty or contractual support agreement. It
provides intelligent event diagnosis, and automatic, secure submission of hardware event notifications to Hewlett
Packard Enterprise, which will initiate a fast and accurate resolution based on your product's service level.
Hewlett Packard Enterprise strongly recommends that you register your device for remote support.

If your product includes additional remote support details, use search to locate that information.

Remote support and Proactive Care information
HPE Get Connected

www.hpe.com/services/getconnected
HPE Proactive Care services

www.hpe.com/services/proactivecare
HPE Proactive Care service: Supported products list

www.hpe.com/services/proactivecaresupportedproducts
HPE Proactive Care advanced service: Supported products list

www.hpe.com/services/proactivecareadvancedsupportedproducts

Proactive Care customer information
Proactive Care central

www.hpe.com/services/proactivecarecentral
Proactive Care service activation

www.hpe.com/services/proactivecarecentralgetstarted

Warranty information
To view the warranty for your product or to view the Safety and Compliance Information for Server, Storage,
Power, Networking, and Rack Products reference document, go to the Enterprise Safety and Compliance website:

www.hpe.com/support/Safety-Compliance-EnterpriseProducts

Additional warranty information
HPE ProLiant and x86 Servers and Options

www.hpe.com/support/ProLiantServers-Warranties
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HPE Enterprise Servers
www.hpe.com/support/EnterpriseServers-Warranties

HPE Storage Products
www.hpe.com/support/Storage-Warranties

HPE Networking Products
www.hpe.com/support/Networking-Warranties

Regulatory information
To view the regulatory information for your product, view the Safety and Compliance Information for Server,
Storage, Power, Networking, and Rack Products, available at the Hewlett Packard Enterprise Support Center:

www.hpe.com/support/Safety-Compliance-EnterpriseProducts

Additional regulatory information

Hewlett Packard Enterprise is committed to providing our customers with information about the chemical
substances in our products as needed to comply with legal requirements such as REACH (Regulation EC No
1907/2006 of the European Parliament and the Council). A chemical information report for this product can be
found at:

www.hpe.com/info/reach

For Hewlett Packard Enterprise product environmental and safety information and compliance data, including
RoHS and REACH, see:

www.hpe.com/info/ecodata

For Hewlett Packard Enterprise environmental information, including company programs, product recycling, and
energy efficiency, see:

www.hpe.com/info/environment

Documentation feedback
Hewlett Packard Enterprise is committed to providing documentation that meets your needs. To help us improve
the documentation, send any errors, suggestions, or comments to Documentation Feedback
(docsfeedback@hpe.com). When submitting your feedback, include the document title, part number, edition,
and publication date located on the front cover of the document. For online help content, include the product
name, product version, help edition, and publication date located on the legal notices page.
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Finding and Maintaining Networking Devices
To find and maintain Networking devices, Hewlett Packard Enterprise recommends using the Network Discovery
Tool. Note that this tool does not replace or augment full-featured Network Management software.

To install the Network Discovery Tool, follow these steps:

Procedure

1. From a PC (running Windows Vista SP2, Windows 7 SP1, 8, 2008 SP2 or R1 SP1, or later), type in the URL*
for the Network Discovery Tool into a browser’s address field and press Enter.

2. When asked, open the file. In the resulting folder, double-click the file setup. Accept running the install.

3. Upon completion, the tool runs automatically. (Note: If .NET is not installed on your system, you may be
prompted to install it. Follow the installation instructions.)

*For additional information, contact http://www.hpe.com/networking/support.

When updating the Network Discovery Tool software, you must first uninstall the old version before
installing the new one.

Run the Network Discovery Tool shortly after powering on newly installed devices. By default, only new
Networking devices will display. Use the filter drop-downs to specify device age, type, and so on, Double-click on
a device to start its web user interface.

For additional information, visit the Network Discovery Tool’s internal help page.

Appendix A
Finding and Maintaining Networking Devices
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Compliance

RFC 4292
Switch families indicted in the Abstract section of the Basic Operations Guide enjoy full conformance of the RFC
4292.

RFC defines a portion of the Management Information Base (MIB) for use in managing objects related to the
forwarding of Internet Protocol (IP) packets in an IP version-independent manner. It is to be noted that the MIB
definition described herein does not support multiple instances based on the same address family type. However,
it does support an instance of the MIB per address family.

RFC 4292 supported operations
Both GET and SET operations are now supported on switches. RFC 4292 is supported in the following ways:

1. The set operation can create IPv4 and IPv6 static routes which include the functions for Reject, Remote, and
Blackhole.

2. A column of any existing row with RowStatus “Active” will not be allowed for modification.

3. Rowstatus will not support “Create-and-wait”.

4. There is an existing HPE proprietary MIB, hpicfIpStaticRouteTable, which is used to configure IPv4 and
IPv6 static routes. Currently CLI commands use this proprietary MIB for configuration. This will remain
unchanged.

5. The SET functions for inetCidrRouteTable (k_test, k_ready, k_setDefaults and k_set) are implemented.
The implementation maps to the existing SET routines of hpicfIpStaticRouteTable with the necessary
changes. Index of InetCidrRouteTable has RoutePolicy whereas hpicfIpStaticRouteTable has
IfIndex. Both MIBs have 6 objects as index.

6. The current GET implementation of inetCidrRouteTable is directly accessing the Gated Routing table to
retrieve all the routes which include Static and Dynamic. The SET routines will have to go through the
hpicfIpStaticRouteTable SET functions as these routes are of type Static.

Appendix B
Compliance
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7. Creation, modification, or deletion of Dynamic route entry is not allowed. This can be achieved by validating
the MIB column inetCidrRouteProto for Static or Dynamic protocol.

8. gateD(routing stack) does not discard any routes, so the value of inetCidrRouteDiscards MIB will always
be 0.

Figure 54: MIB mapping

RFC 4292 MIB operations
To make the switch software fully compliant to RFC 4292, both GET and SET operations are supported as
indicated in the table below.

Table 10: GET and SET operations

inetCidrRouteTable Type Access

inetCidrRouteDestType* InetAddressType, Not-accessible

inetCidrRouteDest* InetAddress, Not-accessible

inetCidrRoutePfxLen* InetAddressPrefixLength, Not-accessible

inetCidrRoutePolicy* OBJECT IDENTIFIER, Not-accessible

inetCidrRouteNextHopType* InetAddressType, Not-accessible

inetCidrRouteNextHop* InetAddress Not-accessible

Table Continued
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inetCidrRouteTable Type Access

inetCidrRouteIfIndex InterfaceIndexOrZero, Read-Create

inetCidrRouteType INTEGER, Read-Create

inetCidrRouteProto IANAipRouteProtocol, Read-Only

inetCidrRouteAge Gauge32, Read-Only

inetCidrRouteNextHopAS InetAutonomousSystemNumber, Read-Create

inetCidrRouteMetric1 Integer32, Read-Create

inetCidrRouteMetric2 Integer32, Read-Create

inetCidrRouteMetric3 Integer32, Read-Create

inetCidrRouteMetric4 Integer32, Read-Create

inetCidrRouteMetric5 Integer32, Read-Create

inetCidrRouteStatus RowStatus Read-Create

* INDEX OBJECTS

JITC authorization requirements
The Joint Interoperability Test Command (JITC) conducts testing of national security systems and information
technology systems hardware, software, and components. Hewlett Packard Enterprise is in compliance with JITC
which provides the following.

• Logs of security-related events with new login credentials separate from operator or manager credentials.

• Log message when the event log wraps.

• Configuration commands that allow users to set the maximum number of concurrent sessions.

• Configuration commands which allow users to set the maximum number of concurrent sessions per user.

• Increase the delay between failed login attempts.

The HPE 3800 Switch and HPE 2920 Switch are currently UC APL certified.

Local authentication and authorization
JITC requires that access to security logs be provided through security user authentication and authorization. For
more information about JITC security authentication and authorization, see the Access Security Guide for your
switch.
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Security user log access
Security user logs are accessible when both the authentication and authorization are local. A default group called
the default-security-group is available in manager mode and has the privileges to execute the commands copy
security-log, show security-logging, and clear security-logging. When a security user is
attached to the group, they will only be able to execute these three commands. Other users will not be able to
execute the commands, no matter whether they are an operator or manager.

For more information about JITC security user log creation and access, see the Access Security Guide for your
switch.

Authentication and Authorization through RADIUS
For RADIUS authentication and authorization, the security user will be able to access to security log by
configuring the file located on RADIUS server. For more information about JITC authentication and authorization
through RADIUS, see the Access Security Guide for your switch.

Authentication and Authorization through TACACS
For TACACS authentication and authorization, the user can access to security log by configuring the file located
on TACACS server. For more information about JITC security authentication and authorization, see the Access
Security Guide for your switch.

Common access card (two-factor) authentication

Overview
A common access card (CAC) is a United States Department of Defense (DoD) smart card for multifactor
authentication. CACs are issued as standard identification for active-duty military personnel, reserve personnel,
civilian employees, non-DoD government employees, state employees of the National Guard, and eligible
contractor personnel. In addition to its use as an ID card, a CAC is required for access to government buildings
and computer networks.

Two-factor authentication
Part of the requirement necessary to satisfy the Federal Government Certification is two-factor authentication.
Two-factor authentication is the redundant authentication of the CAC. For example, the CAC satisfies two-factor
authentication by mandating that you have both the physical card and know the pin number associated with the
card.

To provide support for CAC authentication, the requirement for the network is the establishment of SSH
connections. Two-factor authentication constitutes authentication based on public key or certificate and
username/password on the switch.

Restrictions
The following are some of the restrictions when working with CAC authentication:

• Support is not provided for any other management connections other than SSH.

• Support is not provided for any switch acting as CAC SSH client.

• Support is not provided for public-key authentication based on DSA and ECDSA public keys.

• The maximum number of client public keys that can be installed is 10.

• When there is failure in any one of the authentication methods, the SSH connection will not be established.

• The following table lists the invalid authentication methods for SSH.
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login enable

public-key certificate

public-key two-factor-certificate

certificate public-key

certificate two-factor-public-key

two-factor-public-key certificate

two-factor-public-key two-factor-certificate

two-factor-certificate public-key

two-factor-certificate two-factor-public-key

Expected behaviors
With include-credentials command

• When the command include-credentials is enabled, public keys are stored both in configuration and
flash files.

• When the command no include-credentials is executed, the client public key is stored only in the flash.

• When the command no include-credentials store-in-config is executed, behavior is then based
on the user entry made with the pop-up message.

The command switch(config)# no include-credentials store-in-config will display a
message similar to:

This will remove any switch passwords and inactive SSH 
authorized keys from all configuration files.  This will also restore
 the functionality to store only a single set of passwords and authorized 
keys on the switch.

Continue (y/n)?  y
The SSH authorized keys associated with the active configuration will be 
deleted.

Would you like to retain these as the switch global SSH authorized keys 
(y/n)?  y

If the above option entered is “y”, then the client public key will be 
available in the flash but not in the config.

If the above option entered is “n”, then the client public key is neither 
available in the flash nor in the config.

Zeroization

When the zeroization command switch(config)# crypto key zeroize ssh-client-key is executed,
the client public keys will be zeroized in the flash.
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switch(config)# crypto key zeroize ssh-client-key

The manager key pair will be deleted, continue (y/n)? y 

The command erase all zeroize will also perform the 
zeroization of the key files in the flash.

The command erase all will only delete the key files from 
flash.
      
Switch is moved to/from enhanced security mode

Since the secure mode change goes through zeroization, the client keys are deleted and the switch will revert to
the default configuration without any client keys on the switch.

Attempting to configure a two-factor authentication method with no public key or username configured

If, during the download of the configuration file, the username and/or public key is not configured, then no action
will be taken. A warning message will display similar to:

username and/or public key is not configured.
An RMON will be logged with the message that the authentication method is set to two-factor with some
configuration missing.

When the user tries to connect using SSH, the connection will fail.

Deletion of the public key and/or username when the authentication method is set to two-factor
authentication

For the following three scenarios:

• After the authentication method is set to two-factor, if the client public keys are deleted while the usernames
still exists on the switch...

• After the authentication method being set to two-factor, if the username is deleted the public key exists on the
switch...

• When both the public key and usernames are deleted while the authentication method is being set to two-
factor authentication...

The new SSH connection will fail at either the public key authentication and/or username/password
authentication. RMON will be logged with appropriate message on the switch.

An alternative solution is to block the deletion of the public key and/or username when the
authentication method is set as two-factor authentication. With this approach, the impact of many
configurations need to be taken care cautiously since the username/password can be configured
through many interfaces such as SNMP, REST, WebUI, Menu, setup mgmt.-interfaces, and include-
credentials.

Authentication method re-configured at run time

If the authentication method is reconfigured at run time, the modified authentication method will be applied when
the new connection will be established.
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Secure Mode
With this release, the 3810M switch in secure mode is in compliance with the Federal Information Processing
Standards (FIPS). For more information, see the Access Security Guide of your switch.

Federal government certification
The following phase 3 certification features are included in the 16.03 release.

Local command audit logging

The logging of all administrative actions on a device is a requirement for NDcPP certification:

• All administrative actions (commands) must be logged locally.

• Enabling and disabling of command log storage is required.

• The identity of a user causing an event must be logged.

• When the command log is exhausted by 80% and wraparound occurs, the event must be logged and a trap
must be generated.

• The logs have a maximum of 240 characters and are stored in the command log buffer. If the log message
exceeds this maximum length, it is truncated and is not stored in the command log buffer.

Password storage in SHA-256 format

On Aruba switches, passwords can be configured either in plaintext or SHA-1 format. You can now configure the
passwords in SHA-256 format as well. For more information, see the Access Security Guide of your switch.

SSH Re-keying

To comply with RFC 4251, session re-keying ensures that either the SSH server or the SSH client initiates a re-
key. This results in a new set of encryption and integrity keys to be exchanged between them. Once the re-key is
complete, new keys are used for further communication, which ensures that the same key is not used for a long
duration and the security of the session is maintained. For more information, see the Access Security Guide of
your switch.

OSPFv3 RFC compliance

This feature supports authentication for OSPFv3 routing traffic on Aruba devices via IPsec. The authentication
support for OSPFv3 is provided in compliance with RFC 4552. Authentication is supported using AH protocol.
Authentication and confidentiality support using ESP is not supported in this release. For more information, see
the IPv6 Configuration Guide of your switch.

X.509v3 certificate extension RSA minimum key support

There are three requirements for NDcPP certification:

• Minimum secure RSA key size.

• Enforcement of TLS 1.1/TLS 1.2 for all TLS connections.

• Validation of extended key usage extension for X509v3 certificates.

As part of the minimum secure RSA key size requirement, an option has been added to the existing tls
configuration command to support minimum TLS version support for cloud application requirement.
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X.509v3 certificate authentication for SSH

This feature supports user-authentication in SSH using X.509v3-based certificates. For more information, see the
Access Security Guide of your switch.
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Managing the device link detection protocol
(DLDP)

Enabling or disabling DLDP
Device Link Detection Protocol (DLDP) must be enabled globally and on one or more interfaces to begin
monitoring. DLDP is disabled by default.

• To enable DLDP on the switch, use the command dldp enable.

• To disable DLDP on the switch, use the command dldp disable.

• To disable DLDP globally, use the command no dldp enable.

Setting the DLDP advertisement interval
Setting the DLDP advertisement interval appropriately for your network environment assures that DLDP can
detect unidirectional links before network performance deteriorates. Hewlett Packard Enterprise recommends
keeping the advertisement interval the same across the link partners.

• To set the advertisement interval, use the command dldp interval <1-100>, specifying a value between
1 and 100 seconds.

• To reset the advertisement interval to the default value of 5 seconds, use the command no dldp interval.

Enabling and disabling types of DLDP debugging
• To enable specific types of debugging for DLDP on the specified ports, use the following command:

debug dldp all|error|event| packet|state-machine|timer <port-list>
• To disable specific types of debugging for DLDP on the specified ports, use the following command:

no debug dldp all|error|event| packet|state-machine|timer <port-list>

Arguments:

all

Display all DLDP debug messages.

error

Display all DLDP error messages.

event

Display all the DLDP event messages.

Appendix C
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packet

Display all DLDP packet messages.

stat-machine

Display all DLDP state machine messages.

timer

Display all DLDP timer messages.

port-list

Display all DLDP debug messages for the listed port.

Clearing statistics on DLDP packets
Procedure

1. To clear statistics on DLDP packets that pass through the specified ports, use the following command:

clear statistics dldp <port-list>
2. To clear statistics on DLDP packets that pass through all ports, use the following command:

clear statistics dldp all

Viewing DLDP configuration information and statistics
• To view the DLDP statistics for the specified ports, use the command show dldp statistics <port-

list>. The port-list argument specifies a single port, a list of ports, or a range of ports.

• To view the DLDP statistics for all ports, use the command show dldp statistics all
• To view the DLDP configuration information and statistics for the specified ports, use the command show

dldp <port-list>. The port-list argument specifies a single port, a list of ports, or a range of ports.

• To view the DLDP configuration information and statistics for all ports, use the command show dldp all.

The following examples shows the DLDP statistics for port number a1.

show dldp statistics a1 

Status and Counters - Device Link Detection Protocol
Port : a1 
Packets Sent                           : 256
Packets Received                       : 255
Invalid Packets Received               : 0
Authentication Failed Packets Received : 0
Valid Packets Received                 : 255
The following example shows the DLDP statistics for ports a1 through a3.

show dldp statistics a1-a3

Status and Counters - Device Link Detection Protocol
Port : a1
Packets Sent                           : 256
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Packets Received                       : 255
Invalid Packets Received               : 0
Authentication Failed Packets Received : 0
Valid Packets Received                 : 255
Port : a2
Packets Sent                           : 256
Packets Received                       : 255
Invalid Packets Received               : 0
Authentication Failed Packets Received : 0
Valid Packets Received                 : 255
Port : a3 
Packets Sent                           : 0
Packets Received                       : 0
Invalid Packets Received               : 0
Authentication Failed Packets Received : 0
Valid Packets Received                 : 0
The following example shows the DLDP configuration information and statistics for port number a1.

show dldp a1
The output will display sensitive information. Continue (y/n)?

Status and Configuration - Device Link Detection Protocol
Global Status         : Enabled
Advertisement Interval (Sec) : 5 
Authentication Mode          : None
Authentication Password      : Password
Unidirectional Shutdown Mode : Auto
DelayDown Timer Value (Sec)  : 1
Number of DLDP Enabled Ports : 2
Interface A1
DLDP Port State     : Bidirectional
Number of Neighbors : 1 (Maximum number ever detected: 2)

Port      Port        Link     Neighbor MAC  Neighbor    Neighbor      Neighbor
        State        State    Address       Port Index               Aged Time
----- --------------- -------- ------------- ------------ ------------   ------- 
A1    Unidirectional    up      010fe2-000004     5       unconfirmed    0
The following example shows the DLDP configuration information and statistics for ports a1 through a3.

show dldp a1-a3
The output will display sensitive information. Continue (y/n)?

Status and Configuration - Device Link Detection Protocol
Global Status         : Enabled
Advertisement Interval (Sec) : 5 
Authentication Mode          : None
Authentication Password      : Password
Unidirectional Shutdown Mode : Auto
DelayDown Timer Value (Sec)  : 1
Number of DLDP Enabled Ports : 2
Interface A1
DLDP Port State     : Unidirectional
Number of Neighbors : 1 (Maximum number ever detected: 2)
Interface A2
DLDP Port State     : Bidirectional
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Number of Neighbors : 1 (Maximum number ever detected: 2)
Interface A3
DLDP Disabled

Port        Port      Link     Neighbor MAC   Neighbor    Neighbor     Neighbor
          State       State    Address        Port Index             Aged Time
----- ---------------   ------- ------------- ---------- ------------ -------- 
 A1     Unidirectional   up      40a8f0-9e2100     2      unconfirmed    0
 A2     Bidirectional    down     010fe2-000004     3      unconfirmed    0 

Setting the DLDP delaydown timer
The DLDP DelayDown timer specifies the delay, in seconds, before down ports are rechecked.

• To set the DLDP DelayDown timer, use the command dldp delaydown-timer <1-5> , specifying a value
between 1 and 5 seconds.

• To reset the DLDP DelayDown timer to the default value of 1 second, use the command no dldp
delaydown-timer.

Setting DLDP unidirectional-shutdown mode
On the detection of a unidirectional link, the port can be shut down either automatically or manually. This setting
controls whether the shutdown is automatic or manual.

Procedure

1. To set the DLDP unidirectional-shutdown mode, use the following command:

dldp unidirectional-shutdown auto|manual
2. To reset the DLDP unidirectional-shutdown mode to the default value (automatic shutdown), use the following

command:

no dldp unidirectional-shutdown

When DLDP detects a unidirectional port, an event is logged and the port must be shut down
manually by an administrator. In the event that the link state is restored to bidirectional and the
shutdown mode is manual, the user must manually bring up the port. Any dynamic change of the
shutdown mode (that is, auto to manual) will take effect only when DLDP is disabled globally and
enabled again. Likewise, When the link state is restored to Bidirectional and the shutdown mode is
manual, the user must manually bring up the port.

Also, any dynamic change of the shutdown mode (that is, auto->manual/vice versa) will be taken into
effect only when DLDP is disabled globally and enabled back again

Setting the DLDP authentication-mode
The authentication mode determines the type of authentication that DLDP uses. By default, no authentication is
used. Hewlett Packard Enterprise recommends keeping the authentication mode the same between link partners
or it will fail and log errors.
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• To set the DLDP authentication mode, use the following command:

dldp authentication-mode none|md5|simple
• To reset the DLDP authentication mode to the default value (no authentication), use the following command:

no dldp authentication-mode

This is equivalent to specifying none when setting the authentication mode.

Authentication modes:

none

Do not perform DLDP authentication (default).

md5

Authenticate using MD5.

simple

Authenticate using a plain text password.

Setting or removing a DLDP authentication password
• To set the DLDP authentication password to a plain text value, use the following command:

dldp authentication-password simple
• To set the DLDP authentication password to an encrypted value (a base64-encoded aes-256 encrypted string),

use the following command:

dldp authentication-password encrypted
• To remove the DLDP authentication password, use the following command:

no dldp authentication-password

When encrypt-credentials is enabled, the encrypted parameter is displayed. When configuring the
authentication password after configuring the authentication mode, the authentication mode defaults
to none (advertised in PDUs) regardless of which authentication mode you attempt to configure.

If you do not configure the authentication password after you configure the authentication mode, the
authentication mode will be none (advertised in PDUs) no matter which authentication mode you
configure.

The following example shows disabled encrypt-credentials.

dldp authentication-password
simple

Set the authentication password to plain text.

The following example shows enabled encrypt-credentials.

dldp authentication-password
simple

Set the authentication password to plain text.

encrypted

Global encryption key, specified using a base64-encoded aes-256 encrypted string.

196 Aruba Basic Operation Guide for ArubaOS-Switch 16.05

Anexo 02 ITEM 11 (0592659)         SEI 0008478-63.2018.6.02.8000 / pg. 5809



The following example shows both in secure mode.

dldp authentication-password simple
Password will be prompted interactively as above and sets the entered value in the configuration.

Enter Password:
Re-Enter Password:
In Download mode, the authentication password must be accepted as inline parameter only, and not be prompted
interactively.

Include-credentials and encrypt-credentials
considerations
The output of show running-config will be modified if encrypt-credentials is enabled or disabled. The
running-config output changes when include-credentials or encrypt-credentials is enabled or
disabled.

Table 11: Include/exclude credentials

Include
credentials

Encrypt
credentials

show run output Reboot with Saved
Config

Download config file

Disabled Disabled DLDP authentication-
password will not be
displayed.

The plain-text
password in the
Config will be used
to update the
protocol data
structure.

Mis-Configuration (Password
cannot be configured in this
case because password is
not available in downloaded
config.)

Disabled Enabled DLDP authentication-
password will not be
displayed.

The encrypted
password in the
Config will be
decrypted and used
to update the
protocol data
structure.

Mis-Configuration (Password
cannot be configured in this
case because password is
not available in downloaded
config.)

Enabled Disabled DLDP authentication-
password will be
displayed in plain-
text.

The plain-text
password in the
Config will be used
to update the
protocol data
structure.

DLDP authentication-
password stored as plain-
text.

Enabled Enabled DLDP authentication-
password will be
displayed in
encrypted form.

The encrypted
password in the
Config will be
decrypted and used
to update the
protocol data
structure.

DLDP authentication-
password stored as
encrypted.
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dldp authentication-password

dldp authentication-password simple

Enter Password: ****
Re-Enter Password: ****

include-credentials and encrypt-credentials are disabled

show running-config

Running configuration:

encrypt-credentials is enabled and include-credentials is disabled

encrypt-credentials

show running-config

Running configuration:

include-credentials is enabled and encrypt-credentials is disabled

include-credentials

show running-config

Running configuration:

dldp authentication-password simple test
      

encrypt-credentials and include-credentials are enabled

encrypt-credentials

include-credentials

show running-config

Running configuration:
dldp authentication-password encrypted “QFg8OTxYyLMEnFvQt6o542tAmbk4RrH4dO0C60oFokI=”
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Restrictions for DLDP
• DLDP is mutually exclusive with UDLD running on the port and some of the other protocol running on the

switch.

• DLDP is not supported on Distributed trunks that is, cannot be enabled on individual port of a DT trunk.

• DLDP is not supported on DYN trunk

• DLDP PKT received on a DLDP disabled port will not be forwarded and will be dropped by the switch. If DLDP
is globally disabled on the switch, DLDP pkts received will be reforward on the same VLAN.

Overview of device link detection protocol (DLDP)
DLDP is active on the following switches:

Aruba 2530 Switches
Aruba 2920 Switch
Aruba 2930F Switches
Aruba 2930M Switches
Aruba 3810 Switches
HPE 2620 Switch
HPE 3800 Switches
HPE 5400R Switches (both v2 and v3 blades)

Device link detection protocol (DLDP) is switch technology that detects any unidirectional link failures that can
occur in a network. Typically these unidirectional link failures occur among devices connected through fiber-optic
or copper twisted pair (such as category 5 twisted pair) cables. Upon detecting a link failure, the link PHY will be
kept UP and will be blocked in the hardware. All the upper layer protocols of the switch software (STP, LACP, and
so on) will see the interface as DOWN.

Enabling and disabling DLDP: Enable or disable the Device Link Detection Protocol (DLDP) to monitor link
status. DLDP must be enabled globally and on one or more interfaces to begin monitoring. DLDP is disabled by
default.

Advertisement interval: This is the interval between sending DLDP advertisement packets. Setting the DLDP
advertisement interval appropriately for your network environment assures that DLDP can detect unidirectional
links before network performance deteriorates. Hewlett Packard Enterprise recommends keeping the
advertisement interval the same across the link partners or DLDP can fail and produce an error log.
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DLDPDUs are sent as untagged PKTs on default VLAN. No support for tagged advertisements.

Figure 55: Link

DLDP can be enabled on a maximum of 128 ports with each DLDP enabled port can have up to 4
neighbors (with the exception of the switch 2530.

On the Switch 2530, DLDP can be enables on a maximum of 12 ports with each DLDP enabled port
allowed up to 4 neighborhoods.

Figure 56: Broken link
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Mobile web interface
Mobile web interface is available on the following switches:

Switch 2530
Switch 2620

The Mobile Web Interface feature provides a subset of functionality currently available in the existing web
interface but designed for use on mobile devices such as smart phone or tablet.

Viewing web management-to-server configurations
Use the command Show web-management to view the web management-to-server configuration.

The SSL Port is displayed only if HTTPS Access is enabled. The Idle Timeout and Support URL are displayed if
either HTTP or HTTPS is enabled.

The following example shows the display of web management-to-server configuration.

show web-management

Web Management - Server Configuration 
HTTP Access           : Enabled
HTTPS Access          : Enabled
SSL Port              : 433
Idle Timeout          : 7200 seconds

Appendix D
Mobile web interface
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ArubaOS‐Switch Software Feature Support Matrix 16.07 
YA-YB/YC/WC/YC/KB Switches (minimum firmware versions)

Software Features
Firmware Prefix

2530
YA/YB

2540
YC

2930F
WC

2930M
WC

3810M
KB

5400R 
KB

Bridging
Data Link Detection Protocol (DLDP) YA.15.17/YB.15.17 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.17
Distributed Trunking PIM-DM n/a n/a n/a n/a KB.16.01 KB.15.17
Distributed Trunking PIM-SM n/a n/a n/a n/a KB.16.01 KB.15.18
Distributed Trunking Primary/Secondary Configuration n/a n/a n/a n/a KB.16.01 KB.15.15
Distributed Trunking Switch to Server n/a n/a n/a n/a KB.16.01 KB.15.15
Distributed Trunking Switch to Switch n/a n/a n/a n/a KB.16.01 KB.15.16
GVRP YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
LACP (802.3ad) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
LACP Key for Controlling Dynamic Trunk Configuration YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
LACP MAD n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
LACP Trunk Load Balancing Information Output YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
LLDP (802.1ab) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
LLDP MED (Media Endpoint Discovery) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
LLDP PoE+ Support YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
LLDP over OOBM n/a n/a n/a WC.16.04.0004 KB.16.01 KB.16.01
LLDP TLV YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Loop Protection YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
MAX VLANs: 512 YA.15.10/YB.15.12 YC.16.02.0012 n/a n/a n/a n/a
MAX VLANs: 1K n/a n/a n/a n/a n/a n/a
MAX VLANs: 2K n/a n/a WC.16.02.0003 WC.16.04.0004 n/a n/a
MAX VLANs: 4K n/a n/a n/a n/a KB.16.01 KB.16.01
Meshing: Concurrent Meshing and Routing n/a n/a n/a n/a KB.16.01 KB.15.15
Meshing: Mesh ID Configuration n/a n/a n/a n/a KB.16.01 KB.15.15
Meshing: Switch Meshing n/a n/a n/a n/a KB.16.01 KB.15.15
MVRP: Multiple VLAN Registration Protocol YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Q-in-Q n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Single Instance (802.1d-1998) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SmartLink YA.15.14/YB.15.14 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Spanning tree: BPDU Filtering YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Spanning tree: BPDU Protection YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Spanning tree: Fast Mode YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Spanning tree: Loop Guard YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Spanning tree: Multiple STP (802.1s Standards Compliant) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

Spanning tree: 64 MSTP instances n/a n/a   n/a n/a KB.16.01 KB.16.01
Spanning tree: PVST Protection and Filtering YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Spanning tree: PVST+ Compatibility YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Spanning tree: Rapid STP (802.1w Standards Compliant) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Spanning tree: Root Guard YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Trunking: Enable using TCP/UDP Port Numbers for Trunk Load-
Balancing YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Trunking: Link Aggregation YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
UDLD: Uni-Directional Link Detection YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
UDLD: Verify Before Forwarding YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.16
UFD: Uplink Failure Detection n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

VxLAN n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Wake-on-LAN for a Specific VLAN n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

Management
802.1ap Std MIB Support YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

802.3bz compliance (2.5 Gbps and 5.0 Gbps) for Smart Rate ports n/a n/a n/a WC.16.04.0008 KB.16.04.0008
KB.16.04.0008 (V3 
only)

100Mbps support on SmartRate ports n/a n/a n/a WC.16.06 KB.16.06 KB.16.06
IPSec to Controller for Management Traffic n/a YC.16.02 WC.16.02 WC.16.02 KB.16.02 KB.16.02

IPSec for Management Traffic (with secondary controller support) n/a YC.16.06 WC.16.06 WC.16.06 KB.16.06 KB.16.06
ARP Attack Detection n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Aruba Central on-boarding YA.16.07/YB.16.07 YC.16.07 WC.16.07 WC.16.07 KB.16.07 KB.16.07
Auto-MDI-X YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Banner: Post-Logon User-Configurable Banner Display YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Bidirectional Secure Copying Between Switch and SFTP Server YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
BOOTP/DHCP Relay Gateway YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
BPDU-Throttle n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.16
BYOD Redirect YA.15.16 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.16
Captive Portal for ClearPass YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.16.01
Chassislocate LED at Boot YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Clarify Port VLAN Tagged Status YA.15.12/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Clear Module Configuration n/a YC.16.02.0012 n/a n/a n/a KB.15.15
CLI Return Message Category (Error; Warning; Information) YA.15.10/YB.15.12 n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Compliance with IEEE Standard for MIB Object ieee8021MstpMib YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Comware CLI Support YA.15.11/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Config Backup and Restore without Reboot YA.16.05/YB.16.05 YC.16.05 WC.16.05 WC.16.05 KB.16.05 KB.16.05
Config Menu YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Control Plane Protection n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Control Plane Policing (CoPP) n/a n/a WC.16.04.0008 WC.16.04.0008 KB.16.04.0008 KB.16.04.0008
Custom Default Switch Configuration YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Customized Commands for Local User Accounts YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Device Profile: Auto configuration for Aruba APs/Switches YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Device Profile: Auto configuration for Custom device types YA.16.01/YB.16.01 YC.16.02.0012 WC.16.04.0008 WC.16.04.0008 KB.16.04.0008 KB.16.04.0008
DHCP Client DNS Support YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
DHCPv6 Client Options YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
DHCP Option 82 YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
DHCP Option 60 and 150 n/a YC.16.06 WC.16.06 WC.16.06 KB.16.06 KB.16.06

DHCP Relay YA.15.14/YB.15.14 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
DHCPv6 Relay n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
DHCPv6 Relay Option 79 n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.16
Disable IP Address on a VLAN Without Deleting the Address YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

Disable Username Prompt for Management Interface Authentication YA.15.15/YB.15.15 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Display Configuration of Selected Interface YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Display Transceiver YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
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Display Transceiver Information for Transceiver Cable Diagnostics YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
DNS Capabilities for Telnet YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Dual Flash Images YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Encoded Version Info Added to Config Files YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Encrypt Passwords and Authentication Keys in the Config File YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Event Log: Severity Change YA.15.12/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Event Log Buffer: Configurable threshold for SNMP traps YA.16.06/YB.16.06 YC.16.06 WC.16.06 WC.16.06 KB.16.06 KB.16.06
Fastboot YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Fault Finder Extended to Cover Flapping Transceiver Mitigation YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Fault Finder (Per Port Enable) n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 n/a
Filtering PVID Mismatch Log Message YA.15.14/YB.15.14 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Find-Fix-and-Inform YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Flow Control (802.3x) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Generic Header ID in Config File YA.15.16/YB.15.16 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.16
Grouped Config File Display per Interface YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
ICMP Throttling YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
IP Forwarding MIB YA.15.17/YB.15.17 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.17
IP Service Level Agreement (SLA) n/a YC.16.02.0012 WC.16.02.0008 WC.16.04.0004 KB.16.02 KB.16.02
IP Stacking YA.15.10/YB.15.12 n/a n/a n/a n/a n/a
IPv6 DNS via RA Options n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
IPv6 Host (Dual Stack) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Local Management Privilege Groups YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
MAC Limit Notify YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Management Interface Wizard YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Minimum Password Length YA.15.15/YB.15.15 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Module Reload n/a n/a n/a n/a n/a KB.15.15
MS-CHAPv2 for Switch Management Interface YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Multiple Configuration Files YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
NTP: Network Time Protocol YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
OOBM: IPv6 Host Function n/a n/a n/a WC.16.04.0004 KB.16.01 KB.15.15
Avoid double tunneling of Aruba APs on Tunneled Node n/a n/a WC.16.05 WC.16.05 KB.16.05 KB.16.05
PTP (Precision Time Protocol) IEEE 1588 n/a n/a n/a WC.16.04.0004 n/a n/a
Readable Interface Names in Traps YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Reinterpret CDP Info when Using IP Phones YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Report Config Changes Per-User Per-Session YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
REST APIs YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 K.16.01 KB.16.01
Retain configuration on 5400R 
when switching from v3-only to v-2 compatible mode n/a n/a n/a n/a n/a KB.16.02
RMON YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RMON: Extended RMON YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RMON: Local Alarm Threshold YA.15.13/YB.15.13 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Save Running Configuration to TFTP via SNMP YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Saving Security Credentials in a Configuration File YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Scheduled Reload YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Secure FTP YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Secure Shell v2 (SSHv2) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Secure Sockets Layer (SSL) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Send syslog Messages via TCP YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
sFlow YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
sFlow Data over OOBM n/a n/a n/a WC.16.04.0004 KB.16.01 KB.15.15
sFlow Set Agent Address YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
sFlow Using IPv6 YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Single Source IP Identity YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SNMP v1/v2c/v3/v3 with AES YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SNMP: Enable SNMP Trap when Switch Config Changes YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SNMP: MIB to Check Load of Module Slots n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SNMP: Password Set via SNMP YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SNMP: Server Source IP Commands YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SNMP: Trap if MAC Address Add to or Delete from a Port YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SNMP: Trap on MAC Address Table Changes YA.15.14/YB.15.14 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SNMP: Trap on Power Supply Removal YA.15.14/YB.15.14 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SNMP: Trap Throttling YA.15.13/YB.15.13 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SNTP: Simple Network Time Protocol YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Syslog Config Change Reporting YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Syslog over TLS YA.15.15/YB.15.15 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Syslog: Disable Debug without Affecting Syslog YA.15.13/YB.15.13 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Syslog: Per-Interface Syslog Event Enable-Disable YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Sysname in Syslog Messages YA.15.15/YB.15.15 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
TFTP & SSH Concurrent Usage YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.18
TFTP Uploadable Configuration YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Transceivers - Diagnostic Optical Monitoring 
(show interface transceiver detail) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Username and Password Length Increase YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
VLAN information added to 'show mac-address' Output YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
VSF: Virtual Switch Framework n/a n/a WC.16.03.0003 n/a n/a KB.16.01 (V3 only)
VSF 8-member Stack (2930F only) n/a n/a WC.16.06 n/a n/a n/a
Web GUI YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Web GUI Inactivity Timer YA.15.15/YB.15.15 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Next-Gen Web GUI YB.16.03 YC.16.02.0012 WC.16.02.0008 WC.16.04.0004 KB.16.03.0003 KB.16.03.0003
ZTP with TR-69 YA.15.16/YB.15.16 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 n/a n/a
ZTP with DHCP YA.16.01/YB.16.01 YC.16.01 WC.16.01 WC.16.01 KB.16.01 KB.16.01
ZTP with DHCPv6 n/a YC.16.06 WC.16.06 WC.16.06 KB.16.06 KB.16.06
ZTP for Activate YA.16.04/YB.16.04 YC.16.02.0012 WC.16.02.0010 WC.16.04.0004 KB.16.02 KB.16.02
HTTP Proxy Support YA.16.06/YB.16.06 YC.16.06 WC.16.06 WC.16.06 KB.16.06 KB.16.06
Job Scheduler YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
DHCPv4 Server n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.16
DHCPv6 Server n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.16
Console Lockout n/a YC.16.06 WC.16.06 WC.16.06 KB.16.06 KB.16.06

OpenFlow
OpenFlow 1.0 n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
OpenFlow 1.3 n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Openflow: Custom Matches n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.02 KB.16.02

Anexo 03 ITEM 11 (0592664)         SEI 0008478-63.2018.6.02.8000 / pg. 5816



Software Features
Firmware Prefix

2530
YA/YB

2540
YC

2930F
WC

2930M
WC

3810M
KB

5400R 
KB

OpenFlow: L4 Match n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.18
OpenFlow: MacGroups n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.18
Openflow: Source IP specification YA.16.05/YB.16.05 YC.16.05 WC.16.05 WC.16.05 KB.16.05 KB.16.05

OpenFlow: TCP Flags and L4 port ranges in Custom Match Mode n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01(V3 ONLY)

Power
Energy Efficient Ethernet (EEE) YA.15.12/n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
External Power Support  (EPS) n/a n/a n/a n/a n/a n/a
Hibernate mode n/a n/a n/a WC.16.04.0004 n/a n/a
Power over Ethernet (POE) (802.3af) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Power over Ethernet Plus (POE+) (802.3at) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Redundant Power Support n/a n/a n/a WC.16.04.0004 KB.16.01 KB.15.15

Priority/Quality of Service (QoS)
Broadcast Control YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Broadcast Storm Control n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Classifier-Based QoS and Rate Limiting n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Egress Port Monitoring (Outbound) n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
ICMP Rate Limiting YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Inbound Rate-Limiting for Broadcast and Multicast Traffic YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Layer 4 TCP/UDP Packet Priority YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Mirroring: MAC based Mirroring n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Mirroring: MAC based Remote Mirroring n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Mirroring: no VLAN Tag added n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Mirroring: Port YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Mirroring: Remote n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Multicast Storm Control YA.16.06/YB.16.06 YC.16.06 WC.16.06 WC.16.06 KB.16.06 KB.16.06
QoS: Class of Service (CoS) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
QoS: Egress Queue Rate-limiting n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
QoS: Guaranteed Minimum Bandwidth n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
QoS: IPv6 QoS YA.15.14/YB.15.14 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

QoS: Monitor Egress Queues for Dropped Packets if QoS Configured YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
QoS: Netdestinations and Netservices YA.16.03 YC.16.03.0003 WC.16.03.0003 WC.16.04.0004 KB.16.03.0003 KB.16.03.0003
QoS: Packet Priority (802.1p) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
QoS: Per Port Trust YA.16.02 YC.16.02.0012 WC.16.02.0008 WC.16.04.0004 KB.16.02 KB.16.02
QoS: Port and Priority-based Rate Limiting YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
QoS: Priority Queuing YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
QoS: Selectable Queuing Configurations YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
QoS: Strict Priority Queuing n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
QoS: TCP/UDP Port Ranges YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
QoS: Traffic Template YA/YB. 16.01.0004 n/a WC.16.04.0008 WC.16.04.0008 KB.16.05 KB.16.05
QoS: Turn on/off VLAN Precedence YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.16
QoS: VLAN Port-Based Prioritization (802.1p) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Rate Limiting YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Rate Limiting Unknown Unicast Traffic n/a n/a WC.16.05 WC.16.05 KB.16.05 KB.16.05
Traffic Policing (with two rate three color marker) n/a n/a WC.16.06 WC.16.06 KB.16.06 KB.16.06

Routing and Multicast
ARP Age Timer Increase YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
BFD: Bidirectional Forwarding Detection (OSPF/VRRP) n/a n/a n/a n/a KB.16.01 KB.16.01 (V3 only)

BFD: Bidirectional Forwarding Detection (Static Routes) n/a n/a n/a n/a KB.16.04.0008
KB.16.04.0008 (V3 
only)

BGP: Border Gateway Protocol n/a n/a n/a n/a KB.16.01 KB.15.15
BGP: MD5 Authentication n/a n/a n/a n/a KB.16.01 KB.15.15
BGP: Route Filtering and Peer Restart Time Display n/a n/a n/a n/a KB.16.01 KB.15.15
BGP: Route Maps n/a n/a n/a n/a KB.16.01 KB.15.15
BGP: BGP-4 n/a n/a n/a n/a KB.16.01 KB.15.16
mDNS (Bonjour and Chromecast) Gateway YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Disable Overlapping Subnet Configuration YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
ECMP (Equal Cost Multipath) n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
ECMP with Static Routes n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Identification Field in Static Route Config YA.15.13/YB.15.13 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
IGMP v3 and MLD v2 Capabilities  (YA only supports MLD v1) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

Improved Log Commands and Output for OSPFv2 Troubleshooting n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.15.15
IPv6 Default gateway for OOBM n/a n/a n/a WC.16.04.0008 KB.16.04.0008 KB.16.04.0008
IPv6 Default Router Preference n/a n/a WC.16.04.0008 WC.16.04.0008 KB.16.04.0008 KB.16.04.0008

IPv6 over IPv4 Tunneling n/a n/a n/a n/a KB.16.01 KB.15.15
IPv6 Static Route Tag n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KA.15.16
IRDP n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Multicast: Block Unknown Multicast YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Multicast: IP Multicast snooping (Data Driven IGMP) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Multicast: IGMP v3 n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Multicast: IPv6 MLD Multicast Snooping YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Multi-Netting YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
OSPF (2930F & 2930M only support single-area OSPF) n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.15.15
OSPF ECMP n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.15.15
OSPF Global Cost Setting n/a n/a WC.16.05 WC.16.05 KB.16.05 KB.16.05

OSPF LSA Type 3 Summarized Prefix Cost n/a n/a n/a n/a KB.16.01 KB.15.15

OSPF LSA Type 3 Summarized Prefix Cost for OSPF v3 n/a n/a n/a n/a KB.16.01 KB.15.15
OSPF Neighbor Shutdown Notification n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.15.15
OSPF Neighbor Timer Information Display n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.15.15
OSPF NSSA Range Metrics added to OSPFv2 n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.15.15
OSPF/VRRP Nonstop Routing added to Management Failover n/a n/a WC.16.03.0003 WC.16.04.0004 KB.16.01 KB.15.15
OSPFv2 config Metric Cost/Range n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.15.15
OSPFv3 n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.15.15
OSPFv3 over 6-in-4 Tunnels n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.15.15
OSPFv3 Trap Global Enable/Disable n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.15.16
PIM: Override Reverse Path Forward (RPF) Lookup n/a n/a WC.16.03.0003 WC.16.04.0004 KB.16.01 KB.15.15
PIM: 'router pim' Command Enhancements n/a n/a WC.16.03.0003 WC.16.04.0004 KB.16.01 KB.15.15
PIM-DM n/a n/a WC.16.03.0003 WC.16.04.0004 KB.16.01 KB.15.15
PIM-SM n/a n/a WC.16.03.0003 WC.16.04.0004 KB.16.01 KB.15.15
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PIMv6 SM and DM n/a n/a WC.16.05 WC.16.05 KB.16.05 KB.16.05
Policy-Based Routing (PBR) n/a n/a WC.16.03.0003 WC.16.04.0004 KB.16.01 KB.15.15
RIP v1/v2 n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RIP v2 with MD5 Authentication n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.18
RIPng n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Router Advertisement (RA) Guard n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Service Insertion: Intercept Tunnels n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Service Insertion: Mirror Tunnels n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.17
Show IP Route Summary n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Static Blackhole or Reject Routes Redistribution into RIP n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Static Routes n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Tunneled Node (per port) n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.02 KB.16.02
Tunneled Node (per user) n/a n/a WC.16.04.0008 WC.16.04.0008 KB.16.04.0008 KB.16.04.0008
Tunneled Node: Fallback to local switching n/a n/a WC.16.02.0011 WC.16.04.0004 KB.16.02.0011 KB.16.02.0011
UDP Broadcast Forwarding n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Virtual Router Redundancy Protocol (VRRP) n/a n/a WC.16.03.0003 WC.16.04.0004 KB.16.01 KB.15.15
VRRP Preemptive Delay Timer n/a n/a WC.16.03.0003 WC.16.04.0004 KB.16.01 KB.15.15
VRRP Track Ports & Dynamic Priority Change n/a n/a WC.16.03.0003 WC.16.04.0004 KB.16.01 KB.15.15
VRRPv3 n/a n/a WC.16.03.0003 WC.16.04.0004 KB.16.01 KB.15.15
VRRP: Support for Self-Ping, Telnet, SSH, Web GUI n/a n/a WC.16.06 WC.16.06 KB.16.06 KB.16.06

Security
802.1v Protocol VLANs YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
802.1X and RADIUS Login (Port-Based Access) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
AAA Authorization on HTTPS (T5) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
ACL Grouping n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
ACL: Access Control List YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
ACL: Logging Match YA.15.15/YB.15.15 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
ACL: MAC ACLs n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.18
ACL: Rule added to IP Directed Broadcast n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.18
Advanced Threat Detection YA.16.05/YB.16.05 YC.16.05 WC.16.05 WC.16.05 KB.16.05 KB.16.05
Device Fingerprinting with ClearPass n/a n/a WC.16.06 WC.16.06 KB.16.06 KB.16.06

Cached Re-authentication (Hold State if RADIUS Server Unavailable) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Concurrent 802.1x, WebAuth, and MacAuth YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Concurrent TACACS+ and SFTP YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
DHCP Snooping YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

DHCP Snooping: CLI to clear DSnoop Counter
YA 16_03_001.SWI/YB 
16_03_001.SWI YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

DHCP Snooping: DHCPv4 Snooping Max Binding YA.15.14/YB.15.14 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

DHCP Snooping: DHCPv6 Snooping
YA.15.16/YB.15.16

YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.16
Dynamic ARP Protection YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Dynamic IP Lockdown YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Egress ACLs n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.18
IPv6 Protocol VLANs YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Local MAC Authentication YA.15.16/YB.15.16 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Local User Roles YA.16.02 YC.16.02.0012 WC.16.02.0008 WC.16.04.0004 KB.16.02 KB.16.02
Downloadable User Roles n/a YC.16.04 WC.16.04 WC.16.04 KB.16.04 KB.16.04
Downloadable User Roles 
with Secondary Role Pushed to Controller n/a n/a WC.16.05 WC.16.05 KB.16.05 KB.16.05
MAC Authentication YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
MAC Authentication: Client Limit Increased to 256 n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
MAC Authentication: Hitless Re-Authentication YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
MAC Authentication:  Port-based YA.16.02/YB.16.02 YC.16.02.0012 WC.16.02.0008 WC.16.04.0004 KB.16.02 KB.16.02
MAC Authentication Toggle YA.16.02/YB.16.02 YC.16.02.0012 WC.16.02.0008 WC.16.04.0004 KB.16.02 KB.16.02
MAC Authentication: Unauth-Redirect YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
MAC-based VLANs (MBV) YA.15.14 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
MAC-based VLANs: Controlling MBV via CLI for NAC n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.16
MAC Pinning YA.16.05/YB.16.05 n/a WC.16.05 WC.16.05 KB.16.05 KB.16.05
MACSec: SmartRate Modules n/a n/a n/a WC.16.04.0004 KB.16.01 KB.15.18
MACSec: V3 only n/a n/a n/a WC.16.04.0004 KB.16.01 KB.15.17
Multiple 802.1X Clients Per Port YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
ND Snooping n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Open Authentication Roles n/a n/a WC.16.05 WC.16.05 KB.16.05 KB.16.05
Critical Authentication Roles n/a n/a WC.16.05 WC.16.05 KB.16.05 KB.16.05
Password Complexity YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Port Monitoring YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Port Security (MAC Lockdown) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Port Security (MAC Lockout) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Port Security Auto Recovery n/a n/a WC.16.06 WC.16.06 KB.16.06 KB.16.06
Protocol Based VLANs YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Private VLAN n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
RBAC: Role Based Access Control n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
RADIUS YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RADIUS Assigned ACLs YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RADIUS Assigned GVRP VLANs YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RADIUS Attributes for QoS and Rate-Limiting YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RADIUS Authenticated mgr Level Login YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RADIUS Authentication for Browser Access YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RADIUS Configuration via SNMP YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RADIUS for 802.1X Accounting YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RADIUS IPv6 YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RADIUS Port Speed VSA n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RADIUS Service Tracking YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Source Port Filter YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SSH Client YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

SSH Re-key (Government Certification) n/a n/a WC.16.04.0008 WC.16.04.0008 KB.16.04.0008 KB.16.04.0008
Static IP Lockdown n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
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Synchronization for 802.1X Supplicants  (for Nonstop Switching) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
TACACS+ YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

User Lockout (Government Certification) n/a n/a WC.16.04.0008 WC.16.04.0008 KB.16.04.0008 KB.16.04.0008
Virus Throttling (Connection Rate Filtering) n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Web-based Authentication YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

Supportability
Debug Command for PIM Packet Events Added n/a n/a n/a n/a KB.16.01 KB.15.15
Flight Data Recorder Log n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.02 KB.15.15
LACP Debug Logging and Show Commands YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.02 KB.15.15
Preview Mode n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01

Time Domain Reflectometry (SmartRate modules not supported) n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.02
KB.16.01
(V3 only)

Supportability Infrastructure: 
User Initiated Diagnostic Reset via Clear button YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Supportability Infrastructure: 
User Initiated Diagnostic Reset via Serial Console YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
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Bridging
Data Link Detection Protocol (DLDP) WB.15.17 RA.15.17 KA.15.17
Distributed Trunking PIM-DM n/a n/a KA.15.17
Distributed Trunking PIM-SM n/a n/a KA.15.18
Distributed Trunking Primary/Secondary Configuration n/a n/a KA.15.11
Distributed Trunking Switch to Server n/a n/a KA.15.09
Distributed Trunking Switch to Switch n/a n/a KA.15.16
GVRP WB.15.11 RA.15.05 KA.15.03
LACP (802.3ad) WB.15.11 RA.15.05 KA.15.03
LACP Key for Controlling Dynamic Trunk Configuration WB.15.11 RA.15.05 KA.15.09
LACP MAD WB.15.14 n/a KA.15.14
LACP Trunk Load Balancing Information Output WB.15.11 RA.15.05 KA.15.09
LLDP (802.1ab) WB.15.11 RA.15.05 KA.15.03
LLDP MED (Media Endpoint Discovery) WB.15.11 RA.15.05 KA.15.03
LLDP PoE+ Support WB.15.11 RA.15.05 KA.15.03
LLDP over OOBM WB.16.01 n/a KA.16.01
LLDP TLV WB.15.11 RA.15.05 KA.15.03
Loop Protection WB.15.11 RA.15.05 KA.15.03
MAX VLANs: 512 n/a RA.15.05 n/a
MAX VLANs: 1K WB.16.01 n/a n/a
MAX VLANs: 2K n/a n/a n/a
MAX VLANs: 4K n/a n/a KA.16.01
Meshing: Concurrent Meshing and Routing n/a n/a KA.15.09
Meshing: Mesh ID Configuration n/a n/a KA.15.07
Meshing: Switch Meshing n/a n/a KA.15.03
MVRP: Multiple VLAN Registration Protocol WB.16.01 RA.16.01 KA.16.01
Q-in-Q n/a n/a KA.15.03
Single Instance (802.1d-1998) WB.15.11 RA.15.05 KA.15.03
SmartLink WB.15.14 RA.15.14 KA.15.14
Spanning tree: BPDU Filtering WB.15.11 RA.15.05 KA.15.03
Spanning tree: BPDU Protection WB.15.11 RA.15.05 KA.15.03
Spanning tree: Fast Mode WB.15.11 RA.15.05 KA.15.03
Spanning tree: Loop Guard WB.15.11 RA.15.05 KA.15.09
Spanning tree: Multiple STP (802.1s Standards Compliant) WB.15.11 RA.15.05 KA.15.03
Spanning tree: 64 MSTP instances n/a n/a KA.16.01
Spanning tree: PVST Protection and Filtering WB.15.11 RA.15.05 KA.15.03
Spanning tree: PVST+ Compatibility WB.15.11 RA.15.05 KA.15.03
Spanning tree: Rapid STP (802.1w Standards Compliant) WB.15.11 RA.15.05 KA.15.03
Spanning tree: Root Guard WB.15.11 RA.15.05 KA.15.03
Trunking: Enable using TCP/UDP Port Numbers for Trunk Load-
Balancing WB.15.11 RA.15.05 KA.15.09
Trunking: Link Aggregation WB.15.11 RA.15.05 KA.15.03
UDLD: Uni-Directional Link Detection WB.15.11 RA.15.05 KA.15.03
UDLD: Verify Before Forwarding WB.15.16 RA.15.05 KA.15.16
UFD: Uplink Failure Detection WB.15.11 n/a KA.15.09
VxLAN n/a n/a n/a
Wake-on-LAN for a Specific VLAN WB.15.11 RA.15.05 KA.15.09
Management
802.1ap Std MIB Support WB.15.11 RA.15.09 KA.15.09

802.3bz compliance (2.5 Gbps and 5.0 Gbps) for Smart Rate ports n/a n/a n/a
100Mbps support on SmartRate ports n/a n/a n/a
IPSec to Controller for Management Traffic WB.16.02 n/a KA.16.02

IPSec for Management Traffic (with secondary controller support) WB.16.06 n/a n/a
ARP Attack Detection WB.16.01 n/a KA.16.01
Auto-MDI-X WB.15.11 RA.15.05 KA.15.03
Banner: Post-Logon User-Configurable Banner Display WB.15.11 RA.15.05 KA.15.03
Bidirectional Secure Copying Between Switch and SFTP Server WB.15.11 RA.15.05 KA.15.09
BOOTP/DHCP Relay Gateway WB.15.11 RA.15.05 KA.15.03
BPDU-Throttle WB.15.16 n/a KA.15.16
BYOD Redirect WB.15.16 RA.15.16 KA.15.16
Captive Portal for ClearPass WB.16.01 RA.16.01 KA.16.01
Chassislocate LED at Boot WB.15.11 RA.15.05 KA.15.14
Clarify Port VLAN Tagged Status WB.15.12 RA.15.12 KA.15.12
Clear Module Configuration n/a n/a n/a
CLI Return Message Category (Error; Warning; Information) WB.15.11 RA.15.05 KA.15.03
Compliance with IEEE Standard for MIB Object ieee8021MstpMib WB.15.11 RA.15.06 KA.15.06
Comware CLI Support WB.15.13 RA.15.11 KA.15.08
Config Backup and Restore without Reboot WB.16.05
Config Menu WB.15.11 RA.15.05 KA.15.03
Control Plane Protection WB.15.18 n/a KA.15.14
Control Plane Policing (CoPP) n/a n/a n/a
Custom Default Switch Configuration WB.15.11 RA.15.05 KA.15.12
Customized Commands for Local User Accounts WB.15.11 RA.15.05 KA.15.09
Device Profile: Auto configuration for Aruba APs/Switches WB.16.01 RA.16.01 KA.16.01
Device Profile: Auto configuration for Custom device types WB.16.01 n/a n/a
DHCP Client DNS Support WB.15.11 RA.15.07 KA.15.07
DHCPv6 Client Options WB.15.11 RA.15.05 KA.15.09
DHCP Option 82 WB.15.11 RA.15.05 KA.15.03
DHCP Option 60 and 150 n/a n/a n/a
DHCP Relay WB.15.11 RA.15.05 KA.15.03
DHCPv6 Relay WB.15.11  RA.15.05 KA.15.03
DHCPv6 Relay Option 79 WB.15.16  RA.16.01 KA.15.16
Disable IP Address on a VLAN Without Deleting the Address WB.15.11 RA.15.10 KA.15.09

Disable Username Prompt for Management Interface Authentication
WB.15.15 RA.15.15 KA.15.15

Display Configuration of Selected Interface WB.15.11 RA.15.05 KA.15.03
Display Transceiver WB.15.11 RA.15.07 KA.15.09
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Display Transceiver Information for Transceiver Cable Diagnostics
WB.15.11 RA.15.07 KA.15.06

DNS Capabilities for Telnet WB.15.11 RA.15.05 KA.15.03
Dual Flash Images WB.15.11 RA.15.05 KA.15.03
Encoded Version Info Added to Config Files WB.15.11 RA.15.05 KA.15.09
Encrypt Passwords and Authentication Keys in the Config File WB.15.11 RA.15.06 KA.15.09
Event Log: Severity Change WB.15.11 RA.15.12 KA.15.12
Event Log Buffer: Configurable threshold for SNMP traps n/a n/a n/a
Fastboot WB.15.11 RA.15.05 KA.15.03
Fault Finder Extended to Cover Flapping Transceiver Mitigation WB.15.11 RA.15.05 KA.15.03
Fault Finder (Per Port Enable) n/a n/a KA.16.01
Filtering PVID Mismatch Log Message WB.15.15 RA.15.14 KA.15.14
Find-Fix-and-Inform WB.15.11 RA.15.05 KA.15.03
Flow Control (802.3x) WB.15.11 RA.15.05 KA.15.03
Generic Header ID in Config File WB.15.16 RA.15.16 KA.15.16
Grouped Config File Display per Interface WB.15.11 RA.15.08 KA.15.08
ICMP Throttling WB.15.11 RA.15.05 KA.15.03
IP Forwarding MIB WB.15.17 RA.15.17 KA.15.17
IP Service Level Agreement (SLA) WB.16.02 n/a KA.16.02
IP Stacking n/a RA.15.05 n/a
IPv6 DNS via RA Options WB.15.11 RA.15.10 KA.15.10
IPv6 Host (Dual Stack) WB.15.11 RA.15.05 KA.15.03
Local Management Privilege Groups WB.15.11 RA.15.05 KA.15.09
MAC Limit Notify WB.15.11 RA.15.10 KA.15.09
Management Interface Wizard WB.15.11 RA.15.05 KA.15.03
Minimum Password Length WB.15.15 RA.15.15 KA.15.15
Module Reload n/a n/a n/a
MS-CHAPv2 for Switch Management Interface WB.15.11 RA.15.05 KA.15.03
Multiple Configuration Files WB.15.11 RA.15.05 KA.15.03
NTP: Network Time Protocol WB.16.01 RA.16.01 KA.16.01
OOBM: IPv6 Host Function WB.15.11 n/a KA.15.03
Avoid double tunneling of Aruba APs on Tunneled Node n/a
PTP (Precision Time Protocol) IEEE 1588 n/a n/a n/a
Readable Interface Names in Traps WB.15.11 RA.15.05 KA.15.12
Reinterpret CDP Info when Using IP Phones WB.15.11 RA.15.05 KA.15.10
Report Config Changes Per-User Per-Session WB.15.11 RA.15.05 KA.15.07
REST APIs WB.16.01 RA.16.01 KA.16.01
Retain configuration on 5400R 
when switching from v3-only to v-2 compatible mode

n/a n/a n/a

RMON WB.15.11 RA.15.05 KA.15.03
RMON: Extended RMON WB.15.11 RA.15.05 KA.15.03
RMON: Local Alarm Threshold WB.15.13 RA.15.13 KA.15.13
Save Running Configuration to TFTP via SNMP WB.15.11 RA.15.05 KA.15.03
Saving Security Credentials in a Configuration File WB.15.11 RA.15.05 KA.15.03
Scheduled Reload WB.15.11 RA.15.05 KA.15.03
Secure FTP WB.15.11 RA.15.05 KA.15.03
Secure Shell v2 (SSHv2) WB.15.11 RA.15.05 KA.15.03
Secure Sockets Layer (SSL) WB.15.11 RA.15.05 KA.15.03
Send syslog Messages via TCP WB.15.11 RA.15.10 KA.15.09
sFlow WB.15.11 RA.15.05 KA.15.03
sFlow Data over OOBM WB.15.11 n/a KA.15.13
sFlow Set Agent Address WB.15.11 RA.15.10 KA.15.07
sFlow Using IPv6 n/a RA.15.10 KA.15.07
Single Source IP Identity WB.15.11 RA.15.10 KA.15.03
SNMP v1/v2c/v3/v3 with AES WB.15.11 RA.15.05 KA.15.03
SNMP: Enable SNMP Trap when Switch Config Changes WB.15.11 RA.15.05 KA.15.09
SNMP: MIB to Check Load of Module Slots WB.15.11 n/a KA.15.10
SNMP: Password Set via SNMP WB.15.11 RA.15.05 KA.15.03
SNMP: Server Source IP Commands WB.15.11 RA.15.05 KA.15.03
SNMP: Trap if MAC Address Add to or Delete from a Port WB.15.11 RA.15.05 KA.15.09
SNMP: Trap on MAC Address Table Changes WB.15.14 RA.15.14 KA.15.14
SNMP: Trap on Power Supply Removal WB.15.14 RA.15.14 KA.15.14
SNMP: Trap Throttling WB.15.13 RA.15.13 KA.15.13
SNTP: Simple Network Time Protocol WB.15.11 RA.15.05 KA.15.03
Syslog Config Change Reporting WB.15.11 RA.15.10 KA.15.09
Syslog over TLS WB.15.15 RA.15.16 KA.15.15
Syslog: Disable Debug without Affecting Syslog WB.15.13 RA.15.13 KA.15.13
Syslog: Per-Interface Syslog Event Enable-Disable WB.15.11 RA.15.05 KA.15.13
Sysname in Syslog Messages WB.15.15 RA.15.15 KA.15.15
TFTP & SSH Concurrent Usage WB.15.15 RA.15.05 KA.15.18
TFTP Uploadable Configuration WB.15.11 RA.15.05 KA.15.03
Transceivers - Diagnostic Optical Monitoring 
(show interface transceiver detail) WB.15.11 RA.15.07 KA.15.07
Username and Password Length Increase WB.15.11 RA.15.05 KA.15.03
VLAN information added to 'show mac-address' Output WB.15.11 RA.15.05 KA.15.09
VSF: Virtual Switch Framework n/a n/a n/a
VSF 8-member Stack (2930F only) n/a n/a n/a
Web GUI WB.15.11 RA.15.05 KA.15.03
Web GUI Inactivity Timer WB.15.15 RA.15.15 KA.15.15
Next-Gen Web GUI WB.16.03.0003 RA.16.03 KA.16.03.0003
ZTP with TR-69 WB.15.18 RA.15.16 n/a
ZTP with DHCP WB.16.01 n/a KA.16.01
ZTP with DHCPv6 n/a n/a n/a
ZTP for Activate WB.16.02 n/a KA.16.02
HTTP Proxy Support WB.16.06 n/a n/a
Job Scheduler WB.16.01 RA.16.01 KA.16.01
DHCPv4 Server WB.15.16 RA.15.16 KA.15.16
DHCPv6 Server WB.15.16 RA.15.16 KA.15.16
Console Lockout n/a n/a n/a
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OpenFlow
OpenFlow 1.0 WB.15.12 n/a KA.15.10
OpenFlow 1.3 WB.15.14 n/a KA.15.14
Openflow: Custom Matches n/a n/a n/a
OpenFlow: L4 Match WB.15.18 n/a KA.15.18
OpenFlow: MacGroups WB.15.18 n/a KA.15.18
Openflow: Source IP specification WB.16.05
OpenFlow: TCP Flags and L4 port ranges in Custom Match Mode n/a n/a n/a
Power
Energy Efficient Ethernet (EEE) WB.15.11 n/a KA.15.03
External Power Support  (EPS) WB.15.13 RA.15.05 n/a
Hibernate mode n/a n/a n/a
Power over Ethernet (POE) (802.3af) WB.15.11 RA.15.05 KA.15.03
Power over Ethernet Plus (POE+) (802.3at) WB.15.11 n/a KA.15.03
Redundant Power Support WB.15.13 RA.15.05 KA.15.03
Priority/Quality of Service (QoS)
Broadcast Control WB.15.11 RA.15.05 KA.15.03
Broadcast Storm Control WB.15.15 n/a KA.15.15
Classifier-Based QoS and Rate Limiting WB.15.11 n/a KA.15.03
Egress Port Monitoring (Outbound) n/a n/a KA.15.03
ICMP Rate Limiting WB.15.11 RA.15.05 KA.15.03
Inbound Rate-Limiting for Broadcast and Multicast Traffic WB.15.11 RA.15.05 KA.15.03
Layer 4 TCP/UDP Packet Priority WB.15.11 RA.15.05 KA.15.03
Mirroring: MAC based Mirroring n/a n/a KA.15.03
Mirroring: MAC based Remote Mirroring n/a n/a KA.15.03
Mirroring: no VLAN Tag added n/a n/a KA.15.03
Mirroring: Port WB.15.11 RA.15.05 KA.15.03
Mirroring: Remote n/a n/a KA.15.03
Multicast Storm Control n/a n/a n/a
QoS: Class of Service (CoS) WB.15.11 RA.15.05 KA.15.03
QoS: Egress Queue Rate-limiting WB.15.15 n/a KA.15.15
QoS: Guaranteed Minimum Bandwidth WB.15.11 n/a KA.15.03
QoS: IPv6 QoS WB.15.11 RA.15.14 KA.15.03

QoS: Monitor Egress Queues for Dropped Packets if QoS Configured WB.15.11 RA.15.05 KA.15.09
QoS: Netdestinations and Netservices WB.16.03 n/a n/a
QoS: Packet Priority (802.1p) WB.15.11 RA.15.05 KA.15.03
QoS: Per Port Trust WB.16.02 RA.16.02 KA.16.02
QoS: Port and Priority-based Rate Limiting WB.15.11 RA.15.05 KA.15.03
QoS: Priority Queuing WB.15.11 RA.15.05 KA.15.03
QoS: Selectable Queuing Configurations WB.15.11 RA.15.05 KA.15.03
QoS: Strict Priority Queuing WB.15.11 n/a KA.15.12
QoS: TCP/UDP Port Ranges WB.15.11 RA.15.05 KA.15.03
QoS: Traffic Template n/a n/a n/a
QoS: Turn on/off VLAN Precedence WB.15.11 RA.15.05 KA.15.16
QoS: VLAN Port-Based Prioritization (802.1p) WB.15.11 RA.15.05 KA.15.03
Rate Limiting WB.15.11 RA.15.05 KA.15.03
Rate Limiting Unknown Unicast Traffic n/a n/a n/a
Traffic Policing (with two rate three color marker) n/a n/a n/a
Routing and Multicast
ARP Age Timer Increase WB.15.11 RA.15.05 KA.15.03
BFD: Bidirectional Forwarding Detection (OSPF/VRRP) n/a n/a n/a
BFD: Bidirectional Forwarding Detection (Static Routes) n/a n/a n/a
BGP: Border Gateway Protocol n/a n/a KA.15.09
BGP: MD5 Authentication n/a n/a KA.15.09
BGP: Route Filtering and Peer Restart Time Display n/a n/a KA.15.09
BGP: Route Maps n/a n/a KA.15.09
BGP: BGP-4 n/a n/a KA.15.16
mDNS (Bonjour and Chromecast) Gateway WB.16.01  RA.15.09 KA.16.01
Disable Overlapping Subnet Configuration WB.15.11 RA.15.09 KA.15.09
ECMP (Equal Cost Multipath) WB.15.11 RA.15.05 KA.15.03
ECMP with Static Routes WB.15.11 RA.15.05 KA.15.03
Identification Field in Static Route Config WB.15.13 RA.15.13 KA.15.13
IGMP v3 and MLD v2 Capabilities  (YA only supports MLD v1) WB.15.11  n/a KA.15.09

Improved Log Commands and Output for OSPFv2 Troubleshooting WB.16.02 n/a KA.15.09
IPv6 Default gateway for OOBM WB.16.04.0008 n/a KA.16.04.0008
IPv6 Default Router Preference WB.16.04.0008 n/a KA.16.04.0008
IPv6 over IPv4 Tunneling n/a n/a KA.15.06
IPv6 Static Route Tag WB.15.16 n/a KA.15.16
IRDP WB.15.11 RA.15.05 KA.15.03
Multicast: Block Unknown Multicast WB.15.11 RA.15.05 KA.15.09
Multicast: IP Multicast snooping (Data Driven IGMP) WB.15.11 RA.15.05 KA.15.03
Multicast: IGMP v3 WB.16.01 n/a KA.16.01
Multicast: IPv6 MLD Multicast Snooping WB.15.11 RA.15.05 KA.15.03
Multi-Netting WB.15.11 RA.15.05 KA.15.03
OSPF (2930F & 2930M only support single-area OSPF) WB.16.02 n/a KA.15.03
OSPF ECMP WB.16.02 n/a KA.15.03
OSPF Global Cost Setting n/a
OSPF LSA Type 3 Summarized Prefix Cost n/a n/a KA.15.09
OSPF LSA Type 3 Summarized Prefix Cost for OSPF v3 n/a n/a KA.15.09
OSPF Neighbor Shutdown Notification WB.16.02 n/a KA.15.09
OSPF Neighbor Timer Information Display WB.16.02 n/a KA.15.09
OSPF NSSA Range Metrics added to OSPFv2 WB.16.02 n/a KA.15.09
OSPF/VRRP Nonstop Routing added to Management Failover WB.16.02 n/a KA.15.09
OSPFv2 config Metric Cost/Range WB.16.02 n/a KA.15.09
OSPFv3 WB.16.02 n/a KA.15.03
OSPFv3 over 6-in-4 Tunnels n/a n/a KA.15.09
OSPFv3 Trap Global Enable/Disable WB.16.02 n/a KA.15.16
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PIM: Override Reverse Path Forward (RPF) Lookup n/a n/a KA.15.09
PIM: 'router pim' Command Enhancements n/a n/a KA.15.09
PIM-DM n/a n/a KA.15.03
PIM-SM n/a n/a KA.15.03
PIMv6 SM and DM n/a
Policy-Based Routing (PBR) n/a n/a KA.15.09
RIP v1/v2 WB.15.11 RA.15.05 KA.15.03
RIP v2 with MD5 Authentication WB.15.18 RA.15.18 KA.15.18
RIPng WB.16.01 n/a KA.16.01
Router Advertisement (RA) Guard WB.15.11 n/a KA.15.09
Service Insertion: Intercept Tunnels WB.15.15 n/a KA.15.15
Service Insertion: Mirror Tunnels WB.15.17 n/a KA.15.17
Show IP Route Summary WB.15.11 RA.15.07 KA.15.09
Static Blackhole or Reject Routes Redistribution into RIP WB.15.11 n/a KA.15.09
Static Routes WB.15.11 RA.15.05 KA.15.03
Tunneled Node (per port) WB.16.02 n/a KA.16.02
Tunneled Node (per user) n/a n/a n/a
Tunneled Node: Fallback to local switching WB.16.02.0011 n/a KA.16.02.0011
UDP Broadcast Forwarding WB.15.11 RA.15.05 KA.15.03
Virtual Router Redundancy Protocol (VRRP) n/a n/a KA.15.03
VRRP Preemptive Delay Timer n/a n/a KA.15.03
VRRP Track Ports & Dynamic Priority Change n/a n/a KA.15.03
VRRPv3 n/a n/a KA.15.13
VRRP: Support for Self-Ping, Telnet, SSH, Web GUI n/a n/a n/a
Security
802.1v Protocol VLANs WB.15.11 RA.15.05 KA.15.03
802.1X and RADIUS Login (Port-Based Access) WB.15.11 RA.15.05 KA.15.03
AAA Authorization on HTTPS (T5) WB.15.11 RA.15.05 KA.15.03
ACL Grouping  n/a n/a KA.16.01
ACL: Access Control List WB.15.11 RA.15.05 KA.15.03
ACL: Logging Match WB.15.11 RA.15.05 KA.15.09
ACL: MAC ACLs n/a n/a n/a
ACL: Rule added to IP Directed Broadcast WB.15.18 RA.15.18 KA.15.18
Advanced Threat Detection WB.16.05 n/a n/a
Device Fingerprinting with ClearPass n/a n/a n/a

Cached Re-authentication (Hold State if RADIUS Server Unavailable) WB.15.11 RA.15.05 KA.15.03
Concurrent 802.1x, WebAuth, and MacAuth WB.15.11 RA.15.05 KA.15.03
Concurrent TACACS+ and SFTP WB.15.11 RA.15.05 KA.15.03
DHCP Snooping WB.15.11 RA.15.05 KA.15.03
DHCP Snooping: CLI to clear DSnoop Counter WB.15.13  RA.16.03.0001 KA.15.13
DHCP Snooping: DHCPv4 Snooping Max Binding WB.15.14  RA.15.14 KA.15.14
DHCP Snooping: DHCPv6 Snooping WB.15.16 RA.15.16 KA.15.16
Dynamic ARP Protection WB.15.11 RA.15.05 KA.15.03
Dynamic IP Lockdown WB.15.11 RA.15.05 KA.15.03
Egress ACLs WB.15.18 n/a KA.15.18
IPv6 Protocol VLANs WB.15.11 RA.15.05 KA.15.03
Local MAC Authentication WB.15.14 RA.15.16 KA.15.14
Local User Roles WB.16.02 RA.16.02 KA.16.02
Downloadable User Roles WB.16.04 n/a n/a
Downloadable User Roles 
with Secondary Role Pushed to Controller n/a n/a n/a
MAC Authentication WB.15.11 RA.15.05 KA.15.03
MAC Authentication: Client Limit Increased to 256 n/a n/a KA.15.03
MAC Authentication: Hitless Re-Authentication WB.15.11 RA.15.05 KA.15.03
MAC Authentication:  Port-based WB.16.02 RA.16.02 KA.16.02
MAC Authentication Toggle WB.16.02 RA.16.02 KA.16.02
MAC Authentication: Unauth-Redirect WB.15.11 RA.15.05 KA.15.03
MAC-based VLANs (MBV) WB.15.14 RA.15.10 KA.15.09
MAC-based VLANs: Controlling MBV via CLI for NAC WB.15.16 n/a KA.15.16
MAC Pinning WB.16.05
MACSec: SmartRate Modules n/a n/a n/a
MACSec: V3 only n/a n/a n/a
Multiple 802.1X Clients Per Port WB.15.11 RA.15.05 KA.15.03
ND Snooping WB.16.01 n/a KA.16.01
Open Authentication Roles n/a
Critical Authentication Roles n/a
Password Complexity WB.16.01 RA.16.01 KA.16.01
Port Monitoring WB.15.11 RA.15.05 KA.15.03
Port Security (MAC Lockdown) WB.15.11 RA.15.05 KA.15.03
Port Security (MAC Lockout) WB.15.11 RA.15.05 KA.15.03
Port Security Auto Recovery n/a n/a n/a
Protocol Based VLANs WB.15.11 RA.15.05 KA.15.03
Private VLAN WB.16.01 n/a KA.16.01
RBAC: Role Based Access Control WB.16.01 n/a KA.16.01
RADIUS WB.15.11 RA.15.05 KA.15.03
RADIUS Assigned ACLs WB.15.11 RA.15.05 KA.15.03
RADIUS Assigned GVRP VLANs WB.15.11 RA.15.05 KA.15.03
RADIUS Attributes for QoS and Rate-Limiting WB.15.11 RA.15.05 KA.15.03
RADIUS Authenticated mgr Level Login WB.15.11 RA.15.05 KA.15.03
RADIUS Authentication for Browser Access WB.15.11 RA.15.05 KA.15.03
RADIUS Configuration via SNMP WB.15.11 RA.15.05 KA.15.03
RADIUS for 802.1X Accounting WB.15.11 RA.15.05 KA.15.03
RADIUS IPv6 WB.15.12 RA.15.12 KA.15.12
RADIUS Port Speed VSA WB.15.13 n/a KA.15.13
RADIUS Service Tracking WB.16.01 RA.16.01 KA.16.01
Source Port Filter WB.15.11 RA.15.05 KA.15.03
SSH Client WB.15.11 RA.15.05 KA.15.09
SSH Re-key (Government Certification)  n/a  n/a  n/a
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Static IP Lockdown WB.15.11 RA.15.05 KA.15.03

Synchronization for 802.1X Supplicants  (for Nonstop Switching) WB.15.11 RA.15.05 KA.15.03
TACACS+ WB.15.11 RA.15.05 KA.15.03
User Lockout (Government Certification) WB.16.04.0008  n/a n/a
Virus Throttling (Connection Rate Filtering) n/a n/a KA.15.03
Web-based Authentication WB.15.11 RA.15.05 KA.15.03
Supportability
Debug Command for PIM Packet Events Added n/a n/a KA.15.09
Flight Data Recorder Log WB.15.12 n/a KA.15.09
LACP Debug Logging and Show Commands WB.15.11 RA.15.06 KA.15.09
Preview Mode WB.16.04 n/a n/a
Time Domain Reflectometry  (SmartRate modules not supported) WB.16.04.0008 n/a n/a
Supportability Infrastructure: 
User Initiated Diagnostic Reset via Clear button WB.16.01 RA.16.01 KA.16.01
Supportability Infrastructure: 
User Initiated Diagnostic Reset via Serial Console WB.16.01 RA.16.01 KA.16.01

Software Support
Minimum

SW Version 

AirWave (ZTP, configuration, software update) 8.2.1

AirWave over IPSec 8.2.1

Aruba Central n/a

Aruba Activate n/a

Aruba Activate Firmware Upgrade n/a

Aruba Controller (70xx & 72xx series) 6.5

VAN Controller (SDN) 2.8.8.0366
Network Optimizer 1.5.4.109
Network Protector 1.5.5.39
Network Visualizer 1.2.7.164

IMC 7.2

ClearPass (CoA Port Bounce, Captive Portal) 6.6.0

All software version references to 16.07 are for 16.07.0001

HPE Part Number 5200-5376 
Published: October 2018
Edition: 1

To help us improve the documentation, send any errors, suggestions, 
or comments to docsfeedback@hpe.com.

© Copyright 2015-2018 Hewlett Packard Enterprise Development LP 

The information contained herein is subject to change without notice. 
The only warranties for Hewlett Packard Enterprise products and 
services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be 
construed as constituting an  additional warranty. Hewlett Packard 
Enterprise shall not be liable for technical or editorial errors or 
omissions contained herein.

ClearPass version 6.7.0 is required for 
Advanced Threat Detection 

2920, 2930F, 2930M, 3800, 3810, 5400R v2/v3
2530, 2540, 2620, 2920, 2930F, 2930M, 3800, 3810, 
5400R 2930M requires at least 7.3 E0503

2920, 2930F, 2930M, 3800, 3810, 5400R v2/v3

2530, 2540, 2620, 2920, 2930F, 2930M, 3800, 3810, 
5400R v2/v3

2920, 2930F, 2930M, 3800, 3810, 5400R v2/v3
2920, 2930F, 2930M, 3800, 3810, 5400R v2/v3

2920, 2930F, 2930M, 3800, 3810, 5400R

Switches manufactured as of February 2016.

2530, 2540, 2920, 2930F, 2930M, 3800, 3810, 
5400Rzl

Switches manufactured as of February 2016 
except 5400R zl2, which is as of June 2016.

2530,2920, 2930F, 2930M, 2540, 3800, 3810, 5400R 
zl

2530, 2540, 2920, 2930F, 2930M, 3810,5400R(only 
Template),2920-Stk(16.04), 2930M-
Stk(16.06), 5400R_VSF(16.06.0008)

Comments

2530, 2540, 2620, 2920, 2930F, 2930M, 3800, 3810, 
5400R v2/v3 2530 >=8.2.1.1,  2930M >=8.2.4

2540, 2920, 2930F, 2930M, 3800,5400R, 3810
Controller firmware version must be at least 
6.5.

Supported Switch Platforms
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This guide provides information on how to configure, manage, and monitor basic switch operation.

Applicable products
This guide applies to these products:

Aruba 2530 Switch Series (J9772A, J9773A, J9774A, J9775A, J9776A, J9777A, J9778A, J9779A, J9780A,
J9781A, J9782A, J9783A, J9853A, J9854A, J9855A, J9856A, JL070A)

Switch prompts used in this guide
Examples in this guide are representative and may not match your particular switch/environment. Examples use
simplified prompts as follows:

Prompt Explanation

switch# # indicates manager context (authority).

switch> > indicates operator context (authority).

switch(config)# (config) indicates the config context.

switch(vlan-x)# (vlan-x) indicates the vlan context of config, where x
represents the VLAN ID. For example:
switch(vlan-128)#.

switch(eth-x)# (eth-x) indicates the interface context of config,
where x represents the interface. For example:
switch(eth-48)#.

switch-Stack# Stack indicates that stacking is enabled.

switch-Stack(config)# Stack(config) indicates the config context while
stacking is enabled.

switch-Stack(stacking)# Stack(stacking) indicates the stacking context of
config while stacking is enabled.

switch-Stack(vlan-x)# Stack(vlan-x) indicates the vlan context of config
while stacking is enabled, where x represents the
VLAN ID. For example: switch-
Stack(vlan-128)#.

switch-Stack(eth-x/y)# Stack(eth-x/y) indicates the interface context of
config, in the form (eth-<member-in-stack>/
<interface>). For example: switch(eth-1/48)#

Chapter 1
About this guide
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For successful time protocol setup and specific configuration details, you may need to contact your
system administrator regarding your local configuration.

General steps for running a time protocol on the switch
Using time synchronization ensures a uniform time among interoperating devices. This helps you to manage and
troubleshoot switch operation by attaching meaningful time data to event and error messages.

The switch offers TimeP, SNTP (Simple Network Time Protocol), NTP, and a timesync command for changing
the time protocol selection (or turning off time protocol operation).

Although you can create and save configurations for all time protocols without conflicts, the switch
allows only one active time protocol at any time.

In the factory-default configuration, time synchronization is disabled by default.

Because the Aruba 2530 Switch Series does not contain an RTC (real time clock) chip, Hewlett
Packard Enterprise recommends configuring one of the time synchronization protocols supported.
Failure to do so could result in the switch time being reset to the factory default of 01/01/1990
00:00:00 in the case of a switch reload, software upgrade, or power cycle.

TimeP time synchronization
You can either manually assign the switch to use a TimeP server or use DHCP to assign the TimeP server. In
either case, the switch can get its time synchronization updates from only one designated TimeP server. This
option enhances security by specifying which time server to use.

SNTP time synchronization
SNTP provides three operating modes:

• Broadcast mode

The switch acquires time updates by accepting the time value from the first SNTP time broadcast detected. (In
this case, the SNTP server must be configured to broadcast time updates to the network broadcast address;
see the documentation provided with your SNTP server application.) Once the switch detects a particular
server, it ignores time broadcasts from other SNTP servers unless the configurable Poll Interval expires three
consecutive times without an update received from the first-detected server.

To use Broadcast mode, the switch and the SNTP server must be in the same subnet.

• DHCP mode

DHCP mode is enabled by default. In DHCP mode, the SNTP server address and the timezone are provided in
the DHCP address reply.

• Unicast mode

Chapter 2
Time Protocols
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The switch requests a time update from the configured SNTP server. (You can configure one server using the
menu interface, or up to three servers using the CLI sntp server command.) This option provides increased
security over the Broadcast mode by specifying which time server to use instead of using the first one detected
through a broadcast.

Selecting a time synchronization protocol
Procedure

1. Select the time synchronization protocol: TimeP, SNTP, or NTP.

2. Enable the protocol; the choices are:

a. TimeP: DHCP or Manual
b. SNTP: Broadcast or Unicast
c. NTP: Broadcast or Unicast

3. Configure the remaining parameters for the time protocol you selected.

The switch retains the parameter settings for both time protocols even if you change from one protocol to the
other. Thus, if you select a time protocol, the switch uses the parameters you last configured for the selected
protocol.

Simply selecting a time synchronization protocol does not enable that protocol on the switch unless you also
enable the protocol itself (step 2, above). For example, in the factory-default configuration, TimeP is the selected
time synchronization method. However, because TimeP is disabled in the factory-default configuration, no time
synchronization protocol is running.

Disabling time synchronization
You can use either of the following methods to disable time synchronization without changing the TimeP, SNTP, or
NTP configuration:

• Global config level of the CLI

Execute no timesync.

• System Information screen of the Menu interface

1. Set the Time Synch Method parameter to None.

2. Press [Enter] , then [S] (for Save ).

SNTP: Selecting and configuring
The following table shows the SNTP parameters and their operations.
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Table 1: SNTP parameters

SNTP parameter Operation

Time Sync Method Used to select either SNTP, TIMEP, NTP, or None as the time synchronization method.

SNTP Mode

 Disabled The Default. SNTP does not operate, even if specified by the Menu interface Time Sync
Method parameter or the CLI timesync command.

 Unicast Directs the switch to poll a specific server for SNTP time synchronization. Requires at
least one server address.

Broadcast Directs the switch to acquire its time synchronization from data broadcast by any SNTP
server to the network broadcast address. The switch uses the first server detected and
ignores any others. However, if the Poll Interval expires three times without the switch
detecting a time update from the original server, the switch accepts a broadcast time
update from the next server it detects.

Poll Interval
(seconds)

In Unicast Mode: Specifies how often the switch polls the designated SNTP server for a
time update.In Broadcast Mode: Specifies how often the switch polls the network
broadcast address for a time update.Value is between 30 to 720 seconds.

Server Address Used only when the SNTP Mode is set to Unicast. Specifies the IP address of the SNTP
server that the switch accesses for time synchronization updates. You can configure up to
three servers; one using the menu or CLI, and two more using the CLI.

Server Version Specifies the SNTP software version to use and is assigned on a per-server basis. The
version setting is backwards-compatible. For example, using version 3 means that the
switch accepts versions 1 through 3. Default: 3; range: 1 to 7.

Priority Specifies the order in which the configured servers are polled for getting the time. Value is
between 1 and 3.

Viewing and configuring SNTP (Menu)

Procedure

1. From the Main Menu, select:
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a. 2. Switch Configuration…

b. 1. System Information

Figure 1: System Information screen (default values)

2. Press [E] (for Edit ).

Move the cursor to the System Name field.

3. Use the Space bar to move the cursor to the Time Sync Method field.

4. Use the Space bar to select SNTP, then move to the SNTP Mode field.

5. Complete one of the following options.

Option 1

a. Use the Space bar to select the Broadcast mode.

b. Move the cursor to the Poll Interval field.

c. Go to 6. (For Broadcast mode details, see SNTP time synchronization)

Figure 2: Time configuration fields for SNTP with broadcast mode

Option 2

d. Use the Space bar to select the Unicast mode.

e. Move the cursor to the Server Address field.

f. Enter the IP address of the SNTP server you want the switch to use for time synchronization.

This step replaces any previously configured server IP address. If you will be using backup
SNTP servers (requires use of the CLI), see SNTP unicast time polling with multiple SNTP
servers.
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g. Move the cursor to the Server Version field. Enter the value that matches the SNTP server version running
on the device you specified in the preceding step.

If you are unsure which version to use, Hewlett Packard Enterprise recommends leaving this value at the
default setting of 3 and testing SNTP operation to determine whether any change is necessary.

Using the menu to enter the IP address for an SNTP server when the switch already has one
or more SNTP servers configured, the switch deletes the primary SNTP server from the server
list. The switch then selects a new primary SNTP server from the IP addresses in the updated
list. For more on this topic, see SNTP unicast time polling with multiple SNTP servers.

h. Move the cursor to the Poll Interval field, then go to step 6.

Figure 3: SNTP configuration fields for SNTP configured with unicast mode

6. In the Poll Interval field, enter the time in seconds that you want for a Poll Interval.

(For Poll Interval operation, see SNTP parameters)

7. Press Enter to return to the Actions line, then S (for Save) to enter the new time protocol configuration in both
the startup-config and running-config files.

Viewing and configuring SNTP (CLI)
Syntax:

show sntp
Lists both the time synchronization method (TimeP, SNTP, or None) and the SNTP configuration, even if SNTP is
not the selected time protocol.

If you configure the switch with SNTP as the time synchronization method, then enable SNTP in broadcast mode
with the default poll interval, show sntp lists the following:

SNTP configuration when SNTP is the selected time synchronization method

switch(config)# show sntp

 SNTP Configuration

  Time Sync Mode: Sntp
  SNTP Mode : Unicast
  Poll Interval (sec) [720] : 719

  Priority SNTP Server Address            Protocol Version
  -------- ------------------------------ ----------------
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  1        2001:db8::215:60ff:fe79:8980   7
  2        10.255.5.24                    3
  3        fe80::123%vlan10               3
In the factory-default configuration (where TimeP is the selected time synchronization method), show sntp still
lists the SNTP configuration, even though it is not currently in use. In SNTP configuration when SNTP is not
the selected time synchronization method on page 25, even though TimeP is the current time synchronous
method, the switch maintains the SNTP configuration.

SNTP configuration when SNTP is not the selected time synchronization method

switch(config)# show sntp

 SNTP Configuration

  Time Sync Mode: Timep
  SNTP Mode : Unicast
  Poll Interval (sec) [720] : 719

  Priority SNTP Server Address            Protocol Version
  -------- ------------------------------ ----------------
  1        2001:db8::215:60ff:fe79:8980   7
  2        10.255.5.24                    3
  3        fe80::123%vlan10               3
Syntax:

show management
This command can help you to easily examine and compare the IP addressing on the switch. It lists the IP
addresses for all time servers configured on the switch, plus the IP addresses and default gateway for all VLANs
configured on the switch.

Display showing IP addressing for all configured time servers and VLANs

switch(config)# show management

 Status and Counters - Management Address Information

  Time Server Address : fe80::215:60ff:fe7a:adc0%vlan10

  Priority  SNTP Server Address            Protocol Version
  --------- ------------------------------ ----------------
  1         2001:db8::215:60ff:fe79:8980   7
  2         10.255.5.24                    3
  3         fe80::123%vlan10               3

  Default Gateway   :10.0.9.80

  VLAN Name    MAC Address     | IP address
  ------------ --------------- + ---------------
  DEFAULT_VLAN 001279-88a100   | Disabled
  VLAN10       001279-88a100   | 10.0.10.17
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Configuring (enabling or disabling) the SNTP mode
Enabling the SNTP mode means to configure it for either broadcast or unicast mode. Remember that to run SNTP
as the switch's time synchronization protocol, you must also select SNTP as the time synchronization method by
using the CLI timesync command (or the menu interface Time Sync Method parameter.)

Syntax:

timesync sntp
Selects SNTP as the time protocol.

sntp {<broadcast | unicast>}
Enables the SNTP mode.

Syntax:

sntp server <ip-addr>
Required only for unicast mode.

Syntax:

sntp server priority <1-3>
Specifies the order in which the configured servers are polled for getting the time. Value is between 1 and 3.

Syntax:

sntp <30-720>
Configures the amount of time between updates of the system clock via SNTP.

Default: 720 seconds

Enabling SNTP in Broadcast Mode
Because the switch provides an SNTP polling interval (default: 720 seconds), you need only these two commands
for minimal SNTP broadcast configuration:

Syntax:

timesync sntp
Selects SNTP as the time synchronization method.

Syntax:

sntp broadcast
Configures broadcast as the SNTP mode.

Example:

Suppose that time synchronization is in the factory-default configuration (TimeP is the currently selected time
synchronization method.) Complete the following:
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Procedure

1. View the current time synchronization.

2. Select SNTP as the time synchronization mode.

3. Enable SNTP for Broadcast mode.

4. View the SNTP configuration again to verify the configuration.

The commands and output would appear as follows:

Figure 4: Enabling SNTP operation in Broadcast Mode

switch(config)# show sntp 1
 SNTP Configuration
  Time Sync Mode: Timep
  SNTP Mode : disabled
  Poll Interval (sec) [720] :720

switch(config)# timesync sntp

switch(config)# sntp broadcast

switch(config)# show sntp 2
 SNTP Configuration
  Time Sync Mode: Sntp
  SNTP Mode : Broadcast
  Poll Interval (sec) [720] :720

• 1show sntp displays the SNTP configuration and also shows that TimeP is the currently

active time synchronization mode.

• 2show sntp again displays the SNTP configuration and shows that SNTP is now the

currently active time synchronization mode and is configured for broadcast operation.

Enabling SNTP in unicast mode (CLI)
Like broadcast mode, configuring SNTP for unicast mode enables SNTP. However, for unicast operation, you
must also specify the IP address of at least one SNTP server. The switch allows up to three unicast servers. You
can use the Menu interface or the CLI to configure one server or to replace an existing unicast server with
another. To add a second or third server, you must use the CLI. For more on SNTP operation with multiple
servers, see SNTP unicast time polling with multiple SNTP servers on page 37

Syntax:

timesync sntp
Selects SNTP as the time synchronization method.

Syntax:

sntp unicast
Configures the SNTP mode for unicast operation.
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Syntax:

[no] sntp server priority < 1-3 > < ip-address > [version]
Use the no version of the command to disable SNTP.

priority
Specifies the order in which the configured SNTP servers are polled for the time.

ip-address
An IPv4 or IPv6 address of an SNTP server.

version
The protocol version of the SNTP server. Allowable values are 1 through 7; default is 3.

Syntax:

no sntp server priority <1-3> <ip-addr>
Deletes the specified SNTP server.

priority <1-3>
value must match what server is configured with. Deleting an SNTP server when only one is
configured disables SNTP unicast operation.

Example:

To select SNTP and configure it with unicast mode and an SNTP server at 10.28.227.141 with the default server
version (3) and default poll interval (720 seconds):

switch(config)# timesync sntp
Selects SNTP.

switch(config)# sntp unicast
Activates SNTP in unicast mode.

switch(config)# sntp server priority 1 10.28.227.141
Specifies the SNTP server and accepts the current SNTP server version (default: 3).

Configuring SNTP for unicast operation

switch(config)# show sntp

 SNTP Configuration

  Time Sync Mode: Sntp
  SNTP Mode : Unicast
  Poll Interval (sec) [720] : 720

  Priority SNTP Server Address                            Protocol Version
  -------- ---------------------------------------------- ----------------
  1        2001:db8::215:60ff:fe79:8980 7
  2        10.255.5.24 3
  3        fe80::123%vlan10 3
In this Example:, the Poll Interval and the Protocol Version appear at their default settings.
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Both IPv4 and IPv6 addresses are displayed.

Note: Protocol Version appears only when there is an IP address configured for an SNTP server.

If the SNTP server you specify uses SNTP v4 or later, use the sntp server command to specify the correct
version number. For example, suppose you learned that SNTP v4 was in use on the server you specified above
(IP address 10.28.227.141). You would use the following commands to delete the server IP address , re-enter it
with the correct version number for that server.

Specifying the SNTP protocol version number

switch(config)# no sntp server 10.28.227.141 1
switch(config)# sntp server 10.28.227.141 4 2
switch(config)# show sntp
 
 SNTP Configuration

  Time Sync Mode: Sntp
  SNTP Mode : Broadcast
  Poll Interval (sec) [720] : 600

  IP Address     Protocol Version
  -------------  -----------------
  10.28.227.141  4 3
      

• 1Deletes unicast SNTP server entry.

• 2Re-enters the unicast server with a non-default protocol version.

• 3show sntp displays the result.

Changing the SNTP poll interval (CLI)
Syntax:

sntp <30..720>
Specifies the amount of time between updates of the system clock via SNTP. The default is 720 seconds and the
range is 30 to 720 seconds. (This parameter is separate from the poll interval parameter used for Timep
operation.)

Example:

To change the poll interval to 300 seconds:

switch(config)# sntp 300
Changing the SNTP server priority (CLI)
You can choose the order in which configured servers are polled for getting the time by setting the server priority.

Syntax:

sntp server priority <1-3> <ip-address>
Specifies the order in which the configured servers are polled for getting the time Value is between 1 and 3.

You can enter both IPv4 and IPv6 addresses. For more information about IPv6 addresses, see the
IPv6 configuration guide for your switch.
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Example:

To set one server to priority 1 and another to priority 2:

switch(config)# sntp server priority 1 10.28.22.141

switch(config)# sntp server priority 2
                 2001:db8::215:60ff:fe79:8980

Disabling time synchronization without changing the SNTP configuration (CLI)
The recommended method for disabling time synchronization is to use the timesync command.

Syntax:

no timesync
Halts time synchronization without changing your SNTP configuration.

Example:

Suppose SNTP is running as the switch's time synchronization protocol, with broadcast as the SNTP mode and
the factory-default polling interval. You would halt time synchronization with this command:

switch(config)# no timesync
If you then viewed the SNTP configuration, you would see the following:

SNTP with time synchronization disabled

switch(config)# show sntp
 SNTP Configuration
  Time Sync Mode: Disabled
  SNTP Mode : Broadcast
  Poll Interval (sec) [720] : 720

Disabling the SNTP Mode
If you want to prevent SNTP from being used even if it is selected by timesync (or the Menu interface's Time
Sync Method parameter), configure the SNTP mode as disabled.

Syntax:

no sntp
Disables SNTP by changing the SNTP mode configuration to Disabled.

Example:

If the switch is running SNTP in unicast mode with an SNTP server at 10.28.227.141 and a server version of 3
(the default), no sntp changes the SNTP configuration as shown below and disables time synchronization on
the switch.

Disabling time synchronization by disabling the SNTP mode

switch(config)# no sntp
switch(config)# show sntp

 SNTP Configuration

  Time Sync Mode: Sntp
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  SNTP Mode : disabled
  Poll Interval (sec) [720] : 600

  IP Address     Protocol Version
  -------------  -----------------
  10.28.227.141  3
Note that even though the Time Sync Mode is set to Sntp, time synchronization is disabled because no sntp
has disabled the SNTP Mode parameter.

TimeP: Selecting and configuring
The following table shows TimeP parameters and their operations.

Table 2: TimeP parameters

TimeP
parameter

Operation

Time Sync
Method

Used to select either TIMEP, SNTP, NTP, or None as the time synchronization method.

TimeP Mode

 Disabled TimeP does not operate, even if specified by the Menu interface Time Sync Method
parameter or the CLI timesync command.

 DHCP When TimeP is selected as the time synchronization method, the switch attempts to acquire a
TimeP server IP address via DHCP. If the switch receives a server address, it polls the server
for updates according to the TimeP poll interval. If the switch does not receive a TimeP server
IP address, it cannot perform time synchronization updates.

 Manual When TimeP is selected as the time synchronization method, the switch attempts to poll the
specified server for updates according to the TimeP poll interval. If the switch fails to receive
updates from the server, time synchronization updates do not occur.

 Server
Address

Used only when the TimeP Mode is set to Manual. Specifies the IP address of the TimeP
server that the switch accesses for time synchronization updates. You can configure one
server.

Viewing, enabling, and modifying the TimeP protocol (Menu)

Procedure

1. From the Main Menu, select:

2. Switch Configuration
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1. System Information

Figure 5: System Information screen (default values)

2. Press [E] (for Edit).

The cursor moves to the System Name field.

3. Move the cursor to the Time Sync Method field.

4. If TIMEP is not already selected, use the Space bar to select TIMEP, then move to the TIMEP Mode field.

5. Do one of the following:

• Use the Space bar to select the DHCP mode.

◦ Move the cursor to the Poll Interval field.

◦ Go to step 6.

Enabling TIMEP or DHCP

Time Sync Method [None] :   TIMEP
TimeP Mode [Disabled] :     DHCP
Poll Interval (min) [720] : 720
Time Zone [0] :             0
Daylight Time Rule [None] : None

• Use the Spacebar to select the Manual mode.

◦ Move the cursor to the Server Address field.

◦ Enter the IP address of the TimeP server you want the switch to use for time synchronization.

This step replaces any previously configured TimeP server IP address.

◦ Move the cursor to the Poll Interval field, then go to step 6.
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6. In the Poll Interval field, enter the time in minutes that you want for a TimeP Poll Interval.

7. Select [Enter] to return to the Actions line, then select [S] (for Save) to enter the new time protocol
configuration in both the startup-config and running-config files.

Viewing the current TimeP configuration (CLI)
Using different show commands, you can display either the full TimeP configuration or a combined listing of all
TimeP, SNTP, and VLAN IP addresses configured on the switch.

Syntax:

show timep
Lists both the time synchronization method (TimeP, SNTP, or None) and the TimeP configuration, even if SNTP is
not the selected time protocol. (If the TimeP Mode is set to Disabled or DHCP, the Server field does not appear.)

If you configure the switch with TimeP as the time synchronization method, then enable TimeP in DHCP mode
with the default poll interval, show timep lists the following:

TimeP configuration when TimeP is the selected Time synchronization method

switch(config)# show timep

 Timep Configuration

  Time Sync Mode: Timep
  TimeP Mode [Disabled] : DHCP    Server Address : 10.10.28.103
  Poll Interval (min) [720] : 720
If SNTP is the selected time synchronization method, show timep still lists the TimeP configuration even though
it is not currently in use. Even though, in this Example:, SNTP is the current time synchronization method, the
switch maintains the TimeP configuration:

TimeP configuration when TimeP is not the selected time synchronization method

switch(config)# show timep

 Timep Configuration
 
  Time Sync Mode: Sntp
  TimeP Mode [Disabled] : Manual   Server Address : 10.10.28.100
  Poll Interval (min) [720] : 720
Syntax:

show management
Helps you to easily examine and compare the IP addressing on the switch. It lists the IP addresses for all time
servers configured on the switch plus the IP addresses and default gateway for all VLANs configured on the
switch.

Display showing IP addressing for all configured time servers and VLANs

switch(config)# show management

 Status and Counters - Management Address Information
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  Time Server Address : 10.10.28.100

  Priority SNTP Server Address                            Protocol Version
  -------- ---------------------------------------------- ----------------
  1        10.10..28.101                                  3
  2        10.255.5.24                                    3
  3        fe80::123%vlan10                               3

  Default Gateway : 10.0.9.80
 
  VLAN Name    MAC Address         | IP Address
  ------------ ------------------- + -------------------
  DEFAULT_VLAN 001279-88a100       | 10.30.248.184
  VLAN10 001279-88a100             | 10.0.10.17

Configuring (enabling or disabling) the TimeP mode
Enabling the TimeP mode means to configure it for either broadcast or unicast mode. Remember to run TimeP as
the switch's time synchronization protocol, you must also select TimeP as the time synchronization method by
using the CLI timesync command (or the menu interface Time Sync Method parameter.

Syntax:

timesync timep
Selects TimeP as the time synchronization method.

Syntax:

ip timep {<dhcp | manual>}
Enables the selected TimeP mode.

Syntax:

[no] ip timep
Disables the TimeP mode.

Syntax:

[no] timesync
Disables the time protocol.

Enabling TimeP in manual mode (CLI)
Like DHCP mode, configuring TimeP for manual mode enables TimeP. However, for manual operation, you must
also specify the IP address of the TimeP server. (The switch allows only one TimeP server.)

Syntax:

timesync timep
Selects TimeP.

Syntax:

ip timep manual <ip-addr>
Activates TimeP in manual mode with a specified TimeP server.
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Syntax:

no ip timep
Disables TimeP.

Enabling TimeP in DHCP Mode
Because the switch provides a TimeP polling interval (default:720 minutes), you need only these two commands
for a minimal TimeP DHCP configuration:

Syntax:

timesync timep
Selects TimeP as the time synchronization method.

Syntax:

ip timep dhcp
Configures DHCP as the TimeP mode.

For example, suppose:

• Time Synchronization is configured for SNTP.

• You want to:

◦ View the current time synchronization.

◦ Select TimeP as the synchronization mode.

◦ Enable TimeP for DHCP mode.

◦ View the TimeP configuration.

Enabling TimeP in Manual Mode
Like DHCP mode, configuring TimeP for Manual Mode enables TimeP. However, for manual operation, you must
also specify the IP address of the TimeP server. (The switch allows only one TimeP server.) To enable the TimeP
protocol:

Syntax:

timesync timep
Selects TimeP.

Syntax:

ip timep manual <ip-addr>
Activates TimeP in manual mode with a specified TimeP server.

Syntax:

[no] ip timep
Disables TimeP.
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To change from one TimeP server to another, you must use the no ip timep command to disable
TimeP mode, the reconfigure TimeP in manual mode with the new server IP address.

Example:

To select TimeP and configure it for manual operation using a TimeP server address of 10.28.227.141 and the
default poll interval (720 minutes, assuming the TimeP poll interval is already set to the default):

switch(config)# timesync time
Selects TimeP.

switch(config)# ip timep manual 10.28.227.141
Activates TimeP in Manual mode.

Configuring TimeP for manual operation

switch(config)# timesync timep
switch(config)# ip timep manual 10.28.227.141
switch(config)# show timep
 Timep Configuration
  Time Sync Mode: Timep
  TimeP Mode :  Manual              Server Address : 10.28.227.141
  Poll Interval (min) : 720

Changing from one TimeP server to another (CLI)

Procedure

1. Use the no ip timep command to disable TimeP mode.

2. Reconfigure TimeP in Manual mode with the new server IP address.

Changing the TimeP poll interval (CLI)
Syntax:

ip timep {< dhcp | manual >} interval <1-9999>
Specifies how long the switch waits between time polling intervals. The default is 720 minutes and the range is 1
to 9999 minutes. (This parameter is separate from the poll interval parameter used for SNTP operation.)

Example:

To change the poll interval to 60 minutes:

switch(config)# ip timep interval 60

Disabling time synchronization without changing the TimeP configuration (CLI)
Syntax:

no timesync
Disables time synchronization by changing the Time Sync Mode configuration to Disabled. This halts time
synchronization without changing your TimeP configuration. The recommended method for disabling time
synchronization is to use the timesync command.
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Example:

Suppose TimeP is running as the switch's time synchronization protocol, with DHCP as the TimeP mode, and the
factory-default polling interval. You would halt time synchronization with this command:

switch(config)# no timesync
If you then viewed the TimeP configuration, you would see the following:

TimeP with time synchronization disabled

switch(config)# show timep

 Timep Configuration
  Time Sync Mode: Disabled
  TimeP Mode : DHCP Poll Interval (min): 720

Disabling the TimeP mode
Syntax:

no ip timep
Disables TimeP by changing the TimeP mode configuration to Disabled and prevents the switch from using it as
the time synchronization protocol, even if it is the selected Time Sync Method option.

Example:

If the switch is running TimeP in DHCP mode, no ip timep changes the TimeP configuration as shown below
and disables time synchronization. Even though the TimeSync mode is set to TimeP, time synchronization is
disabled because no ip timep has disabled the TimeP mode parameter.

Disabling time synchronization by disabling the TimeP mode parameter

switch(config)# no ip timep

switch(config)# show timep

 Timep Configuration
  Time Sync Mode: Timep
  TimeP Mode : Disabled

SNTP unicast time polling with multiple SNTP servers
When running SNTP unicast time polling as the time synchronization method, the switch requests a time update
from the server you configured with either the Server Address parameter in the menu interface, or the primary
server in a list of up to three SNTP servers configured using the CLI. If the switch does not receive a response
from the primary server after three consecutive polling intervals, the switch tries the next server (if any) in the list.
If the switch tries all servers in the list without success, it sends an error message to the Event Log and
reschedules to try the address list again after the configured Poll Interval time has expired.

If there are already three SNTP server addresses configured on the switch, and you want to use the CLI to
replace one of the existing addresses with a new one, you must delete the unwanted address before you
configure the new one.

Chapter 2 Time Protocols 37

Anexo 04 ITEM 11 (0592666)         SEI 0008478-63.2018.6.02.8000 / pg. 5861



Displaying all SNTP server addresses configured on the switch (CLI)
The System Information screen in the menu interface displays only one SNTP server address, even if the switch
is configured for two or three servers. The CLI show management command displays all configured SNTP
servers on the switch.

How to list all SNTP servers configured on the switch

switch(config)# show management
 
 Status and Counters - Management Address Information

  Time Server Address : fe80::215:60ff:fe7a:adc0%vlan10

  Priority SNTP Server Address                            Protocol Version
  -------- ---------------------------------------------- ----------------
  1 2001:db8::215:60ff:fe79:8980                          7
  2 10.255.5.24                                           3
  3 fe80::123%vlan10                                      3

  Default Gateway : 10.0.9.80

  VLAN Name    MAC Address         | IP Address
  ------------ ------------------- + -------------------
  DEFAULT_VLAN 001279-88a100       | Disabled
  VLAN10       001279-88a100       | 10.0.10.17

Adding and deleting SNTP server addresses

Adding addresses
As mentioned earlier, you can configure one SNTP server address using either the Menu interface or the CLI. To
configure a second and third address, you must use the CLI. To configure the remaining two addresses, you
would do the following:

Creating additional SNTP server addresses with the CLI

switch(config)# sntp server priority <1-3> 2001:db8::215:60ff:fe79:8980
switch(config)# sntp server 10.255.5.24

If there are already three SNTP server addresses configured on the switch, and you want to use the
CLI to replace one of the existing addresses with a new one, you must delete the unwanted address
before you configure the new one.

Deleting addresses
Syntax:

no sntp server <ip-addr>
Deletes a server address. If there are multiple addresses and you delete one of them, the switch re-orders the
address priority.

Example:

To delete the primary address in the above Example: and automatically convert the secondary address to primary:
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switch(config)# no sntp server 10.28.227.141

Operating with multiple SNTP server addresses
configured (Menu)
When you use the Menu interface to configure an SNTP server IP address, the new address writes over the
current primary address, if one is configured.

SNTP messages in the Event Log
If an SNTP time change of more than three seconds occurs, the switch's Event Log records the change. SNTP
time changes of less than three seconds do not appear in the Event Log.

Network Time Protocol (NTP)
All NTP communications use Coordinated Universal Time (UTC). An NTP server usually receives its time from an
authoritative time source, such as a radio clock or an atomic clock attached to a time server, and then distributes
this time across the network. NTP is extremely efficient; no more than one packet per minute is necessary to
synchronize two machines to within a millisecond of each other.

NTP uses a stratum to describe the distance between a network device and an authoritative time source:

• A stratum 1 time server is directly attached to an authoritative time source (such as a radio or atomic clock or a
GPS time source).

• A stratum 2 NTP server receives its time through NTP from a stratum 1 time server.

Before synchronizing, NTP compares the time reported by several network devices and does not synchronize
with one that is significantly different, even if it is a stratum 1.

The security features of NTP can be used to avoid the accidental or malicious setting of incorrect time. One such
mechanism is available: an encrypted authentication mechanism.

Though similar, the NTP algorithm is more complex and accurate than the Simple Network Time Protocol (SNTP).

Enabling this feature results in synchronizing the system clock; therefore, it may affect all sub-
systems that rely on system time.

Commands
The following commands allow the user to configure NTP or show NTP configurations.

timesync Command
This command is used to configure the protocol used for network time synchronization.

Syntax

[no] timesync { timep | sntp | timep-or-sntp | ntp }
Options
no
Deletes all timesync configurations on the device.

timep
Updates the system clock using TIMEP.
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sntp
Updates the system clock using SNTP.

timep-or-sntp
Updates the system clock using TIMEP or SNTP (default).

ntp
Updates the system clock using NTP

Example
switch(config)# timesync
sntp                  Update the system clock using SNTP.
timep                 Update the system clock using TIMEP.
timep-or-sntp         Update the system clock using TIMEP or SNTP.
ntp                   Update the system clock using NTP.

timesync ntp
This command is used to update the system clock using NTP.

Syntax

timesync ntp
Description

Update the system clock using NTP.

ntp
This command selects the operating mode of the NTP client.

Syntax

ntp [broadcast|unicast]
Options
broadcast
Sets ntp client to operate in broadcast mode.

unicast
Sets ntp client to operate in unicast mode.

Usage

The default mode is broadcast.

[no] ntp
This command disables NTP and removes all NTP configurations on the device.

Syntax
[no] ntp [authentication <key-id>
 | broadcast | enable | max-association 
<integer> | server 
<IP-ADDR> | trap 
<trap-name> | unicast]
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Description

Disable NTP and removes the entire NTP configuration.

Options

authentication

Configure NTP authentication.

broadcast

Operate in broadcast mode.

enable

Enable/disable NTP.

max-association

Maximum number of Network Time Protocol (NTP) associations.

server

Configure a NTP server to poll for time synchronization.

trap

Enable/disable NTP traps.

unicast

Operate in unicast mode.

Example
switch(config)# no ntp
This will delete all NTP configurations on this device. Continue [y/n]?

ntp enable
This command is used to enable or disable NTP on the switch.

Syntax

ntp enable
Example
switch(config)# ntp
enable       Enable/disable NTP.
Description

Enable or disable NTP. Use [no] to disable NTP.

Restrictions

Validation Error/Warning/Prompt

If timeSync is in SNTP or Timep when NTP is enabled. Timesync is not configured to NTP.

When timesync is NTP and ntp is enabled and we try to
change timesync to SNTP.

Disable NTP before changing timesync to
SNTP or TIMEP

ntp authentication
This command is used for authentication of NTP server by the NTP client.
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Syntax
ntp authentication key-id <KEY-ID> [authentication-mode <MODE> key-value <KEY-
STRING>] [trusted]
Parameters/Options
key-id <id>
Sets the key-id for the authentication key.

Subcommands
authentication-mode
Sets the NTP authentication mode

key-value <KEY-STRING>
Sets the key-value for the authentication key.

[trusted]
Sets the authentication key as trusted.
Example
Switch(config)# ntp
Authentication      Configure NTP authentication.

Switch(config)# ntp authentication
key-id              Set the key-id for this authentication key.

Switch(config)# ntp authentication key-id 
<1-4294967295>      Set the authentication key-id.

Switch(config)# ntp authentication key-id 1
authentication-mode  Set the NTP authentication mode.
trusted              Set this authentication key as trusted.

Switch(config)# ntp authentication key-id 1 
authentication-mode|trusted md5
Authenticate using MD5.

Switch(config)# ntp authentication key-id 1 
authentication-mode|trusted md5key-value  Set the NTP authentication key.

Switch(config)# ntp authentication key-id 1
authentication-mode|trusted md5 key-value 
KEY           Enter a string to be set as the NTP authentication key.

ntp authentication key-id
Syntax
ntp authentication key-id 
<key-id> [authentication-mode [md5 | sha1]
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 key-value <key-value>] [trusted]
      
Description

The NTP client authenticates the NTP server.

Options

authentication-mode

Set the NTP authentication mode.

• md5: Authenticate using MD5.

• sha1: Authenticate using SHA1.

trusted

Set this authentication key as trusted.

ntp max-association
This command is used to configure the maximum number of servers associated with this NTP client.

Syntax
ntp max-association 
<number>
      
Options
max-association <number>
Sets the maximum number of NTP associations.

Description

Configure maximum number of servers associated with the client. Up to eight servers can be configured as the
maximum.

Restrictions

The range for a maximum number of NTP associations is 1–8.

Example
Switch(config)# ntp
max-associations      Maximum number of NTP associations.

Switch(config)# ntp max-associations
<1-8>                  Enter the number.
Restrictions

Validation Error/Warning/Prompt

When the number of configured NTP servers is more
than the max-associations value.

The maximum number of NTP servers
allowed is <number>.

When the max-associations value is less than the (n)
number of configured NTP servers.

Max-associations value cannot be less
than the number of NTP servers
configured.
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ntp server
This command is used to configure the NTP servers.

Syntax

[no] ntp server

ntp server <IP-ADDR|IPv6-ADDR> [key <key-id>] [oobm] [max-poll <max-poll-val>][min-poll <min-poll-val>][burst | iburst] [version <1-4>]

Parameters/Options
[no]
Removes the unicast NTP configurations on the device.

Subcommands
IP-ADDR
Sets the IPv4 address of the NTP server.

IPV6-ADDR
Sets the IPv6 address of the NTP server.

oobm
Specifies that the NTP Unicast server is accessible over an OOBM interface.

key <key-id>
Specifies the authentication key.

max-poll <max-poll-val>
Configures the maximum time intervals in power of 2 seconds. Range is 4–17 (e.g., 5 would translate to 2 raised
to 5 or 32).

min-poll <min-poll-val>
Configures the minimum time intervals in seconds. Range is 4–17.

burst
Enables burst mode.

iburst
Enables initial burst mode.

version
Sets version 1–4.

Usage

A maximum of 8 NTP servers can be configured.

Example
switch(config)# ntp
server          Allow the software clock to be synchronized by an NTP
time server.
broadcast       Operate in broadcast mode.
unicast         Operate in unicast mode.

switch(config)# ntp server
IP-ADDR         IPv4 address of the NTP server. 

44 Aruba 2530 Management and Configuration Guide for ArubaOS-Switch 16.05

Anexo 04 ITEM 11 (0592666)         SEI 0008478-63.2018.6.02.8000 / pg. 5868



IPV6-ADDR       IPv6 address of the NTP server.

switch(config)# ntp server <IP-ADDR>
Key             Specify the authentication key.

switch(config)# ntp server <IP-ADDR> key key-id
Max-poll        Configure the maximum time intervals in seconds.

switch(config)# ntp server <IP-ADDR> key key-id max-poll
<4-17>          Enter an integer number.

Switch(config)# ntp server <IP-ADDR> key key-id
Min-poll        Configure the minimum time intervals in seconds.

switch(config)# ntp server <IP-ADDR> key key-id min-poll
<4-17>          Enter an integer number.

switch(config)# ntp server <IP-ADDR> key key-id prefer max-poll 
<max-poll-val> min-poll <min-poll-val>
iburst          Enable initial burst (iburst) mode.
burst           Enable burst mode.

Switch(config)# ntp server IP-ADDR key key-id prefer maxpoll <number>
minpoll <number> iburst
Restrictions

Validation Error/Warning/Prompt

If authentication key-id not configured Authentication key-id has not been
configured.

If Key-id is not marked as trusted Key-id is not trusted.

When min poll value is more than max poll value NTP max poll value should be more than
min poll value.

ntp server key-id
Syntax
ntp server <IP-ADDR |IPV6-ADDR> 
key—id <key-id> [max-poll 
<max-poll-val>] [min-poll 
<min-poll-val>] [burst | iburst]
      
Description

Configure the NTP server. <IP-ADDR> indicates the IPv4 address of the NTP server. <IPV6-ADDR> indicates the
IPv6 address of the NTP server.

Options
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burst

Enables burst mode.

iburst

Enables initial burst (iburst) mode.

key-id

Set the authentication key to use for this server.

max-poll <max-poll-val>

Configure the maximum time intervals in seconds.

min-poll <min-poll-val>

Configure the minimum time intervals in seconds.

ntp ipv6-multicast
This command is used to configure NTP multicast on a VLAN interface.

Syntax
ntp ipv6-multicast
Description

Configure the interface to listen to the NTP multicast packets.

Example
Switch(vlan-2)# ntp
ipv6-multicast       Configure the interface to listen to the NTP multicast packets.
Restrictions

Validation Error/Warning/Prompt

If ipv6 is not enabled on vlan interface IPv6 address not configured on the
VLAN.

debug ntp
This command is used to display debug messages for NTP.

Syntax
debug ntp <event | 
packet>
      
Options
event
Displays event log messages related to NTP.

packets
Displays NTP packet messages.

Description

Enable debug logging. Use [no] to disable debug logging.
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Example
Switch(config)# debug ntp
event                 Display event log messages related to NTP.
packet                Display NTP packet messages.

ntp trap
This command is used to configure NTP traps.

Syntax
ntp trap <trap-name>
      
Description

Enable NTP traps. Use [no] to disable NTP traps.

Options

ntp-mode-change

Trap name resulting in send notification when the NTP entity changes mode, including
starting and stopping (if possible).

ntp-stratum-change

Trap name resulting in send notification when stratum level of NTP changes.

ntp-peer-change

Trap name resulting in send notification when a (new) syspeer has been selected.

ntp-new-association

Trap name resulting in send notification when a new association is mobilized.

ntp-remove-association

Trap name resulting in send notification when an association is demobilized.

ntp-config-change

Trap name resulting in send notification when the NTP configuration has changed.

ntp-leapsec-announced

Trap name resulting in send notification when a leap second has been announced.

ntp-alive-heartbeat

Trap name resulting in send notification periodically (as defined by
ntpEntHeartbeatInterval) to indicate that the NTP entity is still alive.

all

Enable all traps.

Usage

The traps defined below are generated as the result of finding an unusual condition while parsing an NTP packet
or a processing a timer event. Note that if more than one type of unusual condition is encountered while parsing
the packet or processing an event, only the first one will generate a trap. Possible trap names are:

- 'ntpEntNotifModeChange' The notification to be sent when the NTP entity changes
mode, including starting and stopping (if possible).
- 'ntpEntNotifStratumChange' The notification to be sent when stratum level of NTP
changes.
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- 'ntpEntNotifSyspeerChanged' The notification to be sent when a (new) syspeer has
been selected.
- 'ntpEntNotifAddAssociation' The notification to be sent when a new association is
mobilized.
- 'ntpEntNotifRemoveAssociation' The notification to be sent when an association is
demobilized.
- 'ntpEntNotifConfigChanged' The notification to be sent when the NTP configuration
has changed.
- 'ntpEntNotifLeapSecondAnnounced' The notification to be sent when a leap second
has been announced.
- 'ntpEntNotifHeartbeat' The notification to be sent periodically (as defined by
ntpEntHeartbeatInterval) to indicate that the NTP entity is still alive.
- 'ntpEntNotifAll' The notification to be sent when all traps have been enabled

show ntp statistics
This command is used to show NTP statistics.

Syntax
show ntp statistics
Description

Show information about NTP packets.

Examples
Switch(config)# show ntp statistics

NTP Global statistics information

NTP In Packets                : 100
NTP Out Packets               : 110
NTP Bad Version Packets       : 4
NTP Protocol Error Packets    : 0

switch(config)# show ntp statistics

NTP Global statistics information

NTP In Packets             : 100
NTP Out Packets            : 110
NTP Bad Version Packets    : 4    
NTP Protocol Error Packets : 0

show ntp status
Syntax

Description

Show the status of NTP.

show ntp status
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Example
Switch(config)# show ntp status

NTP Status information
NTP Status             : Disabled             NTP Mode        : Broadcast
Synchronization Status : Synchronized         Peer Dispersion : 8.01 sec
Stratum Number         : 2                    Leap Direction  : 1
Reference Assoc Id     : 1                    Clock Offset    : 0.0000 sec
Reference              : 192.0.2.1            Root Delay      : 0.00 sec
Precision              : 2**7                 Root Dispersion : 15.91 sec
NTP Uptime             : 01d 09h 15m          Time Resolution : 1
Drift                  : 0.000000000 sec/sec

System Time            : Tue Aug 25 04:59:11 2015
Reference Time         : Mon Jan  1 00:00:00 1990

show ntp associations
Syntax
show ntp associations [detail 
<IP-ADDR>]
      
Description

Show the status of configured NTP associations.

Options

detail

Show the detailed status of NTP associations configured for the system.

Switch(config)# show ntp associations

                    NTP Associations Entries

Address          St   T  When Poll  Reach   Delay    Offset   Dispersion   
--------------   ---  -- ---- ----- ------ -------   -------  ----------
121.0.23.1       16   u   -  1024    0     0.000     0.000     0.000
231.45.21.4      16   u   -  1024    0     0.000     0.000     0.000
55.21.56.2       16   u   -  1024    0     0.000     0.000     0.000
23.56.13.1        3   u 209  1024  377     54.936   -6.159     12.688
91.34.255.216     4   u 132  1024  377     1.391     0.978     3.860

Switch(config)# show ntp associations detail <IP ADDR>

NTP association information

IP address       : 172.31.32.2                  Peer Mode       : Server  
Status           : Configured, Insane, Invalid  Peer Poll Intvl : 64 
Stratum          : 5                            Root Delay      : 137.77 sec
Ref Assoc ID     : 0                            Root Dispersion : 142.75
Association Name : NTP Association 0            Reach           : 376
Reference ID     : 16.93.49.4                   Delay           : 4.23 sec
Our Mode         : Client                       Offset          : -8.587 sec 
Our Poll Intvl   : 1024                         Precision       : 2**19  
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Dispersion       : 1.62 sec
Association In Packets    : 60
Association Out Packets   : 60
Association Error Packets : 0
Origin Time      : Fri Jul 3 11:39:40 2015
Receive Time     : Fri Jul 3 11:39:44 2015
Transmit Time    : Fri Jul 3 11:39:44 2015

-----------------------------------------------------------------------------
Filter Delay =   4.23    4.14    2.41    5.95    2.37    2.33    4.26    4.33
Filter Offset = -8.59   -8.82   -9.91   -8.42  -10.51  -10.77  -10.13  -10.11

show ntp authentication
Syntax

Description

Show the authentication status and other information about the authentication key.

show ntp authentication

Switch(config)# show ntp authentication

NTP Authentication Information

Key-ID     Auth Mode   Trusted
--------   ----------  -------
67            md5        yes 
7             md5        no  
1             sha1       yes 
2             sha1       no
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Validation rules

Validation Error/Warning/Prompt

If access-list name is not valid. Please enter a valid access-list name.

If the authentication method is being set to
two-factor authentication, various messages
display.

If both the public key and username/password are not
configured: Public key and username/password should
be configured for a successful two-factor
authentication.

If public key is configured and username is not
configured:

Username and password should be configured for a
successful two-factor authentication.

If the username is configured and public key is not
configured:

Public key should be configured for a successful two-
factor authentication.

If “ssh-server” certificate is not installed at the time of
enabling certificate-password authentication:

The “ssh-server” certificate should be installed for a
successful two-factor authentication.

If the authentication method is set to two-
factor while installing the public key, a
message displays.

The client public keys without username will not be
considered for the two-factor authentication for the SSH
session.

If the username and the key installation user
for that privilege do not match, a message
displays and installation is not allowed.

This will also happen when the
authentication method is set for two-factor.

The username in the key being installed does not
match the username configured on the switch.

If the maximum number of <username : TA
profile> associations is reached for a given
TA profile, a message displays.

Maximum number of username associations with a TA
profile is 10.

If secondary authentication type for two-
factor authentication chosen is not "none", a
message displays.

Not legal combination of authentication methods.

If the authentication method is anything other
than two-factor and the two-factor
authentication method options are set, a
message displays.

Not legal combination of authentication methods.

If two-factor authentication is set and user
tries to SSH into another system using ssh
<ip | hostname> command, a message
displays.

SSH client is not supported when the two-factor
authentication is enabled.

Table Continued
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Validation Error/Warning/Prompt

If timeSync is in SNTP or Timep when NTP
is enabled.

Timesync is not configured to NTP.

If timesync is NTP and NTP is enabled and
we try to change timesync to SNTP.

Disable NTP before changing timesync to SNTP or
TIMEP.

If we try to configure NTP servers more than
the configured max-associations value.

The maximum number of NTP servers allowed is 2.

If we have ‘n’ NTP servers configured and
we try to configure a max-associations value
less than (n) number of NTP servers already
configured.

Max-associations value cannot be less than the
number of NTP servers configured.

If authentication key-id is not configured. Authentication key-id %d has not been configured.

If key-id is not marked as trusted. Key-id %d is not trusted.

If min poll value is more than max poll value. NTP max poll value should be more than min poll
value.

If ipv6 is not enabled on vlan interface. IPv6 address not configured on the VLAN.
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Event log messages

Cause

Event Message

RMON_AUTH_TWO_FACTOR_AUTHEN_STATUS W 01/01/15 18:24:03 03397: auth: %s.

Examples:

W 01/01/15 18:24:03 03397: auth: Public key and
username/password should be configured for the
successful two-factor authentication.

W 01/01/15 18:24:03 03397: auth: Username and
password should be configured for the successful
two-factor authentication.

W 01/01/15 18:24:03 03397: auth: Public key should
be configured for the successful two-factor
authentication.

I 01/01/15 18:24:03 03397: auth: The validation of
certificate of SSH user ‘user1’ is successful.

RMON_SSH_KEY_TWO_FACTOR_EN W 01/01/15 18:24:03 03399: ssh: %s.

Examples:

W 01/01/15 18:24:03 03399: ssh: The client public
keys without username will not be considered for the
two-factor authentication for SSH session.

W 01/01/15 18:24:03 03399: ssh: The privilege level
for the user with the SSH key conflicts with the user
configured.

RMON_SSH_TWO_FACTOR_AUTH_FAIL W 01/01/15 18:24:03 03398: ssh: %s.

Examples:

W 01/01/15 18:24:03 03398: ssh: The two-factor
authentication for SSH session failed due to the
failure in public key authentication.

W 01/01/15 18:24:03 03398: ssh: The two-factor
authentication for SSH session failed due to the
failure in username/password authentication.

W 01/01/15 18:24:03 03398: ssh: The two-factor
authentication for SSH session failed due to the
failure in validating the client certificate.

W 01/01/15 18:24:03 03398: ssh: The two-factor
authentication for SSH session failed as “ssh-server”
certificate is not installed.

When NTP client enabled. NTP client is enabled.

When NTP client disabled. NTP client is disabled.
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Event Message

When NTP found a new broadcast server. A new broadcast server at %s.

When system clock was updated with new time. The system clock time was changed by %ld sec %lu
nsec. The new time is %s.

When NTP stratum was updated. The NTP Stratum was changed from %d to %d.

When all NTP associations are cleared. All the NTP server associations are reset.

When server is not reachable. The NTP Server 10.1.1.2 is unreachable. (2 times in
60 seconds)

When MD5/SHA1 authentication failed. The MD5 authentication on the NTP packet failed.

The SHA1 authentication on the NTP packet failed.
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Viewing port status and configuring port parameters

Connecting transceivers to fixed-configuration devices
If the switch either fails to show a link between an installed transceiver and another device or demonstrates errors
or other unexpected behavior on the link, check the port configuration on both devices for a speed and/or duplex
(mode) mismatch.

• To check the mode setting for a port on the switch, use either the Port Status screen in the menu interface or
show interfaces brief in the CLI (see Viewing port status and configuration (CLI)).

• To display information about the transceivers installed on a switch, enter the show tech receivers
command in the CLI (The show tech transceivers command on page 63).

Viewing port configuration (Menu)
The menu interface displays the configuration for ports and (if configured) any trunk groups.

From the Main Menu, select:

1. Status and Counters 4. Port Status

A switch port status screen

==========================- CONSOLE - MANAGER MODE -==========================
                       Status and Counters - Port Status

                  Intrusion                           MDI   Flow  Bcast
  Port     Type     Alert   Enabled Status     Mode   Mode  Ctrl  Limit
  ----- --------- --------- ------- ------ ---------- ----- ----- ------
  1     100/1000T No        Yes     Down   100FDx     Auto  off   0
  2     100/1000T No        Yes     Down   1000FDx    Auto  off   0
  3     100/1000T No        Yes     Down   1000FDx    Auto  off   0
  4     100/1000T No        Yes     Down   1000FDx    Auto  off   0
  5     100/1000T No        Yes     Down   1000FDx    Auto  off   0
  6     100/1000T No        Yes     Down   1000FDx    Auto  off   0
  7     100/1000T No        Yes     Down   1000FDx    Auto  off   0
  8     100/1000T No        Yes     Down   1000FDx    Auto  off   0
  9     100/1000T No        Yes     Down   1000FDx    Auto  off   0
  10    100/1000T No        Yes     Down   1000FDx    Auto  off   0
  11    100/1000T No        Yes     Down   1000FDx    Auto  off   0

 Actions->   Back   Intrusion log   Help

Return to previous screen.
Use up/down arrow keys to scroll to other entries, left/right arrow keys to
change action selection, and <Enter> to execute action.

Chapter 3
Port Status and Configuration
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Port Type The port Type field represents the IEEE or other industry protocol in operation on that port. For
example, 1000Base-SX is a gigabit protocol for gigabit operation over fiber optic cable.

Status of
Ports

A port can be enabled or disabled:

• Yes: Enabled, the default. This indicates the port is ready for a network connection.

• No: Disabled, the port will not operate, even if properly connected to a network. Use the setting,
For example, to shut the port down for diagnostic purposes or while you are making topology
changes.

The status of a port can be up or down (Read-only):

Up: The port senses a link beat.

Down: The port is not enabled, has no cables connected, or is experiencing a network error. For
troubleshooting information, see the installation and getting started guide for your switch.

Flow
Control

With the port mode set to Auto (the default) and flow control on (enabled), the switch negotiates
flow control on the indicated port. If the port mode is not set to Auto, or if flow control is off
(disabled) on the port, then flow control is not used. Flow control must be enabled on both ends of
a link.

• On: Enabled. The port uses 802.3x Link Layer Flow Control, generates flow control packets,
and processes received flow control packets.

• Off: Disabled (default).The port does not generate flow control packets, and drops any flow
control packets it receives.

Broadcast
Limit

The broadcast limit specifies the percentage of the theoretical maximum network bandwidth that
can be used for broadcast and multicast traffic. Any broadcast or multicast traffic exceeding that
limit will be dropped. Zero (0) means the feature is disabled.

The broadcast-limit command operates at the port context level to set the broadcast limit for a
port on a switch.

This feature is not appropriate for networks that require high levels of IPX or RIP
broadcast traffic.

Modes The mode is the port’s speed and duplex (date transfer operation) setting. The following table
shows possible modes available, depending on the port type (copper or fiber) and port speed.

Table 3: Supported Modes

Mode Speed and Duplex Settings

Auto-MDIX Senses speed and negotiates with the port at the other end of the link for port operation (MDI-X
or MDI). To see what the switch negotiates for the Auto setting, use the CLI show interfaces
brief command or the menu commands “1. Status and Counters”, “3. Port Status”.This
features applies only to copper port switches using twisted-pair copper Ethernet cables.

MDI Sets the port to connect with a PC using a crossover cable (Manual mode— applies only to
copper port switches using twisted-pair copper Ethernet cables).

Table Continued
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Mode Speed and Duplex Settings

MDIX Sets the port to connect with a PC using a straight-through cable (Manual mode—applies only to
copper port switches using twisted-pair copper Ethernet cables).

Auto-10 Allows the port to negotiate between half-duplex (HDx) and full-duplex (FDx) while keeping
speed at 10Mbps. Also negotiates flow control (enabled or disabled). Hewlett Packard
Enterprise recommends Auto-10 for links between 10/100 auto-sensing ports connected with
Cat 3 cabling. (Cat 5 cabling is required for 100 Mbps links.)

Auto-100 Uses 100 Mbps and negotiates with the port at the other end of the link for other port operation
features.

Auto-10-100 Allows the port to establish a link with the port at the other end at either 10 Mbps or 100 Mbps,
using the highest mutual speed and duplex mode available. Only these speeds are allowed with
this setting.

Auto-1000 Uses 1000 Mbps and negotiates with the port at the other end of the link for other port operation
features.

10HDx Uses 10 Mbps, Half-Duplex

100HDx Uses 100 Mbps, Half-Duplex

10FDX Uses 10 Mbps, Full-Duplex

100FDx Uses 100 Mbps, Full-Duplex

1000FDx Uses 1000 Mbps, Full-Duplex

10 GbE FDx Uses 10 Gigabits/sec Full-Duplex

The next two tables display the protocols and modes supported for copper ports and fiber optic ports, respectively.

Table 4: Protocols and modes supported for copper ports

10/100 Mbps Gigabit 10 Gigabit

10/100 TX 10/100/1000-T 10GBASE-CX4

Modes Settings Modes Settings Modes Settings

Auto

10HDx

100HDx

10FDx

100FDx

100FDx

10HDx

100HDx

10FDx

100FDX

Auto

Auto-10

Auto-100

Auto-10-100

Auto-1000

10HDx

100HDX

1000FDx

10HDx

100FDx

100FDx

1000FDx

10HDx

100HDx

Auto 10 Gigabit FDx
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Table 5: Protocols and modes supported for fiber optic ports

100 Mbps Gigabit 10 Gigabit

Protocols 100BASE-FX

100BASE-BX10

1000BASE-SX

1000BASE-LX

1000BASE-BX

101000BASE-LH

10GBASE-SR

10GBASE-LR

10GBASE-LRM

Modes 100HDx

100FDx

Auto1000FDx Auto

Configuring ports (Menu)
The menu interface uses the same screen for configuring both individual ports and port trunk groups. For
information on port trunk groups, see the chapter on "Port Trunking".

Procedure

1. From the Main Menu, select:

2. Switch Configuration…

2. Port/Trunk Settings

Port/trunk settings with a trunk group configured

=====================- TELNET - MANAGER MODE -=====================
              Switch Configuration - Port/Trunk Settings

  Port     Type     Enabled      Mode      Flow Ctrl  Group  Type
  ----   -------- + --------  -----------  ---------  -----  -----
  A1     1000T    | Yes       Auto-10-100  Disable
  A2     1000T    | Yes       Auto-10-100  Disable
  A3     1000T    | Yes       Auto         Disable
  A3     1000T    | Yes       Auto         Disable
  A4     1000T    | Yes       Auto         Disable
  A5     1000T    | Yes       Auto         Disable
  A6     1000T    | Yes       Auto         Disable
  A7     1000T    | Yes       Auto         Disable    Trk1   Trunk
  A8     1000T    | Yes       Auto         Disable    Trk2   Trunk

 Actions->   Cancel    Edit    Save    Help

Cancel changes and return to previous screen.
Use arrow keys to change action selection and <Enter> to execute
action.

2. Press [E] (for Edit).

The cursor moves to the Enabled field for the first port.

For further information on configuration options for these features, see the online help provided with this
screen.

3. When you have finished making changes to the above parameters, press [Enter], then press [S] (for
Save).
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Viewing port status and configuration (CLI)
Use the following commands to display port status and configuration data.

Syntax:

show interfaces [brief | config | < port-list >]
brief

Lists the current operating status for all ports on the switch.

config
Lists a subset of configuration data for all ports on the switch; that is, for each port, the display shows whether
the port is enabled, the operating mode, and whether it is configured for flow control.

<port-list>
Shows a summary of network traffic handled by the specified ports.

The show interfaces brief command listing

switch(config)# show interfaces brief
Status and Counters - Port Status

                | Intrusion                            MDI   Flow  Bcast
Port  Type      | Alert     Enabled Status Mode        Mode  Ctrl  Limit
----- --------- + --------- ------- ------ ----------  ----- ----- ------
B1    100/1000T | No        Yes     Down   Auto-10-100 Auto  off   0
B2    100/1000T | No        Yes     Down   1000FDx     Auto  off   0
B3    100/1000T | No        Yes     Down   1000FDx     Auto  off   0
B4    100/1000T | No        Yes     Down   1000FDx     Auto  off   0
B5    100/1000T | No        Yes     Down   1000FDx     Auto  off   0
B6    100/1000T | No        Yes     Down   1000FDx     Auto  off   0

The show interfaces config command listing

switch(config)# show interfaces config

 Port Settings

  Port  Type      | Enabled Mode         Flow Ctrl MDI
  ----- --------- + ------- ------------ --------- ----
  B1    100/1000T | Yes     Auto-10-100  Disable   Auto
  B2    100/1000T | Yes     Auto         Disable   Auto
  B3    100/1000T | Yes     Auto         Disable   Auto
  B4    100/1000T | Yes     Auto         Disable   Auto
  B5    100/1000T | Yes     Auto         Disable   Auto
  B6    100/1000T | Yes     Auto         Disable   Auto

Dynamically updating the show interfaces command (CLI/Menu)
Syntax:

show interfaces display
Uses the display option to initiate the dynamic update of the show interfaces command, with the output
being the same as the show interfaces command.
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Select Back to exit the display.

Example:

switch# show interfaces display
When using the display option in the CLI, the information stays on the screen and is updated every 3 seconds, as
occurs with the display using the menu feature. The update is terminated with Cntl-C.

You can use the arrow keys to scroll through the screen when the output does not fit in one screen.

Figure 6: show interfaces display command with dynamically updating output

Customizing the show interfaces command (CLI)
You can create show commands displaying the information that you want to see in any order you want by using
the custom option.

Syntax:
show interfaces custom [port-list] column-list
Select the information that you want to display. Supported columns are shown in the table below.

Table 6: Supported columns, what they display, and examples:

Parameter column Displays Examples

port Port identifier A2

type Port type 100/1000T

status Port status up or down

Table Continued
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Parameter column Displays Examples

speed Connection speed and duplex 1000FDX

mode Configured mode auto, auto-100, 100FDX

mdi MDI mode auto, MDIX

flow Flow control on or off

name Friendly port name

vlanid The vlan id this port belongs to, or "tagged" if it
belongs to more than one vlan

4tagged

enabled port is or is not enabled yes or nointrusion

intrusion Intrusion alert status no

bcast Broadcast limit 0

The custom show interfaces command

switch(config)# show int custom 1-4 port name:4 type vlan intrusion speed enabled mdi

 Status and Counters - Custom Port Status

                                   Intrusion
  Port Name       Type       VLAN  Alert     Speed   Enabled MDI-mode
  ---- ---------- ---------- ----- --------- ------- ------- --------
  1    Acco       100/1000T  1     No        1000FDx Yes     Auto
  2    Huma       100/1000T  1     No        1000FDx Yes     Auto
  3    Deve       100/1000T  1     No        1000FDx Yes     Auto
  4    Lab1       100/1000T  1     No        1000FDx Yes     Auto
You can specify the column width by entering a colon after the column name, then indicating the number of
characters to display. In the above example, the Name column displays only the first four characters of the name.
All remaining characters are truncated.

Each field has a fixed minimum width to be displayed. If you specify a field width smaller than the
minimum width, the information is displayed at the minimum width. For example, if the minimum
width for the Name field is 4 characters and you specify Name:2, the Name field displays 4
characters.

You can enter parameters in any order. There is a limit of 80 characters per line; if you exceed this limit an error
displays.

Error messages associated with the show interfaces command
The following table provides information on error messages associated with the show interfaces custom
command.
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Error Error message

Requesting too many fields (total characters exceeds
80)

Total length of selected data exceeds one line

Field name is misspelled Invalid input: <input>

Mistake in specifying the port list Module not present for port or invalid port: <input>

The port list is not specified Incomplete input: custom

Note on using pattern matching with the show interfaces custom command
If you have included a pattern matching command to search for a field in the output of the show int custom
command, and the show int custom command produces an error, the error message may not be visible and
the output is empty. For example, if you enter a command that produces an error (such as vlan is misspelled) with
the pattern matching include option, the output may be empty:

HP Switch(config)# show int custom 1-3 name vlun  |  include vlan1
It is advisable to try the show int custom command first to ensure there is output, and then enter the
command again with the pattern matching option.

Note that in the above command, you can substitute int for interface; that is: show int custom.

Viewing port utilization statistics (CLI)
Use the show interface port-utilization command to view a real-time rate display for all ports on the
switch. The example below shows a sample output from this command.

A show interface port-utilization command listing

switch(config)# show interfaces port-utilization
 Status and Counters - Port Utilization

                             Rx                            Tx
 Port  Mode     | -------------------------- | --------------------------
                | Kbits/sec  Pkts/sec  Util  | Kbits/sec  Pkts/sec  Util
 ----- -------- + ---------- --------- ----- + ---------- --------- -----
 B1    1000FDx  | 0          0         0     | 0          0         0 
 B2    1000FDx  | 0          0         0     | 0          0         0 
 B3    1000FDx  | 0          0         0     | 0          0         0 
 B4    1000FDx  | 0          0         0     | 0          0         0 
 B5    1000FDx  | 0          0         0     | 0          0         0 
 B6    1000FDx  | 0          0         0     | 0          0         0 
 B7     100FDx  | 624        86        00.62 | 496        0         00.49 
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Operating notes for viewing port utilization statistics

• For each port on the switch, the command provides a real-time display of the rate at which data is received
(Rx) and transmitted (Tx) in terms of kilobits per second (KBits/s), number of packets per second (Pkts/s), and
utilization (Util) expressed as a percentage of the total bandwidth available.

• The show interfaces <port-list> command can be used to display the current link status and the port
rate average over a 5 minute period. Port rates are shown in bits per second (bps) for ports up to 1 Gigabit; for
10 Gigabit ports, port rates are shown in kilobits per second (Kbps).

Viewing transceiver status (CLI)
The show interfaces transceivers command allows you to:

• Remotely identify transceiver type and revision number without having to physically remove an installed
transceiver from its slot.

• Display real-timestatus information about all installed transceivers, including non-operational transceivers.

The example shows sample output from the show tech transceivers command.

Part # column below enables you to determine the manufacturer for a specified transceiver and
revision number.

The show tech transceivers command

switch# show tech transceivers

Transceiver Technical Information:
 Port # |   Type    | Prod # | Serial #         | Part #
 -------+-----------+--------+------------------+----------
 21     | 1000SX    | J4858B | CN605MP23K       |
 22     | 1000LX    | J4859C | H11E7X           | 2157-2345
 23     | ??        | ??     | non operational  | 
 25     | 10GbE-CX4 | J8440A | US509RU079       | 
 26     | 10GbE-CX4 | J8440A | US540RU002       | 
 27     | 10GbE-LR  | J8437B | PPA02-2904:0017  | 2157-2345
 28     | 10GbE-SR  | J8436B | 01591602         | 2158-1000
 29     | 10GbE-ER  | J8438A | PPA03-2905:0001  | 

The following transceivers may not function correctly:
 Port #         Message
 --------       ------------------------
 Port 23        Self test failure.

Operating Notes
The following information is displayed for each installed transceiver:

• Port number on which transceiver is installed.

• Type of transceiver.

• Product number — Includes revision letter, such as A, B, or C. If no revision letter follows a product number,
this means that no revision is available for the transceiver.

• Part number — Allows you to determine the manufacturer for a specified transceiver and revision number.
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• For a non-HPE switches installed transceiver (see line 23 of "The show tech transceivers command"
example), no transceiver type, product number, or part information is displayed. In the Serial Number field,
non-operational is displayed instead of a serial number.

• The following error messages may be displayed for a non-operational transceiver:

◦ Unsupported Transceiver. (SelfTest Err#060)
◦ This switch only supports revision B and above transceivers.
◦ Self test failure.
◦ Transceiver type not supported in this port.
◦ Transceiver type not supported in this software version.
◦ Not an HPE Switch Transceiver.

Enabling or disabling ports and configuring port mode (CLI)
You can configure one or more of the following port parameters.

Syntax:

[no] interface <port-list> [<disable|enable>]
Disables or enables the port for network traffic. Does not use the no form of the command. (Default: enable.)

speed-duplex [<auto-10|10-full|10-half|100-full|100-half|auto|auto-100|1000-full>]
Note that in the above Syntax:, you can substitute int for interface (for example, int <port-list> ).

Specifies the port's data transfer speed and mode. Does not use the no form of the command. (Default: auto.)

The 10/100 auto-negotiation feature allows a port to establish a link with a port at the other end at either 10 Mbps
or 100 Mbps, using the highest mutual speed and duplex mode available. Only these speeds are allowed with this
setting.

Examples:

To configure port C5 for auto-10-100, enter this command:

switch(config)# int c5 speed-duplex auto-10-100
To configure ports C1 through C3 and port C6 for 100Mbps full-duplex, enter these commands:

switch(config)# int c1-c3,c6 speed-duplex 100-full
Similarly, to configure a single port with the above command settings, you could either enter the same command
with only the one port identified or go to the context level for that port and then enter the command. For example,
to enter the context level for port C6 and then configure that port for 100FDx:

switch(config)# int e c6
switch(eth-C6)# speed-duplex 100-full
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If port C8 was disabled, and you wanted to enable it and configure it for 100FDx with flow-control active, you
could do so with either of the following command sets:

Figure 7: Two methods for changing a port configuration

For more on flow control, see Enabling or disabling flow control (CLI) on page 65.

Enabling or disabling flow control (CLI)

You must enable flow control on both ports in a given link. Otherwise, flow control does not operate
on the link and appears as Off in the show interfaces brief port listing, even if flow control is
configured as enabled on the port in the switch. (See The show interfaces brief command
listing example.) Also, the port (speed-duplex) mode must be set to Auto (the default).

To disable flow control on some ports, while leaving it enabled on other ports, just disable it on the individual ports
you want to exclude.

Syntax:

[no] interface <port-list> flow-control
Enables or disables flow control packets on the port. The no form of the command disables flow control on the
individual ports. (Default: Disabled.)

Examples:

Suppose that:

1. You want to enable flow control on ports A1-A6.

2. Later, you decide to disable flow control on ports A5 and A6.

3. As a final step, you want to disable flow control on all ports.
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Assuming that flow control is currently disabled on the switch, you would use these commands:

Figure 8: Configuring flow control for a series of ports

switch(config)# int a1-a6 flow-control

switch(config)# show interfaces brief

 Status and Counters - Port Status

                   | Intrusion                           MDI  Flow Bcast
  Port   Type      | Alert     Enabled Status Mode       Mode Ctrl Limit
  ------ --------- + --------- ------- ------ ---------- ---- ---- ----- 
  A1     10GbE-T   | No        Yes     Up     1000FDx    NA   on   0
  A2     10GbE-T   | No        Yes     Up     10GigFD    NA   on   0
  A3     10GbE-T   | No        Yes     Up     10GigFD    NA   on   0
  A4     10GbE-T   | No        Yes     Up     10GigFD    NA   on   0
  A5     10GbE-T   | No        Yes     Up     10GigFD    NA   on   0
  A6     10GbE-T   | No        Yes     Up     10GigFD    NA   on   0
  A7     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A8     10GbE-T   | No        Yes     Up     10GigFD    NA   off  0

switch(config)# no int a5-a6 flow-control

switch(config)# show interfaces brief

 Status and Counters - Port Status

                   | Intrusion                           MDI  Flow Bcast
  Port   Type      | Alert     Enabled Status Mode       Mode Ctrl Limit
  ------ --------- + --------- ------- ------ ---------- ---- ---- ----- 
  A1     10GbE-T   | No        Yes     Up     1000FDx    NA   on   0
  A2     10GbE-T   | No        Yes     Down   10GigFD    NA   on   0
  A3     10GbE-T   | No        Yes     Down   10GigFD    NA   on   0
  A4     10GbE-T   | No        Yes     Down   10GigFD    NA   on   0
  A5     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A6     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A7     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A8     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0

switch(config)# no int a1-a4 flow-control

switch(config)# show interfaces brief

 Status and Counters - Port Status

                   | Intrusion                           MDI  Flow Bcast
  Port   Type      | Alert     Enabled Status Mode       Mode Ctrl Limit
  ------ --------- + --------- ------- ------ ---------- ---- ---- ----- 
  A1     10GbE-T   | No        Yes     Down   1000FDx    NA   off  0
  A2     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A3     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A4     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A5     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A6     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A7     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A8     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
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Configuring a broadcast limit
Broadcast-Limit on switches covered in this guide is configured on a per-port basis. You must be at the port
context level for this command to work, for example:

switch(config)#int 1
switch(int 1)# broadcast-limit 1

Broadcast-limit
Syntax:

broadcast-limit <0-99>
Enables or disables broadcast limiting for outbound broadcasts on a selected port on the switch. The value
selected is the percentage of traffic allowed, for example, broadcast-limit 5 allows 5% of the maximum
amount of traffic for that port. A value of zero disables broadcast limiting for that port.

You must switch to port context level before issuing the broadcast-limit command.

This feature is not appropriate for networks requiring high levels of IPX or RIP broadcast traffic.

Syntax:

show config
Displays the startup-config file. The broadcast limit setting appears here if enabled and saved to the startup-config
file.

Syntax:

show running-config
Displays the running-config file. The broadcast limit setting appears here if enabled. If the setting is not also saved
to the startup-config file, rebooting the switch returns broadcast limit to the setting currently in the startup-config
file.

For example, the following command enables broadcast limiting of 1 percent of the traffic rate on the selected port
on the switch:

switch(int 1)# broadcast-limit 1
For a one Gbps port this results in a broadcast traffic rate of ten Mbps.

Port shutdown with broadcast storm
A LAN broadcast storm arises when an excessively high rate of broadcast packets flood the LAN. Occurrence of
LAN broadcast storm disrupts traffic and degrades network performance. To prevent LAN traffic from being
disrupted, an enhancement of fault-finder commands adds new options, and the corresponding MIBs, that trigger
a port disablement when a broadcast storm is detected on that port.

Under this enhancement, the CLI commands given only supports broadcast traffic and not multicast and unicast
types of traffic.

The waiting period range for re-enabling ports is 0 to 604800 seconds. The default waiting period to re-enable a
port is zero which prevents the port from automatic re-enabling.

Avoid port flapping when choosing the waiting period by considering the time to re-enable carefully.
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Use the following commands to configure the broadcast-storm on a port.

Syntax:

[no] fault-finder broadcast-storm [ethernet] <port-list> action [warn|warn-and-disable <seconds>] [percent <percent>|pps <rate>]

To remove the current configuration of broadcast-storm on a port, use:

Syntax:

no fault-finder broadcast-storm [ethernet] <port-list>
broadcast-storm

Configure broadcast storm control.

pps
Rising threshold level in number of broadcast packets per second.

percent
Rising threshold level as a percentage of bandwidth of the port. The percentage is calculated on 64 byte
packet size.

warn
Log the event only.

warn-and-disable
Log the event and disable the port.

seconds
Re-enable the port after waiting for the specified number of seconds. Default is not to re-enable.

Configuration examples:
switch(config)# fault-finder broadcast-storm [ethernet] <A1> action [warn-and-disable <65535>]< percent 10>
switch(config)# fault-finder broadcast-storm [ethernet] <A2> action [warn-and-disable <pps 100>
switch(config)# fault-finder broadcast-storm [ethernet] <A22> action [warn] <pps 100>

Viewing broadcast storm
Use the following command to display the broadcast-storm-control configuration.

Syntax:

show fault-finder broadcast-storm [[ethernet] port-list]
Examples:
switch# show fault-finder broadcast-storm [A1]

Port Bcast Storm Port Status Rising
Threshold

Action Disable
Timer

Disable
Timer Left

A1 Yes Down 10% warn-and-
disable

65535 —

switch (config)# show fault-finder broadcast-storm
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Port Bcast Storm Port Status Rising
Threshold

Action Disable
Timer

Disable
Timer Left

A1 Yes Down 200 pps warn-and-
disable

10 9

switch (config)# show fault-finder broadcast-storm A1

Port Bcast Storm Port Status Rising
Threshold

Action Disable
Timer

Disable
Timer Left

A1 No Up — none — —

switch (config)# show fault-finder broadcast-storm

Port Bcast Storm Port Status Rising
Threshold

Action Disable
Timer

Disable
Timer Left

A1 Yes Up 75% warn — —

SNMP MIB
SNMP support will be provided through the following MIB objects:

hpicfFfBcastStormControlPortConfig OBJECT IDENTIFIER

:: = { hpicfFaultFinder 5 }

hpicfFfBcastStormControlPortConfigTable OBJECT-TYPE

• syntax sequence: HpicfFfBcastStormControlPortConfigEntry

• max-access: not-accessible

• status: current

• description: This table provides information about broadcast storm control configuration of all ports.::=
{hpicfFfBcastStormControlPortConfig 1}

hpicfFfBcastStormControlPortConfigEntry OBJECT-TYPE

• syntax HpicfFfBcastStormControlPortConfigEntry

• max-access: not-accessible

• status: current

• description: This object provides information about broadcast storm control configuration of each port.

• index: {hpicfffbcaststormcontrolportindex}::= {hpicfFfBcastStormControlPortConfigTable 1}

hpicfFfBcastStormControlPortConfigEntry ::=

Syntax sequence:hpicfFfBcastStormControlPortIndex InterfaceIndex,

hpicfFfBcastStormControlMode Integer,

hpicfFfBcastStormControlRisingpercent Integer32,

hpicfFfBcastStormControlRisingpps Integer32,
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hpicfFfBcastStormControlAction Integer,

hpicfFfBcastStormControlPortDisableTimer Unsigned32

hpicfFfBcastStormControlPortIndex OBJECT-TYPE

• Syntax: Interfaceindex

• max-access: not-accessible

• status: current

• description: The Index Value Which Uniquely Identifies A Row In The Interfaces Table.

::= {hpicfFfBcastStormControlPortConfigEntry 1}

hpicfFfBcastStormControlMode OBJECT-TYPE

• Syntax Integer: disabled(1), Bcastrisinglevelpercent(2), Bcastrisinglevelpps(3)

• max-access: read-write

• status: current

• description: The broadcast storm control mode of a port. A value of disable (1) indicates that no rising
threshold value is set for broadcast storm traffic on this port. A value of bcastrisinglevelpercent (2) indicates
that the rising threshold rate for broadcast storm traffic is configured in percentage of port bandwidth. A value
of bcastrisinglevelpps (3) indicates that the rising threshold rate for broadcast storm traffic is configured in
packets per second.

• DEFVAL: disabled

::= {hpicfFfBcastStormControlPortConfigEntry 2}

hpicfFfBcastStormControlRisingpercent OBJECT-TYPE

• Syntax Integer32 (1..100)

• max-access: read-write

• status: current

• description: This Is The Rising Threshold Level in percent of bandwidth of the port.
hpicfFfBcastStormControlAction occurs when broadcast traffic reaches this level.

::= {hpicfFfBcastStormControlPortConfigEntry 3}

hpicfFfBcastStormControlRisingpps OBJECT-TYPE

• Syntax Integer32 (1..10000000)

• max-access: read-write

• status: current

• description: This object indicates the rising threshold for broadcast storm control. This value is in packets-per-
second of received broadcast traffic. hpicfffbcaststormcontrolaction object takes action when broadcast
traffic reaches this level.
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::= {hpicfFfBcastStormControlPortConfigEntry 4}

hpicfFfBcastStormControlAction OBJECT-TYPE

• Syntax integer: none(1), warn(2), warnanddisable(3)

• max-access: read-write

• status: current

• Description: This object defines the action taken by the switch when a broadcast storm occurs on a port. A
value of none (1) indicates that no action is performed. A value of warn (2) indicates that an event is logged
when broadcast traffic crosses the threshold value set on that port. A value of warn-and-disable (3) indicates
that the port is disabled and an event is logged as soon as the broadcast traffic reaches the threshold value
set on that port.

• DEFVAL: none

::= {hpicfFfBcastStormControlPortConfigEntry 5}

hpicfFfBcastStormControlPortDisableTimer OBJECT-TYPE

• Syntax Unsigned32 (0..604800)

• Units: seconds

• max-access: read-write

• status: current

• Description: This object specifies the time period for which the port remains in disabled state. A port is disabled
when broadcast traffic reaches the threshold value set on that port. This time period is specified in seconds.
The default value is zero which means that the port remains disabled and is not enabled again.

• DEFVAL {0}

::= {hpicfFfBcastStormControlPortConfigEntry 6}

Configuring auto-MDIX
Copper ports on the switch can automatically detect the type of cable configuration (MDI or MDI-X) on a
connected device and adjust to operate appropriately.

This means you can use a "straight-through" twisted-pair cable or a "crossover" twisted-pair cable for any of the
connections—the port makes the necessary adjustments to accommodate either one for correct operation. The
following port types on your switch support the IEEE 802.3ab standard, which includes the "Auto MDI/MDI-X"
feature:

• 10/100-TX xl module ports

• 100/1000-T xl module ports

• 10/100/1000-T xl module ports

Using the above ports:
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• If you connect a copper port using a straight-through cable on a switch to a port on another switch or hub that
uses MDI-X ports, the switch port automatically operates as an MDI port.

• If you connect a copper port using a straight-through cable on a switch to a port on an end node—such as a
server or PC—that uses MDI ports, the switch port automatically operates as an MDI-X port.

Auto-MDIX was developed for auto-negotiating devices, and was shared with the IEEE for the development of the
IEEE 802.3ab standard. Auto-MDIX and the IEEE 802.3ab Auto MDI/MID-X feature are completely compatible.
Additionally, Auto-MDIX supports operation in forced speed and duplex modes.

For more information on this subject, see the IEEE 802.3ab standard reference. For more information on MDI-X,
the installation and getting started guide for your switch.

Manual override
If you require control over the MDI/MDI-X feature, you can set the switch to either of these non-default modes:

• Manual MDI

• Manual MDI-X

The table below shows the cabling requirements for the MDI/MDI-X settings.

Table 7: Cable types for auto and manual MDI/MDI-X settings

Setting MDI/MDI-X device type

PC or other MDI device type Switch, hub, or other MDI-X device

Manual MDI Crossover cable Straight-through cable

Manual MDI-X Straight-through cable Crossover cable

Auto-MDI-X (the default) Either crossover or straight-through cable

The AutoMDIX features apply only to copper port switches using twisted-pair copper Ethernet cables.

Configuring auto-MDIX (CLI)
The auto-MDIX features apply only to copper port switches using twisted-pair copper Ethernet cables. For
information about auto-MDIX, see Configuring auto-MDIX on page 71.

Syntax:

interface <port-list> mdix-mode < {auto-mdix | mdi | mdix>}

auto-mdix The automatic,default setting. This configures the port for automatic detection of the cable
(either straight-through or crossover).

mdi The manual mode setting that configures the port for connecting to either a PC or other MDI
device with a crossover cable, or to a switch, hub, or other MDI-X device with a straight-
through cable.

mdix The manual mode setting that configures the port for connecting to either a switch, hub, or
other MDI-X device with a crossover cable, or to a PC or other MDI device with a straight-
through cable.
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Syntax:

show interfaces config
Lists the current per-port Auto/MDI/MDI-X configuration.

Syntax:

show interfaces brief

• Where a port is linked to another device, this command lists the MDI mode the port is currently using.

• In the case of ports configured for Auto ( auto-mdix), the MDI mode appears as either MDI or MDIX,
depending upon which option the port has negotiated with the device on the other end of the link.

• In the case of ports configured for MDI or MDIX, the mode listed in this display matches the configured setting.

• If the link to another device was up, but has gone down, this command shows the last operating MDI mode the
port was using.

• If a port on a given switch has not detected a link to another device since the last reboot, this command lists
the MDI mode to which the port is currently configured.

The show interfaces config displays the following data when port A1 is configured for auto-mdix, port A2
is configured for mdi, and port A3 is configured for mdix:

Displaying the current MDI configuration

switch(config)# show interfaces config

 Port Settings

  Port   Type      | Enabled Mode         Flow Ctrl MDI
  ------ --------- + ------- ------------ --------- ---- 
  A1     10GbE-T   | Yes     Auto         Disable   Auto 
  A2     10GbE-T   | Yes     Auto         Disable   MDI 
  A3     10GbE-T   | Yes     Auto         Disable   MDIX 
  A4     10GbE-T   | Yes     Auto         Disable   Auto 
  A5     10GbE-T   | Yes     Auto         Disable   Auto 
  A6     10GbE-T   | Yes     Auto         Disable   Auto 
  A7     10GbE-T   | Yes     Auto         Disable   Auto 
  A8     10GbE-T   | Yes     Auto         Disable   Auto

Displaying the current MDI operating mode

switch(config)# show interfaces brief

 Status and Counters - Port Status

                   | Intrusion                           MDI  Flow Bcast
  Port   Type      | Alert     Enabled Status Mode       Mode Ctrl Limit
  ------ --------- + --------- ------- ------ ---------- ---- ---- ----- 
  A1     10GbE-T   | No        Yes     Up     1000FDx    MDIX off  0
  A2     10GbE-T   | No        Yes     Down   10GigFD    MDI  off  0
  A3     10GbE-T   | No        Yes     Down   10GigFD    MDIX off  0
  A4     10GbE-T   | No        Yes     Down   10GigFD    Auto off  0
  A5     10GbE-T   | No        Yes     Down   10GigFD    Auto off  0
  A6     10GbE-T   | No        Yes     Down   10GigFD    Auto off  0
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  A7     10GbE-T   | No        Yes     Down   10GigFD    Auto off  0
  A8     10GbE-T   | No        Yes     Down   10GigFD    Auto off  0

Using friendly (optional) port names
This feature enables you to assign alphanumeric port names of your choosing to augment automatically assigned
numeric port names. This means you can configure meaningful port names to make it easier to identify the source
of information listed by some show commands. (Note that this feature augments port numbering, but does not
replace it.)

Configuring and operating rules for friendly port names

• At either the global or context configuration level, you can assign a unique name to a port. You can also assign
the same name to multiple ports.

• The friendly port names you configure appear in the output of the show name [port-list], show config, and
show interface <port-number > commands. They do not appear in the output of other show
commands or in Menu interface screens. (See Displaying friendly port names with other port data (CLI) on
page 75.)

• Friendly port names are not a substitute for port numbers in CLI commands or Menu displays.

• Trunking ports together does not affect friendly naming for the individual ports. (If you want the same name for
all ports in a trunk, you must individually assign the name to each port.)

• A friendly port name can have up to 64 contiguous alphanumeric characters.

• Blank spaces within friendly port names are not allowed, and if used, cause an invalid input error. (The switch
interprets a blank space as a name terminator.)

• In a port listing, not assigned indicates that the port does not have a name assignment other than its fixed
port number.

• To retain friendly port names across reboots, you must save the current running-configuration to the startup-
config file after entering the friendly port names. (In the CLI, use the write memory command.)

Configuring friendly port names (CLI)
For detailed information about friendly port names, see Using friendly (optional) port names on page 74.

Syntax:

interface <port-list> name <port-name-string>
Assigns a port name to port-list.

Syntax:

no interface <port-list> name
Deletes the port name from <port-list>.

Configuring a single port name (CLI)
Suppose that you have connected port A3 on the switch to Bill Smith's workstation, and want to assign Bill's name
and workstation IP address (10.25.101.73) as a port name for port A3:

74 Aruba 2530 Management and Configuration Guide for ArubaOS-Switch 16.05

Anexo 04 ITEM 11 (0592666)         SEI 0008478-63.2018.6.02.8000 / pg. 5898



Configuring a friendly port name

switch(config)# int A3 name
Bill_Smith@10.25.101.73
switch(config)# write mem
switch(config)# show name A3

 Port Names
  Port : A3
   Type : 10/100TX

Configuring the same name for multiple ports (CLI)
Suppose that you want to use ports A5 through A8 as a trunked link to a server used by a drafting group. In this
case you might configure ports A5 through A8 with the name "Draft-Server:Trunk."

Configuring one friendly port name on multiple ports

switch(config)# int a5-a8 name Draft-Server:Trunk
switch(config)# write mem
switch(config)# show name a5-a8
 
 Port Names

  Port : A5
   Type : 10GbE-T
   Name : Draft-Server:Trunk
 
 Port : A6
   Type : 10GbE-T
   Name : Draft-Server:Trunk
 
 Port : A7
   Type : 10GbE-T
   Name : Draft-Server:Trunk

  Port : A8
   Type : 10GbE-T
   Name : Draft-Server:Trunk

Displaying friendly port names with other port data (CLI)
You can display friendly port name data in the following combinations:

Syntax:

show name
Displays a listing of port numbers with their corresponding friendly port names and also quickly shows you which
ports do not have friendly name assignments. (show name data comes from the running-config file.)

Syntax:

show interface <port-number>
Displays the friendly port name, if any, along with the traffic statistics for that port. (The friendly port name data
comes from the running-config file.)
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Syntax:

show config
Includes friendly port names in the per-port data of the resulting configuration listing. (show config data comes
from the startup-config file.)

Listing all ports or selected ports with their friendly port names (CLI)
Syntax:

show name [port-list]
Lists the friendly port name with its corresponding port number and port type. The show name command without
a port list shows this data for all ports on the switch.

Friendly port name data for all ports on the switch

switch(config)# show name
Port Names
  Port   Type      Name
  ------ --------- ---------------------------- 
  A1     10GbE-T
  A2     10GbE-T
  A3     10GbE-T   Bill_Smith@10.25.101.73
  A4     10GbE-T
  A5     10GbE-T   Draft-Server:Trunk 
  A6     10GbE-T   Draft-Server:Trunk 
  A7     10GbE-T   Draft-Server:Trunk 
  A8     10GbE-T   Draft-Server:Trunk

Friendly port name data for specific ports on the switch

switch(config)# show name A3-A5
 Port Names
  Port : A3
  Type : 10GbE-T
  Name : Bill_Smith@10.25.101.73
 Port : A4
  Type : 10GbE-T 
  Name :
 Port : A5
  Type : 10GbE-T
  Name : Draft-Server:Trunk

Including friendly port names in per-port statistics listings (CLI)
Syntax:

show interface <port-number>
Includes the friendly port name with the port's traffic statistics listing. A friendly port name configured to a port is
automatically included when you display the port's statistics output.

If you configure port A1 with the name "O'Connor_10.25.101.43," the show interface output for this port
appears similar to the following:
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A friendly port name in a per-port statistics listing

switch(config)# show interface a1
 Status and Counters - Port Counters for port A1

  Name  : O’Connor@10.25.101.43
  MAC Address     : 001871-b995ff
  Link Status     : Up
  Totals (Since boot or last clear) :
   Bytes Rx       : 2,763,197          Bytes Tx       : 22,972
   Unicast Rx     : 2044               Unicast Tx     : 128
   Bcast/Mcast Rx  : 23,456            Bcast/Mcast Tx : 26
  Errors (Since boot or last clear) :
   FCS Rx         : 0                  Drops Tx       : 0
   Alignment Rx    : 0                 Collisions Tx  : 0
   Runts Rx       : 0                  Late Colln Tx  : 0
   Giants Rx      : 0                  Excessive Colln : 0
   Total Rx Errors : 0                 Deferred Tx    : 0
  Others (Since boot or last clear) :
   Discard Rx     : 0                  Out Queue Len  : 0
   Unknown Protos  : 0
  Rates (5 minute weighted average) :
   Total Rx (bps) : 3,028,168          Total Tx  (bps) : 1,918,384
   Unicast Rx (Pkts/sec) : 5           Unicast Tx (Pkts/sec) : 0
   B/Mcast Rx (Pkts/sec) : 71          B/Mcast Tx (Pkts/sec) : 0
   Utilization Rx  : 00.30 %           Utilization Tx : 00.19 %
For a given port, if a friendly port name does not exist in the running-config file, the Name line in the above
command output appears as:

Name : 

Searching the configuration for ports with friendly port names (CLI)
This option tells you which friendly port names have been saved to the startup-config file. (show config does
not include ports that have only default settings in the startup-config file.)

Syntax:

show config
Includes friendly port names in a listing of all interfaces (ports) configured with non-default settings. Excludes
ports that have neither a friendly port name nor any other non-default configuration settings.

See Listing of the startup-config file with a friendly port name configured (and saved) on page 77 to
configure port A1 with a friendly port name. Notice that the command sequence saves the friendly port name for
port A1 in the startup-config file. The name entered for port A2 is not saved because it was executed after write
memory.

Listing of the startup-config file with a friendly port name configured (and saved)

switch(config)# int A1 name Print_Server@10.25.101.43
switch(config)# write mem
switch(config)# int A2 name Herbert's_PC

switch(config)# show config

 Startup configuration:
; J9091A Configuration Editor; Created on release xx.15.05.xxxx
hostname "HPSwitch"
 interface AQ
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  name "Print_Server@10.25.101.43
 exit

snmp-server community "public" Unrestricted
.
.
.

Uni-directional link detection (UDLD)
Uni-directional link detection (UDLD) monitors a link between two switches and blocks the ports on both ends of
the link if the link fails at any point between the two devices. This feature is particularly useful for detecting failures
in fiber links and trunks. Figure 9: UDLD Example: on page 78 shows an Example:.

Figure 9: UDLD Example:

In this Example:, each switch load balances traffic across two ports in a trunk group. Without the UDLD feature, a
link failure on a link that is not directly attached to one of the HPE switches remains undetected. As a result, each
switch continue to send traffic on the ports connected to the failed link. When UDLD is enabled on the trunk ports
on each switch, the switches detect the failed link, block the ports connected to the failed link, and use the
remaining ports in the trunk group to forward the traffic.

Similarly, UDLD is effective for monitoring fiber optic links that use two uni-direction fibers to transmit and receive
packets. Without UDLD, if a fiber breaks in one direction, a fiber port may assume the link is still good (because
the other direction is operating normally) and continue to send traffic on the connected ports. UDLD-enabled
ports; however, will prevent traffic from being sent across a bad link by blocking the ports in the event that either
the individual transmitter or receiver for that connection fails.

Ports enabled for UDLD exchange health-check packets once every five seconds (the link-keepalive interval). If a
port does not receive a health-check packet from the port at the other end of the link within the keepalive interval,
the port waits for four more intervals. If the port still does not receive a health-check packet after waiting for five
intervals, the port concludes that the link has failed and blocks the UDLD-enabled port.

When a port is blocked by UDLD, the event is recorded in the switch log or via an SNMP trap (if configured); and
other port blocking protocols, like spanning tree or meshing, will not use the bad link to load balance packets. The
port will remain blocked until the link is unplugged, disabled, or fixed. The port can also be unblocked by disabling
UDLD on the port.

Configuring UDLD
When configuring UDLD, keep the following considerations in mind:
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• UDLD is configured on a per-port basis and must be enabled at both ends of the link. See the note below for a
list of switches that support UDLD.

• To configure UDLD on a trunk group, you must configure the feature on each port of the group individually.
Configuring UDLD on a trunk group's primary port enables the feature on that port only.

• Dynamic trunking is not supported. If you want to configure a trunk group that contains ports on which UDLD is
enabled, you must remove the UDLD configuration from the ports. After you create the trunk group, you can
re-add the UDLD configuration.

Configuring uni-directional link detection (UDLD) (CLI)
For detailed information about UDLD, see Uni-directional link detection (UDLD) on page 78.

Syntax:

[no] interface <port-list> link-keepalive
Enables UDLD on a port or range of ports.

To disable this feature, enter the no form of the command.

Default: UDLD disabled

Syntax:

link-keepalive interval <interval>
Determines the time interval to send UDLD control packets. The interval parameter specifies how often the ports
send a UDLD packet. You can specify from 10 to 100, in 100-ms increments, where 10 is 1 second, 11 is 1.1
seconds, and so on.

Default: 50 (5 seconds)

Syntax:

link-keepalive retries <num>
Determines the maximum number of retries to send UDLD control packets. The num parameter specifies the
maximum number of times the port will try the health check. You can specify a value from 3 to 10.

Default: 5

Syntax:

[no] interface <port-list> link-keepalive vlan <vid>
Assigns a VLAN ID to a UDLD-enabled port for sending tagged UDLD control packets.Under default settings,
untagged UDLD packets can still be transmitted and received on tagged only ports; however, a warning message
is logged.

The no form of the command disables UDLD on the specified ports.

Default: UDLD packets are untagged; tagged-only ports transmit and receive untagged UDLD control packets

Enabling UDLD (CLI)
UDLD is enabled on a per-port basis.

Example:

Chapter 3 Port Status and Configuration 79

Anexo 04 ITEM 11 (0592666)         SEI 0008478-63.2018.6.02.8000 / pg. 5903



To enable UDLD on port a1, enter:

switch(config)#interface al link-keepalive
To enable the feature on a trunk group, enter the appropriate port range. For example:

switch(config)#interface al-a4 link-keepalive

When at least one port is UDLD-enabled, the switch will forward out UDLD packets that arrive on
non-UDLD-configured ports out of all other non-UDLDconfigured ports in the same vlan. That is,
UDLD control packets will “pass through” a port that is not configured for UDLD. However, UDLD
packets will be dropped on any blocked ports that are not configured for UDLD.

Changing the keepalive interval (CLI)
By default, ports enabled for UDLD send a link health-check packet once every 5 seconds. You can change the
interval to a value from 10 to 100 deciseconds, where 10 is 1 second, 11 is 1.1 seconds, and so on.

Example:

To change the packet interval to seven seconds, enter the following command at the global configuration level:

switch(config)# link-keepalive interval 70

Changing the keepalive retries (CLI)
By default, a port waits 5 seconds to receive a health-check reply packet from the port at the other end of the link.
If the port does not receive a reply, the port tries four more times by sending up to four more health-check
packets. If the port still does not receive a reply after the maximum number of retries, the port goes down.

You can change the maximum number of keepalive attempts to a value from 3 to 10.

Example:

To change the maximum number of attempts to four, enter the following command at the global configuration
level:

switch(config)# link-keepalive retries 4

Configuring UDLD for tagged ports
The default implementation of UDLD sends the UDLD control packets untagged, even across tagged ports. If an
untagged UDLD packet is received by a non-HPE switch, that switch may reject the packet. To avoid such an
occurrence, you can configure ports to send out UDLD control packets that are tagged with a specified VLAN.

To enable ports to receive and send UDLD control packets tagged with a specific VLAN ID, enter a command
such as the following at the interface configuration level:

switch(config)#interface link-keepalive vlan 22

• You must configure the same VLANs that will be used for UDLD on all devices across the
network; otherwise, the UDLD link cannot be maintained.

• If a VLAN ID is not specified, UDLD control packets are sent out of the port as untagged packets.

• To re-assign a VLAN ID, re-enter the command with the new VLAN ID number. The new
command overwrites the previous command setting.

• When configuring UDLD for tagged ports, you may receive a warning message if there are any
inconsistencies with the VLAN configuration of the port.
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Viewing UDLD information (CLI)
Syntax:

show link-keepalive
Displays all the ports that are enabled for link-keepalive.

Syntax:

show link-keepalive statistics
Displays detailed statistics for the UDLD-enabled ports on the switch.

Syntax:

clear link-keepalive statistics
Clears UDLD statistics. This command clears the packets sent, packets received, and transitions counters in the
show link-keepalive statistics display.

Viewing summary information on all UDLD-enabled ports (CLI)
Enter the show link-keepalive command.

Example:

Figure 10: Example: of show link-keepalive command

Viewing detailed UDLD information for specific ports (CLI)
Enter the show link-keepalive statistics command.
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Example:

Figure 11: Example: of show link-keepalive statistics command

Clearing UDLD statistics (CLI)
Enter the following command:

switch# clear link-keepalive statistics
This command clears the packets sent, packets received, and transitions counters in the show link
keepalive statistics display (see Figure 11: Example: of show link-keepalive statistics command on
page 82 for an Example:).
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Introduction to PoE
PoE technology allows IP telephones, wireless LAN access points, and other appliances to receive power and
transfer data over existing ethernet LAN cabling. For more information about PoE technology, see the PoE/PoE+
planning and implementation guide, which is available on the HPE Networking website at http://www.hpe.com/
networking. Enter your Switch number.

Additionally, PoE+ provides more power-management capability, allowing the switch to have more power
available for more PDs. Power can be allocated exactly and automatically according to what the PD actually
requires at a given time.

PoE terminology
Power-over-ethernet (PoE) and Power-over-ethernet plus (PoE+ or POEP) operate similarly in most cases. Any
differences between PoE and PoE+ operation are noted; otherwise, the term "PoE" is used to designate both PoE
and PoE+ functionality.

Planning and implementing a PoE configuration
This section provides an overview of some considerations for planning a PoE application. For additional
information on this topic, refer to the HPE PoE/PoE+ planning and implementation guide which is available on the
HPE Networking web site at http://www.hpe.com/networking.

Some of the elements you may want to consider for a PoE installation include:

• Port assignments to VLANs

• Use of security features

• Power requirements

This section can help you to plan your PoE installation. If you use multiple VLANs in your network, or if you have
concerns about network security, you should read the first two topics. If your PoE installation comes close to (or is
likely to exceed) the system’s ability to supply power to all devices that may request it, then you should also read
the third topic. (If it is unlikely that your installation will even approach a full utilization of the PoE power available,
then you may find it unnecessary to spend much time on calculating PoE power scenarios.)

Power requirements
To get the best PoE performance, you should provide enough PoE power to exceed the maximum amount of
power that is needed by all the PDs that are being used.

By connecting an external power supply you can optionally provision more PoE wattage per port and or supply
the switch with redundant 12V power to operate should an internal power supply fail. A Power Supply Shelf
(external power supply) can also be connected to these switches to provide extra or redundant PoE power.

See the HPE PoE/PoE+ planning and implementation guide for detailed information about the PoE/PoE+ power
requirements for your switch.

Chapter 4
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Assigning PoE ports to VLANs
If your network includes VLANs, you may want to assign various PoE-configured ports to specific VLANs. For
example, if you are using PoE telephones in your network, you may want to assign ports used for telephone
access to a VLAN reserved for telephone traffic.

Applying security features to PoE configurations
You can utilize security features built into the switch to control device or user access to the network through PoE
ports in the same way as non-PoE ports.

MAC Address Security: Using Port Security, you can configure each switch port with a unique list of MAC
addresses for devices that are authorized to access the network through that port. For more information, refer to
the titled “Configuring and Monitoring Port Security” in the access security guide for your switch.

Assigning priority policies to PoE traffic
You can use the configurable QoS (Quality of Service) features in the switch to create prioritization policies for
traffic moving through PoE ports. The available classifiers and their order of precedence are show in the table
below.

Table 8: Classifiers for prioritizing outbound packets

Priority QoS classifier

1 UDP/TCP application type (port)

2 Device priority (destination or source IP address)

3 IP type of service (ToS) field (IP packets only)

4 VLAN priority

5 Incoming source-port on the switch

6 Incoming 802.1 priority (present in tagged VLAN environments)

For more on this topic, refer to the titled “Quality of Service: Managing Bandwidth More Effectively” in the
Advanced Traffic Management Guide for your switch.

PoE Event Log messages
Please see the event log message reference guide for information about Event Log messages. To see these
manuals, go to http://www.hpe.com/networking. Auto search the model number for your switch, for Example:
“HPE Switch 2530”, then select the device from the list and click on Product manuals. Click on the “User guide”
link under Manuals.

About PoE operation
Using the commands described in this chapter, you can:

• Enable or disable PoE operation on individual ports.

• Monitor PoE status and performance per module.
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• Configure a non-default power threshold for SNMP and Event Log reporting of PoE consumption on either all
PoE ports on the switch or on all PoE ports in one or more PoE modules.

• Specify the port priority you want to use for provisioning PoE power in the event that the PoE resources
become oversubscribed.

Power-sourcing equipment (PSE) detects the power needed by a powered device (PD) before supplying that
power, a detection phase referred to as "searching." If the PSE cannot supply the required amount of power, it
does not supply any power. For PoE using a Type 1 device, a PSE will not supply any power to a PD unless the
PSE has at least 17 watts available. For example, if a PSE has a maximum available power of 382 watts and is
already supplying 378 watts, and is then connected to a PD requiring 10 watts, the PSE will not supply power to
the PD.

For PoE+ using Type 2 devices, the PSE must have at least 33 watts available.

Configuration options
In the default configuration, PoE support is enabled on the ports in a PoE module installed on the switch. The
default priority for all ports is low and the default power notification threshold is 80%. Using the CLI, you can:

• Disable or re-enable PoE operation on individual PoE ports

• Enable support for pre-standard devices

• Change the PoE priority level on individual PoE ports

• Change the threshold for generating a power level notice

• Manually allocate the amount of PoE power for a port by usage, value, or class

• Allocate PoE power based on the link-partner’s capabilities via LLDP

The ports support standard networking links and PoE links. You can connect either a non-PoE device
or a PD to a port enabled for PoE without reconfiguring the port.

PD support
To best utilize the allocated PoE power, spread your connected PoE devices as evenly as possible across
modules. Depending on the amount of power delivered to a PoE module, there may or may not always be enough
power available to connect and support PoE operation on all ports in the module. When a new PD connects to a
PoE module and the module does not have enough power left for that port, if the new PD connects to a port "X"
that has a:

• Higher

PoEpriority than another port "Y" that is already supporting another PD, the power is removed from port "Y"
and delivered to port "X." In this case the PD on port "Y" loses power and the PD on port "X" receives power.

• Lower

priority than all other PoE ports currently providing power to PDs, power is not supplied to port "X" until one or
more PDs using higher priority ports are removed.

In the default configuration (usage), when a PD connects to a PoE port and begins operating, the port retains
only enough PoE power to support the PD's operation. Unused power becomes available for supporting other PD
connections. However, if you configure the poe-allocate-by option to either value or class, all of the power
configured is allocated to the port.

Chapter 4 Power Over Ethernet (PoE/PoE+) Operation 85

Anexo 04 ITEM 11 (0592666)         SEI 0008478-63.2018.6.02.8000 / pg. 5909



For PoE (not PoE+), while 17 watts must be available for a PoE module on the switch to begin supplying power to
a port with a PD connected, 17 watts per port is not continually required if the connected PD requires less power.
For example, with 20 watts of PoE power remaining available on a module, you can connect one new PD without
losing power to any connected PDs on that module. If that PD draws only 3 watts, 17 watts remain available, and
you can connect at least one more PD to that module without interrupting power to any other PoE devices
connected to the same module. If the next PD you connect draws 5 watts, only 12 watts remain unused. With only
12 unused watts available, if you then connect yet another PD to a higher-priority PoE port, the lowest-priority port
on the module loses PoE power and remains unpowered until the module once again has 17 or more watts
available. (For information on power priority, see Power priority operation on page 86.)

For PoE+, there must be 33 watts available for the module to begin supplying power to a port with a PD
connected.

Disconnecting a PD from a PoE port makes that power available to any other PoE ports with PDs waiting for
power. If the PD demand for power becomes greater than the PoE power available, power is transferred from the
lower-priority ports to the higher-priority ports. (Ports not currently providing power to PDs are not affected.)

Power priority operation
If a PSE can provide power for all connected PD demand, it does not use its power priority settings to allocate
power. However, if the PD power demand oversubscribes the available power, the power allocation is prioritized
to the ports that present a PD power demand. This causes the loss of power from one or more lower-priority ports
to meet the power demand on other, higher-priority ports. This operation occurs regardless of the order in which
PDs connect to the module's PoE-enabled ports.

Power allocation is prioritized according to the following methods:

• Priority class methodAssigns a power priority of low (the default), high, or critical to each enabled PoE port.

• Port-number priority methodA lower-numbered port has priority over a higher-numbered port within the same
configured priority class, for example, port A1 has priority over port A5 if both are configured with high priority.

Configuring PoE operation

Disabling or re-enabling PoE port operation
Syntax:

[no] interface <port-list> power-over-ethernet
Re-enables PoE operation on <port-list> and restores the priority setting in effect when PoE was disabled on
<port-list>.

The no form of the command disables PoE operation on <port-list>.

Default: All PoE ports are initially enabled for PoE operation at Low priority. If you configure a higher priority, this
priority is retained until you change it.

For PoE, disabling all ports allows the 22 watts of minimum PoE power or the 38 watts for PoE+
power allocated for the module to be recovered and used elsewhere. You must disable ALL ports for
this to occur.

Enabling support for pre-standard devices
The HPE switches covered in this guide also support some pre-802.3af devices. For a list of the supported
devices, see the FAQ for your switch model.
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Syntax:

[no] power-over-ethernet pre-std-detect
Detects and powers pre-802.3af standard devices.

The default setting for the pre-std-detect PoE parameter has changed.

Configuring the PoE port priority
Syntax:

interface <port-list> power-over-ethernet [critical | high | low]
Reconfigures the PoE priority level on <port-list>. For a given level, ports are prioritized by port number in
ascending order. For example, if ports 1-24 have a priority level of critical, port 1 has priority over ports 2-24.

If there is not enough power available to provision all active PoE ports at a given priority level, the lowest-
numbered port at that level is provisioned first. For chassis switches, the lowest-numbered port at that level
starting with module A, then B, C, and so on is provisioned. PoE priorities are invoked only when all active PoE
ports cannot be provisioned (supplied with PoE power)

Critical Specifies the highest-priority PoE support for <port-list>. The active PoE ports at this level are
provisioned before the PoE ports at any other level are provisioned.

High Specifies the second priority PoE support for <port-list>. The active PoE ports at this level are
provisioned before the Low priority PoE ports are provisioned.

Low (Default) Specifies the third priority PoE support for <port-list>. The active PoE ports at this level
are provisioned only if there is power available after provisioning any active PoE ports at the
higher priority levels.

The following table shows some examples of PoE priority configuration.
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Table 9: PoE priority operation on a PoE module

Port Priority setting Configuration command1 and resulting operation with PDs connected
to ports C3 through C24

C3 - C17 Critical In this Example:, the following CLI command sets ports C3 to C17 to
Critical:

switch(config)# interface c3-c17 power-over-ethernet
     critical
The critical priority class always receives power. If there is not enough
power to provision PDs on all ports configured for this class, no power goes
to ports configured for high and low priority. If there is enough power to
provision PDs on only some of the critical-priority ports, power is allocated to
these ports in ascending order, beginning with the lowest-numbered port in
the class, which, in this case, is port 3.

C18 - C21 high In this Example:, the following CLI command sets ports C19 to C22 to high:

switch(config)# interface c19-c22 power-over-ethernet 
high
The high priority class receives power only if all PDs on ports with a critical
priority setting are receiving power. If there is not enough power to provision
PDs on all ports with a high priority, no power goes to ports with a low
priority. If there is enough power to provision PDs on only some of the high-
priority ports, power is allocated to these ports in ascending order, beginning,
in this Example:, with port 18, until all available power is in use.

C22 - C24 low In this Example:, the CLI command sets ports C23 to C24 to low2:

switch(config)# interface c23-c24 power-over-ethernet 
low
This priority class receives power only if all PDs on ports with high and
critical priority settings are receiving power. If there is enough power to
provision PDs on only some low- priority ports, power is allocated to the ports
in ascending order, beginning with the lowest-numbered port in the class
(port 22, in this case), until all available power is in use.

C1 - C2 N/A In this Example:, the CLI command disables PoE power on ports C1 to C2:

switch(config)# no interface c1-c2 power-over-ethernet
There is no priority setting for the ports in this Example:.

1 For a listing of PoE configuration commands with descriptions, see Configuring PoE operation.
2 In the default PoE configuration, the ports are already set to low priority. In this case, the command is not necessary.

Controlling PoE allocation
Syntax:

[no] int <port-list> poe-allocate-by [usage | class | value]
Allows you to manually allocate the amount of PoE power for a port by either its class or a defined value.
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The default option for PoE allocation is usage, which is what a PD attached to the port is allocated. You can
override this value by specifying the amount of power allocated to a port by using the class or value options.

usage (Default) The automatic allocation by a PD.

class Uses the power ramp-up signature of the PD to identify which power class the device will be in.
Classes and their ranges are shown in the following table.

value A user-defined level of PoE power allocated for that port.

The allowable PD requirements are lower than those specified for PSEs to allow for power losses
along the Cat-5 cable.

Table 10: Power classes and their values

Power class Value

0 Depends on cable type and PoE architecture. Maximum power level output of 15.4 watts at the
PSE.This is the default class; if there is not enough information about the load for a specific
classification, the PSE classifies the load as class 0 (zero).

1 Requires at least 4 watts at the PSE.

2 Requires at least 7 watts at the PSE.

3 15.4 watts

4 For PoE+Maximum power level output of 30 watts at the PSE.

Example:

To allocate by class for ports 6 to 8:

switch(config)# int 6-8 PoE-allocate-by class

Manually configuring PoE power levels
You can specify a power level (in watts) allocated for a port by using the value option. This is the maximum
amount of power that will be delivered.

To configure a port by value:

Procedure

1. Set the PoE allocation by entering the poe-allocate-by value command:

switch(config) # int A6 poe-allocate-by value
2. or in interface context:

switch(eth-A6) # poe-allocate-by value
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3. Select a value:

switch(config) # int A6 poe-value 15
4. or in interface context:

switch(eth-A6) # poe-value 15
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To view the settings, enter the show power-over-ethernet command, shown in Figure 12: PoE allocation
by value and the maximum power delivered on page 91.

Figure 12: PoE allocation by value and the maximum power delivered

switch(config)# show power-over-ethernet A6

 Status and Counters - Port Power Status for port A7

  Power Enable     : Yes
                                       LLDP Detect     : enabled
  Priority         : low               Configured Type :
  AllocateBy       : value             Value           : 15 W 
  Detection Status : Delivering        Power Class     : 2

  Over Current Cnt : 0                 MPS Absent Cnt  : 0
  Power Denied Cnt : 0                 Short Cnt       : 0

  Voltage          : 55.1 V            Current         : 154 mA
  Power            : 8.4 W

Maximum power delivered.

If you set the PoE maximum value to less than what the PD requires, a fault occurs, as shown in Figure 13: PoE
power value set too low for the PD on page 91.

Figure 13: PoE power value set too low for the PD

switch(config)# int A7 poe-value 4

switch(config)# show power-over-ethernet A7

 Status and Counters - Port Power Status for port A7

  Power Enable     : Yes
                                       LLDP Detect     : enabled
  Priority         : low               Configured Type :
  AllocateBy       : value             Value           : 4 W
  Detection Status : fault             Power Class     : 2

  Over Current Cnt : 1                 MPS Absent Cnt  : 0
  Power Denied Cnt : 2                 Short Cnt       : 0

  Voltage          : 55.1 V            Current         : 154 mA
  Power            : 8.4 W

‘Fault’ appears when the PoE power value is set too low.

Changing the threshold for generating a power notice
By default, PoE support is enabled on the switch’s 10/100Base-TX ports, with the power priority set to Low and
the power threshold set to 80 (%). The following commands allow you to adjust these settings.

Syntax:

power threshold <1-99>
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The power threshold is a configurable percentage of the total PoE power available on the switch. When PoE
consumption exceeds the threshold, the switch automatically generates an SNMP trap and also sends a message
to the Event Log. For example, if the power threshold is set to 80% (the default), and an increasing PoE power
demand crosses this threshold, the switch sends an SNMP trap and generates this Event Log message:

PoE usage has exceeded threshold of 80 %.
If the switch is configured for debug logging, it also sends the same message to the configured debug
destination(s).

The switch automatically invokes the power threshold at the global configuration level with a default setting of
80%. You can configure the power threshold to a value in the range of 1% to 99%.

If an increasing PoE power load (1) exceeds the configured power threshold (which triggers the log message and
SNMP trap), and then (2) later begins decreasing and drops below the threshold again, the switch generates
another SNMP trap, plus a message to the Event Log and any configured Debug destinations. To continue the
above Example:

PoE usage is below configured threshold of 80 %.

Cycling power on a port
Simply disabling a PoE port does not affect power delivery through that port. To cycle the power on a PD receiving
power from a PoE port on the switch, disable, then re-enable the power to that port.

Syntax:

[no] interface [e] <port-list> power
Re-enables PoE operation on <port-list> and restores the priority setting in effect when PoE was disabled on
<port-list>. The [no] form of the command disables PoE operation on <port-list>. (Default: All 10/100Base-TX
ports on the switch enabled for PoE operation at Low priority.)

For example, to cycle the power on a PoE device connected to port 1 on a switch covered in this guide:

switch(config)# no interface 1 power
switch(config)# interface 1 power

PoE/PoE+ allocation using LLDP information

LLDP with PoE
When using PoE, enabling poe-lldp-detect allows automatic power configuration if the link partner supports
PoE. When LLDP is enabled, the information about the power usage of the PD is available, and the switch can
then comply with or ignore this information. You can configure PoE on each port according to the PD (IP phone,
wireless device, and so on) specified in the LLDP field. The default configuration is for PoE information to be
ignored if detected through LLDP.

Detecting PoE information via LLDP affects only power delivery; it does not affect normal Ethernet
connectivity.

Enabling or disabling ports for allocating power using LLDP
Syntax:

int <port-list> poe-lldp-detect [enabled | disabled]
Enables or disables ports for allocating PoE power based on the link-partner's capabilities via LLDP.
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Default: Disabled

Example:

You can enter this command to enable LLDP detection:

switch(config) # int A7 poe-lldp-detect enabled
or in interface context:

switch(eth-A7) # poe-lldp-detect enabled
For more information on PoE/PoE+ and LLDP, see PoE/PoE+ allocation using LLDP information on page 92.

Enabling PoE detection via LLDP TLV advertisement
Use this command and insert the desired port or ports:

switch(config) # lldp config <port-number> medTlvenable poe
    
For more information on LLDP, see PoE/PoE+ allocation using LLDP information on page 92.

LLDP with PoE+

Overview
The DLC for PoE provides more exact control over the power requirement between a PSE and PD. The DLC
works in conjunction with the PLC and is mandatory for any Type-2 PD that requires more than 12.95 watts of
input power.

DLC is defined as part of the IEEE 802.3at standard.

You can implement the power negotiation between a PSE and a PD at the physical layer or at the data link layer.
After the link is powered at the physical layer, the PSE can use LLDP to query the PD repeatedly to discover the
power needs of the PD. Communication over the data link layer allows finer control of power allotment, which
makes it possible for the PSE to supply dynamically the power levels needed by the PD. Using LLDP is optional
for the PSE but mandatory for a Type 2 PD that requires more than 12.95 watts of power.

If the power needed by the PD is not available, that port is shut off.

PoE allocation
There are two ways LLDP can negotiate power with a PD:

• Using LLDP MED TLVs

Disabled by default. Can be enabled using the int <port-list> PoE-lldp-detect [enable|
disable] command, as shown below.LLDP MED TLVs sent by the PD are used to negotiate power only if
the LLDP PoE+ TLV is disabled or inactive; if the LLDP PoE+ TLV is sent as well (not likely), the LLDP MED
TLV is ignored.

• Using LLDP PoE+ TLVs

Enabled by default. The LLDP PoE+ TLV is always advertised unless it has been disabled (enable it by using
the lldp config <port-list> dot3TlvEnable poe_config command.)For the Command syntax,
see Initiating advertisement of PoE+ TLVs on page 94. It always takes precedence over the LLDP MED
TLV.
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Enabling PoE-lldp-detect allows the data link layer to be used for power negotiation. When a PD requests
power on a PoE port, LLDP interacts with PoE to see if there is enough power to fulfill the request. Power is set at
the level requested. If the PD goes into power-saving mode, the power supplied is reduced; if the need for power
increases, the amount supplied is increased. PoE and LLDP interact to meet the current power demands.

Syntax:

int <port-list> poe-lldp-detect [enabled | disabled]
Allows the data link layer to be used for power negotiation between a PD on a PoE port and LLDP.

Default: Disabled

Example:

You can enter this command to enable LLDP detection:

switch(config) # int 7 PoE-lldp-detect enabled
or in interface context:

switch(eth-7) # PoE-lldp-detect enabled

Detecting PoE information via LLDP affects only power delivery; it does not affect normal Ethernet
connectivity.

You can view the settings by entering the show power-over-ethernet brief command, as shown in Port
with LLDP configuration information obtained from the device on page 94.

Port with LLDP configuration information obtained from the device

switch(config)# show power-over-ethernet brief

 Status and Counters - Port Power Status

  POE   | Power   Power     Alloc Alloc  Actual Configured  Detection   Power
  Port  | Enable  Priority  By    Power  Power  Type        Status      Class
  ----- + ------- --------- ----- ------ ------ ----------- ----------- ----
  A1    | Yes     low       usage 17 W   0.0 W  Phone1      Delivering  1
  A2    | Yes     low       usage 17 W   0.0 W              Searching   0
  A3    | Yes     low       usage 17 W   0.0 W              Searching   0
  A4    | Yes     low       usage 17 W   0.0 W              Searching   0
  A5    | Yes     low       usage 17 W   0.0 W              Searching   0
  A6    | Yes     low       usage 17 W   8.4 W              Delivering  0
  

Initiating advertisement of PoE+ TLVs
Syntax:

lldp config <port-list> dot3TlvEnable poe_config
Enables advertisement of data link layer power using PoE+ TLVs. The TLV is processed only after the physical
layer and the data link layer are enabled. The TLV informs the PSE about the actual power required by the device.

Default: Enabled
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If LLDP is disabled at runtime, and a PD is using PoE+ power that has been negotiated through
LLDP, there is a temporary power drop; the port begins using PoE+ power through the PLC. This
event is recorded in the Event Log. An Example: message would look like the following:

W 08/04/13 13:35:50 02768 ports: Port A1 PoE power dropped.
Exceeded physical classification for a PoE Type1 device (LLDP process 
disabled)
When LLDP is enabled again, it causes a temporary power drop. This event is also recorded in the
Event Log. An Example: message looks like the following:

W 08/04/13 13:36:31 02771 ports: Port A1 PoE power dropped.
Exceeded physical classification due to change in classification type (LLDP 
process enabled)

Viewing PoE when using LLDP information
Syntax:

show lldp config <port-list>
Displays the LLDP port configuration information, including the TLVs advertised.

LLDP port configuration information with PoE

switch(config)# show lldp config 4

 LLCP Port Configuration Detail

  Port : 4
  AdminStatus [Tx_Rx] : Tx_Rx
  NotificationsEnabled [False] : False
  Med Topology Trap Enabled [False] : False

  TLVS Advertised:
   * port_descr
   * system_name
   * system_descr
   * system_cap

   * capabilities
   * network_policy
   * location_id
   * poe

   * macphy_config
   * poeplus_config

  IpAddress Advertised:
Local power information on page 95 shows an Example: of the local device power information using the show
lldp info local-device <port-list> command.

Local power information

switch(config)# show lldp info local-device A1

 LLCP Local Port Information Detail
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  Port     : A1
  PortType : local
  PortId   : 1
  PortDesc : A1
  Pvid     : 1

 Poe Plus Information Detail

     Poe Device Type           : Type2 PSE
     Power Source              : Primary
     Power Priority            : low
     PD Requested Power Value  : 20 Watts
     PSE Actual Power Value    : 20 Watts
Remote power information on page 96 shows the remote device power information using the show lldp
info remote-device <port-list> command.

Remote power information

switch(config)# show lldp info remote-device A3

 LLCP Remote Device Information Detail

  Local Port   : A3
  ChassisType  : mac-address
  ChassisId    : 00 16 35 ff 2d 40
  PortType     : local
  PortId       : 23
  SysName      : HPSwitch
  System Descr : HP Switch, revision YA.14.xx
  PortDescr    : 23
  Pvid         : 55

  System Capabilities Supported  : bridge, router
  System Capabilities Enabled    : bridge

  Remote Management Address
     Type    : ipv4
     Address : 10.0.102.198

  Poe Plus Information Detail

     Poe Device Type           : Type2 PD
     Power Source              : Only PSE
     Power Priority            : low
     PD Requested Power Value  : 20 Watts
     PSE Actual Power Value    : 20 Watts

Operation note
The advertisement of power with TLVs for LLDP PoE+ is enabled by default. If LLDP is disabled at runtime and a
PD is using PoE+ power that has been negotiated through LLDP, there will be a temporary power drop. The port
will begin using PoE+ power through the PLC. This event is recorded in the event log. An Example: message
would look like the following:

W 08/04/13 13:35:50 02768 ports: Port A1 PoE power dropped.
Exceeded physical classification for a PoE Type1 device
(LLDP process disabled)
When LLDP is enabled again, it causes a temporary power drop. This event is also recorded in the event log. An
Example: message looks like the following:
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W 08/04/13 13:36:31 02771 ports: Port A1 PoE power dropped.
Exceeded physical classification due to change in
classification type (LLDP process enabled)

Viewing the global PoE power status of the switch
Syntax:

show power-over-ethernet
Displays the switch's global PoE power status, including:

• Pre-standard Detect

Shows whether PoE for pre-802.3af-standard powered devices is enabled on the switch. (Default: Off; shows
On when PoE for pre-802.3af-standard powered devices has been enabled.)

• Operational Status

Indicates whether PoE power is available on the switch. (Default: On; shows Off if PoE power is not available.
Shows Faulty if internal or external PoE power is oversubscribed or faulty.)

• Usage Threshold (%)

Lists the configured percentage of available PoE power provisioning the switch must exceed to generate a
usage notice in the form of an Event Log message and an SNMP trap. If this event is followed by a drop in
power provisioning below the threshold, the switch generates another SNMP trap and Event Log message.
Event Log messages are also sent to any optionally configured debug destinations. (Default: 80%)

• Total Available Power

Lists the maximum PoE wattage available to provision active PoE ports on the switch. This is the amount of
usable power for PDs.

• Total Failover Power

Lists the amount of PoE power available in the event of a single power supply failure. This is the amount of
power the switch can maintain without dropping any PDs.

• Total Redundancy Power

Indicates the amount of PoE power held in reserve for redundancy in case of a power supply failure.

• Total Remaining Power

The amount of PoE power still available.

brief Displays PoE information for each port. See Viewing PoE status on all ports on page 98.

<port-
list>

Displays PoE information for the ports in port-list. See Viewing the PoE status on specific
ports on page 100.

The show power-over-ethernet displays data similar to that shown in Output for the show power-over-
ethernet command on page 97.

Output for the show power-over-ethernet command

switch(config)# show power-over-ethernet

 Status and Counters - System Power Status
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  Pre-standard Detect  : On
  System Power Status  : No redundancy
  PoE Power Status     : No redundancy

 Chassis power-over-ethernet

  Total Available Power  :  600 W
  Total Failover Power   :  300 W
  Total Redundancy Power :    0 W
  Total Used Power       :    9 W +/- 6W
  Total Remaining Power  :  591 W

 Internal Power
        1  300W/POE  /Connected.
        2  300W/POE  /Connected.
        3  Not Connected.
        4  Not Connected.
 External Power
        EPS1  /Not Connected.
        EPS2  /Not Connected.

Viewing PoE status on all ports
Syntax:

show power-over-ethernet brief
Displays the port power status:

PoE Port Lists all PoE-capable ports on the switch.

Power Enable Shows Yes for ports enabled to support PoE (the default) and No for ports on which PoE is
disabled.

Power Priority Lists the power priority (Low, High, and Critical) configured on ports enabled for PoE. (For
more information on this topic, see Configuring PoE operation on page 86.)

Alloc by Displays how PoE is allocated (usage, class, value).

Alloc Power The maximum amount of PoE power allocated for that port (expressed in watts).Default: 17
watts for PoE; 33 watts for PoE+.

Actual Power The power actually being used on that port.

Configured Type If configured, shows the user-specified identifier for the port. If not configured, this field is
empty.

Table Continued
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Detection Status
• Searching: The port is trying to detect a PD connection.

• Delivering: The port is delivering power to a PD.

• Disabled: On the indicated port, either PoE support is disabled or PoE power is enabled
but the PoE module does not have enough power available to supply the port's power
needs.

• Fault: The switch detects a problem with the connected PD.

• Other Fault: The switch has detected an internal fault that prevents it from supplying
power on that port.

Power Class Shows the 802.3af power class of the PD detected on the indicated port. Classes include:

0: 0.44 to 12.95 watts can be drawn by the PD. Default class.

1: 0.44 to 3.84 watts

2: 3.84 to 6.49 watts

3: 6.49 to 12.95 watts

4: For PoE+; up to 25.5 watts can be drawn by the PD

The show power-over-ethernet brief displays this output:

Output for the show power-over-ethernet brief command

switch(config)# show power-over-ethernet brief

 Status and Counters - System Power Status

  System Power Status  : No redundancy
  PoE Power Status     : No redundancy

  Available: 600 W Used: 9 W Remaining: 591 W

  Module A Power
  Available: 408 W Used: 9 W Remaining: 399 W

  POE   | Power   Power     Alloc Alloc  Actual Configured  Detection  Power
  Port  | Enable  Priority  By    Power  Power  Type        Status     Class
  ----- + ------- --------- ----- ------ ------ ----------- ---------- ----
  A1    | Yes     low       usage 17 W   0.0 W              Searching  0
  A2    | Yes     low       usage 17 W   0.0 W              Searching  0
  A3    | Yes     low       usage 17 W   0.0 W              Searching  0
  A4    | Yes     low       usage 17 W   0.0 W              Searching  0
  A5    | Yes     low       usage 17 W   0.0 W              Searching  0
  A6    | Yes     low       usage 17 W   8.4 W              Delivering 2
  A7    | Yes     low       usage 17 W   0.0 W              Searching  0
  A8    | Yes     low       usage 17 W   0.0 W              Searching  0
  A9    | Yes     low       usage 17 W   0.0 W              Searching  0
You can also show the PoE information by slot:

Showing the PoE information by slot

switch(config)# show power-over-ethernet slot A

 Status and Counters - System Power Status for slot A

Chapter 4 Power Over Ethernet (PoE/PoE+) Operation 99

Anexo 04 ITEM 11 (0592666)         SEI 0008478-63.2018.6.02.8000 / pg. 5923



  Maximum Power      : 408 W           Operational Status   : On
  Power In Use       :   9 W +/- 6 W   Usage Threshold (%) : 80

Viewing the PoE status on specific ports
Syntax:

show power-over-ethernet <port-list>
Displays the following PoE status and statistics (since the last reboot) for each port in <port-list>:

Power Enable Shows Yes for ports enabled to support PoE (the
default) and No for ports on which PoE is disabled. For
ports on which power is disabled, this is the only field
displayed by show power-over-ethernet port-
list .

Priority Lists the power priority (Low, High, and Critical)
configured on ports enabled for PoE. (For more on this
topic, see Configuring PoE operation on page 86.)

Allocate by How PoE is allocated (usage, class, value).

Detection Status
• Searching: The port is trying to detect a PD

connection.

• Delivering: The port is delivering power to a PD.

• Disabled: On the indicated port, either PoE support
is disabled or PoE power is enabled but the PoE
module does not have enough power available to
supply the port's power needs.

• Fault: The switch detects a problem with the
connected PD.

• Other Fault: The switch has detected an internal
fault that prevents it from supplying power on that
port.

Over Current Cnt Shows the number of times a connected PD has
attempted to draw more than 15.4 watts for PoE or
24.5 watts for PoE+. Each occurrence generates an
Event Log message.

Power Denied Cnt Shows the number of times PDs requesting power on
the port have been denied because of insufficient
power available. Each occurrence generates an Event
Log message.

Voltage The total voltage, in volts, being delivered to PDs.

Power The total power, in watts, being delivered to PDs.

Table Continued
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LLDP Detect Port is enabled or disabled for allocating PoE power,
based on the link-partner's capabilities via LLDP.

Configured Type If configured, shows the user-specified identifier for the
port. If not configured, the field is empty.

Value The maximum amount of PoE power allocated for that
port (expressed in watts). Default: 17 watts for PoE; 33
watts for PoE+

Power Class Shows the power class of the PD detected on the
indicated port. Classes include:

0: 0.44 to 12.95 watts

1: 0.44 to 3.84 watts

2: 3.84 to 6.49 watts

3: 6.49 to 12.95 watts

4: For PoE+; up to 25.5 watts can be drawn by the PD

MPS Absent Cnt Shows the number of times a detected PD has no
longer requested power from the port. Each
occurrence generates an Event Log message. ("MPS"
refers to the "maintenance power signature.")

Short Cnt Shows the number of times the switch provided
insufficient current to a connected PD.

Current The total current, in mA, being delivered to PDs.

If you want to view the PoE status of ports A6 and A7, you would use show power-over-ethernet A6-A7 to
display the data:

Output for the show power-over-ethernet <port-list> command

switch(config)# show power-over-ethernet slot A6-A7

 Status and Counters - Port Power Status for port A6

  Power Enable      : Yes
                                        LLDP Detect     : enabled
  Priority          : low               Configured Type : 
  AllocateBy        : value             Value           : 17 W
  Detection Status  : Delivering        Power Class     : 2

  Over Current Cnt  :0                  MPS Absent Cnt  : 0
  Power Denied Cnt  :0                  Short Cnt       : 0

  Voltage           : 55.1 V            Current         : 154 mA
  Power             : 8.4 W

 Status and Counters - Port Power Status for port A7

  Power Enable      : Yes
                                        LLDP Detect     : disabled
  Priority          : low               Configured Type : 
  AllocateBy        : value             Value           : 17 W
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  Detection Status  : Searching         Power Class     : 0

  Over Current Cnt  :0                  MPS Absent Cnt  : 0
  Power Denied Cnt  :0                  Short Cnt       : 0

  Voltage           : 0 V               Current         : 0 mA
  Power             : 0 W
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Overview of port trunking
Port trunking allows you to assign up to eight physical links to one logical link (trunk) that functions as a single,
higher-speed link providing dramatically increased bandwidth. This capability applies to connections between
backbone devices as well as to connections in other network areas where traffic bottlenecks exist. A trunk group
is a set of up to eight ports configured as members of the same port trunk. The ports in a trunk group do not have
to be consecutive. For Example:

Figure 14: Conceptual Example: of port trunking

With full-duplex operation in a eight-port trunk group, trunking enables the following bandwidth capabilities:

Port connections and configuration
All port trunk links must be point-to-point connections between a switch and another switch, router, server, or
workstation configured for port trunking. No intervening, non-trunking devices are allowed. It is important to note
that ports on both ends of a port trunk group must have the same mode (speed and duplex) and flow control
settings.

Link connections

The switch does not support port trunking through an intermediate, non-trunking device such as
a hub, or using more than onemedia type in a port trunk group. Similarly, for proper trunk
operation, all links in the same trunk group must have the samespeed, duplex, and flow control.

Port security restriction

Port security does not operate on a trunk group. If you configure port security on one or more
ports that are later added to a trunk group, the switch resets the port security parameters for
those ports to the factory-default configuration.

To avoid broadcast storms or loops in your network while configuring a trunk, first disable or
disconnect all ports you want to add to or remove from the trunk. After you finish configuring the
trunk, enable or re-connect the ports.

Chapter 5
Port Trunking
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Port trunk features and operation
The switches covered in this guide offer these options for port trunking:

• LACP: IEEE 802.3ad—Trunk group operation using LACP on page 114

• Trunk: Non-Protocol—Trunk group operation using the "trunk" option on page 120

Up to 144 trunk groups are supported on the switches. The actual maximum depends on the number of ports
available on the switch and the number of links in each trunk. (Using the link aggregation control protocol—LACP
—option, you can include standby trunked ports in addition to the maximum of eight actively trunking ports.) The
trunks do not have to be the same size; For example, 100 two-port trunks and 11 eight-port trunks are supported.

LACP requires full-duplex (FDx) links of the same media type (10/100Base-T, 100FX, and so on) and
the same speed, and enforces speed and duplex conformance across a trunk group. For most
installations, Hewlett Packard Enterprise Switch recommends that you leave the port Mode settings
at Auto (the default). LACP also operates with Auto-10, Auto-100, and Auto-1000 (if
negotiation selects FDx), and 10FDx, 100FDx, and 1000FDx settings. (The 10-gigabit ports
available for some switch models allow only the Auto setting.)

Fault tolerance
If a link in a port trunk fails, the switch redistributes traffic originally destined for that link to the remaining links in
the trunk. The trunk remains operable as long as there is at least one link in operation. If a link is restored, that
link is automatically included in the traffic distribution again. The LACP option also offers a standby link capability,
which enables you to keep links in reserve for service if one or more of the original active links fails. (See Trunk
group operation using LACP on page 114.)

Trunk configuration methods

Dynamic LACP trunk
The switch automatically negotiates trunked links between LACP-configured ports on separate devices, and offers
one dynamic trunk option: LACP. To configure the switch to initiate a dynamic LACP trunk with another device,
use the interface command in the CLI to set the default LACP option to active on the ports you want to use
for the trunk. For example, the following command sets ports C1 to C4 to LACP active:

switch(config) int c1-c4 lacp active
The preceding Example: works if the ports are not already operating in a trunk. To change the LACP option on
ports already operating as a trunk, you must first remove them from the trunk. For example, if ports C1 to C4 are
LACP-active and operating in a trunk with another device, you would do the following to change them to LACP-
passive:

switch(config)# no int c1-c4 lacp
Removes the ports from the trunk.

switch(config)# int c1-c4 lacp passive
Configures LACP passive.

Static trunk
The switch uses the links you configure with the Port/Trunk Settings screen in the menu interface or the trunk
command in the CLI to create a static port trunk. The switch offers two types of static trunks: LACP and Trunk.

104 Aruba 2530 Management and Configuration Guide for ArubaOS-Switch 16.05

Anexo 04 ITEM 11 (0592666)         SEI 0008478-63.2018.6.02.8000 / pg. 5928



Table 11: Trunk types used in static and dynamic trunk groups

Trunking method LACP Trunk

Dynamic Yes No

Static Yes Yes

The following table describes the trunking options for LACP and Trunk protocols.

Table 12: Trunk configuration protocols

Protocol Trunking Options

LACP (802.3ad) Provides dynamic and static LACP trunking options.

• Dynamic LACP — Use the switch-negotiated dynamic LACP trunk when:

◦ The port on the other end of the trunk link is configured for Active or Passive LACP.

◦ You want fault-tolerance for high-availability applications. If you use an eight-link
trunk, you can also configure one or more additional links to operate as standby
links that will activate only if another active link goes down.

• Static LACP — Use the manually configured static LACP trunk when:

◦ The port on the other end of the trunk link is configured for a static LACP trunk.

◦ You want to configure non-default spanning tree or IGMP parameters on an LACP
trunk group.

◦ You want an LACP trunk group to operate in a VLAN other than the default VLAN
and GVRP is disabled. (See VLANs and dynamic LACP on page 118.)

◦ You want to use a monitor port on the switch to monitor an LACP trunk.

For more information, see Trunk group operation using LACP on page 114.

Trunk

(non-protocol)

Provides manually configured, static-only trunking to:

• Most HPE Switch and routing switches not running the 802.3ad LACP protocol.

• Windows NT and HP-UX workstations and servers

Use the Trunk option when:

• The device to which you want to create a trunk link is using a non-802.3ad trunking
protocol.

• You are unsure which type of trunk to use, or the device to which you want to create a
trunk link is using an unknown trunking protocol.

• You want to use a monitor port on the switch to monitor traffic on a trunk.

See Trunk group operation using the "trunk" option on page 120.
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Table 13: General operating rules for port trunks

Media: For proper trunk operation, all ports on both ends of a trunk group must have
the same media type and mode (speed and duplex). (For the switches, HPE
Switch recommends leaving the port Mode setting at Auto or, in networks
using Cat 3 cabling, Auto-10.)

Port Configuration: The default port configuration is Auto, which enables a port to sense speed
and negotiate duplex with an auto-enabled port on another device. HPE
recommends that you use the Auto setting for all ports you plan to use for
trunking. Otherwise, you must manually ensure that the mode setting for each
port in a trunk is compatible with the other ports in the trunk. See:
Recommended port mode setting for LACP example

All of the following operate on a per-port basis, regardless of trunk
membership:

• Enable/Disable

• Flow control (Flow Ctrl)

LACP is a full-duplex protocol. See Trunk group operation using LACP on
page 114.

Trunk configuration: All ports in the same trunk group must be the same trunk type (LACP or trunk).
All LACP ports in the same trunk group must be either all static LACP or all
dynamic LACP.A trunk appears as a single port labeledDyn1(for an LACP
dynamic trunk) or Trk1 (for a static trunk of type LACP, Trunk) on various
menu and CLI screens. For a listing of which screens show which trunk types,
see How the switch lists trunk data on page 120.For spanning-tree or
VLAN operation, configuration for all ports in a trunk is done at the trunk level.
(You cannot separately configure individual ports within a trunk for spanning-
tree or VLAN operation.)

Traffic distribution: All of the switch trunk protocols use the SA/DA (source address/destination
address) method of distributing traffic across the trunked links. See Outbound
traffic distribution across trunked links on page 121.

Table Continued
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Spanning Tree: 802.1D (STP) and 802.1w (RSTP) Spanning Tree operate as a global setting
on the switch (with one instance of Spanning Tree per switch). 802.1s (MSTP)
Spanning Tree operates on a per-instance basis (with multiple instances
allowed per switch). For each Spanning Tree instance, you can adjust
Spanning Tree parameters on a per-port basis.A static trunk of any type
appears in the Spanning Tree configuration display, and you can configure
Spanning Tree parameters for a static trunk in the same way that you would
configure Spanning Tree parameters on a non-trunked port. (Note that the
switch lists the trunk by name—such as Trk1—and does not list the individual
ports in the trunk.) For example, if ports C1 and C2 are configured as a static
trunk named Trk1, they are listed in the Spanning Tree display as Trk1 and do
not appear as individual ports in the Spanning Tree displays. See A port trunk
in a Spanning Tree listing on page 108.When Spanning Tree forwards on a
trunk, all ports in the trunk will be forwarding. Conversely, when Spanning Tree
blocks a trunk, all ports in the trunk are blocked.

A dynamic LACP trunk operates only with the default Spanning Tree settings.
Also, this type of trunk appears in the CLI show spanning-tree display, but
not in the Spanning Tree Operation display of the Menu interface.

If you remove a port from a static trunk, the port retains the same Spanning
Tree settings that were configured for the trunk.In the below Example:, ports
C1 and C2 are members of TRK1 and do not appear as individual ports in the
port configuration part of the listing.See: A port trunk in a Spanning Tree
listing example

IP multicast protocol (IGMP): A static trunk of any type appears in the IGMP configuration display, and you
can configure IGMP for a static trunk in the same way that you would
configure IGMP on a non-trunked port. (Note that the switch lists the trunk by
name—such as Trk1—and does not list the individual ports in the trunk.) Also,
creating a new trunk automatically places the trunk in IGMP Auto status if
IGMP is enabled for the default VLAN.A dynamic LACP trunk operates only
with the default IGMP settings and does not appear in the IGMP configuration
display or show ip igmp listing.

VLANs: Creating a new trunk automatically places the trunk in the DEFAULT_VLAN,
regardless of whether the ports in the trunk were in another VLAN. Similarly,
removing a port from a trunk group automatically places the port in the default
VLAN. You can configure a static trunk in the same way that you configure a
port for membership in any VLAN.

For a dynamic LACP trunk to operate in a VLAN other than the default VLAN
(DEFAULT_VLAN), GVRP must be enabled. See Trunk group operation
using LACP on page 114.

Port security: Trunk groups (and their individual ports) cannot be configured for port security,
and the switch excludes trunked ports from the show port-security
listing. If you configure non-default port security settings for a port, then
subsequently try to place the port in a trunk, you see the following message
and the command is not executed:< port-list> Command cannot operate
over a logical port.

Monitor port: A trunk cannot be a monitor port. A monitor port can monitor a static trunk but
cannot monitor a dynamic LACP trunk.

Chapter 5 Port Trunking 107

Anexo 04 ITEM 11 (0592666)         SEI 0008478-63.2018.6.02.8000 / pg. 5931



Recommended port mode setting for LACP

switch(config)# show interfaces config

 Port Settings

  Port  Type      | Enabled Mode         Flow Ctrl MDI
  ----- --------- + ------- ------------ --------- ----
  1     10/100TX  | Yes     Auto         Enable    Auto
  2     10/100TX  | Yes     Auto         Enable    MDI

A port trunk in a Spanning Tree listing

Port  Type      Cost Priority State      | Designated Bridge
----- --------- ---- -------- ---------- + -----------------
C3    100/1000T 5    12B      Forwarding | 0020c1-b27ac0
C4    100/1000T 5    12B      Forwarding | 0060b0-889e00
C5    100/1000T 5    12B      Disabled   | 
C6    100/1000T 5    12B      Disabled   | 
Trk1            1    64       Forwarding | 0001e7-a0ec00
 

Viewing and configuring a static trunk group (Menu)
Configure port trunking before you connect the trunked links to another switch, routing switch, or
server. Otherwise, a broadcast storm could occur. (If you need to connect the ports before
configuring them for trunking, you can temporarily disable the ports until the trunk is configured. See
"Enabling or Disabling Ports and Configuring Port Mode".)

This procedure uses the Port/Trunk Settings screen to configure a static port trunk group on the switch.

Procedure

1. Follow the procedures in the preceding IMPORTANT note.

2. From the Main Menu, select:

2. Switch Configuration…

2. Port/Trunk Settings
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3. Press [E] (for Edit) and then use the arrow keys to access the port trunk parameters.

Figure 15: Example: of the menu screen for configuring a port trunk group

4. In the Group column, move the cursor to the port you want to configure.

5. Use the Space bar to choose a trunk group assignment (Trk1, Trk2, and so on) for the selected port.

a. For proper trunk operation, all ports in a trunk must have the same media type and mode (such as
10/100TX set to 100FDx, or 100FX set to 100FDx). The flow control settings must also be the same for all
ports in a given trunk. To verify these settings, see "Viewing Port Status and Configuring Port Parameters".

b. You can configure the trunk group with up to eight ports per trunk. If multiple VLANs are configured, all
ports within a trunk will be assigned to the same VLAN or set of VLANs. (With the 802.1Q VLAN capability
built into the switch, more than one VLAN can be assigned to a trunk. See the "Static Virtual LANs
(VLANs)" in the advanced traffic management guide for your switch.)

(To return a port to a non-trunk status, keep pressing the Space bar until a blank appears in the highlighted
Group value for that port.)

Figure 16: Example: of the Configuration for a Two-Port Trunk Group

6. Move the cursor to the Type column for the selected port and use the Space bar to select the trunk type:

a. LACP

b. Trunk (the default type if you do not specify a type)

All ports in the same trunk group on the same switch must have the same Type (LACP or Trunk).
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7. When you are finished assigning ports to the trunk group, press [Enter] , then [S] (for Save) and return to the
Main Menu. (It is not necessary to reboot the switch.)

During the Save process, traffic on the ports configured for trunking is delayed for several seconds. If the
Spanning Tree Protocol is enabled, the delay may be up to 30 seconds.

8. Connect the trunked ports on the switch to the corresponding ports on the opposite device. If you previously
disabled any of the trunked ports on the switch, enable them now. (See "Viewing Port Status and Configuring
Port Parameters")

Check the Event Log ("Using the Event Log for Troubleshooting Switch Problems") to verify that the trunked ports
are operating properly.

Viewing and configuring port trunk groups (CLI)
You can list the trunk type and group for all ports on the switch or for selected ports. You can also list LACP-only
status information for LACP-configured ports.

Viewing static trunk type and group for all ports or for selected ports
Syntax:

show trunks [< port-list >]
Omitting the <port-list> parameter results in a static trunk data listing for all LAN ports in the switch.

Example:

In a switch where ports A4 and A5 belong to Trunk 1 and ports A7 and A8 belong to Trunk 2, you have the
options shown in Listing specific ports belonging to static trunks on page 110 and A show trunk listing
without specifying ports on page 110 for displaying port data for ports belonging to static trunks.

Using a port list specifies, for switch ports in a static trunk group, only the ports you want to view. In this case, the
command specifies ports A5 through A7. However, because port A6 is not in a static trunk group, it does not
appear in the resulting listing:

Listing specific ports belonging to static trunks

switch# show trunks e 5-7

 Load Balancing

  Port | Name                    Type      | Group Type
  ---- + ----------------------- --------- + ----- -----
  5    | Print-Server-Trunk      10/100TX  | Trk1  Trunk
  7    |                         10/100TX  | Trk2  Trunk
The show trunks <port-list> command in the above Example: includes a port list, and thus shows trunk
group information only for specific ports that have membership in a static trunk. In A show trunk listing without
specifying ports on page 110, the command does not include a port list, so the switch lists all ports having static
trunk membership.

A show trunk listing without specifying ports

switch# show trunks

 Load Balancing

 Port | Name                    Type      | Group Type
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 ---- + ----------------------- --------- + ----- -----
 4    | Print-Server-Trunk      10/100TX  | Trk1  Trunk
 5    | Print-Server-Trunk      10/100TX  | Trk1  Trunk
 7    |                         10/100TX  | Trk2  Trunk
 8    |                         10/100TX  | Trk2  Trunk

Viewing static LACP and dynamic LACP trunk data
Syntax:

show lacp
Lists data for only the LACP-configured ports.

Example:

Ports A1 and A2 have been previously configured for a static LACP trunk. (For more on the Active parameter,
see table "LACP port status data".)

A show LACP listing

switch# show lacp

                          LACP
       LACP     Trunk    Port              LACP     Admin  Oper
Port   Enabled  Group    Status   Partner  Status   Key    Key
----   -------  -------  -------  -------  -------  ------ ------ 
Al     Active   Trkl     Up       Yes      Success  0      250
A2     Active   Trkl     Up       Yes      Success  0      250
A3     Active   A3       Down     No       Success  0      300
A4     Passive  A4       Down     No       Success  0      0
A5     Passive  A5       Down     No       Success  0      0
A6     Passive  A6       Down     No       Success  0      0
For a description of each of the above-listed data types, see table "LACP port status data".

Dynamic LACP Standby Links
Dynamic LACP trunking enables you to configure standby links for a trunk by including more than eight ports in a
dynamic LACP trunk configuration. When eight ports (trunk links) are up, the remaining link(s) will be held in
standby status. If a trunked link that is “Up” fails, it will be replaced by a standby link, which maintains your
intended bandwidth for the trunk. (Refer to also the “Standby” entry under “Port Status” in "Table 4-5. LACP Port
Status Data".) In the next Example:, ports A1 through A9 have been configured for the same LACP trunk. Notice
that one of the links shows Standby status, while the remaining eight links are “Up”.

A Dynamic LACP trunk with one standby link

switch# show lacp
                              LACP
       LACP      Trunk    Port                LACP    Admin    Oper
Port   Enabled   Group    Status   Partner   Status   Key      Key
----   -------   -----    ------   -------   ------   ----    -----
Al     Active     Dyn1     Up        Yes     Success   100      100
A2     Active     Dyn1     Up        Yes     Success   100      100
A3     Active     Dyn1     Up        Yes     Success   100      100
A4     Active     Dyn1     Up        Yes     Success   100      100
A5     Active     Dyn1     Up        Yes     Success   100      100
A6     Active     Dyn1     Up        Yes     Success   100      100
A7     Active     Dyn1     Up        Yes     Success   100      100
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A8     Active     Dyn1     Up        Yes     Success   100      100
A9     Active     Dyn1    Standby    Yes     Success   100      100

Configuring a static trunk or static LACP trunk group
Configure port trunking before you connect the trunked links between switches. Otherwise, a
broadcast storm could occur. (If you need to connect the ports before configuring them for trunking,
you can temporarily disable the ports until the trunk is configured. See "Enabling or Disabling Ports
and Configuring Port Mode".)

The "Port trunk features and operation" section describes the maximum number of trunk groups you can
configure on the switch. An individual trunk can have up to eight links, with additional standby links if you’re using
LACP. You can configure trunk group types as follows:

Trunk Type Trunk Group Membership

TrkX (Static) DynX (Dynamic)

LACP Yes Yes

Trunk Yes No

The following examples show how to create different types of trunk groups.

Syntax:

trunk < port-list > < trk1 ... trk144 > {<trunk | lacp>}
Configures the specified static trunk type.

Example:

This Example: uses ports C4 to C6 to create a non-protocol static trunk group with the group name Trk2.

switch(config)# trunk c4-c6 trk2 trunk

Removing ports from a static trunk group
Removing a port from a trunk can create a loop and cause a broadcast storm. When you remove a
port from a trunk where spanning tree is not in use, HPE Switch recommends that you first disable
the port or disconnect the link on that port.

Syntax:

no trunk <port-list>
Removes the specified ports from an existing trunk group.

Example:

To remove ports C4 and C5 from an existing trunk group:

switch(config)# no trunk c4-c5

Enabling a dynamic LACP trunk group
In the default port configuration, all ports on the switch are set to disabled. To enable the switch to automatically
form a trunk group that is dynamic on both ends of the link, the ports on one end of a set of links must be LACP
Active. The ports on the other end can be either LACP Activeor LACP Passive. The active command enables
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the switch to automatically establish a (dynamic) LACP trunk group when the device on the other end of the link is
configured for LACP Passive.

Example:

Figure 17: Criteria for automatically forming a dynamic LACP trunk

Syntax:

interface <port-list> lacp active
Configures <port-list> as LACP active. If the ports at the other end of the links on <port-list> are
configured as LACP passive, this command enables a dynamic LACP trunk group on <port-list> .

Example:

This Example: uses ports C4 and C5 to enable a dynamic LACP trunk group.

switch(config)# interface c4-c5 lacp active

Removing ports from a dynamic LACP trunk group
To remove a port from dynamic LACP trunk operation, you must turn off LACP on the port. (On a port in an
operating, dynamic LACP trunk, you cannot change between LACP Active and LACP passive without first
removing LACP operation from the port.)

Unless spanning tree is running on your network, removing a port from a trunk can result in a loop.
To help prevent a broadcast storm when you remove a port from a trunk where spanning tree is not
in use, Hewlett Packard Enterprise recommends that you first disable the port or disconnect the link
on that port.

Syntax:

no interface <port-list> lacp
Removes <port-list> from any dynamic LACP trunk and returns the ports in <port-list> to passive
LACP.

Example:
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Port C6 belongs to an operating, dynamic LACP trunk. To remove port C6 from the dynamic trunk and return it to
passive LACP, do the following:

switch(config)# no interface c6 lacp
switch(config)# interface c6 lacp passive
In the above Example:, if the port on the other end of the link is configured for active LACP or static LACP, the
trunked link will be re-established almost immediately.

Viewing existing port trunk groups (WebAgent)
While the WebAgent does not enable you to configure a port trunk group, it does provide a view of an existing
trunk group.

To view any port trunk groups:

1. In the navigation pane, click Interface.

2. Click Port Info/Config. The trunk information for the port displays in the Port Properties box.

Trunk group operation using LACP
The switch can automatically configure a dynamic LACP trunk group, or you can manually configure a static
LACP trunk group.

LACP requires full-duplex (FDx) links of the same media type (10/100Base-T, 100FX, and so on) and
the same speed and enforces speed and duplex conformance across a trunk group. For most
installations, HPE Switch recommends that you leave the port mode settings at Auto (the default).
LACP also operates with Auto-10, Auto-100, and Auto-1000 (if negotiation selects FDx), and
10FDx, 100FDx, and 1000FDx settings.

LACP trunk status commands include:

Trunk display method Static LACP trunk Dynamic LACP trunk

CLI show lacp command Included in listing. Included in listing.

CLI show trunk command Included in listing. Not included.

Port/Trunk Settings screen in menu interface Included in listing. Not included

Thus, to display a listing of dynamic LACP trunk ports, you must use the show lacp command.

In most cases, trunks configured for LACP on the switches operate as described in the following table.
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Table 14: LACP trunk types

LACP port trunk
configuration

Operation

Dynamic LACP This option automatically establishes an 802.3ad-compliant trunk group, with
LACP for the port Type parameter and DynX for the port Group name, where X is
an automatically assigned value from 1 to 144, depending on how many dynamic
and static trunks are currently on the switch. (The switch allows a maximum of
144 trunk groups in any combination of static and dynamic trunks.)

Dynamic LACP trunks operate only in the default VLAN (unless GVRP is enabled
and Forbid is used to prevent the trunked ports from joining the default VLAN).
Thus, if an LACP dynamic port forms using ports that are not in the default VLAN,
the trunk automatically moves to the default VLAN unless GVRP operation is
configured to prevent this from occurring. In some cases, this can create a traffic
loop in your network. For more information on this topic, see VLANs and
dynamic LACP on page 118 .

Under the following conditions, the switch automatically establishes a dynamic
LACP port trunk group and assigns a port Group name:

• The ports on both ends of each link have compatible mode settings (speed and
duplex).

• The port on one end of each link must be configured for LACP Active and the
port on the other end of the same link must be configured for either LACP
Passive or LACP Active. For Example:

Either of the above link configurations allows a dynamic LACP trunk link.

Backup Links: A maximum of eight operating links are allowed in the trunk, but,
with dynamic LACP, you can configure one or more additional (backup) links that
the switch automatically activates if a primary link fails. To configure a link as a
standby for an existing eight-port dynamic LACP trunk, ensure that the ports in the
standby link are configured as either active-to-active or active-to-passive between
switches.

Displaying dynamic LACP trunk data: To list the configuration and status for a
dynamic LACP trunk, use the CLI show lacp command.

The dynamic trunk is automatically created by the switch and is not listed in the
static trunk listings available in the menu interface or in the CLI show trunk
listing.

Static LACP Provides a manually configured, static LACP trunk to accommodate these
conditions:
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LACP port trunk
configuration

Operation

• The port on the other end of the trunk link is configured for a static LACP trunk.

• You want to configure non-default Spanning Tree or IGMP parameters on an
LACP trunk group.

• You want an LACP trunk group to operate in a VLAN other than the default
VLAN and GVRP is disabled. (See VLANs and dynamic LACP on page
118.)

• You want to use a monitor port on the switch to monitor an LACP trunk.

The trunk operates if the trunk group on the opposite device is running one of the
following trunking protocols:

• Active LACP

• Passive LACP

• Trunk

This option uses LACP for the port Type parameter and TrkX for the port Group
parameter, where X is an automatically assigned value in a range corresponding
to the maximum number of trunks the switch allows. (See Port trunk features
and operation for the maximum number of trunk groups allowed on the
switches.)

Displaying static LACP trunk data : To list the configuration and status for a
static LACP trunk, use the CLI show lacp command. To list a static LACP trunk
with its assigned ports, use the CLI show trunk command or display the menu
interface Port/Trunk Settings screen.Static LACP does not allow standby ports.

Default port operation
In the default configuration, LACP is disabled for all ports. If LACP is not configured as Active on at least one end
of a link, the port does not try to detect a trunk configuration and operates as a standard, untrunked port. The
following table lists the elements of per-port LACP operation. To display this data for a switch, execute the
following command in the CLI:

switch# show lacp
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Table 15: LACP port status data

Status
name

Meaning

Port Numb Shows the physical port number for each port configured for LACP operation (C1, C2, C3 …).
Unlisted port numbers indicate that the missing ports that are assigned to a static trunk group are
not configured for any trunking.

LACP
Enabled

Active: The port automatically sends LACP protocol packets.

Passive: The port does not automatically send LACP protocol packets and responds only if it
receives LACP protocol packets from the opposite device.A link having either two active LACP
ports or one active port and one passive port can perform dynamic LACP trunking. A link having
two passive LACP ports does not perform LACP trunking because both ports are waiting for an
LACP protocol packet from the opposite device.

In the default switch configuration, LACP is disabled for all ports.

Trunk
Group

TrkX: This port has been manually configured into a static LACP trunk.

Trunk group same as port number: The port is configured for LACP, but is not a member of a
port trunk.

Port Status Up: The port has an active LACP link and is not blocked or in standby mode.

Down: The port is enabled, but an LACP link is not established. This can indicate, For example, a
port that is not connected to the network or a speed mismatch between a pair of linked ports.

Disabled: The port cannot carry traffic.

Blocked: LACP, Spanning Tree has blocked the port. (The port is not in LACP standby mode.) This
may be caused by a (brief) trunk negotiation or a configuration error, such as differing port speeds
on the same link or trying to connect the switch to more trunks than it can support. (See Trunk
configuration protocols.)

Some older devices are limited to four ports in a trunk. When eight LACP-enabled ports are
connected to one of these older devices, four ports connect, but the other four ports are blocked.

Standby: The port is configured for dynamic LACP trunking to another device, but the maximum
number of ports for the dynamic trunk to that device has already been reached on either the switch
or the other device. This port will remain in reserve, or "standby" unless LACP detects that another,
active link in the trunk has become disabled, blocked, or down. In this case, LACP automatically
assigns a standby port, if available, to replace the failed port.

LACP
Partner

Yes: LACP is enabled on both ends of the link.

No: LACP is enabled on the switch, but either LACP is not enabled or the link has not been
detected on the opposite device.

LACP
Status

Success: LACP is enabled on the port, detects and synchronizes with a device on the other end of
the link, and can move traffic across the link.

Failure: LACP is enabled on a port and detects a device on the other end of the link, but is not able
to synchronize with this device, and therefore is not able to send LACP packets across the link.
This can be caused, For example, by an intervening device on the link (such as a hub), a bad
hardware connection, or if the LACP operation on the opposite device does not comply with the
IEEE 802.3ad standard.

LACP notes and restrictions
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802.1X (Port-based access control) configured on a port
To maintain security, LACP is not allowed on ports configured for 802.1X authenticator operation. If you configure
port security on a port on which LACP (active or passive) is configured, the switch removes the LACP
configuration, displays a notice that LACP is disabled on the port, and enables 802.1X on that port.

switch(config)# aaa port-access authenticator b1
LACP has been disabled on 802.1x port(s). 
switch(config)#
The switch does not allow you to configure LACP on a port on which port access (802.1X) is enabled. For
Example:

switch(config)# int b1 lacp passive 
Error configuring port < port-number > : LACP and 802.1x cannot 
be run together. 
switch(config)#
To restore LACP to the port, you must first remove the 802.1X configuration of the port and then re-enable LACP
active or passive on the port.

Port security configured on a port
To maintain security, LACP is not allowed on ports configured for port security. If you configure port security on a
port on which LACP (active or passive) is configured, the switch removes the LACP configuration, displays a
notice that LACP is disabled on the port, and enables port security on that port. For example:

switch(config)# port-security a17 learn-mode static address-
limit 2 LACP has been disabled on secured port(s).
switch(config)#
The switch does not allow you to configure LACP on a port on which port security is enabled. For example:

switch(config)# int a17 lacp passive
Error configuring port A17: LACP and port security cannot be
run together.
switch(config)#
To restore LACP to the port, you must remove port security and re-enable LACP active or passive.

Changing trunking methods
To convert a trunk from static to dynamic, you must first eliminate the static trunk.

Static LACP trunks
When a port is configured for LACP (active or passive), but does not belong to an existing trunk group, you can
add that port to a static trunk. Doing so disables dynamic LACP on that port, which means you must manually
configure both ends of the trunk.

Dynamic LACP trunks
You can configure a port for LACP-active or LACP-passive, but on a dynamic LACP trunk you cannot configure
the other options that you can on static trunks. If you want to manually configure a trunk, use the trunk
command.

VLANs and dynamic LACP
A dynamic LACP trunk operates only in the default VLAN (unless you have enabled GVRP on the switch and use
Forbid to prevent the ports from joining the default VLAN).
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If you want to use LACP for a trunk on a non-default VLAN and GVRP is disabled, configure the trunk as a static
trunk.

Blocked ports with older devices
Some older devices are limited to four ports in a trunk. When eight LACP-enabled ports are connected to one of
these older devices, four ports connect, but the other four ports are blocked. The LACP status of the blocked
ports is shown as "Failure."

If one of the other ports becomes disabled, a blocked port replaces it (Port Status becomes "Up"). When the other
port becomes active again, the replacement port goes back to blocked (Port Status is "Blocked"). It can take a few
seconds for the switch to discover the current status of the ports.

Blocked ports with LACP

switch(eth-B1-B8)# show lacp

                         LACP

  PORT   LACP      TRUNK   PORT     LACP      LACP
  NUMB   ENABLED   GROUP   STATUS   PARTNER   STATUS
  ----   -------   ------  ------   -------   ------
  B1     Active    Dyn1    Up       Yes       Success
  B2     Active    Dyn1    Up       Yes       Success
  B3     Active    Dyn1    Up       Yes       Success
  B4     Active    Dyn1    Up       Yes       Success
  B5     Active    Dyn1    Blocked  Yes       Failure
  B6     Active    Dyn1    Blocked  Yes       Failure
  B7     Active    B7      Down     No        Success
  B8     Active    B8      Down     No        Success
If there are ports that you do not want on the default VLAN, ensure that they cannot become dynamic LACP trunk
members. Otherwise a traffic loop can unexpectedly occur. For Example:

Figure 18: A dynamic LACP trunk forming in a VLAN can cause a traffic loop

Easy control methods include either disabling LACP on the selected ports or configuring them to operate in static
LACP trunks.

Spanning Tree and IGMP
If Spanning Tree, IGMP, or both are enabled in the switch, a dynamic LACP trunk operates only with the default
settings for these features and does not appear in the port listings for these features.
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Half-duplex, different port speeds, or both not allowed in LACP trunks
Theports on both sides of an LACP trunk must be configured for the same speed and for full-duplex (FDx). The
802.3ad LACP standard specifies a full-duplex (FDx) requirement for LACP trunking. (10-gigabit ports operate
only at FDx.)

A port configured as LACP passive and not assigned to a port trunk can be configured to half-duplex (HDx).
However, in any of the following cases, a port cannot be reconfigured to an HDx setting:

• If the port is a 10-gigabit port.

• If a port is set to LACP Active, you cannot configure it to HDx.

• If a port is already a member of a static or dynamic LACP trunk, you cannot configure it to HDx.

• If a port is already set to HDx, the switch does not allow you to configure it for a static or dynamic LACP trunk.

Dynamic/static LACP interoperation
A port configured for dynamic LACP can properly interoperate with a port configured for static (TrkX) LACP, but
any ports configured as standby LACP links are ignored.

Trunk group operation using the "trunk" option
This method creates a trunk group that operates independently of specific trunking protocols and does not use a
protocol exchange with the device on the other end of the trunk. With this choice, the switch simply uses the
SA/DA method of distributing outbound traffic across the trunked ports without regard for how that traffic is
handled by the device at the other end of the trunked links. Similarly, the switch handles incoming traffic from the
trunked links as if it were from a trunked source.

When a trunk group is configured with the trunk option, the switch automatically sets the trunk to a priority of "4"
for Spanning Tree operation (even if Spanning Tree is currently disabled). This appears in the running-config file
as spanning-tree Trkn priority 4. Executing write memory after configuring the trunk places the same
entry in the startup-config file.

Use the trunk option to establish a trunk group between a switch and another device, where the other device's
trunking operation fails to operate properly with LACP trunking configured on the switches.

How the switch lists trunk data
Static trunk group

Appears in the menu interface and the output from the CLI show trunk and show interfaces
commands.

Dynamic LACP trunk group

Appears in the output from the CLI show lacp command.

Interface option Dynamic LACP trunk
group

Static LACP trunk group Static non-protocol

Menu interface No Yes Yes

CLI show trunk No Yes Yes

CLI show interfaces No Yes Yes

Table Continued
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Interface option Dynamic LACP trunk
group

Static LACP trunk group Static non-protocol

CLI show lacp Yes Yes No

CLI show spanning-
tree

No Yes Yes

CLI show igmp No Yes Yes

CLI show config No Yes Yes

Outbound traffic distribution across trunked links
The two trunk group options (LACP and trunk) use SA/DA pairs for distributing outbound traffic over trunked links.
That is, the switch sends traffic from the same source address to the same destination address through the same
trunked link, and may also send traffic from the same source address to a different destination address through
the same link or a different link, depending on the mapping of path assignments among the links in the trunk.
Likewise, the switch distributes traffic for the same destination address but from different source addresses
through links depending on the path assignment.

The load-balancing is done on a per-communication basis. Otherwise, traffic is transmitted across the same path
as shown in the figure below. That is, if Client A attached to Switch 1 sends five packets of data to Server A
attached to Switch 2, the same link is used to send all five packets. The SA/DA address pair for the traffic is the
same. The packets are not evenly distributed across any other existing links between the two switches; they all
take the same path.

Figure 19: Example: of single path traffic through a trunk

The actual distribution of the traffic through a trunk depends on a calculation using bits from the SA/DA. When an
IP address is available, the calculation includes the last five bits of the IP source address and IP destination
address; otherwise, the MAC addresses are used. The result of that process undergoes a mapping that
determines which link the traffic goes through. If you have only two ports in a trunk, it is possible that all the traffic
will be sent through one port even if the SA/DA pairs are different. The more ports you have in the trunk, the more
likely it is that the traffic will be distributed among the links.
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When a new port is added to the trunk, the switch begins sending traffic, either new traffic or existing traffic,
through the new link. As links are added or deleted, the switch redistributes traffic across the trunk group. For
example, in the figure below showing a three-port trunk, traffic could be assigned as shown in the following table.

Figure 20: Example: of port-trunked network

Table 16: Example: of link assignments in a trunk group (SA/DA distribution)

Source Destination Link

Node A Node W 1

Node B Node X 2

Node C Node Y 3

Node D Node Z 1

Node A Node Y 2

Node B Node W 3

Because the amount of traffic coming from or going to various nodes in a network can vary widely, it is possible
for one link in a trunk group to be fully utilized while other links in the same trunk have unused bandwidth capacity,
even if the assignments were evenly distributed across the links in a trunk.
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VLAN-based rate-limiting
VLAN-based rate-limiting provides specific bandwidth for a specific VLAN for the inbound traffic on the VLAN. It
allows the user to specify the maximum number of kilobits per second (kbps) a VLAN can receive. The specified
VLAN drops all traffic that exceeds the configured rate. Unused bandwidth is not carried over from one interval to
the next.

VLAN-based rate limiting and rate limiting per interface/port are supported together on the same port. If applying
any of these rate-limit configurations results in blocking the inbound traffic on that port, further packets on that port
are dropped. Any VLAN-based rate limiting applies to all traffic on that VLAN.

Global QoS priority policies and rate limit policies cannot be configured at the same time.

VLAN-based rate limiting is disabled by default.

VLAN-based rate limiting does not work on broadcast traffic. The hardware design lowers the priority
of broadcast traffic to avoid flooding the CPU.

The HPE Switch supports data rate in multiples of 64 kbps. If the configured value is between 1-63, it
is rounded off to 64. For all other non-zero values, it is rounded off to the nearest lower multiple of
64, and the rate-limit is applied

Setting limits for inbound traffic on a specific VLAN

switch(vlan-1)# rate-limit all in kbps <rate>

Usage: rate-limit all in kbps <rate>
       no rate-limit all in

all: Set limits for all traffic
in : Set limits for all inbound traffic

ICMP rate-limiting
In IP networks, ICMP messages are generated in response to either inquiries or requests from routing and
diagnostic functions. These messages are directed to the applications originating the inquiries. In unusual
situations, if the messages are generated rapidly with the intent of overloading network circuits, they can threaten
network availability. This problem is visible in denial-of-service (DoS) attacks or other malicious behaviors where a
worm or virus overloads the network with ICMP messages to an extent where no other traffic can get through.
(ICMP messages themselves can also be misused as virus carriers). Such malicious misuses of ICMP can
include a high number of ping packets that mimic a valid source IP address and an invalid destination IP address
(spoofed pings), and a high number of response messages (such as Destination Unreachable error messages)
generated by the network.

ICMP rate-limiting provides a method for limiting the amount of bandwidth that may be used for inbound ICMP
traffic on a switch port. This feature allows users to restrict ICMP traffic to percentage levels that permit necessary
ICMP functions, but throttle additional traffic that may be caused by worms or viruses (reducing their spread and
effect). In addition, ICMP rate-limiting preserves inbound port bandwidth for non-ICMP traffic.

Chapter 6
Port Traffic Controls
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ICMP is necessary for routing, diagnostic, and error responses in an IP network. ICMP rate-limiting is
primarily used for throttling worm or virus-like behavior and should normally be configured to allow
one to five percent of available inbound bandwidth (at 10 Mbps or 100 Mbps speeds) or 100 to
10,000 kbps (1Gbps or 10 Gbps speeds) to be used for ICMP traffic. This feature should not be
used to remove all ICMP traffic from a network.

ICMP rate-limiting does not throttle non-ICMP traffic. In cases where you want to throttle both ICMP
traffic and all other inbound traffic on a given interface, you can separately configure both ICMP rate-
limiting and all-traffic rate-limiting.

The all-traffic rate-limiting command (rate-limit all) and the ICMP rate-limiting command
(rate-limit icmp) operate differently:

• All-traffic rate-limiting applies to both inbound and outbound traffic and can be specified either in
terms of a percentage of total bandwidth or in terms of bits per second;

• ICMP rate-limiting applies only to inbound traffic and can be specified as only a percentage of
total bandwidth.

Guidelines for configuring ICMP rate-limiting
Apply ICMP rate-limiting on all connected interfaces on the switch to effectively throttle excessive ICMP
messaging from any source. Figure 21: Example: of ICMP rate-limiting on page 124 shows an Example: of
how to configure this for a small to mid-sized campus though similar rate-limit thresholds are applicable to other
network environments. On edge interfaces, where ICMP traffic should be minimal, a threshold of 1% of available
bandwidth should be sufficient for most applications. On core interfaces, such as switch-to-switch and switch-to-
router, a maximum threshold of 5% should be sufficient for normal ICMP traffic. ("Normal" ICMP traffic levels
should be the maximums that occur when the network is rebooting.)

Figure 21: Example: of ICMP rate-limiting

Configuring ICMP rate-limiting
For detailed information about ICMP rate-limiting, see ICMP rate-limiting on page 123.

The rate-limit icmp command controls inbound usage of a port by setting a limit on the bandwidth available
for inbound ICMP traffic.

Syntax:

[no] int <port-list> rate-limit icmp {< percent < 0-100 > | kbps < 0-10000000 > | [trap-clear>]}
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Configures inbound ICMP traffic rate-limiting. You can configure a rate limit from either the global configuration
level (as shown above) or from the interface context level. The no form of the command disables ICMP rate-
limiting on the specified interfaces.

(Default: Disabled.)

percent <1-100> Values in this range allow ICMP traffic as a percentage of the bandwidth available
on the interface.

kbps <0-10000000> Specifies the rate at which to forward traffic in kilobits per second.

0 Causes an interface to drop all incoming ICMP traffic and is not recommended.
See the caution.

trap-clear Clears existing ICMP rate limiting trap condition.

Note: ICMP rate-limiting is not supported on meshed ports. (Rate-limiting can reduce the efficiency of paths
through a mesh domain).

Example:

Either of the following commands configures an inbound rate limit of 1% on ports A3 to A5, which are used as
network edge ports:

switch(config) # int a3-a5 rate-limit icmp 1
switch(eth-A3-A5) # rate-limit icmp 1

When using kbps-mode ICMP rate-limiting, the rate-limiting only operates on the IP payload part of
the ICMP packet (as required by metering RFC 2698). This means that effective metering is at a rate
greater than the configured rate, with the disparity increasing as the packet size decreases (the
packet to payload ratio is higher).

Also, in kbps mode, metering accuracy is limited at low values, For example, less than 45 Kbps. This
is to allow metering to function well at higher media speeds such as 10 Gbps.

For information on using ICMP rate-limiting and all-traffic rate-limiting on the same interface, seeUsing both
ICMP rate-limiting and all-traffic rate-limiting on the same interface on page 125.

Using both ICMP rate-limiting and all-traffic rate-limiting on the same
interface
ICMP and all-traffic rate-limiting can be configured on the same interface. All-traffic rate-limiting applies to all
inbound or outbound traffic (including ICMP traffic), while ICMP rate-limiting applies only to inbound ICMP traffic.

If the all-traffic load on an interface meets or exceeds the currently configured all-traffic inbound rate-
limit while the ICMP traffic rate-limit on the same interface has not been reached, all excess traffic is
dropped, including any inbound ICMP traffic above the all-traffic limit (regardless of whether the
ICMP rate-limit has been reached).

Example:

Suppose:

• The all-traffic inbound rate-limit on port "X" is configured at 55% of the port's bandwidth.

• The ICMP traffic rate-limit on port "X" is configured at 2% of the port's bandwidth.

If at a given moment:
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• Inbound ICMP traffic on port "X" is using 1% of the port's bandwidth, and

• Inbound traffic of all types on port "X" demands 61% of the ports's bandwidth,

all inbound traffic above 55% of the port's bandwidth, including any additional ICMP traffic, is dropped as long as
all inbound traffic combined on the port demands 55% or more of the port's bandwidth.

Viewing the current ICMP rate-limit configuration
The show rate-limit icmp command displays the per-interface ICMP rate-limit configuration in the running-
config file.

Syntax:

show rate-limit icmp [< port-list >]
Without [port-list], this command lists the ICMP rate-limit configuration for all ports on the switch.

With [port-list], this command lists the rate-limit configuration for the specified interfaces. This command operates
the same way in any CLI context

If you want to view the rate-limiting configuration on ports 1–6:

Listing the rate-limit configuration

switch(config)# show rate-limit icmp 1-6

 Inbound ICMP Rate Limit Maximum Percentage

        |          Rate
  Port  | Mode     Limit
  ----- + -------- --------
  1     | Disabled Disabled
  2     | kbps     100
  3     | %        5
  4     | %        1
  5     | %        1
  6     | Disabled Disable
The show running command displays the currently applied setting for any interfaces in the switch configured for
all traffic rate-limiting and ICMP rate-limiting.

The show config command displays this information for the configuration currently stored in the startup-
config file. (Note that configuration changes performed with the CLI, but not followed by a write mem
command, do not appear in the startup-config file.)

Operating notes for ICMP rate-limiting
ICMP rate-limiting operates on an interface (per-port) basis to allow, on average, the highest expected amount of
legitimate, inbound ICMP traffic.

• Interface support: ICMP rate-limiting is available on all types of ports (other than trunk ports or mesh ports),
and at all port speeds configurable for the switch.

• Rate-limiting is not permitted on mesh ports: Either type of rate-limiting (all-traffic or ICMP) can reduce the
efficiency of paths through a mesh domain.

• Rate-limiting is not supported on port trunks: Neither all-traffic nor ICMP rate-limiting are supported on
ports configured in a trunk group.
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• ICMP percentage-based rate-limits are calculated as a percentage of the negotiated link speed: For
example, if a 100 Mbps port negotiates a link to another switch at 100 Mbps and is ICMP rate-limit configured
at 5%, the inbound ICMP traffic flow through that port is limited to 5 Mbps. Similarly, if the same port negotiates
a 10 Mbps link, it allows 0.5 Mbps of inbound traffic. If an interface experiences an inbound flow of ICMP traffic
in excess of its configured limit, the switch generates a log message and an SNMP trap (if an SNMP trap
receiver is configured).

• ICMP rate-limiting is port-based: ICMP rate-limiting reflects the available percentage of an interface's entire
inbound bandwidth. The rate of inbound flow for traffic of a given priority and the rate of flow from an ICMP
rate-limited interface to a particular queue of an outbound interface are not measures of the actual ICMP rate
limit enforced on an interface.

• Below-maximum rates: ICMP rate-limiting operates on a per-interface basis, regardless of traffic priority.
Configuring ICMP rate-limiting on an interface where other features affect inbound port queue behavior (such
as flow control) can result in the interface not achieving its configured ICMP rate-limiting maximum. For
example, in some situations with flow control configured on an ICMP rate-limited interface, there can be
enough "back pressure" to hold high-priority inbound traffic from the upstream device or application to a rate
that does not allow bandwidth for lower-priority ICMP traffic. In this case, the inbound traffic flow may not
permit the forwarding of ICMP traffic into the switch fabric from the rate-limited interface. (This behavior is
termed "head-of-line blocking" and is a well-known problem with flow-control.) In cases where both types of
rate-limiting (rate-limit all and rate-limit icmp) are configured on the same interface, this situation
is more likely to occur.

In another type of situation, an outbound interface can become oversubscribed by traffic received from multiple
ICMP rate-limited interfaces. In this case, the actual rate for traffic on the rate-limited interfaces may be lower
than configured because the total traffic load requested to the outbound interface exceeds the interface's
bandwidth, and thus some requested traffic may be held off on inbound.

• Monitoring (mirroring) ICMP rate-limited interfaces: If monitoring is configured, packets dropped by ICMP
rate-limiting on a monitored interface are still forwarded to the designated monitor port. (Monitoring shows
what traffic is inbound on an interface, and is not affected by "drop" or "forward" decisions.)

• Optimum rate-limiting operation: Optimum rate-limiting occurs with 64-byte packet sizes. Traffic with larger
packet sizes can result in performance somewhat below the configured inbound bandwidth. This is to ensure
the strictest possible rate-limiting of all sizes of packets.

• Outbound traffic flow: Configuring ICMP rate-limiting on an interface does not control the rate of outbound
traffic flow on the interface.

Notes on testing ICMP rate-limiting
ICMP rate-limiting is applied to the available bandwidth on an interface. If the total bandwidth requested by all
ICMP traffic is less than the available, configured maximum rate, no ICMP rate-limit can be applied. That is, an
interface must be receiving more inbound ICMP traffic than the configured bandwidth limit allows. If the interface
is configured with both rate-limit all and rate-limit icmp, the ICMP limit can be met or exceeded only
if the rate limit for all types of inbound traffic has not already been met or exceeded. Also, to test the ICMP limit
you need to generate ICMP traffic that exceeds the configured ICMP rate limit. Using the recommended settings
—1% for edge interfaces and 5% maximum for core interfaces—it is easy to generate sufficient traffic. However, if
you are testing with higher maximums, you need to ensure that the ICMP traffic volume exceeds the configured
maximum.

When testing ICMP rate-limiting where inbound ICMP traffic on a given interface has destinations on multiple
outbound interfaces, the test results must be based on the received outbound ICMP traffic.

ICMP rate-limiting is not reflected in counters monitoring inbound traffic because inbound packets are counted
before the ICMP rate-limiting drop action occurs.
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ICMP rate-limiting trap and Event Log messages
If the switch detects a volume of inbound ICMP traffic on a port that exceeds the ICMP rate-limit configured for
that port, it generates one SNMP trap and one informational Event Log message to notify the system operator of
the condition. (The trap and Event Log message are sent within two minutes of when the event occurred on the
port.) For Example:

I 06/30/05 11:15:42 RateLim: ICMP traffic exceeded configured limit on port A1
These trap and Event Log messages provide an advisory that inbound ICMP traffic on a given interface has
exceeded the configured maximum. The additional ICMP traffic is dropped, but the excess condition may indicate
an infected host (or other traffic threat or network problem) on that interface. The system operator should
investigate the attached devices or network conditions further; the switch does not send more traps or Event Log
messages for excess ICMP traffic on the affected port until the system operator resets the port's ICMP trap
function.

The switch does not send more traps or Event Log messages for excess ICMP traffic on the affected port until the
system operator resets the port’s ICMP trap function. The reset can be done through SNMP from a network
management station or through the CLI with the trap-clear command option.

Syntax:

interface <port-list> rate-limit icmp trap-clear
On a port configured with ICMP rate-limiting, this command resets the ICMP trap function, which allows the switch
to generate a new SNMP trap and an Event Log message if ICMP traffic in excess of the configured limit is
detected on the port.

Example:

An operator noticing an ICMP rate-limiting trap or Event Log message originating with port 1 on a switch would
use the following command to reset the port to send a new message if the condition occurs again:

HP Switch(config)# interface 1 rate-limit icmp trap-clear

Determining the switch port number used in ICMP port reset commands
To enable excess ICMP traffic notification traps and Event Log messages, use the setmib command described
on ICMP rate-limiting trap and Event Log messages on page 128. The port number included in the command
corresponds to the internal number the switch maintains for the designated port and not the port's external
identity.

To match the port's external slot/number to the internal port number, use the walkmib ifDescr command, as
shown in the following example:

Matching internal port numbers to external port numbers

switch# walkmib ifDescr
ifDescr.1 = 1
ifDescr.2 = 2
ifDescr.3 = 3
ifDescr.4 = 4
ifDescr.5 = 5
ifDescr.6 = 6
ifDescr.7 = 7
ifDescr.8 = 8
ifDescr.9 = 9
ifDescr.10 = 10
ifDescr.11 = 11
ifDescr.12 = 12
ifDescr.13 = 13
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ifDescr.14 = 14
ifDescr.15 = 15
ifDescr.16 = 16
ifDescr.17 = 17
ifDescr.18 = 18
ifDescr.19 = 19
ifDescr.20 = 20
ifDescr.21 = 21
ifDescr.22 = 22
ifDescr.23 = 23
ifDescr.24 = 24
ifDescr.210 = Trk1
ifDescr.211 = Trk2
ifDescr.330 = DEFAULT_VLAN
ifDescr.4425 = HP Switch software loopback interface
ifDescr.4426 = HP Switch software loopback interface
.
.
.

Configuring inbound rate-limiting for broadcast and multicast traffic
You can configure rate-limiting (throttling) of inbound broadcast and multicast traffic on the switch, which helps
prevent the switch from being disrupted by traffic storms if they occur on the rate-limited port. The rate-limiting is
implemented as a percentage of the total available bandwidth on the port.

The rate-limit command can be executed from the global or interface context, for Example:

switch(config)# interface 3 rate-limit bcast in percent 10
or

switch(config)# interface 3
switch(eth-3)# rate-limit bcast in percent 10
Syntax:

rate-limit {< bcast | mcast >} in percent < 0-100 > 

Option
in percent <0-100>
Also supports configuring limit in kbps

[no] rate-limit {<bcast | [mcast >]} in
Enables rate-limiting and sets limits for the specified inbound broadcast or multicast traffic. Only the amount of
traffic specified by the percent is forwarded.

Default: Disabled

If you want to set a limit of 50% on inbound broadcast traffic for port 3, you can first enter interface context for port
3 and then execute the rate-limit command, as shown in Inbound broadcast rate-limiting of 50% on port 3
on page 130. Only 50% of the inbound broadcast traffic will be forwarded.
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Inbound broadcast rate-limiting of 50% on port 3

switch(config)# int 3
switch(eth-3)# rate-limit bcast in percent 50

switch(eth-3)# show rate-limit bcast
 Broadcast-Traffic Rate Limit Maximum %

  Port  | Inbound Limit Mode      Radius Override
  ----- + ------------- --------- ---------------
  1     | Disabled      Disabled  No-override
  2     | Disabled      Disabled  No-override
  3     | Disabled      %         No-override
  4     | Disabled      Disabled  No-override
  5     | Disabled      Disabled  No-override
If you rate-limit multicast traffic on the same port, the multicast limit is also in effect for that port, as shown in 
Inbound multicast rate-limiting of 20% on port 3 on page 130. Only 20% of the multicast traffic will be
forwarded.

Inbound multicast rate-limiting of 20% on port 3

switch(eth-3)# rate-limit mcast in percent 20
switch(eth-3)# show rate-limit mcast
 
 Multicast-Traffic Rate Limit Maximum %

  Port  | Inbound Limit Mode      Radius Override
  ----- + ------------- --------- ---------------
  1     | Disabled      Disabled  No-override
  2     | Disabled      Disabled  No-override
  3     | 20            %         No-override
  4     | Disabled      Disabled  No-override
To disable rate-limiting for a port enter the no form of the command, as shown in Disabling inbound multicast
rate-limiting for port 3 on page 130.

Disabling inbound multicast rate-limiting for port 3

switch(eth-3)# no rate-limit mcast in

switch(eth-3)# show rate-limit mcast
 
 Multicast-Traffic Rate Limit Maximum %

  Port  | Inbound Limit Mode      Radius Override
  ----- + ------------- --------- ---------------
  1     | Disabled      Disabled  No-override
  2     | Disabled      Disabled  No-override
  3     | Disabled      Disabled  No-override
  4     | Disabled      Disabled  No-override

Operating Notes
The following information is displayed for each installed transceiver:

• Port number on which transceiver is installed.

• Type of transceiver.
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• Product number — Includes revision letter, such as A, B, or C. If no revision letter follows a product number,
this means that no revision is available for the transceiver.

• Part number — Allows you to determine the manufacturer for a specified transceiver and revision number.

• For a non-HPE switches installed transceiver (see line 23 of "The show tech transceivers command"
example), no transceiver type, product number, or part information is displayed. In the Serial Number field,
non-operational is displayed instead of a serial number.

• The following error messages may be displayed for a non-operational transceiver:

◦ Unsupported Transceiver. (SelfTest Err#060)
◦ This switch only supports revision B and above transceivers.
◦ Self test failure.
◦ Transceiver type not supported in this port.
◦ Transceiver type not supported in this software version.
◦ Not an HPE Switch Transceiver.

Jumbo frames
The maximum transmission unit(MTU) is the maximum size IP frame the switch can receive for Layer 2 frames
inbound on a port. The switch drops any inbound frames larger than the MTU allowed on the port. Ports operating
at a minimum of 1 Gbps can accept forward frames of up to 9220 bytes (including four bytes for a VLAN tag)
when configured for jumbo traffic. You can enable inbound jumbo frames on a per-VLAN basis. That is, on a
VLAN configured for jumbo traffic, all ports belonging to that VLAN and operating at a minimum of 1 Gbps allow
inbound jumbo frames of up to 9220 bytes.

Operating rules

• Required port speed: This feature allows inbound and outbound jumbo frames on ports operating at a
minimum of 1 Gbps.

• GVRP operation: A VLAN enabled for jumbo traffic cannot be used to create a dynamic VLAN. A port
belonging to a statically configured, jumbo-enabled VLAN cannot join a dynamic VLAN.

• Port adds and moves: If you add a port to a VLAN that is already configured for jumbo traffic, the switch
enables that port to receive jumbo traffic. If you remove a port from a jumbo-enabled VLAN, the switch
disables jumbo traffic capability on the port only if the port is not currently a member of another jumbo-enabled
VLAN. This same operation applies to port trunks.

• Jumbo traffic sources: A port belonging to a jumbo-enabled VLAN can receive inbound jumbo frames
through any VLAN to which it belongs, including non-jumbo VLANs. For example, if VLAN 10 (without jumbos
enabled) and VLAN 20 (with jumbos enabled) are both configured on a switch, and port 1 belongs to both
VLANs, port 1 can receive jumbo traffic from devices on either VLAN. For a method to allow only some ports in
a VLAN to receive jumbo traffic, see Configuring a maximum frame size on page 135.
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Jumbo traffic-handling

• HPE does not recommend configuring a voice VLAN to accept jumbo frames. Voice VLAN frames are typically
small, and allowing a voice VLAN to accept jumbo frame traffic can degrade the voice transmission
performance.

• You can configure the default, primary, and/or (if configured) the management VLAN to accept jumbo frames
on all ports belonging to the VLAN.

• When the switch applies the default MTU (1522-bytes including 4 bytes for the VLAN tag) to a VLAN, all ports
in the VLAN can receive incoming frames of up to 1522 bytes. When the switch applies the jumbo MTU (9220
bytes including 4 bytes for the VLAN tag) to a VLAN, all ports in that VLAN can receive incoming frames of up
to 9220 bytes. A port receiving frames exceeding the applicable MTU drops such frames, causing the switch to
generate an Event Log message and increment the "Giant Rx" counter (displayed by show interfaces
<port-list> ).

• The switch allows flow control and jumbo frame capability to co-exist on a port.

• The default MTU is 1522 bytes (including 4 bytes for the VLAN tag). The jumbo MTU is 9220 bytes (including 4
bytes for the VLAN tag).

• When a port is not a member of any jumbo-enabled VLAN, it drops all jumbo traffic. If the port is receiving
"excessive"inbound jumbo traffic, the port generates an Event Log message to notify you of this condition. This
same condition also increments the switch's "Giant Rx" counter.

• If you do not want all ports in a given VLAN to accept jumbo frames, you can consider creating one or more
jumbo VLANs with a membership comprising only the ports you want to receive jumbo traffic. Because a port
belonging to one jumbo-enabled VLAN can receive jumbo frames through any VLAN to which it belongs, this
method enables you to include both jumbo-enabled and non-jumbo ports within the same VLAN.

For example, suppose you want to allow inbound jumbo frames only on ports 6, 7, 12, and 13. However, these
ports are spread across VLAN 100 and VLAN 200 and also share these VLANs with other ports you want
excluded from jumbo traffic. A solution is to create a third VLAN with the sole purpose of enabling jumbo traffic
on the desired ports, while leaving the other ports on the switch disabled for jumbo traffic. That is:

VLAN 100 VLAN 200 VLAN 300

Ports 6-10 11-15 6, 7, 12, and 13

Jumbo-enabled? No No Yes

If there are security concerns with grouping the ports as shown for VLAN 300, you can either use source-port
filtering to block unwanted traffic paths or create separate jumbo VLANs, one for ports 6 and 7, and another for
ports 12 and 13.

• Outbound jumbo traffic. Any port operating at 1 Gbps or higher can transmit outbound jumbo frames through
any VLAN, regardless of the jumbo configuration. The VLAN is not required to be jumbo-enabled, and the port
is not required to belong to any other, jumbo-enabled VLANs. This can occur in situations where a non-jumbo
VLAN includes some ports that do not belong to another, jumbo-enabled VLAN and some ports that do belong
to another, jumbo-enabled VLAN. In this case, ports capable of receiving jumbo frames can forward them to
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the ports in the VLAN that do not have jumbo capability, as shown in Figure 22: Forwarding jumbo frames
through non-jumbo ports on page 133.

Figure 22: Forwarding jumbo frames through non-jumbo ports

Jumbo frames can also be forwarded out non-jumbo ports when the jumbo frames received inbound on a
jumbo-enabled VLAN are routed to another, non-jumbo VLAN for outbound transmission on ports that have no
memberships in other, jumbo-capable VLANs. Where either of the above scenarios is a possibility, the
downstream device must be configured to accept the jumbo traffic. Otherwise, this traffic will be dropped by
the downstream device.

Configuring jumbo frame operation
For detailed information about jumbo frames, see Jumbo frames on page 131.

Overview

1. Determine the VLAN membership of the ports or trunks through which you want the switch to accept inbound
jumbo traffic. For operation with GVRP enabled, refer to the GVRP topic under “Operating Rules”, above.

2. Ensure that the ports through which you want the switch to receive jumbo frames are operating at least at
gigabit speed. (Check the Mode field in the output for the show interfaces brief <port-list>
command.)

3. Use the jumbo command to enable jumbo frames on one or more VLANs statically configured in the switch.
(All ports belonging to a jumbo-enabled VLAN can receive jumbo frames.

4. Execute write memory to save your configuration changes to the startupconfig file.

Viewing the current jumbo configuration
Syntax:

show vlans
Lists the static VLANs configured on the switch and includes a Jumbo column to indicate which VLANs are
configured to support inbound jumbo traffic. All ports belonging to a jumbo-enabled VLAN can receive jumbo
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traffic. (For more information, see Configuring a maximum frame size on page 135.) See Figure Figure 23:
Example: listing of static VLANs to show jumbo status per VLAN on page 134.

Figure 23: Example: listing of static VLANs to show jumbo status per VLAN

Syntax:

show vlans ports <port-list>
Lists the static VLANs to which the specified ports belong, including the Jumbo column to indicate which VLANs
are configured to support jumbo traffic.

Entering only one port in <port-list > results in a list of all VLANs to which that port belongs.

Entering multiple ports in <port-list > results in a superset list that includes the VLAN memberships of all
ports in the list, even though the individual ports in the list may belong to different subsets of the complete VLAN
listing.

Example:

If port 1 belongs to VLAN 1, port 2 belongs to VLAN 10, and port 3 belongs to VLAN 15, executing this command
with a port-list of 1 - 3 results in a listing of all three VLANs, even though none of the ports belong to all three
VLANS. (See Figure 24: Listing the VLAN memberships for a range of ports on page 134.)

Figure 24: Listing the VLAN memberships for a range of ports

Syntax:

show vlans <vid>
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Shows port membership and jumbo configuration for the specified vid . (See Figure 25: Example: of listing the
port membership and jumbo status for a VLAN on page 135.)

Figure 25: Example: of listing the port membership and jumbo status for a VLAN

Enabling or disabling jumbo traffic on a VLAN
Syntax:

vlan <vid> jumbo

[no] vlan <vid> jumbo
Configures the specified VLAN to allow jumbo frames on all ports on the switch that belong to that VLAN. If the
VLAN is not already configured on the switch, vlan <vid> jumbo also creates the VLAN.

A port belonging to one jumbo VLAN can receive jumbo frames through any other VLAN statically configured on
the switch, regardless of whether the other VLAN is enabled for jumbo frames.

The [no] form of the command disables inbound jumbo traffic on all ports in the specified VLAN that do not also
belong to another VLAN that is enabled for jumbo traffic. In a VLAN context, the command forms are jumbo and
no jumbo.

(Default: Jumbos disabled on the specified VLAN.)

Configuring a maximum frame size
You can globally set a maximum frame size for jumbo frames that will support values from 1518 bytes to 9216
bytes for untagged frames.

Syntax:

jumbo max-frame-size <size>
Sets the maximum frame size for jumbo frames. The range is from 1518 bytes to 9216 bytes. (Default: 9216
bytes)

The jumbo max-frame-size is set on a GLOBAL level.

Default: 9216 bytes
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Configuring IP MTU
The following feature is available on the switches covered in this guide. jumbos support is required
for this feature. On switches that do not support this command, the IP MTU value is derived from the
maximum frame size and is not configurable.

You can set the IP MTU globally by entering this command. The value of max-frame-size must be greater than
or equal to 18 bytes more than the value selected for ip-mtu. For example, if ip-mtu is set to 8964, the max-
frame-size is configured as 8982.

Syntax:

jumbo ip-mtu <size>
Globally sets the IP MTU size. Values range between 1500 and 9198 bytes. This value must be 18 bytes less
than the value of max-frame-size.

(Default: 9198 bytes)

SNMP implementation
Jumbo maximum frame size
The maximum frame size for jumbos is supported with the following proprietary MIB object:

hpSwitchMaxFrameSize OBJECT-TYPE
This is the value of the global max-frame-size supported by the switch. The default value is set to 9216 bytes.

Jumbo IP MTU
The IP MTU for jumbos is supported with the following proprietary MIB object:

hpSwitchIpMTU OBJECT-TYPE
This is the value of the global jumbos IP MTU (or L3 MTU) supported by the switch. The default value is set to
9198 bytes (a value that is 18 bytes less than the largest possible maximum frame size of 9216 bytes). This
object can be used only in switches that support max-frame-size and ip-mtu configuration.

Displaying the maximum frame size
Use the show jumbos command to display the globally configured untagged maximum frame size for the switch,
as shown in the following Example:.

switch(config)# show jumbos

 Jumbos Global Values

  Configured : MaxFrameSize : 9216   Ip-MTU : 9198
  In Use     : MaxFrameSize : 9216   Ip-MTU : 9198
For more information about frame size, see Jumbo frames on page 131.

Operating notes for maximum frame size

• When you set a maximum frame size for jumbo frames, it must be on a global level. You cannot use the
jumbo max-frame-size command on a per-port or per-VLAN basis.

• The original way to configure jumbo frames remains the same, which is per-VLAN, but you cannot set a
maximum frame size per-VLAN.

• Jumbo support must be enabled for a VLAN from the CLI or through SNMP.
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• Setting the maximum frame size does not require a reboot.

• When you upgrade to a version of software that supports setting the maximum frame size from a version that
did not, the max-frame-size value is set automatically to 9216 bytes.

• Configuring a jumbo maximum frame size on a VLAN allows frames up to max-frame-size even though
other VLANs of which the port is a member are not enabled for jumbo support.

Troubleshooting

A VLAN is configured to allow jumbo frames, but one or more ports drops all inbound
jumbo frames
The port may not be operating at a minimum of 1 Gbps on the other switches covered in this guide. Regardless of
a port's configuration, if it is actually operating at a speed lower than 1 Gbps for the other switches, it drops
inbound jumbo frames. For example, if a port is configured for Auto mode (speed-duplex auto), but has
negotiated a 7 Mbps speed with the device at the other end of the link, the port cannot receive inbound jumbo
frames. To determine the actual operating speed of one or more ports, view the Mode field in the output for the
following command:

show interfaces brief <port-list>

A non-jumbo port is generating "Excessive undersize/giant frames" messages in the
Event Log
The switches can transmit outbound jumbo traffic on any port, regardless of whether the port belongs to a jumbo
VLAN. In this case, another port in the same VLAN on the switch may be jumbo-enabled through membership in
a different, jumbo-enabled VLAN, and may be forwarding jumbo frames received on the jumbo VLAN to non-
jumbo ports.
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Overview
Detection of link-flap and taking action on the port is done via fault-finder command at 3 different sensitivity levels
(low, medium and high). The configuration in fault-finder for link-flap is a global configuration affecting all ports on
the switch/stack. To provide further granularity to link-flap detection and action which provides different link-flap
detection and action configuration for each port rather than the same configuration for all ports on the switch/
stack. The per-port configuration will supersede the global configuration for fault-finder link-flap.

A configurable option to re-enable ports disabled by link-flap after a waiting period is also been added. The
waiting period time is expressed in unit of seconds in the range 0 to 604800. Maximum allowed waiting period is
one week. Zero is the default value, meaning that the port will not be re-enabled automatically.

A very important point is the wording of “link-flap” itself – i.e. the word “link”. This condition should be
at the link/port-level granular, allowing alerts and actions only on those certain links/ports where the
functionality is needed.

Fault-finder link-flap
Syntax

In the config context:

[no] fault-finder link-flap [ethernet] PORT-LIST action warn | warn-and-disable SECONDS sensitivity low | medium | high

Description

Configures the link-flap on a port. The default value is warn.

Options

link-flap

Configure link-flap control.

warn

Log the event only.

warn-and-disable

Log the event and disable the port.

seconds

Re-enable the port after waiting for the specified number of seconds. The default value is 0, which indicates
that the port will not be automatically enabled.

sensitivity

Indicate the sensitivity of the link-flap control threshold within a 10-second interval.
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• Low indicates 10 link-flaps.

• Medium indicates 6 link-flaps.

• High indicates 3 link-flaps.

Parameters

action

Configure the action taken when a fault is detected.

ethernet PORT-LIST
Enable link-flap control on a list of ports.

warn

Warn about faults found.

warn-and-disable

Warn and disable faulty component.

seconds

Configure the number of seconds for which the port remains disabled. A value of 0 means that the port will
remain disabled until manually re-enabled.

sensitivity

Configure the fault sensitivity level.

low

Low sensitivity.

medium

Medium sensitivity

high

High sensitivity.

Subcommand Syntax

[no] fault-finder link-flap ethernet PORT-LIST
Description

To remove the current configuration of link-flap on a port

Usage

Enable a linkFault-Finder check and set parameters for it. These commands may be repeated to enable additional
checks. The default sensitivity is medium and the default action is warn.

[no] fault-finder all | fault sensitivity low | medium | high action warn | warn-and-disable

[no] fault-finder broadcast-storm sensitivity low | medium | high action warn | warn-and-disable SECONDS

[no] fault-finder link-flap sensitivity low | medium | high action warn | warn-and-disable

[no] fault-finder link-flap PORT-LIST action warn | warn-and-disable SECONDS sensitivity low | medium | high
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Configure ports for link-flap detection with high sensitivity

Configure ports A1 to A5 for link-flap detection with sensitivity of high (3 flaps over 10s) and to log and disable
port for 65535s if the link-flap threshold is exceeded.

switch(config)# fault-finder link-flap ethernet A1-A5 action warn-and-disable 65535 
sensitivity high

Configure ports for link-flap detection with medium sensitivity

Configure ports A8 for link-flap detection with sensitivity of medium (6 flaps over 10s) and to log and disable port if
the link-flap threshold is exceeded. User will need to re-enable the port if disabled.

switch(config)# fault-finder link-flap ethernet A8 action warn-and-disable 0 sensitivity medium

Configure ports for link-flap detection with low sensitivity

Configure ports A22 for link-flap detection with sensitivity of low (10 flaps over 10s) and to log if the link-flap
threshold is exceeded

switch(config)# fault-finder link-flap ethernet A22 action warn sensitivity low

Disable link-flap detection

Disable link-flap detection for port A5

switch(config)# no fault-finder link-flap ethernet A5

Show fault-finder link-flap
Syntax

show fault-finder link-flap ethernet PORT-LIST
Description

Display the link-flap control configuration.

Show fault-finder link-flap

switch# show fault-finder link-flap A1

         Link  | Port                                  Disable    Disable Time
  Port   Flap  | Status Sensitivity Action             Timer      Left        
  ------ ----- + ------ ----------- ------------------ ---------- ------------
  A1     Yes     Down      Low        warn-and-disable 65535      45303

switch# show fault-finder link-flap
         Link  | Port                                    Disable    Disable Time
  Port   Flap  | Status Sensitivity Action               Timer      Left        
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  ------ ----- + ------ ----------- ------------------- ---------- ------------
  A1     Yes     Down      Low         warn-and-disable  65535      45303
  A5     No      Up        None        None                -          -
  A22    Yes     Down      Low         warn-and-disable    -          -
  A23    Yes     Down      High        warn-and-disable   100         -

This example displays only the list of ports configured via the above per-port config commands, does
not include the global configuration ports.

Event Log
Cause

Message Cause

FFI: port <ID>- Excessive link state transitions. Link-flap is detected by fault-finder per the sensitivity
configured.

FFI: port <ID>- Excessive link state
transitions.FFI: port <ID>-Port disabled by
Fault-finder.FFI: port <ID>-Administrator action
is required to re-enable.ports: Fault-finder (71)
has disabled port <ID>.ports: port <ID> is now
offline.vlan: VLAN<VLAN-ID> virtual LAN is
disabled.

Link-flap is detected and the action is to disable the port with
no disable timer.

FFI: port <ID>- Excessive link state
transitions.FFI: port <ID>-Port disabled by
Fault-finder.ports: Fault-finder(71) has disabled
port <ID> for <SECONDS> seconds.ports: port
<ID> is now off-line.vlan: VLAN<VLAN-ID>
virtual LAN is disabled.

Link-flap is detected and the action is to disable the port with
disable timer.

port <ID> timer (71) has expired.ports: port
<ID> is now on-line.vlan: VLAN<VLAN-ID>
virtual LAN is enabled.

The port is enabled when the disable timer expires.

Restrictions
• Per port configuration for options – link-flap only. Global settings for other options.

• No support for menu interface.

• No support for Web UI.

• No support for trunks.
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Using SNMP tools to manage the switch
SNMP is a management protocol that allows an SNMP client application to retrieve device configuration and
status information and to configure the device (get and set). You can manage the switch via SNMP from a
network management station.

To implement SNMP management, the switch must have an IP address configured either manually or dynamically
(using DHCP or Bootp). If multiple VLANs are configured, each VLAN interface should have its own IP address.
For DHCP use with multiple VLANs, see section "The Primary VLAN" in the "Static Virtual LANs (VLANs)" of the
advanced traffic management guide for your switch.

If you use the switch's Authorized IP Managers and Management VLAN features, ensure that the
SNMP management station, the choice of switch port used for SNMP access to the switch, or both,
are compatible with the access controls enforced by these features. Otherwise, SNMP access to the
switch will be blocked.

For more information on Authorized IP Managers, see the access security guide for your switch. (The
latest version of this guide is available on the HPE Networking website.) For information on the
Management VLAN feature, see the section "The Secure Management VLAN" in the "Static Virtual
LANs (VLANs)" chapter of the advanced traffic management guide for your switch.

SNMP management features
SNMP management features on the switch include:

• SNMP version 1, version 2c, or version 3 over IP

• Security via configuration of SNMP communities (SNMPv3 communities on page 149)

• Security via authentication and privacy for SNMPv3 access

• Event reporting via SNMP

◦ Version 1 traps

◦ RMON: groups 1, 2, 3, and 9

• Flow sampling using sFlow

• Standard MIBs, such as the Bridge MIB (RFC 1493), Ethernet MAU MIB (RFC 1515), and others.

The switch SNMP agent also uses certain variables that are included in an HPE proprietary MIB (management
information base) file.

1. Type a model number of your switch (For example, 8212) or product number in the Auto Search text box.

2. Select an appropriate product from the drop down list.

3. Click the Display selected button.

Chapter 8
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4. From the options that appear, select Software downloads.

5. MIBs are available with switch software in the Other category.

Click on software updates, then MIBs.

SNMPv1 and v2c access to the switch
SNMP access requires an IP address and subnet mask configured on the switch. If you are using DHCP/Bootp to
configure the switch, ensure that the DHCP/Bootp process provides the IP address.

Once an IP address is configured, the main steps for configuring SNMPv1 and v2c access management features
are:

Procedure

1. Configure the appropriate SNMP communities. (See SNMPv3 communities on page 149.)

2. Configure the appropriate trap receivers.

In some networks, authorized IP manager addresses are not used. In this case, all management stations using
the correct community name may access the switch with the View and Access levels that have been set for that
community. If you want to restrict access to one or more specific nodes, you can use the switch's IP Authorized
Manager feature. (See the access security guide for your switch.)

If network management security is a concern, Hewlett Packard Enterprise recommends that you
change the write access for the "public" community to "Restricted."

SNMPv3 access to the switch
SNMPv3 access requires an IP address and subnet mask configured on the switch. (See "IP Configuration" on
page 8-2.) If you are using DHCP/Bootp to configure the switch, ensure that the DHCP/Bootp process provides
the IP address. (See "DHCP/Bootp Operation".)

Once you have configured an IP address, the main steps for configuring SNMPv3 access management features
are the following:

Procedure

1. Enable SNMPv3 for operation on the switch (see Enabling SNMPv3 on page 144).

2. Configure the appropriate SNMP users (see SNMPv3 users on page 145).

3. Configure the appropriate SNMP communities (see SNMPv3 communities on page 149).

4. Configure the appropriate trap receivers (see SNMP notifications on page 152).

In some networks, authorized IP manager addresses are not used. In this case, all management stations using
the correct User and community name may access the switch with the View and Access levels that have been set
for that community. If you want to restrict access to one or more specific nodes, you can use the IP Authorized
Manager feature for the switch. (See the access security guide for your switch.)

SNMP version 3 (SNMPv3) adds some new commands to the CLI for configuring SNMPv3 functions. To enable
SNMMPv3 operation on the switch, use the snmpv3 enable command. An initial user entry will be generated
with MD5 authentication and DES privacy.

You may (optionally) restrict access to only SNMPv3 agents by using the snmpv3 only command. To restrict
write-access to only SNMPv3 agents, use the snmpv3 restricted-access command.
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Restricting access to only version 3 messages will make the community named “public” inaccessible
to network management applications (such as autodiscovery, traffic monitoring, SNMP trap
generation, and threshold setting) from operating in the switch.

Enabling and disabling switch for access from SNMPv3 agents
This includes the creation of the initial user record.

Syntax:

[no] snmpv3 enable

Enabling or disabling restrictions to access from only SNMPv3 agents
When enabled, the switch rejects all non-SNMPv3 messages.

Syntax:

[no] snmpv3 only

Enabling or disabling restrictions from all non-SNMPv3 agents to read-only access
Syntax:

[no] snmpv3 restricted-access

Viewing the operating status of SNMPv3
Syntax:

show snmpv3 enable

Viewing status of message reception of non-SNMPv3 messages
Syntax:

show snmpv3 only

Viewing status of write messages of non-SNMPv3 messages
Syntax:

show snmpv3 restricted-access

Enabling SNMPv3
The snmpv3 enable command allows the switch to:

• Receive SNMPv3 messages.

• Configure initial users.

• Restrict non-version 3 messages to "read only" (optional).
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Restricting access to only version 3 messages makes the community named "public" inaccessible to
network management applications (such as autodiscovery, traffic monitoring, SNMP trap generation,
and threshold setting) from running on the switch.

Example:

SNMP version 3 enable command

SNMPv3 users

To create new users, most SNMPv3 management software requires an initial user record to clone.
The initial user record can be downgraded and provided with fewer features, but not upgraded by
adding new features. For this reason, Hewlett Packard Enterprise recommends that when you
enable SNMPv3, you also create a second user with SHA authentication and DES privacy.

To use SNMPv3 on the switch, you must configure the users that will be assigned to different groups:

Procedure

1. Configure users in the User Table with the snmpv3 user command.

To view the list of configured users, enter the show snmpv3 user command (see Adding users on page
146)

2. Assign users to Security Groups based on their security model with the snmpv3 group command (see 
Assigning users to groups (CLI) on page 147).

If you add an SNMPv3 user without authentication, privacy, or both, to a group that requires either
feature, the user will not be able to access the switch. Ensure that you add a user with the
appropriate security level to an existing security group.
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Adding users
To configure an SNMPv3 user, you must first add the user name to the list of known users with the snmpv3 user
command, as shown in Figure 26: Adding SNMPv3 users and displaying SNMPv3 configuration on page
146.

Figure 26: Adding SNMPv3 users and displaying SNMPv3 configuration

SNMPv3 user commands
Syntax:
[no] snmpv3 user <USER_NAME> [auth md5|sha] <AUTH_PASS> [priv des|aes] <PRIV_PASS>
    
[no] snmpv3 remote-engine-id <engineid> user <username> [auth {md5| sha}
         <authentication password>] [priv {des|aes} <privacy password>]
Parameters and options

no

Used to delete a user entry. When you delete a user, only the user name is required.

<AUTH_PASS>

With authorization, you can set either MD5 or SHA authentication. The authentication password auth_pass
must be 6 to 32 characters and is mandatory when you configure authentication.

priv des|aes

With privacy, the switch supports DES (56-bit) and AES (128-bit) encryption. Defaults to DES. Only AES 128-
bit and DES 56-bit encryption are supported as privacy protocols. Other non-standard encryption algorithms,
such as AES-172, AES-256, and 3-DES are not supported.

<PRIV_PASS>

The privacy password priv_pass must be 6 to 32 characters and is mandatory when you configure privacy.

remote-engine-id <engineid>

Sets the SNMPv3 remote engine ID in colon-separated hexadecimal notation.

Listing Users
To display the management stations configured to access the switch with SNMPv3 and view the authentication
and privacy protocols that each station uses, enter the show snmpv3 user command.
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Syntax:

show snmpv3 user
Display of the management stations configured on VLAN 1 on page 147 displays information about the
management stations configured on VLAN 1 to access the switch.

Display of the management stations configured on VLAN 1

switch# configure terminal
switch(config)# vlan 1
switch(vlan-1)# show snmpv3 user

Status and Counters - SNMPv3 Global Configuration Information

 User Name      Auth. Protocol   Privacy Protocol
 -----------    --------------   -----------------
 initial        MD5              CFB AES-128
 NetworkAdmin   MD5              CBC-DES

Assigning users to groups (CLI)
Next you must set the group access level for the user by assigning the user to a group. This is done with the
snmpv3 group command, as shown in Figure 27: Example: of assigning users to groups on page 147. For
more details on the MIBs access for a given group, see Group access levels on page 148.

Figure 27: Example: of assigning users to groups

Syntax:

[no] snmpv3 group
Assigns or removes a user to a security group for access rights to the switch. To delete an entry, all of the
following three parameters must be included in the command:
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group <group_name> Identifies the group that has the privileges that will be assigned to the user.
For more details, see Group access levels on page 148.

user <user_name> Identifies the user to be added to the access group. This must match the
user name added with the snmpv3 user command.

sec-model {<ver1 | ver2c |
ver3>

Defines which security model to use for the added user. An SNMPv3
access group should use only the ver3 security model.

Group access levels
The switch supports eight predefined group access levels, shown in the following table. There are four levels for
use by version 3 users and four are used for access by version 2c or version 1 management applications.

Table 17: Predefined group access levels

Group name Group access type Group read view Group write view

managerpriv Ver3 Must have
Authentication and Privacy

ManagerReadView ManagerWriteView

managerauth Ver3 Must have
Authentication

ManagerReadView ManagerWriteView

operatorauth Ver3 Must have
Authentication

OperatorReadView DiscoveryView

operatornoauth Ver3 No Authentication OperatorReadView DiscoveryView

commanagerrw Ver2c or Ver1 ManagerReadView ManagerWriteView

commanagerr Ver2c or Ver1 ManagerReadView DiscoveryView

comoperatorrw Ver2c or Ver1 OperatorReadView OperatorReadView

comoperatorr Ver2c or Ver1 OperatorReadView DiscoveryView

Each view allows you to view or modify a different set of MIBs:

• Manager Read View – access to all managed objects

• Manager Write View – access to all managed objects except the following:

◦ vacmContextTable

◦ vacmAccessTable

◦ vacmViewTreeFamilyTable

• OperatorReadView – no access to the following:

◦ icfSecurityMIB

◦ hpSwitchIpTftpMode

◦ vacmContextTable
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◦ vacmAccessTable

◦ vacmViewTreeFamilyTable

◦ usmUserTable

◦ snmpCommunityTable

• Discovery View – Access limited to samplingProbe MIB.

All access groups and views are predefined on the switch. There is no method to modify or add
groups or views to those that are predefined on the switch.

SNMPv3 communities
SNMP commuities are supported by the switch to allow management applications that use version 2c or version 1
to access the switch. The communities are mapped to Group Access Levels that are used for version 2c or
version 1 support. This mapping happens automatically based on the communities access privileges, but special
mappings can be added with the snmpv3 community command (see Mapping SNMPv3 communities (CLI) on
page 149).

Mapping SNMPv3 communities (CLI)
SNMP commuities are supported by the switch to allow management applications that use version 2c or version 1
to access the switch. For more details, see SNMPv3 communities on page 149.

Syntax:

[no] snmpv3 community
Maps or removes a mapping of a community name to a group access level. To remove a mapping you need to
specify only the index_name parameter.

index <index_name> An index number or title for the mapping. The values of 1 to 5 are reserved and can
not be mapped.

name
<community_name>

The community name that is being mapped to a group access level.

sec-name
<security_name>

The group level to which the community is being mapped.

tag <tag_value> This is used to specify which target address may have access by way of this index
reference.

Example:
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Figure 28: Assigning a community to a group access level on page 150 shows the assigning of the Operator
community on MgrStation1 to the CommunityOperatorReadWrite group. Any other Operator has an access level
of CommunityOperatorReadOnly.

Figure 28: Assigning a community to a group access level

SNMP community features
Use SNMP communities to restrict access to the switch by SNMP management stations by adding, editing, or
deleting SNMP communities. You can configure up to five SNMP communities, each with either an operator-level
or a manager-level view and either restricted or unrestricted write access.

Using SNMP requires that the switch have an IP address and subnet mask compatible with your network.

Viewing and configuring non-version-3 SNMP communities (Menu)

Procedure

1. From the Main Menu, select:

2. Switch Configuration…

6. SNMP Community Names

Figure 29: The SNMP Communities screen (default values)

2. Press [A] (for Add ).

If you need information on the options in each field, press [Enter] to move the cursor to the Actions line, then
select the Help option. When you are finished with Help, press [E] (for Edit) to return the cursor to the
parameter fields.
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3. Enter the name you want in the Community Name field, and use the Space bar to select the appropriate value
in each of the other fields. (Use the [Tab] key to move from one field to the next.)

4. Press [Enter] , then [S] (for Save ).

Listing community names and values (CLI)
This command lists the data for currently configured SNMP community names (along with trap receivers and the
setting for authentication traps—see SNMP notifications on page 152).

Syntax:

show snmp-server [< community-string >]
Example:

Lists the data for all communities in a switch; that is, both the default "public" community name and another
community named "blue-team."

Figure 30: Example: of the SNMP community listing with two communities

To list the data for only one community, such as the "public" community, use the above command with the
community name included. For Example:

switch# show snmp-server public

Configuring community names and values (CLI)
The snmp-server command enables you to add SNMP communities with either default or specific access
attributes, and to delete specific communities.

Syntax:

[no] snmp-server community <community-name>
Configures a new community name.

• If you do not also specify operator or manager, the switch automatically assigns the community to the
operator MIB view.

• If you do not specify restricted or unrestricted, the switch automatically assigns the community to
restricted (read-only) access.

The no form uses only the <community-name> variable and deletes the named community from the switch.
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[operator | manager] Optionally assigns an access level.

• At the operator level, the community can access all MIB objects
except the CONFIG MIB.

• At the manager level, the community can access all MIB objects.

[restricted |
unrestricted] Optionally assigns MIB access type.

• Assigning the restricted type allows the community to read MIB
variables, but not to set them.

• Assigning the unrestricted type allows the community to read and
set MIB variables.

Example:

To add the following communities:

Community Access Level Type of Access

red-team manager (Access to all MIB
objects.)

unrestricted (read/write)

blue-team operator (Access to all MIB
objects except the CONFIG MIB.)

restricted (read-only)

switch(config)# snmp-server community red-team
   manager unrestricted
switch(config)# snmp-server community blue-team
   operator restricted
To eliminate a previously configured community named "gold-team":

switch(config) # no snmp-server community gold-team

SNMP notifications
The switches:

• Default Traps: A switch automatically sends default traps to trap receivers using the configured community
name. You have to configure and supply the community name to use in the trap-receiver config, there is no
default. Use the snmp-server host <IP_ADDRESS> community "<COMMUNITY_NAME>" command to
configure a community name and the snmp-server host <IP_ADDRESS> community
"<COMMUNITY_NAME>" trap-level [all | critical | not-info | debug | none] command
to set the level of traps to send to the community.

• SNMPv2c informs

• SNMP v3 notification process, including traps

This section describes how to configure a switch to send network security and link-change notifications to
configured trap receivers.
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Supported Notifications
By default, the following notifications are enabled on a switch:

• Manager password changes

• SNMP authentication failure

• Link-change traps: when the link on a port changes from up to down (linkDown) or down to up (linkUp)

• Port-security (web, MAC, or 802.1X) authentication failure

• Invalid password entered in a login attempt through a direct serial, Telnet, or SSH connection

• Inability to establish a connection with the RADIUS or TACACS+ authentication server

• DHCP snooping events

• ARP protection events

General steps for configuring SNMP notifications

Procedure

1. Determine the versions of SNMP notifications that you want to use in your network.

If you want to use SNMPv1 and SNMPv2c traps, you must also configure a trap receiver. See the following
sections and follow the required configuration procedures:

• SNMPv1 and SNMPv2c Traps on page 153

• Configuring an SNMP trap receiver (CLI) on page 154

• Enabling SNMPv2c informs (CLI) on page 155

If you want to use SNMPv3 notifications (including traps), you must also configure an SNMPv3 management
station. Follow the required configuration procedure in Configuring SNMPv3 notifications (CLI) on page
156.

2. To reconfigure any of the SNMP notifications that are enabled by default to be sent to a management station
(trap receiver), see Enabling Link-Change Traps (CLI) on page 161.

3. (Optional) See the following sections to configure optional SNMP notification features and verify the current
configuration:

• Configuring the source IP address for SNMP notifications (CLI) on page 162

• Viewing SNMP notification configuration (CLI) on page 164

SNMPv1 and SNMPv2c Traps
The switches support the following functionality from earlier SNMP versions (SNMPv1 and SNMPv2c):

• Trap receivers: A trap receiver is a management station to which the switch sends SNMP traps and
(optionally) event log messages sent from the switch. From the CLI you can configure up to ten SNMP trap
receivers to receive SNMP traps from the switch.

• Default Traps: A switch automatically sends default traps to trap receivers using the configured community
name. You have to configure and supply the community name to use in the trap-receiver config, there is no
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default. Use the snmp-server host <IP_ADDRESS> community "<COMMUNITY_NAME>" command to
configure a community name and the snmp-server host <IP_ADDRESS> community
"<COMMUNITY_NAME>" trap-level [all | critical | not-info | debug | none] command
to set the level of traps to send to the community.

• Thresholds: A switch automatically sends all messages created when a system threshold is reached to the
network management station that configured the threshold, regardless of the trap receiver configuration.

SNMP trap receivers
Use the snmp-server host command to configure a trap receiver that can receive SNMPv1 and SNMPv2c
traps, and (optionally) Event Log messages. When you configure a trap receiver, you specify its community
membership, management station IP address, and (optionally) the type of Event Log messages to be sent.

If you specify a community name that does not exist—that is, has not yet been configured on the switch—the
switch still accepts the trap receiver assignment. However, no traps are sent to that trap receiver until the
community to which it belongs has been configured on the switch.

To replace one community name with another for the same IP address, you must first enter the

no snmp-server host <community-name> {< ipv4-address | ipv6-address >}
command to delete the unwanted community name. Otherwise, if you add a new community name
with an IP address that is already used with a different community name, two valid community name
entries are created for the same management station.

If you do not specify the event level ([none|all|not-info|critical|debug]), the switch does
not send Event Log messages as traps. However, "well-known" traps and threshold traps (if
configured) are still sent.

Configuring an SNMP trap receiver (CLI)
Syntax:

snmp-server host {< ipv4-addr | ipv6-addr >} < community name>
Configures a destination network management station to receive SNMPv1/v2c traps and (optionally) Event Log
messages sent as traps from the switch, using the specified community name and destination IPv4 or IPv6
address. You can specify up to ten trap receivers (network management stations). (The default community name
is public.)
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[{<none | all | not-info | 
critical | debug>}]

(Optional) Configures the security level of the Event Log
messages you want to send as traps to a trap receiver (see
the following table).

• The type of Event Log message that you specify applies
only to Event Log messages, not to threshold traps.

• For each configured event level, the switch continues to
send threshold traps to all network management stations
that have the appropriate threshold level configured.

• If you do not specify an event level, the switch uses the
default value (none) and sends no Event Log messages as
traps.

[<inform>]
(Optional) Configures the switch to send SNMPv2 inform
requests when certain events occur. For more information, see 
Enabling SNMPv2c informs (CLI).

Table 18: Security levels for Event Log messages sent as traps

Security Level Action

None (default) Sends no Event Log messages.

All Sends all Event Log messages.

Not-Info Sends all Event Log messages that are not for information only.

Critical Sends only Event Log messages for critical error conditions.

Debug Sends only Event Log messages needed to troubleshoot network- and switch-level problems.

Example:

To configure a trap receiver in a community named "red-team" with an IP address of 10.28.227.130 to receive
only "critical" event log messages, you can enter the following command:

switch(config)# snmp-server host 10.28.227.130 red-team critical

SNMPv2c informs
On a switch enabled for SNMPv2c, you can use the snmp-server host inform command (Enabling
SNMPv2c informs (CLI) on page 155) to send inform requests when certain events occur. When an SNMP
Manager receives an inform request, it can send an SNMP response back to the sending agent on the switch to
let the agent know that the inform request reached its destination.

If the sending agent on the switch does not receive an SNMP response back from the SNMP Manager within the
timeout period, the inform request may be resent, based on the retry count value.

When you enable SNMPv2c inform requests to be sent, you must specify the IP address and community name of
the management station that will receive the inform notification.

Enabling SNMPv2c informs (CLI)
For information about enabling SNMPv2c informs, see SNMPv2c informs on page 155.
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Syntax:

[no] snmp-server host {< ipv4-addr | ipv6-addr >} <community name> inform [retries < count >] [timeout < interval >]

Enables (or disables) the inform option for SNMPv2c on the switch and allows you to configure options for
sending SNMP inform requests.

retries Maximum number of times to resend an inform request if no SNMP response is received.
(Default: 3)

timeout Number of seconds to wait for an acknowledgement before resending the inform request.
(Default: 15 seconds)

The retries and timeout values are not used to send trap requests.

To verify the configuration of SNMPv2c informs, enter the show snmp-server command, as shown in Display
of SNMPv2c inform configuration on page 156 (note indication of inform Notify Type in bold below):

Display of SNMPv2c inform configuration

switch(config)# show snmp-server

 SNMP Communities

  Community Name   MIB View Write Access
  ---------------- -------- ------------ public          Manager  Unrestricted

 Trap Receivers

  Link-Change Traps Enabled on Ports [All] : All
  ...
  Address               Community       Events Sent Notify Type Retry Timeout
  --------------------- --------------- ----------- ----------- ----- --------
  15.28.333.456         guest           All         inform      3     15

 Excluded MIBs

 Snmp Response Pdu Source-IP Information

  Selection Policy   : Default rfc1517

 Trap Pdu Source-IP Information 
  Selection Policy   : Configured IP 
  Ip Address        : 10.10.10.10

Configuring SNMPv3 notifications (CLI)
The SNMPv3 notification process allows messages that are passed via SNMP between the switch and a network
management station to be authenticated and encrypted.

Procedure

1. Enable SNMPv3 operation on the switch by entering the snmpv3 enable command (See "SNMP Version 3
Commands" on page N-7).
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When SNMPv3 is enabled, the switch supports:

• Reception of SNMPv3 notification messages (traps and informs)

• Configuration of initial users

• (Optional) Restriction of non-SNMPv3 messages to "read only"

2. Configure SNMPv3 users by entering the snmpv3 user command (see SNMPv3 users on page 145). Each
SNMPv3 user configuration is entered in the User Table.

3. Assign SNMPv3 users to security groups according to their level of access privilege by entering the snmpv3
group command (see Assigning users to groups (CLI) on page 147).

4. Define the name of an SNMPv3 notification configuration by entering the snmpv3 notify command.

Syntax:

[no] snmpv3 notify <notify_name> tagvalue <tag_name> type {inform|trap}

Associates the name of an SNMPv3 notification configuration with a tag name used (internally) in SNMPv3
commands. To delete a notification-to-tag mapping, enter no snmpv3 notify notify_name .

notify <notify_name> Specifies the name of an SNMPv3 notification configuration.

tagvalue <tag_name> Specifies the name of a tag value used in other SNMPv3 commands, such as
snmpv3 targetaddress params taglist tag_name in Step 5.

type Specifies the notification type as inform or trap. By default, the notification
type is trap.

5. Configure the target address of the SNMPv3 management station to which SNMPv3 informs and traps are
sent by entering the snmpv3 targetaddress command.

Syntax:

[no] snmpv3 targetaddress {< ipv4-addr | ipv6-addr >} <name>
Configures the IPv4 or IPv6 address, name, and configuration filename of the SNMPv3 management station to
which notification messages are sent.
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params <parms_name> Name of the SNMPv3 station's parameters file.The
parameters filename configured with params
params_name must match the params params_name
value entered with the snmpv3 params command in
Step 6.

taglist <tag_name> [tag_name] … Specifies the SNMPv3 notifications (identified by one or
more tag_name values) to be sent to the IP address of the
SNMPv3 management station.

You can enter more than one tag_name value. Each
tag_name value must be already associated with the
name of an SNMPv3 notification configuration entered
with the snmpv3 notify command in Step 4.Use a
blank space to separate tag_name values.

You can enter up to 103 characters in tag_name entries
following the taglist keyword.

[filter {<none | debug | all | not-
info | critical>}]

(Optional) Configures the type of messages sent to a
management station.(Default: none.)

[udp-port < port >] (Optional) Specifies the UDP port to use.(Default: 162.)

[port-mask < mask >] (Optional) Specifies a range of UDP ports. (Default: 0.)

[addr-mask < mask >] (Optional) Specifies a range of IP addresses as
destinations for notification messages.(Default: 0.)

[retries < value >] (Optional) Number of times a notification is retransmitted if
no response is received. Range: 1-255.(Default: 3.)

[timeout < value >] (Optional) Time (in millisecond increments) allowed to
receive a response from the target before notification
packets are retransmitted. Range: 0-2147483647.[Default:
1500 (15 seconds).]

[max-msg-size < size >] (Optional) Maximum number of bytes supported in a
notification message to the specified target. (Default:
1472)

6. Create a configuration record for the target address with the snmpv3 params command.

Syntax:

[no] snmpv3 params <params_name> user <user_name>
Applies the configuration parameters and IP address of an SNMPv3 management station (from the params
params_name value configured with the snmpv3 targetaddress command in Step 5) to a specified
SNMPv3 user (from the user user_name value configured with the snmpv3 user command in Step 2).

If you enter the snmpv3 params user command, you must also configure a security model ( sec-model)
and message processing algorithm ( msg-processing).
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{<sec-model [ver1 | ver2c | ver3>]} Configures the security model used for SNMPv3
notification messages sent to the management
station configured with the snmpv3
targetaddress command in Step 5.

If you configure the security model as ver3, you
must also configure the message processing value as
ver3.

{msg-processing {<ver1 | ver2c | ver3>}
[noaut | auth | priv]}

Configures the algorithm used to process messages
sent to the SNMPv3 target address.

If you configure the message processing value as
ver3 and the security model as ver3, you must also
configure a security services level ( noauth, auth, or
priv).

Example:

An Example: of how to configure SNMPv3 notification is shown here:

Figure 31: Example: of an SNMPv3 notification configuration

Network security notifications
By default, a switch is enabled to send the SNMP notifications listed in Supported Notifications on page 153
when a network security event (For example, authentication failure) occurs. However, before security notifications
can be sent, you must first configure one or more trap receivers or SNMPv3 management stations as described
in:

• Configuring an SNMP trap receiver (CLI) on page 154

• Configuring SNMPv3 notifications (CLI) on page 156

You can manage the default configuration of the switch to disable and re-enable notifications to be sent for the
following types of security events:

• ARP protection events

• Inability to establish a connection with the RADIUS or TACACS+ authentication server

• DHCP snooping events

• Dynamic IP Lockdown hardware resources consumed

• Link change notification
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• Invalid password entered in a login attempt through a direct serial, Telnet, or SSH connection

• Manager password changes

• Port-security (web, MAC, or802.1X) authentication failure

• SNMP authentication failure

• Running configuration changes

Enabling or disabling notification/traps for network security failures and other security
events (CLI)
For more information, see Network security notifications on page 159.

Syntax:

[no] snmp-server enable traps [snmp-auth | password-change-mgr | login-failure-mgr 
| port-security | auth-server-fail | dhcp-snooping | arp-protect | running-config-
change]
Enables or disables sending one of the security notification types listed below to configured trap receivers.
(Unless otherwise stated, all of the following notifications are enabled in the default configuration.)

The notification sends a trap:

arp-protect If ARP packets are received with an invalid source or
destination MAC address, an invalid IP address, or an
invalid IP-to-MAC binding.

auth-server-fail If the connection with a RADIUS or TACACS+
authentication server fails.

dhcp-snooping If DHCP packets are received from an untrusted
source or if DHCP packets contain an invalid IP-to-
MAC binding.

dhcpv6-snooping Set the traps for DHCPv6 snooping.

dyn-ip-lockdown If the switch is out of hardware resources needed to
program a dynamic IP lockdown rule

dyn-ipv6-lockdown Enable traps for Dynamic IPv6 lockdown..

link-change <port-list> When the link state on a port changes from up to
down, or the reverse.

login-failure-mgr For a failed login with a manager password.

password-change-mgr When a manager password is reset.

mac-notify Globally enables the generation of SNMP trap
notifications upon MAC address table changes.

nd-snooping Set the trap for nd snooping

Table Continued
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port-security For a failed authentication attempt through a web,
MAC, or 801.X authentication session.

running-config-change When changes to the running configuration file are
made.

snmp-authentication [extended |
standard]

For a failed authentication attempt via SNMP.(Default:
extended.)

Startup-config-change Sends a trap when changes to the startup
configuration file are made. See “Enabling SNMP
Traps on Startup Configuration Changes” on page 6–
34. (Default: Disabled)

To determine the specific cause of a security event, check the Event Log in the console interface to see why a
trap was sent. For more information, see "Using the Event Log for Troubleshooting Switch Problems".

Viewing the current configuration for network security notifications (CLI)
Enter the show snmp-server traps command, as shown in Display of configured network security
notifications on page 161. Note that command output is a subset of the information displayed with the show
snmp-server command in Display of SNMP notification configuration.

Display of configured network security notifications

switch(config)# show snmp-server traps

 Trap Receivers

  Link-Change Traps Enabled on Ports [All] : A1-A24

  Traps Category                  Current Status
  ------------------------------  --------------------------
  SNMP Authentication           : Extended
  Password change               : Enabled
  Login failures                : Enabled
  Port-Security                 : Enabled
  Authorization Server Contact  : Enabled
  DHCP Snooping                 : Enabled
  Dynamic ARP Protection        : Enabled
  Dynamic IP Lockdown           : Enabled

  Address                Community  Events Sent Notify Type Retry Timeout
  ---------------------- ---------- ----------- ----------- ----- -------
  15.255.5.225           public     All         trap          3   15
  2001:0db8:0000:0001
    :0000:0000:0000:0121 user_1     All         trap          3   15

  Excluded MIBs

Enabling Link-Change Traps (CLI)
By default, a switch is enabled to send a trap when the link state on a port changes from up to down (linkDown) or
down to up (linkUp). To reconfigure the switch to send link-change traps to configured trap receivers, enter the
snmp-server enable traps link-change command.

Chapter 8 Configuring for Network Management Applications 161

Anexo 04 ITEM 11 (0592666)         SEI 0008478-63.2018.6.02.8000 / pg. 5985



Syntax:

[no] snmp-server enable traps link-change <port-list> [all]
Enables or disables the switch to send a link-change trap to configured trap receivers when the link state on a
port goes from up to down or down to up.

Enter all to enable or disable link-change traps on all ports on the switch.

Readable interface names in traps
The SNMP trap notification messages for linkup and linkdown events on an interface includes IfDesc and IfAlias
var-bind information.

Source IP address for SNMP notifications
The switch uses an interface IP address as the source IP address in IP headers when sending SNMP
notifications (traps and informs) or responses to SNMP requests.

For multi-netted interfaces, the source IP address is the IP address of the outbound interface of the SNMP reply,
which may differ from the destination IP address in the IP header of the received request. For security reasons, it
may be desirable to send an SNMP reply with the IP address of the destination interface (or a specified IP
address) on which the corresponding SNMP request was received.

To configure the switch to use the source IP address on which an SNMP request was received in SNMP
notification/traps and replies, enter the snmp-server response-source and snmp-server trap-source
commands (Configuring the source IP address for SNMP notifications (CLI)).

Configuring the source IP address for SNMP notifications (CLI)
For more information, see Source IP address for SNMP notifications on page 162.

Syntax:

[no] snmp-server response-source [dst-ip-of-request | [ipv4-addr | ipv6-addr] | loopback <0-7>]
Specifies the source IP address of the SNMP response PDU. The default SNMP response PDU uses the IP
address of the active interface from which the SNMP response was sent as the source IP address.

The no form of the command resets the switch to the default behavior (compliant with rfc-1517).

(Default: Interface IP address)

dst-ip-of-request Destination IP address of the SNMP request PDU that is used as the
source IP address in an SNMP response PDU.

[ipv4-addr | ipv6-addr] User-defined interface IP address that is used as the source IP address
in an SNMP response PDU. Both IPv4 and IPv6 addresses are
supported.

loopback <0-7> IP address configured for the specified loopback interface that is used as
the source IP address in an SNMP response PDU. If multiple loopback IP
addresses are configured, the lowest alphanumeric address is used.

To use the IP address of the destination interface on which an SNMP request was received as the source IP
address in the IP header of SNMP traps and replies, enter the following command:

switch(config)# snmp-server response-source dst-ip-of-request
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Syntax:

[no] snmp-server trap-source [ipv4-addr | loopback <0-7>]
Specifies the source IP address to be used for a trap PDU. To configure the switch to use a specified source IP
address in generated trap PDUs, enter the snmp-server trap-source command.

The no form of the command resets the switch to the default behavior (compliant with rfc-1517).

(Default: Use the interface IP address in generated trap PDUs)

ipv4-addr User-defined interface IPv4 address that is used as the source IP address in generated
traps. IPv6 addresses are not supported.

loopback <0-7> P address configured for the specified loopback interface that is used as the source IP
address in a generated trap PDU. If multiple loopback IP addresses are configured, the
lowest alphanumeric address is used.

When you use the snmp-server response-source and snmp-server trap-source
commands, note the following behavior:

• The snmp-server response-source and snmp-server trap-source commands
configure the source IP address for IPv4 interfaces only.

• You must manually configure the snmp-server response-source value if you wish to change
the default user-defined interface IP address that is used as the source IP address in SNMP traps
(RFC 1517).

• The values configured with the snmp-server response-source and snmp-server trap-
source commands are applied globally to all interfaces that are sending SNMP responses or
SNMP trap PDUs.

• Only the source IP address field in the IP header of the SNMP response PDU can be changed.

• Only the source IP address field in the IP header and the SNMPv1 Agent Address field of the
SNMP trap PDU can be changed.

Verifying the configuration of the interface IP address used as the source IP address in IP
headers for SNMP replies and traps sent from the switch (CLI)
Enter the show snmp-server command to display the SNMP policy configuration, as shown in Display of
source IP address configuration on page 163.

Display of source IP address configuration

switch(config)# show snmp-server
 
 SNMP Communities
  
  Community Name   MIB View Write Access
  ---------------- -------- ------------
  public           Manager  Unrestricted

 Trap Receivers
  Link-Change Traps Enabled on Ports [All] : All

  ...
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 Excluded MIBs
 Snmp Response Pdu Source-IP Information
  Selection Policy : dstIpOfRequest 1

 Trap Pdu Source-IP Information
  Selection Policy : Configured IP
1 dstIpOfRequest: The destination IP address of the interface on which an SNMP request is received i s used as
the source IP address in SNMP replies.

Viewing SNMP notification configuration (CLI)
Syntax:

show snmp-server
Displays the currently configured notification settings for versions SNMPv1 and SNMPv2c traps, including SNMP
communities, trap receivers, link-change traps, and network security notifications.

Example:

In the following Example:, the show snmp-server command output shows that the switch has been configured
to send SNMP traps and notifications to management stations that belong to the "public," "red-team," and "blue-
team" communities.

Figure 32: Display of SNMP notification configuration

Advanced management: RMON
The switch supports RMON (remote monitoring) on all connected network segments. This allows for
troubleshooting and optimizing your network.

The following RMON groups are supported:
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• Ethernet Statistics (except the numbers of packets of different frame sizes)

• Alarm

• History (of the supported Ethernet statistics)

• Event

The RMON agent automatically runs in the switch. Use the RMON management station on your network to
enable or disable specific RMON traps and events. Note that you can access the Ethernet statistics, Alarm and
Event groups from the HPE Switch Manager network management software.

CLI-configured sFlow with multiple instances
sFlow can also be configured via the CLI for up to three distinct sFlow instances: once enabled, an sFlow
receiver/destination can be independently configured for full flow-sampling and counter-polling. CLI-configured
sFlow instances may be saved to the startup configuration to persist across a switch reboot.

Configuring sFlow (CLI)
The following sFlow commands allow you to configure sFlow instances via the CLI. For more information, see 
Advanced management: RMON on page 164.

Syntax:

[no] sflow <receiver-instance> destination <ip-address> [< udp-port-num >]
Enables an sFlow receiver/destination. The receiver-instance number must be a 1, 2, or 3.

By default, the udp destination port number is 6343.

To disable an sFlow receiver/destination, enter no sflow receiver-instance .

Syntax:

sflow <receiver-instance> sampling <port-list> <sampling rate>
Once an sFlow receiver/destination has been enabled, this command enables flow sampling for that instance.
The receiver-instance number is 1, 2, or 3, and the sampling rate is the allowable non-zero skipcount for the
specified port or ports.

To disable flow-sampling for the specified port-list, repeat the above command with a sampling rate of 0.

Syntax:

sflow <receiver-instance> polling <port-list> <polling interval>
Once an sFlow receiver/destination has been enabled, this command enables counter polling for that instance.
The receiver-instance number is 1, 2, or 3, and the polling interval may be set to an allowable non-zero value to
enable polling on the specified port or ports.

To disable counter-polling for the specified port-list, repeat the above command with a polling interval of 0.

Under the multiple instance implementation, sFlow can be configured via the CLI or via SNMP.
However, CLI-owned sFlow configurations cannot be modified via SNMP, whereas SNMP-owned
instances can be disabled via the CLI using the no sflow <receiver-instance> command.
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Viewing sFlow Configuration and Status (CLI)
The following sFlow commands allow you to display sFlow configuration and status via the CLI. Viewing sFlow
destination information on page 166 is an Example: of sflow agent information.

Syntax:

show sflow agent
Displays sFlow agent information. The agent address is normally the IP address of the first VLAN configured.

The show sflow agent command displays read-only switch agent information. The version information shows
the sFlow version, MIB support, and software versions; the agent address is typically the IP address of the first
VLAN configured on the switch.

Viewing sflow agent information

switch# show sflow agent

  Version          1.3;HP;XX.11.40
  Agent Address    10.0.10.228
Syntax:

show sflow <receiver instance> destination
Displays information about the management station to which the sFlow sampling-polling data is sent.

The show sflow instance destination command includes information about the management-station's
destination address, receiver port, and owner, as shown in Viewing sFlow destination information on page
166.

Viewing sFlow destination information

switch# show sflow 2 destination

  Destination Instance        2
  sflow                       Enabled
  Datagrams Sent              221
  Destination Address         10.0.10.41
  Receiver Port               6343
  Owner                       Administrator, CLI-owned, Instance 2
  Timeout (seconds)           99995530
  Max Datagram Size           1400
  Datagram Version Support    5
Note the following details:

• Destination Address remains blank unless it has been configured.

• Datagrams Sent shows the number of datagrams sent by the switch agent to the management station since
the switch agent was last enabled.

• Timeout displays the number of seconds remaining before the switch agent will automatically disable sFlow
(this is set by the management station and decrements with time).

• Max Datagram Size shows the currently set value (typically a default value, but this can also be set by the
management station).
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Syntax:

show sflow <receiver instance> sampling-polling <port-list/range>
Displays status information about sFlow sampling and polling.

The show sflow instance sampling-polling [port-list] command displays information about
sFlow sampling and polling on the switch, as shown in Figure 33: Example: of viewing sFlow sampling and
polling information on page 167. You can specify a list or range of ports for which to view sampling information.

Figure 33: Example: of viewing sFlow sampling and polling information

The sampling and polling instances (noted in parentheses) coupled to a specific receiver instance
are assigned dynamically, and so the instance numbers may not always match. The key thing to note
is whether sampling or polling is enabled on a port, and the sampling rates or polling intervals for the
receiver instance configured on each port.

Configuring UDLD Verify before forwarding
When an UDLD enabled port transitions to link-up, the port will begin with a UDLD blocking state. UDLD will
probe via protocol packet exchange to determine the bidirectional state of the link. Until UDLD has completed the
probe, all data traffic will be blocked. If the link is found to be bidirectional, UDLD will unblock the port for data
traffic to pass. Once UDLD unblocks the port, other protocols will see the port as up and data traffic can be safely
forwarded.

The default mode of a switch is “forward first then verify’’. Enabling UDLD link-up will default to “forward first then
verify”. To change the mode to “verify then forward”, you need to configure using the commands found in section
6.72.

Link-UP data traffic will resumed after probing the link partner completes. All other protocols running
will see the port as down.

UDLD time delay
UDLD protocol informs the link partner simultaneously as it detects a state change from unidirectional to
bidirectional traffic. Additional packet exchanges will be carried out by UDLD in addition to the existing UDLD
exchanges whenever state changes from unidirectional to bidirectional.
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Table 19: Peer state transition timings

Interval Time Interval 1 Interval 1 + delta Interval 2 Interval 3

5 sec 5+(<5) sec* 10 sec 15 sec

With triggered
updates

State = blockedPeer
State = blocked

Inform PeerState =
unblockedPeer State
= unblocked

Regular UDLD TX Regular UDLD TX

Without triggered
updates

State = blockedPeer
State = blocked

State =
unblockedPeer State
= blocked

Inform PeerState =
unblockedPeer State
= unblocked

Regular UDLD TX

*delta is the time when the unblock event occurs on local side

Restrictions

• There is no support available when configuring this mode from the web and menu interface.

• There are no new packet types are introduced with UDLD.

• There are no new UDLD timers being introduced.

UDLD configuration commands
Syntax:

HP Switch(config)# link-keepalive mode [verify-then-forward | forward-then-verify]
This command configures the link-keepalive mode.

Link-keepalive provides two modes of operation; verify-then-forward and forward-then-verify.

When using the verify-then-forward mode, the port is in a blocking state until the link configured for UDLD
establishes bidirectional communication. When using the forward-then-verify mode, the port forwards the
data then verifies the status of the link-in state.

When a unidirectional state is detected, the port is moved to a blocked state.

When a bidirectional state is detected, the data is forwarded without interruption.

Syntax:

HP Switch(config)# link-keepalive mode verify-then-forward
Keeps the port in a logically blocked state until the link configured for UDLD has been successfully established in
bi-directional communication.

Syntax:

HP Switch(config)# link-keepalive mode forward-then-verify
Forwards the data then verifies the status of the link. If a unidirectional state is detected, the port is then moved to
a blocked state.
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Syntax:

HP Switch(config)# link-keepalive interval <deciseconds>
Configure the interval for link-keepalive. The link-keepalive interval is the time between sending two
UDLD packets. The time interval is entered in deciseconds (1/10 sec). The default keepalive interval is 50
deciseconds.

Example:

A value of 10 is 1 sec., 11 is 1.1 sec.

Syntax:

HP Switch(config)# link-keepalive retries <number>
Maximum number of sending attempts for UDLD packets before declaring the link as faulty.

Default keepalive attempt is 4.

Show commands
Syntax:

switch(config)# show link-keepalive
Sample output:

Total link-keepalive enabled ports: 8
Keepalive Retries : 4
Keepalive Interval: 5 sec
Keepalive Mode : verify-then-forward
Physical Keepalive Adjacent UDLD

Port  Enabled Status           Status    Switch       VLAN
----- ------- ---------------- --------- ------------- ----------
1     Yes     down             off-line  000000-000000 untagged
2     Yes     down             off-line  000000-000000 untagged
3     Yes     down             off-line  000000-000000 untagged
4     Yes     down             off-line  000000-000000 untagged
5     Yes     down             off-line  000000-000000 untagged
6     Yes     down             off-line  000000-000000 untagged
7     Yes     down             off-line  000000-000000 untagged
8     Yes     down             off-line  000000-000000 untagged

RMON generated when user changes UDLD mode
RMON events are generated when UDLD is configured. The first time you configure the mode, the UDLD states
will be re-initialized. An event log entry is initiated to include the reason for the initial UDLD blocking state during
link up.

Example:

UDLD mode [verify-then-forward | forward-then-verify] is configured

Severity: - Info.

LLDP
To standardize device discovery on all HPE switches, LLDP is implemented while offering limited read-only
support for CDP, as documented in this manual. For the latest information on your switch model, consult the
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Release Notes (available on the HPE Networking website). If LLDP has not yet been implemented (or if you are
running an older version of software), consult a previous version of the Management and Configuration Guide for
device discovery details.

LLDP (Link Layer Discovery Protocol): provides a standards-based method for enabling the switches covered
in this guide to advertise themselves to adjacent devices and to learn about adjacent LLDP devices.

LLDP-MED (LLDP Media Endpoint Discovery): Provides an extension to LLDP and is designed to support VoIP
deployments.

LLDP-MED is an extension for LLDP, and the switch requires that LLDP be enabled as a prerequisite
to LLDP-MED operation.

An SNMP utility can progressively discover LLDP devices in a network by:

Procedure

1. Reading a given device's Neighbors table (in the Management Information Base, or MIB) to learn about other,
neighboring LLDP devices.

2. Using the information learned in step 1 to find and read the neighbor devices' Neighbors tables to learn about
additional devices, and so on.

Also, by using show commands to access the switch's neighbor database for information collected by an
individual switch, system administrators can learn about other devices connected to the switch, including device
type (capability) and some configuration information. In VoIP deployments using LLDP-MED on the switches,
additional support unique to VoIP applications is also available. See LLDP-MED (media-endpoint-discovery) on
page 185.

General LLDP operation
An LLDP packet contains data about the transmitting switch and port. The switch advertises itself to adjacent
(neighbor) devices by transmitting LLDP data packets out all ports on which outbound LLDP is enabled and by
reading LLDP advertisements from neighbor devices on ports that are inbound LLDP-enabled. (LLDP is a one-
way protocol and does not include any acknowledgement mechanism.) An LLDP-enabled port receiving LLDP
packets inbound from neighbor devices stores the packet data in a Neighbor database (MIB).

LLDP-MED
This capability is an extension to LLDP and is available on the switches. See LLDP-MED (media-endpoint-
discovery) on page 185.

Packet boundaries in a network topology

• Where multiple LLDP devices are directly connected, an outbound LLDP packet travels only to the next LLDP
device. An LLDP-capable device does not forward LLDP packets to any other devices, regardless of whether
they are LLDP-enabled.

• An intervening hub or repeater forwards the LLDP packets it receives in the same manner as any other
multicast packets it receives. Thus, two LLDP switches joined by a hub or repeater handle LLDP traffic in the
same way that they would if directly connected.

• Any intervening 802.1D device or Layer-3 device that is either LLDP-unaware or has disabled LLDP operation
drops the packet.

170 Aruba 2530 Management and Configuration Guide for ArubaOS-Switch 16.05

Anexo 04 ITEM 11 (0592666)         SEI 0008478-63.2018.6.02.8000 / pg. 5994



LLDP operation configuration options
In the default configuration, LLDP is enabled and in both transmit and receive mode on all active ports. The LLDP
configuration includes global settings, which apply to all active ports on the switch, and per-port settings, which
affect only the operation of the specified ports.

The commands in the LLDP sections affect both LLDP and LLDP-MED operation. For information on operation
and configuration unique to LLDP-MED, see LLDP-MED (media-endpoint-discovery) on page 185.

Enable or disable LLDP on the switch
In the default configuration, LLDP is globally enabled on the switch. To prevent transmission or receipt of LLDP
traffic, you can disable LLDP operation.

Enable or disable LLDP-MED
In the default configuration for the switches, LLDP-MED is enabled by default. (Requires that LLDP is also
enabled.) For more information, see LLDP-MED (media-endpoint-discovery) on page 185.

Change the frequency of LLDP packet transmission to neighbor devices
On a global basis, you can increase or decrease the frequency of outbound LLDP advertisements.

Change the Time-To-Live for LLDP packets sent to neighbors
On a global basis, you can increase or decrease the time that the information in an LLDP packet outbound from
the switch will be maintained in a neighbor LLDP device.

Transmit and receive mode
With LLDP enabled, the switch periodically transmits an LLDP advertisement (packet) out each active port
enabled for outbound LLDP transmissions and receives LLDP advertisements on each active port enabled to
receive LLDP traffic (Configuring per-port transmit and receive modes (CLI) on page 179). Per-port
configuration options include four modes:

• Transmit and receive (tx_rx): This is the default setting on all ports. It enables a given port to both transmit
and receive LLDP packets and to store the data from received (inbound) LLDP packets in the switch's MIB.

• Transmit only (txonly): This setting enables a port to transmit LLDP packets that can be read by LLDP
neighbors. However, the port drops inbound LLDP packets from LLDP neighbors without reading them. This
prevents the switch from learning about LLDP neighbors on that port.

• Receive only (rxonly): This setting enables a port to receive and read LLDP packets from LLDP neighbors
and to store the packet data in the switch's MIB. However, the port does not transmit outbound LLDP packets.
This prevents LLDP neighbors from learning about the switch through that port.

• Disable (disable): This setting disables LLDP packet transmissions and reception on a port. In this state, the
switch does not use the port for either learning about LLDP neighbors or informing LLDP neighbors of its
presence.

SNMP notification
You can enable the switch to send a notification to any configured SNMP trap receiver(s) when the switch detects
a remote LLDP data change on an LLDP-enabled port (Configuring SNMP notification support on page 179).

Per-port (outbound) data options
The following table lists the information the switch can include in the per-port, outbound LLDP packets it
generates. In the default configuration, all outbound LLDP packets include this information in the TLVs transmitted
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to neighbor devices. However, you can configure LLDP advertisements on a per-port basis to omit some of this
information (Configuring a remote management address for outbound LLDP advertisements (CLI) on page
180).

Table 20: Data available for basic LLDP advertisements

Data type Configuration options Default Description

Time-to-Live 1 120 Seconds The length of time an
LLDP neighbor retains the
advertised data before
discarding it.

Chassis Type2, N/A Always Enabled Indicates the type of
identifier used for Chassis
ID.

Chassis ID33 N/A Always Enabled Uses base MAC address
of the switch.

Port Type4,33 N/A Always Enabled Uses "Local," meaning
assigned locally by LLDP.

Port Id33 N/A Always Enabled Uses port number of the
physical port. This is an
internal number reflecting
the reserved slot/port
position in the chassis. For
more information on this
numbering scheme, see
the appendix "MAC
Address Management".

Remote Management Address

Type3,3 N/A Always Enabled Shows the network
address type.

Address55 Default or Configured Uses a default address selection method unless an
optional address is configured. See Remote
management address on page 173.

System Name33 Enable/Disable Enabled Uses the switch's
assigned name.

System Description33 Enable/Disable Enabled Includes switch model
name and running
software version, and
ROM version.

Port Description33 Enable/Disable Enabled Uses the physical port
identifier.

Table Continued
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Data type Configuration options Default Description

System capabilities
supported3,3

Enable/Disable Enabled Identifies the switch's
primary capabilities
(bridge, router).

System capabilities
enabled3,66 3

Enable/Disable Enabled Identifies the primary
switch functions that are
enabled, such as routing.

1 The Packet Time-to-Live value is included in LLDP data packets.
2 Subelement of the Chassis ID TLV.
3 Populated with data captured internally by the switch. For more on these data types, refer to the IEEE P802.1AB Standard.
4 Subelement of the Port ID TLV.
5 Subelement of the Remote-Management-Address TLV.
6 Subelement of the System Capability TLV.

Remote management address
The switch always includes an IP address in its LLDP advertisements. This can be either an address selected by
a default process or an address configured for inclusion in advertisements. See IP address advertisements on
page 174.

Debug logging
You can enable LLDP debug logging to a configured debug destination (Syslog server, a terminal device, or both)
by executing the debug lldp command. (For more information on Debug and Syslog, see the "Troubleshooting"
appendix in this guide.) Note that the switch's Event Log does not record usual LLDP update messages.

Options for reading LLDP information collected by the switch
You can extract LLDP information from the switch to identify adjacent LLDP devices. Options include:

• Using the switch's show lldp info command options to display data collected on adjacent LLDP devices—
as well as the local data the switch is transmitting to adjacent LLDP devices (Displaying the global LLDP,
port admin, and SNMP notification status (CLI) on page 174).

• Using an SNMP application that is designed to query the Neighbors MIB for LLDP data to use in device
discovery and topology mapping.

• Using thewalkmib command to display a listing of the LLDP MIB objects

LLDP and LLDP-MED standards compatibility
The operation covered by this section is compatible with these standards:

• IEEE P802.1AB

• RFC 2922 (PTOPO, or Physical Topology MIB)

• RFC 2737 (Entity MIB)

• RFC 2863 (Interfaces MIB)

• ANSI/TIA-1057/D6 (LLDP-MED; refer to LLDP-MED (media-endpoint-discovery) on page 185.)
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LLDP operating rules
For additional information specific to LLDP-MED operation, see LLDP-MED (media-endpoint-discovery) on
page 185.

Port trunking
LLDP manages trunked ports individually. That is, trunked ports are configured individually for LLDP operation, in
the same manner as non-trunked ports. Also, LLDP sends separate advertisements on each port in a trunk, and
not on a per-trunk basis. Similarly, LLDP data received through trunked ports is stored individually, per-port.

IP address advertisements
In the default operation, if a port belongs to only one static VLAN, the port advertises the lowest-order IP address
configured on that VLAN. If a port belongs to multiple VLANs, the port advertises the lowest-order IP address
configured on the VLAN with the lowest VID. If the qualifying VLAN does not have an IP address, the port
advertises 127.0.0.1 as its IP address. For example, if the port is a member of the default VLAN (VID=1), and
there is an IP address configured for the default VLAN, the port advertises this IP address. In the default
operation, the IP address that LLDP uses can be an address acquired by DHCP or Bootp.

You can override the default operation by configuring the port to advertise any IP address that is manually
configured on the switch, even if the port does not belong to the VLAN configured with the selected IP address
(Configuring a remote management address for outbound LLDP advertisements (CLI) on page 180). (Note
that LLDP cannot be configured through the CLI to advertise an addresses acquired through DHCP or Bootp.
However, as mentioned above, in the default LLDP configuration, if the lowest-order IP address on the VLAN with
the lowest VID for a given port is a DHCP or Bootp address, the switch includes this address in its LLDP
advertisements unless another address is configured for advertisements on that port.) Also, although LLDP allows
configuring multiple remote management addresses on a port, only the lowest-order address configured on the
port will be included in outbound advertisements. Attempting to use the CLI to configure LLDP with an IP address
that is either not configured on a VLAN or has been acquired by DHCP or Bootp results in the following error
message.

xxx.xxx.xxx.xxx: This IP address is not configured or is a DHCP address.

Spanning-tree blocking
Spanning tree does not prevent LLDP packet transmission or receipt on STP-blocked links.

802.1X blocking
Ports blocked by 802.1X operation do not allow transmission or receipt of LLDP packets.

Configuring LLDP operation

Displaying the global LLDP, port admin, and SNMP notification status (CLI)
In the default configuration, LLDP is enabled and in both transmit and receive mode on all active ports. The LLDP
configuration includes global settings that apply to all active ports on the switch, and per-port settings that affect
only the operation of the specified ports.

The commands in this section affect both LLDP and LLDP-MED operation. for information on operation and
configuration unique to LLDP-MED, refer to “LLDP-MED (Media-Endpoint-Discovery)”.

Syntax:

show lldp config

174 Aruba 2530 Management and Configuration Guide for ArubaOS-Switch 16.05

Anexo 04 ITEM 11 (0592666)         SEI 0008478-63.2018.6.02.8000 / pg. 5998



Displays the LLDP global configuration, LLDP port status, and SNMP notification status. For information on port
admin status, see Configuring per-port transmit and receive modes (CLI) on page 179.

show lldp config produces the following display when the switch is in the default LLDP configuration:

Viewing the general LLDP configuration

switch(config)# show lldp config

 LLDP Global Configuration

  LLDP Enabled [Yes] : Yes
  LLDP Transmit Interval     [30] : 30
  LLDP Hold time Multiplier   [4] : 4
  LLDP Delay Interval         [2] : 2
  LLDP Reinit Interval        [2] : 2
  LLDP Notification Interval  [5] : 5
  LLDP Fast Start Count       [5] : 5

 LLDP Port Configuration

  Port | AdminStatus NotificationEnabled  Med Topology Trap Enabled
  ---- + ----------- -------------------  -------------------------
  A1   | Tx_Rx       False                False
  A2   | Tx_Rx       False                False
  A3   | Tx_Rx       False                False
  A4   | Tx_Rx       False                False
  A5   | Tx_Rx       False                False
  A6   | Tx_Rx       False                False
  A7   | Tx_Rx       False                False
  A8   | Tx_Rx       False                False

The values displayed in the LLDP column correspond to the lldp refresh-interval command

Viewing port configuration details (CLI)
Syntax:

show lldp config <port-list>
Displays the LLDP port-specific configuration for all ports in <port-list>, including which optional TLVs and any
non-default IP address that are included in the port's outbound advertisements.
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For information on the notification setting, see Configuring SNMP notification support on page 179. For
information on the other configurable settings displayed by this command, see Configuring per-port transmit
and receive modes (CLI) on page 179.

Figure 34: Per-port configuration display

Configuring Global LLDP Packet Controls
The commands in this section configure the aspects of LLDP operation that apply the same to all ports in the
switch.

LLDP operation on the switch
Enabling LLDP operation (the default) causes the switch to:

• Use active, LLDP-enabled ports to transmit LLDP packets describing itself to neighbor devices.

• Add entries to its neighbors table based on data read from incoming LLDP advertisements.

Enabling or disabling LLDP operation on the switch (CLI)
For more information, see LLDP operation on the switch on page 176.

Syntax:

[no] lldp run
Enables or disables LLDP operation on the switch.

The no form of the command, regardless of individual LLDP port configurations, prevents the switch from
transmitting outbound LLDP advertisements and causes the switch to drop all LLDP advertisements received
from other devices.

The switch preserves the current LLDP configuration when LLDP is disabled. After LLDP is disabled, the
information in the LLDP neighbors database remains until it times-out.

(Default: Enabled)

176 Aruba 2530 Management and Configuration Guide for ArubaOS-Switch 16.05

Anexo 04 ITEM 11 (0592666)         SEI 0008478-63.2018.6.02.8000 / pg. 6000



Disabling LLDP

switch(config)# no lldp run

Changing the packet transmission interval (CLI)
This interval controls how often active ports retransmit advertisements to their neighbors.

Syntax:

lldp refresh-interval <5-32768>
Changes the interval between consecutive transmissions of LLDP advertisements on any given port.

(Default: 30 seconds)

The refresh-interval must be greater than or equal to (4 x delay-interval). (The default
delay-interval is 2). For example, with the default delay-interval, the lowest refresh-
interval you can use is 8 seconds (4 x 2=8). Thus, if you want a refresh-interval of 5
seconds, you must first change the delay interval to 1 (that is, 4 x 1 5). If you want to change the
delay-interval, use the setmib command.

Time-to-Live for transmitted advertisements
The Time-to-Live value (in seconds) for all LLDP advertisements transmitted from a switch is controlled by the
switch that generates the advertisement and determines how long an LLDP neighbor retains the advertised data
before discarding it. The Time-to-Live value is the result of multiplying the refresh-interval by the
holdtime-multiplier.

Changing the time-to-live for transmitted advertisements (CLI)
For more information, see Time-to-Live for transmitted advertisements on page 177.

Syntax:

lldp holdtime-multiplier <2-10>
Changes the multiplier an LLDP switch uses to calculate the Time-to-Live for the LLDP advertisements it
generates and transmits to LLDP neighbors. When the Time-to-Live for a given advertisement expires, the
advertised data is deleted from the neighbor switch's MIB.

(Default: 4; Range 2–10)

Example:

If the refresh-interval on the switch is 15 seconds and the holdtime-multiplier is at the default, the Time-to-
Live for advertisements transmitted from the switch is 60 seconds (4 x 15).

To reduce the Time-to-Live, you could lower the holdtime-interval to 2, which would result in a Time-to-Live
of 30 seconds.

switch(config)# lldp holdtime-multiplier 2

Delay interval between advertisements generated by value or status changes to the
LLDP MIB
The switch uses a delay-interval setting to delay transmitting successive advertisements resulting from these
LLDP MIB changes. If a switch is subject to frequent changes to its LLDP MIB, lengthening this interval can
reduce the frequency of successive advertisements. You can change the delay-interval by using either an SNMP
network management application or the CLI setmib command.
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Changing the delay interval between advertisements generated by value or status changes to
the LLDP MIB (CLI)
Syntax:

setmib lldpTxDelay.0 -i <1-8192>
Uses setmib to change the minimum time (delay-interval) any LLDP port will delay advertising successive LLDP
advertisements because of a change in LLDP MIB content.

(Default: 2; Range 1–8192)

The LLDP refresh-interval (transmit interval) must be greater than or equal to (4 x delay-interval).
The switch does not allow increasing the delay interval to a value that conflicts with this relationship.
That is, the switch displays Inconsistent value if (4 x delay-interval) exceeds the current
transmit interval, and the command fails. Depending on the current refresh-interval setting, it may be
necessary to increase the refresh-interval before using this command to increase the delay-interval.

Example:

To change the delay-interval from 2 seconds to 8 seconds when the refresh-interval is at the default 30 seconds,
you must first set the refresh-interval to a minimum of 32 seconds (32 = 4 x 8). (See Figure 35: Changing the
transmit-delay interval on page 178.)

Figure 35: Changing the transmit-delay interval

Reinitialization delay interval
In the default configuration, a port receiving a disable command followed immediately by a txonly, rxonly, or
tx_rx command delays reinitializing for two seconds, during which LLDP operation remains disabled. If an active
port is subjected to frequent toggling between the LLDP disabled and enabled states, LLDP advertisements are
more frequently transmitted to the neighbor device. Also, the neighbor table in the adjacent device changes more
frequently as it deletes, then replaces LLDP data for the affected port which, in turn, generates SNMP traps (if
trap receivers and SNMP notification are configured). All of this can unnecessarily increase network traffic.
Extending the reinitialization-delay interval delays the ability of the port to reinitialize and generate LLDP traffic
following an LLDP disable/enable cycle.

Changing the reinitialization delay interval (CLI)
Syntax:

setmib lldpReinitDelay.0 -i <1-10>
Uses setmib to change the minimum time (reinitialization delay interval) an LLDP port will wait before
reinitializing after receiving an LLDP disable command followed closely by a txonly or tx_rx command. The delay
interval commences with execution of the lldp admin-status port-list disable command.

(Default: 2 seconds; Range 1–10 seconds)
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Example:

The following command changes the reinitialization delay interval to five seconds:

switch(config)# setmib lldpreinitdelay.0 -i 5

Configuring SNMP notification support
You can enable SNMP trap notification of LLDP data changes detected on advertisements received from neighbor
devices, and control the interval between successive notifications of data changes on the same neighbor.

Enabling LLDP data change notification for SNMP trap receivers (CLI)
Syntax:

[no] lldp enable-notification <port-list>
Enables or disables each port in port-list for sending notification to configured SNMP trap receivers if an LLDP
data change is detected in an advertisement received on the port from an LLDP neighbor.

(Default: Disabled)

For information on configuring trap receivers in the switch, see SNMP notifications on page 152.

Example:

This command enables SNMP notification on ports 1 - 5:

switch(config)# lldp enable-notification 1-5

Changing the minimum interval for successive data change notifications for the same
neighbor
If LLDP trap notification is enabled on a port, a rapid succession of changes in LLDP information received in
advertisements from one or more neighbors can generate a high number of traps. To reduce this effect, you can
globally change the interval between successive notifications of neighbor data change.

Syntax:

setmib lldpnotificationinterval.0 -i <1-3600>
Globally changes the interval between successive traps generated by the switch. If multiple traps are generated in
the specified interval, only the first trap is sent. The remaining traps are suppressed. (A network management
application can periodically check the switch MIB to detect any missed change notification traps. See IEEE
P802.1AB or later for more information.)

(Default: 5 seconds)

Example:

The following command limits change notification traps from a particular switch to one per minute.

switch(config)# setmib lldpnotificationinterval.0 -i 60 lldpNotificationInterval.0=60

Configuring per-port transmit and receive modes (CLI)
Syntax:

lldp admin-status <port-list> {<txonly | rxonly | tx_rx | disable>}
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With LLDP enabled on the switch in the default configuration, each port is configured to transmit and receive
LLDP packets. These options enable you to control which ports participate in LLDP traffic and whether the
participating ports allow LLDP traffic in only one direction or in both directions.

txonly Configures the specified ports to transmit LLDP packets, but block inbound LLDP packets from
neighbor devices.

rxonly Configures the specified ports to receive LLDP packets from neighbors, but block outbound packets
to neighbors.

tx_rx Configures the specified ports to both transmit and receive LLDP packets. (This is the default
setting.)

disable Disables LLDP packet transmit and receive on the specified ports.

Basic LLDP per-port advertisement content
In the default LLDP configuration, outbound advertisements from each port on the switch include both mandatory
and optional data.

Mandatory Data
An active LLDP port on the switch always includes the mandatory data in its outbound advertisements. LLDP
collects the mandatory data, and, except for the Remote Management Address, you cannot use LLDP commands
to configure the actual data.

• Chassis Type (TLV subelement)

• Chassis ID (TLV)

• Port Type (TLV subelement)

• Port ID (TLV)

• Remote Management Address (TLV; actual IP address is a subelement that can be a default address or a
configured address)

Configuring a remote management address for outbound LLDP advertisements (CLI)
This is an optional command you can use to include a specific IP address in the outbound LLDP advertisements
for specific ports. For more information, see Basic LLDP per-port advertisement content on page 180.

Syntax:

[no] lldp config <port-list> ipAddrEnable <ip-address>
Replaces the default IP address for the port with an IP address you specify. This can be any IP address
configured in a static VLAN on the switch, even if the port does not belong to the VLAN configured with the
selected IP address.

The no form of the command deletes the specified IP address.

If there are no IP addresses configured as management addresses, the IP address selection method returns to
the default operation.

Default: The port advertises the IP address of the lowest-numbered VLAN (VID) to which it belongs. If there is no
IP address configured on the VLANs to which the port belongs, and if the port is not configured to advertise an IP
address from any other (static) VLAN on the switch, the port advertises an address of 127.0.0.1.)
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This command does not accept either IP addresses acquired through DHCP or Bootp, or IP
addresses that are not configured in a static VLAN on the switch.

Example:

If port 3 belongs to a subnetted VLAN that includes an IP address of 10.10.10.100 and you want port 3 to use this
secondary address in LLDP advertisements, you need to execute the following command:

switch(config)# lldp config 3 ipAddrEnable 10.10.10.100
Syntax:

[no] lldp config <port-list> basicTlvEnable <TLV-Type>

port_descr For outbound LLDP advertisements, this TLV includes an alphanumeric string describing
the port.(Default: Enabled)

system_name For outbound LLDP advertisements, this TLV includes an alphanumeric string showing the
assigned name of the system.(Default: Enabled)

system_descr For outbound LLDP advertisements, this TLV includes an alphanumeric string describing
the full name and version identification for the hardware type, software version, and
networking application of the system.(Default: Enabled)

system_cap For outbound advertisements, this TLV includes a bitmask of supported system capabilities
(device functions). Also includes information on whether the capabilities are enabled.
(Default: Enabled)

Example:

If you want to exclude the system name TLV from the outbound LLDP advertisements for all ports on a switch,
use this command:

switch(config)# no lldp config 1-24 basicTlvEnable system_name
If you later decide to reinstate the system name TLV on ports 1-5, use this command:

switch(config)# lldp config 1-5 basicTlvEnable system_name

Optional Data
You can configure an individual port or group of ports to exclude one or more of the following data types from
outbound LLDP advertisements.

• Port description (TLV)

• System name (TLV)

• System description (TLV)

• System capabilities (TLV)

◦ System capabilities Supported (TLV subelement)

◦ System capabilities Enabled (TLV subelement)

• Port speed and duplex (TLV subelement)
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Optional data types, when enabled, are populated with data internal to the switch; that is, you cannot use LLDP
commands to configure their actual content.

Support for port speed and duplex advertisements
This feature is optional for LLDP operation, but is required for LLDP-MED operation.

Port speed and duplex advertisements are supported on the switches to inform an LLDP endpoint and the switch
port of each other's port speed and duplex configuration and capabilities. Configuration mismatches between a
switch port and an LLDP endpoint can result in excessive collisions and voice quality degradation. LLDP enables
discovery of such mismatches by supporting SNMP access to the switch MIB for comparing the current switch
port and endpoint settings. (Changing a current device configuration to eliminate a mismatch requires intervention
by the system operator.)

An SNMP network management application can be used to compare the port speed and duplex data configured
in the switch and advertised by the LLDP endpoint. You can also use the CLI to display this information. For more
information on using the CLI to display port speed and duplex information, seeViewing the current port speed
and duplex configuration on a switch port on page 196.

Configuring support for port speed and duplex advertisements (CLI)
For more information, see Support for port speed and duplex advertisements on page 182.

Syntax:

[no] lldp config <port-list> dot3TlvEnable macphy_config
Options
macphy_config

MAC Physical Config TLV

poeplus_config
Power Via MDI Config TLV

eee_config
EEE Config TLV

For outbound advertisements, this TLV includes the (local) switch port's current speed and duplex settings, the
range of speed and duplex settings the port supports, and the method required for reconfiguring the speed and
duplex settings on the device (autonegotiation during link initialization, or manual configuration).

Using SNMP to compare local and remote information can help in locating configuration mismatches.

(Default: Enabled)

For LLDP operation, this TLV is optional. For LLDP-MED operation, this TLV is mandatory.

Port VLAN ID TLV support on LLDP
The port-vlan-id option enables advertisement of the port VLAN ID TLV as part of the regularly advertised
TLVs. This allows discovery of a mismatch in the configured native VLAN ID between LLDP peers. The
information is visible using show commands and is logged to the Syslog server.

Configuring the VLAN ID TLV
This TLV advertisement is enabled by default. To enable or disable the TLV, use this command. For more
information, see Port VLAN ID TLV support on LLDP Port VLAN ID TLV support on LLDP on page 182.
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Syntax:

[no] lldp config <port-list> dot1TlvEnable port-vlan-id
Enables the VLAN ID TLV advertisement.

The no form of the command disables the TLV advertisement.

Default: Enabled.

Options
port-vlan-id

Specifies the 802.1 TLV list to advertise.

vlan-name
Specifies that the VLAN name TLV is to be advertised.

Enabling the VLAN ID TLV

HP Switch(config)# lldp config a1 dot1TlvEnable port-vlan-id

Viewing the TLVs advertised
The show commands display the configuration of the TLVs. The command show lldp config lists the TLVs
advertised for each port, as shown in the following examples.

Displaying the TLVs for a port

switch(config)# show lldp config a1

 LLDP Port Configuration Detail

  Port   : A1
  AdminStatus [Tx_Rx] : Tx_Rx
  NotificationEnabled [False] : False
  Med Topology Trap Enabled [False] : False

  TLVS Advertised:
  * port_descr
  * system_name
  * system_descr
  * system_cap

  * capabilities
  * network_policy
  * location_id
  * poe

  * macphy_config

  * port_vlan_id 1

 IpAddress Advertised:
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  :
  :

1The VLAN ID TLV is being advertised.

Local device LLDP information

switch(config)# show lldp config info local-device a1

 LLDP Port Configuration Information Detail

  Port     : A1
  PortType : local
  PortId   : 1
  PortDesc : A1

  Port VLAN ID : 1 1

1The information that LLDP used in its advertisement.

Remote device LLDP information

switch(config)# show lldp info remote-device a1

LLDP Remote Device Information Detail

  Local Port   : A1
  ChassisType  : mac-address
  ChassisId    : 00 16 35 22 ca 40
  PortType     : local
  PortID       : 1
  SysName      : esp-dback
  System Descr : HP J8693A Switch 3500yl-48G, revision XX.13.03, ROM...
  PortDescr    : A1

  System Capabilities Supported : bridge, router
  System Capabilities Enabled   : bridge, router

  Port VLAN ID : 200

  Remote Management Address
     Type    : ipv4
     Address : 192.168.1.1

SNMP support
The LLDP-EXT-DOT1-MIB has the corresponding MIB variables for the Port VLAN ID TLV. The TLV
advertisement can be enabled or disabled using the MIB object lldpXdot1ConfigPortVlanTxEnable in the
lldpXdot1ConfigPortVlanTable.

The port VLAN ID TLV local information can be obtained from the MIB object lldpXdot1LocPortVlanId in the
local information table lldpXdot1LocTable.

The port VLAN ID TLV information about all the connected peer devices can be obtained from the MIB object
lldpXdot1RemPortVlanId in the remote information table lldpXdot1RemTable.
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LLDP-MED (media-endpoint-discovery)
LLDP-MED (ANSI/TIA-1057/D6) extends the LLDP (IEEE 802.1AB) industry standard to support advanced
features on the network edge for Voice Over IP (VoIP) endpoint devices with specialized capabilities and LLDP-
MED standards-based functionality. LLDP-MED in the switches uses the standard LLDP commands described
earlier in this section, with some extensions, and also introduces new commands unique to LLDP-MED operation.
The show commands described elsewhere in this section are applicable to both LLDP and LLDP-MED operation.
LLDP-MED benefits include:

• Plug-and-play provisioning for MED-capable, VoIP endpoint devices

• Simplified, vendor-independent management enabling different IP telephony systems to interoperate on one
network

• Automatic deployment of convergence network policies (voice VLANs, Layer 2/CoS priority, and Layer 3/QoS
priority)

• Configurable endpoint location data to support the Emergency Call Service (ECS) (such as Enhanced 911
service, 999, 112)

• Detailed VoIP endpoint data inventory readable via SNMP from the switch

• Power over Ethernet (PoE) status and troubleshooting support via SNMP

• support for IP telephony network troubleshooting of call quality issues via SNMP

This section describes how to configure and use LLDP-MED features in the switches to support VoIP network
edge devices (media endpoint devices) such as:

• IP phones

• Voice/media gateways

• Media servers

• IP communications controllers

• Other VoIP devices or servers

Figure 36: Example: of LLDP-MED network elements

LLDP-MED endpoint support
LLDP-MED interoperates with directly connected IP telephony (endpoint) clients having these features and
services:
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• Autonegotiate speed and duplex configuration with the switch

• Use the following network policy elements configured on the client port

◦ Voice VLAN ID

◦ 802.1p (Layer 2) QoS

◦ Diffserv codepoint (DSCP) (Layer 3) QoS

• Discover and advertise device location data learned from the switch

• Support ECS (such as E911, 999, and 112)

• Advertise device information for the device data inventory collected by the switch, including:

◦ Hardware revision

◦ Firmware revision

◦ Software revision

◦ Serial number

◦ Manufacturer name

◦ Model name

Asset ID

• Provide information on network connectivity capabilities (For example, a multi-port VoIP phone with Layer 2
switch capability)

• Support the fast-start capability

LLDP-MED is intended for use with VoIP endpoints and is not designed to support links between
network infrastructure devices, such as switch-to-switch or switch-to-router links.

LLDP-MED endpoint device classes
LLDP-MED endpoint devices are, by definition, located at the network edge and communicate using the LLDP-
MED framework. Any LLDP-MED endpoint device belongs to one of the following three classes:

• Class 1 (generic endpoint devices): These devices offer the basic LLDP discovery services, network policy
advertisement (VLAN ID, Layer 2/802.1p priority, and Layer 3/DSCP priority), and PoE management. This
class includes such devices as IP call controllers and communication-related servers.

• Class 2 (media endpoint devices): These devices offer all Class 1 features plus media-streaming capability,
and include such devices as voice/media gateways, conference bridges, and media servers.

• Class 3 (communication devices): These devices are typically IP phones or end-user devices that otherwise
support IP media and offer all Class 1 and Class 2 features, plus location identification and emergency 911
capability, Layer 2 switch support, and device information management.

LLDP-MED operational support
The switches offer two configurable TLVs supporting MED-specific capabilities:

• medTlvEnable (for per-port enabling or disabling of LLDP-MED operation)

• medPortLocation (for configuring per-port location or emergency call data)
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LLDP-MED operation also requires the port speed and duplex TLV (dot3TlvEnable), which is enabled
in the default configuration.

Topology change notifications provide one method for monitoring system activity. However, because
SNMP normally employs UDP, which does not guarantee datagram delivery, topology change
notification should not be relied upon as the sole method for monitoring critical endpoint device
connectivity.

LLDP-MED fast start control
Syntax:

lldp fast-start-count <1-10>
An LLDP-MED device connecting to a switch port may use the data contained in the MED TLVs from the switch to
configure itself. However, the lldp refresh-interval setting (default: 30 seconds) for transmitting
advertisements can cause an unacceptable delay in MED device configuration.

To support rapid LLDP-MED device configuration, the lldp fast-start-count command temporarily
overrides the refresh-interval setting for the fast-start-count advertisement interval. This results in the
port initially advertising LLDP-MED at a faster rate for a limited time. Thus, when the switch detects a new LLDP-
MED device on a port, it transmits one LLDP-MED advertisement per second out the port for the duration of the
fast-start-count interval. In most cases, the default setting should provide an adequate fast-start-
count interval.

(Default: 5 seconds)

This global command applies only to ports on which a new LLDP-MED device is detected. It does not
override the refresh-interval setting on ports where non-MED devices are detected.

Advertising device capability, network policy, PoE status and location data
The medTlvEnable option on the switch is enabled in the default configuration and supports the following LLDP-
MED TLVs:

• LLDP-MED capabilities: This TLV enables the switch to determine:

◦ Whether a connected endpoint device supports LLDP-MED

◦ Which specific LLDP-MED TLVs the endpoint supports

◦ The device class (1, 2, or 3) for the connected endpoint

This TLV also enables an LLDP-MED endpoint to discover what LLDP-MED TLVs the switch port currently
supports.

• Network policy operating on the port to which the endpoint is connected (VLAN, Layer 2 QoS, Layer 3 QoS)

• PoE (MED Power-over-Ethernet)

• Physical location data (see Configuring location data for LLDP-MED devices on page 190)

LLDP-MED operation requires the macphy_config TLV subelement (enabled by default) that is
optional for IEEE 802.1AB LLDP operation. For more information, see the dot3TlvEnable
macphy_config command (Configuring support for port speed and duplex advertisements
(CLI) on page 182).
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Network policy advertisements
Network policy advertisements are intended for real-time voice and video applications, and include these TLV
subelements:

• Layer 2 (802.1p) QoS

• Layer 3 DSCP (diffserv code point) QoS

• Voice VLAN ID (VID)

VLAN operating rules
These rules affect advertisements of VLANs in network policy TLVs:

• The VLAN ID TLV subelement applies only to a VLAN configured for voice operation (vlan <vid> voice ).

• If there are multiple voice VLANs configured on a port, LLDP-MED advertises the voice VLAN having the
lowest VID.

• The voice VLAN port membership configured on the switch can be tagged or untagged. However, if the LLDP-
MED endpoint expects a tagged membership when the switch port is configured for untagged, or the reverse,
a configuration mismatch results. (Typically, the endpoint expects the switch port to have a tagged voice VLAN
membership.)

• If a given port does not belong to a voice VLAN, the switch does not advertise the VLAN ID TLV through this
port.

Policy elements
These policy elements may be statically configured on the switch or dynamically imposed during an authenticated
session on the switch using a RADIUS server and 802.1X or MAC authentication. (Web authentication does not
apply to VoIP telephones and other telecommunications devices that are not capable of accessing the switch
through a Web browser.) The QoS and voice VLAN policy elements can be statically configured with the following
CLI commands:

vlan <vid> voice
vlan <vid> {<tagged | untagged> <port-list>}
int <port-list> qos priority <0-7>
vlan <vid> qos dscp <codepoint>

A codepoint must have an 802.1p priority before you can configure it for use in prioritizing packets by
VLAN-ID. If a codepoint you want to use shows No Override in the Priority column of the
DSCP policy table (display with show qos-dscp map, then use qos-dscp map <codepoint>
priority <0-7> to configure a priority before proceeding. For more information on this topic, see
the "Quality of Service (QoS): Managing Bandwidth More Effectively" in the advanced traffic
management guide for your switch.

Enabling or Disabling medTlvEnable
In the default LLDP-MED configuration, the TLVs controlled by medTlvEnable are enabled. For more information,
see Advertising device capability, network policy, PoE status and location data on page 187.

Syntax:

[no] lldp config <port-list> medTlvEnable <medTlv>
Enables or disables advertisement of the following TLVs on the specified ports:

188 Aruba 2530 Management and Configuration Guide for ArubaOS-Switch 16.05

Anexo 04 ITEM 11 (0592666)         SEI 0008478-63.2018.6.02.8000 / pg. 6012



• Device capability TLV

• Configured network policy TLV

• Configured location data TLV (see Configuring location data for LLDP-MED devices on page 190.)

• Current PoE status TLV

(Default: All of the above TLVs are enabled.)

Helps to locate configuration mismatches by allowing use of an SNMP application to compare the LLDP-MED
configuration on a port with the LLDP-MED TLVs advertised by a neighbor connected to that port.

capabilities This TLV enables the switch to determine:

• Which LLDP-MED TLVs a connected endpoint can discover

• The device class (1, 2, or 3) for the connected endpoint

This TLV also enables an LLDP-MED endpoint to discover what LLDP-MED TLVs
the switch port currently supports.(Default: enabled)

This TLV cannot be disabled unless the network_policy, poe, and location_id
TLVs are already disabled.

network_policy This TLV enables the switch port to advertise its configured network policies (voice
VLAN, Layer 2 QoS, Layer 3 QoS), and allows LLDP-MED endpoint devices to
autoconfigure the voice network policy advertised by the switch. This also enables
the use of SNMP applications to troubleshoot statically configured endpoint network
policy mismatches.(Default: Enabled)

Network policy is advertised only for ports that are configured as members of the
voice VLAN. If the port belongs to more than one voice VLAN, the voice VLAN with
the lowest-numbered VID is selected as the VLAN for voice traffic. Also, this TLV
cannot be enabled unless the capability TLV is already enabled.

For more information, see Network policy advertisements on page 188.

location_id This TLV enables the switch port to advertise its configured location data (if any). For
more information on configuring location data, see Configuring location data for
LLDP-MED devices on page 190.(Default: Enabled)

When disabled, this TLV cannot be enabled unless the capability TLV is already
enabled.

poe This TLV enables the switch port to advertise its current PoE state and to read the
PoE requirements advertised by the LLDP-MED endpoint device connected to the
port.(Default: Enabled)

When disabled, this TLV cannot be enabled unless the capability TLV is already
enabled.

For more on this topic, see PoE advertisements on page 189.

PoE advertisements
These advertisements inform an LLDP-MED endpoint of the power (PoE) configuration on switch ports. Similar
advertisements from an LLDP-MED endpoint inform the switch of the endpoint's power needs and provide
information that can be used to identify power priority mismatches.
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PoE TLVs include the following power data:

• Power type: indicates whether the device is a power-sourcing entity (PSE) or a PD. Ports on the J8702A PoE
zl module are PSE devices. A MED-capable VoIP telephone is a PD.

• Power source: indicates the source of power in use by the device. Power sources for PDs include PSE, local
(internal), and PSE/local. The switches advertise Unknown.

• Power priority: indicates the power priority configured on the switch (PSE) port or the power priority
configured on the MED-capable endpoint.

• Power value: indicates the total power in watts that a switch port (PSE) can deliver at a particular time, or the
total power in watts that the MED endpoint (PD) requires to operate.

Viewing PoE advertisements
To display the current power data for an LLDP-MED device connected to a port, use the following command:

show lldp info remote-device <port-list>
For more information on this command, see page A-60.

To display the current PoE configuration on the switch, use the following commands:

show power brief <port-list>
show power <port-list>
For more information on PoE configuration and operation, see Power Over Ethernet (PoE/PoE+) Operation.

Location data for LLDP-MED devices
You can configure a switch port to advertise location data for the switch itself, the physical wall-jack location of the
endpoint (recommended), or the location of a DHCP server supporting the switch, endpoint, or both. You also
have the option of configuring these different address types:

• Civic address: physical address data such as city, street number, and building information

• ELIN (Emergency Location Identification Number): an emergency number typically assigned to MLTS
(Multiline Telephone System) Operators in North America

• Coordinate-based location: attitude, longitude, and altitude information (Requires configuration via an SNMP
application.)

Configuring location data for LLDP-MED devices
Syntax:

[no] lldp config <port-list> medPortLocation <Address-Type>
Configures location of emergency call data the switch advertises per port in the location_id TLV. This TLV is
for use by LLDP-MED endpoints employing location-based applications.

The switch allows one medPortLocation entry per port (without regard to type). Configuring a new
medPortLocation entry of any type on a port replaces any previously configured entry on that port.

civic-addr <COUNTRY-STR> <WHAT> <CA-TYPE> <CA-VALUE> … [< CA-TYPE > < CA-VALUE >] … [< CA-TYPE > < CA-VALUE >]

Enables configuration of a physical address on a switch port and allows up to 75 characters of address
information.
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COUNTRY-STR A two-character country code, as defined by ISO 3166. Some examples include FR
(France), DE (Germany), and IN (India). This field is required in a civic-addr
command. (For a complete list of country codes, visit http://www.iso.org.)

WHAT A single-digit number specifying the type of device to which the location data
applies:

0: Location of DHCP server

1: Location of switch

2: Location of LLDP-MED endpoint (recommended application)

This field is required in a civic-addr command.

Table Continued
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Type/Value Pairs
(CA-TYPE and CA-
VALUE)

A series of data pairs, each composed of a location data "type" specifier and the
corresponding location data for that type. That is, the first value in a pair is expected
to be the civic address "type" number ( CA-TYPE), and the second value in a pair is
expected to be the corresponding civic address data ( CA-VALUE).

For example, if the CA-TYPE for "city name" is "3," the type/value pair to define the
city of Paris is "3 Paris."

Multiple type/value pairs can be entered in any order, although Hewlett Packard
Enterprise recommends that multiple pairs be entered in ascending order of the CA-
TYPE.

When an emergency call is placed from a properly configured class 3 endpoint
device to an appropriate PSAP, the country code, device type, and type/value pairs
configured on the switch port are included in the transmission. The "type" specifiers
are used by the PSAP to identify and organize the location data components in an
understandable format for response personnel to interpret.

A civic-addr command requires a minimum of one type/value pair, but typically
includes multiple type/value pairs as needed to configure a complete set of data
describing a given location.

CA-TYPE: This is the first entry in a type/value pair and is a number defining the
type of data contained in the second entry in the type/value pair ( CA-VALUE).
Some examples of CA-TYPE specifiers include:

• 3=city

• 6=street (name)

• 25=building name

(Range: 0 - 255)For a sample listing of CA-TYPE specifiers, see Some location
codes used in CA-TYPE fields.

CA-VALUE:This is the second entry in a type/value pair and is an alphanumeric
string containing the location information corresponding to the immediately
preceding CA-TYPE entry.

Strings are delimited by either blank spaces, single quotes (' … '), or double quotes
("… ").

Each string should represent a specific data type in a set of unique type/value pairs
comprising the description of a location, and each string must be preceded by a CA-
TYPE number identifying the type of data in the string.

A switch port allows one instance of any given CA-TYPE. For example, if a type/
value pair of 6 Atlantic (to specify "Atlantic" as a street name) is configured on port
A5 and later another type/value pair of 6 Pacific is configured on the same port,
Pacific replaces Atlantic in the civic address location configured for port A5.

elin-addr
<emergency-number>

This feature is intended for use in ECS applications to support class 3 LLDP-MED
VoIP telephones connected to a switch in an MLTS infrastructure.

An ELIN is a valid NANP format telephone number assigned to MLTS operators in
North America by the appropriate authority. The ELIN is used to route emergency
(E911) calls to a PSAP.

(Range: 1-15 numeric characters)
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Configuring coordinate-based locations
Latitude, longitude, and altitude data can be configured per switch port using an SNMP management application.
For more information, see the documentation provided with the application. A further source of information on this
topic is RFC 3825-Dynamic host configuration protocol option for coordinate-based location configuration
information.

Endpoint use of data from a medPortLocation TLV sent by the switch is device-dependent. See the
documentation provided with the endpoint device.

Table 21: Some location codes used in CA-TYPE fields

Location element Code1 Location element Code

national subdivision 1 street number 19

regional subdivision 2 additional location data 22

city or township 3 unit or apartment 26

city subdivision 4 floor 27

street 6 room number 28

street suffix 18

1 The code assignments in this table are examples from a work-in-progress (the internet draft titled "Dynamic Host Configuration
Protocol (DHCPv4 and DHCPv6) Option for Civic Addresses Configuration Information draft-ietf-geopriv-dhcp-civil-06" dated
May 30, 2005.) For the actual codes to use, contact the PSAP or other authority responsible for specifying the civic addressing
data standard for your network.

Example:

Suppose a system operator wants to configure the following information as the civic address for a telephone
connected to her company's network through port A2 of a switch at the following location:

CA-type CA-type CA-VALUE

national subdivision 1 CA

city 3 Widgitville

street 6 Main

street number 19 1433

unit 26 Suite 4-N

floor 27 4

room number 28 N4-3

The following example shows the commands for configuring and displaying the above data.
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A civic address configuration

switch(config)# lldp config 2 medportlocation civic-addr US 2 1 CA 3
Widgitville 6 Main 19 1433 26 Suite_4—N 27 4 28 N4—3

switch(config)# show lldp config 2
 LLDP Port Configuration Detail
  Port : A2
  AdminStatus [Tx_Rx] : Tx_Rx
  NotificationEnabled [False] : False
  Med Topology Trap Enabled [False] : False
  Country Name          : US 
  What                  : 2
  Ca-Type               : 1
  Ca-Length             : 2
  Ca-Value              : CA 
  Ca-Type               : 3
  Ca-Length             : 11
  Ca-Value              : Widgitville
  Ca-Type               : 6
  Ca-Length             : 4
  Ca-Value              : Main
  Ca-Type               : 19
  Ca-Length             : 4
  Ca-Value              : 1433
  Ca-Type               : 26
  Ca-Length             : 9
  Ca-Value              : Suite_4-N 
  Ca-Type               : 27
  Ca-Length             : 1
  Ca-Value              : 4
  Ca-Type               : 28
  Ca-Length             : 4
  Ca-Value              : N4-3

Viewing switch information available for outbound advertisements
Syntax:

show lldp info local-device [port-list]
Without the [port-list] option, displays the global switch information and the per-port information currently
available for populating outbound LLDP advertisements.

With the [port-list] option, displays only the following port-specific information that is currently available for
outbound LLDP advertisements on the specified ports:

• PortType
• PortId
• PortDesc

This command displays the information available on the switch. Use the lldp config <port-
list> command to change the selection of information that is included in actual outbound
advertisements. In the default LLDP configuration, all information displayed by this command is
transmitted in outbound advertisements.
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In the default configuration, the switch information currently available for outbound LLDP advertisements appears
similar to the display in the following example.

Displaying the global and per-port information available for outbound advertisements

switch(config)# show lldp info local-device

 LLDP Local Device Information

  Chassis Type : mac-address
  Chassis Id : 00 23 47 4b 68 DD
  System Name : HP Switch1
  System Description : HP J9091A Switch 3500yl, revision XX.15.06...
  System Capabilities Supported:bridge
  System Capabilities Enabled:bridge

  Management Address 1
     Type:ipv4
     Address:

  LLDP Port Information

   Port  | PortType  PortId  PortDesc
   ----- + --------- ------- ---------
   1     | local     1       1
   2     | local     2       2
   3     | local     3       3
   4     | local     4       4
   5     | local     5       5

1

The Management Address field displays only the LLDP-configurable IP addresses on the switch. (Only manually-
configured IP addresses are LLDP-configurable.) If the switch has only an IP address from a DHCP or Bootp
server, then the Management Address field is empty (because there are no LLDP-configurable IP addresses
available.

The default per-port information content for ports 1 and 2

switch(config)# show lldp info local 1-2

  LLDP Local Port Information Detail

   Port     : 1
   PortType : local
   PortId   : 1
   PortDesc : 1

---------------------------------------- 
   Port     : 2
   PortType : local
   PortId   : 2
   PortDesc : 2

Displaying the current port speed and duplex configuration on a switch port
You can compare port speed and duplex information for a switch port and a connected LLDP-MED endpoint for
configuration mismatches by using an SNMP application. You can also use the switch CLI to display this
information, if necessary. The show interfaces brief <port-list> and show lldp info remote-
device [port-list] commands provide methods for displaying speed and duplex information for switch
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ports. For information on displaying the currently configured port speed and duplex on an LLDP-MED endpoint,
see Viewing the current port speed and duplex configuration on a switch port on page 196.

Viewing the current port speed and duplex configuration on a switch port
Syntax:

show interfaces brief <port-list>
Includes port speed and duplex configuration in the Mode column of the resulting display.

Viewing advertisements currently in the neighbors MIB
Syntax:

show lldp info remote-device [port-list]
Without the [port-list] option, provides a global list of the individual devices it has detected by reading LLDP
advertisements. Discovered devices are listed by the inbound port on which they were discovered.

Multiple devices listed for a single port indicates that such devices are connected to the switch through a hub.

Discovering the same device on multiple ports indicates that the remote device may be connected to the
switch in one of the following ways:

• Through different VLANS using separate links. (This applies to switches that use the same MAC address for
all configured VLANs.)

• Through different links in the same trunk.

• Through different links using the same VLAN. (In this case, spanning-tree should be invoked to prevent a
network topology loop. Note that LLDP packets travel on links that spanning-tree blocks for other traffic types.)

With the [port-list] option, provides a listing of the LLDP data that the switch has detected in advertisements
received on the specified ports.

For descriptions of the various types of information displayed by these commands, see Data available for basic
LLDP advertisements.

A global listing of discovered devices

switch(config)# show lldp info remote

 LLDP Remote Devices Information

  LocalPort | ChassisId                 PortId PortDescr SysName
  --------- + ------------------------- ------ --------- -------------
  1         | 00 11 85 35 3b 80         6      6         HP Switch
  2         | 00 11 85 cf 66 60         8      8         HP Switch

An LLLDP-MED listing of an advertisement received from an LLDP-MED (VoIP telephone) source

switch(config)# show lldp info remote-device 1

 LLDP Remote Device Information Detail

  Local Port   : A2
  ChassisType  : network-address
  ChassisId    : 0f ff 7a 5c
  PortType     : mac-address
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  PortId       : 08 00 0f 14 de f2
  SysName      : HP Switch
  System Descr : HP Switch, revision xx.15.06.0000x
  PortDescr    : LAN Port

  System Capabilities Supported : bridge, telephone
  System Capabilities Enabled   : bridge, telephone

  Remote Management Address

  MED Information Detail 1
    EndpointClass          :Class3
    Media Policy Vlan id   :10
    Media Policy Priority  :7
    Media Policy Dscp      :44
    Media Policy Tagged    :False
    Poe Device Type        :PD
    Power Requested        :47
    Power Source           :Unknown
    Power Priority         :High

1Indicates the policy configured on the telephone. A configuration mismatch occurs if the supporting port is
configured differently.

Displaying LLDP statistics
LLDP statistics are available on both a global and a per-port levels. Rebooting the switch resets the LLDP
statistics counters to zero. Disabling the transmit and/or receive capability on a port "freezes" the related port
counters at their current values.

Viewing LLDP statistics
For more information, see Displaying LLDP statistics on page 197.

Syntax:

show lldp stats [port-list]
The global LLDP statistics command displays an overview of neighbor detection activity on the switch, plus data
on the number of frames sent, received, and discarded per-port.

The per-port LLDP statistics command enhances the list of per-port statistics provided by the global statistics
command with some additional per-port LLDP statistics.

Global LLDP Counters:

Neighbor Entries List Last
Updated

The elapsed time since a neighbor was last added or deleted.

New Neighbor Entries Count The total of new LLDP neighbors detected since the last switch reboot.
Disconnecting, and then reconnecting a neighbor increments this
counter.

Table Continued
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Neighbor Entries Deleted
Count

The number of neighbor deletions from the MIB for AgeOut Count and
forced drops for all ports.For example, if the admin status for port on a
neighbor device changes from tx_rx or txonly to disabled or
rxonly, the neighbor device sends a "shutdown" packet out the port
and ceases transmitting LLDP frames out that port.The device receiving
the shutdown packet deletes all information about the neighbor received
on the applicable inbound port and increments the counter.

Neighbor Entries Dropped
Count

The number of valid LLDP neighbors the switch detected, but could not
add.This can occur, For example, when a new neighbor is detected when
the switch is already supporting the maximum number of neighbors. See 
Neighbor maximum on page 199.

Neighbor Entries AgeOut
Count

The number of LLDP neighbors dropped on all ports because of Time-to-
Live expiring.

Per-Port LLDP Counters:

NumFramesRecvd The total number of valid, inbound LLDP advertisements received from
any neighbors on port-list .Where multiple neighbors are connected
to a port through a hub, this value is the total number of LLDP
advertisements received from all sources.

NumFramesSent The total number of LLDP advertisements sent from port-list.

NumFramesDiscarded The total number of inbound LLDP advertisements discarded by port-
list.This can occur, For example, when a new neighbor is detected on the
port, but the switch is already supporting the maximum number of
neighbors. See Neighbor maximum on page 199. This can also be an
indication of advertisement formatting problems in the neighbor device.

Frames Invalid The total number of invalid LLDP advertisements received on the port.An
invalid advertisement can be caused by header formatting problems in
the neighbor device.

TLVs Unrecognized The total number of LLDP TLVs received on a port with a type value in
the reserved range.This can be caused by a basic management TLV
from a later LLDP version than the one currently running on the switch.

TLVs Discarded The total number of LLDP TLVs discarded for any reason. In this case,
the advertisement carrying the TLV may be accepted, but the individual
TLV is not usable.

Neighbor Ageouts The number of LLDP neighbors dropped on the port because of Time-to-
Live expiring.

Examples:

A global LLDP statistics display

switch(config)# show lldp stats

 LLDP Device Statistics

  Neighbor Entries List Last Updated : 2 hours
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  New Neighbor Entries Count : 20
  Neighbor Entries Deleted Count : 20
  Neighbor Entries Dropped Count : 0
  Neighbor Entries AgeOut Count : 20

 LLDP Port Statistics
 
  Port   | NumFramesRecvd NumFramesSent NumFramesDiscarded
  ------ + -------------- ------------- ------------------ 
  A1     | 97317          97843         0
  A2     | 21             12            0
  A3     | 0              0             0
  A4     | 446            252           0
  A5     | 0              0             0
  A6     | 0              0             0
  A7     | 0              0             0
  A8     | 0              0             0

A per-port LLDP statistics display

switch(config)# show lldp stats 1

 LLDP Port Statistics Detail

  PortName : 1
  Frames Discarded  : 0
  Frames Invalid    : 0
  Frames Received   : 7309
  Frames Sent       : 7231
  TLVs Unrecognized : 0
  TLVs Discarded    : 0
  Neighbor Ageouts  : 0

LLDP Operating Notes

Neighbor maximum
The neighbors table in the switch supports as many neighbors as there are ports on the switch. The switch can
support multiple neighbors connected through a hub on a given port, but if the switch neighbor maximum is
reached, advertisements from additional neighbors on the same or other ports will not be stored in the neighbors
table unless some existing neighbors time-out or are removed.

LLDP packet forwarding
An 802.1D-compliant switch does not forward LLDP packets, regardless of whether LLDP is globally enabled or
disabled on the switch.

One IP address advertisement per port
LLDP advertises only one IP address per port, even if multiple IP addresses are configured by lldp config
port-list ipAddrEnable on a given port.

802.1Q VLAN Information
LLDP packets do not include 802.1Q header information and are always handled as untagged packets.

Effect of 802.1X Operation
If 802.1X port security is enabled on a port, and a connected device is not authorized, LLDP packets are not
transmitted or received on that port. Any neighbor data stored in the neighbor MIB for that port prior to the
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unauthorized device connection remains in the MIB until it ages out. If an unauthorized device later becomes
authorized, LLDP transmit and receive operation resumes.

Neighbor data can remain in the neighbor database after the neighbor is disconnected
After disconnecting a neighbor LLDP device from the switch, the neighbor can continue to appear in the switch's
neighbor database for an extended period if the neighbor's holdtime-multiplier is high; especially if the
refresh-interval is large. See Changing the time-to-live for transmitted advertisements (CLI) on page
177.

Mandatory TLVs
All mandatory TLVs required for LLDP operation are also mandatory for LLDP-MED operation.

LLDP and CDP data management
This section describes points to note regarding LLDP and CDP (Cisco Discovery Protocol) data received by the
switch from other devices. LLDP operation includes both transmitting LLDP packets to neighbor devices and
reading LLDP packets received from neighbor devices. CDP operation is limited to reading incoming CDP
packets from neighbor devices. (HPE switches do not generate CDP packets.)

Incoming CDP and LLDP packets tagged for VLAN 1 are processed even if VLAN 1 does not contain any ports.
VLAN 1 must be present, but it is typically present as the default VLAN for the switch.

The switch may pick up CDP and LLDP multicast packets from VLAN 1 even when CDP- and /or
LLDP-enabled ports are not members of VLAN 1.

LLDP and CDP neighbor data
With both LLDP and (read-only) CDP enabled on a switch port, the port can read both LLDP and CDP
advertisements, and stores the data from both types of advertisements in its neighbor database. (The switch
stores only CDP data that has a corresponding field in the LLDP neighbor database.) The neighbor database
itself can be read by either LLDP or CDP methods or by using the show lldp commands. Take note of the
following rules and conditions:

• If the switch receives both LLDP and CDP advertisements on the same port from the same neighbor, the
switch stores this information as two separate entries if the advertisements have different chassis ID and port
ID information.

• If the chassis and port ID information are the same, the switch stores this information as a single entry. That is,
LLDP data overwrites the corresponding CDP data in the neighbor database if the chassis and port ID
information in the LLDP and CDP advertisements received from the same device is the same.

• Data read from a CDP packet does not support some LLDP fields, such as "System Descr,"
"SystemCapSupported," and "ChassisType." For such fields, LLDP assigns relevant default values. Also:

◦ The LLDP "System Descr" field maps to CDP's "Version" and "Platform" fields.

◦ The switch assigns "ChassisType" and "PortType" fields as "local" for both the LLDP and the CDP
advertisements it receives.

◦ Both LLDP and CDP support the "System Capability" TLV. However, LLDP differentiates between what a
device is capable of supporting and what it is actually supporting, and separates the two types of
information into subelements of the System Capability TLV. CDP has only a single field for this data. Thus,
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when CDP System Capability data is mapped to LLDP, the same value appears in both LLDP System
Capability fields.

◦ System Name and Port Descr are not communicated by CDP, and thus are not included in the switch's
Neighbors database.

Because HPE switches do not generate CDP packets, they are not represented in the CDP data
collected by any neighbor devices running CDP.

A switch with CDP disabled forwards the CDP packets it receives from other devices, but does not
store the CDP information from these packets in its own MIB.

LLDP data transmission/collection and CDP data collection are both enabled in the switch's default configuration.
In this state, an SNMP network management application designed to discover devices running either CDP or
LLDP can retrieve neighbor information from the switch regardless of whether LLDP or CDP is used to collect the
device-specific information.

Protocol state Packet generation Inbound data
management

Inbound packet
forwarding

CDP Enabled N/A Store inbound CDP data. No forwarding of inbound
CDP packets.

CDP Disabled N/A No storage of CDP data
from neighbor devices.

Floods inbound CDP
packets from connected
devices to outbound ports.

LLDP Enabled1 Generates and
transmits LLDP
packets out all ports
on the switch.

Store inbound LLDP data. No forwarding of inbound
LLDP packets.

LLDP Disabled No packet
generation.

No storage of LLDP data
from neighbor devices.

No forwarding of inbound
LLDP packets.

CDP operation and commands
By default the switches have CDP enabled on each port. This is a read-only capability, meaning that the switch
can receive and store information about adjacent CDP devices but does not generate CDP packets.

When a CDP-enabled switch receives a CDP packet from another CDP device, it enters that device's data in the
CDP Neighbors table, along with the port number where the data was received—and does not forward the packet.
The switch also periodically purges the table of any entries that have expired. (The hold time for any data entry in
the switch's CDP Neighbors table is configured in the device transmitting the CDP packet and cannot be
controlled in the switch receiving the packet.) A switch reviews the list of CDP neighbor entries every three
seconds and purges any expired entries.

For details on how to use an SNMP utility to retrieve information from the switch's CDP Neighbors
table maintained in the switch's MIB, see the documentation provided with the particular SNMP utility.

Viewing the current CDP configuration of the switch
CDP is shown as enabled/disabled both globally on the switch and on a per-port basis.
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Syntax:

show cdp
Lists the global and per-port CDP configuration of the switch.

The following example shows the default CDP configuration.

Default CDP configuration

switch(config)# show cdp

 Global CDP information

  Enable CDP [Yes] : Yes (Receive Only)

  Port CDP
  ---- --------
  1    enabled
  2    enabled
  3    enabled
  .      .
  .      .
  .      .

Viewing the current CDP neighbors table of the switch
Devices are listed by the port on which they were detected.

Syntax:

show cdp neighbors
Lists the neighboring CDP devices the switch detects, with a subset of the information collected from the device's
CDP packet.

[[e] port-numb [detail]]
Lists the CDP device connected to the specified port. (Allows
only one port at a time.)Using detail provides a longer list of
details on the CDP device the switch detects on the specified
port.

[detail [[e] port-numb]]
Provides a list of the details for all of the CDP devices the
switch detects.Using port-num produces a list of details for
the selected port.

The following example displays the CDP devices that the switch has detected by receiving their CDP packets.

CDP neighbors table listing

switch(config)# show cdp neighbors

 CDP neighbors information

  Port Device ID                     | Platform                     Capability
  ---- ----------------------------- + ---------------------------- -----------
  1    Accounting (0030c1-7fcc40)    | J4812A HP Switch. . .        S
  2    Resear¢1-1 (0060b0-889e43)    | J4121A HP Switch. . .        S
  4    Support (0060b0_761a45)       | J4121A HP Switch. . .        S
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  7    Marketing (0030c5_33dc59)     | J4313A HP Switch. . .        S
  12   Mgmt NIC(099a05-09df9b        | NIC Model X666               H
  12   Mgmt NIC(099a05-09df11        | NIC Model X666               H

Enabling and Disabling CDP Operation
Enabling CDP operation (the default) on the switch causes the switch to add entries to its CDP Neighbors table
for any CDP packets it receives from other neighboring CDP devices.

Disabling CDP operation clears the switch's CDP Neighbors table and causes the switch to drop inbound CDP
packets from other devices without entering the data in the CDP Neighbors table.

Syntax:

[no] cdp run
Enables or disables CDP read-only operation on the switch.

(Default: Enabled)

Example:

To disable CDP read-only on the switch:

switch(config)# no cdp run
When CDP is disabled:

• show cdp neighbors
displays an empty CDP Neighbors table

• show cdp
displaysGlobal CDP informationEnable CDP [Yes]: No

Enabling or disabling CDP operation on individual ports
In the factory-default configuration, the switch has all ports enabled to receive CDP packets. Disabling CDP on a
port causes it to drop inbound CDP packets without recording their data in the CDP Neighbors table.

Syntax:

[no] cdp enable {< [e] port-list >}
Example:

To disable CDP on port A1:

switch(config)# no cdp enable a1

Filtering CDP information
In some environments it is desirable to be able to configure a switch to handle CDP packets by filtering out the
MAC address learns from untagged VLAN traffic from IP phones. This means that normal protocol processing
occurs for the packets, but the addresses associated with these packets is not learned or reported by the software
address management components. This enhancement also filters out the MAC address learns from LLDP and
802.1x EAPOL packets on untagged VLANs.

The feature is configured per-port.
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Configuring the switch to filter untagged traffic
Enter this command to configure the switch not to learn CDP, LLDP, or EAPOL traffic for a set of interfaces.

Syntax:

[no] ignore-untagged-mac <port-list>
Prevents MAC addresses from being learned on the specified ports when the VLAN is untagged and the
destination MAC address is one of the following:

• 01000C-CCCCCC (CDP)

• 0180c2- 00000e (LLDP)

• 0180c2-000003 (EAPOL)

Configuring the switch to ignore packet MAC address learns for an untagged VLAN

switch(config) ignore-untagged-mac 1-2

Displaying the configuration
Enter the show running-config command to display information about the configuration.

Configuration showing interfaces to ignore packet MAC address learns

switch(config) show running-config

Running configuration:

; J9627 Configuration Editor; Created on release XX.15.XX
; Ver #03:03.1f.ef:f0

hostname “HP Switch”
interface 1
   ignore-untagged-mac
   exit
interface 2
   ignore-untagged-mac
   exit
.
.
.
vlan 1
   name “DEFAULT_VLAN”
   untagged 1-24
   ip address dhcp-bootp
   exit
.
.
.

Filtering PVID mismatch log messages
This enhancement filters out PVID mismatch log messages on a per-port basis. PVID mismatches are logged
when there is a difference in the PVID advertised by a neighboring switch and the PVID of the switch port which
receives the LLDP advertisement. Logging is an LLDP feature that allows detection of possible vlan leakage
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between adjacent switches. However, if these events are logged too frequently, they can overwhelm the log buffer
and push relevant logging data out of log memory, making it difficult to troubleshoot another issue.

Logging is disabled and enabled with the support of CLI commands.

This enhancement also includes displaying the Mac-Address in the PVID mismatch log message when the port ID
is Mac-Address instead of displaying garbage characters in the peer device port ID field.

Use the following command to disable the logging of the PVID mismatch log messages:

Syntax:

logging filter [filter-name][sub filter id] <regularexpression> deny
Regular-expression

The regular expression should match the message which is to be filtered.

Syntax:

logging filter [filter-name] enable

Generic header ID in configuration file

Introduction
Auto deployment relies on DHCP options and the current DHCP auto-configuration function. Auto deployment is
platform independent, avoiding the J-number validation of the downloaded configuration file when downloaded
using DHCP option 66/67. The downloaded configuration file has an IGNORE tag immediately after the J-number
in its header.

An option to add an add-ignore-tag to an existing copy command will insert an ignore tag into the
configuration header. This insertion happens while transferring the configurations, (startup configuration
filesand running configuration files) from the switch to a configuration file setup on a remote server.
The process uses TFTP/SFTP or can be accomplished with a serially connected workstation using XMODEM.

Add-Ignore-Tag option
The add-ignore-tag option is used in conjunction with the copy command to transfer the startup
configuration or running configuration files from the switch to a remote server with IGNORE tag
inserted into it.

The IGNORE tag is inserted into the first line of the configuration file directly after the J-number.

Configuration file

; J9782A IGNORE Configuration Editor; Created on release #YB.15.14.0000x
; Ver #04:63.ff.37.27:88
hostname "HP-2530-24"
snmp-server community "public" unrestricted
vlan 1
name "DEFAULT_VLAN"
no untagged 2,20-25
untagged 1,3-19,26-28
ip address dhcp-bootp
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The J-number validation is ignored only when configuration file that contains the IGNORE tag is
downloaded to a switch via DHCP option 66/67. When a configuration file containing the
IGNORE tag is downloaded to a switch using CLI, SNMP or WebUI, the downloaded
configuration file is only accepted if the J-number in it matches the J-number on the switch.

There is no change to the current switch configuration when executing the copy command with the add-ignore-
tag option. The IGNORE tag is only added to the configuration file being exported to the external server. The
configuration file stored on an external server is then downloaded to the switch using DHCP option 66 during
bootup. If the IGNORE tag is available in the downloaded configuration file then the switch will avoid the J-
number validation of the configuration file. The downloaded configuration file will then go through a line
by line validation. Once the configuration file passes this validation, it gets updated in the flash. Once the
configuration file has been updated, the switch will reboot automatically.

The J-number in the downloaded configuration file is replaced with that of the switch. The
IGNORE tag is removed from the downloaded configuration file before updating it to flash. The
show running-configuration command will not display the IGNORE tag but displays the
switch’s J-number as part of the output.

Copy with add-ignore-tag

switch(config)# copy startup-config tftp <ip-addr> <filename> add-ignore-tag
switch(config)# copy running-config tftp <ip-addr> <filename> add-ignore-tag
switch(config)# copy startup-config sftp <ip-addr> <filename> add-ignore-tag
switch(config)# copy running-config sftp <ip-addr> <filename> add-ignore-tag
switch(config)# copy startup-config xmodem add-ignore-tag
switch(config)# copy running-config xmodem add-ignore-tag

Configuration commands for the add-ignore-tag option
Configuration files can be transferred to the switch from a server using the following copy commands:

• copy tftp
• copy xmodem
• copy sftp

Copy commands

copy tftp < startup-config | running-config > < ip-address > < remote-file >[ pc | unix ]
copy xmodem startup-config < pc | unix >
copy sftp < startup-config | running-config > < ip-address > < remote-file >
Configuration files that are downloaded using the copy commands as described in the example will be
accepted by the switch if they pass J-number validations and line by line validations after download. The
downloaded configuration file will be discarded by the switch if the validations fail. If the validations fail, the switch
will work with it’s previous configuration.

Show logging commands for the add-ignore-tag option
The show logging command is used to locate errors during a configuration validation process. The event log
catalogs entries with the ID#00158 and updates for each invalid entry found in the configuration file.
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Show logging

-- Reverse event Log listing: Events Since Boot ----
W 01/07/14 00:29:31 00158 update: line 13. Module command missing for port or invalid port: 36
I 01/07/14 00:29:30 00131 tftp: Transfer completed
I 01/07/14 00:29:29 00090 dhcp: Trying to download Config File (using TFTP) received in DHCP from 192.168.1.1

Downloading manually edited configuration file is not encouraged.

Exclusions
The IGNORE tag is not an available option when using external SCP, SFTP or TFTP clients such as PuTTY, Open
SSH, WinSCP and SSH Secure Shell to transfer configuration files out of the switch.
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The Captive Portal feature allows the support of the ClearPass Policy Manager (CPPM) into the ArubaOS-Switch
product line. The switch provides configuration to allow you to enable or disable the Captive Portal feature. By
default, Captive Portal is disabled to avoid impacting existing installations as this feature is mutually exclusive with
the following web-based authentication mechanisms: Web Authentication, EWA, MAFR, and BYOD Redirect.

Captive Portal is user-based, rather than port or VLAN-based, therefore the configuration is on a switch global
basis. ArubaOS-Switch supports the following authentication types on the switch with RADIUS for Captive Portal:

• Media Access Control (MAC)

• 802.1X

Once you enable Captive Portal, the redirect functionality is triggered only if a redirect URL attribute is provided
as part of the RADIUS Access-Accept response from an authentication request of type 802.1X or MAC. The
redirect enables the client to self-register or directly login with valid credentials via the CPPM. Upon subsequent
re-authentication, it provides access to the network per the CPPM configured policies that are communicated via
the RADIUS attributes.

The redirect feature offers:

• Client self-registration

• Client direct login with valid credentials via CPPM Captive Portal

• On-boarding

• Ability to quarantine devices to remedy their status

Requirements
• HTTPS support requires a certificate to be configured on the switch with a usage type of all or captive-

portal.

• If you are running HPE 5400 Series v2 modules, you must turn off the compatibility mode with the following
command:

switch(config)# no allow-v1-modules
This will ensure that the switch will only power up with the v2 modules.

Chapter 9
Captive Portal for ClearPass
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Best Practices
• Use the Port Bounce VSA via a CoA message, instead of the Disconnect message, to cause the second

RADIUS authentication to occur during the Captive Portal exchange. This is the more reliable method for
forcing a re-DHCP for the client.

• Configure Captive Portal such that the first ACCESS_ACCEPT returns a rate limit VSA to reduce the risk of DoS
attacks. This configuration enables rate limiting for the HTTP/HTTPS ACL for traffic sent to CPPM. 

• Do not use the keyword cpy in any other NAS-Filter-Rules. The keyword cpy in the enforcement profile
attributes is specific to CPPM use. It is only supported with the deny attribute. If you configure the cpy
keyword to permit, no ACL will be applied.

Limitations
• Captive Portal will not work with RADIUS configured on a loopback port or on the Out-of-Band Management

(OOBM) port.

• Captive Portal is supported in CPPM versions 6.5.5 and later. However, by manually modifying the RADIUS
dictionary files, any CPPM version 6.5.* can be used.

• Captive Portal does not support v1 modules, and will not work unless compatibility mode is turned off.

• Captive Portal does not support IPv6.

• Simultaneous Captive Portal client connections: maximum of 512

• Captive Portal does not support web proxy. The permit CPPM ACLs and the steal ACLs only use port 80 and
443. Non-standard ports for HTTP and HTTPS are not supported.

• Captive Portal is mutually exclusive with the following web-based authentication mechanisms: Web
Authentication, EWA, MAFR, and BYOD.

• URL-string limitation of 253 characters.

Features

High Availability
Captive Portal includes support for High Availability (HA). The Captive Portal configurations (such as enablement,
authenticated clients, and redirect URLs) are replicated to standby or other members.

If the feature is enabled and a failover occurs, clients in the process of onboarding are still redirected to Captive
Portal, and authenticated clients continue to have the same access to the network.

Clients that are in the process of authenticating via MAC or 802.1X authentication will not be replicated to the
standby. Replication of client data is only done when MAC or 802.1X authentication has resulted in a successful
authentication.

Load balancing and redundancy
The following options are available to create load balancing and provide redundancy for CPPM:
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• Virtual IP use for a CPPM server cluster

• CPPM servers configured in the switch RADIUS server group 

• External load balancer

Captive Portal when disabled
By default, Captive Portal is disabled. If the Captive Portal feature is disabled and the switch receives a redirect
URL attribute from the RADIUS server as part of the Access-Accept, it will view the redirect as an error. The
authentication success will be overridden, the session will be flushed, and the switch will send the Accounting
Start and Accounting Stop messages to indicate the client is no longer authenticated.

The Captive Portal feature may be disabled while there are in flight authentication requests. These are
authentication sessions that have not finished the final authentication with the switch. The switch flushes all
sessions with a redirect URL associated with them when Captive Portal is disabled.

Fully authenticated sessions are not impacted when Captive Portal is disabled. If CPPM deems these sessions to
be invalid, a RADIUS Disconnect can be sent to flush all these sessions.

Disabling Captive Portal
To disable Captive Portal, enter one of the following:

switch(config)# aaa authentication captive-portal disable
        

switch(config)# no aaa authentication captive-portal enable
        

Configuring Captive Portal on CPPM
Procedure

1. Importing the HP RADIUS dictionary

2. Creating enforcement profiles

3. Creating a ClearPass guest self-registration

4. Configuring the login delay

Import the HP RADIUS dictionary
For CPPM versions 6.5.*, you must update the HP RADIUS dictionary. To import the dictionary in CPPM, follow
these steps:

Procedure

1. Go to Administration -> Dictionaries -> RADIUS and click Import.

2. Select the XML HP RADIUS Dictionary from your Hard Drive.

3. Click Import.
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Create enforcement profiles

Create the HPE Bounce Host-Port profile and the Guest Login profile only if they do not already
exist.

For the HPE Bounce Host-Port profile, configure Captive Portal so that the RADIUS CoA message that includes
the Port Bounce VSA is sent to force the second RADIUS re-authentication after the user registers their device
and makes it known.

Procedure

1. In CPPM, go to Configuration -> Enforcement -> Profiles

2. Click Add.

3. Enter the Profile Name: HPE Bounce Host-Port

4. Enter the Description: Custom-defined profile to bounce host port (HPE).

5. Select the type RADIUS_CoA.

6. Select the action CoA.

7. Add all of the attributes required for a CoA message, and specify the port bounce duration (valid values are
between 0 and 60). This is the amount of time in seconds the port will be held in the down state. The
recommended setting is 12 seconds.

8. Repeat Step 2 to Step 6 to configure the Guest Login profile that will be sent as part of the first RADIUS
Access-Accept and enforce the redirect to the Captive Portal on CPPM. For this profile, select RADIUS as the
type and Accept as the action.

9. Add all of the NAS-Filter-Rule attributes specified below, replacing the IP address in the first two NAS-Filter-
Rule attributes with your CPPM address. Add the HPE-Captive-Portal-URL attribute to specify the redirect
URL, replacing the IP address with your CPPM address. This will cause the client to be redirected to the
Captive Portal on CPPM. You can add other attributes, such as a VLAN to isolate onboarding clients, or a rate
limit to help prevent DoS attacks.
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The HPE-Captive-Portal-URL value must be a URL normalized string. The scheme and host
must be in lower case, for example http://www.example.com/.

Create a ClearPass guest self-registration

Procedure

1. From the Customize Guest Registration window, select Server-initiated as the Login Method.

2. Optionally, under Security Hash, select the level of checking to apply to the redirect URL.
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Configure the login delay
Enter the Login Delay value. The value must be greater than the HPE-Port-Bounce-Host attribute. In this
example, we set the login delay value to 20 seconds.

Configuring the switch
Once you have configured Captive Portal, you can configure the switch. To configure the switch, you must first
configure the switch as a RADIUS client, then configure the ports that will be used for Captive Portal, as follows:

Procedure

1. Configure the switch as a RADIUS client. In this example, the CPPM IP address is 10.73.4.136 and
secret is the secret key shared with the RADIUS server:

a. switch(config)# radius-server host 10.73.4.136 key "secret"
b. switch(config)# radius-server host 10.73.4.136 dyn-authorization
c. switch(config)# radius-server host 10.73.4.136 time-window 0

Make sure to set your time-window to 0. See Event Timestamp not working.

2. Configure the ports that will be used for Captive Portal. In this example, the commands enable ports B3-B5 for
MAC Authentication:

a. switch(config)# aaa authentication port-access chap-radius
b. switch(config)# aaa port-access mac-based B3-B5

3. If you configured the Security Hash to Deny login on validation error in Create a ClearPass
guest self-registration on page 212, configure the URL key.

See Configure the URL key on page 214.

4. Configure the certificate. See Configuring a certificate for Captive Portal usage on page 214

5. Enable Captive portal:

switch(config)# aaa authentication captive-portal enable

By default, Captive Portal is disabled. Once enabled, you are redirected to the URL supplied via the HPE-
Captive-Portal-URL VSA. Captive Portal is enabled on a global/switch wide basis.
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Configure the URL key
You can optionally configure a URL hash key to provide some security for the Captive Portal exchange with
CPPM. The key is a shared secret between CPPM and the switch. When configured, the switch generates a
HMAC-SHA1 hash of the entire redirect URL, and appends the hash to the URL to be sent to CPPM as part of the
HTTP redirect. If CPPM is configured to check the hash, it will generate the hash of the URL using its version of
the URL hash key and compare against the value provided by the switch. The action taken by CPPM upon a
match or mismatch is determined by what is configured on CPPM.

CPPM provides the following options: 

• Do not check - login will always be permitted 

• Deny login on validation error - login will not be permitted

The URL hash key is globally configured and will be used for all redirects to Captive Portal. This key is not
configured on a per CPPM or RADIUS server basis. If the key is not specified, the hash is not added to the URL.
The URL hash key is an ASCII string with a maximum length of 64 characters.

The URL key supports the FIPS certification feature encrypt-credentials and can optionally be encrypted for more
robust security. This option is only available when the global encrypt-credentials is enabled.

To configure a plain text captive-portal URL key: 

switch(config)# aaa authentication captive-portal url-hash-key plaintext <KEY>
        
 

To configure an encrypted captive-portal URL key when encrypt-credentials is enabled:

switch(config)# aaa authentication captive-portal url-hash-key encrypted <ENCRYPTED-
KEY> 
        
To clear a captive-portal URL key: 

switch(config)# no aaa authentication captive-portal url-hash-key
        

Configuring a certificate for Captive Portal usage
HTTPS support requires the use of a certificate. If a certificate for Captive Portal does not exist, the certificate
designated for all use is used instead. 

To create a certificate signing request for Captive Portal, enter:

switch(config)# crypto pki create-csr certificate-name <cert-name> usage captive-
portal
        
To create a self-signed certificate for Captive Portal, enter: 

switch(config)# crypto pki enroll-self-signed certificate-name
        

Display Captive Portal configuration
To display the Captive Portal configuration settings, enter the show captive-portal command: 
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switch(config)# show captive-portal 

Captive Portal Configuration 
 Redirection Enabled    : Yes
 URL Hash Key Configured : No 
      

Show certificate information
To view the certificate information, enter: 

switch(config)# show crypto pki local-certificate 
        
  Name                Usage            Expiration    Parent / Profile 

  -------------------- ---------------  -------------- -------------------- 

   cp                  Captive Portal   2016/08/14    default 

Troubleshooting
Event Timestamp not working

Symptom

The client gets a credentials request on the web browser even though the valid credentials were already provided,
or the client is not redirected to the Captive Portal.

Cause

• ClearPass 6.5.x does not support the sending of Event Timestamp in automated workflows (manual via
Access Tracker works).

• The switch will reject CoA requests when the time on CPPM is ahead of the switch time by even a second.

Action

Set the time-window security feature in PVOS to 0:

radius-server host<CLEARPASS-IP> time-window 0

Cannot enable Captive Portal

Symptom

When running the aaa authentication captive-portal enable command, getting the following error
message:

Captive portal cannot be enabled when BYOD redirect, MAC authentication failure 
redirect, or web-based authentication are enabled.

Cause

The failure is due to a mutual exclusion restriction.
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Action

1. Check which one of the following are enabled: BYOD redirect, MAC authentication failure redirect, or web-
based authentication.

2. Disabled the enabled authentication method found in step 1.

3. Run the aaa authentication captive-portal enable command.

Unable to enable feature

Symptom

One of the following messages is displayed:

• BYOD redirect cannot be enabled when captive portal is enabled.
• MAC authentication failure redirect cannot be enabled when captive 

portal is enabled.
• Web-based authentication cannot be enabled when captive portal 

is enabled.
• V1 compatibility mode cannot be enabled when captive portal 

is enabled.

Cause

You cannot enable these features when Captive Portal is already enabled. They are mutually exclusive.

Action

You can either disable Captive Portal or avoid enabling these features.

Authenticated user redirected to login page

Symptom

User is redirected back to the login page to submit credentials even after getting fully authenticated.

Solution 1

Cause

The status is not changed to Known. 

Action

After the client submits the credentials, the CPPM service must change the Endpoint Status to Known.

Solution 2

Cause

The cache value is set.
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Action

Clear the CPPM Cache Timeout of the Endpoint Repository.

Unable to configure a URL hash key

Symptom

The following message is displayed:

Key exceeds the maximum length of 64 characters.

Cause

The URL hash key is not valid.

Action

Select a key that is 64 or less ASCII text. For example:

switch(config)# aaa authentication captive-portal url-hash-key plaintext
“8011A89FEAE0234BCCA”

authentication command
Use the following authentication commands to configure ClearPass Captive Portal.

Command Description

aaa authentication captive-portal enable Enables redirection to a Captive Portal server for
additional client authentication.

aaa authentication captive-portal
disable
or

no aaa authentication captive-portal
enable

Disables redirection to a Captive Portal server for
additional client authentication.

aaa authentication captive-portal url-
hash-key

Configures a hash key used to verify the integrity of the
portal URL.

show command
Use the following show commands to view the various configurations and certificates.

Command Description

show running-config Shows the running configuration.

show config Shows the saved configuration.

show ip Shows the switch IP addresses.

Table Continued
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Command Description

show captive-portal Captive portal configuration.

show port-access clients [port]
[detailed]

Consolidated client view; the detailed option shows
the Access Policy that is applied. The IP address is
only displayed if dhcp-snooping is enabled.

For the summary view (without the detailed option),
only the untagged VLAN is displayed.

show radius authentication Displays NAS identifier and data on the configured
RADIUS server and switch interactions with this server.

show radius dyn-authorization Statistics for Radius CoA and Disconnect.

show radius accounting Statistics for Radius accounting.

show crypto pki local-certificate
[summary]

Installed certificates.

Debug command
Use the debug command to help you debug your issues.

Command Description

debug security captive-portal Enables debug logging for the Captive Portal sub-
system.

debug security port-access mac-based Enables debug logging for the MAC-auth sub-system.

debug security port-access authenticator Enables debug logging for the 802.1X authenticator
sub-system.

debug security radius-server Enables debug logging for the Radius sub-system.

debug destination session Prints debug messages to terminal.

debug destination logging Sends debug messages to the syslog server.

debug destination buffer Prints debug messages to a buffer in memory.
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AirWave is a Network Management Solution (NMS) tool. Once connected to AirWave using the WebUI and CLI
interfaces, you can:

• Configure your switches using Zero Touch Provisioning (ZTP)

• Configure your switches using the CLI

• Troubleshoot your switches

• Monitor your switches

• Upgrade your firmware for your switches

Once you have configured your switch, you can monitor, manage, and upgrade your hardware using the AirWave
Management Platform.

Requirements
• DHCP server

• AirWave NMS

• HPE Aruba switches

Best Practices
• Implement ZTP in a secure and private environment. Any public access may compromise the security of the

switch, as follows:

◦ ZTP is enabled only on the factory default configuration of the switch. DHCP snooping is not enabled. You
must manage the Rogue DHCP server.

◦ The DHCP offer is in plain data without encryption. Therefore, the offer can be listened by any device on
the network and they can in turn obtain the AirWave information.

◦ The TLS certificate of the server is not validated by the switch during the HTTPs check-in to AirWave. The
AirWave server is in the private environment of the switch.

Limitations
• ZTP is not supported through OOBM.

• The DNS/hostname in option 66 is not supported, only the IPv4 address.

• The switch does not validate peer certificate of the AirWave server as part of the TLS handshake.

Chapter 10
ZTP with AirWave Network Management
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• The HTTPS check-in to AirWave does not support HTTPS proxy.

• For non-ZTP cases, the AirWave check-in starts by validating the following condition: Primary or Management
VLAN must be configured with the IP address and one of the interface must be UP. By default, VLAN 1 is the
primary VLAN.

Switch configuration
To configure your switch, follow these steps:

1. Configure AirWave details in DHCP (preferred method) on page 220.

If you are using existing HPE switches and using the DHCP server for the configuration or
firmware management, you can configure the AirWave details in DHCP using this method: 
Configure AirWave details in DHCP (alternate method) on page 225

2. If you are configuring the switch using a CLI, see Configure a switch using the CLI on page 234.

If you are using ZTP, the configuration is automatic and does not require any user interaction, see Zero Touch
Provisioning

The switch contacts the AirWave server that is configured on the switch and initiates the check-in process.

Once you have configured the DHCP server, the AirWave details received from the DHCP options are stored in
the switch configuration. This assures that the configuration is retained across reboots.

Once AirWave completes the switch check-in, it lists the first switch as New Devices. The first switch is used to
create a new configuration template for the specific group and device type. With this new template, the required
configuration is generated for the group. Subsequent switch of the specific type and joining the same group as the
first device are added directly to the group and the configuration is pushed using the configuration template via a
SSH connection.

Configure AirWave details in DHCP (preferred method)
To configure a DHCP server for AirWave, from a Windows Server 2008, do the following steps:

Procedure

1. From the Start menu, select Server Manager.
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2. Select Roles -> DHCP -> Server -> w2k8 -> IPv4.

3. Right click on IPv4 and select Set Predefined Options...
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4. The Predefined Options and Values screen is displayed. Click Add....

5. Enter the desired Name (any), Data type (select String), Code (enter 60), and Description (any).
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6. Click OK.

7. From the Predefined Options and Values screen, under Value, enter the String ArubaInstantAP. The string
is case sensitive and must be ArubaInstantAP.

8. Click OK.

9. Under IPv4, expand Scope. Right click on Scope Options and select Configure Options...
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10. Under the General tab, select 043 Vendor Specific Info. The Data entry data appears. Under ASCII, enter
hpeSwitch:hp2920,90.1.1.10,admin. The ASCII value has the following format:
<Group>:<Topfolder>,<AMP IP>,<shared secret>
If you need to add sub-folders, use the following format:

<Group>:<Topfolder>:<folder1>,<AMP IP>,<shared secret>
11.

12. Under the General tab, select 060 Airwave. Click OK.
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No changes are required to the 060 option.

13. You can verify the AirWave details as follows:

switch# show amp-server
switch# show run
          

Configure AirWave details in DHCP (alternate method)
To configure a DHCP server for ZTP and AirWave, from a Windows Server 2008, do the following steps:

You must repeat these steps for every type of switch that needs to be configured for ZTP, selecting a
different Vendor Class for each type of switch.

Procedure

1. From the Start menu, select Server Manager.

Chapter 10 ZTP with AirWave Network Management 225

Anexo 04 ITEM 11 (0592666)         SEI 0008478-63.2018.6.02.8000 / pg. 6049



2. Select Roles -> DHCP -> Server -> w2k8 -> IPv4.

3. Right click on IPv4 and select Define Vendor Classes...
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4. The DHCP Vendor Classes window is displayed. Click Add....

5. To get the vendor-specific value of a switch, go to the switch console and enter:

switch# show dhcp client vendor-specific
          
In our example, the command returns the following value:

    Vendor Class Id = HP J9729A 2920-24G-PoE+ Switch dslforum.org 
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Processing of Vendor Specific Configuration is enabled

6. From the New Class window, enter the desired Display name (any) and the Description (any). For the
ASCII field, enter the exact value that you got by executing the show command performed in the previous
step. In this example, HP J9729A 2920-24G-PoE+ Switch dslforum.org.

7. Click OK.

8. Right click on IPv4 and select Set Predefined Options....
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9. From the Predefined Options and Values window, select Option class. The Option Class displayed is the
one that you configured under DHCP Vendor Class. In this example, the Option Class is switch.

10. Click Add....
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11. From the Option Type window, enter the desired Class (any), the Data type (select string), the Code (enter
146), and the Description (any).

12. Click OK.

13. Under the Predefined Options and Values window, enter the Value String. In this example, we enter
hpeSwitch:hp2920,90.1.1.10,admin. The String has the following format: <Group>:<Topfolder>,<AMP
IP>,<shared secret>
If you need to add sub-folders, use the following format:<Group>:<Topfolder>:<folder1>,<AMP
IP>,<shared secret>
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14. Click OK.

15. Under IPv4, expand Scope. Right click on Scope Options and select Configure Options...

16. From the Scope Options window:

a. Select the Advanced tab.

b. Under Vendor class, select the desired switch. In this example, switch.

c. Select the 146 hpswitch option.

d. Click OK.

Chapter 10 ZTP with AirWave Network Management 231

Anexo 04 ITEM 11 (0592666)         SEI 0008478-63.2018.6.02.8000 / pg. 6055



17. You can verify the AirWave details as follows:

switch# show amp-server
switch# show run
          

Zero Touch Provisioning
The Zero Touch Provisioning (ZTP) solution enables the auto-configuration of your switches on the first boot
without requiring any administrator’s intervention at the switch. The switches use DHCP server option
configurations to support ZTP.

If the switch does not contain the minimal configuration set, ZTP will get disabled. See Image
Upgrade

Auto-configuration using ZTP
ZTP auto-configures your switches as follows:
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Procedure

1. The switch boots up with the factory default configuration.

2. The switch sends out a DHCP discovery from the primary VLAN interface.

a. The preferred configuration method uses DHCP option 43 value as a string to parse Airwave configuration.
Switch would expect a DHCP option 60 with value ArubaInstantAP along with DHCP option 43 to parse
Airwave details

b. The alternate configuration method supports both encapsulated values from option 43 and direct value from
option 43.  Encapsulated vendor-specific sub options, with sub-option code 146 is for Airwave details.

3. After the AirWave details are verified and configured, the switch initiates the check-in into the AirWave server
using the HTTPS communication.

The AirWave configuration must be in the following format:

<Group>:<Topfolder>:<folder1>,<AMP IP >,<shared secret>

4. After a successful registration, AirWave can monitor, configure, and troubleshoot the switches. Refer to Aruba
Networks and AirWave Switch Configuration Guide.

5. Check-in failure retry is done every 60 seconds for 10 retries.

6. If the DHCP options are not configured for AirWave, the switch is left in its default state for manual
configuration.

Disabling ZTP
Zero touch provisioning is disabled if you make any of the following changes to the switch’s configuration:

• Enter the switch configuration mode using the configure terminal command.

• Enter into Menu and exit without doing any configuration

• Make any successful configuration that changes the running-configuration of the switch using a CLI, SNMP,
REST APIs, menu interface, or the web GUI.

• If you upgrade with non-minimal configuration set from any 15.xx version to version 16.01, see Image
Upgrade

Image Upgrade
If you upgrade from any 15.xx version to version 16.01, the following minimal set of configuration is validated to
enable or disable the ZTP process:

• If the switch has any other VLAN apart from the default VLAN, ZTP gets disabled.

• In default VLAN, if the IPv4 address is not set as DHCP (default option is DHCP), ZTP gets disabled.

• In default VLAN, if IPv6 is enabled or configured, ZTP gets disabled.

If you have any other configuration during the upgrade, ZTP will be in the enabled state only.
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Configure a switch using the CLI
Use the amp-server command to configure the AirWave IP address, group, folder, and shared secret. You must
have the manager role to execute this command.

For example:

HP switch(config)# amp-server ip 172.16.185.23 group 2530 folder 2530 secret secret
      
The show amp-server command shows the configuration details:

switch# show amp-server
Airwave Configuration details
  AMP Server IP           : 172.16.185.23
  AMP Server Group        : 2530
  AMP Server Folder       : 2530
  AMP Server Secret       : secret
  AMP Server Config status: Configured
      

Stacking and chassis switches
The ZTP and AirWave interaction for stacked switches is similar to the one for the standalone switch, with the
exception that only the commander in the stack processes the ZTP and AirWave interaction.

Stacking supports the following features:

• Backplane Stacking (BPS) running on:

◦ HPE Aruba 2920 Switch Series

◦ HPE Aruba 3810M Series

• Virtual Switching Framework (VSF) running on HPE Aruba 5400R Switch Series v3 modules

• Chassis running on HPE Aruba 5400R Switch Series v3 modules

Troubleshooting
Cause

You can troubleshoot switches by using the SSH connection and the device logs available in AirWave. For a list of
all RMON message, refer to ArubaOS-Switch Event Log Message Reference Guide.

You can enable the debug logging with the debug ztp command, see debug ztp

View AMP server messages
To display the AMP server debug messages, enter:

switch# debug ztp
        
To print the debug messages to the terminal, enter:

switch# debug destination session
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Validation Rules

Validation Error/Warning

Invalid AirWave IP address Invalid input: 300.300.300.300

Group name exceeds max length String %s too long. Allowed length is 32 characters.

Folder name exceeds max length String %s too long. Allowed length is 128 characters.

Secret name exceeds max length String %s too long. Allowed length is 32 characters.

AirWave IP address or Group or folder or secret is not
configured.

Incomplete input: amp-server

View configuration details
to view the AirWave configuration details, use the show amp-server command. For example:

Airwave Configuration details

  AMP Server IP           : 192.168.1.1
  AMP Server Group        : HP_GROUP
  AMP Server Folder       : folder
  AMP Server Secret       : secret123
  AMP Server Config Status: Configured
The show amp-server command displays the following values for the above configuration details. The show
running command also displays the AirWave configuration details.

For example, to show details of the running configuration:

switch# show running-config
hostname "Aruba-2930F-24G"
module 1 type j9726a
snmp-server community "public" unrestricted
oobm
   ip address dhcp-bootp
   exit
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-24
   ip address dhcp-bootp
   exit
amp-server ip 192.168.1.1 group "group" folder "folder" secret "secret123"

amp-server
Syntax
[no] amp-server ip <IP ADDRESS> group <GROUP> folder <FOLDER> secret <SECRET>
Description

The amp-server command configures the AirWave Management Platform (AMP) IP address, group, folder, and
shared secret and triggers the device registration with AMP.

Only the manager role can execute this command.
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Parameters
ip
AMP server IP address.

group
AMP server group name.

folder
AMP server folder name.

secret
AMP server shared secret string.

Options
no
The no amp-server command removes the configuration for the AMP server.

Permissions

Only the manager role can execute this command.

debug ztp
Syntax
[no] debug ztp
Description

Enables or disables ZTP debug logging.

Parameters
ztp
Zero Touch Provisioning.

Options
no
The no debug ztp command disables the ZTP debug logging.
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Auto device detection and configuration
The auto device detection and configuration detects a directly connected Aruba AP dynamically and applies
predefined configurations to ports on which the Aruba AP is detected.

You can create port configuration profiles, associate them to a device type, and enable or disable a device type.
The only device type supported is aruba-ap and it is used to identify all the Aruba APs.

When a configured device type is connected on a port, the system automatically applies the corresponding port
profile. Connected devices are identified using LLDP. When the LLDP information on the port ages out, the device
profile is removed.

By default, the device profile feature is disabled. When you enable the device profile support for a device type, if
no other device profile is mapped to the device type, the default device profile default-ap-profile is
associated with the device type. You can modify the AP default device profile configuration but you cannot delete
it. The default-ap-profile command supports only the AP device type.

Requirements

Only APs directly connected to the switch will be detected.

Limitations

• Only one device type is supported, aruba-ap, and it is used to identify all the Aruba APs.

• You can modify the configuration parameters of the default profile, default-ap-profile, but you cannot
delete it or change its name.

• The maximum value for poe-max-power is 33 W.

• If the port was part of any protocol VLANs prior to the device profile application, those VLANs will not be
removed while applying the device profile.

• Egress rate limiting is not supported on the Aruba 2530 Switch Series.

• The egress-bandwidth is only supported for devices running on:

◦ Aruba 2920 Switch Series

◦ Aruba 2930F Switch Series

◦ Aruba 5400R zl2 Switch Series v2 & v3 modules

• The egress-bandwidth option is not supported and not displayed in the CLI running on:

Aruba 2530 Switch Series

Feature Interactions

Chapter 11
Auto configuration upon Aruba AP detection
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Profile Manager and 802.1X
Profile Manager interoperates with RADIUS when it is working in the client mode. When a port is blocked due to
802.1X authentication failure, the LLDP packets cannot come in on that port. Therefore, the Aruba AP cannot be
detected and the device profile cannot be applied. When the port gets authenticated, the LLDP packets comes in,
the AP is detected, and the device profile is applied.

You must ensure that the RADIUS server will not supply additional configuration such as VLAN or CoS during the
802.1X authentication as they will conflict with the configuration applied by the Profile Manager. If the RADIUS
server supplies any such configurations to a port, the device profile will not be applied on such ports.

Profile Manager and LMA/WMA/MAC-AUTH
If either LMA, WMA, or MAC-AUTH is enabled on an interface, all the MAC addresses reaching the port must be
authenticated. If LMA, WMA, or MAC-AUTH is configured on an interface, the user can have more granular
control and does not need the device profile configuration. Therefore, the device profile will not be applied on
such interface.

Profile manager and Private VLANs
When the device profile is applied, a check is performed to verify if the VLAN addition violates any PVLAN
requirements. The following PVLAN related checks are done before applying the VLANs configured in the device
profile to an interface:

• A port can be a member of only one VLAN from a given PVLAN instance.

• A promiscuous port cannot be a member of a secondary VLAN.

Procedure for creating a device identity and associating a device type

Procedure

1. Create a device identity using the command:

switch# device-identity name <DEVICE-NAME>
          

2. Specify the OUI used in LLDP's organization using specific TLV, (type =127). OUI should be in XXXXXX
format. The default OUI "000000" indicates that device-identity will not use LLDP to identify device:

switch(config)# device-identity name <DEVICE-NAME> lldp oui <MAC_OUI>
 sub-type <SUBTYPE>

To add new device on switch:

switch(config)# device-identity name abc lldp oui a1b2c3 sub 2
To remove device from switch:

switch(config)# no device-identity name abc
3. Show device identity configuration:

switch(config)# show device-identity lldp

Device Identity Configuration

 Index  Device name            Oui        Subtype

238 Aruba 2530 Management and Configuration Guide for ArubaOS-Switch 16.05

Anexo 04 ITEM 11 (0592666)         SEI 0008478-63.2018.6.02.8000 / pg. 6062



 ------ ---------------------- ---------- -------
 1      abc                    a1b2c3     2     

device-profile name
Syntax

[no] device-profile name <PROFILE-NAME> [untagged-vlan <VLAN-ID> | 
             tagged-vlan <VLAN-LIST> |
             cos <COS-VALUE> | 
             ingress-bandwidth <Percentage> | 
             egress-bandwidth <Percentage> | 
             {poe-priority {critical | high | low} | 
             speed-duplex {auto | auto-10 | auto-100 | ...} |
             poe-max-power <Watts>]
Description

This command is used to create an user-defined profile. A profile is a named collection of port settings applied as
a group. You can modify the default profile, default-ap-profile, but you cannot delete it. You can create four
additional profiles.

The default-ap-profile has the following values:

• untagged-vlan: 1

• tagged-vlan: None

• ingress-bandwidth: 100

• egress-bandwidth: 100

• cos: 0

• speed-duplex: auto

• poe-max-power: 33

• poe-priority: critical

You can modify these parameters. For example, you can execute no untagged-vlan to create a device profile
with tagged only ports.

Parameters
name
Specifies the name of the profile to be configured. The profile names can be at most 32 characters long.

cos
The Class of Service (CoS) priority for traffic from the device.

untagged-vlan
The port is an untagged member of specified VLAN.

tagged-vlan
The port is a tagged member of the specified VLANs.

ingress-bandwidth
The ingress maximum bandwidth for the device port.

egress-bandwidth
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The egress maximum bandwidth for the device port.

poe-priority
The PoE priority for the device port.

speed-duplex
The speed and duplex for the device port.

poe-max-power
The maximum PoE power for the device port.

Options
no
Removes the user-defined profiles.

Restrictions

• You can modify the configuration parameters of the default profile, default-ap-profile, but you cannot
delete it or change its name.

• For Aruba 5400R Switch Series and Aruba 2930F Switch Series devices, the maximum value for poe-max-
power is 30 W. For all other devices, the maximum value for poe-max-power is 33 W.

• Egress rate limiting is not supported for devices running on:

◦ Aruba 2530 Switch Series

◦ Aruba 2540 Switch Series

◦ Aruba 2930F Switch Series

• The egress-bandwidth is only supported for Aruba 2920 and Aruba 5400R Switch Series v2 & v3.

• The egress-bandwidth option is not supported and not displayed in the CLI for the Aruba 2530 switch.

• The profile configuration is only applicable to access points.

device-profile type
Syntax

device-profile type <DEVICE> [associate <PROFILE-NAME> | enable | disable ]
Description

This command specifies an approved device type in order to configure and attach a profile to it. The profile’s
configuration is applied to any port where a device of this type is connected.

Parameters
type
An approved device type in order to configure and attach a profile to it. The only device type supported is aruba-
ap and it is used to identify all the Aruba APs.

APs.

associate
Associates a profile with a device type.

enable
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Enables automatic profile association.

disable
Disables automatic profile association.

Options
no
Removes the device type association and disables the feature for the device type. By default, this feature is
disabled.

Restrictions

Only one device type is supported, aruba-ap, and it is used to identify all the Aruba access points.

Rogue AP Isolation
The Rogue AP Isolation feature detects and blocks any unauthorized APs in the network. You can either log or
block the rogue device. If the action requested is to log the rogue device, the MAC address of the rogue device is
logged in the system logs (RMON). If the action is to block the rogue device, the traffic to and from the MAC
address of the rogue device is blocked. The MAC is also logged in the system log.

When an Aruba AP detects a rogue AP on the network, it sends out the MAC address of the AP as well as the
MAC of the clients connected to the AP to the switch using the ArubaOS-Switch proprietary LLDP TLV protocol.
The switch then adds a rule in its hardware table to block all the traffic originating from the rogue AP’s MAC
address.

The rogue-ap-isolation command configures the rogue AP isolation for the switch and gives the option to
enable or disable the rogue AP isolation feature. The rogue-ap-isolation action command gives you the
ability to block the traffic to or from the rogue device or log the MAC of the rogue device. When the action is set to
block, the rogue MAC is logged as well. By default, the action is set to block.

The rogue-ap-isolation whitelist command lets you add devices detected as possible rogue APs to the
whitelist. A maximum of 128 MAC addresses are supported for the whitelist.

The clear rogue-aps command clears the detected rogue AP device MAC address.

Limitations

• You can add a maximum of 128 MAC addresses to the whitelist.

• When a MAC is already authorized by any of the port security features such as LMA, WMA, or 802.1X, the
MAC is logged but you cannot block it using the rogue-ap-isolation feature. A RMON event is logged to
notify the user.

• When a MAC is already configured as an IP received MAC of a VLAN interface, the MAC is logged but you
cannot block it by using the rogue-ap-isolation feature. A RMON event is logged to notify the user.

• When a MAC is already locked out via lockout-mac or locked down using the static-mac configuration,
the MAC is logged but you cannot block it using the rogue-ap-isolation feature. A RMON event is logged
to notify the user.

• The number of rogue MACs supported on a switch is a function of the value of max-vlans at boot time. Since
the resources are shared with the lockout-mac feature, the scale is dependent on how many lockout
addresses have been configured on the switch using the lockout-mac feature. The following table lists the
scale when there are no lockout addresses configured on the switch:
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Max VLAN Supported MACs

0 < VLAN <= 8 200

8 < VLAN <= 16 100

16 < VLAN <= 256 64

256 < VLAN <= 1024 16

1024 < VLAN <= 2048 8

2048 < VLAN <= 4094 4

The switch will create an RMON log entry and the rogue MAC will be ignored when the limit is reached.

If the max-vlans value is changed to a different value, the scale of rogue MACs supported will
not change until the next reboot.

Feature Interactions

MAC lockout and lockdown
The Rogue AP isolation feature uses the MAC lockout feature to block MACs in hardware. Therefore, any MAC
blocked with the Rogue AP isolation feature cannot be added with the lockout-mac or static-mac command
if the action type is set to block. 

For example:

switch# lockout-mac 247703-7a8950 
Cannot add the entry for the MAC address 247703-7a8950 because it is already 
blocked by rogue-ap-isolation. 
      

switch# static-mac 247703-7a8950 vlan 1 interface 1 
Cannot add the entry for the MAC address 247703-7a8950 because it is already 
blocked by rogue-ap-isolation. 
      
Similarly, any MAC that was added with the lockout-mac or static-mac command and that is being detected
as rogue will be logged, but not blocked in hardware as it already is set to block. If the MAC is removed from
lockout-mac or static-mac but is still in the rogue device list, it will be blocked back in hardware if the action
type is block.

LMA/WMA/802.1X/Port-Security
Any configuration using LMA, WMA, 802.1X, or Port-Security will not be blocked if the Rogue AP isolation feature
is enabled. All these features act only when a packet with the said MAC is received on a port.

If rogue-ap-isolation blocks a MAC before it is configured to be authorized, packets from such MACs will be
dropped until one of the following happens:

• Rogue action is changed to LOG.

• Rogue-AP isolation feature is disabled.
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• The MAC is not detected as rogue anymore.

• LLDP is disabled on the port (or globally).

Once a MAC has been authorized by one of these features, it will not be blocked by Rogue AP isolation. A RMON
will be logged to indicate the failure to block.

The Rogue AP module will retry to block any such MACs periodically. In the event of the MAC no longer being
authorized, Rogue AP isolation will block the MAC again. No RMON is logged to indicate this event. 

L3 MAC
The Rogue AP isolation feature will not block a MAC configured as an IP receive MAC address on a VLAN
interface. This event will be logged in RMON if such MACs are detected as rogue.

Conversely, any MAC already blocked by Rogue AP isolation will not be allowed to be configured as an IP receive
MAC address of a VLAN interface.

For example:

switch# vlan 1 ip-recv-mac-address 247703-3effbb 
Cannot add an entry for the MAC address 247703-3effbb because it is already
blocked by rogue-ap-isolation. 
      

Using the Rogue AP Isolation feature

Procedure

1. Check the feature state:

switch# show rogue-ap-isolation

 Rogue AP Isolation

  Rogue AP Status : Disabled
  Rogue AP Action : Block

  Rogue MAC Address Neighbour MAC Address
  ----------------- ---------------------
          

2. Enable the feature:

switch# rogue-ap-isolation enable
switch# show rogue-ap-isolation

 Rogue AP Isolation

  Rogue AP Status : Enabled
  Rogue AP Action : Block

  Rogue MAC Address Neighbour MAC Address
  ----------------- ---------------------
          

3. Change the action type from block to log:

switch# rogue-ap-isolation action log
switch# show rogue-ap-isolation

 Rogue AP Isolation
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  Rogue AP Status : Enabled
  Rogue AP Action : Log

  Rogue MAC Address Neighbour MAC Address
  ----------------- ---------------------
          

4. List the current whitelist entries:

switch# show rogue-ap-isolation whitelist

Rogue AP Whitelist Configuration

 Rogue AP MAC
 ------------------
          

5. Add a new whitelist entry:

switch# rogue-ap-isolation whitelist 005056-00326a
switch# show rogue-ap-isolation whitelist

Rogue AP Whitelist Configuration

 Rogue AP MAC
 ------------------
 00:50:56:00:32:6a
          

rogue-ap-isolation
syntax

rogue-ap-isolation {enable | disable}
Description

Configures the rogue AP isolation for the switch.

Parameters
enable
Enables the rogue AP isolation.

disable
Disables the rogue AP isolation.

rogue-ap-isolation action
syntax

rogue-ap-isolation action {log | block}
Description

Configures the action to take for the rogue AP packets. This function is disabled by default.

Parameters
action
Configure the action to take for rogue AP packets. By default, the rogue AP packets are blocked.
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Options
log
Logs traffic to or from any rogue access points.

block
Blocks and logs traffic to or from any rogue access points.

rogue-ap-isolation whitelist
syntax

[no] rogue-ap-isolation whitelist <MAC-ADDRESS>
Description

Configures the rogue AP Whitelist MAC addresses for the switch. Use this command to add to the whitelist the
MAC addresses of approved access points or MAC addresses of clients connected to the rogue access points.
These approved access points will not be added to the rogue AP list even if they are reported as rogue devices.

Parameters
MAC-ADDRESS
Specifies the MAC address of the device to be moved from the rogue AP list to the whitelist.

Options
no
Removes the MAC address individually by specifying the MAC.

Restrictions

You can add a maximum of 128 MAC addresses to the whitelist.

clear rogue-ap-isolation
syntax

clear rogue-ap-isolation { <MAC-ADDRESS> | all }
Description

Removes the MAC addresses from the rogue AP list.

Parameters
MAC-ADDRESS
Specifies the MAC address of the device to be moved from the rogue AP list.

all
Clears all MAC addresses from the rogue AP list.

Restrictions

The MAC addresses cleared using this option will be added back to the rogue list under the following cases:

1. The LLDP administrator status of the port on which the AP that reported the MAC is disabled and enabled
back.

2. The data that is in the rogue AP TLV sent from the AP that informed the rogue MAC has changed.

3. To permanently ignore a MAC from being detected as rogue, add it to the whitelist.
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Troubleshooting
Dynamic configuration not displayed when using “show running-config”

Symptom

The show running-config command does not display the dynamic configuration applied through the device
profile.

Cause

The show running-config command shows only the permanent user configuration and parameters
configured through device profile.

Action

Use the specific show device-profile command to display the parameters dynamically configured through
the device profile.

Switch does not detect the rogue AP TLVs

Symptom

The switch does not detect the rogue AP TLVs that could be sent from the neighboring device.

Cause

The LLDP administrator status of a port is moved from txOnly to tx_rx or rx_only within 120 seconds of the
previous state change to txOnly.

Action

1. Wait for 120 seconds before moving from the state txOnly to the state tx_rx or rx_only. 

2. Move the administrator status to disable and then back to tx_rx or rx_only.

The show run command displays non-numerical value for untagged-vlan

Symptom

The show run command displays one of the following values for untagged-vlan:

• no untagged-vlan
• untagged-vlan : None

Cause

The no device-profile or the no rogue-ap-isolation whitelist command is executed to configure
untagged-vlan to 0.
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Action

No action is required.

Show commands
Use the following show commands to view the various configurations and status.

Command Description

show device-profile Shows the device profile configuration and status.

show device-profile config Shows the device profile configuration details for a
single profile or all profiles.

show device-profile status Shows currently applied device profiles.

show rogue-ap-isolation Shows the following information:

• The status of the feature: enabled or disabled.

• The current action type for the rogue MACs
detected.

• The list of MAC addresses detected as rogue and
the MAC address of the AP that reported them.

show rogue-ap-isolation whitelist Shows the rogue AP whitelist configuration.

show run Shows the running configuration.

Validation Rules

Validation Error/Warning/Prompt

device-profile profile-name default-ap-
profile

Maximum tagged VLANs that can be associated with a
device-profile is 256.

device-profile profile-name creation. String too long. Allowed length is 32 characters.

device-profile profile-name creation. Device profile <> already exists.

device-profile profile-name creation. The maximum number of device profiles allowed is 5.

device-profile profile-name deletion. Device profile <> does not exist.

device-profile profile-name deletion. Cannot delete profile <> when associated with a device
type.

device-profile profile-name deletion. Default profile cannot be deleted.

Table Continued
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Validation Error/Warning/Prompt

device-profile profile-name modification via
SNMP.

Default profile name cannot be changed.

device-profileprofile-name creation/
modification via SNMP.

Device profile index cannot be greater than 5.

untagged-vlan Invalid VLAN.

untagged-vlan Cannot configure the VLAN <> as an untagged VLAN
because this is already used as a tagged VLAN.

tagged-vlan 1-1000 The maximum number of tagged VLANs in a profile is
less than 512 or the maximum VLANs, MAX_VLANs,
configurable in the system.

tagged-vlan Cannot configure the VLAN <> as a tagged VLAN
because this is already used as an untagged VLAN.

ingress-bandwidth SNMP should return WRONG_VALUE_ERROR.

egress-bandwidth SNMP should return WRONG_VALUE_ERROR.

cos SNMP should return WRONG_VALUE_ERROR.

speed-duplex SNMP should return WRONG_VALUE_ERROR.

poe-max-power SNMP should return WRONG_VALUE_ERROR.

poe-priority SNMP should return WRONG_VALUE_ERROR.

device-profile type aruba-ap profile-
name

String <> too long. Allowed length is 32 characters.

device-profile type aruba-ap profile-
name

Device profile <> does not exist.

device-profile type aruba-switch-router Device type is not supported.

rogue-ap-whitelist Whitelist MAC address already exists in the list.

rogue-ap-whitelist Whitelist MAC address does not exist in the list.

rogue-ap-whitelist The maximum number of whitelist MACs allowed is
128.

rogue-ap-whitelist <MAC> Cannot add the whitelist entry because the specified
MAC address is already configured as a lock-out MAC.

Table Continued
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Validation Error/Warning/Prompt

lock-out <MAC> Cannot add the lock-out entry because the specified
MAC address is already configured as a whitelist MAC.

lockout-mac <MAC-ADDRESS>ORstatic-mac
<MAC-ADDRESS> vlan <vlan-id> interface
<interface>ORvlan <vlan-id> ip-recv-mac-
address <MAC-ADDRESS

Cannot add an entry for the MAC address <MAC-
ADDRESS> because it is already blocked by rogue-
ap-isolation.
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Aruba Central Network Management Solution Overview
The Aruba Central network management solution, a software-as-a-service subscription in the cloud, provides
streamlined management of multiple network devices. Aruba switches are able to talk to Aruba Central and utilize
cloud-based management functionality. Cloud-based management functionality allows for the deployment of
network devices at sites with no IT personnel (branch offices, retail stores, and so forth). The communication
channel used to connect the devices with the cloud portal is outside the control of end users. It adheres to
corporate standards like the use of firewalls.

This feature provides:

• Zero-touch provisioning

• Network Management/Remote monitoring

• Events/alerts notification

• Configuration

• Firmware management

Table 22: Features supported by Aruba Central

Configuration

VLANS Create VLANs

IP address assignment

Tag/Untag

Ports Admin status [Up/Down]

PoE [ Enable/Disable for an interface]

User
Management

Create/delete Operator User

Create Manager user

IP address assignment to Uplink Vlan [ Static to DHCP and vice versa ]

Name server configuration

RCD

Establish a remote console session to Switch

Monitoring

Events

Statistics

Chapter 12
Aruba Central integration
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Firmware Management

Update the switch firmware

Troubleshooting

Execute troubleshooting commands from central

Restricted commands in switch when connected to Central

boot
recopy
erase
reload
startup-default
upgrade-software
setup
delete
reboot
restore
menu
write memory
amp-server

Limited Management Interface on switch

WebUI
REST
SNMP
TR-69
Menu

You can provision the switch in Aruba Activate. For more information about provisioning, See Aruba Networks and
AirWave Switch Configuration Guide.

LED behavior during connectivity loss
For the 2530, the FDX LED does not blink. It remains on during connectivity loss.

Configuration commands

aruba-central
Syntax
aruba-central {enable | disable | support-mode {enable | disable}}
Description

Configure Aruba Central server support. When enabled, and when a server web address has been obtained using
Aruba Activate, the system will connect to an Aruba Central server. The system will obtain configuration updates
and most local configuration commands will be disabled. This mode is enabled by default.

Enter support mode to enable all configuration commands. Normally, when the system is connected to an Aruba
Central server, the configuration is updated from that server and most local configuration commands are disabled.
Support mode enables those commands for use in troubleshooting problems. Support mode is disabled by
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default. When the system is not connected to Aruba Central server, the full command set is enabled for local
configuration.

Restrictions

• Switch communication to Aruba Central is not supported via OOBM.

• Aruba-central is not supported in FIPS switches and it will be disabled by default.

• Aruba-central is not supported in Stack switches and it will be disabled by default.

To avoid broadcast storm or loops in your network while configuring ZTP, do not have redundant links
after you complete ZTP and Airwave registration. Authorize the new switch and then push the
Golden Configuration template from Airwave.

Example

Enable Aruba Central server support

switch(config)# aruba-central enable
Disable Aruba Central server support

switch(config)# aruba-central disable
Enter support mode to enable all CLI configuration commands

switch(config)# aruba-central support-mode enable

This mode will enable all CLI configuration commands, including those normally reserved by the Aruba Central
service. 
Use of this mode may invalidate the configuration provisioned through Aruba Central server.
Continue (y/n)?              

Show commands

show aruba-central
Syntax
show aruba-central
Description

Show Aruba Central server information.

show aruba-central

switch# show aruba-central

 Configuration and Status - Aruba Central
  Server URL           : https://hpsw-jenkins-soa-qa-build-1404-250.test.pdt1.arubathena.com/ws
  Connected            : Yes
  Mode                 : Managed
  Last Disconnect Time : Tue Jun 14 16:01:15 2016
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LACP-MAD commands

Configuration command
The following command defines whether LACP is enabled on a port, and whether it is in active or passive mode
when enabled. When LACP is enabled and active, the port sends LACP packets and listens to them. When LACP
is enabled and passive, the port sends LACP packets only if it is spoken to. When LACP is disabled, the port
ignores LACP packets. If the command is issued without a mode parameter, 'active' is assumed. During dynamic
link aggregation using LACP, ports with the same key are aggregated as a single trunk. MAD passthrough applies
only to trunks and not to physical ports.

switch# [no] interface <port-list> lacp [mad-passthrough <enable|disable>|active|passive|key <key>]

show commands
LACP-MAD supports the following show commands:

• show LACP-MAD passthrough configuration on LACP trunks

switch# show lacp [counters [<port-list>] | local [<port-list>] |peer [<port-
list>] | distributed | mad-passthrough [counters [<port-list>]]]

• show LACP-MAD passthough counters on ports

switch# show lacp mad-passthrough counters [<port-list>]

clear command
Clear all LACP statistics including MAD passthrough counters. Resets LACP packets sent and received on all
ports.

switch# clear lacp statistics

LACP-MAD overview
Link Aggregation Control Protocol-Multi-Active Detection (LACP-MAD) is a detection mechanism deployed by
switches to recover from a breakup of the Virtual Switching Framework (VSF) stack due to link or other failure.

LACP-MAD is implemented by sending extended LACP data units (LACPDUs) with a type length value (TLV) that
conveys the active ID of an VSF virtual device. The active ID is identical to the member ID of the master and is
thus unique to the VSF virtual device. When LACP MAD detection is enabled, the members exchange their active
IDs by sending extended LACPDUs.

Chapter 13
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• When the VSF virtual device operates normally, the active IDs in the extended LACPDUs sent by all members
are the same, indicating that there is no multi-active collision.

• When there is a breakup in the VSF stack, the active IDs in the extended LACPDUs sent by the members in
different VSF virtual devices are different, indicating that there are multi-active collisions.

LACP-MAD passthrough helps VSF-capable devices detect multi-access and take corrective action. These
devices do not initiate transmission of LACP-MAD frames or participate in any MAD decision making process.
These devices simply forward LACP-MAD TLVs received on one interface to the other interfaces on the trunk.
LACP-MAD passthrough can be enabled for 24 LACP trunks. By default, LACP-MAD passthrough is disabled.
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The following table lists the switch scalability values for the areas of VLANs, ACLs, hardware, ARP, and routing.

Subject Maximum

IPv4 ACLs

total named (extended or standard) Up to 2048 (minus any IPv4 numeric standard or extended ACL
assignments and any RADIUS-assigned ACLs)11

total numbered standard Up to 99

total numbered extended Up to 10011

total ACEs in all IPv4 ACLs Up to 307211

Layer-3

VLANs with at least one IP Address 512

IP addresses per system 2048 IPv4

2048 IPv6

IP addresses per VLAN 32

Static routes (IPv4 and IPv6
combined)

256

IPv4 host hardware table 72 K (8K internal, 64K external)

IPv4 BMP hardware table 2 K

ARP

ARP entries 25,000

Packets held for ARP resolution 25

Dynamic Routing

Total routes supported IPv4 only: 10,000 (including ARP)

IPv4 and IPv6: 10 K (IPv4) and 3 K

(IPv6)

IPv6 only: 5 K

IPv4 Routing Protocol

RIP interfaces 128

Table Continued
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Subject Maximum

IPv6 Routing Protocol

DHCPv6 Helper Addresses 32 unique addresses; multiple instances of same address counts as 1
towards maximum

1 

256 Aruba 2530 Management and Configuration Guide for ArubaOS-Switch 16.05

Anexo 04 ITEM 11 (0592666)         SEI 0008478-63.2018.6.02.8000 / pg. 6080



Overview
The switches support several methods for transferring files to and from a physically connected device, or via the
network, including TFTP and Xmodem. This appendix explains how to download new switch software, upload or
download switch configuration files and software images, and upload command files for configuring ACLs.

Downloading switch software
HPE Switch periodically provides switch software updates through the Switch Networking website. For more
information, see the support and warranty booklet shipped with the switch, or visit http://www.hpe.com/
networking and click on software updates.

This manual uses the terms switch software and software image to refer to the downloadable
software files the switch uses to operate its networking features. Other terms sometimes include
Operating System, or OS.

General software download rules

• Switch software that you download via the menu interface always goes to primary flash.

• After a software download, you must reboot the switch to implement the new software. Until a reboot occurs,
the switch continues to run on the software it was using before the download.

Downloading new switch software does not change the current switch configuration. The switch
configuration is contained in separate files that can also be transferred. See Transferring switch
configurations on page 273.

In most cases, if a power failure or other cause interrupts a flash image download, the switch reboots
with the image previously stored in primary flash. In the unlikely event that the primary image is
corrupted (which may occur if a download is interrupted by a power failure), the switch goes into boot
ROM mode. In this case, use the boot ROM console to download a new image to primary flash.

Using TFTP to download software from a server
This procedure assumes that:

• A software version for the switch has been stored on a TFTP server accessible to the switch. (The software file
is typically available from the HPE Switch Networking website at http://www.hpe.com/networking.)

• The switch is properly connected to your network and has already been configured with a compatible IP
address and subnet mask.

• The TFTP server is accessible to the switch via IP.

Before you use the procedure, do the following:

Chapter 15
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• Obtain the IP address of the TFTP server in which the software file has been stored.

• If VLANs are configured on the switch, determine the name of the VLAN in which the TFTP server is operating.

• Determine the name of the software file stored in the TFTP server for the switch (For example, E0820.swi).

If your TFTP server is a UNIX workstation, ensure that the case (upper or lower) that you specify for
the filename is the same case as the characters in the software filenames on the server.

Downloading from a server to primary flash using TFTP (Menu)
Note that the menu interface accesses only the primary flash.

Procedure

1. In the console Main Menu, select Download OS to display the screen in Figure 37: Example: of a download
OS (software) screen (default values) on page 258. (The term "OS" or "operating system" refers to the
switch software):

Figure 37: Example: of a download OS (software) screen (default values)

2. Press [E] (for Edit ).

3. Ensure that the Method field is set to TFTP (the default).

4. In the TFTP Server field, enter the IP address of the TFTP server in which the software file has been stored.

5. In the Remote File Name field, enter the name of the software file (if you are using a UNIX system, remember
that the filename is case-sensitive).

6. Press [Enter], then [X] (for eXecute ) to begin the software download.
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The following screen appears:

Figure 38: Example: of the download OS (software) screen during a download

A "progress" bar indicates the progress of the download. When the entire software file has been received, all
activity on the switch halts and you will see Validating and writing system software to FLASH...

7. After the primary flash memory is updated with the new software, you must reboot the switch to implement the
newly downloaded software. Return to the Main Menu and press [6] (for Reboot Switch ).

You will see this prompt:

Continue reboot of system? : No

Press the space bar once to change No to Yes, then press [Enter] to begin the reboot.

When you use the menu interface to download a switch software, the new image is always stored
in primary flash. Also, using the Reboot Switch command in the Main Menu always reboots the
switch from primary flash. Rebooting the switch from the CLI provides more options. See
"Rebooting the Switch" in the basic operation guide.

8. After you reboot the switch, confirm that the software downloaded correctly:

a. From the Main Menu, select

2. Switch Configuration...

2. Port/Trunk Settings

b. Check the Firmware revision line.

For troubleshooting information on download failures, see Troubleshooting TFTP download failures on page
260.
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Troubleshooting TFTP download failures

Cause

When using the menu interface, if a TFTP download fails, the Download OS (Operating System, or software)
screen indicates the failure as seen in the following figure.

Figure 39: Example: of message for download failure

Some of the causes of download failures include:

• Incorrect or unreachable address specified for the TFTP Server parameter. This may include network
problems.

• Incorrect VLAN.

• Incorrect name specified for the Remote File Name parameter, or the specified file cannot be found on the
TFTP server. This can also occur if the TFTP server is a UNIX machine and the case (upper or lower) for the
filename on the server does not match the case for the filename entered for the Remote File Name parameter
in the Download OS (Operating System, or software) screen.

• One or more of the switch's IP configuration parameters are incorrect.

• For a UNIX TFTP server, the file permissions for the software file do not allow the file to be copied.

• Another console session (through either a direct connection to a terminal device or through Telnet) was
already running when you started the session in which the download was attempted.

To find more information on the cause of a download failure:

• Examine the messages in the switch's Event Log by executing the show log tftp command from the CLI.

• For descriptions of individual Event Log messages, see the latest version of the event log message reference
guide for your switch, available on the HPE Switch website. (See "Getting Documentation From the Web".)

If an error occurs in which normal switch operation cannot be restored, the switch automatically
reboots itself, and an appropriate message is displayed after the reboot.
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Downloading from a server to flash using TFTP (CLI)
Syntax:

copy tftp flash <ip-address> <remote-file> [<primary | secondary>]
Automatically downloads a switch software file to primary or secondary flash. If you do not specify the flash
destination, the TFTP download defaults to primary flash.

Example:

To download a switch software file named k0800.swi from a TFTP server with the IP address of 10.28.227.103 to
primary flash:

Procedure

1. Execute copy as shown below:
The command to download an OS (switch software)

switch# copy tftp flash 10.28.227.103 k0800.swi
The primary OS Image will be deleted, continue [y/n]? y 1
01431K 2

• 1This message means that the image you want to upload will replace the image currently in primary flash.

• 2Dynamic counter continually displays the number of bytes transferred.

When the switch finishes downloading the software file from the server, it displays this progress message:

Validating and Writing System Software to FLASH ...
2. When the download finishes, you must reboot the switch to implement the newly downloaded software image.

To do so, use one of the following commands:

Syntax:

boot system flash {<primary | secondary>}
Boots from the selected flash.

Syntax:

reload
Boots from the flash image and startup-config file. A switch covered in this guide (with multiple configuration
files), also uses the current startup-config file.

For more information on these commands, see "Rebooting the Switch" in the basic operation guide for your
switch.

3. To confirm that the software downloaded correctly, execute show system and check the Firmware revision
line.

For information on primary and secondary flash memory and the boot commands, see "Using Primary and
Secondary Flash Image Options" in the basic operation guide for your switch.

If you use auto-tftp to download a new image in a redundant management system, the active
management module downloads the new image to both the active and standby modules. Rebooting
after the auto-tftp process completes reboots the entire system.
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Using SCP and SFTP
For some situations you may want to use a secure method to issue commands or copy files to the switch. By
opening a secure, encrypted SSH session and enabling ip ssh file transfer, you can then use a third-party
software application to take advantage of SCP and SFTP. SCP and SFTP provide a secure alternative to TFTP
for transferring information that may be sensitive (like switch configuration files) to and from the switch.
Essentially, you are creating a secure SSH tunnel as a way to transfer files with SFTP and SCP channels.

Once you have configured your switch to enable secure file transfers with SCP and SFTP, files can be copied to
or from the switch in a secure (encrypted) environment and TFTP is no longer necessary.

To use these commands, you must install on the administrator workstation a third-party application software client
that supports the SFTP and/or SCP functions. Some examples of software that supports SFTP and SCP are
PuTTY, Open SSH, WinSCP, and SSH Secure Shell. Most of these are freeware and may be downloaded without
cost or licensing from the internet. There are differences in the way these clients work, so be sure you also
download the documentation.

As described earlier in this chapter you can use a TFTP client on the administrator workstation to update software
images. This is a plain-text mechanism that connects to a standalone TFTP server or another HPE switch acting
as a TFTP server to obtain the software image files. Using SCP and SFTP allows you to maintain your switches
with greater security. You can also roll out new software images with automated scripts that make it easier to
upgrade multiple switches simultaneously and securely.

SFTP is unrelated to FTP, although there are some functional similarities. Once you set up an SFTP session
through an SSH tunnel, some of the commands are the same as FTP commands. Certain commands are not
allowed by the SFTP server on the switch, such as those that create files or folders. If you try to issue commands
such as create or remove using SFTP, the switch server returns an error message.

You can use SFTP just as you would TFTP to transfer files to and from the switch, but with SFTP, your file
transfers are encrypted and require authentication, so they are more secure than they would be using TFTP.
SFTP works only with SSH version 2 (SSH v2).

SFTP over SSH version 1 (SSH v1) is not supported. A request from either the client or the switch
(or both) using SSH v1 generates an error message. The actual text of the error message differs,
depending on the client software in use. Some examples are:

Protocol major versions differ: 2 vs. 1
Connection closed

Protocol major versions differ: 1 vs. 2
Connection closed

Received disconnect from <ip-addr> : /usr/local/libexec/
sftp-server: command not supported
Connection closed

SCP is an implementation of the BSD rcp (Berkeley UNIX remote copy) command tunneled through an SSH
connection.

SCP is used to copy files to and from the switch when security is required. SCP works with both SSH v1 and SSH
v2. Be aware that the most third-party software application clients that support SCP use SSHv1.

The general process for using SCP and SFTP involves three steps:

Procedure

1. Open an SSH tunnel between your computer and the switch if you have not already done so.
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(This step assumes that you have already set up SSH on the switch.)

2. Execute ip ssh filetransfer to enable secure file transfer.

3. Use a third-party client application for SCP and SFTP commands.

Enabling SCP and SFTP
For more information about secure copy and SFTP, see Using SCP and SFTP on page 262.

Procedure

1. Open an SSH session as you normally would to establish a secure encrypted tunnel between your computer
and the switch.

For more detailed directions on how to open an SSH session, see "Configuring secure shell (SSH)" in the
access security guide for your switch. Please note that this is a one-time procedure for new switches or
connections. If you have already done it once you should not need to do it a second time.

2. To enable secure file transfer on the switch (once you have an SSH session established between the switch
and your computer), open a terminal window and enter the following command:

switch(config)# ip ssh filetransfer

For information on disabling TFTP and auto-TFTP, see Disabling TFTP and auto-TFTP for enhanced security
on page 263.

Disabling TFTP and auto-TFTP for enhanced security
Using the ip ssh filetransfer command to enable SFTP automatically disables TFTP and auto-TFTP (if
either or both are enabled), as shown in Switch configuration with SFTP enabled on page 263.

Switch configuration with SFTP enabled

switch(config)# ip ssh filetransfer
Tftp and auto-tftp have been disabled. 1
switch(config)# sho run

Running configuration:

; J9091A Configuration Editor; Created on release #xx.15.xx

hostname "HP Switch"
module 1 type J8702A
module 2 type J702A
vlan 1
   name "DEFAULT_VLAN"
   untagged A1-A24,B1-B24
   ip address 10.28.234.176 255.255.240.0
   exit
ip ssh filetransfer 2
no tftp-enable
password manager
password operator
1 Enabling SFTP automatically disables TFTP and auto-tftp and displays this message.
2 Viewing the configuration shows that SFTP is enabled and TFTP is disabled.

If you enable SFTP and then later disable it, TFTP and auto-TFTP remain disabled unless they are explicitly re-
enabled.
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Operating rules are:

• The TFTP feature is enabled by default, and can be enabled or disabled through the CLI, the Menu interface
(see Figure 40: Using the Menu interface to disable TFTP on page 264), or an SNMP application. Auto-
TFTP is disabled by default and must be configured through the CLI.

Figure 40: Using the Menu interface to disable TFTP

• While SFTP is enabled, TFTP and auto-TFTP cannot be enabled from the CLI. Attempting to enable either
non-secure TFTP option while SFTP is enabled produces one of the following messages in the CLI:

SFTP must be disabled before enabling tftp.

SFTP must be disabled before enabling auto-tftp.
Similarly, while SFTP is enabled, TFTP cannot be enabled using an SNMP management application.
Attempting to do so generates an "inconsistent value" message. (An SNMP management application cannot
be used to enable or disable auto-TFTP.)

• To enable SFTP by using an SNMP management application, you must first disable TFTP and, if configured,
auto-TFTP on the switch. You can use either an SNMP application or the CLI to disable TFTP, but you must
use the CLI to disable auto-TFTP.

The following CLI commands disable TFTP and auto-TFTP on the switch.

Syntax:

no tftp-enable
This command disables all TFTP operation on the switch except for the auto-TFTP feature. To re-enable TFTP
operation, use the tftp-enable command. When TFTP is disabled, the instances of tftp in the CLI copy
command and the Menu interface “Download OS” screen become unavailable.

This command does not disable auto-TFTP operation. To disable an auto- TFTP command
configured on the switch, use the no auto-tftp command described below to remove the
command entry from the switch’s configuration.
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Syntax:

no auto-tftp
If auto-TFTP is configured on the switch, this command deletes the auto-tftp entry from the switch
configuration, thus preventing auto-tftp operation if the switch reboots.

This command does not affect the current TFTP-enable configuration on the switch.

Enabling SSH V2 (required for SFTP)

switch(config)# ip ssh version 2

As a matter of policy, administrators should not enable the SSH V1-only or the SSH V1-or-V2
advertisement modes. SSHv1 is supported on only some legacy switches (such as the HPE Switch
Series 2500 switches).

Confirming that SSH is enabled

switch(config)# show ip ssh
Once you have confirmed that you have enabled an SSH session (with the show ip ssh command), enter ip
ssh filetransfer so that SCP and/or SFTP can run. You can then open your third-party software client
application to begin using the SCP or SFTP commands to safely transfer files or issue commands to the switch.

Any attempts to use SCP or SFTP without using ip ssh filetransfer cause the SCP or SFTP
session to fail. Depending on the client software in use, you will receive an error message on the
originating console, for Example:

IP file transfer not enabled on the switch
Disabling secure file transfer

switch(config)# no ip ssh filetransfer

Authentication
Switch memory allows up to ten public keys. This means the authentication and encryption keys you use for your
third-party client SCP/SFTP software can differ from the keys you use for the SSH session, even though both
SCP and SFTP use a secure SSH tunnel.

SSH authentication is mutually exclusive with RADIUS servers.

Some clients, such as PSCP (PuTTY SCP), automatically compare switch host keys for you. Other clients require
you to manually copy and paste keys to the $HOME/.ssh/known_hosts file. Whatever SCP/SFTP software tool
you use, after installing the client software you must verify that the switch host keys are available to the client.

Because the third-party software utilities you may use for SCP/SFTP vary, you should refer to the documentation
provided with the utility you select before performing this process.
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SCP/SFTP operating notes

• Any attempts to use SCP or SFTP without using ip ssh filetransfer will cause the SCP or SFTP session to fail.
Depending on the client software in use, you will receive an error message on the originating console, for
Example:

IP file transfer not enabled on the switch
• There is a delay when SFTP is copying an image onto the switch, and although the command prompt returns

in a couple of seconds, the switch may take approximately a minute and half writing the image to flash. You
can keep entering the show flash command to see when the copy is complete and the flash is updated. You
can also check the log for an entry similar to the following:

I 01/09/13 16:17:07 00150 update: Primary Image updated.

I 01/09/13 16:13:22 00636 ssh: sftp session from 15.22.22.03
• When an SFTP client connects, the switch provides a file system displaying all of its available files and folders.

No file or directory creation is permitted by the user. Files may be only uploaded or downloaded, according to
the permissions mask. All of the necessary files the switch needs are already in place on the switch. You do
not need to (nor can you) create new files.

• The switch supports one SFTP session or one SCP session at a time.

• All files have read-write permission. Several SFTP commands, such as create or remove, are not allowed
and return an error message. The switch displays the following files:

/
+---cfg
|   running-config
|   startup-config
+---log
|   crash-data
|   crash-data-a
|   crash-data-b 
|   crash-data-c 
|   crash-data-d 
|   crash-data-e            "      "
|   crash-data-f ""
|   crash-data-g
|   crash-data-h            "      "
|   crash-data-I ""
|   crash-data-J ""
|   crash-data-K ""
|   crash-data-L "    "
|   crash-log
|   crash-log-a
|   crash-log-b 
|   crash-log-c 
|   crash-log-d
|   crash-log-e""
|   crash-log-f""
|   crash-log-g
|   crash-log-h" "
|   crash-log-I" "
|   crash-log-J" "
|   crash-log-K" "
|   crash-log-L" "
|   event log
+---os
|   primary
|   secondary
\---ssh
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    +---mgr_keys
    |   authorized_keys
    \---oper_keys
    |   authorized_keys
\---core
|   port_1-24.cor    core-dump for ports 1-24 (stackable switches only)
|   port_25-48.cor   core-dump for ports 25-48 (stackable switches only)

Once you have configured your switch for secure file transfers with SCP and SFTP, files can be copied to or from
the switch in a secure (encrypted) environment and TFTP is no longer necessary.

Troubleshooting SSH, SFTP, and SCP operations

Cause

You can verify secure file transfer operations by checking the switch's event log, or by viewing the error messages
sent by the switch that most SCP and SFTP clients print out on their console.

Messages that are sent by the switch to the client depend on the client software in use to display
them on the user console.

Broken SSH connection
If an ssh connection is broken at the wrong moment (for instance, the link goes away or spanning tree brings
down the link), a fatal exception occurs on the switch. If this happens, the switch gracefully exits the session and
produces an Event Log message indicating the cause of failure. The following three examples show the error
messages that may appear in the log, depending on the type of session that is running (SSH, SCP, or SFTP):

ssh: read error Bad file number, session aborted I 01/01/90
00:06:11 00636 ssh: sftp session from ::ffff:10.0.12.35 W
01/01/90 00:06:26 00641 ssh:

sftp read error Bad file number, session aborted I 01/01/90
00:09:54 00637 ssh: scp session from ::ffff:10.0.12.35 W 01/
01/90

ssh: scp read error Bad file number, session aborted

The Bad file number is from the system error value and may differ depending on the cause of
the failure. In the third Example:, the device file to read was closed as the device read was about to
occur.

Attempt to start a session during a flash write
If you attempt to start an SCP (or SFTP) session while a flash write is in progress, the switch does not allow the
SCP or SFTP session to start. Depending on the client software in use, the following error message may appear
on the client console:

Received disconnect from 10.0.12.31: 2: Flash access in
progress

lost connection

Failure to exit from a previous session
This next Example: shows the error message that may appear on the client console if a new SCP (or SFTP)
session is started from a client before the previous client session has been closed (the switch requires
approximately ten seconds to timeout the previous session):
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Received disconnect from 10.0.12.31: 2: Wait for previous
session to complete

lost connection

Attempt to start a second session
The switch supports only one SFTP session or one SCP session at a time. If a second session is initiated (For
example, an SFTP session is running and then an SCP session is attempted), the following error message may
appear on the client console:

Received disconnect from 10.0.12.31: 2: Other SCP/SFTP
session running

lost connection

Using Xmodem to download switch software from a PC or UNIX
workstation
This procedure assumes that:

• The switch is connected via the Console RS-232 port to a PC operating as a terminal. (For information on
connecting a PC as a terminal and running the switch console interface, see the installation and getting started
guide you received with the switch.)

• The switch software is stored on a disk drive in the PC.

• The terminal emulator you are using includes the Xmodem binary transfer feature. (For example, in the
HyperTerminal application included with Windows NT, you would use the Send File option in the Transfer
drop-down menu.)

Downloading to primary flash using Xmodem (Menu)

The menu interface accesses only the primary flash.

Procedure

1. From the console Main Menu, select

7. Download OS

2. Press [E] (for Edit).

3. Use the Space bar to select XMODEM in the Method field.

4. Press [Enter], then [X] (for eXecute) to begin the software download.

The following message appears:

Press enter and then initiate Xmodem transfer from the attached computer.....

5. Press [Enter] and then execute the terminal emulator commands to begin Xmodem binary transfer.

For example, using HyperTerminal:
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a. Click on Transfer, then Send File.

b. Enter the file path and name in the Filename field.

c. In the Protocol field, select Xmodem.

d. Click on the [Send] button.

The download then commences. It can take several minutes, depending on the baud rate set in the switch and
in your terminal emulator.

6. After the primary flash memory has been updated with the new software, you must reboot the switch to
implement the newly downloaded software. Return to the Main Menu and press [6] (for Reboot Switch). You
then see the following prompt:

Continue reboot of system? : No

Press the space bar once to change No to Yes, then press [Enter] to begin the reboot.

7. To confirm that the software downloaded correctly:

a. From the Main Menu, select

1. Status and Counters

1. General System Information

b. Check the Firmware revision line.

Downloading to primary or secondary flash using Xmodem and a terminal emulator
(CLI)
Syntax:

copy xmodem flash [<primary | secondary>]
Downloads a software file to primary or secondary flash. If you do not specify the flash destination, the Xmodem
download defaults to primary flash.

Example:

To download a switch software file named E0822.swi from a PC (running a terminal emulator program such as
HyperTerminal) to primary flash:

Procedure

1. Execute the following command in the CLI:

switch# copy xmodem flash
Press 'Enter and start XMODEM on your host...

2. Execute the terminal emulator commands to begin the Xmodem transfer. For example, using HyperTerminal:

a. Click on Transfer, then Send File.

b. Type the file path and name in the Filename field.
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c. In the Protocol field, select Xmodem.

d. Click on the [Send] button.

The download can take several minutes, depending on the baud rate used in the transfer.

3. When the download finishes, you must reboot the switch to implement the newly downloaded software. To do
so, use one of the following commands:
Syntax:

boot system flash {<primary | secondary>}
Reboots from the selected flash

Syntax:

reload
Reboots from the flash image currently in use

For more information on these commands, see “Rebooting the Switches” in the basic operation guide for your
switch.

4. To confirm that the software downloaded correctly:

switch# show system
Check the Firmware revision line. It should show the software version that you downloaded in the preceding
steps.

If you need information on primary/secondary flash memory and the boot commands, see "Using Primary and
Secondary Flash Image Options" in the basic operation guide for your switch.

Switch-to-switch download
You can use TFTP to transfer a software image between two switches of the same series. The CLI enables all
combinations of flash location options. The menu interface enables you to transfer primary-to-primary or
secondary-to-primary.

Switch-to-switch download to primary flash (Menu)
Using the menu interface, you can download a switch software file from either the primary or secondary flash of
one switch to the primary flash of another switch of the same series.

Procedure

1. From the switch console Main Menu in the switch to receive the download, select 7. Download OS screen.

2. Ensure that the Method parameter is set to TFTP (the default).

3. In the TFTP Server field, enter the IP address of the remote switch containing the software file you want to
download.

4. For the Remote File Name , enter one of the following:

a. To download the software in the primary flash of the source switch, enter
flash
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in lowercase characters.

b. To download the software in the secondary flash of the source switch, enter
/os/secondary
.

5. Press [Enter], and then [X] (for eXecute ) to begin the software download.

A "progress" bar indicates the progress of the download. When the entire switch software download has been
received, all activity on the switch halts and the following messages appear:

Validating and writing system software to FLASH...

6. After the primary flash memory has been updated with the new software, you must reboot the switch to
implement the newly downloaded software. Return to the Main Menu and press [6] (for Reboot Switch ). You
then see this prompt:

Continue reboot of system? : No

Press the space bar once to change No to Yes, then press [Enter] to begin the reboot.

7. To confirm that the software downloaded correctly:

a. From the Main Menu, select

Status and Counters

General System Information

b. Check the Firmware revision line.

Downloading the OS from another switch (CLI)
Where two switches in your network belong to the same series, you can download a software image between
them by initiating a copy tftp command from the destination switch. The options for this CLI feature include:

• Copy from primary flash in the source to either primary or secondary in the destination.

• Copy from either primary or secondary flash in the source to either primary or secondary flash in the
destination.

Downloading from primary only (CLI)
Syntax:

copy tftp flash <ip-addr> flash [primary | secondary]
When executed in the destination switch, downloads the software flash in the source switch's primary flash to
either the primary or secondary flash in the destination switch.

If you do not specify either a primary or secondary flash location for the destination, the download automatically
goes to primary flash.

To download a software file from primary flash in a switch with an IP address of 10.29.227.103 to the primary flash
in the destination switch, you would execute the following command in the destination switch's CLI:
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Switch-to-switch, from primary in source to either flash in destination

switch# copy tftp flash 10.29.227.13 flash
Device will be rebooted, do you want to continue [y/n]? y
00107K 1

1Running Total of Bytes Downloaded

Downloading from either flash in the source switch to either flash in the destination
switch (CLI)
Syntax:

copy tftp flash <ip-addr> {</os/primary> | </os/secondary>} [primary | secondary]
This command (executed in the destination switch) gives you the most options for downloading between switches.
If you do not specify either a primary or secondary flash location for the destination, the download automatically
goes to primary flash.

To download a software file from secondary flash in a switch with an IP address of 10.28.227.103 to the
secondary flash in a destination switch, you would execute the following command in the destination switch's CLI:

Switch-to-switch, from either flash in source to either flash in destination

switch# copy tftp flash 10.29.227.13 flash /os/secondary secondary
Device will be rebooted, do you want to continue [y/n]? y
00184K

Using AirWave to update switch software
AirWave can be used to update HPE switch products. For further information, refer to the ZTP with Airwave
network Management chapter in this manual.

Using IMC to update switch software
IMC includes a software update utility for updating on HPE switch products. For further information, refer to the
getting started guide and the administrator’s guide, provided electronically with the application.

Copying software images
For details on how switch memory operates, including primary and secondary flash, see “Switch
Memory and Configuration” in the basic operation guide for your switch.

TFTP: Copying a software image to a remote host (CLI)
Syntax:

copy flash tftp <ip-addr> <filename>
Copies the primary flash image to a TFTP server.

Example:

To copy the primary flash to a TFTP server having an IP address of 10.28.227.105:
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switch# copy flash tftp 10.28.227.105 k0800.swi
where k0800.swi is the filename given to the flash image being copied.

Xmodem: Copying a software image from the switch to a serially connected
PC or UNIX workstation (CLI)
To use this method, the switch must be connected via the serial port to a PC or UNIX workstation.

Syntax:

copy flash xmodem {[<pc] | unix>}
Uses Xmodem to copy a designated configuration file from the switch to a PC or UNIX workstation.

Example:

To copy the primary flash image to a serially connected PC:

Procedure

1. Execute the following command:

switch# copy xmodem flash
Press 'Enter' and start XMODEM on your host...

2. After you see the above prompt, press [Enter].

3. Execute the terminal emulator commands to begin the file transfer.

Transferring switch configurations
Using the CLI commands described in the section beginning with TFTP: Copying a configuration file to a
remote host (CLI) on page 273, you can copy switch configurations to and from a switch, or copy a software
image to configure or replace an ACL in the switch configuration.

For greater security, you can perform all TFTP operations using SFTP, as described in the section 
Using SCP and SFTP on page 262.

You can also use the include-credentials command to save passwords, secret keys, and other
security credentials in the running config file. For more information, see the section on "Saving
Security Credentials in a Config File" in the access security guide for your switch.

TFTP: Copying a configuration file to a remote host (CLI)
Syntax:

copy {<startup-config | running-config>} tftp < ip-addr > < remote-file > [pc | unix]

copy config <filename> tftp <ip-addr> <remote-file> [pc | unix]
This command can copy a designated config file in the switch to a TFTP server. For more information, see
"Multiple Configuration Files" in the basic operation guide for your switch.

Example:

To upload the current startup configuration to a file named sw8200 in the configs directory on drive "d" in a TFTP
server having an IP address of 10.28.227.105:

Chapter 15 File Transfers 273

Anexo 04 ITEM 11 (0592666)         SEI 0008478-63.2018.6.02.8000 / pg. 6097



switch# copy startup-config tftp 10.28.227.105
   d:\configs\sw8200

TFTP: Copying a configuration file from a remote host (CLI)
Syntax:

copy tftp {<startup-config | running-config> < ip-address > < remote-file >} [pc | unix]

copy tftp config <filename> <ip-address> <remote-file> [pc | unix]
This command can copy a configuration from a remote host to a designated config file in the switch. For more
information, see "Multiple Configuration Files" in the basic operation guide for your switch.

For more information on flash image use, see "Using Primary and Secondary Flash Image Options" in the basic
operation guide for your switch.

Example:

To download a configuration file named sw8200 in the configs directory on drive "d" in a remote host having an
IP address of 10.28.227.105:

switch# copy tftp startup-config 10.28.227.105
   d:\configs\sw8200

TFTP: Copying a customized command file to a switch (CLI)
Using the copy tftp command with the show-tech option provides the ability to copy a customized command
file to the switch. When the show tech custom command is executed, the commands in the custom file are
executed instead of the hard-coded list of commands. If no custom file is found, the current hard-coded list is
executed. This list contains commands to display data, such as the image stamp, running configuration, boot
history, port settings, and so on.

Syntax:

copy tftp show-tech <ipv4 or ipv6 address> <filename>
Copies a customized command file to the switch (see Using the copy tftp show-tech command to upload a
customized command file on page 274).

Using the copy tftp show-tech command to upload a customized command file

switch(config)# copy tftp show-tech 10.10.10.3 commandfile1
Syntax:

show tech custom
Executes the commands found in a custom file instead of the hard-coded list.

Exit the global config mode (if needed) before executing show tech commands.

You can include show tech commands in the custom file, with the exception of show tech custom. For
example, you can include the command show tech all.

If no custom file is found, a message displays stating "No SHOW-TECH file found." (No custom file was uploaded
with the copy tftp show-tech command.)
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The show tech custom command

switch# show tech custom
No SHOW-TECH file found.

Xmodem: Copying a configuration file to a serially connected PC or UNIX
workstation (CLI)
To use this method, the switch must be connected via the serial port to a PC or UNIX workstation. You will need
to:

• Determine a filename to use

• Know the directory path you will use to store the configuration file.

Syntax:

copy {<startup-config | running-config>} xmodem {<pc | unix>}

copy config <filename> xmodem {<pc | unix>}
Uses Xmodem to copy a designated configuration file from the switch to a PC or UNIX workstation. For more
information, see "Multiple Configuration Files" in the basic operation guide for your switch.

Example:

To copy a configuration file to a PC serially connected to the switch:

1. Determine the file name and directory location on the PC.

2. Execute the following command:

switch# copy startup-config xmodem pc
Press 'Enter' and start XMODEM on your host...

3. After you see the above prompt, press [Enter].

4. Execute the terminal emulator commands to begin the file transfer.

Xmodem: Copying a configuration file from a serially connected PC or
UNIX workstation (CLI)
To use this method, the switch must be connected via the serial port to a PC or UNIX workstation on which is
stored the configuration file you want to copy. To complete the copying, you need to know the name of the file to
copy and the drive and directory location of the file.

Syntax:

copy xmodem startup-config {<pc | unix>}

copy xmodem config <filename> < {pc | unix>}
Copies a configuration file from a serially connected PC or UNIX workstation to a designated configuration file on
the switch.

For more information, see "Multiple Configuration Files" in the basic operation guide for your switch.
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Example:

To copy a configuration file from a PC serially connected to the switch:

Procedure

1. Execute the following command:

switch# copy xmodem startup-config pc
Device will be rebooted, do you want to continue [y/n]? y
Press 'Enter' and start XMODEM on your host...

2. After you see the above prompt, press [Enter].

3. Execute the terminal emulator commands to begin the file transfer.

4. When the download finishes, you must reboot the switch to implement the newly downloaded software. To do
so, use one of the following commands:

Syntax:

boot system flash [primary | secondary]

boot system flash [config < filename >]
Switches boot from the designated configuration file. For more information, see "Multiple Configuration Files"
in the basic operation guide for your switch.

Syntax:

reload

Reboots from the flash image currently in use.

(For more on these commands, see "Rebooting the Switch" in the basic operation guide for your switch.)

Copying diagnostic data to a remote host, PC or UNIX
workstation
You can use the CLI to copy the following types of switch data to a text file in a destination device:

Command output

Sends the output of a switch CLI command as a file on the destination device.

Event log

Copies the switch's Event Log into a file on the destination device.

Crash data

Software-specific data useful for determining the reason for a system crash.

Crash log

Processor-specific operating data useful for determining the reason for a system crash.

Flight data recorder (FDR) logs

Information that is “interesting” at the time of the crash, as well as when the switch is not performing correctly
but has not crashed.

The destination device and copy method options are as follows (CLI keyword is in bold):
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• Remote Host via TFTP.

• Serially connected PC or UNIX workstation via Xmodem.

Copying command output to a destination device (CLI)
Syntax:

copy command-output <"cli-command"> tftp <ip-address> <filepath-filename>

copy command-output <"cli-command"> xmodem
Example:

To use Xmodem to copy the output of show config to a serially connected PC:

Figure 41: Sending command output to a file on an attached PC

The command you specify must be enclosed in double quotation marks.

Copying Event Log output to a destination device (CLI)
Syntax:

copy event-log tftp <ip-address> <filepath_filename>

copy event-log xmodem <filename>
Example:

To copy the event log to a PC connected to the switch:

Figure 42: Sending event log content to a file on an attached PC

Copying crash data content to a destination device (CLI)
This command uses TFTP, USB or Xmodem to copy the Crash Data content to a destination device.

Syntax:

copy crash-data tftp <ip-address> <filename>

copy crash-data xmodem

Chapter 15 File Transfers 277

Anexo 04 ITEM 11 (0592666)         SEI 0008478-63.2018.6.02.8000 / pg. 6101



These commands copy the crash data content to a remote host, attached USB device, or to a serially connected
PC or UNIX workstation.

slot-id a - h—Retrieves the crash log or crash data from the processor on the module in the specified
slot

mm Retrieves crash log or crash data from the switch's chassis processor. When "mm" is specified,
crash files from both management modules are copied.

oobm For switches that have a separate OOBM port, specifies that the transfer is through the OOBM
interface. (Default is transfer through the data interface.)

You can copy individual slot information or the management module (mm) switch information. If you do not specify
either, the command defaults to the mm data.

To copy the switch's crash data to a file in a PC:

Copying switch crash data content to a PC

switch(config)# copy crash-data xmodem pc
Press 'Enter' and start XMODEM on your host... 

Transfer complete

At this point press [Enter] and start the Xmodem command sequence in your terminal emulator.
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Overview
The switches have several built-in tools for monitoring, analyzing, and troubleshooting switch and network
operation:

• Status: Includes options for displaying general switch information, management address data, port status, port
and trunk group statistics, MAC addresses detected on each port or VLAN, and STP, IGMP, and VLAN data.

• Counters: Display details of traffic volume on individual ports.

• Event Log: Lists switch operating events (Using the Event Log for troubleshooting switch problems on
page 327 ).

• Alert Log: Lists network occurrences detected by the switch—in the System > Logging screen of the
WebAgent.

• Configurable trap receivers: Uses SNMP to enable management stations on your network to receive SNMP
traps from the switch.

• Port monitoring (mirroring): Copy all traffic from the specified ports to a designated monitoring port.

• Chassis Locator LED: The blue Locator LED lights up when you enter the chassislocate command.

Link test and ping test—analysis tools in troubleshooting situations—are described in 
Troubleshooting on page 303. See Diagnostic tools on page 365.

Accessing port and trunk group statistics
Use the CLI to view port counter summary reports, and to view detailed traffic summary for specific ports.

show interfaces
Syntax
show interfaces <PORT-LIST>
        
Description

Provides an overview of port activity for all ports on the switch or for the ports you specify. Displays the totals
accumulated since the last boot or the last execution of the clear statistics command.

Parameters and options
<PORT-LIST>

View port activity for specific ports.

Reset port counters
When troubleshooting network issues, you can clear all counters and statistics without rebooting the switch using
the clear statistics global command or using the menu.

Chapter 16
Monitoring and Analyzing Switch Operation
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SNMP displays the counter and statistics totals accumulated since the last reboot, and it is not affected by the
clear statistics global command or the clear statistics <PORT-LIST> command. Clearing
statistics initiates an SNMP trap.

Once cleared, statistics cannot be reintroduced.

clear statistics
Syntax
clear statistics [<PORT-LIST>|global]
      
Description

This command clears all counters and statistics for all interfaces except SNMP.

Parameters and options
<PORT-LIST>

Clears the counters and statistics for specific ports.

global
Clears all counters and statistics for all interfaces except SNMP.
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Accessing port and trunk statistics (Menu)

Procedure

1. From the Main Menu, select 1. Status and Counters ... , and then select 4. Port Counters.

Figure 43: Example of port counters on the menu interface

2. To view details about the traffic on a particular port, use the ↓ key to highlight that port number, and then select
Show Details . For example, selecting port A2 displays a screen similar to the example below.

Figure 44: Example of the display for Show Details on a selected port

This screen also includes the Reset action for the current session.

MAC address tables

MAC address views and searches
You can view and search MAC addresses using the CLI or the menu.

show mac-address
Syntax
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show mac-address [vlan <VLAN-ID>] [<PORT-LIST>] [<MAC-ADDR>]
Description

Lists all MAC addresses on the switch and their corresponding port numbers. You can also choose to list specific
addresses and ports, or addresses and ports on a VLAN. The switches operate with a multiple forwarding
database architecture.

List all learned MAC addresses on the switch and corresponding port numbers

switch# show mac-address

List all learned MAC addresses on one or more ports and corresponding port numbers

switch# show mac-address a1-a4,a6

List all learned MAC addresses on a VLAN and corresponding port numbers

switch# show mac-address vlan 100

List the port on which the switch learned a specific MAC address

To find the port on which the switch learns a MAC address of 080009-21ae84:

Using the menu to view and search MAC addresses
To determine which switch port on a selected VLAN the switch uses to communicate with a specific device on the
network:

Procedure

1. From the Main Menu, select 1. Status and Counters ... , and then select 5. VLAN Address Table.

2. Use the arrow keys to scroll to the VLAN you want, and then press Enter on the keyboard to select it.
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The switch then displays the MAC address table for that VLAN (Figure 45: Example of the address table on
page 283.)

Figure 45: Example of the address table

3. To page through the listing, use Next page and Prev page .

Finding the port connection for a specific device on a VLAN
This feature uses a device's MAC address that you enter to identify the port used by that device.

Procedure

1. Proceeding from Figure 45: Example of the address table on page 283, press [S] (for Search ), to display
the following prompt:

Enter MAC address: _
2. Enter the MAC address you want to locate and press [Enter].
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3. The address and port number are highlighted if found (Figure 46: Example of menu indicating located MAC
address on page 284.) If the switch does not find the MAC address on the currently selected VLAN, it leaves
the MAC address listing empty.

Figure 46: Example of menu indicating located MAC address

4. Press [P] (for Prev page ) to return to the full address table listing.

Viewing and searching port-level MAC addresses
This feature displays and searches for MAC addresses on the specified port instead of for all ports on the switch.

Procedure

1. From the Main Menu, select:

1. Status and Counters ...

7. Port Address Table

2. Use the Space bar to select the port you want to list or search for MAC addresses, then press [Enter] to list
the MAC addresses detected on that port.

Determining whether a specific device is connected to the selected port
Proceeding from Step 2, above:

Procedure

1. Press [S] (for Search), to display the following prompt:

Enter MAC address: _
2. Enter the MAC address you want to locate and press [Enter].

The address is highlighted if found. If the switch does not find the address, it leaves the MAC address listing
empty.

3. Press [P] (for Prev page) to return to the previous per-port listing.

MSTP data
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show spanning-tree
Syntax
show spanning-tree
Description

Displays the global and regional spanning-tree status for the switch, and displays the per-port spanning-tree
operation at the regional level.

Values for the following parameters appear only for ports connected to active devices: Designated Bridge,
Hello Time, PtP, and Edge.

show spanning-tree command output

Figure 47: show spanning-tree command output

IP IGMP status
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show ip igmp
Syntax
show ip igmp <VLAN-ID> [config] [group <IP-ADDR>|groups] [statistics]
        
Description

Global command that lists IGMP status for all VLANs configured in the switch, including:

• VLAN ID (VID) and name

• Querier address

• Active group addresses per VLAN

• Number of report and query packets per group

• Querier access port per VLAN

Parameters and options
config

Displays the IGMP configuration information, including VLAN ID, VLAN name, status, forwarding, and Querier
information.

vlan-id

Per-VLAN command listing above, IGMP status for specified VLAN (VID).

group <IP-ADDR>
Lists the ports currently participating in the specified group, with port type, Access type, Age Timer data and
Leave Timer data.

groups
Displays VLAN-ID, group address, uptime, expiration time, multicast filter type, and the last reporter for IGMP
groups.

statistics
Displays IGMP operational information, such as VLAN IDs and names, and filtered and flooding statistics.

Output from show ip igmp config command

IGMP statistical information

switch(vlan-2)# show ip igmp statistics

 IGMP Service Statistics
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  Total VLANs with IGMP enabled               : 1
  Current count of multicast groups joined    : 1

 IGMP Joined Groups Statistics

  VLAN ID VLAN Name                        Filtered     Flood
  ------- -------------------------------- ------------ ------------
  2       VLAN2                            2            1

VLAN information

show vlan
Syntax
show vlan <VLAN-ID>
        
Description

Lists the maximum number of VLANs to support, existing VLANS, VLAN status (static or dynamic), and primary
VLAN.

Parameters and options
<VLAN-ID>

Lists the following for the specified VLAN:

• Name, VID, and status (static/dynamic)

• Per-port mode (tagged, untagged, forbid, no/auto)

• "Unknown VLAN" setting (Learn, Block, Disable)

• Port status (up/down)

List data on specific VLANs

The next three figures show how you can list data for the following VLANs:

Ports VLAN VID

A1-A12 DEFAULT_VLAN 1

Table Continued
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A1, A2 VLAN-33 33

A3, A4 VLAN-44 44

Figure 48: Listing the VLAN ID (vid) and status for specific ports

Figure 49: Example of VLAN listing for the entire switch

Figure 50: Port listing for an individual VLAN

Configuring a source switch in a local mirroring session
Enter the mirror port command on the source switch to configure an exit port on the same switch. To create
the mirroring session, use the information gathered in High-level overview of the mirror configuration process
on page 292.
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Syntax

mirror 1 - 4 port exit-port-# [name name-str] no mirror 1- 4
Assigns the exit port to use for the specified mirroring session and must be executed from the global configuration
level.

1 - 4 Identifies the mirroring session created by this command. (Multiple
sessions on the switch can use the same exit port.)

name name-str Optional alphanumeric name string used to identify the session
( up to 15 characters)

port exit-port-
#

Exit port for mirrored traffic in the remote session. This is the port
to which a traffic analyzer or IDS is connected.

The no form of the command removes the mirroring session and any mirroring source previously assigned to that
session.

Selecting all traffic on a port interface for mirroring
according to traffic direction
Syntax

[no] interface port/trunk/mesh monitor [in | out | both] [mirror 1 - 4 | name-str] 
[{1 - 4 | name-str} | {1 - 4 | name-str} | {1 - 4 | name-str}] [no-tag-added]
Assigns a mirroring source to a previously configured mirroring session on a source switch by specifying the port,
trunk, and/or mesh sources to use, the direction of traffic to mirror, and the session.

interface port/trunk/mesh Identifies the source ports, static trunks, and/or mesh on which to mirror
traffic.

Use a hyphen for a range of consecutive ports or trunks (a5-a8, Trk2-
Trk4.)

Use a comma to separate non-contiguous interfaces (b11, b14, Trk4,
Trk7.)

monitor all [in | out | 
both]

For the interface specified by port/trunk/mesh , selects traffic to mirror based
on whether the traffic is entering or leaving the switch on the interface:

• in: Mirrors entering traffic.

• out: Mirrors exiting traffic.

• both: Mirrors traffic entering and exiting.

If you enter the monitor all command without selection criteria or a
session identifier, the command applies by default to session 1

Table Continued
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mirror [1 - 4 | name-str]
Assigns the traffic specified by the interface and direction to a session by
number or—if configured—by name. The session must have been
previously configured.

Depending on how many sessions are already configured on the switch, you
can use the same command to assign the specified source to up to four
sessions, for example, interface a1 monitor all in mirror 1 2
4.

• 1 - 4: Configures the selected port traffic to be mirrored in the specified
session number.

• [ name name-str]: Optional; configures the selected port traffic to be
mirrored in the specified session name. The string can be used
interchangeably with the session number when using this command to
assign a mirroring source to a session.

[no-tag-added] Prevents a VLAN tag from being added to the mirrored copy of an outbound
packet sent to a local or remote mirroring destination.

The no form of the command removes a mirroring source assigned to the session, but does not remove the
session itself. This enables you to repurpose a session by removing an unwanted mirroring source and adding
another in its place.

Viewing all mirroring sessions configured on the switch
Syntax

show monitor
If a monitored source for a remote session is configured on the switch, the following information is displayed.
Otherwise, the output displays: Mirroring is currently disabled.

Sessions Lists the four configurable sessions on the switch.

Status Displays the current status of each session:

• active: The session is configured.

• inactive: Only the destination has been configured; the mirroring source is not configured.

• not defined: Mirroring is not configured for this session.

Type Indicates whether the mirroring session is local (port), remote (IPv4), or MAC-based (mac) for
local or remote sessions.

Sources Indicates how many monitored source interfaces are configured for each mirroring session.

Policy Indicates whether the source is using a classifier-based mirroring policy to select inbound IPv4
or IPv6 traffic for mirroring.

If a remote mirroring endpoint is configured on the switch, the following information is displayed. Otherwise, the
output displays: There are no Remote Mirroring endpoints currently assigned.
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Type Indicates whether the mirroring session is local (port), remote (IPv4), or MAC-based
(mac) for local or remote sessions.

UDP Source Addr The IP address configured for the source VLAN or subnet on which the monitored
source interface exists. In the configuration of a remote session, the same UDP source
address must be configured on the source and destination switches.

UDP port The unique UDP port number that identifies a remote session. In the configuration of a
remote session, the same UDP port number must be configured on the source and
destination switches.

UDP Dest Addr The IP address configured for the destination VLAN or subnet on which the remote exit
port exists. In the configuration of a remote session, the same UDP destination address
must be configured on the source and destination switches.

Dest Port Identifies the exit port for a remote session on a remote destination switch.

Figure 51: Displaying the currently configured mirroring sessions on the switch

Viewing the mirroring configuration for a specific session
Syntax

show monitor [1 - 4 | name name-str]
Displays detailed configuration information for a specified local mirroring session on a source switch.

Session Displays the number of the specified session.

Session Name Displays the name of the session, if configured.

Policy Indicates whether the source is using a classifier-based mirroring policy to select
inbound IPv4 or IPv6 traffic for mirroring.

Mirroring Destination For a local mirroring session, displays the port configured as the exit port on the source
switch.

Table Continued
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Monitoring Sources For the specified local session, displays the source (port, trunk, or VLAN) interface and
the MAC address (if configured) used to select mirrored traffic.

Direction For the selected interface, indicates whether mirrored traffic is entering the switch (in),
leaving the switch (out), or both.

Using the Menu to configure local mirroring

Menu and WebAgent limits
You can use the Menu and WebAgent to quickly configure or reconfigure local mirroring on session 1 and allow
one of the following two mirroring source options:

• Any combination of source ports, trunks, and a mesh.

• One static, source VLAN interface.

The Menu and WebAgent also has these limits:

• Configure and display only session 1 and only as a local mirroring session for traffic in both directions on the
specified interface. (Selecting inbound-only or outbound-only is not an option.)

• If session 1 has been configured in the CLI for local mirroring for inbound-only or outbound-only traffic on one
or more interfaces, using the Menu to change the session 1 configuration automatically reconfigures the
session to monitor both inbound and outbound traffic on the designated interface(s.)

• If session 1 has been configured in the CLI with an ACL/classifier-based mirroring policy or as a remote
mirroring session, the Menu is not available for changing the session 1 configuration.

• The CLI (and SNMP) can be used to override any Menu configuration of session 1.

High-level overview of the mirror configuration process

Determine the mirroring session and destination

For a local mirroring session
Determine the port number for the exit port (such as A5, B10, and so forth), then go to Configure the monitored
traffic in a mirror session.

Configure the monitored traffic in a mirror session
This step configures one or more interfaces on a source switch with traffic-selection criteria to select the traffic to
be mirrored in a local session configured in section.

Classifier-based mirroring configuration
1. Evaluate the types of traffic in your network and identify the traffic types that you want to mirror.

2. Create an IPv4 or IPv6 traffic class using the class command to select the packets that you want to mirror in
a session on a preconfigured local or remote destination device.

A traffic class consists of match criteria, which consist of match and ignore commands.
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• match commands define the values that header fields must contain for a packet to belong to the class and
be managed by policy actions.

• ignore commands define the values which, if contained in header fields, exclude a packet from the policy
actions configured for the class.

Be sure to enter match/ignore statements in the precise order in which you want their criteria to
be used to check packets.

The following match criteria are supported in match/ignore statements for inbound IPv4/IPv6 traffic:

• IP source address (IPv4 and IPv6)

• IP destination address (IPv4 and IPv6)

• IP protocol (such as ICMP or SNMP)

• Layer 3 IP precedence bits

• Layer 3 DSCP codepoint

• Layer 4 TCP/UDP application port (including TCP flags)

• VLAN ID

Enter one or more match or ignore commands from the class configuration context to filter traffic and
determine the packets on which policy actions will be performed.

3. Create a mirroring policy to configure the session and destination device to which specified classes of inbound
traffic are sent by entering the policy mirror command from the global configuration context.

Be sure to enter each class and its associated mirroring actions in the precise order in which you
want packets to be checked and processed.

To configure the mirroring actions that you want to execute on packets that match the criteria in a specified
class, enter one or more class action mirror commands from the policy configuration context.

You can configure only one mirroring session (destination) for each class. However, you can configure the
same mirroring session for different classes.

A packet that matches the match criteria in a class is mirrored to the exit (local or remote) port that has been
previously configured for the session, where session is a value from 1 to 4 or a text string (if you configured the
session with a name when you entered the mirror command.)

Prerequisite: The local or remote exit port for a session must be already configured before you enter the
mirror session parameter in a class action statement:

• In a local mirroring session, the exit port is configured with the mirror <session-number> port
command

• In a remote mirroring session, the remote exit port is configured with the mirror endpoint ip and
mirror <session-number> remote ip commands.

Restriction: In a policy, you can configure only one mirroring session per class. However, you can configure the
same session for different classes.

Mirroring is not executed on packets that match ignore criteria in a class.
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The execution of mirroring actions is performed in the order in which the classes are numerically listed in the
policy.

The complete no form of the class action mirror command or the no <seq-number> command
removes a class and mirroring action from the policy configuration.

To manage packets that do not match the match or ignore criteria in any class in the policy, and therefore have
no mirroring actions performed on them, you can enter an optional default class. The default class is placed at
the end of a policy configuration and specifies the mirroring actions to perform on packets that are neither
matched nor ignored.

4. (Optional) To configure a default-class in a policy, enter the default-class command at the end of a policy
configuration and specify one or more actions to be executed on packets that are not matched and not
ignored.

Prerequisite: The local or remote exit port for a session must be already configured with a destination device
before you enter the mirror <session> parameter in a default-class action statement.

5. Apply the mirroring policy to inbound traffic on a port (interface service-policy in command) or VLAN
(vlan service-policy in command) interface.

After you apply a mirroring policy for one or more preconfigured sessions on a port or VLAN
interface, the switch immediately starts to use the traffic-selection criteria and exit port to mirror
traffic to the destination device connected to each exit port.

In a remote mirroring session that uses IPv4 encapsulation, if the remote switch is not already
configured as the destination for the session, its performance may be adversely affected by the
stream of mirrored traffic.

For this reason, Hewlett Packard Enterprise strongly recommends that you first configure the exit
switch in a remote mirroring session before you apply a mirroring service policy on a port or VLAN
interface.

Restrictions: The following restrictions apply to a mirroring service policy:

• Only one mirroring policy is supported on a port or VLAN interface.

• If you apply a mirroring policy to a port or VLAN interface on which a mirroring policy is already configured,
the new policy replaces the existing one.

• A mirroring policy is supported only on inbound traffic.

Because only one mirroring policy is supported on a port or VLAN interface, ensure that the policy you want to
apply contains all the required classes and actions for your configuration.

Classifier-based mirroring restrictions
The following restrictions apply to mirroring policies configured with the classifier-based model:

• A mirroring policy is supported only on inbound IPv4 or IPv6 traffic.

• A mirroring policy is not supported on a meshed port interface. (Classifier-based policies are supported only on
a port, VLAN, or trunk interface.)

• Only one classifier-based mirroring policy is supported on a port or VLAN interface. You can, however, apply a
classifier-based policy of a different type, such as QoS.

• You can enter multiple class action mirror statements in a policy.
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◦ You can configure only one mirroring session (destination) for each class.

◦ You can configure the same mirroring session for different classes.

• If a mirroring session is configured with a classifier-based mirroring policy on a port or VLAN interface, no
other traffic-selection criteria (MAC-based or all inbound and/or outbound traffic) can be added to the session.

Figure 52: Mirroring configuration in which only a mirroring policy is supported

• If a mirroring session is already configured with one or more traffic-selection criteria (MAC-based or all inbound
and/or outbound traffic), the session does not support the addition of a classifier-based policy.

Figure 53: Mirroring configuration in which only traffic-selection criteria are supported

Mirroring configuration examples

Local mirroring using traffic-direction criteria

An administrator wants to mirror the inbound traffic from workstation "X" on port A5 and workstation "Y" on port
B17 to a traffic analyzer connected to port C24 (see Figure 54: Local mirroring topology on page 296.) In this
case, the administrator chooses "1" as the session number. (Any unused session number from 1 to 4 is valid.)
Because the switch provides both the source and destination for the traffic to monitor, local mirroring can be used.
In this case, the command sequence is:
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• Configure the local mirroring session, including the exit port.

• Configure the monitored source interfaces for the session.

Figure 54: Local mirroring topology

Figure 55: Configuring a local mirroring session for all inbound and outbound port traffic

Maximum supported frame size
The IPv4 encapsulation of mirrored traffic adds a 54-byte header to each mirrored frame. If a resulting frame
exceeds the MTU allowed in the network, the frame is dropped or truncated.

Oversized mirroring frames are dropped or truncated, according to the setting of the [truncation]
parameter in the mirror command. Also, remote mirroring does not allow downstream devices in a
mirroring path to fragment mirrored frames.

If jumbo frames are enabled on the mirroring source switch, the mirroring destination switch and all
downstream devices connecting the source switch to the mirroring destination must be configured to
support jumbo frames.

Enabling jumbo frames to increase the mirroring path MTU
On 1-Gbps and 10-Gbps ports in the mirroring path, you can reduce the number of dropped frames by enabling
jumbo frames on all intermediate switches and routers. (The MTU on the switches covered by this manual is 9220
bytes for frames having an 802.1Q VLAN tag, and 9216 bytes for untagged frames.)

296 Aruba 2530 Management and Configuration Guide for ArubaOS-Switch 16.05

Anexo 04 ITEM 11 (0592666)         SEI 0008478-63.2018.6.02.8000 / pg. 6120



Table 23: Maximum frame sizes for mirroring

Frame type
configuration

Maximum
frame size

VLAN tag Frame
mirrored
to local
port

Frame mirrored to remote
port

Data Data IPv4 header

Untagged Non-jumbo (default
config.)

1518 0 1518 1464 54

Jumbo on all VLANs 9216 0 9216 9162 54

Jumbo11 On all but
source VLAN

1518 0 n/a 1464 54

Tagged Non-jumbo 1522 4 1522 1468 54

Jumbo11 on all VLANs 9220 4 9218 9164 54

Jumbo11 On all but
source VLAN

1522 4 n/a22 1468 54

1 Jumbo frames are allowed on ports operating at or above 1 Gbps
2 For local mirroring, a non-jumbo configuration on the source VLAN dictates an MTU of 1518 bytes for untagged frames, and

an MTU of 1522 for tagged frames, regardless of the jumbo configuration on any other VLANs on the switch.

Effect of downstream VLAN tagging on untagged,
mirrored traffic
In a remote mirroring application, if mirrored traffic leaves the switch without 802.1Q VLAN tagging, but is
forwarded through a downstream device that adds 802.1Q VLAN tags, the MTU for untagged mirrored frames
leaving the source switch is reduced below the values shown in Maximum frame sizes for mirroring.
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For example, if the MTU on the path to the destination is 1522 bytes, untagged mirrored frames leaving the
source switch cannot exceed 1518 bytes. Likewise, if the MTU on the path to the destination is 9220 bytes,
untagged mirrored frames leaving the source switch cannot exceed 9216 bytes.

Figure 56: Effect of downstream VLAN tagging on the MTU for mirrored traffic

Operating notes for traffic mirroring

• Mirroring dropped traffic

When an interface is configured to mirror traffic to a local or remote destination, packets are mirrored
regardless of whether the traffic is dropped while on the interface. For example, if an ACL is configured on a
VLAN with a deny ACE that eliminates packets from a Telnet application, the switch still mirrors the Telnet
packets that are received on the interface and subsequently dropped.

• Mirroring and spanning tree

Mirroring is performed regardless of the STP state of a port or trunk. This means, for example, that inbound
traffic on a port blocked by STP can still be monitored for STP packets during the STP setup phase.

• Tagged and untagged frames

For a frame entering or leaving the switch on a mirrored port, the mirrored copy retains the tagged or untagged
state the original frame carried when it entered into or exited from the switch. (The tagged or untagged VLAN
membership of ports in the path leading to the mirroring destination does not affect the tagged or untagged
status of the mirrored copy itself.)

Thus, if a tagged frame arrives on a mirrored port, the mirrored copy is also tagged, regardless of the status of
ports in the destination path. If a frame exits from the switch on a mirrored port that is a tagged member of a
VLAN, the mirrored copy is also tagged for the same reason.

To prevent a VLAN tag from being added to the mirrored copy of an outbound packet sent to a mirroring
destination, you must enter the no-tag-added parameter when you configure a port, trunk, or mesh interface
to select mirrored traffic.

• Effect of IGMP on mirroring

If both inbound and outbound mirroring is operating when IGMP is enabled on a VLAN, two copies of mirrored
IGMP frames may appear at the mirroring destination.
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• Mirrored traffic not encrypted

Mirrored traffic undergoes IPv4 encapsulation, but mirrored encapsulated traffic is not encrypted.

• IPv4 header added

The IPv4 encapsulation of mirrored traffic adds a 54-byte header to each mirrored frame. If a resulting frame
exceeds the maximum MTU allowed in the network, it is dropped or truncated (according to the setting of the
[truncation] parameter in the mirror command.)

To reduce the number of dropped frames, enable jumbo frames in the mirroring path, including all intermediate
switches and/or routers. (The MTU on the switch is 9220 bytes, which includes 4 bytes for the 802.1Q VLAN
tag.)

• Intercepted or injected traffic

The mirroring feature does not protect against either mirrored traffic being intercepted or traffic being injected
into a mirrored stream by an intermediate host.

• Inbound mirrored IPv4-encapsulated frames are not mirrored

The switch does not mirror IPv4-encapsulated mirrored frames that it receives on an interface. This prevents
duplicate mirrored frames in configurations where the port connecting the switch to the network path for a
mirroring destination is also a port whose inbound or outbound traffic is being mirrored.

For example, if traffic leaving the switch through ports B5, B6, and B7 is being mirrored through port B7 to a
network analyzer, the mirrored frames from traffic on ports B5 and B6 will not be mirrored a second time as
they pass through port B7.

• Switch operation as both destination and source

A switch configured as a remote destination switch can also be configured to mirror traffic to one of its own
ports (local mirroring) or to a destination on another switch (remote mirroring.)

• Monitor command note

If session 1 is already configured with a destination, you can enter the [no] vlan <VID>monitor or [no]
interface <PORT> monitor command without mirroring criteria and a mirror session number. In this
case, the switch automatically configures or removes mirroring for inbound and outbound traffic from the
specified VLAN or ports to the destination configured for session 1.

• Loss of connectivity suspends remote mirroring

When a remote mirroring session is configured on a source switch, the switch sends an ARP request to the
configured destination approximately every 60 seconds. If the source switch fails to receive the expected ARP
response from the destination for the session, transmission of mirrored traffic in the session halts. However,
because the source switch continues to send ARP requests for each configured remote session, link
restoration or discovery of another path to the destination enables the source switch to resume transmitting the
session's mirrored traffic after a successful ARP response cycle occurs.

Note that if a link's connectivity is repeatedly interrupted ("link toggling"), little or no mirrored traffic may be
allowed for sessions using that link. To verify the status of any mirroring session configured on the source
switch, use the show monitor command.
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Troubleshooting traffic mirroring
Cause

If mirrored traffic does not reach the configured remote destination (endpoint) switch or remote exit port, check the
following configurations:

• If the destination for mirrored traffic is on a different VLAN than the source, routing must be correctly
configured along the path from the source to the destination.

• All links on the path from the source switch to the destination switch must be active.

A mirroring exit port should be connected only to a network analyzer, IDS, or other network edge
device that has no connection to other network resources. Configuring a mirroring exit port
connection to a network can result in serious network performance problems, and is strongly
discouraged by HPE Aruba.

Interface monitoring features
You can designate monitoring of inbound and outbound traffic on ports and static trunks. This allows the
monitoring of individual ports, groups of contiguous ports, and static port trunks.

The switch monitors network activity by copying all traffic inbound and outbound on the specified interfaces to the
designated monitoring port, to which a network analyzer can be attached.

If a tagged packet arrives on a monitored port, the packet will remain tagged when it goes out a monitored port
even if that port is configured as untagged. If the packet is untagged, it will remain untagged going out the monitor
port. The monitor port state (tagged or untagged) does not affect the tagging of the packet. However, egress
mirroring does not reflect the tagged or untagged characteristic to the mirror port, instead it reflects the tagged or
untagged characteristic of the mirror port.

When both inbound and outbound monitoring is done, and IGMP is enabled on any VLAN, you may
get two copies of IGMP packets on the monitored port.

VLANs and port trunks cannot be used as a monitoring port.

The switch can monitor static LACP trunks, but not dynamic LACP trunks.

It is possible, when monitoring multiple interfaces in networks with high traffic levels, to copy more
traffic to a monitor port than the link can support. In this case, some packets may not be copied to
the monitor port.

Configuring port and static trunk monitoring (Menu)
This procedure describes configuring the switch for monitoring when monitoring is disabled. (If monitoring has
already been enabled, the screens will appear differently than shown in this procedure.)

1. From the console Main Menu, select:2. Switch Configuration... 3. Network Monitoring Port

2. In the Actions menu, press [E] (for Edit).

3. If monitoring is currently disabled (the default) then enable it by pressing the Space bar (or [Y]) to select Yes.

4. Press the down arrow key to display a screen similar to the following and move the cursor to the Monitoring
Port parameter.

5. Use the Space bar to select the port to use for monitoring.

300 Aruba 2530 Management and Configuration Guide for ArubaOS-Switch 16.05

Anexo 04 ITEM 11 (0592666)         SEI 0008478-63.2018.6.02.8000 / pg. 6124



6. Use the down arrow key to move the cursor to the Action column for the individual ports and position the
cursor at a port you want to monitor.

7. Press the Space bar to select Monitor for each port and trunk that you want monitored. (Use the down arrow
key to move from one interface to the next in the Action column.)

8. When you finish selecting ports to monitor, press [Enter], then press [S] (for Save ) to save your changes and
exit from the screen.

9. Return to the Main Menu.

Configuring port and static trunk monitoring (CLI)
You must use the following configuration sequence to configure port and static trunk monitoring in the CLI:

1. Assign a monitoring (mirror) port.

2. Designate the port(s) and/or static trunk(s) to monitor.

Displaying the monitoring configuration
Syntax:

show monitor
This command lists the port assigned to receive monitored traffic and the ports and/or trunks being monitored.

For example, if you assign port 5 as the monitoring port and configure the switch to monitor ports 2-4, show
monitor displays the following:

Monitored port listing

switch(config)# show monitor

 Network Monitoring Port

  Mirror Port: 4

  Monitoring sources 
  ------------------
  2
  3
  4

• Port receiving monitored traffic.

• Monitored ports

Configuring the monitor port
Syntax:
[no] mirror-port [ <port-num> ]
    
This command assigns or removes a monitoring port, and must be executed from the global configuration level.
Removing the monitor port disables port monitoring and resets the monitoring parameters to their factory-default
settings.
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For example, to assign port 6 as the monitoring port:

switch(config)# mirror-port 6
To turn off monitoring:

switch(config)# no mirror-port

Selecting or removing monitoring source interfaces
After you configure a monitor port you can use either the global configuration level or the interface context level to
select ports or static trunks as monitoring sources. You can also use either level to remove monitoring sources.

Syntax:
[no] interface <monitor-list> monitor
    
<monitor-list>

Includes port numbers and static trunk names such as 4, 7, 5-8, trk1

Identifies the switch elements to monitor through the currently configured monitor port. You can monitor the ports
and static trunks available on the switch.

Elements in the monitor list can include port numbers and static trunk names at the same time.

For example, with a port such as port 6 configured as the monitoring (mirror) port, you would use either of the
following commands to select these interfaces for monitoring:

• 1–3, and 5

• Trunk 2

Selecting ports and static trunks as monitoring sources

switch(config)# int 1-3, 5, trk2, monitor

Disabling monitoring at the interface context and the global config level

switch(eth-1-3, 5)# no int 5 monitor 
switch(eth-1-3, 5)# no monitor

switch(config)# no int 5 monitor 
switch(config)# no int 1-3, 5 monitor

• These two commands show how to disable monitoring at the interface context level for a single port or all ports
in an interface context level.

• These two commands show how to disable monitoring at the global config level for a single port or a group of
ports.
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Overview
This chapter addresses performance-related network problems that can be caused by topology, switch
configuration, and the effects of other devices or their configurations on switch operation. (For switch-specific
information on hardware problems indicated by LED behavior, cabling requirements, and other potential
hardware-related problems, see the installation guide you received with the switch.)

HPE periodically places switch software updates on the HPE Switch Networking website. HPE
recommends that you check this website for software updates that may have fixed a problem you are
experiencing.

For information on support and warranty provisions, see the Support and Warranty booklet shipped with the
switch.

Troubleshooting approaches
Cause

Use these approaches to diagnose switch problems:

• Check the HPE website for software updates that may have solved your problem: http://www.hpe.com/
networking

• Check the switch LEDs for indications of proper switch operation:

◦ Each switch port has a Link LED that should light whenever an active network device is connected to the
port.

◦ Problems with the switch hardware and software are indicated by flashing the Fault and other switch
LEDs.For a description of the LED behavior and information on using the LEDs for troubleshooting, see the
installation guide shipped with the switch.

• Check the network topology/installation. For topology information, see the installation guide shipped with the
switch.

• Check cables for damage, correct type, and proper connections. You should also use a cable tester to check
your cables for compliance to the relevant IEEE 802.3 specification. For correct cable types and connector pin-
outs, see the installation guide shipped with the switch.

• Use the Port Utilization Graph and Alert Log in the WebAgent included in the switch to help isolate problems.
These tools are available through the WebAgent:

◦ Port Utilization Graph

◦ Alert log
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◦ Port Status and Port Counters screens

◦ Diagnostic tools (Link test, Ping test, configuration file browser)

• For help in isolating problems, use the easy-to-access switch console built into the switch or Telnet to the
switch console. For operating information on the Menu and CLI interfaces included in the console, see
chapters 3 and 4. These tools are available through the switch console:

◦ Status and Counters screens

◦ Event Log

◦ Diagnostics tools (Link test, Ping test, configuration file browser, and advanced user commands)

Browser or Telnet access problems

Cannot access the WebAgent

• Access may be disabled by the Web Agent Enabled parameter in the switch console. Check the setting on this
parameter by selecting:

2. Switch Configuration

1. System Information

• The switch may not have the correct IP address, subnet mask, or gateway. Verify by connecting a console to
the switch's Console port and selecting:

2. Switch Configuration

5. IP Configuration

Note: If DHCP/Bootp is used to configure the switch, the IP addressing can be verified by selecting:

1. Status and Counters...

2. Switch Management Address Information

Also check the DHCP/Bootp server configuration to verify correct IP addressing.

• If you are using DHCP to acquire the IP address for the switch, the IP address "lease time" may have expired
so that the IP address has changed. For more information on how to "reserve" an IP address, see the
documentation for the DHCP application that you are using.

• If one or more IP-authorized managers are configured, the switch allows inbound telnet access only to a
device having an authorized IP address. For more information on IP Authorized managers, see the access
security guide for your switch.

• Java™ applets may not be running on the web browser. They are required for the switch WebAgent to operate
correctly. Refer to the online Help on your web browser for how to run the Java applets.

Cannot Telnet into the switch console from a station on the network

• Off-subnet management stations can lose Telnet access if you enable routing without first configuring a static
(default) route. That is, the switch uses the IP default gateway only while operating as a Layer 2 device. While
routing is enabled on the switch, the IP default gateway is not used. You can avoid this problem by using the ip

304 Aruba 2530 Management and Configuration Guide for ArubaOS-Switch 16.05

Anexo 04 ITEM 11 (0592666)         SEI 0008478-63.2018.6.02.8000 / pg. 6128



route command to configure a static (default) route before enabling routing. For more information, see "IP
Routing Features" in the multicast and routing guide for your switch.

• Telnet access may be disabled by the Inbound Telnet Enabled parameter in the System Information
screen of the menu interface:

2. Switch Configuration

1. System Information

• The switch may not have the correct IP address, subnet mask, or gateway. Verify by connecting a console to
the switch's Console port and selecting:

2. Switch Configuration

5. IP Configuration

• If you are using DHCP to acquire the IP address for the switch, the IP address "lease time" may have expired
so that the IP address has changed. For more information on how to "reserve" an IP address, see the
documentation for the DHCP application that you are using.

• If one or more IP-authorized managers are configured, the switch allows inbound telnet access only to a
device having an authorized IP address. For more information on IP Authorized managers, see the access
security guide for your switch.

Unusual network activity
Network activity that fails to meet accepted norms may indicate a hardware problem with one or more of the
network components, possibly including the switch. Such problems can also be caused by a network loop or
simply too much traffic for the network as it is currently designed and implemented. Unusual network activity is
usually indicated by the LEDs on the front of the switch or measured with the switchconsole interface or with a
network management tool. For information on using LEDs to identify unusual network activity, see the installation
guide you received with the switch.

A topology loop can also cause excessive network activity. The Event Log "FFI" messages can be indicative of
this type of problem.

General problems

The network runs slow; processes fail; users cannot access servers or other devices
Broadcast storms may be occurring in the network. These may be caused by redundant links between nodes.

• If you are configuring a port trunk, finish configuring the ports in the trunk before connecting the related cables.
Otherwise you may inadvertently create a number of redundant links (that is, topology loops) that will cause
broadcast storms.

• Turn on STP to block redundant links

• Check for FFI messages in the Event Log

Duplicate IP addresses
This is indicated by this Event Log message:

ip: Invalid ARP source: IP address on IP address
where both instances of IP address are the same address, indicating that the switch's IP address has been
duplicated somewhere on the network.
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Duplicate IP addresses in a DHCP network
If you use a DHCP server to assign IP addresses in your network, and you find a device with a valid IP address
that does not appear to communicate properly with the server or other devices, a duplicate IP address may have
been issued by the server. This can occur if a client has not released a DHCP-assigned IP address after the
intended expiration time and the server "leases" the address to another device. This can also happen, For
example, if the server is first configured to issue IP addresses with an unlimited duration, and then is
subsequently configured to issue IP addresses that will expire after a limited duration. One solution is to configure
"reservations" in the DHCP server for specific IP addresses to be assigned to devices having specific MAC
addresses. For more information, see the documentation for the DHCP server.

One indication of a duplicate IP address in a DHCP network is this Event Log message:

ip: Invalid ARP source: <IP-address>
       on <IP-address>
where both instances of IP-address are the same address, indicating that the IP address has been duplicated
somewhere on the network.

The switch has been configured for DHCP/Bootp operation, but has not received a
DHCP or Bootp reply
When the switch is first configured for DHCP/Bootp operation, or if it is rebooted with this configuration, it
immediately begins sending request packets on the network. If the switch does not receive a reply to its DHCP/
Bootp requests, it continues to periodically send request packets, but with decreasing frequency. Thus, if a DHCP
or Bootp server is not available or accessible to the switch when DHCP/Bootp is first configured, the switch may
not immediately receive the desired configuration.

After verifying that the server has become accessible to the switch, reboot the switch to re-start the process.

802.1Q Prioritization problems

Ports configured for non-default prioritization (level 1 to 7) are not performing the
specified action
If the ports were placed in a trunk group after being configured for non-default prioritization, the priority setting
was automatically reset to zero (the default). Ports in a trunk group operate only at the default priority setting.

Addressing ACL problems

ACLs are properly configured and assigned to VLANs, but the switch is not using the
ACLs to filter IP layer 3 packets

Procedure

1. The switch may be running with IP routing disabled. To ensure that IP routing is enabled, execute show
running and look for the IP routing statement in the resulting listing. For Example:
Indication that routing is enabled

switch(config)# show running
Running configuration:
; J9091A Configuration Editor; Created on release #XX.15.06
hostname " HPswitch "
ip default-gateway 10.33.248.1
ip routing 1
logging 10.28.227.2
snmp-server community "public" Unrestricted
ip access-list extended "Controls for VLAN 20"
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permit tcp 0.0.0.0 255.255.255.255 10.10.20.98 0.0.0.0 eq 80
permit tcp 0.0.0.0 255.255.255.255 10.10.20.21 0.0.0.0 eq 80
deny tcp 0.0.0.0 255.255.255.255 10.10.20.1 0.0.0.255 eq 80
deny tcp 10.10.20.1? 0.0.0.0 10.10.10.100 0.0.0.0 eq 20 log
deny tcp 10.10.20.20 0.0.0.0 10.10.10.100 0.0.0.0 eq 20 log
deny tcp 10.10.20.43 0.0.0.0 10.10.10.100 0.0.0.0 eq 20 log
permit ip 10.10.20.1 0.0.0.255 10.10.10.100 0.0.0.0
deny ip 10.10.30.1 0.0.0.255 10.10.10.100 0.0.0.0
permit ip 10.10.30.1 0.0.0.255 10.10.10.1 0.0.0.255
exit

1

Indicates that routing is enabled, a requirement for ACL operation. (There is an exception. Refer to the Note,
below.)

If an ACL assigned to a VLAN includes an ACE referencing an IP address on the switch itself as
a packet source or destination, the ACE screens traffic to or from this switch address regardless
of whether IP routing is enabled. This is a security measure designed to help protect the switch
from unauthorized management access.

If you need to configure IP routing, execute the ip routing command.

2. ACL filtering on the switches applies only to routed packets and packets having a destination IP address (DA)
on the switch itself.

Also, the switch applies assigned ACLs only at the point where traffic enters or leaves the switch on a VLAN.
Ensure that you have correctly applied your ACLs ("in" and/or "out") to the appropriate VLANs.

The switch does not allow management access from a device on the same VLAN
The implicit deny any function that the switch automatically applies as the last entry in any ACL always blocks
packets having the same DA as the switch's IP address on the same VLAN. That is, bridged packets with the
switch itself as the destination are blocked as a security measure.

To preempt this action, edit the ACL to include an ACE that permits access to the switch's DA on that VLAN from
the management device.

Error (Invalid input) when entering an IP address
When using the "host" option in the Command syntax, ensure that you are not including a mask in either dotted
decimal or CIDR format. Using the "host" option implies a specific host device and therefore does not permit any
mask entry.

Correctly and incorrectly specifying a single host

Switch(config)# access-list 6 permit host 10.28.100.100 1

Switch(config)# access-list 6 permit host 10.28.100.100 255.255.255.2552 
Invalid input: 255.255.255.255

Switch(config)# access-list 6 permit host 10.28.100.100/32 3
Invalid input: 10.28.100.100/32
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• 1Correct.

• 2Incorrect. No mask needed to specify a single host.

• 3Incorrect. No mask needed to specify a single host.

Apparent failure to log all "deny" matches
Where the log statement is included in multiple ACEs configured with a "deny" option, a large volume of "deny"
matches generating logging messages in a short period of time can impact switch performance. If it appears that
the switch is not consistently logging all "deny" matches, try reducing the number of logging actions by removing
the log statement from some ACEs configured with the "deny" action.

The switch does not allow any routed access from a specific host, group of hosts, or
subnet
The implicit deny any function that the switch automatically applies as the last entry in any ACL may be blocking
all access by devices not specifically permitted by an entry in an ACL affecting those sources. If you are using the
ACL to block specific hosts, a group of hosts, or a subnet, but want to allow any access not specifically permitted,
insert permit any as the last explicit entry in the ACL.

The switch is not performing routing functions on a VLAN
Two possible causes of this problem are:

• Routing is not enabled. If show running indicates that routing is not enabled, use the ip routing
command to enable routing.

• An ACL may be blocking access to the VLAN (on a switch covered in this guide). Ensure that the switch's IP
address on the VLAN is not blocked by one of the ACE entries in an ACL applied to that VLAN. A common
mistake is to either not explicitly permit the switch's IP address as a DA or to use a wildcard ACL mask in a
deny statement that happens to include the switch's IP address. For an Example: of this problem, see section
"General ACL Operating Notes" in the "Access Control Lists (ACLs)" of the latest access security guide for
your switch.

Routing through a gateway on the switch fails
Configuring a "deny" ACE that includes a gateway address can block traffic attempting to use the gateway as a
next-hop.

Remote gateway case
Configuring ACL "101" (example below) and applying it outbound on VLAN 1 in the figure below includes the
router gateway (10.0.8.1) needed by devices on other networks. This can prevent the switch from sending ARP
and other routing messages to the gateway router to support traffic from authorized remote networks.
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In Figure 57: Inadvertently blocking a gateway on page 309, this ACE (see data in bold below) denies access
to the 10 Net's 10.0.8.1 router gateway needed by the 20 Net (Subnet mask is 255.255.255.0).See: example

Figure 57: Inadvertently blocking a gateway

To avoid inadvertently blocking the remote gateway for authorized traffic from another network (such as the 20
Net in this Example:):

Procedure

1. Configure an ACE that specifically permits authorized traffic from the remote network.

2. Configure narrowly defined ACEs to block unwanted IP traffic that would otherwise use the gateway; such
ACEs might deny traffic for a particular application, particular hosts, or an entire subnet.

3. Configure a "permit any" ACE to specifically allow any IP traffic to move through the gateway.

ACE blocking an entire subnet

switch(config)# access-list config

ip access-list extended "101"
  deny ip 0.0.0.0 255.255.255.255 10.0.8.30 0.0.0.255
  permit ip 0.0.0.0 255.255.255.255 0.0.0.00 255.255.255.255
  exit
      

Local gateway case
If you use the switch as a gateway for traffic you want routed between subnets, use these general steps to avoid
blocking the gateway for authorized applications:

Procedure

1. Configure gateway security first for routing with specific permit and deny statements.

2. Permit authorized traffic.

3. Deny any unauthorized traffic that you have not already denied in step 1 on page 309.

IGMP-related problems
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IP multicast (IGMP) traffic that is directed by IGMP does not reach IGMP hosts or a
multicast router connected to a port
IGMP must be enabled on the switch and the affected port must be configured for "Auto" or "Forward" operation.

IP multicast traffic floods out all ports; IGMP does not appear to filter traffic
The IGMP feature does not operate if the switch or VLAN does not have an IP address configured manually or
obtained through DHCP/Bootp. To verify whether an IP address is configured for the switch or VLAN, do one of
the following:

• Try using the WebAgent: If you can access the WebAgent, then an IP address is configured.

• Try to telnet to the switch console: If you can Telnet to the switch, an IP address is configured.

• Use the switch console interface: From the Main Menu, check the Management Address Information screen
by clicking on:

1. Status and Counters

2. Switch Management Address Information

LACP-related problems

Unable to enable LACP on a port with the interface <port-number> lacp
command
In this case, the switch displays the following message:

Operation is not allowed for a trunked port.
You cannot enable LACP on a port while it is configured as a static Trunk port. To enable LACP on a static-
trunked port:

Procedure

1. Use the no trunk <port-number> command to disable the static trunk assignment.

2. Execute interface <port-number> lacp .

Removing a port from a trunk without first disabling the port can create a traffic loop that can slow
down or halt your network. Before removing a port from a trunk, Hewlett Packard Enterprise
recommends that you either disable the port or disconnect it from the LAN.

Port-based access control (802.1X)-related problems
To list the 802.1X port-access Event Log messages stored on the switch, use show log 802.

See also Radius-related problems on page 313.

The switch does not receive a response to RADIUS authentication requests
In this case, the switch attempts authentication using the secondary method configured for the type of access you
are using (console, Telnet, or SSH).
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There can be several reasons for not receiving a response to an authentication request. Do the following:

• Use ping to ensure that the switch has access to the configured RADIUS servers.

• Verify that the switch is using the correct encryption key (RADIUS secret key) for each server.

• Verify that the switch has the correct IP address for each RADIUS server.

• Ensure that the radius-server timeout period is long enough for network conditions.

The switch does not authenticate a client even though the RADIUS server is properly
configured and providing a response to the authentication request
If the RADIUS server configuration for authenticating the client includes a VLAN assignment, ensure that the
VLAN exists as a static VLAN on the switch. See "How 802.1X Authentication Affects VLAN Operation" in the
access security guide for your switch.

During RADIUS-authenticated client sessions, access to a VLAN on the port used for
the client sessions is lost
If the affected VLAN is configured as untagged on the port, it may be temporarily blocked on that port during an
802.1X session. This is because the switch has temporarily assigned another VLAN as untagged on the port to
support the client access, as specified in the response from the RADIUS server. See "How 802.1X Authentication
Affects VLAN Operation" in the access security guide for your switch.

The switch appears to be properly configured as a supplicant, but cannot gain access
to the intended authenticator port on the switch to which it is connected
If aaa authentication port-access is configured for Local, ensure that you have entered the local login
(operator-level) username and password of the authenticator switch into the identity and secret parameters
of the supplicant configuration. If instead, you enter the enable (manager-level) username and password, access
will be denied.

The supplicant statistics listing shows multiple ports with the same authenticator MAC
address
The link to the authenticator may have been moved from one port to another without the supplicant statistics
having been cleared from the first port. See "Note on Supplicant Statistics" in the chapter on Port-Based and
User-Based Access Control in the access security guide for your switch.

The show port-access authenticator <port-list> command shows one or
more ports remain open after they have been configured with control unauthorized
802.1X is not active on the switch. After you execute aaa port-access authenticator active, all ports
configured with control unauthorized should be listed as Closed.

Authenticator ports remain "open" until activated

switch(config)# show port-access authenticator e 9
 Port Access Authenticator Status
  Port-access authenticator activated [No] : No
              Access Authenticator Authenticator
  Port Status Control  State Backend  State
  ---- ------ -------- -------------- --------------
  9    Open 1   FU       Force Auth     Idle

Switch(config)# show port-access authenticator active
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Switch(config)# show port-access authenticator e 9
 Port Access Authenticator Status
  Port-access authenticator activated [No] : Yes
              Access Authenticator Authenticator
  Port Status Control  State Backend  State
  ---- ------ -------- -------------- --------------
  9    Closed FU       Force Unauth   Idle

1Port A9 shows an “Open” status even though Access Control is set to Unauthorized (Force Auth). This is
because the port-access authenticator has not yet been activated.

RADIUS server fails to respond to a request for service, even though the server's IP
address is correctly configured in the switch
Use show radius to verify that the encryption key (RADIUS secret key) the switch is using is correct for the
server being contacted. If the switch has only a global key configured, it either must match the server key or you
must configure a server-specific key. If the switch already has a server-specific key assigned to the server's IP
address, it overrides the global key and must match the server key.

Displaying encryption keys

switch(config)# show radius
 Status and Counters - General RADIUS Information
  Deadtime(min) : 0
  Timeout(secs) : 5
  Retransmit Attempts : 3
  Global Encryption Key : My-Global-Key
  Dynamic Authorization UDP Port : 3799

                  Auth Acct DM/ Time
  Server IP Addr  Port Port CoA Window Encryption Key
  --------------- ---- ---- --- ------ ---------------
  10.33.18.119    1812 1813            119-only-key
Also, ensure that the switch port used to access the RADIUS server is not blocked by an 802.1X configuration on
that port. For example, show port-access authenticator <port-list> gives you the status for the
specified ports. Also, ensure that other factors, such as port security or any 802.1X configuration on the RADIUS
server are not blocking the link.

The authorized MAC address on a port that is configured for both 802.1X and port
security either changes or is re-acquired after execution of aaa port-access
authenticator <port-list> initialize
If the port is force-authorized with aaa port-access authenticator <port-list> control
authorized command and port security is enabled on the port, then executing initialize causes the port to
clear the learned address and learn a new address from the first packet it receives after you execute
initialize.

A trunked port configured for 802.1X is blocked
If you are using RADIUS authentication and the RADIUS server specifies a VLAN for the port, the switch allows
authentication, but blocks the port. To eliminate this problem, either remove the port from the trunk or reconfigure
the RADIUS server to avoid specifying a VLAN.

QoS-related problems
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Loss of communication when using VLAN-tagged traffic
If you cannot communicate with a device in a tagged VLAN environment, ensure that the device either supports
VLAN tagged traffic or is connected to a VLAN port that is configured as Untagged.

Radius-related problems

The switch does not receive a response to RADIUS authentication requests
In this case, the switch attempts authentication using the secondary method configured for the type of access you
are using (console, Telnet, or SSH).

There can be several reasons for not receiving a response to an authentication request. Do the following:

• Use ping to ensure that the switch has access to the configured RADIUS server.

• Verify that the switch is using the correct encryption key for the designated server.

• Verify that the switch has the correct IP address for the RADIUS server.

• Ensure that the radius-server timeout period is long enough for network conditions.

• Verify that the switch is using the same UDP port number as the server.

Because of an inconsistency between the Windows XP 802.1x supplicant timeout value and the
switch default timeout value, which is 5, when adding a backup RADIUS server, set the switch
radius-server timeout value to 4. Otherwise, the switch may not failover properly to the backup
RADIUS server.

RADIUS server fails to respond to a request for service, even though the server's IP
address is correctly configured in the switch
Use show radius to verify that the encryption key the switch is using is correct for the server being contacted. If
the switch has only a global key configured, it either must match the server key or you must configure a server-
specific key. If the switch already has a server-specific key assigned to the server's IP address, it overrides the
global key and must match the server key.

Global and unique encryption keys

Switch(config)# show radius
 Status and Counters - General RADIUS Information
  Deadtime(min) : 0
  Timeout(secs) : 5
  Retransmit Attempts : 3
  Global Encryption Key : My-Global-Key 1
  Dynamic Authorization UDP Port : 3799

                  Auth Acct DM/ Time
  Server IP Addr  Port Port CoA Window Encryption Key
  --------------- ---- ---- --- ------ ---------------
  10.33.18.119    1812 1813            119-only-key 2

• 1

Global RADIUS Encryption Key

• 2
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Unique RADIUS Encryption Key for the RADIUS server at 10.33.18.119

MSTP and fast-uplink problems
If you enable MSTP, Hewlett Packard Enterprise recommends that you leave the remainder of the
MSTP parameter settings at their default values until you have had an opportunity to evaluate MSTP
performance in your network. Because incorrect MSTP settings can adversely affect network
performance, you should avoid making changes without having a strong understanding of how MSTP
operates. To learn the details of MSTP operation, see the IEEE802.1s standard.

Broadcast storms appearing in the network
This can occur when there are physical loops (redundant links) in the topology. Where this exists, you should
enable MSTP on all bridging devices in the topology to detect the loop.

STP blocks a link in a VLAN even though there are no redundant links in that VLAN
In 802.1Q-compliant switches, MSTP blocks redundant physical links even if they are in separate VLANs. A
solution is to use only one, multiple-VLAN (tagged) link between the devices. Also, if ports are available, you can
improve the bandwidth in this situation by using a port trunk. See "Spanning Tree Operation with VLANs" in
"Static Virtual LANs (VLANs)" in the advanced traffic management guide for your switch.

Fast-uplink troubleshooting
Some of the problems that can result from incorrect use of fast-uplink MSTP include temporary loops and
generation of duplicate packets.

Problem sources can include:

• Fast-uplink is configured on a switch that is the MSTP root device.

• Either the Hello Time or the Max Age setting (or both) is too long on one or more switches. Return the
Hello Time and Max Age settings to their default values (2 seconds and 20 seconds, respectively, on a
switch).

• A "downlink" port is connected to a switch that is further away (in hop count) from the root device than the
switch port on which fast-uplink MSTP is configured.

• Two edge switches are directly linked to each other with a fast-uplink (Mode = Uplink) connection.

• Fast uplink is configured on both ends of a link.

• A switch serving as a backup MSTP root switch has ports configured for fast-uplink MSTP and has become
the root device because of a failure in the original root device.

SSH-related problems

Switch access refused to a client
Even though you have placed the client's public key in a text file and copied the file (using the copy tftp pub-
key-file command) into the switch, the switch refuses to allow the client to have access. If the source SSH
client is an SSHv2 application, the public key may be in the PEM format, which the switch (SSHv1) does not
interpret. Check the SSH client application for a utility that can convert the PEM-formatted key into an ASCII-
formatted key.
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Executing IP SSH does not enable SSH on the switch
The switch does not have a host key. Verify by executing show ip host-public-key. If you see the message

ssh cannot be enabled until a host key is configured (use 'crypto' command).
you need to generate an SSH key pair for the switch. To do so, execute crypto key generate (see
"Generating the switch's public and private key pair" in the SSH chapter of the access security guide for your
switch.)

Switch does not detect a client's public key that does appear in the switch's public key
file (show ip client-public-key)
The client's public key entry in the public key file may be preceded by another entry that does not terminate with a
new line (CR). In this case, the switch interprets the next sequential key entry as simply a comment attached to
the preceding key entry. Where a public key file has more than one entry, ensure that all entries terminate with a
new line (CR). While this is optional for the last entry in the file, not adding a new line to the last entry creates an
error potential if you either add another key to the file at a later time or change the order of the keys in the file.

An attempt to copy a client public-key file into the switch has failed and the switch lists
one of the following messages
Download failed: overlength key in key file.
Download failed: too many keys in key file.
Download failed: one or more keys is not a valid RSA public key.
The public key file you are trying to download has one of the following problems:

• A key in the file is too long. The maximum key length is 1024 characters, including spaces. This could also
mean that two or more keys are merged together instead of being separated by a <CR> <LF>.

• There are more than ten public keys in the key file.

• One or more keys in the file is corrupted or is not a valid rsa public key.

Client ceases to respond ("hangs") during connection phase
The switch does not support data compression in an SSH session. Clients often have compression turned on by
default, but then disable it during the negotiation phase. A client that does not recognize the compression-request
FAILURE response may fail when attempting to connect. Ensure that compression is turned off before attempting
a connection to prevent this problem.

TACACS-related problems

Event Log
When troubleshooting TACACS+ operation, check the switch's Event Log for indications of problem areas.

All users are locked out of access to the switch
If the switch is functioning properly, but no username/password pairs result in console or Telnet access to the
switch, the problem may be caused by how the TACACS+ server and/or the switch are configured. Use one of the
following methods to recover:
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• Access the TACACS+ server application and adjust or remove the configuration parameters controlling access
to the switch.

• If the above method does not work, try eliminating configuration changes in the switch that have not been
saved to flash (boot-up configuration) by causing the switch to reboot from the boot-up configuration (which
includes only the configuration changes made prior to the last write memory command.) If you did not use
write memory to save the authentication configuration to flash, pressing the Reset button reboots the
switch with the boot-up configuration.

• Disconnect the switch from network access to any TACACS+ servers and then log in to the switch using either
Telnet or direct console port access. Because the switch cannot access a TACACS+ server, it defaults to local
authentication. You can then use the switch's local Operator or Manager username/password pair to log on.

• As a last resort, use the Clear/Reset button combination to reset the switch to its factory default boot-up
configuration. Taking this step means you will have to reconfigure the switch to return it to operation in your
network.

No communication between the switch and the TACACS+ server application
If the switch can access the server device (that is, it can ping the server), a configuration error may be the
problem. Some possibilities include:

• The server IP address configured with the switch's tacacs-serverhost command may not be correct. (Use
the switch's show tacacs-server command to list the TACACS+ server IP address.)

• The encryption key configured in the server does not match the encryption key configured in the switch (by
using the tacacs-server key command). Verify the key in the server and compare it to the key configured
in the switch. (Use show tacacs-server to list the global key. Use show config or show config
running to list any server-specific keys.)

• The accessible TACACS+ servers are not configured to provide service to the switch.

Access is denied even though the username/password pair is correct
Some reasons for denial include the following parameters controlled by your TACACS+ server application:

• The account has expired.

• The access attempt is through a port that is not allowed for the account.

• The time quota for the account has been exhausted.

• The time credit for the account has expired.

• The access attempt is outside of the time frame allowed for the account.

• The allowed number of concurrent logins for the account has been exceeded.

For more help, see the documentation provided with your TACACS+ server application.

Unknown users allowed to login to the switch
Your TACACS+ application may be configured to allow access to unknown users by assigning them the privileges
included in a default user profile. See the documentation provided with your TACACS+ server application.
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System allows fewer login attempts than specified in the switch configuration
Your TACACS+ server application may be configured to allow fewer login attempts than you have configured in
the switch with the aaa authentication num-attempts command.

TimeP, SNTP, or Gateway problems

The switch cannot find the time server or the configured gateway
TimeP, SNTP, and Gateway access are through the primary VLAN, which in the default configuration is the
DEFAULT_VLAN. If the primary VLAN has been moved to another VLAN, it may be disabled or does not have
ports assigned to it.

VLAN-related problems

Monitor port
When using the monitor port in a multiple-VLAN environment, the switch handles broadcast, multicast, and
unicast traffic output from the monitor port as follows:

• If the monitor port is configured for tagged VLAN operation on the same VLAN as the traffic from monitored
ports, the traffic output from the monitor port carries the same VLAN tag.

• If the monitor port is configured for untagged VLAN operation on the same VLAN as the traffic from the
monitored ports, the traffic output from the monitor port is untagged.

• If the monitor port is not a member of the same VLAN as the traffic from the monitored ports, traffic from the
monitored ports does not go out the monitor port.

None of the devices assigned to one or more VLANs on an 802.1Q-compliant switch are
being recognized
If multiple VLANs are being used on ports connecting 802.1Q-compliant devices, inconsistent VLAN IDs may
have been assigned to one or more VLANs. For a given VLAN, the same VLAN ID must be used on all connected
802.1Q-compliant devices.

Link configured for multiple VLANs does not support traffic for one or more VLANs
One or more VLANs may not be properly configured as "Tagged" or "Untagged." A VLAN assigned to a port
connecting two 802.1Q-compliant devices must be configured the same on both ports. For example, VLAN_1 and
VLAN_2 use the same link between switch "X" and switch "Y," as shown in Figure 58: Example: of correct
VLAN port assignments on a link on page 317.

Figure 58: Example: of correct VLAN port assignments on a link
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• If VLAN_1 (VID=1) is configured as "Untagged" on port 3 on switch "X," it must also be configured as
"Untagged" on port 7 on switch "Y." Make sure that the VLAN ID (VID) is the same on both switches.

• Similarly, if VLAN_2 (VID=2) is configured as "Tagged" on the link port on switch "A," it must also be configured
as "Tagged" on the link port on switch "B." Make sure that the VLAN ID (VID) is the same on both switches.

Duplicate MAC addresses across VLANs
The switches operate with multiple forwarding databases. Thus, duplicate MAC addresses occurring on different
VLANs can appear where a device having one MAC address is a member of more than one 802.1Q VLAN, and
the switch port to which the device is linked is using VLANs (instead of MSTP or trunking) to establish redundant
links to another switch. If the other device sends traffic over multiple VLANs, its MAC address consistently
appears in multiple VLANs on the switch port to which it is linked.

Be aware that attempting to create redundant paths through the use of VLANs causes problems with some
switches. One symptom is that a duplicate MAC address appears in the Port Address Table of one port and then
later appears on another port. While the switches have multiple forwarding databases and thus do not have this
problem, some switches with a single forwarding database for all VLANs may produce the impression that a
connected device is moving among ports because packets with the same MAC address but different VLANs are
received on different ports. You can avoid this problem by creating redundant paths using port trunks or spanning
tree.

Figure 59: Example: of duplicate MAC address

Fan failure
When two or more fans fail, a two-minute timer starts. After two minutes, the switch is powered down and must be
rebooted to restart it. This protects the switch from possible overheating.

Hewlett Packard Enterprise recommends that you replace a failed fan tray assembly within one minute of
removing it.

Viewing transceiver information
This features provides the ability to view diagnostic monitoring information for transceivers with Diagnostic Optical
Monitoring (DOM) support. The following table indicates the support level for specific transceivers:
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Product # Description Support1

J8436A 10GbE X2–SC SR
Optic

V

J8437A 10GbE X2–SC LR Optic V

J8440B 10GbE X2-CX4 Xcver NA

J8440C 10GbE X2-CX4 Xcver NA

J4858A Gigabit-SX-LC Mini-
GBIC

V

J4858B Gigabit-SX-LC Mini-
GBIC

V

J4858C Gigabit-SX-LC Mini-
GBIC

V (some)

J9054B 100-FX SFP-LC
Transceiver

N

J8177C Gigabit 1000Base-T
Mini-GBIC

NA

J9150A 10GbE SFP+ SR
Transceiver

D

J9151A 10GbE SFP+ LR
Transceiver

D

J9152A 10GbE SFP+ LRM
Transceiver

D

J9153A 10GbE SFP+ ER
Transceiver

D

J9144A 10GbE X2-SC LRM
Transceiver

D

J8438A 10Gbe X2-SC ER
Transceiver

D

1 Support indicators:

• V - Validated to respond to DOM requests

• N - No support of DOM

• D - Documented by the component suppliers as supporting DOM

• NA - Not applicable to the transceiver (copper transceiver)
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Not all transceivers support Digital Optical Monitoring. If DOM appears in the Diagnostic Support field
of the show interfaces transceiver detail command, or the hpicfTransceiverMIB
hpicfXcvrDiagnostics MIB object, DOM is supported for that transceiver.

Viewing information about transceivers (CLI)
Syntax:

show interfaces transceiver [port-list] [detail]
Displays information about the transceivers. If a port is specified, displays information for the transceiver in that
port.

[detail]
Displays detailed transceiver information.

MIB support
The hpicfTransceiver MIB is available for displaying transceiver information.

Viewing transceiver information
The transceiver information displayed depends on the show command executed.

The output for show interfaces transceiver [port-list] is shown below. You can specify multiple
ports, separated by commas, and the information for each transceiver will display.

Output for a specified transceiver

switch(config)# show interfaces transceiver 21

Transceiver Technical information:

                     Product      Serial             Part
 Port    Type        Number       Number             Number
 ------- ----------- ------------ ------------------ ----------
 21      1000SX      J4858C       MY050VM9WB         1990-3657
If there is no transceiver in the port specified in the command, the output displays as shown below.

Output when no transceiver is present in specified interface

switch(config)# show interfaces transceiver 22

 No Transceiver found on interface 22
When no ports are specified, information for all transceivers found is displayed.

Output when no ports are specified

switch(config)# show interfaces transceiver

 Transceiver Technical information:

                      Product      Serial             Part
  Port    Type        Number       Number             Number
  ------- ----------- ------------ ------------------ ----------
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  21      1000SX      J4858C       MY050VM9WB         1990-3657
  22      1000SX      J4858B       P834DIP2
You can specify all for port-list as shown below.

Output when “all” is specified

switch(config)# show interfaces transceiver all

 No Transceiver found on interface 1

 No Transceiver found on interface 2
.
.
.
 No Transceiver found on interface 24

 Transceiver Technical information:

                      Product      Serial             Part
  Port    Type        Number       Number             Number
  ------- ----------- ------------ ------------------ ----------
  21      1000SX      J4858C       MY050VM9WB         1990-3657
  22      1000SX      J4858B       P834DIP2

Information displayed with the detail parameter
When the show interfaces transceiver [port-list] detail command is executed, the following
information displays.

Table 24: General transceiver information

Parameter Description

Interface
Index

The switch interface number

Transceiver-
type

Pluggable transceiver type

Transceiver
model

Pluggable transceiver model

Connector-
type

Type of connector of the transceiver

Wavelength For an optical transceiver: the central wavelength of the laser sent, in nm. If the transceiver
supports multiple wavelengths, the values will be separated by a comma.

Transfer
Distance

Link-length supported by the transceiver in meters. The corresponding transfer medium is
shown in brackets following the transfer distance value, For example, 50um multimode fiber. If
the transceiver supports multiple transfer media, the values are separated by a comma.

Table Continued
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Parameter Description

Diagnostic
Support

Shows whether the transceiver supports diagnostics:
None

Supported

DOM

Supported

VCT

Supported

Serial Number Serial number of the transceiver

The information in the next three tables is only displayed when the transceiver supports DOM.

Table 25: DOM information

Parameter Description

Temperature Transceiver temperature (in degrees Centigrade)

Voltage Supply voltage in transceiver (Volts)

Bias Laser bias current (mA)

RX power Rx power (mW and dBm))

TX power Tx power (mW and dBm)

The alarm information for GBIC/SFP transceivers is shown in this table.

Table 26: Alarm and error information (GBIC/SFP transceivers only)

Alarm Description

RX loss of signal Incoming (RX) signal is lost

RX power high Incoming (RX) power level is high

RX power low Incoming (RX) power level is low

TX fault Transmit (TX) fault

TX bias high TX bias current is high

TX bias low TX bias current is low

TX power high TX power is high

Table Continued
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Alarm Description

TX power low TX power is low

Temp high Temperature is high

Temp low Temperature is low

Voltage High Voltage is high

Voltage Low Voltage is low

The alarm information for XENPAK transceivers is shown in this table.

Table 27: Alarm and error information (XENPAK transceivers)

Alarm Description

WIS local fault WAN Interface Sublayer local fault

Receive optical power fault Receive optical power fault

PMA/PMD receiver local fault Physical Medium Attachment/Physical Medium Dependent receiver local
fault

PCS receiver local fault Physical Coding Sublayer receiver local fault

PHY XS receive local fault PHY Extended Sublayer receive local fault

RX power high RX power is high

RX power low RX power is low

Laser bias current fault Laser bias current fault

Laser temperature fault Laser temperature fault

Laser output power fault Laser output power fault

TX fault TX fault

PMA/PMD transmitter local fault PMA/PMD transmitter local fault

PCS Transmit local fault PCS transmit local fault

PHY XS transmit local fault PHY SX transmit local fault

TX bias high TX bias current is high

TX bias low TX bias current is low

Table Continued
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Alarm Description

TX power high TX power is high

TX power low TX power is low

Temp high Temperature is high

Temp low Temperature is low

An Example: of the output for the show interfaces transceiver [port-list] detail for a 1000SX transceiver is shown
below.

Detailed information for a 1000SX Mini-GBIC transceiver

switch(config)# show interfaces transceiver 21 detail

 Transceiver in 21
  Interface index    : 21
  Type               : 1000SX 
  Model              : J4858C
  Connector type     : LC 
  Wavelength         : 850nm
  Transfer distance  : 300m (50um), 150m (62.5um),
  Diagnostic support : DOM
  Serial number      : MY050VM9WB

 Status
  Temperature : 50.111C 
  Voltage     : 3.1234V
  TX Bias     : 6mA
  TX Power    : 0.2650mW, -5.768dBm
  RX Power    : 0.3892mW, -4.098dBm

 Time stamp   :  Mon Mar 7 14:22:13 2011
An Example: of the output for a 10GbE-LR transceiver is shown below.

Detailed information for a 10GbE-LR transceiver

switch(config)# show interfaces transceiver 23 detail

 Transceiver in 23
  Interface Index   : 24
  Type              : 10GbE-LR 
  Model             : J8437A
  Connector type    : SC
  Wavelength        : Channel #0: 1310nm, #1:0nm, #2:0nm, #3:0nm
  Transfer distance : 10000m (SM)
  Diagnostic support: DOM
  Serial number     : ED456SS987

 Status
  Temperature : 32.754C 
  TX Bias     : 42.700mA
  TX Power    : 0.5192mW, -2.847dBm
  RX Power    : 0.0040mW, -23.979dBm

 Recent Alarms:
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  Rx power low alarm
  Rx power low warning

 Recent errors:
  Receive optical power fault
  PMA/PMD receiver local fault
  PMA/PMD transmitter local fault
  PCS receive local fault
  PHY XS transmit local fault

 Time stamp : Mon Mar 7 16:26:06 2013

Viewing transceiver information for copper transceivers with VCT support
This feature provides the ability to view diagnostic monitoring information for copper transceivers with Virtual
Cable Test (VCT) support. The cable quality of the copper cables connected between transceivers can be
ascertained using the transceiver cable diagnostics. Results of the diagnostics are displayed with the appropriate
CLI show commands and with SNMP using the hpicfTransceiver MIB.

The J8177C 1000Base-T Mini-GBIC is supported.

Testing the Cable
Enter the test cable-diagnostics command in any context to begin cable diagnostics for the transceiver.
The diagnostic attempts to identify cable faults. The tests may take a few seconds to complete for each interface.
There is the potential of link loss during the diagnostic.

Syntax:

test cable-diagnostics [port-list]
Invokes cable diagnostics and displays the results.

Output from test cable-diagnostics command

HP Switch # test cable-diagnostics a23-a24

 The ‘test cable-diagnostics’ command will cause a loss of link and will take a few seconds per 
 interface to complete.

 Continue (Y/N)? y

MDI  Cable     Distance  Pair  Pair      MDI 
 Port  Pair  Status     to Fault  Skew  Polarity  Mode
 ----- ----- ---------- --------- ----- --------- ------ 
 A23   1-2   OK         0 m       6 ns  Normal    MDIX
       3-6   OK         0 m       0 ns  Normal
       4-5   OK         0 m       6 ns  Normal    MDIX
       7-8   OK         0 m       6 ns  Normal
 A24   1-2   Short      2 m
       3-6   Impedance  3 m
       4-5   Impedance  3 m
       7-8   Open       1 m

Copper cable diagnostic test results

switch# show interfaces transceiver a23 detail

 Transceiver in A23
  Interface Index   : 23
  Type              : 1000T-sfp

Chapter 17 Troubleshooting 325

Anexo 04 ITEM 11 (0592666)         SEI 0008478-63.2018.6.02.8000 / pg. 6149



  Model             : J8177C 
  Connector Type    : RJ45
  Wavelength        : n/a
  Transfer Distance : 100m (copper), 
  Diagnostic Support : VCT
  Serial Number     : US051HF099

  Link Status       : Up
  Speed             : 1000
  Duplex            : Full

       MDI   Cable      Distance  Pair  Pair      MDI 
 Port  Pair  Status     to Fault  Skew  Polarity  Mode
 ----- ----- ---------- --------- ----- --------- ----- 
 A23   1-2   OK         0 m       6 ns  Normal    MDIX
       3-6   OK         0 m       0 ns  Normal
       4-5   OK         0 m       6 ns  Normal    MDIX
       7-8   OK         0 m       6 ns  Normal

   Test Last Run   : Fri Apr 22 20:33:23 2011

General transceiver information

Parameter Description

Interface Index The switch interface number

Transceiver-type Pluggable transceiver type

Transceiver
model

Pluggable transceiver model

Connector-type Type of connector of the transceiver

Wavelength For an optical transceiver: the central wavelength of the laser sent, in nm. If the transceiver
supports multiple wavelengths, the values will be separated by a comma. An electrical
transceiver value is displayed as N/A.

Transfer
Distance

Link-length supported by the transceiver in meters. The corresponding transfer medium is
shown in brackets following the transfer distance value, For example, 50um multimode fiber.
If the transceiver supports multiple transfer media, the values are separated by a comma.

Diagnostic
Support

Shows whether the transceiver supports diagnostics:
None

Supported

DOM

Supported

VCT

Supported

Serial Number Serial number of the transceiver

Link Status Link up or down

Table Continued
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Parameter Description

Speed Speed of transceiver in Mbps

Duplex Type of duplexing

Cable Status Values are OK, Open, Short, or Impedance

Distance to Fault The distance in meters to a cable fault (accuracy is +/- 2 meters); displays 0 (zero) if there is
no fault

Pair Skew Difference in propagation between the fastest and slowest wire pairs

Pair Polarity Signals on a wire pair are polarized, with one wire carrying the positive signal and one
carrying the negative signal.

MDI Mode The MDI crossover status of the two wire pairs (1&2, 3&6, 4&5, 7&8), will be either MDI or
MDIX

Using the Event Log for troubleshooting switch problems
The Event Log records operating events in single- or double-line entries and serves as a tool to isolate and
troubleshoot problems.

Once the log has received 2000 entries, it discards the oldest message each time a new message is received.
The Event Log window contains 14 log entry lines. You can scroll through it to view any part of the log.

Once the log has received 2000 entries, it discards the oldest message each time a new message is received.
The Event Log window contains 14 log-entry lines. You can scroll through it to view any part of the log.

The Event Log is erased if power to the switch is interruptedor if you enter the boot system
command. The contents of the Event Log are not erased if you:

• Reboot the switch by choosing the Reboot Switch option from the menu interface.

• Enter the reload command from the CLI.

Event Log entries
As shown in Figure 60: Format of an event log entry on page 327, each Event Log entry is composed of six or
seven fields, depending on whether numbering is turned on or not:

Figure 60: Format of an event log entry
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Item Description

Severity One of the following codes (from highest to lowest severity):

M—(major) indicates that a fatal switch error has occurred.

E—(error) indicates that an error condition occurred on the switch.

W—(warning) indicates that a switch service has behaved unexpectedly.I—(information)
provides information on normal switch operation.

D—(debug) is reserved for HPE internal diagnostic information.

Date The date in the format mm/dd/yy when an entry is recorded in the log.

Time The time in the format hh:mm:ss when an entry is recorded in the log.

Event number The number assigned to an event. You can turn event numbering on and off with the [no]
log-number command.

System module The internal module (such as "ports:" for port manager) that generated a log entry. If VLANs
are configured, a VLAN name also appears for an event that is specific to an individual
VLAN.

Event message A brief description of the operating event.

Table 28: Event Log system modules

System module Description Documented in HPE Switch
hardware/software guide

802.1x 802.1X authentication: Provides
access control on a per-client or
per-port basis:

• Client-level security that allows
LAN access to 802.1X clients
(up to 32 per port) with valid user
credentials

• Port-level security that allows
LAN access only on ports on
which a single 802.1X-capable
client (supplicant) has entered
valid RADIUS user credentials

Access Security Guide

addrmgr Address Table Manager: Manages
MAC addresses that the switch has
learned and are stored in the
switch's address table.

Management and Configuration
Guide

Table Continued
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System module Description Documented in HPE Switch
hardware/software guide

auth Authorization: A connected client
must receive authorization through
web, AMC, RADIUS-based,
TACACS+-based, or 802.1X
authentication before it can send
traffic to the switch.

Access Security Guide

cdp Cisco Discovery Protocol: Supports
reading CDP packets received from
neighbor devices, enabling a switch
to learn about adjacent CDP
devices. HPE does not support the
transmission of CDP packets to
neighbor devices.

Management and Configuration
Guide

console Console interface used to monitor
switch and port status, reconfigure
the switch, and read the event log
through an in-band Telnet or out-of-
band connection.

Installation and Getting Started
Guide

cos Class of Service (CoS): Provides
priority handling of packets
traversing the switch, based on the
IEEE 802.1p priority carried by each
packet.CoS messages also include
QoS events. The QoS feature
classifies and prioritizes traffic
throughout a network, establishing
an end-to-end traffic priority policy
to manage available bandwidth and
improve throughput of important
data.

Advanced Traffic Management
Guide

dhcp Dynamic Host Configuration
Protocol (DHCP) server
configuration: Switch is
automatically configured from a
DHCP (Bootp) server, including IP
address, subnet mask, default
gateway, Timep Server address,
and TFTP server address.

Management and Configuration
Guide

dhcp v6c DHCP for IPv6 prefix assignment IPv6 Configuration Guide

dhcpr DHCP relay: Forwards client-
originated DHCP packets to a
DHCP network server.

Advanced Traffic Management
Guide

Table Continued
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System module Description Documented in HPE Switch
hardware/software guide

download Download operation for copying a
software version or files to the
switch.

Management and Configuration
Guide

dma Direct Access Memory (DMA):
Transmits and receives packets
between the CPU and the switch.

—

fault Fault Detection facility, including
response policy and the sensitivity
level at which a network problem
should generate an alert.

Management and Configuration
Guide

ffi Find, Fix, and Inform: Event or alert
log messages indicating a possible
topology loop that causes excessive
network activity and results in the
network running slow. FFI
messages include events on
transceiver connections with other
network devices.

Installation and Getting Started
Guide

Management and Configuration
Guide

garp Generic Attribute Registration
Protocol (GARP), defined in the
IEEE 802.1D-1998 standard.

Advanced Traffic Management
Guide

gvrp GARP VLAN Registration Protocol
(GVRP): Manages dynamic 802.1Q
VLAN operations, in which the
switch creates temporary VLAN
membership on a port to provide a
link to another port in the same
VLAN on another device.

Advanced Traffic Management
Guide

hpesp Management module that maintains
communication between switch
ports.

Installation and Getting Started
Guide

igmp Internet Group Management
Protocol: Reduces unnecessary
bandwidth usage for multicast traffic
transmitted from multimedia
applications on a per-port basis.

Multicast and Routing Guide

Table Continued
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System module Description Documented in HPE Switch
hardware/software guide

ip IP addressing: Configures the
switch with an IP address and
subnet mask to communicate on the
network and support remote
management access; configures
multiple IP addresses on a VLAN;
enables IP routing on the switch.

Management and Configuration
Guide

iplock IP Lockdown: Prevents IP source
address spoofing on a per-port and
per-VLAN basis by forwarding only
the IP packets in VLAN traffic that
contain a known source IP address
and MAC address binding for the
port.

Access Security Guide

ipx Novell Netware protocol filtering: On
the basis of protocol type, the
switch can forward or drop traffic to
a specific set of destination ports on
the switch.

Access Security Guide

lacp LACP trunks: The switch can either
automatically establish an 802.3ad-
compliant trunk group or provide a
manually configured, static LACP
trunk.

Management and Configuration
Guide

ldbal Load balancing in LACP port trunks
or 802.1s Multiple Spanning Tree
protocol (MSTP) that uses VLANs in
a network to improve network
resource utilization and maintain a
loop-free environment.Load-
balancing messages also include
switch meshing events. The switch
meshing feature provides redundant
links, improved bandwidth use, and
support for different port types and
speeds.

Management and Configuration
Guide

Advanced Traffic Management
Guide

lldp Link-Layer Discovery Protocol:
Supports transmitting LLDP packets
to neighbor devices and reading
LLDP packets received from
neighbor devices, enabling a switch
to advertise itself to adjacent
devices and to learn about adjacent
LLDP devices.

Management and Configuration
Guide

Table Continued
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System module Description Documented in HPE Switch
hardware/software guide

macauth Web and MAC authentication: Port-
based security employed on the
network edge to protect private
networks and the switch itself from
unauthorized access using one of
the following interfaces:

• Web page login to authenticate
users for access to the network

• RADIUS server that uses a
device's MAC address for
authentication

Access Security Guide

maclock MAC lockdown and MAC lockout

• MAC lockdown prevents station
movement and MAC address
"hijacking" by requiring a MAC
address to be used only on an
assigned port on the switch.
MAC Lockdown also restricts the
client device to a specific VLAN.

• MAC lockout blocks a specific
MAC address so that the switch
drops all traffic to or from the
specified address.

Access Security Guide

mgr Windows-based network
management solutions for
managing and monitoring
performance of HPE switches.

Management and Configuration
Guide

netinet Network Internet: Monitors the
creation of a route or an Address
Resolution Protocol (ARP) entry
and sends a log message in case of
failure.

Advanced Traffic Management
Guide

pagp Ports Aggregation Protocol (PAgP):
Obsolete. Replaced by LACP
(802.3ad).

—

Table Continued
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System module Description Documented in HPE Switch
hardware/software guide

ports Port status and port configuration
features, including mode (speed
and duplex), flow control, broadcast
limit, jumbo packets, and security
settings.

Port messages include events on
POE operation and transceiver
connections with other network
devices.

Installation and Getting Started
Guide

Management and Configuration
Guide

Access Security Guide

radius RADIUS (Remote Authentication
Dial-In User Service) authentication
and accounting: A network server is
used to authenticate user-
connection requests on the switch
and collect accounting information
to track network resource usage.

Access Security Guide

snmp Simple Network Management
Protocol: Allows you to manage the
switch from a network management
station, including support for
security features, event reporting,
flow sampling, and standard MIBs.

Management and Configuration
Guide

sntp Simple Network Time Protocol:
Synchronizes and ensures a
uniform time among interoperating
devices.

Management and Configuration
Guide

ssh Secure Shell version 2 (SSHv2):
Provides remote access to
management functions on a switch
via encrypted paths between the
switch and management station
clients capable of SSH operation.

SSH messages also include events
from the Secure File Transfer
Protocol (SFTP) feature. SFTP
provides a secure alternative to
TFTP for transferring sensitive
information, such as switch
configuration files, to and from the
switch in an SSH session.

Access Security Guide

Table Continued
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System module Description Documented in HPE Switch
hardware/software guide

ssl Secure Socket Layer Version 3
(SSLv3), including Transport Layer
Security (TLSv1) support: Provides
remote web access to a switch via
encrypted paths between the switch
and management station clients
capable of SSL/TLS operation.

Access Security Guide

stack Stack management: Uses a single
IP address and standard network
cabling to manage a group (up to
16) of switches in the same IP
subnet (broadcast domain),
resulting in a reduced number of IP
addresses and simplified
management of small workgroups
for scaling your network to handle
increased bandwidth demand.

Advanced Traffic Management
Guide

stp Multiple-instance spanning tree
protocol/MSTP (802.1s): Ensures
that only one active path exists
between any two nodes in a group
of VLANs in the network. MSTP
operation is designed to avoid loops
and broadcast storms of duplicate
messages that can bring down the
network.

Advanced Traffic Management
Guide

system Switch management, including
system configuration, switch
bootup, activation of boot ROM
image, memory buffers, traffic and
security filters.

System messages also include
events from management interfaces
(menu and CLI) used to reconfigure
the switch and monitor switch status
and performance.

Management and Configuration
Guide

Access Security Guide

tacacs TACACS+ authentication: A central
server is used to control access to
the switches (and other TACACS-
aware devices) in the network
through a switch's console port
(local access) or Telnet (remote
access).

Access Security Guide

Table Continued
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System module Description Documented in HPE Switch
hardware/software guide

tcp Transmission Control Protocol: A
transport protocol that runs on IP
and is used to set up connections.

Advanced Traffic Management
Guide

telnet Session established on the switch
from a remote device through the
Telnet virtual terminal protocol.

Management and Configuration
Guide

tftp Trivial File Transfer Protocol:
Supports the download of files to
the switch from a TFTP network
server.

Management and Configuration
Guide

timep Time Protocol: Synchronizes and
ensures a uniform time among
interoperating devices.

Management and Configuration
Guide

update Updates (TFTP or serial) to HPE
switch software and updates to
running-config and start-up config
files

Management and Configuration
Guide

vlan Static 802.1Q VLAN operations,
including port-and protocol-based
configurations that group users by
logical function instead of physical
location

A port-based VLAN creates a
layer-2 broadcast domain
comprising member ports that
bridge IPv4 traffic among
themselves.

VLAN messages include events
from management interfaces (menu
and CLI) used to reconfigure the
switch and monitor switch status
and performance.

Advanced Traffic Management
Guide

xmodem Xmodem: Binary transfer feature
that supports the download of
software files from a PC or UNIX
workstation.

Management and Configuration
Guide

Using the Menu
To display the Event Log from the Main Menu, select Event Log. The following example shows a sample event
log display.
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An event log display

Switch 5406zl                                     25-Oct-2013  18:02:52
==========================-CONSOLE - MANAGER MODE -
=============================
M 10/25/13 16:30:02 sys: 'Operator cold reboot from CONSOLE session.'
I 10/25/13 17:42:51 00061 system: ------------------------------------------
-
I 10/25/13 17:42:51 00063 system: System went down : 10/25/13 16:30:02
I 10/25/13 17:42:51 00064 system: Operator cold reboot from CONSOLE session.
W 10/25/13 17:42:51 00374 chassis: WARNING: SSC is out of Date: Load 8.2 or
newer
I 10/25/13 17:42:51 00068 chassis: Slot D Inserted
I 10/25/13 17:42:51 00068 chassis: Slot E Inserted
I 10/25/13 17:42:51 00068 chassis: Slot F Inserted
I 10/25/13 17:42:51 00690 udpf: DHCP relay agent feature enabled
I 10/25/13 17:42:51 00433 ssh: Ssh server enabled
I 10/25/13 17:42:51 00400 stack: Stack Protocol disabled
I 10/25/13 17:42:51 00128 tftp: Enable succeeded
I 10/25/13 17:42:51 00417 cdp: CDP enabled

----  Log events stored in memory 1-751. Log events on screen 690-704.

  Actions->    Back    Next page    Prev page    End    Help

Return to previous screen.
Use up/down arrow to scroll one line, left/right arrow keys to
change action selection, and <Enter> to execute action.
The log status line below the recorded entries states the total number of events stored in the event log and
which logged events are currently displayed.

To scroll to other entries in the Event Log, either preceding or following the currently visible portion, press the keys
indicated at the bottom of the display (Back,Nextpage, Prev page, or End) or the keys described in the
following table.

Event Log control keys

Key Action

[N] Advances the display by one page (next page).

[P] Rolls back the display by one page (previous page).

[v] Advances display by one event (down one line).

[ˆ] Rolls back display by one event (up one line).

[E] Advances to the end of the log.

[H] Displays Help for the Event Log.

Using the CLI
Syntax:

By default, the show logging command displays the log messages recorded since the last reboot in
chronological order:
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-a Displays all recorded log messages, including those before the last reboot.

-b Displays log events as the time since the last reboot instead of in a date/time format.

-r Displays all recorded log messages, with themost recent entries listed first (reverse order).

-s Displays the active management module (AM) and standby management module (SM) log
events.

-t Displays the log events with a granularity of 10 milliseconds.

-m Displays only major log events.

-e Displays only error event class.

-p Displays only performance log events.

-w Displays only warning log events.

-i Displays only informational log events.

-d Displays only debug log events.

filter Displays only log filter configuration and status information.

<option-
str>

Displays all Event Log entries that contain the specified text. Use an <option-str> value with -a or
-r to further filter show logging command output.

Example:

To display all Event Log messages that have "system" in the message text or module name, enter the following
command:

switch# show logging -a system
To display all Event Log messages recorded since the last reboot that have the word "system" in the message
text or module name, enter:

switch# show logging system

Clearing Event Log entries
Syntax:

Removes all entries from the event log display output.

Use the clear logging command to hide, but not erase, Event Log entries displayed in show logging
command output. Only new entries generated after you enter the command will be displayed.

To redisplay all hidden entries, including Event Log entries recorded prior to the last reboot, enter the show
logging -a command.
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Turning event numbering on
Syntax:

[no] log-numbers
Turns event numbering on and off

Using log throttling to reduce duplicate Event Log and SNMP messages
A recurring event can generate a series of duplicate Event Log messages and SNMP traps in a relatively short
time. As a result, the Event Log and any configured SNMP trap receivers may be flooded with excessive, exactly
identical messages. To help reduce this problem, the switch uses log throttle periods to regulate (throttle)
duplicate messages for recurring events, and maintains a counter to record how many times it detects duplicates
of a particular event since the last system reboot.

When the first instance of a particular event or condition generates a message, the switch initiates a log throttle
period that applies to all recurrences of that event. If the logged event recurs during the log throttle period, the
switch increments the counter initiated by the first instance of the event, but does not generate a new message.

If the logged event repeats again after the log throttle period expires, the switch generates a duplicate of the first
message, increments the counter, and starts a new log throttle period during which any additional instances of the
event are counted, but not logged. Thus, for a particular recurring event, the switch displays only one message in
the Event Log for each log throttle period in which the event reoccurs. Also, each logged instance of the event
message includes counter data showing how many times the event has occurred since the last reboot. The switch
manages messages to SNMP trap receivers in the same way.

Log throttle periods
The length of the log throttle period differs according to an event's severity level:

Severity level Log throttle period

I (Information) 6000 Seconds

W (Warning) 600 Seconds

D (Debug) 60 Seconds

M (Major) 6 Seconds

Example:

Suppose that you configure VLAN 100 on the switch to support PIM operation, but do not configure an IP
address. If PIM attempts to use VLAN 100, the switch generates the first instance of the following Event Log
message and counter.

In The first instance of an event message and counter on page 338 the counter (1) indicates that
this is the first instance of this event since the switch last rebooted.

The first instance of an event message and counter

W 10/01/12 09:00:33 PIM:No IP address configured on VID 100 (1)
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If PIM operation causes the same event to occur six more times during the initial log throttle period, there are no
further entries in the Event Log. However, if the event occurs again after the log throttle period has expired, the
switch repeats the message (with an updated counter) and starts a new log throttle period.

Figure 61: Duplicate messages over multiple log throttling periods

Note that if the same type of event occurs under different circumstances, the switch handles these as unrelated
events for the purpose of Event Log messages. For example, if PIM operation simultaneously detects that VLANs
100 and 205 are configured without IP addresses, you see log messages similar to the following:

Figure 62: Example: of log messages generated by unrelated events of the same type

Example: of event counter operation
Suppose the switch detects the following after a reboot:

• Three duplicate instances of the PIM "Send error" during the first log throttle period for this event

• Five more instances of the same Send error during the second log throttle period for this event

• Four instances of the same Send error during the third log throttle period for this event

In this case, the duplicate message appears three times in the Event Log (once for each log throttle period for the
event being described), and the duplicate message counter increments as shown in the following table. (The
same operation applies for messages sent to any configured SNMP trap receivers.)

Table 29: How the duplicate message counter increments

Instances during 1st log
throttle period

Instances during 2nd log
throttle period

Instances during 3rd log
throttle period

Duplicate message
counter1

3 1

5 4

4 9
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1 This value always comprises the first instance of the duplicate message in the current log throttle period plus all previous
occurrences of the duplicate message occurring since the switch last rebooted.

Reporting information about changes to the running configuration
Syslog can be used for sending notifications to a remote syslog server about changes made to the running
configuration. The notifications in the syslog messages are sent in ASCII format and contain this information:

• Notice-Type: Describes the syslog notification as a “running config change”.

• Event-ID: Identifier for the running config change event that occurred on the switch.

• Config-Method: The source for the running config change.

• Device-Name: The managed device.

• User-Name: User who made the running config change.

• Remote-IP-Address: IP address of a remote host from which the user is connected.

Syntax:

[no] logging notify <running-config-change> [transmission-interval <0-4294967295>
Enables sending the running configuration change notifications to the syslog server.

The no form of the command disables sending the running configuration changes to the syslog server.

Default: Disabled

<running-config-change > Mandatory option for the notify parameter. Specifies the type of
notification to send.

transmission-interval
<0-4294967295> Specifies the time interval (in seconds) between the

transmission of two consecutive notifications. Running config
changes occurring within the specified interval will not generate
syslog notifications.

A value of zero means there is no limit; a notification is sent for every running config change.

Default: Zero

Sending running config changes to the syslog server

switch(config)# logging notify running-config-change
transmission-interval 10

Debug/syslog operation
While the Event Log records switch-level progress, status, and warning messages on the switch, the debug/
system logging (syslog) feature provides a way to record Event Log and debug messages on a remote device.
For example, you can send messages about routing misconfigurations and other network protocol details to an
external device, and later use them to debug network-level problems.

Debug/syslog messaging
The debug/syslog feature allows you to specify the types of Event Log and debug messages that you want to
send to an external device. You can perform the following operations:
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• Use the debug commandto configure messaging reports for the following event types:

◦ Events recorded in the switch's Event Log

◦ LLDP events

◦ SSH events

• Use the logging commandto select a subset of Event Log messages to send to an external device for
debugging purposes according to:

◦ Severity level

◦ System module

Hostname in syslog messages
The syslog now messages the sender identified by hostname.

The hostname field identifies the switch that originally sends the syslog message. Configurable through the CLI
and SNMP, the format of the hostname field supports the following formats:

• ip-address: The IP address of the sending interface will be used as the message origin identifier. This is the
default format for the origin identifier. The IP address of the sending interface (in dotted decimal notation) is the
default format.

• hostname: The hostname of the sending switch will be used as the message origin identifier.

• none: No origin identifier will be embedded in the syslog message. Nilvalue is used as defined by “-“.

This configuration is system-wide, not per syslog server. There is no support for fully-qualified domain name.

Logging origin-id
Use the logging origin-id command to specify the content for the hostname field.

Syntax:

logging origin-id [ip-address|hostname|none]

[no] logging origin-id [ip-address|hostname|none]
To reset the hostname field content back to default (IP-address), use the no form of the command.

filter

Creates a filter to restrict which events are logged.

IP-ADDR

Adds an IPv4 address to the list of receiving syslog servers.

IPV6-ADDR

Adds an IPv6 address to the list of receiving syslog servers.

origin-id

Sends the Syslog messages with the specified origin-id.
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notify

Notifies the specified type sent to the syslog server(s).

priority-descr

A text string associated with the values of facility, severity, and system-module.

severity

Event messages of the specified severity or higher sent to the syslog server.

system-module

Event messages of the specified system module (subsystem) sent to the syslog server.

hostname

Sets the hostname of the device as the origin-id.

none

Disables origin-id in the syslog message.

Add an IP address to the list of receiving syslog servers.

Use of no without an IP address specified will remove all IP addresses from the list of syslog receivers. If an IP
address is specified, that receiver will be removed. Both link-local with zone ID and global IPv6 addresses are
supported.

• Specify syslog server facility with the option <facility>. The command no logging <facility> sets
the facility back to defaults.

• Specify filtering rules.

• Specify severity for event messages to be filtered to the syslog server with the option <severity>. The
command no logging <severity> sets the severity back to default.

• Event messages of specified system module will be sent to the syslog server. Using no sends messages from
all system modules. Messages are first filtered by selected severity.

• Specify syslog server transport layer with options [udp]|[tcp]|[tls].

• Specify syslog server port number with options [udp PORT-NUM]|[tcp PORT-NUM]|[tls PORT-NUM].

• Specify notification types to be sent to the syslog server.

• Use the option transmission-interval to control the egress rate limit for transmitting notifications, 0 value
means there is no rate limit. The values are in seconds. Only one syslog message is allowed for transmission
within specified time interval.

• Specify the origin information for the syslog messages with the option origin-id.
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When the syslog server receives messages from the switch, the IPv6 address of the switch is partly
displayed.

Example:

Configured Host Ipv6 Address: 2001::1

Expected Syslog message:

Syslog message: USER.INFO: Oct 11 02:40:02 2001::1 00025 ip:
ST1CMDR: VLAN60: ip address 30.1.1.1/24 configured on vlan 60
Actual Truncated syslog message:

Syslog message: USER.INFO: Oct 11 02:40:02 2001:: 00025 ip: ST1CMDR:
VLAN60: ip address 30.1.1.1/24 configured on vlan 60

Use the command in the following example to set the origin-id to the hostname.

Setting the origin-id to the hostname

switch(config)# logging origin-id hostname
The following syslog message will occur:

<14> Jan 1 00:15:35 HP-2910al-24G 00076 ports: port 2 is now on-line
Use the command in the following example to set the origin-id to none (nilvalue).

Setting the origin-id to none (nilvalue)

switch(config)# logging origin-id none
The following syslog message will occur:

<14> Jan 1 00:15:35 - 00076 ports: port 2 is now on-line
Use any of the commands in the following example to set the origin-id to ip-address (default).

Setting the origin-id to ip-address (default)

switch(config)# logging origin-id ip-address

switch(config)# no logging origin-id hostname

switch(config)# no logging origin-id none
The following syslog message will occur:

<14> Jan 1 00:15:35 169.254.230.236 00076 ports: port 2 is now on-line

Viewing the identification of the syslog message sender
Use the commands show debug or show running-config to display the identification of the syslog message
sender. The default option for origin-id is ip-address. The command show running-config will not
display the configured option when origin-id is set to the default value of ip address.

When hostname or none is configured using logging origin-id, the same displays as part of the show
running-config command.

Chapter 17 Troubleshooting 343

Anexo 04 ITEM 11 (0592666)         SEI 0008478-63.2018.6.02.8000 / pg. 6167



Syntax:

show debug
Default option is ip-address.

The following shows the output of the show debug command when configured without loggin origin-id.

Output of the show debug command when configured without login origin-id

Debug Logging
  Origin identifier: Outgoing Interface IP
  Destination:     None

Enabled debug types:
  None are enabled.
The command logging origin-id hostname will produce the syslog message shown in the following
example.

Syslog message for logging origin-id hostname

Debug Logging
  Origin identifier: Hostname
  Destination:    None

Enabled debug types:
  None are enabled.
The command logging origin-id none will produce the syslog message shown in the following example.

Syslog message for logging origin-id none

Debug Logging
  Origin identifier: none
  Destination:    None

Enabled debug types:
  None are enabled.
Syntax:

show running-config
The following example shows the output of the show running-config command.

Output of the show running-config command

The command logging origin-id hostname will display the 
following:
logging origin-id hostname
The command logging origin-id none will display as the following:

logging origin-id none
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SNMP MIB
SNMP support will be provided through the following MIB objects.

HpicfSyslogOriginId = textual-convention

Description

This textual convention enumerates the origin identifier of syslog message.

Syntax: integer

ip-address

hostname

none

Status

current

hpicfSyslogOriginId OBJECT-TYPE

Description

Specifies the content of a Hostname field in the header of a syslog message.

Syntax:

HpicfSyslogOriginId

Max-access

read-write

Status

current

Default

ip-address

Debug/syslog destination devices
To use debug/syslog messaging, you must configure an external device as the logging destination by using the
logging and debug destination commands. For more information, see Debug destinations on page 353
and Configuring a syslog server on page 355.

A debug/syslog destination device can be a syslog server and/or a console session. You can configure debug and
logging messages to be sent to:

• Up to six syslog servers

• A CLI session through a direct RS-232 console connection, or a Telnet or SSH session
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Debug/syslog configuration commands

Event notification logging — Automatically sends switch-level
event messages to the switch's
Event Log. Debug and syslog do
not affect this operation, but add the
capability of directing Event Log
messaging to an external device.

logging command <syslog-ip-addr> Enables syslog messaging to be
sent to the specified IP address.
IPv4 and IPv6 are supported.

facility (Optional) The logging
facility command specifies the
destination (facility) subsystem used
on a syslog server for debug
reports.

priority-desc A text string associated with the
values of facility, severity, and
system-module.

severity Sends Event Log messages of
equal or greater severity than the
specified value to configured debug
destinations. (The default setting is
to send Event Log messages from
all severity levels.)

system-module Sends Event Log messages from
the specified system module to
configured debug destinations. The
severity filter is also applied to the
system-module messages you
select.

The default setting is to send Event
Log messages from all system
modules. To restore the default
setting, enter the no logging
system-module <system-
module> or logging system-
module all-pass commands.

all Sends debug logging to configured
debug destinations for all ACL,
Event Log, IP-OSPF, and IP-RIP
options.

Table Continued
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destination logging: Disables or re-enables
syslog logging on one or more
syslog servers configured with the
logging syslog-ip-addr
command.session: Assigns or re-
assigns destination status to the
terminal device that was most
recently used to request debug
output.buffer: Enables syslog
logging to send the debug message
types specified by the debug
<debug-type> command to a
buffer in switch memory.

event Sends standard Event Log
messages to configured debug
destinations. (The same messages
are also sent to the switch's Event
Log, regardless of whether you
enable this option.)

ip forwarding: Sends IPv4
forwarding messages to the debug
destinations.packet: Sends IPv4
packet messages to the debug
destinations.rip: Sends RIP event
logging to the debug destinations.

ipv6 dhcpv6-client: Sends DHCPv6
client debug messages to the
configured debug
destination.forwarding: Sends
IPv6 forwarding messages to the
debug destination(s)nd: Sends IPv6
debug messages for IPv6 neighbor
discovery to the configured debug
destinations.packet: Sends IPv6
packet messages to the debug
destinations.

lldp Sends LLDP debug messages to
the debug destinations.

ssh Sends SSH debug messages at the
specified level to the debug
destination. The levels are fatal,
error, info, verbose, debug, debug2,
and debug3.

Using the Debug/Syslog feature, you can perform the following operations:
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• Configure the switch to send Event Log messages to one or more Syslog servers. In addition, you can
configure the messages to be sent to the User log facility (default) or to another log facility on configured
Syslog servers.

• Configure the switch to send Event Log messages to the current management- access session (serial-connect
CLI, Telnet CLI, or SSH).

• Disable all Syslog debug logging while retaining the Syslog addresses from the switch configuration. This
allows you to configure Syslog messaging and then disable and re-enable it as needed.

• Display the current debug configuration. If Syslog logging is currently active, the list f configured Syslog
servers is displayed.

• Display the current Syslog server list when Syslog logging is disabled.

Configuring debug/syslog operation

Procedure

1. To use a syslog server as the destination device for debug messaging, follow these steps:

a. Enter the logging <syslog-ip-addr> command at the global configuration level to configure the
syslog server IP address and enable syslog logging. Optionally, you may also specify the destination
subsystem to be used on the syslog server by entering the logging facility command.If no other
syslog server IP addresses are configured, entering the logging command enables both debug
messaging to a syslog server and the event debug message type. As a result, the switch automatically
sends Event Log messages to the syslog server, regardless of other debug types that may be configured.

b. Re-enter the logging command in Step 1a to configure additional syslog servers. You can configure up to
a total of six servers. (When multiple server IP addresses are configured, the switch sends the debug
message types that you configure in Step 3 to all IP addresses.)

2. To use a CLI session on a destination device for debug messaging:

a. Set up a serial, Telnet, or SSH connection to access the switch's CLI.

b. Enter the debug destination session command at the manager level.

3. Enable the types of debug messages to be sent to configured syslog servers, the current session device, or
both by entering the debug <debug-type> command and selecting the desired options.

Repeat this step if necessary to enable multiple debug message types.

By default, Event Log messages are sent to configured debug destination devices. To block Event Log
messages from being sent, enter the no debug event command.

4. If necessary, enable a subset of Event Log messages to be sent to configured syslog servers by specifying a
severity level, a system module, or both using the following commands:

switch(config)# logging severity <debug | major | error | warning | info>
switch(config)# logging system-module <system-module>

To display a list of valid values for each command, enter logging severity or logging system-module
followed by ? or pressing the Tab key.
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The severity levels in order from the highest to lowest severity are major, error, warning, info, and debug. For a
list of valid values for the logging system-module <system-module> command, see Event Log
system modules.

5. If you configure system-module, severity-level values, or both to filter Event Log messages, when you finish
troubleshooting, you may want to reset these values to their default settings so that the switch sends all Event
Log messages to configured debug destinations (syslog servers, CLI session, or both).

To remove a configured setting and restore the default values that send all Event Log messages, enter one or
both of the following commands:

switch(config)# no logging severity <debug | major | error | warning | info>
switch(config)# no logging system-module <system-module>

If you configure a severity-level, system-module, logging destination, or logging facility value and
save the settings to the startup configuration (For example, by entering the write memory
command), the debug settings are saved after a system reboot (power cycle or reboot) and re-
activated on the switch. As a result, after switch startup, one of the following situations may occur:

• Only a partial set of Event Log messages may be sent to configured debug destinations.

• Messages may be sent to a previously configured syslog server used in an earlier debugging
session.

Viewing a debug/syslog configuration
Use the show debug command to display the currently configured settings for:

• Debug message types and Event Log message filters (severity level and system module) sent to debug
destinations

• Debug destinations (syslog servers or CLI session) and syslog server facility to be used

Syntax:

show debug
Displays the currently configured debug logging destinations and message types selected for debugging
purposes. (If no syslog server address is configured with the logging <syslog-ip-addr> command, no
show debug command output is displayed.)

Output of the show debug command

switch(config)# show debug

 Debug Logging
  Destination:
   Logging --
    10.28.38.164
    Facility=kern
    Severity=warning
    System module=all-pass
   Enabled debug types:
    event
Example:
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In the following Example:, no syslog servers are configured on the switch (default setting). When you configure a
syslog server, debug logging is enabled to send Event Log messages to the server. To limit the Event Log
messages sent to the syslog server, specify a set of messages by entering the logging severity and
logging system-module commands.

Figure 63: Syslog configuration to receive event log messages from specified system module and severity levels

As shown at the top of Figure 63: Syslog configuration to receive event log messages from specified
system module and severity levels on page 350, if you enter the show debug command when no syslog
server IP address is configured, the configuration settings for syslog server facility, Event Log severity level, and
system module are not displayed. However, after you configure a syslog server address and enable syslog
logging, all debug and logging settings are displayed with the show debug command.

If you do not want Event Log messages sent to syslog servers, you can block the messages from being sent by
entering the no debug event command. (There is no effect on the normal logging of messages in the switch's
Event Log.)

Example:

The next Example: shows how to configure:

• Debug logging of ACL and IP-OSPF packet messages on a syslog server at 18.38.64.164 (with user as the
default logging facility).

• Display of these messages in the CLI session of your terminal device's management access to the switch.

• Blocking Event Log messages from being sent from the switch to the syslog server and a CLI session.
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To configure syslog operation in these ways with the debug/syslog feature disabled on the switch, enter the
commands shown in Figure 64: Debug/syslog configuration for multiple debug types and multiple
destinations on page 351.

Figure 64: Debug/syslog configuration for multiple debug types and multiple destinations

Debug command
At the manager level, use the debug command to perform two main functions:

• Specify the types of event messages to be sent to an external destination.

• Specify the destinations to which selected message types are sent.

By default, no debug destination is enabled and only Event Log messages are enabled to be sent.

To configure a syslog server, use the logging <syslog-ip-addr> command. For more
information, see Configuring a syslog server on page 355.

Debug messages
Syntax:

[no] debug <debug-type>
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all Configures the switch to send all debug message
types to configured debug destinations.(Default:
Disabled—No debug messages are sent.)

cdp Sends CDP information to configured debug
destinations.

destination logging—Disables or re-enables syslog logging on
one or more syslog servers configured with the
logging <syslog-ip-addr>
command.session—Assigns or re-assigns
destination status to the terminal device that was
most recently used to request debug output.buffer
—Enables syslog logging to send the debug
message types specified by the debug <debug-
type> command to a buffer in switch memory.

event Configures the switch to send Event Log messages
to configured debug destinations.

This value does not affect the reception
of event notification messages in the
Event Log on the switch.

Event Log messages are automatically enabled to
be sent to debug destinations in these conditions:

• If no syslog server address is configured and you
enter the logging <syslog-ip-addr>
command to configure a destination address.

• If at least one syslog server address is configured
in the startup configuration, and the switch is
rebooted or reset.

Event log messages are the default type of debug
message sent to configured debug destinations.

ip [fib | packet] Sends IP messages to configured destinations.

ip [fib [events]] For the configured debug destinations:events—
Sends IP forwarding information base events.

ip [packet] Enables the specified PIM message type.

Table Continued
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ipv6 [dhcpv6-client | nd | packet] See the "IPv6 Diagnostic and
Troubleshooting" in the IPv6
configuration guide for your switch for
more detailed IPv6 debug options.

When no debug options are included, displays
debug messages for all IPv6 debug options.
dhcpv6-client [events | packet]—Displays
DHCPv6 client event and packet data.nd—Displays
debug messages for IPv6 neighbor
discovery.packet—Displays IPv6 packet messages.

lldp Enables all LLDP message types for the configured
destinations.

security [port-access | port-security |
radius-server | ssh | tacacs-server |
user-profile-mib]

port-access—Sends port-access debug
messages to the debug destination.radius-
server—Sends RADIUS debug messages to the
debug destination.ssh—Sends SSH debug
messages at the specified level to the debug
destination. The levels are fatal, error, info, verbose,
debug, debug2, and debug3.tacacs-server—
Sends TACACS debug messages to the debug
destination.user-profile-mib—Sends user
profile MIB debug messages to the debug
destination.

snmp <pdu> Displays the SNMP debug messages.pdu—Displays
SNMP pdu debug messages.

Debug destinations
Use the debug destination command to enable (and disable)syslog messaging on a syslog server or to a CLI
session for specified types of debug and Event Log messages.

Syntax:

[no] debug destination {<logging | session | buffer>}
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logging Enables syslog logging to configured syslog servers so that the debug message types
specified by the debug <debug-type> command (see Debug messages on page 351)
are sent.(Default: Logging disabled)To configure a syslog server IP address, see 
Configuring a syslog server on page 355.

Debug messages from the switches covered in this guide have a debug
severity level. Because the default configuration of some syslog servers
ignores syslog messages with the debug severity level, ensure that the
syslog servers you want to use to receive debug messages are configured to
accept the debug level. For more information, see Operating notes for
debug and Syslog on page 364.

session Enables transmission of event notification messages to the CLI session that most recently
executed this command. The session can be on any one terminal emulation device with
serial, Telnet, or SSH access to the CLI at the Manager level prompt (switch#_).If more
than one terminal device has a console session with the CLI, you can redirect the
destination from the current device to another device. Do so by executing debug
destination session in the CLI on the terminal device on which you now want to
display event messages.Event message types received on the selected CLI session are
configured with the debug <debug-type> command.

buffer Enables syslog logging to send the debug message types specified by the debug
<debug-type> command to a buffer in switch memory.To view the debug messages
stored in the switch buffer, enter the show debug buffer command.

Logging command
At the global configuration level, the loggingcommand allows you to enable debug logging on specified syslog
servers and select a subset of Event Log messages to send for debugging purposes according to:

• Severity level

• System module

By specifying both a severity level and system module, you can use both configured settings to filter the Event
Log messages you want to use to troubleshoot switch or network error conditions.

After you configure a syslog server and a severity level and/or system module to filter the Event Log
messages that are sent, if you save these settings to the startup configuration file by entering the
write memory command, these debug and logging settings are automatically re-activated after a
switch reboot or power recycle. The debug settings and destinations configured in your previous
troubleshooting session will then be applied to the current session, which may not be desirable.

After a reboot, messages remain in the Event Log and are not deleted. However, after a power
recycle, all Event Log messages are deleted.

If you configure a severity level, system module, or both to temporarily filter Event Log messages, be
sure to reset the values to their default settings by entering the no form of the following commands to
ensure that Event Log messages of all severity levels and from all system modules are sent to
configured syslog servers:

switch(config)# no logging severity <debug | major | error | warning | 
info>
switch(config)# no logging system-module <system-module>
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Configuring a syslog server
Syslog is a client-server logging tool that allows a client switch to send event notification messages to a
networked device operating with syslog server software. Messages sent to a syslog server can be stored to a file
for later debugging analysis.

To use the syslog feature, you must install and configure a syslog server application on a networked host
accessible to the switch. For instructions, see the documentation for the syslog server application.

To configure a syslog service, use the logging <syslog-ip-addr> command as shown below.

When you configure a syslog server, Event Log messages are automatically enabled to be sent to the server. To
reconfigure this setting, use the following commands:

• debug
Specifies additional debug message types (see Debug messages on page 351).

• logging
Configures the system module or severity level used to filter the Event Log messages sent to configured
syslog servers. (See Configuring the severity level for Event Log messages sent to a syslog server on
page 363 and Configuring the system module used to select the Event Log messages sent to a syslog
server on page 364.)

To display the currently configured syslog servers as well as the types of debug messages and the severity-level
and system-module filters used to specify the Event Log messages that are sent, enter the show debug
command (See Debug/syslog configuration commands on page 346).

Syntax:

[no] logging <syslog-ip-addr>
Enables or disables syslog messaging to the specified IP address. You can configure up to six addresses. If you
configure an address when none are already configured, this command enables destination logging (syslog) and
the Event debug type. Therefore, at a minimum, the switch begins sending Event Log messages to configured
syslog servers. The ACL, IP-OSPF, and/or IP-RIP message types are also sent to the syslog servers if they are
currently enabled as debug types. (See Debug messages on page 351.)

no logging Removes all currently configured syslog logging destinations from the
running configuration.Using this form of the command to delete the only
remaining syslog server address disables debug destination logging on the
switch, but the default Event debug type does not change.

no logging <syslog-ip-
address> Removes only the specified syslog logging destination from the running

configuration.Removing all configured syslog destinations with the no
logging command (or a specified syslog server destination with the no
logging <syslog-ip-address> command) does not delete the syslog
server IP addresses stored in the startup configuration.

Deleting syslog addresses in the startup configuration
Enter a no logging command followed by the write memory command.

Verifying the deletion of a syslog server address
Display the startup configuration by entering the show config command.
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Blocking the messages sent to configured syslog servers from the currently configured
debug message type
Enter the no debug <debug-type> command. (See Debug messages on page 351.)

Disabling syslog logging on the switch without deleting configured server addresses
Enter the no debug destination logging command. Note that, unlike the case in which no syslog servers
are configured, if one or more syslog servers are already configured and syslog messaging is disabled,
configuring a new server address does not re-enable syslog messaging. To re-enable syslog messaging, you
must enter the debug destination logging command.

Sending logging messages using TCP
Syntax:

[no] logging <ip-addr> [udp 1024-49151 | tcp 1024-49151]
Allows the configuration of the UDP or TCP transport protocol for the transmission of logging messages to a
syslog server.

Specifying a destination port with UDP or TCP is optional.

Default ports: UDP port is 514

TCP port is 1470

Default Transport Protocol: UDP

Because TCP is a connection-oriented protocol, a connection must be present before the logging information is
sent. This helps ensure that the logging message will reach the syslog server. Each configured syslog server
needs its own connection. You can configure the destination port that is used for the transmission of the logging
messages.

Configuring TCP for logging message transmission using the default port

switch(config)# logging 192.123.4.5 tcp
(Default TCP port 1470 is used.)

Configuring TCP for logging message transmission using a specified port

switch(config)# logging 192.123.4.5 9514
(TCP port 9514 is used.)

Configuring UDP for logging message transmission using the default port

switch(config)# logging 192.123.4.5 udp
(Default UDP port 514 is used.)

Configuring UDP for logging message transmission using a specified port

switch(config)# logging 192.123.4.5 9512
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(UDP port 9512 is used.)

Syntax:

[no] logging facility <facility-name>
The logging facility specifies the destination subsystem used in a configured syslog server. (All configured syslog
servers must use the same subsystem.) Hewlett Packard Enterprise recommends the default (user) subsystem
unless your application specifically requires another subsystem. Options include:

user (default) Random user-level messages

kern Kernel messages

mail Mail system

daemon System daemons

auth Security/authorization messages

syslog Messages generated internally by syslog

lpr Line-printer subsystem

news Netnews subsystem

uucp uucp subsystem

cron cron/at subsystem

sys9 cron/at subsystem

sys10 - sys14 Reserved for system use

local10 - local17 Reserved for system use

Use the no form of the command to remove the configured facility and reconfigure the default (user) value.

Disable LinkUp/Down Syslog messages based on port
This feature provides a per-port basis filter that can restrict the logging of events that are associated with a link
status change. Unimportant linkup/linkdown events can be filtered out, avoiding unwanted messages in the event
log and reducing troubleshooting time.

The specific port-based events to be controlled are:

RMON_PMGR_PORT_UP—Indicates that the port has changed from and off-line to an on-line state. To be online
the port must be both connected to the LAN and enabled through configuration.

RMON_PMGR_PORT_DOWN—Indicates that the port has changed from an on-line state to an offline state. For
this state to occur, the port is physically disconnected from the LAN, disabled through the configuration, or both.

The following rules apply:

• Only one filter can be enabled at a time.

• The maximum number of configured filters is 10.

• A filter is identified by a unique name of up to 16 printable ASCII characters.
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• Filters can be dynamically replaced; the newly enabled filter automatically disables the previous filter.

• A filter always contains a default sub-filter that functions as the filtering rules terminator.

• To apply filtering to an event logging process, the filter must be explicitly enabled from the CLI.

• Enabled filter modules can be dynamically modified; the changes will take effect immediately.

A filter module may include up to 19 option sub-filters and a default sub-filter. The sub-filter types are:

• Severity—checks the severity level of the event log message. The severity values are:

◦ major

◦ warning

◦ error

◦ info

◦ debug

• Event number—Checks the event number of the event log message.

• Regular expression—Checks everything beyond the date/time portion of the event log message.

A sub-filter has a sequence number, criteria to be matched, and a resulting action when a match occurs. All of the
parameters must be specified in order to create the sub-filter.

• Sequence number: Used for the ordering of sub-filters. Range 1-98.

• Matching criteria: Can be the severity level, event number, or a regular expression.

• Action to execute: When a match occurs, the resulting action is either permit the logging of the event, or deny
the logging of the event.

The following sub-filter rules apply:

• Up to 19 optional sub-filters and a default sub-filter are allowed in a filter module.

• Sub-filters in the filter module can be of the same or different types.

• Sub-filter entries can be modified with new criteria and action definitions.

• Sub-filters are executed from the lowest sequence number to the highest. As soon as a match is found the log
event is immediately accepted or rejected and no further matching operation is performed.

• The default sub-filter must always be the last entry in a filter module. It functions as the rules terminator when
the criteria matching performed by the prior sub-filters in a filter does not produce an action.

• The default sub-filter cannot be deleted, re-ordered, or changed. The only parameter that can be modified is
the action parameter of permit or deny. The default is permit.

Creating a filter
Syntax:

[no] logging filter <name> <sequence> [severity <severity>|event-num <num>|<regexp>] [permit|deny]
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Creates a logging filter to restrict which events are logged. The no form of the command removes the logging
filter.

<name>: The name that identifies the filter.

severity <severity>: Specifies the severity of an event—major, warning, error, info, or debug.

event-num <num>: Specifies an event number to match.

deny: If the log entry matches the specified criteria, do not log the event message. No further criteria are
evaluated for a match.

permit: If the log entry matches the specified criteria, log the event message. No further criteria are evaluated for
a match.

Enabling a Filter after Creation
Syntax:

[no] logging filter <name> enable | disable
Enables a log filter. Only one filter can be enabled at a time. An enabled filter automatically disables a previously
enabled filter.

<name>: The name that identifies the filter.

Clearing a Filter
Syntax:

[no] clear logging filter <name|all>
Clears statistics counters for the named logging filter or for all filters.

Viewing Filter Configuration Information
Syntax:

show logging filter name
Displays the logging filter’s configuration information. The Matches column indicates the number of times that
criteria has matched.

Specifying the criteria for a filter and then enabling the filter

switch(config)# logging filter SevWarnFatal 10 severity warning permit
switch(config)# logging filter SevWarnFatal 20 severity major permit
switch(config)# logging filter SevWarnFatal default deny

switch(config)# logging filter SevWarnFatal enable

1. The filter named SevWarnFatal adds a sub-filter of the severity type, with a sequence number of 10. The sub-
filter specifies that a match for an event log message with a severity of “warning” will be logged.

2. The second sub-filter has a sequence number of 20 and a severity type of major. The sub-filter specifies that a
match for an event log message with a severity of “major” will be logged.
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3. The default sub-filter, which is created automatically at the time of filter creation, is always the last entry in the
filter module. It matches “anything” and cannot be changed. You can change the actions to either permit or
deny. This example specifies that any message that did not meet the prior matching criteria will not be logged.

4. The last command enables the filter named SevWarnFatal. If there was another filter enabled, this filter
automatically replaces it and the other filter is disabled.

Specifying the criteria for a filter named noUpDownEvents and then enabling the filter

switch(config)# logging filter noUpDownEvent 10 event-num 76 deny
switch(config)# logging filter noUpDownEvent 20 event-num 77 deny
switch(config)# logging filter noUpDownEvent default permit

switch(config)# logging filter noUpDownEvent enable

1. The filter named noUpDownEvents adds a sub-filter with a type of event-num, and a sequence number of 10.
The sub-filter specifies that a match for an event log message with an event number of “76” will not be logged.

2. The second sub-filter has a sequence number of 20 and a type of event-num. The sub-filter specifies that a
match for an event log message with an event number of “77” will not be logged.

3. The default sub-filter, which is created automatically at the time of filter creation, is always the last entry in the
filter module. It matches “anything” and cannot be changed. You can change the actions to either permit or
deny. This example specifies that any message that did not meet the prior matching criteria will be logged.

4. The last command enables the filter named noUpDownEvents. If there was another filter enabled, this filter
automatically replaces it and the other filter is disabled.

Specifying the criteria for a match using a regular expression and then enabling the filter

switch(config)# logging filter noUpPorts 10 "(A10|A22|B5) is now on-line" deny
switch(config)# logging filter noUpPorts default permit

switch(config)# logging filter noUpPorts enable
This example denies logging of the matching regular expression “port <port-num> is now on-line” for ports A10,
A22, and B5.

1. The filter named noUpPorts adds a sub-filter with a type of regular expression for ports A10, A22, and B5. The
sub-filter specifies the matching criteria for the regular expression and if there is a match, the event log
message is not logged.

2. The default sub-filter specifies that any message that did not meet the prior matching criteria will be logged.

3. The last command enables the filter named noUpPorts.

Specifying the criteria for a match using a regular expression for specific ports

switch(config)# logging filter noStpBlockPorts 10 "(A[1-9]|A10|B[1-4])
.*Blocked by STP" permit
switch(config)# logging filter noStpBlockPorts 20 " .*Blocked by STP" deny
switch(config)# logging filter noStpBlockPorts default permit

switch(config)# logging filter noStpBlockPorts enable
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1. The filter named noStpBlockPorts adds a sub-filter with a type of regular expression with a sequence number
of 10. This rule specifies that event messages from ports A1-A10, and B1-B4 with the “.*Blocked by STP”
expression pattern in the message body are logged.

2. The second command adds a sub-filter with a type of regular expression and a sequence number of 20. This
rule specifies that event messages generated from any ports with the “.*Blocked by STP” expression pattern in
the message body are not logged.

3. The default sub-filter specifies that any message that did not meet the prior matching criteria will be logged.

4. The last command enables the filter named noStpBlockPorts.

Output examples:

The configured logging filters

HP Switch# show logging filter

 Status and Counters - Log Filters Information

  Name            Enabled
  --------------- -------
  noUpPorts       No
  SevWarnFatal    No
  noUpDownEvents  No
  noStpBlockPorts Yes

Output for specified logging filters

HP Switch# show logging filter sevWarnFatal

 Status and Counters - Log Filters Information

  Name             : Enabled
  Enabled          : Yes
  Messages Dropped : 0

  Seq Type      Value                               Action Matches
  --- --------  ----------------------------------  ------ -------
  10  Severity  warning                             Permit 2
  20  Severity  major                               Permit 2
  def          (any)                                Deny   0

switch(config)# show logging filter noStpBlockPorts

 Status and Counters - Log Filters Information

  Name             : noStpBlockPorts
  Enabled          : Yes
  Messages Dropped : 0

  Seq Type      Value                                Action Matches
  --- --------  -----------------------------------  ------ -------
  10  RegExp    (A[1-9]|A10|B[1-4]).*Blocked by STP  Permit 2
  20  RegExp    .*Blocked by STP                     Deny   2
  def           (any)                                Permit 0
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Output of running-config file

HP Switch# show running-config

Running configuration:

; J9470A Configuration Editor; Created on release #XX.15.13.0000x
; Ver #04:0f.ff.3f.ef:24
hostname "HP Switch"
module 1 type j94dda
logging filter "noUpPorts" 10 "(A10|A22|B5) is now on-line" deny
logging filter "noUpPorts" default permit
logging filter "SevWarnFatal" 10 severity warning permit
logging filter "SevWarnFatal" 20 severity major permit
logging filter "SevWarnFatal" default deny
logging filter "noUpDownEvent" 10 event-num 76 deny
logging filter "noUpDownEvent" 20 event-num 77 deny
logging filter "noUpDownEvent" default permit
logging filter "noStpBlockPorts" 10 "(A[1-9]|A10|B[1-4]) .*Blocked by STP" permit
logging filter "noStpBlockPorts" 20 " .*Blocked by STP" deny
logging filter "noStpBlockPorts" default permit
logging filter "noStpBlockPorts" enable
snmp-server community "public" unrestricted
snmp-server host 15.255.133.156 community "public"
snmp-server host 15.255.133.146 community "public"
vlan 1
.
.
.

Adding a description for a Syslog server
You can associate a user-friendly description with each of the IP addresses (IPv4 only) configured for syslog
using the CLI or SNMP.

The Hewlett Packard Enterprise MIB hpicfSyslog.mib allows the configuration and monitoring of
syslog for SNMP (RFC 3164 supported).

Entering the no logging command removes ALL the syslog server addresses without a verification
prompt.

The CLI command is:

Syntax:

logging <ip-addr> [control-descr ZZZZTRISHZZZZ <text_string>] 
 no logging <ip-addr> [control-descr]
An optional user-friendly description that can be associated with a server IP address. If no description is entered,
this is blank. If <text_string> contains white space, use quotes around the string. IPv4 addresses only.

Use the no form of the command to remove the description. Limit: 255 characters

To remove the description using SNMP, set the description to an empty string.
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The logging command with a control description

switch(config)# logging 10.10.10.2 control-descr syslog_one

Adding a priority description
This description can be added with the CLI or SNMP. The CLI command is:

Syntax:

logging priority-descr <text_string> 
 no logging priority-descr
Provides a user-friendly description for the combined filter values of severity and system module. If no
description is entered, this is blank.

If text_string contains white space, use quotes around the string.

Use the no form of the command to remove the description.

Limit: 255 characters

The logging command with a priority description

switch(config)# logging priority-descr severe-pri

A notification is sent to the SNMP agent if there are any changes to the syslog parameters, either
through the CLI or with SNMP.

Configuring the severity level for Event Log messages sent to a syslog
server
Event Log messages are entered with one of the following severity levels (from highest to lowest):

Major A fatal error condition has occurred on the switch.

Error An error condition has occurred on the switch.

Warning A switch service has behaved unexpectedly.

Information Information on a normal switch event.

Debug Reserved for HPE switch internal diagnostic information.

Using the logging severity command, you can select a set of Event Log messages according to their
severity level and send them to a syslog server. Messages of the selected and higher severity will be sent. To
configure a syslog server, see Configuring a syslog server on page 355.

Syntax:

[no] logging severity {< major | error | warning | info | debug >}
Configures the switch to send all Event Log messages with a severity level equal to or higher than the specified
value to all configured Syslog servers.

Default: debug (Reports messages of all severity levels.)
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Use the no form of the command to remove the configured severity level and reconfigure the default value, which
sends Event Log messages of all severity levels to syslog servers.

The severity setting does not affect event notification messages that the switch normally sends to the
Event Log. All messages remain recorded in the Event Log.

Configuring the system module used to select the Event Log messages sent to a syslog
server
Event Log messages contain the name of the system module that reported the event. Using the logging
system-module command, you can select a set of Event Log messages according to the originating system
module and send them to a syslog server.

Syntax:

[no] logging system-module <system-module>
Configures the switch to send all Event Log messages being logged from the specified system module to
configured syslog servers. (To configure a syslog server, see Configuring a syslog server.)

See Event Log system modules for the correct value to enter for each system module.

Default: all-pass (Reports all Event Log messages.)

Use the no form of the command to remove the configured system module value and reconfigure the default
value, which sends Event Log messages from all system modules to syslog servers.

You can select messages from only one system module to be sent to a syslog server; you cannot configure
messages from multiple system modules to be sent. If you re-enter the command with a different system module
name, the currently configured value is replaced with the new one.

This setting has no effect on event notification messages that the switch normally sends to the Event
Log.

Operating notes for debug and Syslog

• Rebooting the switch or pressing the Reset button resets the debug configuration.

Debug option Effect of a reboot or reset

logging (debug destination) If syslog server IP addresses are stored in the startup-config file, they are
saved across a reboot and the logging destination option remains enabled.
Otherwise, the logging destination is disabled.

session (debug destination) Disabled.

ACL (debug type) Disabled.

All (debug type) Disabled.

Table Continued
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Debug option Effect of a reboot or reset

event (debug type) If a syslog server IP address is configured in the startup-config file, the
sending of Event Log messages is reset to enabled, regardless of the
last active setting.

If no syslog server is configured, the sending of Event Log messages is
disabled.

IP (debug type) Disabled.

• Debug commands do not affect normal message output to the Event Log.

Using the debug event command, you can specify that Event Log messages are sent to the debug
destinations you configure (CLI session, syslog servers, or both) in addition to the Event Log.

• Ensure that your syslog servers accept debug messages.

All syslog messages resulting from a debug operation have a "debug" severity level. If you configure the switch
to send debug messages to a syslog server, ensure that the server's syslog application is configured to accept
the "debug" severity level. (The default configuration for some syslog applications ignores the "debug" severity
level.)

• Duplicate IP addresses are not stored in the list of syslog servers.

• If the default severity value is in effect, all messages that have severities greater than the default value are
passed to syslog. For example, if the default severity is "debug," all messages that have severities greater
than debug are passed to syslog.

• There is a limit of six syslog servers. All syslog servers are sent the same messages using the same filter
parameters. An error is generated for an attempt to add more than six syslog servers.

Diagnostic tools

Port auto-negotiation
When a link LED does not light (indicating loss of link between two devices), the most common reason is a failure
of port auto-negotiation between the connecting ports. If a link LED fails to light when you connect the switch to a
port on another device, do the following:

Procedure

1. Ensure that the switch port and the port on the attached end-node are both set to Auto mode.

2. If the attached end-node does not have an Auto mode setting, you must manually configure the switch port to
the same setting as the end-node port. See Port Status and Configuration on page 55.

Ping and link tests
The ping test and the link test are point-to-point tests between your switch and another IEEE 802.3-compliant
device on your network. These tests can tell you whether the switch is communicating properly with another
device.
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To respond to a ping test or a link test, the device you are trying to reach must be IEEE 802.3-
compliant.

Ping test
A test of the path between the switch and another device on the same or another IP network that can respond to
IP packets (ICMP Echo Requests). To use the ping (or traceroute) command with host names or fully
qualified domain names, see DNS resolver on page 380.

Link test
A test of the connection between the switch and a designated network device on the same LAN (or VLAN, if
configured). During the link test, IEEE 802.2 test packets are sent to the designated network device in the same
VLAN or broadcast domain. The remote device must be able to respond with an 802.2 Test Response Packet.

Executing ping or link tests (WebAgent)
To start a ping or link test in the WebAgent:

1. In the navigation pane, click Troubleshooting.

2. Click Ping/Link Test.

3. Click Start.

4. To halt a link or ping test before it concludes, click Stop.

For an Example: of the text screens, see Figure 65: Ping test and link test screen on the WebAgent on page
366.

Figure 65: Ping test and link test screen on the WebAgent

Destination IP Address is the network address of the target, or destination, device to which you want to test a
connection with the switch. An IP address is in the X.X.X.X format where X is a decimal number between 0 and
255.

Number of Packets to Send is the number of times you want the switch to attempt to test a connection.

Timeout in Seconds is the number of seconds to allow per attempt to test a connection before determining that
the current attempt has failed.
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Testing the path between the switch and another device on an IP network
The ping test uses ICMP echo requests and ICMP echo replies to determine if another device is alive. It also
measures the amount of time it takes to receive a reply from the specified destination. The ping command has
several extended commands that allow advanced checking of destination availability.

Syntax:

ping {<ip-address | hostname | switch-num>} [repetitions <1-10000>] [timeout 
<1-60>] [{source <ip-address> | <vlan-id>}] [data-size <0-65471>] [data-fill 
<0-1024>]

ping6 {<ip-address | hostname | [switch-num>]} [repetitions <1-10000>] [timeout 
<1-60>] [{source <ip-address> | <vlan-id>}] [data-size <0-65471>] [data-fill 
<0-1024>]
Sends ICMP echo requests to determine if another device is alive.

{< ip-address | hostname >} Target IP address or hostname of the destination node
being pinged

repetitions <1-10000> Number of ping packets sent to the destination
address.

Default: 1

timeout <1-60> Timeout interval in seconds; the ECHO REPLY must
be received before this time interval expires for the
ping to be successful.

Default: 5

source {<ip-addr | hostname>} Source IP address or hostname. The source IP
address must be owned by the router. If a VLAN is
specified, the IP address associated with the specified
VLAN is used.

data-size <0-65471> Size of packet sent.

Default: 0 (zero)

data-fill <0-1024> The data pattern in the packet.

Default: Zero length string

Ping tests

switch# ping 10.10.10.10
10.10.10.10 is alive, time = 15 ms

switch# ping 10.10.10.10 repetitions 3
10.10.10.10 is alive, iteration 1, time = 15 ms
10.10.10.10 is alive, iteration 1, time = 15 ms
10.10.10.10 is alive, iteration 1, time = 15 ms

switch# ping 10.10.10.10 timeout 2
10.10.10.10 is alive, time = 10 ms
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switch# ping 10.11.12.13
The destination address is unreachable.

Halting a ping test
To halt a ping test before it concludes, press [Ctrl] [C].

To use the ping (or traceroute) command with host names or fully qualified domain names, see 
DNS resolver on page 380.

Issuing single or multiple link tests
Single or multiple link tests can have varying repetitions and timeout periods. The defaults are:

• Repetitions: 1 (1 to 999)

• Timeout: 5 seconds (1 to 256 seconds)

Syntax:

link <mac-address> [repetitions <1-999>] [timeout <1-256>] [vlan < vlan-id >]
Example:

Figure 66: Link tests

Tracing the route from the switch to a host address
The traceroute command enables you to trace the route from the switch to a host address.

This command outputs information for each (router) hop between the switch and the destination address. Note
that every time you execute traceroute, it uses the same default settings unless you specify otherwise for that
instance of the command.
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Syntax:

traceroute {<ip-address | hostname>}

traceroute6 {<ip-address | hostname>}
Lists the IP address or hostname of each hop in the route, plus the time in microseconds for the traceroute
packet reply to the switch for each hop.

{< ip-address | 
hostname >}

The IP address or hostname of the device to which to send the traceroute.

[minttl < 1-255 >]
For the current instance of traceroute, changes the minimum number of hops
allowed for each probe packet sent along the route.

• If minttl is greater than the actual number of hops, the output includes only the
hops at and above the minttl threshold. (The hops below the threshold are not
listed.)

• If minttl matches the actual number of hops, only that hop is shown in the
output.

• If minttl is less than the actual number of hops, all hops are listed.

For any instance of traceroute, if you want a minttl value other than the default,
you must specify that value.(Default: 1)

[maxttl < 1-255 >]
For the current instance of traceroute, changes the maximum number of hops
allowed for each probe packet sent along the route.If the destination address is
further from the switch than maxttl allows, traceroute lists the IP addresses for
all hops it detects up to the maxttl limit.For any instance of traceroute, if you
want a maxttl value other than the default, you must specify that value.(Default: 30)

[timeout < 1-120 
>]

For the current instance of traceroute, changes the timeout period the switch waits
for each probe of a hop in the route. For any instance of traceroute, if you want a
timeout value other than the default, you must specify that value.Default: 5 seconds

[probes < 1-5 >]
For the current instance of traceroute, changes the number of queries the switch
sends for each hop in the route.For any instance of traceroute, if you want a
probes value other than the default, you must specify that value.(Default: 3)

[[source <ip-
addr] | [vlan-
id>]]

The source IP address or VLAN. The source IP address must be owned by the
router. If a VLAN is specified, the IP address associated with the specified VLAN is
used.

For information about traceroute6, see the IPv6 configuration guide for your switch.
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Halting an ongoing traceroute search
Press the [Ctrl] [C] keys.

A low maxttl causes traceroute to halt before reaching the destination address
Executing traceroute with its default values for a destination IP address that is four hops away produces a
result similar to this:

Figure 67: A completed traceroute enquiry

Continuing from the previous Example: (Figure 67: A completed traceroute enquiry on page 370), executing
traceroute with an insufficient maxttl for the actual hop count produces an output similar to this:

Figure 68: Incomplete traceroute because of low maxttl setting

If a network condition prevents traceroute from reaching the destination
Common reasons for traceroute failing to reach a destination include:

• Timeouts (indicated by one asterisk per probe, per hop)

• Unreachable hosts

• Unreachable networks

• Interference from firewalls

• Hosts configured to avoid responding
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Executing traceroute where the route becomes blocked or otherwise fails results in an output marked by
timeouts for all probes beyond the last detected hop. For example, with a maximum hop count of 7 (maxttl = 7),
where the route becomes blocked or otherwise fails, the output appears similar to this:

Figure 69: Traceroute failing to reach the destination address

Viewing switch configuration and operation
In some troubleshooting scenarios, you may need to view the switch configuration to diagnose a problem. The
complete switch configuration is contained in a file that you can browse from the CLI using the commands
described in this section.

Viewing the startup or running configuration file
Syntax:

write terminal
Displays the running configuration.

show config Displays the startup configuration.

show running-config Displays the running-config file.

For more information and examples of how to use these commands, see “Switch Memory and Configuration” in
the basic operation guide.

Viewing the configuration file (WebAgent)
To display the running configuration using the WebAgent:

1. In the navigation pane, click Troubleshooting.

2. Click Configuration Report.

3. Use the right-side scroll bar to scroll through the configuration listing.

Viewing a summary of switch operational data
Syntax:

show tech
By default, the show tech command displays a single output of switch operating and running-configuration data
from several internal switch sources, including:

Chapter 17 Troubleshooting 371

Anexo 04 ITEM 11 (0592666)         SEI 0008478-63.2018.6.02.8000 / pg. 6195



• Image stamp (software version data)

• Running configuration

• Event Log listing

• Boot history

• Port settings

• Status and counters — port status

• IP routes

• Status and counters — VLAN information

• GVRP support

• Load balancing (trunk and LACP)

The show tech command on page 372 shows sample output from the show tech command.

The show tech command

switch# show tech

 show system

  Status and Counters - General System Information

   System Name        : Switch
   System Contact     :
   System Location    :

   MAC Age Time (sec) : 300

   Time Zone          : 0
   Daylight Time Rule : None

   Software revision  : XX.14.xx     Base MAC Addr  : 001871-c42f00
   ROM Version        : XX.12.12     Serial Number  : SG641SU00L

   Up Time            : 23 hours    Memory - Total :
   CPU Util (%)       : 10                    Free :

   IP Mgmt - Pkts Rx  : 759         Packet - Total : 6750
              Pkts Tx : 2             Buffers Free : 5086
                                            Lowest : 4961
                                            Missed : 0

show flash
Image       Size(Bytes)   Date  Version
-----       -----------  ------ --------
To specify the data displayed by the show tech command, use the copy show tech command.

Saving show tech command output to a text file
When you enter the show tech command, a summary of switch operational data is sent to your terminal
emulator. You can use your terminal emulator's text capture features to save the show tech data to a text file for
viewing, printing, or sending to an associate to diagnose a problem.
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For example, if your terminal emulator is the Hyperterminal application available with Microsoft® Windows®
software, you can copy the show tech output to a file and then use either Microsoft Word or Notepad to display
the data. (In this case, Microsoft Word provides the data in an easier-to-read format.)

The following example uses the Microsoft Windows terminal emulator. If you are using a different terminal
emulator application, see the documentation provided with the application.

Procedure

1. In Hyperterminal, click on Transfer|Capture Text….

Figure 70: Capture text window of the Hyperterminal application

2. In the File field, enter the path and file name in which you want to store the show tech output.

Figure 71: Entering a path and filename for saving show tech output

3. Click [Start] to create and open the text file.

4. From the global configuration context, enter the show tech command:

switch# show tech
The show tech command output is copied into the text file and displayed on the terminal emulator screen.
When the command output stops and displays -- MORE --, press the Space bar to display and copy more
information. The CLI prompt appears when the command output finishes.

5. Click on Transfer|Capture Text|Stop in HyperTerminal to stop copying data and save the text file.

If you do not stop HyperTerminal from copying command output into the text file, additional unwanted data can
be copied from the HyperTerminal screen.

6. To access the file, open it in Microsoft Word, Notepad, or a similar text editor.

Viewing more information on switch operation
Use the following commands to display additional information on switch operation for troubleshooting purposes.

Syntax:

show boot-history
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Displays the crash information saved for each management module on the switch.

show history
Displays the current command history. This command output is used for reference or when you want to repeat a
command (See Displaying the information you need to diagnose problems on page 376).

show system-information
Displays globally configured parameters and information on switch operation.

show version
Displays the software version currently running on the switch and the flash image from which the switch booted
(primary or secondary). For more information, see "Displaying Management Information" in the "Redundancy
(Switch 8212zl)" .

show interfaces
Displays information on the activity on all switch ports (see "Viewing Port Status and Configuring Port
Parameters" in the "Port Status and Configuration" ).

show interfaces-display
Displays the same information as the show interfaces command and dynamically updates the output every
three seconds. Press Ctrl + C to stop the dynamic updates of system information. Use the Arrow keys to view
information that is off the screen.

Searching for text using pattern matching with show command
Selected portions of the output are displayed, depending on the parameters chosen.

Syntax:

show {< command option > | < include | exclude | begin >} <regular expression>
Uses matching pattern searches to display selected portions of the output from a show command. There is no
limit to the number of characters that can be matched. Only regular expressions are permitted; symbols such as
the asterisk cannot be substituted to perform more general matching.

include Only the lines that contain the matching pattern are displayed in the output.

exclude Only the lines that contain the matching pattern are not displayed in the output.

begin The display of the output begins with the line that contains the matching pattern.

Pattern matching is case-sensitive.

Following are examples of what portions of the running config file display depending on the option chosen.

Pattern matching with include option

switch(config)# show run | include ipv6 1
   ipv6 enable
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   ipv6 enable
ipv6 access-list "EH-01"
switch(config)#

1Displays only lines that contain “ipv6”.

Pattern matching with exclude option

switch(config)# show run | exclude ipv6 1

Running configuration:

; J9299A Configuration Editor; Created on release #YA.15.XX
; Ver #01:01:00

hostname "HP Switch"
mirror-port 4
qos dscp-map 000000 priority 0
qos dscp-map 001000 priority 1
...
interface 1
  lacp Active
exit
interface 6
  name "Print_Server"
exit
...
vlan 1
  name "DEFAULT_VLAN"
  untagged 1-24
  ip address dhcp-bootp
  exit
...
port-security 17 learn-mode static address-limit 3 action send-alarm
power-over-ethernet pre-std-detect
no ip ssh cipher 3des-cbc
ip timep dhcp
snmp-server community "public" unrestricted
snmp-server community "public" unrestricted
...
vlan 1
  exit

1Displays all lines that do not contain “ipv6”.

Pattern matching with begin option

switch(config)# show run | begin ipv6 1
   ipv6 enable
   no untagged 21-24
   exit
vlan 20
   name "VLAN20"
   untagged 21-24
   ipv6 enable
   no ip address
   exit
policy qos "michael"
   exit
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ipv6 access-list "EH-01"
   sequence 10 deny tcp 2001:db8:255::/48 2001:db8:125::/48
   exit
no autorun
password manager

1Displays the running config beginning at the first line that contains “ipv6”.

The following is an Example: of the show arp command output, and then the output displayed when the
include option has the IP address of 15.255.128.1 as the regular expression.

The show arp command and pattern matching with the include option

switch(config)# show arp

 IP ARP table

  IP Address      MAC Address    Type    Port
  -------------   -------------- ------- ----
  15.255.128.1    00000c-07ac00  dynamic B1
  15.255.131.19   00a0c9-b1503d  dynamic
  15.255.133.150  000bcd-3cbeec  dynamic B1

switch(config)# show arp | include 15.255.128.1
  15.255.128.1    00000c-07ac00  dynamic B1

Displaying the information you need to diagnose problems
Use the following commands in a troubleshooting session to more accurately display the information you need to
diagnose a problem.

Syntax:

alias
Creates a shortcut alias name for commonly used commands and command options.

Syntax:

kill
Terminates a currently running, remote troubleshooting session. Use the show ip ssh command to list the
current management sessions.

Syntax:

[no] page
Toggles the paging mode for show commands between continuous listing and per-page listing.

Syntax:

repeat
Repeatedly executes one or more commands so that you can see the results of multiple commands displayed
over a period of time. To halt the command execution, press any key on the keyboard.
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Syntax:

setup
Displays the Switch Setup screen from the menu interface.

Restoring the factory-default configuration
As part of your troubleshooting process, it may become necessary to return the switch configuration to the factory
default settings. This process:

• Momentarily interrupts the switch operation

• Clears any passwords

• Clears the console Event Log

• Resets the network counters to zero

• Performs a complete self test

• Reboots the switch into its factory default configuration, including deleting an IP address

There are two methods for resetting to the factory-default configuration:

• CLI

• Clear/Reset button combination

Hewlett Packard Enterprise recommends that you save your configuration to a TFTP server before
resetting the switch to its factory-default configuration. You can also save your configuration via
Xmodem to a directly connected PC.

Resetting to the factory-default configuration

Using the CLI
This command operates at any level except the Operator level.

Syntax:

erase startup-configuration
Deletes the startup-config file in flash so that the switch will reboot with its factory-default configuration.

The erase startup-config command does not clear passwords unless include-
credentials has been set, at which time this command does erase username/password
information and any other credentials stored in the config file. For more information, see the section
on "Saving Security Credentials in a Config File" in the access security guide for your switch.
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Using Clear/Reset

Procedure

1. Using pointed objects, simultaneously press both the Reset and Clear buttons on the front of the switch.

2. Continue to press the Clear button while releasing the Reset button.

3. When the Self Test LED begins to flash, release the Clear button.

The switch then completes its self test and begins operating with the configuration restored to the factory
default settings.

Restoring a flash image
The switch can lose its operating system if either the primary or secondary flash image location is empty or
contains a corrupted OS file and an operator uses the erase flash command to erase a good OS image file
from the opposite flash location.

Recovering from an empty or corrupted flash state
Use the switch's console serial port to connect to a workstation or laptop computer that has the following:

• A terminal emulator program with Xmodem capability, such as the HyperTerminal program included in
Windows PC software.

• A copy of a good OS image file for the switch

The following procedure requires the use of Xmodem and copies an OS image into primary flash
only.

This procedure assumes you are using HyperTerminal as your terminal emulator. If you use a
different terminal emulator, you may need to adapt this procedure to the operation of your particular
emulator.

1. Start the terminal emulator program.

Ensure that the terminal program is configured as follows:

• Baud rate: 9600

• No parity

• 8 Bits

• 1 stop bit

• No flow control

2. Use the Reset button to reset the switch.

The following prompt should then appear in the terminal emulator:

Enter h or ? for help.

=>
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3. Because the OS file is large, you can increase the speed of the download by changing the switch console and
terminal emulator baud rates to a high speed. For Example:

a. Change the switch baud rate to 115,200 Bps.

 => sp 115200
b. Change the terminal emulator baud rate to match the switch speed:

I. In HyperTerminal, select Call|Disconnect.

II. Select File|Properties.

III. Click on Configure.

IV. Change the baud rate to 115200.

V. Click on [OK], then in the next window, click on [OK] again.

VI. Select Call|Connect.

VII. Press [Enter] one or more times to display the => prompt.

4. Start the Console Download utility by entering do at the =prompt and pressing [Enter]:

 => do
5. You then see this prompt:

You have invoked the console download utility. 
Do you wish to continue? (Y/N)>_

6. At the above prompt:

a. Enter y (for Yes)

b. Select Transfer|File in HyperTerminal.

c. Enter the appropriate filename and path for the OS image.

d. Select the Xmodem protocol (and not the 1k Xmodem protocol).

e. Click on [Send].
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If you are using HyperTerminal, you will see a screen similar to the following to indicate that the download is in
progress:

Figure 72: Example: of Xmodem download in progress

When the download completes, the switch reboots from primary flash using the OS image you downloaded in
the preceding steps, plus the most recent startup-config file.

DNS resolver
The domain name system (DNS) resolver is designed for use in local network domains, where it enables the use
of a host name or fully qualified domain name with DNS-compatible switch CLI commands.

DNS operation supports both IPv4 and IPv6 DNS resolution and multiple, prioritized DNS servers. (For
information on IPv6 DNS resolution, see the latest IPv6 configuration guide for your switch.)

Basic operation

• When the switch is configured with only the IP address of a DNS server available to the switch, a DNS-
compatible command, executed with a fully qualified domain name, can reach a device found in any domain
accessible through the configured DNS server.

• When the switch is configured with both of the following:

◦ The IP address of a DNS server available to the switch

◦ The domain suffix of a domain available to the configured DNS serverthen:

◦ A DNS-compatible command that includes the host name of a device in the same domain as the configured
domain suffix can reach that device.

◦ A DNS-compatible command that includes a fully qualified domain name can reach a device in any domain
that is available to the configured DNS server.

Example:

Suppose the switch is configured with the domain suffix mygroup.HP Switch.net and the IP address for an
accessible DNS server. If an operator wants to use the switch to ping a target host in this domain by using the
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DNS name "leader" (assigned by a DNS server to an IP address used in that domain), the operator can use either
of the following commands:

Figure 73: Example: of using either a host name or a fully qualified domain name

In the proceeding Example:, if the DNS server's IP address is configured on the switch, but a domain suffix is
either not configured or is configured for a different domain than the target host, the fully qualified domain name
must be used.

Note that if the target host is in a domain other than the domain configured on the switch:

• The host's domain must be reachable from the switch. This requires that the DNS server for the switch must
be able to communicate with the DNS servers in the path to the domain in which the target host operates.

• The fully qualified domain name must be used, and the domain suffix must correspond to the domain in which
the target host operates, regardless of the domain suffix configured in the switch.

Example:

Suppose the switch is configured with the domain suffix mygroup.HP Switch.net and the IP address for an
accessible DNS server in this same domain. This time, the operator wants to use the switch to trace the route to a
host named "remote-01" in a different domain named common.group.net. Assuming this second domain is
accessible to the DNS server already configured on the switch, a traceroute command using the target's fully
qualified DNS name should succeed.

Figure 74: Example: using the fully qualified domain name for an accessible target in another domain

Configuring and using DNS resolution with DNS-compatible commands
The DNS-compatible commands include ping and traceroute.)

Procedure

1. Determine the following:

a. The IP address for a DNS server operating in a domain in your network.

b. The priority (1 to 3) of the selected server, relative to other DNS servers in the domain.

c. The domain name for an accessible domain in which there are hosts you want to reach with a DNS-
compatible command. (This is the domain suffix in the fully qualified domain name for a given host
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operating in the selected domain. See Basic operation on page 380.) Note that if a domain suffix is not
configured, fully qualified domain names can be used to resolve DNS-compatible commands.

d. The host names assigned to target IP addresses in the DNS server for the specified domain.

2. Use the data from the first three bullets in step1 to configure the DNS entry on the switch.

3. Use a DNS-compatible command with the host name to reach the target devices.

Configuring a DNS entry
The switch allows up to two DNS server entries (IP addresses for DNS servers). One domain suffix can also be
configured to support resolution of DNS names in that domain by using a host name only. Including the domain
suffix enables the use of DNS-compatible commands with a target's host name instead of the target's fully
qualified domain name.

Syntax:

[no] ip dns server-address priority <1-3> <ip-addr>
Configures the access priority and IP address of a DNS server accessible to the switch. These settings specify:

• The relative priority of the DNS server when multiple servers are configured

• The IP address of the DNS server

These settings must be configured before a DNS-compatible command can be executed with host name criteria.

The switch supports two prioritized DNS server entries. Configuring another IP address for a priority that has
already been assigned to an IP address is not allowed.

To replace one IP address at a given priority level with another address having the same priority, you must first
use the no form of the command to remove the unwanted address. Also, only one instance of a given server
address is allowed in the server list. Attempting to enter a duplicate of an existing entry at a different priority level
is not allowed .
To change the priority of an existing server address, use the no form of the command to remove the entry, then
re-enter the address with the new priority.

The no form of the command replaces the configured IP address with the null setting. (Default: null)

Syntax:

[no] ip dns domain-name <domain-name-suffix>
This optional DNS command configures the domain suffix that is automatically appended to the host name
entered with a DNS-compatible command. When the domain suffix and the IP address for a DNS server that can
access that domain are both configured on the switch, you can execute a DNS-compatible command using only
the host name of the desired target. (For an Example:, see Example: of using either a host name or a fully
qualified domain name.) In either of the following two instances, you must manually provide the domain
identification by using a fully qualified DNS name with a DNS-compatible command:

• If the DNS server IP address is configured on the switch, but the domain suffix is not configured (null).

• The domain suffix configured on the switch is not the domain in which the target host exists.

The switch supports one domain suffix entry and three DNS server IP address entries. (See the preceding
command description.)

382 Aruba 2530 Management and Configuration Guide for ArubaOS-Switch 16.05

Anexo 04 ITEM 11 (0592666)         SEI 0008478-63.2018.6.02.8000 / pg. 6206



The no form of the command replaces the configured domain suffix with the null setting. (Default: null)

Using DNS names with ping and traceroute: Example:
In the network illustrated in Figure 75: Example: network domain on page 383, the switch at 10.28.192.1 is
configured to use DNS names for DNS-compatible commands in the pubs.outdoors.com domain. The DNS
server has been configured to assign the host name docservr to the IP address used by the document server
(10.28.229.219).

Figure 75: Example: network domain

Configuring switch "A" with the domain name and the IP address of a DNS server for the domain enables the
switch to use host names assigned to IP addresses in the domain to perform ping and traceroute actions on
the devices in the domain. To summarize:

Entity Identity

DNS server IP address 10.28.229.10

Domain name (and domain suffix for hosts in the
domain)

pubs.outdoors.com

Host name assigned to 10.28.229.219 by the DNS
server

docservr

Fully qualified domain name for the IP address used by
the document server (10.28.229.219)

docservr.pubs.outdoors.com

Switch IP address 10.28.192.1

Document server IP address 10.28.229.219

With the above already configured, the following commands enable a DNS-compatible command with the host
name docserver to reach the document server at 10.28.229.219.

Configuring switch "A" in Example: network domain to support DNS resolution

switch(config)# ip dns server-address 10.28.229.10
switch(config)# ip dns domain-name pbs.outdoors.com
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Ping and traceroute execution for the network in Example: network domain

switch(config)# ping docservr
10.28.229.219 is alive, time = 1 ms

switch# traceroute docservr
traceroute to 10.28.229.219
              1 hop min, 30 hops max, 5 sec. timeout, 3 probes
 1 10.28.192.2 1           1 ms       0 ms       0 ms
 2 10.28.229.219 2         0 ms       0 ms       0 ms

• 1First-Hop Router (“B”)

• 2Traceroute Target

As mentioned under the following example, if the DNS entry configured in the switch does not include the domain
suffix for the desired target, you must use the target host's fully qualified domain name with DNS-compatible
commands. For example, using the document server in Figure 75: Example: network domain on page 383 as a
target:

Figure 76: Example: of ping and traceroute execution when only the DNS server IP address is configured

Viewing the current DNS configuration
The show ip command displays the current domain suffix and the IP address of the highest priority DNS server
configured on the switch, along with other IP configuration information. If the switch configuration currently
includes a non-default (non-null) DNS entry, it will also appear in the show run command output.

Figure 77: Example: of viewing the current DNS configuration
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Operating notes

• Configuring another IP address for a priority that has already been assigned to an IP address is not allowed.
To replace one IP address at a given priority level with another address having the same priority, you must first
use the no form of the command to remove the unwanted address. Also, only one instance of a given server
address is allowed in the server list. Attempting to enter a duplicate of an existing entry at a different priority
level is not allowed. To change the priority of an existing server address, use the no form of the command to
remove the entry, then re-enter the address with the new priority.

• To change the position of an address already configured with priority x, you must first use no ip dns
server-address priority x <ip-addr> to remove the address from the configuration, then use ip
dns server-address priority <ip-addr> to reconfigure the address with the new priority. Also, if the
priority to which you want to move an address is already used in the configuration for another address, you
must first use the no form of the command to remove the current address from the target priority.

• The DNS servers and domain configured on the switch must be accessible to the switch, but it is not
necessary for any intermediate devices between the switch and the DNS server to be configured to support
DNS operation.

• When multiple DNS servers are configured on the switch, they can reside in the same domain or different
domains.

• A DNS configuration must include the IP address for a DNS server that is able to resolve host names for the
desired domain. If a DNS server has limited knowledge of other domains, its ability to resolve DNS-compatible
command requests is also limited.

• If the DNS configuration includes a DNS server IP address but does not also include a domain suffix, then any
DNS-compatible commands should include the target host’s fully qualified domain name.

• Switch-Initiated DNS packets go out through theVLAN having the best route to the DNS server, even if
aManagement VLAN has been configured.

• The DNS server address must be manually input. It is not automatically determined viaDHCP.

Event Log messages
Please see the Event Log Message Reference Guide for information about Event Log messages.
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Overview
The switch assigns MAC addresses in these areas:

• For management functions, one Base MAC address is assigned to the default VLAN (VID = 1). (All VLANs on
the switches covered in this guide use the same MAC address.)

• For internal switch operations: One MAC address per port (see Viewing the port and VLAN MAC addresses
on page 388.

MAC addresses are assigned at the factory. The switch automatically implements these addresses for VLANs and
ports as they are added to the switch.

The switch’s base MAC address is also printed on a label affixed to the switch.

Determining MAC addresses
Use the CLI to view the switch's port MAC addresses in hexadecimal format.

Use the menu interface to view the switch's base MAC address and the MAC address assigned to any VLAN
you have configured on the switch. (The same MAC address is assigned to VLAN1 and all other VLANs
configured on the switch.)

The switch's base MAC address is used for the default VLAN (VID =1) that is always available on the
switch. This is true for dynamic VLANs as well; the base MAC address is the same across all VLANs.

Viewing the MAC addresses of connected devices
Syntax:

show mac-address [port-list | mac-addr | vlan < vid>]
Lists the MAC addresses of the devices the switch has detected, along with the number of the specific port on
which each MAC address was detected.

Chapter 18
MAC Address Management
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[port-list]
Lists the MAC addresses of the devices the switch has detected, on the specified
ports.

[mac-addr]
Lists the port on which the switch detects the specified MAC address.Returns the
following message if the specified MAC address is not detected on any port in the
switch:

MAC address <mac-addr> not found.
                

[vlan <vid>]
Lists the MAC addresses of the devices the switch has detected on ports belonging
to the specified VLAN, along with the number of the specific port on which each MAC
address was detected.

Viewing the switch's MAC address assignments for VLANs
configured on the switch
The Management Address Information screen lists the MAC addresses for:

• Base switch (default VLAN; VID=1)

• Any additional VLANs configured on the switch.

Also, the Base MAC address appears on a label on the back of the switch.

The Base MAC address is used by the first (default) VLAN in the switch. This is usually the VLAN
named "DEFAULT_VLAN" unless the name has been changed (by using the VLAN Names screen).
On the switches covered in this guide, the VID (VLAN identification number) for the default VLAN is
always "1," and cannot be changed.

From the Main Menu, select

1. Status and Counters

2. Switch Management Address Information
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If the switch has only the default VLAN, the following screen appears. If the switch has multiple static VLANs,
each is listed with its address data.

Figure 78: Example: of the Management Address Information screen

Viewing the port and VLAN MAC addresses
The MAC address assigned to each switch port is used internally by such features as Flow Control and the
spanning-tree protocol. Using the walkmib command to determine the MAC address assignments for individual
ports can sometimes be useful when diagnosing switch operation.

This procedure displays the MAC addresses for all ports and existing VLANs in the switch,
regardless of which VLAN you select.

Procedure

1. If the switch is at the CLI Operator level, use the enable command to enter the Manager level of the CLI.

2. Enter the following command to display the MAC address for each port on the switch:

switch# walkmib ifPhysAddress
(The above command is not case-sensitive.)

Example:

A switch with the following module configuration shows MAC address assignments similar to those shown in the
example below:
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• A 4-port module in slot A, a 24-port module in slot C, and no modules in slots B and D

• Two non-default VLANs configured

Figure 79: Example: of Port MAC address assignments on a switch
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Configuring the savepower LED option
The savepower led command provides the ability to turn off port LEDs even when a link exists. If power-saving
is enabled, it can be temporarily overridden by the LED Mode button on the front panel. If the LED Mode button is
pressed, the LEDs will behave normally (turn on) for a period of 10 minutes, and then turn off again.

Syntax:

[no] savepower led
Turns power-saving option on or off for the LEDs.

The savepower led command

switch(config)# savepower led
The no form of the savepower led command cancels power saving mode and the LEDs are returned to their
original state.

To display the configured status of the LED power-saving option, use the show savepower led command.

Output of the show savepower led command

switch(config)# show savepower led

 LED Save Power Information

Configuration Status : Enabled

Configuring the savepower port-low-pwr option
The port-low-pwr option puts all the ports on the switch into auto low power mode if they are not linked.

Syntax:

[no] savepower port-low-pwr
Puts ports in low power mode.

When a link is detected, the ports return to normal power mode.

The no form of the command puts the ports into normal power mode.

The savepower port-low-power command

switch(config)# savepower port-low-pwr
To display the status of the power-down feature, use the show savepower portlow-pwr command. The
output shows if the feature is enabled or not enabled.

Chapter 19
Power-Saving Features
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Output for the show savepower port-low-pwr command

switch(config)# show savepower port-low-pwr

  Port Save Power Status: Enabled
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Job Scheduler
The Job Scheduler feature enables the user to schedule commands or jobs on the switch for one time or multiple
times. This is similar in concept to the UNIX ‘cron’ utility. The user can schedule any CLI command that the user
would otherwise enter interactively. This includes commands to enable or disable ports, LEDs, and Power-Over-
Ethernet. Jobs can also be scheduled to be triggered by certain pre-defined events such as switch reboot. The
only major restriction on commands scheduled is that, it should not prompt/ask for any user inputs.

Commands

Job at | delay | enable | disable
Set schedule jobs using the options and set the count for the number of times the job is repeated.

Syntax

job JOB NAME at | delay | enable | disable
Description

Schedule a command to run automatically. Jobs can be scheduled to run once, multiple times on a recurring
basis, or after certain events such as reboots. All commands run with manager privilege in configuration context.

The [no] form of the command deletes a scheduled job.

By default, jobs will be repeated an infinite number of times.

Restrictions

Jobs scheduled at any event will not be counted.

Jobs that are scheduled at the event “reboot” will not work in some multi management switches.

Range

• <1-1000>: is the value range for the count option.

• ([[DD:]HH:]MM): is the format used for the specific delay.

Options

count

Specify the number of times the job should run.

delay

Specify the delay before running the job.

enable

Enable a job that is disabled or expired.

disable

Disable a job. By default, a job is enabled.

Chapter 20
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Usage

job <JOB NAME> at <([DD:]HH:]MM on <WEEKDAY-LIST>)> config-save <COMMAND> count <1-1000>

job <JOB NAME> at <[HH:]MM on [MM/]DD> config-save <COMMAND> count <1-1000>

job <JOB NAME> at <EVENT> config-save <COMMAND>

job <JOB NAME> delay <([DD:]HH:]MM> config-save <COMMAND> count <1-1000>

job <JOB NAME> enable | disable

[no] job <JOB NAME>

Show job
Syntax

show job
Description

Show the jobs scheduled.

Show job

switch# show job

 Job Scheduler Status and Configuration

  Scheduler Status : Waiting for the system time to be set

                     Event or            Repeat  Save 
  Name               Time                Count   Cfg  Command
  ------------------ ---------------- ------- ---- ------------
  Burrrrrrrrrrrr...  reboot              --    Yes chassislocate blink
  baz                reboot              --     No  show time
  foo                17:00 SxTWTxS       --     No  savepower led
  a1                 12:00               2      Yes sh time
  a2                 Every 2:14:30 days  75     Yes vlan 3
  a3                 Every 00:00:25 days 1      No  vlan 4

Caution

The scheduler does not run until the system time is set.

Show job <Name>
Syntax

show job JOB NAME
Description

Show the job by name.
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Show job <JOB NAME>

switch# show job a1

Job Information

Job Name    : a1
Runs At     : 01:24
Config Save : No
Repeat Count: --
Job Status  : Enabled
Run Count   : 1
Error Count : 0
Command     : show time
Job Status  : Enabled

 Output from Last Run
 --------------------
 Tue Dec 15 01:24:00 2015
 

switch# show job a2

Job Information

Job Name    : a2
Runs At     : Every 2:14:30 days
Config Save : Yes
Repeat Count: 75
Run Count   : 0
Error Count : 0
Command     : vlan 3
Job Status  : Disabled

switch# show job foo

Job Information

Job Name    : foo
Runs At     : 17:00 SxTWTxS
Config Save : Yes
Repeat Count: --
Run Count   : 0
Error Count : 0
Command     : savepower led
Job Status  : Enabled
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Overview
The traditional way of restoring a configuration from a backup configuration file required a switch reboot for the
new configurations to be effective. There were network outages and a planned downtime for even minor changes.
The switch configuration can now be restored from a backup configuration without reboot. It also provides hash of
the current running configuration, which can be used for auditing.

The backup configuration can be created using the new command cfg-backup. An existing method of copying a
configuration file from a remote location (for example, TFTP server) can also be used to backup a configuration or
copied from flash.

More information

show hash on page 415
cfg-backup on page 399
cfg-restore config_bkp on page 408

Benefits of configuration restore without reboot

• Restores a new or modified configuration without reboot, with minimal network outage. Any NMS can use this
method for configuration rebase workflows. Only configurations that were exported from the switch can be
imported or restored on the switch.

• Restores the configuration without reboot from a backup configuration when the running configuration has
functional issues, like misconfigurations from remote management stations.

Recommended scenarios
• Use the configuration restore feature for incremental configuration updates.

• Use the force option with cfg-restore, for commands which require reboot.

• Use the verbose option to get detailed progress on the configuration restore process.

More information

Force configuration restore on page 403
cfg-restore verbose on page 407

Use cases
• A user can switch to a new configuration without rebooting the switch.

• If a user loses connectivity after applying the new configuration, a job scheduler executes the job after a
specific time frame. This restores the current configuration to the switch, without rebooting it.

More information

Switching to a new configuration on page 396

Chapter 21
Configuration backup and restore without reboot
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Rolling back to a stable configuration using job scheduler on page 397

Switching to a new configuration

Procedure

1. Back up the configuration using cfg-backup running-config config <config_name> command. In
the following example, the configuration name used is “stable”.
cfg-backup running-config config stable

2. Check the backup configuration using show config files command.

switch(config)# show config files

Configuration files:

id | act pri sec | name
---+-------------+--------
1  |  *   *   *  | config
2  |             | stable
3  |             |
4  |             |
5  |             |

3. Change the running configuration as required, and backup the new configuration as “newfile”.

cfg-backup running-config config newfile

switch(config)# show config files

Configuration files:

 id | act pri sec | name
 ---+-------------+---------
  1 |  *   *   *  | config
  2 |             | stable
  3 |             | newfile
  4 |             |
  5 |             |

4. Check the difference between the “newfile” (running configuration) and “stable” (backed up configuration)
using cfg-restore flash stable diff command. Based on the difference, apply the backed-up
configuration using cfg-restore flash stable command.

5. Check the status of the configuration restore using show cfg-restore status command.

switch(config)# show cfg-restore status

 Status                 : Success
 Config File Name       : stable
 Source                 : Flash
 Time Taken             : 3 Seconds
 Last Run               : Tue Nov 28 18:24:09 2017

 Recovery Mode          : Enabled
 Failure Reason         : -

 Number of Add Commands    : 14
 Number of Remove Commands : 0
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 Time Taken for Each Phase :
      Calculating diff     : 1 Seconds
      Adding commands      : 2 Seconds
      Removing commands    : 0 Seconds

Rolling back to a stable configuration using job scheduler

Procedure

1. Configure the job using alias with the required configuration.

alias <name> <command-list>
job <name> delay [[DD:]HH:]MM <command>
To schedule a job execution with cfg-restore operation once after 15 minutes (00:00:15):

alias "cfg_rollback" "cfg-restore flash stable"
job "cfg_stable" delay 00:00:15 "cfg_rollback" count 1

2. Back up the current stable configuration using the command cfg-backup running-config config
<config_name>.

cfg-backup running-config config stable
3. Check the backup configuration using the command show config files.

switch(config)# show config files

Configuration files:

id | act pri sec | name
---+-------------+-------
1  |  *   *   *  | config
2  |             | stable
3  |             |
4  |             |
5  |             |

4. Edit the configuration as needed. If the user is still connected to the switch, the configuration is stable and the
job which reloads the older configuration can be cancelled using the command no job cfg_stable.

switch(config)# no job cfg_stable
5. If the user loses connectivity after applying the new configuration, the job scheduler executes the job after the

15-minute timer expires, and “stable” configuration is restored. Use the following commands to check the
output:

• switch(config)# show job cfg_stable
• switch(config)# show cfg-restore status

switch(config)# show job cfg_stable

 Job Information

  Job Name       : cfg_stable
  Runs At        : Every 00:00:15 days:hours:minutes
  Config Save    : No
  Repeat Count   : 1
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  Job Status     : Enabled
  Running Status : Active
  Run Count      : 0
  Error Count    : 0
  Skip Count     : 0
  Command        : cfg_rollback

switch(config)# show cfg-restore status
 Status                 : Success
 Config File Name       : stable
 Source                 : Flash
 Time Taken             : 9 Seconds
 Last Run               : Tue Nov 28 20:50:00 2017

 Recovery Mode          : Enabled
 Failure Reason         : -

 Number of Add Commands    : 27
 Number of Remove Commands : 0

 Time Taken for Each Phase :
      Calculating diff     : 4 Seconds
      Adding commands      : 1 Seconds
      Removing commands    : 0 Seconds

If the configuration involves any sensitive information, backup and restore the configuration by
enabling the include-credentials command.

Commands used in switch configuration restore without
reboot
cfg-backup

Backs up the selected configuration to the flash file.

show config files details
Shows a detailed list of configuration files available in the flash.

cfg-restore
Restores the given configuration as the running configuration without reboot.

show cfg-restore status
Shows the status of latest restore performed.

show cfg-restore latest-diff
Views the list of configuration changes that are removed, modified, or added to the running configuration.

show hash
Shows the SHA ID of a startup or running configuration.

Configuration backup
The configuration backup creates a backup of the running or startup configuration of ArubaOS-Switch on-demand
to the flash storage on the switch.

You can now back up the configuration for ArubaOS-Switch feature on the flash storage of the switch. The
maximum number of backup files supported has increased from three to five.
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When you downgrade configuration backup files from five to three, and if the current number of files
is either a four or five, an error message Configuration file <name> stored in config
index 5 is not supported in lower image versions is displayed.

cfg-backup
Syntax
cfg-backup {running-config | startup-config} config <FILE-NAME>

Description

Backs up the selected configuration to the flash file mentioned. When the firmware is downgraded to lower
versions, the details of only three configuration files appear in the show config files command.

Command context
config

Parameters
running-config

Copies the running configuration to switch flash file.
startup-config

Copies the startup configuration to switch flash file.

flash
Name of the configuration file in flash.

Usage
copy {startup-config | running-config} {sftp | tftp} <server address> <FILE-NAME>
The existing copy command copies the startup and running configuration to the TFTP or SFTP server.

Examples

switch(config)# cfg-backup
 running-config       Backup the running configuration to the flash file
                      mentioned.
 startup-config       Backup the startup configuration to the flash file
                      mentioned.

switch(config)# cfg-backup {running-config | startup-config}
 config                Backup the named configuration file.

switch(config)# cfg-backup {running-config | startup-config} config
 ASCII-STR             Enter an ASCII string.

show config files
Syntax
show config files

Description

Shows a list of configuration files available in the flash.
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Command context
config

Examples

switch# show config files
Configuration files:

 id | act pri sec | name
 ---+-------------+---------
  1 |  *   *   *  | config
  2 |             | add
  3 |             | modify
  4 |             | golden_config
  5 |             | poe2
To show the details of saved configuration files:

switch(config)# show config files
 details        Show details of saved configuration files.

switch(config)#show config files details

 Backup Configuration files:

 File Name      : config
 File ID        : 1
 File Size      : 35902 Bytes
 Last Modified  : Mon Jan 01 1990 00:09:28
 Version        : WC.16.05.0000x

 File Name      : add
 File ID        : 2
 File Size      : 35902 Bytes
 Last Modified  : Mon Oct 23 2017 03:42:38
 Version        : WC.16.05.0000x

 File Name      : modify
 File ID        : 3
 File Size      : 35902 Bytes
 Last Modified  : Mon Oct 23 2017 03:42:38
 Version        : WC.16.05.0000x
To view the contents of a configuration file in the flash:

switch# show config add

; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a
snmp-server community "public" unrestricted
vlan 1
   name "DEFAULT_VLAN"
   no untagged 3-10
   untagged 1-2,11-28
   ip address dhcp-bootp
   exit
vlan 100
   name "VLAN100"
   untagged 3-5
   no ip address
   exit

400 Aruba 2530 Management and Configuration Guide for ArubaOS-Switch 16.05

Anexo 04 ITEM 11 (0592666)         SEI 0008478-63.2018.6.02.8000 / pg. 6224



vlan 200
name "VLAN200"
   untagged 6-10
   no ip address
   exit

Configuration restore without reboot
The cfg-restore without reboot command restores the configuration without reboot from a backup
configuration to the running configuration of the switch.

The details about the difference between a running and a backup configuration can be displayed using cfg-
restore {flash | tftp | sftp} <FILE-NAME> diff command.

More information

Configuration backup on page 398
Viewing the differences between a running configuration and a backup configuration on page 413

cfg-restore
Syntax
cfg-restore {flash | tftp <IP-ADDRESS> | sftp <IP-ADDRESS>} <FILE-NAME> [diff |
force | non-blocking | recovery-mode | verbose]

Description

Restores the given configuration as the running configuration without reboot. If the configuration is not suitable to
successfully restore without reboot, the command will return a failure message with details.

The restored configuration commands will be executed on a running configuration, so the name of
the current active configuration does not change after configuration restore, except for the force
option.

Command context
config

Parameters
flash

Copies file from flash.
tftp

Copies file from TFTP server.

sftp
Copies file from SFTP server.

<IP-ADDRESS>

IP address of the TFTP server.

<FILE-NAME>

Name of the backup configuration file to restore into the running configuration.

diff
Provides the list of changes that will be applied on the running configuration.
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force
Forces a reboot if configuration in restored configuration requires a reboot. Applies the configuration with
reboot if the configuration has reboot required commands or system-wide change commands. After a forced
reboot, the name of the configuration changes.

non-blocking
Configuration restoration in non-blocking mode, where actual process happens in the background.

recovery-mode
Enables or disables recovery-mode. Recovery-mode is enabled by default and this retains the current running
configuration if configuration restoration fails.

verbose
Provides the details of configuration restore status and the list of commands to be added or deleted.

Usage

• cfg-restore flash <FILE-NAME> [non-blocking | diff | force | recovery-mode{enable
| disable}]] | [verbose [force | [recovery-mode{enable | disable}] | [diff |
force]

• cfg-restore tftp {<IPV4-ADDR> | <IPV6-ADDR> | <HOSTNAME-STR> <FILE-NAME> [non-
blocking | diff | force | recovery-mode{enable | disable}]] | [verbose [force |
[recovery-mode{enable | disable}]] | [diff |force]

• cfg-restore sftp {<IPV4-ADDR> | <IPV6-ADDR> | <HOSTNAME-STR> | user <name> {<IP-
ADDRESS|IPV6-ADDRESS|HOSTNAME-STR>} | <USERNAME@>{<HOST-NAME> | <IPV4-ADDR> |
<IPV6-ADDR>}} [port <1-65535>] <FILE-NAME> [non-blocking | diff | force |
recovery-mode{enable | disable}]] | [verbose [force | [recovery-mode{enable |
disable}]] | [diff |force]

Examples

switch# cfg-restore
 flash              Copy file from flash. 
 sftp               Copy file from SFTP Server. 
 tftp               Copy file from TFTP Server. 

switch# cfg-restore flash
 FILE-NAME          Name of the backup configuration file to restore into the running 
                       configuration. 

switch# cfg-restore flash config_file
 diff               Provide the list of changes that will be applied on the
                    running configuration.
 force              Apply the configuration with reboot if the
                    configuration has reboot required commands or
                    system-wide change commands present.
 non-blocking       Config restoration in non-blocking mode.
 recovery-mode      To enable/disable recovery-mode.
 verbose               Provide the details of config restore status and the list of commands to be added 
                    or deleted.        

switch# cfg-restore tftp
 HOSTNAME-STR       Specify hostname of TFTP Server.
 IP-ADDR            IP Address of the TFTP Server.
 IPV6-ADDR          IPV6 Address of the TFTP Server.

switch# cfg-restore tftp 10.100.0.12
 FILE-NAME          Name of the backup configuration file to restore into the running 
                       configuration. 

switch# cfg-restore tftp 10.100.0.12 config_file
 diff                Provide the list of changes that will be applied on the
                     running configuration.
 force               Apply the configuration with reboot if the
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                     configuration has reboot required commands or
                     system-wide change commands present.
 non-blocking        Config restoration in non-blocking mode.
 recovery-mode       To enable/disable recovery-mode.
 verbose                Provide the details of config restore status and the list of commands to be added 
                     or deleted.

switch(config)# cfg-restore flash add non-blocking
 diff                Provide the list of changes that will be applied on
                     the running configuration.
 force               Apply the configuration with reboot if the configuration has reboot required commands or
                     system-wide change commands present.
 recovery-mode       To enable/disable recovery-mode.

Force configuration restore
The cfg-restore command fails if a reboot is required. The Configuration restoration is not
allowed as the configuration has reboot required commands error is displayed, along with lines
requiring a reboot. The force option in the cfg-restore command allows a user to force a reboot. The
command is: cfg-restore {flash | tftp | sftp} <FILE-NAME> force.

Before reboot, config is the active configuration. After the device reboots, the backup file becomes the new
active configuration.

id | act pri sec | name
---+-------------+---------------
 1 |  *   *   *  | config
 2 |             | def
 3 |             | golden_config
 4 |             |
 5 |             | 

switch(config)# cfg-restore flash golden_config
Current running-configuration will be replaced with 'golden_config'.
Continue (y/n)? y
Configuration restore is in progress, configuration changes are temporarily
 disabled.
Configuration restoration is not allowed as the configuration has reboot required commands.

switch(config)# show cfg-restore status
 Status                 : Failed
 Config File Name       : golden_config
 Source                 : Flash
 Time Taken             : 5 Seconds
 Last Run               : Mon Oct 30 23:03:19 2017

 Recovery Mode          : Enabled
 Failure Reason         : Reboot required commands present.
 Command : console terminal none

 Number of Add Commands    : 0
 Number of Remove Commands : 1

Time Taken for Each Phase :
      Calculating diff     : 3 Seconds
      Adding commands      : 0 Seconds
      Removing commands    : 0 Seconds

switch# cfg-restore flash golden_config force
Device may be rebooted if the configuration file has reboot required or
system-wide change commands. Do you want to continue  (y/n)?
Current running-configuration will be replaced with 'golden_config'.
Continue (y/n)?
Configuration restore is in progress, configuration changes are temporarily
disabled.

Successfully applied configuration 'golden_config' to running configuration.

Rebooting switch...
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In the preceding output, Command : console terminal none shows that cfg-restore failed because a
reboot is required.

After the switch reboots and comes up, the golden_config becomes the active configuration.

In case of a switch reboot, the switch comes up with the configuration associated with the primary or
secondary.

 id | act pri sec | name
 ---+-------------+------------------------------------------------
  1 |      *   *  | config
  2 |             | def
  3 |  *          | golden_config
  4 |             | 
  5 |             |

switch# show cfg-restore status
 Status                 : Success
 Config File Name       : default
 Source                 : Flash
 Time Taken             : 1 Seconds
 Last Run               : Mon Oct 23 07:17:03 2017

 Recovery Mode          : Enabled
 Failure Reason         : -

 Number of Add Commands    : 0
 Number of Remove Commands : 5

Time Taken for Each Phase :

      Calculating diff     : 1 Seconds
      Adding commands      : 0 Seconds
      Removing commands    : 0 Seconds

Time taken for adding and deleting commands is zero, as the switch reboots. It is similar to
downloading a startup-configuration to the device.

cfg-restore non-blocking

Syntax
cfg-restore {flash | tftp | sftp} <FILE-NAME> non-blocking

Description

Performs restore in non-blocking mode.

Command context
config

Example

switch(config)# cfg-restore flash add non-blocking
Current running-configuration will be replaced with 'add'.
Continue (y/n)? y
Configuration restore is in progress, configuration changes are
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temporarily disabled.
switch(config)#

switch(config)# show cfg-restore status
 Status                 : Success
 Config File Name       : add
 Source                 : Flash
 Time Taken             : 2 Seconds
 Last Run               : Sun Oct 22 22:09:02 2017

 Recovery Mode          : Enabled
 Failure Reason         : -

 Number of Add Commands    : 7
 Number of Remove Commands : 10

Time Taken for Each Phase :                                               
      Calculating diff     : 1 Seconds
      Adding commands      : 0 Seconds
      Removing commands    : 0 Seconds

cfg-restore recovery-mode

Syntax
cfg-restore {flash | tftp | sftp} <FILE-NAME> recovery-mode {enable | disable}

Description

Restores the current running configuration, if a restore to the backup configuration fails. By default, recovery-
mode is enabled.

Command context
config

Usage

To disable recovery mode, use cfg-restore {flash | tftp | sftp} <FILE-NAME> recovery-mode
disable.

Example

With the following running configuration, a restore to the backup file modify fails, but this configuration will be
retained as recovery mode is enabled.

switch(config)# show running-config

Running configuration:

; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a
ip routing
snmp-server community "public" unrestricted
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-28
   ip address dhcp-bootp
   exit
vlan 10
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   name "VLAN10"
   no ip address
   exit

switch(config)# show config modify
; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a
ip default-gateway 172.20.0.1
ip routing
snmp-server community "public" unrestricted
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-28
   ip address dhcp-bootp
   exit
vlan 100
   name "VLAN100"
   no ip address
   exit

switch(config)# cfg-restore flash modify
Current running-configuration will be replaced with 'modify'.
Continue (y/n)? y
Configuration restore is in progress, configuration changes are
 temporarily disabled.

Configuration restore to config 'modify' failed, restored source
 configuration to running configuration.

switch(config)# show running-config

Running configuration:

; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a
ip routing
snmp-server community "public" unrestricted
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-28
   ip address dhcp-bootp
   exit
vlan 10
   name "VLAN10"
   no ip address
   exit

switch(config)# cfg-restore flash modify recovery-mode disable
Current running-configuration will be replaced with 'modify'.
Continue (y/n)? y
Configuration restore is in progress, configuration changes are
 temporarily disabled.

Partially applied configuration 'modify' to running configuration.
Aruba-2930F-24G-PoEP-4SFPP(config)# show running-config

Running configuration:

; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
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hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a
ip routing
snmp-server community "public" unrestricted
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-28
   ip address dhcp-bootp
   exit
vlan 100
   name "VLAN100"
   no ip address
   exit

cfg-restore verbose

Syntax
cfg-restore {flash | tftp | sftp} <FILE-NAME> verbose

Description

Provides the details of configuration restore status and the list of commands to be added or deleted along with
cfg-restore.

Command context
config

Examples

switch(config)# cfg-restore flash config verbose
Current running-configuration will be replaced with 'config'.
Continue (y/n)? y

Configuration restore is in progress, configuration changes are temporarily disabled.

Configuration Restore Information: 

 Status                 : Success
 Config File Name       : config
 Source                 : Flash
 Time Taken             : 6 Seconds
 Last Run               : Tue Nov  7 03:43:07 2017

 Recovery Mode          : Enabled
 Failure Reason         : -

 Number of Add Commands    : 0
 Number of Remove Commands : 12

Time Taken for Each Phase :
      Calculating diff     : 2 Seconds
      Adding commands      : 0 Seconds
      Removing commands    : 0 Seconds

Configuration delete list:

vlan 2
   name "VLAN2"
   no ip address
   exit
vlan 3
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   name "VLAN3"
   no ip address
   exit
vlan 4
   name "VLAN4"
   no ip address
   exit
vlan 5
   name "VLAN5"
   no ip address
   exit

Successfully applied configuration 'config' to running configuration.

cfg-restore config_bkp

Syntax
cfg-restore {tftp <ip-address> | sftp <ip-address>} config_bkp

Description

Downloads and restores a configuration from the TFTP or SFTP server, without rebooting the switch.

The commands from the restored configuration will be executed on the running configuration. The
name of the current active configuration will not change after a configuration restore.

Command context
config

Example

switch(config)# cfg-restore tftp
 HOSTNAME-STR          Specify hostname of TFTP Server.
 IP-ADDR               IP Address of the TFTP Server.
 IPV6-ADDR             IPV6 Address of the TFTP Server.

switch(config)# cfg-restore sftp
 HOSTNAME-STR          Specify hostname of the SFTP server.
 IP-ADDR               IP Address of the SFTP Server.
 IPV6-ADDR             IPV6 Address of the SFTP Server.
 user                  Specify username on the remote system information
 USER@IP-STR           Specify username along with remote system
                       information

switch(config)# cfg-restore tftp 10.100.0.12 pvos/tftp_2930_config_file
Current running-configuration will be replaced with 'tftp_2930_config_file'.
Continue (y/n)? y
Configuration restore is in progress, configuration changes are temporarily disabled.

Successfully applied configuration 'tftp_2930_config_file' to running configuration.

switch(config)# sh cfg-restore status
 Status                 : Success
 Config File Name       : tftp_2930_config_file
 Source                 : TFTP
 Time Taken             : 4 Seconds
 Last Run               : Wed Nov  8 21:11:10 2017

 Recovery Mode          : Enabled
 Failure Reason         : -
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 Number of Add Commands    : 4
 Number of Remove Commands : 7

Time Taken for Each Phase :
      Calculating diff     : 1 Seconds
      Adding commands      : 0 Seconds
      Removing commands    : 0 Seconds

switch(config)# show config files

Configuration files:

 id | act pri sec | name
 ---+-------------+---------
  1 |  *   *   *  | config
  2 |             |
  3 |             |
  4 |             |
  5 |             |

Configuration restore with force option

Prerequisites
Back up the configuration using traditional copy config or cfg-backup commands.

Procedure

1. Execute the show config files command. By default, the config file provides all the associations.

switch(config)# show config files

Configuration files:

 id | act pri sec | name
 ---+-------------+-------
  1 |  *   *   *  | config
  2 |             | file1
  3 |             | file2
  4 |             |
  5 |             |

2. Use cfg-restore flash file1 force command to see the configuration of file1.

switch(config)# cfg-restore flash file1 force
As the file1 configuration requires a reboot, a system reboot occurs. When the switch comes up, file1 is the
new active configuration.

switch(config)# sh config files

Configuration files:

 id | act pri sec | name
 ---+-------------+---------
  1 |      *   *  | config
  2 |  *          | file1
  3 |             | file2
  4 |             |
  5 |             |

Chapter 21 Configuration backup and restore without reboot 409

Anexo 04 ITEM 11 (0592666)         SEI 0008478-63.2018.6.02.8000 / pg. 6233



During a configuration restore with reboot, the association changes. To make the configuration as
a default configuration for subsequent system reboots, use startup-default [<primary|
secondary>] config FILENAME command.

For startup-default config file1:

switch(config)# show config files

Configuration files:

id | act pri sec | name
 --+-------------+---------
 1 |             | config
 2 |  *   *   *  | file1
 3 |             | file2
 4 |             |
 5 |             |

System reboot commands
Following commands require a system reboot:

• secure-mode standard
• secure-mode enhanced
• mesh id [0-9]
• mesh [a-z | A-Z | 0-9]
• max-vlans <257-4094>
• no allow-v2-modules
• qinq (mixedvlan | svlan)
• qos queue-config
• terminal type (vt100 | ansi)
• console (flow-control | terminal)
• vsf member [0-9]
• vsf remove
• access-list grouping
• console baud-rate (speed-sense | 1200 | 2400 | 4800 | 9600 | 19200 | 38400 |

57600 | 115200)

Systemwide change commands
Following commands change the system configuration:

• module [0-9 | a-z | A-Z]
• module [0-9 | a-z | A-Z] type <type>
• igmp lookup-mode ip
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• flexible-module [a-z | A-Z] type <type>
• stacking member [0-9] flexible-module [a-z | A-Z] type <type>

Configuration restore without force option
If the two configuration files backed up are file1 and file2:

Prerequisites
Backup the configuration using either the traditional copy config or the cfg-backup commands.

Procedure

1. Execute the show config files command. By default, the config file provides all the associations.

switch(config)# show config files

Configuration files:

 id | act pri sec | name
 ---+-------------+-------
  1 |  *   *   *  | config
  2 |             | file1
  3 |             | file2
  4 |             |
  5 |             |

2. Use cfg-restore flash file1 command to see the configuration of file1.

switch(config)# cfg-restore flash file1
Even after executing the previous command, associations will remain the same, but the running configuration
is replaced by file1 configuration.

In a configuration restore without reboot, the association remains the same. The default config
file is updated based on the configuration of the restored file.

show cfg-restore status
Syntax
show cfg-restore status

Description

Shows the status of latest restore performed. The running configuration is updated based on the configuration of
the restored file.

Command context
config

Usage
show cfg-restore {status | latest-diff}
This command provides information on:
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• how a restore is performed

• whether a flash file was used from SFTP or TFTP server

• the total time taken to restore

• the time when last restore was initiated

• whether a recovery-mode was enabled

• the number of add and delete commands

• reboot commands present (if any), and

• the split time taken for each phase

Examples

switch(config)# show cfg-restore
 latest-diff           Shows the difference between running and back-up
                       configuration.
 status                Show configuration restoration status.

switch(config)# show cfg-restore status
Status           : [Failed| In progress | Success | Not Started]
Config File name : def
Source           : [-|Tftp|sftp|Flash|REST]
Time taken       : [-|20 Seconds.]
Last Run         : [-|Tue March 07 22:12:16 2017.]

Recovery Mode          : Enabled
Failure Reason         : -

Number of Add Commands    : 0
Number of Remove Commands : 3

Time Taken for Each Phase :
      Calculating diff     : 1 Seconds
      Adding commands      : 0 Seconds
      Removing commands    : 0 Seconds
If the configuration restoration fails, the line number and the failed commands are displayed:

switch(config)# show cfg-restore status
Status           : Failed
Config File name : def
Source           : Flash
Time taken       : 20 Seconds
Last Run         : Sun Oct 22 20:22:54 2017

Recovery Mode          : Enabled
Failure Reason         : Add commands have been failed

Number of Add Commands    : 0
Number of Remove Commands : 3

Time Taken for Each Phase :
      Calculating diff     : 1 Seconds
      Adding commands      : 0 Seconds
      Removing commands    : 0 Seconds

Failed to remove commands:
 Line: 12 vlan 10
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 Line: 15 no ipv6 nd snooping mac-check
Failed to add commands:
 Line: 10 icmp 10.100.0.12 source-inter vlan 1
 Line: 20 udp-echo 10.100.0.12 source vlan 1

The number of add and delete commands is calculated excluding the exit commands in the
configuration file.

Viewing the differences between a running configuration and a backup
configuration

Prerequisites
Use the cfg-restore {flash | tftp | sftp} <FILE-NAME> diff command to view the list of
configuration changes that are removed, modified, or added to the running configuration.

Procedure

1. Execute the show running-config command to show the running configuration of the switch.

switch(config)# show running-config

Running configuration:

; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a
snmp-server community "public" unrestricted
vlan 1
   name "DEFAULT_VLAN"
   no untagged 11-13,15-18
   untagged 1-10,14,19-28
   ip address dhcp-bootp
   exit
vlan 100
   name "VLAN100"
   untagged 11-13
   no ip address
   exit
vlan 300
   name "VLAN300"
   untagged 15-18
   no ip address
   exit

2. Execute the show config golden_config command to show the backup configuration of the switch.

switch(config)# show config golden_config
; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a
; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a

3. Execute the cfg-restore flash golden_config diff command to view the differences that will be
applied.
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switch# cfg-restore flash golden_config diff 

Configuration delete list:

vlan 1
   no untagged 11-13,15-18
   untagged 3-10
   exit
vlan 100
   untagged 11-13
   exit
vlan 300
   name "VLAN300"

   untagged 15-18
   no ip address
   exit

Configuration add list:

vlan 1
   no untagged 3-10
   untagged 11-13,15-18
   exit
vlan 100
   untagged 3-5
   exit
vlan 200
   name "VLAN200"
   untagged 6-10
   no ip address
   exit

If the running and the backup configuration is the same, no difference will be displayed.

switch(config)# cfg-restore flash modify diff

Current config and backup config is identical.

4. Execute the show cfg restore latest-diff command to display the difference between the running
and the backup configuration.

switch(config)# show cfg-restore
 latest-diff           Shows the difference between running and back-up
                       configuration.
 status                Show configuration restoration status.

switch(config)# show cfg-restore latest-diff

Configuration delete list:

ip default-gateway 172.20.0.1
vlan 100
   name "VLAN100"
   no ip address
   exit

Configuration add list:

vlan 10
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   name "VLAN10"
   no ip address
   exit

switch(config)#

Show commands to show the SHA of a configuration
The show commands provide SHA details of the running and startup configurations.

show hash
Syntax
show {config | running-config} hash {recalculate}

Description

Shows SHA ID of startup or running configuration.

Command context
config

Examples

switch# show config
 config
 files                 List saved configuration files.
 hash                  Display the hash calculated for the startup
                       configuration.
 interface             Show the startup configuration for interfaces.
 oobm                  Show the startup configuration for OOBM.
 
To display the hash calculated for the startup configuration:

switch(config)# show config hash
The hash must be calculated.  This may take several minutes.

Continue (y/n)? y

Calculating hash...
Startup Configuration hash:

4f66 8b77 6b66 e5fb 0c12 f7fb 8ea6 b548 af2e 2e03

This hash is only valid for comparison to a baseline hash if
the configuration has not been explicitly changed (such as
with a CLI command) or implicitly changed (such as by the
removal of a hardware module).

switch(config)# show config hash
recalculate           Calculate hash (if needed) without prompting.

switch(config)# show config hash recalculate
Startup Configuration hash:

4f66 8b77 6b66 e5fb 0c12 f7fb 8ea6 b548 af2e 2e03

This hash is only valid for comparison to a baseline hash if
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the configuration has not been explicitly changed (such as
with a CLI command) or implicitly changed (such as by the
removal of a hardware module).
To display the hash calculated for the running configuration:

switch(config)# show running-config hash
The hash must be calculated.  This may take several minutes.

Continue (y/n)? y

Calculating hash...
Running configuration hash:

6d88 0880 98af e8a8 b564 15cd 368e 4269 9d61 4bfa

This hash is only valid for comparison to a baseline hash if
the configuration has not been explicitly changed (such as
with a CLI command) or implicitly changed (such as by the
removal of a hardware module).

Scenarios that block the configuration restoration process
The configuration restoration process is blocked in the following scenarios:

• If the restored configuration file requires a reboot.

• If the restored configuration changes the entire configuration (for example, module add or remove).

More information

cfg-restore on page 401

Limitations
Switch configuration restore without reboot feature does not support the following scenarios:

• Removing a physically present member through cfg-restore command

• Flex-module provisioning or removal on standalone or a stack

• Module provisioning or removal on standalone or a stack

• Adding a VLAN when the VLAN limit is already reached by having dynamic VLANs. Due to timing issues, ports
or dynamic VLANs take some time to become offline or be removed, even after applying a removal command.
In such a case, restore commands fail as normal CLI commands.

• The maximum number of backup configuration files has been increased from three to five. When the firmware
is downgraded to lower versions, the show config files command displays the details to only three
configuration files.

• Restore is allowed based on the available system resource factors.

Blocking of configuration from other sessions
All write operations are not allowed from other sessions (CLI/WebUI/SNMP/REST, and so on) during a
configuration restoration process. Only read operation is allowed. Attempts to use write operation results in the
Configuration restore is in progress, configuration changes are temporarily
disabled error. The following show commands are blocked during a configuration restoration process:
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• show-tech
• show config
• show running-config
• show startup-config

Troubleshooting and support
Switch configuration restore without reboot feature provides CLI support to:

• display the number of commands with line number that failed to restore.

• display the delta between running configuration and the configuration to be restored.

More information

Viewing the differences between a running configuration and a backup configuration on page 413
show cfg-restore status on page 411

debug cfg-restore
Syntax
debug cfg-restore

Description

Debug logs display the commands executed by cfg-restore.

Command context

config and manager

Example

switch(config)# debug cfg-restore
switch(config)# debug destination buffer
switch(config)# show debug buffer
0000:01:39:51.58 CFG mCfgRestoreMgr:cfg-restore to config file "backup_conif"
   started.
0000:01:39:56.45 CFG mCfgRestoreMgr:cfg-restore diff calculated, number of
   commands to add =0 number of commands to delete = 3.
0000:01:39:56.45 CFG mCfgRestoreMgr:cfg-restore iteration count = 1.
0000:01:39:56.51 CFG mCfgRestoreMgr:Command executed = no vlan 2 tagged 9,
   Status = Success.
0000:01:39:56.51 CFG mCfgRestoreMgr:Command deleted = vlan 2 tagged 9.
0000:01:39:56.58 CFG mCfgRestoreMgr:Command executed = no vlan 3 tagged 9,
   Status = Success.
0000:01:39:56.58 CFG mCfgRestoreMgr:Command deleted = vlan 3 tagged 9.
0000:01:39:56.64 CFG mCfgRestoreMgr:Command executed = no vlan 4 tagged 9,
   Status = Success.
0000:01:39:56.65 CFG mCfgRestoreMgr:Command deleted = vlan 4 tagged 9.
0000:01:39:56.65 CFG mCfgRestoreMgr:cfg-restore iteration count = 2.
0000:01:39:59.38 CFG mCfgRestoreMgr:Successfully applied configuration
   'backup_conif' to running configuration.
** Total debug messages = 22
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HPE’s Virtual Technician is a set of tools aimed at aiding network switch administrators in diagnosing and caring
for their networks. VT provides tools for switch diagnoses when faced with unforeseen issues.

To improve the Virtual Technician features of our devices, HPE has added the following tools:

• Cisco Discovery Protocol

• Enabling Debug tracing for MOCANA code

• User diagnostic crash via front panel security button

• User diagnostic crash via the serial console

Cisco Discovery Protocol (CDP)

Show cdp traffic
Syntax

show cdp traffic
Description

Displays the number of Cisco Discovery Protocol (CDP) packets transmitted, received and dropped.

CDP frame Statistics

Port No|Transmitted Frames|Received Frames|Discarded Frames|Error Frames
-------  -----------------  --------------   ---------------  ---------
A1               46                  26              6           7
A2               30                  35              7           9
A3              120                 420              670       670

Clear cdp counters
Syntax

clear cdp counters
Description

Allows a user to clear CDP statistics.

Clear cdp counters

Port No|Transmitted Frames|Received Frames|Discarded Frames|Error Frames
-------  -----------------  --------------   ---------------  ---------
A1          46                   26                6              7

Chapter 22
Virtual Technician
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A2          30                   35                7              9
A3         120                  420               670            670

Enable/Disable debug tracing for MOCANA code

Debug security
Syntax

debug security ssl
Description

Enables the debug tracing for MOCANA code.

Use the [no] parameter to disable debug tracing.

ssl

Display all SSL messages.

User diagnostic crash via Front Panel Security (FPS)
button
Allows the switch’s front panel Clear button to manually initiate a diagnostic reset. In the case of an application
hang, this feature allows you to perform reliable diagnostics by debugging via the front panel Clear button.
Diagnostic reset is controlled via Front Panel Security (FPS) options.

Front panel security password-clear
From the configure context:

Syntax

[no] front-panel-security password-clear <RESET-ON-CLEAR> | factory-reset | 
password-recovery | diagnostic-reset <CLEAR-BUTTON | SERIAL-CONSOLE>
Description

Enable the ability to clear the password(s) and/or configuration via the front panel buttons.

[no] disables the password clear option.

Parameters

• If password-clear is disabled, the password(s) cannot be reset using the clear button on the front panel of
the device.

• If factory-reset is disabled, the configuration/password(s) can not be reset using the clear and reset
button combination at boot time.

• When password-recovery is enabled (and the front panel buttons disabled), a lost password can be
recovered by contacting HPE customer support.

• When password-recovery is disabled, there is no way to access a device after losing a password with the
front panel buttons disabled.
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• If diagnostic-reset is disabled, the user cannot perform a diagnostic switch reset on those rare events
where the switch becomes unresponsive to user input because of unknown reason(s).

• If diagnostic-reset is enabled, the user can perform a diagnostic hard reset which will capture valuable
diagnostic data and reset the switch.

Options

factory-reset

Enable/Disable factory-reset ability.

password-clear

Enable/Disable password clear.

password-recovery

Enable/Disable password recovery.

diagnostic-reset

Enable/Disable diagnostic reset.

Front-panel-security diagnostic-reset
From the configure context:

Syntax

front-panel-security diagnostic-reset <CLEAR-BUTTON | SERIAL-CONSOLE>
Description

Enables the diagnostic reset so that the switch can capture diagnostic data.

• To initiate diagnostic reset via the clear button, press the clear button for at least 30 seconds but not more than
40 seconds.

• To initiate diagnostic switch reset via the serial console, enter the diagnostic reset sequence on the serial
console.

Options

Clear button

Enables the diagnostics by choosing the clear button option.

Serial console

Enables the diagnostics by choosing the serial console option.

[no] front-panel-security diagnostic-reset
From the configure context:

Syntax

[no] front-panel-security diagnostic-reset
Description

Disables the diagnostic reset feature so that the user is prevented from capturing diagnostic data and performing
a diagnostic reset on the switch. Both the sub-options reset-via-serial-console and reset-via-clear-
button will be disabled. This is necessary if the switch becomes unresponsive (hangs) for unknown reasons.
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No front-panel-security diagnostic-reset

no front-panel-security diagnostic-reset

Clear Password       - Enabled
Reset-on-clear     - Disabled
Factory Reset        - Enabled
Password Recovery    - Enabled
Diagnostic Reset     - Disabled

Disabling the diagnostic reset prevents the switch from capturing diagnostic data on those rare
events where the switch becomes unresponsive to user input because of unknown reasons. Ensure
that you are familiar with the front panel security options before proceeding.

Front-panel-security diagnostic-reset clear-button
From the configure context:

Syntax

front-panel-security diagnostic-reset clear-button
Description

This command will enable diagnostic-reset via clear button. The user will be allowed to perform diagnostic reset
by depressing the clear button for 30 seconds and not more than 40 seconds.

Front-panel-security diagnostic-rest clear-button

front-panel-security diagnostic-rest clear-button

Diagnostic Reset     - Enabled
clear-button        - Enabled
serial-console      -Disabled

Disabling the diagnostic reset prevents the switch from capturing diagnostic data on those rare
events where the switch becomes unresponsive to user input because of unknown reasons. Ensure
that you are familiar with the front panel security options before proceeding.

[No] front-panel-security diagnostic-reset clear-button
From the configure context:

Syntax

[no] front-panel-security diagnostic-reset clear-button
Description

Disables the diagnostic-reset via clear button.

Disabling the diagnostic reset prevents the switch from capturing diagnostic data on those rare
events where the switch becomes unresponsive to user input because of unknown reasons. Ensure
that you are familiar with the front panel security options before proceeding.
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Show front-panel-security
Syntax

show front-panel-security
Options

Show front-panel-security

Clear Password    - Enabled
Reset –on-clear   - Disabled
Factory Reset     - Enabled
Password Recovery - Enabled
Diagnostic Reset  - Enabled

By default, user initiated diagnostic reset is enabled.

Diagnostic table

Validation rules

Validation Error

Extra ‘token’ passed after diagnostic-reset. Invalid input: <token>.

FPS Error Log

Event Message

RMON_BOOT_CRASH_RECORD1 Diagnostic reset sequence detected on serial
console; user has initiated diagnostic reset.

On detection on local serial

RMON_BOOT_CRASH_RECORD1 SMM: Diagnostic reset sequence detected
on serial console; user has initiated
diagnostic reset.

On detection on SMM serial console and
signaled to AMM

RMON_BOOT_CRASH_RECORD1 STKM: Diagnostic reset sequence detected
on serial console; user has initiated
diagnostic reset.

On detection on non-commander serial
console and signaled to commander

Table Continued
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Event Message

RMON_BOOT_CRASH_RECORD1 User has initiated diagnostic reset via the
serial console.

Sw_panic() message

RMON_BOOT_CRASH_RECORD1 SMM: User has initiated diagnostic reset via
the serial console.

Sw_panic() message when triggered via
SMM

RMON_BOOT_CRASH_RECORD1 STKM: User has initiated diagnostic reset via
the serial console.

Sw_panic() message when triggered via non-
commander

Console print STKM: HA Sync in progress; user initiated
diagnostic request via the serial console
rejected. Retry after sometime.

Printed on the device console. When standby
is in sync state, we don’t want to crash the
commander. So we report to the user to retry
later

Console print STKM: Member is booting; user initiated
diagnostic request via the serial console
rejected. Retry after sometime.

Printed on the device console. When the
member is till booting, it doesn’t have the
commander member number, thus we can’t
issue UIDC on the commander. So we report
to the user to retry later.

User initiated diagnostic crash via the serial console
Remotely triggers a diagnostic reset of the switch via a serial console. This reset reboots the switch and collects
diagnostic data for debugging an application hang, a system hang or any other rare occurrence. Diagnostic reset
is controlled via FPS options.

The serial sequence to initiate the User Initiated Diagnostic Reset via Serial console is Ctrl+S, Ctrl+T, Ctrl+Q, Ctrl
+T, Ctrl+S.

Front-panel-security diagnostic-reset serial-console
In the configure context:

Syntax

front-panel-security diagnostic-reset serial-console
Enables the diagnostic-reset via serial console. Allows the user to perform diagnostic reset by keying-in
diagnostic reset sequence.
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Front-panel-security diagnostic-reset serial-console

front-panel-security diagnostic-reset serial-console

Diagnostic Reset     - Enabled
clear-button       - Disabled
serial-console     - Enabled

[No] front-panel-security diagnostic-reset serial-console
In the configure context:

Syntax

[no] front-panel-security diagnostic-reset serial-console
Description

Disables the diagnostic-reset via serial console.

No front-panel-security diagnostic-reset serial-console

no front-panel-security diagnostic-reset serial-console

Diagnostic Reset     - Disabled

Disabling the diagnostic reset prevents the switch from capturing diagnostic data on those rare
events where the switch becomes unresponsive to user input because of unknown reasons. Ensure
that you are familiar with the front panel security options before proceeding.

Serial console error messages

Error Message

RMON_BOOT_CRASH_RECORD1 Diagnostic reset sequence detected on serial console;
user has initiated diagnostic reset.

RMON_BOOT_CRASH_RECORD1 SMM: Diagnostic reset sequence detected on serial
console; user has initiated diagnostic reset.

RMON_BOOT_CRASH_RECORD1 STKM: Diagnostic reset sequence detected on serial
console; user has initiated diagnostic reset.

RMON_BOOT_CRASH_RECORD1 User has initiated diagnostic reset via the serial
console.

RMON_BOOT_CRASH_RECORD1 SMM: User has initiated diagnostic reset via the serial
console.

RMON_BOOT_CRASH_RECORD1 STKM: User has initiated diagnostic reset via the serial
console.

Table Continued
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Error Message

Console print STKM: HA Sync in progress; user initiated diagnostic
request via the serial console rejected. Retry after
sometime.

Console print STKM: Member is booting; user initiated diagnostic
request via the serial console rejected. Retry after
sometime.
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Overview
Auto device detection

The command device-profile enables the user to define profiles and configure the associations of profiles to
each device type. By creating a device profile, parameters will be defined for a connection interface by device
type. To configure each parameter under a profile name, a context level is provided.

The command device-profile name <PROFILE NAME> configures for the default values. The default value
is permissible when no user-defined profile is created.

To associate each device type with a device profile, a context level is created which authorizes the user to enable
or disable the profile by device-type. Only the device type aruba-ap is supported.

Rogue AP isolation

The command rogue-ap-isolation configures each device and blocks, logs, or allows a rogue AP when
detected. The command enables or disables rogue AP isolation.

The command clear rogue-ap-isolation is provided to clear the detected rogue AP device MAC address.

Show commands are provided to display the configuration and status of the profiles. Another show command will
display the list of rogue APs detected.

Jumbo frames on a device port

Configure jumbo frame support for the device port. Jumbo frames are not permissible by default.

Enabling jumbo frame support in a profile might affect other ports with different profiles. When a profile has jumbo
frame enabled and is applied to any port, all other ports that are members of any VLAN listed in the profile will
also have jumbo frame support.

Configuration commands

allow-jumbo-frames
Syntax
allow-jumbo-frames
Description

Configure jumbo frame support for the device port. Jumbo frames are not enabled by default.

Enabling jumbo frame support in a profile affects other ports with different profiles. When a profile has jumbo
frames enabled and is applied to any port, all other ports that are members of any VLAN listed in the profile will
also have jumbo frame support.

Chapter 23
Easing Wired/Wireless Deployment feature integration
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Validation rules

Validation Error/Warning/Prompt

Invalid jumbo command. Invalid input.

If jumbo frame support is configured on a VLAN for
which the device profile had overridden the
configuration, display the existing warning.

This configuration change will be delayed because a
device profile that enables jumbo frame support is
applied to a port in this VLAN.

Default AP Profile
Creates a user-defined profile.

The profile name is a valid character string with the maximum permissible length of 32. The default profile is
named default-ap-profile and cannot be modified.

The default configuration parameters may be modified using the command device-<PROFILE NAME>
default-ap-profile . Up to four different profiles may be configured.

The [no] command removes the user-defined profiles.

device-profile
From within the configure context:

Syntax
device-profile <PROFILE-NAME> <DEVICE-TYPE>
    
Description

Create port configuration profiles and associate them with devices. When a configured device type is connected
on a port, the system will automatically apply the corresponding port profile. When the device is disconnected, the
profile is removed after a 2 minute delay. Connected devices are identified using LLDP.

Options

<PROFILE-NAME>

Specify the name of the profile to be configured.

<DEVICE-TYPE>

Specify an approved device-type to configure and attach a profile to.

Parameters

allow-jumbo-frames

Configure jumbo frame support for the device port.

untagged-vlan <VLAN-ID>

Configure this port as an untagged member of specified VLAN.

tagged-vlan <VLAN-LIST>

Configure this port as a tagged member of the specified VLANs.

cos <COS-VALUE>

Configure the Class of Service (CoS) priority for traffic from the device.
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ingress-bandwidth <PERCENTAGE>

Configure ingress maximum bandwidth for the device port.

egress-bandwidth <PERCENTAGE>

Configure egress maximum bandwidth for the device port.

poe-max-power <WATTS>

Configure the maximum PoE power for the device port (in watts).

poe-priority

Configure the PoE priority for the device port.

Usage
[no] device-profile name <PROFILE-NAME>
    
[no] device-profile type <DEVICE>
    

Associating a device with a profile
To associate an Aruba access point (AP) device-type to a user-defined profile, use the context HPE
Switch(device-aruba-ap)#. All Aruba access points use the identifier aruba-ap.

The [no] form of the command removes the device type association and disables the feature for the device type.

The feature is disabled by default.

device-profile type
From within the configure context:

Syntax

device-profile type <DEVICE> [associate <PROFILE-NAME> | enable | disable ]
Description

This command specifies an approved device type in order to configure and attach a profile to it. The profile’s
configuration is applied to any port where a device of this type is connected.

Approved device types

aruba-ap

Aruba access point device.

Options

From within the device-aruba-ap context

associate <PROFILE-NAME>

Associated the specified device type by profile name.

enable

Enables the automatic profile association.

disable

Disables the automatic profile association.
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Usage
[no] device-profile type <DEVICE> [associate <PROFILE-NAME> |enable | disable]
    
Restrictions

Only one device type is supported, aruba-ap, and it is used to identify all the Aruba access points.

Configuring the rogue-ap-isolation command
Used to configure the rogue-ap-isolation command. A block/log option may be configured for when a rogue
AP is identified by the switch. The block/log option may be enabled or disabled. The default action is to block a
rogue AP.

The whitelist command is used to configure any specific MAC addresses excluded from the rogue AP list. The
whitelist configuration is saved in the configuration. The whitelist supports 128 MACs.

The [no] form the command is used to remove the MAC address individually by specifying the MAC.

rogue-ap-isolation
Within the configure context:

Syntax
rogue-ap-isolation
Description

Configure rogue AP isolation and rogue AP Whitelist MAC addresses for the switch. When enabled, the system
detects the MAC address of rogue access points and takes the specified action for traffic or from that address.
The whitelist is used to add MAC addresses of approved access points to the whitelist.

Options

action

Configure the action to take for rogue AP packets. Actions available are enable, disable, block, log, and
whitelist.

block

Block and logs traffic to or from any rogue access points.

log

Log traffic to or from any rogue access points.

enable

Enable the rogue AP Isolation.

disable

Disable the rogue AP Isolation.

whitelist <MAC-ADDRESS>

Configures rogue AP Whitelist MAC addresses for the switch. This option is used to add MAC addresses of
approved access points to the whitelist.

<MAC-ADDR>

Specify the MAC address of the device to be moved from the Rogue AP list to the whitelist.
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Usage
rogue-ap-isolation [enable | disable]
rogue-ap-isolation action [log | block]
[no] rogue-ap-isolation whitelist <MAC-ADDRESS>
    

VXLAN show commands
VXLAN show commands include commands to display the status of a VXLAN feature, tunnels, and tunnel
statistics.

show device-profile
Syntax

Within the configure context:

show device-profile
Description

Show device profile configuration and status.

config

Show the device profile configuration details for a single, or all, profiles.

status

Show currently applied device profiles.

Usage
show device-profile config <PROFILE-NAME>
    
show device-profile status

show device-profile config

Switch# Show device-profile config
 Device Profile Configuration
  Configuration for device profile : default-ap-profile
   untagged-vlan    : 1
   tagged-vlan      : None
   ingress-bandwith : 100%
   egress-bandwith  : 100%
   cos       : 0
   speed-duplex     : auto
   poe-max-power    : 33W
   poe-priority     : High
   allow-jumbo-frames: Enabled

  Configuration for device profile : profile1
   untagged-vlan    : 10
   tagged-vlan      : 40,50,60
   ingress-bandwith : 10%
   egress-bandwith  : 95%
   cos       : 4
   speed-duplex     : auto-10
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   poe-max-power    : 20W
   poe-priority     : Low

show device-profile config profile1

Switch# Show device-profile config profile1
 Device Profile Configuration
  Configuration for device profile : profile1
   untagged-vlan    : 10
   tagged-vlan      : 40,50,60
   ingress-bandwith : 10%
   egress-bandwith  : 95%
   cos       : 4
   speed-duplex     : auto-10
   poe-max-power    : 20W
   poe-priority     : Low

show command device-profile status
Syntax
show device-profile [config | status]
Description

Displays the device-profile configuration or device-profile status.

Options

config

Show device profile configuration details for a single profile or all profiles.

status

Show currently applied device profiles status.

show device-profile status

Switch# show device-profile status

 Device Profile Status
  Port          Device Type      Applied Device Profile
  ----          -----------      ----------------------
  5             aruba-ap         profile1
  10            aruba-ap         profile1

Show rogue-ap-isolation
Syntax
show rogue-ap-isolation
Description

Show rogue access point information.

Options

whitelist

Show rogue access point whitelist information.
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Usage
show rogue-ap-isolation whitelist

show rogue-ap-isolation

Switch# show rogue-ap-isolation

 Rogue AP Isolation 
  Rogue AP Status : Enable
  Rogue AP Action : Block
   Rogue AP MAC                    Neighbor Device 
   -----------------               -----------------
   11:22:33:44:55:66               00:12:34:56:67:89
   aa:bb:cc:dd:ee:ff               00:98:45:56:67:89

show rogue-ap-isolation whitelist

Switch# show rogue-ap-isolation whitelist 

 Rogue AP Whitelist Configuration
  Rogue AP MAC                    
  -----------------             
  11:22:33:44:55:66               
  aa:bb:cc:dd:ee:ff  
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Overview
Every client is associated with a user role. User roles associate a set of attributes for authenticated clients (clients
with authentication configuration) and unauthenticated clients, applied to each user session. User roles must be
enabled globally.

Local user roles are only supported when running YA software.

Examples of user roles are:

• Employee = All access

• Contractor = Limited access to resources

• Guest = Browse Internet

Each user role determines the client network privileges, frequency of reauthentication, applicable bandwidth
contracts, and other permissions. There are a maximum of 32 administratively configurable user roles available
with one predefined and read-only user role called denyall.

A user role consists of optional parameters such as:

• Captive portal profileSpecifies the URL via:

◦ captive-portal profile

or

◦ Vendor Specific Attribute (VSA). RADIUS: HP HP-Captive-Portal-URL = <http://...>

• Ingress user policy

L3 (IPv4 and/or IPv6) ordered list of Classes with actions, with an implicit deny all for IPv4 and IPv6.

• Reauthentication period

The time that the session is valid for. The default is 0 unless the user role is overridden. The default means
that the reauthentication is disabled.

Reauthentication period is required to override the default of 0.

• Untagged VLAN (either VLAN ID or VLAN-name)

VLAN precedence order behavior:

Chapter 24
Local user roles
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◦ If configured, untagged VLAN specified in the user role (VSA Derived Role, UDR, or Initial Role).

◦ Statically configured untagged and/or tagged VLANs of the port the user is on.

Operational notes

• When user roles are enabled, all users that are connecting on ports where authentication is configured will
have a user role applied. User role application happens even if the user fails to authenticate. If the user cannot
be authenticated, the “Initial Role” will be applied to that user.

• The user role may be applied in one of two ways:

◦ Vendor Specific Attribute (VSA)

Type: RADIUS: Hewlett-Packard-Enterprise

Name: HPE-User-Role

ID: 25

Value: <myUserRole>

The RADIUS server (ClearPass Policy Manager) determines application of the VSA Derived Role. The role
is sent to the switch via a RADIUS VSA. The VSA Derived Role will have the same precedence order as
the authentication type (802.1x, WMA).

◦ User Derived Role (UDR

)The User Derived Role is part of Local MAC authentication (LMA) and is applied when user roles are
enabled and LMA is configured.

UDR will have the same precedence as LMA. Precedence behavior of the authentication types will be
maintained, (802.1x -> LMA -> WMA (highest to lowest)).

Restrictions

• User roles cannot be enabled when BYOD redirect, MAC authentication failure redirect, or enhanced web-
based authentication are enabled.

• Web-based authentication is not supported on the same port with other authentication methods when user
roles are enabled.

• show port-access <AUTH-TYPE> commands are not supported when user-roles are enabled. The
command show port-access clients [detail] is the only way to see authenticated clients with their
associated roles.

• aaa port-access auth <port> control commands are not supported when user roles are enabled.

• unauth-vid commands are not supported when user roles are enabled.

• auth-vid commands are not supported when user roles are enabled.

Limitations for web-based authentication

Cannot be combined with other authentication types on same port.

Limitations for LMA

Reauthentication period and captive portal profile are not supported.
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Error messages

Action Error message

Attempting to enable BYOD Redirect when user roles
are enabled.

BYOD redirect cannot be enabled when user roles are
enabled.

Attempting to enable MAFR when user roles are
enabled.

MAC authentication failure redirect cannot be enabled
when user roles are enabled.

Attempting to enable enhanced web-based
authentication when user roles are enabled.

Enhanced web-based authentication cannot be
enabled when user roles are enabled.

Attempting to enable web-based authentication when
other authentication types are enabled for the same
port, and user roles are enabled.

Web-based authentication cannot be enabled with
other authentication types on this port when user roles
are enabled.

switch (config)# show port-access mac-
based clients User roles are enabled. Use show port-access

clients to view client information.

switch (config)# aaa port-access
authenticator e8 control autho 802.1x control mode, Force Authorized/

Unauthorized, cannot be set when user roles are
enabled.

Attempting to enable local user role
when MAFR, BYOD, or EWA are enabled. User roles cannot be enabled when BYOD redirect,

MAC authentication failure redirect, or enhanced web-
based authentication are enabled.

Captive-portal commands

Overview
The Captive Portal profile defines the web address that a user is redirected to for Captive Portal authentication. If
the url is blank, a RADIUS VSA will be used.

There is a predefined profile called use-radius-vsa that is already configured to use the RADIUS
VSA.

Two captive portal profiles are supported:

• Predefined and read-only

Predefined and read-only profile name is use-radius-vsa.

• Customized

[no] aaa authentication captive-portal profile
Syntax
[no] aaa authentication captive-portal profile <PROFILE-STR> [url <URL-STR>]
    
Description
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Create a captive-portal profile. Profiles are used in user roles to direct the user to a designated captive portal
server. When the profile includes a web address, that web address is always used to contact the server. When no
web address is specified, it is obtained from the RADIUS VSA.

A profile does not have to be pre-existing in the switch for it to be configured to a user role.

Options

profile

Configure a captive portal profile.

<PROFILE-STR>

Configure a captive portal profile string 64 characters long.

url

Configure the captive portal server web address.

<URL-STR>

Configure the captive portal server web address string.

Usage
Switch# aaa authentication captive-portal profile <NAME>
    
Switch# aaa authentication captive-portal profile <NAME> url <URL>

Validation rules

Validation Error/Message/Prompt

Attempts made to remove a nonexisting profile will
return an error:

switch# no aaa authentication captive-
portal profile NON_EXISTING_PROFILE

Captive portal profile
NON_EXISTING_PROFILE not found.

When including the configured web address after the
web address parameter:

[no] aaa authentication captive-portal
profile myCaptivePortalProfile url
http://myCPPM.local/guest/
captive_portal_login.php

Invalid input: http://blablabla.com

A profile name with invalid syntax produces an error:

Switch# aaa authentication captive-
portal-profile “this is an invalid name”

#aaa authentication captive-portal-
profile “this is an invalid name”
Invalid character ' ' in name.

When trying to modify a profile that is predefined,
switch# aaa authentication captive-
portal-profile name use-radius-vsa

Captive portal profile use-radius-vsa is read only
and cannot be modified

Table Continued
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Validation Error/Message/Prompt

A profile name that is too long produces an error:

switch# aaa authentication captive-
portal-
profiletest342...;ldklsdjflkdsjflk

The name must be fewer than 64 characters.

When attempting to configure more than the number of
admin configured profiles,switch# aaa
authentication captive-portal-profile
profileNumber2

No more captive portal profiles may be created.

Policy commands

Overview
These commands create a context that may be used to classify the policy. From the existing policy command, a
new policy type called user was added. The new actions are specific to policy user:

• redirect

• permit

• deny

Only L3 classes (IPv4 and IPv6) are currently supported.

The user policy includes “implicit deny all rules” for both IPv4 and IPv6 traffic.

policy user
Syntax
policy user <POLICY-NAME>
    
Description

Create and enter newly created user policy context.

Usage
Switch (config)# policy user employee

[no] policy user
Syntax
[no] policy user <POLICYNAME>
    
Description

Delete and remove specified user policy from switch configuration.

Operating notes
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• The user policy will include implicit “deny all” rules for both IPv4 and IPv6 traffic.

• ipv4 or ipv6 classes must specify source address as any. Specifying host addresses or subnets will result in
the following error message:

Switch (policy-user)# class ipv4 class25 action priority 0 
User policies cannot use classes that have a source IP address specified.

• permit and deny are mutually exclusive.

• ip-precedence and dscp are mutually exclusive.

Usage
switch (config)# no policy user employee

policy resequence
Syntax
policy resequence <POLICYNAME> <START><INCREMENT>
    
Description

Resequence classes and remarks configured within specified user policy. The usage shows resequencing classes
and remarks within user policy “employee” starting at 200 and incrementing by 2.

Usage
Switch (config)# policy user employee 200 2

Commands in the policy-user context
Create classes inside of the policy context before you apply actions to them.

(policy-user)# class
Within the policy-user context:

Syntax
(policy-user)# [no] [<SEQUENCE-NUMBER>] class ipv4 | ipv6 <CLASS-NAME> [action 
permit | deny | redirect captive portal] | [action dscp | ip—precedence <CODEPOINT 
| PRECEDENCE>] [action priority <PRIORITY>] | [action rate-limit kbps <RATE>]
    
Description

Associate a class with ACL or QoS actions for this policy.

Options

Options

deny

Deny all traffic.

DSCP

Specify an IP DSCP.

IP-precedence

Specify the IP precedence.
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permit

Permit all traffic.

priority

Specify the priority.

rate-limit

Configure rate limiting for all traffic.

redirect

Specify a redirect destination.

Usage
Switch(policy-user)# class ipv6 employeeIpv6Http action deny
Switch(policy-user)# class ipv4 http action redirect captive-portal
Switch(policy-user)# class ipv4 dnsDhcp action permit

User role configuration

aaa authorization user-role
Syntax
aaa authorization user-role [enable | disable| [initial-role <ROLE-STR>] |[name <ROLE>]]
    
Description

Configure user roles. A user role determines the client network privileges, the frequency of reauthentication,
applicable bandwidth contracts, along with other permissions. Every client is associated with a user role or the
client is blocked from access to the network.

Options

enable

Enable authorization using user roles.

disable

Disable authorization using user roles.

initial-role

The default initial role “denyall” is used when no other role applies. If a client connects to the switch and does
not have a user role associated, then the initial role is used. Any role can be configured as initial role using
this option. Can be configured at per port level. The per port initial role takes priority over global initial role.

The initial role may be assigned if:

• captive-portal profile is configured with a web address, but the Captive Portal VSA is sent from RADIUS

• captive-portal profile is configured to use the RADIUS VSA but no Captive Portal VSA is sent.

• captive-portal feature is disabled when the captive-portal profile is referenced in the applied user role to the
client.

• The user role feature is enabled with RADIUS authentication, but no user role VSA is returned.

• User role does not exist.
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• Not enough TCAM resource available.

• Access-Reject from RADIUS.

• User role VSA is sent along with invalid attributes.

• RADIUS not reachable.

• VLAN configured on the user role does not exist.

• Captive Portal profile does not exist.

• User policy configured on the user role does not exist.

• Reauthentication period is enabled (nonzero) in the user role for LMA.

• Captive Portal profile is included in the user role for LMA.

name <NAME-STR>

Create or modify a user-role. Role name identifies a user-role. When adding a user-role, a new context will be
created. The context prompt will be named “user-role” (user-role)#.

Usage
Switch# aaa authorization user-role enable
Switch# aaa authorization user-role disable
Switch# aaa authorization user-role name <ROLE1>
    
Switch# [no] aaa authorization user-role enable
Switch# [no] aaa authorization user-role name <ROLE1>
    
Switch# aaa authorization user-role initial-role <ROLE1>
    
Switch# aaa authorization user-role name <MYUSERROLE> policy <MYUSERPOLICY>
    
Switch# aaa authorization user-role name <MYUSERROLE> captive-portal-profile <MYCAPTPORTPROFILE>
    
Switch# aaa authorization user-role name <MYUSERROLE> vlan-id <VID>
    
Switch# aaa authorization user-role name <MYUSERROLE> reauth-period <0-999999999>
    

Error log

Scenario Error Message

If the user tries to delete a user-role
configured as the initial role

User role <INITIAL_ROLE_NAME> is configured as the initial role and
cannot be deleted.

If the user attempts to configure more
than the number of administrator
configured roles

#aaa authorization user-role name roleNumber33. No
more user roles can be created.

Table Continued
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Scenario Error Message

If the user enters a role name that is too
long

switch# aaa authorization user-role
test342....jflkdsjflk. The name must be fewer than 64
characters long.

If the user enters a role name with
invalid syntax

switch# aaa authorization user-role name “this is an
invalid name”. Invalid character ' ' in name.

If the user tries to delete a nonexisting
user-role

User role <NON_EXISTING_ROLE_NAME> not found.

Switch# aaa authorization
user-role name <DENYALL> User role <DENYALL> is read only and cannot be modified.

captive-portal-profile
From within the user-role context:

Syntax
captive-portal-profile <PROFILE_NAME>
    
Description

Assigns a captive portal profile to the user role. The predefined captive portal profile, use-radius-vsa,
indicates that the redirect web address must be sent via RADIUS.

To clear a captive portal profile from the user role, use the [no] version of the command.

policy
From within the user-role context:

Syntax
policy <POLICY_NAME>
    
Description

Assigns a user policy to the user role. To clear a policy from the user role, use the [no] version of the command.

Modification of the user policy, or class contained in a user policy, will force users consuming that
user policy via a user role to be deauthenticated.

reauth-period
From within the user-role context:

Syntax
reauth-period <VALUE>
    
Description

Set the reauthentication period for the user role. Use [0] to disable reauthentication. For RADIUS-based
authentication methods, it will override the RADIUS session timeout. It also overrides any port-based reauth-
period configuration with the exception that LMA does not support a reauth-period.
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Options

<VALUE>

Valid values are 0 – 999,999,999; a required configuration in user roles and it defaults to 0.

(user-role)# reauth-period 100

Set the reauthentication value for the current user role:

(user-role)# reauth-period 100

(user-role)# reauth-period 0

0 is used to disable reauthentication, and it is the default value.

(user-role)# reauth-period 0

Validation rules

Validation Error/Warning/Prompt

(user-role)# reauth-period 10000000 Invalid input: 100000000000000000

VLAN commands
The VLAN must be configured on the switch at the time the user role is applied. Only one of VLAN-
name or VLAN-ID is allowed for any user role.

Modification of the VLAN will force users assigned to that VLAN via a user role to be
deauthenticated.

vlan-id
From within the user-role context:

Subcommand syntax
vlan-id <VLAN-ID>
    
Description

Create a VLAN with id VLAN-ID.

Use the [no] version of the command when clearing the VLAN-ID from the user role:

Usage
(user-role)# no vlan-id

vlan-name
From within the user-role context:

Subcommand syntax
vlan-name <VLAN-NAME>
    
Description

Create a VLAN with the name VLAN-NAME. Only one of VLAN-NAME or VLAN-ID is allowed for any user role.
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Use the [no] version of the command when clearing the VLAN from the user role, by name:

Usage
(user-role)# no vlan-name

vlan-id 100

(user-role)# vlan-id 100

vlan-name vlan100

(user-role)#vlan-name VLAN100

VLAN range commands
This command is executed from a global configuration context.

VLANs specified by VLAN-ID-LIST

Syntax
[no] vlan <VLAN-ID-LIST>

Description

Creates VLANs specified by the VLAN-ID-LIST and returns to the global configuration context. Use the [no]
version of the command to delete the VLANs specified by the VLAN-ID-LIST.

Examples
config# vlan 2-15
config# vlan 5,10,13-20,25
config# no vlan 2-10
config# no vlan 2,5,15-18,25

VLANs specified by VLAN-ID-LIST and tag specified ports specified by PORT-LIST

Syntax
[no] vlan <VLAN-ID-LIST> tagged <PORT-LIST>

Description

Creates VLANs specified by the VLAN-ID-LIST and tags the ports specified by the PORT-LIST to the VLAN-ID-
LIST. If VLANs already exist, the tagging of ports specified by the PORT-LIST is performed.

Use the [no] version of the command to remove the tagged PORT-LIST from a range of VLANs specified by the
VLAN-ID-LIST. After command execution, CLI returns to the global configuration context.

Examples
config# vlan 2-15 tagged A1-A20
config# vlan 5,10,13-20,25 tagged A1-A5,L2,L5-L10
config# vlan 2-20 tagged all
config# no vlan 2-15 tagged A1-A5
config# no vlan 5,10,13-20 tagged A1-A5,L6

Chapter 24 Local user roles 443

Anexo 04 ITEM 11 (0592666)         SEI 0008478-63.2018.6.02.8000 / pg. 6267



Applying a UDR
UDR can be used to assign user roles locally (that is, without RADIUS). LMA has been extended to allow applying
a user role to a MAC address, MAC group, MAC mask, or MAC OUI.

aaa port-access local-mac apply user-role
Syntax
[no] aaa port-access local-mac apply user-role <Role-Name> [ mac-oui <MAC-OUI> | 
mac-mask <MAC-MASK> |mac-addr <MAC-ADDR> | mac-group <MAC-GROUP-NAME>]
Description

Apply user roles.

Options

mac-addr

To apply user role with MAC address.

mac-group

To apply user role with MAC group.

mac-mask

To apply user role with MAC Mask.

mac-oui

To apply user role with MAC OUI.

Usage
[no] aaa port-access local-mac apply user-role <MYUSERROLE> [mac-oui <MAC-OUI>]
    
[no] aaa port-access local-mac apply user-role <MYUSERROLE> [mac-mask <MAC-MASK>]
    
[no] aaa port-access local-mac apply user-role <MYUSERROLE> [mac-addr <MAC-ADDR>]
    
[no] aaa port-access local-mac apply user-role <MYUSERROLE> [mac-group <MAC-GROUP-NAME>]
    

VXLAN show commands
VXLAN show commands include commands to display the status of a VXLAN feature, tunnels, and tunnel
statistics.

show captive-portal profile
Syntax
show captive-portal profile
Description

Show Captive Portal profile configuration.
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show captive-portal profile

(config)# show captive-portal profile

 Captive Portal Profile Configuration
  Name : use-radius-vsa
  Type : predefined
  URL  :
  
  Name : myCaptivePortalProfile
  Type : custom
  URL  : http://mycppm.local/guest/captive_portal_login.php

show user-role
Syntax
show user-role [<ROLE-NAME>] [detailed]
    
Description

Show users role configuration.

Options

<ROLE-NAME>

Show user roles by role-name.

<ROLE-NAME> detailed

Show user roles in detail by role-name.

show user-role

Switch# show user-role 

 User Roles

  Enabled      : <Yes/No>
  Initial Role : denyall

  Type          Name
  ----------    ------------
  local         Employee
  local         Guest
  predefined    denyall

show user-role <ROLE-NAME>

Switch# show user-role captivePortalwithVSA

User Role Information

Name                              : captivePortalwithVSA
  Type                              : local
  Reauthentication Period (seconds) : 0
  Untagged VLAN                     : 610
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  Captive Portal Profile            : use-radius-vsa
  Policy                            : cppolicy

show user-role detailed

The example shows how to configure user roles to use Clearpass as a Captive Portal. The Captive Portal URL is
specified in a RADIUS VSA.

Switch# show user-role captivePortalwithVSA detailed

User Role Information
   Name                              : captivePortalwithVSA
   Type                              : local
   Reauthentication Period (seconds) : 0
   VLAN                              : 610
   Captive Portal Profile            : use-radius-vsa
     URL                             : (use RADIUS VSA)
   Policy                            : cppolicy

Statements for policy "cppolicy"
policy user "cppolicy"
     10 class ipv4 "cppm" action permit
     20 class ipv4 "steal" action redirect captive-portal
     30 class ipv4 "other" action permit
   exit

Statements for class IPv4 "cppm"
class ipv4 "cppm"
     10 match tcp 0.0.0.0 255.255.255.255 1.0.9.15 0.0.0.0 eq 80
     20 match tcp 0.0.0.0 255.255.255.255 1.0.9.15 0.0.0.0 eq 443
   exit

Statements for class IPv4 "steal"
class ipv4 "steal"
     10 match tcp 0.0.0.0 255.255.255.255 0.0.0.0 255.255.255.255 eq 80
     20 match tcp 0.0.0.0 255.255.255.255 0.0.0.0 255.255.255.255 eq 443
   exit

Statements for class IPv4 "other"
class ipv4 "other"
     10 match udp 0.0.0.0 255.255.255.255 0.0.0.0 255.255.255.255 eq 53
     20 match udp 0.0.0.0 255.255.255.255 0.0.0.0 255.255.255.255 eq 67
     30 match icmp 0.0.0.0 255.255.255.255 0.0.0.0 255.255.255.255
   exit

show port-access clients
Syntax
show port-access clients [detailed]
Description

Use this command to display the status of active authentication sessions.

show port-access clients

Port Access Client Status

Port  Client Name   MAC Address   IP Address      User Role       Type VLAN
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----- ------------- ------------- --------------- -------------------- ------
1/A18 001517581ec4  001517-581ec4 10.108.1.201    ixia1           MAC   108
A7                  000c29-5121fc n/a             denyall         LOCAL
A8                  000c29-d12996 n/a             myrole          LOCAL 42

show port-access clients detailed

Switch (config)# show port-access clients detailed

 Port Access Client Status Detail
  Client Base Details :
   Port            : 1/A18                 Authentication Type : mac-based
   Client Status   : authenticated         Session Time        : 11 seconds
   Client Name     : 001517581ec4          Session Timeout     : 60 seconds
   MAC Address     : 001517-581ec4
   IP              : 10.108.1.201

 User Role Information
   Name                              : ixia1
   Type                              : local
   Reauthentication Period (seconds) : 60
   Untagged VLAN                     : 108
   Tagged VLANs                      :
   Captive Portal Profile            :
   Policy                            : policyIxia1

Statements for policy "policyIxia1"
policy user "policyIxia1"
     10 class ipv4 "classIxia1" action rate-limit kbps 11000
   exit

Statements for class IPv4 "classIxia1"
class ipv4 "classIxia1"
     10 match ip 0.0.0.0 255.255.255.255 0.0.0.0 255.255.255.255
   exit
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Overview
The Port QoS Trust feature restricts which packet QoS information may be used to determine inbound queue
servicing and any priority information to be permitted into the local hop.

Port QoS Trust Mode configuration allows preservation or removal of the inbound QoS priorities carried in Layer 2
(the VLAN cos or Priority CodePoint (PCP) value, known as the 802.1p priority tag) and/or in Layer 3 (the IP-ToS
byte, in IP-Precedence or IP-Diffserv mode). The different modes let the customer trust all, some, or no packet
priority fields.

The per-port configuration enables the customer to trust some sources or devices and not others. This feature is
mutually exclusive with any active port-priority configuration.

Configuration commands
qos trust
Syntax
qos trust [default|dot1p|dscp|ip-prec|none|device [none|<DEVICE-TYPE>]]
      
Description

Set the QoS Trust Mode configuration for the port.

Options

default

Trust 802.1p priority and preserve DSCP or IP-ToS.

device <DEVICE-TYPE>

On approved devices, trust IP-ToS Differentiated-Services in IP packets, and use the DSCP-MAP to remark
the 802.1p priority. If the DSCP codepoint does not have an associated priority, the priority will be remarked to
0. On unapproved devices, trust 802.1p priority and preserve any IP- ToS values.

dot1p

Trust 802.1p priority and preserve DSCP or IP-ToS.

dscp

Trust IP-ToS Differentiated-Services in IP packets, and use the DSCP-MAP to remark the 802.1p priority. If
the DSCP codepoint does not have an associated 802.1p priority, the priority will be remarked to 0.

ip-precedence

Trust IP-ToS IP-Precedence mode in IP packets and remark the 802.1p priority.

none

Do not trust either the 802.1p priority or the IP-ToS values.

QoS trust devices

Chapter 25
Port QoS Trust Mode
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aruba-ap

Aruba Access point device.

none

Clear all trusted devices from port.

Both SNMP and the CLI will verify that the current QoS Port Priority and desired QoS Trust Mode
configuration are not mutually exclusive (and conversely).

qos dscp-map
Syntax
qos dscp-map <CODEPOINT> priority <PRIORITY> [name <NAME> | default | legacy]
      
Description

Modifies DSCP mapping.

Options

default

Returns switch to the fully mapped factory-default configuration.

legacy

Restore the legacy default behavior (partial mapping) used in earlier code releases.

Show commands

show qos trust
Syntax
show qos trust [device] <PORT>
    
Description

Shows port-based QoS trust configuration

Options

device

Show list of trusted devices per-port.

<port>

Show trusted devices on a single port.

Usage
show qos trust [device | [ethernet <PORT-LIST> ]
    

show qos trust

switch# show qos trust
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Port-based qos Trust Configuration

  Port    Trust Mode   | Device Trust State ---- --- ----
  A1      Default      |    
  A2      Default      |     
  A3      Device**     | Trusted
  A4      IP-Prec      |
  A5      Dot1p        |
  A5      None         |
  A5      DSCP         |
  A5      Device**     | 
  A5      Dot1p        |

** For a list of trusted devices per-port, use the command show qos trust device.
To show trusted devices on a single port, use the command show qos trust device <PORT>.
      

show qos trust device

switch# show qos trust device

Port-Based QoS Trust Configuration

  Port    Trusted Devices
  ------- ---------------
  A1      aruba-ap
  A2      aruba-ap
  A4      aruba-ap

show qos trust device <PORT>

switch# show qos trust device <PORT>

Port A4 QoS Trust Configuration
   Current state: Trusted

   Trusted Devices: aruba-ap

Validation rules
Validation Error/Warning/Prompt

qos trust 
<UNSUPPORTEDDEVICETYPE>
                

Invalid input: %s

no qos trust <ANYVALUE>
                

Invalid command. To disable trust for a port, use
qos trust none. To return to the default
configuration and leave priority information
unchanged, use qos trust default.

QoS priority when trust mode is
anything other than <NONE> or
<DEFAULT>.

The port QoS trust mode must be <DEFAULT>
or <NONE> to configure the QoS port priority
feature.

Table Continued
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Validation Error/Warning/Prompt

QoS DSCP when trust mode is
anything other than <NONE> or
<DEFAULT>.

The port QoS trust mode must be <DEFAULT>
or <NONE> to configure the QoS port priority
feature.

QoS trust dot1.p when any port
QoS priority is enabled.

The port QoS priority feature must be disabled
before configuring this port QoS trust mode.

QoS trust ip-prec when any port QoS
priority is enabled.

The port QoS priority feature must be disabled
before configuring this port QoS trust mode.

QoS trust DSCP when any port QoS
priority is enabled.

The port QoS priority feature must be disabled
before configuring this port QoS trust mode.

QoS trust device when any port QoS
priority is enabled.

The port QoS priority feature must be disabled
before configuring this port QoS trust mode.
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Net-service Overview
Net-service names are used as alias in defining ACL rules for defined lists. An alias of net-service will configure a
list of hosts, networks, or subnets.

Extended ACL can have both source IP, destination IP and port number along with protocol in its ACE. An alias-
based ACE for an extended ACL therefore allows the use of an alias of net-service protocol and destination port.

Limitations

• Alias-based ACE will not support access-control based on source port which is a limitation of the net-service
command. The use of net-service will also restrict operators specified for port number to equals and range.

◦ Operators lt, gt, equal,negative, and range for the source port in the ACL rule are not specified using
the options available in net-service.

◦ Operators lt, gt, negative are not specified for destination port using the options available in net-
service.

◦ Only the ACL will be affected when changes are made to an existing net-service. Either the rule must be
reapplied to the ACL or the switch must be rebooted to affect the service.

netservice [tcp | udp | port]
Syntax
[no] netservice <NAME-STR> [tcp | udp | <PROTOCOL>] 
 port <PORT-LIST>
Description

Configures net-service.

Parameters

protocol

IP protocol number.

Range: 0-255

TCP

Configure an alias for a TCP protocol.

UDP

Configure an alias for a UDP protocol.

port

Specify a single port or a list of noncontiguous port numbers, by entering up to six port numbers, separated by
commas or range of ports.

Range: 0-65535

Chapter 26
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Example net-service tcp-service tcp 100

     net-destination src-ip
      host 10.120.0.1
      host 10.91.1.1
      host 10.0.100.12   

   net-destination destn-ip 
      host 16.90.51.12
      host 10.93.24.1

   net-service tcp-service tcp 100
   ip access-list extended “acl1”
      permit alias src-ip alias destn-ip alias tcp-service

Net-destination overview
The use of net-destination and net-service helps reduce effort required to configure ACL rules.

Net-destination is a list of hosts, networks, or subnets that are used to configure an ACL rules.

There are two types of ACLs supported and configured on the switch:

• Standard

• Extended

Standard

The standard ACL can have an IP source or network in the ACE. Defining the alias-based ACE for standard ACL,
only use an alias of net-destination for the source.

Example - standard

net-destination src-ip
      host 10.120.0.1
      host 10.91.1.1
      host 10.0.100.12   

   net-destination destn-ip 
      host 16.90.51.12
      host 10.93.24.1

   net-service tcp-service tcp 100
   ip access-list extended “acl1”
      permit alias src-ip alias destn-ip 
         alias tcp-service
Extended

The extended ACL can have both source IP, destination IP and port number along with protocol in its ACE.
Defining an alias-based ACE for an extended ACL can use an alias of net-destination for the source and
destination and an alias of net-service for the protocol and destination port. Alias-based ACE will not support
access-control based on source port which is a limitation of the net-service command. The use of net-service will
also restrict the operators that can be specified for port number to equalsand range.

Example - extended

HP-Switch-5406Rzl2(config)# ip access-list extended aext1
HP-Switch-5406Rzl2(config-ext-nacl)#
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   permit tcp host 10.100.12.1 gt 23 16.90.0.0 /16 range 200 400
HP-Switch-5406Rzl2(config-ext-nacl)# exit 
Limitations

• Limited to IPv4 addresses per syntax.

• Any changes made to an existing net-destination that is used by an ACL, will be applied on the ACL only when
the rule is reapplied to it or when switch is rebooted.

• The number of entries for a single net-destination is limited. The number of net-destinations configurable on a
switch is also limited.

• A considerable amount of memory (for global structures) will be allocated when alias-based ACEs are
configured which may cause issues on a switch with low memory.

• The Host or Domain name cannot be specified as an entry in a net-destination.

• Application level gateway will not be supported as the existing ACL infra does not support ALG.

• SNMP support to configure and delete net-destination, net-service, and the alias-based rules will not be
provided.

• The ‘invert’ and ‘range’ option have been deprecated as per ArubaOS-Switch 7.4 CLI Reference Guide and
hence will not be supported. However, the functionality of ‘invert’ option can be achieved through the ‘deny’
rule.

• RADIUS server-based ACL application to interface/VLAN will not be supported for ACLs with alias-based
rules.

net-destination host |position | network
Syntax
[no] netdestination <NAME-STR> [host <IP-ADDR>
 [position <NUM>] network <IP-ADDR/MASK-LENGTH>
 [position <NUM>]]
Description

Net-destination is a list of hosts, networks, or subnets that are used to configure an ACL rule.

Parameters

host

Configures a single IPv4 host.

network

An IPv4 subnet consisting of an IP address and netmask.

no

Removes any configured item in list or an entire net-destination.

position

Specifies the position of a host, network, or range in the net-destination. This optional parameter is specific to
a net-destination and may only be used to sort entries in a list.
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show net-destination
Syntax
show net-destination <NAME-STR>
Description

Show a host-specific net-destination.
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Networking Websites
Hewlett Packard Enterprise Networking Information Library

www.hpe.com/networking/resourcefinder

Hewlett Packard Enterprise Networking Software

www.hpe.com/networking/software

Hewlett Packard Enterprise Networking website

www.hpe.com/info/networking

Hewlett Packard Enterprise My Networking website

www.hpe.com/networking/support

Hewlett Packard Enterprise My Networking Portal

www.hpe.com/networking/mynetworking

Hewlett Packard Enterprise Networking Warranty

www.hpe.com/networking/warranty

General websites
Hewlett Packard Enterprise Information Library

www.hpe.com/info/EIL

For additional websites, see Support and other resources.

Chapter 27
Websites
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Accessing Hewlett Packard Enterprise Support
• For live assistance, go to the Contact Hewlett Packard Enterprise Worldwide website:

http://www.hpe.com/assistance

• To access documentation and support services, go to the Hewlett Packard Enterprise Support Center website:

http://www.hpe.com/support/hpesc

Information to collect

• Technical support registration number (if applicable)

• Product name, model or version, and serial number

• Operating system name and version

• Firmware version

• Error messages

• Product-specific reports and logs

• Add-on products or components

• Third-party products or components

Accessing updates
• Some software products provide a mechanism for accessing software updates through the product interface.

Review your product documentation to identify the recommended software update method.

• To download product updates:

Hewlett Packard Enterprise Support Center
www.hpe.com/support/hpesc

Hewlett Packard Enterprise Support Center: Software downloads
www.hpe.com/support/downloads

Software Depot
www.hpe.com/support/softwaredepot

• To subscribe to eNewsletters and alerts:

www.hpe.com/support/e-updates

• To view and update your entitlements, and to link your contracts and warranties with your profile, go to the
Hewlett Packard Enterprise Support Center More Information on Access to Support Materials page:

Chapter 28
Support and other resources
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www.hpe.com/support/AccessToSupportMaterials

Access to some updates might require product entitlement when accessed through the Hewlett
Packard Enterprise Support Center. You must have an HPE Passport set up with relevant
entitlements.

Customer self repair
Hewlett Packard Enterprise customer self repair (CSR) programs allow you to repair your product. If a CSR part
needs to be replaced, it will be shipped directly to you so that you can install it at your convenience. Some parts
do not qualify for CSR. Your Hewlett Packard Enterprise authorized service provider will determine whether a
repair can be accomplished by CSR.

For more information about CSR, contact your local service provider or go to the CSR website:

http://www.hpe.com/support/selfrepair

Remote support
Remote support is available with supported devices as part of your warranty or contractual support agreement. It
provides intelligent event diagnosis, and automatic, secure submission of hardware event notifications to Hewlett
Packard Enterprise, which will initiate a fast and accurate resolution based on your product's service level.
Hewlett Packard Enterprise strongly recommends that you register your device for remote support.

If your product includes additional remote support details, use search to locate that information.

Remote support and Proactive Care information
HPE Get Connected

www.hpe.com/services/getconnected
HPE Proactive Care services

www.hpe.com/services/proactivecare
HPE Proactive Care service: Supported products list

www.hpe.com/services/proactivecaresupportedproducts
HPE Proactive Care advanced service: Supported products list

www.hpe.com/services/proactivecareadvancedsupportedproducts

Proactive Care customer information
Proactive Care central

www.hpe.com/services/proactivecarecentral
Proactive Care service activation

www.hpe.com/services/proactivecarecentralgetstarted

Warranty information
To view the warranty for your product or to view the Safety and Compliance Information for Server, Storage,
Power, Networking, and Rack Products reference document, go to the Enterprise Safety and Compliance website:

www.hpe.com/support/Safety-Compliance-EnterpriseProducts

Additional warranty information
HPE ProLiant and x86 Servers and Options

www.hpe.com/support/ProLiantServers-Warranties
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HPE Enterprise Servers
www.hpe.com/support/EnterpriseServers-Warranties

HPE Storage Products
www.hpe.com/support/Storage-Warranties

HPE Networking Products
www.hpe.com/support/Networking-Warranties

Regulatory information
To view the regulatory information for your product, view the Safety and Compliance Information for Server,
Storage, Power, Networking, and Rack Products, available at the Hewlett Packard Enterprise Support Center:

www.hpe.com/support/Safety-Compliance-EnterpriseProducts

Additional regulatory information

Hewlett Packard Enterprise is committed to providing our customers with information about the chemical
substances in our products as needed to comply with legal requirements such as REACH (Regulation EC No
1907/2006 of the European Parliament and the Council). A chemical information report for this product can be
found at:

www.hpe.com/info/reach

For Hewlett Packard Enterprise product environmental and safety information and compliance data, including
RoHS and REACH, see:

www.hpe.com/info/ecodata

For Hewlett Packard Enterprise environmental information, including company programs, product recycling, and
energy efficiency, see:

www.hpe.com/info/environment

Documentation feedback
Hewlett Packard Enterprise is committed to providing documentation that meets your needs. To help us improve
the documentation, send any errors, suggestions, or comments to Documentation Feedback
(docsfeedback@hpe.com). When submitting your feedback, include the document title, part number, edition,
and publication date located on the front cover of the document. For online help content, include the product
name, product version, help edition, and publication date located on the legal notices page.
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Remote Device Deployment (TR-069)

Introduction
TR-069 is a technical specification created by the Broadband Forum. The TR-069 protocol specifies client and
server requirements to manage devices across the Internet by using a client server architecture to provide
communication between the CPE (Customer Premises Equipment) and the ACS (Auto Configuration Server). A
protocol helps to manage complex networks where many devices such as modems, routers, gateways, VoIP
phones and mobile tablets compete for resources. TR-069 defines the CPE WAN Management Protocol (CWMP)
protocol necessary to remotely manage end-user devices. ACS provides automatic configuration for these
devices.

CWMP is automatically enabled. To conserve resources, reconfigure this setting using the cwmp
disable command.

TR-069 defines an auto-configuration architecture which provides the following primary capabilities:

• Auto-configuration and dynamic service provisioning

• Software/firmware image management

• Status and performance monitoring

• Diagnostics

• Bidirectional SOAP/HTTP based protocol

Appendix A
Remote Device Deployment (TR-069)
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Advantages of TR-069

• TR-069 can manage devices with dynamic IP addresses.

TR-069 use Organization Unique ID (OUI) and serial number rather than IP to identify a device.

• TR-069 can manage devices in a private network.

The HPE ACS BIMS (an iMC module) uses HTTP to communicate with the device, and the session is initiated
by the device, so BIMS can pass through NAT to manage the device.

• TR-069 is secure.

TR-069 can use HTTPS to communicate with or transfer files to/from the device; it is more secure than TFTP,
FTP or Telnet.

• TR-069 is suitable for WAN management across internet.

• TR-069 is suitable for zero-touch configuration.

The zero-configuration mechanism is defined in the TR-069 specification.

• TR-069 is suitable for large-scale device management.

TR-069 support distributed architecture. The ACS can be distributed to multiple servers, each ACS can
manage part of devices.
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Zero-touch configuration process
Auto configuration or “zero-touch” deployment is a recurring customer requirement, especially for remote-office
deployments. New devices introduced inside a private network require management tools be co-located to
configure them or update firmware, or require manual intervention to do configuration. TR-069 allows managing
devices that reside in a private network via HTTP(S), enabling a new set of deployment and management models
today, not possible using SNMP.

The client side, when configured, will contact the server at a predefined URL, using HTTP or HTTPS as protocol.
After authentication, the ACS is able to perform the following basic operations:

• Update CPE Configuration.

• Update CPE TR-069 parameters.

• Update CPE firmware.

• Reboot CPE (backup, startup, and running configurations)

• Run CPE ping diagnostics.

• Reset CPE to factory default.

• Get periodic Status (several parameters can be retrieved depending on what is supported).

Since TR-069 uses HTTP, it can be used across a WAN. If the CPE can reach the URL, it can be managed.
TR-069 is mostly a push protocol where the client periodically sends information without server requests. This
allows for greater scalability over traditional SNMP based tools, which are also bounded to work within the LAN,
while TR-069 can offer management to remote offices.
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Zero-touch configuration for Campus networks

In this example, the following steps to configure CPEs for a Campus Network environment.

1. Pre-configuration for all CPEs in BIMS.

2. CPEs get BIMS parameters from DHCP server.

3. CPEs initiate a connection to BIMS, then BIMS deploys the pre-configuration to CPEs.
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Zero-touch configuration for Branch networks

In this example, the following steps to configure CPEs for a Branch network environment.

1. Create the basic configuration for your spoke device manually, using the username/password from ISP and
BIMS URL.

2. The IPSec VPN configuration is generated by IVM and deployed by BIMS.

3. The IPSec VPN tunnel is automatically created.

4. The device in the branch private network can DHCP relay to HQ to continue the zero touch configuration.
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Zero-touch configuration setup and execution
1. DHCP configuration

2. BIMS configuration

3. Execution

CLI commands

Configuration setup
Within the configure mode:

Syntax:

cwmp
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acs

Configure Auto Configuration Server (ACS) access.

cpe

Configure Customer Premises Equipment (CPE) access.

disable

Disable the CPE WAN Management Protocol.

CWMP is automatically enabled. To conserve resources, reconfigure this setting using the cwmp
disable command.

enable

Enable the CPE WAN Management Protocol.

Syntax:

[no] cwmp
acs

Configure Auto Configuration Server (ACS) access.

cpe

Configure Customer Premises Equipment (CPE) access.

enable

Enable the CPE WAN Management Protocol.

ACS password configuration
Syntax:

cwmp acs
password

Configure the password used for authentication when the switch connects to the ACS.

url

Configure the URL of the ACS.

username

Configure the username used for authentication when the switch connects to the ACS.

When encrypt-credentials is off
Syntax:

cwmp acs password
plaintext

Configure the password used for authentication when the switch connects to the ACS.
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When encrypt-credentials is on
Syntax:

cwmp acs password
encrypted-key

An encrypted password generated with the encrypt-credentials command.

plaintext

Configure the password used for authentication when the switch connects to the ACS.

Encrypt-credential on

cwmp acs password encrypted-key
ASCII-STR

Enter an ASCII string (maximum length: 384 characters).

Plaintext password

cwmp acs password plaintext
PASSWORD-STR

A plaintext password used for ACS authentication (maximum length: 256 characters).

ACS URL configuration
Syntax:

cwmp acs url
URL-STR

The URL of the ACS (maximum length: 256 characters).

ACS username configuration
Syntax:

cwmp acs username
USERNAME-STR

A username for ACS authentication (maximum length: 256 characters).

CPE configuration
Syntax:

cwmp cpe
password

Configure the password used for authentication when the ACS connects to the switch.
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username

Configure the username used for authentication when the ACS connects to the switch.

CPE password configuration

When encrypt-credentials is on
Syntax:

cwmp cpe password
encrypted-key

An encrypted password generated with the 'encrypt-credentials' command.

plaintext

Configure the password used for authentication when the ACS connects to the switch.

Syntax:

cwmp cpe password encrypted-key
ASCII-STR

Enter an ASCII string (maximum length: 384 characters).

When encrypt-credentials is off
Syntax:

cwmp cpe [password]
plaintext

Configure the password used for authentication when the ACS connects to the switch

Syntax:

cwmp cpe
PASSWORD-STR

A plaintext password used for ACS authentication (maximum length: 256 characters).

CPE username configuration
Syntax:

cwmp cpe [username]
USERNAME-STR

A username for ACS authentication (maximum length: 256 characters).
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Enable/disable CWMP
Syntax:

cwmp [enable|disable]

Show commands

CWMP configuration and status query
Syntax:

show cwmp
configuration

Show current CWMP configuration.

status

Show current CWMP status.

When CWMP is enabled
Syntax:

show cwmp configuration

CWMP configuration

CWMP Configuration
CWMP Status          : Enabled
ACS URL              : http://16.93.62.32:9090
ACS Username         : bims
Inform Enable Status : Enabled
Inform Interval      : 60
Inform Time          : 2014-04-08T06:00:00
Reconnection Timeout : 30

CWMP status

CWMP Status
CWMP Status              : Enabled
ACS URL                  : http://16.93.62.32:9090
ACS URL Origin           : Config
ACS Username             : bims
Connection Status        : Disconnected
Data Transfer Status     : None
Last ACS Connection Time : Wed Apr  9 16:56:00 2014
Time to Next Connection  : 00:00:36

When CWMP is disabled
Syntax:

show cwmp status

Appendix A Remote Device Deployment (TR-069) 469

Anexo 04 ITEM 11 (0592666)         SEI 0008478-63.2018.6.02.8000 / pg. 6293



CWMP status

CWMP Status
CWMP Status              : Disabled

CWMP configuration

show cwmp configuration
CWMP Configuration
CWMP Status          : Disabled

Event logging
The TR-069 client offers some tools to diagnose problems:

• System logging

• Status/control commands

System logging
The CPE implements the following system log notification codes and sample messages:

• RMON_TR69_INFORM_COMPLETE

◦ INFORM to http://15.29.20.50:9090/ from (IP address not set yet) completed with error.

◦ INFORM to http://15.29.20.50:9090/ from 10.0.10.212 completed with error.

◦ INFORM to http://15.29.20.50:9090/ from 10.0.10.212 completed successfully.

• RMON_TR69_AUTH_FAILED

◦ Authentication on ACS http://15.29.20.50:9090/ failed.

• RMON_TR69_CONN_FAILED

◦ Connection attempts with ACS http://15.29.20.50:9090/ from 10.0.10.212 failed.

To avoid flooding the system log on frequent attempts to connect with the ACS, the following criteria are used with
both successful and failed attempts:

1. The very first event is always logged.

2. Any change from success to failure or vice versa is always logged.

3. Repeat success or failure events are logged only once every five minutes.

The HTTP file transfer component supports these system log notification codes and sample messages:

• RMON_HTTP_XFER_COMPLETE
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◦ I 11/19/13 08:06:13 04185 http: Download of http://10.0.11.240:9876/path to DestinationFile completed
successfully.

◦ I 11/19/13 08:06:13 04185 http: Upload of SourceFile to http://10.0.11.240:9876/path completed
successfully.

• RMON_HTTP_CONN_FAILED

◦ W 11/19/13 08:06:13 04186 http: Connection to http://10.0.11.240:9876/path failed.

• RMON_HTTP_TIMED_OUT

◦ W 11/19/13 08:06:13 04192 http: Download of http://10.0.11.240:9876/path to DestinationFile timed out.

◦ W 02/20/14 00:32:17 04192 http: Upload of SourceFile to http://10.0.11.240:9876/path timed out.

• RMON_HTTP_NO_SPACE

◦ W 11/19/13 08:06:13 04189 http: Upload of SourceFile to http://10.0.11.240:9876/path canceled because of
insufficient memory.

• RMON_HTTP_REQ_FAILED

◦ W 11/19/13 08:06:13 04190 http: Upload of SourceFile to http://10.0.11.240:9876/path failed (errno 13).

◦ W 11/19/13 08:06:13 04190 http: Upload of SourceFile to http://10.0.11.240:9876/path failed (errno 1).

◦ W 11/19/13 08:06:13 04190 http: Download of http://10.0.11.240:9876/path to DestinationFile failed (errno
13).

◦ W 11/19/13 08:06:13 04190 http: Download of http://10.0.11.240:9876/path to DestinationFile failed (errno
1).

◦ W 11/19/13 08:06:13 04190 http: Download of http://10.0.11.240:9876/path to DestinationFile failed (errno
17).

• RMON_HTTP_WRONG_FILE

◦ W 11/19/13 08:06:13 04191 http: Download canceled because file http://10.0.11.240:9876/path is
malformed or incompatible.

◦ W 11/19/13 08:06:13 04191 http: Download canceled because file http://10.0.11.240:9876/path is
malformed or incompatible.

• RMON_HTTP_FILE_NOT_FOUND

◦ W 11/19/13 08:06:13 04200 http: Upload of SourceFile to http://10.0.11.240:9876/path canceled because of
inexistent file.

Status/control commands
The following commands help assess the general state of TR–069 and control the source of the ACS
configuration record:
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Table 30: Status/control commands

Command Result

show cwmp status
CWMP is Enabled  ACS URL           : https://16.93.62.32:9443
ACS URL is set by                  : Config
ACS Username                       : bims
Connection status                  : Disconnected
Data transfer status               : None
Time of last successful connection : Thu Feb 20 01:16:59 2014
Interval upon to next connection   : Null

show cwmp
configuration CWMP is Enabled  ACS URL          : https://16.93.62.32:9443

ACS Username                      : bims 
Inform Enable Status              : Disabled
Inform Interval                   : 3559 
Inform Time                       :  
Reconnection times                : 30

[no] dhcp tr69-
acs-url Prevents using any ACS information from DHCP
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Configuration backup and restore without
reboot

Beginning with switch software release 16.05, the configuration backup and restore without reboot supports the
following features:

Interface Access (Telnet, Console/Serial, web) Port Shutdown with Broadcast Storm

Access Control Lists (ACLs) Source-Port Filters

AAA Authentication TACACS+ Authentication

CoS (Class of Service) Time Protocols (TimeP, SNTP)

Network Management Applications (SNMP) Uni-directional Link Detection (UDLD)

Port Configuration Virus Throttling (Connection-Rate Filtering)

Port Security Web-based Authentication

Port-Based Access Control (802.1X) Backplane stacking

Quality of Service (QoS) Job Scheduler

Spanning Tree (STP, RSTP, MSTP, RPVST+) Authorized IP Managers

VLANs Authorized Manager List (Web, SSH, TFTP)

802.1Q VLAN Tagging Auto MDIX Configuration

802.1X Port-Based Priority DHCP Configuration

802.1X Multiple Authenticated Clients Per Port Flow Control (802.3x)

IGMP Friendly Port Names

LACP/Trunk Guaranteed Minimum Bandwidth (GMB)

MAC Lockdown IP Addressing

MAC-based Authentication IP Routing

MAC Lockout Jumbo Packets

LMA LLDP

Multicast Filtering LLDP-MED

Power over Ethernet (PoE and PoE+) Loop Protection

Protocol Filters MAC Address Management

RADIUS Authentication and Accounting Management VLAN

RADIUS-Based Configuration Passwords and Password Clear Protection/include-
credentials

Table Continued

Appendix B
Configuration backup and restore without reboot
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Encrypted-password QoS: Strict-Priority Queuing

Port Monitoring QoS: Turn on/off VLAN Precedence

Port Status QoS: Egress Queue Rate-limiting

Rate-Limiting CDP

Syslog System Parameters (hostname, Banner)

System Information Front-panel-security

Telnet Access DLDP

Traffic/Security Filters OOBM

VLAN Mirroring (1 static VLAN)/Port mirroring Switch interconnect

Voice VLAN Airwave Controller IP configuration

Web Authentication RADIUS Support Aruba Central integration

Web UI Captive portal commands

Log IP address of an ACL match Consolidated Client View

access-list logtimer IPsec for Zero Touch Provisioning

UFD: Uplink Failure Detection Local User roles

Wake-on-LAN for a Specific VLAN Port QoS Trust Mode

WebUI Inactivity Timer Per-port Tunneled node

Control Plane Protection Zero-touch provisioning - DHCP, Activate

Egress ACLs CPPM support

Device profile - switch auto configuration HTTP redirection/Captive portal

Device profile: Auto configuration with Aruba AP
detection

Device profile: LLDP Authentication Bypass with AP

Tunneled Node enhancement: fallback to switching RADIUS Port Speed VSA

Rogue AP isolation Dynamic ARP Protection

DHCP Option 82 Dynamic IP Lockdown

DHCP snooping Eavesdrop Protection

Distributed Trunking GVRP

RMON 1,2,3,9 Private VLANs

SavePower Features IP SLA

sFlow sys-debug acl

VxLAN MAC Based VLANs (MBV)

Smartlink RBAC: Role Based Access Control

Fault Finder extended to cover Flapping Transceiver
Mitigation

RADIUS Service Tracking

Fault Finder (Per Port Enable) sys-debug destination

SNMP Trap Throttling Protocol VLANS
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Glossary
Acronym Definition

ACL Access Control List

AMP AirWave Management Platform

AP Access Point

BYOD Bring Your Own Device

BPS Backplane Stacking

CoA Change of Authorization

CLI Command Line Interface

CPPM ClearPass Policy Manager

DHCP Dynamic Host Configuration Protocol

DoS Denial-of-Service

EWA Enhanced Web Authentication

IP Internet Protocol

HA High Availability

HMAC-SHA1 Hash-based Message Authentication Code used with
the SHA-1 cryptographic hash function.

HTTP Hypertext Transfer Protocol

HTTPS Secure Hypertext Transfer Protocol

ID Identifier

IP Internet Protocol

Table Continued

Appendix C
Glossary
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Acronym Definition

L3 The third, or routing, layer of the open systems
interconnection (OSI) model. The network layer routes
data to different LANs and Wide Area Networks
(WANs) based on network addresses.

LAN Local Area Network

MAC Media Access Control

MAFR MAC Authentication Failure Redirect

MAS Management Interface Specification

NMS Network Management System

PVOS ArubaOS-Switch Operating System

RADIUS Remote Authentication Dial In User Service

SNMP Simple Network Management Protocol

VLAN Virtual Local Area Network

VSA Vendor Specific Attribute

VSF Virtual Switching Framework

ZTP Zero Touch Provisioning
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Resumo da garantia e suporte do produto da HPE Networking
 
(outubro de 

2018) 
 

A versão mais atual deste documento está disponível em www.hpe.com/networking/warrantysummary 
Detalhes da política de garantia do produto de rede da HPE estão disponíveis em www.hpe.com/networking/warranty 

Informações sobre os serviços para produtos HPE Networking podem ser encontradas em www.hpe.com/networking/services  
 As informações contidas neste documento estão sujeitas a alterações sem aviso prévio. As garantias para produtos e serviços da HPE são as estabelecidas nas 

declarações de garantia expressa que acompanham tais produtos e serviços. Além disso, nossos produtos já vêm com garantias que não podem ser excluídas sob as leis 
do consumidor da Austrália e Nova Zelândia. Sujeitas às informações anteriores, nenhuma informação aqui descrita deve ser interpretada como parte de uma garantia 

adicional. A HPE não se responsabiliza por erros técnicos ou editoriais ou omissões contidos neste documento. 

 
 

 

 

Produtos 
Duração da 

garantia
1
 

Substituição de 
hardware

2
 

Suporte técnico 
em horário 
comercial

3
 

Suporte técnico 24h 
por dia, 7 dias por 

semana
3
 

(Após 1º de dezembro de 2015) 

Versões de 
software/sistem
a operacional

4
 

S
w

it
c
h

e
s

 

Modular      

 129xx, 125xx, 119xx 1 ano 10 dias 1 ano N/A Desde que sejam 
de propriedade4 

 105xx, 75xx 1 ano 10 dias 1 ano 90 dias Desde que sejam 
de propriedade4 

 84xx, 83xx 5 anos 10 dias 90 dias N/A 5 anos4 

 82xxzl, 54xxzl/R, 42xxvl 
Vida útil

5
 Envio no PDU 

Desde que sejam de 
propriedade5 

90 dias 
Desde que sejam 
de propriedade4 

Configuração fixa      

 79xx, 59xx/AF, 583x/AF, 582x/AF, 57xx 1 ano 10 dias 1 ano N/A Desde que sejam 
de propriedade4 

 Switches Altoline 9xxx, 6xxx (adquiridos após 31 de março de 

2016) 
1 ano 10 dias 1 ano N/A N/A 

 Switches Arista (Consulte 

http://www.arista.com/assets/data/pdf/Warranty.pdf para obter 
detalhes) 

1 ano15 10 dias15 1 ano15 N/A N/A 

 580x/AF 
Vida útil

5
 Envio no PDU 

Desde que sejam de 
propriedade5 

N/A 
Desde que sejam 
de propriedade4 

 55xx, 513x, 512x, 38xx, 36xx, 35xx/yl, 31xx, 29xx/al, 281x, 
26xx, 25xx/G 

Vida útil
5
 Envio no PDU 

Desde que sejam de 
propriedade5 

90 dias 
Desde que sejam 
de propriedade4 

Gerenciamento Inteligente       

 195x, 192x, 191x, 18xx, 17xx, 1620 (Adquiridos após 1º de 

outubro de 2017) 
Vida útil

14 
 Envio no PDU 

90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia14 

90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia14 

Desde que sejam 
de propriedade4 

Não gerenciado       

 1420, 1410 (Adquiridos após 1º de outubro de 2017) 

Vida útil
14 

 Envio no PDU 

90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia 14 

90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia 14 

N/A 

 1405 (Adquiridos após 1º de outubro de 2017) 3 anos
14

 Envio no PDU 90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia

 14
 

90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia

14
 

N/A 

L
A

N
 s

e
m

 f
io

 

Pontos de acesso internos      

 Pontos de acesso gerenciados por controlador (APs) Aruba 
Vida útil

10
 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A 90 dias (somente 

para correção de bug) 

 3WN/P, 155/P, pontos de acesso remoto Aruba 108/109 
(RAPs)  Vida útil

10
 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A 

Imagem 
atualizada 

periodicamente
13

 

 Pontos de acesso instantâneo Aruba (IAPs) 
Vida útil

10
 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A 

Imagem 
atualizada 

periodicamente
13

 

 M330, M2xx 
Vida útil

5
 Envio no PDU 

Desde que sejam de 
propriedade5 

90 dias 
Desde que sejam 
de propriedade4 

 Ponto de Acesso OfficeConnect 20 

3 anos
14

 Envio no PDU 

90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia

14
 

90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia

14
 

Desde que sejam 
de propriedade4 

Controladores      

 Controladores Aruba
 

1 ano 
30 dias 

PDU/Devolução 
à fábrica

11
 

90 dias
12

 N/A N/A 

 Switches de acesso a mobilidade Aruba 
Vida útil

10
 Envio no PDU 90 dias 90 dias 

Desde que sejam 
de propriedade4 

Outros produtos de WLAN       

 Pontos de acesso externos Gerenciados pelo Controlador 
Aruba Série 2xx Vida útil

10
 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A 90 dias (somente 

para correção de bug) 

 Pontos de acesso instantâneo externos Aruba Série 2xx 
(IAPs) Vida útil

10
 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A 

Imagem 
atualizada 

periodicamente
13

 

 Dispositivos AirWave, Dispositivos ClearPass, Dispositivos 
IntroSpect 1 ano 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias

12
 

N/A 
90 dias (somente 

para correção de bug) 

 Roteadores de malha sem fio para ambiente externo 
MST2HP, MST2HAC, MSR2KP, MSR4KP Aruba 1 ano 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias

12
 N/A 90 dias (somente 

para correção de bug) 

 Beacons Aruba 
90 dias 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A 90 dias (somente 

para correção de bug) 

 Sensores de capa 
90 dias 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A 90 dias (somente 

para correção de bug) 

 Fontes de alimentação, antenas e acessórios Aruba 
1 ano 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A N/A 
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Resumo da garantia e suporte do produto da HPE Networking
 
(outubro de 

2018) 
 

A versão mais atual deste documento está disponível em www.hpe.com/networking/warrantysummary 
Detalhes da política de garantia do produto de rede da HPE estão disponíveis em www.hpe.com/networking/warranty 

Informações sobre os serviços para produtos HPE Networking podem ser encontradas em www.hpe.com/networking/services  
 As informações contidas neste documento estão sujeitas a alterações sem aviso prévio. As garantias para produtos e serviços da HPE são as estabelecidas nas 

declarações de garantia expressa que acompanham tais produtos e serviços. Além disso, nossos produtos já vêm com garantias que não podem ser excluídas sob as leis 
do consumidor da Austrália e Nova Zelândia. Sujeitas às informações anteriores, nenhuma informação aqui descrita deve ser interpretada como parte de uma garantia 

adicional. A HPE não se responsabiliza por erros técnicos ou editoriais ou omissões contidos neste documento. 

 
 

 

 

R
o

te
a
d

o
re

s
 

Roteadores      

 
88xx, HSR68xx 1 ano 10 dias 1 ano 

N/A Desde que sejam de 
propriedade4 

 
HSR66xx, 66xx, MSR50, MSR4xxx, MSR3xxx, MSR30 1 ano 10 dias 1 ano 

90 dias Desde que sejam de 
propriedade4 

 
MSR2xxx, MSR20, MSR1xxx, MSR9xx 1 ano Envio no PDU 1 ano 

90 dias Desde que sejam de 
propriedade4 

 ALU 77xx 
1 ano

9
 

Devolução para 
a fábrica

9
 

1 ano
9
 N/A 

Todas as 
atualizações de 

licença adquiridas9 

 Roteadores VSR  
90 dias 

(Somente mídia) 
N/A 90 dias N/A 

Todas as 
atualizações de 

licença adquiridas8 

G
e

re
n

c
ia

m
e

n
to

 

Gerenciamento de rede      

 Centro de gerenciamento inteligente (detalhes do suporte em 

www.hpe.com/networking/IMCSupport) 
90 dias 

 (Somente mídia) 
N/A 90 dias N/A 90 dias (somente para 

correção de bug) 

 AirWave, ALE, Aruba Central, ClearPass, Meridian, VIA, Visual RF 90 dias 
 (Somente mídia) 

N/A 90 dias N/A 90 dias (somente para 

correção de bug) 

 Controlador HPE VAN SDN e aplicativos HPE SDN 90 dias 
 (Somente mídia) 

N/A 90 dias N/A Todas as 
atualizações de 

licença adquiridas8
 

 Rede em nuvem distribuída HPE  90 dias 
 (Somente mídia) 

N/A N/A N/A Nenhum 

 Dispositivos controladores da Big Switch Networks (Consulte 

www.bigswitch.com/support para detalhes sobre garantia e suporte) 
N/D

16
 N/D

16
 N/D

16
 N/D

16
 N/D

16
 

P
ro
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u
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s
 d
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d
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d
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n

a
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Transceptores      

 Transceptores Aruba (Números dos produtos transceptores JWxxxx para 
Controladores e Switches MAS) 1 ano  

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A N/A 

 Transceptores da marca Aruba (exceto os números dos produtos 
transceptores JWxxxx) 
 e 
HPE X244, X242, X142, X132, X131, X129, X122, X121, X119, X112, X111 

Vida útil
5
 Envio no PDU Desde que 

sejam de 
propriedade5 

N/A N/A 

 Transceptores Aruba 100G 1 ano 10 dias 1 ano N/A N/A 

 HPE X2A0, X240, X190, X180, X170, X160, X150, X140, X135, X130, 
X125, X124, X120, X115, X114, X110 

1 ano 30 dias 1 ano N/A N/A 

 

1) Fontes de alimentação, módulos e acessórios removíveis, como antenas, ventiladores, cabos 
de alimentação, etc., podem ter cobertura de garantia diferente do dispositivo de host. 
Consulte a referência rápida de cobertura de garantia do HPE Networking em 
www.hpe.com/networking/warrantyquickref para obter mais detalhes.  

2) O tempo de resposta baseia-se em um esforço comercialmente razoável e está sujeito a um 
tempo de corte de envio diário. Em alguns países e regiões e de acordo com determinadas 
restrições do fornecedor o tempo de resposta pode variar. Entre em contato com a sua 
organização de serviço HPE local para obter a disponibilidade de tempo de resposta em sua 
área. Envio PDU = Envio no próximo dia útil. 

3) O suporte técnico da garantia por telefone ou meio eletrônico é fornecido durante o horário 
comercial da HPE local para todo o período de garantia para os fins de diagnóstico de 
defeitos de hardware ou software. Muitos produtos adquiridos após 1º de dezembro de 2015 
incluem 90 dias de suporte técnico 24 horas por dia, 7 dias por semana, conforme indicado. 
Consulte a declaração de garantia limitada Hewlett-Packard do produto para obter detalhes 
adicionais da cobertura. Serviços de cobertura estendida estão disponíveis. 

4) Inclui todas as versões de software/OS geralmente disponíveis oferecidas para os produtos 
específicos listados, quando e se disponíveis, enquanto o cliente possuir o produto, exceto 
onde observado. Algumas versões do software podem exigir hardware adicional ou novo. 
Clientes que desejem que atualizações, correções e ajustes de recurso específicos sejam 
priorizados em versões futuras, devem adquirir os serviços de suporte apropriados da HPE. 

5) Para os produtos adquiridos após 1º de dezembro de 2014, a garantia se estende somente 
enquanto o usuário final original possuir o produto. Inclui a cobertura de qualquer ventilador e 
fonte de alimentação incorporados por todo o período de garantia. Um comprovante de 
aquisição ou de arrendamento pode ser exigido como condição para que exista direito ao 
serviço de garantia.  

6) Garantia de hardware, suporte técnico e todas as versões de software fornecidas para 
hardware e apenas UM OS de serviço, quando e se disponíveis, enquanto o usuário final 
original possuir o produto. Consulte documentação específica do produto para suporte ao 
aplicativo. 5 anos de garantia na unidade de disco nos módulos de zl de serviços avançados 
HPE Alliance One. 

7) Produtos comprados antes de 1º de agosto de 2013 incluem 1 ano de suporte técnico e 1 
ano (somente correção de bugs).  

8) Inclui todas as atualizações de software oferecidas para a versão licenciada, quando e se 
disponível. Atualizações de software vão requerer a compra de SKU, pacote de serviços de 
suporte ou contrato apropriado. 

9) Todo o suporte técnico, de hardware e de software para produtos de ALU 77xx é fornecido 
diretamente somente pela Alcatel-Lucent e não pela HPE. Para suporte da Alcatel-Lucent, 
selecione o país do qual o cliente está ligando no link a seguir e ele mostrará as informações 
de contato de suporte da ALU apropriadas: https://Services.support.Alcatel-
Lucent.com/product_support/. A garantia de hardware requer o envio de produtos com falha 
para a ALU para o reparo ou reposição. O custo de logística para o envio de produto no local 
do cliente para o local da ALU para reparo ou reposição será coberto pelo cliente. Versões de 
manutenção de software estão incluídas para a principal versão do software adquirida. As 
principais atualizações de versão do software não estão incluídas. Serviços podem ser 
adquiridos na HPE ou na Alcatel-Lucent para expandir sua cobertura de suporte e upgrades 
de software. O suporte será fornecido pela Alcatel Lucent para esses serviços. 

10) Para os produtos adquiridos depois de 1º de dezembro de 2015, o hardware tem garantia 
estendida somente enquanto o usuário final original possuir o produto e está limitada a cinco 
(5) anos a partir da data de término da venda. 

11) Para os primeiros 30 dias a partir do envio, a HPE fornecerá a substituição 
antecipada de envio no mesmo dia para os produtos de hardware cobertos. Depois 
de trinta (30) dias a partir do envio e durante o período de garantia restante, a HPE 
substituirá ou reparará qualquer produto fora de conformidade e o devolverá em 
condição de operação, enviando após o recebimento da HPE do produto fora de 
conformidade por meio do procedimento RMA da HPE, com recebimento pelo 
cliente em até dez (10) dias em uma base comercialmente razoável. 

12) A HPE fornecerá uma resposta por e-mail no próximo dia útil com o propósito de 
diagnosticar defeitos de hardware ou software durante o horário comercial no 
Horário do Pacífico para os primeiros 90 dias após a compra.  

13) A HPE disponibilizará uma imagem de versão de software de OS instantânea 
recente no portal de software. Essa imagem também está disponível para pontos de 
acesso remoto (RAPs) que estejam executando o OS instantâneo. 

14) Esses produtos são cobertos por 90 dias de suporte telefônico 24x7. 
Posteriormente, apenas suporte por bate-papo estará disponível para o período 
restante da garantia. A garantia de vida útil limitada (quando aplicável) é estendida 
somente enquanto o usuário final original possuir o produto e está limitada a 5 
(cinco) anos a partir do final da data de venda.  Esta garantia inclui a cobertura de 
qualquer ventilador embutido e fonte de alimentação por todo o período de garantia. 
Um comprovante de aquisição ou de arrendamento pode ser exigido como condição 
para que exista direito ao serviço de garantia. Consulte 
www.hpe.com/OfficeConnect/support/ para mais informações sobre o novo 
processo de suporte do OfficeConnect.  

15) Todo o suporte técnico de hardware e de software para produtos Arista é fornecido 
diretamente pela Arista e não pela HPE. Consulte a página de suporte ao cliente da 
Arista para informações de contato: https://www.arista.com/en/support/customer-
support. Os custos de transporte, se houver, relacionados à devolução de um 
hardware defeituoso para um centro de reparos Arista será custeado pelo cliente. A 
Arista irá pagar quaisquer custos de transporte relacionados a uma nova entrega de 
um Hardware reparado ou substituído. Serviços podem ser adquiridos na HPE ou 
na Arista para expandir sua cobertura de suporte e upgrades de software. O suporte 
será fornecido pela Arista para esses serviços. Para obter detalhes sobre a garantia 
e suporte da Arista, consulte: http://www.arista.com/assets/data/pdf/Warranty.pdf. 

16) Todo o suporte técnico de hardware e de software para produtos Big Switch 
Networks é fornecido diretamente pela BSN e não pela HPE. Consulte a página de 
atendimento ao cliente da Big Switch Networks para informações de contato: 
www.bigswitch.com/support. Para detalhes sobre opções de garantia e suporte da 
Big Switch Networks, consulte: 
http://bigswitch.com/sites/default/files/bsn_support_and_maintenance_policy.v2.2.20
16.11.14.pdf. 
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Hewlett Packard Enterprise (HPE) is committed to compliance with all 
applicable laws and regulations, including material restriction 
requirements under the European Union Recast RoHS Directive, 
otherwise known as EU RoHS 2, applicable restrictions under Annex 
XVII of the EU REACH Regulation and China’s Management Methods 
for Restricted Use of Hazardous Substances in Electrical and 
Electronic Products, otherwise known as China RoHS 2.  
 
Hewlett Packard Enterprise believes that legislation, like the EU RoHS 
2 Directive, plays an important role in promoting industry-wide 
transition to restrict substances of concern. In general, the restriction 
of any substance should take into account the following key items:  
 
• Global harmonization of the legislation content and implementation 

requirements 
• Substance risk assessment, including a clear understanding of the 

environmental impacts of alternative substances 
• Clear identification of what substances (vs. broad classes or 

categories) are to be restricted 
• Clear identification of when alternative technologies are proven and 

readily available 
• Appropriate lead time to allow the industry to transition 
• Substances that are not used or found in final products should not 

be included in the restrictions 
• Material application exemptions should be allowed for the use of 

restricted substances in applications where current substitution is 
not technically feasible 

• Inclusion of maximum concentration values setting de minimis 
levels below which the relevant substances may be present 

 

Hewlett Packard Enterprise’s 
Compliance with Restriction of 
Hazardous Substances (RoHS) 
Legislation 
(rev 14.0 Oct 2016) 

 

Hewlett Packard Enterprise 

3000 Hanover Street 

Palo Alto, CA 94304 

www.hpe.com 
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Hewlett Packard Enterprise fully supports the restriction of the four 
substances incorporated into EU RoHS 2 by Commission Delegated 
Directive 2015/863/EU, specifically:  
 
• Diisobutyl Phthalate (DIBP) 
• Bis (2-ethylhexyl) phthalate (DEHP) 
• Butyl benzyl phthalate (BBP) 
• Dibutylphthalate (DBP) 
 
Hewlett Packard Enterprise believes other substances should be 
considered for inclusion in future RoHS legislation. This includes the 
restriction of polyvinyl chloride (PVC) and brominated flame retardants 
(BFRs) from electrical and electronic equipment (EEE). HPE believes 
PVC and BFRs should be the focus for the restriction of chlorine (Cl) 
and bromine (Br) from electrical and electronic equipment, where 
technically feasible. HPE’s reasons for focusing on PVC and BFRs 
are: 
 
• PVC and BFRs cover 99% of the uses for Cl and Br in electronics; 
• Given the high percentage usage, these substances have the 

highest impact; 
• Restriction of these substances where technically feasible would 

substantially accomplish the goal to eliminate Cl and Br from 
electronic products. 

 
By July 2007, all PVC and BFRs were restricted[1] from the external 
case plastics in HPE branded products. When technically feasible, we 
will continue to phase out other uses of brominated flame retardants 
(BFRs), polyvinyl chloride (PVC), and phthalates to meet market 
demands and customer expectations, taking into account product life 
cycles. 
 
Hewlett Packard Enterprise is taking a proactive approach to 
evaluating materials in its products to assess environmental, health or 
safety risks. HPE may restrict substances because of customer or 
legal requirements, or because HPE believes it is appropriate based 
on a precautionary approach. HPE strives to replace legally permitted 
materials when scientific data have established a potential health or 
environmental risk and lower-risk, commercially and technically viable 
alternatives are available. At HPE the evaluation of alternative 
materials is a continuous process.  
 
Our continued internal voluntary goal is to meet the substance 
restrictions of the EU RoHS legislation outside the EU (and EFTA) 
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within 6 months of each of the EU’s various legal compliance dates on 
a worldwide basis for virtually all Hewlett Packard Enterprise branded 
new products in scope of the Directive, except where it is widely 
recognized that there is no technically feasible alternative (as 
indicated by an exemption under the EU RoHS Directive).  
 
In early 2003, a company-wide RoHS team was formed to manage all 
aspects of Hewlett Packard Company’s global response to all the 
RoHS legislations around the world.  Since the separation of Hewlett 
Packard Company and the creation of Hewlett Packard Enterprise, 
HPE has continued this approach. HPE’s initiative to address the 
RoHS legislations is part of the company’s Design for Environment 
program, which includes using materials more efficiently, finding 
alternatives for designated materials, designing for energy efficiency, 
and designing products that can be easily recycled. 
 
Hewlett Packard Enterprise continues to plan for further “RoHS-like” 
legislation in other jurisdictions and will meet any additional 
requirements that arise. HPE complies with the requirements of all the 
RoHS legislations currently in effect (including those specifically listed 
under Compliance Status below). HPE’s Compliance Verification is 
based on our risk analysis of restricted substances entering the 
supply chain and includes technical documentation outlined in the 
European Union’s EN 50581:2012 standard. 
 
More detailed information can be found at 
www.hpe.com/info/environment 
Living Progress Report 

Design for environment 
Compliance Verification 
General Specifications for the Environment 
Eco Declarations 
 

 
Hewlett Packard Enterprise’s Compliance Status to EXISTING 
RoHS Legislation:  

 

European Union  

HPE products in-scope and put on the market in the EU and EFTA 
Member States comply with the requirements of EU RoHS Directive 
(2011/65/EU) including Commission Decisions withdrawing 
exemptions.  
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Serbia 
HPE products[2] comply with Serbia's WEEE and RoHS "Regulations 
on the List of Electrical and Electronic Products, Measures Banning 
and Restricting the Recovery of Electrical and Electronic Equipment 
Containing Hazardous Materials, and the Methods and Procedures for 
Managing Waste from Electrical and Electronic Products", which 
entered into force on January 4, 2011. RoHS restrictions apply to 
equipment placed on the market on or after July 1, 2011. 
 
Turkey 
HPE products[2] comply with Turkey’s “Regulation on the Restriction of 
the use of Certain Hazardous Substance in Electrical and Electronic 
Equipment”, otherwise known as Turkey RoHS which came into effect 
on March 30, 2009. 
 
Ukraine 
HPE products[2] comply with the substance restrictions in Ukraine’s 
“Technical Regulation on restrictions as to the use of some dangerous 
substances in electric and electronic devices”, otherwise known as 
Ukraine RoHS which came into effect on 1 January 2011. 
 
China 
HPE products[2] comply with China’s, “Management Methods for 
Restricted Use of Hazardous Substances in Electrical and Electronic 
Products”, otherwise known as China RoHS 2 which came into effect 
on July 1, 2016. 
 
India  
HPE products[2] comply with the material restrictions of India’s 
legislation “India E-waste (Management) Rules, 2016”, otherwise 
known as India RoHS, which came into effect on October 1, 2016 and 
will replace the E-Waste (Management and Handling) Rules, 2011. 
 
Japan  
Japan’s “The Marking of Presence of the Specific Chemical 
Substances for Electrical and Electronic Equipment” (JIS-C-0950), 
otherwise known as J-MOSS came into effect on July 1, 2006. At 
present, no HPE-brand products are in scope of J-MOSS.  
 

Korea  
In Korea, “The Act for Resource Recycling of Electrical/Electronic 
Products and Automobiles”, otherwise known as Korean RoHS came 
into effect on January 1, 2008. Korea’s RoHS 2 came into effect on 
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January 1, 2013. At present, no HPE-brand products are in scope of 
Korea RoHS 2. 
 
Taiwan (BSMI) RoHS 
HPE products[2] will comply with Taiwan’s CNS 15663 standard, 
otherwise known as BSMI RoHS, which is a Guidance to reduce the 
restricted chemical substances used in electrical and electronic 
products. This standard was released on July 30, 2013 and applies to 
servers placed on the market on or after July 1, 2017 and other 
products placed on the market on or after January 1, 2018. 
 
Vietnam 
HPE products[2] comply with Vietnam’s legislation “Circular 
30/2011/TT-BCT: Temporarily regulating the permitted limits for a 
number of hazardous substances in electric and electronic products”, 
otherwise known as Vietnam RoHS which came into effect on 
December 1, 2012. You can find HPE’s Vietnam RoHS declarations 
at: http://www8.hp.com/us/en/hpe/hp-
information/livingprogress/environmentalprogress/msds-specs-
more.html 
 
California 
California’s, “Electronic Waste Recycling Act of 2003 (Senate Bill 20) 
substance restrictions”, otherwise known as California RoHS came 
into effect on January 1, 2007. At present, no HPE-brand products are 
in scope of California RoHS. 
 
New Jersey 
New Jersey’s “Electronic Waste Recycling Act” (Senate Bill 2144), 
otherwise known as New Jersey RoHS came into effect on 1 January 
2011. At present, no HPE-brand products are in scope of New Jersey 
RoHS. 
 
Worldwide  
HPE has an internal voluntary goal to meet the substance restrictions 
of the EU RoHS legislation outside the EU (and EFTA) within 6 
months of each of the EU’s various legal compliance dates on a 
worldwide basis for virtually all HPE branded new products in scope of 
the Directive, except where it is widely recognized that there is no 
technically feasible alternative (as indicated by an exemption under 
the EU RoHS Directive). 
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Notes:  
[1] See HPE’s General Specification for the Environment Identification 
Numbers: 041210-80 and 070905-88.  
[2] HPE products that are both in scope and put on the market in the given 
jurisdiction. 
 

 

© Copyright 2016 Hewlett Packard Enterprise Development LP  
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HPE Networking Product Warranty & Support Summary (October 2018)

The most current version of this document is available at www.hpe.com/networking/warrantysummary
HPE Networking product warranty policy details are available at www.hpe.com/networking/warranty

Information on services for HPE Networking products can be found at www.hpe.com/networking/services
The information contained herein is subject to change without notice.  Warranties for HPE products and services are set forth in the express warranty statements 

accompanying such products and services.   In addition, our goods come with guarantees that cannot be excluded under Australian and New Zealand consumer laws.  
Subject to the foregoing, nothing herein should be construed as constituting an additional warranty.  HPE shall not be liable for technical or editorial errors or omissions 

contained herein.

 

Products
Warranty 
duration1

Hardware 
replacement2

Business 
Hours 

Technical 
Support3

24x7
Technical 
Support3

(After Dec. 1, 2015)

Software/OS 
Releases4

S
w

it
c

h
e

s

Modular

129xx, 125xx, 119xx 1 year 10 days 1 year N/A As long as owned4

105xx, 75xx 1 year 10 days 1 year 90 days As long as owned4

84xx, 83xx 5 years 10 days 90 days N/A 5 years4

82xxzl, 54xxzl/R, 42xxvl
Lifetime5 NBD Ship

As long as 
owned5 90 days As long as owned4

Fixed-configuration

79xx, 59xx/AF, 583x/AF, 582x/AF, 57xx 1 year 10 days 1 year N/A As long as owned4

Altoline 9xxx, 6xxx Switches (Purchased after March 31, 2016) 1 year 10 days 1 year N/A N/A

Arista switches (See http://www.arista.com/assets/data/pdf/Warranty.pdf for details) 1 year15 10 days15 1 year15 N/A N/A

580x/AF
Lifetime5 NBD Ship

As long as 
owned5 N/A As long as owned4

55xx, 513x, 512x, 38xx, 36xx, 35xx/yl, 31xx, 29xx/al, 281x, 26xx, 25xx/G
Lifetime5 NBD Ship

As long as 
owned5 90 days As long as owned4

Smart Managed 

195x, 192x, 191x, 18xx, 1620 (Purchased after October 1, 2017)

Lifetime14 NBD Ship

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14

As long as owned4

Unmanaged 

1420, 1410 (Purchased after October 1, 2017)

Lifetime14 NBD Ship

90 days 
Phone 

support-Chat 
support entire 

warranty 
period 14

90 days 
Phone 

support-Chat 
support entire 

warranty 
period 14

N/A

1405 (Purchased after October 1, 2017) 3 years14 NBD Ship 90 days 
Phone 

support-Chat 
support entire 

warranty 
period 14

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14

N/A

W
ir

e
le

s
s
 L

A
N

Indoor Access Points

Aruba Controller-Managed Access Points (APs)
Lifetime10

30 day 
NBD/Return-to-

factory11

90 days N/A 90 days (bug fix only)

3WN/P, 155/P, 108/109 Aruba Remote Access points (RAPs) 
Lifetime10

30 day 
NBD/Return-to-

factory11

90 days N/A
Periodic updated 

image13

Aruba Instant Access Points (IAPs)
Lifetime10

30 day 
NBD/Return-to-

factory11

90 days N/A
Periodic updated 

image13

M330, M2xx
Lifetime5 NBD Ship

As long as 
owned5 90 days

As long as owned4

OfficeConnect 20 Access Point

3 years14 NBD Ship

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14

As long as owned4

Controllers

Aruba controllers
1 year

30 day 
NBD/Return-to-

factory11

90 days12 N/A N/A

Aruba Mobility Access Switches Lifetime10 NBD Ship 90 days 90 days As long as owned4

Other WLAN products 

Aruba Controller-Managed 2xx Series Outdoor Access Points
Lifetime10

30 day 
NBD/Return-to-

factory11

90 days N/A 90 days (bug fix only)

Aruba Instant 2xx Series Outdoor Access Points (IAPs)
Lifetime10

30 day 
NBD/Return-to-

factory11

90 days N/A
Periodic updated 

image13

AirWave Appliances, ClearPass Appliances, IntroSpect Appliances
1 year

30 day 
NBD/Return-to-

factory11

90 days12

N/A
90 days (bug fix only)

MST2HP, MST2HAC, MSR2KP, MSR4KP Aruba Outdoor Wireless Mesh 
Routers 1 year

30 day 
NBD/Return-to-

factory11

90 days12 N/A 90 days (bug fix only)

Aruba Beacons
90 days

30 day 
NBD/Return-to-

factory11

90 days N/A 90 days (bug fix only)

Cape Sensors
90 days

30 day 
NBD/Return-to-

factory11

90 days N/A 90 days (bug fix only)

Aruba Power Supplies, Antennae, Accessories
1 year

30 day 
NBD/Return-to-

factory11

90 days N/A N/A
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HPE Networking Product Warranty & Support Summary (October 2018)

The most current version of this document is available at www.hpe.com/networking/warrantysummary
HPE Networking product warranty policy details are available at www.hpe.com/networking/warranty

Information on services for HPE Networking products can be found at www.hpe.com/networking/services
The information contained herein is subject to change without notice.  Warranties for HPE products and services are set forth in the express warranty statements 

accompanying such products and services.   In addition, our goods come with guarantees that cannot be excluded under Australian and New Zealand consumer laws.  
Subject to the foregoing, nothing herein should be construed as constituting an additional warranty.  HPE shall not be liable for technical or editorial errors or omissions 

contained herein.

 

R
o

u
te

rs

Routers

88xx, HSR68xx 1 year 10 days 1 year N/A As long as owned4

HSR66xx, 66xx, MSR50, MSR4xxx, MSR3xxx, MSR30 1 year 10 days 1 year 90 days As long as owned4

MSR2xxx, MSR20, MSR1xxx, MSR9xx 1 year NBD Ship 1 year 90 days As long as owned4

ALU 77xx
1 year9 Return-to-

factory9 1 year9 N/A
All updates for 

purchased license9

VSR routers 90 days
(Media only)

N/A 90 days N/A
All updates for 

purchased license8

M
a

n
a

g
e

m
e
n

t

Network Management

Intelligent Management Center (support details at www.hpe.com/networking/IMCSupport) 90 days
(Media only)

N/A 90 days N/A 90 days (bug fix only)

AirWave, ALE, ArubaCentral, ClearPass, Meridian, VIA, Visual RF 90 days
(Media only)

N/A 90 days N/A 90 days (bug fix only)

HPE VAN SDN controller and HPE SDN applications 90 days
(Media only)

N/A 90 days N/A All updates for 
purchased license8

HPE Distributed Cloud Networking 90 days
(Media only)

N/A N/A N/A None

Big Switch Networks controller appliances (See www.bigswitch.com/support for 

warranty & support details)
N/A16 N/A16 N/A16 N/A16 N/A16

A
d

d
it

io
n

a
l 

N
e
tw

o
rk

in
g

 

P
ro

d
u

c
ts

Transceivers

Aruba Transceivers (Transceiver product numbers JWxxxx for Controllers 
and MAS Switches) 1 year 

30 day 
NBD/Return-to-

factory11

90 days N/A N/A

Aruba branded transceivers (except transceiver product numbers JWxxxx)
and

HPE X244, X242, X142, X132, X131, X129, X122, X121, X119, X112, X111

Lifetime5 NBD Ship As long as 
owned5

N/A N/A

Aruba 100G transceivers 1 year 10 days 1 year N/A N/A

HPE X2A0, X240, X190, X180, X170, X160, X150, X140, X135, X130, 
X125, X124, X120, X115, X114, X110

1 year 30 days 1 year N/A N/A

1) Removable power supplies, modules and accessories such as antennas, fans, power cords, 
etc. may have different warranty coverage than the host device.  See the HPE Networking 
Warranty Coverage Quick Reference at www.hpe.com/networking/warrantyquickref for more 
details. 

2) Response time is based on commercially reasonable effort and subject to a daily shipment 
cutoff time.  In some countries and regions and under certain supplier constraints, response 

time may vary.  Contact your local HPE service organization for response time availability in 
your area.  NBD Ship = Next Business Day shipment.

3) Warranty phone and electronic case technical support is provided during local HPE business 
hours for the entire warranty period for the purposes of diagnosing hardware or software 
defects.  Many products purchased after December 1, 2015 include 90 days of 24x7 technical 
support as noted.  See product’s Hewlett-Packard Limited Warranty Statement for additional 
coverage details.  Extended coverage services are available.

4) Includes all generally available software/OS releases offered for the specific products listed, 
when and if available, for as long as the customer owns the product, except where noted.  
Some software releases may require additional or new hardware.  Customers who desire 
specific feature updates, patches and fixes to be prioritized into future releases should 
purchase the appropriate support services from HPE.

5) For products purchased after December 1, 2014, the warranty extends only for as long as the 
original end user owns the product. Includes coverage of any built-in fans and power supplies 
for the entire warranty period. You may be required to provide proof of purchase or lease as a 
condition of receiving warranty service.  

6) Hardware warranty, technical support and all software releases provided for hardware and the 
ONE Service OS only, when and if available, for as long as the original end user owns the 
product.  See product specific documentation for application support.  5 year warranty on the 
disk drive in the HPE Alliance One Advanced Services zl Modules.

7) Products purchased before August 1, 2013 include 1 year of technical support and 1 year 
(bug fix only). 

8) Includes all software updates offered for the licensed version, when and if available.  Software 
upgrades will require purchase of appropriate SKU, packaged support services or contract.

9) All technical, hardware and software support for ALU 77xx products is provided directly by 
Alcatel-Lucent only and not HPE.  For support from Alcatel-Lucent, select the country from 
which the customer is calling in the following link and it will present the appropriate ALU 
support contact information: https://services.support.alcatel-lucent.com/product_support/.  
Hardware warranty requires shipping failed product to ALU for repair or replacement.  
Logistics cost for shipment of product from customer’s site to ALU site for repair or 
replacement will be covered by the customer.  Software maintenance releases are included 
for the major software release purchased.  Major software release upgrades are NOT 
included.  Services may be purchased from HPE or Alcatel-Lucent to extend your support 
coverage and software upgrades.  Support will be provided by Alcatel Lucent for these 
services.

10) For products purchased after December 1, 2015, the warranty extends only for as long as the 
original end user owns the product and is limited to five (5) years from the end of sale date.

11) For the first 30 days from shipment, HPE will provide same day ship advanced 
replacement for the covered hardware products.  After thirty (30) days from shipment 
through the remaining warranty period, HPE will replace or repair any non-compliant 
Product and return it in operable condition, shipping after HPE’s receipt of the non-
compliant Product via HPE’s RMA procedure, with receipt by customer within ten 
(10) days on a commercially reasonable basis.

12) HPE will provide next business day email response for the purposes of diagnosing 
hardware or software defects during standard Pacific Time Zone business hours for 
the first 90 days after purchase. 

13) HPE will make one recent Instant OS software release image available on the 
software portal.  This image is also available for Remote Access Points (RAPs) 
running Instant OS.

14) These products are covered by 90 days of 24x7 phone support.  Thereafter, only 
chat support would be available for the remaining warranty period.  Limited lifetime 
warranty (where applicable) extends only for as long as the original end user owns 
the product and is limited to five (5) years from the end of sale date. This warranty 
includes coverage of any built-in fans and power supplies for the entire warranty 
period. You may be required to provide proof of purchase or lease as a condition of 
receiving warranty service. See www.hpe.com/OfficeConnect/support/ for more 
information on the new OfficeConnect support process. 

15) All technical, hardware and software support for Arista products is provided directly 
by Arista and not HPE.   Consult the Arista customer support page for contact 
information: https://www.arista.com/en/support/customer-support.  Transportation 
costs, if any, incurred in connection with the return of a defective Hardware to an 
Arista repair center shall be borne by Customer. Arista shall pay any transportation 
costs incurred with the redelivery of a repaired or replaced Hardware. Services may 
be purchased from HPE or Arista to extend your support coverage and software 
upgrades.  Support will be provided by Arista for these services.  For details on 
Arista warranty and support, see: 
http://www.arista.com/assets/data/pdf/Warranty.pdf.

16) All technical, hardware and software support for Big Switch Networks products is 
provided directly by BSN and not HPE.  Consult the Big Switch Networks customer 
support page for contact information: www.bigswitch.com/support.  For details on 
Big Switch Networks warranty and support options, see: 
http://bigswitch.com/sites/default/files/bsn_support_and_maintenance_policy.v2.2.20
16.11.14.pdf.
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Worldwide support numbers for these product 

families:*

 – Aruba products

 – HPE Nimble Storage products

Support matrix

Technical Support Phone Numbers

Country Support type Support phone number Hours of operations

Aland Contract +358 20 320 300 24x7

Warranty and Out of Warranty +358 20 353 232 M–F 8:00–17:00

Albania Contract & Warranty/Out of Warranty +355 42 322 411 24x7

Algeria Contract & Warranty/Out of Warranty +216 23 92 5000 24x7

Andorra Contract +34 902 220 030 24x7

Warranty and Out of Warranty +34 902 010 333 M–F 8:30–17:30

Angola Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Anguilla Contract & Warranty 1-800-225-5288 then 

844 692-8150

24x7

Antigua and Barbuda Contract & Warranty #1 then 844 692-8151 24x7

Argentina Contratos 0 800 444 7867

+52 55 5258 4500

24x7

Garantías 0 800 333 4857

+52 55 1500 3155

M–F 8:00–17:00

Armenia Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Aruba Contract & Warranty +1 844 264 1328 24x7

Australia Contract & Warranty/Out of Warranty 13 11 47

+61 2 8031 8315

24x7

Azerbaijan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

* For all other product types, please call the support number for your country listed in this document.
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Support matrix Page 2

Country Support type Support phone number Hours of operations

Bahamas Contract & Warranty 1-800-872-2881 then 

844 692-8152

24x7

Bahrain Contract & Warranty/Out of Warranty +973 1 619 82 94 24x7

Barbados Contract & Warranty 1-800-225-5288 then 

844 692-8153

24x7

Belarus Contract & Warranty/Out of Warranty 8 8200 073 01 01

+7 495 411 69 07

24x7

Belgium Contract 078 250 144

+32 26 200 055

24x7

Warranty and Out of Warranty 078 600 600

+32 26 200 099

M–F 8:00–17:00

Belize Contract & Warranty 811 then 844 692-8148 24x7

Benin Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Bermuda Contract & Warranty 1-800-225-5288 then 

844 692-8154

24x7

Bolivia Contratos 800 110 348

+52 55 5258 4500

24x7

Garantías 800 110 348

+52 55 1500 3155

M–F 8:00–17:00

Bonaire (Sint Eustatius, Saba) Contract & Warranty 001-800-872-2881 then 

844 752-2839

24x7

Bosnia and Herzegovina Contract & Warranty/Out of Warranty +387 338 219 22 24x7

Botswana Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Bouvet Island Contract & Warranty/Out of Warranty 800 56 044 24x7

Brasil Contract 0800 55 6405

+55 11 3173 8802 

+55 11 4688 5102

24x7

Warranty 0800 710 2029

+55 11 2377 1002 

+55 11 2377 0002

M–F 8:00–17:00
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Support matrix Page 3

Country Support type Support phone number Hours of operations

British Indian Ocean Territory Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

British Virgin Islands Contract & Warranty 1-800-872-2881 then 

844 692-8156

24x7

Bulgaria Contract & Warranty/Out of Warranty 0700-1-47-47 24x7

Burkina Faso Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Burundi Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Cameroon Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Canada Contract

Contrat

1-800-633-3600 24x7

Warranty and Out of Warranty

Produits garantis et hors garantie

1-844-806-3425 24x7 for most products

Cape Verde Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Cayman Islands Contract & Warranty 1-800-225-5288 then 

844 692-8157

24x7

Central African Republic Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Chad Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Chile Contratos 800 362 365

+52 55 5258 4500

24x7

Garantías 800 123 605

+52 55 1500 3155

M–F 8:00–17:00

Collectivity of Saint Martin Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Colombia Contratos 01 800 051 4747

+57 1 6004150

24x7

Garantías 800 051 7127

+52 55 1500 3155

M–F 9:00–18:00

Comoros Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7
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Support matrix Page 4

Country Support type Support phone number Hours of operations

Costa Rica Contratos 800 794 4401

+52 55 5258 4500

24x7

Garantías 800 794 4401

+52 55 1500 3155

M–F 8:00–17:00

Croatia Contract & Warranty/Out of Warranty 0800 303 556 24x7

Curaçao Contract & Warranty 001-800-872-2881 then 

844 264-1326

24x7

Cyprus Contract & Warranty/Out of Warranty 801 11 47 22 73

+30 211 181 3846

24x7

Czech Republic Contract & Warranty/Out of Warranty 239 018 791 24x7

Denmark Contract +45 70 10 80 25 24x7

Warranty and Out of Warranty +45 70 11 77 00 M–F 8:00–17:00

Deutschland Dienstleistungsverträge/Contracts +49 69 380 789 143 24x7

Produkte innerhalb und außerhalb der Herstellergarantie +49 69 380 789 142 Montag–Freitag

8:00–17:00

(außer an bundeseinheitlichen Feiertagen)

Djibouti Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Dominica Contract & Warranty 1-800-225-5288 then 

844 264-1327

24x7

Dominican Republic Contract & Warranty 1-888-225-5288 then 

844 264-1328

+52 55 5258 4500

24x7

Ecuador Contratos 1-800-225-528 then 

844 845-8165

+52 55 5258 4500

24x7

Garantías 1-800-225-528 then 

844 845-8165

+52 55 1500 3155 

M–F 8:00–17:00

Egypt Contract & Warranty/Out of Warranty 0800 000 0814

+20 2 353 131 62

24x7
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Support matrix Page 5

Country Support type Support phone number Hours of operations

El Salvador Contratos 800-1785 then 

844 845-8167

+52 55 5258 4500

24x7

Garantías 800-1785 then 

844 845-8167

+52 55 1500 3155 

M–F 8:00–17:00

Equatorial Guinea Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Eritrea Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

España Contrato de Mantenimiento +34 902 220 030

+34 913496569

24x7

Garantía y fuera de garantía +34 902 010 333

+34 913496559

Lunes a viernes, 8:30 a 17:30 de julio y agosto,  

8:30 a 14:30

Estonia Contract & Warranty/Out of Warranty +372 686 88 71 24x7

Ethiopia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Falkland Islands Contract & Warranty/Out of Warranty +44 845 161 0050 24x7

Faroe Islands Contract +45 70 10 80 25 24x7

Warranty and Out of Warranty +45 70 11 77 00 M–F 8:00–17:00

Finland Contract +358 20 320 300 24x7

Warranty and Out of Warranty +358 20 353 232 M–F 8:00–17:00

France Contrat 0825 00 41 23

+33 173018471

24x7

Ligne payante au tarif local en France

Garantie et Hors Garantie 0826 10 49 49

+33 173018475

Lundi–Vendredi 

8:30–18:00

(à l’exception des jours fériés et jours de fermeture d’HPE)

French Guiana Contract & Warranty 0800 99 00 11 then 

844 264-1329

24x7

French Polynesia Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

French Southern Territories Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Gabon Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7
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Support matrix Page 6

Country Support type Support phone number Hours of operations

Gambia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Georgia Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Ghana Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Gibraltar Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

Greece Contract & Warranty/Out of Warranty 801 11 47 22 73

+30 211 181 3846

24x7

Greenland Contract +45 70 10 80 25 24x7

Warranty and Out of Warranty +45 70 11 77 00 M–F 8:00–17:00

Grenada Contract & Warranty 1-800-225-5288 then 

844 264-1330

24x7

Guadeloupe Contract & Warranty 0-800-99-0011 then 

844 264-1331

24x7

Guatemala Contratos 999-9190 then 

844 845-8169

+52 55 5258 4500

24x7

Garantías 999-9190 then 

844 845-8169

+52 55 1500 3155

M–F 8:00–17:00

Guernsey Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

Guinea Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Guinea-Bissau Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Guyana Contract & Warranty 159 then 844 752-2835 24x7

Haiti Contract & Warranty +1 844 264 1328 24x7
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Support matrix Page 7

Country Support type Support phone number Hours of operations

Honduras Contratos 800-0-123 then 

844 752-2837

+52 55 5258 4500

24x7

Garantías 800-0-123 then 

844 752-2837

+52 55 1500 3155 

M–F 8:00–17:00

Hong Kong Contract +852 2292 3333 24x7

Alpha, ProLiant, and attached HPE Storage Systems

Warranty +852 3071 3873 M–F 8:30–17:30

HPE Networking, UNIX® system, NetServer, and attached 

HPE Storage systems 

Warranty +852 2904 8338 24x7

ProLiant & attached 

HPE Storage Systems 

Value line (need PIN code during AOH)

Hungary Contract 1 778 9670 24x7

Warranty and Out of Warranty 1 778 9669 M–F 9:00–17:00

Iceland Contract +47 800 56 044 24x7

Warranty and Out of Warranty +47 800 62 800 M–F 8:00–17:00

India Warranty 1800 419 8080 (Callers in India)

+91 806 703 7209 (International Callers)

M–F 9:00–18:00

Indonesia Contract & Warranty 0018 0385 20668

+62 21 5799 4050

24x7

Iran Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Iraq Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Ireland Contract 1850 924 590

+ 353 1 4118915

24x7

Warranty and Out of Warranty 1890 946 500

+ 353 1 4118912

M–F 8:00–18:00

(except Bank Holidays)

Isle of Man Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00
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Support matrix Page 8

Country Support type Support phone number Hours of operations

Israel Contract & Warranty/Out of Warranty 1-809-400-300

+972 3-3726489

24x7

Italia Contratti 02 452 790 50 24x7

In garanzia o fuori garanzia 02 385 912 12 Lunedì–Venerdì 8:00–17:00

Ivory Coast Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Jamaica Contract & Warranty 1-800-872-2881 then 

844 264-1332

24x7

日本 Warranty support.hpe.com/hpsc/doc/public/display?docId=emr_

na-c04770344

Jersey Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

Jordan Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Kazakhstan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Kenya Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Kosovo Contract & Warranty/Out of Warranty 0800 300 003/0800 190 038 (Serbia)

035 542 322 411 (Albania)

24x7

Kuwait Contract & Warranty/Out of Warranty 632 9930 24x7

Kyrgyzstan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Latvia Contract & Warranty/Out of Warranty 678 521 84 24x7

Lebanon Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Lesotho Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Liberia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Libya Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Liechtenstein Contract +41 0848 800 724 24x7

Warranty and Out of Warranty +41 0848 80 20 20 M–F 8:00–18:00

Lithuania Contract & Warranty/Out of Warranty +370 521 415 92 24x7
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Support matrix Page 9

Country Support type Support phone number Hours of operations

Luxembourg Contract +352 27 303 111 24x7

Warranty and Out of Warranty +352 27 303 303 M–F 8:00–17:00

Macedonia Contract & Warranty/Out of Warranty 0800 90 472 24x7

Madagascar Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Malawi Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Malaysia Contract & Warranty 1800 88 1811 (Callers in Malaysia)

+60 3 6207 4533 (International Callers)

24x7

Mali Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Malta Contract & Warranty/Out of Warranty +356 27 781 269 24x7

Martinique Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Mauritania Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Mauritius Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Mayotte Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

México Contratos 800 501 9800

+52 55 5258 4500

24x7

Garantías 800 890 6348

+52 55 1500 3155

M–F 8:00–17:00

Moldova Contract & Warranty/Out of Warranty +7 499 272 37 82 24x7

Monaco Contrat +33 1 73 01 84 71 24x7

Ligne payante au tarif local en France

Garantie et Hors Garantie +33 1 73 01 84 75 Lundi–Vendredi 

8:30–18:00

(à l’exception des jours fériés et jours de fermeture d’HPE)

Montenegro Contract & Warranty/Out of Warranty 0800 300 003 24x7

Montserrat Contract & Warranty 1-800-225-5288 then 

844 264-1333

24x7

Morocco Contract & Warranty/Out of Warranty 00 212 5 22 24 87 70

+44 1793 794886

24x7
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Support matrix Page 10

Country Support type Support phone number Hours of operations

Mozambique Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Namibia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Netherlands Contract 0900 115 0000

+31 205 040 666

24x7

Warranty and Out of Warranty 0900 117 0000 M–F 8:00–17:00

New Caledonia Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

New Zealand Contract & Warranty/Out of Warranty 0800 664 747

+61 2 8031 8316

24x7

Nicaragua Contratos 1-800-0164 then 

844 752-2840

+52 55 5258 4500

24x7

Garantías 1-800-0164 then 

844 752-2840

+52 55 1500 3155

M–F 8:00–17:00

Niger Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Nigeria Contract & Warranty/Out of Warranty 01 27 14 777

+44 203 564 4148

24x7

Norway Contract 800 56 044 24x7

Warranty and Out of Warranty 800 62 800 M–F 8:00–17:00

Oman Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Österreich Dienstleistungsverträge/Contracts 08 1000 2000 24x7

Produkte innerhalb und ausserhalb der

Herstellergarantie

08 1000 1000 M–F 8:00–18:00

Palestinian Territory Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Panama Contratos 800-2288 then 

844 845-8163

+52 55 5258 4500

24x7

Garantías 800-2288 then 

844 845-8163

+52 55 1500 3155 

M–F 8:00–17:00
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Country Support type Support phone number Hours of operations

Paraguay Contratos 008-11-800 then 

844 752-2842

+52 55 5258 4500

24x7

Garantías 008-11-800 then 

844 752-2842

+52 55 1500 3155 

M–F 8:00–17:00

Perú Contratos 0 800 1 9703

+52 55 5258 4500

24x7

Garantías 0800 44 366

+52 55 1500 3155 

M–F 8:00–17:00

Philippines Contract & Warranty 1800 1441 0669

 1800 8908 6404

+63 2395 3565

24x7

Poland Contract & Warranty/Out of Warranty 0 800 702 284

(22) 306 04 84

24x7

Portugal Contract 808 203 203 24x7

Warranty and Out of Warranty 213 164 164 M–F 9:00–18:00

Puerto Rico Contratos 844 752-2843

+52 55 5258 4500

24x7

Garantías 844 752-2843

+52 55 1500 3155 

M–F 8:00–17:00

Qatar Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Republic of Congo Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Réunion Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Romania Contract & Warranty/Out of Warranty +40 317 305 020 24x7

Россия Поддержка 8 800 500 92 55

+7 495 411 69 07

24x7

Rwanda Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Saint Barthélemy Contract 0-800-990-011 then 

844 845-8168

24x7

Warranty and Out of Warranty +212 5 22 24 87 70 24x7
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Saint Helena (Ascension and Tristan da Cunha) Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Saint Kitts and Nevis Contract & Warranty 1-800-225-5288 then 

844 264-1334

24x7

Saint Lucia Contract & Warranty/Out of Warranty 1 844 231 8954 24x7

Saint Pierre and Miquelon Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Saint Vincent and the Grenadines Contract & Warranty 1-800-225-5288 then 

844 845-8160

24x7

San Marino Contract 02 452 790 50 24x7

Warranty and Out of Warranty 02 385 912 12 M–F 8:00–17:00

Sao Tome and Principe Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Saudi Arabia Contract & Warranty/Out of Warranty 800 844 4611 24x7

Schweiz
Suisse

Dienstleistungsvertrag/

Contrat de services

0848 800 724

+41 43 557 9021

24x7

8Rp./Min*

Herstellergarantie/

Produits garantis

0848 80 20 20

+41 44 200 4115

Montag–Freitag

Lundi–Vendredi

8:00–17:00

(außer Feiertage) 

8Rp./Min*

*aus dem schweizerischen Festnetz; abweichende Preise aus 

Mobilfunknetzen sind je nach Anbieter möglich.

Senegal Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Serbia Contract & Warranty/Out of Warranty 0800 300 003

0800 190 038 

24x7

Seychelles Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Sierra Leone Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Singapore Contract & Warranty 1800 272 4333 (Callers in Singapore)

+65 6272 4333 (International Callers)

24x7

Sint Maarten Contract & Warranty 800-99-0011 then 

844 264-1335

24x7
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Slovakia Contract & Warranty/Out of Warranty 02 686 221 79 24x7

Slovenia Contract & Warranty/Out of Warranty 0800 80 745 24x7

Somalia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

South Africa Contract 0860 001 020 24x7

Warranty and Out of Warranty 0860 001 030 M–F 8:00–17:00

(except public Holidays)

South Georgia and the South Sandwich Islands Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

대한민국 Contract & Warranty +82 1577 3270 M–F 09:00–18:00

Server & Storage

Contract & Warranty +82 1588 0142 M–F 09:00–18:00

Networking

South Sudan Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Sudan Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Suriname Contract & Warranty/Out of Warranty 156 then 844 231-8955 24x7

Svalbard and Jan Mayen Contract +47 800 56 044 24x7

Warranty and Out of Warranty +47 800 62 800 M–F 8:00–17:00

Swaziland Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Sweden Contract 0771 30 30 50 24x7

Warranty and Out of Warranty 0771 30 30 00 M–F 8:00–17:00

Syria Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Taiwan Contract & Warranty 0800 211 666

+886 2 2656 7204

M–F 8:30–17:30

Tajikistan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7
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Tanzania Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Thailand Contract 1800 441 4048

+66 2 118 6000

24x7

Warranty 1800 441 4085

+66 2 118 6300

M–F 8:30–17:30

The Democratic Republic of Congo Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Togo Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Trinidad and Tobago Contract & Warranty/Out of Warranty 1-800-872-2881 then 

844 845-8161

24x7

Tunisia Contract & Warranty/Out of Warranty +216 23 92 5000 24x7

Turkey Contract 850 759 0 724

+90 850 759 0 724

24x7

Warranty and Out of Warranty 850 759 0 473

+90 850 759 0 473

08:30–17:30 GMT+3

Turkmenistan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Turks and Caicos Islands Contract & Warranty 1-800-225-5288 then 

844 845-8162

24x7

Uganda Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Ukraine Contract & Warranty/Out of Warranty 0 800 501 526 24x7

United Arab Emirates Contract & Warranty/Out of Warranty 800 0444 1477 24x7

United Kingdom Contract 0845 161 0050 24x7

Warranty and Out of Warranty 0845 161 0030 M–F 8:00–18:00

United States Contract 1-800-633-3600 24x7

Warranty and Out of Warranty 1-844-806-3425 24x7

Uruguay Contratos 0004 110 032 632

+52 55 5258 4500

24x7

Garantías 0004 110 032 632

+52 55 1500 3155 

M–F 8:00–17:00
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Country Support type Support phone number Hours of operations

US Virgin Islands Contract & Warranty +1 844 845-8164 24x7

Uzbekistan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Vatican City Contract 02 45279050 24x7

Warranty and Out of Warranty 02 38591212 M–F 8:00–17:00

Venezuela Contratos & Garantías +58 212 7102103 24x7

Vietnam Contract & Warranty +84 28 4458 2390 24x7

Wallis and Futuna Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Western Sahara Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Yemen Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Zambia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Zimbabwe Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7
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Aruba 2930F Switch Series
 

 

Models
Aruba 2930F 24G 4SFP+ Switch JL253A
Aruba 2930F 48G 4SFP+ Switch JL254A
Aruba 2930F 24G PoE+ 4SFP+ Switch JL255A
Aruba 2930F 48G PoE+ 4SFP+ Switch JL256A
Aruba 2930F 8G PoE+ 2SFP+ Switch JL258A
Aruba 2930F 24G 4SFP Switch JL259A
Aruba 2930F 48G 4SFP Switch JL260A
Aruba 2930F 24G PoE+ 4SFP Switch JL261A
Aruba 2930F 48G PoE+ 4SFP Switch JL262A
Aruba 2930F 24G PoE+ 4SFP+ TAA-compliant Switch JL263A
Aruba 2930F 48G PoE+ 4SFP+ TAA-compliant Switch JL264A
Aruba 2930F 48G PoE+ 4SFP 740W Switch JL557A
Aruba 2930F 48G PoE+ 4SFP+ 740W Switch JL558A
Aruba 2930F 48G PoE+ 4SFP+ 740W TAA-compliant Switch JL559A

 

Key features
Aruba Layer 3 switch series with VSF stacking, static, RIP and Access OSPF Routing, dynamic
segmentation, ACLs, and robust QoS
Supports cloud and on-premises management. And advanced policy management using Aruba
ClearPass
Convenient built-in 1GbE or 10GbE uplinks and up to 740 W PoE+
Software-defined ready with REST APIs and OpenFlow support
Simple deployment with Zero Touch Provisioning

 

QuickSpecs Aruba 2930F Switch Series

Overview
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Product overview
The Aruba 2930F Switch Series is designed for customers creating smart digital workplaces that are optimized for mobile
users with an integrated wired and wireless approach. These convenient Layer 3 network switches include built-in uplinks
and power so are simple to deploy and manage with advanced security and network management tools like Aruba
ClearPass Policy Manager, Aruba AirWave and cloud-based Aruba Central.

A powerful Aruba ProVision ASIC delivers performance, robust feature support and value with programmability for the latest
applications. Stacking with Virtual Switching Framework (VSF) provides simplicity and scalability. The 2930F supports built-
in 1GbE or 10GbE uplinks, PoE+, Access OSPF routing, Dynamic Segmentation, robust QoS, RIP routing, and IPv6 with no
software licensing required.

The Aruba 2930F Switch Series provides a convenient and cost-effective access switch solution that can be quickly set up
with Zero Touch Provisioning. The robust basic Layer 3 feature set includes a limited lifetime warranty.

 

Enhanced Capabilities
Unified Wired and Wireless Support

Supports unified wired and wireless policies
Aruba ClearPass Policy Manager
Switch auto-configuration
automatically configures switch for different settings such as VLAN, CoS, PoE max power, and PoE
priority when an Aruba access point is detected.
User role
defines a set of switch-based policies in areas such as security, authentication, and QoS. A user role
can be assigned to a group of users or devices, using switch-based local user role or download from
ClearPass
Dynamic segmentation
provides a secured tunnel to transport network traffic on a per-port or per-user-role basis to an Aruba
Controller.  In per-user-role Tunneled Node, users are authenticated with ClearPass Policy Manager
which can direct the traffic to be tunneled to Aruba controller or switch locally
Static IP visibility
allows ClearPass to do accounting for clients with static IP address

Software-defined networks

REST APIs and OpenFlow
Supports multiple programmatic interfaces, including REST APIs and Openflow 1.0 and 1.3, to enable
automation of network operations, monitoring, and troubleshooting.

Quality of Service (QoS)

Traffic prioritization (IEEE 802.1p)
for classification into eight priority levels mapped to eight queues
Layer 4 prioritization
based on TCP/UDP port numbers
Class of Service (CoS)
sets the IEEE 802.1p priority tag based on IP address, IP Type of Service (ToS), Layer 3 protocol,
TCP/UDP port number, source port, and DiffServ
Rate limiting
sets per-port ingress enforced maximums and per-port, per-queue minimums
Large buffers
provide graceful congestion management
Unknown Unicast Rate Limiting

QuickSpecs Aruba 2930F Switch Series
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throttles unicast packets with unknown destination addresses and limits flooding on the VLAN

Connectivity

Convenient built-in 10 Gbps Ethernet (4 x SFP+) uplinks
available on select models
Auto-MDIX
provides automatic adjustments for straight-through or crossover cables on all 10/100 and
10/100/1000 ports
IEEE 802.3at Power over Ethernet (PoE+)
provides up to 30 W per port that allows support of the latest PoE+-capable devices such as IP
phones, wireless access points, and security cameras, as well as any IEEE 802.3af-compliant end
device; eliminates the cost of additional electrical cabling and circuits that would otherwise be
necessary in IP phone and WLAN deployments
Support for pre-standard PoE
detects and provides power to pre-standard PoE devices
IPv6

− IPv6 host
enables switches to be managed in an IPv6 network

− Dual stack (IPv4 and IPv6)
transitions from IPv4 to IPv6, supporting connectivity for both protocols

− MLD snooping
forwards IPv6 multicast traffic to the appropriate interface

− IPv6 ACL/QoS
supports ACL and QoS for IPv6 network traffic

− IPv6 routing
supports static and RIPng protocols

− Security
provides RA guard, DHCPv6 protection, dynamic IPv6 lockdown, and ND snooping

Performance and efficiency

Energy-efficient design
− 80 PLUS Silver Certified power supply

increases power efficiency and savings
− Energy-efficient Ethernet (EEE) support

reduces power consumption in accordance with IEEE 802.3az

Designed with the latest Aruba Provision ASIC
providing very low latency, increased packet buffering, and adaptive power consumption
Selectable queue configurations
allows for increased performance by selecting the number of queues and associated memory buffering
that best meet the requirements of the network applications
-Stacking topology

− Virtual Switching Framework (VSF) front plane stacking creates one virtual resilient switch from
up to eight* switches

− Ring topology supports up to an 8-member stack
− Virtualized switching provides simplified management as the switches act as a single chassis

when stacked
1 Requires ArubaOS-Switch 16.06 software.

Convergence

IP multicast snooping and data-driven IGMP
automatically prevent flooding of IP multicast traffic
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LLDP-MED (Media Endpoint Discovery)
defines a standard extension of LLDP that stores values for parameters such as QoS and VLAN to
configure automatically network devices such as IP phones
IEEE 802.1AB Link Layer Discovery Protocol (LLDP)
facilitates easy mapping using network management applications with LLDP automated device
discovery protocol
PoE and PoE+ allocations
support multiple methods (automatic, IEEE 802.3at dynamic, LLDP-MED fine grain, IEEE 802.3af
device class, or user-specified) to allocate and manage PoE/PoE+ power for more efficient energy
savings
Local MAC Authentication
assigns attributes such as VLAN and QoS using locally configured profile that can be a list of MAC
prefixes
IP multicast routing
includes PIM Sparse and Dense modes to route IP multicast traffic (limited to 16 interfaces)
Protocol Independent Multicast for IPv6
supports one-to-many and many-to-many media casting use cases such as IPTV over IPv6 networks

Resiliency and high availability

IEEE 802.1s Multiple Spanning Tree
provides high link availability by allowing multiple spanning trees; provides legacy support for IEEE
802.1d and IEEE 802.1w
Virtual Router Redundancy Protocol (VRRP)
allows groups of two routers to dynamically back each other up to create highly available routed
environments for IPv4 and IPv6 networks (limited to 128 VRs)
IEEE 802.3ad link-aggregation-control protocol (LACP) and port trunking
support up to 60 static or dynamic trunks with each trunk having up to eight links (ports) per static trunk
SmartLink
provides easy-to-configure link redundancy of active and standby links
SNMPv1, v2, and v3
provide complete support of SNMP; provide full support of industry-standard Management Information
Base (MIB) plus private extensions; SNMPv3 supports increased security using encryption

Simplified configuration and management

Aruba Central support
cloud based management platform offers simple, secure, and cost effective way to manage switches
Zero-Touch Provisioning (ZTP)
simplifies installation of the switch infrastructure using Aruba Activate or a DHCP-based process with
AirWave and Central Network Management
Built-in programmable and easy to use REST API interface
provides configuration automation for campus networks
Flexible management with same hardware
supports both cloud-based Central and on-premises AirWave with the same hardware, ensuring
management platform changes without ripping and replacing switching infrastructure
Out-of-band Ethernet management port
enables management on a separate physical management network, and keeps management traffic
segmented from network data traffic

Manageability

Dual flash images
provides independent primary and secondary operating system files for backup while upgrading
Friendly port names
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allow assignment of descriptive names to ports
Find-Fix-Inform feature
finds and fixes common network problems automatically, then informs administrator
Supports multiple configuration files
stored to a flash image
RMON, XRMON, and sFlow
provide advanced monitoring and reporting capabilities for statistics, history, alarms, and events
Troubleshooting
ingress and egress port monitoring enable more efficient network problem solving
Unidirectional link detection (UDLD)
monitors the link between two switches and blocks the ports on both ends of the link if the link goes
down at any point between the two devices
IP service level agreements (SLA) for voice
monitor quality of voice traffic using the UDP jitter and UDP jitter for VoIP tests

Layer 2 switching

VLAN Support and Tagging
supports IEEE 802.1Q (4094 VLAN IDs) and 2K VLANs simultaneously
Jumbo packet support
improves the performance of large data transfers; supports frame size of up to 9220 bytes
IEEE 802.1v protocol VLANs
isolate select non-IPv4 protocols automatically into their own VLANs
Rapid Per-VLAN Spanning Tree (RPVST+)
allows each VLAN to build a separate spanning tree to improve link bandwidth usage; is compatible
with PVST+
GVRP and MVRP
allows automatic learning and dynamic assignment of VLANs
VxLAN
encapsulation (tunneling) protocol for overlay network that enables a more scalable virtual network
deployment

Layer 3 services

DHCP server
centralizes and reduces the cost of IPv4 address management

Layer 3 routing

Static IP routing
provides manually configured routing; includes ECMP capability
256 static and 10,000 RIP routes
facilitate segregation of user data, without adding external hardware
Routing Information Protocol (RIP)
provides RIPv1, RIPv2, and RIPng routing
Access OSPF
provides OSPFv2 and OSPFv3 protocols for routing between access and the next layer on the LAN.
Only one OSPF area and up to 8 interfaces are supported
Policy-based routing
uses a classifier to select traffic that can be forwarded based on policy set by the network administrator
(limited to 16 next-hop routes)

Security

Control Plane Policing set rate limit on control protocols to protect CPU overload from DOS
attacks
Multiple user authentication methods
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− uses an IEEE 802.1X supplicant on the client in conjunction with a RADIUS server to
authenticate in accordance with industry standards

− supports Web-based authentication
− supports MAC-based authentication

Authentication flexibility
− Multiple IEEE 802.1X users per port

provides authentication of multiple devices on a single port; prevents a user from
"piggybacking" on another user's IEEE 802.1X authentication

− Concurrent IEEE 802.1X, Web, and MAC authentication schemes per port
switch port will accept up to 32 sessions of IEEE 802.1X, Web, and MAC authentications

TPM-based Security
includes a Trusted Platform Module (TPM) for secure hardware-based generation and storage of
cryptographic keys that can be used for a variety of authentication purposes
Access control lists (ACLs)
provide IP Layer 3 filtering based on source/destination IP address/subnet and source/destination
TCP/UDP port number
Source-port filtering
allows only specified ports to communicate with each other
RADIUS/TACACS+
eases switch management security administration by using a password authentication server
Secure shell
encrypts all transmitted data for secure remote CLI access over IP networks
Secure Sockets Layer (SSL)
encrypts all HTTP traffic, allowing secure access to the browser-based management GUI in the switch
Port security
allows access only to specified MAC addresses, which can be learned or specified by the administrator
MAC address lockout
prevents particular configured MAC addresses from connecting to the network
Secure FTP
allows secure file transfer to and from the switch; protects against unwanted file downloads or
unauthorized copying of a switch configuration file
Switch management logon security
helps secure switch CLI logon by optionally requiring either RADIUS or TACACS+ authentication
Custom banner
displays security policy when users log in to the switch
STP BPDU port protection
blocks Bridge Protocol Data Units (BPDUs) on ports that do not require BPDUs, preventing forged
BPDU attacks
DHCP protection
blocks DHCP packets from unauthorized DHCP servers, preventing denial-of-service attacks
Dynamic ARP protection
blocks ARP broadcasts from unauthorized hosts, preventing eavesdropping or theft of network data
STP root guard
protects the root bridge from malicious attacks or configuration mistakes
Identity-driven ACL
enables implementation of a highly granular and flexible access security policy and VLAN assignment
specific to each authenticated network user
Per-port broadcast throttling
Configures broadcast control selectively on heavy traffic port uplinks
Private VLAN
provides network security by restricting peer-to-peer communication to prevent a variety of malicious
attacks; typically a switch port can only communicate with other ports in the same community and/or
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an uplink port, regardless of VLAN ID or destination MAC address
Open authentication role
simplifies first-time deployment of AAA in brownfield deployments by allowing full network access for
failed clients and provides instant connectivity as soon as a client is plugged-in
Critical authentication role
ensures that important infrastructure devices such as IP phones are allowed network access even in
the absence of a RADIUS server
MAC pinning
allows non-chatty legacy devices to stay authenticated by pinning client MAC addresses to the port
until the clients logoff or get disconnected

Monitor and diagnostics

Digital optical monitoring of SFP+ and 1000BASE-T transceivers
allows detailed monitoring of the transceiver settings and parameters

Warranty and support

Limited Lifetime Warranty
see http://www.hpe.com/networking/warrantysummary for warranty and support information
included with your product purchase.
Software releases
to find software for your product, refer to http://www.hpe.com/networking/support; for details on the
software releases available with your product purchase, refer to
http://www.hpe.com/networking/warrantysummary 

 

QuickSpecs Aruba 2930F Switch Series

Overview

DA - 15576   Worldwide QuickSpecs — Version 10 — 12/3/2018 Page  7

Anexo 01 ITENS 8 E 9 (0592696)         SEI 0008478-63.2018.6.02.8000 / pg. 6335

http://www.hpe.com/networking/warrantysummary
http://www.hpe.com/networking/support
http://www.hpe.com/networking/warrantysummary


 

Build To Order:
BTO is a standalone unit with no integration. BTO products ship standalone are not part of a CTO or Rack-
Shippable solution.
   
Aruba 2930F 24G 4SFP+ Switch JL253A

24 RJ-45 autosensing 10/100/1000 ports
4 SFP/SFP+ 1G/10G ports
min=0 \\ max=4 SFP/SFP+  Transceivers
1U - Height

See Configuration
NOTE: 1, 2, 3

   
PDU Cable NA/MEX/TW/JP JL253A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL253A#B2C

C15 PDU Jumper Cord (ROW)  
   
High Volt Switch to Wall Power Cord JL253A#B2E

HPE 2.3M C13 to NEMA L6-20P Power Cord(J9936A)  
   
Aruba 2930F 48G 4SFP+ Switch JL254A

48 RJ-45 autosensing 10/100/1000 ports
4 SFP/SFP+ 1G/10G ports
min=0 \\ max=4 SFP/SFP+  Transceivers
1U - Height

See Configuration
NOTE: 1, 2, 3

   
PDU Cable NA/MEX/TW/JP JL254A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL254A#B2C

C15 PDU Jumper Cord (ROW)  
   
High Volt Switch to Wall Power Cord JL254A#B2E

HPE 2.3M C13 to NEMA L6-20P Power Cord(J9936A)  
   
Aruba 2930F 24G PoE+ 4SFP+ Switch JL255A

24 RJ-45 PoE+ autosensing 10/100/1000 ports
4 SFP/SFP+ 1G/10G ports
min=0 \\ max=4 SFP/SFP+  Transceivers
1U - Height

See Configuration
NOTE: 1, 2, 3

   
PDU Cable NA/MEX/TW/JP JL255A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL255A#B2C

C15 PDU Jumper Cord (ROW)  
   
High Volt Switch to Wall Power Cord JL255A#B2E

HPE 2.3M C13 to NEMA L6-20P Power Cord(J9936A)  
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Aruba 2930F 48G PoE+ 4SFP+ Switch JL256A

48 RJ-45 PoE+ autosensing 10/100/1000 ports
4 SFP/SFP+ 1G/10G ports
min=0 \\ max=4 SFP/SFP+  Transceivers
1U - Height

See Configuration
NOTE: 1, 2, 3

   
PDU Cable NA/MEX/TW/JP JL256A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL256A#B2C

C15 PDU Jumper Cord (ROW)  
   
High Volt Switch to Wall Power Cord JL256A#B2E

HPE 2.3M C13 to NEMA L6-20P Power Cord(J9936A)  
   
Aruba 2930F 8G PoE+ 2SFP+ Switch JL258A

8 RJ-45 PoE+ autosensing 10/100/1000 ports
2 SFP/SFP+ 1G/10G ports
min=0 \\ max=2 SFP/SFP+  Transceivers
1U - Height

See Configuration
NOTE: 1, 2, 3

   
PDU Cable NA/MEX/TW/JP JL258A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL258A#B2C

C15 PDU Jumper Cord (ROW)  
   
High Volt Switch to Wall Power Cord JL258A#B2E

HPE 2.3M C13 to NEMA L6-20P Power Cord(J9936A)  
   
Aruba 2930F 24G 4SFP Switch JL259A

24 RJ-45 autosensing 10/100/1000 ports
4 SFP 1G ports
min=0 \\ max=4 SFP Transceivers
1U - Height

See Configuration
NOTE: 1, 3

   
PDU Cable NA/MEX/TW/JP JL259A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL259A#B2C

C15 PDU Jumper Cord (ROW)  
   
High Volt Switch to Wall Power Cord JL259A#B2E

HPE 2.3M C13 to NEMA L6-20P Power Cord(J9936A)  
   
   
Aruba 2930F 48G PoE+ 4SFP 740W Switch JL557A
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48 RJ-45 autosensing 10/100/1000 ports
4 SFP 1G ports
min=0 \\ max=4 SFP  Transceivers
1U - Height

See Configuration
NOTE: 1, 3

   
PDU Cable NA/MEX/TW/JP JL557A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL557A#B2C

C15 PDU Jumper Cord (ROW)  
   
High Volt Switch to Wall Power Cord JL557A#B2E

HPE 2.3M C13 to NEMA L6-20P Power Cord(J9936A)  
   
No Power Cord JL557A#AC3

No Localized Power Cord Selected  
   
Aruba 2930F 48G 4SFP Switch JL260A

48 RJ-45 autosensing 10/100/1000 ports
4 SFP 1G ports
min=0 \\ max=4 SFP  Transceivers
1U - Height

See Configuration
NOTE: 1, 3

   
PDU Cable NA/MEX/TW/JP JL260A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL260A#B2C

C15 PDU Jumper Cord (ROW)  
   
High Volt Switch to Wall Power Cord JL260A#B2E

HPE 2.3M C13 to NEMA L6-20P Power Cord(J9936A)  
   
Aruba 2930F 24G PoE+ 4SFP Switch JL261A

24 RJ-45 PoE+ autosensing 10/100/1000 ports
4 SFP 1G ports
min=0 \\ max=4 SFP Transceivers
1U - Height

See Configuration
NOTE: 1, 3

   
PDU Cable NA/MEX/TW/JP JL261A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL261A#B2C

C15 PDU Jumper Cord (ROW)  
   
High Volt Switch to Wall Power Cord JL261A#B2E

HPE 2.3M C13 to NEMA L6-20P Power Cord(J9936A)  
   
Aruba 2930F 48G PoE+ 4SFP+ 740W Switch JL558A
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48 RJ-45 PoE+ autosensing 10/100/1000 ports
4 SFP 1G ports
min=0 \\ max=4 SFP Transceivers
1U - Height

See Configuration
NOTE: 1, 3

   
PDU Cable NA/MEX/TW/JP JL558A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL558A#B2C

C15 PDU Jumper Cord (ROW)  
   
High Volt Switch to Wall Power Cord JL558A#B2E

HPE 2.3M C13 to NEMA L6-20P Power Cord(J9936A)  
   
No Power Cord JL558A#AC3

No Localized Power Cord Selected  
   
Aruba 2930F 48G PoE+ 4SFP Switch JL262A

48 RJ-45 PoE+ autosensing 10/100/1000 ports
4 SFP 1G ports
min=0 \\ max=4 SFP Transceivers
1U - Height

See Configuration
NOTE: 1, 3 

   
PDU Cable NA/MEX/TW/JP JL262A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL262A#B2C

C15 PDU Jumper Cord (ROW)  
   
High Volt Switch to Wall Power Cord JL262A#B2E

HPE 2.3M C13 to NEMA L6-20P Power Cord(J9936A)  
   
TAA Compliant Chassis  
   
Aruba 2930F 24G PoE+ 4SFP+ TAA-compliant Switch JL263A

24 RJ-45 PoE+ autosensing 10/100/1000 ports
4 SFP/SFP+ 1G/10G ports
min=0 \\ max=4 SFP/SFP+  Transceivers
1U - Height

See Configuration
NOTE: 1, 2, 3, 4

   
PDU Cable NA/MEX/TW/JP JL263A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL263A#B2C

C15 PDU Jumper Cord (ROW)  
   
High Volt Switch to Wall Power Cord JL263A#B2E

HPE 2.3M C13 to NEMA L6-20P Power Cord(J9936A)  
   
Aruba 2930F 48G PoE+ 4SFP+ 740W TAA-compliant Switch JL559A
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48 RJ-45 PoE+ autosensing 10/100/1000 ports
4 SFP/SFP+ 1G/10G ports
min=0 \\ max=4 SFP/SFP+  Transceivers
1U - Height

See Configuration
NOTE: 1, 2, 3, 4

   
PDU Cable NA/MEX/TW/JP JL559A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL559A#B2C

C15 PDU Jumper Cord (ROW)  
   
High Volt Switch to Wall Power Cord JL559A#B2E

HPE 2.3M C13 to NEMA L6-20P Power Cord(J9936A)  
   
No Power Cord JL559A#AC3

No Localized Power Cord Selected  
   
Aruba 2930F 48G PoE+ 4SFP+ TAA-compliant Switch JL264A

48 RJ-45 PoE+ autosensing 10/100/1000 ports
4 SFP/SFP+ 1G/10G ports
min=0 \\ max=4 SFP/SFP+  Transceivers
1U - Height

See Configuration
NOTE: 1, 2, 3, 4

   
PDU Cable NA/MEX/TW/JP JL264A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL264A#B2C

C15 PDU Jumper Cord (ROW)  
   
High Volt Switch to Wall Power Cord JL264A#B2E

HPE 2.3M C13 to NEMA L6-20P Power Cord(J9936A)  
   
Configuration Rules:  
   
NOTE 1 The following Transceivers install into this Chassis :  

HPE X121 1G SFP LC SX Transceiver J4858C
HPE X121 1G SFP LC LX Transceiver J4859C
HPE X121 1G SFP LC LH Transceiver J4860C
HPE X121 1G SFP RJ45 T Transceiver J8177C
HPE X111 100M SFP LC FX Transceiver J9054C
Aruba 1G SFP LC SX 500m OM2 MMF Transceiver J4858D
Aruba 1G SFP LC LX 10km SMF Transceiver J4859D
Aruba 1G SFP LC LH 70km SMF Transceiver J4860D
Aruba 1G SFP RJ45 T 100m Cat5e Transceiver J8177D

  Aruba 100M SFP LC FX 2km MMF Transceiver J9054D
   
NOTE 2 The following Transceivers install into this Switch:

HPE X132 10G SFP+ LC ER Transceiver J9153A
HPE X132 10G SFP+ LC SR Transceiver J9150A
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HPE X132 10G SFP+ LC LR Transceiver J9151A
Aruba 10G SFP+ LC SR 300m OM3 MMF Transceiver J9150D
Aruba 10G SFP+ LC LR 10km SMF Transceiver J9151D
Aruba 10G SFP+ LC ER 40km SMF Transceiver J9153D
Aruba 10G SFP+ to SFP+ 1m Direct Attach Copper Cable J9281D
Aruba 10G SFP+ to SFP+ 3m Direct Attach Copper Cable J9283D
HPE X242 10G SFP+ to SFP+ 1m Direct Attach Copper Cable J9281B
HPE X242 10G SFP+ to SFP+ 3m Direct Attach Copper Cable J9283B

     
NOTE 3 Localization required on orders without #B2B, #B2C or #B2E options.
     
NOTE 4 TAA Switch Chassis are available in the US, UK, Israel, Vietnam, South Korea, India and

Taiwan only.
     
Remarks:    
  Drop down under power supply should offer the following options and results:

Switch/Router/Power Supply to PDU Power Cord -  #B2B in North America, Mexico, Taiwan,
and Japan or #B2C ROW. (Watson Default B2B or B2C for Rack Level CTO)
Switch/Router/Power Supply to Wall Power Cord - Localized Option (Watson Default for BTO
and Box Level CTO)
#AC3 - No Power Cord

 

Rack Level Integration CTO Models  

   
Aruba 2930F 24G 4SFP+ Switch JL253A

24 RJ-45 autosensing 10/100/1000 ports
4 SFP/SFP+ 1G/10G ports
min=0 \\ max=4 SFP/SFP+  Transceivers
1U - Height

See Configuration
NOTE: 1, 2, 3, 4, 5

   
PDU Cable NA/MEX/TW/JP JL253A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL253A#B2C

C15 PDU Jumper Cord (ROW)  
   
High Volt Switch to Wall Power Cord JL253A#B2E

HPE 2.3M C13 to NEMA L6-20P Power Cord(J9936A)  
   
Aruba 2930F 48G 4SFP+ Switch JL254A

48 RJ-45 autosensing 10/100/1000 ports
4 SFP/SFP+ 1G/10G ports
min=0 \\ max=4 SFP/SFP+  Transceivers
1U - Height

See Configuration
NOTE: 1, 2, 3, 4, 5

   
PDU Cable NA/MEX/TW/JP JL254A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL254A#B2C

C15 PDU Jumper Cord (ROW)  
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High Volt Switch to Wall Power Cord JL254A#B2E

HPE 2.3M C13 to NEMA L6-20P Power Cord(J9936A)  
   
Aruba 2930F 24G PoE+ 4SFP+ Switch JL255A

24 RJ-45 PoE+ autosensing 10/100/1000 ports
4 SFP/SFP+ 1G/10G ports
min=0 \\ max=4 SFP/SFP+  Transceivers
1U - Height

See Configuration
NOTE: 1, 2, 3, 4, 5

   
PDU Cable NA/MEX/TW/JP JL255A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL255A#B2C

C15 PDU Jumper Cord (ROW)  
   
High Volt Switch to Wall Power Cord JL255A#B2E

HPE 2.3M C13 to NEMA L6-20P Power Cord(J9936A)  
   
Aruba 2930F 48G PoE+ 4SFP+ Switch JL256A

48 RJ-45 PoE+ autosensing 10/100/1000 ports
4 SFP/SFP+ 1G/10G ports
min=0 \\ max=4 SFP/SFP+  Transceivers
1U - Height

See Configuration
NOTE: 1, 2, 3, 4, 5

   
PDU Cable NA/MEX/TW/JP JL256A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL256A#B2C

C15 PDU Jumper Cord (ROW)  
   
High Volt Switch to Wall Power Cord JL256A#B2E

HPE 2.3M C13 to NEMA L6-20P Power Cord(J9936A)  
   
Aruba 2930F 24G 4SFP Switch JL259A

24 RJ-45 autosensing 10/100/1000 ports
4 SFP 1G ports
min=0 \\ max=4 SFP Transceivers
1U - Height

See Configuration
NOTE: 1, 3, 4, 5

   
PDU Cable NA/MEX/TW/JP JL259A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL259A#B2C

C15 PDU Jumper Cord (ROW)  
   
High Volt Switch to Wall Power Cord JL259A#B2E

HPE 2.3M C13 to NEMA L6-20P Power Cord(J9936A)  
   
Aruba 2930F 48G PoE+ 4SFP 740W Switch JL557A
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48 RJ-45 autosensing 10/100/1000 ports
4 SFP 1G ports
min=0 \\ max=4 SFP  Transceivers
1U - Height

See Configuration
NOTE: 1, 3

   
PDU Cable NA/MEX/TW/JP JL557A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL557A#B2C

C15 PDU Jumper Cord (ROW)  
   
High Volt Switch to Wall Power Cord JL557A#B2E

HPE 2.3M C13 to NEMA L6-20P Power Cord(J9936A)  
   
No Power Cord JL557A#AC3

No Localized Power Cord Selected  
   
Aruba 2930F 48G 4SFP Switch JL260A

48 RJ-45 autosensing 10/100/1000 ports
4 SFP 1G ports
min=0 \\ max=4 SFP  Transceivers
1U - Height

See Configuration
NOTE: 1, 3, 4, 5

   
PDU Cable NA/MEX/TW/JP JL260A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL260A#B2C

C15 PDU Jumper Cord (ROW)  
   
High Volt Switch to Wall Power Cord JL260A#B2E

HPE 2.3M C13 to NEMA L6-20P Power Cord(J9936A)  
   
Aruba 2930F 24G PoE+ 4SFP Switch JL261A

24 RJ-45 PoE+ autosensing 10/100/1000 ports
4 SFP 1G ports
min=0 \\ max=4 SFP Transceivers
1U - Height

See Configuration
NOTE: 1, 3, 4, 5

   
PDU Cable NA/MEX/TW/JP JL261A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL261A#B2C

C15 PDU Jumper Cord (ROW)  
   
High Volt Switch to Wall Power Cord JL261A#B2E

HPE 2.3M C13 to NEMA L6-20P Power Cord(J9936A)  
   
Aruba 2930F 48G PoE+ 4SFP+ 740W Switch JL558A
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48 RJ-45 PoE+ autosensing 10/100/1000 ports
4 SFP 1G ports
min=0 \\ max=4 SFP Transceivers
1U - Height

See Configuration
NOTE: 1, 3

   
PDU Cable NA/MEX/TW/JP JL558A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL558A#B2C

C15 PDU Jumper Cord (ROW)  
   
High Volt Switch to Wall Power Cord JL558A#B2E

HPE 2.3M C13 to NEMA L6-20P Power Cord(J9936A)  
   
No Power Cord JL558A#AC3

No Localized Power Cord Selected  
   
Aruba 2930F 48G PoE+ 4SFP Switch JL262A

48 RJ-45 PoE+ autosensing 10/100/1000 ports
4 SFP 1G ports
min=0 \\ max=4 SFP Transceivers
1U - Height

See Configuration
NOTE: 1, 3, 4, 5

   
PDU Cable NA/MEX/TW/JP JL262A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL262A#B2C

C15 PDU Jumper Cord (ROW)  
   
High Volt Switch to Wall Power Cord JL262A#B2E

HPE 2.3M C13 to NEMA L6-20P Power Cord(J9936A)  
   
TAA Compliant Chassis  
   
Aruba 2930F 24G PoE+ 4SFP+ TAA-compliant Switch JL263A

24 RJ-45 PoE+ autosensing 10/100/1000 ports
4 SFP/SFP+ 1G/10G ports
min=0 \\ max=4 SFP/SFP+  Transceivers
1U - Height

See Configuration
NOTE: 1, 2, 3, 4, 5,

6

   
PDU Cable NA/MEX/TW/JP JL263A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL263A#B2C

C15 PDU Jumper Cord (ROW)  
   
High Volt Switch to Wall Power Cord JL263A#B2E

HPE 2.3M C13 to NEMA L6-20P Power Cord(J9936A)  
   
Aruba 2930F 48G PoE+ 4SFP+ 740W TAA-compliant Switch JL559A
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48 RJ-45 PoE+ autosensing 10/100/1000 ports
4 SFP/SFP+ 1G/10G ports
min=0 \\ max=4 SFP/SFP+  Transceivers
1U - Height

See Configuration
NOTE: 1, 2, 3, 4, 5,

6

   
PDU Cable NA/MEX/TW/JP JL559A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL559A#B2C

C15 PDU Jumper Cord (ROW)  
   
High Volt Switch to Wall Power Cord JL559A#B2E

HPE 2.3M C13 to NEMA L6-20P Power Cord(J9936A)  
   
No Power Cord JL559A#AC3

No Localized Power Cord Selected  
   
Aruba 2930F 48G PoE+ 4SFP+ TAA-compliant Switch JL264A

48 RJ-45 PoE+ autosensing 10/100/1000 ports
4 SFP/SFP+ 1G/10G ports
min=0 \\ max=4 SFP/SFP+  Transceivers
1U - Height

See Configuration
NOTE: 1, 2, 3, 4, 5,

6

   
PDU Cable NA/MEX/TW/JP JL264A#B2B

C15 PDU Jumper Cord (NA/MEX/TW/JP)  
   
PDU Cable ROW JL264A#B2C

C15 PDU Jumper Cord (ROW)  
   
High Volt Switch to Wall Power Cord JL264A#B2E

HPE 2.3M C13 to NEMA L6-20P Power Cord(J9936A)  
   
   
Configuration Rules:  
   
NOTE 1 The following Transceivers install into this Chassis :  

HPE X121 1G SFP LC SX Transceiver J4858C
HPE X121 1G SFP LC LX Transceiver J4859C
HPE X121 1G SFP LC LH Transceiver J4860C
HPE X121 1G SFP RJ45 T Transceiver J8177C
HPE X111 100M SFP LC FX Transceiver J9054C
Aruba 1G SFP LC SX 500m OM2 MMF Transceiver J4858D
Aruba 1G SFP LC LX 10km SMF Transceiver J4859D
Aruba 1G SFP LC LH 70km SMF Transceiver J4860D
Aruba 1G SFP RJ45 T 100m Cat5e Transceiver J8177D

  Aruba 100M SFP LC FX 2km MMF Transceiver J9054D
   
NOTE 2 The following Transceivers install into this Switch:

HPE X132 10G SFP+ LC ER Transceiver J9153A
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HPE X132 10G SFP+ LC SR Transceiver J9150A
HPE X132 10G SFP+ LC LR Transceiver J9151A
Aruba 10G SFP+ LC SR 300m OM3 MMF Transceiver J9150D
Aruba 10G SFP+ LC LR 10km SMF Transceiver J9151D
Aruba 10G SFP+ LC ER 40km SMF Transceiver J9153D
Aruba 10G SFP+ to SFP+ 1m Direct Attach Copper Cable J9281D
Aruba 10G SFP+ to SFP+ 3m Direct Attach Copper Cable J9283D
HPE X242 10G SFP+ to SFP+ 1m Direct Attach Copper Cable J9281B
HPE X242 10G SFP+ to SFP+ 3m Direct Attach Copper Cable J9283B

     
NOTE 3 If this switch is factory installed in HPE Racks, Then the J9583A#0D1 is required. 

CLIC Only - Allow the J9583AZ in all regions.
   
NOTE 4 Localization required on orders without #B2B, #B2C, #B2E options.  
   
NOTE 5 If this Switch Chassis is selected for Rack Level Integration, Then the Switch Chassis needs

to integrate (with #0D1) to the HPE Rack.
   
NOTE 6 TAA Switch Chassis are available in the US, UK, Israel, Vietnam, South Korea, India and

Taiwan only.
   
Remarks: Drop down under power supply should offer the following options and results:

Switch/Router/Power Supply to PDU Power Cord -  #B2B in North America, Mexico, Taiwan,
and Japan or #B2C ROW. (Watson Default B2B or B2C for Rack Level CTO)
Switch/Router/Power Supply to Wall Power Cord - Localized Option (Watson Default for BTO
and Box Level CTO)
#AC3 - No Power Cord

   
Enter the following menu selections as integrated to the CTO Model X server above if order is factory built. 
   

Transceivers  

   
SFP Transceivers  
   
HPE X111 100M SFP LC FX Transceiver J9054C
Aruba 100M SFP LC FX 2km MMF Transceiver J9054D
HPE X121 1G SFP LC LH Transceiver J4860C
HPE X121 1G SFP LC LX Transceiver J4859C
HPE X121 1G SFP LC SX Transceiver J4858C
HPE X121 1G SFP RJ45 T Transceiver J8177C
Aruba 1G SFP LC SX 500m OM2 MMF Transceiver J4858D
Aruba 1G SFP LC LX 10km SMF Transceiver J4859D
Aruba 1G SFP LC LH 70km SMF Transceiver J4860D
Aruba 1G SFP RJ45 T 100m Cat5e Transceiver J8177D
   
SFP+ Transceivers  
   
HPE X132 10G SFP+ LC ER Transceiver J9153A
HPE X132 10G SFP+ LC SR Transceiver J9150A
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HPE X132 10G SFP+ LC LR Transceiver J9151A
Aruba 10G SFP+ LC SR 300m OM3 MMF Transceiver J9150D
Aruba 10G SFP+ LC LR 10km SMF Transceiver J9151D
Aruba 10G SFP+ LC ER 40km SMF Transceiver J9153D
Aruba 10G SFP+ to SFP+ 1m Direct Attach Copper Cable J9281D
Aruba 10G SFP+ to SFP+ 3m Direct Attach Copper Cable J9283D
HPE X242 10G SFP+ to SFP+ 1m Direct Attach Copper Cable J9281B
HPE X242 10G SFP+ to SFP+ 3m Direct Attach Copper Cable J9283B
   

Cables  

   
Console Cables  
   
(std 0 // max 99) User Selection (min 0 // max 99) per switch
   
Aruba X2C2 RJ45 to DB9 Console Cable JL448A
   
   
Multi-Mode Cables  
   
(std 0 // max 99) User Selection (min 0 // max 99) per switch
   
HPE LC to LC Multi-mode OM3 2-Fiber 0.5m 1-Pack Fiber Optic Cable AJ833A
   
HPE LC to LC Multi-mode OM3 2-Fiber 1.0m 1-Pack Fiber Optic Cable AJ834A
   
HPE LC to LC Multi-mode OM3 2-Fiber 2.0m 1-Pack Fiber Optic Cable AJ835A
   
HPE LC to LC Multi-mode OM3 2-Fiber 5.0m 1-Pack Fiber Optic Cable AJ836A
   
HPE LC to LC Multi-mode OM3 2-Fiber 15.0m 1-Pack Fiber Optic Cable AJ837A
   
HPE LC to LC Multi-mode OM3 2-Fiber 30.0m 1-Pack Fiber Optic Cable AJ838A
   
HPE LC to LC Multi-mode OM3 2-Fiber 50.0m 1-Pack Fiber Optic Cable AJ839A
   
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 1m Cable QK732A
   
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 2m Cable QK733A
   
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 5m Cable QK734A
   
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 15m Cable QK735A
   
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 30m Cable QK736A
   
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 50m Cable QK737A
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Switch Enclosure Options  

     
Mounting Kit  
   
(std 0 // max 1) User Selection (min 0 // max 1) per switch  
   
HPE X410 1U Universal 4-post Rackmount Kit J9583A
  See Configuration

NOTE: 1, 2
   
Configuration Rules:  
NOTE 1 If this Mounting Kit is order with #0D1 then it integrates to the HPE Universal Rack.  (not the

switch)
   
NOTE 2 This Rack Mount Kit is not compatible with JL258A
   
Accessories
   
For JL258A System (std 0 // max 1) User Selection (min 0 // max 1) per switch  
   
Aruba 2930F 8-port Cable Guard JL311A
   
Aruba 2930F 8-port Power Shelf JL312A
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Aruba 2930F 24G 4SFP+ Switch (JL253A)

I/O ports and slots 24 RJ-45 autosensing 10/100/1000 ports (IEEE 802.3 Type 10BASE-T, IEEE
802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T)
Duplex: 10BASE-T/100BASE-TX: half or full; 1000BASE-T: full only
4 SFP+ 1/10GbE ports; PHY-less

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 17.42(w) x 7.88(d) x 1.73(h) in (44.25 x 20.02 x 4.39 cm)
(1U height)

Weight 5.31 lb (2.41 kg)

Memory and processor Dual Core ARM Coretex A9 @ 1016 MHz, 1 GB DDR3 SDRAM; Packet buffer
size: 12.38 MB 4.5MB Ingress/7.875MB Egress, 4 GB eMMC

Performance 1000 Mb Latency < 3.8 µs (64-byte packets)

10 Gbps Latency < 1.6 µs (64-byte packets)

Throughput up to 95.2 Mpps

Switching capacity 128 Gbps

Routing table size 2,000 IPv4, 1,000 IPv6 in hardware, 200 OSPF, 256
Static, 10,000 RIP

MAC address table
size

32768 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C); up to 5000 Feet, - 0C to
40C (32F to 104F) up to 10000 Feet

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C); up to 15000 Feet

Nonoperating/Storage
temperature

15% to 95% @ 149°F (65°C), noncondensing

Acoustic Power: 49.7 dB, Pressure: 37.1 dB

Airflow direction Side-to-side

Electrical
characteristics

Maximum heat
dissipation

100 BTU/hr (105.5 kJ/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current 0.6/0.4 A

Maximum power
rating

29.3 W

Idle power 19.5 W

Frequency 50/60 Hz

Notes Idle power is the actual power consumption of the device
with no ports connected..
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided
for planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all
modules populated..
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Safety UL 60950-1, 2nd Edition; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; IEC 60950-1:2005 +A1:2009 +A2:2013; CSA 22.2 No.
60950-1-07 2nd; EN 60825-1:2014 / IEC 60825-1:2014 Class 1

Emissions EN 55032:2012/CISPR 32 Class A; FCC CFR 47 Part 15 Class A; VCCI Class A;
ICES-003 Class A; CNS 13438

Immunity Generic EN 55024:2010/CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

  Harmonics IEC/EN 61000-3-2

  Flicker IEC/EN 61000-3-3

Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; SNMP manager;
Telnet; RMON1; FTP; Out-of-band management (serial RS-232C or micro USB)

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the service-level descriptions and
product numbers. For details about services and response times in your area, please contact
your local Hewlett Packard Enterprise sales office.

Aruba 2930F 48G 4SFP+ Switch (JL254A)
I/O ports and slots 48 RJ-45 autosensing 10/100/1000 ports (IEEE 802.3 Type 10BASE-T, IEEE

802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T); Duplex: 10BASE-
T/100BASE-TX: half or full; 1000BASE-T: full only
4 SFP+ 1/10GbE ports; PHY-less

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 17.42(w) x 9.7(d) x 1.73(h) in (44.25 x 24.63 x 4.39 cm)
(1U height)

Weight 6.83 lb (3.10 kg)

Memory and processor Dual Core ARM Coretex @ 1016 MHz, 1 GB DDR3 SDRAM; Packet buffer size:
12.38 MB 4.5MB Ingress/7.875MB Egress, 4 GB eMMC

Performance 1000 Mb Latency < 3.8 µs (64-byte packets)

10 Gbps Latency < 1.6 µs (64-byte packets)

Throughput up to 112.0 Mpps

Switching capacity 176 Gbps

Routing table size 2,000 IPv4, 1,000 IPv6 in hardware, 200 OSPF, 256
Static, 10,000 RIP

MAC address table
size

32768 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C); up to 5000 Feet, - 0C to
40C (32F to 104F) up to 10000 Feet
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Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C); up to 15000 Feet

Nonoperating/Storage
temperature

15% to 95% @ 149°F (65°C), noncondensing

Acoustic Power: 54.1 dB, Pressure: 40.2 dB

Airflow direction Side-to-side

Electrical
characteristics

Maximum heat
dissipation

157.2 BTU/hr (165.8 KJ/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current 0.9/0.6 A

Maximum power
rating

46.6 W

Idle power 32.7 W

Frequency 50/60 Hz

Notes Idle power is the actual power consumption of the device
with no ports connected..
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided
for planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all
modules populated..

Safety UL 60950-1, 2nd Edition; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; IEC 60950-1:2005 +A1:2009 +A2:2013; CSA 22.2 No.
60950-1-07 2nd; EN 60825-1:2014 / IEC 60825-1:2014 Class 1

Emissions EN 55032:2012/CISPR 32 Class A; FCC CFR 47 Part 15 Class A; VCCI Class A;
ICES-003 Class A; CNS 13438

Immunity Generic EN 55024:2010/CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

  Harmonics IEC/EN 61000-3-2

  Flicker IEC/EN 61000-3-3

Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; SNMP manager;
Telnet; RMON1; FTP; Out-of-band management (serial RS-232C or micro USB)

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the service-level descriptions and
product numbers. For details about services and response times in your area, please contact
your local Hewlett Packard Enterprise sales office.
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Aruba 2930F 24G PoE+ 4SFP+ Switch (JL255A)
I/O ports and slots 24 RJ-45 autosensing 10/100/1000 PoE+ ports (IEEE 802.3 Type 10BASE-T,

IEEE 802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T, IEEE 802.3at
PoE+); Duplex: 10BASE-T/100BASE-TX: half or full; 1000BASE-T: full only
4 SFP+ 1/10GbE ports; PHY-less

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 17.42(w) x 11.98(d) x 1.73(h) in (44.25 x 30.42 x 4.39 cm)
(1U height)

Weight 8.6 lb (3.9 kg)

Memory and processor Dual Core ARM Coretex @ 1016 MHz, 1 GB DDR3 SDRAM; Packet buffer size:
12.38 MB 4.5 MB Ingress/7.875MB Egress, 4 GB eMMC

Performance 1000 Mb Latency < 3.8 µs (64-byte packets)

10 Gbps Latency < 1.6 µs (64-byte packets)

Throughput up to 95.2 Mpps

Switching capacity 128 Gbps

Routing table size 2,000 IPv4, 1,000 IPv6 in hardware, 200 OSPF, 256
Static, 10,000 RIP

MAC address table
size

32768 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C); up to 5000 Feet, - 0C to
40C (32F to 104F) up to 10000 Feet

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C); up to 15000 Feet

Nonoperating/Storage
temperature

15% to 95% @ 149°F (65°C), noncondensing

Acoustic Power: 54.1 dB, Pressure: 40.2 dB

Airflow direction Side-to-side

Electrical
characteristics

80plus.org
Certification

Silver

Maximum heat
dissipation

258.0 BTU/hr (272.2 KJ/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current 4.9/2.4 A

Maximum power
rating

445 W

Idle power 36.8 W

PoE power 370 W PoE+

Frequency 50/60 Hz

Notes Idle power is the actual power consumption of the device
with no ports connected..
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided
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for planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all
modules populated..

Safety UL 60950-1 2nd Edition; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; IEC 60950-1:2005 +A1:2009 +A2:2013; CSA 22.2 No.
60950-1-07 2nd; EN 60825-1:2014 / IEC 60825-1:2014 Class 1

Emissions EN 55032:2012/CISPR 32 Class A; FCC CFR 47 Part 15 Class A; VCCI Class A;
ICES-003 Class A; CNS 13438

Immunity Generic EN 55024:2010/CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

  Harmonics IEC/EN 61000-3-2

  Flicker IEC/EN 61000-3-3

Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; SNMP manager;
Telnet; RMON1; FTP; Out-of-band management (serial RS-232C or micro USB)

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the service-level descriptions and
product numbers. For details about services and response times in your area, please contact
your local Hewlett Packard Enterprise sales office.

Aruba 2930F 48G PoE+ 4SFP+ Switch (JL256A)
I/O ports and slots 48 RJ-45 autosensing 10/100/1000 PoE+ ports (IEEE 802.3 Type 10BASE-T,

IEEE 802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T, IEEE 802.3at
PoE+); Duplex: 10BASE-T/100BASE-TX: half or full; 1000BASE-T: full only
4 SFP+ 1/10GbE ports; PHY-less

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 17.42(w) x 11.98(d) x 1.73(h) in (44.25 x 30.42 x 4.39 cm)
(1U height)

Weight 9.83 lb (4.46 kg)

Memory and processor Dual Core ARM Coretex @ 1016 MHz, 1 GB DDR3 SDRAM; Packet buffer size:
12.38 MB 4.5MB Ingress/7.875MB Egress, 4 GB eMMC

Performance 1000 Mb Latency < 3.8 µs (64-byte packets)

10 Gbps Latency < 1.6 µs (64-byte packets)

Throughput up to 112.0 Mpps

Switching capacity 176 Gbps

Routing table size 2,000 IPv4, 1,000 IPv6 in hardware, 200 OSPF, 256
Static, 10,000 RIP
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MAC address table
size

32768 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C); up to 5000 Feet, - 0C to
40C (32F to 104F) up to 10000 Feet

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C); up to 15000 Feet

Nonoperating/Storage
temperature

15% to 95% @ 149°F (65°C), noncondensing

Acoustic Power: 55.7 dB, Pressure: 41.7 dB

Airflow direction Side-to-side

Electrical
characteristics

80plus.org
Certification

Silver

Maximum heat
dissipation

293.0 BTU/hr (309.1 kJ/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current 5.1/2.5 A

Maximum power
rating

459 W

Idle power 48.6 W

PoE power 370 W PoE+

Frequency 50/60 Hz

Notes Idle power is the actual power consumption of the device
with no ports connected..
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided
for planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all
modules populated..

Safety UL 60950-1 2nd Edition; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; IEC 60950-1:2005 +A1:2009 +A2:2013; CSA 22.2 No.
60950-1-07 2nd; EN 60825-1:2014 / IEC 60825-1:2014 Class 1

Emissions EN 55032:2012/CISPR 32 Class A; FCC CFR 47 Part 15 Class A; VCCI Class A;
ICES-003 Class A; CNS 13438

Immunity Generic EN 55024:2010/CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

  Harmonics IEC/EN 61000-3-2
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  Flicker IEC/EN 61000-3-3

Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; SNMP manager;
Telnet; RMON1; FTP; Out-of-band management (serial RS-232C or micro USB)

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the service-level descriptions and
product numbers. For details about services and response times in your area, please contact
your local Hewlett Packard Enterprise sales office.

Aruba 2930F 8G PoE+ 2SFP+ Switch (JL258A)
I/O ports and slots 8 RJ-45 autosensing 10/100/1000 PoE+ ports (IEEE 802.3 Type 10BASE-T, IEEE

802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T, IEEE 802.3at
PoE+); Duplex: 10BASE-T/100BASE-TX: half or full; 1000BASE-T: full only
2 SFP+ 1/10GbE ports; PHY-less

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 10(w) x 10(d) x 1.73(h) in (25.4 x 25.4 x 4.39 cm) (1U
height)

Weight 4.41 lb (2.0 kg)

Memory and processor Dual Core ARM Coretex A9 @ 1016 MHz, 1 GB DDR3 SDRAM; Packet buffer
size: 12.38 MB 4.5MB Ingress/7.785 Egress, 4 GB eMMC

Performance 1000 Mb Latency < 3.8 µs (64-byte packets)

10 Gbps Latency < 1.6 µs (64-byte packets)

Throughput up to 41.7 Mpps

Switching capacity 56 Gbps

Routing table size 2,000 IPv4, 1,000 IPv6 in hardware, 200 OSPF, 256
Static, 10,000 RIP

MAC address table
size

32768 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C); up to 5000 Feet, - 0C to
40C (32F to 104F) up to 10000 Feet

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C); up to 15000 Feet

Nonoperating/Storage
temperature

15% to 95% @ 149°F (65°C), noncondensing

Acoustic Power: 0 dB, Pressure: 0 dB Fanless

Electrical
characteristics

Description Power supply meets DoE VI certification.

Maximum heat
dissipation

58.6 BTU/hr (61.8 kJ/hr)

Voltage 90 - 264 VAC, rated

Current 2.6 A

Maximum power
rating

155 W

PoE power 125 W PoE+
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Frequency 50/60 Hz

Notes Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided
for planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all
modules populated.
PoE Power is the power supplied by the internal power
supply, it is dependent on the type and quantity of power
supplies and may be supplemented with the use of a
External Power Supply (EPS).

Safety UL 60950-1 2nd Edition; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; IEC 60950-1:2005 +A1:2009 +A2:2013; CSA 22.2 No.
60950-1-07 2nd; EN 60825-1:2014 / IEC 60825-1:2014 Class 1

Emissions EN 55032:2012/CISPR 32 Class A; FCC CFR 47 Part 15 Class A; VCCI Class A;
ICES-003 Class A; CNS 13438

Immunity Generic EN 55024:2010/CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

  Harmonics IEC/EN 61000-3-2

  Flicker IEC/EN 61000-3-3

Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; SNMP manager;
Telnet; RMON1; FTP; Out-of-band management (serial RS-232C or micro USB)

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the service-level descriptions and
product numbers. For details about services and response times in your area, please contact
your local Hewlett Packard Enterprise sales office.

Aruba 2930F 24G 4SFP Switch (JL259A)
I/O ports and slots 24 RJ-45 autosensing 10/100/1000 ports (IEEE 802.3 Type 10BASE-T, IEEE

802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T); Duplex: 10BASE-
T/100BASE-TX: half or full; 1000BASE-T: full only
4 SFP

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 17.42(w) x 7.88(d) x 1.73(h) in (44.25 x 20.02 x 4.39 cm)
(1U height)

Weight 5.31 lb (2.41 kg)

Memory and processor Dual Core ARM Coretex A9 @ 1016 MHz, 1 GB DDR3 SDRAM; Packet buffer
size: 12.38 MB 4.5MB Ingress/7.785 Egress, 4 GB eMMC

Performance 1000 Mb Latency < 3.8 µs (64-byte packets)
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Throughput up to 41.7 Mpps

Switching capacity 56 Gbps

Routing table size 2,000 IPv4, 1,000 IPv6 in hardware, 200 OSPF, 256
Static, 10,000 RIP

MAC address table
size

32768 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C); up to 5000 Feet, - 0C to
40C (32F to 104F) up to 10000 Feet

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C); up to 15000 Feet

Nonoperating/Storage
temperature

15% to 95% @ 149°F (65°C), noncondensing

Acoustic Power: 49.7 dB, Pressure: 37.1 dB

Airflow direction Side-to-side

Electrical
characteristics

Maximum heat
dissipation

100 BTU/hr (105.5 kJ/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current 0.6/0.4 A

Maximum power
rating

29.3 W

Idle power 19.5 W

Frequency 50/60 Hz

Notes Idle power is the actual power consumption of the device
with no ports connected.
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided
for planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all
modules populated.

Safety UL 60950-1 2nd Edition; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; IEC 60950-1:2005 +A1:2009 +A2:2013; CSA 22.2 No.
60950-1-07 2nd; EN 60825-1:2014 / IEC 60825-1:2014 Class 1

Emissions EN 55032:2012/CISPR 32 Class A; FCC CFR 47 Part 15 Class A; VCCI Class A;
ICES-003 Class A; CNS 13438

Immunity Generic EN 55024:2010/CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11
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  Harmonics IEC/EN 61000-3-2

  Flicker IEC/EN 61000-3-3

Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; SNMP manager;
Telnet; RMON1; FTP; Out-of-band management (serial RS-232C or micro USB)

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the service-level descriptions and
product numbers. For details about services and response times in your area, please contact
your local Hewlett Packard Enterprise sales office.

Aruba 2930F 48G 4SFP Switch (JL260A)
I/O ports and slots 48 RJ-45 autosensing 10/100/1000 ports (IEEE 802.3 Type 10BASE-T, IEEE

802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T); Duplex: 10BASE-
T/100BASE-TX: half or full; 1000BASE-T: full only
4 SFP

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 17.42(w) x 9.7(d) x 1.73(h) in (44.25 x 24.63 x 4.39 cm)
(1U height)

Weight 6.83 lb (3.10 kg)

Memory and processor Dual Core ARM Coretex @ 1016 MHz, 1 GB DDR3 SDRAM; Packet buffer size:
12.38 MB 4.5MB Ingress/7.875MB Egress, 4 GB eMMC

Performance 1000 Mb Latency < 3.8 µs (64-byte packets)

Throughput up to 77.4 Mpps

Switching capacity 104 Gbps

Routing table size 2,000 IPv4, 1,000 IPv6 in hardware, 200 OSPF, 256
Static, 10,000 RIP

MAC address table
size

32768 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C); up to 5000 Feet, - 0C to
40C (32F to 104F) up to 10000 Feet

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C); up to 15000 Feet

Nonoperating/Storage
temperature

15% to 95% @ 149°F (65°C), noncondensing

Acoustic Power: 54.1 dB, Pressure: 40.2 dB

Airflow direction Side-to-side

Electrical
characteristics

Maximum heat
dissipation

100.0 BTU/hr (105.5 kJ/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current 0.9/0.6 A

Maximum power
rating

46.6 W

Idle power 32.7 W
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Frequency 50/60 Hz

Notes Idle power is the actual power consumption of the device
with no ports connected.
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided
for planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all
modules populated.

Safety UL 60950-1, 2nd Edition; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; IEC 60950-1:2005 +A1:2009 +A2:2013; CSA 22.2 No.
60950-1-07 2nd; EN 60825-1:2014 / IEC 60825-1:2014 Class 1

Emissions EN 55032:2012/CISPR 32 Class A; FCC CFR 47 Part 15 Class A; VCCI Class A;
ICES-003 Class A; CNS 13438

Immunity Generic EN 55024:2010/CISPR 24

ESD IEC 61000-4-2:

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

  Harmonics IEC/EN 61000-3-2

 
Flicker IEC/EN 61000-3-3

Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; SNMP manager;
Telnet; RMON1; FTP; Out-of-band management (serial RS-232C or micro USB)

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the service-level descriptions and
product numbers. For details about services and response times in your area, please contact
your local Hewlett Packard Enterprise sales office.

Aruba 2930F 24G PoE+ 4SFP Switch (JL261A)
I/O ports and slots 24 RJ-45 autosensing 10/100/1000 PoE+ ports (IEEE 802.3 Type 10BASE-T,

IEEE 802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T, IEEE 802.3at
PoE+); Duplex: 10BASE-T/100BASE-TX: half or full; 1000BASE-T: full only
4 SFP

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 17.42(w) x 11.98(d) x 1.73(h) in (44.25 x 30.42 x 4.39 cm)
(1U height)

Weight 8.6 lb (3.9 kg)

Memory and processor Dual Core ARM Coretex A9 @ 1016 MHz, 1 GB DDR3 SDRAM; Packet buffer
size: 12.38 MB 4.5MB Ingress/7.785 Egress, 4 GB eMMC

Performance 1000 Mb Latency < 3.8 µs (64-byte packets)
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Throughput up to 41.7 Mpps

Switching capacity 56 Gbps

Routing table size 2,000 IPv4, 1,000 IPv6 in hardware, 200 OSPF, 256
Static, 10,000 RIP

MAC address table
size

32768 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C); up to 5000 Feet, - 0C to
40C (32F to 104F) up to 10000 Feet

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C); up to 15000 Feet

Nonoperating/Storage
temperature

15% to 95% @ 149°F (65°C)

Acoustic Power: 54.1 dB, Pressure: 40.6 dB

Airflow direction Side-to-side

Electrical
characteristics

80plus.org
Certification

Silver

Maximum heat
dissipation

258.0 BTU/hr (272.2 kJ/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current 4.9/2.4 A

Maximum power
rating

445 W

Idle power 36.8 W

PoE power 370 W PoE+

Frequency 50/60 Hz

Notes Idle power is the actual power consumption of the device
with no ports connected.
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided
for planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all
modules populated.

Safety UL 60950-1 2nd Edition; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; IEC 60950-1:2005 +A1:2009 +A2:2013; CSA 22.2 No.
60950-1-07 2nd; EN 60825-1:2014 / IEC 60825-1:2014 Class 1

Emissions EN 55032:2012/CISPR 32 Class A; FCC CFR 47 Part 15 Class A; VCCI Class A;
ICES-003 Class A; CNS 13438

Immunity Generic EN 55024:2010/CISPR 24

ESD IEC 61000-4-2:

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6
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Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

  Harmonics IEC/EN 61000-3-2

  Flicker IEC/EN 61000-3-3

Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; SNMP manager;
Telnet; RMON1; FTP; Out-of-band management (serial RS-232C or micro USB)

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the service-level descriptions and
product numbers. For details about services and response times in your area, please contact
your local Hewlett Packard Enterprise sales office.

Aruba 2930F 48G PoE+ 4SFP Switch (JL262A)
I/O ports and slots 48 RJ-45 autosensing 10/100/1000 PoE+ ports (IEEE 802.3 Type 10BASE-T,

IEEE 802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T, IEEE 802.3at
PoE+); Duplex: 10BASE-T/100BASE-TX: half or full; 1000BASE-T: full only
4 SFP

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 17.42(w) x 11.98(d) x 1.73(h) in (44.25 x 30.42 x 4.39 cm)
(1U height)

Weight 9.83 lb (4.46 kg)

Memory and processor Dual Core ARM Coretex @ 1016 MHz, 1 GB DDR3 SDRAM; Packet buffer size:
12.38 MB 4.5MB Ingress/7.875MB Egress, 4 GB eMMC

Performance 1000 Mb Latency < 3.8 µs (64-byte packets)

Throughput up to 77.4 Mpps

Switching capacity 104 Gbps

Routing table size 2,000 IPv4, 1,000 IPv6 in hardware, 200 OSPF, 256
Static, 10,000 RIP

MAC address table
size

32768 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C); up to 5000 Feet, - 0C to
40C (32F to 104F) up to 10000 Feet

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C); up to 15000 Feet

Nonoperating/Storage
temperature

15% to 95% @ 149°F (65°C)

Acoustic Power: 55.7 dB, Pressure: 41.7 dB

Airflow direction Side-to-side

Electrical
characteristics

80plus.org
Certification

Silver

QuickSpecs Aruba 2930F Switch Series

Technical Specifications

DA - 15576   Worldwide QuickSpecs — Version 10 — 12/3/2018 Page  33

Anexo 01 ITENS 8 E 9 (0592696)         SEI 0008478-63.2018.6.02.8000 / pg. 6361

http://www.hpe.com/networking/services


Maximum heat
dissipation

293.0 BTU/hr (309.1 kJ/hr)

Voltage 100 - 127 / 200 - 240 VAC, rated

Current 5.1/2.5 A

Maximum power
rating

459 W

Idle power 48.6 W

PoE power 370 W PoE+

Frequency 50/60 Hz

Notes Idle power is the actual power consumption of the device
with no ports connected.
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided
for planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all
modules populated.

Safety UL 60950-1 2nd Edition; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; IEC 60950-1:2005 +A1:2009 +A2:2013; CSA 22.2 No.
60950-1-07 2nd; EN 60825-1:2014 / IEC 60825-1:2014 Class 1

Emissions EN 55032:2012/CISPR 32 Class A; FCC CFR 47 Part 15 Class A; VCCI Class A;
ICES-003 Class A; CNS 13438

Immunity Generic EN 55024:2010/CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

  Harmonics IEC/EN 61000-3-2

  Flicker IEC/EN 61000-3-3

Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; SNMP manager;
Telnet; RMON1; FTP; Out-of-band management (serial RS-232C or micro USB)

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the service-level descriptions and
product numbers. For details about services and response times in your area, please contact
your local Hewlett Packard Enterprise sales office.

 
Aruba 2930F 24G PoE+ 4SFP+ TAA-compliant Switch (JL263A)
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I/O ports and slots 24 RJ-45 autosensing 10/100/1000 PoE+ ports (IEEE 802.3 Type 10BASE-T,
IEEE 802.3u Type 100BASETX, IEEE 802.3ab Type 1000BASE-T, IEEE 802.3at
PoE+); Duplex: 10BASE-T/100BASE-TX: half or full; 1000BASE-T: full only
4 SFP+ 1/10GbE ports
PHY-less

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 17.42(w) x 11.98(d) x 1.73(h) in. (44.25 x 30.42 x 4.39
cm) (1U height)

Weight 8.6 lb (3.9 kg)

Memory and processor Dual Core ARM® Cortex A9 @ 1016 MHz, 1 GB DDR3 SDRAM; Packet buffer
size: 12.38 MB; 4.5 MB Ingress/7.785 MB Egress, 4 GB eMMC

Performance 1000 Mb Latency < 3.8 µs (64-byte packets)

10 Gbps Latency < 1.6 µs (64-byte packets)

Throughput Up to 95.2 Mpps

Switching capacity 128 Gbps

Routing table size 2,000 IPv4, 1,000 IPv6 in hardware, 200 OSPF, 256
Static, 10,000 RIP

MAC address table
size

32,768 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C); up to 5000 Feet, -0°C to
40°C (32°F to 104°F) up to 10000 Feet

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C); up to 15000 Feet

Nonoperating/Storage
temperature

15% to 95% @ 149°F (65°C)

Acoustic Power: 54.1 dB, Pressure: 40.6 dB

Airflow direction Side-to-side

Electrical
characteristics

80plus.org
Certification

Silver

Maximum heat
dissipation

258.0 BTU/hr (272.2kJ/hr)

Voltage 100-127 / 200-240 VAC, rated

Current 4.9/2.4 A

Maximum power
rating

445 W

Idle power 36.8 W

PoE power 370 W PoE+

Frequency 50/60 Hz

Notes Idle power is the actual power consumption of the device
with no ports connected.
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided
for planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all
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modules populated.
Safety UL 69050-1: 2nd Edition; EN 60950-1:2006 +A11:2009 +A1:2010

+A12:2011+A2:2013; IEC 60950-1:2005 +A1:2009 +A2:2013; CSA 22.2 No.
60950-1-07 2nd; EN 60825-1:2014 / IEC 60825-1:2014 Class 1

Emissions EN 55032:2012/CISPR 32 Class A; FCC CFR 47 Part 15 Class A; VCCI Class A;
ICES-003 Class A; CNS 13438

Immunity Generic EN 55024:2010/CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

  Harmonics IEC/EN 61000-3-2

  Flicker IEC/EN 61000-3-3

Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; SNMP manager;
Telnet; RMON1; FTP; Out-of-band management (serial RS-232C or micro USB)

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the service-level descriptions and
product numbers. For details about services and response times in your area, please contact
your local Hewlett Packard Enterprise sales office.

 
Aruba 2930F 48G PoE+ 4SFP+ TAA-compliant Switch (JL264A)
I/O ports and slots 48 RJ-45 autosensing 10/100/1000 PoE+ ports (IEEE 802.3 Type 10BASE-T,

IEEE 802.3u Type 100BASETX, IEEE 802.3ab Type 1000BASE-T, IEEE 802.3at
PoE+); Duplex: 10BASE-T/100BASE-TX: half or full; 1000BASE-T: full only
4 SFP+ 1/10GbE ports
PHY-less

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 17.42(w) x 11.98(d) x 1.73(h) in. (44.25 x 30.42 x 4.39
cm) (1U height)

Weight 9.83 lb (4.46 kg)

Memory and processor Dual Core ARM® Cortex A9 @ 1016 MHz, 1 GB DDR3 SDRAM; Packet buffer
size: 12.38 MB; 4.5 MB Ingress/7.785 MB Egress, 4 GB eMMC

Performance 1000 Mb Latency < 3.8 µs (64-byte packets)

10 Gbps Latency < 1.6 µs (64-byte packets)

Throughput Up to 112.0 Mpps

Switching capacity 176 Gbps

Routing table size 2,000 IPv4, 1,000 IPv6 in hardware, 200 OSPF, 256
Static, 10,000 RIP
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MAC address table
size

32,768 entries

Environment Operating
temperature

32°F to 113°F (0°C to 45°C); up to 5000 Feet, -0°C to
40°C (32°F to 104°F) up to 10000 Feet

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C); up to 15000 Feet

Nonoperating/Storage
temperature

15% to 95% @ 149°F (65°C)

Acoustic Power: 55.7 dB, Pressure: 41.7 dB

Airflow direction Side-to-side

Electrical
characteristics

80plus.org
Certification

Silver

Maximum heat
dissipation

293.0 BTU/hr (309.1 kJ/hr)

Voltage 100-127 / 200-240 VAC, rated

Current 5.1/2.5 A

Maximum power
rating

459 W

Idle power 48.6 W

PoE power 370 W PoE+

Frequency 50/60 Hz

Notes Idle power is the actual power consumption of the device
with no ports connected.
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided
for planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all
modules populated.

Safety UL 69050-1: 2nd Edition; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; IEC 60950-1:2005 +A1:2009 +A2:2013; CSA 22.2 No.
60950-1-07 2nd; EN 60825-1:2014 / IEC 60825-1:2014 Class 1

Emissions EN 55032:2012/CISPR 32 Class A; FCC CFR 47 Part 15 Class A; VCCI Class A;
ICES-003 Class A; CNS 13438

Immunity Generic EN 55024:2010/CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

  Harmonics IEC/EN 61000-3-2
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  Flicker IEC/EN 61000-3-3

Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; SNMP manager;
Telnet; RMON1; FTP; Out-of-band management (serial RS-232C or micro USB)

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the service-level descriptions and
product numbers. For details about services and response times in your area, please contact
your local Hewlett Packard Enterprise sales office.

 
Aruba 2930F 48G PoE+ 4SFP 740W Switch (JL557A)
I/O ports and slots 48 RJ-45 autosensing 10/100/1000 PoE+ ports (IEEE 802.3 Type 10BASE-T,

IEEE 802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T, IEEE 802.3at
PoE+); Duplex: 10BASE-T/100BASE-TX: half or full; 1000BASE-T: full only
4 SFP+

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 17.42 (w) x 12.77 (d) x 1.73 (h) in
(44.25 x 32.42 x 4.39 cm)
(1U height)

Weight 10.56 lb (4.79 kg)

Memory and processor Dual Core ARM Coretex A9 @ 1016 MHz, 1 GB DDR3 SDRAM; Packet buffer
size: 12.38 MB 4.5MB Ingress/7.785 Egress,4 GB eMMC

Performance 1000 Mb Latency < 3.8 µs (64-byte packets)

Throughput up to 77.4 Mpps

Switching capacity 104 Gbps

Routing table size 2,000 IPv4, 1,000 IPv6 in hardware, 200 OSPF, 256
Static, 10,000 RIP

MAC address table
size

32,768

Environment Operating
temperature

32°F to 113°F (0°C to 45°C);
up to 5,000 Feet,
0°C to 40°C (32°F to 104°F)
up to 10,000 Feet

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C); up to 15,000 Feet

Nonoperating/Storage
temperature

15% to 95% @ 149°F (65°C)

Acoustic (power and
pressure) in decibals

Power: 55.1 dB, Pressure: 41.1 dB

Airflow direction Side to side

Electrical
characteristics

80plus.org
Certification

Gold

Maximum heat
dissipation

420.9 BTU/hr (444.1 kJ/hr)

Voltage 100-127 / 200-240 VAC, rated
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Current 9.2 / 4.9 A

Maximum power
rating

980W

Idle power 49.9W

PoE power 740 W PoE+

Frequency 50/60 Hz

Notes Idle power is the actual power consumption of the device
with no ports connected.
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided
for planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all
modules populated.

Safety UL 69050-1: 2nd Edition; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; IEC 60950- 1:2005 +A1:2009 +A2:2013; CSA 22.2 No.
60950-1-07 2nd; EN 60825- 1:2014 / IEC 60825-1:2014 Class 1

Emissions EN 55032:2012/CISPR 32 Class A; FCC CFR 47 Part 15 Class A; VCCI Class A;
ICES-003 Class A; CNS 13438

Immunity Generic EN 55024:2010/CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

  Harmonics IEC/EN 61000-3-2

  Flicker IEC/EN 61000-3-3

Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; SNMP manager;
Telnet; RMON1; FTP; Out-of-band management (serial RS-232C or micro USB)

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the service-level descriptions and
product numbers. For details about services and response times in your area, please contact
your local Hewlett Packard Enterprise sales office.

 
Aruba 2930F 48G PoE+ 4SFP+ 740W Switch (JL558A)
I/O ports and slots 48 RJ-45 autosensing 10/100/1000 PoE+ ports (IEEE 802.3 Type 10BASE-T,

IEEE 802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T, IEEE 802.3at
PoE+); Duplex: 10BASE-T/100BASE-TX: half or full; 1000BASE-T: full only
4 SFP+ 1/10GbE ports
PHY-less

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port
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Physical
characteristics

Dimensions 17.42 (w) x 12.77 (d) x 1.73 (h) in
(44.25 x 32.42 x 4.39 cm)
(1U height)

Weight 10.56 lb (4.79 kg)

Memory and processor Dual Core ARM Coretex A9 @ 1016 MHz, 1 GB DDR3 SDRAM; Packet buffer
size: 12.38 MB 4.5MB Ingress/7.785 Egress,4 GB eMMC

Performance 1000 Mb Latency < 3.8 µs (64-byte packets)

10Gbps latency < 1.6 µs (64-byte packets)

Throughput up to 112.0 Mpps

Switching capacity 176 Gbps

Routing table size 2,000 IPv4, 1,000 IPv6 in hardware, 200 OSPF, 256
Static, 10,000 RIP

MAC address table
size

32,768

Environment Operating
temperature

32°F to 113°F (0°C to 45°C);
up to 5,000 Feet,
0°C to 40°C (32°F to 104°F)
up to 10,000 Feet

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C); up to 15,000 Feet

Nonoperating/Storage
temperature

15% to 95% @ 149°F (65°C)

Acoustic (power and
pressure) in decibals

Power: 55.1 dB, Pressure: 41.1 dB

Airflow direction Side to side

Electrical
characteristics

80plus.org
Certification

Gold

Maximum heat
dissipation

420.9 BTU/hr (444.1 kJ/hr)

Voltage 100-127 / 200-240 VAC, rated

Current 9.2 / 4.9 A

Maximum power
rating

980W

Idle power 49.9W

PoE power 740 W PoE+

Frequency 50/60 Hz

Notes Idle power is the actual power consumption of the device
with no ports connected.
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided
for planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all
modules populated.
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Safety UL 69050-1: 2nd Edition; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; IEC 60950- 1:2005 +A1:2009 +A2:2013; CSA 22.2 No.
60950-1-07 2nd; EN 60825- 1:2014 / IEC 60825-1:2014 Class 1

Emissions EN 55032:2012/CISPR 32 Class A; FCC CFR 47 Part 15 Class A; VCCI Class A;
ICES-003 Class A; CNS 13438

Immunity Generic EN 55024:2010/CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8

Voltage dips and
interruptions

IEC 61000-4-11

  Harmonics IEC/EN 61000-3-2

  Flicker IEC/EN 61000-3-3

Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; SNMP manager;
Telnet; RMON1; FTP; Out-of-band management (serial RS-232C or micro USB)

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the service-level descriptions and
product numbers. For details about services and response times in your area, please contact
your local Hewlett Packard Enterprise sales office.

 
Aruba 2930F 48G PoE+ 4SFP+ 740W TAA-compliant Switch (JL559A)
I/O ports and slots 48 RJ-45 autosensing 10/100/1000 PoE+ ports (IEEE 802.3 Type 10BASE-T,

IEEE 802.3u Type 100BASE-TX, IEEE 802.3ab Type 1000BASE-T, IEEE 802.3at
PoE+); Duplex: 10BASE-T/100BASE-TX: half or full; 1000BASE-T: full only
4 SFP+ 1/10GbE ports
PHY-less

Additional ports and
slots

1 dual-personality (RJ-45 or USB micro-B) serial console port

Physical
characteristics

Dimensions 17.42 (w) x 12.77 (d) x 1.73 (h) in
(44.25 x 32.42 x 4.39 cm)
(1U height)

Weight 10.56 lb (4.79 kg)

Memory and processor Dual Core ARM Coretex A9 @ 1016 MHz, 1 GB DDR3 SDRAM; Packet buffer
size: 12.38 MB 4.5MB Ingress/7.785 Egress,4 GB eMMC

Performance 1000 Mb Latency < 3.8 µs (64-byte packets)

10Gbps latency < 1.6 µs (64-byte packets)

Throughput up to 112.0 Mpps

Switching capacity 176 Gbps

Routing table size 2,000 IPv4, 1,000 IPv6 in hardware, 200 OSPF, 256
Static, 10,000 RIP
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MAC address table
size

32,768

Environment Operating
temperature

32°F to 113°F (0°C to 45°C);
up to 5,000 Feet,
0°C to 40°C (32°F to 104°F)
up to 10,000 Feet

Operating relative
humidity

15% to 95% @ 104°F (40°C), noncondensing

Nonoperating/Storage
temperature

-40°F to 158°F (-40°C to 70°C); up to 15,000 Feet

Nonoperating/Storage
temperature

15% to 95% @ 149°F (65°C)

Acoustic (power and
pressure) in decibals

Power: 55.1 dB, Pressure: 41.1 dB

Airflow direction Side to side

Electrical
characteristics

80plus.org
Certification

Gold

Maximum heat
dissipation

420.9 BTU/hr (444.1 kJ/hr)

Voltage 100-127 / 200-240 VAC, rated

Current 9.2 / 4.9 A

Maximum power
rating

980W

Idle power 49.9W

PoE power 740 W PoE+

Frequency 50/60 Hz

Notes Idle power is the actual power consumption of the device
with no ports connected.
Maximum power rating and maximum heat dissipation are
the worst-case theoretical maximum numbers provided
for planning the infrastructure with fully loaded PoE (if
equipped), 100% traffic, all ports plugged in, and all
modules populated.

Safety UL 69050-1: 2nd Edition; EN 60950-1:2006 +A11:2009 +A1:2010
+A12:2011+A2:2013; IEC 60950- 1:2005 +A1:2009 +A2:2013; CSA 22.2 No.
60950-1-07 2nd; EN 60825- 1:2014 / IEC 60825-1:2014 Class 1

Emissions EN 55032:2012/CISPR 32 Class A; FCC CFR 47 Part 15 Class A; VCCI Class A;
ICES-003 Class A; CNS 13438

Immunity Generic EN 55024:2010/CISPR 24

ESD IEC 61000-4-2

Radiated IEC 61000-4-3

EFT/Burst IEC 61000-4-4

Surge IEC 61000-4-5

Conducted IEC 61000-4-6

Power frequency
magnetic field

IEC 61000-4-8
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Voltage dips and
interruptions

IEC 61000-4-11

  Harmonics IEC/EN 61000-3-2

  Flicker IEC/EN 61000-3-3

Management Aruba AirWave Network Management; IMC - Intelligent Management Center;
Command-line interface; Web browser; Configuration menu; SNMP manager;
Telnet; RMON1; FTP; Out-of-band management (serial RS-232C or micro USB)

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the service-level descriptions and
product numbers. For details about services and response times in your area, please contact
your local Hewlett Packard Enterprise sales office.

 
Standards and protocols (applies to all products in series)

Denial of service
protection

CPU DoS Protection

Device Management RFC 1155 Structure and Mgmt Information (SMIv1)
RFC 1157 SNMPv1/v2c
RFC 1591 DNS (client)
RFC 1901 (Community based SNMPv2)
RFC 1901-1907 SNMPv2c, SMIv2 and Revised MIB-II
RFC 1908 (SNMP v1/2 Coexistence)
RFC 2576 (Coexistence between SNMP V1, V2, V3)
RFC 2578-2580 SMIv2
RFC 2579 (SMIv2 Text Conventions)
RFC 2580 (SMIv2 Conformance)
RFC 2819 (RMON groups Alarm, Event, History and Statistics only)
RFC 3416 (SNMP Protocol Operations v2)
RFC 3417 (SNMP Transport Mappings)
HTML and telnet management
HTTP, SSHv1, and Telnet
Multiple Configuration Files
Multiple Software Images
SNMP v3 and RMON RFC support
SSHv1/SSHv2 Secure Shell
TACACS/TACACS+
Web UI

General Protocols IEEE 802.1AX-2008 Link Aggregation
IEEE 802.1D MAC Bridges
IEEE 802.1p Priority
IEEE 802.1Q VLANs
IEEE 802.1s Multiple Spanning Trees
IEEE 802.1v VLAN classification by Protocol and Port
IEEE 802.1w Rapid Reconfiguration of Spanning Tree
IEEE 802.3ab 1000BASE-T
IEEE 802.3ad Link Aggregation Control Protocol (LACP)
IEEE 802.3af Power over Ethernet
IEEE 802.3at PoE+
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IEEE 802.3az Energy Efficient Ethernet
IEEE 802.3x Flow Control
RFC 768 UDP
RFC 783 TFTP Protocol (revision 2)
RFC 792 ICMP
RFC 793 TCP
RFC 826 ARP
RFC 854 TELNET
RFC 868 Time Protocol
RFC 951 BOOTP
RFC 1058 RIPv1
RFC 1256 ICMP Router Discovery Protocol (IRDP)
RFC 1350 TFTP Protocol (revision 2)
RFC 1519 CIDR
RFC 1542 BOOTP Extensions
RFC 1918 Address Allocation for Private Internet
RFC 2030 Simple Network Time Protocol (SNTP) v4
RFC 2131 DHCP
RFC 2236 IGMP Snooping
RFC 2453 RIPv2
RFC 2865 Remote Authentication Dial In User Service (RADIUS)
RFC 2866 RADIUS Accounting
RFC 3046 DHCP Relay Agent Information Option
RFC 3411 An Architecture for Describing Simple Network Management Protocol
(SNMP) Management Frameworks
RFC 3412 Message Processing and Dispatching for the Simple Network
Management Protocol (SNMP)
RFC 3413 Simple Network Management Protocol (SNMP) Applications
RFC 3414 User-based Security Model (USM) for version 3 of the Simple Network
Management Protocol (SNMPv3)
RFC 3415 View-based Access Control Model (VACM) for the Simple Network
Management Protocol (SNMP)
RFC 3416 Protocol Operations for SNMP
RFC 3417 Transport Mappings for the Simple Network Management Protocol
(SNMP)
RFC 3418 Management Information Base (MIB) for the Simple Network
Management Protocol (SNMP)
RFC 3575 IANA Considerations for RADIUS
RFC 3576 Ext to RADIUS (CoA only)
RFC 4541 Considerations for Internet Group Management Protocol (IGMP) and
Multicast Listener Discovery (MLD) Snooping Switches
RFC 4675 RADIUS VLAN & Priority
RFC 4861 Neighbor Discovery for IP version 6 (IPv6)
RFC 4862 IPv6 Stateless Address Autoconfiguration
RFC 5905 Network Time Protocol Version 4: Protocol and Algorithms Specification
UDLD (Uni-directional Link Detection)

IP Multicast RFC 1112 IGMP
RFC 2236 IGMPv2
RFC 2710 Multicast Listener Discovery (MLD) for IPv6
RFC 3376 IGMPv3
RFC 4541 Considerations for Internet Group Management Protocol (IGMP) and
Multicast Listener Discovery (MLD) Snooping Switches
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IPv6 RFC 1981 IPv6 Path MTU Discovery
RFC 2080 RIPng for IPv6
RFC 2081 RIPng Protocol Applicability Statement
RFC 2082 RIP-2 MD5
RFC 2460 IPv6 Specification
RFC 2464 Transmission of IPv6 over Ethernet Networks
RFC 2710 Multicast Listener Discovery (MLD) for IPv6
RFC 2925 Definitions of Managed Objects for Remote Ping, Traceroute, and Lookup
Operations (Ping only)
RFC 2925 Remote Operations MIB (Ping only)
RFC 3019 MLDv1 MIB
RFC 3315 DHCPv6 (client and relay)
RFC 3484 Default Address Selection for IPv6
RFC 3513 IPv6 Addressing Architecture
RFC 3596 DNS Extension for IPv6
RFC 3810 MLDv2 for IPv6
RFC 4022 MIB for TCP
RFC 4113 MIB for UDP
RFC 4251 SSHv6 Architecture
RFC 4252 SSHv6 Authentication
RFC 4253 SSHv6 Transport Layer
RFC 4254 SSHv6 Connection
RFC 4291 IP Version 6 Addressing Architecture
RFC 4293 MIB for IP
RFC 4419 Key Exchange for SSH
RFC 4443 ICMPv6
RFC 4541 IGMP & MLD Snooping Switch
RFC 4861 IPv6 Neighbor Discovery
RFC 4862 IPv6 Stateless Address Auto-configuration
RFC 5095 Deprecation of Type 0 Routing Headers in IPv6
RFC 6620 FCFS SAVI
draft-ietf-savi-mix

MIBs IEEE 802.1ap (MSTP and STP MIB's only)
IEEE 8021-Bridge-MIB (2008)
IEEE 8021-Q-Bridge-MIB (2008)
RFC 1155 Structure & ID of Mgmt Info for TCP/IP Internets
RFC 1156 (TCP/IP MIB)
RFC 1157 A Simple Network Management Protocol (SNMP)
RFC 1213 MIB II
RFC 1493 Bridge MIB
RFC 1724 RIPv2 MIB
RFC 2021 RMONv2 MIB
RFC 2578 Structure of Management Information Version 2 (SMIv2)
RFC 2579 Textual Conventions for SMIv2
RFC 2580 Conformance Statements for SMIv2
RFC 2613 SMON MIB
RFC 2618 RADIUS Client MIB
RFC 2620 RADIUS Accounting MIB
RFC 2665 Ethernet-Like-MIB
RFC 2668 802.3 MAU MIB
RFC 2674 802.1p and IEEE 802.1Q Bridge MIB
RFC 2737 Entity MIB (Version 2)
RFC 2819 RMON MIB
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RFC 2863 The Interfaces Group MIB
RFC 2925 Ping MIB
RFC 2932 IP (Multicast Routing MIB)
RFC 2933 IGMP MIB
RFC 3414 SNMP-User based-SM MIB
RFC 3415 SNMP-View based-ACM MIB
RFC 3417 Simple Network Management Protocol (SNMP) over IEEE 802 Networks
RFC 3418 MIB for SNMPv3
RFC 4836 Managed Objects for 802.3 Medium Attachment Units (MAU)

Network
Management

IEEE 802.1AB Link Layer Discovery Protocol (LLDP)
RFC 1155 Structure of Management Information
RFC 1157 SNMPv1
RFC 2021 Remote Network Monitoring Management Information Base Version 2
using SMIv2
RFC 2576 Coexistence between SNMP versions
RFC 2578 Structure of Management Information Version 2 (SMIv2)
RFC 2579 Textual Conventions for SMIv2
RFC 2580 Conformance Statements for SMIv2
RFC 2819 Four groups of RMON: 1 (statistics), 2 (history), 3 (alarm) and 9 (events)
RFC 2819 Remote Network Monitoring Management Information Base
RFC 2856 Textual Conventions for Additional High Capacity Data Types
RFC 2925 Definitions of Managed Objects for Remote Ping, Traceroute, and Lookup
Operations
RFC 3164 BSD syslog Protocol
RFC 3176 sFlow
RFC 3411 SNMP Management Frameworks
RFC 3412 Message Processing and Dispatching for the Simple Network
Management Protocol (SNMP)
RFC 3413 Simple Network Management Protocol (SNMP) Applications
RFC 3414 User-based Security Model (USM) for version 3 of the Simple Network
Management Protocol (SNMPv3)
RFC 3415 View-based Access Control Model (VACM) for the Simple Network
Management Protocol (SNMP)
RFC 3418 Management Information Base (MIB) for the Simple Network
Management Protocol (SNMP)
RFC 5424 Syslog Protocol
ANSI/TIA-1057 LLDP Media Endpoint Discovery (LLDP-MED)
SNMPv1/v2c/v3
XRMON

QoS/CoS IEEE 802.1p (CoS)
RFC 2474 DiffServ Precedence, including 8 queues/port
RFC 2475 DiffServ Architecture
RFC 2597 DiffServ Assured Forwarding (AF)
RFC 2598 DiffServ Expedited Forwarding (EF)
Ingress Rate Limiting

Security IEEE 802.1X Port Based Network Access Control
RFC 1321 The MD5 Message-Digest Algorithm
RFC 1334 PPP Authentication Protocols (PAP)
RFC 1492 An Access Control Protocol, Sometimes Called TACACS
RFC 1492 TACACS+
RFC 1994 PPP Challenge Handshake Authentication Protocol (CHAP)
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RFC 2082 RIP-2 MD5 Authentication
RFC 2104 Keyed-Hashing for Message Authentication
RFC 2138 RADIUS Authentication
RFC 2139 RADIUS Accounting
RFC 2246 Transport Layer Security (TLS)
RFC 2548 Microsoft Vendor-specific RADIUS Attributes
RFC 2618 RADIUS Authentication Client MIB
RFC 2620 RADIUS Accounting Client MIB
RFC 2698 A Two Rate Three Color Marker
RFC 2716 PPP EAP TLS Authentication Protocol
RFC 2818 HTTP Over TLS
RFC 2865 RADIUS (client only)
RFC 2865 RADIUS Authentication
RFC 2866 RADIUS Accounting
RFC 2867 RADIUS Accounting Modifications for Tunnel Protocol Support
RFC 2868 RADIUS Attributes for Tunnel Protocol Support
RFC 2869 RADIUS Extensions
RFC 2882 NAS Requirements: Extended RADIUS Practices
RFC 3162 RADIUS and IPv6
RFC 3576 Dynamic Authorization Extensions to RADIUS
RFC 3579 RADIUS Support For Extensible Authentication Protocol (EAP)
RFC 3580 IEEE 802.1X RADIUS
RFC 3580 IEEE 802.1X Remote Authentication Dial In User Service (RADIUS)
Usage Guidelines
RFC 4675 RADIUS Attributes
Access Control Lists (ACLs)
draft-grant-tacacs-02 (TACACS)
Guest VLAN for 802.1X
MAC Authentication
MAC Lockdown
MAC Lockout
Port Security
Secure Sockets Layer (SSL)
SSHv2 Secure Shell
Web Authentication
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Aruba 2930F Switch Series accessories  
   

Transceivers  

Aruba 100M SFP LC FX 2km MMF Transceiver J9054D  
Aruba 1G SFP RJ45 T 100m Cat5e Transceiver J8177D   
Aruba 1G SFP LC SX 500m OM2 MMF Transceiver J4858D   
Aruba 1G SFP LC LX 10km SMF Transceiver J4859D   
Aruba 1G SFP LC LH 70km SMF Transceiver J4860D   
Aruba 10G SFP+ LC SR 300m OM3 MMF Transceiver J9150D   
Aruba 10G SFP+ LC LR 10km SMF Transceiver J9151D   
Aruba 10G SFP+ LC ER 40km SMF Transceiver J9153D   
Aruba 10G SFP+ to SFP+ 1m Direct Attach Copper Cable J9281D   
Aruba 10G SFP+ to SFP+ 3m Direct Attach Copper Cable J9283D
NOTE: no support for J9152D 10G LRM, nor J9285D 10G 7m DAC  

   

Cables  

   

Aruba X2C2 RJ45 to DB9 Console Cable JL448A
HPE LC to LC Multi-mode OM3 2-Fiber 0.5m 1-Pack Fiber Optic Cable AJ833A
HPE LC to LC Multi-mode OM3 2-Fiber 1.0m 1-Pack Fiber Optic Cable AJ834A
HPE LC to LC Multi-mode OM3 2-Fiber 2.0m 1-Pack Fiber Optic Cable AJ835A
HPE LC to LC Multi-mode OM3 2-Fiber 5.0m 1-Pack Fiber Optic Cable AJ836A
HPE LC to LC Multi-mode OM3 2-Fiber 15.0m 1-Pack Fiber Optic Cable AJ837A
HPE LC to LC Multi-mode OM3 2-Fiber 30.0m 1-Pack Fiber Optic Cable AJ838A
HPE LC to LC Multi-mode OM3 2-Fiber 50.0m 1-Pack Fiber Optic Cable AJ839A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 1m Cable QK732A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 2m Cable QK733A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 5m Cable QK734A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 15m Cable QK735A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 30m Cable QK736A
HPE Premier Flex LC/LC Multi-mode OM4 2 fiber 50m Cable QK737A
   
Aruba 2930F 24G 4SFP+ Switch (JL253A)  

HPE X410 1U Universal 4-post Rackmount Kit J9583A
   
Aruba 2930F 48G 4SFP+ Switch (JL254A)  

HPE X410 1U Universal 4-post Rackmount Kit J9583A
   
Aruba 2930F 24G PoE+ 4SFP+ Switch (JL255A)  

HPE X410 1U Universal 4-post Rackmount Kit J9583A
   
Aruba 2930F 48G PoE+ 4SFP+ Switch (JL256A)  

HPE X410 1U Universal 4-post Rackmount Kit J9583A
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Aruba 2930F 8G PoE+ 2SFP+ Switch (JL258A)  

Aruba 2930F 8-port Cable Guard JL311A
Aruba 2930F 8-port Power Shelf JL312A
   
Aruba 2930F 24G 4SFP Switch (JL259A)  

HPE X410 1U Universal 4-post Rackmount Kit J9583A
   
Aruba 2930F 48G 4SFP Switch (JL260A)  

HPE X410 1U Universal 4-post Rackmount Kit J9583A
   
Aruba 2930F 24G PoE+ 4SFP Switch (JL261A)  

HPE X410 1U Universal 4-post Rackmount Kit J9583A
   
Aruba 2930F 48G PoE+ 4SFP Switch (JL262A)  

HPE X410 1U Universal 4-post Rackmount Kit J9583A
   
Aruba 2930F 24G PoE+ 4SFP+ TAA-compliant Switch (JL263A)  

HPE X410 1U Universal 4-post Rackmount Kit     J9583A
   
Aruba 2930F 48G PoE+ 4SFP+ TAA-compliant Switch (JL264A)  

HPE X410 1U Universal 4-post Rackmount Kit J9583A
   
Aruba 2930F 48G PoE+ 4SFP 740W Switch (JL557A)  

HPE X410 1U Universal 4-post Rackmount Kit     J9583A
   
Aruba 2930F 48G PoE+ 4SFP+ 740W Switch (JL558A)  

HPE X410 1U Universal 4-post Rackmount Kit     J9583A
   
Aruba 2930F 48G PoE+ 4SFP+ 740W TAA-compliant Switch (JL559A)  

HPE X410 1U Universal 4-post Rackmount Kit     J9583A
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NOTE: Details are not available for all accessories. The following specifications were available at the time
of publication.

 
Aruba 2930F 8-port
Cable Guard (JL311A)

The Cable Guard
secures cables that are
connected to the switch
and provides extra
security against theft or
tampering with the switch
and its cables after it is
installed

Product Type Mounting Kit
Physical
characteristics

Dimensions: 1.42(w) x 4.33(d) x 0.69(h) in (3.6 x 11 x 1.75 cm)
Weight: 1.28 lb (0.58 kg)

Notes Dimensions: 10.94" x 3.62" x 1.69" or 27.8cm x 9.2cm x 4.3cm
w/ears 10.94" x 1.69" x 1.69" or 27.8cm x 4.3cm x 4.3cm
without ears
Weight: 1.262 lbs or 57 kg (including faceplate, ears, and
screws) 1.026 lbs or . 47 kg (faceplate only)

Warranty Limited Lifetime Warranty: See
http://www.hpe.com/networking/warrantysummary for
warranty and support information included with your product
purchase.

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the
service-level descriptions and product numbers. For details
about services and response times in your area, please
contact your local Hewlett Packard Enterprise sales office.

 
Aruba 2930F 8-port
Power Shelf (JL312A)

An easy-to-use solution
for attaching the external
power adapter to any of
the Aruba 2530 8-port
switches.

Product Type Mounting Kit
Physical
characteristics

Dimensions: 10.75(w) x 6(d) x 2(h) in (27.31 x 15.24 x 5.08
cm)
Weight: 0.93 lb (0.42 kg)

Overall Positioning
Statement

The Aruba 2930F 8-port Power Shelf provides an easy to use
solution for attaching the external power adapter to the Aruba
2930F 8G 2SFP+ PoE+ Switch. The power adapter shelf can
be quickly attached on the rear of the Aruba 2930F 8G PoE+
2SFP+ Switch and the adapter fit into place. This power
adapter shelf is designed for wall, table or rack deployments.

Key Features Quickly attach external power adapter to 8 port switch
Designed for use with Aruba 2930F 8G PoE+ 2SFP+
Switch

Notes The Aruba 2930F 8-port Power Shelf is an accessory for the
Aruba 2930F 8G PoE+ 2SFP+ Switch. The shelf mounts on
the back of the switch providing a place to hold the external
power adapter.

Warranty Limited Lifetime Warranty: See
http://www.hpe.com/networking/warrantysummary for
warranty and support information included with your product
purchase.

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the
service-level descriptions and product numbers. For details
about services and response times in your area, please
contact your local Hewlett Packard Enterprise sales office.
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HPE X121 1G SFP LC
SX Transceiver
(J4858C)

A small form-factor
pluggable (SFP) Gigabit
SX
transceiver that provides
a full-duplex Gigabit
solution
up to 550 m on
multimode fiber.

Ports 1 LC 1000BASE-SX port; Duplex: full only
Physical
characteristics

Dimensions: 2.24(d) x 0.54(w) x 0.48(h) in. (5.69 x 1.37 x 1.22
cm)
Weight: 0.04 lb. (0.02 kg)
Transceiver form factor: SFP

Environment Operating temperature: 32°F to 158°F (0°C to 70°C)
Operating relative humidity: 5% to 85%, noncondensing
Nonoperating/Storage temperature: -40°F to 203°F (-40°C to
85°C)
Altitude: up to 10,000 ft. (3 km)

Electrical
characteristics

Power consumption typical: 0.4 W
Power consumption maximum: 0.7 W

Cabling Type:

62.5/125 µm or 50/125 µm (core/cladding) diameter,
graded-index, low metal content, multimode fiber optic,
complying with ITU-T G.651 and ISO/IEC 793-2 Type
A1b or A1a, respectively;

Maximum distance:

2-220 m (62.5 µm core diameter, 160 MHz*km bandwidth
2-275 m (62.5 µm core diameter, 200 MHz*km bandwidth
2-500 m (50 µm core diameter, 400 MHz*km bandwidth)
2-550 m (50 µm core diameter, 500 MHz*km bandwidth)

Cable length: 2-550m
Fiber type: Multi Mode

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the
service-level descriptions and product numbers. For details
about services and response times in your area, please
contact your local Hewlett Packard Enterprise sales office.
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HPE X121 1G SFP LC
LX Transceiver
(J4859C)

HPE X121 1G SFP LC
LX Transceiver: An SFP
format
gigabit transceiver with
LC connectors using LX
technology.

Ports 1 LC 1000BASE-LX port (IEEE 802.3z Type 1000BASE-LX);
Duplex: full only

Physical
characteristics

Dimensions: 2.24(d) x 0.54(w) x 0.486(h) in. (5.69 x 1.37 x
1.23 cm)
Weight:0.04 lb. (0.02 kg)

Environment Operating temperature: 32°F to 158°F (0°C to 70°C)
Operating relative humidity: 0% to 85%, noncondensing
Nonoperating/Storage temperature: -40°F to 212°F (-40°C to
100°C)
Altitude: up to 10,000 ft. (3 km)

Cabling Type:

Either single mode or multimode; 62.5/125 µm or 50/125
µm (core/cladding) diameter, graded-index, low metal
content, multimode fiber optic, complying with ITU-T
G.651 and ISO/IEC 793-2 Type A1b or A1a, respectively;
Low metal content, single-mode fiber-optic, complying
with ITU-T G.652 and ISO/IEC 793-2 Type B1;

Maximum distance:

2-550 m (multimode 62.5 µm core diameter, 500 MHz*km
bandwidth)
2-550 m (multimode 50 µm core diameter, 400 MHz*km
bandwidth)
2-550 m (multimode 50 µm core diameter, 500 MHz*km
bandwidth)
2-10,000 m (single-mode fiber)

Notes A mode conditioning patch cord may be needed in some
multimode fiber installations.
Wavelength: 1310nm
Power Consumption: < 500mW Typical

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the
service-level descriptions and product numbers. For details
about services and response times in your area, please
contact your local Hewlett Packard Enterprise sales office.
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HPE X121 1G SFP LC
LH Transceiver
(J4860C)

A small form-factor
pluggable (SFP) Gigabit
LH transceiver that
provides a full-duplex
Gigabit solution up to 70
km on single-mode fiber.

Ports 1 LC 1000BASE-LH port (no IEEE standard exists for 1550 nm
optics); Duplex: full only

Physical
characteristics

Dimensions: 2.17(d) x 0.60(w) x 0.46(h) in. (5.5 x 1.53 x 1.18
cm)
Weight: 0.04 lb. (0.02 kg)

Environment Operating temperature: -40°F to 185°F (-40°C to 85°C)
Operating relative humidity: 0% to 95% @ 77°F (25°C),
noncondensing
Nonoperating/Storage temperature: -40°F to 185°F (-40°C to
85°C)
Altitude: up to 10,000 ft. (3 km)

Cabling Cable type:

Low metal content, single-mode fiber-optic, complying
with ITU-T G.652 and ISO/IEC 793-2 Type B1;

Maximum distance:

10-70,000 m (single-mode fiber)
Notes Power consumption is 0.8 watts typical with 1 watt maximum at

100% utilization.
For distances less than 20 km, a 10 dB attenuator must be
used.
For distances between 20 km and 40 km, a 5 dB attenuator
must be used.
Attenuators can be purchased from most cable vendors.

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the
service-level descriptions and product numbers. For details
about services and response times in your area, please
contact your local Hewlett Packard Enterprise sales office.

 
HPE X111 100M SFP LC
FX Transceiver
(J9054C)

HP X111 100M SFP LC
FX Transceiver: An SFP
format 100-megabit
transceiver with LC
connectors using FX
technology.

Ports 1 LC 100BASE-FX port (IEEE 802.3u Type 100BASE-FX);
Duplex: half or full

Physical
characteristics

Dimensions: 2.7(d) x 0.54(w) x 0.48(h) in. (6.86 x 1.38 x 1.22
cm)
Weight: 0.06 lb. (0.03 kg)

Environment Operating temperature: 32°F to 158°F (0°C to 70°C)
Operating relative humidity: 5% to 95%
Nonoperating/Storage temperature: -40°F to 185°F (-40°C to
85°C)
Nonoperating/Storage relative humidity: 5% to 85%
Altitude: up to 10,000 ft. (3 km)

Cabling Cable type:
62.5/125 ìm or 50/125 ìm (core/cladding) diameter, graded-index, low
metal content, multimode fiber optic, complying with ITU-T G.651 and
ISO/IEC 793-2 Type A1b or A1a, respectively; Maximum distance:
2 km (full duplex) or 412 m (half duplex)
 

Notes Transmitter wavelength: 1310nm
Power consumption is 1.1 watt maximum.
For supported platforms and minimum software requirements
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to support this product, see the document titled "Support for
the J9054C 100-FX SFP-LC Transceiver" on the "ProCurve
Mini-GBICs and SFPs" Manuals Web page.

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the
service-level descriptions and product numbers. For details
about services and response times in your area, please
contact your local Hewlett Packard Enterprise sales office.

 
 
HPE LC to LC Multi-
mode OM3 2-Fiber
0.5m 1-Pack Fiber
Optic Cable (AJ833A)

Cabling Cable type:
50/125 µm (core/cladding) diameter, mulitimode fiber optic, with
effective modal bandwidth of 2000 MHz/km as detailed in TIA-492AAAC
for distances of up to 300 m

Maximum distance:
10Gbps Transfer Rate (Ethernet): 300m

Notes Cable Specs: Tight buffered duplex fiber optic multimode OM3 50/125
um fiber optic cable and Ethernet assembly with LC duplex connectors
on one end and LC duplex connectors on other end.

Dimensions: Core diameter: 50 ± 3.0um Cladding
diameter: 125 ± 2.0um Coating diameter: 245 ± 10um
Optical glass: Bandwidth: For LED sources: 1500/500
MHz-km @850/1300nm.
Optical glass: Bandwidth: For Laser sources: 2000/500
MHz-km @850/1300nm. VCSEL Laser sources: 600 /
600 meters @850/1300nm for Gigabit Ethernet compliant
links.
CABLE: The cable is duplex zipcord graded index
50/125um multimode optical fiber and designed to work
in both the 850 and 1300 nm wavelength windows.
BULK CABLE & CABLE ASSEMBLY CONFIGURATION:
Jacket Material: Riser Grade - Low Smoke Zero Halogen
thermoplastic.
Jacket Color: Aqua for OM3 multimode per TIA 598
Boot Color: White
Insertion Loss: less than 0.5 dB @ 850 with LED source,
0.003 dB/M added for lengths > 30 meters.
Maximum Cable attenuation: 3.0 dB/km @ 850 nm, 1.0
dB/Km @ 1310 nm @ 23°C as tested in accordance with
EIA 455-46.
Weight: Air Packed Weight: 1 LB Net Weight: 0.454Kg

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the
service-level descriptions and product numbers. For details
about services and response times in your area, please
contact your local Hewlett Packard Enterprise sales office.
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HPE Premier Flex
LC/LC Multi-mode OM4
2 fiber 1m Cable
(QK732A)

Notes Cable Specs: Graded-index, "bendable" fiber optic multimode OM3+
50/125um duplex cable and Ethernet assembly with LC duplex
connectors on each end.

Core Diameter: 50um ±3um, Cladding diameter: 125um ±2um; Coating
diameter: 245 ± 10um
Bandwidth: 3000 MHz-km @ 850nm (Laser)
Jacket Color: Blue
Jacket Material: Riser Grade - Low Smoke Zero Halogen (LSZH)
thermoplastic
Boot Color: White
Outer Jacket Print: HPE PremierFlex OM3+ Fiber Optic Cable,
50/125um, Type OFNR (UL), LSZH, cUL, OFN FT4, ROHS. Cable also
has a longitudinal white stripe that runs the entire length of the cable.
Insertion Loss: Less than 0.5dB @ 850nm with LED source, 0.003dB/m
added for lengths >30m
Maximum Cable Attenuation: 3.0 dB/km @ 850nm, 1.0 dB/km @
1310nm @ 23°C as tested in accordance with EIA 455-45

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the
service-level descriptions and product numbers. For details
about services and response times in your area, please
contact your local Hewlett Packard Enterprise sales office.

 
HPE Premier Flex
LC/LC Multi-mode OM4
2 fiber 2m Cable
(QK733A)

Notes Cable Specs: Graded-index, "bendable" fiber optic multimode OM3+
50/125um duplex cable and Ethernet assembly with LC duplex
connectors on each end.

Core diameter: 50um ±3um, Cladding diameter: 125um ±2um; Coating
diameter: 245 ± 10um
Bandwidth: 3000 MHz-km @ 850nm (Laser)
Jacket Color: Blue
Jacket Material: Riser Grade - Low Smoke Zero Halogen (LSZH)
thermoplastic
Boot Color: White
Outer Jacket Print: HPE PremierFlex OM3+ Fiber Optic Cable,
50/125um, Type OFNR (UL), LSZH, cUL, OFN FT4, ROHS. Cable also
has a longitudinal white stripe that runs the entire length of the cable.
Insertion Loss: Less than 0.5dB @ 850nm with LED source, 0.003dB/m
added for lengths >30m
Maximum Cable Attenuation: 3.0 dB/km @ 850nm, 1.0 dB/km @
1310nm @ 23°C as tested in accordance with EIA 455-45

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the
service-level descriptions and product numbers. For details
about services and response times in your area, please
contact your local Hewlett Packard Enterprise sales office.
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HPE Premier Flex
LC/LC Multi-mode OM4
2 fiber 5m Cable
(QK734A)

Notes Cable Specs: Graded-index, "bendable" fiber optic multimode OM3+
50/125um duplex cable and Ethernet assembly with LC duplex
connectors on each end.

Core diameter: 50um ±3um, Cladding diameter: 125um ±2um; Coating
diameter: 245 ± 10um
Bandwidth: 3000 MHz-km @ 850nm (Laser)
Jacket Color: Blue
Jacket Material: Riser Grade - Low Smoke Zero Halogen (LSZH)
thermoplastic
Boot Color: White
Outer Jacket Print: HPE PremierFlex OM3+ Fiber Optic Cable,
50/125um, Type OFNR (UL), LSZH, cUL, OFN FT4, ROHS. Cable also
has a longitudinal white stripe that runs the entire length of the cable.
Insertion Loss: Less than 0.5dB @ 850nm with LED source, 0.003dB/m
added for lengths >30m
Maximum Cable Attenuation: 3.0 dB/km @ 850nm, 1.0 dB/km @
1310nm @ 23°C as tested in accordance with EIA 455-45

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the
service-level descriptions and product numbers. For details
about services and response times in your area, please
contact your local Hewlett Packard Enterprise sales office.

 
HPE Premier Flex
LC/LC Multi-mode OM4
2 fiber 15m Cable
(QK735A)

Notes Cable Specs: Graded-index, "bendable" fiber optic multimode OM3+
50/125um duplex cable and Ethernet assembly with LC duplex
connectors on each end.

Core diameter: 50um ±3um, Cladding diameter: 125um ±2um; Coating
diameter: 245 ± 10um
Bandwidth: 3000 MHz-km @ 850nm (Laser)
Jacket Color: Blue
Jacket Material: Riser Grade - Low Smoke Zero Halogen (LSZH)
thermoplastic
Boot Color: White
Outer Jacket Print: HPE PremierFlex OM3+ Fiber Optic Cable,
50/125um, Type OFNR (UL), LSZH, cUL, OFN FT4, ROHS. Cable also
has a longitudinal white stripe that runs the entire length of the cable.
Insertion Loss: Less than 0.5dB @ 850nm with LED source, 0.003dB/m
added for lengths >30m
Maximum Cable Attenuation: 3.0 dB/km @ 850nm, 1.0 dB/km @
1310nm @ 23°C as tested in accordance with EIA 455-45

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the
service-level descriptions and product numbers. For details
about services and response times in your area, please
contact your local Hewlett Packard Enterprise sales office.
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HPE Premier Flex
LC/LC Multi-mode OM4
2 fiber 30m Cable
(QK736A)

Notes Cable Specs: Graded-index, "bendable" fiber optic multimode OM3+
50/125um duplex cable and Ethernet assembly with LC duplex
connectors on each end.

Core diameter: 50um ±3um, Cladding diameter: 125um ±2um; Coating
diameter: 245 ± 10um
Bandwidth: 3000 MHz-km @ 850nm (Laser)
Jacket Color: Blue
Jacket Material: Riser Grade - Low Smoke Zero Halogen (LSZH)
thermoplastic
Boot Color: White
Outer Jacket Print: HPE PremierFlex OM3+ Fiber Optic Cable,
50/125um, Type OFNR (UL), LSZH, cUL, OFN FT4, ROHS. Cable also
has a longitudinal white stripe that runs the entire length of the cable.
Insertion Loss: Less than 0.5dB @ 850nm with LED source, 0.003dB/m
added for lengths >30m
Maximum Cable Attenuation: 3.0 dB/km @ 850nm, 1.0 dB/km @
1310nm @ 23°C as tested in accordance with EIA 455-45

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the
service-level descriptions and product numbers. For details
about services and response times in your area, please
contact your local Hewlett Packard Enterprise sales office.

 
HPE Premier Flex
LC/LC Multi-mode OM4
2 fiber 50m Cable
(QK737A)

Notes Cable Specs: Graded-index, "bendable" fiber optic multimode OM3+
50/125um duplex cable and Ethernet assembly with LC duplex
connectors on each end.

Core diameter: 50um ±3um, Cladding diameter: 125um ±2um; Coating
diameter: 245 ± 10um
Bandwidth: 3000 MHz-km @ 850nm (Laser)
Jacket Color: Blue
Jacket Material: Riser Grade - Low Smoke Zero Halogen (LSZH)
thermoplastic
Boot Color: White
Outer Jacket Print: HPE PremierFlex OM3+ Fiber Optic Cable,
50/125um, Type OFNR (UL), LSZH, cUL, OFN FT4, ROHS. Cable also
has a longitudinal white stripe that runs the entire length of the cable.
Insertion Loss: Less than 0.5dB @ 850nm with LED source, 0.003dB/m
added for lengths >30m
Maximum Cable Attenuation: 3.0 dB/km @ 850nm, 1.0 dB/km @
1310nm @ 23°C as tested in accordance with EIA 455-45

Services Refer to the Hewlett Packard Enterprise website at
http://www.hpe.com/networking/services for details on the
service-level descriptions and product numbers. For details
about services and response times in your area, please
contact your local Hewlett Packard Enterprise sales office.
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Date Version History Action Description of Change:
03-Dec-2018 Version 10 Changed Software feature update: Key features,

Product overview, Enhanced Capabilities and
Technical Specifications updated

02-Jul-2018 Version 9 Changed Software feature update
15-Jan-2018 Version 8 Changed Minor changes made on Technical

Specifications
08-Jan-2018 Version 7 Added Models added: JL557A, JL558A, JL559A
03-Jul-2017 Version 6 Added SKU added: JL448A
20-Jan-2017 Version 5 Changed Minor changes made on Standards and

protocols
07-Nov-2016 Version 4 Changed Product overview, Features and Benefits,

Technical Specifications updated
02-Sep-2016 Version 3 Changed Product description updated.
24-June-2016 Version 2 Changed Updated B2E Attribute Description for all

switches on the Configuration section.
06-Jun-2016 Version 1 Creation Document creation
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This guide provides information on how to use the switch interfaces and introduces basic operations.

Applicable products
This guide applies to these products:

Aruba 2530 Switch Series (J9772A, J9773A, J9774A, J9775A, J9776A, J9777A, J9778A, J9779A, J9780A,
J9781A, J9782A, J9783A, J9853A, J9854A, J9855A, J9856A, JL070A)

Aruba 2540 Switch Series (JL354A, JL355A, JL356A, JL357A)

Aruba 2920 Switch Series (J9726A, J9727A, J9728A, J9729A, J9836A)

Aruba 2930F Switch Series (JL253A, JL254A, JL255A, JL256A, JL258A, JL259A, JL260A, JL261A, JL262A,
JL263A, JL264A, JL557A, JL558A, JL559A)

Aruba 2930M Switch Series (JL319A, JL320A, JL321A, JL322A, JL323A, JL324A)

Aruba 3810 Switch Series (JL071A, JL072A, JL073A, JL074A, JL075A, JL076A)

Aruba 5400R zl2 Switch Series (J9821A, J9822A, J9850A, J9851A, JL001A, JL002A, JL003A, JL095A)

Switch prompts used in this guide
Examples in this guide are representative and may not match your particular switch/environment. Examples use
simplified prompts as follows:

Prompt Explanation

switch# # indicates manager context (authority).

switch> > indicates operator context (authority).

switch(config)# (config) indicates the config context.

switch(vlan-x)# (vlan-x) indicates the vlan context of config, where x
represents the VLAN ID. For example:
switch(vlan-128)#.

switch(eth-x)# (eth-x) indicates the interface context of config,
where x represents the interface. For example:
switch(eth-48)#.

switch-Stack# Stack indicates that stacking is enabled.

switch-Stack(config)# Stack(config) indicates the config context while
stacking is enabled.

switch-Stack(stacking)# Stack(stacking) indicates the stacking context of
config while stacking is enabled.

Table Continued

Chapter 1
About this guide
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Prompt Explanation

switch-Stack(vlan-x)# Stack(vlan-x) indicates the vlan context of config
while stacking is enabled, where x represents the
VLAN ID. For example: switch-
Stack(vlan-128)#.

switch-Stack(eth-x/y)# Stack(eth-x/y) indicates the interface context of
config, in the form (eth-<member-in-stack>/
<interface>). For example: switch(eth-1/48)#

10 Aruba Basic Operation Guide for ArubaOS-Switch 16.05
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Using the switch setup screen
The quickest and easiest way to minimally configure the switch for management and password protection is to
use a direct console connection to the switch, start a console session and access the Switch Setup screen.

Procedure

1. Using the method described in the Installation and Getting Started Guide for your switch, connect a terminal
device to the switch and display the switch console command (CLI) prompt (the default display).

2. The CLI prompt appears displaying the switch model number, for example: HPE switch#

3. Screen. The following illustration is an example of a Setup screen with default settings. Your screen may vary
slightly.

Figure 1: Example Switch Setup screen

4. Use the [Tab] key to select the Manager Password field and enter a manager password of up to 16
characters and press [Tab].

5. Tab to the IP Config (DHCP/Bootp) field and use the Space bar to select the Manual option and press [Tab].

6. Tab to the IP Address field and enter the IP address that is compatible with your network and press Enter.

Chapter 2
Getting Started
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7. Tab to the Subnet Mask field and enter the subnet mask used for your network.

8. Press S (for Save).

After editing, pressing Enter and then selecting Save will also save the configuration.

Table 1: Setup screen field descriptions

Parameter Default

System
Name

blank Optional; up to 255 characters, including spaces

System
Contact

blank Optional; up to 255 characters, including spaces

Manager
Password

blank Recommended; up to 16 characters (no blank spaces)

Logon
Default

CLI The default setting selects the command-line interface for console access. The
alternative is the Menu interface.

Time Zone 0 (none) Optional: 1440 to -1440. The number of minutes your location is to the West (-) or
East (+) of GMT.

Community
Name

public Default setting recommended.

Spanning
Tree Enabled

No Default setting recommended unless STP is already running on your network or the
switch will be used in complex network topologies.

Default
Gateway

blank Recommended. Enter the IP address of the next-hop gateway node if network traffic
has to reach off-subnet destinations.

Time Sync
Method

TimeP Optional: The protocol the switch uses to acquire a time signal. The options are
SNTP and TimeP.

TimeP Mode Disabled Synchronizes the time kept on the switch to the TimeP server1.

IP Config DHCP/
Bootp

Set to Manual unless a DHCP/Bootp server is used on your network to configure IP
addressing.

IP Address xxx.xxx.xx
x.xxx

Recommended. If you set IP Config to Manual, then enter an IP address compatible
with your network2.

Subnet Mask xxx.xxx.xx
x.xxx

Recommended. If you entered an IP address, then enter a subnet mask compatible
with your network2.

1For more on this topic, see the "Time Protocols" chapter in the latest Management and Configuration Guide for
your switch.
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2The IP address and subnet mask assigned for the switch must be compatible with the IP addressing used in your
network. For more on IPv4 addressing, see Configuring IP Addressing on page 128. For IPv6 addressing
topics, see the latest IPv6 configuration guide for your switch.

Recommended minimal configuration
In the factory default configuration, the switch has no IP (Internet Protocol) address and subnet mask, and no
passwords. In this state, it can be managed only through a direct console connection. To manage the switch
through in-band (networked) access, you must configure the switch with an IP address and subnet mask
compatible with your network. Also, you must configure a Manager password to control access privileges from the
console and web browser interface. Other parameters in the Switch Setup screen can be left at their default
settings or you can configure them with values you enter.

For more information on IP addressing, see Configuring IP Addressing on page 128.

By default, the switch is configured to acquire an IPv4 address configuration from a DHCP or Bootp
server. To use DHCP/Bootp instead of the manual method described in this chapter, see DHCP/
Bootp Operation in the Management and Configuration Guide for your switch.

For information on configuring IPv6 addressing, see to the latest IPv6 Configuration Guide for your
switch.

Login banners

Custom log in banners
You can configure the switch to display a login banner of up to 3070 characters. An operator initiates a
management session with the switch through any of the following methods:

• Telnet

• Serial connection

• SSHv2

• WebAgent

The default banner displays product registration information.

If a banner is configured, the banner page is displayed when you access the WebAgent. The default product
registration information is not displayed as there is already a product registration prompt displayed in the
WebAgent.

Banner operation with telnet, serial, or SSHv2 access
When a system operator begins a login session, the switch displays the banner above the prompts for local
password and Press any key to continue. Entering a correct password or, if no password is configured, pressing
any key clears the banner from the CLI and displays the CLI prompt.

Banner operation with the WebAgent
When a system operator uses the WebAgent to access the switch, the text of a nondefault banner configured on
the switch appears in a dedicated banner window with a link to the next page. Click Continue to display either the
Registration page or the switch’s home page. If the banner feature is disabled or if the switch is using the factory-
default banner, then the banner page does not appear in the WebAgent screen when an operator initiates a login
session with the switch.
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Banner operating notes

• The default banner appears only when the switch is in the factory default configuration. Using the command
no banner motd deletes the currently configured banner text and blocks display of the default banner. The
default banner is restored only if the switch is reset to its factory default configuration.

• The switch supports one banner at any time. Configuring a new banner replaces any former banner configured
on the switch.

• If the switch is configured with ssh version 1 or ssh version 1-or-2, configuring the banner sets the
SSH configuration to ssh version 2 and displays the message Warning: SSH version has been
set to v2.

• If a banner is configured, the switch does not allow configuration with ssh version 1 or ssh version 1-
or-2. Attempting to do so produces the error message Banner has to be disabled first..

• If a banner is enabled on the switch, the WebAgent displays Notice to all users on the banner page.

banner motd command with non-interactive mode
The use of escape characters allows the banner motd command to be used in non-interactive mode for multiple
message lines. In non-interactive mode, you can create a banner message enclosed in double quotes or other
delimiter that uses escape characters within the delimiters. Other existing CLI commands do not support the
escape characters. For more information on interactive and non-interactive mode, see Enabling and disabling
CLI interactive command mode on page 60 in this guide.

Table 2: Supported escape characters

Character

\" double quote

\’ single quote

\` forward quote

\\ backslash

\f form feed

\n newline

\r carriage return

\t horizontal tab

\v vertical tab

Configuring the banner message using escape characters within double quote delimiters

switch(config)# banner motd 
"You can use the \’banner motd\’ CLI command in non-interactive mode.\n\n\tThe banner
motd command will support escape characters."
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switch(config)# show banner motd

Banner Information

Banner status: Enabled

Configured Banner:

You can use the ‘banner motd’ CLI command in non-interactive mode.

     The banner motd command will support escape characters."

The running configuration file with banner motd configured in non-interactive mode

switch(config)# show running-config

Running configuration:

;J8693A Configuration Editor; Created on release #K.15.10.0002
;Ver #01:01:00

hostname "switch"
vlan 1
  name "DEFAULT_VLAN"
  untagged 1-48, a1-a4
  ip address dhcp-bootp
  exit
banner motd "You can use the \’banner motd\’ CLI command in
non-interactive mode.\n\n\tThe banner motd command will support
escape characters."

Configuring the banner message using an alternate delimiter of ‘#’

switch(config)# banner motd #
Enter TEXT message.

End with the character ‘#’.

You can use the banner motd CLI command in non-interactive mode. The banner motd command \n\n\t
will support escape characters #.

Chapter 2 Getting Started 15
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Starting a menu interface session
Starting the session

In its factory default configuration, the switch console starts with the CLI prompt. To use the menu interface with
Manager privileges, go to the Manager level prompt and enter the menu command.

Prerequisites

Before you start a menu interface session, you must complete the following tasks:

1. Configure and connect to the switch. See the Installation and Getting Started Guide for your switch.

2. Access the menu interface using any of the following methods.

• A direct serial connection to the switch console port, as described in the installation guide you received with
the switch.

• A Telnet connection to the switch console from a networked PC or the switch web interface. To use Telnet,
your switch must first be configured with an IP address and subnet mask compatible with your network.

Procedure

1. Use one of these methods to connect to the switch:

a. A PC terminal emulator or terminal

b. Telnet

2. Do one of the following:

a. If you are using Telnet, go to step 3.

b. If you are using a PC terminal emulator, press [Enter] one or more times until a prompt appears.

3. When the switch screen appears, do one of the following:

a. If a password has been configured, the password prompt appears.

Password: _
Type the Manager password and press [Enter]. Entering the Manager password gives you manager-level
access to the switch. (Entering the Operator password gives you operator-level access to the switch. See
the Access Security Guide for your switch.)

b. If no password has been configured, the CLI prompt appears. Go to the next step.

Chapter 3
Using the Menu Interface
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4. When the CLI prompt appears, display the Menu interface by entering the menu command. For example:
switch# menu [Enter] results in the following display:

Figure 2: Example of the Main Menu with Manager Privileges

For a description of Main Menu features, see Main Menu features on page 20.

To configure the switch using the menu interface instead of the CLI, go to the Manager level prompt
in the CLI, enter the setup command, and in the resulting display, change the Logon Default
parameter to Menu. For more information, see the Installation and Getting Started Guide of your
switch.

Ending a menu session and exiting the console
The method for ending a menu session and exiting the console depends on whether, during the session, any
changes made to the switch configuration requires a switch reboot to activate. (Most changes via the menu
interface need only a Save, and do not require a switch reboot.) Configuration changes that need a reboot are
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marked with an asterisk (*) next to the configured item in the menu and also next to the Switch Configuration
item in the Main Menu.

Figure 3: Example indication of a configuration change requiring a reboot

Procedure

1. In the current session, if you have not made configuration changes that require a switch reboot to activate,
return to the Main Menu and press [0] (zero) to logout. Then, exit the terminal program, turn off the terminal, or
quit the Telnet session.

2. If you have made configuration changes that require a switch reboot— that is, if an asterisk (*) appears next to
a configured item or next to Switch Configuration in the Main Menu:

a. Return to the Main Menu.

b. Press [6] to select Reboot Switch and follow the instructions on the reboot screen.

3. Rebooting the switch terminates the menu session, and if you are using Telnet, disconnects the Telnet session.
(See Rebooting the switch on page 93).

4. Exit from the terminal program, turn off the terminal, or close the Telnet application program.

Rebooting the switch
Rebooting the switch from the menu interface:

Procedure

1. Terminates all current sessions and performs a reset of the operating system

2. Activates any menu interface configuration changes that require a reboot

3. Resets statistical counters to zero

(Note that statistical counters can be reset to zero without rebooting the switch.)
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To Reboot the switch, use the Reboot Switch option in the Main Menu. (Note that Reboot Switch is not available
if you log on in Operator mode; that is, if you enter an Operator password instead of a manager password at the
password prompt.)

Figure 4: The Reboot Switch option in the Main Menu

Rebooting to activate configuration changes. Configuration changes for most parameters in the menu
interface become effective as soon as you save them. However, you must reboot the switch to implement a
change in the Maximum VLANs to support parameter. To access this parameter, go to the Main Menu and
select:

    2. Switch Configuration

         8. VLAN Menu

             1. VLAN Support.
      
If you make configuration changes in the menu interface that require a reboot, the switch displays an asterisk (*)
next to the menu item in which the change has been made. For example, if you change and save the value for the
Maximum VLANs to support parameter, an asterisk appears next to the VLAN Support entry in the VLAN Menu
screen, and also next to the Switch Configuration entry in the Main Menu.

To activate changes indicated by the asterisk, go to the Main Menu and select the Reboot Switch option.

Executing the write memory command in the CLI does not affect pending configuration changes
indicated by an asterisk in the menu interface. That is, only a reboot from the menu interface or a
boot or reload command from the CLI will activate a pending configuration change indicated by an
asterisk.

Configuring ports on HPE 3800 switches with stacking
enabled
When stacking is enabled on an HPE 3800 switch, the procedures for configuring specific switch ports are the
same as for 3800 switches without stacking enabled. However, the port designations for the ports in the stack are
modified. That is, each port is identified by its switch’s stack member ID followed by a slash and then the port
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number, as it is shown on the switch. For example, for a switch with stack member ID 3, port 10 on that switch is
identified as port 3/10 for CLI command input and output. Entering a CLI command on a 3800 switch configured
for stacking without using the modified port designation results in the message ”Module not present for port or
invalid port”.

For more on this topic, see "Interaction with Other Switch Features" in the "Stack Management" chapter of the
latest Management and Configuration Guide for 3800 switches.

Using individual features of the menu interface.
To use the individual features of the menu interface, see the references listed in the following table.

Option: Turn to:

To use the Run Setup option See the Installation and Getting Started Guide shipped with the
switch.

To view and monitor switch status and
counters

Appendix B, "Monitoring and Analyzing Switch Operation" in the
Management and Configuration Guide for your switch.

To learn how to configure and use
passwords and other security features

See the Access Security Guide for your switch.

To learn how to use the Event Log Appendix C, "Using the Event Log for Troubleshooting Switch
Problems" in the Management and Configuration Guide for your
switch.

To learn how the CLI operates Using the Command Line Interface (CLI) on page 57

To download switch software Appendix A, "File Transfers" in the Management and Configuration
Guide for your switch.

For a description of how switch memory
handles configuration changes

Configuring the switch on page 76

Main Menu features
The Main Menu gives you access to these Menu interface features:

• Status and Counters:

Provides access to display screens showing switch information, port status and counters, and port and VLAN
address tables. (See the Management and Configuration Guide for your switch.) All of the items that are
included in Status and Counters are stated in the following list:

◦ Address Table

◦ General System Information

◦ Module Information

◦ Port Address Table

◦ Port Counters

◦ Port Status
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◦ Spanning Tree Information

◦ Switch Management Address Information

◦ VLAN Address Table

• Switch Configuration:

Provides access to configuration screens for displaying and changing the current configuration settings. (See
the contents listing at the front of this manual.) For an index of the features covered in the software manuals
for your switch, see the Software feature index-extended manual for your switch. All of the items that are
included in Switch Configuration are stated in the following list:

◦ System Information

◦ Port/Trunk Settings

◦ Network Monitoring Port

◦ IP Configuration

◦ SNMP Community Names

◦ IP authorized Managers

◦ VLAN Menu

◦ Spanning Tree Operation

• Console Passwords:

Provides access to the screen used to set or change Manager-level and Operator-level passwords, and to
delete Manager and Operator password protection. (See the Access Security Guide for your switch.)

• Event Log:

Enables you to read progress and error messages that are useful for checking and troubleshooting switch
operation. (See the Management and Configuration Guide for your switch.)

• Command Line (CLI):

Selects the Command Line Interface at the same level (Manager or Operator) that you are accessing in the
Menu interface.

• Reboot Switch:

Performs a "warm" reboot of the switch, which clears most temporary error conditions, resets the network
activity counters to zero, and resets the system up-time to zero. A reboot is required to activate a change in
the VLAN Support parameter.

• Download OS:

Enables you to download a new software version to the switch. (See Appendix A, "File Transfers" in the
Management and Configuration Guide for your switch.)

• Run Setup:

Displays the Switch Setup screen for quickly configuring basic switch parameters such as IP addressing,
default gateway, logon default interface, and others. (See the Installation and Getting Started Guide for your
switch.)

• Logout:

Closes the Menu interface and console session, and disconnects Telnet access to the switch.
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Overview of the Menu Interface
The menu interface operates through the switch console to provide you with a subset of switch commands in an
easy-to-use menu format.

• Performs a "quick configuration" of basic parameters, such as the IP addressing required to provide
management access through your network

• Configures these features:

◦ Manager and Operator passwords

◦ System parameters

◦ IP addressing

◦ Time protocol

◦ Ports

◦ Trunk groups

◦ A network monitoring port

◦ SNMP community names

◦ IP authorized managers

◦ VLANs (Virtual LANs) and GVRP

• View status, counters, and Event Log information

• Update switch software

• Reboot the switch

For a detailed list of menu features, see the Main Menu features on page 20.

Screen structure and navigation
Menu interface screens include these three elements:

• Parameter fields and/or read-only information such as statistics

• Navigation and configuration actions, such as Save, Edit, and Cancel

• Help line to describe navigation options, individual parameters, and read-only data
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For example, in the following System Information screen:

Figure 5: Elements of the screen structure

"Forms" design. The configuration screens, in particular, operate similarly to a number of PC applications that
use forms for data entry. When you first enter these screens, you see the current configuration for the item you
have selected. To change the configuration, the basic operation is to:

1. Press [E] to select the Edit action.

2. Navigate through the screen making all the necessary configuration changes.

3. Press [Enter] to return to the Actions line. From there, you can save the configuration changes or cancel the
changes. Cancel returns the configuration to the values you saw when you first entered the screen.
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Table 3: How to navigate the Menu interface

Task: Actions:

Execute an
action from the
"Actions –>" list
at the bottom of
the screen:

Reconfigure
(edit) a
parameter
setting or a field:

1. Select a configuration item, such as System Name.

2. Press [E](for Edit on the Actions line).

3. Use [[Tab]] or the arrow keys ([←], [→], [↑], or [↓]) to highlight the item or field.

4. Do one of the following:

• If the parameter has preconfigured values, either use the Space bar to select a new
option or enter the first part of your selection and the rest of the selection appears
automatically. (The help line instructs you to "Select" a value.)

• If there are no preconfigured values, type in a value (the Help line instructs you to
"Enter" a value).

5. If you want to change another parameter value, return to step 3.

6. If you are finished editing parameters in the displayed screen, press [Enter] to return to
the Actions line and do one of the following:

• To save and activate configuration changes, press [S] (for the Save action). This saves
the changes in the startup configuration and also implements the change in the
currently running configuration. (See, "Switch Memory and Configuration".)

• To exit from the screen without saving any changes that you have made (or if no
changes are done), press [C] (for the Cancel action).

Note: In the menu interface, executing Save activates most parameter changes and saves
them in the startup configuration (or flash) memory, and it is therefore not necessary to
reboot the switch after making these changes. But, if an asterisk appears next to any menu
item you reconfigure, the switch will not activate or save the change for that item until you
reboot the switch. In this case, rebooting must be done after you have made all desired
changes and then returned to the Main Menu.

7. When you finish editing parameters, return to the Main Menu.

8. If necessary, reboot the switch by highlighting Reboot Switch in the Main Menu and
pressing [Enter]. (See the Note in Step 6.)

Exit from a
read-only
screen.

Press [B] (for the Back action).

To get Help on individual parameter descriptions. In most screens, there is a Help option in the Actions line.
Whenever any of the items in the Actions line are highlighted, press [H], and a separate help screen is displayed.
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To get Help on the actions or data fields in each screen: Use the arrow keys ([←], [→], [↑], or [↓]) to select an
action or data field. The help line under the Actions items describes the currently selected action or data field.

For guidance on how to navigate in a screen: See the instructions provided at the bottom of the screen, or See 
Screen structure and navigation on page 22.)

Privilege levels and password security
Hewlett Packard Enterprise strongly recommends that you configure a Manager password to help prevent
unauthorized access to your network. A Manager password grants full read/write access to the switch. An
Operator password grants access to status and counter, Event Log, and the Operator level in the CLI. After you
configure passwords on the switch and log off of the interface, access to the menu interface (and the CLI and web
browser interface) requires entries of either the Manager or Operator password.

• If the switch does not have Manager or an Operator password, anyone having access to the
console interface can operate the console with full manager privileges.

• If you configure only an Operator password, entering the Operator password enables full
manager privileges.

• If the switch only has a Manager password someone without a password can still gain read-only
access.

For more information on passwords, see the Access Security Guide for your switch.

Menu interaction with other interfaces
The menu interface displays the current running-config parameter settings. From the running config, use the
menu interface to save configuration changes made in the CLI. A configuration change made through any switch
interface overwrites earlier changes made through any other interface.

The Menu Interface and the CLI both use the switch console. Use the menu command to enter the menu from the
CLI and the CLI option from the menu interface to enter the CLI.

For more on how switch memory manages configuration changes, see the Switch Memory and Configuration.
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Management and configuration of ArubaOS-Switch can occur through its web interface. Two interfaces are
available, the Legacy UI and the Next Generation UI.

• The Legacy UI provides full functionality for the monitoring and configuration of switches running ArubaOS.

• The Next Generation UI provides a subset of the Legacy UI functionality. Additional functionality will be added
in future releases and it will eventually replace the Legacy UI.

Accessing the ArubaOS-Switch Next Generation UI
Access the ArubaOS-Switch Improved UI by clicking the Access Improved GUI link displayed in the upper right
corner of the Traditional UI.

Figure 6: Traditional UI

Using HTTPS secure connection
ArubaOS-Switch devices can be configured and monitored using a web browser based HTTP interface, which is
enabled by default. However, this connection method is unencrypted, thus making it vulnerable to credential
interception by devices connected to the network in the path between the user and the switch being configured.
To secure connections to the web management UI, it is recommended to enable HTTPS and disable HTTP
access to the switch. HTTPS is HTTP traffic running on a Secure Sockets Layer (SSL)/Transport Layer Security
(TLS) connection, which requires a certificate to be present on the switch. To generate a certificate; enable
HTTPS, and disable HTTP, the steps are as follows:

Procedure

1. Open a switch console session and enter the configuration context using the command:

Chapter 4
ArubaOS-Switch UI
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switch# configure
2. Create a self-signed SSL/TLS certificate.

switch(config)# crypto pki enroll-self-signed certificate-name <name of certificate> subject common-name <common name of device>

a. View the SSL/TLS certificate information.

switch(config)# show crypto pki local-certificate web-mgmt
Certificate Detail:
Version: 3 (0x2)
Serial Number:
   56:12:69:dd:3d:91:c1:8a:4e:2c:f4:62:a3:0a:96:76:b5:f0:b4:31
Signature Algorithm: sha256withRSAEncryption
Issuer: CN=5400R
Validity
   Not Before: Aug 14 13:33:32 2017 GMT
   Not After : Aug 14 23:59:59 2018 GMT
Subject: CN=5400R
Subject Public Key Info:
   Public Key Algorithm: rsaEncryption
   RSA Public Key: (1024 bit)
      Modulus (1024 bit):
          30:0d:06:09:2a:86:48:86:f7:0d:01:01:01:05:00:
          03:81:8d:00:30:81:89:02:81:81:00:b0:90:f9:d8:
          88:f0:d5:eb:31:1e:aa:06:3b:30:5a:5b:d2:ed:eb:
          ff:12:ff:9d:52:55:98:cd:2a:c2:72:8e:94:69:47:
          a3:29:0f:f7:47:c3:c9:57:fa:11:d8:9a:8d:2f:e4:
          84:5e:3d:67:b2:fc:59:81:53:83:12:6a:68:6b:a5:
          4d:20:8f:b5:be:a2:23:b9:aa:e5:9a:55:ac:4a:fb:
          20:4b:71:6d:74:db:ab:89:4f:ed:27:c0:aa:31:fa:
          4b:64:76:be:f8:11:de:0e:5e:1e:17:b2:ba:a2:13:
          ce:2e:aa:31:d6:51:ad:e5:ed:23:93:42:27:d2:44:
          bd:2f:83:9d:02:03:01:00:01
      Exponent: 65537 (0x10001)
X509v3 extensions:
   X509v3 Key Usage: critical
      Digital Signature, Key Encipherment, Key Agreement
   X509v3 Extended Key Usage:
      TLS Web Server Authentication

Signature Algorithm: sha256withRSAEncryption
   5c:00:9e:b2:8a:98:49:f3:e5:11:51:a8:2b:23:07:0c:f8:e8:
   26:bf:09:98:8a:9a:45:22:57:5b:af:ab:2f:ed:34:50:4d:ac:
   d9:59:18:e1:52:68:7f:20:ae:14:e7:d9:97:1b:91:5f:ae:ba:
   cd:b5:d3:7b:14:b6:da:99:fa:4f:2b:ed:65:96:59:fc:87:45:
   1c:49:93:2b:8c:47:3e:08:ae:7f:85:c3:31:58:17:32:d5:13:
   60:a3:c1:d2:4c:69:d5:54:7e:3d:e2:67:64:ba:38:6e:cb:c5:
   9e:17:9e:0b:30:52:8f:47:5d:59:2b:0e:c3:14:07:8f:f0:71:
   97:9d
MD5 Fingerprint: cbdc 5288 60e1 9576 4fd8 1f1d cae7 4edc
SHA1 Fingerprint: 6ea3 7708 a6dd cd6d 065b 1b34 1734 f385 42d6 0121

3. Enable HTTPS web management.

switch(config)# web-management ssl
4. (Recommended) Disable HTTP web management.
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switch(config)# no web-management
5. Verify the web-management configuration.

switch(config)# show web-management

 Web Management - Server Configuration

  HTTP Access    : Disabled
  HTTPS Access   : Enabled
  SSL Port       : 443
  Idle Timeout   : 600 seconds
  Management URL : http://h17007.www1.hpe.com/device_help
  Support URL    : http://www.arubanetworks.com/products/networking/
  User Interface : Improved
  Listen Mode    : bot

6. To log into the web management UI, open a browser and enter an IP address configured on the switch .

For example, https://X.X.X.X

IP addresses are configured on the switch by the VLAN. Use show ip command to view the configured IP
addresses.

For more information about SSL/TLS configuration, see the ArubaOS-Switch Access Security Guide of your
switch.
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Improved UI functionality
Overview

The Improved UI includes four major elements that are common across all views within the UI. The dashboard
view, which provides an at-a-glance overview of system performance, is displayed here as an example. All four
elements are described below the dashboard image.

Figure 7: Improved UI dashboard

Header panel

This is the panel in the upper right corner of the screen. It includes the following icons and fields, from left to right:

• Search: Enter a search term in this field and press Enter to view results.

Reboot: Click this icon to reboot the switch. You will be asked to confirm before the switch is rebooted.

• Refresh: Click this icon to reload the components and refresh the page.

• Toggle locator LED: Click this icon to identify a physical device.

• Notifications: Click this icon to see a list of recent events.

• Help: Click this icon to see the help text associated with the current screen.

• User details: Click this icon to see a list of user roles. You can also launch the Traditional user interface by
clicking Launch Traditional GUI.

• Settings: Click this icon to modify the web interface settings for the current screen.

Navigation pane

This is the gray bar on the left side of the screen. It contains a series of drop-down menus, each representing an
area of functionality, that allow you to navigate through the Improved UI. The drop-down menus include:
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• General: Includes the Dashboard submenu.

• System: Includes the Status, Events, Monitor, SNMP, Firmware Update, and Stack (supported only for BPS/
VSF) submenus.

• Interfaces: Includes the Ports, PoE, Monitor, VLANs, and Trunks submenus.

• Traffic: Includes the Spanning Tree submenu.

• Security: Includes the Clients, User Roles, Intrusion Log, Port Security, and IP Authorization submenus.

• Configurations: Includes the Config Report and Management submenus.

View pane

The view pane is a series of viewing options to the right of the navigation pane. It is broken into two sections:

Status panels - These panels display the status of the following elements.

Click on the ... icon in each status panel to navigate to the detailed view associated with the selected
panel. For example, if you click on ... in th PoE view option, you will jump to the PoE page.

• PoE: Displays PoE port status.

◦ Green: No PoE ports have a fault or have been denied power.

◦ Yellow: One or more PoE ports have been denied power.

◦ Red: One or more PoE ports have a fault.

• Storage: Displays system storage status.

◦ Green: The current system storage use is within normal range.

◦ Yellow: The current system storage use exceeds the warning threshold of 70%.

◦ Red: The current system storage use exceeds the critical threshold of 90%.

• Fans: Displays system fan status.

◦ Green: All fans are operating normally.

◦ Yellow: One or more fans have failed but the number of failures does not exceed 50% of all system fans.

◦ Red: At least 50% of the system fans have failed.

• Security: Displays security status based on the Intrusion Log flags.

◦ Green: No intrusion events have occurred since acknowledgement.

◦ Yellow: This status has no warning state.

◦ Red: At least one new intrusion event has occurred.

• Spanning Tree: Displays spanning tree status.
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◦ Green: Spanning tree is disabled or no loop/root inconsistent ports were detected.

◦ Yellow: Either loop or root inconsistent ports were detected.

◦ Red: Both loop and root inconsistent ports were detected.

• Clients: Displays the summarized status of clients connected to the switch.

◦ Green: All switch clients successfully authenticated/No Clients Connected.

◦ Yellow: At least one client is not properly authenticated.

◦ Red: Client authentication attempts were rejected.

• Ports: Displays ports with warning or critical events.

◦ Green: Only info/debug events occurred on device ports.

◦ Yellow: Warning events have occurred on one or more ports.

◦ Red: Error/major events have occurred on one or more ports.

• Power Supplies: Displays system power supply status.

◦ Green: All power supplies are operating normally.

◦ Yellow: One or more power supplies have failed but the number of failures does not exceed 40% of all
system power supplies.

◦ Red: At least 40% of the system power supplies have failed.

• Temperatures: Displays system temperature status.

◦ Green: The current system temperature is within normal range.

◦ Yellow: The current system temperature exceeds the warning threshold of <variable>. The threshold is
based on a user-controlled setting on the switch.

◦ Red: The current system temperature exceeds the critical threshold of <variable>. The threshold is based
on a user-controlled setting on the switch.

• Uptime: Displays the device system uptime.

Gauges - These gauges display information about:

• CPU: Displays the current CPU usage of the device.

◦ The outer ring of the gauge indicates regions of normal, warning, and critical values.

◦ The peak value shown on the inner ring indicates the highest CPU usage reached for the device.

◦ Green: CPU usage is within normal range.

◦ Yellow: CPU usage exceeds the warning threshold of 75%.

◦ Red: CPU usage exceeds the critical threshold of 90%.

• Memory: Displays the current memory usage of the device.
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◦ The outer ring of the gauge indicates regions of normal, warning, and critical values.

◦ The peak value shown on the inner ring indicates the highest memory usage reached for the device.

◦ Green: Memory usage is within normal range.

◦ Yellow: Memory usage exceeds the warning threshold of 75%.

◦ Red: Memory usage exceeds the critical threshold of 90%.

• Packet Buffers: Displays the current packet buffer usage of the device.

◦ The outer ring of the gauge indicates regions of normal, warning, and critical values.

◦ The peak value shown on the inner ring indicates the highest packet buffer usage reached for the device.

◦ Green: Packet buffer usage is within normal range.

◦ Yellow: Packet buffer usage exceeds the warning threshold of 85%.

◦ Red: Packet buffer usage exceeds the critical threshold of 95%.

• Tx Drops: Displays the current transmit drop rate of the device.

◦ The outer ring of the gauge indicates regions of normal, warning, and critical values.

◦ The peak value shown on the inner ring indicates the highest transmit drop rate reached for the device.

◦ Green: Transmit drop rate is within normal range.

◦ Yellow: Transmit drop rate exceeds the warning threshold of 3% of transmit attempts.

◦ Red: Transmit drop rate exceeds the critical threshold of 5% of transmit attempts.

• Message Buffers: Displays the current message buffer usage of the device.

◦ The outer ring of the gauge indicates regions of normal, warning, and critical values.

◦ The peak value shown on the inner ring indicates the highest message buffer usage reached for the device.

◦ Green: Message buffer usage is within normal range.

◦ Yellow: Message buffer usage exceeds the warning threshold of 75%.

◦ Red: Message buffer usage exceeds the critical threshold of 90%.

• Rx Errors: Displays the current receive error rate of the device.

◦ The outer ring of the gauge indicates regions of normal, warning, and critical values.

◦ The peak value shown on the inner ring indicates the highest receive error rate reached for the device.
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◦ Green: Receive error rate is within normal range.

◦ Yellow: Receive error rate exceeds the warning threshold of 2% of received frames.

◦ Red: Receive error rate exceeds the critical threshold of 5% of received frames.

• Top Interfaces: Displays the top ten ports with any one of 25 user-selected metrics (RX Total Frames in this
example). Only ports that are enabled and up will be shown.

Right pane

Also called the events pane, this section displays:

• The latest events on the system

• User settings per page

• User roles across the system

• Help information

System — Status
Figure 8: System–Status

IP Info: Displays the basic IP configuration of the default VLAN. It is also possible to specify an IP configuration
mode and associated settings.

Hardware: Displays basic hardware information for the device or stack commander. The MAC address and serial
number of the device or stack commander are shown.

System Info: Displays general system information including:
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• Product name

• Configured values for the device name

• Contact

• Location

• Uptime since the device was last rebooted

For a stack, this information pertains to the stack commander. It is also possible to edit the values for device
name, contact, and location.

Software Versions: Displays the primary software, secondary software, and ROM versions for the device or, for a
stack, the stack commander. In a stack, the commander's active software version is propagated to all stack
members.

Storage: Displays system storage details for the device or, for a stack, summary data for each stack member.

• For a standalone device, a breakout of storage use per volume is shown.

• For a stack member, clicking the icon in its summary will navigate to the Stack page for the member where its
breakout data can be viewed.

• This panel can be swapped to the top of the page by clicking the icon in the top right corner.

Fans: Displays system fan details for the device or, for a stack, summary data for each stack member.

• For a standalone device, a breakout of fan details is shown.

• For a stack member, clicking the icon in its summary will navigate to the stack page where its breakout data
may be viewed.

• This panel can be swapped to the top of the page by clicking the icon in the top right corner.

Power Supplies: Displays system power supply status regarding the presence of removable supplies and their
status in a device. For a stack, summary data is displayed for each stack member.

• For a standalone device, a breakout of power supply details is shown.

• For a stack member, clicking the icon in its summary will navigate to the stack page where its breakout data
may be viewed.

• This panel can be swapped to the top of the page by clicking the icon in the top right corner.

Temperature: Displays system thermal status for the device or, for a stack, summary data for each stack
member.

• For a standalone device, a breakout of temperature details is shown.

• For a stack member, clicking the icon in its summary will navigate to the stack page where its breakout data
may be viewed.

• This panel can be swapped to the top of the page by clicking the icon in the top right corner.

34 Aruba Basic Operation Guide for ArubaOS-Switch 16.05

Anexo 02 ITENS 8 E 9 (0592700)         SEI 0008478-63.2018.6.02.8000 / pg. 6420



System — Events
Figure 9: System–Events

Events List: Displays a list of the current system events. Available information includes event severity, time of
occurrence, member information, and description.

Filter Events: The display dropdown and filter icon can be used to show/hide table columns and filter the results
based on the user-specified options. Select either tool to begin filtering.
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System — Stack
Figure 10: System–Stack

This view is only present on switch stacks.

Box Graphic: Displays each stack member physically.

• Used to view member information.

• The switch outlined in orange is the currently selected member.

• Data on the page reflects the selected member.

• The Box Graphic can be flipped to show either the front or back of the switch.

Fans: Displays member fan status.

Status:

• Green: The current system storage use is within normal range.

• Yellow: The current system storage use exceeds the warning threshold of 70%.

• Red: The current system storage use exceeds the critical threshold of 90%.

Storage: Displays system storage status.

Status:
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• Green: All fans are operating normally.

• Yellow: One or more fans have failed but the number of failures does not exceed 50% of all system fans.

• Red: At least 50% of the system fans have failed.

Temperature: Displays system temperature status.

Status:

• Green: The current system temperature is within normal range.

• Yellow: The current system temperature exceeds the warning threshold of <variable>. The threshold is based
on a user-controlled setting on the switch.

• Red: The current system temperature exceeds the critical threshold of <variable>. The threshold is based on
a user-controlled setting on the switch.

Power Supplies: Displays system power supply status.

Status:

• Green: All power supplies are operating normally.

• Yellow: One or more power supplies have failed but the number of failures does not exceed 40% of all system
power supplies.

• Red: At least 40% of the system power supplies have failed.

Stack Details: Displays system information regarding the stack including stack topology/configuration and
software version on all members.

Member Details: Displays status, MAC address, location and stack name.

CPU: Displays the current CPU usage of the selected stack member.

• The outer ring of the gauge indicates regions of normal, warning, and critical values.

• The peak value shown on the inner ring indicates the highest CPU usage reached for the device.

Status:

• Green: CPU usage is within normal range.

• Yellow: CPU usage exceeds the warning threshold of 75%.

• Red: CPU usage exceeds the critical threshold of 90%.

Memory: Displays current memory usage of the selected stack member.

• The outer ring of the gauge indicates regions of normal, warning, and critical values.

• The peak value shown on the inner ring indicates the highest memory usage reached for the device.

Status:
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• Green: Memory usage is within normal range.

• Yellow: Memory usage exceeds the warning threshold of 75%.

• Red: Memory usage exceeds the critical threshold of 90%.

Packet Buffers: Displays current packet buffer usage.

• The outer ring of the gauge indicates regions of normal, warning, and critical values.

• The peak value shown on the inner ring indicates the highest packet buffer usage reached for the device.

Status:

• Green: Packet buffer usage is within normal range.

• Yellow: Packet buffer usage exceeds the warning threshold of 85%.

• Red: Packet buffer usage exceeds the critical threshold of 95%.

Tx Drops: Displays current transmit drop rate.

• The outer ring of the gauge indicates regions of normal, warning, and critical values.

• The peak value shown on the inner ring indicates the highest transmit drop rate reached for the device.

Status:

• Green: Transmit drop rate is within normal range.

• Yellow: Transmit drop rate exceeds the warning threshold of 3% of transmit attempts.

• Red: Transmit drop rate exceeds the critical threshold of 5% of transmit attempts.

Message Buffers: Displays current message buffer usage.

• The outer ring of the gauge indicates regions of normal, warning, and critical values.

• The peak value shown on the inner ring indicates the highest message buffer usage reached for the device.

Status:

• Green: Message buffer usage is within normal range.

• Yellow: Message buffer usage exceeds the warning threshold of 75%.

• Red: Message buffer usage exceeds the critical threshold of 90%.

Rx Errors: Displays the current receive error rate.

• The outer ring of the gauge indicates regions of normal, warning, and critical values.

• The peak value shown on the inner ring indicates the highest receive error rate reached for the device.

Status:
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• Green: Receive error rate is within normal range.

• Yellow: Receive error rate exceeds the warning threshold of 2% of received frames.

• Red: Receive error rate exceeds the critical threshold of 5% of received frames.

System — Monitor
Figure 11: System–Monitor

Monitors up to six system metrics at a given time.

• Metrics include:

◦ CPU usage

◦ Memory usage

◦ Packet buffer usage

◦ Transmit drop rate

◦ Message buffer usage

◦ Receive error rate

• Metrics can be hidden from the graph by selecting the corresponding graph icon in the toolbar at the top of the
graph.

• Select and slide the minimap (the gray box at the bottom of the graph) to zoom in and out of the graph. You
can also focus in on a specific portion of the graph.

• Zooming in will provide a finer granularity of displayed data points, while zooming out will display fewer data
points.

Pause and Play Graph: Use the pause and play icons in the toolbar in the upper right corner of the graph to start
and stop the display of data points on the current graph.

• Pausing the graph will not pause the collection of system monitor data.

• Upon restarting the graph, the data points collected while the graph was paused will be filled in.
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Graph options: Select the Graph Settings icon in the upper right corner of the graph to:

• View system monitor graph options

• Select metrics to graph

• Show/hide system alerts

• Show/hide summary lines (maximum, minimum, and average)

The Metrics Statistics: Displays statistics for each of the currently graphed metrics. Statistics include average,
maximum, and minimum values for the metric.

System – SNMP
Figure 12: System–SNMP

Trap receivers: Displays all the trap receivers configured.

• Each card represents a trap receiver configured.

• To add a trap receiver, click the Add Trap Receiver (+) icon on the left side of the black panel.

• To edit a trap receiver, select the Edit Trap Receiver icon on the receiver card.

• To delete a trap receiver, select the Delete Trap Receiver icon on the receiver card.

• The interface offers different sorting options, which can be viewed by hovering over the sort icons. Select one
to apply the sort. Select the arrow next to the sort icons to switch between ascending and descending sorting.

• Different sorting options are available, which can be viewed by hovering over the sort icons. Select one to
apply the sort.

• Select the arrow next to the sort icons to switch between ascending and descending sort order.

IP Configuration: Displays the IP Configuration for the Trap Source and Trap Response. To edit either the Trap
Source or Trap Response, select the Edit Configuration icon in the upper right corner of the IP Configuration
panel.
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Community Names: Displays a list of all community names. To add a community name, select the Add
Community Name icon (+) in the upper right corner of the Community Names panel.

Community Info: Select a community name in the table to display it in the Community Info tile.

• To edit the community name, select the Edit Community Name icon in the upper right corner of the Community
Info tile.

• To delete a community name, select the Delete Community Name icon in the upper right corner of the
Community Info tile.

General Traps: Displays the traps supported and indicates whether each is enabled or disabled. To enable or
disable a trap:

1. Select the Edit General Traps icon in the upper right corner of the General Traps tile.

2. Check or clear the box to the right of the trap to enable or disable that trap.

3. Click Save or Cancel.

Link Status Change Trap: Select the Expand icon on the left of the panel to view a table of ports and their link
status change trap configurations.

• Use the page controls at the bottom of the table to navigate all the ports.

• If the Expand icon was previously selected, select the Collapse icon at the upper left of the panel to hide the
table.

• To edit the link status change trap configuration for a port, select the Edit Link Status Change Trap icon in the
upper right corner of the panel.

System – Firmware Update
Figure 13: System–Firmware Update

This functionality updates the device firmware with a file from the local system where the browser is being used.
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1. Select which image to update: primary or secondary.

2. Drag and drop a file onto the indicated area or click Choose File to browse for a file.

3. Click Upload File to initiate the upload.

Interfaces — Ports
Figure 14: Interfaces–Ports

Port List: Displays a list of all physical ports on the device. Use the pagination control at the bottom of the table to
page though the port list.

Box View: Visual representation of the physical view of the device including hardware status and ports.

• Active and disabled ports display the corresponding status indicator inside the port image.

• If a back of the box view is available, the option to view the back of the box displays in the toolbar at the top of
the page.

Filter Port Table: The display dropdown and filter icon can be used to show/hide table columns and filter the table
results based on the user-specified options. Select either tool to begin filtering.

Port Configuration: Configure a port by selecting the Edit Ports icon in the upper right corner of the toolbar at the
top of the table. The configuration panel opens to allow for port selection and option configuration.
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Interfaces — PoE
Figure 15: Interfaces–PoE

This view displays the PoE information for the switch. In a stack, the power information will not be displayed for
non-PoE switches.

• The box view and port table data is updated every 30 seconds.

• The detail view is updated every 3 seconds.

PoE Port List: Displays a list of all PoE physical ports on the device. Non-PoE ports are not shown. Use the
pagination control at the bottom of the table to page though the port list.

PoE Box View: Visual representation of the physical view of the device including hardware status and ports.
Active and disabled ports display the corresponding status indicator inside the port image.

PoE Port Details: The PoE Port Details panel provides detailed information on the configuration, power usage,
and statistics of a selected port. A port can be selected using the Box View or the port table.

Filter PoE Port Table: The display dropdown and filter icon can be used to show/hide table columns and filter the
table results based on the user-specified options. Select either tool to begin filtering.

PoE Port Configuration: Configure a port by selecting the Edit Ports icon in the upper right corner of the toolbar
at the top of the table. The configuration panel opens to allow for port selection and option configuration. By
default, the selected port will be edited.
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Interfaces — Monitor
Figure 16: Interfaces–Monitor

Interface Monitor Graph: Monitors up to six interface metrics at a given time.

• There are approximately two dozen metrics to choose from on any interface; all except utilization are
expressed as per-second rates (for example, frames/second).

• Metrics may be monitored on a single interface or across multiple interfaces. The total number monitored at
any juncture is limited to six or fewer.

• Only interfaces that are enabled and up may be selected.

• Metrics can be hidden from the graph by selecting the corresponding graph icon in the toolbar at the top of the
graph.

• Metric collection is started anew each time this view is entered.

Pause and Play Graph: Use the pause and play icons in the upper right corner of the graph to start and stop the
display of data points on the graph.

• Pausing the graph will not pause the collection of interface monitor data.

• Upon restarting the graph, the data points collected while the graph was paused will be filled in.

Graph Options: Select the Graph Settings icon in the upper right corner of the graph to select interfaces and
metrics to graph data for.
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Interfaces — VLANs
Figure 17: Interfaces–VLANs

VLAN Box View: Indicates which ports are members of the selected VLAN. Color and shape indicators are used
to differentiate between port types and membership. Editing port membership can also be done through the box
view.

Device VLAN Info: Displays the general VLAN information pertaining to the device.

VLAN Details: Displays a range of details regarding the selected VLAN. Select a VLAN by clicking it in the table.

All VLANs: Displays all configured VLANs on the device including information regarding each of the configured
VLANs. This information includes:

• Status

• IP information

• Port membership

Select a VLAN in the table to view more information.

Edit General VLAN Info: Configure VLAN properties on the device. Configuration options include:

• Setting the primary and management VLAN

• Enabling or disabling GVRP

• Setting the maximum number of VLANs

Edit VLAN: Edit the properties and port membership of an existing VLAN.

Create VLAN: Create a VLAN.

Delete VLAN: Delete an existing VLAN.

Chapter 4 ArubaOS-Switch UI 45

Anexo 02 ITENS 8 E 9 (0592700)         SEI 0008478-63.2018.6.02.8000 / pg. 6431



Edit VLAN via Box View: Select Ports in the box view to add or remove that port from the currently selected
VLAN. Use the dropdown option in the header to change the port type.

Magnify Box View: Magnify the box view to display up to six VLANs in a single port to view VLAN membership.
Double-click in the magnifier to cycle to the next VLAN if more than six are present. Press the Esc key to exit the
magnifier.

Interfaces — Trunks
Figure 18: Interfaces–Trunks

Trunk Table: Displays a list of active trunks on the device or the configured trunk groups.

• Active trunks are trunk groups that have ports assigned to them.

• Toggle between the active trunks and trunk groups by using the labeled button in the upper right corner of the
table.

Trunk Details: Displays details about a selected trunk. Select a trunk in the table to see its details.

Load Balancing: Displays the current load balancing algorithm configured on the switch.

• L2 - Uses the best MAC Source Address (MAC-SA) and MAC Destination Address (MAC-DA) information to
load balance traffic.

• L3 - Uses the best IP Source Address (IPSA) and IP Destination Address (IPDA) method to load balance IP
traffic, and MAC Source Address (MAC-SA) and MAC Destination Address (MAC-DA) to load balance non-IP
traffic.

• L4 - Uses the best L4 information (if present) or L3 information for IP traffic, or MAC Source Address (MAC-
SA) and MAC Destination Address (MAC-DA) for non-IP traffic.

Edit Load Balancing: Edit the configured load balancing algorithm on the device.
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Edit Trunks: Configure trunks on this device.

Traffic — Spanning Tree
Figure 19: Traffic–Spanning Tree

Spanning Tree Status: Displays whether spanning tree is enabled or disabled on the device.

Spanning Tree Mode: Displays the current spanning tree mode on the device:

• MSTP (Multiple Spanning Tree)

• RPVST (Rapid Per-VLAN Spanning Tree)

Loop Inconsistent Ports: Displays the list of loop inconsistent ports on the device detected by Loop Guard.

Root Inconsistent Ports: Displays the list of root inconsistent ports on the device detected by Root Guard.

Root Change History: Displays the last 10 root change events on the device.

• By default, a scatter plot chart will be shown representing the data on an hourly basis broken out per day.

• Use the icon in the upper right corner of this component to view the data in a standard table format.

Assigned Ports: Displays the ports assigned to a variety of spanning tree port types that are configurable
through the CLI. Types include:

• Loop Guard

• Root Guard

• TCN Guard

• BPDU Protected Ports

• BPDU Filtered ports

Topology Change Count: Displays the current topology change count on the device.

Time Since Last Change: Displays the time since that last topology change detected on the device.

MSTP Details: Displays the MSTP configuration identifiers on the device including the name, revision, and digest.
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Security — Clients
Figure 20: Security–Clients

Authentication Type Graph: Displays a graph that summarizes the use of authentication types used for client
authorization. Displays statistics like most used and least used authentication types.

User Role Graph: Displays a graph that summarizes the use of user roles associated with the connected clients.

Client Status Summary: Displays the total number of clients connected to the switch. Also displays client status
summary.

Client Details: Displays client-specific information such as:

• Physical port ID

• MAC address

• IP address

• Untagged and tagged VLANs

• User role session time

Connected Clients: Displays a list of all clients connected to the switch. Use the pagination controls at the
bottom of the page to move through the client list.

Filter Clients Table: The display dropdown and filter icon can be used to show/hide table columns and filter the
table results based on user-specified options. Select either tool to begin filtering.
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Security — User Roles
Figure 21: Security–User Roles

User Roles: Displays all user roles configured on the switch.

• Each card represents a user role configured.

• User role cards are clickable.

• You can sort the role cards by name or type.

• Click Apply the sort.

• Click the arrow to switch between ascending and descending sort orders.

User Role Information: Indicates whether the user role is enabled or disabled. Also displays the initial user role
configured on the switch.

User Role Card: Displays user role details such as:

• Name

• Type

• Policy

• VLAN

• Captive portal profile

• Reauthentication period
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Security — Intrusion Log
Figure 22: Security–Intrusion Log

Intrusion Log: Displays a list of the 20 most recent violation attempts detected on the device regardless of
whether the alert flags for these attempts have been reset.

Ports With Intrusion Flag: Displays a list of ports that have the intrusion flag set. The flag gets set when the
device detects a violation attempt on the listed port.

Reset Intrusion Flags: Reset all intrusion flags using the Reset Intrusion Flag button located in the upper right
corner of the log table.

Security — Port Security
Figure 23: Security–Port Security
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Port Security Table: Displays security properties for all ports on the device.

Properties include:

• Learn mode

• Address limit

• Violation action

Select a row in the table to see additional details about the port.

Learn Mode: Displays the selected ports learn mode.

Mode options include:

• Continuous

• Static

• Configured

• Port Access

• Limited

Additional information about what the assigned mode means can be seen following the mode type.

Authorized Address Limit: Displays the number of authorized addresses allowed on the port.

Authorized MAC Addresses: Displays the authorized MAC addresses allowed on the port.

Filter Port Table: Filter the port table by any of the available table columns.

Edit Port: Configure the port security properties on the selected port.

Security — IP Authorization
Figure 24: Security–IP Authorization
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IP Authorization Info: Displays the IP Authorization Info from the row selected in the IP Authorization Table. You
can edit the entry by selecting the drawing icon in the top right corner. You can also delete the entry by selecting
the garbage icon in the top right corner.

Total Single Station Entries with Manager Access: Displays the total number of entries in the IP Authorization
Table that have Manager Access Level and only apply to one computer. This is essentially all entries with a
subnet mask of 255.255.255.255 or 32 prefix length and have Manager Access Level.

Total Multiple Station Entries with Manager Access: Displays the total number of entries in the IP
Authorization Table that have Manager Access Level and apply to multiple computers. This is essentially all
entries with a subnet mask different from 255.255.255.255 or 32 prefix length and have Manager Access Level.

Total Single Station Entries with Operator Access: Displays the total number of entries in the IP Authorization
Table that have Operator Access Level and only apply to one computer. This is essentially all entries with a
subnet mask of 255.255.255.255 or 32 prefix length and have Operator Access Level.

Total Multiple Station Entries with Operator Access: Displays the total number of entries in the IP
Authorization Table that have Operator Access Level and apply to multiple computers. This is essentially all
entries with a subnet mask different from 255.255.255.255 or 32 prefix length and have Operator Access Level.

IP Authorized Management: Displays a table of all IP Authorized entries. You can add an entry by selecting the
add icon in the top right corner. To edit or delete an entry, use the icons in the IP Authorization Info tile.

Configurations — Config Report
Figure 25: Configurations–Config Report

Running Configuration: Displays the current running configuration as shown in the show running-config
CLI command.

Expand and collapse nodes in the running configuration by selecting the + and - icons next to a node that has
content underneath it.
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Configurations — Management
Figure 26: Configurations–Management

Download: Downloads the selected configuration file from the device to the local system where the browser is
being used.

Delete: Deletes the selected configuration file from the device. A confirmation window is displayed because after
a file is deleted it cannot be recovered.

Rename: Renames the selected configuration file to a new name. A field is displayed in which the new name may
be entered. When done, Click Save or Cancel.

Update: Updates an existing device configuration file or uploads a new configuration file from the local system
where the browser is being used. A confirmation window is displayed because after the upload begins it cannot
be aborted.

Procedure

1. Drag and drop a file onto the indicated area or click the button to browse for a file to be uploaded.

2. Specify which configuration file is to be updated (existing or new). If using a new file, the name of the file on
the local system will be used.

3. Click Update to initiate the upload.

4. A confirmation window displays because after the upload begins, it cannot be aborted.
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Overview of Preview Mode
Preview mode feature is available only when preview mode is enabled on a switch. The intent of having features
in preview mode is to allow users to experiment the features and solicit early feedback from them.

Use the features in a preview mode at your own risk. When you enable preview mode on a switch, you are
prompted before entering the preview mode. On confirmation, the prev-mode is prefixed with the switch
configuration prompt.

For example:

(Prev-mode) switch(config)#

The existing configuration for a switch continues even after you enable preview mode.

When you exit the preview mode, you are prompted to reboot the switch. Rebooting the switch reverts the switch
to a configuration that existed prior to enabling preview mode.

Supported Platforms

Aruba 2930F
Aruba 5400R
Aruba 3810M

Enabling Preview Mode
Procedure

Use the CLI command to enable the preview mode on the switch.

Syntax
preview-mode
Description

Enter preview mode on the switch. You can now configure the features in preview mode. Exiting the preview
mode reboots the switch to a configuration, that existed prior to enabling the preview mode.

Example output
switch(config)# preview-mode
ATTENTION: You are entering preview mode on this product. This mode, the
commands, features and functionality specific to this mode, and all output
from this mode are Hewlett Packard Enterprise Confidential and Proprietary.
You may use this mode at your own risk. Any defects or issues encountered
in this mode will be addressed per Hewlett Packard Enterprise's discretion.

Chapter 5
Operating in Preview Mode
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Continue (y/n)? y
Prev-mode)switch(config)#

Viewing features in Preview Mode
Procedure

Use the CLI command to view the features in a preview mode.

Syntax
show preview-mode
Description

Displays the list of features in preview mode.

Parameters
features
Displays the features in a preview mode.

Example output
(Prev-mode)switch(config)# show preview-mode
 features              Show the features under preview mode.
(Prev-mode)switch(config)# show preview-mode features
 Features in Preview Mode:
 Multicast Offload Engine  Enable/Disable multicast offload engine for routed
                           multicast IPv4 traffic.
                           Usage:
                           fabric-offload multicast ipv4 route

Multicast Offload Engine
In the current release, enabling Multicast Offload Engine (MOE) to route multicast IPv4 traffic is the only feature
supported on the switch in a preview mode.

Procurve switches without MOE enabled, use ingress replication to send multicast traffic to multiple destinations.
The processes such as request, reply, or forward are repeated for every destination node chip. Thus, it results in
sending the packet over the ingress node’s fabric interface once for each destination node. To overcome this
problem, MOE is enabled.

There is a significant improvement in the performance, as enabling MOE prevents sending multiple copies of the
packet across the ingress node chip’s fabric interface. When you enable MOE, the request or reply process to
each destination node chip still occurs, but the packet is forwarded once to the fabric chip, and the fabric chip
replicates the packet to all other destination nodes that has to receive the packet.

In the current release, MOE is enabled only to route multicast IPv4 packets.

As the feature is available for experiment purpose, it has the following limitations:

• You cannot use MOE with VSF.

• You cannot enable MOE on jumbo-enabled VLANs.
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Supported Platform

Aruba 5400R v3 standalone

Enabling MOE
Procedure

Use the CLI command to enable MOE for IPv4 multicast traffic. The running-config file displays the MOE
enabled for IPv4 traffic.

Syntax
fabric-offload multicast ipv4 route {enable|disable}
Description

Enable or disable multicast offload engine for routed multicast IPv4 traffic.

Usage
fabric-offload multicast ipv4 route {enable|disable}
Example output
(Prev-mode)switch# show running-config

Running configuration:

; J9851A Configuration Editor; Created on release #KB.16.01.0000x
; Ver #0a:19.f4.7b.ff.ff.fc.ff.ff.3f.ef:b0 
hostname "HP-5412Rzl2" 
module A type j9992a
module L type j9987a
fabric-offload multicast ipv4 route enable
ip routing
ip multicast-routing
snmp-server community "public" unrestricted
oobm
ip address dhcp-bootp
exit
vlan 1
name "DEFAULT_VLAN"
untagged A1-A21,L1-L24
ip address dhcp-bootp
exit
no allow-v2-modules
preview-mode 

56 Aruba Basic Operation Guide for ArubaOS-Switch 16.05

Anexo 02 ITENS 8 E 9 (0592700)         SEI 0008478-63.2018.6.02.8000 / pg. 6442



Listing available commands

Procedure

1. Type ? to list available commands. Typing the ? symbol lists the commands you can execute at the current
privilege level.

2. The commands that are available to a user depend on the user’s privilege level. At a given privilege level, you
can list and execute the commands that the privilege level offers, plus all commands available at preceding
levels.

3. When - - MORE - - appears, there are more commands in the listing. Do one of the following:

a. To list the next screen of commands, press the Space bar.

b. To list the remaining commands one-by-one, repeatedly press [Enter].

The following example shows the result of typing? at the Operator level. You can list and execute only the
Operator-level commands at the Operator level.

Figure 27: The Operator-level command listing

switch> ?
 chassislocate         Control the chassis locate led.
 dir                   Display a list of the files and subdirectories in a
                       directory on a USB device.
 display               Display current system information.
 enable                Enter the Manager Exec context.
 exit                  Return to the previous context or terminate current
                       console/telnet session if you are in the Operator
                       context level.
 link-test             Test the connection to a MAC address on the LAN.
 logout                Terminate this console/telnet session.
 menu                  Change console user interface to menu system.
 page                  Toggle paging mode.
 ping                  Send IPv4 ping request(s) to a device on the network.
 ping6                 Send IPv6 ping request(s) to a device on the network.
 quit                  Exit from current command view
 services              Display parameters for the services module.
 show                  Display switch operation information.
 traceroute            Trace the IPv4 route to a device on the network.
 traceroute6           Trace the IPv6 route to a device on the network.
 verify                Verify the signature of a switch firmware image.
 wireless-services     Display parameters for the wireless-services module.
-- MORE --, next page: Space, next line: Enter, quit: Control-C

Chapter 6
Using the Command Line Interface (CLI)
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The following example shows the result of typing? at the Manager level. At this level, you can list and execute
commands that are available at both the Operator and Manager levels. Typing ? at the Global Configuration level
or the Context Configuration level produces similar results.

Figure 28: The Manager-level command listing

switch# ?
 backup                Backup next startup-configuration file to TFTP server
 boot                  Reboot the device.
 clear                 Clear table/statistics.
 clock                 Display/set current time, date, and local time
                       parameters.
 command-alias         Specify command alias
 configure             Enter the Configuration context.
 copy                  Copy datafiles to/from the switch.
 debug                 Enable/disable debug logging.
 delete                Delete a file
 diagnostic-level      Set the diagnostic level.
 end                   Return to the Manager Exec context.
 erase                 Erase stored data files.
 getMIB                Retrieve and display the value of the MIB objects
                       specified.
 getNextMIB            Retrieve and display the value of the next MIB object
                       for each OID specified
 kill                  Kill other active console, Telnet, or SSH sessions.
 licenses              Manage premium features.
 log                   Display log events.
 print                 Execute a command and redirect its output to the device
                       channel for current session.
-- MORE --, next page: Space, next line: Enter, quit: Control-C
  

Listing command options
Procedure

Enter command keywords followed by ? to display command options.

For example, suppose you want to see the command options for configuring the console settings:

switch(config)# console ?
 baud-rate             Set the data transmission speed for the device connect
                       sessions initiated through the Console port.
 events                Set level of the events displayed in the device's Events
                       Log.
 flow-control          Set the Flow Control Method; default is xon-xoff.
 idle-timeout          The number of seconds of no activity detected before the
                       switch terminates a session.
 inactivity-timer      [Deprecated] Set the number of minutes of no activity
                       detected before the switch terminates a communication
                       session.
 local-terminal        Set type of terminal being used for the current console
                       or Telnet session (default is vt100).
 screen-refresh        Set refresh time for menu status and counters in
                       seconds.
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 terminal              Set type of terminal being used for all console and
                       Telnet sessions (default is vt100).

Displaying CLI “Help”
Do one of the following:

Procedure

1. Type “help” to display a list of commands that includes a brief summary of each command’s purpose.
The list includes all commands available at the current privilege level. That is, at the Operator level, executing
help displays the Help summaries only for Operator-Level commands. At the Manager level, executing help

displays the Help summaries for both the Operator and Manager levels, and so on.

2. Type a command string followed by “help” to display detailed information about how to use an individual
command. Use the following syntax:

<command-string> help
Help is displayed for any command that is available at the current privilege level. An “Invalid input” message is
displayed if you try to list the help for an individual command from a privilege level that does not include that
command.

The following example shows the result of typing “help” at the Operator privilege level. The Operator-Level
commands are listed with their purposes.

Figure 29: Help for Operator-Level commands

switch> help

 chassislocate         Control the chassis locate led.
 dir                   Display a list of the files and subdirectories in a
                       directory on a USB device.
 display               Display current system information.
 enable                Enter the Manager Exec context.
 exit                  Return to the previous context or terminate current
                       console/telnet session if you are in the Operator
                       context level.
 link-test             Test the connection to a MAC address on the LAN.
 logout                Terminate this console/telnet session.

The following example shows Help for the interface command at the Global Configuration privilege level:

Figure 30: Detailed Help for a specific command

switch(config)# interface help
Usage: no interface < [ethernet] PORT-LIST [...] | loopback <num> >

Description: Enter the Interface Configuration Level, or execute one
             command for that level. Without optional parameters
             specified, the 'interface' command changes the context to
             the Interface Configuration Context Level for execution of 
             configuration changes to the port or ports in the PORT-LIST
             or with loopback keywork it will change context to loopback
             mode. Use 'interface ?' to get a list of all valid commands.
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Note that trying to list the help for an individual command from a privilege level that does not include that
command results in an error message. For example, trying to list the help for the interface command while at the
global configuration level produces this result:

switch# speed-duplex help
Invalid input: speed-duplex

Enabling and disabling CLI message prefixes
When message prefixes are enabled, a CLI command returns a message that is prefixed with “Error”, “Warning”,
or “Information” to indicate the type of message.

Procedure

1. Type “session show-message-type enable” to enable the display of prefixes with the returned message.

2. Type “session show-message-type disable” to disable the display of prefixes with the returned message.

The syntax is as follows:

session show-message-type [enable|disable]
The message prefixes setting is not saved when the switch is rebooted. The message prefixes are disabled on all
CLI sessions by default.

The following example shows returned messages of each of the three message types.

Figure 31: Message prefixes

switch(config)# router rip
Error: IP Routing support must be enabled first.

switch(config)# qinq mixed vlan
Warning: This command will reboot the device. Any prior configuration
on this config file will be erased and the device will boot up with a
default configuration
for the new qinq mode.
Do you want to continue [y/n]? n

switch(config)# snmp-server mib hpSwitchAuthMIB included
Information: For security reasons, network administrators are
encouraged to disable SNMPv2 before using the MIB.
To determine if message labeling is enabled, enter the show session command.

Figure 32: The label cli-return-message command enabled

switch(config)# show session
show message type   : Enabled
cli interactive mode: Enabled

Enabling and disabling CLI interactive command mode
When the CLI interactive command mode is enabled, you must explicitly enter the choice of yes (‘y’) or no (‘n’) for
interactive commands. When interactive command mode is disabled, you are not prompted to explicitly enter the
choice of yes (‘y’) or no (‘n’) unless you are saving a configuration.
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Procedure

1. Type “session interactive-mode enable” to enable the CLI interactive command mode.

2. Type “session interactive-mode disable” to disable the CLI interactive command mode.

The syntax is as follows:

session interactive-mode [enable|disable]
The interactive–mode setting is not saved when the switch is rebooted. The interactive mode is enabled on all CLI
sessions by default.

The following example shows some commands used with the CLI interactive command mode disabled.

Figure 33: CLI interactive mode when disabled

switch(config)# no password all
Password protection for all will be deleted, continue [y/n]? y

switch(config)# boot system flash secondary
System will be rebooted from secondary image.
Do you want to continue [y/n]? y
Do you want to save current configuration [y/n]? n

To determine if the CLI interactive mode is enabled or disabled, enter the show session command.

Figure 34: CLI interactive mode enabled

switch(config)# show session
show message type   : Enabled
cli interactive mode: Enabled

Interactive commands requiring additional options
Interactive commands that require input other than yes or no are not affected when CLI interactive mode is
disabled. A warning message is displayed when these commands are executed, for example:

Interactive mode is disabled; This command will be ignored. 
Enable cli-interactive-mode to use this command.
The following commands will issue this warning when interactive mode is disabled. An alternate way to enter the
command (when one is available) is shown.

Command Non-Interactive Alternate Command

setup mgmt-interfaces
No equivalent non-interactive command

aaa port-access supplicant 
<port-list> secret

aaa port-access supplicant <port-list> secret 
<secret-string>

password manager password manager plaintext <password-string>

password operator password operator plaintext <password-string>

Table Continued
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Command Non-Interactive Alternate Command

aaa port-access supplicant 
<port-list> secret

aaa port-access supplicant <port-list> secret 
<secret-string>

crypto host-cert generate 
self-signed

crypto host-cert generate self-signed <start-date> <end-date> <CNAME-STR> <ORG-
UNIT-STR> <ORGANIZATION-STR> <CITY-STR> <STATE-STR> <CODE>

Menu commands
When CLI interactive mode is disabled, all CLI commands that launch the menu interface are not affected by the
interactive mode. A warning message is displayed, for example:

switch(config)# menu
Interactive mode is disabled; This command will be ignored.
Enable cli-interactive-mode to use this command.

Other menu-based commands that will not be affected are:

• setup

• show interfaces display

SNMPv3 special cases
The following are special cases when using SNMPv3 with interactive mode.

• snmpv3 user:

In interactive mode, the command snmpv3 user will create snmpv3 users, even if snmpv3 has not been
enabled.

• snmpv3 user:

When interactive mode is disabled, this command only enables snmpv3. It does not prompt for an
authentication password. When the command is first executed, a default initial user is created. A message
displays:

User ‘initial’ has been created.

Simplifying entry of commands at the command line
Do one or more of the following to simplify entry of commands:

Procedure

1. To find or complete a command, use the [TAB] key.

See Finding or completing a command on page 63

2. To re-execute a command, use the redocommand.

See redo on page 64

3. To repeatedly re-execute one or more commands, use the repeat command.
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See repeat on page 64

4. To create a shortcut name for a command to simplify keystrokes, use the alias command.

See alias on page 65

5. To simplify movement or placement of your cursor at the command line, use the shortcut keystrokes. See
CLI shortcut keystrokes on page 67

Finding or completing a command

Procedure

1. Type one or more consecutive characters of a command and then press
[Tab] (with no spaces allowed) to find a CLI command or to quickly complete a CLI command name. The CLI
completes the current command name, including hyphenated extensions, if you have typed enough characters
for the CLI to distinguish it from other possibilities.

2. The following example shows the result when you press
[Tab] immediately after typing “t” at the Global Configuration level. The CLI displays the available command
options that begin with “t”.

switch(config)# t
 tacacs-server
 telnet-server
 tftp
 time
 timesync
 trunk
 trunk-load-balance
 task-monitor
 telnet
 terminal
 test
 traceroute
 traceroute6

3. The following example shows the result when you press
[Tab] immediately after typing “port-”.

switch (config)# port-
switch (config)# port-security

4. The following example shows the result of pressing
[Tab] after a completed command word lists the further options for that command. In this example, entering

switch(config)# qos[Tab]
          
displays the following:

switch (config)# qos
 udp-port              Set UDP port-based priority.
 tcp-port              Set TCP port-based priority.
 device-priority       Configure device-based priority for a particular IP
                       address.
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 dscp-map              Define mapping between a DSCP (Differentiated-Services
                       Codepoint) value and an 802.1p priority.
 protocol              Configure protocol-based priority.
 queue-config          Configure the number of egress priority queues for each
                       port.
 type-of-service       Configure the Type-of-Service method the device uses to
                       prioritize IP traffic.
 watch-queue           Enables monitoring of per-queue dropped packets due to
                       outbound congestion on the given port.

redo
Syntax
redo [ <number> | <command-str> ]
Description

Parameters/Options/Flags/Strings/...

The redo command re-executes a command. The last command that was used is executed by default.

Specifiers
<number>

Specifies the position of the command in the history list. When the position is specified, the nth command
starting from the most recent command in the history is executed.

<command-str>
Specifies the name of a previously executed command. The most recently executed command whose name
matches the specified string is executed.

Example

This example shows the use of the redo command.

switch(config)# show history
2       show arp
1       show flash

switch(config)# redo 2

  IP ARP table

   IP Address     MAC Address     Type      Port
   -------------  --------------  --------  ----
   15.255.128.1   00000c-07ac00   dynamic   A11 

repeat
Syntax
repeat [cmdlist] [count] [delay]
Description

The repeat command repeatedly re-executes one or more commands. By default, the most recent command in
the history is executed until a key is pressed.

Options
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[cmdlist]
Specifies the position of a command, or range of positions of multiple commands, in the history list. The nth
most recent commands in the history, where "n" is the position in the history list, are re-executed.

[count]
Specifies number of times to execute the command or commands.

[delay]
Specifies a delay. The execution of the command is delayed for the number of seconds specified.

Usage
switch(config)# repeat 1-4,7-8,10 count 2 delay 3
Example

This demonstrates the use of the repeat command to re-execute commands that are at positions 1 through 2 in
the command history.

switch(config)# show history
3        show ver
2        show ip
1        show arp

switch(config)# repeat 1-2

  IP ARP table

   IP Address      MAC Address       Type      Port
   --------------  ----------------  --------  ----
   15.255.128.1    000000-000000     dynamic

Internet (IP) Service

IP Routing : Disabled

Default Gateway :
Default TTL     : 64
Arp Age         : 20
Domain Suffix   :
DNS server      :

VLAN               | IP Config   IP Address      Subnet Mask    Proxy ARP
------------------ + ----------- --------------- -------------- ---------
DEFAULT_VLAN       | DHCP/Bootp  15.255.131.90   255.255.248.0  No No

alias
Syntax
alias <name> <command>
no alias <name> <command>
Description

The alias command creates a shortcut alias name that can be used in place of a CLI command to simplify
keystrokes and aid memory. The alias command is executed from the current configuration context.
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Options
no

Specifies that the alias for the command is to be removed.

Specifiers
<name>

Specifies the alias for the CLI command. The alias name must not be an existing CLI command.

<command>
Specifies an existing CLI command for which to create the alias. The command must be enclosed in quotes.

It is recommended that you use an alias that does not have an existing tab completion in the CLI. For
example, using an alias that starts with "show" or "int" would complete to "show" and "interface" respectively
when you use the tab completion function.

Privilege

The alias command is executed from the current configuration context (operator, manager, or global). If the
command that is aliased has to be executed in the global configuration context, you must execute the alias for
that command in the global configuration context. This prevents bypassing the security for a particular context.

Restrictions

• The alias name must not be an existing CLI command. Existing CLI commands are searched before looking
for an alias command; an alias that is identical to an existing command will not be executed.

• Hewlett Packard Enterprise recommends that you configure no more than 128 aliases.

Example

This example shows the creation and use of an alias for the show int custom command to demonstrate how a
command alias can simplify keystrokes when entering a command. The actual show int custom command is
used first and then an alias is created for it and then used.

switch(config)# show int custom 1-4 port name:4 type vlan intrusion speed
enabled mdi

 Status and Counters - Custom Port Status

                               Intrusion
Port Name     Type       VLAN  Alert     Speed   Enabled MDI-mode
---- -------- ---------- ----- --------- ------- ------- -------
1    Acco     100/1000T  1     No        1000FDx Yes     Auto
2    Huma     100/1000T  1     No        1000FDx Yes     Auto
3    Deve     100/1000T  1     No        1000FDx Yes     Auto
4    Lab1     100/1000T  1     No        1000FDx Yes     Auto

switch(config)# alias sic "show int custom 1-4 port name:4 type vlan intrusion
speed enabled mdi"
switch(config)#

switch(config)# sic 

Status and Counters - Custom Port Status

                               Intrusion
Port Name     Type       VLAN  Alert     Speed   Enabled MDI-mode
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---- -------- ---------- ----- --------- ------- ------- -------
1    Acco     100/1000T  1     No        1000FDx Yes     Auto
2    Huma     100/1000T  1     No        1000FDx Yes     Auto
3    Deve     100/1000T  1     No        1000FDx Yes     Auto
4    Lab1     100/1000T  1     No        1000FDx Yes     Auto

CLI shortcut keystrokes

Keystrokes Functions

[Ctrl] [A] Jumps to the first character of the command line.

[Ctrl] [B] or ‘←’ Moves the cursor back one character.

[Ctrl] [C] Terminates a task and displays the command prompt.

[Ctrl] [D] Deletes the character at the cursor.

[Ctrl] [E] Jumps to the end of the current command line.

[Ctrl] [F] or ‘→’ Moves the cursor forward one character.

[Ctrl] [K] Deletes from the cursor to the end of the command line.

[Ctrl] [L] or [Ctrl] [R] Repeats current command line on a new line.

[Ctrl] [N] or ‘↓’ Enters the next command line in the history buffer.

[Ctrl] [P] or ‘↑’ Enters the previous command line in the history buffer.

[Ctrl] [U] or [Ctrl] [X] Deletes from the cursor to the beginning of the command line.

[Ctrl] [W] Deletes the last word typed.

[Esc] [B] Moves the cursor backward one word.

[Esc] [D] Deletes from the cursor to the end of the word.

[Esc] [F] Moves the cursor forward one word.

[Backspace] Deletes the first character to the left of the curser in the command line.

[Spacebar] Moves the cursor forward one character.

Overview of the CLI
The CLI is a text-based command interface for configuring and monitoring the switch. The CLI gives you access
to the switch’s full set of commands while providing the same password protection that is used in the web browser
interface (WebAgent) and the menu interface.

Access

Like the menu interface, the CLI is accessed through the switch console, and in the switch’s factory default state,
is the default interface when you start a console session. You can access the console out-of-band by directly
connecting a terminal device to the switch, or in-band by using Telnet either from a terminal device or through the
WebAgent.
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Also, if you are using the menu interface, you can access the CLI by selecting the Command Line (CLI) option in
the Main Menu.

Privilege levels

The CLI offers these privilege levels to help protect the switch from unauthorized access:

1. Operator

2. Manager

3. Global Configuration

4. Context Configuration

CLI commands are not case-sensitive.

When you use the CLI to make a configuration change, the switch writes the change to the Running-Config file in
volatile memory. This allows you to test your configuration changes before making them permanent. To make
changes permanent, you must use the write memory command to save them to the Startup-Config file in non-
volatile memory. If you reboot the switch without first using write memory, all changes made since the last reboot
or write memory (whichever is later) will be lost.

More information

Configuring the switch on page 76.

Privilege levels for CLI access

Privilege levels at log on
Privilege levels control the type of access to the CLI. To implement this control, you must set at least a Manager
password. Without a Manager password configured, anyone having serial port, Telnet, or web browser
access to the switch can reach all CLI levels. (For more on setting passwords, See the usernames and
passwords in the Access Security Guide for your switch.)

When you use the CLI to log on to the switch, and passwords are set, you will be prompted to enter a password.
For example:

CLI log-on screen with password(s) set

switch
Software revision K.15.12.0001

Copyright (C) 1991-2013 Hewlett-Packard Development Company, L.P.

                      RESTRICTED RIGHTS LEGEND
Confidential computer software.  Valid license from HP required for possession,
use or copying. Consistent with FAR 12.211 and 12.212, Commercial Computer
Software, Computer Software Documentation, and Technical Data for Commercial
Items are licensed to the U.S. Government under vendor's standard commercial
license.
                     HEWLETT-PACKARD DEVELOPMENT COMPANY, L.P.
                   20555 State Highway 249, Houston, TX 77070

We'd like to keep you up to date about:
  * Software feature updates
  * New product announcements
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  * Special events
Please register your products now at:  www.hp.com/networking/register

Username:
In the above case, you will enter the CLI at the level corresponding to the password you provide (operator or
manager).

If no passwords are set when you log on to the CLI, you will enter at the Manager level. For example:

switch# _

Hewlett Packard Enterprise strongly recommends that you configure a Manager password. If a
Manager password is not configured, then the Manager level is not password-protected, and anyone
having in-band or out-of-band access to the switch may be able to reach the Manager level and
compromise switch and network security. Note that configuring only an Operator password does not
prevent access to the Manager level by intruders who have the Operator password.

Pressing the Clear button on the front of the switch removes password protection. For this reason,
it is recommended that you protect the switch from physical access by unauthorized persons.
If you are concerned about switch security and operation, you must install the switch in a secure
location, such as a locked wiring closet.

Privilege level operation
The access sequence for the various privilege levels is shown in Figure 35: Access sequence for privilege
levels on page 69.

Figure 35: Access sequence for privilege levels

You can move between the privilege levels. The following table lists examples and results of movement between
the privilege levels.
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Change in Levels Example of Prompt, Command, and Result

Operator level to Manager level
switch> enable

Password:_

switch#_

After you enter enable, the
Password prompt appears. After
you enter the Manager
password, the system prompt
appears with the # symbol:

Manager level to Global
configuration level switch# config

switch(config)#

Global configuration level to a
Context configuration level switch(config)# vlan 10

switch(vlan-10)#

Context configuration level to
another Context configuration
level

switch(vlan-10)# interface e 3

switch(int-3)#

The CLI accepts "e" as the
abbreviated form of "ethernet".

Move from any level to the
preceding level switch(int-3)# exit

switch(config)# exit

switch# exit

switch>

Move from any level to the
Manager level switch(int-3)# end

switch#
-or-

switch(config)# end

switch#

Moving between the CLI and the Menu interface. When moving between interfaces, the switch retains the
current privilege level (Manager or Operator). That is, if you are at the Operator level in the menu and select the
Command Line Interface (CLI) option from the Main Menu, the CLI prompt appears at the Operator level.

Changing parameter settings. Regardless of which interface is used (CLI, menu interface, or WebAgent), the
most recently configured version of a parameter setting overrides any earlier settings for that parameter. For
example, if you use the menu interface to configure an IP address of "X" for VLAN 1 and later use the CLI to
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configure a different IP address of "Y" for VLAN 1, then "Y" replaces "X" as the IP address for VLAN 1 in the
running-config file. If you subsequently execute write memory in the CLI, then the switch also stores "Y" as the
IP address for VLAN 1 in the startup-config file. (For more on the startup-config and running config files, see
"Switch Memory and Configuration".)

Operator privileges
At the Operator level, you can examine the current configuration and move between interfaces without being able
to change the configuration. A ">" character delimits the Operator-level prompt. For example:

switch>_

(Example of the Operator prompt.)

When using enable to move to the Manager level, the switch prompts you for the Manager password if one has
already been configured.

Manager privileges
Manager privileges give you three additional levels of access: Manager, Global Configuration, and Context
Configuration. A "#" character delimits any Manager prompt. For example:

switch#_

(Example of the Manager prompt.)

Manager level:

Provides all Operator level privileges plus the ability to perform system-level actions that do not require saving
changes to the system configuration file. The prompt for the Manager level contains only the system name and
the "#" delimiter, as shown above. To select this level, enter the enable command at the Operator prompt and
enter the Manager password, when prompted. For example:

switch> enable
Password:
switch# _ 

Enter enable at the Operator prompt. CLI prompt for the
Manager password. The Manager prompt appears after the
correct Manager password is entered.

Global configuration level:

Provides all Operator and Manager level privileges, and enables you to make configuration changes to any of the
switch’s software features. The prompt for the Global Configuration level includes the system name and "(config)".
To select this level, enter the config command at the Manager prompt. For example:

switch# config
switch(config)#_

Enter config at the Manager prompt. The Global Config
prompt.

Context configuration level:

Provides all Operator and Manager privileges, and enables you to make configuration changes in a specific
context, such as one or more ports or a VLAN. The prompt for the Context Configuration level includes the
system name and the selected context. For example:

switch(eth-1)#
switch(vlan-10)#
The Context level is useful, for example, for executing several commands directed at the same port or VLAN, or if
you want to shorten the command strings for a specific context area. To select this level, enter the specific context
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at the Global Configuration level prompt. For example, to select the context level for an existing VLAN with the
VLAN ID of 10, you would enter the following command and see the indicated result:

switch(config)# vlan 10
switch(vlan-10)#

Table 4: Privilege level hierarchy — Operator Privilege

Privilege Level Example of Prompt and Permitted Operations

Operator Level
switch> show <command> setup

View status and configuration
information.

ping <argument>

link-test <argument>

Perform connectivity tests.

enable
Move from the CLI interface to the menu
interface.

Use enable at the
Operator level to move to
the Manager level.

menu
Move from the CLI interface to the menu
interface.

logout
Exit from the CLI interface and terminate
the console session.

exit
Terminate the current session (same as
logout).
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Table 5: Privilege level hierarchy — Manager Privilege

Privilege Level Example of Prompt and Permitted Operations

Manager Level
switch#

Perform system-level actions such as system
control, monitoring, and diagnostic commands,
plus any of the Operator-level commands. For a
list of available commands, enter ? at the
prompt.

Global Configuration Level
switch(config)#

Execute configuration commands, plus all
Operator and manager commands. For a list of
available commands, enter ? at the prompt.

Context Configuration Level
switch(eth-5)#

switch(vlan-100)#

Execute context-specific configuration
commands, such as a particular VLAN or switch
port. This is useful for shortening the command
strings you type, and for entering a series of
commands for the same context. For a list of
available commands, enter ? at the prompt.

Configuration commands and context configuration
modes
You can execute any configuration command in the global configuration mode or in selected context modes.
However, using a context mode enables you to execute context-specific commands faster, with shorter command
strings.

The switch offers interface (port or trunk group) and VLAN context configuration modes:

Port or trunk-group context. Includes port-or trunk-specific commands that apply only to the selected port(s) or
trunk group, plus the global configuration, Manager, and Operator commands. The prompt for this mode includes
the identity of the selected port(s):

switch(config)# interface c3-c6
switch(eth-C5-C8)#
switch(config)# interface trk1
switch(eth-Trk1)#
Commands executed at configuration level for entering port and trk1static trunk-group contexts, and
resulting prompts showing port or static trunk contexts.

switch(eth-C5-C8)#
switch(eth-Trk1)#
switch(eth-C5-C8)# ?
switch(eth-C5-C8)# ?
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Lists the commands you can use in the port or static trunk context, plus the Manager, Operator, and
context commands you can execute at this level.

Figure 36: Context-specific commands affecting port context

VLAN context. Includes VLAN-specific commands that apply only to the selected VLAN, plus Manager and
Operator commands. The prompt for this mode includes the VLAN ID of the selected VLAN. For example, if you
had already configured a VLAN with an ID of 100 in the switch:

switch(config)# vlan 100
Command executed at configuration level to enter VLAN 100 context.

switch(vlan-100)#
Resulting prompt showing VLAN 100 context.

switch(vlan-100)# ?
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Lists commands you can use in the VLAN context, plus Manager, Operator, and context commands you
can execute at this level.

Figure 37: Context-specific commands affecting VLAN context
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Using the CLI to implement configuration changes
The CLI offers these capabilities for implementing configuration changes:

Procedure

1. Access to the full set of switch configuration features

2. The option of testing configuration changes before making them permanent

How to use the CLI to view the current configuration files. Use show commands to view the configuration for
individual features, such as port status or Spanning Tree Protocol. However, to view either the entire startup-
config file or the entire running-config file, use the following commands:

• show config

Displays a listing of the current startup-config file.

• show running–config

Displays a listing of the current running-config file.

• write terminal

Displays a listing of the current running-config file.

• show default–config

Displays a listing of a custom default config file.

• show config status

Compares the startup-config file to the running-config file and lists one of the following results:

◦ If the two configurations are the same, you will see:

Running configuration is the same as the startup configuration.

◦ If the two configurations are different, you will see:

Running configuration has been changed and saved.

show config, show running–config, and write terminal commands display the configuration
settings that differ from the switch’s factory default configuration.

How to use the CLI to reconfigure switch features. Use this procedure to permanently change the switch
configuration (that is, to enter a change in the startup-config file).

Chapter 7
Configuring the switch

76 Aruba Basic Operation Guide for ArubaOS-Switch 16.05

Anexo 02 ITENS 8 E 9 (0592700)         SEI 0008478-63.2018.6.02.8000 / pg. 6462



1. Use the appropriate CLI commands to reconfigure the desired switch parameters. This updates the selected
parameters in the running-config file.

2. Use the appropriate show commands to verify that you have correctly made the desired changes.

3. Observe the switch’s performance with the new parameter settings to verify the effect of your changes.

4. When you are satisfied that you have the correct parameter settings, use the write memory command to copy
the changes to the startup-config file.

The write memory command saves the running configuration file to the startup-config. The saved configuration
becomes the boot-up configuration of the switch on the next boot.

When using redundant management, saves the running configuration of the switch to flash on the active
management module. The saved configuration becomes the boot-up configuration of the switch the next time it is
booted. The saved configuration file is synchronised to the standby management module.

Note: If the active management module and the standby management module are running on different operating
systems because the boot set-default command was executed and then the standby module was rebooted, the
write memory command displays this warning: "Warning: The next reboot or failover is set to boot from a
different software image. These config changes may be incompatible or not used after a reboot or failover."

For example, the default port mode setting is auto. Suppose that your network uses Cat 3 wiring and you want to
connect the switch to another autosensing device capable of 100 Mbps operation. Because 100 Mbps over Cat 3
wiring can introduce transmission problems, the recommended port mode is auto-10, which allows the port to
negotiate full- or half-duplex, but restricts speed to 10 Mbps. The following command configures port A5 to
auto-10 mode in the running-config file, allowing you to observe performance on the link without making the mode
change permanent.

switch(config)# interface e a5 speed-duplex auto-10
After you are satisfied that the link is operating properly, you can save the change to the switch’s permanent
configuration (the startup-config file) by executing the following command:

switch(config)# write memory
The new mode (auto-10) on port A5 is now saved in the startup-config file, and the startup-config and running-
config files are identical. If you subsequently reboot the switch, the auto-10 mode configuration on port A5 will
remain because it is included in the startup-config file.

Beginning with K.15.01.0031, configuration changes to ports may require up to 10 seconds to take
effect, especially on switches with high CPU utilization. After a configuration command, perform an
appropriate show or show running-config command to confirm the configuration change. If
configuration scripts are used, the script must be modified either to check for successful completion
of the previous command before executing the next command, or to sleep for 10 seconds after the
configuration command is executed.

How to cancel changes you have made to the running-config file. If you use the CLI to change parameter
settings in the running-config file, and then decide that you do not want those changes to remain, you can use
either of the following methods to remove them:

• Manually enter the earlier values you had for the changed settings. (This is recommended if you want to
restore a small number of parameter settings to their previous boot-up values.)

• Update the running-config file to match the startup-config file by rebooting the switch. (This is recommended if
you want to restore a larger number of parameter settings to their previous boot-up values.)
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If you use the CLI to change a parameter setting, and then execute the boot command without first executing the
write memory command to save the change, the switch prompts you to specify whether to save the changes in
the current running-config file. For example:

Figure 38: Boot prompt for an unsaved configuration

The above prompt means that one or more parameter settings in the running-config file differ from their
counterparts in the startup-config file and you can choose which config file to retain and which to discard.

• If you want to update the startup-config file to match the running-config file, press [Y] for “yes”. (This means
that the changes you entered in the running-config file will be saved in the startup-config file.)

• If you want to discard the changes you made to the running-config file so that it will match the startup-config
file, then select [N] for “no”. (This means that the switch will discard the changes you entered in the running-
config file and will update the running-config file to match the startup-config file.)

If you use the CLI to make a change to the running-config file, you can either use the write memory
command or select the save option allowed during a reboot (see Figure 38: Boot prompt for an
unsaved configuration on page 78) to save the change to the startup-config file. That is, if you use
the CLI to change a parameter setting, but then reboot the switch from either the CLI or the menu
interface without first executing the write memory command in the CLI, the current startup-config file
will replace the running-config file, and any changes in the running-config file will be lost.

Using the Save command in the menu interface does not save a change made to the running config
by the CLI unless you have also made a configuration change in the menu interface. Also, the menu
interface displays the current running-config values. Thus, where a parameter setting is accessible
from both the CLI and the menu interface, if you change the setting in the CLI, the new value will
appear in the menu interface display for that parameter. However, as indicated above, unless you
also make a configuration change in the menu interface, only the write memory command in
the CLI will actually save the change to the startup-config file.

How to reset the startup-config and running-config files to the factory default configuration. Use the erase
startup-config command to reboot the switch, which replaces the contents of the current startup-config and
running-config files with the factory-default startup configuration.

Figure 39: The erase startup-config command

switch(config)# erase startup-config
Configuration will be deleted and device rebooted, continue [y/n]?
Press [y] to replace the current configuration with the factory default configuration and reboot the switch. Press [n]
to retain the current configuration and prevent a reboot.
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In a redundant management system, this command erases the startup config file on both the active and the
standby management modules as long as redundancy has not been disabled. If the standby management module
is not in standby mode or has failed selftest, the startup config file is not erased.

Creating a custom default configuration
The custom default configuration feature provides the ability to initialize a switch to a different state from the
factory default state when you delete the active configuration file. The factory default configuration is not changed.
If a custom configuration file has been created and the active configuration file is deleted, the switch will boot up
using the custom configuration file.

The feature provides the ability to:

Procedure

1. Use a customized configuration file as a default configuration file

2. Enable the switch to start up with the specified default configuration

The existence of a custom default configuration file does not affect the results of loading a remotely stored
configuration file onto the switch.

Using a custom default configuration, you can configure the features you want to be in the default configuration.
When the active configuration is deleted using the erase startup command, the active configuration is removed
and the custom default configuration file will be used upon bootup. The standard default configuration file remains
and is used if there is no custom default configuration.

This feature does not change the system defaults. The custom default configuration file is
automatically used when the startup configuration file is erased. It has no effect on what is loaded
onto the switch when a remotely stored configuration file is restored.

The default configuration file can be customized using commands at the CLI prompt or by copying a configuration
file with the desired configuration using TFTP, USB, or XMODEM copy commands. The existing default
configuration file also can be transferred from the switch using these commands.

To start creating the configuration file to be used as the custom default configuration file, enter the commands that
configure the features desired and then save the configuration file using the write memory command. The
following example is as shown.

Figure 40: Creating a config file with the desired features

switch(config)# spanning-tree
switch(config)# interface 4 flow-control

switch(config)# write memory
This configuration, which enables flow control on interface 4, and also spanning tree on the switch, is stored in the
startup configuration file.

To save this configuration as the custom default configuration, the startup configuration file is copied to the default
configuration file, as shown following.

Figure 41: Copying the startup configuration file to the custom default configuration file

switch(config)# copy startup-config default-config
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Copying an existing configuration file to the custom default configuration
file
Use the following command to copy a configuration file that exists in flash memory to the custom default
configuration file:

copy config <source-filename> default-config
The switch can have up to three different configuration files stored in flash memory. (For more information about
multiple configuration files, see "Multiple Configuration Files" in the Management and Configuration Guide for your
switch.)

switch(config)# copy abc.cfg default-config

HPE does not support issues that arise from a configuration file that was manually edited and
downloaded to the switch.

Copying the custom default config file onto the switch
The custom default config file can be copied onto the switch using TFTP, XMODEM, or USB.

• TFTP

Use thecopy tftp default-config command to copy a configuration file stored on a TFTP server to the custom
default configuration file:

copy tftp default-config <ip-addr> <stored config file name>
Copying a stored config file to the default config file using TFTP

switch(config)# copy tftp default-config 10.10.10.1 stored_config.cfg
• XMODEM

Use thecopy xmodem default-config command to copy a configuration file to the custom default
configuration file using XMODEM:

copy xmodem default-config
Copying a stored config file to the custom default config file using XMODEM

switch(config)# copy xmodem default-config
• USB

Use thecopy usb default-config command to copy a configuration file to the custom default configuration file
using USB:

copy usb default-config <stored config file name>
Copying a stored config file to the custom default config file using USB

switch# copy usb default-config stored_config.cfg

Copying the custom default config file off the switch
The following sections explains how to copy the custom default config file off the switch using TFTP, XMODEM, or
USB.
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Procedure

1. TFTP—Enter the following command to copy the custom default configuration file to the stored_config.cfg file
on the TFTP server.

copy default-config tftp <server ip-address> stored_config.cfg
2. XMODEM—Enter the following command to copy the custom default configuration file to the configuration file

specified by the XMODEM server device.

copy default-config xmodem
3. USB—Enter the following command to copy a custom default configuration file from the switch to the

stored_config.cfg file on the USB device.

copy default-config usb stored_config.cfg

Using SFTP and SCP to transfer the custom configuration
To transfer the default custom configuration file to or from the switch, you must connect to the switch’s SSH server
using any SCP or SFTP client. Instead of the actual name of the custom default configuration file, an alias name
of "default-config" is displayed in the file listings and for get/store functions.

When you use an SCP client to connect to the switch, you must know the name of the file you wish
to get or store. When you use SFTP client to connect to the switch, you are provided with a list of
filenames which are accessed by the switch.

While the switch supports an SSH server with SCP and/or SFTP running on it, the switch is not an
SCP or SFTP client. You must have an SCP/SFTP client implemented in order to execute copy scp
or copy sftp commands on the switch.

The following example shows the output from running puTTY psftp on a remote PC.

C:\PuTTY> psftp 10.1.243.209

We'd like to keep you up to date about:
  * Software feature updates
  * New product announcements
  * Special events

Please register your product at: www.register.hp.com

Remote working directory is /
psftp> ls
Listing directory /
drwxr-xr-x    2 J9145A   J9145A   0 Jan 01 00:01 cfg
drwxr-xr-x    2 J9145A   J9145A   0 Jan 01 00:01 core
drwxr-xr-x    2 J9145A   J9145A   0 Jan 01 00:01 log
drwxrwxrwx    2 J9145A   J9145A   0 Jan 01 00:01 os 
drwxrwxrwx    3 J9145A   J9145A   0 Jan 01 00:01 ssh

psftp> ls /cfg
Listing directory /cfg

-rwxrw-r--  1 J9145A  J9145A  1749 Jan 01 00:01 default-config 
-rw-r--r--  1 J9145A  J9145A   745 Jan 01 01:19 running-config
-rwxrw-r--  1 J9145A  J9145A   360 Jan 01 01:19 startup-config

psftp>
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Erasing a configuration file
To erase a configuration file:

Procedure

1. To erase the startup configuration file, use the erase startup-config command.
If a custom default configuration file exists and the erase startup-config command is executed, the current
active configuration is erased and the switch is booted with the custom default configuration. If a custom
default configuration file does not exist and the erase startup-config command is executed, the current active
configuration is erased and the switch is booted with the system default configuration.

2. To erase the custom default configuration file, use the erase default-config command.

The following example shows how to erase the startup config file when a default custom config file exists

switch(config)# erase startup-config
Configuration will be deleted, and existing login passwords
removed, and device rebooted (using the custom default
configuration), continue [y/n]?

The following example shows how to erase the startup config file when a default custom config file does not exist

switch(config)# erase startup-config
Configuration will be deleted, and existing login passwords removed,
and device rebooted, continue [y/n]?

The following example shows how to erase the custom default config file.

switch(config)# erase default-config
The custom default configuration will be erased. The "erase
startup-config" command will now use system generated default
configuration. Continue [y/n]?

Displaying the configuration files
To display configuration files:

• Use the show config files command to display the existing configuration files. This command also indicates
whether a custom default configuration file exists.

• Use either the command show default config or the command show running-config to display the custom
default configuration.

If a custom default configuration file exists and you erase the current active config file (using the erase
startup-config command), use the show running-configcommand to display the custom default
configuration, which is loaded upon bootup.
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When the show default config command is executed in enhanced secure mode the following
prompt displays:

Do you want to show sensitive information (y/n)?
If "Y/y" is entered, the normal command output is displayed on the console. If "N/n" is entered, all the
sensitive information is hidden and will be displayed as asterisks ("*****"). The default option is "N/n"
when interactive mode is disabled. For more information, see the "Secure Mode" in the Access
Security Guide for your switch.

Output displaying three configuration files
switch(config)# show config files

Configuration files:

id | act pri sec | name
---+-------------+--------------------------
 1    *   *      | config
 2               | secondaryconfig
 3            *  | Kconfig
==================
A Custom default configuration file exists.

Output for custom default configuration file
switch(config)# show default-config

Custom default configuration:

; J8693A Configuration Editor; Created on release #K.15.14.0001

; Ver #02:0b:ef:e6
hostname "switch"
module 1 type J93x7
module 2 type J93x7
vlan 1
  name "DEFAULT-VLAN"
  untagged 1-24
  ip address dhcp-bootp
  exit
interface 4
  flow-control
  exit snmp-server community "public" unrestricted
spanning-tree

Output of custom default config file when current active config file erased
switch(config)# show running-config

Custom default configuration:

; J8693A Configuration Editor; Created on release #K.15.12.0001
; Ver #02:0b:ef:e6
hostname "switch"
module 1 type J93x7
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module 2 type J93x7
vlan 1
  name "DEFAULT-VLAN"
  untagged 1-24
  ip address dhcp-bootp
  exit
interface 4
  flow-control
  exit
snmp-server community "public" unrestricted
spanning-tree

Troubleshooting custom default configuration files

Symptom

Switch cannot boot due to custom default configuration files.

Cause

Problem with the custom configuration file.

Action

1. Remove the custom configuration file from the ROM mode interface.

2. Use the erase default-config command to remove the custom default configuration file.

The custom default configuration files cannot be erased using the front panel buttons on the switch.

Using the menu and WebAgent to implement configuration
changes configuration file
The menu and WebAgent offer these advantages:

Procedure

1. Quick, easy menu or window access to a subset of switch configuration features

2. Viewing several related configuration parameters in the same screen, with their default and current settings

3. Immediately changing both the running-config file and the startup-config file with a single command

Menu: implementing configuration changes

You can use the menu interface to simultaneously save and implement a subset of switch configuration changes
without having to reboot the switch. That is, when you save a configuration change in the menu interface, you
simultaneously change both the running-config file and the startup-config file.

The only exception to this operation is two VLAN-related parameter changes that require a reboot as
described in this section.

Using Save and Cancel in the menu interface

For any configuration screen in the menu interface, the save command:
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1. Implements the changes in the running-config file

2. Saves your changes to the startup-config file

If you decide not to save and implement the changes in the screen, select Cancel to discard them and continue
switch operation with the current operation. For example, suppose that you have made the changes as shown in
the following System Information screen:

Figure 42: Example of pending configuration changes you can save or cancel

If you reconfigure a parameter in the CLI and then go to the menu interface without executing a write
memory command, those changes are stored only in the running configuration (even if you execute a
Save operation in the menu interface). If you then execute a switch boot command in the menu
interface, the switch discards the configuration changes made while using the CLI. To ensure that
changes made while using the CLI are saved, execute write memory in the CLI before rebooting the
switch.

Rebooting from the menu interface

Rebooting from the menu interface does the following:

• Terminates the current session and performs a reset of the operating system

• Activates any configuration changes that require a reboot

• Resets statistical counters to zero
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To Reboot the switch, use the Reboot Switch option in the Main Menu. (Note that the Reboot Switch option is not
available if you log on in Operator mode; that is, if you enter an Operator password instead of a manager
password at the password prompt.)

Figure 43: The Reboot Switch option in the Main Menu

Rebooting To Activate Configuration Changes. Configuration changes for most parameters become effective
as soon as you save them. However, you must reboot the switch in order to implement a change in the Maximum
VLANs to support parameter.

(To access these parameters, go to the Main menu and select 2. Switch Configuration, then 8. VLAN Menu,
then 1. VLAN Support.)

If configuration changes requiring a reboot have been made, the switch displays an asterisk (*) next to the menu
item in which the change has been made. For example, if you change and save parameter values for the
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Maximum VLANs to support parameter, an asterisk appears next to the VLAN Support entry in the VLAN
Menu screen, and also next to the Switch Configuration … entry in the Main menu:

Figure 44: Indication of a configuration change requiring a reboot

WebAgent: implementing configuration changes

You can use the WebAgent to simultaneously save and implement a subset of switch configuration changes
without having to reboot the switch. That is, when you save a configuration change, you simultaneously change
both the running-config file and the startup-config file. For online help with configuring changes in the WebAgent,
click the "?" in the WebAgent screen.

If you reconfigure a parameter in the CLI and then go to the WebAgent without executing a write
memory command, those changes will be saved to the startupconfig file if you click Save in the
WebAgent.

Zeroizing the file storage of the management module

Zeroizing the management module files

Procedure

Use the erase all to erase all management module files, including configuration files, core dumps, password files,
crypto-key files, and so on.
Software images are not erased.

erase all zeroize

When executed without the zeroize option, files are removed, but the flash storage is not zeroized.
The data is still physically present in the flash. The flash can be removed from the switch and the
data recovered with file recovery tools.

It is recommended that zeroization be performed from the serial console so that the status
information can be viewed during the zeroization process.
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switch(config)# erase all zeroize

The system will be rebooted and all management module files
except software images will be erased and zeroized. This will
take up to 60 minutes and the switch will not be usable during
that time. Continue (y/n)? y

Zeroizing from the ROM console
Use the erase-all zeroize command at the prompt to zeroize the file storage from the ROM console of the switch.
This is typically done during a switch recovery process. The warning messages are the same as for the CLI
command.

Zeroizing the management module files from the ROM console

=> erase-all zeroize

The system will be rebooted and all management module files
except software images will be erased and zeroized. This will
take up to 60 minutes and the switch will not be usable during
that time. Continue (y/n)? y

Zeroization
Sometimes it is desirable to completely remove the information stored in user files from flash storage. The
zeroization feature will remove and "zeroize" all the files from flash storage except software images. Information
removed includes the following:

• switch configurations

• system generated private keys

• user installed private keys

• legacy manager/operator password files

• crypto-key files

• fdr logs

• core dumps

Zeroization can be initiated in these ways:

• CLI command erase all

• ROM console command

• During Secure Mode transition, initiated through the secure-mode CLI command executed in a serial session

The zeroization process takes some time, so it is performed during the initial process of a switch reboot. After
zeroization, the configuration file is rebuilt from the default config file, which is similar to the config rebuilding
process performed by the erase startup-config command.

When zeroization is triggered by a secure mode transition, HA handles zeroization on the AMM and SMM
automatically.

When the CLI command (erase all zeroize) is used to start zeroization, the AMM syncs with the SMM and
ensures that the SMM performs the same level of zeroization before the AMM starts the zeroization process on
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itself. The AMM before the zeroization process occurs remains the AMM, unless it takes over a minute for the
AMM to boot up, in which case the prior SMM becomes the AMM.

When zeroization is started from the ROM console, there is no synchronization performed between the AMM and
SMM, as zeroization from the ROM console is treated as a recovery facility. Each MM has to be zeroized
individually.

For information about Secure Mode and zeroization, see the "Secure Mode (5400zl and 3800)" in the Access
Security Guide for your switch.

Using Primary and Secondary flash image options
The switches covered in this guide feature two flash memory locations for storing switch software image files:

Procedure

1. Primary Flash:

The default storage for a switch software image.

2. Secondary Flash:

The additional storage for either a redundant or an alternate switch software image.

With the Primary/Secondary flash option, you can test a new image in your system without having to replace a
previously existing image. You can also use the image options for troubleshooting. For example, you can copy a
problem image into Secondary flash for later analysis and place another, proven image in Primary flash to run
your system. The switch can use only one image at a time.

The following tasks involve primary/secondary flash options:

• Displaying the current flash image data and determining which switch software versions are available

• Switch software downloads

• Replacing and removing (erasing) a local switch software version

• System booting

Displaying the current flash image data
Use the commands in this section to:

• Determine whether there are flash images in both primary and secondary flash

• Determine whether the images in primary and secondary flash are the same

• Identify which switch software version is currently running

Viewing the currently active flash image version. Use the show version command to identify the software
version on which the switch is currently running, and whether the active version was booted from the primary or
secondary flash image.
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For example, if the switch is using a software version of X.X.XX stored in Primary flash, show version produces
the following:

Figure 45: The identity of the current flash image

switch(config)# show version

Image stamp:  /su/code/build/info(s01)
              Dec 01 2006 10:50:26
              X.X.XX
              1223
Boot Image:   Primary
Determining whether the flash images are different versions. If the flash image sizes in primary and
secondary are the same, then in almost every case, the primary and secondary images are identical. This
command provides a comparison of flash image sizes, plus the boot ROM version and from which flash image the
switch booted. For example, in the following case, the images are different versions of the switch software, and
the switch is running on the version stored in the secondary flash image:

switch(config)# show flash
Image            Size(Bytes)   Date   Version
-----            ----------  -------- -------------
Primary Image    : 7493854   03/21/10 K.15.01.0001
Secondary Image  : 7463821   03/23/10 K.15.01.0001

Boot Rom Version: K.15.08
Default Boot    : Primary
Determining which flash image versions are installed. The show version command displays which software
version the switch is currently running and whether that version booted from primary or secondary flash. Thus, if
the switch booted from primary flash, you will see the version number of the software version stored in primary
flash, and if the switch booted from secondary flash, you will see the version number of the software version
stored in secondary flash. Thus, by using show version, then rebooting the switch from the opposite flash
image and using show version again, you can determine the version(s) of switch software in both flash
sources. For example: Determining the software version in Primary and Secondary flash

switch(config)# show version
Management Module 1: Active
Image stamp:    /sw/code/build/btm(ec_K_15)
                Aug 2 2012 09:06:58
                K.15.12.001
                152
Boot Image:     Primary
switch(config)# boot system flash secondary
Device will be rebooted, do you want to continue [y/n]? y
  .
  .
  .

switch(config)# show version
Management Module 1: Active
Image stamp:    /sw/code/build/btm(ec_K_15)
                Aug 2 2012 09:06:58
                K.15.12.001
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                1753
Boot Image:     Secondary

Switch software downloads
The following table shows the switch’s options for downloading a software version to flash and booting the switch
from flash.

Table 6: Primary/Secondary memory access

Action Menu CLI Web Agent SNMP

Download to Primary Yes Yes Yes Yes

Download to Secondary No Yes No Yes

Boot from Primary Yes Yes Yes Yes

Boot from Secondary No Yes No Yes

The different software download options involve different copy commands, plus xmodem, usb, and tftp.

Download interruptions. In most cases, if a power failure or other cause interrupts a flash image download, the
switch reboots with the image previously stored in primary flash. In the unlikely event that the primary image is
corrupted, as a result of an interruption, the switch will reboot from secondary flash and you can either copy the
secondary image into primary or download another image to primary from an external source.

Replacing or removing local switch software
This section describes commands for erasing a software version and copying an existing software version
between primary and secondary flash.

It is not necessary to erase the content of a flash location before downloading another software file.
The process automatically overwrites the previous file with the new file. If you want to remove an
unwanted software version from flash, Hewlett Packard Enterprise recommends that you do so by
overwriting it with the same software version that you are using to operate the switch, or with another
acceptable software version. To copy a software file between the primary and secondary flash
locations, See "Copying a switch software image from one flash location to another", below.

The local commands described here are for flash image management within the switch. To download
a software image file from an external source, see "File Transfers" in the Management and
Configuration Guide for your switch.

Copying a switch software image from one flash location to another. When you copy the flash image from
primary to secondary or the reverse, the switch overwrites the file in the destination location with a copy of the file
from the source location. This means you do not have to erase the current image at the destination location
before copying in a new image.

Chapter 7 Configuring the switch 91

Anexo 02 ITENS 8 E 9 (0592700)         SEI 0008478-63.2018.6.02.8000 / pg. 6477



Verify that there is an acceptable software version in the source flash location from which you are
going to copy. Use the show flash command or, if necessary, the procedure under Displaying the
current flash image data to verify an acceptable software version. Attempting to copy from a source
image location that has a corrupted flash image overwrites the image in the destination flash
location. In this case, the switch will not have a valid flash image in either flash location, but will
continue running on a temporary flash image in RAM. Do not reboot the switch. Instead,
immediately download another valid flash image to primary or secondary flash. Otherwise, if the
switch is rebooted without a software image in either primary or secondary flash, the temporary flash
image in RAM will be cleared and the switch will go down. To recover, see "Restoring a Flash Image"
in the Management and Configuration Guide for your switch.

Syntax
copy flash flash <destination flash>
where: destination flash = primary or secondary:

For example, to copy the image in secondary flash to primary flash:

Verify that there is a valid flash image in the secondary flash location. The following figure indicates that a
software image is present in secondary flash. (If you are unsure whether the image is secondary flash is valid, try
booting from it before you proceed by using boot system flash secondary

The following example indicates two different software versions in Primary and Secondary flash:

switch(config)# show flash
Image             Size (bytes) Date     Version
----------------- ------------ -------- --------------------
Primary Image     : 10167529    10/14/11 K.14.89
Secondary Image   : 15085139    08/17/12 K.15.10.0001

Boot ROM Version : K.15.28
Default Boot     : Primary

Syntax

Execute the copy command as follows:

switch(config)# copy flash flash primary
Erasing the contents of Primary or Secondary flash. This command deletes the software image file from the

No undo! Before using this command in one flash image location (primary or secondary), ensure that
you have a valid software file in the other flash image location (secondary or primary). If the switch
has only one flash image loaded (in either primary or secondary flash) and you erase that image,
then the switch does not have a software image stored in flash. In this case, if you do not reboot or
power cycle the switch, you can recover by using xmodem or tftp to download another software
image.

erase flash [primary | secondary]

For example, to erase the software image in primary flash, do the following:

1. First verify that a usable flash image exists in secondary flash. The most reliable way to ensure this is to reboot
the switch from the flash image you want to retain. For example, if you are planning to erase the primary
image, then first reboot from the secondary image to verify that the secondary image is present and
acceptable for your system:
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switch# boot system flash secondary
2. Then erase the software image in the selected flash (in this case, primary):

switch# erase flash primary
The Primary OS Image will be deleted, continue [y/n]?

3. Type ‘y’ at the prompt to complete the flash erase.

4. Use show flash to verify erasure of the selected software flash image. The “0” shows that the primary flash has
been erased.

The following example shows flash listing after erasing Primary flash

switch# show flash
Compressed Primary Code size = 0
Compressed Secondary code size = 2555802
Boot ROM Version : K.15.19
Default Boot : Secondary

In redundant management systems, this command will erase the selected flash in both the active and the standby
management modules. If redundancy has been disabled or the standby module has failed self-test, this command
only affects the active management module.

Rebooting the switch

Setting the default flash for bootup
To specify the default flash (primary or secondary) to boot from on the next boot, use the boot set-default flash
command. The syntax is as follows:

boot set-default flash [ primary|secondary ]

switch(config)# boot set-default flash secondary
switch(config)# show flash
Image           Size(Bytes)   Date    Version
------          ----------   -------  -------------
Primary Image   : 7476770    03/15/10 K.15.01.0001
Secondary Image : 7476770    03/15/10 K.15.01.0001

Boot Rom Version: K.15.08
Default Boot    : Secondary

switch(config)# boot
This management module will now reboot from secondary
and will become the standby module! You will need to 
use the other management module's console interface.
Do you want to continue [y/n]?

Booting from the default flash or configuration file

Procedure

1. To boot the switch from the default flash (primary or secondary) image, use the boot command.

This command allows a boot sequence that includes the complete set of self-tests.

The switch is booted either from the flash (primary or secondary) that you are currently booted on or from the
flash image that was set by the boot set-default command or by the last executed boot system flash
<primary | secondary> command. You can select which image to boot from during the boot process itself
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(you are prompted with a message which will indicate the flash being booted from). When using redundant
management, the switch will fail over to the standby management module.

2. To boot from a configuration file, use the boot config <filename> command.

This command allows a boot sequence that includes the complete set of self-tests.

The following example shows the Boot command (default Primary flash) with redundant management

switch(config)# boot
This management module will now reboot from primary image
and will become the standby module! You will need to use
the other management module's console interface.
Do you want to continue [y/n]? y

Do you want to save current configuration [y/n]? n
In the above example, typing either a ‘y’ or ‘n’ at the second prompt initiates the reboot operation. (Entering ‘y’
saves any configuration changes from the running-config file to the startup-config file; entering ‘n’ discards them.)

The following example shows the Boot command booting from a different flash than the current flash (with
redundant management module present)

switch(config)# show flash
Image Size(Bytes) Date Version
Primary Image : 7497114 03/29/10 K.15.01.0001
Secondary Image : 7497114 03/29/10 K.15.01.0001
Boot Rom Version: K.15.08
Default Boot : Primary

switch(config)# boot set-default flash secondary
This command changes the location of the default boot.
This command will change the default flash image to boot from 
secondary. Hereafter, 'reload' 'boot' commands will boot from
secondary. Do you want to continue [y/n]? y

switch(config)# boot
This management module will now reboot from secondary image
and will become the standby module! You will need to use the
other management module's console interface.
Do you want to continue [y/n]? n

Booting from a specified flash

Procedure

1. To reboot from primary flash, use the boot system flash primary command.

This command allows a boot sequence that includes the complete set of self-tests.

2. To reboot from secondary flash, use the boot system flash secondary command.

This command allows a boot sequence that includes the complete set of self-tests.

The following example shows use of the command to reboot the switch from secondary flash when there are no
pending configuration changes in the running-config file. Typing either a [y] or [n] at the second prompt initiates
the reboot operation.
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Boot command with secondary flash option
switch(config)# boot system flash secondary
System will be rebooted from secondary image. Do you want to continue [y/n]?

Enabling and disabling the fastboot option

Procedure

1. To enable the fastboot option, use the fastboot command.

When this option is enabled, the bootup sequence does not include the internal power-on self-tests, resulting
in a faster boot time.

2. To disable the fastboot option, use the no fastboot command.

When this option is disabled, the bootup sequence includes the complete set of self-tests.

3. To display the status of the fastboot feature, either enabled or disabled, use the show fastbootcommand.

When using redundant management and fastboot is enabled, it is saved to the standby management module
when the config files are synchronized. Fastboot is used during the next bootup on either management module.

Enabling the fastboot option
switch(config)# fastboot

Using reload
The reload command reboots the switch from the flash image that you are currently booted on (primary or
secondary) or the flash image that was set either by the boot set-default command or by the last executed boot
system flash <primary | secondary> command. Because reload bypasses some subsystem self-tests, the
switch reboots faster than if you use either of the boot command options. If you are using redundant
management and redundancy is enabled, the switch will failover to the other management module.

Syntax
reload
For example, if you change the number of VLANs the switch supports, you must reboot the switch in order to
implement the change. The reload command prompts you to save or discard the configuration changes.

The following example shows how to use reload with redundant management and pending configuration changes:

switch(config)# max-vlans 12
Command will take effect after saving configuration and reboot.

switch(config)# reload
This command will cause a switchover to the other management
module which may not be running the same software image and
configurations. Do you want to continue [y/n]? y
Scheduled reload. Beginning with software release K.11.34, additional parameters have been added to the
reload command to allow for a scheduled reboot of the switch via the CLI.

Syntax
reload [after <[dd:]hh:] [mm>] | [at <hh:mm[:ss]>] [<mm/dd[/[yy]yy]>]
no reload [after <[dd:]hh:] [mm>] | [at <hh:mm[:ss]>] [<mm/dd[/[yy]yy]>]
Enables a scheduled warm reboot of the switch. The switch boots up with the same startup config file and using
the same flash image as before the reload.

Chapter 7 Configuring the switch 95

Anexo 02 ITENS 8 E 9 (0592700)         SEI 0008478-63.2018.6.02.8000 / pg. 6481



When using redundant management, the reload at/after command causes a switch over at the
scheduled time to the other management module, which may not be running the same software
image or have the same configurations.

Parameters include:

• after

Schedules a warm reboot of the switch after a given amount of time has passed.

• at

Schedules a warm reboot of the switch at a given time.

The no form of the command removes a pending reboot request.

For more details and examples, see the following.

The scheduled reload feature removes the requirement to physically reboot the switch at inconvenient times (for
example, at 1:00 in the morning). Instead, a reload at 1:00 mm/dd command can be executed (where mm/dd is
the date the switch is scheduled to reboot).

Configuration changes are not saved with reload at or reload after commands. No prompt to save
configuration file changes is displayed. See Boot and reload command comparison.

Examples of scheduled reload commands:

• To schedule a reload in 15 minutes:

switch# reload after 15
• To schedule a reload in 3 hours:

switch# reload after 03:00
• To schedule a reload for the same time the following day:

switch# reload after 01:00:00
• To schedule a reload for the same day at 12:05:

switch# reload at 12:05
• To schedule a reload for some future date:

switch# reload at 12:05 01/01/2008

The following example shows the reload command with a redundant management system

switch(config)# reload after 04:14:00
    Reload scheduled in 4 days, 14 hours, 0 minutes
This command will cause a switchover at the scheduled
time to the other management module which may not be
running the same software image and configurations.
Do you want to continue [y/n]?
Module reload. The module reload feature allows you to reset a module by initiating a warm reboot of a specified
module or modules. This saves time over rebooting the entire switch, which can take several minutes to complete
and disrupts all users on the switch. The specified module has its power turned off, and then turned on again. This
causes the module to reset to a known good state and reload its software.
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Syntax
reload [[after <[[DD:]HH:]MM>] | [[at HH:MM[:SS] [MM/DD[/[YY]YY]]]]
| [[module <slot-id-range>]]]
no reload [[after <[[DD:]HH:]MM>] | [[at HH:MM[:SS] [MM/DD[/[YY]YY]]]]
| [[module <slot-id-range>]]]
When specified with the module parameter, initiates a reload of the module in the specified slot or slots by turning
the slot power off, then on again. A valid slot or range of slots must be specified. The at and after parameters are
not allowed with the module option. The no version of the command is not valid with the module option.

When the reload command is executed without any parameters, an immediate switch reload occurs.

This feature is not supported for HPE One modules.

module: Powers the module on or off, forcing a software reload of the specified module or modules.

The following example shows reloading a specified module:

switch(config)# reload module C
The ‘reload module’ command will shutdown the specified
modules. Ports on specified modules will no longer pass
traffic. Any management traffic to the switch which
passes through the affected modules will be interrupted
(e.g. ssh, telnet, snmp). This command may take up to 2
minutes to power down all specified modules. Please check 
the event log for current status of module power down,
power up cycle. Continue [y/n]?
Displaying reload information. Use the show reload command to display the reload information. This can
include:

• A scheduled, pending reload of the entire switch

• A statement that no reload is scheduled

• The time of the last reload of each module on the system

The following example shows the scheduled reload at information:

switch(config)# reload at 23:45
Reload scheduled at 23:45:47 6/16/2012
(in 0 days, 1 hours, 41 minutes

switch(config)# show reload at
Reload scheduled for 23:45:47 06/16/2012
(in 0 days, 1 hours, 40 minutes)

switch(config)# show reload after
Reload scheduled for 23:45:47 6/16/2012
(in 0 days, 1 hours, 40 minutes)
The following example shows the scheduled reload after information:

switch(config)# reload after 35
Reload scheduled in 0 days, 0 hours, 35 minutes

switch(config)# show reload at
Reload scheduled in 0 days, 0 hours, 34 minutes
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switch(config)# show reload after
Reload scheduled in 0 days, 0 hours, 34 minutes
The following example shows the module reload information:

switch(config)# show reload module

Module Reload information:

Module | Last reload date
-------+---------------------
  C      10:50:51 01/13/2012

Boot and reload command comparison
The switch offers reboot options through the boot and reload commands, plus the options inherent in a dual-flash
image system. Generally, using boot provides more comprehensive self-testing; using reload gives you a faster
reboot time.

Table 7: Comparing the boot and reload commands

Actions Included in Boot? Included in Reload Note

Save all configuration
changes since the last
boot or reload

Optional, with prompt Optional with reload <cr>,
when prompt displays. Not
saved with reload at/after
commands; No prompt is
displayed.

Config changes saved to
the startup-config file if "y"
is selected (reload
command).

Perform all system self-
tests

Yes No The reload command
provides a faster system
reboot.

Choice of primary or
secondary flash image

Yes No—Uses the current flash
image.

Perform a scheduled
reboot

No Yes Use the reload command
with after/at parameters
(see for Using reload
details).

Operating notes about booting
Default boot source. The switch reboots from primary flash by default unless you specify the secondary flash by
entering either the boot system flash [primary | secondary] or boot set-default flash [primary | secondary]
command. Both the boot command and the reload command will reboot based on how these options have been
selected.

Boot attempts from an empty flash location. In this case, the switch aborts the attempt and displays:

Image does not exist
Operation aborted.
Interaction of Primary and Secondary flash images with the current configuration. The switch has one
startup-config file (see Configuration file management on page 115), which it always uses for reboots,
regardless of whether the reboot is from primary or secondary flash. Also, for rebooting purposes, it is not
necessary for the software image and the startup-config file to support identical software features. For example,
suppose that you have just downloaded a software upgrade that includes new features that are not supported in
the software you used to create the current startup-config file. In this case, the software simply assigns factory-
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default values to the parameters controlling the new features. Similarly, If you create a startup-config file while
using a version "Y" of the switch software, and then reboot the switch with an earlier software version "X" that
does not include all the features found in "Y", the software simply ignores the parameters for any features that it
does not support.

Scheduled reload. If no parameters are entered after the reload command, an immediate reboot is executed.
The reload at and reload after command information is not saved across reboots. If the switch is rebooted before
a scheduled reload command is executed, the command is effectively canceled. When entering a reload at or
reload after command, a prompt will appear to confirm the command before it can be processed by the switch.
For the reload at command, if mm/dd/yy are left blank, the current day is assumed.

The scheduled reload feature removes the requirement to physically reboot the switch at inconvenient times (for
example, at 1:00 in the morning). Instead, a reload at 1:00 mm/dd command can be executed (where mm/dd is
the date the switch is scheduled to reboot).

Managing multiple configuration files

Viewing the status and content of startup-config files

Procedure

1. To view a list of the available startup-config files on the switch and the current use of each file, use the show
config files command.

2. To view the content of the default startup-config file, use the show config command.

The default startup-config file is the startup-config file that is currently active on the switch.

3. To view the content of a specific startup-config file, use the show config <filename> command.
The filename argument specifies the file.With Multiple Configuration enabled, the switch can have up to three
startup-config files. This command can display the content of any of the startup-config files stored in the
switch, whereas the show config command always displays the content of the default startup-config file.

Changing or overriding the reboot configuration policy
To change the reboot configuration policy, do one of the following:

• Use the startup-default primary config <filename> command to change the current policy so that the switch
automatically reboots from the primary flash using the specified startup-config file. The filename argument
specifies the startup-config file to use.

• Use the startup-default secondary config <filename> command to change the current policy so that the
switch automatically reboots from the secondary flash using the specified startup-config file. The filename
argument specifies the startup-config file to use.

To override the default reboot configuration policy for a single reboot instance, do one of the following:

• Use the boot system flash primary config <filename> command to override the current policy so that the
switch automatically reboots from the primary flash using the specified startup-config file. The filename
argument specifies the startup-config file to use.

• Use the boot system flash secondary config <filename> command to override the current policy so that the
switch automatically reboots from the secondary flash using the specified startup-config file. The filename
argument specifies the startup-config file to use.
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Reboot configuration policy that uses different startup-config files for different software versions

Suppose that you have the following situation:

• Software release “A” is stored in primary flash and a later software release is stored in secondary flash.

• Memory slot 1 stores a reliable, minimal configuration (named minconfig) to be used with the software
version in the primary flash.

• Memory slot 2 stores a modified startup-config file (named newconfig) to be used with the software version
in secondary flash. This startup-config file includes untested changes for improved network operation.

The operator wants to ensure that in case of a need to reboot by pressing the Reset button, or if a power failure
occurs, the switch will automatically reboot with the minimal startup-config file in memory slot 1. Since a reboot
due to pressing the Reset button or to a power cycle always uses the software version in primary flash, the
operator has to configure the switch to always boot from primary flash with the startup-config file named
minconfig (in memory slot 1). Also, whenever the switch boots from secondary flash, the operator also wants
the startup-config named newconfig to be used. The following two commands configure the desired behavior.

switch(config)# startup-default primary config minconfig
switch(config) # startup-default secondary config newconfig

Managing startup-config files in the switch
Managing the startup-config files involves renaming, copying, and erasing startup-config files.

• Use the rename config <current-filename> <new-filename> command to change the name of an existing
startup-config file. The current-filename argument specifies the existing startup-config file and the new-
filename argument specifies the new name for the file.

A file name can include up to 63, alphanumeric characters. Blanks are allowed in a file name enclosed in
quotes (" " or ‘ ‘). File names are not case-sensitive.

A file name can include up to 63, alphanumeric characters. Blanks are allowed in a file name enclosed in
quotes (" " or ‘ ‘). File names are not case-sensitive.

For redundant management systems, renaming a config file affects both the active management module and
the standby management module, unless redundancy is disabled or the standby module failed selftest.

• Use the copy config <source-filename> config <target-filename> command to create a new startup-config
file or to replace an existing startup-config file with a new one.

This command copies the contents of an existing startup-config file in one memory slot to a new startup-config
file in another, empty memory slot.

If the target startup-config file already exists, it is overwritten by the content of the source startup-config file
otherwise, it will be created in the first empty configuration memory slot on the switch. If the destination
startup-config file does not already exist and there are no empty configuration memory slots on the switch,
then a new startup-config file is not created.

• Do one of the following to erase any of the startup-config files in the switches memory slots:

◦ Use the erase config <filename> command to erase the specified startup-config file. filename argument

specifies the file to be erased.

◦ Use the erase startup-config command to erase the currently active startup-config file.
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In some cases, erasing a file causes the switch to generate a new, default-configuration file for the affected
memory slot. Where a file is assigned to either the primary or the secondary flash, but is not the currently active
startup config file, erasing the file does not remove the flash assignment from the memory slot for that file. Thus, if
the switch boots using a flash location that does not have an assigned startup-config, then the switch creates a
new, default startup-config file and uses this file in the reboot. (This new startup-config file contains only the
default configuration for the software version used in the reboot.) Executing write memory after the reboot
causes a switch-generated filename of config x to appear in the show config files display for the new file,
where x corresponds to the memory slot number.

In a redundant management system, these commands erase the startup config file on both the active and the
standby management modules as long as redundancy has not been disabled. If the standby management module
is not in standby mode or has failed selftest, the startup config file is not erased.

The following example shows how to create and assign a new startup config file

If you wanted to experiment with configuration changes to the software version in secondary flash, you could
create and assign a separate starup-config file for this purpose, as shown in the following command sequence.

switch(config)# copy config config1 config config2
switch(config)# startup-default secondary config config2
switch(config)# show config files

Configuration files:

id | act pri sec | name
---+-------------+-----------------------------------------------
 1 |  *   *      | Config1
 2 |          *  | Config2
 3 |             | 

The following example shows how to erase a non-active startup-config file. The memory configuration has a non-
active configuration file named “config3”, which you want to erase.

switch(config)# show config files

Configuration files:

id | act pri sec | name
---+-------------+-----------------------------------------------
 1 |  *   *      | minconfig
 2 |          *  | config2
 3 |             | config3

switch(config)# erase config config3
switch(config)# show config files

Configuration files:

id | act pri sec | name
---+-------------+-----------------------------------------------
 1 |  *   *      | minconfig
 2 |          *  | config2
 3 |             | 

Uploading a configuration file to a remote TFTP host
Uploading a configuration file from a remote TFTP host
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To upload a configuration file to a remote TFTP host through the out-of-band management interface, do one of the
following:

Prerequisites

Before you upload a configuration file to a remote TFTP host, you must insure that the switch has a separate out-
of-band management port if the traffic is being transmitted through the out-of-band management interface.

Procedure

1. Use the copy config <src-file> tftp <ip-addr> <remote-file> pc oobm command to upload
a configuration file to a remote TFTP PC host.

2. Use the copy config <src-file> tftp <ip-addr> <remote-file> unix oobm command to
upload a configuration file to a remote TFTP UNIX host.

To upload a configuration file to a remote TFTP host through the data interface, do one of the following:

• Use the copy config <src-file> tftp <ip-addr> <remote-file> pc command to upload a
configuration file to a remote TFTP PC host.

• Use the copy config <src-file> tftp <ip-addr> <remote-file> unix command to upload a
configuration file to a remote TFTP UNIX host.

For more information on using TFTP to upload a file to a remote server, see "TFTP: Copying a Configuration File
to a Remote Host" in Appendix A of the Management and Configuration Guide for your switch.

Example

The following command uploads a startup-config file named test01 from the switch to a (UNIX) TFTP server at IP
address 10.10.28.14:

switch(config)# copy config test-01 tftp 10.10.28.14 test-01.txt unix

Downloading a configuration file from a remote TFTP host
Downloading a configuration file from a remote TFTP host

To download a configuration file from a remote TFTP host through the out-of-band management interface, do one
of the following:

Prerequisites

Before you download a configuration file from a remote TFTP host, you must insure that the switch has the
following:

• An empty memory slot.

• A separate out-of-band management port, if the traffic is being transmitted through the out-of-band
management interface.

Procedure

1. Use the copy tftp config <dest-file> <ip-addr> <remote-file> pc oobm command to
download a configuration file from a remote TFTP PC host.

2. Use the copy tftp config <dest-file> <ip-addr> <remote-file> UNIX oobm command to
download a configuration file from a remote TFTP UNIX host.
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To download a configuration file from a remote TFTP host through the data interface, do one of the following:

• Use the copy tftp config <dest-file> <ip-addr> <remote-file> pc command to download a
configuration file from a remote TFTP PC host.

• Use the copy tftp config <dest-file> <ip-addr> <remote-file> UNIX command to download
a configuration file from a remote TFTP UNIX host.

For more on using TFTP to download a file from a remote host, see "TFTP: Copying a Configuration File from a
Remote Host" in Appendix A of the Management and Configuration Guide for your switch.

Example

The following command downloads a startup-config file named test01.txt from a (UNIX) TFTP server at IP
address 10.10.28.14 to the first empty memory slot in the switch:

switch(config)# copy tftp config test-01 10.10.28.14 test-01.txt unix

Uploading a configuration file to a serially connected host
To upload a configuration file to a serially connected host, do one of the following:

Procedure

1. Use the copy config <filename> xmodem pc command to upload a configuration file to a serially
connected PC host.

2. Use the copy config <filename> xmodem unix command to upload a configuration file to a serially
connected UNIX host.

For more on using Xmodem to upload a file to a serially connected host, see "Xmodem: Copying a Configuration
File to a Serially Connected PC or UNIX Workstation" in Appendix A of the Management and Configuration Guide
for your switch.

Downloading a configuration file from a serially connected host
To download a configuration file from a serially connected host, do one of the following:

Procedure

1. Use the copy xmodem config <dest-file> pc command to download a configuration file from a
serially connected PC host.

2. Use the copy xmodem config <dest-file> unix command to download a configuration file from a
serially connected UNIX host.

For more on using Xmodem to copy a file from a serially connected host, see "Xmodem: Copying a Configuration
File from a Serially Connected PC or UNIX Workstation" in Appendix A of the Management and Configuration
Guide for your switch.

Multiple configuration files
In this mode of operation, you cannot preserve different startupconfig files across a reboot without using remote
storage.

The switch allows up to three startup-config files with options for selecting which startup-config file to use for:

Chapter 7 Configuring the switch 103

Anexo 02 ITENS 8 E 9 (0592700)         SEI 0008478-63.2018.6.02.8000 / pg. 6489



• A fixed reboot policy using a specific startup-config file for a specific boot path (primary or secondary flash)

• Overriding the current reboot policy on a per-instance basis

Figure 46: Optional reboot process

While you can still use remote storage for startup-config files, you can now maintain multiple startup-config files
on the switch and choose which version to use for a reboot policy or an individual reboot.

This choice of which configuration file to use for the startup-config at reboot provides the following new options:

• The switch can reboot with different configuration options without having to exchange one configuration file for
another from a remote storage location.

• Transitions from one software release to another can be performed while maintaining a separate configuration
for the different software release versions.

• By setting a reboot policy using a known good configuration and then overriding the policy on a per-instance
basis, you can test a new configuration with the provision that if an unattended reboot occurs, the switch will
come up with the known, good configuration instead of repeating a reboot with a misconfiguration.

Operating notes for multiple configuration files
Multiple configuration storage in the switch. The switch uses three memory "slots", with identity (id) numbers
of 1, 2, and 3, as shown by the following output of the show config files command.

switch(config)# show config files
Configuration files:

id | act pri sec | name
---+-------------+-----------------------------------------------
 1 |             | oldConfig 
 2 |  *   *   *  | workingConfig 
 3 |             | 

A startup-config file stored in a memory slot has a unique, changeable file name. The switches covered in this
guide can use the startup-config in any of the memory slots (if the software version supports the configured
features). In the default configuration, if the switch was shipped from the factory with software installed in both the
primary and secondary boot paths, then one startup-config file named “config1” is used for both paths and is
stored in memory slot 1. Memory slots 2 and 3 are empty in this default configuration.

An asterisk ( * ) in the act, pri, or sec column has the following meaning:
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• act column: The corresponding startup-config file is currently in use.

• pri column: The corresponding startup-config file is currently assigned to the primary boot path.

• sec column: The corresponding startup-config file is currently assigned to the secondary boot path.

Reboot policy. With multiple startup-config files in the switch you can specify a policy for the switch to use upon
reboot. The options include:

• Use the designated startup-config file with either or both reboot paths (primary or secondary flash)

• Override the current reboot policy for one reboot instance by specifying a boot path (primary or secondary
flash) and the startup-config file to use.

For a given reboot, the switch automatically reboots from the startup-config file assigned to the flash location
(primary or secondary) being used for the current reboot. For example, when you first download a software
version that supports multiple configuration files and boot from the flash location of this version, the switch copies
the existing startup-config file (named oldConfig) into memory slot 2, renames this file to workingConfig, and
assigns workingConfig as:

• The active configuration file

• The configuration file to use when booting from either primary or secondary flash

In this case, the switch is configured to automatically use the workingConfig file in memory slot 2 for all
reboots.

Changes to the startup-config file. When the switch reboots, the startupconfig file supplies the configuration for
the running-config file the switch uses to operate. Changes to the running-config file are written back to the
startup-config file that was used at the last reboot. The changes are written when the write-mem command (or, in
the Menu interface, the Save command) is executed. For example, suppose that a system administrator performs
the following on a switch that has two startup-config files (workingconfig and backupconfig):

1. Reboot the switch through the Primary boot path using the startup-config file named backupconfig.

2. Use the CLI to make configuration changes in the running-config file, and then execute write-mem.
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The result is that the startup-config file used to reboot the switch is modified by the actions in step 2.

Figure 47: Reboot process and making changes to the startup-config file

An alternate startup-config file. A new configuration file can be created for an alternate startup-config file. There
are two methods for creating a new configuration file:

• Copy an existing startup-config file to a new filename, then reboot the switch, make the desired changes to the
running-config file, then execute write memory.

• Erase the active startup-config file. This generates a new, default startupconfig file that always results when
the switch automatically reboots after deletion of the currently active startup-config file.

The transition to multiple configuration files. At the first reboot with a software release supporting multiple
configuration, the switch:

• Assigns the filename oldConfig to the existing startup-config file (which is stored in memory slot 1).

• Saves a copy of the existing startup-config file in memory slot 2 with the filename workingConfig.

• Assigns the workingConfig file as the active configuration and the default configuration for all subsequent
reboots using either primary or secondary flash.

The following output of the show config files command shows the switch memory assignments after the first
reboot from software that supports multiple configuration. In this state, the switch always uses the
workingConfig file to reboot.

switch(config)# show config files
Configuration files:
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id | act pri sec | name
---+-------------+-----------------------------------------------
 1 |             | oldConfig 
 2 |  *   *   *  | workingConfig 
 3 |             | 

Viewing the configuration of interfaces

Viewing the running configuration of interfaces
To view the running configuration of interfaces, do one of the following:

Procedure

1. Use the show running-config [structured]command to view the running configuration of all
interfaces. Include the structured option to group the information in a logical manner.

2. Use the show running-config interface port-listcommand to view the running configuration of the
specified port interfaces. Include the structuredoption to group the information in a logical manner.

3. Use the show running-config interface loopback <0-7> command to view the running
configuration of the specified loopback interfaces. Include the structuredoption to group the information in a
logical manner.

4. Use the show running-config interface vlan <vlan-id-list>
command to view the running configuration of the specified VLAN interfaces. Include the structured option to
group the information in a logical manner.

Examples

The following example shows Running configuration output in preview mode.

switch(config)# preview-mode 
ATTENTION: You are entering preview mode on this product. This mode, the 
commands, features and functionality specific to this mode, and all output
from this mode are Hewlett Packard Enterprise Confidential and Proprietary.
You may use this mode at your own risk. Any defects or issues encountered  
in this mode will be addressed per Hewlett Packard Enterprise's discretion.
Continue (y/n)? y                                                           
(Prev-mode)switch(config)# show running-config

Running configuration:

; JL075A Configuration Editor; Created on release #KB.16.01.0000x
; Ver #0c:01.7c.59.f4.7b.ff.ff.fc.ff.ff.3f.ef:

hostname "Aruba-3810M-16SFPP-2s"
module 1 type jl075x
module 2 type jl075y
module 3 type jl075z
snmp-server community "public" unrestricted
oobm
   ip address dhcp-bootp
   exit
vlan 1
   name "DEFAULT_VLAN"
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   untagged 1-16
   ip address dhcp-bootp
   exit
preview-mode
The following example shows Running configuration output for interfaces A2 - A4

switch(eth-A2-A4)# show running-config

Running configuration:

; J8698A Configuration Editor; Created on release #K.15.10.0001
; Ver #02:0b:ef:e6
hostname "switch"
interface A2
   disable
   name "test1"
   flow-control
   broadcast-limit 80
   speed-duplex 100-full
   unknown-vlans Block 
   qos priority 4 
   lacp Passive
   gvrp join-timer 30
   gvrp leave-timer 60
   gvrp leaveall-timer 700
exit
interface A3
   disable name "test1"
   flow-control
   broadcast-limit 80
   speed-duplex 100-full
   unknown-vlans Block
   qos priority 4
   lacp Passive
   gvrp join-timer 30
   gvrp leave-timer 60
   gvrp leaveall-timer 700
exit
vlan 1
   name "DEFAULT_VLAN"
   untagged A1-A4,C1-C24,F1-F4
   ip address dhcp-bootp
   exit
interface A2
   dhcp-snooping trust
   bandwidth-min output 20 10 10 10 20 10 10 10
   rate-limit bcast in percent 75
   ipv6 access-group "check" in
   exit
interface A3
   dhcp-snooping trust
   bandwidth-min output 20 10 10 10 20 10 10 10
   rate-limit bcast in percent 75
   ipv6 access-group "check" in
   exit
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The following example shows an example of the running config for a range of interfaces. The configuration
information for interfaces A2 and A3 is now displayed together.

switch(config)# show running-config interface A2-A3

Running configuration:

interface A2
   disable
   name "test1"
   flow-control
   broadcast-limit 80
   speed-duplex 100-full
   unknown-vlans block
   qos priority 4
   gvrp join-timer 30 leave-timer 60 leaveall-timer 700
   dhcp-snooping trust
   lacp passive
   bandwidth-min output 20 10 10 10 20 10 10 10
   rate-limit bcast in percent 75
   ipv6 access-group "check" in
   untagged vlan 1
   exit
interface A3
   disable
   name "test1"
   flow-control
   broadcast-limit 80
   speed-duplex 100-full
   unknown-vlans block
   qos priority 4
   gvrp join-timer 30 leave-timer 60 leaveall-timer 700
   dhcp-snooping trust
   lacp passive
   bandwidth-min output 20 10 10 10 20 10 10 10
   rate-limit bcast in percent 75
   ipv6 access-group "check" in
   untagged vlan 1
   exit
The following example shows an example of the running config file for a range of interfaces after some
configuration changes have been made.

switch(config)# no stack
switch(config)# mesh 2-3
Command will take effect after saving configuration and reboot.

switch(config)# write memory
switch(config)# reload

switch# show running-config interface 2-3

Running configuration:

interface 2
   untagged vlan 1
   mesh
   exit
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interface 3
   flow-control
   untagged vlan 1
   mesh
   exit
The following example is an example of the running config output showing VLAN information.

switch(config)# show running-config

Running configuration:
; J8698A Configuration Editor; Created on release #K.15.10.0001
; Ver #02:0b:ef:e6
hostname "switch"
module 1 type J9309A
module 3 type J8702A
module 6 type J8702A
ip routing
vlan 1
   name "DEFAULT_VLAN"
   untagged A1-A4,C1-C24,F1-F24
   ip address dhcp-bootp
   exit
vlan 2
   name "test-vlan-2"
   ip helper-address 4.1.1.1
   ip helper-address 5.1.1.1
   ip address 1.1.1.1 255.255.255.0
   ipv6 address 2001::/64 anycast
   ipv6 enable
   exit
vlan 3
   name "VLAN3"
   ip helper-address 7.1.1.1
   ip forward-protocol udp 7.1.1.1 snmp
   ip forward-protocol udp 11.1.1.2 dns
   no ip address
   exit
vlan 4
   name "VLAN4"
   ip address 5.1.1.1 255.255.255.0
   ip bootp-gateway 5.1.1.1
   exit
logging 10.0.102.90
logging system-module ospf
ip route 5.1.1.0 255.255.255.0 vlan 4 distance 3
In the following example, the configuration information for VLAN 4 is now displayed in one place.

switch(config)# show running-config vlan 3-4

Running configuration:

vlan 3
   name "VLAN3"
   ip helper-address 7.1.1.1
   ip forward-protocol udp 7.1.1.1 snmp
   ip forward-protocol udp 11.1.1.2 dns
   no ip address
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   exit
vlan 4
   name "VLAN4"
   ip address 5.1.1.1 255.255.255.0
   ip bootp-gateway 5.1.1.1
   ip route 5.1.1.0 255.255.255.0 distance 3
   exit
Below is an example of the running config for a range of VLANs after configuration changes have been made to
selected VLANs.

switch(config)# dhcp-snooping
switch(config)# vlan 14
switch(vlan-14)# exit
switch(config)# vlan 15
switch(vlan-15)# exit
switch(config)# vlan 23
switch(vlan-23)# exit
switch(config)# dhcp-snooping vlan 14-15
switch(config)# static-mac 00:11:22:33:44:55 vlan 23 interface A3
switch(config)# spanning-tree instance 2 vlan 15

switch(config)# show running-config vlan 14-15

Running configuration:

vlan 14
   name "VLAN14"
   no ip address
   dhcp-snooping
   exit
vlan 15
   name "VLAN15"
   no ip address
   dhcp-snooping
   spanning-tree instance 2
   exit

Viewing the startup configuration of interfaces
To view the startup configuration of interfaces, do one of the following:

• Use the show config command to view the startup configuration of all interfaces.

• Use the show config interface port-listcommand to view the startup configuration of the specified
port interfaces.

• Use the show config interface loopback <0-7>command to view the startup configuration of the
specified VLAN interfaces.

Examples

The following example shows startup configuration output.

switch(config)# show config

Startup configuration:

; J8698A Configuration Editor; Created on release #K.14.54C
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; Ver #02:0b:ef:e6
hostname "switch"
module 1 type J9309A
module 3 type J8702A
module 6 type J8702A
vlan 1
   name "DEFAULT_VLAN"
   untagged A1-A4,C1-C9,C15-C24,F1-F24
   ip address dhcp-bootp
   no untagged C10-C14
   exit
vlan 5
   name "VLAN5"
   untagged C10-C14
   ip address 5.1.1.1 255.255.255.128
   exit
interface loopback 5
   ip address 7.1.1.1
   exit
interface loopback 7
   ip address 12.1.1.1
   exit
snmp-server community "public" unrestricted
Following is an example of the startup config output for a selected VLAN.

switch(vlan-5)# show config vlan 5

Startup configuration:

vlan 5
   name "VLAN5"
   untagged C10-C14
   ip address 5.1.1.1 255.255.255.128
   exit

The following shows an example of the startup config output for a range of interfaces for a specific VLAN.

Figure 48: Startup config output for a range of interfaces for a specific VLAN

switch(vlan-5)# show config interface C10-C13

Startup configuration:

interface C10
   untagged vlan 5
   exit
interface C11
   untagged vlan 5
   exit
interface C12
   untagged vlan 5
   exit
interface C13
   untagged vlan 5
   exit
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Using automatic configuration update with DHCP Option
66
Prerequisites

To use automatic configuration update with DHCP Option 66, you must do the following:

• Enable one or more DHCP servers with Option 66.

• Insure that one or more TFTP servers have the desired configuration file.

• Insure that the configuration files to be updated were generated on the switch.

• Enable the configuration file to update with Option 66, as described in Enabling and disabling the
configuration file update using Option 66 on page 113.

HPE switches are initially booted up with the factory-shipped configuration file. The automatic configuration
update provides a way to automatically download a different configuration file from a TFTP server using DHCP
Option 66.

Enabling and disabling the configuration file update using Option 66

Procedure

1. Use the dhcp config-file-update command to enable the configuration update using Option 66.

2. Use the no dhcp config-file-update command to disable the configuration update using Option 66.

The configuration file update using Option 66 is enabled by default.

Possible scenarios for updating the configuration file
The following table shows various network configurations and how Option 66 is handled.

Scenario Behavior

Single Server serving
Multiple VLANs • Each DHCP-enabled VLAN interface initiates DHCPDISCOVER message,

receives DHCPOFFER from the server, and send DHCPREQUEST to obtain the
offered parameters.

• If multiple interfaces send DHCPREQUESTs, it is possible that more than one
DHCPACK is returned with a valid Option 66.

• Evaluating and updating the configuration file occurs only on the primary VLAN.

• Option 66 is ignored by any interfaces not belonging to the primary VLAN.

Multiple Servers serving a
Single VLAN • Each DHCP-enabled VLAN interface initiates one DHCPDISCOVER and

receives one or more DHCPOFFER messages.

• Each interface accepts the best offer.

• Option 66 is processed only for the interface belonging to the primary VLAN.

Table Continued
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Scenario Behavior

Multiple Servers serving
Multiple VLANs • Each DHSP-enabled VLAN interface initiates DHCPDISCOVER and receives

one or more DHCPOFFER messages.

• Each interface accepts the best offer.

• Option 66 is processed only for the interface belonging to the primary VLAN.

Multi-homed Server
serving Multiple VLANs • The switch perceives the multi-homed server as multiple separate servers.

• Each DHCP-enabled VLAN interface initiates DHCPDISCOVER and receives
one DHCPOFFER message.

• Each interface accepts the offer.

• Option 66 is processed only for the interface belonging to the primary VLAN.

Operating notes about automatic configuration
Replacing the existing configuration file: After the switch has completed the DHCP transaction on the Primary
VLAN, the two options will cause the switch to download the configuration file from the TFTP server. After the
DHCP client downloads the configuration file, the switch compares the contents of that file with the existing
configuration file. If the content is different, the new configuration file replaces the existing file and the switch
reboots.

Option 66 and the IP address of a TFTP server: Option 66 includes the IP address of the TFTP server from
which the configuration file is downloaded.

Option 67 and the configuration file name: Option 67 includes the name of the configuration file. If the
DHCPACK contains this option, it overrides the default name for the configuration file (switch.cfg)

Global DHCP parameters: Global parameters are processed only if received on the primary VLAN.

Best Offer: The "Best Offer" is the best DHCP or BootP offer sent by the DHCP server in response to the
DHCPREQUEST sent by the switch. The criteria for selecting the "Best Offer" are:

• DHCP is preferred over BootP

• If two BootP offers are received, the first one is selected

• For two DHCP offers:

◦ The offer from an authoritative server is selected

◦ If there is no authoritative server, the offer with the longest lease is selected

Log messages: The file transfer is implemented by the existing TFTP module. The system logs the following
message if an incorrect IP address is received for Option 66: "Invalid IP address <ip-address> received for
DHCP Option 66".

Overview of switch configuration
Switch configuration involves:
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• How switch memory manages configuration changes

• How the CLI implements configuration changes

• How the menu interface and WebAgent implement configuration changes

• How the switch provides software options through primary/secondary flash images

• How to use the switch’s primary and secondary flash options, including displaying flash information, booting or
restarting the switch, and other topics

Configuration file management
The switch maintains two configuration files, the running-config file and the startup-config file.

Table 8: Switch memory operation

Running Config File Startup-config File

Volatile Memory Flash (Non-Volatile Memory)

Controls switch operation. When the switch boots, the
contents of this file are erased and replaced by the
contents of the startup-config file. If no configuration
changes have been made in the CLI since the switch
was last booted, the running-config file is identical to
the startup-config file.

Preserves the most recently saved configuration
through any subsequent reboot.

CLI configuration changes are written to this file. To
use the CLI to save the latest version of the file to the
startup-config file, you must execute the write memory
command.

*NOTE: Menu interface configuration changes are simultaneously written to both the running-config and the
startup-config file.

Booting the switch replaces the current running-config file with a new running-config file that is an exact copy of
the current startup-config file.

Any of the following actions boots the switch:

• Executing the boot or the reload command in the CLI

• Executing the boot command in the menu interface

• Pressing the Reset button on the front of the switch

• Removing, then restoring power to the switch

For more on reboots and the switch’s dual-flash images, See Using Primary and Secondary flash
image options on page 89.

Options for saving a new configuration. Making one or more changes to the running-config file creates a new
operating configuration. Saving a new configuration means to overwrite (replace) the current startup-config file
with the current running-config file. This means that if the switch subsequently reboots for any reason, it will
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resume operation using the new configuration instead of the configuration previously defined in the startup-config
file. There are three ways to save a new configuration:

• In the CLI:

Use the write memory command. This overwrites the current startup-config file with the contents of the
current running-config file.

• In the menu interface:

Use the Save command. This overwrites both the running-config file and the startup-config file with the
changes you have specified in the menu interface screen.

• In the WebAgent:

Click Save. This overwrites both the running-config file and the startup-config file with the changes you have
specified in the WebAgent screen.

Note that using the CLI instead of the menu or WebAgent gives you the option of changing the running
configuration without affecting the startup configuration. This allows you to test the change without making it
"permanent". When you are satisfied that the change is satisfactory, you can make it permanent by executing the
write memory command. For example, suppose that you use the following command to disable port 5:

switch(config)# interface ethernet 5 disable
The above command disables port 5 in the running-config file, but not in the startup-config file. Port 5 remains
disabled only until the switch reboots. If you want port 5 to remain disabled through the next reboot, use write
memory to save the current running-config file to the startup-config file in flash memory.

switch(config)# write memory
If you use the CLI to make a configuration change and then change from the CLI to the Menu interface without
first using write memory to save the change to the startup-config file, then the switch prompts you to save the
change. For example, if you use the CLI to create VLAN 20, and then select the menu interface, VLAN 20 is
configured in the running-config file, but not in the startup-config file. In this case you will see:

switch(config)# vlan 20
switch(config)# menu
Do you want to save current configuration [y/n]?
If you type ‘y’, the switch overwrites the startup-config file with the running-config file, and your configuration
change(s) will be preserved across reboots. If you type ‘n’, your configuration change(s) will remain only in the
running-config file. In this case, if you do not subsequently save the running-config file, your unsaved
configuration changes will be lost if the switch reboots for any reason.

Storage and retrieval of configuration files. You can store or retrieve a backup copy of the startup-config file on
another device. For more information, see "Transferring Switch Configurations" in the Management and
Configuration Guide for your switch.
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Managing interface access

Listing the current console/serial link configuration
Use the show console command to list the current console/serial link configuration.

Use of show console command

This example demonstrates the use of the show console command.

switch (config)# show console

Console/Serial Link

Inbound Telnet Enabled [Yes] : Yes
Web Agent Enabled [Yes] : Yes

Terminal Type [VT100] : VT100
Screen Refresh Interval (sec) [3] : 3
Displayed Events [All] : All
Baud Rate [speed-sense] : speed-sense
Flow Control [XON/XOFF] : XON/XOFF
Global Session Idle Timeout (sec) [0] : 0
Serial/USB Console Idle Timeout (sec) [not set] : not set
Current Session Idle Timeout (sec) : 0

Enabling and disabling inbound Telnet access
In the default configuration, inbound Telnet access is enabled.

Enabling and disabling inbound Telnet access

To enable inbound Telnet access, do one of the following:

Prerequisites

Before you enable or disable inbound Telnet access on a switch, you must insure that the switch has a separate
out-of-band management port if you want to use an out-of-band management port for Telnet access. See
Appendix I, "Network Out-of-Band Management" in this guide for more information about out-of-band
management.

Procedure

1. Use the telnet-server command to enable inbound Telnet access through the data ports.

2. Use the following command to enable inbound Telnet access through specific ports: telnet-server
[ listen < oobm | data | both > ]
Data ports ( listen data option), out-of-band management ports (listen oobm option), or both data and out-of-
band management ports (listen both) can be specified.
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To disable inbound Telnet access, do one of the following:

• Use the no telnet-server command to disable inbound Telnet access through the data ports.

• Use the following command to disable inbound Telnet access through specific ports:no telnet-server
[ listen < oobm | data | both > ]Data ports (listen data option), out-of-band management ports
(listen oobm option), or both data and out-of-band management ports (listen both) can be specified.

Examples

To disable inbound Telnet access:

switch(config)# no telnet-server
To re-enable inbound Telnet access:

switch(config)# telnet-server

Initiating an outbound Telnet session to another device
Initiating an outbound Telnet session to another network device

To initiate an outbound Telnet session, do one of the following:

Prerequisites

Before you initiate an outbound Telnet session to another network device, you must insure that:

• The switch has a separate out-of-band management port, if you want to use an out-of-band management port
for the outbound Telnet traffic. See Appendix I, "Network Out-of-Band Management" in this guide for more
information about out-of-band management.

• Stacking is enabled, if you want to initiate an outbound Telnet session to a member switch that is a
commander in a stack.

Procedure

1. Use the following command to initiate an outbound Telnet session through a data port:
telnet <ipv4-addr | ipv6-addr | hostname | switch-num>

2. Use the following command to initiate an outbound Telnet session through an out-of-band management port:
telnet < ipv4-addr | ipv6-addr | hostname | switch-num > oobm

In these commands, the destination device for the outbound Telnet session is specified as an IPv4 address, IPv6
address, hostname, or stack number (1-16) of a member switch.

Examples

If the host "Labswitch" is in the domain abc.com, you can enter the following command and the destination is
resolved to "Labswitch.abc.com":

switch(config)# telnet Labswitch
You can also enter the full domain name of the host in the command:

switch(config)# telnet Labswitch.abc.com
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You can use the show telnet command to display the resolved IP address.

Figure 49: The show telnet command displaying resolved IP addresses

switch(config)# show telnet

  Telnet Activity

  -------------------------------------------------------
  Session  : **  1
  Privilege: Manager
  From     : Console
  To       :

  -------------------------------------------------------
  Session  : **  2
  Privilege: Manager
  From     : 12.13.14.10
  To       : 15.33.66.20

  -------------------------------------------------------
  Session  : **  3
  Privilege: Operator
  From     : 2001:db7:5:0:203:4ff:fe0a:251
  To       : 2001:db7:5:0:203:4ff1:fddd:12

Web-management interface configuration for idle timeout
An administrator sets the idle timeout for the WebUI management interface and specifies a session timeout page
that is displayed to the user when the WebUI management session ends.

Use the following command to configure the Web-management interface for idle timeout:

web-management [management-url <URL>] [support-url <URL>] [plaintext] [ssl<TCP-
PORT>] [idle-timeout <300-7200>]

The following parameters are specified to configure the Web-management interface for idle timeout:
Management-url

Specify URL to load when the [?] button is clicked on the device's web interface.

Support-url

Specify URL to load when the Support tab is clicked on the device's web interface.

Plaintext

Indicates that the http server has to be enabled with no security. If no parameters are specified, plaintext
is implied. The plaintext server always listens on the well-known port 80.

SSL

Indicates that the http server has to be enabled with Secure Sockets Layer support. TCP port on which the
https server must listen for connections. If the TCP port is not specified, the default is port 443.

The ssl and plaintext variants of the command function independently of each other. Enabling http+ssl
does not automatically prevent the device from accepting plaintext connections; you must explicitly disable
plaintext connections with the command [no] web-management plaintext.

Idle-timeout

Specifies the idle timeout for web management sessions. This ranges from 300 seconds to 7200 seconds.
The default value is 600 seconds.
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The following example shows WebUI Idle timeout

switch(config)# web-management
idle-timeout Set the idle timeout for web management sessions.
management-url Specify URL for web interface [?] button.
plaintext Enable or disable the http server (insecure).
ssl Enable or disable the https server (secure).
support-url Specify URL for web interface support page.
switch(config)# web-management idle-timeout
<300-7200> Enter an integer number.

Enabling and disabling inbound WebAgent access
In the default configuration, inbound WebAgent (web browser) access, that is, inbound HTTP access, is enabled.

Enabling and disabling inbound WebAgent access

To enable inbound WebAgent access, do one of the following:

Prerequisites

Before you enable or disable inbound WebAgent access on a switch, you must insure that the switch has a
separate out-of-band management port if you want to use an out-of-band management port for WebAgent
access. See Appendix I, "Network Out-of-Band Management" in this guide for more information about out-of-band
management.

Procedure

1. Use the web-management command to enable inbound WebAgent access through the data ports.

2. Use the following command to enable inbound WebAgent access through specific ports:
web-management [ listen < oobm | data | both > ] Data ports (listen data option), out-of-band
management ports (listen oobm option), or both data and out-of-band management ports (listen both) can
be specified.

To disable inbound WebAgent access, do one of the following:

• Use the no web-management command to disable inbound WebAgent access through the data ports.

• Use the following command to disable inbound WebAgent access through specific ports:no web-
management [ listen < oobm | data | both > ]Data ports (listen data option), out-of-band
management ports (listen oobm option), or both data and out-of-band management ports (listen both) can
be specified.

Examples

To disable inbound WebAgent access:

switch(config)# no web-management
To re-enable inbound WebAgent access:

switch(config)# web-management

Reconfiguring the console/serial link settings
Use the following command to reconfigure the console/serial link settings:

console
[terminal <vt100|ansi|none>]
[screen-refresh <1|3|5|10|20|30|45|60]
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[baud-rate <speed-sense|1200|2400|4800|9600|19200|38400|57600|1155200>]
[flow-control <xon/xoff|none>]
[idle-timeout <0-7200>]
[events [<none]|all|not-info|critical|debug>]
[local-terminal <vt100|none|ansi>]
Considerations for setting idle-timeout, baud rate, and flow control settings:

• If the console idle-timeoutexpires, any outbound Telnet or SSH sessions open on the switch are terminated.

• If you change the baud rate or flow control settings, you must make the corresponding changes in your
console access device. Otherwise, you may lose connectivity between the switch and your terminal emulator
due to differences between terminal and switch settings for these two parameters.

All console parameter changes except events require that you save the configuration with write memory and
then execute boot before the new console configuration will take effect.

Switch models supporting redundant management, console settings, such as mode, flow-control, and baud-rate,
are the same on both management modules. There cannot be individual settings for each management module.

This example (Executing a series of console commands) shows how to configure the switch with the following:

• VT100 operation

• 19,200 baud

• No flow control

• 600 second (10 minutes) idle timeout

• Critical log events

switch(config)# console terminal vt100
This command will take effect after saving the
configuration and rebooting the system.

switch(config)# console baud-rate 19200
This command will take effect after saving the
configuration and rebooting the system.

switch(config)# console flow-control none
This command will take effect after saving the
configuration and rebooting the system.

switch(config)# console idle-timeout 600
switch(config)# console events critical
switch(config)# write memory
switch(config)# reload

Software version support of console/serial link settings
In software release versions K.15.12 and greater, the console inactivity-timer <minutes> command has been
deprecated and replaced by the console idle-timeout <seconds> command. As an example:

switch(config)#console inactivity-timer 2
is now equivalent to:

switch(config)#console idle-timeout 120
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In addition, the serial or USB console idle timeout can be controlled separately if needed. The console idle-
timeout serial-usb seconds command allows for this behavior. As an example:

switch(config)#console idle-timeout 120
switch(config)#console idle-timeout serial-usb 15
This sequence of commands will set the Telnet/SSH idle timeout to 120 seconds and the serial-usb idle timeout to
15 seconds. Another example:

switch(config)#console idle-timeout 120
switch(config)#console idle-timeout serial-usb 0
This sequence of commands will set the Telnet/SSH idle timeout to 120 seconds and the serial-usb idle timeout to
0, or, in other words, to never time out.

The console inactivity-timer minutes command will continue to be accepted in version, but it will be converted
to the new command format in the running configuration. This command conversion will also happen on a
software update to version if the console inactivity-timer minutes command was part of the previous
configuration.

These settings can be displayed using show console.

Interface-access parameters
The interface access in the switch operates properly by default. However, you can modify interface-access
parameters to suit your particular needs.

The following table lists the interface-access parameters that are modifiable and their default values. In most
cases, the default values are acceptable for standard operation.

Parameter Default value

Idle-Timeout 10 Minutes (disabled)

Inbound Telnet Access Enabled

Outbound Telnet Access n/a

WebAgent Access Enabled

Terminal type VT-100

Event Log event types to list (Displayed Events) All

Baud Rate Speed Sense

Flow Control XON/XOFF

Basic switch security is through passwords. You can gain additional security by using the security
features described in the Access Security Guide for your switch. You can also simply block
unauthorized access via the WebAgent or Telnet (as described in this section) and installing the
switch in a locked environment.

Terminal line width and length settings
For console/serial link and inbound telnet sessions, the switch output:
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• Uses whatever width is set by the terminal program. If width is not specified, 80 characters is the default.

• Automatically wraps on word boundaries (such as spaces) for non-columnar output

• Automatically wraps on column boundaries for columnar output

Hewlett Packard Enterprise recommends that you do not set your terminal width (terminal width <y>) above
150 columns. (Windows telnet displays up to 156 characters on 1280 pixelwide display, so 150 is comfortably
within this).

Window size negotiation for a telnet session
When a telnet connection is established with a switch, the switch always uses the default values of 80 columns by
24 lines for the window dimensions. The window can be resized by either dragging the corner of the window, or by
executing the terminal length <x> width <y> CLI command and then configuring the telnet client with
those dimensions. The new window dimensions are lost after that telnet session ends.

When the telnet connection is established with a switch, either the switch or the telnet client needs to initiate the
inquiry about the availability of NAWS. If NAWS is available, you can resize the window by dragging the corner of
the window to the desired size. The telnet software uses NAWS to tell the switch what the new window
dimensions are. If the switch supports the requested window dimensions, it uses them for all future interactions. If
the switch does not support those window dimensions, it refuses them and the telnet client requests an alternate
set of window dimensions. The negotiation continues until the telnet client and the switch agree on the window
dimensions.

The switch currently responds to a request from the remote telnet client to negotiate window size. However, some
telnet clients do not request to negotiate window size unless the switch’s telnet server suggests that NAWS is
available.

This feature allows window size negotiation to occur with telnet clients that support NAWS but do not try to use it
unless it is suggested by the switch’s telnet server. The switch’s telnet server will suggest to the telnet client that
NAWS is available.

Denying interface access
Use the kill [<session-number command to terminate a currently running remote session. Interface access
is denied when a remote session terminates.

The following example shows how to terminate a remote session using the kill command:

The switch supports up to five management sessions. The show ip ssh command lists the current management
sessions. If you are using the switch’s serial port for a console session and want to terminate an active Telnet
session, you would do the following:
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Viewing and setting system information

Viewing system information
Use the show system information command to list the current system information.

Examples

This example demonstrates the use of the show command to list the current system information.

switch# show system information

  Status and Counters - General System Information

   System Name        : switch
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   System Contact     :
   System Location    :

   MAC Age Time (sec) : 300

   Time Zone          : 0
   Daylight Time Rule : None

Setting system information
Do one of the following to set system information:

Procedure

1. Use the following command to set a plain-language identity for the switch, which helps to distinguish one
switch from another:
hostname <name-string> snmp-server [contact <system-contact>][location <system-
location>]
Each field allows up to 255 characters. To help simplify administration, it is recommended that you set
hostname to a character string that is meaningful within your system.

2. Use the mac-age-time <10-1000000>
command to set the MAC age time for learned MAC addresses. The default value is 300 seconds.

The MAC age time corresponds to the MAC Age Interval in the menu interface.

3. Use the following command to set the time zone and daylight-time rule:
time timezone <-720 - 840> time daylight-time-rule [ alaska | continental-us-and-
canada | middle-europe-and-portugal | southern-hemisphere | western-europe |
<user-defined> ]
The default daylight-time rule is none. For the time zone: east of the 0 meridian, the sign is "+"; west of the 0
meridian, the sign is "-". For example, the time zone setting for Berlin, Germany is +60 (zone + 1, or 60
minutes) and the time zone setting for Vancouver, Canada is –480 (zone – 8, or –480 minutes).

4. Use the time [<hh>:<mm>[:<ss>]][<mm>/<dd>/[<yy>]<yy>]command to set the time and
date.
The CLI uses a 24-hour clock scheme; that is, hour (hh) values from 1 p.m. to midnight are input as 13 - 24,
respectively.

Examples

Example

This example shows the use of the time command to set the switch to 9:45 a.m. on November 17, 2012:

switch(config)# time 9:45 11/17/12
This example shows the use of the time command to set the time zone and daylight time rule for Vancouver,
Canada:

switch(config)# time timezone -480 daylight-time-rule
continental-us-and-canada
This example shows the use of the mac-age-time command to set the age time to seven minutes:

switch(config)# mac-age-time 420
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This example shows the system information listing after executing the hostname command to name the switch
"Blue" with "Next-4474" as the system contact, and "North-Data-Room" as the location:

System parameters
The following table lists the system parameters that are modifiable and their default values. Configuration of
system information is optional, but recommended.

System parameter Default value

System Name switch product name

System Contact n/a

System Location n/a

300 seconds

Time Sync Method None

Time Zone 0

Daylight Time Rule None

Time January 1, 1990 at 00:00:00 at last power reset

MAC Age Time

Descriptions of the system parameters:

• System Name:

Using a unique name helps you to identify individual devices where you are using an SNMP network
management tool.

• System Contact and Location:
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This information is helpful for identifying the person administratively responsible for the switch and for
identifying the locations of individual switches.

• MAC Age Time:

The number of seconds a MAC address the switch has learned remains in the switch’s address table before
being aged out (deleted). Aging out occurs when there has been no traffic from the device belonging to that
MAC address for the configured interval.

• Time Sync Method:

Selects the method (TimeP or SNTP) the switch will use for time synchronization. For more on this topic, see
the "Time Protocols" chapter in the latest Management and Configuration Guide.

• Time Zone:

The number of minutes your time zone location is to the West (+) or East (-) of Coordinated Universal Time
(formerly GMT). The default 0 means that no time zone is configured. For example, the time zone for Berlin,
Germany is + 60 (minutes) and the time zone for Vancouver, Canada is - 480 (minutes).

• Daylight Time Rule:

Specifies the daylight savings time rule to apply for your location. The default is None. (For more on this topic,
See Appendix D, "Daylight Savings Time on switches.)

• Time:

Used in the CLI to specify the time of day, the date, and other system parameters.
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Using the menu or WebAgent to configure IP addressing

Using the Switch Setup screen to quickly setup IP addressing
If you just want to give the switch an IP address so that it can communicate on your network, or if you are not
using VLANs, Hewlett Packard Enterprise recommends that you use the Switch Setup screen to quickly configure
IP addressing.

To use the Switch Setup screen for quickly configuring IP addressing, do one of the following:

Procedure

1. Enter the setup command at the CLI Manager level prompt:

switch# setup
2. Select 8. Run Setup in the Main Menu of the menu interface.

For more on using the Switch Setup screen, See the Installation and Getting Started Guide you received with the
switch.

Using the menu to configure IP address, Gateway, and Time-To-Live (TTL)

Procedure

1. From the Main Menu, select:

  2. Switch Configuration...

      5. IP Configuration

          
2. If multiple VLANs are configured, a screen showing all VLANs appears. The Menu interface displays the IP

address for any VLAN. If you use the CLI to configure the IP address on a VLAN, use the CLI show ip
command to list them.

3. Press [E] (for Edit).

4. If the switch needs to access a router, for example, to reach off-subnet destinations, select the Default
Gateway field and enter the IP address of the gateway router.

5. If you need to change the packet Time-To-Live (TTL) setting, select Default TTL and type in a value between 2
and 255.

6. To configure IP addressing, select IP Config and do one of the following:

a. If you want to have the switch retrieve its IP configuration from a DHCP or Bootp server, at the

Chapter 9
Configuring IP Addressing
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IP Config

field, keep the value as

DHCP/ Bootp

and go to step 8.

b. If you want to manually configure the IP information, use the Space bar to select
Manual

and use the

[Tab]

key to move to the other IP configuration fields.

7. Select the IP Address field and enter the IP address for the switch.

8. Select the Subnet Mask field and enter the subnet mask for the IP address.

9. Press [Enter], then [S](for Save).

Using the WebAgent to configure IP addressing
Using the WebAgent to configure IP addressing

To configure IP addressing on the switch:

Prerequisites

Before you use the WebAgent to configure IP addressing, you must insure the switch has an IP address that is
reachable through your network.

Procedure

1. In the navigation pane, click Home.

2. Click Quick Setup.

3. In the Switch Quick Setup Parameters box, click Change.

4. Enter the IP address and any other information such as the Subnet mask and Gateway.

5. Click Save to save your changes.

6. If you need further information on using the WebAgent, click [?] to access the web-based help available for the
switch.

Using the CLI to configure IP Addressing, Gateway, and
Time-To-Live (TTL)

Viewing the current IP configuration
Do one of the following:

• Use the show ip command to view the IP addressing for each VLAN that is configured in the switch.
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If only the DEFAULT_VLAN exists, then its IP configuration applies to all ports in the switch. Where multiple
VLANs are configured, the IP addressing is listed per VLAN. The display includes switch-wide packet time-to-
live, and (if configured) the switch’s default gateway and Timep configuration.

• Use the show management
command to view the IP addressing and time server IP addressing that is configured on the switch.

Examples

The following example shows the switch's default IP addressing. In the factory default configuration (no IP
addressing assigned), the switch’s IP addressing appears as:

switch(config)# show ip

 Internet (IP) Service

   IP Routing : Disabled

   Default Gateway :
   Default TTL     : 64
   Arp Age         : 20
   Domain Suffix   :
   DNS server      :

                      |                                           Proxy ARP
VLAN                  | IP Config  IP Address      Subnet Mask    Std Local
--------------------- + ---------- --------------- -------------- ----------
DEFAULT_VLAN          | DHCP/Bootp
With multiple VLANs and some other features configured, show ip provides additional information. The following
example shows IP listing with non-default IP addressing configured

switch(config)# show ip

 Internet (IP) Service

   IP Routing : Disabled

   Default Gateway : 10.20.227.1
   Default TTL     : 64
   Arp Age         : 20
   Domain Suffix   :
   DNS server      :

                      |                                           Proxy ARP
VLAN                  | IP Config  IP Address      Subnet Mask    Std Local
--------------------- + ---------- --------------- -------------- ----------
DEFAULT_VLAN          | Manual     10.28.227.101   255.255.248.0   No   No
VLAN22                | Disabled

Configuring an IP address and subnet mask on a VLAN
Use one of the following forms of the vlan command to configure an IP address and subnet mask:
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• vlan <vlan-id> ip address <ip-address>/<mask-length>
• vlan <vlan-id> ip address <ip-address> <mask-bits>
• vlan <vlan-id> ip address <dhcp-bootp>

You must either include the ID of the VLAN for which you are configuring IP addressing or go to the context
configuration level for that VLAN. (If you are not using VLANs on the switch—that is, if the only VLAN is the
default VLAN—then the VLAN ID is always "1".)

The default IP address setting for the DEFAULT_VLAN is DHCP/Bootp. On additional VLANs you create, the
default IP address setting is disabled.

Examples

The following example configures IP addressing on the default VLAN with the subnet mask specified in mask bits.

switch(config)# vlan 1 ip address 10.28.227.103 255.255.255.0
The following example configures the same IP addressing as the preceding example, but specifies the subnet
mask by mask length.

switch(config)# vlan 1 ip address 10.28.227.103/24

Removing an IP address that is configured on a VLAN
Use one of the following forms of the vlan command to delete an IP address that is configured on a VLAN:

Procedure

1. no vlan <vlan-id> ip address <ip-address>/<mask-length>
2. no vlan <vlan-id> ip address <ip-address> <mask-bits>

Examples

The following example deletes an IP address configured on VLAN 1.

switch (config) no vlan 1 ip address 10.28.227.103/24

Multiple IP addresses configuration on a VLAN (multinetting)
Use one of the following forms of the vlan command to configure multiple IP addresses on a VLAN (multinetting).

• vlan <vlan-id> ip address <ip-address>/<mask-length>
• vlan <vlan-id> ip address <ip-address> <mask-bits>

The following is supported:

• Up to 2000 IP addresses for the switch.

• Up to 32 IP addresses for the same VLAN

• Up to 512 IP VLANs, that is, VLANs on which you can configure IP addresses

• Each IP address on a VLAN must be for a separate subnet, whether on the same VLAN or different VLANs.

The Internet (IP) Service screen in the Menu interface displays the first IP address for each VLAN. You must use
the CLI show ip command to display the full IP address listing for multinetted VLANs.
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Configuring and displaying multi netted VLAN

If you wanted to multinet VLAN_20 (VID = 20) with the IP addresses shown below, you would perform steps
similar to the following. For this example, assume that the first IP address is already configured.

IP Address VID IP Address Subnet Mask

1st address 20 10.25.33.101 255.255.240.0

2nd address 20 10.26.33.101 255.255.240.0

3rd address 20 10.27.33.101 255.255.240.0

switch(config)# vlan 20
switch(vlan-20)# ip address 10.26.33.101/20
switch(vlan-20)# ip address 10.27.33.101/20

switch(config)# show ip

 Internet (IP) Service

   IP Routing      : Disabled

   Default Gateway : 10.20.227.1
   Default TTL     : 64
   Arp Age         : 20
   Domain Suffix   : 
   DNS server      :

                       |                                           Proxy ARP
   VLAN                | IP Config  IP Address      Subnet Mask    Std Local
   ------------------- + ---------- --------------- -------------- ----------
   DEFAULT_VLAN        | Manual     10.20.30.100   255.255.240.0   No   No
   VLAN_20             | Manual     10.25.33.101   255.255.240.0   No   No
                       | Manual     10.26.33.101   255.255.240.0   No   No
                       | Manual     10.27.33.101   255.255.240.0   No   No

Multinetting on the default VLAN

To multinet the default VLAN, you would do the following:

switch(vlan-20)# vlan 1
switch(vlan-1)# ip address 10.21.30.100/20

switch(config)# show ip

 Internet (IP) Service

   IP Routing      : Disabled

   Default Gateway : 10.20.227.1
   Default TTL     : 64
   Arp Age         : 20
   Domain Suffix   : 
   DNS server      :
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                       |                                           Proxy ARP
   VLAN                | IP Config  IP Address      Subnet Mask    Std Local
   ------------------- + ---------- --------------- -------------- ----------
   DEFAULT_VLAN        | Manual     10.20.30.100   255.255.240.0   No   No
                       | Manual     10.21.30.100   255.255.240.0   No   No
   VLAN_20             | Manual     10.25.33.101   255.255.240.0   No   No
                       | Manual     10.26.33.101   255.255.240.0   No   No
                       | Manual     10.27.33.101   255.255.240.0   No   No

Removing IP addresses from a multinetted VLAN
Use one of the following forms of the vlan command to delete an IP address that is configured on a multinetted
VLAN:

Procedure

1. no vlan <vlan-id> ip address <ip-address>/<mask-length>
2. no vlan <vlan-id> ip address <ip-address> <mask-bits>

Configuring the optional default gateway

Prerequisites

Before you use the CLI to configure the optional default gateway, you must be at the global configuration level.

One default gateway can be manually assigned to the switch. The switch does not allow IP addressing received
from a DHCP or Bootp server to replace a manually configured default gateway.

Configuring the optional default gateway

Use the ip default-gateway <ip-address> command to configure the optional default gateway:

Examples

The following example shows the configuration of the default gateway with the IP address 10.28.227.115.

switch(config)# ip default-gateway 10.28.227.115

Setting the Time-To-Live (TTL)

Prerequisites

Before you use the CLI to set the TTL, you must be at the global configuration level.

The Time-To-Live (TTL) is the maximum number of routers (hops) through which a packet can pass before being
discarded. Each router decreases a packet’s TTL by 1 before forwarding the packet. If a router decreases the TTL
to 0, the router drops the packet instead of forwarding it.

Setting the TTL

Use the ip ttl <number-of-hops> command to set the TTL. The default value for the TTL is 64 and the
range is 2 - 255.

Examples

The following example sets the TTL to 60.

switch(config)# ip ttl 60

Managing loopback interfaces
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Adding a loopback interface

This task is not support by Switch 2530 (J9772A–J9783A) products.

Adding a loopback interface

To add a loopback interface on the switch:

Prerequisites

Before you use the CLI to add a loopback interface, you must be at the global configuration level.

Procedure

1. Use the interface loopback <number> command to create the loopback interface. The number
argument is a value from 1 to 7.

2. Use the ip address <ip address> command to configure an IP address for the loopback interface.

3. You can configure up to 32 IP addresses on a loopback interface. You do not need to specify a network mask.
A loopback interface uses the default subnet mask 255.255.255.255.

Examples

Figure 50: A loopback interface configured with one IP address

switch(config)# interface loopback 1
switch(config)# ip address 10.1.1.1
Figure 51: Loopback interfaces configured with multiple IP addresses

This example shows the addition of two loopback interfaces, each with two IP addresses configured.

switch(config)# interface loopback 0
switch(lo0)# ip address 172.16.101.8
switch(lo0)# ip address 172.16.101.9
switch(lo0)# exit
switch(config)# interface loopback 1
switch(lol)# ip address 172.16.102.1
switch(lol)# ip address 172.16.102.2

Removing a loopback interface

Prerequisites

Before you use the CLI to remove a loopback interface, you must be at the global configuration level.

This task is not support by Switch 2530 (J9772A–J9783A) products.

Removing a loopback interface

Use the no interface loopback <number> command to remove a loopback interface. The number
argument is a value from 1 to 7, specifying the loopback interface to be removed.
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You cannot remove the default loopback interface (number 0) with IP address 127.0.0.1.

Displaying loopback interface configurations
Do one of the following:

• Use the show ip command to display a list of the loopback interfaces, which are sorted according to the
loopback number.

The list of loopback interfaces is displayed below other IP configuration parameters, such as packet TTL and
ARP age-out values, and VLAN IP configurations. The default loopback interface (

• Use the show ip route command to display the loopback interfaces in a list of IP routing entries. The list is
sorted according to the destination IP address.

Examples

The following example displays the IP addresses configured for two user-defined loopback interfaces(lo1 and
lo2).

switch# show ip

 IP Routing : Enabled

   Default Gateway : 15.255.128.1
   Default TTL     : 64
   Arp Age         : 20
   Domain Suffix   :
   DNS server      : 

                    |                                           Proxy ARP
   VLAN             | IP Config  IP Address      Subnet Mask    Std Local
   ---------------- + ---------- --------------- -------------- ----------
   DEFAULT_VLAN     | Manual     10.0.8.121     255.255.0.0     No   No
   VLAN2              Manual     192.168.12.1   255.255.255.0   No   No
   VLAN3              Disabled

                           Loopback Addresses
   Loopback   IP Config    IP Address           Subnet Mask
   --------   ----------   ------------------   ---------------
   lol        Manual       172.16.110.2         255.255.255.255 
   lo2        Manual       172.16.112.2         255.255.255.255 
   lo2        Manual       172.16.114.1         255.255.255.255
The following example displays the configuration of the default loopback interface (lo0) and one user-defined
loopback interface (lo2).

switch# show ip route

                                IP Route Entries

Destination        Gateway         VLAN Type      Sub-Type   Metric    Dist.
------------------ --------------- ---- --------- ---------- --------- ----
10.0.0.0/16        DEFAULT_VLAN    1    connected             1         0
127.0.0.0/8        reject               static                0         0
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127.0.0.1/32       lo0                  connected             1         0
172.16.10.121/32   lo2                  static                1         0
172.16.100.0/24    10.0.8.11       1    ospf       IntraArea  1         1
172.16.102.0/24    VLAN2           2    connected             1         0

Summary of loopback interface configuration
Summary of loopback interface configuration:

• You can configure a loopback interface only from the CLI; you cannot configure a loopback interface from the
WebAgent or Menu interface.

• Loopback interfaces share the same IP address space with VLAN configurations. The maximum number of IP
addresses supported on a switch is 2048, which includes all IP addresses configured for both VLANs and
loopback interfaces (except for the default loopback IP address 127.0.0.1).

• Each IP address that you configure on a loopback interface must be unique in the switch. This means that the
address cannot be used by a VLAN interface or another loopback interface.

• For example, if you configure a VLAN with IP address 172.16.100.8/24, you cannot configure a loopback
interface with IP address 172.16.100.8. In the same way, if you configure a loopback interface (lo1) with IP
address 172.16.101.8, you cannot configure another loopback interface (lo2) with IP address 172.16.101.8.

• You can configure multiple IP addresses on a loopback interface (lo0 to lo7). Up to 32 IP addresses are
supported on a loopback interface.

Overview of loopback interfaces
By default, each switch has an internal loopback interface (lo0) with the IP address 127.0.0.1. This IP address is
used only for internal traffic transmitted within the switch and is not used in packet headers in egress traffic sent to
network devices.

You can configure up to seven other loopback interfaces (lo1, lo2, lo3, and so on) on the switch to use to
transmit network across the network. Each loopback interface can have multiple IP addresses. Routing protocols,
such as RIP and OSPF, advertise the configured loopback addresses throughout a network or autonomous
system.

User-defined loopback addresses provide the following benefits:

• A loopback interface is a virtual interface that is always up and reachable as long as at least one of the IP
interfaces on the switch is operational. As a result, a loopback interface is useful for debugging tasks since its
IP address can always be pinged if any other switch interface is up.

• You can use a loopback interface to establish a Telnet session, ping the switch, and access the switch through
SNMP, SSH, and HTTP (WebAgent).

• A loopback IP address can be used by routing protocols. For example, you can configure the loopback IP
address as the router ID used to identify the switch in an OSPF area. Because the loopback interface is
always up, you ensure that the switch's router ID remains constant and that the OSPF network is protected
from changes caused by downed interfaces.

OSPF does not require that you use an IP address as the router ID. OSPF only requires the router ID to be a
unique value within the autonomous system (AS). However, if you configure the loopback IP address as the router
ID, OSPF can reach the switch if any switch interface is up. (Normally, OSPF automatically configures the router
ID with the IP address of a switch interface. The disadvantage is that if the interface goes down, OSPF can no
longer ping the switch using the router ID even if other interfaces are operational.)

For more information about how to configure a loopback IP address to participate in an OSPF broadcast area,
see the titled "(Optional) Assigning Loopback Addresses to an Area" in the Multicast and Routing Guide.
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Retaining VLAN-1 IP addressing across configuration file
downloads

Enabling IP preserve to retain VLAN-1 IP addressing

Procedure

1. IP Preserve retains VLAN-1 IP addressing across configuration file downloads.

2. To set up IP Preserve, insert the “ip preserve“ at the end of a configuration file, as shown in the following
example. Note that you do not execute IP Preserve by entering a command in the CLI.

; J9091A Configuration Editor; Created on release #K.15.14.0001
hostname "switch"
time daylight-time-rule None
.
.
.
password manager
password operator
ip preserve

Operating rules for IP preserve
When ip preserve is entered as the last line in a configuration file stored on a TFTP server:

• If the switch’s current IP address for VLAN 1 was not configured by DHCP/ Bootp, IP Preserve retains the
switch’s current IP address, subnet mask, and IP gateway address when the switch downloads the file and
reboots. The switch adopts all other configuration parameters in the configuration file into the startup-config
file.

• If the switch’s current IP addressing for VLAN 1 is from a DHCP server, IP Preserve is suspended. In this
case, whatever IP addressing the configuration file specifies is implemented when the switch downloads the
file and reboots. If the file includes DHCP/Bootp as the IP addressing source for VLAN 1, the switch will
configure itself accordingly and use DHCP/ Bootp. If instead, the file includes a dedicated IP address and
subnet mask for VLAN 1 and a specific gateway IP address, then the switch will implement these settings in
the startup-config file.

• The ip preserve statement does not appear in show config listings. To verify IP Preserve in a
configuration file, open the file in a text editor and view the last line.

Overview of IP preserve
For the switches covered in this guide, IP Preserve enables you to copy a configuration file to multiple switches
while retaining the individual IP address and subnet mask on VLAN 1 in each switch, and the Gateway IP address
assigned to the switch. This enables you to distribute the same configuration file to multiple switches without
overwriting their individual IP addresses.

To summarize the IP Preserve effect on IP addressing:
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• If the switch received its most recent VLAN 1 IP addressing from a DHCP/ Bootp server, it ignores the ip
preserve command when it downloads the configuration file, and implements whatever IP addressing
instructions are in the configuration file.

• If the switch did not receive its most recent VLAN 1 IP addressing from a DHCP/Bootp server, it retains its
current IP addressing when it downloads the configuration file.

• The content of the downloaded configuration file determines the IP addresses and subnet masks for other
VLANs.

The following examples demonstrate the operation of IP Preserve:

Figure 52: Example of IP Preserve operation with multiple series switches

If you apply the following configuration file to the scenario that is shown in Figure 52: Example of IP Preserve
operation with multiple series switches on page 138, switches 1 - 3 will retain their manually assigned IP
addressing and switch 4 will be configured to acquire its IP addressing from a DHCP server.

Configuration file in TFTP server with DHCP/Bootp specified as the IP addressing source

switch(config)# show run

Running configuration:

; J9091A Configuration Editor; Created on release #K.15.10.0001

hostname "switch"
module 1 type J8702A
module 2 type J8705A
trunk A11-A12 Trk1 Trunk
ip default-gateway 10.10.10.115
snmp-server community "public" Unrestricted
vlan 1
   name "DEFAULT_VLAN"
   untagged A1-A10,A13-A24,B1-B24,Trk1
   ip address dhcp-bootp
   exit
spanning-tree Trk1 priority 4
password manager
password operator

138 Aruba Basic Operation Guide for ArubaOS-Switch 16.05

Anexo 02 ITENS 8 E 9 (0592700)         SEI 0008478-63.2018.6.02.8000 / pg. 6524



If you apply the following configuration file to the scenario that is shown in Figure 52: Example of IP Preserve
operation with multiple series switches on page 138, switches 1 - 3 will still retain their manually assigned IP
addressing. However, switch 4 will be configured with the IP addressing included in the file.

Configuration file in TFTP server with dedicated IP addressing, instead of DHCP/Bootp

switch# show run

Running configuration:

; J9091A Configuration Editor; Created on release #K.15.10.0001

hostname "switch"
module 1 type J8702A
module 2 type J8705A
trunk A11-A12 Trk1 Trunk
ip default-gateway 10.10.10.115
snmp-server community "public" Unrestricted
vlan 1
   name "DEFAULT_VLAN"
   untagged A1,A7-A10,A13-A24,B1-B24,Trk1
   ip address 10.12.17.175 255.255.255.0
   tagged A4-A6
   no untagged A2-A3
   exit
vlan 2
   name "VLAN2"
   untagged A2-A3
   no ip address
   exit
spanning-tree Trk1 priority 4
password manager
password operator

Configuring a single source IP address for software
applications

Specifying the source IP address
Only one source IP address can be specified for each software application.

Do one of the following:

• Use the following command to specify the source IP address for the specified software application.

ip source-interface
< radius | sflow | sntp | syslog | tacacs | telnet | tftp >
< loopback <id> | vlan <vlan-id> | address <ip-address> >

• Use the following command to specify the source IP address for all software applications.

ip source-interface all
< loopback <id> | vlan <vlan-id> | address <ip-address> >

• loopback <id> :

Specifies that the IP address of the loopback interface is used as the source IP address in outgoing packets. If
the loopback interface has no IP address, then the application reverts to the default behavior. If more than one
IP address is configured, then the lowest IP address is used.
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• vlan <vlan-id> :

Specifies that the IP address of the indicated VLAN interface is used as the source IP address of outgoing
packets. If the specified VLAN interface has no IP address configured, or is down, then the application reverts
to the default behavior. If more than one IP address is configured, then the lowest IP address is used.

• address <ip-address> :

Specifies the IP address that should be used as the source IP address of outgoing packets. The IP address
must be a valid IP address configured on one of the switch’s VLAN or loopback interfaces. If the interface is
down, then the application reverts to the default behavior.

Canceling the source IP address assignment
When the source IP address assignment for a software application is canceled, the application reverts to its
default behavior and the system determines the source IP address of outgoing application-specific IP packets at
packet transmission time.

Do one of the following:

• Use the following command to cancel the source IP address assignment for the specified software application.

no ip source-interface 
< radius | sflow | sntp | syslog | tacacs | telnet | tftp >

• Use the following command to cancel the source IP address assignment for all software applications.

no ip source-interface all

Viewing source IP address configurations
Do one of the following:

• Use the following command to view the source IP address configuration for the specified protocol.

show ip source-interface
[ radius | sflow | sntp | tacacs | telnet | tftp | syslog ]

• Use the following command to view the source IP address configuration for all protocols.

show ip source-interface

Examples

The following example shows a specific IP address assigned for the RADIUS application protocol

switch(config)# ip source-interface radius address 10.10.10.2

switch(config)# show ip source-interface radius

  Source-IP Configuration Information

  Protocol | Admin Selection Policy  IP Interface   IP Address
  -------- + ----------------------- -------------- --------------
  Radius   | Configured IP Address   vlan 3         10.10.10.2 
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The following example shows a VLAN interface assigned as the source IP address for the TACACS application
protocol

switch(config)# ip source-interface tacacs vlan 22

switch(config)# show ip source-interface tacacs

  Source-IP Configuration Information

   Protocol | Admin Selection Policy  IP Interface   IP Address
   -------- + ----------------------- -------------- --------------
   Tacacs   | Configured IP Interface vlan 22        10.10.10.4 
The following example shows Source IP address configurations for all application protocols

switch(config)# show ip source-interface

 Source-IP Configuration Information

  Protocol | Admin Selection Policy  IP Interface  IP Address
  -------- + ----------------------- ------------- ---------------
  Tacacs   | Configured IP Interface vlan 22
  Radius   | Configured IP Address                 10.10.10.2
  Syslog   | Configured IP Interface vlan 10
  Telnet   | Outgoing Interface
  Tftp     | Outgoing Interface
  Sntp     | Outgoing Interface
  Sflow    | Outgoing Interface

Viewing source IP selection policy status
Do one of the following:

• Use the following command to view the source IP selection policy status for the specified protocol.

show ip source-interface status
[ radius | sflow | sntp | tacacs | telnet | tftp | syslog ]

• Use the following command to view the source IP selection policy status for all protocols.

show ip source-interface status

The following example shows Source IP selection policy status for all application protocols

switch(config)# show ip source-interface status

 Source-IP Status Information

  Protocol | Admin Selection Policy  Oper Selection Policy
  -------- + ----------------------- ----------------------
  Tacacs   | Configured IP Interface Configured IP Interface
  Radius   | Configured IP Address   Configured IP Address
  Syslog   | Configured IP Interface Outgoing Interface
  Telnet   | Outgoing Interface      Outgoing Interface
  Tftp     | Outgoing Interface      Outgoing Interface
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  Sntp     | Outgoing Interface      Outgoing Interface
  Sflow    | Configured IP Address   Configured IP Address

Viewing full source IP details
The full source IP details for an application protocol include the source IP selection policy status, the source IP
address configuration, and the state of the source IP interface.

Do one of the following:

• Use the following command to view the full source IP details for the specified protocol.

show ip source-interface detail
[ radius | sflow | sntp | tacacs | telnet | tftp | syslog ]

• Use the following command to view the full source IP details for all protocols.

show ip source-interface detail

Examples

The following example shows detailed information displayed for the Tacacs application protocol.

switch(config)# show ip source-interface detail tacacs

 Source-IP Detailed Information

  Protocol : Tacacs
  Admin Policy           : Configured IP Interface
  Oper Policy            : Outgoing Interface
  Source IP Interface    : Vlan 22
  Source IP Address      : 10.10.10.4
  Source Interface State : Down
The following example shows detailed information displayed for each application protocol.

switch(config)# show ip source-interface detail

  Source-IP Detailed Information

   Protocol : Tacacs
   Admin Policy           : Configured IP Interface
   Oper Policy            : Configured IP Interface
   Source IP Interface    : vlan 22
   Source IP Address      : 10.10.10.4
   Source Interface State : Up

   Protocol : Radius
   Admin Policy           : Configured IP Address
   Oper Policy            : Configured IP Address
   Source IP Interface    : vlan 3
   Source IP Address      : 10.10.10.2
   Source Interface State : Up

   Protocol : Syslog
   Admin Policy           : Configured IP Interface
   Oper Policy            : Configured IP Interface
   Source IP Interface    : vlan 10
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   Source IP Address      : 10.10.10.10
   Source Interface State : Up

   Protocol : Telnet
   Admin Policy           : Configured IP Interface
   Oper Policy            : Configured IP Interface
   Source IP Interface    : loopback 1
   Source IP Address      : 10.10.10.11
   Source Interface State : Up

   Protocol : Tftp
   Admin Policy           : Outgoing Interface
   Oper Policy            : Outgoing Interface
   Source IP Interface    : N/A
   Source IP Address      : N/A
   Source Interface State : N/A

   Protocol : Sntp
   Admin Policy           : Outgoing Interface
   Oper Policy            : Outgoing Interface
   Source IP Interface    : N/A
   Source IP Address      : N/A
   Source Interface State : N/A

   Protocl : Sflow
   Admin Policy           : Outgoing Interface
   Oper Policy            : Outgoing Interface
   Source IP Interface    : N/A
   Source IP Address      : N/A
   Source Interface State : N/A

Viewing protocol configuration and status information
Use the following command to view configuration and status information for the specified application protocol. The
displayed information includes the operational source IP selection policy.

show [ radius | sflow | sntp | tacacs | telnet | tftp | syslog ]
Examples

The following example shows the details for the Radius application protocol

switch(config)# show radius

Status and Counters - General RADIUS Information

  Deadtime(min) : 0
  Timeout(secs) : 5
  Retransmit Attempts : 3
  Global Encryption Key :
  Dynamic Authorization UDP Port : 3799
  Source IP Selection : Configured IP address
The following example shows the details for the Telnet application protocol

switch(config)# show telnet

  Telnet Activity
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  Source IP Selection: 10.10.10.11

  -------------------------------------------------------
  Session  : **  1
  Privilege: Manager
  From     : Console
  To       : 
The following example shows details for the SNTP application protocol

switch(config)# show sntp

SNTP Configuration

SNTP Authentication : Disabled
Time Sync Mode: Timep
SNTP Mode : disabled
Poll Interval (sec) [720] : 720
Source IP Selection: Outgoing Interface

Configuration error messages
The following error messages may appear when configuring source IP selection if the interface does not exist, is
not configured for IP, or is down.

Error Message Description

Warning: Specified IP address is not configured
on any interface

The IP address specified has not been assigned to any
interface on the switch.

Warning: Specified IP interface is not configured The IP interface has not been configured.

Warning: Specified IP interface is not configured
for IP

An IP address has not been assigned to this interface.

Warning: Specified IP interface is down The interface on the switch associated with this IP address is
down.

Warning: Specified IP interface is configured for
DHCP

The IP address has not been configured specifically
(manually) for this interface and may change.

Overview of single source IP addresses for software applications
A single source IP address can be configured for the following software applications:

• RADIUS

• SFlow

• SNTP

• System Logging applications

• TACACS

• Telnet

• TFTP
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The above IP-based software applications use a client-server communication model, that is, the client’s source IP
address is used for unique client identification. The source IP address is determined by the system and is usually
the IP address of the outgoing interface in the routing table. However, routing switches may have multiple routing
interfaces due to load balancing or routing redundancy, and outgoing packets can potentially be sent by different
paths at different times. This results in different source IP addresses, which creates a client identification problem
on the server site. For example, there is no way to designate a fixed IP address for outgoing packets for RADIUS
or TACACS, so it is necessary to configure in the RADIUS or TACACS database all possible IP addresses that
are configured on the switch as valid clients. When using system logging, it can be difficult to interpret the logging
and accounting data on the server site as the same client can be logged with different IP addresses.

To decrease the amount of administrative work involved, a configuration model is provided that allows the
selection of an IP address to use as the source address for all outgoing traffic generated by a specified software
application on the switch. This allows unique identification of the software application on the server site regardless
of which local interface has been used to reach the destination server.

The source IP selection policy
The source IP address selection for the application protocols is defined through assignment of one of the
following policies:

• Outgoing Interface—the IP address of the outgoing IP interface is used as the source IP address. This is the
default policy and the default behavior of applications.

• Configured IP Address—the specific IP address that is used as the source IP address. This address is
configured on one of the switch’s IP interfaces, either a VLAN interface or a Loopback interface.

• Configured IP Interface—the IP address from the specific IP interface (VLAN or Loopback) is used as the
source IP address. If there are multiple IP addresses assigned (multinetting, for example), the lowest IP
address is used.

If the selection policy cannot be executed because the interface does not have an IP address configured, does
not exist, or is down, the application protocol uses the default Outgoing Interface policy. A warning message is
displayed, but the configuration changes are accepted. When using the show ip source-interface status
command to display information about the source IP address selection policy, the administratively-assigned
source IP selection policy and the actual (operational) source IP selection policy in effect are displayed.

The operational source IP selection policy may be different from the assigned source selection policy if the IP
interface does not exist or is down. In this case, the default of Outgoing Interface appears as the operational
policy, as shown in the following example.

The administratively-assigned source IP selection policy differing from the operational policy

switch(config)# show ip source-interface detail tacacs

 Source-IP Detailed Information

  Protocol : Tacacs
  Admin Policy           : Configured IP Interface
  Oper Policy            : Outgoing Interface
  Source IP Interface    : Vlan 22
  Source IP Address      : 10.10.10.4
  Source Interface State : Down
Below is an example of assigning a specific source IP address for a RADIUS application. The administrative
policy is Configured IP Address.
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A specific IP address assigned for the RADIUS application protocol

switch(config)# ip source-interface radius address 10.10.10.2

switch(config)# show ip source-interface radius

  Source-IP Configuration Information

  Protocol | Admin Selection Policy  IP Interface   IP Address
  -------- + ----------------------- -------------- --------------
  Radius   | Configured IP Address   vlan 3         10.10.10.2 
In the example below, a VLAN interface (VLAN 22) is specified as the source IP address for TACACS. The
administrative policy is Configured IP Interface.

Using a VLAN interface as the source IP address for TACACS

switch(config)# ip source-interface tacacs vlan 22

switch(config)# show ip source-interface tacacs

  Source-IP Configuration Information

   Protocol | Admin Selection Policy  IP Interface   IP Address
   -------- + ----------------------- -------------- --------------
   Tacacs   | Configured IP Interface vlan 22        10.10.10.4 
The next example shows a VLAN interface being specified as the source IP address for logging. The
administrative policy is Configured IP Interface.

Using a VLAN interface as the source IP Address for logging (Syslog)

switch(config)# ip source-interface syslog vlan 10

switch(config)# show ip source-interface syslog

  Source-IP Configuration Information

   Protocol | Admin Selection Policy  IP Interface   IP Address
   -------- + ----------------------- -------------- --------------
   Syslog   | Configured IP Interface vlan 10        10.10.10.10

IP configuration features
IP configuration features:

Feature Default

IP Address and Subnet Mask DHCP/Bootp

Multiple IP Addresses on a VLAN n/a

Default Gateway Address none

Packet Time-To-Live (TTL) 64 seconds

Table Continued
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Feature Default

Time Server (Timep)1 DHCP

Single Source IP Addressing outgoing IP address

1 For more on this topic, see the "Time Protocols" chapter in the latest Management and Configuration Guide.

IP address and subnet mask. Configuring the switch with an IP address expands your ability to manage the
switch and use its features. By default, the switch is configured to automatically receive IP addressing on the
default VLAN from a DHCP/Bootp server that has been configured correctly with information to support the
switch. (See DHCP/Bootp operation on page 150 for information on setting up automatic configuration from a
server.) However, if you are not using a DHCP/Bootp server to configure IP addressing, use the menu interface or
the CLI to manually configure the initial IP values. After you have network access to a device, you can use the
WebAgent to modify the initial IP configuration if needed.

For information on how IP addressing affects switch operation, See Effects of IP addressing on switch
operation on page 147.

Multinetting: assigning multiple IP addresses to a VLAN. For a given VLAN you can assign up to 32 IP
addresses. This allows you to combine two or more subnets on the same VLAN, which enables devices in the
combined subnets to communicate normally through the network without needing to reconfigure the IP addressing
in any of the combined subnets.

Default gateway operation. The default gateway is required when a router is needed for tasks such as reaching
off-subnet destinations or forwarding traffic across multiple VLANs. The gateway value is the IP address of the
next-hop gateway node for the switch, which is used if the requested destination address is not on a local subnet/
VLAN. If the switch does not have a manually-configured default gateway and DHCP/Bootp is configured on the
primary VLAN, then the default gateway value provided by the DHCP or Bootp server will be used. If the switch
has a manually configured default gateway, then the switch uses his gateway, even if a different gateway is
received via DHCP or Bootp on the primary VLAN. This is also true for manually configured TimeP, SNTP, and
Time-To-Live(TTL). (In the default configuration, VLAN 1 is the Primary VLAN.)

For more information on Primary VLANs, see the Advanced Traffic Management Guide.

For more information on TimeP and SNTP, see the “Time Protocols” chapter in the Management and
Configuration Guide.

Packet Time-To-Live (TTL). This parameter specifies the maximum number of routers (hops) through which a
packet can pass before being discarded. Each router decreases a packet’s TTL by 1 before forwarding the
packet. If decreasing the TTL causes the TTL to be 0, the router drops the packet instead of forwarding it. In most
cases, the default setting (64) is adequate.

Effects of IP addressing on switch operation
Without an IP address and subnet mask compatible with your network, the switch can be managed only through a
direct terminal device connection to the Console RS-232 port. You can use direct-connect console access to take
advantage of features that do not depend on IP addressing. However, to realize the full capabilities HPE proactive
networking offers through the switch, configure the switch with an IP address and subnet mask compatible with
your network. The following table lists the general features available with and without a network-compatible IP
address configured.

Chapter 9 Configuring IP Addressing 147

Anexo 02 ITENS 8 E 9 (0592700)         SEI 0008478-63.2018.6.02.8000 / pg. 6533



Table 9: Features available with and without IP addressing on the switch

Features available without an IP Address Additional features available with an IP Address
and subnet mask

• Direct-connect access to the CLI and the menu
interface

• DHCP or Bootp support for automatic IP address
configuration, and DHCP support for automatic
Timep server IP address configuration

• Multiple Spanning Tree Protocol

• Port settings and port trunking

• Switch meshing

• Console-based status and counters information for
monitoring switch operation and diagnosing
problems through the CLI or menu interface

• VLANs and GVRP

• Serial downloads of software updates and
configuration files (Xmodem)

• Link test

• Port monitoring

• Password authentication

• Quality of Service (QoS)

• Authorized IP manager security

• WebAgent access, with configuration, security, and
diagnostic tools, plus the Alert Log for discovering
problems detected in the switch along with
suggested solutions

• SNMP network management access for network
configuration, monitoring, problem-finding, and
reporting, analysis, and recommendations for
changes to increase control and uptime

• TACACS+, RADIUS, SSH, SSL, and 802.1X
authentication

• Multinetting on VLANs

• Telnet access to the CLI or the menu interface

• IGMP

• TimeP and SNTP server configuration1

• TFTP download of configurations and software
updates

• Access Control Lists (ACLs)

• IP routing, Multicast Routing

• VRRP router redundancy

• PIM-DM and PIM-SM

• Radius

• Ping test

1 For more information on TimeP and SNTP, see the “Time Protocols” chapter in the Management and Configuration Guide.

Network preparations for configuring DHCP/Bootp
In its default configuration, the switch is configured for DHCP/Bootp operation. However, the DHCP/Bootp feature
will not acquire IP addressing for the switch unless the following tasks have already been completed:

• For Bootp operation

◦ A Bootp database record has already been entered into an appropriate Bootp server

◦ The necessary network connections are in place

◦ The Bootp server is accessible from the switch

• For DHCP operation
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◦ A DHCP scope has been configured on the appropriate DHCP server

◦ The necessary network connections are in place

◦ A DHCP server is accessible from the switch

Designating a primary VLAN other than the default VLAN affects the switch’s use of information
received via DHCP/Bootp. For more on this topic, See the describing VLANs in the Advanced Traffic
Management Guide for your switch.

After you reconfigure or reboot the switch with DHCP/Bootp enabled in a network providing DHCP/Bootp service,
the switch does the following:

• Receives an IP address and subnet mask and, if configured in the server, a gateway IP address and the
address of a Timep server.

• If the DHCP/Bootp reply provides information for downloading a configuration file, the switch uses TFTP to
download the file from the designated source, then reboots itself. (This assumes that the switch or VLAN has
connectivity to the TFTP file server specified in the reply, that the configuration file is correctly named, and that
the configuration file exists in the TFTP directory.)

Overview of IP Addressing
You can configure IP addressing through all the switch’s interfaces. You can also:

• Easily edit a switch configuration file to allow downloading the file to multiple switches without overwriting each
switch’s unique gateway and VLAN 1 IP addressing.

• Assign up to 32 IP addresses to a VLAN (multinetting).

• Select an IP address to use as the source address for all outgoing traffic generated by a specified software
application on the switch. This allows unique identification of the software application on the server site
regardless of which local interface has been used to reach the destination server.

Why configure IP addressing? In its factory default configuration, the switch operates as a multiport learning
bridge with network connectivity provided by the ports on the switch. However, to enable specific management
access and control through your network, you will need IP addressing. Effects of IP addressing on switch
operation on page 147 shows the switch features that depend on IP addressing to operate.

IP addressing with multiple VLANs
In the factory default configuration, the switch has one, permanent default VLAN (named DEFAULT_VLAN) that
includes all ports on the switch. Thus, when only the default VLAN exists in the switch, if you assign an IP
address and subnet mask to the switch, you are actually assigning the IP addressing to the DEFAULT_VLAN.
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• If multiple VLANs are configured, then each VLAN can have its own IP address. This is because
each VLAN operates as a separate broadcast domain and requires a unique IP address and
subnet mask. A default gateway (IP) address for the switch is optional, but recommended.

• In the factory default configuration, the default VLAN (named DEFAULT_VLAN) is the switch’s
primary VLAN. The switch uses the primary VLAN for learning the default gateway address. The
switch can also learn other settings from a DHCP or Bootp server, such as (packet) Time-To-Live
(TTL), and Timep or SNMP settings. (Other VLANs can also use DHCP or BootP to acquire IP
addressing. However, the switch’s gateway, TTL, and TimeP or SNTP values, which are applied
globally, and not per-VLAN, will be acquired through the primary VLAN only, unless manually set
by using the CLI, Menu, or WebAgent. (If these parameters are manually set, they will not be
overwritten by alternate values received from a DHCP or Bootp server.) For more on VLANs, see
the titled “Static Virtual LANs” in the Advanced Traffic Management Guide for your switch.

• The IP addressing used in the switch must be compatible with your network. That is, the IP
address must be unique and the subnet mask must be appropriate for your IP network.

• If you change the IP address through either Telnet access or the WebAgent, the connection to the
switch will be lost. You can reconnect by either restarting Telnet with the new IP address or
entering the new address as the URL in your web browser.

DHCP/Bootp operation
Overview. DHCP/Bootp is used to provide configuration data from a DHCP or Bootp server to the switch. This
data can be the IP address, subnet mask, default gateway, Timep Server address, and TFTP server address. If a
TFTP server address is provided, this allows the switch to TFTP a previously saved configuration file from the
TFTP server to the switch. With either DHCP or Bootp, the servers must be configured prior to the switch being
connected to the network.

The switches covered in this guide are compatible with both DHCP and Bootp servers.

The DHCP/Bootp process. Whenever the IP Config parameter in differences the switch or in an individual
VLAN in the switch is configured to DHCP/Bootp (the default), or when the switch is rebooted with this
configuration:

1. DHCP/Bootp requests are automatically broadcast on the local network. (The switch sends one type of request
to which either a DHCP or Bootp server can respond.)

2. When a DHCP or Bootp server receives the request, it replies with a previously configured IP address and
subnet mask for the switch. The switch also receives an IP Gateway address if the server has been configured
to provide one. In the case of Bootp, the server must first be configured with an entry that has the switch’s
MAC address. (To determine the switch’s MAC address, See Appendix D, “MAC Address Management”.) The
switch properly handles replies from either type of server. If multiple replies are returned, the switch tries to use
the first reply.)

If you manually configure default gateway, TTL, TimeP, and/or SNTP parameters on the switch, it
ignores any values received for the same parameters via DHCP or Bootp.

If the switch is initially configured for DHCP/Bootp operation (the default), or if it reboots with this configuration, it
begins sending request packets on the network. If the switch does not receive a reply to its DHCP/Bootp
requests, it continues to periodically send request packets, but with decreasing frequency. Thus, if a DHCP or
Bootp server is not available or accessible to the switch when DHCP/Bootp is first configured, the switch may not
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immediately receive the desired configuration. After verifying that the server has become accessible to the switch,
reboot the switch to restart the process immediately.

DHCP operation. A significant difference between a DHCP configuration and a Bootp configuration is that an IP
address assignment from a DHCP server is automatic. Depending on how the DHCP server is configured, the
switch may receive an IP address that is temporarily leased. Periodically the switch may be required to renew its
lease of the IP configuration. Thus, the IP addressing provided by the server may be different each time the
switch reboots or renews its configuration from the server. However, you can fix the address assignment for the
switch by doing either of the following:

• Configure the server to issue an “infinite” lease.

• Using the switch’s MAC address as an identifier, configure the server with a “Reservation” so that it will always
assign the same IP address to the switch. (For MAC address information, See Appendix D, “MAC Address
Management”.)

For more information on either of these procedures, See the documentation provided with the DHCP server.

Bootp operation. When a Bootp server receives a request, it searches its Bootp database for a record entry that
matches the MAC address in the Bootp request from the switch. If a match is found, the configuration data in the
associated database record is returned to the switch. For many Unix systems, the Bootp database is contained in
the /etc/bootptab file. In contrast to DHCP operation, Bootp configurations are always the same for a specific
receiving device. That is, the Bootp server replies to a request with a configuration previously stored in the server
and designated for the requesting device.

Bootp Database Record Entries. A minimal entry in the Bootp table file /etc/bootptab to update an IP
address and subnet mask to the switch or a VLAN configured in the switch would be similar to this entry:

8212switch:\
   ht=ether:\
   ha=0030c1123456:\
   ip=10.66.77.88:\
   sm=255.255.248.0:\
   gw=10.66.77.1:\
   hn:\
   vm=rfc1048
An entry in the Bootp table file /etc/bootptab to tell the switch or VLAN where to obtain a configuration file
download would be similar to this entry:

8212switch:\
    ht=ether:\
    ha=0030c1123456:\
    ip=10.66.77.88:\
    sm=255.255.248.0:\
    gw=10.66.77.1:\
    lg=10.22.33.44:\
    T144="switch.cfg":\
    vm=rfc1048
where:

8212swi
tch

is a user-defined symbolic name to help you find the correct section of the bootptab file. If you have
multiple switches that will be using Bootp to get their IP configuration, you must use a unique symbolic
name for each switch.

ht is the "hardware type". For the switches covered in this guide, enter ether (for Ethernet). This tag
must precede the ha tag.

Table Continued
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ha is the "hardware address". Use the switch's (or VLAN's) 12-digit MAC address.

ip is the IP address to be assigned to the switch (or VLAN).

sm is the subnet mask of the subnet in which the switch (or VLAN) is installed.

gw is the IP address of the default gateway.

lg TFTP server address (source of final configuration file)

T144 is the vendor-specific "tag" identifying the configuration file to download.

vm is a required entry that specifies the Bootp report format. Use rfc1048 for the switches covered in
this guide.

The above Bootp table entry is a sample that will work for the switch when the appropriate addresses
and file names are used.
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Viewing or downloading the software manual set
Procedure

Go to the Networking website http://www.hpe.com/networking/support to view or download product
documentation.

Updating the switch software to a new version

Updating the switch software
Process overview:

Procedure

1. Go to the Networking website (http://www.hpe.com/networking/support) to download the new switch
software file.

HPE periodically provides switch software updates through the Networking website. Check the website
frequently for the latest software version available for your switch.

2. Review the Best practices, recommendations, and precautions on page 158.

3. Backup your configuration, as specified in Backing up your current configuration and image on page 154.

4. Do one of the following to download and install the new switch software:

a. For a TFTP transfer from a server, do either of the following:

• Select Download OS in the Main Menu of the switch’s menu interface and use the (default) TFTP
option. For more information about using the switch’s menu interface, see Using the Menu Interface on
page 16.

• In the switch’s CLI, complete the Downloading and installing software from a TFTP server on page
155 task. Use the copy tftp command in the switch’s CLI (see below).

b. For an Xmodem transfer from a PC or Unix workstation, do either of the following:

• Select Download OS in the Main Menu of the switch’s menu interface and select the XMODEM option.
For more information about using the switch’s menu interface, see Using the Menu Interface on page
16.

• In the switch’s CLI, complete the Downloading and installing software from a PC or Unix
workstation on page 156 task.

c. For a transfer from a USB flash drive: In the switch’s CLI, complete the
Downloading and installing software from a USB flash drive on page 157task.

Chapter 10
Managing switch software
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Downloading new software does not change the current switch configuration. The switch
configuration is contained in a separate file that can also be transferred, for example, to archive or to
be used in another switch of the same model.

Backing up your current configuration and image

Procedure

1. Save your current configuration (Config1) to backup configuration file (Config2).

a. Before copying the config, verify the current state of your system using the show version, show flash and
show config files commands. For example:

Switch1# show version
Image stamp:   /sw/code/build/btm(t4a)
               Nov 6 2009 13:20:26
               K.14.47
               188
Boot Image:    Primary

Switch1# show flash
Image           Size(Bytes)   Date    Version
------          -----------  -------  -------
Primary Image   : 9839140    11/06/09 K.14.47
Secondary Image : 0
Boot Rom Version: K.12.20
Default Boot    : Primary

Switch1# show config files

Configuration files:

 id | act pri sec | name
 ---+-------------+-----------------------------
  1 | *    *   *  | config1
  2 |             | 
  3 |             | 

b. Create a backup configuration file and verify the change.

Switch1# copy config config1 config config2
Switch1# show config files

Configuration files:

 id | act pri sec | name
 ---+-------------+-----------------------------
  1 | *    *   *  | config1
  2 |             | config2
  3 |             | 

2. Save the current config to a tftp server using the copy tftp command. For example:

Switch1# copy startup-config tftp 10.1.1.60
Switch1_config_K_14_47.cfg

This step is necessary because switches do not support roll back (going from a newer software
version to an older software version) without the ability to copy a backup config file onto the
device.
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3. Back up your current running image (primary) to the secondary image.

Switch1# copy flash flash secondary

Switch1# show flash
Image           Size(Bytes)   Date    Version
------          -----------  -------  -------
Primary Image   :  9839140   11/06/09 K.14.47
Secondary Image :  9839140   11/06/09 K.14.47
Boot Rom Version: K.12.20
Default Boot    : Primary
 

4. Set your secondary image to boot with Config2.

Switch1# startup-default secondary config config2 

Switch1# show config files

Configuration files:

 id | act pri sec | name
 ---+-------------+-----------------------------
  1 | *    *      | config1
  2 |          *  | config2
  3 |             | 
This step will enable you to revert from the new software version to your previous software version (K.14.47 in
the examples shown in steps 1 through 3) with your previous configuration just by invoking the command boot
system flash secondary.

Downloading and installing software from a TFTP server

Procedure

1. Use the following command, specifying the filename and the primary or secondary flash destination:

copy tftp flash <ip-address> <remote-os-file> [ primary | secondary ]
Note that if you do not specify the flash destination, the TFTP download defaults to the primary flash.

For example, to download a software file named K_15_10_0001.swi from a TFTP server with the IP address of
10.28.227.103 to the primary flash destination, execute the copy command as shown below:

switch# copy tftp flash 10.28.227.103 K_15_10_0001.swi
The primary OS image will be deleted. continue
continue[y/n]? Y
03125K

2. When the switch finishes downloading the software file from the server, it displays the progress message

Validating and Writing System Software to FLASH...
3. When the CLI prompt reappears, the switch is ready to reboot to activate the downloaded software:

a. Use the show flash command to verify that the new software version is in the expected flash area (primary
or secondary).

b. Reboot the switch from the flash area (primary or secondary) that holds the new software, using the
following command:

boot system flash [ primary | secondary ]
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After the switch reboots, it displays the CLI or Main Menu, depending on the Logon Default setting last
configured in the menu’s Switch Setup screen.

4. Verify the software version by displaying the system information for the switch (for example, through the show
system-information command), and viewing the Software revision field.

Downloading and installing software from a PC or Unix workstation
Downloading and installing software from a PC or Unix workstation

To download software from a PC or Unix workstation:

Prerequisites

Before you download and install software from a PC or Unix workstation, insure that:

• The switch is connected via the Console RS-232 port to a PC operating as a terminal. (See your switch
Installation and Getting Started Guide for information on connecting a PC as a terminal and running the switch
console interface.)

• The switch software is stored on a disk drive in the PC.

• The terminal emulator you are using includes the Xmodem binary transfer feature. (For example, in the
HyperTerminal application included with most Windows systems, the Send File option in the Transfer drop-
down menu supports the Xmodem protocol.)

Procedure

1. To reduce the download time, you may want to increase the baud rate in your terminal emulator and in the
switch to a value such as 115,200 bits per second. (The baud rate must be the same in both devices.) For
example, to change the baud rate in the switch to 115200, execute this command:

switch(config)# console baud-rate 115200
(If you use this option, be sure to set your terminal emulator to the same baud rate.)

Changing the console baud-rate requires saving to the Startup Config with the write memory command.
Alternatively, you can log out of the switch and change your terminal emulator speed and allow the switch to
Auto-Detect your new higher baud rate (that is, 115,200 bps)

2. Use the following CLI command, specifying the primary or secondary flash destination:

copy xmodem flash [ primary | secondary ]
For example, the following command specifies the primary flash destination:

switch# copy xmodem flash primary
The primary OS image will be deleted. continue [y/n]? Y
Press ‘Enter’ and start XMODEM on your host...

3. Execute the terminal emulator commands to begin the Xmodem transfer. For example, using HyperTerminal:

a. Click Transfer, then Send File.

b. Type the file path and name in the Filename field.

c. In the Protocol field, select Xmodem.

d. Click Send button.

The download can take several minutes, depending on the baud rate used in the transfer.
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4. If you increased the baud rate on the switch (1), use the same command to return it to its previous setting. (A
baud rate of 9600 bits per second is recommended for most applications.) Remember to return your terminal
emulator to the same baud rate as the switch.

5. Use the show flash command to verify that the new software version is in the expected flash area (primary or
secondary).

6. Reboot the switch from the flash area (primary or secondary) that holds the new software, using the following
command:

boot system flash [ primary | secondary ]
After the switch reboots, it displays the CLI or Main Menu, depending on the Logon Default setting last
configured in the menu’s Switch Setup screen.

Downloading and installing software from a USB flash drive
Downloading and installing software from a USB flash drive

To download software from a USB flash drive:

Prerequisites

Before you download and install software from a USB flash drive, insure that:

• The software version is stored on the USB flash drive and you know the file name (such as
K_15_10_0001.swi).

• The USB flash drive is properly installed in the USB port on the switch.

• The USB flash drive is supported. Some USB flash drives may not be supported on your switch. For
information on USB device compatibility, see the networking support (http://www.hpe.com/networking/
support).

Procedure

1. Use the following CLI command, specifying the filename and the primary or secondary flash destination:

copy usb flash <filename> [ primary | secondary ]
For example, to download a software file named K_15_10_0001.swi from a USB flash drive to the secondary
flash destination, execute the command as shown below:

switch# copy usb flash K_15_10_0001.swi secondary
The secondary OS image will be deleted. continue
[y/n]? Y
03125K

2. When the switch finishes downloading the software file from the server, it displays the progress message:

Validating and Writing System Software to FLASH...
3. When the CLI prompt reappears, the switch is ready to reboot to activate the downloaded software:

a. Use the show flash command to verify that the new software version is in the expected flash area (primary
or secondary).

b. Reboot the switch from the flash area (primary or secondary) that holds the new software, using the
following command:

boot system flash [ primary | secondary ]
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After the switch reboots, it displays the CLI or Main Menu, depending on the Logon Default setting last
configured in the menu’s Switch Setup screen.

4. Verify the software version by displaying the system information for the switch (for example, through the show
system-information command), and viewing the Software revision field.

Best practices, recommendations, and precautions
Best practices for software updates

There is a slight change in the versioning system.

Software updates that contain significant new features and enhancements may be designated by an increment to
both the major and minor release version numbers. That is, K.15.01.0031 represents a major update to software
version(s) K.14.xx, and K.14.xx represents a major update to K.13.xx, and so forth. In addition, a future version
(such as K.15.02.xxxx) may represent a minor release to version K.15.01.xxxx, but may still contain significant
changes. To mitigate against potential migration issues when performing such updates, this section documents
best practices for updating the switch, including contingency procedures for rolling back to previous software
versions and saved configurations.

Recommendations and precautions for software updates

Before you update the switch software to a new version:

• We strongly recommend that you save a copy of your config file to an external location.

• We advise against rolling back (going from a newer software version to an older software version) without
copying a backup config file to the device.

If you do choose to downgrade software using your existing config file, unpredictable changes in the config file
and switch behavior may occur. If booting a K.15.01.0031 or later config file into a K.14.xx or earlier versions of
software, the following commands may be removed from your config file:

• Any commands that are present in K.15.01.0031 (or later) but are not present in earlier versions of software

• logging

• snmp-server

• mirror-session

• auto-tftp

• filter source-port

• fault-finder

• interface loopback

After following these steps, you end up with the following results:

• Primary image will hold the new software image you want to install

• Secondary image will hold the image you are currently running

• Primary image will boot with Config1 (config file corresponding to new software version)

• Secondary image will boot with Config2* (config file corresponding to previous software version)
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* The current config file must be copied to Config2, or you will be unable to revert if the need arises.

You might opt to use a different methodology in which the new software will be installed as the
secondary and not the primary image, in which case you would use the commands boot system
flash secondary, and/or boot set-default flash secondary to change the location of the default
boot. However, since you will still need to take precautions to allow you to revert to your previous
configuration. We strongly recommend that you follow the methods that are proposed in our update
process. This will ensure that you can use our proposed rollback procedures if the need arise.

Validating switch software

Validating a software image
A software is valid if it has a valid digital signature, which is generated by HPE Code Signing Service (HPECSS).
Switches that support digital signature verification will generate an error message if you attempt to download an
image that is not digitally signed.

• To manually verify the software’s digital signature when the switch does not support digital signature
verification, use the following command:

verify signature flash {primary|secondary}
If the signature is valid, the following message is displayed:

Signature is valid.

• To bypass signature verification, use the allow-no-signatureoption in the copycommand as follows:

copy {tftp|sftp|usb|xmodem} flash [<hostname/IP>]
[<filename>] {primary|secondary} allow-no-signatures

Theallow-no-signature option is available on switches that support non-signed legacy software releases and
must be used with caution. To determine support for your switch, go to: http://www.hpe.com/networking/
swvalidation.

Software signing and verification
As an enhanced security feature, you can verify whether a software image being downloaded to or stored in your
switch has, in fact, been provided by Networking without any modification or corruption.

Validation is based on the image signature that is generated and attached to the switch software by HPE Code
Signing Service (HPECSS). Networking implemented digital signature validation starting with specific switch
software versions. For a list of these software versions, go to: http://www.hpe.com/networking/swvalidation.

Once a switch software image has been digitally signed on a specific version, all later versions will
also be signed.

Switches supporting digital signature verification will generate an error message if you attempt to download an
image that is not digitally signed. For example, using the CLI commands described above to revert back to an
image that is not signed from an image that is signed and supports verification would result in the following
message:

This software image does
not contain a digital signature and
cannot be validated as originating
from HP. You may bypass this
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validation by using the
'allow no-signature’ option. Please
see www.hp.com/networking/swvalidation
for information about which versions
of software contain digital signatures.
When you use the copy command to download a properly signed image, the CLI logs the following syslog
message:

Update: Firmware image contains valid signature.
Errors related to signature validation will generate one of the following log messages:

Update: Aborted. Downloaded file invalid.
Update: Aborted. Firmware image does not contain a signature. 
Update: Aborted. Firmware image signature is not valid.

Rolling back switch software
If you are downgrading to a software version that supports long user names and passwords, ignore the
prerequisite. Software versions K.15.01.0032 and later support the longer user names and passwords

Prerequisite

Before downgrading to a software version that does not support long user names and passwords from a software
version that supports them, complete one of the following tasks.

• Use the passwordCLI command or the Web browser interface, change usernames or passwords to be no
more than 16 characters in length, and without any special characters. Then execute a CLI write
memorycommand (required if the include-credentialsfeature has ever been enabled).

• Clear the values using the no password all CLI command. Then execute a CLI, write memorycommand
(required if the include-credentialsfeature has ever been enabled).

• Clear password values by using the "Clear" button on the switch. Then execute a CLI, write
memorycommand (required if the include-credentialsfeature has ever been enabled).

Rolling back switch software

To roll back your switch from K.15.01.0031 to K.14.47, for example, follow the steps below:

1. Verify that your images and configuration are set correctly using the show version, show flash and show
config files commands.

Switch1# show version
Image stamp:   /sw/code/build/btm(t5a)
               Apr 23 2010 05:43:42
               K.15.01.0031
               67
Boot Image:    Primary

Switch1# show flash
Image           Size(Bytes)   Date    Version
------          -----------  -------  -------
Primary Image   : 11537788   04/23/10 K.15.01.0031
Secondary Image :  9839140   11/06/09 K.14.47
Boot Rom Version: K.15.09
Default Boot    : Primary

Switch1# show config files
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Configuration files:

 id | act pri sec | name
 ---+-------------+-----------------------------
  1 | *    *      | config1
  2 |          *  | config2
  3 |             | 

2. Boot the switch using the secondary image (with config2).

Switch1# boot system flash secondary
System will be rebooted from secondary image. Do
you want to continue [y/n]? y
Enter ‘y’ for yes, and the switch will boot from the secondary image (K.14.47, in this example) with the
corresponding configuration for that software version (Config2).

Managing scheduled jobs

Schedule a job to run automatically
A job, that is command, can be scheduled to run on a recurring basis or after certain events. Use the following
command to schedule a job:

job <name> at
job <Name> at [HH:]MM [on [MM/]DD] [config-save] <Command-str>
job <Name> at <Event> [config-save] <Command-str>
job

Schedule a command to run automatically in the future.

Name

The name of the job to add or delete.

at

Schedule when the job runs.

reboot

Run the job as soon as possible after every switch boot.

[HH:]MM

The time when the job has to run.

on

Schedule the job to run on specified days.

MM/DD

The date when the job has to run.

<31-1>

The day relative to the end of the month when the job has to run.

<1-31>

The day of the month when the job has to run.
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WEEKDAY-LIST

The days of the week when the job has to run.

config-save

Save configuration changes made by the job.

Command-str

The command to execute when this job runs.

This command uses a new “weekday list” token type. A weekday list represents one or more days of
the week and is stored internally. It allows users to specify a list of individual days or a range of days
and use abbreviations. Examples of this weekday list are:

• Monday, Friday

• Mon-Wed

• mo,we-fr,su

Examples

The following example shows a pair of jobs that disable PoE during non-working hours
Switch(config)# job poe-on at 8:00 on mon-fri config-save "interface 1-24 power-over-ethernet"
Switch(config)# job poe-off at 17:00 on mon-fri config-save "no interface 1-24 power-over-ethernet"

The following example shows a job that block access to a server during weekends
Switch(config)# ip access-list extended block-server
Switch(config-ext-nacl)# deny ip any host 10.0.1.80
Switch(config-ext-nacl)# permit ip any any
Switch(config-ext-nacl)# exit
Switch(config)# job allow at 8:00 on mon config-save "no interface 1-24 ip access-group block-server in"
Switch(config)# job deny at 17:00 on fri config-save " interface 1-24 ip access-group block-server in"

The following example shows a job that blinks the Chassis Locate LED when the switch reboots

Switch(config)# job reboot-led at reboot "chassislocate blink"
The following example shows a job that reboots the switch on the first day of each year

Switch(config)# job annual-reboot at 2:00 on 1/1 boot

Deleting a scheduled job
Use the command no job <name> to delete a scheduled job. The name argument specifies the job to be
deleted.

Delete a scheduled job named “baz”

switch# show job

Job Scheduler Status and Configuration
Scheduler Status : Waiting for the system time to be set

                       Event or     Save 
Name                   Time         Cfg    Command
-------------------- ------------- ----   -------------------------------------
Burrrrrrrrrrrrrrr... reboot        Yes  chassislocate blink
baz                  reboot        No   show time 
foo                  17:00 SxTWTxS No   savepower led
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switch# no job baz

Viewing scheduled jobs
Do one of the following:

• Use the command show job <Name> to view details of a specific scheduled job.

• Use the command show job to view a list of all the scheduled jobs.

Names and commands that are longer than their column width are truncated with an ellipsis in the display. To
assist administrators in diagnosing problems with jobs, there is a detail view for a single job. If the last job run
produced any output, the first 255 characters of that output will be shown from the last job run whether that job
was successful or not. A successful run will overwrite the error output from a previous failed run.

Examples

The following example displays the list of the scheduled jobs

switch# show job

Job Scheduler Status and Configuration
Scheduler Status : Waiting for the system time to be set

                       Event or     Save 
Name                   Time         Cfg    Command
-------------------- ------------- ----   -------------------------------------
Burrrrrrrrrrrrrrr... reboot        Yes  chassislocate blink
baz                  reboot        No   show time 
foo                  17:00 SxTWTxS No   savepower led
The following example displays the details of a specific scheduled job

switch# show job baz

Job Information
Job Name    : baz
Runs At     : reboot
Config Save : No
Run Count   : 1
Error Count : 0
Command     : show time
Output from Last Run
--------------------
Mon Jan  1 00:00:44 1990

Time adjustments and scheduling jobs
Daylight savings time adjustments

When daylight savings time (DST) begins (“spring forward”), the local time jumps from 0200 to 0300. The Job
Scheduler “catches up” by running all jobs scheduled between 0200 and 0300 the next time it wakes up. This
prevents jobs from being skipped when they appear in the 0200 to 0300 time frame.
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When daylight savings time (DST) ends (“fall back”), the local time jumps from 0200 to 0100. The Job Scheduler
skips all jobs scheduled between 0100 and 0200 to allow local time to catch up. Those jobs already ran once
before DST ended will not repeat.

If an administrator configures a new job during the repeat of the 0100 to 0200 hour on the day DST
ends, the new job will not be run because the Job Scheduler skips that hour.

External adjustments

External adjustments to the system time can happen to correct for clock drift or for other administrative reasons.
The new time update can come from SNTP, from a configuration command at the CLI, or from an SNMP SET of
the system time MIB object. When a time adjustment takes place, the Job Scheduler task is called with the new
clock value. Jobs scheduled during a time clock jump forward are run while any jobs scheduled during a time
clock jump back are skipped.

Adjustment of more than 10 minutes are considered a major change and reset the Job Scheduler. Any jobs
scheduled during a time clock jump forward are skipped while any jobs scheduled during a time clock jump back
are repeated.

Calendar conflicts

Because the Job Scheduler MIB is more flexible than the CLI scheduling grammar, it is possible to create job
schedules via SNMP that cannot be displayed by the CLI. The following rules are imposed on MIB values to limit
them to what the CLI can display.

• If any bits are set in hpicfJobSchedulerEvent, all Calendar values are ignored. They may be set with SNMP,
but are ignored when looking for jobs to run. The Calendar values are also ignored by the command show
running-config.

• If any bit is set in CalendarDayOfWeek, then CalendarMonth and CalendarDayOfMonth are ignored.

• If no bits are set in CalendarDayOfWeek or CalendarDayOfMonth, then CalendarMonth is ignored.

• Only 1 bit may be set in the CalendarMonth, CalendarDayOfMonth, CalendarHour, and CalendarMinute
objects. Attempting to set a value with more than 1 bit returns an InconsistentValue error.

• If no bits are set in CalendarHour and CalendarMinute, the job is considered to be in a transition state and not
valid. This could happen when an SNMP management application is creating a job one object at a time. Jobs
in this state are ignored by the scheduler and by the command show running-config.

The Job Scheduler
The Job Scheduler provides administrators the ability to schedule recurring commands or “jobs” on their switch. A
feature of the Job Scheduler is the ability to schedule a command to run on a recurring basis or after certain
events. For example, a command can be triggered to run by certain predefined events such as switch reboot.

There is no prompt for user input with this feature. Administrators using this feature can schedule commands such
as enabling or disabling ports, turning on or off LEDs and Power-Over-Ethernet commands. All commands run
with manager privilege in configuration context.

Jobs that are scheduled can be viewed or deleted.

Alternate configuration files
An alternate configuration that is saved to the switch is viewed or copied through the software currently running
on the switch. This may result in a misleading portrayal of the configuration. For example, if a configuration is
created on K.14.47 and saved as config2, and if it is then viewed or transferred while the switch is running K.
15.01.0031, it will appear as though K.15.01.0031 has converted the configuration. However, the alternate
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configuration file, config2, will still be intact on the switch and load properly when the switch is booted into the
same software version from which the configuration file originated.

When an enhancement introduces a feature that did not previously exist in the switch, it may present several
challenges to the user.

Backwards compatibility of the configuration created with a version of software that supports a new feature or
parameter is not guaranteed. Software versions that did not recognize or support a particular command or
parameter will not be able to interpret that line in the configuration. For this reason, it is strongly recommended
that network administrators always save their configuration while still running the switch with the original
software version, and with a notation indicating the software version on which the configuration was saved. For
example, a user might save a configuration for a switch running K.14.47 to a TFTP server with an IP address of
10.10.10.15 as follows:

switch-onK1447# copy running-config tftp
10.10.10.15 5406onK1447
If, for example, the user deems it necessary to revert to the use of K.14.47, the user can boot into it and then
restore the saved config from the TFTP server.

Viewing or copying an alternate configuration that is saved to the switch flash can be accomplished only with the
software that is currently running on the switch.

Here, for example, a configuration is created on K.14.47 and then saved to flash:

switch-onK1447# copy config config2 config
K1447config <cr>
And later, the configuration that was created on K.14.47 is viewed while the switch is running K.15.01.0031:

switch-onK1501# show config K1447config <cr>
The command output will show how the K.14.47 config would be interpreted if it were to be used by the K.
15.01.0031 software. Copying the K1447config file to a TFTP server would similarly trigger an interpretation by
the software performing the file transfer. Note, however, that this does not actually change the configuration. If the
version is rolled back from K.15.01.0031 to K.14.47 with a command like the following (given that K.14.47 is
stored in secondary flash), the K.14.xx formatted config is still intact and valid.

switch# boot system flash secondary config
K1447config
This "interpretation" during a TFTP or show command execution is inherent in the architecture of the switch.
When switch features change significantly (such as the move from IPv4 support to IPv6 support), there may be
configuration parameters from the previous config that cannot be translated by the switch for viewing while it is
running the new software. This necessitates storing configurations for each version of software to an external
location, if the user would like to view the stored config prior to reloading it.
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Switches provide a way to automatically adjust the system clock for Daylight Saving Time (DST) changes. To use
this feature, define the month and date to begin and to end the change from standard time. In addition to the
value "none" (no time changes), there are five predefined settings named:

• Alaska

• Canada and Continental US

• Middle Europe and Portugal

• Southern Hemisphere

• Western Europe

The predefined settings follow these rules:

Alaska:

• Begin DST at 2 am on the second Sunday in March.

• End DST at 2 am on the first Sunday in November.

Canada and Continental US:

• Begin DST at 2 am on the second Sunday in March.

• End DST at 2 am on the first Sunday in November.

Middle Europe and Portugal:

• Begin DST at 2 am the first Sunday on or after March 25th.

• End DST at 2 am the first Sunday on or after September 24th.

Southern Hemisphere:

• Begin DST at 2 am the first Sunday on or after October 25th.

• End DST at 2 am the first Sunday on or after March 1st.

Western Europe:

• Begin DST at 2 am the first Sunday on or after March 23rd.

• End DST at 2 am the first Sunday on or after October 23rd.

Chapter 11
Daylight Saving Time
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A sixth option named "User defined" allows you to customize the DST configuration by entering the beginning
month and date plus the ending month and date for the time change. The menu interface screen looks like the
following: (all month/date entries are at their default values):

Figure 53: Menu interface with "user-defined" daylight time rule option

Before configuring a "User defined" daylight time rule, it is important to understand how the switch treats the
entries. Given the "Beginning day" and "Ending day", based on an algorithm from Sunday, the switch determines
the date to change the system clock :

• If the configured day is a Sunday, the time changes at 2 am on that day.

• If the configured day is not a Sunday, the time changes at 2 am on the first Sunday after the configured day.

This is true for both the "Beginning day" and the "Ending day."

With that algorithm, you can use the value "1" to represent "first Sunday of the month," and a value equal to
"number of days in the month minus 6" to represent "last Sunday of the month." This allows a single configuration
for every year, no matter what date is the appropriate Sunday to change the clock.
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Configuring the module power-saving option
Do one of the following:

• Use the command savepower module <slot-list> to turn off power for the modules in the specified
slots.

• Use the command savepower module all to turn off power for all the modules.

The following example shows how to turn off power for the module in slot "c".

If a savepower module <slot-list> or a savepower module all command is immediately
followed by a no savepower module <slot-list> or a no savepower module all
command, the first slot in the list is powered down and then brought up.

Configuring the LED power-saving option
Do one of the following:

• Use the following command to turn off the chassis LEDs for the specified slots.

savepower led <slot-list>
[timer [MM/DD[/[YY]YY] HH:MM|now|duration [HH:MM[recur]]]

• Use the following command to turn off all the chassis LEDs.

savepower led all
[timer [MM/DD[/[YY]YY] HH:MM|now|duration [HH:MM[recur]]]

Each of these commands includes a timer option. When the timer is configured, the LEDs are turned off for the
specified time period and duration. There is one system-wide timer.

Chapter 12
Managing power-saving features
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The following example shows how to turn off LEDs beginning on 6/1 at 12:01 for 12 hours and repeat daily

Configuring the slot low-power option
Do one of the following:

• Use the command savepower port-low-pwr <slot-list> to put the specified slots into low-power
mode.

• Use the command savepower port-low-pwr all to put the all the slots into low-power mode.

Slots will go into lower-power mode only if they are not linked. The slots that have the low-power option
configured periodically monitor connections to determine if the link has become active. If a LAN cable is
connected to one of the slots, that slot will come out of the low-power mode state after approximately two seconds
(the monitoring period) and enter into normal power mode. The remaining slots continue to be in low-power mode.

The following example shows how to put slot "c" into low-power mode.
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Disabling power-saving options
Do one of the following to disable the power-saving option for modules. A module is powered on when its power-
saving option is disabled.

• Use the command no savepower module <slot-list> to disable the power-saving option for the
modules in the specified slots.

• Use the command no savepower module all to disable the power-saving option for all the modules.

Do one of the following to disable the power-saving option on chassis LEDs. An LED returns to its original state
and any scheduled or running timer is canceled when the power-saving option is disabled on the LED.

• Use the command no savepower led <slot-list> to disable the power-saving option on the chassis
LEDs for the specified slots.

• Use the command no savepower led all to disable the power-saving option on all the chassis LEDs.

Do one of the following to disable the low-power mode for slots. A slot returns to normal power mode when its
low-power mode is disabled.

• Use the command no savepower port-low-pwr <slot-list> to disable the low-power mode for the
specified slots.

• Use the command no savepower port-low-pwr all to disable the low-power mode for all the slots.

Enabling energy-efficient-ethernet (EEE)
Prerequisites

Before you enable energy-efficient-ethernet (EEE), you must insure that both sides of the link are EEE-capable to
support the power-saving idle mode.

Energy-efficient-ethernet follows the 802.3az standard, which provides support for a system to operate in low-
power idle mode during low-link use.

Enabling energy-efficient-ethernet (EEE)

To enable EEE on the specified port or a range of ports, use the following command:
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int <port-list> energy-efficient-ethernet

Enable EEE on ports B5 through B7

Enabling advertisement of EEE TLVs
The layer 2 (data link layer) Energy-efficient-ethernet (EEE) capability is a feature that allows ports to negotiate
the best optimizations for energy efficiency.Use the following command to enable the advertisement of Layer 2
EEE TLVs for a specified port or a range of ports.

lldp config <port-list> dot3TlvEnable eee_config
The following example shows how to enable the advertisement of Layer 2 EEE TLV for port B5.
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Disabling EEE or advertisement of EEE TLV
To disable enable Energy-efficient-ethernet(EEE) on the specified port or a range of ports, use the following
command:

no int <port-list> energy-efficient-ethernet
To disable the advertisement of Layer 2 EEE TLVs for a specified port or a range of ports, use the following
command:

no lldp config <port-list> dot3TlvEnable eee_config

Hibernate mode

hibernate
Syntax
hibernate <seconds>

Description

Hibernate the system. This command saves the current configuration and powers off the system for the specified
period. When the hibernation period expires, the switch will power up and boot using the normal boot process. A
typical use case is to have the job scheduler execute the hibernate command. For example, put the switch into
hibernate mode from midnight until 5 a.m.
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During hibernation, the system will not respond to any network traffic and the console will be inaccessible. The
only way to reboot the switch before the hibernation period expires is to press the Mode button on the front panel
or cycle power, thus disabling the hibernate job and timer.

The system prompts for y or n confirmation before putting the system into hibernate mode.

This feature is available on the 2930M and only in standalone. It is disabled for stacks.

Command context

Manager

Parameters
<seconds>

Specifies the length of time, in seconds, that the system will remain in hibernate mode. Duration: 0 to
2147483647 seconds.

Example

Hibernate the switch for 8 minutes.

switch# hibernate 480

This command will save the current configuration and then power off the
system for the specified period. During that time the system will not
respond to any network traffic and the console will be inaccessible. The
only way to reboot the switch before the hibernation period expires will
be to press the Mode button on the front panel or cycle power.

Continue(y/n)?

Viewing settings for power-saving and energy efficiency
Various versions of the show command are used to display current settings for power-saving options, Energy-
efficient-ethernet (EEE), and EEE TLV.

Do one of the following to view settings:

• Use the command show savepower module to view the current settings for the module power-saving
option.

• Use the command show savepower led to view the current settings for the LED power-saving option.

• Use the command show savepower port-low-pwr to view the current settings for the slot low-power
option.

• Use the command show energy-efficient-ethernet to view the current settings for Energy-efficient-
ethernet (EEE).

• Use the command show lldp info local-device <port-list> to view the current settings for EEE
TLV on the specified local ports.

• Use the command show lldp info remote-device <port-list> to view the current settings for EEE
TLV on the link partner of the specified port.

Display of the current settings for EEE TLV on the link partner of port B6
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Display of the current settings for EEE TLV on the local port B5

Display of the current settings for the slot low-power option

Display of the current settings for the LED power-saving option
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Display of the current settings for the module power-saving option

Displayed values for Energy-efficient-ethernet (EEE)
The displayed values for the energy efficient Energy-efficient-ethernet (EEE) status are explained in the following
table.

Parameter Description

EEE Config The EEE configuration status, read from the
configuration database.

Enabled
EEE mode is enabled.

Disabled
EEE mode is disabled.

Current Status Current EEE operational status.

Active
The port is advertised and auto-negotiated EEE with
link partner (an EEE-capable partner.) EEE mode is
enabled.

Table Continued

Chapter 12 Managing power-saving features 175

Anexo 02 ITENS 8 E 9 (0592700)         SEI 0008478-63.2018.6.02.8000 / pg. 6561



Parameter Description

Inactive
Set to one of the following conditions:

• EEE configuration is disabled on the local port.

• Local port advertises EEE capabilities with "EEE
disabled" link partner or non-EEE link partner.

• Auto-negotiation is mandatory for EEE to work. EEE
configuration will not be applied if the port is in
forced/manual (speed-duplex) mode. The current
status will be ‘inactive" for forced/manual mode port
configuration.

• EEE is not supported for 10Base-T. The current
status will be ‘inactive' if the link is operating in
10Base-T mode.

Unsupported
The local physical interface does not have EEE
capability.

txWake Current value of transmit wake-up time (in
microseconds.)

The interface modules do not support adjustment of both transmit and receive wake-up times.
Therefore, txWake is constant.

Power-saving features supported by modules
The modules support the power-saving features as indicated in the table below:

Product number Description LED power on/off Slot auto low-
power mode

Slot power on/off

J8702A Switch zl 24
10/100/1000 PoE
Module

Yes Yes Yes

J8705A Switch zl 20 Gig-T
+ 4 mGBIC Module

Yes Yes Yes

J8706A Switch zl 24-Port
Mini-GBIC Module

Yes No Yes

J8707A Switch zl 4-Port
10GbE X2 Module

Yes No Yes

J8708A Switch zl 4-Port
10GbE CX4 Module

Yes No Yes

Table Continued
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Product number Description LED power on/off Slot auto low-
power mode

Slot power on/off

J9307A Switch 24-Port
10/100/1000 PoE+ zl
Module

Yes Yes Yes

J9308A Switch 20-Port
10/100/1000 PoE+/4-
Port MiniGBIC zl
Module

Yes Yes Yes

J9309A Switch 4-Port 10Gbe
SFP+ zl Module

Yes No Yes

J9478A Switch 24-Port
10/100 PoE+ zl
Module

Yes Yes Yes

Overview of power-saving features
There are several power-saving features that can be configured for the indicated switches and modules. The
power-saving features include:

• Turn slot power on or off

• Turn LED power on or off

• Turn slot auto low-power mode on or off

• Use LLDP for Energy-Efficient-Ethernet

Slot power

The savepower module option shuts down the slot power for the specified modules in the order specified in the
command. The ports on these modules no longer pass traffic. Any management traffic (SNMP, SSH, Telnet) that
passes through these modules is interrupted. It can take up to two minutes to power down all the specified
modules. Check the Event Log to see the current status of the module power down. This command applies to
PoE/PoE+ modules as well as non-PoE/PoE+ modules.

LED power

The savepower LED option provides the ability to turn off specified slot LEDs or all LEDs. You can also configure
a timer for turning off the chassis LEDs or the specified slot LEDs. There is one system-wide timer; all the
selected slots will have the chassis LEDs turned off for the same amount of time.

When the timer option is configured, a timer for turning off the chassis LEDs or configured slot LEDs. The LEDs
are turned off for the configured time period and duration.

MM/DD[/[YY]YY] HH:MM Specifies the date and time to start the timer.

now Instantaneously turns off the LEDs. The configured
timer is canceled and all the configured modules go
into power-saving mode immediately.

Table Continued
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duration [HH:]MM: The amount of time the LEDs
remain turned off. (Optional)If the duration value is
zero, when the timer starts, the LEDs are turned off
indefinitely until the timer is canceled or the command
is overridden with another command.Default: 0 (zero)

recur: (Optional) If specified, the LEDs are turned off
on a daily basis at the configured time. The recur
option is ignored if the duration is configured as
zero.Default: disabled.

A new command overrides the previous command, regardless of the current state. For example, if a timer is
active and new command is given, the currently running timer is canceled and the new timer is scheduled.

Slot auto low-power mode

The auto low-power mode option puts the slots into auto low-power mode if they are not linked. If a particular slot
is specified, only that slot goes into auto low-power mode. Specifying savepower port-low-pwr all puts all
the slots into auto low-power mode.

The ports in low-power mode periodically monitor to determine if the link has become active. If a LAN cable is
connected to one of the ports, that port will come out of the low-power mode state after approximately 2 seconds
(the monitor period) and enter into normal power mode. The remaining ports continue to be in low-power mode.

Energy-efficient-ethernet

Energy-efficient-ethernet (EEE) follows the 802.3az standard, which provides support for a system to operate in
low-power idle mode during low-link use. This allows both sides of a link to disable or turn off a portion of the
system's transmit/receive circuitry, saving power. When traffic is ready for transmission, the interface sends a
"wake-up" message to the link partner to prepare to receive the traffic. The circuitry is returned to "normal" mode.
Both sides of the link must be EEE-capable to support the power-saving idle mode.

Layer 2 (data link layer) EEE capability is a feature that allows fine-tuning for EEE that uses LLDP TLVs for the
negotiation of physical link partners' wake-up time values. An EEE-capable port notifies its link partner about the
EEE capabilities supported. The ports then negotiate how to best optimize energy efficiency.
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Networking Websites
Hewlett Packard Enterprise Networking Information Library

www.hpe.com/networking/resourcefinder

Hewlett Packard Enterprise Networking Software

www.hpe.com/networking/software

Hewlett Packard Enterprise Networking website

www.hpe.com/info/networking

Hewlett Packard Enterprise My Networking website

www.hpe.com/networking/support

Hewlett Packard Enterprise My Networking Portal

www.hpe.com/networking/mynetworking

Hewlett Packard Enterprise Networking Warranty

www.hpe.com/networking/warranty

General websites
Hewlett Packard Enterprise Information Library

www.hpe.com/info/EIL

For additional websites, see Support and other resources.

Chapter 13
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Accessing Hewlett Packard Enterprise Support
• For live assistance, go to the Contact Hewlett Packard Enterprise Worldwide website:

http://www.hpe.com/assistance

• To access documentation and support services, go to the Hewlett Packard Enterprise Support Center website:

http://www.hpe.com/support/hpesc

Information to collect

• Technical support registration number (if applicable)

• Product name, model or version, and serial number

• Operating system name and version

• Firmware version

• Error messages

• Product-specific reports and logs

• Add-on products or components

• Third-party products or components

Accessing updates
• Some software products provide a mechanism for accessing software updates through the product interface.

Review your product documentation to identify the recommended software update method.

• To download product updates:

Hewlett Packard Enterprise Support Center
www.hpe.com/support/hpesc

Hewlett Packard Enterprise Support Center: Software downloads
www.hpe.com/support/downloads

Software Depot
www.hpe.com/support/softwaredepot

• To subscribe to eNewsletters and alerts:

www.hpe.com/support/e-updates

• To view and update your entitlements, and to link your contracts and warranties with your profile, go to the
Hewlett Packard Enterprise Support Center More Information on Access to Support Materials page:

Chapter 14
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www.hpe.com/support/AccessToSupportMaterials

Access to some updates might require product entitlement when accessed through the Hewlett
Packard Enterprise Support Center. You must have an HPE Passport set up with relevant
entitlements.

Customer self repair
Hewlett Packard Enterprise customer self repair (CSR) programs allow you to repair your product. If a CSR part
needs to be replaced, it will be shipped directly to you so that you can install it at your convenience. Some parts
do not qualify for CSR. Your Hewlett Packard Enterprise authorized service provider will determine whether a
repair can be accomplished by CSR.

For more information about CSR, contact your local service provider or go to the CSR website:

http://www.hpe.com/support/selfrepair

Remote support
Remote support is available with supported devices as part of your warranty or contractual support agreement. It
provides intelligent event diagnosis, and automatic, secure submission of hardware event notifications to Hewlett
Packard Enterprise, which will initiate a fast and accurate resolution based on your product's service level.
Hewlett Packard Enterprise strongly recommends that you register your device for remote support.

If your product includes additional remote support details, use search to locate that information.

Remote support and Proactive Care information
HPE Get Connected

www.hpe.com/services/getconnected
HPE Proactive Care services

www.hpe.com/services/proactivecare
HPE Proactive Care service: Supported products list

www.hpe.com/services/proactivecaresupportedproducts
HPE Proactive Care advanced service: Supported products list

www.hpe.com/services/proactivecareadvancedsupportedproducts

Proactive Care customer information
Proactive Care central

www.hpe.com/services/proactivecarecentral
Proactive Care service activation

www.hpe.com/services/proactivecarecentralgetstarted

Warranty information
To view the warranty for your product or to view the Safety and Compliance Information for Server, Storage,
Power, Networking, and Rack Products reference document, go to the Enterprise Safety and Compliance website:

www.hpe.com/support/Safety-Compliance-EnterpriseProducts

Additional warranty information
HPE ProLiant and x86 Servers and Options

www.hpe.com/support/ProLiantServers-Warranties
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HPE Enterprise Servers
www.hpe.com/support/EnterpriseServers-Warranties

HPE Storage Products
www.hpe.com/support/Storage-Warranties

HPE Networking Products
www.hpe.com/support/Networking-Warranties

Regulatory information
To view the regulatory information for your product, view the Safety and Compliance Information for Server,
Storage, Power, Networking, and Rack Products, available at the Hewlett Packard Enterprise Support Center:

www.hpe.com/support/Safety-Compliance-EnterpriseProducts

Additional regulatory information

Hewlett Packard Enterprise is committed to providing our customers with information about the chemical
substances in our products as needed to comply with legal requirements such as REACH (Regulation EC No
1907/2006 of the European Parliament and the Council). A chemical information report for this product can be
found at:

www.hpe.com/info/reach

For Hewlett Packard Enterprise product environmental and safety information and compliance data, including
RoHS and REACH, see:

www.hpe.com/info/ecodata

For Hewlett Packard Enterprise environmental information, including company programs, product recycling, and
energy efficiency, see:

www.hpe.com/info/environment

Documentation feedback
Hewlett Packard Enterprise is committed to providing documentation that meets your needs. To help us improve
the documentation, send any errors, suggestions, or comments to Documentation Feedback
(docsfeedback@hpe.com). When submitting your feedback, include the document title, part number, edition,
and publication date located on the front cover of the document. For online help content, include the product
name, product version, help edition, and publication date located on the legal notices page.
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Finding and Maintaining Networking Devices
To find and maintain Networking devices, Hewlett Packard Enterprise recommends using the Network Discovery
Tool. Note that this tool does not replace or augment full-featured Network Management software.

To install the Network Discovery Tool, follow these steps:

Procedure

1. From a PC (running Windows Vista SP2, Windows 7 SP1, 8, 2008 SP2 or R1 SP1, or later), type in the URL*
for the Network Discovery Tool into a browser’s address field and press Enter.

2. When asked, open the file. In the resulting folder, double-click the file setup. Accept running the install.

3. Upon completion, the tool runs automatically. (Note: If .NET is not installed on your system, you may be
prompted to install it. Follow the installation instructions.)

*For additional information, contact http://www.hpe.com/networking/support.

When updating the Network Discovery Tool software, you must first uninstall the old version before
installing the new one.

Run the Network Discovery Tool shortly after powering on newly installed devices. By default, only new
Networking devices will display. Use the filter drop-downs to specify device age, type, and so on, Double-click on
a device to start its web user interface.

For additional information, visit the Network Discovery Tool’s internal help page.
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Compliance

RFC 4292
Switch families indicted in the Abstract section of the Basic Operations Guide enjoy full conformance of the RFC
4292.

RFC defines a portion of the Management Information Base (MIB) for use in managing objects related to the
forwarding of Internet Protocol (IP) packets in an IP version-independent manner. It is to be noted that the MIB
definition described herein does not support multiple instances based on the same address family type. However,
it does support an instance of the MIB per address family.

RFC 4292 supported operations
Both GET and SET operations are now supported on switches. RFC 4292 is supported in the following ways:

1. The set operation can create IPv4 and IPv6 static routes which include the functions for Reject, Remote, and
Blackhole.

2. A column of any existing row with RowStatus “Active” will not be allowed for modification.

3. Rowstatus will not support “Create-and-wait”.

4. There is an existing HPE proprietary MIB, hpicfIpStaticRouteTable, which is used to configure IPv4 and
IPv6 static routes. Currently CLI commands use this proprietary MIB for configuration. This will remain
unchanged.

5. The SET functions for inetCidrRouteTable (k_test, k_ready, k_setDefaults and k_set) are implemented.
The implementation maps to the existing SET routines of hpicfIpStaticRouteTable with the necessary
changes. Index of InetCidrRouteTable has RoutePolicy whereas hpicfIpStaticRouteTable has
IfIndex. Both MIBs have 6 objects as index.

6. The current GET implementation of inetCidrRouteTable is directly accessing the Gated Routing table to
retrieve all the routes which include Static and Dynamic. The SET routines will have to go through the
hpicfIpStaticRouteTable SET functions as these routes are of type Static.

Appendix B
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7. Creation, modification, or deletion of Dynamic route entry is not allowed. This can be achieved by validating
the MIB column inetCidrRouteProto for Static or Dynamic protocol.

8. gateD(routing stack) does not discard any routes, so the value of inetCidrRouteDiscards MIB will always
be 0.

Figure 54: MIB mapping

RFC 4292 MIB operations
To make the switch software fully compliant to RFC 4292, both GET and SET operations are supported as
indicated in the table below.

Table 10: GET and SET operations

inetCidrRouteTable Type Access

inetCidrRouteDestType* InetAddressType, Not-accessible

inetCidrRouteDest* InetAddress, Not-accessible

inetCidrRoutePfxLen* InetAddressPrefixLength, Not-accessible

inetCidrRoutePolicy* OBJECT IDENTIFIER, Not-accessible

inetCidrRouteNextHopType* InetAddressType, Not-accessible

inetCidrRouteNextHop* InetAddress Not-accessible

Table Continued
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inetCidrRouteTable Type Access

inetCidrRouteIfIndex InterfaceIndexOrZero, Read-Create

inetCidrRouteType INTEGER, Read-Create

inetCidrRouteProto IANAipRouteProtocol, Read-Only

inetCidrRouteAge Gauge32, Read-Only

inetCidrRouteNextHopAS InetAutonomousSystemNumber, Read-Create

inetCidrRouteMetric1 Integer32, Read-Create

inetCidrRouteMetric2 Integer32, Read-Create

inetCidrRouteMetric3 Integer32, Read-Create

inetCidrRouteMetric4 Integer32, Read-Create

inetCidrRouteMetric5 Integer32, Read-Create

inetCidrRouteStatus RowStatus Read-Create

* INDEX OBJECTS

JITC authorization requirements
The Joint Interoperability Test Command (JITC) conducts testing of national security systems and information
technology systems hardware, software, and components. Hewlett Packard Enterprise is in compliance with JITC
which provides the following.

• Logs of security-related events with new login credentials separate from operator or manager credentials.

• Log message when the event log wraps.

• Configuration commands that allow users to set the maximum number of concurrent sessions.

• Configuration commands which allow users to set the maximum number of concurrent sessions per user.

• Increase the delay between failed login attempts.

The HPE 3800 Switch and HPE 2920 Switch are currently UC APL certified.

Local authentication and authorization
JITC requires that access to security logs be provided through security user authentication and authorization. For
more information about JITC security authentication and authorization, see the Access Security Guide for your
switch.

186 Aruba Basic Operation Guide for ArubaOS-Switch 16.05

Anexo 02 ITENS 8 E 9 (0592700)         SEI 0008478-63.2018.6.02.8000 / pg. 6572



Security user log access
Security user logs are accessible when both the authentication and authorization are local. A default group called
the default-security-group is available in manager mode and has the privileges to execute the commands copy
security-log, show security-logging, and clear security-logging. When a security user is
attached to the group, they will only be able to execute these three commands. Other users will not be able to
execute the commands, no matter whether they are an operator or manager.

For more information about JITC security user log creation and access, see the Access Security Guide for your
switch.

Authentication and Authorization through RADIUS
For RADIUS authentication and authorization, the security user will be able to access to security log by
configuring the file located on RADIUS server. For more information about JITC authentication and authorization
through RADIUS, see the Access Security Guide for your switch.

Authentication and Authorization through TACACS
For TACACS authentication and authorization, the user can access to security log by configuring the file located
on TACACS server. For more information about JITC security authentication and authorization, see the Access
Security Guide for your switch.

Common access card (two-factor) authentication

Overview
A common access card (CAC) is a United States Department of Defense (DoD) smart card for multifactor
authentication. CACs are issued as standard identification for active-duty military personnel, reserve personnel,
civilian employees, non-DoD government employees, state employees of the National Guard, and eligible
contractor personnel. In addition to its use as an ID card, a CAC is required for access to government buildings
and computer networks.

Two-factor authentication
Part of the requirement necessary to satisfy the Federal Government Certification is two-factor authentication.
Two-factor authentication is the redundant authentication of the CAC. For example, the CAC satisfies two-factor
authentication by mandating that you have both the physical card and know the pin number associated with the
card.

To provide support for CAC authentication, the requirement for the network is the establishment of SSH
connections. Two-factor authentication constitutes authentication based on public key or certificate and
username/password on the switch.

Restrictions
The following are some of the restrictions when working with CAC authentication:

• Support is not provided for any other management connections other than SSH.

• Support is not provided for any switch acting as CAC SSH client.

• Support is not provided for public-key authentication based on DSA and ECDSA public keys.

• The maximum number of client public keys that can be installed is 10.

• When there is failure in any one of the authentication methods, the SSH connection will not be established.

• The following table lists the invalid authentication methods for SSH.
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login enable

public-key certificate

public-key two-factor-certificate

certificate public-key

certificate two-factor-public-key

two-factor-public-key certificate

two-factor-public-key two-factor-certificate

two-factor-certificate public-key

two-factor-certificate two-factor-public-key

Expected behaviors
With include-credentials command

• When the command include-credentials is enabled, public keys are stored both in configuration and
flash files.

• When the command no include-credentials is executed, the client public key is stored only in the flash.

• When the command no include-credentials store-in-config is executed, behavior is then based
on the user entry made with the pop-up message.

The command switch(config)# no include-credentials store-in-config will display a
message similar to:

This will remove any switch passwords and inactive SSH 
authorized keys from all configuration files.  This will also restore
 the functionality to store only a single set of passwords and authorized 
keys on the switch.

Continue (y/n)?  y
The SSH authorized keys associated with the active configuration will be 
deleted.

Would you like to retain these as the switch global SSH authorized keys 
(y/n)?  y

If the above option entered is “y”, then the client public key will be 
available in the flash but not in the config.

If the above option entered is “n”, then the client public key is neither 
available in the flash nor in the config.

Zeroization

When the zeroization command switch(config)# crypto key zeroize ssh-client-key is executed,
the client public keys will be zeroized in the flash.
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switch(config)# crypto key zeroize ssh-client-key

The manager key pair will be deleted, continue (y/n)? y 

The command erase all zeroize will also perform the 
zeroization of the key files in the flash.

The command erase all will only delete the key files from 
flash.
      
Switch is moved to/from enhanced security mode

Since the secure mode change goes through zeroization, the client keys are deleted and the switch will revert to
the default configuration without any client keys on the switch.

Attempting to configure a two-factor authentication method with no public key or username configured

If, during the download of the configuration file, the username and/or public key is not configured, then no action
will be taken. A warning message will display similar to:

username and/or public key is not configured.
An RMON will be logged with the message that the authentication method is set to two-factor with some
configuration missing.

When the user tries to connect using SSH, the connection will fail.

Deletion of the public key and/or username when the authentication method is set to two-factor
authentication

For the following three scenarios:

• After the authentication method is set to two-factor, if the client public keys are deleted while the usernames
still exists on the switch...

• After the authentication method being set to two-factor, if the username is deleted the public key exists on the
switch...

• When both the public key and usernames are deleted while the authentication method is being set to two-
factor authentication...

The new SSH connection will fail at either the public key authentication and/or username/password
authentication. RMON will be logged with appropriate message on the switch.

An alternative solution is to block the deletion of the public key and/or username when the
authentication method is set as two-factor authentication. With this approach, the impact of many
configurations need to be taken care cautiously since the username/password can be configured
through many interfaces such as SNMP, REST, WebUI, Menu, setup mgmt.-interfaces, and include-
credentials.

Authentication method re-configured at run time

If the authentication method is reconfigured at run time, the modified authentication method will be applied when
the new connection will be established.
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Secure Mode
With this release, the 3810M switch in secure mode is in compliance with the Federal Information Processing
Standards (FIPS). For more information, see the Access Security Guide of your switch.

Federal government certification
The following phase 3 certification features are included in the 16.03 release.

Local command audit logging

The logging of all administrative actions on a device is a requirement for NDcPP certification:

• All administrative actions (commands) must be logged locally.

• Enabling and disabling of command log storage is required.

• The identity of a user causing an event must be logged.

• When the command log is exhausted by 80% and wraparound occurs, the event must be logged and a trap
must be generated.

• The logs have a maximum of 240 characters and are stored in the command log buffer. If the log message
exceeds this maximum length, it is truncated and is not stored in the command log buffer.

Password storage in SHA-256 format

On Aruba switches, passwords can be configured either in plaintext or SHA-1 format. You can now configure the
passwords in SHA-256 format as well. For more information, see the Access Security Guide of your switch.

SSH Re-keying

To comply with RFC 4251, session re-keying ensures that either the SSH server or the SSH client initiates a re-
key. This results in a new set of encryption and integrity keys to be exchanged between them. Once the re-key is
complete, new keys are used for further communication, which ensures that the same key is not used for a long
duration and the security of the session is maintained. For more information, see the Access Security Guide of
your switch.

OSPFv3 RFC compliance

This feature supports authentication for OSPFv3 routing traffic on Aruba devices via IPsec. The authentication
support for OSPFv3 is provided in compliance with RFC 4552. Authentication is supported using AH protocol.
Authentication and confidentiality support using ESP is not supported in this release. For more information, see
the IPv6 Configuration Guide of your switch.

X.509v3 certificate extension RSA minimum key support

There are three requirements for NDcPP certification:

• Minimum secure RSA key size.

• Enforcement of TLS 1.1/TLS 1.2 for all TLS connections.

• Validation of extended key usage extension for X509v3 certificates.

As part of the minimum secure RSA key size requirement, an option has been added to the existing tls
configuration command to support minimum TLS version support for cloud application requirement.
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X.509v3 certificate authentication for SSH

This feature supports user-authentication in SSH using X.509v3-based certificates. For more information, see the
Access Security Guide of your switch.
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Managing the device link detection protocol
(DLDP)

Enabling or disabling DLDP
Device Link Detection Protocol (DLDP) must be enabled globally and on one or more interfaces to begin
monitoring. DLDP is disabled by default.

• To enable DLDP on the switch, use the command dldp enable.

• To disable DLDP on the switch, use the command dldp disable.

• To disable DLDP globally, use the command no dldp enable.

Setting the DLDP advertisement interval
Setting the DLDP advertisement interval appropriately for your network environment assures that DLDP can
detect unidirectional links before network performance deteriorates. Hewlett Packard Enterprise recommends
keeping the advertisement interval the same across the link partners.

• To set the advertisement interval, use the command dldp interval <1-100>, specifying a value between
1 and 100 seconds.

• To reset the advertisement interval to the default value of 5 seconds, use the command no dldp interval.

Enabling and disabling types of DLDP debugging
• To enable specific types of debugging for DLDP on the specified ports, use the following command:

debug dldp all|error|event| packet|state-machine|timer <port-list>
• To disable specific types of debugging for DLDP on the specified ports, use the following command:

no debug dldp all|error|event| packet|state-machine|timer <port-list>

Arguments:

all

Display all DLDP debug messages.

error

Display all DLDP error messages.

event

Display all the DLDP event messages.
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packet

Display all DLDP packet messages.

stat-machine

Display all DLDP state machine messages.

timer

Display all DLDP timer messages.

port-list

Display all DLDP debug messages for the listed port.

Clearing statistics on DLDP packets
Procedure

1. To clear statistics on DLDP packets that pass through the specified ports, use the following command:

clear statistics dldp <port-list>
2. To clear statistics on DLDP packets that pass through all ports, use the following command:

clear statistics dldp all

Viewing DLDP configuration information and statistics
• To view the DLDP statistics for the specified ports, use the command show dldp statistics <port-

list>. The port-list argument specifies a single port, a list of ports, or a range of ports.

• To view the DLDP statistics for all ports, use the command show dldp statistics all
• To view the DLDP configuration information and statistics for the specified ports, use the command show

dldp <port-list>. The port-list argument specifies a single port, a list of ports, or a range of ports.

• To view the DLDP configuration information and statistics for all ports, use the command show dldp all.

The following examples shows the DLDP statistics for port number a1.

show dldp statistics a1 

Status and Counters - Device Link Detection Protocol
Port : a1 
Packets Sent                           : 256
Packets Received                       : 255
Invalid Packets Received               : 0
Authentication Failed Packets Received : 0
Valid Packets Received                 : 255
The following example shows the DLDP statistics for ports a1 through a3.

show dldp statistics a1-a3

Status and Counters - Device Link Detection Protocol
Port : a1
Packets Sent                           : 256
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Packets Received                       : 255
Invalid Packets Received               : 0
Authentication Failed Packets Received : 0
Valid Packets Received                 : 255
Port : a2
Packets Sent                           : 256
Packets Received                       : 255
Invalid Packets Received               : 0
Authentication Failed Packets Received : 0
Valid Packets Received                 : 255
Port : a3 
Packets Sent                           : 0
Packets Received                       : 0
Invalid Packets Received               : 0
Authentication Failed Packets Received : 0
Valid Packets Received                 : 0
The following example shows the DLDP configuration information and statistics for port number a1.

show dldp a1
The output will display sensitive information. Continue (y/n)?

Status and Configuration - Device Link Detection Protocol
Global Status         : Enabled
Advertisement Interval (Sec) : 5 
Authentication Mode          : None
Authentication Password      : Password
Unidirectional Shutdown Mode : Auto
DelayDown Timer Value (Sec)  : 1
Number of DLDP Enabled Ports : 2
Interface A1
DLDP Port State     : Bidirectional
Number of Neighbors : 1 (Maximum number ever detected: 2)

Port      Port        Link     Neighbor MAC  Neighbor    Neighbor      Neighbor
        State        State    Address       Port Index               Aged Time
----- --------------- -------- ------------- ------------ ------------   ------- 
A1    Unidirectional    up      010fe2-000004     5       unconfirmed    0
The following example shows the DLDP configuration information and statistics for ports a1 through a3.

show dldp a1-a3
The output will display sensitive information. Continue (y/n)?

Status and Configuration - Device Link Detection Protocol
Global Status         : Enabled
Advertisement Interval (Sec) : 5 
Authentication Mode          : None
Authentication Password      : Password
Unidirectional Shutdown Mode : Auto
DelayDown Timer Value (Sec)  : 1
Number of DLDP Enabled Ports : 2
Interface A1
DLDP Port State     : Unidirectional
Number of Neighbors : 1 (Maximum number ever detected: 2)
Interface A2
DLDP Port State     : Bidirectional
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Number of Neighbors : 1 (Maximum number ever detected: 2)
Interface A3
DLDP Disabled

Port        Port      Link     Neighbor MAC   Neighbor    Neighbor     Neighbor
          State       State    Address        Port Index             Aged Time
----- ---------------   ------- ------------- ---------- ------------ -------- 
 A1     Unidirectional   up      40a8f0-9e2100     2      unconfirmed    0
 A2     Bidirectional    down     010fe2-000004     3      unconfirmed    0 

Setting the DLDP delaydown timer
The DLDP DelayDown timer specifies the delay, in seconds, before down ports are rechecked.

• To set the DLDP DelayDown timer, use the command dldp delaydown-timer <1-5> , specifying a value
between 1 and 5 seconds.

• To reset the DLDP DelayDown timer to the default value of 1 second, use the command no dldp
delaydown-timer.

Setting DLDP unidirectional-shutdown mode
On the detection of a unidirectional link, the port can be shut down either automatically or manually. This setting
controls whether the shutdown is automatic or manual.

Procedure

1. To set the DLDP unidirectional-shutdown mode, use the following command:

dldp unidirectional-shutdown auto|manual
2. To reset the DLDP unidirectional-shutdown mode to the default value (automatic shutdown), use the following

command:

no dldp unidirectional-shutdown

When DLDP detects a unidirectional port, an event is logged and the port must be shut down
manually by an administrator. In the event that the link state is restored to bidirectional and the
shutdown mode is manual, the user must manually bring up the port. Any dynamic change of the
shutdown mode (that is, auto to manual) will take effect only when DLDP is disabled globally and
enabled again. Likewise, When the link state is restored to Bidirectional and the shutdown mode is
manual, the user must manually bring up the port.

Also, any dynamic change of the shutdown mode (that is, auto->manual/vice versa) will be taken into
effect only when DLDP is disabled globally and enabled back again

Setting the DLDP authentication-mode
The authentication mode determines the type of authentication that DLDP uses. By default, no authentication is
used. Hewlett Packard Enterprise recommends keeping the authentication mode the same between link partners
or it will fail and log errors.
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• To set the DLDP authentication mode, use the following command:

dldp authentication-mode none|md5|simple
• To reset the DLDP authentication mode to the default value (no authentication), use the following command:

no dldp authentication-mode

This is equivalent to specifying none when setting the authentication mode.

Authentication modes:

none

Do not perform DLDP authentication (default).

md5

Authenticate using MD5.

simple

Authenticate using a plain text password.

Setting or removing a DLDP authentication password
• To set the DLDP authentication password to a plain text value, use the following command:

dldp authentication-password simple
• To set the DLDP authentication password to an encrypted value (a base64-encoded aes-256 encrypted string),

use the following command:

dldp authentication-password encrypted
• To remove the DLDP authentication password, use the following command:

no dldp authentication-password

When encrypt-credentials is enabled, the encrypted parameter is displayed. When configuring the
authentication password after configuring the authentication mode, the authentication mode defaults
to none (advertised in PDUs) regardless of which authentication mode you attempt to configure.

If you do not configure the authentication password after you configure the authentication mode, the
authentication mode will be none (advertised in PDUs) no matter which authentication mode you
configure.

The following example shows disabled encrypt-credentials.

dldp authentication-password
simple

Set the authentication password to plain text.

The following example shows enabled encrypt-credentials.

dldp authentication-password
simple

Set the authentication password to plain text.

encrypted

Global encryption key, specified using a base64-encoded aes-256 encrypted string.
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The following example shows both in secure mode.

dldp authentication-password simple
Password will be prompted interactively as above and sets the entered value in the configuration.

Enter Password:
Re-Enter Password:
In Download mode, the authentication password must be accepted as inline parameter only, and not be prompted
interactively.

Include-credentials and encrypt-credentials
considerations
The output of show running-config will be modified if encrypt-credentials is enabled or disabled. The
running-config output changes when include-credentials or encrypt-credentials is enabled or
disabled.

Table 11: Include/exclude credentials

Include
credentials

Encrypt
credentials

show run output Reboot with Saved
Config

Download config file

Disabled Disabled DLDP authentication-
password will not be
displayed.

The plain-text
password in the
Config will be used
to update the
protocol data
structure.

Mis-Configuration (Password
cannot be configured in this
case because password is
not available in downloaded
config.)

Disabled Enabled DLDP authentication-
password will not be
displayed.

The encrypted
password in the
Config will be
decrypted and used
to update the
protocol data
structure.

Mis-Configuration (Password
cannot be configured in this
case because password is
not available in downloaded
config.)

Enabled Disabled DLDP authentication-
password will be
displayed in plain-
text.

The plain-text
password in the
Config will be used
to update the
protocol data
structure.

DLDP authentication-
password stored as plain-
text.

Enabled Enabled DLDP authentication-
password will be
displayed in
encrypted form.

The encrypted
password in the
Config will be
decrypted and used
to update the
protocol data
structure.

DLDP authentication-
password stored as
encrypted.
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dldp authentication-password

dldp authentication-password simple

Enter Password: ****
Re-Enter Password: ****

include-credentials and encrypt-credentials are disabled

show running-config

Running configuration:

encrypt-credentials is enabled and include-credentials is disabled

encrypt-credentials

show running-config

Running configuration:

include-credentials is enabled and encrypt-credentials is disabled

include-credentials

show running-config

Running configuration:

dldp authentication-password simple test
      

encrypt-credentials and include-credentials are enabled

encrypt-credentials

include-credentials

show running-config

Running configuration:
dldp authentication-password encrypted “QFg8OTxYyLMEnFvQt6o542tAmbk4RrH4dO0C60oFokI=”

198 Aruba Basic Operation Guide for ArubaOS-Switch 16.05

Anexo 02 ITENS 8 E 9 (0592700)         SEI 0008478-63.2018.6.02.8000 / pg. 6584



Restrictions for DLDP
• DLDP is mutually exclusive with UDLD running on the port and some of the other protocol running on the

switch.

• DLDP is not supported on Distributed trunks that is, cannot be enabled on individual port of a DT trunk.

• DLDP is not supported on DYN trunk

• DLDP PKT received on a DLDP disabled port will not be forwarded and will be dropped by the switch. If DLDP
is globally disabled on the switch, DLDP pkts received will be reforward on the same VLAN.

Overview of device link detection protocol (DLDP)
DLDP is active on the following switches:

Aruba 2530 Switches
Aruba 2920 Switch
Aruba 2930F Switches
Aruba 2930M Switches
Aruba 3810 Switches
HPE 2620 Switch
HPE 3800 Switches
HPE 5400R Switches (both v2 and v3 blades)

Device link detection protocol (DLDP) is switch technology that detects any unidirectional link failures that can
occur in a network. Typically these unidirectional link failures occur among devices connected through fiber-optic
or copper twisted pair (such as category 5 twisted pair) cables. Upon detecting a link failure, the link PHY will be
kept UP and will be blocked in the hardware. All the upper layer protocols of the switch software (STP, LACP, and
so on) will see the interface as DOWN.

Enabling and disabling DLDP: Enable or disable the Device Link Detection Protocol (DLDP) to monitor link
status. DLDP must be enabled globally and on one or more interfaces to begin monitoring. DLDP is disabled by
default.

Advertisement interval: This is the interval between sending DLDP advertisement packets. Setting the DLDP
advertisement interval appropriately for your network environment assures that DLDP can detect unidirectional
links before network performance deteriorates. Hewlett Packard Enterprise recommends keeping the
advertisement interval the same across the link partners or DLDP can fail and produce an error log.
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DLDPDUs are sent as untagged PKTs on default VLAN. No support for tagged advertisements.

Figure 55: Link

DLDP can be enabled on a maximum of 128 ports with each DLDP enabled port can have up to 4
neighbors (with the exception of the switch 2530.

On the Switch 2530, DLDP can be enables on a maximum of 12 ports with each DLDP enabled port
allowed up to 4 neighborhoods.

Figure 56: Broken link
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Mobile web interface
Mobile web interface is available on the following switches:

Switch 2530
Switch 2620

The Mobile Web Interface feature provides a subset of functionality currently available in the existing web
interface but designed for use on mobile devices such as smart phone or tablet.

Viewing web management-to-server configurations
Use the command Show web-management to view the web management-to-server configuration.

The SSL Port is displayed only if HTTPS Access is enabled. The Idle Timeout and Support URL are displayed if
either HTTP or HTTPS is enabled.

The following example shows the display of web management-to-server configuration.

show web-management

Web Management - Server Configuration 
HTTP Access           : Enabled
HTTPS Access          : Enabled
SSL Port              : 433
Idle Timeout          : 7200 seconds

Appendix D
Mobile web interface
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ArubaOS‐Switch Software Feature Support Matrix 16.07 
YA-YB/YC/WC/YC/KB Switches (minimum firmware versions)

Software Features
Firmware Prefix

2530
YA/YB

2540
YC

2930F
WC

2930M
WC

3810M
KB

5400R 
KB

Bridging
Data Link Detection Protocol (DLDP) YA.15.17/YB.15.17 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.17
Distributed Trunking PIM-DM n/a n/a n/a n/a KB.16.01 KB.15.17
Distributed Trunking PIM-SM n/a n/a n/a n/a KB.16.01 KB.15.18
Distributed Trunking Primary/Secondary Configuration n/a n/a n/a n/a KB.16.01 KB.15.15
Distributed Trunking Switch to Server n/a n/a n/a n/a KB.16.01 KB.15.15
Distributed Trunking Switch to Switch n/a n/a n/a n/a KB.16.01 KB.15.16
GVRP YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
LACP (802.3ad) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
LACP Key for Controlling Dynamic Trunk Configuration YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
LACP MAD n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
LACP Trunk Load Balancing Information Output YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
LLDP (802.1ab) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
LLDP MED (Media Endpoint Discovery) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
LLDP PoE+ Support YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
LLDP over OOBM n/a n/a n/a WC.16.04.0004 KB.16.01 KB.16.01
LLDP TLV YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Loop Protection YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
MAX VLANs: 512 YA.15.10/YB.15.12 YC.16.02.0012 n/a n/a n/a n/a
MAX VLANs: 1K n/a n/a n/a n/a n/a n/a
MAX VLANs: 2K n/a n/a WC.16.02.0003 WC.16.04.0004 n/a n/a
MAX VLANs: 4K n/a n/a n/a n/a KB.16.01 KB.16.01
Meshing: Concurrent Meshing and Routing n/a n/a n/a n/a KB.16.01 KB.15.15
Meshing: Mesh ID Configuration n/a n/a n/a n/a KB.16.01 KB.15.15
Meshing: Switch Meshing n/a n/a n/a n/a KB.16.01 KB.15.15
MVRP: Multiple VLAN Registration Protocol YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Q-in-Q n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Single Instance (802.1d-1998) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SmartLink YA.15.14/YB.15.14 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Spanning tree: BPDU Filtering YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Spanning tree: BPDU Protection YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Spanning tree: Fast Mode YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Spanning tree: Loop Guard YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Spanning tree: Multiple STP (802.1s Standards Compliant) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

Spanning tree: 64 MSTP instances n/a n/a   n/a n/a KB.16.01 KB.16.01
Spanning tree: PVST Protection and Filtering YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Spanning tree: PVST+ Compatibility YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Spanning tree: Rapid STP (802.1w Standards Compliant) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Spanning tree: Root Guard YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Trunking: Enable using TCP/UDP Port Numbers for Trunk Load-
Balancing YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Trunking: Link Aggregation YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
UDLD: Uni-Directional Link Detection YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
UDLD: Verify Before Forwarding YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.16
UFD: Uplink Failure Detection n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

VxLAN n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Wake-on-LAN for a Specific VLAN n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

Management
802.1ap Std MIB Support YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

802.3bz compliance (2.5 Gbps and 5.0 Gbps) for Smart Rate ports n/a n/a n/a WC.16.04.0008 KB.16.04.0008
KB.16.04.0008 (V3 
only)

100Mbps support on SmartRate ports n/a n/a n/a WC.16.06 KB.16.06 KB.16.06
IPSec to Controller for Management Traffic n/a YC.16.02 WC.16.02 WC.16.02 KB.16.02 KB.16.02

IPSec for Management Traffic (with secondary controller support) n/a YC.16.06 WC.16.06 WC.16.06 KB.16.06 KB.16.06
ARP Attack Detection n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Aruba Central on-boarding YA.16.07/YB.16.07 YC.16.07 WC.16.07 WC.16.07 KB.16.07 KB.16.07
Auto-MDI-X YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Banner: Post-Logon User-Configurable Banner Display YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Bidirectional Secure Copying Between Switch and SFTP Server YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
BOOTP/DHCP Relay Gateway YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
BPDU-Throttle n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.16
BYOD Redirect YA.15.16 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.16
Captive Portal for ClearPass YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.16.01
Chassislocate LED at Boot YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Clarify Port VLAN Tagged Status YA.15.12/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Clear Module Configuration n/a YC.16.02.0012 n/a n/a n/a KB.15.15
CLI Return Message Category (Error; Warning; Information) YA.15.10/YB.15.12 n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Compliance with IEEE Standard for MIB Object ieee8021MstpMib YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Comware CLI Support YA.15.11/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Config Backup and Restore without Reboot YA.16.05/YB.16.05 YC.16.05 WC.16.05 WC.16.05 KB.16.05 KB.16.05
Config Menu YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Control Plane Protection n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Control Plane Policing (CoPP) n/a n/a WC.16.04.0008 WC.16.04.0008 KB.16.04.0008 KB.16.04.0008
Custom Default Switch Configuration YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Customized Commands for Local User Accounts YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Device Profile: Auto configuration for Aruba APs/Switches YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Device Profile: Auto configuration for Custom device types YA.16.01/YB.16.01 YC.16.02.0012 WC.16.04.0008 WC.16.04.0008 KB.16.04.0008 KB.16.04.0008
DHCP Client DNS Support YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
DHCPv6 Client Options YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
DHCP Option 82 YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
DHCP Option 60 and 150 n/a YC.16.06 WC.16.06 WC.16.06 KB.16.06 KB.16.06

DHCP Relay YA.15.14/YB.15.14 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
DHCPv6 Relay n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
DHCPv6 Relay Option 79 n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.16
Disable IP Address on a VLAN Without Deleting the Address YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

Disable Username Prompt for Management Interface Authentication YA.15.15/YB.15.15 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Display Configuration of Selected Interface YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Display Transceiver YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
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Software Features
Firmware Prefix

2530
YA/YB

2540
YC

2930F
WC

2930M
WC

3810M
KB

5400R 
KB

Display Transceiver Information for Transceiver Cable Diagnostics YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
DNS Capabilities for Telnet YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Dual Flash Images YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Encoded Version Info Added to Config Files YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Encrypt Passwords and Authentication Keys in the Config File YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Event Log: Severity Change YA.15.12/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Event Log Buffer: Configurable threshold for SNMP traps YA.16.06/YB.16.06 YC.16.06 WC.16.06 WC.16.06 KB.16.06 KB.16.06
Fastboot YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Fault Finder Extended to Cover Flapping Transceiver Mitigation YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Fault Finder (Per Port Enable) n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 n/a
Filtering PVID Mismatch Log Message YA.15.14/YB.15.14 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Find-Fix-and-Inform YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Flow Control (802.3x) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Generic Header ID in Config File YA.15.16/YB.15.16 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.16
Grouped Config File Display per Interface YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
ICMP Throttling YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
IP Forwarding MIB YA.15.17/YB.15.17 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.17
IP Service Level Agreement (SLA) n/a YC.16.02.0012 WC.16.02.0008 WC.16.04.0004 KB.16.02 KB.16.02
IP Stacking YA.15.10/YB.15.12 n/a n/a n/a n/a n/a
IPv6 DNS via RA Options n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
IPv6 Host (Dual Stack) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Local Management Privilege Groups YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
MAC Limit Notify YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Management Interface Wizard YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Minimum Password Length YA.15.15/YB.15.15 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Module Reload n/a n/a n/a n/a n/a KB.15.15
MS-CHAPv2 for Switch Management Interface YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Multiple Configuration Files YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
NTP: Network Time Protocol YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
OOBM: IPv6 Host Function n/a n/a n/a WC.16.04.0004 KB.16.01 KB.15.15
Avoid double tunneling of Aruba APs on Tunneled Node n/a n/a WC.16.05 WC.16.05 KB.16.05 KB.16.05
PTP (Precision Time Protocol) IEEE 1588 n/a n/a n/a WC.16.04.0004 n/a n/a
Readable Interface Names in Traps YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Reinterpret CDP Info when Using IP Phones YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Report Config Changes Per-User Per-Session YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
REST APIs YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 K.16.01 KB.16.01
Retain configuration on 5400R 
when switching from v3-only to v-2 compatible mode n/a n/a n/a n/a n/a KB.16.02
RMON YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RMON: Extended RMON YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RMON: Local Alarm Threshold YA.15.13/YB.15.13 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Save Running Configuration to TFTP via SNMP YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Saving Security Credentials in a Configuration File YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Scheduled Reload YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Secure FTP YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Secure Shell v2 (SSHv2) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Secure Sockets Layer (SSL) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Send syslog Messages via TCP YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
sFlow YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
sFlow Data over OOBM n/a n/a n/a WC.16.04.0004 KB.16.01 KB.15.15
sFlow Set Agent Address YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
sFlow Using IPv6 YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Single Source IP Identity YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SNMP v1/v2c/v3/v3 with AES YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SNMP: Enable SNMP Trap when Switch Config Changes YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SNMP: MIB to Check Load of Module Slots n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SNMP: Password Set via SNMP YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SNMP: Server Source IP Commands YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SNMP: Trap if MAC Address Add to or Delete from a Port YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SNMP: Trap on MAC Address Table Changes YA.15.14/YB.15.14 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SNMP: Trap on Power Supply Removal YA.15.14/YB.15.14 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SNMP: Trap Throttling YA.15.13/YB.15.13 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SNTP: Simple Network Time Protocol YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Syslog Config Change Reporting YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Syslog over TLS YA.15.15/YB.15.15 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Syslog: Disable Debug without Affecting Syslog YA.15.13/YB.15.13 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Syslog: Per-Interface Syslog Event Enable-Disable YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Sysname in Syslog Messages YA.15.15/YB.15.15 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
TFTP & SSH Concurrent Usage YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.18
TFTP Uploadable Configuration YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Transceivers - Diagnostic Optical Monitoring 
(show interface transceiver detail) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Username and Password Length Increase YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
VLAN information added to 'show mac-address' Output YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
VSF: Virtual Switch Framework n/a n/a WC.16.03.0003 n/a n/a KB.16.01 (V3 only)
VSF 8-member Stack (2930F only) n/a n/a WC.16.06 n/a n/a n/a
Web GUI YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Web GUI Inactivity Timer YA.15.15/YB.15.15 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Next-Gen Web GUI YB.16.03 YC.16.02.0012 WC.16.02.0008 WC.16.04.0004 KB.16.03.0003 KB.16.03.0003
ZTP with TR-69 YA.15.16/YB.15.16 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 n/a n/a
ZTP with DHCP YA.16.01/YB.16.01 YC.16.01 WC.16.01 WC.16.01 KB.16.01 KB.16.01
ZTP with DHCPv6 n/a YC.16.06 WC.16.06 WC.16.06 KB.16.06 KB.16.06
ZTP for Activate YA.16.04/YB.16.04 YC.16.02.0012 WC.16.02.0010 WC.16.04.0004 KB.16.02 KB.16.02
HTTP Proxy Support YA.16.06/YB.16.06 YC.16.06 WC.16.06 WC.16.06 KB.16.06 KB.16.06
Job Scheduler YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
DHCPv4 Server n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.16
DHCPv6 Server n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.16
Console Lockout n/a YC.16.06 WC.16.06 WC.16.06 KB.16.06 KB.16.06

OpenFlow
OpenFlow 1.0 n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
OpenFlow 1.3 n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Openflow: Custom Matches n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.02 KB.16.02
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OpenFlow: L4 Match n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.18
OpenFlow: MacGroups n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.18
Openflow: Source IP specification YA.16.05/YB.16.05 YC.16.05 WC.16.05 WC.16.05 KB.16.05 KB.16.05

OpenFlow: TCP Flags and L4 port ranges in Custom Match Mode n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01(V3 ONLY)

Power
Energy Efficient Ethernet (EEE) YA.15.12/n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
External Power Support  (EPS) n/a n/a n/a n/a n/a n/a
Hibernate mode n/a n/a n/a WC.16.04.0004 n/a n/a
Power over Ethernet (POE) (802.3af) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Power over Ethernet Plus (POE+) (802.3at) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Redundant Power Support n/a n/a n/a WC.16.04.0004 KB.16.01 KB.15.15

Priority/Quality of Service (QoS)
Broadcast Control YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Broadcast Storm Control n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Classifier-Based QoS and Rate Limiting n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Egress Port Monitoring (Outbound) n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
ICMP Rate Limiting YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Inbound Rate-Limiting for Broadcast and Multicast Traffic YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Layer 4 TCP/UDP Packet Priority YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Mirroring: MAC based Mirroring n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Mirroring: MAC based Remote Mirroring n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Mirroring: no VLAN Tag added n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Mirroring: Port YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Mirroring: Remote n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Multicast Storm Control YA.16.06/YB.16.06 YC.16.06 WC.16.06 WC.16.06 KB.16.06 KB.16.06
QoS: Class of Service (CoS) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
QoS: Egress Queue Rate-limiting n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
QoS: Guaranteed Minimum Bandwidth n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
QoS: IPv6 QoS YA.15.14/YB.15.14 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

QoS: Monitor Egress Queues for Dropped Packets if QoS Configured YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
QoS: Netdestinations and Netservices YA.16.03 YC.16.03.0003 WC.16.03.0003 WC.16.04.0004 KB.16.03.0003 KB.16.03.0003
QoS: Packet Priority (802.1p) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
QoS: Per Port Trust YA.16.02 YC.16.02.0012 WC.16.02.0008 WC.16.04.0004 KB.16.02 KB.16.02
QoS: Port and Priority-based Rate Limiting YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
QoS: Priority Queuing YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
QoS: Selectable Queuing Configurations YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
QoS: Strict Priority Queuing n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
QoS: TCP/UDP Port Ranges YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
QoS: Traffic Template YA/YB. 16.01.0004 n/a WC.16.04.0008 WC.16.04.0008 KB.16.05 KB.16.05
QoS: Turn on/off VLAN Precedence YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.16
QoS: VLAN Port-Based Prioritization (802.1p) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Rate Limiting YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Rate Limiting Unknown Unicast Traffic n/a n/a WC.16.05 WC.16.05 KB.16.05 KB.16.05
Traffic Policing (with two rate three color marker) n/a n/a WC.16.06 WC.16.06 KB.16.06 KB.16.06

Routing and Multicast
ARP Age Timer Increase YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
BFD: Bidirectional Forwarding Detection (OSPF/VRRP) n/a n/a n/a n/a KB.16.01 KB.16.01 (V3 only)

BFD: Bidirectional Forwarding Detection (Static Routes) n/a n/a n/a n/a KB.16.04.0008
KB.16.04.0008 (V3 
only)

BGP: Border Gateway Protocol n/a n/a n/a n/a KB.16.01 KB.15.15
BGP: MD5 Authentication n/a n/a n/a n/a KB.16.01 KB.15.15
BGP: Route Filtering and Peer Restart Time Display n/a n/a n/a n/a KB.16.01 KB.15.15
BGP: Route Maps n/a n/a n/a n/a KB.16.01 KB.15.15
BGP: BGP-4 n/a n/a n/a n/a KB.16.01 KB.15.16
mDNS (Bonjour and Chromecast) Gateway YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Disable Overlapping Subnet Configuration YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
ECMP (Equal Cost Multipath) n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
ECMP with Static Routes n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Identification Field in Static Route Config YA.15.13/YB.15.13 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
IGMP v3 and MLD v2 Capabilities  (YA only supports MLD v1) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

Improved Log Commands and Output for OSPFv2 Troubleshooting n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.15.15
IPv6 Default gateway for OOBM n/a n/a n/a WC.16.04.0008 KB.16.04.0008 KB.16.04.0008
IPv6 Default Router Preference n/a n/a WC.16.04.0008 WC.16.04.0008 KB.16.04.0008 KB.16.04.0008

IPv6 over IPv4 Tunneling n/a n/a n/a n/a KB.16.01 KB.15.15
IPv6 Static Route Tag n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KA.15.16
IRDP n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Multicast: Block Unknown Multicast YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Multicast: IP Multicast snooping (Data Driven IGMP) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Multicast: IGMP v3 n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Multicast: IPv6 MLD Multicast Snooping YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Multi-Netting YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
OSPF (2930F & 2930M only support single-area OSPF) n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.15.15
OSPF ECMP n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.15.15
OSPF Global Cost Setting n/a n/a WC.16.05 WC.16.05 KB.16.05 KB.16.05

OSPF LSA Type 3 Summarized Prefix Cost n/a n/a n/a n/a KB.16.01 KB.15.15

OSPF LSA Type 3 Summarized Prefix Cost for OSPF v3 n/a n/a n/a n/a KB.16.01 KB.15.15
OSPF Neighbor Shutdown Notification n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.15.15
OSPF Neighbor Timer Information Display n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.15.15
OSPF NSSA Range Metrics added to OSPFv2 n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.15.15
OSPF/VRRP Nonstop Routing added to Management Failover n/a n/a WC.16.03.0003 WC.16.04.0004 KB.16.01 KB.15.15
OSPFv2 config Metric Cost/Range n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.15.15
OSPFv3 n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.15.15
OSPFv3 over 6-in-4 Tunnels n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.15.15
OSPFv3 Trap Global Enable/Disable n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.01 KB.15.16
PIM: Override Reverse Path Forward (RPF) Lookup n/a n/a WC.16.03.0003 WC.16.04.0004 KB.16.01 KB.15.15
PIM: 'router pim' Command Enhancements n/a n/a WC.16.03.0003 WC.16.04.0004 KB.16.01 KB.15.15
PIM-DM n/a n/a WC.16.03.0003 WC.16.04.0004 KB.16.01 KB.15.15
PIM-SM n/a n/a WC.16.03.0003 WC.16.04.0004 KB.16.01 KB.15.15
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PIMv6 SM and DM n/a n/a WC.16.05 WC.16.05 KB.16.05 KB.16.05
Policy-Based Routing (PBR) n/a n/a WC.16.03.0003 WC.16.04.0004 KB.16.01 KB.15.15
RIP v1/v2 n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RIP v2 with MD5 Authentication n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.18
RIPng n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Router Advertisement (RA) Guard n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Service Insertion: Intercept Tunnels n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Service Insertion: Mirror Tunnels n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.17
Show IP Route Summary n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Static Blackhole or Reject Routes Redistribution into RIP n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Static Routes n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Tunneled Node (per port) n/a n/a WC.16.02.0008 WC.16.04.0004 KB.16.02 KB.16.02
Tunneled Node (per user) n/a n/a WC.16.04.0008 WC.16.04.0008 KB.16.04.0008 KB.16.04.0008
Tunneled Node: Fallback to local switching n/a n/a WC.16.02.0011 WC.16.04.0004 KB.16.02.0011 KB.16.02.0011
UDP Broadcast Forwarding n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Virtual Router Redundancy Protocol (VRRP) n/a n/a WC.16.03.0003 WC.16.04.0004 KB.16.01 KB.15.15
VRRP Preemptive Delay Timer n/a n/a WC.16.03.0003 WC.16.04.0004 KB.16.01 KB.15.15
VRRP Track Ports & Dynamic Priority Change n/a n/a WC.16.03.0003 WC.16.04.0004 KB.16.01 KB.15.15
VRRPv3 n/a n/a WC.16.03.0003 WC.16.04.0004 KB.16.01 KB.15.15
VRRP: Support for Self-Ping, Telnet, SSH, Web GUI n/a n/a WC.16.06 WC.16.06 KB.16.06 KB.16.06

Security
802.1v Protocol VLANs YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
802.1X and RADIUS Login (Port-Based Access) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
AAA Authorization on HTTPS (T5) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
ACL Grouping n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
ACL: Access Control List YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
ACL: Logging Match YA.15.15/YB.15.15 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
ACL: MAC ACLs n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.18
ACL: Rule added to IP Directed Broadcast n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.18
Advanced Threat Detection YA.16.05/YB.16.05 YC.16.05 WC.16.05 WC.16.05 KB.16.05 KB.16.05
Device Fingerprinting with ClearPass n/a n/a WC.16.06 WC.16.06 KB.16.06 KB.16.06

Cached Re-authentication (Hold State if RADIUS Server Unavailable) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Concurrent 802.1x, WebAuth, and MacAuth YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Concurrent TACACS+ and SFTP YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
DHCP Snooping YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

DHCP Snooping: CLI to clear DSnoop Counter
YA 16_03_001.SWI/YB 
16_03_001.SWI YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

DHCP Snooping: DHCPv4 Snooping Max Binding YA.15.14/YB.15.14 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

DHCP Snooping: DHCPv6 Snooping
YA.15.16/YB.15.16

YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.16
Dynamic ARP Protection YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Dynamic IP Lockdown YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Egress ACLs n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.18
IPv6 Protocol VLANs YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Local MAC Authentication YA.15.16/YB.15.16 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Local User Roles YA.16.02 YC.16.02.0012 WC.16.02.0008 WC.16.04.0004 KB.16.02 KB.16.02
Downloadable User Roles n/a YC.16.04 WC.16.04 WC.16.04 KB.16.04 KB.16.04
Downloadable User Roles 
with Secondary Role Pushed to Controller n/a n/a WC.16.05 WC.16.05 KB.16.05 KB.16.05
MAC Authentication YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
MAC Authentication: Client Limit Increased to 256 n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
MAC Authentication: Hitless Re-Authentication YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
MAC Authentication:  Port-based YA.16.02/YB.16.02 YC.16.02.0012 WC.16.02.0008 WC.16.04.0004 KB.16.02 KB.16.02
MAC Authentication Toggle YA.16.02/YB.16.02 YC.16.02.0012 WC.16.02.0008 WC.16.04.0004 KB.16.02 KB.16.02
MAC Authentication: Unauth-Redirect YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
MAC-based VLANs (MBV) YA.15.14 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
MAC-based VLANs: Controlling MBV via CLI for NAC n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.16
MAC Pinning YA.16.05/YB.16.05 n/a WC.16.05 WC.16.05 KB.16.05 KB.16.05
MACSec: SmartRate Modules n/a n/a n/a WC.16.04.0004 KB.16.01 KB.15.18
MACSec: V3 only n/a n/a n/a WC.16.04.0004 KB.16.01 KB.15.17
Multiple 802.1X Clients Per Port YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
ND Snooping n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Open Authentication Roles n/a n/a WC.16.05 WC.16.05 KB.16.05 KB.16.05
Critical Authentication Roles n/a n/a WC.16.05 WC.16.05 KB.16.05 KB.16.05
Password Complexity YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Port Monitoring YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Port Security (MAC Lockdown) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Port Security (MAC Lockout) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Port Security Auto Recovery n/a n/a WC.16.06 WC.16.06 KB.16.06 KB.16.06
Protocol Based VLANs YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Private VLAN n/a n/a WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
RBAC: Role Based Access Control n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
RADIUS YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RADIUS Assigned ACLs YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RADIUS Assigned GVRP VLANs YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RADIUS Attributes for QoS and Rate-Limiting YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RADIUS Authenticated mgr Level Login YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RADIUS Authentication for Browser Access YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RADIUS Configuration via SNMP YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RADIUS for 802.1X Accounting YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RADIUS IPv6 YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RADIUS Port Speed VSA n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
RADIUS Service Tracking YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Source Port Filter YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
SSH Client YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

SSH Re-key (Government Certification) n/a n/a WC.16.04.0008 WC.16.04.0008 KB.16.04.0008 KB.16.04.0008
Static IP Lockdown n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
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Firmware Prefix

2530
YA/YB

2540
YC

2930F
WC

2930M
WC

3810M
KB

5400R 
KB

Synchronization for 802.1X Supplicants  (for Nonstop Switching) YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
TACACS+ YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

User Lockout (Government Certification) n/a n/a WC.16.04.0008 WC.16.04.0008 KB.16.04.0008 KB.16.04.0008
Virus Throttling (Connection Rate Filtering) n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15
Web-based Authentication YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.15.15

Supportability
Debug Command for PIM Packet Events Added n/a n/a n/a n/a KB.16.01 KB.15.15
Flight Data Recorder Log n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.02 KB.15.15
LACP Debug Logging and Show Commands YA.15.10/YB.15.12 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.02 KB.15.15
Preview Mode n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01

Time Domain Reflectometry (SmartRate modules not supported) n/a YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.02
KB.16.01
(V3 only)

Supportability Infrastructure: 
User Initiated Diagnostic Reset via Clear button YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
Supportability Infrastructure: 
User Initiated Diagnostic Reset via Serial Console YA.16.01/YB.16.01 YC.16.02.0012 WC.16.02.0003 WC.16.04.0004 KB.16.01 KB.16.01
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ArubaOS‐Switch Software Feature Support Matrix 16.07 
WB/RA/KA Switches (minimum firmware versions)

Software Features
Firmware Prefix

2920
WB

2620
RA

3800
KA

Bridging
Data Link Detection Protocol (DLDP) WB.15.17 RA.15.17 KA.15.17
Distributed Trunking PIM-DM n/a n/a KA.15.17
Distributed Trunking PIM-SM n/a n/a KA.15.18
Distributed Trunking Primary/Secondary Configuration n/a n/a KA.15.11
Distributed Trunking Switch to Server n/a n/a KA.15.09
Distributed Trunking Switch to Switch n/a n/a KA.15.16
GVRP WB.15.11 RA.15.05 KA.15.03
LACP (802.3ad) WB.15.11 RA.15.05 KA.15.03
LACP Key for Controlling Dynamic Trunk Configuration WB.15.11 RA.15.05 KA.15.09
LACP MAD WB.15.14 n/a KA.15.14
LACP Trunk Load Balancing Information Output WB.15.11 RA.15.05 KA.15.09
LLDP (802.1ab) WB.15.11 RA.15.05 KA.15.03
LLDP MED (Media Endpoint Discovery) WB.15.11 RA.15.05 KA.15.03
LLDP PoE+ Support WB.15.11 RA.15.05 KA.15.03
LLDP over OOBM WB.16.01 n/a KA.16.01
LLDP TLV WB.15.11 RA.15.05 KA.15.03
Loop Protection WB.15.11 RA.15.05 KA.15.03
MAX VLANs: 512 n/a RA.15.05 n/a
MAX VLANs: 1K WB.16.01 n/a n/a
MAX VLANs: 2K n/a n/a n/a
MAX VLANs: 4K n/a n/a KA.16.01
Meshing: Concurrent Meshing and Routing n/a n/a KA.15.09
Meshing: Mesh ID Configuration n/a n/a KA.15.07
Meshing: Switch Meshing n/a n/a KA.15.03
MVRP: Multiple VLAN Registration Protocol WB.16.01 RA.16.01 KA.16.01
Q-in-Q n/a n/a KA.15.03
Single Instance (802.1d-1998) WB.15.11 RA.15.05 KA.15.03
SmartLink WB.15.14 RA.15.14 KA.15.14
Spanning tree: BPDU Filtering WB.15.11 RA.15.05 KA.15.03
Spanning tree: BPDU Protection WB.15.11 RA.15.05 KA.15.03
Spanning tree: Fast Mode WB.15.11 RA.15.05 KA.15.03
Spanning tree: Loop Guard WB.15.11 RA.15.05 KA.15.09
Spanning tree: Multiple STP (802.1s Standards Compliant) WB.15.11 RA.15.05 KA.15.03
Spanning tree: 64 MSTP instances n/a n/a KA.16.01
Spanning tree: PVST Protection and Filtering WB.15.11 RA.15.05 KA.15.03
Spanning tree: PVST+ Compatibility WB.15.11 RA.15.05 KA.15.03
Spanning tree: Rapid STP (802.1w Standards Compliant) WB.15.11 RA.15.05 KA.15.03
Spanning tree: Root Guard WB.15.11 RA.15.05 KA.15.03
Trunking: Enable using TCP/UDP Port Numbers for Trunk Load-
Balancing WB.15.11 RA.15.05 KA.15.09
Trunking: Link Aggregation WB.15.11 RA.15.05 KA.15.03
UDLD: Uni-Directional Link Detection WB.15.11 RA.15.05 KA.15.03
UDLD: Verify Before Forwarding WB.15.16 RA.15.05 KA.15.16
UFD: Uplink Failure Detection WB.15.11 n/a KA.15.09
VxLAN n/a n/a n/a
Wake-on-LAN for a Specific VLAN WB.15.11 RA.15.05 KA.15.09
Management
802.1ap Std MIB Support WB.15.11 RA.15.09 KA.15.09

802.3bz compliance (2.5 Gbps and 5.0 Gbps) for Smart Rate ports n/a n/a n/a
100Mbps support on SmartRate ports n/a n/a n/a
IPSec to Controller for Management Traffic WB.16.02 n/a KA.16.02

IPSec for Management Traffic (with secondary controller support) WB.16.06 n/a n/a
ARP Attack Detection WB.16.01 n/a KA.16.01
Auto-MDI-X WB.15.11 RA.15.05 KA.15.03
Banner: Post-Logon User-Configurable Banner Display WB.15.11 RA.15.05 KA.15.03
Bidirectional Secure Copying Between Switch and SFTP Server WB.15.11 RA.15.05 KA.15.09
BOOTP/DHCP Relay Gateway WB.15.11 RA.15.05 KA.15.03
BPDU-Throttle WB.15.16 n/a KA.15.16
BYOD Redirect WB.15.16 RA.15.16 KA.15.16
Captive Portal for ClearPass WB.16.01 RA.16.01 KA.16.01
Chassislocate LED at Boot WB.15.11 RA.15.05 KA.15.14
Clarify Port VLAN Tagged Status WB.15.12 RA.15.12 KA.15.12
Clear Module Configuration n/a n/a n/a
CLI Return Message Category (Error; Warning; Information) WB.15.11 RA.15.05 KA.15.03
Compliance with IEEE Standard for MIB Object ieee8021MstpMib WB.15.11 RA.15.06 KA.15.06
Comware CLI Support WB.15.13 RA.15.11 KA.15.08
Config Backup and Restore without Reboot WB.16.05
Config Menu WB.15.11 RA.15.05 KA.15.03
Control Plane Protection WB.15.18 n/a KA.15.14
Control Plane Policing (CoPP) n/a n/a n/a
Custom Default Switch Configuration WB.15.11 RA.15.05 KA.15.12
Customized Commands for Local User Accounts WB.15.11 RA.15.05 KA.15.09
Device Profile: Auto configuration for Aruba APs/Switches WB.16.01 RA.16.01 KA.16.01
Device Profile: Auto configuration for Custom device types WB.16.01 n/a n/a
DHCP Client DNS Support WB.15.11 RA.15.07 KA.15.07
DHCPv6 Client Options WB.15.11 RA.15.05 KA.15.09
DHCP Option 82 WB.15.11 RA.15.05 KA.15.03
DHCP Option 60 and 150 n/a n/a n/a
DHCP Relay WB.15.11 RA.15.05 KA.15.03
DHCPv6 Relay WB.15.11  RA.15.05 KA.15.03
DHCPv6 Relay Option 79 WB.15.16  RA.16.01 KA.15.16
Disable IP Address on a VLAN Without Deleting the Address WB.15.11 RA.15.10 KA.15.09

Disable Username Prompt for Management Interface Authentication
WB.15.15 RA.15.15 KA.15.15

Display Configuration of Selected Interface WB.15.11 RA.15.05 KA.15.03
Display Transceiver WB.15.11 RA.15.07 KA.15.09

Anexo 03 ITENS 8 E 9 (0592705)         SEI 0008478-63.2018.6.02.8000 / pg. 6593



Software Features
Firmware Prefix

2920
WB

2620
RA

3800
KA

Display Transceiver Information for Transceiver Cable Diagnostics
WB.15.11 RA.15.07 KA.15.06

DNS Capabilities for Telnet WB.15.11 RA.15.05 KA.15.03
Dual Flash Images WB.15.11 RA.15.05 KA.15.03
Encoded Version Info Added to Config Files WB.15.11 RA.15.05 KA.15.09
Encrypt Passwords and Authentication Keys in the Config File WB.15.11 RA.15.06 KA.15.09
Event Log: Severity Change WB.15.11 RA.15.12 KA.15.12
Event Log Buffer: Configurable threshold for SNMP traps n/a n/a n/a
Fastboot WB.15.11 RA.15.05 KA.15.03
Fault Finder Extended to Cover Flapping Transceiver Mitigation WB.15.11 RA.15.05 KA.15.03
Fault Finder (Per Port Enable) n/a n/a KA.16.01
Filtering PVID Mismatch Log Message WB.15.15 RA.15.14 KA.15.14
Find-Fix-and-Inform WB.15.11 RA.15.05 KA.15.03
Flow Control (802.3x) WB.15.11 RA.15.05 KA.15.03
Generic Header ID in Config File WB.15.16 RA.15.16 KA.15.16
Grouped Config File Display per Interface WB.15.11 RA.15.08 KA.15.08
ICMP Throttling WB.15.11 RA.15.05 KA.15.03
IP Forwarding MIB WB.15.17 RA.15.17 KA.15.17
IP Service Level Agreement (SLA) WB.16.02 n/a KA.16.02
IP Stacking n/a RA.15.05 n/a
IPv6 DNS via RA Options WB.15.11 RA.15.10 KA.15.10
IPv6 Host (Dual Stack) WB.15.11 RA.15.05 KA.15.03
Local Management Privilege Groups WB.15.11 RA.15.05 KA.15.09
MAC Limit Notify WB.15.11 RA.15.10 KA.15.09
Management Interface Wizard WB.15.11 RA.15.05 KA.15.03
Minimum Password Length WB.15.15 RA.15.15 KA.15.15
Module Reload n/a n/a n/a
MS-CHAPv2 for Switch Management Interface WB.15.11 RA.15.05 KA.15.03
Multiple Configuration Files WB.15.11 RA.15.05 KA.15.03
NTP: Network Time Protocol WB.16.01 RA.16.01 KA.16.01
OOBM: IPv6 Host Function WB.15.11 n/a KA.15.03
Avoid double tunneling of Aruba APs on Tunneled Node n/a
PTP (Precision Time Protocol) IEEE 1588 n/a n/a n/a
Readable Interface Names in Traps WB.15.11 RA.15.05 KA.15.12
Reinterpret CDP Info when Using IP Phones WB.15.11 RA.15.05 KA.15.10
Report Config Changes Per-User Per-Session WB.15.11 RA.15.05 KA.15.07
REST APIs WB.16.01 RA.16.01 KA.16.01
Retain configuration on 5400R 
when switching from v3-only to v-2 compatible mode

n/a n/a n/a

RMON WB.15.11 RA.15.05 KA.15.03
RMON: Extended RMON WB.15.11 RA.15.05 KA.15.03
RMON: Local Alarm Threshold WB.15.13 RA.15.13 KA.15.13
Save Running Configuration to TFTP via SNMP WB.15.11 RA.15.05 KA.15.03
Saving Security Credentials in a Configuration File WB.15.11 RA.15.05 KA.15.03
Scheduled Reload WB.15.11 RA.15.05 KA.15.03
Secure FTP WB.15.11 RA.15.05 KA.15.03
Secure Shell v2 (SSHv2) WB.15.11 RA.15.05 KA.15.03
Secure Sockets Layer (SSL) WB.15.11 RA.15.05 KA.15.03
Send syslog Messages via TCP WB.15.11 RA.15.10 KA.15.09
sFlow WB.15.11 RA.15.05 KA.15.03
sFlow Data over OOBM WB.15.11 n/a KA.15.13
sFlow Set Agent Address WB.15.11 RA.15.10 KA.15.07
sFlow Using IPv6 n/a RA.15.10 KA.15.07
Single Source IP Identity WB.15.11 RA.15.10 KA.15.03
SNMP v1/v2c/v3/v3 with AES WB.15.11 RA.15.05 KA.15.03
SNMP: Enable SNMP Trap when Switch Config Changes WB.15.11 RA.15.05 KA.15.09
SNMP: MIB to Check Load of Module Slots WB.15.11 n/a KA.15.10
SNMP: Password Set via SNMP WB.15.11 RA.15.05 KA.15.03
SNMP: Server Source IP Commands WB.15.11 RA.15.05 KA.15.03
SNMP: Trap if MAC Address Add to or Delete from a Port WB.15.11 RA.15.05 KA.15.09
SNMP: Trap on MAC Address Table Changes WB.15.14 RA.15.14 KA.15.14
SNMP: Trap on Power Supply Removal WB.15.14 RA.15.14 KA.15.14
SNMP: Trap Throttling WB.15.13 RA.15.13 KA.15.13
SNTP: Simple Network Time Protocol WB.15.11 RA.15.05 KA.15.03
Syslog Config Change Reporting WB.15.11 RA.15.10 KA.15.09
Syslog over TLS WB.15.15 RA.15.16 KA.15.15
Syslog: Disable Debug without Affecting Syslog WB.15.13 RA.15.13 KA.15.13
Syslog: Per-Interface Syslog Event Enable-Disable WB.15.11 RA.15.05 KA.15.13
Sysname in Syslog Messages WB.15.15 RA.15.15 KA.15.15
TFTP & SSH Concurrent Usage WB.15.15 RA.15.05 KA.15.18
TFTP Uploadable Configuration WB.15.11 RA.15.05 KA.15.03
Transceivers - Diagnostic Optical Monitoring 
(show interface transceiver detail) WB.15.11 RA.15.07 KA.15.07
Username and Password Length Increase WB.15.11 RA.15.05 KA.15.03
VLAN information added to 'show mac-address' Output WB.15.11 RA.15.05 KA.15.09
VSF: Virtual Switch Framework n/a n/a n/a
VSF 8-member Stack (2930F only) n/a n/a n/a
Web GUI WB.15.11 RA.15.05 KA.15.03
Web GUI Inactivity Timer WB.15.15 RA.15.15 KA.15.15
Next-Gen Web GUI WB.16.03.0003 RA.16.03 KA.16.03.0003
ZTP with TR-69 WB.15.18 RA.15.16 n/a
ZTP with DHCP WB.16.01 n/a KA.16.01
ZTP with DHCPv6 n/a n/a n/a
ZTP for Activate WB.16.02 n/a KA.16.02
HTTP Proxy Support WB.16.06 n/a n/a
Job Scheduler WB.16.01 RA.16.01 KA.16.01
DHCPv4 Server WB.15.16 RA.15.16 KA.15.16
DHCPv6 Server WB.15.16 RA.15.16 KA.15.16
Console Lockout n/a n/a n/a
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2920
WB

2620
RA

3800
KA

OpenFlow
OpenFlow 1.0 WB.15.12 n/a KA.15.10
OpenFlow 1.3 WB.15.14 n/a KA.15.14
Openflow: Custom Matches n/a n/a n/a
OpenFlow: L4 Match WB.15.18 n/a KA.15.18
OpenFlow: MacGroups WB.15.18 n/a KA.15.18
Openflow: Source IP specification WB.16.05
OpenFlow: TCP Flags and L4 port ranges in Custom Match Mode n/a n/a n/a
Power
Energy Efficient Ethernet (EEE) WB.15.11 n/a KA.15.03
External Power Support  (EPS) WB.15.13 RA.15.05 n/a
Hibernate mode n/a n/a n/a
Power over Ethernet (POE) (802.3af) WB.15.11 RA.15.05 KA.15.03
Power over Ethernet Plus (POE+) (802.3at) WB.15.11 n/a KA.15.03
Redundant Power Support WB.15.13 RA.15.05 KA.15.03
Priority/Quality of Service (QoS)
Broadcast Control WB.15.11 RA.15.05 KA.15.03
Broadcast Storm Control WB.15.15 n/a KA.15.15
Classifier-Based QoS and Rate Limiting WB.15.11 n/a KA.15.03
Egress Port Monitoring (Outbound) n/a n/a KA.15.03
ICMP Rate Limiting WB.15.11 RA.15.05 KA.15.03
Inbound Rate-Limiting for Broadcast and Multicast Traffic WB.15.11 RA.15.05 KA.15.03
Layer 4 TCP/UDP Packet Priority WB.15.11 RA.15.05 KA.15.03
Mirroring: MAC based Mirroring n/a n/a KA.15.03
Mirroring: MAC based Remote Mirroring n/a n/a KA.15.03
Mirroring: no VLAN Tag added n/a n/a KA.15.03
Mirroring: Port WB.15.11 RA.15.05 KA.15.03
Mirroring: Remote n/a n/a KA.15.03
Multicast Storm Control n/a n/a n/a
QoS: Class of Service (CoS) WB.15.11 RA.15.05 KA.15.03
QoS: Egress Queue Rate-limiting WB.15.15 n/a KA.15.15
QoS: Guaranteed Minimum Bandwidth WB.15.11 n/a KA.15.03
QoS: IPv6 QoS WB.15.11 RA.15.14 KA.15.03

QoS: Monitor Egress Queues for Dropped Packets if QoS Configured WB.15.11 RA.15.05 KA.15.09
QoS: Netdestinations and Netservices WB.16.03 n/a n/a
QoS: Packet Priority (802.1p) WB.15.11 RA.15.05 KA.15.03
QoS: Per Port Trust WB.16.02 RA.16.02 KA.16.02
QoS: Port and Priority-based Rate Limiting WB.15.11 RA.15.05 KA.15.03
QoS: Priority Queuing WB.15.11 RA.15.05 KA.15.03
QoS: Selectable Queuing Configurations WB.15.11 RA.15.05 KA.15.03
QoS: Strict Priority Queuing WB.15.11 n/a KA.15.12
QoS: TCP/UDP Port Ranges WB.15.11 RA.15.05 KA.15.03
QoS: Traffic Template n/a n/a n/a
QoS: Turn on/off VLAN Precedence WB.15.11 RA.15.05 KA.15.16
QoS: VLAN Port-Based Prioritization (802.1p) WB.15.11 RA.15.05 KA.15.03
Rate Limiting WB.15.11 RA.15.05 KA.15.03
Rate Limiting Unknown Unicast Traffic n/a n/a n/a
Traffic Policing (with two rate three color marker) n/a n/a n/a
Routing and Multicast
ARP Age Timer Increase WB.15.11 RA.15.05 KA.15.03
BFD: Bidirectional Forwarding Detection (OSPF/VRRP) n/a n/a n/a
BFD: Bidirectional Forwarding Detection (Static Routes) n/a n/a n/a
BGP: Border Gateway Protocol n/a n/a KA.15.09
BGP: MD5 Authentication n/a n/a KA.15.09
BGP: Route Filtering and Peer Restart Time Display n/a n/a KA.15.09
BGP: Route Maps n/a n/a KA.15.09
BGP: BGP-4 n/a n/a KA.15.16
mDNS (Bonjour and Chromecast) Gateway WB.16.01  RA.15.09 KA.16.01
Disable Overlapping Subnet Configuration WB.15.11 RA.15.09 KA.15.09
ECMP (Equal Cost Multipath) WB.15.11 RA.15.05 KA.15.03
ECMP with Static Routes WB.15.11 RA.15.05 KA.15.03
Identification Field in Static Route Config WB.15.13 RA.15.13 KA.15.13
IGMP v3 and MLD v2 Capabilities  (YA only supports MLD v1) WB.15.11  n/a KA.15.09

Improved Log Commands and Output for OSPFv2 Troubleshooting WB.16.02 n/a KA.15.09
IPv6 Default gateway for OOBM WB.16.04.0008 n/a KA.16.04.0008
IPv6 Default Router Preference WB.16.04.0008 n/a KA.16.04.0008
IPv6 over IPv4 Tunneling n/a n/a KA.15.06
IPv6 Static Route Tag WB.15.16 n/a KA.15.16
IRDP WB.15.11 RA.15.05 KA.15.03
Multicast: Block Unknown Multicast WB.15.11 RA.15.05 KA.15.09
Multicast: IP Multicast snooping (Data Driven IGMP) WB.15.11 RA.15.05 KA.15.03
Multicast: IGMP v3 WB.16.01 n/a KA.16.01
Multicast: IPv6 MLD Multicast Snooping WB.15.11 RA.15.05 KA.15.03
Multi-Netting WB.15.11 RA.15.05 KA.15.03
OSPF (2930F & 2930M only support single-area OSPF) WB.16.02 n/a KA.15.03
OSPF ECMP WB.16.02 n/a KA.15.03
OSPF Global Cost Setting n/a
OSPF LSA Type 3 Summarized Prefix Cost n/a n/a KA.15.09
OSPF LSA Type 3 Summarized Prefix Cost for OSPF v3 n/a n/a KA.15.09
OSPF Neighbor Shutdown Notification WB.16.02 n/a KA.15.09
OSPF Neighbor Timer Information Display WB.16.02 n/a KA.15.09
OSPF NSSA Range Metrics added to OSPFv2 WB.16.02 n/a KA.15.09
OSPF/VRRP Nonstop Routing added to Management Failover WB.16.02 n/a KA.15.09
OSPFv2 config Metric Cost/Range WB.16.02 n/a KA.15.09
OSPFv3 WB.16.02 n/a KA.15.03
OSPFv3 over 6-in-4 Tunnels n/a n/a KA.15.09
OSPFv3 Trap Global Enable/Disable WB.16.02 n/a KA.15.16
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PIM: Override Reverse Path Forward (RPF) Lookup n/a n/a KA.15.09
PIM: 'router pim' Command Enhancements n/a n/a KA.15.09
PIM-DM n/a n/a KA.15.03
PIM-SM n/a n/a KA.15.03
PIMv6 SM and DM n/a
Policy-Based Routing (PBR) n/a n/a KA.15.09
RIP v1/v2 WB.15.11 RA.15.05 KA.15.03
RIP v2 with MD5 Authentication WB.15.18 RA.15.18 KA.15.18
RIPng WB.16.01 n/a KA.16.01
Router Advertisement (RA) Guard WB.15.11 n/a KA.15.09
Service Insertion: Intercept Tunnels WB.15.15 n/a KA.15.15
Service Insertion: Mirror Tunnels WB.15.17 n/a KA.15.17
Show IP Route Summary WB.15.11 RA.15.07 KA.15.09
Static Blackhole or Reject Routes Redistribution into RIP WB.15.11 n/a KA.15.09
Static Routes WB.15.11 RA.15.05 KA.15.03
Tunneled Node (per port) WB.16.02 n/a KA.16.02
Tunneled Node (per user) n/a n/a n/a
Tunneled Node: Fallback to local switching WB.16.02.0011 n/a KA.16.02.0011
UDP Broadcast Forwarding WB.15.11 RA.15.05 KA.15.03
Virtual Router Redundancy Protocol (VRRP) n/a n/a KA.15.03
VRRP Preemptive Delay Timer n/a n/a KA.15.03
VRRP Track Ports & Dynamic Priority Change n/a n/a KA.15.03
VRRPv3 n/a n/a KA.15.13
VRRP: Support for Self-Ping, Telnet, SSH, Web GUI n/a n/a n/a
Security
802.1v Protocol VLANs WB.15.11 RA.15.05 KA.15.03
802.1X and RADIUS Login (Port-Based Access) WB.15.11 RA.15.05 KA.15.03
AAA Authorization on HTTPS (T5) WB.15.11 RA.15.05 KA.15.03
ACL Grouping  n/a n/a KA.16.01
ACL: Access Control List WB.15.11 RA.15.05 KA.15.03
ACL: Logging Match WB.15.11 RA.15.05 KA.15.09
ACL: MAC ACLs n/a n/a n/a
ACL: Rule added to IP Directed Broadcast WB.15.18 RA.15.18 KA.15.18
Advanced Threat Detection WB.16.05 n/a n/a
Device Fingerprinting with ClearPass n/a n/a n/a

Cached Re-authentication (Hold State if RADIUS Server Unavailable) WB.15.11 RA.15.05 KA.15.03
Concurrent 802.1x, WebAuth, and MacAuth WB.15.11 RA.15.05 KA.15.03
Concurrent TACACS+ and SFTP WB.15.11 RA.15.05 KA.15.03
DHCP Snooping WB.15.11 RA.15.05 KA.15.03
DHCP Snooping: CLI to clear DSnoop Counter WB.15.13  RA.16.03.0001 KA.15.13
DHCP Snooping: DHCPv4 Snooping Max Binding WB.15.14  RA.15.14 KA.15.14
DHCP Snooping: DHCPv6 Snooping WB.15.16 RA.15.16 KA.15.16
Dynamic ARP Protection WB.15.11 RA.15.05 KA.15.03
Dynamic IP Lockdown WB.15.11 RA.15.05 KA.15.03
Egress ACLs WB.15.18 n/a KA.15.18
IPv6 Protocol VLANs WB.15.11 RA.15.05 KA.15.03
Local MAC Authentication WB.15.14 RA.15.16 KA.15.14
Local User Roles WB.16.02 RA.16.02 KA.16.02
Downloadable User Roles WB.16.04 n/a n/a
Downloadable User Roles 
with Secondary Role Pushed to Controller n/a n/a n/a
MAC Authentication WB.15.11 RA.15.05 KA.15.03
MAC Authentication: Client Limit Increased to 256 n/a n/a KA.15.03
MAC Authentication: Hitless Re-Authentication WB.15.11 RA.15.05 KA.15.03
MAC Authentication:  Port-based WB.16.02 RA.16.02 KA.16.02
MAC Authentication Toggle WB.16.02 RA.16.02 KA.16.02
MAC Authentication: Unauth-Redirect WB.15.11 RA.15.05 KA.15.03
MAC-based VLANs (MBV) WB.15.14 RA.15.10 KA.15.09
MAC-based VLANs: Controlling MBV via CLI for NAC WB.15.16 n/a KA.15.16
MAC Pinning WB.16.05
MACSec: SmartRate Modules n/a n/a n/a
MACSec: V3 only n/a n/a n/a
Multiple 802.1X Clients Per Port WB.15.11 RA.15.05 KA.15.03
ND Snooping WB.16.01 n/a KA.16.01
Open Authentication Roles n/a
Critical Authentication Roles n/a
Password Complexity WB.16.01 RA.16.01 KA.16.01
Port Monitoring WB.15.11 RA.15.05 KA.15.03
Port Security (MAC Lockdown) WB.15.11 RA.15.05 KA.15.03
Port Security (MAC Lockout) WB.15.11 RA.15.05 KA.15.03
Port Security Auto Recovery n/a n/a n/a
Protocol Based VLANs WB.15.11 RA.15.05 KA.15.03
Private VLAN WB.16.01 n/a KA.16.01
RBAC: Role Based Access Control WB.16.01 n/a KA.16.01
RADIUS WB.15.11 RA.15.05 KA.15.03
RADIUS Assigned ACLs WB.15.11 RA.15.05 KA.15.03
RADIUS Assigned GVRP VLANs WB.15.11 RA.15.05 KA.15.03
RADIUS Attributes for QoS and Rate-Limiting WB.15.11 RA.15.05 KA.15.03
RADIUS Authenticated mgr Level Login WB.15.11 RA.15.05 KA.15.03
RADIUS Authentication for Browser Access WB.15.11 RA.15.05 KA.15.03
RADIUS Configuration via SNMP WB.15.11 RA.15.05 KA.15.03
RADIUS for 802.1X Accounting WB.15.11 RA.15.05 KA.15.03
RADIUS IPv6 WB.15.12 RA.15.12 KA.15.12
RADIUS Port Speed VSA WB.15.13 n/a KA.15.13
RADIUS Service Tracking WB.16.01 RA.16.01 KA.16.01
Source Port Filter WB.15.11 RA.15.05 KA.15.03
SSH Client WB.15.11 RA.15.05 KA.15.09
SSH Re-key (Government Certification)  n/a  n/a  n/a
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Static IP Lockdown WB.15.11 RA.15.05 KA.15.03

Synchronization for 802.1X Supplicants  (for Nonstop Switching) WB.15.11 RA.15.05 KA.15.03
TACACS+ WB.15.11 RA.15.05 KA.15.03
User Lockout (Government Certification) WB.16.04.0008  n/a n/a
Virus Throttling (Connection Rate Filtering) n/a n/a KA.15.03
Web-based Authentication WB.15.11 RA.15.05 KA.15.03
Supportability
Debug Command for PIM Packet Events Added n/a n/a KA.15.09
Flight Data Recorder Log WB.15.12 n/a KA.15.09
LACP Debug Logging and Show Commands WB.15.11 RA.15.06 KA.15.09
Preview Mode WB.16.04 n/a n/a
Time Domain Reflectometry  (SmartRate modules not supported) WB.16.04.0008 n/a n/a
Supportability Infrastructure: 
User Initiated Diagnostic Reset via Clear button WB.16.01 RA.16.01 KA.16.01
Supportability Infrastructure: 
User Initiated Diagnostic Reset via Serial Console WB.16.01 RA.16.01 KA.16.01

Software Support
Minimum

SW Version 

AirWave (ZTP, configuration, software update) 8.2.1

AirWave over IPSec 8.2.1

Aruba Central n/a

Aruba Activate n/a

Aruba Activate Firmware Upgrade n/a

Aruba Controller (70xx & 72xx series) 6.5

VAN Controller (SDN) 2.8.8.0366
Network Optimizer 1.5.4.109
Network Protector 1.5.5.39
Network Visualizer 1.2.7.164

IMC 7.2

ClearPass (CoA Port Bounce, Captive Portal) 6.6.0

All software version references to 16.07 are for 16.07.0001

HPE Part Number 5200-5376 
Published: October 2018
Edition: 1

To help us improve the documentation, send any errors, suggestions, 
or comments to docsfeedback@hpe.com.

© Copyright 2015-2018 Hewlett Packard Enterprise Development LP 

The information contained herein is subject to change without notice. 
The only warranties for Hewlett Packard Enterprise products and 
services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be 
construed as constituting an  additional warranty. Hewlett Packard 
Enterprise shall not be liable for technical or editorial errors or 
omissions contained herein.

ClearPass version 6.7.0 is required for 
Advanced Threat Detection 

2920, 2930F, 2930M, 3800, 3810, 5400R v2/v3
2530, 2540, 2620, 2920, 2930F, 2930M, 3800, 3810, 
5400R 2930M requires at least 7.3 E0503

2920, 2930F, 2930M, 3800, 3810, 5400R v2/v3

2530, 2540, 2620, 2920, 2930F, 2930M, 3800, 3810, 
5400R v2/v3

2920, 2930F, 2930M, 3800, 3810, 5400R v2/v3
2920, 2930F, 2930M, 3800, 3810, 5400R v2/v3

2920, 2930F, 2930M, 3800, 3810, 5400R

Switches manufactured as of February 2016.

2530, 2540, 2920, 2930F, 2930M, 3800, 3810, 
5400Rzl

Switches manufactured as of February 2016 
except 5400R zl2, which is as of June 2016.

2530,2920, 2930F, 2930M, 2540, 3800, 3810, 5400R 
zl

2530, 2540, 2920, 2930F, 2930M, 3810,5400R(only 
Template),2920-Stk(16.04), 2930M-
Stk(16.06), 5400R_VSF(16.06.0008)

Comments

2530, 2540, 2620, 2920, 2930F, 2930M, 3800, 3810, 
5400R v2/v3 2530 >=8.2.1.1,  2930M >=8.2.4

2540, 2920, 2930F, 2930M, 3800,5400R, 3810
Controller firmware version must be at least 
6.5.

Supported Switch Platforms
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This guide provides information on how to configure, manage, and monitor basic switch operation.

Applicable products
This guide applies to these products:

Aruba 2930F Switch Series (JL253A, JL254A, JL255A, JL256A, JL258A, JL259A, JL260A, JL261A, JL262A,
JL263A, JL264A, JL557A, JL558A, JL559A)

Aruba 2930M Switch Series (JL319A, JL320A, JL321A, JL322A, JL323A, JL324A, R0M67A, R0M68A)

Switch prompts used in this guide
Examples in this guide are representative and may not match your particular switch/environment. Examples use
simplified prompts as follows:

Prompt Explanation

switch# # indicates manager context (authority).

switch> > indicates operator context (authority).

switch(config)# (config) indicates the config context.

switch(vlan-x)# (vlan-x) indicates the vlan context of config, where x
represents the VLAN ID. For example:
switch(vlan-128)#.

switch(eth-x)# (eth-x) indicates the interface context of config,
where x represents the interface. For example:
switch(eth-48)#.

switch-Stack# Stack indicates that stacking is enabled.

switch-Stack(config)# Stack(config) indicates the config context while
stacking is enabled.

switch-Stack(stacking)# Stack(stacking) indicates the stacking context of
config while stacking is enabled.

switch-Stack(vlan-x)# Stack(vlan-x) indicates the vlan context of config
while stacking is enabled, where x represents the
VLAN ID. For example: switch-
Stack(vlan-128)#.

switch-Stack(eth-x/y)# Stack(eth-x/y) indicates the interface context of
config, in the form (eth-<member-in-stack>/
<interface>). For example: switch(eth-1/48)#

Chapter 1
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NOTE:

For successful time protocol setup and specific configuration details, you may need to contact your
system administrator regarding your local configuration.

General steps for running a time protocol on the switch
Using time synchronization ensures a uniform time among interoperating devices. This helps you to manage and
troubleshoot switch operation by attaching meaningful time data to event and error messages.

The switch offers TimeP, SNTP (Simple Network Time Protocol), NTP, and a timesync command for changing
the time protocol selection (or turning off time protocol operation).

NOTE: Although you can create and save configurations for all time protocols without conflicts, the
switch allows only one active time protocol at any time.

In the factory-default configuration, time synchronization is disabled by default.

NOTE: Because the Aruba 2930F Switch does not contain an RTC (real time clock) chip, Hewlett
Packard Enterprise recommends configuring one of the time synchronization protocols supported.
Failure to do so could result in the switch time being reset to the factory default of 01/01/1990
00:00:00 in the case of a switch reload, software upgrade, or power cycle.

TimeP time synchronization
You can either manually assign the switch to use a TimeP server or use DHCP to assign the TimeP server. In
either case, the switch can get its time synchronization updates from only one designated TimeP server. This
option enhances security by specifying which time server to use.

SNTP time synchronization
SNTP provides three operating modes:

• Broadcast mode

The switch acquires time updates by accepting the time value from the first SNTP time broadcast detected. (In
this case, the SNTP server must be configured to broadcast time updates to the network broadcast address;
see the documentation provided with your SNTP server application.) Once the switch detects a particular
server, it ignores time broadcasts from other SNTP servers unless the configurable Poll Interval expires three
consecutive times without an update received from the first-detected server.

NOTE: To use Broadcast mode, the switch and the SNTP server must be in the same subnet.

• DHCP mode

DHCP mode is enabled by default. In DHCP mode, the SNTP server address and the timezone are provided in
the DHCP address reply.

• Unicast mode

The switch requests a time update from the configured SNTP server. (You can configure one server using the
menu interface, or up to three servers using the CLI sntp server command.) This option provides increased

Chapter 2
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security over the Broadcast mode by specifying which time server to use instead of using the first one detected
through a broadcast.

NTP time synchronization
The Network Time Protocol (NTP) synchronizes the time of day among a set of distributed time servers and
clients in order to correlate events when receiving system logs and other time-specific events from multiple
network devices. NTP uses the User Datagram Protocol (UDP) as its transport protocol.

timesync Command
This command is used to configure the protocol used for network time synchronization.

Syntax

[no] timesync { timep | sntp | timep-or-sntp | ntp }
Options
no
Deletes all timesync configurations on the device.

timep
Updates the system clock using TIMEP.

sntp
Updates the system clock using SNTP.

timep-or-sntp
Updates the system clock using TIMEP or SNTP (default).

ntp
Updates the system clock using NTP

Example
switch(config)# timesync
sntp                  Update the system clock using SNTP.
timep                 Update the system clock using TIMEP.
timep-or-sntp         Update the system clock using TIMEP or SNTP.
ntp                   Update the system clock using NTP.

Selecting a time synchronization protocol
Procedure

1. Select the time synchronization protocol: TimeP, SNTP, or NTP.

2. Enable the protocol; the choices are:

a. TimeP: DHCP or Manual
b. SNTP: Broadcast or Unicast
c. NTP: Broadcast or Unicast

3. Configure the remaining parameters for the time protocol you selected.
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The switch retains the parameter settings for both time protocols even if you change from one protocol to the
other. Thus, if you select a time protocol, the switch uses the parameters you last configured for the selected
protocol.

Simply selecting a time synchronization protocol does not enable that protocol on the switch unless you also
enable the protocol itself (step 2, above). For example, in the factory-default configuration, TimeP is the selected
time synchronization method. However, because TimeP is disabled in the factory-default configuration, no time
synchronization protocol is running.

Disabling time synchronization
You can execute no timesync (global config level of the CLI) to disable time synchronization without changing
the TimeP, SNTP, or NTP configuration.

TimeP: Selecting and configuring
The following table shows TimeP parameters and their operations.

Table 1: TimeP parameters

TimeP
parameter

Operation

Time Sync
Method

Used to select either TIMEP, SNTP, NTP, or None as the time synchronization method.

TimeP Mode

 Disabled TimeP does not operate, even if specified by the Menu interface Time Sync Method
parameter or the CLI timesync command.

 DHCP When TimeP is selected as the time synchronization method, the switch attempts to acquire a
TimeP server IP address via DHCP. If the switch receives a server address, it polls the server
for updates according to the TimeP poll interval. If the switch does not receive a TimeP server
IP address, it cannot perform time synchronization updates.

 Manual When TimeP is selected as the time synchronization method, the switch attempts to poll the
specified server for updates according to the TimeP poll interval. If the switch fails to receive
updates from the server, time synchronization updates do not occur.

 Server
Address

Used only when the TimeP Mode is set to Manual. Specifies the IP address of the TimeP
server that the switch accesses for time synchronization updates. You can configure one
server.

Viewing the current TimeP configuration (CLI)
Using different show commands, you can display either the full TimeP configuration or a combined listing of all
TimeP, SNTP, and VLAN IP addresses configured on the switch.

Syntax:

show timep
Lists both the time synchronization method (TimeP, SNTP, or None) and the TimeP configuration, even if SNTP is
not the selected time protocol. (If the TimeP Mode is set to Disabled or DHCP, the Server field does not appear.)
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If you configure the switch with TimeP as the time synchronization method, then enable TimeP in DHCP mode
with the default poll interval, show timep lists the following:

TimeP configuration when TimeP is the selected Time synchronization method

switch(config)# show timep

 Timep Configuration

  Time Sync Mode: Timep
  TimeP Mode [Disabled] : DHCP    Server Address : 10.10.28.103
  Poll Interval (min) [720] : 720
If SNTP is the selected time synchronization method, show timep still lists the TimeP configuration even though
it is not currently in use. Even though, in this Example:, SNTP is the current time synchronization method, the
switch maintains the TimeP configuration:

TimeP configuration when TimeP is not the selected time synchronization method

switch(config)# show timep

 Timep Configuration
 
  Time Sync Mode: Sntp
  TimeP Mode [Disabled] : Manual   Server Address : 10.10.28.100
  Poll Interval (min) [720] : 720
Syntax:

show management
Helps you to easily examine and compare the IP addressing on the switch. It lists the IP addresses for all time
servers configured on the switch plus the IP addresses and default gateway for all VLANs configured on the
switch.

Display showing IP addressing for all configured time servers and VLANs

switch(config)# show management

 Status and Counters - Management Address Information

  Time Server Address : 10.10.28.100

  Priority SNTP Server Address                            Protocol Version
  -------- ---------------------------------------------- ----------------
  1        10.10..28.101                                  3
  2        10.255.5.24                                    3
  3        fe80::123%vlan10                               3

  Default Gateway : 10.0.9.80
 
  VLAN Name    MAC Address         | IP Address
  ------------ ------------------- + -------------------
  DEFAULT_VLAN 001279-88a100       | 10.30.248.184
  VLAN10 001279-88a100             | 10.0.10.17
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Configuring (enabling or disabling) the TimeP mode
Enabling the TimeP mode means to configure it for either broadcast or unicast mode. Remember to run TimeP as
the switch's time synchronization protocol, you must also select TimeP as the time synchronization method by
using the CLI timesync command.

Syntax:

timesync timep
Selects TimeP as the time synchronization method.

Syntax:

ip timep {<dhcp | manual>}
Enables the selected TimeP mode.

Syntax:

[no] ip timep
Disables the TimeP mode.

Syntax:

[no] timesync
Disables the time protocol.

Enabling TimeP in manual mode (CLI)
Like DHCP mode, configuring TimeP for manual mode enables TimeP. However, for manual operation, you must
also specify the IP address of the TimeP server. (The switch allows only one TimeP server.)

Syntax:

timesync timep
Selects TimeP.

Syntax:

ip timep manual <ip-addr>
Activates TimeP in manual mode with a specified TimeP server.

Syntax:

no ip timep
Disables TimeP.

Enabling TimeP in DHCP Mode
Because the switch provides a TimeP polling interval (default:720 minutes), you need only these two commands
for a minimal TimeP DHCP configuration:

Syntax:

timesync timep
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Selects TimeP as the time synchronization method.

Syntax:

ip timep dhcp
Configures DHCP as the TimeP mode.

For example, suppose:

• Time Synchronization is configured for SNTP.

• You want to:
◦ View the current time synchronization.

◦ Select TimeP as the synchronization mode.

◦ Enable TimeP for DHCP mode.

◦ View the TimeP configuration.

Enabling TimeP in Manual Mode
Like DHCP mode, configuring TimeP for Manual Mode enables TimeP. However, for manual operation, you must
also specify the IP address of the TimeP server. (The switch allows only one TimeP server.) To enable the TimeP
protocol:

Syntax:

timesync timep
Selects TimeP.

Syntax:

ip timep manual <ip-addr>
Activates TimeP in manual mode with a specified TimeP server.

Syntax:

[no] ip timep
Disables TimeP.

NOTE:

To change from one TimeP server to another, you must use the no ip timep command to disable
TimeP mode, the reconfigure TimeP in manual mode with the new server IP address.

Example:

To select TimeP and configure it for manual operation using a TimeP server address of 10.28.227.141 and the
default poll interval (720 minutes, assuming the TimeP poll interval is already set to the default):

switch(config)# timesync time
Selects TimeP.

switch(config)# ip timep manual 10.28.227.141
Activates TimeP in Manual mode.
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Configuring TimeP for manual operation

switch(config)# timesync timep
switch(config)# ip timep manual 10.28.227.141
switch(config)# show timep
 Timep Configuration
  Time Sync Mode: Timep
  TimeP Mode :  Manual              Server Address : 10.28.227.141
  Poll Interval (min) : 720

Changing from one TimeP server to another (CLI)

Procedure

1. Use the no ip timep command to disable TimeP mode.

2. Reconfigure TimeP in Manual mode with the new server IP address.

Changing the TimeP poll interval (CLI)
Syntax:

ip timep {< dhcp | manual >} interval <1-9999>
Specifies how long the switch waits between time polling intervals. The default is 720 minutes and the range is 1
to 9999 minutes. (This parameter is separate from the poll interval parameter used for SNTP operation.)

Example:

To change the poll interval to 60 minutes:

switch(config)# ip timep interval 60

Disabling time synchronization without changing the TimeP configuration (CLI)
Syntax:

no timesync
Disables time synchronization by changing the Time Sync Mode configuration to Disabled. This halts time
synchronization without changing your TimeP configuration. The recommended method for disabling time
synchronization is to use the timesync command.

Example:

Suppose TimeP is running as the switch's time synchronization protocol, with DHCP as the TimeP mode, and the
factory-default polling interval. You would halt time synchronization with this command:

switch(config)# no timesync
If you then viewed the TimeP configuration, you would see the following:

TimeP with time synchronization disabled

switch(config)# show timep

 Timep Configuration
  Time Sync Mode: Disabled
  TimeP Mode : DHCP Poll Interval (min): 720
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Disabling the TimeP mode
Syntax:

no ip timep
Disables TimeP by changing the TimeP mode configuration to Disabled and prevents the switch from using it as
the time synchronization protocol, even if it is the selected Time Sync Method option.

Example:

If the switch is running TimeP in DHCP mode, no ip timep changes the TimeP configuration as shown below
and disables time synchronization. Even though the TimeSync mode is set to TimeP, time synchronization is
disabled because no ip timep has disabled the TimeP mode parameter.

Disabling time synchronization by disabling the TimeP mode parameter

switch(config)# no ip timep

switch(config)# show timep

 Timep Configuration
  Time Sync Mode: Timep
  TimeP Mode : Disabled

SNTP: Selecting and configuring
The following table shows the SNTP parameters and their operations.

Table 2: SNTP parameters

SNTP parameter Operation

Time Sync Method Used to select either SNTP, TIMEP, NTP, or None as the time synchronization method.

SNTP Mode

 Disabled The Default. SNTP does not operate, even if specified by the Menu interface Time Sync
Method parameter or the CLI timesync command.

 Unicast Directs the switch to poll a specific server for SNTP time synchronization. Requires at
least one server address.

Broadcast Directs the switch to acquire its time synchronization from data broadcast by any SNTP
server to the network broadcast address. The switch uses the first server detected and
ignores any others. However, if the Poll Interval expires three times without the switch
detecting a time update from the original server, the switch accepts a broadcast time
update from the next server it detects.

Poll Interval
(seconds)

In Unicast Mode: Specifies how often the switch polls the designated SNTP server for a
time update.In Broadcast Mode: Specifies how often the switch polls the network
broadcast address for a time update.Value is between 30 to 720 seconds.

Table Continued
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SNTP parameter Operation

Server Address Used only when the SNTP Mode is set to Unicast. Specifies the IP address of the SNTP
server that the switch accesses for time synchronization updates. You can configure up to
three servers; one using the menu or CLI, and two more using the CLI.

Server Version Specifies the SNTP software version to use and is assigned on a per-server basis. The
version setting is backwards-compatible. For example, using version 3 means that the
switch accepts versions 1 through 3. Default: 3; range: 1 to 7.

Priority Specifies the order in which the configured servers are polled for getting the time. Value is
between 1 and 3.

Viewing and configuring SNTP (CLI)
Syntax:

show sntp
Lists both the time synchronization method (TimeP, SNTP, or None) and the SNTP configuration, even if SNTP is
not the selected time protocol.

If you configure the switch with SNTP as the time synchronization method, then enable SNTP in broadcast mode
with the default poll interval, show sntp lists the following:

SNTP configuration when SNTP is the selected time synchronization method

switch(config)# show sntp

 SNTP Configuration

  Time Sync Mode: Sntp
  SNTP Mode : Unicast
  Poll Interval (sec) [720] : 719

  Priority SNTP Server Address            Protocol Version
  -------- ------------------------------ ----------------
  1        2001:db8::215:60ff:fe79:8980   7
  2        10.255.5.24                    3
  3        fe80::123%vlan10               3
In the factory-default configuration (where TimeP is the selected time synchronization method), show sntp still
lists the SNTP configuration, even though it is not currently in use. In SNTP configuration when SNTP is not
the selected time synchronization method on page 35, even though TimeP is the current time synchronous
method, the switch maintains the SNTP configuration.

SNTP configuration when SNTP is not the selected time synchronization method

switch(config)# show sntp

 SNTP Configuration

  Time Sync Mode: Timep
  SNTP Mode : Unicast
  Poll Interval (sec) [720] : 719
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  Priority SNTP Server Address            Protocol Version
  -------- ------------------------------ ----------------
  1        2001:db8::215:60ff:fe79:8980   7
  2        10.255.5.24                    3
  3        fe80::123%vlan10               3
Syntax:

show management
This command can help you to easily examine and compare the IP addressing on the switch. It lists the IP
addresses for all time servers configured on the switch, plus the IP addresses and default gateway for all VLANs
configured on the switch.

Display showing IP addressing for all configured time servers and VLANs

switch(config)# show management

 Status and Counters - Management Address Information

  Time Server Address : fe80::215:60ff:fe7a:adc0%vlan10

  Priority  SNTP Server Address            Protocol Version
  --------- ------------------------------ ----------------
  1         2001:db8::215:60ff:fe79:8980   7
  2         10.255.5.24                    3
  3         fe80::123%vlan10               3

  Default Gateway   :10.0.9.80

  VLAN Name    MAC Address     | IP address
  ------------ --------------- + ---------------
  DEFAULT_VLAN 001279-88a100   | Disabled
  VLAN10       001279-88a100   | 10.0.10.17

Configuring (enabling or disabling) the SNTP mode
Enabling the SNTP mode means to configure it for either broadcast or unicast mode. Remember that to run SNTP
as the switch's time synchronization protocol, you must also select SNTP as the time synchronization method by
using the CLI timesync command.

Syntax:

timesync sntp
Selects SNTP as the time protocol.

sntp {<broadcast | unicast>}
Enables the SNTP mode.

Syntax:

sntp server <ip-addr>
Required only for unicast mode.
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Syntax:

sntp server priority <1-3>
Specifies the order in which the configured servers are polled for getting the time. Value is between 1 and 3.

Syntax:

sntp <30-720>
Configures the amount of time between updates of the system clock via SNTP.

Default: 720 seconds

Enabling SNTP in Broadcast Mode
Because the switch provides an SNTP polling interval (default: 720 seconds), you need only these two commands
for minimal SNTP broadcast configuration:

Syntax:

timesync sntp
Selects SNTP as the time synchronization method.

Syntax:

sntp broadcast
Configures broadcast as the SNTP mode.

Example:

Suppose that time synchronization is in the factory-default configuration (TimeP is the currently selected time
synchronization method.) Complete the following:

Procedure

1. View the current time synchronization.

2. Select SNTP as the time synchronization mode.

3. Enable SNTP for Broadcast mode.

4. View the SNTP configuration again to verify the configuration.
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The commands and output would appear as follows:

Figure 1: Enabling SNTP operation in Broadcast Mode

switch(config)# show sntp 1
 SNTP Configuration
  Time Sync Mode: Timep
  SNTP Mode : disabled
  Poll Interval (sec) [720] :720

switch(config)# timesync sntp

switch(config)# sntp broadcast

switch(config)# show sntp 2
 SNTP Configuration
  Time Sync Mode: Sntp
  SNTP Mode : Broadcast
  Poll Interval (sec) [720] :720

• 1show sntp displays the SNTP configuration and also shows that TimeP is the currently

active time synchronization mode.

• 2show sntp again displays the SNTP configuration and shows that SNTP is now the

currently active time synchronization mode and is configured for broadcast operation.

Enabling SNTP in unicast mode (CLI)
Like broadcast mode, configuring SNTP for unicast mode enables SNTP. However, for unicast operation, you
must also specify the IP address of at least one SNTP server. The switch allows up to three unicast servers. You
can use the Menu interface or the CLI to configure one server or to replace an existing unicast server with
another. To add a second or third server, you must use the CLI. For more on SNTP operation with multiple
servers, see SNTP unicast time polling with multiple SNTP servers on page 48

Syntax:

timesync sntp
Selects SNTP as the time synchronization method.

Syntax:

sntp unicast
Configures the SNTP mode for unicast operation.

Syntax:

[no] sntp server priority < 1-3 > < ip-address > [version]
Use the no version of the command to disable SNTP.

priority
Specifies the order in which the configured SNTP servers are polled for the time.

ip-address
An IPv4 or IPv6 address of an SNTP server.
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version
The protocol version of the SNTP server. Allowable values are 1 through 7; default is 3.

Syntax:

no sntp server priority <1-3> <ip-addr>
Deletes the specified SNTP server.

NOTE: 
priority <1-3>
value must match what server is configured with. Deleting an SNTP server when only one is
configured disables SNTP unicast operation.

Example:

To select SNTP and configure it with unicast mode and an SNTP server at 10.28.227.141 with the default server
version (3) and default poll interval (720 seconds):

switch(config)# timesync sntp
Selects SNTP.

switch(config)# sntp unicast
Activates SNTP in unicast mode.

switch(config)# sntp server priority 1 10.28.227.141
Specifies the SNTP server and accepts the current SNTP server version (default: 3).

Configuring SNTP for unicast operation

switch(config)# show sntp

 SNTP Configuration

  Time Sync Mode: Sntp
  SNTP Mode : Unicast
  Poll Interval (sec) [720] : 720

  Priority SNTP Server Address                            Protocol Version
  -------- ---------------------------------------------- ----------------
  1        2001:db8::215:60ff:fe79:8980 7
  2        10.255.5.24 3
  3        fe80::123%vlan10 3
In this Example:, the Poll Interval and the Protocol Version appear at their default settings.

Both IPv4 and IPv6 addresses are displayed.

Note: Protocol Version appears only when there is an IP address configured for an SNTP server.

If the SNTP server you specify uses SNTP v4 or later, use the sntp server command to specify the correct
version number. For example, suppose you learned that SNTP v4 was in use on the server you specified above
(IP address 10.28.227.141). You would use the following commands to delete the server IP address , re-enter it
with the correct version number for that server.
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Specifying the SNTP protocol version number

switch(config)# no sntp server 10.28.227.141 1
switch(config)# sntp server 10.28.227.141 4 2
switch(config)# show sntp
 
 SNTP Configuration

  Time Sync Mode: Sntp
  SNTP Mode : Broadcast
  Poll Interval (sec) [720] : 600

  IP Address     Protocol Version
  -------------  -----------------
  10.28.227.141  4 3
      

• 1Deletes unicast SNTP server entry.

• 2Re-enters the unicast server with a non-default protocol version.

• 3show sntp displays the result.

Changing the SNTP poll interval (CLI)
Syntax:

sntp <30..720>
Specifies the amount of time between updates of the system clock via SNTP. The default is 720 seconds and the
range is 30 to 720 seconds. (This parameter is separate from the poll interval parameter used for Timep
operation.)

Example:

To change the poll interval to 300 seconds:

switch(config)# sntp 300
Changing the SNTP server priority (CLI)
You can choose the order in which configured servers are polled for getting the time by setting the server priority.

Syntax:

sntp server priority <1-3> <ip-address>
Specifies the order in which the configured servers are polled for getting the time Value is between 1 and 3.

NOTE: You can enter both IPv4 and IPv6 addresses. For more information about IPv6 addresses,
see the IPv6 configuration guide for your switch.

Example:

To set one server to priority 1 and another to priority 2:

switch(config)# sntp server priority 1 10.28.22.141

switch(config)# sntp server priority 2
                 2001:db8::215:60ff:fe79:8980
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Disabling time synchronization without changing the SNTP configuration (CLI)
The recommended method for disabling time synchronization is to use the timesync command.

Syntax:

no timesync
Halts time synchronization without changing your SNTP configuration.

Example:

Suppose SNTP is running as the switch's time synchronization protocol, with broadcast as the SNTP mode and
the factory-default polling interval. You would halt time synchronization with this command:

switch(config)# no timesync
If you then viewed the SNTP configuration, you would see the following:

SNTP with time synchronization disabled

switch(config)# show sntp
 SNTP Configuration
  Time Sync Mode: Disabled
  SNTP Mode : Broadcast
  Poll Interval (sec) [720] : 720

Disabling the SNTP Mode
If you want to prevent SNTP from being used even if it is selected by timesync, configure the SNTP mode as
disabled.

Syntax:

no sntp
Disables SNTP by changing the SNTP mode configuration to Disabled.

Example:

If the switch is running SNTP in unicast mode with an SNTP server at 10.28.227.141 and a server version of 3
(the default), no sntp changes the SNTP configuration as shown below and disables time synchronization on
the switch.

Disabling time synchronization by disabling the SNTP mode

switch(config)# no sntp
switch(config)# show sntp

 SNTP Configuration

  Time Sync Mode: Sntp
  SNTP Mode : disabled
  Poll Interval (sec) [720] : 600

  IP Address     Protocol Version
  -------------  -----------------
  10.28.227.141  3
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Note that even though the Time Sync Mode is set to Sntp, time synchronization is disabled because no sntp
has disabled the SNTP Mode parameter.

SNTP client authentication
Enabling SNTP authentication allows network devices such as switches to validate the SNTP messages received
from an NTP or SNTP server before updating the network time. NTP or SNTP servers and clients must be
configured with the same set of authentication keys so that the servers can authenticate the messages they send
and clients (switches) can validate the received messages before updating the time.

This feature provides support for SNTP client authentication on switches, which addresses security
considerations when deploying SNTP in a network.

Requirements
You must configure the following to enable SNTP client authentication on the switch.

SNTP client authentication support

• Timesync mode must be SNTP. Use the timesync sntp command. (SNTP is disabled by default).

• SNTP must be in unicast or broadcast mode. See Configuring unicast and broadcast mode for
authentication on page 45.

• The MD5 authentication mode must be selected.

• An SNTP authentication key-identifier (key-id) must be configured on the switch and a value (key-value)
must be provided for the authentication key. A maximum of 8 sets of key-id and key-value can be
configured on the switch.

• Among the keys that have been configured, one key or a set of keys must be configured as trusted. Only
trusted keys are used for SNTP authentication.

• If the SNTP server requires authentication, one of the trusted keys has to be associated with the SNTP server.

• SNTP client authentication must be enabled on the Switch. If client authentication is disabled, packets are
processed without authentication.

All of the above steps are necessary to enable authentication on the client.

SNTP server authentication support

NOTE: SNTP server is not supported on Switch products.

You must perform the following on the SNTP server:

• The same authentication key-identifier, trusted key, authentication mode and key-value that were configured
on the SNTP client must also be configured on the SNTP server.

• SNTP server authentication must be enabled on the server.

If any of the parameters on the server are changed, the parameters have to be changed on all the SNTP clients in
the network as well. The authentication check fails on the clients otherwise, and the SNTP packets are dropped.

Configuring the key-identifier, authentication mode, and key-value (CLI)
This command configures the key-id, authentication-mode, and key-value, which are required for
authentication. It is executed in the global configuration context.
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Syntax:

sntp authentication key-id <key-id> authentication-mode <md5> key-value <key-string> [trusted]

no sntp authentication key-id <key-id>
Configures a key-id, authentication-mode (MD5 only), and key-value, which are required for authentication.

The no version of the command deletes the authentication key.

Default: No default keys are configured on the switch.

key-id
A numeric key identifier in the range of 1-4,294,967,295 (232) that identifies the unique key value. It is sent in
the SNTP packet.

key-value <key-string>
The secret key that is used to generate the message digest. Up to 32 characters are allowed for key-
string .

encrypted-key <<key-string>>
Set the SNTP authentication key value using a base64–encoded aes-256 encrypted string.

Setting parameters for SNTP authentication

switch(config)# sntp authentication key-id 55 authentication-mode md5
key-value secretkey1

Configuring a trusted key
Trusted keys are used in SNTP authentication. In unicast mode, you must associate a trusted key with a
specific NTP/SNTP server. That key is used for authenticating the SNTP packet.

In unicast mode, a specific server is configured on the switch so that the SNTP client communicates with the
specified server to get the date and time.

In broadcast mode, the SNTP client switch checks the size of the received packet to determine if it is
authenticated. If the broadcast packet is authenticated, the key-id value is checked to see if the same key-id value
is configured on the SNTP client switch. If the switch is configured with the same key-id value, and the key-id
value is configured as "trusted," the authentication succeeds. Only trusted key-id value information is used for
SNTP authentication. For information about configuring these modes, see Configuring unicast and broadcast
mode for authentication on page 45.

If the packet contains key-id value information that is not configured on the SNTP client switch, or if the received
packet contains no authentication information, it is discarded. The SNTP client switch expects packets to be
authenticated if SNTP authentication is enabled.

When authentication succeeds, the time in the packet is used to update the time on the switch.

Configuring a key-id as trusted (CLI)
Enter the following command to configure a key-id as trusted.

Syntax:

sntp authentication key-id <key-id> trusted

no sntp authentication key-id <key-id> trusted
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Trusted keys are used during the authentication process. You can configure the switch with up to eight sets of
key-id/key-value pairs. One specific set must selected for authentication; this is done by configuring the set as
trusted.

The key-id itself must already be configured on the switch. To enable authentication, at least one key-id must
be configured as trusted.

The no version of the command indicates the key is unreliable (not trusted).

Default: No key is trusted by default.

For detailed information about trusted keys, see Configuring a trusted key on page 43

Associating a key with an SNTP server (CLI)
Syntax:

[no] sntp server priority <1-3> {< ip-address | ipv6-address >} <version-num> [key-id <1-4,294,967,295>]

Configures a key-id to be associated with a specific server. The key itself must already be configured on the
switch.

The no version of the command disassociates the key from the server. This does not remove the authentication
key.

Default: No key is associated with any server by default.

priority
Specifies the order in which the configured servers are polled for getting the time.

version-num
Specifies the SNTP software version to use and is assigned on a per-server basis. The version setting is
backwards-compatible. For example, using version 3 means that the switch accepts versions 1 through 3.
Default: 3; range: 1 - 7.

key-id
Optional command. The key identifier sent in the SNTP packet. This key-id is associated with the SNTP
server specified in the command.

Associating a key-id with a specific server

switch(config)# sntp server priority 1 10.10.19.5 2 key-id 55

Enabling SNTP client authentication
The sntp authentication command enables SNTP client authentication on the switch. If SNTP
authentication is not enabled, SNTP packets are not authenticated.

Syntax:

[no] sntp authentication
Enables the SNTP client authentication.

The no version of the command disables authentication.

Default: SNTP client authentication is disabled.
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Configuring unicast and broadcast mode for authentication
To enable authentication, you must configure either unicast or broadcast mode. When authentication is enabled,
changing the mode from unicast to broadcast or vice versa is not allowed; you must disable authentication and
then change the mode.

To set the SNTP mode or change from one mode to the other, enter the appropriate command.

Syntax:

sntp unicast

sntp broadcast
Enables SNTP for either broadcast or unicast mode.

Default: SNTP mode is disabled by default. SNTP does not operate even if specified by the CLI timesync
command.

Unicast Directs the switch to poll a specific server periodically for SNTP time synchronization.The
default value between each polling request is 720 seconds, but can be configured.At least one
manually configured server IP address is required.

NOTE: At least one key-id must be configured as trusted, and it must be associated with one of
the SNTP servers. To edit or remove the associated key-id information or SNTP server information,
SNTP authentication must be disabled.

Broadcast Directs the switch to acquire its time synchronization from data broadcast by any SNTP server
to the network broadcast address. The switch uses the first server detected and ignores any
others. However, if the Poll Interval (configurable up to 720 seconds) expires three times
without the switch detecting a time update from the original server, the switch accepts a
broadcast time update from the next server it detects.

Viewing SNTP authentication configuration information (CLI)
The show sntp command displays SNTP configuration information, including any SNTP authentication keys that
have been configured on the switch.

SNTP configuration information

switch(config)# show sntp

 SNTP Configuration

  SNTP Authentication : Enabled
  Time Sync Mode: Sntp
  SNTP Mode : Unicast
  Poll Interval (sec) [720] : 720

  Priority SNTP Server Address                  Protocol Version KeyId
  -------- ------------------------------------ ---------------- -----
  1        10.10.10.2                           3                55
  2        fe80::200:24ff:fec8:4ca8             3                55
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Viewing all SNTP authentication keys that have been configured on the switch (CLI)
Enter the show sntp authentication command, as shown in Show sntp authentication command output
on page 46.

Show sntp authentication command output

switch(config)# show sntp authentication

  SNTP Authentication Information

  SNTP Authentication : Enabled

  Key-ID  Auth Mode  Trusted
  ------- ---------- --------
  55      MD5        Yes
  10      MD5        No

Viewing statistical information for each SNTP server (CLI)
To display the statistical information for each SNTP server, enter the show sntp statistics command.

The number of SNTP packets that have failed authentication is displayed for each SNTP server address, as
shown in SNTP authentication statistical information on page 46.

SNTP authentication statistical information

switch(config)# show sntp statistics
SNTP Statistics

  Received Packets : 0
  Sent Packets : 3
  Dropped Packets : 0

  SNTP Server Address                     Auth Failed Pkts
  --------------------------------------- ----------------
  10.10.10.1                                  0
  fe80::200:24ff:fec8:4ca8                    0

Saving configuration files and the include-credentials command
You can use the include-credentials command to store security information in the running-config file. This
allows you to upload the file to a TFTP server and then later download the file to the switches on which you want
to use the same settings. For more information about the include-credentials command, see "Configuring
Username and Password Security" in the access security guide for your switch.

The authentication key values are shown in the output of the show running-config and show config
commands only if the include-credentials command was executed.

When SNTP authentication is configured and include-credentials has not been executed, the SNTP
authentication configuration is not saved.

Configuration file with SNTP authentication information

switch(config) # show config
Startup configuration:
.
.
.
timesync sntp
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sntp broadcast
sntp 50
sntp authentication
sntp server priority 1 10.10.10.2.3 key-id 55
sntp server priority 2 fe80::200:24ff:fec8:4ca8 4 key-id 55

NOTE: SNTP authentication has been enabled and a key-id of 55 has been created.

In this Example:, the include-credentials command has not been executed and is not present in the
configuration file. The configuration file is subsequently saved to a TFTP server for later use. The SNTP
authentication information is not saved and is not present in the retrieved configuration files, as shown in the
following Example:.

Retrieved configuration file when include credentials is not configured

switch(config) # copy tftp startup-config 10.2.3.44 config1
.
.
.
Switch reboots ...
.
Startup configuration
.
.
.
timesync sntp
sntp broadcast
sntp 50 sntp server priority 1 10.10.10.2.3
sntp server priority 2 fe80::200:24ff:fec8:4ca8 4
.
.
.

NOTE: The SNTP authentication line and the Key-ids are not displayed. You must reconfigure SNTP
authentication.

Chapter 2 Time Protocols 47

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 6644



If include-credentials is configured, the SNTP authentication configuration is saved in the configuration file.
When the show config command is entered, all of the information that has been configured for SNTP
authentication displays, including the key-values.

Figure 2: Saved SNTP Authentication information when include-credentials is configured

SNTP unicast time polling with multiple SNTP servers
When running SNTP unicast time polling as the time synchronization method, the switch requests a time update
from the server you configured with either the Server Address parameter in the menu interface, or the primary
server in a list of up to three SNTP servers configured using the CLI. If the switch does not receive a response
from the primary server after three consecutive polling intervals, the switch tries the next server (if any) in the list.
If the switch tries all servers in the list without success, it sends an error message to the Event Log and
reschedules to try the address list again after the configured Poll Interval time has expired.

If there are already three SNTP server addresses configured on the switch, and you want to use the CLI to
replace one of the existing addresses with a new one, you must delete the unwanted address before you
configure the new one.

Displaying all SNTP server addresses configured on the switch (CLI)
The System Information screen in the menu interface displays only one SNTP server address, even if the switch
is configured for two or three servers. The CLI show management command displays all configured SNTP
servers on the switch.

How to list all SNTP servers configured on the switch

switch(config)# show management
 
 Status and Counters - Management Address Information

  Time Server Address : fe80::215:60ff:fe7a:adc0%vlan10

  Priority SNTP Server Address                            Protocol Version
  -------- ---------------------------------------------- ----------------
  1 2001:db8::215:60ff:fe79:8980                          7
  2 10.255.5.24                                           3
  3 fe80::123%vlan10                                      3
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  Default Gateway : 10.0.9.80

  VLAN Name    MAC Address         | IP Address
  ------------ ------------------- + -------------------
  DEFAULT_VLAN 001279-88a100       | Disabled
  VLAN10       001279-88a100       | 10.0.10.17

Adding and deleting SNTP server addresses

Adding addresses
As mentioned earlier, you can configure one SNTP server address using either the Menu interface or the CLI. To
configure a second and third address, you must use the CLI. To configure the remaining two addresses, you
would do the following:

Creating additional SNTP server addresses with the CLI

switch(config)# sntp server priority <1-3> 2001:db8::215:60ff:fe79:8980
switch(config)# sntp server 10.255.5.24

NOTE: If there are already three SNTP server addresses configured on the switch, and you want to
use the CLI to replace one of the existing addresses with a new one, you must delete the unwanted
address before you configure the new one.

Deleting addresses
Syntax:

no sntp server <ip-addr>
Deletes a server address. If there are multiple addresses and you delete one of them, the switch re-orders the
address priority.

Example:

To delete the primary address in the above Example: and automatically convert the secondary address to primary:

switch(config)# no sntp server 10.28.227.141

SNTP messages in the Event Log
If an SNTP time change of more than three seconds occurs, the switch's Event Log records the change. SNTP
time changes of less than three seconds do not appear in the Event Log.

Network Time Protocol (NTP)
All NTP communications use Coordinated Universal Time (UTC). An NTP server usually receives its time from an
authoritative time source, such as a radio clock or an atomic clock attached to a time server, and then distributes
this time across the network. NTP is extremely efficient; no more than one packet per minute is necessary to
synchronize two machines to within a millisecond of each other.

NTP uses a stratum to describe the distance between a network device and an authoritative time source:

• A stratum 1 time server is directly attached to an authoritative time source (such as a radio or atomic clock or a
GPS time source).

• A stratum 2 NTP server receives its time through NTP from a stratum 1 time server.
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Before synchronizing, NTP compares the time reported by several network devices and does not synchronize
with one that is significantly different, even if it is a stratum 1.

The security features of NTP can be used to avoid the accidental or malicious setting of incorrect time. One such
mechanism is available: an encrypted authentication mechanism.

Though similar, the NTP algorithm is more complex and accurate than the Simple Network Time Protocol (SNTP).

IMPORTANT: Enabling this feature results in synchronizing the system clock; therefore, it may affect
all sub-systems that rely on system time.

Commands
The following commands allow the user to configure NTP or show NTP configurations.

timesync ntp
This command is used to update the system clock using NTP.

Syntax

timesync ntp
Description

Update the system clock using NTP.

ntp
This command selects the operating mode of the NTP client.

Syntax

ntp [broadcast|unicast]
Options
broadcast
Sets ntp client to operate in broadcast mode.

unicast
Sets ntp client to operate in unicast mode.

Usage

The default mode is broadcast.

[no] ntp
This command disables NTP and removes all NTP configurations on the device.

Syntax
[no] ntp [authentication <key-id>
 | broadcast | enable | max-association 
<integer> | server 
<IP-ADDR> | trap 
<trap-name> | unicast]
      
Description
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Disable NTP and removes the entire NTP configuration.

Options

authentication

Configure NTP authentication.

broadcast

Operate in broadcast mode.

enable

Enable/disable NTP.

max-association

Maximum number of Network Time Protocol (NTP) associations.

server

Configure a NTP server to poll for time synchronization.

trap

Enable/disable NTP traps.

unicast

Operate in unicast mode.

Example
switch(config)# no ntp
This will delete all NTP configurations on this device. Continue [y/n]?

ntp enable
This command is used to enable or disable NTP on the switch.

Syntax

ntp enable
Example
switch(config)# ntp
enable       Enable/disable NTP.
Description

Enable or disable NTP. Use [no] to disable NTP.

Restrictions

Validation Error/Warning/Prompt

If timeSync is in SNTP or Timep when NTP is enabled. Timesync is not configured to NTP.

When timesync is NTP and ntp is enabled and we try to
change timesync to SNTP.

Disable NTP before changing timesync to
SNTP or TIMEP

ntp authentication
This command is used for authentication of NTP server by the NTP client.

Syntax
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ntp authentication key-id <KEY-ID> [authentication-mode <MODE> key-value <KEY-
STRING>] [trusted]
Parameters/Options
key-id <id>
Sets the key-id for the authentication key.

Subcommands
authentication-mode
Sets the NTP authentication mode

key-value <KEY-STRING>
Sets the key-value for the authentication key.

[trusted]
Sets the authentication key as trusted.
Example
Switch(config)# ntp
Authentication      Configure NTP authentication.

Switch(config)# ntp authentication
key-id              Set the key-id for this authentication key.

Switch(config)# ntp authentication key-id 
<1-4294967295>      Set the authentication key-id.

Switch(config)# ntp authentication key-id 1
authentication-mode  Set the NTP authentication mode.
trusted              Set this authentication key as trusted.

Switch(config)# ntp authentication key-id 1 
authentication-mode|trusted md5
Authenticate using MD5.

Switch(config)# ntp authentication key-id 1 
authentication-mode|trusted md5key-value  Set the NTP authentication key.

Switch(config)# ntp authentication key-id 1
authentication-mode|trusted md5 key-value 
KEY           Enter a string to be set as the NTP authentication key.

ntp authentication key-id
Syntax
ntp authentication key-id 
<key-id> [authentication-mode [md5 | sha1]
 key-value <key-value>] [trusted]
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Description

The NTP client authenticates the NTP server.

Options

authentication-mode

Set the NTP authentication mode.

• md5: Authenticate using MD5.

• sha1: Authenticate using SHA1.

trusted

Set this authentication key as trusted.

ntp max-association
This command is used to configure the maximum number of servers associated with this NTP client.

Syntax
ntp max-association 
<number>
      
Options
max-association <number>
Sets the maximum number of NTP associations.

Description

Configure maximum number of servers associated with the client. Up to eight servers can be configured as the
maximum.

Restrictions

The range for a maximum number of NTP associations is 1–8.

Example
Switch(config)# ntp
max-associations      Maximum number of NTP associations.

Switch(config)# ntp max-associations
<1-8>                  Enter the number.
Restrictions

Validation Error/Warning/Prompt

When the number of configured NTP servers is more
than the max-associations value.

The maximum number of NTP servers
allowed is <number>.

When the max-associations value is less than the (n)
number of configured NTP servers.

Max-associations value cannot be less
than the number of NTP servers
configured.

ntp server
This command is used to configure the NTP servers.
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Syntax

[no] ntp server

ntp server <IP-ADDR|IPv6-ADDR> [key <key-id>] [oobm] [max-poll <max-poll-val>][min-poll <min-poll-val>][burst | iburst] [version <1-4>]

Parameters/Options
[no]
Removes the unicast NTP configurations on the device.

Subcommands
IP-ADDR
Sets the IPv4 address of the NTP server.

IPV6-ADDR
Sets the IPv6 address of the NTP server.

key <key-id>
Specifies the authentication key.

max-poll <max-poll-val>
Configures the maximum time intervals in power of 2 seconds. Range is 4–17 (e.g., 5 would translate to 2 raised
to 5 or 32).

min-poll <min-poll-val>
Configures the minimum time intervals in seconds. Range is 4–17.

burst
Enables burst mode.

iburst
Enables initial burst mode.

version
Sets version 1–4.

Usage

A maximum of 8 NTP servers can be configured.

Example
switch(config)# ntp
server          Allow the software clock to be synchronized by an NTP
time server.
broadcast       Operate in broadcast mode.
unicast         Operate in unicast mode.

switch(config)# ntp server
IP-ADDR         IPv4 address of the NTP server. 
IPV6-ADDR       IPv6 address of the NTP server.

switch(config)# ntp server <IP-ADDR>
Key             Specify the authentication key.
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switch(config)# ntp server <IP-ADDR> key key-id
Max-poll        Configure the maximum time intervals in seconds.

switch(config)# ntp server <IP-ADDR> key key-id max-poll
<4-17>          Enter an integer number.

Switch(config)# ntp server <IP-ADDR> key key-id
Min-poll        Configure the minimum time intervals in seconds.

switch(config)# ntp server <IP-ADDR> key key-id min-poll
<4-17>          Enter an integer number.

switch(config)# ntp server <IP-ADDR> key key-id prefer max-poll 
<max-poll-val> min-poll <min-poll-val>
iburst          Enable initial burst (iburst) mode.
burst           Enable burst mode.

Switch(config)# ntp server IP-ADDR key key-id prefer maxpoll <number>
minpoll <number> iburst
Restrictions

Validation Error/Warning/Prompt

If authentication key-id not configured Authentication key-id has not been
configured.

If Key-id is not marked as trusted Key-id is not trusted.

When min poll value is more than max poll value NTP max poll value should be more than
min poll value.

ntp server key-id
Syntax
ntp server <IP-ADDR |IPV6-ADDR> 
key—id <key-id> [max-poll 
<max-poll-val>] [min-poll 
<min-poll-val>] [burst | iburst]
      
Description

Configure the NTP server. <IP-ADDR> indicates the IPv4 address of the NTP server. <IPV6-ADDR> indicates the
IPv6 address of the NTP server.

Options

burst

Enables burst mode.

iburst

Enables initial burst (iburst) mode.
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key-id

Set the authentication key to use for this server.

max-poll <max-poll-val>

Configure the maximum time intervals in seconds.

min-poll <min-poll-val>

Configure the minimum time intervals in seconds.

ntp ipv6-multicast
This command is used to configure NTP multicast on a VLAN interface.

Syntax
ntp ipv6-multicast
Description

Configure the interface to listen to the NTP multicast packets.

Example
Switch(vlan-2)# ntp
ipv6-multicast       Configure the interface to listen to the NTP multicast packets.
Restrictions

Validation Error/Warning/Prompt

If ipv6 is not enabled on vlan interface IPv6 address not configured on the
VLAN.

debug ntp
This command is used to display debug messages for NTP.

Syntax
debug ntp <event | 
packet>
      
Options
event
Displays event log messages related to NTP.

packets
Displays NTP packet messages.

Description

Enable debug logging. Use [no] to disable debug logging.

Example
Switch(config)# debug ntp
event                 Display event log messages related to NTP.
packet                Display NTP packet messages.

ntp trap
This command is used to configure NTP traps.
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Syntax
ntp trap <trap-name>
      
Description

Enable NTP traps. Use [no] to disable NTP traps.

Options

ntp-mode-change

Trap name resulting in send notification when the NTP entity changes mode, including
starting and stopping (if possible).

ntp-stratum-change

Trap name resulting in send notification when stratum level of NTP changes.

ntp-peer-change

Trap name resulting in send notification when a (new) syspeer has been selected.

ntp-new-association

Trap name resulting in send notification when a new association is mobilized.

ntp-remove-association

Trap name resulting in send notification when an association is demobilized.

ntp-config-change

Trap name resulting in send notification when the NTP configuration has changed.

ntp-leapsec-announced

Trap name resulting in send notification when a leap second has been announced.

ntp-alive-heartbeat

Trap name resulting in send notification periodically (as defined by
ntpEntHeartbeatInterval) to indicate that the NTP entity is still alive.

all

Enable all traps.

Usage

The traps defined below are generated as the result of finding an unusual condition while parsing an NTP packet
or a processing a timer event. Note that if more than one type of unusual condition is encountered while parsing
the packet or processing an event, only the first one will generate a trap. Possible trap names are:

- 'ntpEntNotifModeChange' The notification to be sent when the NTP entity changes
mode, including starting and stopping (if possible).
- 'ntpEntNotifStratumChange' The notification to be sent when stratum level of NTP
changes.
- 'ntpEntNotifSyspeerChanged' The notification to be sent when a (new) syspeer has
been selected.
- 'ntpEntNotifAddAssociation' The notification to be sent when a new association is
mobilized.
- 'ntpEntNotifRemoveAssociation' The notification to be sent when an association is
demobilized.
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- 'ntpEntNotifConfigChanged' The notification to be sent when the NTP configuration
has changed.
- 'ntpEntNotifLeapSecondAnnounced' The notification to be sent when a leap second
has been announced.
- 'ntpEntNotifHeartbeat' The notification to be sent periodically (as defined by
ntpEntHeartbeatInterval) to indicate that the NTP entity is still alive.
- 'ntpEntNotifAll' The notification to be sent when all traps have been enabled

show ntp statistics
This command is used to show NTP statistics.

Syntax
show ntp statistics
Description

Show information about NTP packets.

Examples
Switch(config)# show ntp statistics

NTP Global statistics information

NTP In Packets                : 100
NTP Out Packets               : 110
NTP Bad Version Packets       : 4
NTP Protocol Error Packets    : 0

switch(config)# show ntp statistics

NTP Global statistics information

NTP In Packets             : 100
NTP Out Packets            : 110
NTP Bad Version Packets    : 4    
NTP Protocol Error Packets : 0

show ntp status
Syntax

Description

Show the status of NTP.

show ntp status
Example
Switch(config)# show ntp status

NTP Status information
NTP Status             : Disabled             NTP Mode        : Broadcast
Synchronization Status : Synchronized         Peer Dispersion : 8.01 sec
Stratum Number         : 2                    Leap Direction  : 1
Reference Assoc Id     : 1                    Clock Offset    : 0.0000 sec
Reference              : 192.0.2.1            Root Delay      : 0.00 sec
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Precision              : 2**7                 Root Dispersion : 15.91 sec
NTP Uptime             : 01d 09h 15m          Time Resolution : 1
Drift                  : 0.000000000 sec/sec

System Time            : Tue Aug 25 04:59:11 2015
Reference Time         : Mon Jan  1 00:00:00 1990

show ntp associations
Syntax
show ntp associations [detail 
<IP-ADDR>]
      
Description

Show the status of configured NTP associations.

Options

detail

Show the detailed status of NTP associations configured for the system.

Switch(config)# show ntp associations

                    NTP Associations Entries

Address          St   T  When Poll  Reach   Delay    Offset   Dispersion   
--------------   ---  -- ---- ----- ------ -------   -------  ----------
121.0.23.1       16   u   -  1024    0     0.000     0.000     0.000
231.45.21.4      16   u   -  1024    0     0.000     0.000     0.000
55.21.56.2       16   u   -  1024    0     0.000     0.000     0.000
23.56.13.1        3   u 209  1024  377     54.936   -6.159     12.688
91.34.255.216     4   u 132  1024  377     1.391     0.978     3.860

Switch(config)# show ntp associations detail <IP ADDR>

NTP association information

IP address       : 172.31.32.2                  Peer Mode       : Server  
Status           : Configured, Insane, Invalid  Peer Poll Intvl : 64 
Stratum          : 5                            Root Delay      : 137.77 sec
Ref Assoc ID     : 0                            Root Dispersion : 142.75
Association Name : NTP Association 0            Reach           : 376
Reference ID     : 16.93.49.4                   Delay           : 4.23 sec
Our Mode         : Client                       Offset          : -8.587 sec 
Our Poll Intvl   : 1024                         Precision       : 2**19  

Dispersion       : 1.62 sec
Association In Packets    : 60
Association Out Packets   : 60
Association Error Packets : 0
Origin Time      : Fri Jul 3 11:39:40 2015
Receive Time     : Fri Jul 3 11:39:44 2015
Transmit Time    : Fri Jul 3 11:39:44 2015

-----------------------------------------------------------------------------
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Filter Delay =   4.23    4.14    2.41    5.95    2.37    2.33    4.26    4.33
Filter Offset = -8.59   -8.82   -9.91   -8.42  -10.51  -10.77  -10.13  -10.11

show ntp authentication
Syntax

Description

Show the authentication status and other information about the authentication key.

show ntp authentication

Switch(config)# show ntp authentication

NTP Authentication Information

Key-ID     Auth Mode   Trusted
--------   ----------  -------
67            md5        yes 
7             md5        no  
1             sha1       yes 
2             sha1       no

Validation rules

Validation Error/Warning/Prompt

If access-list name is not valid. Please enter a valid access-list name.

If the authentication method is being set to
two-factor authentication, various messages
display.

If both the public key and username/password are not
configured: Public key and username/password should
be configured for a successful two-factor
authentication.

If public key is configured and username is not
configured:

Username and password should be configured for a
successful two-factor authentication.

If the username is configured and public key is not
configured:

Public key should be configured for a successful two-
factor authentication.

If “ssh-server” certificate is not installed at the time of
enabling certificate-password authentication:

The “ssh-server” certificate should be installed for a
successful two-factor authentication.

If the authentication method is set to two-
factor while installing the public key, a
message displays.

The client public keys without username will not be
considered for the two-factor authentication for the SSH
session.
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Validation Error/Warning/Prompt

If the username and the key installation user
for that privilege do not match, a message
displays and installation is not allowed.

This will also happen when the
authentication method is set for two-factor.

The username in the key being installed does not
match the username configured on the switch.

If the maximum number of <username : TA
profile> associations is reached for a given
TA profile, a message displays.

Maximum number of username associations with a TA
profile is 10.

If secondary authentication type for two-
factor authentication chosen is not "none", a
message displays.

Not legal combination of authentication methods.

If the authentication method is anything other
than two-factor and the two-factor
authentication method options are set, a
message displays.

Not legal combination of authentication methods.

If two-factor authentication is set and user
tries to SSH into another system using ssh
<ip | hostname> command, a message
displays.

SSH client is not supported when the two-factor
authentication is enabled.

If timeSync is in SNTP or Timep when NTP
is enabled.

Timesync is not configured to NTP.

If timesync is NTP and NTP is enabled and
we try to change timesync to SNTP.

Disable NTP before changing timesync to SNTP or
TIMEP.

If we try to configure NTP servers more than
the configured max-associations value.

The maximum number of NTP servers allowed is 2.

If we have ‘n’ NTP servers configured and
we try to configure a max-associations value
less than (n) number of NTP servers already
configured.

Max-associations value cannot be less than the
number of NTP servers configured.

If authentication key-id is not configured. Authentication key-id %d has not been configured.

If key-id is not marked as trusted. Key-id %d is not trusted.

If min poll value is more than max poll value. NTP max poll value should be more than min poll
value.

If ipv6 is not enabled on vlan interface. IPv6 address not configured on the VLAN.
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Event log messages

Cause

Event Message

RMON_AUTH_TWO_FACTOR_AUTHEN_STATUS W 01/01/15 18:24:03 03397: auth: %s.

Examples:

W 01/01/15 18:24:03 03397: auth: Public key and
username/password should be configured for the
successful two-factor authentication.

W 01/01/15 18:24:03 03397: auth: Username and
password should be configured for the successful
two-factor authentication.

W 01/01/15 18:24:03 03397: auth: Public key should
be configured for the successful two-factor
authentication.

I 01/01/15 18:24:03 03397: auth: The validation of
certificate of SSH user ‘user1’ is successful.

RMON_SSH_KEY_TWO_FACTOR_EN W 01/01/15 18:24:03 03399: ssh: %s.

Examples:

W 01/01/15 18:24:03 03399: ssh: The client public
keys without username will not be considered for the
two-factor authentication for SSH session.

W 01/01/15 18:24:03 03399: ssh: The privilege level
for the user with the SSH key conflicts with the user
configured.

RMON_SSH_TWO_FACTOR_AUTH_FAIL W 01/01/15 18:24:03 03398: ssh: %s.

Examples:

W 01/01/15 18:24:03 03398: ssh: The two-factor
authentication for SSH session failed due to the
failure in public key authentication.

W 01/01/15 18:24:03 03398: ssh: The two-factor
authentication for SSH session failed due to the
failure in username/password authentication.

W 01/01/15 18:24:03 03398: ssh: The two-factor
authentication for SSH session failed due to the
failure in validating the client certificate.

W 01/01/15 18:24:03 03398: ssh: The two-factor
authentication for SSH session failed as “ssh-server”
certificate is not installed.

When NTP client enabled. NTP client is enabled.

When NTP client disabled. NTP client is disabled.
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Event Message

When NTP found a new broadcast server. A new broadcast server at %s.

When system clock was updated with new time. The system clock time was changed by %ld sec %lu
nsec. The new time is %s.

When NTP stratum was updated. The NTP Stratum was changed from %d to %d.

When all NTP associations are cleared. All the NTP server associations are reset.

When server is not reachable. The NTP Server 10.1.1.2 is unreachable. (2 times in
60 seconds)

When MD5/SHA1 authentication failed. The MD5 authentication on the NTP packet failed.

The SHA1 authentication on the NTP packet failed.

Precision Time Protocol (PTP)

ptp
Syntax
ptp {enable | disable}

no ptp {enable | disable}

Description

Enable updating of IEEE 1588 PTP packets.

• The feature is disabled by default.

• The no form of this command is the same as ptp disable.

NOTE: This feature is available on the 2930M and only in standalone. It is disabled for stacks.

Command context
interface

Parameters
enable

When the ptp command is enabled, ports that support IEEE 1588 will operate in end-to-end transparent
mode and will update the correction field of forwarded PTP packets.

disable
When the ptp command is disabled, PTP packets are forwarded unchanged.

Restrictions

• IEEE 1588 end-to-end transparent mode cannot be enabled when there are flexible modules or transceiver
ports in the system that do not support IEEE 1588. If a user attempts this, an error message like the following
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displays: Port A1 does not support IEEE 1588 end-to-end transparent mode.Use the
command show ptp to identify the unsupported ports.

• IEEE 1588 end-to-end transparent mode cannot be enabled on a stack. If the user attempts this, an error
message like the following displays: IEEE 1588 end-to-end transparent mode cannot be
enabled when stacking is enabled.

• IEEE 1588 end-to-end transparent mode must be enabled or disabled on all ports at the same time.

• MACsec cannot be enabled when IEEE 1588 end-to-end transparent mode is enabled.

• IEEE 1588 end-to-end transparent mode cannot be enabled when MACsec is enabled.

show ptp
Syntax
show ptp [<port-list>]

Description

Show IEEE 1588 PTP status.

Command context

Operator

Parameters
port-list

Specifies the ports for which to show PTP status.

Example

switch# show ptp
 Status and Counters - Precision Time Protocol

  Port  | PTP Config PTP Status   RX Count TX Count
  ----- + ---------- ------------ -------- --------
  1/1   | Disabled   Inactive     0        0       
  1/2   | Disabled   Inactive     0        0    
  1/3   | Disabled   Inactive     0        0       
  1/4   | Disabled   Inactive     0        0       
  1/5   | Disabled   Inactive     0        0       
  1/6   | Disabled   Inactive     0        0       
  1/7   | Disabled   Inactive     0        0       
  1/8   | Disabled   Inactive     0        0       
  1/9   | Disabled   Inactive     0        0       
  1/10  | Disabled   Inactive     0        0       
  1/11  | Disabled   Inactive     0        0       
  1/12  | Disabled   Inactive     0        0       
  1/13  | Disabled   Inactive     0        0       
  1/14  | Disabled   Inactive     0        0       
  1/15  | Disabled   Inactive     0        0       
  1/16  | Disabled   Inactive     0        0       
  1/17  | Disabled   Inactive     0        0       
  1/18  | Disabled   Inactive     0        0       

Monitoring resources
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Displaying current resource usage
To display current resource usage in the switch, enter the following command:

Syntax:

show {<qos | access-list | policy> resources}
Displays the resource usage of the policy enforcement engine on the switch by software feature. For each type of
resource, the amount still available and the amount used by each software feature is shown.

show resources This output allows you to view current resource usage and, if
necessary, prioritize and reconfigure software features to free
resources reserved for less important features.

qosaccess-listopenflowpolicy Display the same command output and provide different ways to
access task-specific information.

See “Viewing OpenFlow Resources” in the OpenFlow
administrators guide for your switch.

Displaying current resource usage shows the resource usage on a switch configured for ACLs, QoS, RADIUS-
based authentication, and other features:

The "Rules Used" columns show that ACLs, VT, mirroring, and other features (For example, Management VLAN)
have been configured globally or per-VLAN, because identical resource consumption is displayed for each port
range in the switch. If ACLs were configured per-port, the number of rules used in each port range would be
different.

Displaying current resource usage

switch(config)# show access-list resources

 Resource usage in Policy Enforcement Engine

        | Rules       | Rules Used
  Ports | Available   | ACL | QoS | IDM | Other |
  ------+-------------+-----+-----+-----+-------|
  1-48  |        2006 |  10 |   5 |   0 |    6  |

        | Meters      | Meters Used
  Ports | Available   | ACL | QoS | IDM | Other |
  ------+-------------+-----+-----+-----+-------|
  1-48  |         255 |     |   5 |     |     0 |

        | Application |
        | Port Ranges |  Application Port Ranges Used
  Ports |  Available  | ACL | QoS | IDM | Other |
  ------+-------------+-----+-----+-----+-------|
  1-48  |          31 |   1 |   0 |   0 |     0 |

2 of 16 Policy Engine management resources used.

Key:
ACL = Access Control Lists
QoS = Device & Application Port Priority
IDM = Identity Driven Management
Other = Management VLAN, DHCP Snooping, ARP Protection, RA Guard.
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Resource usage includes resources actually in use, or reserved for future
use by the listed feature. Internal dedicated-purpose resources, such as
port bandwidth limits or VLAN QoS priority, are not included.

Viewing information on resource usage
The switch allows you to view information about the current usage and availability of resources in the Policy
Enforcement engine, including the following software features:

• Access control lists (ACL)

• Quality-of-service (QoS), including device and application port priority, ICMP rate-limiting, and QoS policies

• Dynamic assignment of per-port or per-user ACLs and QoS through RADIUS authentication designated as
“IDM”.

• Virus throttling (VT) using connection-rate filtering

• Mirroring policies, including switch configuration as an endpoint for remote intelligent mirroring

• Other features, including:
◦ Management VLAN

◦ DHCP snooping

◦ Dynamic ARP protection

◦ Jumbo IP-MTU

Policy enforcement engine
The policy enforcement engine is thehardware element in the switch that manages QoS, mirroring, and ACL
policies, as well as other software features, using the rules that you configure. Resource usage in the policy
enforcement engine is based on how these features are configured on the switch:

• Resource usage by dynamic port ACLs is determined as follows:
Dynamic port ACLs configured by a RADIUS server for an authenticated client determine the current resource
consumption for this feature on a specified slot. When a client session ends, the resources in use for that client
become available for other uses.

• When the following features are configured globally or per-VLAN, resource usage is applied across all port
groups or all slots with installed modules:
◦ ACLs

◦ QoS configurations that use the following commands:
– QoS device priority (IP address) through the CLI using the qos device-priority command

– QoS application port through the CLI using qos tcp-port or qos udp-port
– VLAN QoS policies through the CLI using service-policy

◦ Management VLAN configuration

◦ DHCP snooping

◦ Dynamic ARP protection

◦ Remote mirroring endpoint configuration
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◦ Mirror policies per VLAN through the CLI using monitor service
◦ Jumbo IP-MTU

• When the following features are configured per-port, resource usage is applied only to the slot or port group on
which the feature is configured:
◦ ACLs or QoS applied per-port or per-user through RADIUS authentication

◦ ACLs applied per-port through the CLI using the ip access-group or ipv6 traffic-filter
commands

◦ QoS policies applied per port through the CLI using the service-policy command

◦ Mirror policies applied per-port through the CLI using the monitor all service and service-
policycommands

◦ ICMP rate-limiting through the CLI using the rate-limit icmp command

Usage notes for show resources output
• A 1:1 mapping of internal rules to configured policies in the switch does not necessarily exist. As a result,

displaying current resource usage is the most reliable method for keeping track of available resources. Also,
because some internal resources are used by multiple features, deleting a feature configuration may not
increase the amount of available resources.

• Resource usage includes resources actually in use or reserved for future use by the listed features.

• "Internal dedicated-purpose resources" include the following features:
◦ Per-port ingress and egress rate limiting through the CLI using rate-limit in/out
◦ Per-port or per-VLAN priority or DSCP through the CLI using qos priority or qos dscp
◦ Per protocol priority through the CLI using qos protocol

• The "Available" columns display the resources available for additional feature use.

• The "IDM" column shows the resources used for RADIUS-based authentication.

• "Meters" are used when applying either ICMP rate-limiting or a QoS policy with a rate-limit class action.

When insufficient resources are available
The switch has ample resources for configuring features and supporting RADIUS-authenticated clients (with or
without the optional IDMapplication).

If the resources supporting these features become fully subscribed:

• The current feature configuration, RADIUS-authenticated client sessions, and VT instances continue to
operate normally.

• The switch generates anevent log notice to say that current resources are fully subscribed.

• Currently engaged resources must be released before any of the following actions are supported:
◦ Modifying currently configured ACLs, IDM, VT, and other software features, such as Management VLAN,

DHCP snooping, and dynamic ARP protection.You can modify currently configured classifier-base QoS and
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mirroring policies if a policy has not been applied to an interface. However, sufficient resources must be
available when you apply a configured policy to an interface.

◦ Acceptance of new RADIUS-based client authentication requests (displayed as a new resource entry for
IDM).Failure to authenticate a client that presents valid credentials may indicate that insufficient resources
are available for the features configured for the client in the RADIUS server. To troubleshoot, check the
event log.

◦ Throttling or blocking of newly detected clients with high rate-of-connection requests (as defined by the
current VT configuration).The switch continues to generate Event Log notifications (and SNMP trap
notification, if configured) for new instances of high-connection-rate behavior detected by the VT feature.
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Viewing port status and configuring port parameters

Connecting transceivers to fixed-configuration devices
If the switch either fails to show a link between an installed transceiver and another device or demonstrates errors
or other unexpected behavior on the link, check the port configuration on both devices for a speed and/or duplex
(mode) mismatch.

• To check the mode setting for a port on the switch, use either the Port Status screen in the menu interface or
show interfaces brief in the CLI (see Viewing port status and configuration (CLI)).

• To display information about the transceivers installed on a switch, enter the show tech receivers
command in the CLI (The show tech transceivers command on page 76).

Table 3: Status and parameters for each port type

Status or
parameter

Description

Enabled Yes (default): The port is ready for a network connection.

No: The port will not operate, even if properly connected in a network. Use this setting, For
example, if the port needs to be shut down for diagnostic purposes or while you are making
topology changes.

Status (read-only) Up: The port senses a link beat.

Down: The port is not enabled, has no cables connected, or is experiencing a network error.
For troubleshooting information, see the installation and getting started guide you received
with the switch. See also to Appendix C, "Troubleshooting" (in this manual).

Table Continued

Chapter 3
Port Status and Configuration
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Status or
parameter

Description

Mode The port's speed and duplex (data transfer operation) setting.10/100/1000Base-T
Ports:
• Auto-MDIX (default): Senses speed and negotiates with the port at the other end of the

link for port operation (MDI-X or MDI).To see what the switch negotiates for the auto
setting, use the CLI show interfaces brief command.

• MDI: Sets the port to connect with a PC using a crossover cable (manual mode—applies
only to copper port switches using twisted-pair copper Ethernet cables)

• MDIX: Sets the port to connect with a PC using a straight-through cable (manual mode—
applies only to copper port switches using twisted-pair copper Ethernet cables)

• Auto-10: Allows the port to negotiate between half-duplex (HDx) and full-duplex (FDx)
while keeping speed at 10 Mbps. Also negotiates flow control (enabled or disabled).
Hewlett Packard Enterprise recommends auto-10 for links between 10/100 auto-sensing
ports connected with Cat 3 cabling. (Cat 5 cabling is required for 100 Mbps links.).

• 10HDx:10 Mbps, half-duplex

• 10FDx: 10 Mbps, full-duplex

• Auto-100: Uses 100 Mbps and negotiates with the port at the other end of the link for
other port operation features.

• Auto-10-100: Allows the port to establish a link with the port at the other end at either
10 Mbps or 100 Mbps, using the highest mutual speed and duplex mode available. Only
these speeds are allowed with this setting.

• Auto-1000: Uses 1000 Mbps and negotiates with the port at the other end of the link for
other port operation features.

• 100Hdx: Uses 100 Mbps, half-duplex.

• 100Fdx: Uses 100 Mbps, full-duplex

Gigabit Fiber-Optic Ports (Gigabit-SX, Gigabit-LX, and Gigabit-LH):

• 1000FDx: 1000 Mbps (1 Gbps), full-duplex only

• Auto (default): The port operates at 1000FDx and auto-negotiates flow control with the
device connected to the port.

Gigabit Copper Ports:

• 1000FDx: 1000 Mbps (1 Gbps), full-duplex only

• Auto (default): The port operates at 1000FDx and auto-negotiates flow control with the
device connected to the port.
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Status or
parameter

Description

10-Gigabit CX4 Copper Ports: 10-Gigabit SC Fiber-Optic Ports (10-GbE SR, 10-GbE
LR, 10-GbE ER):

Auto: The port operates at 10 gigabits FDx and negotiates flow control. Lower speed
settings or half-duplex are not allowed.

NOTE: Conditioning patch cord cables are not supported on 10-GbE.

Auto-MDIX The switch supports Auto-MDIX on 10Mb, 100Mb, and 1 Gb T/TX (copper) ports. (Fiber
ports and 10-gigabit ports do not use this feature.)

• Automdix: Configures the port for automatic detection of the cable type (straight-
through or crossover).

• MDI: Configures the port to connect to a switch, hub, or other MDI-X device with a
straight-through cable.

• MDIX: Configures the port to connect to a PC or other MDI device with a straight-through
cable.

Flow control
• Disabled (default): The port does not generate flow control packets, and drops any flow

control packets it receives.

• Enabled: The port uses 802.3x link layer flow control, generates flow-control packets,
and processes received flow-control packets.

With the port mode set to Auto (the default) and flow control enabled, the switch negotiates
flow control on the indicated port. If the port mode is not set to Auto, or if flow control is
disabled on the port, flow control is not used. Note that flow control must be enabled on both
ends of a link.

Broadcast limit Specifies the percentage of the theoretical maximum network bandwidth that can be used
for broadcast traffic. Any broadcast traffic exceeding that limit will be dropped. Zero (0)
means the feature is disabled.

The broadcast-limit command operates at the port context level to set the broadcast limit for
a port on the switch.

NOTE: This feature is not appropriate for networks that require high levels of
IPX or RIP broadcast traffic.

Viewing port status and configuration (CLI)
Use the following commands to display port status and configuration data.

Syntax:

show interfaces [brief | config | < port-list >]
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brief
Lists the current operating status for all ports on the switch.

config
Lists a subset of configuration data for all ports on the switch; that is, for each port, the display shows whether
the port is enabled, the operating mode, and whether it is configured for flow control.

<port-list>
Shows a summary of network traffic handled by the specified ports.

The show interfaces brief command listing

switch(config)# show interfaces brief
Status and Counters - Port Status

                | Intrusion                            MDI   Flow  Bcast
Port  Type      | Alert     Enabled Status Mode        Mode  Ctrl  Limit
----- --------- + --------- ------- ------ ----------  ----- ----- ------
B1    100/1000T | No        Yes     Down   Auto-10-100 Auto  off   0
B2    100/1000T | No        Yes     Down   1000FDx     Auto  off   0
B3    100/1000T | No        Yes     Down   1000FDx     Auto  off   0
B4    100/1000T | No        Yes     Down   1000FDx     Auto  off   0
B5    100/1000T | No        Yes     Down   1000FDx     Auto  off   0
B6    100/1000T | No        Yes     Down   1000FDx     Auto  off   0

The show interfaces config command listing

switch(config)# show interfaces config

 Port Settings

  Port  Type      | Enabled Mode         Flow Ctrl MDI
  ----- --------- + ------- ------------ --------- ----
  B1    100/1000T | Yes     Auto-10-100  Disable   Auto
  B2    100/1000T | Yes     Auto         Disable   Auto
  B3    100/1000T | Yes     Auto         Disable   Auto
  B4    100/1000T | Yes     Auto         Disable   Auto
  B5    100/1000T | Yes     Auto         Disable   Auto
  B6    100/1000T | Yes     Auto         Disable   Auto

Dynamically updating the show interfaces command (CLI/Menu)
Syntax:

show interfaces display
Uses the display option to initiate the dynamic update of the show interfaces command, with the output
being the same as the show interfaces command.

NOTE: Select Back to exit the display.

Example:

switch# show interfaces display
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When using the display option in the CLI, the information stays on the screen and is updated every 3 seconds, as
occurs with the display using the menu feature. The update is terminated with Cntl-C.

You can use the arrow keys to scroll through the screen when the output does not fit in one screen.

Figure 3: show interfaces display command with dynamically updating output

Customizing the show interfaces command (CLI)
You can create show commands displaying the information that you want to see in any order you want by using
the custom option.

Syntax:
show interfaces custom [port-list] column-list
Select the information that you want to display. Supported columns are shown in the table below.

Table 4: Supported columns, what they display, and examples:

Parameter column Displays Examples

port Port identifier A2

type Port type 100/1000T

status Port status up or down

speed Connection speed and duplex 1000FDX

mode Configured mode auto, auto-100, 100FDX

mdi MDI mode auto, MDIX

flow Flow control on or off

Table Continued
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Parameter column Displays Examples

name Friendly port name

vlanid The vlan id this port belongs to, or "tagged" if it
belongs to more than one vlan

4tagged

enabled port is or is not enabled yes or nointrusion

intrusion Intrusion alert status no

bcast Broadcast limit 0

The custom show interfaces command

switch(config)# show int custom 1-4 port name:4 type vlan intrusion speed enabled mdi

 Status and Counters - Custom Port Status

                                   Intrusion
  Port Name       Type       VLAN  Alert     Speed   Enabled MDI-mode
  ---- ---------- ---------- ----- --------- ------- ------- --------
  1    Acco       100/1000T  1     No        1000FDx Yes     Auto
  2    Huma       100/1000T  1     No        1000FDx Yes     Auto
  3    Deve       100/1000T  1     No        1000FDx Yes     Auto
  4    Lab1       100/1000T  1     No        1000FDx Yes     Auto
You can specify the column width by entering a colon after the column name, then indicating the number of
characters to display. In the above example, the Name column displays only the first four characters of the name.
All remaining characters are truncated.

NOTE: Each field has a fixed minimum width to be displayed. If you specify a field width smaller than
the minimum width, the information is displayed at the minimum width. For example, if the minimum
width for the Name field is 4 characters and you specify Name:2, the Name field displays 4
characters.

You can enter parameters in any order. There is a limit of 80 characters per line; if you exceed this limit an error
displays.

Error messages associated with the show interfaces command
The following table provides information on error messages associated with the show interfaces custom
command.

Error Error message

Requesting too many fields (total characters exceeds
80)

Total length of selected data exceeds one line

Field name is misspelled Invalid input: <input>

Mistake in specifying the port list Module not present for port or invalid port: <input>

The port list is not specified Incomplete input: custom
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Note on using pattern matching with the show interfaces custom command
If you have included a pattern matching command to search for a field in the output of the show int custom
command, and the show int custom command produces an error, the error message may not be visible and
the output is empty. For example, if you enter a command that produces an error (such as vlan is misspelled) with
the pattern matching include option, the output may be empty:

Switch(config)# show int custom 1-3 name vlun  |  include vlan1
It is advisable to try the show int custom command first to ensure there is output, and then enter the
command again with the pattern matching option.

Note that in the above command, you can substitute int for interface; that is: show int custom.

show interface smartrate
Syntax
show interface <PORT-LIST> smartrate
      
Description

The option smartrate has been added to the show interface <PORT-LIST> command. This option is used
to display port diagnostics on a Smart Rate port only. If the command is run on a non‐Smart Rate port, a
message similar to Port A1: This command is only applicable to Smart Rate ports is
displayed.

The show interface <PORT-LIST> smartrate command can be used to retrieve the physical layer link
diagnostics information for the smartrate ports. As part of 802.3bz implementation, the CLI information has been
updated with the latest BASE-T modes.

Viewing port utilization statistics (CLI)
Use the show interface port-utilization command to view a real-time rate display for all ports on the
switch. The example below shows a sample output from this command.

A show interface port-utilization command listing

switch(config)# show interfaces port-utilization
 Status and Counters - Port Utilization

                             Rx                            Tx
 Port  Mode     | -------------------------- | --------------------------
                | Kbits/sec  Pkts/sec  Util  | Kbits/sec  Pkts/sec  Util
 ----- -------- + ---------- --------- ----- + ---------- --------- -----
 B1    1000FDx  | 0          0         0     | 0          0         0 
 B2    1000FDx  | 0          0         0     | 0          0         0 
 B3    1000FDx  | 0          0         0     | 0          0         0 
 B4    1000FDx  | 0          0         0     | 0          0         0 
 B5    1000FDx  | 0          0         0     | 0          0         0 
 B6    1000FDx  | 0          0         0     | 0          0         0 
 B7     100FDx  | 624        86        00.62 | 496        0         00.49 
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Operating notes for viewing port utilization statistics
• For each port on the switch, the command provides a real-time display of the rate at which data is received

(Rx) and transmitted (Tx) in terms of kilobits per second (KBits/s), number of packets per second (Pkts/s), and
utilization (Util) expressed as a percentage of the total bandwidth available.

• The show interfaces <port-list> command can be used to display the current link status and the port
rate average over a 5 minute period. Port rates are shown in bits per second (bps) for ports up to 1 Gigabit; for
10 Gigabit ports, port rates are shown in kilobits per second (Kbps).

Viewing transceiver status (CLI)
The show interfaces transceivers command allows you to:

• Remotely identify transceiver type and revision number without having to physically remove an installed
transceiver from its slot.

• Display real-timestatus information about all installed transceivers, including non-operational transceivers.

The example shows sample output from the show tech transceivers command.

NOTE: Part # column below enables you to determine the manufacturer for a specified transceiver
and revision number.

The show tech transceivers command

switch# show tech transceivers

Transceiver Technical Information:
 Port # |   Type    | Prod # | Serial #         | Part #
 -------+-----------+--------+------------------+----------
 21     | 1000SX    | J4858B | CN605MP23K       |
 22     | 1000LX    | J4859C | H11E7X           | 2157-2345
 23     | ??        | ??     | non operational  | 
 25     | 10GbE-CX4 | J8440A | US509RU079       | 
 26     | 10GbE-CX4 | J8440A | US540RU002       | 
 27     | 10GbE-LR  | J8437B | PPA02-2904:0017  | 2157-2345
 28     | 10GbE-SR  | J8436B | 01591602         | 2158-1000
 29     | 10GbE-ER  | J8438A | PPA03-2905:0001  | 

The following transceivers may not function correctly:
 Port #         Message
 --------       ------------------------
 Port 23        Self test failure.

Operating Notes
The following information is displayed for each installed transceiver:

• Port number on which transceiver is installed.

• Type of transceiver.

• Product number — Includes revision letter, such as A, B, or C. If no revision letter follows a product number,
this means that no revision is available for the transceiver.

• Part number — Allows you to determine the manufacturer for a specified transceiver and revision number.
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• For a non-Aruba switches installed transceiver, no transceiver type, product number, or part information is
displayed. In the Serial Number field, non-operational is displayed instead of a serial number.

• The following error messages may be displayed for a non-operational transceiver:

◦ Unsupported Transceiver. (SelfTest Err#060)
◦ This switch only supports revision B and above transceivers.
◦ Self test failure.
◦ Transceiver type not supported in this port.
◦ Transceiver type not supported in this software version.
◦ Not an Switch Transceiver.

Enabling or disabling ports and configuring port mode (CLI)
You can configure one or more of the following port parameters.

See Status and parameters for each port type.

Syntax:

[no] interface <port-list> [<disable|enable>]
Disables or enables the port for network traffic. Does not use the no form of the command. (Default: enable.)

speed-duplex [<auto-10|10-full|10-half|100-full|100-half|auto|auto-100|1000-full>]
Note that in the above Syntax:, you can substitute int for interface (for example, int <port-list> ).

Specifies the port's data transfer speed and mode. Does not use the no form of the command. (Default: auto.)

The 10/100 auto-negotiation feature allows a port to establish a link with a port at the other end at either 10 Mbps
or 100 Mbps, using the highest mutual speed and duplex mode available. Only these speeds are allowed with this
setting.

Examples:

To configure port C5 for auto-10-100, enter this command:

switch(config)# int c5 speed-duplex auto-10-100
To configure ports C1 through C3 and port C6 for 100Mbps full-duplex, enter these commands:

switch(config)# int c1-c3,c6 speed-duplex 100-full
Similarly, to configure a single port with the above command settings, you could either enter the same command
with only the one port identified or go to the context level for that port and then enter the command. For example,
to enter the context level for port C6 and then configure that port for 100FDx:

switch(config)# int e c6
switch(eth-C6)# speed-duplex 100-full
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If port C8 was disabled, and you wanted to enable it and configure it for 100FDx with flow-control active, you
could do so with either of the following command sets:

Figure 4: Two methods for changing a port configuration

For more on flow control, see Enabling or disabling flow control (CLI) on page 78.

Enabling or disabling flow control (CLI)

NOTE: You must enable flow control on both ports in a given link. Otherwise, flow control does not
operate on the link and appears as Off in the show interfaces brief port listing, even if flow
control is configured as enabled on the port in the switch. (See The show interfaces brief
command listing example.) Also, the port (speed-duplex) mode must be set to Auto (the default).

To disable flow control on some ports, while leaving it enabled on other ports, just disable it on the individual ports
you want to exclude.

(You can find more information on flow control in the Status and parameters for each port type table.)

Syntax:

[no] interface <port-list> flow-control
Enables or disables flow control packets on the port. The no form of the command disables flow control on the
individual ports. (Default: Disabled.)

Examples:

Suppose that:

1. You want to enable flow control on ports A1-A6.

2. Later, you decide to disable flow control on ports A5 and A6.

3. As a final step, you want to disable flow control on all ports.
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Assuming that flow control is currently disabled on the switch, you would use these commands:

Figure 5: Configuring flow control for a series of ports

switch(config)# int a1-a6 flow-control

switch(config)# show interfaces brief

 Status and Counters - Port Status

                   | Intrusion                           MDI  Flow Bcast
  Port   Type      | Alert     Enabled Status Mode       Mode Ctrl Limit
  ------ --------- + --------- ------- ------ ---------- ---- ---- ----- 
  A1     10GbE-T   | No        Yes     Up     1000FDx    NA   on   0
  A2     10GbE-T   | No        Yes     Up     10GigFD    NA   on   0
  A3     10GbE-T   | No        Yes     Up     10GigFD    NA   on   0
  A4     10GbE-T   | No        Yes     Up     10GigFD    NA   on   0
  A5     10GbE-T   | No        Yes     Up     10GigFD    NA   on   0
  A6     10GbE-T   | No        Yes     Up     10GigFD    NA   on   0
  A7     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A8     10GbE-T   | No        Yes     Up     10GigFD    NA   off  0

switch(config)# no int a5-a6 flow-control

switch(config)# show interfaces brief

 Status and Counters - Port Status

                   | Intrusion                           MDI  Flow Bcast
  Port   Type      | Alert     Enabled Status Mode       Mode Ctrl Limit
  ------ --------- + --------- ------- ------ ---------- ---- ---- ----- 
  A1     10GbE-T   | No        Yes     Up     1000FDx    NA   on   0
  A2     10GbE-T   | No        Yes     Down   10GigFD    NA   on   0
  A3     10GbE-T   | No        Yes     Down   10GigFD    NA   on   0
  A4     10GbE-T   | No        Yes     Down   10GigFD    NA   on   0
  A5     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A6     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A7     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A8     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0

switch(config)# no int a1-a4 flow-control

switch(config)# show interfaces brief

 Status and Counters - Port Status

                   | Intrusion                           MDI  Flow Bcast
  Port   Type      | Alert     Enabled Status Mode       Mode Ctrl Limit
  ------ --------- + --------- ------- ------ ---------- ---- ---- ----- 
  A1     10GbE-T   | No        Yes     Down   1000FDx    NA   off  0
  A2     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A3     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A4     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A5     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A6     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A7     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
  A8     10GbE-T   | No        Yes     Down   10GigFD    NA   off  0
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Port shutdown with broadcast storm
A LAN broadcast storm arises when an excessively high rate of broadcast packets flood the LAN. Occurrence of
LAN broadcast storm disrupts traffic and degrades network performance. To prevent LAN traffic from being
disrupted, an enhancement of fault-finder commands adds new options, and the corresponding MIBs, that trigger
a port disablement when a broadcast storm is detected on that port.

Under this enhancement, the CLI commands given only supports broadcast traffic and not multicast and unicast
types of traffic.

The waiting period range for re-enabling ports is 0 to 604800 seconds. The default waiting period to re-enable a
port is zero which prevents the port from automatic re-enabling.

NOTE: Avoid port flapping when choosing the waiting period by considering the time to re-enable
carefully.

Use the following commands to configure the broadcast-storm on a port.

Syntax:

[no] fault-finder broadcast-storm [ethernet] <port-list> action [warn|warn-and-disable <seconds>] [percent <percent>|pps <rate>]

To remove the current configuration of broadcast-storm on a port, use:

Syntax:

no fault-finder broadcast-storm [ethernet] <port-list>
broadcast-storm

Configure broadcast storm control.

pps
Rising threshold level in number of broadcast packets per second.

percent
Rising threshold level as a percentage of bandwidth of the port. The percentage is calculated on 64 byte
packet size.

warn
Log the event only.

warn-and-disable
Log the event and disable the port.

seconds
Re-enable the port after waiting for the specified number of seconds. Default is not to re-enable.

Configuration examples:
switch(config)# fault-finder broadcast-storm [ethernet] <A1> action [warn-and-disable <65535>]< percent 10>
switch(config)# fault-finder broadcast-storm [ethernet] <A2> action [warn-and-disable <pps 100>
switch(config)# fault-finder broadcast-storm [ethernet] <A22> action [warn] <pps 100>

Viewing broadcast storm
Use the following command to display the broadcast-storm-control configuration.
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Syntax:

show fault-finder broadcast-storm [[ethernet] port-list]
Examples:
switch# show fault-finder broadcast-storm [A1]

Port Bcast Storm Port Status Rising
Threshold

Action Disable
Timer

Disable
Timer Left

A1 Yes Down 10% warn-and-
disable

65535 —

switch (config)# show fault-finder broadcast-storm

Port Bcast Storm Port Status Rising
Threshold

Action Disable
Timer

Disable
Timer Left

A1 Yes Down 200 pps warn-and-
disable

10 9

switch (config)# show fault-finder broadcast-storm A1

Port Bcast Storm Port Status Rising
Threshold

Action Disable
Timer

Disable
Timer Left

A1 No Up — none — —

switch (config)# show fault-finder broadcast-storm

Port Bcast Storm Port Status Rising
Threshold

Action Disable
Timer

Disable
Timer Left

A1 Yes Up 75% warn — —

SNMP MIB
SNMP support will be provided through the following MIB objects:

hpicfFfBcastStormControlPortConfig OBJECT IDENTIFIER

:: = { hpicfFaultFinder 5 }

hpicfFfBcastStormControlPortConfigTable OBJECT-TYPE

• syntax sequence: HpicfFfBcastStormControlPortConfigEntry

• max-access: not-accessible

• status: current

• description: This table provides information about broadcast storm control configuration of all ports.::=
{hpicfFfBcastStormControlPortConfig 1}

hpicfFfBcastStormControlPortConfigEntry OBJECT-TYPE
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• syntax HpicfFfBcastStormControlPortConfigEntry

• max-access: not-accessible

• status: current

• description: This object provides information about broadcast storm control configuration of each port.

• index: {hpicfffbcaststormcontrolportindex}::= {hpicfFfBcastStormControlPortConfigTable 1}

hpicfFfBcastStormControlPortConfigEntry ::=

Syntax sequence:hpicfFfBcastStormControlPortIndex InterfaceIndex,

hpicfFfBcastStormControlMode Integer,

hpicfFfBcastStormControlRisingpercent Integer32,

hpicfFfBcastStormControlRisingpps Integer32,

hpicfFfBcastStormControlAction Integer,

hpicfFfBcastStormControlPortDisableTimer Unsigned32

hpicfFfBcastStormControlPortIndex OBJECT-TYPE

• Syntax: Interfaceindex

• max-access: not-accessible

• status: current

• description: The Index Value Which Uniquely Identifies A Row In The Interfaces Table.

::= {hpicfFfBcastStormControlPortConfigEntry 1}

hpicfFfBcastStormControlMode OBJECT-TYPE

• Syntax Integer: disabled(1), Bcastrisinglevelpercent(2), Bcastrisinglevelpps(3)

• max-access: read-write

• status: current

• description: The broadcast storm control mode of a port. A value of disable (1) indicates that no rising
threshold value is set for broadcast storm traffic on this port. A value of bcastrisinglevelpercent (2) indicates
that the rising threshold rate for broadcast storm traffic is configured in percentage of port bandwidth. A value
of bcastrisinglevelpps (3) indicates that the rising threshold rate for broadcast storm traffic is configured in
packets per second.

• DEFVAL: disabled

::= {hpicfFfBcastStormControlPortConfigEntry 2}

hpicfFfBcastStormControlRisingpercent OBJECT-TYPE

• Syntax Integer32 (1..100)

• max-access: read-write

• status: current

• description: This Is The Rising Threshold Level in percent of bandwidth of the port.
hpicfFfBcastStormControlAction occurs when broadcast traffic reaches this level.

::= {hpicfFfBcastStormControlPortConfigEntry 3}
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hpicfFfBcastStormControlRisingpps OBJECT-TYPE

• Syntax Integer32 (1..10000000)

• max-access: read-write

• status: current

• description: This object indicates the rising threshold for broadcast storm control. This value is in packets-per-
second of received broadcast traffic. hpicfffbcaststormcontrolaction object takes action when broadcast
traffic reaches this level.

::= {hpicfFfBcastStormControlPortConfigEntry 4}

hpicfFfBcastStormControlAction OBJECT-TYPE

• Syntax integer: none(1), warn(2), warnanddisable(3)

• max-access: read-write

• status: current

• Description: This object defines the action taken by the switch when a broadcast storm occurs on a port. A
value of none (1) indicates that no action is performed. A value of warn (2) indicates that an event is logged
when broadcast traffic crosses the threshold value set on that port. A value of warn-and-disable (3) indicates
that the port is disabled and an event is logged as soon as the broadcast traffic reaches the threshold value
set on that port.

• DEFVAL: none

::= {hpicfFfBcastStormControlPortConfigEntry 5}

hpicfFfBcastStormControlPortDisableTimer OBJECT-TYPE

• Syntax Unsigned32 (0..604800)

• Units: seconds

• max-access: read-write

• status: current

• Description: This object specifies the time period for which the port remains in disabled state. A port is disabled
when broadcast traffic reaches the threshold value set on that port. This time period is specified in seconds.
The default value is zero which means that the port remains disabled and is not enabled again.

• DEFVAL {0}

::= {hpicfFfBcastStormControlPortConfigEntry 6}

Multicast Storm Control

Overview
A multicast storm arises when excessive multicast traffic is exchanged on network ports. Excessive traffic
includes more than expected traffic, or which exceeds a limit value or some percentage of network traffic, or a
percentage of network channel capacity.

To prevent this, a warning message, along with port-shutdown option, is displayed to the user when the network
detects similar multicast packets. At this time, the user can disable the port temporarily and enable it again, or
permanently disable it.
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fault-finder multicast-storm

Syntax
fault-finder multicast-storm <PORT-LIST> action {warn | warn-and-disable <Seconds>} {percent <Percent> | pps <Rate>}
no fault-finder multicast-storm <PORT-LIST> action {warn | warn-and-disable <Seconds>} {percent <Percent> | pps <Rate>}

Description

Per-port command to configure multicast-storm. The no form of the command disables multicast-storm
configuration on the port.

Parameters

PORT-LIST

Enable multicast storm control on a list of ports.

Seconds

Configure the number of seconds for which the port remains disabled.

Percent

Rising threshold level as a percentage of bandwidth of the port. The percentage is calculated on 64 byte
packet size.

Rate

Rising threshold level in number of multicast packets per second

Command context
config

Examples

switch(config)# fault-finder multicast-storm
action                Configure the action taken when a fault is detected.
[ethernet] PORT-LIST  The ports on which to enable Multicast Storm Control.
sensitivity           Configure the fault sensitivity level.

switch(config)# fault-finder multicast-storm ethernet
PORT-LIST             Enter a port number, a list of ports or 'all' for all
                      ports.

switch(config)# fault-finder multicast-storm ethernet 1/1
action                Configure the action taken when a multicast storm is
                      detected.
                                                                                   
switch(config)# fault-finder multicast-storm ethernet 1/1 action
warn                  Log an event only.
warn-and-disable      Log an event and disable the port.

switch(config)# fault-finder multicast-storm ethernet 1/1 action warn-and-disable

SECONDS               Configure the number of seconds for which the port
                      remains disabled. A value of 0 means that the port will
                      remain disabled until manually re-enabled.

switch(config)# fault-finder multicast-storm ethernet 1/1 action warn-and-disable 10

percent               Configure the number of inbound multicast packets per
                      second that is considered a multicast storm. This
                      threshold is computed assuming a size of 64 bytes per
                      incoming multicast packet.
pps                   Configure the number of inbound multicast packets per
                      second that is considered a multicast storm.
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switch(config)# fault-finder multicast-storm ethernet 1/1 action warn-and-disable 10 percent

<1-100>               The percentage that is considered a multicast storm.

switch(config)# fault-finder multicast-storm ethernet 1/1 action warn-and-disable 10 percent 40

Per port show fault-finder output:

switch(config)# show fault-finder multicast-storm 1/1

        Mcast | Port   Rising                     Disable    Disable Time
  Port  Storm | Status Threshold Action           Timer      Left
  ----- ----- + ------ --------- ---------------- ---------- ------------
  1/1   Yes   | Down   40%       warn-and-disable 10          -

switch(config)# show fault-finder multicast-storm

        Mcast | Port   Rising                     Disable    Disable Time
  Port  Storm | Status Threshold Action           Timer      Left
  ----- ----- + ------ --------- ---------------- ---------- ------------
  1/1   Yes   | Down   40%       warn-and-disable 10          -
  1/2   Yes   | Down   50%       warn-and-disable 10          -
  1/3   Yes   | Down   50%       warn-and-disable 10          -
  1/4   Yes   | Down   50%       warn-and-disable 10          -
  1/5   Yes   | Down   50%       warn-and-disable 10          -
  1/6   Yes   | Down   50%       warn-and-disable 10          -
  1/7   Yes   | Down   50%       warn-and-disable 10          -
  1/8   Yes   | Down   50%       warn-and-disable 10          -
  1/9   Yes   | Down   50%       warn-and-disable 10          -
  1/10  Yes   | Down   50%       warn-and-disable 10          -
  1/11  Yes   | Down   50%       warn-and-disable 10          -
  1/12  Yes   | Down   50%       warn-and-disable 10          -
Configure ports 1/1 to 1/5 for multicast storm control, and warn and disable the ports after 100 seconds, with a
rising threshold of 20%:

switch(config)# fault-finder multicast-storm ethernet 1/1-1/5 action
warn-and-disable 100 percent 20

switch(config)# show fault-finder multicast-storm ethernet 1/1-1/5

        Mcast | Port   Rising                      Disable    Disable Time
  Port  Storm | Status Threshold Action            Timer      Left
  ----- ----- + ------ --------- ----------------  ---------- ------------
  1/1   Yes   | Down   20%       warn-and-disable  100         -
  1/2   Yes   | Down   20%       warn-and-disable  100         -
  1/3   Yes   | Down   20%       warn-and-disable  100         -
  1/4   Yes   | Down   20%       warn-and-disable  100         -
  1/5   Yes   | Down   20%       warn-and-disable  100         -
Disable multicast storm control on port 1/1:

switch(config)# no fault-finder multicast-storm ethernet 1/1
switch(config)# show fault-finder multicast-storm ethernet 1/1

        Mcast | Port   Rising                     Disable    Disable Time
  Port  Storm | Status Threshold Action           Timer      Left
  ----- ----- + ------ --------- ---------------- ---------- ------------
  1/1   No    | Down      -       none              -          -
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fault-finder multicast-storm action

Syntax
fault-finder multicast-storm [action {warn | warn-and-disable}] [sensitivity {low | medium |high}]
no fault-finder multicast-storm [action {warn | warn-and-disable}] [sensitivity {low | medium |high}]

Description

Global command to configure multicast-storm. The no form of the command disables multicast-storm
configuration on the port. The default sensitivity is medium and the default action is warn.

Parameters

warn

Log an event only

warn-and-disable

Log an event and disable the port

low

Low sensitivity

medium

Medium sensitivity

high

High sensitivity

Command context
config

Examples

switch(config)# fault-finder multicast-storm action warn
sensitivity     Configure the fault sensitivity level.

switch(config)# fault-finder multicast-storm action warn sensitivity
low             Low sensitivity.
medium          Medium sensitivity.
high            High sensitivity.

switch(config)# fault-finder multicast-storm action warn-and-disable
sensitivity     Configure the fault sensitivity level.

switch(config)# fault-finder multicast-storm action warn-and-disable sensitivity
low             Low sensitivity.
medium          Medium sensitivity.
high            High sensitivity.

switch(config)# fault-finder multicast-storm action warn-and-disable sensitivity high 
Global show command for auto-100 duplex Smart Rate port:

switch(config)# show fault-finder

Fault Finder

Fault ID              Sensitivity  Action
-------------------   -----------  ----------------
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bad-driver            medium       warn
bad-transceiver       medium       warn
bad-cable             medium       warn
too-long-cable        medium       warn
over-bandwidth        medium       warn
broadcast-storm       medium       warn
loss-of-link          medium       warn
duplex-mismatch-hdx   medium       warn
duplex-mismatch-fdx   medium       warn
multicast-storm       high         warn-and-disable
link-flap             medium       warn

show running-config

Syntax
show running-config

Description

Displays information about the current configuration.

Command context

Manager

Example

switch(config)# show running-config

Running configuration:

; hpStack_WC Configuration Editor; Created on release #WC.16.06.0000x
; Ver #13:03.f8.1c.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:49

stacking
   member 1 type "JL320A" mac-address 941882-dccf00
   member 1 flexible-module A type JL081A
   exit
hostname "switch"
fault-finder multicast-storm sensitivity high action warn-and-disable
fault-finder multicast-storm 1/1 action warn-and-disable 100 percent 20
fault-finder multicast-storm 1/2 action warn-and-disable 100 percent 20
fault-finder multicast-storm 1/3 action warn-and-disable 100 percent 20
fault-finder multicast-storm 1/4 action warn-and-disable 100 percent 20
fault-finder multicast-storm 1/5 action warn-and-disable 100 percent 20
fault-finder multicast-storm 1/7 action warn-and-disable 10 pps 100
fault-finder multicast-storm 1/8 action warn-and-disable 10 percent 20
fault-finder multicast-storm 1/9 action warn-and-disable 10 percent 20
snmp-server community "public" unrestricted
oobm
   ip address dhcp-bootp
   member 1
      ip address dhcp-bootp
      exit

show logging

Syntax
show logging
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Description

Checks the FFI multicast-storm logging message.

Command context

Manager

Example

switch# show logging
Keys:   W=Warning   I=Information
        M=Major     D=Debug E=Error

----  Event Log listing: Events Since Boot  ----
I 01/07/90 20:22:55 00076 ports: port 3 is now on-line
M 01/07/90 20:22:52 02677 FFI: port 3-Port enabled by Fault-finder.
I 01/07/90 20:22:33 00077 ports: port 3 is now off-line
M 01/07/90 20:22:33 02676 FFI: port 3-Re-enable after 20 seconds.
M 01/07/90 20:22:33 02673 FFI: port 3-Port disabled by Fault-finder.
M 01/07/90 20:22:33 02675 FFI: port 3-Excessive Multicast-storm control threshold 10 % exceeded.

Restrictions
Multicast storm control is not supported in the following scenarios:

• Unicast packet traffic

• If the port is configured as a VSF port

• If the port is configured as a trunk port

Configuring auto-MDIX
Copper ports on the switch can automatically detect the type of cable configuration (MDI or MDI-X) on a
connected device and adjust to operate appropriately.

This means you can use a "straight-through" twisted-pair cable or a "crossover" twisted-pair cable for any of the
connections—the port makes the necessary adjustments to accommodate either one for correct operation. The
following port types on your switch support the IEEE 802.3ab standard, which includes the "Auto MDI/MDI-X"
feature:

• 10/100-TX xl module ports

• 100/1000-T xl module ports

• 10/100/1000-T xl module ports

Using the above ports:

• If you connect a copper port using a straight-through cable on a switch to a port on another switch or hub that
uses MDI-X ports, the switch port automatically operates as an MDI port.

• If you connect a copper port using a straight-through cable on a switch to a port on an end node—such as a
server or PC—that uses MDI ports, the switch port automatically operates as an MDI-X port.

Auto-MDIX was developed for auto-negotiating devices, and was shared with the IEEE for the development of the
IEEE 802.3ab standard. Auto-MDIX and the IEEE 802.3ab Auto MDI/MID-X feature are completely compatible.
Additionally, Auto-MDIX supports operation in forced speed and duplex modes.

For more information on this subject, see the IEEE 802.3ab standard reference. For more information on MDI-X,
the installation and getting started guide for your switch.
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Manual override
If you require control over the MDI/MDI-X feature, you can set the switch to either of these non-default modes:

• Manual MDI

• Manual MDI-X

The table below shows the cabling requirements for the MDI/MDI-X settings.

Table 5: Cable types for auto and manual MDI/MDI-X settings

Setting MDI/MDI-X device type

PC or other MDI device type Switch, hub, or other MDI-X device

Manual MDI Crossover cable Straight-through cable

Manual MDI-X Straight-through cable Crossover cable

Auto-MDI-X (the default) Either crossover or straight-through cable

The AutoMDIX features apply only to copper port switches using twisted-pair copper Ethernet cables.

Configuring auto-MDIX (CLI)
The auto-MDIX features apply only to copper port switches using twisted-pair copper Ethernet cables. For
information about auto-MDIX, see Configuring auto-MDIX on page 88.

Syntax:

interface <port-list> mdix-mode < {auto-mdix | mdi | mdix>}

auto-mdix The automatic,default setting. This configures the port for automatic detection of the cable
(either straight-through or crossover).

mdi The manual mode setting that configures the port for connecting to either a PC or other MDI
device with a crossover cable, or to a switch, hub, or other MDI-X device with a straight-
through cable.

mdix The manual mode setting that configures the port for connecting to either a switch, hub, or
other MDI-X device with a crossover cable, or to a PC or other MDI device with a straight-
through cable.

Syntax:

show interfaces config
Lists the current per-port Auto/MDI/MDI-X configuration.

Syntax:

show interfaces brief
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• Where a port is linked to another device, this command lists the MDI mode the port is currently using.

• In the case of ports configured for Auto ( auto-mdix), the MDI mode appears as either MDI or MDIX,
depending upon which option the port has negotiated with the device on the other end of the link.

• In the case of ports configured for MDI or MDIX, the mode listed in this display matches the configured setting.

• If the link to another device was up, but has gone down, this command shows the last operating MDI mode the
port was using.

• If a port on a given switch has not detected a link to another device since the last reboot, this command lists
the MDI mode to which the port is currently configured.

The show interfaces config displays the following data when port A1 is configured for auto-mdix, port A2
is configured for mdi, and port A3 is configured for mdix:

Displaying the current MDI configuration

switch(config)# show interfaces config

 Port Settings

  Port   Type      | Enabled Mode         Flow Ctrl MDI
  ------ --------- + ------- ------------ --------- ---- 
  A1     10GbE-T   | Yes     Auto         Disable   Auto 
  A2     10GbE-T   | Yes     Auto         Disable   MDI 
  A3     10GbE-T   | Yes     Auto         Disable   MDIX 
  A4     10GbE-T   | Yes     Auto         Disable   Auto 
  A5     10GbE-T   | Yes     Auto         Disable   Auto 
  A6     10GbE-T   | Yes     Auto         Disable   Auto 
  A7     10GbE-T   | Yes     Auto         Disable   Auto 
  A8     10GbE-T   | Yes     Auto         Disable   Auto

Displaying the current MDI operating mode

switch(config)# show interfaces brief

 Status and Counters - Port Status

                   | Intrusion                           MDI  Flow Bcast
  Port   Type      | Alert     Enabled Status Mode       Mode Ctrl Limit
  ------ --------- + --------- ------- ------ ---------- ---- ---- ----- 
  A1     10GbE-T   | No        Yes     Up     1000FDx    MDIX off  0
  A2     10GbE-T   | No        Yes     Down   10GigFD    MDI  off  0
  A3     10GbE-T   | No        Yes     Down   10GigFD    MDIX off  0
  A4     10GbE-T   | No        Yes     Down   10GigFD    Auto off  0
  A5     10GbE-T   | No        Yes     Down   10GigFD    Auto off  0
  A6     10GbE-T   | No        Yes     Down   10GigFD    Auto off  0
  A7     10GbE-T   | No        Yes     Down   10GigFD    Auto off  0
  A8     10GbE-T   | No        Yes     Down   10GigFD    Auto off  0

Using friendly (optional) port names
This feature enables you to assign alphanumeric port names of your choosing to augment automatically assigned
numeric port names. This means you can configure meaningful port names to make it easier to identify the source
of information listed by some show commands. (Note that this feature augments port numbering, but does not
replace it.)
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Configuring and operating rules for friendly port names
• At either the global or context configuration level, you can assign a unique name to a port. You can also assign

the same name to multiple ports.

• The friendly port names you configure appear in the output of the show name [port-list], show config, and
show interface <port-number > commands. They do not appear in the output of other show
commands or in Menu interface screens. (See Displaying friendly port names with other port data (CLI) on
page 92.)

• Friendly port names are not a substitute for port numbers in CLI commands or Menu displays.

• Trunking ports together does not affect friendly naming for the individual ports. (If you want the same name for
all ports in a trunk, you must individually assign the name to each port.)

• A friendly port name can have up to 64 contiguous alphanumeric characters.

• Blank spaces within friendly port names are not allowed, and if used, cause an invalid input error. (The switch
interprets a blank space as a name terminator.)

• In a port listing, not assigned indicates that the port does not have a name assignment other than its fixed
port number.

• To retain friendly port names across reboots, you must save the current running-configuration to the startup-
config file after entering the friendly port names. (In the CLI, use the write memory command.)

Configuring friendly port names (CLI)
For detailed information about friendly port names, see Using friendly (optional) port names on page 90.

Syntax:

interface <port-list> name <port-name-string>
Assigns a port name to port-list.

Syntax:

no interface <port-list> name
Deletes the port name from <port-list>.

Configuring a single port name (CLI)
Suppose that you have connected port A3 on the switch to Bill Smith's workstation, and want to assign Bill's name
and workstation IP address (10.25.101.73) as a port name for port A3:

Configuring a friendly port name

switch(config)# int A3 name
Bill_Smith@10.25.101.73
switch(config)# write mem
switch(config)# show name A3

 Port Names
  Port : A3
   Type : 10/100TX
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Configuring the same name for multiple ports (CLI)
Suppose that you want to use ports A5 through A8 as a trunked link to a server used by a drafting group. In this
case you might configure ports A5 through A8 with the name "Draft-Server:Trunk."

Configuring one friendly port name on multiple ports

switch(config)# int a5-a8 name Draft-Server:Trunk
switch(config)# write mem
switch(config)# show name a5-a8
 
 Port Names

  Port : A5
   Type : 10GbE-T
   Name : Draft-Server:Trunk
 
 Port : A6
   Type : 10GbE-T
   Name : Draft-Server:Trunk
 
 Port : A7
   Type : 10GbE-T
   Name : Draft-Server:Trunk

  Port : A8
   Type : 10GbE-T
   Name : Draft-Server:Trunk

Displaying friendly port names with other port data (CLI)
You can display friendly port name data in the following combinations:

Syntax:

show name
Displays a listing of port numbers with their corresponding friendly port names and also quickly shows you which
ports do not have friendly name assignments. (show name data comes from the running-config file.)

Syntax:

show interface <port-number>
Displays the friendly port name, if any, along with the traffic statistics for that port. (The friendly port name data
comes from the running-config file.)

Syntax:

show config
Includes friendly port names in the per-port data of the resulting configuration listing. (show config data comes
from the startup-config file.)

Listing all ports or selected ports with their friendly port names (CLI)
Syntax:

show name [port-list]
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Lists the friendly port name with its corresponding port number and port type. The show name command without
a port list shows this data for all ports on the switch.

Friendly port name data for all ports on the switch

switch(config)# show name
Port Names
  Port   Type      Name
  ------ --------- ---------------------------- 
  A1     10GbE-T
  A2     10GbE-T
  A3     10GbE-T   Bill_Smith@10.25.101.73
  A4     10GbE-T
  A5     10GbE-T   Draft-Server:Trunk 
  A6     10GbE-T   Draft-Server:Trunk 
  A7     10GbE-T   Draft-Server:Trunk 
  A8     10GbE-T   Draft-Server:Trunk

Friendly port name data for specific ports on the switch

switch(config)# show name A3-A5
 Port Names
  Port : A3
  Type : 10GbE-T
  Name : Bill_Smith@10.25.101.73
 Port : A4
  Type : 10GbE-T 
  Name :
 Port : A5
  Type : 10GbE-T
  Name : Draft-Server:Trunk

Including friendly port names in per-port statistics listings (CLI)
Syntax:

show interface <port-number>
Includes the friendly port name with the port's traffic statistics listing. A friendly port name configured to a port is
automatically included when you display the port's statistics output.

If you configure port A1 with the name "O'Connor_10.25.101.43," the show interface output for this port
appears similar to the following:

A friendly port name in a per-port statistics listing

switch(config)# show interface a1
 Status and Counters - Port Counters for port A1

  Name  : O’Connor@10.25.101.43
  MAC Address     : 001871-b995ff
  Link Status     : Up
  Totals (Since boot or last clear) :
   Bytes Rx       : 2,763,197          Bytes Tx       : 22,972
   Unicast Rx     : 2044               Unicast Tx     : 128
   Bcast/Mcast Rx  : 23,456            Bcast/Mcast Tx : 26
  Errors (Since boot or last clear) :
   FCS Rx         : 0                  Drops Tx       : 0
   Alignment Rx    : 0                 Collisions Tx  : 0
   Runts Rx       : 0                  Late Colln Tx  : 0
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   Giants Rx      : 0                  Excessive Colln : 0
   Total Rx Errors : 0                 Deferred Tx    : 0
  Others (Since boot or last clear) :
   Discard Rx     : 0                  Out Queue Len  : 0
   Unknown Protos  : 0
  Rates (5 minute weighted average) :
   Total Rx (bps) : 3,028,168          Total Tx  (bps) : 1,918,384
   Unicast Rx (Pkts/sec) : 5           Unicast Tx (Pkts/sec) : 0
   B/Mcast Rx (Pkts/sec) : 71          B/Mcast Tx (Pkts/sec) : 0
   Utilization Rx  : 00.30 %           Utilization Tx : 00.19 %
For a given port, if a friendly port name does not exist in the running-config file, the Name line in the above
command output appears as:

Name : 

Searching the configuration for ports with friendly port names (CLI)
This option tells you which friendly port names have been saved to the startup-config file. (show config does
not include ports that have only default settings in the startup-config file.)

Syntax:

show config
Includes friendly port names in a listing of all interfaces (ports) configured with non-default settings. Excludes
ports that have neither a friendly port name nor any other non-default configuration settings.

See Listing of the startup-config file with a friendly port name configured (and saved) on page 94 to
configure port A1 with a friendly port name. Notice that the command sequence saves the friendly port name for
port A1 in the startup-config file. The name entered for port A2 is not saved because it was executed after write
memory.

Listing of the startup-config file with a friendly port name configured (and saved)

switch(config)# int A1 name Print_Server@10.25.101.43
switch(config)# write mem
switch(config)# int A2 name Herbert's_PC

switch(config)# show config

 Startup configuration:
; J9091A Configuration Editor; Created on release xx.15.05.xxxx
hostname "Switch"
 interface AQ
  name "Print_Server@10.25.101.43
 exit

snmp-server community "public" Unrestricted
.
.
.
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Uni-directional link detection (UDLD)
Uni-directional link detection (UDLD) monitors a link between two switches and blocks the ports on both ends of
the link if the link fails at any point between the two devices. This feature is particularly useful for detecting failures
in fiber links and trunks. Figure 6: UDLD Example: on page 95 shows an Example:.

Figure 6: UDLD Example:

In this Example:, each switch load balances traffic across two ports in a trunk group. Without the UDLD feature, a
link failure on a link that is not directly attached to one of the switch remains undetected. As a result, each switch
continue to send traffic on the ports connected to the failed link. When UDLD is enabled on the trunk ports on
each switch, the switches detect the failed link, block the ports connected to the failed link, and use the remaining
ports in the trunk group to forward the traffic.

Similarly, UDLD is effective for monitoring fiber optic links that use two uni-direction fibers to transmit and receive
packets. Without UDLD, if a fiber breaks in one direction, a fiber port may assume the link is still good (because
the other direction is operating normally) and continue to send traffic on the connected ports. UDLD-enabled
ports; however, will prevent traffic from being sent across a bad link by blocking the ports in the event that either
the individual transmitter or receiver for that connection fails.

Ports enabled for UDLD exchange health-check packets once every five seconds (the link-keepalive interval). If a
port does not receive a health-check packet from the port at the other end of the link within the keepalive interval,
the port waits for four more intervals. If the port still does not receive a health-check packet after waiting for five
intervals, the port concludes that the link has failed and blocks the UDLD-enabled port.

When a port is blocked by UDLD, the event is recorded in the switch log or via an SNMP trap (if configured); and
other port blocking protocols, like spanning tree or meshing, will not use the bad link to load balance packets. The
port will remain blocked until the link is unplugged, disabled, or fixed. The port can also be unblocked by disabling
UDLD on the port.
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Configuring UDLD
When configuring UDLD, keep the following considerations in mind:

• UDLD is configured on a per-port basis and must be enabled at both ends of the link. See the note below for a
list of switches that support UDLD.

• To configure UDLD on a trunk group, you must configure the feature on each port of the group individually.
Configuring UDLD on a trunk group's primary port enables the feature on that port only.

• Dynamic trunking is not supported. If you want to configure a trunk group that contains ports on which UDLD is
enabled, you must remove the UDLD configuration from the ports. After you create the trunk group, you can
re-add the UDLD configuration.

Configuring uni-directional link detection (UDLD) (CLI)
For detailed information about UDLD, see Uni-directional link detection (UDLD) on page 95.

Syntax:

[no] interface <port-list> link-keepalive
Enables UDLD on a port or range of ports.

To disable this feature, enter the no form of the command.

Default: UDLD disabled

Syntax:

link-keepalive interval <interval>
Determines the time interval to send UDLD control packets. The interval parameter specifies how often the ports
send a UDLD packet. You can specify from 10 to 100, in 100-ms increments, where 10 is 1 second, 11 is 1.1
seconds, and so on.

Default: 50 (5 seconds)

Syntax:

link-keepalive retries <num>
Determines the maximum number of retries to send UDLD control packets. The num parameter specifies the
maximum number of times the port will try the health check. You can specify a value from 3 to 10.

Default: 5

Syntax:

[no] interface <port-list> link-keepalive vlan <vid>
Assigns a VLAN ID to a UDLD-enabled port for sending tagged UDLD control packets.Under default settings,
untagged UDLD packets can still be transmitted and received on tagged only ports; however, a warning message
is logged.

The no form of the command disables UDLD on the specified ports.

Default: UDLD packets are untagged; tagged-only ports transmit and receive untagged UDLD control packets

Enabling UDLD (CLI)
UDLD is enabled on a per-port basis.
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Example:

To enable UDLD on port a1, enter:

switch(config)#interface al link-keepalive
To enable the feature on a trunk group, enter the appropriate port range. For example:

switch(config)#interface al-a4 link-keepalive

NOTE:

When at least one port is UDLD-enabled, the switch will forward out UDLD packets that arrive on
non-UDLD-configured ports out of all other non-UDLDconfigured ports in the same vlan. That is,
UDLD control packets will “pass through” a port that is not configured for UDLD. However, UDLD
packets will be dropped on any blocked ports that are not configured for UDLD.

Changing the keepalive interval (CLI)
By default, ports enabled for UDLD send a link health-check packet once every 5 seconds. You can change the
interval to a value from 10 to 100 deciseconds, where 10 is 1 second, 11 is 1.1 seconds, and so on.

Example:

To change the packet interval to seven seconds, enter the following command at the global configuration level:

switch(config)# link-keepalive interval 70

Changing the keepalive retries (CLI)
By default, a port waits 5 seconds to receive a health-check reply packet from the port at the other end of the link.
If the port does not receive a reply, the port tries four more times by sending up to four more health-check
packets. If the port still does not receive a reply after the maximum number of retries, the port goes down.

You can change the maximum number of keepalive attempts to a value from 3 to 10.

Example:

To change the maximum number of attempts to four, enter the following command at the global configuration
level:

switch(config)# link-keepalive retries 4

Configuring UDLD for tagged ports
The default implementation of UDLD sends the UDLD control packets untagged, even across tagged ports. If an
untagged UDLD packet is received by a non-HPE switch, that switch may reject the packet. To avoid such an
occurrence, you can configure ports to send out UDLD control packets that are tagged with a specified VLAN.

To enable ports to receive and send UDLD control packets tagged with a specific VLAN ID, enter a command
such as the following at the interface configuration level:

switch(config)#interface link-keepalive vlan 22
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NOTE:

• You must configure the same VLANs that will be used for UDLD on all devices across the
network; otherwise, the UDLD link cannot be maintained.

• If a VLAN ID is not specified, UDLD control packets are sent out of the port as untagged packets.

• To re-assign a VLAN ID, re-enter the command with the new VLAN ID number. The new
command overwrites the previous command setting.

• When configuring UDLD for tagged ports, you may receive a warning message if there are any
inconsistencies with the VLAN configuration of the port.

Viewing UDLD information (CLI)
Syntax:

show link-keepalive
Displays all the ports that are enabled for link-keepalive.

Syntax:

show link-keepalive statistics
Displays detailed statistics for the UDLD-enabled ports on the switch.

Syntax:

clear link-keepalive statistics
Clears UDLD statistics. This command clears the packets sent, packets received, and transitions counters in the
show link-keepalive statistics display.

Viewing summary information on all UDLD-enabled ports (CLI)
Enter the show link-keepalive command.

Example:

Figure 7: Example: of show link-keepalive command
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Viewing detailed UDLD information for specific ports (CLI)
Enter the show link-keepalive statistics command.

Example:

Figure 8: Example: of show link-keepalive statistics command

Clearing UDLD statistics (CLI)
Enter the following command:

switch# clear link-keepalive statistics
This command clears the packets sent, packets received, and transitions counters in the show link
keepalive statistics display (see Figure 8: Example: of show link-keepalive statistics command on
page 99 for an Example:).

Uplink Failure Detection
Uplink Failure Detection (UFD) is a network path redundancy feature that works in conjunction with NIC teaming
functionality. UFD continuously monitors the link state of the ports configured as links-to-monitor (LtM), and when
these ports lose link with their partners, UFD will disable the set of ports configured as links-to-disable (LtD.)
When an uplink port goes down, UFD enables the switch to auto-disable the specific downlinks connected to the
NICs. This allows the NIC teaming software to detect link failure on the primary NIC port and fail over to the
secondary NIC in the team.

NIC teams must be configured for switch redundancy when used with UFD, that is, the team spans ports on both
Switch A and Switch B. The switch automatically enables the downlink ports when the uplink returns to service.
For an example of teamed NICs in conjunction with UFD, see Figure 9: Teamed NICs in conjunction with UFD
on page 100.) For an example of teamed NICs with a failed uplink, see Figure 10: Teamed NICs with a failed
uplink on page 100.
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For UFD functionality to work as expected, the NIC teaming must be in Network Fault Tolerance (NFT) mode.

Figure 9: Teamed NICs in conjunction with UFD

Figure 10: Teamed NICs with a failed uplink

NOTE: The state of the LtD is purely governed by the state of the LtM, and is independent of the
physical state of the ports in the LtD.
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Configuration Guidelines for UFD
Below is a list of configuration guidelines to be followed for UFD. These are applicable only to blade switches
where there is a clear distinction between downlink and uplink ports.

1. UFD is required only when uplink-path redundancy is not available on the blade switches.

2. An LtM can be either one or more uplink ports or one or more multi-link trunk group of uplink ports.

3. Ports that are already members of a trunk group are not allowed to be assigned to an LtM or LtD.

4. A trunk group configured as an LtM can contain multiple uplink ports, but no downlink ports or ISL (Inter-
Switch-Link) ports.

5. A port cannot be added to a trunk group if it already belongs to an LtM or LtD.

6. An LtD can contain one or more ports, and/or one or more trunks

7. A trunk group configured as an LtD can contain multiple downlink ports, but no uplink ports or ISL (Inter-
Switch-Link) ports.

A common API will be provided for higher layers, like CLI and SNMP, which will determine if a port-list can be an
LtM or LtD. The API will handle the platform specific details and ensure a uniform code flow for blade and other
switch families.

Switches do not have a clear distinction between uplink and downlink ports so some of the points listed above
may not be applicable.

UFD enable/disable

uplink-failure-detection
Syntax
uplink-failure-detection
Description

Used to globally enable UFD. The [no] option globally disables UFD.

UFD configuration

uplink-failure-detection track

Syntax
uplink-failure-detection track <track_ID> links-to-monitor <port-list> links-to-disable <port-list>
delay <delay_value>

no uplink-failure-detection track <track_ID> links-to-monitor <port-list> links-to-disable <port-list>
delay <delay_value>

Description

Configures LtM and LtD ports for track-id. UFD delay is configured in seconds until when uplink must remain in a
stable state before restoring the downlink. UFD delay is configurable between 0 to 300 seconds. The default
delay value is 0.

The no form of this command resets the parameter.
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Command context
config

Parameters
<track_ID>

Specifies the track id.

<Port-List>

Specifies the port list.

<delay_value>

Specifies the delay value.

Examples
Configure port A8 as LtM, port A6 as LtD, and delay value as 100 for track 1:

Switch(config)# uplink-failure-detection track 1 links-to-monitor A8 
links-to-disable A6 delay 100

switch(config)# show running-config

Running configuration:

; J9851A Configuration Editor; Created on release #KB.16.08.0001
; Ver #14:01.4f.f8.1d.fb.7f.bf.bb.ff.7c.59.fc.7b.ff.ff.fc.ff.ff.3f.ef:4e
hostname "switch"
module A type j9993a
module L type j9992a
snmp-server community "public" unrestricted
oobm
   ip address dhcp-bootp
   exit
uplink-failure-detection
uplink-failure-detection track 1 links-to-monitor A8 links-to-disable A6 delay 100
vlan 1
   name "DEFAULT_VLAN"
   untagged A1-A8,L1-L21
   ip address dhcp-bootp
   ipv6 enable
   ipv6 address dhcp full
   exit
To set delay value to 2:

switch(config)# uplink-failure-detection track 1 delay 2
To set delay value to 0:

switch(config)#no uplink-failure-detection track 1 delay 2
Alternately, to set delay value to 0, a user can also use the following command:

switch(config)#uplink-failure-detection track 1 delay 0

show uplink-failure-detection

Syntax
show uplink-failure-detection
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Description

Shows the uplink failure detection information.

Command context
manager

Examples

switch# show uplink-failure-detection

Uplink Failure Detection Information

  UFD Enabled   : Yes

  Track | Monitored   Links to    LtM      LtD      LtM       LtD        Delay
  ID    | Links       Disable     State    State    Lacp Key  Lacp Key   (sec)
  ------+----------   ----------- -------- -------  --------- ---------- ------
  1     | Dyn1        Dyn2        Up       Up       1         2          0
  32    | Trk1        Trk3        Up       Up                            300
  50    | Trk2        Trk4        Up       Up                            120
  64    | 2/12        2/14        Up       Up                            150
If there is a failure, and one track is in Down/Auto-Disabled state, the show uplink-failure-detection
command displays:

switch(config)# show uplink-failure-detection

Uplink Failure Detection Information

  UFD Enabled   : Yes

  Track | Monitored    Links to     LtM    LtD           LtM      LtD      Delay
  ID    | Links        Disable      State  State         Lacp Key Lacp Key (sec)
  ----- + ------------ ------------ ------ ------------- -------- -------- -----
  1     | Trk1         A4           Up     Up                              100
  2     | A5           A6           Down   Auto-Disabled                   0

Error log

Cause

UFD will log messages in the following scenarios:

• Admin status change.

• When an UFD LtD delay expires, as a result the LtD link is brought up.

• When the UFD Link transition delay is triggered, an LtM returns to service, and as a result the UFD delay is
triggered.

Invalid port error messages

Cause

• When a user specifies an invalid LtM port, a message similar to the following is displayed.
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Invalid port(s) specified as links-to-monitor.
• When a user specifies an invalid LtD port, a message similar to the following is displayed.

Invalid port(s) specified as links-to-disable.
• When a user specifies an incorrect delay value, an error message similar to the following is displayed:

Delay specified does not match with the configured value of <delay value>.

Basic USB port commands
NOTE: The USB port is available only on the 2930M Switch Series.

usb-port
Syntax
usb-port

no usb-port
Description

Enables the USB port.

The no form of the command disables the USB port and any access to the device.

Command context
Config

show usb-port
Syntax
show usb-port

Description

Displays the status of the USB port. It can be enabled, disabled, or not present.

Command context
operator

Usage

One of the following messages indicates the presence or absence of a USB device:

• Not able to sense device in USB port
• USB device detected in port
• no USB device detected in port

Example

Display USB port status.
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switch# show usb-port

  USB port status: enabled
  USB port power status: power on    (USB device detected in port)

Chapter 3 Port Status and Configuration 105

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 6702



Introduction to PoE
PoE technology allows IP telephones, wireless LAN access points, and other appliances to receive power and
transfer data over existing ethernet LAN cabling. For more information about PoE technology, see the PoE/PoE+
planning and implementation guide, which is available on the Networking website at http://www.hpe.com/
networking. Enter your Switch number.

Additionally, PoE+ provides more power-management capability, allowing the switch to have more power
available for more PDs. Power can be allocated exactly and automatically according to what the PD actually
requires at a given time.

PoE terminology
PoE and PoE+ operate similarly in most cases. Any differences between PoE and PoE+ operation are noted;
otherwise, the term "PoE" is used to designate both PoE and PoE+ functionality.

Planning and implementing a PoE configuration
This section provides an overview of some considerations for planning a PoE application. For additional
information on this topic, refer to the PoE/PoE+ planning and implementation guide which is available on the
Networking web site at http://www.hpe.com/networking.

Some of the elements you may want to consider for a PoE installation include:

• Port assignments to VLANs

• Use of security features

• Power requirements

This section can help you to plan your PoE installation. If you use multiple VLANs in your network, or if you have
concerns about network security, you should read the first two topics. If your PoE installation comes close to (or is
likely to exceed) the system’s ability to supply power to all devices that may request it, then you should also read
the third topic. (If it is unlikely that your installation will even approach a full utilization of the PoE power available,
then you may find it unnecessary to spend much time on calculating PoE power scenarios.)

Power requirements
To get the best PoE performance, you should provide enough PoE power to exceed the maximum amount of
power that is needed by all the PDs that are being used.

By connecting an external power supply you can optionally provision more PoE wattage per port and or supply
the switch with redundant 12V power to operate should an internal power supply fail.

See the PoE/PoE+ planning and implementation guide for detailed information about the PoE/PoE+ power
requirements for your switch.

Assigning PoE ports to VLANs
If your network includes VLANs, you may want to assign various PoE-configured ports to specific VLANs. For
example, if you are using PoE telephones in your network, you may want to assign ports used for telephone
access to a VLAN reserved for telephone traffic.

Chapter 4
Power Over Ethernet (PoE/PoE+) Operation
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Applying security features to PoE configurations
You can use the port security features built into the switch to control device or user access to the network through
PoE ports in the same way as non-PoE ports. Using Port Security, you can configure each switch port with a
unique list of MAC addresses for devices that are authorized to access the network through that port. For more
information, refer to the titled “Configuring and Monitoring Port Security” in the access security guide for your
switch.

Assigning priority policies to PoE traffic
You can use the configurable QoS (Quality of Service) features in the switch to create prioritization policies for
traffic moving through PoE ports. The table below lists the available classifiers and their order of precedence.

Table 6: Classifiers for prioritizing outbound packets

Priority QoS classifier

1 UDP/TCP application type (port)

2 Device priority (destination or source IP address)

3 IP type of service (ToS) field (IP packets only)

4 VLAN priority

5 Incoming source-port on the switch

6 Incoming 802.1 priority (present in tagged VLAN environments)

For more on this topic, refer to the titled “Quality of Service: Managing Bandwidth More Effectively” in the
advanced traffic management guide for your switch.

PoE operation
Using the commands described in this chapter, you can:

• Enable or disable PoE operation on individual ports.

• Monitor PoE status and performance.

• Configure a non-default power threshold for SNMP and Event Log reporting of PoE consumption on either all
PoE ports on the switch or on all PoE ports.

• Specify the port priority you want to use for provisioning PoE power in the event that the PoE resources
become oversubscribed.

A PSE detects the power needed by a connected PD before supplying that power via a phase referred to as
"searching". If the PSE cannot supply the required amount of power, it does not supply any power. For PoE using
a Type 1 device, a PSE will not supply any power to a PD unless the PSE has at least 17 watts available. For
example, if a PSE has a maximum available power of 382 watts and is already supplying 378 watts, and is then
connected to a PD requiring 10 watts, the PSE will not supply power to the PD.

For PoE+ using Type 2 devices, the PSE must have at least 33 watts available.

Configuration options
In the default configuration, all ports in a switch covered in this guide are configured to support PoE operation.
You can:
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• Disable or re-enable per-port PoE operation on individual ports to help control power usage and avoid
oversubscribing PoE resources.

• Configure per-port priority for allocating power in case a PoE device becomes oversubscribed and must drop
power for some lower-priority ports to support the demand on other, higher-priority ports.

• Manually allocate the amount of PoE power for a port by usage, value, or class.

• Allocate PoE power based on the link-partner’s capabilities via LLDP.

NOTE:

The ports support standard networking links and PoE links. You can connect either a non-PoE device
or a PD to a port enabled for PoE without reconfiguring the port.

PD support
To best utilize the allocated PoE power, spread your connected PoE devices as evenly as possible. Depending on
the amount of power the power supply device delivers to a PoE switch, there may or may not always be enough
power available to connect and support PoE operation on all the ports. When a new PD connects to a PoE switch
and the switch does not have enough power left for that port:

• If the new PD connects to a port “X” having a higher PoE priority than another port “Y” that is already
supporting another PD, then the power is removed from port “Y” and delivered to port “X”. In this case the PD
on port “Y” loses power and the PD on port “X” receives power.

• If the new PD connects to a port “X” having a lower priority than all other PoE ports currently providing power
to PDs, then power is not supplied to port “X” until one or more PDs using higher priority ports are removed.

In the default configuration (usage), when a PD connects to a PoE port and begins operating, the port retains
only enough PoE power to support the PD's operation. Unused power becomes available for supporting other PD
connections. However, if you configure the poe-allocate-by option to either value or class, all of the power
configured is allocated to the port.

For PoE (not PoE+), while 17 watts must be available for a PoE module on the switch to begin supplying power to
a port with a PD connected, 17 watts per port is not continually required if the connected PD requires less power.
For example, with 20 watts of PoE power remaining available on a module, you can connect one new PD without
losing power to any connected PDs on that module. If that PD draws only 3 watts, 17 watts remain available, and
you can connect at least one more PD to that module without interrupting power to any other PoE devices
connected to the same module. If the next PD you connect draws 5 watts, only 12 watts remain unused. With only
12 unused watts available, if you then connect yet another PD to a higher-priority PoE port, the lowest-priority port
on the module loses PoE power and remains unpowered until the module once again has 17 or more watts
available. (For information on power priority, see Power priority operation on page 108.)

For PoE+, there must be 33 watts available for the module to begin supplying power to a port with a PD
connected.

Disconnecting a PD from a PoE port makes that power available to any other PoE ports with PDs waiting for
power. If the PD demand for power becomes greater than the PoE power available, power is transferred from the
lower-priority ports to the higher-priority ports. (Ports not currently providing power to PDs are not affected.)

Power priority operation

When is power allocation prioritized?
If a PSE can provide power for all connected PD demand, it does not use its power priority settings to allocate
power. However, if the PD power demand oversubscribes the available power, then the power allocation is
prioritized to the ports that present a PD power demand. This causes the loss of power from one or more lower-
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priority ports to meet the power demand on other, higher-priority ports. This operation occurs regardless of the
order in which PDs connect to the switch’s PoE-enabled ports.

How is power allocation prioritized?
There are two ways that PoE power is prioritized:

• Using a priority class method, a power priority of Low (the default), High, or Critical is assigned to each
enabled PoE port.

• Using a port-number priority method, a lower-numbered port has priority over a higher-numbered port within
the same configured priority class, For example, port A1 has priority over port A5 if both are configured with
High priority.

Configuring PoE operation
In the default configuration, PoE support is enabled on the ports in a PoE switch. The default priority for all ports
is Low and the default power notification threshold is 80 (%).

Using the CLI, you can:

• Disable or re-enable PoE operation on individual PoE ports

• Enable support for pre-standard devices

• Change the PoE priority level on individual PoE ports

• Change the threshold for generating a power level notice

• Manually allocate the amount of PoE power for a port by usage, value, or class

• Allocate PoE power based on the link-partner’s capabilities via LLDP

Disabling or re-enabling PoE port operation
Syntax:

[no] interface <port-list> power-over-ethernet
Re-enables PoE operation on <port-list> and restores the priority setting in effect when PoE was disabled on
<port-list>.

The no form of the command disables PoE operation on <port-list>.

Default: All PoE ports are initially enabled for PoE operation at Low priority. If you configure a higher priority, this
priority is retained until you change it.

Enabling support for pre-standard devices
The switches covered in this guide also support some pre-802.3af devices. For a list of the supported devices,
see the FAQ for your switch model.

Syntax:

[no] power-over-ethernet pre-std-detect
Detects and powers pre-802.3af standard devices.
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NOTE: The default setting for the pre-std-detect PoE parameter changed. In earlier software the
default setting is “on”. The default setting is “off”.

Configuring the PoE port priority
Syntax:

interface <port-list> power-over-ethernet [critical | high | low]
Reconfigures the PoE priority level on <port-list>. For a given level, ports are prioritized by port number in
ascending order. For example, if ports A1-A24 have a priority level of critical, port A1 has priority over ports A2-
A24.

If there is not enough power available to provision all active PoE ports at a given priority level, the lowest-
numbered port at that level is provisioned first. PoE priorities are invoked only when all active PoE ports cannot
be provisioned (supplied with PoE power)

Critical Specifies the highest-priority PoE support for <port-list>. The active PoE ports at this level are
provisioned before the PoE ports at any other level are provisioned.

High Specifies the second priority PoE support for <port-list>. The active PoE ports at this level are
provisioned before the Low priority PoE ports are provisioned.

Low (Default) Specifies the third priority PoE support for <port-list>. The active PoE ports at this level
are provisioned only if there is power available after provisioning any active PoE ports at the
higher priority levels.

Controlling PoE allocation
The default option for PoE allocation is usage, which is what a PD attached to the port is allocated. You can
override this value by specifying the amount of power allocated to a port by using the class or value options.

Syntax:

[no] int <port-list> poe-allocate-by [usage | class | value]
Allows you to manually allocate the amount of PoE power for a port by either its class or a defined value.

usage The automatic allocation by a PD

class Uses the power ramp-up signature of the PD to identify which power class the device will be in.
Classes and their ranges are shown in the table below.

value A user-defined level of PoE power allocated for that port.

NOTE: The allowable PD requirements are lower than those specified for PSEs to allow for power
losses along the Cat-5 cable.

110 Aruba 2930F / 2930M Management and Configuration Guide
for ArubaOS-Switch 16.08

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 6707



Table 7: Power classes and their values

Power
class

Value

0 Depends on cable type and PoE architecture. Maximum power level output of 15.4 watts at the
PSE.This is the default class; if there is not enough information about the load for a specific
classification, the PSE classifies the load as class 0 (zero).

1 Requires at least 4 watts at the PSE.

2 Requires at least 7 watts at the PSE.

3 15.4 watts

4 For PoE+Maximum power level output of 30 watts at the PSE.

Example:

To allocate by class for ports 6 to 8:

switch(config)# int 6-8 PoE-allocate-by class

Manually configuring PoE power levels
You can specify a power level (in watts) allocated for a port by using the value option. This is the maximum
amount of power that will be delivered.

To configure a port by value:

Procedure

1. Set the PoE allocation by entering the poe-allocate-by value command:

switch(config) # int A6 poe-allocate-by value
or in interface context:

switch(eth-A6) # poe-allocate-by value
2. Select a value:

switch(config) # int A6 poe-value 15
or in interface context:

switch(eth-A6) # poe-value 15
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To view the settings, enter the show power-over-ethernet command, shown in Figure 11: PoE allocation
by value and the maximum power delivered on page 112.

Figure 11: PoE allocation by value and the maximum power delivered

switch(config)# show power-over-ethernet A6

 Status and Counters - Port Power Status for port A6

  Power Enable     : Yes
                                       LLDP Detect     : enabled
  Priority         : low               Configured Type :
  AllocateBy       : value             Value           : 15 W 1
  Detection Status : Delivering        Power Class     : 2

  Over Current Cnt : 0                 MPS Absent Cnt  : 0
  Power Denied Cnt : 0                 Short Cnt       : 0

  Voltage          : 55.1 V            Current         : 154 mA
  Power            : 8.4 W

1Maximum power delivered.

If you set the PoE maximum value to less than what the PD requires, a fault occurs, as shown in Figure 12: PoE
power value set too low for the PD on page 112.

Figure 12: PoE power value set too low for the PD

switch(config)# int A7 poe-value 4

switch(config)# show power-over-ethernet A7

 Status and Counters - Port Power Status for port A7

  Power Enable     : Yes
                                       LLDP Detect     : enabled
  Priority         : low               Configured Type :
  AllocateBy       : value             Value           : 4 W
  Detection Status : fault 1             Power Class     : 2

  Over Current Cnt : 1                 MPS Absent Cnt  : 0
  Power Denied Cnt : 2                 Short Cnt       : 0

  Voltage          : 55.1 V            Current         : 154 mA
  Power            : 8.4 W

1‘Fault’ appears when the PoE power value is set too low.

Configuring PoE redundancy
When PoE redundancy is enabled, PoE redundancy occurs automatically. The switch keeps track of power use
and will not supply PoE power to additional PoE devices trying to connect if that results in the switch not having
enough power in reserve for redundancy if one of the power supplies should fail.

Syntax:

[no] power-over-ethernet redundancy [n+1 | full]
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Allows you to set the amount of power held in reserve for redundancy.

no Means that all available power can be allocated to PDs.Default: No PoE redundancy
enforced.

n+1 One of the power supplies is held in reserve for redundancy. If a single power supply
fails, no powered devices are shut down.If power supplies with different ratings are
used, the highest-rated power supply is held in reserve to ensure full redundancy.

full Half of the available power supply is held in reserve for redundancy. If power supplies
with different ratings are used, the highest-rated power supply is held in reserve to
ensure full redundancy.

For more information about PoE redundancy and power supplies, see the PoE/PoE+ planning and
implementation guide, available on the website at http://www.hpe.com/networking. Auto search the model
number for your switch, For example, “Aruba switch 2930”, then select the device from the list, and click on
Product manuals. Click on the “Setup and install — general” link under Manuals.

Changing the threshold for generating a power notice
You can configure one of the following thresholds:

• A global power threshold that applies to all ports on the switch. This setting acts as a trigger for sending a
notice when the PoE power consumption on any PoE port installed in the switch crosses the configured global
threshold level. (Crossing the threshold level in either direction—PoE power usage either increasing or
decreasing— triggers the notice.) The default setting is 80%.

• A per-slot power threshold that applies to an individual PoE module installed in the designated slot. This
setting acts as a trigger for sending a notice when the module in the specified slot exceeds or goes below a
specific level of PoE power consumption.

NOTE: Some switches covered by this manual provide a single fixed slot.

Syntax:

power-over-ethernet [slot < slot-id-range >] threshold <1-99>
This command specifies the PoE usage level (as a percentage of the PoE power available on a module) at which
the switch generates a power usage notice. This notice appears as an SNMP trap and a corresponding Event Log
message and occurs when a PoE module's power consumption crosses the configured threshold value. That is,
the switch generates a notice whenever the power consumption on a module either exceeds or drops below the
specified percentage of the total PoE power available on the module.

This command configures the notification threshold for PoE power usage on either a global or per-module (slot)
basis.

Without the [slot PoE <slot-id-range>] option, the switch applies one power threshold setting on all PoE
modules installed in the switch.

Example:

Suppose slots A, B, and C each have a PoE module installed. In this case, executing the following command sets
the global notification threshold to 70% of available PoE power:

switch(config)# power-over-ethernet threshold 70
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With this setting, if module B is allocated 100 watts of PoE power and is using 68 watts, and then another PD is
connected to the module in slot B that uses 8 watts, the 70% threshold of 70 watts is exceeded. The switch sends
an SNMP trap and generates this Event Log message:

Slot B POE usage has exceeded threshold of 70%.
If the switch is configured for debug logging, it also sends the Event Log message to the configured debug
destination(s).

On any PoE module, if an increasing PoE power load (1) exceeds the configured power threshold (which triggers
the log message and SNMP trap), and then (2) later decreases and drops below the threshold again, the switch
generates another SNMP trap, plus a message to the Event Log and any configured Debug destinations.

To continue the preceding Example:, if the PoE power usage on the PoE module in slot B drops below 70%,
another SNMP trap is generated and you will see this message in the Event Log:

Slot B POE usage is below threshold of 70%.
For a message listing, please see the event log message reference guide for your switch. Go to http://
www.hpe.com/networking; auto search the model number for your switch, for Example: “Aruba Switch 2920”,
then select the device from the list and click on Product manuals. Click on the “User guide” link under Manuals.

(Default Global PoE Power Threshold: 80). By using the [slot <slot-id-range>] option, you can specify
different notification thresholds for different PoE modules installed in the switch. For example, you could set the
power threshold for a PoE module in slot “A” to 75% and the threshold for the module in slot “B” to 68% by
executing the following two commands:

switch(config)# power-over-ethernet slot a threshold 75
switch(config)# power-over-ethernet slot b threshold 68

NOTE: The last threshold command affecting a given slot supersedes the previous threshold
command affecting the same slot. Thus, executing the following two commands in the order shown
sets the threshold for the PoE module in slot “D” to 75%, but leaves the thresholds for any PoE
modules in the other slots at 90%.

switch(config)# power-over-ethernet threshold 90
switch(config)# power-over-ethernet slot d threshold 75
If you reverse the order of the above two commands, all PoE modules in the switch will have a
threshold of 90%.

PoE/PoE+ allocation using LLDP information

LLDP with PoE
When using PoE, enabling poe-lldp-detect allows automatic power configuration if the link partner supports
PoE. When LLDP is enabled, the information about the power usage of the PD is available, and the switch can
then comply with or ignore this information. You can configure PoE on each port according to the PD (IP phone,
wireless device, and so on) specified in the LLDP field. The default configuration is for PoE information to be
ignored if detected through LLDP.

NOTE:

Detecting PoE information via LLDP affects only power delivery; it does not affect normal Ethernet
connectivity.
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Enabling or disabling ports for allocating power using LLDP
Syntax:

int <port-list> poe-lldp-detect [enabled | disabled]
Enables or disables ports for allocating PoE power based on the link-partner's capabilities via LLDP.

Default: Disabled

Example:

You can enter this command to enable LLDP detection:

switch(config) # int A7 poe-lldp-detect enabled
or in interface context:

switch(eth-A7) # poe-lldp-detect enabled

Enabling PoE detection via LLDP TLV advertisement
Use this command and insert the desired port or ports:

switch(config) # lldp config <port-number> medTlvenable poe
    

LLDP with PoE+

Overview
The data link layer classification DLC for PoE provides more exact control over the power requirement between a
PSE and PD. The DLC works in conjunction with the physical layer classification PLC and is mandatory for any
Type-2 PD that requires more than 12.95 watts of input power.

NOTE:

DLC is defined as part of the IEEE 802.3at standard.

The power negotiation between a PSE and a PD can be implemented at the physical layer or at the data link
layer. After the link is powered at the physical layer, the PSE can use LLDP to repeatedly query the PD to
discover the power needs of the PD. Communication over the data link layer allows finer control of power
allotment, which makes it possible for the PSE to supply dynamically the power levels needed by the PD. Using
LLDP is optional for the PSE but mandatory for a Type 2 PD that requires more than 12.95 watts of power.

If the power needed by the PD is not available, that port is shut off.

PoE allocation
LLDP can negotiate power with a PD by using LLDP MED TLVs (disabled by default). This can be enabled using
the int <port-list> PoE-lldp-detect [enabled|disabled] command, as shown below. LLDP MED
TLVs sent by the PD are used to negotiate power only if the LLDP PoE+ TLV is disabled or inactive; if the LLDP
PoE+ TLV is sent as well (not likely), the LLDP MED TLV is ignored.

Enabling PoE-lldp-detect allows the data link layer to be used for power negotiation. When a PD requests
power on a PoE port, LLDP interacts with PoE to see if there is enough power to fulfill the request. Power is set at
the level requested. If the PD goes into power-saving mode, the power supplied is reduced; if the need for power
increases, the amount supplied is increased. PoE and LLDP interact to meet the current power demands.

Syntax:

int <port-list> poe-lldp-detect [enabled | disabled]
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Allows the data link layer to be used for power negotiation between a PD on a PoE port and LLDP.

Default: Disabled

Example:

You can enter this command to enable LLDP detection:

switch(config) # int 7 PoE-lldp-detect enabled
or in interface context:

switch(eth-7) # PoE-lldp-detect enabled

NOTE:

Detecting PoE information via LLDP affects only power delivery; it does not affect normal Ethernet
connectivity.

You can view the settings by entering the show power-over-ethernet brief command, as shown in Port
with LLDP configuration information obtained from the device on page 116.

Port with LLDP configuration information obtained from the device

switch(config)# show power-over-ethernet brief

 Status and Counters - Port Power Status

  System Power Status  : No redundancy
  PoE Power Status     : No redundancy

  Available: 300 W Used: 0 W Remaining: 300 W

  Module A Power
  Available: 300 W Used: 5 W Remaining: 295 W

  POE   | Power   Power     Alloc Alloc  Actual Configured  Detection   Power
  Port  | Enable  Priority  By    Power  Power  Type        Status      Class
  ----- + ------- --------- ----- ------ ------ ----------- ----------- ----
  A1    | Yes     low       usage 17 W   0.0 W  Phone1      Delivering  1
  A2    | Yes     low       usage 17 W   0.0 W              Searching   0
  A3    | Yes     low       usage 17 W   0.0 W              Searching   0
  A4    | Yes     low       usage 17 W   0.0 W              Searching   0
  A5    | Yes     low       usage 17 W   0.0 W              Searching   0
  A6    | Yes     low       usage 17 W   0.0 W              Searching   0
  

Viewing PoE when using LLDP information
Viewing LLDP port configuration
To view information about LLDP port configuration, use the show lldp config command.

Syntax:

show lldp config <port-list>
Displays the LLDP port configuration information, including the TLVs advertised.

LLDP port configuration information with PoE

switch(config)# show lldp config 4
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 LLCP Port Configuration Detail

  Port : 4
  AdminStatus [Tx_Rx] : Tx_Rx
  NotificationsEnabled [False] : False
  Med Topology Trap Enabled [False] : False

  TLVS Advertised:
   * port_descr
   * system_name
   * system_descr
   * system_cap

   * capabilities
   * network_policy
   * location_id
   * poe

   * macphy_config
   * poeplus_config

  IpAddress Advertised:
Local power information on page 117 shows an Example: of the local device power information using the show
lldp info local-device <port-list> command.

Local power information

switch(config)# show lldp info local-device A1

 LLCP Local Port Information Detail

  Port     : A1
  PortType : local
  PortId   : 1
  PortDesc : A1
  Pvid     : 1

 Poe Plus Information Detail

     Poe Device Type           : Type2 PSE
     Power Source              : Primary
     Power Priority            : low
     PD Requested Power Value  : 20 Watts
     PSE Actual Power Value    : 20 Watts
Remote power information on page 117 shows the remote device power information using the show lldp
info remote-device <port-list> command.

Remote power information

switch(config)# show lldp info remote-device A3

 LLCP Remote Device Information Detail

  Local Port   : A3
  ChassisType  : mac-address
  ChassisId    : 00 16 35 ff 2d 40
  PortType     : local
  PortId       : 23
  SysName      : Switch
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  System Descr : Switch 3500-24, revision W.14.xx
  PortDescr    : 23
  Pvid         : 55

  System Capabilities Supported  : bridge, router
  System Capabilities Enabled    : bridge

  Remote Management Address
     Type    : ipv4
     Address : 10.0.102.198

  Poe Plus Information Detail

     Poe Device Type           : Type2 PD
     Power Source              : Only PSE
     Power Priority            : low
     PD Requested Power Value  : 20 Watts
     PSE Actual Power Value    : 20 Watts

Operating note
The advertisement of power with TLVs for LLDP PoE+ is enabled by default. If LLDP is disabled at runtime and a
PD is using PoE+ power that has been negotiated through LLDP, there will be a temporary power drop. The port
will begin using PoE+ power through the PLC. This event is recorded in the event log. An Example: message
would look like the following:

W 08/04/13 13:35:50 02768 ports: Port A1 PoE power dropped.
Exceeded physical classification for a PoE Type1 device
(LLDP process disabled)
When LLDP is enabled again, it causes a temporary power drop. This event is also recorded in the event log. An
Example: message looks like the following:

W 08/04/13 13:36:31 02771 ports: Port A1 PoE power dropped.
Exceeded physical classification due to change in
classification type (LLDP process enabled)

Viewing the global PoE power status of the switch
Syntax:

show power-over-ethernet [brief | [[ethernet] <port-list>] | [slot <slot-id-range> | all>]]
Displays the switch's global PoE power status, including:

• Total Available Power

Lists the maximum PoE wattage available to provision active PoE ports on the switch. This is the amount of
usable power for PDs.

• Total Failover Power

Lists the amount of PoE power available in the event of a single power supply failure. This is the amount of
power the switch can maintain without dropping any PDs.

• Total Redundancy Power

Indicates the amount of PoE power held in reserve for redundancy in case of a power supply failure.

• Total Remaining Power

The amount of PoE power still available.
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brief Displays PoE information for each port. See Viewing PoE status on all ports on page
119.

<port-list> Displays PoE information for the ports in port-list. See Viewing the PoE status on
specific ports on page 121.

<slot-id-
range>

Displays PoE information for the selected slots. See Showing the PoE information by
slot).Enter the all option to display the PoE information for all slots.

The show power-over-ethernet displays data similar to that shown in show power-over-ethernet
command output on page 119.

show power-over-ethernet command output

switch(config)# show power-over-ethernet

 Status and Counters - System Power Status

  Pre-standard Detect  : On
  System Power Status  : No redundancy
  PoE Power Status     : No redundancy

 Chassis power-over-ethernet

  Total Available Power  :  600 W
  Total Failover Power   :  300 W
  Total Redundancy Power :    0 W
  Total Used Power       :    9 W +/- 6W
  Total Remaining Power  :  591 W

 Internal Power
        1  300W/POE  /Connected.
        2  300W/POE  /Connected.
        3  Not Connected.
        4  Not Connected.
 External Power
        EPS1  /Not Connected.
        EPS2  /Not Connected.

Viewing PoE status on all ports
Syntax:

show power-over-ethernet brief
Displays the port power status:

PoE Port Lists all PoE-capable ports on the switch.

Power Enable Shows Yes for ports enabled to support PoE (the default) and No for ports on which PoE is
disabled.

Power Priority Lists the power priority (Low, High, and Critical) configured on ports enabled for PoE. (For
more information on this topic, see Configuring PoE operation on page 109.)

Alloc by Displays how PoE is allocated (usage, class, value).

Table Continued
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Alloc Power The maximum amount of PoE power allocated for that port (expressed in watts).Default: 17
watts for PoE; 33 watts for PoE+.

Actual Power The power actually being used on that port.

Configured Type If configured, shows the user-specified identifier for the port. If not configured, this field is
empty.

Detection Status • Searching: The port is trying to detect a PD connection.

• Delivering: The port is delivering power to a PD.

• Disabled: On the indicated port, either PoE support is disabled or PoE power is enabled
but the PoE module does not have enough power available to supply the port's power
needs.

• Fault: The switch detects a problem with the connected PD.

• Other Fault: The switch has detected an internal fault that prevents it from supplying
power on that port.

Power Class Shows the 802.3af power class of the PD detected on the indicated port. Classes include:
• 0: 0.44 to 12.95 watts can be drawn by the PD. Default class.

• 1: 0.44 to 3.84 watts

• 2: 3.84 to 6.49 watts

• 3: 6.49 to 12.95 watts

• 4: For PoE+; up to 25.5 watts can be drawn by the PD

The show power-over-ethernet brief displays this output:

show power-over-ethernet brief command output

switch(config)# show power-over-ethernet brief

 Status and Counters - System Power Status

  System Power Status  : No redundancy
  PoE Power Status     : No redundancy

  Available: 600 W Used: 9 W Remaining: 591 W

  Module A Power
  Available: 408 W Used: 9 W Remaining: 399 W

  POE   | Power   Power     Alloc Alloc  Actual Configured  Detection  Power
  Port  | Enable  Priority  By    Power  Power  Type        Status     Class
  ----- + ------- --------- ----- ------ ------ ----------- ---------- ----
  A1    | Yes     low       usage 17 W   0.0 W              Searching  0
  A2    | Yes     low       usage 17 W   0.0 W              Searching  0
  A3    | Yes     low       usage 17 W   0.0 W              Searching  0
  A4    | Yes     low       usage 17 W   0.0 W              Searching  0
  A5    | Yes     low       usage 17 W   0.0 W              Searching  0
  A6    | Yes     low       usage 17 W   8.4 W              Delivering 2
  A7    | Yes     low       usage 17 W   0.0 W              Searching  0
  A8    | Yes     low       usage 17 W   0.0 W              Searching  0
  A9    | Yes     low       usage 17 W   0.0 W              Searching  0
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You can also show the PoE information by slot:

Showing the PoE information by slot

switch(config)# show power-over-ethernet slot A

 Status and Counters - System Power Status for slot A

  Maximum Power      : 408 W           Operational Status  : On
  Power In Use       :   9 W +/- 6 W   Usage Threshold (%) : 80

Viewing the PoE status on specific ports
Syntax:

show power-over-ethernet <port-list>
Displays the following PoE status and statistics (since the last reboot) for each port in <port-list> :

Power Enable Shows Yes for ports enabled to support PoE (the default) and No for ports on which PoE is
disabled. For ports on which power is disabled, this is the only field displayed by show
power-over-ethernet <port-list> .

Priority Lists the power priority (Low, High, and Critical) configured on ports enabled for PoE. (For
more on this topic, see Configuring PoE operation on page 109.)

Allocate by How PoE is allocated (usage, class, value).

Detection Status • Searching: The port is trying to detect a PD connection.

• Delivering: The port is delivering power to a PD.

• Disabled: On the indicated port, either PoE support is disabled or PoE power is enabled
but the PoE module does not have enough power available to supply the port's power
needs.

• Fault: The switch detects a problem with the connected PD.

• Other Fault: The switch has detected an internal fault that prevents it from supplying
power on that port.

Over Current Cnt Shows the number of times a connected PD has attempted to draw more than 15.4 watts
for PoE or 24.5 watts for PoE+. Each occurrence generates an Event Log message.

Power Denied
Cnt

Shows the number of times PDs requesting power on the port have been denied because
of insufficient power available. Each occurrence generates an Event Log message.

Voltage The total voltage, in volts, being delivered to PDs.

Power The total power, in watts, being delivered to PDs.

LLDP Detect Port is enabled or disabled for allocating PoE power, based on the link-partner's capabilities
via LLDP.

Configured Type If configured, shows the user-specified identifier for the port. If not configured, the field is
empty.

Value The maximum amount of PoE power allocated for that port (expressed in watts). Default: 17
watts for PoE; 33 watts for PoE+

Table Continued
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Power Class Shows the power class of the PD detected on the indicated port. Classes include:
• 0: 0.44 to 12.95 watts

• 1: 0.44 to 3.84 watts

• 2: 3.84 to 6.49 watts

• 3: 6.49 to 12.95 watts

• 4: For PoE+; up to 25.5 watts can be drawn by the PD

MPS Absent Cnt Shows the number of times a detected PD has no longer requested power from the port.
Each occurrence generates an Event Log message. ("MPS" refers to the "maintenance
power signature.")

Short Cnt Shows the number of times the switch provided insufficient current to a connected PD.

Current The total current, in mA, being delivered to PDs.

If you want to view the PoE status of ports A6 and A7, you would use show power-over-ethernet A6-A7 to
display the data:

show power-over-ethernet <port-list> output

switch(config)# show power-over-ethernet slot A6-A7

 Status and Counters - Port Power Status for port A6

  Power Enable      : Yes
                                        LLDP Detect     : enabled
  Priority          : low               Configured Type : 
  AllocateBy        : value             Value           : 17 W
  Detection Status  : Delivering        Power Class     : 2

  Over Current Cnt  :0                  MPS Absent Cnt  : 0
  Power Denied Cnt  :0                  Short Cnt       : 0

  Voltage           : 55.1 V            Current         : 154 mA
  Power             : 8.4 W

 Status and Counters - Port Power Status for port A7

  Power Enable      : Yes
                                        LLDP Detect     : disabled
  Priority          : low               Configured Type : 
  AllocateBy        : value             Value           : 17 W
  Detection Status  : Searching         Power Class     : 0

  Over Current Cnt  :0                  MPS Absent Cnt  : 0
  Power Denied Cnt  :0                  Short Cnt       : 0

  Voltage           : 0 V               Current         : 0 mA
  Power             : 0 W

802.3bt support
IEEE 802.3bt standard enables delivering up to 90W of power across a network cable supporting all standardized
copper link speeds of up to 10G-BaseT, commonly referred to as Power over Ethernet (PoE) or 4-Pair PoE.
Earlier IEEE 802.3af and IEEE 802.3at PoE specifications permit Type 1 and 2 PSEs to deliver power over 2-
pairs of a 4-pair Ethernet cable. The IEEE 802.3bt specifications permit Type 3 and 4 PSEs to deliver power over
all 4-pairs of the Ethernet cable enabling higher efficiency and power delivery to remote devices.
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IEEE 802.3bt standard devices are backwards compatible with previous PoE standard devices, IEEE 802.3at and
IEEE 802.3af, allowing existing PoE devices to deliver or receive power up to their maximum IEEE 802.3 PoE
classification.

The 2930M switches provide modular stacking, modular 10GbE, 40GbE, or Smart Rate multi-gigabit ports, and
hot-swappable power supplies for redundancy, up to 60W PoE per port (up to 1440W PoE total**) for powering
APs, cameras, and IoT devices.

NOTE: ** The front panel ports are able push up to 60W of PoE per port. For 1440W PoE, 2x
JL087A Aruba X372 54VDC 1050W 110-240VAC Power Supplies must be installed.

NOTE: The 802.3bt support is available only on two switch models of 2930M, R0M67A and
R0M68A.

The following Aruba 2930M models provide up to 60W PoE per port** and are compatible with IEEE 802.3bt
standard (Class 6):

• Aruba 2930M 40G 8 Smart Rate PoE Class 6 1-slot Switch (R0M67A) - 36 1GbE ports; 8 Smart Rate ports (1,
2.5, 5, 10GbE); 4 dual personality ports (1SFP, 1G BASE-T - includes PoE)

• Aruba 2930M 24 Smart Rate PoE Class 6 1-slot Switch (R0M68A) - 24 Smart Rate ports (1, 2.5, 5GbE)

Some of the advantages of 802.3bt support includes:

• Reduced power loss since power is transferred from PSE to PD over all 4 pairs of wires.

• Backward compatible with 802.3af and 802.3at PDs.

• Support for Dual Signature PDs.

• Require the PD to draw a minimum amount of power to keep the connection active, 10mA minimum load.
802.3bt allows for smaller MPS pulse current and larger interval between pulses. With these changes,
significant power savings is possible in large deployments involving tens of thousands of PoE ports where both
the PSE and PD are 802.3bt compliant. The power savings that can be accomplished is big for the industrial
lighting.

Definition of terms

Term Definition

Detection Signature Resistance of PD during detection.

Classification Signature Used by PSE to identify the PD device type and vice
versa.

MPS Maintain Power Signature

Dual Signature (DS) PD Has independent detection signatures, classification
signatures, and MPS on each pair set.

Single Signature (SS) PD Shares the same detection signature, classification
signature, and MPS between both pair sets.

PLC Physical Layer Classification

DLC Data Link Layer Classification
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Table 8: PoE types, classes, standards, power needs for SS PDs

Classes Associated PoE types Associated IEEE standard Maximum power at PD port

Minimum power at PSE port

Class 0 1 802.3at 13 W / 15.4 W

Class 1 1 or 3 802.3at or 802.3bt 3.84 W / 4 W

Class 2 1 or 3 802.3at or 802.3bt 6.49 W / 7 W

Class 3 1 or 3 802.3at or 802.3bt 13 W / 15.4 W

Class 4 2 or 3 802.3at or 802.3bt 25.5 W / 30 W

Class 5 3 802.3bt 40 W / 45 W

Class 6 3 802.3bt 51 W / 60 W

Class 7 4 802.3bt 62 W / 75 W

Class 8 4 802.3bt 71.3 W / 90 W

Table 9: PoE types, classes, standards, power needs for DS PDs

Classes Associated PoE types Associated IEEE standard Maximum power at each PD
pairset

Class 1 3 or 4 802.3bt 3.84 W

Class 2 3 or 4 802.3bt 6.49 W

Class 3 3 or 4 802.3bt 13 W

Class 4 3 or 4 802.3bt 25.5 W

Class 5 4 802.3bt 35.5 W

Configuring the switch
A 802.3bt PD will be detected and powered with default switch configuration. CLI configuration is not required
when the PDs are 802.3bt compliant or 802.3af or 802.3at compliant.

Troubleshooting non-compliant PDs

If the new Class 5-8 PDs support LLDP power negotiation, the default switch configuration does not require
additional CLI configuration changes. However, if the new .Class 5-8 PDs do not support LLDP or need the
maximum PoE power at initial power up, then switch CLI config changes are required on a port basis to disable
dot3Tlvs which provide Class 6 (60W) power delivery.

[no] lldp config <port> dot3TlvEnable poeplus_config
DLC enabled

When DLC is enabled, a Class 4 and above PD can draw up to 15.4W power at the PSE side. Essentially a Class
4 or above PD is demoted to Class 3 to maintain the legacy functionality of switches where a PD can draw 15.4W
at PLC. The PD must use LLDP to negotiate for higher power. For Dual Signature PD, each channel can draw up
to 15.4W of power to ensure each port can draw a total of 30W.
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• The default switch configuration always power demotes all Class 4-8 SS PDs to Class 3 power and requires
successful LLDP dot3Tlv 29 octet power negotiation for Class 5-8 PDs or 12 octet power negotiation for Class
4 PDs before increasing the power delivery to above 16W.

• The default switch configuration always power demotes all Class 4 and above DS PDs to Class 3 power at
PLC. It requires successful LLDP dot3Tlv 29 octet power negotiation through DLC.

• The switch requires the PD to negotiate through LLDP for any power request above 13W. In this case, the
switch class demotes the PD to Class 3 power.

• The switch does not have enough available power in its reserve to supply the full power requested by the PD.
In this case, the switch offers a lower Class level of power to the PD. For example, the switch offers Class 4
power (25.4 W) or class 3 power (13 W) to a Class 5 PD or a Class 6 PD.

DLC disabled

When DLC is disabled, a PD can draw full power as requested at the PLC. This can go up to a maximum of Class
6 for Single Signature and Class 4 for Dual Signature PD.

Recommendations

• IEEE standards do not require Class 4/Type 2 PSE to interoperate with Class 5-8 PDs. However, the PLC
mutual identification in the beginning of power-up cycle will indicate to a class 5-8 PD that it is connected to
PSE capable of only 30W. If required, a class 5-8 PD can power up with 30W and operate in reduced
functionality modes.

• Some Class 5-8 PDs may require their full requested power. The PD can power up and shut down when
exceeding iCut ~33W in Class4/Type 2 switches.

• Ensure that the PSE port supports the same or higher Class than the connected PD Class for interoperability.

You can continue to use Cat5e cable deployments to deliver power. Operating at link speeds of 5Gbps or greater
may require you to limit the cable length to less than 100 meter. This limitation is imposed by the Ethernet
physical capabilities and not by the PoE standard.

Show commands
The show commands display the following:

• Dual Signature Indicator (#) which denotes the PD connected to the port is a Dual Signature PD.

• Power Delivery Indicator (*) which indicate loss of power to a port in the event of loss of a PSU powering the
port.

• Power Demotion Indicator (^) which appears when the switch is unable to supply the entire power requested
by the PD. The scenarios include:

Example of show pow br

switch(config)# show pow br
Status and Configuration Information
  System Power Status          : No redundancy
  PoE Power Status             : No redundancy
  Operational Power Status     : No redundancy
  Available: 1440 W  Used: 89 W  Remaining: 1351 W
 PoE    Pwr      Pwr      Pre-std Alloc Alloc  PSE Pwr PD Pwr PoE Port    PLC PLC
 Port   Enab     Priority Detect  Cfg   Actual Rsrvd   Draw   Status      Cls Type
 ------ ---- -------- ------- ----- ------ ------- ------- ----------- --- ---- 
 #1     Yes      low      off    usage usage  57.3 W  49.1 W  Delivering  4   3
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 2      Yes      low      off    usage usage  0.0 W   0.0 W   Searching   0   -
#10     Yes      low      on     usage usage  2.0 W   1.9 W   Delivering  3^  3
 14     Yes      low      off    usage usage  9.0 W   8.4 W   Delivering  3^  3
 24     Yes      low      off    usage lldp   7.3 W   6.9 W   Delivering  4   2
 # - Dual signature power delivery
 ^ - Power demoted ports

Example of show pow port
Example show command output at a port where LLDP is enabled for a Dual Signature PD.

Aruba-Stack-2930M(config)$ show pow 1/28

  Status and Configuration Information for port 1/28

  Power Enable      : Yes                   PoE Port Status    : Delivering
  PLC Class/Type    : 5/4                   Priority Config    : critical
  DLC Class/Type    : 5/4                   Pre-std Detect     : on
  Alloc By Config   : usage                 Configured Type    :
  Alloc By Actual   : lldp                  PoE Value Config   : n/a

  PoE Counter Information

  Over Current Cnt  : 284                   MPS Absent Cnt     : 5
  Power Denied Cnt  : 0                     Short Cnt          : 0

  LLDP Information

  PSE Allocated Power Value : 0.0 W           PSE TLV Configured : dot3, MED
  PD Requested Power Value  : 0.0 W           PSE TLV Sent Type  : dot3
  MED LLDP Detect           : Enabled         PD TLV Sent Type   : dot3

  LLDP Dual Signature Information

  PSE Allocated Power Value A : 20.0 W      PSE Allocated Power Value B : 20.0 W
  PD Requested Power Value A  : 20.0 W      PD Requested Power Value B  : 20.0 W

  Power Information

  PSE Voltage       : 54.0 V                PSE Reserved Power : 3.2 W
  PD Amperage Draw  : 57 mA                 PD Power Draw      : 3.2 W

Example show command output at a port where LLDP is disabled.

Aruba-2930M-40G-8SR-PoE-Class6(slot 1)$ show pow 1
 Status and Configuration Information for port 1
  Power Enable      : Yes                   PoE Port Status    : Delivering
  PLC Class/Type    : 4/3                   Priority Config    : low
  DLC Class/Type    : 0/-                   Pre-std Detect     : off
  Alloc By Config   : usage                 Configured Type    :
  Alloc By Actual   : usage                 PoE Value Config   : n/a
  PoE Counter Information
  Over Current Cnt  : 0                     MPS Absent Cnt     : 0
  Power Denied Cnt  : 0                     Short Cnt          : 0

  LLDP Information
  PSE Allocated Power Value : 0.0 W         PSE TLV Configured : MED
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  PD Requested Power Value  : 0.0 W         PSE TLV Sent Type  : MED
  MED LLDP Detect           : Disabled      PD TLV Sent Type   : n/a

  LLDP Dual Signature Information
  PSE Allocated Power Value A : 25.5 W      PSE Allocated Power Value B : 25.5 W
  PD Requested Power Value A  : 0.0 W       PD Requested Power Value B  : 0.0 W

  Power Information
  PSE Voltage       : 55.0 V                PSE Reserved Power : 57.4 W
  PD Amperage Draw  : 890 mA                PD Power Draw      : 49.2 W

 
Example show command output at a port for a Single Signature PD.

Aruba-2930M-40G-8SR-PoE-Class6(slot 1)$ show pow 14
 Status and Configuration Information for port 14
  Power Enable      : Yes                   PoE Port Status    : Delivering
  PLC Class/Type    : 3/3                   Priority Config    : low
  DLC Class/Type    : 0/-                   Pre-std Detect     : off
  Alloc By Config   : usage                 Configured Type    :
  Alloc By Actual   : usage                 PoE Value Config   : n/a
  PoE Counter Information
  Over Current Cnt  : 0                     MPS Absent Cnt     : 0
  Power Denied Cnt  : 0                     Short Cnt          : 0

  LLDP Information
  PSE Allocated Power Value : 8.3 W         PSE TLV Configured : dot3, MED
  PD Requested Power Value  : 0.0 W         PSE TLV Sent Type  : dot3
  MED LLDP Detect           : Disabled      PD TLV Sent Type   : n/a

  Power Information
  PSE Voltage       : 54.0 V                PSE Reserved Power : 9.0 W
  PD Amperage Draw  : 151 mA                PD Power Draw      : 8.4 W

Example of show lldp info loc/remote port
A Dual Signature PD is connected to the 2930M .3bt switch:

 LLDP Local Port Information Detail
 Port     : 1/1
 PortType : local
 PortId   : 1
 PortDesc : 1/1
 Pvid     : 1

Poe Plus Information Detail

 Poe Device Type            : Type2 PSE
 Power Source               : Primary
 Power Priority             : Low
 PD Requested Power value   : 25.5 Watts
 PSE Allocated  Power Value : 0.0 Watts
 PD Requested Power value Mode A   :  25.5 Watts
 PSE Allocated  Power Value Alt A  :  12.7 Watts
 PD Requested Power value Mode B   :  25.5 Watts
 PSE Allocated  Power Value Alt B  :  12.7 Watts

PoE Event Log messages
Please see the event log message reference guide for information about Event Log messages. To see these
manuals, go to http://www.hpe.com/networking. Auto search the model number for your switch, for Example:

Chapter 4 Power Over Ethernet (PoE/PoE+) Operation 127

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 6724

http://www.hpe.com/networking


“Switch 2920”, then select the device from the list and click on Product manuals. Click on the “User guide” link
under Manuals.
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Overview of port trunking
Port trunking allows you to assign up to eight physical links to one logical link (trunk) that functions as a single,
higher-speed link providing dramatically increased bandwidth. This capability applies to connections between
backbone devices as well as to connections in other network areas where traffic bottlenecks exist. A trunk group
is a set of up to eight ports configured as members of the same port trunk. The ports in a trunk group do not have
to be consecutive. For Example:

Figure 13: Conceptual Example: of port trunking

Port connections and configuration
All port trunk links must be point-to-point connections between a switch and another switch, router, server, or
workstation configured for port trunking. No intervening, non-trunking devices are allowed. It is important to note
that ports on both ends of a port trunk group must have the same mode (speed and duplex) and flow control
settings.

NOTE:
Link connections

The switch does not support port trunking through an intermediate, non-trunking device such as
a hub, or using more than onemedia type in a port trunk group. Similarly, for proper trunk
operation, all links in the same trunk group must have the samespeed, duplex, and flow control.

Port security restriction

Port security does not operate on a trunk group. If you configure port security on one or more
ports that are later added to a trunk group, the switch resets the port security parameters for
those ports to the factory-default configuration.

CAUTION:

To avoid broadcast storms or loops in your network while configuring a trunk, first disable or
disconnect all ports you want to add to or remove from the trunk. After you finish configuring the
trunk, enable or re-connect the ports.

Chapter 5
Port Trunking
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Port trunk features and operation
The switches covered in this guide offer these options for port trunking:

• LACP: IEEE 802.3ad—Trunk group operation using LACP on page 142

• Trunk: Non-Protocol—Trunk group operation using the "trunk" option on page 149

Up to 60 trunk groups are supported on the switches. The actual maximum depends on the number of ports
available on the switch and the number of links in each trunk. (Using the link aggregation control protocol—LACP
—option, you can include standby trunked ports in addition to the maximum of eight actively trunking ports.) The
trunks do not have to be the same size; For example, 100 two-port trunks and 11 eight-port trunks are supported.

NOTE: LACP requires full-duplex (FDx) links of the same media type (10/100Base-T, 100FX, and so
on) and the same speed, and enforces speed and duplex conformance across a trunk group. For
most installations, Hewlett Packard Enterprise Switch recommends that you leave the port Mode
settings at Auto (the default). LACP also operates with Auto-10, Auto-100, and Auto-1000 (if
negotiation selects FDx), and 10FDx, 100FDx, and 1000FDx settings. (The 10-gigabit ports
available for some switch models allow only the Auto setting.)

Fault tolerance
If a link in a port trunk fails, the switch redistributes traffic originally destined for that link to the remaining links in
the trunk. The trunk remains operable as long as there is at least one link in operation. If a link is restored, that
link is automatically included in the traffic distribution again. The LACP option also offers a standby link capability,
which enables you to keep links in reserve for service if one or more of the original active links fails. (See Trunk
group operation using LACP on page 142.)

Trunk configuration methods

Dynamic LACP trunk
The switch automatically negotiates trunked links between LACP-configured ports on separate devices, and offers
one dynamic trunk option: LACP. To configure the switch to initiate a dynamic LACP trunk with another device,
use the interface command in the CLI to set the default LACP option to active on the ports you want to use
for the trunk. For example, the following command sets ports C1 to C4 to LACP active:

switch(config) int c1-c4 lacp active
The preceding Example: works if the ports are not already operating in a trunk. To change the LACP option on
ports already operating as a trunk, you must first remove them from the trunk. For example, if ports C1 to C4 are
LACP-active and operating in a trunk with another device, you would do the following to change them to LACP-
passive:

switch(config)# no int c1-c4 lacp
Removes the ports from the trunk.

switch(config)# int c1-c4 lacp passive
Configures LACP passive.

Using keys to control dynamic LACP trunk configuration
The lacp key option provides the ability to control dynamic trunk configuration. Ports with the same key will be
aggregated as a single trunk.

There are two types of keys associated with each port, the Admin key and the Operational key. The Operational
key is the key currently in use. The Admin key is used internally to modify the value of the Operational key. The
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Admin and Operational key are usually the same, but using static LACP can alter the Operational key during
runtime, in which case the keys would differ.

The lacp key command configures both the Admin and Operational keys when using dynamic LACP trunks. It
only configures the Admin key if the trunk is a static LACP trunk. It is executed in the interface context.

Syntax:

[no] lacp [active | passive | key <0-65535>]
Sets the LACP key. During dynamic link aggregation using LACP, ports with the same key are aggregated as a
single trunk.

Enabling LACP and configuring an LACP key

switch(config)# int A2-A3 lacp active
switch(config)# int A2-A3 lacp key 500

switch(config)# show lacp

                           LACP
       LACP    Trunk   Port            LACP    Admin  Oper
  Port Enabled Group   Status  Partner Status  Key    Key
  ---- ------- ------- ------- ------- ------- ------ ------
  A2   Active  A2      Down    No      Success 500    500
  A3   Active  A3      Down    No      Success 500    500

An interface configured with a different LACP key

switch(config)# int A5 lacp active
switch(config)# int A5 lacp key 250

switch# show lacp
                           LACP
       LACP    Trunk   Port            LACP    Admin  Oper
  Port Enabled Group   Status  Partner Status  Key    Key
  ---- ------- ------- ------- ------- ------- ------ ------
  A1   Active  Dyn1    Up      Yes     Success 100    100
  A2   Active  Dyn1    Up      Yes     Success 100    100
  A3   Active  Dyn1    Up      Yes     Success 100    100
  A4   Active  Dyn1    Up      Yes     Success 100    100
  A5   Active  A5      Up      No      Success 250    250

Static trunk
The switch uses the links you configure with the Port/Trunk Settings screen in the menu interface or the trunk
command in the CLI to create a static port trunk. The switch offers two types of static trunks: LACP and Trunk.

Table 10: Trunk types used in static and dynamic trunk groups

Trunking method LACP Trunk

Dynamic Yes No

Static Yes Yes

The following table describes the trunking options for LACP and Trunk protocols.
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Table 11: Trunk configuration protocols

Protocol Trunking Options

LACP (802.3ad) Provides dynamic and static LACP trunking options.

• Dynamic LACP — Use the switch-negotiated dynamic LACP trunk when:
◦ The port on the other end of the trunk link is configured for Active or Passive LACP.

◦ You want fault-tolerance for high-availability applications. If you use an eight-link
trunk, you can also configure one or more additional links to operate as standby
links that will activate only if another active link goes down.

• Static LACP — Use the manually configured static LACP trunk when:
◦ The port on the other end of the trunk link is configured for a static LACP trunk.

◦ You want to configure non-default spanning tree or IGMP parameters on an LACP
trunk group.

◦ You want an LACP trunk group to operate in a VLAN other than the default VLAN
and GVRP is disabled. (See VLANs and dynamic LACP on page 148.)

◦ You want to use a monitor port on the switch to monitor an LACP trunk.

For more information, see Trunk group operation using LACP on page 142.

Trunk

(non-protocol)

Provides manually configured, static-only trunking to:

• Most Switches and routing switches are not running the 802.3ad LACP protocol.

• Windows NT and HPE-UX workstations and servers

Use the Trunk option when:

• The device to which you want to create a trunk link is using a non-802.3ad trunking
protocol.

• You are unsure which type of trunk to use, or the device to which you want to create a
trunk link is using an unknown trunking protocol.

• You want to use a monitor port on the switch to monitor traffic on a trunk.

See Trunk group operation using the "trunk" option on page 149.
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Table 12: General operating rules for port trunks

Media: For proper trunk operation, all ports on both ends of a trunk group must have
the same media type and mode (speed and duplex). (For the switches, it is
recommended to leave the port mode setting at Auto or, in networks using
Cat 3 cabling, Auto-10.)

Port Configuration: The default port configuration is Auto, which enables a port to sense speed
and negotiate duplex with an auto-enabled port on another device. It is
recommended that you use the Auto setting for all ports you plan to use for
trunking. Otherwise, you must manually ensure that the mode setting for each
port in a trunk is compatible with the other ports in the trunk. See:
Recommended port mode setting for LACP example

All of the following operate on a per-port basis, regardless of trunk
membership:

• Enable/Disable

• Flow control (Flow Ctrl)

LACP is a full-duplex protocol. See Trunk group operation using LACP on
page 142.

Trunk configuration: All ports in the same trunk group must be the same trunk type (LACP or trunk).
All LACP ports in the same trunk group must be either all static LACP or all
dynamic LACP.A trunk appears as a single port labeledDyn1(for an LACP
dynamic trunk) or Trk1 (for a static trunk of type LACP, Trunk) on various
menu and CLI screens. For a listing of which screens show which trunk types,
see How the switch lists trunk data on page 149.For spanning-tree or
VLAN operation, configuration for all ports in a trunk is done at the trunk level.
(You cannot separately configure individual ports within a trunk for spanning-
tree or VLAN operation.)

Traffic distribution: All of the switch trunk protocols use the SA/DA (source address/destination
address) method of distributing traffic across the trunked links. See Outbound
traffic distribution across trunked links on page 150.

Table Continued
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Spanning Tree: 802.1D (STP) and 802.1w (RSTP) Spanning Tree operate as a global setting
on the switch (with one instance of Spanning Tree per switch). 802.1s (MSTP)
Spanning Tree operates on a per-instance basis (with multiple instances
allowed per switch). For each Spanning Tree instance, you can adjust
Spanning Tree parameters on a per-port basis.A static trunk of any type
appears in the Spanning Tree configuration display, and you can configure
Spanning Tree parameters for a static trunk in the same way that you would
configure Spanning Tree parameters on a non-trunked port. (Note that the
switch lists the trunk by name—such as Trk1—and does not list the individual
ports in the trunk.) For example, if ports C1 and C2 are configured as a static
trunk named Trk1, they are listed in the Spanning Tree display as Trk1 and do
not appear as individual ports in the Spanning Tree displays. See A port trunk
in a Spanning Tree listing on page 135.When Spanning Tree forwards on a
trunk, all ports in the trunk will be forwarding. Conversely, when Spanning Tree
blocks a trunk, all ports in the trunk are blocked.

A dynamic LACP trunk operates only with the default Spanning Tree settings.
Also, this type of trunk appears in the CLI show spanning-tree display, but
not in the Spanning Tree Operation display of the Menu interface.

If you remove a port from a static trunk, the port retains the same Spanning
Tree settings that were configured for the trunk.In the below Example:, ports
C1 and C2 are members of TRK1 and do not appear as individual ports in the
port configuration part of the listing.See: A port trunk in a Spanning Tree
listing example

IP multicast protocol (IGMP): A static trunk of any type appears in the IGMP configuration display, and you
can configure IGMP for a static trunk in the same way that you would
configure IGMP on a non-trunked port. (Note that the switch lists the trunk by
name—such as Trk1—and does not list the individual ports in the trunk.) Also,
creating a new trunk automatically places the trunk in IGMP Auto status if
IGMP is enabled for the default VLAN.A dynamic LACP trunk operates only
with the default IGMP settings and does not appear in the IGMP configuration
display or show ip igmp listing.

VLANs: Creating a new trunk automatically places the trunk in the DEFAULT_VLAN,
regardless of whether the ports in the trunk were in another VLAN. Similarly,
removing a port from a trunk group automatically places the port in the default
VLAN. You can configure a static trunk in the same way that you configure a
port for membership in any VLAN.

For a dynamic LACP trunk to operate in a VLAN other than the default VLAN
(DEFAULT_VLAN), GVRP must be enabled. See Trunk group operation
using LACP on page 142.

Port security: Trunk groups (and their individual ports) cannot be configured for port security,
and the switch excludes trunked ports from the show port-security
listing. If you configure non-default port security settings for a port, then
subsequently try to place the port in a trunk, you see the following message
and the command is not executed:< port-list> Command cannot operate
over a logical port.

Monitor port: A trunk cannot be a monitor port. A monitor port can monitor a static trunk but
cannot monitor a dynamic LACP trunk.
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Recommended port mode setting for LACP

switch(config)# show interfaces config

 Port Settings

  Port  Type      | Enabled Mode         Flow Ctrl MDI
  ----- --------- + ------- ------------ --------- ----
  1     10/100TX  | Yes     Auto         Enable    Auto
  2     10/100TX  | Yes     Auto         Enable    MDI

A port trunk in a Spanning Tree listing

Port  Type      Cost Priority State      | Designated Bridge
----- --------- ---- -------- ---------- + -----------------
C3    100/1000T 5    12B      Forwarding | 0020c1-b27ac0
C4    100/1000T 5    12B      Forwarding | 0060b0-889e00
C5    100/1000T 5    12B      Disabled   | 
C6    100/1000T 5    12B      Disabled   | 
Trk1            1    64       Forwarding | 0001e7-a0ec00
 

Viewing and configuring port trunk groups (CLI)
You can list the trunk type and group for all ports on the switch or for selected ports. You can also list LACP-only
status information for LACP-configured ports.

Viewing static trunk type and group for all ports or for selected ports
Syntax:

show trunks [< port-list >]
Omitting the <port-list> parameter results in a static trunk data listing for all LAN ports in the switch.

Example:

In a switch where ports A4 and A5 belong to Trunk 1 and ports A7 and A8 belong to Trunk 2, you have the
options shown in Listing specific ports belonging to static trunks on page 135 and A show trunk listing
without specifying ports on page 136 for displaying port data for ports belonging to static trunks.

Using a port list specifies, for switch ports in a static trunk group, only the ports you want to view. In this case, the
command specifies ports A5 through A7. However, because port A6 is not in a static trunk group, it does not
appear in the resulting listing:

Listing specific ports belonging to static trunks

switch# show trunks e 5-7

 Load Balancing

  Port | Name                    Type      | Group Type
  ---- + ----------------------- --------- + ----- -----
  5    | Print-Server-Trunk      10/100TX  | Trk1  Trunk
  7    |                         10/100TX  | Trk2  Trunk
The show trunks <port-list> command in the above Example: includes a port list, and thus shows trunk
group information only for specific ports that have membership in a static trunk. In A show trunk listing without
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specifying ports on page 136, the command does not include a port list, so the switch lists all ports having static
trunk membership.

A show trunk listing without specifying ports

switch# show trunks

 Load Balancing

 Port | Name                    Type      | Group Type
 ---- + ----------------------- --------- + ----- -----
 4    | Print-Server-Trunk      10/100TX  | Trk1  Trunk
 5    | Print-Server-Trunk      10/100TX  | Trk1  Trunk
 7    |                         10/100TX  | Trk2  Trunk
 8    |                         10/100TX  | Trk2  Trunk

Viewing static LACP and dynamic LACP trunk data
Syntax:

show lacp
Lists data for only the LACP-configured ports.

Example:

Ports A1 and A2 have been previously configured for a static LACP trunk. (For more on the Active parameter,
see table "LACP port status data".)

A show LACP listing

switch# show lacp

                          LACP
       LACP     Trunk    Port              LACP     Admin  Oper
Port   Enabled  Group    Status   Partner  Status   Key    Key
----   -------  -------  -------  -------  -------  ------ ------ 
Al     Active   Trkl     Up       Yes      Success  0      250
A2     Active   Trkl     Up       Yes      Success  0      250
A3     Active   A3       Down     No       Success  0      300
A4     Passive  A4       Down     No       Success  0      0
A5     Passive  A5       Down     No       Success  0      0
A6     Passive  A6       Down     No       Success  0      0
For a description of each of the above-listed data types, see table "LACP port status data".

Dynamic LACP Standby Links
Dynamic LACP trunking enables you to configure standby links for a trunk by including more than eight ports in a
dynamic LACP trunk configuration. When eight ports (trunk links) are up, the remaining link(s) will be held in
standby status. If a trunked link that is “Up” fails, it will be replaced by a standby link, which maintains your
intended bandwidth for the trunk. (Refer to also the “Standby” entry under “Port Status” in "Table 4-5. LACP Port
Status Data".) In the next Example:, ports A1 through A9 have been configured for the same LACP trunk. Notice
that one of the links shows Standby status, while the remaining eight links are “Up”.

A Dynamic LACP trunk with one standby link

switch# show lacp
                              LACP
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       LACP      Trunk    Port                LACP    Admin    Oper
Port   Enabled   Group    Status   Partner   Status   Key      Key
----   -------   -----    ------   -------   ------   ----    -----
Al     Active     Dyn1     Up        Yes     Success   100      100
A2     Active     Dyn1     Up        Yes     Success   100      100
A3     Active     Dyn1     Up        Yes     Success   100      100
A4     Active     Dyn1     Up        Yes     Success   100      100
A5     Active     Dyn1     Up        Yes     Success   100      100
A6     Active     Dyn1     Up        Yes     Success   100      100
A7     Active     Dyn1     Up        Yes     Success   100      100
A8     Active     Dyn1     Up        Yes     Success   100      100
A9     Active     Dyn1    Standby    Yes     Success   100      100

Configuring a static trunk or static LACP trunk group
IMPORTANT: Configure port trunking before you connect the trunked links between switches.
Otherwise, a broadcast storm could occur. (If you need to connect the ports before configuring them
for trunking, you can temporarily disable the ports until the trunk is configured. See "Enabling or
Disabling Ports and Configuring Port Mode".)

The "Port trunk features and operation" section describes the maximum number of trunk groups you can
configure on the switch. An individual trunk can have up to eight links, with additional standby links if you’re using
LACP. You can configure trunk group types as follows:

Trunk Type Trunk Group Membership

TrkX (Static) DynX (Dynamic)

LACP Yes Yes

Trunk Yes No

The following examples show how to create different types of trunk groups.

Syntax:

trunk < port-list > < trk1 ... trk60 > {<trunk | lacp>}
Configures the specified static trunk type.

Example:

This Example: uses ports C4 to C6 to create a non-protocol static trunk group with the group name Trk2.

switch(config)# trunk c4-c6 trk2 trunk

Removing ports from a static trunk group
CAUTION: Removing a port from a trunk can create a loop and cause a broadcast storm. When you
remove a port from a trunk where spanning tree is not in use, The switch recommends that you first
disable the port or disconnect the link on that port.

Syntax:
no trunk <port-list>
Removes the specified ports from an existing trunk group.

Example:

To remove ports C4 and C5 from an existing trunk group:
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switch(config)# no trunk c4-c5

Enabling a dynamic LACP trunk group
In the default port configuration, all ports on the switch are set to disabled. To enable the switch to automatically
form a trunk group that is dynamic on both ends of the link, the ports on one end of a set of links must be LACP
Active. The ports on the other end can be either LACP Activeor LACP Passive. The active command enables
the switch to automatically establish a (dynamic) LACP trunk group when the device on the other end of the link is
configured for LACP Passive.

Example:

Figure 14: Criteria for automatically forming a dynamic LACP trunk

Syntax:

interface <port-list> lacp active
Configures <port-list> as LACP active. If the ports at the other end of the links on <port-list> are
configured as LACP passive, this command enables a dynamic LACP trunk group on <port-list> .

Example:

This Example: uses ports C4 and C5 to enable a dynamic LACP trunk group.

switch(config)# interface c4-c5 lacp active

Removing ports from a dynamic LACP trunk group
To remove a port from dynamic LACP trunk operation, you must turn off LACP on the port. (On a port in an
operating, dynamic LACP trunk, you cannot change between LACP Active and LACP passive without first
removing LACP operation from the port.)

CAUTION:

Unless spanning tree is running on your network, removing a port from a trunk can result in a loop.
To help prevent a broadcast storm when you remove a port from a trunk where spanning tree is not
in use, Hewlett Packard Enterprise recommends that you first disable the port or disconnect the link
on that port.
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Syntax:

no interface <port-list> lacp
Removes <port-list> from any dynamic LACP trunk and returns the ports in <port-list> to passive
LACP.

Example:

Port C6 belongs to an operating, dynamic LACP trunk. To remove port C6 from the dynamic trunk and return it to
passive LACP, do the following:

switch(config)# no interface c6 lacp
switch(config)# interface c6 lacp passive
In the above Example:, if the port on the other end of the link is configured for active LACP or static LACP, the
trunked link will be re-established almost immediately.

Specifying Minimum Active Links for LACP
Link Aggregation Control Protocol (LACP) allows the operator to configure a minimum number of active member
links in a trunk group to remain operational. When the number of active member links in the trunk is less than the
configured threshold value, the LACP trunk will be shut down. An additional option is provided to configure an
enable-timer, on expiry of which the LACP trunk brought down by the min-active-links functionality, will
be re-enabled. Once the trunk member ports are re-enabled, the validation for the active links against the
configured threshold is performed after a minute and the trunk state will be decided accordingly. The trunk will be
up and the traffic will be forwarded though the LACP trunk during this period.

NOTE:

• If the minimum active links are configured without enable-timer configuration, the LACP trunk
disabled by the feature will remain down until the operator explicitly disables and re-enables the
port or triggers a port up indication by any alternative means.

• If the number of active links in a LACP trunk is less than the threshold value, the trunk will not be
functional and traffic will not pass through the respective trunk.

• If the number of active links in the trunk drops below the threshold, the entire trunk will be brought
down and complete traffic flowing through the same will be dropped. Hence, this configuration
must be used carefully in a topology where there is a redundant traffic path.

• It is recommended to configure the min-active-links on one side of the trunk.

lacp min-active-links

Syntax
lacp min-active-links <value>

no lacp min-active-links <value>

Description

Configures the minimum threshold value for the active member links in a LACP trunk group.

The no form of this command deletes the configured threshold and sets the threshold value to default.

Command context
interface
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Example: eth-Trk

Parameters

value

Sets the threshold value for LACP trunk. The value is an integer that ranges from zero to eight which
represents the number of minimum active links. The default value is zero which disables the minimum active
links.

Example

Switch(eth-Trk11)# lacp
enable-timer          Configure the time in seconds to wait before re-enabling 
                      the trunk disabled by LACP feature for minimum active links.
key                   Set the LACP key.
mad-passthrough       Enable or disable MAD passthrough on the LACP trunks.
min-active-links      Configure the threshold for the minimum number of active
                      member links in a LACP trunk group, for it to be operational.
active                Enable active LACP.
passive               Enable passive LACP.
static                Set the mode of a static LACP port to active or passive.
Switch(eth-Trk11)# lacp min-active-links
<0-8>                 Enter a number. 
Switch(eth-Trk11)# lacp min-active-links 5
WARNING: This configuration can result in disabling the trunk, if the
number of active links in the trunk drops below the configured threshold.
Continue (y/n)? y

lacp enable-timer

Syntax
lacp enable-timer <value>

no lacp enable-timer <value>

Description

Configures the timer on expiry of which the member links disabled by LACP min-active-links functionality,
will be re-enabled.

The no form of this command deletes the configured time and sets the time to default.

Command context
interface
Example: eth-Trk

Parameters

value

Sets the time duration to wait before enabling the disabled trunk. The time duration ranges from 0 to 604800
seconds. The default value is zero which disables the timer.

Example

Switch(eth-Trk11)# lacp
enable-timer          Configure the time in seconds to wait before re-enabling 
                      the trunk disabled by LACP feature for minimum active links.
key                   Set the LACP key.
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mad-passthrough       Enable or disable MAD passthrough on the LACP trunks.
min-active-links      Configure the threshold for the minimum number of active
                      member links in a LACP trunk group, for it to be operational.
active                Enable active LACP.
passive               Enable passive LACP.
static                Set the mode of a static LACP port to active or passive.
Switch(eth-Trk11)# lacp enable-timer
<0-604800>            Enter a number.
Switch(eth-Trk11)# lacp enable-timer 120

show lacp min-active-links

Syntax
show lacp min-active-links

Description

Shows the LACP minimum active links information for each trunk group.

Example

switch# show lacp min-active-links

Trunk   Minimum active  Enable-Time
Group   Links           (seconds)
------- --------------- ------------
Trk1    0               0
Trk3    0               0
Trk11   5               120
Trk12   3               356
show running-configuration

switch# show running-config
Running configuration:

; hpStack_KB Configuration Editor; Created on release #KB.16.08.0000x
; Ver #14:0f.6f.f8.1d.fb.7f.bf.bb.ff.7c.59.fc.7b.ff.ff.fc.ff.ff.3f.ef:60

stacking
   member 1 type "JL074A" mac-address ecebb8-117400
   member 1 flexible-module A type JL079A
   member 2 type "JL074A" mac-address ecebb8-1d1580
   member 2 flexible-module A type JL079A
   member 3 type "JL075A" mac-address 1c98ec-996c80
   member 3 flexible-module A type JL083A
   member 3 flexible-module B type JL081A
   exit
hostname "Switch-2"
mirror 1 port 1/16
mirror 2 port 1/32
trunk 1/35-1/36,2/35-2/36 trk1 lacp
trunk 1/A1,1/A2,2/A1,2/A2 trk3 lacp
trunk 1/1-1/2,2/1-2/2,3/1-3/3 trk11 lacp
trunk 3/13-3/14,3/A1-3/A2 trk12 lacp
interface Trk11
   lacp min-active-links 5
   lacp enable-timer 120
   exit
interface Trk12
   lacp min-active-links 3
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   lacp enable-timer 356
   exit

Limitations

• Dynamic LACP, static trunks, and distributed trunks will not support this feature.

• The command is not available for REST/next Gen UI.

• If the LACP trunk is down due to lack of active links with the timer enabled, a dynamic update to the enable-
timer by configuration will not take effect immediately as the current timer runs with the previously configured
value.

• When the LACP trunk is blocked by min-active-links and the enable-timer is running, the member
links will be prevented from becoming operational even if there is an external intervention caused by
configuration or topology changes.

• If the enable-timer is not configured, the operator must restore the member links of the LACP trunk which
are blocked by the minimum active links.

• If there is a flap in any member links, the LACP trunk disabled by min-active-links may end up flapping
when enable-timer is not configured.

• The min-active-links feature is not supported on the previous releases (that is prior to 16.08 version). On
downgrading the switch to the previous version, the configuration will be removed without any warning.

Viewing existing port trunk groups (WebAgent)
While the WebAgent does not enable you to configure a port trunk group, it does provide a view of an existing
trunk group.

To view any port trunk groups:

1. In the navigation pane, click Interface.

2. Click Port Info/Config. The trunk information for the port displays in the Port Properties box.

Trunk group operation using LACP
The switch can automatically configure a dynamic LACP trunk group, or you can manually configure a static
LACP trunk group.

NOTE: LACP requires full-duplex (FDx) links of the same media type (10/100Base-T, 100FX, and so
on) and the same speed and enforces speed and duplex conformance across a trunk group. For
most installations, it is recommended that you leave the port mode settings at Auto (the default).
LACP also operates with Auto-10, Auto-100, and Auto-1000 (if negotiation selects FDx), and
10FDx, 100FDx, and 1000FDx settings.

LACP trunk status commands include:

Trunk display method Static LACP trunk Dynamic LACP trunk

CLI show lacp command Included in listing. Included in listing.

CLI show trunk command Included in listing. Not included.

Thus, to display a listing of dynamic LACP trunk ports, you must use the show lacp command.

142 Aruba 2930F / 2930M Management and Configuration Guide
for ArubaOS-Switch 16.08

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 6739



In most cases, trunks configured for LACP on the switches operate as described in the following table.
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Table 13: LACP trunk types

LACP port trunk
configuration

Operation

Dynamic LACP This option automatically establishes an 802.3ad-compliant trunk group, with
LACP for the port Type parameter and DynX for the port Group name, where X is
an automatically assigned value from , depending on how many dynamic and
static trunks are currently on the switch. (The switch allows a maximum of 60
trunk groups in any combination of static and dynamic trunks.)

Dynamic LACP trunks operate only in the default VLAN (unless GVRP is enabled
and Forbid is used to prevent the trunked ports from joining the default VLAN).
Thus, if an LACP dynamic port forms using ports that are not in the default VLAN,
the trunk automatically moves to the default VLAN unless GVRP operation is
configured to prevent this from occurring. In some cases, this can create a traffic
loop in your network. For more information on this topic, see VLANs and
dynamic LACP on page 148 .

Under the following conditions, the switch automatically establishes a dynamic
LACP port trunk group and assigns a port Group name:

• The ports on both ends of each link have compatible mode settings (speed
and duplex).

• The port on one end of each link must be configured for LACP Active and the
port on the other end of the same link must be configured for either LACP
Passive or LACP Active. For Example:

Either of the above link configurations allows a dynamic LACP trunk link.

Backup Links: A maximum of eight operating links are allowed in the trunk, but,
with dynamic LACP, you can configure one or more additional (backup) links that
the switch automatically activates if a primary link fails. To configure a link as a
standby for an existing eight-port dynamic LACP trunk, ensure that the ports in
the standby link are configured as either active-to-active or active-to-passive
between switches.

Displaying dynamic LACP trunk data: To list the configuration and status for a
dynamic LACP trunk, use the CLI show lacp command.

The dynamic trunk is automatically created by the switch and is not listed in the
static trunk listings available in the menu interface or in the CLI show trunk
listing.

Static LACP Provides a manually configured, static LACP trunk to accommodate these
conditions:
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LACP port trunk
configuration

Operation

• The port on the other end of the trunk link is configured for a static LACP trunk.

• You want to configure non-default Spanning Tree or IGMP parameters on an
LACP trunk group.

• You want an LACP trunk group to operate in a VLAN other than the default
VLAN and GVRP is disabled. (See VLANs and dynamic LACP on page
148.)

• You want to use a monitor port on the switch to monitor an LACP trunk.

The trunk operates if the trunk group on the opposite device is running one of the
following trunking protocols:

• Active LACP

• Passive LACP

• Trunk

This option uses LACP for the port Type parameter and TrkX for the port Group
parameter, where X is an automatically assigned value in a range corresponding
to the maximum number of trunks the switch allows. (See Port trunk features
and operation for the maximum number of trunk groups allowed on the
switches.)

Displaying static LACP trunk data : To list the configuration and status for a
static LACP trunk, use the CLI show lacp command. To list a static LACP trunk
with its assigned ports, use the CLI show trunk command or display the menu
interface Port/Trunk Settings screen.Static LACP does not allow standby ports.

Default port operation
In the default configuration, LACP is disabled for all ports. If LACP is not configured as Active on at least one end
of a link, the port does not try to detect a trunk configuration and operates as a standard, untrunked port. The
following table lists the elements of per-port LACP operation. To display this data for a switch, execute the
following command in the CLI:

switch# show lacp
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Table 14: LACP port status data

Status
name

Meaning

Port Numb Shows the physical port number for each port configured for LACP operation (C1, C2, C3 …).
Unlisted port numbers indicate that the missing ports that are assigned to a static trunk group are
not configured for any trunking.

LACP
Enabled

Active: The port automatically sends LACP protocol packets.

Passive: The port does not automatically send LACP protocol packets and responds only if it
receives LACP protocol packets from the opposite device.A link having either two active LACP
ports or one active port and one passive port can perform dynamic LACP trunking. A link having
two passive LACP ports does not perform LACP trunking because both ports are waiting for an
LACP protocol packet from the opposite device.

In the default switch configuration, LACP is disabled for all ports.

Trunk
Group

TrkX: This port has been manually configured into a static LACP trunk.

Trunk group same as port number: The port is configured for LACP, but is not a member of a
port trunk.

Port Status Up: The port has an active LACP link and is not blocked or in standby mode.

Down: The port is enabled, but an LACP link is not established. This can indicate, For example, a
port that is not connected to the network or a speed mismatch between a pair of linked ports.

Disabled: The port cannot carry traffic.

Blocked: LACP, Spanning Tree has blocked the port. (The port is not in LACP standby mode.)
This may be caused by a (brief) trunk negotiation or a configuration error, such as differing port
speeds on the same link or trying to connect the switch to more trunks than it can support. (See 
Trunk configuration protocols.)

Some older devices are limited to four ports in a trunk. When eight LACP-enabled ports are
connected to one of these older devices, four ports connect, but the other four ports are blocked.

Standby: The port is configured for dynamic LACP trunking to another device, but the maximum
number of ports for the dynamic trunk to that device has already been reached on either the switch
or the other device. This port will remain in reserve, or "standby" unless LACP detects that another,
active link in the trunk has become disabled, blocked, or down. In this case, LACP automatically
assigns a standby port, if available, to replace the failed port.

LACP
Partner

Yes: LACP is enabled on both ends of the link.

No: LACP is enabled on the switch, but either LACP is not enabled or the link has not been
detected on the opposite device.

LACP
Status

Success: LACP is enabled on the port, detects and synchronizes with a device on the other end of
the link, and can move traffic across the link.

Failure: LACP is enabled on a port and detects a device on the other end of the link, but is not
able to synchronize with this device, and therefore is not able to send LACP packets across the
link. This can be caused, For example, by an intervening device on the link (such as a hub), a bad
hardware connection, or if the LACP operation on the opposite device does not comply with the
IEEE 802.3ad standard.
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LACP notes and restrictions

802.1X (Port-based access control) configured on a port
To maintain security, LACP is not allowed on ports configured for 802.1X authenticator operation. If you configure
port security on a port on which LACP (active or passive) is configured, the switch removes the LACP
configuration, displays a notice that LACP is disabled on the port, and enables 802.1X on that port.

switch(config)# aaa port-access authenticator b1
LACP has been disabled on 802.1x port(s). 
switch(config)#
The switch does not allow you to configure LACP on a port on which port access (802.1X) is enabled. For
Example:

switch(config)# int b1 lacp passive 
Error configuring port < port-number > : LACP and 802.1x cannot 
be run together. 
switch(config)#
To restore LACP to the port, you must first remove the 802.1X configuration of the port and then re-enable LACP
active or passive on the port.

Port security configured on a port
To maintain security, LACP is not allowed on ports configured for port security. If you configure port security on a
port on which LACP (active or passive) is configured, the switch removes the LACP configuration, displays a
notice that LACP is disabled on the port, and enables port security on that port. For example:

switch(config)# port-security a17 learn-mode static address-
limit 2 LACP has been disabled on secured port(s).
switch(config)#
The switch does not allow you to configure LACP on a port on which port security is enabled. For example:

switch(config)# int a17 lacp passive
Error configuring port A17: LACP and port security cannot be
run together.
switch(config)#
To restore LACP to the port, you must remove port security and re-enable LACP active or passive.

Changing trunking methods
To convert a trunk from static to dynamic, you must first eliminate the static trunk.

Static LACP trunks
When a port is configured for LACP (active or passive), but does not belong to an existing trunk group, you can
add that port to a static trunk. Doing so disables dynamic LACP on that port, which means you must manually
configure both ends of the trunk.

Dynamic LACP trunks
You can configure a port for LACP-active or LACP-passive, but on a dynamic LACP trunk you cannot configure
the other options that you can on static trunks. If you want to manually configure a trunk, use the trunk
command.
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VLANs and dynamic LACP
A dynamic LACP trunk operates only in the default VLAN (unless you have enabled GVRP on the switch and use
Forbid to prevent the ports from joining the default VLAN).

If you want to use LACP for a trunk on a non-default VLAN and GVRP is disabled, configure the trunk as a static
trunk.

Blocked ports with older devices
Some older devices are limited to four ports in a trunk. When eight LACP-enabled ports are connected to one of
these older devices, four ports connect, but the other four ports are blocked. The LACP status of the blocked
ports is shown as "Failure."

If one of the other ports becomes disabled, a blocked port replaces it (Port Status becomes "Up"). When the other
port becomes active again, the replacement port goes back to blocked (Port Status is "Blocked"). It can take a few
seconds for the switch to discover the current status of the ports.

Blocked ports with LACP

switch(eth-B1-B8)# show lacp

                         LACP

  PORT   LACP      TRUNK   PORT     LACP      LACP
  NUMB   ENABLED   GROUP   STATUS   PARTNER   STATUS
  ----   -------   ------  ------   -------   ------
  B1     Active    Dyn1    Up       Yes       Success
  B2     Active    Dyn1    Up       Yes       Success
  B3     Active    Dyn1    Up       Yes       Success
  B4     Active    Dyn1    Up       Yes       Success
  B5     Active    Dyn1    Blocked  Yes       Failure
  B6     Active    Dyn1    Blocked  Yes       Failure
  B7     Active    B7      Down     No        Success
  B8     Active    B8      Down     No        Success
If there are ports that you do not want on the default VLAN, ensure that they cannot become dynamic LACP trunk
members. Otherwise a traffic loop can unexpectedly occur. For Example:

Figure 15: A dynamic LACP trunk forming in a VLAN can cause a traffic loop

Easy control methods include either disabling LACP on the selected ports or configuring them to operate in static
LACP trunks.
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Spanning Tree and IGMP
If Spanning Tree, IGMP, or both are enabled in the switch, a dynamic LACP trunk operates only with the default
settings for these features and does not appear in the port listings for these features.

Half-duplex, different port speeds, or both not allowed in LACP trunks
Theports on both sides of an LACP trunk must be configured for the same speed and for full-duplex (FDx). The
802.3ad LACP standard specifies a full-duplex (FDx) requirement for LACP trunking. (10-gigabit ports operate
only at FDx.)

A port configured as LACP passive and not assigned to a port trunk can be configured to half-duplex (HDx).
However, in any of the following cases, a port cannot be reconfigured to an HDx setting:

• If the port is a 10-gigabit port.

• If a port is set to LACP Active, you cannot configure it to HDx.

• If a port is already a member of a static or dynamic LACP trunk, you cannot configure it to HDx.

• If a port is already set to HDx, the switch does not allow you to configure it for a static or dynamic LACP trunk.

Dynamic/static LACP interoperation
A port configured for dynamic LACP can properly interoperate with a port configured for static (TrkX) LACP, but
any ports configured as standby LACP links are ignored.

Trunk group operation using the "trunk" option
This method creates a trunk group that operates independently of specific trunking protocols and does not use a
protocol exchange with the device on the other end of the trunk. With this choice, the switch simply uses the
SA/DA method of distributing outbound traffic across the trunked ports without regard for how that traffic is
handled by the device at the other end of the trunked links. Similarly, the switch handles incoming traffic from the
trunked links as if it were from a trunked source.

When a trunk group is configured with the trunk option, the switch automatically sets the trunk to a priority of "4"
for Spanning Tree operation (even if Spanning Tree is currently disabled). This appears in the running-config file
as spanning-tree Trkn priority 4. Executing write memory after configuring the trunk places the same
entry in the startup-config file.

Use the trunk option to establish a trunk group between a switch and another device, where the other device's
trunking operation fails to operate properly with LACP trunking configured on the switches.

How the switch lists trunk data
Static trunk group

Appears in the menu interface and the output from the CLI show trunk and show interfaces
commands.

Dynamic LACP trunk group

Appears in the output from the CLI show lacp command.
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Interface option Dynamic LACP trunk
group

Static LACP trunk group Static non-protocol

CLI show trunk No Yes Yes

CLI show interfaces No Yes Yes

CLI show lacp Yes Yes No

CLI show spanning-
tree

No Yes Yes

CLI show igmp No Yes Yes

CLI show config No Yes Yes

Outbound traffic distribution across trunked links
The two trunk group options (LACP and trunk) use SA/DA pairs for distributing outbound traffic over trunked links.
That is, the switch sends traffic from the same source address to the same destination address through the same
trunked link, and may also send traffic from the same source address to a different destination address through
the same link or a different link, depending on the mapping of path assignments among the links in the trunk.
Likewise, the switch distributes traffic for the same destination address but from different source addresses
through links depending on the path assignment.

The load-balancing is done on a per-communication basis. Otherwise, traffic is transmitted across the same path
as shown in the figure below. That is, if Client A attached to Switch 1 sends five packets of data to Server A
attached to Switch 2, the same link is used to send all five packets. The SA/DA address pair for the traffic is the
same. The packets are not evenly distributed across any other existing links between the two switches; they all
take the same path.

Figure 16: Example: of single path traffic through a trunk

The actual distribution of the traffic through a trunk depends on a calculation using bits from the SA/DA. When an
IP address is available, the calculation includes the last five bits of the IP source address and IP destination
address; otherwise, the MAC addresses are used. The result of that process undergoes a mapping that
determines which link the traffic goes through. If you have only two ports in a trunk, it is possible that all the traffic
will be sent through one port even if the SA/DA pairs are different. The more ports you have in the trunk, the more
likely it is that the traffic will be distributed among the links.
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When a new port is added to the trunk, the switch begins sending traffic, either new traffic or existing traffic,
through the new link. As links are added or deleted, the switch redistributes traffic across the trunk group. For
example, in the figure below showing a three-port trunk, traffic could be assigned as shown in the following table.

Figure 17: Example: of port-trunked network

Table 15: Example: of link assignments in a trunk group (SA/DA distribution)

Source Destination Link

Node A Node W 1

Node B Node X 2

Node C Node Y 3

Node D Node Z 1

Node A Node Y 2

Node B Node W 3

Because the amount of traffic coming from or going to various nodes in a network can vary widely, it is possible
for one link in a trunk group to be fully utilized while other links in the same trunk have unused bandwidth capacity,
even if the assignments were evenly distributed across the links in a trunk.

Trunk load balancing using port layers
Trunk load balancing using port layers allows the use of TCP/UDP source and destination port number for trunk
load balancing. This is in addition to the current use of source and destination IP address and MAC addresses.
Configuration of Layer 4 load balancing would apply to all trunks on the switch. Only non-fragmented packets will
have their TCP/UDP port number used by load balancing. This ensures that all frames associated with a
fragmented IP packet are sent through the same trunk on the same physical link.

The priority for using layer packet information when this feature is enabled is as follows:

Procedure

1. L4-based: If the packet protocol is an IP packet, use Layer 4, or Layer 3, or Layer 2 information, whichever is
present, in that order.

2. L3-based: If the packet protocol is an IP packet, use Layer 3, or Layer 2 information, whichever is present, in
that order.

3. L2-based: If the packet protocol is an IP packet use Layer 2 information.

4. For all options, if the packet is not an IP packet, use Layer 2 information.

Enabling trunk load balancing
Enter the following command to enable load balancing.
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Syntax:

trunk-load-balance L3-based | [L4-based >]
This option enables load balancing based on port layer information. The configuration is executed in global
configuration context and applies to the entire switch.

Default: L3-based load balancing

L2-based: Load balance based on Layer 2 information.

L3-based: Load balance based on Layer 3 information if present, or Layer 2 information.

L4-based: Load balance on Layer 4 port information if present, or Layer 3 if present, or Layer 2.

Enabling L4-based trunk load balancing

switch(config)# trunk-load-balance L4 based

Output when L4-based trunk load balancing is enabled

Switch(config)# show trunk

Load Balancing Method: L4-based

 Port | Name                          Type      | Group  Type
 ---- + ----------------------------- --------- + ------ -------
 41                                   100/1000T   Trk1   Trunk
 42                                   100/1000T   Trk1   Trunk
Note in Running config file when L4-based trunk load balancing is enabled on page 152 that in if L4 trunk
load balancing is enabled, a line appears in the running-config file. If it is not enabled, nothing appears as this is
the default and the default values are not displayed.

Running config file when L4-based trunk load balancing is enabled

switch(config)# show running-config

Running configuration

; J9091A Configuration Editor; Created on release #XX.15.02.0001x

hostname "Switch"
module 1 type J8702A
module 5 type J9051A
module 7 type J8705A
module 10 type J8708A
module 12 type J8702A
trunk-load-balance L4-based
vlan 1
   name "DEFAULT_VLAN"
   untagged A1-A24, G1-G24, J1-J4, L1-L24
   ip address dhcp-bootp
   tagged EUP
   no untagged EDP
   exit
snmp-server community "public" unrestricted
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Rate-limiting
CAUTION: Rate-limiting is intended for use on edge ports in a network. It is not recommended for
use on links to other switches, routers, or servers within a network, or for use in the network core.
Doing so can interfere with applications the network requires to function properly.

All traffic rate-limiting
Rate-limiting for all traffic operates on a per-port basis to allow only the specified bandwidth to be used for
inbound or outbound traffic. When traffic exceeds the configured limit, it is dropped. This effectively sets a usage
level on a given port and is a tool for enforcing maximum service level commitments granted to network users.
This feature operates on a per-port level and is not configurable on port trunks. Rate-limiting is designed to be
applied at the network edge to limit traffic from non-critical users or to enforce service agreements such as those
offered by Internet Service Providers (ISPs) to provide only the bandwidth for which a customer has paid.

NOTE:

Rate-limiting also can be applied by a RADIUS server during an authentication client session.
Applying rate-limiting to desirable traffic is not recommended. For further details, see "RADIUS
Authentication and Accounting" in the access security guide for your switch.

The switches also support ICMP rate-limiting to mitigate the effects of certain ICMP-based attacks.

ICMP traffic is necessary for network routing functions. For this reason, blocking all ICMP traffic is not
recommended.

Configuring in/out rate-limiting
Syntax:

[no] int <port-list> rate-limit all <in|out> percent <0-100>|kbps <0-100000000>>
Configures a traffic rate limit (on non-trunked ports) on the link. The no form of the command disables rate-limiting
on the specified ports.

The rate-limit all command controls the rate of traffic sent or received on a port by setting a limit on the
bandwidth available. It includes options for:

• Rate-limiting on inbound or outbound traffic.

• Specifying the traffic rate as either a percentage of bandwidth, or in terms of bits per second.

(Default: Disabled.)

in or out Specifies a traffic rate limit on inbound traffic passing through that port or on outbound traffic.

percent or
kbps

Specifies the rate limit as a percentage of total available bandwidth, or in kilobits per second.
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NOTE:

The granularity of actual limits may vary across different switch models.

For more details on configuring rate-limiting, see All traffic rate-limiting on page 153.

Notes:

• The rate-limit icmp command specifies a rate limit on inbound ICMP traffic only (see ICMP rate-limiting
on page 157).

• Rate-limiting does not apply to trunked ports (including meshed ports).

• Kbps rate-limiting is done in segments of 1% of the lowest corresponding media speed. For example, if the
media speed is 1 Kbps, the value would be 1 Mbps. A 1-100 Kbps rate-limit is implemented as a limit of 100
Kbps; a limit of 100-199 Kbps is also implemented as a limit of 100 Kbps, a limit of 200-299 Kbps is
implemented as a limit of 200 Kbps, and so on.

• Percentage limits are based on link speed. For example, if a 100 Mbps port negotiates a link at 100 Mbps and
the inbound rate-limit is configured at 50%, then the traffic flow through that port is limited to no more than 50
Mbps. Similarly, if the same port negotiates a 10 Mbps link, then it allows no more than 5 Mbps of inbound
traffic.Configuring a rate limit of 0 (zero) on a port blocks all traffic on that port. However, if this is the
desired behavior on the port, Hewlett Packard Enterprise recommends using the <port-list> disable
command instead of configuring a rate limit of 0.

You can configure a rate limit from either the global configuration level or from the port context level. For example,
either of the following commands configures an inbound rate limit of 60% on ports 3 – 5:

switch(config)# int 3-5 rate-limit all in percent 60
switch(eth-3-5)# rate-limit all in percent 60

Displaying the current rate-limit configuration
The show rate-limit all command displays the per-port rate-limit configuration in the running-config file.

Syntax:

show rate-limit all [<port-list>]
Without [port-list] , this command lists the rate-limit configuration for all ports on the switch.

With [port-list] , this command lists the rate-limit configuration for the specified ports. This command
operates the same way in any CLI context.

If you want to view the rate-limiting configuration on the first six ports:

Example:

Listing the rate-limit configuration on page 154 shows a rate-limiting configuration for the first six ports. In this
instance:

• Ports 1–4 are configured with an outbound rate limit of 200 Kbps.

• Port 5 is configured with an inbound rate limit of 20%.

• Port 6 is not configured for rate-limiting.

Listing the rate-limit configuration

switch# show rate-limit all 1-6
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 All-Traffic Rate Limit Maximum %

         | Inbound            Radius      | Outbound           Radius
  Port   | Limit     Mode     Override    | Limit     Mode     Override
  ------ + --------- -------- ----------- + --------- -------- --------
  1      | Disabled  Disabled No-override | 200       kbps     No-override
  2      | Disabled  Disabled No-override | 200       kbps     No-override
  3      | Disabled  Disabled No-override | 200       kbps     No-override
  4      | Disabled  Disabled No-override | 200       kbps     No-override
  5      | 20        %        No-override | Disabled  Disabled No-override
  6      | Disabled  Disabled No-override | Disabled  Disabled No-override

NOTE: To view RADIUS-assigned rate-limit information, use one of the following command options:

show port-access
    web-based clients <port-list> detailed
    mac-based clients <port-list> detailed
    authenticator clients <port-list> detailed
    
For more on RADIUS-assigned rate-limits, see title "Configuring RADIUS Server Support for Switch
Services" in the latest Management and Configuration Guide for your switch.

The show running command displays the currently applied setting for any interfaces in the switch configured for
all traffic rate-limiting and ICMP rate limiting.

The show config command displays this information for the configuration currently stored in the startup-
config file. (Note that configuration changes performed with the CLI, but not followed by a write mem
command, do not appear in the startup-config file.)

Rate-limit settings listed in the show config output

switch# show config

Startup configuration: 3

; J9727A Configuration Editor; Created on release #WB.15.18.0000x
; Ver #09:14.29.eb.8f.fc.f3.ff.37.2d:ba

hostname "Switch"
module 1 type j9727a
interface 1
   rate-limit all out kbps 200
   exit
interface 2
   rate-limit all out kbps 200
   exit
interface 3
   rate-limit all out kbps 200
   exit
interface 4
   rate-limit all out kbps 200
   exit
interface 5
   rate-limit all in percent 20
   exit
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Operating notes for rate-limiting
• Rate-limiting operates on a per-port basis, regardless of traffic priority. Rate-limiting is available on all

types of ports (other than trunked ports) and at all port speeds configurable for these switches.

• Rate-limiting on a trunk is not allowed for the all, bcast, icmp, and mcast traffic types. Rate-limiting is
not supported on ports configured in a trunk group (including mesh ports). Configuring a port for rate-limiting
and then adding it to a trunk suspends rate-limiting on the port while it is in the trunk. Attempting to configure
rate-limiting on a port that already belongs to a trunk generates the following message:<port-list> :
Operation is not allowed for a trunked port.

• Rate-limiting and hardware. The hardware will round the actual Kbps rate down to the nearest multiple of 64
Kbps.

• Rate-limiting is visible as an outbound forwarding rate. Because inbound rate-limiting is performed on
packets during packet-processing, it is not shown via the inbound drop counters. Instead, this limit is verifiable
as the ratio of outbound traffic from an inbound rate-limited port versus the inbound rate. For outbound rate-
limiting, the rate is visible as the percentage of available outbound bandwidth (assuming that the amount of
requested traffic to be forwarded is larger than the rate-limit).

• Operation with other features. Configuring rate-limiting on a port where other features affect port queue
behavior (such as flow control) can result in the port not achieving its configured rate-limiting maximum. For
example, in a situation where flow control is configured on a rate-limited port, there can be enough "back
pressure" to hold high-priority inbound traffic from the upstream device or application to a rate that is lower
than the configured rate limit. In this case, the inbound traffic flow does not reach the configured rate and lower
priority traffic is not forwarded into the switch fabric from the rate-limited port. (This behavior is termed "head-
of-line blocking" and is a well-known problem with flow-control.)In another type of situation, an outbound port
can become oversubscribed by traffic received from multiple rate-limited ports. In this case, the actual rate for
traffic on the rate-limited ports may be lower than configured because the total traffic load requested to the
outbound port exceeds the port's bandwidth, and thus some requested traffic may be held off on inbound.

• Traffic filters on rate-limited ports. Configuring a traffic filter on a port does not prevent the switch from
including filtered traffic in the bandwidth-use measurement for rate-limiting when it is configured on the same
port. For example, ACLs, source-port filters, protocol filters, and multicast filters are all included in bandwidth
usage calculations.

• Monitoring (mirroring) rate-limited interfaces. If monitoring is configured, packets dropped by rate-limiting
on a monitored interface are still forwarded to the designated monitor port. (Monitoring shows what traffic is
inbound on an interface, and is not affected by "drop" or "forward" decisions.)

• Optimum rate-limiting operation. Optimum rate-limiting occurs with 64-byte packet sizes. Traffic with larger
packet sizes can result in performance somewhat below the configured bandwidth. This is to ensure the
strictest possible rate-limiting of all sizes of packets.
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NOTE: Rate-limiting is applied to the available bandwidth on a port and not to any specific
applications running through the port. If the total bandwidth requested by all applications is less than
the configured maximum rate, then no rate-limit can be applied. This situation occurs with a number
of popular throughput-testing applications, as well as most regular network applications. Consider the
following Example: that uses the minimum packet size:

The total available bandwidth on a 100 Mbps port "X" (allowing for Inter-packet Gap—IPG), with no
rate-limiting restrictions, is:

(((100,000,000 bits) / 8 ) / 84) × 64 = 9,523,809 bytes per second
where:

• The divisor (84) includes the 12-byte IPG, 8-byte preamble, and 64-bytes of data required to
transfer a 64-byte packet on a 100 Mbps link.

• Calculated "bytes-per-second" includes packet headers and data. This value is the maximum
"bytes-per-second" that 100 Mbps can support for minimum-sized packets.

Suppose port "X" is configured with a rate limit of 50% (4,761,904 bytes). If a throughput-testing
application is the only application using the port and transmits 1 Mbyte of data through the port, it
uses only 10.5% of the port's available bandwidth, and the rate-limit of 50% has no effect. This is
because the maximum rate permitted (50%) exceeds the test application's bandwidth usage
(126,642-164,062 bytes, depending upon packet size, which is only 1.3% to 1.7% of the available
total). Before rate-limiting can occur, the test application's bandwidth usage must exceed 50% of the
port's total available bandwidth. That is, to test the rate-limit setting, the following must be true:

bandwidth usage (0.50 × 9,523,809)

ICMP rate-limiting
In IP networks, ICMP messages are generated in response to either inquiries or requests from routing and
diagnostic functions. These messages are directed to the applications originating the inquiries. In unusual
situations, if the messages are generated rapidly with the intent of overloading network circuits, they can threaten
network availability. This problem is visible in denial-of-service (DoS) attacks or other malicious behaviors where a
worm or virus overloads the network with ICMP messages to an extent where no other traffic can get through.
(ICMP messages themselves can also be misused as virus carriers). Such malicious misuses of ICMP can
include a high number of ping packets that mimic a valid source IP address and an invalid destination IP address
(spoofed pings), and a high number of response messages (such as Destination Unreachable error messages)
generated by the network.

ICMP rate-limiting provides a method for limiting the amount of bandwidth that may be used for inbound ICMP
traffic on a switch port. This feature allows users to restrict ICMP traffic to percentage levels that permit necessary
ICMP functions, but throttle additional traffic that may be caused by worms or viruses (reducing their spread and
effect). In addition, ICMP rate-limiting preserves inbound port bandwidth for non-ICMP traffic.

CAUTION:

ICMP is necessary for routing, diagnostic, and error responses in an IP network. ICMP rate-limiting is
primarily used for throttling worm or virus-like behavior and should normally be configured to allow
one to five percent of available inbound bandwidth (at 10 Mbps or 100 Mbps speeds) or 100 to
10,000 kbps (1Gbps or 10 Gbps speeds) to be used for ICMP traffic. This feature should not be
used to remove all ICMP traffic from a network.
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NOTE:

ICMP rate-limiting does not throttle non-ICMP traffic. In cases where you want to throttle both ICMP
traffic and all other inbound traffic on a given interface, you can separately configure both ICMP rate-
limiting and all-traffic rate-limiting.

The all-traffic rate-limiting command (rate-limit all) and the ICMP rate-limiting command
(rate-limit icmp) operate differently:

• All-traffic rate-limiting applies to both inbound and outbound traffic and can be specified either in
terms of a percentage of total bandwidth or in terms of bits per second;

• ICMP rate-limiting applies only to inbound traffic and can be specified as only a percentage of
total bandwidth.

Guidelines for configuring ICMP rate-limiting
Apply ICMP rate-limiting on all connected interfaces on the switch to effectively throttle excessive ICMP
messaging from any source. Figure 18: Example: of ICMP rate-limiting on page 158 shows an Example: of
how to configure this for a small to mid-sized campus though similar rate-limit thresholds are applicable to other
network environments. On edge interfaces, where ICMP traffic should be minimal, a threshold of 1% of available
bandwidth should be sufficient for most applications. On core interfaces, such as switch-to-switch and switch-to-
router, a maximum threshold of 5% should be sufficient for normal ICMP traffic. ("Normal" ICMP traffic levels
should be the maximums that occur when the network is rebooting.)

Figure 18: Example: of ICMP rate-limiting

Configuring ICMP rate-limiting
For detailed information about ICMP rate-limiting, see ICMP rate-limiting on page 157.

The rate-limit icmp command controls inbound usage of a port by setting a limit on the bandwidth available
for inbound ICMP traffic.

Syntax:

[no] int <port-list> rate-limit icmp {< percent < 0-100 > | kbps < 0-10000000 > | [trap-clear>]}

Configures inbound ICMP traffic rate-limiting. You can configure a rate limit from either the global configuration
level (as shown above) or from the interface context level. The no form of the command disables ICMP rate-
limiting on the specified interfaces.
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(Default: Disabled.)

percent <1-100> Values in this range allow ICMP traffic as a percentage of the bandwidth available
on the interface.

kbps <0-10000000> Specifies the rate at which to forward traffic in kilobits per second.

0 Causes an interface to drop all incoming ICMP traffic and is not recommended.
See the caution.

trap-clear Clears existing ICMP rate limiting trap condition.

Note: ICMP rate-limiting is not supported on meshed ports. (Rate-limiting can reduce the efficiency of paths
through a mesh domain).

Example:

Either of the following commands configures an inbound rate limit of 1% on ports A3 to A5, which are used as
network edge ports:

switch(config) # int a3-a5 rate-limit icmp 1
switch(eth-A3-A5) # rate-limit icmp 1

NOTE: When using kbps-mode ICMP rate-limiting, the rate-limiting only operates on the IP payload
part of the ICMP packet (as required by metering RFC 2698). This means that effective metering is
at a rate greater than the configured rate, with the disparity increasing as the packet size decreases
(the packet to payload ratio is higher).

Also, in kbps mode, metering accuracy is limited at low values, For example, less than 45 Kbps. This
is to allow metering to function well at higher media speeds such as 10 Gbps.

For information on using ICMP rate-limiting and all-traffic rate-limiting on the same interface, seeUsing both
ICMP rate-limiting and all-traffic rate-limiting on the same interface on page 159.

Using both ICMP rate-limiting and all-traffic rate-limiting on the same
interface
ICMP and all-traffic rate-limiting can be configured on the same interface. All-traffic rate-limiting applies to all
inbound or outbound traffic (including ICMP traffic), while ICMP rate-limiting applies only to inbound ICMP traffic.

NOTE: If the all-traffic load on an interface meets or exceeds the currently configured all-traffic
inbound rate-limit while the ICMP traffic rate-limit on the same interface has not been reached, all
excess traffic is dropped, including any inbound ICMP traffic above the all-traffic limit (regardless of
whether the ICMP rate-limit has been reached).

Example:

Suppose:

• The all-traffic inbound rate-limit on port "X" is configured at 55% of the port's bandwidth.

• The ICMP traffic rate-limit on port "X" is configured at 2% of the port's bandwidth.

If at a given moment:
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• Inbound ICMP traffic on port "X" is using 1% of the port's bandwidth, and

• Inbound traffic of all types on port "X" demands 61% of the ports's bandwidth,

all inbound traffic above 55% of the port's bandwidth, including any additional ICMP traffic, is dropped as long as
all inbound traffic combined on the port demands 55% or more of the port's bandwidth.

Viewing the current ICMP rate-limit configuration
The show rate-limit icmp command displays the per-interface ICMP rate-limit configuration in the running-
config file.

Syntax:

show rate-limit icmp [< port-list >]
Without [port-list], this command lists the ICMP rate-limit configuration for all ports on the switch.

With [port-list], this command lists the rate-limit configuration for the specified interfaces. This command operates
the same way in any CLI context

If you want to view the rate-limiting configuration on ports 1–6:

Listing the rate-limit configuration

switch(config)# show rate-limit icmp 1-6

 Inbound ICMP Rate Limit Maximum Percentage

        |          Rate
  Port  | Mode     Limit
  ----- + -------- --------
  1     | Disabled Disabled
  2     | kbps     100
  3     | %        5
  4     | %        1
  5     | %        1
  6     | Disabled Disable
The show running command displays the currently applied setting for any interfaces in the switch configured for
all traffic rate-limiting and ICMP rate-limiting.

The show config command displays this information for the configuration currently stored in the startup-
config file. (Note that configuration changes performed with the CLI, but not followed by a write mem
command, do not appear in the startup-config file.)

Operating notes for ICMP rate-limiting
ICMP rate-limiting operates on an interface (per-port) basis to allow, on average, the highest expected amount of
legitimate, inbound ICMP traffic.

• Interface support: ICMP rate-limiting is available on all types of ports (other than trunk ports or mesh ports),
and at all port speeds configurable for the switch.

• Rate-limiting is not permitted on mesh ports: Either type of rate-limiting (all-traffic or ICMP) can reduce the
efficiency of paths through a mesh domain.

• Rate-limiting on a trunk is not allowed for the all, bcast, icmp, and mcast traffic types. Neither all-
traffic nor ICMP rate-limiting are supported on ports configured in a trunk group.
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• ICMP percentage-based rate-limits are calculated as a percentage of the negotiated link speed: For
example, if a 100 Mbps port negotiates a link to another switch at 100 Mbps and is ICMP rate-limit configured
at 5%, the inbound ICMP traffic flow through that port is limited to 5 Mbps. Similarly, if the same port negotiates
a 10 Mbps link, it allows 0.5 Mbps of inbound traffic. If an interface experiences an inbound flow of ICMP traffic
in excess of its configured limit, the switch generates a log message and an SNMP trap (if an SNMP trap
receiver is configured).

• ICMP rate-limiting is port-based: ICMP rate-limiting reflects the available percentage of an interface's entire
inbound bandwidth. The rate of inbound flow for traffic of a given priority and the rate of flow from an ICMP
rate-limited interface to a particular queue of an outbound interface are not measures of the actual ICMP rate
limit enforced on an interface.

• Below-maximum rates: ICMP rate-limiting operates on a per-interface basis, regardless of traffic priority.
Configuring ICMP rate-limiting on an interface where other features affect inbound port queue behavior (such
as flow control) can result in the interface not achieving its configured ICMP rate-limiting maximum. For
example, in some situations with flow control configured on an ICMP rate-limited interface, there can be
enough "back pressure" to hold high-priority inbound traffic from the upstream device or application to a rate
that does not allow bandwidth for lower-priority ICMP traffic. In this case, the inbound traffic flow may not
permit the forwarding of ICMP traffic into the switch fabric from the rate-limited interface. (This behavior is
termed "head-of-line blocking" and is a well-known problem with flow-control.) In cases where both types of
rate-limiting (rate-limit all and rate-limit icmp) are configured on the same interface, this situation
is more likely to occur.

In another type of situation, an outbound interface can become oversubscribed by traffic received from multiple
ICMP rate-limited interfaces. In this case, the actual rate for traffic on the rate-limited interfaces may be lower
than configured because the total traffic load requested to the outbound interface exceeds the interface's
bandwidth, and thus some requested traffic may be held off on inbound.

• Monitoring (mirroring) ICMP rate-limited interfaces: If monitoring is configured, packets dropped by ICMP
rate-limiting on a monitored interface are still forwarded to the designated monitor port. (Monitoring shows
what traffic is inbound on an interface, and is not affected by "drop" or "forward" decisions.)

• Optimum rate-limiting operation: Optimum rate-limiting occurs with 64-byte packet sizes. Traffic with larger
packet sizes can result in performance somewhat below the configured inbound bandwidth. This is to ensure
the strictest possible rate-limiting of all sizes of packets.

• Outbound traffic flow: Configuring ICMP rate-limiting on an interface does not control the rate of outbound
traffic flow on the interface.

ICMP rate-limiting trap and Event Log messages
If the switch detects a volume of inbound ICMP traffic on a port that exceeds the ICMP rate-limit configured for
that port, it generates one SNMP trap and one informational Event Log message to notify the system operator of
the condition. (The trap and Event Log message are sent within two minutes of when the event occurred on the
port.) For Example:

I 06/30/05 11:15:42 RateLim: ICMP traffic exceeded configured limit on port A1
These trap and Event Log messages provide an advisory that inbound ICMP traffic on a given interface has
exceeded the configured maximum. The additional ICMP traffic is dropped, but the excess condition may indicate
an infected host (or other traffic threat or network problem) on that interface. The system operator should
investigate the attached devices or network conditions further; the switch does not send more traps or Event Log
messages for excess ICMP traffic on the affected port until the system operator resets the port's ICMP trap
function.

The switch does not send more traps or Event Log messages for excess ICMP traffic on the affected port until the
system operator resets the port’s ICMP trap function. The reset can be done through SNMP from a network
management station or through the CLI with the trap-clear command option.
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Syntax:

interface <port-list> rate-limit icmp trap-clear
On a port configured with ICMP rate-limiting, this command resets the ICMP trap function, which allows the switch
to generate a new SNMP trap and an Event Log message if ICMP traffic in excess of the configured limit is
detected on the port.

Example:

An operator noticing an ICMP rate-limiting trap or Event Log message originating with port 1 on a switch would
use the following command to reset the port to send a new message if the condition occurs again:

Switch(config)# interface 1 rate-limit icmp trap-clear

Determining the switch port number used in ICMP port reset commands
To enable excess ICMP traffic notification traps and Event Log messages, use the setmib command described
on ICMP rate-limiting trap and Event Log messages on page 161. The port number included in the command
corresponds to the internal number the switch maintains for the designated port and not the port's external
identity.

To match the port's external slot/number to the internal port number, use the walkmib ifDescr command, as
shown in the following example:

Matching internal port numbers to external port numbers

switch# walkmib ifDescr
ifDescr.1 = 1
ifDescr.2 = 2
ifDescr.3 = 3
ifDescr.4 = 4
ifDescr.5 = 5
ifDescr.6 = 6
ifDescr.7 = 7
ifDescr.8 = 8
ifDescr.9 = 9
ifDescr.10 = 10
ifDescr.11 = 11
ifDescr.12 = 12
ifDescr.13 = 13
ifDescr.14 = 14
ifDescr.15 = 15
ifDescr.16 = 16
ifDescr.17 = 17
ifDescr.18 = 18
ifDescr.19 = 19
ifDescr.20 = 20
ifDescr.21 = 21
ifDescr.22 = 22
ifDescr.23 = 23
ifDescr.24 = 24
ifDescr.210 = Trk1
ifDescr.211 = Trk2
ifDescr.330 = DEFAULT_VLAN
ifDescr.4425 = Switch software loopback interface
ifDescr.4426 = Switch software loopback interface
.
.
.
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Configuring inbound rate-limiting for broadcast and multicast traffic
You can configure rate-limiting (throttling) of inbound broadcast and multicast traffic on the switch, which helps
prevent the switch from being disrupted by traffic storms if they occur on the rate-limited port. The rate-limiting is
implemented as a percentage of the total available bandwidth on the port.

The rate-limit command can be executed from the global or interface context, for Example:

switch(config)# interface 3 rate-limit bcast in percent 10
or

switch(config)# interface 3
switch(eth-3)# rate-limit bcast in percent 10
Syntax:

rate-limit {< bcast | mcast >} in percent < 0-100 > 

Option
in percent <0-100>
Also supports configuring limit in kbps

[no] rate-limit {<bcast | [mcast >]} in
Enables rate-limiting and sets limits for the specified inbound broadcast or multicast traffic. Only the amount of
traffic specified by the percent is forwarded.

Default: Disabled

If you want to set a limit of 50% on inbound broadcast traffic for port 3, you can first enter interface context for port
3 and then execute the rate-limit command, as shown in Inbound broadcast rate-limiting of 50% on port 3
on page 163. Only 50% of the inbound broadcast traffic will be forwarded.

Inbound broadcast rate-limiting of 50% on port 3

switch(config)# int 3
switch(eth-3)# rate-limit bcast in percent 50

switch(eth-3)# show rate-limit bcast
 Broadcast-Traffic Rate Limit Maximum %

  Port  | Inbound Limit Mode      Radius Override
  ----- + ------------- --------- ---------------
  1     | Disabled      Disabled  No-override
  2     | Disabled      Disabled  No-override
  3     | Disabled      %         No-override
  4     | Disabled      Disabled  No-override
  5     | Disabled      Disabled  No-override
If you rate-limit multicast traffic on the same port, the multicast limit is also in effect for that port, as shown in 
Inbound multicast rate-limiting of 20% on port 3 on page 164. Only 20% of the multicast traffic will be
forwarded.
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Inbound multicast rate-limiting of 20% on port 3

switch(eth-3)# rate-limit mcast in percent 20
switch(eth-3)# show rate-limit mcast
 
 Multicast-Traffic Rate Limit Maximum %

  Port  | Inbound Limit Mode      Radius Override
  ----- + ------------- --------- ---------------
  1     | Disabled      Disabled  No-override
  2     | Disabled      Disabled  No-override
  3     | 20            %         No-override
  4     | Disabled      Disabled  No-override
To disable rate-limiting for a port enter the no form of the command, as shown in Disabling inbound multicast
rate-limiting for port 3 on page 164.

Disabling inbound multicast rate-limiting for port 3

switch(eth-3)# no rate-limit mcast in

switch(eth-3)# show rate-limit mcast
 
 Multicast-Traffic Rate Limit Maximum %

  Port  | Inbound Limit Mode      Radius Override
  ----- + ------------- --------- ---------------
  1     | Disabled      Disabled  No-override
  2     | Disabled      Disabled  No-override
  3     | Disabled      Disabled  No-override
  4     | Disabled      Disabled  No-override

Operating Notes
The following information is displayed for each installed transceiver:

• Port number on which transceiver is installed.

• Type of transceiver.

• Product number — Includes revision letter, such as A, B, or C. If no revision letter follows a product number,
this means that no revision is available for the transceiver.

• Part number — Allows you to determine the manufacturer for a specified transceiver and revision number.

• For a non-Aruba switches installed transceiver, no transceiver type, product number, or part information is
displayed. In the Serial Number field, non-operational is displayed instead of a serial number.

• The following error messages may be displayed for a non-operational transceiver:

◦ Unsupported Transceiver. (SelfTest Err#060)
◦ This switch only supports revision B and above transceivers.
◦ Self test failure.
◦ Transceiver type not supported in this port.
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◦ Transceiver type not supported in this software version.
◦ Not an Switch Transceiver.

Guaranteed minimum bandwidth (GMB)
GMB provides a method for ensuring that each of a given port's outbound traffic priority queues has a specified
minimum consideration for sending traffic out on the link to another device. This can prevent a condition where
applications generating lower-priority traffic in the network are frequently or continually "starved" by high volumes
of higher-priority traffic. You can configure GMB per-port and, in the case of the 2920 and 5400R switches, per
static trunk.

GMB operation
NOTE: Earlier software releases supported GMB configuration on a per-port basis. Beginning with
software release 15.18, the 2920 and 5400R switches also support GMB configuration on static
trunks. (GMB configuration is not supported on dynamic LACP or distributed (DT) trunks.

For application to static trunk interfaces (2920 and 5400r only), GMB enforcement is applied
individually to each port belonging to the trunk, and not to the trunk as a whole.

For any port, group of ports or, static trunks, you can use the default minimum bandwidth settings for each
outbound priority queue or a customized bandwidth profile. It is also possible to disable the feature entirely.

The switch services per-port outbound traffic in a descending order of priority; that is, from the highest priority to
the lowest priority. By default, each port (including each port in a static trunk) offers eight prioritized, outbound
traffic queues. Tagged VLAN traffic is prioritized according to the 802.1p priority the traffic carries. Untagged
VLAN traffic is assigned a priority of 0 (normal).

Table 16: Per-port outbound priority queues

802.1p Priority settings in tagged VLAN packets1 Outbound priority queue for a given port

1 (low) 1

2 (low) 2

0 (normal) 3

3 (normal) 4

4 (medium) 5

5 (medium) 6

6 (high) 7

7 (high) 8

1 The switch processes outbound traffic from an untagged port at the "0" (normal) priority level.

You can use GMB to reserve a specific percentage of each port's available outbound bandwidth for each of the
eight priority queues. This means that regardless of the amount of high-priority outbound traffic on a port
(including each port in a static trunk), you can ensure that there will always be bandwidth reserved for lower-
priority traffic.
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Since the switch services outbound traffic according to priority (highest to lowest), the highest-priority outbound
traffic on a given port automatically receives the first priority in servicing. Thus, in most applications, it is
necessary only to specify the minimum bandwidth you want to allocate to the lower priority queues. In this case,
the high-priority traffic automatically receives all unassigned bandwidth without starving the lower-priority queues.

Conversely, configuring a bandwidth minimum on only the high-priority outbound queue of a port or static trunk
(and not providing a bandwidth minimum for the lower-priority queues) is not recommended, because it may
"starve" the lower-priority queues.

NOTE: For a given port, when the demand on one or more outbound queues exceeds the minimum
bandwidth configured for those queues, the switch apportions unallocated bandwidth to these
queues on a priority basis. As a result, specifying a minimum bandwidth for a high-priority queue but
not specifying a minimum for lower-priority queues can starve the lower-priority queues during
periods of high demand on the high priority queue. For example, if a port or static trunk configured to
allocate a minimum bandwidth of 80% for outbound high-priority traffic experiences a demand above
this minimum, this burst starves lower-priority queues that do not have a minimum configured.
Normally, this will not altogether halt lower priority traffic on the network, but will likely cause delays
in the delivery of the lower-priority traffic.

The sum of the GMB settings for all outbound queues on a given port or static trunk cannot exceed
100%.

Impacts of QoS queue configuration on GMB operation
The section Configuring GMB for outbound traffic on page 167 assumes the ports on the switch offer eight
prioritized, outbound traffic queues. This may not always be the case, however, because the switch supports a
QoS queue configuration feature that allows you to reduce the number of outbound queues from eight (the
default) to four queues, or two.

Changing the number of queues affects the GMB commands (interface bandwidth-min and show
bandwidth output) such that they operate only on the number of queues currently configured. If the queues
are reconfigured, the guaranteed minimum bandwidth per queue is automatically re-allocated according to the
following percentages:

Table 17: Default GMB percentage allocations per QoS queue configuration

802.1p priority 8 queues (default) 4 queues 2 queues

1 (lowest) 2% 10% 90%

2 3%

0 (normal) 30% 70%

3 10%

4 10% 10% 10%

5 10%

6 15% 10%

7 (highest) 20%

NOTE: For more information on queue configuration and the associated default minimum bandwidth
settings, see the "Quality of Service (QoS): managing bandwidth more effectively" in the advanced
traffic management guide for your switch.
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Configuring GMB for outbound traffic
For any port, group of ports, or static trunk, you can configure either the default minimum bandwidth settings for
each outbound priority queue or a customized bandwidth allocation. For most applications, Hewlett Packard
Enterprise recommends configuring GMB with the same values on all ports on the switch so that the outbound
traffic profile is consistent for all outbound traffic. However, there may be instances where it may be advantageous
to configure special profiles on connections to servers or to the network infrastructure (such as links to routers,
other switches, or to the network core).

Syntax:

[no] int <port-list|trk_#> bandwidth-min output
Configures the default minimum bandwidth allocation for the outbound priority queue for each port or static trunk
in the <port-list|trk_#> . In the eight-queue configuration, the default values per priority queue are:

• Queue 1 (low priority): 2%

• Queue 2 (low priority): 3%

• Queue 3 (normal priority): 30%

• Queue 4 (normal priority): 10%

• Queue 5 (medium priority): 10%

• Queue 6 (medium priority): 10%

• Queue 7 (high priority): 15%

• Queue 8 (high priority): 20%

The no form of the command disables GMB for all ports and trunks in the <port-list> . In this state, which is
the equivalent of setting all outbound queues on a port or static trunk to 0 (zero), a high level of higher-priority
traffic can starve lower-priority queues, which can slow or halt lower-priority traffic in the network.

You can configure bandwidth minimums from either the global configuration level (as shown above) or from the
port or static trunk context level. For information on outbound port queues, see Per-port outbound priority
queues.

Syntax:

[no] int <<port-list|trk_#>> bandwidth-min output [0-100|strict] [0-100]
Select a minimum bandwidth.

For ports and trunks in <port-list|trk_#> , specifies the minimum outbound bandwidth as a percent of the
total bandwidth for each outbound queue. The queues receive service in descending order of priority of each port.

NOTE: For application to static trunk interfaces (2920 and 5400R only), GMB enforcement is applied
individually to each port belonging to the trunk, and not to the trunk as a whole.

You must specify a bandwidth percent value for all except the highest priority queue, which may instead be set to
"strict" mode. The sum of the bandwidth percentages below the top queue cannot exceed 100%. (0 is a value for
a queue percentage setting.)

Configuring a total of less than 100% across the eight queues results in unallocated bandwidth that remains
harmlessly unused unless a given queue becomes oversubscribed. In this case, the unallocated bandwidth is
apportioned to oversubscribed queues in descending order of priority. For example, if you configure a minimum of
10% for queues 1 to 7 and 0% for queue 8, the unallocated bandwidth is available to all eight queues in the
following prioritized order:
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Queue 8 (high priority)
Queue 7 (high priority)
Queue 6 (medium priority)
Queue 5 (medium priority)
Queue 4 (normal priority)
Queue 3 (normal priority)
Queue 2 (low priority)
Queue 1 (low priority)

A setting of 0 (zero percent) on a queue means that no bandwidth minimum is specifically reserved for that queue
for each of the ports (including trunked ports) in the <port-list|trk_#> .

Also, there is no benefit to setting the high-priority queue (queue 8) to 0 (zero) unless you want the medium
queue (queues 5 and 6) to be able to support traffic bursts above its guaranteed minimum.

[strict]: Provides the ability to configure the highest priority queue as strict. Per-queue values must be
specified in priority order, with queue 1 having the lowest priority and queue 8 (or 4, or 2) having the highest
priority (the highest queue is determined by how many queues are configured on the switch. Two, four, and eight
queues are permitted (see the qos queue-config command). The strict queue is provided all the bandwidth it
needs. Any remaining bandwidth is shared among the non-strict queues based on need and configured
bandwidth profiles (the profiles are applied to the leftover bandwidth in this case). The total sum of percentages
for non-strict queues must not exceed 100.

NOTE: Configuring 0% for a queue can result in that queue being starved if any higher queue
becomes over-subscribed and is then given all unused bandwidth.

The switch applies the bandwidth calculation to the link speed the port or trunk is currently using. For
example, if a 10/100 Mbs port negotiates to 10 Mbps on the link, it bases its GMB calculations on 10
Mbps, not 100 Mbps.

Use show bandwidth output <<port-list|trk_#>> to display the current GMB
configuration. (The show config and show running commands do not include GMB
configuration data.)

Example:

For example, suppose you want to configure the following outbound minimum bandwidth availability for ports 1
and 2:

Priority of
outbound port
queue

Minimum
bandwidth %

Effect on outbound bandwidth allocation

8 20% Queue 8 has the first priority use of all outbound bandwidth not
specifically allocated to queues 1 to 7.

If, For example, bandwidth allocated to queue 5 is not being used
and queues 7 and 8 become oversubscribed, queue 8 has first-
priority use of the unused bandwidth allocated to queue 5.

7 15% Queue 7 has a GMB of 15% available for outbound traffic. If queue
7 becomes oversubscribed and queue 8 is not already using all of
the unallocated bandwidth, queue 7 can use the unallocated
bandwidth.

Also, any unused bandwidth allocated to queues 6 to queue 1 is
available to queue 7 if queue 8 has not already claimed it.

Table Continued
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Priority of
outbound port
queue

Minimum
bandwidth %

Effect on outbound bandwidth allocation

6 10% Queue 6 has a GMB of 10% and, if oversubscribed, is subordinate
to queues 8 and 7 in priority for any unused outbound bandwidth
available on the port.

5 10% Queue 5 has a GMB of 10% and, if oversubscribed, is subordinate
to queues 8, 7, and 6 for any unused outbound bandwidth
available on the port.

4 10% Queue 4 has a GMB of 10% and, if oversubscribed, is subordinate
to queues, 8, 7, 6, and 5 for any unused outbound bandwidth
available on the port.

3 30% Queue 3 has a GMB of 30% and, if oversubscribed, is subordinate
to queues, 8, 7, 6, 5, and 4 for any unused outbound bandwidth
available on the port.

2 3% Queue 2 has a GMB of 3% and, if oversubscribed, is subordinate
to queues, 8, 7, 6, 5, 4, and 3 for any unused outbound bandwidth
available on the port.

1 2% Queue 1 has a GMB of 2% and, if oversubscribed, is subordinate
to all the other queues for any unused outbound bandwidth
available on the port.

Either of the following commands configures ports 1 through 5 with bandwidth settings:

Switch(config) # int 1-5 bandwidth-min output 2 3 30 10 10 10 15 strict
Switch(interface 1–5) # bandwidth-min output 2 3 30 10 10 10 15 strict

Viewing the current GMB configuration
This command displays the per-port GMB configuration in the running-config file.

Syntax:

show bandwidth output <port-list|trk_#>
Without <port-list|trk_#> , this command lists the GMB configuration for all ports and static trunks on the
switch.

With <port-list|trk_#> , this command lists the GMB configuration for the specified ports and static trunks.

This command operates the same way in any CLI context. If the command lists Disabled for a port or trunk,
there are no bandwidth minimums configured for any queue on the port or trunk. (See the description of the no
form of the bandwidth-min output command.)

Listing the GMB configuration on page 169 displays the GMB configuration resulting from either of the above
commands.

Listing the GMB configuration

switch(config)# show bandwidth output 1-5, trk1
 Outbound Guaranteed Minimum Bandwidth %
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  Port   Q1  Q2     Q3  Q4     Q5  Q6  Q7  Q8
  ------ --- ------ --- ------ --- --- --- ------
  1      2   3      30  10     10  10  15  strict
  2      2   3      30  10     10  10  15  strict
  3      2   3      30  10     10  10  15  strict
  4      2   3      30  10     10  10  15  strict
  5      2   3      30  10     10  10  15  strict
  Trk1   2   3      30  10     10  10  15  strict

GMB operating notes

Impact of QoS queue configuration on GMB commands
Changing the number of queues causes the GMB commands (interface bandwidth-min and show
bandwidth output) to operate only on the number of queues currently configured. In addition, when the qos
queue-config command is executed, any previously configured bandwidth-min output settings are
removed from the startup configuration. For the default GMB percentage allocations per number of queues, see 
Default GMB percentage allocations per QoS queue configuration.

Rate-limiting Unknown Unicast Traffic
Unknown unicast traffic consists of unicast packets with unknown destination MAC addresses. The switch floods
the unicast packets to all interfaces that are members of the VLAN. An attacker can bring down the network by
sending out packets to random destination MAC addresses and hence it is important to rate limit traffic with
unknown destination addresses.

You can rate limit the unknown unicast traffic per port level in either percent or kbps mode.

rate-limit unknown-unicast in percent
Syntax
interface port-list rate-limit unknown-unicast in percent 0-100

Description

Sets a rate limit for unicast flood traffic.

Command context
interface

Parameters
in

Sets a rate limit for incoming unicast flood traffic.

percent
Specifies the rate limit as a percentage of the total available bandwidth.

kbps
Specifies the rate limit in Kb/s.

Examples

switch(config)# int 2
switch(eth-2)# rate-limit
all                   Set a rate limit for all traffic.
bcast                 Set a rate limit for broadcast traffic.
icmp                  Set a rate limit for ICMP traffic.
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mcast                 Set a rate limit for multicast traffic.
queues                Set a rate limit for each traffic queue.
unknown-unicast       Set a rate limit for unicast flood traffic.
switch(eth-2)# rate-limit unknown-unicast
in                    Set a rate limit for incoming unicast flood traffic.
switch(eth-2)# rate-limit unknown-unicast in
kbps
percent
switch(eth-2)# rate-limit unknown-unicast in percent 10
switch(eth-2)# show rate-limit
 bcast                 Show broadcast traffic rate limits.
 icmp                  Show ICMP traffic rate limits.
 mcast                 Show multicast traffic rate limits.
 queues                Show limits for outgoing queue traffic.
 unknown-unicast       Show unicast flood traffic rate limits.
switch(eth-2)# show rate-limit unknown-unicast
 [ethernet] PORT-LIST  The ports to show information for.

switch(eth-2)# show rate-limit unknown-unicast 2

 Unknown-Unicast Traffic Rate Limit Maximum %

  Port  | Inbound Limit Mode
  ----- + ------------- ---------
  2     | 10            %

rate-limit unknown-unicast in kbps
Syntax
interface port-list rate-limit unknown-unicast in kbps rate

Description

Sets a rate limit for unicast flood traffic.

Command context
interface

Parameters
in

Sets a rate limit for incoming unicast flood traffic.

percent
Specifies the rate limit as a percentage of the total available bandwidth.

kbps
Specifies the rate limit in Kb/s.

Examples

switch(config)# int 1
switch(eth-1)# rate-limit
all                   Set a rate limit for all traffic.
bcast                 Set a rate limit for broadcast traffic.
icmp                  Set a rate limit for ICMP traffic.
mcast                 Set a rate limit for multicast traffic.
queues                Set a rate limit for each traffic queue.
unknown-unicast       Set a rate limit for unicast flood traffic.
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switch(eth-1)# rate-limit unknown-unicast
in                    Set a rate limit for incoming unicast flood traffic.
switch(eth-1)# rate-limit unknown-unicast  in
kbps
percent
switch(eth-1)# rate-limit unknown-unicast  in kbps 100
switch(eth-1)# show rate-limit
all                   Show total traffic rate limits.
bcast                 Show broadcast traffic rate limits.
icmp                  Show ICMP traffic rate limits.
mcast                 Show multicast traffic rate limits.
queues                Show limits for outgoing queue traffic.
unknown-unicast       Show unicast flood traffic rate limits.
switch(eth-1)# show rate-limit unknown-unicast

Unknown-Unicast Traffic Rate Limit Maximum %

  Port  | Inbound Limit Mode
  ----- + ------------- ---------
  1     | 100            kbps
  2     | Disabled      Disabled
  3     | Disabled      Disabled
  4     | Disabled      Disabled
  5     | Disabled      Disabled
  6     | Disabled      Disabled
  7     | Disabled      Disabled
  8     | Disabled      Disabled
  9     | Disabled      Disabled
  10    | Disabled      Disabled
  11    | Disabled      Disabled
  12    | Disabled      Disabled
  13    | Disabled      Disabled
  14    | Disabled      Disabled
  15    | Disabled      Disabled
  16    | Disabled      Disabled

show rate-limit unknown-unicast
Syntax
show rate-limit unknown-unicast

Description

Displays the per port rate limit configuration.

Command context
interface

Parameters
ethernet <port-list>

To view the rate limit configuration for the specified port.

Examples

switch(eth-2)# show rate-limit unknown-unicast

 Unknown-Unicast Traffic Rate Limit Maximum %

  Port  | Inbound Limit Mode
  ----- + ------------- ---------
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  1     | 10            kbps
  2     | 10            %
  3     | Disabled      Disabled
  4     | Disabled      Disabled
  5     | Disabled      Disabled
  6     | Disabled      Disabled
  7     | Disabled      Disabled
  8     | Disabled      Disabled
  9     | Disabled      Disabled
  10    | Disabled      Disabled
  11    | Disabled      Disabled
  12    | Disabled      Disabled
  13    | Disabled      Disabled
  14    | Disabled      Disabled
  15    | Disabled      Disabled
  16    | Disabled      Disabled
  17    | Disabled      Disabled
  18    | Disabled      Disabled

Jumbo frames
The maximum transmission unit(MTU) is the maximum size IP frame the switch can receive for Layer 2 frames
inbound on a port. The switch drops any inbound frames larger than the MTU allowed on the port. Ports operating
at a minimum of 1 Gbps can accept forward frames of up to 9220 bytes (including four bytes for a VLAN tag)
when configured for jumbo traffic. You can enable inbound jumbo frames on a per-VLAN basis. That is, on a
VLAN configured for jumbo traffic, all ports belonging to that VLAN and operating at a minimum of 1 Gbps allow
inbound jumbo frames of up to 9220 bytes.

Operating rules
• Required port speed: This feature allows inbound and outbound jumbo frames on ports operating at a

minimum of 1 Gbps.

• GVRP operation: A VLAN enabled for jumbo traffic cannot be used to create a dynamic VLAN. A port
belonging to a statically configured, jumbo-enabled VLAN cannot join a dynamic VLAN.

• Port adds and moves: If you add a port to a VLAN that is already configured for jumbo traffic, the switch
enables that port to receive jumbo traffic. If you remove a port from a jumbo-enabled VLAN, the switch
disables jumbo traffic capability on the port only if the port is not currently a member of another jumbo-enabled
VLAN. This same operation applies to port trunks.

• Jumbo traffic sources: A port belonging to a jumbo-enabled VLAN can receive inbound jumbo frames
through any VLAN to which it belongs, including non-jumbo VLANs. For example, if VLAN 10 (without jumbos
enabled) and VLAN 20 (with jumbos enabled) are both configured on a switch, and port 1 belongs to both
VLANs, port 1 can receive jumbo traffic from devices on either VLAN. For a method to allow only some ports in
a VLAN to receive jumbo traffic, see Configuring a maximum frame size on page 177.

Jumbo traffic-handling
• Configuring a voice VLAN to accept jumbo frames is not recommended. Voice VLAN frames are typically

small, and allowing a voice VLAN to accept jumbo frame traffic can degrade the voice transmission
performance.

• You can configure the default, primary, and/or (if configured) the management VLAN to accept jumbo frames
on all ports belonging to the VLAN.

• When the switch applies the default MTU (1522-bytes including 4 bytes for the VLAN tag) to a VLAN, all ports
in the VLAN can receive incoming frames of up to 1522 bytes. When the switch applies the jumbo MTU (9220
bytes including 4 bytes for the VLAN tag) to a VLAN, all ports in that VLAN can receive incoming frames of up
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to 9220 bytes. A port receiving frames exceeding the applicable MTU drops such frames, causing the switch to
generate an Event Log message and increment the "Giant Rx" counter (displayed by show interfaces
<port-list> ).

• The switch allows flow control and jumbo frame capability to co-exist on a port.

• The default MTU is 1522 bytes (including 4 bytes for the VLAN tag). The jumbo MTU is 9220 bytes (including 4
bytes for the VLAN tag).

• When a port is not a member of any jumbo-enabled VLAN, it drops all jumbo traffic. If the port is receiving
"excessive"inbound jumbo traffic, the port generates an Event Log message to notify you of this condition. This
same condition also increments the switch's "Giant Rx" counter.

• If you do not want all ports in a given VLAN to accept jumbo frames, you can consider creating one or more
jumbo VLANs with a membership comprising only the ports you want to receive jumbo traffic. Because a port
belonging to one jumbo-enabled VLAN can receive jumbo frames through any VLAN to which it belongs, this
method enables you to include both jumbo-enabled and non-jumbo ports within the same VLAN.

For example, suppose you want to allow inbound jumbo frames only on ports 6, 7, 12, and 13. However, these
ports are spread across VLAN 100 and VLAN 200 and also share these VLANs with other ports you want
excluded from jumbo traffic. A solution is to create a third VLAN with the sole purpose of enabling jumbo traffic
on the desired ports, while leaving the other ports on the switch disabled for jumbo traffic. That is:

VLAN 100 VLAN 200 VLAN 300

Ports 6-10 11-15 6, 7, 12, and 13

Jumbo-enabled? No No Yes

If there are security concerns with grouping the ports as shown for VLAN 300, you can either use source-port
filtering to block unwanted traffic paths or create separate jumbo VLANs, one for ports 6 and 7, and another for
ports 12 and 13.

• Outbound jumbo traffic. Any port operating at 1 Gbps or higher can transmit outbound jumbo frames through
any VLAN, regardless of the jumbo configuration. The VLAN is not required to be jumbo-enabled, and the port
is not required to belong to any other, jumbo-enabled VLANs. This can occur in situations where a non-jumbo
VLAN includes some ports that do not belong to another, jumbo-enabled VLAN and some ports that do belong
to another, jumbo-enabled VLAN. In this case, ports capable of receiving jumbo frames can forward them to
the ports in the VLAN that do not have jumbo capability, as shown in Figure 19: Forwarding jumbo frames
through non-jumbo ports on page 174.

Figure 19: Forwarding jumbo frames through non-jumbo ports

Jumbo frames can also be forwarded out non-jumbo ports when the jumbo frames received inbound on a
jumbo-enabled VLAN are routed to another, non-jumbo VLAN for outbound transmission on ports that have no
memberships in other, jumbo-capable VLANs. Where either of the above scenarios is a possibility, the
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downstream device must be configured to accept the jumbo traffic. Otherwise, this traffic will be dropped by
the downstream device.

Configuring jumbo frame operation
For detailed information about jumbo frames, see Jumbo frames on page 173.

Overview

1. Determine the VLAN membership of the ports or trunks through which you want the switch to accept inbound
jumbo traffic. For operation with GVRP enabled, refer to the GVRP topic under “Operating Rules”, above.

2. Ensure that the ports through which you want the switch to receive jumbo frames are operating at least at
gigabit speed. (Check the Mode field in the output for the show interfaces brief <port-list>
command.)

3. Use the jumbo command to enable jumbo frames on one or more VLANs statically configured in the switch.
(All ports belonging to a jumbo-enabled VLAN can receive jumbo frames.

4. Execute write memory to save your configuration changes to the startupconfig file.

Viewing the current jumbo configuration
Syntax:

show vlans
Lists the static VLANs configured on the switch and includes a Jumbo column to indicate which VLANs are
configured to support inbound jumbo traffic. All ports belonging to a jumbo-enabled VLAN can receive jumbo
traffic. (For more information, see Configuring a maximum frame size on page 177.) See Figure Figure 20:
Example: listing of static VLANs to show jumbo status per VLAN on page 175.

Figure 20: Example: listing of static VLANs to show jumbo status per VLAN

Syntax:

show vlans ports <port-list>
Lists the static VLANs to which the specified ports belong, including the Jumbo column to indicate which VLANs
are configured to support jumbo traffic.

Entering only one port in <port-list > results in a list of all VLANs to which that port belongs.

Entering multiple ports in <port-list > results in a superset list that includes the VLAN memberships of all
ports in the list, even though the individual ports in the list may belong to different subsets of the complete VLAN
listing.

Example:
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If port 1 belongs to VLAN 1, port 2 belongs to VLAN 10, and port 3 belongs to VLAN 15, executing this command
with a port-list of 1 - 3 results in a listing of all three VLANs, even though none of the ports belong to all three
VLANS. (See Figure 21: Listing the VLAN memberships for a range of ports on page 176.)

Figure 21: Listing the VLAN memberships for a range of ports

Syntax:

show vlans <vid>
Shows port membership and jumbo configuration for the specified vid . (See Figure 22: Example: of listing the
port membership and jumbo status for a VLAN on page 176.)

Figure 22: Example: of listing the port membership and jumbo status for a VLAN

Enabling or disabling jumbo traffic on a VLAN
Syntax:

vlan <vid> jumbo

[no] vlan <vid> jumbo
Configures the specified VLAN to allow jumbo frames on all ports on the switch that belong to that VLAN. If the
VLAN is not already configured on the switch, vlan <vid> jumbo also creates the VLAN.

A port belonging to one jumbo VLAN can receive jumbo frames through any other VLAN statically configured on
the switch, regardless of whether the other VLAN is enabled for jumbo frames.

The [no] form of the command disables inbound jumbo traffic on all ports in the specified VLAN that do not also
belong to another VLAN that is enabled for jumbo traffic. In a VLAN context, the command forms are jumbo and
no jumbo.

(Default: Jumbos disabled on the specified VLAN.)
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Configuring a maximum frame size
You can globally set a maximum frame size for jumbo frames that will support values from 1518 bytes to 9216
bytes for untagged frames.

Syntax:

jumbo max-frame-size <size>
Sets the maximum frame size for jumbo frames. The range is from 1518 bytes to 9216 bytes. (Default: 9216
bytes)

NOTE:

The jumbo max-frame-size is set on a GLOBAL level.

Default: 9216 bytes

Configuring IP MTU
NOTE:

The following feature is available on the switches covered in this guide. jumbos support is required
for this feature. On switches that do not support this command, the IP MTU value is derived from the
maximum frame size and is not configurable.

You can set the IP MTU globally by entering this command. The value of max-frame-size must be greater than
or equal to 18 bytes more than the value selected for ip-mtu. For example, if ip-mtu is set to 8964, the max-
frame-size is configured as 8982.

Syntax:

jumbo ip-mtu <size>
Globally sets the IP MTU size. Values range between 1500 and 9198 bytes. This value must be 18 bytes less
than the value of max-frame-size.

(Default: 9198 bytes)

SNMP implementation
Jumbo maximum frame size
The maximum frame size for jumbos is supported with the following proprietary MIB object:

hpSwitchMaxFrameSize OBJECT-TYPE
This is the value of the global max-frame-size supported by the switch. The default value is set to 9216 bytes.

Jumbo IP MTU
The IP MTU for jumbos is supported with the following proprietary MIB object:

hpSwitchIpMTU OBJECT-TYPE
This is the value of the global jumbos IP MTU (or L3 MTU) supported by the switch. The default value is set to
9198 bytes (a value that is 18 bytes less than the largest possible maximum frame size of 9216 bytes). This
object can be used only in switches that support max-frame-size and ip-mtu configuration.

Displaying the maximum frame size
Use the show jumbos command to display the globally configured untagged maximum frame size for the switch,
as shown in the following Example:.
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switch(config)# show jumbos

 Jumbos Global Values

  Configured : MaxFrameSize : 9216   Ip-MTU : 9198
  In Use     : MaxFrameSize : 9216   Ip-MTU : 9198
For more information about frame size, see Jumbo frames on page 173.

Operating notes for maximum frame size
• When you set a maximum frame size for jumbo frames, it must be on a global level. You cannot use the

jumbo max-frame-size command on a per-port or per-VLAN basis.

• The original way to configure jumbo frames remains the same, which is per-VLAN, but you cannot set a
maximum frame size per-VLAN.

• Jumbo support must be enabled for a VLAN from the CLI or through SNMP.

• Setting the maximum frame size does not require a reboot.

• When you upgrade to a version of software that supports setting the maximum frame size from a version that
did not, the max-frame-size value is set automatically to 9216 bytes.

• Configuring a jumbo maximum frame size on a VLAN allows frames up to max-frame-size even though
other VLANs of which the port is a member are not enabled for jumbo support.

Troubleshooting

A VLAN is configured to allow jumbo frames, but one or more ports drops all inbound
jumbo frames
The port may not be operating at a minimum of 1 Gbps on the other switches covered in this guide. Regardless of
a port's configuration, if it is actually operating at a speed lower than 1 Gbps for the other switches, it drops
inbound jumbo frames. For example, if a port is configured for Auto mode (speed-duplex auto), but has
negotiated a 7 Mbps speed with the device at the other end of the link, the port cannot receive inbound jumbo
frames. To determine the actual operating speed of one or more ports, view the Mode field in the output for the
following command:

show interfaces brief <port-list>

A non-jumbo port is generating "Excessive undersize/giant frames" messages in the
Event Log
The switches can transmit outbound jumbo traffic on any port, regardless of whether the port belongs to a jumbo
VLAN. In this case, another port in the same VLAN on the switch may be jumbo-enabled through membership in
a different, jumbo-enabled VLAN, and may be forwarding jumbo frames received on the jumbo VLAN to non-
jumbo ports.

Fault Finder
Fault Finder is a feature that helps administrators to debug unusual network activity such as flapping links or
transceivers or to troubleshoot issues such as multicast or broadcast storms. Fault Finder helps in preventing
network loops and taking care of situations that arise out of defective equipment and malicious attacks.

The following is the list of issues detected by the Fault Finder:

• Excessive CRC/alignment errors (bad cable)

• Excessive flapping of transceivers (bad transceiver)
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• Too many undersized/giant packets (bad driver)

• Excessive late collisions (cable too long)

• High collision or drop rate (over bandwidth)

• Excessive broadcast packets (broadcast storm)

• Excessive multicast packets (multicast storm)

• Duplex mismatch (duplex mismatch HDx - reconfigure to Full Duplex)

• Duplex mismatch (duplex mismatch FDx - reconfigure port to Auto)

• Rapid detection of link faults and recoveries (link flap)

• Link loss detection (loss of link)

NOTE: Fault finder is also known as FFI (find-fix-inform).

Fault Finder thresholds
Switches feature automatic fault detection, which helps protect against network loops and defective equipment.
The fault detection sensitivity setting determines the types of alerts reported to the Alert Log based on their level
of severity or sensitivity. The sensitivity levels are:

• High Sensitivity.

This policy directs the switch to send all alerts to the Alert Log. This setting is most effective on networks that
have none or few problems.

• Medium Sensitivity. This policy directs the switch to send alerts related to network problems to the Alert Log.
If you want to be notified of problems which cause a noticeable slowdown on the network, use this setting.

• Low Sensitivity. This policy directs the switch to send only the most severe alerts to the Alert Log. This policy
is most effective on a network where there are normally a lot of problems and you want to be informed of only
the most severe ones

• Disabled. Disables the Alert Log and transmission of alerts (traps) to the management server (in cases where
a network management tool such as ProCurve Manager is in use). Use this option when you don’t want to use
the Alert Log.

Enabling Fault Finder
Enter this CLI command to enable fault detection:

Syntax:

[no] fault-finder [fault][sensitivity <low|medium|high>][action <warn|warn-and-disable>]
Enables or disables Fault Finder and sets sensitivity.

When the warn-and-disable action option is configured, Fault Finder may also shut down a bad port in
addition to sending an alert to the Alert Log.

Default setting: fault-finder sensitivity medium action warn
[fault]: Supported values are:
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• all: All fault types

• bad-driver: Too many undersized/giant packets

• bad-transceiver: Excessive jabbering

• bad-cable: Excessive CRC/alignment errors

• too-long-cable: Excessive late collisions

• over-bandwidth: High collision or drop rate

• broadcast-storm: Excessive broadcasts

• duplex-mismatch-HDx: Duplex mismatch. Reconfigure to Full Duplex

• duplex-mismatch-FDx: Duplex mismatch. Reconfigure port to Auto

• link-flap: Rapid detection of link faults and recoveries

• loss-of-link: Link loss detected. (Sensitivity not applicable)

Examples:

To set Fault Finder with a high sensitivity to issue a warning and then disable a port on which there is a high
collision or drop rate, you could configure these options:

switch(config)# fault-finder over-bandwidth sensitivity 
high action warn-and-disable
To set Fault Finder with a medium sensitivity to issue a warning about excessive CRC or alignment errors on a
port, you could configure these options:

switch(config)# fault-finder bad-cable sensitivity 
medium action warn
To set Fault Finder with a low sensitivity to issue a warning about rapid detection of link faults, you could
configure these options:

switch(config)# fault-finder link-flap sensitivity 
low action warn
To disable Fault Finder, enter this command:

switch(config)# no fault-finder all
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Table 18: Fault finder sensitivities for supported conditions

Condition
triggering
fault finder

Sensitivities Units (in
packets)

Time period Fault finder
reacts:

High Medium Low

Bad driver —
Too many
under-sized
packets or too
many giant
packets

6 21 36 1/10,000
Incoming

20 secs If (undersized/
total) >=
(sensitivity/
10,000)OrIf
(giant/total) >=
(sensitivity/
10,000)

Bad
transceiver —
Excessive
jabbering -
Jabbers:
(Jabbers are
packets
longer than
the MTU) -
Fragments:
(packets
shorter than
they should
be)

65 2110 3614 1/10,000
IncomingOne
Fragments

20 secs20
secs

If (jabbers/
total) >=
(sensitivity/
10,000)Or If
fragment
count in the
last 20
seconds >=
sensitivity

Bad cable —
Excessive
CRC/
alignment
errors

6 21 36 1/10,000
Incoming

20 secs If (CRC and
alignment
errors/ total)
>= (sensitivity/
10,000)

Too Long
Cable —
Excessive late
collisions (a
late collision
error occurs
after the first
512 bit times)

6 21 36 1/10,000
Outgoing

20 secs If (late
collisions/
total) >=
(sensitivity/
10,000)

Table Continued
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Condition
triggering
fault finder

Sensitivities Units (in
packets)

Time period Fault finder
reacts:

Over
bandwidth -
High collision
rate -High
drop rate

665 21257 36449 1/10,000
OutgoingOne
Packet

5 mins5 mins If (excessive
collisions/
total) >=
(sensitivity/
10,000)The
count of
dropped
packets >=
sensitivity
during the last
5 minutes.

Broadcast
storm —
Excessive
broadcasts

1475 5000 8525 One
Broadcast
Packet

1 sec If the average
per second of
broadcast
packets in the
last 20
seconds >=
sensitivity

Muticast
storm —
Excessive
multicasts

1475 5000 8525 One Multicast
Packet

1 sec If the average
per second of
multicast
packets in the
last 20
seconds >=
sensitivity

Duplex
mismatch
HDx

6 21 36 1/10,000
Outgoing

20 sec If (late
collisions/
total) >=
(sensitivity/
10,000)

Duplex
mismatch FDx

6 21 36 1/10,000
Incoming

20 sec If (CRC and
alignment
errors/ total)
>= (sensitivity/
10,000)

Link flap —
Excessive
transitions
between link-
up and link-
down states.

4 7 11 One
Transitions

10 secs If the
Transition
count in the
last 10s >=
sensitivity.

Example: of sensitivity calculation:

If a sensitivity is set to High, and a bad cable is causing 15 CRC errors out of a total of 3500 packets transmitted
in a 20 second period:
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1. CRC errors/total must be >= (sensitivity/10,000) to trigger an alert.

2. CRC errors/total = 15/3500 = .00043

3. Sensitivity/10,000 = 6/10,000 = .0006

4. .00043 is not greater than or equal to .0006, so an alert is not triggered.
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Using SNMP tools to manage the switch
SNMP is a management protocol that allows an SNMP client application to retrieve device configuration and
status information and to configure the device (get and set). You can manage the switch via SNMP from a
network management station.

To implement SNMP management, the switch must have an IP address configured either manually or dynamically
(using DHCP or Bootp). If multiple VLANs are configured, each VLAN interface should have its own IP address.
For DHCP use with multiple VLANs, see section "The Primary VLAN" in the "Static Virtual LANs (VLANs)" of the
Advanced traffic management guide for your switch.

NOTE: If you use the switch's Authorized IP Managers and Management VLAN features, ensure that
the SNMP management station, the choice of switch port used for SNMP access to the switch, or
both, are compatible with the access controls enforced by these features. Otherwise, SNMP access
to the switch will be blocked.

For more information on Authorized IP Managers, see the Access security guide for your switch.
(The latest version of this guide is available on the Networking website.) For information on the
Management VLAN feature, see the section "The Secure Management VLAN" in the "Static Virtual
LANs (VLANs)" chapter of the Advanced traffic management guide for your switch.

SNMP management features
SNMP management features on the switch include:

• SNMP version 1, version 2c, or version 3 over IP

• Security via configuration of SNMP communities (SNMPv3 communities on page 191)

• Security via authentication and privacy for SNMPv3 access

• Event reporting via SNMP
◦ Version 1 traps

◦ RMON: groups 1, 2, 3, and 9

• Flow sampling using sFlow

• Standard MIBs, such as the Bridge MIB (RFC 1493), Ethernet MAU MIB (RFC 1515), and others.

The switch SNMP agent also uses certain variables that are included in an proprietary MIB (management
information base) file.

1. Type a model number of your switch (For example, 8212) or product number in the Auto Search text box.

2. Select an appropriate product from the drop down list.

3. Click the Display selected button.

4. From the options that appear, select Software downloads.

5. MIBs are available with switch software in the Other category.

Chapter 7
Configuring for Network Management Applications
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Click on software updates, then MIBs.

SNMPv1 and v2c access to the switch
SNMP access requires an IP address and subnet mask configured on the switch. If you are using DHCP/Bootp to
configure the switch, ensure that the DHCP/Bootp process provides the IP address.

Once an IP address is configured, the main steps for configuring SNMPv1 and v2c access management features
are:

Procedure

1. Configure the appropriate SNMP communities. (See SNMPv3 communities on page 191.)

2. Configure the appropriate trap receivers.

In some networks, authorized IP manager addresses are not used. In this case, all management stations using
the correct community name may access the switch with the View and Access levels that have been set for that
community. If you want to restrict access to one or more specific nodes, you can use the switch's IP Authorized
Manager feature. (See the access security guide for your switch.)

CAUTION: If network management security is a concern, Hewlett Packard Enterprise recommends
that you change the write access for the "public" community to "Restricted."

SNMPv3 access to the switch
SNMPv3 access requires an IP address and subnet mask configured on the switch. (See "IP Configuration" on
page 8-2.) If you are using DHCP/Bootp to configure the switch, ensure that the DHCP/Bootp process provides
the IP address. (See "DHCP/Bootp Operation".)

Once you have configured an IP address, the main steps for configuring SNMPv3 access management features
are the following:

Procedure

1. Enable SNMPv3 for operation on the switch (see Enabling SNMPv3 on page 186).

2. Configure the appropriate SNMP users (see SNMPv3 users on page 187).

3. Configure the appropriate SNMP communities (see SNMPv3 communities on page 191).

4. Configure the appropriate trap receivers (see SNMP notifications on page 194).

In some networks, authorized IP manager addresses are not used. In this case, all management stations using
the correct User and community name may access the switch with the View and Access levels that have been set
for that community. If you want to restrict access to one or more specific nodes, you can use the IP Authorized
Manager feature for the switch. (See the access security guide for your switch.)

SNMP version 3 (SNMPv3) adds some new commands to the CLI for configuring SNMPv3 functions. To enable
SNMMPv3 operation on the switch, use the snmpv3 enable command. An initial user entry will be generated
with MD5 authentication and DES privacy.

You may (optionally) restrict access to only SNMPv3 agents by using the snmpv3 only command. To restrict
write-access to only SNMPv3 agents, use the snmpv3 restricted-access command.
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CAUTION:

Restricting access to only version 3 messages will make the community named “public” inaccessible
to network management applications (such as autodiscovery, traffic monitoring, SNMP trap
generation, and threshold setting) from operating in the switch.

Enabling and disabling switch for access from SNMPv3 agents
This includes the creation of the initial user record.

Syntax:

[no] snmpv3 enable

Enabling or disabling restrictions to access from only SNMPv3 agents
When enabled, the switch rejects all non-SNMPv3 messages.

Syntax:

[no] snmpv3 only

Enabling or disabling restrictions from all non-SNMPv3 agents to read-only access
Syntax:

[no] snmpv3 restricted-access

Viewing the operating status of SNMPv3
Syntax:

show snmpv3 enable

Viewing status of message reception of non-SNMPv3 messages
Syntax:

show snmpv3 only

Viewing status of write messages of non-SNMPv3 messages
Syntax:

show snmpv3 restricted-access

Enabling SNMPv3
The snmpv3 enable command allows the switch to:

• Receive SNMPv3 messages.

• Configure initial users.

• Restrict non-version 3 messages to "read only" (optional).
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CAUTION: Restricting access to only version 3 messages makes the community named "public"
inaccessible to network management applications (such as autodiscovery, traffic monitoring, SNMP
trap generation, and threshold setting) from running on the switch.

Example:

SNMP version 3 enable command

SNMPv3 users

NOTE: To create new users, most SNMPv3 management software requires an initial user record to
clone. The initial user record can be downgraded and provided with fewer features, but not upgraded
by adding new features. For this reason, Hewlett Packard Enterprise recommends that when you
enable SNMPv3, you also create a second user with SHA authentication and DES privacy.

To use SNMPv3 on the switch, you must configure the users that will be assigned to different groups:

Procedure

1. Configure users in the User Table with the snmpv3 user command.

To view the list of configured users, enter the show snmpv3 user command (see Adding users on page
188)

2. Assign users to Security Groups based on their security model with the snmpv3 group command (see 
Assigning users to groups (CLI) on page 189).

CAUTION: If you add an SNMPv3 user without authentication, privacy, or both, to a group that
requires either feature, the user will not be able to access the switch. Ensure that you add a user with
the appropriate security level to an existing security group.
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Adding users
To configure an SNMPv3 user, you must first add the user name to the list of known users with the snmpv3 user
command, as shown in the following image.

Figure 23: Adding SNMPv3 users and displaying SNMPv3 configuration

SNMPv3 user commands
Syntax:
[no] snmpv3 user <USER_NAME> [auth md5|sha] <AUTH_PASS> [priv des|aes] <PRIV_PASS>
    
[no] snmpv3 remote-engine-id <engineid> user <username> [auth {md5| sha}
         <authentication password>] [priv {des|aes} <privacy password>]
Parameters and options

no

Used to delete a user entry. When you delete a user, only the user name is required.

<AUTH_PASS>

With authorization, you can set either MD5 or SHA authentication. The authentication password auth_pass
must be 6 to 32 characters and is mandatory when you configure authentication.

priv des|aes

With privacy, the switch supports DES (56-bit) and AES (128-bit) encryption. Defaults to DES. Only AES 128-
bit and DES 56-bit encryption are supported as privacy protocols. Other non-standard encryption algorithms,
such as AES-172, AES-256, and 3-DES are not supported.

<PRIV_PASS>

The privacy password priv_pass must be 6 to 32 characters and is mandatory when you configure privacy.

remote-engine-id <engineid>

Sets the SNMPv3 remote engine ID in colon-separated hexadecimal notation.

Listing Users
To display the management stations configured to access the switch with SNMPv3 and view the authentication
and privacy protocols that each station uses, enter the show snmpv3 user command.

Syntax:

show snmpv3 user
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Displays information about the management stations configured on VLAN 1 to access the switch.

Display of the management stations configured on VLAN 1

switch# configure terminal
switch(config)# vlan 1
switch(vlan-1)# show snmpv3 user

Status and Counters - SNMPv3 Global Configuration Information

 User Name      Auth. Protocol   Privacy Protocol
 -----------    --------------   -----------------
 initial        MD5              CFB AES-128
 NetworkAdmin   MD5              CBC-DES

Assigning users to groups (CLI)
Next you must set the group access level for the user by assigning the user to a group. The access level for the
user is done with the snmpv3 group command as shown in the following image. For more details on the MIBs
access for a given group, see Group access levels on page 190.

Figure 24: Example: of assigning users to groups

Syntax:

[no] snmpv3 group
Assigns or removes a user to a security group for access rights to the switch. To delete an entry, all the following
three parameters must be included in the command:

group <group_name> Identifies the group that has the privileges that will be assigned to the user.
For more details, see Group access levels on page 190.

user <user_name> Identifies the user to be added to the access group that must match the
user name added with the snmpv3 user command.

sec-model {<ver1 | ver2c |
ver3>

Defines which security model to use for the added user. An SNMPv3
access group use only the ver3 security model.
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Group access levels
The switch supports eight predefined group access levels, shown in the following table. There are four levels for
use by version 3 users and four are used for access by version 2c or version 1 management applications.

Table 19: Predefined group access levels

Group name Group access type Group read view Group write view

managerpriv Ver3 Must have
Authentication and Privacy

ManagerReadView ManagerWriteView

managerauth Ver3 Must have
Authentication

ManagerReadView ManagerWriteView

operatorauth Ver3 Must have
Authentication

OperatorReadView DiscoveryView

operatornoauth Ver3 No Authentication OperatorReadView DiscoveryView

commanagerrw Ver2c or Ver1 ManagerReadView ManagerWriteView

commanagerr Ver2c or Ver1 ManagerReadView DiscoveryView

comoperatorrw Ver2c or Ver1 OperatorReadView OperatorReadView

comoperatorr Ver2c or Ver1 OperatorReadView DiscoveryView

Table 20: SNMPv3 Params and Group Configs Combinations

SNMPv3 Params SNMPv3 group Snmpv3 user config

noauth (no authentication and no
privacy)

operatornoauth snmpv3 user "user1"

auth (authentication and no privacy) managerpriv,
managerauth,operatorauth,
operatornoauth

snmpv3 user "user1" auth md5
"45800d22ccb8b485ab52fe2d8b92e
a85"

priv (authentication and privacy) managerpriv,
managerauth,operatorauth,
operatornoauth

snmpv3 user "user1" auth md5
"45800d22ccb8b485ab52fe2d8b92e
a85" priv des
"45800d22ccb8b485ab52fe2d8b92e
a85"

Each view allows you to view or modify a different set of MIBs:

• Manager Read View – access to all managed objects

• Manager Write View – access to all managed objects except the following:
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◦ vacmContextTable

◦ vacmAccessTable

◦ vacmViewTreeFamilyTable

• OperatorReadView – no access to the following:
◦ icfSecurityMIB

◦ hpSwitchIpTftpMode

◦ vacmContextTable

◦ vacmAccessTable

◦ vacmViewTreeFamilyTable

◦ usmUserTable

◦ snmpCommunityTable

• Discovery View – Access limited to samplingProbe MIB.

NOTE: All access groups and views are predefined on the switch. There is no method to modify or
add groups or views to those that are predefined on the switch.

SNMPv3 communities
SNMP commuities are supported by the switch to allow management applications that use version 2c or version 1
to access the switch. The communities are mapped to Group Access Levels that are used for version 2c or
version 1 support. This mapping happens automatically based on the communities access privileges, but special
mappings can be added with the snmpv3 community command (see Mapping SNMPv3 communities (CLI) on
page 191).

Mapping SNMPv3 communities (CLI)
SNMP commuities are supported by the switch to allow management applications that use version 2c or version 1
to access the switch. For more details, see SNMPv3 communities on page 191.

Syntax:
[no] snmpv3 community
Maps or removes a mapping of a community name to a group access level. To remove a mapping you need to
specify only the index_name parameter.

index <index_name> An index number or title for the mapping. The values of 1 to 5 are reserved and can
not be mapped.

name
<community_name>

The community name that is being mapped to a group access level.

sec-name
<security_name>

The group level to which the community is being mapped.

tag <tag_value> This is used to specify which target address may have access by way of this index
reference.

Example:

Chapter 7 Configuring for Network Management Applications 191

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 6788



The following image shows the assigning an Operator community on MgrStation1 to the
CommunityOperatorReadWrite group. Any other operator has an access level of CommunityOperatorReadOnly.

Figure 25: Assigning a community to a group access level

SNMP community features
Use SNMP communities to restrict access to the switch by SNMP management stations by adding, editing, or
deleting SNMP communities. You can configure up to five SNMP communities, each with either an operator-level
or a manager-level view and either restricted or unrestricted write access.

Using SNMP requires that the switch have an IP address and subnet mask compatible with your network.

Listing community names and values (CLI)
This command lists the data for currently configured SNMP community names (along with trap receivers and the
setting for authentication traps—see SNMP notifications on page 194).

Syntax:

show snmp-server [< community-string >]
Example:

Lists the data for all communities in a switch; that is, both the default "public" community name and another
community named "blue-team."

Figure 26: Example: of the SNMP community listing with two communities
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To list the data for only one community, such as the "public" community, use the above command with the
community name included. For Example:

switch# show snmp-server public

Configuring community names and values (CLI)
The snmp-server command enables you to add SNMP communities with either default or specific access
attributes, and to delete specific communities.

Syntax:

[no] snmp-server community <community-name>
Configures a new community name.

• If you do not also specify operator or manager, the switch automatically assigns the community to the
operator MIB view.

• If you do not specify restricted or unrestricted, the switch automatically assigns the community to
restricted (read-only) access.

The no form uses only the <community-name> variable and deletes the named community from the switch.

[operator | manager] Optionally assigns an access level.

• At the operator level, the community can access all MIB objects
except the CONFIG MIB.

• At the manager level, the community can access all MIB objects.

[restricted |
unrestricted] Optionally assigns MIB access type.

• Assigning the restricted type allows the community to read MIB
variables, but not to set them.

• Assigning the unrestricted type allows the community to read and
set MIB variables.

Example:

To add the following communities:

Community Access Level Type of Access

red-team manager (Access to all MIB
objects.)

unrestricted (read/write)

blue-team operator (Access to all MIB
objects except the CONFIG MIB.)

restricted (read-only)

switch(config)# snmp-server community red-team
   manager unrestricted
switch(config)# snmp-server community blue-team
   operator restricted
To eliminate a previously configured community named "gold-team":
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switch(config) # no snmp-server community gold-team

SNMP notifications
The switches:

• Default Traps: A switch automatically sends default traps to trap receivers using the configured community
name. You have to configure and supply the community name to use in the trap-receiver config, there is no
default. Use the snmp-server host <IP_ADDRESS> community "<COMMUNITY_NAME>" command to
configure a community name and the snmp-server host <IP_ADDRESS> community
"<COMMUNITY_NAME>" trap-level [all | critical | not-info | debug | none] command
to set the level of traps to send to the community.

• SNMPv2c informs

• SNMP v3 notification process, including traps

This section describes how to configure a switch to send network security and link-change notifications to
configured trap receivers.

Supported Notifications
By default, the following notifications are enabled on a switch:

• Manager password changes

• SNMP authentication failure

• Link-change traps: when the link on a port changes from up to down (linkDown) or down to up (linkUp)

• Port-security (web, MAC, or 802.1X) authentication failure

• Invalid password entered in a login attempt through a direct serial, Telnet, or SSH connection

• Inability to establish a connection with the RADIUS or TACACS+ authentication server

• DHCP snooping events

• ARP protection events

General steps for configuring SNMP notifications

Procedure

1. Determine the versions of SNMP notifications that you want to use in your network.

If you want to use SNMPv1 and SNMPv2c traps, you must also configure a trap receiver. See the following
sections and follow the required configuration procedures:

• SNMPv1 and SNMPv2c Traps on page 195

• Configuring an SNMP trap receiver (CLI) on page 196

• Enabling SNMPv2c informs (CLI) on page 199
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If you want to use SNMPv3 notifications (including traps), you must also configure an SNMPv3 management
station. Follow the required configuration procedure in Configuring SNMPv3 notifications (CLI) on page
199.

2. To reconfigure any of the SNMP notifications that are enabled by default to be sent to a management station
(trap receiver), see Enabling Link-Change Traps (CLI) on page 204.

3. (Optional) See the following sections to configure optional SNMP notification features and verify the current
configuration:

• Configuring the source IP address for SNMP notifications (CLI) on page 205

• Viewing SNMP notification configuration (CLI) on page 207

SNMPv1 and SNMPv2c Traps
The switches support the following functionality from earlier SNMP versions (SNMPv1 and SNMPv2c):

• Trap receivers: A trap receiver is a management station to which the switch sends SNMP traps and
(optionally) event log messages sent from the switch. From the CLI you can configure up to ten SNMP trap
receivers to receive SNMP traps from the switch.

• Default Traps: A switch automatically sends default traps to trap receivers using the configured community
name. You have to configure and supply the community name to use in the trap-receiver config, there is no
default. Use the snmp-server host <IP_ADDRESS> community "<COMMUNITY_NAME>" command to
configure a community name and the snmp-server host <IP_ADDRESS> community
"<COMMUNITY_NAME>" trap-level [all | critical | not-info | debug | none] command
to set the level of traps to send to the community.

• Thresholds: A switch automatically sends all messages created when a system threshold is reached to the
network management station that configured the threshold, regardless of the trap receiver configuration.

SNMP trap receivers
Use the snmp-server host command to configure a trap receiver that can receive SNMPv1 and SNMPv2c
traps, and (optionally) Event Log messages. When you configure a trap receiver, you specify its community
membership, management station IP address, and (optionally) the type of Event Log messages to be sent.

If you specify a community name that does not exist—that is, has not yet been configured on the switch—the
switch still accepts the trap receiver assignment. However, no traps are sent to that trap receiver until the
community to which it belongs has been configured on the switch.

NOTE:

To replace one community name with another for the same IP address, you must first enter the

no snmp-server host <community-name> {< ipv4-address | ipv6-address >}
command to delete the unwanted community name. Otherwise, if you add a new community name
with an IP address that is already used with a different community name, two valid community name
entries are created for the same management station.

If you do not specify the event level ([none|all|not-info|critical|debug]), the switch does
not send Event Log messages as traps. However, "well-known" traps and threshold traps (if
configured) are still sent.
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Configuring an SNMP trap receiver (CLI)
Syntax:

snmp-server host {< ipv4-addr | ipv6-addr >} < community name>
Configures a destination network management station to receive SNMPv1/v2c traps and (optionally) Event Log
messages sent as traps from the switch, using the specified community name and destination IPv4 or IPv6
address. You can specify up to ten trap receivers (network management stations). (The default community name
is public.)

[{<none | all | not-info | 
critical | debug>}]

(Optional) Configures the security level of the Event Log
messages you want to send as traps to a trap receiver (see
the following table).

• The type of Event Log message that you specify applies
only to Event Log messages, not to threshold traps.

• For each configured event level, the switch continues to
send threshold traps to all network management stations
that have the appropriate threshold level configured.

• If you do not specify an event level, the switch uses the
default value (none) and sends no Event Log messages as
traps.

[<inform>]
(Optional) Configures the switch to send SNMPv2 inform
requests when certain events occur. For more information, see 
Enabling SNMPv2c informs (CLI).

Table 21: Security levels for Event Log messages sent as traps

Security Level Action

None (default) Sends no Event Log messages.

All Sends all Event Log messages.

Not-Info Sends all Event Log messages that are not for information only.

Critical Sends only Event Log messages for critical error conditions.

Debug Sends only Event Log messages needed to troubleshoot network- and switch-level problems.

Example:

To configure a trap receiver in a community named "red-team" with an IP address of 10.28.227.130 to receive
only "critical" event log messages, you can enter the following command:

switch(config)# snmp-server host 10.28.227.130 red-team critical

Overview
You can configure the threshold limit as a percentage for RMON event log memory. Range is between 1 to 100.
An RMON log message is generated when the RMON event logging memory reaches the configured threshold
percentage. If SNMP traps are enabled, then the same traps are generated for the RMON event.
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Use the rmonlog-set-threshold command to set the threshold limit for RMON event log memory.

rmonlog-set-threshold

Syntax
rmonlog-set-threshold <percentage>

no rmonlog-set-threshold <percentage>

Description

Configures the threshold percentage for RMON event logging. The default value is 80.

The no form of this command resets RMON event logging threshold to default value.

Command context
config

Parameters
percentage

Specifies the threshold percentage value between 1 to 100.

Examples

switch (config)# rmonlog-set-threshold 45

switch (config)# show running-config

Running configuration:

; JL071A Configuration Editor; Created on release #KB.16.06.0000x
; Ver #13:03.f8.1c.fb.7f.bf.bb.ff.7c.59.fc.7b.ff.ff.fc.ff.ff.3f.ef:05

hostname "switch"
module 1 type jl071x
flexible-module A type JL081A
interface A1
   speed-duplex auto-100
   exit
snmp-server community "public" unrestricted
oobm
   ip address dhcp-bootp
   exit
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-24,A1-A4
   ip address dhcp-bootp
   ipv6 enable
   ipv6 address dhcp full
   exit
rmonlog-set-threshold 45
The following event log message is logged when the RMON log memory reaches the threshold value.

W 03/25/18 07:44:51 03443 system:The event log buffer is 45% full.

SNMP trap when MAC address table changes
An SNMP trap is generated when a laptop/PC is removed from the back of an IP phone and the laptop/PC MAC
address ages out of the MAC table for the Aruba 2930 switch.
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The mac-notify trap feature globally enables the generation of SNMP trap notifications on MAC address table
changes (learns/moves/removes/ages.)

The following command enables trap for aged MAC addresses:

Syntax:

switch(config)# [no] mac-notify traps [port-list] aged
Example:

For port 1 the command is:

Syntax:

switch(config)# mac-notify traps 1 aged
show command
Use the following show command to display the different mac-notify traps configured on an interface:

Syntax:

Switch # show mac-notify traps
Displays the following information:

Mac Notify Trap Information
Mac-notify Enabled : No
Mac-move Enabled : No
Trap-interval : 30
Port   MAC Addresses trap learned/removed/aged
------ ---------------------------------------
1       Learned, Removed & Aged
2            Removed & Aged
3            Learned & Aged
4            Learned & Removed
5            Aged
6            Learned
7            Removed
Example:

For port 1 the command would be as follows

Switch # show mac-notify traps 1
Displays the following information:

1 Aged

SNMPv2c informs
On a switch enabled for SNMPv2c, you can use the snmp-server host inform command (Enabling
SNMPv2c informs (CLI) on page 199) to send inform requests when certain events occur. When an SNMP
Manager receives an inform request, it can send an SNMP response back to the sending agent on the switch to
let the agent know that the inform request reached its destination.

If the sending agent on the switch does not receive an SNMP response back from the SNMP Manager within the
timeout period, the inform request may be resent, based on the retry count value.

When you enable SNMPv2c inform requests to be sent, you must specify the IP address and community name of
the management station that will receive the inform notification.
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Enabling SNMPv2c informs (CLI)
For information about enabling SNMPv2c informs, see SNMPv2c informs on page 198.

Syntax:

[no] snmp-server host {< ipv4-addr | ipv6-addr >} <community name> inform [retries < count >] [timeout < interval >]

Enables (or disables) the inform option for SNMPv2c on the switch and allows you to configure options for
sending SNMP inform requests.

retries Maximum number of times to resend an inform request if no SNMP response is received.
(Default: 3)

timeout Number of seconds to wait for an acknowledgement before resending the inform request.
(Default: 15 seconds)

NOTE: The retries and timeout values are not used to send trap requests.

To verify the configuration of SNMPv2c informs, enter the show snmp-server command, as shown in the
following image (note indication of inform Notify Type in bold):

Display of SNMPv2c inform configuration

switch(config)# show snmp-server

 SNMP Communities

  Community Name   MIB View Write Access
  ---------------- -------- ------------ public          Manager  Unrestricted

 Trap Receivers

  Link-Change Traps Enabled on Ports [All] : All
  ...
  Address               Community       Events Sent Notify Type Retry Timeout
  --------------------- --------------- ----------- ----------- ----- --------
  15.28.333.456         guest           All         inform      3     15

 Excluded MIBs

 Snmp Response Pdu Source-IP Information

  Selection Policy   : Default rfc1517

 Trap Pdu Source-IP Information 
  Selection Policy   : Configured IP 
  Ip Address        : 10.10.10.10

Configuring SNMPv3 notifications (CLI)
The SNMPv3 notification process allows messages that are passed via SNMP between the switch and a network
management station to be authenticated and encrypted.

Procedure

1. Enable SNMPv3 operation on the switch by entering the snmpv3 enable command.
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When SNMPv3 is enabled, the switch supports:

• Reception of SNMPv3 notification messages (traps and informs)

• Configuration of initial users

• (Optional) Restriction of non-SNMPv3 messages to "read only"

2. Configure SNMPv3 users by entering the snmpv3 user command. Each SNMPv3 user configuration is
entered in the User Table.

3. Assign SNMPv3 users to security groups according to their level of access privilege by entering the snmpv3
group command.

4. Define the name of an SNMPv3 notification configuration by entering the snmpv3 notify command.

Syntax:
[no] snmpv3 notify <notify_name> tagvalue <tag_name> type {inform|trap}

Associates the name of an SNMPv3 notification configuration with a tag name used (internally) in SNMPv3
commands. To delete a notification-to-tag mapping, enter no snmpv3 notify notify_name .

notify <notify_name> Specifies the name of an SNMPv3 notification configuration.

tagvalue <tag_name> Specifies the name of a tag value used in other SNMPv3 commands, such as
snmpv3 targetaddress params taglist tag_name in Step 5.

type Specifies the notification type as inform or trap. By default, the notification
type is trap.

5. Configure the target address of the SNMPv3 management station to which SNMPv3 informs and traps are
sent by entering the snmpv3 targetaddress command.

Syntax:
[no] snmpv3 targetaddress <ASCII-STR> params <ASCII-STR> <IP-ADDR> taglist <ASCII-STR>
Configures the IPv4 or IPv6 address, name, and configuration filename of the SNMPv3 management station to
which notification messages are sent.
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params <ASCII-STR> Name of the SNMPv3 station's parameters file. The
parameters filename configured with params <ASCII-
STR> must match the params <ASCII-STR> value
entered with the snmpv3 params command in Step 6.

The <IP-ADDR> sets the IP address of the destination.

taglist <ASCII-STR> [ASCII-STR] … Specifies the SNMPv3 notifications (identified by one or
more ASCII-STR values) to be sent to the IP address of
the SNMPv3 management station.

You can enter more than one ASCII-STR value. Each
ASCII-STR value must be already associated with the
name of an SNMPv3 notification configuration entered
with the snmpv3 notify command in Step 4.Use a
blank space to separate values.

ASCII-STR

You can enter up to 103 characters in ASCII-STR entries
following the taglist keyword.

[filter {<none | debug | all | not-
info | critical>}]

(Optional) Configures the type of messages sent to a
management station.(Default: none.)

[udp-port < port >] (Optional) Specifies the UDP port to use.(Default: 162.)

[port-mask < mask >] (Optional) Specifies a range of UDP ports. (Default: 0.)

[addr-mask < mask >] (Optional) Specifies a range of IP addresses as
destinations for notification messages.(Default: 0.)

[retries < value >] (Optional) Number of times a notification is retransmitted if
no response is received. Range: 1-255.(Default: 3.)

[timeout < value >] (Optional) Time (in millisecond increments) allowed to
receive a response from the target before notification
packets are retransmitted. Range: 0-2147483647.[Default:
1500 (15 seconds).]

[max-msg-size < size >] (Optional) Maximum number of bytes supported in a
notification message to the specified target. (Default:
1472)

6. Create a configuration record for the target address with the snmpv3 params command.

Syntax:
[no] snmpv3 params <ASCII-STR> user <user_name> sec-model <security_model> 
message-processing <security_model> <security_service>
Applies the configuration parameters and IP address of an SNMPv3 management station (from the params
<ASCII-STR> value configured with the snmpv3 targetaddress command in Step 5) to a specified
SNMPv3 user (from the user <user_name> value configured with the snmpv3 user command in Step 2).

If you enter the snmpv3 params user command, you must also configure a security model ( sec_model)
and message processing algorithm ( message-processing).
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{<sec_model [ver1 | ver2c | ver3>]} Configures the security model used for SNMPv3
notification messages sent to the management
station configured with the snmpv3
targetaddress command in Step 5.

If you configure the security model as ver3, you
must also configure the message processing value as
ver3.

{msg-processing {<ver1 | ver2c | ver3>}
[noaut | auth | priv]}

Configures the algorithm used to process messages
sent to the SNMPv3 target address.

If you configure the message processing value as
ver3 and the security model as ver3, you must also
configure a security services level ( noauth, auth, or
priv).

Example:

An example to how to configure SNMPv3 notification in the following image:

Figure 27: Example: SNMPv3 notification configuration

Network security notifications
By default, a switch is enabled to send the SNMP notifications listed in Supported Notifications on page 194
when a network security event (For example, authentication failure) occurs. However, before security notifications
can be sent, you must first configure one or more trap receivers or SNMPv3 management stations as described
in:

• Configuring an SNMP trap receiver (CLI) on page 196

• Configuring SNMPv3 notifications (CLI) on page 199

You can manage the default configuration of the switch to disable and re-enable notifications to be sent for the
following types of security events:

• ARP protection events

• Inability to establish a connection with the RADIUS or TACACS+ authentication server

• DHCP snooping events

• Dynamic IP Lockdown hardware resources consumed

• Link change notification
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• Invalid password entered in a login attempt through a direct serial, Telnet, or SSH connection

• Manager password changes

• Port-security (web, MAC, or802.1X) authentication failure

• SNMP authentication failure

• Running configuration changes

Enabling or disabling notification/traps for network security failures and other security
events (CLI)
Syntax:
[no] snmp-server enable traps [arp-protect | auth-server-fail | dhcp-server 
| dhcp-snooping | dhcpv6-snooping | dyn-ip-lockdown | dyn-ipv6-lockdown | link-change 
| login-failure-mgr | mac-count-notify | mac-notify | macsec | nd-snooping | password-change-mgr 
| port-security | running-config-change | snmp-authentication | startup-config-change | vsf ]

Enables or disables sending one of the security notification types listed below to configured trap receivers.
(Unless otherwise stated, all of the following notifications are enabled in the default configuration.)

The notification sends a trap:

arp-protect Traps for Dynamic ARP Protection.

auth-server-fail Traps reporting authentication server unreachable.

dhcp-server Traps for DHCP-Server.

dhcp-snooping Traps for DHCP-Snooping.

dhcpv6-snooping Set the traps for DHCPv6 snooping.

dyn-ip-lockdown Traps for Dynamic Ip Lockdown.

dyn-ipv6-lockdown Enable traps for Dynamic IPv6 Lockdown.

link-change Traps for link-up and link-down.

login-failure-mgr Traps for management interface login failure.

mac-count-notify Traps for MAC addresses learned on the specified
ports exceeds the threshold.

mac-notify Traps for (learned/removed) MAC address table
changes.

macsec Configure the traps for MACsec notifications.

nd-snooping Set the trap for nd snooping

password-change-mgr Traps for management interface password change.

port-security Traps for port access authentication failure.

Table Continued
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running-config-change Traps for running config change.

snmp-authentication [extended |
standard]

Select RFC-1157 (standard) or ICF-SNMP (extended)
traps.

Startup-config-change Traps for changes to the startup configuration.

vsf Enable traps for the VSF functionality.

To determine the specific cause of a security event, check the Event Log in the console interface to see why a
trap was sent. For more information, see "Using the Event Log for Troubleshooting Switch Problems".

Viewing the current configuration for network security notifications (CLI)
Enter the show snmp-server traps command, as shown in the following example. Note that command output
is a subset of the information displayed with the show snmp-server command in Display of SNMP
notification configuration.

Display of configured network security notifications

switch(config)# show snmp-server traps

 Trap Receivers

  Link-Change Traps Enabled on Ports [All] : A1-A24

  Traps Category                  Current Status
  ------------------------------  --------------------------
  SNMP Authentication           : Extended
  Password change               : Enabled
  Login failures                : Enabled
  Port-Security                 : Enabled
  Authorization Server Contact  : Enabled
  DHCP Snooping                 : Enabled
  Dynamic ARP Protection        : Enabled
  Dynamic IP Lockdown           : Enabled

  Address                Community  Events Sent Notify Type Retry Timeout
  ---------------------- ---------- ----------- ----------- ----- -------
  15.255.5.225           public     All         trap          3   15
  2001:0db8:0000:0001
    :0000:0000:0000:0121 user_1     All         trap          3   15

  Excluded MIBs

Enabling Link-Change Traps (CLI)
By default, a switch is enabled to send a trap when the link state on a port changes from up to down (linkDown) or
down to up (linkUp). To reconfigure the switch to send link-change traps to configured trap receivers, enter the
snmp-server enable traps link-change command.

Syntax:

[no] snmp-server enable traps link-change <port-list> [all]
Enables or disables the switch to send a link-change trap to configured trap receivers when the link state on a
port goes from up to down or down to up.
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Enter all to enable or disable link-change traps on all ports on the switch.

Readable interface names in traps
The SNMP trap notification messages for linkup and linkdown events on an interface includes IfDesc and IfAlias
var-bind information.

Source IP address for SNMP notifications
The switch uses an interface IP address as the source IP address in IP headers when sending SNMP
notifications (traps and informs) or responses to SNMP requests.

For multi-netted interfaces, the source IP address is the IP address of the outbound interface of the SNMP reply,
which may differ from the destination IP address in the IP header of the received request. For security reasons, it
may be desirable to send an SNMP reply with the IP address of the destination interface (or a specified IP
address) on which the corresponding SNMP request was received.

To configure the switch to use the source IP address on which an SNMP request was received in SNMP
notification or traps and replies, enter the snmp-server response-source and snmp-server trap-
source commands (For more information, see Configuring the source IP address for SNMP notifications
(CLI)).

Configuring the source IP address for SNMP notifications (CLI)
For more information, see Source IP address for SNMP notifications on page 205.

Syntax:

[no] snmp-server response-source [dst-ip-of-request | [ipv4-addr | ipv6-addr] | loopback <0-7>]
Specifies the source IP address of the SNMP response PDU. The default SNMP response PDU uses the IP
address of the active interface from which the SNMP response was sent as the source IP address.

The no form of the command resets the switch to the default behavior (compliant with rfc-1517).

(Default: Interface IP address)

dst-ip-of-request Destination IP address of the SNMP request PDU that is used as the
source IP address in an SNMP response PDU.

[ipv4-addr | ipv6-addr] User-defined interface IP address that is used as the source IP address
in an SNMP response PDU. Both IPv4 and IPv6 addresses are
supported.

loopback <0-7> IP address configured for the specified loopback interface that is used as
the source IP address in an SNMP response PDU. If multiple loopback IP
addresses are configured, the lowest alphanumeric address is used.

To use the IP address of the destination interface on which an SNMP request was received as the source IP
address in the IP header of SNMP traps and replies, enter the following command:

switch(config)# snmp-server response-source dst-ip-of-request
Syntax:

[no] snmp-server trap-source [ipv4-addr | loopback <0-7>]
Specifies the source IP address to be used for a trap PDU. To configure the switch to use a specified source IP
address in generated trap PDUs, enter the snmp-server trap-source command.
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The no form of the command resets the switch to the default behavior (compliant with rfc-1517).

(Default: Use the interface IP address in generated trap PDUs)

ipv4-addr User-defined interface IPv4 address that is used as the source IP address in generated
traps. IPv6 addresses are not supported.

loopback <0-7> P address configured for the specified loopback interface that is used as the source IP
address in a generated trap PDU. If multiple loopback IP addresses are configured, the
lowest alphanumeric address is used.

NOTE: When you use the snmp-server response-source and snmp-server trap-source
commands, note the following behavior:

• The snmp-server response-source and snmp-server trap-source commands
configure the source IP address for IPv4 interfaces only.

• You must manually configure the snmp-server response-source value if you wish to change
the default user-defined interface IP address that is used as the source IP address in SNMP traps
(RFC 1517).

• The values configured with the snmp-server response-source and snmp-server trap-
source commands are applied globally to all interfaces that are sending SNMP responses or
SNMP trap PDUs.

• Only the source IP address field in the IP header of the SNMP response PDU can be changed.

• Only the source IP address field in the IP header and the SNMPv1 Agent Address field of the
SNMP trap PDU can be changed.

Verifying the configuration of the interface IP address used as the source IP address in
IP headers for SNMP replies and traps sent from the switch (CLI)
Enter the show snmp-server command to display the SNMP policy configuration, as shown in the following
example.

Display of source IP address configuration

switch(config)# show snmp-server
 
 SNMP Communities
  
  Community Name   MIB View Write Access
  ---------------- -------- ------------
  public           Manager  Unrestricted

 Trap Receivers
  Link-Change Traps Enabled on Ports [All] : All

  ...

 Excluded MIBs
 Snmp Response Pdu Source-IP Information
  Selection Policy : dstIpOfRequest 1

 Trap Pdu Source-IP Information
  Selection Policy : Configured IP
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1 dstIpOfRequest: The destination IP address of the interface on which an SNMP request is received and used as
the source IP address in SNMP replies.

Viewing SNMP notification configuration (CLI)
Syntax:

show snmp-server
Displays the currently configured notification settings for versions SNMPv1 and SNMPv2c traps, including SNMP
communities, trap receivers, link-change traps, and network security notifications.

Example:

In the following Example:, the show snmp-server command output shows that the switch has been configured
to send SNMP traps and notifications to management stations that belong to the "public," "red-team," and "blue-
team" communities.

Figure 28: Display of SNMP notification configuration

Hardware events and traps

Current default traps
The default event scenarios for currently generated traps on ArubaOS-Switches are:

• Device cold start notifications

• Device warm start notifications

• Port down notifications

• Port up notifications

Chapter 7 Configuring for Network Management Applications 207

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 6804



• Authentication failure notifications

• Enterprise change notifications

• Intrusion alarm notifications

Event scenario matrix
Different event scenarios for which traps are generated:

Event Id Severity Action Message

68 Info Slot Insertion I 06/20/16 09:18:43 00068 chassis: AM1: Slot C Inserted

67 Info Slot Removal I 06/20/16 09:18:50 00067 chassis: AM1: Slot C Removed

405 Info Transceiver Insertion I 06/20/16 09:18:56 00405 ports: AM1: port A23 xcvr hot-
swap insert

406 Info Transceiver Removal I 06/20/16 09:19:04 00406 ports: AM1: port A23 xcvr hot-
swap remove

552 Warning Stacking module
Insertion

W 04/20/16 09:20:43 00552 chassis: ST1-CMDR: Stacking
Module insertion detected: Reboot required

552 Warning Stacking module
Removal

W 06/20/16 09:19:43 00552 chassis: ST1-CMDR: Stacking
Module removal detected: Reboot required

Enabling and disabling traps

Action Command

Disable both the log and
trap

setMib eventType.<event_Id> -i 1 – to disable both log & Trap

Enable log only setMib eventType.<event_Id> -i 2 – to allow only log

Enable both the log and
trap (Default)

setMib eventType.<event_Id> -i 4 – to allow both log & Trap

Enable trap only setMib eventType.<event_Id> -i 3 – to allow only trap

NOTE: If the event is configured to disable a trap, then the trap will not be sent for that particular
event. In all other scenarios, a trap is generated for the listed events.

SNMP trap captures examples

Inserting a slot module

Event Id: 68
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Removing a slot module

Event Id: 67

Inserting transceiver

Event Id: 405
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Removing a transceiver
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Inserting a stack-module

Configuring the MAC address count option
The MAC Address Count feature provides a way to notify the switch management system when the number of
MAC addresses learned on a switch port exceeds the permitted configurable number.

To enable the mac-count-notify option, enter this command in global config context.

Syntax:

[no] snmp-server enable traps mac-count-notify
Sends a trap when the number of MAC addresses learned on the specified ports exceeds the configured
<learned-count> value.

To configure the mac-count-notify option on a port or ports, enter this command. When the configured number of
MAC addresses is exceeded (the learned-count), a trap is sent.

Syntax:

[no] mac-count-notify traps <port-list> [<learned-count>]
Configures mac-count-notify traps on the specified ports (or all) for the entire switch.

The [no] form of the command disables mac-count-notify traps.

[<learned-count>]: The number of MAC addresses learned before sending a trap. Values range between
1-128.

Default: 32
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Configuring mac-count notify traps on ports 5–7

switch (config)# mac-count-notify traps 5-7 50

Displaying information about the mac-count-notify option
Use the show mac-count-notify traps [<port-list>] command to display information about the configured value for
sending a trap, the current count, and if a trap has been sent.

Information displayed for the show mac-count-notify traps command

switch(config)# show mac-count-notify traps

Mac-count-notify Enabled: Yes

Port    Count for        Count    Trap Sent
        sending Trap
------  ---------------  -------  ------------
1
2
3
4
5          50             0        No
6          50             2        No
7          50             0        No
8
9
...
The interface context can be used to configure the value for sending a trap.

Configuring mac-count-notify traps from the interface context

switch(config)# interface 5

Switch (eth-5)# mac-count-notify traps 35
The show snmp-server traps command displays whether the MAC Address Count feature is enabled or
disabled.

Information about SNMP traps, including MAC address count being Enabled/Disabled

switch(config)# show snmp-server traps
 
 Trap Receivers

  Link-Change Traps Enabled on Ports [All] : All
 
  Traps Category                 Current Status
  ____________________________   __________________
  SNMP Authentication          : Extended
  Password change              : Enabled
  Login failures               : Enabled
  Port-Security                : Enabled
  Authorization Server Contact : Enabled
  DHCP-Snooping                : Enabled
  Dynamic ARP Protection       : Enabled
  Dynamic IP Lockdown          : Enabled
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  MAC address table changes    : Disabled
  MAC Address Count            : Enabled 1

  Address          Community   Events  Type   Retry  Timeout
  ---------------- ----------- ------- ------ ------ -------
  15.146.194.77    public      None    trap   3      15
  15.255.134.252   public      None    trap   3      15
  16.181.49.167    public      None    trap   3      15
  16.181.51.14     public      None    trap   3      15
  
Excluded MIBs
      

1The notify option is enabled.

Advanced management: RMON
The switch supports RMON (remote monitoring) on all connected network segments. This allows for
troubleshooting and optimizing your network.

The following RMON groups are supported:

• Ethernet Statistics (except the numbers of packets of different frame sizes)

• Alarm

• History (of the supported Ethernet statistics)

• Event

The RMON agent automatically runs in the switch. Use the RMON management station on your network to
enable or disable specific RMON traps and events. Note that you can access the Ethernet statistics, Alarm and
Event groups from the Switch Manager network management software.

CLI-configured sFlow with multiple instances
sFlow can also be configured via the CLI for up to three distinct sFlow instances: once enabled, an sFlow
receiver/destination can be independently configured for full flow-sampling and counter-polling. CLI-configured
sFlow instances may be saved to the startup configuration to persist across a switch reboot.

Configuring sFlow (CLI)
The following sFlow commands allow you to configure sFlow instances via the CLI. For more information, see 
Advanced management: RMON on page 213.

Syntax:

[no] sflow <receiver-instance> destination <ip-address> [< udp-port-num >]
Enables an sFlow receiver/destination. The receiver-instance number must be a 1, 2, or 3.

By default, the udp destination port number is 6343.

To disable an sFlow receiver/destination, enter no sflow receiver-instance .

Syntax:

sflow <receiver-instance> sampling <port-list> <sampling rate>
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Once an sFlow receiver/destination has been enabled, this command enables flow sampling for that instance.
The receiver-instance number is 1, 2, or 3, and the sampling rate is the allowable non-zero skipcount for the
specified port or ports.

To disable flow-sampling for the specified port-list, repeat the above command with a sampling rate of 0.

Syntax:

sflow <receiver-instance> polling <port-list> <polling interval>
Once an sFlow receiver/destination has been enabled, this command enables counter polling for that instance.
The receiver-instance number is 1, 2, or 3, and the polling interval may be set to an allowable non-zero value to
enable polling on the specified port or ports.

To disable counter-polling for the specified port-list, repeat the above command with a polling interval of 0.

NOTE:

Under the multiple instance implementation, sFlow can be configured via the CLI or via SNMP.
However, CLI-owned sFlow configurations cannot be modified via SNMP, whereas SNMP-owned
instances can be disabled via the CLI using the no sflow <receiver-instance> command.

Viewing sFlow Configuration and Status (CLI)
The following sFlow commands allow you to display sFlow configuration and status through the CLI Viewing
sFlow destination information on page 214 is an example of sflow agent information.

Syntax:

show sflow agent
Displays sFlow agent information. The agent address is normally the IP address of the first VLAN configured.

The show sflow agent command displays read-only switch agent information. The version information shows
the sFlow version, MIB support, and software versions; the agent address is typically the IP address of the first
VLAN configured on the switch.

Viewing sflow agent information

switch# show sflow agent

  Version          1.3;XX.11.40
  Agent Address    10.0.10.228
Syntax:

show sflow <receiver instance> destination
Displays information about the management station to which the sFlow sampling-polling data is sent.

The show sflow instance destination command includes information about the management-station's
destination address, receiver port, and owner, as shown in the following example.

Viewing sFlow destination information

switch# show sflow 2 destination

  Destination Instance        2
  sflow                       Enabled
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  Datagrams Sent              221
  Destination Address         10.0.10.41
  Receiver Port               6343
  Owner                       Administrator, CLI-owned, Instance 2
  Timeout (seconds)           99995530
  Max Datagram Size           1400
  Datagram Version Support    5
Note the following details:

• Destination Address remains blank unless it has been configured.

• Datagrams Sent shows the number of datagrams sent by the switch agent to the management station since
the switch agent was last enabled.

• Timeout displays the number of seconds remaining before the switch agent will automatically disable sFlow
(this is set by the management station and decrements with time).

• Max Datagram Size shows the currently set value (typically a default value, but this can also be set by the
management station).

Syntax:

show sflow <receiver instance> sampling-polling <port-list/range>
Displays status information about sFlow sampling and polling.

The show sflow instance sampling-polling [port-list] command displays information about
sFlow sampling and polling on the switch, as shown in the following example. You can specify a list or range of
ports for which to view sampling information.

Figure 29: Example: Viewing sFlow sampling and polling information

NOTE: The sampling and polling instances (noted in parentheses) coupled to a specific receiver
instance are assigned dynamically, and so the instance numbers may not always match. The key
thing to note is whether sampling or polling is enabled on a port, and the sampling rates or polling
intervals for the receiver instance configured on each port.

Configuring UDLD Verify before forwarding
When an UDLD enabled port transitions to link-up, the port will begin with a UDLD blocking state. UDLD will
probe via protocol packet exchange to determine the bidirectional state of the link. Until UDLD has completed the
probe, all data traffic will be blocked. If the link is found to be bidirectional, UDLD will unblock the port for data
traffic to pass. Once UDLD unblocks the port, other protocols will see the port as up and data traffic can be safely
forwarded.
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The default mode of a switch is “forward first then verify’’. Enabling UDLD link-up will default to “forward first then
verify”. To change the mode to “verify then forward”, you need to configure using the commands found in section
6.72.

NOTE: Link-UP data traffic will resumed after probing the link partner completes. All other protocols
running will see the port as down.

UDLD time delay
UDLD protocol informs the link partner simultaneously as it detects a state change from unidirectional to
bidirectional traffic. Additional packet exchanges will be carried out by UDLD in addition to the existing UDLD
exchanges whenever state changes from unidirectional to bidirectional.

Table 22: Peer state transition timings

Interval Time Interval 1 Interval 1 + delta Interval 2 Interval 3

5 sec 5+(<5) sec* 10 sec 15 sec

With triggered
updates

State = blockedPeer
State = blocked

Inform PeerState =
unblockedPeer State
= unblocked

Regular UDLD TX Regular UDLD TX

Without triggered
updates

State = blockedPeer
State = blocked

State =
unblockedPeer State
= blocked

Inform PeerState =
unblockedPeer State
= unblocked

Regular UDLD TX

*delta is the time when the unblock event occurs on local side

Restrictions
• There is no support available when configuring this mode from the web and menu interface.

• There are no new packet types are introduced with UDLD.

• There are no new UDLD timers being introduced.

UDLD configuration commands
Syntax:
Switch(config)# link-keepalive mode [verify-then-forward | forward-then-verify]
This command configures the link-keepalive mode.

Link-keepalive provides two modes of operation; verify-then-forward and forward-then-verify.

When using the verify-then-forward mode, the port is in a blocking state until the link configured for UDLD
establishes bidirectional communication. When using the forward-then-verify mode, the port forwards the
data then verifies the status of the link-in state.

When a unidirectional state is detected, the port is moved to a blocked state.

When a bidirectional state is detected, the data is forwarded without interruption.

Syntax:
Switch(config)# link-keepalive mode verify-then-forward
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Keeps the port in a logically blocked state until the link configured for UDLD has been successfully established in
bi-directional communication.

Syntax:
Switch(config)# link-keepalive mode forward-then-verify
Forwards the data then verifies the status of the link. If a unidirectional state is detected, the port is then moved to
a blocked state.

Syntax:
Switch(config)# link-keepalive interval <deciseconds>
Configure the interval for link-keepalive. The link-keepalive interval is the time between sending two
UDLD packets. The time interval is entered in deciseconds (1/10 sec). The default keepalive interval is 50
deciseconds.

Example:

A value of 10 is 1 sec., 11 is 1.1 sec.

Syntax:
Switch(config)# link-keepalive retries <number>
Maximum number of sending attempts for UDLD packets before declaring the link as faulty.

Default keepalive attempt is 4.

Show commands
Syntax:

switch(config)# show link-keepalive
Sample output:

Total link-keepalive enabled ports: 8
Keepalive Retries : 4
Keepalive Interval: 5 sec
Keepalive Mode : verify-then-forward
Physical Keepalive Adjacent UDLD

Port  Enabled Status           Status    Switch       VLAN
----- ------- ---------------- --------- ------------- ----------
1     Yes     down             off-line  000000-000000 untagged
2     Yes     down             off-line  000000-000000 untagged
3     Yes     down             off-line  000000-000000 untagged
4     Yes     down             off-line  000000-000000 untagged
5     Yes     down             off-line  000000-000000 untagged
6     Yes     down             off-line  000000-000000 untagged
7     Yes     down             off-line  000000-000000 untagged
8     Yes     down             off-line  000000-000000 untagged

RMON generated when user changes UDLD mode
RMON events are generated when UDLD is configured. The first time you configure the mode, the UDLD states
will be re-initialized. An event log entry is initiated to include the reason for the initial UDLD blocking state during
link up.

Example:

UDLD mode [verify-then-forward | forward-then-verify] is configured
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Severity: - Info.

LLDP
To standardize device discovery on all switches, LLDP is implemented while offering limited read-only support for
CDP, as documented in this manual. For the latest information on your switch model, consult the Release Notes
(available on the HPE Networking website). If LLDP has not yet been implemented (or if you are running an older
version of software), consult a previous version of the Management and Configuration Guide for device discovery
details.

LLDP (Link Layer Discovery Protocol): provides a standards-based method for enabling the switches covered
in this guide to advertise themselves to adjacent devices and to learn about adjacent LLDP devices.

LLDP-MED (LLDP Media Endpoint Discovery): Provides an extension to LLDP and is designed to support VoIP
deployments.

NOTE: LLDP-MED is an extension for LLDP, and the switch requires that LLDP be enabled as a
prerequisite to LLDP-MED operation.

An SNMP utility can progressively discover LLDP devices in a network by:

Procedure

1. Reading a given device's Neighbors table (in the Management Information Base, or MIB) to learn about other,
neighboring LLDP devices.

2. Using the information learned in step 1 to find and read the neighbor devices' Neighbors tables to learn about
additional devices, and so on.

Also, by using show commands to access the switch's neighbor database for information collected by an
individual switch, system administrators can learn about other devices connected to the switch, including device
type (capability) and some configuration information. In VoIP deployments using LLDP-MED on the switches,
additional support unique to VoIP applications is also available. See LLDP-MED (media-endpoint-discovery) on
page 233.

General LLDP operation
An LLDP packet contains data about the transmitting switch and port. The switch advertises itself to adjacent
(neighbor) devices by transmitting LLDP data packets out all ports on which outbound LLDP is enabled and by
reading LLDP advertisements from neighbor devices on ports that are inbound LLDP-enabled. (LLDP is a one-
way protocol and does not include any acknowledgement mechanism.) An LLDP-enabled port receiving LLDP
packets inbound from neighbor devices stores the packet data in a Neighbor database (MIB).

LLDP-MED
This capability is an extension to LLDP and is available on the switches. See LLDP-MED (media-endpoint-
discovery) on page 233.
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Packet boundaries in a network topology
• Where multiple LLDP devices are directly connected, an outbound LLDP packet travels only to the next LLDP

device. An LLDP-capable device does not forward LLDP packets to any other devices, regardless of whether
they are LLDP-enabled.

• An intervening hub or repeater forwards the LLDP packets it receives in the same manner as any other
multicast packets it receives. Thus, two LLDP switches joined by a hub or repeater handle LLDP traffic in the
same way that they would if directly connected.

• Any intervening 802.1D device or Layer-3 device that is either LLDP-unaware or has disabled LLDP operation
drops the packet.

LLDP operation configuration options
In the default configuration, LLDP is enabled and in both transmit and receive mode on all active ports. The LLDP
configuration includes global settings, which apply to all active ports on the switch, and per-port settings, which
affect only the operation of the specified ports.

The commands in the LLDP sections affect both LLDP and LLDP-MED operation. For information on operation
and configuration unique to LLDP-MED, see LLDP-MED (media-endpoint-discovery) on page 233.

Enable or disable LLDP on the switch
In the default configuration, LLDP is globally enabled on the switch. To prevent transmission or receipt of LLDP
traffic, you can disable LLDP operation.

Enable or disable LLDP-MED
In the default configuration for the switches, LLDP-MED is enabled by default. (Requires that LLDP is also
enabled.) For more information, see LLDP-MED (media-endpoint-discovery) on page 233.

Change the frequency of LLDP packet transmission to neighbor devices
On a global basis, you can increase or decrease the frequency of outbound LLDP advertisements.

Change the Time-To-Live for LLDP packets sent to neighbors
On a global basis, you can increase or decrease the time that the information in an LLDP packet outbound from
the switch will be maintained in a neighbor LLDP device.

Transmit and receive mode
With LLDP enabled, the switch periodically transmits an LLDP advertisement (packet) out each active port
enabled for outbound LLDP transmissions and receives LLDP advertisements on each active port enabled to
receive LLDP traffic (Configuring per-port transmit and receive modes (CLI) on page 228). Per-port
configuration options include four modes:

• Transmit and receive (tx_rx): This is the default setting on all ports. It enables a given port to both transmit
and receive LLDP packets and to store the data from received (inbound) LLDP packets in the switch's MIB.

• Transmit only (txonly): This setting enables a port to transmit LLDP packets that can be read by LLDP
neighbors. However, the port drops inbound LLDP packets from LLDP neighbors without reading them. This
prevents the switch from learning about LLDP neighbors on that port.
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• Receive only (rxonly): This setting enables a port to receive and read LLDP packets from LLDP neighbors
and to store the packet data in the switch's MIB. However, the port does not transmit outbound LLDP packets.
This prevents LLDP neighbors from learning about the switch through that port.

• Disable (disable): This setting disables LLDP packet transmissions and reception on a port. In this state, the
switch does not use the port for either learning about LLDP neighbors or informing LLDP neighbors of its
presence.

SNMP notification
You can enable the switch to send a notification to any configured SNMP trap receiver(s) when the switch detects
a remote LLDP data change on an LLDP-enabled port (Configuring SNMP notification support on page 227).

Per-port (outbound) data options
The following table lists the information the switch can include in the per-port, outbound LLDP packets it
generates. In the default configuration, all outbound LLDP packets include this information in the TLVs transmitted
to neighbor devices. However, you can configure LLDP advertisements on a per-port basis to omit some of this
information (Configuring a remote management address for outbound LLDP advertisements (CLI) on page
228).

Table 23: Data available for basic LLDP advertisements

Data type Configuration options Default Description

Time-to-Live 1 120 Seconds The length of time an
LLDP neighbor retains the
advertised data before
discarding it.

Chassis Type2, N/A Always Enabled Indicates the type of
identifier used for Chassis
ID.

Chassis ID33 N/A Always Enabled Uses base MAC address
of the switch.

Port Type4,33 N/A Always Enabled Uses "Local," meaning
assigned locally by LLDP.

Port Id33 N/A Always Enabled Uses port number of the
physical port. This is an
internal number reflecting
the reserved slot/port
position in the chassis. For
more information on this
numbering scheme, see
the appendix "MAC
Address Management".

Remote Management Address

Table Continued
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Data type Configuration options Default Description

Type3,3 N/A Always Enabled Shows the network
address type.

Address55 Default or Configured Uses a default address selection method unless an
optional address is configured. See Remote
management address on page 221.

System Name33 Enable/Disable Enabled Uses the switch's
assigned name.

System Description33 Enable/Disable Enabled Includes switch model
name and running
software version, and
ROM version.

Port Description33 Enable/Disable Enabled Uses the physical port
identifier.

System capabilities
supported3,3

Enable/Disable Enabled Identifies the switch's
primary capabilities
(bridge, router).

System capabilities
enabled3,66 3

Enable/Disable Enabled Identifies the primary
switch functions that are
enabled, such as routing.

1 The Packet Time-to-Live value is included in LLDP data packets.
2 Subelement of the Chassis ID TLV.
3 Populated with data captured internally by the switch. For more on these data types, refer to the IEEE P802.1AB Standard.
4 Subelement of the Port ID TLV.
5 Subelement of the Remote-Management-Address TLV.
6 Subelement of the System Capability TLV.

Remote management address
The switch always includes an IP address in its LLDP advertisements. This can be either an address selected by
a default process or an address configured for inclusion in advertisements. See IP address advertisements on
page 222.

Debug logging
You can enable LLDP debug logging to a configured debug destination (Syslog server, a terminal device, or both)
by executing the debug lldp command. (For more information on Debug and Syslog, see the "Troubleshooting"
appendix in this guide.) Note that the switch's Event Log does not record usual LLDP update messages.

Options for reading LLDP information collected by the switch
You can extract LLDP information from the switch to identify adjacent LLDP devices. Options include:
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• Using the switch's show lldp info command options to display data collected on adjacent LLDP devices—
as well as the local data the switch is transmitting to adjacent LLDP devices (Displaying the global LLDP,
port admin, and SNMP notification status (CLI) on page 223).

• Using an SNMP application that is designed to query the Neighbors MIB for LLDP data to use in device
discovery and topology mapping.

• Using thewalkmib command to display a listing of the LLDP MIB objects

LLDP and LLDP-MED standards compatibility
The operation covered by this section is compatible with these standards:

• IEEE P802.1AB

• RFC 2922 (PTOPO, or Physical Topology MIB)

• RFC 2737 (Entity MIB)

• RFC 2863 (Interfaces MIB)

• ANSI/TIA-1057/D6 (LLDP-MED; refer to LLDP-MED (media-endpoint-discovery) on page 233.)

LLDP operating rules
For additional information specific to LLDP-MED operation, see LLDP-MED (media-endpoint-discovery) on
page 233.

Port trunking
LLDP manages trunked ports individually. That is, trunked ports are configured individually for LLDP operation, in
the same manner as non-trunked ports. Also, LLDP sends separate advertisements on each port in a trunk, and
not on a per-trunk basis. Similarly, LLDP data received through trunked ports is stored individually, per-port.

IP address advertisements
In the default operation, if a port belongs to only one static VLAN, the port advertises the lowest-order IP address
configured on that VLAN. If a port belongs to multiple VLANs, the port advertises the lowest-order IP address
configured on the VLAN with the lowest VID. If the qualifying VLAN does not have an IP address, the port
advertises 127.0.0.1 as its IP address. For example, if the port is a member of the default VLAN (VID=1), and
there is an IP address configured for the default VLAN, the port advertises this IP address. In the default
operation, the IP address that LLDP uses can be an address acquired by DHCP or Bootp.

You can override the default operation by configuring the port to advertise any IP address that is manually
configured on the switch, even if the port does not belong to the VLAN configured with the selected IP address
(Configuring a remote management address for outbound LLDP advertisements (CLI) on page 228). (Note
that LLDP cannot be configured through the CLI to advertise an addresses acquired through DHCP or Bootp.
However, as mentioned above, in the default LLDP configuration, if the lowest-order IP address on the VLAN with
the lowest VID for a given port is a DHCP or Bootp address, the switch includes this address in its LLDP
advertisements unless another address is configured for advertisements on that port.) Also, although LLDP allows
configuring multiple remote management addresses on a port, only the lowest-order address configured on the
port will be included in outbound advertisements. Attempting to use the CLI to configure LLDP with an IP address
that is either not configured on a VLAN or has been acquired by DHCP or Bootp results in the following error
message.

xxx.xxx.xxx.xxx: This IP address is not configured or is a DHCP address.
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Spanning-tree blocking
Spanning tree does not prevent LLDP packet transmission or receipt on STP-blocked links.

802.1X blocking
Ports blocked by 802.1X operation do not allow transmission or receipt of LLDP packets.

Configuring LLDP operation

Displaying the global LLDP, port admin, and SNMP notification status (CLI)
In the default configuration, LLDP is enabled and in both transmit and receive mode on all active ports. The LLDP
configuration includes global settings that apply to all active ports on the switch, and per-port settings that affect
only the operation of the specified ports.

The commands in this section affect both LLDP and LLDP-MED operation. for information on operation and
configuration unique to LLDP-MED, refer to “LLDP-MED (Media-Endpoint-Discovery)”.

Syntax:

show lldp config
Displays the LLDP global configuration, LLDP port status, and SNMP notification status. For information on port
admin status, see Configuring per-port transmit and receive modes (CLI) on page 228.

show lldp config produces the following display when the switch is in the default LLDP configuration:

Viewing the general LLDP configuration

switch(config)# show lldp config

 LLDP Global Configuration

  LLDP Enabled [Yes] : Yes
  LLDP Transmit Interval     [30] : 30
  LLDP Hold time Multiplier   [4] : 4
  LLDP Delay Interval         [2] : 2
  LLDP Reinit Interval        [2] : 2
  LLDP Notification Interval  [5] : 5
  LLDP Fast Start Count       [5] : 5

 LLDP Port Configuration

  Port | AdminStatus NotificationEnabled  Med Topology Trap Enabled
  ---- + ----------- -------------------  -------------------------
  A1   | Tx_Rx       False                False
  A2   | Tx_Rx       False                False
  A3   | Tx_Rx       False                False
  A4   | Tx_Rx       False                False
  A5   | Tx_Rx       False                False
  A6   | Tx_Rx       False                False
  A7   | Tx_Rx       False                False
  A8   | Tx_Rx       False                False

NOTE: The values displayed in the LLDP column correspond to the lldp refresh-interval
command
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Viewing port configuration details (CLI)
Syntax:

show lldp config <port-list>
Displays the LLDP port-specific configuration for all ports in <port-list>, including which optional TLVs and any
non-default IP address that are included in the port's outbound advertisements.

For information on the notification setting, see Configuring SNMP notification support on page 227. For
information on the other configurable settings displayed by this command, see Configuring per-port transmit
and receive modes (CLI) on page 228.

Figure 30: Per-port configuration display

Configuring Global LLDP Packet Controls
The commands in this section configure the aspects of LLDP operation that apply the same to all ports in the
switch.

LLDP operation on the switch
Enabling LLDP operation (the default) causes the switch to:

• Use active, LLDP-enabled ports to transmit LLDP packets describing itself to neighbor devices.

• Add entries to its neighbors table based on data read from incoming LLDP advertisements.

Enabling or disabling LLDP operation on the switch (CLI)
For more information, see LLDP operation on the switch on page 224.

Syntax:

[no] lldp run
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Enables or disables LLDP operation on the switch.

The no form of the command, regardless of individual LLDP port configurations, prevents the switch from
transmitting outbound LLDP advertisements and causes the switch to drop all LLDP advertisements received
from other devices.

The switch preserves the current LLDP configuration when LLDP is disabled. After LLDP is disabled, the
information in the LLDP neighbors database remains until it times-out.

(Default: Enabled)

Disabling LLDP

switch(config)# no lldp run

Changing the packet transmission interval (CLI)
This interval controls how often active ports retransmit advertisements to their neighbors.

Syntax:

lldp refresh-interval <5-32768>
Changes the interval between consecutive transmissions of LLDP advertisements on any given port.

(Default: 30 seconds)

NOTE:

The refresh-interval must be greater than or equal to (4 x delay-interval). (The default
delay-interval is 2). For example, with the default delay-interval, the lowest refresh-
interval you can use is 8 seconds (4 x 2=8). Thus, if you want a refresh-interval of 5
seconds, you must first change the delay interval to 1 (that is, 4 x 1 5). If you want to change the
delay-interval, use the setmib command.

Time-to-Live for transmitted advertisements
The Time-to-Live value (in seconds) for all LLDP advertisements transmitted from a switch is controlled by the
switch that generates the advertisement and determines how long an LLDP neighbor retains the advertised data
before discarding it. The Time-to-Live value is the result of multiplying the refresh-interval by the
holdtime-multiplier.

Changing the time-to-live for transmitted advertisements (CLI)
For more information, see Time-to-Live for transmitted advertisements on page 225.

Syntax:

lldp holdtime-multiplier <2-10>
Changes the multiplier an LLDP switch uses to calculate the Time-to-Live for the LLDP advertisements it
generates and transmits to LLDP neighbors. When the Time-to-Live for a given advertisement expires, the
advertised data is deleted from the neighbor switch's MIB.

(Default: 4; Range 2–10)

Example:

If the refresh-interval on the switch is 15 seconds and the holdtime-multiplier is at the default, the Time-to-
Live for advertisements transmitted from the switch is 60 seconds (4 x 15).

To reduce the Time-to-Live, you could lower the holdtime-interval to 2, which would result in a Time-to-Live
of 30 seconds.
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switch(config)# lldp holdtime-multiplier 2

Delay interval between advertisements generated by value or status changes to the
LLDP MIB
The switch uses a delay-interval setting to delay transmitting successive advertisements resulting from these
LLDP MIB changes. If a switch is subject to frequent changes to its LLDP MIB, lengthening this interval can
reduce the frequency of successive advertisements. You can change the delay-interval by using either an SNMP
network management application or the CLI setmib command.

Changing the delay interval between advertisements generated by value or status
changes to the LLDP MIB (CLI)
Syntax:

setmib lldpTxDelay.0 -i <1-8192>
Uses setmib to change the minimum time (delay-interval) any LLDP port will delay advertising successive LLDP
advertisements because of a change in LLDP MIB content.

(Default: 2; Range 1–8192)

NOTE: The LLDP refresh-interval (transmit interval) must be greater than or equal to (4 x delay-
interval). The switch does not allow increasing the delay interval to a value that conflicts with this
relationship. That is, the switch displays Inconsistent value if (4 x delay-interval) exceeds the
current transmit interval, and the command fails. Depending on the current refresh-interval setting, it
may be necessary to increase the refresh-interval before using this command to increase the delay-
interval.

Example:

To change the delay-interval from 2 seconds to 8 seconds when the refresh-interval is at the default 30 seconds,
you must first set the refresh-interval to a minimum of 32 seconds (32 = 4 x 8) as shown in the following image.

Figure 31: Changing the transmit-delay interval

Reinitialization delay interval
In the default configuration, a port receiving a disable command followed immediately by a txonly, rxonly, or
tx_rx command delays reinitializing for two seconds, during which LLDP operation remains disabled. If an active
port is subjected to frequent toggling between the LLDP disabled and enabled states, LLDP advertisements are
more frequently transmitted to the neighbor device. Also, the neighbor table in the adjacent device changes more
frequently as it deletes, then replaces LLDP data for the affected port which, in turn, generates SNMP traps (if
trap receivers and SNMP notification are configured). All of this can unnecessarily increase network traffic.
Extending the reinitialization-delay interval delays the ability of the port to reinitialize and generate LLDP traffic
following an LLDP disable/enable cycle.
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Changing the reinitialization delay interval (CLI)
Syntax:

setmib lldpReinitDelay.0 -i <1-10>
Uses setmib to change the minimum time (reinitialization delay interval) an LLDP port will wait before
reinitializing after receiving an LLDP disable command followed closely by a txonly or tx_rx command. The delay
interval commences with execution of the lldp admin-status port-list disable command.

(Default: 2 seconds; Range 1–10 seconds)

Example:

The following command changes the reinitialization delay interval to five seconds:

switch(config)# setmib lldpreinitdelay.0 -i 5

Configuring SNMP notification support
You can enable SNMP trap notification of LLDP data changes detected on advertisements received from neighbor
devices, and control the interval between successive notifications of data changes on the same neighbor.

Enabling LLDP data change notification for SNMP trap receivers (CLI)
Syntax:

[no] lldp enable-notification <port-list>
Enables or disables each port in port-list for sending notification to configured SNMP trap receivers if an LLDP
data change is detected in an advertisement received on the port from an LLDP neighbor.

(Default: Disabled)

For information on configuring trap receivers in the switch, see SNMP notifications on page 194.

Example:

This command enables SNMP notification on ports 1 - 5:

switch(config)# lldp enable-notification 1-5

Changing the minimum interval for successive data change notifications for the same
neighbor
If LLDP trap notification is enabled on a port, a rapid succession of changes in LLDP information received in
advertisements from one or more neighbors can generate a high number of traps. To reduce this effect, you can
globally change the interval between successive notifications of neighbor data change.

Syntax:

setmib lldpnotificationinterval.0 -i <1-3600>
Globally changes the interval between successive traps generated by the switch. If multiple traps are generated in
the specified interval, only the first trap is sent. The remaining traps are suppressed. (A network management
application can periodically check the switch MIB to detect any missed change notification traps. See IEEE
P802.1AB or later for more information.)

(Default: 5 seconds)

Example:

The following command limits change notification traps from a particular switch to one per minute.
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switch(config)# setmib lldpnotificationinterval.0 -i 60 lldpNotificationInterval.0=60

Configuring per-port transmit and receive modes (CLI)
Syntax:

lldp admin-status <port-list> {<txonly | rxonly | tx_rx | disable>}
With LLDP enabled on the switch in the default configuration, each port is configured to transmit and receive
LLDP packets. These options enable you to control which ports participate in LLDP traffic and whether the
participating ports allow LLDP traffic in only one direction or in both directions.

txonly Configures the specified ports to transmit LLDP packets, but block inbound LLDP packets from
neighbor devices.

rxonly Configures the specified ports to receive LLDP packets from neighbors, but block outbound packets
to neighbors.

tx_rx Configures the specified ports to both transmit and receive LLDP packets. (This is the default
setting.)

disable Disables LLDP packet transmit and receive on the specified ports.

Basic LLDP per-port advertisement content
In the default LLDP configuration, outbound advertisements from each port on the switch include both mandatory
and optional data.

Mandatory Data
An active LLDP port on the switch always includes the mandatory data in its outbound advertisements. LLDP
collects the mandatory data, and, except for the Remote Management Address, you cannot use LLDP commands
to configure the actual data.

• Chassis Type (TLV subelement)

• Chassis ID (TLV)

• Port Type (TLV subelement)

• Port ID (TLV)

• Remote Management Address (TLV; actual IP address is a subelement that can be a default address or a
configured address)

Configuring a remote management address for outbound LLDP advertisements (CLI)
This is an optional command you can use to include a specific IP address in the outbound LLDP advertisements
for specific ports. For more information, see Basic LLDP per-port advertisement content on page 228.

Syntax:

[no] lldp config <port-list> ipAddrEnable <ip-address>
Replaces the default IP address for the port with an IP address you specify. This can be any IP address
configured in a static VLAN on the switch, even if the port does not belong to the VLAN configured with the
selected IP address.

The no form of the command deletes the specified IP address.
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If there are no IP addresses configured as management addresses, the IP address selection method returns to
the default operation.

Default: The port advertises the IP address of the lowest-numbered VLAN (VID) to which it belongs. If there is no
IP address configured on the VLANs to which the port belongs, and if the port is not configured to advertise an IP
address from any other (static) VLAN on the switch, the port advertises an address of 127.0.0.1.)

NOTE: This command does not accept either IP addresses acquired through DHCP or Bootp, or IP
addresses that are not configured in a static VLAN on the switch.

Example:

If port 3 belongs to a subnetted VLAN that includes an IP address of 10.10.10.100 and you want port 3 to use this
secondary address in LLDP advertisements, you need to execute the following command:

switch(config)# lldp config 3 ipAddrEnable 10.10.10.100
Syntax:

[no] lldp config <port-list> basicTlvEnable <TLV-Type>

port_descr For outbound LLDP advertisements, this TLV includes an alphanumeric string describing
the port.(Default: Enabled)

system_name For outbound LLDP advertisements, this TLV includes an alphanumeric string showing the
assigned name of the system.(Default: Enabled)

system_descr For outbound LLDP advertisements, this TLV includes an alphanumeric string describing
the full name and version identification for the hardware type, software version, and
networking application of the system.(Default: Enabled)

system_cap For outbound advertisements, this TLV includes a bitmask of supported system capabilities
(device functions). Also includes information on whether the capabilities are enabled.
(Default: Enabled)

Example:

If you want to exclude the system name TLV from the outbound LLDP advertisements for all ports on a switch,
use this command:

switch(config)# no lldp config 1-24 basicTlvEnable system_name
If you later decide to reinstate the system name TLV on ports 1-5, use this command:

switch(config)# lldp config 1-5 basicTlvEnable system_name

Optional Data
You can configure an individual port or group of ports to exclude one or more of the following data types from
outbound LLDP advertisements.

• Port description (TLV)

• System name (TLV)

• System description (TLV)

• System capabilities (TLV)
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◦ System capabilities Supported (TLV subelement)

◦ System capabilities Enabled (TLV subelement)

• Port speed and duplex (TLV subelement)

Optional data types, when enabled, are populated with data internal to the switch; that is, you cannot use LLDP
commands to configure their actual content.

Support for port speed and duplex advertisements
This feature is optional for LLDP operation, but is required for LLDP-MED operation.

Port speed and duplex advertisements are supported on the switches to inform an LLDP endpoint and the switch
port of each other's port speed and duplex configuration and capabilities. Configuration mismatches between a
switch port and an LLDP endpoint can result in excessive collisions and voice quality degradation. LLDP enables
discovery of such mismatches by supporting SNMP access to the switch MIB for comparing the current switch
port and endpoint settings. (Changing a current device configuration to eliminate a mismatch requires intervention
by the system operator.)

An SNMP network management application can be used to compare the port speed and duplex data configured
in the switch and advertised by the LLDP endpoint. You can also use the CLI to display this information. For more
information on using the CLI to display port speed and duplex information, seeViewing the current port speed
and duplex configuration on a switch port on page 244.

Configuring support for port speed and duplex advertisements (CLI)
For more information, see Support for port speed and duplex advertisements on page 230.

Syntax:

[no] lldp config <port-list> dot3TlvEnable macphy_config
Options
macphy_config

MAC Physical Config TLV

poeplus_config
Power Via MDI Config TLV

eee_config
EEE Config TLV

For outbound advertisements, this TLV includes the (local) switch port's current speed and duplex settings, the
range of speed and duplex settings the port supports, and the method required for reconfiguring the speed and
duplex settings on the device (autonegotiation during link initialization, or manual configuration).

Using SNMP to compare local and remote information can help in locating configuration mismatches.

(Default: Enabled)

NOTE: For LLDP operation, this TLV is optional. For LLDP-MED operation, this TLV is mandatory.

Port VLAN ID TLV support on LLDP
The port-vlan-id option enables advertisement of the port VLAN ID TLV as part of the regularly advertised
TLVs. This allows discovery of a mismatch in the configured native VLAN ID between LLDP peers. The
information is visible using show commands and is logged to the Syslog server.
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Configuring the VLAN ID TLV
This TLV advertisement is enabled by default. To enable or disable the TLV, use this command. For more
information, see Port VLAN ID TLV support on LLDP Port VLAN ID TLV support on LLDP on page 230.

Syntax:
[no] lldp config <port-list> dot1TlvEnable port-vlan-id
Enables the VLAN ID TLV advertisement.

The no form of the command disables the TLV advertisement.

Default: Enabled.

Options
port-vlan-id

Specifies the 802.1 TLV list to advertise.

vlan-name
Specifies that the VLAN name TLV is to be advertised.

Enabling the VLAN ID TLV

Switch(config)# lldp config a1 dot1TlvEnable port-vlan-id

Viewing the TLVs advertised
The show commands display the configuration of the TLVs. The command show lldp config lists the TLVs
advertised for each port, as shown in the following examples.

Displaying the TLVs for a port

switch(config)# show lldp config a1

 LLDP Port Configuration Detail

  Port   : A1
  AdminStatus [Tx_Rx] : Tx_Rx
  NotificationEnabled [False] : False
  Med Topology Trap Enabled [False] : False

  TLVS Advertised:
  * port_descr
  * system_name
  * system_descr
  * system_cap

  * capabilities
  * network_policy
  * location_id
  * poe

  * macphy_config

  * port_vlan_id 1

 IpAddress Advertised:
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  :
  :

1The VLAN ID TLV is being advertised.

Local device LLDP information

switch(config)# show lldp config info local-device a1

 LLDP Port Configuration Information Detail

  Port     : A1
  PortType : local
  PortId   : 1
  PortDesc : A1

  Port VLAN ID : 1 1

1The information that LLDP used in its advertisement.

Remote device LLDP information

switch(config)# show lldp info remote-device a1

LLDP Remote Device Information Detail

  Local Port   : A1
  ChassisType  : mac-address
  ChassisId    : 00 16 35 22 ca 40
  PortType     : local
  PortID       : 1
  SysName      : esp-dback
  System Descr : J8693A Switch 3500yl-48G, revision XX.13.03, ROM...
  PortDescr    : A1

  System Capabilities Supported : bridge, router
  System Capabilities Enabled   : bridge, router

  Port VLAN ID : 200

  Remote Management Address
     Type    : ipv4
     Address : 192.168.1.1

SNMP support
The LLDP-EXT-DOT1-MIB has the corresponding MIB variables for the Port VLAN ID TLV. The TLV
advertisement can be enabled or disabled using the MIB object lldpXdot1ConfigPortVlanTxEnable in the
lldpXdot1ConfigPortVlanTable.

The port VLAN ID TLV local information can be obtained from the MIB object lldpXdot1LocPortVlanId in the
local information table lldpXdot1LocTable.

The port VLAN ID TLV information about all the connected peer devices can be obtained from the MIB object
lldpXdot1RemPortVlanId in the remote information table lldpXdot1RemTable.
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LLDP-MED (media-endpoint-discovery)
LLDP-MED (ANSI/TIA-1057/D6) extends the LLDP (IEEE 802.1AB) industry standard to support advanced
features on the network edge for Voice Over IP (VoIP) endpoint devices with specialized capabilities and LLDP-
MED standards-based functionality. LLDP-MED in the switches uses the standard LLDP commands described
earlier in this section, with some extensions, and also introduces new commands unique to LLDP-MED operation.
The show commands described elsewhere in this section are applicable to both LLDP and LLDP-MED operation.
LLDP-MED benefits include:

• Plug-and-play provisioning for MED-capable, VoIP endpoint devices

• Simplified, vendor-independent management enabling different IP telephony systems to interoperate on one
network

• Automatic deployment of convergence network policies (voice VLANs, Layer 2/CoS priority, and Layer 3/QoS
priority)

• Configurable endpoint location data to support the Emergency Call Service (ECS) (such as Enhanced 911
service, 999, 112)

• Detailed VoIP endpoint data inventory readable via SNMP from the switch

• Power over Ethernet (PoE) status and troubleshooting support via SNMP

• support for IP telephony network troubleshooting of call quality issues via SNMP

This section describes how to configure and use LLDP-MED features in the switches to support VoIP network
edge devices (media endpoint devices) such as:

• IP phones

• Voice/media gateways

• Media servers

• IP communications controllers

• Other VoIP devices or servers

Figure 32: Example: of LLDP-MED network elements

LLDP-MED endpoint support
LLDP-MED interoperates with directly connected IP telephony (endpoint) clients having these features and
services:
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• Autonegotiate speed and duplex configuration with the switch

• Use the following network policy elements configured on the client port
◦ Voice VLAN ID

◦ 802.1p (Layer 2) QoS

◦ Diffserv codepoint (DSCP) (Layer 3) QoS

• Discover and advertise device location data learned from the switch

• Support ECS (such as E911, 999, and 112)

• Advertise device information for the device data inventory collected by the switch, including:

◦ Hardware revision

◦ Firmware revision

◦ Software revision

◦ Serial number

◦ Manufacturer name

◦ Model name

Asset ID

• Provide information on network connectivity capabilities (For example, a multi-port VoIP phone with Layer 2
switch capability)

• Support the fast-start capability

NOTE:

LLDP-MED is intended for use with VoIP endpoints and is not designed to support links between
network infrastructure devices, such as switch-to-switch or switch-to-router links.

LLDP-MED endpoint device classes
LLDP-MED endpoint devices are, by definition, located at the network edge and communicate using the LLDP-
MED framework. Any LLDP-MED endpoint device belongs to one of the following three classes:

• Class 1 (generic endpoint devices): These devices offer the basic LLDP discovery services, network policy
advertisement (VLAN ID, Layer 2/802.1p priority, and Layer 3/DSCP priority), and PoE management. This
class includes such devices as IP call controllers and communication-related servers.

• Class 2 (media endpoint devices): These devices offer all Class 1 features plus media-streaming capability,
and include such devices as voice/media gateways, conference bridges, and media servers.

• Class 3 (communication devices): These devices are typically IP phones or end-user devices that otherwise
support IP media and offer all Class 1 and Class 2 features, plus location identification and emergency 911
capability, Layer 2 switch support, and device information management.

LLDP-MED operational support
The switches offer two configurable TLVs supporting MED-specific capabilities:

• medTlvEnable (for per-port enabling or disabling of LLDP-MED operation)

• medPortLocation (for configuring per-port location or emergency call data)
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NOTE:

LLDP-MED operation also requires the port speed and duplex TLV (dot3TlvEnable), which is enabled
in the default configuration.

Topology change notifications provide one method for monitoring system activity. However, because
SNMP normally employs UDP, which does not guarantee datagram delivery, topology change
notification should not be relied upon as the sole method for monitoring critical endpoint device
connectivity.

LLDP-MED fast start control
Syntax:

lldp fast-start-count <1-10>
An LLDP-MED device connecting to a switch port may use the data contained in the MED TLVs from the switch to
configure itself. However, the lldp refresh-interval setting (default: 30 seconds) for transmitting
advertisements can cause an unacceptable delay in MED device configuration.

To support rapid LLDP-MED device configuration, the lldp fast-start-count command temporarily
overrides the refresh-interval setting for the fast-start-count advertisement interval. This results in the
port initially advertising LLDP-MED at a faster rate for a limited time. Thus, when the switch detects a new LLDP-
MED device on a port, it transmits one LLDP-MED advertisement per second out the port for the duration of the
fast-start-count interval. In most cases, the default setting should provide an adequate fast-start-
count interval.

(Default: 5 seconds)

NOTE:

This global command applies only to ports on which a new LLDP-MED device is detected. It does not
override the refresh-interval setting on ports where non-MED devices are detected.

Advertising device capability, network policy, PoE status and location data
The medTlvEnable option on the switch is enabled in the default configuration and supports the following LLDP-
MED TLVs:

• LLDP-MED capabilities: This TLV enables the switch to determine:
◦ Whether a connected endpoint device supports LLDP-MED

◦ Which specific LLDP-MED TLVs the endpoint supports

◦ The device class (1, 2, or 3) for the connected endpoint

This TLV also enables an LLDP-MED endpoint to discover what LLDP-MED TLVs the switch port currently
supports.

• Network policy operating on the port to which the endpoint is connected (VLAN, Layer 2 QoS, Layer 3 QoS)

• PoE (MED Power-over-Ethernet)

• Physical location data (see Configuring location data for LLDP-MED devices on page 238)
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NOTE: LLDP-MED operation requires the macphy_config TLV subelement (enabled by default) that
is optional for IEEE 802.1AB LLDP operation. For more information, see the dot3TlvEnable
macphy_config command (Configuring support for port speed and duplex advertisements
(CLI) on page 230).

Network policy advertisements
Network policy advertisements are intended for real-time voice and video applications, and include these TLV
subelements:

• Layer 2 (802.1p) QoS

• Layer 3 DSCP (diffserv code point) QoS

• Voice VLAN ID (VID)

VLAN operating rules
These rules affect advertisements of VLANs in network policy TLVs:

• The VLAN ID TLV subelement applies only to a VLAN configured for voice operation (vlan <vid> voice ).

• If there are multiple voice VLANs configured on a port, LLDP-MED advertises the voice VLAN having the
lowest VID.

• The voice VLAN port membership configured on the switch can be tagged or untagged. However, if the LLDP-
MED endpoint expects a tagged membership when the switch port is configured for untagged, or the reverse,
a configuration mismatch results. (Typically, the endpoint expects the switch port to have a tagged voice VLAN
membership.)

• If a given port does not belong to a voice VLAN, the switch does not advertise the VLAN ID TLV through this
port.

Policy elements
These policy elements may be statically configured on the switch or dynamically imposed during an authenticated
session on the switch using a RADIUS server and 802.1X or MAC authentication. (Web authentication does not
apply to VoIP telephones and other telecommunications devices that are not capable of accessing the switch
through a Web browser.) The QoS and voice VLAN policy elements can be statically configured with the following
CLI commands:

vlan <vid> voice
vlan <vid> {<tagged | untagged> <port-list>}
int <port-list> qos priority <0-7>
vlan <vid> qos dscp <codepoint>

NOTE: A codepoint must have an 802.1p priority before you can configure it for use in prioritizing
packets by VLAN-ID. If a codepoint you want to use shows No Override in the Priority column
of the DSCP policy table (display with show qos-dscp map, then use qos-dscp map
<codepoint> priority <0-7> to configure a priority before proceeding. For more information
on this topic, see the "Quality of Service (QoS): Managing Bandwidth More Effectively" in the
advanced traffic management guide for your switch.

Enabling or Disabling medTlvEnable
In the default LLDP-MED configuration, the TLVs controlled by medTlvEnable are enabled. For more information,
see Advertising device capability, network policy, PoE status and location data on page 235.
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Syntax:

[no] lldp config <port-list> medTlvEnable <medTlv>
Enables or disables advertisement of the following TLVs on the specified ports:

• Device capability TLV

• Configured network policy TLV

• Configured location data TLV (see Configuring location data for LLDP-MED devices on page 238.)

• Current PoE status TLV

(Default: All of the above TLVs are enabled.)

Helps to locate configuration mismatches by allowing use of an SNMP application to compare the LLDP-MED
configuration on a port with the LLDP-MED TLVs advertised by a neighbor connected to that port.

capabilities This TLV enables the switch to determine:

• Which LLDP-MED TLVs a connected endpoint can discover

• The device class (1, 2, or 3) for the connected endpoint

This TLV also enables an LLDP-MED endpoint to discover what LLDP-MED TLVs
the switch port currently supports.(Default: enabled)

This TLV cannot be disabled unless the network_policy, poe, and location_id
TLVs are already disabled.

network_policy This TLV enables the switch port to advertise its configured network policies (voice
VLAN, Layer 2 QoS, Layer 3 QoS), and allows LLDP-MED endpoint devices to
autoconfigure the voice network policy advertised by the switch. This also enables
the use of SNMP applications to troubleshoot statically configured endpoint network
policy mismatches.(Default: Enabled)

Network policy is advertised only for ports that are configured as members of the
voice VLAN. If the port belongs to more than one voice VLAN, the voice VLAN with
the lowest-numbered VID is selected as the VLAN for voice traffic. Also, this TLV
cannot be enabled unless the capability TLV is already enabled.

For more information, see Network policy advertisements on page 236.

location_id This TLV enables the switch port to advertise its configured location data (if any). For
more information on configuring location data, see Configuring location data for
LLDP-MED devices on page 238.(Default: Enabled)

When disabled, this TLV cannot be enabled unless the capability TLV is already
enabled.

poe This TLV enables the switch port to advertise its current PoE state and to read the
PoE requirements advertised by the LLDP-MED endpoint device connected to the
port.(Default: Enabled)

When disabled, this TLV cannot be enabled unless the capability TLV is already
enabled.

For more on this topic, see PoE advertisements on page 238.
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PoE advertisements
These advertisements inform an LLDP-MED endpoint of the power (PoE) configuration on switch ports. Similar
advertisements from an LLDP-MED endpoint inform the switch of the endpoint's power needs and provide
information that can be used to identify power priority mismatches.

PoE TLVs include the following power data:

• Power type: indicates whether the device is a power-sourcing entity (PSE) or a PD. Ports on the J8702A PoE
zl module are PSE devices. A MED-capable VoIP telephone is a PD.

• Power source: indicates the source of power in use by the device. Power sources for PDs include PSE, local
(internal), and PSE/local. The switches advertise Unknown.

• Power priority: indicates the power priority configured on the switch (PSE) port or the power priority
configured on the MED-capable endpoint.

• Power value: indicates the total power in watts that a switch port (PSE) can deliver at a particular time, or the
total power in watts that the MED endpoint (PD) requires to operate.

Viewing PoE advertisements
To display the current power data for an LLDP-MED device connected to a port, use the following command:

show lldp info remote-device <port-list>
For more information on this command, see page A-60.

To display the current PoE configuration on the switch, use the following commands:

show power brief <port-list>
show power <port-list>

Location data for LLDP-MED devices
You can configure a switch port to advertise location data for the switch itself, the physical wall-jack location of the
endpoint (recommended), or the location of a DHCP server supporting the switch, endpoint, or both. You also
have the option of configuring these different address types:

• Civic address: physical address data such as city, street number, and building information

• ELIN (Emergency Location Identification Number): an emergency number typically assigned to MLTS
(Multiline Telephone System) Operators in North America

• Coordinate-based location: attitude, longitude, and altitude information (Requires configuration via an SNMP
application.)

Configuring location data for LLDP-MED devices
Syntax:

[no] lldp config <port-list> medPortLocation <Address-Type>
Configures location of emergency call data the switch advertises per port in the location_id TLV. This TLV is
for use by LLDP-MED endpoints employing location-based applications.
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NOTE: The switch allows one medPortLocation entry per port (without regard to type). Configuring a
new medPortLocation entry of any type on a port replaces any previously configured entry on that
port.

civic-addr <COUNTRY-STR> <WHAT> <CA-TYPE> <CA-VALUE> … [< CA-TYPE > < CA-VALUE >] … [< CA-TYPE > < CA-VALUE >]

Enables configuration of a physical address on a switch port and allows up to 75 characters of address
information.

COUNTRY-STR A two-character country code, as defined by ISO 3166. Some examples include FR
(France), DE (Germany), and IN (India). This field is required in a civic-addr
command. (For a complete list of country codes, visit http://www.iso.org.)

WHAT A single-digit number specifying the type of device to which the location data
applies:

0: Location of DHCP server

1: Location of switch

2: Location of LLDP-MED endpoint (recommended application)

This field is required in a civic-addr command.

Table Continued
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Type/Value Pairs
(CA-TYPE and CA-
VALUE)

A series of data pairs, each composed of a location data "type" specifier and the
corresponding location data for that type. That is, the first value in a pair is expected
to be the civic address "type" number ( CA-TYPE), and the second value in a pair is
expected to be the corresponding civic address data ( CA-VALUE).

For example, if the CA-TYPE for "city name" is "3," the type/value pair to define the
city of Paris is "3 Paris."

Multiple type/value pairs can be entered in any order, although Hewlett Packard
Enterprise recommends that multiple pairs be entered in ascending order of the CA-
TYPE.

When an emergency call is placed from a properly configured class 3 endpoint
device to an appropriate PSAP, the country code, device type, and type/value pairs
configured on the switch port are included in the transmission. The "type" specifiers
are used by the PSAP to identify and organize the location data components in an
understandable format for response personnel to interpret.

A civic-addr command requires a minimum of one type/value pair, but typically
includes multiple type/value pairs as needed to configure a complete set of data
describing a given location.

CA-TYPE: This is the first entry in a type/value pair and is a number defining the
type of data contained in the second entry in the type/value pair ( CA-VALUE).
Some examples of CA-TYPE specifiers include:

• 3=city

• 6=street (name)

• 25=building name

(Range: 0 - 255)For a sample listing of CA-TYPE specifiers, see Some location
codes used in CA-TYPE fields.

CA-VALUE:This is the second entry in a type/value pair and is an alphanumeric
string containing the location information corresponding to the immediately
preceding CA-TYPE entry.

Strings are delimited by either blank spaces, single quotes (' … '), or double quotes
("… ").

Each string should represent a specific data type in a set of unique type/value pairs
comprising the description of a location, and each string must be preceded by a CA-
TYPE number identifying the type of data in the string.

A switch port allows one instance of any given CA-TYPE. For example, if a type/
value pair of 6 Atlantic (to specify "Atlantic" as a street name) is configured on port
A5 and later another type/value pair of 6 Pacific is configured on the same port,
Pacific replaces Atlantic in the civic address location configured for port A5.

elin-addr
<emergency-number>

This feature is intended for use in ECS applications to support class 3 LLDP-MED
VoIP telephones connected to a switch in an MLTS infrastructure.

An ELIN is a valid NANP format telephone number assigned to MLTS operators in
North America by the appropriate authority. The ELIN is used to route emergency
(E911) calls to a PSAP.

(Range: 1-15 numeric characters)
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Configuring coordinate-based locations
Latitude, longitude, and altitude data can be configured per switch port using an SNMP management application.
For more information, see the documentation provided with the application. A further source of information on this
topic is RFC 3825-Dynamic host configuration protocol option for coordinate-based location configuration
information.

NOTE: Endpoint use of data from a medPortLocation TLV sent by the switch is device-dependent.
See the documentation provided with the endpoint device.

Table 24: Some location codes used in CA-TYPE fields

Location element Code1 Location element Code

national subdivision 1 street number 19

regional subdivision 2 additional location data 22

city or township 3 unit or apartment 26

city subdivision 4 floor 27

street 6 room number 28

street suffix 18

1 The code assignments in this table are examples from a work-in-progress (the internet draft titled "Dynamic Host Configuration
Protocol (DHCPv4 and DHCPv6) Option for Civic Addresses Configuration Information draft-ietf-geopriv-dhcp-civil-06" dated
May 30, 2005.) For the actual codes to use, contact the PSAP or other authority responsible for specifying the civic addressing
data standard for your network.

Example:

Suppose a system operator wants to configure the following information as the civic address for a telephone
connected to her company's network through port A2 of a switch at the following location:

CA-type CA-type CA-VALUE

national subdivision 1 CA

city 3 Widgitville

street 6 Main

street number 19 1433

unit 26 Suite 4-N

floor 27 4

room number 28 N4-3

The following example shows the commands for configuring and displaying the above data.
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A civic address configuration

switch(config)# lldp config 2 medportlocation civic-addr US 2 1 CA 3
Widgitville 6 Main 19 1433 26 Suite_4—N 27 4 28 N4—3

switch(config)# show lldp config 2
 LLDP Port Configuration Detail
  Port : A2
  AdminStatus [Tx_Rx] : Tx_Rx
  NotificationEnabled [False] : False
  Med Topology Trap Enabled [False] : False
  Country Name          : US 
  What                  : 2
  Ca-Type               : 1
  Ca-Length             : 2
  Ca-Value              : CA 
  Ca-Type               : 3
  Ca-Length             : 11
  Ca-Value              : Widgitville
  Ca-Type               : 6
  Ca-Length             : 4
  Ca-Value              : Main
  Ca-Type               : 19
  Ca-Length             : 4
  Ca-Value              : 1433
  Ca-Type               : 26
  Ca-Length             : 9
  Ca-Value              : Suite_4-N 
  Ca-Type               : 27
  Ca-Length             : 1
  Ca-Value              : 4
  Ca-Type               : 28
  Ca-Length             : 4
  Ca-Value              : N4-3

Viewing switch information available for outbound advertisements
Syntax:
show lldp info local-device [port-list]
Without the [port-list] option, displays the global switch information and the per-port information currently
available for populating outbound LLDP advertisements.

With the [port-list] option, displays only the following port-specific information that is currently available for
outbound LLDP advertisements on the specified ports:

• PortType
• PortId
• PortDesc

NOTE: This command displays the information available on the switch. Use the lldp config
<port-list> command to change the selection of information that is included in actual outbound
advertisements. In the default LLDP configuration, all information displayed by this command is
transmitted in outbound advertisements.

In the default configuration, the switch information currently available for outbound LLDP advertisements appears
similar to the display in the following example.
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Displaying the global and per-port information available for outbound advertisements

switch(config)# show lldp info local-device

 LLDP Local Device Information

  Chassis Type : mac-address
  Chassis Id : 00 23 47 4b 68 DD
  System Name : Switch1
  System Description : J9091A Switch 3500yl, revision XX.15.06...
  System Capabilities Supported:bridge
  System Capabilities Enabled:bridge

  Management Address 1
     Type:ipv4
     Address:

  LLDP Port Information

   Port  | PortType  PortId  PortDesc
   ----- + --------- ------- ---------
   1     | local     1       1
   2     | local     2       2
   3     | local     3       3
   4     | local     4       4
   5     | local     5       5

1

The Management Address field displays only the LLDP-configurable IP addresses on the switch. (Only manually-
configured IP addresses are LLDP-configurable.) If the switch has only an IP address from a DHCP or Bootp
server, then the Management Address field is empty (because there are no LLDP-configurable IP addresses
available.

The default per-port information content for ports 1 and 2

switch(config)# show lldp info local 1-2

  LLDP Local Port Information Detail

   Port     : 1
   PortType : local
   PortId   : 1
   PortDesc : 1

---------------------------------------- 
   Port     : 2
   PortType : local
   PortId   : 2
   PortDesc : 2

Displaying the current port speed and duplex configuration on a switch port
You can compare port speed and duplex information for a switch port and a connected LLDP-MED endpoint for
configuration mismatches by using an SNMP application. You can also use the switch CLI to display this
information, if necessary. The show interfaces brief <port-list> and show lldp info remote-
device [port-list] commands provide methods for displaying speed and duplex information for switch
ports. For information on displaying the currently configured port speed and duplex on an LLDP-MED endpoint,
see Viewing the current port speed and duplex configuration on a switch port on page 244.
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Viewing the current port speed and duplex configuration on a switch port
Syntax:

show interfaces brief <port-list>
Includes port speed and duplex configuration in the Mode column of the resulting display.

Viewing advertisements currently in the neighbors MIB
Syntax:
show lldp info remote-device [port-list]
Without the [port-list] option, provides a global list of the individual devices it has detected by reading LLDP
advertisements. Discovered devices are listed by the inbound port on which they were discovered.

Multiple devices listed for a single port indicates that such devices are connected to the switch through a hub.

Discovering the same device on multiple ports indicates that the remote device may be connected to the
switch in one of the following ways:

• Through different VLANS using separate links. (This applies to switches that use the same MAC address for
all configured VLANs.)

• Through different links in the same trunk.

• Through different links using the same VLAN. (In this case, spanning-tree should be invoked to prevent a
network topology loop. Note that LLDP packets travel on links that spanning-tree blocks for other traffic types.)

With the [port-list] option, provides a listing of the LLDP data that the switch has detected in advertisements
received on the specified ports.

For descriptions of the various types of information displayed by these commands, see Data available for basic
LLDP advertisements.

A global listing of discovered devices

switch(config)# show lldp info remote

 LLDP Remote Devices Information

  LocalPort | ChassisId                 PortId PortDescr SysName
  --------- + ------------------------- ------ --------- -------------
  1         | 00 11 85 35 3b 80         6      6         Switch
  2         | 00 11 85 cf 66 60         8      8         Switch

An LLLDP-MED listing of an advertisement received from an LLDP-MED (VoIP telephone) source

switch(config)# show lldp info remote-device 1

 LLDP Remote Device Information Detail

  Local Port   : A2
  ChassisType  : network-address
  ChassisId    : 0f ff 7a 5c
  PortType     : mac-address
  PortId       : 08 00 0f 14 de f2
  SysName      : Switch
  System Descr : Switch, revision xx.15.06.0000x
  PortDescr    : LAN Port
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  System Capabilities Supported : bridge, telephone
  System Capabilities Enabled   : bridge, telephone

  Remote Management Address

  MED Information Detail 1
    EndpointClass          :Class3
    Media Policy Vlan id   :10
    Media Policy Priority  :7
    Media Policy Dscp      :44
    Media Policy Tagged    :False
    Poe Device Type        :PD
    Power Requested        :47
    Power Source           :Unknown
    Power Priority         :High

1Indicates the policy configured on the telephone. A configuration mismatch occurs if the supporting port is
configured differently.

Displaying LLDP statistics
LLDP statistics are available on both a global and a per-port levels. Rebooting the switch resets the LLDP
statistics counters to zero. Disabling the transmit and/or receive capability on a port "freezes" the related port
counters at their current values.

Viewing LLDP statistics
For more information, see Displaying LLDP statistics on page 245.

Syntax:

show lldp stats [port-list]
The global LLDP statistics command displays an overview of neighbor detection activity on the switch, plus data
on the number of frames sent, received, and discarded per-port.

The per-port LLDP statistics command enhances the list of per-port statistics provided by the global statistics
command with some additional per-port LLDP statistics.

Global LLDP Counters:

Neighbor Entries List Last
Updated

The elapsed time since a neighbor was last added or deleted.

New Neighbor Entries Count The total of new LLDP neighbors detected since the last switch reboot.
Disconnecting, and then reconnecting a neighbor increments this
counter.

Neighbor Entries Deleted
Count

The number of neighbor deletions from the MIB for AgeOut Count and
forced drops for all ports.For example, if the admin status for port on a
neighbor device changes from tx_rx or txonly to disabled or
rxonly, the neighbor device sends a "shutdown" packet out the port
and ceases transmitting LLDP frames out that port.The device receiving
the shutdown packet deletes all information about the neighbor received
on the applicable inbound port and increments the counter.

Table Continued
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Neighbor Entries Dropped
Count

The number of valid LLDP neighbors the switch detected, but could not
add.This can occur, For example, when a new neighbor is detected when
the switch is already supporting the maximum number of neighbors. See 
Neighbor maximum on page 247.

Neighbor Entries AgeOut
Count

The number of LLDP neighbors dropped on all ports because of Time-to-
Live expiring.

Per-Port LLDP Counters:

NumFramesRecvd The total number of valid, inbound LLDP advertisements received from
any neighbors on port-list .Where multiple neighbors are connected
to a port through a hub, this value is the total number of LLDP
advertisements received from all sources.

NumFramesSent The total number of LLDP advertisements sent from port-list.

NumFramesDiscarded The total number of inbound LLDP advertisements discarded by port-
list.This can occur, For example, when a new neighbor is detected on the
port, but the switch is already supporting the maximum number of
neighbors. See Neighbor maximum on page 247. This can also be an
indication of advertisement formatting problems in the neighbor device.

Frames Invalid The total number of invalid LLDP advertisements received on the port.An
invalid advertisement can be caused by header formatting problems in
the neighbor device.

TLVs Unrecognized The total number of LLDP TLVs received on a port with a type value in
the reserved range.This can be caused by a basic management TLV
from a later LLDP version than the one currently running on the switch.

TLVs Discarded The total number of LLDP TLVs discarded for any reason. In this case,
the advertisement carrying the TLV may be accepted, but the individual
TLV is not usable.

Neighbor Ageouts The number of LLDP neighbors dropped on the port because of Time-to-
Live expiring.

Examples:

A global LLDP statistics display

switch(config)# show lldp stats

 LLDP Device Statistics

  Neighbor Entries List Last Updated : 2 hours
  New Neighbor Entries Count : 20
  Neighbor Entries Deleted Count : 20
  Neighbor Entries Dropped Count : 0
  Neighbor Entries AgeOut Count : 20

 LLDP Port Statistics
 
  Port   | NumFramesRecvd NumFramesSent NumFramesDiscarded
  ------ + -------------- ------------- ------------------ 
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  A1     | 97317          97843         0
  A2     | 21             12            0
  A3     | 0              0             0
  A4     | 446            252           0
  A5     | 0              0             0
  A6     | 0              0             0
  A7     | 0              0             0
  A8     | 0              0             0

A per-port LLDP statistics display

switch(config)# show lldp stats 1

 LLDP Port Statistics Detail

  PortName : 1
  Frames Discarded  : 0
  Frames Invalid    : 0
  Frames Received   : 7309
  Frames Sent       : 7231
  TLVs Unrecognized : 0
  TLVs Discarded    : 0
  Neighbor Ageouts  : 0

LLDP Operating Notes

Neighbor maximum
The neighbors table in the switch supports as many neighbors as there are ports on the switch. The switch can
support multiple neighbors connected through a hub on a given port, but if the switch neighbor maximum is
reached, advertisements from additional neighbors on the same or other ports will not be stored in the neighbors
table unless some existing neighbors time-out or are removed.

LLDP packet forwarding
An 802.1D-compliant switch does not forward LLDP packets, regardless of whether LLDP is globally enabled or
disabled on the switch.

One IP address advertisement per port
LLDP advertises only one IP address per port, even if multiple IP addresses are configured by lldp config
port-list ipAddrEnable on a given port.

802.1Q VLAN Information
LLDP packets do not include 802.1Q header information and are always handled as untagged packets.

Effect of 802.1X Operation
If 802.1X port security is enabled on a port, and a connected device is not authorized, LLDP packets are not
transmitted or received on that port. Any neighbor data stored in the neighbor MIB for that port prior to the
unauthorized device connection remains in the MIB until it ages out. If an unauthorized device later becomes
authorized, LLDP transmit and receive operation resumes.

Neighbor data can remain in the neighbor database after the neighbor is disconnected
After disconnecting a neighbor LLDP device from the switch, the neighbor can continue to appear in the switch's
neighbor database for an extended period if the neighbor's holdtime-multiplier is high; especially if the
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refresh-interval is large. See Changing the time-to-live for transmitted advertisements (CLI) on page
225.

Mandatory TLVs
All mandatory TLVs required for LLDP operation are also mandatory for LLDP-MED operation.

LLDP and CDP data management
This section describes points to note regarding LLDP and CDP (Cisco Discovery Protocol) data received by the
switch from other devices. LLDP operation includes both transmitting LLDP packets to neighbor devices and
reading LLDP packets received from neighbor devices. CDP operation is limited to reading incoming CDP
packets from neighbor devices. (switches do not generate CDP packets.)

Incoming CDP and LLDP packets tagged for VLAN 1 are processed even if VLAN 1 does not contain any ports.
VLAN 1 must be present, but it is typically present as the default VLAN for the switch.

NOTE: The switch may pick up CDP and LLDP multicast packets from VLAN 1 even when CDP-
and /or LLDP-enabled ports are not members of VLAN 1.

LLDP and CDP neighbor data
With both LLDP and (read-only) CDP enabled on a switch port, the port can read both LLDP and CDP
advertisements, and stores the data from both types of advertisements in its neighbor database. (The switch
stores only CDP data that has a corresponding field in the LLDP neighbor database.) The neighbor database
itself can be read by either LLDP or CDP methods or by using the show lldp commands. Take note of the
following rules and conditions:

• If the switch receives both LLDP and CDP advertisements on the same port from the same neighbor, the
switch stores this information as two separate entries if the advertisements have different chassis ID and port
ID information.

• If the chassis and port ID information are the same, the switch stores this information as a single entry. That is,
LLDP data overwrites the corresponding CDP data in the neighbor database if the chassis and port ID
information in the LLDP and CDP advertisements received from the same device is the same.

• Data read from a CDP packet does not support some LLDP fields, such as "System Descr,"
"SystemCapSupported," and "ChassisType." For such fields, LLDP assigns relevant default values. Also:
◦ The LLDP "System Descr" field maps to CDP's "Version" and "Platform" fields.

◦ The switch assigns "ChassisType" and "PortType" fields as "local" for both the LLDP and the CDP
advertisements it receives.

◦ Both LLDP and CDP support the "System Capability" TLV. However, LLDP differentiates between what a
device is capable of supporting and what it is actually supporting, and separates the two types of
information into subelements of the System Capability TLV. CDP has only a single field for this data. Thus,
when CDP System Capability data is mapped to LLDP, the same value appears in both LLDP System
Capability fields.

◦ System Name and Port Descr are not communicated by CDP, and thus are not included in the switch's
Neighbors database.

NOTE: Because switches do not generate CDP packets, they are not represented in the CDP data
collected by any neighbor devices running CDP.

A switch with CDP disabled forwards the CDP packets it receives from other devices, but does not
store the CDP information from these packets in its own MIB.
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LLDP data transmission/collection and CDP data collection are both enabled in the switch's default configuration.
In this state, an SNMP network management application designed to discover devices running either CDP or
LLDP can retrieve neighbor information from the switch regardless of whether LLDP or CDP is used to collect the
device-specific information.

Protocol state Packet generation Inbound data
management

Inbound packet
forwarding

CDP Enabled N/A Store inbound CDP data. No forwarding of inbound
CDP packets.

CDP Disabled N/A No storage of CDP data
from neighbor devices.

Floods inbound CDP
packets from connected
devices to outbound ports.

LLDP Enabled1 Generates and
transmits LLDP
packets out all ports
on the switch.

Store inbound LLDP data. No forwarding of inbound
LLDP packets.

LLDP Disabled No packet
generation.

No storage of LLDP data
from neighbor devices.

No forwarding of inbound
LLDP packets.

CDP operation and commands
By default the switches have CDP enabled on each port. This is a read-only capability, meaning that the switch
can receive and store information about adjacent CDP devices but does not generate CDP packets.

When a CDP-enabled switch receives a CDP packet from another CDP device, it enters that device's data in the
CDP Neighbors table, along with the port number where the data was received—and does not forward the packet.
The switch also periodically purges the table of any entries that have expired. (The hold time for any data entry in
the switch's CDP Neighbors table is configured in the device transmitting the CDP packet and cannot be
controlled in the switch receiving the packet.) A switch reviews the list of CDP neighbor entries every three
seconds and purges any expired entries.

NOTE:

For details on how to use an SNMP utility to retrieve information from the switch's CDP Neighbors
table maintained in the switch's MIB, see the documentation provided with the particular SNMP utility.

Viewing the current CDP configuration of the switch
CDP is shown as enabled/disabled both globally on the switch and on a per-port basis.

Syntax:

show cdp
Lists the global and per-port CDP configuration of the switch.

The following example shows the default CDP configuration.

Default CDP configuration

switch(config)# show cdp

 Global CDP information
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  Enable CDP [Yes] : Yes (Receive Only)

  Port CDP
  ---- --------
  1    enabled
  2    enabled
  3    enabled
  .      .
  .      .
  .      .

Viewing the current CDP neighbors table of the switch
Devices are listed by the port on which they were detected.

Syntax:

show cdp neighbors
Lists the neighboring CDP devices the switch detects, with a subset of the information collected from the device's
CDP packet.

[[e] port-numb [detail]]
Lists the CDP device connected to the specified port. (Allows
only one port at a time.)Using detail provides a longer list of
details on the CDP device the switch detects on the specified
port.

[detail [[e] port-numb]]
Provides a list of the details for all of the CDP devices the
switch detects.Using port-num produces a list of details for
the selected port.

The following example displays the CDP devices that the switch has detected by receiving their CDP packets.

CDP neighbors table listing

switch(config)# show cdp neighbors

 CDP neighbors information

  Port Device ID                     | Platform                     Capability
  ---- ----------------------------- + ---------------------------- -----------
  1    Accounting (0030c1-7fcc40)    | J4812A Switch. . .           S
  2    Resear¢1-1 (0060b0-889e43)    | J4121A Switch. . .           S
  4    Support (0060b0_761a45)       | J4121A Switch. . .           S
  7    Marketing (0030c5_33dc59)     | J4313A Switch. . .           S
  12   Mgmt NIC(099a05-09df9b        | NIC Model X666               H
  12   Mgmt NIC(099a05-09df11        | NIC Model X666               H

Enabling and Disabling CDP Operation
Enabling CDP operation (the default) on the switch causes the switch to add entries to its CDP Neighbors table
for any CDP packets it receives from other neighboring CDP devices.

Disabling CDP operation clears the switch's CDP Neighbors table and causes the switch to drop inbound CDP
packets from other devices without entering the data in the CDP Neighbors table.

Syntax:

[no] cdp run
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Enables or disables CDP read-only operation on the switch.

(Default: Enabled)

Example:

To disable CDP read-only on the switch:

switch(config)# no cdp run
When CDP is disabled:

• show cdp neighbors
displays an empty CDP Neighbors table

• show cdp
displaysGlobal CDP informationEnable CDP [Yes]: No

Enabling or disabling CDP operation on individual ports
In the factory-default configuration, the switch has all ports enabled to receive CDP packets. Disabling CDP on a
port causes it to drop inbound CDP packets without recording their data in the CDP Neighbors table.

Syntax:

[no] cdp enable {< [e] port-list >}
Example:

To disable CDP on port A1:

switch(config)# no cdp enable a1

Configuring CDPv2 for voice transmission
Legacy Cisco VOIP phones only support manual configuration or using CDPv2 for voice VLAN auto-configuration.
LLDP-MED is not supported. CDPv2 exchanges information such as software version, device capabilities, and
voice VLAN information between directly connected devices such as a VOIP phone and a switch.

When the Cisco VOIP phone boots up (or sometimes periodically), it queries the switch and advertises
information about itself using CDPv2. The switch receives the VOIP VLAN Query TLV (type 0x0f) from the phone
and then immediately sends the voice VLAN ID in a reply packet to the phone using the VLAN Reply TLV (type
0x0e). The phone then begins tagging all packets with the advertised voice VLAN ID.

NOTE: A voice VLAN must be configured before the voice VLAN can be advertised. For example, to
configure VLAN 10 as a voice VLAN tagged for ports 1 through 10, enter these commands:

switch(config)# vlan 10
switch(vlan-10)# tagged 1-10
switch(vlan-10)# voice
switch(vlan-10)# exit

The switch CDP packet includes these TLVs:

• CDP Version: 2

• CDP TTL: 180 seconds

• Checksum

• Capabilities (type 0x04): 0x0008 (is a switch)

• Native VLAN: The PVID of the port
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• VOIP VLAN Reply (type 0xe): voice VLAN ID (same as advertised by LLDPMED)

• Trust Bitmap (type 0x12): 0x00

• Untrusted port COS (type 0x13): 0x00

CDP should be enabled and running on the interfaces to which the phones are connected. Use the cdp enable
and cdp run commands.

The pre-standard-voice option for the cdp mode command allows the configuration of CDP mode so that it
responds to received CDP queries from a VoIP phone.

Syntax:

[no] cdp mode pre-standard-voice [admin-status < port-list > [tx_rx | rxonly]]
Enable CDP-compatible voice VLAN discovery with pre-standard VoIP phones. In this mode, when a CDP VoIP
VLAN query is received on a port from pre-standard phones, the switch replies back with a CDP packet that
contains the VID of the voice VLAN associated with that port.

NOTE: Not recommended for phones that support LLDP-MED.

pre-standard-voice Enables CDP-compatible voice VLAN discovery with pre-standard VoIP phones.

admin-status Sets the port in either transmit and receive mode, or receive mode only.Default: tx-rx.
<port-list>

Sets this port in transmit and receive mode, or receive mode only.

rxonly

Enable receive-only mode of CDP processing.

tx_rx

Enable transmit and receive mode.

switch(config)# cdp mode pre-standard-voice admin-status A5 rxonly

The show cdp output when CDP Run is disabled

switch(config)# show cdp
Global CDP information
Enable CDP [yes] : no

The show cdp output when cdp run and sdp mode are enabled

switch(config)# show cdp

 Global CDP Information

  Enable CDP [Yes]  : Yes
  CDP mode [rxonly] : pre-standard-voice
  CDP Hold Time [180] : 180
  CDP Transmit Interval [60] : 60

  Port CDP       admin-status
  ---- --------- ------------
  A1   enabled   rxonly
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  A2   enabled   tx_rx
  A3   enabled   tx_rx
When CDP mode is not pre-standard voice, the admin-status column is note displayed.

The show cdp output when cdp run and cdp mode rxonly are enabled

switch(config)# show cdp

 Global CDP Information

  Enable CDP [Yes} : Yes
  CDP mode [rxonly] : rxonly

  Port CDP
  ---- --------
  A1   enabled
  A2   enabled
  A3   enabled

The show running-config when admin-status is configured

switch(config)# show running-config

Running configuration:

; J9477A Configuration Editor; Created on release #XX.16.09.0000x
; Ver #03:01:1f:ef:f2
hostname “Switch”
module 1 type J9307A
cdp mode pre-standard-voice admin-status A5 RxOnly

Filtering CDP information
In some environments it is desirable to be able to configure a switch to handle CDP packets by filtering out the
MAC address learns from untagged VLAN traffic from IP phones. This means that normal protocol processing
occurs for the packets, but the addresses associated with these packets is not learned or reported by the software
address management components. This enhancement also filters out the MAC address learns from LLDP and
802.1x EAPOL packets on untagged VLANs.

The feature is configured per-port.

Configuring the switch to filter untagged traffic
Enter this command to configure the switch not to learn CDP, LLDP, or EAPOL traffic for a set of interfaces.

Syntax:

[no] ignore-untagged-mac <port-list>
Prevents MAC addresses from being learned on the specified ports when the VLAN is untagged and the
destination MAC address is one of the following:

• 01000C-CCCCCC (CDP)

• 0180c2- 00000e (LLDP)

• 0180c2-000003 (EAPOL)
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Configuring the switch to ignore packet MAC address learns for an untagged VLAN

switch(config) ignore-untagged-mac 1-2

Displaying the configuration
Enter the show running-config command to display information about the configuration.

Configuration showing interfaces to ignore packet MAC address learns

switch(config) show running-config

Running configuration:

; J9627 Configuration Editor; Created on release XX.15.XX
; Ver #03:03.1f.ef:f0

hostname “Switch”
interface 1
   ignore-untagged-mac
   exit
interface 2
   ignore-untagged-mac
   exit
.
.
.
vlan 1
   name “DEFAULT_VLAN”
   untagged 1-24
   ip address dhcp-bootp
   exit
.
.
.

Filtering PVID mismatch log messages
This enhancement filters out PVID mismatch log messages on a per-port basis. PVID mismatches are logged
when there is a difference in the PVID advertised by a neighboring switch and the PVID of the switch port which
receives the LLDP advertisement. Logging is an LLDP feature that allows detection of possible vlan leakage
between adjacent switches. However, if these events are logged too frequently, they can overwhelm the log buffer
and push relevant logging data out of log memory, making it difficult to troubleshoot another issue.

Logging is disabled and enabled with the support of CLI commands.

This enhancement also includes displaying the Mac-Address in the PVID mismatch log message when the port ID
is Mac-Address instead of displaying garbage characters in the peer device port ID field.

Use the following command to disable the logging of the PVID mismatch log messages:

Syntax:

logging filter [filter-name][sub filter id] <regularexpression> deny
Regular-expression

The regular expression should match the message which is to be filtered.
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Syntax:

logging filter [filter-name] enable

Overview
A command has been written to suppress the IPv4 / IPv6 management address transmission in outgoing LLDP
packets.

A local LAN device transmits organization-specific information in the form of type, length, and value (TLV). The
organization-associated values are stored in the LLDP organizationally defined local device LLDP MIB
extensions. Management address TLV in IPv4 and IPv6 environments is optional from the TLV basic management
set.

TLV basic management set

• Port description TLV — Describes the port in an alpha-numeric format. The value equals the ifDescr object,
if the LAN device supports RFC 2863.

• System name TLV — Assigns the system name in an alpha-numeric format. The value equals the sysName
object, if the LAN device supports RFC 3418.

• System description TLV — Describes the network entity in an alpha-numeric format. The system description
TLV includes the system name, versions of hardware, operating system, and networking software supported in
the device. The value equals the sysDescr object, if the LAN device supports RFC 3418.

• System capabilities TLV — Indicates primary functions of the device and if they are enabled in the device.

• Management address TLV — Indicates the addresses of the local LLDP agent. Other remote managers can
use this address to obtain information related to the local device.

The command lldp config <all> ipAddrEnable <IP_ADDR> is used to advertise specific IP address
through the port.

The command [no] lldp config <PORT NO> basicTlvEnable management_addr suppresses the IP
address to be advertised.

Commands

[no] lldp config basicTlvEnable management_addr
Syntax

In the configure context:

[no] lldp config <PORT_NUM> basicTlvEnable management_addr
      
Description

The feature suppresses the IPv4 or IPv6 address as well as suppresses the MAC address if the [no] ip
address is configured. By default this management address TLV is enabled in switch. No other TLV (except
management address TLV) suppression will occur when this command is used.

Parameters

Management_addr

Management TLV

Example
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[no] lldp config all basicTlvEnable management_addr

lldp config
Syntax
lldp config <port-number>
    
Description

Configure the lldp for the desired port by number.

Parameter
basicTlvEnable

Enables the basic advertised TLV for each port by number.

Options

<management_addr>

Use the option <management_addr> to specify specific devices to enable TLV advertisement.

Usage
lldp config <port_num> basicTlvEnable <management_addr>

Show commands
Use the command show running-config to view the lldp configuration.

Example

switch# show running-config

Running configuration:
...
no lldp config 1 basicTlvEnable management_addr
Example

switch# show lldp config 1

LLDP Port Configuration Detail

  Port : 1
  AdminStatus [Tx_Rx] : Tx_Rx
  NotificationEnabled [False] : False
  Med Topology Trap Enabled [False] : False
  TLVS Advertised:
   
* management_addr 
   
   
  IpAddress Advertised:
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Overview
The Dynamic Host Configuration Protocol (DHCP) is a network protocol that enables a server to automate
assignment of IP addresses to hosts. A DHCP server can be configured to provide other network information like
IP addresses of TFTP servers, DNS server, boot file name and vendor specific options. Commonly there are two
types of address assignments, dynamic and manual. The lease of dynamic addresses is renewed periodically;
manual leases are permanently assigned to hosts. With this feature, you can configure multiple pools of IP
addresses for IP address assignment and tracking.

IP pools
A DHCP server is configured with IP pools. The server is then instructed to use IP addresses falling into the
specified range of IP while offering leases. Multiple IP pools are configured to not have duplicate or overlapping IP
subnets. You can also configure a DHCP server with multiple IP ranges within an IP subnet; this confines the
allocatable IP addresses within the configured IP pool.

An IP pool will be claimed valid only if it is either:

• Dynamic pool – Has a network address, subnet mask and IP range(s)

• Static pool – Should have a static IP-to-MAC binding.

The DHCP server will discard the invalid and incomplete pools and will only operate on the valid IP pools. The
DHCP server will require at least one valid pool to start.

DHCP options
On a DHCP server, an IP pool is configured with various options. These options signify additional information
about the network. Options are supported with explicit commands such as boot-file. Option codes that
correspond to explicit commands can not be configured with a generic option command; the generic option
command requires an option code and TLV.

NOTE:

RFC 2132 defines various network information that a client may request when trying to get the lease.

BootP support
The DHCP server also functions as BootP server. A manual binding configured in a static IP Pool may either
service a BootP client request or a DHCP client request.

Authoritative server and support for DHCP inform packets
The server message DHCPinformmay be received when the server is already configured for static IPv4
addresses so that the server can to get configuration parameters dynamically.

NOTE: RFC 2131 states that if a client has obtained a network address through some other means
(e.g., manual configuration), it may use a DHCPinform request message to obtain other local
configuration parameters. Servers receiving a DHCPinform message construct a DHCPACK
message with any local configuration parameters appropriate for the client without: allocating a new
address, checking for an existing binding, filling in yiaddr or including lease time parameters.

Chapter 8
DHCPv4 server

Chapter 8 DHCPv4 server 257

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 6854



Authoritative pools
To process the DHCPINFORM packets received from a client within the given IP pool, a DHCP server has to be
configured as authoritative for that IP pool. The server is the sole authority for this IP pool so when a client
requests an IP address lease where the server is authoritative, and the server has no record of that IP address,
the server will respond with DHCPNAK message which indicates that the client should no longer use that IP
address. Any DHCPINFORM packet received for a non-authoritative pool will be ignored by the DHCP server.

The authoritative command has no effect when configured on a static pool or an incomplete pool without a
network statement. In such cases, the server intentionally not send an error message.

A CLI toggle is provided under the pool context that will allow the authoritative configuration.

NOTE:

The authoritative command requires a network statement to be configured on a pool.

Authoritative dummy pools
A dummy pool, without the range statement, can be configured and made authoritative. A dummy pool allows
static-bind entries which do not have matching dynamic pools with network statements to be configured. By
creating a dummy pool on a DHCP server, the support for DHCPinform packets will not be actively serving the
client on this pool. No active leases or resource consumption will be sent to the DHCP server when this option is
used.

Dummy pools help the DHCP server learn the network topology.

Example

dhcp-server pool dummy192
network 192.168.10.0 255.255.255.255
option 1…
option 2…
:
option n…
authoritative
exit

Change in server behavior
Making the server authoritative for an IP pool changes how the server processes DHCP REQUEST packets.

The following table exhibits the behavior on the receiving DHCP REQUEST and DHCP inform packets from
DHCP clients residing on either authoritative and non-authoritative pools.
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Table 25: Authoritative and non-authoritative pools

Authoritative Pool Non-authoritative pool

When a
DHCP client
sending..

For Own IP For IP
belonging to
different
client

Unknown IP
falling outside
the range

For Own IP For IP belonging to
different client

Unknown IP
falling outside
the range

DHCP
INFORM

send ACK send ACK send ACK DROP DROP DROP

DHCP
REQUEST

send ACK send NACK send NACK send ACK DROP DROP

DHCPv4 configuration commands

DHCPv4 server

dhcp-server
Syntax
[no] dhcp-server [enable | disable]
Description

Use this command to nable/disable the DHCPv4 server in a switch. Defaults to disabled.

Parameters and options

no

Removes all DHCPv4 server configurations.

enable

Enables the DHCPv4 server on the device. The no form of this command

disable

Disables the DHCPv4 server on the device.

DHCP address pool name

dhcp-server pool
Syntax
[no] dhcp-server pool <POOL-NAME>
        
Description

Configure the DHCPv4 server IP address pool with either a static IP or a network IP range.

Parameters and options
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pool

DHCPv4 server IP address pool.

ASCII-STR

Enter an ASCII string.

authoritative

Configure the DHCP server authoritative for a pool.

bootfile-name

Specify the boot file name which is used as a boot image.

default-router

List of IP addresses of the default routers.

dns-server

List of IP addresses of the DNS servers.

domain-name

Configure the DNS (Domain Name System) domain name for translation of hostnames to IP addresses.

lease

Lease period of an IP address.

netbios-name-server

List of IP addresses of the NetBIOS (WINS) name servers.

netbios-node-type

NetBIOS node type for a Microsoft DHCPv4 client.

network

Subnet IP and mask of the DHCPv4 server address pool.

option

Raw DHCPv4 server options.

range

Range of IP addresses for the DHCPv4 server address pool.

static-bind

Static binding information for the DHCPv4 server address pool.

tftp-server

Configure a TFTP server for the DHCPv4 server address pool.

Validations

Validation Error/Warning/Prompt

Configuring pool when maximum Number of pools
already configured.

Maximum number of pools (128) has already been
reached

Configuring Pool with a name that exceeds the
maximum length requirement.

String %s too long. Allowed length is 32 characters.

Table Continued
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Trying to delete non existing pool The specified address pool does not exist.

Only alphanumeric characters, numerals and
underscore is allowed in the pool name. Violating
this would throw the following error message.

Invalid name. Only alphanumeric characters and
hyphen are allowed.

Trying to delete existing pool or adding new pool
when DHCP server enabled.

DHCP server should be disabled before changing
the configuration.

Authoritative
Syntax
[no] authoritative
Description

The DHCP server is the sole authority for the network configured under this pool. When the DHCP server is
configured as authoritative, the server will respond with DHCP ACK or NACK as appropriate for all the received
DHCP REQUEST and DHCP INFORM packets belonging to the subnet.

Non-authoritative DHCP INFORM packets received from the clients on a non-authoritative pool will be ignored.

Parameters and options

authoritative

Configure the DHCP server authoritative for a pool.

DHCP client boot file

bootfile-name
Syntax
[no] bootfile-name <FILENAME>
      
Description

Specify the boot file name to be used as the boot image.

DHCP client default router

default-router
Syntax
[no] default-router <IP-ADDR-STR> [IP-ADDR2 IP-ADDR8]
Description

Configure the DHCP pool context to the default router for a DHCP client. List all of the IP addresses of the default
routers.

Two IP addresses must be separated by a comma.

Maximum of eight default routers can be configured.

DNS IP servers

Chapter 8 DHCPv4 server 261

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 6858



dns-server
Syntax
[no] dns-server <IP-ADDR> [IP-ADDR2 IP-ADDR8]
Description

Configure the DHCP pool context to the DNS IP servers that are available to a DHCP client. List of IP addresses
of the DNS servers.

Two IP addresses must be separated by comma.

Maximum of eight DNS servers can be configured.

Configure a domain name

domain-name
Syntax
[no] domain-name <NAME>
Description

Configure the DNS domain name for translation of hostnames to IP addresses.

Configure lease time

lease
Syntax
[no] lease [DD:HH:MM | infinite]
Description

Configure the lease time for an IP address in the DHCP pool. Lease time is infinite for static pools.

The default lease period is one day.

Parameters and options

DD:HH:MM

Enter lease period.

Lease

Lease period of an IP address.

NetBIOS WINS servers
Syntax
[no] netbios-name-server <IP-ADDR-STR> [IP-ADDR2  IP-ADDR8]
Description

Configure the DHCP pool for the NetBIOS WINS servers that are available to a Microsoft DHCP client. List all IP
addresses of the NetBIOS(WINS) name servers. The Windows Internet Naming Service (WINS) is a name
resolution service that Microsoft DHCP clients use to correlate host names to IP addresses within a general
grouping of networks.

Two IP addresses must be separated by a comma.
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Maximum of 8 NetBIOS (WINS) name servers can be configured.

NetBIOS node type

net bios-ode-type
Syntax
[no] netbios-node-type [ broadcast | hybrid | mixed | peer-to-peer ]
Description

Configure the DHCP pool mode to the NetBIOS node type for a Microsoft DHCP. The NetBIOS node type for
Microsoft DHCP clients can be one of four settings: broadcast, peer-to-peer, mixed, or hybrid.

Parameters and options

broadcast

Broadcast node.

hybrid

Hybrid node.

mixed

Mixed node.

peer-to-peer

Peer to peer node.

Subnet and mask

network
Syntax
[no] network <ip-addr/mask-lenght>
Description

Configure the DHCPv4 server pool subnet and mask for the DHCP server address pool.

Range is configured to enable pool.

Parameters and options

ip-addr/mask-lenght

Interface IP address/mask.

DHCP server options

Configure DHCP server options
Syntax

[no] option <CODE> {ascii <ascii-string>|hex <hex-string>|ip <IP-ADDR-STR>[IP-ADDR2 … IP-ADDR8]}

ascii

Specify ASCII string as option code value.
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hex

Specify hexadecimal string as option code value.

ip

Specify one or more IP addresses as option code value.

ip-addr-str

Specify IP address.

ascii-str

Enter an ASCII string.

hex-str

Specify Hexadecimal string.

Configure the raw DHCP server options.

NOTE: Following DHCP options are not supported:

1,3,6,12,15,44,46,50,52,54,55,57,58,59,61,66,67,82.

You can use the following available CLIs for respective DHCP option codes:

DHCP
Option
code

CLI Syntax

1 [no] network <ip-addr/mask-lenght>
3 [no] default-router <IP-ADDR-STR> [IP-ADDR2 ... IP-ADDR8]
6 [no] dns-server <IP-ADDR> [IP-ADDR2 ... IP-ADDR8]
15 [no] domain-name <name>
44 [no] netbios-name-server <IP-ADDR-STR> [IP-ADDR2 ... IP-ADDR8]
43 [no] option 43 {ascii <ascii-string>|hex <hex-string>|ip <IP-

ADDR-STR>[IP-ADDR2 … IP-ADDR8]}
46 [no] netbios-node-type <broadcast | hybrid | mixed | peer-to-

peer>
60 [no] option 60 {ascii <ascii-string>|hex <hex-string>|ip <IP-

ADDR-STR>[IP-ADDR2 … IP-ADDR8]}
66 [no] tftp-server server-name < ASCII-STR>
67 [no] bootfile-name<filename>
138 [no] option 138 {ascii <ascii-string>|hex <hex-string>|ip <IP-

ADDR-STR>[IP-ADDR2 … IP-ADDR8]}
150 [no] tftp-server server-ip <ip-address> or [no] option 150 <IP-

ADDR-STR> [IP-ADDR2 ... IP-ADDR8]

NOTE: DHCP server raw Option 43 is supported and it is used for AirWave ZTP.

DHCP server raw Option 60 is supported from 16.06.

DHCP server raw Option 138 is supported and it is used for IPsec tunnel configuration in DHCP
client.
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IP address range

range
Syntax
[no] range <IP-ADDR>[<IP-ADDR>]
Description

Configure the DHCP pool to the range of IP address for the DHCP address pool.

Parameters and options

range

Range of IP addresses for the DHCPv4 server address pool.

ip-addr

Low IP address.

High IP address.

Static bindings

static-bind
Syntax
static-bind ip <IP-ADDR/MASK-LENGTH> mac <MAC-ADDR>
        
Description

Configure static binding information for the DHCPv4 server address pool. Manual bindings are IP addresses that
have been manually mapped to the MAC addresses of hosts that are found in the DHCP database. Manual
bindings are just special address pools. There is no limit on the number of manual bindings but you can only
configure one manual binding per host pool.

Parameters and options

ip

Specify client IP address.

static-bind

Static binding information for the DHCPv4 server address pool.

ip-addr / mask-length

Interface IP address or mask.

mac

Specify client MAC address.

mac-addr

Enter a MAC address.

TFTP server domain name
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tftp-server
Syntax

[no] tftp-server [server-name <server-name> | server-ip < ip-address >]
Description

Configure the TFTP server domain name for the DHCP address pool.

Parameters and options

tftp-server

Configure a TFTP server for the DHCPv4 server address pool.

server-name

TFTP server name for the DHCPv4 server address pool.

Configure the TFTP server address

tftp-server
Syntax
tftp-server server-ip <IP-ADDRESS>
        
Description

Configure the TFTP server address for the DHCP address pool.

Parameters and options

server-ip

TFTP server IP addresses for the DHCPv4 server address pool.

ip-addr

Specify TFTP server IP address.

Number of ping packets

dhcp-server ping
Syntax
[no] dhcp-server ping [packets <0-10>|timeout <0-10>]
Description

Specify, in the global configuration context, the number of ping packets the DHCP server will send to the pool
address before assigning the address. The default is two packets.

Parameters and options

ping

Specify DHCPv4 ping parameters.

packets <0-10>

Specify number of ping packets in the range of 0 to 10. 0 disables ping.
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timeout <1-10

Ping timeout in the range of 1–10 seconds. Indicates the amount of time the DHCPv4 server must wait before
timing out a ping packet. Defaults to one second.

Save DHCP server automatic bindings

dhcp-server database
Syntax
[no] dhcp-server database [file ASCII-STR] [delay<15-86400>][timeout <0-86400>]
Description

Specifies DHCPv4 database agent and the interval between database updates and database transfers.

Parameters and options

delay

Seconds to delay writing to the lease database file.

file

URL Format: "tftp://<ip-address>/<filename>".

database

Specifies DHCPv4 database agent and the interval between database updates and database transfers.

timeout

Seconds to wait for the transfer before failing.

ascii-str

Database URL.

<15-86400>

Delay in seconds.

<0-86400>

Timeout in seconds.

DHCP server and SNMP notifications

snmp-server enable traps
Syntax
[no] snmp-server enable traps dhcp-server
Description

Configure a DHCP server to send SNMP notifications to the SNMP entity. This command enables or disables
event traps sent by the switch.

Parameters and options

dhcp-server

Traps for DHCP-Server.

Conflict logging on a DHCP server
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dhcp-server conflict-logging
Syntax
[no] dhcp-server conflict-logging
Description

Enable conflict logging on a DHCP server. Default is disabled.

Parameters and options

conflict-logging

Enable DHCPv4 server address conflict logging.

Enable the DHCP server on a VLAN

dhcp-server
Syntax
dhcp-server
Description

Enable DHCPv4 server on a VLAN. DHCPv4 client or DHCPv4 relay cannot co-exist with DHCPv4 server on a
VLAN.

Parameters and options

dhcp-server

Enable DHCPv4 server on a VLAN.

Clear commands

clear dhcp-server conflicts
Syntax
clear dhcp-server conflicts <IP-ADDR>
        
Description

Reset DHCPv4 server conflicts database. If IP address is specified, reset only that conflict.

Parameters and options

dhcp-server

Clears theDHCPv4 server information.

ip-addr

Specify the IP address whose conflict is to be cleared.

Reset all DHCP server and BOOTP counters

clear dhcp-server statistics
Syntax
clear dhcp-server statistics
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Description

Reset all DHCP server and BOOTP counters

Parameters and options

statistics

Reset DHCPv4 server and BOOTP counters.

Delete an automatic address binding

clear dhcp-server statistics
Syntax
clear dhcp-server statistics
Description

Delete an automatic address binding from the DHCP server database.

Parameters and options

binding

Reset DHCPv4 server automatic address bindings.

ip-addr

Specify IP address of the binding is to be cleared.

Show commands

show dhcp-server
Syntax
show dhcp-server [binding|conflicts|database|statistics|pool <POOL-NAME>]
        
Description

Show DHCPv4 server global configuration information for the device.

Parameters and options

binding

Display the DHCPv4 server address bindings on the device..

conflicts

Display address conflicts found by a DHCPv4 server when addresses are offered by a client.

database

Display DHCPv4 server database agent information.

statistics

Display DHCPv4 server statistics.

pool <POOL-NAME>

Display the DHCPv4 server IP pool information.
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Event log

Event Log Messages

Cause

Table 26: Event Log Messages

Events Debug messages

DHCP server is enabled globally. DHCP server is enabled globally.

DHCP server is enabled globally. Warnings -
One or more incomplete pool configurations
are found during the server startup.

DHCP server is enabled globally.Warning -One or
more incomplete pool configurations are found
during the server startup.

A dynamic pool is considered invalid, if
network IP or subnet mask is not configured.
A static pool is considered incomplete, if
network IP, subnet mask or MAC address is
not configured.

DHCP server failed to start. The reason for
failure is printed as the argument.

DHCP server failed to start: %s "with a manual
binding.

DHCP server is disabled globally. DHCP server is disabled globally.

The DHCP server configurations are deleted. The DHCP server configurations are deleted

Decline from client when server assigns an
illegal Ipv6 address.

%s: Decline offer from %x (server) of %x because
the address is illegal.

DHCP server is enabled on a specific VLAN. DHCP server is enabled on VLAN %d

DHCP server is disabled on a specific VLAN. DHCP server is disabled on VLAN %d

Ping check is enabled and configured with
specified retry count and timeout values

Ping-check configured with retry count = %d,
timeout = %d

Ping check is disabled Ping-check is disabled

Conflict-logging is enabled Conflict-logging is enabled

Conflict-logging is disabled. Conflict-logging is disabled.

A specific IP address is removed from the
conflict logging database.

IP address %s is removed from the conflict-
logging database.

Table Continued
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Events Debug messages

All IP addresses are removed from the
conflict-logging database.

"All IP addresses are removed from the conflict-
logging database

Dynamic binding for a specific IP address is
freed.

Dynamic binding for IP address %s is freed

All the dynamic IP bindings are freed. All the dynamic IP bindings are freed

Remote binding database is configured for a
specific URL.

Remote binding database is configured at %s

Remote biding database is disabled. Remote binding database is disabled

Binding database is read from the specified
URL at the specified time

Binding database read from %s at %s

Failed to read the remote binding from the
specified URL.

Failed to read the remote binding database at %s

Binding database is written to the specified
URL at the specified time.

Binding database written to %s at %s

Failed to write the binding database to the
specified URL. The reason for failure is
printed as argument.

Failed to write the binding database to %s.
Error: %s

Invalid bindings are found in the database at
the specified URL.

Invalid binding database at %s

The specified VLAN does not have a
matching IP pool configured.This occurs
when the DHCP-server is enabled on the
specified VLAN, but no IP pool is configured
with a network IP matching the VLAN
network IP.

VLAN %d does not have a matching IP pool

Binding database is replicated to standby
management module.

Binding database is replicated to standby
management module

DHCP server is listening for DHCP
packetsThis message is displayed when
DHCP server is enabled globally and DHCP
server is enabled on at-least one VLAN.

DHCP server is listening for DHCP packets

DHCP server is disabled on all the VLANs.
Server is no longer listening for DHCP
packets.

DHCP server is disabled on all the VLANs. Server
is no longer listening for DHCP packets

The specified IP is not offered to the DHCP
client, as it is already in use.

IP address %s is not offered, as it is already
in use

Table Continued
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Events Debug messages

No IP addresses available on the specified
pool.

No IP addresses to offer from pool %s

High threshold reached for the specified
pool. Count of Active bindings and Free
bindings are printed as arguments.

High threshold reached for pool %s. Active
bindings: %d, Free bindings: %d

Low threshold reached for the specified pool.
Count of Active bindings and Free bindings
are printed as arguments.

Low threshold reached for pool %s. Active
bindings: %d, Free bindings: %d

No active VLAN with an IP address is
available to read binding database from the
configured URL.

No active Vlan with an IP address available to
read binding database
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DHCPv6 hardware address
The incremental deployment of IPv6 to existing IPv4 networks results in dual-stacking network environments.
Some devices will act as both DHCPv4 and DHCPv6 clients. For these dual-stack situation, here is a need to
associate DHCPv4 and DHCPv6 messages with the same client interface. A DHCPv4 server uses the client link-
layer address as the customer identifier and a key for lookup in the client database. The DHCPv6 Relay-Forward
message carries the client link-layer address to the DHCPv6 server allowing the association of both DHCPv4 and
DHCPv6 messages with the same client interface.

As defined in RFC-6939, DHCPv6 relay agents receiving solicit and request messages that originate from
DHCPv6 clients include the link-layer source address of the received DHCPv6 message. This is accomplished in
the Client Link-Layer Address option within DHCPv6 Relay-Forward messages. The Client Link-Layer Address
enables the server to recognize and service specific clients. DHCPv6 relay agent behavior (as set by the
configuration) decides whether the Client Link-Layer Address option is included for each client.

DHCPv6 relays agents include Option–79 for all message types when enabled. The message types are: solicit,
request, confirm, decline, renew, rebind, release and information-request. DHCPv6 provides additional
information for event debugging and logging related to the client at the server.

NOTE:

All cascading relay-agents simply encapsulate the message received and relay-forward to the server.
The service function does not receive any message-types directly from the client even when the
feature is enabled.

DHCPv6 snooping and relay
Configuring DHCPv6 and DIPLDv6 through SNMP

NOTE: DHCPv6 snooping and Dynamic IPv6 Lockdown (DIPLDv6) are currently configurable
through SNMP using MIBs. For more information, see the MIB and Trap Matrix.

dhcpv6–snooping
Syntax
[no] dhcpv6-snooping [vlan <VLAN-ID-RANGE>]
      
Description

Enable or disable the global administrative status of DHCPv6 snooping. You must enable DHCP snooping
globally (dhcpv6-snooping) to enable snooping on any VLAN.

Parameters and options

no

Disabling global administrative status (no dhcpvt-snooping) disables snooping on all VLANs.

vlan <VLAN-ID-RANGE>]

Disables snooping on a VLAN or a range of VLANs. Requires enabling DHCP global snooping (dhcpv6-
snooping)

Chapter 9
DHCPv6 server
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Validation rules for DHCPv6 global snooping

Validation Error/Warning/Prompt

Verify whether entered ipv6 address is valid Invalid Ipv6 address:< ipv6-address>

If an invalid server address is configured Invalid IP address. Only IPv6 unicast or link-
local addresses are supported.

If the limit on configuring the authorized servers had
reached.

Cannot configure the authorized server as
only 20 authorized servers can be configured.

Validation rules for DHCPv6–snooping VLAN

Validation Error/Warning/Prompt

if the VLAN is a SVLAN and the bridge mode is
mixed mode

DHCPv6-snooping is not supported on
SVLANs and SVLAN ports in QinQ mixed
VLAN mode

If number of snooped VLAN count is greater than
max_vlans_with_dipv6ld and also the max binding
limit has reached.

DHCPv6 snooping cannot be enabled on %s
VLANs. The switch will support only 8
DHCPv6 snooping enabled VLANs when
Dynamic IPv6 Lockdown feature is enabled.

If the VLAN which is being configured for DHCPv6
Snooping has a Smart Link enabled port.

Cannot configure DHCPv6 Snooping on a
VLAN containing Smart Link ports.

If a VLAN is being configured as a Smart Link
protected VLAN and DHCPv6 Snooping is enabled
on it.

Cannot configure a VLAN as a protected
VLAN when DHCPv6 Snooping is enabled on
it .

If Smart Link is being configured on a port which is a
part of DHCPv6 Snooping VLAN..

Cannot configure the Smart Link feature on a
port when DHCPv6 Snooping is enabled on
that port.

dhcpv6 snooping trust
Syntax
[no] dhcpv6-snooping trust ethernet <PORT-LIST>
        
Description

Configure trusted interfaces. The system forwards server packets received on trusted interfaces only.

Parameters and options

no

Marks the specified interfaces as untrusted. Port state defaults to untrusted.

Validation rules

274 Aruba 2930F / 2930M Management and Configuration Guide
for ArubaOS-Switch 16.08

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 6871



Validation Error/Warning/Prompt

Verify whether the port exist in the device. Module not present for port or invalid port: <PORT-
LIST>

If the port is a part of a SVLAN and the
bridge mode is mixed mode.

Port %s cannot be configured as trusted port as it is
part of a SVLAN in QinQ mixed VLAN mode.

If the port is not a part of a dsnoopv6
enabled VLAN

Port %s is not a part of a DHCPv6-snooping VLAN.

If trusted attribute is being configured on
a port on which max-binding has been
already configured.

Disable max-binding feature configured on the port
before configuring it as a trusted port.

If a Dynamic trunk is configured as a
trusted port.

Cannot configure a port as a DHCPv6 Snooping trusted
port when Dynamic Trunking is enabled on that port.

If a Smart Link port is being configured as
a trusted port

Cannot configure a Smart Link port as a DHCPv6
Snooping trusted port.

If a trusted port is being configured as a
Smart Link port

Cannot configure a DHCPv6 Snooping trusted port as a
Smart Link port

dhcpv6–snooping authorized-server
Syntax
[no] dhcpv6-snooping authorized-server <IPV6-ADDRESS>
        
Description

Configure authorized DHCPv6 servers. For DHCPv6 snooping to allow a server to client packet to be forwarded, it
must be received on a trusted port from an authorized server. If no authorized servers are configured, all server
addresses are valid.

ddhcpv6–snooping database file
Syntax
[no] dhcpv6-snooping database file [ASCII-STR|delay <15-86400>| timeout<0-86400>]
        
Description

Configure a lease entry file and its options for storing DHCPv6 snooping binding database.

Parameters and options

ASCII-STR

Copies the DHCPv6 snooping lease file to a TFTP server. The parameter ASCII-STR is a URL and is in the
format tftp://<IP-ADDR>/<FILENAME>. The TFTP address can be up to 255 characters. IP-ADDR can
be an IPv4 address or an IPv6 address. The IPv6 address must be enclosed in square brackets [].

timeout seconds

Configures the number of seconds to wait for the DSNOOPv6 lease file transfer to complete. An error
message is displayed if the file transfer is not completed within the timeout value. A value of zero indicates
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that the attempt to transfer the DHCPv6 lease file retries indefinitely. The default timeout value is 300
seconds.

database

Configure the parameters to copy the DHCPv6 Snooping lease file to a TFTP server.

delay

Configure the number of seconds to wait before copying the DSNOOPv6 lease file to a TFTP server.

file

Copy the DHCPv6 Snooping lease file to a TFTP server.

timeout

Configure the number of seconds to wait for the DSNOOPv6 lease file transfer to complete.

Validation rules

Validation Error/Warning/Prompt

Verify whether file name entered is in URL format database: Bad URL format.

Verify whether the timeout value is within the limit Invalid input: <value>

Verify whether the delay value is within the limit. Invalid input: <value>

If the URL format is not proper Bad URL format.

If the entered URL does not have a valid transfer
mode.

URL Transport mode is not supported.

dhcpv6–snooping max-bindings
Syntax
[no] dhcpv6-snooping max-bindings <PORT-LIST 1-8192>
Description

Configure the maximum number of binding addresses allowed per binding anchor. A binding anchor is a unique
attribute that can be associated with a client address.

Parameters and options

max-bindings

Configuring maximum number of binding addresses allowed per port.

• If the max-bindings value is configured before enabling dhcpv6-snooping the limit is immediately
applied and the bindings are not allowed to exceed the max-bindings value.

• The max-bindings value is setafter enabling dhcpv6-snooping.

• The current bindings are greater than the max-binding value, the configuration will be applied as and when
clients release their IPv6 addresses.

• Current bindings are lesser than that of the value entered, the configuration will be immediately applied.

<PORT-LIST 1-8192>

Specify the ports on which max-bindings need to be applied in the range of 1–8192.
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Validation rules

Validation Error/Warning/Prompt

Verify max-bindings value entered is in the range Invalid input: <value>

If DHCPv6-Snooping is already configured before
entering the command and current bindings are
greater than the value being set.

Existing bindings %d are more than the max-
bindings being configured, and the maximum
limit will be applied once the number of existing
bindings fall below this limit

If the value is being configured for a trusted port Cannot configure maximum binding for DHCPv6
snooping feature on a trusted port

If the value is being configured for a port which is
not a part of a dhcpv6-snooped vlan

Port %s is not a part of a DHCPv6-snooping
VLAN.

If the max-binding value is being set for a Dynamic
trunk.

Cannot configure DHCPv6 Snooping on a port
when Dynamic Trunking is enabled on that port.

If the number of static bindings is greater than the
max-binding value being set.

Cannot configure the maximum binding value
because the number of static bindings on the
port exceeds the maximum binding value.

If a port on which max-binding is enabled is being
put into a trunk.

Cannot add a port to a trunk group when
DHCPv6 Snooping Maxbinding is configured on
that port.

If a trunk has max-bindings configured on it. And the
trunk is being removed.

Cannot remove the port %s from the trunk group
because DHCPv6 Snooping max-binding is
configured on the trunk and removing the port
will delete the trunk.

If DT trunk is being configured on a max-binding
enabled port.

Cannot configure Distributed Trunking on a port
when DHCPv6 Snooping max-binding is
configured on that port.

IMPORTANT: DT trunks can use jumbo VLAN as usual, but user needs to ensure that jumbo is
configured on both the DT pairs, otherwise packet drops/fragmentations can be seen.

dhcpv6–relay option 79
Syntax
[no] dhcpv6-relay option 79
Description

Enabling option 79 will force the DHCPv6 Relay agent to forward the client Link-layer address. Defaults to
disabled.

snmp-server enable traps dhcpv6-snooping
Syntax
[no] snmp-server enable traps dhcpv6-snooping [out-of-resources|errant-reply]
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Description

Configure the traps for DHCPv6 snooping.

Parameters and options

out-of-resources

This trap is sent when the number of bindings exceed the maximum limit of 8192 bindings.

errant-reply

This trap is sent when a DHCPv6 reply packet is received on an untrusted port or from an un-authorized
server.

clear dhcpv6–snooping stats
Syntax
clear dhcpv6-snooping stats
Description

Clears dhcpv6 snooping statistics.

Validation rules

Validation Error/Warning/Prompt

If dhcp-snooping not enabled
globally

DHCPv6 snooping is disabled.

debug security dhcpv6–snooping
Syntax
debug security dhcpv6-snooping [config|event|packet]
Description

Enable debug for DHCPv6 snooping.

Parameters and options

config

Debug DHCPv6 snooping configuration.

event

Debug a DHCPv6 snooping event.

packet

Debug DHCPv6 snooping by packet.

ipv6 source-lockdown ethernet
Syntax
[no] ipv6 source-lockdown ethernet <PORT-LIST>
      
Description

Used to configure DIPv6LD lockdown globally and on specific ports which can be configured on per-port basis
using the PORT-LIST option.
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Parameters and options

[ethernet] PORT-LIST

Specify the ports being configured for Ipv6 source-lockdown.

source-lockdown

Enable IPv6 source lockdown for a specific port.

Validation rules

Validation Error/Warning/Prompt

Verify whether dhcpv6-snooping is enabled
globally

DHCPv6 snooping is disabled.

Verify whether port configured is in the VLAN
which is dhcpv6-snooping enabled.

Ports <PORT-LIST> are not in a DHCPv6
Snooping VLAN.

If lockdown is being configured on a trusted port Port %s is a trusted port.

If the HW resources are not available for changing
dipv6ld global or a port characteristic

Cannot enable DIPLDv6 as required resources are
unavailable.

If global GVRP is enabled DIPLDv6 cannot be enabled when GVRP is
enabled

If no of snooped VLAN count is greater than
max_vlans_with_dipv6ld

DHCPv6 snooping cannot be enabled on %s
VLANs. The switch support only 8 DhCPv6
snooping enabled VLANs when Dynamic Ipv6
lockdown is enabled.

If Binding limits are exceeded Cannot enable Dynamic Ipv6 Lockdown on ports
%s as manual binding limits are exceeded.

If lockdown is being enabled on an interface which
is part of a dynamic trunk (LACP)

Cannot configure Dynamic Ipv6 Lockdown on
interface %s, it is a Dynamic trunk.

If lock down is being configured on a mesh port Cannot configure Dynamic Ipv6 Lockdown on a
logical mesh port.

If trunk is being formed using a port which has
DIPLDv6 enabled on it.

Cannot add a port to a trunk group when Dynamic
IPv6 Lockdown is enabled on that port.

If DIPLDv6 is configured on a trunk and the trunk
is being removed.

Cannot remove the port %s from the trunk group
because Dynamic IPv6 Lockdown is configured on
the trunk and removing the port will delete the
trunk.

If DIPLDv6 is being is configured on a Smart Link
port

Cannot enable Dynamic IPv6 Lockdown feature on
a Smart Link port.

If Smart Link is being enabled on a DIPLDv6
enabled port

Cannot configure the Smart Link feature on a port
when the Dynamic IPv6 Lockdown feature is
enabled on that port.
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ipv6 source-binding
Syntax
[no] ipv6 source-binding VLAN-ID IPV6-ADDR MAC-ADDR PORT-NUM IPV6-ADDR
        
Description

Add a DHCPv6 static binding entry into the binding table. Static binding entries will have infinite lifetime.

Parameters and options

VLAN-ID

The VLAN ID of the static binding entry.

Ipv6-ADDRESS

The Ipv6 address of the static binding entry.

MAC-ADDRESS

The MAC address of the static binding entry.

[ethernet] PORT-NUM

Port number of the static binding entry.

IPV6-ADDR

The Ipv6 link-local address of the static binding entry.

Validation rules

Validation Error/Warning/Prompt

Verify whether the vlan id is proper Invalid input:%s

Verify whether the mac-address is valid Invalid input:%s

Verify whether the ipv6 address is valid Invalid input:%s

Verify whether the port number is valid on the
device

Module not present for port or invalid port: <port-
num>

If any other addresses other than global unicast
address are entered

Invalid Ipv6 address

If the ipv6 address entered is not a unicast. Only Ipv6 unicast addresses are supported.

If a multicast ipv6 address is entered to configure a
binding.

Cannot configure a binding using a multicast IPV6
address.

If an invalid MAC address is being added into the
binding table.

Cannot add a %s MAC address to the table.

If an invalid port is used for configuring a static
binding

Port %s is invalid.

Table Continued
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Validation Error/Warning/Prompt

If DSNOOPV6 is globally disabled when
configuring a static binding.

Cannot configure static binding whenDHCPv6
Snooping is disabled.

While configuring a static binding if the Ipv6
address is already present in the Binding table but
the entered vlanid and MAC address doesnot
match with the one present in the binding table.

%s has already been assigned to a VID/MAC.
Delete the existing binding first.

If a binding which does not exist in the binding
table is tried to be removed.

Binding for %s not found.

If DIPLDv6 limits are exceeded on the switch. Cannot add the IPv6 source binding because the
number of source bindings exceeds the maximum
limit of
“STR(DSNOOPV6_MAX_STATIC_LEASES)”.

If more than 4 IPv6 addresses are being assigned
to a VID/MAC pair

Cannot add the IPv6 source binding because only
“STR(DHCPV6_MAX_IAADDRS)”IPv6 addresses
can be bound to a VID-MAC pair.

If a VID-MAC pair is bound to a link-local address
and the same VID-MAC pair is being assigned
another link-local address.

%s is already bound to a link-local address. To
bind another link-local address, delete the existing
binding .

If a binding exists for a particular client in the BST
and the same binding is being configured for
another port.

The IPv6 source binding already exists for another
port.

If the switch total limit for bindings is exceeded. Cannot add the IPv6 source binding because the
number of source bindings exceeds the maximum
limit of
STR(DSNOOPV6_MAX_STATIC_LEASES).

If a trunk is being configured for a port which has
static binding configured on it.

Cannot add a port to a trunk group when IPv6
source binding is configured on that port.

If static binding is being configured on a Smart Link
enabled port

Cannot configure IPv6 source binding on a Smart
Link port.

If Smart Link is being configured on a port with
static binding.

Cannot configure Smart Link feature on a port
when IPv6 source binding is configured on that
port.

snmp-server enable traps dyn-ipv6-lockdown
Syntax
[no] snmp-server enable traps dyn-ipv6-lockdown [out-of-resources | violations]
Description

The Dynamic IPv6 Lockdown trap is sent when resources are unavailable for configuring. This trap is sent when a
source lockdown violation takes place.

Parameters and options
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out-of-resources

Dynamic IPv6 Lockdown out of resources.

violations

Dynamic IPv6 lockdown violations.

debug security dynamic-ipv6-lockdown
Syntax
debug security dynamic-ipv6-lockdown
Description

Enable debug for DIPLDv6

Show commands for DHCPv6–snooping

show dhcpv6-snooping
Syntax
show dhcpv6-snooping
Description

Show dhcpv6 snooping configuration.

Validaton rules

Validation Error/Warning/Prompt

If dhcpv6-snooping not enabled DHCPv6 snooping is disabled

show dhcpv6 snooping bindings
Syntax
show dhcpv6-snooping bindings
Description

Show dhcpv6 snooping binding entries. This would show both dynamic and static binding entries.

Validation rules

Validation Error/Warning/Prompt

If dhcpv6-snooping not enabled DHCPv6 snooping is disabled

show dhcpv6 snooping statistics
Syntax
show dhcpv6-snooping stats
Description

Show dhcpv6-snooping statistics.
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show ipv6 source-lockdown
Syntax
show ipv6 source-lockdown [bindings | status]
        
Description

Shows IPv6 source bindings that are configured using the command IPv6 source-bindings.

Parameters and options

bindings

Show source bindings for Dynamic IPv6 Lockdown ports.

status

Show source bindings for Dynamic IPv6 Lockdown status.

Show source bindings Dynamic IPv6 Lockdown status

Dynamic IPv6 Lockdown Bindings

Port    IPv6 Address                             Vlan   MAC         Not 
Address                                                             in HW
---- ---------------------------------------- ----- ------------- -------
A1   3000:abbb:1234:3456:1234: 1234:1234:1234  1     123456-789101  Yes
F23  300:ab::2                                 4092  abcdef-123455  No

show ipv6 source-lockdown status
Syntax
show ipv6 source-lockdown status
Description

Used to show IPV6 source-lockdown status per port.

Parameters and options

source-lockdown

Show dynamic IPv6 Lockdown.

Show dynamic IPv6 Lockdown configuration

Dynamic IPv6 Lockdown information
Global State: Enabled
Port   Operational State
------ --------------------------
1    Active
2    Active
IPv6 Source Lockdown is disabled on Ports 3-24.
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show snmp-server traps
Syntax
show snmp-server traps <COMMUNITY-STR>
      
Description

Shows traps controlled. Shows all information on SNMP communities, trap receivers and SNMP response or trap
source-ip policy configured on the switch.

Parameters and options

traps

Show all configured traps.

<COMMUNITY-STR>

Displays information for the specified community only.

Show snmp-server traps

switch(config)# sh snmp-server traps

Trap Receivers
Link-Change Traps Enabled on Ports [All] : All

Traps Category                                             Current Status
_____________________________       __________________
SNMP Authentication                                   : Extended
Password change                                            : Enabled
Login failures                                              : Enabled
Port-Security                                                : Enabled
Authorization Server Contact                 : Enabled
DHCP-Snooping                                                : Enabled
DHCPv6-Snooping Out of Resource            : Enabled
DHCPv6-Snooping Errant Replies              : Enabled
Dynamic ARP Protection                              : Enabled
Dynamic IP Lockdown                                    : Enabled
Dynamic IPv6 Lockdown Out of Resource : Enabled
Dynamic IPv6 Lockdown Violations           : Enabled
Startup Config change                                : Disabled
Running Config Change                                : Disabled
MAC address table changes                        : Disabled
MAC Address Count                                        : Disabled

Address               Community             Events  Type  Retry  Timeout

Excluded MIBs
switch(config)#
Alignment change – right shifted

show distributed-trunking consistency-parameters
Syntax
show distributed-trunking consistency-parameters global feature
Description

Parameters and options
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dhcp-snooping

Display DHCP snooping peer consistency details.

IGMP

Display IGMP peer consistency details.

loop-protect

Display Loop protect peer consistency details.

MLD

Display MLD peer consistency details.

pim-dm

Display PIM-DM peer consistency details.

pim-sm

Display PIM-SM peer consistency details.

Display PIM-SM peer consistency details.

show distributed-trunking consistency-parameters global feature pim-sm

PIM-SM Enabled VLANs on Local : 20,30
PIM-SM Enabled VLANs on Peer : 20,30

show distributed-trunking consistency-parameters
Syntax
show distributed-trunking consistency-parameters global <PIM-SM>
Description

Display global peer consistency details. If the platforms do not match an error message similar to inconsistant
criteria is returned.

Parameters and options

global

Display global peer consistency details.

<PIM-SM>

Display PIM-SM peer consistency details.

Show distributed-trunking consistency-parameters global

switch# show distributed-trunking consistency-parameters global
Local Peer
----- ----
Peer config unavailable.
Image Version KB.15.18.0000x

IP Routing Disabled Disabled
Peer-keepalive interval 1000 0
PIM-DM Support Disabled Disabled
PIM-SM Support Disabled Disabled
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IGMP enabled VLANs on Local :
IGMP enabled VLANs on Peer :
PIM-DM Enabled VLANs on Local : <List of Vlans>
PIM-DM Enabled VLANs on Peer : <List of Vlans>
PIM-SM enabled VLANs on Local : <List of Vlans>
PIM-SM enabled VLANs on Peer : <List of Vlans>
DHCP-snooping Enabled on Local :
DHCP-Snooping Enabled on Peer                 : Yes
DHCP-Snooping Enabled VLANs on Local          : 1
DHCP-Snooping Enabled VLANs on Peer           : 1
DHCP-Snooping Max-Binding Configured on Local  : Yes

Ports  Max-Bindings
------- ------------
Trk2   6

DHCP-Snooping Max-Binding Configured on Peer   : No

Feature pim-sm

show distributed-trunking consistency-parameters global feature pim-sm

PIM-SM Enabled VLANs on Local : 20,30
PIM-SM Enabled VLANs on Peer : 20,30

show dhcpv6 relay
Syntax
show dhcpv6-relay
Description

Displays the DHCPv6 relay configuration. Cannot be configured from the WebUI or Menu.

Sample output

show dhcpv6-relay

DHCPV6 Relay Agent : Enabled
Option 79 : Disabled
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DHCPv6 event log
Cause

Event Message

RMON_DSNOOPV6_UNTRUSTED_PORT_SERVER_RELAY %s: %s message received on
the untrusted port %s from
%s.

RMON_DSNOOPV6_UNTRUSTED_PORT_SERVER_SUSP %s: Ceasing the log
messages for the server
packets received on an
untrusted port for %s.

RMON_DSNOOPV6_UNTRUSTED_PORT_CLIENT_DEST %s: Client packet destined to
the untrusted port %s is
dropped.

RMON_DSNOOPV6_UNTRUSTED_PORT_CLIENT_DEST_SUSP %s: Ceasing the log
messages for the client
packets destined to an
untrusted port for %s.

RMON_DSNOOPV6_UNAUTHORIZED_SERVER %s: Unauthorized server %s
detected on port %s

RMON_DSNOOPV6_UNAUTHORIZED_SERVER_SUSP %s: Ceasing unauthorized
server logs for %s

RMON_DSNOOPV6_BAD_RELEASE %s: Illegal IPv6 release from
%02X%02X%02X-%02X%02X
%02X on port %s; Address
leased to other client or not
leased. %s.

RMON_DSNOOPV6_BAD_RELEASE_SUSP %s: Ceasing the log
messages for the illegal IPv6
release messages received
from the clients for %s

RMON_DSNOOPV6_TABLE_FULL %s: Unable to add the
DHCPv6 lease because the
lease table is full.

RMON_DSNOOPV6_TABLE_FULL_SUSP %s: Ceasing the log
messages for the failed lease
table updates for %s.

Table Continued

Chapter 9 DHCPv6 server 287

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 6884



Event Message

RMON_DSNOOPV6_MAX_BINDING_CROSSED %s: Droppped IPv6 request
from %02X%02X%02X-%02X
%02X%02X. The max-binding
limit has reached on the port
%s. %s

RMON_DSNOOPV6_MAX_BINDING_CROSSED_SUSP %s: Ceasing max-binding limit
crossed packet information
logs for %s.

RMON_DSNOOPV6_EVENT_MAXBINDING_REMOVED %s: The DHCPv6-Snooping
max-binding configured on
port %s is removed.

RMON_DSNOOPV6_EVENT_MAXBINDING_REMOVED_SUSP %s: Ceasing the log
messages for the removal of
DHCPv6-Snooping max-
binding from the ports for %s

RMON_DSNOOPV6_EVENT_BINDINGS_EQUALS_MAXBIND %s: The number of bindings
on the port %s equals the
maximum binding configured
on that port.

RMON_DSNOOPV6_EVENT_BINDINGS_EQUALS_MAXBIND_SUSP %s: Ceasing the log
messages for bindings on port
that equals max-binding value
for %s.

RMON_DSNOOPV6_EVENT_MAXBIND_BELOW_BINDINGS %s: The number of bindings
on the port %s exceeds the
maximum binding configured
on that port.

RMON_DSNOOPV6_EVENT_MAXBIND_BELOW_BINDINGS_SUSP %s: Ceasing the log
messages for bindings on port
that exceeds max-binding for
%s.

RMON_DSNOOPV6_READ_LEASES_ERROR %s: Reading %s/%s %s

RMON_DSNOOPV6_READ_LEASES_SUSP %s: Ceasing remote server
lease file read status logs for
%s

RMON_DSNOOPV6_WRITE_LEASES_ERROR %s: Writing %s/%s %s

RMON_DSNOOPV6_WRITE_LEASES_SUSP %s: Ceasing remote server
lease file write status logs for
%s

Table Continued
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Event Message

RMON_DSNOOPV6_TABLE_FULL_REM_LEASE %s: The dynamic binding for
%s on port %s was replaced
with a manual binding.

RMON_DSNOOPV6_TABLE_FULL_REM_LEASE_SUSP %s: Ceasing removed lease
logs for %s.

RMON_DSNOOPV6_BAD_IP_REQ %s: Illegal IPv6 request from
%02X%02X%02X-%02X%02X
%02X on port %s; %s.

RMON_DSNOOPV6_BAD_IP_REQ_SUSP %s: s: Ceasing the log
messages for illegal IPv6
requests for %s

RMON_DSNOOPV6_BAD_IP_OFFER %s: Offered lease from %s
conflicts other leases in BST.
%s.

RMON_DSNOOPV6_BAD_IP_OFFER_SUSP %s: Ceasing the log
messages for duplicate IPv6
offers for %s.

RMON_DSNOOPV6_ILLEGAL_LEASE %s: Dropped the IPv6 offer
from %s because the offered
address is illegal. %s.

RMON_DSNOOPV6_ILLEGAL_LEASE_SUSP %s: Ceasing the log
messages for illegal IPv6
offers for %s

RMON_DSNOOPV6_INVALID_PACKET %s: Invalid DHCPv6 packet
%s. %s.

RMON_DSNOOPV6_INVALID_PACKET_SUSP %s: Ceasing the log
messages for invalid DHCPv6
packets for %s

RMON_DSNOOPV6_DIPLDV6_PORT_REMOVED_VLAN Port %s removed from
dhcpv6-snooping enabled vlan
%d

RMON_DIPLDV6_DSNOOPV6_DISABLED_GLOBAL Dhcpv6-snooping disabled
globally, dynamic Ipv6
lockdown also disabled.

RMON_DIPLDV6_DSNOOPv6_DISABLED_VLAN Dhcpv6-snooping disabled on
vlan %d, dynamic Ipv6
lockdown also disabled.

Table Continued
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Event Message

RMON_DSNOOPV6_PORT_TRUSTED_TO_VALIDATING The port %s is configured as
an untrusted port.

RMON_DSNOOPV6_PORT_ADD_TO_TRUNK_ERROR Unable to add port %s to
trunk, insufficient HW
resources.

RMON_DIPLDV6_PORT_ADD_HW_RESOURCE_ERROR Unable to apply dynamic Ipv6
lockdown to port %s,
insufficient HW resources.

RMON_DIPLDV6_ADD_BINDING_OUT_OF_RESOURCES Unable to add binding for %x,
%02x%02x%02x-%02x%02x
%02x on port %s.

RMON_DIPLDV6_VLAN_DENY_OUT_OF_RESOURCES Unable to ipv6 lock-down
VLAN %d on port %s, not
enough HW resources.

RMON_DIPLDV6_VIOLATION Access denied %s -> %s port
%s, %d packets received
since last log

RMON_DIPLDV6_DHCPV6_REQUEST_DROPPED DHCPV6 REQUEST dropped
for %02x%02x%02x-%02x
%02x%02x port %s, unable to
add the binding; a port or
switch limit was reached.

RMON_DIPLDV6_VIOLATION_ON_VLAN Access was denied on VLAN
%d, %d packets received
since last log.

RMON_DSNOOPV6_CONFLICT_IN_BST %s: The IPv6 address %s
provided by the DHCPv6
server to the client %s is
already assigned to another
client %s.

RMON_DSNOOPV6_CONFLICT_IN_BST_SUSP %s: Ceasing status logs for
Conflicts in BST for %s
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DHCPv6 event messages
Cause

Events Debug messages

When the BST becomes full, to indicate that lease
bindings are being dropped.

Unable to add binding for %x, %02x%02x%02x-%02x
%02x%02x on port %s. BST is full.

When DHCPv6 packet validation fails (packets are
received on which they are not expected to).

Dropping packet as validation failed, reason %s

When a Dynamic binding is replaced with a static
binding on a particular port.

The dynamic binding for %s on port %s was replaced
with a manual binding.

While an attempt to release an Ipv6 address from port
which is leased to another port.

Unable to release. %02x%02x%02x-%02x%02x%02x
is bound not bound to port %u.

Decline from client to server when client finds the
address issued by server is already in use in the link
where the client is connected.

%s: Decline offer from %x (server)of %x because the
address is already assigned to another client.

Decline from client when server assigns an illegal Ipv6
address.

%s: Decline offer from %x (server) of %x because the
address is illegal.

When TFTP transfer of binding state table is a success
or failure.

TFTP of BST from the dsnoopv6 device is successful /
failed.

When a DIPLDv6 enabled port is removed from a
DsnoopV6 enabled vlan.

Port %u is removed from a dhcpv6-snooped VLAN

When DsnoopV6 is disabled globally which makes
DIPLDv6 no longer configured?

Dhcpv6-snooping disabled globally, dynamic Ipv6
lockdown also disabled.

When DsnoopV6 is disabled on a particular VLAN
which makes DIPLDv6 also disabled

Dhcpv6-snooping disabled on VLAN %s, dynamic Ipv6
lockdown also disabled.

When a port moved from SAVI-Trust to validating port. Port %u is validating.

While adding a port to a trunk for which DIPLDv6 is
already enabled.

Unable to add port %u to trunk, dynamic ipv6 lockdown
is enabled on it.

While enabling DIPLDv6 on a port which is added to a
trunk.

Unable to configure dynamic Ipv6 lockdown on port %u
which is a part of a trunk.

While enabling DIPLDv6 on a port for which ACL is
configured.

Unable to configure dynamic Ipv6 lockdown on port
%u, ACL is configured on port.

When it is unable to add a lock on a particular VLAN
for a particular port due to vlan deny rule.

Access was denied on VLAN %d, deny rule exists on
the VLAN

Table Continued
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Events Debug messages

When DIPLDv6 violations are detected on a VLAN Access was denied on VLAN %d, %d packets received
since last log.

When max-binding limit is reached on a Port Max-binding limit reached on Port %s.
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Aruba offers on-premise and cloud-based management solutions for switches, access points, and controllers.

AirWave is an award-winning on-premise Network Management Solution (NMS) that manages both Aruba and
third-party network devices. AirWave is ideal for Campus networks and for organizations which prefer to have
complete control over the hardware and software and have their NMS within premises (for example: either in the
head office or data center or one of the large campuses).

Aruba Central is a popular cloud-based management solution for Branch and Distributed Enterprises which prefer
simplicity, programmability, and integration with third-party cloud-based solutions for automation. Central offers
cloud portal subscriptions through which one can manage the entire network of Aruba devices, without having to
set up, upgrade, scale, or manage an NMS.

In this chapter, the focus is primarily on the Zero Touch Provisioning (ZTP) and connection to either AirWave or
Central using ZTP for check-in, configuration download, and management.

What is ZTP?

ZTP enables the auto-configuration of factory-default switches without requiring any manual setup process. It
helps the administrators to deploy their fleet of switches at multiple branches without requiring a technical expert
onsite. It is of use for distributed enterprises (for example: hotels, hospitals, retail stores, educational institutions,
and other enterprises) where an administrator is not available at every site.

Aruba offers ZTP solution which reduces the overall cost of ownership. Aruba ships infrastructure devices such as
switches, access points, and controllers directly to the site of usage. With ZTP, even a nontechnical user (for
example: store manager in a retail chain or a class teacher in a school) can deploy devices at site. When the
devices are connected to AirWave or Central, ZTP automatically sets up the required firmware and configurations,
and services without the need for technical expertise on site.

ZTP with AirWave
Aruba supports ZTP using:

• DHCP servers for on-premise management (see DHCP server configuration for DHCP based ZTP).

• Activate for cloud-based management. Activate is a cloud-based inventory management and provisioning
service (see Activate based ZTP with AirWave).

You can choose any of the ZTP methods based on your requirement. For example: If all the campuses and
branches which an Enterprise manages are reachable within a private network, it is recommended to use DHCP
based ZTP. If an Enterprise network spans multiple campuses and branches using WAN to communicate, use
Activate based ZTP.

DHCP-based ZTP with AirWave
IPv6 based ZTP is supported from 16.06 switch version. Switches can be connected to AirWave through IPv4 or
IPv6 addresses. To enable IPv6 ZTP provisioning, the ipv6 enable and ipv6 address dhcp full will be
enabled by default from 16.06 switch version. These commands also get enabled when the switch upgrades from
any older images to 16.06 with factory default configuration. From 16.06 release, the switch can act as DHCP
server for IPv4 ZTP. The switch supports DHCP option 60 and 43 which is required for ZTP. AirWave 8.2.6.1
supports IPv6 ZTP over data port and AirWave 8.2.8 will support IPv6 ZTP over OOBM port.

Chapter 10
Zero Touch Provisioning with AirWave and Central
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Configuring DHCP-based ZTP with AirWave
ZTP auto-configures your switches as follows:

Procedure

1. The switch boots up with the factory default configuration.

2. The switch sends out a DHCP discovery from data port/OOBM.

IPv4:

• The preferred configuration method uses DHCP option 43 value as a string to parse AirWave configuration.
Switch expects a DHCP option 60 with value ArubaInstantAP along with DHCP option 43 to parse
AirWave details.

• The alternative configuration method supports both encapsulated values from option 43 and direct value
from option 43. Encapsulated vendor-specific sub options, with suboption code 146 is for AirWave details.

NOTE: IPv4 DHCP sub option 146 is not supported to configure AMP information through OOBM.

IPv6:

• IPv6 uses DHCP option 17 with sub option 100 and vendor class Enterprise ID as 47196.

• DHCPv6 based ZTP on OOBM interface, ipv6 enable and ipv6 address dhcp full commands are
enabled by default on OOBM interface.

3. After the AirWave details are verified and configured, the switch initiates the check-in into the AirWave server
using the HTTPS communication. The AirWave configuration must be in the following format:

<Group>:<Topfolder>:<folder1>,<AMP IP >,<shared secret>
4. From 16.08, if AirWave is reachable through both OOBM and Data VLAN, switch tries to register only with

AirWave using OOBM.

5. After a successful registration, AirWave can monitor, configure, and troubleshoot the switches. Refer to Aruba
Networks and AirWave Switch Configuration Guide.

6. Check-in failure retry is done every 60 seconds for 10 retries.

7. If DHCP does not provide AirWave details, the switch connects to Activate (Activate ZTP starts) for AirWave or
Aruba Central details. If the DHCP options are not configured for AirWave, the switch is left in its default state
for manual configuration.
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In the preceding illustration, the workflow is as follows:

1. The switches being provisioned in the branches are booted obtaining the IP address from the DHCP server.

2. The DHCP servers provide information about the AirWave server in the Corporate Head Quarters.

3. The switches connect to the AirWave server through the Corporate Network (MPLS VPN or equivalent).

4. The AirWave server pushes the configuration to the switches based on the AirWave folder, switch model, and
branch location.

5. An optional IPsec tunnel can be established between the branches and the Corporate HQ to secure the
management traffic. For more information, refer the Activate-based ZTP with AirWave.

NOTE: If IPsec tunnel is required for AirWave, the switch requires Aruba Mobility Controller IP
address, which is provided through ZTP with DHCP Option 138 (CAPWAP).

DHCP server configuration for DHCP based ZTP
You can configure the DHCP server for AirWave using Windows DHCP server, Linux DHCP server, and ArubaOS
DHCP server.

Preferred Methods
The following methods are preferred to configure DHCP server for AirWave:

Configure AirWave details in Windows DHCP server for IPv4

NOTE: AirWave provisioning using IPv6 on Windows based DHCP server is not supported.

To configure the AirWave details in Windows DHCP server for IPv4, do the following steps:

Procedure

1. From the Start menu, select Server Manager.
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2. Select Roles -> DHCP -> Server -> w2k8 -> IPv4.

3. Right-click IPv4 and select Set Predefined Options...
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4. The Predefined Options and Values screen is displayed. Click Add....

5. Enter the Name (any), Data type (select String), Code (enter 60), and Description (any).
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6. Click OK.

7. From the Predefined Options and Values screen, under Value, enter the String ArubaInstantAP. The
string is case-sensitive and must be ArubaInstantAP.

8. Click OK.

9. Under IPv4, expand Scope. Right-click Scope Options and select Configure Options...
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10. Under the General tab, select 043 Vendor Specific Info. The Data entry data appears. Under ASCII, enter
hpeSwitch:hp2920,90.1.1.10, admin. The ASCII value has the following format:
<Group>:<Topfolder>,<AMP IP>,<shared secret>

11. To add subdirectories, use the following format: <Group>:<Topfolder>:<folder1>,<AMP
IP>,<shared secret>

12. Under the General tab, select 060 AirWave. Click OK.
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NOTE: No changes are required to the 060 option.

13. You can verify the AirWave details as follows:

switch# show amp-server
switch# show run

Configure AirWave details in Linux DHCP server for IPv4
To configure the AirWave details in Linux DHCP server for IPv4, enter the following information:

option CAPWAP code 138 = array of ip-address; 
ddns-update-style ad-hoc; 
subnet 192.168.20.0 netmask 255.255.255.0 { 
   option tftp-server-name "192.168.20.5"; 
   option routers 192.168.20.31; 
   option ntp-servers 192.168.20.5; 
   option domain-name "Airport"; 
   option domain-name-servers 192.168.20.5; 
   option CAPWAP 171.0.0.3; 
   
   #option 43 "171.0.0.100"; 
   range 192.168.20.10 192.168.20.30; 
}
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Configure AirWave details in Linux DHCP server for IPv6
To configure the AirWave details in Linux DHCP server for IPv6, enter the following information:
default-lease-time 900;
preferred-lifetime 600;
option dhcp-renewal-time 300;
option dhcp-rebinding-time 600;
allow leasequery;
option dhcp6.info-refresh-time 800;
dhcpv6-lease-file-name "/root/dhcpd6.leases";
host myclient {
        # The entry is looked up by this
        host-identifier option
                dhcp6.client-id 00:01:00:01:00:04:93:e0:00:00:00:00:a2:a2;

        # A fixed address
        fixed-address6 2001::1234;

        # A fixed prefix
        fixed-prefix6 2001::/64;

        # For debug (to see when the entry statements are executed)
        #  (log sol when a matching Solicitation is received)
        ##if packet(0,1) = 1 { log(debug,sol); }
}

# The subnet where the server is attached
subnet6 2001::/64 {
        range6 2001::5000 2001::5090;

        # Some /64 prefixes available for Prefix Delegation (RFC 3633)
#3ffe:501:ffff:100:: 3ffe:501:ffff:111:: /64;
        prefix6 2001::  2001:3:: /64;

        option dhcp6.name-servers 2001::6001,2001::6002;

        option dhcp6.vendor-opts
        00:00:B8:5C:   # HPE enterprise-number
        00:64:00:35:   # suboption (100) + length of AW string

#below hex values are for this ascii string : group:folder,2001::212,secret
67:72:6f:75:70:3a:66:6f:6c:64:65:72:2c:32:30:30:31:3a:3a:32:34:32:2c:73:65:63:72:65:74;
}

Configure AirWave details in ArubaOS-Switch DHCP server for IPv4

NOTE: AirWave provisioning using IPv6 on ArubaOS-Switch based DHCP server is not supported.

To configure the AirWave details in ArubaOS-Switch DHCP server for IPv4, enter the following information:

option 43 ascii "group:folder,192.168.240.242,secret1"
option 60 ascii "ArubaInstantAP"
Alternate Methods
The following are the alternate methods to configure DHCP server for AirWave:

Chapter 10 Zero Touch Provisioning with AirWave and Central 301

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 6898



Configure AirWave details in Windows DHCP server for IPv4

NOTE: AirWave provisioning using IPv6 on Windows based DHCP server is not supported.

To configure the AirWave details in Windows DHCP server for IPv4, do the following steps:

NOTE:

• Use these steps to configure ZTP for every switch by selecting a different Vendor Class for each
type of switch.

• This method is not applicable for ZTP through OOBM.

Procedure

1. From the Start menu, select Server Manager.

2. Select Roles -> DHCP -> Server -> w2k8 -> IPv4.
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3. Right-click IPv4 and select Define Vendor Classes....

4. The DHCP Vendor Classes window is displayed. Click Add....
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5. To get the vendor-specific value of a switch, go to the switch console and enter:

switch# show dhcp client vendor-specific
          

6. The following is the sample command output: Processing of Vendor Specific Configuration is enabled.

    Vendor Class Id = J9729A 2920-24G-PoE+ Switch dslforum.org 
7. From the New Class window, enter the desired Display name (any) and the Description (any). For the

ASCII field, enter the exact value that you got by executing the show command performed in the previous
step. In this example, Hewlett Packard Enterprise J9729A 2920-24G-PoE+ Switch dslforum.org.
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8. Click OK.

9. Right-click IPv4 and select Set Predefined Options....

10. From the Predefined Options and Values window, select Option class. The Option Class displayed is the
one that you configured under DHCP Vendor Class. In this example, the Option Class is switch.
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11. Click Add....

12. From the Option Type window, enter the desired Class (any), the Data type (select string), the Code (enter
146), and the Description (any).

13. Click OK.

14. Under the Predefined Options and Values window, enter the Value String. In this example, enter
hpeSwitch:hp2920,90.1.1.10, admin. The String has the following format:

<Group>:<Topfolder>,<AMP IP>,<shared secret>
15. To add sub-folders, use the following format:

<Group>:<Topfolder>:<folder1>,<AMP IP>,<shared secret>
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16. Click OK.

17. Under IPv4, expand Scope. Right-click Scope Options and select Configure Options...

18. From the Scope Options window:

a. Select the Advanced tab.

b. Under Vendor class, select the desired switch. In this example, switch.

c. Select the 146 switch option.

d. Click OK.
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19. You can verify the AirWave details as follows:

switch# show amp-server
switch# show run

Configure AirWave details in Linux DHCP server for IPv4
To configure the AirWave details in Linux DHCP server for IPv4, enter the following information:

option space ArubaInstantAP;
option ArubaInstantAP.cfg code 144 = text;
option ArubaInstantAP.img code 145 = text;
option ArubaInstantAP.org code 146 = text;
option CAPWAP code 138 = array of ip-address;

ddns-update-style ad-hoc;

subnet 192.168.20.0 netmask 255.255.255.0 {
   option tftp-server-name "192.168.20.5";
   option routers 192.168.20.31;
   option ntp-servers 192.168.20.5;
   option domain-name "Airport";
   option domain-name-servers 192.168.20.5;
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   option CAPWAP 171.0.0.3, 192.168.20.31;

   class "vendor-class" {
        match substring (option vendor-class-identifier,0,2);
        #match option vendor-class-identifier;
   }
   subclass "vendor-class" "HP" {
      vendor-option-space ArubaInstantAP;
      #option ArubaInstantAP.cfg "runningConfig_5400R.txt";
      #option ArubaInstantAP.img "KB_16_01_0004.swi";
      option ArubaInstantAP.org "aw_group:fold,171.0.0.100,secret1234";
   }
    subclass "vendor-class" "Ar" {
      vendor-option-space ArubaInstantAP;
      #option ArubaInstantAP.cfg "runningConfig_5400R.txt";
      #option ArubaInstantAP.img "KB_16_01_0004.swi";
      option ArubaInstantAP.org "aw_group:fold,171.0.0.100,secret1234";
   }
   range 192.168.20.10 192.168.20.30;
}

Limitations

• The HTTPS check-in to AirWave does not support HTTPS proxy.

• For non-ZTP cases, the AirWave check-in starts by validating the following condition:

Primary or Management VLAN must be configured with the IP address and one of the interfaces must be UP.
By default, VLAN 1 is the primary VLAN.

• OOBM redirection is not supported by VSF.

Best Practices

• Implement ZTP in a secure and private environment. Any public access may compromise the security of the
switch, as follows:
◦ Since ZTP is enabled only on the factory default configuration of the switch, DHCP snooping is not

enabled. The Rogue DHCP server must be manually managed.

◦ The DHCP offer is in plain data without encryption. Therefore, the offer can be listened by any device on
the network and they can in turn obtain the AirWave information.

◦ The TLS certificate of the server is not validated by the switch during the HTTPs check-in to AirWave. The
AirWave server must be hosted in a private and secure environment of the switch.

Configure AirWave details manually
This section focuses on configuring the switch manually to reach out to AirWave. Manual configuration may be
required, if ZTP is disabled due to the following scenarios or if AirWave credentials are not provided during the
DHCP offer:

• Switch with configuration that explicitly disables ZTP

• Switch with nondefault configuration

• Switches that have upgraded from older images to 16.xx
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In any of the above scenarios, you need to manually configure to reach the AirWave server using the amp-
server command. This command helps you configure the AirWave IP address, group, folder, and shared secret.
You must have the manager role to execute this command.

For example:

switch(config)# amp-server ip 192.168.1.1 group "group" folder "folder" secret "branch1024"
        

The show amp-server command shows the configuration details:

AirWave Configuration details
AMP Server IP : 192.168.1.1
AMP Server Group : GROUP
AMP Server Folder : folder
AMP Server Secret : branch1024
AMP Server Config Status: Configured
        

amp-server

Syntax
amp-server ip <IP-ADDR | IPv6-ADDR> group <GROUP> folder <FOLDER> secret <SECRET>

no amp-server

Description

The amp-server command configures AirWave Management Platform (AMP) IP address, group, folder, and
shared secret for triggering the device registration with AMP. The amp-server command supports both the IPv4
and IPv6 addresses. Switch cannot be provisioned simultaneously with IPv4 and IPv6 AirWave addresses.

NOTE: The amp-server with IPv6 address is supported from 16.06 switch version.

The no form of this command removes the configuration for the AMP server.

Command context
config

Parameters
IP-ADDR

AMP server IPv4 address.

IPv6-ADDR

AMP server IPv6 address.

GROUP

AMP server group name.

FOLDER

AMP server folder name.

SECRET

AMP server shared secret string.
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Example

Switch(config)# amp-server
 ip                    Configure AMP server IP address.
Switch(config)# amp-server ip
 IP-ADDR               Enter an IP address.
 IPV6-ADDR             Enter an IPv6 address.
Switch(config)# amp-server ip 192.168.1.1
 group                 AMP server group name.
Switch(config)# amp-server ip 192.168.1.1 group
 GROUPNAME-STR         AMP server group name.
Switch(config)# amp-server ip 192.168.1.1 group grp11
 folder                AMP server folder name.
Switch(config)# amp-server ip 192.168.1.1 group grp11 folder
 FOLDERNAME-STR        AMP server folder name.
Switch(config)# amp-server ip 192.168.1.1 group grp11 folder fld11
 secret                AMP server shared secret string.
Switch(config)# amp-server ip 192.168.1.1 group grp11 folder fld11 secret
 SECRET-STR            AMP server shared secret string.
Switch(config)# amp-server ip 192.168.1.1 group grp11 folder fld11 secret scrt11

Switch(config)# amp-server ip
 IP-ADDR               Enter an IP address.
 IPV6-ADDR             Enter an IPv6 address.
Switch(config)# amp-server ip 2001:1db8:3cd4:1115:1111:2222:1a2f:1a2b
 group                 AMP server group name.
Switch(config)# amp-server ip 2001:1db8:3cd4:1115:1111:2222:1a2f:1a2b 
group
 GROUPNAME-STR         AMP server group name.
Switch(config)# amp-server ip 2001:1db8:3cd4:1115:1111:2222:1a2f:1a2b 
group grp21
 folder                AMP server folder name.
Switch(config)# amp-server ip 2001:1db8:3cd4:1115:1111:2222:1a2f:1a2b 
group grp21 folder
 FOLDERNAME-STR        AMP server folder name.
Switch(config)# amp-server ip 2001:1db8:3cd4:1115:1111:2222:1a2f:1a2b 
group grp21 folder fld21
 secret                AMP server shared secret string.
Switch(config)# amp-server ip 2001:1db8:3cd4:1115:1111:2222:1a2f:1a2b 
group grp21 folder fld21 secret
 SECRET-STR            AMP server shared secret string.
Switch(config)# amp-server ip 2001:1db8:3cd4:1115:1111:2222:1a2f:1a2b 
group grp21 folder fld21 secret scrt21
To view the AirWave configuration details, use the show amp-server command.

show amp-server

AMP Server Configuration details

  AMP Server IP            : 2001:1db8:3cd4:1115:1111:2222:1a2f:1a2b
  AMP Server Group         : grp21
  AMP Server Folder        : fld21
  AMP Server Secret        : scrt21
  AMP Server Config Status : Configured
show running-configuration

switch# show running-config

; JL071A Configuration Editor; Created on release #KB.16.06.0000x
; Ver #13:03.f8.1c.fb.7f.bf.bb.ff.7c.59.fc.7b.ff.ff.fc.ff.ff.3f.ef:05

hostname "Switch"
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module 1 type jl071x
flexible-module A type JL081A
snmp-server community "public" unrestricted
oobm
   ip address dhcp-bootp
   exit
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-24,A1-A4
   ip address dhcp-bootp
   ipv6 enable
   ipv6 address dhcp full
   exit
amp-server ip 2001:1db8:3cd4:1115:1111:2222:1a2f:1a2b group "grp21" folder "fld21" 
   secret "scrt21"

NOTE: ipv6 enable and ipv6 address dhcp full are enabled by default on VLAN 1 from
16.06 switch version.

debug ztp
Syntax
debug ztp
no debug ztp
Description

Enables or disables ZTP debug logging.

Parameters and options
ztp

Zero Touch Provisioning.

no
The no debug ztp command disables ZTP debug logging.

Stacking support
The ZTP process for stacked switches with AirWave is similar to the one for the standalone switch, with the
exception that only the commander in the stack checks in with AirWave.

Disabling ZTP
ZTP is disabled if you make any of the following changes to the switch configuration:

• Enter the switch configuration mode using the configure terminal command.

• Enter into Menu and exit without doing any configuration

• Use CLI, SNMP, REST APIs, menu interface, or the web GUI to configure any settings. The change is shown
in the running-configuration of the switch.

• When device is upgraded from any 15.xx version to 16.01, see Image Upgrade.

• Once DHCP server or Activate offers Airwave/Central details, ZTP is disabled. If the details are offered again,
it is ignored.
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Image Upgrade
If you upgrade from any 15.xx version to version 16.xx, the following minimal set of configuration is validated to
enable or disable the ZTP process:

• If the switch has any other VLAN apart from the default VLAN, ZTP gets disabled.

• In default VLAN, if the IPv4 address is not set as DHCP (default option is DHCP), ZTP gets disabled.

• In default VLAN, if IPv6 is enabled or configured, ZTP gets disabled.

If you have any other configuration during the upgrade, ZTP will continue to be in the enabled state.

Troubleshooting

Cause

You can troubleshoot switches by using the SSH connection and the device logs available in AirWave. For a list of
all RMON message, refer to ArubaOS-Switch Event Log Message Reference Guide.

You can enable the debug logging with the debug ztp command, see debug ztp.

AMP server messages
To display the AMP server debug messages, enter:

switch# debug ztp
        
To print the debug messages to the terminal, enter:

switch# debug destination session
      

Activate based ZTP with AirWave
ZTP with Activate is used in the following scenarios to help switches check in through the Internet with public
facing instances of Airwave:

• Deployments where administrators do not have a DHCP server to configure Airwave options

• Absence of corporate network reaching every branch

NOTE:

• Activate based ZTP is not supported for IPv6.

• Activate based ZTP is not supported for both IPv4 and IPv6 through OOBM.

Configuring Activate-based ZTP with AirWave
For Activate-based ZTP, the switch connects to Aruba Activate service through the Internet and autoconfiguration
takes place based on the settings provided in Activate. For more information on how to set up an Activate
account, folder and their rules, refer to the Aruba Activate User Guide.
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In the preceding illustration, the workflow is as follows:

1. The switches being provisioned in the branches are booted and connect to the Activate on the cloud.

2. Based on the administrator’s provisioning (folder, rule), the device is placed in the appropriate folder before
getting redirected to the AirWave server in the Corporate HQ.

3. The switches connect to the AirWave server, and the server pushes the configuration to the switches based on
the AirWave folder, switch model, and branch location.

4. Optionally, an IPsec tunnel to the Controller in the HQ can be constructed to secure the management traffic to
AirWave. This configuration can be set as part of the initial configuration push from Activate.

IPsec for AirWave Connectivity

Overview
This feature supports secure communication between the switch and Aruba mobility controller (VPN concentrator)
for AirWave traffic. The switch also provides the necessary support for ZTP by establishing a secure tunnel
between the switch and AirWave, which are provided by a DHCP server or Activate.

IPsec ensures that communication between the switch and AirWave server (management traffic) is protected by
establishing a secure channel between the switches and the Aruba VPN Controller (connected to AirWave
server).

IPsec for Management Traffic
IPsec supports ZTP in deployment scenarios less restrictive than private LANs. ZTP enables switches to be
configured and managed automatically without administrator intervention. In a deployment scenario where a
switch and AirWave are located in different branches connected through an untrusted public network (the
Internet), the communication between the switch and AirWave server can be protected.

NOTE: 

• IPsec tunnel is not supported with IPv6.

• IPsec tunnel is not supported through OOBM.

You can configure IPsec tunnel using any of the following methods:
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• Activate ZTP

• DHCP ZTP with option 138

1. To assign controller IP addresses, select DHCP option 138.

2. Define the controller IP addresses for both the primary and secondary controllers.

• Manual configuration

IPsec Tunnel Establishment

• IPsec tunnel for AirWave is auto-configured. The switch decides to create IPsec tunnel only when an Aruba
controller IP is present in the device before establishing the connection to AirWave.

• If the controller IP is not provided, the switch will try to establish a direct connection to AirWave.

• If the controller IP is present, the switch auto configures and initiates an IPsec tunnel interface. Once the
tunnel is established, the Aruba controller provides an inner IP which the switch will then use as source IP to
send any AirWave bound traffic. The switch then creates a static route to AirWave with the IPsec tunnel
interface as the gateway.
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IPsec Tunnel Failures
The following behaviors can cause an IPsec tunnel creation failure:

• Time

The time in the switch has to be valid and correct. Ensure that NTP configuration is set up on switch and on
the controller where the tunnel is terminating.

• Authentication

The switch MAC addresses for both members must be added to the Aruba controller whitelist.

• Controller IP

The controller IP must be reachable from the switch.

• Inner IP pool

Ensure the inner IP pool is configured on the controller. Tunnel establishment is not successful, if the pool is
full.

• Static Route

There must not be any conflicting static route in the system for the AirWave IP configured.

• License

The controller must have sufficient license to support IPsec tunnels.

IPsec tunnel to secondary controller
ArubaOS-Switch assists support for IPsec tunnel between switch and the Aruba Controller (VPN concentrator) to
carry the switch generated traffic to multiple services behind the Aruba Controller. The services include AirWave
management station, ClearPass, DNS, Syslog, and so on.

IPsec tunnel needs a backup support for IPsec session failure. If the existing IPsec session is lost, the switch is
able to establish a new IPsec tunnel session with a backup controller (secondary controller).

Backup controller support for IPsec tunnel
The switch supports two controllers with all the services such as ClearPass, Syslog, DNS, and AirWave. In such
scenarios, a controller functions as a backup controller.

1. aruba-vpn is modified to support backup controller IP.

aruba-vpn type amp peer-ip <IP_addr> backup-peer-ip <IP_addr>

no aruba-vpn type amp peer-ip <IP_addr> backup-peer-ip <IP_addr>

switch(config)# aruba-vpn type amp peer-ip 171.0.0.1
backup-peer-ip        Configure the Aruba VPN backup IP address.
tos                   Configure the Aruba VPN tos value.
ttl                   Configure the Aruba VPN ttl value.
switch(config)# aruba-vpn type amp peer-ip 171.0.0.1 backup-peer-ip 171.0.0.3

2. When the switch is configured with both the primary and backup controllers, the switch will establish IPsec
tunnel connection with primary controller.

3. Switch initiates a new IPsec session with either primary or backup controller once "Dead Peer Detection" event
is triggered for existing IPsec session.

4. Switch retries establishing IPsec session with both primary and backup controllers alternatively until a
successful IPsec handshake.
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5. Switch tries to establish the IPsec tunnel with the same controller when the following events occur:

• Switch IP change

• Vlan ID change

• Redundancy switch over

6. If aruba-vpn type is amp, after five consecutive AirWave check-in failures, the existing tunnel is destroyed
and an IPsec tunnel is established with the other controller.

NOTE: ZTP continues to support existing DHCP options for AirWave or Controller IP discovery. You
can configure both the primary and backup controllers IP in DHCP.
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Switch reachability to the controllers

Figure 33: Controllers through same VLAN

Figure 34: Controllers through different VLANs

Restrictions

1. Priority based failover is not supported.

2. When there is a failover to backup controller, the primary controller will not try to re-establish the IPsec session
when it becomes active.

3. Failover to the other (either primary or secondary) controller results in data loss. All the existing application
sessions in the switch will be terminated.
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NOTE: The failover will take up to three minutes.

4. The events such as time change and port flap, breaks the existing IPsec session and triggers a failover. The
new IPsec session is established with a backup controller. In such scenario, switch does not perform any
reachability test before selecting a controller to retry.

AirWave IP after discovery
AirWave IP and Aruba Controller IP (either from the Activate Server or from a DHCP server) are established and
auto configured in an IPsec-IPv4 Tunnel. Once received, the IPsec tunnel is auto configured and established to
send AirWave traffic securely. The Aruba Controller provides an inner-ip to the switch which then can
communicate with AirWave.

Configuring the Aruba controller
On the Aruba Controller, configure through CLI:

Procedure

1. Add the switch MAC address to whitelist for authentication. For more information, refer http://
www.arubanetworks.com/techdocs/ArubaOS_63_Web_Help/Content/ArubaFrameStyles/Control_Plane/
Whitelists_on_Campus_and_Remote_APs.htm

2. Add an IP address pool that can be assigned to switch after tunnel creation. The IP range must not overlap
with the interfaces IP on the controller.

ip local pool "ipsec" 2.0.0.100 2.0.0.255
3. Create access lists that permit AirWave traffic and assign them to ap-roles. It is required only if the controller

version is less than 6.5.2.0 or 8.1.0.0. If required, you can add specific acls such as sys-switch-role.

ip access-list session acl
any any tcp 22 permit
any any tcp 443 permit
user-role sys-switch role
access-list session acl

4. View the whitelist.

AirWave Controller IP configuration commands

aruba-vpn type

Syntax
aruba-vpn type amp peer-ip <IP_addr> backup-peer-ip <IP_addr>

no aruba-vpn type amp peer-ip <IP_addr> backup-peer-ip <IP_addr>

aruba-vpn type any peer-ip <IP_addr> backup-peer-ip <IP_addr>

no aruba-vpn type any peer-ip <IP_addr> backup-peer-ip <IP_addr>
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Description

Configure the Aruba VPN type, peer IP address. When Aruba VPN type is any, the tunnel is established
independent of Airwave configuration.

The no form of the command removes the aruba-vpn type statement from the configuration.

Parameters
type

Configure the controller IP.

amp
Configure Remote Access VPN session to protect specific switch generated traffic. It also supports secure
ZTP of Airwave Management Platform (AMP) server.

any
Configure Remote Access VPN session to protect specific switch generated traffic. Secure ZTP is not
supported.

<IP_addr>

IP address of the VPN.

Usage
switch(config)# aruba-vpn type 

switch(config)# aruba-vpn type amp 

switch(config)# aruba-vpn type amp peer-ip

switch(config)# aruba-vpn type any

NOTE: 

• When you configure aruba-vpn type as any, the switch creates a tunnel and updates the
inner-ip.

• You can create routes using the ip route command for next hop as aruba-vpn sends
management traffic over the tunnel. For example: ip route 2.0.0.0 255.255.255.0
tunnel aruba-vpn

Show commands

show aruba-vpn
Syntax
show aruba-vpn type <VPN-TYPE>
Description

Show Aruba-VPN configuration information.

show aruba-vpn

show aruba-vpn
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 Aruba VPN details

  Aruba VPN Type           : amp
  Aruba VPN Peer IP        : 171.0.0.1
  Aruba VPN Backup Peer IP : 171.0.0.3
  Aruba VPN Config Status  : Configured
  Aruba VPN tos            : Value from IPv4 header
  Aruba VPN ttl            : 64

show aruba-vpn type amp

show aruba-vpn type amp

 Aruba VPN details

  Aruba VPN Type           : amp
  Aruba VPN Peer IP        : 171.0.0.1
  Aruba VPN Backup Peer IP : 171.0.0.3
  Aruba VPN Config Status  : Configured
  Aruba VPN tos            : Value from IPv4 header
  Aruba VPN ttl            : 64

show ip route
Syntax
show ip route
Description

Show the IP route.

show ip route

show ip route

                                IP Route Entries

  Destination        Gateway         VLAN Type      Sub-Type   Metric     Dist.
  ------------------ --------------- ---- --------- ---------- ---------- -----
  0.0.0.0/0          192.168.20.31   1    static               250        1
**2.0.0.9/32         aruba-vpn            static               1          1
 *2.0.0.108/32       aruba-vpn            connected            1          0
  127.0.0.0/8        reject               static               0          0
  127.0.0.1/32       lo0                  connected            1          0
  192.168.20.0/24    DEFAULT_VLAN    1    connected            1          0
*The inner IP received from the Aruba Controller.

**Static Route for AirWave IP. Added automatically by the switch after tunnel establishment.

show interfaces tunnel aruba-vpn
Syntax
show interfaces tunnel aruba-vpn
Description
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Auto-configured tunnel interface before creating IPsec. The tunnel ID is auto generated and to avoid conflict with
user generated tunnel interface, the tunnel id is always the max tunnel supported by the switch + 1.

aruba-vpn

Display the configuration and status details of aruba-vpn tunnel.

brief

Display brief configuration and status for all tunnels.

Usage
show interfaces tunnel aruba-vpn
show interfaces tunnel brief
show interfaces [tunnel] [<TUNNEL-LIST> | <TUNNEL-NAME> | brief | type]
      

switch(config)# show interfaces tunnel aruba-vpn 

 Tunnel Configuration : 

  Tunnel               : tunnel-129
  Tunnel Name          : aruba-vpn-tunnel
  Tunnel Status        : Enabled
  Source Address       : 192.168.20.10
  Destination Address  : 171.0.0.3
  Mode                 : IPsec IPv4
  TOS                  : Value from IPv4 header
  TTL                  : 64
  IPv6                 : Disabled
  MTU                  : 1280

 Current Tunnel Status :

  Tunnel State               : Up
  Destination Address Route  : 0.0.0.0/0
  Next Hop IP                : 192.168.20.31
  Next Hop Interface         : vlan-1
  Next Hop IP Link Status    : Up
  Source Address             : Configured on vlan-1
  IP Datagrams Received      : 11
  IP Datagrams Transmitted   : 36  

switch(config)#  show interfaces tunnel brief
 Status - Tunnel Information Brief
  Tunnel                   : tunnel-129
  Mode                     : IPsec IPv4
  Source Address           : 192.168.20.10
  Destination Address      : 171.0.0.3
  Configured Tunnel Status : Enabled
  Current Tunnel State     : Up

show crypto-ipsec sa
Syntax
show crypto ipsec sa
Description
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Show crypto-IPsec statistics.

switch# show crypto ipsec sa

  Crypto IPSec Status 
  Interface              : 1         
  Source Address         : 192.168.20.10                           
  Destination Address    : 171.0.0.3                               
  Source Port            : 0              Destination Port   : 0              
  SPI                    : 3767553536                                         
  Encapsulation Protocol : ESP                                                
  Encryption             : AES            Hash               : SHA1           
  PFS                    : 0              PFS Group          :
  Mode                   : tunnel
  Key Life               : 3600           Remaining key Life : 3303
  Key Size               : 0              Remaining key Size : 0
  Interface              : 2
  Source Address         : 171.0.0.3
  Destination Address    : 192.168.20.10
  Source Port            : 0              Destination Port   : 0
  SPI                    : 4173307552
  Encapsulation Protocol : ESP
  Encryption             : AES            Hash               : SHA1
  PFS                    : 0              PFS Group          :
  Mode                   : tunnel
  Key Life               : 3600           Remaining key Life : 3301
  Key Size               : 0              Remaining key Size : 0
Usage
show crypto ipsec statistics

show running-configuration
Syntax
show running-configuration

NOTE: IP route or tunnel interface will not be displayed in show run as they are auto created.

show running-configuration

show running-config

Running configuration:

; JL258A Configuration Editor; Created on release #XX.XX.XX.XXXX
; Ver #11:10.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:bc
hostname "switch"
module 1 type jl258a
ip default-gateway 192.168.20.31
snmp-server community "public" unrestricted
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-10
   ip address 192.168.20.10 255.255.255.0
   exit
amp-server ip 2.0.0.9 group "aw_group" folder "fold" secret "secret123"
aruba-vpn type amp peer-ip 171.0.0.3
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ZTP with Aruba Central
Aruba Central does not require any configuration of local DHCP server or other network components but requires
a switch with Internet access.

Users with access to Aruba Central cloud portal must provision their switches and assign licenses accordingly.
Once complete, Aruba Central will automatically program the Activate portal with the required switch details and
the group to which the switch must check in.

NOTE:

• Aruba Central does not support IPv6 connectivity.

• Aruba Central is not applicable for connection through OOBM interface.

The following diagram illustrates the working of Aruba Central ZTP:

The workflow is as follows:

1. The switches being provisioned in branches boot and connect to the Activate on the cloud.

2. Based on administrator’s provisioning (such as folder, rule), the device is placed in the appropriate folder
before being redirected to the Aruba Central.

3. The switches check-in with Central and the server pushes the configuration to the switches based on the
group, switch model, and branch location.

For more information on Aruba Central configuration, refer to the Aruba Central Configuration Guide.

After the switch successfully checks-in with Aruba Central, the following management interfaces on the switch are
disabled:

• WebUI

• REST

• SNMP
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• TR-69

• Menu

There is a restriction on executing the following commands over CLI:

• boot

• recopy

• erase

• reload

• startup-default

• upgrade-software

• setup

• delete

• reboot

• restore

• menu

• write memory

• amp-server

LED Blink feature
Central connectivity loss is indicated by LEDs. If connectivity is broken and Aruba-Central is enabled, the
USR/FDX and Locator LEDs will blink. The LEDs will stop blinking once the switch is connected back to Central. 

Aruba Central Configuration manually
In factory default switches, ZTP with Central is turned ON. ZTP can be disabled in the following scenarios:

• Switches with edited configuration

• Switches where the administrator has explicitly turned off ZTP with Central

In any of the mentioned scenarios, an administrator can manually configure Aruba Central using the aruba-
central command.

Activating ArubaOS-Switch Firmware Integration
CLIs are available for Activate firmware updates which enables, update, checks and shows firmware upgrades.
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Operating Notes

Switch will periodically check with Activate every seven days for the latest image version.

Download the image from the URL provided by Activate and upgrade the switch with the new image.

Restrictions

When a switch is managed by either AirWave or Aruba Central, the automatic firmware check is disabled.

Activate upgrade from the non-supported build is disabled upon upgrading to version 16.03.

Upon upgrade from version 16.02 to version 16.03 with activate provision enabled, activate software update will
be enabled.

activate software-update enable

Syntax
activate software-update [enable | disable]

Description

Enables or disables the Activate software update.

Activate software-update is enabled by default.

Options
disable

Disables the Activate software update.
enable

Enables the Activate software update.

Example

Switch will check with activate for every seven days for latest image available and RMON logs will be generated:

I 10/25/16 14:04:27 05219 activate: 
A system software update is available to version WB.16.02.0012.

activate software-update check

Syntax
activate software-update check

Description

Check the Activate software update manually.

Example

switch(config)$# activate software-update check

 Configuration and Status - Activate Software Update
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  Activate Server Address      : device.arubanetworks.com
  Activate Server Polling      : Enabled
  Installed Software Version   : WB.16.04.0000x
  Server Software Version      : Not available - server communication error.
  Server Software Image URL    : Not available - server communication error.
switch(config)$

NOTE: This switch is not connected to Activate, hence communication error is shown in “Server
Software Version” and “Server Software Image URL” field.

activate software-update update
Syntax
switch#(config) activate software-update update
Description

Updates the software for Activate.

Options
primary

Update primary software image using the Aruba Activate server.

secondary

Update secondary software image using the Aruba Activate server.

Example

switch# activate software-update update

This command will save the current configuration,
update the selected software image, and reboot the
system to the selected partition.

Continue (y/n)? y

000M

show activate software-update

Syntax
show activate software-update

Description

Show the configuration and status of the Activate software update.

Example output

switch(config)$ show activate software-update 

Configuration and Status - Activate Software Update

  Activate Server Address      : device.arubanetworks.com
  Activate Server Polling      : Enabled
  Installed Software Version   : WB.16.04.0000x
  Server Software Version      : Not available - server communication error.
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  Server Software Image URL    : Not available - server communication error.
switch(config)$

Show activate provision

Syntax
show activate provision

Description

Show the configuration and status of the Activate Provision services.

Examples

switch(config)#show activate provision

 Configuration and Status - Activate Provision service
  Activate server address    : device.arubanetworks.com
  Activate server polling    : Enabled
  Activation key             : ABC-XYZ-123
Default status when Activate server polling is not started

switch(config)#show activate provision

 Configuration and Status - Activate Provision Service

  Activate Provision Service   : Enabled
  Activate Server Address      : device.arubanetworks.com
  Activation Key               : Not Available
  NTP/HTP Time Sync Status     : Not Updated
  Activate DNS Lookup          : NA
  Proxy Server DNS Lookup      : NA
  Activate Connection Status   : NA
  Error Reason                 : NA
Connected to Activate (post DNS resolution) and got Central URL

switch(config)#show activate provision
Configuration and Status - Activate Provision Service

  Activate Provision Service   : Enabled
  Activate Server Address      : device.arubanetworks.com
  Activation Key               : ZAELQSRB
  NTP/HTP Time Sync Status     : Time sync from NTP
  Activate DNS Lookup          : Success
  Proxy Server DNS Lookup      : NA
  Activate Connection Status   : Success
  Error Reason                 : NA
Disable the Activate polling, after getting the Central URL

switch(config)#show activate provision

 Configuration and Status - Activate Provision Service

  Activate Provision Service   : Disabled
  Activate Server Address      : device.arubanetworks.com
  Activation Key               : ZAELQSRB
  NTP/HTP Time Sync Status     : Time sync from NTP
  Activate DNS Lookup          : Success
  Proxy Server DNS Lookup      : NA
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  Activate Connection Status   : Success
  Error Reason                 : NA  
Unsuccessful Activate connection when device entry not present in Activate

switch(config)# show activate provision

 Configuration and Status - Activate Provision Service

  Activate Provision Service   : Enabled
  Activate Server Address      : device.arubanetworks.com
  Activation Key               : Not Available
  NTP/HTP Time Sync Status     : Time sync from NTP
  Activate DNS Resolution      : Success
  Proxy Server DNS Lookup      : NA
  Activate Connection Lookup   : Failure
  Error Reason                 : Failed response received. 
  Status code                  : not-authenticated
Activate pushing AirWave parameters to switch

switch(config)#show activate provision

 Configuration and Status - Activate Provision Service

  Activate Provision Service   : Enabled
  Activate Server Address      : device.arubanetworks.com
  Activation Key               : ZAELQSRB
  NTP/HTP Time Sync Status     : Time sync from NTP
  Activate DNS Lookup          : Success
  Proxy Server DNS Lookup      : NA
  Activate Connection Status   : Success
  Error Reason                 : NA 
Unsuccessful Activate connection due to unresolved Activate server address

switch(config)#show activate provision

 Configuration and Status - Activate Provision Service

  Activate Provision Service   : Enabled
  Activate Server Address      : device.arubanetworks.com
  Activation Key               : Not Available
  Time Sync Status             : Time sync from NTP pool
  Activate DNS Lookup          : Failure
  Proxy Server DNS Lookup      : NA
  Activate Connection Status   : NA
  Error Reason                 : NA  

NOTE: DNS resolution is a field in the WebUI (under Dependencies section), it will show DNS
resolution as failure .
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Fields added in 16.07. Status Validation

Time sync status • Time sync from NTP

• Time sync from HTTP

• Time sync from other source

• Not updated

• NA

• Default - Not updated, time is not
updated from NTP and HTTP.

• NA - In this case switch get the
time through SNTP/ CLI/time
server configuration before NTP/
HTTP.

Activate DNS Lookup. • Success

• Failure

• NA

• Default - NA

• Other outputs are based on
device.arubanetworks.com
DNS lookup.

Proxy Server DNS Lookup • Success

• Failure

• NA

• NA - If proxy is not configured.

• Other outputs are based on
proxy lookup.

Activate Connection Status. • Success

• Failure

• NA

Default - NA

Error Reason Default - NA

aruba-central
Syntax
aruba-central {enable | disable | support-mode {enable | disable}}
Description

Configure Aruba Central server support. When enabled, and when a server web address has been obtained using
Aruba Activate, the system will connect to an Aruba Central server. The system will obtain configuration updates
and most local configuration commands will be disabled. This mode is enabled by default.

Enter support mode to enable all configuration commands. Normally, when the system is connected to an Aruba
Central server, the configuration is updated from that server and most local configuration commands are disabled.
Support mode enables those commands for use in troubleshooting problems. Support mode is disabled by
default. When the system is not connected to Aruba Central server, the full command set is enabled for local
configuration.

Restrictions

• Switch communication to Aruba Central is not supported via OOBM.

• Aruba-central is not supported in FIPS switches and it will be disabled by default.

• Aruba-central is not supported in Stack switches and it will be disabled by default.
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CAUTION: To avoid broadcast storm or loops in your network while configuring ZTP, do not have
redundant links after you complete ZTP and Airwave registration. Authorize the new switch and then
push the Golden Configuration template from Airwave.

Example

Enable Aruba Central server support

switch(config)# aruba-central enable
Disable Aruba Central server support

switch(config)# aruba-central disable
Enter support mode to enable all CLI configuration commands

switch(config)# aruba-central support-mode enable

This mode will enable all CLI configuration commands, including those normally reserved by the Aruba Central
service. 
Use of this mode may invalidate the configuration provisioned through Aruba Central server.
Continue (y/n)?              

Troubleshooting
You can troubleshoot switches by using the SSH connection and the device logs available in AirWave. For a list of
all RMON message, refer to Event Log Messages Guide of your switch

You can enable the debug logging with the debug ztp command, see debug ztp .

Show aruba-central
Syntax
show aruba-central
Description

Shows Aruba Central server information.

Example

 switch#show aruba-central
 Configuration and Status - Aruba Central

  Server URL              : https://internal.central.arubanetworks.com/ws
  Connected               : Yes
  Mode                    : Managed
  Last Disconnect Time    : NA
  Server DNS Lookup       : Success
  Proxy Server DNS Lookup : NA
  Error Reason            : NA
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Fields added in 16.07. Status Validation

Server DNS Lookup • Success

• Failure

• NA

By default status is NA. Other status
is based on DNS resolution.

Proxy Server DNS Lookup • Success

• Failure

• NA

If proxy is not configured, status will
be NA. Otherwise Status will be set
based on proxy server DNS lookup.

Error Reason Default-NA

Error reason for Aruba Central
Error Reason field is added in the switch firmware as part of Aruba Central Onboarding Feature from 16.07. Error
reason log helps in debugging switch firmware for central connectivity failure.

Preprocessor Directive Mocana Error
Enum

Error Reason

1 CLOUD_TCP_ERR ERR_TCP TCP error. Check the
server reachability.

2 CLOUD_TCP_READ_ERR ERR_TCP_READ_ERR
OR

TCP read error.
Malformed packet
received or the SSL
socket is closed.

3 CLOUD_TCP_READ_TIMEOUT_ERR ERR_TCP_READ_TIM
EOUT

TCP timeout. Server
is taking longer time
to respond. Check
the server
reachability.

4 CLOUD_TLS_ERR ERR_SSL TLS error. Verify if
the device or system
certificate is valid.

5 CLOUD_TLS_CERT_VAL_ERR ERR_SSL_CERT_VAL
IDATION_FAILED

Certificate validation
failed. Verify if it is
correctly installed,
valid, and trusted.

6 CLOUD_TLS_MUTUAL_AUTH_FAIL_ERR ERR_SSL_MUTUAL_A
UTHENTICATION_FA
ILED

TLS mutual
authentication has
failed.

7 CLOUD_TLS_MUTUAL_AUTH_NOT_REQ_ERR ERR_SSL_MUTUAL_A
UTHENTICATION_NO
T_REQUESTED

Client authentication
is not requested by
server.

8 CLOUD_TLS_MUTUAL_AUTH_REQ_IGNORE_ERR ERR_SSL_MUTUAL_A
UTHENTICATION_RE
QUEST_IGNORED

TLS mutual
authentication
request is ignored.

Table Continued
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Preprocessor Directive Mocana Error
Enum

Error Reason

9 CLOUD_TLS_INVALID_SIG_ERR ERR_SSL_INVALID_
SIGNATURE

Unable to verify the
signature on a
certificate.

10 CLOUD_TLS_NO_DATA_RECV_ERR ERR_SSL_NO_DATA_
TO_RECEIVE

No data received
from server. Check
the server
reachability.

11 CLOUD_CERT_ERR ERR_CERT System certificate is
invalid.

12 CLOUD_CERT_EXPIRE_ERR ERR_CERT_EXPIRED System certificate
expired. Contact
Aruba support.

13 CLOUD_INVALID_TIME_ERR ERR_CERT_START_T
IME_VALID_IN_FUT
URE

Wrong system time.

14 CLOUD_TLS_MULTIPLE_CONN ERR_SSL_TOO_MANY
_CONNECTIONS

Too many
connections to
server. Disconnect
the device and
connect back.

15 CLOUD_TLS_NO_CIPHER_MATCH ERR_SSL_NO_CIPHE
R_MATCH

Cipher suites are not
common between
device and server.

16 CLOUD_TLS_UNKNOWN_CA ERR_SSL_UNKNOWN_
CERTIFICATE_AUTH
ORITY

Server certificate is
not issued by a
trusted CA.

17 CLOUD_TLS_NO_SELF_SIGNET_CERT ERR_SSL_NO_SELF_
SIGNED_CERTIFICA
TES

Server presented a
self-signed
certificate. This
certificate is not
supported for mutual
authentication.

18 CLOUD_GENERIC_ERR TLS generic error
(code: -XYZ)

19 CLOUD_HTTP_101_PROT_MISSNG Internal error:
HTTP/1.1 protocol
missing. Contact
Aruba support.

20 CLOUD_HTTP_UPGRADE_MISSNG_IN_RESP Internal error:
Missing Upgrade in
HTTP response.
Contact Aruba
support.

Table Continued
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Preprocessor Directive Mocana Error
Enum

Error Reason

21 CLOUD_HTTP_ACCEPT_KEY_MISSNG_IN_RESP Internal error:
Missing Sec-
WebSocket-Accept
in HTTP response.
Contact Aruba
support.

22 CLOUD_HTTP_MISMATCH_ACCEPT_KEY Internal error:
Mismatch Sec-
WebSocket-Accept
in HTTP response.
Contact Aruba
support.

23 CLOUD_URL_NOT_REACHABLE_VIA_PXY Central server is not
reachable through
proxy.

debug ztp
Syntax
debug ztp
no debug ztp
Description

Enables or disables ZTP debug logging.

Parameters and options
ztp

Zero Touch Provisioning.

no
The no debug ztp command disables ZTP debug logging.

Error Reason log for Activate Provision
Error Reason field is added in the switch firmware as part of Aruba Central Onboarding Feature from 16.07. Error
reason log helps in debugging switch firmware for central connectivity failure.

Following table shows the list of error reasons.

Preprocessor Directive Error Reason

ACTIVATE_RESP_FAIL_CODE Activate provision fails because of invalid response
received from server with status code: %s.

ACTIVATE_CURL_FAIL_CODE Device fails to reach Activate server with error: %s.

ACTIVATE_FAIL_PROV_NO_DEVICE_ENTRY Device is not registered with Activate server.

ACTIVATE_NON_TPM_CODE_MISSING EST provision with activate server fails because of
invalid response received from Activate server.
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Stacking support
The ZTP process for stacked switches with Central is similar to the one for a standalone switch, with the
exception that only the commander in the stack checks in with Central. For switches supported on Central when
stacking is ON, refer to the Aruba Central Switch Configuration Guide.

Fault finder switch events
Fault finder switch events supported by Aruba Central

EVENT_FF_BAD_DRIVER_NIC

EVENT_FF_BAD_XCVR_NIC

EVENT_FF_BAD_CABLE

EVENT_FF_CABLE_LEN_HOPS

EVENT_FF_LOOP_OVER_BAND

EVENT_FF_BCAST_STORM

EVENT_PPMGR_DMM_SET_FULL_WARN

EVENT_PPMGR_DMM_SET_AUTO_WARN

EVENT_FF_LINKFLAP

interface device-type network-device
Syntax
interface <PORT-LIST> device-type network-device

no interface <PORT-LIST> device-type network-device

Description

Configures the type of device and identifies a port connected with a network infrastructure device (such as switch,
AP, router). The switch will not report the client entries on the port to Central.

The no form of this command removes the configuration of type of the device connected to the ports.

Command context
config

Parameters
PORT-LIST

Specifies the port number for the device.

Usage
[no] device-type { network-device }

Example

Switch(config)# interface 2
device-type       Configures the type of device being connected to the port.

switch(config)# interface 2 device-type 
network-device    Marks a port being connected with a network infra 
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                  device (switch / AP / router).

switch(config)# interface 2 device-type network-device

Switch(config)# show running config
; JL074A Configuration Editor; Created on release #KB.16.04.0000x
; Ver #10:9b.7f.bf.bb.ff.7c.59.fc.7b.ff.ff.fc.ff.ff.3f.ef:81     

hostname "Aruba-3810M-48G-PoEP-1-slot"
module 1 type jl074x
module 2 type jl074y
flexible-module A type JL078A
interface 2
   device-type network-device
   exit
interface 3
   device-type network-device
   exit

HTTP Proxy support with ZTP overview
The Aruba switch connects through Public Cloud or infrastructure to access Aruba Activate and Aruba Central.
The switch can use a combination of the Public and Private networks to access Aruba AirWave, and Aruba
ClearPass. In this case, the switch is visible as an Internet asset that can cause data breaching. Routing
connections through the enterprise proxy servers prevents the data breaching.

The ArubaOS-Switch does not set up an HTTP/SSL connection with the public or private server directly. Instead,
the switch sets up a TCP connection with the proxy server.

If the public server is available and reachable through the proxy server, then the switch connection to the
destination server is successful. After establishing the connection, the proxy server behaves as a Network
Address Translation (NAT) device, in which case, the proxy server forwards the received packets to the intended
destinations.

Limitations:

• HTTPS proxy is not supported.

• Authenticating the HTTP proxy is not supported.

• HTTP proxy support is only for IPv4 endpoints.

Configuring ZTP:

When the switch is provisioned for Central or Controller, switch is managed once it is connected to the public
network. In case the user wants to reach the public network through the proxy, then the IP address of the proxy
server must be present in the switch before initiating the Activate or Central connectivity.

In ZTP mode, the proxy IP address can be received using the DHCP option. The ZTP mode works when the
switch is booted with a default configuration. For the switch to connect to public servers through proxy, the proxy
IP must be known through DHCP. The switch requests an IP address from the primary VLAN.

The proxy IP address is received through a vendor-specific DHCP option. The switch parses and uses the proxy
IP address to connect in ZTP mode. Aruba switches reserve suboption -148 under DHCP vendor-specific option
43 for configuring proxy URL.

After the switch is out of ZTP mode, the proxy IP address if configured through CLI takes precedence. Otherwise,
the Aruba OS switch may use the DHCP received proxy IP address for connectivity.

e Proxy Configuration
When configuring the proxy server, the following applications will be taking the proxy route to reach the
destination. You can configure the proxy server as indicated in DHCP or proxy server command.

336 Aruba 2930F / 2930M Management and Configuration Guide
for ArubaOS-Switch 16.08

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 6933



• Aruba AirWave

• Aruba Activate

• Firmware download through MNP

• Aruba ClearPass connectivity

• Aruba Central connectivity

• TR69 support

Support for Aruba AirWave

AirWave is used to manage the ArubaOS-Switches and its communication to the switch is over HTTPS. When
AirWave is deployed with Aruba controller, an IPsec tunnel is created between the switch and the controller. All
the communication between the switch and AirWave occurs through the tunnel. In this case, the proxy is
bypassed implicitly.

AirWave establishes ICMP, SNMP, and SSH connections to the switch for switch management. Since AirWave
does not have the visibility for the switch IP address, the ICMP, SNMP, and SSH connections will not be initiated
to the switch. So reverse NAT functionality must be enabled for ensuring these packets reach the switch. If
AirWave must work without proxy, then AirWave IP is bypassed explicitly.

Support for Aruba ClearPass

For downloading a user role from ClearPass, switch initiates HTTPS connection with ClearPass. If the proxy is
configured, proxy server is used to reach ClearPass. When ClearPass is deployed with Aruba controller,
ClearPass must be explicitly exempted from proxy. Add the ClearPass IP address in the exception list of the proxy
as the communication happens through the IPsec tunnel or normally.

Proxy Configuration using windows DHCP server

In the ZTP provisioning, you can push the Proxy server and exception configurations through a Windows DHCP
server using DHCP option 148.

Procedure

1. Add a new DHCP Server role. Navigate to Server Manager > Roles > DHCP sever > domain DHCP Server
> IPv4. In the master pane of the Server Manager window, click IPv4 and select Define Vendor classes.
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2. To get vendor-specific value of a switch, go to switch command prompt and enter show dhcp client
vendor-specific command. Vendor class identifier for the switch (VCI) appears as follows:

Switch# show dhcp client vendor-specific
Vendor Class Id = J9854A 2530-24G-PoE+-2SFP+ Switch
Processing of Vendor Specific Configuration is enabled.

3. Add Displayed name and Description for the New Vendor Class in the ASCII field, add J9854A
2530-24G-PoE+-2SFP+ Switch value exactly obtained from the switch, otherwise the option may not work.
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4. Right-click IPv4 and select Set Predefined Options. Select option class as the newly defined vendor class,
click ADD and enter the following information for Proxy details:

a. Name - Proxy

b. Data Type - String

c. Code - 148

d. Description - Proxy details.
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Now the new vendor class will have new suboption with code 148. Next is to add these vendor class and
suboptions to the scope. To add proxy server details to scope, navigate to Server Manager and select Server
Options in the IPv4 window.

5. Right click server options and select Configure options. Go to Advanced tab, select the vendor class from
the menu as the newly defined class. New suboptions that are added appears.

Check 148 and add Proxy details in string value field, in the format as mentioned:

<http://web-proxy.in.ABCcorp.net:8080> or <http://192.168.50.18:3128>

Check 144 and add configuration filename in string value field (optional).
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6. Click Apply and OK and the proxy option is added in the Server options.

7. Now restart the DHCP service and download new DHCP attributes in the switch, you can check that the proxy
details are correctly downloaded in the switch using the show proxy config command.
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proxy server
Syntax
proxy server <http://<ip-addr/FQDN>:port number>

no proxy server

Description

Configures the URL/IP address to reach the proxy server. Provide the correct proxy port number along with the
URL/IP address. Port number must be in the range of 1024 to 65535. HTTPS proxy server is not supported.

The no form of this command removes the proxy server.

Command context
config

Parameters
url:port number

Specifies the URL address with port number for the proxy server.

Parameters
ip-addr:port number

Specifies the IP address with port number for the proxy server.

Example

switch(config)# proxy server "http://web-proxy.au.abccorp.net:3128"
switch(config)# proxy server "http://192.168.0.6:8080"

proxy exception ip | host
Syntax
proxy exception ip | host {ip-addr/mask-length | hostname} 

no proxy exception ip | host {ip-addr/mask-length | hostname}

Description

Configures an IPv4 address/mask length and URL to the list of IP address and host, which can be reached
without the HTTP proxy server.

The no form of this command removes the proxy exception for the specified entry (IPv4 address/host name).

Command context
config

Parameters
ip-addr/mask-length | hostname

Specifies IPv4 address/mask length and host name.
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Example

switch(config)# proxy exception ip 192.168.0.10/12
switch(config)# proxy exception host "http://web-proxy.au.abdcorp.net:3128"

show proxy config
Syntax
show proxy config

Description

Shows the proxy configuration.

Command context
config

Examples

switch(config)# show proxy config

 Http Proxy Configuration details

  Server URL           : http://web-proxy.au.abccorp.net:3128

 Manually configured exceptions

  No      Exception
  ------- -----------------------------------------
  1       192.168.0.10/12
  2       http://web-proxy.au.abdcorp.net:3128

 Automatically added exceptions

  No      Exception
  ------- -----------------------------------------
        1                            2.0.0.9

NOTE: On configuring IPsec tunnel, Airwave IP is automatically added as an exception in the switch.
The IPsec tunnel is configured directly over the network bypassing the HTTP proxy server.
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Overview
The switches support several methods for transferring files to and from a physically connected device or via the
network, including TFTP and Xmodem. This appendix explains how to download new switch software, upload or
download switch configuration files and software images, and upload command files for configuring ACLs.

Downloading switch software
Switch periodically provides switch software updates through the Switch Networking website. For more
information, see the support and warranty booklet shipped with the switch, or visit http://www.hpe.com/
networking and click on software updates.

NOTE: This manual uses the terms switch software and software image to refer to the
downloadable software files the switch uses to operate its networking features. Other terms
sometimes include Operating System, or OS.

General software download rules
• Switch software that you download via the menu interface always goes to primary flash.

• After a software download, you must reboot the switch to implement the new software. Until a reboot occurs,
the switch continues to run on the software it was using before the download.

NOTE:

Downloading new switch software does not change the current switch configuration. The switch
configuration is contained in separate files that can also be transferred. See Transferring switch
configurations on page 358.

In most cases, if a power failure or other cause interrupts a flash image download, the switch reboots
with the image previously stored in primary flash. In the unlikely event that the primary image is
corrupted (which may occur if a download is interrupted by a power failure), the switch goes into boot
ROM mode. In this case, use the boot ROM console to download a new image to primary flash.

Using TFTP to download software from a server
This procedure assumes that:

• A software version for the switch has been stored on a TFTP server accessible to the switch. (The software file
is typically available from the Switch Networking website at http://www.hpe.com/networking.)

• The switch is properly connected to your network and has already been configured with a compatible IP
address and subnet mask.

• The TFTP server is accessible to the switch via IP.

Before you use the procedure, do the following:
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• Obtain the IP address of the TFTP server in which the software file has been stored.

• If VLANs are configured on the switch, determine the name of the VLAN in which the TFTP server is operating.

• Determine the name of the software file stored in the TFTP server for the switch (For example, E0820.swi).

NOTE: If your TFTP server is a UNIX workstation, ensure that the case (upper or lower) that you
specify for the filename is the same case as the characters in the software filenames on the server.

Troubleshooting TFTP download failures

Cause

When using the menu interface, if a TFTP download fails, the Download OS (Operating System, or software)
screen indicates the failure as seen in the following figure.

Figure 35: Example: of message for download failure

Some of the causes of download failures include:

• Incorrect or unreachable address specified for the TFTP Server parameter. This may include network
problems.

• Incorrect VLAN.

• Incorrect name specified for the Remote File Name parameter, or the specified file cannot be found on the
TFTP server. This can also occur if the TFTP server is a UNIX machine and the case (upper or lower) for the
filename on the server does not match the case for the filename entered for the Remote File Name parameter
in the Download OS (Operating System, or software) screen.

• One or more of the switch's IP configuration parameters are incorrect.

• For a UNIX TFTP server, the file permissions for the software file do not allow the file to be copied.

• Another console session (through either a direct connection to a terminal device or through Telnet) was
already running when you started the session in which the download was attempted.

To find more information on the cause of a download failure:
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• Examine the messages in the switch's Event Log by executing the show log tftp command from the CLI.

• For descriptions of individual Event Log messages, see the latest version of the event log message reference
guide for your switch, available on the Switch website. (See "Getting Documentation From the Web".)

NOTE: If an error occurs in which normal switch operation cannot be restored, the switch
automatically reboots itself, and an appropriate message is displayed after the reboot.

Downloading from a server to flash using TFTP (CLI)
Syntax:

copy tftp flash <ip-address> <remote-file> [<primary | secondary>]
Automatically downloads a switch software file to primary or secondary flash. If you do not specify the flash
destination, the TFTP download defaults to primary flash.

Example:

To download a switch software file named k0800.swi from a TFTP server with the IP address of 10.28.227.103 to
primary flash:

Procedure

1. Execute copy as shown below:
The command to download an OS (switch software)

switch# copy tftp flash 10.28.227.103 k0800.swi
The primary OS Image will be deleted, continue [y/n]? y 1
01431K 2

• 1This message means that the image you want to upload will replace the image currently in primary flash.

• 2Dynamic counter continually displays the number of bytes transferred.

When the switch finishes downloading the software file from the server, it displays this progress message:

Validating and Writing System Software to FLASH ...
2. When the download finishes, you must reboot the switch to implement the newly downloaded software image.

To do so, use one of the following commands:

Syntax:

boot system flash {<primary | secondary>}
Boots from the selected flash.

Syntax:

reload
Boots from the flash image and startup-config file. A switch covered in this guide (with multiple configuration
files), also uses the current startup-config file.
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For more information on these commands, see "Rebooting the Switch" in the basic operation guide for your
switch.

3. To confirm that the software downloaded correctly, execute show system and check the Firmware revision
line.

For information on primary and secondary flash memory and the boot commands, see "Using Primary and
Secondary Flash Image Options" in the basic operation guide for your switch.

NOTE: If you use auto-tftp to download a new image in a redundant management system, the
active management module downloads the new image to both the active and standby modules.
Rebooting after the auto-tftp process completes reboots the entire system.

Enabling TFTP (CLI)
TFTP is enabled by default on the switch. If TFTP operation has been disabled, you can re-enable it by specifying
TFTP client or server functionality with the tftp [client|server] command at the global configuration level.

Syntax:

[no] tftp [client | server]
Disables/re-enables TFTP for client or server functionality so that the switch can:

• Use TFTP client functionality to access TFTP servers in the network to receive downloaded files.

• Use TFTP server functionality to upload files to other devices on the network.

NOTE: Usage notes

To disable all TFTP client or server operation on the switch except for the auto-TFTP feature, enter
the no tftp [client|server] command.

When IP SSH file transfer is used to enable SCP and SFTP functionality on the switch, this disables
TFTP client and server functionality. Once ip ssh file transfer is enabled, TFTP and auto-TFTP
cannot be re-enabled from the CLI.

When TFTP is disabled, instances of TFTP in the CLI copy command and the Menu interface
"Download OS" screen become unavailable.

The no tftp [client|server] command does not disable auto-TFTP operation. To disable an
auto-TFTP command configured on the switch, use the no auto-tftp command to remove the
command entry from the switch's configuration.

For information on how to configure TFTP file transfers on an IPv6 network, see the "IPv6
Management Features" in the IPv6 configuration guide for your switch.

Configuring the switch to download software automatically from a TFTP server using
auto-TFTP (CLI)
The auto-tftp command lets you configure the switch to download software automatically from a TFTP server.

At switch startup, the auto-TFTP feature automatically downloads a specified software image to the switch from a
specified TFTP server and then reboots the switch. To implement the process, you must first reboot the switch
using one of the following methods:
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• Enter the boot system flash primary command in the CLI.

• With the default flash boot image set to primary flash (the default), enter the boot or the reload command, or
cycle the power to the switch. (To reset the boot image to primary flash, use boot set-default flash
primary.)

Syntax:

auto-tftp <ip-addr> <filename>
By default, auto-TFTP is disabled. This command configures the switch to automatically download the specified
software file from the TFTP server at the specified IP address. The file is downloaded into primary flash memory
at switch startup; the switch then automatically reboots from primary flash.

NOTE: To enable auto-TFTP to copy a software image to primary flash memory, the version number
of the downloaded software file (For example, XX_14_01.swi) must be different from the version
number currently in the primary flash image.

The current TFTP client status (enabled or disabled) does not affect auto-TFTP operation. (See 
Enabling TFTP (CLI) on page 347.)

Completion of the auto-TFTP process may require several minutes while the switch executes the
TFTP transfer to primary flash and then reboots again.

The no form of the command disables auto-TFTP operation by deleting the auto-tftp entry from the startup
configuration.

The no auto-tftp command does not affect the current TFTP-enabled configuration on the switch. However,
entering the ip ssh filetransfer command automatically disables both auto-tftp and tftp operation.

Use USB to transfer files to and from the switch
The switch's USB port (labeled as Aux Port) allows the use of a USB flash drive for copying configuration files to
and from the switch.

Operating rules and restrictions:

• Unformatted USB flash drives must first be formatted on a PC (Windows FAT format.) For devices with multiple
partitions, only the first partition is supported. Devices with secure partitions are not supported.

• If they already exist on the device, subdirectories are supported. When specifying a filename , you must enter
either the individual file name (if at the root) or the full path name (for example, /subdir/filename.)

• To view the contents of a USB flash drive, use the dir command. This lists all files and directories at the root.
To view the contents of a directory, you must specify the subdirectory name (that is, dir subdirectory.)

• The USB port supports a single USB device. USB hubs to add more ports are not supported.

NOTE: Some USB flash drives may not be supported on your switch. Consult the latest Release
Notes for information on supported devices.

Using SCP and SFTP
For some situations you may want to use a secure method to issue commands or copy files to the switch. By
opening a secure, encrypted SSH session and enabling ip ssh file transfer, you can then use a third-party
software application to take advantage of SCP and SFTP. SCP and SFTP provide a secure alternative to TFTP
for transferring information that may be sensitive (like switch configuration files) to and from the switch.
Essentially, you are creating a secure SSH tunnel as a way to transfer files with SFTP and SCP channels.
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Once you have configured your switch to enable secure file transfers with SCP and SFTP, files can be copied to
or from the switch in a secure (encrypted) environment and TFTP is no longer necessary.

To use these commands, you must install on the administrator workstation a third-party application software client
that supports the SFTP and/or SCP functions. Some examples of software that supports SFTP and SCP are
PuTTY, Open SSH, WinSCP, and SSH Secure Shell. Most of these are freeware and may be downloaded without
cost or licensing from the internet. There are differences in the way these clients work, so be sure you also
download the documentation.

As described earlier in this chapter you can use a TFTP client on the administrator workstation to update software
images. This is a plain-text mechanism that connects to a standalone TFTP server or another switch acting as a
TFTP server to obtain the software image files. Using SCP and SFTP allows you to maintain your switches with
greater security. You can also roll out new software images with automated scripts that make it easier to upgrade
multiple switches simultaneously and securely.

SFTP is unrelated to FTP, although there are some functional similarities. Once you set up an SFTP session
through an SSH tunnel, some of the commands are the same as FTP commands. Certain commands are not
allowed by the SFTP server on the switch, such as those that create files or folders. If you try to issue commands
such as create or remove using SFTP, the switch server returns an error message.

You can use SFTP just as you would TFTP to transfer files to and from the switch, but with SFTP, your file
transfers are encrypted and require authentication, so they are more secure than they would be using TFTP.
SFTP works only with SSH version 2 (SSH v2).

NOTE: SFTP over SSH version 1 (SSH v1) is not supported. A request from either the client or the
switch (or both) using SSH v1 generates an error message. The actual text of the error message
differs, depending on the client software in use. Some examples are:

Protocol major versions differ: 2 vs. 1
Connection closed

Protocol major versions differ: 1 vs. 2
Connection closed

Received disconnect from <ip-addr> : /usr/local/libexec/
sftp-server: command not supported
Connection closed

SCP is an implementation of the BSD rcp (Berkeley UNIX remote copy) command tunneled through an SSH
connection.

SCP is used to copy files to and from the switch when security is required. SCP works with both SSH v1 and SSH
v2. Be aware that the most third-party software application clients that support SCP use SSHv1.

The general process for using SCP and SFTP involves three steps:

Procedure

1. Open an SSH tunnel between your computer and the switch if you have not already done so.

(This step assumes that you have already set up SSH on the switch.)

2. Execute ip ssh filetransfer to enable secure file transfer.

3. Use a third-party client application for SCP and SFTP commands.

Enabling SCP and SFTP
For more information about secure copy and SFTP, see Using SCP and SFTP on page 348.
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Procedure

1. Open an SSH session as you normally would to establish a secure encrypted tunnel between your computer
and the switch.

For more detailed directions on how to open an SSH session, see "Configuring secure shell (SSH)" in the
access security guide for your switch. Please note that this is a one-time procedure for new switches or
connections. If you have already done it once you should not need to do it a second time.

2. To enable secure file transfer on the switch (once you have an SSH session established between the switch
and your computer), open a terminal window and enter the following command:

switch(config)# ip ssh filetransfer

For information on disabling TFTP and auto-TFTP, see Disabling TFTP and auto-TFTP for enhanced security
on page 350.

Disabling TFTP and auto-TFTP for enhanced security
Using the ip ssh filetransfer command to enable SFTP automatically disables TFTP and auto-TFTP (if
either or both are enabled), as shown below.

Switch configuration with SFTP enabled

switch(config)# ip ssh filetransfer
Tftp and auto-tftp have been disabled. 1
switch(config)# sho run

Running configuration:

; J9091A Configuration Editor; Created on release #xx.15.xx

hostname "Switch"
module 1 type J8702A
module 2 type J702A
vlan 1
   name "DEFAULT_VLAN"
   untagged A1-A24,B1-B24
   ip address 10.28.234.176 255.255.240.0
   exit
ip ssh filetransfer 2
no tftp-enable
password manager
password operator
1 Enabling SFTP automatically disables TFTP and auto-tftp and displays this message.
2 Viewing the configuration shows that SFTP is enabled and TFTP is disabled.

If you enable SFTP and then later disable it, TFTP and auto-TFTP remain disabled unless they are explicitly re-
enabled.

Operating rules are:

• The TFTP feature is enabled by default, and can be enabled or disabled through the CLI or an SNMP
application. Auto-TFTP is disabled by default and must be configured through the CLI.

• While SFTP is enabled, TFTP and auto-TFTP cannot be enabled from the CLI. Attempting to enable either
non-secure TFTP option while SFTP is enabled produces one of the following messages in the CLI:
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SFTP must be disabled before enabling tftp.

SFTP must be disabled before enabling auto-tftp.
Similarly, while SFTP is enabled, TFTP cannot be enabled using an SNMP management application.
Attempting to do so generates an "inconsistent value" message. (An SNMP management application cannot
be used to enable or disable auto-TFTP.)

• To enable SFTP by using an SNMP management application, you must first disable TFTP and, if configured,
auto-TFTP on the switch. You can use either an SNMP application or the CLI to disable TFTP, but you must
use the CLI to disable auto-TFTP.

Enabling SSH V2 (required for SFTP)

switch(config)# ip ssh version 2

NOTE: As a matter of policy, administrators should not enable the SSH V1-only or the SSH V1-or-V2
advertisement modes. SSHv1 is supported on only some legacy switches.

Confirming that SSH is enabled

switch(config)# show ip ssh
Once you have confirmed that you have enabled an SSH session (with the show ip ssh command), enter ip
ssh filetransfer so that SCP and/or SFTP can run. You can then open your third-party software client
application to begin using the SCP or SFTP commands to safely transfer files or issue commands to the switch.

NOTE:

Any attempts to use SCP or SFTP without using ip ssh filetransfer cause the SCP or SFTP
session to fail. Depending on the client software in use, you will receive an error message on the
originating console, for Example:

IP file transfer not enabled on the switch
Disabling secure file transfer

switch(config)# no ip ssh filetransfer

Authentication
Switch memory allows up to ten public keys. This means the authentication and encryption keys you use for your
third-party client SCP/SFTP software can differ from the keys you use for the SSH session, even though both
SCP and SFTP use a secure SSH tunnel.

NOTE:

SSH authentication is mutually exclusive with RADIUS servers.

Some clients, such as PSCP (PuTTY SCP), automatically compare switch host keys for you. Other clients require
you to manually copy and paste keys to the $HOME/.ssh/known_hosts file. Whatever SCP/SFTP software tool
you use, after installing the client software you must verify that the switch host keys are available to the client.

Because the third-party software utilities you may use for SCP/SFTP vary, you should refer to the documentation
provided with the utility you select before performing this process.
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SCP/SFTP operating notes
• Any attempts to use SCP or SFTP without using ip ssh filetransfer will cause the SCP or SFTP session to fail.

Depending on the client software in use, you will receive an error message on the originating console, for
Example:

IP file transfer not enabled on the switch
• There is a delay when SFTP is copying an image onto the switch, and although the command prompt returns

in a couple of seconds, the switch may take approximately a minute and half writing the image to flash. You
can keep entering the show flash command to see when the copy is complete and the flash is updated. You
can also check the log for an entry similar to the following:

I 01/09/13 16:17:07 00150 update: Primary Image updated.

I 01/09/13 16:13:22 00636 ssh: sftp session from 15.22.22.03
• When an SFTP client connects, the switch provides a file system displaying all of its available files and folders.

No file or directory creation is permitted by the user. Files may be only uploaded or downloaded, according to
the permissions mask. All of the necessary files the switch needs are already in place on the switch. You do
not need to (nor can you) create new files.

• The switch supports one SFTP session or one SCP session at a time.

• All files have read-write permission. Several SFTP commands, such as create or remove, are not allowed
and return an error message. The switch displays the following files:

/
+---cfg
|   running-config
|   startup-config
+---log
|   crash-data
|   crash-data-a
|   crash-data-b 
|   crash-data-c 
|   crash-data-d 
|   crash-data-e            "      "
|   crash-data-f ""
|   crash-data-g
|   crash-data-h            "      "
|   crash-data-I ""
|   crash-data-J ""
|   crash-data-K ""
|   crash-data-L "    "
|   crash-log
|   crash-log-a
|   crash-log-b 
|   crash-log-c 
|   crash-log-d
|   crash-log-e""
|   crash-log-f""
|   crash-log-g
|   crash-log-h" "
|   crash-log-I" "
|   crash-log-J" "
|   crash-log-K" "
|   crash-log-L" "
|   event log
+---os
|   primary
|   secondary
\---ssh
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    +---mgr_keys
    |   authorized_keys
    \---oper_keys
    |   authorized_keys
\---core
|   port_1-24.cor    core-dump for ports 1-24 (stackable switches only)
|   port_25-48.cor   core-dump for ports 25-48 (stackable switches only)

Once you have configured your switch for secure file transfers with SCP and SFTP, files can be copied to or from
the switch in a secure (encrypted) environment and TFTP is no longer necessary.

Troubleshooting SSH, SFTP, and SCP operations

Cause

You can verify secure file transfer operations by checking the switch's event log, or by viewing the error messages
sent by the switch that most SCP and SFTP clients print out on their console.

NOTE: Messages that are sent by the switch to the client depend on the client software in use to
display them on the user console.

Broken SSH connection
If an ssh connection is broken at the wrong moment (for instance, the link goes away or spanning tree brings
down the link), a fatal exception occurs on the switch. If this happens, the switch gracefully exits the session and
produces an Event Log message indicating the cause of failure. The following three examples show the error
messages that may appear in the log, depending on the type of session that is running (SSH, SCP, or SFTP):

ssh: read error Bad file number, session aborted I 01/01/90
00:06:11 00636 ssh: sftp session from ::ffff:10.0.12.35 W
01/01/90 00:06:26 00641 ssh:

sftp read error Bad file number, session aborted I 01/01/90
00:09:54 00637 ssh: scp session from ::ffff:10.0.12.35 W 01/
01/90

ssh: scp read error Bad file number, session aborted

NOTE:

The Bad file number is from the system error value and may differ depending on the cause of
the failure. In the third Example:, the device file to read was closed as the device read was about to
occur.

Attempt to start a session during a flash write
If you attempt to start an SCP (or SFTP) session while a flash write is in progress, the switch does not allow the
SCP or SFTP session to start. Depending on the client software in use, the following error message may appear
on the client console:

Received disconnect from 10.0.12.31: 2: Flash access in
progress

lost connection

Failure to exit from a previous session
This next Example: shows the error message that may appear on the client console if a new SCP (or SFTP)
session is started from a client before the previous client session has been closed (the switch requires
approximately ten seconds to timeout the previous session):
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Received disconnect from 10.0.12.31: 2: Wait for previous
session to complete

lost connection

Attempt to start a second session
The switch supports only one SFTP session or one SCP session at a time. If a second session is initiated (For
example, an SFTP session is running and then an SCP session is attempted), the following error message may
appear on the client console:

Received disconnect from 10.0.12.31: 2: Other SCP/SFTP
session running

lost connection

Using Xmodem to download switch software from a PC or UNIX
workstation
This procedure assumes that:

• The switch is connected via the Console RS-232 port to a PC operating as a terminal. (For information on
connecting a PC as a terminal and running the switch console interface, see the installation and getting started
guide you received with the switch.)

• The switch software is stored on a disk drive in the PC.

• The terminal emulator you are using includes the Xmodem binary transfer feature. (For example, in the
HyperTerminal application included with Windows NT, you would use the Send File option in the Transfer
drop-down menu.)

Downloading to primary or secondary flash using Xmodem and a terminal emulator
(CLI)
Syntax:

copy xmodem flash [<primary | secondary>]
Downloads a software file to primary or secondary flash. If you do not specify the flash destination, the Xmodem
download defaults to primary flash.

Example:

To download a switch software file named E0822.swi from a PC (running a terminal emulator program such as
HyperTerminal) to primary flash:

Procedure

1. Execute the following command in the CLI:

switch# copy xmodem flash
Press 'Enter and start XMODEM on your host...

2. Execute the terminal emulator commands to begin the Xmodem transfer. For example, using HyperTerminal:

a. Click on Transfer, then Send File.

b. Type the file path and name in the Filename field.
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c. In the Protocol field, select Xmodem.
d. Click on the [Send] button.

The download can take several minutes, depending on the baud rate used in the transfer.

3. When the download finishes, you must reboot the switch to implement the newly downloaded software. To do
so, use one of the following commands:
Syntax:

boot system flash {<primary | secondary>}
Reboots from the selected flash

Syntax:

reload
Reboots from the flash image currently in use

For more information on these commands, see “Rebooting the Switches” in the basic operation guide for your
switch.

4. To confirm that the software downloaded correctly:

switch# show system
Check the Firmware revision line. It should show the software version that you downloaded in the preceding
steps.

If you need information on primary/secondary flash memory and the boot commands, see "Using Primary and
Secondary Flash Image Options" in the basic operation guide for your switch.

Switch-to-switch download
You can use TFTP to transfer a software image between two switches of the same series. The CLI enables all
combinations of flash location options.

Downloading the OS from another switch (CLI)
Where two switches in your network belong to the same series, you can download a software image between
them by initiating a copy tftp command from the destination switch. The options for this CLI feature include:

• Copy from primary flash in the source to either primary or secondary in the destination.

• Copy from either primary or secondary flash in the source to either primary or secondary flash in the
destination.

Downloading from primary only (CLI)
Syntax:

copy tftp flash <ip-addr> flash [primary | secondary]
When executed in the destination switch, downloads the software flash in the source switch's primary flash to
either the primary or secondary flash in the destination switch.

If you do not specify either a primary or secondary flash location for the destination, the download automatically
goes to primary flash.

Chapter 11 File Transfers 355

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 6952



To download a software file from primary flash in a switch with an IP address of 10.29.227.103 to the primary flash
in the destination switch, you would execute the following command in the destination switch's CLI:

Switch-to-switch, from primary in source to either flash in destination

switch# copy tftp flash 10.29.227.13 flash
Device will be rebooted, do you want to continue [y/n]? y
00107K 1

1Running Total of Bytes Downloaded

Downloading from either flash in the source switch to either flash in the destination
switch (CLI)
Syntax:

copy tftp flash <ip-addr> {</os/primary> | </os/secondary>} [primary | secondary]
This command (executed in the destination switch) gives you the most options for downloading between switches.
If you do not specify either a primary or secondary flash location for the destination, the download automatically
goes to primary flash.

To download a software file from secondary flash in a switch with an IP address of 10.28.227.103 to the
secondary flash in a destination switch, you would execute the following command in the destination switch's CLI:

Switch-to-switch, from either flash in source to either flash in destination

switch# copy tftp flash 10.29.227.13 flash /os/secondary secondary
Device will be rebooted, do you want to continue [y/n]? y
00184K

Using AirWave to update switch software
AirWave can be used to update switch products. For further information, refer to the ZTP with Airwave network
Management chapter in this manual.

Using IMC to update switch software
IMC includes a software update utility for updating on switch products. For further information, refer to the getting
started guide and the administrator’s guide, provided electronically with the application.

Copying software images
NOTE:

For details on how switch memory operates, including primary and secondary flash, see “Switch
Memory and Configuration” in the basic operation guide for your switch.

TFTP: Copying a software image to a remote host (CLI)
Syntax:

copy flash tftp <ip-addr> <filename>
Copies the primary flash image to a TFTP server.

Example:
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To copy the primary flash to a TFTP server having an IP address of 10.28.227.105:

switch# copy flash tftp 10.28.227.105 k0800.swi
where k0800.swi is the filename given to the flash image being copied.

Xmodem: Copying a software image from the switch to a serially connected
PC or UNIX workstation (CLI)
To use this method, the switch must be connected via the serial port to a PC or UNIX workstation.

Syntax:

copy flash xmodem {[<pc] | unix>}
Uses Xmodem to copy a designated configuration file from the switch to a PC or UNIX workstation.

Example:

To copy the primary flash image to a serially connected PC:

Procedure

1. Execute the following command:

switch# copy xmodem flash
Press 'Enter' and start XMODEM on your host...

2. After you see the above prompt, press [Enter].

3. Execute the terminal emulator commands to begin the file transfer.

Copying diagnostic data

copy command-log
Syntax
copy command-log {sftp | tftp | usb | xmodem}
Description

This command copies the Command Log content to a remote host or to a serially-connected PC or UNIX
workstation.

• Use the sftp option to copy data to an SFTP server.

• Use the tftp option to copy data to a TFTP server.

• Use the usb option to copy data to a USB flash drive.

• Use the xmodem option to copy data to the console using XMODEM.

copy event-log
Syntax
copy event-log [tftp <IP-ADDRESS> <FILEPATH_FILENAME> [oobm]] [usb <FILENAME>] [xmodem <FILENAME>]
        

Description
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These commands copy the Event Log content to a remote host, attached USB device, or to a serially connected
PC or UNIX workstation.

Parameters and options
oobm

For switches that have a separate OOBM port, the oobm parameter specifies that the transfer is through the
OOBM interface. If this parameter is not specified, the transfer is through the data interface. The oobm
parameter is not available on switches that do not have a separate OOBM port.

Copy the event log to a PC connected to the switch

Figure 36: Sending event log content to a file on an attached PC

Transferring switch configurations
Using the CLI commands described in the section beginning with TFTP: Copying a configuration file to a
remote host (CLI) on page 358, you can copy switch configurations to and from a switch, or copy a software
image to configure or replace an ACL in the switch configuration.

NOTE:

For greater security, you can perform all TFTP operations using SFTP, as described in the section 
Using SCP and SFTP on page 348.

You can also use the include-credentials command to save passwords, secret keys, and other
security credentials in the running config file. For more information, see the section on "Saving
Security Credentials in a Config File" in the access security guide for your switch.

TFTP: Copying a configuration file to a remote host (CLI)
Syntax:

copy {<startup-config | running-config>} tftp < ip-addr > < remote-file > [pc | unix]

copy config <filename> tftp <ip-addr> <remote-file> [pc | unix]
This command can copy a designated config file in the switch to a TFTP server. For more information, see
"Multiple Configuration Files" in the basic operation guide for your switch.

Example:

To upload the current startup configuration to a file named sw8200 in the configs directory on drive "d" in a TFTP
server having an IP address of 10.28.227.105:

switch# copy startup-config tftp 10.28.227.105
   d:\configs\sw8200
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TFTP: Copying a configuration file from a remote host (CLI)
Syntax:

copy tftp {<startup-config | running-config> < ip-address > < remote-file >} [pc | unix]

copy tftp config <filename> <ip-address> <remote-file> [pc | unix]
This command can copy a configuration from a remote host to a designated config file in the switch. For more
information, see "Multiple Configuration Files" in the basic operation guide for your switch.

For more information on flash image use, see "Using Primary and Secondary Flash Image Options" in the basic
operation guide for your switch.

Example:

To download a configuration file named sw8200 in the configs directory on drive "d" in a remote host having an
IP address of 10.28.227.105:

switch# copy tftp startup-config 10.28.227.105
   d:\configs\sw8200

TFTP: Copying a customized command file to a switch (CLI)
Using the copy tftp command with the show-tech option provides the ability to copy a customized command
file to the switch. When the show tech custom command is executed, the commands in the custom file are
executed instead of the hard-coded list of commands. If no custom file is found, the current hard-coded list is
executed. This list contains commands to display data, such as the image stamp, running configuration, boot
history, port settings, and so on.

Syntax:

copy tftp show-tech <ipv4 or ipv6 address> <filename>
Copies a customized command file to the switch (see Using the copy tftp show-tech command to upload a
customized command file on page 359).

Using the copy tftp show-tech command to upload a customized command file

switch(config)# copy tftp show-tech 10.10.10.3 commandfile1
Syntax:

show tech custom
Executes the commands found in a custom file instead of the hard-coded list.

NOTE:

Exit the global config mode (if needed) before executing show tech commands.

You can include show tech commands in the custom file, with the exception of show tech custom. For
example, you can include the command show tech all.

If no custom file is found, a message displays stating "No SHOW-TECH file found." (No custom file was uploaded
with the copy tftp show-tech command.)
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The show tech custom command

switch# show tech custom
No SHOW-TECH file found.

USB: Copying a configuration file to a USB device
Syntax:
copy startup-config usb <FILENAME>
This command can copy a designated config file in the switch to a USB device.

Example:

MyConfig is the name given to the configuration file that you copy from the switch to the USB device.

switch# copy startup-config usb MyConfig

USB: Copying a configuration file from a USB device
Syntax:
copy usb startup-config <FILENAME>
Description:

Copies a configuration file from a USB device to the startup configuration file on the switch. To execute the
command, you must know the name of the file to copy.

Example:

MyConfig is the name given to the configuration file that you copy from the switch to the USB device.

switch# copy usb startup-config MyConfig

Xmodem: Copying a configuration file to a serially connected PC or UNIX
workstation (CLI)
To use this method, the switch must be connected via the serial port to a PC or UNIX workstation. You will need
to:

• Determine a filename to use

• Know the directory path you will use to store the configuration file.

Syntax:

copy {<startup-config | running-config>} xmodem {<pc | unix>}

copy config <filename> xmodem {<pc | unix>}
Uses Xmodem to copy a designated configuration file from the switch to a PC or UNIX workstation. For more
information, see "Multiple Configuration Files" in the basic operation guide for your switch.

Example:

To copy a configuration file to a PC serially connected to the switch:

1. Determine the file name and directory location on the PC.

2. Execute the following command:
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switch# copy startup-config xmodem pc
Press 'Enter' and start XMODEM on your host...

3. After you see the above prompt, press [Enter].

4. Execute the terminal emulator commands to begin the file transfer.

Xmodem: Copying a configuration file from a serially connected PC or
UNIX workstation (CLI)
To use this method, the switch must be connected via the serial port to a PC or UNIX workstation on which is
stored the configuration file you want to copy. To complete the copying, you need to know the name of the file to
copy and the drive and directory location of the file.

Syntax:

copy xmodem startup-config {<pc | unix>}

copy xmodem config <filename> < {pc | unix>}
Copies a configuration file from a serially connected PC or UNIX workstation to a designated configuration file on
the switch.

For more information, see "Multiple Configuration Files" in the basic operation guide for your switch.

Example:

To copy a configuration file from a PC serially connected to the switch:

Procedure

1. Execute the following command:

switch# copy xmodem startup-config pc
Device will be rebooted, do you want to continue [y/n]? y
Press 'Enter' and start XMODEM on your host...

2. After you see the above prompt, press [Enter].

3. Execute the terminal emulator commands to begin the file transfer.

4. When the download finishes, you must reboot the switch to implement the newly downloaded software. To do
so, use one of the following commands:

Syntax:

boot system flash [primary | secondary]

boot system flash [config < filename >]
Switches boot from the designated configuration file. For more information, see "Multiple Configuration Files"
in the basic operation guide for your switch.

Syntax:

reload

Reboots from the flash image currently in use.
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(For more on these commands, see "Rebooting the Switch" in the basic operation guide for your switch.)

Transferring ACL command files
This section describes how to upload and execute a command file to the switch for configuring or replacing an
ACL in the switch configuration. Such files should contain only access control entry (ACE) commands. For more
on this general topic, including an Example: of an ACL command file created offline, see the section "Editing
ACLs and Creating an ACL Offline" in the "Access Control Lists (ACLs)" of the latest access security guide for
your switch.

TFTP: Uploading an ACL command file from a TFTP server (CLI)
Syntax:

copy tftp command-file <ip-addr> <filename.txt> {<unix | pc>}
Copies and executes the named text file from the specified TFTP server address and executes the ACL
commands in the file.

<ip-addr> The IP address of a TFTP server available to the switch

<filename.txt> A text file containing ACL commands and stored in the TFTP directory of the server
identified by ip-addr

{<unix | pc>} The type of workstation used for serial, Telnet, or SSH access to the switch CLI

Depending on the ACL commands used, this action does one of the following in the running-config file:

• Creates a new ACL.

• Replaces an existing ACL. (See "Creating an ACL Offline" in the "Access Control Lists (ACLs)" in the latest
access security guide for your switch.)

• Adds to an existing ACL

Example:

Suppose you:

• Created an ACL command file named vlan10_in.txt to update an existing ACL.

• Copied the file to a TFTP server at 18.38.124.16.

Using a PC workstation, you then execute the following from the CLI to upload the file to the switch and
implement the ACL commands it contains:

switch(config)# copy tftp command-file 18.38.124.16
vlan10_in.txt pc
The switch displays this message:

Running configuration may change, do you want to continue
[y/n]?
To continue with the upload, press the [Y] key. To abort the upload, press the [N] key. Note that if the switch
detects an illegal (non-ACL) command in the file, it bypasses the illegal command, displays a notice (as shown in 
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Figure 37: Using the copy command to download and configure an ACL on page 363), and continues to
implement the remaining ACL commands in the file.

Figure 37: Using the copy command to download and configure an ACL

switch(config)# copy tftp command-file 10.38.124.18 v1an10_in.txt pc
Running configuration may change, do you want to continue [y/n]? y
  1. ip access-list extended "155"
  2. deny tcp 0.0.0.0 255.255.255.255 10.10.10.2 0.0.0.0 eq 23 1og
  3. permit ip 0.0.0.0 255.255.255.255 0.0.0.0 255.255.255.255
  4. show running
Command files are limited to access-list commands. 1
  5. exit
Switch(config)# show running 2
Running configuration:

; J9091A Configuration Editor; Created on release #W.15.05.0000x
; Ver #01:01:00

hostname "Switch"
cdp run
ip default-gateway 10.38.248.1
logging 10.38.227.2
snmp-server community "public" unrestricted
ip access-list extended "155"
deny tcp 0.0.0.0 255.255.255.255 10.10.10.2 0.0.0.0 eq 23 1og
permit ip 0.0.0.0 255.255.255.255 0.0.0.0 255.255.255.255
exit
1This message indicates that the show running command just above it is not an ACL command and will be
ignored by the switch.
2Manually executing the show running from the CLI indicates that the file was implemented, creating ACL 155
in the switch’s running configuration.

Xmodem: Uploading an ACL command file from a serially connected PC or
UNIX workstation (CLI)
Syntax:

copy xmodem command-file {<unix | pc>}
Uses Xmodem to copy and execute an ACL command from a PC or UNIX workstation. Depending on the ACL
commands used, this action does one of the following in the running-config file:

• Creates a new ACL.

• Replaces an existing ACL. (See "Creating an ACL Offline" in the "Access Control Lists (ACLs)" in the latest
access security guide for your switch.)

• Adds to an existing ACL.

Single copy command
When a switch crashes, five files relating to the crash; core-dump, crash-data, crash-log, fdr-log, and event-log
are created and should be copied for review. All five files (core-dump, crash-data, crash-log, fdr-log, and event-
log) should be copied to a destination specified under a directory by file name.
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TFTP

A destination directory and files can be created for all crash files (core-dump, crash-data, crash-log, fdr-log,
and event-log) on an TFTP server (with write permissions).

SFTP

Files are auto created on the SFTP server as a secured transfer. The destination directories however can be
manually created on the server.

NOTE: Specified directories can be used for the TFTP/SFTP transfers in the copy command. If the
directory is specified, all files will be copied under one directory, otherwise all files will be copied to
the TFTP/SFTP server home directory. It is mandatory to specify the directory name.

Single copy command
Syntax

copy source destination options
Copy data files to and from the switch.

Source

Specify the source of data using any of the following destinations.

Destination Operation note

Flash n/a

SFTP For transfer of crash-files via SFTP, the destination directory must exist on the SFTP
server with write permissions.

File creation is not mandatory as files are automatically created with the chassis serial
number suffix to the filename when using SFTP.

TFTP For transfer of crash-files via TFTP, the destination directory along with the file names
(core-dump, crash-data, crash-log, fdr-log, and event-log) must exist on the TFTP
server with write permissions.

Xmodem n/a

Data Files

Specify the data file to be copied from the source.

Data file Operation note

command-output
command

Specify a command to copy output.

When using command-output, place the desired CLI command in double-quotes. For
example: "show system".

config file-
name

Copy named configuration file.

The file-name option is the source configuration file being copied.

Table Continued
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Data file Operation note

core-dump Copy core-dump file from flash.

crash-data Copy the switch crash-data file.

crash-log a|b|
c|d|e|f|g|h|
master

Copy the switch crash-log file.

crash-files Copy core-dump, crash-data, crash-log, fdr-log, and event-log files to an SFTP/TFTP
server, or xmodem terminal.

When using the crash-files option, the destination directory alone must be
specified as the destination path. Specifying the file names is not mandatory.

default-config Copy custom default-config file.

event-log Copy event-log file.

fdr-log Copy FDR-og file from the switch to an SFTP/TFTP server or xmodem terminal.

flash Copy the switch system image file.

SFTP server Copy data from a SFTP server.

startup-config Copy in-flash configuration file.

ssh-client-
known-hosts Copy the known hosts file.

ssh-server-
pub-key Copy the switch's SSH server public key.

running-config Copy running configuration file.

TFTP Copy data from a TFTP server.

xmodem Use xmodem on the terminal as the data source.

Destination

Specify the copy target.

Destination

SFTP

TFTP

USB (available only on the 2930M Switch Series)

xmodem
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Destination

SFTP

TFTP

xmodem

Data Files

Specify the data file name at the target.

Data file

command file
config
default-config
flash
pub-key-file
show-tech
startup-config
ssh-client-key
ssh-client-known-hosts

Options

Option Operation note Requirement

append Add the keys for operator access. n/a

directory Directory name to upload. Required for TFTP and SFTP transfers.

filename File-name to upload/download. Required for TFTP and SFTP transfers.

hostname Hostname of the TFTP, SFTP
server.

Required for TFTP, SFTP transfers.

IPv4 address TFTP, SFTP server IPv4 address. Required for TFTP, SFTP transfers.

IPv6 address TFTP, SFTP server IPv6 address. Required for TFTP, SFTP transfers.

manager Replace the keys for manager
access; follow with the append
option to add the keys.

n/a
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Option Operation note Requirement

operator Replace the keys for operator
access (default); follow with the
append option to add the keys.

n/a

pc n/a

unix n/a

Multiple management switches
Syntax

copy crash-files
interfaces

Copy interfaces crash files.

management

Copy management crash files.

Destination

SFTP TFTP Xmodem

Slot-ID X X X

MM-active X X X

MM-standby X X X

Stacking switches
Syntax

copy crash-files
member

Copy stack member crash files.

Options for member

Option Destination

SFTP TFTP USB xmodem

management X X X X

interfaces X X X X
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Standalone switches
Syntax

copy crash-files
Options

Option Destination

SFTP TFTP xmodem

management X X X

interfaces X X X

Crash file options
Syntax

copy crash-files crash-file-options host-name-str | ip-addr | ipv6-addrsftp dirname-str
Options

host-name-str

Specify hostname of the SFTP server.

ip-addr

Specify SFTP server IPv4 address.

ipv6–addr

Specify SFTP server IPv6 address.

user

Specify the username on the remote system.

username@ip-str

Specify the username along with remote system. Information (hostname, IPv4 or IPv6 address).

dirname-str

Specify the destination directory name.

Destination options

management

Copy management crash files.

Flight Data Recorder (FDR)
The Flight Data Recorder (FDR) log collects information that is "interesting" when the switch is not performing
correctly, but has not crashed. Runtime logs are written to FDR memory while the switch is running and crashtime
logs are collected and stored in the FDR buffer during a switch crash.

Syntax:

copy fdr-log [[slot < slot-list >] | [mm-active [[current] | [previous]]] | [mm-
standby] | [all]] tftp [[< hostname] | [ip-addr >]] <filename>
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Copies fdr-log files to a user-specified file.

all
Copies all the log files from both management modules and all slots.

mm-active
Copies the active management module's log.

mm-standby
Copies the standby management module's log.

slot
Retrieves the crash log from the module in the identified slots.

USB
NOTE: The USB port is available only on the 2930M Switch Series.

usb-port
Syntax
usb-port

no usb-port
Description

Enables the USB port.

The no form of the command disables the USB port and any access to the device.

Command context
Config

show usb-port
Syntax
show usb-port

Description

Displays the status of the USB port. It can be enabled, disabled, or not present.

Command context
operator

Usage

One of the following messages indicates the presence or absence of a USB device:

• Not able to sense device in USB port
• USB device detected in port
• no USB device detected in port
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Example

Display USB port status.

switch# show usb-port

  USB port status: enabled
  USB port power status: power on    (USB device detected in port)

Downloading switch software using USB

Prerequisites

Procedure

1. Store a software version for the switch on a USB flash drive. (The latest software file is typically available from
the Switch Networking website at http://www.hpe.com/networking/support.)

2. Insert the USB device into the switch's USB port.

3. Determine the name of the software file stored on the USB flash drive (for example, K.0800.swi).

4. Decide whether the image will be installed in the primary or secondary flash.

Copying using USB
To copy the primary image to a USB flash drive:

Procedure

1. Insert a USB device into the switch's USB port.

2. Execute the command: switch# copy flash usb K.0800.swi primary/secondary where K.
0800.swi is the name given to the primary flash image that is copied from the switch to the USB device.

copy flash usb
Syntax
copy flash usb <FILENAME>
        
Description

Uses the USB port to copy the specified flash image from the switch to a USB flash memory device. The default
setting will use the primary image.

Copy a switch software file named K.0800.swi from a USB device to primary flash.
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Procedure

1. Issue the copy usb flash command as shown below:

Figure 38: The command to copy switch software from USB

2. When the switch finishes copying the software file from the USB device, it displays this progress message:
Validating and Writing System Software to the Filesystem....

3. When the save finishes, you must reboot the switch to load the newly loaded software.

4. To confirm that the software downloaded correctly, execute show system and check the Software revision
line.

copy usb command-file
Syntax
copy usb command-file <FILENAME.TXT> [unix|pc]
      
Description

Copies and executes the named text file from a USB flash drive and executes the ACL commands in the file.
Depending on the ACL commands used, this action does one of the following in the running-config file:

• Creates a new ACL.

• Replaces an existing ACL.

• Adds to an existing ACL.

Parameters
<FILENAME.TXT>

A text file containing ACL commands and stored in the USB flash drive.

unix|pc
The type of workstation used to create the text file.

Upload an ACL command file from USB

Using a PC workstation, execute the following from the CLI to upload the file to the switch and implement the ACL
commands it contains:

switch(config)# copy usb command-file vlan10_in.txt pc
The switch displays this message:

Running configuration may change, do you want to continue
[y/n]?
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If the switch detects an illegal (non-ACL) command in the file, it bypasses the illegal command, displays a notice,
and continues to implement the remaining ACL commands in the file.
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Overview
The switches have several built-in tools for monitoring, analyzing, and troubleshooting switch and network
operation:

• Status: Includes options for displaying general switch information, management address data, port status, port
and trunk group statistics, MAC addresses detected on each port or VLAN, and STP, IGMP, and VLAN data.

• Counters: Display details of traffic volume on individual ports.

• Event Log: Lists switch operating events (Using the Event Log for troubleshooting switch problems on
page 488 ).

• Alert Log: Lists network occurrences detected by the switch—in the System > Logging screen of the
WebAgent.

• Configurable trap receivers: Uses SNMP to enable management stations on your network to receive SNMP
traps from the switch.

• Port monitoring (mirroring): Copy all traffic from the specified ports to a designated monitoring port.

NOTE: Link test and ping test—analysis tools in troubleshooting situations—are described in 
Troubleshooting on page 458. See Diagnostic tools on page 527.

Switch and network operations
The switches have several built-in tools for monitoring, analyzing, and troubleshooting switch and network
operation:

• Status

Includes options for displaying general switch information, management address data, port status, port and
trunk group statistics, MAC addresses detected on each port or VLAN, and STP, IGMP, and VLAN data.

• Counters

Display details of traffic volume on individual ports

• Event Log

Lists switch operating events. See the ProVision switch software troubleshooting guide for troubleshooting
information.

• Configurable trap receivers

Uses SNMP to enable management stations on your network to receive SNMP traps from the switch.

• Port monitoring (mirroring)

Copy all traffic from the specified ports to a designated monitoring port .

NOTE: Link test and ping test—analysis tools in troubleshooting situations—are described in the
ProVision Switch Software Troubleshooting Guide.

Chapter 12
Monitoring and Analyzing Switch Operation
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Status and counters data
This section describes the status and counters screens available through the switch console interface and/or the
WebAgent.

NOTE: You can access all console screens from the WebAgent via Telnet to the console. Telnet
access to the switch is available in the Device View window under the Configuration tab.

show system
Syntax
show system [chassislocate|information|fans]
Description

Displays global system information and operational parameters for the switch.

Parameters and options
chassislocate

Displays the chassisLocator LED status. Possible values are ON, Off, or Blink. When the status is On or Blink,
the number of minutes that the Locator LED will continue to be on or to blink is displayed. (See Figure 39:
Command results for show system chassislocate command on page 375.)

information
Displays global system information and operational parameters for the switch. (See Figure 41: Switch
system information on page 375.)

power-supply
Shows chassis power supply and settings.

temperature
Shows system temperature and settings.

fans
Shows system fan status. (See Figure 40: System fan status on page 375.)
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show system chassislocate command

Figure 39: Command results for show system chassislocate command

Figure 40: System fan status

Figure 41: Switch system information

chassislocate
Syntax

Description

Identifies the location of a specific switch by activating the blue locator LED on the front panel of the switch.

chassislocate [blink|on|off]
Parameters and options
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blink <1–1440>
Blinks the chassis locate LED for a specified number of minutes (Default: 30 min.)

on <1–1440>
Turns the chassis locate LED on for a specified number of minutes (Default: 20 min.)

off
Turns the chassis locate LED off.

Chassislocate at startup
The chassislocate command has an optional parameter that configures it to run in the future instead of
immediately.

Syntax
chassislocate [on|blink] <MINUTES> at [now|startup]
chassislocate off
Parameters and options
<MINUTES>

Specify the number of minutes for the chassis locate LED to remain on or blink.

at
Specify when the command is applied (default immediately.)

now
Turn on the chassis locate LED immediately.

startup
Turn on the chassis locate LED at switch startup.

off
Turn off the chassis locate LED switch

chassislocate at startup

chassislocate blink 10 at startup

show system chassislocate
Syntax
show system chassislocate
Description

Displays the current status of the chassislocate settings.

Display locator LED status

Locator LED Status
          Current    Time
Member    State      Remaining  Configuration
------    -------    ---------  -------------
1         blink      00:27:05   blink 30 at startup
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2         on         01:05:27
3         off

General system information

Accessing system information (CLI)
Syntax:

show system [chassislocate | information | fans | power-supply | temperature]
Displays global system information and operational parameters for the switch.

chassislocate Shows the chassisLocator LED status. Possible values are On,
Off, or Blink.When the status is On or Blink, the number of minutes
that the Locator LED will continue to be on or to blink is displayed.
(See Command results for show system chassislocate
command on page 377)

information Shows global system information and operational parameters for
the switch. (See Switch system information on page 377.)

fans Shows system fan status. (See System fan status on page 377.)

Command results for show system chassislocate command

switch(config)# show system chassislocate

Chassis Locator LED: ON 5 minutes 5 seconds

switch(config)# show system chassislocate

Chassis Locator LED: BLINK 10 minutes 6 seconds

switch(config)# show system chassislocate

Chassis Locator LED: OFF

System fan status

switch(config)# show system fans

Fan Information
   Num | State | Failures
-------+-------------+----------
 Sys-1 | Fan OK | 0

0 / 1 Fans in Failure State
0 / 1 Fans have been in Failure State

Switch system information

switch(config)# show system

 Status and Counters - General System Information
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  System Name        : Switch
  System Contact     :
  System Location    :

  MAC Age Time (sec) : 300

  Time Zone          : 0
  Daylight Time Rule : None

  Software revision  : T.13.XX     Base MAC Addr   : 001635-b57cc0
  ROM Version        : XX.12.12     Serial Number   : LP621KI005

  Up Time            : 51 secs     Memory - Total  : 152,455,616
  CPU Util (%)       : 3                    Free   : 100,527,264

  IP Mgmt - Pkts Rx  :0            Packet - Total  : 6750
            Pkts Tx  :0            Buffers  Free   : 5086
                                            Lowest : 5086
                                            Missed : 0

Collecting processor data with the task monitor (CLI)
The task monitor feature allows you to enable or disable the collection of processor utilization data. The task-
monitor cpu command is equivalent to the existing debug mode command taskusage -d.

When the task-monitor command is enabled, the show cpu command summarizes the processor usage by
protocol and system functions.

Syntax:

[no] task-monitor cpu
Allows the collection of processor utilization data.

Only manager logins can execute this command.

The settings are not persistent, that is, there are no changes to the configuration.

(Default: Disabled)

The task-monitor cpu command and show cpu output

switch(config)# task-monitor cpu
switch(config)# show cpu

2 percent busy, from 2865 sec ago
1 sec ave: 9 percent busy
5 sec ave: 9 percent busy
1 min ave: 1 percent busy

 % CPU | Description
-------+-----------------
    99 | Idle

task-monitor cpu
Syntax

[no] task-monitor cpu
Description
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Enables or disables the collection of processor utilization data, and requires a manager log in. Settings are not
persistent; there are no changes to the configuration. Defaults to disabled.

task-monitor cpu command

Figure 42: The task-monitor cpu command and show cpu output

Switch management address information access

show management
Syntax
show management
Description

Displays switch management address information.

Component information views
The CLI show modules command displays additional component information for the following:

• SSM—identification, including serial number

• Mini-GBICS—a list of installed mini-GBICs displaying the type, "J" number, and serial number (when available)

show modules
Syntax
show modules
Description

Displays information about the installed modules (Figure 43: The show modules command output on page
380), including:

• The slot in which the module is installed

• The module description

• The serial number
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Additionally, this command displays the part number (J number) and serial number of the chassis. (See Figure
44: The show modules details command for the 8212zl, showing SSM and mini-GBIC information on page
380.)

show modules command

Figure 43: The show modules command output

show modules details command

Figure 44: The show modules details command for the 8212zl, showing SSM and mini-GBIC information

Task usage reporting
The task usage reporting feature provides the ability to collect and display CPU usage data (with a refresh rate of
5 seconds) of running tasks on the switch. It includes the following commands:

• process-tracking: This command is used to enable/disable the task-usage collecting capability for a
specific module on the switch.

• show cpu process: This command is used to display task-usage statistics for a specific module.

Syntax:
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[no] process-tracking [slot[SLOT-LIST] [<time>]] [<time>]
Enables/disables module process-tracking functionality.

process-tracking <tab>

slot Enables/disables process-tracking for a module.

INTEGER Specifies time to track value between 1 second to 30 seconds.

<cr>

process-tracking slot <tab>

SLOT-ID-RANGE Enter an alphabetic device slot identifier or slot range.

process-tracking slot A

INTEGER Specifies time to track value between 1 second to 30 seconds.

<cr>

process-tracking slot A 10 <tab>

<cr>

process-tracking 10 <tab>

<cr>

Syntax:
show cpu [<CHASSIS_MIN_CPU_UTIL_INDEX-CHASSIS_MAX_CPU_UTIL_INDEX>]
[slot <SLOT-LIST>
[<CHASSIS_MIN_CPU_UTIL_INDEX-CHASSIS_MODULE_MAX_CPU_UTIL_INDEX>]]
[process [[slot <SLOT-LIST>] [refresh <iterations>]]
[refresh <iterations>]
Shows average CPU utilization over the last 1, 5, and 60 seconds, or the number of seconds specified.

Use the slot option to display CPU utilization for the specified modules, rather than the chassis CPU.

Use the process option to display module process usages.

Syntax:
show cpu process [slot [SLOT-LIST][refresh <iterations>]]
[refresh <iterations>]
Displays module process usage.

show cpu <tab>

process Displays process usage.

slot Displays module CPU statistics.

Table Continued
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<1-300> Time (in seconds) over which to average CPU utilization.

<cr>

show cpu process <tab>

refresh Number of times to refresh process usage display.

slot Displays module process usage.

<cr>

show cpu process refresh <tab>

INTEGER Enter an integer number.

show cpu process refresh 10 <tab>

<cr>

show cpu process slot <tab>

SLOT-ID-RANGE Enter an alphabetic device slot identifier or slot range.

show cpu process slot A <tab>

refresh Number of times to refresh process usage display.

<cr>

show cpu process slot A refresh <tab>

INTEGER Enter an integer number.

show cpu process slot A refresh 10 <tab>

<cr>

Output for the show cpu process command

switch# show cpu process

                              | Recent |  %   | Time Since | Times  | Max
Process Name      | Priority  | Time   | CPU  | Last Ran   | Ran    | Time
----------------- + --------- + ------ + ---- + ---------- + ------ + -------
Idle-1            | 226       | 10 s   | 41   | 57 us      | 380986 | 69 us
Idle-3            | 1         | 5 s    | 20   | 52 us      | 761665 | 55 us
Idle-0            | 226       | 8 s    | 33   | 19 us      | 380867 | 66 us
Sessions & I/O-24 | 171       | 926 ms | 3    | 1 ms       | 150    | 335 ms

Output for the show cpu process slot <slot-list> command

switch# show cpu process slot A
slot a:
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                              | Recent |  %   | Time Since | Times  | Max
Process Name      | Priority  | Time   | CPU  | Last Ran   | Ran    | Time
----------------- + --------- + ------ + ---- + ---------- + ------ + -------
System Services-2 | 156       | 253 ms | 2    | 767 ms     | 12     | 35 ms
Idle-3            | 1         | 3 s    | 28   | 13 ms      | 101309 | 150 us
Hardware Mgmt-2   | 192       | 282 ms | 2    | 303 us     | 44     | 12 ms
Idle-1            | 226       | 6 s    | 55   | 13 ms      | 50793  | 233 us
Idle-0            | 226       | 1 s    | 9    | 14 ms      | 50633  | 106 us

Switch management address information

Accessing switch management address information (CLI)
Syntax:

show management

Overview of MAC Address Management
The switch assigns MAC addresses in these areas:

• For management functions, one Base MAC address is assigned to the default VLAN (VID = 1). (All VLANs on
the switches covered in this guide use the same MAC address.)

• For internal switch operations: One MAC address per port (see Viewing the port and VLAN MAC addresses
on page 384.

MAC addresses are assigned at the factory. The switch automatically implements these addresses for VLANs and
ports as they are added to the switch.

NOTE: The switch’s base MAC address is also printed on a label affixed to the switch.

Determining MAC addresses
Use the CLI to view the switch's port MAC addresses in hexadecimal format.

NOTE: The switch's base MAC address is used for the default VLAN (VID =1) that is always
available on the switch. This is true for dynamic VLANs as well; the base MAC address is the same
across all VLANs.

Viewing the MAC addresses of connected devices
Syntax:

show mac-address [port-list | mac-addr | vlan < vid>]
Lists the MAC addresses of the devices the switch has detected, along with the number of the specific port on
which each MAC address was detected.
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[port-list]
Lists the MAC addresses of the devices the switch has detected, on the specified
ports.

[mac-addr]
Lists the port on which the switch detects the specified MAC address.Returns the
following message if the specified MAC address is not detected on any port in the
switch:

MAC address <mac-addr> not found.
                

[vlan <vid>]
Lists the MAC addresses of the devices the switch has detected on ports belonging
to the specified VLAN, along with the number of the specific port on which each MAC
address was detected.

Viewing the switch's MAC address assignments for VLANs configured on the switch
The Management Address Information screen lists the MAC addresses for:

• Base switch (default VLAN; VID=1)

• Any additional VLANs configured on the switch.

Also, the Base MAC address appears on a label on the back of the switch.

NOTE: The Base MAC address is used by the first (default) VLAN in the switch. This is usually the
VLAN named "DEFAULT_VLAN" unless the name has been changed (by using the VLAN Names
screen). On the switches covered in this guide, the VID (VLAN identification number) for the default
VLAN is always "1," and cannot be changed.

Viewing the port and VLAN MAC addresses
The MAC address assigned to each switch port is used internally by such features as Flow Control and the
spanning-tree protocol. Using the walkmib command to determine the MAC address assignments for individual
ports can sometimes be useful when diagnosing switch operation.

NOTE: This procedure displays the MAC addresses for all ports and existing VLANs in the switch,
regardless of which VLAN you select.

Procedure

1. If the switch is at the CLI Operator level, use the enable command to enter the Manager level of the CLI.

2. Enter the following command to display the MAC address for each port on the switch:

switch# walkmib ifPhysAddress
(The above command is not case-sensitive.)

Example:

A switch with the following module configuration shows MAC address assignments similar to those shown in the
example below:
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• A 4-port module in slot A, a 24-port module in slot C, and no modules in slots B and D

• Two non-default VLANs configured

Figure 45: Example: of Port MAC address assignments on a switch

Port Status
The WebAgent and the console interface show the same port status data.

Viewing port status (CLI)
Syntax:

show interfaces brief

Viewing port and trunk group statistics (WebAgent)

1. In the navigation pane of the WebAgent, click Interface.

2. Click Port Info/Config.

For information about this screen, click ? in the upper right corner of the WebAgent screen.
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NOTE:

To reset the port counters to zero, you must reboot the switch.

Port and trunk group statistics and flow control status
The features described in this section enable you to determine the traffic patterns for each port since the last
reboot or reset of the switch. You can display:

• A general report of traffic on all LAN ports and trunk groups in the switch, along with the per-port flow control
status (On or Off).

• A detailed summary of traffic on a selected port or trunk group.

You can also reset the counters for a specific port.

The menu interface provides a dynamic display of counters summarizing the traffic on each port. The CLI lets you
see a static "snapshot" of port or trunk group statistics at a particular moment.

As mentioned above, rebooting or resetting the switch resets the counters to zero. You can also reset the
counters to zero for the current session. This is useful for troubleshooting. See the Note, below.

NOTE:

The Reset action resets the counter display to zero for the current session, but does not affect the
cumulative values in the actual hardware counters. (In compliance with the SNMP standard, the
values in the hardware counters are not reset to zero unless you reboot the switch.) Exiting from the
console session and starting a new session restores the counter displays to the accumulated values
in the hardware counters.

Accessing port and trunk group statistics (CLI)
Viewing the port counter summary report
Syntax:

show interfaces
Provides an overview of port activity for all ports on the switch.

Viewing a detailed traffic summary for specific ports
Syntax:

show interfaces <port-list>
Provides traffic details for the ports you specify.

Displaying trunk load balancing statistics
To display trunk counters information since the trunk was formed with the given ports. If ports are added or
removed from the trunk-groups, statistical data is reset.

Syntax:

show trunk-statistics <trunk-group>
Displays the trunk counter information since the trunk was formed.
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Ouptut for the show trunk-statistics command

switch(config)# show trunk-statistics trk1

 Group : Trk1 Ports : 3,4
 Monitoring time : 23 hours 15 minutes

 Totals

  Packets Rx : 3,452,664 Bytes Rx : 14,004,243
  Packets Tx : 2,121,122 Bytes Tx : 2,077,566
  Packets Tx Drop :

  Rates (5 minute weighted average):
   Trunk utilization Rx : 30.2 %
   Trunk utilization Tx : 78.2 %

 Traffic Spread past 5 minutes

  Port | %Tx   | %Rx   | Bytes Rx   | Bytes Tx   | Dropped Frame-Tx
  ---- + ----- + ----- + ---------- + ---------- + ----------------
  3    | 27    | 42    | 1,223,445  | 2,112,122  | 123,122
  4    | 73    | 58    | 356,233    | 993,222    | 0

Clearing trunk load balancing statistics
To display trunk counters information since the trunk was formed with the given ports. If ports are added or
removed from the trunk-groups, statistical data is reset. The data is for a specific trunk.

Syntax:

clear trunk-statistics <trunk-group>
Clears statistics for all trunks if no trunks identified.

trunk-group: Clears specific trunk counter information since the trunk was formed.

Resetting the port counters
It is useful to be able to clear all counters and statistics without rebooting the switch when troubleshooting network
issues. The clear statistics global command clears all counters and statistics for all interfaces except
SNMP. You can also clear the counters and statistics for an individual port using the clear statistics
<port-list> command.

Syntax:

clear statistics {<< port-list > | global>}
When executed with the port-list option, clears the counters and statistics for an individual port.

When executed with the global option, clears all counters and statistics for all interfaces except SNMP.

The show interfaces [<port-list>] command displays the totals accumulated since the last boot or the
last clear statistics command was executed. The menu page also displays these totals.

SNMP displays the counter and statistics totals accumulated since the last reboot; it is not affected by the clear
statistics global command or the clear statistics <port-list> command. An SNMP trap is sent
whenever the statistics are cleared.

Viewing the switch's MAC address tables

Chapter 12 Monitoring and Analyzing Switch Operation 387

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 6984



Accessing MAC address views and searches (CLI)
Syntax:

show mac-address 
 [vlan < vlan-id>] 
 [<port-list>] 
 [< mac-addr >]
Listing all learned MAC addresses on the switch, with the port number on which each
MAC address was learned

Switch# show mac-address

Listing all learned MAC addresses on one or more ports, with their corresponding port
numbers
For example, to list the learned MAC address on ports A1 through A4 and port A6:

Switch# show mac-address a1-a4,a6

Listing all learned MAC addresses on a VLAN, with their port numbers
This command lists the MAC addresses associated with the ports for a given VLAN. For Example:

Switch# show mac-address vlan 100

NOTE: The switches operate with a multiple forwarding database architecture.

Finding the port on which the switch learned a specific MAC address
For example, to find the port on which the switch learns a MAC address of 080009-21ae84:

Accessing MSTP Data (CLI)
Syntax:

show spanning-tree
Displays the switch's global and regional spanning-tree status, plus the per-port spanning-tree operation at the
regional level.

Values for the following parameters appear only for ports connected to active devices: Designated Bridge,
Hello Time, PtP, and Edge.
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Example:

Figure 46: Output from show spanning-tree command

Viewing internet IGMP status (CLI)
The switch uses the CLI to display the following IGMP status on a per-VLAN basis:
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Viewing VLAN information (CLI)

Show command Output

show vlan Lists:

• Maximum number of VLANs to support

• Existing VLANs

• Status (static or dynamic)

• Primary VLAN

show vlan <vlan-id> For the specified VLAN, lists:

• Name, VID, and status (static/dynamic)

• Per-port mode (tagged, untagged, forbid, no/auto)

• "Unknown VLAN" setting (Learn, Block, Disable)

• Port status (up/down)

Example:

Suppose that your switch has the following VLANs:

Ports VLAN VID

A1-A12 DEFAULT_VLAN 1

A1, A2 VLAN-33 33

A3, A4 VLAN-44 44

The next three examples show how you could list data on the above VLANs.

Listing the VLAN ID (vid) and status for specific ports

Switch# show vlan ports A1-A2

 Status and Counters = VLAN Information - for ports A1,A2

  802.1Q VLAN ID Name         Status
  -------------- ------------ ------
  1              DEFAULT_VLAN Static
  33             VLAN-33      Static
Note: Because ports A1 and A2 are not members of VLAN-44, it does not appear in this listing.

VLAN listing for the entire switch

Switch# show vlan
 Status and Counters = VLAN Information

 VLAN support : Yes
 Maximum VLANs to support : 9
 Primary VLAN: DEFAULT_VLAN
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 802.1Q VLAN ID Name         Status
 -------------- ------------ ------
 1              DEFAULT_VLAN Static
 33             VLAN-33      Static
 44             VLAN-44      Static

Port listing for an individual VLAN

switch(config)# show vlan 1
 
 Status and Counters - VLAN Information - VLAN 1

  VLAN ID : 1
  Name : DEFAULT_VLAN
  Status : Static
  Voice : Yes
  Jumbo : No

  Port Information Mode     Unknown VLAN Status
  ---------------- -------- ------------ ------
  A1               Untagged Learn        Up
  A2               Untagged Learn        Up
  A3               Untagged Learn        Up
  A4               Untagged Learn        Down
  A5               Untagged Learn        Up
  A6               Untagged Learn        Up
  A7               Untagged Learn        Up
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WebAgent status information
The WebAgent Status screen provides an overview of the status of the switch. Scroll down to view more details.
For information about this screen, click on ? in the upper right corner of the WebAgent screen. For an Example: of
a status screen, see Figure 47: Example: of a WebAgent status screen on page 392.

Figure 47: Example: of a WebAgent status screen

Compatibility mode for v2 zl and zl modules
In the following context, v2 zl modules are the second version of the current zl modules.

Compatibility Mode allows the inter-operation of v2 zl modules with zl modules in a chassis switch. When in
Compatibility Mode, the switch accepts either v2 zl or zl modules. The default is Compatibility Mode enabled. If
Compatibility Mode is disabled by executing the no allow-v1-modules command, the switch will only power
up v2 zl modules.

allow-v1-modules
Syntax
[no] allow-v1-modules
Enables Compatibility Mode for interoperation of v2 zl and zl modules in the same chassis. (See Figure 48:
Enabling compatibility mode on page 392.) The no form of the command disables Compatibility Mode. Only
the v2 zl modules are powered up. (See Figure 49: Disabling compatibility mode on page 393.) Defaults to
enabled.

allow-v1–modules

Figure 48: Enabling compatibility mode
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no allow-v1–modules

Figure 49: Disabling compatibility mode

Port status
You can view port status using either the CLI or the menu.

show interfaces brief
Syntax
show interfaces brief
Description

View the port status.

Accessing port and trunk group statistics
Use the CLI to view port counter summary reports, and to view detailed traffic summary for specific ports.

Trunk bandwidth utilization
• Trunk interface counters display the accumulated statistics over the trunk members' ports since the time they

are added into trunk.

• Bandwidth utilization for trunks is calculated by averaging the value of the sum of bandwidth utilization for each
trunk member in the last 5 minute interval .

show interfaces

Syntax
show interfaces [brief | config | <PORT-LIST>]

Description

Shows interface information for ports or trunk groups in brief or configuration detail.

Command context
operator or manager

Parameters
brief

Shows the current operating status for all ports or trunk groups on the switch in brief detail.

config
Shows the configuration data for all ports or trunk groups on the switch.

<PORT-LIST>

Specifies the list of ports for which status information will be shown.

Chapter 12 Monitoring and Analyzing Switch Operation 393

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 6990



<TRUNK-GROUP>

Specifies the trunk group for which status information will be shown. The status information shown consists of
total transmit and receive counters and weighted average rate for the trunk group specified. The weighted
average rate is calculated in 5 minute intervals.

Usage

Both external and internal ports are supported on the same module. Internal ports have an “I” suffix in the output
of the show command to indicate that they are internal ports.

• “10GbE-INT” – Internal 10G data-plane ports (1i-2i, 4i-5i)

• “1GbE-INT” – Internal 1G control-plane port (3i)

• Port 3i always shows as link-down.

Examples

Show brief information and status of all interfaces.

switch# show interfaces brief

Status and Counters - Port Status
                | Intrusion                            MDI   Flow  Bcast
Port  Type      | Alert     Enabled Status Mode        Mode  Ctrl  Limit
----- --------- + --------- ------- ------ ----------  ----- ----- ------
B1    100/1000T | No        Yes     Down   Auto-10-100 Auto  off   0
B2    100/1000T | No        Yes     Down   1000FDx     Auto  off   0
B3    100/1000T | No        Yes     Down   1000FDx     Auto  off   0
B4    100/1000T | No        Yes     Down   1000FDx     Auto  off   0
B5    100/1000T | No        Yes     Down   1000FDx     Auto  off   0
B6    100/1000T | No        Yes     Down   1000FDx     Auto  off   0
Show the configuration of the interfaces currently available.

switch# show interfaces config

Port Settings
  Port  Type      | Enabled Mode         Flow Ctrl MDI
  ----- --------- + ------- ------------ --------- ----
  B1    100/1000T | Yes     Auto-10-100  Disable   Auto
  B2    100/1000T | Yes     Auto         Disable   Auto
  B3    100/1000T | Yes     Auto         Disable   Auto
  B4    100/1000T | Yes     Auto         Disable   Auto
  B5    100/1000T | Yes     Auto         Disable   Auto
  B6    100/1000T | Yes     Auto         Disable   Auto 
Show brief information and status of interfaces for ports D1i, D2i, and D3i.

switch# show interfaces brief d1i-d3i

Status and Counters - Port Status
                  | Intrusion                           MDI  Flow Bcast
Port   Type       | Alert     Enabled Status Mode       Mode Ctrl Limit
------ ---------- + --------- ------- ------ ---------- ---- ---- -----
D1i    10GbE-INT  | No        Yes     Up     10GigFD    NA   off  0
D2i    10GbE-INT  | No        Yes     Up     10GigFD    NA   off  0
D3i    1GbE-INT   | No        Yes     Down   1000FDx    NA   off  0
Show the brief information and status of interfaces for ports B1 through internal port B3i.
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switch# show interfaces brief b1-b3i

Status and Counters - Port Status
                   | Intrusion                           MDI  Flow Bcast
 Port   Type       | Alert     Enabled Status Mode       Mode Ctrl Limit 
 ------ ---------- + --------- ------- ------ ---------- ---- ---- -----
 B1     100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B2     100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B3     100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B4     100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B5     100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B6     100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B7     100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B8     100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B9     100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B10    100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B11    100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B12    100/1000T  | No        Yes     Down   1000FDx    Auto off  0
 B1i    10GbE-INT  | No        Yes     Up     10GigFD    NA   off  0
 B2i    10GbE-INT  | No        Yes     Up     10GigFD    NA   off  0
 B3i    1GbE-INT   | No        Yes     Up     1000FDx    NA   off  0
Show detailed interface information for port trunk 1.

switch# show interface trk1

Status and Counters - Port Counters for port Trk1                      
  Name  :  Trk1
  MAC Address      : 3464a9-b1b8bf 
  Link Status      : Up 
  Totals (Since boot or last clear) : 
   Bytes Rx        : 777,713,956          Bytes Tx        : 596,853,141   
   Unicast Rx      : 1,154,693            Unicast Tx      : 0             
   Bcast/Mcast Rx  : 48,563               Bcast/Mcast Tx  : 607,474,910   
  Errors (Since boot or last clear) : 
   FCS Rx          : 0                    Drops Tx        : 0             
   Alignment Rx    : 0                    Collisions Tx   : 0             
   Runts Rx        : 0                    Late Colln      : 0             
   Giants Rx       : 0                    Excessive Colln : 0             
   Total Rx Errors : 0                    Deferred Tx     : 0               
  Others (Since boot or last clear) : 
   Discard Rx      : 0                    Out Queue Len   : 0             
   Unknown Protos  : 0                  
  Rates (5 minute weighted average) :
   Total Rx(Kbps)  : 76,800                 Total Tx(Kbps): 76,800              
   Unicast Rx (Pkts/sec) : 21             Unicast Tx (Pkts/sec) : 0            
   B/Mcast Rx (Pkts/sec) : 114,878        B/Mcast Tx (Pkts/sec) : 114,900      
   Utilization Rx  : 00.76 %                                                  
Utilization Tx  : 00.76 % 

show interfaces trunk-utilization

Syntax
show interfaces trunk-utilization

Description

Shows the bandwidth utilization calculations for all trunk members.

Command context

operator or manager
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Example

Show bandwidth utilization for trunks.

Switch(config)# show interfaces trunk-utilization

Status and Counters - Port Utilization

                         Rx                           Tx
 Port     | --------------------------- | ---------------------------
          | Kbits/sec   Pkts/sec  Util  | Kbits/sec  Pkts/sec   Util
 --------  ---------- ----- + ---------- ---------- ---------  -----
 Trk1     | 0          0          0     | 0          0          0
 Trk2     | 0          0          0     | 0          0          0
 Trk10    | 0          0          0     | 0          0          0

Statistic interactions of interface counters

Table 27: Statistic interactions

Interface counters are cleared using the command clear statistics. When certain actions are taken to ports
and trunks, the outcome of the clear command differs.

Action taken Trigger Interaction with interface counter

Adding Port
into trunk

CLI/SNMP • Interface counters for this port will be cleared across all sessions.

• Average rate counters are not cleared.

Removing
Port from
trunk

CLI/SNMP • Interface counters for this port will be cleared across all sessions.

• Average rate counters are not cleared.

Trunk port
coming Up

CLI enable • No change in counters.

• Interface counters for this port are not cleared.

• Average rate counters are not cleared. Counters will start from 0 when the
trunk port comes up.

Trunk port
coming Up

Cable connect • No change in counters.

• Interface counters for this port are not cleared.

• Average rate counters are not cleared. Counters will start from 0 when the
trunk port comes up.

Trunk port
going Down

CLI disable • Interface counters for this port are not cleared.

• Average rate counters are cleared.

Trunk port
going Down

Cable
disconnect

• Interface counters for this port are not cleared.

• Average rate counters are cleared.

Table Continued
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Action taken Trigger Interaction with interface counter

Trunk port
going Down

Module crash/
module reload

• Interface counters for this port are not cleared.

• Average rate counters are cleared.

Trunk port
going Down

Save power - off • Interface counters for this port are not cleared.

• Average rate counters are cleared.

Trunk port
going Down

Stacking
member reboot/
crash/shutdown.

• Interface counters for this port are not cleared.

• Average rate counters of this port is not cleared.

• Utilization for the port is cleared.

• Utilization for the trunk group is updated accordingly

Trunk port
going Down

Module remove/
member
remove.

• Statistics for removed trunk port can not be accessed as the port is
removed.

• Interface counters for the trunk group is updated.

• Utilization for the trunk group is updated.

Clear
statistics on
physical port
which is part
of trunk

CLI • Not allowed.

• The error message Module not present for port or invalid
port: <PORT-NUM> displays when the command clear statistics
is executed on a port which part of a trunk.

Clear
statistics on
trunk.

CLI • Interface counters for physical ports which are part of trunk will be cleared.

• Average rate counters are not cleared.

Reset port counters
When troubleshooting network issues, you can clear all counters and statistics without rebooting the switch using
the clear statistics global command or using the menu.

SNMP displays the counter and statistics totals accumulated since the last reboot, and it is not affected by the
clear statistics global command or the clear statistics <PORT-LIST> command. Clearing
statistics initiates an SNMP trap.

IMPORTANT: Once cleared, statistics cannot be reintroduced.

clear statistics
Syntax
clear statistics [<PORT-LIST>|global]
      
Description

This command clears all counters and statistics for all interfaces except SNMP.

Parameters and options
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<PORT-LIST>

Clears the counters and statistics for specific ports.

global
Clears all counters and statistics for all interfaces except SNMP.

MAC address tables

MAC address views and searches
You can view and search MAC addresses using the CLI or the menu.

show mac-add detail

Syntax
show mac-address detail

Description

Shows the age of the learned MAC addresses in the MAC table. The age of a specific MAC-address will be
displayed in dd:hr:min:sec.msec format.

Command context
manager

Examples
show mac-add detail on a specified switch.

switch# show mac-add detail

Status and Counters - Port Address Table

  MAC Address       Port                            VLAN Age (d:h:m:s.ms)
  ----------------- ------------------------------- ---- ----------------
  3c4a92-31c100     F23                             1    0000:00:00:00.34
  9cb654-ce6169     A2                              1    0000:00:02:37.93
  c09134-cd2740     F23                             1    0000:00:00:00.28
  c09134-cd277d     F23                             1    0000:00:00:23.62
  f0921c-85b0e0     F24                             1    0000:00:00:08.29
  f0921c-85b0e9     F24                             1    0000:00:00:09.47
show mac-add detail for Vxlan Tunnel supporting and non-supporting platforms.

switch# show mac-address detail
 
Status and Counters - Port Address Table
  MAC Address       Port                            VLAN Age (d:h:m:s.ms)
  ----------------- ------------------------------- ---- ----------------
  f0921c-b6e940     L22                             1    0000:00:23:26.93
  0180c2-00000f     A24                             50   0000:00:00:00.00
  d18cc2-00000f     A24                             50   0001:21:43:59.92
  e18dd2-00000f     A24                             50   0000:18:23:24.22
show mac-add detail for platforms not supporting Vxlan Tunnels.
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stack-Switch# show mac-address detail 
 
Status and Counters - Port Address Table
  MAC Address   Port   VLAN Age (d:h:m:s.ms)  
  ------------- ------ ---- ----------------
  009c02-d80f28 1/2    1    0000:00:00:30.18
  3464a9-abe500 1/2    1    0030:07:01:20.23

show mac-address

Syntax
show mac-address [vlan <VLAN-ID> ] [<PORT-LIST>] [<MAC-ADDR>] [TUNNEL-ID]

Description

Lists all MAC addresses on the switch and their corresponding port numbers. You can also choose to list specific
addresses and ports, or addresses and ports on a VLAN. The switches operate with a multiple forwarding
database architecture.

Command context
manager

Parameters
vlan <VLAN-ID>

Show MAC addresses learned on a specified VLAN.

PORT-LIST

Show MAC addresses learned on the specified ports.

<MAC-ADDR>
Show the specified port for a specified MAC address.

TUNNEL-ID

Show MAC addresses learned on the specified VXLAN tunnel.

Usage
show mac-address

Lists all learned MAC addresses on the switch and their corresponding port numbers.

show mac-address a1-a4,a6
Lists all learned MAC addresses on one or more ports and their corresponding port numbers.

show mac-address vlan 100
Lists all learned MAC addresses on a VLAN and their corresponding port numbers.

show mac-address <MAC-ADDRESS> detail

Syntax

Syntax
show mac-address <MAC-ADDRESS> detail
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Description

Specifies the age and existing details of the specific mac address given.

manager

Parameters
<MAC-ADDRESS>

Specifies the mac-address being requested in detail.

Examples

Show mac-address detail for f0921c-b6e97e.

switch# show mac-address f0921c-b6e97e detail

 Status and Counters - Port Address Table
  MAC Address       Port                            VLAN Age (d:h:m:s.ms)
  ----------------- ------------------------------- ---- ----------------
  f0921c-b6e97e     L22                             1    0000:00:00:30.18
Show mac-address detail for a stacked switch.

switch-Stack# show mac-address 009c02-d80f28 detail
 Status and Counters - Port Address Table
  MAC Address   Port   VLAN Age (d:h:m:s.ms)  
  ------------- ------ ---- ----------------
  009c02-d80f28 1/2    1    0000:00:00:30.18

Finding the port connection for a specific device on a VLAN
This feature uses a device's MAC address that you enter to identify the port used by that device.

Procedure

1. Proceeding from the figure above, press [S] (for Search ), to display the following prompt:

Enter MAC address: _
2. Enter the MAC address you want to locate and press [Enter].

The address and port number are highlighted if found. If the switch does not find the MAC address on the
currently selected VLAN, it leaves the MAC address listing empty.

3. Press [P] (for Prev page ) to return to the full address table listing.

Determining whether a specific device is connected to the selected port
Proceeding from Step 2, above:

Procedure

1. Press [S] (for Search), to display the following prompt:

Enter MAC address: _
2. Enter the MAC address you want to locate and press [Enter].
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The address is highlighted if found. If the switch does not find the address, it leaves the MAC address listing
empty.

3. Press [P] (for Prev page) to return to the previous per-port listing.

MSTP data
show spanning-tree
Syntax
show spanning-tree
Description

Displays the global and regional spanning-tree status for the switch, and displays the per-port spanning-tree
operation at the regional level.

Values for the following parameters appear only for ports connected to active devices: Designated Bridge,
Hello Time, PtP, and Edge.
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show spanning-tree command output

Figure 50: show spanning-tree command output

IP IGMP status

show ip igmp
Syntax
show ip igmp <VLAN-ID> [config] [group <IP-ADDR>|groups] [statistics]
        
Description

Global command that lists IGMP status for all VLANs configured in the switch, including:
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• VLAN ID (VID) and name

• Querier address

• Active group addresses per VLAN

• Number of report and query packets per group

• Querier access port per VLAN

Parameters and options
config

Displays the IGMP configuration information, including VLAN ID, VLAN name, status, forwarding, and Querier
information.

vlan-id

Per-VLAN command listing above, IGMP status for specified VLAN (VID).

group <IP-ADDR>
Lists the ports currently participating in the specified group, with port type, Access type, Age Timer data and
Leave Timer data.

groups
Displays VLAN-ID, group address, uptime, expiration time, multicast filter type, and the last reporter for IGMP
groups.

statistics
Displays IGMP operational information, such as VLAN IDs and names, and filtered and flooding statistics.

Output from show ip igmp config command

IGMP statistical information

switch(vlan-2)# show ip igmp statistics

 IGMP Service Statistics

  Total VLANs with IGMP enabled               : 1
  Current count of multicast groups joined    : 1

 IGMP Joined Groups Statistics

  VLAN ID VLAN Name                        Filtered     Flood
  ------- -------------------------------- ------------ ------------
  2       VLAN2                            2            1
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VLAN information

show vlan
Syntax
show vlan <VLAN-ID>
        
Description

Lists the maximum number of VLANs to support, existing VLANS, VLAN status (static or dynamic), and primary
VLAN.

Parameters and options
<VLAN-ID>

Lists the following for the specified VLAN:

• Name, VID, and status (static/dynamic)

• Per-port mode (tagged, untagged, forbid, no/auto)

• "Unknown VLAN" setting (Learn, Block, Disable)

• Port status (up/down)

List data on specific VLANs

The next three figures show how you can list data for the following VLANs:

Ports VLAN VID

A1-A12 DEFAULT_VLAN 1

Table Continued
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A1, A2 VLAN-33 33

A3, A4 VLAN-44 44

Figure 51: Listing the VLAN ID (vid) and status for specific ports

Figure 52: Example of VLAN listing for the entire switch

Figure 53: Port listing for an individual VLAN

Configuring local mirroring
To configure a local mirroring session in which the mirroring source and destination are on the same switch, follow
these general steps:

Procedure

1. Determine the session and local destination port:
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a. Session number (1) and (optional) alphanumeric name

b. Exit port (any port on the switch except a monitored interface used to mirror traffic)

IMPORTANT: Hewlett Packard Enterprise strongly discourages connecting a mirroring exit port to
a network because doing so can result in serious network performance problems. Only connect
an exit port to a network analyzer, IDS, or other network edge device that has no connection to
other network resources.

2. Enter the mirror-port port number command to configure the session.

3. Determine the traffic to be selected for mirroring by any of the following methods and the appropriate
configuration level (mesh and switch).

4. Enter the monitor command to assign one or more source interfaces to the session.

After you complete step 4, the switch begins mirroring traffic to the configured exit port.

The following commands configure mirroring for a local session in which the mirroring source and destination are
on the same switch.

• The mirror command identifies the destination in a mirroring session.

• The interface and vlan commands identify the mirroring source, including source interface, traffic
direction, and traffic-selection criteria for a specified session.

NOTE: With no allow-v2-modules specified in the configuration of a switch with V3 modules on KB
firmware, Egress VLAN ACLs do not filter mirrored traffic. You must use a port ACL to filter mirrored
traffic.

Local mirroring sessions
Syntax
[no] mirror-port <EXIT-PORT-#>
        
Description

Configure local mirroring sessions.

Parameters and options
mirror-port <EXIT-PORT-#>

When used with mirror-port <EXIT-PORT-#> command, removes the mirroring session and any
mirroring source previously assigned to that session by the following commands.

Traffic-direction criteria

interface monitor all
Syntax
[no] [interface <PORT> |<TRUNK>] monitor

Mirror policy for inbound traffic
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class [ipv4|ipv6]
Syntax
class [ipv4|ipv6] <CLASSNAME> [no] [seq-number] [match|ignore] <IP-PROTOCOL>
<SOURCE-ADDRESS> <DESTINATION-ADDRESS>][precedence <PRECEDENCE-VALUE>][tos <TOS-
VALUE>][ip-dscp <CODEPOINTS>][vlan <VLAN-ID>]
Description

Configures the mirroring policy for inbound traffic on the switch.

Parameters and options

policy mirror
Syntax
policy mirror <POLICY-NAME> [no] <SEQ-NUMBER> [class [ipv4|ipv6] <CLASSNAME> action
mirror <SESSION>] [action mirror <SESSION>] [no] default-class action mirror
<SESSION> [no] [interface <PORT/TRUNK>| vlan <VID-#>] service-policy <MIRROR-
POLICY-NAME> in
Description

The [no] [interface <PORT/TRUNK>| vlan <VID-#>] service-policy <MIRROR-POLICY-NAME>
in command removes the mirroring policy from a port, VLAN, trunk, or mesh interface for a specified session,
but leaves the session available for other assignments.

Parameters and options
mirror <SESSION>

Accepts either a number (1 to 4) or a name. To use a name, you must first configure the name <NAME-STR>
parameter option for the specified mirroring session using the policy mirror command.

MAC-based criteria to select traffic

monitor mac
Syntax
[no] monitor mac  <MAC-ADDR> [src|dst|both] mirror session
      
Description

Configures traffic using MAC-based criteria.

Parameters and options
no

Use the no form of the complete Command syntax (for example, no monitor mac 112233-445566 src
mirror 3) to remove a MAC address as mirroring criteria from an active session on the switch without
removing the session itself.

mirror
Enter the monitor mac mirror command at the global configuration level.
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Remote mirroring destination on a remote switch
Syntax
mirror endpoint ip <SRC-IP> <SRC-UDP-PORT > <DST-IP> <EXIT-PORT> [truncation]
      
Description

Configures a remote mirroring destination on a remote switch.

Parameters and options

Remote mirroring destination on a local switch

mirror remote ip
Syntax
mirror <SESSION> remote ip <SRC-IP> <SRC-UDP-PORT> <DST-IP>
      
Description

Configures a remote mirroring destination on a local switch.

Parameters and options

Local mirroring destination on the local switch

mirror port
Syntax
mirror  <SESSION>  port  <EXIT-PORT> 
      
Description

Configures a local mirroring destination on a local switch.

Parameters and options

Monitored traffic
interface
Syntax
interface <PORT/TRUNK/MESH>
Description

Parameters and options

monitor all
Syntax
monitor all [in|out|both] mirror <SESSION> [no-tag-added]
monitor ip access-group ACL-NAME in mirror <SESSION>
monitor mac <MAC-ADDR> [src|dest|both] mirror
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show monitor [endpoint|<SESSION-NUMBER>|name <SESSION-NAME>

service-policy
Syntax
service-policy <mirror-policy-name> in

Destination mirror on a remote switch

mirror endpoint
Syntax
mirror endpoint ip  <SRC-IP-ADDR>   <SRC-UDP-PORT>  <DST-IP-ADDR>  port  <EXIT-PORT> 
      
Description

Enter this command on a remote switch to configure the exit port to use in a remote mirroring session. to
configure the mirroring source on the local switch.

The mirror endpoint ip command configures:

• The unique UDP port number to be used for the mirroring session on the source switch. The recommended
port range is from 7933 to 65535.

• The IP address of the source switch to use in the session.

• The IP address and exit-port number on the remote (endpoint) switch.

In a remote mirroring endpoint, the IP address of exit port and the remote destination switch can belong to
different VLANs.

Source mirror on the local switch

mirror remote ip
Syntax
[no] mirror 1 - 4 [name <NAME-STR>] remote ip <SRC-IP> <SRC-UDP-PORT> <DST-IP>
[truncation]
Description

Configures the mirroring source on the local switch.

Parameters and options
no mirror 1–4

Removes both the mirroring session and any mirroring sources previously assigned to the session by the
following commands.

Traffic-direction criteria
Syntax
[no] [interface <PORT> <TRUNK> <MESH>|vlan <VID-#>] monitor all in|out|both mirror 1–4|<NAME-STR> [1 — 4|<NAME-STR . . .>]
        

Description
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Configures traffic direction criteria for specific traffic

Configure ACL criteria to select inbound
interface monitor ip access-group
Syntax
[no] [interface <PORT> <TRUNK> <MESH>|vlan <VID-#>] monitor ip access—group <ACL—NAME> inmirror [1–4|<NAME-STR>] [1 — 4|<NAME-STR . . .>]
      

Configuring a destination switch in a remote mirroring
session

CAUTION: When configuring a remote mirroring session, always configure the destination switch
first. Configuring the source switch first can result in a large volume of mirrored, IPv4-encapsulated
traffic arriving at the destination without an exit path, which can slow switch performance.

Syntax

mirror endpoint ip src-ip src-udp-port dst-ip exit-port-# no mirror endpoint ip src-ip src-udp-port dst-ip

Used on a destination switch to configure the remote endpoint of a mirroring session. The command uniquely
associates the mirrored traffic from the desired session on a monitored source with a remote exit port on the
destination switch. You must use the same set of source and destination parameters used when you configure the
same session on both the source and destination switches.

For a given mirroring session, the same src-ip , src-udp-port and dst-ip values must be entered with
the mirror endpoint ip command on the destination switch, and later with the mirror remote ip
command on the source switch.

CAUTION: Do not remove the configuration of a remote mirroring endpoint support for a given
session if there are source switches currently configured to mirror traffic to the endpoint.

src-ip Must exactly match the src-ip address you configure on the source switch for the
remote session.

src-udp-port Must exactly match the src-udp-port value you configure on the source switch
for the remote session. The recommended port range is 7933 to 65535.This setting
associates the monitored source with the desired remote endpoint in the remote
session by using the same, unique UDP port number to identify the session on the
source and remote switches.

dst-ip Must exactly match the dst-ip setting you configure on the source switch for the
remote session.

exit-port-# Exit port for mirrored traffic in the remote session, to which a traffic analyzer or IDS
is connected.

The no form of the command deletes the mirroring endpoint for the configured session on the remote destination
switch.
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Configuring a source switch in a local mirroring session
Enter the mirror port command on the source switch to configure an exit port on the same switch. To create
the mirroring session, use the information gathered in High-level overview of the mirror configuration process
on page 430.

Syntax

mirror 1 port exit-port-# [name name-str] no mirror 1
Assigns the exit port to use for the specified mirroring session and must be executed from the global configuration
level.

1 Identifies the mirroring session created by this command. (Multiple
sessions on the switch can use the same exit port.)

name name-str Optional alphanumeric name string used to identify the session
( up to 15 characters)

port exit-port-
#

Exit port for mirrored traffic in the remote session. This is the port
to which a traffic analyzer or IDS is connected.

The no form of the command removes the mirroring session and any mirroring source previously assigned to that
session.

Configuring a source switch in a remote mirroring session
Syntax

[no] mirror 1 - 4 [name name-str] remote ip src-ip src-udp-port dst-ip [truncation]
Used on the source switch to uniquely associate the mirrored traffic in the specified session with a remote
destination switch. You must configure the same source and destination parameters when you configure the same
session on both the source and destination switches. (If multiple remote sessions use the same source and
destination IP addresses, each session must use a unique UDP port value.)

When you execute this command, the following message is displayed:

Caution: Please configure destination switch first.
          Do you want to continue [y/n]?

      

• If you have not yet configured the session on the remote destination switch, follow the configuration procedure
in Configure a mirroring destination on a remote switch on page 431 before using this command.

• If you have already configured the session on the remote destination switch, enter y (for "yes") to complete this
command.

1 - 4 Identifies the mirroring session created by this command.

name name-str Optional alphanumeric name string used as an additional session
identifier (up to 15 characters.)

Table Continued
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src-ip The IP address of the VLAN or subnet on which the traffic to be
mirrored enters or leaves the switch.

src-udp-port Associates the remote session with a UDP port number. When
multiple sessions have the same source IP address src-ip and
destination IP address dst-ip , the UDP port number must be
unique in each session. The UDP port number used for a given
session should be in the range of 7933 to 65535.

CAUTION: UDP port numbers below 7933 are reserved
for various IP applications. Using them for mirroring can
result in the interruption of other IP functions and in
non-mirrored traffic being received on the destination
switch and sent to a device connected to the remote
exit port.

The configured UDP port number is included in the frames mirrored
from the source switch to the remote destination switch (mirror
endpoint), and enables the remote switch to match the frames to
the exit port configured for the combined UDP port number, source IP
address, and destination IP address..

dst-ip For the remote session specified in the command, this is the IP
address of the VLAN or subnet on which the remote exit port exists.
(The exit port to which a traffic analyzer or IDS is connected is
configured on the remote switch in section.) .)

[truncation] Enables truncation of oversize frames, causing the part of the frame
in excess of the MTU size to be truncated. Unless truncation is
enabled, oversize frames are dropped. The frame size is truncated to
a multiple of 18 bytes—for example, if the MTU is 1000 bytes, the
frame is truncated to 990 bytes (55 * 18 bytes.)

The no form of the command removes the mirroring session and any mirroring source previously assigned to the
session. To preserve the session while deleting a monitored source assigned to it.

Selecting all traffic on a port interface for mirroring
according to traffic direction
Syntax

[no] interface port/trunk/mesh monitor [in | out | both] [mirror 1 | name-str] [{1 
| name-str} | {1 | name-str} | {1 | name-str}] [no-tag-added]
Assigns a mirroring source to a previously configured mirroring session on a source switch by specifying the port,
trunk, and/or mesh sources to use, the direction of traffic to mirror, and the session.
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interface port/trunk/mesh Identifies the source ports, static trunks, and/or mesh on which to mirror
traffic.

Use a hyphen for a range of consecutive ports or trunks (a5-a8, Trk2-
Trk4.)

Use a comma to separate non-contiguous interfaces (b11, b14, Trk4,
Trk7.)

monitor all [in | out | 
both]

For the interface specified by port/trunk/mesh , selects traffic to mirror based
on whether the traffic is entering or leaving the switch on the interface:

• in: Mirrors entering traffic.

• out: Mirrors exiting traffic.

• both: Mirrors traffic entering and exiting.

If you enter the monitor all command without selection criteria or a
session identifier, the command applies by default to session 1

mirror [1 | name-str]
Assigns the traffic specified by the interface and direction to a session by
number or—if configured—by name. The session must have been
previously configured.

Depending on how many sessions are already configured on the switch, you
can use the same command to assign the specified source to up to four
sessions, for example, interface a1 monitor all in mirror 1.

• 1 : Configures the port traffic to be mirrored in the specified session
number.

• [ name name-str]: Optional; configures the port traffic to be mirrored
in the specified session name. The string can be used interchangeably
with the session number when using this command to assign a mirroring
source to a session.

[no-tag-added] Prevents a VLAN tag from being added to the mirrored copy of an outbound
packet sent to a local or remote mirroring destination.

The no form of the command removes a mirroring source assigned to the session, but does not remove the
session itself. This enables you to repurpose a session by removing an unwanted mirroring source and adding
another in its place.

Selecting all traffic on a VLAN interface for mirroring
according to traffic direction
Syntax

vlan vid-# monitor all [in | out | both] [mirror 1 - 4 | name-str] [{1 - 4 | name-str} | {1 - 4 | name-str} | {1 - 4 | name-str}]

This command assigns a monitored VLAN source to a previously configured mirroring session on a source switch
by specifying the VLAN ID, the direction of traffic to mirror, and the session.
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vlan vid-# Identifies the VLAN on which to mirror traffic.

monitor all [in | out
| both] Uses the direction of traffic on the specified vid-# to select traffic to mirror. If

you enter the monitor all command without selection criteria or a session
identifier, the command applies by default to session 1.

mirror [1 - 4 | name-
str] Assigns the VLAN traffic defined by the VLAN ID and traffic direction to a

session number or name.

Depending on how many sessions are already configured on the switch, you
can use the same command to assign the specified VLAN source to up to four
sessions, for example, interface a1 monitor all in mirror 1 2 4.

• 1 - 4: Configures the selected VLAN traffic to be mirrored in the specified
session number.

• [name name-str]: Optional; configures the selected port traffic to be
mirrored in the specified session name. The string can be used
interchangeably with the session number when using this command to
assign a mirroring source to a session. To configure an alphanumeric name
for a mirroring session, see the command description under Configuring a
source switch in a remote mirroring session on page 411.

Assigning a VLAN to a mirroring session precludes assigning any other mirroring sources to the same session. If
a VLAN is already assigned to a given mirroring session, using this command to assign another VLAN to the
same mirroring session results in the second assignment replacing the first. Also, if there are other (port, trunk, or
mesh) mirroring sources already assigned to a session, the switch displays a message similar to:

Mirror source port exists on session N. Can not add mirror
source VLAN.
The no form of the command removes a mirroring source assigned to the session, but does not remove the
session itself. This allows you to repurpose a session by removing an unwanted mirroring source and adding
another in its place.

Configuring a MAC address to filter mirrored traffic on an
interface
Enter the monitor mac mirror command at the global configuration level.

Syntax

[no] monitor mac mac-addr [src | dest | both] {mirror 1 - 4 | name-str} [1 - 4 | name-str] [1 - 4 | name-str] [1 - 4 | name-str]

Use this command to configure a source and/or destination MAC address as criteria for selecting traffic in one or
more mirroring sessions on the switch. The MAC address you enter is configured to mirror inbound (src),
outbound (dest), or both inbound and outbound (both) traffic on any port or learned VLAN on the switch.
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monitor mac mac-addr
Configures the MAC address as selection criteria for mirroring traffic on any port or learned VLAN on the switch.

{src | dest | both}
Specifies how the MAC address is used to filter and mirror packets in inbound
and/or outbound traffic on the interfaces on which the mirroring session is
applied:

• src: Mirrors all packets in inbound traffic that contain the specified MAC
address as source address.

• dest: Mirrors all packets in outbound traffic that contain the specified MAC
address as destination address.

NOTE: The MAC address of the switch is not supported as either
the source or destination MAC address used to select mirrored
traffic.

both: Mirrors all packets in both inbound and outbound traffic that contain the
specified MAC address as either source or destination address.

mirror [1 - 4 | name-
str]

Assigns the inbound and/or outbound traffic filtered by the specified MAC
address to a previously configured mirroring session. The session is identified
by a number or (if configured) a name.

Depending on how many sessions are configured on the switch, you can use
the same command to configure a MAC address as mirroring criteria in up to
four sessions. To identify a session, you can enter either its name or number; for
example: mirror 1 2 3 traffsrc4
1 - 4: Specifies a mirroring session by number, for which the configured MAC
address is used to select and mirror inbound and/or outbound traffic.

Packets that are sent or received on an interface configured with a mirroring session and that contain the MAC
address as source and/or destination address are mirrored to a previously configured destination device.

To remove a MAC address as selection criteria in a mirroring session, you must enter the complete Command
syntax, for example, no monitor mac 998877-665544 dest mirror 4.

The no form of the command removes the MAC address as a mirroring criteria from an active session, but does
not remove the session itself. This enables you to repurpose a session by removing an unwanted mirroring
criteria and adding another in its place.

Configuring classifier-based mirroring
For more information and a list of general steps for the process beginning with this command, see the information
about restrictions on classifier-based mirroring.

Context: Global configuration

Syntax

[no] class [ipv4 | ipv6 classname]
Defines the name of a traffic class and specifies whether a policy is to be applied to IPv4 or IPv6 packets, where
classname is a text string (64 characters maximum.)
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After you enter the class command, you enter the class configuration context to specify match criteria. A traffic
class contains a series of match and ignore commands, which specify the criteria used to classify packets.

To configure a default traffic class, use the default-class command as described below. A default class
manages the packets that do not match the match/ignore criteria in any other classes in a policy.

Context: Class configuration

Syntax

[no] seq-number
 [match | ignore ip-protocol source-address destination-address] [ip-dscp 
codepoint] [precedence precedence-value] [tos tos-value] [vlan vlan-id]
For detailed information about how to enter match and ignore commands to configure a traffic class, the
Advanced Traffic Management Guide.

Context: Global configuration

Syntax

[no] policy mirror policy-name
Defines the name of a mirroring policy and enters the policy configuration context.

A traffic policy consists of one or more classes and one or more mirroring actions configured for each class of
traffic. The configured actions are executed on packets that match a match statement in a class. No policy action
is performed on packets that match an ignore statement.

Context: Policy configuration

Syntax

[no] seq-number
 class [ipv4 | ipv6 classname] action mirror session
Defines the mirroring action to be applied on a pre-configured IPv4 or IPv6 traffic class when a packet matches
the match criteria in the traffic class. You can enter multiple class action mirror statements in a policy.

[seq-number] The (optional) seq-number parameter sequentially orders the mirroring actions
that you enter in a policy configuration. Actions are executed on matching
packets in numerical order.

Default: Mirroring action statements are numbered in increments of 10, starting
at 10.

class [ipv4 | ipv6
classname] Defines the preconfigured traffic class on which the mirroring actions in the

policy are executed and specifies whether the mirroring policy is applied to IPv4
or IPv6 traffic in the class. The classname is a text string (64 characters
maximum.)

action mirror session Configures mirroring for the destination and session specified by the session
parameter.
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Context: Policy configuration

Syntax

[no] default-class action mirror session [action mirror session ...]
Configures a default class that allows packets that are not matched nor ignored by any of the class configurations
in a mirroring policy to be mirrored to the destination configured for the specified session.

Applying a mirroring policy on a port or VLAN interface
Enter one of the following service-policy commands from the global configuration context.

Context: Global configuration

Syntax

interface <PORT-LIST> service-policy policy-name in
Configures the specified ports with a mirroring policy that is applied to inbound traffic on each interface.

Separate individual port numbers in a series with a comma, for example, a1,b4,d3. Enter a range of ports by
using a dash, for example, a1-a5.

The mirroring policy name you enter must be the same as the policy name you configured with the policy
mirror command.

Syntax

vlan vlan-id service-policy policy-name in
Configures a mirroring policy on the specified VLAN that is applied to inbound traffic on the VLAN interface.

Valid VLAN ID numbers range from 1 to 4094.

The mirroring policy name you enter must be the same as the policy name you configured with the policy
mirror command in the syntax policy mirror.

Viewing a classifier-based mirroring configuration
To display information about a classifier-based mirroring configuration or statistics on one or more mirroring
policies, enter one of the following commands:

Syntax

show class [ipv4 class-name | ipv6 class-name | config]
Syntax

show policy [policy-name | config]
Syntax

show policy resources
Syntax

show statistics policy [policy-name] [interface port-num | vlan vid in]

Chapter 12 Monitoring and Analyzing Switch Operation 417

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 7014



Viewing all mirroring session configured on the switch
Syntax
show monitor
If a monitored source for a mirror session is configured on the switch, the following information is displayed.
Otherwise, the output displays: Mirroring is currently disabled. Mirror port configured on the switch is shown:

switch(config) # show monitor

Network Monitoring Port

Mirror Port: 16

Monitoring sources
  ------------------
  2
  5

Viewing the remote endpoints configured on the switch
Syntax

show monitor endpoint
Displays the remote mirroring endpoints configured on the switch. Information on local sessions configured on the
switch is not displayed. (To view the configuration of a local session, use the show monitor [1-4 | name
<name-str>] command)

Type Indicates whether the session is a port (local) or IPv4 (remote) mirroring session.

show monitor
endpoint

The IP address configured for the source VLAN or subnet on which the monitored source
interface exists. In the configuration of a remote session, the same UDP source address
must be configured on the source and destination switches.

UDP port The unique UDP port number that identifies a remote session. In the configuration of a
remote session, the same UDP port number must be configured on the source and
destination switches.

UDP Dest Addr The IP address configured for the destination VLAN or subnet on which the remote exit port
exists. In the configuration of a remote session, the same UDP destination address must be
configured on the source and destination switches.

Dest Port fies the exit port for a remote session on a remote destination switch.

Example
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In the following figure, the show monitor endpoint output shows that the switch is configured as the remote
endpoint (destination) for two remote sessions from the same monitored source interface.

Figure 54: Displaying the configuration of remote mirroring endpoints on the switch

Viewing the mirroring configuration for a specific session
Syntax

show monitor [1 | name name-str]
Displays detailed configuration information for a specified local or remote mirroring session on a source switch.

Session Displays the session.

Session Name Displays the name of the session, if configured.

Policy Indicates whether the source is using a classifier-based mirroring policy to select
inbound IPv4 or IPv6 traffic for mirroring.

Mirroring Destination For a local mirroring session, displays the port configured as the exit port on the source
switch. For a remote mirroring session, displays IPv4, which indicates mirroring to a
remote (endpoint) switch.

UDP Source Addr The IP address configured for the source VLAN or subnet on which the monitored
source interface exists. In the configuration of a remote session, the same UDP source
address must be configured on the source and destination switches.

UDP port The unique UDP port number that identifies a remote session. In the configuration of a
remote session, the same UDP port number must be configured on the source and
destination switches.

UDP Dest Addr The IP address configured for the destination VLAN or subnet on which the remote exit
port exists. In the configuration of a remote session, the same UDP destination address
must be configured on the source and destination switches.

Status For a remote session, displays current session activity:

• active: The session is configured and is mirroring traffic. A remote path has been
discovered to the destination.

• inactive: The session is configured, but is not currently mirroring traffic. A remote
path has not been discovered to the destination.

• not defined: Mirroring is not configured for this session.

Table Continued
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Monitoring Sources For the specified local or remote session, displays the source (port, trunk, or VLAN)
interface and the MAC address (if configured) used to select mirrored traffic.

Direction For the selected interface, indicates whether mirrored traffic is entering the switch (in),
leaving the switch (out), or both.

Viewing a remote mirroring session
After you configure session 2 for remote mirroring (Figure 55: Configuring a remote mirroring session and
monitored source on page 420), you can enter the show monitor 2 command to verify the configuration
(Figure 56: Displaying the Configuration of a Remote Mirroring Session on page 420.)

Figure 55: Configuring a remote mirroring session and monitored source

Figure 56: Displaying the Configuration of a Remote Mirroring Session
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Viewing a MAC-based mirroring session
After you configure a MAC-based mirroring session (Figure 57: Configuring a MAC-based mirroring session
on page 421), you can enter the show monitor 3 command to verify the configuration (Figure 58: Displaying
a MAC-based mirroring session on page 421.)

Figure 57: Configuring a MAC-based mirroring session

Figure 58: Displaying a MAC-based mirroring session

Viewing a local mirroring session
When used to display the configuration of a local session, the show monitor command displays a subset of the
information displayed for a remote mirroring session.

Example

Figure 59: Displaying the configuration of a local mirroring session on page 421 displays a local mirroring
configuration for a session configured as follows:

• Session number: 1

• Session name: Detail

• Classifier-based mirroring policy, "MirrorAdminTraffic", is used to select inbound traffic on port B1.

• Mirrored traffic is sent to exit port B3.

Figure 59: Displaying the configuration of a local mirroring session
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Viewing information on a classifier-based mirroring
session
In the following example, a classifier-based mirroring policy (mirrorAdminTraffic) mirrors selected inbound
IPv4 packets on VLAN 5 to the destination device configured for mirroring session 3.

Figure 60: Configuring a classifier-based mirroring policy in a local mirroring session

Displaying a classifier-based policy in a local mirroring session

switch(config)# show monitor 3

Network Monitoring

   Session: 3   Session Name: 
   Policy: MirrorAdminTraffic

     Mirror Destination:  C1   (Port) 

     Monitoring Sources  Direction
     ------------------  ---------
     VLAN: 5             Source

Viewing information about a classifier-based mirroring
configuration
Syntax

show class ipv4 classname
show class ipv6 classname
show class config

ipv4 classname Lists the statements that make up the IPv4 class identified by classname.

ipv6 classname Lists the statements that make up the IPv6 class identified by classname.

config Displays all classes, both IPv4 and IPv6, and lists the statements that make up
each class.
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Additional variants of the show class … command provide information on classes that are members of policies
that have been applied to ports or VLANs.

Figure 61: show class output for a mirroring policy

Viewing information about a classifier-based mirroring
configuration
Syntax

show policy policy-name
show policy config

policy-name Lists the statements that make up the specified policy.

config Displays the names of all policies defined for the switch and lists the statements that
make up each policy.

Additional variants of the show policy command provide information on policies that have been applied to ports
or VLANs.

Figure 62: show policy output for a mirroring policy

Viewing resource usage for mirroring policies
Syntax

show policy resources
Displays the number of hardware resources (rules, meters, and application port ranges) used by classifier-based
mirroring policies (local and remote) that are currently applied to interfaces on the switch, as well as QoS policies
and other software features.
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NOTE: The information displayed is the same as the output of the show qos resources and
show access-list resources commands.

Figure 63: Displaying the hardware resources used by currently configured mirroring policies

Viewing the mirroring configurations in the running
configuration file
Use the show run command to view the current mirroring configurations on the switch. In the show run
command output, information about mirroring sources in configured sessions begins with the mirror keyword;
monitored source interfaces are listed per-interface.

Compatibility mode
The following table shows how the v2 zl and zl modules behave in various combinations and situations when
Compatibility mode is enabled and when it is disabled.
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Table 28: Compatibility mode enabled/disabled comparisons

Modules Compatibility mode enabled Compatibility mode disabled

v2 zl modules
only

Can insert zl module and the module will come
up. Any v2 zl modules are limited to the zl
configuration capacities.

v2 zl modules are at full capacity. zl modules
are not allowed to power up.

Mixed v2 zl
and zl
modules

Can insert zl module and the module will come
up. Any v2 zl modules are limited to the zl
configuration capacities. If compatibility mode is
disabled, the zl modules go down.

ZL modules are not allowed to power up.

zl modules
only

Same as exists already. If a v2 zl module is
inserted, it operates in the same mode as the zl
module, but with performance increases.

The Management Module is the only module
that powers up.

In Compatibility Mode, no v2 zl features are
allowed, whether the modules are all v2 zl or
not.

If Compatibility Mode is disabled and then
enabled, the startup config is erased and the
chassis reboots.

Traffic mirroring overview
Traffic mirroring (Intelligent Mirroring) allows you to mirror (send a copy of) network traffic received or transmitted
on a switch interface to a local or remote destination, such as a traffic analyzer or IDS.)

Traffic mirroring provides the following benefits:

• Allows you to monitor the traffic flow on specific source interfaces.

• Helps in analyzing and debugging problems in network operation resulting from a misbehaving network or an
individual client. The mirroring of selected traffic to an external device makes it easier to diagnose a network
problem from a centralized location in a topology spread across a campus.

Mirroring overview
Figure 64: Local and remote sessions showing mirroring terms on page 426 shows an example of the terms
used to describe the configuration of a sample local and remote mirroring session:

• In the local session, inbound traffic entering Switch A is monitored on port A2 and mirrored to a destination
(host), traffic analyzer 1, through exit port A15 on the switch.A local mirroring session means that the
monitored interface (A2) and exit port (A15) are on the same switch.

• In the remote session, inbound traffic entering Switch A is monitored on port A1. A mirrored copy of monitored
traffic is routed through the network to a remote mirroring endpoint: exit port B7 on Switch B. A destination
device, traffic analyzer 2, is connected to the remote exit port.A remote mirroring session means that:
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◦ The monitored interface (A1) and exit port (B7) are on different switches.

◦ Mirrored traffic can be bridged or routed from a source switch to a remote switch.

Figure 64: Local and remote sessions showing mirroring terms

Mirroring destinations
Traffic mirroring supports destination devices that are connected to the local switch or to a remote switch:

Traffic can be copied to a destination (host) device connected to the same switch as the mirroring source in a
local mirroring session. You can configure up to four exit ports to which destination devices are connected.

Mirroring sources and sessions
Traffic mirroring supports the configuration of port in up to four mirroring sessions on a switch. Each session can
have one or more sources (ports and/or static trunks) that monitor traffic entering and/or leaving the switch.

NOTE: Using the CLI, you can make full use of the switch's local and remote mirroring capabilities.

Mirroring sessions
A mirroring session consists of a mirroring source and destination (endpoint.) Although a mirroring source can be
one of several interfaces, as mentioned above, for any session, the destination must be a single (exit) port. The
exit port cannot be a trunk.

You can map multiple mirroring sessions to the same exit port, which provides flexibility in distributing hosts, such
as traffic analyzers or an IDS. In a remote mirroring endpoint, the IP address of the exit port and the remote
destination switch.
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Mirroring sessions can have the same or a different destination. You can configure an exit port on the local
(source) switch and/or on a remote switch as the destination in a mirroring session. When configuring a mirroring
destination, consider the following options:

You can segregate traffic by type, direction, or source.

Mirroring session limits
A switch running software release K.12.xx or greater supports the following:

A maximum of one mirroring (local and remote) sessions.

Selecting mirrored traffic
You can use any of the following options to select the traffic to be mirrored on a port, trunk, mesh, or VLAN
interface in a local or remote session:

• All traffic

Monitors all traffic entering or leaving the switch on one or more interfaces (inbound and outbound.)

• Direction-based traffic selection

Monitors traffic that is either entering or leaving the switch (inbound or outbound.) Monitoring traffic in only one
direction improves operation by reducing the amount of traffic sent to a mirroring destination.

• MAC-based traffic selection

Monitors only traffic with a matching source and/or destination MAC address in packet headers entering and/or
leaving the switch on one or more interfaces (inbound and/or outbound.)

• Classifier-based service policy

Provides a finer granularity of match criteria to zoom in on a subset of a monitored port or VLAN traffic (IPv4 or
IPv6) and select it for local or remote mirroring (inbound only.)

Deprecation of ACL-based traffic selection

The use of ACLs for selecting traffic in a mirroring session has been deprecated and is replaced by the use of
advanced classifier-based service policies.

As with ACL criteria, classifier-based match/ignore criteria allow you to limit a mirroring session to selected
inbound packets on a given port or VLAN interface (instead of mirroring all inbound traffic on the interface.)

The following commands have been deprecated:

• interface port/trunk/mesh monitor ip access-group acl-name in mirror [1 - 4 |
name-str]

• vlan vid-# monitor ip access-group acl-name in mirror [1 - 4 | name-str]

After you install and boot release K.14.01 or greater, ACL-based local and remote mirroring sessions configured
on a port or VLAN interface are automatically converted to classifier-based mirroring policies.

If you are running software release K.13.XX or earlier, ACL permit/deny criteria are supported to select IP traffic
entering a switch to mirror in a local or remote session, using specified source and/or destination criteria.

Mirrored traffic destinations
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Local destinations
A local mirroring traffic destination is a port on the same switch as the source of the traffic being mirrored.

Remote destinations
A remote mirroring traffic destination is an switch configured to operate as the exit switch for mirrored traffic
sessions originating on other switches.

CAUTION: After you configure a mirroring session with traffic-selection criteria and a destination, the
switch immediately starts to mirror traffic to each destination device connected to an exit port. In a
remote mirroring session that uses IPv4 encapsulation, if the intended exit switch is not already
configured as the destination for the session, its performance may be adversely affected by the
stream of mirrored traffic. For this reason, Switch strongly recommends that you configure the exit
switch for a remote mirroring session before configuring the source switch for the same session.

Monitored traffic sources
You can configure mirroring for traffic entering or leaving the switch on:

Ports and static trunks

Provides the flexibility for mirroring on individual ports, groups of ports, static port trunks, or any combination of
these..

Criteria for selecting mirrored traffic
On the monitored sources listed above, you can configure the following criteria to select the traffic you want to
mirror:

• Direction of traffic movement (entering or leaving the switch, or both.)

• Type of IPv4 or IPv6 traffic entering the switch, as defined by a classifier-based service policy.

• Source and/or destination MAC addresses in packet headers.

Mirroring configuration
The table below shows the different types of mirroring that you can configure using the CLI, Menu, and SNMP
interfaces.

Table 29: Mirroring configuration options

Monitoring
interface and
configuration
level

Traffic selection
criteria

Traffic direction

CLI config Menu and web i/f
config 1

Snmp config

Port(s) Trunk(s)
Mesh

All traffic Not Applicable Not Applicable Not Applicable

1 Configures only session 1, and only for local mirroring.

Configuration notes

Using the CLI, you can configure all mirroring options on a switch.
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You can use the CLI can configure sessions 1 to 4 for local or remote mirroring in any combination, and override a
Menu configuration of session 1.

You can also use SNMP configure sessions 1 to 4 for local or remote mirroring in any combination and override a
Menu configuration of session 1, except that SNMP cannot be used to configure a classifier-based mirroring
policy.

Remote mirroring endpoint and intermediate devices
The remote mirroring endpoint that is used in a remote mirroring session must be an switch that supports the
mirroring functions described in this chapter. (A remote mirroring endpoint consists of the remote switch and exit
port connected to a destination device.) Because remote mirroring on an switch uses IPv4 to encapsulate
mirrored traffic sent to a remote endpoint switch, the intermediate switches and routers in a layer 2/3 domain can
be from any vendor if they support IPv4.

The following restrictions apply to remote endpoint switches and intermediate devices in a network configured for
traffic mirroring:

• The exit port for a mirroring destination must be an individual port and not a trunk, mesh, or VLAN interface.

• A switch mirrors traffic on static trunks, but not on dynamic LACP trunks.

• A switch mirrors traffic at line rate. When mirroring multiple interfaces in networks with high-traffic levels, it is
possible to copy more traffic to a mirroring destination than the link supports. However, some mirrored traffic
may not reach the destination. If you are mirroring a high-traffic volume, you can reduce the risk of
oversubscribing a single exit port by:
◦ Directing traffic from different session sources to multiple exit ports.

◦ Configuring an exit port with a higher bandwidth than the monitored source port.

Remote mirroring overview
To configure a remote mirroring session in which the mirroring source and destination are on different switches,
follow these general steps:

After you complete 5.b on page 430, the switch begins mirroring traffic to the remote destination (endpoint)
configured for the session.

1. Determine the IP addressing, UDP port number, and destination (exit) port number for the remote session:

a. Source VLAN or subnet IP address on the source switch.

b. Destination VLAN or subnet IP address on the destination switch.

c. Random UDP port number for the session (7933-65535.)

d. Remote mirroring endpoint: Exit port and IP address of the remote destination switch (In a remote mirroring
endpoint, the IP address of the exit port and remote switch can belong to different VLANs. Any loopback IP
address can be used except the default loopback address 127.0.0.1.)

Requirement: For remote mirroring, the same IP addressing and UDP port number must be configured on both
the source and destination switches.

2. On the remote destination (endpoint) switch, enter the mirror endpoint command with the information
from 1 on page 429 to configure a mirroring session for a specific exit port.

3. Determine the session (1 to 4) and (optional) alphanumeric name to use on the source switch.

4. Determine the traffic to be filtered by any of the following selection methods and the appropriate configuration
level (VLAN, port, mesh, trunk, global):
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a. Direction: inbound, outbound, or both.

b. Classifier-based mirroring policy: inbound only for IPv4 or IPv6 traffic.

c. MAC source and/or destination address: inbound, outbound, or both.

5. On the source switch:

a. Enter the mirror command with the session number (1 to 4) and the IP addresses and UDP port number
from 1 on page 429 to configure a mirroring session. If desired, enter the [truncation] parameter to
allow oversize packets to be truncated rather than dropped.

b. Enter one of the following commands to configure one or more of the traffic-selection methods in 4 on page
429 for the configured session:

interface port/trunk/mesh [monitor | service-policy policy-name in] vlan vid 
[monitor | service-policy policy-name in] monitor mac mac-addr

After you complete 5b, the switch begins mirroring traffic to the remote destination (endpoint) configured for the
session.

Quick reference to remote mirroring setup
Commands to configure mirroring for a remote session in which the mirroring source and destination are on
different switches:

• The mirror command identifies the destination in a mirroring session.

• The interface and vlan commands identify the monitored interface, traffic direction, and traffic-selection
criteria for a specified session.

CAUTION: When configuring a remote mirroring session, always configure the destination switch
first. Configuring the source switch first can result in a large volume of mirrored, IPv4-encapsulated
traffic arriving at the destination without an exit path, which can slow switch performance.

High-level overview of the mirror configuration process

Determine the mirroring session and destination

For a local mirroring session
Determine the port number for the exit port (such as A5, B10, and so forth).

For a remote mirroring session
Determine the following information and then go to.

• The IP address of the VLAN or subnet on which the exit port exists on the destination switch.

• The port number of the remote exit port on the remote destination switch. (In a remote mirroring endpoint, the
IP address of the exit port and the remote destination switch can belong to different VLANs.)

• The IP address of the VLAN or subnet on which the mirrored traffic enters or leaves the source switch.
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CAUTION: Although the switch supports the use of UDP port numbers from 1 to 65535, UDP port
numbers below 7933 are reserved for various IP applications. Using these port numbers for
mirroring can result in an interruption of other IP functions, and in non-mirrored traffic being
received on the destination (endpoint) switch and sent to the device connected to the remote exit
port.

• The unique UDP port number to use for the session on the source switch. (The recommended port range is
from 7933 to 65535.)

Configure a mirroring destination on a remote switch
This step is required only if you are configuring a remote mirroring session in which the exit port is on a different
switch than the monitored (source) interface.

For remote mirroring, you must configure the destination switch to recognize each mirroring session and forward
mirrored traffic to an exit port before you configure the source switch. Configure the destination switch with the
values you determined for remote mirroring in Determine the mirroring session and destination.

NOTE: A remote destination switch can support up to 32 remote mirroring endpoints (exit ports
connected to a destination device in a remote mirroring session.)

Configure a destination switch in a remote mirroring session
Enter the mirror endpoint ip command on the remote switch to configure the switch as a remote endpoint
for a mirroring session with a different source switch.

Configure a mirroring session on the source switch
To configure local mirroring, exit port number is all that is required.

If the exit port for a mirroring destination is on a remote switch instead of the local (source) switch, you must enter
the source IP address, destination IP address, and UDP port number for the remote mirroring session. You may
also wish to enable frame truncation to allow oversize frames to be truncated rather than dropped.

Frames that exceed the maximum size (MTU) are either dropped or truncated, according to the setting of the
[truncation] parameter in the mirror command.

Frames that are near the MTU size may become oversize when the 54-byte remote mirroring tunnel header is
added for transport between source switch and destination switch.

(The addition of the header is a frequent cause for frames becoming oversize, but note that all oversize frames,
whatever the cause of their excess size, are dropped or truncated.) If a frame is truncated, bytes are removed
from the end of the frame. This may cause the checksum in the original frame header to fail. Some protocol
analyzers may flag such a checksum mismatch as an alert.

NOTE: Note that if you enable jumbo frames to allow large frames to be transmitted, you must
enable jumbo frames on all switches in the path between source and destination switches.

Configure a source switch in a remote mirroring session
Enter the mirror remote ip command on the source switch to configure a remote destination switch for a
mirroring session on the source switch. The source IP address, UDP port number, and destination IP address that
you enter must be the same values that you entered with the mirror endpoint ip command.
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CAUTION: After you configure a mirroring session with traffic-selection criteria and a destination, the
switch immediately starts to mirror traffic to the destination device connected to each exit port. In a
remote mirroring session that uses IPv4 encapsulation, if the remote (endpoint) switch is not already
configured as the destination for the session, its performance may be adversely affected by the
stream of mirrored traffic. For this reason, Hewlett Packard Enterprise strongly recommends that you
configure the endpoint switch in a remote mirroring session, as described on the previous page in the
section titled "For a remote mirroring session", before using the mirror remote ip command in
this section to configure the mirroring source for the same session.

Configure the monitored traffic in a mirror session
This step configures one or more interfaces on a source switch with traffic-selection criteria to select the traffic to
be mirrored in a local or remote session configured in section.

Traffic selection options
To configure traffic mirroring, specify the source interface, traffic direction, and criteria to be used to select the
traffic to be mirrored by using the following options:

• Interface type
◦ Port, trunk, and/or mesh

◦ VLAN

◦ Switch (global configuration level)

• Traffic direction and selection criteria
◦ All inbound and/or outbound traffic on a port or VLAN interface

◦ Only inbound IP traffic selected with an ACL (deprecated in software release K.14.01 and greater)

◦ Only inbound IPv4 or IPv6 traffic selected with a classifier-based mirroring policy

◦ All inbound and/or outbound traffic selected by MAC source and/or destination address

The different ways to configure traffic-selection criteria on a monitored interface are described in the following
sections.

Mirroring-source restrictions
In a mirroring session, you can configure any of the following sources of mirrored traffic:

• Multiple port and trunk, and/or mesh interfaces

• One VLAN

If you configure a VLAN as the source interface in a mirroring session and assign a second VLAN to the
session, the second VLAN overwrites the first VLAN as the source of mirrored traffic.

• One classifier-based policy

If you configure a mirroring policy on a port or VLAN interface to mirror inbound traffic in a session, you cannot
configure a port, trunk, mesh, ACL, or VLAN as an additional source of mirrored traffic in the session.

• Up to 320 MAC addresses (used to select traffic according to source, destination MAC address, or both) in all
mirroring sessions configured on a switch
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About selecting all inbound/outbound traffic to mirror
If you have already configured session 1 with a local or remote destination, you can enter the vlan vid
monitor or interface port monitor command without additional parameters for traffic-selection criteria
and session number to configure mirroring for all inbound and outbound traffic on the specified VLAN or port
interfaces in session 1 with the preconfigured destination.

Untagged mirrored packets
Although a VLAN tag is added (by default) to the mirrored copy of untagged outbound packets to indicate the
source VLAN of the packet, it is sometimes desirable to have mirrored packets look exactly like the original
packet. The no-tag-added parameter gives you the option of not tagging mirrored copies of outbound packets,
as shown in Figure 65: Mirroring commands with the no-tag-added option on page 433 and Figure 66:
Displaying a mirror session configuration with the no-tag-added option on page 433.

Figure 65: Mirroring commands with the no-tag-added option

Figure 66: Displaying a mirror session configuration with the no-tag-added option

About using SNMP to configure no-tag-added
The MIB object hpicfBridgeDontTagWithVlan is used to implement the no-tag-added option, as shown below:

hpicfBridgeDontTagWithVlan OBJECT-TYPE
   SYNTAX INTEGER
     {
     enabled(1),
     disabled(2)
    }
   MAX-ACCESS  read-write
   STATUS   current
   DESCRIPTION
    "This oid mentions whether VLAN tag is part of the
   mirror'ed copy of the packet. The value ‘enabled'
   denotes that the VLAN tag shouldn't be part
   of the mirror'ed copy; ‘disabled' does put
   the VLAN tag in the mirror'ed copy. Only one
   logical port is allowed.
   This object is persistent and when written
   the entity
     SHOULD save the change to non-volatile storage."
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   DEFVAL { 2 }
  ::= { hpicfBridgeMirrorSessionEntry 2 }

Operating notes
The following conditions apply for the no-tag-added option:

• The specified port can be a physical port, trunk port, or mesh port.

• Only a single logical port (physical port or trunk) can be associated with a mirror session when the no-tag-
added option is specified. No other combination of ACL mirroring, VLAN mirroring, or port mirroring can be
associated with the mirror session. If more than one logical port is specified, the following error message is
displayed:

Cannot monitor more than one logical port with no-tag-added option

• If a port changes its VLAN membership and/or untagged status within the VLAN, the "untagged port mirroring"
associated with that port is updated when the configuration change is processed.

• Only four ports or trunks can be monitored at one time when all four mirror sessions are in use (one logical
port per mirror session) without VLAN tags being added to a mirrored copy.

• The no-tag-added option can also be used when mirroring is configured with SNMP.

• A VLAN tag is still added to the copies of untagged packets obtained via VLAN-based mirroring.

About selecting inbound/outbound traffic using a MAC address
Use the monitor mac mirror command at the global configuration level to apply a source and/or destination
MAC address as the selection criteria used in a local or remote mirroring session.

While classifier-based mirroring allows you to mirror traffic using a policy to specify IP addresses as selection
criteria, MAC-based mirroring allows you monitor switch traffic using a source and/or destination MAC address.
You can apply MAC-based mirroring in one or more mirroring sessions on the switch to monitor:

• Inbound traffic

• Outbound traffic

• Both inbound and outbound traffic

MAC-based mirroring is useful in Switch Network Immunity security solutions that provide detection and response
to malicious traffic at the network edge. After isolating a malicious MAC address, a security administrator can
mirror all traffic sent to and received from the suspicious address for troubleshooting and traffic analysis.

The MAC address that you enter with the monitor mac mirror command is configured to select traffic for
mirroring from all ports and learned VLANs on the switch. Therefore, a suspicions MAC address used in wireless
applications can be continuously monitored as it re-appears in switch traffic on different ports or VLAN interfaces.

You can configure MAC-based mirroring from the CLI or an SNMP management station and use it to mirror:

• All inbound and outbound traffic from a group of hosts to one destination device.

• Inbound and/or outbound traffic from each host to a different destination device.

• Inbound and outbound traffic from all monitored hosts separately on two destination devices: mirroring all
inbound traffic to one device and all outbound traffic to another device.

Restrictions

The following restrictions apply to MAC-based mirroring:
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• Up to 320 different MAC addresses are supported for traffic selection in all mirroring sessions configured on
the switch.

• A destination MAC address is not supported as mirroring criteria for routed traffic, because in routed packets,
the destination MAC address is changed to the next-hop address when the packet is forwarded. Therefore, the
destination MAC address that you want to mirror will not appear in routed packet headers.

This restriction also applies to the destination MAC address of a host that is directly connected to a routing
switch. (Normally, a host is connected to an edge switch, which is directly connected to the router.)

To mirror routed traffic, we recommend that you use classifier-based policies to select IPv4 or IPv6 traffic for
mirroring, as described in.

• On a switch, you can use a MAC address only once as a source MAC address and only once as a destination
MAC address to filter mirrored traffic.

For example, after you enter the following commands:

monitor mac 111111-222222 src mirror 1
monitor mac 111111-222222 dest mirror 2
The following commands are not supported:

monitor mac 111111-222222 src mirror 3
monitor mac 111111-222222 dest mirror 4
In addition, if you enter the monitor mac 111111-222222 both mirror 1 command, you cannot use
the MAC address 111111-222222 in any other monitor mac mirror configuration commands on the
switch.

• To re-use a MAC address that has already been configured as a source and/or destination address for traffic
selection in a mirror session, you must first remove the configuration by entering the no form of the command
and then re-enter the MAC address in a new monitor mac mirror command.

For example, if you have already configured MAC address 111111-222222 to filter inbound and outbound
mirrored traffic, and you decide to use it to filter only inbound traffic in a mirror session, you could enter the
following commands:

monitor mac 111111-222222 both mirror 1
no monitor mac 111111-222222 both mirror 1
monitor mac 111111-222222 src mirror 1

• A mirroring session in which you configure MAC-based mirroring is not supported on a port, trunk, mesh, or
VLAN interface on which a mirroring session with a classifier-based mirroring policy is configured.

About selecting inbound traffic using advanced classifier-based mirroring
In addition to the traffic selection options, traffic mirroring supports the use of advanced classifier-based functions
that provide:

• A finer granularity for selecting the inbound IP traffic that you want to mirror on an individual port or VLAN
interface (instead of mirroring all inbound traffic on the interface)

• Support for mirroring both IPv4 and IPv6 traffic

• The ability to re-use the same traffic classes in different software-feature configurations; for example, you can
apply both a QoS rate-limiting and mirroring policy on the same class of traffic.
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Classifier-based mirroring policies provide greater precision when analyzing and debugging a network traffic
problem. Using multiple match criteria, you can finely select and define the classes of traffic that you want to
mirror on a traffic analyzer or IDS device.

Classifier-based mirroring configuration
1. Evaluate the types of traffic in your network and identify the traffic types that you want to mirror.
2. Create an IPv4 or IPv6 traffic class using the class command to select the packets that you want to mirror in

a session on a preconfigured local or remote destination device.

A traffic class consists of match criteria, which consist of match and ignore commands.

• match commands define the values that header fields must contain for a packet to belong to the class and
be managed by policy actions.

• ignore commands define the values which, if contained in header fields, exclude a packet from the policy
actions configured for the class.

NOTE: Be sure to enter match/ignore statements in the precise order in which you want their
criteria to be used to check packets.

The following match criteria are supported in match/ignore statements for inbound IPv4/IPv6 traffic:

• IP source address (IPv4 and IPv6)

• IP destination address (IPv4 and IPv6)

• IP protocol (such as ICMP or SNMP)

• Layer 3 IP precedence bits

• Layer 3 DSCP codepoint

• Layer 4 TCP/UDP application port (including TCP flags)

• VLAN ID

Enter one or more match or ignore commands from the class configuration context to filter traffic and
determine the packets on which policy actions will be performed.

3. Create a mirroring policy to configure the session and destination device to which specified classes of inbound
traffic are sent by entering the policy mirror command from the global configuration context.

NOTE: Be sure to enter each class and its associated mirroring actions in the precise order in
which you want packets to be checked and processed.

To configure the mirroring actions that you want to execute on packets that match the criteria in a specified
class, enter one or more class action mirror commands from the policy configuration context.

You can configure only one mirroring session (destination) for each class. However, you can configure the
same mirroring session for different classes.

A packet that matches the match criteria in a class is mirrored to the exit (local or remote) port that has been
previously configured for the session, where session value is 1 or a text string (if you configured the session
with a name when you entered the mirror command.)

Prerequisite: The local or remote exit port for a session must be already configured before you enter the
mirror session parameter in a class action statement:
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• In a local mirroring session, the exit port is configured with the mirror <session-number> port
command

• In a remote mirroring session, the remote exit port is configured with the mirror endpoint ip and
mirror <session-number> remote ip commands.

Restriction: In a policy, you can configure only one mirroring session per class. However, you can configure the
same session for different classes.

Mirroring is not executed on packets that match ignore criteria in a class.

The execution of mirroring actions is performed in the order in which the classes are numerically listed in the
policy.

The complete no form of the class action mirror command or the no <seq-number> command
removes a class and mirroring action from the policy configuration.

To manage packets that do not match the match or ignore criteria in any class in the policy, and therefore have
no mirroring actions performed on them, you can enter an optional default class. The default class is placed at
the end of a policy configuration and specifies the mirroring actions to perform on packets that are neither
matched nor ignored.

4. (Optional) To configure a default-class in a policy, enter the default-class command at the end of a policy
configuration and specify one or more actions to be executed on packets that are not matched and not
ignored.

Prerequisite: The local or remote exit port for a session must be already configured with a destination device
before you enter the mirror <session> parameter in a default-class action statement.

5. Apply the mirroring policy to inbound traffic on a port (interface service-policy in command) or VLAN
(vlan service-policy in command) interface.

CAUTION: After you apply a mirroring policy for one or more preconfigured sessions on a port or
VLAN interface, the switch immediately starts to use the traffic-selection criteria and exit port to
mirror traffic to the destination device connected to each exit port.

In a remote mirroring session that uses IPv4 encapsulation, if the remote switch is not already
configured as the destination for the session, its performance may be adversely affected by the
stream of mirrored traffic.

For this reason, Hewlett Packard Enterprise strongly recommends that you first configure the exit
switch in a remote mirroring session before you apply a mirroring service policy on a port or VLAN
interface.

Restrictions: The following restrictions apply to a mirroring service policy:

• Only one mirroring policy is supported on a port or VLAN interface.

• If you apply a mirroring policy to a port or VLAN interface on which a mirroring policy is already configured,
the new policy replaces the existing one.

• A mirroring policy is supported only on inbound traffic.

Because only one mirroring policy is supported on a port or VLAN interface, ensure that the policy you want to
apply contains all the required classes and actions for your configuration.

Classifier-based mirroring restrictions
The following restrictions apply to mirroring policies configured with the classifier-based model:
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• A mirroring policy is supported only on inbound IPv4 or IPv6 traffic.

• A mirroring policy is not supported on a meshed port interface. (Classifier-based policies are supported only on
a port, VLAN, or trunk interface.)

• Only one classifier-based mirroring policy is supported on a port or VLAN interface. You can, however, apply a
classifier-based policy of a different type, such as QoS.

• You can enter multiple class action mirror statements in a policy.

◦ You can configure only one mirroring session (destination) for each class.

◦ You can configure the same mirroring session for different classes.

• If a mirroring session is configured with a classifier-based mirroring policy on a port or VLAN interface, no
other traffic-selection criteria (MAC-based or all inbound and/or outbound traffic) can be added to the session.

Figure 67: Mirroring configuration in which only a mirroring policy is supported

• If a mirroring session is already configured with one or more traffic-selection criteria (MAC-based or all inbound
and/or outbound traffic), the session does not support the addition of a classifier-based policy.

Figure 68: Mirroring configuration in which only traffic-selection criteria are supported

About applying multiple mirroring sessions to an interface
You can apply a mirroring policy to an interface that is already configured with another traffic-selection method
(MAC-based or all inbound and/or outbound traffic) for a different mirroring session.

The classifier-based policy provides a finer level of granularity that allows you to zoom in on a subset of port or
VLAN traffic and select it for local or remote mirroring.
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In the following example, traffic on Port b1 is used as the mirroring source for two different, local mirroring
sessions:

• All inbound and outbound traffic on Ports b1, b2, and b3 is mirrored in session 4.

• Only selected voice traffic on Port b1 is mirrored in session 2.

Figure 69: Example of applying multiple sessions to the same interface

Mirroring configuration examples

Local mirroring using traffic-direction criteria

An administrator wants to mirror the inbound traffic from workstation "X" on port A5 and workstation "Y" on port
B17 to a traffic analyzer connected to port C24 (see Figure 70: Local mirroring topology on page 439.) In this
case, the administrator chooses "1" as the session number. (Any unused session number from 1 to 4 is valid.)
Because the switch provides both the source and destination for the traffic to monitor, local mirroring can be used.
In this case, the command sequence is:

• Configure the local mirroring session, including the exit port.

• Configure the monitored source interfaces for the session.

Figure 70: Local mirroring topology

Figure 71: Configuring a local mirroring session for all inbound and outbound port traffic
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Remote mirroring using a classifier-based policy

In the network shown in the figure below, an administrator has connected a traffic analyzer to port A15 (in VLAN
30) on switch C to monitor the TCP traffic to the server at 10.10.30.153 from workstations connected to switches
A and B. Remote mirroring sessions are configured on switches A and B, and a remote mirroring endpoint on
switch C. TCP traffic is routed through the network to the server from VLANs 10 and 20 on VLAN 30.

Figure 72: Sample topology in a remote mirroring session

To configure this remote mirroring session using a classifier-based policy to select inbound TCP traffic on two
VLAN interfaces, take the following steps:

1. On remote switch C, configure a remote mirroring endpoint using port A15 as the exit port (as described in 
Configure a mirroring destination on a remote switch on page 431.)

Figure 73: Configuring a remote mirroring endpoint: remote switch and exit port

2. On source switch A, configure an association between the remote mirroring endpoint on switch C and a
mirroring session on switch A (as described in Configure a mirroring session on the source switch on
page 431.)
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3. On switch A, configure a classifier-based mirroring policy to select inbound TCP traffic destined to the server at
10.10.30.153, and apply the policy to the interfaces of VLAN 10 (as described in About selecting inbound
traffic using advanced classifier-based mirroring on page 435.)

Figure 74: Configuring a classifier-based policy on source switch A

4. On source switch B, repeat steps 2 and 3:

a. Configure an association between the remote mirroring endpoint on switch C and a mirroring session on
switch B.

b. Configure a classifier-based mirroring policy to select inbound TCP traffic destined to the server at
10.10.30.153, and apply the policy to a VLAN interface for VLAN 20.
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Because the remote session has mirroring sources on different switches, you can use the same session
number (1) for both sessions.

Figure 75: Configuring a classifier-based policy on source switch B

Remote mirroring using traffic-direction criteria

In the network shown in the figure below, the administrator connects another traffic analyzer to port B10 (in VLAN
40) on switch C to monitor all traffic entering switch A on port C12. For this mirroring configuration, the
administrator configures a mirroring destination (with a remote exit port of B10) on switch C, and a remote
mirroring session on switch A.

If the mirroring configuration in the proceeding example is enabled, it is necessary to use a different session
number (2) and UDP port number (9400.) (The IP address of the remote exit port [10.10.40.7] connected to traffic
analyzer 2 [exit port B10] can belong to a different VLAN than the destination IP address of the VLAN used to
reach remote switch C [10.20.40.1]).

Figure 76: Sample topology for remote mirroring from a port interface

To configure this remote mirroring session using a directional-based traffic selection on a port interface, the
operator must take the following steps:
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1. On remote switch C, configure the remote mirroring endpoint using port B10 as the exit port for a traffic
analyzer (as described in Configure a mirroring destination on a remote switch on page 431):

Figure 77: Configuring a remote mirroring endpoint

2. On source switch A, configure session 2 to use UDP port 9400 to reach the remote mirroring endpoint on
switch C (10.10.40.1):

mirror 2 remote ip 10.10.10.119 9400 10.10.40.1
3. On source switch A, configure the local port C12 to select all inbound traffic to send to the preconfigured

mirroring destination for session 2:

interface c12 monitor all in mirror 2
Figure 78: Configuring a remote mirroring session for inbound port traffic

Maximum supported frame size
The IPv4 encapsulation of mirrored traffic adds a 54-byte header to each mirrored frame. If a resulting frame
exceeds the MTU allowed in the network, the frame is dropped or truncated.

NOTE:

Oversized mirroring frames are dropped or truncated, according to the setting of the [truncation]
parameter in the mirror command. Also, remote mirroring does not allow downstream devices in a
mirroring path to fragment mirrored frames.

If jumbo frames are enabled on the mirroring source switch, the mirroring destination switch and all
downstream devices connecting the source switch to the mirroring destination must be configured to
support jumbo frames.
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Enabling jumbo frames to increase the mirroring path MTU
On 1-Gbps and 10-Gbps ports in the mirroring path, you can reduce the number of dropped frames by enabling
jumbo frames on all intermediate switches and routers. (The MTU on the switches covered by this manual is 9220
bytes for frames having an 802.1Q VLAN tag, and 9216 bytes for untagged frames.)

Table 30: Maximum frame sizes for mirroring

Frame type
configuration

Maximum
frame size

VLAN tag Frame
mirrored
to local
port

Frame mirrored to remote
port

Data Data IPv4 header

Untagged Non-jumbo (default
config.)

1518 0 1518 1464 54

Jumbo on all VLANs 9216 0 9216 9162 54

Jumbo11 On all but
source VLAN

1518 0 n/a 1464 54

Tagged Non-jumbo 1522 4 1522 1468 54

Jumbo11 on all VLANs 9220 4 9218 9164 54

Jumbo11 On all but
source VLAN

1522 4 n/a22 1468 54

1 Jumbo frames are allowed on ports operating at or above 1 Gbps
2 For local mirroring, a non-jumbo configuration on the source VLAN dictates an MTU of 1518 bytes for untagged frames, and

an MTU of 1522 for tagged frames, regardless of the jumbo configuration on any other VLANs on the switch.

Effect of downstream VLAN tagging on untagged,
mirrored traffic
In a remote mirroring application, if mirrored traffic leaves the switch without 802.1Q VLAN tagging, but is
forwarded through a downstream device that adds 802.1Q VLAN tags, the MTU for untagged mirrored frames
leaving the source switch is reduced below the values shown in Maximum frame sizes for mirroring.
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For example, if the MTU on the path to the destination is 1522 bytes, untagged mirrored frames leaving the
source switch cannot exceed 1518 bytes. Likewise, if the MTU on the path to the destination is 9220 bytes,
untagged mirrored frames leaving the source switch cannot exceed 9216 bytes.

Figure 79: Effect of downstream VLAN tagging on the MTU for mirrored traffic

Operating notes for traffic mirroring
• Mirroring dropped traffic

When an interface is configured to mirror traffic to a local or remote destination, packets are mirrored
regardless of whether the traffic is dropped while on the interface. For example, if an ACL is configured on a
VLAN with a deny ACE that eliminates packets from a Telnet application, the switch still mirrors the Telnet
packets that are received on the interface and subsequently dropped.

• Mirroring and spanning tree

Mirroring is performed regardless of the STP state of a port or trunk. This means, for example, that inbound
traffic on a port blocked by STP can still be monitored for STP packets during the STP setup phase.

• Tagged and untagged frames

For a frame entering or leaving the switch on a mirrored port, the mirrored copy retains the tagged or untagged
state the original frame carried when it entered into or exited from the switch. (The tagged or untagged VLAN
membership of ports in the path leading to the mirroring destination does not affect the tagged or untagged
status of the mirrored copy itself.)

Thus, if a tagged frame arrives on a mirrored port, the mirrored copy is also tagged, regardless of the status of
ports in the destination path. If a frame exits from the switch on a mirrored port that is a tagged member of a
VLAN, the mirrored copy is also tagged for the same reason.

To prevent a VLAN tag from being added to the mirrored copy of an outbound packet sent to a mirroring
destination, you must enter the no-tag-added parameter when you configure a port, trunk, or mesh interface
to select mirrored traffic.

• Effect of IGMP on mirroring

If both inbound and outbound mirroring is operating when IGMP is enabled on a VLAN, two copies of mirrored
IGMP frames may appear at the mirroring destination.

• Mirrored traffic not encrypted

Mirrored traffic undergoes IPv4 encapsulation, but mirrored encapsulated traffic is not encrypted.

• IPv4 header added

The IPv4 encapsulation of mirrored traffic adds a 54-byte header to each mirrored frame. If a resulting frame
exceeds the maximum MTU allowed in the network, it is dropped or truncated (according to the setting of the
[truncation] parameter in the mirror command.)
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To reduce the number of dropped frames, enable jumbo frames in the mirroring path, including all intermediate
switches and/or routers. (The MTU on the switch is 9220 bytes, which includes 4 bytes for the 802.1Q VLAN
tag.)

• Intercepted or injected traffic

The mirroring feature does not protect against either mirrored traffic being intercepted or traffic being injected
into a mirrored stream by an intermediate host.

• Inbound mirrored IPv4-encapsulated frames are not mirrored

The switch does not mirror IPv4-encapsulated mirrored frames that it receives on an interface. This prevents
duplicate mirrored frames in configurations where the port connecting the switch to the network path for a
mirroring destination is also a port whose inbound or outbound traffic is being mirrored.

For example, if traffic leaving the switch through ports B5, B6, and B7 is being mirrored through port B7 to a
network analyzer, the mirrored frames from traffic on ports B5 and B6 will not be mirrored a second time as
they pass through port B7.

• Switch operation as both destination and source

A switch configured as a remote destination switch can also be configured to mirror traffic to one of its own
ports (local mirroring) or to a destination on another switch (remote mirroring.)

• Monitor command note

If session 1 is already configured with a destination, you can enter the [no] vlan <VID>monitor or [no]
interface <PORT> monitor command without mirroring criteria and a mirror session number. In this
case, the switch automatically configures or removes mirroring for inbound and outbound traffic from the
specified VLAN or ports to the destination configured for session 1.

• Loss of connectivity suspends remote mirroring

When a remote mirroring session is configured on a source switch, the switch sends an ARP request to the
configured destination approximately every 60 seconds. If the source switch fails to receive the expected ARP
response from the destination for the session, transmission of mirrored traffic in the session halts. However,
because the source switch continues to send ARP requests for each configured remote session, link
restoration or discovery of another path to the destination enables the source switch to resume transmitting the
session's mirrored traffic after a successful ARP response cycle occurs.

Note that if a link's connectivity is repeatedly interrupted ("link toggling"), little or no mirrored traffic may be
allowed for sessions using that link. To verify the status of any mirroring session configured on the source
switch, use the show monitor command.

Troubleshooting traffic mirroring
Cause

If mirrored traffic does not reach the configured remote destination (endpoint) switch or remote exit port, check the
following configurations:

• The configured remote exit port must not be a member of a trunk or mesh.

• If the destination for mirrored traffic is on a different VLAN than the source, routing must be correctly
configured along the path from the source to the destination.

CAUTION: A mirroring exit port should be connected only to a network analyzer, IDS, or other
network edge device that has no connection to other network resources. Configuring a mirroring exit
port connection to a network can result in serious network performance problems, and is strongly
discouraged.
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Interface monitoring features
You can designate monitoring of inbound and outbound traffic on:

Ports and static trunks: Allows monitoring of individual ports, groups of contiguous ports, and static port trunks.

The switch monitors network activity by copying all traffic inbound and outbound on the specified interfaces to the
designated monitoring port, to which a network analyzer can be attached.

If a tagged packet arrives on a monitored port, the packet will remain tagged when it goes out a monitored port
even if that port is configured as untagged. If the packet is untagged, it will remain untagged going out the monitor
port. The monitor port state (tagged or untagged) does not affect the tagging of the packet. However, egress
mirroring does not reflect the tagged or untagged characteristic to the mirror port, instead it reflects the tagged or
untagged characteristic of the mirror port.

NOTE: When both inbound and outbound monitoring is done, and IGMP is enabled on any VLAN,
you may get two copies of IGMP packets on the monitored port.

Port trunks cannot be used as a monitoring port.

The switch can monitor static LACP trunks, but not dynamic LACP trunks.

It is possible, when monitoring multiple interfaces in networks with high traffic levels, to copy more
traffic to a monitor port than the link can support. In this case, some packets may not be copied to
the monitor port.

Configuring port and static trunk monitoring (CLI)
You must use the following configuration sequence to configure port and static trunk monitoring in the CLI:

1. Assign a monitoring (mirror) port.

2. Designate the port(s) and/or static trunk(s) to monitor.

Displaying the monitoring configuration
Syntax:

show monitor
This command lists the port assigned to receive monitored traffic and the ports and/or trunks being monitored.

For example, if you assign port 5 as the monitoring port and configure the switch to monitor ports 2-4, show
monitor displays the following:

Monitored port listing

switch(config)# show monitor

 Network Monitoring Port

  Mirror Port: 5 1

  Monitoring sources 2
  ------------------
  2
  3
  4
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• 1Port receiving monitored traffic.

• 2Monitored Ports

Configuring the monitor port
Syntax:

[no] mirror-port [< port-num >]
This command assigns or removes a monitoring port, and must be executed from the global configuration level.
Removing the monitor port disables port monitoring and resets the monitoring parameters to their factory-default
settings.

For example, to assign port 6 as the monitoring port:

switch(config)# mirror-port 6
To turn off monitoring:

switch(config)# no mirror-port

Selecting or removing monitoring source interfaces
After you configure a monitor port you can use either the global configuration level or the interface context level to
select ports, static trunks, or VLANs as monitoring sources. You can also use either level to remove monitoring
sources.

Syntax:

[no] interface <monitor-list> monitor

<monitor-list> Includes port numbers and static trunk names such as 4, 7, 5-8, trk1.

NOTE: Individual ports and static trunks can be monitored at the same time. However, if you
configure the switch to monitor a VLAN, all other interfaces are removed from monitoring. Also, you
can configure only one VLAN at a time for monitoring.

Elements in the monitor list can include port numbers and static trunk names at the same time.

For example, with a port such as port 5 configured as the monitoring (mirror) port, you would use either of the
following commands to select these interfaces for monitoring:

• Ports 6-9, and 14

• Trunk 2

Selecting ports and static trunks as monitoring sources

switch(config)# int 6-9, 14 trk2, monitor
To monitor a VLAN:

Configuring VLAN monitoring

switch(config)# vlan 20 monitor 
switch(config)# show monitor
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 Network Monitoring Port

  Mirror Port: 5

  Monitoring sources
  ------------------
  VLAN_20

Disabling monitoring at the interface context and the global config level

switch(eth-1-3, 5)# no int 5 monitor 1
switch(eth-1-3, 5)# no monitor

switch(config)# no int 5 monitor 2
switch(config)# no int 1-3, 5 monitor

• 1These two commands show how to disable monitoring at the interface context level for a single port or all
ports in an interface context level.

• 2These two commands show how to disable monitoring at the global config level for a single port or a group of
ports.

Fans
There are three fan types:

• Power supply fans

• Fan-tray fans

• Stacking switch fans

show system

Syntax
show system [chassislocate | information | temperature]

Description

Shows global system information and operational parameters for the switch.

Command context
manager and operator

Parameters
chassislocate

Shows the chassis locator LED status. Possible values are ON, Off, and Blink. When the status is On or Blink,
the number of minutes that the Locator LED will continue to be on or to blink is displayed.

information
Displays global system information and operational parameters for the switch.

temperature
Shows system temperature and settings.
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Usage

• To show system fans, see show system fans

• To show chassis power supply and settings, see show system power-supply

• To show system fans for VSF members, see show system fans vsf

Examples

Locating the system chassis by LED blink using the show system chassislocate command.

Showing the general switch system information by using the show system command.

show system fans
Syntax
show system fans

Description

Shows the state, status, and location of system fans.

Command context
manager and operator
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Usage

Command can be executed using various command contexts. See examples for use of command context PoEP
and VSF.

Examples

The state of all system fans is shown by using the command show system fans.

Switch# show system fans

Fan Information
  Num  | State       | Failures | Location 
-------+-------------+----------+----------
Fan-1  | Fan OK      |   0      | Fan Tray
Fan-2  | Fan OK      |   0      | Fan Tray
Fan-3  | Fan OK      |   0      | Fan Tray
Fan-4  | Fan OK      |   0      | Fan Tray
Fan-5  | Fan OK      |   0      | Fan Tray
Fan-6  | Fan OK      |   0      | Fan Tray
Fan-7  | Fan Removed |   0      | PS 1
Fan-8  | Fan Failed  |   2      | PS 2
Fan-9  | Fan OK      |   0      | PS 3
Fan-10 | Fan OK      |   0      | PS 4

1 / 10 Fans in Failure State
1 / 10 Fans have been in Failure State
The state of all system fans within the PoEP context is shown by using the command show system fans.

Switch(PoEP)# show system fans

Fan Information
  Num  | State       | Failures | Location
-------+-------------+---------------------
Fan-1  | Fan OK      |   0      | Chassis
Fan-2  | Fan OK      |   0      | Chassis
Fan-3  | Fan OK      |   0      | Chassis
Fan-4  | Fan Removed |   0      | PS 1
Fan-5  | Fan Failed  |   2      | PS 2

1 / 5 Fans in Failure State
1 / 5 Fans have been in Failure State
The state of all stacked switch system fans is shown by using the command show system fans within the
stacked context.

Switch(stacked)# show system fans                                          

Fan Information
Member  1

  Num  | State       | Failures | Location
-------+-------------+---------------------
Sys-1  | Fan OK      |   0      | Chassis
Sys-2  | Fan OK      |   0      | Chassis
Sys-3  | Fan OK      |   0      | Chassis
Sys-4  | Fan Removed |   0      | PS 1
Sys-5  | Fan Failed  |   2      | PS 2

0 / 5 Fans in Failure State
0 / 5 Fans have been in Failure State
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Member  2

  Num  | State       | Failures | Location
-------+-------------+---------------------
Sys-1  | Fan OK      |   0      | Chassis
Sys-2  | Fan OK      |   0      | Chassis
Sys-3  | Fan OK      |   0      | Chassis
Sys-4  | Fan OK      |   0      | PS 1
Sys-5  | Fan OK      |   0      | PS 2

0 / 5 Fans in Failure State
0 / 5 Fans have been in Failure State
The state of all VSF switch members system fans is shown by using the command show system fans from
within the VSF context.

VSF-Switch# show system fans

Fan Information
VSF-Member  1

  Num  | State       | Failures | Location
-------+-------------+----------+---------
Sys-1  | Fan OK      |   0      | Fan Tray
Sys-2  | Fan OK      |   0      | Fan Tray
Sys-3  | Fan OK      |   0      | Fan Tray
Sys-4  | Fan OK      |   0      | Fan Tray
Sys-5  | Fan Removed |   0      | PS 1
Sys-6  | Fan Failed  |   2      | PS 2

1 / 6 Fans in Failure State
1 / 6 Fans have been in Failure State

VSF-Member  2

  Num  | State       | Failures | Location
-------+-------------+----------+---------
Sys-1  | Fan OK      |   0      | Fan Tray
Sys-2  | Fan OK      |   0      | Fan Tray
Sys-3  | Fan OK      |   0      | Fan Tray
Sys-4  | Fan OK      |   0      | Fan Tray
Sys-5  | Fan OK      |   0      | PS 1
Sys-6  | Fan OK      |   0      | PS 2

0 / 6 Fans in Failure State
0 / 6 Fans have been in Failure State

show system power-supply
Syntax
show system power-supply [detailed | fahrenheit]

Description

Shows power supply information in either full detail or full detail in Fahrenheit only. Default temperature is
displayed in degrees Celsius.

Command context
manager and operator
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Parameters
detailed

Shows detailed switch power supply sensor information.

fahrenheit
Shows detailed switch power supply sensor information with temperatures in degrees Fahrenheit.

Usage

• The show system power-supply detailed command shows detailed information for the local power
supplies only.

• The show system power-supply detailed command shows detailed information for power supplies in
the powered state only.

Examples

Use of the command show system power-supply shows the power supply status for all active switches.

Switch# show system power-supply

Power Supply Status:

 PS#    Model      Serial          State         AC/DC  + V    Wattage
 ---- --------- ------------ ----------------- -------------- ---------
   1   J9828A    IN30G4D009   Powered           AC 120V/240V      700
   2   J9828A    IN30G4D00C   Powered           AC 120V/240V      700
   3                          Not Present       -- ---------        0
   4   J9830A    IN43G4G05H   Powered           AC 120V/240V     2750

   3 /  4 supply bays delivering power.
   Total power: 4150 W

Use of the command show system power-supply detailed shows the power supply status in detail for all
active switches.

Switch# show system power-supply detailed                        

 Status and Counters - Power Supply Detailed Information 

  PS# Model   Serial      State        Status
  --- ------- ----------- ------------ -------------------------------------
  1   J9828A  IN30G4D009  Powered      AC Power Consumption : 44 Watts      
                                       AC MAIN Voltage      : 209 Volts     
                                       Power Supplied       : 31 Watts      
                                       Power Capacity       : 700 Watts     
                                       Inlet Temp (C/F)     : 27.0C/80.6F   
                                       Internal Temp (C/F)  : 30.5C/86.0F   
                                       Fan 1 Speed          : 1600 RPM (47%) 
                                       Fan 2 Speed          : 1600 RPM (47%) 

  2   J9828A  IN30G4D00C  Powered      AC Power Consumption : 46 Watts
                                       AC MAIN Voltage      : 209 Volts
                                       Power Supplied       : 21 Watts
                                       Power Capacity       : 700 Watts
                                       Inlet Temp (C/F)     : 27.7C/80.6F
                                       Internal Temp (C/F)  : 32.5C/89.6F
                                       Fan 1 Speed          : 1600 RPM (47%)
                                       Fan 2 Speed          : 1600 RPM (47%)
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  3                       Not Present

  4   J9830A  IN43G4G05H  Powered      AC Power Consumption : 90 Watts
                                       AC MAIN/AUX Voltage  : 210/118 Volts
                                       Power Supplied       : 16 Watts
                                       Power Capacity       : 2750 Watts
                                       Inlet Temp (C/F)     : 30.9C/86.0F
                                       Internal Temp (C/F)  : 65.6C/149.0F
                                       Fan 1 Speed          : 2000 RPM (37%)
                                       Fan 2 Speed          : 1950 RPM (36%)

   3 /  4 supply bays delivering power.
   Currently supplying 68 W / 4150 W total power.
Use of the command show system power-supply fahrenheit shows the power supply status in
Fahrenheit for all active switches.

Switch# show system power-supply detailed fahrenheit
Power Supply Status:
 Mem PS# Model   Serial      State        Status
 --- --- ------- ----------- ------------ -----------------------------------
 1   1   J9830A  IN5BGZ81KZ  Powered      Power Consumption   : 95 Watts
                                          AC MAIN/AUX Voltage : 118/208 Volts
                                          Inlet/Internal Temp : 85.6F/87.7F 
                                          Fan 1 Speed (util)  : 1650RPM (20%)
                                          Fan 2 Speed (util)  : 1600RPM (19%)     

 1   2   J9829A  IN5BGZ81KX  Powered      Power Consumption   : 51 Watts
                                          AC Input Voltage    : 208 Volts
                                          Inlet/Internal Temp : 85.6F/87.7F 
                                          Fan 1 Speed (util)  : 1650RPM (20%)
                                          Fan 2 Speed (util)  : 1600RPM (19%)

 1   3   J9828A  IN5BGZ81KY  Powered      Power Consumption   : 43 Watts
                                          AC Input Voltage    : 119 Volts
                                          Inlet/Internal Temp : 85.6F/87.7F 
                                          Fan 1 Speed (util)  : 1650RPM (20%)
                                          Fan 2 Speed (util)  : 1600RPM (19%)

 1   4                       Not Present

 2   1   J9830A  IN5BGZ81KZ  Powered      Power Consumption   : 95 Watts
                                          AC MAIN/AUX Voltage : 118/208 Volts
                                          Inlet/Internal Temp : 85.6F/87.7F 
                                          Fan 1 Speed (util)  : 1650RPM (20%)
                                          Fan 2 Speed (util)  : 1600RPM (19%)

 2   2   J9829A  IN5BGZ81KX  Powered      Power Consumption   : 51 Watts
                                          AC Input Voltage    : 208 Volts
                                          Inlet/Internal Temp : 85.6F/87.7F 
                                          Fan 1 Speed (util)  : 1650RPM (20%)
                                          Fan 2 Speed (util)  : 1600RPM (19%)

 2   3   J9828A  IN5BGZ81KY  Powered      Power Consumption   : 43 Watts
                                          AC Input Voltage    : 119 Volts
                                          Inlet/Internal Temp : 85.6F/87.7F 
                                          Fan 1 Speed (util)  : 1650RPM (20%)
                                          Fan 2 Speed (util)  : 1600RPM (19%)
 2   4                       Not Present
------------------------------------------------------------------------------
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   6 / 8 supply bays delivering power.
   Total Input Power: 378 Watts
Use of the command show system power-supply detailed shows the power supply status all active
switches including a nonpowered J9830A PSU.

switch# show system power-supply detailed                        

 Status and Counters - Power Supply Detailed Information 

  PS# Model   Serial      State        Status
  --- ------- ----------- ------------ -------------------------------------
  1   J9828A  IN30G4D009  Powered      AC Power Consumption : 44 Watts      
                                       AC MAIN Voltage      : 209 Volts     
                                       Power Supplied       : 31 Watts      
                                       Power Capacity       : 700 Watts     
                                       Inlet Temp (C/F)     : 27.0C/80.6F   
                                       Internal Temp (C/F)  : 30.5C/86.0F   
                                       Fan 1 Speed          : 1600 RPM 
                                       Fan 2 Speed          : 1600 RPM

  2   J9828A  IN30G4D00C  Powered      AC Power Consumption : 46 Watts
                                       AC MAIN Voltage      : 209 Volts
                                       Power Supplied       : 21 Watts
                                       Power Capacity       : 700 Watts
                                       Inlet Temp (C/F)     : 27.7C/80.6F
                                       Internal Temp (C/F)  : 32.5C/89.6F
                                       Fan 1 Speed          : 1600 RPM
                                       Fan 2 Speed          : 1600 RPM

  3                       Not Present

  4   J9830A  IN43G4G05H  Aux Not Powered 

   2 /  4 supply bays delivering power.
   Currently supplying 68 W / 4150 W total power.
Use of the command show system power-supply shows the power supply status all active switches with
power supply #2 showing permanent failure.

switch# show system power-supply

Power Supply Status:

 PS#    Model      Serial          State         AC/DC  + V    Wattage
 ---- --------- ------------ ----------------- -------------- ---------
   1                          Not Present       -- ---------        0
   2   J9829A    IN30G4D00C   Permanent Failure  AC 120V/240V     1100
   3   J9829A    IN30G4D00D   Powered           -- ---------       1100
   4   J9829A    IN43G4G05H   Powered           AC 120V/240V      1100

   3 /  4 supply bays delivering power.
   Total power: 3300 W
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Table 31: Field key for output of show system power-supply detailed

Field Description

AC Power
Consumption

Actual power consumed from AC input

AC MAIN/AUX
Voltage

Actual voltage measured on AC Input:
• Two voltages are displayed for PS#4, as the J9830A includes two

AC input IEC connectors.

• Most power-supplies contain a single AC Input IEC connector and
are labeled MAIN.

Power Supplied Actual voltage being supplied from the power-supply to the switch for
general power and PoE.

Power Capacity The maximum power that the power-supply can provide to the switch.

Inlet Temp (C/F) The thermal sensor at the inlet of the power-supply - shown in both
Celsius and Fahrenheit

Internal Temp
(C/F)

The thermal sensor internal to the power-supply (will vary depending
upon the model) - shown in both Celsius and Fahrenheit.

NOTE: There is no "Output Temperature Sensor" on
either the 5400R or 3810M switches.

Fan Speed Shows the current fan speed in RPM and the percent of total fan speed
utilization. For PSUs that contain more than one fan, a separate line
will be included for each.

Currently
Supplying

A summary of the total power being supplied and the total capacity
(same summary as seen on the command show system power-
supply).

Fan failures and SNMP traps

Power supply fan-fault

Power supply events indicating an internal fan-fault are reported by SNMP traps issued up to 10 seconds after the
corresponding power supply fan fault occures.

For single event power supply fan faults, a corresponding SNMP trap is issued.

Single event and corresponding SNMP trap issued for a power supply fan-fault and recovery

Shown is a fan-fault (fan 1 of 2) and spontaneous recovery a few seconds after within power supply in bay
number 2. The event is issued as informative (I).

I 11/30/16 14:01:59 02778 chassis: AM1: Internal power supply 2: Fan 1 OK.

Fan-tray fan-fault events

For single event fan-tray fan-faults, the corresponding SNMP traps are issued only for fans within the fan-tray.

Single event and corresponding SNMP trap issued for a fan-tray fan-fault and recovery

Shown is a fan-tray fan-fault (fan number 3) and spontaneous recovery a few seconds after. The event is issued
as "Informative" (I).
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I 11/30/16 14:03:08 00070 chassis: AM1: Fan OK: Fan: 3  Failures: 1
Shown is a fan-tray fan-fault (fan number 3) failure. The event is issued as a "Warning" (w).

W 11/30/16 14:02:38 00070 chassis: AM1: Fan failure: Fan: 3 Failures: 1
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Overview
This chapter addresses performance-related network problems that can be caused by topology, switch
configuration, and the effects of other devices or their configurations on switch operation. (For switch-specific
information on hardware problems indicated by LED behavior, cabling requirements, and other potential
hardware-related problems, see the installation guide you received with the switch.)

NOTE: Switch software updates are periodically places on the Switch Networking website. It is
recommended that you check this website for software updates that may have fixed a problem you
are experiencing.

For information on support and warranty provisions, see the Support and Warranty booklet shipped with the
switch.

Troubleshooting approaches
Cause

Use these approaches to diagnose switch problems:

• Check the HPE website for software updates that may have solved your problem: http://www.hpe.com/
networking

• Check the switch LEDs for indications of proper switch operation:
◦ Each switch port has a Link LED that should light whenever an active network device is connected to the

port.

◦ Problems with the switch hardware and software are indicated by flashing the Fault and other switch
LEDs.For a description of the LED behavior and information on using the LEDs for troubleshooting, see the
installation guide shipped with the switch.

• Check the network topology/installation. For topology information, see the installation guide shipped with the
switch.

• Check cables for damage, correct type, and proper connections. You should also use a cable tester to check
your cables for compliance to the relevant IEEE 802.3 specification. For correct cable types and connector pin-
outs, see the installation guide shipped with the switch.

• Use the Port Utilization Graph and Alert Log in the WebAgent included in the switch to help isolate problems.
These tools are available through the WebAgent:
◦ Port Utilization Graph

◦ Alert log

◦ Port Status and Port Counters screens

◦ Diagnostic tools (Link test, Ping test, configuration file browser)

• For help in isolating problems, use the easy-to-access switch console built into the switch or Telnet to the
switch console. For operating information on the Menu and CLI interfaces included in the console, see
chapters 3 and 4. These tools are available through the switch console:

Chapter 13
Troubleshooting
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◦ Status and Counters screens

◦ Event Log

◦ Diagnostics tools (Link test, Ping test, configuration file browser, and advanced user commands)

Browser or Telnet access problems

Cannot access the WebAgent
• Access may be disabled by the Web Agent Enabled parameter in the switch console. Check the setting on this

parameter by selecting:

2. Switch Configuration

1. System Information

• The switch may not have the correct IP address, subnet mask, or gateway. Verify by connecting a console to
the switch's Console port and selecting:

2. Switch Configuration

5. IP Configuration

Note: If DHCP/Bootp is used to configure the switch, the IP addressing can be verified by selecting:

1. Status and Counters...

2. Switch Management Address Information

Also check the DHCP/Bootp server configuration to verify correct IP addressing.

• If you are using DHCP to acquire the IP address for the switch, the IP address "lease time" may have expired
so that the IP address has changed. For more information on how to "reserve" an IP address, see the
documentation for the DHCP application that you are using.

• If one or more IP-authorized managers are configured, the switch allows inbound telnet access only to a
device having an authorized IP address. For more information on IP Authorized managers, see the access
security guide for your switch.

• Java™ applets may not be running on the web browser. They are required for the switch WebAgent to operate
correctly. Refer to the online Help on your web browser for how to run the Java applets.

Cannot Telnet into the switch console from a station on the network
• Off-subnet management stations can lose Telnet access if you enable routing without first configuring a static

(default) route. That is, the switch uses the IP default gateway only while operating as a Layer 2 device. While
routing is enabled on the switch, the IP default gateway is not used. You can avoid this problem by using the ip
route command to configure a static (default) route before enabling routing. For more information, see "IP
Routing Features" in the multicast and routing guide for your switch.

• Telnet access may be disabled by the Inbound Telnet Enabled parameter in the System Information
screen of the menu interface:

2. Switch Configuration

1. System Information

• The switch may not have the correct IP address, subnet mask, or gateway. Verify by connecting a console to
the switch's Console port and selecting:

2. Switch Configuration
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5. IP Configuration

• If you are using DHCP to acquire the IP address for the switch, the IP address "lease time" may have expired
so that the IP address has changed. For more information on how to "reserve" an IP address, see the
documentation for the DHCP application that you are using.

• If one or more IP-authorized managers are configured, the switch allows inbound telnet access only to a
device having an authorized IP address. For more information on IP Authorized managers, see the access
security guide for your switch.

Unusual network activity
Network activity that fails to meet accepted norms may indicate a hardware problem with one or more of the
network components, possibly including the switch. Such problems can also be caused by a network loop or
simply too much traffic for the network as it is currently designed and implemented. Unusual network activity is
usually indicated by the LEDs on the front of the switch or measured with the switchconsole interface or with a
network management tool. For information on using LEDs to identify unusual network activity, see the installation
guide you received with the switch.

A topology loop can also cause excessive network activity. The Event Log "FFI" messages can be indicative of
this type of problem.

General problems

The network runs slow; processes fail; users cannot access servers or other devices
Broadcast storms may be occurring in the network. These may be caused by redundant links between nodes.

• If you are configuring a port trunk, finish configuring the ports in the trunk before connecting the related cables.
Otherwise you may inadvertently create a number of redundant links (that is, topology loops) that will cause
broadcast storms.

• Turn on STP to block redundant links

• Check for FFI messages in the Event Log

Duplicate IP addresses
This is indicated by this Event Log message:

ip: Invalid ARP source: IP address on IP address
where both instances of IP address are the same address, indicating that the switch's IP address has been
duplicated somewhere on the network.

Duplicate IP addresses in a DHCP network
If you use a DHCP server to assign IP addresses in your network, and you find a device with a valid IP address
that does not appear to communicate properly with the server or other devices, a duplicate IP address may have
been issued by the server. This can occur if a client has not released a DHCP-assigned IP address after the
intended expiration time and the server "leases" the address to another device. This can also happen, For
example, if the server is first configured to issue IP addresses with an unlimited duration, and then is
subsequently configured to issue IP addresses that will expire after a limited duration. One solution is to configure
"reservations" in the DHCP server for specific IP addresses to be assigned to devices having specific MAC
addresses. For more information, see the documentation for the DHCP server.

One indication of a duplicate IP address in a DHCP network is this Event Log message:

ip: Invalid ARP source: <IP-address>
       on <IP-address>
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where both instances of IP-address are the same address, indicating that the IP address has been duplicated
somewhere on the network.

The switch has been configured for DHCP/Bootp operation, but has not received a
DHCP or Bootp reply
When the switch is first configured for DHCP/Bootp operation, or if it is rebooted with this configuration, it
immediately begins sending request packets on the network. If the switch does not receive a reply to its DHCP/
Bootp requests, it continues to periodically send request packets, but with decreasing frequency. Thus, if a DHCP
or Bootp server is not available or accessible to the switch when DHCP/Bootp is first configured, the switch may
not immediately receive the desired configuration.

After verifying that the server has become accessible to the switch, reboot the switch to re-start the process.

802.1Q Prioritization problems

Ports configured for non-default prioritization (level 1 to 7) are not performing the
specified action
If the ports were placed in a trunk group after being configured for non-default prioritization, the priority setting
was automatically reset to zero (the default). Ports in a trunk group operate only at the default priority setting.

Addressing ACL problems

ACLs are properly configured and assigned to VLANs, but the switch is not using the
ACLs to filter IP layer 3 packets

Procedure

1. The switch may be running with IP routing disabled. To ensure that IP routing is enabled, execute show
running and look for the IP routing statement in the resulting listing. For Example:
Indication that routing is enabled

switch(config)# show running
Running configuration:
; J9091A Configuration Editor; Created on release #XX.15.06
hostname "Switch"
ip default-gateway 10.33.248.1
ip routing 1
logging 10.28.227.2
snmp-server community "public" Unrestricted
ip access-list extended "Controls for VLAN 20"
permit tcp 0.0.0.0 255.255.255.255 10.10.20.98 0.0.0.0 eq 80
permit tcp 0.0.0.0 255.255.255.255 10.10.20.21 0.0.0.0 eq 80
deny tcp 0.0.0.0 255.255.255.255 10.10.20.1 0.0.0.255 eq 80
deny tcp 10.10.20.1? 0.0.0.0 10.10.10.100 0.0.0.0 eq 20 log
deny tcp 10.10.20.20 0.0.0.0 10.10.10.100 0.0.0.0 eq 20 log
deny tcp 10.10.20.43 0.0.0.0 10.10.10.100 0.0.0.0 eq 20 log
permit ip 10.10.20.1 0.0.0.255 10.10.10.100 0.0.0.0
deny ip 10.10.30.1 0.0.0.255 10.10.10.100 0.0.0.0
permit ip 10.10.30.1 0.0.0.255 10.10.10.1 0.0.0.255
exit

1
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Indicates that routing is enabled, a requirement for ACL operation. (There is an exception. Refer to the Note,
below.)

NOTE: If an ACL assigned to a VLAN includes an ACE referencing an IP address on the switch
itself as a packet source or destination, the ACE screens traffic to or from this switch address
regardless of whether IP routing is enabled. This is a security measure designed to help protect
the switch from unauthorized management access.

If you need to configure IP routing, execute the ip routing command.

2. ACL filtering on the switches applies only to routed packets and packets having a destination IP address (DA)
on the switch itself.

Also, the switch applies assigned ACLs only at the point where traffic enters or leaves the switch on a VLAN.
Ensure that you have correctly applied your ACLs ("in" and/or "out") to the appropriate VLANs.

The switch does not allow management access from a device on the same VLAN
The implicit deny any function that the switch automatically applies as the last entry in any ACL always blocks
packets having the same DA as the switch's IP address on the same VLAN. That is, bridged packets with the
switch itself as the destination are blocked as a security measure.

To preempt this action, edit the ACL to include an ACE that permits access to the switch's DA on that VLAN from
the management device.

Error (Invalid input) when entering an IP address
When using the "host" option in the Command syntax, ensure that you are not including a mask in either dotted
decimal or CIDR format. Using the "host" option implies a specific host device and therefore does not permit any
mask entry.

Correctly and incorrectly specifying a single host

Switch(config)# access-list 6 permit host 10.28.100.100 1

Switch(config)# access-list 6 permit host 10.28.100.100 255.255.255.2552 
Invalid input: 255.255.255.255

Switch(config)# access-list 6 permit host 10.28.100.100/32 3
Invalid input: 10.28.100.100/32

• 1Correct.

• 2Incorrect. No mask needed to specify a single host.

• 3Incorrect. No mask needed to specify a single host.

Apparent failure to log all "deny" matches
Where the log statement is included in multiple ACEs configured with a "deny" option, a large volume of "deny"
matches generating logging messages in a short period of time can impact switch performance. If it appears that
the switch is not consistently logging all "deny" matches, try reducing the number of logging actions by removing
the log statement from some ACEs configured with the "deny" action.
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The switch does not allow any routed access from a specific host, group of hosts, or
subnet
The implicit deny any function that the switch automatically applies as the last entry in any ACL may be blocking
all access by devices not specifically permitted by an entry in an ACL affecting those sources. If you are using the
ACL to block specific hosts, a group of hosts, or a subnet, but want to allow any access not specifically permitted,
insert permit any as the last explicit entry in the ACL.

The switch is not performing routing functions on a VLAN
Two possible causes of this problem are:

• Routing is not enabled. If show running indicates that routing is not enabled, use the ip routing
command to enable routing.

• An ACL may be blocking access to the VLAN (on a switch covered in this guide). Ensure that the switch's IP
address on the VLAN is not blocked by one of the ACE entries in an ACL applied to that VLAN. A common
mistake is to either not explicitly permit the switch's IP address as a DA or to use a wildcard ACL mask in a
deny statement that happens to include the switch's IP address. For an Example: of this problem, see section
"General ACL Operating Notes" in the "Access Control Lists (ACLs)" of the latest access security guide for
your switch.

Routing through a gateway on the switch fails
Configuring a "deny" ACE that includes a gateway address can block traffic attempting to use the gateway as a
next-hop.

Remote gateway case
Configuring ACL "101" (example below) and applying it outbound on VLAN 1 in the figure below includes the
router gateway (10.0.8.1) needed by devices on other networks. This can prevent the switch from sending ARP
and other routing messages to the gateway router to support traffic from authorized remote networks.

In Figure 80: Inadvertently blocking a gateway on page 463, this ACE (see data in bold below) denies access
to the 10 Net's 10.0.8.1 router gateway needed by the 20 Net (Subnet mask is 255.255.255.0).See: example

Figure 80: Inadvertently blocking a gateway

To avoid inadvertently blocking the remote gateway for authorized traffic from another network (such as the 20
Net in this Example:):
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Procedure

1. Configure an ACE that specifically permits authorized traffic from the remote network.

2. Configure narrowly defined ACEs to block unwanted IP traffic that would otherwise use the gateway; such
ACEs might deny traffic for a particular application, particular hosts, or an entire subnet.

3. Configure a "permit any" ACE to specifically allow any IP traffic to move through the gateway.

ACE blocking an entire subnet

switch(config)# access-list config

ip access-list extended "101"
  deny ip 0.0.0.0 255.255.255.255 10.0.8.30 0.0.0.255
  permit ip 0.0.0.0 255.255.255.255 0.0.0.00 255.255.255.255
  exit
      

Local gateway case
If you use the switch as a gateway for traffic you want routed between subnets, use these general steps to avoid
blocking the gateway for authorized applications:

Procedure

1. Configure gateway security first for routing with specific permit and deny statements.

2. Permit authorized traffic.

3. Deny any unauthorized traffic that you have not already denied in step 1.

IGMP-related problems

IP multicast (IGMP) traffic that is directed by IGMP does not reach IGMP hosts or a
multicast router connected to a port
IGMP must be enabled on the switch and the affected port must be configured for "Auto" or "Forward" operation.

IP multicast traffic floods out all ports; IGMP does not appear to filter traffic
The IGMP feature does not operate if the switch or VLAN does not have an IP address configured manually or
obtained through DHCP/Bootp. To verify whether an IP address is configured for the switch or VLAN, do one of
the following:

• Try using the WebAgent: If you can access the WebAgent, then an IP address is configured.

• Try to telnet to the switch console: If you can Telnet to the switch, an IP address is configured.

• Use the switch console interface: From the Main Menu, check the Management Address Information screen
by clicking on:

1. Status and Counters

2. Switch Management Address Information

LACP-related problems
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Unable to enable LACP on a port with the interface <port-number> lacp
command
In this case, the switch displays the following message:

Operation is not allowed for a trunked port.
You cannot enable LACP on a port while it is configured as a static Trunk port. To enable LACP on a static-
trunked port:

Procedure

1. Use the no trunk <port-number> command to disable the static trunk assignment.

2. Execute interface <port-number> lacp .

CAUTION: Removing a port from a trunk without first disabling the port can create a traffic loop that
can slow down or halt your network. Before removing a port from a trunk, Hewlett Packard Enterprise
recommends that you either disable the port or disconnect it from the LAN.

Port-based access control (802.1X)-related problems
NOTE:

To list the 802.1X port-access Event Log messages stored on the switch, use show log 802.

See also Radius-related problems on page 467.

The switch does not receive a response to RADIUS authentication requests
In this case, the switch attempts authentication using the secondary method configured for the type of access you
are using (console, Telnet, or SSH).

There can be several reasons for not receiving a response to an authentication request. Do the following:

• Use ping to ensure that the switch has access to the configured RADIUS servers.

• Verify that the switch is using the correct encryption key (RADIUS secret key) for each server.

• Verify that the switch has the correct IP address for each RADIUS server.

• Ensure that the radius-server timeout period is long enough for network conditions.

The switch does not authenticate a client even though the RADIUS server is properly
configured and providing a response to the authentication request
If the RADIUS server configuration for authenticating the client includes a VLAN assignment, ensure that the
VLAN exists as a static VLAN on the switch. See "How 802.1X Authentication Affects VLAN Operation" in the
access security guide for your switch.

During RADIUS-authenticated client sessions, access to a VLAN on the port used for
the client sessions is lost
If the affected VLAN is configured as untagged on the port, it may be temporarily blocked on that port during an
802.1X session. This is because the switch has temporarily assigned another VLAN as untagged on the port to
support the client access, as specified in the response from the RADIUS server. See "How 802.1X Authentication
Affects VLAN Operation" in the access security guide for your switch.

Chapter 13 Troubleshooting 465

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 7062



The switch appears to be properly configured as a supplicant, but cannot gain access
to the intended authenticator port on the switch to which it is connected
If aaa authentication port-access is configured for Local, ensure that you have entered the local login
(operator-level) username and password of the authenticator switch into the identity and secret parameters
of the supplicant configuration. If instead, you enter the enable (manager-level) username and password, access
will be denied.

The supplicant statistics listing shows multiple ports with the same authenticator MAC
address
The link to the authenticator may have been moved from one port to another without the supplicant statistics
having been cleared from the first port. See "Note on Supplicant Statistics" in the chapter on Port-Based and
User-Based Access Control in the access security guide for your switch.

The show port-access authenticator <port-list> command shows one or
more ports remain open after they have been configured with control unauthorized
802.1X is not active on the switch. After you execute aaa port-access authenticator active, all ports
configured with control unauthorized should be listed as Closed.

Authenticator ports remain "open" until activated

switch(config)# show port-access authenticator e 9
 Port Access Authenticator Status
  Port-access authenticator activated [No] : No
              Access Authenticator Authenticator
  Port Status Control  State Backend  State
  ---- ------ -------- -------------- --------------
  9    Open 1   FU       Force Auth     Idle

Switch(config)# show port-access authenticator active
Switch(config)# show port-access authenticator e 9
 Port Access Authenticator Status
  Port-access authenticator activated [No] : Yes
              Access Authenticator Authenticator
  Port Status Control  State Backend  State
  ---- ------ -------- -------------- --------------
  9    Closed FU       Force Unauth   Idle

1Port A9 shows an “Open” status even though Access Control is set to Unauthorized (Force Auth). This is
because the port-access authenticator has not yet been activated.

RADIUS server fails to respond to a request for service, even though the server's IP
address is correctly configured in the switch
Use show radius to verify that the encryption key (RADIUS secret key) the switch is using is correct for the
server being contacted. If the switch has only a global key configured, it either must match the server key or you
must configure a server-specific key. If the switch already has a server-specific key assigned to the server's IP
address, it overrides the global key and must match the server key.

Displaying encryption keys

switch(config)# show radius
 Status and Counters - General RADIUS Information
  Deadtime(min) : 0
  Timeout(secs) : 5
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  Retransmit Attempts : 3
  Global Encryption Key : My-Global-Key
  Dynamic Authorization UDP Port : 3799

                  Auth Acct DM/ Time
  Server IP Addr  Port Port CoA Window Encryption Key
  --------------- ---- ---- --- ------ ---------------
  10.33.18.119    1812 1813            119-only-key
Also, ensure that the switch port used to access the RADIUS server is not blocked by an 802.1X configuration on
that port. For example, show port-access authenticator <port-list> gives you the status for the
specified ports. Also, ensure that other factors, such as port security or any 802.1X configuration on the RADIUS
server are not blocking the link.

The authorized MAC address on a port that is configured for both 802.1X and port
security either changes or is re-acquired after execution of aaa port-access
authenticator <port-list> initialize
If the port is force-authorized with aaa port-access authenticator <port-list> control
authorized command and port security is enabled on the port, then executing initialize causes the port to
clear the learned address and learn a new address from the first packet it receives after you execute
initialize.

A trunked port configured for 802.1X is blocked
If you are using RADIUS authentication and the RADIUS server specifies a VLAN for the port, the switch allows
authentication, but blocks the port. To eliminate this problem, either remove the port from the trunk or reconfigure
the RADIUS server to avoid specifying a VLAN.

QoS-related problems

Loss of communication when using VLAN-tagged traffic
If you cannot communicate with a device in a tagged VLAN environment, ensure that the device either supports
VLAN tagged traffic or is connected to a VLAN port that is configured as Untagged.

Radius-related problems

The switch does not receive a response to RADIUS authentication requests
In this case, the switch attempts authentication using the secondary method configured for the type of access you
are using (console, Telnet, or SSH).

There can be several reasons for not receiving a response to an authentication request. Do the following:

• Use ping to ensure that the switch has access to the configured RADIUS server.

• Verify that the switch is using the correct encryption key for the designated server.

• Verify that the switch has the correct IP address for the RADIUS server.

• Ensure that the radius-server timeout period is long enough for network conditions.

• Verify that the switch is using the same UDP port number as the server.
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NOTE: Because of an inconsistency between the Windows XP 802.1x supplicant timeout value and
the switch default timeout value, which is 5, when adding a backup RADIUS server, set the switch
radius-server timeout value to 4. Otherwise, the switch may not failover properly to the backup
RADIUS server.

RADIUS server fails to respond to a request for service, even though the server's IP
address is correctly configured in the switch
Use show radius to verify that the encryption key the switch is using is correct for the server being contacted. If
the switch has only a global key configured, it either must match the server key or you must configure a server-
specific key. If the switch already has a server-specific key assigned to the server's IP address, it overrides the
global key and must match the server key.

Global and unique encryption keys

Switch(config)# show radius
 Status and Counters - General RADIUS Information
  Deadtime(min) : 0
  Timeout(secs) : 5
  Retransmit Attempts : 3
  Global Encryption Key : My-Global-Key 1
  Dynamic Authorization UDP Port : 3799

                  Auth Acct DM/ Time
  Server IP Addr  Port Port CoA Window Encryption Key
  --------------- ---- ---- --- ------ ---------------
  10.33.18.119    1812 1813            119-only-key 2

• 1

Global RADIUS Encryption Key

• 2

Unique RADIUS Encryption Key for the RADIUS server at 10.33.18.119

MSTP and fast-uplink problems
CAUTION:

If you enable MSTP, Hewlett Packard Enterprise recommends that you leave the remainder of the
MSTP parameter settings at their default values until you have had an opportunity to evaluate MSTP
performance in your network. Because incorrect MSTP settings can adversely affect network
performance, you should avoid making changes without having a strong understanding of how MSTP
operates. To learn the details of MSTP operation, see the IEEE802.1s standard.

Broadcast storms appearing in the network
This can occur when there are physical loops (redundant links) in the topology. Where this exists, you should
enable MSTP on all bridging devices in the topology to detect the loop.

STP blocks a link in a VLAN even though there are no redundant links in that VLAN
In 802.1Q-compliant switches, MSTP blocks redundant physical links even if they are in separate VLANs. A
solution is to use only one, multiple-VLAN (tagged) link between the devices. Also, if ports are available, you can
improve the bandwidth in this situation by using a port trunk. See "Spanning Tree Operation with VLANs" in
"Static Virtual LANs (VLANs)" in the advanced traffic management guide for your switch.
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Fast-uplink troubleshooting
Some of the problems that can result from incorrect use of fast-uplink MSTP include temporary loops and
generation of duplicate packets.

Problem sources can include:

• Fast-uplink is configured on a switch that is the MSTP root device.

• Either the Hello Time or the Max Age setting (or both) is too long on one or more switches. Return the
Hello Time and Max Age settings to their default values (2 seconds and 20 seconds, respectively, on a
switch).

• A "downlink" port is connected to a switch that is further away (in hop count) from the root device than the
switch port on which fast-uplink MSTP is configured.

• Two edge switches are directly linked to each other with a fast-uplink (Mode = Uplink) connection.

• Fast uplink is configured on both ends of a link.

• A switch serving as a backup MSTP root switch has ports configured for fast-uplink MSTP and has become
the root device because of a failure in the original root device.

SSH-related problems

Switch access refused to a client
Even though you have placed the client's public key in a text file and copied the file (using the copy tftp pub-
key-file command) into the switch, the switch refuses to allow the client to have access. If the source SSH
client is an SSHv2 application, the public key may be in the PEM format, which the switch (SSHv1) does not
interpret. Check the SSH client application for a utility that can convert the PEM-formatted key into an ASCII-
formatted key.

Executing IP SSH does not enable SSH on the switch
The switch does not have a host key. Verify by executing show ip host-public-key. If you see the message

ssh cannot be enabled until a host key is configured (use 'crypto' command).
you need to generate an SSH key pair for the switch. To do so, execute crypto key generate (see
"Generating the switch's public and private key pair" in the SSH chapter of the access security guide for your
switch.)

Switch does not detect a client's public key that does appear in the switch's public key
file (show ip client-public-key)
The client's public key entry in the public key file may be preceded by another entry that does not terminate with a
new line (CR). In this case, the switch interprets the next sequential key entry as simply a comment attached to
the preceding key entry. Where a public key file has more than one entry, ensure that all entries terminate with a
new line (CR). While this is optional for the last entry in the file, not adding a new line to the last entry creates an
error potential if you either add another key to the file at a later time or change the order of the keys in the file.

An attempt to copy a client public-key file into the switch has failed and the switch lists
one of the following messages
Download failed: overlength key in key file.
Download failed: too many keys in key file.
Download failed: one or more keys is not a valid RSA public key.
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The public key file you are trying to download has one of the following problems:

• A key in the file is too long. The maximum key length is 1024 characters, including spaces. This could also
mean that two or more keys are merged together instead of being separated by a <CR> <LF>.

• There are more than ten public keys in the key file.

• One or more keys in the file is corrupted or is not a valid rsa public key.

Client ceases to respond ("hangs") during connection phase
The switch does not support data compression in an SSH session. Clients often have compression turned on by
default, but then disable it during the negotiation phase. A client that does not recognize the compression-request
FAILURE response may fail when attempting to connect. Ensure that compression is turned off before attempting
a connection to prevent this problem.

TACACS-related problems

Event Log
When troubleshooting TACACS+ operation, check the switch's Event Log for indications of problem areas.

All users are locked out of access to the switch
If the switch is functioning properly, but no username/password pairs result in console or Telnet access to the
switch, the problem may be caused by how the TACACS+ server and/or the switch are configured. Use one of the
following methods to recover:

• Access the TACACS+ server application and adjust or remove the configuration parameters controlling access
to the switch.

• If the above method does not work, try eliminating configuration changes in the switch that have not been
saved to flash (boot-up configuration) by causing the switch to reboot from the boot-up configuration (which
includes only the configuration changes made prior to the last write memory command.) If you did not use
write memory to save the authentication configuration to flash, pressing the Reset button reboots the
switch with the boot-up configuration.

• Disconnect the switch from network access to any TACACS+ servers and then log in to the switch using either
Telnet or direct console port access. Because the switch cannot access a TACACS+ server, it defaults to local
authentication. You can then use the switch's local Operator or Manager username/password pair to log on.

• As a last resort, use the Clear/Reset button combination to reset the switch to its factory default boot-up
configuration. Taking this step means you will have to reconfigure the switch to return it to operation in your
network.

No communication between the switch and the TACACS+ server application
If the switch can access the server device (that is, it can ping the server), a configuration error may be the
problem. Some possibilities include:

• The server IP address configured with the switch's tacacs-serverhost command may not be correct. (Use
the switch's show tacacs-server command to list the TACACS+ server IP address.)

• The encryption key configured in the server does not match the encryption key configured in the switch (by
using the tacacs-server key command). Verify the key in the server and compare it to the key configured
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in the switch. (Use show tacacs-server to list the global key. Use show config or show config
running to list any server-specific keys.)

• The accessible TACACS+ servers are not configured to provide service to the switch.

Access is denied even though the username/password pair is correct
Some reasons for denial include the following parameters controlled by your TACACS+ server application:

• The account has expired.

• The access attempt is through a port that is not allowed for the account.

• The time quota for the account has been exhausted.

• The time credit for the account has expired.

• The access attempt is outside of the time frame allowed for the account.

• The allowed number of concurrent logins for the account has been exceeded.

For more help, see the documentation provided with your TACACS+ server application.

Unknown users allowed to login to the switch
Your TACACS+ application may be configured to allow access to unknown users by assigning them the privileges
included in a default user profile. See the documentation provided with your TACACS+ server application.

System allows fewer login attempts than specified in the switch configuration
Your TACACS+ server application may be configured to allow fewer login attempts than you have configured in
the switch with the aaa authentication num-attempts command.

TimeP, SNTP, or Gateway problems

The switch cannot find the time server or the configured gateway
TimeP, SNTP, and Gateway access are through the primary VLAN, which in the default configuration is the
DEFAULT_VLAN. If the primary VLAN has been moved to another VLAN, it may be disabled or does not have
ports assigned to it.

VLAN-related problems

Monitor port
When using the monitor port in a multiple-VLAN environment, the switch handles broadcast, multicast, and
unicast traffic output from the monitor port as follows:

• If the monitor port is configured for tagged VLAN operation on the same VLAN as the traffic from monitored
ports, the traffic output from the monitor port carries the same VLAN tag.

• If the monitor port is configured for untagged VLAN operation on the same VLAN as the traffic from the
monitored ports, the traffic output from the monitor port is untagged.

• If the monitor port is not a member of the same VLAN as the traffic from the monitored ports, traffic from the
monitored ports does not go out the monitor port.
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None of the devices assigned to one or more VLANs on an 802.1Q-compliant switch are
being recognized
If multiple VLANs are being used on ports connecting 802.1Q-compliant devices, inconsistent VLAN IDs may
have been assigned to one or more VLANs. For a given VLAN, the same VLAN ID must be used on all connected
802.1Q-compliant devices.

Link configured for multiple VLANs does not support traffic for one or more VLANs
One or more VLANs may not be properly configured as "Tagged" or "Untagged." A VLAN assigned to a port
connecting two 802.1Q-compliant devices must be configured the same on both ports. For example, VLAN_1 and
VLAN_2 use the same link between switch "X" and switch "Y," as shown in Figure 81: Example: of correct
VLAN port assignments on a link on page 472.

Figure 81: Example: of correct VLAN port assignments on a link

• If VLAN_1 (VID=1) is configured as "Untagged" on port 3 on switch "X," it must also be configured as
"Untagged" on port 7 on switch "Y." Make sure that the VLAN ID (VID) is the same on both switches.

• Similarly, if VLAN_2 (VID=2) is configured as "Tagged" on the link port on switch "A," it must also be configured
as "Tagged" on the link port on switch "B." Make sure that the VLAN ID (VID) is the same on both switches.

Duplicate MAC addresses across VLANs
The switches operate with multiple forwarding databases. Thus, duplicate MAC addresses occurring on different
VLANs can appear where a device having one MAC address is a member of more than one 802.1Q VLAN, and
the switch port to which the device is linked is using VLANs (instead of MSTP or trunking) to establish redundant
links to another switch. If the other device sends traffic over multiple VLANs, its MAC address consistently
appears in multiple VLANs on the switch port to which it is linked.

Be aware that attempting to create redundant paths through the use of VLANs causes problems with some
switches. One symptom is that a duplicate MAC address appears in the Port Address Table of one port and then
later appears on another port. While the switches have multiple forwarding databases and thus do not have this
problem, some switches with a single forwarding database for all VLANs may produce the impression that a
connected device is moving among ports because packets with the same MAC address but different VLANs are
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received on different ports. You can avoid this problem by creating redundant paths using port trunks or spanning
tree.

Figure 82: Example: of duplicate MAC address

Disabled overlapping subnet configuration
Previous software versions allowed configuration of VLAN IP addresses in overlapping subnets which can cause
incorrect routing of packets and result in IP communication failure. As of software version WB.15.09, overlapping
subnet configurations are no longer allowed. An overlapping subnet is determined by the configuration order. The
subnet that is configured first is valid, but any subsequent IP addresses that overlap are not allowed.

When the switch is booted into software version WB.15.09 or later, and the configuration file includes overlapping
subnets, the following occurs:

• The event log provides an error message in the format:

ip: VLANx : IP initialization failed for vlan x.
For a multinetted VLAN (multiple IP addresses assigned to the VLAN), only the IP addresses that are
overlapping subnets are removed. The other IP addresses on the VLAN are retained and function correctly.
The error message can be somewhat misleading; the IP addresses on the VLAN that are not overlapping are
initialized correctly.

• The output of the show ip command correctly indicates that the overlapping IP address does not exist on the
VLANs that have error messages in the event log.

• The output of the show running-config command incorrectly indicates that the overlapping IP address is
configured. In Figure 83: An IP address that is not actually configured on the VLAN on page 473, the IP
address shown in VLAN6 is not actually configured on the VLAN; it has been removed.

Figure 83: An IP address that is not actually configured on the VLAN

switch(config)# show running-config

.

.

.
  vlan 5
     name “VLAN5”
     ip address 11.22.33.1 255.0.0.0
     exit
  vlan 6
     name “VLAN6”
     ip address 11.23.34.1 255.255.255.0
     exit
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The information is retained in the config file to allow you to boot up the switch and have it function as it did
when it was configured with earlier software that allows overlapping subnets.If you attempt to remove the
overlapping subnet from the VLAN, the switch displays an error message similar to:

The IP address <ip-address> is not configured on this VLAN
          
This occurs because the overlapping IP address has been removed and is not visible to the switch. To resolve
this:

• Enter the show ip command to determine which addresses are visible to the switch.

• Remove the erroneous IP addresses from the config file by entering the no ip address command to
remove all the IP addresses from the specific VLAN. Be sure to document the other valid IP addresses on that
VLAN so they can be restored after removing the erroneous IP addresses from the config file.

If you go back to a software version prior to WB.15.09 before removing the overlapping IP address, the prior
software version enables the overlapping IP subnet.

Fan failure
Whenever a fan failure occurs, the Fan/Fault LEDs blink amber and a log entry is recorded. During a fan failure,
all operational fans are automatically set to the maximum operating speed until the fan failure has been resolved.
At that time, the fan speed is reset to the minimum operating speed.

Mitigating flapping transceivers
In traditional switches, the state of a link is driven directly by the reported state of the port, which is required for
rapid detection of link faults. However, the consequence of this is that a marginal transceiver, optical, or wire
cabling, one that "flaps" up and down several times per second, can cause STP and other protocols to react
poorly, resulting in a network outage. The link-flap option expands the functionality of the existing fault finder
function to include a "link-flap" event and a new action of "warn-and-disable." Together, these additions allow the
errant condition to be detected, and the port in question can be optionally disabled.

Syntax:

fault-finder <link-flap> sensitivity {<low | medium | high} > action {<warn | warn-and-disable>}

Default settings: Sensitivity = Medium; Action = Warn

Sensitivity thresholds are static. In a 10-second window, if more than the threshold number of link state transitions
(up or down) are detected, the event is triggered. The 10-second window is statically determined, that is, the
counters are reset every 10 seconds, as opposed to being a sliding window. The counters are polled twice per
second (every 500 milliseconds), and the event is triggered if the sensitivity threshold is crossed at that time.

The sensitivity thresholds are:

High 3 transitions in 10 seconds

Medium 6 transitions in 10 seconds

Low 10 transitions in 10 seconds

Configuring the link-flap event and corresponding action applies to all ports and port types (it is a global setting
per FFI event type). Note that normal link transition protocols may prevent link state changes from occurring fast
enough to trigger the event for some port types, configurations, and sensitivity settings.
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When the link-flap threshold is met for a port configured for warn (For example, fault-finder link-flap
sensitivity medium action warn), the following message is seen in the switch event log.

02672 FFI: port <number>-Excessive link state transitions
When the link-flap threshold is met for a port configured for warn-and-disable (For example, fault-finder
linkflap sensitivity medium action warn-and-disable), the following messages are seen in the
switch event log.

02672 FFI: port <number>-Excessive link state transitions
02673 FFI: port <number>-Port disabled by Fault-finder.
02674 FFI: port <number>-Administrator action required to re-enable.
The warn-and-disable action is available for all fault-finder events on an individual basis. It may be used, For
example, to disable a port when excessive broadcasts are received. Because the fault-generated disabling of a
port requires operator intervention to re-enable the port, such configuration should be used with care. For
example, link-flap-initiated disablement is not desired on ports that are at the client edge of the network, because
link state changes there are frequent and expected.

Hewlett Packard Enterprise does not recommend automatic disabling of a port at the core or distribution layers
when excessive broadcasts are detected, because of the potential to disable large parts of the network that may
be uninvolved and for the opportunity to create a denial-of-service attack.

Fault-finder link-flap
Syntax

In the config context:

[no] fault-finder link-flap [ethernet] PORT-LIST action warn | warn-and-disable SECONDS sensitivity low | medium | high

Description

Configures the link-flap on a port. The default value is warn.

Options

link-flap

Configure link-flap control.

warn

Log the event only.

warn-and-disable

Log the event and disable the port.

seconds

Re-enable the port after waiting for the specified number of seconds. The default value is 0, which indicates
that the port will not be automatically enabled.

sensitivity

Indicate the sensitivity of the link-flap control threshold within a 10-second interval.

• Low indicates 10 link-flaps.

• Medium indicates 6 link-flaps.

• High indicates 3 link-flaps.

Parameters
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action

Configure the action taken when a fault is detected.

ethernet PORT-LIST
Enable link-flap control on a list of ports.

warn

Warn about faults found.

warn-and-disable

Warn and disable faulty component.

seconds

Configure the number of seconds for which the port remains disabled. A value of 0 means that the port will
remain disabled until manually re-enabled.

sensitivity

Configure the fault sensitivity level.

low

Low sensitivity.

medium

Medium sensitivity

high

High sensitivity.

Subcommand Syntax

[no] fault-finder link-flap ethernet PORT-LIST
Description

To remove the current configuration of link-flap on a port

Usage

Enable a linkFault-Finder check and set parameters for it. These commands may be repeated to enable additional
checks. The default sensitivity is medium and the default action is warn.

[no] fault-finder all | fault sensitivity low | medium | high action warn | warn-and-disable

[no] fault-finder link-flap sensitivity low | medium | high action warn | warn-and-disable

[no] fault-finder link-flap PORT-LIST action warn | warn-and-disable SECONDS sensitivity low | medium | high

Configure ports for link-flap detection with high sensitivity

Configure ports A1 to A5 for link-flap detection with sensitivity of high (3 flaps over 10s) and to log and disable
port for 65535s if the link-flap threshold is exceeded.

switch(config)# fault-finder link-flap ethernet A1-A5 action warn-and-disable 65535 
sensitivity high
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Configure ports for link-flap detection with medium sensitivity

Configure ports A8 for link-flap detection with sensitivity of medium (6 flaps over 10s) and to log and disable port if
the link-flap threshold is exceeded. User will need to re-enable the port if disabled.

switch(config)# fault-finder link-flap ethernet A8 action warn-and-disable 0 sensitivity medium

Configure ports for link-flap detection with low sensitivity

Configure ports A22 for link-flap detection with sensitivity of low (10 flaps over 10s) and to log if the link-flap
threshold is exceeded

switch(config)# fault-finder link-flap ethernet A22 action warn sensitivity low

Disable link-flap detection

Disable link-flap detection for port A5

switch(config)# no fault-finder link-flap ethernet A5

Show fault-finder link-flap
Syntax

show fault-finder link-flap ethernet PORT-LIST
Description

Display the link-flap control configuration.

Show fault-finder link-flap

switch# show fault-finder link-flap A1

         Link  | Port                                  Disable    Disable Time
  Port   Flap  | Status Sensitivity Action             Timer      Left        
  ------ ----- + ------ ----------- ------------------ ---------- ------------
  A1     Yes     Down      Low        warn-and-disable 65535      45303

switch# show fault-finder link-flap
         Link  | Port                                    Disable    Disable Time
  Port   Flap  | Status Sensitivity Action               Timer      Left        
  ------ ----- + ------ ----------- ------------------- ---------- ------------
  A1     Yes     Down      Low         warn-and-disable  65535      45303
  A5     No      Up        None        None                -          -
  A22    Yes     Down      Low         warn-and-disable    -          -
  A23    Yes     Down      High        warn-and-disable   100         -

NOTE: This example displays only the list of ports configured via the above per-port config
commands, does not include the global configuration ports.
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Event Log

Cause

Message Cause

FFI: port <ID>- Excessive link state transitions. Link-flap is detected by fault-finder per the sensitivity
configured.

FFI: port <ID>- Excessive link state
transitions.FFI: port <ID>-Port disabled by
Fault-finder.FFI: port <ID>-Administrator action
is required to re-enable.ports: Fault-finder (71)
has disabled port <ID>.ports: port <ID> is now
offline.vlan: VLAN<VLAN-ID> virtual LAN is
disabled.

Link-flap is detected and the action is to disable the port with
no disable timer.

FFI: port <ID>- Excessive link state
transitions.FFI: port <ID>-Port disabled by
Fault-finder.ports: Fault-finder(71) has disabled
port <ID> for <SECONDS> seconds.ports: port
<ID> is now off-line.vlan: VLAN<VLAN-ID>
virtual LAN is disabled.

Link-flap is detected and the action is to disable the port with
disable timer.

port <ID> timer (71) has expired.ports: port
<ID> is now on-line.vlan: VLAN<VLAN-ID>
virtual LAN is enabled.

The port is enabled when the disable timer expires.

Restrictions

• Per port configuration for options – link-flap only. Global settings for other options.

• No support for menu interface.

• No support for Web UI.

• No support for trunks.

Viewing transceiver information
This features provides the ability to view diagnostic monitoring information for transceivers with Diagnostic Optical
Monitoring (DOM) support. The following table indicates the support level for specific transceivers:

Product # Description Support1

J8436A 10GbE X2–SC SR
Optic

V

J8437A 10GbE X2–SC LR Optic V

J8440B 10GbE X2-CX4 Xcver NA

J8440C 10GbE X2-CX4 Xcver NA

Table Continued
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Product # Description Support1

J4858A Gigabit-SX-LC Mini-
GBIC

V

J4858B Gigabit-SX-LC Mini-
GBIC

V

J4858C Gigabit-SX-LC Mini-
GBIC

V (some)

J9054B 100-FX SFP-LC
Transceiver

N

J8177C Gigabit 1000Base-T
Mini-GBIC

NA

J9150A 10GbE SFP+ SR
Transceiver

D

J9151A 10GbE SFP+ LR
Transceiver

D

J9152A 10GbE SFP+ LRM
Transceiver

D

J9153A 10GbE SFP+ ER
Transceiver

D

J9144A 10GbE X2-SC LRM
Transceiver

D

J8438A 10Gbe X2-SC ER
Transceiver

D

JH233A 40G QSFP+ MPO
eSR4 Transceiver

V

JH232A 40G QSFP+ LC LR4
SM Transceiver

V

JL308A 40G QSFP+BIDI V

JH231A 40G QSFP+ MPO SR4
Transceiver

V

1 Support indicators:

• V - Validated to respond to DOM requests

• N - No support of DOM

• D - Documented by the component suppliers as supporting DOM

• NA - Not applicable to the transceiver (copper transceiver)
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NOTE: Not all transceivers support Digital Optical Monitoring. If DOM appears in the Diagnostic
Support field of the show interfaces transceiver detail command, or the
hpicfTransceiverMIB hpicfXcvrDiagnostics MIB object, DOM is supported for that transceiver.

Viewing information about transceivers (CLI)
Syntax:

show interfaces transceiver [port-list] [detail]
Displays information about the transceivers. If a port is specified, displays information for the transceiver in that
port.

[detail]
Displays detailed transceiver information.

MIB support
The hpicfTransceiver MIB is available for displaying transceiver information.

Viewing transceiver information
The transceiver information displayed depends on the show command executed.

The output for show interfaces transceiver [port-list] is shown below. You can specify multiple
ports, separated by commas, and the information for each transceiver will display.

Output for a specified transceiver

switch(config)# show interfaces transceiver 21

Transceiver Technical information:

                     Product      Serial             Part
 Port    Type        Number       Number             Number
 ------- ----------- ------------ ------------------ ----------
 21      1000SX      J4858C       MY050VM9WB         1990-3657
If there is no transceiver in the port specified in the command, the output displays as shown below.

Output when no transceiver is present in specified interface

switch(config)# show interfaces transceiver 22

 No Transceiver found on interface 22
When no ports are specified, information for all transceivers found is displayed.

Output when no ports are specified

switch(config)# show interfaces transceiver

 Transceiver Technical information:

                      Product      Serial             Part
  Port    Type        Number       Number             Number
  ------- ----------- ------------ ------------------ ----------
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  21      1000SX      J4858C       MY050VM9WB         1990-3657
  22      1000SX      J4858B       P834DIP2
You can specify all for port-list as shown below.

Output when “all” is specified

switch(config)# show interfaces transceiver all

 No Transceiver found on interface 1

 No Transceiver found on interface 2
.
.
.
 No Transceiver found on interface 24

 Transceiver Technical information:

                      Product      Serial             Part
  Port    Type        Number       Number             Number
  ------- ----------- ------------ ------------------ ----------
  21      1000SX      J4858C       MY050VM9WB         1990-3657
  22      1000SX      J4858B       P834DIP2

Information displayed with the detail parameter
When the show interfaces transceiver [port-list] detail command is executed, the following
information displays.

Table 32: General transceiver information

Parameter Description

Interface
Index

The switch interface number

Transceiver-
type

Pluggable transceiver type

Transceiver
model

Pluggable transceiver model

Connector-
type

Type of connector of the transceiver

Wavelength For an optical transceiver: the central wavelength of the laser sent, in nm. If the transceiver
supports multiple wavelengths, the values will be separated by a comma.

Transfer
Distance

Link-length supported by the transceiver in meters. The corresponding transfer medium is
shown in brackets following the transfer distance value, For example, 50um multimode fiber. If
the transceiver supports multiple transfer media, the values are separated by a comma.

Table Continued
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Parameter Description

Diagnostic
Support

Shows whether the transceiver supports diagnostics:
None

Supported

DOM

Supported

VCT

Supported

Serial Number Serial number of the transceiver

The information in the next three tables is only displayed when the transceiver supports DOM.

Table 33: DOM information

Parameter Description

Temperature Transceiver temperature (in degrees Centigrade)

Voltage Supply voltage in transceiver (Volts)

Bias Laser bias current (mA)

RX power Rx power (mW and dBm))

TX power Tx power (mW and dBm)

The alarm information for GBIC/SFP transceivers is shown in this table.

Table 34: Alarm and error information (GBIC/SFP transceivers only)

Alarm Description

RX loss of signal Incoming (RX) signal is lost

RX power high Incoming (RX) power level is high

RX power low Incoming (RX) power level is low

TX fault Transmit (TX) fault

TX bias high TX bias current is high

TX bias low TX bias current is low

TX power high TX power is high

Table Continued
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Alarm Description

TX power low TX power is low

Temp high Temperature is high

Temp low Temperature is low

Voltage High Voltage is high

Voltage Low Voltage is low

The alarm information for XENPAK transceivers is shown in this table.

Table 35: Alarm and error information (XENPAK transceivers)

Alarm Description

WIS local fault WAN Interface Sublayer local fault

Receive optical power fault Receive optical power fault

PMA/PMD receiver local fault Physical Medium Attachment/Physical Medium Dependent receiver local
fault

PCS receiver local fault Physical Coding Sublayer receiver local fault

PHY XS receive local fault PHY Extended Sublayer receive local fault

RX power high RX power is high

RX power low RX power is low

Laser bias current fault Laser bias current fault

Laser temperature fault Laser temperature fault

Laser output power fault Laser output power fault

TX fault TX fault

PMA/PMD transmitter local fault PMA/PMD transmitter local fault

PCS Transmit local fault PCS transmit local fault

PHY XS transmit local fault PHY SX transmit local fault

TX bias high TX bias current is high

TX bias low TX bias current is low

Table Continued
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Alarm Description

TX power high TX power is high

TX power low TX power is low

Temp high Temperature is high

Temp low Temperature is low

An Example: of the output for the show interfaces transceiver [port-list] detail for a 1000SX transceiver is shown
below.

Detailed information for a 1000SX Mini-GBIC transceiver

switch(config)# show interfaces transceiver 21 detail

 Transceiver in 21
  Interface index    : 21
  Type               : 1000SX 
  Model              : J4858C
  Connector type     : LC 
  Wavelength         : 850nm
  Transfer distance  : 300m (50um), 150m (62.5um),
  Diagnostic support : DOM
  Serial number      : MY050VM9WB

 Status
  Temperature : 50.111C 
  Voltage     : 3.1234V
  TX Bias     : 6mA
  TX Power    : 0.2650mW, -5.768dBm
  RX Power    : 0.3892mW, -4.098dBm

 Time stamp   :  Mon Mar 7 14:22:13 2011
An Example: of the output for a 10GbE-LR transceiver is shown below.

Detailed information for a 10GbE-LR transceiver

switch(config)# show interfaces transceiver 23 detail

 Transceiver in 23
  Interface Index   : 24
  Type              : 10GbE-LR 
  Model             : J8437A
  Connector type    : SC
  Wavelength        : Channel #0: 1310nm, #1:0nm, #2:0nm, #3:0nm
  Transfer distance : 10000m (SM)
  Diagnostic support: DOM
  Serial number     : ED456SS987

 Status
  Temperature : 32.754C 
  TX Bias     : 42.700mA
  TX Power    : 0.5192mW, -2.847dBm
  RX Power    : 0.0040mW, -23.979dBm

 Recent Alarms:

484 Aruba 2930F / 2930M Management and Configuration Guide
for ArubaOS-Switch 16.08

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 7081



  Rx power low alarm
  Rx power low warning

 Recent errors:
  Receive optical power fault
  PMA/PMD receiver local fault
  PMA/PMD transmitter local fault
  PCS receive local fault
  PHY XS transmit local fault

 Time stamp : Mon Mar 7 16:26:06 2013

Viewing transceiver information for copper transceivers
with VCT support
This feature provides the ability to view diagnostic monitoring information for copper transceivers with Virtual
Cable Test (VCT) support. The cable quality of the copper cables connected between transceivers can be
ascertained using the transceiver cable diagnostics. Results of the diagnostics are displayed with the appropriate
CLI show commands and with SNMP using the hpicfTransceiver MIB.

The J8177C 1000Base-T Mini-GBIC is supported.

Testing the Cable
Enter the test cable-diagnostics command in any context to begin cable diagnostics for the transceiver.
The diagnostic attempts to identify cable faults. The tests may take a few seconds to complete for each interface.
There is the potential of link loss during the diagnostic.

Syntax:

test cable-diagnostics [port-list]
Invokes cable diagnostics and displays the results.

Output from test cable-diagnostics command

Switch # test cable-diagnostics a23-a24

 The ‘test cable-diagnostics’ command will cause a loss of link and will take a few seconds per 
 interface to complete.

 Continue (Y/N)? y

MDI  Cable     Distance  Pair  Pair      MDI 
 Port  Pair  Status     to Fault  Skew  Polarity  Mode
 ----- ----- ---------- --------- ----- --------- ------ 
 A23   1-2   OK         0 m       6 ns  Normal    MDIX
       3-6   OK         0 m       0 ns  Normal
       4-5   OK         0 m       6 ns  Normal    MDIX
       7-8   OK         0 m       6 ns  Normal
 A24   1-2   Short      2 m
       3-6   Impedance  3 m
       4-5   Impedance  3 m
       7-8   Open       1 m

Copper cable diagnostic test results

switch# show interfaces transceiver a23 detail

 Transceiver in A23
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  Interface Index   : 23
  Type              : 1000T-sfp
  Model             : J8177C 
  Connector Type    : RJ45
  Wavelength        : n/a
  Transfer Distance : 100m (copper), 
  Diagnostic Support : VCT
  Serial Number     : US051HF099

  Link Status       : Up
  Speed             : 1000
  Duplex            : Full

       MDI   Cable      Distance  Pair  Pair      MDI 
 Port  Pair  Status     to Fault  Skew  Polarity  Mode
 ----- ----- ---------- --------- ----- --------- ----- 
 A23   1-2   OK         0 m       6 ns  Normal    MDIX
       3-6   OK         0 m       0 ns  Normal
       4-5   OK         0 m       6 ns  Normal    MDIX
       7-8   OK         0 m       6 ns  Normal

   Test Last Run   : Fri Apr 22 20:33:23 2011

General transceiver information

Parameter Description

Interface Index The switch interface number

Transceiver-type Pluggable transceiver type

Transceiver
model

Pluggable transceiver model

Connector-type Type of connector of the transceiver

Wavelength For an optical transceiver: the central wavelength of the laser sent, in nm. If the transceiver
supports multiple wavelengths, the values will be separated by a comma. An electrical
transceiver value is displayed as N/A.

Transfer
Distance

Link-length supported by the transceiver in meters. The corresponding transfer medium is
shown in brackets following the transfer distance value, For example, 50um multimode fiber.
If the transceiver supports multiple transfer media, the values are separated by a comma.

Diagnostic
Support

Shows whether the transceiver supports diagnostics:
None

Supported

DOM

Supported

VCT

Supported

Serial Number Serial number of the transceiver

Table Continued
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Parameter Description

Link Status Link up or down

Speed Speed of transceiver in Mbps

Duplex Type of duplexing

Cable Status Values are OK, Open, Short, or Impedance

Distance to Fault The distance in meters to a cable fault (accuracy is +/- 2 meters); displays 0 (zero) if there is
no fault

Pair Skew Difference in propagation between the fastest and slowest wire pairs

Pair Polarity Signals on a wire pair are polarized, with one wire carrying the positive signal and one
carrying the negative signal.

MDI Mode The MDI crossover status of the two wire pairs (1&2, 3&6, 4&5, 7&8), will be either MDI or
MDIX

Viewing transceiver information
This features provides the ability to view diagnostic monitoring information for transceivers with Diagnostic Optical
Monitoring (DOM) support. The following table indicates the support level for specific transceivers:

Product # Description Support1

J8436A 10GbE X2–SC SR
Optic

V

J8437A 10GbE X2–SC LR Optic V

J8440B 10GbE X2-CX4 Xcver NA

J8440C 10GbE X2-CX4 Xcver NA

J4858A Gigabit-SX-LC Mini-
GBIC

V

J4858B Gigabit-SX-LC Mini-
GBIC

V

J4858C Gigabit-SX-LC Mini-
GBIC

V (some)

J9054B 100-FX SFP-LC
Transceiver

N

J8177C Gigabit 1000Base-T
Mini-GBIC

NA

Table Continued
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Product # Description Support1

J9150A 10GbE SFP+ SR
Transceiver

D

J9151A 10GbE SFP+ LR
Transceiver

D

J9152A 10GbE SFP+ LRM
Transceiver

D

J9153A 10GbE SFP+ ER
Transceiver

D

J9144A 10GbE X2-SC LRM
Transceiver

D

J8438A 10Gbe X2-SC ER
Transceiver

D

1 Support indicators:

• V - Validated to respond to DOM requests

• N - No support of DOM

• D - Documented by the component suppliers as supporting DOM

• NA - Not applicable to the transceiver (copper transceiver)

NOTE: Not all transceivers support Digital Optical Monitoring. If DOM appears in the Diagnostic
Support field of the show interfaces transceiver detail command, or the
hpicfTransceiverMIB hpicfXcvrDiagnostics MIB object, DOM is supported for that transceiver.

Using the Event Log for troubleshooting switch problems
The Event Log records operating events in single- or double-line entries and serves as a tool to isolate and
troubleshoot problems.

Once the log has received 2000 entries, it discards the oldest message each time a new message is received.
The Event Log window contains 14 log entry lines. You can scroll through it to view any part of the log.

Once the log has received 2000 entries, it discards the oldest message each time a new message is received.
The Event Log window contains 14 log-entry lines. You can scroll through it to view any part of the log.

NOTE:

The Event Log is erased if power to the switch is interruptedor if you enter the boot system
command. The contents of the Event Log are not erased if you:

• Reboot the switch by choosing the Reboot Switch option from the menu interface.

• Enter the reload command from the CLI.
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Event Log entries
As shown in Figure 84: Format of an event log entry on page 489, each Event Log entry is composed of six or
seven fields, depending on whether numbering is turned on or not:

Figure 84: Format of an event log entry

Item Description

Severity One of the following codes (from highest to lowest severity):

M—(major) indicates that a fatal switch error has occurred.

E—(error) indicates that an error condition occurred on the switch.

W—(warning) indicates that a switch service has behaved unexpectedly.I—(information)
provides information on normal switch operation.

D—(debug) is reserved for internal diagnostic information.

Date The date in the format mm/dd/yy when an entry is recorded in the log.

Time The time in the format hh:mm:ss when an entry is recorded in the log.

Event number The number assigned to an event. You can turn event numbering on and off with the [no]
log-number command.

System module The internal module (such as "ports:" for port manager) that generated a log entry. If VLANs
are configured, a VLAN name also appears for an event that is specific to an individual
VLAN.

Event message A brief description of the operating event.
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Table 36: Event Log system modules

System module Description Documented in Switch hardware/
software guide

802.1x 802.1X authentication: Provides
access control on a per-client or
per-port basis:

• Client-level security that allows
LAN access to 802.1X clients
(up to 32 per port) with valid user
credentials

• Port-level security that allows
LAN access only on ports on
which a single 802.1X-capable
client (supplicant) has entered
valid RADIUS user credentials

Access Security Guide

acl ACLs: Filter layer-3 IP traffic to or
from a host to block unwanted IP
traffic and block or limit other
protocol traffic such as TCP, UDP,
IGMP, and ICMP. ACEs specify the
filter criteria and an action (permit or
deny) to take on a packet if it meets
the criteria.

Advanced Traffic Management
Guide

addrmgr Address Table Manager: Manages
MAC addresses that the switch has
learned and are stored in the
switch's address table.

Management and Configuration
Guide

arp-protect Dynamic ARP Protection: Protects
the network from ARP cache
poisoning. Only valid ARP requests
and responses are relayed or used
to update the local ARP cache. ARP
packets with invalid IP-to-MAC
address bindings advertised in the
source protocol address and source
physical address fields are
discarded.

Access Security Guide

auth Authorization: A connected client
must receive authorization through
web, AMC, RADIUS-based,
TACACS+-based, or 802.1X
authentication before it can send
traffic to the switch.

Access Security Guide

Table Continued

490 Aruba 2930F / 2930M Management and Configuration Guide
for ArubaOS-Switch 16.08

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 7087



System module Description Documented in Switch hardware/
software guide

cdp Cisco Discovery Protocol: Supports
reading CDP packets received from
neighbor devices, enabling a switch
to learn about adjacent CDP
devices. HPE does not support the
transmission of CDP packets to
neighbor devices.

Management and Configuration
Guide

chassis Hardware operation, including
modules and ports, power supply,
fans, transceivers, CPU interrupt
errors, switch temperature, and so
on. Chassis messages include
events on Power Over Ethernet
(POE) operation.

Installation and Getting Started
Guide

Management and Configuration
Guide

connfilt Connection-rate filtering: Used on
the network edge to protect the
network from attack by worm-like
malicious code by detecting hosts
that are generating IP traffic that
exhibits this behavior and
(optionally) either throttling or
dropping all IP traffic from the
offending hosts.Connection-rate
filtering messages include events
on virus throttling. Virus throttling
uses connection-rate filtering to stop
the propagation of malicious agents.

Access Security Guide

console Console interface used to monitor
switch and port status, reconfigure
the switch, and read the event log
through an in-band Telnet or out-of-
band connection.

Installation and Getting Started
Guide

cos Class of Service (CoS): Provides
priority handling of packets
traversing the switch, based on the
IEEE 802.1p priority carried by each
packet.CoS messages also include
QoS events. The QoS feature
classifies and prioritizes traffic
throughout a network, establishing
an end-to-end traffic priority policy
to manage available bandwidth and
improve throughput of important
data.

Advanced Traffic Management
Guide

Table Continued
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System module Description Documented in Switch hardware/
software guide

dca Dynamic Configuration Arbiter
(DCA) determines the client-specific
parameters that are assigned in an
authentication session.

Access Security Guide

dhcp Dynamic Host Configuration
Protocol (DHCP) server
configuration: Switch is
automatically configured from a
DHCP (Bootp) server, including IP
address, subnet mask, default
gateway, Timep Server address,
and TFTP server address.

Management and Configuration
Guide

dhcp v6c DHCP for IPv6 prefix assignment IPv6 Configuration Guide

dhcpr DHCP relay: Forwards client-
originated DHCP packets to a
DHCP network server.

Advanced Traffic Management
Guide

download Download operation for copying a
software version or files to the
switch.

Management and Configuration
Guide

dhcp-snoop DHCP snooping: Protects your
network from common DHCP
attacks, such as address spoofing
and repeated address requests.

Access Security Guide

dma Direct Access Memory (DMA):
Transmits and receives packets
between the CPU and the switch.

—

fault Fault Detection facility, including
response policy and the sensitivity
level at which a network problem
should generate an alert.

Management and Configuration
Guide

fdr-log FDR collects information that is
“interesting” at the time of the crash,
as well as when the switch is
misbehaving, but has not crashed.
Runtime logs are written to FDR
memory while the switch is running,
and crashtime logs are collected
and stored in the FDR buffer during
a switch crash.

Management and Configuration
Guide
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System module Description Documented in Switch hardware/
software guide

ffi Find, Fix, and Inform: Event or alert
log messages indicating a possible
topology loop that causes excessive
network activity and results in the
network running slow. FFI
messages include events on
transceiver connections with other
network devices.

Installation and Getting Started
Guide

Management and Configuration
Guide

garp Generic Attribute Registration
Protocol (GARP), defined in the
IEEE 802.1D-1998 standard.

Advanced Traffic Management
Guide

gvrp GARP VLAN Registration Protocol
(GVRP): Manages dynamic 802.1Q
VLAN operations, in which the
switch creates temporary VLAN
membership on a port to provide a
link to another port in the same
VLAN on another device.

Advanced Traffic Management
Guide

hpesp Management module that maintains
communication between switch
ports.

Installation and Getting Started
Guide

idm Identity-driven Management:
Optional management application
used to monitor and control access
to switch.

Advanced Traffic Management
Guide

igmp Internet Group Management
Protocol: Reduces unnecessary
bandwidth usage for multicast traffic
transmitted from multimedia
applications on a per-port basis.

Multicast and Routing Guide

inst-mon Instrumentation Monitor: Identifies
attacks on the switch by generating
alerts for detected anomalies.

Access Security Guide

ip IP addressing: Configures the
switch with an IP address and
subnet mask to communicate on the
network and support remote
management access; configures
multiple IP addresses on a VLAN;
enables IP routing on the switch.

Management and Configuration
Guide

Multicast and Routing Guide

Table Continued
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System module Description Documented in Switch hardware/
software guide

ipaddrmgr IP Address Manager: Programs IP
routing information in switch
hardware.

Multicast and Routing Guide

iplock IP Lockdown: Prevents IP source
address spoofing on a per-port and
per-VLAN basis by forwarding only
the IP packets in VLAN traffic that
contain a known source IP address
and MAC address binding for the
port.

Access Security Guide

ipx Novell Netware protocol filtering: On
the basis of protocol type, the
switch can forward or drop traffic to
a specific set of destination ports on
the switch.

Access Security Guide

kms Key Management System:
Configures and maintains security
information (keys) for all routing
protocols, including a timing
mechanism for activating and
deactivating an individual protocol.

Access Security Guide

lacp LACP trunks: The switch can either
automatically establish an 802.3ad-
compliant trunk group or provide a
manually configured, static LACP
trunk.

Management and Configuration
Guide

ldbal Load balancing in LACP port trunks
or 802.1s Multiple Spanning Tree
protocol (MSTP) that uses VLANs in
a network to improve network
resource utilization and maintain a
loop-free environment.Load-
balancing messages also include
switch meshing events. The switch
meshing feature provides redundant
links, improved bandwidth use, and
support for different port types and
speeds.

Management and Configuration
Guide

Advanced Traffic Management
Guide
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System module Description Documented in Switch hardware/
software guide

lldp Link-Layer Discovery Protocol:
Supports transmitting LLDP packets
to neighbor devices and reading
LLDP packets received from
neighbor devices, enabling a switch
to advertise itself to adjacent
devices and to learn about adjacent
LLDP devices.

Management and Configuration
Guide

loop_protect Loop protection: Detects the
formation of loops when an
unmanaged device on the network
drops spanning tree packets and
provides protection by transmitting
loop protocol packets out ports on
which loop protection has been
enabled.

Advanced Traffic Management
Guide

macauth Web and MAC authentication: Port-
based security employed on the
network edge to protect private
networks and the switch itself from
unauthorized access using one of
the following interfaces:

• Web page login to authenticate
users for access to the network

• RADIUS server that uses a
device's MAC address for
authentication

Access Security Guide

maclock MAC lockdown and MAC lockout

• MAC lockdown prevents station
movement and MAC address
"hijacking" by requiring a MAC
address to be used only on an
assigned port on the switch.
MAC Lockdown also restricts the
client device to a specific VLAN.

• MAC lockout blocks a specific
MAC address so that the switch
drops all traffic to or from the
specified address.

Access Security Guide

mgr Windows-based network
management solutions for
managing and monitoring
performance of the switches.

Management and Configuration
Guide

Table Continued
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System module Description Documented in Switch hardware/
software guide

mld Multicast Listener Discovery (MLD):
IPv6 protocol used by a router to
discover the presence of multicast
listeners. MLD can also optimize
IPv6 multicast traffic flow with the
snooping feature.

Multicast and Routing Guide

mtm Multicast Traffic Manager (MTM):
Controls and coordinates L3
multicast traffic for upper layer
protocols.

Multicast and Routing Guide

netinet Network Internet: Monitors the
creation of a route or an Address
Resolution Protocol (ARP) entry
and sends a log message in case of
failure.

Advanced Traffic Management
Guide

pagp Ports Aggregation Protocol (PAgP):
Obsolete. Replaced by LACP
(802.3ad).

—

ports Port status and port configuration
features, including mode (speed
and duplex), flow control, broadcast
limit, jumbo packets, and security
settings.

Port messages include events on
POE operation and transceiver
connections with other network
devices.

Installation and Getting Started
Guide

Management and Configuration
Guide

Access Security Guide

radius RADIUS (Remote Authentication
Dial-In User Service) authentication
and accounting: A network server is
used to authenticate user-
connection requests on the switch
and collect accounting information
to track network resource usage.

Access Security Guide

ratelim Rate-limiting: Enables a port to limit
the amount of bandwidth a user or
device may utilize for inbound traffic
on the switch.

Management and Configuration
Guide
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System module Description Documented in Switch hardware/
software guide

sflow Flow sampling: sFlow is an industry
standard sampling technology,
defined by RFC 3176, used to
continuously monitor traffic flows on
all ports providing network-wide
visibility into the use of the network.

Management and Configuration
Guide

snmp Simple Network Management
Protocol: Allows you to manage the
switch from a network management
station, including support for
security features, event reporting,
flow sampling, and standard MIBs.

Management and Configuration
Guide

sntp Simple Network Time Protocol:
Synchronizes and ensures a
uniform time among interoperating
devices.

Management and Configuration
Guide

ssh Secure Shell version 2 (SSHv2):
Provides remote access to
management functions on a switch
via encrypted paths between the
switch and management station
clients capable of SSH
operation.SSH messages also
include events from the Secure File
Transfer Protocol (SFTP) feature.
SFTP provides a secure alternative
to TFTP for transferring sensitive
information, such as switch
configuration files, to and from the
switch in an SSH session.

Access Security Guide

ssl Secure Socket Layer Version 3
(SSLv3), including Transport Layer
Security (TLSv1) support: Provides
remote web access to a switch via
encrypted paths between the switch
and management station clients
capable of SSL/TLS operation.

Access Security Guide

Table Continued
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System module Description Documented in Switch hardware/
software guide

stack Stack management: Uses a single
IP address and standard network
cabling to manage a group (up to
16) of switches in the same IP
subnet (broadcast domain),
resulting in a reduced number of IP
addresses and simplified
management of small workgroups
for scaling your network to handle
increased bandwidth demand.

Advanced Traffic Management
Guide

stp Multiple-instance spanning tree
protocol/MSTP (802.1s): Ensures
that only one active path exists
between any two nodes in a group
of VLANs in the network. MSTP
operation is designed to avoid loops
and broadcast storms of duplicate
messages that can bring down the
network.

Advanced Traffic Management
Guide

system Switch management, including
system configuration, switch
bootup, activation of boot ROM
image, memory buffers, traffic and
security filters.

System messages also include
events from management interfaces
(menu and CLI) used to reconfigure
the switch and monitor switch status
and performance.

Basic Operation Guide

Access Security Guide

tacacs TACACS+ authentication: A central
server is used to control access to
the switches (and other TACACS-
aware devices) in the network
through a switch's console port
(local access) or Telnet (remote
access).

Access Security Guide

tcp Transmission Control Protocol: A
transport protocol that runs on IP
and is used to set up connections.

Advanced Traffic Management
Guide

telnet Session established on the switch
from a remote device through the
Telnet virtual terminal protocol.

Basic Operation Guide

Table Continued
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System module Description Documented in Switch hardware/
software guide

tftp Trivial File Transfer Protocol:
Supports the download of files to
the switch from a TFTP network
server.

Basic Operation Guide

timep Time Protocol: Synchronizes and
ensures a uniform time among
interoperating devices.

Management and Configuration
Guide

udld Uni-directional Link Detection:
Monitors a link between two
switches and blocks the ports on
both ends of the link if the link fails
at any point between the two
devices.

Access Security Guide

udpf UDP broadcast forwarding:
Supports the forwarding of client
requests sent as limited IP
broadcasts addressed to a UDP
application port on a network server.

Multicast and Routing Guide

update Updates (TFTP or serial) to HPE
switch software and updates to
running-config and start-up config
files

Basic Operation Guide

Table Continued
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System module Description Documented in Switch hardware/
software guide

vlan Static 802.1Q VLAN operations,
including port-and protocol-based
configurations that group users by
logical function instead of physical
location

• A port-based VLAN creates a
layer-2 broadcast domain
comprising member ports that
bridge IPv4 traffic among
themselves.

• A protocol-based VLAN creates
a layer-3 broadcast domain for
traffic of a particular routing
protocol, and comprises member
ports that bridge traffic of the
specified protocol type among
themselves.

VLAN messages include events
from management interfaces (menu
and CLI) used to reconfigure the
switch and monitor switch status
and performance.

Advanced Traffic Management
Guide

xmodem Xmodem: Binary transfer feature
that supports the download of
software files from a PC or UNIX
workstation.

Basic Operation Guide

Using the CLI
Syntax:

show logging [-a, -b, -r, -s, -t, -m, -e, -p, -w, -i, -d, command, filter] [< option-str >]
By default, the show logging command displays the log messages recorded since the last reboot in
chronological order:

-a Displays all recorded log messages, including those before the last reboot.

-b Displays log events as the time since the last reboot instead of in a date/time format.

-r Displays all recorded log messages, with themost recent entries listed first (reverse order).

-s Displays the active management module (AM) and standby management module (SM) log
events.

-t Displays the log events with a granularity of 10 milliseconds.

Table Continued
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-m Displays only major log events.

-e Displays only error event class.

-p Displays only performance log events.

-w Displays only warning log events.

-i Displays only informational log events.

-d Displays only debug log events.

command Displays only command logs.

filter Displays only log filter configuration and status information.

<option-
str>

Displays all Event Log entries that contain the specified text. Use an <option-str> value with -a or
-r to further filter show logging command output.

Example:

To display all Event Log messages that have "system" in the message text or module name, enter the following
command:

switch# show logging -a system
To display all Event Log messages recorded since the last reboot that have the word "system" in the message
text or module name, enter:

switch# show logging system

Clearing Event Log entries
Syntax:

clear logging [command]
Removes all entries from the event log display output.

Use the clear logging command to hide, but not erase, Event Log entries displayed in show logging
command output. Only new entries generated after you enter the command will be displayed.

To redisplay all hidden entries, including Event Log entries recorded prior to the last reboot, enter the show
logging -a command.

The command option removes all entries from the command log.

Turning event numbering on
Syntax:

[no] log-numbers
Turns event numbering on and off
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Using log throttling to reduce duplicate Event Log and SNMP messages
A recurring event can generate a series of duplicate Event Log messages and SNMP traps in a relatively short
time. As a result, the Event Log and any configured SNMP trap receivers may be flooded with excessive, exactly
identical messages. To help reduce this problem, the switch uses log throttle periods to regulate (throttle)
duplicate messages for recurring events, and maintains a counter to record how many times it detects duplicates
of a particular event since the last system reboot.

When the first instance of a particular event or condition generates a message, the switch initiates a log throttle
period that applies to all recurrences of that event. If the logged event recurs during the log throttle period, the
switch increments the counter initiated by the first instance of the event, but does not generate a new message.

If the logged event repeats again after the log throttle period expires, the switch generates a duplicate of the first
message, increments the counter, and starts a new log throttle period during which any additional instances of the
event are counted, but not logged. Thus, for a particular recurring event, the switch displays only one message in
the Event Log for each log throttle period in which the event reoccurs. Also, each logged instance of the event
message includes counter data showing how many times the event has occurred since the last reboot. The switch
manages messages to SNMP trap receivers in the same way.

Log throttle periods
The length of the log throttle period differs according to an event's severity level:

Severity level Log throttle period

I (Information) 6000 Seconds

W (Warning) 600 Seconds

D (Debug) 60 Seconds

M (Major) 6 Seconds

Example:

Suppose that you configure VLAN 100 on the switch to support PIM operation, but do not configure an IP
address. If PIM attempts to use VLAN 100, the switch generates the first instance of the following Event Log
message and counter.

NOTE:

In The first instance of an event message and counter on page 502 the counter (1) indicates
that this is the first instance of this event since the switch last rebooted.

The first instance of an event message and counter

W 10/01/12 09:00:33 PIM:No IP address configured on VID 100 (1)
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If PIM operation causes the same event to occur six more times during the initial log throttle period, there are no
further entries in the Event Log. However, if the event occurs again after the log throttle period has expired, the
switch repeats the message (with an updated counter) and starts a new log throttle period.

Figure 85: Duplicate messages over multiple log throttling periods

Note that if the same type of event occurs under different circumstances, the switch handles these as unrelated
events for the purpose of Event Log messages. For example, if PIM operation simultaneously detects that VLANs
100 and 205 are configured without IP addresses, you see log messages similar to the following:

Figure 86: Example: of log messages generated by unrelated events of the same type

Example: of event counter operation
Suppose the switch detects the following after a reboot:

• Three duplicate instances of the PIM "Send error" during the first log throttle period for this event

• Five more instances of the same Send error during the second log throttle period for this event

• Four instances of the same Send error during the third log throttle period for this event

In this case, the duplicate message appears three times in the Event Log (once for each log throttle period for the
event being described), and the duplicate message counter increments as shown in the following table. (The
same operation applies for messages sent to any configured SNMP trap receivers.)

Table 37: How the duplicate message counter increments

Instances during 1st log
throttle period

Instances during 2nd log
throttle period

Instances during 3rd log
throttle period

Duplicate message
counter1

3 1

5 4

4 9
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1 This value always comprises the first instance of the duplicate message in the current log throttle period plus all previous
occurrences of the duplicate message occurring since the switch last rebooted.

Reporting information about changes to the running configuration
Syslog can be used for sending notifications to a remote syslog server about changes made to the running
configuration. The notifications in the syslog messages are sent in ASCII format and contain this information:

• Notice-Type: Describes the syslog notification as a “running config change”.

• Event-ID: Identifier for the running config change event that occurred on the switch.

• Config-Method: The source for the running config change.

• Device-Name: The managed device.

• User-Name: User who made the running config change.

• Remote-IP-Address: IP address of a remote host from which the user is connected.

Syntax:

[no] logging notify <running-config-change> [transmission-interval <0-4294967295>
Enables sending the running configuration change notifications to the syslog server.

The no form of the command disables sending the running configuration changes to the syslog server.

Default: Disabled

<running-config-change > Mandatory option for the notify parameter. Specifies the type of
notification to send.

transmission-interval
<0-4294967295> Specifies the time interval (in seconds) between the

transmission of two consecutive notifications. Running config
changes occurring within the specified interval will not generate
syslog notifications.

A value of zero means there is no limit; a notification is sent for every running config change.

Default: Zero

Sending running config changes to the syslog server

switch(config)# logging notify running-config-change
transmission-interval 10

Debug/syslog operation
While the Event Log records switch-level progress, status, and warning messages on the switch, the debug/
system logging (syslog) feature provides a way to record Event Log and debug messages on a remote device.
For example, you can send messages about routing misconfigurations and other network protocol details to an
external device, and later use them to debug network-level problems.

Debug/syslog messaging
The debug/syslog feature allows you to specify the types of Event Log and debug messages that you want to
send to an external device. You can perform the following operations:
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• Use the debug commandto configure messaging reports for the following event types:

◦ ACL "deny" matches

◦ Dynamic ARP protection events

◦ DHCP snooping events

◦ DIPLD events

◦ Events recorded in the switch's Event Log

◦ IP routing events (IPv4 and IPv6)

◦ LACP events

◦ LLDP events

◦ SNMP events

◦ SSH events

• Use the logging commandto select a subset of Event Log messages to send to an external device for
debugging purposes according to:
◦ Severity level

◦ System module

Hostname in syslog messages
The syslog now messages the sender identified by hostname.

The hostname field identifies the switch that originally sends the syslog message. Configurable through the CLI
and SNMP, the format of the hostname field supports the following formats:

• ip-address: The IP address of the sending interface will be used as the message origin identifier. This is the
default format for the origin identifier. The IP address of the sending interface (in dotted decimal notation) is the
default format.

• hostname: The hostname of the sending switch will be used as the message origin identifier.

• none: No origin identifier will be embedded in the syslog message. Nilvalue is used as defined by “-“.

This configuration is system-wide, not per syslog server. There is no support for fully-qualified domain name.

Logging origin-id
Use the logging origin-id command to specify the content for the hostname field.

Syntax:

logging origin-id [ip-address|hostname|none]

[no] logging origin-id [ip-address|hostname|none]
To reset the hostname field content back to default (IP-address), use the no form of the command.

filter

Creates a filter to restrict which events are logged.
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IP-ADDR

Adds an IPv4 address to the list of receiving syslog servers.

IPV6-ADDR

Adds an IPv6 address to the list of receiving syslog servers.

origin-id

Sends the Syslog messages with the specified origin-id.

notify

Notifies the specified type sent to the syslog server(s).

priority-descr

A text string associated with the values of facility, severity, and system-module.

severity

Event messages of the specified severity or higher sent to the syslog server.

system-module

Event messages of the specified system module (subsystem) sent to the syslog server.

hostname

Sets the hostname of the device as the origin-id.

none

Disables origin-id in the syslog message.

Add an IP address to the list of receiving syslog servers.

Use of no without an IP address specified will remove all IP addresses from the list of syslog receivers. If an IP
address is specified, that receiver will be removed. Both link-local with zone ID and global IPv6 addresses are
supported.

• Specify syslog server facility with the option <facility>. The command no logging <facility> sets
the facility back to defaults.

• Specify filtering rules.

• Specify severity for event messages to be filtered to the syslog server with the option <severity>. The
command no logging <severity> sets the severity back to default.

• Event messages of specified system module will be sent to the syslog server. Using no sends messages from
all system modules. Messages are first filtered by selected severity.

• Specify syslog server transport layer with options [udp]|[tcp]|[tls].

• Specify syslog server port number with options [udp PORT-NUM]|[tcp PORT-NUM]|[tls PORT-NUM].

• Specify notification types to be sent to the syslog server.

• Use the option transmission-interval to control the egress rate limit for transmitting notifications, 0 value
means there is no rate limit. The values are in seconds. Only one syslog message is allowed for transmission
within specified time interval.

• Specify the origin information for the syslog messages with the option origin-id.
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NOTE: When the syslog server receives messages from the switch, the IPv6 address of the switch is
partly displayed.

Example:

Configured Host Ipv6 Address: 2001::1

Expected Syslog message:

Syslog message: USER.INFO: Oct 11 02:40:02 2001::1 00025 ip:
ST1CMDR: VLAN60: ip address 30.1.1.1/24 configured on vlan 60
Actual Truncated syslog message:

Syslog message: USER.INFO: Oct 11 02:40:02 2001:: 00025 ip: ST1CMDR:
VLAN60: ip address 30.1.1.1/24 configured on vlan 60

Use the command in the following example to set the origin-id to the hostname.

Setting the origin-id to the hostname

switch(config)# logging origin-id hostname
The following syslog message will occur:

<14> Jan 1 00:15:35 2910al-24G 00076 ports: port 2 is now on-line
Use the command in the following example to set the origin-id to none (nilvalue).

Setting the origin-id to none (nilvalue)

switch(config)# logging origin-id none
The following syslog message will occur:

<14> Jan 1 00:15:35 - 00076 ports: port 2 is now on-line
Use any of the commands in the following example to set the origin-id to ip-address (default).

Setting the origin-id to ip-address (default)

switch(config)# logging origin-id ip-address

switch(config)# no logging origin-id hostname

switch(config)# no logging origin-id none
The following syslog message will occur:

<14> Jan 1 00:15:35 169.254.230.236 00076 ports: port 2 is now on-line

Viewing the identification of the syslog message sender
Use the commands show debug or show running-config to display the identification of the syslog message
sender. The default option for origin-id is ip-address. The command show running-config will not
display the configured option when origin-id is set to the default value of ip address.

When hostname or none is configured using logging origin-id, the same displays as part of the show
running-config command.
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Syntax:

show debug
Default option is ip-address.

The following shows the output of the show debug command when configured without loggin origin-id.

Output of the show debug command when configured without login origin-id

Debug Logging
  Origin identifier: Outgoing Interface IP
  Destination:     None

Enabled debug types:
  None are enabled.
The command logging origin-id hostname will produce the syslog message shown in the following
example.

Syslog message for logging origin-id hostname

Debug Logging
  Origin identifier: Hostname
  Destination:    None

Enabled debug types:
  None are enabled.
The command logging origin-id none will produce the syslog message shown in the following example.

Syslog message for logging origin-id none

Debug Logging
  Origin identifier: none
  Destination:    None

Enabled debug types:
  None are enabled.
Syntax:

show running-config
The following example shows the output of the show running-config command.

Output of the show running-config command

The command logging origin-id hostname will display the 
following:
logging origin-id hostname
The command logging origin-id none will display as the following:

logging origin-id none
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SNMP MIB
SNMP support will be provided through the following MIB objects.

HpicfSyslogOriginId = textual-convention

Description

This textual convention enumerates the origin identifier of syslog message.

Syntax: integer

ip-address

hostname

none

Status

current

hpicfSyslogOriginId OBJECT-TYPE

Description

Specifies the content of a Hostname field in the header of a syslog message.

Syntax:

HpicfSyslogOriginId

Max-access

read-write

Status

current

Default

ip-address

Debug/syslog destination devices
To use debug/syslog messaging, you must configure an external device as the logging destination by using the
logging and debug destination commands. For more information, see Debug destinations on page 519
and Configuring a syslog server on page 521.

A debug/syslog destination device can be a syslog server and/or a console session. You can configure debug and
logging messages to be sent to:

• Up to six syslog servers

• A CLI session through a direct RS-232 console connection, or a Telnet or SSH session

Chapter 13 Troubleshooting 509

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 7106



Debug/syslog configuration commands

Event notification logging — Automatically sends switch-level
event messages to the switch's
Event Log. Debug and syslog do
not affect this operation, but add the
capability of directing Event Log
messaging to an external device.

logging command <syslog-ip-addr> Enables syslog messaging to be
sent to the specified IP address.
IPv4 and IPv6 are supported.

facility (Optional) The logging
facility command specifies the
destination (facility) subsystem used
on a syslog server for debug
reports.

priority-desc A text string associated with the
values of facility, severity, and
system-module.

neighbor-adjacency
[detail]

Enables or disables OSPFv3 (IPv6)
adjacency logging. Must be
executed in OSPFv3 context. The
detail option displays all the
adjacency state transitions and
adjacency-related errors.

severity Sends Event Log messages of
equal or greater severity than the
specified value to configured debug
destinations. (The default setting is
to send Event Log messages from
all severity levels.)

system-module Sends Event Log messages from
the specified system module to
configured debug destinations. The
severity filter is also applied to the
system-module messages you
select.

The default setting is to send Event
Log messages from all system
modules. To restore the default
setting, enter the no logging
system-module <system-
module> or logging system-
module all-pass commands.

Table Continued
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debug Command acl Sends ACL syslog logging to
configured debug destinations.
When there is a match with a "deny"
statement, directs the resulting
message to the configured debug
destinations.

all Sends debug logging to configured
debug destinations for all ACL,
Event Log, IP-OSPF, and IP-RIP
options.

cdp Displays CDP information.

destination logging: Disables or re-enables
syslog logging on one or more
syslog servers configured with the
logging syslog-ip-addr
command.session: Assigns or re-
assigns destination status to the
terminal device that was most
recently used to request debug
output.buffer: Enables syslog
logging to send the debug message
types specified by the debug
<debug-type> command to a
buffer in switch memory.

event Sends standard Event Log
messages to configured debug
destinations. (The same messages
are also sent to the switch's Event
Log, regardless of whether you
enable this option.)

Table Continued
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ip fib: Displays IP Forwarding
Information Base messages and
events.forwarding: Sends IPv4
forwarding messages to the debug
destinations.ospf: Sends OSPF
event logging to the debug
destinations.ospfv3: Enables
debug messages for
OSPFv3.packet: Sends IPv4
packet messages to the debug
destinations. pim [packet
[filter {source < ip-addr
> | vlan < vid >}]] : Enables
or disables tracing of PIM
messages.Note: When PIM
debugging is enabled, the following
message displays:

PIM Debugging can be 
extremely CPU intensive 
when run
on a device with an 
existing high CPU load or 
on a switch
with more than 10 PIM-
enabled VLANs. In high 
load
situations, the switch 
may suffer from protocol
starvation, high latency, 
or even reload. When 
debugging
a switch with more than 
10 PIM-enabled VLANs, the 
“vlan”
option in “debug ip pim 
packet” should be 
utilized.
Debugging should only be 
used temporarily while
troubleshooting problems. 
Customers are advised to
exercise caution when 
running this command in a 
highstress
production network.
                
pbr: Logs a message when a PBR
policy is applied, when the action in
a class goes active or when it goes
inactive.rip: Sends RIP event
logging to the debug destinations.

Table Continued
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ipv6 dhcpv6-client: Sends DHCPv6
client debug messages to the
configured debug
destination.dhcpv6-relay: Sends
DHCPv6 relay debug messages to
the configured debug
destination.forwarding: Sends
IPv6 forwarding messages to the
debug destination(s)nd: Sends IPv6
debug messages for IPv6 neighbor
discovery to the configured debug
destinations.

lacp event: Sends messages related to
change events.packet: Sends
messages when BPDUs are
exchanged.

lldp Sends LLDP debug messages to
the debug destinations.

security Sends security messages to the
debug destination.

services Displays debug messages on the
services module.

snmp Sends snmp messages to the
debug destination.

Using the Debug/Syslog feature, you can perform the following operations:

• Configure the switch to send Event Log messages to one or more Syslog servers. In addition, you can
configure the messages to be sent to the User log facility (default) or to another log facility on configured
Syslog servers.

• Configure the switch to send Event Log messages to the current management- access session (serial-connect
CLI, Telnet CLI, or SSH).

• Disable all Syslog debug logging while retaining the Syslog addresses from the switch configuration. This
allows you to configure Syslog messaging and then disable and re-enable it as needed.

• Display the current debug configuration. If Syslog logging is currently active, the list f configured Syslog
servers is displayed.

• Display the current Syslog server list when Syslog logging is disabled.

Configuring debug/syslog operation

Procedure

1. To use a syslog server as the destination device for debug messaging, follow these steps:
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a. Enter the logging <syslog-ip-addr> command at the global configuration level to configure the
syslog server IP address and enable syslog logging. Optionally, you may also specify the destination
subsystem to be used on the syslog server by entering the logging facility command.If no other
syslog server IP addresses are configured, entering the logging command enables both debug
messaging to a syslog server and the event debug message type. As a result, the switch automatically
sends Event Log messages to the syslog server, regardless of other debug types that may be configured.

b. Re-enter the logging command in Step 1a to configure additional syslog servers. You can configure up to
a total of six servers. (When multiple server IP addresses are configured, the switch sends the debug
message types that you configure in Step 3 to all IP addresses.)

2. To use a CLI session on a destination device for debug messaging:

a. Set up a serial, Telnet, or SSH connection to access the switch's CLI.

b. Enter the debug destination session command at the manager level.

3. Enable the types of debug messages to be sent to configured syslog servers, the current session device, or
both by entering the debug <debug-type> command and selecting the desired options.

Repeat this step if necessary to enable multiple debug message types.

By default, Event Log messages are sent to configured debug destination devices. To block Event Log
messages from being sent, enter the no debug event command.

4. If necessary, enable a subset of Event Log messages to be sent to configured syslog servers by specifying a
severity level, a system module, or both using the following commands:

switch(config)# logging severity <debug | major | error | warning | info>
switch(config)# logging system-module <system-module>

To display a list of valid values for each command, enter logging severity or logging system-module
followed by ? or pressing the Tab key.

The severity levels in order from the highest to lowest severity are major, error, warning, info, and debug. For a
list of valid values for the logging system-module <system-module> command, see Event Log
system modules.

5. If you configure system-module, severity-level values, or both to filter Event Log messages, when you finish
troubleshooting, you may want to reset these values to their default settings so that the switch sends all Event
Log messages to configured debug destinations (syslog servers, CLI session, or both).

To remove a configured setting and restore the default values that send all Event Log messages, enter one or
both of the following commands:

switch(config)# no logging severity <debug | major | error | warning | info>
switch(config)# no logging system-module <system-module>

CAUTION: If you configure a severity-level, system-module, logging destination, or logging facility
value and save the settings to the startup configuration (For example, by entering the write
memory command), the debug settings are saved after a system reboot (power cycle or reboot) and
re-activated on the switch. As a result, after switch startup, one of the following situations may occur:

• Only a partial set of Event Log messages may be sent to configured debug destinations.

• Messages may be sent to a previously configured syslog server used in an earlier debugging
session.
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Viewing a debug/syslog configuration
Use the show debug command to display the currently configured settings for:

• Debug message types and Event Log message filters (severity level and system module) sent to debug
destinations

• Debug destinations (syslog servers or CLI session) and syslog server facility to be used

Syntax:

show debug
Displays the currently configured debug logging destinations and message types selected for debugging
purposes. (If no syslog server address is configured with the logging <syslog-ip-addr> command, no
show debug command output is displayed.)

Output of the show debug command

switch(config)# show debug

 Debug Logging
  Destination:
   Logging --
    10.28.38.164
    Facility=kern
    Severity=warning
    System module=all-pass
   Enabled debug types:
    event
Example:

In the following Example:, no syslog servers are configured on the switch (default setting). When you configure a
syslog server, debug logging is enabled to send Event Log messages to the server. To limit the Event Log
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messages sent to the syslog server, specify a set of messages by entering the logging severity and
logging system-module commands.

Figure 87: Syslog configuration to receive event log messages from specified system module and severity levels

As shown at the top of Figure 87: Syslog configuration to receive event log messages from specified
system module and severity levels on page 516, if you enter the show debug command when no syslog
server IP address is configured, the configuration settings for syslog server facility, Event Log severity level, and
system module are not displayed. However, after you configure a syslog server address and enable syslog
logging, all debug and logging settings are displayed with the show debug command.

If you do not want Event Log messages sent to syslog servers, you can block the messages from being sent by
entering the no debug event command. (There is no effect on the normal logging of messages in the switch's
Event Log.)

Example:

The next Example: shows how to configure:

• Debug logging of ACL and IP-OSPF packet messages on a syslog server at 18.38.64.164 (with user as the
default logging facility).

• Display of these messages in the CLI session of your terminal device's management access to the switch.

• Blocking Event Log messages from being sent from the switch to the syslog server and a CLI session.
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To configure syslog operation in these ways with the debug/syslog feature disabled on the switch, enter the
commands shown in Figure 88: Debug/syslog configuration for multiple debug types and multiple
destinations on page 517.

Figure 88: Debug/syslog configuration for multiple debug types and multiple destinations

Debug command
At the manager level, use the debug command to perform two main functions:

• Specify the types of event messages to be sent to an external destination.

• Specify the destinations to which selected message types are sent.

By default, no debug destination is enabled and only Event Log messages are enabled to be sent.

NOTE:

To configure a syslog server, use the logging <syslog-ip-addr> command. For more
information, see Configuring a syslog server on page 521.

Debug messages
Syntax:

[no] debug <debug-type>
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acl When a match occurs on an ACL "deny" ACE (with log configured), the
switch sends an ACL message to configured debug destinations. For
information on ACLs, see the "Access Control Lists (ACLs)" in the latest
version of the following guides:

• IPv4 ACLs: access security guide

• IPv6 ACLs: IPv6 configuration guide

NOTE: ACE matches (hits) for permit and deny entries can be
tracked using the show statistics <aclv4|aclv6>
command.

(Default: Disabled—ACL messages for traffic that matches "deny" entries
are not sent.)

all Configures the switch to send all debug message types to configured debug
destinations.(Default: Disabled—No debug messages are sent.)

cdp Sends CDP information to configured debug destinations.

destination logging—Disables or re-enables syslog logging on one or more syslog
servers configured with the logging <syslog-ip-addr>
command.session—Assigns or re-assigns destination status to the
terminal device that was most recently used to request debug
output.buffer—Enables syslog logging to send the debug message types
specified by the debug <debug-type> command to a buffer in switch
memory.For more information on these options, see Debug destinations on
page 519.

event Configures the switch to send Event Log messages to configured debug
destinations.

NOTE: This value does not affect the reception of event
notification messages in the Event Log on the switch.

Event Log messages are automatically enabled to be sent to debug
destinations in these conditions:

• If no syslog server address is configured and you enter the logging
<syslog-ip-addr> command to configure a destination address.

• If at least one syslog server address is configured in the startup
configuration, and the switch is rebooted or reset.

Event log messages are the default type of debug message sent to
configured debug destinations.

ip [fib | forwarding |
packet | rip] Sends IP messages to configured destinations.

ip [fib [events]] For the configured debug destinations:events—Sends IP forwarding
information base events.

ip [packet] Enables the specified PIM message type.

Table Continued
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ip [rip [database
| event |
trigger]]

rip {<database | event | trigger>} —Enables the specified RIP
message type for the configured destination(s). database—Displays
database changes. event—Displays RIP events. trigger—Displays
trigger messages.

ipv6 [dhcpv6-client | nd
| packet] NOTE: See the "IPv6 Diagnostic and Troubleshooting" in the

IPv6 configuration guide for your switch for more detailed IPv6
debug options.

When no debug options are included, displays debug messages for all IPv6
debug options. dhcpv6-client [events | packet]—Displays
DHCPv6 client event and packet data.nd—Displays debug messages for
IPv6 neighbor discovery.packet—Displays IPv6 packet messages.

lldp Enables all LLDP message types for the configured destinations.

security [arp-protect |
dhcp-snooping | dynamic-
ip-lockdown | port-access
| port-security | radius-
server | ssh | tacacs-
server | user-profile-
mib]

arp-protect— Sends dynamic ARP protection debug messages to
configured debug destinations.dhcp-snooping—Sends DHCP snooping
debug messages to configured debug destinations. agent—Displays DHCP
snooping agent messages. event—Displays DHCP snooping event
messages. packet—Displays DHCP snooping packet messages.
dynamic-ip-lockdown—Sends dynamic IP lockdown debug messages to
the debug destination.port-access—Sends port-access debug messages
to the debug destination.radius-server—Sends RADIUS debug
messages to the debug destination.ssh—Sends SSH debug messages at
the specified level to the debug destination. The levels are fatal, error, info,
verbose, debug, debug2, and debug3.tacacs-server—Sends TACACS
debug messages to the debug destination.user-profile-mib—Sends
user profile MIB debug messages to the debug destination.

services <slot-id-range> Displays debug messages on the services module. Enter an alphabetic
module ID or range of module IDs for the <slot-id-range> parameter.

snmp <pdu> Displays the SNMP debug messages.pdu—Displays SNMP pdu debug
messages.

Debug destinations
Use the debug destination command to enable (and disable)syslog messaging on a syslog server or to a CLI
session for specified types of debug and Event Log messages.

Syntax:

[no] debug destination {<logging | session | buffer>}
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logging Enables syslog logging to configured syslog servers so that the debug message types
specified by the debug <debug-type> command (see Debug messages on page 517)
are sent.(Default: Logging disabled)To configure a syslog server IP address, see 
Configuring a syslog server on page 521.

NOTE: Debug messages from the switches covered in this guide have a
debug severity level. Because the default configuration of some syslog
servers ignores syslog messages with the debug severity level, ensure that
the syslog servers you want to use to receive debug messages are
configured to accept the debug level. For more information, see Operating
notes for debug and Syslog on page 526.

session Enables transmission of event notification messages to the CLI session that most recently
executed this command. The session can be on any one terminal emulation device with
serial, Telnet, or SSH access to the CLI at the Manager level prompt (switch#_).If more
than one terminal device has a console session with the CLI, you can redirect the
destination from the current device to another device. Do so by executing debug
destination session in the CLI on the terminal device on which you now want to
display event messages.Event message types received on the selected CLI session are
configured with the debug <debug-type> command.

buffer Enables syslog logging to send the debug message types specified by the debug
<debug-type> command to a buffer in switch memory.To view the debug messages
stored in the switch buffer, enter the show debug buffer command.

Logging command
At the global configuration level, the loggingcommand allows you to enable debug logging on specified syslog
servers and select a subset of Event Log messages to send for debugging purposes according to:

• Severity level

• System module

By specifying both a severity level and system module, you can use both configured settings to filter the Event
Log messages you want to use to troubleshoot switch or network error conditions.

CAUTION:

After you configure a syslog server and a severity level and/or system module to filter the Event Log
messages that are sent, if you save these settings to the startup configuration file by entering the
write memory command, these debug and logging settings are automatically re-activated after a
switch reboot or power recycle. The debug settings and destinations configured in your previous
troubleshooting session will then be applied to the current session, which may not be desirable.

After a reboot, messages remain in the Event Log and are not deleted. However, after a power
recycle, all Event Log messages are deleted.

If you configure a severity level, system module, or both to temporarily filter Event Log messages, be
sure to reset the values to their default settings by entering the no form of the following commands to
ensure that Event Log messages of all severity levels and from all system modules are sent to
configured syslog servers:

switch(config)# no logging severity <debug | major | error | warning | 
info>
switch(config)# no logging system-module <system-module>
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Configuring a syslog server
Syslog is a client-server logging tool that allows a client switch to send event notification messages to a
networked device operating with syslog server software. Messages sent to a syslog server can be stored to a file
for later debugging analysis.

To use the syslog feature, you must install and configure a syslog server application on a networked host
accessible to the switch. For instructions, see the documentation for the syslog server application.

To configure a syslog service, use the logging <syslog-ip-addr> command as shown below.

When you configure a syslog server, Event Log messages are automatically enabled to be sent to the server. To
reconfigure this setting, use the following commands:

• debug
Specifies additional debug message types (see Debug messages on page 517).

• logging
Configures the system module or severity level used to filter the Event Log messages sent to configured
syslog servers. (See Configuring the severity level for Event Log messages sent to a syslog server on
page 524 and Configuring the system module used to select the Event Log messages sent to a
syslog server on page 525.)

To display the currently configured syslog servers as well as the types of debug messages and the severity-level
and system-module filters used to specify the Event Log messages that are sent, enter the show debug
command (See Debug/syslog configuration commands on page 510).

Syntax:

[no] logging <syslog-ip-addr>
Enables or disables syslog messaging to the specified IP address. You can configure up to six addresses. If you
configure an address when none are already configured, this command enables destination logging (syslog) and
the Event debug type. Therefore, at a minimum, the switch begins sending Event Log messages to configured
syslog servers. The ACL, IP-OSPF, and/or IP-RIP message types are also sent to the syslog servers if they are
currently enabled as debug types. (See Debug messages on page 517.)

no logging Removes all currently configured syslog logging destinations from the
running configuration.Using this form of the command to delete the only
remaining syslog server address disables debug destination logging on the
switch, but the default Event debug type does not change.

no logging <syslog-ip-
address> Removes only the specified syslog logging destination from the running

configuration.Removing all configured syslog destinations with the no
logging command (or a specified syslog server destination with the no
logging <syslog-ip-address> command) does not delete the syslog
server IP addresses stored in the startup configuration.

Deleting syslog addresses in the startup configuration
Enter a no logging command followed by the write memory command.

Verifying the deletion of a syslog server address
Display the startup configuration by entering the show config command.
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Blocking the messages sent to configured syslog servers from the currently configured
debug message type
Enter the no debug <debug-type> command. (See Debug messages on page 517.)

Disabling syslog logging on the switch without deleting configured server addresses
Enter the no debug destination logging command. Note that, unlike the case in which no syslog servers
are configured, if one or more syslog servers are already configured and syslog messaging is disabled,
configuring a new server address does not re-enable syslog messaging. To re-enable syslog messaging, you
must enter the debug destination logging command.

Sending logging messages using TCP
Syntax:

[no] logging <ip-addr> [udp 1024-49151 | tcp 1024-49151]
Allows the configuration of the UDP or TCP transport protocol for the transmission of logging messages to a
syslog server.

Specifying a destination port with UDP or TCP is optional.

Default ports: UDP port is 514

TCP port is 1470

Default Transport Protocol: UDP

Because TCP is a connection-oriented protocol, a connection must be present before the logging information is
sent. This helps ensure that the logging message will reach the syslog server. Each configured syslog server
needs its own connection. You can configure the destination port that is used for the transmission of the logging
messages.

Configuring TCP for logging message transmission using the default port

switch(config)# logging 192.123.4.5 tcp
(Default TCP port 1470 is used.)

Configuring TCP for logging message transmission using a specified port

switch(config)# logging 192.123.4.5 9514
(TCP port 9514 is used.)

Configuring UDP for logging message transmission using the default port

switch(config)# logging 192.123.4.5 udp
(Default UDP port 514 is used.)

Configuring UDP for logging message transmission using a specified port

switch(config)# logging 192.123.4.5 9512
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(UDP port 9512 is used.)

Syntax:

[no] logging facility <facility-name>
The logging facility specifies the destination subsystem used in a configured syslog server. (All configured syslog
servers must use the same subsystem.) Hewlett Packard Enterprise recommends the default (user) subsystem
unless your application specifically requires another subsystem. Options include:

user (default) Random user-level messages

kern Kernel messages

mail Mail system

daemon System daemons

auth Security/authorization messages

syslog Messages generated internally by syslog

lpr Line-printer subsystem

news Netnews subsystem

uucp uucp subsystem

cron cron/at subsystem

sys9 cron/at subsystem

sys10 - sys14 Reserved for system use

local10 - local17 Reserved for system use

Use the no form of the command to remove the configured facility and reconfigure the default (user) value.

Adding a description for a Syslog server
You can associate a user-friendly description with each of the IP addresses (IPv4 only) configured for syslog
using the CLI or SNMP.

NOTE:

The Hewlett Packard Enterprise MIB hpicfSyslog.mib allows the configuration and monitoring of
syslog for SNMP (RFC 3164 supported).

CAUTION:

Entering the no logging command removes ALL the syslog server addresses without a verification
prompt.

The CLI command is:
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Syntax:

logging <ip-addr> [control-descr ZZZZTRISHZZZZ <text_string>] 
 no logging <ip-addr> [control-descr]
An optional user-friendly description that can be associated with a server IP address. If no description is entered,
this is blank. If <text_string> contains white space, use quotes around the string. IPv4 addresses only.

Use the no form of the command to remove the description. Limit: 255 characters

NOTE:

To remove the description using SNMP, set the description to an empty string.

The logging command with a control description

switch(config)# logging 10.10.10.2 control-descr syslog_one

Adding a priority description
This description can be added with the CLI or SNMP. The CLI command is:

Syntax:

logging priority-descr <text_string> 
 no logging priority-descr
Provides a user-friendly description for the combined filter values of severity and system module. If no
description is entered, this is blank.

If text_string contains white space, use quotes around the string.

Use the no form of the command to remove the description.

Limit: 255 characters

The logging command with a priority description

switch(config)# logging priority-descr severe-pri

NOTE:

A notification is sent to the SNMP agent if there are any changes to the syslog parameters, either
through the CLI or with SNMP.

Configuring the severity level for Event Log messages sent to a syslog
server
Event Log messages are entered with one of the following severity levels (from highest to lowest):

Major A fatal error condition has occurred on the switch.

Error An error condition has occurred on the switch.

Warning A switch service has behaved unexpectedly.

Table Continued
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Information Information on a normal switch event.

Debug Reserved for switch internal diagnostic information.

Using the logging severity command, you can select a set of Event Log messages according to their
severity level and send them to a syslog server. Messages of the selected and higher severity will be sent. To
configure a syslog server, see Configuring a syslog server on page 521.

Syntax:

[no] logging severity {< major | error | warning | info | debug >}
Configures the switch to send all Event Log messages with a severity level equal to or higher than the specified
value to all configured Syslog servers.

Default: debug (Reports messages of all severity levels.)

Use the no form of the command to remove the configured severity level and reconfigure the default value, which
sends Event Log messages of all severity levels to syslog servers.

NOTE: The severity setting does not affect event notification messages that the switch normally
sends to the Event Log. All messages remain recorded in the Event Log.

Configuring the system module used to select the Event Log messages sent to a syslog
server
Event Log messages contain the name of the system module that reported the event. Using the logging
system-module command, you can select a set of Event Log messages according to the originating system
module and send them to a syslog server.

Syntax:

[no] logging system-module <system-module>
Configures the switch to send all Event Log messages being logged from the specified system module to
configured syslog servers. (To configure a syslog server, see Configuring a syslog server.)

See Event Log system modules for the correct value to enter for each system module.

Default: all-pass (Reports all Event Log messages.)

Use the no form of the command to remove the configured system module value and reconfigure the default
value, which sends Event Log messages from all system modules to syslog servers.

You can select messages from only one system module to be sent to a syslog server; you cannot configure
messages from multiple system modules to be sent. If you re-enter the command with a different system module
name, the currently configured value is replaced with the new one.

NOTE: This setting has no effect on event notification messages that the switch normally sends to
the Event Log.

Enabling local command logging
Use this command to enable local command logging. This satisfies the NDcPP certification requirement that:

• All administrative actions (commands) are logged locally.

• Local command log storage can be enabled and disabled.
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• The identity of the user causing an event is logged.

• When the command log is exhausted by 80% and wraparound occurs, the event is logged and a trap is
generated.

• Log messages have a maximum of 240 characters (the RMON event maximum string length) and are stored in
the command log buffer.

• Log messages greater than the maximum length are truncated and are not stored in the command log buffer.

Syntax:

[no] logging command 

Operating notes for debug and Syslog
• Rebooting the switch or pressing the Reset button resets the debug configuration.

Debug option Effect of a reboot or reset

logging (debug destination) If syslog server IP addresses are stored in the startup-config file, they are
saved across a reboot and the logging destination option remains enabled.
Otherwise, the logging destination is disabled.

session (debug destination) Disabled.

ACL (debug type) Disabled.

All (debug type) Disabled.

event (debug type) If a syslog server IP address is configured in the startup-config file, the
sending of Event Log messages is reset to enabled, regardless of the
last active setting.

If no syslog server is configured, the sending of Event Log messages is
disabled.

IP (debug type) Disabled.

• Debug commands do not affect normal message output to the Event Log.

Using the debug event command, you can specify that Event Log messages are sent to the debug
destinations you configure (CLI session, syslog servers, or both) in addition to the Event Log.

• Ensure that your syslog servers accept debug messages.

All syslog messages resulting from a debug operation have a "debug" severity level. If you configure the switch
to send debug messages to a syslog server, ensure that the server's syslog application is configured to accept
the "debug" severity level. (The default configuration for some syslog applications ignores the "debug" severity
level.)

• Duplicate IP addresses are not stored in the list of syslog servers.
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• If the default severity value is in effect, all messages that have severities greater than the default value are
passed to syslog. For example, if the default severity is "debug," all messages that have severities greater
than debug are passed to syslog.

• There is a limit of six syslog servers. All syslog servers are sent the same messages using the same filter
parameters. An error is generated for an attempt to add more than six syslog servers.

Diagnostic tools

Port auto-negotiation
When a link LED does not light (indicating loss of link between two devices), the most common reason is a failure
of port auto-negotiation between the connecting ports. If a link LED fails to light when you connect the switch to a
port on another device, do the following:

Procedure

1. Ensure that the switch port and the port on the attached end-node are both set to Auto mode.

2. If the attached end-node does not have an Auto mode setting, you must manually configure the switch port to
the same setting as the end-node port.

Ping and link tests
The ping test and the link test are point-to-point tests between your switch and another IEEE 802.3-compliant
device on your network. These tests can tell you whether the switch is communicating properly with another
device.

NOTE:

To respond to a ping test or a link test, the device you are trying to reach must be IEEE 802.3-
compliant.

Ping test
A test of the path between the switch and another device on the same or another IP network that can respond to
IP packets (ICMP Echo Requests). To use the ping (or traceroute) command with host names or fully
qualified domain names, see DNS resolver on page 544.

Link test
A test of the connection between the switch and a designated network device on the same LAN (or VLAN, if
configured). During the link test, IEEE 802.2 test packets are sent to the designated network device in the same
VLAN or broadcast domain. The remote device must be able to respond with an 802.2 Test Response Packet.

Executing ping or link tests (WebAgent)
To start a ping or link test in the WebAgent:

1. In the navigation pane, click Troubleshooting.

2. Click Ping/Link Test.

3. Click Start.

4. To halt a link or ping test before it concludes, click Stop.
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For an Example: of the text screens, see Figure 89: Ping test and link test screen on the WebAgent on page
528.

Figure 89: Ping test and link test screen on the WebAgent

Destination IP Address is the network address of the target, or destination, device to which you want to test a
connection with the switch. An IP address is in the X.X.X.X format where X is a decimal number between 0 and
255.

Number of Packets to Send is the number of times you want the switch to attempt to test a connection.

Timeout in Seconds is the number of seconds to allow per attempt to test a connection before determining that
the current attempt has failed.

Testing the path between the switch and another device on an IP network
The ping test uses ICMP echo requests and ICMP echo replies to determine if another device is alive. It also
measures the amount of time it takes to receive a reply from the specified destination. The ping command has
several extended commands that allow advanced checking of destination availability.

Syntax:

ping {<ip-address | hostname>} [repetitions <1-10000>] [timeout <1-60>] [source < 
{ip-address | <vlan-id> | loopback <0-7>>}] [data-size <0-65471>] [data-fill 
<0-1024>] [ip-option {<record-route | loose-source-route | strict-source-route | 
include-timestamp | include-timestamp-and-address | include timestamp-from} >] 
[tos <0-255>]

ping6 {<ipv6-address | hostname>} [repetitions <1-10000>] [timeout <1-60>] [source 
< {ip-address | vlan-id | loopback <0-7>>}] [data-size <0-65471>] [data-fill 
<0-1024>]
Sends ICMP echo requests to determine if another device is alive.

{< ip-address | hostname
>}

Target IP address or hostname of the destination node being pinged

repetitions <1-10000> Number of ping packets sent to the destination address.

Default: 1

Table Continued
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timeout <1-60> Timeout interval in seconds; the ECHO REPLY must be received before
this time interval expires for the ping to be successful.

Default: 5

source {< ip-addr | vid |
loopback <0-7>>}

Source IP address, VLAN ID, or loopback address used for the ping.

The source IP address must be owned by the router.If a VLAN is specified,
the IP address associated with the specified VLAN is used.

data-size <0-65471> Size of packet sent.

Default: 0 (zero)

data-fill <0-1024> The data pattern in the packet.

Default: Zero length string

ip-option Specify an IP option, such as loose or strict source routing, or an include-
timestamp option:include-timestamp: Adds the timestamp option to the
IP header. The timestamp displays the amount of travel time to and from a
host.

Default: 9include-timestamp-and-address: Records the
intermediate router's timestamp and IP address.

Default: 4include-timestamp-from: Records the timestamp of the
specified router addresses.loose-source-route <IP-addr> : The
loose-source-route option prompts for the IP address of each source
IP on the path. It allows you to specify the IP addresses that you want the
ping packet to go through; the packet may go through other IP addresses
as well.record-route <1-9> : Displays the IP addresses of the
interfaces that the ping packet goes through on its way to the destination
and on the way back.

When specified without loose or strict recording, the source route is not
recorded. The source route is automatically recorded when loose or strict
source routing is enabled.

Default: 9strict-source-route <IP-addr> : Restricts the ping
packet to only those IP addresses that have been specified and no other
addresses.

tos <0-255> Specifies the type of service to be entered in the header packet.

Default: 0 (zero)

Ping tests

switch# ping 10.10.10.10
10.10.10.10 is alive, time = 15 ms

switch# ping 10.10.10.10 repetitions 3
10.10.10.10 is alive, iteration 1, time = 15 ms
10.10.10.10 is alive, iteration 1, time = 15 ms
10.10.10.10 is alive, iteration 1, time = 15 ms

switch# ping 10.10.10.10 timeout 2
10.10.10.10 is alive, time = 10 ms
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switch# ping 10.11.12.13
The destination address is unreachable.

Halting a ping test
To halt a ping test before it concludes, press [Ctrl] [C].

NOTE:

To use the ping (or traceroute) command with host names or fully qualified domain names, see 
DNS resolver on page 544.

Issuing single or multiple link tests
Single or multiple link tests can have varying repetitions and timeout periods. The defaults are:

• Repetitions: 1 (1 to 999)

• Timeout: 5 seconds (1 to 256 seconds)

Syntax:

link <mac-address> [repetitions <1-999>] [timeout <1-256>] [vlan < vlan-id >]
Example:

Figure 90: Link tests

Tracing the route from the switch to a host address
The traceroute command enables you to trace the route from the switch to a host address.

This command outputs information for each (router) hop between the switch and the destination address. Note
that every time you execute traceroute, it uses the same default settings unless you specify otherwise for that
instance of the command.

Syntax:

traceroute {< ip-address | hostname >} [maxttl <1-255>] [minttl <1-255>] [probes 

530 Aruba 2930F / 2930M Management and Configuration Guide
for ArubaOS-Switch 16.08

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 7127



<1-5>] [source {<ip-address | source-vlan <vid> | loopback <0-7>}] [dstport 
<1-34000>] [srcport <1-34000>] [ip-option {<record-route | loose-source-route | 
strict-source-route | include-timestamp | include-timestamp-and-address | include 
timestamp-from>}] [< timeout 1-120 >]
Lists the IP address or hostname of each hop in the route, plus the time in microseconds for the traceroute
packet reply to the switch for each hop.

{< ip-address | 
hostname >}

The IP address or hostname of the device to which to send the traceroute.

[minttl < 1-255 >]
For the current instance of traceroute, changes the minimum number of hops
allowed for each probe packet sent along the route.

• If minttl is greater than the actual number of hops, the output includes only the
hops at and above the minttl threshold. (The hops below the threshold are not
listed.)

• If minttl matches the actual number of hops, only that hop is shown in the
output.

• If minttl is less than the actual number of hops, all hops are listed.

For any instance of traceroute, if you want a minttl value other than the default,
you must specify that value.(Default: 1)

[maxttl < 1-255 >]
For the current instance of traceroute, changes the maximum number of hops
allowed for each probe packet sent along the route.If the destination address is
further from the switch than maxttl allows, traceroute lists the IP addresses for
all hops it detects up to the maxttl limit.For any instance of traceroute, if you
want a maxttl value other than the default, you must specify that value.(Default: 30)

[probes < 1-5 >]
For the current instance of traceroute, changes the number of queries the switch
sends for each hop in the route.For any instance of traceroute, if you want a
probes value other than the default, you must specify that value.(Default: 3)

[source {< ip-
addr | vid | 
loopback <0-7> >}]

The source IPv4 address, VLAN ID, or Loopback address.

[dstport < 
1-34000 >]

Destination port.

Table Continued
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[srcport < 
1-34000 >]

Source port.

[ip-option]
Specify an IP option, such as loose or strict source routing, or an include-timestamp
option:[include-timestamp]: Adds the timestamp option to the IP header. The
timestamp displays the amount of travel time to and from a host.Default:
9[include-timestamp-and-address]: Records the intermediate router's
timestamp and IP address.Default: 4[loose-source-route <IP-addr>] :
Prompts for the IP address of each source IP on the path.It allows you to specify the
IP addresses that you want the ping packet to go through; the packet may go through
other IP addresses as well.[record-route <1-9>] : Displays the IP addresses of
the interfaces that the ping packet goes through on its way to the destination and on
the way back.When specified without loose or strict recording, the source route is not
recorded. The source route is automatically recorded when loose or strict source
routing is enabled.Default: 9[strict-source-route <IP-addr>] : Restricts the
ping packet to only those IP addresses that have been specified and no other
addresses.[timeout <1-120>]: For the current instance of traceroute,
changes the timeout period the switch waits for each probe of a hop in the route.For
any instance of traceroute, if you want a timeout value other than the default, you
must specify that value.(Default: 5 seconds)

NOTE: For information about traceroute6, see the IPv6 configuration guide for your switch.

Halting an ongoing traceroute search
Press the [Ctrl] [C] keys.

A low maxttl causes traceroute to halt before reaching the destination address
Executing traceroute with its default values for a destination IP address that is four hops away produces a
result similar to this:

Figure 91: A completed traceroute enquiry
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Continuing from the previous Example: (Figure 91: A completed traceroute enquiry on page 532), executing
traceroute with an insufficient maxttl for the actual hop count produces an output similar to this:

Figure 92: Incomplete traceroute because of low maxttl setting

If a network condition prevents traceroute from reaching the destination
Common reasons for traceroute failing to reach a destination include:

• Timeouts (indicated by one asterisk per probe, per hop)

• Unreachable hosts

• Unreachable networks

• Interference from firewalls

• Hosts configured to avoid responding

Executing traceroute where the route becomes blocked or otherwise fails results in an output marked by
timeouts for all probes beyond the last detected hop. For example, with a maximum hop count of 7 (maxttl = 7),
where the route becomes blocked or otherwise fails, the output appears similar to this:

Figure 93: Traceroute failing to reach the destination address

Viewing switch configuration and operation
In some troubleshooting scenarios, you may need to view the switch configuration to diagnose a problem. The
complete switch configuration is contained in a file that you can browse from the CLI using the commands
described in this section.

Viewing the startup or running configuration file
Syntax:

write terminal
Displays the running configuration.
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show config Displays the startup configuration.

show running-config Displays the running-config file.

For more information and examples of how to use these commands, see “Switch Memory and Configuration” in
the basic operation guide.

Viewing the configuration file (WebAgent)
To display the running configuration using the WebAgent:

1. In the navigation pane, click Troubleshooting.

2. Click Configuration Report.

3. Use the right-side scroll bar to scroll through the configuration listing.

Viewing a summary of switch operational data
Syntax:

show tech
By default, the show tech command displays a single output of switch operating and running-configuration data
from several internal switch sources, including:

• Image stamp (software version data)

• Running configuration

• Event Log listing

• Boot history

• Port settings

• Status and counters — port status

• IP routes

• Status and counters — VLAN information

• GVRP support

• Load balancing (trunk and LACP)

The show tech command on page 534 shows sample output from the show tech command.

The show tech command

switch# show tech

 show system

  Status and Counters - General System Information

   System Name        : Switch
   System Contact     :
   System Location    :
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   MAC Age Time (sec) : 300

   Time Zone          : 0
   Daylight Time Rule : None

   Software revision  : XX.14.xx     Base MAC Addr  : 001871-c42f00
   ROM Version        : XX.12.12     Serial Number  : SG641SU00L

   Up Time            : 23 hours    Memory - Total :
   CPU Util (%)       : 10                    Free :

   IP Mgmt - Pkts Rx  : 759         Packet - Total : 6750
              Pkts Tx : 2             Buffers Free : 5086
                                            Lowest : 4961
                                            Missed : 0

show flash
Image       Size(Bytes)   Date  Version
-----       -----------  ------ --------
To specify the data displayed by the show tech command, use the copy show tech command.

Saving show tech command output to a text file
When you enter the show tech command, a summary of switch operational data is sent to your terminal
emulator. You can use your terminal emulator's text capture features to save the show tech data to a text file for
viewing, printing, or sending to an associate to diagnose a problem.

For example, if your terminal emulator is the Hyperterminal application available with Microsoft® Windows®
software, you can copy the show tech output to a file and then use either Microsoft Word or Notepad to display
the data. (In this case, Microsoft Word provides the data in an easier-to-read format.)

The following example uses the Microsoft Windows terminal emulator. If you are using a different terminal
emulator application, see the documentation provided with the application.
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Procedure

1. In Hyperterminal, click on Transfer|Capture Text….

Figure 94: Capture text window of the Hyperterminal application

2. In the File field, enter the path and file name in which you want to store the show tech output.

Figure 95: Entering a path and filename for saving show tech output

3. Click [Start] to create and open the text file.

4. From the global configuration context, enter the show tech command:

switch# show tech
The show tech command output is copied into the text file and displayed on the terminal emulator screen.
When the command output stops and displays -- MORE --, press the Space bar to display and copy more
information. The CLI prompt appears when the command output finishes.

5. Click on Transfer|Capture Text|Stop in HyperTerminal to stop copying data and save the text file.

If you do not stop HyperTerminal from copying command output into the text file, additional unwanted data can
be copied from the HyperTerminal screen.

6. To access the file, open it in Microsoft Word, Notepad, or a similar text editor.

Customizing show tech command output
Use the copy show tech command to customize the detailed switch information displayed with the show tech
command to suit your troubleshooting needs.

To customize the information displayed with the show tech command:

Procedure

1. Determine the information that you want to gather to troubleshoot a problem in switch operation.

2. Enter the copy show tech command to specify the data files that contain the information you want to view.
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Syntax:

copy <source> show-tech
Specifies the operational and configuration data from one or more source files to be displayed by the show tech
command. Enter the command once for each data file that you want to include in the display.

Default: Displays data from all source files, where <source> can be any one of the following values:

command-output "<command>" Includes the output of a specified command in show-tech
command output.

Enter the command name between double-quotation marks,
For example, copy "show system" show-tech.

crash-data [slot-id | master] Includes the crash data from all management and interface
modules in show tech command output.

To limit the amount of crash data displayed, specify an
installed module or management modules, where:

• slot-id: Includes the crash data from an installed
module. Valid slot IDs are the letters a through h.

• master: Includes the crash data from both management
modules.

crash-log [slot-id | master] Includes the crash logs from all management and interface
modules in show tech command output.

To limit the amount of crash-log data displayed, specify an
installed module or management modules, where:

slot-id: Includes the crash log from an installed module.
Valid slot IDs are the letters a through h.

master: Includes the crash log from both management
modules.

event-log Copies the contents of the Event Log to show tech
command output.

running-config Includes the contents of the running configuration file in show
tech command output

startup-config Includes the contents of the startup configuration file in show
tech command output.

Table Continued
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tftp config {<startup-config |
running-config} <ip-addr> <remote-
file> {<pc | unix>}

Downloads the contents of a configuration file from a remote
host to show tech command output, where:

<ip-addr> : Specifies the IP address of the remote host
device.

<remote-file>: Specifies the pathname on the remote host
for the configuration file whose contents you want to include in
the command output.

pc|unix: Specifies whether the remote host is a DOS-based
PC or UNIX workstation.

xmodem config {<startup-config |
config < filename > | command-file
< acl-filename.txt >} {<pc | unix>}

Copies the contents of a configuration file or ACL command
file from a serially connected PC or UNIX workstation to show
tech command output, where:

startup-config: Specifies the name of the startup
configuration file on the connected device.

config <filename> : Specifies the pathname of a
configuration file on the connected device.

command-file <acl-filename.txt> : Specifies the
pathname of an ACL command file on the connected device.

pc|unix: Specifies whether the connected device is a DOS-
based PC or UNIX workstation.

Viewing more information on switch operation
Use the following commands to display additional information on switch operation for troubleshooting purposes.

Syntax:

show boot-history
Displays the crash information saved for each management module on the switch.

show history
Displays the current command history. This command output is used for reference or when you want to repeat a
command (See Displaying the information you need to diagnose problems on page 541).

show system-information
Displays globally configured parameters and information on switch operation.

show version
Displays the software version currently running on the switch and the flash image from which the switch booted
(primary or secondary). For more information, see "Displaying Management Information" in the "Redundancy
(Switch 8212zl)" .

show interfaces
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Displays information on the activity on all switch ports (see "Viewing Port Status and Configuring Port
Parameters" in the "Port Status and Configuration" ).

show interfaces-display
Displays the same information as the show interfaces command and dynamically updates the output every
three seconds. Press Ctrl + C to stop the dynamic updates of system information. Use the Arrow keys to view
information that is off the screen.

Searching for text using pattern matching with show command
Selected portions of the output are displayed, depending on the parameters chosen.

Syntax:

show {< command option > | < include | exclude | begin >} <regular expression>
Uses matching pattern searches to display selected portions of the output from a show command. There is no
limit to the number of characters that can be matched. Only regular expressions are permitted; symbols such as
the asterisk cannot be substituted to perform more general matching.

include Only the lines that contain the matching pattern are displayed in the output.

exclude Only the lines that contain the matching pattern are not displayed in the output.

begin The display of the output begins with the line that contains the matching pattern.

NOTE: Pattern matching is case-sensitive.

Following are examples of what portions of the running config file display depending on the option chosen.

Pattern matching with include option

switch(config)# show run | include ipv6 1
   ipv6 enable
   ipv6 enable
ipv6 access-list "EH-01"
switch(config)#

1Displays only lines that contain “ipv6”.

Pattern matching with exclude option

switch(config)# show run | exclude ipv6 1

Running configuration:

; J9299A Configuration Editor; Created on release #WB.15.XX

hostname "Switch"
snmp-server community "notpublic" Unrestricted
vlan 1
  name "DEFAULT_VLAN"
  untagged A1-A24,B1-B20
  ip address dhcp-bootp
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  no untagged B21-B24
  exit
vlan 20
  name "VLAN20"
  untagged B21-B24
  no ip address
  exit
policy qos "michael"
  exit
  sequence 10 deny tcp 2001:db8:255::/48 2001:db8:125::/48
  exit
no autorun
password manager

1Displays all lines that do not contain “ipv6”.

Pattern matching with begin option

switch(config)# show run | begin ipv6 1
   ipv6 enable
   no untagged 21-24
   exit
vlan 20
   name "VLAN20"
   untagged 21-24
   ipv6 enable
   no ip address
   exit
policy qos "michael"
   exit
ipv6 access-list "EH-01"
   sequence 10 deny tcp 2001:db8:255::/48 2001:db8:125::/48
   exit
no autorun
password manager

1Displays the running config beginning at the first line that contains “ipv6”.

The following is an Example: of the show arp command output, and then the output displayed when the
include option has the IP address of 15.255.128.1 as the regular expression.

The show arp command and pattern matching with the include option

switch(config)# show arp

 IP ARP table

  IP Address      MAC Address    Type    Port
  -------------   -------------- ------- ----
  15.255.128.1    00000c-07ac00  dynamic B1
  15.255.131.19   00a0c9-b1503d  dynamic
  15.255.133.150  000bcd-3cbeec  dynamic B1

switch(config)# show arp | include 15.255.128.1
  15.255.128.1    00000c-07ac00  dynamic B1
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Displaying the information you need to diagnose problems
Use the following commands in a troubleshooting session to more accurately display the information you need to
diagnose a problem.

Syntax:

alias
Creates a shortcut alias name for commonly used commands and command options.

Syntax:

kill
Terminates a currently running, remote troubleshooting session. Use the show ip ssh command to list the
current management sessions.

Syntax:

[no] page
Toggles the paging mode for show commands between continuous listing and per-page listing.

Syntax:

repeat
Repeatedly executes one or more commands so that you can see the results of multiple commands displayed
over a period of time. To halt the command execution, press any key on the keyboard.

Syntax:

setup
Displays the Switch Setup screen from the menu interface.

Restoring the factory-default configuration
As part of your troubleshooting process, it may become necessary to return the switch configuration to the factory
default settings. This process:

• Momentarily interrupts the switch operation

• Clears any passwords

• Clears the console Event Log

• Resets the network counters to zero

• Performs a complete self test

• Reboots the switch into its factory default configuration, including deleting an IP address

There are two methods for resetting to the factory-default configuration:

• CLI

• Clear/Reset button combination
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NOTE: Hewlett Packard Enterprise recommends that you save your configuration to a TFTP server
before resetting the switch to its factory-default configuration. You can also save your configuration
via Xmodem to a directly connected PC.

Resetting to the factory-default configuration

Using the CLI
This command operates at any level except the Operator level.

Syntax:

erase startup-configuration
Deletes the startup-config file in flash so that the switch will reboot with its factory-default configuration.

NOTE:

The erase startup-config command does not clear passwords unless include-
credentials has been set, at which time this command does erase username/password
information and any other credentials stored in the config file. For more information, see the section
on "Saving Security Credentials in a Config File" in the access security guide for your switch.

Using Clear/Reset

Procedure

1. Using pointed objects, simultaneously press both the Reset and Clear buttons on the front of the switch.

2. Continue to press the Clear button while releasing the Reset button.

3. When the Self Test LED begins to flash, release the Clear button.

The switch then completes its self test and begins operating with the configuration restored to the factory
default settings.

Restoring a flash image
The switch can lose its operating system if either the primary or secondary flash image location is empty or
contains a corrupted OS file and an operator uses the erase flash command to erase a good OS image file
from the opposite flash location.

Recovering from an empty or corrupted flash state
Use the switch's console serial port to connect to a workstation or laptop computer that has the following:

• A terminal emulator program with Xmodem capability, such as the HyperTerminal program included in
Windows PC software.

• A copy of a good OS image file for the switch
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NOTE: The following procedure requires the use of Xmodem and copies an OS image into primary
flash only.

This procedure assumes you are using HyperTerminal as your terminal emulator. If you use a
different terminal emulator, you may need to adapt this procedure to the operation of your particular
emulator.

1. Start the terminal emulator program.

Ensure that the terminal program is configured as follows:

• Baud rate: 9600

• No parity

• 8 Bits

• 1 stop bit

• No flow control

2. Use the Reset button to reset the switch.

The following prompt should then appear in the terminal emulator:

Enter h or ? for help.

=>
3. Because the OS file is large, you can increase the speed of the download by changing the switch console and

terminal emulator baud rates to a high speed. For Example:

a. Change the switch baud rate to 115,200 Bps.

 => sp 115200
b. Change the terminal emulator baud rate to match the switch speed:

I. In HyperTerminal, select Call|Disconnect.

II. Select File|Properties.

III. Click on Configure.

IV. Change the baud rate to 115200.

V. Click on [OK], then in the next window, click on [OK] again.

VI. Select Call|Connect.

VII. Press [Enter] one or more times to display the => prompt.

4. Start the Console Download utility by entering do at the =prompt and pressing [Enter]:

 => do
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5. You then see this prompt:

You have invoked the console download utility. 
Do you wish to continue? (Y/N)>_

6. At the above prompt:

a. Enter y (for Yes)

b. Select Transfer|File in HyperTerminal.

c. Enter the appropriate filename and path for the OS image.

d. Select the Xmodem protocol (and not the 1k Xmodem protocol).

e. Click on [Send].

If you are using HyperTerminal, you will see a screen similar to the following to indicate that the download is in
progress:

Figure 96: Example: of Xmodem download in progress

When the download completes, the switch reboots from primary flash using the OS image you downloaded in
the preceding steps, plus the most recent startup-config file.

DNS resolver
The domain name system (DNS) resolver is designed for use in local network domains, where it enables the use
of a host name or fully qualified domain name with DNS-compatible switch CLI commands.

DNS operation supports both IPv4 and IPv6 DNS resolution and multiple, prioritized DNS servers. (For
information on IPv6 DNS resolution, see the latest IPv6 configuration guide for your switch.)

Basic operation
• When the switch is configured with only the IP address of a DNS server available to the switch, a DNS-

compatible command, executed with a fully qualified domain name, can reach a device found in any domain
accessible through the configured DNS server.

• When the switch is configured with both of the following:
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◦ The IP address of a DNS server available to the switch

◦ The domain suffix of a domain available to the configured DNS serverthen:

◦ A DNS-compatible command that includes the host name of a device in the same domain as the configured
domain suffix can reach that device.

◦ A DNS-compatible command that includes a fully qualified domain name can reach a device in any domain
that is available to the configured DNS server.

Example:

Suppose the switch is configured with the domain suffix mygroup. Switch.net and the IP address for an
accessible DNS server. If an operator wants to use the switch to ping a target host in this domain by using the
DNS name "leader" (assigned by a DNS server to an IP address used in that domain), the operator can use either
of the following commands:

Figure 97: Example: of using either a host name or a fully qualified domain name

In the proceeding Example:, if the DNS server's IP address is configured on the switch, but a domain suffix is
either not configured or is configured for a different domain than the target host, the fully qualified domain name
must be used.

Note that if the target host is in a domain other than the domain configured on the switch:

• The host's domain must be reachable from the switch. This requires that the DNS server for the switch must
be able to communicate with the DNS servers in the path to the domain in which the target host operates.

• The fully qualified domain name must be used, and the domain suffix must correspond to the domain in which
the target host operates, regardless of the domain suffix configured in the switch.

Example:

Suppose the switch is configured with the domain suffix mygroup. Switch.net and the IP address for an
accessible DNS server in this same domain. This time, the operator wants to use the switch to trace the route to a
host named "remote-01" in a different domain named common.group.net. Assuming this second domain is
accessible to the DNS server already configured on the switch, a traceroute command using the target's fully
qualified DNS name should succeed.

Figure 98: Example: using the fully qualified domain name for an accessible target in another domain
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Configuring and using DNS resolution with DNS-compatible commands
The DNS-compatible commands include ping and traceroute.)

Procedure

1. Determine the following:

a. The IP address for a DNS server operating in a domain in your network.

b. The priority (1 to 3) of the selected server, relative to other DNS servers in the domain.

c. The domain name for an accessible domain in which there are hosts you want to reach with a DNS-
compatible command. (This is the domain suffix in the fully qualified domain name for a given host
operating in the selected domain. See Basic operation on page 544.) Note that if a domain suffix is not
configured, fully qualified domain names can be used to resolve DNS-compatible commands.

d. The host names assigned to target IP addresses in the DNS server for the specified domain.

2. Use the data from the first three bullets in step1 to configure the DNS entry on the switch.

3. Use a DNS-compatible command with the host name to reach the target devices.

Configuring a DNS entry
The switch allows up to two DNS server entries (IP addresses for DNS servers). One domain suffix can also be
configured to support resolution of DNS names in that domain by using a host name only. Including the domain
suffix enables the use of DNS-compatible commands with a target's host name instead of the target's fully
qualified domain name.

Syntax:

[no] ip dns server-address priority <1-3> <ip-addr>
Configures the access priority and IP address of a DNS server accessible to the switch. These settings specify:

• The relative priority of the DNS server when multiple servers are configured

• The IP address of the DNS server

These settings must be configured before a DNS-compatible command can be executed with host name criteria.

The switch supports two prioritized DNS server entries. Configuring another IP address for a priority that has
already been assigned to an IP address is not allowed.

To replace one IP address at a given priority level with another address having the same priority, you must first
use the no form of the command to remove the unwanted address. Also, only one instance of a given server
address is allowed in the server list. Attempting to enter a duplicate of an existing entry at a different priority level
is not allowed .
To change the priority of an existing server address, use the no form of the command to remove the entry, then
re-enter the address with the new priority.

The no form of the command replaces the configured IP address with the null setting. (Default: null)

Syntax:

[no] ip dns domain-name <domain-name-suffix>
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This optional DNS command configures the domain suffix that is automatically appended to the host name
entered with a DNS-compatible command. When the domain suffix and the IP address for a DNS server that can
access that domain are both configured on the switch, you can execute a DNS-compatible command using only
the host name of the desired target. (For an Example:, see Example: of using either a host name or a fully
qualified domain name.) In either of the following two instances, you must manually provide the domain
identification by using a fully qualified DNS name with a DNS-compatible command:

• If the DNS server IP address is configured on the switch, but the domain suffix is not configured (null).

• The domain suffix configured on the switch is not the domain in which the target host exists.

The switch supports one domain suffix entry and three DNS server IP address entries. (See the preceding
command description.)

The no form of the command replaces the configured domain suffix with the null setting. (Default: null)

Using DNS names with ping and traceroute: Example:
In the network illustrated in Figure 99: Example: network domain on page 547, the switch at 10.28.192.1 is
configured to use DNS names for DNS-compatible commands in the pubs.outdoors.com domain. The DNS
server has been configured to assign the host name docservr to the IP address used by the document server
(10.28.229.219).

Figure 99: Example: network domain

Configuring switch "A" with the domain name and the IP address of a DNS server for the domain enables the
switch to use host names assigned to IP addresses in the domain to perform ping and traceroute actions on
the devices in the domain. To summarize:

Entity Identity

DNS server IP address 10.28.229.10

Domain name (and domain suffix for hosts in the
domain)

pubs.outdoors.com

Host name assigned to 10.28.229.219 by the DNS
server

docservr

Fully qualified domain name for the IP address used by
the document server (10.28.229.219)

docservr.pubs.outdoors.com

Table Continued
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Entity Identity

Switch IP address 10.28.192.1

Document server IP address 10.28.229.219

With the above already configured, the following commands enable a DNS-compatible command with the host
name docserver to reach the document server at 10.28.229.219.

Configuring switch "A" in Example: network domain to support DNS resolution

switch(config)# ip dns server-address 10.28.229.10
switch(config)# ip dns domain-name pbs.outdoors.com

Ping and traceroute execution for the network in Example: network domain

switch(config)# ping docservr
10.28.229.219 is alive, time = 1 ms

switch# traceroute docservr
traceroute to 10.28.229.219
              1 hop min, 30 hops max, 5 sec. timeout, 3 probes
 1 10.28.192.2 1           1 ms       0 ms       0 ms
 2 10.28.229.219 2         0 ms       0 ms       0 ms

• 1First-Hop Router (“B”)

• 2Traceroute Target

As mentioned under the following example, if the DNS entry configured in the switch does not include the domain
suffix for the desired target, you must use the target host's fully qualified domain name with DNS-compatible
commands. For example, using the document server in Figure 99: Example: network domain on page 547 as a
target:

Figure 100: Example: of ping and traceroute execution when only the DNS server IP address is configured
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Viewing the current DNS configuration
The show ip command displays the current domain suffix and the IP address of the highest priority DNS server
configured on the switch, along with other IP configuration information. If the switch configuration currently
includes a non-default (non-null) DNS entry, it will also appear in the show run command output.

Figure 101: Example: of viewing the current DNS configuration

Operating notes
• Configuring another IP address for a priority that has already been assigned to an IP address is not allowed.

To replace one IP address at a given priority level with another address having the same priority, you must first
use the no form of the command to remove the unwanted address. Also, only one instance of a given server
address is allowed in the server list. Attempting to enter a duplicate of an existing entry at a different priority
level is not allowed. To change the priority of an existing server address, use the no form of the command to
remove the entry, then re-enter the address with the new priority.

• To change the position of an address already configured with priority x, you must first use no ip dns
server-address priority x <ip-addr> to remove the address from the configuration, then use ip
dns server-address priority <ip-addr> to reconfigure the address with the new priority. Also, if the
priority to which you want to move an address is already used in the configuration for another address, you
must first use the no form of the command to remove the current address from the target priority.

• The DNS servers and domain configured on the switch must be accessible to the switch, but it is not
necessary for any intermediate devices between the switch and the DNS server to be configured to support
DNS operation.

• When multiple DNS servers are configured on the switch, they can reside in the same domain or different
domains.

• A DNS configuration must include the IP address for a DNS server that is able to resolve host names for the
desired domain. If a DNS server has limited knowledge of other domains, its ability to resolve DNS-compatible
command requests is also limited.

• If the DNS configuration includes a DNS server IP address but does not also include a domain suffix, then any
DNS-compatible commands should include the target host’s fully qualified domain name.

• Switch-Initiated DNS packets go out through theVLAN having the best route to the DNS server, even if
aManagement VLAN has been configured.

• The DNS server address must be manually input. It is not automatically determined viaDHCP.
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Event Log messages
Please see the Event Log Message Reference Guide for information about Event Log messages.

Locating a switch (Locator LED)
To locate where a particular switch is physically installed, use the chassislocate command to activate the blue
Locator LED on the switch's front panel.

Syntax:

chassislocate [blink | on | off]
Locates a switch by using the blue Locate LED on the front panel.

blink <1-1440> Blinks the chassis Locate LED for a specified number of minutes (Default: 30
minutes).

on <1-1440> Turns the chassis Locate LED on for a specified number of minutes (Default: 30
minutes).

off Turns the chassis Locate LED off.

Locating a switch with the chassislocate command

switch(config)# chassislocate
 blink <1-1440>       Blink the chassis locate led (default 30 minutes).
 off                  Turn the chassis locate led off.
 on <1-1440>          Turn the chassis locate led on (default 30 minutes).
switch(config)# chassislocate
For redundant management systems, if the active management module failsover, the Locator LED does not
remain lit.
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Job Scheduler
The Job Scheduler feature enables the user to schedule commands or jobs on the switch for one time or multiple
times. This is similar in concept to the UNIX ‘cron’ utility. The user can schedule any CLI command that the user
would otherwise enter interactively. This includes commands to enable or disable ports, LEDs, and Power-Over-
Ethernet. Jobs can also be scheduled to be triggered by certain pre-defined events such as switch reboot. The
only major restriction on commands scheduled is that, it should not prompt/ask for any user inputs.

Commands

Job at | delay | enable | disable
Set schedule jobs using the options and set the count for the number of times the job is repeated.

Syntax

job JOB NAME at | delay | enable | disable
Description

Schedule a command to run automatically. Jobs can be scheduled to run once, multiple times on a recurring
basis, or after certain events such as reboots. All commands run with manager privilege in configuration context.

The [no] form of the command deletes a scheduled job.

By default, jobs will be repeated an infinite number of times.

Restrictions

Jobs scheduled at any event will not be counted.

Jobs that are scheduled at the event “reboot” will not work in some multi management switches.

Range

• <1-1000>: is the value range for the count option.

• ([[DD:]HH:]MM): is the format used for the specific delay.

Options

count

Specify the number of times the job should run.

delay

Specify the delay before running the job.

enable

Enable a job that is disabled or expired.

disable

Disable a job. By default, a job is enabled.

Chapter 14
Job Scheduler
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Usage

job <JOB NAME> at <([DD:]HH:]MM on <WEEKDAY-LIST>)> config-save <COMMAND> count <1-1000>

job <JOB NAME> at <[HH:]MM on [MM/]DD> config-save <COMMAND> count <1-1000>

job <JOB NAME> at <EVENT> config-save <COMMAND>

job <JOB NAME> delay <([DD:]HH:]MM> config-save <COMMAND> count <1-1000>

job <JOB NAME> enable | disable

[no] job <JOB NAME>

Show job
Syntax

show job
Description

Show the jobs scheduled.

Show job

switch# show job

 Job Scheduler Status and Configuration

  Scheduler Status : Waiting for the system time to be set

                     Event or            Repeat  Save 
  Name               Time                Count   Cfg  Command
  ------------------ ---------------- ------- ---- ------------
  Burrrrrrrrrrrr...  reboot              --    Yes chassislocate blink
  baz                reboot              --     No  show time
  foo                17:00 SxTWTxS       --     No  savepower led
  a1                 12:00               2      Yes sh time
  a2                 Every 2:14:30 days  75     Yes vlan 3
  a3                 Every 00:00:25 days 1      No  vlan 4

NOTE: Caution

The scheduler does not run until the system time is set.

Show job <Name>
Syntax

show job JOB NAME
Description

Show the job by name.
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Show job <JOB NAME>

switch# show job a1

Job Information

Job Name    : a1
Runs At     : 01:24
Config Save : No
Repeat Count: --
Job Status  : Enabled
Run Count   : 1
Error Count : 0
Command     : show time
Job Status  : Enabled

 Output from Last Run
 --------------------
 Tue Dec 15 01:24:00 2015
 

switch# show job a2

Job Information

Job Name    : a2
Runs At     : Every 2:14:30 days
Config Save : Yes
Repeat Count: 75
Run Count   : 0
Error Count : 0
Command     : vlan 3
Job Status  : Disabled

switch# show job foo

Job Information

Job Name    : foo
Runs At     : 17:00 SxTWTxS
Config Save : Yes
Repeat Count: --
Run Count   : 0
Error Count : 0
Command     : savepower led
Job Status  : Enabled
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Overview
The traditional way of restoring a configuration from a backup configuration file required a switch reboot for the
new configurations to be effective. There were network outages and a planned downtime for even minor changes.
The switch configuration can now be restored from a backup configuration without reboot. It also provides hash of
the current running configuration, which can be used for auditing.

The backup configuration can be created using the new command cfg-backup. An existing method of copying a
configuration file from a remote location (for example, TFTP server) can also be used to backup a configuration or
copied from flash.

More information

show hash on page 574
cfg-backup on page 558
cfg-restore config_bkp on page 567

Benefits of configuration restore without reboot

• Restores a new or modified configuration without reboot, with minimal network outage. Any NMS can use this
method for configuration rebase workflows. Only configurations that were exported from the switch can be
imported or restored on the switch.

• Restores the configuration without reboot from a backup configuration when the running configuration has
functional issues, like misconfigurations from remote management stations.

Recommended scenarios
• Use the configuration restore feature for incremental configuration updates.

• Use the force option with cfg-restore, for commands which require reboot.

• Use the verbose option to get detailed progress on the configuration restore process.

More information

Force configuration restore on page 562
cfg-restore verbose on page 566

Use cases
• A user can switch to a new configuration without rebooting the switch.

• If a user loses connectivity after applying the new configuration, a job scheduler executes the job after a
specific time frame. This restores the current configuration to the switch, without rebooting it.

More information

Switching to a new configuration on page 555
Rolling back to a stable configuration using job scheduler on page 556

Chapter 15
Configuration backup and restore without reboot
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Switching to a new configuration

Procedure

1. Back up the configuration using cfg-backup running-config config <config_name> command. In
the following example, the configuration name used is “stable”.
cfg-backup running-config config stable

2. Check the backup configuration using show config files command.

switch(config)# show config files

Configuration files:

id | act pri sec | name
---+-------------+--------
1  |  *   *   *  | config
2  |             | stable
3  |             |
4  |             |
5  |             |

3. Change the running configuration as required, and backup the new configuration as “newfile”.

cfg-backup running-config config newfile

switch(config)# show config files

Configuration files:

 id | act pri sec | name
 ---+-------------+---------
  1 |  *   *   *  | config
  2 |             | stable
  3 |             | newfile
  4 |             |
  5 |             |

4. Check the difference between the “newfile” (running configuration) and “stable” (backed up configuration)
using cfg-restore flash stable diff command. Based on the difference, apply the backed-up
configuration using cfg-restore flash stable command.

5. Check the status of the configuration restore using show cfg-restore status command.

switch(config)# show cfg-restore status

 Status                 : Success
 Config File Name       : stable
 Source                 : Flash
 Time Taken             : 3 Seconds
 Last Run               : Tue Nov 28 18:24:09 2017

 Recovery Mode          : Enabled
 Failure Reason         : -

 Number of Add Commands    : 14
 Number of Remove Commands : 0

 Time Taken for Each Phase :
      Calculating diff     : 1 Seconds
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      Adding commands      : 2 Seconds
      Removing commands    : 0 Seconds

Rolling back to a stable configuration using job scheduler

Procedure

1. Configure the job using alias with the required configuration.

alias <name> <command-list>
job <name> delay [[DD:]HH:]MM <command>
To schedule a job execution with cfg-restore operation once after 15 minutes (00:00:15):

alias "cfg_rollback" "cfg-restore flash stable"
job "cfg_stable" delay 00:00:15 "cfg_rollback" count 1

2. Back up the current stable configuration using the command cfg-backup running-config config
<config_name>.

cfg-backup running-config config stable
3. Check the backup configuration using the command show config files.

switch(config)# show config files

Configuration files:

id | act pri sec | name
---+-------------+-------
1  |  *   *   *  | config
2  |             | stable
3  |             |
4  |             |
5  |             |

4. Edit the configuration as needed. If the user is still connected to the switch, the configuration is stable and the
job which reloads the older configuration can be cancelled using the command no job cfg_stable.

switch(config)# no job cfg_stable
5. If the user loses connectivity after applying the new configuration, the job scheduler executes the job after the

15-minute timer expires, and “stable” configuration is restored. Use the following commands to check the
output:

• switch(config)# show job cfg_stable
• switch(config)# show cfg-restore status

switch(config)# show job cfg_stable

 Job Information

  Job Name       : cfg_stable
  Runs At        : Every 00:00:15 days:hours:minutes
  Config Save    : No
  Repeat Count   : 1
  Job Status     : Enabled
  Running Status : Active
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  Run Count      : 0
  Error Count    : 0
  Skip Count     : 0
  Command        : cfg_rollback

switch(config)# show cfg-restore status
 Status                 : Success
 Config File Name       : stable
 Source                 : Flash
 Time Taken             : 9 Seconds
 Last Run               : Tue Nov 28 20:50:00 2017

 Recovery Mode          : Enabled
 Failure Reason         : -

 Number of Add Commands    : 27
 Number of Remove Commands : 0

 Time Taken for Each Phase :
      Calculating diff     : 4 Seconds
      Adding commands      : 1 Seconds
      Removing commands    : 0 Seconds

NOTE: If the configuration involves any sensitive information, backup and restore the
configuration by enabling the include-credentials command.

Commands used in switch configuration restore without
reboot
cfg-backup

Backs up the selected configuration to the flash file.

show config files details
Shows a detailed list of configuration files available in the flash.

cfg-restore
Restores the given configuration as the running configuration without reboot.

show cfg-restore status
Shows the status of latest restore performed.

show cfg-restore latest-diff
Views the list of configuration changes that are removed, modified, or added to the running configuration.

show hash
Shows the SHA ID of a startup or running configuration.

Configuration backup
The configuration backup creates a backup of the running or startup configuration of ArubaOS-Switch on-demand
to the flash storage on the switch. The maximum number of backup files supported has increased from three to
five.

NOTE: When you downgrade configuration backup files from five to three, and if the current number
of files is either a four or five, an error message Configuration file <name> stored in
config index 5 is not supported in lower image versions is displayed.
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cfg-backup
Syntax
cfg-backup {running-config | startup-config} config <FILE-NAME>

Description

Backs up the selected configuration to the flash file mentioned. When the firmware is downgraded to lower
versions, the details of only three configuration files appear in the show config files command.

Command context
config

Parameters
running-config

Copies the running configuration to switch flash file.
startup-config

Copies the startup configuration to switch flash file.

flash
Name of the configuration file in flash.

Usage
copy {startup-config | running-config} {sftp | tftp} <server address> <FILE-NAME>
The existing copy command copies the startup and running configuration to the TFTP or SFTP server.

Examples

switch(config)# cfg-backup
 running-config       Backup the running configuration to the flash file
                      mentioned.
 startup-config       Backup the startup configuration to the flash file
                      mentioned.

switch(config)# cfg-backup {running-config | startup-config}
 config                Backup the named configuration file.

switch(config)# cfg-backup {running-config | startup-config} config
 ASCII-STR             Enter an ASCII string.

show config files
Syntax
show config files

Description

Shows a list of configuration files available in the flash.

Command context
config
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Examples

switch# show config files
Configuration files:

 id | act pri sec | name
 ---+-------------+---------
  1 |  *   *   *  | config
  2 |             | add
  3 |             | modify
  4 |             | golden_config
  5 |             | poe2
To show the details of saved configuration files:

switch(config)# show config files
 details        Show details of saved configuration files.

switch(config)#show config files details

 Backup Configuration files:

 File Name      : config
 File ID        : 1
 File Size      : 35902 Bytes
 Last Modified  : Mon Jan 01 1990 00:09:28
 Version        : WC.16.05.0000x

 File Name      : add
 File ID        : 2
 File Size      : 35902 Bytes
 Last Modified  : Mon Oct 23 2017 03:42:38
 Version        : WC.16.05.0000x

 File Name      : modify
 File ID        : 3
 File Size      : 35902 Bytes
 Last Modified  : Mon Oct 23 2017 03:42:38
 Version        : WC.16.05.0000x
To view the contents of a configuration file in the flash:

switch# show config add

; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a
snmp-server community "public" unrestricted
vlan 1
   name "DEFAULT_VLAN"
   no untagged 3-10
   untagged 1-2,11-28
   ip address dhcp-bootp
   exit
vlan 100
   name "VLAN100"
   untagged 3-5
   no ip address
   exit
vlan 200
name "VLAN200"
   untagged 6-10
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   no ip address
   exit

Configuration restore without reboot
The cfg-restore without reboot command restores the configuration without reboot from a backup
configuration to the running configuration of the switch.

The details about the difference between a running and a backup configuration can be displayed using cfg-
restore {flash | tftp | sftp} <FILE-NAME> diff command.

More information

Configuration backup on page 557
Viewing the differences between a running configuration and a backup configuration on page 572

cfg-restore
Syntax
cfg-restore {flash | tftp <IP-ADDRESS> | sftp <IP-ADDRESS>} <FILE-NAME> [diff |
force | non-blocking | recovery-mode | verbose]

Description

Restores the given configuration as the running configuration without reboot. If the configuration is not suitable to
successfully restore without reboot, the command will return a failure message with details.

NOTE: The restored configuration commands will be executed on a running configuration, so the
name of the current active configuration does not change after configuration restore, except for the
force option.

Command context
config

Parameters
flash

Copies file from flash.
tftp

Copies file from TFTP server.

sftp
Copies file from SFTP server.

<IP-ADDRESS>

IP address of the TFTP server.

<FILE-NAME>

Name of the backup configuration file to restore into the running configuration.

diff
Provides the list of changes that will be applied on the running configuration.
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force
Forces a reboot if configuration in restored configuration requires a reboot. Applies the configuration with
reboot if the configuration has reboot required commands or system-wide change commands. After a forced
reboot, the name of the configuration changes.

non-blocking
Configuration restoration in non-blocking mode, where actual process happens in the background.

recovery-mode
Enables or disables recovery-mode. Recovery-mode is enabled by default and this retains the current running
configuration if configuration restoration fails.

verbose
Provides the details of configuration restore status and the list of commands to be added or deleted.

Usage

• cfg-restore flash <FILE-NAME> [non-blocking | diff | force | recovery-mode{enable
| disable}]] | [verbose [force | [recovery-mode{enable | disable}] | [diff |
force]

• cfg-restore tftp {<IPV4-ADDR> | <IPV6-ADDR> | <HOSTNAME-STR> <FILE-NAME> [non-
blocking | diff | force | recovery-mode{enable | disable}]] | [verbose [force |
[recovery-mode{enable | disable}]] | [diff |force]

• cfg-restore sftp {<IPV4-ADDR> | <IPV6-ADDR> | <HOSTNAME-STR> | user <name> {<IP-
ADDRESS|IPV6-ADDRESS|HOSTNAME-STR>} | <USERNAME@>{<HOST-NAME> | <IPV4-ADDR> |
<IPV6-ADDR>}} [port <1-65535>] <FILE-NAME> [non-blocking | diff | force |
recovery-mode{enable | disable}]] | [verbose [force | [recovery-mode{enable |
disable}]] | [diff |force]

Examples

switch# cfg-restore
 flash              Copy file from flash. 
 sftp               Copy file from SFTP Server. 
 tftp               Copy file from TFTP Server. 

switch# cfg-restore flash
 FILE-NAME          Name of the backup configuration file to restore into the running 
                       configuration. 

switch# cfg-restore flash config_file
 diff               Provide the list of changes that will be applied on the
                    running configuration.
 force              Apply the configuration with reboot if the
                    configuration has reboot required commands or
                    system-wide change commands present.
 non-blocking       Config restoration in non-blocking mode.
 recovery-mode      To enable/disable recovery-mode.
 verbose               Provide the details of config restore status and the list of commands to be added 
                    or deleted.        

switch# cfg-restore tftp
 HOSTNAME-STR       Specify hostname of TFTP Server.
 IP-ADDR            IP Address of the TFTP Server.
 IPV6-ADDR          IPV6 Address of the TFTP Server.

switch# cfg-restore tftp 10.100.0.12
 FILE-NAME          Name of the backup configuration file to restore into the running 
                       configuration. 

switch# cfg-restore tftp 10.100.0.12 config_file
 diff                Provide the list of changes that will be applied on the
                     running configuration.
 force               Apply the configuration with reboot if the
                     configuration has reboot required commands or
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                     system-wide change commands present.
 non-blocking        Config restoration in non-blocking mode.
 recovery-mode       To enable/disable recovery-mode.
 verbose                Provide the details of config restore status and the list of commands to be added 
                     or deleted.

switch(config)# cfg-restore flash add non-blocking
 diff                Provide the list of changes that will be applied on
                     the running configuration.
 force               Apply the configuration with reboot if the configuration has reboot required commands or
                     system-wide change commands present.
 recovery-mode       To enable/disable recovery-mode.

Force configuration restore
The cfg-restore command fails if a reboot is required. The Configuration restoration is not
allowed as the configuration has reboot required commands error is displayed, along with lines
requiring a reboot. The force option in the cfg-restore command allows a user to force a reboot. The
command is: cfg-restore {flash | tftp | sftp} <FILE-NAME> force.

Before reboot, config is the active configuration. After the device reboots, the backup file becomes the new
active configuration.

id | act pri sec | name
---+-------------+---------------
 1 |  *   *   *  | config
 2 |             | def
 3 |             | golden_config
 4 |             |
 5 |             | 

switch(config)# cfg-restore flash golden_config
Current running-configuration will be replaced with 'golden_config'.
Continue (y/n)? y
Configuration restore is in progress, configuration changes are temporarily
 disabled.
Configuration restoration is not allowed as the configuration has reboot required commands.

switch(config)# show cfg-restore status
 Status                 : Failed
 Config File Name       : golden_config
 Source                 : Flash
 Time Taken             : 5 Seconds
 Last Run               : Mon Oct 30 23:03:19 2017

 Recovery Mode          : Enabled
 Failure Reason         : Reboot required commands present.
 Command : console terminal none

 Number of Add Commands    : 0
 Number of Remove Commands : 1

Time Taken for Each Phase :
      Calculating diff     : 3 Seconds
      Adding commands      : 0 Seconds
      Removing commands    : 0 Seconds

switch# cfg-restore flash golden_config force
Device may be rebooted if the configuration file has reboot required or
system-wide change commands. Do you want to continue  (y/n)?
Current running-configuration will be replaced with 'golden_config'.
Continue (y/n)?
Configuration restore is in progress, configuration changes are temporarily
disabled.

Successfully applied configuration 'golden_config' to running configuration.

Rebooting switch...
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In the preceding output, Command : console terminal none shows that cfg-restore failed because a
reboot is required.

After the switch reboots and comes up, the golden_config becomes the active configuration.

NOTE: In case of a switch reboot, the switch comes up with the configuration associated with the
primary or secondary.

 id | act pri sec | name
 ---+-------------+------------------------------------------------
  1 |      *   *  | config
  2 |             | def
  3 |  *          | golden_config
  4 |             | 
  5 |             |

switch# show cfg-restore status
 Status                 : Success
 Config File Name       : default
 Source                 : Flash
 Time Taken             : 1 Seconds
 Last Run               : Mon Oct 23 07:17:03 2017

 Recovery Mode          : Enabled
 Failure Reason         : -

 Number of Add Commands    : 0
 Number of Remove Commands : 5

Time Taken for Each Phase :

      Calculating diff     : 1 Seconds
      Adding commands      : 0 Seconds
      Removing commands    : 0 Seconds

NOTE: Time taken for adding and deleting commands is zero, as the switch reboots. It is similar to
downloading a startup-configuration to the device.

cfg-restore non-blocking

Syntax
cfg-restore {flash | tftp | sftp} <FILE-NAME> non-blocking

Description

Performs restore in non-blocking mode.

Command context
config

Example

switch(config)# cfg-restore flash add non-blocking
Current running-configuration will be replaced with 'add'.
Continue (y/n)? y
Configuration restore is in progress, configuration changes are
temporarily disabled.
switch(config)#
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switch(config)# show cfg-restore status
 Status                 : Success
 Config File Name       : add
 Source                 : Flash
 Time Taken             : 2 Seconds
 Last Run               : Sun Oct 22 22:09:02 2017

 Recovery Mode          : Enabled
 Failure Reason         : -

 Number of Add Commands    : 7
 Number of Remove Commands : 10

Time Taken for Each Phase :                                               
      Calculating diff     : 1 Seconds
      Adding commands      : 0 Seconds
      Removing commands    : 0 Seconds

cfg-restore recovery-mode

Syntax
cfg-restore {flash | tftp | sftp} <FILE-NAME> recovery-mode {enable | disable}

Description

Restores the current running configuration, if a restore to the backup configuration fails. By default, recovery-
mode is enabled.

Command context
config

Usage

To disable recovery mode, use cfg-restore {flash | tftp | sftp} <FILE-NAME> recovery-mode
disable.

Example

With the following running configuration, a restore to the backup file modify fails, but this configuration will be
retained as recovery mode is enabled.

switch(config)# show running-config

Running configuration:

; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a
ip routing
snmp-server community "public" unrestricted
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-28
   ip address dhcp-bootp
   exit
vlan 10
   name "VLAN10"
   no ip address
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   exit

switch(config)# show config modify
; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a
ip default-gateway 172.20.0.1
ip routing
snmp-server community "public" unrestricted
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-28
   ip address dhcp-bootp
   exit
vlan 100
   name "VLAN100"
   no ip address
   exit

switch(config)# cfg-restore flash modify
Current running-configuration will be replaced with 'modify'.
Continue (y/n)? y
Configuration restore is in progress, configuration changes are
 temporarily disabled.

Configuration restore to config 'modify' failed, restored source
 configuration to running configuration.

switch(config)# show running-config

Running configuration:

; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a
ip routing
snmp-server community "public" unrestricted
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-28
   ip address dhcp-bootp
   exit
vlan 10
   name "VLAN10"
   no ip address
   exit

switch(config)# cfg-restore flash modify recovery-mode disable
Current running-configuration will be replaced with 'modify'.
Continue (y/n)? y
Configuration restore is in progress, configuration changes are
 temporarily disabled.

Partially applied configuration 'modify' to running configuration.
Aruba-2930F-24G-PoEP-4SFPP(config)# show running-config

Running configuration:

; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a
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ip routing
snmp-server community "public" unrestricted
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-28
   ip address dhcp-bootp
   exit
vlan 100
   name "VLAN100"
   no ip address
   exit

cfg-restore verbose

Syntax
cfg-restore {flash | tftp | sftp} <FILE-NAME> verbose

Description

Provides the details of configuration restore status and the list of commands to be added or deleted along with
cfg-restore.

Command context
config

Examples

switch(config)# cfg-restore flash config verbose
Current running-configuration will be replaced with 'config'.
Continue (y/n)? y

Configuration restore is in progress, configuration changes are temporarily disabled.

Configuration Restore Information: 

 Status                 : Success
 Config File Name       : config
 Source                 : Flash
 Time Taken             : 6 Seconds
 Last Run               : Tue Nov  7 03:43:07 2017

 Recovery Mode          : Enabled
 Failure Reason         : -

 Number of Add Commands    : 0
 Number of Remove Commands : 12

Time Taken for Each Phase :
      Calculating diff     : 2 Seconds
      Adding commands      : 0 Seconds
      Removing commands    : 0 Seconds

Configuration delete list:

vlan 2
   name "VLAN2"
   no ip address
   exit
vlan 3
   name "VLAN3"
   no ip address
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   exit
vlan 4
   name "VLAN4"
   no ip address
   exit
vlan 5
   name "VLAN5"
   no ip address
   exit

Successfully applied configuration 'config' to running configuration.

cfg-restore config_bkp

Syntax
cfg-restore {tftp <ip-address> | sftp <ip-address>} config_bkp

Description

Downloads and restores a configuration from the TFTP or SFTP server, without rebooting the switch.

NOTE: The commands from the restored configuration will be executed on the running configuration.
The name of the current active configuration will not change after a configuration restore.

Command context
config

Example

switch(config)# cfg-restore tftp
 HOSTNAME-STR          Specify hostname of TFTP Server.
 IP-ADDR               IP Address of the TFTP Server.
 IPV6-ADDR             IPV6 Address of the TFTP Server.

switch(config)# cfg-restore sftp
 HOSTNAME-STR          Specify hostname of the SFTP server.
 IP-ADDR               IP Address of the SFTP Server.
 IPV6-ADDR             IPV6 Address of the SFTP Server.
 user                  Specify username on the remote system information
 USER@IP-STR           Specify username along with remote system
                       information

switch(config)# cfg-restore tftp 10.100.0.12 pvos/tftp_2930_config_file
Current running-configuration will be replaced with 'tftp_2930_config_file'.
Continue (y/n)? y
Configuration restore is in progress, configuration changes are temporarily disabled.

Successfully applied configuration 'tftp_2930_config_file' to running configuration.

switch(config)# sh cfg-restore status
 Status                 : Success
 Config File Name       : tftp_2930_config_file
 Source                 : TFTP
 Time Taken             : 4 Seconds
 Last Run               : Wed Nov  8 21:11:10 2017

 Recovery Mode          : Enabled
 Failure Reason         : -

 Number of Add Commands    : 4
 Number of Remove Commands : 7
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Time Taken for Each Phase :
      Calculating diff     : 1 Seconds
      Adding commands      : 0 Seconds
      Removing commands    : 0 Seconds

switch(config)# show config files

Configuration files:

 id | act pri sec | name
 ---+-------------+---------
  1 |  *   *   *  | config
  2 |             |
  3 |             |
  4 |             |
  5 |             |

Configuration restore with force option

Prerequisites
Back up the configuration using traditional copy config or cfg-backup commands.

Procedure

1. Execute the show config files command. By default, the config file provides all the associations.

switch(config)# show config files

Configuration files:

 id | act pri sec | name
 ---+-------------+-------
  1 |  *   *   *  | config
  2 |             | file1
  3 |             | file2
  4 |             |
  5 |             |

2. Use cfg-restore flash file1 force command to see the configuration of file1.

switch(config)# cfg-restore flash file1 force
As the file1 configuration requires a reboot, a system reboot occurs. When the switch comes up, file1 is the
new active configuration.

switch(config)# sh config files

Configuration files:

 id | act pri sec | name
 ---+-------------+---------
  1 |      *   *  | config
  2 |  *          | file1
  3 |             | file2
  4 |             |
  5 |             |

NOTE: During a configuration restore with reboot, the association changes. To make the
configuration as a default configuration for subsequent system reboots, use startup-default
[<primary|secondary>] config FILENAME command.
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For startup-default config file1:

switch(config)# show config files

Configuration files:

id | act pri sec | name
 --+-------------+---------
 1 |             | config
 2 |  *   *   *  | file1
 3 |             | file2
 4 |             |
 5 |             |

System reboot commands
Following commands require a system reboot:

• secure-mode standard
• secure-mode enhanced
• mesh id [0-9]
• mesh [a-z | A-Z | 0-9]
• max-vlans <257-4094>
• no allow-v2-modules
• qinq (mixedvlan | svlan)
• qos queue-config
• terminal type (vt100 | ansi)
• console (flow-control | terminal)
• vsf member [0-9]
• vsf remove
• access-list grouping
• console baud-rate (speed-sense | 1200 | 2400 | 4800 | 9600 | 19200 | 38400 |

57600 | 115200)

Systemwide change commands
Following commands change the system configuration:

• module [0-9 | a-z | A-Z]
• module [0-9 | a-z | A-Z] type <type>
• igmp lookup-mode ip
• flexible-module [a-z | A-Z] type <type>
• stacking member [0-9] flexible-module [a-z | A-Z] type <type>
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Configuration restore without force option
If the two configuration files backed up are file1 and file2:

Prerequisites
Backup the configuration using either the traditional copy config or the cfg-backup commands.

Procedure

1. Execute the show config files command. By default, the config file provides all the associations.

switch(config)# show config files

Configuration files:

 id | act pri sec | name
 ---+-------------+-------
  1 |  *   *   *  | config
  2 |             | file1
  3 |             | file2
  4 |             |
  5 |             |

2. Use cfg-restore flash file1 command to see the configuration of file1.

switch(config)# cfg-restore flash file1
Even after executing the previous command, associations will remain the same, but the running configuration
is replaced by file1 configuration.

NOTE: In a configuration restore without reboot, the association remains the same. The default
config file is updated based on the configuration of the restored file.

show cfg-restore status
Syntax
show cfg-restore status

Description

Shows the status of latest restore performed. The running configuration is updated based on the configuration of
the restored file.

Command context
config

Usage
show cfg-restore {status | latest-diff}
This command provides information on:

• how a restore is performed

• whether a flash file was used from SFTP or TFTP server

• the total time taken to restore

• the time when last restore was initiated
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• whether a recovery-mode was enabled

• the number of add and delete commands

• reboot commands present (if any), and

• the split time taken for each phase

Examples

switch(config)# show cfg-restore
 latest-diff           Shows the difference between running and back-up
                       configuration.
 status                Show configuration restoration status.

switch(config)# show cfg-restore status
Status           : [Failed| In progress | Success | Not Started]
Config File name : def
Source           : [-|Tftp|sftp|Flash|REST]
Time taken       : [-|20 Seconds.]
Last Run         : [-|Tue March 07 22:12:16 2017.]

Recovery Mode          : Enabled
Failure Reason         : -

Number of Add Commands    : 0
Number of Remove Commands : 3

Time Taken for Each Phase :
      Calculating diff     : 1 Seconds
      Adding commands      : 0 Seconds
      Removing commands    : 0 Seconds
If the configuration restoration fails, the line number and the failed commands are displayed:

switch(config)# show cfg-restore status
Status           : Failed
Config File name : def
Source           : Flash
Time taken       : 20 Seconds
Last Run         : Sun Oct 22 20:22:54 2017

Recovery Mode          : Enabled
Failure Reason         : Add commands have been failed

Number of Add Commands    : 0
Number of Remove Commands : 3

Time Taken for Each Phase :
      Calculating diff     : 1 Seconds
      Adding commands      : 0 Seconds
      Removing commands    : 0 Seconds

Failed to remove commands:
 Line: 12 vlan 10
 Line: 15 no ipv6 nd snooping mac-check
Failed to add commands:
 Line: 10 icmp 10.100.0.12 source-inter vlan 1
 Line: 20 udp-echo 10.100.0.12 source vlan 1
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NOTE: The number of add and delete commands is calculated excluding the exit commands in the
configuration file.

Viewing the differences between a running configuration and a backup
configuration

Prerequisites
Use the cfg-restore {flash | tftp | sftp} <FILE-NAME> diff command to view the list of
configuration changes that are removed, modified, or added to the running configuration.

Procedure

1. Execute the show running-config command to show the running configuration of the switch.

switch(config)# show running-config

Running configuration:

; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a
snmp-server community "public" unrestricted
vlan 1
   name "DEFAULT_VLAN"
   no untagged 11-13,15-18
   untagged 1-10,14,19-28
   ip address dhcp-bootp
   exit
vlan 100
   name "VLAN100"
   untagged 11-13
   no ip address
   exit
vlan 300
   name "VLAN300"
   untagged 15-18
   no ip address
   exit

2. Execute the show config golden_config command to show the backup configuration of the switch.

switch(config)# show config golden_config
; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a
; JL255A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #12:08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ba
hostname "Aruba-2930F-24G-PoEP-4SFPP"
module 1 type jl255a

3. Execute the cfg-restore flash golden_config diff command to view the differences that will be
applied.

switch# cfg-restore flash golden_config diff 
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Configuration delete list:

vlan 1
   no untagged 11-13,15-18
   untagged 3-10
   exit
vlan 100
   untagged 11-13
   exit
vlan 300
   name "VLAN300"

   untagged 15-18
   no ip address
   exit

Configuration add list:

vlan 1
   no untagged 3-10
   untagged 11-13,15-18
   exit
vlan 100
   untagged 3-5
   exit
vlan 200
   name "VLAN200"
   untagged 6-10
   no ip address
   exit

NOTE: If the running and the backup configuration is the same, no difference will be displayed.

switch(config)# cfg-restore flash modify diff

Current config and backup config is identical.

4. Execute the show cfg restore latest-diff command to display the difference between the running
and the backup configuration.

switch(config)# show cfg-restore
 latest-diff           Shows the difference between running and back-up
                       configuration.
 status                Show configuration restoration status.

switch(config)# show cfg-restore latest-diff

Configuration delete list:

ip default-gateway 172.20.0.1
vlan 100
   name "VLAN100"
   no ip address
   exit

Configuration add list:

vlan 10
   name "VLAN10"
   no ip address
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   exit

switch(config)#

Show commands to show the SHA of a configuration
The show commands provide SHA details of the running and startup configurations.

show hash
Syntax
show {config | running-config} hash {recalculate}

Description

Shows SHA ID of startup or running configuration.

Command context
config

Examples

switch# show config
 config
 files                 List saved configuration files.
 hash                  Display the hash calculated for the startup
                       configuration.
 interface             Show the startup configuration for interfaces.
 oobm                  Show the startup configuration for OOBM.
 
To display the hash calculated for the startup configuration:

switch(config)# show config hash
The hash must be calculated.  This may take several minutes.

Continue (y/n)? y

Calculating hash...
Startup Configuration hash:

4f66 8b77 6b66 e5fb 0c12 f7fb 8ea6 b548 af2e 2e03

This hash is only valid for comparison to a baseline hash if
the configuration has not been explicitly changed (such as
with a CLI command) or implicitly changed (such as by the
removal of a hardware module).

switch(config)# show config hash
recalculate           Calculate hash (if needed) without prompting.

switch(config)# show config hash recalculate
Startup Configuration hash:

4f66 8b77 6b66 e5fb 0c12 f7fb 8ea6 b548 af2e 2e03

This hash is only valid for comparison to a baseline hash if
the configuration has not been explicitly changed (such as
with a CLI command) or implicitly changed (such as by the
removal of a hardware module).
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To display the hash calculated for the running configuration:

switch(config)# show running-config hash
The hash must be calculated.  This may take several minutes.

Continue (y/n)? y

Calculating hash...
Running configuration hash:

6d88 0880 98af e8a8 b564 15cd 368e 4269 9d61 4bfa

This hash is only valid for comparison to a baseline hash if
the configuration has not been explicitly changed (such as
with a CLI command) or implicitly changed (such as by the
removal of a hardware module).

Scenarios that block the configuration restoration process
The configuration restoration process is blocked in the following scenarios:

• If the restored configuration file requires a reboot.

• If the restored configuration changes the entire configuration (for example, module add or remove).

More information

cfg-restore on page 560

Troubleshooting and support
Switch configuration restore without reboot feature provides CLI support to:

• display the number of commands with line number that failed to restore.

• display the delta between running configuration and the configuration to be restored.

More information

Viewing the differences between a running configuration and a backup configuration on page 572
show cfg-restore status on page 570

debug cfg-restore
Syntax
debug cfg-restore

Description

Debug logs display the commands executed by cfg-restore.

Command context

config and manager

Example

switch(config)# debug cfg-restore
switch(config)# debug destination buffer
switch(config)# show debug buffer
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0000:01:39:51.58 CFG mCfgRestoreMgr:cfg-restore to config file "backup_conif"
   started.
0000:01:39:56.45 CFG mCfgRestoreMgr:cfg-restore diff calculated, number of
   commands to add =0 number of commands to delete = 3.
0000:01:39:56.45 CFG mCfgRestoreMgr:cfg-restore iteration count = 1.
0000:01:39:56.51 CFG mCfgRestoreMgr:Command executed = no vlan 2 tagged 9,
   Status = Success.
0000:01:39:56.51 CFG mCfgRestoreMgr:Command deleted = vlan 2 tagged 9.
0000:01:39:56.58 CFG mCfgRestoreMgr:Command executed = no vlan 3 tagged 9,
   Status = Success.
0000:01:39:56.58 CFG mCfgRestoreMgr:Command deleted = vlan 3 tagged 9.
0000:01:39:56.64 CFG mCfgRestoreMgr:Command executed = no vlan 4 tagged 9,
   Status = Success.
0000:01:39:56.65 CFG mCfgRestoreMgr:Command deleted = vlan 4 tagged 9.
0000:01:39:56.65 CFG mCfgRestoreMgr:cfg-restore iteration count = 2.
0000:01:39:59.38 CFG mCfgRestoreMgr:Successfully applied configuration
   'backup_conif' to running configuration.
** Total debug messages = 22
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Virtual Technician is a set of tools aimed at aiding network switch administrators in diagnosing and caring for their
networks. VT provides tools for switch diagnoses when faced with unforeseen issues.

To improve the Virtual Technician features of our devices have added the following tools:

• Cisco Discovery Protocol

• Enabling Debug tracing for MOCANA code

• User diagnostic crash via front panel security button

• User diagnostic crash via the serial console

Cisco Discovery Protocol (CDP)

Show cdp traffic
Syntax

show cdp traffic
Description

Displays the number of Cisco Discovery Protocol (CDP) packets transmitted, received and dropped.

CDP frame Statistics

Port No|Transmitted Frames|Received Frames|Discarded Frames|Error Frames
-------  -----------------  --------------   ---------------  ---------
A1               46                  26              6           7
A2               30                  35              7           9
A3              120                 420              670       670

Clear cdp counters
Syntax

clear cdp counters
Description

Allows a user to clear CDP statistics.

Clear cdp counters

Port No|Transmitted Frames|Received Frames|Discarded Frames|Error Frames
-------  -----------------  --------------   ---------------  ---------
A1          46                   26                6              7
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A2          30                   35                7              9
A3         120                  420               670            670

show cdp neighbors detail
Syntax
show cdp neighbors detail
Description

Shows CDP neighbors on specified port only.

show cdp neighbor detail

CDP neighbors information

  Port : 1/13
  Device ID : 0.0.0.0
  Address Type : IP
  Address      : 0.0.0.0
  Platform     :
  Capability   : Switch
  Device Port  : 00 1b 4f 49 e7 76
  Version      :

------------------------------------------------------------------------------

  Port : 2/25
  Device ID : 94 18 82 55 50 20
  Address Type : IP
  Address      : 172.31.99.143
  Platform     : Aruba JL356A 2540-24G-PoE+-4SFP+ Switch, revision YC.16....
  Capability   : Switch
  Device Port  : 3
  Version      : Aruba JL356A 2540-24G-PoE+-4SFP+ Switch, revision YC.16....

Enable/Disable debug tracing for MOCANA code

Debug security
Syntax

debug security ssl
Description

Enables the debug tracing for MOCANA code.

Use the [no] parameter to disable debug tracing.

ssl

Display all SSL messages.
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User diagnostic crash via Front Panel Security (FPS)
button
Allows the switch’s front panel Clear button to manually initiate a diagnostic reset. In the case of an application
hang, this feature allows you to perform reliable diagnostics by debugging via the front panel Clear button.
Diagnostic reset is controlled via Front Panel Security (FPS) options.

Front panel security password-clear
From the configure context:

Syntax

[no] front-panel-security password-clear <RESET-ON-CLEAR> | factory-reset | 
password-recovery | diagnostic-reset <CLEAR-BUTTON | SERIAL-CONSOLE>
Description

Enable the ability to clear the password(s) and/or configuration via the front panel buttons.

[no] disables the password clear option.

Parameters

• If password-clear is disabled, the password(s) cannot be reset using the clear button on the front panel of
the device.

• If factory-reset is disabled, the configuration/password(s) can not be reset using the clear and reset
button combination at boot time.

• When password-recovery is enabled (and the front panel buttons disabled), a lost password can be
recovered by contacting customer support.

• When password-recovery is disabled, there is no way to access a device after losing a password with the
front panel buttons disabled.

• If diagnostic-reset is disabled, the user cannot perform a diagnostic switch reset on those rare events
where the switch becomes unresponsive to user input because of unknown reason(s).

• If diagnostic-reset is enabled, the user can perform a diagnostic hard reset which will capture valuable
diagnostic data and reset the switch.

Options

factory-reset

Enable/Disable factory-reset ability.

password-clear

Enable/Disable password clear.

password-recovery

Enable/Disable password recovery.

diagnostic-reset

Enable/Disable diagnostic reset.

Front-panel-security diagnostic-reset
From the configure context:
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Syntax

front-panel-security diagnostic-reset <CLEAR-BUTTON | SERIAL-CONSOLE>
Description

Enables the diagnostic reset so that the switch can capture diagnostic data.

• To initiate diagnostic reset via the clear button, press the clear button for at least 30 seconds but not more than
40 seconds.

• To initiate diagnostic switch reset via the serial console, enter the diagnostic reset sequence on the serial
console.

Options

Clear button

Enables the diagnostics by choosing the clear button option.

Serial console

Enables the diagnostics by choosing the serial console option.

[no] front-panel-security diagnostic-reset
From the configure context:

Syntax

[no] front-panel-security diagnostic-reset
Description

Disables the diagnostic reset feature so that the user is prevented from capturing diagnostic data and performing
a diagnostic reset on the switch. Both the sub-options reset-via-serial-console and reset-via-clear-
button will be disabled. This is necessary if the switch becomes unresponsive (hangs) for unknown reasons.

No front-panel-security diagnostic-reset

no front-panel-security diagnostic-reset

Clear Password       - Enabled
Reset-on-clear     - Disabled
Factory Reset        - Enabled
Password Recovery    - Enabled
Diagnostic Reset     - Disabled

CAUTION:

Disabling the diagnostic reset prevents the switch from capturing diagnostic data on those rare
events where the switch becomes unresponsive to user input because of unknown reasons. Ensure
that you are familiar with the front panel security options before proceeding.

Front-panel-security diagnostic-reset clear-button
From the configure context:
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Syntax

front-panel-security diagnostic-reset clear-button
Description

This command will enable diagnostic-reset via clear button. The user will be allowed to perform diagnostic reset
by depressing the clear button for 30 seconds and not more than 40 seconds.

Front-panel-security diagnostic-rest clear-button

front-panel-security diagnostic-rest clear-button

Diagnostic Reset     - Enabled
clear-button        - Enabled
serial-console      -Disabled

CAUTION:

Disabling the diagnostic reset prevents the switch from capturing diagnostic data on those rare
events where the switch becomes unresponsive to user input because of unknown reasons. Ensure
that you are familiar with the front panel security options before proceeding.

[No] front-panel-security diagnostic-reset clear-button
From the configure context:

Syntax

[no] front-panel-security diagnostic-reset clear-button
Description

Disables the diagnostic-reset via clear button.

CAUTION:

Disabling the diagnostic reset prevents the switch from capturing diagnostic data on those rare
events where the switch becomes unresponsive to user input because of unknown reasons. Ensure
that you are familiar with the front panel security options before proceeding.

Show front-panel-security
Syntax

show front-panel-security
Options

Show front-panel-security

Clear Password    - Enabled
Reset –on-clear   - Disabled
Factory Reset     - Enabled
Password Recovery - Enabled
Diagnostic Reset  - Enabled
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NOTE:

By default, user initiated diagnostic reset is enabled.

Diagnostic table
To accomplish this Do this Result

Soft Reset (Standalone
switch)

Press and release the Reset button The switch operating system is cleared
gracefully (such as data transfer
completion, temporary error conditions are
cleared), then reboots and runs self tests.

Hard Reset (Standalone
switch)

Press and hold the Reset button for
more than 5 seconds (until all LEDs
turn on), then release.

The switch reboots, similar to a power
cycle. A hard reset is used, for example,
when the switch CPU is in an unknown
state or not responding.

Delete console and
management access
passwords

Press Clear for at least one second,
but not longer than 5 seconds.

The switch deletes all access password.

Restore the factory default
configuration

1. Press Clear and Reset
simultaneously.

2. While continuing to press Clear,
release Reset.

3. When the Test LED begins blinking
(after approximately 25 seconds),
release Clear.

The switch removes all configuration
changes, restores the factory default
configuration, and runs self test.

Diagnostic reset 1. Press Clear to 30–40 seconds.

2. When the test LED begins blinking
(approximately after 30 seconds),
release Clear.

NOTE: Releasing the
Clear button when TEST
LED is not blinking
(approximately after 40
seconds ) will not honor
the diagnostic reset
request.

This initiates diagnostic reset, collects
diagnostic information, and reboots the
switch.

NOTE: These buttons are provided for the user’s convenience. If switch security is a concern,
ensure that the switch is installed in a secure location, such as a locked writing closet. To disable
the buttons, use the front-panel-security command.
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Validation rules

Validation Error

Extra ‘token’ passed after diagnostic-reset. Invalid input: <token>.

FPS Error Log

Event Message

RMON_BOOT_CRASH_RECORD1 Diagnostic reset sequence detected on serial
console; user has initiated diagnostic reset.

On detection on local serial

RMON_BOOT_CRASH_RECORD1 SMM: Diagnostic reset sequence detected
on serial console; user has initiated
diagnostic reset.

On detection on SMM serial console and
signaled to AMM

RMON_BOOT_CRASH_RECORD1 STKM: Diagnostic reset sequence detected
on serial console; user has initiated
diagnostic reset.

On detection on non-commander serial
console and signaled to commander

RMON_BOOT_CRASH_RECORD1 User has initiated diagnostic reset via the
serial console.

Sw_panic() message

RMON_BOOT_CRASH_RECORD1 SMM: User has initiated diagnostic reset via
the serial console.

Sw_panic() message when triggered via
SMM

RMON_BOOT_CRASH_RECORD1 STKM: User has initiated diagnostic reset via
the serial console.

Sw_panic() message when triggered via non-
commander

Table Continued
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Event Message

Console print STKM: HA Sync in progress; user initiated
diagnostic request via the serial console
rejected. Retry after sometime.

Printed on the device console. When standby
is in sync state, we don’t want to crash the
commander. So we report to the user to retry
later

Console print STKM: Member is booting; user initiated
diagnostic request via the serial console
rejected. Retry after sometime.

Printed on the device console. When the
member is till booting, it doesn’t have the
commander member number, thus we can’t
issue UIDC on the commander. So we report
to the user to retry later.

User initiated diagnostic crash via the serial console
Remotely triggers a diagnostic reset of the switch via a serial console. This reset reboots the switch and collects
diagnostic data for debugging an application hang, a system hang or any other rare occurrence. Diagnostic reset
is controlled via FPS options.

The serial sequence to initiate the User Initiated Diagnostic Reset via Serial console is Ctrl+S, Ctrl+T, Ctrl+Q, Ctrl
+T, Ctrl+S.

Front-panel-security diagnostic-reset serial-console
In the configure context:

Syntax

front-panel-security diagnostic-reset serial-console
Enables the diagnostic-reset via serial console. Allows the user to perform diagnostic reset by keying-in
diagnostic reset sequence.

Front-panel-security diagnostic-reset serial-console

front-panel-security diagnostic-reset serial-console

Diagnostic Reset     - Enabled
clear-button       - Disabled
serial-console     - Enabled

[No] front-panel-security diagnostic-reset serial-console
In the configure context:

Syntax

[no] front-panel-security diagnostic-reset serial-console
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Description

Disables the diagnostic-reset via serial console.

No front-panel-security diagnostic-reset serial-console

no front-panel-security diagnostic-reset serial-console

Diagnostic Reset     - Disabled

CAUTION:

Disabling the diagnostic reset prevents the switch from capturing diagnostic data on those rare
events where the switch becomes unresponsive to user input because of unknown reasons. Ensure
that you are familiar with the front panel security options before proceeding.

Serial console error messages

Error Message

RMON_BOOT_CRASH_RECORD1 Diagnostic reset sequence detected on serial console;
user has initiated diagnostic reset.

RMON_BOOT_CRASH_RECORD1 SMM: Diagnostic reset sequence detected on serial
console; user has initiated diagnostic reset.

RMON_BOOT_CRASH_RECORD1 STKM: Diagnostic reset sequence detected on serial
console; user has initiated diagnostic reset.

RMON_BOOT_CRASH_RECORD1 User has initiated diagnostic reset via the serial
console.

RMON_BOOT_CRASH_RECORD1 SMM: User has initiated diagnostic reset via the serial
console.

RMON_BOOT_CRASH_RECORD1 STKM: User has initiated diagnostic reset via the serial
console.

Console print STKM: HA Sync in progress; user initiated diagnostic
request via the serial console rejected. Retry after
sometime.

Console print STKM: Member is booting; user initiated diagnostic
request via the serial console rejected. Retry after
sometime.
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Overview
IP Service Level Agreement (IP SLA) is a feature that helps administrators collect information about network
performance in real time. With increasing pressure on maintaining agreed-upon Service Level Agreements on
Enterprises and ISPs alike, IP SLA serves as a useful tool.

Any IP SLA test involves a source node and a destination node. For all discussions in this document, the source
is always an ArubaOS-switch with IP SLA support. As shown in the diagram above, a destination can, in most
cases, be any IP-enabled device. For some SLA types that expect a nonstandard response to a test packet, an
“SLA responder” must be configured. An “SLA responder” is nothing but an ArubaOS-switch with IP SLA
configurations on it that enable it to respond to the test packet.

The IP SLA feature provides:

• Application-aware monitoring that simulates actual protocol packets.

• Predictable measures that aid in ease of deployment and help with assessment of existing network
performance.

• Accurate measures of delay and packet loss for time-sensitive applications.

• End-to-end measurements to represent actual user experience.

We support the following SLA types:

• UDP Echo, including connectivity testing of transport layer (UDP) services, Round-Trip-Time (RTT)
measurement, one-way delay, and packet loss details.

• ICMP Echo, including connectivity testing, RTT measurement, and packet loss details.

• TCP Connect, including connectivity testing of transport layer (TCP) services, and handshake time
measurement.

• DHCP, which measures the round-trip time taken to discover a DHCP Server and obtain a leased IP address
from it.

Chapter 17
IP Service Level Agreement
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• DNS, which measures the time taken for a DNS resolution. This measures the difference between the time
taken to send a request to the DNS server and the time the IP SLA source receives a reply.

• User Datagram Protocol (UDP) Jitter, which measures RTT, one way jitter and one way delays.

• UDP Jitter for VoIP, which measures RTT, one way jitter, one way delays, ICPIF (Impairment Calculated
Planning Impairment Factor) and MOS (Mean Opinion Score).

Limitations for IPSLA support on Aruba switches:

• IP SLA is not enabled for IPv6.

• DHCP SLA supports DHCPv4 only.

• IP SLA tests cannot be initiated over OOBM interfaces.

• History results for the configured IP SLAs will not be available after a switchover or a reboot.

• Maximum number of IP SLAs that can be configured varies based on the type of SLA test.

• When there are multiple IP SLAs configured with destination as hostname, the DNS resolution happens
serially. There can be a delay in sending the test probe (which will be sent only after successful DNS
resolution).

• For TCP Connect SLA type, the four-tuple (source IP/port, destination IP/port) must be unique.

• System clocks between the source and the responder must be synchronized with NTP if One Way Delay
parameters have to be calculated for UDP Echo tests.

• Timeout for probes is 3 seconds for all SLA types and is not configurable.

• Transient spikes in RTT occur during the tests (in the source and the responder) if processor usage is high.
Consider average result values over a period of time rather than point-in-time results. This is not applicable for
UDP Jitter nor Jitter for VoIP.

Entity Limit

Maximum number of SLAs enabled. 50

Maximum history bucket size per SLA.1 50

Number of responders that can be configured. 10

1 Not applicable for UDP Jitter and Jitter for VoIP.

The following are operational restrictions with respect to IP SLA jitter implementation:

• Feature is not supported on 2540.

• Feature is supported only on v3-based platforms (5400R, 3810, 2930F).

• No history results are stored.

• IPSLA Jitter and Jitter for VoIP initiator and responder is only supported on 5400R with v3 modules
(noncompatibility mode), 3810, and 2930F switches.

• The maximum number of Jitter responder sessions (UDP Jitter + Jitter For VoIP) supported is 10. The
maximum number of Jitter initiator sessions (UDP Jitter + Jitter For VoIP) supported is 5.

• IMC (Intelligent Management Center) supports below IP SLAs:
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NOTE: 5400R requires V3 modules

◦ UDP Jitter

◦ UDP Jitter Voip

◦ UDP Echo

◦ TCP connect

◦ ICMP echo

◦ DHCP

• Measurement of RTT and jitter values is in milliseconds.

• IPv6 SLA for UDP jitter and VoIP is not supported.

• UDP jitter and UDP jitter for VoIP tests are not supported over Tunnel, Trunk, and OOBM interfaces.

• UDP jitter and UDP jitter for VoIP results are not carried forward across failover or a device reboot.

• History bucket size cannot be configured for UDP jitter and VoIP tests. Results are aggregated for the last 25
probes.

• System clocks between the source and the responder must be synchronized with NTP if One Way Delay
parameters have to be calculated for UDP Jitter & UDP Jitter for VoIP tests.

• The UDP jitter and UDP jitter for VoIP feature on ArubaOS-Switch has the following limited interoperability with
Comware 7 SLA v2 version:

◦ One Way packet drops (SD packet loss and DS packet loss) on the Comware Jitter initiator is not reported
when interoperating with Aruba Jitter Responder.

• IP SLA responder or initiator implementation is not interoperable with Cisco's IP SLA feature.

How IP SLA works
1. The source originates a test packet to the destination.

2. The destination responds to the test packet, at times embedding the needed information in the response
packet.

3. Upon receiving the response, the source calculates the test results based on the timestamp, other packet
parameters, and so on.

4. The source stores the results and updates the history records for the SLA.

5. The source reschedules the SLA for the next run.

NOTE: For one-way delay calculations, the IP SLA sender and IP SLA responder must be NTP Time
Synchronized.

Configuration commands

[no] ip-sla <ID>
Syntax
[no] ip-sla <ID>
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Description

Configure the IP Service Level Agreement (SLA) parameters. The value of ID can range from 1-255.

Options

clear

Clear history records, message statistics, and threshold counters of particular SLA entry.

dhcp

Configure DHCP as the IP SLA test mechanism.

disable

Disable the IP SLA.

dns

Configure DNS as the IP SLA test mechanism.

enable

Enable the IP SLA.

history-size

Configure the number of history records to be stored for the IP SLA.

icmp-echo

Configure ICMP echo as the IP SLA test mechanism.

monitor

Configure monitoring parameters and respective threshold-action values.

schedule

Configure the start time, stop time, lifetime, and frequency of run for the IP SLA.

tcp-connect

Configure TCP connect as the IP SLA test mechanism.

tos

Configure the Type of Service value to be set in the test packet for the IP SLA.

udp-echo

Configure UDP echo as the IP SLA test mechanism.

On platforms that support Jitter and VOIP, the following options are also provided:

udp-jitter

Configure UDP jitter as the IP SLA test mechanism.

udp-jitter-voip

Configure UDP jitter for VoIP as the IP SLA test mechanism.

ip-sla <ID> clear
Syntax
ip-sla <ID> clear
Description

Clear history records, message statistics, and threshold counters of a particular SLA entry.
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Options

records

Clear history records, message statistics, and threshold counters of particular SLA entry.

[no] ip-sla <ID> history-size
Syntax
[no] ip-sla <ID> history-size
Description

Configure the number of history records to be stored for the IP SLA. The maximum supported size is 50 and the
default value for history-size is 25.

[no] ip-sla <ID> icmp-echo
Syntax
[no] ip-sla <ID> icmp-echo [<IP-ADDR> | <HOST-NAME>] [source <IP-ADDR> 
| source-interface vlan <VLAN-ID>] [payload-size <SIZE>]
Description

Configure ICMP echo as the IP SLA test mechanism. Requires destination address/hostname and source
address/vlan id for the IP SLA of ICMP-Echo SLA type.

payload-size

: Value can range from 1-1440. By default, payload-size is not set.

[no] ip-sla <ID> udp-echo
Syntax
[no] ip-sla <ID> udp-echo [destination [<IP-ADDR> | <HOST-NAME>] 
<PORT-NUM>] [source <IP-ADDR> | <VLAN-ID>] [payload-size <SIZE>]
Description

Configure UDP echo as the IP SLA test mechanism. Requires destination address/hostname and source address/
VLAN ID for the IP SLA of UDP-Echo SLA type.

• PORT-NUM: Value can range from 1024–65535.

• payload-size: Value can range from 1-1440. By default, payload-size is not set.

[no] ip-sla <ID> tcp-connect
Syntax
[no] ip-sla <ID> tcp-connect [destination [<IP-ADDR> | <HOST-NAME>] 
<PORT-NUM>] [source [<IP-ADDR> | <VLAN-ID>] <PORT-NUM>]
Description

Configure TCP connect as the IP SLA test mechanism. Requires destination address/hostname and source
address/VLAN ID for the IP SLA of TCP connect SLA type. The value of PORT-NUM can range from 1024-65535.
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[no] ip-sla <ID> monitor threshold-config
Syntax
[no] ip-sla <ID> monitor threshold-config [rtt | srcTodstTime | dstToSrcTime] 
threshold-type [immediate | consecutive <COUNT>] threshold-value <UPPER-LIMIT> 
<LOWER-LIMIT> action-type [trap | log | trap-log | none]
Description

Set upper and lower threshold parameters.

• threshold-type immediate: Take action immediately when the monitored parameters cross the threshold
upper limit (subsequent notifications for upper thresholds are not generated until the parameter values go
lower than the configured lower threshold value).

• threshold-type consecutive: Take action after threshold is hit consecutively for number of times.

• action-type: Describes action to be taken when the upper threshold is crossed.

• trap: Send snmp-trap when configured threshold is hit.

• log: Only log the event when configured threshold is hit.

• trap-log: Send snmp-trap and log the event when configured threshold is hit.

• none: Take no action.

NOTE: The command option threshold-config can be individually set for rtt, srcTodstTime, and
dstToSrcTime.

[no] ip-sla <ID> monitor packet-loss
Syntax
[no] ip-sla <ID> monitor packet-loss threshold-type [immediate | consecutive 
<COUNT>] action-type [trap | log | trap-log | none]
Description

Configure threshold-action values when packet loss happens.

• threshold-type immediate: Take action immediately when the monitored parameters cross the threshold
upper limit (subsequent notifications for upper thresholds are not generated until the parameter values go
lower than the configured lower threshold value).

• threshold-type consecutive: Take action after threshold is hit consecutively for number of times.

• action-type: Describes action to be taken when the upper threshold is crossed.

• trap: Send snmp-trap when configured threshold is hit.

• log: Only log the event when configured threshold is hit.

• trap-log: Send snmp-trap and log the event when configured threshold is hit.

• none: Take no action.

[no] ip-sla <ID> monitor test-completion
Syntax
[no] ip-sla <ID> monitor test-completion action-type [trap | log | trap-log | none]
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Description

Configure action to be taken when test gets completed.

• trap: Send snmp-trap when configured threshold is hit.

• log: Only log the event when configured threshold is hit.

• trap-log: Send snmp-trap and log the event when configured threshold is hit.

• none: Take no action.

[no] ip-sla <ID> schedule
Syntax
[no] ip-sla <ID> schedule [[now | startTime <START-TIME>] [forever | stopTime <STOP-TIME> 
| repetitions <NUM>] [frequency <FREQUENCY>
Description

Configure the start time, stop time, lifetime, and frequency of run for the IP SLA. The default value for the
frequency of operation is 60 seconds.

[no] ip-sla <ID> tos
Syntax
[no] ip-sla <ID> tos <VALUE>
Description

Configure the Type of Service value to be set in the test packet for the IP SLA.

Valid values: 0–255

[no] ip-sla responder
Syntax
[no] ip-sla responder
Description

Configure SLA responder to respond to probe packets.

• IP address: local interface IP address

• port: takes L4 port numbers.

• SLA types supported: udp-echo, tcp-connect, UDP Jitter & Jitter For VoIP.

[no] ip-sla <ID> udp-jitter
Syntax
[no] ip-sla <ID> udp-jitter destination [<IP-ADDR> | <HOST-NAME>] <PORT-NUM> 
source [<IP-ADDR> | <VLAN-ID>] [payload-size <SIZE> num-of-packets <NUM> packet-
interval <PKT-INTERVAL>]
Description

Configures the UDP Jitter test.
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• Payload-size: Payload size of the test packet. Value can range from 68-8100. Default value is 68.

• Num-of-packets: Number of packets sent in one probe. Default is 10. Allowed range: 10-1000.

• Packet-interval: Inter packet gap in milliseconds.Time between consecutive packets within a probe. Default is
20ms. Allowed range: 10-60000

[no] ip-sla <ID> udp-jitter-voip
Syntax
[no] ip-sla <ID> udp-jitter-voip destination [<IP-ADDR> | <HOST-NAME>] <PORT-NUM> 
source [<IP-ADDR> | <VLAN-ID>] [codec-type <CODEC-TYPE> advantage-factor <ADV-
FACTOR>]
Description

Configures the UDP Jitter for VoIP test.

• Codec-type: Codec to be used to encode the test VoIP packets. Available codecs: g711a, g711u, g729a.
Default is g711a.

• Advantage-factor: Advantage factor to be configured for the test. Default is 0. Allowed range: 0-20.

Show commands

show ip-sla <ID>
Syntax
show ip-sla <ID>
Description

Show IP SLA configurations.

Options

history

Show the IP SLA results history.

message-statistics

Show the IP SLA message statistics.

results

Show the IP SLA results for UDP Jitter and UDP Jitter VoIP.

aggregated-results

Show the IP SLA aggregated results for UDP Jitter and UDP Jitter VOIP.

show ip-sla <ID>

SLA ID: 1
Status: [Enabled | Admin-disabled | Scheduled | Expired | Running]

SLA Type: [ICMP-echo | tcp-connect | UDP-echo | DHCP | DNS | udp-jitter | voip]

Destination Hostname: www.arubanetworks.com
Destination Address : 20.0.0.2
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Source Address      : 20.0.0.1
History Bucket Size : 5
TOS: 32
Schedule:
      Frequency (seconds)       : 60
      Life                      : [Forever | 144 seconds]
      Start Time                : Tue Oct 27 22:12:16 2015
      Next Scheduled Run Time   : Tue Oct 27 22:43:16 2015

Threshold-Monitor is    : Enabled
      Threshold Config: RTT
      Threshold Type  : immediate
      Upper Threshold : 500 ms
     Lower Threshold : 100 ms
     Action Type     : Trap and Log

     Threshold Config: packet-loss
     Threshold Type  : consecutive (5)
     Action Type     : Trap

     Threshold Config: test-completion
     Action Type: None

show ip-sla <ID> history
Syntax
show ip-sla <ID> history
Description

Show the IP SLA results history.

show ip-sla <ID> history

SLA ID : 1

SLA Type : UDP-Echo

Minimum RTT (ms)        : 1
Maximum RTT (ms)        : 4294967282
Average RTT (ms)        : 3
Total RTT (ms)          : 315
RTT2 (sum of RTT squared): 63681

Start Time               Status  RTT      Description
------------------------ -------- ----      ------------
Mon Jan 1 00:51:28 1990 Failed  -        DMA tail drop detected.
Mon Jan 1 00:51:30 1990 Failed  -        SLA disabled before probe response arrived.

show ip-sla <ID> message-statistics
Syntax
show ip-sla <ID> message-statistics
Description

Show the IP SLA message statistics.
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show ip-sla <ID> message-statistics

SLA ID : 1 
Status : Running 
SLA Type : UDP-Echo 
Destination Address : 10.0.0.2
Source Address : 10.0.0.1 
Destination Port : 2000 
History Bucket Size : 25 
Payload Size : 500 
TOS : 0 
Messages: 
Destination Address Unreachable : 0 
Probes Skipped Awaiting DNS Resolution : 0
DNS Resolution Failed : 0 
No Route to Target : 0 
Internal Error : 0 
Local Interface is Down : 0 
No Response from Target : 0 
Successful Probes Sent : 3 
Probe Response received : 3 
Possibly Tail Dropped : 0 

show ip-sla <ID> results
Syntax
show ip-sla <ID> results
Description

Shows the results for the last IPSLA UDP Jitter or UDP Jitter for VoIP test. Note this command is not valid for any
other SLA type.

Switch (config)# sh ip-sla 1 results

Test Results for SLA ID: 1
Probe Id               : 10
SLA Type               : UDP-Jitter
Destination IP Address     : 10.2.2.2  
Destination Port     : 4444
    Source IP Address     : 10.2.2.2  
    Source Port         : 5555

Number of Packets Sent             : 10
Number of Packets Received         : 10
Minimum Round Trip Time            : 15
Maximum Round Trip Time            : 32
Average Round Trip Time            : 17
Square-Sum of Round Trip Time      : 3235
Last Succeeded Probe Time          : 2008-05-29 13:56:17.6

Extended Results:
  Packet Loss in Test        : 0%

UDP-Jitter Results:
   RTT Number             : 10
   Min Positive SD        : 4        Min Positive DS        : 1
   Max Positive SD        : 21       Max Positive DS        : 28
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   Positive SD Number     : 5        Positive DS Number        : 4
   Positive SD Sum        : 52       Positive DS Sum        : 38
   Positive SD Average    : 10       Positive DS Average    : 10
   Positive SD Square Sum : 754      Positive DS Square Sum    : 460
   Min Negative SD        : 1        Min Negative DS        : 6
   Max Negative SD        : 13       Max Negative DS        : 22
   Negative SD Number     : 4        Negative DS Number        : 5
   Negative SD Sum        : 38       Negative DS Sum        : 52
   Negative SD Average    : 10       Negative DS Average    : 10
   Negative SD Square Sum : 460      Negative DS Square Sum    : 754

One-way Results:
   Max SD Delay           : 15       Max DS Delay        : 16
   Min SD Delay           : 7        Min DS Delay        : 7
   Number of SD Delays    : 10       Number of DS Delay    s    : 10
   Sum of SD Delays       : 78       Sum of DS Delays        : 85
   Square Sum of SD Delays: 666      Square Sum of DS Delays    : 787

     
   For UDP Jitter for VoIP SLA, the following parameters are additionally shown:

Voice Scores:
   ICPIF                                                            : 4        
MOS                                                : 4.38

show ip-sla <ID> aggregated-results
Syntax
show ip-sla <ID> aggregated-results
Description

Shows the aggregated results for the last 25 probes conducted for an IPSLA UDP Jitter or UDP Jitter For VoIP
SLA test. Note this command is not valid for any other SLA type.

Switch (config)# show ip-sla 1 aggregated-results

Test results for SLA ID: 1
SLA Type               : UDP-Jitter
Destination IP Address : 10.2.2.2  
Destination Port                         : 4444
Source IP Address      : 10.2.2.2  
Source Port                                             : 5555
First Probe Start Time    : 2008-05-29 13:56:17.6

Number of Packets Sent             : 10
Number of Packets Received         : 10
Minimum Round Trip Time            : 15
Maximum Round Trip Time            : 32
Average Round Trip Time            : 17
Square-Sum of Round Trip Time      : 3235

Aggregated Results for the Last 25 Probes

Extended Results:
  Packet Loss in Test        : 0%
  Probe Failure Reason       : 

UDP-Jitter Results:
   RTT Number             : 10
   Min Positive SD        : 4        Min Positive DS        : 1
   Max Positive SD        : 21       Max Positive DS        : 28
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   Positive SD Number     : 5        Positive DS Number        : 4
   Positive SD Sum        : 52       Positive DS Sum        : 38
   Positive SD Average    : 10       Positive DS Average    : 10
   Positive SD Square Sum : 754      Positive DS Square Sum    : 460
   Min Negative SD        : 1        Min Negative DS        : 6
   Max Negative SD        : 13       Max Negative DS        : 22
   Negative SD Number     : 4        Negative DS Number        : 5
   Negative SD Sum        : 38       Negative DS Sum        : 52
   Negative SD Average    : 10       Negative DS Average    : 10
   Negative SD Square Sum : 460      Negative DS Square Sum    : 754

One-way Results:
   Max SD Delay           : 15       Max DS Delay        : 16
   Min SD Delay           : 7        Min DS Delay        : 7
   Number of SD Delays    : 10       Number of DS Delay    s    : 10
   Sum of SD Delays       : 78       Sum of DS Delays        : 85
   Square Sum of SD Delays: 666      Square Sum of DS Delays    : 787

      For UDP Jitter for VoIP SLA, the following parameters are additionally shown:

Voice Scores:
   Max MOS Value        : 4.38     Min MOS Value                : 4.38
   Max ICPIF Value      : 0        Min ICPIF Value        : 0

show ip-sla responder
Syntax
show ip-sla responder
Description

Show the IP SLA responder details.

show ip-sla responder

SLA type         : UDP-echo
Listening Address: 1.1.1.1
Listening Port   : 5555

show ip-sla responder statistics
Syntax
show ip-sla responder statistics
Description

Show the IP SLA responder statistics details.

Options

udp-jitter

Show the IP SLA responder statistics for UDP Jitter SLA type.

udp-jitter-voip

Show the IP SLA responder statistics for UDP Jitter VoIP SLA type.
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show ip-sla responder statistics

IP SLA Responder  : Active
Number of packets received       : 31
Number of error packets received : 0
Number of packets sent           : 0 

Recent Sources :  
 10.12.80.100 [07:23:49.085 UTC Sun Oct 25 2015] UDP 
 10.12.80.100 [07:22:49.003 UTC Sun Oct 25 2015] TCP
 10.12.80.100 [07:20:48.717 UTC Sun Oct 25 2015] TCP
 10.12.80.100 [07:18:48.787 UTC Sun Oct 25 2015] TCP
 10.12.80.100 [07:17:48.871 UTC Sun Oct 25 2015] TCP

show tech ip-sla
Syntax
show tech ip-sla
Description

Display output of a predefined command sequence used by technical support.

show tech ip-sla

switch# sh tech ip-sla

ipslaShowTech

 ======== IP SLA show tech BEGIN ============ 

 GLOBALS: 
 Hash Handle:                      1e7bab20
 Struct Mem Handle for hash:       1e7ba2a8
 Struct Mem Handle for SLA ID LL:  1e7c9430
 Struct Mem Handle for FD List:    1e7bd690
 FastLog Handle:                   dfabf5c
 IPSLACtrl task ID:                1068091456
 IPSLA Sender ID:                  1068092544
 IPSLA Listener ID:                1068091840
 Number of enabled SLA's:          1
 SLA ID List Handle:               1ec1ffd4
 FD ID List Handle:                0
 Ring Full Counter:                0

 Details for SLA ID: 1

SLA ID: 1
Status: Running

SLA mechanism: ICMP-Echo

Destination address: 192.168.1.2
Source address: 192.168.1.1
History bucket size: 25
Payload size: 0
TOS: 0
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Schedule:
      Frequency (seconds)       : 60
      Life                      : Forever
      Start Time                : Mon Jun 13 10:42:52 2016
      Next Scheduled Run Time   : Mon Jun 13 10:46:52 2016

Threshold-Monitor is  : Enabled
        Threshold Config     : RTT
        Threshold Type       : Immediate
        Upper Threshold      : 10
        Lower Threshold      : 2
        Action Type          : Log

SLA ID: 1
Status: Running

SLA mechanism: ICMP-Echo

Destination address: 192.168.1.2
Source address: 192.168.1.1
History bucket size: 25
Payload size: 0
TOS: 0
Messages:
       Destination address unreachable        : 0
       Probes skipped awaiting DNS resolution : 0
       DNS resolution failed                  : 0
       No route to target                     : 0
       Internal error                         : 0
       Local interface is down                : 0
       No response from target                : 0
       Successful probes sent                 : 9
       Probe response received                : 9
       Possibly tail dropped                  : 0

Count of Threshold hits:
                RTT              : 0
                packetLoss       : 0

SLA ID: 1

Minimum RTT (ms)         : 1
Maximum RTT (ms)         : 1
Average RTT (ms)         : 1
Total RTT (ms)           : 9
RTT2 (sum of RTT squared): 9

     Start Time                  Status       RTT               Description
     ----------                  ------       ---               -----------
Tue Jun 14 10:43:12 2016        Passed          1
Mon Jun 13 10:39:05 2016        Passed          1
Mon Jun 13 10:40:05 2016        Passed          1
Mon Jun 13 10:41:05 2016        Passed          1
Mon Jun 13 10:42:05 2016        Passed          1
Mon Jun 13 10:42:52 2016        Passed          1
Mon Jun 13 10:43:52 2016        Passed          1
Mon Jun 13 10:44:52 2016        Passed          1
Mon Jun 13 10:45:52 2016        Passed          1

 ICMP ID hash walk: 
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 ========== IP SLA show tech END ==============

 ======== IP SLA Server show tech BEGIN ============ 
Responder not active
IP SLA Responder: Inactive

 ======== IP SLA Server show tech END ============ 

=== The command has completed successfully. ===

clear ip-sla responder statistics
Syntax
clear ip-sla responder statistics <SLA-TYPE> <LOCAL-IP-ADDR> <LOCAL-PORT-NUM>
             source <SOURCE-IP-ADDR>

Description

Clear IP SLA responder statistics for either UDP jitter or VoIP UDP jitter.

Command context
config

Parameters
<SLA-TYPE>

Specifies the SLA type.

udp-jitter
Selects standard UDP jitter.

udp-jitter-voip
Selects UDP VOIP jitter.

<LOCAL-IP-ADDR>

Specifies the local interface IP address

<LOCAL-PORT-NUM>

Specifies the local interface port number. Range: 1024 to 65535.

<SOURCE-IP-ADDR>

Specifies the Source IP address.

Examples

Clear IP SLA responder statistics for UDP jitter:

switch(config)# clear ip-sla responder statistics udp-jitter 1.1.1.1 1100 source 1.1.1.2
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Validation rules
Validation Error/Warning/Prompt

Enabling SLA without configuring SLA type. Cannot enable IP SLA, no valid source/destination configured.

IP address given for source or destination is
multicast or broadcast.

Invalid IP address.

Configure the SLA type with a source IP which
is configured in the same switch.

Destination IP cannot be configured as the same as one of the
local interface IP addresses.

Configure threshold with invalid value. Invalid threshold count value. For threshold type 'Immediate',
count must be 1 and for 'Consecutive', count must be greater
than or equals to 2.

Configure threshold value for 'PacketLoss' or
'TestCompletion'

Configuration is not applicable when threshold is configured
for 'PacketLoss' or 'TestCompletion'.

Configure threshold type for TestCompletion. Configuration is not applicable when threshold is configured
for 'TestCompletion'.

Configure schedule with proper end time with a
frequency which is out of end time.

Invalid endtime. Endtime is not enough to run the tests for
configured frequency and repetitions.

Configuring ‘srcTodstTime’ or ‘dstTosrcTime’
threshold configuration for ‘icmp-echo’ or ‘tcp-
connect’.

Invalid threshold configuration for configured SLA type.

Enabling the IP SLA which is already in enabled
state.

IP SLA is already enabled.

Disabling the IP SLA which is already in
disabled state.

IP SLA is already disabled.

Show IP SLA history of un-configured SLA. IP SLA is not configured for this ID.

Enable more number (currently decided 50 as
limit) of IP SLA.

Maximum number of enabled IP SLAs at a time is limited to
50.

Removing IP SLA type/tos/history size/
schedule/ threshold configuration with un-
configured value.

IP SLA configuration does not exist.

Configuring scheduler with a frequency value
which is not satisfying the condition frequency >
number of packets per probe * packet interval.

Frequency value is insufficient to configure the scheduler.

Scheduler already configured and try to
configure SLA type with a value of ‘number of
packets per probe’ and ‘packet interval’ which is
not satisfying the condition frequency > number
of packets per probe * packet interval.

Number of packets/packet interval is insufficient to configure
IP SLA type.

Table Continued
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Validation Error/Warning/Prompt

Configuring IP SLA with invalid values. Invalid configuration for IP SLA.

Change the IP SLA configuration when the SLA
is enabled.

Configuration changes not allowed when IP SLA is enabled.

When IP address vs port number configured for
an SLA is already in use

Error: Socket for configured address, port is already in use,
choose different port number

When Source IP address given in SLA
configuration is not configured in the switch

Error: Source IP address is not configured in switch

Invalid SLA ID given in show command Error: Invalid IP SLA ID

Configure SLA more than allowed limit Warning: The maximum number of IP SLAs allowed is 50.

Configure Responder more than allowed limit Error: IP SLA Responder configurations reached max limit. No
more configurations accepted.

Configure inter-packet interval when number of
packets to be sent out is one.

Error Not applicable as Number of packets to be sent out is 1.

Upper threshold value is less than lower
threshold value.

Error: Upper threshold value X is less than lower threshold
value Y.

Configure schedule with start time greater than
stop time.

Error: Stop time must be greater than start time.

Configure schedule with past stop time. Error: Stop time must be greater than current time.

Configure schedule with invalid frequency
value.

Error: Schedule frequency is out of range. Valid range is 5 to
604800.

Configuring history size with invalid value. Error: IP SLA History size is out of range. Valid range is 1–50.

Configuring SLA type with invalid payload value. IP SLA Payload value is out of range. Valid range is 1–1440.

Configuring SLA type with invalid port number. Invalid port number. Valid range is 1024 to 65535.

Configure the IPSLA parameters without
configuring SLA type.

No valid IP SLA type configuration found.

Configuring the responder with existing details. IP SLA Responder with same configuration exist.

Configure management VLAN as source VLAN. Error: Not allowed to configure management VLAN as source
interface.

Enabling IP SLA without required configuration
parameters.

Configuration is incomplete to enable the entry.

Configure IPSLA UDP Jitter/VoIP session when
an OpenFlow custom match mode instance is
already enabled.

Cannot enable IP SLA: Initiator cannot co-exist with OpenFlow
custom Cannot enable IP SLA: Initiator cannot co-exist with
OpenFlow custom

Table Continued
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Validation Error/Warning/Prompt

Configure UDP Jitter/VoIP IPSLA Initiator
session with a source IP same as tunnel overlay
VLAN

Cannot enable IP SLA: The source VLAN cannot be a tunnel
overlay VLAN.

Configure UDP Jitter/VoIP IPSLA Initiator
session with a source IP same as a service
tunnel endpoint.

Cannot enable IP SLA: The source VLAN cannot be a service
tunnel endpoint.

Event log messages
Cause

Event Message

User adds IP SLA endpoint configuration. I 10/28/15 02:47:12 05020 ipsla: The IP SLA 1 of
SLA Type: UDP-Echo, Source IPv4 Address:
10.0.0.1, Destination IPv4 Address: 10.0.0.5,
Destination Port: 54563 added.

User removes the endpoint configuration. I 10/28/15 02:47:12 05021 ipsla: The IP SLA 1 of
SLA Type: UDP-Echo, Source IPv4 Address:
10.0.0.1, Destination IPv4 Address: 10.0.0.5,
Destination Port: 54563 removed.

When the SLA state changes (can be either system
initiated or done by the user)

I 10/28/15 01:42:22 05027 ipsla: IP SLA 1 state
changed to Expired.I 10/28/15 01:42:22 05021 ipsla:
IP SLA 1 state changed to Enabled.I 10/28/15
01:42:22 05021 ipsla: IP SLA 1 state changed to
Scheduled.I 10/28/15 01:42:22 05021 ipsla: IP SLA
1 state changed to Admin-disabled.

User configures a responder I 10/28/15 01:42:22 05025 ipsla: IP SLA responder
configured for SLA Type: TCP-Connect, Listen
Address: 10.0.0.7, Listen Port: 38425

User removes a responder I 10/28/15 01:42:22 05026 ipsla: IP SLA responder
removed for SLA Type: TCP-Connect, Listen
Address: 10.0.0.7, Listen Port: 38425

SLA test results cross configured threshold I 10/28/15 01:42:22 05022 ipsla: IP SLA 1, threshold
is crossed. Monitored Param: RTT, Threshold Type:
immediate, Upper threshold: 500, Lower threshold:
100, Action Type: Trap and Log. Actual Threshold:
600

User adds DNS IP-SLA configuration I 08/09/16 02:47:12 05029 ipsla: The IP SLA 1 of
SLA Type: DNS, Name server IPv4 Address:
10.0.0.1, Target Hostname: a.hpe.com added

Table Continued

Chapter 17 IP Service Level Agreement 603

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 7200



Event Message

User removes DNS IP-SLA configuration I 08/09/16 02:47:12 05030 ipsla: The IP SLA 1 of
SLA Type: DNS, Name server IPv4 Address:
10.0.0.1, Target Hostname: a.hpe.com removed.

The packet loss threshold for the SLA has reached I 08/09/16 02:47:12 05023 ipsla: The IP SLA 1 of
SLA Type: DNS, Packet loss is observed. Threshold
type: immediate, Action type: Trap and Log

The SLA test has completed and the threshold
config for test completion is present

I 08/09/16 02:47:12 05024 ipsla: The IP SLA 1,
Probe for SLA Type: UDP-Echo, Source IPv4
Address:1.1.1.2, Destination IPv4 Address:1.1.1.3,
Destination Port:3000 Completed

TCP-Connect Duplicate configuration is present W 08/09/16 02:47:12 05028 ipsla: Duplicate
configuration detected; the IP SLA 10 configuration
is the same as the IP SLA 1. For TCP, 4-tuple
combination has to be unique.

User adds DHCP SLA configuration I 08/09/16 02:47:12 05031 ipsla: The IP SLA 1 of
SLA Type: DHCP, Vlan: 1 added.

User removes DHCP SLA configuration I 08/09/16 02:47:12 05032 ipsla: The IP SLA 1 of
SLA Type: DHCP, Vlan: 1 removed.

DHCP SLA test has completed and the threshold
config for test completion is present

I 08/09/16 02:47:12 05033 ipsla: The IP SLA 1,
Probe for SLA Type: DHCP, Source Vlan : 1
Completed

Interoperability
NOTE: Packet loss is expected when H3C TCP-CONNECT source, with a frequency less than or
equal to 10 ms, interoperates with TCP-CONNECT responder.

IP SLA UDP Jitter and Jitter for VoIP

Overview
The UDP Jitter and Jitter for VoIP SLA types enable the user to assess the suitability of the network for voice &
video related traffic. These SLA's basically calculate parameters like RTT, one way delay, one way positive and
negative Jitter etc.
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The above diagram shows a typical deployment, where voice & video traffic are exchanged between branch
offices of an enterprise over the backbone network. Assessment of the network readiness is always helpful for
hosting such services. Parameters like RTT, Jitter and one way delay are a good indicator of network health which
assist a network administrator to diagnose latency related issues in the network. VoIP traffic is generally sensitive
to delays in the network.

Jitter stands for inter-packet delay variance. If the inter-packet delay increases between successive probe
packets, jitter is said to be positive. If the inter-packet delay decreases, jitter is said to be negative. Positive jitter
values are undesirable for a network as they indicate increased latencies. A value of 0 jitter is desirable.

Significance of jitter
Consider a media player which plays video streams from a server. Assume that packets take 1 second in flight to
reach the media player. This means the moment a user requests a video from the server, the very first packet will
arrive after one second and successive packets will be sent immediately (ideally). In real world scenarios,
intermediate node latencies, different return paths for different packets and network congestion can contribute to
varying delays. To counter such effects, packets are buffered at the media player. The amount of packet buffering
needed can be derived from the jitter values.

NOTE: The above analogy is applicable for other voice & video services and can be a good measure
to assess the possibility for hosting a service on a network.

Solution components

IP SLA responder

This device receives IP SLA probe packets from a configured initiator, timestamps the frame at a pre-defined
location in the packet upon receipt and sends the same frame back to the initiator.

IP SLA initiator

This device initiates IP SLA probe packets to multiple destinations each with a certain user configurable packet
content and periodicity.

The initiator timestamps the frame at a pre-defined location before sending the frame out to the configured
destinations and re-timestamps the frame at a different location once it receives the same back from the
responder.
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IP SLA measurement engine

This is an application running on the initiator. It processes response frames received from the IP SLA responder
and computes one-way delay, jitter and RTT based on the timestamps present in the packet.

This application aggregates this computed information across multiple probe samples and stores this for
consumption by an NMS via SNMP or via the device CLI.

It also supports asynchronous user configurable threshold breach notification to an NMS (via SNMP Traps).

SLA Measurements
The following metrics are measured as part of this IP SLA jitter functionality.

One way jitter

One way jitter is defined as the time difference between inter-packets transmit time and inter-packets arrival time
in a given direction. This is measured in both the Initiator to Responder direction (referred to as SD jitter) as well
as the Responder to initiator direction (referred to as DS jitter).

Ideally, the jitter in both directions should be 0. A positive value of jitter is bad for VOIP and higher values of jitter
will mean poor conversation quality. This is explained in the illustration below:

606 Aruba 2930F / 2930M Management and Configuration Guide
for ArubaOS-Switch 16.08

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 7203



One way delay

One way delay is defined as the time difference between the Initiator transmitting the frame and the Responder
receiving the frame. This requires the Initiator and the Responder to be time synchronized with the same clock
server. This is explained in the illustration below:

Round trip time

RTT is measured at the initiator on a per packet basis and is as illustrated below:
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Definition of Terms
Term Definition

DCA Dynamic Configuration Arbiter

ClearPass ClearPass Policy Manager

GRE Generic Routing Encapsulation

SAC Switch Anchor Controller

S-SAC Standby Switch Anchor Controller

UAC User Anchor Controller

Switch Bootstrap Control plane protocol packets exchange process between a switch and an SAC to register
a switch with the configured SAC.

User Bootstrap Control plane protocol packets exchange process between a switch and a UAC to register
a user with the published UAC.

Secondary role This information is an indication to the controller that it has to enforce additional policies to
user traffic based on policy configuration associated with the secondary role.

Reserved VLAN
mode

A VLAN is automatically created and reserved for tunnels in this mode.

Overview
Dynamic Segmentation enables Aruba switches to tunnel traffic (all traffic or the traffic of particular clients) to
Aruba controllers.

Dynamic Segmentation includes the following:

• User-Based Tunneling tunnels client traffic on the basis of user roles. This ability to dynamically tunnel traffic is
powerful, and when used correctly, can help in solving several deployment problems that are prevalent in
legacy campus networks. The policies associated with the client can be driven through a RADIUS server, a
downloaded role from ClearPass, or by local MAC authentication in the switch. Many devices that require
power over Ethernet (PoE) and network access, such as security cameras, printers, payment card readers,
and medical devices, do not have built in security software such as those on desktop or laptop computers.
These devices can pose a risk to networks with the lack security on the device. User-Based Tunneling can
authenticate these devices using ClearPass, and tunnel the client traffic, utilizing the advanced firewall and
policy capabilities in the Aruba Mobility Controller. For providing secure access to IoT devices within the Aruba
Intelligent Edge wired network, controller clustering is available in ArubaOS 8.0.0.0. For more information, see 
User-Based Tunneling.

• Port-Based Tunneling allows the Aruba switch to tunnel traffic to an Aruba Mobility Controller on a per-port
basis. All traffic on a configured switch port is statically tunneled to an Aruba Mobility Controller. For more
information, see Port-Based Tunneling.

Tunneling is enabled in the Aruba user role and can be combined with the Downloadable User Role (DUR)
feature for dynamic and flexible policy enforcement and segmentation.

Chapter 18
Dynamic Segmentation
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NOTE: Maximum supported user tunnels per switch or stack: 1024

Maximum supported user tunnels per port: 32

Benefits of Dynamic Segmentation
The benefits of dynamic segmentation are:

• Colorless ports / client flexibility

• Client isolation

• Same policy for wired or wireless clients

• With ClearPass, no role preconfiguration is needed.

• Tunnel client traffic over core complexity

• Reduced switch configuration

• Traffic visibility

• Wired guest access

• Simple branch configuration

• Controller supplied client attributes visibility

Use Cases
Following are the common use cases for Dynamic Segmentation, apart from the common use case of segmenting
traffic based on user role policy:

• Create a wired guest capability.

• Provide a firewall at the Mobility Controller.

Wired Firewall Access:
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To restrict user access, firewall and policies can be implemented for users tunneled to an Aruba Mobility
Controller by using the built-in firewall capabilities of the Aruba Mobility Controller.

Figure 102: Wired Firewall Access

Wired Guest Traffic Segmentation:

The Dynamic Segmentation feature supports segmenting wired guest traffic on the network. This is achieved by
creating the secondary role as a guest role on the Mobility Controller and assigning a specific guest VLAN.
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Access and firewall policy is then implemented on the controller to isolate guest access to the rest of the campus
network.

Figure 103: Wired Guest Traffic Segmentation

Users/Devices and Policy Enforcement Recommendations
The following table calls out the enforcement recommendations for different type of users and devices. While it is
recommended to tunnel the traffic in some cases, other cases can be met by simply using local forwarding on the
switch.

Type Enforcement Description

Access Point Local Local infrastructure device.

Voice/Video Device Local Desk and conference phones, security cameras, and room media
systems.

Employee on Managed
Device

Local Users connecting from a healthy and managed device can stay
local to the Aruba switch.

Employee on Unmanaged
device

Tunnel Users connecting from an unmanaged or potentially untrusted
device can be tunneled.

New/Unknown Device Tunnel Tunnel new or unknown devices, potentially untrusted devices used
for profiling, potential onboarding, guest registration, and
quarantine.

Guest User Tunnel Guest users to DMZ guest network.

Table Continued

Chapter 18 Dynamic Segmentation 611

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 7208



Type Enforcement Description

Contractor Tunnel Contractors may need more access than a traditional guest user.

Change in User/Device
Posture

Tunnel User or device goes from a healthy to unhealthy state (OnGuard
checks, IntroSpect notification, Ingress Event Engine Notification)

Colorless Ports
Within a campus network with a few thousand switch access ports and numerous intermediate distribution frames
(IDFs), network admins must put in effort to assign VLAN IDs to the devices. It is also difficult to maintain switch
port to VLAN mapping, and a significant configuration effort to manage thousands of lines of configurations on the
switches is required.

With colorless ports, all the switches would have similar configuration with IP, credentials, authentication, VLANs,
and uplinks. All access ports need only a few lines of configuration common for all ports. No admin intervention is
needed to assign a VLAN to a user, since the user is automatically assigned a reserved VLAN ID.

The benefits of colorless ports are:

• Simplified user experience

• Increased visibility. It is easy to see what is on the network.

• Increased security. The network correctly applies the correct policy to a device.

• Simplified switch configuration. All access ports are configured the same.

For more details on the colorless ports, see User Roles in the Access Security Guide for your switch.

Port-Based Tunneling
In a traditional campus network, wireless traffic is encapsulated between the access point and controller using a
tunnel. With Port-Based Tunneling on the Aruba switches, a similar implementation is done using the same
mechanism with an Aruba Mobility Controller. In essence, a wired port becomes a “wired AP”. Each switch port
can then be individually configured to create a single tunnel to the Mobility Controller. However, at the Mobility
Controller, each tunneled node port is seen as separate tunnel to provide more granular visibility, as each tunnel
has a unique GRE key. By tunneling traffic to the Mobility Controller, in Port-Based Tunneling, authentication and
network policies are applied and enforced at the controller-side for tunneled, wired traffic. This simplifies
configuration on the switch and centralizes policies at the Mobility Controller. Port-Based Tunneling allows using
the same enforcement options for wired and wireless clients. This includes stateful session processing, deep
packet inspection, URL filtering, and bandwidth contracts.

The main purpose of Port-Based Tunneling is to use the Mobility Controller as a unified policy enforcement point
for traffic from both wired and wireless clients.

NOTE: If the Mobility Controller is not reached by the Aruba switch, the user can fall back to local
switching, which allows the tunneled ports to communicate with the other ports in the same VLAN.

IMPORTANT: 

• Port-Based Tunneling is configured on a per-port basis. Traffic to and from ports that
is not configured as tunneled is forwarded using the standard layer switching
technology.

• An ArubaOS-switch can be configured with a main and a backup tunnel termination
controller called “tunneled-node server”.

• Port-Based Tunneling does not support HA and load balancing over an Aruba
Mobility Controller Cluster compared to User-Based Tunneling.
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Configuring Port-Based Tunneling
Jumbo frames must be enabled on all devices between the access switch and the controller to support the L2
GRE tunnels.

Follow the steps below to configure port-based tunneling:

Prerequisites
It is recommended to create a specific VLAN for tunneled node operation. The VLAN:

• Must be configured as the only VLAN for tunneled node access ports (untagged)

• Cannot be assigned an IP address – No layer 3 interface

• Must exist on the controller

Procedure

1. Issue the following command to setup the IP address of the Aruba Mobility Controller (tunneled node server):

Switch(config)# tunneled-node-server controller-ip 10.2.10.11
Optional steps:

a. Setup backup controller IP by issuing the following command:

Switch(config)# tunneled-node-server backup-controller-ip 10.2.10.12
b. Set tunneling keepalive timer by issuing the following command. Ensure the time interval between

keepalive messages is set to the default value (8):

Switch(config)# tunneled-node-server keepalive interval
<1-8> Configure the time interval between two successive keepalive messages sent to the
controller

2. Issue the following commands to enable port-based tunneling on an interface or a range of interfaces:

Switch(config)# vlan 200 untagged 1/21-1/24
exit
Switch(config)#interface 1/21-1/24 tunneled-node-server

3. Issue the following commands to verify the state of the port-based tunnel(s):

Switch(config)# show tunneled-node server state
Tunneled Node Port State
Active Controller IP Address : 10.2.10.11
Port State
------ -------------------------
2/23 Complete
You can view the tunnel statistics by issuing the following command:

View tunnel statistics
Switch(config)# show tunneled-node-server statistics
Tunneled Node Statistics
Port : 2/23
Control Plane Statistics
Bootstrap packets sent : 1
Bootstrap packets received : 1
Bootstrap packets invalid : 0
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Tunnel Statistics
Rx Packets : 302
Tx Packets : 0
Rx 5 Minute Weighted Average Rate (Pkts/sec)
: 0 Tx 5 Minute Weighted Average Rate
(Pkts/sec) : 0
Aggregate Statistics
Heartbeat packets sent : 56607
Heartbeat packets received : 56607
Heartbeat packets invalid : 0
Fragmented Packets Dropped (Rx) : 0
Packets to Non-Existent Tunnel : 0
MTU Violation Drop : 0

Operating notes
• Tunneled node profile may be created using CLI and SNMP.

• The tunneled node profile supports configuring of:
◦ Primary controller (both IPv4 and IPv6).

◦ Backup controller (both IPv4 and IPv6).

◦ Heartbeat keepalive timeout – range 1-40 seconds.

• Only one tunneled node profile may be created.

• The tunneled-node profile may be applied to a physical port only via CLI and SNMP.

• The maximum number of physical ports to which the profile may be applied is:
◦ Aruba 5400R Switch Series (non-VSF): 256 physical ports.

◦ Aruba 5400R Switch Series (VSF): 512 physical ports.

• High availability (HA) will be supported for the tunneled-node related configuration.

• A tunnel, associated with a port, is “up” when both conditions are met. A tunnel is “down” when either of the
conditions are not met.
◦ Either the primary or backup controller is reachable.

◦ A boot strap message response is received from the controller.

• Heartbeat between the switch and controller has failed when the controller does not respond after five
attempts. All tunnels are brought down with a heartbeat failure.

• A tunnel “up or down” status will be logged for each tunnel node port in the event log.

• The show tech command dumps all user-mode and test-mode command outputs.

• To reach the Aruba controller, the VLAN must have a manual IP configured.

• With the exception of the 802.1x BPDU, the switch consumes all other BPDUs.

• The controller cluster cannot have mix of IPv4 and IPv6 nodes.

• IPv6 addresses are not allowed for both Primary and Backup controllers when in Port-Based Tunnels..

Interaction table
Features enabled with tunneled node:
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Feature

Mirrors (MAC, VLAN, port)

PVST/RPVST/STP

DLDP

UDLD

LLDP/CDP

GVRP/MVRP

LACP

Uplink Failure Detection

sFlow

Loop protect

Smartlink

Global QoS (VLAN, port, rate limit)

MAC lockout/lockdown

ACL/Classifiers (ingress/egress)

IGMP/MLD

GMB

Broadcast-limit

Energy Efficient Ethernet

Flow Control

PoE

• poe-allocate-by

• poe-lldp-detect

Rogue MAC detection

LLDP auto provisioning

Restrictions
• Once a tunneled-node profile is applied to a port, the controller IP (primary and backup) cannot be changed.

• IP address cannot be assigned to VLANs that contain ports with Port-Based Tunneling configured.
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• No support for fragmentation and reassembly for encapsulated frames that result in an MTU violation. Such
frames will be dropped.

• Packets from ports configured with Port-Based Tunnels will not be bridged with locally switched ports.

Features that are blocked when Port-Based Tunnels are configured and the scope of the block (either globally, on
a port basis or on a VLAN basis):

Feature Blocked globally/per port/ VLAN with Port-
Based Tunneling

IP multicast routing Global

Openflow Global

Q-in-Q Global

Distributed Trunking Global

Mesh Global

VXLAN Global

IP address: manual and dhcp VLAN

802.1x, mac auth, webauth, LMA, port
security

Port

DIPLD (IPv4/IPv6) Port

DSNOOP (IPv4/IPv6) VLAN

ARP protect VLAN

RA guard Port

Virus throttling Port

BYOD VLAN

Trunk Profile cannot be applied to a trunk

PBR policies VLAN

VSF on a Port-Based Tunnel configured
port

Port

Source port/Multicast filters Port

DHCP client/Server/Relay VLAN

Preventing double tunneling of Aruba Access Points
When an Aruba Access Point (AP) is connected to a port on which Port-Based Tunneling is configured, there are
two tunnels from that port to the Controller - one for the AP and another for the tunneled node. To improve
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performance of APs connected to tunneled node ports, the following configuration parameter under the device
profile feature prevents double tunneling.

The parameter decides whether to allow or not, a tunneled node to be configured on the port on which the device-
profile is applied. Use the command switch(config)# device-profile name <device-profile-name>
[no] allow-tunneled-node.

NOTE: The default setting of device-profile allows tunneled node. Device profile is applied on
the port only by reading Organizational Specific TLV in LLDP packets.

Preventing double tunneling using device profile
device-profile name

Syntax
device-profile name <device-profile-name> [no] allow-tunneled-node

Description

Allows or disallows tunneled node when device profile is applied on that port.

Command context
config

Parameter
<device-profile-name>

Specifies the name of the device profile to be configured.

Usage

To create a device-profile named “test”, execute the following command:

switch(config)# device-profile name test
To allow tunneled-node by the configured device profile parameter, execute the following command:

switch(device-profile)# allow-tunneled-node

Examples

switch(config)# device-profile name <device-profile-name>
 switch(device-profile)# 
 allow-jumbo-frames    Configure jumbo frame support for the device port.
 allow-tunneled-node   Configure Tunneled Node support for the device port.
 cos                   Configure the Class of Service (CoS) priority for
                       traffic from the device.
 egress-bandwidth      Configure egress maximum bandwidth for the device port.
 ingress-bandwidth     Configure ingress maximum bandwidth for the device
                       port.
 poe-max-power         Configure the maximum PoE power for the device port.
 poe-priority          Configure the PoE priority for the device port.
 speed-duplex          Configure the speed and duplex for the device port.
 tagged-vlan           Configure this port as a tagged member of the specified
                       VLANs.
 untagged-vlan         Configure this port as an untagged member of specified
                       VLAN.
Execute show run command to display the tunneled mode configuration in an enabled or disabled state:
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switch(config)# show run
; J9625A Configuration Editor; Created on release #KB.16.05.0000x
; Ver #0f:02.43.18.82.34.61.1c.28.f3.84.9c.63.ff.37.2f:da
hostname "switch"
snmp-server community "public" unrestricted
device-identity name "cpe" lldp oui 33bbcc
device-identity name "cpe" lldp sub-type 1
device-identity name "phone" lldp oui 112233
 
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-28
   ip address dhcp-bootp
   exit
device-profile name "ram"
   exit
device-profile name "test"
   exit
device-profile type “scs-wan-cpe”
   associate "ram"
   enable
   exit
device-profile type-device "cpe"
   associate "ram"
   enable
   exit
device-profile type-device "phone"
   associate "default-device-profile"
   exit 
When allow-tunneled-node is disabled:

switch(config)# show run
; J9625A Configuration Editor; Created on release #KB.16.05.0000x
; Ver #0f:02.43.18.82.34.61.1c.28.f3.84.9c.63.ff.37.2f:da
hostname "switch"
snmp-server community "public" unrestricted
device-identity name "cpe" lldp oui 33bbcc
device-identity name "cpe" lldp sub-type 1
device-identity name "phone" lldp oui 112233
 
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-28
   ip address dhcp-bootp
   exit
device-profile name "ram"
   exit
device-profile name "test"
   no allow-tunneled-node
   exit
device-profile type “scs-wan-cpe”
   associate "ram"
   enable
   exit
device-profile type-device "cpe"
   associate "ram"
   enable
   exit
device-profile type-device "phone"
   associate "default-device-profile"
   exit 
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show device-profile config

Syntax
show device-profile config

Description

Displays device profile configuration.

Command context
config

Usage

To verify whether tunneled-node is allowed (when “test” is device-profile name):

switch(device-profile)# show device-profile config test
To verify the output when tunneled-node is disabled:

switch(device-profile)# no allow-tunneled-node
switch(device-profile)# show device-profile config test

Example

switch(config)# show device-profile config
 Device Profile Configuration

 Configuration for device-profile : default-ap-profile
  untagged-vlan      : 1
  tagged-vlan        : None
  ingress-bandwidth  : 100%
  egress-bandwidth   : 100%
  cos                : 0
  speed-duplex       : auto
  poe-max-power      : Class/LLDP
  poe-priority       : critical
  allow-jumbo-frames : Disabled
  allow-tunneled-node: Enabled

 Device Profile Configuration

  Configuration for device-profile : test
  untagged-vlan      : 1
  tagged-vlan        : None
  ingress-bandwidth  : 100%
  egress-bandwidth   : 100%
  cos                : None
  speed-duplex       : auto
  poe-max-power      : Class/LLDP
  poe-priority       : critical
  allow-jumbo-frames : Disabled
  allow-tunneled-node: Enabled
When tunneled-node is disabled:

switch(config)# show device-profile config
 Device Profile Configuration

 Configuration for device-profile : default-ap-profile
  untagged-vlan      : 1
  tagged-vlan        : None

Chapter 18 Dynamic Segmentation 619

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 7216



  ingress-bandwidth  : 100%
  egress-bandwidth   : 100%
  cos                : 0
  speed-duplex       : auto
  poe-max-power      : Class/LLDP
  poe-priority       : critical
  allow-jumbo-frames : Disabled
  allow-tunneled-node: Disabled

  Device Profile Configuration

  Configuration for device-profile : test
  untagged-vlan      : 1
  tagged-vlan        : None
  ingress-bandwidth  : 100%
  egress-bandwidth   : 100%
  cos                : None
  speed-duplex       : auto
  poe-max-power      : Class/LLDP
  poe-priority       : critical
  allow-jumbo-frames : Disabled
  allow-tunneled-node: Disabled

User-Based Tunneling
User-Based Tunneling gives Aruba switches the ability to tunnel specific client traffic to an Aruba controller.

Once User-Based Tunneling is enabled, the Aruba controller provides a centralized security policy, authentication,
and access control. The decision to tunnel client traffic is based on the user role. User roles redirect traffic to an
Aruba controller when the tunnel status is up. A secondary role, provided by the authentication subsystem, when
present in the user role authorizations, notifies the User-Based Tunnel and provides a secondary role. The
communication between a User-Based Tunneling switch and the ClearPass is supported only over IPv4.

User-Based Tunneling, combined with ClearPass/LMA policies, can be used to indicate if a client's traffic should
be tunneled to the controller.

User Authentication Workflow
The flowchart below depicts user authentication workflow for User-Based Tunneling:

1. Authenticate user

2. Apply user role to authenticated user

3. Redirect user traffic to controller

4. Apply secondary user role to user traffic on controller
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How it works
The functionality of User-Based Tunneling starts with the tunneled-node server information being discovered on
the Aruba switch. User-Based Tunneling module exchanges information with the tunneled-node server to
determine its reachability and discover the version details. Once the reachability is confirmed, the user-based
tunneling module in the Aruba switch sends a bootstrap message to the tunneled-node server, which replies with
an acknowledge message.

Creating a Tunnel

A GRE heartbeat is initiated between the Aruba switch and the managed device creating a tunnel. A GRE
heartbeat is exchanged with the managed device, which is the switch anchor controller (SAC). This is the
controller-IP in the tunneled-nodeserver command. A secondary heartbeat is also established with the
standby managed device and acts as a secondary switch anchor controller (s-SAC).

Authenticating the User

As a user connects to a secure port, the Aruba switch sends a request to the RADIUS server (in this case,
ClearPass), which authenticates the user and returns a user role attribute to the Aruba switch. Once the attribute
containing information on which user role the user will be placed in is received by the Aruba switch, the user role
that is configured locally on the Aruba switch or downloaded from the ClearPass.

Aruba User Role

A user role can contain policy, captive portal, and VLAN information. When the user role that is returned from the
RADIUS server is applied to the user, the tunneled-node-server-redirect command to redirect traffic to a
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managed device can be included within the user role. When this command is executed and the user-based
tunneling feature status is up, the authentication sub system notifies the user-based tunnel node module,
providing a secondary role. The secondary role is the user role on the managed device where policy generally
exists for tunneled users. This is where the firewall and security will be applied. This secondary-role information is
an indication to the managed device that it has to enforce additional policies to the user traffic based on policy
configuration associated with the secondary role and then from the tunnel.

Tunneling to a Controller Cluster

To ensure high availability, customers can tunnel traffic to a Controller Cluster instead of just to a standalone
controller. If users are tunneled to a controller cluster, the bucket map containing the mapping between a bucket
of clients to the active UAC and s-UAC is populated in the controller. A value based on the client MAC address is
assigned when a user is redirected to a controller. This value is then used to look up the bucket map and the
client device is then anchored to that particular controller node. This secondary-role information is an indication to
the controller that it has to enforce additional policies to user traffic based on policy configuration associated with
the secondary role. After this process, the per user tunneled node module creates a tunnel to this UAC, if not
already created, and forward user traffic to that UAC. If a user role does not contain an attribute to redirect traffic
to a controller, then the switch will forward the traffic locally.

Once user tunnels are established to the user anchor controllers, a PAPI (Process Application Programming
Interface)-based keepalive packet is exchanged with the controllers that have users anchored to them.

NOTE: Upgrading from earlier images to 16.08 or greater with the same user role configuration is
seamless and is supported. After upgrading to 16.08 or later, if Reserved VLAN mode is configured,
the VLAN IDs already configured in user roles will not be used for tunneling traffic to the controller.

Downgrading is not allowed when User-Based Tunneling is operating in Reserved VLAN mode. The
user cannot downgrade to pre-16.08 image if the user role lacks a VLAN configuration.

Licensing Requirements
A license is required to activate Dynamic Segmentation and if the license is not installed, controllers will not be
allowed to form tunnels to Aruba switches and the feature will not be functional. The AP/switch consumes the
following license types:

AP

PEFNG

RFP

WebCC

MC-VA (for VMC-MD)

The show license-usage ap command displays license usage for User-Based Tunnels. Licenses are
consumed per switch and User-Based Tunnels will show up alongside APs for license consumption.

switch# show ap license-usage 
 
AP Licenses
-----------
Type                      Number
----                      ------
AP Licenses               2048
RF Protect Licenses       2048
PEF Licenses              2048
MM Licenses               2048
Controller License        True
Overall AP License Limit  2048
 
AP Usage
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--------
Type             Count
----             -----
Active CAPs      0
Active RAPs      0
Remote-node APs  0
Active MUX       0
Active PUTN      1
Total APs        1
 
Remaining AP Capacity
---------------------                              
Type  Number
----  ------
CAPs  2047
RAPs  2047
show license client-table output on a Controller Cluster:

(cluster1)# show license client-table

Built-in limit: 0
License Client Table
--------------------
Service Type                                        System Limit  Server Lic.  Used Lic.  Remaining Lic.  FeatureBit
------------                                        ------------  -----------  ---------  --------------  ----------
Access Points                                       64            510          2          62              enabled
Next Generation Policy Enforcement Firewall Module  64            254          2          62              enabled
RF Protect                                          64            510          2          62              enabled
Advanced Cryptography                               4096          512          0          512             enabled
WebCC                                               64            0            0          0               disabled
MM-VA                                               65            494          3          62              enabled
MC-VA-RW                                            64            250          0          64              disabled
MC-VA-EG                                            64            0            0          0               disabled
MC-VA-IL                                            64            0            0          0               disabled
MC-VA-JP                                            64            0            0          0               disabled
MC-VA-US                                            64            0            0          0               disabled
VIA                                                 4096          0            0          0               enabled

show license server-table output on the Mobility Master:
(MM1) [mynode]# show license server-table

License Server Table for pool / profile root
--------------------------------------------
Service Type                                        PoolSize  ExpiredLic  ActualPoolSize  UsedLic  RemainingLic  Warnings  FeatureBit
------------                                        --------  ----------  --------------  -------  ------------  --------  ----------
Access Points                                       512       0           512             18       494           None      enabled
Next Generation Policy Enforcement Firewall Module  256       0           256             18       238           None      enabled
RF Protect                                          512       0           512             18       494           None      enabled
Advanced Cryptography                               512       0           512             0        512           None      enabled
WebCC                                               0         0           0               0        0             None      disabled
MM-VA                                               1000      0           1000            12       988           None      enabled
MC-VA-RW                                            250       0           250             0        250           None      enabled
MC-VA-EG                                            50        0           50              0        50            None      enabled
MC-VA-IL                                            50        0           50              0        50            None      enabled
MC-VA-JP                                            50        0           50              0        50            None      enabled
MC-VA-US                                            50        0           50              0        50            None      enabled
VIA                                                 0         0           0               0        0             None      enabled

(MM1) [mynode] # 

Dependencies
Dynamic Segmentation is supported on the following platforms and firmware versions:

Supported Deployments

• Standalone controller

• Clustered controller

Switch Platform and Firmware Support
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• Aruba 3810 Switch Series

• Aruba 2930F Switch Series and Aruba 2930M Switch Series

• Aruba 5400R Switch Series (v3 blades only)

• ArubaOS-Switch 16.04 or later

Controller Firmware Support

• Standalone controller - 7000 Series and 7200 Series running ArubaOS 8.1.0.0 or later

• Clustered controller - 7000 Series and 7200 Series running ArubaOS 8.1.0.0 or later

ClearPass

ClearPass version 6.7.

AirWave

AirWave version 8.2.6.

NOTE: Even though AirWave 8.2.6 or above will work, AirWave 8.2.8 has additional enhancements
to provide visibility to tunnels.

Simplifying User-Based Tunneling with Reserved VLAN
Prior to 16.08, authenticated clients were assigned to the VLANs provided by applied user role profile (configured
or downloadable). Then, the User-Based Tunnel would get established between the switch and controller, and
client traffic would be tunneled to the controller, provided the client VLAN imposed by the user role profile was
created previously in both switch and controller. Otherwise, User-Based Tunneling functionality would fail.

This created an overhead for network admins while configuring all possible client VLANs in each access switch
and controller, so that the client traffic could be tunneled and segregated properly. Since all client traffic was
tunneled to the controller, and controller segregated the traffic based on its configured policy (secondary user
role), there was no value added for maintaining multiple VLANs for various categories of clients.

ArubaOS-Switch 16.08 allows creation of a reserved VLAN through which all tunneled traffic is taken to the
controller and this simplifies deployment of User-Based Tunneling. A fixed/reserved VLAN is configured under
tunneled profile, which is assigned to all tunneled clients and the same VLAN is used while tunneling client traffic
to the controller. Thus, to use a reserved VLAN, it is not required to preconfigure VLANs configured under user
role in switch, prior to initiating client authentication. When a reserved VLAN is configured, if it is not already
present on the switch, it will be created and traffic from all clients on the switch will go through the reserved VLAN.
By adding a single line configuration to tunneled-node command, existing users can migrate to the Reserved
VLAN mode without changing any other configuration.

Differences between User-Based Tunnels with and without Reserved VLAN:

User-Based Tunnels without Reserved VLAN User-Based Tunnels with Reserved VLAN

Tunnel VLANs should be statically configured on all
switches.

Tunnel VLANs need not be statically configured on all
switches.

User role should have VLAN attribute configured. User role need not have VLAN attribute configured.

Multicast traffic is replicated on the switch. Multicast traffic is replicated on the controller.

VLANs need to be synchronized between the switch
and the controller.

VLANs need not be synchronized between the switch
and the controller.

Operating Notes:
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• The reserved VLAN is used exclusively for User-Based Tunneling feature. Deletion of this VLAN is not allowed
outside of tunneled profile configuration.

• The VLANs imposed by user role after successful client authentication is ignored, and the reserved VLAN is
used for on-boarding the tunneled clients.

• Controller segregates tunneled client traffic based on assigned secondary role and unicasts the multicast/
broadcast traffic to individual clients through UAC tunnel.

• SAC multicast tunnels are no longer used in reserved VLAN mode.

• The reserved VLAN configuration on the controller is optional.

• The default VLAN cannot be configured as a reserved VLAN.

• Migration from Port-Based Tunneling to User-Based Tunneling requires a disable and then, a re-enable of
tunneling.

• The user role for tunneled clients will not be allowed to contain untagged and tagged VLAN like normal clients.

Configuration and show commands

Commands to configure a tunneled node server on the switch
Tunneled node configuration
Commands necessary to configure a tunneled node server for a tunneled node Aruba switch:

• switch(config)#tunneled-node-server
• switch(tunneled-node-server)# controller-ip <IP-ADDR | IPV6-ADDR>
• Optional: switch(tunneled-node-server)# backup-controller-ip <IP-ADDR | IPV6-ADDR>
• Optional: switch(tunneled-node-server)# keepalive interval <Integer>
• switch(tunneled-node-server)# mode role-based reserved-vlan <vlan-id>
• switch(tunneled-node-server)# enable

NOTE: IPv6 configurations are only available when the switch is operating in role-based mode (User-
Based Tunneling).

tunneled-node-server
Syntax
tunneled-node-server [controller-ip <IP-ADDR|IPv6-ADDR> | backup-controller-ip 
<IP-ADDR|IPv6-ADDR> | [keepalive <TIMEOUT>] | enable | mode role-based {reversed-vlan <VLAN-ID>}]
    
no tunneled-node-server [controller-ip <IP-ADDR|IPv6-ADDR> | backup-controller-ip 
<IP-ADDR|IPv6-ADDR> | [keepalive <TIMEOUT>] | enable | mode role-based {reversed-vlan <VLAN-ID>}]

Description

Configure tunneled node server information.

The no form of the command removes the tunneled node server configuration.

Options

controller-IP

Configure the controller IP address for the tunneled node. Both IPv4 and iPv6 are supported.
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backup-controller-IP

Configure the backup controller IP address for the tunneled node. Both IPv4 and IPv6 are supported.

keepalive

Configure the keepalive timeout for the tunneled node in seconds [1-40]. The default is 8 seconds.

enable

Enter the manager command context.

mode role-based

Specifies the tunneled node server mode as role based.

mode role-based reserved-vlan

Specifies the VLAN used as tunneled node server reserved VLAN.

Examples
switch(config)# tunneled-node-server controller-ip 15.255.133.148
switch(config)# tunneled-node-server backup-controller-ip 15.255.133.148
switch(config)# tunneled-node-server keepalive 40
tunneled-node-server-redirect

Syntax
tunneled-node-server-redirect [secondary-role <ROLE-NAME>]

no tunneled-node-server-redirect [secondary-role <ROLE-NAME>]

Description

Configures traffic redirect to user-based tunnel. Secondary role is the new user role that will be applied to the
tunneled traffic by the controller.

The no form of this command stops the traffic re-direction to the controller. Secondary role is the new user role
that will be applied to the tunneled traffic by the controller.

Command context
user-role

Parameters
secondary-role <ROLE-NAME>

Specifies the secondary role applied on the user traffic by the controller.

Example

switch(config)# aaa authorization user-role name testrole

switch(user-role)#
 tunneled-node-server-redirect
 tunneled-node-server
The tunneled-node-server-redirect attribute instructs the switch to redirect all traffic with user-role “testrole” to the
controller. The secondary-role “authenticated” specified with the redirect attribute should be configured and
present on the controller. In versions 16.07 and earlier, the client VLAN on the switch needs to be present on the
Controller. With the Reserved VLAN mode introduced in 16.08, this is no longer necessary.
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class ipv4 "testclass"
     10 match ip 0.0.0.0 255.255.255.255 0.0.0.0 255.255.255.255
     20 match tcp 0.0.0.0 255.255.255.255 0.0.0.0 255.255.255.255
   exit
policy user "testpolicy"
     10 class ipv4 "testclass" action permit
   exit
aaa authorization user-role name "testrole"
   policy "testpolicy"
   vlan-id 100
   tunneled-node-server-redirect secondary-role "authenticated"
   exit

NOTE: When the reserved-vlan option is used, the applied VLAN ID under the user-role
"testrole" will not be considered. This is because the traffic will be redirected to the controller using
reserved-vlan, and not the one configured on the switch.

Show the tunneled-node-server status for all users.

switch-PoEP# show tunneled-node-users all

PORT    MAC-ADDRESS     TUNNEL-STATUS   SECONDARY-USERROLE      FAILURE-REASON
1       000ffe-c8ce92   UP              authenticated
5       082e5f-263518   UP              authenticated

NOTE: Starting from 16.08, The CLI constraint while configuring tunneled-node-server-
redirect attribute without configuring VLAN ID has been removed.

IP source interface

Syntax
switch(config)# ip source-interface tunneled-node-server 
[<IP_ADDRESS> | loopback <LOOPBACK_INTERFACE> | vlan <VLAN_ID>]

Description

Defines source IP address or interface for specified protocol.

NOTE: 

• If interface has multiple addresses, lowest address is used.

• Protocols not configured with a specific address will use the IP address of outbound interface as
source.

Command context
ip source-interface

Parameters
<IP_ADDRESS>

Specifies IP address.

<LOOPBACK_INTERFACE>

Specifies a loopback interface.
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<VLAN_ID>

Specifies VLAN ID.

Example

Running configuration:

NOTE: Requires (config)#show run context:

; J9850A Configuration Editor; Created on release #KB.16.05.0000x
; Ver #12:08.1f.fb.7f.bf.bb.ff.7c.59.fc.7b.ff.ff.fc.ff.ff.3f.ef:f4
hostname "Anay5400R"
module A type j9989a
module B type j9986a
module C type j9989a
module D type j9986a
module E type j9986a
module F type j9986a
class ipv4 "testclass"
    10 match ip 0.0.0.0 255.255.255.255 0.0.0.0 255.255.255.255
    20 match tcp 0.0.0.0 255.255.255.255 0.0.0.0 255.255.255.255
  exit
policy user "testpolicy"
    10 class ipv4 "testclass" action permit
  exit
radius-server host 90.90.90.1
ip routing
ip source-interface tunneled-node-server loopback 1
tunneled-node-server
    controller-ip 21.1.1.2
    mode role-based
  exit

Reserved VLAN
Syntax
tunneled-node-server mode role-based reserved-vlan <VLAN-ID>

[no] tunneled-node-server mode role-based reserved-vlan <VLAN-ID>
Description

Enable tunneled node server with a reserved VLAN on which all client traffic is sent to the controller.

Example

To configure a tunneled node server in role-based reserved VLAN mode:

switch(tunneled-node-server)# mode
port-based        Configure tunneled node server mode as port based.
role-based        Configure tunneled node server mode as role based.

switch(tunneled-node-server)# mode role-based
reserved-vlan    Configure VLAN Mode as No-VLAN, switch without tunneled-node client’s 
vlan.

switch(tunneled-node-server)# mode role-based reserved-vlan
VLAN-ID              Configure VLAN to be created and reserved for tunneled-node clients.
                               

switch(tunneled-node-server)# mode role-based reserved-vlan <VLAN-ID>
show tunneled-node-server output:
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switch(config)# show tunneled-node-server
 Tunneled Node Server Information
  State                                              : Enabled
  Primary Controller                                 : 10.0.0.1
  Backup Controller                                  : 
  Keepalive Interval (seconds)                       : 8
  Mode                                               : Role-based
  Vlan-Mode                                          : no-vlan/vlan-extend
  Reserved-VLAN                                         : reserved-VID/0

switch(config)# show vlan <reserved-vid>
VLAN ID    Name               | Status           | Voice    | Jumbo
--------------------------------------------------------------------
<VID>      PUTN-ReservedVLAN  | Port-based       | No       | No

Show commands
show user-role

Syntax
show user-role <role-name>

Description

Displays the user role information for the specified user role name.

Command context
manager or operator

Parameters
<role-name>

Specifies the user role name.

Examples

Shows the user role by specific name.

switch# show user-role testrole

 User Role Information

   Name                              : testrole
   Type                              : local
   Reauthentication Period (seconds) : 0
   Cached Reauth Period (seconds)    : 0
   Logoff Period (seconds)           : 300
   Untagged VLAN                     : 100
   Tagged VLAN                       :
   Captive Portal Profile            :
   Policy                            :
   Tunnelednode Server Redirect      : Enabled
   Secondary Role Name               : XYZ
   Device Attributes                 : Disabled

switch#

show vlan

Syntax
show vlan <reserved-vid>
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Description

Display the details of reserved VLAN ID.

Command context
manager

Parameters
<reserved-vid>

Specifies the reserved VLAN ID.

Examples

switch(config)# show vlan <reserved-vid>

Status and Counters - VLAN Information - VLAN <reserved-vid>

VLAN ID : <reserved-vid>
Name    : TUNNELED_NODE_SERVER_RESERVED
Status  : Port-based
Voice   : No
Jumbo   : No
Private VLAN : none
Associated Primary VID    : none
Associated Secondary VIDs : none

Port Information Mode     Unknown VLAN Status
---------------- -------- ------------ -----------------------

NOTE: The user will not be able to delete the reserved VLAN. Reserved VLAN will be automatically
removed once the reserved-vlan parameter is removed from tunneled-node configuration.

show tunneled-node-server

Syntax
show tunneled-node-server [information | statistics <controller> | state <controller>]

Description

Shows the tunneled-node-server information, statistics, or state.

NOTE: Information for SAC and SSAC Switch Anchor Controller (SAC), Standby Anchor Controller
(SSAC) and User Anchor Controller (UAC) is available in the ArubaOS-Switch Controller Guide at 
https://support.arubanetworks.com/.

Command context
manager or operator

Parameters
information

Specifies tunneled-node-server information, node-list, and the bucket map information.

statistics <controller>
Specifies the data plane statistics with respect to a controller for each port.
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state <controller>
Specifies the data plane state with respect to a controller.

Example

switch(config)# show tunneled-node-server

Tunneled Node Server Information

  State                        : Enabled
  Primary Controller           : 10.10.10.148
  Backup Controller            : 10.10.10.149
  Keepalive Interval (seconds) : 1
  Mode                         : Role-based
  Vlan-Mode                    : vlan-extend-disable
  Reserved-Vlan                : 1111

switch# show tunneled-node-server state

 Local Master Server (LMS) State

 LMS Type     IP Address       State        Capability Role
 Primary   :  10.10.10.148     Complete     Per User   Operational Primary
 Secondary :  10.10.10.149     Complete     Per User   Operational Secondary
 Switch Anchor Controller (SAC) State

               IP Address       Mac Address             State
 SAC         : 10.10.10.148     001a1e-037520           Registered

 User Anchor Controller (UAC) : 10.10.10.148
 User              Port       VLAN       State       Bucket ID
 00000f-000200     1/24       100        Registered  2

switch# show tunneled-node-server statistics

 Tunneled Node Statistics

 Control Plane Statistics

 SAC                  : 10.10.10.148
    Bootstrap Tx      : 1                 Bootstrap Rx         : 1
    Nodelist Rx       : 0                 Nodelist Ackd        : 0
    Bucketmap Rx      : 0                 Bucketmap Ackd       : 0
    Failover Tx       : 0                 Failover Ackd Tx     : 0
    Unbootstrap Tx    : 0                 Unbootstrap Ackd Tx  : 0
    Heartbeat Tx      : 102               Heartbeat Rx         : 102

    UAC               : 10.10.10.148
    Bootstrap Tx      : 1                 Bootstrap Ack        : 1
    Unbootstrap Tx    : 0                 Unbootstrap Ack      : 0
    Keepalive Tx      : 0                 Keepalive Ack        : 0

   Data Plane Statistics

    SAC tunnel Rx                   : 102
    MTU violation Drop              : 0
    Fragmented Packets Dropped (Rx) : 0
    Packets to Non-Existent Tunnel  : 0
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    UAC                                      Packets Tx     Packets Rx
    10.10.10.148                             5463693        331

    User Statistics

    UAC                                      User Count
    10.10.10.148                             1
When the controller is a standalone:

switch(eth-1/24)# show tunneled-node-server information

 SAC Information

  SAC : 10.10.10.148
  Standby-SAC :
UAC List Information

  Cluster Name :
  Cluster Status : Disabled

  [ 0] ::    10.10.10.148         0.0.0.0         0.0.0.0         0.0.0.0
  [ 4] ::         0.0.0.0         0.0.0.0         0.0.0.0         0.0.0.0
  [ 8] ::         0.0.0.0         0.0.0.0         0.0.0.0         0.0.0.0

 Bucket Map Information

  Bucket Name :
  Bucket Map Active : [0 .. 255]
  [  0] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [  6] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [ 12] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [ 18] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [ 24] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [ 30] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [ 36] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [ 42] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [ 48] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [ 54] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [ 60] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [ 66] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [ 72] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [ 78] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [ 84] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [ 90] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [ 96] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [102] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [108] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [114] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [120] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [126] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
  [132] :: (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1) (0, -1, 1)
When the controller is a cluster:

switch$ show tunneled-node-server information

SAC Information

  SAC : 10.10.10.147
  Standby-SAC : 10.10.10.146

UAC List Information
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  Cluster Name : 3NodeProfile
  Cluster Status : Enabled

  [0] ::    10.10.10.147    10.10.10.146         0.0.0.0         0.0.0.0
  [4] ::         0.0.0.0         0.0.0.0         0.0.0.0         0.0.0.0
  [8] ::         0.0.0.0         0.0.0.0         0.0.0.0         0.0.0.0

Bucket Map Information

  Bucket Name : TUNNELED_NODE_ESSID
  Bucket Map Active : [0 .. 255]
  [  0] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [  6] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [ 12] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [ 18] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [ 24] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [ 30] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [ 36] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [ 42] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [ 48] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [ 54] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [ 60] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [ 66] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [ 72] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [ 78] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [ 84] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [ 90] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [ 96] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [102] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [108] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [114] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [120] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [126] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [132] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [138] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [144] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [150] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [156] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)
  [162] :: (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1) (0, 1, 1) (1, 0, 1)

show tunneled-node-users

Syntax
 show tunneled-node-users [all | count | down |  mac <MAC-ADDRESS> |  port <PORT-ADDR> | up ]

Description

Shows the status of a client after configuring and enabling tunneled-node-server-redirect.

Command context
manager or operator

Parameters
<ALL>

Specifies all clients and their status.
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<COUNT>

Specifies the total number of clients configured to tunnel their traffic to the controller.

<DOWN>

Specifies the clients which are not able to tunnel their traffic.

PORT <PORT-ADDR>

Specifies the port client status.

MAC <MAC-ADDRESS>

Specifies the client status based on the MAC address desired by the user.

<UP>

Specifies the status of clients with tunnels up.

Example

switch(config)# show tunneled-node-users 
 all                   Displays all the clients and their status.
 count                 Displays the total number of clients configured to 
                       tunnel their traffic to the controller.
 down                  Displays the clients which are not able to tunnel their
                       traffic.
 mac                   Displays the client status based on the MAC address 
                       desired by the user.
 port                  Displays the client status of the particular port 
                       desired by the user.
 up                    Displays the client status which are having their 
                       tunnels up and running

switch(config)# show tunneled-node-users all

PORT   MAC-ADDRESS  TUNNEL-STATUS   SECONDARY-USERROLE   FAILURE-REASON    
123      XYZ123       UP                 ROLE NAME1           
234      XYZ1234      DOWN               ROLE NAME2       UAC_DOWN
Show the total number of clients configured with the user-based tunneled-node.

switch(config)# show tunneled-node-users count

Total number of clients configured with user-based tunneled node: 2
Show the port access clients in detail.

switch# show port-access clients

Downloaded user roles are preceded by *
 Port Access Client Status

  Port  Client Name   MAC Address       IP Address      User Role         Type  VLAN
  ----- ------------- ----------------- --------------- ----------------- ----- ----
  1/7   2c41387f35b9  2c4138-7f35b9     n/a             Voice_HPE         MAC   171
  1/7   d48564940c46  d48564-940c46     n/a             *DUR_prof2_PUT... MAC   100
  1/16  dur1          001517-857121     n/a             *DUR_prof2_PUT... 8021X 100
  1/17  dur1          d48564-a8afa0     n/a             *DUR_prof2_PUT... 8021X 100
  3/7   2c41387fe7f8  2c4138-7fe7f8     n/a             Voice_HPE         MAC   171
  3/7   e8393537b4a5  e83935-37b4a5     n/a             *DUR_prof2_PUT... MAC   100
Show the detailed port-access clients for port 1/7.

switch# show port-access clients detailed 1/7
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 Port Access Client Status Detail

  Client Base Details :
   Port            : 1/7                   Authentication Type : mac-based
   Client Status   : authenticated         Session Time        : 18972 seconds
   Client Name     : 2c41387f35b9          Session Timeout     : 0 seconds
   MAC Address     : 2c4138-7f35b9
   IP              : n/a

Downloaded user roles are preceded by *
 User Role Information

   Name                              : Voice_HPE
   Type                              :
   Reauthentication Period (seconds) : 0
   Untagged VLAN                     : 171
   Tagged VLANs                      :
   Captive Portal Profile            :
   Policy                            :
   Tunnelednode Server Redirect      : Disabled
   Secondary Role Name               :

  Client Base Details :
   Port            : 1/7                   Authentication Type : mac-based
   Client Status   : authenticated         Session Time        : 18947 seconds
   Client Name     : d48564940c46          Session Timeout     : 0 seconds
   MAC Address     : d48564-940c46
   IP              : n/a

Downloaded user roles are preceded by *
 User Role Information

   Name                              : *DUR_prof2_PUTN-3037-12
   Type                              : downloaded
   Reauthentication Period (seconds) : 0
   Untagged VLAN                     : 100
   Tagged VLANs                      :
   Captive Portal Profile            :
   Policy                            : upol2_DUR_prof2_PUTN-3037-12

Statements for policy "upol2_DUR_prof2_PUTN-3037-12"
policy user "upol2_DUR_prof2_PUTN-3037-12"
     10 class ipv4 "remark2_DUR_prof2_PUTN-3037-12" action rate-limit kbps 1000000 action priority 2 action permit
   exit
Statements for class IPv4 "remark2_DUR_prof2_PUTN-3037-12"
class ipv4 "remark2_DUR_prof2_PUTN-3037-12"
     10 match ip 0.0.0.0 255.255.255.255 0.0.0.0 255.255.255.255
   exit

   Tunnelednode Server Redirect      : Enabled
   Secondary Role Name               : authenticated

Commands to configure VLAN ID in user role
Local user roles allow user-based policy configuration local to an Aruba switch. Within the user role configuration,
use the tunneled-node-server-redirect command to tunnel traffic to a Mobility Controller. When this
command is processed, the tunnel is formed and applied to the secondary role (user role) that exists on the
Mobility Controller.

switch(user-role)# vlan-id
Usage: [no] vlan-id <VLAN_ID>

Description: Set the untagged VLAN that users will be assigned to.
switch(user-role)$ tunneled-node-server-redirect
Usage: [no] tunneled-node-server-redirect [secondary-role <ROLE_NAME>]

Description: Configures traffic redirect to user-based tunnel. Secondary role is the new user role that 
will be applied to the tunneled traffic by the controller.

IMPORTANT: The authenticated secondary-role specified with the redirect attribute should be
configured and present on the Mobility Controller.

IMPORTANT: VLAN change for a current User-Based Tunneled client should be done by changing a
user role with a new untagged VLAN and doing a port bounce (to refresh client IP).
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Tunneled Node profile on a Mobility Controller and Cluster
Use the following commands to configure a secondary user role on the Mobility Controller:

switch(config)# user-role authenticated
access-list session global-sacl
access-list session apprf-authenticated-sacl
access-list session ra-guard
access-list session allowall
access-list session v6-allowall
If the managed device is in a cluster, deploy the following configuration on the Mobility Master:

lc-cluster group-profile "hp2node"
controller 10.0.102.6
controller 10.0.102.218
(ArubaMM) [mm] (config) #cd /md/00:1a:1e:02:a4:c0
(ArubaMM) [00:1a:1e:02:a4:c0] (config) #lc-cluster group-membership hp2node
(ArubaMM) [mm] (config) #cd /md/00:1a:1e:02:a6:40
(ArubaMM) [00:1a:1e:02:a6:40] (config) #lc-cluster group-membership hp2node
(ArubaMM) (config) #show configuration node-hierarchy
Default-node is not configured. Autopark is disabled.
Configuration node hierarchy
----------------------------
Config Node Type
----------- ----
/ System
/md System
/md/00:1a:1e:02:a4:c0 Device
/md/00:1a:1e:02:a6:40 Device
/mm System
/mm/mynode System

NOTE: Configure a cluster profile, specify the managed device IP addresses, and map the managed
devices to the cluster profile.

(ArubaMM) [mynode](config) #show switches
All Switches
------------
IP Address IPv6 Address Name Location Type Model Version Status Configuration State Config
Sync Time (sec) Config ID
---------- ------------ ---- -------- ---- ----- ------- ------ ------------------- ----------
------------ ---------
15.212.178.108 None ArubaMM Building1.floor1 master ArubaMM 8.0.0.0_55647 up UPDATE SUCCESSFUL
0 0
10.0.102.218 None C2 Building1.floor1 MD Aruba7210 8.0.0.0-hp-interop_0000 up UNK
(00:1a:1e:02:a6:40) N/A N/A
10.0.102.6 None C1 Building1.floor1 MD Aruba7210 8.0.0.0-hp-interop_0000 up UNK
(00:1a:1e:02:a4:c0) N/A N/A
Verify that all managed devices are added and the status is Update Successful.

Using User Roles with User-Based Tunneling
User-Based Tunnels can also be used with Local User Roles and any third-party RADIUS server. This requires
that the user roles be preconfigured on the switch. For truly colorless and dynamic policy management, Aruba
recommends the use of ClearPass to dynamically send policies to both the switch and controller using
Downloadable User Roles along with User-Based Tunneling.

• There are two roles required when using Downloadable User Roles with User-Based Tunneling:
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Primary user role: Configured on switch

Secondary user role: Configured on controller

• Both primary and secondary role can be either statically configured or downloaded from the ClearPass.

NOTE: This feature is only available for:

• ClearPass 6.7.0 onward

• Aruba Controller Version 8.3.0 onward

◦ To support Downloadable User Roles on controller, a new VSA (HP-CPPM-Seconday-Role)
is introduced in ClearPass 6.7.0, which contains the secondary user role name:

The Aruba switch downloads user policies from ClearPass using downloadable user roles. This makes the
ClearPass a centralized point to administer user policy to the access switch and minimize user configuration on
the Aruba switch. For downloadable user roles to work appropriately, the signing Certificate Authority (CA) of the
ClearPass HTTPS certificate must be added to the Aruba switch and marked as trusted. With ArubaOS-Switch
16.08, there is an automated way to download the CA certificate of ClearPass. Please refer to the Access
Security Guide on using this feature.

ClearPass Sample Configuration
aaa authorization user-role name "<role-name>" 
vlan-id <vlan id> tunneled-node-server-redirect VSA
When the primary user role is downloaded onto the switch and the secondary user role is downloaded onto the
controller:
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When the primary user role is downloaded onto the switch and the secondary user role is manually configured on
the controller (not sent through VSA):

NOTE: For more information on user roles, see Access Security Guide for ArubaOS-Switch for your
switch.

User-Based Tunneling in v6 networks
Starting with 16.08, User-Based Tunnels are supported in IPv6 environments where all the components forming
tunnels are reachable over IPv6. This is important for users who are in the process of migrating from IPv4 to IPv6-
only environments. To support those users, User-Based Tunnels will work not only in IPv6-only environments but
also hybrid environments where some components run IPv4 while others run IPv6.

The switch, controller, and AirWave can operate in an IPv6-only environment while ClearPass, as of 6.7, still has
to be reachable over IPv4 (but supports v4 and v6 clients). Mixed mode is also supported, where one controller
can be reachable through v4 and the backup controller can be reachable through IPv6, and the deployment
supports clients with dual stacks (v4/v6). Using User-Based Tunnels in a IPv6 network is similar in setup and the
configuration and show command covered in earlier sections work for IPv4 as well as IPv6 environments.

PAPI security

Protocol Application Programming Interface (PAPI)
The PAPI Enhanced Security configuration provides protection to Aruba devices, AirWave, and ALE against
malicious users sending fake messages that results in security challenges.

Starting from ArubaOS-Switch version 16.02, a minor security enhancement has been made to Protocol
Application Programming Interface (PAPI) messages. Protocol Application Programming Interface endpoint
authenticates the sender by performing a check of the incoming messages using MD5 (hash). All PAPI endpoints
— APs, Controllers, Mobility Access Switches, AirWave, and ALE — must use the same secret key. The switch
software currently uses a fixed key to calculate the MD5 digest and cooperate with the controller for PAPI
enhanced security.

NOTE: To use this functionality, the PAPI security profile must be configured on the controller. For
more information on the Aruba controller, see the Aruba Networks Controller Configuration
Manual.

PAPI configurable secret key
To support enhanced PAPI security, a command is available to configure a MD5 secret key.
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papi-security
Syntax
switch(config)# papi-security

Description

Configure MD5 key for enhanced PAPI security.

Parameters
enhanced-security

The enhanced-security CLI must be enabled in Aruba controller for the connection to be truly secured.

<KEY-STR>

Configure MD5 key for enhanced PAPI security using a key-string parameter.

<KEY-VALUE>

Configure MD5 key for enhanced papi security using a key-value parameter.

Restrictions

• To view the status of the PAPI security, using the show run command with the option include
credentials enabled, the PAPI security key will show in the output as an encrypted form.

• Key length has to be between 10-64.

• By default the enhanced-security is disabled.

• When enhanced-security mode is disabled, any AP can obtain the current shared secret key.

• When enhanced-security mode is enabled, an AP is not updated with the new shared secret key unless the AP
knows the previous key and the AP is updated with the new key within one hour of the key creation.

• Key length has to be between 10-64 or the following message will appear:

Minimum key-value length allowed is 10 characters and maximum allowed is 64 
characters.

Usage
Switch(config)# papi-security key-value <KEY-VALUE>
Switch(config)# [no] papi-security <KEY-VALUE>

papi-security key-value

Switch(config)# papi-security key-value TestKey12345678
Switch(config)# no papi-security key-value

Switch(config)# papi-security key-value Test
Minimum key-value length allowed is 10 characters and maximum allowed is 64 characters.

show run with encrypted key

 Switch(config)# show run
Running configuration:
;J9576A Configuration Editor
;Created on release #KA.16.02.0000x
;Ver #0e:01.f0.92.34.5f.3c.6b.fb.ff.fd.ff.ff.3f.ef:78
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;encrypt-cred +NXT3w7ky2IXNXadlJblS/1ZRi/o73Qq28XXcLkSCZq9PU30Kl+KMLMva8rQri5g

 hostname "Switch"
 module 1 type j9576y
 module 2 type j9576x
 encrypt-credentials
 papi-security encrypted-key <"encrypted-key">
 snmp-server community "public" unrestricted
 snmpv3 engineid "00:00:00:0b:00:00:50:65:f3:b4:a6:c0"
 oobm
 ip address dhcp-bootp
 exit

 vlan 1
 name "DEFAULT_VLAN"
 untagged 1-52
 ip address dhcp-bootp
 exit

 activate provision disable

show run with include key

show run
Running configuration:
; J9576A Configuration Editor
; Created on release #KA.16.02.0000x
; Ver#0e:01.f0.92.34.5f.3c.6b.fb.ff.fd.ff.ff.3f.ef:78

 hostname "Switch"
 module 1 type j9576y
 module 2 type j9576x
 include-credentials
 papi-security key-value <"key">
 snmp-server community "public" unrestricted
 snmpv3 engineid "00:00:00:0b:00:00:50:65:f3:b4:a6:c0"
 oobm
 ip address dhcp-bootp
 exit
 
 vlan 1
 name "DEFAULT_VLAN"
 untagged 1-52
 ip address dhcp-bootp
 exit
 
 activate provision disable

Frequently Asked Questions
Following is a list of frequently asked questions and answers relating to per user tunnel node.

In a controller cluster, how does the switch determine which controller to send the user traffic to?

The SAC sends a bucket-map to the switch during the switch bootstrap process. This map is an array of 256
entries with each entry containing the active and standby controller to use. A user’s MAC address is hashed into
this table to get the controller to tunnel the user traffic to.

When is the heartbeat started to SAC and S-SAC?

Heartbeat is over a GRE tunnel with a specific GRE key (0xDEED). This is initiated with SAC and S-SAC
immediately after a switch bootstrap is complete.

What happens when heartbeat to SAC fails?
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A heartbeat failure triggers the switch to:

• Remove users anchored to the SAC.

• Fail over to the S-SAC (Example: S-SAC now becomes the new SAC).

What happens when the keepalive to a UAC fails?

The users anchored to the UAC are removed and a message is logged to the same effect in the event log.

Why should jumbo frames be enabled at the switch?

Jumbo frames have to be enabled at the controller uplink VLAN as well as the client VLAN. The GRE tunnel adds
an effective 46 bytes to every user packet. The effective tunnel MTU = uplink VLAN MTU -46 bytes for a 1500
MTU, the tunnel MTU gets to be 1454 bytes. This means that a user can send up to only 1,454 bytes of frames. In
order for users to be able to send up to 1500 (default) MTU, jumbo frames need to be enabled.

What happens when a UAC controller goes down?

A node list update is sent by the SAC to the switch to inform that a controller went down. All users anchored to
that controller are removed (unbootstrapped). After some time, the controller sends a bucket map update to the
switch. The switch then processes the bucket map update and anchors users to the respective controller
(standby) as per the bucket map. The users will then be switched over to S-UAC The S-UAC becomes the new
UAC, and this new S-UAC is assigned after the bucket map update from SAC.

NOTE: It is important to verify that the bucket map on switch and controller is the same. Also, it
should be verified that users are anchored to the right controller identified in the bucket map on both
the switch and controller.

What happens when a SAC controller goes down?

A node list update is sent by S-SAC to switch. Since the node list is received from the S-SAC and not the SAC,
the switch considers that SAC is down and initiates a failover to S-SAC. Also, the switch removes all users
anchored to SAC. Once S-SAC acknowledges the failover request, the S-SAC becomes the new active SAC. The
new Active SAC then sends a node list update and bucket map update. In the node list update, the new S-SAC
will be provided. The switch will then bootstrap and initiate a heartbeat with new S-SAC. The switch then
processes the bucket map update and anchors users to respective controllers.

NOTE: It is important to verify that the bucket map on switch and controller is the same. Also, it
should be verified that users are anchored to the right controller identified in the bucket map on both
the switch and controller.

What happens when the S-SAC controller goes down?

A node list update is sent by the SAC to the switch. The switch stops the heartbeat with the S-SAC which has
gone down and removes all users anchored to it. The switch then initiates a bootstrap to a new S-SAC provided in
the node list update. Once a bootstrap acknowledgment is received, the switch starts a heartbeat to the new S-
SAC. After some time, the SAC will send a bucket map update. The switch then processes the update and
anchors users to their respective controllers.

NOTE: It is important to verify that the bucket map on the switch and controller is the same. Also, it
should be verified that users are anchored to the appropriate controller according to the bucket map
on both the switch and controller.

What do the states in show tunneled-node-server state mean?

• Registering - Bootstrapping

• Registered - Bootstrapped

• Unregistering – Unbootstrapping

What happens when user-role attributes change?
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A rebootstrap is initiated for users applied within that role containing updated role attributes in the bootstrap
packet. These users move to registering state. Once an acknowledgment is received from the controller, users
then move to registering state. This applies only to VLAN and secondary role changes.

What happens on a client “MAC address move”?

A rebootstrap is initiated for the client. Only after an acknowledgment from the controller is received, the client
traffic begins to be tunneled.

What is the recommendation for Per User Tunnel Node client VLAN configuration?

• Tunneled user client VLAN has to be present at the per user tunneled node switch.

• There is no need to specifically add tunneled user ports to this VLAN. Switch AAA takes care of this through
Mac-Based VLANs.

• The uplink to the controller port should NOT be part of this VLAN.

• The uplink to the controller VLAN and the tunneled users VLAN cannot be same.

A user is registered at the switch but does not respond to a ping. How do I debug?

• Check that the user roles and VLANs are correctly configured at the switch as well as the controller.

• Check that the IP MTU is set to >= (1500+46) at all the switches in the path from User-Based Tunneling switch
to the controller.

There are two parts to the solution, and the part that is not working right should be identified.

• To check if the switch is tunneling the traffic, run the show tunneled-node-server statistics
command to check if the user traffic is being received and transmitted. If the counters do not increment, then
the switch configuration needs to be investigated.

• To check if the Mobility Controller is tunneling traffic, run the show datapath tunnel to see if the Encaps
and Decaps counters increase.

A packet trace of traffic sent from and received at the switch uplink to the controller can also be useful, GRE
encapsulated packets are what will be of interest.
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The Time Domain Reflectometry (TDR) or Cable Diagnostics is a port feature supported on some switches
running ArubaOS-Switch software. TDR is used to detect cable faults on 100BASE-TX and 1000BASE-T ports.

Virtual cable testing
The Virtual Cable Test (VCT) uses the same command as TDR. It is applicable only for GigT transceivers like
copper transceiver (J8177C–ProCurve Gigabit 1000Base-T Mini-GBIC). The VCT test results include distance to
the fault, but not the cable length.

Cable Diagnostics
Syntax

test cable-diagnostics <PORT-LIST>
Description

Use the command to test for cable faults.

Option
PORT-LIST

Specify copper port as a input port number.

Test cable-diagnostics C21

test cable-diagnostics C21

The 'test cable-diagnostics' command will cause a loss of link and will take a few seconds per interface to complete.
Continue [Y/N]? y

MDI         Cable    Distance    Pair   Pair        MDI
Port Pair   Status   to Fault    Skew   Polarity    Mode
---------   ------   --------    -----   ------   ------
C21 1-2       Open       0 m      0 ns
    3-6       Open       0 m      0 ns
    4-5       Open       0 m      0 ns
    7-8       Open       1 m      0 ns

Test cable-diagnostics 1/1-1/10

switch# test cable-diagnostics 1/1-1/10

This command will cause a loss of link on all tested ports and will take
several seconds per port to complete.  Use the ‘show cable-diagnostics’ command to view
 the results.

Continue (y/n)? Y

switch# show cable-diagnostics 1/1-1/10

Cable Diagnostic Status - Copper Ports

       MDI    Cable       Cable Length or
  Port Pair   Status      Distance to Fault

Chapter 19
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  ---- ------ ----------- ---------------------
  1/1  1-2    OK          5m
       3-6    OK          5m
       4-5    OK          7m
       7-8    OK          7m
  1/2  1-2    OK          7m
       3-6    OK          7m
       4-5    OK          7m
       7-8    OK          7m
  1/3  1-2    OK          5m
       3-6    OK          7m
       4-5    OK          5m
       7-8    OK          7m
  1/4  1-2    OK          7m
       3-6    OK          7m
       4-5    OK          7m
       7-8    OK          5m
  1/5  1-2    OK          4m
       3-6    OK          5m
       4-5    OK          5m
       7-8    OK          4m
  1/6  1-2    OK          4m
       3-6    OK          4m
       4-5    OK          4m
       7-8    OK          4m
  1/7  1-2    OK          5m
       3-6    OK          4m
       4-5    OK          5m
       7-8    OK          4m
  1/8  1-2    OK          4m
       3-6    OK          5m
       4-5    OK          4m
       7-8    OK          4m
  1/9  1-2    OK          5m
       3-6    OK          5m
       4-5    OK          5m
       7-8    OK          5m
  1/10 1-2    OK          7m
       3-6    OK          5m
       4-5    OK          5m
       7-8    OK          5m

Good cable tests

switch# test cable-diagnostics 51

This command will cause a loss of link on all tested ports and will take
several seconds per port to complete.  Use the 'show cable-diagnostics'
command to view the results.

Continue (y/n)? Y

switch# show cable-diagnostics 51

Cable Diagnostic Status - Transceiver Ports

         MDI    Cable       Distance   Pair    Pair       MDI
  Port   Pair   Status      to Fault   Skew    Polarity   Mode
  ---- ------   ---------   --------   -----   -------   -----
  51     1-2      OK           0 m      8 ns   Normal     MDI
         3-6      OK           0 m      8 ns   Normal
         4-5      OK           0 m      8 ns   Normal     MDIX
         7-8      OK           0 m      0 ns   Normal
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switch# test cable-diagnostics 52

This command will cause a loss of link on all tested ports and will take
several seconds per port to complete.  Use the 'show cable-diagnostics'
command to view the results.

Continue (y/n)?  Y

switch# show cable-diagnostics 52

Cable Diagnostic Status - Transceiver Ports

         MDI    Cable       Distance   Pair    Pair       MDI
  Port   Pair   Status      to Fault   Skew    Polarity   Mode
  ---- ------   ---------   --------   -----   -------   -----
  52    1-2       OK          0 m       0 ns   Normal     MDI
        3-6       OK          0 m       0 ns   Normal
        4-5       OK          0 m       0 ns   Normal     MDIX
        7-8       OK          0 m       0 ns   Normal

Faulty cable test

switch# test cable-diagnostics 51
This command will cause a loss of link on all tested ports and will take
several seconds per port to complete.  Use the 'show cable-diagnostics'
command to view the results.

Continue (y/n)?  y
switch# show cable-diagnostics 51

Cable Diagnostic Status - Transceiver Ports

       MDI    Cable       Distance   Pair   Pair       MDI
  Port Pair   Status      to Fault   Skew   Polarity   Mode
  ---- ------ ----------- ---------- ------ ---------- ------
  51    1-2    OK          0 m        0 ns
        3-6    Short       1 m        0 ns
        4-5    Short       1 m        0 ns
        7-8    OK          0 m        0 ns

switch# test cable-diagnostics 52

This command will cause a loss of link on all tested ports and will take
several seconds per port to complete.  Use the 'show cable-diagnostics'
command to view the results.

Continue (y/n)?  Y

switch# show cable-diagnostics 52

Cable Diagnostic Status - Transceiver Ports

       MDI    Cable       Distance   Pair   Pair       MDI
  Port Pair   Status      to Fault   Skew   Polarity   Mode
  ---- ------ ----------- ---------- ------ ---------- ------
  52   1-2     Open        0 m        0 ns
       3-6     Open        0 m        0 ns
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       4-5     Open        1 m        0 ns
       7-8     Open        0 m        0 ns
Error message

Error Message Cause

The transceiver on port 1/A1
does not support cable
diagnostics.

• usage of invalid(fiber-SFP+) port

• The selected range includes an entry for an invalid port.

show cable-diagnostics
Syntax
show cable-diagnostics <PORT-LIST>
Description

Use the command to generate results of completed tests on single or multiple ports. For incomplete tests, a
warning is displayed.

Option
PORT
Specify one copper port as an input port number.

clear cable-diagnostics
Syntax
clear cable-diagnostics
Description

Use the command to clear the result buffer.

Example

switch(config)# clear cable-diagnostics

Limitations
TDR has the following limitations:

• TDR length accuracy is ± 5 m

• Does not work on Smart Rate Interfaces with 10GBASE-T and NGBASE-T (2.5G, 5G copper) ports available
on:
◦ v3 blades

– J9991A — Aruba 20-port 10/100/1000BASE-T PoE+ / 4-port 1/2.5/5/10GBASE-T PoE+ MACsec v3 zl2
Module

– J9995A — Aruba 8-port 1/2.5/5/10GBASE-T PoE+ MACsec v3 zl2 Module

◦ 3810M (JL076A — Aruba 3810M 40G 8 HPE Smart Rate PoE+ 1-slot Switch)
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• Not supported on v2 zl modules

• Valid only on 100BASE-TX and 1000BASE-T ports
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List of abbreviated terms
Term Definition

VSF Virtual Switch Framework (front plane stacking)

FPS Front Plane Stacking

BPS Back Plane Stacking

MM Management Module

IM Interface Module

GVRP GARP VLAN Registration Protocol

GARP Generic Attribute Registration Protocol

MVRP Multiple VLAN Registration Protocol

Overview of VSF
Aruba Virtual Switching Framework (VSF) technology virtualizes up to eight physical devices in the same layer
into one virtual fabric which provides high availability and scalability. A virtual fabric is therefore multiple physical
devices in the same layer that use VSF technology.

Chapter 20
Virtual Switching Framework (VSF)
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VSF allows supported switches connected to each other through normal Ethernet connections (copper or fiber) to
behave like a single switch.

Figure 104: Two devices using VSF technology appearing as a single node to the upper-layer and lower-layer
devices

For 16.01, VSF supported a 2–member stack for a pair of 5400R switches with V3 blades, interconnected through
standard Ethernet connections with front-plane stacking capability. Interswitch connectivity was restricted to 10G
and 40G links. From 16.03 onwards, VSF supported a 4-member stack for 1G and 10G links. In VSF 8–member
stack, the same front-plane stacking capability has been extended to 2930F switches. Variants have:

• 1G (copper and SFP) ports and 10G (SFP+) ports.

• PoE+ and non-PoE+ ports.

• None of the variants have an OOBM port.

The VSF feature allows the user to form a stack of up to eight devices of any SKU, including mixing the SKUs in a
single stack. The switches in these stacks are interconnected using standard Ethernet connections. These
interconnections between member switches are called VSF links. Each VSF link can comprise up to eight
individual VSF ports, and traffic between two members will be load-balanced automatically across all the
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connected ports. Each switch can have two VSF links. The switches behave as a single virtual switch. 2930F
supports a maximum of four 10G ports.

Figure 105: A 4–member VSF stack

NOTE: The preceding figure applies to a VSF stack having more than four members too.

Benefits of VSF
Simplified topology and easy management

A VSF fabric appears and behaves as one logical switch and is accessible by the network through a single IP
address.

NOTE: Spanning tree features are not necessary among VSF members.

1:1 redundancy

One member acts as the commander to manage and control the entire VSF fabric. One of the switches acts
as a standby and backs up the commander, and takes over in case of commander failure.

VSF port aggregation

A VSF link can aggregate upto eight VSF ports with the immediate neighboring member. This provides
redundancy till failure of seven VSF ports.

Distributed trunking

The Ethernet link aggregation feature can be used to aggregate physical links between the VSF and its
upstream or downstream devices across the VSF members. This eliminates the need for spanning tree and
also provides load balancing across all ports of the link aggregate.

Network scalability

The processing power is equal to the Commander, the forwarding capacity is equal to all the stack members
combined.
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VSF domain ID
VSF uses VSF domain IDs to uniquely identify VSF fabrics and prevent VSF fabrics from interfering with one
another. One VSF fabric forms one VSF domain.

Figure 106: Two VSF domains

VSF link
A VSF link is a logical interface that connects VSF member devices. Every VSF-capable device supports a VSF
link.

I-Link<Member ID>_1 is the default VSF link name.

To configure a VSF link, a minimum of one physical interface should be bound to the link. The bound physical
interfaces are automatically aggregated to form a VSF link. A VSF link goes down only if all its VSF physical
interfaces are down.

Physical VSF ports
VSF ports connect VSF member devices and must be bound to using a VSF link. These VSF ports forward VSF
protocol packets and data traffic. Up to eight ports can be bound to a VSF link.

NOTE: Once a port is bound to a VSF link, all existing configuration associated with the port, such as
VLAN membership and speed, will be removed.

VSF member ID
VSF fabric uses member IDs to uniquely identify and manage its members. The first part of the interface module
number is the Member ID information, which identifies interfaces in a VSF fabric. The device that wins the election
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and becomes a Commander, will retain its member ID, while the other will automatically be assigned a different
unassigned member ID from the pool and reboot.

NOTE: If the VSF member ID changes when joining a VSF virtual chassis, it will cause a reboot of
that member and not the whole VSF virtual chassis.

Interface naming conventions
An interface is named in the following format:

Interface name

<member ID>/<port-index> For example: 1/1, 2/24.

Definition

<member ID >

VSF member ID of the switch. The VSF member ID will be a part of the interface name in a VSF fabric,
whether a device has formed a VSF fabric with other devices, or not. A single device is also considered to be
a standalone VSF fabric.

<port-index >

Index of the port on the device. Port index depends on the number of ports available on the linecard (or
Interface Module).

For example, on VSF, an interface name would take this form:

<member ID>/<interface-module><port-index>

2/4
where 2 is the member ID and 4 is the port-index.

VSF member roles
• Commander: Control and management plane protocols run on the Commander, which is responsible for

managing the forwarding databases, synchronizing them with the Standby and controlling all line cards
including that of the Standby.

• Standby: Standby is a stateful backup device for the Commander and is ready to take control of the VSF
virtual chassis if the Commander device fails. This enables the VSF virtual chassis to continue its operations
seamlessly in the event of a failure.

• Member: All devices in the stack other than the commander and standby are called member switches. The
member switch does not run any networking protocols and has no states. The ports on this switch are directly
controlled and programmed by the commander switch. When a standby takes over as commander, one of the
member switches is upgraded to standby role.

NOTE: All switches in the VSF stack will have the same software version. During stack formation,
switches which do not have the same software version as the commander, will be updated to the
commander's software. This will cause a reboot of the updated switch.

Member priority
Member priority determines the possibility of a member device being elected as the Commander. A member with
higher priority is more likely to be elected as the Commander. The default priority is 128, but can be between 1
and 255.
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NOTE: Changing the priority does not affect the commander immediately. It will take effect from the
next stack reboot, during the commander election.

Supported topologies
• A VSF fabric can have up to eight members.

• A VSF member can have up to two VSF links.

• A VSF fabric with ring topology is recommended. Loss or failure of one link in this topology will degrade the
topology to chain, without losing any VSF members from the stack. Traffic will still continue with minimal loss of
in-flight traffic.

Table 38: Supported chain topologies

Members Chain topology

1–member
(standalone)

2–member

3–member

4–member

5–member

6–member

7–member

8–member
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Table 39: Supported ring topologies

Members Ring topology

3–member

4–member

5–member

6–member

7–member

8–member

654 Aruba 2930F / 2930M Management and Configuration Guide
for ArubaOS-Switch 16.08

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 7251



Running-configuration synchronization
VSF uses a strict running-configuration synchronization mechanism. In a VSF fabric, the Commander manages
and retains the configuration of all the devices. All other devices obtain and use the running configuration from the
Commander.

VSF split
A VSF split can occur due to a VSF link failure where all ports in the VSF link go down or any member is power-
cycled or crashes in the chain topology. This failure results in independent VSF fabric fragment each having its
own Commander role. It is recommended to configure a Multiple Active Detection (MAD) mechanism to avoid
duplicate IP addresses, routing issues and traffic forwarding problems when a VSF split occurs.

Figure 107: VSF split

In the preceding figure, after the split, Member 1 will be elected as the new Standby in the previous Commander
fragment. Previous Standby will failover and become Commander. Member 2 will be elected as a new standby to
that fragment. Once the fragment become inactive, all front plane ports except VSF links will be brought down. A
limited set of CLI commands will be available on the inactive fragment.

VSF merge
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VSF merge occurs on connecting two different VSF fragments having the same domain-ID through VSF links.
One of the VSF fragments reboots to merge with the other fragment and forms one VSF fabric. Devices merge
only if they have the same domain ID.

Figure 108: VSF Merge

NOTE: Only two fragments can be merged at a time.

VSF commands

Configuration commands

vsf enable
Syntax
vsf enable domain <DOMAIN-ID>
Description

Enable VSF on the switch. Allows for switches to be stacked using Ethernet ports.

Parameters

<DOMAIN-ID>

The domain ID can be from 1 to 4294967295.

NOTE: The command vsf enable causes the switch to reboot once and form the fabric. Upon
reboot, the switch comes up in the "VSF enabled" mode. Port numbers are prefixed with member
numbers, such as "1/1". The configuration on the switch becoming Commander will be retained, but
any pre-existing configuration on other switches will be over-written. The switch will inherit the same
switch software as the member becoming Commander. If the software image of a switch needs to be
updated, the switch will reboot twice.

vsf disable
Syntax
vsf disable
Description

Disable VSF on the virtual chassis.

Restriction

This command will not be available until VSF is enabled.

656 Aruba 2930F / 2930M Management and Configuration Guide
for ArubaOS-Switch 16.08

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 7253



vsf member link
Syntax
[no] vsf member <MEMBER-ID> link <LINK-ID> [[ethernet] <PORT-LIST> | name <LINK-
NAME> [start-disabled]]
Description

Create the VSF links. A set of physical ports between any two members, carrying VSF traffic, is collectively
referred to as a VSF link.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
8.

<LINK-ID>

VSF link ID value 1 to 2.

<PORT-LIST>

The port number or a list of ports. Up to eight ports can be assigned into a VSF link.

<LINK-NAME>

The VSF link name. Up to 11 characters are allowed for link name.

Operating Notes

• A VSF link is a logical port dedicated to the internal connection of a VSF virtual device.

• A VSF link is effective only after it is bound to a physical port.

• When an Ethernet port is bound to a VSF link, it carries VSF data traffic and VSF protocol packets.

vsf domain
Syntax
vsf domain <DOMAIN-ID>
Description

Change a domain ID for the VSF virtual chassis.

Once VSF is enabled and virtual chassis is formed, VSF domain ID can be changed using this command.

Parameters

<DOMAIN-ID>

The VSF virtual chassis domain ID. Domain ID value can be in the range of 1 to 4294967295.

vsf member
Syntax
vsf member <MEMBER-ID>
Description

Configure VSF member parameters.

Parameters
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<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range of 1 to 8.

vsf member shutdown
For a switch that physically exists, this command will cause the switch to shut down. shutdown is used in
preparation to remove the switch from the virtual chassis. The switch will not become a voting member of the
virtual chassis again until it is rejoined.

The shutdown command cannot be used on the Commander. The shutdown command will succeed only if the
switch physically exists and is an active member of the virtual chassis.

Syntax
vsf member <MEMBER-ID> shutdown
Description

Shut down the VSF virtual chassis member.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range of 1 to 8.

Restriction

Shutdown will not be available until VSF is enabled.

vsf member reboot
Syntax
boot vsf member <MEMBER-ID>
Description

Reboot the VSF member and have it rejoin the virtual chassis with the current configuration. If the boot option is
specified, the switch will come back up with the existing member-ID and rejoin the virtual chassis with the current
configuration.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range of 1 to 8.

Restriction

Reboot will not be available until VSF is enabled.

vsf member remove
This command removes the entire configuration for a specified member. After issuing the command, the specified
member-ID is available for reuse and may be provisioned or assigned to another device.

If the member physically exists, its configuration will be erased. It will then be powered down by default.

Syntax
vsf member <MEMBER-ID> remove
Description

Erase the VSF virtual chassis member configuration.

Parameters
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<MEMBER-ID>

The VSF member-ID for the member command/ or parameter. Member ID value can be in the range of 1 to 8.

Restriction

Remove will not be available until VSF is enabled.

vsf member remove reboot

Syntax
vsf member <MEMBER-ID> remove reboot

Description

Removes the entire configuration for a specified member and reboots it. If the member physically exists, its
configuration will be erased. If the VSF link is still present, the member reboots and joins the stack through
automatic configuration.

Command context
config

Parameters
<MEMBER-ID>

The VSF member-ID for the member command/ or parameter. Member ID value can be in the range of 1 to 8.

Example

switch# config
switch(config)# vsf member 2 remove
reboot          Reboot the specified stack member.
switch(config)# vsf member 2 remove reboot

vsf member priority
Syntax
vsf member <MEMBER-ID> priority <PRIORITY>
Description

Assign a priority to the specified VSF virtual chassis member. The higher the priority, the more likely that the
virtual chassis member will become the commander at the next virtual chassis reboot. The default priority value is
128.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range of 1 to 8.

<PRIORITY>

The priority value for VSF member. Priority value can be in the range of 1 to 255.

vsf member type
This CLI command provisions a switch with the member ID and the type defined by the specified J-number for the
device. After provisioning the member, the user may perform any configuration on the device ports.

A “strict” provisioning specifies a MAC address and allows for only one device with the matching J-number and
MAC to be configured.
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A “loose” provisioning allows the device with the specified J-number to be configured without a MAC address
being specified. This allows any device which matches the J-number to adopt this configuration.

If a provisioned configuration exists with the member ID, the following command is used to change the
provisioning from “strict” and “loose” and vice versa. It is recommended to configure the member VSF links, in
case of “strict” and “loose” provisioning. A warning is also displayed while configuring.

switch(config)# vsf member 8 type jl264a mac-address e0071b-c6d180
This will save the current configuration. Continue (y/n)?  y

Warning - The link and port should be provisioned for member 8 to 
join the VSF stack.

switch(config)# vsf member 8 type jl264a                          
This will save the current configuration. Continue (y/n)?  y

Warning - The link and port should be provisioned for member 8 to 
join the VSF stack.

switch(config)# 
Syntax
vsf member <MEMBER-ID> type <TYPE> [mac <MAC-ADDR>]
Description

Configure the family of the VSF member-switch being provisioned. After provisioning, the VSF member-switch
can be configured as if it were physically present. When a VSF member-switch matching the provisioned details
joins the VSF, it is provided this configuration. A new or missing VSF member can be configured as a provisioned
device by using this command.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command/parameter. Member ID value can be in the range of 1 to 8.

<TYPE>

Configure the family of the VSF member-switch being provisioned.

<MAC-ADDR>

Configure the MAC address of the VSF member switch being provisioned.

Restrictions

• If switch “N” physically exists, the command will fail.

• If switch “N” is provisioned, the command can be used to change the MAC or type.

• If the J-Number is known to not support stacking, or the J-Number is unknown, the command will fail.

• If the same MAC address is already provisioned or exists on another member ID, the command will fail.

Usage

vsf member <2> type <J9850A> mac <001122-334455>
Updates the strict provisioning for VSF VC member 2, and changes the MAC address to 001122-334455.

vsf member <2> type <J9850A>
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Changes the “strict” provisioning for VSF VC member 2 to “loose” provisioning. The configured MAC address is
then removed.

vsf member <2> type <J9850A> mac <00aabb-cceedd>
Changes “loose” provisioning for VSF VC member 2 to “strict” provisioning with MAC address 00aabb-cceedd.

snmp-server enable traps vsf
Syntax
[no] snmp-server enable traps vsf
Description

Enable traps for the VSF functionality.

vsf port-speed
Syntax
vsf port speed <SPEED>
Description

Configure the port speed for all VSF ports. Ports that do not support the configured speed can be part of the VSF,
but will not be operational. By default, the speed for the VSF is automatically set to the maximum speed of the
first link port added. The port speed cannot be set to default if there are ports in the link. Changing the link speed
of the VSF ports will trigger a reboot if the entire stack.

Parameters
<SPEED>

The allowed values for port speeds are 1g and 10g.

Usage
[no] vsf port speed <SPEED>
The no form of the command cannot be executed if there are ports configured on the link. All the ports in the link
have to be unconfigured before setting the speed to default.

Example input

Switch(config)# vsf port-speed
 1g                    Specify the VSF ports to auto-negotiate at 1 Gbps.
 10g                   Specify the VSF ports to auto-negotiate at 10 Gbps.

vsf vlan-mad
Syntax
vsf vlan-mad <VLAN-ID>
Description

Configure the VSF Multi-Active Detection (MAD) VLAN. The MAD VLAN is used for stack fragment discovery
when there is a stack split. Only one MAD VLAN can be configured.

Parameters

<VLAN-ID>

VLAN identifier or the VLAN name if configured. Vlan ID value can be in the range of 1 to 4096.

Usage
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[no] vsf vlan-mad <VLAN-ID>

vsf lldp-mad ipv4
Syntax
[no] vsf lldp-mad ipv4 <IPV4_ADDR> v2c <COMMUNITY-STR>
Description

Enable LLDP-MAD on the VSF device.

NOTE: The command vsf lldp mad requires a peer switch to be configured as the “assist”
device. LLDP-MAD is applicable only for a two-member VSF stack.

Parameters

<IPV4_ADDR>

The IPv4 address of the MAD (Multi-Active Detection) device.

<COMMUNITY-STR>

The SNMP community string for the MAD (Multi-Active Detection) device.

Usage
Switch(config)# vsf lldp-mad ipv4
Switch(config)# vsf lldp-mad ipv4 <IPv4_ADDR>
Switch(config)# vsf lldp-mad ipv4 <MAD-IP-ADDRESS> v2c
Switch(config)# vsf lldp-mad ipv4 210.10.0.12 v2c <COMMUNITY-STR>

Show commands

show vsf
Syntax
show vsf
Description

Shows the list of VSF virtual chassis members that are provisioned.

Restrictions

show vsf can be run only after VSF is enabled.

Example output

switch# show vsf

 VSF Domain ID    : 123
 MAC Address      : 941882-435589
 VSF Topology     : Ring
 VSF Status       : Active
 Uptime           : 26d 20h 36m
 VSF MAD          : None
 VSF Port Speed   : 10G
 Software Version : WC.16.06.0000x

 Mbr
 ID  MAC Address       Model                                 Pri Status
 --- ----------------- ------------------------------------- --- ---------------
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  1  f40343-0796b0     Aruba JL258A 2930F-8G-PoE+-2SFP+ S... 128 Member
 *2  941882-435580     Aruba JL254A 2930F-48G-4SFP+ Switch   128 Member
  3  b05ada-9771c0     Aruba JL256A 2930F-48G-PoE+-4SFP+ ... 128 Standby
  4  b05ada-963120     Aruba JL255A 2930F-24G-PoE+-4SFP+ ... 128 Member
  5  9cdc71-393440     Aruba JL256A 2930F-48G-PoE+-4SFP+ ... 128 Member
  6  b05ada-962180     Aruba JL253A 2930F-24G-4SFP+ Switch   128 Member
  7  b05ada-9631e0     Aruba JL255A 2930F-24G-PoE+-4SFP+ ... 128 Commander
  8  b05ada-96f000     Aruba JL253A 2930F-24G-4SFP+ Switch   128 Member
The preceding example shows:

• Topology is ring.

• Member 7 is Commander

• Member 3 is Standby

• Member 1, 2, 4, 5, 6, and 8 are Members

show vsf detail

Syntax
show vsf detail

Description

This commands shows detailed information related to the current state of the VSF virtual chassis.

Example output

switch# show vsf detail 

 VSF Domain ID    : 500                                               
 MAC Address      : ecebb8-d0c905    
 VSF Topology     : Ring                                    
 VSF Status       : Active                                  
 Uptime           : 1d 8h 25m   
 VSF MAD          : VLAN                                    
 VSF Port Speed   : 10G                                     
 Software Version : WC.16.06.0000x

Name             : Aruba-VSF-2930F
Contact          : 
Location         : 

Member ID        : 1 
MAC Address      : ecebb8-d0c900    
Type             : JL558A
Model            : Aruba JL558A 2930F-48G-740W-PoE+-4SFP+ Switch               
Priority         : 250
Status           : Commander      
ROM Version      : WC.16.01.0004                                     
Serial Number    : CN82K91074                                                   
Uptime           : 1d 8h 25m   
CPU Utilization  : 0%  
Memory - Total   : 343,130,624 bytes 
Free             : 221,141,152 bytes 
VSF Links - 
#1 : Active, Peer member 2              
#2 : Active, Peer member 8
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Member ID        : 2 
MAC Address      : 9cdc71-371d20    
Type             : JL253A
Model            : Aruba JL253A 2930F-24G-4SFP+ Switch                         
Priority         : 128
Status           : Member         
ROM Version      : WC.16.01.0006                                     
Serial Number    : CN71HKT0BQ                                                   
Uptime           : 0d 17h 26m  
CPU Utilization  : 0%  
Memory - Total   : 343,130,624 bytes 
Free             : 253,175,276 bytes 
VSF Links - 
#1 : Active, Peer member 3              
#2 : Active, Peer member 1

Member ID        : 3 
MAC Address      : ecebb8-d0bb00    
Type             : JL558A
Model            : Aruba JL558A 2930F-48G-740W-PoE+-4SFP+ Switch               
Priority         : 128
Status           : Member         
ROM Version      : WC.16.01.0006                                     
Serial Number    : CN82K910C3                                                   
Uptime           : 0d 17h 19m  
CPU Utilization  : 0%  
Memory - Total   : 343,130,624 bytes 
Free             : 253,035,252 bytes 
VSF Links - 
#1 : Active, Peer member 2              
#2 : Active, Peer member 4

Member ID        : 4 
MAC Address      : b05ada-974800    
Type             : JL254A
Model            : Aruba JL254A 2930F-48G-4SFP+ Switch                         
Priority         : 128
Status           : Member         
ROM Version      : WC.16.01.0006                                     
Serial Number    : CN65HKV02Y                                                   
Uptime           : 0d 17h 12m  
CPU Utilization  : 0%  
Memory - Total   : 343,130,624 bytes 
Free             : 253,175,244 bytes 
VSF Links - 
#1 : Active, Peer member 3              
#2 : Active, Peer member 5

Member ID        : 5 
MAC Address      : b05ada-962200    
Type             : JL255A
Model            : Aruba JL255A 2930F-24G-PoE+-4SFP+ Switch                    
Priority         : 128
Status           : Member         
ROM Version      : WC.16.01.0004                                     
Serial Number    : CN6ZHKW005                                                   
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Uptime           : 0d 17h 6m   
CPU Utilization  : 0%  
Memory - Total   : 343,130,624 bytes 
Free             : 253,160,108 bytes 
VSF Links - 
#1 : Active, Peer member 4              
#2 : Active, Peer member 6

Member ID        : 6 
MAC Address      : 941882-42d320    
Type             : JL255A
Model            : Aruba JL255A 2930F-24G-PoE+-4SFP+ Switch                    
Priority         : 128
Status           : Standby        
ROM Version      : WC.16.01.0004                                     
Serial Number    : CN69HKW0ZC                                                   
Uptime           : 0d 17h 45m  
CPU Utilization  : 0%  
Memory - Total   : 343,130,624 bytes 
Free             : 240,018,564 bytes 
VSF Links - 
#1 : Active, Peer member 5              
#2 : Active, Peer member 7

Member ID        : 7 
MAC Address      : b05ada-975440    
Type             : JL256A
Model            : Aruba JL256A 2930F-48G-PoE+-4SFP+ Switch                    
Priority         : 128
Status           : Member         
ROM Version      : WC.16.01.0004                                     
Serial Number    : CN6ZHKX063                                                   
Uptime           : 1d 8h 9m    
CPU Utilization  : 0%  
Memory - Total   : 343,130,624 bytes 
VSF Links - 
#1 : Active, Peer member 8              
#2 : Active, Peer member 6

Member ID        : 8 
MAC Address      : e0071b-c6d180    
Type             : JL264A
Model            : Aruba JL264A 2930F-48G-PoE+-4SFP+-TAA Switch                
Priority         : 128
Status           : Member         
ROM Version      : WC.16.01.0004                                     
Serial Number    : CN66HL501D                                                   
Uptime           : 0d 16h 59m  
CPU Utilization  : 0%  
Memory - Total   : 343,130,624 bytes 
Free             : 253,174,992 bytes 
VSF Links - 
#1 : Active, Peer member 7              
#2 : Active, Peer member 1
The above example shows:
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• Member 1 Link 1 is connected to Member 2 Link 1.

• Member 2 Link 2 is connected to Member 3 Link 1.

• Member 3 Link 2 is connected to Member 4 Link 1.

• Member 4 Link 2 is connected to Member 5 Link 1.

• Member 5 Link 2 is connected to Member 6 Link 1.

• Member 6 Link 2 is connected to Member 8 Link 2.

• Member 7 Link 2 is connected to Member 8 Link 1.

• Member 8 Link 1 is connected to Member 7 Link 2.

show vsf link
Syntax
show vsf link
Description

Shows the VSF port state of the VSF links for each VSF member.

Example output

switch# show vsf link

 VSF Member 1

                  Link     Peer   Peer
 Link Link-Name   State    Member Link
 ---- ---------- -------- ------ ---- 
 1    I-Link1_1   Up       2      1   
 2    I-Link1_2   Down     0      0   

 VSF Member 2

                  Link     Peer   Peer
 Link Link-Name   State    Member Link
 ---- ---------- -------- ------ ---- 
 1    I-Link2_1   Up       1      1   
 2    I-Link2_2   Up       3      1   

 VSF Member 3

                  Link     Peer   Peer
 Link Link-Name   State    Member Link
 ---- ---------- -------- ------ ---- 
 1    I-Link3_1   Up       2      2   
 2    I-Link3_2   Up       4      1   

 VSF Member 4

                  Link     Peer   Peer
 Link Link-Name   State    Member Link
 ---- ---------- -------- ------ ---- 
 1    I-Link4_1   Up       3      2   
 2    I-Link4_2   Up       5      1   
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 VSF Member 5

                  Link     Peer   Peer
 Link Link-Name   State    Member Link
 ---- ---------- -------- ------ ---- 
 1    I-Link5_1   Up       4      2   
 2    I-Link5_2   Up       6      1   

 VSF Member 6

                  Link     Peer   Peer
 Link Link-Name   State    Member Link
 ---- ---------- -------- ------ ----
 1    I-Link6_1   Up       5      2
 2    I-Link6_2   Up       8      2

 VSF Member 7

                  Link     Peer   Peer
 Link Link-Name   State    Member Link
 ---- ---------- -------- ------ ----
 1    I-Link7_1   Down     0      0
 2    I-Link7_2   Up       8      1

 VSF Member 8

                  Link     Peer   Peer
 Link Link-Name   State    Member Link
 ---- ---------- -------- ------ ----
 1    I-Link8_1   Up       7      2
 2    I-Link8_2   Up       6      2

NOTE: 

A VSF port speed which does not match with the global port speed, will be in a down state. The
command show vsf link detail will display an error message.

show vsf link detail

Syntax
show vsf link detail

Description

Displays a detailed output of VSF port state and links for each VSF member.

Example output

switch# show vsf link detail

 VSF Member: 1     Link: 1

 Port     State                                                             
 -------- ------------                                                      
 1/9      Up: Connected to port 2/49                                        
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 VSF Member: 2     Link: 1

 Port     State                                                             
 -------- ------------                                                      
 2/49     Up: Connected to port 1/9                                         

 VSF Member: 2     Link: 2

 Port     State                                                             
 -------- ------------                                                      
 2/51     Up: Connected to port 3/51                                        

 VSF Member: 3     Link: 1

 Port     State                                                             
 -------- ------------                                                      
 3/51     Up: Connected to port 2/51                                        

 VSF Member: 3     Link: 2

 Port     State                                                             
 -------- ------------                                                      
 3/49     Up: Connected to port 4/25                                        

 VSF Member: 4     Link: 1

 Port     State                                                             
 -------- ------------                                                      
 4/25     Up: Connected to port 3/49                                        

 VSF Member: 4     Link: 2

 Port     State                                                             
 -------- ------------                                                      
 4/27     Up: Connected to port 5/51                                        

 VSF Member: 5     Link: 1

 Port     State                                                             
 -------- ------------                                                      
 5/51     Up: Connected to port 4/27                                        

 VSF Member: 5     Link: 2

 Port     State                                                             
 -------- ------------                                                      
 5/49     Up: Connected to port 6/25                                        

 VSF Member: 6     Link: 1

 Port     State                                                             
 -------- ------------                                                      
 6/25     Up: Connected to port 5/49                                        

668 Aruba 2930F / 2930M Management and Configuration Guide
for ArubaOS-Switch 16.08

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 7265



 VSF Member: 6     Link: 2

 Port     State                                                             
 -------- ------------                                                      
 6/27     Up: Connected to port 8/27                                        

 VSF Member: 7     Link: 2

 Port     State
 -------- ------------
 7/25     Up: Connected to port 8/25

 VSF Member: 8     Link: 1

 Port     State
 -------- ------------
 8/25     Up: Connected to port 7/25

 VSF Member: 8     Link: 2

 Port     State
 -------- ------------
 8/27     Up: Connected to port 6/27

show vsf member
Syntax

show vsf member <MEMBER ID>
Parameters

<MEMBER ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range of 1 to 8.

Example output

switch# show vsf member 1

Member ID        : 1
MAC Address      : f40343-f83680
Type             : JL256A
Model            : Aruba JL256A 2930F-48G-PoE+-4SFP+ Switch
Priority         : 255
Status           : Member
ROM Version      : WC.16.01.0004
Serial Number    : CN76HKX16H
Uptime           : 36d 20h 5m
CPU Utilization  : 0%
Memory - Total   : 343,482,880 bytes
Free             : 253,575,488 bytes
VSF Links -
#1 : Active, Peer member 2
#2 : Active, Peer member 8

switch# show vsf member 2

Member ID        : 2
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MAC Address      : 98f2b3-bc4700
Type             : JL254A
Model            : Aruba JL254A 2930F-48G-4SFP+ Switch
Priority         : 255
Status           : Commander
ROM Version      : WC.16.01.0004
Serial Number    : CN77HKV09F
Uptime           : 36d 20h 5m
CPU Utilization  : 24%
Memory - Total   : 343,482,880 bytes
Free             : 224,031,528 bytes
VSF Links -
#1 : Active, Peer member 1
#2 : Active, Peer member 3

switch# show vsf member 3

Member ID        : 3
MAC Address      : f40343-6bff80
Type             : JL255A
Model            : Aruba JL255A 2930F-24G-PoE+-4SFP+ Switch
Priority         : 255
Status           : Member
ROM Version      : WC.16.01.0004
Serial Number    : CN77HKW0FM
Uptime           : 36d 20h 5m
CPU Utilization  : 0%
Memory - Total   : 343,482,880 bytes
Free             : 253,575,664 bytes
VSF Links -
#1 : Active, Peer member 2
#2 : Active, Peer member 4

switch# show vsf member 4

Member ID        : 4
MAC Address      : 98f2b3-bc75c0
Type             : JL254A
Model            : Aruba JL254A 2930F-48G-4SFP+ Switch
Priority         : 255
Status           : Member
ROM Version      : WC.16.01.0004
Serial Number    : CN77HKV06B
Uptime           : 36d 20h 5m
CPU Utilization  : 0%
Memory - Total   : 343,482,880 bytes
Free             : 253,575,816 bytes
VSF Links -
#1 : Active, Peer member 3
#2 : Active, Peer member 5

switch# show vsf member 5

Member ID        : 5
MAC Address      : 9cdc71-378c00
Type             : JL253A
Model            : Aruba JL253A 2930F-24G-4SFP+ Switch
Priority         : 255
Status           : Member
ROM Version      : WC.16.01.0004
Serial Number    : CN71HKT0BD
Uptime           : 36d 20h 5m
CPU Utilization  : 0%
Memory - Total   : 343,482,880 bytes
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Free             : 253,575,816 bytes
VSF Links -
#1 : Active, Peer member 4
#2 : Active, Peer member 6

switch# show vsf member 6

Member ID        : 6
MAC Address      : 941882-429800
Type             : JL258A
Model            : Aruba JL258A 2930F-8G-PoE+-2SFP+ Switch
Priority         : 255
Status           : Standby
ROM Version      : WC.16.01.0004
Serial Number    : CN69HL00F4
Uptime           : 36d 20h 5m
CPU Utilization  : 0%
Memory - Total   : 343,482,880 bytes
Free             : 240,710,660 bytes
VSF Links -
#1 : Active, Peer member 5
#2 : Active, Peer member 7

switch# show vsf member 7

Member ID        : 7
MAC Address      : b05ada-960400
Type             : JL253A
Model            : Aruba JL253A 2930F-24G-4SFP+ Switch
Priority         : 128
Status           : Member
ROM Version      : WC.16.01.0004
Serial Number    : CN65HKT03X
Uptime           : 36d 20h 6m
CPU Utilization  : 0%
Memory - Total   : 343,482,880 bytes
Free             : 253,575,844 bytes
VSF Links -
#1 : Active, Peer member 6
#2 : Active, Peer member 8

switch# show vsf member 8

Member ID        : 8
MAC Address      : b05ada-96d620
Type             : JL255A
Model            : Aruba JL255A 2930F-24G-PoE+-4SFP+ Switch
Priority         : 128
Status           : Member
ROM Version      : WC.16.01.0004
Serial Number    : CN65HKW03D
Uptime           : 36d 20h 6m
CPU Utilization  : 0%
Memory - Total   : 343,482,880 bytes
Free             : 253,575,660 bytes
VSF Links -
#1 : Active, Peer member 1
#2 : Active, Peer member 7

show vsf topology
Syntax
show vsf topology
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Description

This command shows information about VSF virtual chassis member connections.

Example output

switch# show vsf topology

 VSF member's interconnection with links:

                   Stby                                         Cmdr
 +---+    +---+    +---+    +---+    +---+    +---+    +---+    +---+
 | 1 |1==1| 2 |2==1| 3 |2==1| 4 |2==1| 5 |2==1| 6 |2==2| 8 |1==2| 7 |
 +---+    +---+    +---+    +---+    +---+    +---+    +---+    +---+
The preceding example shows:

• Member ID 1 Link 1 is connected to Member ID 2 Link 1.

• Member ID 2 Link 2 is connected to Member ID 3 Link 1.

• Member ID 3 Link 2 is connected to Member ID 4 Link 1.

• Member ID 4 Link 2 is connected to Member ID 5 Link 1.

• Member ID 5 Link 2 is connected to Member ID 6 Link 1.

• Member ID 6 Link 2 is connected to Member ID 8 Link 2.

• Member ID 8 Link 1 is connected to Member ID 7 Link 2.

• Member ID 3 is current VSF standby.

• Member ID 7 is current VSF commander.

NOTE: Set the terminal width to 100 for a better alignment of the topology diagram. Default width:
80.

show vsf topology detail
Syntax
show vsf topology detail
Description

This command displays forwarding path information (unidestination and multidestination flood path information).
The unidestination forwarding takes the shortest path in terms of hop counts to reach destination member. The
command output provides the egress VSF link used to send traffic along the shortest path computed. The
multidestination path provides the complete flood path taken along the VSF stack for the multidestination traffic
ingressing VSF stack or sourced at any VSF member.

Example output

switch# show vsf topology detail

 Uni-destination Link Path: 

 VSF Member ID  1    2    3    4    5    6    7    8   
 ------------- ---- ---- ---- ---- ---- ---- ---- ----
 1              -    1    1    1    1    1    1    1
 2              1    -    2    2    2    2    2    2
 3              1    1    -    2    2    2    2    2
 4              1    1    1    -    2    2    2    2
 5              1    1    1    1    -    2    2    2
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 6              1    1    1    1    1    -    2    2
 7              2    2    2    2    2    2    -    2
 8              2    2    2    2    2    2    1    -
In the preceding example, the unidestination traffic from Member ID 1 to Member ID 8 egresses through VSF link
1. Member ID 2 to Member ID 8 egresses through VSF link 2. Member ID 3 to Member ID 8 egresses through
VSF link 3, and so on.

 Multi-destination Path:

 VSF Member ID   Path
 -------------  ------
 1               2-3-4-5-6-8-7
 2               1, 3-4-5-6-8-7
 3               2-1, 4-5-6-8-7
 4               3-2-1, 5-6-8-7
 5               4-3-2-1, 6-8-7
 6               5-4-3-2-1, 8-7
 7               8-6-5-4-3-2-1
 8               7, 6-5-4-3-2-1
In the preceding example, the multidestination traffic:

• ingressing at Member ID 1 will be relayed to Member ID 2, Member ID 2 will further relay to Member ID 3,
Member ID 3 will further relay to Member ID 4, Member ID 4 to Member ID 5, Member ID 5 to Member ID 6,
Member ID 6 to Member ID 8, and Member ID 8 to Member ID 7, which will not relay further. All the receiving
Members will consume multidestination traffic before relaying further.

• ingressing or sourced at Member 2 will take two forwarding paths:
◦ Relay to Member ID 1. Member ID 1 will consume and not relay further.

◦ Relay to Member ID 3 which will further relay to Member ID 4, Member ID 4 to Member ID 5, Member ID 5
to Member ID 6, Member ID 6 to Member ID 8, and Member ID 8 to Member ID 7, which will not relay
further

show vsf topology change-history
Syntax
show vsf topology <change-history>
Description

This command is used to display last 16 topology changes which occurred in the VSF stack and all topology
transitions which occurred in recent history, along with details on which specific VSF member or link pair
witnessed the state transitions.

Parameters
<change-history>

Show VSF stack topology changes.

Example output

Switch# show vsf topology change-history 
 Thu Apr  21 00:06:10 2017 : The link between Member 4, Link 2 and Member 3,
 Link 2 went UP 

 Thu Apr  21 00:06:10 2017 : The link between Member 3, Link 2 and Member 4,
 Link 2 went UP 

 Thu Apr  21 00:06:09 2017 : The link between Member 3, Link 1 and Member 2,
 Link 1 went UP 
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 Thu Apr  21 00:06:09 2017 : The link between Member 2, Link 1 and Member 3,
 Link 1 went UP 

 Thu Apr  21 00:04:07 2017 : The link between Member 2, Link 2 and Member 1,
 Link 2 went UP 

 Thu Apr  21 00:04:07 2017 : The link between Member 1, Link 2 and Member 2,
 Link 2 went UP 

show vsf lldp-mad
Syntax
show vsf lldp-mad {parameters|status}
Description

Display the VSF LLDP MAD (Multi-Active Detection) information.

Parameters

parameters

Displays the MAD-assist configuration as well as the readiness state.

status

Displays the current state of the MAD probe.

Example output

Switch# show vsf lldp-mad parameters

MAD device IP                : 134.1.5.29
    MAD readiness status     : Success | Failure [21:49:45, 9/Jan/2015]
        MAD device MAC       : 08:12:2b:40:44:3a
        Reachable via Vlan   : 10
        Local LAG interface  : TRK5
        MAD-probe portset    : 1, 7, 23
     LAG connectivity        : Full | Partial

Switch# show vsf lldp-mad status
MAD device IP                : 134.1.5.29
    MAD probe portset        : 1, 7, 23

    VSF split                            : Yes | No
    MAD probe originator                 : Yes | No 
    Number of probe requests sent        : 3
    Number of probe responses received   : 0
    MAD Active Fragment                  : Yes | No

show vsf vlan-mad
Syntax
show vsf vlan-mad
Description

Shows information for the VSF Multi-Active Detection (MAD) VLAN.

VLAN MAD Connectivity status:

full

All member VLAN MAD ports are connected to the MAD interconnect device.
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partial

Atleast one member VLAN MAD port is connected to the MAD interconnect device.

none

None of the member VLAN MAD ports are connected to the MAD interconnect device.

Example output

switch# show vsf vlan-mad

Multi-Active Detection VLAN status :

  VLAN ID                      : 200
  VLAN NAME                    : VLAN200
  VLAN MAD Connectivity Status : Full

  Port   Status   Member State
  -----  -------  ---------------
  1/8    Up       Standby
  2/8    Up       Member
  3/8    Up       Member
  4/8    Up       Member
  5/8    Up       Commander
  6/8    Up       Member
  7/8    Up       Member
  8/8    Up       Member
If a MAD VLAN is not configured:

Switch(config)# show vsf vlan-mad
MAD VLAN is not configured
Switch(config)#

show vsf trunk-designated-forwarder
Syntax
show vsf trunk-designated-forwarder member <MEMBER-ID>
Description

Show the designated forwarders for each trunk.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range of 1 to 8.

Example

Switch# show vsf trunk-designated-forwarder member 1

Trunk Designated Forwarders

  NAME  TYPE  Forwarding Member (Flood) Forwarding Member (Unicast)
  ----- ----- ------------------------- ---------------------------
  Trk1  TRK   2                         1, 2
  Trk2  TRK   3                         3, 4

show cpu
Syntax
show cpu <SECONDS>
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Description

Show average CPU utilization.

Usage
show cpu slot <SLOT-LIST> [<SECONDS>]
show cpu process [slot <SLOT-LIST>] [refresh <COUNT>]
Example output

switch(config)# show cpu slot all

VSF slot 1/a:
-------------
42 percent busy, from 300 sec ago
1 sec ave: 37 percent busy
5 sec ave: 36 percent busy
1 min ave: 49 percent busy

VSF slot 2/a:
-------------
1 percent busy, from 300 sec ago
1 sec ave: 2 percent busy
5 sec ave: 1 percent busy
1 min ave: 2 percent busy

VSF slot 3/a:
-------------
1 percent busy, from 300 sec ago
1 sec ave: 1 percent busy
5 sec ave: 1 percent busy
1 min ave: 1 percent busy

VSF slot 4/a:
-------------
0 percent busy, from 300 sec ago
1 sec ave: 1 percent busy
5 sec ave: 1 percent busy
1 min ave: 1 percent busy

VSF slot 5/a:
-------------
0 percent busy, from 300 sec ago
1 sec ave: 1 percent busy
5 sec ave: 1 percent busy
1 min ave: 1 percent busy

VSF slot 6/a:
-------------
1 percent busy, from 300 sec ago
1 sec ave: 1 percent busy
5 sec ave: 1 percent busy
1 min ave: 1 percent busy

VSF slot 7/a:
-------------
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0 percent busy, from 300 sec ago
1 sec ave: 1 percent busy
5 sec ave: 1 percent busy
1 min ave: 1 percent busy

VSF slot 8/a:
-------------
0 percent busy, from 300 sec ago
1 sec ave: 2 percent busy
5 sec ave: 1 percent busy
1 min ave: 1 percent busy

show power-over-ethernet
Syntax
show power-over-ethernet vsf member <MEMBER-ID>
Description

Show PoE information of specified VSF member.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range of 1 to 8.

Example

For show power-over-ethernet vsf member 4:

Switch# show power-over-ethernet vsf member 4

 Status and Counters - System Power Status for member 4

 Maximum Power       : 370 W           Operational Status  : On
 Power In Use        : 0 W +/- 6 W     Usage Threshold (%) : 80

show system information
Syntax
show system information [vsf member <MEMBER-ID>]
Description

Show global configured and operational system parameters. If VSF is enabled, this shows the system information
for all VSF members.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
8.

Example

switch(config)# show system information
 vsf                   Show global configured and operational system parameters
                       of the specified VSF members.
 
switch(config)# show system information

 Status and Counters - General System Information
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  System Name        : Aruba-VSF-2930F
  System Contact     :
  System Location    :
  MAC Age Time (sec) : 300
  Time Zone          : 0
  Daylight Time Rule : None

  Software revision  : WC.16.06.0000x
  Base MAC Addr      : f40343-f8368a

 VSF-Member :1

  ROM Version        : WC.16.01.0004
  Up Time            : 35 days
  CPU Util (%)       : 0
  MAC Addr           : f40343-f83680
  Serial Number      : CN76HKX16H
  Memory   - Total   : 343,482,880
             Free    : 253,575,488

 VSF-Member :2

  ROM Version        : WC.16.01.0004
  Up Time            : 35 days
  CPU Util (%)       : 35
  MAC Addr           : 98f2b3-bc4700
  Serial Number      : CN77HKV09F
  Memory   - Total   : 343,482,880
             Free    : 224,025,392

 VSF-Member :3

  ROM Version        : WC.16.01.0004
  Up Time            : 35 days
  CPU Util (%)       : 2
  MAC Addr           : f40343-6bff80
  Serial Number      : CN77HKW0FM
  Memory   - Total   : 343,482,880
             Free    : 253,575,664

 VSF-Member :4

  ROM Version        : WC.16.01.0004
  Up Time            : 35 days
  CPU Util (%)       : 0
  MAC Addr           : 98f2b3-bc75c0
  Serial Number      : CN77HKV06B
  Memory   - Total   : 343,482,880
             Free    : 253,575,816

 VSF-Member :5

  ROM Version        : WC.16.01.0004
  Up Time            : 35 days
  CPU Util (%)       : 0
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  MAC Addr           : 9cdc71-378c00
  Serial Number      : CN71HKT0BD
  Memory   - Total   : 343,482,880
             Free    : 253,575,816

 VSF-Member :6

  ROM Version        : WC.16.01.0004
  Up Time            : 35 days
  CPU Util (%)       : 0
  MAC Addr           : 941882-429800
  Serial Number      : CN69HL00F4
  Memory   - Total   : 343,482,880
             Free    : 240,710,660

 VSF-Member :7

  ROM Version        : WC.16.01.0004
  Up Time            : 35 days
  CPU Util (%)       : 0
  MAC Addr           : b05ada-960400
  Serial Number      : CN65HKT03X
  Memory   - Total   : 343,482,880
             Free    : 253,575,844

 VSF-Member :8

  ROM Version        : WC.16.01.0004
  Up Time            : 35 days
  CPU Util (%)       : 0
  MAC Addr           : b05ada-96d620
  Serial Number      : CN65HKW03D
  Memory   - Total   : 343,482,880
             Free    : 253,575,660

show system information vsf member
Syntax
show system information vsf member <MEMBER-ID>
Description

Show global configured and operational system parameters of the specified VSF members.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range of 1 to 8.

Example output

switch# show system information vsf member 1

Status and Counters - General System Information

  System Name        : Aruba-VSF-2930F
  System Contact     :
  System Location    :
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  MAC Age Time (sec) : 300
  Time Zone          : 0
  Daylight Time Rule : None

  Software revision  : WC.16.06.0000x
  Base MAC Addr      : f40343-f8368a

VSF-Member :1

  ROM Version        : WC.16.01.0004
  Up Time            : 36 days
  CPU Util (%)       : 0
  MAC Addr           : f40343-f83680
  Serial Number      : CN76HKX16H
  Memory   - Total   : 343,482,880
             Free    : 253,575,488

switch# show system information vsf member 2

Status and Counters - General System Information

  System Name        : Aruba-VSF-2930F
  System Contact     :
  System Location    :
  MAC Age Time (sec) : 300
  Time Zone          : 0
  Daylight Time Rule : None

  Software revision  : WC.16.06.0000x
  Base MAC Addr      : f40343-f8368a

VSF-Member :2

  ROM Version        : WC.16.01.0004
  Up Time            : 36 days
  CPU Util (%)       : 10
  MAC Addr           : 98f2b3-bc4700
  Serial Number      : CN77HKV09F
  Memory   - Total   : 343,482,880
             Free    : 224,022,468

switch# show system information vsf member 3

Status and Counters - General System Information

  System Name        : Aruba-VSF-2930F
  System Contact     :
  System Location    :
  MAC Age Time (sec) : 300
  Time Zone          : 0
  Daylight Time Rule : None

  Software revision  : WC.16.06.0000x
  Base MAC Addr      : f40343-f8368a

VSF-Member :3

  ROM Version        : WC.16.01.0004

680 Aruba 2930F / 2930M Management and Configuration Guide
for ArubaOS-Switch 16.08

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 7277



  Up Time            : 36 days
  CPU Util (%)       : 0
  MAC Addr           : f40343-6bff80
  Serial Number      : CN77HKW0FM
  Memory   - Total   : 343,482,880
             Free    : 253,575,664

switch# show system information vsf member 4

Status and Counters - General System Information

  System Name        : Aruba-VSF-2930F
  System Contact     :
  System Location    :
  MAC Age Time (sec) : 300
  Time Zone          : 0
  Daylight Time Rule : None

  Software revision  : WC.16.06.0000x
  Base MAC Addr      : f40343-f8368a

VSF-Member :4

  ROM Version        : WC.16.01.0004
  Up Time            : 36 days
  CPU Util (%)       : 0
  MAC Addr           : 98f2b3-bc75c0
  Serial Number      : CN77HKV06B
  Memory   - Total   : 343,482,880
             Free    : 253,575,816

switch# show system information vsf member 5

Status and Counters - General System Information

  System Name        : Aruba-VSF-2930F
  System Contact     :
  System Location    :
  MAC Age Time (sec) : 300
  Time Zone          : 0
  Daylight Time Rule : None

  Software revision  : WC.16.06.0000x
  Base MAC Addr      : f40343-f8368a

VSF-Member :5

  ROM Version        : WC.16.01.0004
  Up Time            : 36 days
  CPU Util (%)       : 0
  MAC Addr           : 9cdc71-378c00
  Serial Number      : CN71HKT0BD
  Memory   - Total   : 343,482,880
             Free    : 253,575,816

switch# show system information vsf member 6

Status and Counters - General System Information

  System Name        : Aruba-VSF-2930F
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  System Contact     :
  System Location    :
  MAC Age Time (sec) : 300
  Time Zone          : 0
  Daylight Time Rule : None

  Software revision  : WC.16.06.0000x
  Base MAC Addr      : f40343-f8368a

VSF-Member :6

  ROM Version        : WC.16.01.0004
  Up Time            : 36 days
  CPU Util (%)       : 0
  MAC Addr           : 941882-429800
  Serial Number      : CN69HL00F4
  Memory   - Total   : 343,482,880
             Free    : 240,710,660

switch# show system information vsf member 7

Status and Counters - General System Information

  System Name        : Aruba-VSF-2930F
  System Contact     :
  System Location    :
  MAC Age Time (sec) : 300
  Time Zone          : 0
  Daylight Time Rule : None

  Software revision  : WC.16.06.0000x
  Base MAC Addr      : f40343-f8368a

VSF-Member :7

  ROM Version        : WC.16.01.0004
  Up Time            : 36 days
  CPU Util (%)       : 0
  MAC Addr           : b05ada-960400
  Serial Number      : CN65HKT03X
  Memory   - Total   : 343,482,880
             Free    : 253,575,844

switch# show system information vsf member 8

Status and Counters - General System Information

  System Name        : Aruba-VSF-2930F
  System Contact     :
  System Location    :
  MAC Age Time (sec) : 300
  Time Zone          : 0
  Daylight Time Rule : None

  Software revision  : WC.16.06.0000x
  Base MAC Addr      : f40343-f8368a

VSF-Member :8
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  ROM Version        : WC.16.01.0004
  Up Time            : 36 days
  CPU Util (%)       : 0
  MAC Addr           : b05ada-96d620
  Serial Number      : CN65HKW03D
  Memory   - Total   : 343,482,880
             Free    : 253,575,660

show system fans
Syntax
show system fans [vsf member <MEMBER-ID>]
Description

Show system fan status. If VSF is enabled, this shows the system fan status for all VSF members.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command parameter. Member ID value can be in the range of 1 to 8.

Example output

Aruba-VSF-2930F# show system fans                                           

Fan Information 

VSF-Member  1

  Num  | State       | Failures | Location 
-------+-------------+----------+----------

0 / 0 Fans in Failure State
0 / 0 Fans have been in Failure State

VSF-Member  2

  Num  | State       | Failures | Location 
-------+-------------+----------+----------
Sys-1  | Fan OK      |   0      | Chassis  

0 / 1 Fans in Failure State
0 / 1 Fans have been in Failure State

VSF-Member  3

  Num  | State       | Failures | Location 
-------+-------------+----------+----------
Sys-1  | Fan OK      |   0      | Chassis  
Sys-2  | Fan OK      |   0      | Chassis  
Sys-3  | Fan OK      |   0      | Chassis  

0 / 3 Fans in Failure State
0 / 3 Fans have been in Failure State

VSF-Member  4

  Num  | State       | Failures | Location 
-------+-------------+----------+----------
Sys-1  | Fan OK      |   0      | Chassis  
Sys-2  | Fan OK      |   0      | Chassis  
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0 / 2 Fans in Failure State
0 / 2 Fans have been in Failure State

VSF-Member  5

  Num  | State       | Failures | Location 
-------+-------------+----------+----------
Sys-1  | Fan OK      |   0      | Chassis  
Sys-2  | Fan OK      |   0      | Chassis  
Sys-3  | Fan OK      |   0      | Chassis  

0 / 3 Fans in Failure State
0 / 3 Fans have been in Failure State

VSF-Member  6

  Num  | State       | Failures | Location 
-------+-------------+----------+----------
Sys-1  | Fan OK      |   0      | Chassis

0 / 1 Fans in Failure State
0 / 1 Fans have been in Failure State

VSF-Member  7

  Num  | State       | Failures | Location
-------+-------------+----------+----------
Sys-1  | Fan OK      |   0      | Chassis
Sys-2  | Fan OK      |   0      | Chassis

0 / 2 Fans in Failure State
0 / 2 Fans have been in Failure State

VSF-Member  8

  Num  | State       | Failures | Location
-------+-------------+----------+----------
Sys-1  | Fan OK      |   0      | Chassis

0 / 1 Fans in Failure State
0 / 1 Fans have been in Failure State

show system chassislocate
Syntax
show system chassislocate [vsf member <MEMBER-ID>]
Description

Show locator LED information. If VSF is enabled, this shows locator LED information for all the VSF members.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range of 1 to 8.

Example output

switch(config)#  show system chassislocate

 Locator LED Status

  VSF     Current  Time
  Member  State    Remaining  Configuration
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  ------  -------  ---------  -------------
  1       off
  2       off
  3       off
  4       off
  5       off
  6       off
  7       off
  8       off

show system power-supply

Description

Show chassis power supply information. If VSF is enabled, this shows power supply information for all the VSF
members.

Example output

switch# show system power-supply

Power Supply Status:

  VSF
  Member  PS#   Model     Serial      State           AC/DC  + V        Wattage

  ------- ----- --------- ----------- --------------- ----------------- --------
  1       1     Not Avail Not Avail   Powered         AC 120V/240V       180
  2       1     Not Avail Not Avail   Powered         AC 120V/240V        65
  3       1     Not Avail Not Avail   Powered         AC 120V/240V       500
  4       1     Not Avail Not Avail   Powered         AC 120V/240V       500
  5       1     Not Avail Not Avail   Powered         AC 120V/240V       500
  6       1     Not Avail Not Avail   Powered         AC 120V/240V        65
  7       1     Not Avail Not Avail   Powered         AC 120V/240V       500
  8       1     Not Avail Not Avail   Powered         AC 120V/240V        65

show uptime
Syntax
show uptime [vsf member <MEMBER-ID>]
Description

Display the elapsed time since the last boot of the specified member.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range of 1 to 8.

Example output

switch(config)# show uptime
 VSF Virtual Chassis
 35d 19h 45m

 VSF Member 1
 35d 19h 45m

 VSF Member 2
 35d 19h 45m

 VSF Member 3
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 35d 19h 45m

 VSF Member 4
 35d 19h 45m

 VSF Member 5
 35d 19h 45m

 VSF Member 6
 35d 19h 45m

 VSF Member 7
 35d 19h 45m

 VSF Member 8
 35d 19h 45m

Support commands

copy core-dump
Copy core-dump from the specified VSF member. User can copy available core-dump file from interface module
or management module.

Syntax

copy core-dump vsf member <MEMBER-ID> <SLOT-ID> | mm-active sftp | tftp | usb | 
xmodem <HOST-NAME-STR> | <IP-ADDR> | <IPV6-ADDR> <FILENAME-STR>
Description

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to 8.

Parameters

<MEMBER-ID>

Specify the VSF member.

<SLOT-ID>

Copy interface module core-dump file.

copy fdr-log
Copy FDR (Flight data recorder) logs. User can either copy from management module or interface module or
both.

Syntax

copy fdr-log vsf member <MEMBER-ID> all | mm-active sftp | tftp | usb | xmodem <HOST-NAME-STR> | <IP-ADDR> | <IPV6-ADDR> <FILENAME-STR>

Description

Copy FDR logs from the switch to an SFTP/TFTP server, USB, or xmodem terminal.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
8.
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copy crash-log
Syntax

copy crash-log vsf member <MEMBER-ID> | <SLOT-ID-RANGE> | mm | sftp | tftp | usb | 
xmodem sftp | tftp | usb | xmodem <HOST-NAME-STR> | <IP-ADDR> | <IPV6-ADDR> 
<FILENAME-STR>

Description

Copy the switch log file.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
8.

<SLOT-ID-RANGE>

Enter the single slot identifier.

copy crash-data
Copy the crash data file of the switch.

Syntax
copy crash-data vsf member <MEMBER-ID> <SLOT-ID-RANGE> | mm | sftp | tftp | usb | 
xmodem sftp | tftp | usb | xmodem <HOST-NAME-STR> | <IP-ADDR> | <IPV6-ADDR> 
<FILENAME-STR>

Description

Copy the switch crash data file.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
8.

<SLOT-ID-RANGE>

Enter the single slot identifier.

show boot-history
Syntax
show boot-history [vsf member <MEMBER-ID>]
Description

Display the system boot log for VSF.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
8.
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core-dump
Enable/disable core-dump for the specified member. User can enable/disable core-dump for interface modules or
management module.

Syntax

core-dump interfaces | management-module | vsf | tftp-server member <MEMBER-ID> interfaces | management-module

Description

Enable/disable core-dump on the management module or the interface module.

Parameters

interfaces

Enable/disable core dump on all the interfaces.

management-module

Enable/disable core-dump on the management module.

tftp-server

Address of the auto TFTP server to which the files will be uploaded.

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
8.

erase fdr-log vsf
Erase FDR log from the specified member.

Syntax
erase fdr-log [vsf member <MEMBER-ID>] [slot | mm-active]
Description

Erase the FDR log files.

Parameters

<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
8.

copy crash-files
Syntax
copy crash-files vsf member <MEMBER-ID> [<SLOT-ID-RANGE> | mm-active sftp | tftp |
usb | xmodem] <HOST-NAME-STR> | <IP-ADDR> | <IPV6-ADDR> <FILENAME-STR>
Description

Copy the switch crash files from the specific VSF member

Parameters

mm-active

Copy active management module crash files.
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<MEMBER-ID>

The VSF member-ID for the member command or parameter. Member ID value can be in the range from 1 to
8.

<SLOT-ID-RANGE>

Enter single slot identifier.

Usage
Switch(config)# copy crash-files vsf member
Switch(config)# copy crash-files vsf member 1

VSF configuration
There are two methods to configure VSF for a switch:

• Manual configuration. See Manual configuration of a VSF.

• Automatic configuration. See Automatic configuration of a VSF fabric.

Manual configuration of a VSF

Prerequisites
Manual configuration of a VSF requires the user to individually configure every switch in the stack, and enable
VSF on each switch independently. This process provides the best control for the user to configure VSF member
number, priority, and VSF links.
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It is recommended to have a software version greater than or equal to 16.06.XXXX on all switches, to form a
stack of size greater than four members.

Figure 109: An eight-member ring setup

Procedure

1. To form an eight-member ring setup as shown, do not make the connections initially.

The ports on each switch are Ethernet ports, and connecting as described will create a network loop. The ports
are connected only after each device is fully configured.

2. Log in to the first device, numbered . This is configured as VSF stack member 1.

a. At the prompt, enter the following commands:

Switch# configure
Switch(config)# vsf member 1 priority 200
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Switch(config)# vsf member 1 link 1 24
All configuration on this port has been removed and port is placed in VSF mode.
Switch(config)# vsf member 1 link 2 23
All configuration on this port has been removed and port is placed in VSF mode.
To enable VSF, the REST interface will be disabled.
This will save the current configuration and reboot the switch.
Continue (y/n)? y

b. The above sequence of commands will configure the switch as member 1, with priority 200. Since this
switch has the highest priority configured, it becomes the Commander. The ports 23 and 24 are configured
on VSF links 2 and 1 respectively.

3. Log in to the second device, numbered . It is configured as VSF member 2.

a. Physically connect member 2 with member 1 over the configured VSF ports, and execute the following
commands.

Switch# configure
Switch(config)# vsf member 2 priority 150
Switch(config)# vsf member 2 link 1 25
All configuration on this port has been removed and port is placed in VSF mode.
Switch(config)# vsf member 2 link 1 24
All configuration on this port has been removed and port is placed in VSF mode.
To enable VSF, the REST interface will be disabled.
This will save the current configuration and reboot the switch.
Continue (y/n)? y

b. The preceding sequence of commands will configure the member 2 with priority 150.

4. Log in to the third and fourth devices (configured as members  and  respectively).

a. Physically connect member 3 with member 2. Enter the following commands on device 3:

Switch# configure
Switch(config)# vsf member 3 priority 100
Switch(config)# vsf member 3 link 1 26
All configuration on this port has been removed and port is placed in VSF mode.
Switch(config)# vsf member 3 link 2 25
All configuration on this port has been removed and port is placed in VSF mode.
To enable VSF, the REST interface will be disabled.
This will save the current configuration and reboot the switch.
Continue (y/n)? y

b. Physically connect member 4 with member 3. Enter the following commands on device 4:

Switch# configure
Switch(config)# vsf member 4 priority 100
Switch(config)# vsf member 4 link 1 27
All configuration on this port has been removed and port is placed in VSF mode.
Switch(config)# vsf member 4 link 2 26
All configuration on this port has been removed and port is placed in VSF mode.
To enable VSF, the REST interface will be disabled.
This will save the current configuration and reboot the switch.
Continue (y/n)? y

5. Log in to the fifth and sixth devices (configured as members  and  respectively).

a. Physically connect member 5 with member 4. Enter the following commands on device 5:
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Switch# configure
Switch(config)# vsf member 5 priority 100
Switch(config)# vsf member 5 link 1 28
All configuration on this port has been removed and port is placed in VSF mode.
Switch(config)# vsf member 5 link 2 27
All configuration on this port has been removed and port is placed in VSF mode.
To enable VSF, the REST interface will be disabled.
This will save the current configuration and reboot the switch.
Continue (y/n)? y

b. Physically connect member 6 with member 5. Enter the following commands on device 6:

Switch# configure
Switch(config)# vsf member 6 priority 100
Switch(config)# vsf member 6 link 1 29
All configuration on this port has been removed and port is placed in VSF mode.
Switch(config)# vsf member 6 link 2 28
All configuration on this port has been removed and port is placed in VSF mode.
To enable VSF, the REST interface will be disabled.
This will save the current configuration and reboot the switch.
Continue (y/n)? y

6. Log in to the seventh and eighth devices (configured as members  and  respectively).

a. Physically connect member 7 with member 6. Enter the following commands on device 7:

Switch# configure
Switch(config)# vsf member 7 priority 100
Switch(config)# vsf member 7 link 1 30
All configuration on this port has been removed and port is placed in VSF mode.
Switch(config)# vsf member 7 link 2 29
All configuration on this port has been removed and port is placed in VSF mode.
To enable VSF, the REST interface will be disabled.
This will save the current configuration and reboot the switch.
Continue (y/n)? y

b. Physically connect member 8 with one link to member 1 and another to member 7. Enter the following
commands on device 8:

Switch# configure
Switch(config)# vsf member 8 priority 100
Switch(config)# vsf member 8 link 1 23
All configuration on this port has been removed and port is placed in VSF mode.
Switch(config)# vsf member 8 link 2 30
All configuration on this port has been removed and port is placed in VSF mode.
To enable VSF, the REST interface will be disabled.
This will save the current configuration and reboot the switch.
Continue (y/n)? y
The remaining six members have priority set to 100. All the eight switches will be configured to use the
same domain ID: 5472, which will make a single stack.

7. Connect the switches together as shown. Enable VSF on each of the eight switches by executing the vsf
enable domain 5472 command. Multiple reboots of the switches may occur since the switch roles change
when connected together. To prevent this, the user can power off all switches, connect the cables, and power
on together. The stack will form directly.

8. The final VSF stack configuration after the stack formation will be:
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Switch# show vsf
VSF Domain ID    : 5472
MAC Address      : b05ada-961103
VSF Topology     : Ring
VSF Status       : Active
Uptime           : 0d 2h 26m
VSF MAD          : None
VSF Port Speed   : 1G
Software Version : WC.16.03.0000x

Mbr
ID  MAC Address   Model                                  Pri Status
--- ------------- -------------------------------------- --- ----------
  1  b05ada-961100 Aruba JL253A 2930F-24G-4SFP+ Switch    200 Commander
 *2  b05ada-9721c0 Aruba JL260A 2930F-48G-4SFP Switch     150 Standby
  3  b05ada-972200 Aruba JL254A 2930F-48G-4SFP+ Switch    100 Member
  4  b05ada-96f080 Aruba JL259A 2930F-24G-4SFP Switch     100 Member
  5  9cdc71-393440 Aruba JL253A 2930F-24G-4SFP+ Switch    100 Member
  6  b05ada-962180 Aruba JL260A 2930F-48G-4SFP Switch     100 Member
  7  b05ada-9631e0 Aruba JL254A 2930F-48G-4SFP+ Switch    100 Member
  8  b05ada-96f000 Aruba JL259A 2930F-24G-4SFP Switch     100 Member
It indicates an eight-member VSF stack, with domain ID 5472. The stack topology is a ring, and the stack
interconnect ports are of 1G speed. The user is connected to the console of member 2.

NOTE: The user can alternatively add a port to a VSF link keeping it in disabled state using vsf
member 1 link 1 24 start-disabled command. It is helpful when the user wants to keep
the VSF ports disabled, make the connections, and then enable them back. However, VSF ports
on each member have to be individually enabled for the stack formation.

Manual configuration with multiple ports bundled in a VSF link
In manual configuration of a switch with multiple ports bundled in a VSF link, up to eight VSF ports can be
aggregated in a single VSF link. This creates a load-balanced aggregate VSF connection with redundancy.

NOTE: This method is applicable for a VSF stack having more than four members too.

Figure 110: Manual configuration with multiple ports bundled in a VSF link
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Procedure

1. Log in to the first device. This will be configured as VSF member  . At the prompt, enter the following
commands:

Switch# configure
Switch(config)# vsf member 1 priority 200
Switch(config)# vsf member 1 link 1 49-52 
All configuration on this port has been removed and port is placed in VSF mode.
Switch(config)# vsf member 1 link 2 21-24
All configuration on this port has been removed and port is placed in VSF mode.
Switch(config)# vsf enable domain 5472
To enable VSF, the REST interface will be disabled.
This will save the current configuration and reboot the switch.
Continue (y/n)? y
The above sequence of commands will configure the switch as member 1, which will boot as the Commander
with priority 200.

Switch# show vsf

VSF Domain ID    : 5472
MAC Address      : b05ada-961103
VSF Topology     : No Stack Formed
VSF Status       : Active
Uptime           : 0d 3h 22m
VSF MAD          : None
VSF Port Speed   : 1G
Software Version : WC.16.03.0000x

Mbr
ID  MAC Address   Model                                  Pri Status
--- ------------- -------------------------------------- --- ---------------
*1  b05ada-961100 Aruba JL253A 2930F-24G-4SFP+ Switch    200 Commander

2. Log in to the second device. This will be configured as VSF member . At the prompt, enter the following
commands:

Switch# configure
Switch(config)# vsf member 2 priority 150
Switch(config)# vsf member 2 link 1 49-52
All configuration on this port has been removed and port is placed in VSF mode.
Switch(config)# vsf member 2 link 2 21-24
All configuration on this port has been removed and port is placed in VSF mode.
Switch(config)# vsf enable domain 5472
To enable VSF, the REST interface will be disabled.
This will save the current configuration and reboot the switch.
Continue (y/n)? y
The above sequence of commands will configure switch 2 as the Standby, with a priority of 150. Connect links
of switch 1 and switch 2 after executing the vsf enable domain command. A 2-member stack will be
formed.

Switch# show vsf

VSF Domain ID    : 5472
MAC Address      : b05ada-961103
VSF Topology     : Chain
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VSF Status       : Active
Uptime           : 0d 3h 22m
VSF MAD          : None
VSF Port Speed   : 1G
Software Version : WC.16.03.0000x

Mbr
ID  MAC Address   Model                                  Pri Status
--- ------------- -------------------------------------- --- ---------------
*1  b05ada-961100 Aruba JL253A 2930F-24G-4SFP+ Switch    200 Commander
 2  b05ada-9721c0 Aruba JL260A 2930F-48G-4SFP Switch     150 Standby

3. Log in to the third and fourth devices. These will be configured as members  and  respectively.
Enter the following commands on device 3:

Switch# configure
Switch(config)# vsf member 3 priority 100
Switch(config)# vsf member 3 link 1 21-24
All configuration on this port has been removed and port is placed in VSF mode.
Switch(config)# vsf member 3 link 2 49-52
All configuration on this port has been removed and port is placed in VSF mode.
Switch(config)# vsf enable domain 5472
To enable VSF, the REST interface will be disabled.
This will save the current configuration and reboot the switch.
Continue (y/n)? y
The above sequence of commands will configure switch 3 as a Member, with a priority 100. Connect the links
of switch 2 and switch 3 after executing the vsf enable domain command. A 3-member stack will be
formed.

Switch# show vsf

VSF Domain ID    : 5472
MAC Address      : b05ada-961103
VSF Topology     : Chain
VSF Status       : Active
Uptime           : 0d 3h 22m
VSF MAD          : None
VSF Port Speed   : 1G
Software Version : WC.16.03.0000x

Mbr
ID  MAC Address   Model                                  Pri Status
--- ------------- -------------------------------------- --- ---------------
*1  b05ada-961100 Aruba JL253A 2930F-24G-4SFP+ Switch    200 Commander
 2  b05ada-9721c0 Aruba JL260A 2930F-48G-4SFP Switch     150 Standby
 3  b05ada-972200 Aruba JL254A 2930F-48G-4SFP+ Switch    100 Member
 
Enter the following commands on device 4:

Switch# configure
Switch(config)# vsf member 4 priority 100
Switch(config)# vsf member 4 link 1 49-52
All configuration on this port has been removed and port is placed in VSF mode.
Switch(config)# vsf member 4 link 2 21-24
All configuration on this port has been removed and port is placed in VSF mode.
Switch(config)# vsf enable domain 5472
To enable VSF, the REST interface will be disabled.
This will save the current configuration and reboot the switch.
Continue (y/n)? y
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The above sequence of commands will configure switch 4 as a Member, with a priority 100. Connect links
between switch 3 and switch 4, and switch 4 and switch 1, after executing the vsf enable domain
command on switch 4. A 4-member stack will now be formed with four ports bundled in a single VSF link.

Switch# show vsf

VSF Domain ID    : 5472
MAC Address      : b05ada-961103
VSF Topology     : Ring
VSF Status       : Active
Uptime           : 0d 3h 22m
VSF MAD          : None
VSF Port Speed   : 1G
Software Version : WC.16.03.0000x

Mbr
ID  MAC Address   Model                                  Pri Status
--- ------------- -------------------------------------- --- ---------------
*1  b05ada-961100 Aruba JL253A 2930F-24G-4SFP+ Switch    200 Commander
 2  b05ada-9721c0 Aruba JL260A 2930F-48G-4SFP Switch     150 Standby
 3  b05ada-972200 Aruba JL254A 2930F-48G-4SFP+ Switch    100 Member
 4  b05ada-96f080 Aruba JL259A 2930F-24G-4SFP Switch     100 Member

4. The show vsf link command will display an output of VSF port state and links for each VSF member.

Automatic configuration of a VSF fabric
Automatic configuration of a VSF is simpler than the manual configuration, as it only requires the user to log in
and configure one switch. The other switches automatically get their configurations from the first switch, but only if
the switches are in factory default state. Automatic configuration is not supported on switches that have been
previously deployed, or have had any configuration change made to them, over either CLI, web, or SNMP. A
switch may be restored to factory default state by using the CLI command erase startup-configuration
command.

NOTE: The following configuration methods can be applied to a stack having more than four
members too.

Automatic configuration of a VSF can be configured using two methods:

• without provisioning

• with provisioning
◦ Chassis type, called loose provisioning

◦ Chassis type and MAC-address, called strict provisioning

Without provisioning:

1. Do not connect the ports initially. Since the ports are Ethernet ports, connecting them in a ring topology can
cause loops. Note down the J-number & MAC address of each switch. The J-number is available on the front
panel of the switch while the MAC address is available on the back panel of the switch.

2. Connect to the console of the member intended to be the commander (member 1 in this example). To enable
VSF on the member, execute the following commands:

Switch# configure
Switch(config)# vsf member 1 priority 200
Switch(config)# vsf member 1 link 1 22
All configuration on this port has been removed and port is placed in VSF mode.
Switch(config)# vsf member 1 link 2 23
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All configuration on this port has been removed and port is placed in VSF mode.
Switch(config)# vsf enable domain 3144
To enable VSF, the REST interface will be disabled.
This will save the current configuration and reboot the switch.
Continue (y/n)? y
The preceding sequence of commands will configure the switch as member 1, with priority 200. The ports 22
and 23 are configured on VSF links 1 and 2 respectively. VSF is now enabled. The domain must be specified
while enabling VSF.

3. Upon reboot, the switch is a one-member stack. Execute the show vsf command:

Switch# show vsf

VSF Domain ID    : 3144
MAC Address      : b05ada-961103
VSF Topology     : No Stack Formed
VSF Status       : Active
Uptime           : 0d 3h 22m
VSF MAD          : None
VSF Port Speed   : 1G
Software Version : WC.16.03.0000x

Mbr
ID  MAC Address   Model                                  Pri Status
--- ------------- -------------------------------------- --- ---------------
*1  b05ada-961100 Aruba JL253A 2930F-24G-4SFP+ Switch    200 Commander

4. Physically connect the switch with default configuration to the configured VSF links on member 1. The new
switch will automatically reboot to join the stack as the Standby.

Switch# show vsf

VSF Domain ID    : 3144
MAC Address      : b05ada-961103
VSF Topology     : Chain
VSF Status       : Active
Uptime           : 0d 3h 22m
VSF MAD          : None
VSF Port Speed   : 1G
Software Version : WC.16.03.0000x

Mbr
ID  MAC Address   Model                                  Pri Status
--- ------------- -------------------------------------- --- ---------------
*1  b05ada-961100 Aruba JL253A 2930F-24G-4SFP+ Switch    200 Commander
 2  b05ada-9721c0 Aruba JL260A 2930F-48G-4SFP Switch     150 Standby

5. Configure link 2 of the newly joined member and connect switch 3 with default configuration, to the link 2 of
member 2 (Standby). The new member will automatically reboot and join the stack as member 3.

Switch# show vsf

VSF Domain ID    : 3144
MAC Address      : b05ada-961103
VSF Topology     : Chain
VSF Status       : Active
Uptime           : 0d 3h 22m
VSF MAD          : None
VSF Port Speed   : 1G
Software Version : WC.16.03.0000x

Mbr
ID  MAC Address   Model                                  Pri Status
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--- ------------- -------------------------------------- --- ---------------
*1  b05ada-961100 Aruba JL253A 2930F-24G-4SFP+ Switch    200 Commander
 2  b05ada-9721c0 Aruba JL260A 2930F-48G-4SFP Switch     150 Standby
 3  b05ada-972200 Aruba JL254A 2930F-48G-4SFP+ Switch    128 Member
 

6. All switches can be now interconnected and powered on.

With provisioning:

1. Do not connect the ports initially. Since the ports are Ethernet ports, connecting them in a ring topology can
cause loops. Note down the J-number & MAC address of each switch. The J-number is available on the front
panel of the switch while the MAC address is available on the back panel of the switch.

2. Connect to the console of the member intended to be the commander (member 1 in this example). To enable
VSF on the member, execute the following commands:

Switch# configure
Switch(config)# vsf member 1 priority 200
Switch(config)# vsf member 1 link 1 22
All configuration on this port has been removed and port is placed in VSF mode.
Switch(config)# vsf member 1 link 2 23
All configuration on this port has been removed and port is placed in VSF mode.
Switch(config)# vsf enable domain 3144
To enable VSF, the REST interface will be disabled.
This will save the current configuration and reboot the switch.
Continue (y/n)? y
The preceding sequence of commands will configure the switch as member 1, with priority 200. The ports 22
and 23 are configured on VSF links 1 and 2 respectively. VSF is now enabled. The domain must be specified
while enabling VSF.

3. Upon reboot, the switch is a one-member stack. Execute the show vsf command:

Switch# show vsf

VSF Domain ID    : 3144
MAC Address      : b05ada-961103
VSF Topology     : No Stack Formed
VSF Status       : Active
Uptime           : 0d 3h 22m
VSF MAD          : None
VSF Port Speed   : 1G
Software Version : WC.16.03.0000x

Mbr
ID  MAC Address   Model                                  Pri Status
--- ------------- -------------------------------------- --- ---------------
*1  b05ada-961100 Aruba JL253A 2930F-24G-4SFP+ Switch    200 Commander

4. Provision the configuration for each of the other switches. Provisioning allows the user to specify the type of
each switch in the stack. Once provisioned, the user can make configuration changes on ports of the switch.
When the switch joins the stack, it will automatically get any configuration made. Provision member 2:
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Switch# configure
Switch(config)# vsf member 2 type JL260A mac-address b05ada-9721c0
This will save the current configuration. Continue (y/n)?  y

Warning - The link and port should be provisioned for member 2 to
join the VSF stack.

Switch(config)# vsf member 2 priority 150
Switch(config)# vsf member 2 link 1 2/22
All configuration on this port has been removed and port is placed in VSF mode.
Switch(config)# vsf member 2 link 2 2/23
All configuration on this port has been removed and port is placed in VSF mode.
Switch(config)#
The member number, switch type, and MAC address are specified first. Once this command is executed, the
ports of the switch are now available to be configured, as 2/1, 2/2 and so on. The links of member 2 are also
provisioned, using ports 2/22 and 2/23 on links 1 & 2 respectively. The provisioned switch also shows up in the
stack configuration:

Switch# show vsf

VSF Domain ID    : 3144
MAC Address      : b05ada-961103
VSF Topology     : No Stack Formed
VSF Status       : Active
Uptime           : 0d 3h 22m
VSF MAD          : None
VSF Port Speed   : 1G
Software Version : WC.16.03.0000x

Mbr
ID  MAC Address   Model                                  Pri Status
--- ------------- -------------------------------------- --- ---------------
*1  b05ada-961100 Aruba JL253A 2930F-24G-4SFP+ Switch    200 Commander
 2  b05ada-9721c0 Aruba JL260A 2930F-48G-4SFP Switch     150 Provisioned

5. The same procedure is repeated to provision switches 3 & 4 too. To continue configuring and provisioning
switches 3 & 4, enter the following commands on the console:

Switch(config)# vsf member 3 type JL254A mac-address b05ada-972200
This will save the current configuration. Continue (y/n)?  y

Warning - The link and port should be provisioned for member 3 to
join the VSF stack.

Switch(config)# vsf member 3 link 1 3/46
All configuration on this port has been removed and port is placed in VSF mode.
Switch(config)# vsf member 3 link 2 3/47
All configuration on this port has been removed and port is placed in VSF mode.
Switch(config)# vsf member 4 type JL259A mac-address b05ada-96f080
This will save the current configuration. Continue (y/n)?  y

Warning - The link and port should be provisioned for member 4 to
join the VSF stack.

Switch(config)# vsf member 4 link 1 4/46
All configuration on this port has been removed and port is placed in VSF mode.
Switch(config)# vsf member 4 link 2 4/47
All configuration on this port has been removed and port is placed in VSF mode.
The provisioned switch also shows up in the stack configuration:
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Switch# show vsf

VSF Domain ID    : 3144
MAC Address      : b05ada-961103
VSF Topology     : No Stack Formed
VSF Status       : Active
Uptime           : 0d 3h 22m
VSF MAD          : None
VSF Port Speed   : 1G
Software Version : WC.16.03.0000x

Mbr
ID  MAC Address   Model                                  Pri Status
--- ------------- -------------------------------------- --- ---------------
*1  b05ada-961100 Aruba JL253A 2930F-24G-4SFP+ Switch    200 Commander
 2  b05ada-9721c0 Aruba JL260A 2930F-48G-4SFP Switch     150 Provisioned
 3  b05ada-972200 Aruba JL254A 2930F-48G-4SFP+ Switch    128 Provisioned
 4  b05ada-96f080 Aruba JL259A 2930F-24G-4SFP Switch     128 Provisioned

6. All switches can be now interconnected and powered on. Connect all the switches as shown:

Procedure

1. After the connections have been made, power on switch 2 and 4. These switches will boot up normally as a
standalone switch with the default configuration.

2. The VSF enabled switch will push down the VSF configuration information to the other switches over the VSF
link ports.

3. Since switches 2 and 4 are the directly connected switches, they will receive their configuration first, and
reboot. This procedure takes between 30 seconds to 1 minute.

4. Once switches 2 & 4 have joined the stack, power on switch 3.

5. VSF configuration will be pushed to switch 3. It will reboot last, and join the stack. The final stack configuration
will now include all switches.

Switch# show vsf

VSF Domain ID    : 3144
MAC Address      : b05ada-961103
VSF Topology     : Ring
VSF Status       : Active
Uptime           : 0d 3h 22m
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VSF MAD          : None
VSF Port Speed   : 1G
Software Version : WC.16.03.0000x

Mbr
ID  MAC Address   Model                                  Pri Status
--- ------------- -------------------------------------- --- ---------------
*1  b05ada-961100 Aruba JL253A 2930F-24G-4SFP+ Switch    200 Commander
 2  b05ada-9721c0 Aruba JL260A 2930F-48G-4SFP Switch     150 Standby
 3  b05ada-972200 Aruba JL254A 2930F-48G-4SFP+ Switch    128 Member
 4  b05ada-96f080 Aruba JL259A 2930F-24G-4SFP Switch     128 Member

NOTE: In this scenario, specifying the MAC address of each provisioned switch is optional. If the
MAC address is not specified, the switch is termed a loose-provisioned switch. When the
commander configures a switch connected on a VSF link port, it will find the first provisioned switch
which matches the J-number, and push the configuration to the connected switch.

Port speed
The 2930 switches support only one port speed across all VSF ports in the stack. This port speed is configurable,
and is initially set automatically to the highest speed capable by the first VSF port that is configured.

Users can add ports of any speed to a VSF link. Only ports which match the configured VSF port speed will link
up in the VSF stack. Ports which do not match the VSF port speed will be in an error state, stating port speed
mismatch. This new feature allows users to migrate a stack based on 1G interconnects to a stack based on 10G
interconnects, and vice-versa, without having to reform the VSF stack from the beginning. The migration
procedure from 1G interconnects to 10G interconnects is:

In a stack with 1G interconnects, the user simply adds the 10G ports to each link. These ports should also be
physically interconnected, but they will not link up. Once all the configuration is complete and the interconnections
are made, the user changes the port speed using the command vsf port-speed 10g. This triggers a reboot of
the stack, and once the stack is reformed, it uses the configured 10G ports while the 1G ports will be in error
state. The 1G ports can now be disconnected and unconfigured.

NOTE: In the case of transceiver ports, the speed is determined by the bay type. An SFP+ bay, if
configured, will set port speed to 10G. If an SFP transceiver is inserted into the bay, it will not link up
and be in error state.

VSF port LED front panel
On enabling the VSF link ports, the LED flashes solid orange state in the front panel. The user can recognize and
connect the VSF link ports. Solid orange LED state indicates:

• Port is reserved.

• Port is reserved but disabled.

• Post is reserved and not linked up. The port LED starts showing activity by flashing green when it links up to
the partner port, and successfully forms the VSF stack.

Selecting Usr in the front panel displays stack member information. For example:

• Port1 LED indicates status of Stack Member 1.

• Port2 LED indicates status of Stack Member 2.
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Table 40: Mode LED states and indication

LED States Indication

Slow flash green Stack member number of the displaying chassis

Fast flash green Stack member number of the commander chassis.

On orange Stack member is faulty or in a booting condition.

Off Stack member does not exist in the stack.

VSF port LEDs
Table 41: VSF port LEDs

Global Status LED Mode LED Usr Port LED Diagnostic tips

Solid green Solid green Solid orange See LED 1 and LED 2
display solid green
color, whereas, LED 3
displays solid orange on
page 703

Slow flash orange Solid green Slow flash green-
MemberFast flash green-
CommanderSolid green-
Member with good
stacking connectionSlow
flash orange-Member with
poor stacking connection

See LED 1 displays slow
flash orange, LED 2
displays solid green,
whereas, LED 3 displays
different colors on page
703

Slow flash orange Solid green Slow flash green-
MemberFast flash green-
CommanderSlow flash
orange-Member in another
fragment

See LED 1 displays slow
flash orange and LED 2
displays solid green
color, whereas, LED 3
displays different colors
on page 704

Solid green Solid green Slow flash green-
MemberFast flash green-
Commander

See LED 1 and LED 2
display solid green,
whereas, LED 3 displays
different colors on page
704

Solid green Solid green Slow flash green-
MemberFast flash green-
Commander

See LED 1 and LED 2
display solid green,
whereas, LED 3 displays
different colors on page
704

Diagnostic tips for stacking error
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LED 1 and LED 2 display solid green color, whereas, LED 3 displays solid orange

Symptom

LED 1 and LED 2 display solid green color, whereas, LED 3 is off. 1

1 LED 1 is Global Status LED, LED 2 is Mode LED Usr, and LED 3 is Port LED.

Cause

Stacking is disabled on the switch. The member is unreachable or booting.

Action

1. Connect a console cable to the switch and establish a console session.

2. Enter vsf enable domain <ID> from the CLI config context.

3. Recheck the switch LEDs:

Stacking port LED is back to solid green. Port LED in user mode is green.

LED 1 displays slow flash orange, LED 2 displays solid green, whereas, LED 3 displays
different colors

Symptom

LED 1 displays slow flash orange and LED 2 displays solid green. LED 3 displays slow flash green, fast flash
green, slow flash orange, or solid green.1

1 LED 1 is Global Status LED, LED 2 is Mode LED Usr, and LED 3 is Port LED.

Solution 1

Cause

The interface cable is connected to the VSF port on which the link LED is blinking.

Action

1. Make sure that the stacking cable is fully connected at both ends of the link.

2. If an equipment failure has occurred, see the LEDs on the device at the other end of the connection.

Solution 2

Cause

A stacking link failure has occurred on a link that was functioning:

• The switch at the other end of the VSF port cable has been powered off.

• The stacking feature is disabled on the switch at the other end of the VSF port cable.

• The cable is faulty.

Chapter 20 Virtual Switching Framework (VSF) 703

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 7300



Action

1. If this error occurred on an operational stack, it could result in changes to the stack configuration. This can
include election of a new stack commander and possibly a new standby. Ensure that the correct set of
supported cabling is used for installed transceivers or RJ45 fixed port.

2. See the Stack Management chapter in the 2930F Advance Traffic Management Guide for more information.
Contact your Hewlett Packard Enterprise authorized network reseller, or use the electronic support services
from Hewlett Packard Enterprise to get assistance. See www.hpe.com/support/hpesc.

LED 1 displays slow flash orange and LED 2 displays solid green color, whereas, LED 3
displays different colors

Symptom

LED 1 displays slow flash orange and LED 2 displays solid green color. LED 3 displays slow flash green, fast
flash green, or slow flash orange.1

1 LED 1 is Global Status LED, LED 2 is Mode LED Usr, and LED 3 is Port LED.

Cause

A stack link failure has occurred in a chain topology and multiple stack fragments have been created. Each
fragment will elect a Commander, so there will be multiple switches with the Cmd LED on.

Action

1. Repair the cause of the stack link failure.

2. Reconnect the switches in their original topology so that the switches can reform the original stack.

LED 1 and LED 2 display solid green, whereas, LED 3 displays different colors

Symptom

LED 1 and LED 2 display solid green, whereas, LED 3 displays slow flash green and fast flash green.1

1 LED 1 is Global Status LED, LED 2 is Mode LED Usr, and LED 3 is Port LED.

Cause

Merging two stacks that have different stack IDs which were not previously part of the same stack.

Action

1. Select one of the stacks as the one to retain.

2. Erase the stacking configuration for each switch in the other stack by issuing stacking factory-reset at
the config level. The startup configuration for each switch is erased, including the stacking configuration.

3. Add the switches to the stack as described in the Stack Management chapter of the ArubaOS-Switch
Advanced Traffic Management Guide K/KA/KB.16.01.
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Locating LED behavior in stacking system
Table 42: Locating LED behavior in stacking system

Switch LED State Meaning

Locator(blue) Standalone
commander ChassisLocate On | Off
| Blink

On-Blinking-Off The Locator LED is used to identify
a specific switch in the network
equipment installation. The LED can
be set to Solid or Blink, and for a
specified number of minutes
(1-1440). Default: 30 minutes. Use
chassislocate command to
control this LED.

Locator in 4 member stack Locating
specific stacking Member Chassis
Locate Member <No> On | Off |
Blink

On-Blinking-Off Locator LED is used to locate
specific stacking member in
stacking.

Locator in 4 member stack Global
command to locate all the members
in stack. ChassisLocate On | Off |
Blink

On-Blinking-Off Locator LED is used to locate
specific stacking member in
stacking.

Locator behavior in various member
states

Standby rebooting in the middle of
locate LED duration.

After bootup, standby indicates
Locator, if it was indicating before
reboot.

Member rebooting in the middle of
locate LED duration.

After bootup, member indicates
Locator, if it was indicating before
reboot.

Member removed in the middle of
locate LED duration.

After member is removed, it boots
up as standalone member and does
not indicate Locator LED.

Stack split and merge Locate LED indication is restored
once merged back into stack.

NOTE: 
Unsupported XCVR behavior

When unsupported transceiver is installed or hotswapped on the VSF reserved port, it flashes
slow orange, indicating that the transceiver has failed validation

Port or Link LED behavior

When VSF is reserved, it flashes solid orange, indicating port state as reserved, but moves on to
flash green, showing activity when linked up successfully.

Mode LED set to PoE on VSF enabled Port

PoE is disabled by default on VSF port, hence it indicates slow flash orange on VSF port when
POE mode LED is selected.
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VSF restrictions
• VSF is mutually exclusive with distributed trunking, mesh, and Q-in-Q.

• VSF port restrictions:
◦ Must be 10Gbps/1Gbps.

◦ A VSF link can only comprise ports with the same speed; either all 10G or all 1G. A VSF port speed which
does not match with the global port speed, will be in a down state. The command show vsf link
detail will display an error message.

◦ Maximum eight ports can be configured on one VSF link.

◦ VSF ports must be directly connected and there should be no transit devices between members.

• In a VSF virtual chassis, flow-control is not supported between ports on different chassis across VSF links.

• A VSF stack downgrade is not allowed if we try to downgrade a 2930 VSF stack having a stack size greater
than four members, to an image lesser than 16.06.

• For switches running software versions lesser than 16.06, it is recommended to first upgrade to 16.06 for
supporting a stack having more than four members.

• VSF merge between a fragment running a software version 16.06 and a fragment running an image lesser
than 16.06 is not recommended.

• A power outage or cable connection failures can split a stack with greater than four members, into more than
two fragments (for example, 1-2-3-4, 5-6, and 7-8). To restore the stack to its previous state after addressing
the issues, ensure that not more than two fragments are merged at a time. For example, merge 1-2-3-4 with
5-6, followed by merging 1-2-3-4-5-6 with 7-8.

VSF Use Cases
Use Case 1: Multiple Active Detection
What is MAD?

Multiple Active Detection (MAD) is a protection mechanism against the fallout of a VSF stack split. A stack split
occurs when there is a connectivity failure between the two stack switches. The simplest protection against
connectivity failure is to have multiple redundant ports in the VSF link.

The two switches operate in a “split-brain” scenario. Both split fragments cannot talk to each other and are
forwarding traffic, but:

• they have the same MAC address,

• they have the same IP addresses on all VLANs, and

• depending on the deployment, they are likely to be connected to same uplink/downlink switches though a link-
aggregation.

A MAD protocol must be enabled to prevent network-wide issues that a stack split can cause. MAD protocols
attempt to detect the presence of the other stack fragment. If detected, the goal of MAD is to keep only one stack
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fragment up. The other stack fragment is brought down (all switch ports are disabled). This prevents issues
caused by duplicate IP addresses and/or duplicate MAC address.

Figure 111: MAD interconnect device

NOTE: Once a MAD decision has been accepted and the active member is determined, the member
remains in the current state until the VSF fabric has been repaired.

LLDP MAD

LLDP-MAD is used to detect multiple-active VSF fragments. This protocol is not supported for more than 2–
member stacking switches. When a VSF fabric existing between an active and a standby member fails, LLDP-
MAD determines whether multiple active topology is in place. If LLDP-MAD is configured and a VSF split occurs,
one of the VSF members will become inactive, which disables the non-VSF frontplane ports. This ensures that
only one of the members will be actively forwarding traffic.

Figure 112: LLDP-MAD

MAD readiness check

The MAD assist device must be connected over a LACP trunk interface to the VSF device. Once you configure
the IP address of a MAD assist device, the VSF switch will perform a MAD readiness check to determine:

• If the MAD assist device is reachable.

• If a trunk interface is used to reach the device.

• If the trunk state is up.

If the above three conditions are not met, MAD will fail to detect dual active fragments during a VSF split. This
error will create a log message.
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NOTE: The MAD readiness check is repeated periodically. If MAD-probe parameters have changed,
an appropriate message will be logged.

VLAN MAD

MAD VLAN can be used for management. Switches which support VSF and do not have OOBM ports, use front-
plane ports to detect active stack fragments upon split. One port from each member of the stack should be part of
a MAD VLAN and it should be connected to MAD interconnect device in the same network. MAD VLAN can be
used for the purpose of management like telnet and SSH. The front-plane ports of switches which support only
VSF will be part of one VLAN called MAD VLAN.

Limitations of VLAN MAD

• Any other protocol which may alter the functionality of VLAN MAD should not be enabled on VLAN MAD.

• Proper functionality of VLAN MAD cannot be ensured when there is more than one failure.

• Only one port per member can be assigned to the VLAN MAD.

• A source port filter cannot be configured on a port that is a member of the VLAN MAD.

• VLAN MAD cannot be configured on a VLAN that has source port filter enabled member ports.

• Trunk ports cannot be assigned to the VLAN MAD.

• The default VLAN cannot also be the VLAN MAD.

• GVRP cannot be configured on VLAN MAD member ports. Use the interface level unknown-vlans command
to disable GVRP in ports.

• MVRP cannot be enabled on VLAN MAD member ports.

• VLAN MAD cannot be configured when multicast filter is enabled for MAC address 0x00, 0x12, 0x79, 0x4a,
0xd5, and 0x82.

• LACP enabled port cannot be part of the MAD VLAN.

• BPDU filtering cannot be disabled on MAD VLAN ports.

Use Case 2: Replacing a switch in a stack
A stack maintains the MAC address of all member switches in its configuration. This is to enable the stack to
reform quickly upon reboot. In the event a failed switch needs to be replaced in the stack, the replacement switch
will be considered as a new switch joining the stack, and will be assigned an unused member and a default
configuration.

Switch# show vsf
VSF Domain ID    : 164423
MAC Address      : b05ada-96f043
VSF Topology     : Chain
VSF Status       : Fragment Active
Uptime           : 0d 10h 30m
VSF MAD          : None
VSF Port Speed   : 1G
Software Version : WC.16.03.0003

Mbr
ID  MAC Address       Model                                  Pri Status
--- ----------------- -------------------------------------- --- ---------------
  1  b05ada-962160     Aruba JL253A 2930F-24G-4SFP+ Switch    128 Missing
 *2  b05ada-96f040     Aruba JL253A 2930F-24G-4SFP+ Switch    250 Commander
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  3  b05ada-973680     Aruba JL262A 2930F-48G-PoE+-4SFP Sw... 250 Standby
  4  b05ada-963860     Aruba JL261A 2930F-24G-PoE+-4SFP Sw... 128 Member
In the above stack, member 1 has failed, and needs to be replaced. A replacement switch with the same model
number (JL253A) will not take on the role of the switch it replaced, because the MAC address of the replacement
switch will be different from the switch that it replaces.

To enable the configuration to assimilate the replacement switch as member 1 in the stack, the MAC address
needs to be cleared. Use the CLI command vsf member 1 type JL253A. This will retain all configuration
made on member 1 and remove only the MAC address. After the command is executed, the output of show vsf
will be as follows:

VSF Domain ID    : 164423
MAC Address      : b05ada-96f043
VSF Topology     : Chain
VSF Status       : Fragment Active
Uptime           : 0d 10h 34m
VSF MAD          : None
VSF Port Speed   : 1G
Software Version : WC.16.03.0003

Mbr
ID  MAC Address       Model                                  Pri Status
--- ----------------- -------------------------------------- --- ---------------
  1                    Aruba JL253A 2930F-24G-4SFP+ Switch    128 Provisioned
 *2  b05ada-96f040     Aruba JL253A 2930F-24G-4SFP+ Switch    250 Commander
  3  b05ada-973680     Aruba JL262A 2930F-48G-PoE+-4SFP Sw... 250 Standby
  4  b05ada-963860     Aruba JL261A 2930F-24G-PoE+-4SFP Sw... 128 Member
Subsequently, any switch model under JL253A, which is connected to the stack, will be assigned member 1
configuration and role.

Use Case 3: Changing VSF link speed
The sequence to change the VSF link speed is as follows:

Prerequisites
VSF requires that all ports in all VSF links in the VSF stack must be of the same speed. VSF supports two port
speeds, 1G and 10G, and up to 8 ports can be added to a VSF link. There is no default port speed defined. When
a VSF link is first configured, the global port speed is automatically set to the interface speed of the port on the
link.

• There is no restriction on the ports which can be added to a VSF link. Ports which do not match the global port
speed can be added to a VSF link, but only ports matching the configured global port speed will be up.

• On a running VSF stack, the current applicable port speed is shown as part of the show vsf command
output.

Switch(config)# show vsf
VSF Domain ID      : 164423
MAC Address        : b05ada-9694e3
VSF Topology       : Chain
VSF Status         : Active
Uptime             : 0d 5h 37m
VSF MAD            : None
VSF Port Speed     : 1G
Software Version   : WC.16.03.0003

Procedure

1. Add ports of the desired link speed to each link of the stack.
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Once this is done, the show vsf link detail output would be similar to:

VSF Member: 1     Link: 1

Port     State
-------- ----------------------------
1/1      Up   : Connected to port 4/1
1/25     Error: Port speed mismatch

VSF Member: 1     Link: 2

Port     State
-------- ---------------------------
1/2      Up   : Connected to port 2/2
1/26     Error: Port speed mismatch      

VSF Member: 2     Link: 1

Port     State
-------- ----------------------------
2/1      Up   : Connected to port 3/1
2/25     Error: Port speed mismatch

2. Connect the ports of the new speed (1/25, 1/26, etc.). Since the ports are kept disabled, it is safe to make the
connections at this point. The link will not come up. All links must have ports of both speeds, otherwise the link
will fail to come up when the port speed is changed.

3. Execute the command indicating the target speed: vsf port speed <1G/10G>. This will trigger a reboot of
the whole stack. On reboot, the stack will form using the ports which match the new VSF port speed. Ports
which do not match will be kept disabled. The output of show vsf link detail after the reboot would be
as follows:

VSF Member: 1     Link: 1

Port     State
-------- --------------------------
1/1      Error: Port speed mismatch      
1/25     Up   : Connected to 4/25

VSF Member: 1     Link: 2

Port     State
-------- --------------------------
1/2      Error: Port speed mismatch      
1/26     Up   : Connected to 2/26

VSF Member: 2     Link: 1

Port     State
-------- --------------------------
2/1      Error: Port speed mismatch      
2/25     Up   : Connected to 3/25

4. Disconnect the unused ports (1/1, 1/2 etc.). This is a safety measure to avoid accidentally creating a network
loop when executing the next step.

5. Unconfigure the unused ports from the VSF link, using the command no vsf member 1 link 1 1/1 etc.
Once this step is completed, the output of show vsf link detail would be as follows:
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VSF Member: 1     Link: 1

Port     State
-------- ---------------------
1/25     Up: Connected to 4/25

VSF Member: 1     Link: 2

Port     State
-------- --------------------
1/26     Up: Connected to 2/26

VSF Member: 2     Link: 1

Port     State
-------- ---------------------
2/25     Up: Connected to 3/25
The ports which have been removed from VSF links can now be used as regular Ethernet ports.

Use Case 4: Adding a switch to a stack
The automatic configuration mode only works with a newly unboxed switch, or a switch which has been reset to
factory default configuration using the CLI command erase startup-configuration. Now, connecting the
switch in between the two end switches of the chain will trigger an automatic configuration download to the switch,
after which it will join the stack.

In manual configuration mode, the switch to be added has to be configured to join the stack. This involves the
following steps:

Prerequisites
A functional running stack can be scaled up by adding a switch to increase capacity. There will be minimal
disruption of switching function during this operation. This process is similar to the VSF deployment, and can be
done in either Manual or Automatic configuration mode.

NOTE: The maximum number of members in a VSF stack is 8.

• The first step is to convert running stack to chain, if it is in ring topology. To increase the stack size, add a new
switch to the stack, and then convert it back to a ring.

• This involves disconnecting a VSF link between two stack members. Switching functions will continue, with
possible loss of some in-flight traffic.

Procedure

1. Configure new switch links, which will be connected to the two end switches of the chain.

2. Enable VSF on new switch with the same Domain ID as the stack. This will cause the switch to reboot.

3. Connect the cables to the end switches of the stack, and the stack will be formed.

There could again be some possible loss of some in-flight traffic as a ring topology forms from the chain
topology.
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Use Case 5: Stack split and merge

• Upon a merge, the inactive fragment will reboot and always join the stack.

• In an equal stack split, the fragment with the commander will always be active.

• In an unequal stack split, the fragment with higher number of members will always be active.

NOTE: Any topology change to an active fragment which is in a partial state will result in an
undesirable behavior.

712 Aruba 2930F / 2930M Management and Configuration Guide
for ArubaOS-Switch 16.08

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 7309



Overview
To simplify the deployment of mobility and IoT devices, Aruba switches have a mechanism to automatically detect
devices based on their LLDP signatures and apply configuration to the port to which they are connected. This
reduces the time needed to add, move, or change devices on the network and also eliminates potential
misconfigurations on the port.

Device Profiles allow an administrator to create configuration containers for different classes of devices and
associate them with certain device types. The configuration containers are stored as part of the config, but do not
come into effect until a device with the right LLDP signature is connected to a port on that switch. Device profiles
allow network administrators to apply port settings automatically, eliminating configuration mistakes as well as
reducing the time taken to connect wired devices.

Organization-specific TLVs and subtypes that come as part of LLDP messages are used to detect and apply
profiles to devices. A maximum of 16 devices can be detected and defined using Device Profiles. The following
sections talk about the operational steps that need to be followed to add Mobility and IoT devices as well as
features such as Rogue AP detection that can be used for mobile-first deployments with Aruba APs.

Auto configuring Aruba APs
The auto device detection and configuration detects a directly connected Aruba AP dynamically and applies
predefined configurations to ports on which the Aruba AP is detected.

You can create port configuration profiles, associate them to a device type, and enable or disable a device type.
One of the device types supported is aruba-ap and it is used to identify all the Aruba APs.

When a configured device type is connected on a port, the system automatically applies the corresponding port
profile. Connected devices are identified using LLDP. When the LLDP information on the port ages out, the device
profile is removed.

By default, the device profile feature is disabled. When you enable the device profile support for a device type, if
no other device profile is mapped to the device type, the default device profile default-ap-profile is
associated with the device type. You can modify the AP default device profile configuration but you cannot delete
it. The default-ap-profile command supports only the AP device type.

NOTE: Only APs which are connected directly will be detected.

Associating a device with a profile
To associate an Aruba access point (AP) device-type to a user-defined profile, use the context Switch(device-
aruba-ap)#. All Aruba access points use the identifier aruba-ap.

The [no] form of the command removes the device type association and disables the feature for the device type.

The feature is disabled by default.

device-profile name
Syntax

[no] device-profile name <PROFILE-NAME> [untagged-vlan <VLAN-ID> |
                           tagged-vlan <VLAN-LIST> | cos <COS-VALUE> |
                           ingress-bandwidth <Percentage> |
                           egress-bandwidth <Percentage> |
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                           {poe-priority {critical | high | low} |
                           speed-duplex {auto |auto-10 | auto-100 | ...} |
                           poe-max-power <Watts> |
                           allow-jumbo-frames | allow-tunneled-node]
Description

This command is used to create a user-defined profile. A profile is a named collection of port settings applied as a
group. You can modify the default profile, default-ap-profile, but you cannot delete it. You can create four
additional profiles.

The default-ap-profile has the following values:

• untagged-vlan: 1

• tagged-vlan: None

• ingress-bandwidth: 100

• egress-bandwidth: 100

• cos: 0

• speed-duplex: auto

• poe-max-power: class/LLDP

• poe-priority: critical

You can modify these parameters. For example, you can execute no untagged-vlan to create a device profile
with tagged only ports.

Parameters
name
Specifies the name of the profile to be configured. The profile names can be at most 32 characters long.

cos
The Class of Service (CoS) priority for traffic from the device.

untagged-vlan
The port is an untagged member of specified VLAN.

tagged-vlan
The port is a tagged member of the specified VLANs.

allow-tunneled node
Configuration to allow Tunneled Node when device profile is applied on port.

ingress-bandwidth
The ingress maximum bandwidth for the device port.

egress-bandwidth
The egress maximum bandwidth for the device port.

poe-priority
The PoE priority for the device port.

speed-duplex
The speed and duplex for the device port.
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poe-max-power
The maximum PoE power for the device port. The value is set based on PD Class detection and/or LLDP
negotiation. poe-max-power will have class appropriate value depending on the class of your AP. (Example:
class4 = 25.5W, class 3=13W, class2=6.49W, class1=3.84W, class0=13W)

Options
no
Removes the user-defined profiles.

Restrictions

• You can modify the configuration parameters of the default profile, default-ap-profile, but you cannot
delete it or change its name.

• Egress rate limiting is not supported for devices running on Aruba 2930F Switch Series.

• The profile configuration is only applicable to access points.

device-profile type
From within the configure context:

Syntax

device-profile type <DEVICE> [associate <PROFILE-NAME> | enable | disable ]
Description

This command specifies an approved device type in order to configure and attach a profile to it. The profile’s
configuration is applied to any port where a device of this type is connected.

Approved device types

aruba-ap

Aruba access point device.

arubaos-switch

ArubaOS switch

Options

From within the device-aruba-ap context

associate <PROFILE-NAME>

Associated the specified device type by profile name.

enable

Enables the automatic profile association.

disable

Disables the automatic profile association.

Usage
[no] device-profile type <DEVICE> [associate <PROFILE-NAME> |enable | disable]
    

NOTE: The device types supported are aruba-ap and arubaos-switch.
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device-profile type device-name

Syntax
device-profile type [aruba-ap | aruba-switch | scs-wan-cpe | 
device-name <DEVICE-NAME> associate <PROFILE-NAME> | enable | disable]

no device-profile type [aruba-ap | aruba-switch | scs-wan-cpe | 
device-name <DEVICE-NAME> associate <PROFILE-NAME> | enable | disable]

Description

Associates the device profile with the type of device by identity.

The no form of this command removes the device profile from the device type.

Command context
config

Parameters
associate <PROFILE-NAME>

Selects the profile name associated with the device-type.

enable
Selects the profile of the device being enabled.

disable
Selects the profile of the device being disabled.

Usage

• The command device-profile type aruba-ap enable enables profile for Aruba-AP.

• Device Name is defined the same as Device Identity.

show device-profile
Syntax

Within the configure context:

show device-profile
Description

Show device profile configuration and status.

config

Show the device profile configuration details for a single, or all, profiles.

status

Show currently applied device profiles.

Usage
show device-profile config <PROFILE-NAME>
    
show device-profile status
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show device-profile config

Switch# Show device-profile config
Device Profile Configuration

  Configuration for device-profile : default-ap-profile
  untagged-vlan      : 1
  tagged-vlan        : None
  ingress-bandwidth  : 100%
  egress-bandwidth   : 100%
  cos                : None
  speed-duplex       : auto
  poe-max-power      : Class/LLDP
  poe-priority       : critical
  allow-jumbo-frames : Disabled
  allow-tunneled-node: Enabled
  

show device-profile config profile1

Switch(device-profile)# show device-p config test

 Device Profile Configuration

 Configuration for device-profile : profile1
  untagged-vlan      : 1
  tagged-vlan        : None
  ingress-bandwidth  : 100%
  egress-bandwidth   : 100%
  cos                : None
  speed-duplex       : auto
  poe-max-power      : Class/LLDP
  poe-priority       : critical
  allow-jumbo-frames : Disabled
  allow-tunneled-node: Enabled

show command device-profile status
Syntax
show device-profile [config | status]
Description

Displays the device-profile configuration or device-profile status.

Options

config

Show device profile configuration details for a single profile or all profiles.

status

Show currently applied device profiles status.

show device-profile status

Switch# show device-profile status
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 Device Profile Status
  Port          Device Type      Applied Device Profile
  ----          -----------      ----------------------
  5             aruba-ap         profile1
  10            aruba-ap         profile1

show device-profile config

Syntax
show device-profile config

Description

Shows the device profile configuration.

Command context
config

Examples

Use the command show device-profile config to display the device profile configuration.

switch(config)# show device-profile config

 Device Profile Configuration

 Configuration for device-profile : default-ap-profile
  untagged-vlan      : 1
  tagged-vlan        : None
  ingress-bandwidth  : 100%
  egress-bandwidth   : 100%
  cos                : None
  speed-duplex       : auto
  poe-max-power      : Class/LLDP
  poe-priority       : critical
  allow-jumbo-frames : Disabled
  allow-tunneled-node: Enabled

 Configuration for device-profile : test
  untagged-vlan      : 1
  tagged-vlan        : None
  ingress-bandwidth  : 100%
  egress-bandwidth   : 100%
  cos                : None
  speed-duplex       : auto
  poe-max-power      : Class/LLDP
  poe-priority       : critical
  allow-jumbo-frames : Disabled
  allow-tunneled-node: Enabled
  

 Configuration for device-profile : default-aos-profile
  untagged-vlan      : 1
  tagged-vlan        : None
  ingress-bandwidth  : 100%
  egress-bandwidth   : 100%
  cos                : None
  speed-duplex       : auto
  poe-max-power      : Class/LLDP
  poe-priority       : critical
  allow-jumbo-frames : Disabled
  allow-tunneled-node: Enabled
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 Configuration for device-profile : default-scs-profile
  untagged-vlan      : 1
  tagged-vlan        : None
  ingress-bandwidth  : 100%
  egress-bandwidth   : 100%
  cos                : None
  speed-duplex       : auto
  poe-max-power      : Class/LLDP
  poe-priority       : critical
  allow-jumbo-frames : Disabled
  allow-tunneled-node: Enabled
 

 Configuration for device-profile : default-device-profile
  untagged-vlan      : 1
  tagged-vlan        : None
  ingress-bandwidth  : 100%
  egress-bandwidth   : 100%
  cos                : None
  speed-duplex       : auto
  poe-max-power      : Class/LLDP
  poe-priority       : critical
  allow-jumbo-frames : Disabled
  allow-tunneled-node: Enabled

 Device Profile Association

  Device Type   : aruba-ap
  Profile Name  : default-ap-profile
  Device Status : Disabled

  Device Type   : aruba-switch
  Profile Name  : default-aos-profile
  Device Status : Disabled

  Device Type   : scs-wan-cpe
  Profile Name  : default-scs-profile
  Device Status : Disabled

show device-profile status

Syntax
show device-profile status

Description

Shows the profile status of the device.

Command context
config

Example

Use the show decive-profile status command to view status.

switch(confg)# show device-profile status
Port     Device-type          Applied device profile
 -------- -------------------- ----------------------
 A1         <device-name>           abc
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Default AP Profile
Creates a user-defined profile.

The profile name is a valid character string with the maximum permissible length of 32. The default profile is
named default-ap-profile and cannot be modified.

The default configuration parameters may be modified using the command device-<PROFILE NAME>
default-ap-profile . Up to four different profiles may be configured.

The [no] command removes the user-defined profiles.

allow-jumbo-frames
Syntax
allow-jumbo-frames
Description

Configure jumbo frame support for the device port. Jumbo frames are not enabled by default.

Validation rules

Validation Error/Warning/Prompt

Invalid jumbo command. Invalid input.

If jumbo frame support is configured on a VLAN for
which the device profile had overridden the
configuration, display the existing warning.

This configuration change will be delayed because a
device profile that enables jumbo frame support is
applied to a port in this VLAN.

Auto configuring IoT Devices
Wired IoT devices can also be automatically configured using device profiles. Since the market for IoT devices is
vast, with several hundred manufacturers and thousands of devices, instead of hardcoding the LLDP signatures,
Aruba switches provide a way for an administrator to create a device type for the IoT devices in their deployment.
By associating the custom device type that they create with a device profile, users can leverage the power profiles
not only for Aruba devices but also for other manufacturers. The requirement for automatic detection of IoT
devices is that they should support LLDP.

Creating a device identity and associating a device type

Procedure

1. Create a device identity using the command:

switch# device-identity name <DEVICE-NAME>
          

2. Specify the OUI used in LLDP's organization using specific TLV, (type =127). OUI should be in XXXXXX
format. The default OUI "000000" indicates that device-identity will not use LLDP to identify device:

switch(config)# device-identity name <DEVICE-NAME> lldp oui <MAC_OUI>
 sub-type <SUBTYPE>

To add new device on switch:

switch(config)# device-identity name abc lldp oui a1b2c3 sub 2
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To remove device from switch:

switch(config)# no device-identity name abc
3. Show device identity configuration:

switch(config)# show device-identity lldp

Device Identity Configuration

 Index  Device name            Oui        Subtype
 ------ ---------------------- ---------- -------
 1      abc                    a1b2c3     2     

NOTE: The maximum devices that can be configured using device-identity are 16. The
maximum devices that can be associated using device-profile are 19. The maximum profiles
that can be created using device-profile are 17.

show device-identity
Syntax
show device-identity

Description

Specify name of the device to be discovered.

Command context
config

Usage
device-identity name <device_name> lldp oui <mac_oui> subtype <subtype>
no device-identity name <device_name> lldp oui <mac_oui> subtype <subtype>

Example

device-identity name avayaPhone lldp oui 00096e sub-type 1

switch(device-profile)# show device-identity

 Device Identity Configuration

 Index  Device name            Protocol
 ------ ---------------------- --------------
 1      avayaPhone             LLDP

switch(device-profile)# show device-identity  lldp

 Device Identity Configuration

 Index  Device name            Oui        Subtype
 ------ ---------------------- ---------- -------
 1      avayaPhone             00096e     1
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device-profile type-device associate
From within the configure context:

Syntax

device-profile type-device <DEVICE_NAME> [associate <PROFILE-NAME> | enable | disable ]
Description

Specify device name defined in device-identity in order to configure and attach a profile to it. Device identity uses
discovery protocol like LLDP to identify device. LLDP makes use of OUI and sub type of organizational specific
TLV type 127 to detect device.

Approved device types

aruba-ap

Aruba access point device.

arubaos-switch

ArubaOS switch

Options

<DEVICE_NAME>

Defines in device-identity.

associate <PROFILE-NAME>

Associated the specified device type by profile name.

enable

Enables the automatic profile association.

disable

Disables the automatic profile association.

Usage

Use the following command to configure a device:

device-identity name <DEVICE_NAME> lldp oui <OUI> subtype <SUBTYPE>.
    
Example

device-p device-type avayaPhone associate avaya

NOTE: The device types supported are aruba-ap and arubaos-switch.

show device-profile config

Syntax
show device-profile config

Description

Shows the device profile configuration.
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Command context
config

Examples

Use the command show device-profile config to display the device profile configuration.

switch(device-profile)# show device-p con avaya

 Device Profile Configuration

 Configuration for device-profile : avaya
  untagged-vlan      : 1
  tagged-vlan        : None
  ingress-bandwidth  : 100%
  egress-bandwidth   : 100%
  cos                : None
  speed-duplex       : auto
  poe-max-power      : Class/LLDP
  poe-priority       : critical
  allow-jumbo-frames : Disabled
  allow-tunneled-node: Enabled

show device-profile status
Syntax
show device-profile [config | status]
Description

Displays the device-profile configuration or device-profile status.

Options

config

Show device profile configuration details for a single profile or all profiles.

status

Show currently applied device profiles status.

show device-profile status

Switch# show device-profile status

Device Profile Status
 
              Port     Device-type          Applied device profile
              -------- -------------------- ---------------------------
              A2        avayaPhone          avaya

Support for Aruba device types
The following Aruba device types are supported:

• Aruba-AP

• ArubaOS-Switch

• Any device that can be defined using LLDP OUI and subtype in the switch
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Isolating Rogue APs
One of the important features to turn on in a mobile-first deployment is the ability of the switches to detect and
quarantine rogue access points. Administrators would like to prevent unauthorized access to their networks and a
rogue AP can open up the network to unwanted users and traffic.

The Rogue AP Isolation feature detects and blocks any unauthorized APs in the network. You can either log or
block the rogue device. If the action requested is to log the rogue device, the MAC address of the rogue device is
logged in the system logs (RMON). If the action is to block the rogue device, the traffic to and from the MAC
address of the rogue device is blocked. The MAC is also logged in the system log.

When an Aruba AP detects a rogue AP on the network, it sends out the MAC address of the AP as well as the
MAC of the clients connected to the AP to the switch using the ArubaOS-Switch proprietary LLDP TLV protocol.
The switch then adds a rule in its hardware table to block all the traffic originating from the rogue AP’s MAC
address.

The rogue-ap-isolation command configures the rogue AP isolation for the switch and gives the option to
enable or disable the rogue AP isolation feature. The rogue-ap-isolation action command gives you the
ability to block the traffic to or from the rogue device or log the MAC of the rogue device. When the action is set to
block, the rogue MAC is logged as well. By default, the action is set to block.

The rogue-ap-isolation whitelist command lets you add devices detected as possible rogue APs to the
whitelist. A maximum of 128 MAC addresses are supported for the whitelist.

The clear rogue-aps command clears the detected rogue AP device MAC address.

Using the Rogue AP Isolation feature

Procedure

1. Check the feature state:

switch# show rogue-ap-isolation

 Rogue AP Isolation

  Rogue AP Status : Disabled
  Rogue AP Action : Block

  Rogue MAC Address Neighbour MAC Address
  ----------------- ---------------------
          

2. Enable the feature:

switch# rogue-ap-isolation enable
switch# show rogue-ap-isolation

 Rogue AP Isolation

  Rogue AP Status : Enabled
  Rogue AP Action : Block

  Rogue MAC Address Neighbour MAC Address
  ----------------- ---------------------
          

3. Change the action type from block to log:

switch# rogue-ap-isolation action log
switch# show rogue-ap-isolation
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 Rogue AP Isolation

  Rogue AP Status : Enabled
  Rogue AP Action : Log

  Rogue MAC Address Neighbour MAC Address
  ----------------- ---------------------
          

4. List the current whitelist entries:

switch# show rogue-ap-isolation whitelist

Rogue AP Whitelist Configuration

 Rogue AP MAC
 ------------------
          

5. Add a new whitelist entry:

switch# rogue-ap-isolation whitelist 005056-00326a
switch# show rogue-ap-isolation whitelist

Rogue AP Whitelist Configuration

 Rogue AP MAC
 ------------------
 00:50:56:00:32:6a
          

rogue-ap-isolation
syntax

rogue-ap-isolation {enable | disable}
Description

Configures the rogue AP isolation for the switch.

Parameters
enable
Enables the rogue AP isolation.

disable
Disables the rogue AP isolation.

rogue-ap-isolation action
syntax

rogue-ap-isolation action {log | block}
Description

Configures the action to take for the rogue AP packets. This function is disabled by default.

Parameters
action
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Configure the action to take for rogue AP packets. By default, the rogue AP packets are blocked.

Options
log
Logs traffic to or from any rogue access points.

block
Blocks and logs traffic to or from any rogue access points.

rogue-ap-isolation whitelist
syntax

[no] rogue-ap-isolation whitelist <MAC-ADDRESS>
Description

Configures the rogue AP Whitelist MAC addresses for the switch. Use this command to add to the whitelist the
MAC addresses of approved access points or MAC addresses of clients connected to the rogue access points.
These approved access points will not be added to the rogue AP list even if they are reported as rogue devices.

Parameters
MAC-ADDRESS
Specifies the MAC address of the device to be moved from the rogue AP list to the whitelist.

Options
no
Removes the MAC address individually by specifying the MAC.

Restrictions

You can add a maximum of 128 MAC addresses to the whitelist.

clear rogue-ap-isolation
syntax

clear rogue-ap-isolation { <MAC-ADDRESS> | all }
Description

Removes the MAC addresses from the rogue AP list.

Parameters
MAC-ADDRESS
Specifies the MAC address of the device to be moved from the rogue AP list.

all
Clears all MAC addresses from the rogue AP list.

Restrictions

The MAC addresses cleared using this option will be added back to the rogue list under the following cases:
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1. The LLDP administrator status of the port on which the AP that reported the MAC is disabled and enabled
back.

2. The data that is in the rogue AP TLV sent from the AP that informed the rogue MAC has changed.

3. To permanently ignore a MAC from being detected as rogue, add it to the whitelist.

Feature Interactions

L3 MAC
The Rogue AP isolation feature will not block a MAC configured as an IP receive MAC address on a VLAN
interface. This event will be logged in RMON if such MACs are detected as rogue.

Conversely, any MAC already blocked by Rogue AP isolation will not be allowed to be configured as an IP receive
MAC address of a VLAN interface.

For example:

switch# vlan 1 ip-recv-mac-address 247703-3effbb 
Cannot add an entry for the MAC address 247703-3effbb because it is already
blocked by rogue-ap-isolation. 
      

Limitations

• You can add a maximum of 128 MAC addresses to the whitelist.

• When a MAC is already authorized by any of the port security features such as LMA, WMA, or 802.1X, the
MAC is logged but you cannot block it using the rogue-ap-isolation feature. A RMON event is logged to
notify the user.

• When a MAC is already configured as an IP received MAC of a VLAN interface, the MAC is logged but you
cannot block it by using the rogue-ap-isolation feature. A RMON event is logged to notify the user.

• When a MAC is already locked out via lockout-mac or locked down using the static-mac configuration,
the MAC is logged but you cannot block it using the rogue-ap-isolation feature. A RMON event is logged
to notify the user.

• The number of rogue MACs supported on a switch is a function of the value of max-vlans at boot time. Since
the resources are shared with the lockout-mac feature, the scale is dependent on how many lockout
addresses have been configured on the switch using the lockout-mac feature. The following table lists the
scale when there are no lockout addresses configured on the switch:

Max VLAN Supported MACs

0 < VLAN <= 8 200

8 < VLAN <= 16 100

16 < VLAN <= 256 64

256 < VLAN <= 1024 16

1024 < VLAN <= 2048 8

2048 < VLAN <= 4094 4
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The switch will create an RMON log entry and the rogue MAC will be ignored when the limit is reached.

NOTE: If the max-vlans value is changed to a different value, the scale of rogue MACs
supported will not change until the next reboot.

Troubleshooting

Switch does not detect the rogue AP TLVs

Symptom

The switch does not detect the rogue AP TLVs that could be sent from the neighboring device.

Cause

The LLDP administrator status of a port is moved from txOnly to tx_rx or rx_only within 120 seconds of the
previous state change to txOnly.

Action

1. Wait for 120 seconds before moving from the state txOnly to the state tx_rx or rx_only. 

2. Move the administrator status to disable and then back to tx_rx or rx_only.

Show commands
Use the following show commands to view the various configurations and status.

Command Description

show rogue-ap-isolation Shows the following information:

• The status of the feature: enabled or disabled.

• The current action type for the rogue MACs detected.

• The list of MAC addresses detected as rogue and the MAC address
of the AP that reported them.

show rogue-ap-isolation
whitelist Shows the rogue AP whitelist configuration.

Requirements
Only APs directly connected to the switch will be detected.

Limitations
• Only one device type is supported, aruba-ap, and it is used to identify all the Aruba APs.

• You can modify the configuration parameters of the default profile, default-ap-profile, but you cannot
delete it or change its name.
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• If the port was part of any protocol VLANs prior to the device profile application, those VLANs will not be
removed while applying the device profile.

• The egress-bandwidth is only supported for devices running on:

◦ Aruba 2930F Switch Series

◦ Aruba 2930M Switch Series

• Enabling jumbo frame support in a profile affects other ports with different profiles. When a profile has jumbo
frames enabled and is applied to any port, all other ports that are members of any VLAN listed in the profile will
also have jumbo frame support.

Feature Interactions

Profile Manager and 802.1X
Profile Manager interoperates with RADIUS when it is working in the client mode. When a port is blocked due to
802.1X authentication failure, the LLDP packets cannot come in on that port. Therefore, the Aruba AP cannot be
detected and the device profile cannot be applied. When the port gets authenticated, the LLDP packets comes in,
the AP is detected, and the device profile is applied.

You must ensure that the RADIUS server will not supply additional configuration such as VLAN or CoS during the
802.1X authentication as they will conflict with the configuration applied by the Profile Manager. If the RADIUS
server supplies any such configurations to a port, the device profile will not be applied on such ports.

Profile Manager and LMA/WMA/MAC-AUTH
If either LMA, WMA, or MAC-AUTH is enabled on an interface, all the MAC addresses reaching the port must be
authenticated. If LMA, WMA, or MAC-AUTH is configured on an interface, the user can have more granular
control and does not need the device profile configuration. Therefore, the device profile will not be applied on
such interface.

Profile manager and Private VLANs
When the device profile is applied, a check is performed to verify if the VLAN addition violates any PVLAN
requirements. The following PVLAN related checks are done before applying the VLANs configured in the device
profile to an interface:

• A port can be a member of only one VLAN from a given PVLAN instance.

• A promiscuous port cannot be a member of a secondary VLAN.

MAC lockout and lockdown
The Rogue AP isolation feature uses the MAC lockout feature to block MACs in hardware. Therefore, any MAC
blocked with the Rogue AP isolation feature cannot be added with the lockout-mac or static-mac command
if the action type is set to block. 

For example:

switch# lockout-mac 247703-7a8950 
Cannot add the entry for the MAC address 247703-7a8950 because it is already 
blocked by rogue-ap-isolation. 
      

switch# static-mac 247703-7a8950 vlan 1 interface 1 
Cannot add the entry for the MAC address 247703-7a8950 because it is already 
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blocked by rogue-ap-isolation. 
      
Similarly, any MAC that was added with the lockout-mac or static-mac command and that is being detected
as rogue will be logged, but not blocked in hardware as it already is set to block. If the MAC is removed from
lockout-mac or static-mac but is still in the rogue device list, it will be blocked back in hardware if the action
type is block.

LMA/WMA/802.1X/Port-Security
Any configuration using LMA, WMA, 802.1X, or Port-Security will not be blocked if the Rogue AP isolation feature
is enabled. All these features act only when a packet with the said MAC is received on a port.

If rogue-ap-isolation blocks a MAC before it is configured to be authorized, packets from such MACs will be
dropped until one of the following happens:

• Rogue action is changed to LOG.

• Rogue-AP isolation feature is disabled.

• The MAC is not detected as rogue anymore.

• LLDP is disabled on the port (or globally).

Once a MAC has been authorized by one of these features, it will not be blocked by Rogue AP isolation. A RMON
will be logged to indicate the failure to block.

The Rogue AP module will retry to block any such MACs periodically. In the event of the MAC no longer being
authorized, Rogue AP isolation will block the MAC again. No RMON is logged to indicate this event. 

Troubleshooting
Dynamic configuration not displayed when using “show running-config”

Symptom

The show running-config command does not display the dynamic configuration applied through the device
profile.

Cause

The show running-config command shows only the permanent user configuration and parameters
configured through device profile.

Action

Use the specific show device-profile command to display the parameters dynamically configured through
the device profile.

The show run command displays non-numerical value for untagged-vlan

Symptom

The show run command displays one of the following values for untagged-vlan:

• no untagged-vlan
• untagged-vlan : None
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Cause

The no device-profile or the no rogue-ap-isolation whitelist command is executed to configure
untagged-vlan to 0.

Action

No action is required.

Show commands
Use the following show commands to view the various configurations and status.

Command Description

show device-profile Shows the device profile configuration and status.

show device-profile config Shows the device profile configuration details for a
single profile or all profiles.

show device-profile status Shows currently applied device profiles.

show run Shows the running configuration.
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NOTE: The OOBM port is available only on the 2930M Switch Series.

OOBM concepts
Management communications with a managed switch can be:

• In band—through the networked data ports of the switch

• Out of band—through a dedicated management port (or ports) separate from the data ports

Out-of-band ports have typically been serial console ports using DB-9 or specially wired 8-pin modular (RJ-style)
connectors. Some recent switches have added networked OOBM ports.

OOBM operates on a "management plane" that is separate from the "data plane" used by data traffic on the
switch and by in-band management traffic. That separation means that OOBM can continue to function even
during periods of traffic congestion, equipment malfunction, or attacks on the network. In addition, it can provide
improved switch security: a properly configured switch can limit management access to the management port
only, preventing malicious attempts to gain access via the data ports.

Network OOBM typically occurs on a management network that connects multiple switches. It has the added
advantage that it can be done from a central location and does not require an individual physical cable from the
management station to each switch's console port.

Table 43: Switch management ports

In band Out of band

Networked Directly connected Networked

Management interface Command line (CLI),
menu, Web

Command line (CLI),
menu

Command line (CLI),
menu

Communication plane Data plane Management plane Management plane

Connection port Any data port Dedicated serial or USB
console port

Dedicated networked
management port

Connector type Usually RJ-45; also CX4,
SFP, SFP+, and XFP

DB9 serial, serial-wired 8-
pin RJ

RJ-45

Advantages Allows centralized
management

Not affected by events on
data network, shows boot
sequence

Not affected by events on
data network, allows
centralized management,
allows improved security

Disadvantages Can be affected by events
on data network; does not
show boot sequence

Requires direct connection
to console port (can be
done via networked
terminal server)

Does not show boot
sequence

Chapter 22
Network Out-of-Band Management (OOBM)
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OOBM and switch applications
The table below shows the switch applications that are supported on the OOBM interface as well as on the data
interfaces. In this list, some applications are client-only, some are server-only, and some are both.

Application Inbound OOBM
(server)

Outbound OOBM
(client)

Inbound data plane
(server)

Outbound data
plane (client)

Telnet yes yes yes yes

SSH yes yes 1

SNMP yes yes yes yes

TFTP yes yes yes yes

HTTP yes 1 yes 1

SNTP 1 yes 1 yes

TIMEP 1 yes 1 yes

RADIUS 1 yes 1 yes

TACACS 1 yes 1 yes

DNS 1 yes 1 yes

Syslog 1 yes 1 yes

Ping yes yes yes4 yes

Traceroute yes4 yes yes4 yes

1 N/A = not applicable
2 ***=Ping and Traceroute do not have explicit servers. Ping and Traceroute responses are sent by the host stack.

For applications that have servers, oobm/data/both options have been added to listen mode. There is now a
listen keyword in the CLI commands to allow selection of those options. Default value is both for all servers.

Example
In a typical data center installation, top-of-rack switches connect servers to the data network, while the
management ports of those switches connect to a physically and logically separate management network. This
allows network administrators to manage the switches even if operation on the data network is disrupted.
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In Figure 113: Network OOBM in a data center on page 734, the switches face the hot aisle of the data
center, allowing easy connection to the network ports on the backs of the servers.

Figure 113: Network OOBM in a data center

For even more control, the serial console ports of the switches can be connected to the management network
through a serial console server (essentially, a networked serial switch), allowing the network administrators to
view the CLI activity of each switch at boot time and to control the switches through the console ports (as well as
through the management ports.)

OOBM Configuration
OOBM configuration commands can be issued from the global configuration context (config) or from a specific
OOBM configuration context (oobm.)

Entering the OOBM configuration context from the general configuration
context
Syntax

oobm
Enters the OOBM context from the general configuration context.

Example

switch(config)# oobm
Switch (oobm)#

Enabling and disabling OOBM
From the OOBM context:

Syntax

enable disable
From the general configuration context:
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Syntax

oobm enable oobm disable
Enables or disables networked OOBM on the switch.

OOBM is not compatible with either a management VLAN or stacking. If you attempt to enable OOBM when a
management VLAN is enabled or when stacking is enabled, the command will be rejected and you will receive an
error message.

If an OOBM IP address exists and you disable OOBM, the OOBM IP address configuration is maintained. If you
enable OOBM and there is a pre-existing OOBM IP address, it will be reinstated.

Network OOBM is enabled by default.

Examples

Switch (oobm)# enable
Switch (oobm)# disable
switch(config)# oobm enable
switch(config)# oobm disable

Enabling and disabling the OOBM port
The OOBM interface command enables or disables the OOBM interface (that is, the OOBM port, as opposed
to the OOBM function.)

From the OOBM context:

Syntax

interface [enable | disable]
From the general configuration context:

Syntax

oobm interface [enable | disable]
Enables or disables the networked OOBM interface (port.)

Examples

Switch (oobm)# interface enable
switch(config)# oobm interface disable

Setting the OOBM port speed
The OOBM port operates at 10 Mbps or 100 Mbps, half or full duplex. These can be set explicitly or they can be
automatically negotiated using the auto setting.

From the OOBM context:

Syntax

interface speed-duplex [10-half | 10-full | 100-half | 100-full | auto]
From the general configuration context:
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Syntax

oobm interface speed-duplex [10-half | 10-full | 100-half | 100-full | auto]
Enables or disables the networked OOBM interface (port.) Available settings are:

10-half 10 Mbps, half-duplex

10-full 10-Mbps, full-duplex

100-half 100-Mbps, half-duplex

100-full 100-Mbps, full-duplex

auto auto negotiate for speed and duplex

Example

Switch (oobm)# interface speed-duplex auto

Configuring an OOBM IPv4 address
Configuring an IPv4 address for the OOBM interface is similar to VLAN IP address configuration, but it is
accomplished within the OOBM context.

From the OOBM context:

Syntax

[no] ip address [dhcp-bootp | ip-address/mask-length]
From the general configuration context:

Syntax

[no] oobm ip address [dhcp-bootp | ip-address/mask-length]
Configures an IPv4 address for the switch's OOBM interface.

You can configure an IPv4 address even when global OOBM is disabled; that address will become effective when
OOBM is enabled.

Example

Switch (oobm)# ip address 10.1.1.17/24

Configuring an OOBM IPv4 default gateway
Configuring an IPv4 default gateway for the OOBM interface is similar to VLAN default gateway configuration, but
it is accomplished within the OOBM context.

From the OOBM context:

Syntax

[no] ip default-gateway ip-address
From the general configuration context:
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Syntax

[no] oobm ip default-gateway ip-address
Configures an IPv4 default gateway for the switch's OOBM interface.

Example

Switch (oobm)# ip default-gateway 10.1.1.1

Configuring an IPv6 default gateway for OOBM devices
An OOBM interface is used for managing devices from remote sites. OOBM devices must be given a default
gateway responsible to maintain a network connection when these devices are placed in an IPv6 network enabled
with RA suppression.

To configure and enable an IPv6 default gateway for OOBM interfaces, use the oobm ipv6 default-gateway
command.

oobm ipv6 default-gateway

Syntax
oobm ipv6 default-gateway <IPV6-ADDR>

no oobm ipv6 default-gateway

Description

Configures the IPv6 default gateway address for OOBM interfaces.

The no form of the command deletes the default gateway. It is imparative that an IPv6 address is specified when
the no form of the command is used.

Command context
config

Parameters
<IPV6-ADDR>

Specifies the IPv6 address when configuring the OOBM for a specific gateway.

Example

switch(config)# oobm ipv6 default-gateway 1001::1/64

oobm member ipv6 default-gateway

Syntax
oobm member <MEMBER-ID> ipv6 default-gateway <IPV6-ADDR>

no oobm member <MEMBER-ID> ipv6 default-gateway

Description

Configures the IPv6 default gateway address for an OOBM member using their unique identifier and the IPv6
address of the default gateway.
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When no proceeds the command, the default gateway address is deleted.

Command context
config

Parameters
<MEMBER-ID>

Specifies the unique member-id which allows the OOBM device access to the IPv6 default-gateway.
<IPV6-ADDR>

Specifies the IPv6 address of the default gateway for a member OOBM interface.

Example

Configuring and deleting the OOBM member from a specific IPv6 gateway.

switch(config)# oobm member 1 ipv6 default-gateway 1001::1

switch(config)# no oobm member 1 ipv6 default-gateway

IPv6 default router preferences
The command ipv6 nd ra router-preference {high | medium | low} provides an extension to the
Neighbor Discovery Router Advertisement messages for communicating default router preferences from routers
to hosts. The extension improves the ability of hosts to pick the appropriate router for an off-link destination. In
network topologies, where the host has multiple routers on its Default Router list, the choice of router for an off-
link destination is critical for making the communication more efficient. For example, one router may provide much
better performance than another for a destination while choosing a wrong router may result in failure to
communicate.

ipv6 nd ra router-preference

Syntax
ipv6 nd ra router-preference {low | medium | high}

no ipv6 nd ra router-preference

Description

Sets the router-preference configuration for communicating default router preferences from routers to hosts.
Improves the ability of hosts to pick the appropriate router for an off-link destination by providing options at the
operator level which set the router preference value as low, medium, or high. Depending on the router preference
value set, the host receives the value as part of the IPv6 neighbor discovery router advertisement and chooses
the best router for communication.

The no form of this command removes the router-preference configuration.

Command context
vlan

Parameters
low

Specifies the router-preference value to low.

medium
Specifies the router-preference value to medium. Medium is the default router-preference value.

738 Aruba 2930F / 2930M Management and Configuration Guide
for ArubaOS-Switch 16.08

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 7335



high
Specifies the router-preference value to high.

Usage

• When VRRP is configured, RA messages for Virtual IP are sent with configured router-preference values.

• This command complies with RFC 4191.

Example

Default router-preferences.

switch(vlan-1)# ipv6 nd ra router-preference
 low                   Set the Default Router Preference to low.
 medium                Set the Default Router Preference to medium (default).
 high                  Set the Default Router Preference to high.

switch(vlan-1)# ipv6 nd ra router-preference high

OOBM show commands
The show commands for OOBM are similar to the analogous commands for the data plane. Note that you must
always include the oobm parameter to see the information for the OOBM interface, regardless of the context. For
instance, even from the OOBM context, the show ip command displays the IP configuration for the data plane;
to see the IP configuration of the OOBM interface, you need to use show oobm ip.

Showing the global OOBM and OOBM port configuration
Syntax

show oobm
Summarizes OOBM configuration information. This command displays the global OOBM configuration (enabled
or disabled), the OOBM interface status (up or down), and the port status (enabled/disabled, duplex, and speed.)

You can issue this command from any context

Example

Switch# show oobm 

Global Configuration
  OOBM Enabled   : Yes
  OOBM Port Type  : 10/100TX
  OOBM Interface Status : Up
  OOBM Port   : Enabled
  OOBM Port Speed  : Auto

Showing OOBM IP configuration
Syntax

show oobm ip
Summarizes the IP configuration of the OOBM interface. This command displays the status of IPv4 (enabled/
disabled), the IPv4 default gateway, and the IPv4 address configured for the interface.
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You can issue this command from any context.

Example

Switch# show oobm ip

Showing OOBM ARP information
Syntax

show oobm arp
Summarizes the ARP table entries for the OOBM interface.

You can issue this command from any context.

Example

Switch# show oobm arp

show oobm ipv6
Syntax
show oobm ipv6

Description

Shows the IPv6 service status for OOBM interfaces.

Command context
operator

Example

Shows the IPv6 service status for OOBM interfaces.

switch# show oobm ipv6 

Internet (IPv6) Service for OOBM Interface

  IPv6 Status    : Enabled
  IPv6 Default Gateway : 1000::2

                                                               Address   Intf
 Member IP Config  IP Address/Prefix Length                    Status    Status
 ------ ---------- ------------------------------------------- --------- ------
 Global manual     1000::1/64                                            Up
 Global autoconfig fe80::42a8:f0ff:fe9e:901/64                           Up

show oobm ipv6 (for stacked switches)

Syntax
show oobm ipv6
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Description

Shows the OOBM IPv6 interface for a stacked switch.

Command context
operator

Example

Shows the OOBM IPv6 interface for a stacked switch.

stack-switch# show oobm ipv6

 Internet (IPv6) Service for OOBM Interface

  IPv6 Status    : Enabled
  IPv6 Default Gateway : 3000::2

                                                               Address   Intf
 Member IP Config  IP Address/Prefix Length                    Status    Status
 ------ ---------- ------------------------------------------- --------- ------
 Global manual     3000::1/64                                  Active    Down
 Global autoconfig fe80::42a8:f0ff:fe9b:a581/64                Active    Down
 1      manual     1000::1/64                                  Active    Down
 2      manual     2000::1/64                                  Active    Up

show oobm ipv6 member (for stacked switches)

Syntax

 show oobm ipv6 member <MEMBER-ID>
                

Description

Shows the OOBM IPv6 service detail for a specific member.

Command context
operator

Example

Shows the OOBM IPv6 service detail for a specific member.

stack-switch# show oobm ipv6 member 2

 Internet (IPv6) Service for OOBM Interface

  IPv6 Status    : Enabled
  IPv6 Default Gateway : 1000::1

                                                               Address   Intf
 Member IP Config  IP Address/Prefix Length                    Status    Status
 ------ ---------- ------------------------------------------- --------- ------
 2      manual     1000::2/64                                  Active    Up

Chapter 22 Network Out-of-Band Management (OOBM) 741

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 7338



show oobm ip detail (for stacked switches)

Syntax
show oobm ip detail

Description

Shows the OOBM IP detail for a stacked switch.

Command context
operator

Example

Show the OOBM IP detail for a stacked switch.

stack-switch# show oobm ip detail

 Internet (IP) Service for OOBM Interface

Global Configuration

  IPv4 Status    : Enabled
  IPv6 Status    : Enabled

  IPv4 Default Gateway : 3.3.3.1
  IPv6 Default Gateway : 3000::1

 Origin     | IP Address/Prefix Length                    Status
 ---------- + ------------------------------------------- -----------
 manual     | 3.3.3.2/24                                  preferred
 manual     | 3000::2/64                                  preferred
 autoconfig | fe80::42a8:f0ff:fe9b:a581/64                preferred

Member 1

  IPv4 Status    : Enabled
  IPv6 Status    : Enabled

  IPv4 Default Gateway : 2.2.2.1
  IPv6 Default Gateway : 2000::1

 Origin     | IP Address/Prefix Length                    Status
 ---------- + ------------------------------------------- -----------
 manual     | 2.2.2.2/24                                  preferred
 manual     | 2000::2/64                                  preferred

Member 2

  IPv4 Status    : Enabled
  IPv6 Status    : Enabled

  IPv4 Default Gateway : 1.1.1.1
  IPv6 Default Gateway : 1000::1

 Origin     | IP Address/Prefix Length                    Status
 ---------- + ------------------------------------------- -----------
 manual     | 1.1.1.2/24                                  preferred
 manual     | 1000::2/64                                  preferred
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Application server commands
Application servers (as described in OOBM and server applications in OOBM concepts on page 732) have
added a listen keyword with oobm|data|both options to specify which interfaces are active.

Default value is both for all servers.

Syntax

telnet-server [listen {oobm | data | both}]
Syntax

ip ssh [listen {oobm | data | both}]
Syntax

snmp-server [listen {oobm | data | both}]
Syntax

tftp server [listen {oobm | data | both}]
Syntax

web-management [listen {oobm | data | both}]
In all cases, show running-config displays the server configurations.

Use the no form of the command to prevent the server from running on either interface.

Examples

Telnet: no telnet-server
SSH: no ip ssh …
SNMP: no snmp-server …
TFTP: no tftp server
HTTP: no web-management …
The show servers command shows the listen mode of the servers:

Switch# show servers
Server listen mode

Server   Listen mode
-----------------------------
Telnet        | both
Ssh         | both
Tftp        | both
Web-management | both
Snmp        | both

Application client commands
CLI commands for client applications have added the oobm keyword to allow you to specify that the outgoing
request be issued from the OOBM interface. If you do not specify the oobm keyword, the request will be issued
from the appropriate in-band data interface. Command syntax is:
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Telnet:

telnet ip-address [oobm]
TFTP:

copy tftp ... ip-address filename... [oobm]
SNTP:

[no] sntp server priority priority ip-address [oobm] [version]
TIMEP:

[no] ip timep [dhcp | manual ip-address | [oobm]]
RADIUS:

[no] radius-server host ip-address [oobm]
TACACS+:

[no] tacacs-server host ip-address [oobm]
DNS:

[no] ip dns server-address priority priority ip-address [oobm]
Syslog:

[no] logging ip-address [[control-descr] | [oobm]]
Ping:

ping [...] [source [ip-address | vlan-id | oobm]]
Traceroute:

traceroute [...][source [ip-address|vlan-id|oobm]] Management and Configuration Guide

Example

Figure 114: Example data center on page 745 shows setup and use of network OOBM using the commands
described above.

744 Aruba 2930F / 2930M Management and Configuration Guide
for ArubaOS-Switch 16.08

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 7341



Assume that the figure below describes how you want to set up your data center.

Figure 114: Example data center

Assume that you are configuring the switch in the left-hand rack to communicate on both the data and
management networks. You might do the following:

• Configure an IP address on the data network.

• Verify that out-of-band management is enabled. (It is enabled by default.)

• Configure an IP address on the management network.

• Verify that the switch can communicate on both networks.

The CLI commands that follow would accomplish those tasks. (The first time through the process you might easily
make the omission shown near the end of the example.)

Switch 41# config
Switch 41(config)# vlan 1
Switch 41(vlan-1)# ip address 10.1.129.7/20        Set up IP address on data network.
Switch 41(vlan-1)# end                                  Exit back to manager context.
Switch 41# show oobm                              Look at default OOBM configuration.

Global Configuration
  OOBM Enabled   : Yes
  OOBM Port Type  : 10/100TX
  OOBM Interface Status : Up                              Defaults look appropriate.
  OOBM Port   : Enabled
  OOBM Port Speed  : Auto

Switch 41# config
Switch 41(config)# oobm                                      Go to OOBM context and
Switch 41(oobm)# ip address 10.255.255.41/24                     add IP address and
Switch 41(oobm)# ip default-gateway 10.255.255.1                    default gateway.
Switch 41(oobm)# end                                   Exit back to manager context.
Switch 41# ping 10.1.131.44              Ping server in this rack (on data network.)
10.1.131.44 is alive, time = 19 ms
Switch 41# ping 10.1.131.51                            Ping server in adjacent rack.
10.1.131.51 is alive, time = 15 ms
Switch 41# ping 10.255.255.42                          Ping switch in adjacent rack.
The destination address is unreachable.        Oops! It’s on the management network.
Switch 41# ping source oobm 10.255.255.42             Go through the management port
10.255.255.42 is alive, time = 2 ms                               and it works fine.
Switch 41#
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Networking Websites
Hewlett Packard Enterprise Networking Information Library

www.hpe.com/networking/resourcefinder

Hewlett Packard Enterprise Networking Software

www.hpe.com/networking/software

Hewlett Packard Enterprise Networking website

www.hpe.com/info/networking

Hewlett Packard Enterprise My Networking website

www.hpe.com/networking/support

Hewlett Packard Enterprise My Networking Portal

www.hpe.com/networking/mynetworking

Hewlett Packard Enterprise Networking Warranty

www.hpe.com/networking/warranty

General websites
Hewlett Packard Enterprise Information Library

www.hpe.com/info/EIL

For additional websites, see Support and other resources.

Chapter 23
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746 Aruba 2930F / 2930M Management and Configuration Guide
for ArubaOS-Switch 16.08

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 7343

http://www.hpe.com/networking/resourcefinder
http://www.hpe.com/networking/software
http://www.hpe.com/info/networking
http://www.hpe.com/networking/support
http://www.hpe.com/networking/mynetworking
http://www.hpe.com/networking/warranty
http://www.hpe.com/info/EIL


Accessing Hewlett Packard Enterprise Support
• For live assistance, go to the Contact Hewlett Packard Enterprise Worldwide website:

http://www.hpe.com/assistance

• To access documentation and support services, go to the Hewlett Packard Enterprise Support Center website:

http://www.hpe.com/support/hpesc

Information to collect

• Technical support registration number (if applicable)

• Product name, model or version, and serial number

• Operating system name and version

• Firmware version

• Error messages

• Product-specific reports and logs

• Add-on products or components

• Third-party products or components

Accessing updates
• Some software products provide a mechanism for accessing software updates through the product interface.

Review your product documentation to identify the recommended software update method.

• To download product updates:

Hewlett Packard Enterprise Support Center
www.hpe.com/support/hpesc

Hewlett Packard Enterprise Support Center: Software downloads
www.hpe.com/support/downloads

Software Depot
www.hpe.com/support/softwaredepot

• To subscribe to eNewsletters and alerts:

www.hpe.com/support/e-updates

• To view and update your entitlements, and to link your contracts and warranties with your profile, go to the
Hewlett Packard Enterprise Support Center More Information on Access to Support Materials page:

www.hpe.com/support/AccessToSupportMaterials

Chapter 24
Support and other resources
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IMPORTANT: Access to some updates might require product entitlement when accessed through
the Hewlett Packard Enterprise Support Center. You must have an HPE Passport set up with
relevant entitlements.

Customer self repair
Hewlett Packard Enterprise customer self repair (CSR) programs allow you to repair your product. If a CSR part
needs to be replaced, it will be shipped directly to you so that you can install it at your convenience. Some parts
do not qualify for CSR. Your Hewlett Packard Enterprise authorized service provider will determine whether a
repair can be accomplished by CSR.

For more information about CSR, contact your local service provider or go to the CSR website:

http://www.hpe.com/support/selfrepair

Remote support
Remote support is available with supported devices as part of your warranty or contractual support agreement. It
provides intelligent event diagnosis, and automatic, secure submission of hardware event notifications to Hewlett
Packard Enterprise, which will initiate a fast and accurate resolution based on your product's service level.
Hewlett Packard Enterprise strongly recommends that you register your device for remote support.

If your product includes additional remote support details, use search to locate that information.

Remote support and Proactive Care information
HPE Get Connected

www.hpe.com/services/getconnected
HPE Proactive Care services

www.hpe.com/services/proactivecare
HPE Proactive Care service: Supported products list

www.hpe.com/services/proactivecaresupportedproducts
HPE Proactive Care advanced service: Supported products list

www.hpe.com/services/proactivecareadvancedsupportedproducts

Proactive Care customer information
Proactive Care central

www.hpe.com/services/proactivecarecentral
Proactive Care service activation

www.hpe.com/services/proactivecarecentralgetstarted

Warranty information
To view the warranty information for your product, see the links provided below:

HPE ProLiant and IA-32 Servers and Options
www.hpe.com/support/ProLiantServers-Warranties

HPE Enterprise and Cloudline Servers
www.hpe.com/support/EnterpriseServers-Warranties

HPE Storage Products
www.hpe.com/support/Storage-Warranties

HPE Networking Products
www.hpe.com/support/Networking-Warranties
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Regulatory information
To view the regulatory information for your product, view the Safety and Compliance Information for Server,
Storage, Power, Networking, and Rack Products, available at the Hewlett Packard Enterprise Support Center:

www.hpe.com/support/Safety-Compliance-EnterpriseProducts

Additional regulatory information

Hewlett Packard Enterprise is committed to providing our customers with information about the chemical
substances in our products as needed to comply with legal requirements such as REACH (Regulation EC No
1907/2006 of the European Parliament and the Council). A chemical information report for this product can be
found at:

www.hpe.com/info/reach

For Hewlett Packard Enterprise product environmental and safety information and compliance data, including
RoHS and REACH, see:

www.hpe.com/info/ecodata

For Hewlett Packard Enterprise environmental information, including company programs, product recycling, and
energy efficiency, see:

www.hpe.com/info/environment

Documentation feedback
Hewlett Packard Enterprise is committed to providing documentation that meets your needs. To help us improve
the documentation, send any errors, suggestions, or comments to Documentation Feedback
(docsfeedback@hpe.com). When submitting your feedback, include the document title, part number, edition,
and publication date located on the front cover of the document. For online help content, include the product
name, product version, help edition, and publication date located on the legal notices page.
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LACP-MAD Passthrough
Overview
Link Aggregation Control Protocol-Multi-Active Detection (LACP-MAD) is a detection mechanism deployed by
HPE Comware switches to recover from a breakup of the Intelligent Resilient Framework (IRF) stack due to link or
other failure.

LACP-MAD is implemented by sending extended LACP data units (LACPDUs) with a type length value (TLV) that
conveys the active ID of an IRF device. The active ID is identical to the member ID of the master and is thus
unique to the device. When LACP MAD detection is enabled, the members exchange their active IDs by sending
extended LACPDUs.

• When the IRF device operates normally, the active IDs in the extended LACPDUs sent by all members are the
same, indicating that there is no multiactive collision.

• When there is a breakup in the IRF chassis, the active IDs in the extended LACPDUs sent by the members in
different IRF devices are different, indicating that there are multiactive collisions.

LACP-MAD passthrough helps IRF-capable devices detect multiaccess and take corrective action. These devices
do not initiate transmission of LACP-MAD frames or participate in any MAD decision-making process. These
devices forward LACP-MAD TLVs received on one interface to the other interfaces on the trunk. LACP-MAD
passthrough can be enabled for 24 LACP trunks. By default, LACP-MAD passthrough is disabled.

NOTE: This Appendix is applicable only if the customer is using a hybrid deployment of Comware
and ArubaOS-Switches.

LACP-MAD Passthrough commands
interface lacp
Syntax
[no] interface <PORT-LIST> lacp [mad-passthrough [enable|disable]|active|passive|key <KEY>]
Description

Defines whether LACP is enabled on a port, and whether it is in active or passive mode when enabled. When
LACP is enabled and active, the port sends LACP packets and listens to them. When LACP is enabled and
passive, the port sends LACP packets only if it is spoken to.

When LACP is disabled, the port ignores LACP packets. If the command is issued without a mode parameter,
'active' is assumed. During dynamic link aggregation using LACP, ports with the same key are aggregated as a
single trunk. MAD passthrough applies only to trunks and not to physical ports.

Parameters

mad-passthrough

Applies only to trunks and not to physical ports.

Appendix A
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enable

Allows the port to send LACP packets.

disable

When LACP is disabled, the port ignores LACP packets.

active

When LACP is enabled and active, the port sends LACP packets and listens to them. Defaults to active.

passive

When LACP is enabled and passive, the port sends LACP packets only if it is spoken to.

key <KEY>

During dynamic link aggregation using LACP, ports with the same key are aggregated as a single trunk.

show lacp
Syntax
show lacp [counters [<PORT-LIST>] | local [<PORT-LIST>] |peer [<PORT-LIST>] | distributed | mad-passthrough [counters [<PORT-LIST>]]]
        

Description

Show LACP-MAD passthrough configuration on LACP trunks, or show LACP-MAD passthough counters on ports.

Parameters

counters

Display the various counters related to LACP ports.

local

Display the various local information related to LACP ports.

peer

Display the LACP peer port information.

distributed

Show distributed LACP information.

mad-passthrough

Display the various counters related to LACP MAD passthrough ports.

Usage
show lacp mad-passthrough counters [<PORT-LIST>]

clear lacp statistics
Syntax
clear lacp statistics
Description

Clear all LACP statistics including MAD passthrough counters. Resets LACP packets sent and received on all
ports.
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Remote Device Deployment (TR-069)
Introduction
TR-069 is a technical specification created by the Broadband Forum. The TR-069 protocol specifies client and
server requirements to manage devices across the Internet by using a client server architecture to provide
communication between the CPE (Customer Premises Equipment) and the ACS (Auto Configuration Server). A
protocol helps to manage complex networks where many devices such as modems, routers, gateways, VoIP
phones and mobile tablets compete for resources. TR-069 defines the CPE WAN Management Protocol (CWMP)
protocol necessary to remotely manage end-user devices. ACS provides automatic configuration for these
devices.

NOTE: CWMP is automatically enabled. To conserve resources, reconfigure this setting using the
cwmp disable command.

TR-069 defines an auto-configuration architecture which provides the following primary capabilities:

• Auto-configuration and dynamic service provisioning

• Software/firmware image management

• Status and performance monitoring

• Diagnostics

• Bidirectional SOAP/HTTP based protocol

Appendix B
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Advantages of TR-069
• TR-069 can manage devices with dynamic IP addresses.

TR-069 use Organization Unique ID (OUI) and serial number rather than IP to identify a device.

• TR-069 can manage devices in a private network.
The HPE ACS BIMS (an iMC module) uses HTTP to communicate with the device, and the session is initiated
by the device, so BIMS can pass through NAT to manage the device.

• TR-069 is secure.
TR-069 can use HTTPS to communicate with or transfer files to/from the device; it is more secure than TFTP,
FTP or Telnet.

• TR-069 is suitable for WAN management across internet.

• TR-069 is suitable for zero-touch configuration.
The zero-configuration mechanism is defined in the TR-069 specification.

• TR-069 is suitable for large-scale device management.
TR-069 support distributed architecture. The ACS can be distributed to multiple servers, each ACS can
manage part of devices.

Zero-touch configuration process
Auto configuration or “zero-touch” deployment is a recurring customer requirement, especially for remote-office
deployments. New devices introduced inside a private network require management tools be co-located to
configure them or update firmware, or require manual intervention to do configuration. TR-069 allows managing
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devices that reside in a private network via HTTP(S), enabling a new set of deployment and management models
today, not possible using SNMP.

The client side, when configured, will contact the server at a predefined URL, using HTTP or HTTPS as protocol.
After authentication, the ACS is able to perform the following basic operations:

• Update CPE Configuration.

• Update CPE TR-069 parameters.

• Update CPE firmware.

• Reboot CPE (backup, startup, and running configurations)

• Run CPE ping diagnostics.

• Reset CPE to factory default.

• Get periodic Status (several parameters can be retrieved depending on what is supported).

Since TR-069 uses HTTP, it can be used across a WAN. If the CPE can reach the URL, it can be managed.
TR-069 is mostly a push protocol where the client periodically sends information without server requests. This
allows for greater scalability over traditional SNMP based tools, which are also bounded to work within the LAN,
while TR-069 can offer management to remote offices.
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Zero-touch configuration for Campus networks

In this example, the following steps to configure CPEs for a Campus Network environment.

1. Pre-configuration for all CPEs in BIMS.

2. CPEs get BIMS parameters from DHCP server.

3. CPEs initiate a connection to BIMS, then BIMS deploys the pre-configuration to CPEs.

Zero-touch configuration for Branch networks

In this example, the following steps to configure CPEs for a Branch network environment.
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1. Create the basic configuration for your spoke device manually, using the username/password from ISP and
BIMS URL.

2. The IPSec VPN configuration is generated by IVM and deployed by BIMS.

3. The IPSec VPN tunnel is automatically created.

4. The device in the branch private network can DHCP relay to HQ to continue the zero touch configuration.

Zero-touch configuration setup and execution
1. DHCP configuration

2. BIMS configuration

3. Execution

CLI commands
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Configuration setup
Within the configure mode:

Syntax:

cwmp
acs

Configure Auto Configuration Server (ACS) access.

cpe

Configure Customer Premises Equipment (CPE) access.

disable

Disable the CPE WAN Management Protocol.

NOTE:

CWMP is automatically enabled. To conserve resources, reconfigure this setting using the cwmp
disable command.

enable

Enable the CPE WAN Management Protocol.

Syntax:

[no] cwmp
acs

Configure Auto Configuration Server (ACS) access.

cpe

Configure Customer Premises Equipment (CPE) access.

enable

Enable the CPE WAN Management Protocol.

ACS password configuration
Syntax:

cwmp acs
password

Configure the password used for authentication when the switch connects to the ACS.

url

Configure the URL of the ACS.

username

Configure the username used for authentication when the switch connects to the ACS.
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When encrypt-credentials is off
Syntax:

cwmp acs password
plaintext

Configure the password used for authentication when the switch connects to the ACS.

When encrypt-credentials is on
Syntax:

cwmp acs password
encrypted-key

An encrypted password generated with the encrypt-credentials command.

plaintext

Configure the password used for authentication when the switch connects to the ACS.

Encrypt-credential on

cwmp acs password encrypted-key
ASCII-STR

Enter an ASCII string (maximum length: 384 characters).

Plaintext password

cwmp acs password plaintext
PASSWORD-STR

A plaintext password used for ACS authentication (maximum length: 256 characters).

ACS URL configuration
Syntax:

cwmp acs url
URL-STR

The URL of the ACS (maximum length: 256 characters).

ACS username configuration
Syntax:

cwmp acs username
USERNAME-STR

A username for ACS authentication (maximum length: 256 characters).
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CPE configuration
Syntax:

cwmp cpe
password

Configure the password used for authentication when the ACS connects to the switch.

username

Configure the username used for authentication when the ACS connects to the switch.

CPE password configuration

When encrypt-credentials is on
Syntax:

cwmp cpe password
encrypted-key

An encrypted password generated with the 'encrypt-credentials' command.

plaintext

Configure the password used for authentication when the ACS connects to the switch.

Syntax:

cwmp cpe password encrypted-key
ASCII-STR

Enter an ASCII string (maximum length: 384 characters).

When encrypt-credentials is off
Syntax:

cwmp cpe [password]
plaintext

Configure the password used for authentication when the ACS connects to the switch

Syntax:

cwmp cpe
PASSWORD-STR

A plaintext password used for ACS authentication (maximum length: 256 characters).

CPE username configuration
Syntax:

cwmp cpe [username]

Appendix B Remote Device Deployment (TR-069) 759

Anexo 04 ITENS 8 E 9 (0592709)         SEI 0008478-63.2018.6.02.8000 / pg. 7356



USERNAME-STR

A username for ACS authentication (maximum length: 256 characters).

Enable/disable CWMP
Syntax:

cwmp [enable|disable]

Show commands

CWMP configuration and status query
Syntax:

show cwmp
configuration

Show current CWMP configuration.

status

Show current CWMP status.

When CWMP is enabled
Syntax:

show cwmp configuration

CWMP configuration

CWMP Configuration
CWMP Status          : Enabled
ACS URL              : http://16.93.62.32:9090
ACS Username         : bims
Inform Enable Status : Enabled
Inform Interval      : 60
Inform Time          : 2014-04-08T06:00:00
Reconnection Timeout : 30

CWMP status

CWMP Status
CWMP Status              : Enabled
ACS URL                  : http://16.93.62.32:9090
ACS URL Origin           : Config
ACS Username             : bims
Connection Status        : Disconnected
Data Transfer Status     : None
Last ACS Connection Time : Wed Apr  9 16:56:00 2014
Time to Next Connection  : 00:00:36
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When CWMP is disabled
Syntax:

show cwmp status

CWMP status

CWMP Status
CWMP Status              : Disabled

CWMP configuration

show cwmp configuration
CWMP Configuration
CWMP Status          : Disabled

Event logging
The TR-069 client offers some tools to diagnose problems:

• System logging

• Status/control commands

System logging
The CPE implements the following system log notification codes and sample messages:

• RMON_TR69_INFORM_COMPLETE
◦ INFORM to http://15.29.20.50:9090/ from (IP address not set yet) completed with error.

◦ INFORM to http://15.29.20.50:9090/ from 10.0.10.212 completed with error.

◦ INFORM to http://15.29.20.50:9090/ from 10.0.10.212 completed successfully.

• RMON_TR69_AUTH_FAILED
◦ Authentication on ACS http://15.29.20.50:9090/ failed.

• RMON_TR69_CONN_FAILED
◦ Connection attempts with ACS http://15.29.20.50:9090/ from 10.0.10.212 failed.

To avoid flooding the system log on frequent attempts to connect with the ACS, the following criteria are used with
both successful and failed attempts:

1. The very first event is always logged.

2. Any change from success to failure or vice versa is always logged.

3. Repeat success or failure events are logged only once every five minutes.

The HTTP file transfer component supports these system log notification codes and sample messages:
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• RMON_HTTP_XFER_COMPLETE
◦ I 11/19/13 08:06:13 04185 http: Download of http://10.0.11.240:9876/path to DestinationFile completed

successfully.

◦ I 11/19/13 08:06:13 04185 http: Upload of SourceFile to http://10.0.11.240:9876/path completed
successfully.

• RMON_HTTP_CONN_FAILED
◦ W 11/19/13 08:06:13 04186 http: Connection to http://10.0.11.240:9876/path failed.

• RMON_HTTP_TIMED_OUT
◦ W 11/19/13 08:06:13 04192 http: Download of http://10.0.11.240:9876/path to DestinationFile timed out.

◦ W 02/20/14 00:32:17 04192 http: Upload of SourceFile to http://10.0.11.240:9876/path timed out.

• RMON_HTTP_NO_SPACE
◦ W 11/19/13 08:06:13 04189 http: Upload of SourceFile to http://10.0.11.240:9876/path canceled because of

insufficient memory.

• RMON_HTTP_REQ_FAILED
◦ W 11/19/13 08:06:13 04190 http: Upload of SourceFile to http://10.0.11.240:9876/path failed (errno 13).

◦ W 11/19/13 08:06:13 04190 http: Upload of SourceFile to http://10.0.11.240:9876/path failed (errno 1).

◦ W 11/19/13 08:06:13 04190 http: Download of http://10.0.11.240:9876/path to DestinationFile failed (errno
13).

◦ W 11/19/13 08:06:13 04190 http: Download of http://10.0.11.240:9876/path to DestinationFile failed (errno
1).

◦ W 11/19/13 08:06:13 04190 http: Download of http://10.0.11.240:9876/path to DestinationFile failed (errno
17).

• RMON_HTTP_WRONG_FILE
◦ W 11/19/13 08:06:13 04191 http: Download canceled because file http://10.0.11.240:9876/path is

malformed or incompatible.

◦ W 11/19/13 08:06:13 04191 http: Download canceled because file http://10.0.11.240:9876/path is
malformed or incompatible.

• RMON_HTTP_FILE_NOT_FOUND
◦ W 11/19/13 08:06:13 04200 http: Upload of SourceFile to http://10.0.11.240:9876/path canceled because of

inexistent file.

Status/control commands
The following commands help assess the general state of TR–069 and control the source of the ACS
configuration record:
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Table 44: Status/control commands

Command Result

show cwmp status
CWMP is Enabled  ACS URL           : https://16.93.62.32:9443
ACS URL is set by                  : Config
ACS Username                       : bims
Connection status                  : Disconnected
Data transfer status               : None
Time of last successful connection : Thu Feb 20 01:16:59 2014
Interval upon to next connection   : Null

show cwmp
configuration CWMP is Enabled  ACS URL          : https://16.93.62.32:9443

ACS Username                      : bims 
Inform Enable Status              : Disabled
Inform Interval                   : 3559 
Inform Time                       :  
Reconnection times                : 30

[no] dhcp tr69-
acs-url Prevents using any ACS information from DHCP
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Configuration backup and restore without
reboot

Beginning with switch software release 16.05, the configuration backup and restore without reboot supports the
following features:

Interface Access (Telnet, Console/Serial, web) Port Shutdown with Broadcast Storm

Access Control Lists (ACLs) Source-Port Filters

AAA Authentication TACACS+ Authentication

CoS (Class of Service) Time Protocols (TimeP, SNTP)

Network Management Applications (SNMP) Uni-directional Link Detection (UDLD)

Port Configuration Virus Throttling (Connection-Rate Filtering)

Port Security Web-based Authentication

Port-Based Access Control (802.1X) Backplane stacking

Quality of Service (QoS) Job Scheduler

Spanning Tree (STP, RSTP, MSTP, RPVST+) Authorized IP Managers

VLANs Authorized Manager List (Web, SSH, TFTP)

802.1Q VLAN Tagging Auto MDIX Configuration

802.1X Port-Based Priority DHCP Configuration

802.1X Multiple Authenticated Clients Per Port Flow Control (802.3x)

IGMP Friendly Port Names

LACP/Trunk Guaranteed Minimum Bandwidth (GMB)

MAC Lockdown IP Addressing

MAC-based Authentication IP Routing

MAC Lockout Jumbo Packets

LMA LLDP

Multicast Filtering LLDP-MED

Power over Ethernet (PoE and PoE+) Loop Protection

Protocol Filters MAC Address Management

RADIUS Authentication and Accounting Management VLAN

RADIUS-Based Configuration Passwords and Password Clear Protection/include-
credentials

Table Continued
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Encrypted-password QoS: Strict-Priority Queuing

Port Monitoring QoS: Turn on/off VLAN Precedence

Port Status QoS: Egress Queue Rate-limiting

Rate-Limiting CDP

Syslog System Parameters (hostname, Banner)

System Information Front-panel-security

Telnet Access DLDP

Traffic/Security Filters OOBM

VLAN Mirroring (1 static VLAN)/Port mirroring Switch interconnect

Voice VLAN Airwave Controller IP configuration

Web Authentication RADIUS Support Aruba Central integration

Web UI Captive portal commands

Log IP address of an ACL match Consolidated Client View

access-list logtimer IPsec for Zero Touch Provisioning

UFD: Uplink Failure Detection Local User roles

Wake-on-LAN for a Specific VLAN Port QoS Trust Mode

WebUI Inactivity Timer Per-port Tunneled node

Control Plane Protection Zero-touch provisioning - DHCP, Activate

Egress ACLs ClearPass support

Device profile - switch auto configuration HTTP redirection/Captive portal

Device profile: Auto configuration with Aruba AP
detection

Device profile: LLDP Authentication Bypass with AP

Tunneled Node enhancement: fallback to switching RADIUS Port Speed VSA

Rogue AP isolation Dynamic ARP Protection

DHCP Option 82 Dynamic IP Lockdown

DHCP snooping Eavesdrop Protection

Distributed Trunking GVRP

RMON 1,2,3,9 Private VLANs

SavePower Features IP SLA

sFlow sys-debug acl

VxLAN MAC Based VLANs (MBV)

Smartlink RBAC: Role Based Access Control

Fault Finder extended to cover Flapping Transceiver
Mitigation

RADIUS Service Tracking

Fault Finder (Per Port Enable) sys-debug destination

SNMP Trap Throttling Protocol VLANS
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Limitations
Switch configuration restore without reboot feature does not support the following scenarios:

• Removing a physically present member through cfg-restore command

• Flex-module provisioning or removal on standalone or a stack

• Module provisioning or removal on standalone or a stack

• Adding a VLAN when the VLAN limit is already reached by having dynamic VLANs. Due to timing issues, ports
or dynamic VLANs take some time to become offline or be removed, even after applying a removal command.
In such a case, restore commands fail as normal CLI commands.

• The maximum number of backup configuration files has been increased from three to five. When the firmware
is downgraded to lower versions, the show config files command displays the details to only three
configuration files.

• Restore is allowed based on the available system resource factors.

Blocking of configuration from other sessions
All write operations are not allowed from other sessions (CLI/WebUI/SNMP/REST, and so on) during a
configuration restoration process. Only read operation is allowed. Attempts to use write operation results in the
Configuration restore is in progress, configuration changes are temporarily
disabled error. The following show commands are blocked during a configuration restoration process:

• show-tech
• show config
• show running-config
• show startup-config
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Smart Rate Technology
Smart Rate is a new technology designed to enable higher port link speeds on legacy cabling where an Ethernet
RJ45 port type can link at 1Gbps, 2.5Gbps, 5Gbps, or 10Gbps.

When situations occur where a network link establishes at a lower than expected speed (or not at all) due to
marginal or bad cabling, the Smart Rate port technology allows administrators to triage cabling issues and
determine root causes of lower than expected performance.

Smart Rate Technology is available on the following products:

Switch 5400R v3 zl2 modules (J9991A, J9995A)
Switch 5400R chassis switch bundles (JL002A)

Show Smart Rate port
Syntax

show interface PORT-LIST smartrate
Displays port diagnostics on a Smart Rate port.

Unlinked Smart Rate port

show interface C5 smartrate

Status and Counters - Smart Rate information for Port C5

Model         : 0x03a1
Chip         : 0xb4b3
Firmware (major)      : 0x0002
Firmware (minor)      : 0x0003
Firmware (candidate)     : 0x0005
Firmware (provision)     : 0x0001

      Chan1   Chan2   Chan3   Chan4 (in db)
Current SNR  9.000000  6.700000  3.500000  9.200000
Minimum SNR  9.000000  6.700000  3.500000  9.200000

CRC8 errors:     0
LDPC errors:     0
LDPC 1 iteration:    27620089
LDPC 2 iterations:    954117
LDPC 3 iterations:    0
LDPC 4 iterations:    0
LDPC 5 iterations:    0
LDPC 6 iterations:    0
LDPC 7 iterations:    0
LDPC 8 iterations:    0

23  Number of fast retrains requested by Local Device.
32  Number of fast retrains requested by Link Partner.
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150 Accumulated time (ms) spent in fast retrain since last AN. 
9  Number of RFI Training Link Recovery Events since last AN.
3  Number of Link Recover Events since last AN.

Established link speed       : 5000Mbps
Number of attempts to establish link   : 5
Uptime since link was last established (ms) : 5099

Local port advertised speeds

1000Mbps 2500Mbps  5000Mbps  10Gbps
 No   Yes   Yes   No

Link partner speed capability

1000Mbps  2500Mbps  5000Mbps  10Gbps
 Yes   Yes   Yes   No

Link Partner matching vendor: Yes

Smart Rate port that is linked at 1Gbps

show interface C5 smartrate

Status and Counters - Smart Rate information for Port C5

Model         : 0x03a1
Chip          : 0xb4b3
Firmware (major)     : 0x0002
Firmware (minor)     : 0x0003
Firmware (candidate)    : 0x0005
Firmware (provision)    : 0x0001

Established link speed         :1000Mbps
Number of attempts to establish link    :5
Uptime since link was last established (ms)  : 5099

Local port advertised speeds

1000Mbps  2500Mbps  5000Mbps  10Gbps
 No     No     No     No

Link partner speed capability

1000Mbps  2500Mbps  5000Mbps  10Gbps
 Yes    Yes    Yes    Yes

Link Partner matching vendor: Yes

Rate-Limiting — GMB features when Fast-Connect SmartRate ports are
configured
When Rate-Limiting or Guaranteed Minimum Bandwidths are configured for 5Gbps ports, the granularity of
percentage-based rates for the 5Gbps speed is in steps of 2%. For example, a 1% rate-limit for a 5Gbps port will
function as a 2% limit while a 5% limit will function as a 6% limit.

The Guaranteed Minimum Bandwith profiles will show the same behavior. For example on an 8-queue system,
the actual default servicing profile will be 2%, 4%, 30%, 10%, 10%, 10%, 16%, and 20%. The CLI and SNMP
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values for these ports will show what the customer configured, but the actual hardware results will be in steps of
2%.

This limitation only applies to 5Gbps ports. Ports running at 2.5Gbps have the same 1% granularity as all
previously-offered port speeds.

Error messages
When the show interface PORT-LIST smartrate command is run on a non-Smart Rate port, the
command will fail with an error message similar to the following: Port A1: This command is only
applicable to Smart Rate ports.
When the show interface PORT-LIST smartrate command is run on a Smart Rate port, but is unable to
retrieve all results the command will fail with an error message similar to the following: Port A1: This
command did not complete successfully. Please try again.

Speed-duplex
Syntax

interface PORT-LIST speed-duplex
Options

auto Auto-negotiate link parameters.

auto-100 100 Mbps only, auto-negotiate link parameters.

auto-1000 1000 Mbps only, auto-negotiate link parameters.

auto-2500 2500 Mbps only, auto-negotiate link parameters.

auto-5000 5000 Mbps only, auto-negotiate link parameters.

auto-2500-5000 2500 or 5000 Mbps only, auto-negotiate link parameters.

auto-10g 10 Gbps only, auto-negotiate link parameters.

Limitations on 5Gbps ports
For 5Gbps ports, when the customer has Rate-Limiting or Guaranteed Minimum Bandwidths configured, the
granularity of percentage-based rates for the 5Gbps speed is in steps of 2%. For example a 1% rate-limit for a
5Gbps port will function as a 2% limit, a 5% limit will function as a 6% limit. The Guaranteed Minimum Bandwith
profiles will show the same behavior. On an 8-queue system, the actual default servicing profile will be 2% 4%
30% 10% 10% 10% 16% 20%. The CLI and SNMP values for these ports will show what the customer
configured, but the actual hardware results will be in steps of 2%.

NOTE:

This limitation only applies to the 5Gbps ports. Ports running at 2.5Gbps have a 1% granularity in
port speeds.
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Error messages
• On ports that do not support the respective speed-duplex option, the command will fail with an error message

similar to the following:
Value auto-10 is not applicable to port E1.

• The following speed-duplex options are not available on switch platforms that do not have Smart Rate ports.
◦ auto-2500

◦ auto-5000

◦ auto-2500-5000

100 Mbps Support on Smart Rate ports

Overview
Smart Rate ports are designed to link devices at 1 Gbps, 2.5 Gbps, 5 Gbps, and 10 Gbps. Older devices such as
legacy printers can run at maximum speed of 100 Mbps. To address this issue, the speed duplex auto-100
enhancement is introduced on Smart-Rate ports. Depending on the device model, Smart Rate ports can operate
on 100Mbps speed.

NOTE: If MACsec is configured on a port, we cannot configure speed duplex as auto-100 for that
particular port, and conversely.

100Mbps is supported on auto speed duplex mode by default.

100 Mbps support on Smart Rate ports is available for 5400R, 3810M and 2930M.

interface speed-duplex auto-100

Syntax
interface <PORT> speed-duplex auto-100

Description

Configures speed option to support Auto-100 on Smart Rate ports.

Command context
config

Parameter
PORT

Specify a port number.

Example

switch(config)#interface A1 speed-duplex auto-100  
switch(config)#show interface brief
 Status and Counters - Port Status

                          | Intrusion                           MDI  Flow Bcast
  Port         Type       | Alert     Enabled Status Mode       Mode Ctrl Limit
  ------------ ---------- + --------- ------- ------ ---------- ---- ---- -----
  A1           10GbE-T    | No        Yes     Up     100FDx     MDI  off  0
  A2           10GbE-T    | No        Yes     Up     100FDx     Auto off  0
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  A3           10GbE-T    | No        Yes     Down   10GigFD    Auto off  0
  A4           10GbE-T    | No        Yes     Down   10GigFD    Auto off  0                  

show interfaces smartrate

Syntax
show interfaces <PORT-LIST> smartrate

Description

Displays Smart Rate diagnostic information.

Parameter
PORT-LIST

Specify a port number or a list of ports.

Examples

switch(config)#show interfaces A1 smartrate

 Status and Counters – Smart Rate information for Port A1

  Model                   : 0x03a1
  Chip                    : 0xb582
  Firmware                : 3.3.e
  Provisioning            : 0x0002

  Established link speed                 : 100BASE-T
  Number of attempts to establish link   : 1
  Uptime since link was established      : 30 seconds

  Local Port advertised capabilities
  100MBT  | 1.0GBT  | 2.5G NBT | 5.0G NBT | 2.5GBT | 5.0GBT | 10GBT
   Yes    |  No     |   No     |   No     |  No    |  No    |  No

  Link Partner advertised capabilities
  100MBT  | 1.0GBT  | 2.5G NBT | 5.0G NBT | 2.5GBT | 5.0GBT | 10GBT
   Yes    |  Yes    |   Yes    |   Yes    |  No    |  No    | Yes

switch(config)# show interface A2 smartrate

 Status and Counters – Smart Rate information for Port A2

  Model                   : 0x03a1
  Chip                    : 0xb582
  Firmware                : 3.3.e
  Provisioning            : 0x0002

  Established link speed                 : 100BASE-T
  Number of attempts to establish link   : 1
  Uptime since link was established      : 30 seconds

  Local Port advertised capabilities
  100MBT  | 1.0GBT  | 2.5G NBT | 5.0G NBT | 2.5GBT | 5.0GBT | 10GBT
   Yes    |  Yes    |   Yes    |   Yes    |  Yes   |  Yes   |  Yes

  Link Partner advertised capabilities
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  100MBT  | 1.0GBT  | 2.5G NBT | 5.0G NBT | 2.5GBT | 5.0GBT | 10GBT
   Yes    |  No     |   No     |   No     |  No    |  No    |  N0

show interface config

Syntax
show interface config

Description

Displays port settings.

Example

switch#(config)show interface config
 Port Settings

  Port  Type       | Enabled Mode         Flow Ctrl MDI
  ----- ---------- + ------- ------------ --------- ----
  A1    10GbE-T    | Yes     Auto-100     Disable   Auto
  A2    10GbE-T    | Yes     Auto         Disable   Auto
  A3    10GbE-T    | Yes     Auto         Disable   Auto
  A4    10GbE-T    | Yes     Auto         Disable   Auto

show running-config

Syntax
show running-config

Description

The Smart Rate port auto-100 is part of the show running config output.

Example

switch(config)#show running-config
Running configuration:

; JL320A Configuration Editor; Created on release #WC.16.06.0000x
; Ver #13:03.f8.1c.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:49

module 1 type jl320a
flexible-module A type JL081A
interface A1
   speed-duplex auto-100
   exit

Downgrade with CLI reboot command

Procedure

1. If the Smart Rate port speed configuration is auto-100, boot system flash primary command will
prompt user to change the auto-100 to other configuration.

switch# boot system flash primary
This will reboot the system from the primary image.
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Continue (y/n)? y
2. To proceed, select y.

Firmware downgrade is not allowed when smartrate port is configured with
auto-100. Please change the speed-duplex to other configuration.

3. To reject, select n.

Downgrade without CLI reboot command (power cycle)

Procedure

1. Reboot with auto-100 mode configuration on Smart Rate port, the following events occur:

a. The speed duplex status is shown blank when you execute the show interface brief command.

b. The port status is displayed as down.

2. Save the configuration and again reboot. The preconfigured auto-100 restores the Smart Rate port to auto
mode, thus restoring its functionality.
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Glossary
Acronym Definition

ACL Access Control List

AMP AirWave Management Platform

AP Access Point

BYOD Bring Your Own Device

BPS Backplane Stacking

CoA Change of Authorization

CLI Command Line Interface

CPPM ClearPass Policy Manager

DHCP Dynamic Host Configuration Protocol

DoS Denial-of-Service

EWA Enhanced Web Authentication

IP Internet Protocol

HA High Availability

HMAC-SHA1 Hash-based Message Authentication Code used with
the SHA-1 cryptographic hash function.

HTTP Hypertext Transfer Protocol

HTTPS Secure Hypertext Transfer Protocol

ID Identifier

IP Internet Protocol

Table Continued

Appendix E
Glossary
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Acronym Definition

L3 The third, or routing, layer of the open systems
interconnection (OSI) model. The network layer routes
data to different LANs and Wide Area Networks
(WANs) based on network addresses.

LAN Local Area Network

MAC Media Access Control

MAFR MAC Authentication Failure Redirect

MAS Management Interface Specification

NMS Network Management System

PVOS ArubaOS-Switch Operating System

RADIUS Remote Authentication Dial In User Service

SNMP Simple Network Management Protocol

VLAN Virtual Local Area Network

VSA Vendor Specific Attribute

ZTP Zero Touch Provisioning
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PROTOCOLS AND FEATURES ARUBA 5400R ARUBA 3810M ARUBA 3800 ARUBA 2930M ARUBA 2930F ARUBA 2920 ARUBA 2540 ARBUA 2530
Max_Vlan 4094 4094 4094 2048 2048 1022 512 512

Max_Vlan_IPv4 1024 1024 1024 1024 512 512 512 512

Max_Vlan_IPV6 512 512 512 512 512 256 512 512

Max_Vlan_mixed IPv4 & IPV6(dual stack) 1024 1024 1024 512 512 512 512 512

Multinetting per Vlan for   IPV4 or IPV6 32 32 32 32 32 32 32 32

Max_IPV4 and IPv6 Multinetting 2048 2048 2048 2048 2048 2048 2048 2048

DHCP Server Vlans 512 512 512 512 512 256 256 N/S

DHCP Pool limit 512 512 128 128 128 128 64 N/S

Maximum DHCP Relay helper address for 

IPV4

16 16 16 16 16 16 16 16

Maximum DHCP Relay helper address for  

IPV6 and Mixed (IPV4 & IPV6)

Per   Vlan 32 Per   Vlan 32 Per   Vlan 32 Per Vlan 32 Per   Vlan 32 Per   Vlan 32 per vlan 32 Per   Vlan 32

DHCP Snooping and DHCP V6 Snooping Max   binding 8192 Max   binding 8192 Max   binding 8192 Max binding 8192 Max binding 8192 Max   binding 8192 max binding 8192 Max binding 8192

IPV6_ND_Snooping clients Max   binding  16384 (Global 

IPv6 address + Link local 

Ipv6 address)

Max   binding  16384 (Global IPv6 

address + Link local Ipv6 address)

Max   binding  16384 (Global 

IPv6 address + Link local Ipv6 

address)

Max   binding  16384 

(Global IPv6 address + 

Link local Ipv6 address)

Max   binding  16384 

(Global IPv6 address + Link 

local Ipv6 address)

Max   binding  16384 

(Global IPv6 address + 

Link local Ipv6 address)

Max   binding  16384 

(Global IPv6 address + 

Link local Ipv6 address)

NS

IPv6-ND Snooping Per   Vlan 32 Prefixlist Per   Vlan 32 Prefixlist Per   Vlan 32 Prefixlist Per Vlan 32 Prefixlist Per Vlan 32 Prefixlist Per   Vlan 32 Prefixlist Per   Vlan 32 Prefixlist NS

DIPLD and DIPLD V6 64   Lock down entries per 

hardware

64   Lock down entries per hardware 64   Lock down entries per 

hardware

64 Lock down entries per 

hardware

64 Lock down entries per 

hardware

64   Lock down entries per 

hardware

64   Lock down entries 

per hardware

64   Lock down entries per 

hardware

DLDP 5406R - up to 144 ports

5412R - up to 288 ports

Based   on switchport Based   on switchport Based on switchport Based on switchport Based   on switchport Based   on switchport Based   on switchport

UDLD 5406R - up to 144 ports

5412R - up to 288 ports

Based   on switchport Based   on switchport Based on switchport Based   on switchport Based   on switchport Based   on switchport Based   on switchport

LLDP over OOBM 128   neigbours 128   neigbours 128   neigbours 128 neighbors Not Supported 128   neigbours Not Supported Not Supported

ACL & ACE IPv4 2048   ACL &8192 ACE 2048   ACL &8192 ACE 2048   ACL &8192 ACE 1024 ACL & 4096 ACE 1024 ACL & 4096 ACE 256 ACL & 512 ACE 256 ACL & 2048   ACE 256 ACL (YA), 255 ACL (YB) & 

2150 ACE (YA), 1638 (YB)

ACL & ACE IPv6 2048   ACL &8192 ACE 2048   ACL &8192 ACE 2048   ACL &8192 ACE 1024 ACL & 4096 ACE 1024 ACL & 4096 ACE 256 ACL & 512 ACE 256 ACL & 2048   ACE 128 ACL (YA), 1075 ACE (YA) & 

Not supported (YB)

Mac ACL  2048   ACL & 8192 ACE 2048   ACL & 8192 ACE 2048   ACL & 8192 ACE 1024 ACL & 4096 ACE 1024 ACL & 4096   ACE NS 256 ACL & 2150   ACE NS

Dot1x 32   Clients per port 32   Clients per port 32   Clients per port user based 32 Clients per port 32   Clients per port 32   Clients per port 32   Clients per port 32   Clients per port

Port Based   MAC Authentication  64K 64K 64K 64K 64K 16K 16K 16K

Mac-auth 256 address per   port 256   address per port 256   address per port user 

based

256 address per port 256 address per port 32   address per port 32   address per port 32   address per port

Web-auth 256   Clients per port 256   Clients per port 256   Clients per port user based 256 Clients per port 256 Clients per port 32   Clients per port 32   Clients per port 32   Clients per port

Port-security 64   address per port 64   address per port 64   address per port 64 address per port 64   address per port 64   address per port 64   address per port 64   address per port

PVST Instances 400 400 400 128 128 64 32 32

MSTP Instances for stacking devices N/A 4 4 4 N/A 4 N/S N/S

MSTP Instances 64 64 64 16 16 16 16 16

ARP Throttle blacklist limit 8192 8192 8192 8192 8192 8192 8192 NS

ARP protection  8192 8192 8192 8192 8192 8192 8192 8192

ARP Throttle exclude Mac address limit 10 10 10 10 10 10 10 NS

Static Route Interface based 256 256 256 256 256 256 256 256

Static Route gateway based 1024 1024 1024 256 256 256 256 256

OSPFv2 routes 10000 10000 10000 200 200 200 NS NS

OSPFv2 Area ID 16 16 16 1 1 1 NS NS

OSPFv2 interface 128 128 128 8 8 8 NS NS

OSPFv3 routes 5000 5000 5000 200 200 200 NS NS

OSPFv3 Area ID 16 16 16 1 1 1 NS NS

OSPFv2 peers 128 128 128 128 128 128 NS NS

OSPFv3 peers 128 128 128 128 128 128 NS NS

OSPFv3 Interface 128 128 128 8 8 8 NS NS

VRRP - VR's per Vlan 32 32 32 16 NS NS NS NS

VRRP - VR's 512 512 512 128 NS NS NS NS

VRRP-IPv6 VR's per Vlan 32 32 32 16 NS NS NS NS

VRRP - IPv6 VR's 512 512 512 128 NS NS NS NS

Static-Mac 500 500 500 500 500 500 500 500

RIP routes 10000 10000 10000 10000 10000 10000 2000 NS

RIP peers 128 128 128 128 128 128 32 NS

RIP interface 128 128 128 128 128 128 32 NS

RIPng routes 5000 5000 5000 5000 5000 NS 2000 NS

BGP routes 10000 10000 10000 NS NS NS NS NS

BGP max Peers 10000 32 32 NS NS NS NS NS

sflow instances 3 3 3 3 3 3 3 3

local mirror Session 4 4 4 4 4 1 1 1

remote mirror session 4 4 4 4 4 NS NS NS

remote mirror end point 32 32 32 32 32 NS NS NS

NTP Server 8 8 8 8 8 8 8 8

PVLAN 32 32 32 32 32 16 NS NS

PIM Interface 128 128 128 16 NS NS NS NS

OpenFlow Instance 128 128 128 16 16 16 NS NS

OpenFlow Rules 65535 65535 65535 16000 16000 16000 NS NS

Cert Manager TA Prfile numbers 10 10 10 10 10 10 10 10

Telnet/SSH-Sessions 5 5 5 5 5 5 5 5

RBAC Authorization Groups 64 64 64 64 64 64 64 64

MVRP 512Vlan's/128Ports 512Vlan's/128Ports 512Vlan's/128Ports 512Vlan's/128Ports 512Vlan's/128Ports 512Vlan's/128Ports 512Vlan's/128Ports 512Vlan's/128Ports

VSF 8   x 10G(V3 only) NS NS NS Not Supported for   

spokane

NS NS NS

2   x 40G(V3 only) Not Supported for Ukiah Not Supported for   

spokane

NS NS

ZTP 1   NMS 1   NMS 1   NMS 1 NMS 1   NMS 1   NMS 1   NMS 1   NMS

IGMP dynamic filter (IGMP multicast groups) 2038 2038 2038 1023 1023 1023 1013   dynamic filters + 

10 static filters

502

MLD dynamic filter 2037  2037   2037 1023 1023  1023  502 

BFD Sessions 128 128 128 NS NS NS NS NS

RBAC Rules Per Group 1000 1000 1000 1000 1000 1000 1000 1000

Schedule Job 1000 1000 1000 1000 1000 1000 1000 1000

MDNS Max Vlans per profile 10 10 10 10 10 10 5 5

MDNS Max Profiles 50 50 50 50 50 50 25 25

MDNS Max Rules per profile 15 15 15 15 15 15 15 15

MDNS Max gateway vlans 4094 4094 4094 2048 2048 1022 512 512

IPSLA Responder 10 10 10 10 10 10 N/S N/S

IPSLA sessions 50 50 50 50 50 50 N/S N/S

Stacking NS 10   Members 10   Members 10 Members NS 4   Members NS NS

SNMP Community Strings 5 5 5 5 5 5 5 5

SNMP Trap Receivers 10 10 10 10 10 10 10 10

MAS Device profiles 5 5 5 5 5 5 5 5

MAC address table entries  64K 64K 64K 64K 64K 16K 16K 16K

 ARP table entries for IPv4 and IPv6  25000  25000  25000 25000  25000  25000  1000

REST API Sessions 5 5 5 5 5 5 5 5

Classifiers (qos Policies ) 3072   Policies 3072   Policies  1024   Policies  1152  Policies 1152  Policies  256 Policies NS NS

Classifiers (user Policies ) NS NS NS 1152  Policies NS 256 256 256

Classifiers (Classes ) 3072  IPv4 and IPv6 Classes 3072  IPv4 and IPv6 Classes 1024  IPv4 and IPv6 Classes 1151  IPv4 and IPv6 

Classes

1151  IPv4 and IPv6 

Classes

256    IPv4 and IPv6 

Classes, total

255 255

Classifiers (Class entriess ) 8192   Class entries 8192   Class entries 3072   Class entries 3070 entries 3070 entries 254   class entries 2046 2046

TrustQOS 5406R - up to 144 ports

5412R - up to 288 ports

Based   on switchport Based   on switchport Based   on switchport Based   on switchport Based   on switchport Based   on switchport Based   on switchport (YA only)

8k   entries shared per line 

card

8k   entries shared per line card 8k   entries shared per line card 8K entries shared per line 

card

8k   entries shared per line 

card

2k   entries shared per line 

card

2k   entries shared per 

line card

2k   entries shared per line card

Service Insertion intercept tunnel 16 16 16 16 16 16 16 NS

Service Insertion tap tunnel 4 4 4 4 4 4 4 NS

VXLAN tunnel 64 64 N/A 64 64(V3 only) N/A NS NS

VxLAN Virtual network 64 64 N/A 64 64(V3 only) N/A NS NS

Tunnel node 5406R - up to 144 ports

5412R - up to 288 ports

512 -  VSF

32 clients per port 

1024 clients per switch

 512 stacked

32 clients per port 

1024 clinents per switch

 512 stacked

32 clients per port 

1024 clinents per switch

520 stacked

32 clients per port 

1024 clinents per switch

 192 stacked

32 clients per port 

1024 clinents per switch

 208 stacked

32 clients per port 

1024 clinents per switch

NS NS
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This guide provides information on OpenFlow configuration and administration, OpenFlow command syntax
descriptions, and troubleshooting actions.

Applicable products
This guide applies to these products:

Aruba 2920 Switch Series (J9726A, J9727A, J9728A, J9729A, J9836A)

Aruba 2930F Switch Series (JL253A, JL254A, JL255A, JL256A, JL258A, JL259A, JL260A, JL261A, JL262A,
JL263A, JL264A, JL557A, JL558A, JL559A)

Aruba 2930M Switch Series (JL319A, JL320A, JL321A, JL322A, JL323A, JL324A)

Aruba 3810 Switch Series (JL071A, JL072A, JL073A, JL074A, JL075A, JL076A)

Aruba 5400R zl2 Switch Series (J9821A, J9822A, J9850A, J9851A, JL001A, JL002A, JL003A, JL095A)

Switch prompts used in this guide
Examples in this guide are representative and may not match your particular switch/environment. Examples use
simplified prompts as follows:

Prompt Explanation

switch# # indicates manager context (authority).

switch> > indicates operator context (authority).

switch(config)# (config) indicates the config context.

switch(vlan-x)# (vlan-x) indicates the vlan context of config, where x
represents the VLAN ID. For example:
switch(vlan-128)#.

switch(eth-x)# (eth-x) indicates the interface context of config,
where x represents the interface. For example:
switch(eth-48)#.

switch-Stack# Stack indicates that stacking is enabled.

switch-Stack(config)# Stack(config) indicates the config context while
stacking is enabled.

switch-Stack(stacking)# Stack(stacking) indicates the stacking context of
config while stacking is enabled.

switch-Stack(vlan-x)# Stack(vlan-x) indicates the vlan context of config
while stacking is enabled, where x represents the
VLAN ID. For example: switch-
Stack(vlan-128)#.

switch-Stack(eth-x/y)# Stack(eth-x/y) indicates the interface context of
config, in the form (eth-<member-in-stack>/
<interface>). For example: switch(eth-1/48)#

Chapter 1
About this guide
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This document provides the following:

• General steps for OpenFlow configuration and administration

• OpenFlow command syntax descriptions, including show commands

• OpenFlow troubleshooting commands and debug actions

NOTE: This document covers only the additional features and commands for administering
OpenFlow on certain switches that use software version 15.10 or later.

About OpenFlow
OpenFlow is a programmable open-standard network protocol that uses flexible matching rules to classify and
manage network traffic into flows. OpenFlow defines a set of actions that network devices can take to manage
these flows. An OpenFlow controller defines and communicates policies to specify traffic behavior on OpenFlow
switches. OpenFlow separates the control plane (that decides how traffic must be forwarded) from the data plane
(that implements how traffic is forwarded.)

OpenFlow is based on an Ethernet switch with internal flow-tables and a standardized interface to add and
remove flow entries via an external controller.

OpenFlow is a software environment that allows for experimentation of networking protocols and traffic flows
without interrupting the operation of a production network. OpenFlow traffic can be separated from the rest of the
traffic on the network per VLAN so that OpenFlow does not impact non-OpenFlow traffic.

Chapter 2
Introduction
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OpenFlow implementation on switches separates OpenFlow traffic and non-OpenFlow traffic with OpenFlow
instances. Traffic within an OpenFlow instance does not influence or degrade non-OpenFlow traffic. OpenFlow
configuration commands are applied per-instance.

Figure 1: OpenFlow switches and controller

HPE implementation complies with OpenFlow Switch Specification v1.0.0 (December 31, 2009.) With the K/KA.
15.14, KB.15.15 (for the 5400R), KB.16.01 (for the 3810M), WB.15.14 and WC.16.02 releases, switches support
OpenFlow Switch Specification v1.3.1 (September 2012). For implementation limitations with respect to the
supported specifications, see Supported RFCs and standards on page 14.

For more information, see the Open Networking Foundation website at https://www.opennetworking.org/.

OpenFlow architecture
OpenFlow can be configured to separate non-OpenFlow traffic from OpenFlow traffic. An OpenFlow instance can
either be in the Virtualization or Aggregation Mode.

The communication channel between the OpenFlow Controller and the OpenFlow switch traverses the control-
plane to communicate data and rules about how OpenFlow instances should operate. The OpenFlow instances/
VLANs are the data-plane, which is where the OpenFlow rules are applied. Administrators must ensure that
control-plane traffic does not traverse the data-plane, to avoid data-plane outages or other issues.

Virtualization mode
Virtualization mode allows non-OpenFlow VLANs and VLANs that belong to OpenFlow instances to be configured
on the switch. Each OpenFlow instance is independent and has its own OpenFlow configuration and OpenFlow

10 Aruba OpenFlow 1.3 Administrator Guide for ArubaOS-Switch
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controller connection. An OpenFlow instance in virtualization mode must have a VLAN associated as a member
VLAN.

Figure 2: Virtualization mode

Aggregation mode
In Aggregation mode, all VLANs in the switch are part of an OpenFlow instance. The exception is the
management VLAN and a VLAN that communicates to the controller. Similar to a lab environment the OpenFlow
controller manages all the switching and routing for the switch.

Chapter 2 Introduction 11
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NOTE: When Aggregation is configured, only OpenFlow traffic passes through the switch.
Aggregation mode and virtualization mode are mutually exclusive (that is, virtualization mode cannot
be configured when aggregation mode is configured and conversely).

Figure 3: Aggregation mode

Figure 4: Example network with production non-OpenFlow, production OpenFlow, and experimental OpenFlow

12 Aruba OpenFlow 1.3 Administrator Guide for ArubaOS-Switch
16.0x

Anexo 06 ITENS 8 E 9 (0592717)         SEI 0008478-63.2018.6.02.8000 / pg. 7385



OpenFlow features and benefits
• With the addition of OpenFlow Specification 1.3, the following features are supported:

◦ Multiple Flow tables

◦ Pipeline processing

◦ Custom pipeline processing

◦ Multi-VLAN instances

◦ Groups in hardware

◦ OpenFlow physical, logical, and reserved ports

◦ Version negotiation

◦ Group tables

◦ Auxiliary connections

◦ OpenFlow Extensible Match (OXM)

◦ Multiple controllers

◦ Support for IPv6 flows

• OpenFlow switch side configuration enables the user to:
◦ Enable or disable OpenFlow

◦ Create OpenFlow instances and configure controller connections

◦ Display OpenFlow related configuration

◦ Availability of Config support to retain OpenFlow configuration across a reboot

• OpenFlow supports high availability:
◦ The OpenFlow flow table is preserved across Management Module failover

◦ The OpenFlow configuration is synced from the AMM (Active Management Module) to the SMM (Standby
Management Module).

• OpenFlow includes tools for limiting resources:
◦ Support for limiting the percentage of policy engine and IP control table resources used by OpenFlow

◦ Support for rate-limiting the amount of OpenFlow traffic sent to the controller

◦ Support for rate-limiting the amount of OpenFlow traffic that gets forwarded by the policy engine rules
programmed by OpenFlow

• OpenFlow modes of operation:
◦ Support for hardware-only mode where only flows that can be programmed into hardware are accepted

from the controller.

◦ Support for active mode (default) where new flows are sent to the controller by the switch.

◦ The switch normally handles support for passive mode where new flows no longer are sent to the controller.

IPv6 and OpenFlow

Chapter 2 Introduction 13
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Directing IPv6 traffic using OpenFlow is supported beginning with OpenFlow Specification 1.3. For more
information on configuring IPv6 on switches, see the IPv6 Configuration Guide for your switch.

Administrative methods
This document provides the HPE CLI commands for configuring and administering HPE OpenFlow switches.

The HPE VAN SDN controller has utilities for monitoring, administering, and troubleshooting OpenFlow switches.
These utilities can show the current state of a switch that supports OpenFlow, including features, configuration,
and table entries. Other controllers have similar utilities; for example, the OpenvSwitch controller distribution
includes the utility ovs-ofctl.

Supported RFCs and standards
Switches support OpenFlow Switch Specification, version 1.0.0 (December 31, 2009) from the Open Networking
Foundation, https://www.opennetworking.org/ with some differences.

Unsupported features:

• TABLE action.

• The “enqueue” action per the specification.

• Handling of IP Fragments: OFPC_IP_REASM/OFPC_FRAG_REASM.

• The flow emergency cache implementation.

• OpenFlow 0.8.2 - SSL controller connection.

• OpenFlow 0.8.9 - Explicit handling of IP fragments: OFPC_IP_REASM.

• OpenFlow 0.8.9 - 802.1D Spanning Tree: OpenFlow does not allow full interaction with the switch Spanning
Tree. OpenFlow is confined to the switch Spanning Tree.

• OpenFlow 0.9 - Emergency Flow Cache.

• OpenFlow 0.9 - Barrier Command.

• OpenFlow 1.0 - Slicing. The hardware cannot support the slicing specification. HPE provides its own QoS API
instead.

Hardware acceleration limitations:

All flows cannot be executed in the switch hardware, because of hardware limitations. Flows not executed in
hardware are processed in switch software, which is a slower path.

Switches support OpenFlow Switch Specification, version 1.3.1 (September 2012) from the Open Networking
Foundation, https://www.opennetworking.org/ with some differences.

Unsupported features:

• OFPP_TABLE action.

• Set-Queue action.

• Handling of IP Fragments: OFPC_IP_REASM/OFPC_FRAG_REASM.
◦ Push-MPLS, Set MPLS TTL, Decrement MPLS TTL actions

◦ Push-PBB action
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◦ Copy TTL outwards, Copy TTL inwards actions

◦ Set queue action

• Some commands for port modification from a controller:
◦ OFPPC_NO_STP

◦ OFPPC_NO_RECV

◦ OFPPC_NO_RECV_STP

◦ OFPPC_NO_FWD

NOTE: When port modification commands are sent from the controller, an error message is
returned to the controller: OFPET_PORT_MOD_FAILED.

Hardware differences between v1 and v2 Modules affect feature functionality, see Flow classification on v1, v2,
and v3 modules on page 117 for details.

Interoperability
Table 1: Switch features and interoperability with OpenFlow — by effect on feature or
application

Effect Feature

Feature can override OpenFlow 1 802.1X

MAC Auth

MAC Lockout

MAC Lockdown

Port Security

Web Auth

Feature can override OpenFlow 2 ACLs – Port, VLAN, Router, IDM variants

IDM

Feature can override OpenFlow 3 Rate Limiting

If OpenFlow is used, the feature can be configured. Management VLAN

NOTE: Management VLAN feature can
be configured but it cannot be part of an
OpenFlow instance.

If OpenFlow is used, the feature cannot be configured.
4

Meshing

Q-in-Q

Table Continued
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Effect Feature

Remote Mirror Endpoint

Transparent Mode

OpenFlow can override this feature 5 DHCP Snooping

DHCPv4 client

DHCPv4 relay

DHCPv6 client

DNS

Ping

SNTP

Telnet client and server

TFTP

TimeP

Traceroute

BGP

OpenFlow can override this feature DHCPv6 relay

Dynamic ARP Protection

Dynamic IP Lockdown

IGMP Proxy

IGMPv2

IGMPv3

MLDv1

MLDv2

OSPFv2

OSPFv3

PIM-DM

PIM-SM

Table Continued
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Effect Feature

RIP

Static Multicast Routes

Static Routes

Virus Throttling

VRRP

OpenFlow does not affect this feature Support existing L2, L3, security, HA, QoS
functionalities

OpenFlow does not affect this feature6 Distributed Trunking

GVRP

LACP

Loop Protect

sFlow

UDLD

OpenFlow does not affect this feature 7 STP loop guard

BPDU guard

MSTP

RSTP

STP

PVST

1The authentication features still function in an OpenFlow instance and ports of an OpenFlow instance. The
security features take a first look at the packet before sending the packets to OpenFlow.
2Any ACL entry that sets a drop bit in hardware (TCAM) always wins over the TCAM entry to copy OpenFlow
traffic to the controller. Packets on an OpenFlow instance could then get dropped in hardware due to an ACL
entry. An OpenFlow controller is never able to see those packets.
3Rate Limiting may be applied to limit OpenFlow traffic as well as other traffic. OpenFlow uses a form of rate-
limiter to limit the OpenFlow traffic that gets to the CPU and to the controller.
4Enabling Meshing can break the distinction between OpenFlow VLANs and non-OpenFlow VLANs.
5
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• The OpenFlow controller could set up a flow to match a protocol header and an action to drop the matching
packets. This action could lead to the protocol packets never making it to the protocol handling code in the
software data path, causing the protocol to break on the OpenFlow instance.

• The OpenFlow controller could set up a flow to match a protocol header and a NORMAL action in software for
the matching packets. In such a case, OpenFlow removes the protocol packets in the software data path.
OpenFlow reintroduces the protocol packets after examining the software flow table. Though this action may
not break the protocol, it introduces an additional latency before the protocol running on the switch gets the
protocol packets.

6Protocol packets are not sent through the OpenFlow software data path.
7Port up or down events are sent to the controller to keep the controller aware of available ports on the switch.
OpenFlow cannot override STP, RSTP, or MSTP decisions.

NOTE: Following are the limitations when you enable OpenFlow and VxLAN together on the switch:

• When OpenFlow and VxLAN are enabled together on the same VLAN, the VxLAN tunnels are not
advertised as an OpenFlow port to the controller. The Controller cannot program rules with match
or output as VxLAN tunnels.

• When OpenFlow and VxLAN are enabled together on the switch but on different VLANs, all the
packets tagged as unknown destination by the switch are not executed as per the
OFPP_NORMAL action. Other OpenFlow actions such as output to a physical port or SI tap/
intercept tunnels work as expected.
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Configuration overview
1. Enable OpenFlow.

2. Configure OpenFlow instances.

3. Configure OpenFlow instance members.

4. Set OpenFlow instance mode.

5. Set Flow location.

6. Configure software and hardware rate limiting.

7. Configure listener ports.

8. Configure controller IP and port.

9. Configure policy engine resources.

Entering OpenFlow
Entering OpenFlow context
You can use the openflow command options from configuration level by entering the word openflow, or from
OpenFlow context level by typing the command option.

Syntax

openflow
Enters OpenFlow context

Entering OpenFlow instance context
You can use the instance <instance-name> command from configuration level by beginning the command
with openflow, or from OpenFlow instance context level by typing the command option.

Syntax

openflow instance <instance-name>
Enters OpenFlow instance context

instance-name

OpenFlow instance name

Preparing for configuration
Plan your network including production and OpenFlow VLANs, OpenFlow instances, OpenFlow controller ports,
listening ports, naming and numbering strategy.

Plan the number of VLANs configured for OpenFlow versus non-OpenFlow.

Chapter 3
Configuring OpenFlow
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OpenFlow works on an instance only when OpenFlow is enabled on the instance as well as globally on the
switch.

NOTE:

A maximum of 128 OpenFlow instances can be configured (16 on 2920 and 2930F switches).
By default, a maximum of 2048 VLANs are supported, but if you change the MAX VLANs to 4096,
OpenFlow supports all 4096 VLANs.
A maximum of 64000 OpenFlow rules can be added for 5400R/3810 (16000 for 2920 and 2930F).
A maximum of 128 controllers can be configured (16 for 2920 and 2930F).
A maximum software rate limit of 10000 pps can be configured (2000 for 2920 and 2930F).

Enabling or disabling OpenFlow
Enable or disable OpenFlow globally:

Syntax

openflow [enable | disable]

no openflow
enable

Enables OpenFlow globally.

disable
Disables OpenFlow globally.

NOTE: Using no openflow without any additional parameters deletes all OpenFlow configurations.
A warning message displays to confirm this command.

NOTE: OpenFlow parameters can be changed only with OpenFlow disabled. Instance parameters
cannot be changed when instance is enabled. To enable an instance, use the following command:

openflow instance <instance name> enable

Configuring OpenFlow instances
NOTE:

• Configuration changes are not allowed when instance is enabled. Disable the instance and make
instance-specific configuration changes.

• For a named instance to be enabled, a listen port or a controller, and a member VLAN must be
added to the instance.

• To enable an aggregate instance, a listen-port or a controller has to be added to the instance.

For more on Aggregation Mode, see Aggregation mode on page 11.

For more on Virtualization Mode, see Virtualization mode on page 10.
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Syntax

openflow instance {instance-name | aggregate} [enable | disable]

no openflow instance {instance-name | aggregate} enable
The no form of the command deletes all OpenFlow configurations for the instance.

instance-name

Creates an OpenFlow instance.

Instance names can have a maximum length of 32 case-insensitive alphanumeric characters, numerals, and
underscore.

aggregate
Creates an OpenFlow instance that includes all VLANs except the management VLAN and the OpenFlow
controller VLANs. See Aggregation mode on page 11 for details on the use of this parameter.

enable
Enables the named OpenFlow instance or aggregate.

disable
Disables the named OpenFlow instance or aggregate.

Configure table number for a flow table
This command is used to configure a table number for a flow table. If the table number is not configured, a default
value is given to the table. Table number configuration is supported only on standard-match pipeline-model.

If user does not configure table number for a given table, that table retains its default value.

If any table uses table number as 0, the default table 0 is not configured in the pipeline. In standard match
pipeline-model, user can configure either policy table or the first software table as table 0. When the software
table is configured as table 0, the OpenFlow pipeline has no H/W table at all.

Standard Match

Flow Table Table Number

Start 0

Policy Table 100

S/W Table 1 200

S/W Table 2 201

S/W Table 3 202

S/W Table 4 203
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Syntax

 openflow instance <instance-name> table-num
 no openflow instance <instance-name> table-num

switch(of-inst-t1)# table-num policy-table
Configure table number for flow tables.

policy-table
Specify the policy table number.

sw-table-#
Specify the software table 1 number.

<0-254>

Flow table number.

Flow policy table

switch(of-inst-t1)# table-num  policy-table
<0-254>               Flow table number.

switch(of-inst-t1)# table-num  sw-table-1 
 <0-254>               Flow table number.

switch(of-inst-t1)# table-num  sw-table-2 
<0-254>               Flow table number.

switch(of-inst-t1)# table-num  sw-table-3
 <0-254>               Flow table number.

switch(of-inst-t1)# table-num  sw-table-4 
 <0-254>               Flow table number.

 

Setting OpenFlow protocol version
Syntax

openflow instance <instance-name> version {1.0|1.3[only] }
Default version: 1.0

OpenFlow protocol version supported by the instance.

This command lets you choose which version of OpenFlow the instance will use to negotiate with the controller.
The command also allows for supported earlier versions of OpenFlow to be used in negotiation with the controller
unless the option only is specified. See Configure OpenFlow instance members on page 23.

OpenFlow instance mode
OpenFlow can work either in active or passive mode.

Active mode
New packets of a flow that the switch is not aware of are sent to the OpenFlow controller.
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Passive mode
There is one-way communication from the OpenFlow controller to the switch. Packets that do not match any
flow in the flow table on the switch are not sent to the controller. The switch normally handles such packets of
new flows.

NOTE: This option is applicable only for an OpenFlow version 1.0 instance.

This command sets operation mode for an OpenFlow instance.

Syntax

openflow instance <instance-name> mode {active | passive}
instance-name

Sets the mode for the named instance.

active
New flows are redirected to the controller for the instance.

passive
New flows are not sent to the controller for the instance.

Default: active

Configure OpenFlow instance members
• The same VLAN cannot be added as a member of multiple OpenFlow instances.

• The management VLAN cannot be added to an OpenFlow instance as a member VLAN.

• A Controller VLAN cannot be added to an OpenFlow instance as a member VLAN. For more information about
multi-VLAN , see Interoperability on page 15.

Syntax

openflow instance <instance-name> member vlan <vlan-id>
no openflow instance <instance-name> member vlan <vlan-id>
instance-name

Add a member to this OpenFlow instance.

vlan-id

Adds the VLAN to the named OpenFlow instance.

Configuration commands

Add member VLANs
Syntax

member vlan <vlan-id>
Used to add member VLANs to an instance.

Options
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no member vlan <vlan-id> removes <vlan-id> from the multi-vlan instance. The other VLANs
associated with the instance are still part of the instance. This command can take any of the following forms:

member vlan <vid1>
no member vlan <vid1>

member vlan vid1, vid2, vid3
no member vlan vid1, vid2, vid3

member vlan vid1 – vid3
no member vlan vid1 – vid3

member vlan vid1, vid3 – vid5, vid7
no member vlan vid1, vid3 – vid5, vid7

Add VLANs as members to OpenFlow instance
Syntax

openflow instance <instance-name> member vlan <VLAN-ID-LIST>
no openflow instance <instance-name> member vlan <VLAN-ID-LIST>
Add member VLANs to an OpenFlow instance. An aggregate instance is a special OpenFlow instance that
includes all the VLANs on the switch except the management VLAN and controller VLAN.

<instance-name>

OpenFlow instance name.

<VLAN-ID-LIST>

List of VLANs that are added as member VLAN for an OpenFlow instance.

OpenFlow instance member VLAN

switch(config)# openflow instance <t1> member vlan 4,45-90,120

switch(config)# show running-config
Running configuration:
; J9850A Configuration Editor; Created on release #KB.15.17.0000x
; Ver #07:ff.f7.fc.7f.ff.3f.ef:a3
hostname "switch-name"
module A type j9992a
module F type j9986a
snmp-server community "public" unrestricted openflow
controller-id 1 ip 10.20.30.42 controller-interface vlan 2
 instance "t1"
  listen-port
  member vlan 3,5-7,10,20,30
  controller-id 1
  version 1.3 only
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  flow-location hardware-only
  pipeline-model custom
  enable
  exit
enable
  exit

oobm
 ip address dhcp-bootp
 exit

vlan 1
 name "DEFAULT_VLAN"
 no untagged A1-A4,F23
 untagged A5-A21,F1-F22,F24
 ip address
 exit

vlan 2
 name "VLAN2"
 untagged F23
 ip address 10.20.30.40 255.255.255.0
 exit

vlan 3
 name "VLAN3"
 untagged A1-A4
 no ip address
 exit

vlan 5
 name "VLAN5"
 no ip address
 exit

vlan 6
 name "VLAN6"
 no ip address
 exit

vlan 10
 name "VLAN10"
 no ip address
 exit

vlan 30
 name "VLAN30"
 no ip address
 exit
no allow-v2-modules

switch(config)# show openflow
OpenFlow                                        : Enabled
EgressOnly Ports Mode            : Disabled

Instance Information

                                               No. of      No. of      OpenFlow
Instance Name                   Oper. Status   H/W Flows   S/W Flows   Version
-----------------------------   ------------   ----------   ---------   --------
t1                               Up            4             0          1.3 only
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Flow location
This command sets the location of flows for an instance or the aggregate. In hardware-only mode, flows are
programmed only in hardware. The flows are located in hardware and software by default.

Syntax

openflow instance <instance name> flow-location hardware-only
no openflow instance <instance name> flow-location hardware-only
instance-name

Sets flow location for the named instance.

hardware-only
Sets the location of flows to hardware-only.

Default: Software and hardware.

NOTE: If the flow cannot be added in hardware and the flow-location is set as hardware-only, an
error is returned to the controller.

Configuring listener ports
Configures an OpenFlow port to listen for incoming connections from an OpenFlow controller.

Syntax

openflow instance <instance name> listen-port [tcp port] [oobm]
no openflow instance <instance name> listen-port [tcp port] [oobm]
instance-name

Sets the listen-port for the named instance.

tcp-port

Specify the port to listen on.

Default: Port number 6633

Range: Port number 1024 - 65534

oobm
Configure to listen through the out-of-band management (OOBM) port. This configuration is applicable only
for switches that have a separate OOBM port.

Configuring a controller
Its IP address and connection port identifies a controller. Each OpenFlow instance can have up to three
controllers. OpenFlow controllers can be added or deleted using this command.

Syntax

openflow controller-id <id> [ip < ip-address >] [port < tcp-port >] controller-interface {vlan < vlan-id > | oobm}

no openflow controller-id <id>
id

OpenFlow controller identification number.
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If the controller is not in use by any OpenFlow instances, the no removes the identified controller.

Range: 1 - 128 (1 - 16 for 2920 and 2930F)

ip-address

OpenFlow controller IP address.

tcp-port

Optional: Specify the port through which to connect to a controller.

Default: 6633

Range: 1024 – 65534

controller-interface
The no form of the command with this parameter deletes the OpenFlow controller connection.

vlan-id

Connect to the OpenFlow controller through the identified VLAN.

NOTE: A VLAN that is a member of an OpenFlow instance cannot be added as an OpenFlow
controller interface.

oobm
Connect to the OpenFlow controller through the OOBM interface. Applicable only for switches that have a
separate out-of-band management (OOBM) port.

Associate OpenFlow instance with OpenFlow controller
Once the OpenFlow controller is set up, each instance must be associated to a controller.

Syntax

openflow instance <instance-name> controller-id <controller-ID>
no openflow instance <instance-name> controller-id <controller-ID>
Up to three controllers can be specified per OpenFlow instance.

The no removes the identified controllers.

instance-name

Sets controller for the named instance.

controller-ID

OpenFlow controller ID to be associated with the instance; up to three controllers per instance.

Example: Associating an OpenFlow instance with multiple controllers

To associate controllers 1, 5, and 100 to instance “test”, use the following commands:

switch (config)# openflow instance test controller-id 1
switch (config)#openflow instance test controller-id 5
switch (config)#openflow instance test controller-id 100

NOTE: When an OpenFlow controller is associated with an OpenFlow instance, it cannot be deleted.

Chapter 3 Configuring OpenFlow 27

Anexo 06 ITENS 8 E 9 (0592717)         SEI 0008478-63.2018.6.02.8000 / pg. 7400



Overriding the current exclusion list protocols
openflow instance
Syntax
openflow instance <INSTANCE-NAME> override-protocol
 [protocol-name]
      
Description

Control and view the state of OpenFlow exclusion list.

Options

802.1x

Allow OpenFlow to control 802.1x packets.

all

Allow OpenFlow to control all the protocols in this list.

bonjour

Allow OpenFlow to control BONJOUR packets.

dldp

Allow OpenFlow to control DLDP packets.

gvrp

Allow OpenFlow to control GVRP packets.

lacp

Allow OpenFlow to control LACP packets.

loop-protect

Allow OpenFlow to control LOOP-PROTECT packets.

mvrp

Allow OpenFlow to control MVRP packets.

none

Exclude all protocols in this list from being controlled.

pvst

Allow OpenFlow to control PVST packets.

smartlink

Allow OpenFlow to control Smartlink packets.

stp

Allow OpenFlow to control STP packets.

udld

Allow OpenFlow to control UDLD packets.

Usage
Switch (config)# openflow instance test override-protocol stp
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Example

switch(config)# openflow instance test override-protocol stp

WARNING: Overriding the protocol can also potentially lead to control packets
         of the protocol to bypass any of the security policies like ACL(s).
Continue (y/n)? y

switch(config)# show running-config

Running configuration:

; JL256A Configuration Editor; Created on release #WC.16.03.0000x
; Ver #0e:3f.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:97
hostname "switch-name"
module 1 type jl256a
snmp-server community "public" unrestricted
openflow
   controller-id 1 ip 10.20.30.42 controller-interface vlan 2
   instance "test"
      member vlan 1
      controller-id 1
      version 1.3 only
      override-protocol stp
      exit
   enable
   exit
vlan 1
   name "DEFAULT_VLAN"
   no untagged 32
   untagged 1-31,33-52
   ip address dhcp-bootp
   exit
vlan 2
   name "VLAN2"
   untagged 32
   ip address 10.20.30.40 255.255.255.0
   exit
activate software-update disable

switch(config)# show openflow instance test override-protocol

 Protocol       Override
 ------------   --------
 802.1x         No
 bonjour        No
 dldp           No
 gvrp           No
 lacp           No
 loop-protect   No
 mvrp           No
 pvst           No
 smartlink      No
 stp            Yes
 udld           No

no openflow instance
Syntax
no openflow instance <INSTANCE-NAME> override-protocol 
      
Description
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Add a protocol back to exclusion list.

Options

802.1x

Allow OpenFlow to control 802.1x packets.

all

Allow OpenFlow to control all the protocols in this list.

bonjour

Allow OpenFlow to control BONJOUR packets.

dldp

Allow OpenFlow to control DLDP packets.

gvrp

Allow OpenFlow to control GVRP packets.

lacp

Allow OpenFlow to control LACP packets.

loop-protect

Allow OpenFlow to control LOOP-PROTECT packets.

mvrp

Allow OpenFlow to control MVRP packets.

none

Exclude all protocols in this list from being controlled.

pvst

Allow OpenFlow to control PVST packets.

smartlink

Allow OpenFlow to control Smartlink packets.

stp

Allow OpenFlow to control STP packets.

udld

Allow OpenFlow to control UDLD packets.

Usage
procotcol-name switch# no openflow instance <INSTANCE-NAME> override-protcol
<PROTOCOL-NAME>

Example

switch(config)# openflow instance test override-protocol stp

WARNING: Overriding the protocol can also potentially lead to control packets
         of the protocol to bypass any of the security policies like ACL(s).
Continue (y/n)? y

switch(config)# show running-config

Running configuration:
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; JL256A Configuration Editor; Created on release #WC.16.03.0000x
; Ver #0e:3f.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:97
hostname "switch-name"
module 1 type jl256a
snmp-server community "public" unrestricted
openflow
   controller-id 1 ip 10.20.30.42 controller-interface vlan 2
   instance "test"
      member vlan 1
      controller-id 1
      version 1.3 only
      override-protocol stp
      exit
   enable
   exit
vlan 1
   name "DEFAULT_VLAN"
   no untagged 32
   untagged 1-31,33-52
   ip address dhcp-bootp
   exit
vlan 2
   name "VLAN2"
   untagged 32
   ip address 10.20.30.40 255.255.255.0
   exit
activate software-update disable

switch(config)# show openflow instance test override-protocol

 Protocol       Override
 ------------   --------
 802.1x         No
 bonjour        No
 dldp           No
 gvrp           No
 lacp           No
 loop-protect   No
 mvrp           No
 pvst           No
 smartlink      No
 stp            Yes
 udld           No
      

show openflow instance
Syntax
show openflow instance <INSTANCE-NAME> override-protocol
      
Description

View the current state of the exclusion list.

Example
switch# show openflow instance <INSTANCE-NAME> override-protocol

switch# show openflow instance <INSTANCE-NAME> override-protocol
Protocol              Override
 ------------          --------
 802.1x                No
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 all                   No
 bonjour               No
 dldp                  No
 gvrp                  No
 lacp                  No
 loop-protect          No
 mvrp                  No
 pvst                  No
 smartlink             No
 stp                   No
 traditional-pipeline  No
 udld                  No

openflow instance override-protocol all
Syntax
openflow instance <INSTANCE-NAME> override-protocol all

Description

Allow OpenFlow to control all the protocols.

Command context
Manager

Examples

switch#openflow instance test override-protocol all
WARNING: Overriding the protocol can also potentially lead to control packets
         of the protocol to bypass any of the security policies like ACL(s).
Continue (y/n)? y
switch(openflow)# show openflow instance test override-protocol
Protocol              Override
 ------------          --------
 802.1x                No
 all                   Yes
 bonjour               No
 dldp                  No
 gvrp                  No
 lacp                  No
 loop-protect          No
 mvrp                  No
 pvst                  No
 smartlink             No
 stp                   No
 traditional-pipeline  No

openflow instance override-protocol none
Syntax
openflow instance <INSTANCE-NAME> override-protocol none

Description

Exclude all protocols from being controlled.

Command context
Manager
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Examples

switch# openflow instance test override-protocol stp
Cannot add or remove individual protocols when "override-protocol all" is
 configured.
Un-configure the same using "override protocol none" to proceed.

switch(openflow)# openflow instance test override-protocol none
switch(openflow)# openflow insatnce test override-protocol stp
switch(openflow)# show openflow instance test override-protocol
 Protocol              Override
 ------------          --------
 802.1x                No
 all                   No
 bonjour               No
 dldp                  No
 gvrp                  No
 lacp                  No
 loop-protect          No
 mvrp                  No
 pvst                  No
 smartlink             No
 stp                   Yes
 traditional-pipeline  No
 udld                  No

Securing the connection between an OpenFlow instance
and the controller
Syntax

controller-id <controller-ID> secure
no controller-id <controller-ID> secure
secure

Initiates a TLS connection with the controller (TLS version 1.0 or greater.)

controller-ID

OpenFlow controller ID to be associated with the instance.

This command:

• Secures the instance controller main connection. This option is available for OpenFlow version 1.0 as well as
OpenFlow version 1.3.

• Supports CA signed certificates. For CA signed certificates, same ROOT certificate is used to sign both
controller and switch certificate.

• Supports mutual authentication.

Example

switch(openflow)# show openflow instance test
Configured OF Version         : 1.3 only
Negotiated OF Version         : 1.3
Instance Name                 : test
Data-path Description         : test
Administrator Status          : Enabled
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Member List                   : VLAN 3
Pipeline Model                : Standard Match
Listen Port                   : 6633
Operational Status            : Up
Operational Status Reason     : NA
Datapath ID                   : 000340a8f09e8600
Mode                          : Active
Flow Location                 : Hardware and Software
No. of Hardware Flows         : 6
No. of Software Flows         : 4
Hardware Rate Limit           : 0 kbps
Software Rate Limit           : 100 pps
Conn. Interrupt Mode          : Fail-Secure
Maximum Backoff Interval      : 60 seconds
Probe Interval                : 10 seconds
Hardware Table Miss Count     : NA
No. of Software Flow Tables   : 1
Egress Only Ports             : None
Table Model                   : Policy Engine and Software
Source MAC Group Table        : Disabled
Destination MAC Group Table   : Disabled

Controller Id Connection Status Connection State Secure Role
------------- ----------------- ---------------- ------ ------
1             Connected         Active           No     Equal

Configuring auxiliary connections
Syntax

openflow # auxiliary-connection <index> port <port-number> type [tcp] [udp]
Creates an auxiliary connection with a unique index which is later associated with the instance controller main
connection. Auxiliary connection uses the same source IP address and the datapath ID as the main connection.
The main connection auxiliary ID is set to zero, while the auxiliary connection ID is set to 1. Only one auxiliary
connection is supported per main connection and transport protocol options for auxiliary connections can be
either TCP or UDP.

The packets supported on an auxiliary channel are:

• OFPT_HELLO

• OFPT_ERROR

• OFPT_ECHO_REQUEST/ REPLY

• OFPT_FEATURES_REQUEST/REPLY

• OFPT_PACKET_IN

• OFPT_PACKET_OUT

The main use of an auxiliary connection is for transactions related to message of type: OFPT_PACKET_IN/
OFPT_PACKET_OUT.

Options
index

Unique identifier for an auxiliary connection. Range: 1-128 (16 for 2920 and 2930F)

port-number
Protocol port on which the controller can be reached.Range: 1024-65534
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tcp | udp
Type of transport protocol to be used.

NOTE: Auxiliary connections are terminated when the main connection goes down, or the user
closes it, or when the OpenFlow instance/openflow is disabled, or OpenFlow is globally disabled.

TLS is not supported for Auxiliary connections.

Example

switch(openflow)# auxiliary-connection 1 port 6633 type tcp
switch(openflow)# instance test
switch(of-inst-test)# controller-id 1 auxiliary-connection 1
switch(openflow)# show openflow instance test
 Configured OF Version         : 1.3 only
 Negotiated OF Version         : 1.3
 Instance Name                 : test
 Data-path Description         : test
 Administrator Status          : Enabled
 Member List                   : VLAN 3
 Pipeline Model                : Standard Match
 Listen Port                   : 6633
 Operational Status            : Up
 Operational Status Reason     : NA
 Datapath ID                   : 000340a8f09e8600
 Mode                          : Active
 Flow Location                 : Hardware and Software
 No. of Hardware Flows         : 6
 No. of Software Flows         : 4
 Hardware Rate Limit           : 0 kbps
 Software Rate Limit           : 100 pps
 Conn. Interrupt Mode          : Fail-Secure
 Maximum Backoff Interval      : 60 seconds
 Probe Interval                : 10 seconds
 Hardware Table Miss Count     : NA
 No. of Software Flow Tables   : 1
 Egress Only Ports             : None
 Table Model                   : Policy Engine and Software
 Source MAC Group Table        : Disabled
 Destination MAC Group Table   : Disabled

 Controller Id Connection Status Connection State Secure Role
 ------------- ----------------- ---------------- ------ ------
 1             Connected         Active           No     Equal

               Auxiliary               Auxiliary    Auxiliary
Controller Id Conn. index Auxiliary ID Conn. Status Conn. State   Type
------------- ----------- ------------ ------------ -------------- ----
1             1           1            Connected    Active         TCP

switch(openflow)# show running-config

openflow
   controller-id 1 ip 10.20.30.42 controller-interface vlan 2
   auxiliary-connection 1 port 6633 type tcp
   instance "test"
      listen-port
      member vlan 3
      controller-id 1 auxiliary-connection 1
      version 1.3 only
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      enable
      exit
   enable
   exit

Associating the auxiliary connection index with an
OpenFlow instance
Syntax

openflow instance <instance-name> controller-id <controller-id> auxiliary-connection <index>
<controller-id>

OpenFlow controller ID to be associated with the instance. Range: 1-128 (1-16 for 2920 and 2930F)

index
Auxiliary connection index. Range: 1-128 (1-16 for 2920 and 2930F)

NOTE: Only one auxiliary connection is supported per main controller connection.

Configuring number of software flow tables per instance
Syntax

openflow instance<instance-name> software-flow-table <number-of-software-tables>
Configures the number of software flow tables required for an instance.

<number-of-software-tables>
Set the number of software tables.

Default: 1

Range: 1–4

NOTE:

This command is applicable only for an OpenFlow version 1.3 instance.

OpenFlow instance connection interruption mode
Use this mode to set behavior when an OpenFlow instance on the switch loses connection with the controller.

Syntax

openflow instance <instance-name> connection-interruption-mode {fail-secure | fail-standalone}
no openflow instance <instance-name> connection-interruption-mode {fail-secure | fail-standalone}
fail-secure

If this OpenFlow instance on the switch loses connection with all controllers, packets and messages intended
for controllers are dropped. Flows continue to expire according to their time-outs.

Default: fail-secure
fail-standalone

If this OpenFlow instance on the switch loses connection with all controllers, legacy switching and routing
functions handle packets of new flows. Existing flows of this OpenFlow instance are removed.
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Setting maximum backoff interval for an instance
You can specify the maximum interval between two consecutive attempts to connect to a controller by an
OpenFlow instance. The interval between two consecutive attempts increases exponentially until it reaches the
specified value. All subsequent attempts use the specified value.

Syntax

openflow instance <instance-name> max-backoff-interval <seconds>
instance-name

OpenFlow instance name.

seconds

Maximum backoff interval time; Range: 1 — 3600

Default:

60

Configuring IP Control Table Mode
Depreciated syntax. See the command no pipeline-model {standard-match | ip-control |
custom}.

Syntax

openflow no ip-control-table-mode
Includes IP control table in the OpenFlow packet processing pipeline.

Configure OpenFlow controller ports
An OpenFlow controller is configured globally under OpenFlow context and associated with an instance under
instance context (see Entering OpenFlow instance context on page 19 for more information). OpenFlow
controller traffic cannot be “in-band” or transit on a VLAN managed by OpenFlow. It must transit on a VLAN not
managed by OpenFlow.

OpenFlow controller traffic and OpenFlow traffic can transit on the same port, as long as they use different
VLANs.

The VLAN chosen for OpenFlow controller traffic depends entirely on the IP address of the controller, and no
specific configuration is needed. Thus the switch must have a proper IP configuration, and the controller address
must be part of a subnet that is not on an OpenFlow VLAN.

For information on how to either manually assign an IP address to the switch or set it up to perform DHCP
queries, see the ‘Configuring IP Addressing’ chapter in the Basic Operation Guide for your switch.

Up to three OpenFlow controllers control each OpenFlow instance and each generates OpenFlow commands and
data flows between an OpenFlow switch and the controller.

Controller role change
The following messages are related to controller role change:

OFPT_ROLE_REQUEST
Message from controller to the switch to change or query its role.
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OFPT_ROLE_REPLY
Message sent in response to the OFPT_ROLE_REQUEST, returning the current role of the controller.

OFPT_SET_ASYNC
A controller, through this message can configure what asynchronous message notifications it wants to
receive.

OFPT_GET_ASYNC
Controller uses this message to retrieve the asynchronous configuration set using the OFPT_SET_ASYNC
message.

NOTE:

Whenever a connection is established between the switch and the controller, each controller starts in
the role, OFPCR_ROLE_EQUAL. The controller can query and change its role if necessary.

Controller roles
By operating in different modes, controllers can synchronize handoffs in a scenario where multiple controllers are
connected to the switch. Per the OpenFlow specification 1.3.1, a Controller can operate in one of the following
roles:

• Equal

• Master

• Slave

Equal
Equal is the default role for a controller. The controller has full access to the switch and is equal to other
controllers in the same role receiving all asynchronous messages from the switch (such as packet-in, flow-
removed). Controller-to-switch commands are sent and modified within this role.

Slave
A Slave controller has read-only access to the switch. The controller cannot receive switch asynchronous
messages except for Port-status messages. The controller is denied execution of the controller-to-switch
commands: OFPT_PACKET_OUT, OFPT_FLOW_MOD, OFPT_GROUP_MOD, OFPT_PORT_MOD and
OFPT_TABLE_MOD.

Master
The Master controller has full read-write access to the switch. Only one controller can be the Master at a
given time. When the role of a controller is changed to Master, the switch changes all other controllers that it
connects to, to a Slave role.

Syntax

To know the roles of controllers that a switch is connected to, use the following command:

show openflow instance <instance-name>
Example

switch(openflow)# show openflow instance test

Configured OF Version         : 1.3 only
Negotiated OF Version         : 1.3
Instance Name                 : test
Data-path Description         : test
Administrator Status          : Enabled
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Member List                   : VLAN 3
Pipeline Model                : Standard Match
Listen Port                   : 6633
Operational Status            : Up
Operational Status Reason     : NA
Datapath ID                   : 000340a8f09e8600
Mode                          : Active
Flow Location                 : Hardware and Software
No. of Hardware Flows         : 6
No. of Software Flows         : 4
Hardware Rate Limit           : 0 kbps
Software Rate Limit           : 100 pps
Conn. Interrupt Mode          : Fail-Secure
Maximum Backoff Interval      : 60 seconds
Probe Interval                : 10 seconds
Hardware Table Miss Count     : NA
No. of Software Flow Tables   : 1
Egress Only Ports             : None
Table Model                   : Policy Engine and Software
Source MAC Group Table        : Disabled
Destination MAC Group Table   : Disabled

Controller Id Connection Status Connection State Secure Role
------------- ----------------- ---------------- ------ ------
1             Connected         Active           No     Slave
2             Connected         Active           No     Master

Port modification
Port modification is used to change the characteristics of a port in an OpenFlow instance on the switch via the
controller. The controller sends an OFP_PORT_MOD message to the switch that can change the characteristics
of a specific port.

The following command checks the state of the port configuration for all ports of an instance.

Syntax

show openflow instance <instance-name> port-statistics
Example

switch(of-inst-t1)# show openflow instance t1 port-statistics
Number of Ports :1
Port 1/1        : Up
Status
Admin. Status     : Enabled        Flood    : Enabled
Receive           : Enabled        Forward  : Enabled
Packet_in         : Disabled
Statistics
Collisions        : 0
Rx Packets        : 0             TxPackets : 47
Rx Bytes          : 0             TxBytes   : 10718
Rx Dropped        : 0             TxDropped : 0
Rx Errors         : 0             TxErrors  : 0
Frame Errors      : 0
CRC Errors        : 0
Overrun Errors    : 0
Example: OpenFlow version 1.0

Wireshark Capture of a sample Port-Mod message for a 1.0 instance

OpenFlow Protocol
 Header
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  Version: 0x01
  Type: Port Mod (CSM) (15)
  Length: 32
  Transaction ID: 4
 Port Modification
  Port #: 5
   MAC Address: HewlettP_02:2c:bb (84:34:97:02:2c:bb)
Port ConfigFlags
.... .... .... .... .... .... .... ...0 = Port is administratively down: No (0)
.... .... .... .... .... .... .... ..0. = Disable 802.1D spanning tree on port: No (0)
.... .... .... .... .... .... .... .0.. = Drop non-802.1D packets received on port: No (0)
.... .... .... .... .... .... .... 0... = Drop received 802.1D STP packets: No (0)
.... .... .... .... .... .... ...1 .... = Do not include this port when flooding: Yes (1)
.... .... .... .... .... .... ..0. .... = Drop packets forwarded to port: No (0)
.... .... .... .... .... .... .0.. .... = Do not send packet-in msgs for port: No (0)
Port Config Mask
.... .... .... .... .... .... .... ...0 = Port is administratively down: No (0)
.... .... .... .... .... .... .... ..0. = Disable 802.1D spanning tree on port: No (0)
.... .... .... .... .... .... .... .0.. = Drop non-802.1D packets received on port: No (0)
.... .... .... .... .... .... .... 0... = Drop received 802.1D STP packets: No (0)
.... .... .... .... .... .... ...1 .... = Do not include this port when flooding: Yes (1)
.... .... .... .... .... .... ..0. .... = Drop packets forwarded to port: No (0)
.... .... .... .... .... .... .0.. .... = Do not send packet-in msgs for port: No (0)
Port Advertise Flags
.... .... .... .... .... .... .... ...0 = 10 Mb half-duplex rate support: No (0)
.... .... .... .... .... .... .... ..0. = 10 Mb full-duplex rate support: No (0)
.... .... .... .... .... .... .... .0.. = 100 Mb half-duplex rate support: No (0)
.... .... .... .... .... .... .... 0... = 100 Mb full-duplex rate support: No (0)
... .... .... .... .... .... ...0 .... = 1 Gb half-duplex rate support: No (0)
.... .... .... .... .... .... ..0. .... = 1 Gb full-duplex rate support: No (0)
.... .... .... .... .... .... .0.. .... = 10 Gb full-duplex rate support: No (0)
.... .... .... .... .... .... 0... .... = Copper medium support: No (0)
.... .... .... .... .... ...0 .... .... = Fiber medium support: No (0)
.... .... .... .... .... ..0. .... .... = Auto-negotiation support: No (0)
 .... .... .... .... .... .0.. .... .... = Pause support: No (0)
.... .... .... .... .... 0... .... .... = Asymmetric pause support: No (0)
Pad: 0
Pad: 0
Pad: 0
Pad: 0
Example: OpenFlow version 1.3

Wireshark Capture of a sample Port-Mod message for a 1.3 instance
OpenFlow Protocol
 Header
  Version: 0x04
  Type: Port Mod (CSM) (16)
   Length: 40
  Transaction ID: 4043243760 
  Port Modification
  Port #: 2
  Pad: 0
   Pad: 0
   Pad: 0
   Pad: 0
 MAC Address: HewlettP_02:2c:be (84:34:97:02:2c:be)
   Pad: 0
  Pad: 0
  Port ConfigFlags
.... .... .... .... .... .... .... ...0 = Port is administratively down: No (0)
.... .... .... .... .... .... .... ..0. = Disable 802.1D spanning tree on port: No (0)
.... .... .... .... .... .... .... .0.. = Drop non-802.1D packets received on port: No (0)
.... .... .... .... .... .... .... 0... = Drop received 802.1D STP packets: No (0)
.... .... .... .... .... .... ...0 .... = Do not include this port when flooding: No (0)
.... .... .... .... .... .... ..0. .... = Drop packets forwarded to port: No (0)
.... .... .... .... .... .... .1.. .... = Do not send packet-in msgs for port: Yes (1)
  Port Config Mask
.... .... .... .... .... .... .... ...0 = Port is administratively down: No (0)
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.... .... .... .... .... .... .... ..0. = Disable 802.1D spanning tree on port: No (0)

.... .... .... .... .... .... .... .0.. = Drop non-802.1D packets received on port: No (0)

.... .... .... .... .... .... .... 0... = Drop received 802.1D STP packets: No (0)

.... .... .... .... .... .... ...0 .... = Do not include this port when flooding: No (0)

.... .... .... .... .... .... ..0. .... = Drop packets forwarded to port: No (0)

.... .... .... .... .... .... .1.. .... = Do not send packet-in msgs for port: Yes (1)
 Port Advertise Flags
.... .... .... .... .... .... .... ...0 = 10 Mb half-duplex rate support: No (0)
.... .... .... .... .... .... .... ..0. = 10 Mb full-duplex rate support: No (0)
.... .... .... .... .... .... .... .0.. = 100 Mb half-duplex rate support: No (0)
.... .... .... .... .... .... .... 0... = 100 Mb full-duplex rate support: No (0)
.... .... .... .... .... .... ...0 .... = 1 Gb half-duplex rate support: No (0)
.... .... .... .... .... .... ..0. .... = 1 Gb full-duplex rate support: No (0)
.... .... .... .... .... .... .0.. .... = 10 Gb full-duplex rate support: No (0)
.... .... .... .... .... .... 0... .... = Copper medium support: No (0)
.... .... .... .... .... ...0 .... .... = Fiber medium support: No (0)
.... .... .... .... .... ..0. .... .... = Auto-negotiation support: No (0)
.... .... .... .... .... .0.. .... .... = Pause support: No (0)
.... .... .... .... .... 0... .... .... = Asymmetric pause support: No (0)
  Pad: 0
  Pad: 0
 Pad: 0
 Pad: 0   
Example

Send a Port-Mod command to the switch using dpctl, a controller utility.

root@openflow-ubuntu-10:/home/openflow# dpct ltcp:10.20.30.50:6633 port-desc

... {no="6", hw_addr="00:1b:3f:cf:76:fa", name="A6", config="0x0", state="0x1",
curr="0x0", adv="0x0", supp="0x0", peer="0x0", curr_spd="100000000kbps",
max_spd="100000000kbps"} ...

root@openflow-ubuntu-10:/home/openflow# dcptl tcp:10.20.30.50:6633 port-mod
port=6,addr=00:1b:3f:cf:76:fa,conf=0x40,mask=0x40

SENDING:
port_mod{port="6", hwaddr="00:1b:3f:cf:76:fa", config="0x00000040",
mask="0x40", adv="0x0"}
OK

root@openflow-ubuntu-10:/home/openflow# dcptl tcp:10.20.30.50:6633 port-desc
... {no="6", hw_addr="00:1b:3f:cf:76:fa", name="A6", config="0x40",
state="0x1", curr="0x0", adv="0x0", supp="0x0", peer="0x0",
curr_spd="100000000kbps", max_spd="100000000kbps"} ...

Port modification and OpenFlow versions
An OpenFlow 1.0 instance on the switch supports OFP_PORT_CONFIG, OFPPC_NO_FLOOD and
OFPPC_NO_PACKET_IN.

An OpenFlow v1.3 instance on the switch supports OFP_NO_FLOOD and OFPPC_NO_PACKET_IN.

NOTE:

If a port is not exclusive to the OpenFlow Member VLAN, a Port Modification message from the
controller results in an error returned to the controller.

Configuring egress-only ports
This CLI command enables or disables support for advertising egress-only ports to the controller. Ports that are
members of non-OpenFlow VLANs are egress-only ports. A controller can add a flow with an egress-only port as
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an output port to allow traffic to be forwarded from an OpenFlow VLAN to a non-OpenFlow VLAN. All instance
member ports and egress-only ports are exposed as instance ports to the controller.

Syntax

openflow egress-only-ports
egress-only-ports

Enable or disable support for advertising egress-only ports to the controller.

Ports that are members of non-OpenFlow VLANs are egress-only ports. A controller can add a flow with an
egress-only port as an output port to enable traffic to be forwarded from an OpenFlow VLAN to a non-OpenFlow
VLAN.

NOTE: Egress-only ports cannot be used as an “in-port” in any flow by a controller. If this usage is
attempted, the flow addition fails and an error message is returned to the controller.

Example

switch(openflow)# show openflow instance test

Configured OF Version         : 1.3 only
Negotiated OF Version         : 1.3
Instance Name                 : test
Data-path Description         : test
Administrator Status          : Enabled
Member List                   : VLAN 3
Pipeline Model                : Standard Match
Listen Port                   : 6633
Operational Status            : Up
Operational Status Reason     : NA
Datapath ID                   : 000340a8f09e8600
Mode                          : Active
Flow Location                 : Hardware and Software
No. of Hardware Flows         : 6
No. of Software Flows         : 4
Hardware Rate Limit           : 0 kbps
Software Rate Limit           : 100 pps
Conn. Interrupt Mode          : Fail-Secure
Maximum Backoff Interval      : 60 seconds
Probe Interval                : 10 seconds
Hardware Table Miss Count     : NA
No. of Software Flow Tables   : 1
Egress Only Ports             : None
Table Model                   : Policy Engine and Software
Source MAC Group Table        : Disabled
Destination MAC Group Table   : Disabled

Controller Id Connection Status Connection State Secure Role
------------- ----------------- ---------------- ------ ------
1             Connected         Active           No     Slave
2             Connected         Active           No     Master

NOTE: When the Egress-Only Ports option is enabled for OpenFlow on the switch, the Port-Mod
message for an egress-only port results in an error.

Software and hardware rate limiting
You can specify resource limits used by an OpenFlow instance. Each OpenFlow instance has independent rate-
limiters that can be set separately.
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Syntax

openflow instance <instance-name> limit {hardware-rate | software-rate}
instance-name

OpenFlow instance name.

hardware-rate

Limit the bandwidth that an OpenFlow instance can utilize. The hardware-rate is in kbps.

Range: 0 - 10,000,000

Default: 0

software-rate

Configure the OpenFlow instance packet rate limit. The software-rate is in pps.

Limits the number of packets per second per module that this instance can send to the software path.

Range: 0 - 10000

Default: 100

NOTE:

Increasing the software rate limit increases CPU consumption and may impact system
performance.

If the software rate limit is specified beyond 1000 pps, the following warning message is
displayed: Increasing the software rate limit would increase CPU
consumption and may impact the system performance.

Limiting the usage of hardware resources
Syntax

openflow limit {policy-engine-usage | ip-ctrl-table-usage | multiport-filter-usage} <max-percentage>
policy-engine-usage

Maximum percentage of policy engine resources used by OpenFlow.

ip-ctrl-table-usage
Maximum percentage of IP control table resources used by OpenFlow.

multiport-filter-usage
Maximum percentage of the multiport-filter resources used by OpenFlow.

You can limit the OpenFlow usage of policy engine resources, ip control table, and multiport filters so that other
functions that use the same resources are not impacted severely.

The limit can be set only when OpenFlow is disabled globally.

percentage

Specifying 0% allocates no resources for OpenFlow.

By default, the OpenFlow policy engine resource usage is set at 50% to avoid oversubscribing resources and
impacting performance. The policy engine resource can use Access Control Lists, Quality of Service, Identity
Driven Management, Virus Throttling, Mirroring, Policy Based Routing, and other features in addition to
OpenFlow.
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NOTE: The maximum percentage is not a guaranteed percentage but a maximum allowed limit.

To increase the number of flows beyond the default 50% setting, use the above OpenFlow limit policy-engine-
usage command. If all policy engine resources are in use, OpenFlow rules are no longer added in hardware
and the switch denies attempts to configure ACLs with the CLI. See “Monitoring Resources” in the latest
Management and Configuration Guide for your switch.

Default: 50%; Range: 0 - 100%

NOTE: Resource usage can be set only when OpenFlow is disabled.

Example

switch(openflow)# limit multiport-filter-usage
<0-100>                Enter a number.

switch(openflow)# show openflow multiport-filter-limit

Total Multiport Filters: 1039

              Filters      Filters       Filters
Features      Allocated    Used          Free
-----------   ----------   ------------  --------------
OpenFlow      519          1             518

Hardware statistics refresh interval
Syntax

openflow hardware-statistics refresh-interval policy-engine-table <seconds>
<seconds>

Refresh interval

Default: 20

Range: 0 - 3600

NOTE:

With value of 0, the hardware is no longer polled to update the statistics.

Custom table numbering
Enables a user to configure custom table numbers for tables in an OpenFlow pipeline. If the table number is not
configured, a default value is given to the table.

Syntax

openflow instance <instance-name> table-num policy-table <table-number>
no openflow instance <instance-name> table-num policy-table <table-number>
Configure custom table-number.

policy-table
Specify the policy table number.
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table-num
Specify the software table 1 number.

<0-251>
Flow table number.

Configure table number for flow tables.

switch(of-inst-t1)# table-num policy-table

Changing the table-number for a policy-table

switch(of-inst-t1)# table-num policy-table 1
switch(of-inst-t1)# enable
switch(of-inst-t1)# show openflow instance t1 flow-table

OpenFlow Instance Flow Table Information

Table                       Flow     Available Free   Miss    
ID    Table Name            Count    Flow Count       Count    Goto Table
----- --------------------- -------- ---------------- -------- ------------
0     Start                 1        NA               0        1
1     Policy Table          1        NA               0        200
200   SW Table              1        1                0        *
* Denotes that the pipeline could end here.

Policy table as the first table in the instance.

switch(of-inst-t1)# table-num policy-table 0
switch(of-inst-t1)# enable
switch(of-inst-t1)# show openflow instance t1 flow-table

OpenFlow Instance Flow Table Information

Table                       Flow     Available Free   Miss    
ID    Table Name            Count    Flow Count       Count         Goto Table
----- --------------------- -------- ---------------- ------------- ------------
0     Policy Table          1        NA               0             200
200   SW Table              1        1                NA            *
* Denotes that the pipeline could end here.

Software table as the first table in the instance.

switch(of-inst-t1)# disable
switch(of-inst-t1)# no table-num policy-table
switch(of-inst-t1)# table-num sw-table-1 0
switch(of-inst-t1)# enable
switch(of-inst-t1)# show openflow instance t1 flow-table

OpenFlow Instance Flow Table Information
Table                   Flow   Available Free Miss    
ID    Table Name        Count     Flow Count     Count     Goto Table
----- ----------------- ----  --------------- --------- ------------

Chapter 3 Configuring OpenFlow 45

Anexo 06 ITENS 8 E 9 (0592717)         SEI 0008478-63.2018.6.02.8000 / pg. 7418



0     SW Table          1     1               NA        *
* Denotes that the pipeline could end here.

Implementation notes
• Custom table numbering command is supported only on Standard match mode instances.

• This feature is not supported on OpenFlow v1.0 instances.

• Different OpenFlow instances can have different table numbers for a given table.

• A no version of the command restores the table number to its default value.

• Only policy-table and SW-table-1 can be configured as the first table in standard match mode pipeline.

• The default table numbers in a standard match mode instance are

Standard Match Mode

Flow Table Table Number

Start 0

Policy Table 100

Sw Table 1 200

Sw Table 2 201

Sw Table 3 202

Sw Table 4 203

Configuring VLANs
For information on configuring and verifying VLANs, see the Advanced Traffic Management Guide for your switch.

Configuring and verifying routing
For information on configuring and verifying routing, see the Multicast and Routing Guide for your switch.

Configuring physical and logical ports
For information on configuring and verifying ports, see the ‘Port Status and Configuration’ chapter in the
Management and Configuration Guide for your switch.

Pipeline configuration commands
Syntax

pipeline-model {standard-match | ip-control | custom}
no pipeline-model {standard-match | ip-control | custom}
Configure an OpenFlow instance pipeline model. By default, the instance is configured to use the standard-match
pipeline model.
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standard-match
Configure a standard-match pipeline model. The standard-match pipeline model enables an instance to
advertise its policy-engine and software tables.

ip-control
Configure an ip-control pipeline model. The ip-control pipeline model enables an OpenFlow version 1.3
instance to advertise its IP control table along with policy-engine and software tables.

custom
Configure a custom pipeline model. The custom pipeline model enables an OpenFlow controller to customize
an OpenFlow pipeline model for OpenFlow version 1.3 instance.

An instance without “pipeline-model” configured defaults to standard-match.

OpenFlow MAC group
MAC Group Tables allow the controller to apply the same policy to a set of users, differentiated by the source
MAC address, using a single rule in the policy table. This application is achieved by exposing the MAC CAM as a
separate table to controllers and allows controllers to create MAC groups.

OpenFlow pipeline
MAC group tables can be enabled for an OpenFlow instance in “standard match” mode or “ip control” mode. By
default, both source mac group table and destination mac group tables are disabled. These tables can be
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enabled in the pipeline by using the commands src-mac-grp-table or dest-mac-grp-table. The following
figures depict the various combinations of OpenFlow pipelines that an instance can have.

Figure 5: Standard match mode default pipeline

Figure 6: Standard match SRC enabled pipeline

Figure 7: Standard match DST enabled pipeline

Figure 8: Standard match SRC and DST enabled pipeline

IP control table pipeline
A single consolidated policy table combines “IP Match Policy Table”, “IP Miss Policy Table” and “Non-IP Policy
table”. “Policy table” in IP control table mode allows the controller to match on L3 match, L3 miss and L3 ignore.
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OpenFlow controller must program rules into policy table with metadata to achieve functionality. Table 3 illustrates
the values of metadata and metadata mask that must be programmed.

Figure 9: IP control destination MAC enabled pipeline

Figure 10: IP control source MAC enabled pipeline

Figure 11: IP control table default

Metadata
The controller must program rules with match on metadata to achieve functionality.

The following table illustrates the values of metadata and metadata mask with which these functionalities can be
achieved.

Table 2: Metadata

Metadata Metadata_mask

L3 match 1 1

L3 miss 0 1

L3 ignore 0 0

Non-IP

OpenFlow supports metadata, which is a maskable register value that is used to carry information from one table
to the next.
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OpenFlow metadata

For example, OFPXMT_OFB_METADATA is part of oxm_ofb_match_fields and is a 64-bit field. It is used to
pass information between lookups across multiple tables. This value can be arbitrarily masked. Out of 64 bits, the
current release is using 21 bits and the following table illustrates the interpretation of these bits.

Figure 12: OpenFlow metadata

• SRC MAC GRP
– 10 bits, which identifies the Source Mac Group ID

• DST MAC GRP
– 10 bits, which identifies the destination Mac Group ID

• L3 match
– 1 bit, which is used to identify L3 match/miss for IP control table mode.

The following table shows the values of Metadata_match and metadata_write bits advertised for a different table.

Table 3: Bits advertised

Table # Metadata_match Metadata_write

0 0 0

40 0 0x3FF (Bits 0 to 19)

(Bits 0 to 9 are used to write the src GUID for MAC)

41 0 0xFFC00 (Bits 10 to 19)

(Bits 0 to 9 are used to write the dst GUID for MAC)

50 0 0x100000 (Bit 20)

100 0x01FFFFF (Bits 0 to 20) 0

200 0 0
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NOTE: 

• Rules on the policy table must match on metadata, which in turn is mapped to a MAC‐group
(source/destination MAC).

• The policy table cannot match on a source MAC and destination MAC address separately when
MAC group tables are part of the pipeline.

• In L3 tables, rules can be added with instructions WRITE_METADATA/MASK and GOTO.

• On the policy table, the L3 match, the metadata, metadata_mask specified in the rule interprets
L3.

Command to configure source MAC group table on an instance
Enable the source MAC group table in the OpenFlow pipeline.

Syntax

openflow instance <instance-name> src-mac-grp-table
no openflow instance <instance-name> src-mac-grp-table
Enable the source MAC group table in the OpenFlow pipeline.

NOTE: The src-mac-grp-table is disabled by default.

Destination MAC group table on an instance
Enable the destination MAC group table in the OpenFlow pipeline

Syntax

openflow instance <instance-name> dest-mac-grp-table
no openflow instance <instance-name> dest-mac-grp-table
<instance-name>

OpenFlow instance name

NOTE: The dest-mac-grp-table is disabled by default.

Human readable data-path description
The OFPMP_DESC multipart response message allows an OpenFlow switch to specify a human readable text of
size 255 ASCII characters.

Syntax

Openflow instance <instance-name> datapath-desc <datapath text>
Set a name to the data-path description field in the OFPMP_DESC message. By default, the data path description
is set to the instance name.
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Set a name to the data-path description field

switch(of-inst-test)# datapath-desc dpid1
switch(of-inst-test)# show openflow instance test

Configured OF Version         : 1.3 only
Negotiated OF Version         : 1.3
Instance Name                 : test
Data-path Description         : dpid1
Administrator Status          : Enabled
Member List                   : VLAN 3
Pipeline Model                : Standard Match
Listen Port                   : 6633
Operational Status            : Up
Operational Status Reason     : NA
Datapath ID                   : 000340a8f09e8600
Mode                          : Active
Flow Location                 : Hardware and Software
No. of Hardware Flows         : 6
No. of Software Flows         : 4
Hardware Rate Limit           : 0 kbps
Software Rate Limit           : 100 pps
Conn. Interrupt Mode          : Fail-Secure
Maximum Backoff Interval      : 60 seconds
Probe Interval                : 10 seconds
Hardware Table Miss Count     : NA
No. of Software Flow Tables   : 1
Egress Only Ports             : None
Table Model                   : Policy Engine and Software
Source MAC Group Table        : Disabled
Destination MAC Group Table   : Disabled

Controller Id Connection Status Connection State Secure Role
------------- ----------------- ---------------- ------ ------
1             Connected         Active           No     Equal

Overriding the default drop action of tables.
As of 16.02, when an OpenFlow instance is enabled with version configured to 1.3 or 1.3 only, all the traffic
directed to the OpenFlow member VLAN is dropped. Overriding the default drop action of tables when installed by
a switch enabled in an OpenFlow instance version 1.3 (or 1.3 only) will normalize and minimize traffic loss. An
enable command overrides the action.

Operating notes

• This feature is supported on all three generations of ASIC — v1, v2, and v3.

• This feature is supported on all three pipeline-models — Standard-Match, IP-Control, and Custom.

• This behavior is applicable even when the controller is not connected to the instance except for output-
controller + version 1.3 where packets are forwarded normally until the OpenFlow handshake
completes.

• The default-miss actions are reinstalled after the controller connects and the instance exits the fail-
standalone mode.

Restrictions
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• This feature is available only for instances configured with version 1.3 or 1.3 only.

• The switch will not chain the pipeline and update the miss rule on the last table (except for the implicit rules
in Standard-Match and IP-Control pipeline-models). This default-miss-action will be applied on individual
tables.

◦ In standard-match, there is a miss rule on Table 0 which will still have the action as GOTO 100 irrespective
of the miss action set with this command.

◦ In ip-control, there are two miss rules, one on Table 0 that has action as GOTO 50 and the other on Table
50 that has action as GOTO 100. These two rules again will not be affected by the setting of this command.

Example

The actions are applicable only on tables that support it.

For example, for Table 0 of the standard-match pipeline, the default action will still be Goto-100.
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The OpenFlow meters are available on all products mentioned in the Applicable products section.

Meter types

Supports the following meter types:

• OFPMF_KBPS
• OFPMF_PKTPS

Meter bands and rates

Supports the following bands in meters:

• OFPMBT_DROP
• OFPMBT_DSCP_REMARK (not supported for v1 platforms)

Considerations for a meter band

• A minimum of one band is required.

• A single OpenFlow meter can have either one or two bands.

• Does not support two bands of type OFPMBT_DROP.

• The rate associated with the OFPMBT_DROP band must be higher than the rate associated with the
OFPMBT_DSCP_REMARK band.

• The precision level associated with an OFPMBT_DSCP_REMARK band must be less than or equal to seven.

• Modification of an existing meter is supported on instances running custom pipeline model. For instances
running Standard-match or IP-control pipeline model, you cannot modify an existing meter without the
OFPMBT_DSCP_REMARK band, with a meter having OFPMBT_DROP band and vice-versa.

Meter statistics, scale, and limitations
Meter statistics

For meter statistics, you can use both aggregated and per band packet and byte counters.

Meter scale

• Instances running pipeline model such as standard-match or custom use meters from different pools.

• 2046 is the global limit for number of meters for instances running pipeline model such as standard-match and
IP-control. All instances running in either of these two pipeline models use meters from this pool.

NOTE: The openflow limit policy-engine-usage command is used for determining the
meter scale. By default, a total of 1,022 meters are available (default value of policy-engine-usage
is 50%).

• The global limit of number of meters is 2,000 for instances running in custom pipeline model.

Chapter 4
OpenFlow Meters
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Meter limitations

• If the corresponding match does not have Ethernet type set to IPv4 or IPv6, the meter with a DSCP Remark
meter band will be rejected.

• For standard-match and IP-control pipeline models:
◦ Meters are not supported on software tables (200 to 203).

◦ OpenFlow rules with OFPIT_METER instruction having OFPMBT_DSCP_REMARK band is not supported with
OFPIT_GOTO_TABLE and OFPAT_OUTPUT to OFPP_CONTROLLER.
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Groups represent sets of actions for flooding as well as more complex forwarding semantics (for example,
multipath, fast reroute, and link aggregation). As a general layer of indirection, groups also enable multiple flow
entries to forward to a single identifier (for example, IP forwarding to a common next hop). This abstraction allows
common output actions across flow entries to be changed efficiently.

The group table contains group entries; each group entry contains a list of action buckets with specific semantics
dependent on group type. The actions in one or more action buckets are applied to packets sent to the group.
There are four types of groups:

1. All. All the action buckets in the group are executed when a packet hits the group table.

2. Select. Execute any one action bucket in the group. The switch implementation uses round-robin to select the
action bucket to be executed. OpenFlow specification defines a weight mechanism to do load sharing.
However, this weight mechanism is not supported in the switch implementation. The weight MUST be given as
1. For all the other groups, weight MUST be specified as 0.

3. Indirect. Execute the one defined bucket in this group. This group supports only a single bucket.

4. Fast failover. Execute the first live bucket. The buckets are evaluated for liveness in the order defined by the
group.

Group type ALL
The OpenFlow group type ALL is supported in both hardware and software. The capabilities are:

• Executes all the action buckets in the group.

• Supports groups in hardware, if each group bucket has only a single output port action.

NOTE: If a bucket has more than one instance of an output action or any other action, the bucket
is installed on software instead of hardware.

• Virtual ports other than OFPP_FLOOD are not supported in hardware group buckets.

• Tunnel ports are not supported in group buckets of both hardware and software.

Group type SELECT
The OpenFlow group type SELECT is supported only in software. The capabilities are:

• Executes any one action bucket in the group.

• Uses round-robin to execute any one action bucket in the group.

• Defines weight mechanism for load sharing as per the OpenFlow specification. However, the weight
mechanism is not available in the switch implementation. By default, set the weight as one for group type
SELECT. For all other groups, the weight is zero.

Group Type INDIRECT
The OpenFlow group type INDIRECT is supported only in software. The capabilities are:

Chapter 5
Group table
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• Executes the one defined action bucket in the group.

• Supports only a single action bucket.

Group Type FAST FAILOVER
The OpenFlow group type FAST FAILOVER is supported only in software. The capabilities are:

• Executes the first LIVE action bucket in the group. The buckets are evaluated for liveness in the order defined
by the group.

• OpenFlow virtual ports are not supported as watch ports.

Group actions
Supports the following actions in a group:

• OFPAT_OUTPUT
• OFPAT_COPY_TTL_OUT (software only)

• OFPAT_COPY_TTL_IN (software only)

• OFPAT_SET_NW_TTL (software only)

• OFPAT_DEC_NW_TTL (software only)

• OFPAT_SET_FIELD (software only)

Group statistics
The following statistics are supported in a group:

• Groups in software support both byte and packet counters.

• Groups in hardware support both byte and packet counters only on v3 modules.

• Groups in software also support bucket counters.

Group scale
The group scale limit is as follows:

• Supports a maximum of 1,024 groups across all OpenFlow instances.

• Supports a maximum of eight buckets per group.

• Supports a flow, which can point up to eight different groups (software groups and only one hardware group).

Group limitations
The following are the limitations in a group:

• For all group types other than FAST FAILOVER, the watch_port must be OFPP_ANY.

• Does not support watch_group in the group buckets other than OFPG_ANY
• A software group cannot point to a flow in the hardware.
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• Does not support moving a hardware group after modification to a software group.

• If a flow on the hardware points to a group, the table cannot have any other associated actions.
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OpenFlow supports per-flow rate-limiters for OpenFlow 1.0 as HPE vendor extensions.

A rate-limiter controls the rate of packets passing through a switch. Per-flow rate-limiters associate an arbitrary
number of flows with a rate-limiter. Using OpenFlow with per flow rate-limiters, any number of flows can be flexibly
mapped to a rate-limiter, regardless of their source and destination ports. Rate-limiters can be used via the HPE
VAN SDN controller, which includes support for HPE QoS extensions. A limiter id (an arbitrary 32-bit number)
addresses rate-limiters. Configuration of rate-limiters is done through a simple message from the controller, which
can add, modify or remove a rate-limiter. Flows are directed to rate-limiters through an action. Multiple flows can
be associated with the same rate-limiter. Statistics can be read from the OpenFlow controller for each rate-limiter.

NOTE:

Per-flow rate-limiters are used only if the hardware rate-limiter for the instance is disabled.

QoS extensions
HPE QoS extension to the OpenFlow protocol supports rate-limiters. A rate-limiter controls the rate of packets
passed through it. Per-flow rate-limiters associate an arbitrary number of flows with a rate-limiter. The HPE QoS
vendor extensions support per-flow rate-limiters only with the drop rate flag and not the remark rate or other flags.

Create a limiter
A per-flow rate-limiter is added/created via the HPE VAN SDN controller.

On receiving an OpenFlow message from the OpenFlow controller, the vendor ID is checked for a match to the
HPE vendor ID. If the message type received indicated the addition of a new rate-limiter, a new rate-limiter is
created with the parameters received in the message.

Get limiter details
The details on the limiters configured can be retrieved via the HPE VAN SDN controller. These details can also be
checked on the switch CLI using the command show openflow instance <instance-name> limiters .

Support an OpenFlow flow with a limiter
A flow can be associated with a per-flow rate-limiter by giving the limiter ID as an OpenFlow action. For example,
assume that a per-flow rate-limiter with ID 100 was created. From the HPE VAN SDN controller that supports HPE
QoS extensions, a flow can be associated with this rate-limiter by using this limiter ID of 100 as one of the
specified OpenFlow actions of that flow.

Chapter 6
OpenFlow per-flow rate limiting
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Overview
OpenFlow multi-VLAN instance associates multiple VLANs to an OpenFlow instance.

The capabilities of the OpenFlow multi-VLAN instance include:

• Ability to include more than one VLAN on the switch as member VLAN for an OpenFlow instance in Virtualized
mode.

• Supported on both OpenFlow 1.0 and 1.3 versions.

• For a Multi-VLAN instance, the first VLAN in the Multi-VLAN instance is part of the DPID. Since VLANs cannot
be part of multiple instances, this restriction ensures a unique DPID (the upper 16 bits of the DPID) for each
instance.

• Packet-IN for a Multi-VLAN instance is the same as aggregate mode (that is, the Packet-IN is sent with the
VLAN tag.) If the instance is a single VLAN instance, the behavior is the same as the virtualized instance (that
is, the Packet-IN is sent untagged.)

• Ability to add OpenFlow rules with wild-carded VLAN in such an instance that matches traffic inbound on only
those VLANs that are part of the instance.

• Ability to add OpenFlow rules with a specific VLAN that is part of the VLANs in the instance.

• Supports v2 and v3 modules.

Chapter 7
OpenFlow Multi-VLAN instance
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Custom pipeline-model
The OpenFlow instance supports a pipeline-model type 'custom' on the v3 blades that allows the SDN controllers
to create, modify, and destroy OpenFlow pipelines of its choice in hardware. The instance can be configured with
its pipeline-model set to custom only if it is running in 'v3 mode'.

The capabilities provided by this pipeline-model include:

• SDN controller can create an OpenFlow pipeline with multiple flow tables, each with its own unique match and
action capability.

• All the flow-tables in this pipeline-model will reside in hardware.

• Flow tables in this pipeline-model can be of two types:a. Tables with no wildcard and mask capabilities called
HASH.b. Tables with wildcard and mask capabilities called TCAM.

• If the size of the tables requested by controller cannot be accommodated in hardware, the request is rejected.

• A maximum of 12 tables can be configured per instance by the controller.

• The minimum number of flows in a custom HASH table is 16.

• The minimum number of flows in a custom TCAM table is 2.

See Flow table capabilities on page 121 for the match and action capabilities supported in this pipeline-model.

Default Pipeline in custom mode
An instance can be configured in this mode via CLI by using the command pipeline-model custom.

Figure 13: Table pipeline

The switch consisting of three Hash tables and one TCAM table, as shown in Figure 5, advertises the default
pipeline in custom mode. The default pipeline consists of four tables, three of type HASH and one of type TCAM
with the following capabilities:

Chapter 8
OpenFlow custom pipeline
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Table ID 0 1 2 3

Table Name Custom L2 Src Custom L2 Dst Custom L3 Table Custom TCAM Table

Metadata Match 0x000000000000000
0

0x00000000000000
00

0x00000000000000
00

0x0000000000000000

Metadata Write 0x000000000000000
0

0x00000000000000
00

0x00000000000000
00

0x0000000000000000

Max Entries 8k 8k 8k 2k

Match ETH_SRC

VLAN_VID

ETH_DST

VLAN_VID

ETH_TYPE

VLAN_VID

IP_PROTO

IPV4_SRC

IPV4_DST

TCP_SRC

TCP_DST

UDP_SRC

UDP_DST

IPV6_SRC

IPV6_DST

IN_PORT

ETH_DST

ETH_SRC

ETH_TYPE

VLAN_VID

VLAN_PCP

IP_DSCP

IP_PROTO

IPV4_SRC

IPV4_DST

TCP_SRC

TCP_DST

UDP_SRC

UDP_DST

IPV6_SRC

IPV6_DST

Table Continued
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Table ID 0 1 2 3

Wildcards IN_PORT

ETH_DST

ETH_SRC

ETH_TYPE

VLAN_VID

VLAN_PCP

IP_DSCP

IP_PROTO

IPV4_SRC

IPV4_DST

TCP_SRC

TCP_DST

UDP_SRC

UDP_DST

IPV6_SRC

IPV6_DST

Instructions GOTO

APPLY

WRITE

CLEAR

METER

GOTO

APPLY

WRITE

CLEAR

METER

GOTO

APPLY

WRITE

CLEAR

METER

APPLY

WRITE

CLEAR

METER

Instructions
Miss

GOTO

APPLY

WRITE

CLEAR

METER

GOTO

APPLY

WRITE

CLEAR

METER

GOTO

APPLY

WRITE

CLEAR

METER

APPLY

WRITE

CLEAR

METER

Next Tables 1, 2, 3 2, 3 3

Next Tables
Miss

1, 2, 3 2, 3 3

Table Continued
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Table ID 0 1 2 3

Write Action OUTPUT

GROUP

SET-FIELD

PUSH_VLAN

POP_VLAN

IP_TTL

OUTPUT

GROUP

SET-FIELD

PUSH_VLAN

POP_VLAN

IP_TTL

OUTPUT

GROUP

SET-FIELD

PUSH_VLAN

POP_VLAN

IP_TTL

OUTPUT

GROUP

SET-FIELD

PUSH_VLAN

POP_VLAN

IP_TTL

Write Action
Set-Field

ETH_DST

ETH_SRC

VLAN_VID

VLAN_PCP

ETH_DST

ETH_SRC

VLAN_VID

VLAN_PCP

ETH_DST

ETH_SRC

VLAN_VID

VLAN_PCP

IP_DSCP

IPV4_SRC

IPV4_DST

TCP_SRC

TCP_DST

UDP_SRC

UDP_DST

ETH_DST

ETH_SRC

VLAN_VID

VLAN_PCP

IP_DSCP

IPV4_SRC

IPV4_DST

TCP_SRC

TCP_DST

UDP_SRC

UDP_DST

Write Action
Miss

OUTPUT

GROUP

SET-FIELD

PUSH_VLAN

POP_VLAN

IP_TTL

OUTPUT

GROUP

SET-FIELD

PUSH_VLAN

POP_VLAN

IP_TTL

OUTPUT

GROUP

SET-FIELD

PUSH_VLAN

POP_VLAN

IP_TTL

OUTPUT

GROUP

SET-FIELD

PUSH_VLAN

POP_VLAN

IP_TTL

Write Action
Miss Set-Field

ETH_DST

ETH_SRC

VLAN_VID

VLAN_PCP

ETH_DST

ETH_SRC

VLAN_VID

VLAN_PCP

ETH_DST

ETH_SRC

VLAN_VID

VLAN_PCP

IP_DSCP

IPV4_SRC

IPV4_DST

TCP_SRC

TCP_DST

UDP_SRC

UDP_DST

ETH_DST

ETH_SRC

VLAN_VID

VLAN_PCP

IP_DSCP

IPV4_SRC

IPV4_DST

TCP_SRC

TCP_DST

UDP_SRC

UDP_DST

Table Continued
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Table ID 0 1 2 3

Apply Action OUTPUT

GROUP

OUTPUT

GROUP

OUTPUT

GROUP

OUTPUT

GROUP

SET-FIELD

PUSH_VLAN

POP_VLAN

IP_TTL

Apply Action
Set-Field

ETH_DST

ETH_SRC

VLAN_VID

VLAN_PCP

IP_DSCP

IPV4_SRC

IPV4_DST

TCP_SRC

TCP_DST

UDP_SRC

UDP_DST

Apply Action
Miss

OUTPUT

GROUP

OUTPUT

GROUP

OUTPUT

GROUP

OUTPUT

GROUP

SET-FIELD

PUSH_VLAN

POP_VLAN

IP_TTL

Apply Action
Miss Set-Field

ETH_DST

ETH_SRC

VLAN_VID

VLAN_PCP

IP_DSCP

IPV4_SRC

IPV4_DST

TCP_SRC

TCP_DST

UDP_SRC

UDP_DST
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NOTE: Only one instance will be operationally up in custom pipeline-model by default. The other
instances running the custom pipeline-model will be operationally down with the reason as
Resources not available. This is because all hardware resources are allocated to the first
OpenFlow instance enabled with this pipeline-model. To bring up other instances running this
pipeline-model, the SDN controller will have to free up resources in the existing pipeline on the first
instance.

Pipeline modification process
Pipeline modification follows this basic process:

• An instance must be configured in the custom mode so that the controller can use the table modifications
feature.

• The controller using the “Table Features” request message, triggers a table modification request.

• The first “OFPMP_TABLE_FEATURES” is sent with an empty body and the switch replies with the default
table pipeline.

• The controller understands the current pipeline.

• If the controller wants to modify the default table pipeline, it again sends “OFPMP_TABLE_FEATURES” with
the required table pipeline configuration.

• The table pipeline has details of the table numbers, size of each table, instructions/match/action capabilities of
each table.

• If the table pipeline with all its properties and scale can be achieved in the hardware, the table modification
request is accepted.

• The table modification can happen dynamically on custom pipeline instances (that is, instance need not have
to be disabled to do the table modification).

Figure 14: OpenFlow pipeline
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Figure 15: OpenFlow custom match instance

Example: Custom Pipeline Instance

switch(openflow)# show running-config

Running configuration:

; J9850A Configuration Editor; Created on release #KB.16.02.0000x
; Ver #0d:33.ff.7c.5f.fc.7b.ff.ff.fc.ff.ff.3f.ef:49
hostname "switch-name"
module A type j9991a
module F type j9987a
snmp-server community "public" unrestricted
openflow
   controller-id 1 ip 10.20.30.42 controller-interface vlan 2
   instance aggregate
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      listen-port
      controller-id 1
      version 1.3 only
      pipeline-model custom
      enable
      exit
   enable
   exit
oobm
   ip address dhcp-bootp
   exit
vlan 1
   name "DEFAULT_VLAN"
   no untagged A2-A3,A5
   untagged A1,A4,A6-A24,F1-F24
   ip address dhcp-bootp
   exit
vlan 2
   name "VLAN2"
   untagged A2
   ip address 10.20.30.40 255.255.255.0
   exit
vlan 3
   name "VLAN3"
   untagged A3,A5
   no ip address
   exit
no allow-v2-modules

switch(openflow)# show openflow

 OpenFlow                     : Enabled
 Egress Only Ports Mode       : Disabled

 Instance Information

                                                 No. of     No. of     OpenFlow
  Instance Name                     Oper. Status H/W Flows  S/W Flows  Version
  --------------------------------- ------------ ---------- ---------- --------
  aggregate                         Up           8          0          1.3 only

switch(openflow)# show openflow instance aggregate

 Configured OF Version         : 1.3 only
 Negotiated OF Version         : 1.3
 Instance Name                 : aggregate
 Data-path Description         : aggregate
 Administrator Status          : Enabled
 Member List                   : VLAN 1, 3
 Pipeline Model                : Custom Pipeline
 Listen Port                   : 6633
 Operational Status            : Up
 Operational Status Reason     : NA
 Datapath ID                   : 000140a8f09e8600
 Mode                          : Active
 Flow Location                 : Hardware Only
 No. of Hardware Flows         : 8
 No. of Software Flows         : 0
 Hardware Rate Limit           : 0 kbps
 Software Rate Limit           : 100 pps
 Conn. Interrupt Mode          : Fail-Secure
 Maximum Backoff Interval      : 60 seconds
 Probe Interval                : 10 seconds
 Hardware Table Miss Count     : NA
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 No. of Software Flow Tables   : NA
 Egress Only Ports             : None
 Table Model                   : Custom Pipeline
 Source MAC Group Table        : Disabled
 Destination MAC Group Table   : Disabled

 Controller Id Connection Status Connection State Secure Role
 ------------- ----------------- ---------------- ------ ------
 1             Connected         Active           No     Equal

switch(openflow)# show openflow instance aggregate flow-table

 OpenFlow Instance Flow Table Information

 Table                       Flow     Miss
 ID    Table Name            Count    Count         Goto Table
 ----- --------------------- -------- ------------- -------------
 0     Custom L2 Src         1        0             1, 2, 3
 1     Custom L2 Dst         1        0             2, 3
 2     Custom L3 Table       1        0             3
 3     Custom TCAM Table     5        0             *

 Table
 ID    Table Name            Available Free Flow Count
 ----- --------------------- ------------------------------
 0     Custom L2 Src         Slot A              : 7372
                             Slot F              : 7372
 1     Custom L2 Dst         Slot A              : 6144
                             Slot F              : 6144
 2     Custom L3 Table       Slot A              : 5529
                             Slot F              : 5529
 3     Custom TCAM Table     Slot A              : 2010
                             Slot F              : 2010

 * Denotes that the pipeline could end here.
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Table 4: OpenFlow match field groups

Group 1 Group 2 Group 3 Group 4 Group 5 Group6 Custom(NOTE:
Requires a
separate Group
for every field in
this list)

ETH_DST IPV4_SRC IPV4_DST VLAN_ID TCP_SRC_RAN
GE

VLAN_UNTAG
GED

(Used only if the
table has
wildcards or
maskable
matches; has
match on
VLAN_VID, and
adding this does
not exceed the
maximum limit
of match groups
in a table)

ARP_OP

ETH_SRC IPV6_SRC IPV6_DST VLAN_PCP TCP_DST_RAN
GE

VLAN_TAGGED

(Used only if the
table has
wildcards or
maskable
matches; has
match on
VLAN_VID, and
adding this to a
table does not
exceed the
maximum limit
of match groups
in a table)

ARP_SPA

ETH_TYP
E

IP_DSCP UDP_SRC_RAN
GE

ARP_TPA

IP_PROTO UDP_DST_RAN
GE

ARP_SHA

TCP_SRC ARP_THA

TCP_DST ICMPV4_TYPE

UDP_SRC ICMPV4_CODE

UDP_DST IPV6_FLABEL

Table Continued
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Group 1 Group 2 Group 3 Group 4 Group 5 Group6 Custom(NOTE:
Requires a
separate Group
for every field in
this list)

IN_PORT
(Used if none
of the
previous
tables have
an APPLY
(set-field/
push_vlan/
pop_vlan)

ICMPV6_TYPE

ICMPV6_CODE

IPV6_ND_TARG
ET

TCP_FLAGS

CUSTOM_ONE

CUSTOM_TWO

CUSTOM_THRE
E

CUSTOM_FOUR

IN_PORT

( Used if any of
the previous
tables have an
APPLY (set-field/
push_vlan/
pop_vlan)

Pipeline creation guidelines
Best practices to create a pipeline are:

• Number of tables in your pipeline must not be more than 12.

• Check if the table type has at least one wildcard-able field or a mask-able field.

◦ If yes, maps to a TCAM table in hardware.

◦ If no, maps to a HASH table in hardware.

• Determine the table type for each table in the pipeline. Once you identify the table type as HASH or TCAM, do
the following:
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1. Verify how many match groups can be created for a table.

2. Determine how many groups the matches the selected table type.

3. Determine the number of tiles that will be consumed from the global pool to satisfy the scale of the
requested table type.

• The minimum table size for a HASH table type is 16 and two for a TCAM table.

• The prerequisite fields defined by the OpenFlow specification have to be part of the table match field list.

For example, you cannot create a table with match on IPV4_SRC address without adding ETH_TYPE as a
match field.

• The first table in the pipeline must have the Table-ID as zero. The last valid Table-ID is 254.

• Ensure no references (flows with Go To instruction) to a table are being modified or deleted from a table (that
is not updated), when you selectively modify the current pipeline doing any of the following:
◦ Adding an additional table to the pipeline

◦ Removing an existing table from the pipeline

◦ Modifying the property of an existing table

◦ All of the above

Performance in custom pipeline model
The performance of a custom pipeline model is based on factors such as table type, number of lookups, packet
size, OpenFlow instruction type, and stream type.

Table Type

The following parameters impact the performance:

• A miss is more expensive on a HASH versus a TCAM table type.

• A hit is more expensive on a TCAM versus a HASH table type.

Number of lookups

The performance is reduced when a packet has to do more table lookups, before it egresses the pipeline.

Packet size
The packet size has a major impact on the performance. There is a limit on the number of concurrent packets the
custom pipeline can service at a time. Thus, if the packet size is larger, the throughput in terms of bps is better.

Packets are dropped at the ingress, if the custom pipeline is busy servicing too many packets. You can check the
RX discards on the ingress port to obtain such data.

OpenFlow instruction type

Flows with APPLY instruction yield low performance because of immediate action on the packet against the
WRITE instruction, which accumulates all actions at the end of the pipeline.

Stream type

The traffic generated from the same source lowers the performance when compared to a more distributed stream.
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Scale on custom pipeline Instance
• The hardware can match up to four different Groups of match in the custom-pipeline mode.

• The number of groups depends on the match fields in the HASH or TCAM table.

HASH table

• A single hash table can have match fields from any of the above three groups only.

• Based on the number of groups matched, the scale varies.
◦ If the hash table is created with match fields from one group, it can hold up to 64k entries.

◦ If the hash table is created with match fields from two or three groups, it can hold up to 32k entries.

NOTE: The maximum numbers of flows for 2930F/2930M switches are limited to 16k entries.

TCAM table

• A single tcam table can have match fields from up to four groups. The new group table has more than four
groups.

• The scale varies depending on the number of groups.
◦ If the tcam table is created with match fields from one group, it can hold up to 8k entries.

◦ If the tcam table is created with match fields from two groups, it can hold up to 4k entries

◦ If the tcam table is created with match fields from three or four groups, it can hold up to 2k entries

NOTE: An instance without “pipeline-model” configured defaults to standard-match but changes to
IP-control mode when ip-control-mode is globally enabled.

Custom matches
The OpenFlow 1.3 specification defines a fixed set of packet header fields as OXM fields that can be used by the
SDN controller to identify which fields in the packet it wants to match in any given flow on a flow table. The header
fields defined are a list of well-known and popular protocol fields. The list is not exhaustive. There are still many
packet fields that are not covered in the standard set but might be required to solve potential SDN use cases.

The SDN controller now can define one or more abstract match fields (termed custom match) in a flow-table of
an instance running in custom pipeline-model when defining the new pipeline

Defining a custom match field
To use the customizable matches feature, the SDN controller first needs to create an OpenFlow table wherein it
needs to define what these customizable fields will match on. The table can match on standard OpenFlow OXM
match fields along with the customizable match fields. To create an OpenFlow pipeline with such tables, the
controller sends an OFPMP_TABLE_FEATURES multipart request to the switch with a body that defines what the
pipeline should look like.

OFPTFPT_MATCH is the table feature property type that needs to be set to tell the switch which match fields the
SDN controller wants to match on for a given table. OFPTFPT_MATCH is an array of OXM headers of packet
fields that will be matched on the table.

To define a customizable match field, the OXM header in the OFPTFPT_MATCH should look like the following:
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0 1 2 3 4 5 6 7

OXM_CLASS OXM_FIELD OXM_LEN EXPERIMENTER_ID

START_TYPE OFFSET NUM_BYTES

OXM_CLASS

This needs to be OFPXMC_EXPERIMENTER (0xffff).

OXM_FIELD

This should be one of the new OXM fields that have been defined for this purpose. It can take one of the
following values:

• CUSTOM_MATCH_ONE = 5

• CUSTOM_MATCH_TWO = 6

• CUSTOM_MATCH_THREE = 7

• CUSTOM_MATCH_FOUR = 8

OXM_LEN

The length of the experimenter header excluding the OXM header.

EXPERIMENTER ID

The HPE VENDOR ID.

START TYPE

This field specifies where in the packet to look for the data. It can have one of the following values:

• L2_START = 1 /* Look from L2 header */

• L3_START = 2 /* Look from L3 header */

• L4_START = 3 /* Look from L4 header */

OFFSET

This field defines the byte offset from the ‘START TYPE’ where the match field will start.

NUM_BYTES

This field defines the number of bytes to match from the ‘OFFSET’.

The following table shows an example to define a custom match field to match on TCP sequence number. All the
data has to be in Network Byte Order.

0 1 2 3 4 5 6 7

0xffff
(OFPXMC_EXPERIMENT
ER)

0x05(OXM_
FIELD)

0x0a(OXM_
LEN)

0x00002481 (HP VENDOR ID)

0x0003 (Start at L4) 0x0004 (at 4 bytes offset) 0x0004 (match 4 bytes)
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Programming a flow with match on custom match field
Once the table with one or more custom match field is created on the switch, the controller can program flows to
match on these fields via OFPT_FLOW_MOD message.

The data for the custom field will be embedded as an OXM field within the flow mod request message:

0 1 2 3 4 5 6 7

OXM_CLASS OXM_FIELD OXM_LEN EXPERIMENTER_ID

LENGTH OF MATCH DATA MATCH DATA

MATCH DATA

MATCH DATA

OXM CLASS

This needs to be OFPXMC_EXPERIMENTER (0xffff).

OXM FIELD

This should be the OXM fields for which the data is being defined:

• CUSTOM_MATCH_ONE = 5

• CUSTOM_MATCH_TWO = 6

• CUSTOM_MATCH_THREE = 7

• CUSTOM_MATCH_FOUR = 8

LENGTH

The length of the experimenter header excluding the OXM header.

EXPERIMENTER ID

The HPE VENDOR ID.

LENGTH OF DATA

This field defines the number of bytes of data to consider as the value for the custom match field in the
following 16 bytes of data.

MATCH DATA

This field holds the data to look in the packet in the custom match field. Based on the value defined in the
‘LENGTH OF DATA’ field, only that many bytes are considered relevant from the MSB. The rest of the field
needs to be padded with zeros

The following table shows an example of defining a custom match field to match on TCP sequence number with
value of 0x12345678. The data has to be in Network Byte Order.

0 1 2 3 4 5 6 7

0xffff (OXM_CLASS) 0x05 (OXM_FIELD) 0x18 (OXM_LEN) 0x00002481(HPE VENDOR ID)

0x00000004 (Length of match data) 0x12345678 (Match data)

Table Continued
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0x0000000000000000

0x00000000

Facts
• We support up to four such customizable fields per OpenFlow table.

• The custom fields defined are local to that table. That is, the OXM field CUSTOM_MATCH_ONE…FOUR can
map to a different packet field on each table. They are not global to the whole of OpenFlow pipeline.

• Each custom match field can match up to 128 bits of data. The fields can also be masked and wild carded.

• The maximum allowed offset from any start type is 63 bytes.

• A flow table can have a combination of standard OXM fields with custom match fields.

• Each custom match field consumes a match group in itself.
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When the controller wishes to send out a packet through the OpenFlow switch, it uses the OFPT_PACKET_OUT
message.

All the actions supported on the software tables of standard-match and IP Control pipeline models are supported
in the packet_out message.

IN_PORT

• If the in_port in the packet_out message is set to OFPP_CONTROLLER or OFPP_NONE, the switch treats
it as a CPU generated packet.

• If the in_port in the packet_out message is a logical port that is not a member of the OpenFlow instance
for which the packet_out message is sent, the switch rejects the packet_out message.

OUT_PORT

• If the out-port in the packet_out is OFPP_NORMAL, the switch performs one of the following:

◦ Attempts to route the packets if the Ethernet destination address is set to switch MAC address in the
payload.

◦ Attempts to bridge the packet for non-MAC address packets.

• If the out-port in the packet_out is OFPP_LOCAL, the switch sends the packet to the local IP stack in the
following scenarios:

◦ Packets with Ethernet destination address set to switch MAC address or broadcast MAC address in the
payload.

◦ Packet IP address is set to IP VLAN of the switch in a payload.

• Does not support the virtual port, OFPP_TABLE.

Determining the VLAN
The switch uses the following steps to determine the VLAN to be associated with the packet in the payload:

Procedure

1. Check the VLAN ID in the payload, if tagged.

2. Use the primary VLAN of the in-port for untagged packets.

If the in-port does not have a primary VLAN associated with it, the first instance of the VLAN in the list is
used. The first instance of the VLAN in the list if the packet is untagged and in-port is a tunnel port.

Chapter 9
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NOTE: 

• If the VLAN determined from the above step is not a member VLAN of the instance, the packet is
dropped.

• If the packet in the packet_out message is an LLDP frame, the packet is always sent untagged
to the switch.
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Matching on TCP flags and TCP/UDP port ranges
TCP Flags and L4 port ranges are supported as match parameters in Flow Modification messages from the
controller. Experimenter Match Fields are used to accomplish this operation.

Table 5: Matching on TCP Flags and TCP/UDP port ranges

Supported Not supported

Match on TCP Flags and UDP/TCP source/destination
port ranges in OpenFlow rules.

TCP Flags and UDP/TCP source/destination port
ranges cannot be set/modified using an OpenFlow
action.

Match support available for v1.3 instances only. Instances negotiated to 1.0 do not support the feature
(as 1.0 does not support Experimenter Match fields).

Match capability is available for rules in Policy Tables
(TCAM) and Software Tables.

IP-Control-Table (Table-50) and MAC Table (Table
40/41) does not support matching on TCP flags or port
ranges.

Matching is supported on the previously mentioned
tables for Instances configured in IP-Control table mode
and Standard Match Mode.

Masking is not supported for port ranges.

Match masks are supported for TCP Flags. N/A

Experimenter OXM class is used to communicate the
match capability to the controller (in
TABLE_FEATURES_REPLY).

N/A

Controllers wanting to program a rule with these match
parameters must use the Experimenter Flow Match
Fields to specify the TCP Flags/Port range match
parameters along with the experimenter ID.

N/A

Experimenter match fields
ONF assigned vendor ID is expected in the experimenter Field for all the OpenFlow messages containing the
Experimenter Match fields.

0x00002481 is the HPE Vendor ID.

Controllers in the “oxm_field” of the Experimenter Match Fields in Flow Modification messages must use the
following values:
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OXM field Value

UDP Source Port Range 0

UDP Destination Port Range 1

TCP Source Port Range 2

TCP Destination Port Range 3

TCP Flags 4

Custom Match One 5

Custom Match Two 6

Custom Match Three 7

Custom Match Four 8

Values must be encoded post the Experimenter ID field in the OXM. For TCP Flags, the value and mask are each
16 bits in length. Similarly for Port Ranges, 16-bits are used to encode the Range Begin value followed by 16 bits
for Range End value.

Flow Mod Validations
Table 6: Flow Mod Validations

Scenario Error Type Error Code

The “experimenter” field in the
experimenter header of flow mod
message contains a value other
than HP_VENDOR_ID

OFPET_BAD_MATCH OFPBMC_UNKNOWN

The payload for the TCP flags
match field contains an invalid
value. (Example: in TCAM, if any bit
in position 6:7 is set)

OFPET_BAD_MATCH OFPBMC_BAD_VALUE

If either OFPXMT_OFB_TCP_SRC/
OFPXMT_OFB_UDP_SRC or
OFPXMT_OFB_TCP_DST/
OFPXMT_OFB_UDP_DST is
already present in the flow mod and
L4 source port range or, L4
destination port range matching is
also specified respectively.

OFPET_BAD_MATCH OFPBMC_DUP_FIELD

Table Continued
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Scenario Error Type Error Code

If the port range match is specified
without the
OFPXMT_OFB_IP_PROTO match
pre-requisite.

OFPET_BAD_MATCH OFPBMC_BAD_PREREQ

If the TCP flag matching is specified
without the IP_PROTO match being
set to 6 (TCP).

OFPET_BAD_MATCH OFPBMC_BAD_PREREQ

If all the TCAM range registers for a
slot are used up, an attempt to
install a new rule on the slot with L4
port range match returns an
OFPET_EXPERIMENTER error
message to the controller. The Error
code is as agreed between the
Switch and the Controller team (0).
The “experimenter” field has the
HP_VENDOR_ID.

OFPET_EXPERIMENTER Exp_type =
OFPERR_OFPET_EXPERIMENTE
R_RANGE_FULL (0)

TCP Flags/L4 port range matching in Custom Match Mode
NOTE:

Matching of TCP Flags and L4 port ranges in Custom Match Mode are available from builds KB.
16.01, KB.16.02 and WC.16.02 only.

Matching on TCP Flags and TCP/UDP port ranges in Custom Match Mode is supported using the match
parameters Experimenter Match Fields.

Addition or modification of tag for single-tagged packets
This addition or modification is accomplished with the action “OFPAT_SET_FIELD” and setting the field to
“OFPAT_SET_VLAN_VID (Set the 802.1q VLAN id)” inside the packet.

Is/Is-not table
IS IS-NOT

TCP Flags match supported on TCAM and Hash
tables in Custom match mode.

L4 Port Range matching is not supported in Hash
Table in Custom match mode.

The lower 8 bits of TCP flags can be matched in
TCAM and Hash tables in Custom match mode.

Masking of TCP flags is not supported in Hash
tables.

Table Features request with TCP Flags and L4
Port Ranges as match fields is honored.

Default pipeline for Custom Match Mode does not
support matching on TCP Flags or L4 Port ranges.

Restrictions
The default Custom Match Mode pipeline does not support matching on TCP Flags or L4 port ranges. The switch
does, however, honor a “TABLE features” request message from the controller with match parameters in the
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OFPTFPT_MATCH property. The oxm_class for these match properties are OFPXMC_EXPERIMENTER and
oxm_field values.

The following table shows the encoding format expected.

oxm_class =
OFPXMC_EXPERIMENTER

oxm_field = OFPXMT_OFEXP_UDP_SRC_PORT_RANGE/
OFPXMT_OFEXP_UDP_DST_PORT_RANGE/
OFPXMT_OFEXP_TCP_SRC_PORT_RANGE/
OFPXMT_OFEXP_TCP_DST_PORT_RANGE/
OFPXMT_OFEXP_TCP_FLAGS

Has Mask

oxm_length

Experimenter ID (0x00002481)

There are 60 Range resources available per v3 card. By default, OpenFlow is configured to use only 50% of the
resources.

Each range match in a rule consumes one range resource, with the following exceptions:

• If a rule has same range values for L4 source and L4 dest range, two resources are consumed.

• If two rules have the same UDP/TCP source/Destination range respectively, only one range resource is
consumed.

Range Resource Example
If Rule1 has TCP source=100-200 and Rule 2 has TCP Source=100-200, only 1 range resource is consumed.
Similarly, if Rule1 has TCP source=100-200 and Rule2 has UDP source=100-200, 2 range resources are consumed.
Also, a rule with TCP source=200-300 and TCP Destination=200-300 consumes 2 range resources.

Error Messages
The following error is applicable for TABLE FEATURES request message processing on the switch. This error
code is applicable for custom match mode only. All other error codes mentioned in LINK are also applicable to
Custom Match Mode.

Scenario A Table Features Request Message from the controller
containing individual L4 port matching along with L4 port
range matching.

Error Type OFPET_TABLE_FEATURES_FAILED

Error Code OFPTFFC_EPERM
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OFPAT_PUSH_VLAN and OFPAT_POP_VLAN are supported for single tagged packets only.

Is Is not

Support for OFPAT_PUSH_VLAN and
OFPAT_POP_VLAN on all OpenFlow instance
pipeline models.

OFPAT_PUSH_VLAN and OFPAT_POP_VLAN
actions are not supported on v1 mode of operation.

Support for OFPAT_PUSH_VLAN and
OFPAT_POP_VLAN on v2 and v3 modes of
operation.

OFPAT_PUSH_VLAN action does not support
double tagging.

Support for OFPAT_PUSH_VLAN only with ether-
type as 0x8100 (802.1q)

OFPAT_PUSH_VLAN and OFPAT_SET_FIELD of
OFP_VLAN_VID actions are not supported in the
same flow.

OFPAT_PUSH_VLAN action on an already tagged
packet does not add a fresh 802.1q tag. It modifies
the existing 802.1q tag in the packet.

OFPAT_POP_VLAN action strips only the 802.1q
tag in the packet.

Chapter 11
Push and pop VLAN
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Show OpenFlow information
You can display OpenFlow information for all instances, ports, and flows. The returned information includes the
OpenFlow version supported.

Syntax

show openflow {auxiliary-connections | controllers | flow-table | instance <instance-name> | multiport-filter-limit | resource }

Show OpenFlow information.

auxiliary-connections
Show a list of OpenFlow auxiliary connections.

controllers
Show OpenFlow controller information.

flow-table
Display information for an OpenFlow flow table.

instance
Show information for an OpenFlow instance.

multiport-filter-limit
Show the multiport filter allocated to OpenFlow.

resources
Show OpenFlow resource utilization.

Show global OpenFlow information
Syntax

show openflow
Show OpenFlow information

Show openflow

switch# show openflow
OpenFlow                 : Enabled
Egress Only Ports Mode   : Disabled

Instance Information
                                           No. of    No. of    OpenFlow
Instance Name                 Oper. Status H/W Flows S/W Flows Version
----------------------------- ------------ --------- --------- --------
titan                         Up           6         4         1.3
marez                         Up           6         4         1.3 only

Chapter 12
Show commands
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Show auxiliary connection information
Only one auxiliary connection is supported per main controller connection.

Syntax

show openflow auxiliary-connections
Displays auxiliary connection information.

Example: Show OpenFlow auxiliary-connections

show openflow auxiliary-connections

Auxiliary                         
Conn. Index Type Port 
----------- ---- ----  
1           TCP  7777  
2           UDP  8888 

Show OpenFlow controllers
Displays OpenFlow controllers configured for use by OpenFlow.

Syntax

show openflow controllers
Example: show openflow controllers

switch(config)# show openflow controllers

Controller Information

Controller Id IP Address        Port   Interface
------------- ----------------- ------ ---------
1             20.0.0.2          6633   VLAN 6

Show OpenFlow flow table information
Syntax

show openflow flow-table
Displays global flow table information.

Show OpenFlow flow tables

switch# show openflow flow-table

Flow Table Information

                        Max.      Refresh          Flow
Table Name              Usage     Rate  (seconds)  Count
----------------------- --------- --------------  ------
IP Control Table        50%       12              0
Policy Engine Table     50%       20              0
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                    IP Control Table      Policy Engine Table
Slot ID    Current Usage (%)    Current Usage (%)
-------- -----------------    -------------------
1             0.000000                 0.07
6             0.000000                 0.07

NOTE: Current usage is percentage of OpenFlow maximum usage.

Show OpenFlow instance
Syntax

show openflow instance <instance-name>
Show OpenFlow instance information.

Show OpenFlow instance <instance-name>

switch(openflow)# show openflow instance test
Configured OF Version                                : 1.3 only
Negotiated OF Version                                : 1.3
Instance Name                                        : test
Data-path Description                                : test
Administrator Status                                 : Enabled
Member List                                          : VLAN 3
Pipeline Model                                       : Standard Match
Listen Port                                          : 6633
Operational Status                                   : Up
Operational Status Reason                            : NA
Datapath ID                                          : 000340a8f09e8600
Mode                                                 : Active
Flow Location                                        : Hardware and Software
No. of Hardware Flows                                : 6
No. of Software Flows                                : 4
Hardware Rate Limit                                  : 0 kbps
Software Rate Limit                                  : 100 pps
Conn. Interrupt Mode                                 : Fail-Secure
Maximum Backoff Interval                             : 60 seconds
Probe Interval                                       : 10 seconds
Hardware Table Miss Count                            : NA
No. of Software Flow Tables                          : 1
Egress Only Ports                                    : A1,A4,A6-A24,F1-F24
Table Model                                           : Policy Engine and Software
Source MAC Group Table                               : Disabled
Destination MAC Group Table                          : Disabled
Controller Id Connection Status Connection State Secure Role
------------- ----------------- ---------------- ------ ------
1             Connected         Active           No     Equal

show openflow instance test message-statistics
Syntax
switch# show openflow instance <INSTANCE-NAME> message-statistics
Description

Displays the descriptive reasons for the OpenFlow error codes which are returned to the controller for flow
modifications and pipeline modifications.
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Example

show openflow instance test message-statistics

switch# show openflow instance test message-statistics
OpenFlowMessage
Type                                      Received      Rejected
--------------------------------------- -------------- ----------
OFPT_FLOW_MOD                                 4             1
OFPT_PORT_MOD                                 0             0
OFPT_GROUP_MOD                                0             0
OFPT_METER_MOD                                0             0
OFPMP_TABLE_FEATURES (Change Pipeline)        0             0
OFPMP_TABLE_FEATURES (View Pipeline)          0             0

Flow-Mod Error Counters
OpenFlow
ErrorCode                      Count       Reason
------------------------------ ----- ----------------------------------------
OFPFMFC_EPERM                    1      Input port in the rule is not valid.

Pipeline-Mod Error Counters
OpenFlowError                   Code       Count Reason
------------------------------ ----- ----------------------------------------

Viewing multiport-filter-limit
Syntax

show openflow multiport-filter-limit
Displays multiport filter information. (Only in OpenFlow version 1.3.)

Example: Viewing multiport filter information

switch# show openflow multiport-filter-limit

Total Multiport Filters: 1039 

             Filters     Filters     Filters
Features     Allocated   Used        Free  
------------ ----------- ----------- -----------
OpenFlow     519         1           518

Show OpenFlow resources
Syntax

show openflow resources
Show OpenFlow resource usage in Policy Enforcement Engine.

Show openflow resources

switch(of-inst-test)# show openflow resources

 Ingress Policy Enforcement Engine Rules
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 Resource usage in Policy Enforcement Engine
               |   Rules   |  Rules Used
         Slots | Available | ACL | QoS | IDM |  VT | Mirr | PBR |  OF  | Other |
 --------------+-----------+-----+-----+-----+-----+------+-----+------+-------|
   A           |      8158 |   0 |   0 |   0 |   0 |    0 |   0 |   14 |     4 |
   F           |      8158 |   0 |   0 |   0 |   0 |    0 |   0 |   14 |     4 |

 Ingress Policy Enforcement Engine Meters

               |   Meters  |  Meters Used
         Slots | Available | ACL | QoS | IDM |  VT | Mirr | PBR |  OF  | Other |
 --------------+-----------+-----+-----+-----+-----+------+-----+------+-------|
   A           |      2046 |     |   0 |   0 |   0 |      |     |    1 |     0 |
   F           |      2046 |     |   0 |   0 |   0 |      |     |    1 |     0 |

 Ingress Policy Enforcement Engine Port Ranges

               |Application|
               |Port Ranges|  Application Port Ranges Used
         Slots | Available | ACL | QoS | IDM |  VT | Mirr | PBR |  OF  | Other |
 --------------+-----------+-----+-----+-----+-----+------+-----+------+-------|
   A           |        60 |   0 |   0 |   0 |     |    0 |   0 |    0 |     0 |
   F           |        60 |   0 |   0 |   0 |     |    0 |   0 |    0 |     0 |

 Ingress Policy Enforcement Engine PBR Resources

               |    PBR    |
               | Next-hops |  PBR Next-hops Used
         Slots | Available | ACL | QoS | IDM |  VT | Mirr | PBR |  OF  | Other |
 --------------+-----------+-----+-----+-----+-----+------+-----+------+-------|
   A           |      1024 |     |     |     |     |      |   0 |      |     0 |
   F           |      1024 |     |     |     |     |      |   0 |      |     0 |

 6 of 32 Policy Engine management resources used.

 Resource usage in Custom Pipeline Engine
               |   Tables       |  Tables
         Slots |   Available    |  Used
 --------------+----------------+----------+
   A           |             32 |        0 |
   F           |             32 |        0 |
               |   Action-Set   | Action-Set
         Slots |   Available    | Used
 --------------+----------------+----------+
   A           |          32000 |        0 |
   F           |          32000 |        0 |
               |   Meters       |  Meters
         Slots |   Available    |  Used
 --------------+----------------+----------+
   A           |           2000 |        0 |
   F           |           2000 |        0 |
               |   Counters     |  Counters
         Slots |   Available    |  Used
 --------------+----------------+----------+
   A           |          31000 |        0 |
   F           |          31000 |        0 |
               |   Ranges       |  Ranges
         Slots |   Available    |  Used
 --------------+----------------+----------+
   A           |             64 |        0 |
   F           |             64 |        0 |
 Key:
 ACL = Access Control Lists
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 QoS = Device & Application Port Priority, QoS Policies, ICMP rate limits
 IDM = Identity Driven Management
 VT  = Virus Throttling blocks
 Mirr = Mirror Policies, Remote Intelligent Mirror endpoints
 PBR = Policy Based Routing Policies
 OF = OpenFlow
 Other = Management VLAN, DHCP Snooping, ARP Protection, Jumbo IP-MTU,
         RA Guard, Control Plane Protection, Service Tunnel, ND Snooping, UWW,
         mDNS, tunneled-node-server.

 Resource usage includes resources actually in use, or reserved for future
 use by the listed feature.  Internal dedicated-purpose resources, such as
 port bandwidth limits or VLAN QoS priority, are not included.

NOTE: Resource usage includes resources actually in use, or reserved for future use by the listed
feature. Internal dedicated-purpose resources, such as port bandwidth limits or VLAN QoS priority,
are not included.

Show OpenFlow instance group
Syntax

show openflow instance <instance-name> groups

Show openflow instance group

switch(openflow)# show openflow instance test groups

OpenFlow Instance Groups
   Group ID                      : 2
   Group Type                    : All
   Group Location                : Hardware
   Is Hardware Counter Available : Yes
   Reference Count               : 0
   Packet Count                  : 0
   Byte Count                    : 0
   Duration                      : 57
   Action Buckets                : 1, 2
      Bucket 1
         Packet Count     : NA
         Byte Count       : NA
         Watch port       : Any
         Weight           : 0
         Action           : Output F12
      Bucket 2
         Packet Count     : NA
         Byte Count       : NA
         Watch port       : Any
         Weight           : 0
         Action           : Output F23

switch(openflow)# show openflow instance test groups
 OpenFlow Instance Groups
   Group ID                      : 3
   Group Type                    : All
   Group Location                : Software
   Reference Count               : 0
   Packet Count                  : 0
   Byte Count                    : 0
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   Duration                      : 27
   Action Buckets                : 1
      Bucket 1
         Packet Count     : 0
         Byte Count       : 0
         Watch port       : Any
         Weight           : 0
         Action           : Output A2
                            Output A3

Show OpenFlow instance flow table information
These commands display per instance flow table information, including both hardware and software flow tables.

NOTE: This option is available only for instances running OpenFlow version 1.3.

Viewing specific table capability
Syntax

show openflow instance <instance-name> flow-table<table-id> table-capability
Shows OpenFlow table capability information for a specific flow table ID.

Display OpenFlow flowtable capability

switch(of-inst-test)# show openflow instance test flow-table 100 table-capability

 OpenFlow Flow Table Properties

 Table Match Capabilities:
   Incoming Port                      Ethernet Destination
   Ethernet Source                    Ethernet Type
   VLAN ID                            VLAN PCP
   IP DSCP                            IP Protocol
   IPv4 Source Address                IPv4 Destination Address
   TCP Source Port                    TCP Destination Port
   UDP Source Port                    UDP Destination Port
   ICMP Type                          ICMP Code
   IPv6 Source Address                IPv6 Destination Address
   UDP Source Port Range              UDP Destination Port Range
   TCP Source Port Range              TCP Destination Port Range
   TCP Flags
 Table Wildcard Capabilities:
   Incoming Port                      Ethernet Destination
   Ethernet Source                    Ethernet Type
   VLAN ID                            VLAN PCP
   IP DSCP                            IP Protocol
   IPv4 Source Address                IPv4 Destination Address
   TCP Source Port                    TCP Destination Port
   UDP Source Port                    UDP Destination Port
   ICMP Type                          ICMP Code
   IPv6 Source Address                IPv6 Destination Address
   UDP Source Port Range              UDP Destination Port Range
   TCP Source Port Range              TCP Destination Port Range
   TCP Flags
 Table Instructions:
   Metering
   Apply Actions
      Set-Field
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         Ethernet Destination          Ethernet Source
         VLAN ID                       VLAN PCP
         IP DSCP
      Output                             Push VLAN
      Pop VLAN                           Group
   GoTo 200
 Table-Miss Instructions:
   Metering
   Apply Actions
      Output                             Group
   GoTo 200

switch(of-inst-test)# show openflow instance test flow-table 200 table-capability

 OpenFlow Flow Table Properties

 Table Match Capabilities:
   Incoming Port                      Ethernet Destination
   Ethernet Source                    Ethernet Type
   VLAN ID                            VLAN PCP
   IP DSCP                            IP ECN
   IP Protocol                        IPv4 Source Address
   IPv4 Destination Address           TCP Source Port
   TCP Destination Port               UDP Source Port
   UDP Destination Port               ICMP Type
   ICMP Code                          ARP Opcode
   ARP Source IPv4 Address            ARP Target IPv4 Address
   ARP Source Hardware Address        ARP Target Hardware Address
   IPv6 Source Address                IPv6 Destination Address
   IPv6 Flow Label                    ICMPv6 Type
   ICMPv6 Code                        Target Address for ND
   Source Link-Layer for ND           Target Link-Layer for ND
   IPv6 Extension Header Pseudo-field
   UDP Source Port Range              UDP Destination Port Range
   TCP Source Port Range              TCP Destination Port Range
   TCP Flags
 Table Wildcard Capabilities:
   Incoming Port                      Ethernet Destination
   Ethernet Source                    Ethernet Type
   VLAN ID                            VLAN PCP
   IP DSCP                            IP ECN
   IP Protocol                        IPv4 Source Address
   IPv4 Destination Address           TCP Source Port
   TCP Destination Port               UDP Source Port
   UDP Destination Port               ICMP Type
   ICMP Code                          ARP Opcode
   ARP Source IPv4 Address            ARP Target IPv4 Address
   ARP Source Hardware Address        ARP Target Hardware Address
   IPv6 Source Address                IPv6 Destination Address
   IPv6 Flow Label                    ICMPv6 Type
   ICMPv6 Code                        Target Address for ND
   Source Link-Layer for ND           Target Link-Layer for ND
   IPv6 Extension Header Pseudo-field
   UDP Source Port Range              UDP Destination Port Range
   TCP Source Port Range              TCP Destination Port Range
   TCP Flags
 Table Instructions:
   Apply Actions
      Set-Field
         Ethernet Destination          Ethernet Source
         Ethernet Type                 VLAN ID
         VLAN PCP                      IP DSCP
         IP ECN                        IP Protocol
         IPv4 Source Address           IPv4 Destination Address
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         TCP Source Port               TCP Destination Port
         UDP Source Port               UDP Destination Port
         ICMP Type                     ICMP Code
         ARP Opcode                    ARP Source IPv4 Address
         ARP Target IPv4 Address       ARP Source Hardware Address
         ARP Target Hardware Address   IPv6 Source Address
         IPv6 Destination Address      IPv6 Flow Label
         ICMPv6 Type                   ICMPv6 Code
         Target Address for ND         Source Link-Layer for ND
         Target Link-Layer for ND
      Output                 

Show OpenFlow instance information
You can display OpenFlow instance information.

Syntax

show openflow instance <instance-name>
Show OpenFlow instance information.

capabilities 
Show OpenFlow capabilities exchanged with the controller.

flow-table 
Display information for a flow table.

flows 
Show flow entries.

groups 
Show group table information.

limiters 
Show OpenFlow rate limits.

message-statistics 
Show message statistics information for an instance.

meters
Show instance-specific meters.

port-statistics 
Show port statistics.

Show OpenFlow instance capabilities information
Syntax

show openflow instance <instance-name> capabilities
Displays OpenFlow instance capabilities.

Example: Display OpenFlow instance capabilities information

switch# show openflow instance test capabilities
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Policy Engine Match Capability : Extended Match

Switch Capabilities
--------------------
Flow Statistics
Table Statistics
Port Statistics
Group Statistics
Blank Ports

Viewing OpenFlow instance flow-table
Syntax

show openflow instance <instance-name> flow-table

Show flow table

switch(of-inst-test)# show openflow instance test flow-table

 OpenFlow Instance Flow Table Information

 Table                       Flow     Available Free Miss
 ID    Table Name            Count    Flow Count     Count         Goto Table
 ----- --------------------- -------- -------------- ------------- -------------
 0     Start                 1        NA             0             100
 100   Policy Table          5        NA             0             200
 200   SW Table 1            4        NA             0             *

 * Denotes that the pipeline could end here.

Show OpenFlow instance flows
Shows the flow table entries for a particular OpenFlow instance.

Syntax

show openflow instance <instance-name> flows {flow-type}
flow-type shows the flow table entries for a particular OpenFlow instance.

The various flows that can be shown using the flow-type are:

destination-ip
Show flows matching the destination IP address.

destination-mac
Show flows matching the destination MAC address.

destination-port
Show flows matching the destination port.

ethernet-type
Show flows matching the EtherType.
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ip-protocol
Show flows matching the IP protocol.

ip-tos-bits
Show flows matching the IP ToS bits.

source-ip
Show flows matching the source IP address.

source-mac
Show flows matching the source MAC address.

source-port
Show flows matching the source port.

vlan-id
Show flows matching the VLAN ID.

vlan-priority
Show flows matching the VLAN priority.

destination-ipv6
Show flows matching the destination IPv6 address.

flow-table
Show only flows that are present in the flow-table mentioned.

ingress-port
Show flows matching the ingress port.

source-ipv6
Show flows matching the source IPv6 address.

Example: Flow version 1.0

(<openflow>)# show openflow instance titan flows
Flow 1 Match
  Incoming Port           : F24                  Ethernet Type    : IP
  Source MAC              : 000000-000000        Destination MAC  : 000000-000000
  VLAN ID                 : 0                    VLAN Priority    : 0
  Source Protocol Address : 255.255.255.255/32
  Target Protocol Address : 128.128.128.128/32
  IP Protocol             : 0x00                 IP ToS Bits      : 0
  Source Port             : 0                    Destination Port : 0
Attributes
  Priority                : 32768                Duration         : 10 secs
  Hard Timeout            : 0 secs               Idle Timeout     : 60 secs
  Byte Count              : 0                    Packet Count     : 0
  Controller ID           : 1                    Cookie           : 0x0
  Flow Location           : Software             Hardware Index   : 1
  Reason Code             : 100
  Reason Description      : Rule is in hardware
Actions
  Modify Destination IP   : 183.23.45.64
  Modify Source IP        : 200.123.23.54
  Output                  : A21
 
Example: Flow version 1.3
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(<openflow>)# show openflow instance titan flows
Flow 1
 Match
  Incoming Port           : 1/17                 Ethernet Type    : IP
  Source MAC              : 000000-000000        Destination MAC  : 000000-000000
  VLAN ID                 : 0                    VLAN Priority    : 0
  Source Protocol Address : 255.255.255.255/32
  Target Protocol Address : 128.128.128.128/32
  IP Protocol             : TCP                  IP ToS Bits      : 0
  IP ECN                  : 0                    IP DSCP          : 18
  Source Port              : 0                    Destination Port : 0
 Attributes
  Priority                : 32768                Duration         : 10 secs
  Hard Timeout            : 0 secs               Idle Timeout     : 0 secs
  Byte Count              : 5040                 Packet Count     : 28
  Flow Table ID           : 3                    Controller ID    : 1
  Activity Count          : 0xffffffff           Cookie           : 0x0
  Hardware Index          : 1
 Instructions
  Clear Actions
   Write Actions   Pop VLAN
         Push VLAN Decrement TTL
         Output: : 3/24, 4/5, 1/18
         Goto Table ID: 2
Flow 2
 Match
  Incoming Port           : Trk1                 Ethernet Type    : IPv6
  Source MAC              : 000000-000000        Destination MAC  : 000000-000000
  VLAN ID                 : 0                    VLAN Priority    : 0
  Source Protocol Address : 255.255.255.255/32
  Target Protocol Address : 128.128.128.128/32
  IPv6 Flow Label         : 0
  IPv6 Ext. Header        : Fragment
  ND Source MAC           : 000000-000000 ND     Destination MAC  : 00000-000000
  ND Target IP            : 0:0:0:0:0:0:0:0
  IP Protocol             : 0x2C
  IP ECN                  : 0                    IP DSCP          : 20
  Source Port              : 0                    Destination Port : 0
 Attributes
  Priority                : 12345                Duration         : 10 secs
  Hard Timeout            : 300 secs             Idle Timeout     : 160 secs
  Byte Count              : 0                    Packet Count     : 0
  Flow Table ID           : 6                    Controller ID    : 1
  Activity Count          : 0xffffffff           Cookie           : 0x0
  Hardware Index          : 1
 Instructions
  Apply Actions
     Modify Destination IP  : 2000::5
     Modify Source IP       : 2000::6
     Modify Source MAC      : 121212-121212
     Modify Destination MAC : 131313-131313
     Modify VLAN ID         : 123
     Modify IP DSCP         : 18
     Modify IP ECN          : 1
     Decrement TTL
     Meter ID                : 112
     Group ID               : 2
  Write Actions
     Decrement TTL
     Goto Table ID          : 4
Flow 3
 Match
  Incoming Port           : 0                    Ethernet Type    : ARP
  Source MAC              : 000000-000000        Destination MAC  : 000000-000000
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  VLAN ID                 : 0                    VLAN Priority    : 0
  ARP Opcode              : 1
  ARP Source MAC          : 00A0C9-22B210        ARP Target MAC   : 000000-000000
  Source Protocol Address : 255.255.255.255/32
  Target Protocol Address : 128.128.128.128/32
 Attributes
  Priority                : 32768                Duration         : 10 secs
  Hard Timeout            : 0 secs               Idle Timeout     : 0  secs
  Byte Count              : 12450                Packet Count     : 2323
  Flow Table ID           : 3                    Controller ID    : 3
  Activity Count          : 0xffffffff           Cookie           : 0x0
  Hardware Index          : 1
Flow 4
 Match
  Source MAC              : 000000-000000        Ethernet Type    : 0x8035
  VLAN ID                 : 0                    Destination MAC  : 000000-000000
  ARP Opcode              : 0                    VLAN Priority    : 0
  ARP Source MAC          : 000000-000000
  ARP Target MAC          : 000000-000000
  Source Protocol Address : 0.0.0.0
  Target Protocol Address : 0.0.0.0
  Source IP               : 0.0.0.0
  Destination IP          : 0.0.0.0              ARP Target IP      : 0.0.0.0
  IPv6 Flow Label         : 0
  IPv6 Ext. Header        : None
  ND Source MAC           : 000000-000000
  ND Target IP            : 0:0:0:0:0:0:0:0      ND Destination MAC : 000000-000000
  IP Protocol             : 0x00
  IP ECN                  : 0                    IP DSCP            : 0
  Source Port              : 0                    Destination Port   : 0
 Attributes
  Priority                : 32768                Duration           : 15 secs
  Hard Timeout            : 0 secs               Idle Timeout       : 50 secs
  Byte Count              : 0                    Packet Count       : 0
  Flow Table ID           : 5                    Controller ID      : 5
  Activity Count          : 0xffffffff           Cookie             : 0x0
  Hardware Index          : 1
 Instructions
  Write Actions
     Output  : 2/1
     Output  : Controller

Show group information for a specific instance
Syntax

show openflow instance <instance-name> groups
Displays group information for a specific instance.

Displays OpenFlow group table information. Groups are supported in software tables only. Up to 4 types of groups
are supported and 1024 groups across all instances. A select group uses the round-robin method for every packet
and the number of action buckets are capped to 8 per group. Groups can be filtered based on group-ID. show
openflow instance <instance-name> groups <group-id>

Example

show openflow instance test groups
Group ID                      : 1
Group Type                    : ALL
Reference Count               : 32767
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Packet Count                  : 0
Byte Count                    : 0
Duration                      : 10 seconds
Action Buckets                : 1, 2
 Bucket 1
 Packet Count                 : 0
 Byte Count                   : 0
 Watch port                   : Any
 Weight                       : 0
 Actions                      : output A1
 Bucket 2
   Actions                    :output F2
 Packet Count                 : 0
 Byte Count                   : 0
 Watch port                   : Any
 Weight                       : 0
 Action                       : Output F23

Group ID                      : 1
Group Type                    : SELECT
Reference Count               : 0
Packet Count                  : 0
Byte Count                    : 0
Duration                      : 10
Action Buckets                : 1
 Bucket 1
 Packet Count                 : 0
 Byte Count                   : 0
 Watch Port                   : Any
 Weight                       : 1
 Actions                      : output A

Group ID                      : 7
Group Type                    : INDIRECT
Reference Count               : 0
Packet Count                  : 0
Byte Count                    : 0
Duration                      : 10
Action Buckets                : 1
 Bucket 1
 Packet Count                 : 0
 Byte Count                   : 0
 Watch Port                   : Any
 Weight                       : 0
 Actions                      : output A1
Group ID                      : 32
 Group Type                   : FAST
 FAIL OVER
Reference Count               : 0
Packet Count                  : 0
Byte Count                    : 0
Duration                      : 10
Action Buckets                : 1
 Bucket 1
 Packet Count                 : 0
 Byte Count                   : 0
 Watch port                   : A1
 Weight                       : 0
 Actions                      : output A1
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Example

switch(config)# show openflow instance test groups

OpenFlow Instance Groups
 Group ID                                    : 2
 Group Type                                  : All
 Group Location                              : Hardware
 Is Hardware Counter Available               : No
 Reference Count                             : 1
 Packet Count                                : 0
 Byte Count                                  : 0
 Duration                                    : 30
 Action Buckets                              : 1, 2
Bucket 1
 Packet Count                                : 0
 Byte Count                                  : 0
 Watch port                                  : Any
 Weight                                      : 0
 Action                                      : Output F22
Bucket 2
 Packet Count                                : 0
 Byte Count                                  : 0
 Watch port                                  : Any
 Weight                                      : 0
 Action                                      : Output F23

Rule pointing to above Group:
Flow 3
Match
 Incoming Port          : Any Ethernet Type    : IP
 Source MAC             : Any Destination MAC  : Any
 Source MAC Mask        : 000000-000000
 Destination MAC Mask   : 000000-000000
 VLAN ID                : Any VLAN priority    : Any
 Source IP Address      : 11.11.11.11/32
 Destination IP Address : Any
 IP Protocol            : Any
 IP ECN                 : Any IP DSCP          : Any
 Source Port            : Any Destination Port : Any

Attributes
 Priority               : 32768        Duration          : 36 seconds
 Hard Timeout           : 0 seconds    Idle Timeout      : 0 seconds
 Byte Count             : NA           Packet Count      : 0
 Flow Table ID          : 100          Controller ID     : listen-port
 Cookie                 : 0x0
 Hardware Index: 17

Instructions
 Apply Actions
  Group                 : 2

Show per flow rate limiter information
Displays per-flow rate limiters information.

Syntax

show openflow instance <instance-name> limiters
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Example: Display per-flow rate-limiters for an OpenFlow instance

switch# show openflow instance test limiters

OpenFlow Instance Per Flow Rate Limiters
Maximum Limiters    :    256

                            Rate 
Limiter ID    Action       (kbps)          Flow Count 
----------    ------       ----------     ----------  
112           Drop          128                2  

Viewing message statistics for an instance
This command displays statistics for flow, port, group, meter modification, and table-features message from the
controller, the number of messages of that type received from the controller and the number of messages
rejected.

Syntax

show openflow instance <instance-name> message-statistics
Show message statistics information for an instance. This command displays the number of OpenFlow
modification messages received from the controller and the number of messages rejected by the switch.

Example: Display message-statistics for an OpenFlow instance

switch(of-inst-test)#  show openflow instance test message-statistics
 OpenFlow
 Message Type                            Received       Rejected
 --------------------------------------- -------------- --------
 OFPT_FLOW_MOD                           11             0
 OFPT_PORT_MOD                           0              0
 OFPT_GROUP_MOD                          0              0
 OFPT_METER_MOD                          1              0
 OFPMP_TABLE_FEATURES (Change Pipeline)  0              0
 OFPMP_TABLE_FEATURES (View Pipeline)    1              0

Show meter information for a specific instance
Displays meter information. Meters are instance-specific. Meters are supported only in hardware tables; the
maximum number of meters differs between platforms. DSCP remark meter is supported only in standard match
mode. Further, DSCP remark type band meter cannot be attached to flows with a non-IP match.

NOTE: When a same OpenFlow meter is used two or more times in an OpenFlow pipeline, it results
in the meter rates being skewed, leading to unpredictable behavior in how the packets are metered.
HPE recommends not using a meter more than once in a packet pipeline to avoid undesired
behaviors.

Syntax

show openflow instance <instance-name>
Example: Display meters for an OpenFlow instance

switch(of-inst-test)# show openflow instance test meters
 OpenFlow Instance Meters
 Meter ID             : 17
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 Flow Count           : 0
 Input Packet Count   : 0
 Input Byte Count     : 0
 Duration             : 6
                            Packet/Byte
 Band Type Rate             Count
 --------- ---------------- --------------------
 Drop      500 kbps         0

Viewing port statistics per instance
Syntax

show openflow instance <instance-name> port-statistics
Displays port statistics information per instance.

Example: Display port statistics for version 1.3

switch# show openflow instance test port-statistics
Number of Ports                                    : 2
Port 47          : Up
 Status
 Admin. Status   : Enabled             Flood       : Enabled
 Receive         : Enabled             Forward     : Enabled
 Packet_in       : Enabled
 Statistics
 Collisions      : 0
 Rx Packets      : 0                   Tx Packets  : 68
 Rx Bytes        : 0                   Tx Bytes    : 8066
 Rx Dropped      : 0                   Tx Dropped  : 0
 Rx Errors       : 0                   Tx Errors   : 0
 Frame Errors    : 0
 CRC Errors      : 0
 Overrun Errors  : 0
 Port 48: Down
 Status
 Admin. Status   :                     Flood       :
 Receive         :                     Forward     :
 Packet_in       :
 Statistics
 Collisions      :
 Rx Packets      : 0                   Tx Packets  : 0
 Rx Bytes        : 0                   Tx Bytes    : 0
 Rx Dropped      : 0                   Tx Dropped  : 0
 Rx Errors       : 0                   Tx Errors   : 0
 Frame Errors    : 0
 CRC Errors      : 0
 Overrun Errors  : 0
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Diagnostic Tools Overview and Usage
Debug OpenFlow
You can display OpenFlow protocol packets or event description.

NOTE: The debug openflow packets option displays only OpenFlow protocol packets
exchanged between the switch and the controller.

Syntax

switch# debug openflow <errors|events|instance|packets>
errors

Display OpenFlow error messages.

events
Enable debug messages for all OpenFlow events like addition/deletion/modification, enable/disable.

instance
Specify an OpenFlow instance for instance-specific debug messages.

packets
Enable debug messages for all OpenFlow packets.

Example: Debug logs

Flow deletion

mOFCtrlTask: 00020| DBG|Flow deletion:
idle_timeout=60,dl_type=0x0800,in_port=27,dl_vlan=65535,
dl_vlan_pcp=0,dl_src=00:50:56:9f:5f:0a,dl_dst=00:50:56:9f:19:92,
nw_src=1.2.3.6,nw_dst=1.2.3.4,icmp_type=0,icmp_code=0,
actions=output:26
Flow addition

mOFCtrlTask: 00019| DBG|Flow addition:
idle_timeout=60,dl_type=0x0800,in_port=27,
dl_vlan=65535,dl_vlan_pcp=0,dl_src=00:50:56:9f:5f:0a,
dl_dst=00:50:56:9f:19:92,nw_src=1.2.3.6,nw_dst=1.2.3.4,
icmp_type=0,icmp_code=0,actions=output:26
Flow expiry

mOFCtrlTask: 00018| DBG|Flow expiry:
idle_timeout=1200,dl_type=0x0800,nw_src=1.2.3.7,
nw_dst=1.2.3.8,actions=mod_nw_src:9.8.7.6

Chapter 13
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Error messages
Interoperability error messages
Enabling OpenFlow

Enabling OpenFlow when Meshing is enabled results in an error message similar to the following: OpenFlow
cannot be enabled when Meshing is configured.
Enabling meshing

Enabling meshing when OpenFlow is enabled results in an error message similar to the following: Meshing
cannot be configured when OpenFlow is enabled.
Enable OpenFlow with QinQ

Enabling OpenFlow when Q-in-Q is enabled results in an error message similar to the following: OpenFlow
cannot be enabled when Q-in-Q is configured.
Enabling QinQ with OpenFlow

Enabling Q-in-Q when OpenFlow is enabled results in an error message similar to the following: Q-in-Q cannot
be configured when OpenFlow is enabled.
Enabling transparent mode

Enabling Transparent Mode (TRmode) when OpenFlow is enabled results in an error message similar to the
following: Transparent Mode cannot be enabled when OpenFlow is enabled.
Enabling OpenFlow with transparent mode

Enabling OpenFlow when Transparent Mode is enabled results in an error message similar to the following:
OpenFlow cannot be enabled when Transparent Mode is enabled.
Enabling remote mirror endpoint

Enabling Remote Mirror Endpoint when OpenFlow is enabled generates an error message similar to the following.
Remote Mirror Endpoint cannot be configured when OpenFlow is enabled.
Enabling OpenFlow with remote mirror endpoint

Enabling OpenFlow when Remote Mirror Endpoint is enabled generates an error message similar to the following.
OpenFlow cannot be enabled when Remote Mirror Endpoint is configured.
Adding a port

Adding a port to a trunk that is part of an OpenFlow member VLAN generates an error message similar to the
following.

Trunk in use by an OpenFlow instance may not be modified.
Deleting a port

Deleting a port from a trunk that is part of an OpenFlow member VLAN generates an error message similar to the
following.

Trunk in use by an OpenFlow instance may not be modified.
Moving a trunk

When moving a trunk that is part of an OpenFlow member VLAN from one VLAN to another, the VLAN generates
an error message similar to the following:

Trunk in use by an OpenFlow instance may not be moved.
Tagging/Untagging trunk
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Toggling membership of the trunk from tagged to untagged when that trunk is part of an OpenFlow member VLAN
generates an error message similar to the following.

Trunk in use by an OpenFlow instance may not be modified.
Enable LACP

Trying to enable LACP while OpenFlow is enabled generates the following error message.

LACP cannot be configured when OpenFlow is enabled.
Enable OpenFlow

Trying to enable OpenFlow when LACP is enabled generates the following error message.

OpenFlow cannot be configured when LACP is enabled.
Show per-flow rate limiters

Trying to show per-flow rate limiters for an instance running OpenFlow version 1.3 generates an error message
similar to the following.

This command is supported only for an OpenFlow version 1.0 instance.
no allow-V1–module

Trying to run the command no allow-V1-module when OpenFlow is enabled, generates an error message
similar to the following.

V1 modules cannot be disabled when OpenFlow is enabled.
allow-V1–module

Trying to run the command allow-V1-module when OpenFlow is enabled generates an error message similar
to the following.

V1 modules cannot be enabled when IP Control Table Mode is enabled.
Non-compatible mode

Trying to enable OpenFlow when a switch is in a non-compatible mode (no allow-V1–module) generates an error
message similar to the following.

OpenFlow cannot be enabled when V1 modules are disabled.
Enable virus throttling

Trying to enable virus throttling when OpenFlow is enabled generates an error message similar to the following.

Virus throtting cannot be enabled when OpenFlow is enabled.
Enable OpenFlow with virus throttling

Trying to enable OpenFlow when virus throttling is enabled generates an error message similar to the following.

OpenFlow cannot be configured when virus throttling is enabled.

Controller error messages
Deleting an unconfigured controller

Attempt to delete a controller that has not been configured results in an error message similar to the following:
switch(vlan-3)# no openflow controller-id 2 [controller-id] 2 not found.
Configure or modifying an existing controller

Attempting to configure a controller that exists or modifying the parameters of an existing controller results in an
error message similar to the following: A controller is already configured with this ID.
Associated controllers
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Attempting to delete existing controllers previously associated with an OpenFlow instance result in an error
message similar to the following: Controller cannot be removed when in use by an OpenFlow
instance.
Setting IP Control Table mode

Attempting to set IP Control Table Mode when the switch is in compatible mode results in an error message
similar to the following:

IP Control Table Mode cannot be set when V1 module is enabled.
Specifying an invalid flow table

Attempting to specify an invalid flow table ID results in an error message similar to the following:

Invalid flow table number
Listen port or controller error

Commands issued from listen port or controllers are not successful.

Procedure

1. Enable debug openflow, which displays the switch output, helping you determine whether the error occurs
at the switch or the controller.

2. Enable debug openflow instance [instance-name] to further identify the error.

3. Verify the packet capture for the request and reply to isolate whether the error is occurring at the switch or the
controller.

NOTE: This problem occurs if some controllers do not fully conform to the specification and
therefore cannot handle replies from the switch. The replies in the packet capture are visible from
the switch, but not from the controller.

4. Enable debug destination session to further identify the error.

Specifying a port

An attempt to specify an application port that is out of range results in an error message similar to the following:

Invalid port. Valid range is 1024–65534.

Port error messages
Egress-only ports

Trying to enable or disable egress-only ports when OpenFlow is enabled generates an error message similar to
the following.

Egress only ports can be set only when OpenFlow is disabled.

Limiter error messages
Removing limiters

Trying to remove a limiter when none are configured for an instance generates an error message similar to the
following.

No limiters found for this OpenFlow instance.

VLAN error messages
Member to controller VLAN
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Specifying a member VLAN as a controller VLAN results in an error message similar to the following: The
specified VLAN is already member of OpenFlow instance instance-name and hence
cannot be added as controller interface.
VLAN in an OpenFlow instance

Specifying a VLAN that is already a part of a different OpenFlow instance results in an error message similar to
the following: The VLAN specified is already a member of another OpenFlow instance.
VLAN range

Specifying a VLAN that is outside the allowed VLAN range results in an error message similar to the following:
Invalid Input : VLAN-ID
Management VLAN

When the user tries to add the management VLAN to an OpenFlow instance results in an error message similar
to the following: A management VLAN cannot be a member of an OpenFlow instance.
Configure VLAN as management

When the user tries to configure an OpenFlow instance VLAN as management VLAN results in an error message
similar to the following: Management VLAN cannot be configured. VLAN <n> is member of an
OpenFlow instance.
Dynamic VLAN

When a dynamic VLAN is added as a member VLAN, the result is an error message similar to the following:
Dynamic VLAN cannot be added as a member VLAN.
Controller interface

Adding a controller interface as member VLAN results in an error message similar to the following: Controller
interface cannot be added as member VLAN.

Instance error messages
Enable a named instance

Attempting to enable a named instance without a listen port or controller and a member VLAN displays an error
message similar to the following: A controller and a member VLAN must be added to the named
instance before enabling it.
Enable an aggregate instance

Attempting to enable an aggregate instance without a listen port or controller displays an error message similar to
the following: A listen-port or a controller must be added to the aggregate instance
before enabling it.
Maximum number of instances

Configuring an instance when the maximum number of OpenFlow instances is already configured displays an
error message similar to the following: Maximum number of OpenFlow instances (128) already
configured.
Instance name that exceeds length

Configuring an instance with a name that exceeds the maximum length requirement displays an error message
similar to the following: Maximum length of the instance-name is 32 characters.
Create an aggregate instance

Trying to create an aggregate instance when a named instance exists on the switch displays an error message
similar to the following: An aggregate instance cannot be created when named instances
exist.
Create a named instance

Chapter 13 Troubleshooting OpenFlow 105

Anexo 06 ITENS 8 E 9 (0592717)         SEI 0008478-63.2018.6.02.8000 / pg. 7478



Trying to create a named instance when an aggregate instance is already configured displays an error message
similar to the following: Named instances cannot be created when an aggregate instance
exists.
Deleting an instance

Trying to delete a nonexistent instance displays an error message similar to the following: Instance not
found.
Enabling an instance

Attempting to enable an OpenFlow instance without configuring a listen port or a controller displays an error
message similar to the following: A listen-port or a controller, and a member VLAN must be
added to the named instance before enabling it.
Delete a member

Trying to delete a member that does not belong to the instance displays an error message similar to the following:
VLAN VLAN-ID is not a member of this instance.
Modifying backoff interval

Trying to modify the backoff interval when the instance is enabled displays an error message similar to the
following: Instance configuration cannot be modified when the instance is enabled.
Instance name

When naming an instance, only alphabetic characters, numerals, and underscores are allowed in the instance
name. Failure to follow this rule results in an error message similar to the following: Invalid name. Only
alphanumeric characters and underscores are allowed.

Errors concerning auxiliary connections
Removing auxiliary connection

Removing an auxiliary connection that is associated displays an error message similar to the following
Auxiliary connection is in use by an OpenFlow instance and cannot be removed.
Deleting unconfigured auxiliary connection

Deleting an auxiliary connection that has not been configured displays an error message similar to the following.
Auxiliary connection index not found.
Associating multiple auxiliary indexes

Associating more than one auxiliary index displays an error message similar to the following. Only one
auxiliary connection can be configured per main controller connection.
Associating unconfigured auxiliary indexes

Associating an auxiliary index that is not configured, displays an error message similar to the following. No
auxiliary connection is configured with this index.
Checking for the static limit

Checking for the static limit and error out while configuring displays an error message similar to the following.
Maximum number of auxiliary connections configured.
Associating auxiliary connection

Associating an auxiliary connection to an instance running version 1.0 displays an error message similar to the
following. Auxiliary connection can only be associated with instance running version
1.3 and above.
Associating multiple auxiliary connections
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Associating more than one auxiliary connection to an instance controller connection displays an error message
similar to the following. Only one auxiliary connection can be configured per main
controller connection.

Other scenarios
Setting policy engine resource usage when OpenFlow is enabled

When the policy engine resource usage is set while OpenFlow is enabled, an error message similar to the
following is displayed: Resource usage can be set only when OpenFlow is disabled.
Securing a connection with no certificate configured

When securing a connection with no certificate configured for OpenFlow, an error message similar to the following
is displayed: Certificate for OpenFlow is not configured.
Setting the protocol version with instances enabled

Setting the protocol version when instances are enabled results in an error message similar to the following:
Instance configuration cannot be modified when the instance is enabled.

Troubleshooting an instance
To troubleshoot instances, check the following.

• To connect a controller, there must be ip-connectivity between controller and switch over the controller VLAN.

• The controller must be capable of negotiating to a version equal to or less than the configured or supported
version

• Use the show openflow command to check instances.

Example

switch(openflow)# show openflow
OpenFlow : Enabled
Egress Only Ports Mode : Disabled
Instance Information
No. of No. of OpenFlow
Instance Name Oper. Status H/W Flows S/W Flows Version
------------------------------ ------------ ---------- ---------- --------
test Up 1 4 1.0
Use the show openflow instance <instance-name> command.

Example

switch(openflow)# show openflow instance test
Configured OF Version : 1.0
Negotiated OF Version : 1.0
Instance Name : test
Data-path Description : test
Administrator Status : Enabled
Member List : VLAN 3
Pipeline Model : Standard MatchListen Port : 6633
Operational Status : Up
Operational Status Reason : NA
Datapath ID : 000340a8f09e8600
Mode : Active
Flow Location : Hardware and Software
No. of Hardware Flows : 1
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No. of Software Flows : 4
Hardware Rate Limit : 0 kbps
Software Rate Limit : 100 pps
Conn. Interrupt Mode : Fail-Secure
Maximum Backoff Interval : 60 seconds
Probe Interval : 10 seconds
Hardware Table Miss Count : 0
No. of Software Flow Tables : NA
Egress Only Ports : None
Table Model : Single Table
Source MAC Group Table : Disabled
Destination MAC Group Table : Disabled
Controller Id Connection Status Connection State Secure Role
------------- ----------------- ---------------- ------ ------
1 Connected Active No Equal

Commands issued from listen port or controllers are not successful
When commands issued from the listen port or the controller are not successful, the following commands can be
used to isolate and troubleshoot the problem.

Syntax

show openflow instance <instance-name> flow-table <flow-table-number> table-capabilities
To display the table-capabilities of the instance in OpenFlow 1.3.

Syntax

show vlan <member-vlan-no>
To display the port-description.

Syntax

show openflow instance <instance-name>
To see egress-only ports.

Syntax

show openflow instance <instance-name> port-statistics
To display port statistics.

Syntax

show openflow instance <instance-name> meters <meter-id>
To display the meter statistics.

Syntax

show openflow instance <instance-name> groups
To display groups.

Connection interruption mode setting
For minimal impact to an underlying network when a switch loses connection to the controller, the recommended
setting is fail-standalone mode.
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Flow modification
Add/Modify/Delete flow

When the switch rejects a request to add, modify, or delete a flow mod, use the following command:

Syntax
show openflow instance <instance-name> message-statistics
Example

switch(of-inst-test)# show openflow instance test message-statistics

 OpenFlow
 Message Type                            Received       Rejected
 --------------------------------------- -------------- --------
 OFPT_FLOW_MOD                           11             0
 OFPT_PORT_MOD                           0              0
 OFPT_GROUP_MOD                          0              0
 OFPT_METER_MOD                          0              0
 OFPMP_TABLE_FEATURES (Change Pipeline)  0              0
 OFPMP_TABLE_FEATURES (View Pipeline)    1              0
Verifying flows

The flow can be verified at the switch by using the following command.

Syntax
show openflow instance <instance-name> flows
Enable debug openflow at the switch. Run the command and observe the debug output for more specific
reasons why the switch rejected the flow.

NOTE: Similar troubleshooting techniques can be employed for port-modification, meter-
modification, and group-modification issues.

Programming flow errors
When programming flows via a controller, error messages may be returned based on implementation restrictions
in the OpenFlow switch. Examples relevant to OpenFlow 1.3 include:

• Table 0 restrictions

• Table 0, a read-only table, in the OpenFLow 1.3 multiple pipeline represents the start of the pipeline.

IP control table restrictions

The following may have caused the error conditions for Table 50:

• Table-miss rule is read-only.

• Only unicast IP addresses can be used as match parameters in a flow.

• Only “Goto” instruction is supported by this table.
• Flow with invalid VLAN match parameter is not allowed. A VLAN that does not exist

on the switch is considered invalid.

Possible errors returned to the controller:
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OFPERR_OFPMFC_EPERM

OFPERR_OFPFMFC_TABLE_FULL

OFPERR_OFPBMC_BAD_FIELD (Bad or unsupported match parameter in the flow)

OFPERR_OFPBAC_BAD_TYPE (Bad or unsupported action in the flow)

OFPERR_OFPBIC_BAD_TABLE_ID

OFPERR_OFPFMFC_UNKNOWN (Any internal system error)

Policy engine table restrictions

Error conditions for Table 100, 101, or 102 may result from the following:

• In Aggregate mode, an Output-Port action is allowed only if the flow has VLAN as a match field or has as a
Modify-VLAN action specified.

• Modify VLAN-PCP and P-ToS are the only Set-field actions allowed along with Output:NORMAL action.

OpenFlow V1.0 instance

OpenFlow 1.0 exposes a single table to the controller. The action of the default table-miss rule for such an
instance is "Goto Controller".

OpenFlow 1.3 instance

OpenFlow 1.3 instance exposes a multi-table model. For every table, the action of the default table-miss rule is
“DROP”. The controller must appropriately modify the table-miss rule for every table, for traffic to traverse the
multi-table pipeline.

Example

Consider the table model in standard mode comprised of tables 0, 100, 200-201-202-203:

• If a rule is programed into table 200 that permits traffic, then unless the default “table-miss rule” for table 100 is
modified, traffic does not pass to table 200.

• If the default table-miss rule of table 100 is modified with the action given as “Gototable 200”, traffic proceeds
to table 200. A table-miss rule must be programmed similarly for table 200, and so on.

NOTE:

A table-miss rule is a flow with priority of 0 and all match fields wild-carded.

Flows go missing after addition
Verify the idle-timeout/hard-timeout of the flow.

• Table 50 supports only 12 seconds as the minimum hardware refresh rate. Flows programmed in this table
must have at least an idle-timeout of twice that, or 24 seconds.

• Tables 100/101/102 support a configurable hardware refresh rate. If the “policy-engine-table refresh-interval” is
configured for 5 seconds, minimum idle-timeout supported is 10 seconds (double the time configured.)
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Missing line rate performance after flows are successfully installed
If an instance is running OpenFlow v1.0 and the flow cannot be accommodated in the hardware or a higher
priority overlapping rule is present in software, or we have reached the policy engine usage limit configured, the
flow will be housed in the software table. Use the show openflow instance <instance-name> flows
command to verify that the flow is housed in the software table.

If the flow is programmed in software, line rate performance is not seen in packet forwarding.

To know which flows are accommodated in hardware, see the Flow classification section of this document.

For an OpenFlow1.3 instance, there could be several software tables, 200 to 203.

Troubleshooting scenarios and error messages

How to troubleshoot if instance is not coming up
When an instance is not coming up, use the following commands to troubleshoot the instance status.

Procedure

1. Run the show openflow command.

switch(openflow)# show openflow

 OpenFlow                     : Enabled
 Egress Only Ports Mode       : Disabled

 Instance Information

                                                 No. of     No. of     OpenFlow
  Instance Name                     Oper. Status H/W Flows  S/W Flows  Version
  --------------------------------- ------------ ---------- ---------- --------
  test                              Up           0          0          1.0

2. Run the show openflow instance <instance-name> command.

switch(openflow)# show openflow instance test

 Configured OF Version         : 1.0
 Negotiated OF Version         : 1.0
 Instance Name                 : test
 Data-path Description         : test
 Administrator Status          : Enabled
 Member List                   : VLAN 3
 Pipeline Model                : Standard Match
 Listen Port                   : 6633
 Operational Status            : Up
 Operational Status Reason     : NA
 Datapath ID                   : 000340a8f09e8600
 Mode                          : Active
 Flow Location                 : Hardware and Software
 No. of Hardware Flows         : 0
 No. of Software Flows         : 0
 Hardware Rate Limit           : 0 kbps
 Software Rate Limit           : 100 pps
 Conn. Interrupt Mode          : Fail-Secure
 Maximum Backoff Interval      : 60 seconds
 Probe Interval                : 10 seconds
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 Hardware Table Miss Count     : 0
 No. of Software Flow Tables   : NA
 Egress Only Ports             : None
 Table Model                   : Single Table
 Source MAC Group Table        : Disabled
 Destination MAC Group Table   : Disabled

 Controller Id Connection Status Connection State Secure Role
 ------------- ----------------- ---------------- ------ ------
 1             Disconnected      Backoff          No     Equal

Reporting problems
If you are unable to solve a problem with OpenFlow, do the following:

1. Read the release notes for OpenFlow to see if the problem is known. If it is, follow the solution offered to solve
the problem.

2. Determine whether the product is still under warranty or whether your company purchased support services for
the product. Your operations manager can supply you with the necessary information.

3. If the problem you are experiencing has already been reported, access HPE Support Center and search the
technical knowledge databases to determine the type of documentation and resources you have access to,
which depends on your level of entitlement.

NOTE: The HP Support Center at HPE Support Center offers peer-to-peer support to solve
problems and is free to users after registration.

If this problem is new or if you need additional help, log your problem with the HP Support Center, either on
line through the support case manager at HPE Support Center, or by calling HPE Support. If your warranty
has expired or if you do not have a valid support contract for your product, you can still obtain support services
for a fee, based on the amount of time and material required to solve your problem.

4. If you are requested to supply any information pertaining to the problem, gather the necessary information and
submit it. The following sections describe some of the information that you may be asked to submit.

OpenFlow Flow-Mod and Pipeline-Mod error message
enhancements
Users can track the reasons why a flow or a pipeline is being rejected by a switch.

Operation notes

• More descriptive reasoning is given with specific OpenFlow error codes which helps explain why the switch
rejected a particular flow or pipeline.

• Supported only for instances running OpenFlow 1.3.

• Supported on v1, v2, and v3 of ASICs.

• Supported on all pipeline-models — standard-match, ip-control, and custom.

• Statistics are tracked per OpenFlow instance.

Restrictions

Not all OpenFlow flow-mod and pipeline-mod related failures are tracked.
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Networking Websites
Hewlett Packard Enterprise Networking Information Library

www.hpe.com/networking/resourcefinder

Hewlett Packard Enterprise Networking Software

www.hpe.com/networking/software

Hewlett Packard Enterprise Networking website

www.hpe.com/info/networking

Hewlett Packard Enterprise My Networking website

www.hpe.com/networking/support

Hewlett Packard Enterprise My Networking Portal

www.hpe.com/networking/mynetworking

Hewlett Packard Enterprise Networking Warranty

www.hpe.com/networking/warranty

General websites
Hewlett Packard Enterprise Information Library

www.hpe.com/info/EIL

For additional websites, see Support and other resources.
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Accessing Hewlett Packard Enterprise Support
• For live assistance, go to the Contact Hewlett Packard Enterprise Worldwide website:

http://www.hpe.com/assistance

• To access documentation and support services, go to the Hewlett Packard Enterprise Support Center website:

http://www.hpe.com/support/hpesc

Information to collect

• Technical support registration number (if applicable)

• Product name, model or version, and serial number

• Operating system name and version

• Firmware version

• Error messages

• Product-specific reports and logs

• Add-on products or components

• Third-party products or components

Accessing updates
• Some software products provide a mechanism for accessing software updates through the product interface.

Review your product documentation to identify the recommended software update method.

• To download product updates:

Hewlett Packard Enterprise Support Center
www.hpe.com/support/hpesc

Hewlett Packard Enterprise Support Center: Software downloads
www.hpe.com/support/downloads

Software Depot
www.hpe.com/support/softwaredepot

• To subscribe to eNewsletters and alerts:

www.hpe.com/support/e-updates

• To view and update your entitlements, and to link your contracts and warranties with your profile, go to the
Hewlett Packard Enterprise Support Center More Information on Access to Support Materials page:

www.hpe.com/support/AccessToSupportMaterials

Chapter 15
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IMPORTANT: Access to some updates might require product entitlement when accessed through
the Hewlett Packard Enterprise Support Center. You must have an HPE Passport set up with
relevant entitlements.

Customer self repair
Hewlett Packard Enterprise customer self repair (CSR) programs allow you to repair your product. If a CSR part
needs to be replaced, it will be shipped directly to you so that you can install it at your convenience. Some parts
do not qualify for CSR. Your Hewlett Packard Enterprise authorized service provider will determine whether a
repair can be accomplished by CSR.

For more information about CSR, contact your local service provider or go to the CSR website:

http://www.hpe.com/support/selfrepair

Remote support
Remote support is available with supported devices as part of your warranty or contractual support agreement. It
provides intelligent event diagnosis, and automatic, secure submission of hardware event notifications to Hewlett
Packard Enterprise, which will initiate a fast and accurate resolution based on your product's service level.
Hewlett Packard Enterprise strongly recommends that you register your device for remote support.

If your product includes additional remote support details, use search to locate that information.

Remote support and Proactive Care information
HPE Get Connected

www.hpe.com/services/getconnected
HPE Proactive Care services

www.hpe.com/services/proactivecare
HPE Proactive Care service: Supported products list

www.hpe.com/services/proactivecaresupportedproducts
HPE Proactive Care advanced service: Supported products list

www.hpe.com/services/proactivecareadvancedsupportedproducts

Proactive Care customer information
Proactive Care central

www.hpe.com/services/proactivecarecentral
Proactive Care service activation

www.hpe.com/services/proactivecarecentralgetstarted

Warranty information
To view the warranty information for your product, see the links provided below:

HPE ProLiant and IA-32 Servers and Options
www.hpe.com/support/ProLiantServers-Warranties

HPE Enterprise and Cloudline Servers
www.hpe.com/support/EnterpriseServers-Warranties

HPE Storage Products
www.hpe.com/support/Storage-Warranties

HPE Networking Products
www.hpe.com/support/Networking-Warranties
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Regulatory information
To view the regulatory information for your product, view the Safety and Compliance Information for Server,
Storage, Power, Networking, and Rack Products, available at the Hewlett Packard Enterprise Support Center:

www.hpe.com/support/Safety-Compliance-EnterpriseProducts

Additional regulatory information

Hewlett Packard Enterprise is committed to providing our customers with information about the chemical
substances in our products as needed to comply with legal requirements such as REACH (Regulation EC No
1907/2006 of the European Parliament and the Council). A chemical information report for this product can be
found at:

www.hpe.com/info/reach

For Hewlett Packard Enterprise product environmental and safety information and compliance data, including
RoHS and REACH, see:

www.hpe.com/info/ecodata

For Hewlett Packard Enterprise environmental information, including company programs, product recycling, and
energy efficiency, see:

www.hpe.com/info/environment

Documentation feedback
Hewlett Packard Enterprise is committed to providing documentation that meets your needs. To help us improve
the documentation, send any errors, suggestions, or comments to Documentation Feedback
(docsfeedback@hpe.com). When submitting your feedback, include the document title, part number, edition,
and publication date located on the front cover of the document. For online help content, include the product
name, product version, help edition, and publication date located on the legal notices page.
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Flow classification on v1, v2, and v3 modules
Hardware differences between v1, v2, and v3 modules affect flow match and capabilities. For additional
information about modules, see the latest Release Notes for your switch.

Hardware match chart

Appendix A
Flow classification on v1, v2, and v3 modules
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OpenFlow 1.3 multi-table model and device modes
Figure 16: Standard mode (default)

Figure 17: IP control table default
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Table 7: Device modes and OpenFlow table model

OpenFlow
Protocol Version

Switch Mode Table Model Number of
tables

Matching ability Actions in
Hardware (Nov
2013)

v1.0 Compatible
Mode – “allow-
v1-modules”

(v1 and v2) acts
as v1

Single table only 1 Same as 15_10 Same as 15_10

v1.0 Non Compatible
Mode – “no
allow-v1-
modules”

(v2 only) act as
v2

Single table only 1 Full 12 tuple
match in policy
engine

Same as 15_10

Plus new actions
– rewrite VLAN
ID, rewrite MAC
address, forward
to multiple ports

v1.3 Compatible
Mode

(v1 and v2) acts
as v1

Standard Match 1 policy engine
+ 1 software

Same as 15_10 Same as 15_10

v1.3 Non-Compatible
Mode

(v2 only) act as
v2

Standard Match 1 policy engine
+ 1 software

Full 12 tuple
match in policy
engine

Same as 15_10

Plus new actions
- rewrite VLAN
ID, rewrite MAC
address, forward
to multiple ports

v1.3 Non-Compatible
Mode

(v2 only) act as
v2

IP Control Mode 1 IP Control
Table + 1 Policy
Engine Table + 1
software Table.

{src. VLAN, src.
IP, dst. IP} in IP
control table +

Full 12 tuple
match in policy
engine

Same as 15_10

Plus new actions
in - rewrite VLAN
ID, rewrite MAC
address, forward
to multiple ports

Flow table capabilities

Match/Set-Field
OpenFlow instance running in custom pipeline-model supports tables with the following base class match fields
(not all in a single table).
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Field Match
Supported

Mask
Supported

Supported
since

Set-Field
Supported

Supported
since

OFPXMT_OFB_ETH_DST Yes Yes 15.17 Yes 15,17

OFPXMT_OFB_METADATA Yes Yes 15.17 Yes 15.17

OFPXMT_OFB_VLAN_VID Yes No 15.17 Yes 15.17

OFPXMT_OFB_VLAN_PCP Yes N/A 15.17 Yes 15.17

OFPXMT_OFB_IP_DSCP Yes N/A 15.17 Yes 15.17

OFPXMT_OFB_IPV4_SRC Yes Yes 15.17 Yes 15.17

OFPXMT_OFB_IPV4_DST Yes Yes 15.17 Yes 15.17

OFPXMT_OFB_TCP_SRC Yes N/A 15.17 Yes 15.17

OFPXMT_OFB_TCP_DST Yes N/A 15.17 Yes 15.17

OFPXMT_OFB_UDP_SRC Yes N/A 15.17 Yes 15.17

OFPXMT_OFB_UDP_DST Yes N/A 15.17 Yes 15.17

OFPXMT_OFB_IN_PORT Yes N/A 15.17 N/A N/A

OFPXMT_OFB_IN_PHY_PORT N/A N/A N/A N/A N/A

OFPXMT_OFB_METADATA No No N/A N/A N/A

OFPXMT_OFB_ETH_TYPE Yes N/A 15.17 N/A N/A

OFPXMT_OFB_IP_ECN No N/A N/A N/A N/A

OFPXMT_OFB_IP_PROTO Yes N/A 15.17 N/A N/A

OFPXMT_OFB_SCTP_SRC No N/A N/A No N/A

OFPXMT_OFB_SCTP_DST No N/A N/A No N/A

OFPXMT_OFB_ICMPV4_TYPE Yes N/A 16.02 No N/A

OFPXMT_OFB_ICMPV4_COD
E

Yes N/A 16.02 No N/A

OFPXMT_OFB_ARP_OP Yes N/A 16.02 No N/A

OFPXMT_OFB_ARP_SPA Yes Yes 16.02 No N/A

OFPXMT_OFB_ARP_TPA Yes Yes 16.02 No N/A
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Field Match
Supported

Mask
Supported

Supported
since

Set-Field
Supported

Supported
since

OFPXMT_OFB_ARP_SHA Yes Yes 16.02 No N/A

OFPXMT_OFB_ARP_THA Yes Yes 16.02 No N/A

OFPXMT_OFB_IPV6_SRC Yes Yes 15.17 No N/A

OFPXMT_OFB_IPV6_DST Yes Yes 15.17 No N/A

OFPXMT_OFB_IPV6_FLABEL Yes Yes 16.02 No N/A

OFPXMT_OFB_IPV6_ND_SLL No N/A N/A No N/A

OFPXMT_OFB_IPV6_ND_TLL No N/A N/A No N/A

OFPXMT_OFB_MPLS_LABEL No N/A N/A No N/A

OFPXMT_OFB_MPLS_TC No N/A N/A No N/A

OFPXMT_OFP_MPLS_BOS No N/A N/A No N/A

OFPXMT_OFB_PBB_ISID No No N/A No N/A

OFPXMT_OFB_TUNNEL_ID No No N/A No N/A

OFPXMT_OFB_IPV6_EXTHDR No No N/A No N/A

Instructions

Instruction Supported Supported since

OFPIT_GOTO_TABLE Yes 15.17

OFPIT_WRITE_METADATA No N/A

OFPIT_WRITE_ACTIONS Yes 15.17

OFPIT_APPLY_ACTIONS Yes 15.17

OFPIT_CLEAR_ACTIONS Yes 15.17

OFPIT_METER Yes 15.17
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Actions

Action Supported Supported since

OFPAT_OUTPUT Yes 15.17

OFPAT_COPY_TTL_OUT No

OFPAT_COPY_TTL_IN No

OFPAT_SET_MPLS_TTL No

OFPAT_DEC_MPLS_TTL No

OFPAT_PUSH_VLAN Yes 15.17

OFPAT_POP_VLAN Yes 15.17

OFPAT_PUSH_MPLS No

OFPAT_POP_MPLS No

OFPAT_SET_QUEUE No

OFPAT_GROUP Yes 15.17

OFPAT_SET_NW_TTL Yes 15.17

OFPAT_DEC_NW_TTL No

OFPAT_SET_FIELD Yes 15.17

OFPAT_PUSH_PBB No

OFPAT_POP_PBB No
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Implementation notes
This section documents some of the behaviors exhibited during the implementation of OpenFlow. These
behaviors were exposed during testing and may include unit, conformance, integration, interoperability, stress,
and system testing.

A hardware flow with an idle timeout of 10 seconds gets
deleted even though packets match the flow within the idle
timeout
Problem statement

A hardware rule is programmed with idle timeout as 10 seconds and hard timeout as 0. Packets are pumped at
1000 pps to the switch matching the flow. However, after 10 seconds, the rule gets removed from the switch.

Reason for this behavior

By default the hardware statistics refresh rate (set using openflow hardware-statistics refresh-rate
policy-engine-table <seconds> and information available through show openflow) is 20 seconds. This
rate means that the packet count statistics get updated only every 20 seconds. So, when the idle timeout is set to
less than 20 seconds, when a check is done for flow statistics after 10 seconds, it is not updated. Hence, the flow
is deleted.

Customer Note

The user has the option of reducing or incriminating the refresh rate. However, the user must be aware of its
implications. An increase in refresh rate leads to deletion of flows, which have an idle timeout less than the
configured refresh rate. A decrease in refresh rate leads to over‐use of the CPU (because of polling hardware
statistics more frequently.)

Controller flows — flow in hardware and processing
software
Flows with an action to send matching traffic to controller are installed on hardware. But, the actual traffic
forwarding takes place in software, since we must add the required OpenFlow specific headers. Due to this
characteristic, the actual forwarding does not take place at the line rate. A sample controller flow looks like:

Example

In this example, any packet that comes on port A1, is forwarded to the controller after adding required OpenFlow
packet headers (as the packet is sent as a packet_in) to the controller. Since this processing is done on software,
we cannot send the incoming traffic at line rate.

switch(openflow)# show openflow instance test flows
Flow 1
 Match
  Incoming Port          : A1                    Ethernet Type    : Any
  Source MAC             : Any                   Destination MAC  : Any
  Destination MAC Mask   : 000000-000000
  VLAN ID                : Any                   VLAN Priority    : Any
  Source IP Address      : Any
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  Destination IP Address : Any
  IP Protocol            : Any                   IP ToS Bits      : Any
  Source Port            : Any                   Destination Port : Any
 Attributes
  Priority               : 55000                 Duration         : 4 seconds
  Hard Timeout           : 0 seconds             Idle Timeout     : 0 seconds
  Byte Count             : 0                     Packet Count     : 0
  Controller ID          : listen-port           Cookie           : 0x0
  Flow Location          : Hardware
  Hardware Index         : 0
  Reason Code            : 12
  Reason Description     : Rule is in hardware.
 Actions
    Controller Port

DUT matches and processes incoming untagged packets
for VLAN id
For certain flows with a match on the VLAN ID, even untagged packets are matched. This matching occurs on
untagged ports only. The existing behavior exists because L2 hardware adds the VLAN id and VLAN priority
meta-information irrespective of whether the packet came in tagged or untagged. Flows that can be accelerated
into hardware are put into hardware, whereas flows that cannot be accelerated in hardware are put into software.
The observed behavior is observed for hardware and software flows.

Events that change the Operational Status of the
OpenFlow instance
The Oper. Status field indicates the operational status of the instance and can be either up or down. The
operational status is down when either the member VLAN of the OpenFlow instance does not exist on the switch
or the controller VLAN of the OpenFlow instance does not exist on the switch. In the case when multiple
controllers connect over multiple controller VLANs, the operational status is down when none of the controller
VLANs exist on the switch. When the member VLAN is down - all ports on the member VLAN are down.

For example, the show openflow instance <instance-name> displays all the OpenFlow instance-related
information as follows:

NOTE: For purposes of this example, the instance <test> has been created.

switch(openflow)# show openflow instance test

 Configured OF Version         : 1.3 only
 Negotiated OF Version         : 1.3
 Instance Name                 : test
 Data-path Description         : test
 Administrator Status          : Enabled
 Member List                   : VLAN 3
 Pipeline Model                : Standard Match
 Listen Port                   : 6633
 Operational Status            : Down
 Operational Status Reason     : None of the member VLANs are configured
 Datapath ID                   : 0000000000000000
 Mode                          : Active
 Flow Location                 : Hardware and Software
 No. of Hardware Flows         : 0
 No. of Software Flows         : 0
 Hardware Rate Limit           : 0 kbps
 Software Rate Limit           : 100 pps
 Conn. Interrupt Mode          : Fail-Secure
 Maximum Backoff Interval      : 60 seconds
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 Probe Interval                : 10 seconds
 Hardware Table Miss Count     : NA
 No. of Software Flow Tables   : 1
 Egress Only Ports             : None
 Table Model                   : Policy Engine and Software
 Source MAC Group Table        : Disabled
 Destination MAC Group Table   : Disabled

 Controller Id Connection Status Connection State Secure Role
 ------------- ----------------- ---------------- ------ ------
 1             Disconnected      Void             No     Equal

OpenFlow influence on CPU generated packets
In some cases, TCAM rules affect the CPU generated packets. This behavior is consistent with OpenFlow
versions 1.0 and 1.3. One example of such a case is when a rule is in place with the in_portas a wild card but
has an SRC IP address that matches the IP address configured on the switch.

OpenFlow 1.0 supports IP address masking
OpenFlow supports IP subnet mask. Controllers can specify the subnet mask associated with an IP address and
sent to the OpenFlow switch. The switch accepts the IP address with the subnet mask and associates any
packets coming with the subnet mask with the rule.

For example, the K.15.10. OpenFlow implementation supports the ability to match on IP address and subnet
mask when the OpenFlow controller programs such flows. Consider this example where the ovs-ofctl utility is
used to add a flow that matches on a network source address of 1.1.1.1 with a subnet mask of /24. 10.10.10.1
here is the IP address of the switch that has an OpenFlow listen port open on port 6633.

openflow@openflow-ubuntu-08:~# ovs-ofctl add-flow
tcp:10.10.0.1:6633 ip,nw_src=1.1.1.1/24,actions=output:1
To verify that this flow has been installed on the switch, we run the ovs-ofctl command and verify the output.

openflow@openflow-ubuntu-08:~# ovs-ofctl dump-flows tcp:10.10.0.1:6633
NXST_FLOW reply (xid=0x4): cookie=0x0, duration=13.535s, table=0,
n_packets=0, n_bytes=0, ip,nw_src=1.1.0.0/24 actions=output:1
The show openflow instance test flows command when executed on the switch displays the following:

Example

switch(vlan-3)# show openflow instance test

 Configured OF Version         : 1.3 only
 Negotiated OF Version         : 1.3
 Instance Name                 : test
 Data-path Description         : test
 Administrator Status          : Enabled
 Member List                   : VLAN 3
 Pipeline Model                : Standard Match
 Listen Port                   : 6633
 Operational Status            : Up
 Operational Status Reason     : NA
 Datapath ID                   : 000340a8f09e8600
 Mode                          : Active
 Flow Location                 : Hardware and Software
 No. of Hardware Flows         : 0
 No. of Software Flows         : 0
 Hardware Rate Limit           : 0 kbps

Appendix B Implementation notes 127

Anexo 06 ITENS 8 E 9 (0592717)         SEI 0008478-63.2018.6.02.8000 / pg. 7500



 Software Rate Limit           : 100 pps
 Conn. Interrupt Mode          : Fail-Secure
 Maximum Backoff Interval      : 60 seconds
 Probe Interval                : 10 seconds
 Hardware Table Miss Count     : NA
 No. of Software Flow Tables   : 1
 Egress Only Ports             : None
 Table Model                   : Policy Engine and Software
 Source MAC Group Table        : Disabled
 Destination MAC Group Table   : Disabled

 Controller Id Connection Status Connection State Secure Role
 ------------- ----------------- ---------------- ------ ------
 1             Connected         Active           Yes     Equal

Virtualization mode versus Aggregation mode — VLAN
tags in packet_in messages
There is a difference in the packet_in messages that are sent to the OpenFlow controller by the switch based
on the mode that the OpenFlow instance is operating in. In Virtualization mode, no VLAN tags are sent in
packet_in messages sent to the OpenFlow controller. Even if the packets that came into the switch on the
OpenFlow instance had VLAN tags, the switch in packet_in messages sent to the controller removes the tags.
Flows that match on VLAN PCP or modify VLAN PCP are not supported in Virtualization mode. Any tagged
packets that are received in Virtualization mode may have their PCP modified to default. VLAN PCP is not
matched because tag is always stripped in Virtualization mode.

In Aggregate mode, the switch always sends VLAN tags in packet_in messages sent to the OpenFlow
controller. Even if the packets that came in to the switch on the OpenFlow instance did not have VLAN tags, the
switch adds them in packet_in messages sent to the controller. The switch adds a VLAN tag either based on
the tag that the packet already carried when it came in to the switch or based on the membership of the port that
the packet came in to the switch.

Precedence level in meters
Standard-Match and IP-Control pipeline models

The DSCP Remark action in the meters associated with a flow for the above models writes the prec_level
associated with the band directly into the DSCP field of the packet. This avoids increasing the drop precedence
as defined in the OpenFlow specification.

Custom pipeline model

The DSCP Remark action in meters associated with a flow in custom pipeline model ignores the prec_level
argument passed in the meter modification request. In this model, the remarking is performed based on the band
to which the packet is classified into as per the defined rates.

Input
DSCP

Green Yellow Red Input DSCP Green Yellow Red

0 0 0 0 31 17 9 1

1 1 1 1 32 32 24 16

2 2 2 2 33 33 25 17

3 3 3 3 34 34 26 18

4 4 4 4 35 35 27 19

Table Continued
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5 5 5 5 36 36 28 20

6 0 0 0 37 37 29 21

7 1 1 1 38 24 16 8

8 8 0 0 39 25 17 9

9 9 1 1 40 40 32 24

10 10 2 2 41 41 33 25

11 11 3 3 42 42 34 26

12 12 4 4 43 43 35 27

13 13 5 5 44 44 36 28

14 0 0 0 45 45 37 29

15 1 1 1 46 32 24 16

16 16 8 0 47 33 25 17

17 17 9 1 48 48 40 32

18 18 10 2 49 49 41 33

19 19 11 3 50 50 42 34

20 20 12 4 51 51 43 35

21 21 13 5 52 52 44 36

22 8 0 0 53 53 45 37

23 9 1 1 54 40 32 24

24 24 16 8 55 41 33 25

25 25 17 9 56 56 48 40

26 26 18 10 57 57 49 41

27 27 19 11 58 58 50 42

28 28 20 12 59 59 51 43

29 29 21 13 60 60 52 44

30 16 8 0 61 61 53 45

62 48 40 32

63 49 41 33

Support for miss_len field in ‘switch configuration’
messages
The switch implementation does not honor the miss_len miss_send_len field specified in the packet-in switch
configuration messages. This occurs because the switch does not buffer packets, and the controller sees the
entire packet copied in packet-in message with buffer_id set as OFP_NO_BUFFER.
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Once a controller deletes flows from Table 0, it has to re-
add in order for traffic to flow through an OpenFlow switch
OpenFlow instance running Standard-Match Mode

• When the OpenFlow instance is configured with version 1.3, as soon as the controller connects and negotiates
to 1.3, the switch internally adds the following Rule 1 on Table 0 (which says: GoTo Table 100):
◦ Until the K/KA.15.15 release, if the controller were to delete Rule 1, there was no impact on packet

forwarding on the switch for packets coming on OpenFlow VLANs. Also, the switch always rejected any
attempts made by the controller to add back this default rule to Table 0.

◦ Starting with the K/KA.15.16 release, if the controller were to delete Rule 1, there is an impact on packet
forwarding on the switch for packets coming on OpenFlow VLANs. The switch drops packets incoming on
OpenFlow VLANs. This dropping of packets continues until the controller adds the default rule back to
Table 0. The switch complies to flow-mod requests from the controller on Table 0 based on its advertised
capabilities.

OpenFlow instance running IP-Control Mode

• Rules on Table 0 in this mode:
◦ Rule 1 -> All fields are wild-carded on Table 0 (which says Goto 100).

◦ Rule 2 -> Match on Ether-Type IPv4 on Table 0 (which says Goto 50).

◦ Rule 3 -> Match on Ether-Type IPv6 on Table 0 (which says Goto 50).

• Starting with the K/KA.15.16 release:
◦ If Rule 1 is deleted, all non-IP traffic is dropped incoming on OpenFlow VLANs.

◦ If Rule 2 is deleted, the switch drops all IPv4 traffic incoming on OpenFlow VLANs.

◦ If Rule 3 is deleted, the switch drops all IPv6 traffic incoming on OpenFlow VLANs.

• There is also the case of a Table Miss Rule on Table 50:
Rule 4 -> All fields are wild-carded on Table 50 (which says Goto 102).

• Starting with the K/KA.15.16 release:
If Rule 4 is deleted, the switch drops all IP (both IPv4 and IPv6) traffic that does not match any of the rules on
Table 50.

• In all these cases, the controller has to add these rules back to get the traffic to be forwarded as desired.

OpenFlow matching traffic destined for switch MAC
address
When using OpenFlow, traffic that is destined to a routing switch that matches an OpenFlow flow that emulates
routing does not get routed if there are no ARP entries on the switch for the devices involved. To trigger this, the
traffic must be destined for a MAC address assigned on the switch.

In traditional networking without OpenFlow, when packets to a routable IP destination arrive, the packets will be
buffered/dropped until the next hop to that IP destination is resolved. The ARP resolution is triggered by the
switch itself.
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NOTE: To make this work with OpenFlow, you must ensure that ARPs to all hosts are resolved.

OpenFlow custom pipeline implementation notes
• OpenFlow Table modifications cannot be done in v1/v2 modules or on v3 modules in compatibility mode.

• When the instance is configured in Standard match mode or ip-control-table-mode, controllers cannot change
the default pipeline advertised by controller.

• For IPv6 packets, MAC SA modification is not allowed. L4 ports modifications are not allowed for IPv6 packets.

• Write-metadata instructions are not supported.

• Rules with actions as packet-modifications and OFPP_CONTROLLER are directly rejected. However, if the
rules span across multiple tables (write-instruction in first table having packet modifications and write-
instructions in further tables having OFPP_CONTROLLER) would be accepted – however, the packets taken
to CPU/CONTROLLER are unmodified.

• Special ports OFPP_ALL, OFPP_LOCAL, OFPP_TABLE, and OFPP_IN_PORT are not supported.

• Write-instruction having OFPP_CONTROLLER cannot have a Goto instruction associated with it.

• Write-instruction rules must always have output port specified or Goto to next table or “output port + goto”.

• Counters are associated with tables and flow entries if available. Otherwise, the table or flow creation is
rejected with an error Resources not available to the controller.

• Tables configured from the controller must have a minimum of 512 entries or the table creation request is
rejected.

• Before a table is deleted, the controller must remove all flows in previous tables pointing to the deleted table. If
all flows are not removed, the controller table modification (deletion/modification) is not allowed.

• For multiple custom-pipeline instances, the user must reduce the size of the tables in the first custom-pipeline
instance. Following this procedure, the user must disable and enable the other custom-match instances for
them to become operational.

NOTE:

When a same OpenFlow meter is used two or more times in an OpenFlow pipeline, it results in
skewed meter rates leading to unpredictable behavior in how the packets are metered. HPE
recommends that you do not use a meter more than once in a packet pipeline to avoid undesired
behaviors.

Multi-VLAN implementation notes
• For a Multi-VLAN instance, the first VLAN in the Multi-VLAN instance is part of the DPID. Since VLANs cannot

be part of multiple instances, which ensures a unique DPID for each instance.

• A VLAN, which is member VLAN of one instance, cannot be member VLAN of another instance.

• A VLAN cannot be dynamically added to an instance when it is enabled, the instance must be disabled before
adding a VLAN to an OpenFlow instance.

• The user can configure VLANs that are member VLANs of an instance after creating and enabling the Multi-
VLAN instance.
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• At least one Member-VLAN of a Multi-VLAN instance must be configured on the switch else the operStatus
is marked DOWN.

• Management and controller VLANs cannot be part of an instance.

Implementation notes for OpenFlow groups in hardware
• Groups are not supported in hardware when switch is running in v1 mode.

• Special ports OFPP_ALL, OFPP_NORMAL, OFPP_TABLE, OFPP_IN_PORT, OFPP_LOCAL and
OFPP_CONTROLLER are not supported in OpenFlow groups in hardware.

• Tunnels cannot be part of OpenFlow ALL group.

• Rules in OpenFlow software tables can refer to Groups in software or hardware.

• Rules in OpenFlow hardware tables cannot refer to groups in software.

• On custom pipeline instances, groups in hardware have counters subject to the availability of the counters.

• If the group is in software, it can be referenced only from a software table.

• Rules in hardware tables with group action must not have a goto instruction associated with it.

• Group Modifications:
◦ Modification of a group in hardware that leads to having no Ports, is not allowed.

◦ If the resultant modification can no longer be accommodated in H/W, group modification requests for
Groups in H/W are rejected.

• In custom mode, the groups are always in hardware. Attempts to add groups with actions other than output
ports are rejected.

• The number of OpenFlow groups that can be created on an OpenFlow instance is 1024.

Implementation notes
• Limitations with APPLY {OUTPUT=CTRL} + APPLY {OUTPUT=NORMAL}

When the switch executes the output=ctrl as an apply action, any output=normal action that follows
does not work if the packet is destined to the switch.

As a work around to this limitation, the controller must use WRITE {OUTPUT=CTRL} to copy the packets to the
controller.

• When the system time is updated, the creation time of all the OpenFlow entities such as Flows, Groups,
Meters, and Ports are reset to the new time. Any time based operations such as calculation of duration, idle
and hard timeout are restarted based on the new time.

• Packets with source MAC address as a multicast MAC address are not forwarded from Table 100 to Table 200,
even if the specified rule has a GOTO action.

• Rules which match on overridden protocols in the OpenFlow exclusion list do not support APPLY/WRITE
{OUTPUT=NORMAL} action following er any other OUTPUT action.

• Rules with APPLY/WRITE {OUTPUT=(FLOOD||NORMAL)} are not supported after a {OUTPUT=IN_PORT}
action.

• Rules with action combination APPLY/WRITE {SET-FIELD (ETH_DST + IP_SRC||IP_DST)} +
{OUTPUT =NORMAL} do not modify the ETH_DST to the value specified in the packet.
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• OpenFlow instances running in custom pipeline model do not perform any OpenFlow lookups for packets
coming from the switch CPU.

• OpenFlow forces a fresh switch forwarding plane lookup for packets executing the action sequence APPLY/
WRITE {SET-FIELD (IP_SRC||IP_DST) + [SET-FIELD …]} + {OUTPUT=NORMAL}
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Configuring secure connection HPE VAN SDN
controller

Switches running OpenFlow can securely connect to HPE VAN SDN controller.

To accomplish the secure connection, follow these procedures:

Procedure

1. On the Switch running OpenFlow, create a TA (Trusted Anchor) profile: crypto pki ta-profile
VanProfile [TA-PROFILE-NAME]

2. Copy root certificate to the switch:

copy tftp ta-certificate [TA-PROFILE-NAME] [IP-ADDRESS of the server] [FILE-NAME]
3. Create an identity profile on the switch:

crypto pki identity-profile [PROFILE-NAME-STR] subject common-name [CN-VALUE]
4. Make a certificate signing request:

crypto pki create-csr certificate-name [CERT-NAME] ta-profile [TA-PROFILE-NAME] usage [openflow]

The same root certificate installed on the switch in step 2 must sign the CSR generated in this step.

5. Install the leaf certificate:

crypto pki install-signed-certificate
6. Paste the contents of the signed certificate in PEM format into the switch console.

NOTE: Apart from Steps 5 and 6, another way to install PEM formatted certificate is to download
it via TFTP using the command:

copy tftp local-certificate [TFTP Server IPv4/IPv6 address] [Name of the file containing certificate 
in PEM format]

7. Configure OpenFlow to connect to the VAN SDN controller:

openflow
controller-id 3 ip 103.0.11.31 port 6634 controller interface
vlan 1 instance "van"
member vlan 100
controller id 3 secure
version 1.3
limit hardware-rate 10000000
limit software-rate 10000
enable
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exit
enable
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Service Insertion
For information on tunnels and service insertion, see the Service Insertion Guide.

Appendix D
Service Insertion
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This guide provides information on how to use RestAPI and JSON schema.

Applicable products
This guide applies to these products:

Aruba 2530 Switch Series (J9772A, J9773A, J9774A, J9775A, J9776A, J9777A, J9778A, J9779A, J9780A,
J9781A, J9782A, J9783A, J9853A, J9854A, J9855A, J9856A, JL070A)

Aruba 2540 Switch Series (JL354A, JL355A, JL356A, JL357A)

Aruba 2920 Switch Series (J9726A, J9727A, J9728A, J9729A, J9836A)

Aruba 2930F Switch Series (JL253A, JL254A, JL255A, JL256A, JL258A, JL259A, JL260A, JL261A, JL262A,
JL263A, JL264A, JL557A, JL558A, JL559A)

Aruba 2930M Switch Series (JL319A, JL320A, JL321A, JL322A, JL323A, JL324A, R0M67A, R0M68A)

Aruba 3810 Switch Series (JL071A, JL072A, JL073A, JL074A, JL075A, JL076A)

Aruba 5400R zl2 Switch Series (J9821A, J9822A, J9850A, J9851A, JL001A, JL002A, JL003A, JL095A)

Chapter 1
About this guide
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Overview REST
Representational State Transfer (REST) is a software architecture style consisting of guidelines and best
practices for creating scalable web services. RESTful systems typically communicate over HTTP using the same
verbs (that is, GET, POST, PUT, DELETE) used by web browsers.

The REST server listens for requests from clients on port 80 (HTTP) and port 443 (HTTPs). The REST service
context is "/rest" followed by REST version. For example, http://192.168.1.1/rest/v1.0. REST requests also maybe
sent on the HTTPS port (443).

NOTE: 

• The REST interface is enabled by default.

• Web management or web management SSL must be enabled. If web management is disabled,
requests will not be processed, irrespective of the REST interface status.

• REST requests may also be sent to a switch through an OOBM port.

• REST API requests to stacked switches should use schema version v3 (available since 16.04) or
above.

More information

• JSON Schema and REST API documentation for the most recent version of the software:
◦ JSON Schema X.16.01.xxxx

◦ JSON Schema X.16.02.xxxx

◦ JSON Schema X.16.03.xxxx

◦ JSON Schema X.16.04.xxxx

◦ JSON Schema X.16.05.xxxx

Commands

rest-interface

Syntax
rest-interface

no rest-interface

Description

Enables the REST interface.

The no form of this command disables the REST interface.

Chapter 2
RestAPI
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NOTE: Web management or Web management SSL must be enabled to process the REST
requests. If Web management is disabled, the REST requests will not be processed even though the
REST interface is enabled.

Command context

Required context: config

Examples

Enable the REST interface.

switch(config)# rest-interface
switch(config)# show rest-interface

 REST Interface - Server Configuration

  REST Interface            : Enabled
  REST Operational Status   : Up
  REST Session Idle Timeout : 600 seconds
  HTTP Access               : Enabled
  HTTPS Access              : Disabled
Disable the REST interface.

switch(config)# no rest-interface 
switch(config)# show rest-interface

REST Interface - Server Configuration
  REST Interface            : Disabled
  REST Operational Status   : Down
  HTTP Access               : Enabled
  HTTPS Access              : Disabled

rest-interface session-idle-timeout

Syntax
rest-interface session-idle-timeout <SECONDS>

no rest-interface session-idle-timeout
      

Description

Configure session-idle-timeout for the REST interface sessions. The configurable value range is from 120 to 7200
seconds with the default value at 600 seconds.

The no version of the command resets the session-idle-timeout to the default value.

Command context

Required context: config

debug rest-interface
Syntax
debug rest-interface
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Enables debug logs for the rest-interface.

debug rest-interface

HP-2920-48G(config)# debug rest-interface 
0000:00:23:14.01 rest tHttpd:Received REST POST request
0000:00:23:14.08 rest tHttpd:(http_state:)http_process_post END
0000:00:23:14.15 rest tHttpd:REST request redirected to REST server
0000:00:23:14.22 rest tHttpd:Send REST request message to REST control task
0000:00:23:14.30 rest tHttpd:tHttpd is unblocked with necessary cleanup
0000:00:23:14.38 rest mrest_ctrl:Request for parse header
0000:00:23:14.44 rest mrest_ctrl:Request for parse header after method POST

Show commands

show rest interface

Syntax
show rest interface

Description

The REST operational status will be shown as Up only when the REST interface is enabled and either Web
management or Web management SSL is enabled. HTTP access is enabled when Web management is enabled.
HTTPS access is enabled when Web management SSL is enabled.

Command context

Required context: operator

Example

switch# show rest-interface
REST Interface - Server Configuration
  REST Interface            : Enabled
  REST Operational Status   : Up
  REST Session Idle Timeout : 600 seconds
  HTTP Access               : Enabled
  HTTPS Access              : Disabled

Restrictions
• Rest interface is not supported in FIPS.

• Rest Interface is not supported on ArubaOS 3800 stack switches.

Basic RestAPI Workflows
Use case — login-sessions
If a user is configured on the switch, login request must be posted to the switch for authentication. If user
validation is successful, the switch returns a session id as a cookie that will be used for further requests.

Chapter 2 RestAPI 9
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NOTE: Users are able to create a maximum of five REST sessions simultaneously.

WorkStation# curl --noproxy 10.100.167.104 -X POST 
http://10.100.167.104:80/rest/v1/login-sessions -d '{"userName":"test", "password":"test"}'

Response from the switch when user validation is successful:

{
"uri": "/rest/v1/login-sessions","cookie": 
"sessionId=09CG1bRuT5hkCPzI97mmDjpn4uLtsmgkBsAaWUr9h7GxlkbsiASak1PEyj7Ov3n"
}

Use case — authentication failure
The switch will return an error if authentication fails:

WorkStation# curl --noproxy 10.100.167.104 -X POST 
http://10.100.167.104:80/rest/v1/login-sessions -d '{"userName":"test", "password":"test"}'

Switch response upon failure:

{
 "message": "Authentication failed."
}

NOTE:

• An operator may only use the GET method. A manager is supported for all methods.

• Posting a login request is not required and requests may be sent without a cookie if a user name
is not configured.

Other failure causes

1. The wrong username/password is sent to create login sessions.

2. The user is configured and REST requests are sent without session id.

Use case — creating a VLAN
Creating VLAN using REST:

WorkStation# curl --noproxy 10.100.167.104 --cookie 
"sessionId=09CG1bRuT5hkCPzI97mmDjpn4uLtsmgkBsAaWUr9h7GxlkbsiASak1PEyj7Ov3n" -X POST 
http://10.100.167.104:80/rest/v1/vlans -d '{"vlan_id":5, "name":"VLAN5"}‘
Response from the Switch:

{
    "uri": "/rest/v1/vlans/5",
    "vlan_id": 5,
    "name": "VLAN5",
    "status": "VS_PORT_BASED",
    "type": "VT_STATIC",
    "is_voice_enabled": false,
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    "is_jumbo_enabled": false,
    "is_dsnoop_enabled": false
}

Use case — fetching the VLAN
Fetching the VLAN details using REST:

WorkStation# curl --noproxy 10.100.167.104 --cookie 
"sessionId=09CG1bRuT5hkCPzI97mmDjpn4uLtsmgkBsAaWUr9h7GxlkbsiASak1PEyj7Ov3n" -X GET 
http://10.100.167.104:80/rest/v1/vlans
      
Response from the Switch:

{
   "collection_result": {
      "total_elements_count": 2,
      "filtered_elements_count": 2
   },
   "vlan_element": [
      {
         "uri": "/rest/v1/vlans/1",
         "vlan_id": 1,
         "name": "DEFAULT_VLAN",
         "status": "VS_PORT_BASED",
         "type": "VT_STATIC",
         "is_voice_enabled": false,
         "is_jumbo_enabled": false,
         "is_dsnoop_enabled": false
       },
       {
         "uri": "/rest/v1/vlans/5",
         "vlan_id": 5,
         "name": "VLAN5",
         "status": "VS_PORT_BASED",
         "type": "VT_STATIC",
         "is_voice_enabled": false,
         "is_jumbo_enabled": false,
         "is_dsnoop_enabled": false
       }
   ]
}

Use case — logout of session
Logout of REST session.

WorkStation# curl --noproxy 10.100.167.104 --cookie
 "sessionId=09CG1bRuT5hkCPzI97mmDjpn4uLtsmgkBsAaWUr9h7GxlkbsiASak1PEyj7Ov3n" -X 
DELETE http://10.100.167.104:80/rest/v1/login-sessions
      
The switch will respond with a message simular to: 204 No Content.

[root@UbuntuServer5224 ~]# curl --noproxy 192.168.1.1 -v --cookie 
"sessionId=8XU2msUzBJbXYClpFyVmaageB4iiRE6C94QSvYIfd3xiHelPjgUraYOx5JjWIUq" -X 
DELETE http://192.168.1.1:80/rest/v1/login-sessions
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* About to connect() to 192.168.1.1 port 80 (#0)
*   Trying 192.168.1.1... connected
> DELETE /rest/v1/login-sessions HTTP/1.1
> User-Agent: curl/7.22.0 (x86_64-pc-linux-gnu) libcurl/7.22.0 OpenSSL/1.0.1 zlib/
1.2.3.4 libidn/1.23 librtmp/2.3
> Host: 192.168.1.1
> Accept: */*
> Cookie: sessionId=8XU2msUzBJbXYClpFyVmaageB4iiRE6C94QSvYIfd3xiHelPjgUraYOx5JjWIUq
>
< HTTP/1.1 204 No Content
< Server: eHTTP v2.0
< Connection: keep-alive
< RequestId:
<
* Connection #0 to host 192.168.1.1 left intact
* Closing connection #0
[root@UbuntuServer5224 ~]#

Use case - clearing login sessions

Clearing login sessions

There are two options available to clear login sessions from a switch:

• Enable or Disable the REST interface.

• Reboot the switch.

Clearing a specific session by ID requires the use of the DELETE method of Service RestLoginSessions.

Use case — clearing login sessions
Clearing login sessions.

WorkStation# curl --noproxy 192.168.1.1 -v -k --cookie
 "cookie":"<<Session id>>" -X DELETE  http://192.168.1.1:80/rest/v1/login-sessions
      

[root@UbuntuServer54185 ~]# curl --noproxy 192.168.1.1 -v -k --cookie 
            
"cookie":"sessionId=wv6Nahl7D7dCw4egR5Nnu2d76qs93Y98g3CCwECmEAX8XkVNQGfV0sYDY4thzyJ" 
            -X DELETE  http://192.168.1.1:80/rest/v1/login-sessions
* About to connect() to 192.168.1.1 port 80 (#0)
*   Trying 192.168.1.1... connected
> DELETE /rest/v1/login-sessions HTTP/1.1
> User-Agent: curl/7.22.0 (x86_64-pc-linux-gnu) libcurl/7.22.0 OpenSSL/1.0.1 zlib/1.2.3.4 
            libidn/1.23 librtmp/2.3
> Host: 192.168.1.1
> Accept: */*
> Cookie: cookie:sessionId=wv6Nahl7D7dCw4egR5Nnu2d76qs93Y98g3CCwECmEAX8XkVNQGfV0sYDY4thzyJ
>
< HTTP/1.1 204 No Content
< Server: eHTTP v2.0
< Connection: keep-alive
< RequestId:
<
* Connection #0 to host 192.168.1.1 left intact
* Closing connection #0
[root@UbuntuServer54185 ~]#
[root@UbuntuServer54185 ~]#
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Responses and HTTP status codes returned by RestAPI

GET Response and HTTP status codes returned by the RestAPI
Table 1: GET Response and HTTP status codes

Response Code Description

200 OK Request is successful.

400 Bad request Request is invalid due to
incorrect parameters in the
request.

404 Not Found Request has failed due to
non-existent resource.

500 Internal Server Error Request has failed due to
an error in the switch.

POST responses and HTTP status codes returned by RestAPI
Table 2: POST responses and HTTP status codes

Response Code Description

200 OK Command URI is successful.

201 Created Command URI is created.

202 Accepted Command URI is accepted.

204 No Content No content is returned for command URI.

400 Bad Request Request has failed due to incorrect
parameters in the request.

404 Not Found Request is failed due to non-existent
resource.

405 Method Not Allowed Request not supported on a resource.

500 Internal Server Error Request is failed due to an error in the
switch.

PUT responses and HTTP status codes returned by RestAPI
Table 3: PUT responses and HTTP status codes

Response Code Description

200 OK Resource is successful.

400 Bad Request Failed due to incorrect parameters in the request.

404 Not Found Failed due to non-existent resource.

Table Continued
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Response Code Description

405 Method Not Allowed Not supported on a resource.

500 Internal Server Error Failed due to an error in the switch.

DELETE responses and HTTP status codes returned by RestAPI
Table 4: DELETE responses and HTTP status codes

Response code Description

204 No Content Delete on a resource is
successful.

400 Bad Request Invalid DELETE request
[ some incorrect
parameters in the
request ].

404 Not Found Request has failed due to
non-existent resource.

405 Method Not Allowed Not supported on a
resource.

500 Internal Server Error Request is failed due to an
error in the switch.
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Service ACL
HTTP Method Resource Request Response Description

GET 
             
        

.../acls

N/A CommonElementList Returns the list of
ACL elements
matching the given
query.

POST 
             
        

.../acls

Acl Acl Adds the given
ACL to the model.

GET .../acls/{Acl.id}

N/A Acl Returns the ACL
matching the given
ID.

DELETE 
             
        

.../acls/{Acl.id}

N/A N/A Deletes the ACL
with the given ID
from the model.

GET .../acls/{Acl.id}/rules

N/A CommonElementList Returns the list of
ACL Rule
elements matching
the given query.

POST .../acls/{AclRule.acl_id}/rules

AclRule AclRule Adds the given
ACL Rule to the
model.

GET .../acls/{AclRule.acl_id}/rules/{AclRule.sequence_no}

Table Continued

Chapter 3
Common element list
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HTTP Method Resource Request Response Description

N/A AclRule Returns the ACL
Rule matching the
given ID.

PUT 
             
        

.../acls/{AclRule.acl_id}/rules/{AclRule.sequence_no}

AclRule AclRule Updates the given
ACL Rule in the
model.

DELETE 
             
        

.../acls/{AclRule.acl_id}/rules/{AclRule.sequence_no}

N/A N/A Deletes the ACL
Rule with the
given ID from the
model.

POST .../acls/{ResequenceCommand.acl_id}/rules/resequence

ResequenceCommand Void Triggers a
resequence of
ACL Rule
elements based
on the given
parameters.

GET 
             
        

.../acls/rules

N/A CommonElementList Returns the list of
ACL Rule
elements for all
ACLs.

GET .../acls/deny_fragmented_tcp_header

Returns the ACL
deny-fragmented-
tcp-header

PUT .../acls/deny_fragmented_tcp_header

Update deny-
fragmented-tcp-
header.
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Service AllowUnsupportedTransceiver
HTTP Method Resource Request Response Description

GET .../allow_unsupported_transceiver

N/A N/A Returns
AllowUnsupportedTr
ansceiver system
attribute.

PUT .../allow_unsupported_transceiver

N/A N/A Updates
AllowUnsupportedTr
ansceiver system
attribute.

Service Banner
HTTP Method Resource Request Response Description

GET .../banner

N/A Banner Returns Banner
system attributes.

PUT .../banner

Banner Banner Updates Banner
system attributes.

Service Cdp
HTTP Method Resource Request Response Description

GET .../cdp

N/A Cdp Returns the global
CDP configuration
data.

GET .../cdp

Cdp Cdp Updates the global
CDP configuration
data.
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Service DebugLog
HTTP
Method

Resource Request Response Description

POST .../debug-log/filter

DebugLogFilterComma
nd

DebugLogStats Triggers the filtering of debug
logs based on the given
parameters.

GET .../debug-log/status

N/A DebugLogStats Returns the status of the debug
log filters.

NOTE: Added attributes “debug_destination_to_enable” and “debug_destination_to_disable” in
DebugLogFilterCommand and added attributes “debug_destination” in DebugLogStats.

Service DeviceManagementUser
HTTP
Method

Resource Request Response Description

GET .../management-user

N/A CommonElementList Returns the list of
Management User
elements matching
the given query.

POST .../management-user

DeviceManagementUser DeviceManagementUser Adds the given
Management User to
the model.

GET .../management-user/{DeviceManagementUser.type}

N/A DeviceManagementUser Returns the
Management User
matching the given
ID.

PUT .../management-user/{DeviceManagementUser.type}

DeviceManagementUser DeviceManagementUser Updates the given
Management User in
the model.

Table Continued
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HTTP
Method

Resource Request Response Description

DELETE .../management-user/{DeviceManagementUser.type}

N/A N/A Deletes the
Management User
with the given ID
from the model.

Service Dns
HTTP Method Resource Request Response Description

GET .../dns

N/A Dns Returns the host
system attributes.

PUT .../dns

Dns Dns Updates the host
system attributes.

Service Dot1xSupplicantPort
HTTP Method Resource Request Response Description

GET .../dot1x/supplicant

N/A CommonElementList Returns the list of
802.1X Supplicant
Port elements
matching the given
query.

GET .../dot1x/supplicant/{Dot1xSupplicantPort.port_id}

N/A Dot1xSupplicantPort Returns the 802.1X
Supplicant Port
matching the given
ID.

GET .../dot1x/supplicant/{Dot1xSupplicantPort.port_id}

Dot1xSupplicantPort Returns the 802.1X
Supplicant Port
matching the given
ID.

PUT .../dot1x/supplicant/{Dot1xSupplicantPort.port_id}
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HTTP Method Resource Request Response Description

Dot1xSupplicantPort Dot1xSupplicantPort Updates the given
802.1X Supplicant
Port in the model.

POST .../dot1x/supplicant/{Dot1xSupplicantPort.port_id}/clearstats

N/A N/A Clear statistics of
dot1x supplicant
based on port id.

POST .../dot1x/supplicant/{Dot1xSupplicantPort.port_id}/initialize

N/A N/A Initialize of dot1x
supplicant based on
port id.

GET .../dot1x/supplicant/{Dot1xSupplicantPort.port_id}/stats

N/A Dot1xSupplicantPort Returns the 802.1X
Supplicant statistics
matching the given
port.

GET .../dot1x/supplicant/stats

N/A CommonElementList Returns the list of
802.1X Supplicant
statistics elements
matching the given
query.

Service Fastboot
HTTP Method Resource Request Response Description

GET .../fastboot

N/A Fastboot Returns Fastboot
system attribute.

PUT .../fastboot

Fastboot Fastboot Updates Fastboot
system attribute.
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Service FileTransfer
HTTP Method Resource Request Response Description

POST .../file-transfer

FileTransferCommand Void Triggers a file
transfer based
on the given
parameters.

NOTE: 

Added “show_tech_option” and removed parameters “reboot_device_after_download” and
“force_firmware_install” in FileTransferCommand . Modified the enum “FileTransferType”.

Service Lldp
HTTP Method Resource Request Response Description

GET .../lldp

N/A Lldp Get LLDP Global
Status.

PUT .../lldp

Lldp Lldp Enable/Disable
LLDP Globally.

GET .../lldp/auto_provision/radio_ports

N/A LldpAutoProvisionRadioP
orts

Retrieve LLDP radio
port automatic
provisioning.

GET .../lldp/local-port/{LldpLocalPort.port_id}

N/A LldpLocalPort Get LLDP Local Port
Configurations.

PUT .../lldp/local-port/{LldpLocalPort.port_id}

LldpAutoProvisi
onRadioPorts

LldpAutoProvisionRadioP
orts

Set LLDP radio port
automatic
provisioning.

GET .../lldp/local-port
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HTTP Method Resource Request Response Description

N/A CommonElementList Retrieve the
complete list of LLDP
Local Port elements
including OOBM
port.

GET .../lldp/local-port/{LldpLocalPort.port_id}

N/A LldpLocalPort Get LLDP Local Port
Configurations

PUT .../lldp/local-port/{LldpLocalPort.port_

LldpLocalPort LldpLocalPort Set LLDP Local Port
Configurations.

GET .../lldp/local-port/oobm

N/A LldpOobmPort Retrieve LLDP
OOBM Port
Configurations

PUT .../lldp/local-port/oobm

LldpOobmPort LldpOobmPort Set LLDP OOBM
Port Configurations

GET .../lldp/local_device/info

N/A LldpLocalDevice Retrieve the LLDP
Local Device
Information

GET .../lldp/local_device/ports

N/A CommonElementList Retrieve the LLDP
Local Information of
all ports including
OOBM.

GET .../lldp/local_device/ports/{LldpLocalDevicePort.port_name}

N/A LldpLocalDevicePort Retrieve the LLDP
Local Information per
port.

GET .../lldp/local_device/ports/oobm

N/A LldpLocalDevicePort Retrieve the Local
OOBM port
Information.
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HTTP Method Resource Request Response Description

GET .../lldp/remote-device

N/A CommonElementList Retrieve the LLDP
Remote Information
including devices
connected to OOBM.

GET .../lldp/remote-device/{LldpRemoteDevice.local_port}

N/A LldpRemoteDevice Retrieve the LLDP
Remote Information
per

GET .../lldp/remote-device/oobm

N/A LldpOobmRemoteDevice Retrieve the OOBM
Remote Information.

GET .../lldp/stats/device

N/A LldpDeviceStats Retrieve the LLDP
Neighbour Stats.

GET .../lldp/stats/ports

N/A CommonElementList Retrieve the LLDP
Port Stats for all
ports including
OOBM.

GET .../lldp/stats/ports/{LldpPortStats.port_name}

N/A LldpPortStats Retrieve the LLDP
per Port Stats.

GET ../lldp/stats/ports/oobm

N/A LldpPortStats Retrieve the LLDP
OOBM Stats.
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Service IpAddressSubnet
HTTP Method Resource Request Response Description

GET .../ipaddresses

N/A CommonElementList Returns the list
of IP Address
Subnets
elements
matching the
given query.

GET .../vlans/{Vlan.vlan_id}/ipaddresses

N/A CommonElementList Returns IP
Address Subnets
for the specified
VLAN.

POST .../vlans/{IpAddressSubnet.vlan_id}/ipaddresses

IpAddressSubnet IpAddressSubnet Adds the given
IP Address
Subnet in the
model.

DELETE .../vlans/{Vlan.vlan_id}/ipaddresses

N/A N/A Deletes IP
Address Subnets
for the specified
VLAN.

Service Iplcmp
HTTP Method Resource Request Response Description

GET .../ip_icmp

N/A IpIcmp Returns IP ICMP
attributes.

PUT .../ip_icmp

IpIcmp IpIcmp Updates IP ICMP
attributes.
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Service IpRoute
HTTP Method Resource Request Response Description

GET .../ip-route

N/A CommonElementList Returns the list of IP
Route elements
matching the given
query.

POST .../ip-route

IpRoute IpRoute Adds the given IP
Route in the model.

GET .../ip-route/{IpRoute.id}

N/A IpRoute Returns the IP Route
matching the given
ID.

DELETE .../ip-route/
{IpRoute.id}

N/A N/A Deletes the IP Route
with the given ID
from the model.

GET .../ip-route/settings

N/A IpRouteSettings Returns the global IP
Route settings.

PUT .../ip-route/settings

IpRouteSettings IpRouteSettings Updates the global
IP Route settings.

Service IpSourceInterface
HTTP Method Resource Request Response Description

GET .../ip_source_interface

N/A IpSourceInterface Returns all IP
source-interfaces.

GET .../ip_source_interface/{IpSourceInterface.protocol}

N/A IpSourceInterface Returns IP source-
interface based on
the protocol.
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HTTP Method Resource Request Response Description

PUT .../ip_source_interface/{IpSourceInterface.protocol}

IpSourceInterface IpSourceInterface Update IP source-
interface record for a
protocol.

• If both IP address
& VLAN ID are
null; configuration
will be removed
based on
protocol.

• If both valid IP
address & VLAN
ID are given in
REST request, IP
address will have
preference over
VLAN ID.

Service Ping
HTTP Method Resource Request Response Description

POST .../ping

PingCommand PingCommandResult Triggers a ping
based on the given
parameters.

Service Port
Service Port

HTTP Method Resource Request Response Description

GET .../ports

N/A CommonElementList Returns the list of
Port elements
matching the given
query.

GET .../ports/{Port.id}

N/A Port Returns the Port
matching the given
ID.
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HTTP Method Resource Request Response Description

PUT .../ports/{Port.id}

Port Port Updates the given
Port in the model.

Service Qos
HTTP Method Resource Request Response Description

GET .../qos/dscp-map

CommonCollectionQuery CommonElementList Returns the
list of QoS
DSCP Map
elements
matching the
given query.

GET .../qos/dscp-map/{QosDscpMap.dscp_value}

QosDscpMap QosDscpMap Returns the
QoS DSCP
Map matching
the given ID.

PUT .../qos/dscp-map/{QosDscpMap.dscp_value}

QosDscpMap QosDscpMap Updates the
given QoS
DSCP Map in
the model.

GET .../qos/policies

CommonCollectionQuery CommonElementList Returns the
list of QoS
Policy
elements
matching the
given query.

POST .../qos/policies

QosPolicy QosPolicy Adds the
given QoS
Policy to the
model.

GET .../qos/policies/{QosPolicy.id}
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HTTP Method Resource Request Response Description

QosPolicy QosPolicy Returns the
QoS Policy
matching the
given ID.

DELETE .../qos/policies/{QosPolicy.id}

N/A N/A Deletes the
QoS Policy
with the given
ID from the
model.

GET .../qos/policies/{QosPolicy.id}/policy-actions

QosPolicy CommonElementList Returns the
list of QoS
Policy Action
elements
matching the
given query.

POST .../qos/policies/{QosPolicyAction.policy_id}/policy-actions

QosPolicyAction QosPolicyAction Adds the
given QoS
Policy Action
to the model.

GET .../qos/policies/{QosPolicyAction.policy_id}/policy-actions/{QosPolicyAction.sequence_no}

QosPolicyAction QosPolicyAction Returns the
QoS Policy
Action
matching the
given ID.

PUT .../qos/policies/{QosPolicyAction.policy_id}/policy-actions/{QosPolicyAction.sequence_no}

QosPolicyAction QosPolicyAction Updates the
given QoS
Policy Action
in the model.

DELETE .../qos/policies/{QosPolicyAction.policy_id}/policy-actions/{QosPolicyAction.sequence_no}

N/A N/A Deletes the
QoS Policy
Action with the
given ID from
the model.
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HTTP Method Resource Request Response Description

POST .../qos/policies/{ResequenceCommand.policy_id}/policy-actions/resequence

ResequenceCommand Void Triggers a
resequence of
QoS Policy
Action
elements
based on the
given
parameters.

GET .../qos/traffic-classes

CommonCollectionQuery CommonElementList Returns the
list of QoS
Traffic Class
elements
matching the
given query.

POST .../qos/traffic-classes

QosTrafficClass QosTrafficClass Adds the
given QoS
Traffic Class
to the model.

GET .../qos/traffic-classes/{QosTrafficClass.id}

QosTrafficClass QosTrafficClass Returns the
QoS Traffic
Class
matching the
given ID.

DELETE .../qos/traffic-classes/{QosTrafficClass.id}

N/A N/A Deletes the
QoS Traffic
Class with the
given ID from
the model.

GET .../qos/traffic-classes/{QosTrafficClass.id}/matches

QosTrafficClass CommonElementList Returns the
list of QoS
Class Match
elements
matching the
given query.

Table Continued

Chapter 3 Common element list 29

Anexo 07 ITENS 8 E 9 (0592724)         SEI 0008478-63.2018.6.02.8000 / pg. 7538



HTTP Method Resource Request Response Description

POST .../qos/traffic-classes/{QosClassMatch.traffic_class_id}/matches

QosClassMatch QosClassMatch Adds the
given QoS
Class Match
to the model.

GET .../qos/traffic-classes/{QosClassMatch.traffic_class_id}/matches/{QosClassMatch.sequence_no}

QosClassMatch QosClassMatch Returns the
QoS Class
Match
matching the
given ID.

PUT .../qos/traffic-classes/{QosClassMatch.traffic_class_id}/matches/{QosClassMatch.sequence_no}

QosClassMatch QosClassMatch Updates the
given QoS
Class Match
in the model.

DELETE .../qos/traffic-classes/{QosClassMatch.traffic_class_id}/matches/{QosClassMatch.sequence_no}

N/A N/A Deletes the
QoS Class
Match with the
given ID from
the model.

POST .../qos/traffic_classes/{ResequenceCommand.traffic_class_id}/matches/resequence

ResequenceCommand Void Triggers a
resequence of
QoS Class
Match
elements
based on the
given
parameters.

Service RadiusProfile
HTTP Method Resource Request Response Description

GET .../radius_profile

N/A RadiusProfile Returns the RADIUS
profile information.
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HTTP Method Resource Request Response Description

PUT .../radius_profile

RadiusProfile RadiusProfile Updates the given
RADIUS profile in
the model.

NOTE: 

Added parameters “dead_time”, “key”, “dyn_autz_port”, “tracking_uname”, and “is_tracking_enabled”
in RadiusProfile.

Removed parameter dot1x_authentication_method from RadiusProfile.

Service RadiusServer
HTTP Method Resource Request Response Description

GET .../radius_servers

N/A CommonElementList Returns the
RADIUS
server
information.

POST .../radius_servers

RadiusServer RadiusServer Create the
given RADIUS
server in the
model.

GET .../radius_servers/{RadiusServer.radius_server_id}

N/A RadiusServer Returns the
given RADIUS
server
information.

PUT .../radius_servers/{RadiusServer.radius_server_id}

RadiusServer RadiusServer Updates the
given RADIUS
server in the
model.

DELETE .../radius_servers/
{RadiusServer.radius_server_id}

N/A N/A Deletes the
given radius
server from
the model.
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NOTE: Added Parameters “is_dyn_authorization_enabled”, “time_window_type”, “time_window”, and
“is_oobm” included in RadiusServer.

Service RestLoginSessions
HTTP Method Resource Request Response Description

POST .../rest/v1/login-sessions

RestLoginSessions RestLoginSessionsResult Adds the
given
Management
User to the
model.

DELETE .../rest/v1/login-sessions

N/A N/A Deletes the
Management
User with the
given ID from
the model

Service RestSessionIdleTimeout
HTTP Method Resource Request Response Description

GET .../rest/v1/session-idle-timeout

N/A RestSessionIdleTimeout Returns the
Management
User matching
the given ID.

PUT .../rest/v1/session-idle-timeout/{RestSessionIdleTimeout.type}

RestSessionIdleTimeout RestSessionIdleTimeout Updates the
given
Management
User in the
model.
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Service SmartratePort
HTTP Method Resource Request Response Description

GET .../smartrate/ports

N/A CommonElementList Returns the list of
Smartrate Port
elements matching
the given query.

GET .../smartrate/ports/{SmartratePort.port_id}

N/A SmartratePort Returns the
Smartrate Port info
and stats matching
the given ID.

Service SNTP
HTTP Method Resource Request Response Description

GET .../system/sntp

N/A Sntp Returns SNTP
system attributes.

PUT .../system/sntp

Sntp Sntp Updates SNTP
system attributes.

Service SntpServerDetails
HTTP Method Resource Request Response Description

GET .../system/sntp_server

N/A CommonElementList Returns SNTP
server system
attributes.

POST .../system/sntp_server

SntpServerDetails SntpServerDetails Add SNTP server
system attributes.

GET .../system/sntp_server/{SntpServerDetails.sntp_server_priority}-
{SntpServerDetails.sntp_server_address}
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HTTP Method Resource Request Response Description

N/A SntpServerDetails Returns SNTP
server system
attributes.

DELETE .../system/sntp_server/{SntpServerDetails.sntp_server_priority}-
{SntpServerDetails.sntp_server_address}

N/A N/A Delete SNTP server
system attributes.

Service System
HTTP Method Resource Request Response Description

GET .../system/status/global_info

N/A StackSystemInfoStatsGlobal Returns the global
system information
for stacked switches.

GET .../system/status/members

N/A CommonElementList Returns the list of
member specific
system information
for stacked switches.

GET .../system/status/members/ {MemberSystemStatusInfo.member_id}

N/A MemberSystemStatusInfo Returns the member
specific system
information for
stacked switches.

POST .../system/reboot/commander

Triggers a
commander boot on
stacked device

POST .../system/reboot/member/{MemberSystemStatusInfo.member_id}

Triggers a member
boot on stacked
switch with given
member_id

POST .../system/reboot/standby

Triggers a standby
boot on stacked
device
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HTTP Method Resource Request Response Description

POST .../system/
time/set-
manually

SetSystemDateTimeCo
mmand

N/A Sets the system
date/time based on
the given
parameters.

GET .../system/time

N/A SystemTime Returns the host
system time
configuration.

PUT .../system/time

SystemTime SystemTime Updates the host
system time
configuration.

NOTE: Attribute “operation_mode” changed to “device_operation_mode” in
SystemAttributes.json.

Service TftpClient
HTTP Method Resource Request Response Description

GET .../tftp/client

N/A TftpClient Returns TFTP Client
system attributes.

PUT .../tftp/client

TftpClient TftpClient Updates TFTP Client
system attributes.

Service TraceRoute
HTTP Method Resource Request Response Description

POST .../trace-route

TraceRouteCommand TraceRouteCommandResult Triggers a
trace route
based on the
given
parameters.
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Service Vlan
HTTP Method Resource Request Response Description

GET .../vlans

N/A CommonElementList Returns the list of
VLAN elements
matching the given
query.

POST .../vlans

Vlan Vlan Adds the given
VLAN to the model.

GET .../vlans/{Vlan.vlan_id}

N/A Vlan Returns the VLAN
matching the given
ID.

PUT .../vlans/{Vlan.vlan_id}

Vlan Vlan Updates the given
VLAN in the model.

DELETE .../vlans/{Vlan.vlan_id}

N/A N/A Deletes the VLAN
with the given ID
from the model.

NOTE: Removed attributes “sql.not_null”: true, “sql.unique”: true from parameter “name” of Vlan
schema.

Service VlanPort
HTTP
Method

Resource Request Response Description

GET .../vlans-ports

N/A CommonElementList Returns the list of
VLAN-Port
elements
matching the
given query.

POST .../vlans-ports
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HTTP
Method

Resource Request Response Description

VlanPort VlanPort Adds the given
VLAN-Port using
the specified
mode.

GET .../vlans-ports/{VlanPort.vlan_id}-{VlanPort.port_id}

N/A VlanPort Returns the
VLAN-Port
matching the
given ID.

PUT .../vlans-ports/{VlanPort.vlan_id}-{VlanPort.port_id}

VlanPort VlanPort Updates the given
VLAN-Port using
the specified
mode.

DELETE .../vlans-ports/{VlanPort.vlan_id}-{VlanPort.port_id}

N/A N/A Deletes the given
VLAN-Port
assignment from
the model.
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Service Accounting
HTTP Method Resource Request Response Description

GET .../accounting

N/A Accounting Returns accounting
configuration.

PUT .../accounting

Accounting Accounting Updates the given
accounting
configuration to the
system.

Service AclPort
HTTP Method Resource Request Response Description

GET .../ports-access-groups

N/A WiredElementList Returns the list of
ACL Port Policy
elements matching
the given query.

POST .../ports-access-groups

AclPortPolicy AclPortPolicy Adds the given ACL
Port Policy to the
model.

DELETE .../ports-access-groups/{AclPortPolicy.port_id}-{AclPortPolicy.acl_id}-
{AclPortPolicy.direction}

N/A N/A Deletes the ACL Port
Policy with the given
ID from the model.

GET .../ports-access-groups/{AclPortPolicy.port_id}-{AclPortPolicy.acl_id}-
{AclPortPolicy.direction}/stats

N/A AclPortPolicyStats Returns the ACL
statistics for given
ACL ID, Port, and
Direction.

Chapter 4
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Service AclVlan
HTTP Method Resource Request Response Description

GET .../vlans-access-groups

N/A WiredElementList Returns the list of
ACL VLAN Policy
elements matching
the given query.

POST .../vlans-access-groups

AclVlanPolicy AclVlanPolicy Adds the given ACL
VLAN Policy to the
model.

DELETE .../vlans-access-groups/{AclVlanPolicy.vlan_id}-{AclVlanPolicy.acl_id}-
{AclVlanPolicy.direction}

N/A N/A Deletes the ACL
VLAN Policy with the
given ID from the
model.

GET .../vlans-access-groups/{AclVlanPolicy.vlan_id}-{AclVlanPolicy.acl_id}-
{AclVlanPolicy.direction}/stats

N/A AclVlanPolicyStats Returns the ACL
statistics for given
ACL ID, VLAN, and
Direction.

Service Activate
HTTP Method Resource Request Response Description

POST .../activate

ActivateProvisionReque
st

ActivateProvisionResult Enable system
provisioning and
software update
using Aruba Activate.

GET .../activate/config

N/A ActivateConfig Returns Aruba
Activate provisioning
or software update
configuration.
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HTTP Method Resource Request Response Description

PUT .../activate/config

ActivateConfig ActivateConfig Updates attributes
for Aruba Activate
provisioning or
software update.

Service ArubaVpn
HTTP Method Resource Request Response Description

GET .../amp-server

N/A AmpServer Returns the Amp
server IP, group,
folder and secret.

PUT .../amp-server

AmpServer AmpServer Configure the Amp
Server.

DELETE .../amp-server

N/A N/A Deletes the Aruba
VPN configuration.

GET .../aruba-vpn

N/A ArubaVpn Returns the Aruba
VPN type, peer IP
address,ToS and
TTL value.

PUT .../aruba-vpn

ArubaVpn ArubaVpn Configure the Aruba
VPN.

DELETE .../aruba-vpn

N/A N/A Deletes the Aruba
VPN configuration.
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Service Authentication
HTTP Method Resource Request Response Description

GET .../authentication

N/A Authentication Returns the Authentication
Attributes configured on
the system.

PUT .../authentication

Authentication Authentication Updates the given
authentication
configuration to the
system.

GET .../authentication/console

N/A AuthenticationConsole Returns console
authentication
configuration.

PUT .../authentication/console

AuthenticationConsole AuthenticationConsole Updates the given console
authentication
configuration to the
system.

GET .../authentication/ssh

N/A AuthenticationSsh Returns ssh
authentication
configuration.

PUT .../authentication/ssh

AuthenticationSsh AuthenticationSsh Updates the given ssh
authentication
configuration to the
system.

Service Authorization
HTTP Method Resource Request Response Description

GET .../authorization

N/A Authorization Returns
authorization
configuration.
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HTTP Method Resource Request Response Description

PUT .../authorization

Authorization Authorization Updates the given
authorization
configuration to the
system.

Service BpsCommand
HTTP Method Resource Request Response Description

POST .../stacking/bps/disable

N/A N/A Disable BPS stack.

POST .../stacking/bps/enable

N/A N/A Enable BPS stack.

POST .../stacking/bps/factory_reset

N/A N/A Erase the startup configuration
and all knowledge of other
stack members.

POST .../stacking/bps/member/remove

N/A N/A Erases the stack member
configuration.

POST .../stacking/bps/member/shutdown

N/A N/A Shut down the specified stack
member.

POST .../stacking/bps/set_stack

N/A N/A Makes the inactive stack
active.

Service BpsConfig
HTTP Method Resource Request Response Description

GET .../stacking/bps/info

N/A N/A Returns the BPS
stack information.
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HTTP Method Resource Request Response Description

PUT .../stacking/bps/info

N/A N/A Updates the BPS
stack information.

GET .../stacking/bps/members

N/A N/A Returns all BPS
member
configuration.

POST .../stacking/bps/members

N/A N/A Adds the BPS
member matching
the given member
ID.

GET .../stacking/bps/members/{BpsMember.member_id}

N/A N/A Returns the BPS
member
configuration
matching the given
member ID.

PUT .../stacking/bps/members/{ BpsMember.member_id}

N/A N/A Updates the BPS
member
configuration
matching the given
member ID.

GET .../stacking/bps/members/system_info

N/A N/A Returns all BPS
member system
information.

GET .../stacking/bps/members/system_info /{BpsMemberSystemInfo.member_id}

N/A BpsMemberSystemI
nfo

Returns the BPS
member's system
information matching
the given member
ID.

GET .../stacking/bps/stack_ports

N/A N/A Returns all BPS
stack ports.
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HTTP Method Resource Request Response Description

GET .../stacking/bps/stack_ports/members/{ BpsStackPort.member_id}/stack_port/
{ BpsStackPort.stacking_port}

N/A N/A Returns the details
of the specified stack
port of the member
matching the given
member ID.

Service CableDiagnostics
HTTP Method Resource Request Response Description

POST ../cable_diagnostics

N/A N/A To run cable
diagnostics on all
ports those support
cable diagnostics.
No response will be
seen if the
diagnostics is run on
a port connected to
rest client.

POST .../cable_diagnostics/clear

N/A N/A To clear cable
diagnostics on all
ports.

POST .../cable_diagnostics/clear/port

CableDiagnosticsCo
mmand

N/A To clear cable
diagnostics results
on a port.

POST .../cable_diagnostics/port

CableDiagnosticsCo
mmand

N/A To run cable
diagnostics on a
port. No response
will be seen if the
diagnostics is run on
a port connected to
rest client.

GET .../cable_diagnostics/status

N/A WiredElementList Returns cable
diagnostics status.
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HTTP Method Resource Request Response Description

GET .../cable_diagnostics/status/{CableDiagnostics.port_id}

N/A CableDiagnostics Returns cable
diagnostics status
per port.

Service CaptivePortal
HTTP Method Resource Request Response Description

GET .../captive_portal

N/A CaptivePortal Returns the global
Captive Portal
Configuration.

PUT .../captive_portal

CaptivePortal CaptivePortal Updates the global
Captive Portal
Configuration.

Service CfgBackupCmd
HTTP Method Resource Request Response Description

GET .../system/config/cfg_backup_files

N/A WiredElementList Returns the list of
backup configuration
file details.

POST .../system/config/cfg_backup_files

CfgBackupconf ConfigFileDetails Save the given
configuration File to
the system.

GET .../system/config/cfg_backup_files/ {ConfigFileDetails.file_name}

N/A ConfigFileDetails Returns the details
of backup
configuration files by
name.
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Service CfgRestoreCmd
HTTP Method Resource Request Response Description

POST .../system/config/cfg_restore

CfgRestore CurrentRestoreStatu
s

Restore the given
configuration as the
running configuration
without reboot.
REST performs the
config restoration in
non-blocking mode.

GET .../system/config/cfg_restore/status

N/A CfgRestoreDetails Returns the status of
cfg-restore process.

Service CfgRestoreDiff
HTTP Method Resource Request Response Description

POST .../system/config/cfg_restore/latest_diff

CfgRestoreDiff CurrentDiffStatus Provide the list of
changes that will be
applied on the
running
configuration.

GET .../system/config/ cfg_restore/latest_diff/status

N/A CfgRestoreDiffStatus Returns the status
difference between
two configuration
files.

Service CfgRestorePayload
HTTP Method Resource Request Response Description

OST .../system/config/ cfg_restore/payload

CfgRestorePayload CfgRestorePayloadS
tatus Accepts the encoded

input and restore it
as running
configuration; REST
performs the config
restoration in non-
blocking mode.
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HTTP Method Resource Request Response Description

GET .../system/config/cfg_restore/ payload/status

N/A CfgRestoreDetails Returns the status of
the applied encoded
configuration file.

Service CfgRestorePayloadDiff
HTTP Method Resource Request Response Description

POST .../system/config/cfg_restore/ payload/latest_diff

CfgRestorePayloadD
iff

CurrentPayloadDiffSt
atus

Provide the list of
changes that will be
applied on the
running
configuration.

GET .../system/config/cfg_restore/ payload/latest_diff/status

N/A CfgRestoreDiffStatus Returns the status
difference between
two configuration
files.

Service CliCommand
HTTP Method Resource Request Response Description

POST .../cli

N/A N/A Cli command
interface.

Service CliBatchCommand
HTTP Method Resource Request Response Description

POST .../cli_batch

N/A N/A Cli batch command.

GET .../cli_batch/status

N/A N/A Cli batch command
status.
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Service ConfigHash
HTTP Method Resource Request Response Description

GET .../system/config/config_hash

N/A ConfigHash Returns the SHA of
startup configuration.

GET .../system/config/running_config_hash

N/A RunningConfigHash Returns the SHA of
running
configuration.

Service ConfigPayload
HTTP Method Resource Request Response Description

POST .../system/config/payload

ConfigPayload ConfigPayloadStatus Accepts the encoded
input. If it is for
backup
configuration,
backup the
configuration to
flash. If it is a patch
file content then
download it to flash.

Service ConfigurationResetCommand
HTTP Method Resource Request Response Description

POST .../system/configuration-reset

N/A N/A Reset the system
configuration.

Service DeviceProfile
HTTP Method Resource Request Response Description

GET .../device_identities

N/A N/A Returns all the
device identity
configuration.
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HTTP Method Resource Request Response Description

POST .../device_identities

N/A N/A Adds the given
device identity
configuration to the
model.

GET .../device_identities/{DeviceIdentity.device_name}

N/A N/A Returns the given
device identity
configuration.

PUT .../device_identities/{DeviceIdentity.device_name}

N/A N/A Update the given
device identity
configuration to the
model.

DELETE .../device_identities/{DeviceIdentity.device_name}

N/A N/A Deletes the given
device identity
configuration.

GET .../device_profiles

N/A N/A Returns all device
profile.

POST .../device_profiles

N/A N/A Adds the given
device profile
configuration to the
model.

GET .../device_profiles-vlans

N/A N/A Returns all device
profile associations.

POST .../device_profiles-vlans

N/A N/A Adds the given
device profile
association to the
model.

GET .../device_profiles-vlans/{DeviceProfileVlan.device_profile_name}-
{DeviceProfileVlan.tagged_vlan_id}

N/A N/A Returns the device
profile vlan
configuration.
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HTTP Method Resource Request Response Description

DELETE .../device_profiles-vlans/{DeviceProfileVlan.device_profile_name}-
{DeviceProfileVlan.tagged_vlan_id}

N/A N/A Deletes device
profile vlans.

GET .../device_profiles/{DeviceProfileConfig.device_profile_name}

N/A DeviceProfileConfig Returns the device
profile configuration.

PUT .../device_profiles/{DeviceProfileConfig.device_profile_name}

N/A N/A Update the given
device profile
configuration to the
model.

DELETE .../device_profiles/{DeviceProfileConfig.device_profile_name}

N/A N/A Deletes device
profile configuration.

GET .../device_profiles/status

N/A N/A Returns the device
profile status
configuration.

GET .../device_types

N/A N/A Returns all device
type configurations.

GET .../device_types/{DeviceTypeConfig.device_type}

N/A N/A Returns the device
type configuration.

PUT .../device_types/{DeviceTypeConfig.device_type}

N/A N/A Update the given
device type
configuration to the
model.

NOTE: /device_identity added in device_profiles.
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Service DhcpRelay
HTTP Method Resource Request Response Description

GET .../dhcp-relay

N/A DhcpRelay Returns the DHCP-
Relay global
attributes.

PUT .../dhcp-relay

DhcpRelay DhcpRelay Update the DHCP-
Relay global
attributes.

GET .../dhcp-relay/option_82

N/A DhcpRelayOption82 Returns the DHCP
Relay Option 82.

PUT .../dhcp-relay/option_82

DhcpRelayOption82 DhcpRelayOption82 Updates the given
DHCP Relay Option
82.

GET .../dhcp/options

N/A DhcpOptions Returns the status of
DHCP Options.

PUT .../dhcp/options

DhcpOptions DhcpOptions Updates the status
of given DHCP
Options.

Service DhcpRelayVlan
HTTP Method Resource Request Response Description

GET .../vlans/dhcp-relay

N/A WiredElementList Returns the all
helper addresses
under all vlans.

POST .../vlans/dhcp-relay
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HTTP Method Resource Request Response Description

DhcpRelayVlan DhcpRelayVlan Adds the given
DHCP Relay VLAN
with helper address
in the model.

GET .../vlans/dhcp-relay/{DhcpRelayVlan.vlan_id}-
{DhcpRelayVlan.dhcp_helper_address.octets}

N/A DhcpRelayVlan Returns the DHCP
Relay VLAN with
helper address.

DELETE .../vlans/dhcp-relay/{DhcpRelayVlan.vlan_id}-
{DhcpRelayVlan.dhcp_helper_address.octets}

N/A N/A Deletes the DHCP
Relay VLAN Helper
address from a
VLAN ID.

GET .../vlans/{DhcpRelayVlan.vlan_id} /dhcp-relay

N/A DhcpRelayVlan Returns the DHCP
Relay VLAN
matching the given
ID.

PUT .../vlans/{DhcpRelayVlan.vlan_id} /dhcp-relay

DhcpRelayVlan DhcpRelayVlan Updates the given
DHCP Relay VLAN
in the model.

Service DhcpServer
HTTP Method Resource Request Response Description

GET .../dhcp-server

N/A DhcpServer Returns the DHCP-
Server.

PUT .../dhcp-server

DhcpServer DhcpServer Updates DHCP-
Server in the model.
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Service DhcpServerPool
HTTP Method Resource Request Response Description

GET .../dhcp-server/pools

N/A N/A Returns DHCP-
Server pools.

POST .../dhcp-server/pools

N/A N/A Adds the given
DHCP-Server pool to
the model.

GET .../dhcp-server/pools/{DhcpServerPool.pool_name}

N/A N/A Returns the DHCP-
Server pool by
name.

DELETE .../dhcp-server/pools/{DhcpServerPool.pool_name}

N/A N/A Deletes DHCP-
Server pool by
name.

Service Dot1x
HTTP Method Resource Request Response Description

GET .../dot1x

N/A Dot1x Returns the global
802.1X
configuration.

PUT .../dot1x

Dot1x Dot1x Updates the global
802.1X
configuration.
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Service Dot1xAuthenticatorPort
HTTP Method Resource Request Response Description

GET .../dot1x/authenticator

N/A N/A Returns the list of
802.1X Authenticator
Port elements
matching the given
query.

GET .../dot1x/authenticator/{Dot1xAuthenticatorPort.port_id}

N/A Dot1xAuthenticatorP
ort

Returns the 802.1X
Authenticator Port
matching the given
ID.

PUT .../dot1x/authenticator/{Dot1xAuthenticatorPort.port_id}

N/A N/A Updates the given
802.1X Authenticator
Port in the model.

POST .../dot1x/authenticator/{Dot1xAuthenticatorPort.port_id}/clearstats

N/A N/A Clear statistics of
dot1x authenticator
based on port id.

GET .../dot1x/authenticator/{Dot1xAuthenticatorClientStats.port_id}/client_stats

N/A N/A Returns the 802.1X
Authenticator client
session statistics
matching the given
port.

POST .../dot1x/authenticator/{Dot1xAuthenticatorPort.port_id}/initialize

N/A N/A Initialize of dot1x
authenticator based
on port id.

POST .../dot1x/authenticator/{Dot1xAuthenticatorPort.port_id}/reauthenticate

N/A N/A Initialize of dot1x
authenticator based
on port id.

GET .../dot1x/authenticator/{Dot1xAuthenticatorSessionCounters.port_id}/session_counters
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HTTP Method Resource Request Response Description

N/A N/A Returns the 802.1X
Authenticator
session counters
matching the given
port.

GET .../dot1x/authenticator/{Dot1xAuthenticatorStats.port_id}/stats

N/A N/A Returns the 802.1X
Authenticator
statistics matching
the given port.

GET .../dot1x/authenticator/{Dot1xAuthenticatorStatus.port_id}/stats

N/A N/A Returns the 802.1X
Authenticator status
matching the given
port.

GET .../dot1x/authenticator/client_stats

N/A N/A Returns the list of
802.1X Authenticator
client session
statistics elements
matching the given
query.

GET .../dot1x/authenticator/session_counters

N/A N/A Returns the list of
802.1X Authenticator
session counters
elements matching
the given query.

GET .../dot1x/authenticator/stats

N/A N/A Returns the list of
802.1X Authenticator
statistics elements
matching the given
query.

GET .../dot1x/authenticator/status

N/A N/A Returns the list of
802.1X Authenticator
status elements
matching the given
query.
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Service Dot1xAuthenticationMethod
HTTP Method Resource Request Response Description

GET .../dot1x/authentication_method

N/A Dot1xAuthenticationMethod Returns the 802.1X
Authentication
method details.

PUT .../dot1x/authentication_method

Dot1xAuthenticationMethod Dot1xAuthenticationMethod Updates the given
802.1X
Authentication
method details.

Service Dot1xPortSecurity
HTTP Method Resource Request Response Description

GET .../dot1x/port_security

WiredCollectionQuery WiredElementList Returns the list of
802.1X Port Security
elements matching the
given query.

GET .../dot1x/port_security/{Dot1xPortSecurity.port_id}

N/A Dot1xPortSecurity Returns the 802.1X Port
security details
matching the given ID.

PUT .../dot1x/port_security/{Dot1xPortSecurity.port_id}

Dot1xPortSecurity Dot1xPortSecurity Updates the given
802.1X Port security in
the model.

Service Dsnoop
HTTP Method Resource Request Response Description

GET .../dsnoop

N/A Dsnoop Returns the DHCP-
Snooping global
attributes.

PUT .../dsnoop
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HTTP Method Resource Request Response Description

Dsnoop Dsnoop Update the DHCP-
Snooping global
attributes.

GET .../dsnoop/authorized_server/{DsnoopAuthServer.authorized_server.octets}

N/A DsnoopAuthServer GET a DHCP
Snooping Authorized
server from the
system.

DELETE .../dsnoop/authorized_server/{DsnoopAuthServer.authorized_server.octets}

N/A N/A Remove a DHCP
Snooping Authorized
server from the
system.

GET .../dsnoop/option_82

N/A DsnoopOption82 Returns the DHCP-
Snooping option 82
attributes.

PUT .../dsnoop/option_82

DsnoopOption82 DsnoopOption82 Update the DHCP-
Snooping option 82
attributes.

Service EventLog
HTTP Method Resource Request Response Description

Get .../system-event-log

EventLogged LoggedEventResponseList Download/Query
logged events from
system.

Service EventSubscription
HTTP Method Resource Request Response Description

GET .../event-subscription

N/A SubscriptionStatusList Returns the
subscription status
list.
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HTTP Method Resource Request Response Description

POST .../event-subscription

SubscriptionRequest SubscriptionStatus Subscribe to receive
events.

GET .../event-subscription/{SubscriptionStatus.subscription_id}

N/A SubscriptionStatus Returns the
subscription status.

PUT .../event-subscription/{SubscriptionStatus.subscription_id}

SubscriptionRequest SubscriptionStatus Update subscription.

DELETE .../event-subscription/{SubscriptionStatus.subscription_id}

N/A N/A Delete subscription.

Service Igmp
HTTP Method Resource Request Response Description

GET .../igmp

N/A Igmp Returns IGMP global
configuration.

PUT .../igmp

Igmp Igmp Updates the IGMP
global configuration.

GET .../igmp/ports

N/A WiredElementList Returns the list of
IGMP fastlearn Port
elements matching
the given query.

GET .../igmp/ports/{IgmpPort.port_id}

N/A IgmpPort Returns IGMP port
fastlearn details.

PUT .../igmp/ports/{IgmpPort.port_id}

IgmpPort IgmpPort Updates the IGMP
port fastlearn
details..

POST .../igmp/reload
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HTTP Method Resource Request Response Description

N/A N/A Reset IGMP state on
all interfaces.

GET .../igmp/vlans

N/A WiredElementList Returns the list of
VLAN IGMP
elements matching
the given query.

GET .../igmp/vlans/ports

N/A WiredElementList Returns the list of
VLAN IGMP port
configuration
elements matching
the given query.

GET .../igmp/vlans/static_groups

N/A WiredElementList Returns the list of
VLAN IGMP static
groups configuration
elements matching
the given query.

POST .../igmp/vlans/static_groups

VlanIgmpStaticGroup VlanIgmpStaticGroup Creates the given
VLAN IGMP static
groups configuration
in the model.

GET .../igmp/vlans/static_groups/{Void .id}

N/A VlanIgmpStaticGroup Returns the VLAN
IGMP static group
configuration
matching the given
ID.

DELETE .../igmp/vlans/static_groups/{Void .id}

N/A N/A Deletes the VLAN
IGMP static group
configuration
matching the given
ID.

GET .../igmp/vlans/stats
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HTTP Method Resource Request Response Description

N/A WiredElementList Returns the list of
VLAN IGMP Stats
elements matching
the given query.

GET .../vlans/{VlanIgmp.vlan_id}/igmp

N/A VlanIgmp Returns the VLAN
IGMP matching the
given ID.

PUT .../vlans/{VlanIgmp.vlan_id}/igmp

VlanIgmp VlanIgmp Updates the given
VLAN IGMP in the
model.

GET .../vlans/{VlanIgmpPort.vlan_id}/igmp/ports/{VlanIgmpPort .port_id}

N/A VlanIgmpPort Returns the VLAN
IGMP port
configuration
matching the given
ID.

PUT .../vlans/{VlanIgmpPort.vlan_id}/igmp/ports/{VlanIgmpPort .port_id}

VlanIgmpPort VlanIgmpPort Updates the given
VLAN IGMP port
configuration in the
model.

GET .../vlans/{VlanIgmp.vlan_id}/igmp/stats

N/A VlanIgmpStats Returns the VLAN
IGMP Stats matching
the given ID.

Service IncludeCredentials
HTTP Method Resource Request Response Description

GET .../system/include-credentials

N/A IncludeCredentials Returns the Include-
Credentials settings.

PUT .../system/include-credentials

IncludeCredentials IncludeCredentials Updates the Include-
Credentials settings.
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Service IpAuth
HTTP Method Resource Request Response Description

GET .../ip_auth

WiredCollectionQuery WiredElementList Returns the list of IP
Auth Configuration
matching the given
query.

POST .../ip_auth

IpAuth IpAuth Adds the given IP
Auth Configuration to
the system.

DELETE .../ip_auth/{IpAuth.id}

N/A Void Deletes the IP Auth
Configuration with
the given ID from the
model.

GET .../ip_auth/{IpAuth.id}

N/A IpAuth Returns the IP Auth
Configuration
matching the given
ID.

Service IpClientTracker
HTTP Method Resource Request Response Description

GET .../ip/client_tracker

N/A IpClientTracker Returns Ip Client
Tracker attributes.

PUT .../ip/client_tracker

IpClientTracker IpClientTracker Update the Ip Client
Tracker attributes.
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Service IpSlaClearCommand
HTTP Method Resource Request Response Description

 POST .../ip-slas/{IpSlaConfig.ipsla_id}/clearstats

N/A N/A Clears History and
Message statistics of
ipsla based on
IPSLA ID.

Service IpSlaClearResponderStatsCommand
HTTP Method Resource Request Response Description

POST .../ipsla_responders/clear_stats/{ IpSlaResponder.responder_type}-
{ IpSlaResponder.destination_address}-{ IpSlaResponder.destination_port}-
{ IpSlaResponder.source_address}

N/A N/A Clears statistics of
ipsla responder
based on responder
details.

Service IPSlaConfig
HTTP Method Resource Request Response Description

GET .../ip-slas

N/A WiredElementList Returns the list of IP-
SLA elements
matching the given
query.

POST .../ip-slas

IpSlaConfig IpSlaConfig Adds the given IP-
SLA to the model.

GET .../ip-slas/{ IpSlaConfig.ipsla_id}

N/A IpSlaConfig Returns the IP-SLA
matching the given
ID.

DELETE .../ip-slas/{ IpSlaConfig .ipsla_id}

N/A Void Deletes the IP-SLA
with the given ID
from the model.
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HTTP Method Resource Request Response Description

GET .../ip-slas/{ IpSlaStatus .ipsla_id}/status

N/A IpSlaStatus Returns the IP-SLA
matching the given
ID.

PUT .../ip-slas/{ IpSlaStatus .ipsla_id}/status

IpSlaStatus IpSlaStatus Updates the IP-SLA
status matching the
given ID.

GET ../ip-slas/history/{ IpSlaHistory .ipsla_id}

N/A IpSlaHistory Returns the IP-SLA
history matching the
given ID.

GET .../ip-slas/jitter-voip/aggregated_results/{ IpSlaJitterVoipResults .ipsla_id}

N/A IpSlaJitterVoipResults Returns the IP-SLA
aggregated results
for UDP Jitter/ Jitter-
For-Voip for the
given ID.

GET .../ip-slas/jitter-voip/results/{ IpSlaJitterVoipResults .ipsla_id}

N/A IpSlaJitterVoipResults Returns the IP-SLA
results for UDP Jitter/
Jitter-For-Voip for the
given ID.

GET .../ip-slas/stats/{ IpSlaMessageStats .ipsla_id}

N/A IpSlaMessageStats Returns the IP-SLA
stats matching the
given ID.

Service IpSlaResponder
HTTP Method Resource Request Response Description

GET .../ipsla_responders

N/A WiredElementList Returns IP SLA
Responder List.

POST .../ipsla_responders
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HTTP Method Resource Request Response Description

IpSlaResponder IpSlaResponder Adds the given IP
SLA responder to
the model.

GET .../ipsla_responders/{IpSlaResponder.responder_type}-
{IpSlaResponder .destination_address}-{ IpSlaResponder .destination_port}-
{IpSlaResponder.source_address}

N/A IpSlaResponder Returns the IP SLA
responder by
responder details.

DELETE .../ipsla_responders/{IpSlaResponder.responder_type}-
{IpSlaResponder .destination_address}-{ IpSlaResponder .destination_port}-
{IpSlaResponder .source_address}

N/A N/A Deletes IP SLA
responder by
responder details.

Service IpSlaResponderStats
HTTP Method Resource Request Response Description

GET .../ipslas_responders/statistics/{IpSlaResponderStats.responder_type}-
{ IpSlaResponderStats .destination_address}-{ IpSlaResponderStats .destination_port}-
{ IpSlaResponderStats .source_address}

N/A IpSlaResponderStats Returns the IP SLA
responder statistics
by responder details.

Service Lacp
HTTP Method Resource Request Response Description

GET .../lacp/port

N/A WiredElementList Returns the list port
trunk configurations

POST .../lacp/port

Lacp Lacp Adds port to a Lacp
Trunk.

GET .../lacp/port/{Lacp.port_id}
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HTTP Method Resource Request Response Description

N/A Lacp Returns the LACP
Port Configuration.

DELETE .../lacp/port/{Lacp.port_id}

N/A Void Deletes Port From a
LACP trunk.

Service LocatorLedBlink
HTTP Method Resource Request Response Description

POST .../locator-led-blink

N/A N/A Triggers a locator led
blink based on the
given parameters.

GET .../led_locator_info/{LocatorLedBlinkCommand.member_id}

N/A LocatorLedResult Returns the LED
Locator information
by member.

Service LoopProtect
HTTP Method Resource Request Response Description

GET .../loop_protect

N/A LoopProtect Returns the
attributes of loop
protection

PUT .../loop_protect

LoopProtect LoopProtect Updates attributes of
Loop Protection

GET .../loop_protect/ports

N/A WiredElementList Returns Loop
Protect configuration
for all ports.

GET .../loop_protect/ports/{LoopProtectPort.port_id}
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HTTP Method Resource Request Response Description

N/A LoopProtectPort Returns Loop
Protect per port
details.

PUT .../loop_protect/ports/{LoopProtectPort.port_id}

LoopProtectPort LoopProtectPort Updates attributes of
Loop Protect per
port.

GET .../loop_protect/vlans

N/A WiredElementList Retrieves Loop
Protect VLANs.

GET .../loop_protect/vlans/{LoopProtectVlan.vlan_id}

N/A LoopProtectVlan Retrieves Loop
Protect VLANs by
vlan_id.

PUT .../loop_protect/vlans/{LoopProtectVlan.vlan_id}

LoopProtectVlan LoopProtectVlan Updates Loop
Protect VLANs by
vlan_id.

Service MacAuthenticationPort
HTTP Method Resource Request Response Description

GET .../mac-authentication/port

N/A WiredElementList Returns the list of
MAC Authentication
Port elements
matching the given
query.

GET .../mac-authentication/port/{MacAuthenticationPort.port_id}

N/A MacAuthenticationPort Returns the MAC
Authentication Port
matching the given
ID.

PUT .../mac-authentication/port/{MacAuthenticationPort.port_id}

N/A MacAuthenticationPort Updates the given
MAC Authentication
Port in the model.
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Service MacAuthentication
HTTP Method Resource Request Response Description

GET .../mac-authentication

N/A MacAuthentication Returns the global
MAC authentication
configuration.

PUT .../mac-authentication

MacAuthentication MacAuthentication Updates the global
MAC authentication
configuration.

Service MacTable
HTTP Method Resource Request Response Description

GET .../mac-table

N/A WiredElementList Returns a list of
MAC entries (capped
to 1K right now).

GET .../mac-table/{MacAddress.octets}

N/A MacTableEntry Returns the MAC
table entry for the
given MAC address.

GET .../ports/{Port.id}/mac-table

N/A WiredElementList Returns list of MAC
entries learned on a
given Port ID.

GET .../vlans/{Vlan.vlan_id}/mac-table

N/A WiredElementList Returns list of MAC
entries learned on a
given VLAN ID.

Service Module
HTTP Method Resource Request Response Description

GET .../modules

N/A Module Returns the Module
Information.
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Service Mstp
HTTP Method Resource Request Response Description

GET .../mstp

N/A Mstp Returns the global
MSTP settings.

PUT .../mstp

Mstp Mstp Updates the global
MSTP settings.

GET .../mstp/port

N/A WiredElementList Returns the list of
MSTP Port elements
matching the given
query.

GET .../mstp/port/{ MstpPort .id}

N/A MstpPort Returns the MSTP
Port matching the
given ID.

PUT .../mstp/port/{ MstpPort .id}

MstpPort MstpPort Updates the MSTP
Port matching the
given ID.

Service Oobm
HTTP Method Resource Request Response Description

GET .../oobm/interface/members

Returns the OOBM
Interface settings for
all members in
stacked switches

GET .../oobm/interface/members/{OobmInterface.member_id}

Returns the OOBM
Interface settings per
member_id in
stacked switches.

PUT .../oobm/interface/members/{OobmInterface.member_id}
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HTTP Method Resource Request Response Description

Updates the OOBM
Interface settings per
member_id in
stacked switches.

GET .../oobm/interface/members/{OobmInterfaceStats.member_id}/stats

Returns the OOBM
Interface stats per
member_id in
stacked switches.

GET .../oobm/interface/members/stats

Returns the OOBM
Interface stats for all
members in stacked
switches

GET .../oobm/ip

Returns the Global
OOBM IP settings

PUT .../oobm/ip

Updates the Global
OOBM IP settings

GET .../oobm/ip/members

Returns the OOBM
ip settings for all
members in stacked
switches

GET .../oobm/ip/members/{OobmIp.member_id}

Returns the OOBM
IP settings per
member_id in
stacked switches

PUT .../oobm/ip/members/{OobmIp.member_id}

Updates the OOBM
IP settings per
member_id in
stacked switches
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Service Poe
HTTP Method Resource Request Response Description

GET .../members/{MemberPoe.member_id}/poe

N/A MemberPoe Returns the member
PoE details matching
the given member ID
in stacking enabled
switches.

PUT .../members/{MemberPoe.member_id}/poe

MemberPoe MemberPoe Updates the given
member PoE details
matching the given
member ID in
stacking enabled
switches.

GET .../poe/members

N/A WiredElementList Returns the list of
member elements
matching the given
query in stacking
enabled switches.

POST .../poe/ports/{PortPoe.port_id}/reset

N/A N/A Reset the PoE
controller to which
the port belongs.

GET .../system/status/power/consumption

N/A WiredElementList Returns the Power-
Consumption status
of the host system
(no sampling info).

NOTE: Applicable only for ArubaOS-Switch 5400R.
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Service PortMirrorSession
HTTP Method Resource Request Response Description

GET .../port-mirror

N/A WiredElementList Returns the list of
Port Mirror Session
elements matching
the given query.

POST .../port-mirror

PortMirrorSession PortMirrorSession Adds the given Port
Mirror Session to the
model.

GET .../port-mirror/PortMirrorSession.session_id}

N/A PortMirrorSession Returns the Port
Mirror Session
matching the given
ID.

PUT .../port-mirror/{PortMirrorSession.session_id}

PortMirrorSession PortMirrorSession Updates the given
Port Mirror Session
in the model.

DELETE .../port-mirror/{PortMirrorSession.session_id}

N/A N/A Deletes the Port
Mirror Session with
the given ID from the
model.

Service PortRateLimit
HTTP Method Resource Request Response Description

GET .../ports/icmp_rate_limit

N/A WiredElementList Returns ICMP rate
limit configurations
for all ports.

GET .../ports/icmp_rate_limit/{PortIcmpRateLimit.port_id}

N/A PortIcmpRateLimit Returns port ICMP
rate limit per port id.

Table Continued

Chapter 4 Wired element list 71

Anexo 07 ITENS 8 E 9 (0592724)         SEI 0008478-63.2018.6.02.8000 / pg. 7580



HTTP Method Resource Request Response Description

PUT .../ports/icmp_rate_limit/{PortIcmpRateLimit.port_id}

PortIcmpRateLimit PortIcmpRateLimit Updates attributes of
port ICMP rate limit
per port id.

POST .../ports/icmp_rate_limit_trap_clear/{PortIcmpRateLimitTrapClear.port_id}

PortIcmpRateLimitTrapCl
ear

N/A Clears an existing
ICMP rate limiting
trap condition.

GET .../ports/queues_rate_limit

N/A WiredElementList Returns Egress
queues rate limit
configurations for all
ports.

GET .../ports/queues_rate_limit/{PortQueuesRateLimit.port_id}-
{PortQueuesRateLimit.queues_direction}

N/A PortQueuesRateLimit Returns egress
queues rate limit per
port id.

Service PortSecurity
HTTP Method Resource Request Response Description

GET .../intrusion_logs

N/A WiredElementList Returns the intrusion
logs

GET .../portsec_policies

N/A WiredElementList Returns the list of
Port Security
elements matching
the given query.

GET .../portsec_policies/{PortSecurityPolicy.port_id}

N/A PortSecurityPolicy Returns the Port
Security matching
the given ID.

PUT .../portsec_policies/{PortSecurityPolicy.port_id}
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HTTP Method Resource Request Response Description

PortSecurityPolicy PortSecurityPolicy Updates the given
Port Security in the
model.

GET .../portsec_policies/{PortSecMacAddress.port_id}/mac_addresses/
{PortSecMacAddress.mac_address.octets}

N/A PortSecMacAddress Returns the Port
Security authorized
mac address
configured on a port.
MAC format in uri
should be xxx-xxx.

DELETE .../portsec_policies/{PortSecMacAddress.port_id}/mac_addresses/
{PortSecMacAddress.mac_address.octets}

N/A N/A Deletes a given Port
Security authorized
mac address
configured. MAC
format in uri should
be xxx-xxx.

GET .../portsec_policies/mac_addresses

N/A WiredElementList Returns all the Port
Security authorized
mac address
configured.

POST .../portsec_policies/mac_addresses

PortSecMacAddress PortSecMacAddress Adds an authorized
mac address to port.

Service QosPort
HTTP Method Resource Request Response Description

GET .../qos/ports-policies

WiredCollectionQuery WiredElementList Returns the
list of QoS
Port Policy
elements
matching the
given query.

POST .../qos/ports-policies
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HTTP Method Resource Request Response Description

QosPortPolicy QosPortPolicy Adds the
given QoS
Port Policy to
the model.

DELETE .../qos/ports-policies/{QosPortPolicy.port_id}-{QosPortPolicy.policy_id}

N/A N/A Deletes the
QoS Port
Policy with the
given ID from
the model.

GET .../qos/ports-policies/arg

N/A N/A Returns the
QoS statistics
for given
policy and
Port.

Service QosTrust
HTTP Method Resource Request Response Description

GET .../qos/trust/ports

N/A WiredElementList Returns the Qos
Trust configurations

PUT .../qos/trust/ports/{QosTrust.port_id}

QosTrust QosTrust Returns the Qos
Trust configuraion by
port_id

GET .../qos/trust/ports/{ QosTrust.port_id}

N/A QosTrust Update the Qos
Trust configuration
by port_id
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Service QosVlan
HTTP Method Resource Request Response Description

GET .../qos/vlans-policies

WiredCollectionQuery WiredElementList Returns the
list of QoS
VLAN Policy
elements
matching the
given query.

POST .../qos/vlans-policies

QosVlanPolicy QosVlanPolicy Adds the
given QoS
VLAN Policy
to the model.

DELETE .../qos/vlans-policies/{QosVlanPolicy.vlan_id}-{QosVlanPolicy.policy_id}

N/A N/A Deletes the
QoS VLAN
Policy with the
given ID from
the model.

GET .../qos/vlans-policies/{QosVlanPolicy.vlan_id}-{QosVlanPolicy.policy_id}/stats

N/A QosVlanPolicyStats Returns the
QoS statistics
for given
policy and
VLAN.

Service RadiusServerGroup
HTTP Method Resource Request Response Description

POST .../radius/server_group

RadiusServerGroup RadiusServerGroup Adds the given
RADIUS server
group to the model.

GET .../radius/server_group/{RadiusServerGroup.server_group_name}

N/A RadiusServerGroup Returns the RADIUS
server_group pool by
name.
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HTTP Method Resource Request Response Description

DELETE .../radius/server_group/{RadiusServerGroup.server_group_name}

N/A Void Deletes RADIUS
server group by
name.

Service RedundancyManagement
HTTP Method Resource Request Response Description

GET .../redundancy-management/stats

N/A N/A Returns the
Redundancy
Management stats.

NOTE: 

New attributes, “member_id”, “member_description” and “member_state” are added in
RedundancyManagementStatsEntry.json (in response).

Service RemovePatchfileCommand
HTTP Method Resource Request Response Description

POST .../system/configuration_reset/patch_file

N/A ErasePatchFile Erase the stored
patch file.

Service RestVersion
HTTP Method Resource Request Response Description

 GET .../version

N/A WiredElementList Returns the REST
Version details.

Service Snmpv3
HTTP Method Resource Request Response Description

GET .../snmpv3

N/A SnmpV3 Returns the
Snmpv3Serve
r.
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HTTP Method Resource Request Response Description

PUT .../snmpv3

SnmpV3 SnmpV3 Updates the
Snmpv3Serve
r.

GET .../snmpv3/users

N/A WiredElementList Returns all the
Snmpv3Users
.

POST ... /snmpv3/users

SnmpV3 SnmpV3User Adds the
given
Snmpv3User.

GET ... /snmpv3/users/{SnmpV3User .user_name}

N/A SnmpV3User Returns the
specified
Snmpv3User.

PUT ... /snmpv3/users/{SnmpV3User .user_name}

SnmpV3 SnmpV3User Updates the
given
Snmpv3User.

DELETE ... /snmpv3/users/{SnmpV3User .user_name}

N/A N/A Deletes the
given
Snmpv3User.

GET ... /snmpv3/notify_names

N/A WiredElementList Returns all the
Snmpv3Notify
entries.

POST ... /snmpv3/notify_names

SnmpV3NotifyName SnmpV3NotifyName Adds the
given
Snmpv3Notify
entry.

GET ... /snmpv3/notify_names/{SnmpV3NotifyName .notify_name}
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HTTP Method Resource Request Response Description

N/A SnmpV3NotifyName Returns the
specified
Snmpv3Notify
entry.

DELETE .../snmpv3/notify_names/{SnmpV3NotifyName .notify_name}

N/A N/A Deletes the
given
Snmpv3Notify
entry.

GET ... /snmpv3/params

N/A WiredElementList Returns all the
Snmpv3Para
ms entries.

POST ... /snmpv3/params

SnmpV3Param SnmpV3Param Adds the
given
Snmpv3Para
m entry.

GET ... /snmpv3/params/{SnmpV3Param .parameter_name}

N/A SnmpV3Param Returns the
specified
Snmpv3Para
m entry.

PUT ... /snmpv3/params/{SnmpV3Param .parameter_name}

SnmpV3Param SnmpV3Param Updates the
given
Snmpv3Para
m entry.

DELETE ... /snmpv3/params/{SnmpV3Param.parameter_name}

N/A N/A Deletes the
given
Snmpv3Para
m entry.

GET ... /snmpv3/target_addresses

N/A WiredElementList Returns all the
Snmpv3Target
Addresses
entries.
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HTTP Method Resource Request Response Description

POST ... /snmpv3/target_addresses

SnmpV3TargetAddress SnmpV3TargetAddress Adds the
given
Snmpv3Target
Address entry.

GET ... /snmpv3/target_addresses/{SnmpV3TargetAddress .target_address_name}

N/A SnmpV3TargetAddress Returns the
specified
Snmpv3Target
Address entry.

PUT ... /snmpv3/target_addresses/{SnmpV3TargetAddress .target_address_name}

SnmpV3TargetAddress SnmpV3TargetAddress Updates the
given
Snmpv3Target
Address entry.

DELETE ... /snmpv3/target_addresses/{SnmpV3TargetAddress .target_address_name}

N/A N/A Deletes the
given
Snmpv3Target
Address entry.

Service SnmpServer
HTTP Method Resource Request Response Description

GET .../snmp-server

N/A SnmpServer Returns properties of
SNMP-Server.

PUT .../snmp-server

SnmpServer SnmpServer Updates properties
of SNMP-Server in
the model.
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Service SnmpServerCommunities
HTTP Method Resource Request Response Description

GET .../snmp-server/communities

N/A WiredElementList Returns the SNMP-
Server Community
list.

POST .../snmp-server/communities

SnmpServerCommu
nity

SnmpServerCommunity Adds SNMP-Server
Communities in the
model.

GET .../snmp-server/communities/{SnmpServerCommunity .community_name}

N/A SnmpServerCommunity Returns the SNMP-
Server Community
by name.

PUT .../snmp-server/communities/{SnmpServerCommunity .community_name}

N/A SnmpServerCommunity Updates the SNMP-
Server Community
by name.

DELETE .../snmp-server/communities/{SnmpServerCommunity .community_name}

N/A N/A Deletes the SNMP-
Server Community
by name.

Service SnmpServerHosts
HTTP Method Resource Request Response Description

GET .../snmp-server/hosts

N/A WiredElementList Returns the SNMP-
Server Host details.

POST .../snmp-server/hosts

SnmpServerHost SnmpServerHost Adds SNMP-Server
Hosts in the model.

GET .../snmp-server/hosts/{ SnmpServerHost.host_ip}-{SnmpServerHost .community}
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HTTP Method Resource Request Response Description

N/A SnmpServerHost Returns the SNMP-
Server Host by
name.

PUT .../snmp-server/hosts/{ SnmpServerHost.host_ip}-{SnmpServerHost .community}

SnmpServerHost SnmpServerHost Updates SNMP-
Server Host in the
model.

DELETE .../snmp-server/hosts/{ SnmpServerHost.host_ip}-{SnmpServerHost .community}

N/A N/A Deletes the SNMP-
Server Host by
name.

Service SnmpServerMib
HTTP Method Resource Request Response Description

GET .../snmp-server/mib

N/A SnmpServerMib Returns SNMP-
Server MIB settings.

PUT .../snmp-server/mib

SnmpServerMib SnmpServerMib Updates SNMP-
Server MIB settings
in the model.

Service SnmpServerResponseSource
HTTP Method Resource Request Response Description

GET .../snmp-server/response-source

N/A SnmpServerResponseSour
ce

Returns the SNMP-
Server Response
Source details.

PUT .../snmp-server/response-source

SnmpServerResponseS
ource

SnmpServerResponseSour
ce

Updates SNMP-
Server Response
Source in the model.
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Service SnmpServerTraps
HTTP Method Resource Request Response Description

GET .../snmp-server/traps

N/A SnmpServerTraps Returns the SNMP-
Server Traps.

PUT .../snmp-server/traps

SnmpServerTraps SnmpServerTraps Updates the SNMP-
Server Traps in the
model.

GET .../snmp-server/traps/linktraps

N/A WiredElementList Returns the SNMP-
Server Link Change
Traps.

GET .../snmp-server/traps/linktraps/{ SnmpServerLinkChangeTrap.port_id}

N/A SnmpServerLinkChangeT
rap

Returns the SNMP-
Server Link Traps for
specified port.

PUT .../snmp-server/traps/linktraps/{SnmpServerLinkChangeTrap.port_id}

SnmpServerLinkCha
ngeTrap

SnmpServerLinkChangeT
rap

Updates the SNMP-
Server Link Traps for
specified port in the
model.

Service SnmpServerTrapSource
HTTP Method Resource Request Response Description

GET ../snmp-server/trap-source

N/A SnmpServerTrapSource Returns the SNMP-
Server Trap Source
details.

PUT ../snmp-server/trap-source

SnmpServerTrapSour
ce

SnmpServerTrapSource Updates SNMP-
Server Trap Source
in the model.
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Service SpanningTree
HTTP Method Resource Request Response Description

GET .../stp

N/A SpanningTree Returns
Spanning Tree
global
configuration.

POST .../stp

SpanningTree SpanningTree Updates
attributes of
SpanningTree.

GET .../stp/ports

WiredCollectionQuery WiredElementList Returns
Spanning Tree
configuration
for all ports.

GET .../stp/ports/{SpanningTreePort.port_id}

N/A SpanningTreePort Returns
Spanning Tree
per port
configuration.

GET .../stp/ports/{SpanningTreePort.port_id}

SpanningTreePort SpanningTreePort Updates
attributes of
SpanningTree
per port.

NOTE: Supports RapidPVST.

Service SwitchSystem
HTTP Method Resource Request Response Description

GET .../system/status/switch

N/A SwitchSystemInfoStats Returns the
status of the
ArubaOS-
Switch
system.
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Service Syslog
HTTP Method Resource Request Response Description

GET .../syslog

N/A Syslog Returns the syslog
details.

PUT .../syslog

Syslog Syslog Adds the given
syslog
configurations.

GET .../syslog/servers

N/A WiredElementList Returns the syslog
server details.

POST .../syslog/servers

SyslogServer SyslogServer Adds the given
syslog server
configurations.

GET .../syslog/servers/{SyslogServer.ip_address.octets}

N/A SyslogServer Returns the syslog
server details by
server.

PUT .../syslog/servers/{SyslogServer.ip_address.octets}

SyslogServer SyslogServer Updates the Syslog
server
Configurations by
server.

DELETE .../syslog/servers/{SyslogServer.ip_address.octets}

N/A N/A Deletes the Syslog
server
Configurations by
server.
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Service SyslogEventCriteria
HTTP Method Resource Request Response Description

GET .../syslog/filters/{filter_name}/event-criterias

N/A WiredElementList Returns the syslog
filter criteria details.

POST .../syslog/filters/{filter_name}/event-criterias

SyslogEventCriteria SyslogEventCriteria Adds the given
syslog filter criteria
configurations.

GET .../syslog/filters/{filter_name}/event-criterias/{criteria_id}

N/A SyslogEventCriteria Returns the syslog
filter criteria details
by Criteria id.

PUT .../syslog/filters/{filter_name}/event-criterias/{criteria_id}

SyslogEventCriteria SyslogEventCriteria Update the Syslog
EventCriteria
Configurations by
criteria id .

DELETE  .../syslog/filters/{filter_name}/event-criterias/{criteria_id}

N/A Void Deletes the Syslog
EventCriteria
Configurations by
criteria_id .

Service SyslogFilter
HTTP Method Resource Request Response Description

GET .../syslog/filters

N/A WiredElementList Returns the syslog
filter details.

POST .../syslog/filters

SyslogFilter SyslogFilter Adds the given
syslog
configurations.

GET .../syslog/filters/{filter_name}

Table Continued

Chapter 4 Wired element list 85

Anexo 07 ITENS 8 E 9 (0592724)         SEI 0008478-63.2018.6.02.8000 / pg. 7594



HTTP Method Resource Request Response Description

N/A SyslogFilter Get the Syslog Filter
Configurations by
filter name.

PUT .../syslog/filters/{filter_name}

SyslogFilter SyslogFilter Update the Syslog
Filter Configurations
by filter name.

DELETE .../syslog/filters/{filter_name}

N/A Void Deletes the Syslog
Filter Configurations
by filter name.

Service TACACSProfile
HTTP Method Resource Request Response Description

GET ../tacacs_profile

N/A TacacsProfile Returns TACACS
Profile.

PUT ../tacacs_profile

TacacsServer TacacsServer Updates attributes of
TACACS Profile.

GET .../tacacs_profile/server/{TacacsServer.server_ip.octets}

N/A TacacsServer Returns a TACACS
Profile Server with
matching IP
Address.

PUT .../tacacs_profile/server/{TacacsServer.server_ip.octets}

TacacsServer TacacsServer Updates Tacacs
Server attributes with
matching IP
Address.

DELETE .../tacacs_profile/server/{TacacsServer.server_ip.octets}

N/A N/A Removes TACACS
Profile Server with
matching IP
Address.
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Service TAConfig
HTTP Method Resource Request Response Description

GET .../ta_profiles

N/A WiredElementList Returns the list of TA
Profiles matching the
given query.

POST .../ta_profiles

TaProfile TaProfile Adds the given TA
profile to the system.

GET .../ta_profiles/{TaProfile.ta_name}

N/A TaProfile Returns the TA
profile configuration
matching the given
profile name.

PUT .../ta_profiles/{TaProfile.ta_name}

TaProfile TaProfile Updates the TA
Profile Configuration
matching the given
profile name.

DELETE .../ta_profiles/{TaProfile.ta_name}

N/A N/A Deletes the TA
profile Configuration
with the given profile
name from the
model.

Service TelnetServer
HTTP Method Resource Request Response Description

GET .../telnet/server

N/A TelnetServer Returns the telnet
server configuration.

PUT .../telnet/server

TelnetServer TelnetServer Updates the telnet
server configuration.
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Service Transceiver
HTTP Method Resource Request Response Description

GET .../transceivers

N/A WiredElementList Returns the list
of Transceiver
elements
matching the
given query.

GET .../transceivers/{Transceiver.serial_number}

N/A Transceiver Returns the
Transceiver
matching the
given ID.

GET .../transceivers/{Transceiver.serial_number}/diagnostics

N/A TransceiverDiagnostics Returns the
Transceiver
Diagnostics
matching the
given ID.

Service Trunk
HTTP Method Resource Request Response Description

GET .../trunk/port

N/A WiredElementList Returns the list port
trunk configurations.

POST .../trunk/port

Trunk Trunk Adds port to a Static
Manual Trunk.

GET .../trunk/port/{Trunk.port_id}

N/A Trunk Returns the TRUNK
Port Configuration.

DELETE .../trunk/port/{Trunk.port_id}

N/A Void Deletes Port From a
Trunk.
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Service TunneledNode
HTTP Method Resource Request Response Description

GET .../tunneled_node_server

N/A TunneledNodeServer Returns the
Tunneled Node
configurations.

PUT .../tunneled_node_server

QosTrust TunneledNodeServer Update the Tunneled
Node configurations.

GET .../tunneled_node_server/ports

N/A WiredElementList Returns all the
Tunneled Node Ports
configurations.

GET .../tunneled_node_server/ports/ {TunneledNodePort.port_id}

N/A TunneledNodePort Returns the
Tunneled Node
configurations per
port.

PUT .../tunneled_node_server/ports/ {TunneledNodePort.port_id}

N/A TunneledNodePort Update the Tunneled
Node Port
configurations.

GET .../tunneled_node_server/ports/ {TunneledNodePortStatistics.port_id}/statistics

N/A TunneledNodePortSt
atistics

Returns the
Tunneled Node
Server statistics per
port.

GET .../tunneled_node_server/ports/ aggregate_statistics

N/A TunneledNodeAggre
gateStatis tics

Returns the
Tunneled Node
aggregate statistics.

GET .../tunneled_node_server/ports/statistics

N/A WiredElementList Returns the
Tunneled Node
Server statistics for
all ports.
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Service VsfCommand
HTTP Method Resource Request Response Description

POST .../stacking/vsf/disable

N/A N/A Disable VSF
stack.

POST .../stacking/vsf/enable

VsfEnableCommand N/A Enable and
Modify domain of
VSF stack.

POST .../stacking/vsf/member/remove

VsfRemoveMemberCommand N/A Removes the
member
specified by
member id and
reboots the
member if reboot
is true.

POST .../stacking/vsf/member/shutdown

VsfMemberShutdownCommand N/A Shut down the
member
specified by
member id.

POST .../stacking/vsf/sequenced_reboot

VsfSequencedRebootCommand N/A Initiate a reboot
of the VSF virtual
chassis.

Service VsfConfig
HTTP Method Resource Request Response Description

GET .../stacking/vsf/global_config

N/A VsfGlobalConfig Returns the VSF
Global Configuration.

PUT .../stacking/vsf/global_config

VsfGlobalConf
ig

VsfGlobalConfig Updates the VSF
Global Configuration.

Table Continued
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HTTP Method Resource Request Response Description

GET .../stacking/vsf/info

N/A VsfStackInfo Returns the VSF
stack Information.

GET .../stacking/vsf/members/ {VsfMember.member_id}

N/A VsfMember Returns the VSF
Member
Configuration
matching the given
ID.

Service WebAuth
HTTP Method Resource Request Response Description

GET .../webauth

N/A WebAuth Returns the global
WEB Auth
configuration.

PUT .../webauth

WebAuth WebAuth Updates the global
WEB Auth
configuration.

Service WebAuthPort
HTTP Method Resource Request Response Description

GET .../webauth/port

N/A WiredElementList Returns the list of
WEB Auth Port
elements matching
the given query.

GET .../webauth/port/{WebAuthPort.port_id}

N/A WebAuthPort Returns the WEB
Auth Port matching
the given ID.

PUT .../webauth/port/{WebAuthPort.port_id}

WebAuthPort WebAuthPort Updates the given
WEB Auth Port in
the model.
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Networking Websites
Hewlett Packard Enterprise Networking Information Library

www.hpe.com/networking/resourcefinder

Hewlett Packard Enterprise Networking Software

www.hpe.com/networking/software

Hewlett Packard Enterprise Networking website

www.hpe.com/info/networking

Hewlett Packard Enterprise My Networking website

www.hpe.com/networking/support

Hewlett Packard Enterprise My Networking Portal

www.hpe.com/networking/mynetworking

Hewlett Packard Enterprise Networking Warranty

www.hpe.com/networking/warranty

General websites
Hewlett Packard Enterprise Information Library

www.hpe.com/info/EIL

For additional websites, see Support and other resources.

Chapter 5
Websites
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Accessing Hewlett Packard Enterprise Support
• For live assistance, go to the Contact Hewlett Packard Enterprise Worldwide website:

http://www.hpe.com/assistance

• To access documentation and support services, go to the Hewlett Packard Enterprise Support Center website:

http://www.hpe.com/support/hpesc

Information to collect

• Technical support registration number (if applicable)

• Product name, model or version, and serial number

• Operating system name and version

• Firmware version

• Error messages

• Product-specific reports and logs

• Add-on products or components

• Third-party products or components

Accessing updates
• Some software products provide a mechanism for accessing software updates through the product interface.

Review your product documentation to identify the recommended software update method.

• To download product updates:

Hewlett Packard Enterprise Support Center
www.hpe.com/support/hpesc

Hewlett Packard Enterprise Support Center: Software downloads
www.hpe.com/support/downloads

Software Depot
www.hpe.com/support/softwaredepot

• To subscribe to eNewsletters and alerts:

www.hpe.com/support/e-updates

• To view and update your entitlements, and to link your contracts and warranties with your profile, go to the
Hewlett Packard Enterprise Support Center More Information on Access to Support Materials page:

www.hpe.com/support/AccessToSupportMaterials

Chapter 6
Support and other resources
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IMPORTANT: Access to some updates might require product entitlement when accessed through
the Hewlett Packard Enterprise Support Center. You must have an HPE Passport set up with
relevant entitlements.

Customer self repair
Hewlett Packard Enterprise customer self repair (CSR) programs allow you to repair your product. If a CSR part
needs to be replaced, it will be shipped directly to you so that you can install it at your convenience. Some parts
do not qualify for CSR. Your Hewlett Packard Enterprise authorized service provider will determine whether a
repair can be accomplished by CSR.

For more information about CSR, contact your local service provider or go to the CSR website:

http://www.hpe.com/support/selfrepair

Remote support
Remote support is available with supported devices as part of your warranty or contractual support agreement. It
provides intelligent event diagnosis, and automatic, secure submission of hardware event notifications to Hewlett
Packard Enterprise, which will initiate a fast and accurate resolution based on your product's service level.
Hewlett Packard Enterprise strongly recommends that you register your device for remote support.

If your product includes additional remote support details, use search to locate that information.

Remote support and Proactive Care information
HPE Get Connected

www.hpe.com/services/getconnected
HPE Proactive Care services

www.hpe.com/services/proactivecare
HPE Proactive Care service: Supported products list

www.hpe.com/services/proactivecaresupportedproducts
HPE Proactive Care advanced service: Supported products list

www.hpe.com/services/proactivecareadvancedsupportedproducts

Proactive Care customer information
Proactive Care central

www.hpe.com/services/proactivecarecentral
Proactive Care service activation

www.hpe.com/services/proactivecarecentralgetstarted

Warranty information
To view the warranty information for your product, see the links provided below:

HPE ProLiant and IA-32 Servers and Options
www.hpe.com/support/ProLiantServers-Warranties

HPE Enterprise and Cloudline Servers
www.hpe.com/support/EnterpriseServers-Warranties

HPE Storage Products
www.hpe.com/support/Storage-Warranties

HPE Networking Products
www.hpe.com/support/Networking-Warranties
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Regulatory information
To view the regulatory information for your product, view the Safety and Compliance Information for Server,
Storage, Power, Networking, and Rack Products, available at the Hewlett Packard Enterprise Support Center:

www.hpe.com/support/Safety-Compliance-EnterpriseProducts

Additional regulatory information

Hewlett Packard Enterprise is committed to providing our customers with information about the chemical
substances in our products as needed to comply with legal requirements such as REACH (Regulation EC No
1907/2006 of the European Parliament and the Council). A chemical information report for this product can be
found at:

www.hpe.com/info/reach

For Hewlett Packard Enterprise product environmental and safety information and compliance data, including
RoHS and REACH, see:

www.hpe.com/info/ecodata

For Hewlett Packard Enterprise environmental information, including company programs, product recycling, and
energy efficiency, see:

www.hpe.com/info/environment

Documentation feedback
Hewlett Packard Enterprise is committed to providing documentation that meets your needs. To help us improve
the documentation, send any errors, suggestions, or comments to Documentation Feedback
(docsfeedback@hpe.com). When submitting your feedback, include the document title, part number, edition,
and publication date located on the front cover of the document. For online help content, include the product
name, product version, help edition, and publication date located on the legal notices page.
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This guide provides information on how to configure traffic management features.

Applicable products
This guide applies to these products:

Aruba 2930F Switch Series (JL253A, JL254A, JL255A, JL256A, JL258A, JL259A, JL260A, JL261A, JL262A,
JL263A, JL264A, JL557A, JL558A, JL559A)

Aruba 2930M Switch Series (JL319A, JL320A, JL321A, JL322A, JL323A, JL324A, R0M67A, R0M68A)

Switch prompts used in this guide
Examples in this guide are representative and may not match your particular switch/environment. Examples use
simplified prompts as follows:

Prompt Explanation

switch# # indicates manager context (authority).

switch> > indicates operator context (authority).

switch(config)# (config) indicates the config context.

switch(vlan-x)# (vlan-x) indicates the vlan context of config, where x
represents the VLAN ID. For example:
switch(vlan-128)#.

switch(eth-x)# (eth-x) indicates the interface context of config,
where x represents the interface. For example:
switch(eth-48)#.

switch-Stack# Stack indicates that stacking is enabled.

switch-Stack(config)# Stack(config) indicates the config context while
stacking is enabled.

switch-Stack(stacking)# Stack(stacking) indicates the stacking context of
config while stacking is enabled.

switch-Stack(vlan-x)# Stack(vlan-x) indicates the vlan context of config
while stacking is enabled, where x represents the
VLAN ID. For example: switch-
Stack(vlan-128)#.

switch-Stack(eth-x/y)# Stack(eth-x/y) indicates the interface context of
config, in the form (eth-<member-in-stack>/
<interface>). For example: switch(eth-1/48)#

Chapter 1
About this guide
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Understanding VLANs
Aruba-OS wired switches are 802.1Q VLAN-enabled. In the factory default state, the switch is enabled for up to
256 VLANs. You can reconfigure the switch to support more VLANs. The maximum VLANs allowed varies
according to the switch series.

A group of networked ports assigned to a VLAN form a broadcast domain configured on the switch. On a given
switch, packets are bridged between source and destination ports that belong to the same VLAN.

VLANs enable grouping users by logical function not physical location. They manage bandwidth usage in
networks by:

• Enabling grouping high-bandwidth users on low-traffic segments.

• Organizing users from different LAN segments according to their need for common resources and individual
protocols.

• Improving traffic control at the edge of networks by separating traffic of different protocol types.

• Enhancing network security by creating subnets to control in-band access to specific network resources.

• Cross-domain broadcast traffic in the switch is eliminated and bandwidth saved by not allowing packets to
flood out all ports.

When configuring VLANs, you will need to plan your VLAN strategy as follows:

Procedure

1. Configure static VLANs with:

• a name

• VLAN ID number (VID)

• port members

2. Include port configuration planning to use dynamic VLANs.

3. Create a map of the logical topology.

4. Create a map of the physical topology.

5. Consider the interaction between VLANs and other features:

• Spanning Tree Protocol

• port trunking

• IGMP

6. Configure at least one VLAN in addition to the default VLAN.

7. Configure all ports that pass traffic for a particular subnet address on the same VLAN.

Chapter 2
VLANs

16 Aruba 2930F / 2930M Advanced Traffic Management Guide for
ArubaOS-Switch 16.08

Anexo 08 ITENS 8 E 9 (0592727)         SEI 0008478-63.2018.6.02.8000 / pg. 7620



8. Assign the desired switch ports to the new VLANs.

9. Ensure that the VLAN through which you manage the switch has an IP address, if you are managing VLANs
with SNMP in an IP network.

For information on the restrictions when you configure an IP address on a VLAN interface, see the "Comparing
port based and protocol based VLAN" table in Static VLAN operation.

Static VLAN operation
Static VLANs are configured with a name, VLAN ID number (VID) and port members. For dynamic VLANs, see 
GVRP. 802.1Q compatibility enables you to assign each switch port to multiple VLANs.

Chapter 2 VLANs 17
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Table 1: Port based and protocol based VLAN

Function Port-Based VLANs Protocol-Based VLANs

IP Addressing Usually configured with at least one unique
IP address.

A port-based VLAN can have no IP
address. However, this limits switch
features available to ports on that VLAN.
See "How IP addressing affects switch
operation" in the chapter "Configuring IP
Addressing" in the Basic Operation Guide
for the switch.

Multiple IP addresses allow multiple
subnets within the same VLAN. See the
chapter on "Configuring IP Addressing" in
the ArubaOS-Switch Basic Operation Guide
for the switch.

You can configure IP addresses on all
protocol VLANs, but IP addressing is used
only on IPv4 and IPv6 VLANs.

Restrictions:

Loopback interfaces share the same IP
address space with VLAN configurations.

The maximum number of IP addresses
supported on a switch is 2048; this includes
all IP addresses configured for both VLANs
and loopback interfaces (except for the
default loopback IP address 127.0.0.1).

Each IP address configured on a VLAN
interface must be unique in the switch; it
cannot be used by a VLAN interface or
another loopback interface.

For more information, see the chapter on
"Configuring IP Addressing" in the
ArubaOS-Switch Basic Operation Guide.

Untagged VLAN
Membership

A port can be a member of one untagged,
port-based VLAN. All other port-based
VLAN assignments for that port must be
tagged.

A port can be an untagged member of one
protocol VLAN of a specific protocol type,
such as IPX or IPv6. If the same protocol
type is configured in multiple protocol
VLANs, then a port can be an untagged
member of only one of those. For example,
if you have two protocol VLANs, 100 and
200 and both include IPX, then a port can
be an untagged member of either VLAN
100 or VLAN 200, but not both.

A port's untagged VLAN memberships can
include up to four different protocol types. It
can be an untagged member of one of the
following:

• Four single-protocol VLANs

• Two protocol VLANs where one VLAN
includes a single protocol and the other
includes up to three protocols

• One protocol VLAN where the VLAN
includes four protocols.

Tagged VLAN
Membership

A port can be a tagged member of any port-
based VLAN.

A port can be a tagged member of any
protocol-based VLAN.

Table Continued
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Function Port-Based VLANs Protocol-Based VLANs

Routing If the switch configuration enables IP
routing, the switch can internally route IP
(IPv4) traffic between port-based VLANs
and between port-based and IPv4 protocol-
based VLANs.

If the switch is not configured to route traffic
internally between port-based VLANs, then
an external router must be used to move
traffic between VLANs.

If the switch configuration enables IP
routing, the switch can internally route IPv4
traffic as follows:

• Between multiple IPv4 protocol-based
VLANs

• Between IPv4 protocol-based VLANs
and port-based VLANs.

Other protocol-based VLANs require an
external router for moving traffic between
VLANs.

NOTE: NETbeui and SNA are
non-routable protocols. End
stations intended to receive
traffic in these protocols must
be attached to the same
physical network.

Commands for
Configuring Static
VLANs

vlan <vid> {tagged | untagged 
<port-list>}

vlan <vid> protocol {ipx | ipv4 
| ipv6 | arp | appletalk | sna 
| netbeui}

vlan <vid> {tagged | untagged 
<port-list>}

VLAN environments
You can configure different VLAN types in any combination. The default VLAN will always be present. For more
on the default VLAN, see VLAN support and the default VLAN.
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VLAN environment Elements

The default VLAN (port-based;
VID of 1) only

In the default VLAN configuration, all ports belong to VLAN 1 as
untagged members.

VLAN 1 is a port-based VLAN.

Multiple VLAN environment In addition to the default VLAN, the configuration can include one or
more other port-based VLANs and one or more protocol VLANs.

The maximum VLANs allowed on a switch vary according to the switch.
For details on the maximum VLANs allowed for your switch, see 
Changing the number of VLANs allowed on the switch (CLI) on
page 46.

UsingVLAN tagging, ports can belong to multiple VLANs of all
types.Enabling routing on the switch enables it to route IPv4 and IPv6
traffic between port-based VLANs and between port-based VLANs and
IPv4 protocol VLANs. Routing other types of traffic between VLANs
requires an external router capable of processing the appropriate
protocols.

VLAN operation

General VLAN operation
• A VLAN is composed of multiple ports operating as members of the same subnet or broadcast domain.

• Ports on multiple devices can belong to the same VLAN.

• Traffic moving between ports in the same VLAN is bridged (or switched).

• Traffic moving between different VLANs must be routed.

• A static VLAN is an 802.1Q-compliant VLAN, configured with one or more ports that remain members
regardless of traffic usage.

• A dynamic VLAN is an 802.1Q-compliant VLAN membership that the switch temporarily creates on a port to
provide a link to another port either in the same VLAN on another device.

Types of static VLANs available in the switch
Port-based VLANs
This type of static VLAN creates a specific layer-2 broadcast domain comprised of member ports that bridge traffic
among themselves. Port-Based VLAN traffic is routable on the switches covered in this guide.

Protocol-based VLANs
This type of static VLAN creates a layer-3 broadcast domain for traffic of a particular protocol and is composed of
member ports that bridge traffic of the specified protocol type among themselves. Some protocol types are
routable on the switches covered in this guide.

Designated VLANs
The switch uses these static, port-based VLAN types to separate switch management traffic from other network
traffic. While these VLANs are not limited to management traffic, they provide improved security and availability.

Default VLAN:
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This port-based VLAN is always present in the switch and, in the default configuration, includes all ports as
members. See VLAN support and the default VLAN on page 55.

Except for an IP address and subnet, no configuration steps are needed.

A switch in the default VLAN configuration

In this example, devices connected to these ports are in the same broadcast domain.

Primary VLAN:

The switch uses this port-based VLAN to run certain features and management functions, including DHCP/Bootp
responses for switch management. In the default configuration, the Default VLAN is also the Primary VLAN.
However, any port-based, non-default VLAN can be designated the Primary VLAN. See The primary VLAN on
page 55.

Secure Management VLAN:

This optional, port-based VLAN establishes an isolated network for managing switches that support this feature.
Access to this VLAN and to the switch's management functions are available only through ports configured as
members. See The primary VLAN on page 55.

Voice VLANs:

This optional, port-based VLAN type enables separating, prioritizing, and authenticating voice traffic moving
through your network, avoiding the possibility of broadcast storms affecting VoIP Voice-over-IP) operation. See 
Using voice VLANs on page 53.

NOTE: In a multiple-VLAN environment that includes older switch models there may be problems
related to the same MAC address appearing on different ports and VLANs on the same switch. In
such cases, the solution is to impose cabling and VLAN restrictions. For more on this topic, see 
Multiple VLAN considerations on page 29.

Multiple port-based VLANs
In the following example, routing within the switch is disabled (the default). Thus, communication between any
routable VLANs on the switch must go through the external router. In this case, VLANs W and X can exchange
traffic through the external router, but traffic in VLANs Y and Z is restricted to the respective VLANs.

VLAN 1(the default) is present but not shown. The default VLAN cannot be deleted from the switch, but ports
assigned to other VLANs can be removed from the default VLAN. If internal (IP) routing is enabled on the switch,
then the external router is not needed for traffic to move between port-based VLANs.
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A switch with multiple VLANs configured and internal routing disabled

Protocol VLAN environment
The figure in Multiple port-based VLANs illustrates a protocol VLAN environment also. In this case, VLANs W
and X represent routable protocol VLANs. VLANs Y and Z can be any protocol VLAN.

As noted for the discussion of multiple port-based VLANs, VLAN 1 is not shown. Enabling internal (IP) routing on
the switch allows IP traffic to move between VLANs on the switch, but routable, non-IP traffic always requires an
external router.

Routing options for VLANs
Table 2: Options for routing between VLAN types in the switch

Note that SNA and NETbeui are not routable protocol types. End stations intended to receive traffic in these
protocols must be attached to the same physical network.

Port-
Based

IPX IPv4 IPv6 ARP AppleTalk SNA NETbeui

Port-Based Yes — Yes — — — — —

Protocol IPX — Yes — — — — — —

IPX4 Yes — Yes — — — — —

IPV6 — — — Yes1 — — — —

ARP — — — — Yes1 — — —

AppleTalk — — — — — Yes1 — —

SNA — — — — — — — —

NETbeui — — — — — — — —

802.1Q VLAN tagging
A port can be a member of more than one VLAN of the same type if the device to which the port connects
complies with the 802.1Q VLAN standard.

For example, a port connected to a central server using a network interface card (NIC) that complies with the
802.1Q standard can be a member of multiple VLANs, allowing members of multiple VLANs to use the server.
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• Although these VLANs cannot communicate with each other through the server, they can all access the server
over the same connection from the switch.

• Where VLANs overlap in this way, VLAN "tags" are used in the individual packets to distinguish between traffic
from different VLANs.

• A VLAN tag includes the particular VLAN ID. (VID) of the VLAN on which the packet was generated.

For more on this topic, see Configuring or changing static VLAN per-port settings (CLI) on page 36.

Overlapping VLANs using the same server

Similarly, using 802.1Q-compliant switches, you can connect multiple VLANs through a single switch-to-switch
link.

Connecting multiple VLANs through the same link

Introducing tagged VLANs into legacy networks running only untagged VLANs
You can introduce 802.1Q-compliant devices into networks that have built untagged VLANs based on earlier
VLAN technology. The fundamental rule is that legacy/untagged VLANs require a separate link for each VLAN,
while 802.1Q, or tagged VLANs can combine several VLANs in one link. Thus on the 802.1Q-compliant device,
separate ports (configured as untagged) must be used to connect separate VLANs to non-802.1Q devices.
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Tagged and untagged VLAN technology in the same network

VLAN tagging rules
When tagging is needed
When a port belongs to two or more VLANs of the same type, they remain as separate broadcast domains and
cannot receive traffic from each other without routing.

NOTE:

If multiple, non-routable VLANs exist in the switch—such as NETbeui protocol VLANs—they cannot
receive traffic from each other.

Inbound tagged packets
If a tagged packet arrives on a port that is not a tagged member of the VLAN indicated by the packet's VID, the
switch drops the packet.

Similarly, the switch drops an inbound, tagged packet if the receiving port is an untagged member of the VLAN
indicated by the packet's VID.

Untagged packet forwarding
If the only authorized, inbound VLAN traffic on a port arrives untagged, then the port must be an untagged
member of that VLAN. This is the case where the port is connected to a non-802.1Q compliant device or is
assigned to only one VLAN.

To enable an inbound port to forward an untagged packet, the port must be an untagged member of either a
protocol VLAN matching the packet's protocol, or an untagged member of a port-based VLAN.

That is, when a port receives an incoming, untagged packet, it processes the packet according to the following
ordered criteria:

1. If the port has no untagged VLAN memberships, the switch drops the packet.

2. If the port has an untagged VLAN membership in a protocol VLAN that matches the protocol type of the
incoming packet, then the switch forwards the packet on that VLAN.

3. If the port is a member of an untagged, port-based VLAN, the switch forwards the packet to that VLAN.
Otherwise, the switch drops the packet.

Figure 1: Untagged VLAN operation
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Tagged packet forwarding
If a port is a tagged member of the same VLAN as an inbound, tagged packet received on that port, then the
switch forwards the packet to an outbound port on that VLAN.
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To enable the forwarding of tagged packets, any VLAN to which the port belongs as a tagged member must have
the same VID as that carried by the inbound, tagged packets generated on that VLAN.

Figure 2: Tagged VLAN operation

See also Multiple VLAN considerations on page 29.

Applying VLAN tagging
Example of tagged and untagged VLAN port assignments
If port 7 on an 802.1Q-compliant switch is assigned to only the Red VLAN, the assignment can remain "untagged"
because the port will forward traffic only for the Red VLAN. However, if both the Red and Green VLANs are
assigned to port 7, then at least one of those VLAN assignments must be "tagged" so that Red VLAN traffic can
be distinguished from Green VLAN traffic.

Figure 3: Tagged and untagged VLAN port assignments

In switch X:
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• VLANs assigned to ports X1 - X6 can be untagged because there is only one VLAN assignment per port. Red
VLAN traffic will go out only the Red ports, Green VLAN traffic will go out only the Green ports, and so on.
Devices connected to these ports do not have to be 802.1Q-compliant.

• However, because both the Red VLAN and the Green VLAN are assigned to port X7, at least one of the
VLANs must be tagged for this port.

In switch Y:

• VLANs assigned to ports Y1 - Y4 can be untagged because there is only one VLAN assignment per port.
Devices connected to these ports do not have to be 802.1Q-compliant.

• Because both the Red VLAN and the Green VLAN are assigned to port Y5, at least one of the VLANs must be
tagged for this port.

In both switches:

The ports on the link between the two switches must be configured the same. As shown in the following figure,
the Red VLAN must be untagged on port X7 and Y5 and the Green VLAN must be tagged on port X7 and Y5, or
the opposite way.

NOTE: Each 802.1Q-compliant VLAN must have its own unique VID number and that VLAN must be
given the same VID in every device where configured. That is, if the Red VLAN has a VID of 10 in
switch X, then 10 must also be the Red VID in switch Y.

Figure 4: Example of VLAN ID numbers assigned in the VLAN names screen

Additional VLAN tagging considerations
• Since the purpose of VLAN tagging is to allow multiple VLANs on the same port, any port that has only one

VLAN assigned to it can be configured as "Untagged" (the default) if the authorized inbound traffic for that port
arrives untagged.

• Any port with two or more VLANs of the same type can have one such VLAN assigned as "Untagged." All
other VLANs of the same type must be configured as "Tagged," that is:
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Port-Based VLANs Protocol VLANs

A port can be a member of one untagged, port-based
VLAN. All other port-based VLAN assignments for
that port must be tagged.

A port can be an untagged member of one protocol-
based VLAN of each protocol type. When assigning a
port to multiple, protocol-based VLANs sharing the
same type, the port can be an untagged member of
only one such VLAN.

A port can be a tagged member of any port-based
VLAN.

A port can be a tagged member of any protocol-
based VLAN. See above.

A given VLAN must have the same VID on all 802.1Q-compliant devices in which the VLAN occurs. Also, the
ports connecting two 802.1Q devices should have identical VLAN configurations.

• If all end nodes on a port comply with the 802.1Q standard and are configured to use the correct VID, you can
configure all VLAN assignments on a port as "Tagged" if doing so either makes it easier to manage your VLAN
assignments, or if the authorized, inbound traffic for all VLANs on the port will be tagged.

For a summary and flowcharts of untagged and tagged VLAN operation on inbound traffic, see the following
under VLAN tagging rules on page 24:

• "Inbound Tagged Packets"

• "Untagged Packet Forwarding" and Figure 1: Untagged VLAN operation on page 24

• "Tagged Packet Forwarding" and Figure 2: Tagged VLAN operation on page 26

Example of Networked 802.1Q-compliant devices with multiple VLANs on some ports
In the following network, switches X and Y and servers S1, S2, and the AppleTalk server are 802.1Q-compliant.
(Server S3 could also be 802.1Q-compliant, but it makes no difference for this example.) This network includes
both protocol-based (AppleTalk) VLANs and port-based VLANs.
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• The VLANs assigned to ports X4 - X6 and Y2 - Y5 can all be untagged because there is only one VLAN
assigned per port.

• Port X1 has two AppleTalk VLANs assigned, which means that one VLAN assigned to this port can be
untagged and the other must be tagged.

• Ports X2 and Y1 have two port-based VLANs assigned, so one can be untagged and the other must be tagged
on both ports.

• Ports X3 and Y6 have two port-based VLANs and one protocol-based VLAN assigned. Thus, one port-based
VLAN assigned to this port can be untagged and the other must be tagged. Also, since these two ports share
the same link, their VLAN configurations must match.

In the table, "No" means that the port is not a member of that VLAN. For example, port X3 is not a member of the
Red VLAN and does not carry Red VLAN traffic. Also, if GVRP were enabled (port-based only), Auto would
appear instead of No.

Switch X Switch Y

Port AT-1
VLAN

AT-2
VLAN

Red
VLAN

Green
VLAN

Port AT-1
VLAN

AT-2
VLAN

Red
VLAN

Green
VLAN

X1 Untagged Tagged No No Y1 No No Untagged Tagged

X2 No No Untagged Tagged Y2 No No No Untagged

X3 No Untagged Untagged Tagged Y3 No Untagged No No

X4 No No No Untagged Y4 No No No Untagged

X5 No No Untagged No Y5 No No Untagged No

X6 Untagged No No No Y6 No Untagged Untagged Tagged

NOTE: VLAN configurations on ports connected by the same link must match. Because ports X2 and
Y5 are opposite ends of the same point-to-point connection, both ports must have the same VLAN
configuration, configuring the Red VLAN as "Untagged" and the Green VLAN as "Tagged.”

Multiple VLAN considerations
Switches use a forwarding database to maintain awareness of which external devices are located on which
VLANs. Some switches, such as the switches covered in this guide, have a multiple forwarding database, which
means the switch allows multiple database entries of the same MAC address, with each entry showing the
(different) source VLAN and source port. Other switch models have a single forwarding database, which allows
only one database entry of a unique MAC address, along with the source VLAN and source port on which it is
found. All VLANs on a switch use the same MAC address. Thus, connecting a multiple forwarding database
switch to a single forwarding database switch where multiple VLANs exist imposes some cabling and port VLAN
assignment restrictions. The following table illustrates the functional difference between the two database types.
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Table 3: Forwarding database content

Multiple forwarding database Single forwarding database

MAC address Destination
VLAN ID

Destination port MAC address Destination
VLAN ID

Destination port

0004ea-84d9f4 1 A5 0004ea-84d9f4 100 A9

0004ea-84d9f4 22 A12 0060b0-880af9 105 A10

0004ea-84d9f4 44 A20 0060b0-880a81 107 A17

0060b0-880a81 33 A20

This database allows multiple destinations for the
same MAC address. If the switch detects a new
destination for an existing MAC entry, it just adds a
new instance of that MAC to the table.

This database allows only one destination for a MAC
address. If the switch detects a new destination for an
existing MAC entry, it replaces the existing MAC
instance with a new instance showing the new
destination.

All switches covered in this guide use a multiple forwarding database.

Single forwarding database operation
When a packet arrives with a destination MAC address that matches a MAC address in the switch's forwarding
table, the switch tries to send the packet to the port listed for that MAC address. But if the destination port is in a
different VLAN than the VLAN on which the packet was received, the switch drops the packet. This is not a
problem for a switch with a multiple forwarding database because the switch allows multiple instances of a given
MAC address, one for each valid destination. However, a switch with a single forwarding database allows only
one instance of a given MAC address.

TIP: If you connect both switch types through multiple ports or trunks belonging to different VLANs
and enable routing on the switch with the multiple-forwarding database, then the port and VLAN
record maintained on the switch with the single-forwarding database for the multiple-forwarding
database can change frequently. This may cause poor performance and the appearance of an
intermittent or broken connection.

Switch performance is unreliable
The following example provides a method to identify and correct an unsupported configuration.

Symptom
Poor switch performance, unreliable switch performance, dropped packets, discarded packets, appearance of
intermittent or broken links.

Cause
Incorrect switch configuration.

As shown in the following figure, two switches are connected using two ports on each, and the MAC address table
for Switch A will sometimes record the switch as accessed on port A1 (VLAN 1) and at other times as accessed
on port B1 (VLAN 2).

Procedure

1. PC A sends an IP packet to PC B.

2. The packet enters VLAN 1 in the switch with the MAC address of the switch in the destination field. Because
the switch has not yet learned this MAC address, it does not find the address in its address table and floods
the packet out all ports, including the VLAN 1 link (port A1) to the switch. The switch then routes the packet
through the VLAN 2 link to the switch, which forwards the packet on to PC B. Because the switch received the
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packet from the switch on VLAN 2 (port B1), the switch's single forwarding database records the switch as
being on port B1 (VLAN 2).

3. PC A now sends a second packet to PC B. The packet again enters VLAN 1 in the switch with the MAC
address of the switch in the destination field. However, this time the switch's single forwarding database
indicates that the switch is on port B1 (VLAN 2) and the switch drops the packet instead of forwarding it.

4. Later, the switch transmits a packet to the switch through the VLAN 1 link and the switch updates its address
table to show that the switch is on port A1 (VLAN 1) instead of port B1 (VLAN 2). Thus, the switch's
information on the location of the switch changes over time, and the switch discards some packets directed
through it for the switch. This causes poor performance and the appearance of an intermittent or broken link.

Figure 5: Invalid forwarding configuration

Action/solution
Reconfigure the switches in the configuration.

Procedure

1. Use only one cable or port trunk between single-forwarding and multiple-forwarding database devices.

2. Configure the link with multiple, tagged VLANs.

3. To increase network bandwidth of the connection between devices, use a trunk of multiple physical links.
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Following these rules, the switch forwarding database always lists the switch MAC address on port A1 and the
switch will send traffic to either VLAN on the switch.

Figure 6: Solution for single-forwarding to multiple-forwarding database devices in a multiple VLAN environment

Connecting the Switch to another switch with a multiple forwarding database (Example)
Use one or both of the following connection options:

• A separate port or port trunk interface for each VLAN. This results in a forwarding database having multiple
instances of the same MAC address with different VLAN IDs and port numbers. See Forwarding database
content. The fact that the switches covered by this guide use the same MAC address on all VLAN interfaces
causes no problems.

• The same port or port trunk interface for multiple (tagged) VLANs. This results in a forwarding database having
multiple instances of the same MAC address with different VLAN IDs, but the same port number.

Allowing multiple entries of the same MAC address on different VLANs enables topologies such as the following:

Figure 7: Topology for devices with multiple forwarding databases in a multiple VLAN environment

Configuring VLANs
The CLI configures and displays port-based and protocol-based VLANs.
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In the factory default state, the switch is enabled for up to 256 VLANs, all ports belong to the default primary
VLAN and are in the same broadcast/multicast domain. You can reconfigure the switch to support more VLANs .
The maximum VLANs allowed varies according to the switch series.

The number of VLANs allowed on a switch
The factory default number of VLANs is 256.

You can reconfigure the switch to support more VLANs using the max-vlans command or the GUI. The
maximum VLANs allowed varies according to the switch series. The maximum VLAN values for the switch
documented in this guide are as follows:

Attribute MAX Number of VLANs

2930 Switch Series; WC code

VLAN 2048

IP VLAN 512 total with up to:

• 512 IPv4

• 512 IPv6

static routes 256 total

The maximum VIDs is 4094.

Per-port static VLAN configuration options example
This example shows the options available to assign individual ports to a static VLAN.

GVRP, if configured, affects these options and the VLAN behavior on the switch.

Figure 8: Comparing per-port VLAN options with and without GVRP
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Table 4: Per-port VLAN configuration options

Parameter Effect on port participation in designated VLAN

Tagged Allows the port to join multiple VLANs.

Untagged • Allows VLAN connection to a device that is configured for an untagged VLAN
instead of a tagged VLAN.

• A port can be an untagged member of only one port-based VLAN.

• A port can be an untagged member of only one protocol-based VLAN for any given
protocol type.

For example, if the switch is configured with the default VLAN plus three protocol-
based VLANs that include IPX, then port 1 can be an untagged member of the default
VLAN and one of the protocol-based VLANs.

No or Auto No: When the switch is not GVRP-enabled; prevents the port from joining that VLAN.

Auto: When GVRP is enabled on the switch; it allows the port to dynamically join any
advertised VLAN that has the same VID.

Forbid Prevents the port from joining the VLAN, even if GVRP is enabled on the switch.

Configuring port-based VLAN parameters
NOTE: The CLI configures and displays both port-based and protocol-based VLANs (see Using the
CLI to configure port-based and protocol-based VLAN parameters on page 34.

In the factory default state, the switch is enabled for up to 256 VLANs, all ports belong to the default primary
VLAN and are in the same broadcast/multicast domain. The default VLAN is also the default Primary VLAN; see 
The primary VLAN on page 55. In addition to the default VLAN, you can configure additional static VLANs by
adding new VLAN names and VIDs, and then assigning one or more ports to each VLAN. (The maximum of
VLANs includes the default VLAN, all additional static VLANs you configure, and any dynamic VLANs the switch
creates if you enable GVRP; see GVRP on page 66.) Each port can be assigned to multiple VLANs by using
VLAN tagging; see VLAN tagging rules on page 24.)

Using the CLI to configure port-based and protocol-based VLAN
parameters
In the factory default state, all ports on the switch belong to the port-based default VLAN (DEFAULT_VLAN;
VID=1) and are in the same broadcast/multicast domain.

The default VLAN is also the Primary VLAN.

You can configure additional static VLANs by adding new VLAN names and then assigning one or more ports to
each VLAN.

The maximum VLANs accepted by the switch varies according to the switch series. VIDs numbered up to 4094
are allowed. This must include the default VLAN and any dynamic VLANs the switch creates if you enable GVRP
(see GVRP on page 66).

NOTE: Each port can be assigned to multiple VLANs by using VLAN tagging. See VLAN tagging
rules on page 24.
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Creating a new static VLAN (port-based or protocol-based) (CLI)
The vlan <vid> command operates in the global configuration context to configure a static VLAN and/or take
the CLI to a specified VLAN's context.

Syntax:

vlan <vid> | <ascii-name-string>

no vlan <vid>
If <vid> does not exist in the switch, this command creates a port-based VLAN with the specified <vid>

If the command does not include options, the CLI, moves to the newly created VLAN context.

If an optional name is not specified, the switch assigns a name in the default format VLAN n, where n is the
<vid> assigned to the VLAN.

If the VLAN exists and you enter either the <vid> or the <ascii-name-string> ,the CLI moves to the
specified VLAN's context.

The no form of the command deletes the VLAN as follows:

If one or more ports belong only to the VLAN to be deleted, the CLI notifies you that these ports will be moved to
the default VLAN and prompts you to continue the deletion. For member ports that also belong to another VLAN,
there is no move prompt.

protocol [ipx | ipv4 | ipv6 | arp | appletalk | sna | netbeui]
Configures a static, protocol VLAN of the specified type.

If multiple protocols are configured in the VLAN, the no form removes the specified protocol

If a protocol VLAN is configured with only one protocol type and you use the no form of this command to remove
that protocol, the switch changes the protocol VLAN to a port-based VLAN (if the VLAN does not have an
untagged member port).

If an untagged member port exists on the protocol VLAN, you must either convert the port to a tagged member or
remove the port from the VLAN before removing the last protocol type from the VLAN.

NOTE: If you create an IPv4 protocol VLAN, you must assign the ARP protocol option to it to provide
IP address resolution. Otherwise, IP packets are not deliverable. A Caution message appears in the
CLI if you configure IPv4 in a protocol VLAN that does not already include the ARP protocol option.
The same message appears if you add or delete another protocol in the same VLAN.

name <ascii-name-string>
When included in a vlan command to create a new static VLAN, this command specifies a non-default VLAN
name. Also used to change the current name of an existing VLAN.

NOTE: Avoid spaces and the following characters in the <ascii-name-string> entry: @, #:, $,
^, &, *, ( and). To include a blank space in a VLAN name, enclose the name in single or double
quotes.

voice
Designates a VLAN for VoIP use. For more on this topic, see Using voice VLANs on page 53.
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NOTE: You can use these options from the configuration level by beginning the command with vlan
<vid> , or from the context level of the specific VLAN by just entering the command option.

Creating a new port-based static VLAN

The following example shows how to create a new port-based, static VLAN with a VID of 100 using the following
steps:

1. To create the new VLAN, type the vlan 100 command.

2. To show the VLANs currently configured in the switch, type the show vlans command.

If the Management VLAN field (Primary VLAN : DEFAULT_VLAN Management VLAN shown in the display
information below) is empty, a Secure Management VLAN is not configured in the switch. For more information on
configuring a secure management VLAN, see The secure Management VLAN on page 56.

switch(config)# vlan 100
switch(config)# show vlans

 Status and Counters - VLAN Information
 Maximum VLANs to support : 16
 Primary VLAN : DEFAULT_VLAN
 Management VLAN :

 VLAN ID Name                 Status       Voice Jumbo
 ------- -------------------- ------------ ----- -----
 1       DEFAULT_VLAN         Port-based   No    No
 100     VLAN100              Port-based   No    No

Changing the VLAN context level

To go to a different VLAN context level, such as to the default VLAN:

switch(vlan-100)# vlan default_vlan 
switch(vlan-1)# _

Configuring or changing static VLAN per-port settings (CLI)
Syntax:

vlan <vid>

no vlan <vid>
This command, used with the options listed below, changes the name of an existing static VLAN and the per-port
VLAN membership settings.

NOTE: You can use these options from the configuration level by beginning the command with vlan
<vid>, or from the context level of the specific VLAN by just entering the command option.

tagged <port-list>
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Configures the indicated port as Tagged for the specified VLAN. The no version sets the port to either No or (if
GVRP is enabled) to Auto.

untagged <port-list>
Configures the indicated port as Untagged for the specified VLAN. The no version sets the port to either No or (if
GVRP is enabled) to Auto.

forbid <port-list>
Used in port-based VLANs, configures <port-list> as forbidden to become a member of the specified VLAN,
as well as other actions. Does not operate with option not allowed protocol VLANs. The no version sets the port to
either No or (if GVRP is enabled) to Auto. See GVRP on page 66.

auto <port-list>
Available if GVRP is enabled on the switch. Returns the per-port settings for the specified VLAN to Auto
operation. Auto is the default per-port setting for a static VLAN if GVRP is running on the switch. For information
on dynamic VLAN and GVRP operation, see GVRP on page 66.

Changing the VLAN name and set ports to tagged

Suppose that there is a VLAN named VLAN100 with a VID of 100 and all ports are set to No for this VLAN. To
change the VLAN name to Blue_Team and set ports A1 - A5 to Tagged, use the following commands:

switch(config)# vlan 100 name Blue_Team 
switch(config)# vlan 100 tagged a1-a5

Moving the context level

To move to the vlan 100 context level and execute the same commands:

switch(config)# vlan 100 
switch(vlan-100)# name Blue_Team 
switch(vlan-100)# tagged a1-a5

Changing tagged ports

Similarly, to change the tagged ports in the above examples to No (or Auto, if GVRP is enabled), use either of the
following commands.

At the global config level, use:

switch(config)# no vlan 100 tagged a1-a5
or

At the VLAN 100 context level, use:

switch(vlan-100)# no tagged a1-a5

NOTE: You cannot use these commands with dynamic VLANs. Attempting to do so displays the
message VLAN already exists with no change.
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Converting a dynamic VLAN to a static VLAN (CLI)
Syntax:

static-vlan <vlan-id>
Converts a dynamic, port-based VLAN membership to static, port-based VLAN membership (allows port-based
VLANs only).

For this command,<vlan-id> refers to the VID of the dynamic VLAN membership. Use show vlan to help
identify the VID.

This command requires that GVRP is running on the switch and a port is currently a dynamic member of the
selected VLAN.

After you convert a dynamic VLAN to static, you must configure the switch's per-port participation in the VLAN in
the same way that you would for any static VLAN. For GVRP and dynamic VLAN operation, see GVRP on page
66.

Converting a dynamic VLAN to a port-based static VLAN

Suppose a dynamic VLAN with a VID of 125 exists on the switch. The following command converts the VLAN to a
port-based, static VLAN:

switch(config)# static-vlan 125

Deleting a static VLAN (CLI)
Syntax:
vlan <vid>

no vlan <vid>

CAUTION: Before deleting a static VLAN, reassign all ports in the VLAN to another VLAN.

Deleting a static VLAN

If ports B1-B5 belong to both VLAN 2 and VLAN 3 and ports B6-B10 belong to VLAN 3, deleting VLAN 3 causes
the CLI to prompt you to approve moving ports B6 - B10 to VLAN 1 (the default VLAN). (Ports B1-B5 are not
moved because they still belong to another VLAN.)

switch(config)# no vlan 3
The following ports will be moved to the default VLAN:
B6-B10
Do you want to continue?
[y/n] Y
switch(config)#

Deleting multiple VLANs
The interface command enables you to add or delete interfaces from multiple tagged or untagged VLANs or
SVLANs using a single command. Interfaces can be added or deleted for up to 256 VLANs at a time. If more than
256 VLANs are specified, an error is displayed. The forbid option prevents an interface from becoming a
member of the specified VLANs or SVLANs when used with GVRP.
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Syntax
interface <port-list> <tagged | untagged | forbid> <vlan | svlan <vlan-id-list>>
no interface <port-list> <tagged | untagged | forbid> <vlan | svlan <vlan-id-list>>

The specified interfaces are added to existing VLANs or SVLANs. If a VLAN or SVLAN does not exist, an error
message displays.

The no form of the command removes the specified interfaces from the specified VLANs or SVLANs.

The forbid option prevents an interface from becoming a member of the specified VLANs or SVLANs. It is
executed in interface context.

Removing an interface from several VLANs

The vlan-id-list includes a comma-separated list of VLAN IDs and/or VLAN ID ranges.

To remove interface 1 from VLANs 1, 3, 5, 6, 7, 8, 9, 10

switch(config)# no interface 1,6,7-10 tagged vlan 1,3,5-10

To specify that an interface cannot become a member of VLANs 4 and 5

switch(config)# interface 2 forbid vlan 4-5

Using IP enable/disable for all VLANs
You can administratively disable the IP address on specified VLANs with static IP addresses without removing the
Layer 3 configuration. The switch can be pre-configured as a backup router, then quickly transition from backup to
active by re-enabling Layer 3 routing on one or more VLANs. While the switch is in “backup” mode, it will still be
performing Layer 2 switching.

A MIB object will be toggled to make Layer 3 routing active or inactive on a VLAN.

Interaction with other features
This feature affects management access to the switch as follows:

• IP—SNMP, Telnet, SSH, HTTP, TFTP, SCP, SFTP

• Routing—RIP, OSPF, PIM, VRRP

When the disable layer3 command is configured on a VLAN, the behavior is as if no IP address were
configured for that VLAN. There is no other change in behavior.

Syntax:
disable layer3 vlan <vid> <vid range>
no disable layer3 vlan <vid> <vid range>
In config context, turns off Layer 3 routing for the specified VLAN or VLANs. When executed in vlan context, turns
off Layer 3 routing for that VLAN.

The no form turns on Layer 3 routing for the specified VLAN or VLANs.

Chapter 2 VLANs 39

Anexo 08 ITENS 8 E 9 (0592727)         SEI 0008478-63.2018.6.02.8000 / pg. 7643



The show ip command displays disabled in the IP Config column if Layer 3 has been disabled, or if the VLAN
has no IP configuration. You can tell which is the case by viewing the remaining columns; if there is no IP
configuration, the remaining columns are blank.

Displaying a VLAN disabled for Layer 3

switch(config)# show ip

 Internet (IP) Service

  IP Routing : Disabled

  Default Gateway : 172.22.16.1
  Default TTL     : 64   
  Arp Age         : 20  
  Domain Suffix   :                               
  DNS server      :                                         

                                                                 Proxy ARP
  VLAN              | IP Config  IP Address      Subnet Mask     Std   Local
  ----------------- + ---------- --------------- --------------- ----  -----
  DEFAULT_VLAN      | DHCP/Bootp 172.22.18.100   255.255.248.0   No    No
  VLAN3             | Disabled   172.17.17.17    255.255.255.0   No    No
  VLAN6             | Disabled
  VLAN7             | Manual     10.7.7.1        255.255.255.0   No    No
For IPv6, the Layer 3 Status field displays the status of Layer 3 on that VLAN.

Displaying IPv6 Layer 3 status for a VLAN

switch(config)# show ipv6

 Internet (IPv6) Service

  IPv6 Routing    : Disabled
  Default Gateway :
  ND DAD          : Enabled
  DAD Attempts    : 3

  Vlan Name       : DEFAULT_VLAN
  IPv6 Status     : Disabled
  Layer 3 Status  : Enabled

  Vlan Name       : layer3_off_vlan
  IPv6 Status     : Disabled
  Layer 3 Status  : Disabled

  Address    |                                             Address
  Origin     | IPv6 Address/Prefix Length                  Status
---------- + ------------------------------------------- -----------
  manual     | abcd::1234/32                               tentative
  autoconfig | fe80::218:71ff:febd:ee00/64                 tentative

Interactions with DHCP
Disabling Layer 3 functionality and DHCP are mutually exclusive, with DHCP taking precedence over disable
layer3 on a VLAN. The following interactions occur:
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• If the disable layer3 command is executed when DHCP is already configured, no disabling of the VLAN
occurs. This error message displays: “Layer 3 cannot be disabled on a VLAN that has DHCP enabled.”

• From the CLI: If disable layer3 is configured already and an attempt is made to configure DHCP, DHCP
takes precedence and will be set. The warning message displays: “Layer 3 has also been enabled on this
VLAN since it is required for DHCP.”

• From the CLI: When disabling a range of VLAN IDs, this warning message displays: “Layer 3 will not be
disabled for any LANs that have DHCP enabled.”

• From SNMP: If the disable layer3 command is executed when DHCP is already configured, no disabling
of the VLAN occurs. An INCONSISTENT_VALUE error is returned.

• From SNMP: If disable layer3 is configured already and an attempt is made to configure DHCP, DHCP
takes precedence and will be set.

Changing the Primary VLAN (CLI)
For more information on Primary VLANs, see The primary VLAN on page 55.

To change the Primary VLAN (CLI), use the following command:

primary-vlan vid <ascii-name-string>
In the default VLAN configuration, the port-based default VLAN (DEFAULT_VLAN) is the Primary VLAN. This
command reassigns the Primary VLAN function to an existing, port-based, static VLAN. The switch cannot
reassign the Primary VLAN function to a protocol VLAN.

If you reassign the Primary VLAN to a non-default VLAN, to delete the Primary VLAN from the switch, you must
assign the Primary VLAN to another port-based static VLAN.

To identify the current Primary VLAN and list the available VLANs and their respective VIDs, use show vlans.

Reassigning, renaming and displaying the VLAN command sequence

The following example shows how to reassign the Primary VLAN to VLAN 22 (first command line), rename the
VLAN 22-Primary (second command line) and then display the result (third command line):

switch(config)# primary-vlan 22
switch(config)# vlan 22 name 22-Primary
switch(config)# show vlans

Status and Counters - VLAN Information
Maximum VLANs to support : 8
Primary VLAN : 22-Primary
Management VLAN :

VLAN ID Name                 Status       Voice Jumbo
------- -------------------- ------------ ----- -----
1       DEFAULT_VLAN         Static       No    No
22      22-Primary           Static       No    No
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Configuring a secure Management VLAN (CLI)

Preparation

Procedure

1. Determine a VID and VLAN name suitable for your Management VLAN.

2. Plan your topology to use switches that support Management VLANs. See The secure Management VLAN
on page 56.

3. Include only the following ports:

a. Ports to which you will connect authorized management stations, such as Port A7 in the "Management
VLAN control in a LAN" example in The secure Management VLAN.

b. Ports on one switch that you will use to extend the Management VLAN to ports on other switches, such as
ports A1 in the "Management VLAN control in a LAN" example in The secure Management VLAN.

4. Half-duplex repeaters dedicated to connecting management stations to the Management VLAN can also be
included in this topology. Any device connected to a half-duplex repeater in the Management VLAN will also
have Management VLAN access.

5. Configure the Management VLAN on the selected switch ports.

6. Test the Management VLAN from all of the management stations authorized to use it, including any SNMP-
based network management stations. Also test any Management VLAN links between switches.

NOTE: If you configure a Management VLAN on a switch using a Telnet connection through a port
not in the Management VLAN, you will lose management contact with the switch if you log off your
Telnet connection or execute write memory and reboot the switch.

Configuring an existing VLAN as the Management VLAN (CLI)
Syntax:
management-vlan <vlan-id> | <vlan-name>
no management-vlan <vlan-id> | <vlan-name>
Configures an existing VLAN as the Management VLAN.

The no form disables the Management VLAN and returns the switch to its default management operation.

Default: Disabled. In this case, the VLAN returns to standard VLAN operation.

Switch configuration

You have configured a VLAN named My_VLAN with a VID of 100 and want to configure the switch to do the
following:

• Use My_VLAN as a Management VLAN (tagged, in this case) to connect port A1 on switch "A" to a
management station. The management station includes a network interface card with 802.1Q tagged VLAN
capability.

• Use port A2 to extend the Management VLAN to port B1 which is already configured as a tagged member of
My_VLAN, on an adjacent switch that supports the Management VLAN feature.
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switch(config)# management-vlan 100
switch(config)# vlan 100 tagged a1
switch(config)# vlan 100 tagged a2

Configuration Example

Obtaining an IP address using DHCP (CLI)
Use DHCP to obtain an IPv4 address for your Management VLAN or a client on that VLAN. The following
examples illustrate when an IP address will be received from the DHCP server.

DHCP server on a Management VLAN

If Blue_VLAN is configured as the Management VLAN and the DHCP server is also on Blue_VLAN, Blue_VLAN
receives an IP address. Because DHCP Relay does not forward onto or off the Management VLAN, devices on
Red_VLAN cannot get an IP address from the DHCP server on Blue_VLAN (Management VLAN) and Red_VLAN
does not receive an IP address.

DHCP server on a different VLAN from the Management VLAN

If Red_VLAN is configured as the Management VLAN and the DHCP server is on Blue_VLAN, Blue_VLAN
receives an IP address but Red_VLAN does not.

Chapter 2 VLANs 43

Anexo 08 ITENS 8 E 9 (0592727)         SEI 0008478-63.2018.6.02.8000 / pg. 7647



No Management VLANs configured

If no Management VLAN is configured, both Blue_VLAN and Red_VLAN receive IP addresses.

A client on a different Management VLAN from the DHCP server

If Red_VLAN is configured as the Management VLAN and the client is on Red_VLAN, but the DHCP server is on
Blue_VLAN, the client will not receive an IP address.

44 Aruba 2930F / 2930M Advanced Traffic Management Guide for
ArubaOS-Switch 16.08

Anexo 08 ITENS 8 E 9 (0592727)         SEI 0008478-63.2018.6.02.8000 / pg. 7648



A DHCP server and client on the Management VLAN

If Blue_VLAN is configured as the Management VLAN, the client is on Blue_VLAN and the DHCP server is on
Blue_VLAN, the client receives an IP address.

Obtaining the IP address for a host that is on a different VLAN than the DHCP server
In the following example, the host is on VLAN 20 and is connected on port number 2 of the switch. The DHCP
server, however, is in VLAN 10 and is connected on port 10 of the switch.

Obtaining the IP address for a host that is on a different VLAN than the DHCP server

switch(config)# vlan 10
name "VLAN 10"
untagged 10
ip address 10.1.1.2 255.255.255.0
exit
vlan 20
name "VLAN 20"
untagged 2
ip address 100.99.1.1 255.255.255.0
ip helper-address 10.1.1.1
exit

Disabling the Management feature (CLI)
You can disable the Secure Management feature without deleting the VLAN.

Disabling the secure management feature

The following commands disable the Secure Management feature in the above example:

switch(config)# no management-vlan 100
switch(config)# no management-vlan my_vlan
For more information, see The secure Management VLAN on page 56.
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Changing the number of VLANs allowed on the switch (CLI)
Syntax:

max-vlans<max number of vlans>
Use this command to specify the maximum number of VLANs allowed on the switch. The minimum value is 16.
The maximum value varies according to the switch series.

The total number of allowed IP VLANs (IPv6 + IPv4) is 512.

If GVRP is enabled, this setting includes any dynamic VLANs on the switch. As part of implementing a new
setting, you must execute a write memory command to save the new value to the startup-config file and then
reboot the switch.

NOTE: If multiple VLANs exist on the switch, you cannot reset the maximum number of VLANs to a
value smaller than the current number of VLANs.

The following example shows the command sequence for changing the number of VLANs allowed to 20. You can
execute the commands to write memory and boot at another time.

Example of changing the number of allowed VLANs

switch(config)# max-vlans 20
This command will take effect after saving the configuration 
and rebooting the system.
switch(config)# write memory
switch(config)# boot
This will reboot the system from the primary image, do you want to continue [y/n]? Y
Error Messages

An error message will be displayed, if you set the max-vlans value to a number that exceeds the allowable
value for the switch series.

If you set the max-vlans and later try to downgrade to an earlier version of the switch software that does not
allow that number of max-vlans, successful downgrade may be prevented.

Displaying a switch VLAN configuration
The show vlans command lists the VLANs currently running in the switch, with VID, VLAN name, and VLAN
status. Dynamic VLANs appear only if the switch is running with GVRP enabled and one or more ports has
dynamically joined an advertised VLAN. In the default configuration, GVRP is disabled.

Syntax:

show vlans
The following describes the fields displayed with this command (see the example output):

Maximum VLANs to support

Shows the number of VLANs the switch is currently configured to support.

Primary VLAN

See The primary VLAN on page 55.

Management VLAN

See The secure Management VLAN on page 56.
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802.1Q VLAN ID

The VLAN identification number, or VID.

Name

The default or specified name assigned to the VLAN. For a static VLAN, the default name consists of VLAN-x
where x matches the VID assigned to that VLAN. For a dynamic VLAN, the name consists of GVRP_x where
x matches the applicable VID.

Status
Port-Based

Port-Based, static VLAN

Protocol

Protocol-Based, static VLAN

Dynamic

Port-Based, temporary VLAN learned through GVRP

Voice

Indicates whether a port-based VLAN is configured as a voice VLAN. See Using voice VLANs on page
53.

Jumbo

Indicates whether a VLAN is configured for Jumbo packets. For more on jumbos, see "Port Traffic
Controls" in the management and configuration guide for your switch.

This example shows the listing from the show vlans command. When GVRP is disabled (the default), Dynamic
VLANs do not exist on the switch and do not appear in this listing. For more information, see GVRP on page 66.

Displaying VLAN listing with GVRP enabled

switch# show vlans

 Status and Counters - VLAN Information

  Maximum VLANs to support : 256
  Primary VLAN : DEFAULT_VLAN
  Management VLAN :

  VLAN ID Name                 | Status     Voice Jumbo
  ------- -------------------- + ---------- ----- -----
  1       DEFAULT_VLAN         | Port-based No    No
  10      VLAN_10              | Port-based Yes   Yes
  15      VLAN_15              | Port-based No    No
  20      VLAN_20              | Protocol   No    No
  33      VLAN_33              | Dynamic    No    No

Viewing the VLAN membership of one or more ports (CLI)
Syntax:

show vlan ports <port-list> [detail]
Displays VLAN information for an individual port or a group of ports, either cumulatively or on a detailed per-port
basis.

Chapter 2 VLANs 47

Anexo 08 ITENS 8 E 9 (0592727)         SEI 0008478-63.2018.6.02.8000 / pg. 7651



port-list
Specifies a single port number or a range of ports (for example, a1-a16), or all for which to display
information.

detail
Displays detailed VLAN membership information on a per-port basis.

The following describes the fields displayed by the command (see example output):

Port name

The user-specified port name, if one has been assigned.

VLAN ID

The VLAN identification number, or VID.

Name

The default or specified name assigned to the VLAN. For a static VLAN, the default name consists of VLAN-x
where x matches the VID assigned to that VLAN. For a dynamic VLAN, the name consists of GVRP_x where
x matches the applicable VID.

Status
Port-Based

Port-Based, static VLAN.

Protocol

Protocol-Based, static VLAN.

Dynamic

Port-Based, temporary VLAN learned through GVRP.

Voice

Indicates whether a port-based VLAN is configured as a voice VLAN.

Jumbo

Indicates whether a VLAN is configured for jumbo packets. For more on jumbos, see "Port Traffic Controls" in
the management and configuration guide for your switch.

Mode

Indicates whether a VLAN is tagged or untagged.

Displaying VLAN ports (cumulative listing)

switch(config)#show vlan ports a1-a24

Status and Counters - VLAN Information - for ports A1-A24

VLAN ID Name                 | Status     Voice Jumbo
------- -------------------- + ---------- ----- -----
1       DEFAULT_VLAN         | Port-based No    No
10      VLAN_10              | Port-based Yes   No
15      VLAN_15              | Protocol   No    No

Displaying VLAN ports (detailed listing)

switch(config)#show vlan ports a1-a3 detail
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Status and Counters - VLAN Information - for ports A1

VLAN ID Name                 | Status     Voice Jumbo Mode
------- -------------------- + ---------- ----- ----- --------
1       DEFAULT_VLAN         | Port-based No    No    Untagged
10      VLAN_10              | Port-based Yes   No    Tagged

Status and Counters - VLAN Information - for ports A2

VLAN ID Name                 | Status     Voice Jumbo Mode
------- -------------------- + ---------- ----- ----- --------
1       DEFAULT_VLAN         | Port-based No    No    Untagged
20      VLAN_20              | Protocol   No    No    Untagged

Status and Counters - VLAN Information - for ports A3

VLAN ID Name                 | Status     Voice Jumbo Mode
------- -------------------- + ---------- ----- ----- --------
1       DEFAULT_VLAN         | Port-based No    No    Untagged
33      VLAN_33              | Port-based No    No    Tagged

Viewing the configuration for a particular VLAN (CLI)
Syntax:

show vlans <vlan-id>
Uses the VID to identify and display the data for a specific static or dynamic VLAN.

The following describes the fields displayed with this command (see example output):

802.1Q VLAN ID

The VLAN identification number, or VID.

Name

The default or specified name assigned to the VLAN. For a static VLAN, the default name consists of VLAN-x
where x matches the VID assigned to that VLAN. For a dynamic VLAN, the name consists of GVRP_x where
x matches the applicable VID.

Status
Port-Based

Port-Based, static VLAN.

Protocol

Protocol-Based, static VLAN

Dynamic

Port-Based, temporary VLAN learned through GVRP. See GVRP on page 66.

Voice

Indicates whether a port-based VLAN is configured as a voice VLAN. See Using voice VLANs on page 53.

Jumbo

Indicates whether a VLAN is configured for Jumbo packets. For more on jumbos, see "Port Traffic Controls" in
the management and configuration guide for your switch.

Port Information

Lists the ports configured as members of the VLAN.
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DEFAULT

Shows whether a port is a tagged or untagged member of the listed VLAN.

Unknown VLAN

Shows whether the port can become a dynamic member of an unknown VLAN for which it receives an
advertisement. GVRP must be enabled to allow dynamic joining to occur.

Status

Shows whether the port is participating in an active link.

Displaying information for a specific static VLAN

switch(config)#show vlans 22

Status and Counters - VLAN Information - VLAN 22

 VLAN ID : 22
 Name : VLAN22
 Status : Port-based
 Voice : Yes
 Jumbo : No

 Port Information Mode     Unknown VLAN Status
 ---------------- -------- ------------ ----------
 12               Untagged Learn        Up
 13               Untagged Learn        Up
 14               Untagged Learn        Up
 15               Untagged Learn        Down
 16               Untagged Learn        Up
 17               Untagged Learn        Up
 18               Untagged Learn        Up

Displaying information for a specific dynamic VLAN

The following example shows the information displayed for a specific dynamic VLAN. The show vlans
command lists this data when GVRP is enabled and at least one port on the switch has dynamically joined the
designated VLAN.

switch(config)# show vlans 22

 Status and Counters - VLAN Information - VLAN 22

  VLAN ID : 33
  Name : GVRP_33
  Status : Dynamic
  Voice : No
  Jumbo : No

  Port Information Mode     Unknown VLAN Status
  ---------------- -------- ------------ ----------
  6                Auto     Learn        Up

Customizing the show VLANs output (CLI)
Syntax

show vlans custom [port <port-list>] <column-list>
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Specifies the order you want information to display for the show vlans command. Displays information for one
port or a range of ports. If <port-list> is not specified, all ports display.

Fields that can be included in the customized display:

Field Display Example Default width

id VLAN id 5 6

name VLAN name Vlan55 32

status Status Port-based 10

voice Voice enabled No 5

jumbo Jumbos
enabled

No 5

ipconfig How the IP
address was
configured

Manual

Disabled

DHCP/BootP

10

ipaddr (IPv4)

ipaddr (IPv6)

The IP
addresses

10.10.10.3

fe80::212:79ff:fe8d:8000

15 for IPv4

46 for IPv6

ipmask The subnet
masks

255.255.255.6/64 (prefix for
IPv6 is in format "/XX")

15

proxyarp Whether
proxy ARP is
configured

No 5

localproxyarp Whether local
proxy ARP is
configured

No 9

state "Up" if at least
one port is up

Up 5

Customizing the VLAN display

The following example displays id at its default width and name:20 allows up to 20 characters of the VLAN name
to be displayed. The columns selected for display are separated by spaces.

If the width of the column requested is smaller than the header name of the column, the display of the header
name is truncated.

switch(config)# show vlan custom A1-A3 id name:20 ipaddr state

Status and Counters - VLAN Information - Custom view

VLANID VLAN name            IP Addr                            State
------ -------------------- ---------------------------------  -----
1      DEFAULT_VLAN         15.255.134.74                      Up
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33     Vlan33               10.10.10.01                        Up
44     Vlan44               15.255.164.13                      Up
55     Vlan55               15.255.178.2                       Down
                            15.255.178.3
                            15.255.178.4
60     Vlan60               fe80::212:79ff:fe8d:8000%vlan60    Up

Wrapping column headers

The total output wraps if it is longer than the terminal width; it is not truncated.

switch(config)# show vlan custom id
Status and Counters - VLAN Information - Custom view

 VLANID
 ------
 1
 33
 44

switch(config)# show vlan custom id:2
Status and Counters - VLAN Information - Custom view

 VL
 --
 1
 33
 44

Using pattern matching with the show VLANs custom command
If a pattern matching command is in a search for a field in the output of the show vlan custom command and it
produces an error, the error message may not be visible. For example, if you enter a command with the pattern
matching include option that contains an error (such as 'vlan' is misspelled) as in the following example, the
output may be empty:

switch(config)# show vlans custom 1-3 name vlun include vlan1
Hewlett Packard Enterprise recommends that you try the show vlans custom command first to ensure that
there is output and then enter the command again with the pattern matching option.

Creating an alias for show VLAN commands (CLI)
Create an alias for a frequently used show vlans custom command to avoid entering the selected columns
each time you use the command.

Using a VLAN alias

switch(config)# alias showvlanstatus = “show vlan custom A1-A3 id name:20 status”

switch(config)# show vlan status
Status and Counters - VLAN Information - Custom view

VLANID VLAN name            Status
------ -------------------- ----------
1      DEFAULT_VLAN         Port-based
33     Vlan33               Port-based
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Configuring a VLAN MAC address with heartbeat interval
When installing routing switches in the place of existing routers in a network configuration, you can achieve Layer
3 VLAN migration by using the ip-recv-mac-address command at the VLAN configuration level to:

• Configure the MAC address of the previously installed router on each VLAN interface of a routing switch.

• Optionally configure the time interval to use for sending heartbeat packets with the configured MAC address.

Syntax

ip-recv-mac-address <mac-address> interval <seconds>

no ip-recv-mac-address <mac-address> interval <seconds>
Configures a VLAN interface with the specified MAC address. Enter the no version of the command to remove the
configured MAC address and return to the original MAC address of the switch.

Parameters
interval <seconds>

(Optional) Configures the time interval in seconds used between transmissions of heartbeat packets to all
network devices configured on the VLAN. Valid values are from one to 255 seconds.

Default: 60 seconds.

Displaying a VLAN MAC address configuration (CLI)
Syntax:

show ip-recv-mac-address

Displaying a VLAN MAC address

switch# show ip-recv-mac-address

VLAN L3-Mac-Address Table

VLAN                           L3-Mac-Address                Timeout
-------------                  ------------------------      -----------
DEFAULT_VLAN                  001635-024467                  60
VLAN2                         001635-437529                  100

Using voice VLANs
Configuring voice VLANs separates voice traffic from data traffic and shields your voice traffic from broadcast
storms.
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Operating rules for voice VLANs
• You must statically configure voice VLANs. GVRP and dynamic VLANs do not support voice VLAN operation.

• Configure all ports in a voice VLAN as tagged members of the VLAN. This ensures retention of the QoS
(Quality of Service) priority included in voice VLAN traffic moving through your network.

• If a telephone connected to a voice VLAN includes a data port used for connecting other networked devices
(such as PCs) to the network, then you must configure the port as a tagged member of the voice VLAN and a
tagged or untagged member of the data VLAN you want the other networked device to use.

Components of voice VLAN operation
• Voice VLAN: Configure one or more voice VLANs on the switch. Some reasons for having multiple voice

VLANs include:
◦ Employing telephones with different VLAN requirements

◦ Better control of bandwidth usage

◦ Segregating telephone groups used for different, exclusive purposes

Where multiple voice VLANs exist on the switch, you can use routing to communicate between telephones on
different voice VLANs.

• Tagged/Untagged VLAN Membership: If the appliances using a voice VLAN transmit tagged VLAN packets,
then configure the member ports as tagged members of the VLAN. Otherwise, configure the ports as untagged
members.

Voice VLAN access security
You can use port security configured on an individual port or group of ports in a voice VLAN. That is, you can
allow or deny access to a phone having a particular MAC address. See chapter titled "Configuring and Monitoring
Port Security" in the Access Security Guide for your switch.

NOTE: MAC authentication is not recommended in voice VLAN applications.

Prioritizing voice VLAN QoS (Optional)
Without configuring the switch to prioritize voice VLAN traffic, one of the following conditions applies:

• If the ports in a voice VLAN are not tagged members, the switch forwards all traffic on that VLAN at "normal"
priority.

• If the ports in a voice VLAN are tagged members, then the switch forwards all traffic on that VLAN at whatever
priority the traffic has when received inbound on the switch.

Using the switch's QoS VLAN-ID (VID) priority option, you can change the priority of voice VLAN traffic moving
through the switch. If all port memberships on the voice VLAN are tagged, the priority level you set for voice
VLAN traffic is carried to the next device. With all ports on the voice VLAN configured as tagged members, you
can enforce a QoS priority policy moving through the switch and through your network.

Syntax:
vlan <vid> qos priority <0-7>
The qos priority default setting is 0 (normal), with 1 as the lowest priority and 7 as the highest priority.
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If you configure a voice VLAN with a VID of 10 and want the highest priority for all traffic on this VLAN, execute
the following commands:

switch(config)# vlan 10 qos priority 4
switch(config)# write memory
You also have the option of resetting the DSCP (DiffServe Codepoint) on tagged voice VLAN traffic moving
through the switch. For more information, see Quality of Service (QoS): Managing bandwidth effectively on
page 176.

If all port memberships on the voice VLAN are tagged:

• The priority level set for voice VLAN traffic is carried to the next device.

• You can enforce a QoS priority policy moving through the switch and network.

For more information, see Using voice VLANs on page 53.

Special VLAN types
VLAN support and the default VLAN
In the factory default configuration, VLAN support is enabled and all ports on the switch belong to the port-based,
default VLAN (named DEFAULT_VLAN). This places all ports in the switch into one physical broadcast domain. In
the factory-default state, the default VLAN is also the Primary VLAN.

• You can partition the switch into multiple virtual broadcast domains by configuring one or more additional
VLANs and moving ports from the default VLAN to the new VLANs.

• The switch supports up to 2048 static and dynamic VLANs, with VIDs numbered up to 4094. You can change
the name of the default VLAN, but not its VID, which is always 1.

• You can remove all ports from the default VLAN by placing them in another port-based VLAN, but this VLAN
remains and cannot be deleted from the switch.

For details on port VLAN settings, see Configuring or changing static VLAN per-port settings (CLI) on page
36.

The primary VLAN
As certain features and management functions run on only one VLAN in the switch and because DHCP and
Bootp can run per-VLAN, there is a need for a dedicated VLAN to manage these features and ensure that
multiple instances of DHCP or Bootp on different VLANs do not result in conflicting configuration values for the
switch.

The Primary VLAN is the VLAN the switch uses to run and manage these features and data. In the factory-default
configuration, the switch designates the default VLAN (DEFAULT_VLAN; VID=1) as the Primary VLAN. However
you can designate another static, port-based VLAN as primary.

To summarize, designating a non-default VLAN as primary means that:

• The switch reads DHCP responses on the Primary VLAN instead of on the default VLAN. This includes such
DHCP-resolved parameters as the TimeP server address, Default TTL and IP addressing—including the
Gateway IP address—when the switch configuration specifies DHCP as the source for these values.

• The default VLAN continues to operate as a standard VLAN you cannot delete it or change its VID.

• Any ports not specifically assigned to another VLAN will remain assigned to the Default VLAN, even if it is the
Primary VLAN.

Candidates for Primary VLAN include any static, port-based VLAN currently configured on the switch.
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Protocol-Based VLANs and dynamic (GVRP-learned) VLANs that have not been converted to a static VLAN
cannot be the Primary VLAN. To display the current Primary VLAN, use the CLI show vlan command.

NOTE: If you configure a non-default VLAN as the Primary VLAN, you cannot delete that VLAN
unless you first select a different VLAN to serve as primary.

If you manually configure a gateway on the switch, it ignores any gateway address received via
DHCP or Bootp.

The secure Management VLAN
Configuring a secure Management VLAN creates an isolated network for managing the switches that support this
feature. Access to a secure Management VLAN and the switch's management functions is available only through
ports configured as members.

• Multiple ports on the switch can belong to the Management VLAN. This allows connections for multiple
management stations to the Management VLAN, while allowing Management VLAN links between switches
configured for the same Management VLAN.

• Only traffic from the Management VLAN can manage the switch, which means that only the workstations and
PCs connected to ports belonging to the Management VLAN can manage and reconfigure the switch.

Potential security breaches in a network

This illustrates use of the Management VLAN feature to support management access by a group of management
workstations.

Management VLAN control in a LAN

In this example, Workstation 1 has management access to all three switches through the Management VLAN,
while the PCs do not. This is because configuring a switch to recognize a Management VLAN automatically
excludes attempts to send management traffic from any other VLAN.
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Table 5: VLAN membership in Management VLAN control in a LAN

Switch A1 A3 A6 A7 B2 B4 B5 B9 C2 C3 C6 C8

Management VLAN (VID
= 7)

Y N N Y Y Y N N Y N N N

Marketing VLAN (VID =
12)

N N N N N N N N N Y Y Y

Shipping Dept. VLAN
(VID = 20)

N Y Y N N N N N N N N N

DEFAULT-VLAN (VID = 1) Y Y Y Y Y Y Y Y Y Y Y Y

See Configuring a secure Management VLAN (CLI) on page 42 for configuration details.

Operating notes for Management VLANs
• Use only a static, port-based VLAN for the Management VLAN.

• The Management VLAN feature applies to both IPv4 and IPv6 traffic.

• The Management VLAN does not support IGMP operation.

• Routing between the Management VLAN and other VLANs is not allowed.

• If there are more than 25 VLANs configured on the switch, reboot the switch after configuring the Management
VLAN.

• Only one Management VLAN can be active in the switch. If one Management VLAN VID is saved in the
startup-config file and you configure a different VID in the running-config file, the switch uses the running-
config version until you either use the write-memory command or reboot the switch.

• During a Telnet session to the switch, if you configure the Management VLAN to a VID that excludes the port
through which you are connected to the switch, you will continue to have access only until you terminate the
session by logging out or rebooting the switch.

NOTE: The Management VLAN feature does not control management access through a direct
connection to the switch's serial port.

• During a WebAgent session, if you configure the Management VLAN to a VID that excludes the port through
which you are connected to the switch, you will continue to have access only until you close the browser
session or reboot the switch.
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• Enabling Spanning Tree between a pair of switches where there are multiple links using separate VLANs,
including the Management VLAN, will force the blocking of one or more links. This may include the link
carrying the Management VLAN, which will cause loss of management access to some devices.

• Monitoring Shared Resources: The Management VLAN feature shares internal switch resources with several
other features. The switch provides ample resources for all features. However, if the internal resources
become fully subscribed, the Management VLAN feature cannot be configured until the necessary resources
are released from other uses. For information on determining the current resource availability and usage, see
the appendix titled "Monitoring Resources" in the ArubaOS-Switch Management and Configuration Guide for
your switch.

Inadvertently blocking a Management VLAN link by implementing spanning tree

VLAN operating notes
DHCP/Bootp

If you are using DHCP/Bootp to acquire the switch's configuration, packet time-to-live and TimeP information,
designates the VLAN on which DHCP is configured as the Primary VLAN.

NOTE:

In the factory-default configuration, the DEFAULT_VLAN is the Primary VLAN.

Per-VLAN features

IGMP and some other features operate on a per VLAN basis. This means you must configure such features
separately for each VLAN in which you want them to operate.

Default VLAN

You can rename the default VLAN, but you cannot change its VID (1) or delete it from the switch.

VLAN port assignments

Any ports not specifically removed from the default VLAN remain in the DEFAULT_VLAN, regardless of other
port assignments. Also, a port must always be a tagged or untagged member of at least one port-based
VLAN.

Voice-Over-IP (VoIP)

VoIP operates only over static, port-based VLANs.

Multiple VLAN types configured on the same port

A port can simultaneously belong to both port-based and protocol-based VLANs.
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Protocol Capacity

A protocol-based VLAN can include up to four protocol types. In protocol VLANs using the IPv4 protocol, to
support normal IP network operation ARP must be one of these protocol types (to support normal IP network
operation). Otherwise, IP traffic on the VLAN is disabled.

If you configure an IPv4 protocol VLAN that does not include the ARP VLAN protocol, the switch displays the
following message which indicates a protocol VLAN configured with IPv4 but not ARP:

switch(config)# vlan 97 protocol ipv4

IPv4 assigned without ARP, this may result in undeliverable IP packets.
Deleting Static VLANs

A VLAN can be deleted even if there are currently ports belonging to it. The ports are moved to the default
VLAN.

Adding or Deleting VLANs

Changing the number of VLANs supported on the switch, requires a reboot.

NOTE:

From the CLI, you must perform a write memory command before rebooting. Other VLAN
configuration changes are dynamic.

Effects of VLANs on other switch features
Spanning Tree operation with VLANs
Depending on the spanning tree option configured on the switch, the spanning tree feature may operate as:

• A single instance across all ports on the switch regardless of VLAN assignments

• Multiple instances per-VLAN

For single-instance operation, if redundant physical links exist between the switch and another 802.1Q device, all
but one link will be blocked, even if the redundant links are in separate VLANs. In this case, you can use port
trunking to prevent Spanning Tree from unnecessarily blocking ports (and to improve overall network
performance). For multiple-instance operation, physically redundant links belonging to different VLANs can remain
open. For more information, see Multiple instance spanning tree operation.

NOTE: Spanning Tree operates differently in different devices. For example, in the (obsolete,
non-802.1Q) Switch 2000 and the Switch 800T, Spanning Tree operates per-VLAN, allowing
redundant physical links as long as they are in separate VLANs.

Spanning Tree operates differently in different devices

IP interfaces
There is a one-to-one relationship between a VLAN and an IP network interface. Since the VLAN is defined by a
group of ports, the state (up/down) of those ports determines the state of the IP network interface associated with
that VLAN. When a port-based VLAN or an IPv4 or IPv6 protocol-based VLAN comes up because one or more of
its ports is up, the IP interface for that VLAN is also activated. Likewise, when a VLAN is deactivated because all
of its ports are down, the corresponding IP interface is also deactivated.

Chapter 2 VLANs 59

Anexo 08 ITENS 8 E 9 (0592727)         SEI 0008478-63.2018.6.02.8000 / pg. 7663



VLAN MAC address
The switches have one unique MAC address for all of their VLAN interfaces. You can send an 802.2 test packet to
this MAC address to verify connectivity to the switch and you can assign an IP address to the VLAN interface.
When you Ping that address, ARP will resolve the IP address to this single MAC address.

In a topology where a switch has multiple VLANs and must be connected to a device having a single forwarding
database, some cabling restrictions apply. For more on this topic, see Multiple VLAN considerations on page
29.

Port trunks
When assigning a port trunk to a VLAN, all ports in the trunk are automatically assigned to the same VLAN. A port
trunk is tagged, untagged, or excluded from a VLAN the same way as individual, untrunked ports.

Port monitoring
If you designate a port on the switch for network monitoring, the port will appear in the Port VLAN Assignment
screen and can be configured as a member of any VLAN. For information on how broadcast, multicast and
unicast packets are tagged inside and outside of the VLAN to which the monitor port is assigned, see the section
titled "VLAN-Related Problems" in the "Troubleshooting" appendix of the ArubaOS-Switch Management and
Configuration Guide for your switch.

Jumbo packet support
Jumbo packet support is enabled per-VLAN and applies to all ports belonging to the VLAN. For more information,
see the chapter titled "Port Traffic Controls" in the ArubaOS-Switch Management and Configuration Guide for
your switch.

VLAN restrictions
• A port must be a member of at least one VLAN. In the factory default configuration, all ports are assigned to

the default VLAN (DEFAULT_VLAN; VID=1).

• A port can be a member of one untagged, port-based VLAN. All other port-based VLAN assignments for that
port must be tagged. The "Untagged" designation enables VLAN operation with non 802.1Q-compliant
devices.

• A port can be an untagged member of one protocol-based VLAN of each protocol type. When assigning a port
to multiple, protocol-based VLANs sharing of the same type, the port can be an untagged member of only one
such VLAN.

• With routing enabled on the switch, the switch can route traffic between:
◦ Multiple, port-based VLANs

◦ A port-based VLAN and an IPv4 protocol-based VLAN

◦ A port-based VLAN and an IPv6 protocol-based VLAN

◦ An IPv4 protocol-based VLAN and an IPv6 protocol VLAN

Other, routable, protocol-based VLANs must use an external router to move traffic between VLANs. With
routing disabled, all routing between VLANs must be through an external router.

• Before deleting a static VLAN, t first reassign all ports in the VLAN to another VLAN. You can use the no
vlan <vid> command to delete a static VLAN. For more information, see Creating a new static VLAN
(port-based or protocol-based) (CLI) on page 35.

• Protocol-based VLANs, port-based VLANs and LLDP radio port VLANs cannot run concurrently with RPVST+.
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Migrating Layer 3 VLANs using VLAN MAC configuration
Switches provide for maintaining Layer 3 VLAN configurations when migrating distribution routers in networks not
centrally managed, by configuring the MAC address of the previous router on the VLAN interfaces of the routing
switch.

VLAN MAC address reconfiguration
Switches use one unique MAC address for all VLAN interfaces. If you assign an IP address to a VLAN interface,
ARP resolves the IP address to the MAC address of the routing switch for all incoming packets.

The Layer 3 VLAN MAC Configuration feature lets you reconfigure the MAC address used for VLAN interfaces,
using the CLI. Packets addressed to the reconfigured Layer 3 MAC address, such as ARP and IP data packets,
are received and processed by the routing switch.

Packets transmitted from the routing switch (packets originating from the router and forwarded packets) use the
original Switch MAC address as the source MAC address in Ethernet headers.

ARP reply packets use the reconfigured MAC address in both the:

• ARP Sender MAC address field

• Source MAC address field in the Ethernet frame header

When reconfiguring the MAC address, you may specify a keepalive timeout to transmit heartbeat packets that
advertise the new MAC address

By configuring the MAC address of the previously installed router as the MAC address of each VLAN interface on
the Switch, you can swap the physical port of a router to the Switch after the switch has been properly configured
in the network.

Handling incoming and outgoing VLAN Traffic

Incoming VLAN data packets and ARP requests
These are received and processed on the routing switch according to the MAC address of the previously installed
router configured for each VLAN interface.

Outgoing VLAN traffic
This uses the MAC address of the switch as the source MAC address in packet headers. The MAC address
configured on VLAN interfaces is not used on outbound VLAN traffic.

When the routing switch receives an ARP request for the IP address configured on a VLAN interface, the ARP
reply uses the reconfigured MAC address in both the:

• ARP Sender MAC address field

• Source MAC address field in the Ethernet frame header

When proxy ARP is enabled on a VLAN interface, the ARP reply sent for an ARP request received from VLAN
devices located outside the directly connected IP subnets also contains the reconfigured MAC address in both
the:

• ARP Sender MAC address field

• Source MAC address field in the Ethernet frame header

To hosts in the network, VLAN traffic continues to be routed (using the reconfigured MAC address as destination
address), but outbound VLAN traffic appears to be sent from another router attached to the same subnet (using
the Switch MAC address as source address) attached to the same subnet. Although it appears as an asymmetric
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path to network hosts, the MAC address configuration feature enables Layer 3 VLAN migration. (A successful
VLAN migration is achieved because the hosts do not verify that the source MAC address and the destination
MAC address are the same when communicating with the routing switch.)

Sending heartbeat packets with a configured MAC Address
On the VLAN interfaces of a routing switch, the user-defined MAC address only applies to inbound traffic. As a
result, any connected switches need to learn the new address that is included in the Ethernet frames of outbound
VLAN traffic transmitted from the routing switch.

If a connected switch does not have the newly configured MAC address of the routing switch as a destination in
its MAC address table, it floods packets to all of its ports until a return packet allows the switch to learn the correct
destination address. As a result, the performance of the switch is degraded as it tries to send Ethernet packets to
an unknown destination address.

To allow connected switches to learn the user-configured MAC address of a VLAN interface, the routing switch
can send periodic heartbeat-like Ethernet packets. The Ethernet packets contain the configured MAC address as
the source address in the packet header. IP multicast packets or Ethernet service frames are preferred because
they do not interrupt the normal operation of client devices connected on the segment.

Because the aging time of destination addresses in MAC address tables varies on network devices, you must
also configure a time interval to use for sending heartbeat packets.

Heartbeat packets are sent at periodic intervals with a specific Switch unicast MAC address in the destination
field. This MAC address is assigned to the Switch and is not used by other non- routers. Because the heartbeat
packet contains a unicast MAC address, it does not interrupt host operation. Even if you have multiple 1-65 Static
Virtual LANs (VLANs) Introducing tagged VLAN technology into networks running untagged VLANs switches
connected to the network, there is no impact on network performance because each switch sends heartbeat
packets with its configured MAC address as the destination address.

The format of a heartbeat packet is an extended Ethernet OUI frame with an extended OUI Ethertype (88B7) and
a new protocol identifier in the 5-octet protocol identifier field.

Displaying a VLAN MAC address configuration (CLI)
Syntax:

show ip-recv-mac-address

Displaying a VLAN MAC address

switch# show ip-recv-mac-address

VLAN L3-Mac-Address Table

VLAN                           L3-Mac-Address                Timeout
-------------                  ------------------------      -----------
DEFAULT_VLAN                   001635-024467                 60
VLAN2                          001635-437529                 100

Smart Link
Introduction to Smart Link
Smart link is a switch feature that provides effective, simple, and fast-converging link redundancy in network
topology with dual uplink between different layers of the network. It requires an active (master) and a backup
(slave) link. The active link carries the uplink traffic. Upon failure of the active link, a switchover is triggered and
the traffic is directed to the backup link.
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• In the previous figure, ports A1 and A2 are configured as part of a Smart link group. The connection from the
access switch to Distribution Switch A is the master, and the connection from the access switch to Distribution
Switch B is the slave.

• Only the master interface forwards traffic for a group of VLANs (referred to as protected VLAN group).

• The other interface is in standby mode for this protected group. If port A1 goes down, port A2 starts forwarding
traffic for this protected VLAN group.

• If port A1 comes back up, it goes to standby mode and does not forward traffic. Port A2 continues forwarding
traffic. This is the case if preemption-mode is configured as “role”. If preemption-mode is not configured as
“role”, when the master (A1) comes back up, it becomes Active (forwarding) after the configured ‘preemption-
delay’.

• Since a Smart link group has the information readily available via configuration as to which port should be
forwarding for the protected VLAN group in the case of the active link failure, the failover is much quicker when
compared with STP.

Configuring Smart Link
Use the following commands to configure Smart link:

• Create a smart link group, using optional parameters as necessary:

switch(config)# no smart-link group group-id
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Options

master port

slave port

protected-vlans vid-list

send-control-vlan vid

preemption-mode {off | forced | bandwidth}

preemption-delay 10...max

trap {enable | disable}

NOTE: When executed without any parameters, this command enters into Smart link group
context.

• Configure VLANs to receive flush messages. This is an interface level command. It must be executed for both
the master and the slave port.

switch(config)# smart-link recv-control-vlan vid-list

Enable debug messages for a Smart link group:

switch(config)#debug smart-link [group group-id | all] [flush-packets]

Configuration example
The following example illustrates Smart link configuration with VLAN load-balancing:

• vlans 1-10 mapped to smart-link group 1:

switch(config)#smart-link group 1 master a1 slave a2
switch(config)#smart-link group 1 protected-vlans 1-10
switch(config)#smart-link group 1 send-control-vlan 1
switch(config)#smart-link group 1 preemption-mode role
switch(config)#smart-link group 1 preemption-delay 10

• vlans 11-20 mapped to smart-link group 2:

switch(config)#smart-link group 2 master a2 slave a1
switch(config)#smart-link group 2 protected-vlans 11-20
switch(config)#smart-link group 2 send-control-vlan 10
switch(config)#smart-link group 2 preemption-mode role
switch(config)#smart-link group 2 preemption-delay 15
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Viewing Smart Link information
Smart link supports the following show commands:

• Show the Smart link group information. Detailed output is displayed if group is specified, otherwise only basic
information is displayed for all groups.

show smart-link group {group-id | all}
The H3C-equivalent display command is:

display smart-link group [group-id | all] [begin | exclude | include] regular-expression

• Show statistics of received flush packets

show smart-link flush-statistics
The H3C-equivalent display command is:

display smart-link flush [begin | exclude | include] regular-expression
• Show receive control VLANs configured on per port basis:

show smart-link recv-control-vlans

Clearing statistics
Use the following command to clear group and flush statistics

clear smart-link [flush-statistics] [group group-id | all]
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About GVRP
GVRP (GARP VLAN Registration Protocol) is an application of GARP (Generic Attribute Registration Protocol.) It
enables a switch to dynamically create 802.1Q-compliant VLANs on links with other devices running GVRP and
automatically create VLAN links between GVRP-aware devices. (A GVRP link can include intermediate devices
that are not GVRP-aware.) This operation reduces the chance for errors in VLAN configurations by automatically
providing VID (VLAN ID) consistency across the network. After the switch creates a dynamic VLAN, the CLI
static <vlan-id> command can be used to convert it to a static VLAN. GVRP can also be used to
dynamically enable port membership in static VLANs configured on a switch.

GVRP uses GVRP BPDUs (GVRP Bridge Protocol Data Units) to advertise static VLANs; this a GVRP BPDU is
called an advertisement. On a switch, advertisements are sent outbound from ports to the devices directly
connected to those ports.

GVRP operational rules
• A dynamic VLAN must be converted to a static VLAN before it can have an IP address.

• For the switches covered in this guide, GVRP can be enabled only if max-vlans is set to no more than 512
VLANs.

• The total number of VLANs on the switch (static and dynamic combined) cannot exceed the current Maximum
VLANs setting. For example, in the factory default state, the switch supports up to 256 VLANs. Any additional
VLANs advertised to the switch will not be added unless you first increase the Maximum VLANs setting. In the
global config level of the CLI, use max-vlans.

• Converting a dynamic VLAN to a static VLAN and then executing the write memory command saves the
VLAN in the startup-config file and makes it a permanent part of the switch's VLAN configuration.

• Within the same broadcast domain, a dynamic VLAN can pass through a device that is notGVRP-aware. This
is because a half-duplex repeater, a hub, or a switch that is not GVRP-aware will flood the GVRP (multicast)
advertisement packets out all ports.

• GVRP assigns dynamic VLANs as tagged VLANs. To configure the VLAN as untagged, convert it to a static
VLAN.

• Rebooting a switch on which a dynamic VLAN exists deletes that VLAN. However, the dynamic VLAN
reappears after the reboot if GVRP is enabled and the switch again receives advertisements for that VLAN
through a port configured to add dynamic VLANs.

• By receiving advertisements from other devices running GVRP, the switch learns of static VLANs on those
other devices and dynamically (automatically) creates tagged VLANs on the links to the advertising devices.
Similarly, the switch advertises its static VLANs to other GVRP-aware devices, as well as the dynamic VLANs
the switch has learned.

• A GVRP-enabled switch does not advertise any GVRP-learned VLANs out of the ports on which it originally
learned of those VLANs.

Example of GVRP operation
In the following example, Tagged VLAN ports on switch A and switch C advertise VLANs 22 and 33 to ports on
other GVRP-enabled switches that can dynamically join the VLANs.

Chapter 3
GVRP
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GVRP operation

Options for a GVRP-aware port receiving advertisements
• If there is not already a static VLAN with the advertised VID on the receiving port, such a port can dynamically

create the VLAN and become a member.

• If the switch already has a static VLAN assignment with the same VID as in the advertisement and the port is
configured to Auto for that VLAN, then the port will dynamically join the VLAN and begin moving that VLAN's
traffic. For more detail on Auto, see Enabling a port for dynamic joins.

• Ignore the advertisement for that VID.

• Not participate in that VLAN.

Options for a port belonging to a Tagged or Untagged static VLAN
• Send VLAN advertisements

• Receive advertisements for VLANs on other ports and dynamically join those VLANs.

• Send VLAN advertisements but ignore advertisements received from other ports.

• Avoid GVRP participation by not sending advertisements and dropping any advertisements received from
other devices.

IP addressing
A dynamic VLAN does not have an IP address and moves traffic on the basis of port membership in VLANs.
However, after GVRP creates a dynamic VLAN, you can convert it to a static VLAN. It is then necessary to assign
ports to the VLAN in the same way that you would for a static VLAN created manually. In the static state, you can
configure IP addressing on the VLAN and access it in the same way that you would any other static VLAN.
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Per-port options for handling GVRP "unknown VLANs"
An "unknown VLAN" is a VLAN that the switch learns of by receiving an advertisement for that VLAN on a port
that is not already a member of that VLAN. If the port is configured to learn unknown VLANs, then the VLAN is
dynamically created and the port becomes a tagged member of the VLAN.

GVRP unknown VLAN settings

Suppose that in the Example of GVRP operation, port 1 on switch A is connected to port 5 on switch C.
Because switch A has VLAN 22 statically configured, while switch C does not have this VLAN statically configured
(and does not "Forbid" VLAN 22 on port 5), VLAN 22 is handled as an "Unknown VLAN" on port 5 in switch C.
Conversely, if VLAN 22 was statically configured on switch C, but port 5 was not a member, port 5 would become
a member when advertisements for VLAN 22 were received from switch A.

The CLI show gvrp command VLAN Support screen show a switch's current GVRP configuration, including the
Unknown VLAN settings.

Per-port options for dynamic VLAN advertising and joining
GVRP must be enabled and VLANs must be configured to one or more switches, depending on the topology.

Initiating advertisements
As described in the preceding section, to enable dynamic joins, GVRP must be enabled and a port must be
configured to Learn (the default). However, to send advertisements in your network, one or more static (Tagged,
Untagged, or Auto) VLANs must be configured on one or more switches (with GVRP enabled), depending on your
topology.

Enabling a port for dynamic joins
You can configure a port to dynamically join a static VLAN. The join will occur if that port subsequently receives an
advertisement for the static VLAN. This is done by using the Auto and Learn options described in the table 
Controlling VLAN behavior on ports with static VLANs.

Parameters for controlling VLAN propagation behavior
You can configure an individual port to actively or passively participate in dynamic VLAN propagation or to ignore
dynamic VLAN (GVRP) operation. These options are controlled by the GVRP "Unknown VLAN" and the static
VLAN configuration parameters, as described in the following table.
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Table 6: Controlling VLAN behavior on ports with static VLANs

Per-Port
"Unknown
VLAN" (GVRP)
configuration

Static VLAN Options—Per VLAN Specified on Each Port1

Port Activity: Tagged or
Untagged (Per VLAN)2

Port Activity: Auto2 (Per
VLAN)

Port Activity: Forbid (Per
VLAN)2

Learn (the
Default)

The port:

• Belongs to specified
VLAN.

• Advertises specified
VLAN.

• Can become a member of
dynamic VLANs for which
it receives advertisements.

• Advertises dynamic
VLANs that have at least
one other port (on the
same switch) as a
member.

The port:

• Will become a member of
specified VLAN if it
receives advertisements
for specified VLAN from
another device.

• Will advertise specified
VLAN.

• Can become a member of
other, dynamic VLANs for
which it receives
advertisements.

• Will advertise a dynamic
VLAN that has at least
one other port (on the
same switch) as a
member.

The port:

• Will not become a member
of the specified VLAN.

• Will not advertise specified
VLAN.

• Can become a member of
other dynamic VLANs for
which it receives
advertisements.

• Will advertise a dynamic
VLAN that has at least one
other port on the same
switch as a member.

Block The port:

• Belongs to the specified
VLAN.

• Advertises this VLAN.

• Will not become a member
of new dynamic VLANs for
which it receives
advertisements.

• Will advertise dynamic
VLANs that have at least
one other port as a
member.

The port:

• Will become a member of
specified VLAN if it
receives advertisements
for this VLAN.

• Will advertise this VLAN.

• Will not become a
member of new dynamic
VLANs for which it
receives advertisements.

• Will advertise dynamic
VLANs that have at least
one other port (on the
same switch) as a
member.

The port:

• Will not become a member
of this VLAN.

• Will ignore GVRP PDUs.

• Will not join any dynamic
VLANs.

• Will not advertise VLANs.

Disable The port:

• Is a member of the
specified VLAN.

• Will ignore GVRP PDUs.

The port:

• Will not become a
member of the specified
VLAN.

• Will ignore GVRP PDUs.

The port:

• Will not become a member
of this VLAN.

• Will ignore GVRP PDUs.
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Per-Port
"Unknown
VLAN" (GVRP)
configuration

Static VLAN Options—Per VLAN Specified on Each Port1

Port Activity: Tagged or
Untagged (Per VLAN)2

Port Activity: Auto2 (Per
VLAN)

Port Activity: Forbid (Per
VLAN)2

• Will not join any advertised
VLANs.

• Will not advertise VLANs.

• Will not join any dynamic
VLANs.

• Will not advertise VLANs.

• Will not join any dynamic
VLANs.

• Will not advertise VLANs.

1Each port of the switch must be a Tagged or Untagged member of at least one VLAN. Thus, any port configured
for GVRP to Learn or Block will generate and forward advertisements for static VLAN(s) configured on the switch
and also for dynamic VLANs the switch learns on other ports.
2To configure tagging, Auto, or Forbid, see Configuring or changing static VLAN per-port settings (CLI) on
page 36.

As the preceding table indicates, when you enable GVRP, a port that has a Tagged or Untagged static VLAN has
the option for both generating advertisements and dynamically joining other VLANs.

NOTE: In the table above, the Unknown VLAN parameters are configured on a per-port basis using
the CLI. The Tagged, Untagged, Auto, and Forbid options are configured per static VLAN on every
port.

Because dynamic VLANs operate as Tagged VLANs and because a tagged port on one device
cannot communicate with an untagged port on another device, Hewlett Packard Enterprise
recommends that you use Tagged VLANs for the static VLANs you will use to generate
advertisements.

GVRP and VLAN access control
Enabling GVRP allows a port to advertise and join dynamic VLANs. If a port has not received an advertisement
for an existing dynamic VLAN during the time-to-live (10 seconds), the port removes itself from that dynamic
VLAN.

Advertisements and dynamic joins
When you enable GVRP on a switch, the default GVRP parameter settings allow all of the switch's ports to
transmit and receive dynamic VLAN advertisements (GVRP advertisements) and to dynamically join VLANs.

Enabling GVRP:

• Allows a port to both advertise and join dynamic VLANs (Learn mode—the default).

• Allows a port to send VLAN advertisements, but not receive them from other devices; that is, the port cannot
dynamically join a VLAN but other devices can dynamically join the VLANs it advertises (Block mode).

• Prevents a port from participating in GVRP operation (Disable mode).

Port-Leave from a dynamic VLAN
A dynamic VLAN continues to exist on a port for as long as the port receives its advertisements from another
device connected to that port, or until:

• Converting the VLAN to a static VLAN

• Reconfiguring the port to Block or Disable
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• Disabling GVRP

• Rebooting the switch.

The time-to-live for dynamic VLANs is 10 seconds, if a port has not received an advertisement for an existing
dynamic VLAN during that time, the port removes itself from that dynamic VLAN.

Using GVRP
When GVRP is enabled on a switch, the VID for any static VLAN configured on the switch is advertised, using
BPDUs (Bridge Protocol Data Units), out all ports regardless of whether a port is up or assigned to any particular
VLAN. A GVRP-aware port on another device that receives the advertisements over a link can dynamically join
the advertised VLAN.

A dynamic VLAN (that is, a VLAN learned through GVRP) is tagged on the port on which it was learned. Also, a
GVRP-enabled port can forward an advertisement for a VLAN it learned about from other ports on the same
switch (internal source), but the forwarding port will not itself join that VLAN until an advertisement for that VLAN
is received through a link from another device (external source) on that specific port.

Figure 9: Forwarding advertisements and dynamic joining

If a static VLAN is configured on at least one switch port and that port has established a link with another device,
then all other ports of that switch will send advertisements for that VLAN.

NOTE:

A port can learn of a dynamic VLAN through devices that are not aware of GVRP. VLANs must be
disabled in GVRP-unaware devices to allow tagged packets to pass through.

Planning for GVRP operation
To set up dynamic VLANs for a segment:

Procedure

1. Determine the VLAN topology required for each segment (broadcast domain) on the network.

2. Determine which VLANs must be static and which can be dynamically propagated.
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3. Determine the devices on which static VLANs must be manually created to propagate VLANs throughout the
segment.

4. Determine security boundaries and how individual ports in the segment are to handle dynamic VLAN
advertisements (see Options for handling unknown VLAN advertisements and Controlling VLAN
behavior on ports with static VLANs).

5. Enable GVRP on all devices to be used with dynamic VLANs and configure the appropriate "Unknown VLAN"
parameter (Learn, Block, or Disable) for each port.

6. Configure static VLANs on the switches, where needed, with their per-VLAN parameters (Tagged, Untagged,
Auto, and Forbid—see Options for handling unknown VLAN advertisements and Controlling VLAN
behavior on ports with static VLANs) on each port.

7. Dynamic VLANs will then appear automatically, according to the chosen configuration options.

8. Convert dynamic VLANs to static VLANs, where dynamic VLANs are to become permanent.

Displaying switch current GVRP configuration (CLI)
Syntax:

show gvrp
Shows GVRP status (enabled or disabled), current maximum number of VLANs supported and the current
Primary VLAN.

Displaying GVRP status with GVRP disabled

switch(config)# show gvrp

GVRP support

 Maximum VLANs to support [256] : 256
 Primary VLAN : DEFAULT_VLAN
 GVRP Enabled [No] : No

Displaying GVRP status with GVRP enabled

This example shows the output for the show gvrp command with GVRP enabled. It includes non-default settings
for the Unknown VLAN field for some ports (see Port number 3, 4, 5 below).

switch(config)# show gvrp
 
 GVRP support

  Maximum VLANs to support [256] : 256
  Primary VLAN : DEFAULT_VLAN 
  GVRP Enabled [No] : Yes

Port Type      | Unknown VLAN Join  Leave Leaveall
---- --------- + ------------ ----- ----- --------
1    10/100TX  | Learn       20     300   1000
2    10/100TX  | Learn       20     300   1000
3    10/100TX  | Block       20     300   1000
4    10/100TX  | Disable     20     300   1000
5    10/100TX  | Disable     20     300   1000
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6    10/100TX  | Learn       20     300   1000
7    10/100TX  | Learn       20     300   1000

Displaying switch current GVRP configuration (CLI)
Syntax:

show gvrp
Shows GVRP status (enabled or disabled), current maximum number of VLANs supported and the current
Primary VLAN.

Displaying GVRP status with GVRP disabled

switch(config)# show gvrp

GVRP support

 Maximum VLANs to support [256] : 256
 Primary VLAN : DEFAULT_VLAN
 GVRP Enabled [No] : No

Displaying GVRP status with GVRP enabled

This example shows the output for the show gvrp command with GVRP enabled. It includes non-default settings
for the Unknown VLAN field for some ports (see Port number 3, 4, 5 below).

switch(config)# show gvrp
 
 GVRP support

  Maximum VLANs to support [256] : 256
  Primary VLAN : DEFAULT_VLAN 
  GVRP Enabled [No] : Yes

Port Type      | Unknown VLAN Join  Leave Leaveall
---- --------- + ------------ ----- ----- --------
1    10/100TX  | Learn       20     300   1000
2    10/100TX  | Learn       20     300   1000
3    10/100TX  | Block       20     300   1000
4    10/100TX  | Disable     20     300   1000
5    10/100TX  | Disable     20     300   1000
6    10/100TX  | Learn       20     300   1000
7    10/100TX  | Learn       20     300   1000

Enabling and disabling GVRP on the switch (CLI)
Syntax:

gvrp
Enables GVRP on the switch.

no gvrp
Disables GVRP on the switch.

Chapter 3 GVRP 73

Anexo 08 ITENS 8 E 9 (0592727)         SEI 0008478-63.2018.6.02.8000 / pg. 7677



NOTE:

GVRP can be enabled only if max-vlans is set to no more than 256 VLANs. While GVRP is
enabled on the switch, you cannot apply any ACLs to VLANs configured on the same switch. A
GVRP link can include intermediate devices that are not GVRP-aware. To understand and use
GVRP, you need a working knowledge of 802.1Q VLAN tagging. See 802.1Q VLAN tagging on
page 22.

GVRP assigns dynamic VLANs as Tagged VLANs. To configure the VLAN as Untagged, you must
first convert it to a static VLAN.

A VLAN enabled for jumbo traffic cannot be used to create a dynamic VLAN. A port belonging to a
statically configured, jumbo-enabled VLAN cannot join a dynamic VLAN.

Controlling how individual ports handle advertisements
for new VLANs (CLI)
When GVRP is enabled on the switch, use the unknown-vlans command to change the Unknown VLAN field
for one or more ports.

Syntax:

interface <port-list> unknown-vlans [learn | block | disable]
Changes the Unknown VLAN field to control how one or more ports handle advertisements. Use at either the
Manager or interface context level for a port.

Changing the Unknown VLANs field

In the following example, the first command changes the configuration to Block, the second command displays
the new configuration:

switch(config)# interface 1-2 unknown-vlans block

Switch(config)# show gvrp
 GVRP support
  Maximum VLANs to support [256] : 256
  Primary VLAN : DEFAULT_VLAN 
  GVRP Enabled [No] : Yes

  Port Type      | Unknown VLAN Join  Leave Leaveall
  ---- --------- + ------------ ----- ----- --------
  1    10/100TX  | Block        20    300   1000
  2    10/100TX  | Block        20    300   1000
  3    10/100TX  | Learn        20    300   1000
  4    10/100TX  | Learn        20    300   1000
When you enable GVRP on a switch, you have the per-port join-request options listed in the following table:
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Table 7: Options for handling unknown VLAN advertisements

Unknown VLAN Mode Operation

Learn
(the Default)

Enables the port to become a member of any unknown VLAN for which it
receives an advertisement. Allows the port to advertise other VLANs that have at
least one other port on the same switch as a member.

Block Prevents the port from joining any new dynamic VLANs for which it receives an
advertisement.Allows the port to advertise other VLANs that have at least one
other port as a member.

Disable Causes the port to ignore and drop all GVRP advertisements it receives and
prevents the port from sending any GVRP advertisements.

Listing static and dynamic VLANs on a GVRP-enabled
switch (CLI)
Syntax:

show vlans
Lists all VLANs present in the switch.

Using the show vlans command

In the following illustration, switch B has one static VLAN (the default VLAN), with GVRP enabled and port 1
configured to Learn for Unknown VLANs. Switch A has GVRP enabled and has three static VLANs: the default
VLAN, VLAN-222 and VLAN-333. In this scenario, switch B will dynamically join VLAN-222 and VLAN-333:

The show vlans command lists the dynamic (and static) VLANs in switch B after it has learned and joined
VLAN-222 and VLAN-333.

Switch-B> show vlans

 Status and Counters - VLAN Information

   VLAN support : Yes
   Maximum VLANs to support : 16
   Primary VLAN : DEFAULT_VLAN

   VLAN ID        NAME          Status
   -------------- ------------- ------
   1              DEFAULT_VLAN  Static
   222            GVRP_222      Dynamic
   333            GVRP_333      Dynamic     
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Converting a Dynamic VLAN to a Static VLAN (CLI)
If a port on the switch has joined a dynamic VLAN, you can use the following command to convert that dynamic
VLAN to a static VLAN:

static-vlan <dynamic-vlan-id>

Converting a dynamic VLAN 333 to a static VLAN

When converting a dynamic VLAN to a static VLAN as shown here, all ports on the switch are assigned to the
VLAN in Auto mode.

switch(config)# static-vlan 333
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Multiple VLAN Registration Protocol overview
Multiple VLAN Registration Protocol (MVRP) is a registration protocol defined by IEEE, which propagates VLAN
information dynamically across devices. It also enables devices to learn and automatically synchronize VLAN
configuration information, thereby reducing the configuration workload.

It is an enhanced version of GVRP and improves declaration efficiency. It allows a participant (port) to make or
withdraw declaration of attributes (VLANs). These declarations (or withdraws) are resulted in registration (or
removal of registrations) with other switches in the network.

Salient features

• Complaint as per IEEE 802.1Q-2011(Clause 11.2).

• Supports conversion of dynamic VLAN to static VLAN.

• Supports propagation of radius assigned dynamic VLANs.

• Supports immediate registration and propagation of VLAN attributes during spanning tree topology changes.

• Supports registrar’s administrative control values such as normal, fixed, and forbid.

• Supports MVRP objects on the following standard MIBs:
◦ IEEE8021-Q-BRIDGE-MIB (version 200810150000Z)

◦ IEEE8021-BRIDGE-MIB (version 200810150000Z)

NOTE: Supports other MVRP objects with the help of proprietary MIB, HPE-ICF-MVRP-
MIB(hpicfMvrp.mib).

• Supports on both physical and LAG ports, which include the manual (trunk), static lacp, and dynamic lacp
trunks.

• Supports High Availability hitless.

• Supports configuring MVRP using CLI and SNMP commands.

• Supports configurable timers — Join, Leave, Leave-All, and Periodic.

• Supports fast logging for important MVRP events and error conditions.

• Supports debug logging for all MVRP enabled ports.

• MVRP can be used to manage VLANs on dynamic trunk.

MVRP operating notes
MVRP is an enhanced version of Generic Attribute Registration Protocol (GARP). It is a generic registration
framework defined by the IEEE 802.1ak amendment to the IEEE 802.1Q standard. As GVRP, the same rules for
dynamic propagation and registration of VLANs is also applicable for MVRP on Aruba switches.

• A dynamic VLAN must be converted to a static VLAN before it can have an IP address.

• On the switches covered in this guide, MVRP can be enabled only if max-vlans is not more than 512 VLANs.

Chapter 4
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• The total number of VLANs on the switch (static and dynamic combined) cannot exceed the current maximum
VLANs setting. For example, in the factory default state, the switch supports up to 256 VLANs. Any additional
VLANs advertised to the switch are not added unless you increase the maximum VLANs setting.

• Converting a dynamic VLAN to a static VLAN and then executing the write memory command saves the
VLAN in the startup-config file and makes it a permanent part of the switch's VLAN configuration.

• When you enable MVRP globally, it is enabled by default on dynamic trunks. Based on your requirement, you
can disable MVRP on dynamic trunks. You cannot modify any other MVRP port parameters.

• Within the same broadcast domain, a dynamic VLAN can pass through a device that is not MVRP-aware. This
is because a half-duplex repeater or a switch that is not MVRP-aware floods the MVRP (multicast)
advertisement packets out of all ports.

• Rebooting a switch on which a dynamic VLAN exists deletes the VLAN. However, the dynamic VLAN
reappears after the reboot, if MVRP is enabled. The switch again receives advertisement for the particular
VLAN through a port configured to add dynamic VLANs.

• By receiving advertisements from other devices running MVRP, the switch learns of static VLANs on those
devices and dynamically (automatically) creates tagged VLANs on the links to the advertising devices.
Similarly, the switch advertises its static VLANs and the dynamic VLANs to other MVRP-aware devices, which
the switch has learnt.

• An MVRP enabled switch does not advertise any MVRP learned VLANs out of the ports (on which it originally
learned of those VLANs), until it is dynamically learnt on at least two ports.

• While MVRP is enabled on the switch, you cannot apply any ACLs to VLANs configured on the same switch.

Listing static and dynamic VLANs on an MVRP-enabled
switch
Syntax
show vlan
Description

Displays both static and dynamic VLANs in the switch.

Example output

switch(config)# show vlan

Status and Counters - VLAN Information

  Maximum VLANs to support : 256
  Primary VLAN : DEFAULT_VLAN
  Management VLAN :

  VLAN ID Name                             | Status     Voice Jumbo
  ------- -------------------------------- + ---------- ----- -----
  1       DEFAULT_VLAN                     | Port-based No    No
  40      MVRP_40                          | Dynamic

Converting a dynamic VLAN to a static VLAN
Syntax
static-vlan <dynamic-vlan-id>
Description
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If a port on the switch has joined a dynamic VLAN, use the command to convert dynamic VLAN to static VLANs in
the switch.

Example output

switch(config)# static-vlan 40
switch(config)# show vlan

Status and Counters - VLAN Information

  Maximum VLANs to support : 256
  Primary VLAN : DEFAULT_VLAN
  Management VLAN :

  VLAN ID Name                             | Status     Voice Jumbo
  ------- -------------------------------- + ---------- ----- -----
  1       DEFAULT_VLAN                     | Port-based No    No
  40      VLAN40                           | Port-based No    No

Viewing the current MVRP configuration on a switch

show mvrp
Syntax
show mvrp [config|state|statistics]
Description

Displays the MVRP settings and status.

Example output

switch# show mvrp
 config                Show the MVRP configuration for all ports.
 state                 Show the MVRP state.
 statistics            Show MVRP statistics.

show mvrp config
Syntax
show mvrp config
Description

Displays the MVRP configuration for all ports.

Example output

switch# show mvrp config

 Configuration and Status - MVRP

 Global MVRP status : Disabled

 Port     Status   Periodic Registration Join  Leave    LeaveAll Periodic
                   Timer    Type         Time  Timer    Timer    Timer
 -------  -------- -------- ------------ ----  -------- -------- --------
 1        Disabled Enabled  Normal       20    300      1000     100
 2        Disabled Enabled  Normal       20    300      1000     100
 3        Disabled Enabled  Normal       20    300      1000     100
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show mvrp state
Syntax
show mvrp state <VLAN-ID> [<PORT-NUM>]
Description

Displays the MVRP state.

Parameters
<VLAN-ID>

Specify the MVRP state for VLAN ID.

<PORT-NUM>

Specify the port number to display the MVRP state.

Example output

switch(config)# show mvrp state
 VLAN-ID               Enter a VLAN identifier or the VLAN name if configured.
switch(config)# show mvrp state 1
 [ethernet] PORT-NUM
switch(config)# show mvrp state 1

 Configuration and Status - MVRP state for VLAN 1

 Port     VLAN  Registrar Applicant Forbid
                State     State     Mode
 -------- ----- --------- --------- ---------
 1        1     MT        QA        No

show mvrp statistics
Syntax
show MVRP statistics [<PORT-LIST>]
Description

Displays the MVRP statistics.

Parameter
PORT-LIST
Displays the MVRP statistics at the specified port.

Example output

switch(config)# show mvrp statistics

Status and Counters - MVRP

  MVRP statistics for port  : A1
  ----------------------------
  Failed registration    : 0
  Last PDU origin        : 40a8f0-9e11ff
  Total PDU Transmitted  : 53
  Total PDU Received     : 72
  Frames Discarded       : 0

  Message type  Transmitted     Received
-------------- ------------    ------------
  New           0               0
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  Empty         16466           258
  In            4               0
  Join Empty    0               72
  Join In       53              55
  Leave         0               0
  Leaveall      4               2

clear mvrp statistics
Syntax
clear mvrp statistics [<PORT-LIST>]
Description

Clears the statistics for MVRP on a port or all ports.

Parameters
PORT-LIST
Specify a port number or list of ports or all ports.

Example output

switch# clear mvrp statistics
 [ethernet] PORT-LIST  Enter a port number, a list of ports or 'all' for all ports.
switch# clear mvrp statistics all

debug mvrp
Syntax
debug mvrp {all | event| packet | state-machine | timer} [<PORT-LIST>]
Description

Enables debug messages.

Parameters
all
Display all MVRP debug messages.

event
Display all MVRP event messages.

packet
Display all MVRP packet messages.

state-machine
Display all MVRP state-machine messages.

timer
Display all MVRP timer messages.

PORT-LIST
Display all MVRP debug messages for a port.

Example output

switch(config)# debug mvrp all
switch(config)# show debug
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Debug Logging

  Source IP Selection: Outgoing Interface
  Origin identifier: Outgoing Interface IP
  Destination: None

  Enabled debug types:
   mvrp event include port A1-A24,F1-F24
   mvrp packet include port A1-A24,F1-F24
   mvrp state-machine include port A1-A24,F1-F24
   mvrp timer include port A1-A24,F1-F24

Configuring MVRP
Enabling MVRP globally
MVRP must be enabled globally to allow the device to participate in the protocol.

Syntax
mvrp {enable | disable}
no mvrp
Description

Enables MVRP globally on a switch. MVRP must be enabled globally and at least on one interface. The no form
of the command disables MVRP.

Parameters
enable
Enable MVRP.

disable
Disable MVRP.

Example output

switch# show mvrp config

 Configuration and Status - MVRP

 Global MVRP status : Enabled

 Port     Status   Periodic Registration Join  Leave    LeaveAll Periodic
                   Timer    Type         Time  Timer    Timer    Timer
 -------  -------- -------- ------------ ----  -------- -------- --------
 1        Disabled Enabled  Normal       20    300      1000     100
 2        Disabled Enabled  Normal       20    300      1000     100

Enabling MVRP on an interface
By default, MVRP is disabled on all interfaces.

Syntax
mvrp {enable | disable}
no mvrp
Description

Enables MVRP on an interface. MVRP must be enabled globally and at least on one interface.
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Use no mvrp to disable MVRP.

Parameters
enable
Enable mvrp
disable
Disable mvrp
Example output

switch(config)# mvrp
disable               Disable MVRP.
enable                Enable MVRP.
switch(config)# mvrp enable
switch(config)# interface 1
switch(eth-1)# mvrp enable
switch(eth-1)# show mvrp config

 Configuration and Status - MVRP

 Global MVRP status : Enabled

 Port     Status   Periodic Registration Join  Leave    LeaveAll Periodic
                   Timer    Type         Time  Timer    Timer    Timer
 -------  -------- -------- ------------ ----  -------- -------- --------
 1        Enabled  Enabled  Normal       20    300      1000     100
 2        Disabled Enabled  Normal       20    300      1000     100

MVRP timers
MVRP supports four types of timers:

• Join Timer

• Leave Timer

• LeaveAll Timer

• Periodic Timer

Join Timer
The Join Timer controls the transmission of Join messages. To avoid a PDU storm, an MVRP participant waits for
a duration of the Join Timer after sending a join message, and ensures that all participants transmit at different
times. This is a per port timer and is applicable to all applicants for the port.

mvrp join-timer
Syntax
mvrp join-timer <centiseconds>
no mvrp join-timer
Description

Sets the Join Timer for the port. You can use the timer to space MVRP join messages. To ensure that join
messages are transmitted to other participants, an MVRP participant waits for a specified time before sending a
join message. The Join Timer must be less than half of the Leave Timer. The default value is 20 centiseconds.

Use no mvrp join-timer to set the interval to the default value.
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Parameters
centiseconds
Set the Join Timer for the port.

Usage
mvrp join-timer <20-100>
The MVRP Join Timer ranges from 20 –100 in centiseconds.

Example output

switch(eth-1)# mvrp join-timer
<20-100>              Set the join timer for the port.
switch# mvrp join-timer 40
switch# show mvrp config

 Configuration and Status - MVRP

 Global MVRP status : Enabled

 Port     Status   Periodic Registration Join  Leave    LeaveAll Periodic
                   Timer    Type         Time  Timer    Timer    Timer
 -------  -------- -------- ------------ ----  -------- -------- --------
 1        Enabled  Enabled  Normal       40    300      1000     100
 2        Disabled Enabled  Normal       20    300      1000     100
 3        Disabled Enabled  Normal       20    300      1000     100

Leave Timer
The Leave Timer controls the time duration for which the Registrar state machine waits in the LV state before
changing to the MT state. The Leave Timer is started only when a leave message is received by the applicant
state. The attribute is deregistered, if there are requests to join before the expiry of the Leave Timer. This is a per
port timer and is applicable to all registrars for the port.

mvrp leave-timer
Syntax
mvrp leave-timer <centiseconds>
no mvrp leave-timer
Description

The Leave Timer must be at least twice the Join Timer and must be less than the LeaveAll Timer. The default
value is 300 centiseconds.

Use no mvrp leave-timer to set the interval to the default value.

Parameter
centiseconds
Set the Leave Timer for the port.

Usage
mvrp leave-timer <40-1000000>
The MVRP Leave Timer ranges from 40 –1000000 in centiseconds.

Example output

switch(eth-1)# mvrp leave-timer
<40-1000000>          Set the leave timer for the port.
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switch(eth-1)# mvrp leave-timer 500
switch(eth-1)# show mvrp config

 Configuration and Status - MVRP

 Global MVRP status : Enabled

 Port     Status   Periodic Registration Join  Leave    LeaveAll Periodic
                   Timer    Type         Time  Timer    Timer    Timer
 -------  -------- -------- ------------ ----  -------- -------- --------
 1        Enabled  Enabled  Normal       40    500      1000     100
 2        Disabled Enabled  Normal       20    300      1000     100
 3        Disabled Enabled  Normal       20    300      1000     100

LeaveAll Timer
The LeaveAll Timer controls the frequency with which the LeaveAll state machine generates LeaveAll PDUs.
When a LeaveAll Timer expires, the MVRP sends out LeaveAll messages and restarts the LeaveAll Timer. The
LeaveAll Timer is set to a random value T which ranges from LeaveAllTime < T < 1.5*LeaveAllTime,
where LeaveAll time is the configured LeaveAll time. The default value is 1000 centiseconds. This is a per port
timer.

mvrp leaveall-timer
Syntax
mvrp leaveall-timer <centiseconds>
no mvrp leaveall-timer
Description

The LeaveAll Timer is the time duration between sending LeaveAll messages. The LeaveAll Timer must be
greater than the Leave Timer.

Use no mvrp leaveall-timer to set the interval to the default value.

Parameter
centiseconds
Set the LeaveAll Timer for the port.

Usage
mvrp leaveall-timer <500-1000000>
The MVRP LeaveAll Timer ranges from 500 –1000000 in centiseconds.

Example output

switch# mvrp leaveall-timer
<500-1000000> Set the leaveall timer for the port.
switch# mvrp leaveall-timer 700
switch(eth-1)# show mvrp config

 Configuration and Status - MVRP

 Global MVRP status : Enabled

 Port     Status   Periodic Registration Join  Leave    LeaveAll Periodic
                   Timer    Type         Time  Timer    Timer    Timer
 -------  -------- -------- ------------ ----  -------- -------- --------
 1        Enabled  Enabled  Normal       40    500      700      100
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 2        Disabled Enabled  Normal       20    300      1000     100
 3        Disabled Enabled  Normal       20    300      1000     100

Periodic Timer
The Periodic Timer controls the frequency with which the periodic transmission state machine generates periodic
events. This is a per port timer. On start, the Periodic Timer is set to one second. You can enable or disable the
Periodic Timer. By default, it is enabled. The default value is 100 centiseconds.

mvrp periodic timer
Syntax
mvrp periodic-timer <centiseconds>
no mvrp periodic-timer
Description

Set the Periodic Timer transmission interval for the port.

Use no mvrp periodic-timer to set the interval to the default value.

Parameters
centiseconds
Set the Periodic Timer transmission interval for the port.

Usage
mvrp periodic-timer <100-1000000>
The MVRP Periodic Timer ranges from 100 –1000000 in centiseconds.

Example output

switch(eth-1)# mvrp periodic-timer
<100-1000000>         Set the periodic timer transmission interval for the port.
switch(eth-1)# mvrp periodic-timer 300
switch(eth-1)# show mvrp config

 Configuration and Status - MVRP

 Global MVRP status : Enabled

 Port     Status   Periodic Registration Join  Leave    LeaveAll Periodic
                   Timer    Type         Time  Timer    Timer    Timer
 -------  -------- -------- ------------ ----  -------- -------- --------
 1        Enabled  Enabled  Normal       40    500      700      300
 2        Disabled Enabled  Normal       20    300      1000     100
 3        Disabled Enabled  Normal       20    300      1000     100

mvrp periodic-timer-enable
Syntax
mvrp periodic-timer-enable
no mvrp periodic-timer-enable
Description

Enable Periodic Timer transmission for the port. By default, it is enabled.

Use no mvrp periodic-timer-enable to disable the Periodic Timer on an interface.
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MVRP registration modes
MVRP supports three registration modes:

• Normal

In this mode, a port can register and deregister dynamic VLANs. By default, the registrar mode is normal.

• Fixed

In this mode, a port cannot register or deregister dynamic VLANs. However, if a static VLAN exists in the
system, the port changes to registered state on receipt of join message.

• Forbidden

In this mode, a port does not register dynamic VLANs, ignores all MRP messages, and remains in MT state
(unregistered).

mvrp registration
Syntax
mvrp registration {normal |fixed}
Description

Configures the port response to MRP messages.

Parameters
normal
Port response is normal for the incoming MRP messages.

fixed
Ignores the MRP messages and remains registered.

Example output

switch# mvrp registration
 fixed                 The port ignores all MRP messages and remains registered.
 normal                The port responds normally to incoming MRP messages.

switch(config)# interface A1 mvrp registration fixed
switch(config)# show mvrp config

Configuration and Status - MVRP

Global MVRP status : Enabled

Port     Status   Periodic Registration Join  Leave    LeaveAll Periodic
                   Timer    Type         Time  Timer    Timer    Timer
-------  -------- -------- ------------ ----  -------- -------- --------
A1       Enabled  Enabled  Fixed        20    300      1000     100
A2       Disabled Enabled  Normal       20    300      1000     100
A3       Disabled Enabled  Normal       20    300      1000     100

show tech mvrp
Syntax
show tech mvrp
Description
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Displays statistics of all the MVRP enabled ports.

Example output

switch# show tech mvrp

show mvrp statistics

Status and Counters - MVRP

  MVRP statistics for port  : A1
  ----------------------------
  Failed registration    : 0
  Last PDU origin        : 40a8f0-9e11ff
  Total PDU Transmitted  : 620
  Total PDU Received     : 755
  Frames Discarded       : 0

  Message type  Transmitted     Received
-------------- ------------    ------------
  New           0               0
  Empty         117370          2506
  In            17              0
  Join Empty    1               519
  Join In       658             697
  Leave         0               0
  Leaveall      28              37

mvrpDumpGlobalData

MVRP global enabled status    : enabled
MVRP enabled ports            : A1
Total MVRP enabled ports      : 1
Dyn trunk auto disable count  : 0
Total Static VLANs in system  : 1
Total Dynamic VLANs in system : 1
Max VLANs supported           : 512

Display VLAN_GROUP to VLANs Mapping:

Group ID      Mapped VLANs
----------    ----------------
       0      1-4094

Display timer Ports:

Group ID     Timer Value
----------   -------------

Display Blocked Ports:

Group ID     Blocked Ports
----------   ---------------

mvrppconfig

Mvrp Port state info:

Port   MvrpState   LinkState   Registrar   Value
-----   ---------   ---------   ---------   -----
   A1      Enable          Up      Normal   0X05
   A2     Disable          Up      Normal   0X04
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   A3     Disable        Down      Normal   0000
   A4     Disable        Down      Normal   0000
   A5     Disable        Down      Normal   0000
   A6     Disable        Down      Normal   0000
   A7     Disable        Down      Normal   0000
   A8     Disable        Down      Normal   0000
   A9     Disable        Down      Normal   0000
  A10     Disable        Down      Normal   0000
  A11     Disable        Down      Normal   0000
  A12     Disable        Down      Normal   0000
  A13     Disable        Down      Normal   0000
  A14     Disable        Down      Normal   0000
  A15     Disable        Down      Normal   0000
  A16     Disable        Down      Normal   0000
  A17     Disable        Down      Normal   0000
  A18     Disable        Down      Normal   0000
  A19     Disable        Down      Normal   0000
  A20     Disable        Down      Normal   0000
  A21     Disable        Down      Normal   0000
  A22     Disable        Down      Normal   0000
  A23     Disable        Down      Normal   0000
  A24     Disable        Down      Normal   0000
   F1     Disable        Down      Normal   0000
   F2     Disable        Down      Normal   0000
   F3     Disable        Down      Normal   0000
   F4     Disable        Down      Normal   0000
   F5     Disable        Down      Normal   0000
   F6     Disable        Down      Normal   0000
   F7     Disable        Down      Normal   0000
   F8     Disable        Down      Normal   0000
   F9     Disable        Down      Normal   0000
  F10     Disable        Down      Normal   0000
  F11     Disable        Down      Normal   0000
  F12     Disable        Down      Normal   0000
  F13     Disable        Down      Normal   0000
  F14     Disable        Down      Normal   0000
  F15     Disable        Down      Normal   0000
  F16     Disable        Down      Normal   0000
  F17     Disable        Down      Normal   0000
  F18     Disable        Down      Normal   0000
  F19     Disable        Down      Normal   0000
  F20     Disable        Down      Normal   0000
  F21     Disable          Up      Normal   0X04
  F22     Disable          Up      Normal   0X04
  F23     Disable        Down      Normal   0000
  F24     Disable        Down      Normal   0000

Mvrp Port timer values:

Port  join  leave  leaveall  periodic  periodic-enabled
-----  ----  -----  --------  --------  ----------------
   A1    20    300      1000       100          enabled
   A2    20    300      1000       100          enabled
   A3    20    300      1000       100          enabled
   A4    20    300      1000       100          enabled
   A5    20    300      1000       100          enabled
   A6    20    300      1000       100          enabled
   A7    20    300      1000       100          enabled
   A8    20    300      1000       100          enabled
   A9    20    300      1000       100          enabled
  A10    20    300      1000       100          enabled
  A11    20    300      1000       100          enabled
  A12    20    300      1000       100          enabled
  A13    20    300      1000       100          enabled
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  A14    20    300      1000       100          enabled
  A15    20    300      1000       100          enabled
  A16    20    300      1000       100          enabled
  A17    20    300      1000       100          enabled
  A18    20    300      1000       100          enabled
  A19    20    300      1000       100          enabled
  A20    20    300      1000       100          enabled
  A21    20    300      1000       100          enabled
  A22    20    300      1000       100          enabled
  A23    20    300      1000       100          enabled
  A24    20    300      1000       100          enabled
   F1    20    300      1000       100          enabled
   F2    20    300      1000       100          enabled
   F3    20    300      1000       100          enabled
   F4    20    300      1000       100          enabled
   F5    20    300      1000       100          enabled
   F6    20    300      1000       100          enabled
   F7    20    300      1000       100          enabled
   F8    20    300      1000       100          enabled
   F9    20    300      1000       100          enabled
  F10    20    300      1000       100          enabled
  F11    20    300      1000       100          enabled
  F12    20    300      1000       100          enabled
  F13    20    300      1000       100          enabled
  F14    20    300      1000       100          enabled
  F15    20    300      1000       100          enabled
  F16    20    300      1000       100          enabled
  F17    20    300      1000       100          enabled
  F18    20    300      1000       100          enabled
  F19    20    300      1000       100          enabled
  F20    20    300      1000       100          enabled
  F21    20    300      1000       100          enabled
  F22    20    300      1000       100          enabled
  F23    20    300      1000       100          enabled
  F24    20    300      1000       100          enabled

mvrpmapringShow

Mvrp list info:
-------------------------
Port A1    : connected

Mvrp Map Count Info:

Vlan   Vid    Reg-Count
-----  -----  ----------
1      1      1
2      40     1

=== The command has completed successfully. ===

MVRP limitations
• MVRP and GVRP are mutually exclusive, and cannot coexist.

• MVRP and Smartlink are mutually exclusive. Smartlinks can be enabled on ports, which are not MVRP
enabled and vice versa.

• MVRP and PVST are mutually exclusive. When MVRP is globally enabled, spanning tree mode cannot be set
as PVST and vice versa.

• MVRP can be enabled on a provider bridge environment, but does not support SVLAN ports in mixed mode
configuration.
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• MVRP can be used to manage VLANs on dynamic trunk.

• Enable aaa port-access gvrp-vlans to support RADIUS-assigned VLANs. When you enable aaa
port-access gvrp-vlans, dynamic VLANs created by MVRP or GVRP can be used for radius port
assignment.

• An OpenFlow member VLAN cannot be a dynamic VLAN. As a result, a dynamic VLAN must be converted to
static to be handled by the OpenFlow controller.

• For security purposes, MVRP is disabled by default. MVRP packets are blocked on MVRP disabled ports, but
can be enabled on ports which are security enabled.

• MVRP and private VLAN cannot coexist.

• DIPLDv6 cannot be configured on MVRP enabled ports.

• MVRP support is limited to 512 VLANs and 128 logical ports due to CPU and memory resource availability.

Table 8: MVRP supported ports

Platforms Maximum MVRP ports supported

Aruba 2920
Aruba 2930

128

Aruba 2530 24

Aruba 2540 54

Table 9: MVRP supported VLANs

Platforms Maximum VLANs Maximum MSTP
instance

Maximum ports

Aruba 2920
Aruba 2930

512 16 128

Aruba 2530 512 16 24

Aruba 2540 512 16 54

MVRP statistics
The MVRP statistics generated using show mvrp statistics, records any registration failures, tracks MAC
addresses to derive statistics.

• Registration failure

Maintains the count of registration requests received but failed due to MVRP limitation.

• Peer tracking

Records the MAC address of the MVRP PDU that has caused the recent state change for the registrar
machine. A maximum of one MAC address per port of the originator switch is stored.

• PDU event statistics
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Collects the data on numbers of events (join, leave, and so on) transmitted and received.

More Information

show mvrp statistics
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Overview of MSTP
Without spanning tree, having more than one active path between a pair of nodes causes loops in the network,
which can result in duplication of messages leading to a "broadcast storm" that can bring down the network.

NOTE: MSTP cannot protect against loops when there is an unmanaged device on the network that
drops spanning tree packets, or may fail to detect loops where this is an edge port configured with
client authentication (802.1X, Web and MAC authentication). To protect against the formation of
loops in these cases, you can use the loop protection feature.

Multiple-Instance spanning tree operation (802.1s) ensures that only one active path exists between any two
nodes in a spanning tree instance. A spanning tree instance comprises a unique set of VLANs, and belongs to a
specific spanning tree region. A region can comprise multiple spanning tree instances (each with a different set of
VLANs), and allows one active path among regions in a network. Applying VLAN tagging to the ports in a
multiple-instance spanning tree network enables blocking of redundant links in one instance while allowing
forwarding over the same links for non-redundant use by another instance.

VLAN/Instance groupings

Suppose that there are three switches in a region configured with VLANs grouped into two instances, as follows:

VLANs Instance 1 Instance 2

10, 11, 12 Yes No

20, 21, 22 No Yes

The logical and physical topologies resulting from these VLAN/Instance groupings result in blocking on different
links for different VLANs:

Chapter 5
Multiple instance spanning tree operation
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A multiple spanning tree application
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MSTP structure
MSTP maps active, separate paths through separate spanning tree instances and between MST regions. Each
MST region comprises one or more MSTP switches. Note that MSTP recognizes an STP or RSTP LAN as a
distinct spanning tree region.

Figure 10: An MSTP network with legacy STP and RSTP devices connected

How MSTP operates
In the factory default configuration, spanning tree operation is off. Also, the switch retains its currently configured
spanning tree parameter settings when disabled. Thus, if you disable spanning tree, then later re-enable it, the
parameter settings will be the same as before spanning tree was disabled. The switch also includes a pending
feature that enables you to exchange MSTP configurations with a single command.

NOTE:

The switch automatically senses port identity and type, and automatically defines spanning tree
parameters for each type, and parameters that apply across the switch. Although these parameters
can be adjusted, HPE strongly recommends leaving these settings in their default configurations
unless the proposed changes have been supplied by an experienced network administrator who has
a strong understanding of the IEEE 802.1D/w/s standards and operation.

802.1s Multiple Spanning Tree Protocol (MSTP)
The switches covered in this guide use the IEEE 802.1s Multiple Spanning Tree Protocol (MSTP) standard.

The 802.1D and 802.1w spanning tree protocols operate without regard to a network's VLAN configuration, and
maintain one common spanning tree throughout a bridged network. Thus, these protocols map one loop-free,
logical topology on a given physical topology. The 802.1s Multiple Spanning Tree protocol (MSTP) uses VLANs to
create multiple spanning trees in a network, which significantly improves network resource utilization while
maintaining a loop-free environment.
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While the per-VLAN spanning tree approach adopted by some vendors overcomes the network utilization
problems inherent in using STP or RSTP, using a per-VLAN technology with multiple VLANs can overload the
switch's CPU. MSTP on the switches covered in this guide complies with the IEEE 802.1s standard, and extends
STP and RSTP functionality to map multiple independent spanning tree instances onto a physical topology. With
MSTP, each spanning tree instance can include one or more VLANs and applies a separate, per-instance
forwarding topology. Thus, where a port belongs to multiple VLANs, it may be dynamically blocked in one
spanning tree instance, but forwarding in another instance. This achieves load-balancing across the network while
keeping the switch's CPU load at a moderate level (by aggregating multiple VLANs in a single spanning tree
instance). MSTP provides fault tolerance through rapid, automatic reconfiguration if there is a failure in a
network's physical topology.

With MSTP-capable switches, you can create a number of MST regions containing multiple spanning tree
instances. This requires the configuration of a number of MSTP-capable switches. However, it is not necessary to
do this. You can enable MSTP on an MSTP-capable switch and a spanning tree instance is created automatically.
This instance always exists by default when spanning tree is enabled, and is the spanning tree instance that
communicates with STP and RSTP environments. The MSTP configuration commands operate exactly like RSTP
commands and MSTP is backward-compatible with the RSTP-enabled and STP-enabled switches in your
network.

CAUTION:

Spanning tree interprets a switch mesh as a single link. Because the switch automatically gives
faster links a higher priority, the default MSTP parameter settings are usually adequate for spanning
tree operation. Because incorrect MSTP settings can adversely affect network performance, do not
change the MSTP settings from their default values unless you have a strong understanding of how
spanning tree operates.

In a mesh environment, the default MSTP timer settings (Hello Time and Forward Delay) are usually
adequate for MSTP operation. Because a packet crossing a mesh may traverse several links within the mesh,
using smaller-than-default settings for the MSTP Hello Time and Forward Delay timers can cause
unnecessary topology changes and end-node connectivity problems.

MST regions
All MSTP switches in a given region must be configured with the same VLANs, and each MSTP switch within the
same region must have the same VLAN-to-instance assignments. In addition, a VLAN can belong to only one
instance within any region. Within a region:

• All of the VLANs belonging to a given instance compose a single, active spanning tree topology for that
instance.

• Each instance operates independently of other regions.

Between regions, there is a single, active spanning tree topology.
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How separate instances affect MSTP
Assigning different groups of VLANs to different instances ensures that those VLAN groups use independent
forwarding paths. For example, in the following figure, each instance has a different forwarding path.

Figure 11: Active topologies built by three independent MST instances

While allowing only one active path through a given instance, MSTP retains any redundant physical paths in the
instance to serve as backups (blocked) paths in case the existing active path fails. Thus, if an active path in an
instance fails, MSTP automatically activates (unblocks) an available backup to serve as the new active path
through the instance for as long as the original active path is down. Note also that a given port may
simultaneously operate in different states (forwarding or blocking) for different spanning tree instances within the
same region. This depends on the VLAN memberships to which the port is assigned. For example, if a port
belongs to VLAN 1 in the IST instance of a region and also belongs to VLAN 4 in MSTI "x" in the same region, the
port may apply different states to traffic for these two different instances.

Within a region, traffic routed between VLANs in separate instances can take only one physical path. To ensure
that traffic in all VLANs within a region can travel between regions, all of the boundary ports for each region
should belong to all VLANs configured in the region. Otherwise, traffic from some areas within a region could be
blocked from moving to other regions.

All MSTP switches (including STP and RSTP switches) in a network use BPDUs (Bridge Protocol Data Units) to
exchange information from which to build multiple, active topologies in the individual instances within a region and
between regions. From this information:

• The MSTP switches in each LAN segment determine a designated bridge and designated port or trunk for the
segment.

• The MSTP switches belonging to a particular instance determine the root bridge and root port or trunk for the
instance.

• For the IST instance within a region, the MSTP switches linking that region to other regions (or to STP or
RSTP switches) determine the IST root bridge and IST root port or trunk for the region. (For any Multiple
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spanning tree instance—MSTI—in a region, the regional root may be a different switch that is not necessarily
connected to another region.)

• The MSTP switches block redundant links within each LAN segment, across all instances, and between
regions, to prevent any traffic loops.

As a result, each individual instance (spanning tree) within a region determines its regional root bridge,
designated bridges, and designated ports or trunks.

Regions, legacy STP and RSTP switches, and the Common Spanning Tree
(CST)
The IST instance and any MST instances in a region exist only within that region. Where a link crosses a
boundary between regions (or between a region and a legacy STP or RSTP switch), traffic is forwarded or
blocked as determined by the Common Spanning Tree (CST). The CST ensures that there is only one active path
between any two regions, or between a region and a switch running STP and RSTP. (See the figure in MSTP
structure on page 95.)

MSTP operation with 802.1Q VLANs
As indicated in the preceding sections, within a given MST instance, a single spanning tree is configured for all
VLANs included in that instance. This means that if redundant physical links exist in separate VLANs within the
same instance, MSTP blocks all but one of those links. However, you can prevent the bandwidth loss caused by
blocked redundant links for different VLANs in an instance by using a port trunk. The following example shows
how you can use a port trunk with 802.1Q (tagged) VLANs and MSTP without unnecessarily blocking any links or
losing any bandwidth.

Using a trunked link to support multiple VLAN connectivity within the same MST instance

NOTE:

All switches in a region should be configured with the VLANs used in that region, and all ports linking
MSTP switches together should be members of all VLANs in the region. Otherwise, the path to the
root for a given VLAN will be broken if MSTP selects a spanning tree through a link that does not
include that VLAN.
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MSTP compatibility with RSTP or STP
IEEE 802.1s MSTP includes RSTP functionality and is designed to be compatible with both IEEE 802.1D and
802.1w spanning tree protocols. Using the default configuration values, your switches will interoperate effectively
with RSTP and STP devices. MSTP automatically detects when the switch ports are connected to non-MSTP
devices in the spanning tree and communicates with those devices using 802.1D or 802.1w STP BPDU packets,
as appropriate.

To enable effective interoperation with STP (802.1D) configured devices, however, you may need to adjust the
default configuration values. Here are two such examples:

• The rapid state transitions employed by MSTP may result in an increase in the rates of frame duplication and
misordering in the switched LAN. To allow the switch to support applications and protocols that may be
sensitive to frame duplication and misordering, you can disable rapid transitions by setting the Force Protocol
Version parameter to STP-compatible. The value of this parameter applies to all ports on the switch.

• One of the benefits of MSTP is the implementation of a larger range of port path costs, which accommodates
higher network speeds. However, this can create some incompatibility between devices running the older
802.1D STP. You can adjust to this incompatibility by implementing the global spanning tree legacy-path cost
command.

RSTP and MSTP implement a greater range of path costs than 802.1D STP, and use different default path cost
values to account for higher network speeds. These values are shown in the following table.

Port type 802.1D STP
path cost

RSTP and
MSTP path
cost

10 Mbps 100 2 000 000

100 Mbps 10 200 000

1 Gbps 5 20 000

Because the maximum value for the path cost allowed by 802.1D STP is 65535, devices running that version of
spanning tree cannot be configured to match the values defined by MSTP, at least for 10 Mbps and 100 Mbps
ports. In LANs where there is a mix of devices running 802.1D STP, RSTP, and MSTPs, you should reconfigure
the devices so the path costs match for ports with the same network speeds.

Preconfiguring an MSTP regional topology
The MSTP VLAN configuration enhancement allows you to preconfigure an MSTP regional topology and ensure
that the same VLAN ID-to-MSTI assignments exist on each MSTP switch in the region.

CAUTION: When this software version is installed, the prior VLAN ID-to-MSTI mappings do not
change. However, this enhancement is not backward-compatible. If you install a software version
earlier than this version, and you have configured MSTI entries instances mapped to VLANs, they
will be removed from the configuration file when booting to the prior version of software. Do one of
the following to install or reload a prior version of the software:

• Remove all MSTP mappings from the configuration file, then reconfigure the instance mapping
after running the desired software version.

• Save the current configuration file before updating the software to a new version. If you later
reload this older version of the software, use this configuration file when you reload the older
version.
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The default behavior of the spanning-tree instance vlan command changes so that, before a static VLAN
is configured or a dynamic VLAN is learned on the switch, you can preconfigure its VLAN ID-to-MSTI mapping.
Later, when the VLAN is created, it is automatically assigned to the MSTI to which it was previously mapped.

By supporting preconfigured VLAN ID-to-MSTI topologies, the VLAN configuration enhancement provides the
following benefits:

• Scalability: In a network design in which you plan to use a large number of VLANs, you can preconfigure
identical VLAN ID-to-MSTI mappings on all switches in a single, campus-wide MST region, regardless of the
specific VLANs that you later configure on each switch. After the initial VLAN ID-to-MSTI mapping, you can
decide on the exact VLANs that you need on each switch.All switches in a region must be configured with the
same VLAN ID-to-MSTI mappings and the same MSTP configuration identifiers (region name and revision
number).

• Flexibility: By preconfiguring identical VLAN ID-to-MSTI mappings on all switches in an MST region, you can
combine switches that support different maximum numbers of VLANs.

• Network stability: You can reduce the interruptions in network connectivity caused by the regeneration of
spanning trees in the entire network each time a configuration change in VLAN-to-MSTI mapping is detected
on a switch. The negative impact on network performance is reduced if all newly created VLANs are pre-
mapped to the correct MST instances. Later, VLAN creation and deletion are ignored by MSTP and no
interruption in spanning tree traffic occurs.

• Usability: Dynamically learned GVRP VLANs can be mapped to MSTIs and support MSTP load balancing.

Preconfiguring VLANs in an MST instance
When configuring an MSTP regional topology, multiple spanning tree instances are created. Each MST instance
provides a fully connected active topology for a particular set of VLANs.

Each switch in an MSTP region is configured with the following set of common parameters:

• Region name (spanning-tree config-name)

• Region revision number (spanning-tree config-revision)

• Identical VLAN ID-to-MSTI mapping (spanning-tree instance vlan)

Syntax:
spanning-tree instance 1..16 vlan vid [vid..vid]
no spanning-tree instance 1..16 vlan vid [vid..vid]
Configuring MSTP on the switch automatically configures the IST instance and places all statically and
dynamically configured VLANs on the switch into the IST instance. This command creates a new MST instance
(MSTI) and moves the VLANs specified from the IST to the MSTI.

You must map at least one VLAN to an MSTI when you create it. You cannot map a VLAN ID to more than one
instance. You can create up to 16 MSTIs in a region.

The no form of the command removes one or more VLANs from the specified MSTI. If no VLANs are specified,
the no form of the command deletes the specified MSTI.

When removing a VLAN from an MSTI, the VLAN returns to the IST instance, where it remains or is re-assigned
to another MSTI configured in the region.

NOTE: The valid VLAN IDs to map to a specified MSTI are from 1 to 4094. The VLAN ID-to-MSTI
mapping does not require a VLAN to be already configured on the switch. The MSTP VLAN
enhancement allows preconfiguring MSTP topologies before the VLAN IDs associated with each
instance exist on a switch.
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When using preconfigured VLAN ID-to-MSTI topologies, ensure that MSTP switches remain in the same region
by mapping all VLAN IDs used in the region to the same MSTIs on each regional switch.

Each MST instance supports a different set of VLANs. A VLAN that is mapped to an MST instance cannot be a
member of another MST instance.

The MSTP VLAN configuration enhancement allows you to ensure that the same VLAN ID-to-MSTI assignments
exist on each MSTP switch in a region. Before a static VLAN is configured or a dynamic VLAN is learned on the
switch, use the spanning-tree instance vlan command to map VLANs to each MST instance in the
region. Later, when the VLAN is created, the switch automatically assigns it to the MST instance to which you had
previously mapped it.

Configuring MSTP instances with the VLAN range option (Example)
Using the spanning-tree instance command with the VLAN range option configures the entire range of
VLANs, even if the range includes VLANs that are not currently present on the switch.

Mapping VLANs to MSTP Instance

If VLANs 1, 5, and 7 are currently present and you enter the following command, all the VLANs from 1 through 10
are included, even those VLANs that are not present.

switch(config)# spanning-tree instance 1 vlan 1-10
On switches other than those covered by this guide, only the VLANs that are present will be included, that is, only
VLANs 1, 5, and 7. The switch will map these VLANs to MSTP Instance 1, which results in a Configuration Digest
that is not the same as the Configuration Digest for the switches running this enhancement.

Below, the example shows an MSTP instance configured with the VLAN range option. All the VLANs are included
in the instance whether they exist or not.

Configuration Digest value

The Configuration Digest value shown below is not the same as in the above example indicating that these
switches do not operate in the same instance.

The Common Spanning Tree (CST) will still have the correct root associations.
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Saving the current configuration before a software upgrade
Before updating to a new version of software, follow these steps:

Procedure

1. Enter the show config files command to display your current configuration files:

switch(config)# show config files

Configuration files:

 id | act pri sec | name
 ---+-------------+--------------------
  1 |  *   *   *  | config1
  2 |             | config2
  3 |             |

2. To save a configuration file for software version K.12.43, for example, type:

switch(config)# copy config config1 config configK1243.cfg
Choose any name for the saved configuration file that you prefer.

3. Display the configuration files as shown in the following example. Note the newly created configuration file
listed.

switch(config)# show config files

Configuration files:

 id | act pri sec | name
 ---+-------------+----------------------
  1 |  *   *   *  | config1
  2 |             | config2
  3 |             | configK1243.cfg

4. Update the switch to the desired version, for example, K.12.51. Enter the show flash command to see the
results. The switch is now running the software version K.12.51.

switch(config)# show flash

Image           Size(Bytes)   Date   Version  Build #:
-----           ----------  -------- -------  -------
Primary Image   : 6771179   04/17/08 K.12.51    304
Secondary Image : 7408949   11/06/08 K.12.43    123
Boot Rom Version: K.12.12
Default Boot    : Primary

5. To run the prior software version (K.12.43 in this example), type:

switch(config)# boot system flash secondary config configK1243.cfg
6. After rebooting, the switch is running software version K.12.43 and is using the configuration file that you

saved for this software version, configK1243.cfg.

7. You can also save the K.12.43 configuration file on a TFTP server. To reload the K.12.43 version of the
software again, reload the configuration file before doing the reload.
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Types of Multiple Spanning Tree Instances
A multiple spanning tree network comprises separate spanning tree instances existing in an MST region. (There
can be multiple regions in a network.) Each instance defines a single forwarding topology for an exclusive set of
VLANs. By contrast, an STP or RSTP network has only one spanning tree instance for the entire network, and
includes all VLANs in the network. (An STP or RSTP network operates as a single-instance network.) A region
can include two types of STP instances:

• Internal spanning tree Instance (IST Instance) This is the default spanning tree instance in any MST region. It
provides the root switch for the region and comprises all VLANs configured on the switches in the region that
are not specifically assigned to Multiple Spanning Tree Instances (MSTIs, described below).Within a region,
the IST instance provides a loop-free forwarding path for all VLANs associated with it. VLANs that are not
associated with an MSTI are, by default, associated with the IST instance. Note that the switch automatically
places dynamic VLANs (resulting from GVRP operation) in the IST instance. Dynamic VLANs cannot exist in
an MSTI (described below).

• Multiple Spanning Tree Instance (MSTI)This type of configurable spanning tree instance comprises all static
VLANs you specifically assign to it, and must include at least one VLAN. The VLANs you assign to an MSTI
must initially exist in the IST instance of the same MST region. When you assign a static VLAN to an MSTI, the
switch removes the VLAN from the IST instance. (Thus, you can assign a VLAN to only one MSTI in a given
region.) All VLANs in an MSTI operate as part of the same single spanning tree topology. (The switch does not
allow dynamic VLANs in an MSTI.)

CAUTION:

When you enable MSTP on the switch, the default MSTP spanning tree configuration settings
comply with the values recommended in the IEEE 802.1s Multiple Spanning Tree Protocol (MSTP)
standard. Inappropriate changes to these settings can result in severely degraded network
performance. For this reason, HPE strongly recommends that changing these default settings be
reserved only for experienced network administrators who have a strong understanding of the IEEE
802.1D/w/s standards and operation.

Planning an MSTP application
Before configuring MSTP, keep in mind the following tips and considerations:

• Ensure that the VLAN configuration in your network supports all the forwarding paths necessary for the desired
connectivity. All ports connecting one switch to another within a region and one switch to another between
regions should be configured as members of all VLANs configured in the region.

• Configure all ports or trunks connecting one switch to another within a region as members of all VLANs in the
region. Otherwise, some VLANs could be blocked from access to the spanning tree root for an instance or for
the region.

• Plan individual regions based on VLAN groupings. That is, plan on all MSTP switches in a given region
supporting the same set of VLANs. Within each region, determine the VLAN membership for each spanning
tree instance. (Each instance represents a single forwarding path for all VLANs in that instance.)

• Verify that there is one logical spanning tree path through the following:
◦ Any interregional links

◦ Any IST (Internal Spanning Tree) or Multiple Spanning Tree Instance within a region

◦ Any legacy (802.1D or 802.1w) switch or group of switches. (Where multiple paths exist between an MST
region and a legacy switch, expect the CST (Common Spanning Tree) to block all but one such path.)

• Determine the root bridge and root port for each instance.

• Determine the designated bridge and designated port for each LAN segment.
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• Determine which VLANs to assign to each instance and use port trunks with 802.1Q VLAN tagging where
separate links for separate VLANs would result in a blocked link preventing communication between nodes on
the same VLAN. (See MSTP operation with 802.1Q VLANs .)

• Identify the edge ports connected to end nodes and enable the admin-edge-port setting for these ports.
Leave the admin-edge-port setting disabled for ports connected to another switch, a bridge, or a half-duplex
repeater.

Configuring MSTP at a glance
The general steps for configuring MSTP via the CLI are:

Procedure

1. Configure MSTP global parameters. This involves:

a. Selecting MSTP as the spanning tree mode:
spanning-tree mode mstp

b. Clearing spanning tree debug counters:
spanning-tree clear-debug-counters

c. Specifying required parameters for MST region identity:
Region Name:spanning-tree config-name Region Revision Number:spanning-tree
config-revision

d. Optionally, specifying MSTP parameter changes for region settings:

HPE recommends that you leave these parameters at their default settings for most networks. See the
Caution below.

• The maximum number of hops before the MSTP BPDU (Bridge Protocol Data Unit) is discarded:
spanning-tree max-hops (default: 20)

• Force-Version operation: spanning-tree force-version
• Forward Delay: spanning-tree forward-delay
• Hello Time (if it is the root device): spanning-tree hello-time
• Maximum age to allow for STP packets before discarding: spanning-tree maximum-age
• Device spanning tree priority. Specifies the priority value used along with the switch MAC address to

determine which device is root. The lower a priority value, the higher the priority: spanning-tree
priority

e. Enabling SNMP traps:

no spanning-tree trap [ errant-bpdu | loop-guard | new-root | root-guard ]
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CAUTION: When you enable MSTP on the switch, the default MSTP spanning tree configuration
settings comply with the values recommended in the IEEE 802.1s Multiple Spanning Tree
Protocol (MSTP) standard. Inappropriate changes to these settings can result in severely
degraded network performance. For this reason, HPE strongly recommends that changing these
default settings be reserved only for experienced network administrators who have a strong
understanding of the IEEE 802.1D/w/s standards and operation.

2. Configure per port parameters. HPE recommends that you use the default settings for these parameters and
apply changes on a per-port basis only where a nondefault setting is clearly indicated by the circumstances of
individual links. Other features you might consider include BPDU Filtering or BPDU Protection—these provide
additional per-port control over spanning tree operations and security on the switch.

3. Configure MST instances. Configure one instance for each VLAN group that you want to operate as an active
topology within the region to which the switch belongs. When you create the instance, you must include a
minimum of one VID. You can add more VIDs later if desired. Use the following command:

spanning-tree instance n vlan vid
To move a VLAN from one instance to another, first use no spanning-tree instance n vlan vid to
remove the mapping from the VLAN from the current instance, then add the VLAN to the other instance.
(While the VLAN mapping is removed from an MSTI, it is associated with the region's IST instance.)

4. Configure the priority for each instance with the following command: spanning-tree instance n
priority n

5. Configure MST instance port parameters. HPE recommends that you apply changes on a per-port basis only
where a nondefault setting is clearly indicated by the circumstances of individual links. For example, you might
want to set the path cost value for the ist or for the ports used by a specific MST instance. Use the following
command:spanning-tree instance <ist> | 1..64 <port-list> path-cost [ auto |
1..200000000 ] Alternatively, leaving this setting at the default (auto) allows the switch to calculate the
path-cost from the link speed.

6. Enable spanning tree operation on the switch with the spanning-tree command.

Configuring MSTP operation mode and global settings
The commands in this section apply at the switch (global) level.

Selecting MSTP as the spanning tree mode
Syntax:

spanning-tree mode mstp
Specifies that spanning tree will run in MSTP mode.

Clearing spanning tree debug counters
Syntax:

spanning-tree clear-debug-counters
Clears spanning tree debug counters.
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Resetting the configuration name of the MST region in which a switch
resides
Syntax:
spanning-tree config-name ascii-string
no spanning-tree config-name ascii-string
Resets the configuration name of the MST region in which the switch resides. This name can include up to 32
nonblank characters and is case-sensitive. On all switches within a given MST region, the configuration names
must be identical. For more than one MSTP switch in the same MST region, the identical region name must be
configured on all such switches. If the default configuration name is retained on a switch, it cannot exist in the
same MST region with another switch.

The default name is a text string using the hexadecimal representation of the switch's MAC address.

The no form of the command overwrites the currently configured name with the default name.

NOTE: This option is available only when the switch is configured for MSTP operation. There is no
defined limit on the number of regions you can configure.

Designating the revision number of the MST region for a switch
Syntax:

spanning-tree config-revision revision-number
Configures the revision number designated for the MST region in which you want the switch to reside. This setting
must be the same for all switches residing in the same region. Use this setting to differentiate between region
configurations in situations such as the following:

• Changing configuration settings within a region where you want to track the configuration versions you use

• Creating a new region from a subset of switches in a current region and want to maintain the same region
name.

• Using the pending option to maintain two different configuration options for the same physical region.

This setting must be the same for all MSTP switches in the same MST region.

Range: 0 - 65535

Default: 0

NOTE:

This option is available only when the switch is configured for MSTP operation.

Setting the spanning tree compatibility mode
Syntax:
spanning-tree force-version [ stp-compatible | rstp-operation | mstp-operation ]
Sets the spanning tree compatibility mode. This command forces the switch to emulate behavior of earlier
versions of spanning tree protocol, or return to MSTP behavior. The command is useful in test or debug
applications, and removes the need to reconfigure the switch for temporary changes in spanning tree operation.
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stp-compatible
The switch applies 802.1D STP operation on all ports.

rstp-operation
The switch applies 802.1w operation on all ports except those ports where it detects a system using 802.1D
Spanning Tree. RSTP is Rapid Spanning Tree Protocol.

mstp-operation
The switch applies 802.1s MSTP operation on all ports where compatibility with 802.1D or 802.1w spanning
tree protocols is not required.

NOTE:

Even when mstp-operation is selected, if the switch detects an 802.1D BPDU or an 802.1w
BPDU on a port, it communicates with the device linked to that port using STP or RSTP BPDU
packets. Also, if errors are encountered as described in Configuring MSTP at a glance on page
104, setting force-version to stp-compatible forces the MSTP switch to communicate out all
ports using operations that are compatible with IEEE 802.1D STP.

NOTE:

When using MSTP rapid state transitions

Under some circumstances the rapid state transitions employed by MSTP can increase the rates of
frame duplication and incorrect ordering in the switched LAN. To allow MSTP switches to support
applications and protocols that may be sensitive to frame duplication and incorrect ordering, setting
the Force Protocol Version (force-version) parameter to stp-compatible allows MSTP to
operate with rapid transitions disabled. The value of this parameter applies to all ports on the switch.

Setting the time interval between listening, learning, and forwarding states
Syntax:

spanning-tree forward-delay
Sets the time the switch waits between transitions from listening to learning and from learning to forwarding
states.

Range: 4 - 30

Default: 15 seconds

Setting spanning tree to operate in 802.1D legacy mode
Syntax:
spanning-tree legacy-mode
no spanning-tree legacy-mode
Forces spanning tree to operate in legacy (802.1D) mode.

Default: MSTP-operation.

The no form of this command returns the switch to the default 802.1s native mode (MSTP-operation.)
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Setting spanning tree to operate with 802.1D legacy path cost values
Syntax:
spanning-tree legacy-path-cost
no spanning-tree legacy-path-cost
Forces spanning tree to operate with legacy (802.1D) path cost values.

Default: 802.1t.

The no form of the command returns the switch to the default 802.1t (not legacy) path cost values.

Specifying the time interval between BPDU transmissions
Syntax:

spanning-tree hello-time 1..10
If MSTP is running and the switch is operating as the CIST (Common and Internal Spanning Tree) root for your
network, this command specifies the time in seconds between transmissions of BPDUs for all ports on the switch
configured with the Global option (the default). This parameter applies in MSTP, RSTP, and STP modes.

During MSTP operation, you can override this global setting on a per-port basis with this command: spanning-
tree port-list hello-time 1..10 .

Default: 2 seconds.

Setting the hop limit for BPDUs
Syntax:

spanning-tree max-hops hop-count
Resets the number of hops allowed for BPDUs in an MST region. When an MSTP switch receives a BPDU, it
decrements the hop-count setting the BPDU carries. If the hop-count reaches zero, the receiving switch drops the
BPDU.

The switch does not change the message-age and maximum-age data carried in the BPDU as it moves through
the MST region and is propagated to other regions.

Range: 1 - 40

Default: 20

Setting the maximum age of received STP information
Syntax:

spanning-tree maximum age
Sets the maximum age time for received STP information before it is discarded.

Default: 20 seconds

Manipulating the pending MSTP configuration
Syntax:

spanning-tree pending [apply | config-name | config-revision | instance | reset]
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Manipulates the pending MSTP configuration. The command is useful in test or debug applications, and enables
rapid reconfiguration of the switch for changes in spanning tree operation.

apply
Applies pending MSTP configuration (swaps active and pending configurations).

config-name

Sets the pending MST region configuration name. Default is the switch's MAC address.

config-revision

Sets the pending MST region configuration revision number. Default is 0.

instance

Change pending MST instance configuration.

reset

Copies the active configuration to pending.

Setting the bridge priority for a region and determining the root switch
Syntax:

spanning-tree priority priority-multiplier
Every switch running an instance of MSTP has a Bridge Identifier, which is a unique identifier that helps
distinguish this switch from all others. The switch with the lowest Bridge Identifier is elected as the root for the
tree.

The Bridge Identifier is composed of a configurable priority component (2 bytes) and the bridge's MAC address (6
bytes). You can change the priority component provides flexibility in determining which switch will be the root for
the tree, regardless of its MAC address.

This command sets the switch (bridge) priority for the designated region in which the switch resides. The switch
compares this priority with the priorities of other switches in the same region to determine the root switch for the
region. The lower the priority value, the higher the priority. If there is only one switch in the region, then that switch
is the root switch for the region. The root bridge in a region provides the path to connected regions for the traffic in
VLANs assigned to the region's IST instance. Traffic in VLANs assigned to a numbered STP instance in a given
region moves to other regions through the root switch for that instance.

The priority range for an MSTP switch is 0-61440. However, this command specifies the priority as a multiplier (0 -
15) of 4096. That is, when you specify a priority multiplier value of 0 - 15, the actual priority assigned to the switch
is: (priority-multiplier) x 4096

For example, with 2 as the priority-multiplier on a given MSTP switch, the Switch Priority setting is 8,192.

NOTE:

If multiple switches in the same MST region have the same priority setting, then the switch with the
lowest MAC address becomes the root switch for that region.

Enabling SNMP traps
Syntax:
spanning-tree trap {errant-bpdu | loop-guard | new-root | root-guard}
no spanning-tree trap {errant-bpdu | loop-guard | new-root | root-guard}
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Enables or disables SNMP traps for errant-BPDU, loop guard, new root, and root guard event notifications. This
command is designed to be used in conjunction with the spanning-tree bpdu-filter command and the
bpdu-protection command.

Options
errant-bpdu

Enables SNMP notification when an errant BPDU is received. Designed for use with BPDU filtering.

loop-guard
Enables SNMP notification when a loop guard inconsistency is detected. Designed for use with the Loop
Guard option.

new-root
Enables SNMP notification when a new root is elected on any VLAN configured for MSTP on the switch.

root-guard
Enables SNMP notification when a root guard inconsistency is detected.

Default for all of the above options: Disabled

The no form of the command disables traps on the switch.

Configuring MSTP per-port parameters
In an MSTP topology, per-port parameters are set in the global configuration context. In most cases, HPE
recommends that you use the default settings for these parameters and apply changes on a per-port basis only
where a nondefault setting is clearly indicated by the circumstances of individual links. Some port parameters
(such as admin-edge-port) affect all MSTI instances that consist of VLANs configured on the port. Other port
parameters (such as path-cost) affect only the specified MST.

Enabling immediate transition to forwarding on end nodes
Syntax:
spanning-tree port-list admin-edge-port
no spanning-tree port-list admin-edge-port
Enables admin-edge-port on ports connected to end nodes. During spanning tree establishment, ports with
admin-edge-port enabled transition immediately to the forwarding state. If a bridge or switch is detected on the
segment, the port automatically operates as non-edge, not enabled.

Default: Disabled

If admin-edge-port is disabled on a port and auto-edge-port has not been disabled, the auto-edge-port
setting controls the behavior of the port.

The no form of this command disables edge port operation on the specified ports.

Identifying edge ports automatically
Syntax:
spanning-tree port-list auto-edge-port
no spanning-tree port-list auto-edge-port
Enables automatic identification of edge ports for faster convergence. When enabled, the port looks for BPDUs
for the first 3 seconds. If there are none, the port is classified as an edge port and immediately starts forwarding
packets. If BPDUs are seen on the port, the port is classified as a non‐edge port and normal STP operation
commences on that port.
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If admin-edge-port is enabled for a port, the setting for auto-edge-port is ignored whether set to yes or no.

If admin-edge-port is set to no, and auto-edge-port has not been disabled (set to no), then the auto-
edge-port setting controls the behavior of the port.

CAUTION: Requires thorough knowledge of IEEE 802.1D/w/s standards and operation.

Spanning tree interprets a switch mesh as a single link. Because the switch automatically gives
faster links a higher priority, the default MSTP parameter settings are usually adequate for spanning
tree operation. Because incorrect MSTP settings can adversely affect network performance, do not
change the MSTP settings from their default values unless you have a strong understanding of how
spanning tree operates.

Default: Enabled

The no form of this command disables auto-edge-port operation on the specified ports.

Specifying the interval between BPDU transmissions
Syntax:

spanning-tree port-list hello-time [global | 1 - 10]
When the switch is the CIST root, this parameter specifies the interval (in seconds) between periodic BPDU
transmissions by the designated ports. This interval also applies to all ports in all switches downstream from each
port in the port-list.

A setting of global indicates that the ports in port-list on the CIST root are using the value set by the global
spanning tree hello-time value.

When a given switch X is not the CIST root, the per-port hello-time for all active ports on switch X is
propagated from the CIST root, and is the same as the hello-time in use on the CIST root port in the currently
active path from switch X to the CIST root. When switch X is not the CIST root, then the upstream CIST root's port
hello-time setting overrides the hello-time setting configured on switch X.

Default Per-Port setting: Use Global.

Default Global Hello-Time: 2.

Forcing a port to send RST/MST BPDUs
Syntax:

spanning-tree port-list mcheck
Forces a port to send RST/MST BPDUs for 3 seconds. This tests whether all STP bridges on the attached LAN
have been removed and the port can migrate to native MSTP mode and use RST/MST BPDUs for transmission.

Determining which ports are forwarding ports by assigning port cost
Syntax:

spanning-tree port-list path-cost [auto | 1..200000000]
Assigns an individual port cost that the switch uses to determine which ports are forwarding ports in a given
spanning tree. In the default configuration (auto) the switch determines a port's path cost by the port's type:

10 Mbps
2000000
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100 Mbps
200000

1 Gbps
20000

Default: Auto

Informing the switch of the device type to which a port connects
Syntax:

spanning-tree port-list point-to-point-mac [true | false | auto]
Informs the switch of the type of device to which a specific port connects.

Options
true

(Default) Indicates a point-to-point link to a device such as a switch, bridge, or end-node.

false
Indicates a connection to a half-duplex repeater (which is a shared LAN segment).

auto
Causes the switch to set Force-False on the port if it is not running at full duplex.

Determining which port to use for forwarding
Syntax:

spanning-tree port-list priority priority-multiplier
MSTP uses this parameter to determine the port to use for forwarding. The port with the lowest priority number
has the highest priority for use.

The range is 0 to 240, and is configured by specifying a multiplier from 0 - 15. When you specify a priority
multiplier of 0 - 15, the actual priority assigned to the switch is:

(priority-multiplier) x 16

If you configure 2 as the priority multiplier on a given port, the actual Priority setting is 32. After specifying the port
priority multiplier, the switch displays the actual port priority (and not the multiplier) in the show spanning-tree
or show spanning-tree port-list displays.

You can view the actual multiplier setting for ports by executing show running and looking for an entry in this
format:

spanning-treeport-list priority priority-multiplier
For example, configuring port A2 with a priority multiplier of 3 results in the following line in the show running
output:

spanning-tree A2 priority 3
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Denying a port the role of root port
Syntax:

spanning-treeport-list root-guard
When a port is enabled as root-guard, it cannot be selected as the root port even if it receives superior STP
BPDUs. The port is assigned an "alternate" port role and enters a blocking state if it receives superior STP
BPDUs.

A superior BPDU contains both "better" information on the root bridge and path cost to the root bridge, which
would normally replace the current root bridge selection.

The superior BPDUs received on a port enabled as root-guard are ignored. All other BPDUs are accepted and
the external devices may belong to the spanning tree as long as they do not claim to be the Root device.

Use this command on MSTP switch ports that are connected to devices located in other administrative network
domains to:

• Ensure the stability of the core MSTP network topology so that undesired or damaging influences external to
the network do not enter.

• Protect the configuration of the CIST root bridge that serves as the common root for the entire network.

Default: Disabled

Denying a port propagation change information
Syntax:

spanning-tree port-list tcn-guard
When enabled for a port, this causes the port to stop propagating received topology change notifications and
topology changes to other ports.

Default: Disabled

Configure MST instance ports parameters
Syntax

spanning-tree instance 1-64 ethernet PORT-LIST
Description

Configure MST instance ports parameters.

Best practices

Follow the PORT-LIST with a '?' to get the list of all possible options.

Create a new instance or map VLAN(s) to an existing one
Syntax

spanning-tree instance ist | 1-64 vlan VLAN-ID
Description

Used to create a new instance or map VLAN(s) to an existing one. Each instance must have at least one VLAN
mapped to it. The VLANs unmapped from other instances are automatically mapped to the IST instance. Only IST
VLANs can be directly mapped to other instances. When VLANs are mapped to an instance, they are
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automatically unmapped from the instance they were mapped to before. Any MSTP instance can have all the
VLANs configured in the switch.

Enable event logging
Syntax

no spanning-tree log state-transitions instance 1-64 | ist vlan
Description

By default port state change for IST is added in log.

Deleting an instance
Syntax

no spanning-tree instance <1-64>
Description

Deletes an instance. The IST instance cannot be deleted.

Configure an existent instance
Syntax
no spanning-tree instance <ist|1-64>
Description

Used to configure an existent instance.

Best Practices

Follow the syntax with a '?' to get a complete list of all the configurable parameters and sub-commands.

MSTP Config example

MSTP Config

VLAN 109
  ip addr 10.0.109.10/24
  tag 12
  exit

VLAN 110
  ip addr 10.0.110.10/24
  tag 12
  exit

Spanning-tree
Spanning-tree mode mstp
Spanning-tree config-name "MSTPRegion1"
Spanning-tree config-revision 1
Spanning-tree instance 1 VLAN 109
Spanning-tree instance 1 priority 4
Spanning-tree instance 2 VLAN 110
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Downgrading to lower version build
The downgrade to lower version build will result in “stuck in boot” if more than 16 instances are created in the
DUT.

Operating notes for the VLAN configuration enhancement
• Configuring MSTP on the switch automatically configures the Internal Spanning Tree (IST) instance and

places all statically and dynamically configured VLANs on the switch into the IST instance. The spanning tree
instance vlan command creates a new MST instance and moves the VLANs you specify from the IST to the
MSTI.You must map a least one VLAN ID to an MSTI when you create it. You cannot map a VLAN ID to more
than one instance. You can create up to 16 MSTIs in a region.

• The no form of the spanning tree instance vlan command removes one or more VLANs from the specified
MSTI. If no VLANs are specified, the no form of the command deletes the specified MSTI.When you remove a
VLAN from an MSTI, the VLAN returns to the IST instance, where it can remain or be reassigned to another
MSTI configured in the region.

• If you enter the spanning tree instance vlan command before a static or dynamic VLAN is configured on the
switch to preconfigure VLAN ID-to-MSTI mappings, no error message is displayed. Later, each newly
configured VLAN that has already been associated with an MSTI is automatically assigned to the MSTI.This
new default behavior differs from automatically including configured (static and dynamic) VLANs in the IST
instance and requiring you to manually assign individual static VLANs to an MSTI.

• The valid VLAN IDs that you can map to a specified MSTI are from 1 to 4094. The VLAN ID-to-MSTI mapping
does not require a VLAN to be already configured on the switch. The MSTP VLAN enhancement allows you to
preconfigure MSTP topologies before the VLAN IDs associated with each instance exist on a switch.

• When you use preconfigured VLAN ID-to-MSTI topologies, ensure that MSTP switches remain in the same
region by mapping all VLAN IDs used in the region to the same MSTIs on each regional switch.

• When you upgrade switch software to release K.13.XX and later, the existing MSTP topology configuration is
automatically saved. All existing VLAN ID-to-MSTI assignments are maintained on a switch for uninterrupted
MSTP network operation.

Configuring MST instance parameters
When you enable MSTP on the switch, a spanning tree instance is enabled automatically. The switch supports up
to 16 configurable MST instances for each VLAN group that you want to operate as an active topology within the
region to which the switch belongs. When creating an instance, you must include a minimum of one VID. You can
add more VIDs later if desired.

Syntax:
spanning-tree instance 1..16 vlan vid [vid..vid]
no spanning-tree instance 1..16 vlan vid [vid..vid]
Configuring MSTP on the switch automatically configures the IST instance and places all statically and
dynamically configured VLANs on the switch into the IST instance. This command creates a new MST instance
(MSTI) and moves the VLANs you specify from the IST to the MSTI.

You must map at least one VLAN to an MSTI when you create it. You cannot map a VLAN ID to more than one
instance. You can create up to 16 MSTIs in a region.

The no form of the command removes one or more VLANs from the specified MSTI. If no VLANs are specified,
the no form of the command deletes the specified MSTI.

When you remove a VLAN from an MSTI, the VLAN returns to the IST instance, where it can remain or be re-
assigned to another MSTI configured in the region.
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NOTE: Starting in software release 13.x.x, you can enter the spanning-tree instance vlan
command before a static or dynamic VLAN is configured on the switch to preconfigure VLAN ID-to-
MSTI mappings. No error message is displayed. Later, each newly configured VLAN that has already
been associated with an MSTI is automatically assigned to the MSTI.

This new default behavior differs from automatically including configured (static and dynamic) VLANs in the IST
instance and requiring the manual assigning of individual static VLANs to an MSTI.

NOTE: The valid VLAN IDs that you can map to a specified MSTI are from 1 to 4094. The VLAN ID-
to-MSTI mapping does not require a VLAN to be already configured on the switch. The MSTP VLAN
enhancement allows you to preconfigure MSTP topologies before the VLAN IDs associated with
each instance exist on a switch.

When using preconfigured VLAN ID-to-MSTI topologies, be sure that MSTP switches remain in the same region
by mapping all VLAN IDs used in the region to the same MSTIs on each regional switch.

When upgrading switch software to release 13.x.x and later, the existing MSTP topology configuration is
automatically saved. All existing VLAN ID-to-MSTI assignments are maintained on a switch for uninterrupted
MSTP network operation.

Setting the bridge priority for an instance
Syntax:

spanning-tree instance 1..16 priority priority-multiplier
Sets the switch (bridge) priority for the designated instance. This priority is compared with the priorities of other
switches in the same instance to determine the root switch. The lower the priority value, the higher the priority. If
there is only one switch in the instance, then that switch is the root switch for the instance. The IST regional root
bridge provides the path to instances in other regions that share one or more of the same VLANs.

The priority range for an MSTP switch is 0 - 61440. However, this command specifies the priority as a multiplier (0
- 15) of 4096. When a priority multiplier value is set from 0 - 15, the actual priority assigned to the switch for the
specified MST instance is: (priority-multiplier) x 4096

For example, if you configure 5 as the priority-multiplier for MST Instance 1 on a given MSTP switch, the Switch
Priority setting is 20,480 for that instance in that switch.

NOTE:

If multiple switches in the same MST instance have the same priority setting, the switch with the
lowest MAC address becomes the root switch for that instance.

Assigning a port cost for an MST instance
Syntax:

spanning-tree instance ist | 1..16 port-list path-cost [auto | 1..200000000]
Assigns an individual port cost for the IST or for the specified MST instance.

For a given port, the path cost setting can be different for different MST instances to which the port may belong.
The switch uses the path cost to determine which ports are the forwarding ports in the instance; that is, which
links to use for the active topology of the instance and which ports to block.

The settings are either auto or in a range from 1 to 200,000,000. With the auto setting, the switch calculates the
path cost from the link speed:
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10 Mbps
2000000

100 Mbps
200000

1 Gbps
20000

Default
Auto

Setting the priority for a port in a specified MST instance
Syntax:

spanning-tree instance 1..16 port-list priority priority-multiplier
Sets the priority for the specified ports in the specified MST instance.

For a given port, the priority setting can be different for different MST instances to which the port may belong. The
priority range for a port in a given MST instance is 0 - 255. However, this command specifies the priority as a
multiplier (0 - 15) of 16. When you specify a priority multiplier of 0 - 15, the actual priority assigned to the switch is:
(priority-multiplier) x 16

Setting priority for a port in a specified MST instance

If you configure 2 as the priority multiplier on a given port in an MST instance, then the actual Priority setting is
32x. After you specify the port priority multiplier in an instance, the switch displays the actual port priority and not
the multiplier in the show spanning-tree instance 1..16 or show spanning-tree port-list
instance 1..16 displays.

You can view the actual multiplier setting for ports in the specified instance by executing show running and
looking for an entry in the following format:

spanning-tree instance 1..15 port-list priority priority-multiplier
For example, configuring port A2 with a priority multiplier of 3 in instance 1, results in this line in the show
running output:

spanning-tree instance 1 A2 priority 3

Setting the priority for specified ports for the IST
Syntax:

spanning-tree port-list priority priority-multiplier
Sets the priority for the specified ports for the IST (Instance 0) of the region in which the switch resides.

The priority component of the port's Port Identifier is set. The Port Identifier is a unique identifier that helps
distinguish this switch's ports from all others. It consists of the priority value with the port number extension—
PRIORITY:PORT_NUMBER. A port with a lower value of Port Identifier is more likely to be included in the active
topology.

This priority is compared with the priorities of other ports in the IST to determine which port is the root port for the
IST instance. The lower the priority value, the higher the priority. The IST root port (or trunk) in a region provides
the path to connected regions for the traffic in VLANs assigned to the region's IST instance.
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The priority range for a port in a given MST instance is 0 - 240. However, this command specifies the priority as a
multiplier (0 - 15) of 16. When you specify a priority multiplier of 0 - 15, the actual priority assigned to the switch is:
(priority-multiplier) x 16

Setting priority for specified ports for an IST

Configuring 5 as the priority multiplier on a given port in the IST instance for a region creates an actual priority
setting of 80. After specifying the port priority multiplier for the IST instance, the switch displays the actual port
priority, not the multiplier, in the show spanning-tree instance ist or show spanning-tree port-
list instance ist displays. You can view the actual multiplier setting for ports in the IST instance by
executing show running and looking for an entry in this format:

spanning-tree port-list priority priority-multiplier
So configuring port A2 with a priority multiplier of 2 in the IST instance, results in this line in the show running
output:

spanning-tree A2 priority 2

Enabling or disabling spanning tree operation
This command enables or disables spanning tree operation for any spanning tree protocol enabled on the switch.
Before using to enable spanning tree, be sure that the right version is active on the switch.

Syntax:

no spanning-tree
Enables or disables spanning tree. Enabling spanning tree with MSTP configured, implements MSTP for all
physical ports on the switch according to the VLAN groupings for the IST instance and any other configured
instances.

Disabling MSTP removes protection against redundant loops that can significantly slow or halt a network.

This command simply turns spanning tree on or off. It does not change the existing spanning tree configuration.

NOTE: The convergence time for implementing MSTP changes can be disruptive to your network. To
minimize such disruption, consider using the spanning-tree pending command.

Enabling an entire MST region at once or exchanging one region
configuration for another
This operation exchanges the currently active MSTP configuration with the currently pending MSTP configuration,
making it possible to implement a new MSTP configuration with minimal network disruption or to exchange MSTP
configurations for testing or troubleshooting purposes.

When configuring or reconfiguring MSTP, the switch recalculates the corresponding network paths. This can have
a ripple effect throughout your network as adjacent MSTP switches recalculate network paths to support the
configuration changes invoked in a single switch. Although MSTP employs rapid spanning tree operation, the
convergence time for implementing MSTP changes can be disruptive to your network. However, by using the
spanning-tree pending feature, you can set up an MSTP on the switch and then invoke all instances of the
new configuration at the same time, instead of one at a time.

Syntax:

no spanning-tree pending [apply | config-name | config-revision | instance | reset]
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Exchanges the currently active MSTP configuration with the current pending MSTP configuration. Options are as
follows:

apply
Exchanges the currently active MSTP configuration with the pending MSTP configuration.

config-name

Specifies the pending MST region name. Must be the same for all MSTP switches in the region. (Default: The
switch's MAC address.)

config-revision

Specifies the pending MST region configuration revision number. Must be the same for all MSTP switches in
the region. (Default: 0).

instance
Creates the pending instance and assigns one or more VLANs to the instance.

reset
Copies the switch's currently active MSTP configuration to the pending configuration. This is useful when you
want to experiment with the current MSTP configuration while maintaining an unchanged version.

Creating a pending MSTP configuration
To create a pending MSTP configuration and exchange it with the active MSTP configuration:

Procedure

1. Configure the VLANs to include in any instances in the new region. When you execute the pending
command, all VLANs configured on the switch will be assigned to a single pending IST instance unless
assigned to other, pending MST instances. The pending command creates the region's IST instance
automatically.

2. Configure MSTP as the spanning tree protocol, then execute write mem and reboot. The pending option is
available only with MSTP enabled.

3. Configure the pending region config-name to assign to the switch.

4. Configure the pending config-revision number for the region name.

5. If you want an MST instance other than the IST instance, configure the instance number and assign the
appropriate VLANs (VIDs) using the pending instance1..16vlan [vid | vid-range] command.

6. Repeat step 5 for each additional MST instance necessary.

7. To review your pending configuration, use the show spanning-tree pending command.

8. To exchange the currently active MSTP configuration with the pending MSTP configuration, use the
spanning-tree pending apply command.

Viewing MSTP statistics
NOTE:

SNMP MIB Support for MSTP is a superset of the STP/802.1D and RSTP/802.1w protocols and
uses the MIB objects defined for these two protocols.
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Viewing global MSTP status
The following commands display the MSTP statistics for the connections between MST regions in a network.

Syntax:
show spanning-tree
Displays the switch's global and regional spanning tree status, plus the per-port spanning tree operation at the
regional level. Values for the following parameters appear only for ports connected to active devices:
Designated Bridge, Hello Time, PtP, and Edge.

Syntax:
show spanning-tree port-list
Displays the spanning tree status for the designated ports. You can list data for a series of ports and port trunks
by specifying the first and last port or trunk of any consecutive series of ports and trunks. For example, to display
data for port A20-A24 and trk1, you would use this command: show spanning-tree a20-a42,trk1
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Viewing a common spanning tree status

Viewing detailed port information
The following commands display the MSTP statistics for the connections between MST regions in a network.

Syntax:

show spanning-tree detail
Displays additional parameters concerning the CST ports.

Syntax:

show spanning-tree port-list detail
Displays detailed spanning tree status for the designated ports.
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Viewing port information

NOTE:

This command gives information about the CST only. To view details of specific MST instances, use
the show spanning tree instance commands.

Viewing status for a specific MST instance
The following commands display the MSTP statistics for a specified MST instance.

Syntax:

show spanning-tree instance [ist | 1..16]
Displays the MSTP statistics for either the IST instance or a numbered MST instance running on the switch.

Syntax:

show spanning-tree instance [ist | 1..16] detail
Displays status on all active ports for a specific instance of MSTP.

Syntax:

show spanning-tree port-list instance [ist | 1..16] detail
Displays status on specified ports for a specific instance of MSTP.

Viewing status for a specific instance of an MSTP

This shows how to display detailed status for all active ports for a specific instance of MSTP.
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switch(config)# show spanning-tree instance 11
 MST Instance Information
  Instance ID : 11
  Mapped VLANs : 111,300
  Switch Priority        : 32768

  Topology Change Count   : 2
  Time Since Last Change  : 4 mins

 Regional Root MAC Address : 1cc1de-cfbc80
 Regional Root Priority    : 32768
 Regional Root Path Cost   : 400000
 Regional Root Port        : This switch is root
 Remaining Hops            : 20
 
                                                          Designated
 Port  Type      Cost      Priority Role       State      Bridge
 ----- --------- --------- -------- ---------- ---------- -------------
 1     10/100TX  200000    128      Root       Forwarding 1cc1de-cfbc80
 2     10/100TX  200000    128      Designated Forwarding 1cc1de-02a700
 3     10/100TX  Auto      112      Designated Forwarding 1cc1de-02a700
 4     10/100TX  Auto      128      Disabled   Disabled
 .        .       .         .          .         .

Viewing the MSTP configuration
MSTP configuration can be viewed at the global, per-instance, and regional level

Viewing the global MSTP configuration
This command displays the switch's basic and MST region spanning tree configuration, including basic port
connectivity settings.

Syntax:

show spanning-tree config
The upper part of this output shows the switch's global spanning tree configuration that applies to the MST region.
The port listing shows the spanning tree port parameter settings for the spanning tree region operation configured
by the spanning-tree port-list command.

Syntax:

show spanning-tree port-list config
This command shows the same data as the above command, but lists the spanning tree port parameter settings
for only the specified port or trunk. You can list data for a series of ports and port trunks by specifying the first and
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last port or trunk of any consecutive series of ports and trunks. For example, to display data for port A20-A24
andtrk1, use the command: show spanning-tree a20-a24,trk1 config
Figure 12: Viewing the switch's global spanning tree configuration

Viewing per-instance MSTP configurations
These commands display the per-instance port configuration and current state, along with instance identifiers and
regional root data.

Syntax:

show spanning-tree config instance [ist | 1..16]
The upper part of this output shows the instance data for the ist or for the specified instance. The lower part of the
output lists the spanning tree port settings for the specified instance.

Syntax:

show spanning-tree port-list config instance [ist | 1..16]
This command shows the same data as the preceding command, but lists the spanning tree port parameter
settings for only the specified port or trunk. You can list data for a series of ports and port trunks by specifying the
first and last port or trunk of any consecutive series of ports and trunks.
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Viewing port data

To display data for ports A20-A24 and trk1, you would use the command:

switch(config)# show spanning-tree a20-a24,trk1 config instance 1

Viewing the region-level configuration
This command is useful for quickly verifying the allocation of VLANs in the switch's MSTP configuration, and for
viewing the configured region identifiers.

Syntax:

show spanning-tree mst-config

NOTE:

The switch computes the MSTP Configuration Digest from the VID to MSTI configuration mappings
on the switch itself. As required by the 802.1s standard, all MSTP switches within the same region
must have the same VID to MSTI assignments, and any given VID can be assigned to either the IST
or one of the MSTIs within the region. Thus, the MSTP Configuration Digest must be identical for all
MSTP switches intended to belong to the same region. When comparing two MSTP switches, if their
Digest identifiers do not match, they cannot be members of the same region.

Viewing a region-level configuration

switch(config)# show spanning-tree net-config

 MST Configuration Identifier Information

  MST Configuration Name : REGION_1
  MST Configuration Revision : 1
  MST Configuration Digest : 0xDAD6A13EC5141980B7EBDA71D8991E7C

  IST Mapped VLANs : 1,66

  Instance ID Mapped VLANs
  -------- ---------------
  1        11,22
  2        33,44,55
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Viewing the pending MSTP configuration
This command displays the MSTP configuration the switch will implement if you execute the spanning tree
pending apply command.

Syntax:

show spanning-tree pending [instance | mst-config]
instance [1..16 | ist]

Lists region, instance ID, and VLAN information for the specified, pending instance.

mst-config

Lists region, IST instance VLANs, numbered instances, and assigned VLAN information for the pending
MSTP configuration.

Viewing a pending configuration

switch(config)# show spanning-tree pending instance 3

 Pending MST Instance Configuration Information

  MST Configuration Name : New-Version_01
  MST Configuration Revision : 1
  Instance ID : 3
  Mapped VLANs : 3

switch(config)# show spanning-tree pending mst-config

 Pending MST Configuration Identifier Information

  MST Configuration Name : New-Version_01
  MST Configuration Revision : 1

  IST Mapped VLANs : 1,2,4-4094

  Instance ID Mapped VLANs
  ----------- ---------------------------------------
  3           3

MSTP operating rules
• All switches in a region must be configured with the same set of VLANs, the same MST configuration name

and MST configuration number.

• Within a region, a VLAN can be allocated to either a single MSTI or to the region's IST instance.

• All switches in a region must have the same VID-to-MST instance assignment.

• There is one root MST switch per configured MST instance.

• Because boundary ports provide the VLAN connectivity between regions, all boundary ports on a region's root
switch should be configured as members of all static VLANs defined in the region.

• There is one root switch for the Common and Internal Spanning Tree (CIST). At any given time, all switches in
the network will use the per-port hello-time parameter assignments configured on the CIST root switch.

• Where multiple MST regions exist in a network, there is only one active, physical communication path between
any two regions, or between an MST region and an STP or RSTP switch. MSTP blocks any other physical
paths as long as the currently active path remains in service.
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• Within a network, an MST region appears as a virtual RSTP bridge to other spanning tree entities (other MST
regions, and any switches running 802.1D or 802.1w spanning tree protocols).

• Within an MSTI, there is one physical communication path between any two nodes, regardless of how many
VLANs belong to the MSTI. Within an IST instance, there is also one spanning tree across all VLANs
belonging to the IST instance.

• An MSTI comprises a unique set of VLANs and forms a single spanning tree instance within the region to
which it belongs.

• A dynamic VLAN learned by GVRP will always be placed in the IST instance and cannot be moved to any
configured MST instance.Starting in software release 13.X.X, dynamically learned GVRP VLANs can be
mapped to MSTIs and support MSTP load balancing.

• In software release 13.X.X and later, you can preconfigure static and dynamic VLAN ID-to-MSTI mappings
before the VLAN is created on the switch. Later, when the static VLAN ID is configured or a dynamic GVRP
VLAN is learned, the VLAN is automatically associated with the preconfigured MSTI.

• Communication between MST regions uses a single spanning tree.

• If a port on a switch configured for MSTP receives a legacy (STP/802.1D or RSTP/802.1w) BPDU, it
automatically operates as a legacy port. In this case, the MSTP switch interoperates with the connected STP
or RSTP switch as a separate MST region.

• Within an MST region, there is one logical forwarding topology per instance, and each instance comprises a
unique set of VLANs. Where multiple paths exist between a pair of nodes using VLANs belonging to the same
instance, all but one of those paths will be blocked for that instance. However, if there are different paths in
different instances, all such paths are available for traffic. Separate forwarding paths exist through separate
spanning tree instances.

• A port can have different states (forwarding or blocking) for different instances (which represent different
forwarding paths).

• MSTP interprets a switch mesh as a single link.

Troubleshooting an MSTP configuration
Cause

This section describes the show spanning-tree commands to use to monitor, troubleshoot, and debug the
operation of a multiple-instance spanning tree configuration in a network.

The show spanning-tree commands described in this section allow for focusing on increasingly specific levels
of operation. For example, you can display debug information for:

• All MST instances

• All ports used in one MST instance

• A specific port or several ports used in one MST instance

Also, you can display the change history for the root (bridge) switch used as the single forwarding path for:

• All MST regions, STP bridges, and RSTP bridges in an STP network

• All VLANs on MSTP switches in a region

• All VLANs on MSTP switches in an mst instance
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Viewing the change history of root bridges
The show spanning-tree root-history command allows you to display change history information (up to
10 history entries) for a specified root bridge in any of the following MSTP topologies:

• Common Spanning Tree (cst):Provides connectivity in a bridged network between MST regions, STP LANs,
and RSTP LANs.

• Internal Spanning Tree (ist):Provides connectivity within an MST region for VLANs associated with the
default Common and Internal Spanning Tree (CIST) instance in your network (VLANs that have not been
mapped to an MST instance).

• MST Instance (mst):Connects all static and (from release 13.X.X ) dynamic VLANs assigned to a multiple
spanning tree instance.

Syntax:

show spanning tree root-history [cst | ist | mst] instance-id
Displays the change history for the root bridge in the specified MSTP topology.

cst
Displays the change history for the root bridge of a spanning tree network, including MST regions and STP
and RSTP bridges.

ist
Displays the change history for the root bridge in the IST instance of an MST region.

mst instance-id

Displays the change history for the root bridge in an MST instance, where instance-id is an ID number from 1
to 16.

Use the show spanning-tree root-history command to view the number and dates of changes in the
assignment of a root bridge. Possible intrusion into your MST network may occur if an unauthorized external
device gains access to a spanning tree by posing as the root device in a topology. To prevent an MST port
connected to the device from being selected as the root port in a topology, use the spanning-tree root-
guard command.

Sample output of the show spanning-tree root-history command for different MSTP topologies

The following examples show sample output of the show spanning-tree root-history command for
different MSTP topologies. In each example, the root bridge ID is displayed in the format: priority: mac-address

Where:

• priority

is the MSTP switch priority calculated for one of the following:
◦ The IST (regional) root switch using the spanning-tree priority command

◦ An MSTI root switch using the spanning-tree instance priority command

• mac-address

is the MAC address of the root (bridge) switch.
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Viewing show spanning-tree root-history CST output

Viewing show spanning-tree root-history IST output

Viewing show spanning-tree root-history MSTI output

Enabling traps and viewing trap configuration
Syntax
spanning-tree trap {errant-bpdu | loop-guard | new-root | root-guard}
no spanning-tree trap {errant-bpdu | loop-guard | new-root | root-guard}
Enables SNMP traps. The no form of the command disables SNMP traps.

Syntax

show spanning-tree traps
Displays the current spanning tree trap configuration on the switch.
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Viewing spanning tree traps in their default configuration

switch# show spanning-tree traps

 Status and Counters - STP Traps Information

 Trap Name              | Status
 ---------------------- + --------
 errant-bpdu            | Disabled
 new-root               | Disabled
 root-guard             | Disabled
 loop-guard             | Disabled

Viewing debug counters for all MST instances
The show spanning-tree debug-counters command allows you to display the aggregate values of all
MSTP debug counters that are maintained on a switch. These aggregate values are a summary of the information
collected from all ports and from all spanning tree instances that forward traffic on switch ports.

Use the displayed diagnostic information to globally monitor MSTP operation on a per-switch basis.

Syntax:

show spanning-tree debug-counters
Displays debug counters for MSTP activity on all ports configured for VLANs used in spanning tree instances.

Viewing output for debug counters

The following example shows sample output of the show spanning-tree debug-counters command for all
ports.

switch(config)# show spanning-tree debug-counters

 Status and Counters - MSTP Bridge Common Debug Counters Information

  Counter Name                      Aggregated Value Collected From
  --------------------------------- ---------------- -------------- 
  Invalid BPDUs                     0                CIST
  Errant BPDUs                      170927           CIST 
  MST Config Error BPDUs            0                CIST 
  Looped-back BPDUs                 0                CIST
  Starved BPDUs/MSTI MSGs           0                CIST/MSTIs 
  Exceeded Max Age BPDUs            0                CIST 
  Exceeded Max Hops BPDUs/MSTI MSGs 0                CIST/MSTIs 
  Topology Changes Detected         2                CIST/MSTIs
  Topology Changes Tx               6                CIST/MSTIs 
  Topology Changes Rx               4                CIST/MSTIs 
  Topology Change ACKs Tx           0                CIST 
  Topology Change ACKs Rx           0                CIST
  TCN BPDUs Tx                      0                CIST
  TCN BPDUs Rx                      0                CIST 
  CFG BPDUs Tx                      0                CIST 
  CFG BPDUs Rx                      0                CIST 
  RST BPDUs Tx                      0                CIST 
  RST BPDUs Rx                      0                CIST
  MST BPDUs/MSTI MSGs Tx            10               CIST/MSTIs
  MST BPDUs/MSTI MSGs Rx            341802           CIST/MSTIs
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Viewing debug counters for one MST instance
The show spanning-tree debug-counters instance command allows you to display the aggregate
values of all MSTP debug counters maintained on a switch for a specified spanning tree instance. These
aggregate values are a summary of information collected from all ports that have VLANs assigned to the specified
instance.

Use this command to troubleshoot the global MSTP diagnostic information displayed in show spanning-tree
debug-counters command output when you suspect unauthorized MSTP activity in a specific MST instance.

Syntax:

show spanning-tree debug-counters instance instance-id
Displays debug counters for MSTP activity on all ports configured for VLANs in the specified MST instance.

The valid values for instance instance-id are 0 to 16, where 0 specifies the default MST (CIST) instance and 1
to 16 specify a multiple spanning tree (MST) instance.

Viewing bug counters for a CIST instance

The following example shows sample output of the show spanning-tree debug-counters instance
command when applied to the Common and Internal Spanning Tree (CIST) instance (default MST instance 0) in
the network.

switch(config)# show spanning-tree debug-counters instance 0

 Status and Counters - CIST Common Debug Counters Information

  MST Instance ID : 0

  Counter Name                      Aggregated Value Collected From
  --------------------------------- ---------------- -------------- 
  Invalid BPDUs                     0                Ports
  Errant BPDUs                      172603           Ports
  MST Config Error BPDUs            0                Ports 
  Looped-back BPDUs                 0                Ports 
  Starved BPDUs                     0                Ports 
  Exceeded Max Age BPDUs            0                Ports 
  Exceeded Max Hops BPDUs           0                Ports 
  Topology Changes Detected         1                Ports 
  Topology Changes Tx               3                Ports 
  Topology Changes Rx               2                Ports 
  Topology Change ACKs Tx           0                Ports 
  Topology Change ACKs Rx           0                Ports 
  TCN BPDUs Tx                      0                Ports 
  TCN BPDUs Rx                      0                Ports 
  CFG BPDUs Tx                      0                Ports 
  CFG BPDUs Rx                      0                Ports 
  RST BPDUs Tx                      0                Ports 
  RST BPDUs Rx                      0                Ports 
  MST BPDUs Tx                      5                Ports 
  MST BPDUs Rx                      172577           Ports

Viewing debug counters for ports in an MST instance
The show spanning-tree debug-counters instance ports command displays the aggregate values of
all MSTP debug counters maintained on one or more ports used by a specified spanning tree instance. These
aggregate values are a summary of information collected from the specified ports that have VLANs assigned to
the specified instance.
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Use this command to troubleshoot at a finer level the more general MSTP diagnostic information displayed in the
show spanning-tree debug-counters instance command output, when you suspect unauthorized
MSTP activity on one or more MST ports in an MST instance.

Syntax:

show spanning-tree debug-counters instance instance-id ports port-list
Displays debug counters for MSTP activity on the specified ports configured for VLANs in the specified MST
instance.

instance instance-id

The valid values for instance-id are from 0 to 16, where 0 specifies the default MST (CIST) instance and 1 to
16 specify an MST instance.

ports port-list

Specifies one or more MST ports or trunk ports. In the port list, enter a series of ports by separating the first
and last ports in the series with a dash (-); for example, a2-a8 or trk1-trk3. Separate individual ports and
series of ports with a comma; for example, a2-a8, a20, trk1, trk4-trk5.

Viewing debug counters for a CIST and MST instance

The following example shows sample output of the show spanning-tree debug-counters instance
ports command for both the CIST (default MST instance 0) and an MST instance (instance 2) on port A15.

switch(config)# show spanning-tree debug-counters instance 0 ports a15

 Status and Counters - CIST Port(s) Debug Counters Information

  MST Instance ID : 0
  Port : A15

  Counter Name                Value      Last Updated
  --------------------------- ---------- ----------------- 
  Invalid BPDUs               0
  Errant BPDUs                0
  MST Config Error BPDUs      0
  Looped-back BPDUs           0
  Starved BPDUs               0
  Exceeded Max Age BPDUs      0
  Exceeded Max Hops BPDUs     0
  Topology Changes Detected   1         02/09/07 17:40:59
  Topology Changes Tx         3         02/09/07 17:41:03
  Topology Changes Rx         2         02/09/07 17:41:01
  Topology Change ACKs Tx     0
  Topology Change ACKs Rx     0
  TCN BPDUs Tx                0
  TCN BPDUs Rx                0
  CFG BPDUs Tx                0
  CFG BPDUs Rx                0
  RST BPDUs Tx                0
  RST BPDUs Rx                0
  MST BPDUs Tx                5         02/09/07 17:41:03
  MST BPDUs Rx                173540    02/13/07 18:05:34

Viewing debug counters output for one port in an MST instance

The following example shows spanning tree debug-counters instance ports command output for one port in an
MST instance.
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switch(config)# show spanning-tree debug-counters instance 2 ports a15

 Status and Counters - MSTI Port(s) Debug Counters Information

   MST Instance ID : 2
   Port : A15

   Counter Name                Value      Last Updated
   --------------------------- ---------- ----------------- 
   Starved MSTI MSGs           0
   Exceeded Max Hops MSTI MSGs 0
   Topology Changes Detected   1          02/09/07 17:40:59
   Topology Changes Tx         3          02/09/07 17:41:03
   Topology Changes Rx         2          02/09/07 17:41:01
   MSTI MSGs Tx                5          02/09/07 17:41:03
   MSTI MSGs Rx                173489     02/13/07 18:03:52

Field descriptions in MSTP debug command output
The following table contains descriptions of the debugging information displayed in the output of show
spanning-tree debug-counters commands.

Table 10: MSTP debug command output: field descriptions

Field Displays the number of...

Invalid BPDUs Received BPDUs that failed standard MSTP (802.1Q-REV/D5.0 14.4) validation
checks and were dropped. This counter is maintained by the CIST (default MST
instance 0) on a per-port basis.

Errant BPDUs Received BPDUs that were dropped on a port that is configured to not expect
BPDU packets. This counter is maintained by the CIST (MST instance, 0default
MST instance 0 in the network) on a per-port basis and is incremented each time a
BPDU packet is received on a port configured with the BPDU filter to ignore
incoming BPDU packets (spanning-tree bpdu-filter command) or the
BPDU protection feature to disable the port when BPDU packets are received
(spanning-tree bpdu-protection command).

MST Config Error
BPDUs BPDUs received from a neighbor bridge with inconsistent MST configuration

information. For example, BPDUs from a transmitting bridge may contain the same
MST configuration identifiers (region name and revision number) and format
selector as the receiving bridge, but the value of the Configuration Digest field
(VLAN ID assignments to regional IST and MST instances) is different. This
difference indicates a probable configuration error in MST region settings on the
communicating bridges. The received BPDU is still processed by MSTP.

This counter is maintained by the CIST (default MST instance 0) on a per-port
basis.

Looped-back BPDUs Times a port has received self-sent BPDU packets as the result of an external loop
condition in which the BPDUs were looped back to the originating transmission port.
The received BPDU is still processed by MSTP and the port changes to a blocked
state.

This counter is maintained by the CIST (default MST instance 0) on a per-port
basis.

Table Continued
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Field Displays the number of...

Starved BPDUs Times that no BPDUs are received within the scheduled interval (three times the
Hello Time value configured with the spanning-tree hello-time command)
from a downstream CIST-designated peer port on the CIST root, alternate, or
backup port. As a result, the "starved" port triggers a spanning tree topology
regeneration.

This counter is maintained by the CIST (default MST instance 0) on a per-port
basis.

Starved MSTI MSGs Times that no BPDUs are received within the scheduled interval (three times the
Hello Time value configured with the spanning-tree hello-time command)
from a downstream MSTI-designated peer port on the MSTI root, alternate, or
backup port. As a result, the "starved" port triggers a spanning tree topology
regeneration.

This counter is maintained by the CIST (default MST instance 0) on a per-port
basis.

Exceeded Max Age
BPDUs Times that a BPDU packet is received from a bridge external to the MST region with

a Message Age value greater than the configured value of the Max Age parameter
(spanning-tree maximum age command). This may occur if the receiving
bridge is located too far from the root bridge (beyond the configured size of the
spanning tree domain on the root bridge) or if a BPDU packet with invalid root
information is continuously circulating between bridges in a spanning tree domain
and needs to be aged out.

This counter is maintained by the CIST (default MST instance 0) on a per-port
basis.

Exceeded Max Hops
BPDUs Times that a BPDU packet is received from a bridge internal to the MST region with

a CIST Remaining Hops value less than or equal to 1. This may occur if the
receiving bridge is located too far from the CIST regional root bridge (beyond the
configured size of the MST region on the CIST regional root bridge) or if a BPDU
packet with invalid CIST regional root bridge information is continuously circulating
between bridges in the MST Region and needs to be aged out.

This counter is maintained by the CIST (default MST instance 0 in the region) on a
per-port basis.

Exceeded Max Hops
MSTI MSGs Times that an MSTI MSG packet is received from a bridge internal to the MST

region with an MSTI Remaining Hops value less than or equal to 1. This may occur
if the receiving bridge is located too far from the MSTI regional root bridge (beyond
the configured size of the MST region on the MSTI regional root bridge) or if a
BPDU packet with invalid MSTI regional root bridge information is continuously
circulating between bridges in an MST region and needs to be aged out.

This counter is maintained on a per-MSTI per-port basis.

Topology Changes
Detected Times that a Topology Change event is detected by the CIST or MSTI port and the

port triggers a topology change propagation throughout the network. A Topology
Change event occurs when a non-edge port enters forwarding state.

This counter is maintained on a per-CIST per-port and on a per-MSTI per-port
basis.

Table Continued
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Field Displays the number of...

Topology Changes Tx Times that Topology Change information is propagated (sent out) through the port
to the rest of the network.For a CIST port, the counter is the number of times that a
CFG, RST, or MST BPDU with the TC flag set is transmitted out of the port.For an
MSTI port, the counter is the number of times that an MSTI configuration message
with the TC flag set is transmitted out of the port.

This counter is maintained on a per-CIST per-port and on a per-MSTI per-port
bases.

Topology Changes Rx Times that Topology Change information is received from the peer port.For a CIST
port, the counter is the number of times that a CFG, RST, or MST BPDU with the
TC flag set is received.For an MSTI port, the counter is the number of times that an
MSTI configuration message with the TC flag set is received.

This counter is maintained on a per-CIST per-port and on a per-MSTI per-port
basis.

Topology Change
ACKs Tx Times that the Topology Change acknowledgement is transmitted through the port

(number of CFG, RST or MST BPDUs transmitted with the Topology Change
Acknowledge flag set).

This counter is maintained by the CIST (default MST instance 0) on a per-port
basis.

Topology Change
ACKs Rx Times the Topology Change acknowledgement is received on the port (number of

CFG, RST or MST BPDUs received with the Topology Change Acknowledge flag
set).

This counter is maintained by the CIST (default MST instance 0) on a per-port
basis.

TCN BPDUs Tx Topology Change Notification BPDUs that are transmitted through the port. This
counter is maintained by the CIST (default MST instance 0) on a per-port basis.

TCN BPDUs Rx Topology Change Notification BPDUs that are received on the port.

This counter is maintained by the CIST (default MST instance 0) on a per-port
basis.

CFG BPDUs Tx 802.1D Configuration BPDUs that are transmitted through the port.

This counter is maintained by the CIST (default MST instance 0) on a per-port
basis.

CFG BPDUs Rx 802.1D Configuration BPDUs that are received on the port.

This counter maintained by the CIST (default MST instance 0) on a per-port basis.

RST BPDUs Tx 802.1w RST BPDUs that are transmitted through the port.

This counter is maintained by the CIST (default MST instance 0) on a per-port
basis.

Table Continued
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Field Displays the number of...

RST BPDUs Rx 802.1w RST BPDUs that are received on the port.

This counter is maintained by the CIST (default MST instance 0) on a per-port
basis.

MST BPDUs Tx 802.1s MST BPDUs that are transmitted through the port.

This counter is maintained by the CIST (default MST instance 0) on a per-port
basis.

MST BPDUs Rx 802.1s MST BPDUs that are received on the port.

This counter is maintained by the CIST (default MST instance 0) on a per-port
basis.

MSTI MSGs Tx Times that a configuration message for a specific MSTI was encoded in (802.1s)
MST BPDUs that are transmitted through the port.

This counter is maintained on a per-MSTI per-port basis.

MSTI MSGs Rx Times that the MSTI detected a configuration message destined to the MSTI in
(802.1s) MST BPDUs received on the port.

This counter is maintained on a per-MSTI per-port basis.

Troubleshooting MSTP operation
Table 11: Troubleshooting MSTP operation

Problem Possible cause

Duplicate packets on a
VLAN, or packets not
arriving on a LAN at all.

The allocation of VLANs to MSTIs may not be identical among all switches in a
region.

A switch intended to
operate in a region does
not receive traffic from
other switches in the
region.

An MSTP switch intended for a particular region may not have the same configuration
name or region revision number as the other switches intended for the same region.
The MSTP configuration name (spanning-tree config-name command) and
MSTP configuration revision number (spanning-tree config-revision
command) must be identical on all MSTP switches intended for the same region.

Another possible cause is that the set of VLANs and VLAN ID-to-MSTI mappings
(spanning-tree instance vlan command) configured on the switch may not
match the set of VLANs and VLAN ID-to-MSTI mappings configured on other
switches in the intended region.

BPDU
BPDUs are data messages that are exchanged across the switches within an extended LAN that uses a spanning
tree protocol topology. BPDU packets contain information on ports, addresses, priorities, and costs.
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About BPDU protection
BPDU protection is a security feature designed to protect the active STP topology by preventing spoofed BPDU
packets from entering the STP domain. In a typical implementation, BPDU protection would be applied to edge
ports connected to end user devices that do not run STP. If STP BPDU packets are received on a protected port,
the feature will disable that port and alert the network manager via an SNMP trap as shown below.

BPDU protection enabled at the network edge

Viewing BPDU protection status
Syntax:
show spanning-tree bpdu-protection
Displays a summary listing of ports with BPDU protection enabled. To display detailed per port status information,
enter the specific port numbers as shown here.

Figure 13: Viewing BPDU protection status
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BPDU protected ports are displayed as separate entries of the spanning tree category within the configuration file.

Figure 14: Viewing BPDU filters using the show configuration command

Configuring BPDU filtering
The STP BPDU filter feature allows control of spanning tree participation on a per-port basis. It can be used to
exclude specific ports from becoming part of spanning tree operations. A port with the BPDU filter enabled will
ignore incoming BPDU packets and stay locked in the spanning tree forwarding state. All other ports will maintain
their role.

Syntax:
spanning-tree [port-list | all] bpdu-filter
no spanning-tree [port-list | all] bpdu-filter
Enables or disables the BPDU filter feature on specified port(s). This forces a port to always stay in the forwarding
state and be excluded from standard STP operation.

Sample scenarios in which this feature may be used are:

• To have STP operations running on selected ports of the switch rather than every port of the switch at a time.

• To prevent the spread of errant BPDU frames.

• To eliminate the need for a topology change when a port's link status changes. For example, ports that
connect to servers and workstations can be configured to remain outside of spanning tree operations.

• To protect the network from denial of service attacks that use spoofing BPDUs by dropping incoming BPDU
frames. For this scenario, BPDU protection offers a more secure alternative, implementing port shut-down and
a detection alert when errant BPDU frames are received.

CAUTION: Ports configured with the BPDU filter mode remain active (learning and forward frames);
however, spanning tree cannot receive or transmit BPDUs on the port. The port remains in a
forwarding state, permitting all broadcast traffic. This can create a network storm if there are any
loops (that is, trunks or redundant links) using these ports. If you suddenly have a high load,
disconnect the link and disable the bpdu-filter (using the no command).

Configuring BPDU filtering

To configure BPDU filtering on port a9, enter:

switch(config)# spanning-tree a9 bpdu-filter

Viewing BPDU filtering
Syntax:
spanning-tree show port configuration
Displays the BPDU filter state.
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Viewing BPDU filter status using the show spanning tree command

Viewing BPDU filters using the show configuration command

BPDU filters per port are displayed as separate entries of the spanning tree category within the configuration file.

Configuring and managing BPDU protection
BPDU protection is a security feature designed to protect the active STP topology by preventing spoofed BPDU
packets from entering the STP domain. In a typical implementation, BPDU protection would be applied to edge
ports connected to end user devices that do not run STP. If STP BPDU packets are received on a protected port,
the feature will disable that port and alert the network manager via an SNMP trap as shown in the following
diagram.

Figure 15: BPDU protection enabled at the network edge

The following commands allow you to configure BPDU protection on VLANs for which the port is a member.
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Syntax:

no spanning-tree port-list bpdu-protection
Enables/disables the BPDU protection feature on a port.

Default: Disabled.

Syntax:

no spanning-tree port-list bpdu-protection-timeout timeout
Configures the duration of time when protected ports receiving unauthorized BPDUs will remain disabled. The
default value of 0 (zero) sets an infinite timeout (that is, ports that are disabled by bpdu-protection are not, by
default, re-enabled automatically).

Default: 0

Range: 0 - 65535 seconds

Syntax:

no spanning-tree trap errant-bpdu
Enables/disables the sending of errant BPDU traps.

CAUTION: This command should only be used to guard edge ports that are not expected to
participate in STP operations. Once BPDU protection is enabled, it will disable the port as soon as
any BPDU packet is received on that interface.

Viewing BPDU protection status
Syntax:
show spanning-tree bpdu-protection [port-list]
Displays a summary listing of ports with BPDU protection enabled. To display detailed per-port status information,
enter the specific port number(s). BPDU protected ports are displayed as separate entries of the spanning tree
category within the configuration file.

Viewing BPDU protection status for specific ports

switch# show spanning-tree bpdu-protection 23-24

 Status and Counters - STP BPDU Protection Information

 BPDU Protection Timeout (sec) : 0
 BPDU Protected Ports : 23-24

  Port   Type      Protection State             Errant BPDUs
  ------ --------- ---------- ----------------- ------------
  23     100/1000T Yes        Bpdu Error        1
  24     100/1000T Yes                          0

Re-enabling a port blocked by BPDU protection
Ports disabled by BPDU Protection remain disabled unless BPDU Protection is removed from the switch or by
configuring a nonzero BPDU protection timeout. For example, if you want to re-enable protected ports 60 seconds
after receiving a BPDU, you would use this command:
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switch(config)# spanning-tree bpdu-protection-timeout 60

Enabling and disabling BPDU protection
Syntax:

no spanning-tree port-list bpdu-protection
Enables or disables BPDU protection on specified port(s).

Syntax:

no spanning-tree port-list bpdu-protection-timeout timeout
Configures the duration in seconds when protected ports receiving unauthorized BPDUs will remain disabled. The
default value of 0 (zero) sets an infinite timeout (that is, ports that are disabled by bpdu-protection are not, by
default, re-enabled automatically).

Range: 0-65535 seconds

Default: 0

Syntax:

no spanning-tree trap errant-bpdu
Enables or disables the sending of errant BPDU traps.

CAUTION: This command should only be used to guard edge ports that are not expected to
participate in STP operations. Once BPDU protection is enabled, it will disable the port as soon as
any BPDU packet is received on that interface.

Configuring BPDU protection

To configure BPDU protection on ports 1 to 10 with SNMP traps enabled, enter:

switch(config)# spanning-tree 1-10 bpdu protection
switch(config)# spanning-tree trap errant-bpdu
The following steps will then be set in progress:

1. When an STP BPDU packet is received on ports 1-10, STP treats it as an unauthorized transmission attempt
and shuts down the port that the BPDU came in on.

2. An event message is logged and an SNMP notification trap is generated.

3. The port remains disabled until re-enabled manually by a network administrator using the interface port-list
enable command.

NOTE: To re-enable the BPDU-protected ports automatically, configure a timeout period using the
spanning-tree bpdu-protection-timeout command.

Overview of MSTP BPDU throttling
When an STP enabled switch is hit by an MSTP BPDU storm, the CPU usage rises and the manageability of the
switch goes down. In the following figure, the switch is connected to a HUB where there is a loop. The switch
generates a single MSTP BPDU, which goes through the loop in the HUB and results in a BPDU storm eventually.
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Since all STP packets are taken to the CPU for processing, CPU usage goes high and the switch response slows
down. The switch can become unmanageable as a result of this BPDU storm. BPDU throttling will take care of
BPDU storms automatically through rate-limiting.

Figure 16: MSTP BPDU path

BPDU throttling is enabled when the spanning tree in MSTP mode is enabled. When spanning tree is enabled, all
modules and members are assigned corresponding throttle values from the configuration. The default throttle
value is 256.

An option is also provided to enabling/disabling BPDU throttling. This option is enabled by default if the switch
does not support “V1 modules”. The spanning tree is enabled in MSTP mode by default.

Configuring MSTP BPDU throttling
The CLI allows you to configure MSTP BPDU throttling.

Configuring MSTP BPDU throttling
Syntax

no spanning-tree bpdu-throttle [Throttle-Value]
Configures BPDU throttling on a device. BPDU throttling limits the number of BPDUs that are sent to the switch’s
CPU. The result prevents high CPU utilization on the switch when the network undergoes a broadcast storm or
loop. The BPDU throttle value is in packets per second (pps). The valid BPDU throttle values are 64, 128, and
256 pps. The default throttle value is 256 pps.

Show MSTP BPDU configuration
The CLI allows you to show MSTP BPDU throttling configurations.

Syntax

show spanning-tree bpdu-throttle
Displays the configured throttle value.

142 Aruba 2930F / 2930M Advanced Traffic Management Guide for
ArubaOS-Switch 16.08

Anexo 08 ITENS 8 E 9 (0592727)         SEI 0008478-63.2018.6.02.8000 / pg. 7746



Example

Show spanning-tree bpdu-throttle
BPDU Throttling State  : Enabled
BPDU Throttle value    : 256

Show running configuration
Syntax

show running configuration
Show running configuration will display any one of the following lines based on the configuration.

no spanning-tree bpdu throttle
spanning-tree bpdu throttle 128
spanning-tree bpdu throttle 64

PVST
PVST stands for Per-VLAN Spanning Tree. It allows for the creation of a spanning tree for each VLAN.

PVST protection and filtering
NOTE:

These options are available for switches that support the MSTP protocol only. They are not
supported for switches running RSTP.

PVST protection
If a switch in the core of a network receives Per Vlan Spanning Tree (PVST) BPDUs and forwards the
unrecognized PVST BPDUs on to MSTP-only switches, those switches then disconnect themselves from the
network. This can create instability in the network infrastructure.

When the PVST protection feature is enabled on a port and a PVST BPDU is received on that port, the interface
on which the PVST BPDU arrived is shut down, which isolates the sending switch from the rest of the network. An
event message is logged and an SNMP notification trap is generated. The errant BPDU counter
SwitchStpPortErrantBpduCounter is incremented. The PVST protection feature is enabled per-port.

Figure 17: PVST switch being isolated after sending a PVST BPDU
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NOTE: This is similar to the BPDU Guard feature where BPDU protection is applied to edge ports
connected to end user devices that do not run STP. If STP BPDU packets are received on a
protected port, the feature will disable that port and alert the network manager via an SNMP trap.

PVST filtering
If you configure a port for PVST filtering instead of PVST protection, the port remains in operation but traps are
still generated and the BPDU counter SwitchStpPortErrantBpduCounter is incremented.

CAUTION: Enabling the PVST filter feature allows the port to continuously forward packets without
spanning tree intervention, which could result in loop formation. If this occurs, disable the port and
then reconfigure it with these commands:

no spanning-tree port-list bpdu-filter
no spanning-tree port-list pvst-filter

Enabling and disabling PVST protection on ports
Syntax:

no spanning-tree port-list pvst-protection
Enables or disables PVST protection on the port(s) specified. The command indicates which ports are not
expected to receive any PVST BPDUs.

Default: Disabled on all ports.

Enabling PVST protection

To enable the PVST protection feature on ports 4 through 8, enter:

switch(config)# spanning-tree 4-8 pvst-protection
To disable the PVST protection feature on a port, for example, port 4, enter:

switch(config)# no spanning-tree 4 pvst-protection

Enabling and disabling PVST filters on ports
Syntax:

no spanning-tree port-list pvst-filter
Enables or disables PVST filters on the port(s) specified. The command indicates which ports are not expected to
receive any PVST BPDUs.

Default: Disabled on all ports

Enabling PVST filtering on a port

switch(config)# spanning-tree 8 pvst-filter

Warning: The BPDU filter allows the port to go into a continuousforwarding mode 
and spanning-tree will not interfere, even if the port would cause a loop to form 
in the network topology.
If you suddenly experience high traffic load, disable the port and reconfigure the 
BPDU filter with the CLI command(s):
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            "no spanning-tree PORT_LIST bpdu-filter"
            "no spanning-tree PORT_LIST pvst-filter"

Re-enabling a port manually
Syntax:

no spanning-tree bpdu-protection-timeout timeout
Configures the duration of time protected ports remain disabled. The default value of 0 sets an infinite timeout, so
ports that are disabled are not re-enabled automatically.

NOTE: This is a GLOBAL command.

Range: 0 - 65535 seconds

Default: 0

You can also set the timeout in the MIB with this MIB object: hpSwitchStpBpduProtectionTimeout
It is also possible to use the following automatic re-enable timer command:

switch(config)# spanning-tree bpdu-protection-timeout 120

Viewing ports configured with PVST protection and filtering

Viewing all ports with PVST protection enabled

switch(config)# show spanning-tree pvst-protection

Status and Counters - PVST Port(s) BPDU Protection Information

BPDU Protection Timeout (sec) : 0
PVST Protected Ports : 5-6

Viewing all ports with PVST filtering enabled

switch(config)# show spanning-tree pvst-filter
Status and Counters - PVST Port(s) BPDU Filter Information
PVST Filtered Ports : 8

Listing ports to see which have PVST protection or filtering enabled
Syntax:

show spanning-tree <port-list> detail
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Viewing if PVST protection is enabled (Yes)
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In cases where spanning tree cannot be used to prevent loops at the edge of the network, loop protection may
provide a suitable alternative. Loop protection operates in two modes:

Untagged

The default mode. This mode can be used to find loops in untagged downlinks.

Tagged VLAN

Finds loops on tagged VLANs. This mode can be used to detect loops in tagged-only uplinks where STP
cannot be enabled.

The cases where loop protection might be chosen ahead of spanning tree to detect and prevent loops are as
follows:

On ports with client authentication

When spanning tree is enabled on a switch that use 802.1X, Web authentication, and MAC authentication,
loops may go undetected. For example, spanning tree packets that are looped back to an edge port will not
be processed because they have a different broadcast/multicast MAC address from the client-authenticated
MAC address. To ensure that client-authenticated edge ports get blocked when loops occur, you should
enable loop protection on those ports.

On ports connected to unmanaged devices

Spanning tree cannot detect the formation of loops where there is an unmanaged device on the network that
does not process spanning tree packets and simply drops them. Loop protection has no such limitation, and
can be used to prevent loops on unmanaged switches.

Loop protection enabled in preference to STP

Configuring loop protection
Loop protection provides protection against loops by transmitting loop protocol packets out of ports on which loop
protection has been enabled. When the switch sends out a loop protocol packet and then receives the same
packet on a port that has a receiver-action of send-disable configured, it shuts down the port from which
the packet was sent.

Chapter 6
Loop protection
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Syntax:

no loop-protect port-list [[receiver-action [[send-disable] | [no-disable]]] | 
[transmit-interval 1-10] | [disable-timer 0-604800] | [trap loop-detected]] [mode] 
[[port] | [vlan]] [vlan vid-list]
Description

Configures per-port loop protection on the switch.

Options
receiver-action send-disable | no-disable

Sets the action to be taken when a loop is detected on the specified ports. The port that receives the loop
protection packet determines what action is taken. If send-disable is configured, the port that transmitted
the packet is disabled. If no-disable is configured, the port is not disabled when a loop is detected.

NOTE: The port will not transmit loop protection packets unless it is a member of an untagged
VLAN. If a port is only a member of tagged VLANs, the loop protection packets are not
transmitted.

Default: send-disable
trap loop-detected

Configures loop protection traps for SNMP indicating when a loop has been detected on a port.

disable-timer 0-604800
Configures how long (in seconds) a port is disabled when a loop has been detected. A value of zero disables
the auto re-enable function.

Default: Timer is disabled

transmit-interval 1-10
Configures the time in seconds between the transmission of loop protection packets.

Default: 5 seconds

{mode port | vlan}
Configures loop protection in port or VLAN mode.

vlan vid-list
Configures the VLANs on which loop-protect is enabled. Maximum number of loop-protected VLANs is 32.

Enabling loop protection in port mode
Follow these steps.

Procedure

1. Configure port mode with this command:

switch(config)# loop-protect mode port
2. Enter the loop-protect command and specify the ports on which loop protection should be enabled. For

example:
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switch(config)# loop-protect 1-2
3. Optionally specify receiver-action of send-disable to shut down the port in the event of a loop. For

example:

switch(config)# loop-protect 1-2 receiver-action send-disable

Enabling loop protection in VLAN mode
VLANs can be configured for loop protection only when operating in VLAN mode. When loop-protect is
enabled for a VLAN and a loop-protect enabled interface is a member of that VLAN, loop protect packets are
sent on that VLAN to detect loops.

To enable loop protection in VLAN mode:

Procedure

1. Configure VLAN mode with the command:

switch(config)# loop-protect mode vlan
2. Enter the loop-protect command and specify the VLANs on which loop protection should be enabled. For

example:

switch(config)# loop-protect vlan 20,30

Changing modes for loop protection
When changing from VLAN mode to port mode, you are prompted with the message shown below. The VLANs
will no longer be configured for loop protection.

Changing modes for loop protection

switch(config)# loop-protect mode port
Any Loop Protect enabled VLAN will be deleted. Do you want to continue [Y/N]? 
N
      

Viewing loop protection status in port mode
Syntax:

show loop-protectport-list
Displays the loop protection status for ports. If no ports are specified, the information is displayed only for the
ports that have loop protection enabled.

Viewing loop protection information for port mode

switch(config)# show loop-protect 1-2

 Status and Counters - Loop Protection Information

 Transmit Interval (sec)    : 5
 Port Disable Timer (sec)   : 5
 Loop Detected Trap         : Enabled
 Loop Protect Mode          : Port
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 Loop Protect Enabled VLANs :

     Loop    Loop     Detected  Loop     Time Since  Rx          Port
Port Protect Detected on VLAN   Count    Last Loop   Action      Status
---- ------- -------- --------- -------- ----------- ----------  ---------
1    Yes     Yes        NA      1        5s         send-disable Down
2    Yes     No         NA      0                   send-disable Up

Viewing loop protection status in VLAN mode
Syntax:

show loop-protect port-list
Displays the loop protection status for VLANs. If no ports are specified, the information is displayed only for the
ports that have loop protection enabled.

Viewing loop protection information for VLAN mode

switch(config)# show loop-protect 1-2

 Status and Counters - Loop Protection Information

 Transmit Interval (sec)   : 5
 Port Disable Timer (sec)  : 5
 Loop Detected Trap        : Enabled
 Loop Protect Mode         : Vlan
 Loop Protect Enabled VLANs : 20,30

      Loop   Loop     Detected  Loop     Time Since  Rx          Port
Port Protect Detected on VLAN   Count    Last Loop   Action      Status
---- ------- -------- --------- -------- ----------- ----------  ---------
1    Yes     Yes        20      1        45s        send-disable Down
2    Yes     No                 0                   send-disable Up

STP loop guard
Spanning Tree (STP) is used to ensure a loop-free topology over the LAN. Occasionally a hardware or software
failure can cause STP to fail, creating STP/forwarding loops that can cause network failures where unidirectional
links are used. The non-designated port transitions in a faulty manner because the port is no longer receiving STP
BPDUs.

STP Loop Guard causes the non-designated port to go into the STP loop inconsistent state instead of the
forwarding state. In the loop-inconsistent state, the port prevents data traffic and BPDU transmission through the
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link, therefore avoiding the loop creation. When BPDUs again are received on the inconsistent port, it resumes
normal STP operation automatically. STP loop guard is best applied on blocking or forwarding ports.

Figure 18: Loop creation with transmission failure

Syntax:
spanning-tree port-list loop-guard
no spanning-tree port-list loop-guard
Enables STP loop guard on a particular port or ports. The no form of the command disables STP loop guard.

Default: Disabled.

Enabling spanning tree loop guard on Port 2 and Viewing the port's status

switch(config)# spanning-tree 2 loop-guard

switch(config)# show spanning-tree

 Multiple Spanning Tree (MST) Information

  STP Enabled   : Yes
  Force Version : MSTP-operation
  IST Mapped VLANs : 1-4094
  Switch MAC Address : 0024a8-d13a40
  Switch Priority    : 32768
  Max Age  : 20
  Max Hops : 20
  Forward Delay : 15

  Topology Change Count  : 1
  Time Since Last Change : 20 mins

  CST Root MAC Address : 001083-847000
  CST Root Priority    : 0
  CST Root Path Cost   : 60000
  CST Root Port        : 1

  IST Regional Root MAC Address : 0024a8-d13a40
  IST Regional Root Priority    : 32768
  IST Regional Root Path Cost   : 0
  IST Remaining Hops            : 20

  Root Guard Ports     : 
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  Loop Guard Ports     : 2
  TCN Guard Ports      : 
  BPDU Protected Ports : 
  BPDU Filtered Ports  : 
  PVST Protected Ports : 
  PVST Filtered Ports  :

                 |           Prio              | Designated    Hello
Port   Type      | Cost      rity State        | Bridge        Time PtP Edge
------ --------- + --------- ---- ------------ + ------------- ---- --- ----
1      100/1000T | 20000     128  Forwarding   | 001871-cdea00 2    Yes No
2      100/1000T | Auto      128  Inconsistent |
3      100/1000T | Auto      128  Disabled     |
4      100/1000T | Auto      128  Disabled     |
5      100/1000T | Auto      128  Disabled     |
6      100/1000T | Auto      128  Disabled     |
7      100/1000T | Auto      128  Disabled     |
8      100/1000T | Auto      128  Disabled     |

Viewing summary spanning tree configuration information

switch(config)# show spanning-tree config

 Multiple Spanning Tree (MST) Configuration Information

  STP Enabled [No] : Yes
  Force Version [MSTP-operation] : MSTP-operation
  Default Path Costs [802.1t] : 802.1t
  MST Configuration Name : 0024a8d13a40
  MST Configuration Revision : 0       Switch Priority : 32768
  Forward Delay [15] : 15              Hello Time [2] : 2
  Max Age [20] : 20                    Max Hops [20] : 20
  
               | Path      Prio Admin Auto Admin Hello  Root  Loop  TCN   BPDU
Port Type      | Cost      rity Edge  Edge PtP   Time   Guard Guard Guard Flt
---- --------- + --------- ---- ----- ---- ----- ------ ----- ----- ----- ---
1    100/1000T | Auto      128  No    Yes  True  Global No    No    No    No
2    100/1000T | Auto      128  No    Yes  True  Global No    Yes   No    No
3    100/1000T | Auto      128  No    Yes  True  Global No    No    No    No
4    100/1000T | Auto      128  No    Yes  True  Global No    No    No    No
5    100/1000T | Auto      128  No    Yes  True  Global No    No    No    No
6    100/1000T | Auto      128  No    Yes  True  Global No    No    No    No
.
.
.

Viewing detailed spanning tree configuration information

switch(config)# show spanning-tree detail

 Status and Counters - CST Port(s) Detailed Information
  Port                     : 1
  Status                   : Up
.
.
.

  Port                     : 2
  Status                   : Up
  BPDU Protection          : No
  BPDU Filtering           : No
  PVST Protection          : No
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  PVST Filtering           : No
  Errant BPDU Count        : 0
  Root Guard               : No
  Loop Guard               : Yes
  TCN Guard                : No
  MST Region Boundary      : Yes
  External Path Cost       : 20000
  External Root Path Cost  : 40000
  Administrative Hello Time: Global
  Operational Hello Time   : 2
  AdminEdgePort            : No
  Auto Edge Port           : Yes
  OperEdgePort             : No
  AdminPointToPointMAC     : True
  OperPointToPointMAC      : Yes
  Aged BPDUs Count         : 0
  Loop-back BPDUs Count    : 0
  TC ACK Flag Transmitted  : 0
  TC ACK Flag Received     : 1

 MST        MST        CFG        CFG        TCN        TCN
 BPDUs Tx   BPDUs Rx   BPDUs Tx   BPDUs Rx   BPDUs Tx   BPDUs Rx
 ---------- ---------- ---------- ---------- ---------- ----------
 3          0          24354      1682       0          13

Viewing spanning tree configuration information for a single port

switch(config)# show spanning-tree 2

 Multiple Spanning Tree (MST) Information

  STP Enabled   : Yes
  Force Version : MSTP-operation
  IST Mapped VLANs : 1-4094
  Switch MAC Address : 0024a8-d13a40
  Switch Priority   : 32768
  Max Age : 20
  Max Hops : 20
  Forward Delay : 15

  Topology Change Count  : 1
  Time Since Last Change : 58 mins

  CST Root MAC Address : 001083-847000
  CST Root Priority   : 0
  CST Root Path Cost  : 60000
  CST Root Port       : 1

  IST Regional Root MAC Address : 0024a8-d13a40
  IST Regional Root Priority   : 32768
  IST Regional Root Path Cost  : 0
  IST Remaining Hops           : 20

  Root Guard Ports     : 
  Loop Guard Ports     : 2
  TCN Guard Ports      : 
  BPDU Protected Ports : 
  BPDU Filtered Ports  : 
  PVST Protected Ports : 
  PVST Filtered Ports  :

                 |           Prio              | Designated    Hello
Port   Type      | Cost      rity State        | Bridge        Time PtP Edge
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------ --------- + --------- ---- ------------ + ------------- ---- --- ----
2      100/1000T | Auto      128  Inconsistent |

Operating notes
• The receiver-action option can be configured on a per-port basis and can only be enabled after loop

protection has been enabled on the port. All other configuration options (disable-timer, trap loop-detected, and
transmit interval) are global.

• The trap option refers to an SNMP trap.

• Regardless of how the receiver-action and trap options are configured, all detected loops will be logged
in the switch's event log.

• The no loop-protect port command will not remove a receive-action configuration line from the running
configuration unless this option is set to receive-action send-disable.

• If loop-protect is enabled in port mode, it cannot also be enabled in VLAN mode, and vice-versa.
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PVLAN introduction
A PVLAN (private VLAN) is an extension of a regular VLAN to help restrict traffic between users on the same
VLAN.

The "private" in private VLAN refers to the restriction of the switch ports in the VLAN, called "private ports." Ports
in a PVLAN can communicate only with a specified uplink port and with specified ports within the same VLAN.

A PVLAN consists of a regular VLAN that is partitioned into primary and secondary VLANs. The partitioned
regular VLAN becomes the primary VLAN. Secondary VLANs are associated with the primary VLAN, have unique
VLAN IDs, and have different types—isolated and community—that determine how and to where packets can be
forwarded.

Private VLANs and regular VLANs can coexist on the same switch.

Typical uses for PVLANs include the following:

• Shared environments in which ports can be isolated from each other at the data link layer (for security,
performance, or other reasons), while belonging to the same IP subnet. For example:

◦ Hotels in which each room has a port for Internet access.

◦ Networks configured to allow onsite access to vendors or contractors while keeping them isolated from the
rest of the customer network.

◦ ISP colocation in a data center.

• IP address conservation and efficient IP address assignment. Hosts in secondary VLANs remain in a separate
broadcast domain, but belong to the same IP subnet. Hosts in secondary VLANs are assigned IP addresses
based on the IP subnets associated with the primary VLAN.

• Backup networks, in which the backup server is in a PVLAN, and all the hosts using the backup server are
configured on isolated secondary VLANs.

PVLAN structure

Primary VLAN

The primary VLAN is the standard VLAN that is partitioned to create the PVLAN. The primary VLAN delivers
traffic downstream from the router to all mapped hosts, and contains the uplink from the connected devices to the
router.

The secondary VLANs must use the primary VLAN to communicate with other secondary VLANs or to VLANs
outside the PVLAN. This communication occurs through one or more promiscuous ports associated with the
primary VLAN.

Chapter 7
Private VLANs
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By default, all ports in the primary VLAN act as promiscuous ports.

Figure 19: Primary VLAN in PVLAN
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Secondary VLANs
Isolated VLAN

Ports in an isolated VLAN can communicate using Layer 2 with the promiscuous ports of the primary VLAN
only. The ports that are associated with an isolated VLAN do not have Layer 2 connectivity between each
other, but hosts can communicate with each other using a Layer 3 device.

Figure 20: Isolated VLAN communications

Community VLAN

The ports associated with a community VLAN can communicate using Layer 2 with each other and with the
primary VLAN, but not directly with ports in other community VLANs.
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For one community VLAN port to communicate with a different community VLAN port, the port traffic must go
through the Layer 3 device.

Figure 21: Community VLAN communications

PVLAN port types
PVLANs (private VLANs) have the following types of ports:

• Promiscuous ports

• Community ports

• Isolated ports

• Interswitch link (ISL) ports (PVLAN member ports)

A port in a PVLAN is exactly one type.

Community port
A community port is a host access port in a community VLAN. Community ports can communicate on the Layer 2
level with the following ports:

• Other community ports in the same community VLAN

• Associated promiscuous ports in the primary VLAN

Community ports cannot communicate on the Layer 2 level with ports in any other community or isolated VLAN in
the private VLAN.
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Isolated ports
An isolated port is a host access port in an isolated VLAN. Isolated ports can communicate on the Layer 2 level
with associated promiscuous ports in the primary VLAN only.

Isolated ports cannot communicate on the Layer 2 level with any other ports in the private VLAN (PVLAN)
domain, including other ports in the same isolated VLAN.

However, if the switch that has the isolated port does not have a promiscuous port, traffic from the isolated VLAN
ports can traverse through interswitch link (ISL) ports (PVLAN member ports) to a switch that has a promiscuous
port.

Promiscuous ports
A promiscuous port is a switch port that is connected to a router, firewall, Level 3 switch, or other Common
Gateway device. Promiscuous ports can communicate with all types of ports within a PVLAN (private VLAN)
domain, including community ports and isolated ports.

• Promiscuous ports must be members of the primary VLAN.

• By default, every port in the primary VLAN is configured as a promiscuous port.

Interswitch link (ISL) ports (PVLAN member ports)
Interswitch link (ISL) ports (PVLAN member ports) connect multiple switches in a PVLAN domain.

Interswitch link (ISL) is a generic term to describe a connection between ports on different switches.

In ArubaOS-Switch software:

• Ports used for interswitch links in PVLANs are called "PVLAN member ports" because they automatically
become members of all VLANs within the PVLAN (that is, the primary VLAN, the community VLANs and the
isolated VLANs). They carry traffic from the primary VLAN and all secondary VLANs between switches.

The port type displayed for a PVLAN member port in show commands is: Member
• PVLAN member ports are primary VLAN ports that are configured to remove the promiscuous port interface.

Traffic forwarding through interswitch links
Consider a PVLAN network topology where secondary VLANs have been configured on a set of access switches
but only one of these switches has uplink connectivity. The secondary VLAN traffic on switches that do not have
an uplink configured must be forwarded through interswitch links to the device that has an uplink.

As secondary VLAN traffic traverses the interswitch links, all switches in the path use the secondary VLAN
information carried in the frame to ensure that PVLAN traffic forwarding rules are preserved.

For example, for an isolated VLAN, each switch must ensure the following:
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• Traffic from the isolated VLAN is forwarded to a switch that has a promiscuous port.

• Traffic from an isolated VLAN is not forwarded to any local community ports or to other isolated VLANs.

Figure 22: Interswitch link traffic forwarding

Example PVLAN Configuration
Consider the following PVLAN network scenario:

• VLAN 300 has been partitioned into a PVLAN (private VLAN), across two switches, consisting of the following
VLANs and ports:

◦ The primary VLAN (VLAN 300) with the following ports:

– One promiscuous port connected to a router.

– One port trunk configured as an interswitch link.

◦ One isolated VLAN (VLAN 301) with two ports.

◦ Two community VLANs (VLAN 302 and VLAN 303), each with two ports.

• The two switches also carry normal VLAN traffic for VLAN 5 and VLAN 6.

At the Layer 2 level in the PVLAN:
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• The promiscous port can communicate with all the other ports, including ports in the isolated VLAN and
through interswitch link (ISL) ports (PVLAN member ports).

• The community VLAN ports can communicate with the promiscuous port or other ports in the same community
VLAN. The community VLAN ports cannot communicate with ports in any isolated VLAN or in other community
VLANs. Traffic from community VLAN ports can traverse through interswitch link (ISL) ports (PVLAN member
ports) to other ports belonging to the same community VLAN.

• The isolated VLAN ports can communicate with the promiscuous port only. However, traffic from the isolated
VLAN ports can traverse through interswitch link (ISL) ports (PVLAN member ports) to a switch that has a
promiscuous port.

Example commands

The following example lists the commands used to configure the PVLAN and interswitch links on one of the
switches in the network scenario.

In the example, the number sign (#) delimits comments to you--the reader. Do not enter comments as commands.

# Configure the normal VLANs #
vlan 5
vlan 6
vlan 300

# Configure the normal VLAN host access ports #
vlan 5 untagged 1/11-1/12
vlan 6 untagged 1/13-1/14

# Configure VLAN 300 as a private VLAN #
vlan 300 private-vlan primary
vlan 300 private-vlan isolated 301
vlan 300 private-vlan community 302-303
         
# Configure port A2 as a promiscuous port #
# private-vlan promiscuous is the default configuration #
# for all primary VLAN ports, so you do not have to specify it explicitly  #
vlan 300 untagged A2

# Configure the isolated host access ports #         
vlan 301 untagged 1/8-1/9
    
# Configure the community host access ports #         
vlan 302 untagged 1/17-1/18
vlan 303 untagged 1/19-1/20
    
# Configure interswitch links A3 and A4 as a trunk port group to carry both PVLAN #
# and normal VLAN traffic #

trunk 1/A3,1/A4 trk1 lacp
vlan 300 tagged trk1
vlan 5 tagged trk1
vlan 6 tagged trk1
no interface trk1 private-vlan promiscous

# private-vlan promiscuous is the default configuration for primary VLAN ports #
# You configure ports as interswitch links by #
# removing the promiscuous port configuration #
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Configuring PVLANs
Procedure

1. Create the primary VLAN.

2. (Optional) Add an isolated VLAN.

3. If the PVLAN contains multiple switches, configure interswitch links.

Creating a primary VLAN

Prerequisites

You must be in the global configuration context: switch(config)#

Procedure

Configure a VLAN as the primary VLAN in the private VLAN.

Use the following command:

vlan <VLAN-ID> private-vlan primary
<VLAN-ID>

Specifies the VLAN ID of an existing VLAN or a VLAN you are creating.

For example, the following command configures VLAN 300 as the primary VLAN:

switch(config)# vlan 300 private-vlan primary

Adding the isolated VLAN

Prerequisites

• The primary VLAN must exist in the configuration.

• The isolated VLAN must not exist in the configuration.

• You must be in the global configuration context: switch(config)#

Procedure

Add the isolated VLAN by entering the following command:

vlan <VLAN-ID> private-vlan isolated <Isolated-VLAN-ID>
<VLAN-ID>

Specifies the ID of the primary VLAN.

<Isolated-VLAN-ID>

Specifies the ID of the isolated VLAN.

For example, to add VLAN 301 as the isolated VLAN associated with VLAN 300, enter the following command:
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switch(config)# vlan 300 private-vlan isolated 301

Adding community VLANs

Prerequisites

• The primary VLAN must exist in the configuration.

• The community VLANs must not exist in the configuration.

• You must be in the global configuration context: switch(config)#

Procedure

Add community VLANs by entering the following command:

vlan <VLAN-ID> private-vlan community <VLAN-ID-LIST>
<VLAN-ID>

Specifies the ID of the primary VLAN.

<VLAN-ID-LIST>

Specifies a list of the VLAN IDs of the community VLANs you are adding. Separate individual VLAN IDs with
commas. Specify ranges of VLAN IDs with hyphens.

For example, enter the following command to add VLAN IDs 302 and 303 as community VLANs associated with
primary VLAN 300:

switch(config)# vlan 300 private-vlan community 302,303

Adding ports to PVLANs

Prerequisites

• The PVLAN must exist in the configuration.

• You must be in the global configuration context: switch(config)#

Procedure

• Adding a port to a primary or secondary VLAN in a PVLAN is the same as adding a port to a regular VLAN.

For example, to add port 1/17 as an untagged port to community VLAN 302, enter the following command:

switch(config)# vlan 302 untagged 1/17
• To add promiscuous ports to the primary VLAN, add the ports to the primary VLAN.

Because all primary VLAN ports act as promiscuous ports by default, you do not need to configure primary
ports as promiscuous ports explicitly.

• To add interswitch link (ISL) ports (PVLAN member ports), you must change the configuration of ports in the
primary VLAN. See Configuring interswitch link (ISL) ports (PVLAN member ports) on page 163.

Configuring interswitch link (ISL) ports (PVLAN member ports)
To configure an interswitch link, you must change the configuration of an existing promiscuous port or trunk group
in the primary VLAN on each of the two switches in the link.
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Prerequisites

• The primary VLAN must exist in the configuration.

• You must be in the global configuration context: switch(config)#

Procedure

• To configure a single port as an interswitch link (PVLAN member port):

1. Choose the port to be used for the interswitch link and remove the existing (default) promiscuous port
configuration setting for that interface.

For example:

switch-A(config)# no interface 1/A3 private-vlan promiscuous

• To configure a port trunk group as an interswitch link (PVLAN member):

1. Choose the trunk group to be used for the interswitch link and remove the existing (default) promiscuous
port configuration setting for that interface.

For example:

switch-A(config)# no interface trk1 private-vlan promiscuous

Adding an interswitch link between two switches for VLAN 300

The interface you choose on the second switch does not have to match the interface you choose on the first
switch.

Switch A commands:

switch-A(config)# vlan 300 tagged 1/A3
switch-A(config)# no interface 1/A3 private-vlan promiscous
Switch B commands:

switch-B(config)# vlan 300 tagged 1/A3
switch-B(config)# no interface 1/A3 private-vlan promiscous
You can also configure port trunk groups as an interswitch link. You can use either a static trunk or a static LACP
trunk.

This example shows configuring a trunk group, adding the trunk group to the PVLAN as a tagged interface, and
then configuring that trunk group as an interswitch link.

IMPORTANT: Configure port trunking before you connect the trunked links between switches.
Otherwise, a broadcast storm could occur. (If you want to connect the ports before configuring them
for trunking, you can temporarily disable the ports until the trunk is configured.) For more information
about port trunking, see the ArubaOS-Switch Management and Configuration Guide.

switch-A(config)# switch-A(config)# trunk 1/A3,1/A4 trk1 lacp
switch-A(config)# vlan 300 tagged trk1
switch-A(config)# no interface trk1 private-vlan promiscous
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Configuring promiscuous ports
By default, all ports in the primary VLAN of a private VLAN are configured as promiscuous ports. You do not need
to configure an interface as promiscuous unless it has previously been configured as an interswitch link (ISL) port
(PVLAN member port).

Prerequisites

You must be in the global configuration context: switch(config)#

Procedure

To configure an interface as a promiscuous port, enter the following command:

interface <port-list> private-vlan promiscuous
<port-list>

Specifies the list of ports, separated by commas for individual ports or hyphens for ranges of ports.

For example, the following command to configure interfaces 1/2 and 1/3 as promiscuous ports in the private
VLAN to which they belong.

switch-A(config)# interface 1/2,1/3 private-vlan promiscuous

Rules for configuring PVLANs

• The default VLAN (VLAN 1) cannot be configured as a PVLAN.

• An existing VLAN cannot be configured as a secondary VLAN in a PVLAN.

• A secondary VLAN cannot be reconfigured as the primary VLAN and a primary VLAN cannot be reconfigured
as a secondary VLAN.

To change the VLAN types, you must reconfigure the primary VLAN as a normal VLAN, and then reconfigure
the PVLAN.

• You cannot reconfigure or delete a primary VLAN until its associated secondary VLANs have been deleted.

• A PVLAN cannot be configured as a Management VLAN.

• For information about rules for PVLANs when used with other networking features, see PVLAN Interaction
with other features on page 166.

Rules for assigning ports in PVLANs

• An access port—which is directly connected to a host—can belong to one secondary VLAN in the PVLAN only.

• Promiscuous ports can be members of the primary VLAN only.

• Ports can be one type only: promiscuous, community, isolated, or interswitch link (PVLAN member port)

Configuration limits for PVLANs
The following are configuration limits for PVLAN instances on a switch:
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• Maximum number of primary VLANs: 16

• Maximum number of community VLANs in a PVLAN: 8

• Maximum number of isolated VLANs in a PVLAN: 1

• Maximum number of interswitch links: No configuration limit.

PVLAN Interaction with other features
Features you configure on the primary VLAN only

The following features are not permitted to be configured on secondary VLANs. The configuration of this feature
on the primary VLAN is automatically applied to the secondary VLANs.

• Local-proxy ARP

• Proxy ARP

• DHCP snooping

• DHCPv6 Snooping

• UDP forwarder

• RA Guard

• ND Snooping

• DARPP

• DIPLD v4/v6

• IGMP Snooping

• MLD Snooping

• IPv4/v6 Address

• ND

• IP Directed Broadcast, DHCP Relay, UDP-broadcast-fwd

• Disable-Layer3

• Jumbo-MTU

• DHCP Server

• IP-Recv-MAC

• VRRP

• IRDP

• BGP

• OSPF

• OSPF3

• RIP

• MSTP vlan-instance map

• Smartlink
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• Neighbor Discovery configurations

• Static routes

• Source routes

• Source interface

• Source VLAN for traceroute

• DT peer interface

• Ping (source VLAN configuration)

• Voice VLAN

Features to configure the same on all VLANs in a PVLAN

For the following features, Hewlett Packard Enterprise recommends that you apply the same configuration to the
primary and all secondary VLANs. If you do not apply the same configuration to all the VLANs in the PVLAN
domain, the feature might function in partial or suboptimal ways.

For example, locking down a MAC address (using the Static-MAC feature) on a port and a specific VLAN only
restricts the MAC address on that VLAN. The client device with that MAC address can access other VLANs on
the same port or through other ports. If you create a PVLAN by partitioning a VLAN that uses the Static-MAC
feature, Hewlett Packard Enterprise recommends that you apply the same Static-MAC configurations to the
secondary VLANs.

• DST-IP, L4-7 ACL

• DST-IP, L4-7 Policy Based Mirror

• QoS

• Static-MAC

Features not permitted on PVLANs

The following features are not permitted to be configured on PVLANs:

• Primary-vlan (PVLANs cannot be configured as the primary regular VLAN.)

• Management-vlan

• Protocol-vlan

• Level 3 mulitcast protocols and routing

• PVST

• RPVST

• LLDP radio ports

• Out Mirroring

• Distributed trunking, including Dynamic LACP trunk ports

• GVRP

• MVRP

• PIM
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• QinQ

• VLAN source filtering

• BYOD onboarding VLAN

• OpenFlow

• Isolate-list

• Forbidden ports

• Untrusted port configuration on a primary VLAN port

Security interactions with PVLANs

DHCP and PVLANs

• Ports in the primary VLAN are trusted ports by default.

• The following features cannot be configured on a secondary VLAN:

◦ DHCP snooping

◦ DHCPv6 snooping

◦ DHCP relay

◦ DHCP server

◦ DHCP client

◦ DHCP server IPv4/IPv6 address configuration

◦ IPv4/IPv6 gateway address configuration

◦ Static IP binding in the DHCP binding database

When you configure any of these features on a primary VLAN, the configuration automatically applies to all
secondary VLANs associated with that primary VLAN.

• You can use the show dhcp-snooping binding private-vlan command to show DHCP snooping
information for primary and secondary VLANs in the PVLAN.

Dynamic IP lockdown and PVLANs
When a PVLAN is configured, the output of the show ip source-lockdown command is affected as follows:

show ip source-lockdown status
Shows the port state as active even if the port is associated with a secondary VLAN and DHCP snooping is
enabled on the corresponding primary VLAN.

show ip source-lockdown bindings
The VLAN field shows the primary VLAN only.
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ARP and PVLANs

• Proxy ARP cannot be enabled on interfaces that are in a PVLAN.

• Local proxy ARP cannot be enabled on interfaces that are in a PVLAN.

• Dynamic ARP protect can be configured on primary VLANs only:

◦ In ip source binding commands, you must specify the VLAN ID of the primary VLAN.

◦ The show arp-protect command shows primary VLANs only.

Multicast interactions with PVLANs
The following Layer 2 multicast protocols are supported on PVLANs:

IGMPv2

You can enable IGMP on the primary VLAN in a PVLAN only. Use the MAC lookup mode of IGMP (igmp
lookup-mode mac) only. IP lookup mode is not supported.

MLDv1 and MLDv2

You can enable MLD on the primary VLAN in a PVLAN only.

Filter consumption increases when IGMP or MLD is enabled on a PVLAN because a filter is allocated for the
primary VLAN and for every secondary VLAN when a host connected to a PVLAN joins a multicast group.

PIM is not supported on PVLANs.

Showing PVLAN configurations
Procedure

• To show all configured PVLANs, enter the show vlans private-vlan command without specifying
parameters.

switch(config)# show vlans private-vlan

 Configuration and Association – private VLANs

  primary  secondary  VLAN Type  
  -------  ---------  ---------
  300      301        isolated
           302        community
           303        community  

• To show information about a specific PVLAN, enter the show vlans [<VLAN-ID>] private-vlan
command and specify the VLAN ID of a VLAN in the PVLAN.

Example output if the VLAN is a primary VLAN:

switch(config)# show vlans 300 private-vlan 

 Private VLAN Configuration Information: VLAN 300
  VLAN Type : primary

  Port Type         Ports       
  ------------      ----
  Promiscuous       1/A2
  Member            Trk1
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 Associated Secondary VLANs:

  VLAN ID   VLAN type    Access Ports 
  -------   ---------    ------------  
  301       isolated     1/8-1/9,Trk1
  302       community    1/17-1/18,Trk1
  303       community    1/19-1/20,Trk1
Example output if the VLAN is a secondary VLAN:

(config)# show vlans 301 private-vlan

 Private VLAN Configuration Information: VLAN 301
  VLAN Type     : isolated  
  Access ports  : 1/8-1/9,Trk1
 
 Associated Primary VLAN: 300

  Port Type         Port       
  -----------       ----
  Promiscuous        1/A2
  Member             Trk1

• To show the promiscuous ports of all PVLANs, enter the show private-vlan promiscuous-ports
command.

switch(config)# show private-vlan promiscuous-ports

  primary VLAN    Port  
  -------------  ------    
  300             1/A2 

Examples: show vlans command with PVLANs
When PVLANs (private VLANs) are configured, the output of the show vlans command includes information
about the private VLANs.

Example output when a PVLAN is configured

(config)# show vlans 300

 VLAN ID : 300
 Name : VLAN300
 Status : Port-based
 Voice : No
 Jumbo : No
 Private VLAN: primary
 Associated Primary VID :  None
 Associated Secondary VIDs : 301-303

 Port Information   Mode       Unknown VLAN    Status
 ------------------ -------    --------------  --------
 1/A2               Untagged   Learn           Up
 Trk1               Tagged     Learn           Up

Example output for a secondary isolated VLAN

(config)# show vlans 301

 VLAN ID : 301
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 Name : VLAN301
 Status : Port-based
 Voice : No
 Jumbo : No
 Private VLAN: isolated
 Associated Primary VID :  300
 Associated Secondary VIDs : None

 Port Information   Mode        Unknown VLAN    Status
 ------------------ -------     --------------  --------
 1/8                Untagged    Learn           Up
 1/9                Untagged    Learn           Up
 Trk1               No          Learn           Up

Example: show running-config command for private VLANs
When PVLANs (private VLANs) are configured, the output of the show running-config command includes
information similar to the following example:

switch# show running-config

Running configuration:

...

interface 1/A2
   
...

interface Trk1
...
   no private-vlan promiscuous
...

vlan 300
   name "VLAN300"
   private-vlan primary
   private-vlan isolated 301
   private-vlan community 302
   untagged 1/A2
   tagged Trk1
   no ip address
   exit

vlan 301
   name "VLAN301"
   untagged 1/8-1/9
   no ip address
   exit

vlan 302
   name "VLAN302"
   untagged 1/17-1/18
   no ip address
   exit

vlan 303
   name "VLAN303"
   untagged 1/19-1/20
   no ip address
   exit
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Removing PVLANs from the configuration of the switch
Prerequisites

• The PVLAN (private VLAN) must exist in the configuration.

• You must be in the global configuration context: switch(config)#

Procedure

1. Remove all secondary community VLANs (if configured).

For example:

switch(config)# no vlan 300 private-vlan community 302,303
All member ports of the deleted VLAN are moved to VLAN 1 automatically.

2. Remove the secondary isolated VLAN (if configured).

For example:

switch(config)# no vlan 300 private-vlan isolated 301
All member ports of the deleted VLAN are moved to VLAN 1 automatically.

3. Remove the primary private VLAN configuration from the primary VLAN.

For example:

switch(config)# no vlan 300 private-vlan primary
The primary VLAN is now configured as a regular VLAN and the private VLAN no longer exists.

PVLAN commands
interface private-vlan promiscuous
Syntax

interface <port-list> private-vlan promiscuous

no interface <port-list> private-vlan promiscuous

Description

Configures ports as promiscuous ports in private VLANs.

The no form of this command removes the promiscuous port configuration, which enables the ports to be
configured as interswitch links.

Command context

Required context: config

Parameters
<port-list>

Specifies the ports. Separate individual ports with commas. Specify ranges of ports with hyphens.
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Example

The following example configures interface 1/A2 as a promiscuous port:

switch(config)# interface 1/A2 private-vlan promiscuous

show private-vlan promiscuous-ports
Syntax

show private-vlan promiscuous-ports

Description

Shows a list of all the promiscuous ports of all the PVLANs (private VLANS).

Command context

Required context: config

Example

switch(config)# show private-vlan promiscuous-ports

  primary VLAN    Port  
  -------------  ------    
  300             1/A2

show vlans private-vlan
Syntax

show vlans [<VLAN-ID>] private-vlan

Description

Shows information about the configured PVLANs.

Command context

Required context: config

Parameters
<VLAN-ID>

Specifies the ID of a primary VLAN. When this parameter is specified, the show command displays
information about the specified PVLAN only.

Example of showing all PVLANs (private VLANS)

In the following example, the values in the VLAN type column describe the secondary VLANs.

switch(config)# show vlans private-vlan

 Configuration and Association – private VLANs:

  primary  secondary  VLAN Type  
  -------  ---------  ---------
  300      301        isolated    
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           302        community   
           303        community  

Example of showing information about a primary VLAN

switch(config)# show vlans 300 private-vlan 

 Private VLAN Configuration Information: VLAN 300
  
  VLAN Type : primary

  Port Type         Ports       
  ------------      ----
  Promiscuous       1/A2
  Member            Trk1

 Associated Secondary VLANs:

  VLAN ID   VLAN type    Access Ports 
  -------   ---------    ------------  
  301       isolated     1/8-1/9,Trk1
  302       community    1/17-1/18,Trk1
  303       community    1/19-1/20,Trk1

Example of showing information about a secondary VLAN

(config)# show vlans 301 private-vlan

 Private VLAN Configuration Information: VLAN 301
  VLAN Type     : isolated  
  Access ports  : 1/8-1/9,Trk1
 
 Associated Primary VLAN: 300

  Port Type         Ports       
  -----------       ----------
  Promiscuous        1/A2
  Member             Trk1

vlan private-vlan
Syntax

vlan <PRIMARY-VLAN-ID> private-vlan 
  [primary | isolated <VLAN-ID> | community <VLAN-ID-LIST>]

no vlan <PRIMARY-VLAN-ID> private-vlan 
  [primary | isolated <VLAN-ID> | community <VLAN-ID-LIST>]

Description

Creates new private VLAN or changes an existing VLAN into a private VLAN.

The no form of the command removes secondary VLANs from the configuration or removes the PVLAN from the
configuration by reconfiguring the primary VLAN as a regular VLAN.

Command context

Required context: config
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Parameters
<PRIMARY-VLAN-ID>

Specifies the VLAN ID of the primary VLAN in the PVLAN.

primary
Specifies that <PRIMARY-VLAN-ID> is the primary VLAN in a PVLAN.

isolated <VLAN-ID>
Specifies an isolated VLAN in the PVLAN, where <VLAN-ID> is the VLAN ID of the isolated VLAN.

community <VLAN-ID-LIST>
Specifies one or more community VLANs in the PVLAN, where <VLAN-ID-LIST> contains the VLAN IDs of
the community VLANs. Separate individual VLAN IDs with commas. Specify ranges of VLAN IDs with
hyphens.

Usage

The no form of this command removes the PVLAN configuration as follows:

• When used with the isolated or community parameter, removes the secondary VLAN from the configuration
and assigns any ports to the default VLAN (VLAN 1).

• When used without the isolated or community parameters, removes the private VLAN configuration from the
configuration and converts the primary VLAN into a regular VLAN.

Example

The following example configures a PVLAN with primary VLAN 300, isolated VLAN 301, community VLAN 302,
and community VLAN 303:

switch(config)# vlan 300 private-vlan primary 
switch(config)# vlan 300 private-vlan isolated 301
switch(config)# vlan 300 private-vlan community 302-303
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Introduction to Quality of Service (QoS)
A Quality of Service (QoS) network policy refers to the network-wide controls available to:

• Ensure uniform and efficient traffic-handling throughout your network, while keeping the most important traffic
moving at an acceptable speed, regardless of current bandwidth usage.

• Exercise control over the priority settings of inbound traffic arriving in and travelling through your network.

Adding bandwidth can be a good idea, but is not always feasible and does not completely eliminate the potential
for network congestion. There will always be points in the network where multiple traffic streams merge or where
network links change speed and capacity. The impact and number of these congestion points will increase over
time as more applications and devices are added to the network.

When network congestion occurs, it is important to move traffic on the basis of relative importance. However,
without QoS prioritization, less important traffic consumes network bandwidth and slows down or halts the delivery
of more important traffic. Without QoS, most traffic received by the switch is forwarded with the same priority it
had upon entering the switch. In many cases, such traffic is normal priority and competes for bandwidth with all
other normal-priority traffic, regardless of its relative importance to your organization's mission.

Using QoS to classify and prioritize network traffic
QoS is used to classify and prioritize traffic throughout a network. QoS enables you to establish an end-to-end
traffic-priority policy to improve the control and throughput of important data. You can manage available bandwidth
so that the most important traffic goes first. For example, you can use QoS to:

• Upgrade or downgrade traffic from various servers.

• Control the priority of traffic from dedicated VLANs or applications.

Chapter 8
Quality of Service (QoS): Managing bandwidth effectively
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• Change the priorities of traffic from various segments of your network as your business needs change.

• Set priority policies in edge switches in your network to enable traffic-handling rules across the network.

Figure 23: 802.1p priority based on CoS (Class-of-Service) types and use of VLAN tags

Figure 24: Application of Differentiated Services Codepoint (DSCP) policies

Applying QoS to inbound traffic at the network edge
At the edge switch, QoS classifies certain traffic types and in some cases applies a DSCP policy. At the next hop
(downstream switch) QoS honors the policies established at the edge switch. Further downstream, another switch
may reclassify some traffic by applying new policies, and yet other downstream switches can be configured to
honor the new policies.

Preserving QoS in outbound traffic in a VLAN
QoS is implemented in the form of rules or policies that are configured on the switch. Although you can use QoS
to prioritize traffic only while it moves through the switch, you derive the maximum benefit by using QoS in an
802.1Q VLAN environment (with 802.1p priority tags) or in an untagged VLAN environment (with DSCP policies in
which QoS sets priorities that downstream devices can support without reclassifying the traffic).

Using QoS to optimize existing network resources
By prioritizing traffic, QoS supports traffic growth on the network while optimizing the use of existing resources—
and delaying the need for further investments in equipment and services. QoS enables you to:
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• Specify which traffic has higher or lower priority, regardless of current network bandwidth, or the relative
priority setting of the traffic when it is received on the switch.

• Change (upgrade or downgrade) the priority of outbound traffic.

• Override "illegal" packet priorities set by upstream devices or applications that use 802.1Q VLAN tagging with
802.1p priority tags.

Overview of QoS settings
QoS settings operate on two levels:

• Controlling the priority of outbound packets moving through the switch: Configuring a new 802.1p
priority value allows you to set the outbound priority queue to which a packet is sent. For example, you can
configure an 802.1p priority of 0 through 7 for an outbound packet. When the packet is sent to a port, the QoS
priority determines the outbound queue to which the packet is assigned as shown in the following table:

Table 12: 802.1p priority settings and outbound queue assignment

802.1p priority setting Outbound port 8
queues

Outbound port 4
queues

Outbound port 2
queues

1 1 1 1

2 2

0 3 2

3 4

4 5 3 2

5 6

6 7 4

7 8

(In an 802.1Q VLAN environment with VLAN-tagged ports, if QoS is not configured on the switch, but is
configured on an upstream device, the priorities carried in the packets determine the forwarding queues in the
switch.)

• Configuring a priority for outbound packets and a service (priority) policy for use by downstream
devices:
◦ DSCP Policy: This feature enables you to set a priority policy in outbound IP packets. (You can configure

downstream devices to read and use this policy.) This method is not dependent on VLAN-tagged ports to
carry priority policy to downstream devices, and can:
– Change the codepoint (the upper 6 bits) in the ToS byte.

– Set a new 802.1p priority for the packet.

(Setting DSCP policies requires IPv4 inbound packets.)

◦ 802.1p priority rules: An outbound, VLAN-tagged packet carries an 802.1p priority setting that was
configured (or preserved) in the switch. This priority setting ranges from 0 to 7, and can be used by
downstream devices having up to eight outbound port queues. Thus, if packets within the switch move at
the four priority levels shown in the table above, they still can carry an 802.1p priority that can be used by
downstream devices having more or less than the four priority levels in the switches covered in this guide.
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Also, if the packet enters the switch with an 802.1p priority setting, QoS can override this setting if
configured with an 802.1p priority rule to do so.

NOTE: If your network uses only one VLAN (and therefore does not require VLAN-tagged
ports), you can still preserve 802.1p priority settings in your traffic by configuring the ports as
tagged VLAN members on the links between devices you want to honor traffic priorities.

Rule and policy limits: A large number of 802.1p priority rules and/or DSCP policies are
allowed in any combination. For example, for the 2540 switch 6000 are allowed.

You can configure a QoS priority of 0 through 7 for an outbound packet. When the packet is then sent to a port,
the QoS priority determines which outbound queue the packet uses:

Table 13: QoS priority settings and operation

802.1p priority setting Outbound port 8 queues Outbound port 4 queues Outbound port 2 queues

1 1 1 1

2 2

0 3 2

3 4

4 5 3 2

5 6

6 7 4

7 8

If a packet is not in a VLAN-tagged port environment, then the QoS settings in the table above control only to
which outbound queue the packet goes. Without VLAN tagging, no 802.1p priority is added to the packet for
downstream device use. But if the packet is in a VLAN-tagged environment, then the above setting is also added
to the packet as an 802.1p priority for use by downstream devices and applications (shown in the table below). In
either case, an IP packet can also carry a priority policy to downstream devices by using DSCP-marking in the
ToS byte.

Table 14: Mapping switch QoS priority settings to device queues

Priority setting Outbound port
queues in the
switch

802.1p priority
setting added
to tagged VLAN
packets exiting
the switch

Queue assignment in downstream devices with:

8 queues 3 queues 2 queues

1 Queue 1 1 (low priority) Queue 1 Queue 1 Queue 1

2 2 Queue 2

0 Queue 2 0 (normal
priority)

Queue 3 Queue 2

3 3 Queue 4

Table Continued
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Priority setting Outbound port
queues in the
switch

802.1p priority
setting added
to tagged VLAN
packets exiting
the switch

Queue assignment in downstream devices with:

8 queues 3 queues 2 queues

4 Queue 3 4 (medium
priority)

Queue 5 Queue 3 Queue 2

5 5 Queue 6

6 Queue 4 6 (high priority) Queue 7

7 7 Queue 8

Classifiers for prioritizing outbound packets
NOTE:

Regarding using multiple criteria: Hewlett Packard Enterprise recommends that you configure a
minimum number of the available QoS classifiers for prioritizing any given packet type. Increasing
the number of active classifier options for a packet type increases the complexity of the possible
outcomes and consumes switch resources.

Packet classifiers and evaluation order
The switches covered in this guide provide six types of globally-configured QoS classifiers (match criteria) to
select packets for QoS traffic marking.

The switches covered in this guide provide six QoS classifiers (packet criteria) you can use to configure QoS
priority.

Table 15: Classifier search order and precedence

Search order Precedence Global QoS classifier

1 1 (highest) UDP/TCP application type (port)

2 2 Device priority (destination or source IP address)

3 3 IP type of service (ToS): precedence and DSCP bit sets (IP packets only)

4 4 IP protocol (IP, IPX, ARP, AppleTalk, SNA, and NetBeui)

5 5 VLAN ID

6 6 Incoming source-port on the switch

Default 7 (lowest) The incoming 802.1p priority (present in tagged VLAN environments) is
preserved if no global QoS classifier with a higher precedence matches.

Where multiple classifier types are configured, a switch uses the highest-to-lowest search order shown in the
table to identify the highest-precedence classifier to apply to any given packet. When a match between a packet
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and a classifier is found, the switch applies the QoS policy configured for that classifier and the packet is handled
accordingly.

NOTE: On the switches covered in this guide, if the switch is configured with multiple classifiers that
address the same packet, the switch uses only the QoS configuration for the QoS classifier that has
the highest precedence. In this case, the QoS configuration for another, lower-precedence classifier
that may apply is ignored. For example, if QoS assigns high priority to packets belonging to VLAN
100, but normal priority to all IP protocol packets, since protocol priority (4) has precedence over
VLAN priority (5), IP protocol packets on VLAN 100 will be set to normal priority.

Preparation for configuring QoS

Preserving 802.1p priority
QoS operates in VLAN-tagged and VLAN-untagged environments. If your network does not use multiple VLANs,
you can still implement the 802.1Q VLAN capability for packets to carry their 802.1p priority to the next
downstream device. To do so, configure ports as VLAN-tagged members on the links between switches and
routers in your network infrastructure.

Table 16: Summary of QoS capabilities

Outbound packet options Port membership in VLANs

Tagged Untagged

Control port queue priority for packet
types

Yes Yes

Carry 802.1p priority assignment to
next downstream device

Yes No

Carry DSCP policy to downstream
devices. The policy includes:

• Assigning a ToS Codepoint

• Assigning an 802.1p Priority to the
Codepoint

Yes Yes2

Steps for configuring QoS on the switch

Procedure

1. Determine the QoS policy you want to implement. This includes analyzing the types of traffic flowing through
your network and identifying one or more traffic types to prioritize. In order of QoS precedence, these are:

a. UDP/TCP applications

b. Device Priority—destination or source IP address (Note that destination has precedence over source. See
the table below.

c. IP ToS Precedence Bits (Leftmost three bits in the ToS field of IP packets)

d. IP ToS Differentiated Service bits (Leftmost 6 bits in the ToS field of IP packets)

e. Layer 3 Protocol Priority
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f. VLAN Priority (requires at least one tagged VLAN on the network)

g. Source-Port

h. Incoming 802.1p Priority (requires at least one tagged VLAN on the network). In a tagged VLAN
environment, the incoming 802.1p priority is used as the default QoS classifier if no QoS classifier with a
higher precedence matches

2. Select the QoS option you want to use. The following table lists the traffic types (QoS classifiers) and the QoS
options you can use for prioritizing or setting a policy on these traffic types:

Table 17: QoS marking supported by QoS classifiers

Global QoS classifiers Type of QoS marking used to prioritize outbound traffic

802.1p Priority1 only DSCP policy2: DSCP codepoint
with 802.1p priority

UDP/TCP Supported Supported

IP Device Supported Supported

IP Precedence Supported3 Not Supported

IP DiffServ Supported Supported

L3 Protocol Supported Not Supported

VLAN ID Supported Supported

Source Port Supported Supported

1When you configure only the 802.1p priority to mark packets that match a global QoS classifier, the selected
traffic is prioritized and sent to the corresponding outbound port queue on the switch. VLAN-tagged ports are
necessary to carry the 802.1p priority in a packet header to downstream devices.

2When you configure a DSCP policy to mark packets that match a global QoS classifier, the selected traffic is
also prioritized according to the associated 802.1p priority and sent to the corresponding outbound port queue
on the switch. VLAN-tagged ports carry the 802.1p priority in a packet header to downstream devices. In
addition, you can configure downstream devices to read the DSCP value in IP packets and implement the
service policy implied by the codepoint.
3When using a global QoS IP Precedence classifier, the 802.1p priority is automatically assigned to matching
packets based on the IP precedence bit set in the packet header.

3. If you want 802.1p priority settings to be included in outbound packets, ensure that tagged VLANs are
configured on the appropriate downstream links.

4. Determine the actual QoS configuration changes you will need to make on each QoS-capable device in your
network in order to implement the desired policy. Also, if you want downstream devices to read and use
DSCPs in IP packets from the switch, configure them to do so by enabling ToS Differentiated Service mode
and making sure that the same DSCP policies are configured.

Using classifiers to configure QoS for outbound traffic

Viewing the QoS configuration
Examples of the show qos output are included with the example for each priority type.
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Syntax:

show qos <priority-classifier>
device-priority: Displays the device priority table/configuration (priority based on the IP address).

dscp-map: Displays mappings between DSCP policy and 802.1p priority.

port-priority: Displays the current source-port priority configuration.

protocol-priority: Displays the protocol priority configuration.

queue-config: Displays the outbound port queue configuration information.

resources: Displays the resources used by the Policy Enforcement Engine.

tcp-udp-port-priority: Displays the TCP/UDP port priorities.

type-of-service: Displays the current type-of-service priority configuration. The display output differs
according to the ToS option used:

• IP Precedence
• Diffserve

vlan-priority: Displays the current VLAN priority configuration.

No override
By default, the show command outputs automatically list No-override for priority options that have not been
configured. This means that if you do not configure a priority for a specific option, QoS does not prioritize packets
to which that option applies, resulting in the No-override state.

• IP packets received through a VLAN-tagged port are managed using the 802.1p priority they carry in the
802.1Q field in their headers.

• VLAN-tagged packets received through an untagged port are handled by the switch with “normal” priority.

the show qos vlan-priority output shows the global QoS configurations on the switch that are configured
with the VLAN ID classifier. Note that non-default 802.1p priorities have been configured for VLAN IDs 22 and 33;
packets received on VLAN 1 are managed with the default settings, as described in the two bulleted items above.

Figure 25: Output for the show qos vlan-priority command (example)
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Global TCP/UDP classifier

Global QoS classifier precedence: 1
When you use TCP or UDP and a layer 4 Application port number as a global QoS classifier, traffic carrying the
specified TCP/UDP port numbers is marked with a specified priority level, without regard for any other QoS
classifiers in the switch.

Options for assigning priority
For a given TCP or UDP port number, you can use only one of the above options at a time. However, for different
port numbers, you can use different options.

TCP/UDP port number ranges
There are three ranges:

• Well-Known Ports: 0 – 1023

• Registered Ports: 1024 – 49151

• Dynamic and Private Ports: 49152 – 65535

For more information, including a listing of UDP/TCP port numbers, go to the Internet Assigned Numbers
Authority (IANA) website at:

http://www.iana.org

Then click:

Protocol Number Assignment Services

P (under Directory of General Assigned Numbers)

Port Numbers

Assigning an 802.1p priority for a global TCP/UDP classifier
Syntax:

port-number: TCP/UDP port number from 1 to 65535.

range <start end> : Marks a range of TCP/UDP ports. If you specify a range, the minimum port number
must precede the maximum port number in the range.

priority <0-7>: Marks the specified 802.1p priority in matching TCP or UDP packets.

Syntax:

show qos tcp-udp-port-priority
Displays a listing of all TCP and UDP QoS classifiers currently in the running-config file.

Operating notes on using TCP/UDP port ranges
• Only six concurrent policies are possible when using unique ranges. The number of policies allowed is less if

ACLs are also using port ranges.

• No ranges allowed that include any port numbers configured as part of another QoS application port number
policy.

• An error message is generated if there are not enough hardware resources available when configuring a
policy.

• The entire range of configured port numbers must be specified when using the no form of the command, for
example:
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switch(config)# qos udp-port range 1300 1399 dscp 001110
switch(config)# no qos range 1300 1399

The following example displays the following configuration for TCP and UDP port prioritization:

Configuration for TCP and UDP port prioritization

TCP/UDP port 802.1p priority
for TCP

802.1p priority
for UDP

TCP Port 23 (Telnet) 7 7

UDP Port 23 (Telnet) 7 7

TCP Port 80 (World Wide Web HTTP) 2 2

UDP Port 80 (World Wide Web HTTP) 1 1

Figure 26: Configuring 802.1p priority assignments on TCP/UDP ports

Assigning a DSCP policy for a global TCP/UDP classifier

Procedure

1. Selects an incoming IP packet if the TCP or UDP port number it carries matches the port number specified in
the TCP or UDP classifier (as shown in the figure in Operating notes on using TCP/UDP port ranges).

2. Overwrites (re-marks) the packet's DSCP with the new DSCP configured for matching packets.
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3. Assigns the 802.1p priority associated with the new DSCP (see Differentiated Services Codepoint (DSCP)
mapping on page 205).

4. Forwards the packet through the appropriate outbound port queue.

Creating a DSCP policy based on TCP/UDP port number classifiers
The following procedure creates a DSCP policy for IP packets carrying the selected TCP or UDP port-number
classifier.

Procedure

1. Identify the TCP or UDP port-number classifier you want to use for assigning a DSCP policy.

2. Determine the DSCP policy for packets carrying the selected TCP or UDP port number or range of port
numbers.

a. Determine the DSCP you want to assign to the selected packets. (This codepoint will be used to overwrite
(re-mark) the DSCP carried in packets received from upstream devices.)

b. Determine the 802.1p priority you want to assign to the DSCP.

3. If necessary, use the qos dscp-map <codepoint> priority <0-7> command to configure the DSCP
policy (codepoint and associated 802.1p priority) that you want to use to mark matching packets.

NOTE: Prerequisite: A DSCP codepoint must have a preconfigured 802.1p priority (0 - 7) before
you can use the codepoint to mark matching packets. If a codepoint you want to use shows No-
override in the Priority column of the DSCP Policy table (using the show qos dscp-map
command), you must first configure a priority for the codepoint before proceeding (using the qos
dscp-map priority command).

(Optional) This command is required only if an 802.1p priority is not already assigned to the specified
<codepoint> in the DSCP Policy table. Valid values for a DSCP codepoint are as follows:

• A binary value for the six-bit codepoint from 000000 to 111111.

• A decimal value from 0 (low priority) to 63 (high priority) that corresponds to a binary DSCP bit set

• An ASCII standard (hexadecimal) name for a binary DSCP bit set:

af11 (001010) af42 (100100)

af12 (001100) af43 (100110)

af13 (001110) ef (101110)

af21 (010010) cs1 (001000) = precedence 1

af22 (010100) cs2 (010000) = precedence 2

af23 (010110) cs3 (011000) = precedence 3

af31 (011010) cs4 (100000) = precedence 4

Table Continued
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af32 (011100) cs5 (101000) = precedence 5

af33 (011110) cs6 (110000) = precedence 6

af41 (100010) cs7 (111000) = precedence 7

default (000000)

Enter ? to display the list of valid codepoint entries.

When the switch applies the specified DSCP policy to a packet, the priority determines the packet's queue
in the outbound port to which it is sent. If the packet leaves the switch on a tagged port, it carries the
802.1p priority with it to the next downstream device. For IP packets, the DSCP will be replaced by the
codepoint specified in this command.

(Default: No-override for most codepoints.)

4. Configure the switch to assign the DSCP policy to packets with the specified TCP or UDP port number or
range of port numbers.

no qos {udp-port | tcp-port} [ipv4 | ipv6 | ipv-all] {<port-number> | range 
<port start><port end>} {dscp < codepoint> | priority <priority>}

no qos {udp-port | tcp-port} [ipv4 | ipv6 | ipv-all] {<port-number> | range 
<port start><port end>} {dscp < codepoint> | priority <priority>}
Assigns a DSCP policy to outbound packets having the specified TCP or UDP application-port number or port
range, and overwrites the DSCP in these packets with the assigned <codepoint> value, where:

• port-number: specifies a TCP/UDP port-number from 1 to 65535.

• range <start end>: specifies a range of TCP/UDP ports. If you specify a range, the minimum port
number must precede the maximum port number in the range.

• dscp <codepoint>: overwrites the DSCP codepoint in the IPv4 ToS byte or IPv6 Traffic Class byte of
matching packets with the specified value.Valid values for the DSCP codepoint are as follows:
◦ A binary value for the 6-bit codepoint from 000000 to 111111.

◦ A decimal value from 0 (low priority) to 63 (high priority) that corresponds to a binary DSCP bit set

◦ An ASCII standard name for a binary DSCP bit set

Enter ? to display the list of valid codepoint entries.

The DSCP value you enter must be currently associated with an 802.1p priority in the DSCP Policy
table. The 802.1p priority and determines the packet's queue in the outbound port to which it is sent. If
the packet leaves the switch on a tagged port, it carries the 802.1p priority with it to the next
downstream device.

The default DSCP codepoint is No-override. The DSCP codepoint is not overwritten in matching
packets.

The no form of the command deletes the specified UDP or TCP port number or range of port numbers as a
QoS classifier. If you configured a range of port numbers as the QoS classifier, you must enter the entire
range in the no command; you cannot remove part of a range.
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Syntax

show qos tcp-udp-port-priority
Displays a listing of all TCP and UDP QoS classifiers currently in the running-config file.

Example:

This example shows how to assign the following DSCP policies to packets that match the specified TCP and UDP
port applications:

Port Applications DSCP Policies

DSCP Priority

23-UDP 000111 7

80-TCP 000101 5

914-TCP 000010 1

1001-UDP 000010 1

1. Determine if the DSCP codepoints that you want to use to mark matching packets already have an 802.1p
priority assigned, which could indicate use by existing applications (show qos dscp-map command).

A DSCP codepoint must also have a priority configured before you can use it to mark matching packets.

switch(config)# show qos dscp-map

  DSCP -> 802.p priority mappings

  NOTE: ‘qos type-of-service diff-services’ must be configured
         before DSCP is honored on inbound traffic.

  DSCP CodePoint DSCP Value 802.1p tag   DSCP Policy name
  -------------- ---------- -----------  ----------------------
  000000         0          0            cs0
  000001         1          No-override
  000010         2          No-override
  000011         3          No-override
  000100         4          No-override
  000101         5          No-override
  000110         6          No-override
  000111         7          No-override
  001000         8          1            cs1
  001001         9          No-override

2. Configure the DSCP policies for the codepoints you want to use.

switch(config)# qos dscp-map af11 priority 3
switch(config)# qos dscp-map 13 priority 3
switch(config)# qos dscp-map af13 priority 3
switch(config)# write memory

switch(config)# show config
switch configuration:

; J9146 Configuration Editor; Created on release XX.15.XX
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hostname “Switch”
time daylight-time-rule None
qos dscp-map af11 priority 3
qos dscp-map 13 priority 3
qos dscp-map af13 priority 3
...

3. Assign the DSCP policies to the selected TCP/UDP port applications and display the result.

switch(config)# qos udp-port 23 dscp 000111
switch(config)# qos tcp-port 80 dscp 000101
switch(config)# qos tcp-port 914 dscp 000010
switch(config)# qos udp-port range 1001 2000 dscp 000010

  TCP/UDP port based priorities

           | IP Packet Application            |
  Protocol | Type      Port        Apply rule | DSCP   Priority
  -------- + --------- ----------- ---------- + ------ -----------
  UDP      | IPV4      23          DSCP       | 8      7
  TCP      | IPV4      80          DSCP       | 6      5
  TCP      | IPV4      914         DSCP       | 3      1
  UDP      | IPV4      1001-2000   DSCP       | 3      1
The switch applies the DSCP policies in the above output to IP packets with the specified TCP/UDP port
applications that are received in the switch. The switch manages the packets as follows:

• Overwrites the original DSCPs in the selected packets with the new DSCPs specified in the above policies.

• Assigns the 802.1p priorities in the above policies to the selected packets.

Global IP-device classifier

Global QoS classifier precedence: 2
NOTE: QoS IP-device restriction: The switch does not allow a QoS IP-device priority for the
Management VLAN IP address (if configured). If no Management VLAN is configured, then the
switch does not allow configuring a QoS IP-device priority for the default VLAN IP address.

Options for assigning priority
The packet-marking options for global IP-device classifiers include:

802.1p priority

For a given IP address or subnet mask, you can assign only one of the above options at a time. However, for
different IP addresses, you can use different options.

QoS IP Type-of-Service (ToS) policy and priority

Global QoS classifier precedence: 3
You can assign a maximum of 64 ToS rules. This feature applies only to IPv4 traffic and performs either of the
following:
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• ToS IP-precedence mode: All IP packets generated by upstream devices and applications include
precedence bits in the ToS byte. Using this mode, the switch uses these bits to compute and assign the
corresponding 802.1p priority.

• ToS Differentiated Services (Diffserv) mode: This mode requires knowledge of the codepoints set in IP
packets by the upstream devices and applications. It uses the ToS codepoint in IP packets coming from
upstream devices and applications to assign 802.1p priorities to the packets. You can use this option to do
both of the following:
◦ Assign a new prioritization policy: A “policy” includes both a codepoint and a corresponding 802.1p

priority. This option selects an incoming IPv4 packet on the basis of its codepoint and assigns a new
codepoint and corresponding 802.1p priority. (Use the qos dscp-map command to specify a priority for
any codepoint; see Differentiated Services Codepoint (DSCP) mapping on page 205.)

◦ Assign an 802.1p priority: This option reads the DSCP of an incoming IPv4 packet and, without changing
this codepoint, assigns the 802.1p priority to the packet, as configured in the DSCP Policy Table
(Differentiated Services Codepoint (DSCP) mapping on page 205). This means that a priority value of 0
– 7 must be configured for a DSCP before the switch will attempt to perform a QoS match on the packet’s
DSCP bits.

Before configuring the ToS Diffserv mode, you must use the qos dscp-map command to configure the
desired 802.1p priorities for the codepoints you want to use for either option. See Differentiated Services
Codepoint (DSCP) mapping on page 205 for more information.

Unless IP-Precedence mode and Diffserv mode are both disabled (the default setting), enabling one automatically
disables the other.

Assigning an 802.1p priority to IPv4 packets on the basis of the ToS precedence bits
If a device or application upstream of the switch sets the precedence bits in the ToS byte of IPv4 packets, you can
use this feature to apply that setting for prioritizing packets for outbound port queues. If the outbound packets are
in a tagged VLAN, this priority is carried as an 802.1p value to the adjacent downstream devices.

Syntax:

qos type-of-service ip-precedence
Causes the switch to automatically assign an 802.1p priority to all IPv4 packets by computing each packet’s
802.1p priority from the precedence bits the packet carries. This priority determines the packet’s queue in the
outbound port to which it is sent. If the packet leaves the switch on a tagged port, it carries the 802.1p priority with
it to the next downstream device.

(ToS IP Precedence Default: Disabled)

no qos type-of-service
Disables all ToS classifier operation, including prioritization using the precedence bits.

show qos type-of-service
When the IP-precedence mode is enabled (or if neither ToS option is configured), this command displays the ToS
configuration status. If the Diff-serv mode is enabled, codepoint data is displayed.
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Using the IP-precedence classifier, prioritization of outbound packets relies on the IP-Precedence bit setting that
IP packets carry with them from upstream devices and applications. To configure and verify this option:

Figure 27: Enabling ToS IP-precedence prioritization

To replace this option with the ToS diff-services option, configure diff-services as described below, which
automatically disables IP-Precedence. To disable IP-Precedence without enabling the diff-services option, use this
command: no qos type-of-service

Assigning an 802.1p priority to IPv4 packets on the basis of incoming DSCP
One of the best uses for this option is on an interior switch where you want to honor (continue) a policy set on an
edge switch. That is, it enables you to select incoming packets having a specific DSCP and forward these packets
with the desired 802.1p priority. For example, if an edge switch “A” marks all packets received on port 5 with a
particular DSCP, you can configure a downstream (interior) switch “B” to handle such packets with the desired
priority (regardless of whether 802.1Q tagged VLANs are in use).

Figure 28: Interior switch B honors the policy established in edge switch A

To do so, assign the desired 802.1p priority to the same codepoint that the upstream or edge switch assigns to
the selected packets. When the downstream switch receives an IPv4 packet carrying one of these codepoints, it
assigns the configured priority to the packet and sends it out the appropriate priority queue. (The packet retains
the codepoint it received from the upstream or edge switch). You can use this option concurrently with the diffserv
DSCP Policy option (described later in this section), as long as the DSCPs specified in the two options do not
match.
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NOTE: Regarding DSCP use: Different applications may use the same DSCP in their IP packets.
Also, the same application may use multiple DSCPs if the application originates on different clients,
servers, or other devices. Using an edge switch enables you to select the desired packets and mark
them with predictable DSCPs that can be used by downstream switches to honor policies set in the
edge switch.

When enabled, the switch applies direct 802.1p prioritization to all packets having codepoints that
meet these prerequisites:

• The codepoint is configured with an 802.1p priority in the DSCP table. (Codepoints configured
with No-override are not used.)

• The codepoint is not configured for a new DSCP policy assignment.

Thus, the switch does not allow the same incoming codepoint (DSCP) to be used simultaneously for
directly assigning an 802.1p priority and also assigning a DSCP policy. For a given incoming
codepoint, if you configure one option and then the other, the second overwrites the first.

To use this option:

Procedure

1. Identify a DSCP used to set a policy in packets received from an upstream or edge switch.

2. Determine the 802.1p priority (0–7) you want to apply to packets carrying the identified DSCP. (You can either
maintain the priority assigned in the upstream or edge switch, or assign a new priority.)

3. Use qos dscp-map <codepoint> priority <0-7> to assign the 802.1p priority you want to the
specified DSCP.

4. Enable diff-services if not already enabled.

Syntax:

qos type-of-service diff-services <codepoint>
Causes the switch to read the <codepoint> (DSCP) of an incoming IPv4 packet and, when a match occurs,
assign a corresponding 802.1p priority, as configured in the switch’s DSCP table (see Differentiated Services
Codepoint (DSCP) mapping).

no qos type-of-service
Disables all ToS classifier operation.

no qos dscp-map <codepoint>
Disables direct 802.1p priority assignment to packets carrying the <codepoint> by reconfiguring the codepoint
priority assignment in the DSCP table to No-override. If this codepoint is in use as a DSCP policy for another
diffserv codepoint, you must disable or redirect the other diffserv codepoint’s DSCP policy before you can disable
or change the codepoint. For example, in Figure 30: ToS configuration that enables both 802.1p priority and
DSCP policy assignment on page 193 you cannot change the priority for the 000000 codepoint until you
redirect the DSCP policy for 000001 away from using 000000 as a policy. (See Note on changing a priority
setting on page 206 and Differentiated Services Codepoint (DSCP) mapping on page 205.)

show qos type-of-service
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Displays current Type-of-Service configuration. In diffserv mode it also shows the current direct 802.1p
assignments and the current DSCP assignments covered later in this section.

For example, an edge switch “A” in an untagged VLAN assigns a DSCP of 000110 on IP packets it receives on
port 6, and handles the packets with high priority (7). When these packets reach interior switch “B” you want the
switch to handle them with the same high priority. To enable this operation, you would configure an 802.1p priority
of 7 for packets received with a DSCP of 000110. ToS diff-services must be enabled as shown in the
following images.

Figure 29: Viewing the codepoints available for 802.1p priority assignments

Figure 30: ToS configuration that enables both 802.1p priority and DSCP policy assignment

Assigning a DSCP policy on the basis of the DSCP in IPv4 packets received from
upstream devices
The preceding section describes how to forward a policy set by an edge (or upstream) switch. This option
changes a DSCP policy in an IPv4 packet by changing its IP ToS codepoint and applying the priority associated
with the new codepoint. (A DSCP policy consists of a differentiated services codepoint and an associated 802.1p
priority.) You can use this option concurrently with the diffserv 802.1p priority option (above), as long as the
DSCPs specified in the two options do not match.

To use this option to configure a change in policy:
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Procedure

1. Identify the DSCP used to set a policy in packets received from an upstream or edge switch.

2. Create a new policy by using the qos dscp-map <code-point> priority <0-7> command to
configure an 802.1p priority for the codepoint you will use to overwrite the DSCP that the packet carries from
upstream.

3. Use the qos type-of-service diff-services < mapped to DSCP > dscp < mapped from
DSCP > command to change the policy on packets coming from the edge or upstream switch with the
specified incoming DSCP.

Figure 28: Interior switch B honors the policy established in edge switch A on page 191 illustrates this
scenario

Syntax:

qos type-of-service diff-services
Enables ToS Diff-serve QoS so that Diff-serve policy configurations can be applied to incoming packets that have
matching codepoints.

Syntax:

qos type-of-service diff-services <current-codepoint> dscp <new-codepoint>
Configures the switch to select an incoming IP packet carrying the <current-codepoint> and then use the
<new-codepoint> to assign a new, previously configured DSCP policy to the packet. The policy overwrites the
<current-codepoint> with the <new-codepoint> and assigns the 802.1p priority specified by the policy.

Syntax:

no qos type-of-service
Disables all ToS classifier operation. Current ToS DSCP policies and priorities remain in the configuration and will
become available if you re-enable ToS Diff-services.

Syntax:

no qos type-of-service [diff-services <codepoint>]
Deletes the DSCP policy assigned to the <codepoint> and returns the <codepoint> to the 802.1p priority
setting it had before the DSCP policy was assigned, which is either a value from 0 - 7 or No-override.

Syntax:

show qos type-of-service
Displays a listing of codepoints with any corresponding DSCP policy reassignments for outbound packets. Also
displays the 802.1p priority for each codepoint that does not have a DSCP remarking policy assigned to it.

Example

For example, suppose that you want to configure the following two DSCP policies for packets received with the
indicated DSCPs.
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Received
DSCP

Policy DSCP 802.1p
Priority

Policy Name
(Optional)

001100 17 6 Level 6

001101 16 4 Level 4

1. Determine whether the DSCPs already have priority assignments, which could indicate use by existing
applications. This is not a problem as long as the configured priorities are acceptable for all applications using
the same DSCP. (See Note on changing a priority setting on page 206. Also, a DSCP must have a priority
configured before you can assign any QoS classifiers to use it. See Differentiated Services Codepoint
(DSCP) mapping on page 205.)

2. After configuring the DSCP policies for the codepoints you want to use, assign the policies to the codepoints in
the selected packet type.

An example of policy assignment to outbound packets on the basis of the DSCP in the packets received from
upstream devices is shown below. The specified DSCP policies overwrite the original DSCPs on the selected
packets, and use the 802.1p priorities previously configured.

switch(config)# qos type-of-service diff-services 001100 dscp 17
switch(config)# qos type-of-service diff-services 001101 dscp 16
switch(config)# show qos type-of-service
  Type of Service : Differentiated Services

  Codepoint DSCP Policy | Priority
  --------- ----------- + -----------
  000000                | No-override
  000001                | No-override
  000010                | No-override
  000011                | No-override
  000100                | No-override
  000101                | No-override
  000110                | No-override
  000111                | No-override
  001000    001011      | 7
  001001                | No-override
  001010                | 1
  001011                | 7
  001100    010001      | 6
  001101    010000      | 4

Details of QoS IP ToS
IP packets include a Type of Service (ToS) byte. The ToS byte includes:

Precedence Bits: This element is a subset of the DSCP and is composed of the upper 3 bits of the ToS byte.
When configured to do so, the switch uses the precedence bits to determine a priority for handling the associated
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packet. (The switch does not change the setting of the precedence bits.) Using the ToS Precedence bits to
prioritize IPv4 packets relies on priorities set in upstream devices and applications.

The following figure, shows an example of the ToS byte in the header for an IPv4 packet, and illustrates the
diffserv bits and precedence bits in the ToS byte. (Note that the Precedence bits are a subset of the Differentiated
Services bits.)

Figure 31: The ToS codepoint and precedence bits
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Table 18: How the switch uses the ToS configuration

Outbound port ToS option:

802.1p (value = 0 - 7) Differentiated services

IP packet sent out an
untagged port in a
VLAN

Depending on the value of the IP
Precedence bits in the packet’s
ToS field, the packet will go to
one of eight outbound port
queues in the switch. See the
table in Overview of QoS
settings.

For a given packet carrying a ToS codepoint that
the switch has been configured to detect:

• Change the codepoint according to the
configured policy and assign the 802.1p priority
specified for the new codepoint in the DSCP
Policy Table (Differentiated Services
Codepoint (DSCP) mapping).

• Do not change the codepoint, but assign the
802.1p priority specified for the existing
codepoint in the DSCP Policy Table
(Differentiated Services Codepoint (DSCP)
mapping).

Depending on the 802.1p priority used, the packet
will leave the switch through a queue as defined in
the table in Overview of QoS settings on page
178.If No-override (the default) has been
configured for a specified codepoint, then the
packet is not prioritized by ToS and, by default, is
sent to the “normal priority” queue.

IP packet sent out an
untagged port in a
VLAN

Same as above, plus the IP
Precedence value (0 - 7) will be
used to set a corresponding
802.1p priority in the VLAN tag
carried by the packet to the next
downstream device. See the
table below.

Same as above, plus the Priority value (0 - 7) will
be used to set a corresponding 802.1p priority in
the VLAN tag carried by the packet to the next
downstream device. Where No-override is the
assigned priority, the VLAN tag carries a “0”
(normal priority) 802.1p setting if not prioritized by
other QoS classifiers.

Table 19: ToS IP-precedence bit mappings to 802.1p priorities

ToS byte IP precedence bits Corresponding 802.1p priority Service priority level

000 1 Lowest

001 2 Low

002 0 Normal

003 3

004 4

005 5

Table Continued
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ToS byte IP precedence bits Corresponding 802.1p priority Service priority level

006 6

007 7 Highest

Global Layer-3 protocol classifier

Global QoS classifier precedence: 4
When a global Layer-3 Protocol classifier is configured as the highest-precedence classifier and the switch
receives traffic carrying the specified protocol, matching packets are assigned the priority configured for the
classifier.

Assigning a priority for a global Layer-3 protocol classifier
This global QoS packet-marking option assigns an 802.1p priority to outbound packets having the specified
Layer-3 protocol.

Syntax:

qos protocol < ip | ipx | arp | appletalk | sna | netbeui> priority < 0 - 7 >
Configures an 802.1p priority for outbound packets having the specified protocol. This priority determines the
packet's queue in the outbound port to which it is sent. If the packet leaves the switch on a tagged port, it carries
the 802.1p priority with it to the next downstream device. You can configure one QoS classifier for each protocol
type.

(Default: No-override)

Syntax:

no qos protocol < ip | ipx | arp | appletalk | sna | netbeui >
Disables use of the specified protocol as a QoS classifier and resets the protocol priority to No-override.

Syntax:

show qos protocol-priority
Lists the QoS protocol classifiers with their priority settings.

Configuring global Layer-3 protocol classifiers

To configure the following global Layer-3 protocol classifiers:

1. Configure QoS protocol classifiers with IP at 0 (normal), ARP at 5 (medium), and AppleTalk at 7 (high) and
display the QoS protocol configuration.

2. Disable the QoS IP protocol classifier, downgrade the ARP priority to 4, and again display the QoS protocol
configuration.
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The following example shows the necessary configuration commands.

Figure 32: Adding, viewing, removing, and changing QoS protocol classifiers

QoS VLAN-ID (VID) priority

Global QoS classifier precedence: 5

Options for assigning priority
Priority control options for packets carrying a specified VLAN-ID include:

• 802.1p priority

• DSCP policy: Assigning a new DSCP and 802.1p priority

(For operation when other QoS classifiers apply to the same traffic, see Classifiers for prioritizing outbound
packets on page 180.)

NOTE: QoS with VID priority applies to static VLANs only, and applying QoS to dynamic VLANs
created by GVRP operation is not supported. A VLAN must exist while a subject of a QoS
configuration, and eliminating a VLAN from the switch causes the switch to clear any QoS features
configured for that VID.

Assigning a priority based on VLAN-ID
This option assigns a priority to all outbound packets having the specified VLAN-ID (VID). You can configure this
option by either specifying the VID ahead of the qos command or moving to the VLAN context for the VLAN you
want to configure for priority.

Syntax:

vlan <vid> qos priority <0-7>
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Configures an 802.1p priority for outbound packets belonging to the specified VLAN. This priority determines the
packet’s queue in the outbound port to which it is sent. If the packet leaves the switch on a tagged port, it carries
the 802.1p priority with it to the next downstream device. You can configure one QoS classifier for each VLAN-ID.

(Default: No-override)

Syntax:

no vlan <vid> qos
Removes the specified VLAN-ID as a QoS classifier and resets the priority for that VLAN to No-override.

Syntax:

show qos vlan-priority
Displays a listing of the QoS VLAN-ID classifiers currently in the running-config file, with their priority data.

Procedure

1. For example, suppose that you have the following VLANs configured on the switch and want to prioritize them
as shown:

2. You would then execute the following commands to prioritize the VLANs by VID:

switch(config)# vlan 1 qos dscp 9
switch(config)# vlan 22 qos dscp 8

switch(config)# show qos vlan-priority

  VLAN priorities
  
  VLAN ID Apply rule  | DSCP   Priority
  ------- ----------- + ------ -----------
  1       DSCP        | 001001 7
  22      DSCP        | 001000 6

3. If you then decided to remove VLAN_22 from QoS prioritization:

In this instance, No-override indicates that VLAN 22 is not prioritized by QoS.

switch(config)# no vlan 22 qos
switch(config)# show qos vlan

  VLAN priorities
  
  VLAN ID Apply rule  | DSCP   Priority
  ------- ----------- + ------ -----------
  1       DSCP        | 001001 7
  22      No-override |        No-override

Assigning a DSCP policy based on VLAN-ID
This option assigns a previously configured DSCP policy (codepoint and 802.1p priority) to outbound IP packets
having the specified VLAN-ID (VID). The switch performs the following:

Procedure

1. Selects an incoming IP packet on the basis of the VLAN-ID it carries.

2. Overwrites the packet’s DSCP with the DSCP configured in the switch for such packets.
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3. Assigns 802.1p priority configured in the switch for the new DSCP (see Differentiated Services Codepoint
(DSCP) mapping on page 205).

4. Forwards the packet through the appropriate outbound port queue.

Steps for creating a policy based on VLAN-ID classifier:

1. Determine the VLAN-ID classifier to which you want to assign a DSCP policy.

2. Determine the DSCP policy for packets carrying the selected VLAN-ID:

a. Determine the DSCP you want to assign to the selected packets. (This codepoint will be used to overwrite
the DSCP carried in packets received through the source-port from upstream devices.)

b. Determine the 802.1p priority you want to assign to the DSCP.

3. Configure the DSCP policy by using qos dscp-map to configure the priority for each codepoint (see 
Differentiated Services Codepoint (DSCP) mapping on page 205 for more information).

4. Configure the switch to assign the DSCP policy to packets with the specified VLAN-ID.

Syntax:

vlan <vid> qos dscp <codepoint>
Assigns a DSCP policy to packets carrying the specified VLAN-ID, and overwrites the DSCP in these packets with
the assigned <codepoint> value. This policy includes an 802.1p priority and determines the packet’s queue in
the outbound port to which it is sent. If the packet leaves the switch on a tagged port, it carries the 802.1p priority
with downstream device.

(Default: No-override)

Syntax:

no vlan <vid> qos
Removes QoS classifier for the specified VLAN.

Syntax:

show qos vlan-priority
Displays a listing of the QoS VLAN-ID classifiers currently in the running-config file.

For example, suppose that you wanted to assign this set of priorities:

VLAN-ID DSCP Priority

40 15 7

30 16 5

20 17 1

1 17 1

Assign the DSCP policies to the selected VIDs and display the result.

An example of the completed VID-DSCP priority configuration is shown below.
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switch(config)# vlan 1 qos dscp 17
switch(config)# vlan 20 qos dscp 17
switch(config)# vlan 30 qos dscp 16
switch(config)# vlan 40 qos dscp 15

switch(config)# show qos vlan-priority

 VLAN priorities

  VLAN ID Apply rule  | DSCP   Priority
  ------- ----------- + ------ -----------
  1       DSCP        | 010001 1
  20      DSCP        | 010001 1
  30      DSCP        | 010000 5
  40      DSCP        | 001111 7

In the example above, the switch will now apply the DSCP policies to packets received on the switch with the
specified VLAN-IDs. This means the switch will:

• Overwrite the original DSCPs in the selected packets with the new DSCPs specified in the above policies.

• Assign the 802.1p priorities in the above policies to the appropriate packets.

QoS source-port priority

Global QoS classifier precedence: 6
The QoS source-port option enables you to use a packet’s source-port on the switch as a QoS classifier. Where a
particular source-port classifier has the highest precedence in the switch for traffic entering through that port, then
traffic received from the port is marked with the source-port classifier’s configured priority level. Different source-
port classifiers can have different priority levels.

Options for assigning priority on the switch
Priority control options for packets from a specified source-port include:

• 802.1p priority

• DSCP policy: Assigning a new DSCP and 802.1p priority

(For operation when other QoS classifiers apply to the same traffic, see Classifiers for prioritizing outbound
packets on page 180.)

Options for assigning priority from a RADIUS server
You can use a RADIUS server to impose a QoS source-port priority during an 802.1X port-access authentication
session. See the RADIUS chapter in the ArubaOS-Switch Access Security Guide for your switch.

Assigning a priority based on source-port
This option assigns a priority to all outbound packets having the specified source-port. You can configure this
option by either specifying the source-port ahead of the qos command or moving to the port context for the port
you want to configure for priority. (If you are configuring multiple source-ports with the same priority, you may find
it easier to use the interface <port-list> command to go to the port context instead of individually
configuring the priority for each port.)

Syntax:

interface <port-list> qos priority <0-7>
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Configures an 802.1p priority for packets entering the switch through the specified (source) ports. This priority
determines the packet queue in the outbound ports to which traffic is sent. If a packet leaves the switch on a
tagged port, it carries the 802.1p priority with it to the next downstream device. You can configure one QoS
classifier for each source-port or group of source-ports.

(Default: No-override)

Syntax:

no interface <port-list> qos
Disables use of the specified source-ports for QoS classifiers and resets the priority for the specified sourceports
to No-override.

Syntax:

show qos port-priority
Lists the QoS port-priority classifiers with their priority data.

For example, suppose that you want to prioritize inbound traffic on the following source-ports:

Source-port Priority

1–3 2

4 3

You would then execute the following commands to prioritize traffic received on the above ports.

Configuring and displaying source-port QoS priorities

switch(config)# interface e 1-3 qos priority 2
switch(config)# interface e 4 qos priority 3
switch(config)# show qos port-priority

  Port priorities
  
  Port Apply rule  | DSCP  Priority    Radius Override
  ---- ----------    ----  --------    ---------------
  1    Priority    |       2           No-override
  2    Priority    |       2           No-override
  3    Priority    |       2           No-override
  4    Priority    |       3           No-override
  5    No-override |       No-override No-override
  .    .                   .           .
  .    .                   .           .
If you then decided to remove port 1 from QoS prioritization:

Returning a QoS-prioritized VLAN to “No-override” status

In this instance, No-override indicates that port 1 is not prioritized by QoS.

switch(config)# no interface 1 qos
switch(config)# show qos port-priority

  Port priorities
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  Port Apply rule  | DSCP  Priority    Radius Override
  ---- ----------    ----  --------    ---------------
  1    No-override |       No-override No-override
  2    Priority    |       2           No-override
  3    Priority    |       2           No-override
  4    Priority    |       3           No-override
  5    No-override |       No-override No-override
  .    .                   .           .
  .    .                   .           .

Assigning a DSCP policy based on the source-port
This option assigns a previously configured DSCP policy (codepoint and 802.1p priority) to outbound IP packets
(received from the specified sourceports). That is, the switch:

Procedure

1. Selects an incoming IP packet on the basis of its source-port on the switch.

2. Overwrites the packet’s DSCP with the DSCP configured in the switch for such packets.

3. Assigns 802.1p priority configured in the switch for the new DSCP (see Differentiated Services Codepoint
(DSCP) mapping on page 205).

4. Forwards the packet through the appropriate outbound port queue.

Steps for creating a policy based on source-port classifier:

NOTE: You can select one DSCP per source-port. Also, configuring a new DSCP for a source-port
automatically overwrites (replaces) any previous DSCP or 802.1p priority configuration for that port.)

1. Identify the source-port classifier to which you want to assign a DSCP policy.

2. Determine the DSCP policy for packets having the selected source-port:

a. Determine the DSCP you want to assign to the selected packets. (This codepoint will be used to overwrite
the DSCP carried in packets received through the source-port from upstream devices.)

b. Determine the 802.1p priority you want to assign to the DSCP.

3. Configure the DSCP policy by using qos dscp-map to configure the priority for each codepoint (see 
Differentiated Services Codepoint (DSCP) mapping on page 205 for more information).

4. Configure the switch to assign the DSCP policy to packets from the specified source-port.

Syntax:

interface <port-list> qos dscp <codepoint>
Assigns a DSCP policy to packets from the specified sourceports, and overwrites the DSCP in these packets with
the assigned <codepoint> value. This policy includes an 802.1p priority and determines the packet’s queue in
the outbound port to which it is sent. If the packet leaves the switch on a tagged port, it carries the 802.1p priority
with it to the next downstream device.

(Default: No-override)

Syntax:

no interface <port-list> qos
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Removes QoS classifier for the specified source-ports.

Syntax:

show qos port
Displays a listing of all source-port QoS classifiers currently in the running-config file.

For example, suppose that you wanted to assign this set of priorities that have been configured on the switch:

Source-port DSCP Priority

2 15 7

1, 3 16 5

4, 5 17 1

Assign the DSCP policies to the selected source-ports and display the result.

An example of the completed source-port DSCP-priority configuration is shown below

switch(config)# int 4,5
switch(eth-4,5)# qos dscp 17
switch(eth-4,5)# int 1,3
switch(eth-1,3)# qos dscp 16
switch(eth-1,3)# int 2
switch(eth-2)# qos dscp 15

switch(eth-2)# show qos port-priority

Port priorities

  Port Apply rule  | DSCP   Priority    Radius Override
  ---- ----------- + ------ ----------- ---------------
  1    DSCP        | 010000 5           No-override
  2    DSCP        | 001111 7           No-override
  3    DSCP        | 010000 5           No-override
  4    DSCP        | 010001 1           No-override
  5    DSCP        | 010001 1           No-override
  6    No-override |        No-override No-override
  7    No-override |        No-override No-override
  .         .         .          .           .
  .         .         .          .           .

RADIUS override field
During a client session authenticated by a RADIUS server, the server can impose a port priority that applies only
to that client session. For more information, see the RADIUS chapter in the ArubaOS-Switch Access Security
Guide for your switch.

Differentiated Services Codepoint (DSCP) mapping
Syntax:

show qos dscp-map
Displays the DSCP Policy Table.

Default priority settings for selected codepoints

Chapter 8 Quality of Service (QoS): Managing bandwidth
effectively

205

Anexo 08 ITENS 8 E 9 (0592727)         SEI 0008478-63.2018.6.02.8000 / pg. 7809



Quickly listing non-default codepoint settings
The DSCP Policy Table in Differentiated Services Codepoint (DSCP) mapping, lists the switch’s default
codepoint/priority settings. If you change the priority of any codepoint setting to a non-default value and then
execute write memory, the switch will list the non-default setting in the show config display. For example, in
the default configuration, the following codepoint settings are true:

If you change all three settings to a priority of 3, and then execute write memory, the switch will reflect these
changes in the show config listing:

Figure 33: Example of show config listing with non-default priority settings in the DSCP table

In this case, the packets are handled as follows (as long as no other QoS feature creates priority assignments for
them):

802.1Q status Outbound 802.1p priority

Received and Forwarded on a tagged port member of a VLAN. Unchanged

Received on an Untagged port member of a VLAN; Forwarded on a
tagged port member of a VLAN.

0 (zero)—”normal”

Forwarded on an Untagged port member of a VLAN. None

Note on changing a priority setting
Cannot modify DSCP Policy < codepoint > - in use by other
qos rules.
      

Changing the priority setting on a policy when one or more classifiers are currently
using the policy (example)

Error message for changing the priority on a DSCP policy

switch(config)# qos dscp-map 1 priority 2
Cannot modify DSCP Policy 1 - in use by other qos rules.
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Traffic Policing
Perform traffic policing on the incoming packets as defined in "RFC 2698: Two rate three color marker (trCRM)"
using a meter by specifying the commit and peak-rates. If the traffic exceeds the commit-rate, you can only
change the priority of the packets by remarking (DSCP). For traffic exceeding peak-rate, you can either remark
again or drop the packets.

Traffic policing is supported only on IPv4 and IPv6 traffic classes and not on MAC class.

Traffic rates
The RFC-2698: A two rate three color marker, provides you an option to categorize the incoming traffic based
on the following two rates (in kilobits per second):
Commit Information Rate (CIR)

Specifies the bandwidth limit for guaranteed traffic. Once it exceeds the limit, you can only perform DSCP
remarking (changing priority).

Peak Information Rate (PIR)

Specifies the bandwidth limit for peak traffic. Once it exceeds the limit, you can either remark the DSCP again
or drop the incoming traffic.

You can configure the meter with the preceding traffic rates using the CLI. The show command output provides
the administrator a statistical overview of the metered packets.

Traffic policy configuration
Use the class command to configure a traffic policy by specifying a meter with commit and peak-rates. Traffic
policing helps the administrator to monitor the traffic flow from the configured value. Execute the class command
from the user policy context. Set the user policy from the config context with the policy user <policy-
name> command before executing the class command.

class

Syntax
[<SEQ-NUM>] class { ipv4 | ipv6 } <CLASS-NAME>
                              { action meter 
                                commit-rate kbps <1-10000000> dscp-remark 
                                peak-rate kbps <1-10000000> {drop | dscp-remark}}
no [<SEQ-NUM>] class { ipv4 | ipv6 } <CLASS-NAME>
                              { action meter 
                                commit-rate kbps <1-10000000> dscp-remark 
                                peak-rate kbps <1-10000000> {drop | dscp-remark}}

Description

Allows you to configure the traffic as per two rate three color policy specified in RFC 2698.

The no form of this command removes the metered traffic rate entries from the running configuration output.

Command context

config, config-class, and policy-qos.
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Parameters
commit-rate

Configures the commit-rate as per RFC 2698.

commit-rate kbps<1-10000000>
Configures the commit-rate in Kb/s. Range: 1-10000000.

dscp-remark
Remarks the DSCP for traffic that exceeds the commit or peak-rate.

peak-rate
Configures the peak-rate as per RFC 2698.

peak-rate kbps<1-10000000>
Configures the peak-rate in Kb/s. Range: 1-10000000.

drop
Drops the traffic which exceeds the peak-rate.

Usage
If the traffic on the interface on which the policy is applied exceeds:

• For the commit-rate, its DSCP is remarked to the configured value.

• For the peak-rate, traffic is either dropped or DSCP remarked again.

Examples
switch(config)# class
ipv4                  Classify traffic based on IPv4 information.
ipv6                  Classify traffic based on IPv6 information.
mac                   Classify traffic based on Ethernet header information.
resequence            Renumber the entries in the class.
switch(config)# class ipv4 class1 
switch(config-class)# 10
ignore                Create a rule to ignore specified packets.
match                 Create a rule to match specified packets.
remark                Add a comment to the class.
gre                   Match GRE packets.
esp                   Match ESP packets.
ah                    Match AH packets.
ospf                  Match OSPF packets.
pim                   Match PIM packets.
vrrp                  Match VRRP packets.
alias-src             Specify the netdestination to control incoming packets.
icmp                  Match ICMP packets.
igmp                  Match IGMP packets.
ip                    Match IP packets.
sctp                  Match SCTP packets.
tcp                   Match TCP packets.
udp                   Match UDP packets.
switch(config-class)# 10 match ip any any
ip-dscp               Match a specified IP DSCP value.
precedence            Match a specified IP precedence value.
tos                   Match a specified IP Type of Service value.
vlan                  Match a specified VLAN ID.
<cr>
switch(config-class)# 10 match ip any any
switch(config-class)#
switch(config)#
switch(config)# show run

Running configuration:

; JL557A Configuration Editor; Created on release #WC.16.06.0000x
; Ver #13:03.f8.1c.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:49
hostname "switch-name"
module 1 type jl557a
class ipv4 "class1"
     10 match ip 0.0.0.0 255.255.255.255 0.0.0.0 255.255.255.255
   exit
policy qos "qos-policy-1"
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   exit
policy qos "qos-policy1"
   exit
interface 2
   speed-duplex auto-100
   exit
interface 48
   speed-duplex auto-100
   exit
snmp-server community "public" unrestricted
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-52
   ip address dhcp-bootp
   ipv6 enable
   ipv6 address dhcp full
   exit
switch(policy-qos)# 10 class ipv4
ASCII-STR             Enter an ASCII string.
switch(policy-qos)# 10 class ipv4 class1 action
    dscp                  Specify an IP DSCP.
 ip-precedence         Specify the IP precedence.
 meter                 Configure a two-rate-three-color-marker as specified in
                       RFC 2698.
 priority              Specify the priority.
 rate-limit            Configure rate limiting for all traffic.
switch(policy-qos)# 10 class ipv4 class1 action meter
switch(policy-qos)# 10 class ipv4 class1 action meter commit-rate kb
switch(policy-qos)# 10 class ipv4 class1 action meter commit-rate kbps
<1-10000000>          Enter an integer number.
switch(policy-qos)# 10 class ipv4 class1 action meter commit-rate kbps 1000

dscp-remark           Remark the DSCP for traffic which exceeds the commit-rate.
switch(policy-qos)# 10 class ipv4 class1 action meter commit-rate kbps 1000

dscp-remark           Remark the DSCP for traffic which exceeds the commit-rate.
switch(policy-qos)# 10 class ipv4 class1 action meter commit-rate kbps 1000 dscp
switch(policy-qos)# 10 class ipv4 class1 action meter commit-rate kbps 1000 dscp-remark
af11                  Match DSCP AF11 (001010)
af12                  Match DSCP AF12 (001100)
af22                  Match DSCP AF22 (010100)
af23                  Match DSCP AF23 (010110)
af42                  Match DSCP AF42 (100100)
af43                  Match DSCP AF43 (100110)
cs5                   Match DSCP CS4 (101000)
cs6                   Match DSCP CS6 (110000)
ef                    Match DSCP EF (101110)
switch(policy-qos)# 10 class ipv4 class1 action meter commit-rate kbps 1000 dscp-remark cs7

switch(policy-qos)# 10 class ipv4 class1 action meter commit-rate kbps 1000 dscp-remark cs7 peak-rate
dscp-remark           Remark the DSCP for traffic which exceeds the peak-rate.
switch(policy-qos)# 10 class ipv4 class1 action meter commit-rate kbps 1000 dscp-remark cs7 peak-rate kbps 1000 drop
The commit rate must be less than the peak rate.
switch# 10 class ipv4 class1 action meter commit-rate kbps 1000 dscp-remark cs7 peak-rate kbps 2000

drop                  Drop the traffic which exceeds the peak-rate.
dscp-remark           Remark the DSCP for traffic which exceeds the peak-rate.
switch(policy-qos)# 10 class ipv4 class1 action meter commit-rate kbps 1000 dscp-remark cs7 peak-rate kbps 2000 drop

switch(config)#
switch(config)# show run

; JL557A Configuration Editor; Created on release #WC.16.06.0000x
; Ver #13:03.f8.1c.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:49
hostname "switch-name"
module 1 type jl557a
class ipv4 "class1"
     10 match ip 0.0.0.0 255.255.255.255 0.0.0.0 255.255.255.255
   exit
policy qos "qos-policy-1"
     10 class ipv4 "class1" action meter commit-rate kbps 1000 dscp-remark cs7
peak-rate kbps 2000 drop
   exit
policy qos "qos-policy1"
   exit
interface 2
   speed-duplex auto-100
   exit
interface 48
   speed-duplex auto-100
   exit
snmp-server community "public" unrestricted
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show statistics

Syntax
show statistics policy POLICY-NAME-STR port PORT-NUM

Description

Displays the statistics for a configured policy applied at a port.

Command context
config

Parameters
POLICY-NAME-STR

To view the statistics, specify the policy name.

port PORT-NUM
To view the port statistics, specify either inward or outward bound port number. Currently, traffic policing is
supported only for inward direction.

Usage
show statistics policy qos-policy-1 port 1 in help
For QoS policies with the action meter, the interpretation of the statistics is as follows:
Total

Total number of packets or bytes that matches with the class statement.

Total - Exceeded CIR

Number of packets or bytes that are not metered (which are in the green band as per RFC 2698).

Exceeded CIR - Exceeded PIR

Number of packets or bytes that are remarked due to violation of CIR (which are in the yellow band as per
RFC 2698).

Exceeded PIR

Number of packets or bytes that are dropped or remarked due to violation of PIR (which are in the red band
as per RFC 2698).

Example

switch(config)# interface 1 service-policy qos-policy-1
in                    Apply the policy to inbound packets on the port.
out                   Apply the policy to outbound packets on the port.
switch(config)# interface 1 service-policy qos-policy-1 out
The QoS policy with the action 'meter' cannot be applied to a port in the
outbound direction.
switch(config)# interface 1 service-policy qos-policy-1
in
switch(config)# show statistics policy qos-policy-1
port                  The port to show statistics for.
vlan                  The VLAN to show statistics for.
switch(config)# show statistics policy qos-policy-1 port
[ethernet] PORT-NUM   Enter a port name.
switch(config)# show statistics policy qos-policy-1 port
1
switch(config)# show statistics policy qos-policy-1 port 1 in
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Hit Counts for Policy qos-policy-1 in the last 39 seconds

  Total

      10 class ipv4 "class1" action meter commit-rate kbps 1000 dscp-remark cs7
peak-rate kbps 2000 drop

(     713 )      10 match ip 0.0.0.0 255.255.255.255 0.0.0.0 255.255.255.255
Exceeded PIR |                    0 |                    0

switch(config)# show statistics policy qos-policy-1
switch(config)# interface 1 service-policy qos-policy-1 in help
Usage: [no] interface [ethernet] <PORT-LIST> [...]
       [no] interface loopback <Num> [...]
       [no] interface tunnel <Num> [...]

Description: Enter the Interface Configuration Level, or execute one
             command for that level. With no optional parameters
             specified, the "interface" command enters the
             Interface Configuration Context Level for execution of
             multiple configuration changes to the same interface.

             "interface ?" will show a list of all valid commands.

switch(config)# interface 1 service-policy q
switch(config)# interface 1 service-policy qos-policy-1 in help
switch(config)# show statistics policy qos-policy-1 port 1 in help
Usage: show statistics policy <POLICY-ID> port <PORT> {in|out}
       show statistics policy <POLICY-ID> vlan <VLAN-ID> {in|out}

Scenarios

Scenario 1

The commit-rate is greater or equal to peak rate, an error is displayed when the commit-rate exceeds the peak-
rate value.
switch(policy-qos)# 10 class ipv4 class1 action meter commit-rate kbps 1000 dscp-remark cs7 peak-rate kbps 1000 drop
The commit rate must be less than the peak rate.

Scenario 2

If you apply a policy action meter on a MAC class, an error "Only IPv4 and IPv6 classes are supported" appears.

Scenario 3

If the commit-rate and peak-rate are not in the range <1 to 10000000>, an error that the rates are not within the
configured values appears.

Scenario 4

If you apply a policy with action meter on an interface with 'out' direction, an error "QoS policy with action meter
cannot be applied for a port with outbound direction" appears.

switch(config)# interface 1 service-policy qos-policy-1
in                    Apply the policy to inbound packets on the port.
out                   Apply the policy to outbound packets on the port.
switch(config)# interface 1 service-policy qos-policy-1
out
The QoS policy with the action 'meter' cannot be applied to a port in the
outbound direction.
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Scenario 5

Meter classifier action is supported only on Ethernet ports. An error "QoS policy with classifier action meter is
applicable only on Ethernet ports" appears.

switch(vlan-1)# service-policy test in
QoS policy with classifier action meter is applicable only on Ethernet ports.

Scenario 6

When you configure a class with action meter for a policy applied on trunk or VLAN, an error "Class with meter
action cannot be configured for the policy applied on trunk or VLAN" appears.

Scenario 7

Remarking of 802.1q priority (CoS) field with the corresponding DSCP value is not supported. If attempted, the
CoS field of the packet will be set to zero and only the DSCP field of the packet is remarked. The following
behavior is noted due to this restriction:
Meter has a higher precedence over ACLs

Occurs if you apply CoS through QoS ACL on the same port as two rate meter. The CoS value of the packet
is set to zero as CIR/PIR DSCP are applied through a meter.

Packets that are remarked by meter are always egressed out of the default-priority queue

Occurs if the egress queue is selected based on the CoS value and ASIC limitation.

In the preceding illustration, the packets that are remarked by the meter are always egressed out of the
default-priority queue, Q3. The egress queue is selected based on CoS value and the ASIC limitation. The
CoS packet is marked as zero and the queue corresponding to CoS value of zero is selected.

Metered outcome is undetermined if multiple meters are applied on the same port

Occurs when you meter the traffic on a port using a QoS policy, and apply a new meter on the same port for
that class of traffic using a user-policy. Due to ASIC limitation, the outcome of the metered rate is not
determined.

The following example shows difference in rate limit when a QoS policy and user policy is applied on the
same port:

‘policy-qos’ is a QoS policy
‘policy-user’ is an user policy
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‘c1’ is a class which matches all IP traffic

switch(config)# show policy policy-qos

Statements for policy "policy-qos"
policy qos "policy-qos"
     10 class ipv4 "c1" action rate-limit kbps 2000
   exit

switch(config)# show policy policy-user

Statements for policy "policy-user"
policy user "policy-user"
     10 class ipv4 "c1" action rate-limit kbps 1000
   exit

switch(config)# show class ipv4 c1

Statements for class IPv4 "c1"
class ipv4 "c1"
     10 match ip 0.0.0.0 255.255.255.255 0.0.0.0 255.255.255.255
   exit

The QoS Policy, policy-qos is applied to the interface
switch(config)# show run int 1
 
Running configuration:
 
interface 1
   service-policy "policy-qos" in
   untagged vlan 10
   aaa port-access mac-based
   exit

In the preceding example, we observe that the rate at which traffic 
is limited is as per the configuration (2000 kbps). 
We also observe that port 1 is enabled with mac-based authentication. 
As part of mac-based authentication, user-policy is applied to the client. 

The following show command displays the client details. 

A mac-auth client is applied on the same port with user policy, policy-user
switch(config)# show port-access client detail   
 
 Port Access Client Status Detail
 
  Client Base Details :                     
   Port            : 1                     Authentication Type : mac-based   
   Client Status   : authenticated         Session Time        : 145 seconds   
   Client Name     : 00000087b9fe          Session Timeout     : 0 seconds     
   MAC Address     : 000000-87b9fe    
   IP              : n/a                                    
 
 User Role Information
 
   Name                              : authRole
   Type                              : local
   Reauthentication Period (seconds) : 0
   Untagged VLAN                     : 10
   Tagged VLANs                      :                                                        
   Captive Portal Profile            : 
   Policy                            : policy-user
 
Statements for policy "policy-user"
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policy user "policy-user"
     10 class ipv4 "c1" action rate-limit kbps 1000
   exit
 
 
Statements for class IPv4 "c1"
class ipv4 "c1"
     10 match ip 0.0.0.0 255.255.255.255 0.0.0.0 255.255.255.255
   exit
 
   Tunnelednode Server Redirect      : Disabled
   Secondary Role Name               : 

 After the port is applied with the meter specified in user policy, policy-user (1000 kbps), 
 the rate of traffic varies between 0 kbps and 1000 kbps.

You can overcome the preceding restrictions using the following work-around:

• Stop the incoming traffic or the lower the rate to less than 100 kbps for a couple of seconds after you apply the
second meter on the port.

• Before the traffic flow, apply the meters on the interface.

Restrictions
Traffic policing comes with the following restrictions:

• Does not support MAC classes.

• Cannot configure burst size even though RFC 2698 allows you to specify committed burst size and peak burst
size. Incorrect burst sizes can either lead to excessive traffic loss, or poor rate-limiting thus reducing the
performance.

• Cannot configure rates in packets-per-second.

• Exceeded commit-rate packets are only DSCP remarked.

• Operates only in color blind mode.

• Applicable only for QoS policies and not PBR or mirror policies.

• Cannot configure using Next Gen WEBUI or switch menu.

• QoS policy containing a two rate meter can only be applied on individual physical interfaces, and not on logical
interfaces (VLANs or LAG).

• The Egress ACLs do not support DSCP remarking. As DSCP remarking is the only supported action for
commit-rate violation, traffic policing cannot be enabled on an outward interface.

• If you apply CoS through QoS ACL on the same port as two rate meter, the meter has a higher precedence
over ACLs. The CoS value of the packet is set to zero as CIR/PIR DSCP is applied through a meter.

IP Multicast (IGMP) interaction with QoS
IGMP high-priority-forward causes the switch to service the subscribed IP multicast group traffic at high priority,
even if QoS on the switch has relegated the traffic to a lower priority. This does not affect any QoS priority
settings, so the QoS priority is honored by downstream devices. However, QoS does take precedence over IGMP
normal-priority traffic.

The switch’s ability to prioritize IGMP traffic for either a normal or high priority outbound queue overrides any QoS
criteria, and does not affect any 802.1p priority settings the switch may assign. For a given packet, if both IGMP
high priority and QoS are configured, the QoS classification occurs and the switch marks the packet for
downstream devices, but the packet is serviced by the high-priority queue when leaving the switch.

214 Aruba 2930F / 2930M Advanced Traffic Management Guide for
ArubaOS-Switch 16.08

Anexo 08 ITENS 8 E 9 (0592727)         SEI 0008478-63.2018.6.02.8000 / pg. 7818



IGMP high priority QoS configuration
affects packet

Switch port output
queue

Outbound 802.1p setting
(requires tagged VLAN)

Not Enabled Yes Determined by QoS Determined by QoS

Enabled See above paragraph. High As determined by QoS if QoS
is active.

QoS messages in the CLI
Message Meaning

DSCP Policy < decimal-codepoint > not configured You have attempted to map a QoS classifier to a
codepoint for which there is no configured priority (No-
override). Use the qos dscp-map command to
configure a priority for the codepoint, then map the
classifier to the codepoint.

Cannot modify DSCP Policy < codepoint > - in use by
other qos rules.

You have attempted to map a QoS classifier to a
codepoint that is already in use by other QoS
classifiers. Before remapping the codepoint to a new
priority, you must reconfigure the other QoS classifiers
so that they do not use this codepoint. You can have
multiple QoS classifiers use this same codepoint as
long as it is acceptable for all such classifiers to use
the same priority.

Configuring traffic templates
In order to define mappings of 802.1p priorities to queues, traffic class groups (traffic groups) are defined as part
of a traffic template. A traffic group consists of a set of 802.1p priorities that are mapped to the same egress
queue. A traffic template consists of a set of traffic groups that cover all priorities 0- 7. The number of traffic
groups allowed within a traffic template is equal to the number of queues configured on a platform, although a
queue may have no priorities mapped to it.

For example, if you want to configure a switch with a priority to queue mapping that matches a connected
networking device’s queue configuration, and the neighbor device has 3 queues configured, all priorities should
be mapped to the 3 highest priority queues on the switch in a manner that matches the configuration of the
neighbor device.

Once defined, the traffic template is then assigned in its entirety to all ports of the switch.

Two predefined traffic templates are provided that correspond to the IEEE 802.1p traffic group specification
(default-tcgt) and the 802.1q update (dot1q.tcgt). These predefined templates may be applied as is, or they may
be used as the basis for defining a custom template.

Displaying traffic template information
To display a summary of all traffic templates, enter the show qos traffic-template command.

List of the currently defined traffic templates and their status

switch(config)# show qos traffic-template

System default template: default-tcgt
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Template Name                        Status      Queues
-------------                        ------      ------
example                              Valid          4
dot1q-tcgt (predefined)              Valid          4
default-tcgt (predefined)            Active         4
To display detailed information about a single traffic template, enter the show qos traffic-template
<template-name> command.

List of the currently defined traffic templates and their status

switch(config)# show qos traffic-template default-tcgt

  Template Name: default-tcgt (predefined)
  Status       : Active

Queue-no  Priorities     Name
--------  -------------  --------------------
1         1,2            background-tcg
2         0,3            best-effort-tcg
3         4,5            controlled-load-tcg 
4         6,7            control-tcg
Note: The Name column shows the descriptive names assigned to the traffic group to help identify their purpose.

Creating a traffic template
A traffic template can be created, modified, or deleted by entering this command in the global configuration
context.

Syntax:

qos traffic-template <template-name>

no qos traffic-template <template-name>
Enter the Traffic Template Configuration level or execute one command for that level. With no additional
parameters specified, the qos traffic-template command changes the context to Traffic Template
Configuration level for execution of configuration changes to the named template.

If <template-name> does not exist already, the template will be created as a copy of default-tcgt and the traffic
template context is entered. The maximum length is 40 characters.

If <template-name> already exists, the traffic template context for that template is entered and you can make
modifications to the template.

qos traffic-template <template-name> <copy-from-name>
When executed, a new template is created with the name <template-name> as a copy of the existing template
named <copy-from-name>.

NOTE: You cannot modify any predefined traffic templates.

no qos traffic-template <template-name>
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Deletes the specified traffic template. Predefined templates and the currently active template may not be deleted.

show qos traffic-template [<template-name>]
When entered without the name of a specific traffic template, displays a list of the current traffic templates and
their status - active, valid, or invalid.

When executed with the name of a specific traffic template, detailed information for that traffic template is
displayed.

After executing the qos traffic-template <template-name> command in the global configuration
context, you are in traffic template context and can begin modifying a newly created template or an existing
template.

Creating a new traffic template and entering traffic template configuration context

switch(config)# qos traffic-template example

switch(cfg-tcgt-example1)# show qos traffic-template example
  
 Template Name: example
 Status : Valid

Queue-no  Priorities     Name
--------  -------------  --------------------
1         1,2            background-tcg
2         0,3            best-effort-tcg
3         4,5            controlled-load-tcg
4         6,7            control-tcg
      
1 Traffic template context

You should always check the traffic template status using the show qos traffic-template command to
make sure that the template is valid. Invalid templates cannot be applied to ports. A traffic template will be invalid
if the priorities are not mapped to an egress queue. This can happen, for example, if you delete a priority from a
queue and do not reassign it to another queue.

If a template has been applied, it is considered to be in use and cannot be deleted. The show qos queue-
config command displays the currently active traffic template.

Displaying the currently active traffic template

switch(config)# show qos queue-config

 Egress Queue Configuration

 Number of Queues: 8
 Traffic Template: default-tcgt

        802.1p
 Queue Priority
 ----- --------
 1      1
 2      2
 3      0
 4      3
 5      4
 6      5
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 7      6
 8      7

Configuring traffic groups within a traffic template
When in the traffic template context, you can modify traffic groups within that template by changing which
priorities are assigned to what queues, as well as assigning a name to each group.

Syntax:

map-traffic-group <queue-num> priority <priority> | [name <namestring>]

no map-traffic-group <queue-num> priority <priority> | [name <namestring>]
Allows configuration of traffic groups with a traffic template.

The no form of the command removes a priority from the currently mapped queue.

<queue-num>: Ranges from 1 to the number of active queues, which can vary from 1 to 8 queues. The number
of queues is configured with the qos queue-config command.

priority <0-7>: Specifies an 802.1p priority to assign this queue. This command may be repeated to assign
multiple priorities to the same queue.

name <namestring>: Assigns a documentary label to the traffic group. Maximum length is 40 characters.

The no form of the command removes the descriptive name from the group.

Moving a priority from one traffic group to another
Typically, when modifying a traffic template, priorities are reassigned to different queues. When moving a priority
from one traffic group to another, you must first delete that priority from the traffic group it is currently mapped to
(no map-traffic-group <queue-num> priority <priority> and then add it the desired traffic group.

NOTE: Before changing the traffic groups’ priority mappings from the defaults, it is important to
examine the current policies that act on 802.1p priorities to ensure that the policies best serve the
behavior desired on the network, including DSCP, VLAN, interface, or protocol rules.

Removing priorities from a traffic group

switch(cfg-tcgt-example)# no map-traffic-group 2 priority 0
After removing the priority from the currently mapped queue, the template becomes invalid because priority 0 is
no longer mapped to any queue.

Mapping the priority to a new queue results in a valid traffic template again.

Invalid traffic template because a priority is unmapped

switch(cfg-tcgt-example)# show qos traffic-template example

TRAFFIC-TEMPLATE: example
Status          : Invalid

Queue-no  Priorities     Name
--------  -------------  --------------------
1         1,2            background-tcg
2         3              best-effort-tcg
3         4,5            controlled-load-tcg
4         6,7            control-tcg
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Valid traffic template with remapped queue

switch(cfg-tcgt-example)# map-traffic-group 1 priority 0

switch(cfg-tcgt-example)# show qos traffic-template example

Template Name: example
Status       : Valid

Queue     Priorities     Name
--------  -------------  --------------------
1         1,2            background-tcg
2         3,0            best-effort-tcg
3         4,5            controlled-load-tcg
4         6,7            control-tcg
After modifying a traffic template, you must apply it to the switch to activate the new mapping. See Applying a
traffic template on page 219.

Applying a traffic template
After creating a traffic template with the desired queue assignments, you must apply it. The same traffic templates
is applied to the all ports on the switch. A reboot is required for the new template to take effect.

Syntax:

qos queue-config traffic-template <template-name>
Applies the specified traffic template to all the ports and reboots the switch.

Applying a traffic template to a switch

switch(config)# qos queue-config traffic-template example
 This command will modify the current running configuration,
 execute 'write memory' to replace the startup configuration,
 and then reboot.

Egress queues will be configured as follows:
 4-queues
 Queue servicing: weighted-round-robin
 simple-red disabled
 Traffic template: example

Do you want to save current configuration [y/n/^C]? y
Device will be rebooted, do you want to continue [y/n]? y

Port QoS Trust Mode
The Port QoS Trust feature restricts which packet QoS information may be used to determine inbound queue
servicing and any priority information to be permitted into the local hop.

Port QoS Trust Mode configuration allows preservation or removal of the inbound QoS priorities carried in Layer 2
(the VLAN cos or Priority CodePoint (PCP) value, known as the 802.1p priority tag) and/or in Layer 3 (the IP-ToS
byte, in IP-Precedence or IP-Diffserv mode). The different modes let the customer trust all, some, or no packet
priority fields.

The per-port configuration enables the customer to trust some sources or devices and not others. This feature is
mutually exclusive with any active port-priority configuration.
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Configuration commands

qos trust
Syntax
qos trust [default|dot1p|dscp|ip-prec|none|device [none|<DEVICE-TYPE>]]
      
Description

Set the QoS Trust Mode configuration for the port.

Options

default

Trust 802.1p priority and preserve DSCP or IP-ToS.

device <DEVICE-TYPE>

On approved devices, trust IP-ToS Differentiated-Services in IP packets, and use the DSCP-MAP to remark
the 802.1p priority. If the DSCP codepoint does not have an associated priority, the priority will be remarked to
0. On unapproved devices, trust 802.1p priority and preserve any IP- ToS values.

dot1p

Trust 802.1p priority and preserve DSCP or IP-ToS.

dscp

Trust IP-ToS Differentiated-Services in IP packets, and use the DSCP-MAP to remark the 802.1p priority. If
the DSCP codepoint does not have an associated 802.1p priority, the priority will be remarked to 0.

ip-precedence

Trust IP-ToS IP-Precedence mode in IP packets and remark the 802.1p priority.

none

Do not trust either the 802.1p priority or the IP-ToS values.

QoS trust devices

aruba-ap

Aruba Access point device.

none

Clear all trusted devices from port.

NOTE:

Both SNMP and the CLI will verify that the current QoS Port Priority and desired QoS Trust Mode
configuration are not mutually exclusive (and conversely).

qos dscp-map
Syntax
qos dscp-map <CODEPOINT> priority <PRIORITY> [name <NAME> | default | legacy]
      
Description

Modifies DSCP mapping.

Options
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default

Returns switch to the fully mapped factory-default configuration.

legacy

Restore the legacy default behavior (partial mapping) used in earlier code releases.

Show commands

show qos trust
Syntax
show qos trust [device] <PORT>
    
Description

Shows port-based QoS trust configuration

Options

device

Show list of trusted devices per-port.

<port>

Show trusted devices on a single port.

Usage
show qos trust [device | [ethernet <PORT-LIST> ]
    

show qos trust

switch# show qos trust

Port-based qos Trust Configuration

  Port    Trust Mode   | Device Trust State ---- --- ----
  A1      Default      |    
  A2      Default      |     
  A3      Device**     | Trusted
  A4      IP-Prec      |
  A5      Dot1p        |
  A5      None         |
  A5      DSCP         |
  A5      Device**     | 
  A5      Dot1p        |

** For a list of trusted devices per-port, use the command show qos trust device.
To show trusted devices on a single port, use the command show qos trust device <PORT>.
      

show qos trust device

switch# show qos trust device

Port-Based QoS Trust Configuration
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  Port    Trusted Devices
  ------- ---------------
  A1      aruba-ap
  A2      aruba-ap
  A4      aruba-ap

show qos trust device <PORT>

switch# show qos trust device <PORT>

Port A4 QoS Trust Configuration
   Current state: Trusted

   Trusted Devices: aruba-ap

Validation rules

Validation Error/Warning/Prompt

qos trust 
<UNSUPPORTEDDEVICETYPE>
                

Invalid input: %s

no qos trust <ANYVALUE>
                

Invalid command. To disable trust for a port, use
qos trust none. To return to the default
configuration and leave priority information
unchanged, use qos trust default.

QoS priority when trust mode is
anything other than <NONE> or
<DEFAULT>.

The port QoS trust mode must be <DEFAULT>
or <NONE> to configure the QoS port priority
feature.

QoS DSCP when trust mode is
anything other than <NONE> or
<DEFAULT>.

The port QoS trust mode must be <DEFAULT>
or <NONE> to configure the QoS port priority
feature.

QoS trust dot1.p when any port
QoS priority is enabled.

The port QoS priority feature must be disabled
before configuring this port QoS trust mode.

QoS trust ip-prec when any port QoS
priority is enabled.

The port QoS priority feature must be disabled
before configuring this port QoS trust mode.

QoS trust DSCP when any port QoS
priority is enabled.

The port QoS priority feature must be disabled
before configuring this port QoS trust mode.

QoS trust device when any port QoS
priority is enabled.

The port QoS priority feature must be disabled
before configuring this port QoS trust mode.

QoS queue configuration
QoS queue configuration allows you to reduce the number of outbound queues that all switch ports will use to
buffer packets for 802.1p user priorities. By default, there are eight priority queues or traffic classes. Using this
feature, you can reconfigure the switch to an eight-queue mode, four-queue mode or two-queue mode to increase
the available bandwidth per queue.
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Use the following commands to change the number of queues per port and display the current priority queue
configuration on the switch.

Syntax:

qos queue-config < 2-queues | 4-queues | 8-queues>
Configures the number of outbound priority queues for all ports on the switch using one of the following options:
2-queues, 4-queues, or 8-queues.

(Default: 8-queues)

CAUTION: This command will execute a write memory followed by an immediate reboot,
replacing the Startup configuration with the content of the current Running configuration.

The new configuration will:

• Remove any previously configured bandwidth-min output settings

• Set the new number of outbound port queues

If you select anything but ‘yes’ for this operation, the operation is aborted and a message stating Operation
aborted appears.

Syntax:

show qos queue-config
Displays the current qos queue configuration.

Mapping of outbound port queues
This table shows the mapping of 802.1p priorities to outbound port queues:

Configuring the number of priority queues
To change the number of outbound priority queues for all ports on the switch, use the qos queue-config
command.

Example:

Viewing the QoS queue configuration
Syntax:

show qos queue-config

QoS port egress-queue drop counters
Port egress-queue drop counters help customers debug network behavior and performance issues.

Egress-queue drop counters can be used to detect congestion on outbound ports, and help troubleshoot the
network.

Syntax:

show interfaces queues... | config | custom ... | display | port-utilization | 
transceiver ... | status ... | tunnel ... | ethernet PORT-LIST
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Show port configuration and status information.

show interfaces ...

switch(vlan-2)#show interface queues 1
Status and Counters - Port Counters for port 1

Name  : 
MAC Address      : b05ada-96e0df
Link Status      : Up
Port Enabled     : Yes
Port Totals (Since boot or last clear) :

Rx Packets      : 7                  Tx Packets      : 28
Rx Bytes        : 448                Tx Bytes        : 6,132
Rx Drop Packets : 0                  Tx Drop Packets : 0
Rx Drop Bytes   : 0                  Tx Drop Bytes   : 0

Egress Queue Totals (Since boot or last clear) :
   Tx Packets      Dropped Packets  Tx Bytes         Dropped Bytes
Q1 8               0                1,126            
0                                                    
Q2 0               0                0                
0                                                                                                      
                                                                              0   
Q3 2               0                136              0
Q4 0               0                0                0 
Q5 0               0                0                0
Q6 0               0                0                0
Q7 0               0                0                0
Q8 18              0                4,870            0  

QoS operating notes and restrictions
• All switches: For explicit QoS support of IP subnets, Hewlett Packard Enterprise recommends forcing IP

subnets onto separate VLANs and then configuring VLAN-based classifiers for those VLANs.

• For devices that do not support 802.1Q VLAN-tagged ports: For communication between these devices
and the switch, connect the device to a switch port configured as Untagged for the VLAN in which you want
the device's traffic to move.

• Port tagging rules: For a port on the switch to be a member of a VLAN, the port must be configured as either
Tagged or Untagged for that VLAN. A port can be an untagged member of only one VLAN of a given protocol
type. Otherwise, the switch cannot determine which VLAN should receive untagged traffic.

• Not supported: Use of an inbound 802.1p packet priority as a classifier for remapping a packet's outbound
priority to different 802.1p priority. For example, where inbound packets carry an 802.1p priority of 1, QoS
cannot be configured use this priority as a classifier for changing the outbound priority to 0.
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Introduction to Stack Management
Stacking feature is available on Aruba 2930M switches. Only ring or chain topology is supported on these
switches. For information on stacking topologies, see the Installation and Getting Started Guide corresponding to
your switch.

For more information about the supported power supplies on 2930M switches, see the Power over Ethernet
(PoE/PoE+) Planning and Implementation Guide for your switch.

You cannot stack a 2930M with a 2920 switch. You can only stack similar switches (For example, a 2930M with
another 2930M).

NOTE: This feature is different from the stacking feature that is implemented on some other
Networking switches. The other feature is implemented via the front-panel networking cables and it
does not have the high bandwidth and redundancy features of the 2930M stacking.

The stacking feature for the 2930M switches allows you to connect up to 10 switches and have them act as a
single high-bandwidth switch for both data and management.

One switch in the stack is designated as “Commander” and one switch is elected to be the “Standby”. The other
switches are designated “Member”. The Commander is responsible for the overall management of the stack. The
Standby provides redundancy for the stack and takes over stack management operations if the Commander fails,
or if a Commander failover is forced by an administrator. The Members are not part of the overall stack
management, however, they must manage their local subsystems and ports to operate correctly as part of the
stack. The Commander and Standby are also responsible for their own local subsystems and ports.

Switch Stack Management (stacking) enables you to use a single IP address and standard network cabling to
manage a group of up to 10 total switches in the same IP subnet (broadcast domain). Using stacking for these
switches enables you to:

• Simplify management of small workgroups or wiring closets while scaling your network to handle increased
bandwidth demand.

• Add switches to your network without having to first perform IP addressing tasks.

• Reduce the number of IP addresses needed in your network.

• Reduce downtime with high availability in the event of a failure.

NOTE: In the default configuration, stacking is enabled on these switches. However, if a 2930M
switch is powered on and it does not have a Stacking Module installed, stacking is disabled. If a
Stacking Module is subsequently installed in the switch, stacking must be enabled from the switch
CLI (in the configuration context) by entering the following command:

switch(config)# stacking enable

Configuring a stack

Creating a stack
Ways to create a stack include:

Chapter 9
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• Deterministic method: By the sequence in which the switches are booted. You choose which member
becomes Commander.

• Plug-and-go method: Ensure that stacking is enabled on all the switches, and then connect them together in
the desired stacking topology. The plug-and-go method lets stacking decide which member is the Commander.

Using a deterministic method

1. Install a Stacking Module into a 2930M switch and then boot the switch. Follow the procedure described in
the Switch Installation and Getting Started Guide corresponding to your switch.

NOTE: You cannot use a 2920 stacking module on a 2930M switch and vice versa.

2. Make sure that stacking is enabled for the switch:

a. Enter the show stacking command.

b. If stacking is disabled, enter stacking enable (in global config context). This command causes the
switch to reboot.

3. When the switch finishes booting, enter the show stacking command again. The switch now has the
status of Commander. It has a Member ID of 1 (one) and a default priority of 128. An example of the show
stacking output is shown below.

switch(config)# show stacking
Stack ID         : NO ID - will merge upon connectivity                        
          
MAC Address      : e0071b-e641ca    
Stack Topology   : No Stack Formed                         
Stack Status     : No Stack Formed                         
Split Policy     : One-Fragment-Up 
Uptime           : 0d 0h 12m   
Software Version : WC.16.05.0000x

 Mbr                                                                            
 ID  Mac Address       Model                                 Pri Status         
 --- ----------------- ------------------------------------- --- ---------
*1   e0071b-e641c0     Aruba JL321A 2930M-48G Switch         128 Commander

4. To generate a stack ID, enter the following command:

switch(config)#stacking set-stack
5. (Optional) To have this switch retain its function as Commander through stack boots and other situations, you

can increase its priority. The switch with the highest priority becomes Commander when all the switches are
booted simultaneously. The default priority is 128. The priority can be set to any value between 1 and 255. To
increase the switch’s stacking priority, enter the following command:

switch(config)# stacking member 1 priority 255

6. (Optional) Preconfigure (provision) the stack for the other switches that become members of the stack. You
can assign a member number and a priority by entering the following command for each switch:

switch(config)# stacking member N type JxxxxA [mac MAC-Addr]
where:
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• N is the stacking member number for the switch.

• JxxxxA is the product number of the switch (required). Any of the 2930M models can be installed and
can assume this provisioned configuration. If you specify a value for this parameter, then only a switch of
this specific model type can assume this provisioned configuration.

• (Optional) MAC-Addr can be specified if you want a specific switch to assume this provisioned
configuration. If this value is entered, then the type value for the switch that has this MAC address must
be correct, or a configuration error is logged and the switch is not allowed to join the stack.

7. Connect the stacking cables to the module ports for the desired stacking topology. For example, plug port 1
and 2 in a ring.

8. Install Stacking Modules into the other switches that will be members of the stack, but do not boot them yet.

NOTE: At a minimum, a ring topology must be created. A chain topology is not recommended
because any hardware or software failure in the stack results in lost ports, which increases the
amount of time for the recovery of full stack operation due to multiple reboots. See the
Installation and Getting Started Guide for supported topologies corresponding to your switch.

9. Boot the Standby and Member switches. The second switch that is booted becomes the Standby. The
remaining switches become Members when booted.

10. When all of the switches are booted, enter the show stacking command to confirm that the stack is
operating correctly. The following example shows ten switches in a ring topology.

Viewing output for ten switches in a ring topology

switch(config)# show stacking
MAC Address      : 941882-d83c49
Stack Topology   : Ring                                    
Stack Status     : Active                                  
Split Policy     : One-Fragment-Up 
Uptime           : 0d 0h 6m    
Software Version: WC.16.04.0000x

Mbr                                                                            
 ID  Mac Address       Model                                  Pri  Status         
 --- ----------------- ----------------------------------- -----  ----------
 *1  941882-d83c40     Aruba JL321A 2930M-48G Switch          128  Commander      
  2  941882-dd3480     Aruba JL320A 2930M-24G-PoE+ Switch     128  Member         
  3  941882-d91a40     Aruba JL319A 2930M-24G Switch          128  Member         
  4  941882-d9a240     Aruba JL321A 2930M-48G Switch          128  Member         
  5  941882-d9e900     Aruba JL319A 2930M-24G Switch          128  Member         
  6  941882-da0f40     Aruba JL319A 2930M-24G Switch          128  Member         
  7  941882-dc05c0     Aruba JL322A 2930M-48G-PoE+ Switch     128  Member         
  8  941882-dc9340     Aruba JL322A 2930M-48G-PoE+ Switch     128  Member         
  9  941882-db0080     Aruba JL321A 2930M-48G Switch          128  Standby        
 10 941882-dccf80      Aruba JL320A 2930M-24G-PoE+ Switch     128  Member

Using the plug-and-go method

1. Install a Stacking Module into each 2930M switch that will be in the stack, as described in the Installation and
Getting Started Guide for the switch, but do not connect them together with stacking cables yet.

2. Make sure that stacking is enabled for each switch.
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a. You can determine this by connecting a console to each switch and entering the command show
stacking from the switch CLI.

b. If stacking is disabled, enter the command stacking enable. This command causes the switch to
reboot.

NOTE: By default, stacking is enabled on all the 2930M switches when a Stacking Module is
installed before the switch is powered up for the first time, but if the switches were powered up
without a Stacking Module installed, then stacking is disabled.

If you are connecting stacking cables during/after switch boot, then multiple stacks can form (plug-and-go
method).

3. Connect the stacking cables between the switches to form the desired stacking topology, then power on all
switches.

When the switches that are stacked together complete booting up, one of the switches is elected as the
Commander, one of the switches is elected as the Standby, the remaining switches become Members of the
stack, and the stack becomes fully operational.

To find out the roles of the switches in the stack, connect a console to any of the switches and enter the show
stacking command. You can use the MAC address and other information in the display to determine the roles
of each of the switches.

Adding a switch to a stack as a new member
Networking stacking allows for switches to be added to the stack while the stack is operational (as long as the
maximum number of 10 switches in the stack is not exceeded).

1. Provision the stack for the new switch by entering the following command:

switch(config)# stacking member N type JxxxxA [mac MAC-Addr]
where:

• N is the stacking member number for the switch.

• JxxxxA is the product number of the switch (required). Any of the 2930M models can be installed and
assume this provisioned configuration. If you specify a value for this parameter, then only a switch of this
specific model type can assume this provisioned configuration.

• (Optional) MAC-Addr can be specified if you want a specific switch to assume this provisioned
configuration. If this value is entered, then the type value for the switch that has this MAC address must be
correct, or a configuration error is logged and the switch is not allowed to join the stack.

• (Optional) You can preconfigure a priority for the member switch by entering this command:

switch(config)# stacking <member-ID> priority <1-255>
Where:
◦ <member-ID> is the stacking member number for the switch.

◦ 1–255 is the priority (but it must be less than the priority assigned to the Commander. The priority for the
Standby should be the second highest in the stack. The member switches can be left at the default
priority value of 128.)
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NOTE: You must configure the type and the priority separately.

NOTE: When the new switch has been provisioned in the stack, a complete configuration can be
applied to the switch even before it is physically connected to the stack, connected to the
network, and powered up.

2. Power on the new switch. The new switch does not become a member of the stack unless stacking has been
enabled on the switch.

3. Install a Stacking Module into the new switch, connect the switch into the stack via the stacking cables, and
form the desired stacking topology.

4. When the switch has finished booting, establish a console session with it and, from the config context, issue
the command to enable stacking:

switch(config)# stacking enable
This causes the switch to reboot. When the reboot is complete, the switch is a member of the stack with the
attributes that you provisioned for it.

5. Confirm that the switch is now a member of the stack by issuing a show stacking command via a console
session with any of the switches in the stack. The command output should show that the new switch is a
Standby or Member of the stack with the member number and priority that you assigned to it.

When you add the switch to the stack, the following occurs:

• The Stack Revision Number is incremented by one.

• The Commander verifies that the new switch has the same switch software as the other switches in the stack,
and downloads the software to the new switch if it does not. When downloading new software, there will be an
automatic reboot during this process.

• A stack ID is assigned, even if the switch is later disconnected from the stack.

• The member’s console shows a change in hostname as Aruba-Stack-2930M. The console is redirected.

• The OOBM IP address for that member is no longer reachable.

• Ethernet port address is renamed from 1 to 1/1, 2/1,3/1 ...10/1 depending on the member number or member
port number.

Removing a switch from the stack
You can remove a switch from the stack to be redeployed in another part of the network. The procedures vary
depending on whether the switch is the Commander of the stack or not.

Removing a Member or the Standby

1. Establish a console session with the stack via direct console cable connection or telnet. If using the console
cable, connect it to the Standby.

2. Enter the following command to remove the switch from the stack:

switch(config)# stacking member N remove
This causes the switch to lose its complete configuration and to be removed from the stack configuration. A
subsequent show stacking command issued to the stack will show that the removed switch no longer exists
in the stack.
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3. Power down the removed switch.

4. Disconnect the stacking cables from the removed switch and from the other switches in the stack.

Replacing a faulty member without losing the configuration

You can replace a faulty member from the stack without affecting the switch configuration using the preconfigure
command. The following example shows how to change or drop the MAC address of the faulty member in a four
member stack using the preconfigure command.

switch(config)# stacking member 4 type JL321A mac-address e0071b-def840
This will save the current configuration. Continue [y/n]?  y

switch(config)# show stack

Stack ID         : 0100e007-1bdab580                                           
          
MAC Address      : e0071b-dab58a    
Stack Topology   : Chain                                   
Stack Status     : Active                                  
Split Policy     : One-Fragment-Up 
Uptime           : 0d 0h 34m   
Software Version : WC.16.04.0000x

Mbr                                                                            
 ID  Mac Address       Model                                 Pri  Status         
 --- -------------    -----------------------------------    ---  ----------
 *1  e0071b-dab580     Aruba JL322A 2930M-48G-PoE+ Switch    128  Commander      
  2  e0071b-de7dc0     Aruba JL321A 2930M-48G Switch         128  Member         
  3  e0071b-de8d00     Aruba JL321A 2930M-48G Switch         128  Standby        
  4  e0071b-def840     Aruba JL321A 2930M-48G Switch         128  Not Joined   
After the fourth member boots up:

switch(config)# show stack

Stack ID         : 0100e007-1bdab580                                           
          
MAC Address      : e0071b-dab58a    
Stack Topology   : Ring                                    
Stack Status     : Active                                  
Split Policy     : One-Fragment-Up 
Uptime           : 0d 0h 43m   
Software Version : WC.16.04.0000x

Mbr                                                                            
 ID  Mac Address       Model                                 Pri Status         
 --- ----------------- ------------------------------------- --- ----------
 *1  e0071b-dab580     Aruba JL322A 2930M-48G-PoE+ Switch    128 Commander      
  2  e0071b-de7dc0     Aruba JL321A 2930M-48G Switch         128 Member         
  3  e0071b-de8d00     Aruba JL321A 2930M-48G Switch         128 Standby        
  4  e0071b-def840     Aruba JL321A 2930M-48G Switch         128 Member

NOTE: Use the command stack member <id> remove reboot to reboot a stack when a stack
member is in inconsistent state, and when a failure is also detected.

Removing the Commander

1. Establish a console session with the stack via direct console cable connection or telnet. If using the console
cable, connect it to a switch other than the Commander

2. Enter the following command to force the Commander status over to the Standby switch:
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switch(config)# redundancy switchover
This results in the Standby switch taking the role of the Commander and a new Standby being selected from
the remaining member switches. The former Commander becomes a Member of the stack.

3. To remove the former Commander from the stack:

switch(config)# stacking member N remove
where N is the member number of the former Commander

4. Power down the removed switch.

5. Disconnect the stacking cables from the removed switch and from the other switches in the stack.

Renumbering stack members
If you did not provision the stack for the switches when you first created the stack, it is possible that members did
not acquire the desired member numbers. The stack members can be renumbered.

A four member stack is used in the following example with switches A, B, C, and D. These switches inadvertently
acquired member numbers 1, 3, 2, and 4, respectively. Switch B acquired member number 3 and switch C
acquired member number 2. The stack should have A=member 1, B=member 2, C=member 3, and D=member 4.

1. In the global config context, enter the remove command option for switch B (member 3) and switch C
(member 2):

switch(config)# stack member 3 remove
switch(config)# stack member 2 remove
This command clears the MAC address of the member 2 configuration to allow switch C’s MAC address to be
entered in the next command, without a duplicate MAC address occurring in the stack.

All configurations on the removed member switch are deleted, not just the stacking configuration.

2. Enter the following command:

switch(config)# stack member 2 type <J-number> mac-address <B's MAC address>
switch(config)# stack member 3 type <J-number> mac-address <C's MAC address>

3. Reboot switch B (new member 2) and then switch C (new member 3).

4. To confirm that each switch now has the desired member number, enter the show stacking command.

Restoring the operation of a stack
Restoring the operation of a stack includes restoring stack operation after disconnecting a power cord or a
stacking cable, replacing a failed stack member or a failed stacking module.

Restoring operation after disconnecting a power cord
If a power cord becomes disconnected from one of the switches in the stack, the stack operation is affected. The
stacking status of the switch that lost power is “Missing.” Its record is retained in the stack configuration. The
effect of the power loss depends on the role of the switch in the stack.

• If the Commander loses power, the Standby switch takes over as the Commander and one of the member
switches in the stack is elected as the new Standby.

• If the Standby loses power, one of the member switches in the stack is elected as the new Standby.
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• For any switch that loses power, all the network ports and stacking ports are non-operational until power is
restored to the switch and it rejoins the stack. This affects the stacking topology.

• Reconnecting the power cord restores the operation of the switch, however, if the switch was either the
Commander or the Standby, then it returns in a different role if the topology has 3 or more members. In a 2-
member stack, a Standby that reboots will rejoin as Standby.

Restoring operation after disconnecting a stacking cable
If a stacking cable becomes disconnected from one of the switches in the stack, the effect depends on the
stacking topology that is being used:

• Ring—There is little effect. The stack topology is temporarily changed to a chain topology. To recover, simply
reconnect the stacking cable; the ring topology and the previous stack configuration is restored.

• Chain—The following occurs:
◦ The smaller section (fragment) of the stack that results from the disconnection becomes Inactive (the

Stack Status value shown in the output of the show stacking command is Inactive.

◦ If the two resulting fragments are the same size, the fragment that contains the Commander will be
Active, and the other fragment becomes Inactive.

◦ Both fragments will have a Commander and a Standby selected (if there is more than one switch in each
fragment).

◦ When the stacking cable is reconnected to reform the chain:
– The Commander and Standby of the Active fragment retain those roles for the resulting stack. If the

original Commander was not in that fragment, then the stack will have a new Commander when the
stack is reformed.

– The switches in the Inactive fragment reboot and assume their new roles in the reformed chain.

Replacing a failed stack member
If a Stack Member fails, the effect on the stack depends on which member failed.

• If the Commander fails, the Standby switch takes over as the Commander and one of the Member switches in
the stack is elected as the new Standby. All network ports and stacking ports on the failed switch become non-
operational.

• If the Standby fails, one of the Member switches in the stack is elected as the new Standby. All network ports
and stacking ports on the failed switch become non-operational.

• If a Member fails, all network ports and stacking ports on that switch become non-operational.

If a Stack Member fails:

1. Physically remove the Stack Member from the stack.

2. Replace the failed Stack Member.

NOTE: Hewlett Packard Enterprise recommends using the same type (product or "J" number)
switch as a replacement since all configuration information is retained.

• If you are using the same type switch as a replacement:
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1. Provision the new switch using the stacking member N command.

2. Reconnect all Ethernet ports as they were on the failed switch.

• If you are using a different type switch as a replacement:

1. Remove the failed switch from the stack configuration using the stacking member N remove
command.

2. Provision the new switch using the stacking member N command.

3. Reconnect Ethernet ports and create a new stack configuration on the new switch.

If the replacement switch uses a different version of software, it will be updated automatically to match the
software version running on the stack.

Replacing a failed stacking module
Replacing a failed stacking module is simpler than replacing a Stack Member since the switch configuration itself
does not change. In this case, there is no need to re-provision the switch as a member of the stack. After you
replace the stacking module, if the switch that experienced the module failure was Commander or Standby, the
election of a new Commander and Standby is the same.

Merging stack fragments
When two fragments have the same stack-id, the merge of the fragments is almost always allowed regardless of
the merge policy. The Commander and Standby of the merged stack are selected based on the election rules. All
of the switches in the previously inactive fragment or fragments reboot, and then join the Active fragment as
Members.

If both fragments are Inactive, then an election process occurs. The two (or more) Commanders in the fragments
are compared. The Commander is selected using the following criteria:

1. Highest Stack Rev

2. If the stack rev is the same for both, then choose the switch with the highest configured priority

3. If the priorities are the same for both, then choose the switch with the highest OS revision

4. If the OS revisions are the same, then choose the switch with the longest uptime

5. If the uptimes are the same, then choose the switch with the lowest MAC address

Modifying the stack topology
You can increase the efficiency and redundancy of the stack by adding stacking cables to create a stacking mesh
instead of a ring. This modification can be performed while the switches are powered on and the stack is
operating. After connecting the cables, enter the show stack command. The Stack Topology field value
displays the new topology.

Downloading new software to the stack
The stack is essentially a single switch with the Commander unit controlling the management functionality, so the
process of loading new software is identical to the process for a standalone switch. For example: 2930M. See the
Management and Configuration Guide for your switch.

After new software is loaded on the Commander, the Commander installs the software on all the stack members.
The loading process can take some time.
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To load the new software:

1. Load the new software onto the Commander via TFTP or Xmodem.
2. Once the new software is loaded, establish a console session with the stack and enter the following command:

switch# boot system
This causes the entire stack to be rebooted. Each unit is booted from its image unless you specify otherwise
with options to this command. Make sure that you boot from the image to which you downloaded (that is,
primary or secondary). If you add a new member to an existing stack, the Commander updates the new
switch’s software to match the current stack software. Multiple versions of software are not supported across
stack members.

3. Confirm that the new software has been loaded on each stack member by entering the member-context
command for each member. From the stack member context, you can see the switch software version that is
running on that switch by entering the show flash or show version command.

Syntax:

member-context stack-member
Sets the CLI context so that subsequent commands apply to the stack member that is specified.

Monitoring stacking
Use the following commands to monitor the status and configuration of the stack.

Syntax:
show stacking
Shows the current state of the stack.

Viewing show stacking output

switch(config)# show stacking 

Stack ID         : 0100e007-1bdab580                                           
          
MAC Address      : e0071b-dab58a    
Stack Topology   : Ring                                    
Stack Status     : Active                                  
Split Policy     : One-Fragment-Up 
Uptime           : 0d 0h 45m   
Software Version : WC.16.04.0000x

 Mbr                                                                            
 ID  Mac Address       Model                                 Pri Status         
 --- -------------     ------------------------------------- --- ----------
 *1  e0071b-dab580     Aruba JL322A 2930M-48G-PoE+ Switch    128 Commander      
  2  e0071b-de7dc0     Aruba JL321A 2930M-48G Switch         128 Member         
  3  e0071b-de8d00     Aruba JL321A 2930M-48G Switch         128 Standby        
  4  e0071b-def840     Aruba JL321A 2930M-48G Switch         128 Member
If stacking is disabled on the switch, the show stacking command displays this message:

Stacking is disabled.
Possible values for the various parameters are:
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• Stack Topology: Chain, Ring, Unknown

• Stack Status: Active, Fragment Active, Fragment Inactive

• Pri (Priority): <1 - 255>

• Status: Commander, Standby, Member, Standby Booting, Booting, Missing, Not Joined, Failed

Syntax:
show stacking detail
Shows the same output as the show stacking command, but with much more information about each device's
stack port and connectivity, CPU state, uptime, and so on.

Viewing show stacking detail output

switch(config)# show stacking detail 

Stack ID         : 0100e007-1bdab580                                           
          
MAC Address      : e0071b-dab58a    
Stack Topology   : Ring                                    
Stack Status     : Active                                  
Split Policy     : One-Fragment-Up 
Uptime           : 0d 0h 46m   
Software Version : WC.16.04.0000x

Name             : Aruba-Stack-2930M
Contact          : 
Location         : 

Member ID        : 1 
Mac Address      : e0071b-dab580    
Type             : JL322A
Model            : Aruba JL322A 2930M-48G-PoE+ Switch                          
Priority         : 128
Status           : Commander      
ROM Version      : WC.17.01.0001                                     
Serial Number    : ff ff ff ff ff ff ff ff ff ff                                
Uptime           : 0d 0h 47m   
CPU Utilization  : 2%  
Memory - Total   : 331,407,872 bytes 
Free             : 170,619,327 bytes 
Stack Ports - 
#1 : Active, Peer member 2              
#2 : Active, Peer member 4

MAC Address      : e0071b-dab58a    
Stack Topology   : Ring                                    
Stack Status     : Active                                  
Split Policy     : One-Fragment-Up 
Uptime           : 0d 0h 46m   
Software Version : WC.16.04.0000x

Name             : Aruba-Stack-2930M
Contact          : 
Location         : 

Member ID        : 1 
Mac Address      : e0071b-dab580    
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Type             : JL322A
Model            : Aruba JL322A 2930M-48G-PoE+ Switch                          
Priority         : 128
Status           : Commander      
ROM Version      : WC.17.01.0001                                     
Serial Number    : ff ff ff ff ff ff ff ff ff ff                                
Uptime           : 0d 0h 47m   
CPU Utilization  : 2%  
Memory - Total   : 331,407,872 bytes 
Free             : 170,619,327 bytes 
Stack Ports - 
#1 : Active, Peer member 2              
#2 : Active, Peer member 4

Member ID        : 2 
Mac Address      : e0071b-de7dc0    
Type             : JL321A
Model            : Aruba JL321A 2930M-48G Switch                               
Priority         : 128
Status           : Member         
ROM Version      : WC.17.01.0001                                     
Serial Number    :                                                              
Uptime           : 0d 0h 46m   
CPU Utilization  : 0%  
Memory - Total   : 331,407,872 bytes 
Free             : 198,676,837 bytes 
Stack Ports - 
#1 : Active, Peer member 3              
#2 : Active, Peer member 1

Member ID        : 3 
Mac Address      : e0071b-de8d00    
Type             : JL321A
Model            : Aruba JL321A 2930M-48G Switch                               
Priority         : 128
Status           : Standby        
ROM Version      : WC.17.01.0001                                     
Serial Number    :                                                              
Uptime           : 0d 0h 46m   
CPU Utilization  : 0%  
Memory - Total   : 331,407,872 bytes 
Free             : 186,097,709 bytes

Member ID        : 2 
Mac Address      : e0071b-de7dc0    
Type             : JL321A
Model            : Aruba JL321A 2930M-48G Switch                               
Priority         : 128
Status           : Member         
ROM Version      : WC.17.01.0001                                     
Serial Number    :                                                              
Uptime           : 0d 0h 46m   
CPU Utilization  : 0%  
Memory - Total   : 331,407,872 bytes 
Free             : 198,676,837 bytes 
Stack Ports - 
#1 : Active, Peer member 3              
#2 : Active, Peer member 1
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Member ID        : 3 
Mac Address      : e0071b-de8d00    
Type             : JL321A
Model            : Aruba JL321A 2930M-48G Switch                               
Priority         : 128
Status           : Standby        
ROM Version      : WC.17.01.0001                                     
Serial Number    :                                                              
Uptime           : 0d 0h 46m   
CPU Utilization  : 0%  
Memory - Total   : 331,407,872 bytes 
Free             : 186,097,709 bytes 
Stack Ports - 
#1 : Active, Peer member 4              
#2 : Active, Peer member 2

Member ID        : 4 
Mac Address      : e0071b-def840    
Type             : JL321A
Model            : Aruba JL321A 2930M-48G Switch                               
Priority         : 128
Status           : Member         
ROM Version      : WC.17.01.0001                                     
Serial Number    :                                                              
Uptime           : 0d 0h 7m    
CPU Utilization  : 0%  
Memory - Total   : 331,407,872 bytes 
Free             : 198,678,297 bytes 
Stack Ports - 
#1 : Active, Peer member 1              
#2 : Active, Peer member 3
Syntax:
show stacking member stack-member-list
Shows detailed information about switches in the stack-member-list only.

Syntax:
show stacking stack-ports memberstack-member
Shows the current state of the stacking ports of the specified member. If a member is not specified, the command
shows the state of the ports of all physically present devices in the stack.

Viewing show stacking stack-ports output

switch(config)# show stacking stack-ports 
  Member Stacking Port State    Peer Member Peer Port
  ------ ------------- -------- ----------- ---------
  1      1             Up       2           2        
  1      2             Up       4           1        
  2      1             Up       3           2        
  2      2             Up       1           1        
  3      1             Up       4           2        
  3      2             Up       2           1        
  4      1             Up       1           2        
  4      2             Up       3           1
If you specify specific stack members in the command, then the stacking port information for those members
displays.
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Troubleshooting stacking
Troubleshoot OOBM and split stack issues
If all the OOBM ports in the stack are in the same VLAN, you can use the show oobm commands to view the
current state of all the switches. For example, if you have a five-member chain and the link between member 3
and 4 fails, a stack split will occur with an active fragment on members 1-2-3 and an inactive fragment on
members 4 and 5.

There is one IP address for the active fragment. This can be statically set by assigning an IP address to the global
OOBM port.

If the stack splits, you can connect to the Active Fragment using the global OOBM IP address and then enter the
show oobm discovery command to see if this active fragment has discovered any other members that are
connected using the OOBM LAN.

In the following five member chain example, connect using the global IP address of 10.0.102.173. Once logged
on, enter the show stack command.

Viewing stacking member status before split

switch# show stack

Stack ID         : 02009418-82db0080                                           
          
MAC Address      : 941882-db0089    
Stack Topology   : Chain                                   
Stack Status     : Active                                  
Split Policy     : One-Fragment-Up 
Uptime           : 0d 0h 5m    
Software Version : WC.16.04.0000x

 Mbr                                                                            
 ID  Mac Address       Model                                 Pri Status         
 --- ----------------- ------------------------------------- --- ----------
 *1  941882-db0080     Aruba JL321A 2930M-48G Switch         128 Commander      
  2  941882-dc05c0     Aruba JL322A 2930M-48G-PoE+ Switch    128 Member         
  3  941882-dc9340     Aruba JL322A 2930M-48G-PoE+ Switch    128 Member         
  4  941882-dccf80     Aruba JL320A 2930M-24G-PoE+ Switch    128 Member         
  5  941882-dd3480     Aruba JL320A 2930M-24G-PoE+ Switch    128 Standby  
Viewing stacking member status after split

switch# show stack

Stack ID         : 02009418-82db0080                                           
          
MAC Address      : 941882-db0089    
Stack Topology   : Chain                                   
Stack Status     : Fragment Active                         
Split Policy     : One-Fragment-Up 
Uptime           : 0d 0h 7m    
Software Version : WC.16.04.0000x

 Mbr                                                                            
 ID  Mac Address       Model                                 Pri Status         
 --- ----------------- ------------------------------------- --- ---------------
  1  941882-db0080     Aruba JL321A 2930M-48G Switch         128 Commander      
 *2  941882-dc05c0     Aruba JL322A 2930M-48G-PoE+ Switch    128 Member         
  3  941882-dc9340     Aruba JL322A 2930M-48G-PoE+ Switch    128 Standby Booting
  4  941882-dccf80     Aruba JL320A 2930M-24G-PoE+ Switch    128 Missing        
  5  941882-dd3480     Aruba JL320A 2930M-24G-PoE+ Switch    128 Missing        
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switch# show stack

Stack ID         : 02009418-82db0080                                           
          
MAC Address      : 941882-dd34a2    
Stack Topology   : Chain                                   
Stack Status     : Fragment Inactive                       
Split Policy     : One-Fragment-Up 
Uptime           : 0d 0h 7m    
Software Version : WC.16.04.0000x

 Mbr                                                                            
 ID  Mac Address       Model                                 Pri Status         
 --- ----------------- ------------------------------------- --- ---------------
  1  941882-db0080     Aruba JL321A 2930M-48G Switch         128 Missing        
  2  941882-dc05c0     Aruba JL322A 2930M-48G-PoE+ Switch    128 Missing        
  3  941882-dc9340     Aruba JL322A 2930M-48G-PoE+ Switch    128 Missing        
  4  941882-dccf80     Aruba JL320A 2930M-24G-PoE+ Switch    128 Missing        
 *5  941882-dd3480     Aruba JL320A 2930M-24G-PoE+ Switch    128 Commander      
Enter show oobm discovery to see if the members have been discovered using OOBM.

Viewing oobm discovery

Switch# show oobm discovery 

Active Stack Fragment(local)

IP Address  : 10.0.102.173

Mbr Mac Address        Status
ID
--- ------------------ ----------
1   941882-d83c40      Commander
2   941882-d91a40      Member
3   941882-d9a240      Member

Inactive Stack Fragment(discovered)

IP Address  : 10.0.102.114

Mbr Mac Address        Status
ID
--- ------------------ ----------
5   941882-d9e900      Commander
4   941882-da0f40      Member

 
Switch# show oobm discovery 

Inactive Stack Fragment(local)

IP Address  : 10.0.102.114

Mbr Mac Address        Status
ID
--- ------------------ ----------
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5   941882-d9e900      Commander
4   941882-da0f40      Member

Active Stack Fragment(discovered)

IP Address  : 10.0.102.173

Mbr Mac Address        Status
ID
--- ------------------ ----------
1   941882-d83c40      Commander
2   941882-d91a40      Member
3   941882-d9a240      Member
Members 4 and 5 are up, but is an inactive fragment. It has an addressable IP address, which can be used to
connect to this fragment.

Connecting to a stack fragment

switch# telnet 10.0.102.162 oobm

Aruba JL320A 2930M-24G-PoE+ Switch
Software revision WC.16.04.0000x

(C) Copyright 2017 Hewlett Packard Enterprise Development LP

                      RESTRICTED RIGHTS LEGEND
Confidential computer software. Valid license from Hewlett Packard Enterprise
Development LP required for possession, use or copying. Consistent with FAR
12.211 and 12.212, Commercial Computer Software, Computer Software
Documentation, and Technical Data for Commercial Items are licensed to the
U.S. Government under vendor's standard commercial license.

We'd like to keep you up to date about:
  * Software feature updates
  * New product announcements
  * Special events
Please register your products now at:  www.hpe.com/networking/register

Press any key to continue
Enter the show stacking command.

Viewing missing stack members

switch# show stacking 

Stack ID         : 02009418-82db0080                                           
          
MAC Address      : 941882-dd34a2    
Stack Topology   : Chain                                   
Stack Status     : Fragment Inactive                       
Split Policy     : One-Fragment-Up 
Uptime           : 0d 0h 9m    
Software Version : WC.16.04.0000x

 Mbr                                                                            
 ID  Mac Address       Model                                 Pri Status         
 --- ----------------- ------------------------------------- --- ---------------
  1  941882-db0080     Aruba JL321A 2930M-48G Switch         128 Missing        
  2  941882-dc05c0     Aruba JL322A 2930M-48G-PoE+ Switch    128 Missing        
  3  941882-dc9340     Aruba JL322A 2930M-48G-PoE+ Switch    128 Missing        
  4  941882-dccf80     Aruba JL320A 2930M-24G-PoE+ Switch    128 Missing        
  5  941882-dd3480     Aruba JL320A 2930M-24G-PoE+ Switch    128 Commander       
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Confirm by entering the oobm discovery command. Member 4 is down.

Confirming stack member 4 is down

switch# show oobm discovery 

Inactive Stack Fragment(local)

IP Address  : 10.0.102.162

Mbr Mac Address        Status
ID
--- ------------------ ----------
5   941882-dd3480      Commander

Active Stack Fragment(discovered)

IP Address  : 10.0.102.218

Mbr Mac Address        Status
ID
--- ------------------ ----------
1   941882-db0080      Commander
2   941882-dc05c0      Member
3   941882-dc9340      Member

Using fault recovery/troubleshooting tools
Stacking provides tools and logging information to aid in troubleshooting problems specific to stacking. Problems
may include:

• Installation/deployment issues

• Problems with initial stack creation
◦ Problems with adding or removing members

◦ Booting an existing stack

Stacking failures encountered while running an existing stack

The tools used in troubleshooting problems are:

• Event Log

• Show commands
◦ Show stacking

◦ Show system

◦ Show boot history

• Show tech

• LEDs
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Troubleshooting installation and deployment issues

Cause

Installation and deployment issues include the initial deployment or creation of a stack, adding additional
members or removing members from a stack.

Problem:

When using the Deterministic method, one or more of the statically provisioned members did not join the stack.

Possible reasons a switch does not join a stack are:

• The switch being added is already a member of another stack and has a different stack ID.

• The maximum number of switches is already configured.

• The switch being added has been statically provisioned. The MAC address matches, but the switch type does
not.

• There is a problem with the stack cable.

• The stack cables are connected in a way that creates an unsupported topology.

• Stack module failure.

Solution:

Perform a diagnostic analysis.

Troubleshooting issues with adding or removing members in the stack

Cause

Various problems described below could be causing issues with adding or removing members in the stack.

Problem:

Cannot add a new switch to an existing stack.

Solution:

Identify root cause. Possible reasons for a member not joining an existing stack are:

• The switch being added has already been a member of another stack and has a different stack ID.

• The maximum number of switches is already configured.

• The switch being added has been statically provisioned, but switch type and MAC address in the configuration
do not match the switch being added.

• There is a problem with the stack cable.

• There is a problem with the stack physical cabling (illegal topology).

Problem:

The entire stack does not come up after a boot.

Solution:

There are several reasons why all members do not join the stack:

• There is a problem with the stack cable.

• Physical cabling was changed.
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• Stack booted on incorrect configuration.

• One or more of the switches has a hardware problem (for example, bad power supply, back stacking module,
corrupt flash).

Problem:

One or more of the members keeps rebooting and does not join the stack.

Possible reasons:

• An unresponsive member.

• Heartbeat loss—a stack that has a member no longer in the stack or a member failing after joining the stack.

• Illegal topology.

Problem:

After initial boot sequence, the activity and Link LEDs of an interface are not on and the ports are not passing
traffic.

Solutions:

• Identify the “inactive fragment” and provide alternatives for recovery.

• Verify that all OOBMs are connected so that there is uninterrupted access.

Problem:

After a reboot, the selected Command or Standby are not the expected switches.

Solutions:

Check to see if the log files provide a reason why the Commander and Standby were chosen and which rule they
matched.

Troubleshooting a strictly provisioned, mismatched MAC address

Cause

When switches are strictly provisioned, it is possible to enter an incorrect type or incorrect MAC address. If this
occurs, the switch does not match the intended configuration entry and stacking attempts to add this switch as a
new “plug-and-go” switch. If the stacking configuration already has 10 switches, then the “plug-and-go” fails.

The following example shows a stack with 9 members. There is a new JL319A switch that is supposed to be
member 4; however, the MAC address was mis-typed, therefore, there is an “opening” for a plug-and-go at
member 10. It will join as member 10.

Action

1. This shows the stack before boot.

Viewing a stack with 9 members

switch(config)# show stack

Stack ID         : 02009418-82d83c40                                           
          
MAC Address      : 941882-d83c49    
Stack Topology   : Chain                                   
Stack Status     : Active                                  
Split Policy     : One-Fragment-Up 
Uptime           : 0d 14h 27m  
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Software Version : WC.16.04.0000x

 Mbr                                                                            
 ID  Mac Address       Model                                 Pri Status         
 --- ----------------- ------------------------------------- --- ---------------
 *1  941882-d83c40     Aruba JL321A 2930M-48G Switch         150 Commander      
  2  9cdc71-f576c0     Aruba JL324A 2930M-24SR-PoE+ Switch   128 Member         
  3  941882-d91a40     Aruba JL319A 2930M-24G Switch         128 Standby        
  4  9cdc71-f2bbc6     Aruba JL324A 2930M-24SR-PoE+ Switch   128 Not Joined     
  5  941882-d9a240     Aruba JL321A 2930M-48G Switch         128 Not Joined     
  6  941882-d9e900     Aruba JL319A 2930M-24G Switch         128 Not Joined     
  7  9cdc71-f8f480     Aruba JL323A 2930M-40G-8SR-PoE+ Sw... 128 Not Joined     
  8  941882-da0f40     Aruba JL319A 2930M-24G Switch         128 Not Joined     
  9  9cdc71-f8d400     Aruba JL323A 2930M-40G-8SR-PoE+ Sw... 128 Not Joined 

2. This shows that, after booting, the switch is joined as member 10.

Viewing a member joining the stack

switch(config)# show stack

Stack ID         : 02009418-82d83c40                                           
          
MAC Address      : 941882-d83c49    
Stack Topology   : Chain                                   
Stack Status     : Active                                  
Split Policy     : One-Fragment-Up 
Uptime           : 0d 14h 44m  
Software Version : WC.16.04.0000x

Mbr                                                                            
 ID  Mac Address       Model                                 Pri Status         
 --- ----------------- ------------------------------------- --- ---------------
 *1  941882-d83c40     Aruba JL321A 2930M-48G Switch         150 Commander      
  2  9cdc71-f576c0     Aruba JL324A 2930M-24SR-PoE+ Switch   128 Member         
  3  941882-d91a40     Aruba JL319A 2930M-24G Switch         128 Standby        
  4  9cdc71-f2bbc6     Aruba JL324A 2930M-24SR-PoE+ Switch   128 Not Joined     
  5  941882-d9a240     Aruba JL321A 2930M-48G Switch         128 Not Joined     
  6  941882-d9e900     Aruba JL319A 2930M-24G Switch         128 Not Joined     
  7  9cdc71-f8f480     Aruba JL323A 2930M-40G-8SR-PoE+ Sw... 128 Not Joined     
  8  941882-da0f40     Aruba JL319A 2930M-24G Switch         128 Not Joined     
  9  9cdc71-f8d400     Aruba JL323A 2930M-40G-8SR-PoE+ Sw... 128 Not Joined     
  10 9cdc71-f54940     Aruba JL324A 2930M-24SR-PoE+ Switch   128 Member
To correct this issue:

a. Write down the correct MAC address.

b. Remove the member that was added using plug-and-go with the strictly provisioned, mismatched MAC
address as shown in the following example.

c. Update the strictly provisioned entry with the correct MAC address.

d. Boot the switch.

Removing a member and updating the entry with a MAC address

switch(config)# stacking member 10 remove 
The specified stack member will be removed from the stack and 
its configuration will be erased. The resulting configuration 
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will be saved. The stack member will be shutdown. Continue [y/n]? y

Aruba-Stack-2930M(config)# stacking member 4 type JL324A mac-address 9cdc71-f2bbc0
This will save the current configuration. Continue [y/n]?  y

3. This shows that member 4 has joined the stack.

Viewing that member 4 joined the stack

switch(config)# show stack

Stack ID         : 02009418-82d83c40                                           
          
MAC Address      : 941882-d83c49    
Stack Topology   : Chain                                   
Stack Status     : Active                                  
Split Policy     : One-Fragment-Up 
Uptime           : 0d 14h 50m  
Software Version : WC.16.04.0000x

Mbr                                                                            
 ID  Mac Address       Model                                 Pri Status         
 --- ----------------- ------------------------------------- --- ---------------
 *1  941882-d83c40     Aruba JL321A 2930M-48G Switch         150 Commander      
  2  9cdc71-f576c0     Aruba JL324A 2930M-24SR-PoE+ Switch   128 Member         
  3  941882-d91a40     Aruba JL319A 2930M-24G Switch         128 Standby        
  4  9cdc71-f2bbc6     Aruba JL324A 2930M-24SR-PoE+ Switch   128 Not Joined     
  5  941882-d9a240     Aruba JL321A 2930M-48G Switch         128 Not Joined     
  6  941882-d9e900     Aruba JL319A 2930M-24G Switch         128 Not Joined     
  7  9cdc71-f8f480     Aruba JL323A 2930M-40G-8SR-PoE+ Sw... 128 Not Joined     
  8  941882-da0f40     Aruba JL319A 2930M-24G Switch         128 Not Joined     
  9  9cdc71-f8d400     Aruba JL323A 2930M-40G-8SR-PoE+ Sw... 128 Not Joined
  
boot member 4 
  
  
switch(config)# show stack

Stack ID         : 02009418-82d83c40                                           
          
MAC Address      : 941882-d83c49    
Stack Topology   : Chain                                   
Stack Status     : Active                                  
Split Policy     : One-Fragment-Up 
Uptime           : 0d 14h 50m  
Software Version : WC.16.04.0000x

Mbr                                                                            
 ID  Mac Address       Model                                 Pri Status         
 --- ----------------- ------------------------------------- --- ---------------
 *1  941882-d83c40     Aruba JL321A 2930M-48G Switch         150 Commander      
  2  9cdc71-f576c0     Aruba JL324A 2930M-24SR-PoE+ Switch   128 Member         
  3  941882-d91a40     Aruba JL319A 2930M-24G Switch         128 Standby        
  4  9cdc71-f2bbc0     Aruba JL324A 2930M-24SR-PoE+ Switch   128 Member     
  5  941882-d9a240     Aruba JL321A 2930M-48G Switch         128 Not Joined     
  6  941882-d9e900     Aruba JL319A 2930M-24G Switch         128 Not Joined     
  7  9cdc71-f8f480     Aruba JL323A 2930M-40G-8SR-PoE+ Sw... 128 Not Joined     
  8  941882-da0f40     Aruba JL319A 2930M-24G Switch         128 Not Joined     
  9  9cdc71-f8d400     Aruba JL323A 2930M-40G-8SR-PoE+ Sw... 128 Not Joined
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Troubleshoot a mismatched stack-ID
This is an example of a stack that has two members with three more members that have been strictly provisioned,
following the deterministic method of initial installation.

Viewing a stack with 3 unjoined switches

switch# show stack

Stack ID         : 01009418-82d9e900                                           
          
MAC Address      : 941882-da0f62    
Stack Topology   : Chain                                   
Stack Status     : Active                                  
Split Policy     : One-Fragment-Up 
Uptime           : 0d 0h 3m    
Software Version : WC.16.04.0000x

 Mbr                                                                            
 ID  Mac Address       Model                                 Pri Status         
 --- ----------------- ------------------------------------- --- ---------------
  1  941882-d83c40     Aruba JL321A 2930M-48G Switch         128 Not Joined     
  2  941882-d91a40     Aruba JL319A 2930M-24G Switch         128 Not Joined     
  3  941882-d9a240     Aruba JL321A 2930M-48G Switch         128 Not Joined     
 *4  941882-da0f40     Aruba JL319A 2930M-24G Switch         128 Commander      
  5  941882-d9e900     Aruba JL319A 2930M-24G Switch         128 Standby  
When powering on switch 3, it does not join the stack.

The stack ports for the new switch appear online, however, the show stacking command shows that the
switch has not been recognized.

Viewing the switch is not recognized

switch(config)# show stack

Stack ID         : 01009418-82d9a240                                           
          
MAC Address      : 941882-d9a249    
Stack Topology   : Chain                                   
Stack Status     : Active                                  
Split Policy     : One-Fragment-Up 
Uptime           : 0d 0h 1m    
Software Version : WC.16.04.0000x

 Mbr                                                                            
 ID  Mac Address       Model                                 Pri Status         
 --- ----------------- ------------------------------------- --- ---------------
 *3  941882-d9a240     Aruba JL321A 2930M-48G Switch         128 Commander
The show stacking command does not show that the member is “Not Joined.”

A log file indicates that a “topo /hello” was seen from a switch that was not part of the current stack ID. The
console of the switch that should have been member 3 shows the following example output.

Viewing output from the “not joined” switch

switch(config)# show stacking stack-ports member 4,5

Member 4

  Member Stacking Port State    Peer Member Peer Port
  ------ ------------- -------- ----------- ---------
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  4      1             Down     0           0        
  4      2             Up       5           1        

Member 5

  Member Stacking Port State    Peer Member Peer Port
  ------ ------------- -------- ----------- ---------
  5      1             Up       4           2        
  5      2             Down     0           0  
The output is different if you have an inactive fragment, since this switch can have the configuration from an old
stack. In this case, it might be inactive and show ‘missing’ switches from the old configuration. The stack-id value
does not match the stack ID of the Aruba Stack 2930M stacking factory reset.

switch(config)# stacking factory-reset
Configuration will be deleted and device rebooted,continue [y/n]? 
Y
     
To join this switch to the other stack, execute the stacking factory-reset command to erase all of the stale
stacking configuration information. This command automatically reboots the switch and on its subsequent boot,
the switch is able to join the new stack.

Troubleshoot stacking problems using the show logging command
The show logging command troubleshoots problems in stacking.

Syntax

show logging <a|b|r|s|t|m|p|e|w|i|d|command|filter|option-str|substring ...]>
The options a|r|substring can be used in combination with an event class option.
a

Instructs the switch to display all recorded log events, which include events from previous boot cycles.

b

Display log events as time since boot instead of date/time format.

r

Instructs the switch to display recorded log events in reverse order (most recent first.)

s

Display AMM and SMM log events.

t

Display log events in granularity in 10 milli seconds.

command

Instructs the switch to display command logs.

substring

Instructs the switch to display only those events that match the substring.

The remaining event class options are listed in order of severity - lowest severity first. The output of the command
is confined to event classes of equal or higher severity.

Only one of options d|i|w|e|p|m can be used in the command at a time.

The a|r and substring options may be used in combination with an event class option.
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m

Display major type of messages.

e

Display error event class.

p

Display major and error type of messages.

w

Display major, error, and warning type of messages.

I

Display major, error, warning, and information.

d

Display major, error, warning, information, and debug messages.

filter

Display log filter configuration and status information.

Option-str

Filter events shown.

show logging example output

switch# show logging -e
Keys:   W=Warning   I=Information
         M=Major     D=Debug E=Error
----  Event Log listing: Events Since Boot  ----
M 07/05/17 18:52:33 00064 system: ST4-CMDR: Reboot of Member ID 4, User reboot
M 07/05/17 18:52:33 02796 chassis: ST4-CMDR: Internal power supply 1 inserted.
            Total fault count: 0.
M 07/05/17 18:52:33 02797 chassis: ST4-CMDR: Internal power supply 1 is OK.
            Total fault count: 0.
M 07/05/17 18:52:50 02796 chassis: ST5-STBY: Internal power supply 1 inserted.
            Total fault count: 0.
M 07/05/17 18:52:50 02797 chassis: ST5-STBY: Internal power supply 1 is OK.
            Total fault count: 0.
----  Bottom of Log : Events Listed = 5  ----

Troubleshooting a strictly provisioned, mismatched type

Cause

When the MAC address matches a strictly provisioned configuration, it either matches the configured type and
succeeds, or it does not match the type and fails. This is because the MAC address is unique and you cannot
have duplicate MAC addresses.

The log messages indicate that this was the type of failure. The information in the log message helps you correct
the configuration.

Action

1. The switch that fails to join automatically reboots. Execute the show stacking command to view the mis-
configured entry.

Viewing the mis-configured entry
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switch(config)# show stack

Stack ID         : 01009418-82d83c40                                           
          
MAC Address      : 941882-d83c4a    
Stack Topology   : Chain                                   
Stack Status     : Active                                  
Split Policy     : One-Fragment-Up 
Uptime           : 0d 0h 8m    
Software Version : WC.16.04.0000x

 Mbr                                                                            
 ID  Mac Address       Model                                 Pri Status         
 --- ----------------- ------------------------------------- --- ---------------
 *1  941882-d83c40     Aruba JL321A 2930M-48G Switch         128 Commander      
  2  941882-d91a40     Aruba JL319A 2930M-24G Switch         128 Member         
  3  941882-d9a240     Aruba JL321A 2930M-48G Switch         128 Member         
  4  941882-d9e900     Aruba JL319A 2930M-24G Switch         128 Standby        
  5  941882-da0f40     Aruba JL321A 2930M-48G Switch         128 Not Joined  

2. The configuration entry for member 5 matches a JL319A switch that will be added, however, it will fail because
it is configured as a JL321A switch. failures

The following example shows the log entries with the failure to join the stack.

I 07/05/17 19:21:51 02556 chassis: ST4-STBY: Stack port 1 cable inserted.
W 07/05/17 19:22:02 03277 stacking: ST1-CMDR: Member 5 (941882-da0f40) cannot
            join stack due to incorrect product id: JL319A
I 07/05/17 19:22:02 02558 chassis: ST4-STBY: Stack port 1 is now on-line.
W 07/05/17 19:23:32 03258 stacking: ST1-CMDR: Provisioned switch with Member ID
            5 removed due to loss of communication
I 07/05/17 19:23:32 03272 stacking: ST1-CMDR: Stack fragment active
I 07/05/17 19:24:11 05225 activate: ST1-CMDR: Loading security certificates and
            synchronizing time with NTP.
W 07/05/17 19:24:17 05220 activate: ST1-CMDR: Unable to resolve the Activate
            server address device.arubanetworks.com.
----  Bottom of Log : Events Listed = 192  ----
switch# 

3. You cannot re-type the configuration command with the same MAC address, member ID, and a different J-
number. Remove the configuration and then reconfigure this switch member entry.

Removing a stack member and reconfiguring

switch# stacking member 5 remove
The specified stack member configuration will be erased. The
resulting configuration will be saved. Continue [y/n]?   y
switch(config)# stacking member 5 type JL319A mac-address 941882-da0f40

4. Boot the switch with the matching MAC/Type.

Viewing joined stack members

switch(config)# show stack

Stack ID         : 01009418-82d83c40                                           
          
MAC Address      : 941882-d83c4a    
Stack Topology   : Chain                                   
Stack Status     : Active                                  
Split Policy     : One-Fragment-Up 
Uptime           : 0d 0h 43m   
Software Version : WC.16.04.0000x
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 Mbr                                                                            
 ID  Mac Address       Model                                 Pri Status         
 --- ----------------- ------------------------------------- --- ---------------
  1  941882-d83c40     Aruba JL321A 2930M-48G Switch         128 Commander      
  2  941882-d91a40     Aruba JL319A 2930M-24G Switch         128 Member         
  3  941882-d9a240     Aruba JL321A 2930M-48G Switch         128 Member         
 *4  941882-d9e900     Aruba JL319A 2930M-24G Switch         128 Standby        
  5  941882-da0f40     Aruba JL319A 2930M-24G Switch         128 Member

Troubleshooting maximum stack members exceeded

Cause

This failure can happen if you have an active stack that has already reached its maximum number of members. It
can also happen when the maximum number of switches is reached with a combination of active members and
strictly provisioned members.

Since one of the suggested initial deployment techniques is a deterministic method using strictly provisioned
entries, this failure example demonstrates what occurs if the maximum number of members is reached by strictly
provisioning 10 members. At least one of these configuration entries has an incorrect MAC addresses. Similar to
the mismatched MAC address example, the stack attempts to “plug-and-go” to add the switch, however, since the
maximum number of membership has already been reached, the switch cannot join the stack.

Action

1. The following example shows the show stacking output before the switch attempts to join.

Viewing stack members before the join

switch(config)# show stack

Stack ID         : 02009418-82d83c40                                           
          
MAC Address      : 941882-d83c49    
Stack Topology   : Chain                                   
Stack Status     : Active                                  
Split Policy     : One-Fragment-Up 
Uptime           : 0d 15h 3m   
Software Version : WC.16.04.0000x

Mbr                                                                            
 ID  Mac Address   Model                               Pri Status         
 ---------------------------------------------------------------------
 *1  941882-d83c40 Aruba JL321A 2930M-48G Switch       150 Commander      
  2  9cdc71-f576c0 Aruba JL324A 2930M-24SR-PoE+ Switch 128 Member         
  3  941882-d91a40 Aruba JL319A 2930M-24G Switch       128 Standby        
  4  9cdc71-f2bbc0 Aruba JL324A 2930M-24SR-PoE+ Switch 128 Member         
  5  941882-d9a240 Aruba JL321A 2930M-48G Switch       128 Not Joined         
  6  941882-d9e900 Aruba JL319A 2930M-24G Switch       128 Not Joined         
  7  9cdc71-f8f480 Aruba JL323A 2930M-40G-8SR-PoE+ Sw..128 Not Joined         
  8  941882-da0f40 Aruba JL319A 2930M-24G Switch       128 Not Joined         
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  9  9cdc71-f8d400 Aruba JL323A 2930M-40G-8SR-PoE+ Sw..128 Not Joined         
  10 9cdc71-f54940 Aruba JL324A 2930M-24SR-PoE+ Switch 128 Not Joined

2. When a switch that does not match the MAC addresses attempts to join, that switch reboots when the
maximum configuration is detected. The active stack logs the following:

W 10/07/00 06:01:11 03253 stacking: ST3–CMDR: Maximum number of switches in the 
stack has been reached. Cannot add 1cc1de-4da900 type JL324A.

3. The failure can be due to one of the strictly provisioned entries being incorrect. To correct this entry, reboot the
switch. If there are already 10 switches in the stack, you cannot add additional switches at this time.

Troubleshooting a bad cable

Cause

Bad cables can cause the stack port to flap or go down completely. If there are an excessive number of port flaps,
the port is disabled and the following log message appears:

W 10/06:00 23:23:16 03260 chassis: ST4–CMDR: Stack port 1 disabled due to 
excessive errors. Check cable. To reenable use 'stacking member 4 stack-port 1 
enable'.

Action

1. When this occurs, the show stacking stack-ports command shows the port with a status of “Disabled”.

Viewing a disabled stack port

switch(config)# show stacking stack-ports 

Member Stacking      Port State Peer Member Peer Port
------ ------------- --------   ----------- -----------
1      1             Up         2            2        
1      2             Down       0            0        
2      1             Up         3            2        
2      2             Up         1            1        
3      1             Up         4            2        
3      2             Up         2            1        
4      1             Disabled   0            0        
4      2             Up         3            1        
5      1             Down       0            0        
5      2             Up         4            1     
   
switch(config)#

2. The following example shows member 3, port 2, which should be connected to member 4, port 1. The ports
are down because the cable is bad or disconnected.

Viewing that two ports are down due to a bad connection

switch# show stacking stack-ports 

Member Stacking Port State    Peer Member Peer Port
------ ------------- -------- ----------- ---------
1      1             Up       2           2        
1      2             Down     0           0        
2      1             Up       3           2        
2      2             Up       1           1        
3      1             Down     0           0        
3      2             Up       2           1        
4      1             Up       5           2        
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4      2             Down     0           0        
5      1             Down     0           0        
5      2             Up       4           1   

3. The solution in both cases is to ensure that the cable is firmly connected at both ends. If the problem
continues, replace the cable. It is possible that there could be a problem with the stack port itself. In this case,
validation of this issue requires the installation of a known good cable to see if that cable also fails.

The port state is not UP until both ends of the cable are connected and the cable has been validated as a
genuine cable.

To view the statistics on the physical port, execute the show tech command in member-context 4. The
following examples show the types of information displayed.

Viewing show tech output

Port Number : 1 State : Available
Last Event  : Available Start Req : 1
NE Present  : 1 HPID Good : 1
HPID Fails  : 0 FE Present : 1
Rem Dev Rdy : 1
ESSI Link   : 1 ESSI Good : 1
ESSI Fails  : 0 ESSI TX En : 1
ICL Good    : 1 ICL Enabled : 1
30 Stack Management for 2930M
LP Local RDY: 1 LP Rem RDY : 1
LP DONE     : 1 ICL FailCnt : 0 (10 second interval)
ICL FailCnt : 0 (10 minute interval)
NE Presence HW : 1
FE Presence HW : 1
Rem Dev Rdy HW : 1
Local Dev Rdy HW : 1
Asserted NE Presence HW : 1
Asserted FE Presence HW : 1
Asserted Rem Dev Rdy HW : 1
Phy Frame Errors : 0
Invalid Status Errors      : 0
Invalid Packet Type Errors : 0
Incomplete Packet Errors   : 0
Checksum Errors            : 0
ESSI Flow Out This Port (HW) : 0x2
Viewing trace information for a port

Trace for Port 1
[ 0] [Info ] Start Request Received (Empty) [0]
[ 1] [Info ] Waiting for Stack Module Good (Empty) [0]
[ 2] [Info ] Stack Module Good Received (Empty) [0]
[ 3] [Info ] Cable Insertion Detected (Empty) [1]
[ 4] [Info ] Re-enable NE Present Int [487]
[ 5] [Info ] Starting Cable HPID Validation (Inserted) [488]
[ 6] [Info ] Skipping Cable HPID Validation (Inserted) [488]
[ 7] [Info ] Far End Insertion Detected (Valid) [988]
[ 8] [Info ] Polling for ESSI phy link up (Valid) [988]
[ 9] [Info ] ESSI Link Up [9988]
[10] [Info ] ESSI Link Good (Valid) [9988]
[11] [Info ] ESSI Linked at 9988 ms [9988]
[12] [Info ] Remote Device Ready Detected (Valid) [10898]
[13] [Info ] ICL Change Request Enable (Cable Ready) [10898]
[14] [Info ] Detected Remote Ready Drop. (Cable Ready) [12651]
[15] [Info ] ICL Good. Behind. Partner ready. (Cable Ready) [12988]
[16] [Info ] ICL GOOD received at 2091 ms [12988]
[17] [Info ] Partner LP ready. (Cable Ready) [13980]
[18] [Info ] Set Device Ready. (Cable Ready) [13987]
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[19] [Info ] ESSI Link Verified [13988]
[20] [Info ] ESSI Able to Transmit (Cable Ready)

Troubleshooting when a switch crashes and reboots

Cause

Although the switch software is highly reliable, a switch in the stack can experience a software issue that results
in the crash and reboot of that switch. This crash can happen in the software running on the CPU in the
management CPU or on the software running on the CPUs in the interfaces. In either case, crash information is
generated and the switch is rebooted.

The resiliency of the stack is determined by the stacking topology, however, in all cases, the interfaces/ports on
the switch that crashes are brought down and a reboot of that switch occurs.

The following table describes how the stack reacts to the crashing switch, depending on what role the switch had
when the crash occurred. The assumption in this table is that the topology is a resilient topology (that is, a mesh
or ring).

Stacking
role

Description

Command
er

• The standby takes over as the new Commander

• A new standby is elected

• Crashing switch writes core file to local stable storage

• Crashing switch reboots and joins the stack

• Core file and crash information for this switch is available from the Commander

Standby • A new standby is elected

• Crashing switch writes core file to local stable storage

• Crashing switch reboots and joins the stack

• Core file and crash information for this switch is available from the Commander

Member • Crashing switch writes core file to local stable storage

• Crashing switch reboots and joins the stack

• Core file and crash information for this switch is available from the Commander

After a switch crashes, you can collect data to help understand why the crash occurred. The information is a
combination of crash data, crash log, and core-dump files. The show tech command displays logs of events that
happened right before the crash.

Troubleshooting an unexpected Commander or Standby switch selection

Action

Viewing the running configuration with priority

When a switch stack is established and a boot/reboot of the stack is performed, the Commander and Standby are
selected based on the configured switch priority. There are other rules in the election process that can override
this priority.
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switch(config)# show running-config 

Running configuration:

; Stack_WC Configuration Editor; Created on release #WC.16.04.0000x
; Ver #10:9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ad

stacking
   member 1 type "JL321A" mac-address 941882-d83c40
   member 2 type "JL319A" mac-address 941882-d91a40
   member 3 type "JL321A" mac-address 941882-d9a240
   member 3 priority 200
   member 3 flexible-module A type JL078A
   member 4 type "JL319A" mac-address 941882-d9e900
   member 4 priority 175
   member 4 flexible-module A type JL078A
   member 5 type "JL319A" mac-address 941882-da0f40
   member 5 flexible-module A type JL083A
   exit
hostname "Switch"
snmp-server community "public" unrestricted
oobm
   ip address dhcp-bootp
   member 1
-- MORE --, next page: Space, next line: Enter, qu      ip address dhcp-bootp
      exit
   member 2
      ip address dhcp-bootp
      exit
   member 3
      ip address dhcp-bootp
      exit
   member 4
      ip address dhcp-bootp
      exit
   member 5
      ip address dhcp-bootp
      exit
   exit
vlan 1
   name "DEFAULT_VLAN"
   untagged 1/1-1/48,2/1-2/24,3/1-3/48,3/A1,4/1-4/24,4/A1,5/A1-5/A4
   ip address dhcp-bootp
   exit
On a boot of the stack, member 3 becomes a Commander and member 4 becomes a Standby, based on priority.
If this were a chain with member 1 at one end of the chain and member 5 at the other end, the number of hops
between switches will be part of the election process.

Managing interactions with other switch features
Managing SSH or Telnet sessions
Switches in a non-stacking configuration support up to six sessions running SSH or Telnet concurrently. However,
if stacking is configured, each stacking connection reduces the number of sessions available. For example, five
connections into the stack leaves only one session available for SSH or Telnet.
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Managing switch-level configuration interactions
In a stack, the Commander functions as a single switch and the Standby and Members function as additional
network ports for that switch. Switch configuration is performed in the same manner as for any other switch, as
described in these manuals:

• ArubaOS-Switch Software Basic Operation Guide

• ArubaOS-Switch Software Management and Configuration Guide

• ArubaOS-Switch Access Security Guide

• ArubaOS-Switch Software Multicast and Routing Guide

• ArubaOS-Switch Software Access Security Guide

• ArubaOS-Switch Software IPv6 Configuration Guide

Managing port-level configuration interactions
For features that are configured on specific switch ports in a stack, the configuration procedures are the same as
for stand-alone switches, but the port designations for the ports in the stack are modified. Each port is identified
by the stack member ID of its switch, followed by a slash and then the port number as it is shown on the switch.
For example, for a switch with stack member ID 3, port 10 on that switch would be identified as port 3/10.

Viewing show interfaces brief output for port 3/10

switch(config)# show interfaces brief 3/10

 Status and Counters - Port Status

                         | Intrusion                           MDI  Flow Bcast
  Port         Type      | Alert     Enabled Status Mode       Mode Ctrl Limit
  ------------ --------- + --------- ------- ------ ---------- ---- ---- -----
  3/10         100/1000T | No        Yes     Down   1000FDx         off  0  
Similarly, CLI commands requiring specific port (interface) numbers on a 2930M switch configured for stacking
require the modified port designations. For example, to enter the port context for port 10 on stack member 2, type:

switch(config)# interface 2/10   
switch(eth-2/10)#_
In the output containing designated port numbers for a 2930M switch configured for stacking, the port numbers
are likewise listed in the modified format.

Viewing show interfaces config output

switch(config)# show interfaces config

 Port Settings

  Port   Type      | Enabled Mode         Flow Ctrl MDI
  ------ --------- + ------- ------------ --------- ----
  1/1    100/1000T | Yes     Auto         Disable   Auto
  1/2    100/1000T | Yes     Auto         Disable   Auto
  1/3    100/1000T | Yes     Auto         Disable   Auto
   .
   .
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   .
  2/1    100/1000T | Yes     Auto         Disable   Auto
  2/2    100/1000T | Yes     Auto         Disable   Auto
  2/3    100/1000T | Yes     Auto         Disable   Auto
  2/4    100/1000T | Yes     Auto         Disable   Auto
.
.
.
Attempting to enter a CLI command for a port on a stack member without using the modified port number format
generates a “Module not present...” message such as the following:

switch(config)# interface 10 
Module not present for port or invalid port: 10

LACP support
LACP trunking can support up to 60 trunks in a stacking configuration, each with up to eight links (ports) per trunk.

switch(config)# trunk 1/1,1/2,1/3,1/4,1/5,1/6,1/7,1/8  trk60 lacp 
switch(config)# trunk 1/9 trk60 lacp                              
An attempt to exceed the maximum number (8) of ports in a trunk group.

switch(config)# trunk 1/2 
trk1                  Trunk group 1
trk2                  Trunk group 2
trk3                  Trunk group 3
trk4                  Trunk group 4
trk5                  Trunk group 5
trk6                  Trunk group 6
trk7                  Trunk group 7
trk8                  Trunk group 8
trk9                  Trunk group 9
trk10                 Trunk group 10
trk11                 Trunk group 11
trk12                 Trunk group 12
trk13                 Trunk group 13
trk14                 Trunk group 14
trk15                 Trunk group 15
trk16                 Trunk group 16
trk17                 Trunk group 17
trk18                 Trunk group 18
trk19                 Trunk group 19
trk20                 Trunk group 20
trk21                 Trunk group 21
trk22                 Trunk group 22
trk23                 Trunk group 23
trk24                 Trunk group 24
trk25                 Trunk group 25
trk26                 Trunk group 26
trk27                 Trunk group 27
trk28                 Trunk group 28
trk29                 Trunk group 29
trk30                 Trunk group 30
trk31                 Trunk group 31
trk32                 Trunk group 32
trk33                 Trunk group 33
trk34                 Trunk group 34
trk35                 Trunk group 35
trk36                 Trunk group 36
trk37                 Trunk group 37

256 Aruba 2930F / 2930M Advanced Traffic Management Guide for
ArubaOS-Switch 16.08

Anexo 08 ITENS 8 E 9 (0592727)         SEI 0008478-63.2018.6.02.8000 / pg. 7860



trk38                 Trunk group 38
trk39                 Trunk group 39
trk40                 Trunk group 40
trk41                 Trunk group 41
trk42                 Trunk group 42
trk43                 Trunk group 43
trk44                 Trunk group 44
trk45                 Trunk group 45
trk46                 Trunk group 46
trk47                 Trunk group 47
trk48                 Trunk group 48
trk49                 Trunk group 49
trk50                 Trunk group 50
trk51                 Trunk group 51
trk52                 Trunk group 52
trk53                 Trunk group 53
trk54                 Trunk group 54
trk55                 Trunk group 55
trk56                 Trunk group 56
trk57                 Trunk group 57
trk58                 Trunk group 58
trk59                 Trunk group 59
trk60                 Trunk group 60

Managing OOBM ports
Each OOBM port of a member is assigned one MAC address from that Member's manufacturing allocated range.
The OOBM port also can be assigned an IP address (IPv4 /v6/DHCP/Manual/Auto-Config/LinkLocal). The
Commander's OOBM IP address (called the Global IP address) is used for managing the Commander through the
OOBM port.

After switchover/failover of control from the Commander to the Standby, the OOBM port IP address of the new
Commander is the Global IP address. This change in address causes some undesirable behavior (after failover):

• When using DHCP or DHCPv6, the new Commander requests a new lease and typically receives a new
network address (IPv4 or IPv6). With OOBM high availability (HA), it will seem as if a new link has come up
requesting a network address.

• IPV6 link-local or auto-config addresses will change.

Using a static IP address avoids these issues. During failover, it will be as if the IP address is reconfigured. All
ARP entries are updated automatically.

For more information on OOBM operation, see the ArubaOS-Switch Management and Configuration Guide for
your switch.

Understanding stacking election
Electing a Commander
In those cases in which the Commander of the stack is not identified, the stack undergoes a Commander Election
process. This occurs when the entire stack is rebooted simultaneously, such as during a building power failure
recovery, or when the stack becomes split and the Commander is isolated in the Inactive fragment, requiring the
Active fragment to elect a new Commander.

All of the switches go through discovery and election at the same time. There is an election timer that is set for 60
seconds, and if there are no new switches discovered during that timeout period, the switches in the stack enter
the election phase.

During the election process, for each group of switches that has the same STACK-ID (they should all be the
same), these steps occur:
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1. The switches with the highest Stack Revision are discovered.

2. The switch with the highest configured priority is selected as the Commander.

3. If there are switches with the same “highest” priority, the switch that was the previous Commander is selected.

4. If no switches were previous commanders, the switch that was the previous Standby is selected.

5. If none of the above conditions apply, the switch with the lowest MAC Address is selected as the Commander.

Electing a Standby
The Standby switch is selected by the Commander following the same rules used to elect the Commander. Like
the Commander, the Standby switch is not changed unless a failure occurs (for example, the Standby switch fails,
or the Commander fails and the Standby becomes the Commander).

NOTE:

Since the Commander will update the revision software and set the stack IDs of all the switches, this
information will be the same for all Standby switch contenders.

The criteria used by the Commander to select the Standby is in this priority order:

1. A switch with the same system revision software as the commander is available. This speeds up the initial boot
since the stack will not have to wait for the standby to be updated. (If this were not the case, then the selected
Standby would need to be reloaded with the new system and rebooted, resulting in the selection of a new
Standby. This process would continue until either the original Standby was rebooted or a Standby was chosen
that already had the correct system revision).

2. For all switches with the Commander's revision software, the switch with the highest priority that is not the
current Commander will become the Standby switch.

NOTE:

It is possible for the Standby to have a higher priority than the Commander, if the priority of the
Standby was increased after the Commander becomes the Commander. (The Commander is not
changed unless it fails or is on the Inactive fragment side of a stack that becomes split).

3. If there are two or more switches whose priority is equally high, then the Commander will look at the topology
of the stack and pick a switch that is the most hops away from the Commander. This will increase the
probability that the Commander and Standby switch will be in different stack fragments should a failure occur.

4. If the priorities and hop counts of the contenders are the same, then the switch with the lowest MAC address is
selected as the Standby switch.

Flexible Uplink Modules
The uplink speed and capacity can be changed by adding or removing the uplink modules. The Flexible Uplink
Modules (FUP) that are supported on these switches are JL078A, JL081A, and JL083A modules. The speed and
the number of ports depend on the selected uplink module.

All physically inserted flexible modules are auto-detected when you boot a 2930M switch with the default
configuration (factory reset).

Flexible Ports

The following types of flexible modules are supported on the 2930M switch series:
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• Aruba 2930M 1-port QSFP+ 40GbE Module (JL078A)

• Aruba 2930M 4 HPE Smart Rate PoE+ Module (JL081A)

• Aruba 2930M 4-port 100M/1G/10G SFP+ MACsec Module (JL083A)

NOTE: Only copper and fibre optic media types are supported. Auto media selection, such as
detecting 1G SFP in 10G SFP+ FlexPort, is also supported on 4x10G SFP+ FlexPort.

Naming conventions for FUP
FUP uses the same naming convention as the expansion module ports in Aruba 2920 switch.

Naming FUP with stacking enabled
For switches with stacking enabled, the naming convention for FUP is:

1/A1, 1/A2...1/AN, 2/A1,2/A2...2/AN...10/A1,10/A2...10/AN
Where:

N represents number of ports in the flexible module.

A represents the flexible module names.

1, 2...10 prefix represents the member number that slot ports belong to.

Naming FUP in standalone
For switches with stacking disabled (standalone), the naming convention for FUP is:

A1, A2, A3...AN
Where:

N represents number of ports in the flexible module.

A represents the flexible module names.

Provisioning FUP
Use the CLI commands to provision the FUP for both standalone and with stacking enabled.

Provisioning FUP with stacking enabled
Use the CLI command to provision an FUP for an already provisioned or an existing member configured with the
specified flexible module type defined by the corresponding J-number.

Syntax
stacking member <stack-member> flexible-module <SLOT-ID> type <J-NUMBER>
Description

Specifies the stack member to be configured.

Options

• stack-member
Specify the stack-member in the range 1–10.

• SLOT-ID
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Specify an alphabetic device slot identifier A.

• J-NUMBER
Configure the type of the flexible module to be provisioned.

JL078A
JL081A
JL083A

Preconfigure a flexible module before installing, as it allows the ports to be preconfigured and ready to use. If the
modules are not preconfigured, the default configuration is used. If a module other than the preconfigured module
type is inserted, the module is not activated.

Example output

switch(config)# stacking member 
 <1-10>                Enter a stack member-ID for the 'member' 
                       command/parameter
                       
 switch(config)# stacking member 1 
 flexible-module       Pre-configure a flexible module before installing it.
 priority              Assigns a priority to the specified stack member.
 remove                Erases the stack member's configuration.
 shutdown              Shut down the specified stack member.
 type                  Configure the family of the switch being provisioned.

 switch(config)# stacking member 1 flexible-module 
 SLOT-ID               Enter an alphabetic device slot identifier.

 switch(config)# stacking member 1 flexible-module A 
 remove                Erases the flexible module configuration.
 type                  Configure the type of the flexible module being 
                       provisioned
                      
 switch(config)# stacking member 1 flexible-module A type 
 JL078A               
 JL081A               
 JL083A

 switch(config)# stacking member 1 flexible-module A type JL078A 
 switch(config)# show running-config 

Running configuration:

; Stack_WC Configuration Editor; Created on release #WC.16.04.0000x
; Ver #10:0b.bf.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:bd

stacking
   member 1 type "JL322A" mac-address e0071b-dab580
   member 1 flexible-module A type JL078A
   member 2 type "JL321A" mac-address e0071b-de7dc0
   member 3 type "JL321A" mac-address e0071b-de8d00
   member 3 flexible-module A type JL081A
   member 4 type "JL321A" mac-address e0071b-def840
   exit
hostname "Switch"
snmp-server community "public" unrestricted
oobm
   ip address dhcp-bootp
   member 1
      ip address dhcp-bootp
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      exit
   member 2
      ip address dhcp-bootp
      exit
   member 3
      ip address dhcp-bootp
      exit
   member 4
      ip address dhcp-bootp
      exit
   exit
vlan 1
   name "DEFAULT_VLAN"
   untagged 1/1-1/48,1/A1,2/1-2/48,3/1-3/48,3/A1-3/A4,4/1-4/48
   ip address dhcp-bootp
   exit

Provisioning FUP with stacking disabled
Use the CLI command to provision an FP module in a standalone environment, with the specified flexible module
type defined by the corresponding J-number. Preconfigure a flexible module before installing, as it allows the
ports to be preconfigured and ready to use. If the modules are not preconfigured, the default configuration is
used. If a module other than the preconfigured module type is inserted, the module is not activated.

Syntax
flexible-module <SLOT-ID> {type <J-NUMBER>}
Description

Specify a flexible module to be configured.

Options

• SLOT-ID
Specify an alphabetic device slot identifier A.

• J-NUMBER
Configure the type of the flexible module to be provisioned.

JL078A
JL081A
JL083A

Example output

switch(config)# flexible-module 
SLOT-ID               Enter an alphabetic device slot identifier

switch(config)# flexible-module A 
remove                Erases the flexible module configuration.
type                  Configure the type of the flexible module being 
                      provisioned
                       
                       
switch(config)# flexible-module A type 
JL078A               
JL081A               
JL083A

switch(config)# flexible-module A type JL078A
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switch(config)# show running-config 
                                                 
Running configuration:

; JL322A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #10:9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ad

hostname "Aruba-2930M-48G-PoEP"
module 1 type jl322a
flexible-module A type JL081A
include-credentials
snmp-server community "public" unrestricted
snmpv3 engineid "00:00:00:0b:00:00:e0:07:1b:e5:6b:00"
oobm
   ip address dhcp-bootp
   exit
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-48,A1-A4
   ip address dhcp-bootp
   exit

Unprovisioning FUP
Use the CLI commands to remove the configured FUP for both standalone and with stacking enabled.

Unprovisioning FUP with stacking enabled
Use the CLI command to remove a provisioned FP module.

Syntax
Stacking member <STACK-MEMBER> flexible-module <SLOT-ID> remove
Description

Specify a flexible module to be removed.

Options
Stacking member <STACK-MEMBER> flexible-module <SLOT-ID> remove
Remove the configuration for the specified flexible module.

• stack-member
Specify the stack-member in the range 1–10.

• SLOT-ID
Specify an alphabetic device slot identifier A.

Example output

switch(config)# show running-config 

Running configuration:

; Stack_WC Configuration Editor; Created on release #WC.16.04.0000x
; Ver #10:0b.bf.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:bd

stacking
   member 1 type "JL322A" mac-address e0071b-dab580
   member 1 flexible-module A type JL078A
   member 2 type "JL321A" mac-address e0071b-de7dc0
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   member 3 type "JL321A" mac-address e0071b-de8d00
   member 3 flexible-module A type JL081A
   member 4 type "JL321A" mac-address e0071b-def840
   exit
hostname "Switch"
snmp-server community "public" unrestricted
oobm
   ip address dhcp-bootp
   member 1
      ip address dhcp-bootp
      exit
   member 2
      ip address dhcp-bootp
      exit
   member 3
      ip address dhcp-bootp
      exit
   member 4
      ip address dhcp-bootp
      exit
   exit
vlan 1
   name "DEFAULT_VLAN"
   untagged 1/1-1/48,1/A1,2/1-2/48,3/1-3/48,3/A1-3/A4,4/1-4/48
   ip address dhcp-bootp
   exit

   switch(config)#  stacking member 1 flexible-module A remove
   switch(config)#  show running-config 

Running configuration:

; Stack_WC Configuration Editor; Created on release #WC.16.04.0000x
; Ver #10:0b.bf.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:bd

stacking
   member 1 type "JL322A" mac-address e0071b-dab580
   member 2 type "JL321A" mac-address e0071b-de7dc0
   member 3 type "JL321A" mac-address e0071b-de8d00
   member 3 flexible-module A type JL081A
   member 4 type "JL321A" mac-address e0071b-def840
   exit
hostname "Switch"
snmp-server community "public" unrestricted
oobm
   ip address dhcp-bootp
   member 1
      ip address dhcp-bootp
      exit
   member 2
      ip address dhcp-bootp
      exit
   member 3
      ip address dhcp-bootp
      exit
   member 4
      ip address dhcp-bootp
      exit
   exit
vlan 1
   name "DEFAULT_VLAN"
   untagged 1/1-1/48,2/1-2/48,3/1-3/48,3/A1-3/A4,4/1-4/48
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   ip address dhcp-bootp
   exit

Unprovisioning FUP with stacking disabled
Use the CLI command to remove an already provisioned FP module and its associated configurations.

Syntax
flexible-module <SLOT-ID> {type <J-NUMBER> | remove}
Description

Specify a flexible module, for which configuration has to be removed.

Options
SLOT-ID
Specify an alphabetic device slot identifier A.

Example output

switch(config)#  flexible-module A remove
   
switch(config)# show running-config 

Running configuration:

; JL322A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #10:9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ad

hostname "Aruba-2930M-48G-PoEP"
module 1 type jl322a
include-credentials
snmp-server community "public" unrestricted
snmpv3 engineid "00:00:00:0b:00:00:e0:07:1b:e5:6b:00"
oobm
   ip address dhcp-bootp
   exit
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-48
   ip address dhcp-bootp
   exit

Saving power by turning off FUPs
Use the CLI commands to save power by turning off unutilized FUPs.

Saving power by turning off FUP with stacking enabled
Use the CLI command to power off the flexible module for a stacking member to save power.

Syntax
savepower flexible-module <SLOT-ID> member <STACK-MEMBER>
Description

Power flexible modules off.

Options

• SLOT-ID
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Specify an alphabetic device slot identifier A.

• stack-member
Specify the stack-member to be configured in the range 1–10.

NOTE: You cannot configure savepower for flexible modules on a preprovisioned stack member.
Also, configuring LED status for flexible modules is not supported.

Example output

switch(config)# show modules

Status and Counters - Module Information

  Stack ID       : 0100e007-1bdab580                              
 
  Member                                                                      
  ID     Slot     Module Description                  Serial Number    Status 
  ------ -------- ----------------------------------- ---------------- -------
  1      STK      Aruba JL325A 2p Stacking Module                      Up     
  2      STK      Aruba JL325A 2p Stacking Module                      Up     
  3      A        Aruba JL081A 4p 10GbE XGT Module    SG6ZGZ4226       Up     
  3      STK      Aruba JL325A 2p Stacking Module                      Up     
  4      STK      Aruba JL325A 2p Stacking Module                      Up 
  
 switch(config)# savepower flexible-module 
 SLOT-ID         Enter an alphabetic device slot identifier.
switch(config)# savepower flexible-module A member 3 
This command will shut down the specified modules.  Ports on those
modules will no longer pass traffic and any management traffic to
ports on those modules will be interrupted.  This command may take
up to 2 minutes to power down all specified modules.  Please use the
event log to monitor progress.

Continue (y/n)? y

switch(config)# show modules 

Status and Counters - Module Information

  Stack ID       : 0100e007-1bdab580                              
 
  Member                                                                      
  ID     Slot     Module Description                  Serial Number    Status 
  ------ -------- ----------------------------------- ---------------- -------
  1      STK      Aruba JL325A 2p Stacking Module                      Up     
  2      STK      Aruba JL325A 2p Stacking Module                      Up     
  3      A        Aruba  Expansion Module                              Save...
  3      STK      Aruba JL325A 2p Stacking Module                      Up     
  4      STK      Aruba JL325A 2p Stacking Module                      Up 
  
  switch(config)# show running-config 

Running configuration:

; hpStack_WC Configuration Editor; Created on release #WC.16.04.0000x
; Ver #10:0b.bf.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:bd

stacking
   member 1 type "JL322A" mac-address e0071b-dab580
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   member 2 type "JL321A" mac-address e0071b-de7dc0
   member 3 type "JL321A" mac-address e0071b-de8d00
   member 3 flexible-module A type JL081A
   member 4 type "JL321A" mac-address e0071b-def840
   exit
hostname "Aruba-Stack-2930M"
snmp-server community "public" unrestricted
oobm
   ip address dhcp-bootp
   member 1
      ip address dhcp-bootp
      exit
   member 2
      ip address dhcp-bootp
      exit
   member 3
      ip address dhcp-bootp
      exit
   member 4
      ip address dhcp-bootp
      exit
   exit
vlan 1
   name "DEFAULT_VLAN"
   untagged 1/1-1/48,2/1-2/48,3/1-3/48,3/A1-3/A4,4/1-4/48
   ip address dhcp-bootp
   exit
savepower flexible-module A member 3

Saving power by turning off FUPs with stacking disabled
Use the CLI command to turn off a flexible module with stacking disabled to save power. The flexible module
configuration remains unchanged during a savepower operation.

Syntax
savepower flexible-module <SLOT-ID>
Description

Power flexible modules off.

Option
SLOT-ID
Specify an alphabetic device slot identifier A.

Example output

switch(config)# savepower flexible-module A 

switch(config)# savepower flexible-module A 
This command will shut down the specified modules.  Ports on those
modules will no longer pass traffic and any management traffic to
ports on those modules will be interrupted.  This command may take
up to 2 minutes to power down all specified modules.  Please use the
event log to monitor progress.

Continue (y/n)? y
switch(config)# show modules

Status and Counters - Module Information

  Chassis: 2930M-48G-PoE+  JL322A         Serial Number:   SG6JQN02R 
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  Slot  Module Description                         Serial Number    Status    
  ----- ------------------------------------------ ---------------- ----------
  A     Aruba  Expansion Module                                     SavePower 

  switch(config)# show running-config 

Running configuration:

; JL322A Configuration Editor; Created on release #WC.16.05.0000x
; Ver #10:9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:ad

hostname "Aruba-2930M-48G-PoEP"
module 1 type jl322a
flexible-module A type JL078A
include-credentials
snmp-server community "public" unrestricted
snmpv3 engineid "00:00:00:0b:00:00:e0:07:1b:e5:6b:00"
oobm
   ip address dhcp-bootp
   exit
vlan 1
   name "DEFAULT_VLAN"
   untagged 1-48,A1
   ip address dhcp-bootp
   exit
savepower flexible-module A

Disabling savepower by turning on FUPs
Use the CLI commands to power on FUPs in savepower status.

Turning ON FUPs in savepower status with stacking enabled
Syntax
no savepower flexible-module <SLOT-ID> member <STACK-MEMBER>
Description

Disable save power for FUP in a stack.

Options

• SLOT-ID
Specify an alphabetic device slot identifier A.

• stack-member
Specify the stack-member to be configured in the range 1–10.

Example output

switch(config)# no savepower flexible-module A member 3 
switch(config)# show modules

Status and Counters - Module Information

  Stack ID       : 0100e007-1bdab580                              
 
  Member                                                                      
  ID     Slot     Module Description                  Serial Number    Status 
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  ------ -------- ----------------------------------- ---------------- -------
  1      STK      Aruba JL325A 2p Stacking Module                      Up     
  2      STK      Aruba JL325A 2p Stacking Module                      Up     
  3      A        Aruba JL081A 4p 10GbE XGT Module    SG6ZGZ4226       Booting
  3      STK      Aruba JL325A 2p Stacking Module                      Up     
  4      STK      Aruba JL325A 2p Stacking Module                      Up
  
  switch(config)# show modules

Status and Counters - Module Information

  Stack ID       : 0100e007-1bdab580                              
 
  Member                                                                      
  ID     Slot     Module Description                  Serial Number    Status 
  ------ -------- ----------------------------------- ---------------- -------
  1      STK      Aruba JL325A 2p Stacking Module                      Up     
  2      STK      Aruba JL325A 2p Stacking Module                      Up     
  3      A        Aruba JL081A 4p 10GbE XGT Module    SG6ZGZ4226       Up     
  3      STK      Aruba JL325A 2p Stacking Module                      Up     
  4      STK      Aruba JL325A 2p Stacking Module                      Up

Turning ON FUPs in savepower status with stacking disabled
Syntax
no savepower flexible-module <SLOT-ID>
Description

Disable save power for a standalone FUP.

Option
SLOT-ID
Specify an alphabetic device slot identifier A.

Example output

switch(config)# no savepower flexible-module A

Changing flexible modules on a running stack
You can change a flexible module in a running stack under the following scenarios:

• Inserting a flexible module into a running stack on page 268

• Booting with flexible module configuration, no flexible modules inserted on page 269

• Removing the flexible modules on page 269

• Replacing a flexible module on page 269

There are various options available for each of the above scenarios that helps resolve troubleshooting issues.

Inserting a flexible module into a running stack
You can boot a stack or standalone either with the default or flexible module configuration under various scenarios
such as:

Scenario 1
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A stack or standalone booted with the default configuration, but flexible modules are not inserted at the time of
boot. Hot-Insert a flexible module compatible with the 2930M SKU. The flexible modules are booted and the
flexible ports are available for use. The show modules command displays the flexible module status as UP.

Scenario 2

A stack or standalone booted with the flexible module configuration, but flexible modules are not inserted at the
time of boot. Hot-Insert a flexible module of the same type as configured. The flexible modules are booted and
flexible ports are available for use. The show modules command displays the status of flexible module as UP.

Scenario 3

A stack or standalone booted with the flexible module configuration, but flexible modules are not inserted at the
time of boot. Hot-Insert a flexible module other than the configured. The show modules command displays
Failed State in the output due to a mismatch. RMON has a log entry for Misconfigured module. The
flexible ports are unavailable for use.

Scenario 4

A stack or standalone booted with the flexible module configuration, and same type of flexible modules inserted
as configured at the time of boot. The flexible modules are booted and the flexible ports are available for use. The
show modules command displays status of flexible module as UP.

Scenario 5

A stack or standalone booted with flexible module configuration and flexible modules other than the configured
are inserted at the time of boot. The show modules command displays Failed State in the output due to a
mismatch. RMON has a log entry for Misconfigured module. The flexible ports are unavailable for use.

Booting with flexible module configuration, no flexible modules inserted

Procedure

Boot a stack or standalone with the flexible module configuration and no flexible modules inserted at the time of
boot. Use the unprovision command to remove the existing flexible module, and then Hot-Insert a flexible
module that is compatible with 2930M SKU. The flexible modules are booted and the flexible ports are available
for use. The show modules displays the status of inserted flexible module as UP.

Removing the flexible modules
The following scenarios are available when you boot a stack or standalone with the flexible module configuration,
followed by removing flexible modules of either same or different type than configured:

Scenario 1

Perform a Hot-Removal of the inserted flexible module. The show modules command displays the status of
flexible module as Unknown.

Scenario 2

Perform a Hot-Removal of the inserted flexible module followed by a Hot-Insert of either same or different type.
The flexible ports are unavailable for use.

NOTE: Hewlett Packard Enterprise recommends unprovisioning or provisioning flexible modules as
Hot-Swap is not supported in the current release.

Replacing a flexible module
Although, Hot-Swap is not supported in the current release, you can still replace a flexible module on a running
stack or standalone. To make the flexible module operational, follow these steps:
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Procedure

1. Run the unprovision command.

2. Perform a Hot-Removal of the installed flexible module.

3. Hot-Insert a flexible module of any supported type.

The flexible modules are booted and the flexible ports are available for use. The show modules command
displays the status of inserted flexible module as UP.

Saving power for FUPs
You can save power by turning off the unused flexible modules under the following scenarios:

Procedure

1. Booting a switch with no inserted flexible modules, and with or without flexible module configuration
on page 270

2. Changing flexible modules in savepower status in a running stack on page 270

3. Booting a switch with flexible modules inserted, and flexible modules in savepower status on page 271

Booting a switch with no inserted flexible modules, and with or without
flexible module configuration
The following are the various scenarios:

Scenario 1

The savepower command is executed, but the show modules does not display the flexible modules.

Scenario 2

Insert a flexible module, and then execute savepower. The flexible modules are powered off. The show
modules displays the flexible modules status as savepower.

Scenario 3

Insert a flexible module, execute savepower, and then run no savepower. The flexible modules are powered
on again.

Scenario 4

Execute savepower, and then perform Hot-Insert. The show modules displays the flexible modules status as
savepower, but flexible ports are unavailable for use.

Changing flexible modules in savepower status in a running stack
Scenario 1

Unprovision the flexible module. The show modules does not display the flexible modules.

Scenario 2

Perform a Hot-Removal of the flexible module. The show modules displays the flexible modules status as
Unknown. The savepower configuration is retained for the slot.
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NOTE:

In a stacking environment, execute member remove on which the savepower command is issued.
The show modules does not display the flexible modules. The savepower command is cleared
from the configuration.

Scenario 3

Execute savepower, and then perform Hot-Insert. The show modules displays the flexible modules status as
savepower, but flexible ports are unavailable for use.

Booting a switch with flexible modules inserted, and flexible modules in
savepower status
The show modules displays the flexible modules status as savepower. The flexible ports are unavailable for
use.
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Overview of RPVST+
NOTE: For information on configuring basic and multiple instance spanning tree, see Multiple
instance spanning tree operation.

RPVST+ is a proprietary spanning tree implementation that extends RSTP (802.1w) to run a separate spanning
tree for each VLAN on the switch, and ensures that only one active, loop-free path exists between any two nodes
on a given VLAN.

Table 20: RPVST scalability

Platform Maximum Allowed
RPVST Enabled VLANs

Recommended
Maximum Virtual Ports

Maximum Allowed
Virtual Ports (x is the
number of logical ports
in the system)

2930 128 400 2000 + x

Where x is the sum of all physical ports and logical interface, such as Trk1 if configured.

The following shows how x is calculated using the 2920 switch as an example, you can substitute the actual
values for your switch as shown in the table to do a similar calculation. In a stack of 4 with 2x2920-24 and 1 trunk
interface Trk1 configured, x will be 24+24+1=49. Therefore the maximum allowed vPorts is 299.

Switch# show spanning-tree system-limits rapid-pvst

 Spanning Tree Information 

  STP Enabled              : No 
  Mode                     : MSTP 
  RPVST Enabled VLANs      : 1,4,20-23 

  Switch MAC Address                   : 40a8f0-0df69e 
  Count of RPVST Enabled GVRP VLANs    : 0 
  Count of RPVST Enabled VLANs         : 6 
  Maximum Allowed RPVST Enabled VLANs  : 64 
  Count Of Total Virtual Ports         : 51 
  Maximum Allowed Virtual Ports        : 299

                       Current         Operational     Recommended Maximum 
  Ports                Virtual Ports   Virtual Ports   Virtual Ports 
  -------------------- --------------- --------------- -------------------- 
  Member 1/1-24        31              27              250 
  Member 2/1-24        31              24              250 

Configuring RPVST+ at a glance
The general steps for configuring RPVST+ via the CLI are:

Chapter 10
Rapid per-VLAN spanning tree (RPVST+) operation
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Procedure

1. Select RPVST+ as the active spanning tree mode by entering the following command: spanning-tree
mode rapid-pvst
To begin with the default RPVST+ configuration (recommended), go to step 6.

2. Configure global spanning tree parameters.

3. Configure per-VLAN parameters.

4. Configure per-port per-VLAN parameters. These commands affect RPVST+ operation on traffic associated
with the specified VLAN(s) through the specified port(s).

5. Configure per-port parameters. These commands affect RPVST+ operation for all traffic through the specified
port(s).

6. Use one of the following commands to enable RPVST+ spanning tree operation on the switch:

a. One or more selected VLANs:
spanning-tree vlan vid-list

b. One or more selected VLANs:
spanning-tree vlan vid-list

c. The first 400 VLANs:
spanning-tree
Any VLANs in excess of the first 400 would have RPVST+ disabled. In this case, use the no spanning-tree
vlan vid-list command to change the mix of RPVST+ enabled and disabled VLANs.

Additional configuration options include:

• Allowing traffic on VLAN ID (PVID) mismatched links on page 278

• Configuring STP loop guard on page 279

Selecting RPVST+ as the spanning tree mode
Syntax:
spanning-tree mode [mstp | rapid-pvst]
no spanning-tree mode [mstp | rapid-pvst]
Specifies that spanning tree will run in MSTP (default) or RPVST+ mode.

To view Mode, use the show run command. This will eliminate confusion if there is an RPVST configuration but
MSTP is running. This will lead to a change in the existing factory default setting.

RPVST+ parameters can be configured even if the mode is MSTP and vice versa. This command does not
enable/disable spanning tree. It sets the mode which is operational once spanning tree is enabled using
spanning-tree enable.

The no form of the command changes the spanning tree mode to the default mode (MSTP) .

Configuring global spanning tree
Syntax:

spanning-tree extend system-id
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Creates a unique bridge identifier for each VLAN by adding the VLAN ID (vid) value to the priority field of the
bridge identifier in every RPVST+ BPDU.

Syntax

no spanning-tree log state-transitions [instance <instance-id> cst] 

Command enables/disables event logging for port-block events.

List of VLAN identifiers

Range: <instance-id> 1–16

[vlan <vid-list>]
Syntax:

no spanning-tree ignore-pvid-inconsistency
Causes the switch to ignore per-VLAN ID inconsistencies when the ports on both ends of a point-to-point link are
untagged members of different VLANs, thus allowing RPVST+ to run on the mismatched links. On a given switch,
affects all ports belonging to VLANs on which RPVST+ is enabled.

Default: Disabled

NOTE: The [no] spanning-tree ignore-pvid-inconsistency command is ineffective
when there is a PVID inconsistency between a VLAN1 and any non-VLAN1 member because
VLAN1 uses IEEE BPDUs to form a spanning tree topology.

Syntax:

no spanning-tree bpdu-protection-timeout timeout
Configures the duration of time when protected ports receiving unauthorized BPDUs will remain disabled. The
default value of 0 (zero) sets an infinite timeout (that is, ports that are disabled by bpdu-protection are not, by
default, re-enabled automatically).

Default: 0

Range: 0 - 65535 seconds

Configuring per-VLAN spanning tree
Syntax:

spanning-tree vlan <vid-list> hello-time 1...10
Specifies the time in seconds between transmissions of BPDUs on the specified VLAN(s) when the switch is root
for those VLAN(s).

Default: 2

Range: 1 - 10

Syntax:

spanning-tree vlan <vid-list>forward-delay 4...30
Sets the time in seconds the switch waits before transitioning from listening to learning and from learning to
forwarding states.
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Default: 15

Range: 4 - 30

Syntax:

spanning-tree vlan vid-listmaximum age 6...40
Sets the maximum age in seconds of received STP information before it is discarded for specified VLAN(s).

Default: 20

Range: 6 - 40

NOTE: Maximum age must be within the following bounds:

• greater than or equal to 2x (hello-time +1)

• less than or equal to 2x (forward-delay - 1)

Syntax:

spanning-tree vlan vid-list priority 0...15
Sets the switch (bridge) priority for the designated VLAN. The switch compares this priority with the priorities of
other switches on the same VLAN to determine the RPVST+ root switch for the VLAN. The lower the priority
value, the higher the priority. The switch with the lowest Bridge Identifier on the VLAN is elected as the RPVST+
root switch for that VLAN.

The Bridge Identifier is composed of a configurable Priority (2 bytes) and the switch’s MAC address (6 bytes). You
can change the Priority provides flexibility for determining which switch on the VLAN will be the root for RPVST+,
regardless of its MAC address.

The priority range for an RPVST+ switch is 0-61440. However, this command specifies the priority as a multiplier
(0 - 15) of 4096. That is, when you specify a priority multiplier value of 0 - 15, the actual priority assigned to the
switch is: (priority-multiplier) x 4096.

For example, if you configure “2” as the priority-multiplier on a given RPVST+ switch, then the Switch Priority
setting for the specified VLAN is 8,192.

NOTE: If multiple switches on the same VLAN have the same priority setting, then the switch with
the lowest MAC address becomes the root switch for that VLAN.

Syntax:
spanning-tree vlan vid-list root {primary | secondary}
no spanning-tree vlan vid-list root {primary | secondary}
Specifies the switch as the primary or secondary root bridge for the specified VLAN(s). Otherwise, by default, the
root bridge for each VLAN will be determined by the lowest MAC address in that topology.

The no form of the command returns the determination of root to the lowest MAC address criterion.

Configuring per-port per-VLAN spanning tree
Syntax
spanning-tree pathcostrapid-pvst | mstp[8021d | 8021t | proprietary]
no spanning-tree pathcostrapid-pvst | mstp[8021d | 8021t | proprietary]
Specify a standard to use when calculating the default pathcost.
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Default: 8021t

NOTE: All devices in the network should be configure to use same pathcost mode for proper
functioning.

Syntax:
spanning-tree port port-#: vlan vid-list path-cost {auto | [1...200000000]}
no spanning-tree port port-#: vlan vid-list path-cost {auto | [1...200000000]}
Sets the path cost for a single port on the specified VLAN(s). If the port is a member of more than one VLAN, the
path-cost applies only where the port has traffic for the VLAN(s) specified.

Default: auto

Range: 1 - 200000000

The no form of the command returns path-cost to its default setting.

Syntax:
spanning-tree port port-number vlan vid-list priority <0-15> path-costauto | <Path-Cost> 
no spanning-tree port port-number vlan vid-list priority <0-15> path-costauto | <Path-Cost> 
Sets the port priority for the specified VLANs. The value is in the range of 0-240 divided into steps of 16 that are
numbered 0 to 15. The default is step 16.

The per-port per-VLAN priority is used to help choose the root port for a switch on the specified VLAN if there are
multiple links to the root switch.

Default: 8

Range 0 - 15

The no form of the command sets the priority to its default value.

Configuring per-port spanning tree
Syntax:
spanning-tree port-list admin-edge-port
no spanning-tree port-list admin-edge-port
Enables admin-edge-port on ports connected to end nodes. During spanning tree establishment, ports with
admin-edge-port enabled transition immediately to the forwarding state. If a bridge or switch is detected on the
segment, the port automatically operates as non-edge, not enabled.

If admin-edge-port is disabled on a port and auto-edge-port has not been disabled, the auto-edge-port
setting controls the behavior of the port.

Default: No - disabled

The no form of the command disables edge-port operation on the specified ports.

Syntax:
spanning tree port-list auto-edge-port
no spanning tree port-list auto-edge-port
Enables or disables the automatic identification of edge ports. The port will look for BPDUs for 3 seconds. If there
are none, it begins forwarding packets. If admin-edge-port is enabled for a port, the setting for auto-edge-port
is ignored whether set to yes or no. If admin-edge-port is set to No, and auto-edge- port has not been
disabled (set to No), then the auto-edge-port setting controls the behavior of the port.

Default: Yes - enabled
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The no form of the command disables auto-edge-port operation on the specified ports.

Syntax:
no spanning tree port-list bpdu-filter
Enables or disables BPDU filtering on the specified port(s). The bpdu-filter option forces a port to always stay
in the forwarding state and be excluded from standard STP operation.

Default: Disabled

Syntax:

Enables or disables BPDU protection on the specified port(s).

Syntax:
spanning tree port-list point-to-point-mac [true | false | auto]
Informs the switch of the type of device to which a specific port connects.

true (default)

Indicates a point-to-point link to a device such as a switch, bridge, or end-node.

false
Indicates a connection to a hub (which is a shared LAN segment).

auto
Causes the switch to set Force-False on the port if it is not running at full duplex. (Connections to hubs are
half-duplex.)

Syntax:
spanning tree port-list root-guard
This feature is available in RPVST+ only. When a port is enabled as root-guard, it cannot be selected as the
root port even if it receives superior STP BPDUs. The port is assigned an “alternate” port role and enters a
blocking state if it receives superior STP BPDUs. (A superior BPDU contains “better” information on the root
bridge and path cost to the root bridge, which would normally replace the current root bridge selection.)

The superior BPDUs received on a port enabled as root-guard are ignored. All other BPDUs are accepted and
the external devices may belong to the spanning tree as long as they do not claim to be the Root device. Use the
following command on RPVST+ switch ports that are connected to devices located in other administrative network
domains to ensure the stability of the core RPVST+ network topology so that undesired or damaging influences
external to the network do not enter.

Default: Disabled.

Syntax:
spanning-tree port-list tcn-guard
When tcn-guard is enabled for a port, it causes the port to stop processing or propagating received topology
change notifications and topology changes to other ports.

Default: Disabled.

Enabling or disabling RPVST+ spanning tree
With the spanning tree mode set to RPVST+, you can do either of the following:

• Enable or disable RPVST+ on all VLANs on the switch.

• Enable or disable RPVST+ on specified VLANs that are RPVST+-enabled on the switch.
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Syntax:

no spanning-tree [enable | disable]
To globally enable RPVST+ on all VLANs on the switch, use either of the following:

spanning-tree [enable]

no spanning-tree disable
To globally disable RPVST+ on all VLANs on the switch, use any of the following:

no spanning-tree

spanning-tree disable

no spanning-tree enable

NOTE: This status will always be shown in show run to let you know whether the spanning-tree is
enabled. Having spanning tree present but not enabled will lead to a change in the existing factory
default settings.

NOTE: This command overrides the per-VLAN enable/disable command (below).

Syntax:

spanning-tree vlan vid list [enable | disable]
To enable RPVST+ on one or more VLANs on the switch, use either of the following:

spanning-tree vlan vid list enable

no spanning-tree vlan vid list disable
To disable RPVST+ on one or more VLANs on the switch, use any of the following:

no spanning-tree vlan vid list

spanning-tree vlan vid listdisable

no spanning-tree vlan vid list enable

Allowing traffic on VLAN ID (PVID) mismatched links
When RPVST+ is running in the default configuration on a link where there is a VLAN ID mismatch, PVST blocks
the link, resulting in traffic on the mismatched VLANs being dropped. However, there can be instances where
traffic passing between mismatched VLANs on a link is desirable. When enabled on the switch, the ignore-
pvid-inconsistency command allows this behavior. That is, where the ports on both ends of a point-to-point
link are untagged members of different VLANs, enabling ignore-pvid-inconsistency enables RPVST+ to
process untagged RPVST+ BPDUs belonging to the peer’s untagged VLAN as if it was received on the current
device’s untagged VLAN.
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Syntax:

no spanning-tree ignore-pvid-inconsistency
Causes the switch to ignore per-VLAN ID inconsistencies when the ports on both ends of a point-to-point link are
untagged members of different VLANs, thus allowing RPVST+ to run on the mismatched links. On a given switch,
this affects all ports belonging to VLANs on which RPVST+ is enabled.

Default: Disabled

RPVST+ behavior

Table 21: RPVST+ behavior with ignore-pvid-inconsistency enabled

Switch “A” Port on VLAN X Switch “B” Peer port on VLAN
Y

RPVST+ behavior with ignore-pvid-
inconsistency enabled

Untagged on VLAN 10 Untagged on VLAN 10 Forward

Untagged on VLAN 10 Untagged on VLAN 20 Forward11,

Untagged on VLAN X Tagged on VLAN X Drop

Untagged on VLAN X Tagged on VLAN Y Drop (traffic from both VLANs)

Tagged on VLAN X Tagged on VLAN X Forward1

Tagged on VLAN X Tagged on VLAN Y Drop (traffic from both VLANs)

1 Forwarding state applies if the link has not been blocked by RPVST+ as a redundant link.

NOTE: The no spanning-tree ignore-pvid-inconsistency command is ineffective when
there is a PVID inconsistency between a VLAN1 and any non-VLAN1 member because VLAN1 uses
IEEE BPDUs to form a spanning tree topology.

Configuring STP loop guard
Spanning tree is used to ensure a loop-free topology over the LAN. Occasionally a hardware or software failure
can cause STP to fail, creating STP/ forwarding loops that can cause network failures where unidirectional links
are used. The non-designated port transitions in a faulty manner because the port is no longer receiving STP
BPDUs.

STP Loop Guard causes the non-designated port to go into the STP loop inconsistent state instead of the
forwarding state. In the loop-inconsistent state, the port prevents data traffic through the link, therefore avoiding
the loop creation. When BPDUs again are received on the inconsistent port, it resumes normal STP operation
automatically.

Syntax:
spanning-tree port-list loop-guard
no spanning-tree port-list loop-guard
Enables STP Loop Guard on a particular port or ports. STP Loop Guard is best applied on blocking or forwarding
ports.

The no form of the command disables STP Loop Guard.
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Default: Disabled

Figure 34: Loop creation with transmission failure

Before configuring loop guard

Before configuring Loop Guard on port 20, the status of VLAN 20 appears as follows:

switch(config)# show spanning-tree vlan 20

 Spanning Tree Information

  STP Enabled              [No] : Yes
  Mode                          : RPVST
  Extended System ID            : Enabled
  Ignore PVID Inconsistency     : Disabled
  Switch MAC Address            : 002347-c651c0

  VLAN ID                       : 20
  RPVST Enabled                 : Enabled

  Root MAC Address              : 0024a8-d13a40
  Root Priority                 : 32,768
  Root Path Cost                : 20,000
  Root Port                     : 1
  Operational Hello Time (secs) : 2
  Topology Change Count         : 2
  Time Since Last Change        : 9 secs

                                                           Designated
  Port   Type       Cost   Priority  Role       State      Bridge
  -----  ---------- ------ --------- ---------- ---------- ---------------
   1     100/1000T  20000  128       Root       Forwarding 0024a8-d13a40
   20    10/100TX   200000 128       Alternate  Blocking   002347-587b80

After configuring loop guard

By executing spanning-tree 20 loop-guard, loop guard has been configured on port 20 of Switch 2:
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switch(config)# show spanning-tree

 Spanning Tree Information

  STP Enabled          [No] : Yes
  Mode                      : RPVST
  Extended System ID        : Enabled
  Ignore PVID Inconsistency : Disabled
  RPVST Enabled VLANs       : 20

  Switch MAC Address        : 002347-c651c0
  Root Guard Ports          :
  Loop Guard Ports          : 20
  TCN Guard Ports           :
  BPDU Protected Ports      :
  BPDU Filtered Ports       :
  Auto Edge Ports           : 1-24
  Admin Edge Ports          :

  VLAN  Root Mac        Root       Root       Root                 Hello
  ID    Address         Priority   Path-Cost  Port                 Time(sec)
  ----- --------------- ---------- ---------- -------------------- ---------
  100   0024a8-d13a40   32,768     20,000     1                    2

Switch ceasing to send BPDUs

With switch 1 ceasing to send BPDUs through port 20 to switch 2, port 20 goes into the “inconsistent” state and
ceases to forward traffic, as displayed in the following show spanning-tree output for VLAN 20.

switch(config)# show spanning-tree vlan 20

 Spanning Tree Information

  STP Enabled              [No] : Yes
  Mode                          : RPVST
  Extended System ID            : Enabled
  Ignore PVID Inconsistency     : Disabled
  Switch MAC Address            : 002347-c651c0

  VLAN ID                       : 20
  RPVST Enabled                 : Enabled

  Root MAC Address              : 0024a8-d13a40
  Root Priority                 : 32,768
  Root Path Cost                : 20,000
  Root Port                     : 1
  Operational Hello Time (secs) : 2
  Topology Change Count         : 3
  Time Since Last Change        : 42 hours

                                                          Designated
  Port  Type       Cost   Priority  Role       State      Bridge
  ----- ---------- ------ --------- ---------- ---------- ---------------
  1     100/1000T  20000  128       Root       Forwarding 0024a8-d13a40
  20    10/100TX   200000 128       Alternate  Inconsi... 002347-587b80  
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Viewing configuration file with loop guard enabled

The following example displays show spanning-tree config output with loop guard enabled on Port 20:

switch(config)# show spanning-tree config

 Spanning Tree Information

  STP Enabled          [No] : Yes
  Mode                      : RPVST
  Extended System ID        : Enabled
  Ignore PVID Inconsistency : Disabled
  RPVST Enabled VLANs       : 100

  Switch MAC Address        : 002347-c651c0

  Root Guard Ports          :
  Loop Guard Ports          : 20
  TCN Guard Ports           :
  BPDU Protected Ports      :
  BPDU Filtered Ports       :
  Auto Edge Ports           : 1-24
  Admin Edge Ports          :

                Max Age Forward    Hello     Admin Root
  VLAN Priority (sec)   Delay(sec) Time(sec) Bridge
  ---- -------- ------- ---------- --------- ----------------
  100  32768    20      15         2         Not Configured

About RPVST+
RPVST+ is a proprietary spanning tree implementation that extends RSTP (802.1w) to run a separate spanning
tree for each VLAN on the switch, and ensures that only one active, loop-free path exists between any two nodes
on a given VLAN.

Comparing spanning tree options
Without spanning tree, having more than one active path between a pair of nodes causes loops in the network,
which can result in duplication of messages, leading to a “broadcast storm” that can bring down the network.

The 802.1D spanning tree protocol operates without regard to a network's VLAN configuration, and maintains one
common spanning tree throughout a bridged network. This protocol maps one loop-free, logical topology on a
given physical topology. This results in the least optimal link utilization and longest convergence times.

The 802.1s multiple spanning tree protocol (MSTP) uses multiple spanning tree instances with separate
forwarding topologies. Each instance is composed of one or more VLANs, which significantly improves network
link utilization and the speed of reconvergence after a failure in the network’s physical topology. However, MSTP
requires more configuration overhead and is more susceptible to dropped traffic due to misconfiguration.

Rapid spanning tree protocol (RSTP) requires less configuration overhead, provides faster convergence on point-
to-point links, and speedier failure recovery with predetermined, alternate paths. The switches covered by this
guide, use the IEEE Rapid Per-VLAN spanning tree Protocol (RPVST) standard. RPVST was introduced as an
enhancement to Rapid spanning tree Protocol (RSTP) to improve the link utilization issue and require less
configuration overhead. Basically, RPVST+ is RSTP operating per-VLAN in a single layer 2 domain. VLAN
tagging is applied to the ports in a multi-VLAN network to enable blocking of redundant links in one VLAN while
allowing forwarding over the same links for non-redundant use by another VLAN. Each RPVST+ tree can have a
different root switch and therefore can span through different links. Since different VLAN traffic can take different
active paths from multiple possible topologies, overall network utilization increases.

282 Aruba 2930F / 2930M Advanced Traffic Management Guide for
ArubaOS-Switch 16.08

Anexo 08 ITENS 8 E 9 (0592727)         SEI 0008478-63.2018.6.02.8000 / pg. 7886



Another major advantage of RPVST+ is that it localizes topology change propagation to individual VLANs. Since
there is a separate spanning tree for each VLAN, topology changes affecting a particular VLAN are propagated
only inside that VLAN. The switch flushes the MAC addresses learned only on the affected VLAN and other VLAN
traffic is not disturbed. This minimizes the network flooding caused by the spanning tree topology changes. This is
a significant improvement in the case of a large, flat, layer 2 network. In a network having a large number of per-
VLAN spanning tree instances, RPVST+ can result in an increased load on the switch's CPU.

Understanding how RPVST+ operates
RPVST+ applies one RSTP tree per-VLAN. Each of these RSTP trees can have a different root switch and span
the network through shared or different links. As shown in the following diagram, since the active paths for traffic
on different VLANs can use the same for different links, multiple topologies are possible, and overall network
utilization increases.

Figure 35: RSTP forming a single spanning tree across all VLANs

The topology has four switches running RSTP. Switch “A” is the root switch. To prevent a loop, RSTP blocks the
link between switch “B” and switch “D”. There are two VLANs in this network (VLAN 10 and VLAN 20). Since
RSTP does not have VLAN intelligence, it forces all VLANs in a layer 2 domain to follow the same spanning tree.
There will not be any traffic through the link between switch “B” and switch “D” and hence the link bandwidth gets
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wasted. On the other hand, RPVST+ runs different spanning trees for different VLANs. Consider the following
diagrams.

Figure 36: RPVST+ creating a spanning tree for VLAN 10

Figure 37: RPVST+ creating a spanning tree for VLAN 20

The two topologies above are the same as the first topology, but now the switches run RPVST+ and can span
different trees for different VLANs. Switch “A” is the root switch for the VLAN 10 spanning tree and switch “D” is
the root switch for the VLAN 20 spanning tree. The link between switch “B” and switch “D” is only blocked for
VLAN 10 traffic but VLAN 20 traffic goes through that link. Similarly the link between switch “A” and switch “C” is
blocked only for VLAN 20 traffic but VLAN 10 traffic goes through that link. Here, traffic passes through all the
available links, and network availability and bandwidth utilization increase.

Another major advantage of RPVST+ is that it localizes topology change propagation. Since there is a separate
spanning tree for each VLAN, topology changes affecting a particular VLAN are propagated only inside that
VLAN. The switch flushes the MAC addresses learned only on the affected VLAN, the traffic on other VLANs is
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not disturbed. This minimizes the network flooding due to spanning tree topology changes. This is a significant
improvement in the case of a large, flat, layer 2 network.

The following figure shows a further example of shared links and redundant path-blocking in a network running
RPVST+.

Figure 38: Sample RPVST+ network

Working with the default RPVST+ configuration
In the factory default configuration, spanning tree operation is disabled. Configuring the spanning tree mode as
RPVST+ on a switch and then enabling spanning tree automatically creates a spanning tree instance for each
VLAN on the switch. Configuration with default settings is automatic, and in many cases does not require any
adjustments. This includes operation with spanning tree regions in your network running STP, MSTP, or RSTP.
Also, the switch retains its currently configured spanning tree parameter settings when spanning tree is disabled.
Thus, if you disable, then later re-enable spanning tree, the parameter settings will be the same as before
spanning tree was disabled.

CAUTION:

The switch automatically senses port identity and type, and automatically defines spanning tree
parameters for each type, and parameters that apply across the switch. Although these parameters
can be adjusted, HPE strongly recommends leaving these settings in their default configurations
unless the proposed changes have been supplied by an experienced network administrator who has
a strong understanding of RPVST+ operation.

RPVST+ operating notes
Recommended application

RPVST+ is ideal in networks having less than 100 VLANs. In networks having 100 or more VLANs, MSTP is
the recommended spanning tree choice due to the increased load on the switch CPU.

VLAN membership

A port will be part of a given VLAN spanning tree only if the port is a member of that VLAN.
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RPVST+ interoperates with RSTP and MSTP on VLAN 1

Because a switch running RPVST+ transmits IEEE spanning tree BPDUs, it can interoperate with IEEE RSTP
and MSTP spanning tree regions, and opens or blocks links from these regions as needed to maintain a loop-
free topology with one physical path between regions.

NOTE: RPVST+ interoperates with RSTP and MSTP only on VLAN 1.

Single spanning tree applications

One spanning tree variant can be run on the switch at any given time. On a switch running RPVST+, MSTP
cannot be enabled. However, any MSTP-specific configuration settings in the startup configuration file will be
maintained.

Exclusions

The following features cannot run concurrently with RPVST+:

• Features that dynamically assign ports to VLANs:
◦ GVRP

◦ RADIUS-based VLAN assignments (802.1X, WebAuth, MKAC auth

◦ Auth-VID/UnAuth-VID configuration on interfaces

◦ MAC-Based VLANs

◦ LLDP Radio Port VLAN

• Switch Meshing

• QinQ

• Protocol VLANs

• Distributed Trunking

• Filter Multicast in rapid-PVST mode (The multicast MAC address value cannot be set to the PVST MAC
address 01:00:0c:cc:cc:cd.)

GVRP

Spanning tree mode cannot be set to RPVST+ when GVRP is enabled, and GVRP cannot be enabled when
RPVST+ is enabled.

RPVST+ operating limits

Virtual ports (vPorts) on a switch are determined by the number of physical ports on the switch, plus other
factors. Exceeding the recommended number of vPorts can result in dropped BPDUs.

Allowing traffic on per-VLAN ID (PVID) mismatched links

The switch generates an Event Log message for a VID mismatch on an active RPVST+ VLAN only if
ignore-pvid-inconsistency is disabled (the default).

If ignore-pvid-inconsistency is enabled on multiple switches connected by hubs, there could be more
than two VLANs involved in PVID mismatches that will be ignored by RPVST+.

If there is an actual misconfiguration of port VLAN memberships in a network, then enabling ignore-pvid-
inconsistency prevents RPVST+ from detecting the problem. This could result in packet duplication in the
network because RPVST+ would not converge correctly.
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Viewing RPVST+ statistics and configuration
NOTE:

RPVST+ is a superset of the STP/802.1D and RSTP/802.1w protocols, and uses the RPVST+ MIB
(hpicfRpvst).

Viewing global and VLAN spanning tree status
Syntax:
show spanning-tree
Displays the switch’s global and VLAN spanning tree status.

Viewing the switch's global and VLAN spanning tree status

switch# show spanning-tree

 Spanning Tree Information

  STP Enabled          [No] : Yes
  Mode                      : RPVST
  Extended System ID        : Disabled
  Ignore PVID Inconsistency : Disabled
  RPVST Enabled VLANs       : 10,20

  Switch MAC Address        : 0024a8-d13a40
  Root Guard Ports          :
  Loop Guard Ports          :
  TCN Guard Ports           :
  BPDU Protected Ports      : 23-24
  BPDU Filtered Ports       : 23-24
  Auto Edge Ports           : 1-24,A1-A4
  Admin Edge Ports          :

  VLAN  Root Mac        Root       Root       Root                 Hello
  ID    Address         Priority   Path-Cost  Port                 Time(sec)
  ----- --------------- ---------- ---------- -------------------- ---------
  10    0024a8-d13a40   32,768     0          This switch is root  2
  20    0024a8-d13a40   32,768     0          This switch is root  2

Viewing status for a specific VLAN
Syntax:

show spanning-tree vlan vlan-id
Displays detailed spanning tree information for the VLAN and the ports belonging to the specified VLAN.

Viewing status for a specific VLAN

switch(config)# show spanning-tree vlan 20

 Spanning Tree Information

  STP Enabled              [No] : Yes
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  Mode                          : RPVST
  Extended System ID            : Disabled
  Ignore PVID Inconsistency     : Disabled
  Switch MAC Address            : 0024a8-d13a40

  VLAN ID                       : 20
  RPVST Enabled                 : Enabled

  Root MAC Address              : 0024a8-d13a40
  Root Priority                 : 32,768
  Root Path Cost                : 0
  Root Port                     : This switch is root
  Operational Hello Time (secs) : 2
  Topology Change Count         : 38
  Time Since Last Change        : 23 hours

                                                          Designated
  Port  Type       Cost   Priority  Role       State      Bridge
  ----- ---------- ------ --------- ---------- ---------- ---------------
  9     100/1000T  20000  128       Designated Forwarding 0024a8-d13a40
  21    100/1000T  20000  128       Designated Forwarding 0024a8-d13a40
  22    100/1000T  20000  128       Designated Forwarding 0024a8-d13a40
  23    100/1000T  200000 128       Designated Forwarding 0024a8-d13a40
  24    100/1000T  0      128                  Disabled

Viewing status for a specific port list
Syntax:

show spanning-tree port-list
Displays the spanning tree status for the designated port(s). You can list data for a series of ports and port trunks
by specifying the first and last port or trunk of any consecutive series of ports and trunks. For example, to display
data for port 20-24 and trk1, you would use this command: show spanning-tree 20-42,trk1

Viewing status for a specific port list

switch# show spanning-tree 22

 Spanning Tree Information

  STP Enabled    [No] : Yes
  Mode                : RPVST
  RPVST Enabled VLANs : 10,20

  Switch MAC Address  : 0024a8-d13a40

  Port                   : 22
  Status                 : Up           Port Type           : 100/1000T
  BPDU Protection        : No           BPDU Filtering      : No
  Root Guard             : No           TCN Guard           : No
  Loop Guard             : No           Admin Edge Port     : No
  Admin PointToPoint MAC : Yes

  VLAN   Port       Port      Port       Designated    Hello Oper  Oper
  ID     Path-Cost  Priority  State      Bridge        Time  Edge  PtP
  ------ ---------- --------- ---------- ------------- ----- ----- ------
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  20     20000      128       Forwarding 0024a8-d13a40 2     No    Yes
  25     200000     128       Forwarding 002347-587b80 2     Yes   Yes

Viewing status per-port per-VLAN
Syntax:

show spanning-tree port-list vlan vlan-id
Displays detailed information for ports in the port-list in the given VLAN. This command further filters the
output for show spanning-tree port-list.

Viewing status per-port per-VLAN

switch# show spanning-tree 22 vlan 20

 Spanning Tree Information

  STP Enabled    [No] : Yes
  Mode                : RPVST
  RPVST Enabled VLANs : 10,20

  Switch MAC Address  : 0024a8-d13a40

  Port                   : 22
  Status                 : Up           Port Type           : 100/1000T
  BPDU Protection        : No           BPDU Filtering      : No
  Root Guard             : No           TCN Guard           : No
  Loop Guard             : No           Admin Edge Port     : No
  Admin PointToPoint MAC : Yes

  VLAN   Port       Port      Port       Designated    Hello Oper  Oper
  ID     Path-Cost  Priority  State      Bridge        Time  Edge  PtP
  ------ ---------- --------- ---------- ------------- ----- ----- ------
  20     20000      128       Forwarding 0024a8-d13a40 2     No    Yes

Viewing the global RPVST+ configuration
Syntax:

show spanning-tree config
Displays the switch’s basic and per-VLAN spanning tree configuration.

The upper part of the output shows the switch’s global spanning tree configuration. The port listing shows the
spanning tree port parameter settings for the spanning tree region operation (configured by the spanning-tree
port-list command).

Viewing the global RPVST+ configuration

switch# show spanning-tree config

 Spanning Tree Information

  STP Enabled          [No] : Yes
  Mode                      : RPVST
  Extended System ID        : Enabled
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  Ignore PVID Inconsistency : Disabled
  RPVST Enabled VLANs       : 10,20

  Switch MAC Address        : 002347-587b80

  Root Guard Ports          :
  Loop Guard Ports          :
  TCN Guard Ports           :
  BPDU Protected Ports      :
  BPDU Filtered Ports       :
  Auto Edge Ports           : 1-24
  Admin Edge Ports          :

                Max Age Forward    Hello     Admin Root
  VLAN Priority (sec)   Delay(sec) Time(sec) Bridge
  ---- -------- ------- ---------- --------- ----------------
  1    32768    20      15         2         Not Configured
  10   32768    20      15         2         Not Configured
  20   32768    20      15         2         Not Configured

Viewing the global RPVST+ configuration per port
Syntax:

show spanning-tree [ethernet]port-list config
Lists the spanning tree port parameter settings (global and per VLAN) for only the specified port(s) and trunk(s).
You can list data for a series of ports and port trunks by specifying the first and last port or trunk of any
consecutive series of ports and trunks. For example, to display data for ports 9, 11, 12, 21 and trk1, use this
command: show spanning-tree 9,11,12,21,trk1 config

Viewing the global RPVST+ configuration per port

switch# show spanning-tree 9,11,12,21,22 2 trk1 config

 Spanning Tree Information

  STP Enabled     [No] : Yes
  Mode                 : RPVST
  Switch MAC Address   : 002347-587b80
  RPVST Enabled VLANs  : 10,20

        Admin Auto Admin Root Loop TCN BPDU BPDU
  Port  Edge  Edge PtP   Grd  Grd  Grd Flt  Guard
  ----- ----- ---- ----- ---- ---- --- ---- -----
  9     No    Yes  True  No   No   No  No   No
  11    No    Yes  True  No   No   No  No   No
  12    No    Yes  True  No   No   No  No   No
  21    No    Yes  True  No   No   No  No   No
  Trk1  No    Yes  True  No   No   No  No   No

Viewing the global RPVST+ configuration per port per VLAN
Syntax:

show spanning-tree<ethernet>port-list vlan vlan-id
Lists the spanning tree port parameter settings per port per VLAN.
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Viewing the global RPVST+ configuration per port per VLAN

switch# show spanning-tree 9 config vlan 10

 Spanning Tree Information

  STP Enabled          [No] : Yes
  Mode                      : RPVST
  Extended System ID        : Enabled
  Ignore PVID Inconsistency : Disabled
  Switch MAC Address        : 002347-587b80

  RPVST Enabled             : Enabled
  VLAN ID                   : 10
  Switch Priority           : 32768
  Forward Delay             : 15
  Hello Time                : 2
  Max Age                   : 20
  Admin Root Bridge         : Not Configured

       Path      Port     Admin Auto Admin Root Loop TCN BPDU BPDU
 Port  Cost      Priority Edge  Edge PtP   Grd  Grd  Grd Flt  Guard
 ----- --------- -------- ----- ---- ----- ---- ---- --- ---- -----
 9     20000     128      No    Yes  True  No   No   No  No   No

Viewing the global RPVST+ configuration per VLAN
Syntax:

show spanning-tree config vlan vlan-id
Lists the spanning tree port parameter settings for only the specified VLAN.

Viewing the global RPVST+ configuration per VLAN

switch(config)# show spanning-tree config vlan 20

 Spanning Tree Information

  STP Enabled          [No] : Yes
  Mode                      : RPVST
  Extended System ID        : Enabled
  Ignore PVID Inconsistency : Disabled
  Switch MAC Address        : 002347-587b80

  RPVST Enabled             : Enabled
  VLAN ID                   : 20
  Switch Priority           : 32768
  Forward Delay             : 15
  Hello Time                : 2
  Max Age                   : 20
  Admin Root Bridge         : Not Configured

                   Path      Port
  Port  Type       Cost      Priority
  ----- ---------- --------- ---------
  9     100/1000T  20000     128
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  20    100/1000T  200000    128
  21    100/1000T  20000     128

Viewing BPDU status and related information
Syntax:

show spanning-tree bpdu-protection port-list
Displays the BPDU protection state and errant BPDU count for ports in the port list.

Viewing BPDU status in show spanning tree output

switch# show spanning-tree 22

 Spanning Tree Information

  STP Enabled    [No] : Yes
  Mode                : RPVST
  RPVST Enabled VLANs : 10,20

  Switch MAC Address  : 0024a8-d13a40

  Port                   : 22
  Status                 : Up           Port Type           : 100/1000T
  BPDU Protection        : No           BPDU Filtering      : No
  Root Guard             : No           TCN Guard           : No
  Loop Guard             : No           Admin Edge Port     : No
  Admin PointToPoint MAC : Yes

  VLAN   Port       Port      Port       Designated    Hello Oper  Oper
  ID     Path-Cost  Priority  State      Bridge        Time  Edge  PtP
  ------ ---------- --------- ---------- ------------- ----- ----- ------
  20     20000      128       Forwarding 0024a8-d13a40 2     No    Yes

Viewing BPDU protection status on specific ports

switch# show spanning-tree bpdu-protection 11-12,21-24

 Status and Counters - STP BPDU Protection Information

 BPDU Protection Timeout (sec) : 60
 BPDU Protected Ports : 23-24

  Port   Type      Protection State             Errant BPDUs
  ------ --------- ---------- ----------------- ------------
  11     100/1000T No                           0
  12     100/1000T No                           0
  21     100/1000T No                           0
  22     100/1000T No                           0
  23     100/1000T Yes                          0
  24     100/1000T Yes                          0
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Viewing RPVST+ VLAN and vPort system limits
Each switch model supports a maximum number of active virtual ports (vPorts). New port VLAN memberships
cannot be created once the vPort limit has been reached. Also, there is a maximum recommended number of
active vPorts for each fixed-port switch or each module in a chassis switch. Exceeding the maximum
recommended number of vPorts can result in dropped BPDUs and potential network loops. This command
displays the current vPort status and maximum recommended vPort total per-switch or, for modular switches, per-
module.

Syntax:
show spanning-tree system-limits rapid-pvst
Displays the RPVST+ VLAN and virtual port (vPort) status on the switch.

Viewing RPVST+ VLAN and vPort system limits

switch(config)# show spanning-tree system-limits rapid-pvst

 Spanning Tree Information

  STP Enabled              : Yes
  Mode                     : RPVST
  RPVST Enabled VLANs      : 20

  Switch MAC Address                   : 002347-c651c0
  Count of RPVST Enabled VLANs         : 1
  Maximum Allowed RPVST Enabled VLANs  : 400
  Count Of Total Virtual Ports         : 24
  Maximum Allowed Virtual Ports        : 424

                       Current         Operational     Recommended Maximum
  Ports                Virtual Ports   Virtual Ports   Virtual Ports
  -------------------- --------------- --------------- --------------------
  Ports 1-24           24              2               200

Table 22: Virtual Port Data Fields

vPort data field Description

Count of Total Virtual Ports The count of active vPorts (ports per VLAN) plus the count of non-
active vPorts (all ports that belong to trunks).

Maximum Allowed Virtual Ports The total of the system-created vPort instances plus the maximum
user-assignable vPort instances. Each port on the switch belongs to
at least one VLAN (VLAN-1 by default), which is a system-created
vPort instance. The user-assigned VPORT instances are the
system-assigned vPort instances. The show spanning-tree
system-limits rapid-pvst command combines the system-
created vPort instances and the user-assigned maximum vPort
instances when calculating the maximum allowed virtual ports.

NOTE: Each user-configured trunk on the switch
increments this value by 1.

Table Continued
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vPort data field Description

Current Virtual Ports The number of ports that are members of each VLAN on a per-
module basis (or a per-group of ports basis).

Operational Virtual Ports The number of ports belonging to each PVST-enabled VLAN on a
per-module basis (or a per-group of ports basis). This value should
not exceed the recommended maximum vPort limit.

Recommended Maximum Virtual
Ports The maximum recommended number of vPort instances that should

be allowed on the switch. Exceeding this limit can potentially result
in received BPDUs being dropped.

Configuring vPorts

Virtual ports on a switch are calculated as ports per-VLAN. Also, a trunk membership on one or more VLANs
counts as one vPort per-VLAN, regardless of how many physical ports belong to the trunk. For example, the
following configuration on a modular chassis results in 26 vPorts.

trunk 1,2 trk1
vlan 1
   name "DEFAULT_VLAN"
   untagged 3-24
   no untagged trk1
   exit
vlan 20
   ip address 10.243.230.75 255.255.255.248
   name "VLAN20"
   tagged trk1
   exit
vlan 30
   ip address 10.243.230.83 255.255.255.248
   name "VLAN30"
   tagged 13,14,trk1
   exit

Module “A” Module “B” Module “C” Total vPorts on the
Switch

VLAN 1 22 (A3 - A24) 23 (B2 - B24 24 (C1 - C24)

VLAN 20 1 (trk1: A1 - A2) 1 (trk1: B1)1 0

VLAN 30 2 (A13 - A14) 1 (trk1:
A1 - A2)1

2 (B13 - B14) 1 (trk1:
B1)1

0

vPorts per-
module

26 27 24 77

1 A trunk in a given VLAN counts as one vPort for each module on which it occurs.

Calculating non-active vPorts

Every port that is part of a manually configured trunk is counted as a non-active (reserved) vPort. For example,
the ports in the following configuration are all non-active vPorts:
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trunk 1, 2 trk1
trunk 3-5 trk2 lacp
trunk 17-20 trk3 dt-lacp

Calculating per-module vPorts on chassis switches

The switch-wide active vPort count, there is a vPort count per port module determined by the number of ports per
line card that are members of each VLAN. Also, on modular switches, if a VLAN includes a trunk configured with
ports on more than one module, then one vPort is counted for each module on which the trunk exists (regardless
of how many ports are included in the trunk.) For example, in the following configuration, VLANs 1, 20, and 30
have a total of 74 vPorts.

trunk A1,A2,B1 trk1
vlan 1
    name “DEFAULT_VLAN”
    untagged A3-A24, B2-B24
    no untagged trk1
    exit
vlan 20
    ip address 10.243.230.75 255.255.255.248
    name “VLAN20”
    tagged A3-A12, B2-B12, trk1
    exit
vlan 30
    ip address 10.243.230.83 255.255/255/248
    name “VLAN30”
    tagged A13, A14, B13, B14, trk1
    exit

Module “A” Module “B” All Modules

VLAN 1 22 23 4

VLAN 20 10 + 1 11 + 1 23

VLAN 30 2 + 1 2 + 1 6

Total vPorts 36 38 74

Troubleshooting an RPVST+ configuration
Cause

This section describes the show spanning tree commands you can use to monitor, troubleshoot, and debug the
operation of a per-VLAN spanning tree configuration in your network.

NOTE: The show spanning-treecommands described in this section allow you to troubleshoot
RPVST+ activity in your network by focusing on increasingly specific levels of operation. For
example, you can display debug information for:

• All VLANs

• All ports of one VLAN

• A specific port or several ports used in one VLAN
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Viewing the change history of root bridges
Syntax:

show spanning-tree root-history vlan vlan-id
Displays the last 10 root bridge changes on a specified VLAN configured with RPVST+. Included are the
timestamp and Root Bridge ID recorded at each root bridge change.

Use the show spanning-tree root-history command to view the number and dates of changes in the
assignment of a root bridge. Possible intrusion into your VLAN network may occur if an unauthorized external
device gains access to a spanning tree by posing as the root device in a topology. To prevent a port connected to
the device from being selected as the root port in a topology, use the spanning-tree root-guard command.

Viewing the change history of root bridges

switch# show spanning-tree root-history vlan 20

 Status and Counters - RPVST Root Changes History

  VLAN ID                : 20
  Root Changes Counter   : 53
  Current Root Bridge ID : 32768:0024a8-d13a40

 Root Bridge ID      Date       Time
 ------------------- ---------- --------
 32768:0024a8-d13a40 05/04/2012 21:54:11
     0:001185-c6e500 05/04/2012 21:54:07
 32768:0024a8-d13a40 05/04/2012 16:41:11
     0:001185-c6e500 05/04/2012 16:41:11

Enabling traps and Viewing trap configuration
Syntax:
no spanning-tree trap
[[errant-bpdu | loop-guard | new-root] | [topology-change [vlan<vid-list | instance [instance-ID] {cstt}|root-guard]]

Enables or disables SNMP traps for errant-BPDU, loop guard, new root, and root guard event notifications.

errant-bpdu
Enables SNMP notification when an errant BPDU is received. Designed for use with BPDU filtering.

loop-guard
Enables SNMP notification when a loop guard inconsistency is detected. Designed for use with the Loop
Guard option.

new-root
Enables SNMP notification when a new root is elected on any VLAN configured for RPVST+ on the switch.

root-guard
Enables SNMP notifications when a root-guard inconsistency is detected.

topology-change
Enables notifications sent when a topology change occurs.

topology-change-history
Shows the spanning tree topology history changes.
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Default for all of the above options: Disabled

The no form of the command disables traps on the switch.

Syntax:
show spanning-tree traps
Displays the current spanning tree trap configuration on the switch.

Viewing spanning tree traps in the default configuration

switch(config)# show spanning-tree traps

 Status and Counters - STP Traps Information

 Trap Name              | Status
 ---------------------- + --------
 errant-bpdu            | Disabled
 new-root               | Disabled
 root-guard             | Disabled
 loop-guard             | Disabled

Viewing debug counters for all VLAN instances
Syntax:

show spanning-tree debug-counters
Displays the aggregate values of all RPVST+ debug counters that are maintained on a switch. These aggregate
values are a summary of the information collected from all ports and from all spanning tree instances for all switch
ports. Use the displayed diagnostic information to globally monitor RPVST+ operation on a per-switch basis.

Viewing debug counters for all VLANs

switch# show spanning-tree debug-counters

 Status and Counters - RPVST Debug Counters Information

                                 Aggregated Value
  Counter Name                   Collected from VLANs
  ------------------------------ -------------------------
  Invalid BPDUs                  0
  Errant BPDUs                   0
  Looped-back BPDUs              0
  Starved BPDUs                  18
  Exceeded Max Age BPDUs         3
  Topology Changes Detected      9
  Topology Changes Tx            9
  Topology Changes Rx            4
  Topology Change ACKs Tx        0
  Topology Change ACKs Rx        6
  TCN BPDUs Tx                   4
  TCN BPDUs Rx                   0
  CFG BPDUs Tx                   0
  CFG BPDUs Rx                   0
  RST BPDUs Tx                   0
  RST BPDUs Rx                   0
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  RPVST BPDUs Tx                 1881
  RPVST BPDUs Rx                 2617

Viewing debug counters per-VLAN
Syntax:

show spanning-tree debug vlan vlan-id
Displays the aggregate values of all RPVST+ debug counters maintained on a switch for a specified VLAN.

Viewing debug counters for a specific VLAN

switch(config)# show spanning-tree debug vlan 20

 Status and Counters - RPVST Debug Counters Information

  VLAN ID : 20

                                 Aggregated Value
  Counter Name                   Collected from Ports
  ------------------------------ --------------------
  Invalid BPDUs                  5
  Errant BPDUs                   10
  Looped-back BPDUs              0
  Starved BPDUs                  9
  Exceeded Max Age BPDUs         2
  Topology Changes Detected      9
  Topology Changes Tx            4
  Topology Changes Rx            181
  Topology Change ACKs Tx        0
  Topology Change ACKs Rx        0
  TCN BPDUs Tx                   0
  TCN BPDUs Rx                   0
  CFG BPDUs Tx                   0
  CFG BPDUs Rx                   0
  RST BPDUs Tx                   0
  RST BPDUs Rx                   0
  RPVST BPDUs Tx                 1531
  RPVST BPDUs Rx                 1428

Viewing debug counters per-port per-VLAN
Syntax:

show spanning-tree debug ports port-list vlan vlan-id
Displays the aggregate values of all RPVST+ debug counters maintained on one or more ports used by a
specified VLAN.

Viewing debug counters for a specific port on a VLAN

Switch_A(config)# show spanning-tree debug ports 9 vlan 20

 Status and Counters - RPVST Debug Counters Information

  VLAN ID : 20
  Port : 9
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  Counter Name                   Value           Last Updated
  ------------------------------ --------------- --------------------
  Invalid BPDUs                  0               04/16/2012 22:27:15
  Errant BPDUs                   0               04/16/2012 22:27:15
  Looped-back BPDUs              0               04/16/2012 22:27:15
  Starved BPDUs                  5               05/01/2012 21:48:11
  Exceeded Max Age BPDUs         0               04/16/2012 22:27:15
  Topology Changes Detected      9               05/04/2012 21:54:05
  Topology Changes Tx            5               05/05/2012 22:04:49
  Topology Changes Rx            2               05/07/2012 18:08:34
  Topology Change ACKs Tx        0               04/16/2012 22:27:15
  Topology Change ACKs Rx        0               04/16/2012 22:27:15
  TCN BPDUs Tx                   0               04/16/2012 22:27:15
  TCN BPDUs Rx                   0               04/16/2012 22:27:15
  CFG BPDUs Tx                   0               04/16/2012 22:27:15
  CFG BPDUs Rx                   0               04/16/2012 22:27:15
  RST BPDUs Tx                   0               04/16/2012 22:27:15
  RST BPDUs Rx                   0               04/16/2012 22:27:15
  RPVST BPDUs Tx                 7812            05/05/2012 22:04:49
  RPVST BPDUs Rx                 1065            05/08/2012 19:43:11

Field descriptions for RPVST+ debug command output

Field Shows the number of —

Invalid BPDUs Received BPDUs that failed standard RPVST+ (802.1Q-REV/D5.0 14.4) validation checks
and were dropped. This counter is maintained on a per-port per-VLAN basis.

Errant BPDUs Received BPDUs that were dropped on a port that is configured to not expect BPDU
packets. This counter is maintained on a per-port basis and is incremented each time a
BPDU is received on a port configured with the BPDU filter to ignore incoming BPDU
packets (spanning-tree bpdu-filter command) or the BPDU protection feature to
disable the port when BPDU packets are received (spanning-tree bpdu-protection
command).

Looped-back
BPDUs Times that a port has received self-sent BPDU packets as the result of an external loop

condition in which the BPDUs were looped back to the originating transmission port. The
received BPDU is still processed by RPVST+ and the port changes to a blocked state. This
counter is maintained on a per-port per-VLAN basis.

Starved BPDUs Times that no BPDUs are received within the scheduled interval (three times the Hello Time
value configured with the spanning-tree vlan hello-time command) from a VLAN-
designated peer port on the VLAN root, alternate, or backup port. As a result, the “starved”
port triggers a spanning tree topology regeneration. This counter is maintained on a per-
port per-VLAN basis.

Exceeded Max
Age BPDUs Times that a BPDU packet is received from a bridge with a Message Age value greater than

the configured value of the Max Age parameter (spanning-tree maximum age
command). This may occur if the receiving bridge is located too far from the root bridge
(beyond the configured size of the spanning tree domain on the root bridge) or if a BPDU
packet with invalid root information is continuously circulating between bridges in a
spanning tree domain and needs to be aged out.

Table Continued
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Field Shows the number of —

Topology
Changes
Detected

Times that a Topology Change event is detected by the port on a given VLAN and the port
triggers a topology change propagation throughout the network. A Topology Change event
occurs when a non-edge port enters forwarding state. This counter is maintained on a per-
VLAN per-port basis.

Topology
Changes Tx Times that Topology Change information is propagated (sent out) through the port to the

rest of the network. For a VLAN port running PVST (non-rapid), the counter is the number
of times that a CFG or RST BPDU with the TC flag set is transmitted out of the port. This
counter is maintained on a per-VLAN per-port basis.

Topology
Changes Rx Times that Topology Change information is received from the peer port. For a VLAN port

running PVST (non-rapid), the counter is the number of times that a CFG or RST BPDU
with the TC flag set is received. This counter is maintained on a per-port per-VLAN basis.

Topology
Change ACKs
Tx

Times that the Topology Change acknowledgement is transmitted through the port (number
of CFG or RST BPDUs transmitted with the Topology Change Acknowledge flag set). This
counter is maintained on a per-port per-VLAN basis.

Topology
Change ACKs
Rx

Times that the Topology Change acknowledgement is received on the port (number of CFG
or RST BPDUs received with the Topology Change Acknowledge flag set). This counter is
maintained on a per-VLAN basis.

TCN BPDUs Tx Topology Change Notification BPDUs that are transmitted through the port. This counter is
maintained on a per-port basis.

TCN BPDUs Rx Topology Change Notification BPDUs that are received on the port. This counter is
maintained on a per-port per-VLAN basis.

CFG BPDUs Tx 802.1D configuration BPDUs that are transmitted through the port. This counter is
maintained on a per-port per-VLAN basis.

CFG BPDUs Rx 802.1D configuration BPDUs that are received on the port. This counter maintained on a
per-port per-VLAN basis.

RST BPDUs Tx 802.1w RST BPDUs that are transmitted through the port. This counter is maintained on a
per-port per-VLAN basis.

RST BPDUs Rx 802.1w RST BPDUs that are received on the port. This counter is maintained on a per-port
per-VLAN basis.

RPVST+ event log messages

Event Log message

STP enabled/disabled on a VLAN Spanning tree Protocol enabled/disabled on vlan vlan-
id

Switch does not receive BPDUs from
peer on a particular VLAN and port

VLAN vlan-id starved for a BPDU on port port number
from bridge name

Table Continued
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Event Log message

Switch received BPDU with
inconsistent VLAN

Blocking port-name on vlan vlan-id.

Inconsistency is restored Unblocking port-name on vlan vlan-id Port consistency
restored.

Root port is changed on a VLAN VLAN vlan-idroot changed from bridgepriorty:mac to
bridge priority:mac

Switch received a BPDU with invalid
TLV

Received SSTP BPDU with bad TLV on port-number vlan-
id

The number of vlan-port
instances exceeds the recommended
limit

The number of vlan-port instances exceeded the
recommended limit of num

RADIUS subsystem tries to
dynamically change port VLAN
assignments when mode is RPVST

RADIUS unable to assign port to VLAN vlan-id because
spanning-tree is running in RPVST+ mode

LLDP subsystem tries to dynamically
change port VLAN assignments when
mode is RPVST

LLDP unable to assign port port-number to VLAN vlan-
id because spanning-tree is running in RPVST+ mode

VPORT counts exceed 200 The number of vPorts on slot slot-number exceeds the
recommended limit of vport-count. PVST BPDUs may be
dropped.

Using RPVST+ debug
While the Event Log records switch-level progress, status, and warning messages on the switch, the Debug/
System Logging (Syslog) feature provides a way to record Event Log and debug messages on a remote device.
For example, you can send messages about routing misconfigurations and other network protocol details to an
external device, and later use them to debug network-level problems. The Debug/Syslog feature allows you to
specify the types of Event Log and debug messages that you want to send to an external device. The two
commands described next affect debug operation for RPVST+. For further information on debug operation, see
the ArubaOS-Switch Management and Configuration Guide for your switch.

Syntax:

spanning-tree clear-debug-counters [ports port-list] [vlan vid-list]
Clears all spanning tree debug counters unless specific ports and VLANs are specified.

ports port-list
Clears spanning tree debug counters on the specified ports.

[ethernet]port-list
Clears spanning tree debug counters on an entered list of posts or all for the ports command parameter.

vlan
Clears spanning tree debug counters for the VLAN.
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vlan vlan-id-list
One or more identifiers for the VLAN command parameter.

Using the vlan and ports options together clears the spanning tree debug counters on the specified ports for
the specified VLANs. Counters maintained on the same ports for other VLANs are not cleared.

Syntax:
debug rpvst [event [filter vlan vid-list]]
no debug rpvst [event [filter vlan vid-list]]
debug rpvst [packet [filter port port-list [vlan vid-list]]]
no debug rpvst [packet [filter port port-list [vlan vid-list]]]
Displays RPVST+ debug messages on the destination device specified with the debug destination
logging | session | buffer command.

event
Displays RPVST+ Event Log messages.

filter vlan vid-list
Limits log messages to those generated on the specified VLANs.

packet
Displays RPVST+ packets sent and received.

filter port port-list vlan vid-list
Limits packets displayed to those generated on the specified ports. If the vlan option is used, then packets
displayed are further limited to the ports on the specified VLANs.

The no form of the command disables display of RPVST+ debug messages on the destination device.
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Overview of VXLAN
Virtual Extensible LAN(VXLAN) is a network virtualization technology that allows the extension of L2 networks
over L3 UDP tunnels.

VXLAN tunnel

The 192.168.10.X/24 subnet is being tunneled through the 30.10.10.X/24 network.

Figure 39: VXLAN tunnel

L2 Forwarding in VXLAN
VXLAN learns unicast source MAC addresses similar to hosts off of physical ports. When a packet is de-
encapsulated from a VXLAN tunnel, the source MAC is checked against the MAC table and bound to the tunnel
interface index or if it is not present, it is learned. If the unicast source is in the MAC table but on a different port or
tunnel to it, it is considered a move. The MAC table is used as the destination match to send traffic to a remote
tunnel partner. Any unknown destination addresses are forwarded to all VTEP partners, configured with a
common Virtual Network Identifier (VNI).

Broadcast addresses are handled similar to unknown destination addresses and flooded to all tunnels with
mapped and configured VNI. Floods are copied to each unicast VTEP tunnel. Multicast addresses are not filtered,
they are treated like a flood when going to multiple tunnel destinations.

Fully Meshed Network
In a fully meshed VXLAN network, every VTEP is configured with a tunnel to every other VTEP running the same
VNI. A fully meshed VXLAN network allows for any overlay network to reach any other part of the network for
local L2 to L2 traffic. This is necessary when client to client traffic is needed amongst roaming clients with the
same subnet.

Chapter 11
VXLAN
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Fully meshed network

Every VTEP needs 6 Tunnel connections to reach every other VTEP in the mesh network.

Figure 40: Fully meshed network

Hub Spoke Network
The configuration is simple for all VTEPs except for the gateway. Each outer VTEP needs to have a tunnel
plumbed back to the VXLAN VTEP Gateway for VTEPs 1-6. The gateway however needs a tunnel to each of the
VTEPs configured on the edge.
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Hub spoke network

In the following Hub spoke model, traffic only flows from the edge VTEPs back to the VXLAN gateway.

Figure 41: Hub spoke network

Restrictions
The following is a limitation of VXLAN:

For any given L2 virtual network, only one VTEP can be present for each edge L2 LAN.

VXLAN — Feature interaction table
Feature VXLAN impact

ARP protect VXLAN tunnel interfaces would be (implicitly) TRUSTED interfaces
with no MAC/IP verification on ARP PKTs ingressing tunnels.

ARP protection will be enforced on other untrusted ports of the overlay
VLAN if ARP protection is enabled for that VLAN.

A VLAN that has a virtual IP subnet and a VNI configured for it is
referred to as an overlay VLAN in here.

CDP CDP only runs on physical links. VXLANs are not able to participate in
CDP.

Table Continued
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Feature VXLAN impact

DHCP (v4/v6) relay A gateway device is able to function as a DHCP Relay agent and
support transferring DHCP PKTs between the following depending on
where the DHCP server is housed:
• An overlay subnet and an underlay subnet.

• An overlay subnet and another overlay subnet.

DHCP snooping VXLAN tunnel interfaces would be (implicitly) TRUSTED with no
MAC/IP/Port verification on DHCP PKTs ingressing tunnels.

filter • Connection Rate (Virus Throttling) – Cannot be enabled on a
VXLAN tunnel interface.

• Multicast – Tunnel interface cannot be part of the drop filter. PKTs
coming in on a tunnel interface will honor drop filter if configured for
the multicast address.

• Protocol – Similar to Multicast filters.

• Source Port - Tunnel interface cannot be part of the drop filter. A
tunnel interface cannot have a source port filter configured for it.

IGMP snooping No support for IGMP SNOOPing and Multicast pruning on VXLAN
tunnel interfaces.If a device is an IGMP querier on an overlay VLAN,
the IGMP queries sourced by the device will be sent over the VTEP
fabric to the other nodes as well.IGMP blocked and forward
configuration cannot be applied to VXLAN interfaces.

IGNORE untagged-MAC Not applicable to VXLAN tunnel interfaces.

Link-Keepalive (UDLD) Not supported on VXLAN tunnel interfaces.

LLDP LLDP not supported on tunnel interfaces.

Lockout-MAC Traffic ingressing a network port with source MAC that is configured as
lockout-MAC will not be tunneled.Traffic ingressing a tunnel interface
(i.e. payload) with a source MAC that is configured as lockout-MAC on
the device will be dropped upon DECAP.

Loop Protect Not supported on VXLAN tunnel interfaces

MAC-TRAP

MAC-Count TRAP

This Mac-Trap, when configured on an interface, sends out a trap
when:
• MAC addresses are learned or aged-out on an interface.

• The number of MAC addresses on a port exceeds a certain
threshold.

MAC-Count TRAPs are not supported on VXLAN tunnels.

<Interface> Monitor Cannot monitor a VXLAN tunnel interface.

Table Continued
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Feature VXLAN impact

OpenFlow • OpenFLow sees VXLAN tunnels as logical interfaces and can
program outport rules for tunnels.

• OpenFlow cannot program in_port match rules on VXLAN tunnel
interfaces (similar to SI).

• OpenFlow lookups will be bypassed for packets ingressing VXLAN
tunnels.

Port Security Not supported on VXLAN tunnel interface.

QinQ Mutually exclusive.

QoS

Source VLAN
Source Port
UDP
TCP
device
protocol

Encap

When QoS rules are configured, traffic matching QoS rules and will
be prioritized and tunnelled into the underlay.

The VLAN priority and DSCP is mapped to the outer header.

Decap

Traffic entering a tunnel (i.e. payload) and matching QoS rules will
be prioritized upon decapsulation and forwarded out appropriately.

QOS remark policy (PCP/
DSCP)

Encap

Traffic matching QoS remark rules will have their DSCP remarked
and re-prioritized before being tunneled into the underlay.

Decap

Traffic coming in on a tunnel (i.e. payload) and matching QoS
remark rules (VLAN based) will be remarked and re-prioritized
upon decapsulation and forwarded out appropriately.

QoS rate-limit policy
Interface rate-limit

Encap

If a rate-limit policy (port/VLAN based) is applied to traffic destined
to a tunnel interface, it will be enforced before the traffic is
encapsulated.

Decap

If a rate-limit policy (VLAN based) is applied to (payload) traffic
coming in on a tunnel interface, it will be enforced upon ingress on
the loopback port (after decapsulation).

Not supported on VXLAN interfaces.

SFLOW Cannot configure SFLOW (sampling/polling) on tunnel interfaces and
loopback ports. If a packet destined to a tunnel has been sampled, the
outport field in the SFLOW header will be the tunnel resolved uplink
port.

Table Continued
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Feature VXLAN impact

Smart-Link Cannot be configured on tunnel interfaces.

However Smart-Link can be used to achieve VTEP redundancy. To
ensure that downlink traffic is not disrupted when a VTEP goes down
and the downlink switch’s Slave Port becomes Active, Smart-Link
flush messages will be allowed to traverse the L3 fabric and it will wipe
out MAC table entries on tunnel interfaces for the protected VLANs. It
will also clear the ARP entries pointing to Tunnel entries on the
VTEPs. Per-port recv-control-vlan restriction is not applicable to Flush
packets received on Tunnel Interfaces as they are trusted, any filtering
can always be done on external facing ports.

STP Does not run on tunnel interfaces and loopback ports. This implies that
STP cannot detect loops if any among switches that are connected via
VXLAN tunnels and also directly connected among them.

It is important that only one device as the VTEP for a VLAN in a
network where multiple devices can function as VTEPs for the same
VLAN.

STP Topology Change message does not have to flush MAC
addresses learned on tunnel interfaces as a TC on one segment does
not impact the MAC learns of another segment.

When a device that is STP disabled receives BPDUs, it floods to all
ports of the VLAN. This can result in BPDUs being tunneled to the
remote side as well. The loopback port of the remote end will quench
the packet and not process it.

Static MAC Not supported on VXLAN tunnel interfaces.

UFD Not supported on VXLAN tunnel interfaces.

<Interface> IPv4/v6 ACLs Not supported on VXLAN tunnels and loopback ports (stolen and
internal).

<Interface> IP Source-
Lockdown

Not configurable on VXLAN tunnel and loopback interfaces (stolen
and internal).

<Interface> admin-status Not configurable on VXLAN tunnel interface.

IP Source Binding IP source binding entries cannot be configured on VXLAN tunnel
interfaces and loopback ports (stolen/internal).

<VLAN> RIP, OSPF, BGP Cannot be enabled on overlay VLANs. BGP is not supported on WC.
16.02.

<VLAN> IRDP Cannot be enabled on overlay VLANs.

<VLAN> IGMP (Router) Cannot be enabled on overlay VLANs.

<VLAN> IGMP Proxy Cannot be enabled on overlay VLANs.

<VLAN> UDP Broadcast
Forwarder

Supported on overlay VLANs.

<Interface> QoS Not supported on tunnel and loopback interfaces (stolen/internal).

IPv4 unicast Routing Supported. Can route traffic into a tunnel and route traffic coming out
of a tunnel.

Table Continued
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Feature VXLAN impact

IPv6 unicast Routing Not supported.

<VLAN> MLD Not supported as overlays are IPv4 only.

<VLAN> ND<VLAN> RA Not supported as overlays are IPv4 only.Not supported as overlays
are IPv4 only.

<VLAN> IPv6 Not supported as overlays are IPv4 only

<VLAN> OSPF3 Cannot be enabled on overlay VLANs.

OpenFlow interaction
The OpenFlow features supported on VXLAN tunnel interfaces are listed in the following table. For more
information about OpenFlow, see the OpenFlow Administrators Guide.

IS IS-NOT

OpenFlow agent on the switch will
communicate VXLAN tunnel virtual port add/
remove notifications to the controller.

Cannot add multiple VXLAN tunnel interfaces as part of
multi-port action.

Tunnel virtual port up/down notifications will be
communicated to the controller.

Cannot group VXLAN tunnels and physical ports as part
of multi-port action.

Tunnel virtual port counters (TX/RX packets)
will be supported via OpenFlow multipart
message.

Cannot group outport “Tunnel” action with outport
“Normal” or outport “SendToController” actions.

In OpenFlow virtualized mode, only OpenFlow
version1.3 instances of the Overlay VLAN will
advertise VXLAN virtual ports to the controller.

Cannot group outport “Tunnel” action with Strip VLAN,
Modify VLAN, Modify MAC actions.

The VNI corresponding to the Overlay VLAN
needs to be associated with the VXLAN tunnel
for it to be advertised as a member interface of
that instance.

Cannot support re-directing PKTs to VXLAN tunnels on
an OpenFlow v1.0 instance. Tunnels will only be
supported on OpenFlow v1.3 instances.

In OpenFlow aggregate mode, an OpenFlow
rule that has a VXLAN tunnel as an outport will
be allowed only if the in_vlan is an overlay
VLAN and its VNI is associated with the
VXLAN tunnel.

The solution does not support OpenFlow lookup on
frames coming in on a VXLAN tunnel. These PKTs will
be forwarded as “normal” using the switch L2/L3
forwarding table entries.

OpenFlow meters can be attached to rules that
point to tunnels as output ports and metering
action will work as designed.

When tunnel interfaces are deleted by the administrator
and there are OpenFlow rules that are pointing to those
tunnels, the switch will not automatically remove flows
associated with the tunnel ports. The controller has to
delete those flows explicitly.

VXLAN tunnel interfaces will be part of an
OpenFlow VLAN FLOOD action.

The send-to-tunnel outport action would be supported
only on the Policy Engine (TCAM) tables and not on the
OpenFlow software tables.

Table Continued
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IS IS-NOT

OpenFlow modify VLAN PCP/IP DSCP action
will be supported with tunnel as output port.
This action will modify the payload’s DSCP
field before it’s encapsulated.

OpenFlow Port MOD requests will not be supported on
tunnel ports.

PKT_OUT action will be supported on tunnel
port.

Tunnel Port cannot be used as a match field
(IN_PORT).

All controllers connected to an OpenFlow
instance running version 1.3 will receive the
tunnel notifications irrespective of their roles
(master/slave/equal).

If IP routing is enabled on the device and there
is frame that the ASIC is L3 forwarding,
OpenFlow rule that matches this frame with an
outport of a VXLAN tunnel will encapsulate the
IP routed version of the frame (MAC, VLAN
and TTL fields modified). If ASIC punts this
frame to software for an L3 table lookup miss,
software should forward IP routed version of
the frame to the tunnel after destination is
resolved.

VXLAN tunnels are HA synced to the SMM
and will continue to function after a failover.
OpenFlow rules that are pointing to VXLAN
tunnels will continue to forward frames to
tunnels even after an HA failover.

Coexistence with SI — If an L2/L3 lookup for a
frame points to a VXLAN tunnel it is possible to
deflect this frame to an SI tunnel via an
OpenFlow rule. Upon receiving this frame back
on the SI tunnel (Sentinel validated), an L2/L3
re-lookup will result in the frame being sent out
via the VXLAN tunnel interface. Note that
frames coming in on tunnel interfaces (SI and
VXLAN) will bypass OpenFlow lookups.
OpenFlow redirect to VXLAN tunnels will not
disturb the copy-CPU flags that are also set for
the frame. This is so that OpenFlow/VXLAN
can work in hybrid network set ups where
other features like port-sec, sflow etc. are
enabled along with OpenFlow.

OpenFlow redirect to VXLAN tunnels will not
override a drop action set by some other
lookup in the system. If OpenFlow action
conflicts with a device feature’s action (OF
action is FWD and Feature XYZ’s action is
COPY/DROP), both actions will fail.
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Configuration procedures
The following are the basic configuration procedures used to set up VXLAN traffic.

Procedure

1. Prepare the underlay for VXLAN traffic.

VXLAN uses a UDP tunnel to send L2 traffic over an L3 network. Any transport associated with VXLAN UDP
packet is known as the underlay.

2. Configure Jumbo MTU on the underlay VLANs between Virtual Tunnel Endpoints (VTEPs).

VTEPs are the termination point of UDP VXLAN tunnels.

3. When using different priorities on any overlay VLAN traffic, configure IP Differentiated Service (DSCP) QOS on
all underlay VLANs between VTEPs.

The L2 networks identified by the virtual network identifier (VNI) can also be referenced as the overlay
networks.

4. Enable VXLAN at the switch.

5. Create the overlay VLAN and the Virtual IP network (if the device is an IP gateway).

6. Create a virtual network instance and associate the instance with the overlay VLAN created in step-1.

7. Repeat the same steps for any of the other access devices that are part of the overlay.

8. Create VXLAN tunnels on each access device to the other access switches that are part of the overlay.

9. Depending on which overlay VLANs are configured on each access switch, configure the VN-Tunnel mapping.

This mapping basically instructs the device to carry the VN’s traffic on that tunnel.

VXLAN configuration commands
VXLAN configuration commands include commands to enable and disable a VXLAN, configuring destination UDP
port number, creating and setting the mode of a VXLAN tunnel, setting the source and destination of a VXLAN
tunnel, and binding the VNI to a VLAN.

Enabling VXLAN
Syntax

vxlan enable
Description

Enable creation of VXLAN tunnels.

Disable VXLAN
Syntax

vxlan disable
Description

Disable VXLAN tunnels.
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Configuring destination UDP port number
Syntax

vxlan udp PORT-NUM
Description

Configure destination UDP port for VXLAN tunnels. The no form of the command will set it back to its default
value of 4789.

Options

udp

Configure destination UDP port for VXLAN tunnels.

<1-65535>

Enter the UDP port number. Default value: 4789.

Creating a VXLAN tunnel
Syntax

interface tunnel TUNNEL-ID
Description

Create or enter a tunnel context.

Options

<1-128>

Enter an integer number for the tunnel ID.

Set the mode of a VXLAN tunnel
Syntax

tunnel mode unspecified|6in4|vxlan
Description

Specify the tunnel mode.

Options

unspecified

Set an unspecifiedtunnel

6in4

Set an IPv6-in-IPv4 tunnel.

VXLAN

Set an MAC-in-UDP tunnel.
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Set the source of a VXLAN tunnel
Syntax

tunnel source IP-ADDR
Description

Configure the local (source) IP address for the tunnel.

Options

IP-ADDR

The tunnel source IP address.

Set the destination of a VXLAN tunnel
Syntax

tunnel destination IP-ADDR
Description

Configure the destination IP address for the tunnel.

Options

IP-ADDR

The tunnel destination IP address.

Bind the VNI to a VLAN
Syntax

virtual-network VN-ID VLAN-ID VN-NAME
Description

Configure a virtual network.

Options

<1-16777215>

Specify the virtual network identifier.

VLAN-ID

Specify the VLAN to be mapped to the virtual network.

VN-NAME-STR

Set the virtual network name.

Configure a virtual network

Switch(config)# virtual-network 1 2 Virtual-Network1
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Map overlay VLANs to VXLAN tunnel
Syntax

vxlan tunnel TUNNEL-ID overlay-vlan VLAN-ID-LIST
Description

Map the list of overlay VLANs to a VXLAN tunnel.

Options

<1-128>

Enter the VXLAN tunnel id.

overlay-vlan

Specify the list of overlay VLANs to be mapped to the VXLAN tunnel.

vlan VLAN-ID-LIST

Specify the list overlay VLANs.

Map overlay VLANs to VXLAN tunnel

Switch(config)# vxlan tunnel 1 overlay-vlan 1

VXLAN show commands
VXLAN show commands include commands to display the status of a VXLAN feature, tunnels, and tunnel
statistics.

Show command to display the status of VXLAN feature
Syntax

show VXLAN
Description

Show status of VXLAN tunnel feature.

Show VXLAN

switch# show vxlan
VXLAN Tunnel Information
----------------------------------------------------------------
Status               : Enabled
UDP Port             : 4789

switch# show vxlan
VXLAN Tunnel Information
----------------------------------------------------------------
Status                : Disabled
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Show commands to display tunnels
Syntax

show interfaces tunnel tunnel-list|tunnel-name|brief|type
Description

Show tunnel configuration and status information.

Options

brief

Display the configuration and status of all the tunnels.

tunnel-list

Display the configuration and status of the specified tunnel ID.

tunnel-name

Display the configuration and status of the tunnel specified.

type

Specify the Tunnel type.

Show interfaces tunnel

switch# show interfaces tunnel

Tunnel Configuration :

Tunnel                : tunnel-1
Tunnel Name           : VxLAN_T
Tunnel Status         : Enabled
Source Address        : 2.3.4.6
Destination Address   : 2.3.4.7
Mode                  : 6in4
TOS                   : -1
TTL                   : 64
IPv6                  : Disabled
MTU                   : 1280

Current Tunnel Status :
Tunnel State               : Up
Destination Address Route  : 2.3.4.0/24
Next Hop IP                : 2.3.4.7
Next Hop Interface         : vlan-50
Next Hop IP Link Status    : Up
Source Address             : Configured on vlan-50

Tunnel Configuration :

 Tunnel                : 100664146
 Tunnel Name           : ServiceTunnel01
Tunnel Status          : Enabled
Source Address         : 2.3.4.6
Destination Address    : 1.2.4.4
Mode                   : Service Tunnel
TOS                    : 0
TTL                    : 64
IPv6                   : n/a
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MTU                    : 1468

Current Tunnel Status :
Interface State             : Up
Destination Address Route   : 0.0.0.0/0
Next Hop IP                 : 120.92.82.129
Next Hop Interface          : vlan-1
Next Hop IP Link Status     : Up
Source Address              : 2.3.4.6

Tunnel Configuration :
Tunnel                 : 201327442
Tunnel Name            : VxLAN_Tunnel01
Tunnel Status          : Enabled
Source Address         : 10.0.0.1
Destination Address    : 10.0.0.2
Mode                   : VXLAN Tunnel
TOS                    : -1
TTL                    : 64
IPv6                   : n/a
MTU                    : 1460

Current Tunnel Status   :
Tunnel State            : Up
Destination Address Route : 10.0.0.0/8

Next Hop IP              : 10.0.0.2
Next Hop Interface       : vlan-20
Next Hop IP Link Status  : Up
Source Address           : 10.0.0.1

Tunnel Configuration :

Tunnel              : 201327443
Tunnel Name         : VxLAN_Tunnel02
Tunnel Status       : Enabled
Source Address      : 10.0.0.1
Destination Address : 11.0.0.2
Mode                : VXLAN Tunnel
TOS                 : -1
TTL                 : 64
IPv6                : n/a
MTU                 : 1280

Current Tunnel Status :

Tunnel State               : Down
Down Reason                : TEP Not Reachable
Destination Address Route  :
Next Hop IP                :
Next Hop Interface         :
Next Hop IP Link Status    :
Source Address             : 10.0.0.1

Show VXLAN tunnel statistics
Syntax

show interfaces tunnel type vxlan statistics tunnelifindex | tunnelname-str
Description
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Show the statistics of the VXLAN tunnels.

Options

tunnelifindex

Show statistics of the specified VXLAN tunnel ID.

tunnelname-str

Show statistics of the specified VXLAN tunnel.

Show statistics of the specified VXLAN tunnel ID

switch# show interfaces tunnel type vxlan statistic 201327443
Tunnel Name                                  : VxLAN_Tunnel02
Rx Packets                                   : 0
Tx Packets                                   : 0
Rx 5 Minute Weighted Average Rate (Pkts/sec) : 0
Tx 5 Minute Weighted Average Rate (Pkts/sec) : 0

Show interfaces tunnel type VXLAN statistics tunnelname

switch# show interfaces tunnel type vxlan statistics VxLAN_Tunnel02
Tunnel Index                                   : 201327443
Rx Packets                                     : 0
Tx Packets                                     : 0
Rx 5 Minute Weighted Average Rate (Pkts/sec)   : 0
Tx 5 Minute Weighted Average Rate (Pkts/sec)   : 0
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Introduction to BYOD-redirect
The BYOD (bring-your-own-device) feature lets you design, manage, and control a BYOD network when you
configure the BYOD-redirect feature on your switches.

Where BYOD-redirect is enabled on a switch, the device’s client credentials are sent to the BYOD server for
registration. The BYOD server stores the registration information for each client’s device (such as the device
MAC-address), which gives that client’s device access to the network.

The BYOD solution includes:

• secure user authentication

• centralized authentication process

• authorization and accounting

• unified monitoring and network management services

• ease-of-use self-registration (on-boarding) process

BYOD solution

The following figure illustrates a BYOD solution that includes the following:

• Access point and wireless controller: manages wireless SSIDs.

• BYOD (IMC) server: manages BYOD policy and centralized user management.

Chapter 12
BYOD-redirect
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• switches: redirects user registration traffic to IMC and grants access to ports.

• BYOD Redirect feature

Figure 42: BYOD solution

BYOD features
When BYOD-redirect is enabled on a VLAN, the BYOD feature intercepts HTTP traffic and blocks all other traffic
for which free rules are not enabled. Most BYOD-redirect implementation is platform independent, except
installing free rules to mitigate risks.

Communication between clients and the IMC server is tunneled by the edge switch:

1. A client request is read by the HTTP task.

2. The HTTP task always redirects, after embedding client IP addresses, a URL trying to access the redirected
URL.
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3. The redirect response includes URL parameters: user ip address and url user is trying to access.

4. The client receives a redirect response from the switch and makes an HTTP request to redirect the URL.

Figure 43: The BYOD-redirect function

Interoperability with other switch features
The following rules can help avoid conflicts when BYOD-redirect has been deployed on a switch with other
features:

1. MAFR and BYOD-redirect are mutually exclusive – MAFR (MAC Authentication Failure Redirect) and
BYOD-redirect solve similar problems.

2. DNS sentinel and BYOD-redirect – When a DNS sentinel is enabled, the switch tunnels packets to the
controller. Packets are re-injected to the switch only if the controller classifies DNS packets as permitted.
When BYOD-redirect is enabled, the user should configure an ACL rule to pass through DNS packets to the
switch. If SDN controller policy classifies a DNS packet originating from a client as drop, then BYOD-redirect
does not work.

3. IP sentinel and BYOD-redirect – When IP sentinel is enabled for the IP flows configured by the SDN
controller, the switch tunnels the IP packets to the controller. The IP packets are reinjected to the switch only if
the controller classifies the IP traffic as not malicious. If the SDN controller policy classifies the client’s IP traffic
as malicious, then BYOD-redirect fails.
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4. OpenFlow and BYOD-redirect – If an OpenFlow instance is enabled on a VLAN, then all traffic is given to the
OpenFlow packet processing task. BYOD-redirect requires intercepting IP (HTTP) packets. If BYOD-redirect
interoperates with OpenFlow, traffic should be copied to both OpenFlow and BYOD-redirect; otherwise, the
switch cannot enable BYOD-redirect and OpenFlow on the same VLAN.

5. Other TCAM rules – If any other user has configured TCAM rules that override TCAM entries installed for
BYOD-redirect, BYOD redirect does not work.

Interoperability with other vendors
Because BYOD policy integrates several logical components including MSM, UAM, and RADIUS, the redirected
URL in the BYOD-redirect feature on a switch must include the byod-server-url and user-ip information to
work with the IMC server.

Restrictions
BYOD-redirect has the following restrictions:

1. BYOD-redirect is a per-VLAN configuration; up to three VLANs can be enabled with BYOD-redirect.

2. BYOD-redirect supports up to three redirection servers configured on a switch. When a redirection server URL
is configured, the BYOD module maintains separate data structures to store the redirected URL on the VLAN
where BYOD-redirect is enabled. BYOD-redirect statistics are maintained for each server.

Configuring BYOD
Creating a BYOD server
Configure a portal redirect web-server.

Syntax

no portal web-server [web-server-name] url [url-string]
portal: Configure the BYOD redirect feature.

web-server: Configure portal redirect web-server.

web-server-name: Specify the BYOD web-server name in ASCII.

url: Configure the URL of the BYOD server.

url-string : A URL redirecting the client to the BYOD server must be in ASCII.

Associating a BYOD server
Associate a BYOD server with a specific VLAN to redirect clients to the assigned URL page.

Syntax

no vlan [vlan-id] <portal web-server [web-server-name]>
vlan: Add, delete, edit VLAN configuration, or enter a VLAN context.

vlan-id: VLAN identifier or VLAN name.

portal: Configure the BYOD redirect feature on a VLAN.

web-server: Specify the BYOD web-server.
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web-server-name: BYOD web-server name in ASCII.

Creating a BYOD ACL rule
Configure a BYOD-free rule.

Syntax

no portal free-rule [rule-number] vlan [VLAN-ID] destination <<ip-address> | mask 
<mask-length> | any tcp <des-tcp-port> | udp <des-udp-port> | source <ip-address> 
| mask <mask-length> | any tcp <src-tcp-port> |udp <src-udp-port>>

Term Meaning

portal Configure the BYOD redirect feature.

free-rule Configure a BYOD-free rule.

rule-number Free rule number as an INTEGER<1-6>.

vlan Free rule source VLAN ID.

VLAN-ID VLAN identifier or VLAN name.

destination Free rule destination.

ip-address IP address

mask Mask

mask-length Mask length.

tcp TCP protocol

udp UDP Protocol

des-udp-port tcp port destination

source Free rule source.

<src/des-tcp/udp-port> TCP or UDP port number, as an integer<1-65534>.

any Free rule source any.

ip Free rule source IP.

IP Free rule destination IP.

any Free rule source or destination any.

Implementing BYOD-redirect configuration
BYOD enables employees to register and access corporate resources with personally-owned devices. Though
BYOD provides flexibility to employees, it can bring challenges to IT departments. BYOD-redirect is designed to
help manage and control personal devices and policies at the enterprise network level.
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Before implementing BYOD-redirect ensure that:

• BYOD-redirect is configured on a VLAN.

• BYOD-redirect is supported on up to three VLANs.

• BYOD-redirect is supported with Mac and 802.1X authentications.

• BYOD-redirect works with IMC 7.0 UAM module.

• The client URL and DHCP IP are included in the Redirect URL to the IMC.

NOTE:

Until the registration process has been completed, a client device cannot access the internet or the
enterprise network. Any traffic from this unauthorized device is redirected to the BYOD server.

Implementing BYOD-redirect configuration examples
The following examples show how to implement BYOD-redirect for both wired and wireless solutions.

BYOD configuration on a distribution switch

To facilitate the BYOD-redirect function, complete the following tasks on the distribution switch:

1. Configure DNS and make FQDN solution successful: ip dns server-address priority 1 <DNS-
server-IP>.

NOTE: The argument to the URL can be an FQDN or IP address. If you use the IP address as an
argument, this step is not necessary.

2. Configure BYOD web-server URL: portal web-server "byod" url http://imc.com:8080/byod.

3. Enable BYOD-redirect on a VLAN: vlan 101 portal web-server "byod."

4. Configure BYOD-redirect free-rules on the on-boarding VLAN 101 to permit client traffic transit through DNS
and DHCP servers using the following commands.To permit DNS traffic to/from a DNS server to a client
through on-boarding VLAN:

a. portal free-rule 1 vlan 101 source any udp 0 destination any udp 53
b. portal free-rule 2 vlan 101 source any udp 53 destination any udp 0

To permit DHCP traffic to/from DHCP server to client through on-boarding VLAN:

a. portal free-rule 3 vlan 101 source any udp 68 destination any udp 67
b. portal free-rule 4 vlan 101 source any udp 67 destination any udp 68

5. Register the device in IMC on the on-boarding VLAN. When registration is successful, client traffic is placed
into different VLAN (guest/corporate) configurations.

Client authentication configuration on edge switch

Enable MAC authentication on edge switch port 1-2 using the following commands:

• # enable mac authentication on ports 1-2
• aaa port-access mac-based 1-2
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• # configure number of client limits on port 1 and port2
• aaa port-access mac-based 1 addr-limit 32
• aaa port-access mac-based 2 addr-limit 32
• radius-server host <radius ip> dyn-authorization
• radius-server host <radius ip> time-window 0
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Table 23: Wired and wireless components configured in a network topology

Access Type Edge Switch Distribution Switch Configuration ProcedureNote

Wired Access Edge switch (for example
2530)

5400 switch 1. Register the edge switch in HPE
IMC.

2. Create the configuration on the
edge switch.

3. Create the configuration on 5400
switch.

Wireless Access 1. Make the HPE MSM controller
reachable by IMC.

2. Ensure that access points (HPE
422) are managed by the MSM
controller.

3. Configure MAC or 802.1X
authentication on the MSM
controller.

4. Create the configuration on the
5400 switch.

Figure 44: Wired and wireless components configured in a network topology
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Table 24: Wired clients solution

Access Type Edge Switch Distribution
Switch

Configuration Procedure

Wired Access Edge switch (for
example 2530)

Switch 3810 1. Register the edge switch and distribution
switch in IMC.

2. Ensure that both the edge and distribution
switch can reach the DHCP and DNS server.

3. Create the configuration on the edge switch.

4. Create the configuration on the distribution
switch.

Figure 45: Wired clients solution
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Table 25: Configuration and access for wired clients on an edge switch

Access Type Edge Switch Distribution Switch Configuration Procedure

Wired Access Edge switch (for
example 3500)

N/A 1. Register the edge switch in IMC.

2. Ensure that the edge switch is
reachable by the DHCP and DNS
server.

3. Create the configuration on the edge
switch.

4. Create the configuration on the edge
switch.

Figure 46: Configuration and access for wired clients on an edge switch

Show commands

Show portal server
Display all BYOD servers and their attributes or specify a BYOD web-server-name to display its details.

Syntax

show portal web-server [web-server-name]
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Term Meaning

portal Display BYOD server details..

web-server Specify the BYOD web-server.

web-server name Enter BYOD web-server name in ASCII.

Sample output

Portal Server:
1)imc:
Resolved IP      : 15.146.197.224
VPN Instance     : n/a
URL              : http://15.146.197.224:80/byod
VLAN             : 101
DNS Cache Status : 20 seconds

Show portal redirect statistics
Show redirect statistics of a BYOD.

Syntax

show portal redirect statistics

Term Meaning

portal Display BYOD server details.

redirect Display redirect statistics

statistics Display the statistics.

Sample output

show portal redirect statistics
Status and Counters - Portal Redirect Information
Total Opens           : 0
Resets Connections    : 0
Current Opens         : 0
Packets Received      : 14997
Packets Sent          : 12013
HTTP Packets Sent     : 3002
Current Connection States :
SYN_RECVD     : 0
ESTABLISHED   : 0

Show portal free rule
Display all BYOD free rules and their attributes; the user can specify a BYOD rule to display its free rule.

Syntax

show portal free-rule [free-rule-number]
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Term Meaning

portal Display BYOD server details.

free-rule Display BYOD-free rule.

free-rule-number Free rule number as an integer <0-50>.

Sample output

Rule-Number  : 2
Vlan         : 0
Source:
Protocol  : UDP
Port      : 12345
IP        : 0.0.0.0
Mask      : 0.0.0.0
MAC       : n/a
Interface : n/a
Destination:
Protocol  : UDP
Port      : 123
IP        : 0.0.0.0
Mask      : 0.0.0.0

Associating with the BYOD server on a specified VLAN
Associate a BYOD server with a specific VLAN to redirect clients to the assigned URL page.

Syntax

no vlan <VLAN-ID > [portal web-server < web-server-name>]

Term Meaning

portal Configure the BYOD redirect feature on the VLAN.

web-server Specify the BYOD web-server.

ASCII-STR BYOD web server name.

vlan Add, delete, edit VLAN configuration, or enter a VLAN
context.

VLAN-ID Enter a VLAN identifier or a VLAN name.
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NOTE: All commands previously in the Summary of commands table are indexed under the entry
Command syntax.

Introduction to QinQ
This chapter describes how to enable QinQ operations on the switch and how to configure provider bridge S-
VLANs and port assignments.

The IEEE 802.1ad specification, commonly known as QinQ or provider bridging, extends the IEEE 802.1Q
standard by providing for a second tier of VLANs in a bridged network. The general purpose of QinQ is to allow
frames from multiple customers to be forwarded (or tunneled) through another topology (provider network) using
service VLANs or S-VLANs. The provider bridge, which may comprise multiple devices in the service provider
domain, looks like a simple bridge port to the customer's traffic and maintains the customer's VLANs.

The following diagram shows a sample QinQ topology and use model. Customer A has LANs spread across
multiple site locations and may want to link them together in a single logical LAN. To do this, the customer could
have a cable laid out for the entire distance interconnecting the three sites. A more cost-effective and scalable
alternative, however, would be to tunnel frames through the provider's network to interconnect all the sites
subscribing to the service. This solution can be delivered using QinQ.

Figure 47: QinQ network diagram

NOTE: The Service Provider and customers may belong to the same business entity, as in the case
where a single enterprise uses QinQ to help segregate local networks and increase the scalability of
their backbone infrastructure.

Chapter 13
QinQ (Provider bridging)
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How QinQ works
Under QinQ, the provider network operates on a different VLAN space, independent of the VLANs that are used
in the customer network.

Figure 48: VLANs in a QinQ configuration

Customer VLANs (referred to as C-VLANs by the IEEE 802.1ad specification) are not used to make any
forwarding decisions inside the provider network where customer frames get assigned to service VLANs (S-
VLANs). Inside the provider cloud, frames are forwarded based on the S-VLAN tag only, while the C-VLAN tag
remains shielded during data transmission. The S-VLAN tag is removed when the frame exits the provider
network, restoring the original customer frame.

Features and benefits

• Increases the VLAN space in a provider network or enterprise backbone.

• Reduces the number of VLANs that a provider needs to support within the provider network for the same
number of customers.

• Enables customers to plan their own VLAN IDs, without running into conflicts with service provider VLAN IDs.

• Provides a simple Layer 2VPN solution for small-sized MANs (Metropolitan Area Networks) or intranets.

• Provides for customer traffic isolation at Layer 2 within a Service Provider network.

Configuring QinQ
QinQ must be configured on all the devices and ports participating in the provider bridge. Typically, customer
facing ports are configured as untagged members of S-VLANs and provider facing ports are configured as tagged
members of S-VLANs. Per the IEEE 802.1ad specification, there is no condition binding port types (customer or
provider) to untagged or tagged S-VLAN memberships. Therefore, when configuring QinQ tunnelling on the
switch, you would first configure per-port S-VLAN membership (tagged or untagged), and then configure the port
type as customer-network or provider-network, depending on the device to which the switch port is
connected.

NOTE: A customer-network port can receive S-VLAN tagged frames if the customer and provider
agree on the S-VID association for that customer and the customer device is capable of sending S-
VLAN tagged frames. Configuring QinQ with S-VLANs in a switch stack is not supported. For more
information, see Effects of QinQ on other switch features on page 349.

To configure QinQ take the following steps on all participating provider switches:
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Procedure

1. Enable QinQ on the device, selecting the appropriate QinQ mode (S-VLAN or mixed VLAN mode).

2. Save the configuration and reboot the switch.

3. Configure S-VLANs and assign per port VLAN membership.

4. Configure port-types for all of the switch ports that carry QinQ traffic across the network.

5. (Optional) Assign priorities to traffic passing through the provider network.

CAUTION: A reboot is required to enable/disable QinQ operations on the switch. When moving
between QinQ modes (qinq mixedvlan to qinq svlan or vice versa), the switch boots up with a
default configuration for the new qinq mode and the configuration parameters of the current mode
will be erased.

QinQ Configuration example
This configuration example uses four switches to establish a QinQ tunnel through the provider network.

Figure 49: QinQ configuration example

The design parameters are as follows:

• The provider edge bridge and the provider core bridge are configured in svlan mode.

• Each customer is associated with a single S-VLAN connecting two separate sites: customer A's VLANs (C-
VLANs 1-10) are associated with S-VLAN 100; and customer B's VLANs (C-VLANs 1-20) are associated with
S-VLAN 200.
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NOTE:

• The VLANs of customers A and B can overlap: this will not result in intermixing of customer
frames in the provider cloud because the S-VLANs associated with each customer are different.

• Core devices are not mandatory to establish a QinQ tunnel. For example, two edge-bridges can
be connected directly to create a provider bridge network.

• The relationship between S-VLANs and C-VIDs is typically one to many. An alternative
configuration might associate a single customer's C-VIDs with more than one S-VLAN. Such a
configuration would most likely be used to tunnel distinct C-VIDs through various S-VLANs, but
seldom be used to send the same C-VID through multiple S-VLANs.

Figure 50: Configuration example: Edge Switch 1

At the end of the configuration, the following settings will apply:

• All customer A site traffic received on port A1 will be associated with S-VLAN 100. This is independent of the
C-VLAN tag information that the customer frames may carry.

• All customer B Site 1 traffic will be associated with S-VLAN 200 and be switched out to the core (uplinks A3,
A4) with the S-VLAN tag-id of 200.

• The frame size will increase by 4 since ports A3 and A4 are tagged members of S-VLAN 100 and 200.

To configure the switch, follow these steps:

Procedure

1. Enable QinQ:

Edgel(config)# qinq svlan tag-type 88a8
2. Reboot the box with the configuration saved to transfer into svlan bridge mode.

NOTE: A reboot is required for the QinQ enable command to take effect.

3. Configure S-VLANs and ports connected to the customer network.

Edge1(config)# svlan 100
Edge1(svlan-100)# untagged A1
Edge1(svlan-100)# exit
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Edge1(config)# int A1 qinq port-type customer-network
Edge1(config)# svlan 200
Edge1(svlan-200)# untagged A2
Edge1(svlan-200)# exit
Edge1(config)# int A2 qinq port-type customer-network

NOTE: Customer A is assigned S-VLAN 100 and customer B is assigned S-VLAN 200. However,
the same customer can be associated with more than one SVLAN. Also, interfaces A1 and A2 are
configured as customer network ports because they are linked to customer bridges.

4. Configure the provider ports leading to the core of the provider network.

Edge1(config)# svlan 100 tagged A3, A4
Edge1(config)# svlan 200 tagged A3, A4
Edge1(config)# interface A3,A4 qinq port-type provider-network

NOTE: As recommended by IEEE 802.1ad specification, uplink ports should generally be
configured as tagged ports for S-VLANs that are used to carry customer traffic. However, this is
not a mandatory requirement on switches—S-VLANs that are used for internal provider network
use (not carrying customer traffic but for management of the provider network devices) can have
untagged port memberships.

QinQ Configuration example: provider Edge 2 switch
The configuration details for the Edge 2 switch mirrors the configuration for the Edge 1 switch. All customer traffic
received on port A1 from customer A's site 2 will be associated with S-VLAN 100. Similarly, all customer B's site 2
traffic will be associated with S-VLAN 200.

To configure the switch, follow these steps:

Procedure

1. Enable QinQ:

Edge 2(config)# qinq svlan tag-type 88a8
2. Reboot the box with the configuration saved to transfer into S-VLAN bridge mode.

3. Configure S-VLANs and customer ports connected to the customer network.

Edge2(config)# svlan 100
Edge2(svlan-100)# untagged A1
Edge2(svlan-100)# exit
Edge2(config)# int A1 qinq port-type customer-network
Edge2(config)# svlan 200
Edge2(svlan-200)# untagged A2
Edge2(svlan-200)# exit
Edge2(config)# int A2 qinq port-type customer-network

4. Configure the provider ports leading to the core of the provider network.

Edge1(config)# svlan 100 tagged A3, A4
Edge1(config)# svlan 200 tagged A3, A4
Edge1(config)# interface A3,A4 qinq port-type provider-network
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Configuring example: provider core 1 switch
Figure 51: Configuration example: Core 1 Switch

To configure the Core 1 switch:

Procedure

1. Enable QinQ:

Core l(config)# qinq svlan tag-type 88a8
2. Reboot the box with the configuration saved to transfer into svlan bridge mode.

3. Configure S-VLANs and port assignments.

Core 1(config)# svlan 100
Core 1(svlan-100)# tagged A1, A2
Core 1(svlan-100)# exit
Core 1(config)# svlan 200
Core 1(svlan-200)# tagged A1, A2
Core 1(svlan-200)# exit
Core 1(config)#: interface A1,A2 qinq port-type provider-network

NOTE: The S-VLAN configuration for the core devices is based on what VLANs the edge devices
(Edge 1 and 2) can send. Per the 802.1ad specification, all ports carrying customer traffic will be
tagged on the VLAN that the port carries customer frames on.

To configure the Core 2 switch:

1. Enable QinQ:

Core 2(config)# qinq svlan tag-type 88a8

2. Reboot the box with the configuration saved to transfer into svlan bridge mode.

3. Configure S-VLANs and port assignments.

Core 2(config)# svlan 100
Core 2(svlan-100)# tagged A1, A2
Core 2(svlan-100)# exit
Core 2(config)# svlan 200
Core 2(svlan-100)# tagged A1, A2
Core 2(svlan-100)# exit
Core 2(config)# interface A1,A2 qinq port-type provider-network
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Verifying the configuration
After the edge and core switch configurations are completed, QinQ operations can begin. To verify operations, it
should be possible to assign IP-addresses to customer A or B devices in site 1 and site 2 and ping them. If
everything has been configured correctly, traffic will flow through the provider network cloud and reach the other
site seamlessly.

Enabling QinQ
By default, QinQ is disabled on the switch. To enable QinQ, the switch must be put into either in mixed VLAN
mode or QinQ SVLAN mode by issuing one of the following commands from configuration mode on the CLI.

Syntax:

qinq mixedvlan tag-type [tpid]
From configuration mode, globally enables QinQ mixed mode, an environment that supports both S-VLAN and C-
VLAN traffic on the same device. This command requires a reboot to take effect. Default: Disabled.

Syntax:

qinq svlan tag-type [tpid]
From configuration mode, globally enables QinQ SVLAN mode, an S-VLAN only environment that supports port-
based or s-tagged interfaces of the standard. Requires a reboot to take effect. Default: Disabled.

Setting up S-VLANs
S-VLANs are created via the CLI using the svlan vid command.

Syntax:

svlan {vid | ascii-name-string}

no svlan vid
If vid does not exist in the switch, this command creates a port-based S-VLAN with the specified vid . If the
command does not include options, the CLI moves to the newly created S-VLAN context. If you do not specify an
optional name, the switch assigns a name in the default format: svlan where n is the vid assigned to the S-
VLAN. If the S-VLAN already exists and you enter either the vid or the ascii-name-string, the CLI moves to
the specified S-VLAN's context.

The no form of the command deletes the S-VLAN as follows:

If one or more ports belong only to the S-VLAN to be deleted, the CLI notifies you that these ports will be moved
to the default VLAN and prompts you to continue the deletion. For member ports that also belong to another S-
VLAN, there is no move prompt.

NOTE: When QinQ is disabled, all VLANs must be C-VLANs. When QinQ is enabled in SVLAN
mode, all VLANs must be S-VLANs. When QinQ is enabled in mixed VLAN mode, VLANs can be
configured as either C-VLANs or S-VLANs.

Configuring per-port S-VLAN membership
The svlan vid command supports tagged and untagged options to configure per-port S-VLAN memberships.
Use these options from the configuration level by beginning the command with svlan vid , or from the context
level of the specific VLAN by entering the command option.
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Syntax:

svlan vid
tagged port-list

Configures the indicated ports as Tagged for the specified S-VLAN. The no version sets the ports to either No
or (if GVRP is enabled) to Auto.

untagged port-list
Configures the indicated ports as Untagged for the specified S-VLAN. The no version sets the ports to either
No or (if GVRP is enabled) to Auto

forbid port-list
Dynamic trunks cannot be involved as a part of any static configurations like forbid. Forbid can only be
applied on ports and static trunks .The forbid configuration can be applied to only PPORTS and Static
Trunks (Trk1….Trk144), and not to Dynamic LACP Trunks (Dyn1….Dyn144.)

The no version sets the ports to either no or (if GVRP is enabled) to Auto.

auto port-list
QinQ S-VLAN mode only. Available if GVRP is enabled on the switch. Returns the per-port settings for the
specified S-VLAN to Auto operation. Auto is the default per-port setting for a static VLAN if GVRP is running
on the switch.

NOTE:

Since provider-gvrp is not supported in a QinQ mixed VLAN mode environment, the forbid and
auto configurations are available only in QinQ S-VLAN mode.

You can set forbid mode for MVRP enabled ports.

Set MVRP forbid mode
switch(eth-A1)# forbid
vlan                  Prevent this port from becoming a member of the
                      specified VLAN(s).
switch(eth-A1)# forbid vlan
[vlan]VLAN-ID-LIST    Enter a list of VLAN identifiers or one VLAN identifier.
switch(eth-A1)# forbid vlan 100
switch# show mvrp state 100

Configuration and Status - MVRP state for VLAN 100

Port     VLAN  Registrar Applicant Forbid
                State     State     Mode
-------- ----- --------- --------- ---------
A1       100    MT        AA        Yes

In QinQ mixed VLAN mode
An interface (port or trunk) must be explicitly GVRP-disabled before it can be assigned to the S-VLAN space.
When you first attempt to configure a port as tagged for an S-VLAN, the CLI will issue a message disallowing the
configuration.

config# svlan 200 tagged a1,a2 GVRP enabled ports cannot be members of svlans. 
Disable the interface level gvrp configuration.
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To disable GVRP at the interface, issue the following command:

config# interface a1,a2 unknown-vlans disable
When you configure the port, the CLI will issue a warning prompt:

config# svlan 200 tagged a1,a2 Ports a1, a2 will lose their cvlan memberships if any
Do you want to continue? [y/n] 
Press Y to continue and automatically configure both ports as port-type provider-network (the default for all
S-VLAN member ports).

Configuring port-types
When QinQ is enabled on the switch all S-VLAN member ports must be categorized as either port-type
customer-network or provider-network (See an example below).

Figure 52: Customer or provider ports in the provider network

All ports of a QinQ-enabled device default to provider-network. Any ports participating in the provider bridge
used to connect to customer equipment must be manually configured as port-type customer-network. In a
mixed mode device, ports that are members of C-VLANs and that do not participate in the provider-bridge cannot
be configured to any port-type.

The following command allows you to configure the appropriate port-type.

Syntax:

no interface {[port-list] | Trkx} qinq port-type {customer-network | provider-network}
Configures the specified ports/trunks as a customer network port or provider network port.

Default: port-type provider (for QinQ S-VLAN mode)

Disabling QinQ
To disable QinQ once it has been enabled, issue the following commands from configuration mode on the CLI.

Syntax:

no qinq
This is the default mode when QinQ is disabled on the switch.
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Moving into this configuration from another QinQ configuration requires a reboot to take effect. Upon reboot, all
configuration information for the prior QinQ mode will be lost.

Default setting. Standard VLAN operations apply.

Changing VLAN port memberships (mixed VLAN mode)
On mixed VLAN mode devices, certain per-port features are not supported on S-VLANs that are supported on C-
VLANs. Ports that are currently members of a regular VLAN can move to an S-VLAN only if there is no conflicting
configuration.

NOTE:

To avoid a misconfiguration, HPE recommends that you use a default interface configuration when
moving ports between C-VLANs and S-VLANs.

When configuring S-VLAN port memberships using the svlan command, the CLI issues a warning and prompt if
any of the ports listed already belong to a regular VLAN. For example:

switch(config)# svlan 200 tagged a1,a2
Ports a1, a2 will lose their cvlan memberships if any.
Do you want to continue: y/n?
The warning prompt is displayed only when there is at least one port in the port list that needs to be moved out
from the C-VLAN space to the S-VLAN domain. Similarly, if ports being added to the C-VLAN are already
members of an S-VLAN, the CLI issues a warning that the port's membership with its existing VLANs will be
removed and will prompt for a confirmation before continuing.

If all ports are just being added or removed from within the same VLAN type domain, no prompt will appear. For
example, moving ports from S-VLAN 200 to S-VLAN 300, will not result in any warning as the ports are already
part of the S-VLAN domain.

Moving ports between C-VLANs and S-VLANs (mixed
VLAN mode)
A port (or trunk) that is a member of C-VLANs cannot be moved into the S-VLAN space with conflicting
configurations for the S-VLAN mode. The following is a list of conflicting protocols/features. If a port has any of
these enabled, the feature must be disabled before the port can be moved in to the S-VLAN space.

• An interface has to beGVRP-disabled to move it from the C-VLAN to the S-VLAN space. This is because S-
VLANs of mixed VLAN mode do not support provider-GVRP, and also because a GVRP-enabled configuration
(when the port is a C-VLAN member) is in the context of customer-GVRP which must be disabled before the
port can operate in the S-VLAN space.

• Interface should not have any mirroring or monitoring sessions when moving between C-VLANs and S-VLANs.
The configuration on all mirror/monitor sessions that involve the port must be removed.

• An interface that has auth-vid or unauth-vid configuration cannot move into the S-VLAN space. They have to
be unset.

• Interfaces cannot have LACP enabled (active or passive modes) when moving into the S-VLAN space. They
have be disabled.

Viewing QinQ configuration and status
This section outlines changes and additions to existing show command outputs to display QinQ configuration and
status.

The show qinq command displays QinQ configuration information.
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Syntax:

show qinq
Shows QinQ global and port configurations on the switch, including:

Bridge-mode

• cvlan bridge: QinQ is disabled, normal VLANs apply.

• mixedvlan bridge: Both S-VLANs and regular C-VLANs are available in a mixed VLAN mode environment.

• svlan: No regular VLAN commands are available. All VLANs configured on the switch are S-VLANs only.

Tag-id: Displays only if QinQ is enabled on the switch.

port-type: Displays only if QinQ is enabled on the switch. On a mixed mode device, port type is shown only for S-
VLAN ports.

Viewing show qinq output (QinQ S-VLAN mode)

switch(config)# show qinq

QinQ Global Configuration:
----------------------------------------------- 
Bridge-mode        : svlan bridge

QinQ Interface Configuration:
-------------------------------------------------- 
interface   port-type
---------   ----------
   A1       provider-network 
   A2       provider-network 
   Trk1     customer-network

Viewing a switch VLAN configuration
The following show commands are a subset of those listed in the chapter on Static Virtual LANs (VLANs)
highlighting the changes made to show the additional QinQ VLAN types (C-VLANs and S-VLANs).

The show vlans command lists the VLANs currently running in the switch, including the VID, VLAN name, and
VLAN status. Once QinQ is enabled in mixed VLAN mode, an additional field showing the VLAN type is added to
the display output.

Syntax:

show vlans
Changes to parameters when QinQ is enabled:

VLAN ID

Field name changes from 802.1Q VLAN ID to VLAN ID only.
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Type

In a QinQ mixed mode environment, the VLAN type can be either a regular customer VLAN CVLAN, or it can
be a tunnel VLAN in the provider network S-VLAN.

Figure 53: Viewing show vlans command output with QinQ disabled

Viewing the configuration for a particular VLAN
This command uses the VID to identify and display the data for a specific VLAN. Once QinQ is enabled in mixed
VLAN mode, an additional field showing the VLAN type is added to the display output.

Syntax:

show vlans vlan-id
Changes to parameters when QinQ is enabled:

VLAN ID

Field name changes from 802.1Q VLAN ID to VLAN ID only.
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Type

In a QinQ enabled environment, the VLAN type can be either a regular customer VLAN CVLAN, or it can be a
tunnel VLAN in the provider network S-VLAN.

Figure 54: Viewing show vlan output with QinQ enabled

Viewing the VLAN membership of one or more ports
This command shows to which VLAN a port belongs. Once QinQ is enabled, an additional field showing the VLAN
Type is added to the display output.

Syntax:

show vlans vlan-id
Changes to parameters when QinQ is enabled:

VLAN ID

Field name changes from 802.1Q VLAN ID to VLAN ID only.
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Type

In a QinQ enabled environment, the VLAN type can be either a regular customer VLAN CVLAN, or it can be a
tunnel VLAN in the provider network S-VLAN.

Figure 55: Viewing VLAN membership

Viewing spanning tree status
In QinQ mixed mode, only ports that are members of C-VLANs will be displayed in show spanning tree
output. This is due to the fact that ports that are members of S-VLANs do not participate in C-VLAN spanning tree
and will always be in forwarding state (treated as edge ports).

About QinQ
Operating rules and guidelines
This section provides an overview of QinQ operations and restrictions on the switch.

Enabling QinQ and configuring QinQ modes
By default, QinQ is disabled. When QinQ is enabled via the CLI, an operating mode is globally configured on the
switch. Two QinQ modes are supported:
qinq mixedvlan

C-VLANs and S-VLANs are both supported, with regular switching/routing based on C-VLAN tags in the C-
VLAN domain, while S-VLANs are used for QinQ tunneling through the provider network.

qinq svlan

C-VLANs are not supported on the device. All configured VLANs on the switch must be S-VLANs.

The following table shows how the various QinQ modes and operations impact VLAN configuration options on the
switch.
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Table 26: Relationship of QinQ operating modes to VLAN environments

QinQ Operation CLI Command VLAN Options

QinQ disabled

No QinQ
support(Default)

no qinq Only regular VLAN
commands are
available. If QinQ is
disabled, S-VLAN
commands are not
available.

QinQ enabled

QinQ mixed
VLANmode

qinq mixedvlan Both S-VLAN and
regular VLAN
commands (known as
C-VLANs in a mixed
vlan environment) are
available.

QinQ S-VLAN mode qinq svlan No regular VLAN
commands are
available. All VLANs
configured on the
switch are S-VLANs
only.

QinQ mixed VLAN mode
The QinQ mixed VLAN mode configuration supports both C-VLAN and S-VLAN operations on the same device.
This allows the use of S-VLAN member ports for QinQ tunneling, while regular ports can still do switching or
routing within the C-VLAN space. To tunnel customer frames through the provider network, you can externally
connect a regular port to a customer-network port, eliminating the need for a separate S-VLAN bridge device to
perform such operations. When configuring VLANs on a mixed VLAN mode device, a separate svlan vid
command is used to distinguish the S-VLAN type from regular VLANs.

The main advantage for QinQ mixed VLAN mode is that users do not have to dedicate the entire switch as a
QinQ access switch. For a high density chassis switch, customers can use regular ports for normal LAN
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switching, while S-VLAN member ports can be configured to access the QinQ provider network (see Figure 49:
QinQ configuration example on page 332). There are some additional restrictions in mixed-VLAN mode.

Figure 56: Switch in mixed-VLAN mode

Configuring VLANs
• A VLAN created on a QinQ mixed VLAN mode device can be either a regular VLAN (C-VLAN) or a tunnel

VLAN (S-VLAN). C-VLANs have no mapping/relation to the S-VLANs on the device.

• VLANs created on a QinQ S-VLAN mode device can be S-VLANs only. S-VLANs provide QinQ tunneling of
customer frames and behave like a port-based/s-tagged interface.

QinQ and duplicate VIDs
Duplicate VID's for c-tagged and s-tagged VLANs (for example, C-VID=100; S-VID=100) are allowed in certain
cases. Customer-network ports are essentially S-VLAN ports: they simply read the C-tags in the customer frame
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to insert them into the appropriate untagged S-VLAN for that port. Once this double-tagging occurs, frames are
forwarded based on the S-VLAN tag only, while the C-VLAN tag remains shielded during data transmission.

Figure 57: QinQ and duplicate VIDs: examples of allowed configurations

Assigning ports to VLANs
In mixed VLAN mode, a port can be a member of a C-VLAN or of an S-VLAN but not both.

Configuring port types
The IEEE 802.1ad standard requires that every S-VLAN member port be configured as either a provider-network
or as a customer-network port. In a typical deployment scenario, customer-network ports will be configured as
untagged members of S-VLANs while provider-network ports will be configured as tagged members of S-VLANs.
Note the following configuration rules and guidelines:

• All ports of a device that is QinQ enabled (in S-VLAN mode or mixed VLAN mode) are provider-network ports
by default—if there are any ports that connect to a customer device, they must be manually configured as
customer-network ports.

• Configuring a port-type is applicable only if the device is QinQ enabled and the port is a member of an S-
VLAN. In QinQ mixed mode, ports that are members of C-VLANs cannot be configured to any port-type.
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NOTE:

If a device running in QinQ S-VLAN mode has one or more customer-network ports, it is considered
to be a provider edge and not a provider core bridge. This may affect certain operations, such as
meshing, UDLD, and stacking. This is because at the edge of the provider network such proprietary
protocol are filtered out at customer network ports. This prevents the intermix of stacking meshing/
UDLD protocols in the customer and provider domains (since they use the same dst-mac address
in either domain).

Operating notes and restrictions
Cannot run concurrently with RPVST+

QinQ cannot run concurrently with RPVST+

Changing bridge modes requires a reboot

When changing the operating mode (to/from: QinQ S-VLAN mode, QinQ mixed VLAN mode, or QinQ
disabled), you will prompted to restart the system before the changes can take effect. Upon reboot, all
configuration information for the prior QinQ mode will be lost. Any configurations created will be erased, and
the device will boot up with a default configuration for the new QinQ mode.

Provider edge devices at Layer 2 only

QinQ does not provide Layer 3 capabilities of complete network isolation between customers. In a mixed
VLAN configuration, there is no switching/routing between C-VLANs and S-VLANs. S-VLANs are essentially
Layer 2 VLANs that switch packets based on S-VIDs.

IP support

Regular VLANs support IP and can be routing enabled. S-VLANs of mixed VLAN mode devices cannot be ip
enabled. S-VLANs of S-VLAN mode devices can be ip-enabled, though routing related features (such as ip
routing) are not supported.

Double-tagging causes frame size increases

Since there is both a provider VLAN tag and customer VLAN tag in each QinQ frame, the size of each double-
tagged frame increases by 4 bytes. To accommodate the frame size increase, HPE recommends that you
configure all port-based S-VLANs to accept jumbo frames.

S-VLAN configuration restrictions

S-VLAN commands are not available when QinQ is disabled on the switch.

VLAN configuration restrictions in mixed VLAN mode

• Both C-VLANs and S-VLANs can be configured on the switch. In a mixed mode device, the default VLAN
is always a C-VLAN.

• VLAN types cannot be updated dynamically. A VLAN can be classified only as an S-VLAN or a C-VLAN at
the time its created. Once created, the VLAN cannot be moved between being a C-VLAN and an S-VLAN.
If a VID that was initially created as a regular VLAN needs to be used for an S-VLAN, the VID must be
deleted and re-created as an S-VLAN.

• If a VLAN being configured as an S-VLAN already exists as a GVRP C-VLAN or a static C-VLAN on the
switch, the S-VLAN creation is blocked. Similarly, a C-VLAN creation is blocked if the same VID exists as a
static S-VLAN on the device.

• S-VLANs in a mixed vlan device cannot be configured as a voice-VLAN, primary-VLAN, or management-
VLAN.

• S-VLANs cannot be configured with ip-layer functionality, except for ip-acls.
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VLAN configuration restrictions in S-VLAN mode

• Only S-VLANs are supported—the keyword on all vlan-related command syntax changes from vlan to
svlan.

• Routing related features such as ip-routing, RIP, OSPF, PIM, and VRRP are not supported in S-VLAN
mode.

Port-based restrictions

• In QinQ mixed VLAN mode, a port must be explicitly GVRP-disabled before it can be assigned to the S-
VLAN space.

• In QinQ mixed VLAN mode, only ports that are members of S-VLANs can be configured as customer
network or provider network ports; ports that are members of C-VLANs cannot be configured to any port-
type.

• QinQ mixed VLAN mode devices cannot be connected in an S-VLAN mesh topology. This is because STP
cannot be run in the S-VLAN space, and so amesh topology (or the presence of any redundant links)
would result in loops.

• A port can either be a member of S-VLANs or C-VLANs only, but not a combination of both.

• A port cannot be configured as a Customer-Edge as specified in Section 12.13.3 of the IEEE 802.1ad
specification. In the current software release, such C-tagged interfaces are not supported—only port-
based/S-tagged interfaces are supported.

• Moving ports between C-VLANs and S-VLANs may cause conflicts. For example, if a port has any
mirroring/monitoring sessions set up, they will not be allowed to change VLAN domains until these
sessions are re-configured.

Interoperating with other vendor devices

When enabling QinQ, you can configure a unique tpid value, such as 0x8100, to allow the device to
interoperate with devices that require this value for the inner and outer VLAN-tag. If the provider tag-type is
configured as 0x8100, then:

• Customer-network ports cannot be configured as tagged-S-VLAN members

• Tagged-S-VLAN members cannot be configured as customer-network ports.

Configuring QinQ with other network protocols

The networks for both the customer and provider can be complex. For information on how QinQ may impact
other network protocols (such as spanning tree, LLDP, and GVRP), see the figure in QinQ mixed VLAN
mode.

Changing QinQ modes
Changing QinQ modes (or disabling QinQ operations) will result in the current configuration being erased. See the
following Caution for details.

CAUTION: Configuring the switch to operate in a different bridge mode requires a reboot to take
effect. Upon reboot, all configuration information for the prior QinQ mode is lost. Any configurations
created under the existing QinQ mode is erased, and the device boots up with a default configuration
for the new QinQ mode.

For information on the effect of the different QinQ modes on switch protocols and operations, see the table
Impacts of QinQ configurations on other switch features.
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Effects of QinQ on other switch features
Per the IEEE standards, protocols such as STP and GVRP are assigned separate addresses for customer
networks and provider networks, ensuring that QinQ has no impact on their operations. Bridge Protocol Data
Units (BPDUs) that need to be tunneled through the provider network are treated as normal multicast frames at
the provider bridge and forwarded out.

However, other protocols use common addresses for both customer and provider networks, and so are not
supported when QinQ is enabled on the switch. Similarly, proprietary features such as discovery, UDLD, and loop-
protect do not provide tunneling support. In such cases, where provider networks could run an instance of the
same protocol as a customer could run local to their site, these frames are dropped at the customer-network ports
of the provider bridge.

NOTE: The IEEE standards group is devising new addressing schemes that may support additional
QinQ tunneling operations. Check the latest product release notes for implementation updates as
they apply to switches.

When QinQ is not enabled (the default setting), there are no impacts to the switch's normal operations. The
following table shows the impacts of QinQ on the operation of switch protocols and features based on the QinQ
mode that is configured as QinQ mixed VLAN mode (C-VLANs and S-VLANs are allowed) or QinQ S-VLAN mode
(S-VLANs only).

Table 27: Impacts of QinQ configurations on other switch features

Switch feature Impacts of QinQ configurations and allowed operations

ACLs In QinQ mixed VLAN or S-VLAN modes:

On double-tagged frames , the VID applicable when applying ACLs will be the S-VLAN tag
and not the C-VLAN tag.

aaa In QinQ mixed VLAN mode:

• auth-vid/unauth-vid configuration is not supported on S-VLAN ports; the auth-vid/unauth-
vid cannot be an S-VLAN id.

• If a port that is a member of C-VLANs is configured with auth-vid or unauth-vid and it
needs to be added to the S-VLAN domain, the auth/unauth configuration must first be
undone.

arp-protect In QinQ mixed VLAN mode:

ARP-protect is not supported on S-VLANs, nor on S-VLAN ports.

CDP In QinQ VLAN or S-VLAN modes:

CDP frames are consumed at customer network ports, if CDP is enabled on the device port,
and the customer device shows up as a CDP neighbor on the customer-network port. If not,
the frames are dropped.

Table Continued
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Switch feature Impacts of QinQ configurations and allowed operations

DHCP In QinQ mixed VLAN or S-VLAN modes:

• DHCP relay applies only to C-VLANs.

• DHCP snooping is not supported on S-VLANs.

directed-
broadcast

In QinQ S-VLAN mode:

directed-broadcast is not supported on provider core devices.

GVRP In QinQ mixed VLAN mode:

• S-VLAN ports cannot be GVRP enabled.

• Regular VLANs will participate in C-VLAN GVRP if enabled to do so. S-VLANs will tunnel
all C-VLAN GVRP frames through.

• An explicit GVRP disable on a port is a prerequisite for moving the port to an S-VLAN
domain.

• Port-based interfaces do not have support for provider-GVRP protocols. Provider GVRP
frames received at S-VLAN interfaces will be dropped.

• If a VLAN being configured as an S-VLAN is already a GVRP VLAN on the switch, this S-
VLAN creation would be blocked.

In QinQ S-VLAN mode:

GVRP is supported on S-VLAN ports if the qinq mode is S-VLAN.

igmp-proxy In QinQ mixed VLAN mode:

IGMP-proxy cannot be configured on S-VLANs.

In QinQ S-VLAN mode:

IGMP-proxy is not supported.

IPv6 In QinQ mixed VLAN mode:

IPv6 features are not supported on S-VLANs.

ip-recv-mac In QinQ mixed VLAN mode:

ip-recv-mac
cannot be configured on S-VLANs.

In QinQ S-VLANmode:

ip-recv-mac
is not supported.
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350 Aruba 2930F / 2930M Advanced Traffic Management Guide for
ArubaOS-Switch 16.08

Anexo 08 ITENS 8 E 9 (0592727)         SEI 0008478-63.2018.6.02.8000 / pg. 7954



Switch feature Impacts of QinQ configurations and allowed operations

Jumbo In QinQ mixed VLAN or S-VLAN modes:

No change in operations. HPE recommends to jumbo-enable all S-VLANs used for customer
data tunneling to support the addition of the extra S-tag in each frame.

LACP/ Port
Trunks

In QinQ mixed VLAN mode:

• Dynamic-LACP is not supported on S-VLAN ports: LACP manual trunks alone are
supported. The new trunk will be a member of C-VLANs (port types are not applicable).

• If two ports are added to a trunk, the resultant trunk will be a member of the default-vlan
(vid-1) which is always a C-VLAN. The trunk can subsequently be manually assigned to
an S-VLAN.

• Port-type and VLAN configurations are not mapped. If the port-type is updated through
CLI or SNMP and the port is subsequently moved from the C-VLAN space to the S-VLAN
space then back again, the last configured port-type is retained through each move.

In QinQ S-VLAN mode:

• On S-VLAN bridges, both manual and dynamic LACP trunks are supported. HPE does
not recommend that you configure dynamic trunks on customer ports because they
cannot become dynamic members of S-VLANs (there is no provider-gvrp for a dynamic
trunk to become a member of S-VLANs.)

• A newly formed trunk will by default be of type provider-network. When the trunk is
manually assigned to an S-VLAN for the first time after being created, the port-type is
provider-network.

Layer 3 Protocols
(IP, IP+, DHCP,
ARP, IGMP Layer
3, Layer 3 ACLs)

In QinQ mixed VLAN mode:

• There is no IP layer functionality on S-VLANs.

• No change in IP layer functionality on regular C-VLANs.

• S-VLANs cannot be configured as RIP, OSPF, PIM, or VRRP interfaces.

In QinQ S-VLAN mode:

• S-VLANs can be ip enabled.

• IP routing is not supported.

LLDP In QinQ mixed VLAN or S-VLAN modes:

• LLDP is supported on the device (in both qinq modes). However, there is no provision for
tunneling customer LLDP BPDUs through the provider-network.

• LLDP BPDUs received from a customer's network will be consumed at the customer-
network ports of a provider device and the customer device will be displayed as an LLDP
neighbor. Similarly the provider network device will show up as a neighbor on the
customer's network if the customer-network ports send out LLDP advertisements.
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Switch feature Impacts of QinQ configurations and allowed operations

load-sharing In QinQ S-VLAN mode:

Equal cost multi-path (ECMP) is not supported on provider core devices.

management
VLAN

In QinQ mixed VLAN mode:

The management VLAN cannot be an S-VLAN.

Mirroring/
Monitoring

In QinQ mixed VLAN mode:

• Remote mirroring is not supported on S-VLANs.

• Cannot monitor a VLAN with mirror ports in the other VLAN domain. That is, an S-VLAN
or an S-VLAN port cannot be monitored using a C-VLAN port as its mirror, and vice-
versa.

• When a port is moved from the S-VLAN space to the C-VLAN space (or vice versa), all
mirror/monitor sessions on the port must be unconfigured before the move will be
allowed.

multicast-routing In QinQ S-VLAN mode:

Multicast routing is not supported on provider core devices.

QoS In QinQ mixed VLAN or S-VLAN modes:

HPE does not recommend that you enable DSCP on S-VLANs used for tunneling as the
customer IP-pkt will be modified in the S-VLAN space.

Routing In QinQ S-VLAN mode:

Routing is not supported on provider core devices.

source-binding In QinQ mixed VLAN or S-VLAN modes:

source-binding cannot be configured on S-VLANs.

source-route In QinQ S-VLAN mode:

source-route is not supported on provider core devices.
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Switch feature Impacts of QinQ configurations and allowed operations

Spanning Tree In QinQ mixed VLAN mode:

• Customer (C-VLAN) spanning tree is supported. All C-VLAN ports will receive/transmit
customer STP BPDUs and participate in regular VLAN spanning tree as usual.

• When customer STP BPDUs are received at S-VLAN ports on the switch, they will be
flooded out of the other ports on the S-VLAN. All such frames will be tunneled through the
S-VLAN tunnel unscathed.

• Provider (S-VLAN) spanning tree is not supported on the switch. If S-VLAN STP frames
are received on any S-VLAN enabled ports, they will be re-forwarded out of the other
ports on the S-VLAN.

• STP configuration on S-VLAN ports is not supported.

• If a port that is a member of C-VLANs is moved into being a member of S-VLANs, the
port would, by default, tunnel customer STP BPDUs.

• If a C-VLAN port has been configured with any non-default STP parameters (such as
admin-edge, auto-edge, and bpdu-protect) and is then moved into an S-VLAN,
the port will be put into a forwarding state regardless of the STP configurations done
when the port was a member of the C-VLAN.

• MSTP instances cannot include S-VLANs.

In QinQ S-VLAN mode:

• Provider (S-VLAN) spanning tree is supported—both provider-network ports and
customer-network ports will receive/transmit provider STP BPDUs.

• Customer (VLAN) spanning tree tunneling is supported on S-VLAN interfaces—customer-
network or provider-network ports will tunnel customer STP BPDUs through the
appropriate S-VLAN.

Stacking In QinQ mixed VLAN mode:

Stacking is supported only on C-VLANs. The device does not advertise itself (using the stack
discovery protocol) in the S-VLAN space.

In QinQ S-VLAN mode:

Configuring QinQ with S-VLANs in a switch is not supported. Stacking discovery protocol
frames will not be sent out of customer-network ports; similarly, any stacking discovery
protocol frames received on customer-network ports will be dropped.
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Switch feature Impacts of QinQ configurations and allowed operations

UDLD In QinQ mixed vlan or S-VLAN modes:

• UDLD frames received on udld-disabled customer network ports will be dropped.
However, if the customer-network port is udld-enabled, it can peer with a customer
device.

• UDLD frames received on udld-disabled provider network ports will be re-forwarded out of
other udld-disabled provider network ports on the same VLAN.

• UDLD re-forwarding in the C-VLAN space (QinQ disabled or mixed VLAN mode) will
remain unaltered.

udp-bcast-
forward

In QinQ S-VLAN mode:

udp-bcast-forward
is not supported on provider core devices.

unknown-vlans In QinQ mixed VLAN mode:

• GVRP (learn and disabled modes) not supported on S-VLAN ports.

• A C-VLAN port that has GVRP enabled will need to disable it before it can be added to S-
VLANs.

Voice VLANs In QinQ mixed VLAN mode:

S-VLANs cannot be configured as voice-VLANs.

VRRP In QinQ mixed VLAN or S-VLAN modes:

VRRP is not supported on S-VLANs.
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NOTE: All commands previously in the Summary of commands table are indexed under the entry
Command syntax.

Introduction
Classifier-based service policies are designed to work with existing globally configured switch-wide and port-wide
settings by allowing you to select a subset of:

• Traffic sent to or from certain ports

• VLAN traffic

Once the traffic is selected, you can further manage it.

Classifier-based service policies take precedence over, and may override, globally configured settings. These
policies provide greater control for managing network traffic. Using multiple match criteria, you can finely select
and define the classes of traffic that you want to manage. You can then use policy actions to determine how the
selected traffic is handled.

Classes can be based on IPv4 or IPv6 addresses (which you specify in the policy).

Configuring a traffic class
To configure a traffic class to be used in one or more policies, follow these steps:

Procedure

1. Enter the class command from the global configuration context.

Context: Global configuration

Syntax

no class [ipv4 | ipv6 | mac] classname
Defines a traffic class and specifies whether a policy is to be applied to IPv4 or IPv6 packets, where
classname is a text string (64 characters maximum).

After you enter the class command, you enter the class configuration context to specify match criteria. A
traffic class contains a series of match and ignore commands, which specify the criteria used to classify
packets.

The no form of the command removes the existing class .

2. Enter one or more match or ignore commands from the traffic class configuration context to filter traffic and
determine the packets on which policy actions will be performed.

Context: Class configuration

Syntax

no [seq—number] [match | ignore] igmp source—address destination—address [igmp—
type] [ip—dscp codepoint] [precedence precedence—value] [tos tos—value] [vlan 
vlan—id]
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seq-number (Optional) Sequentially orders the match/ignore statements that you
enter in a traffic class configuration. Packets are checked by the
statements in numerical order.

Default: Match/ignore statements are numbered in increments of 10,
starting at 10. To re-number the match/ignore statements in a class
configuration, use the resequence command.

match | ignore Defines the classifier criteria used to determine which packets belong to
the traffic class.

If a packet matches a match criterion, it becomes a member of the
traffic class and is forwarded according to the actions configured with
the policy command. If a packet matches an ignore criterion, no
policy action is performed on the packet. You can enter one or more
match/ignore statements in a traffic class.

To remove a match/ignore statement from a class configuration, enter
the no seq-number command or the complete form of a no match or
no ignore command.
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ip-protocol Specifies an IP protocol to be matched in packet fields of IPv4 or IPv6
traffic, where ip-protocol is one of the values described below.

When entering a match/ignore command in an IPv4 or IPv6 class,
enter ? to display a list of valid ip-protocol entries.

In an IPv4 class, you can enter any of the following IPv4 protocol match
criteria:

ahesp

gre

icmp1

igmp1

ipip-in-ip

ipv6–in-ip

ospf

pim

sctptcp1

udp1

vrrp

To specify an IPv4 protocol as match criteria, you can also enter its
protocol number. Valid values are from 0 to 255.

For example, 8 means Exterior Gateway Protocol; 121 means Simple
Message Protocol. For a list of IPv4 protocol numbers and
corresponding protocol names, see the IANA "Protocol Number
Assignment Services" at www.iana.com.

In an IPv6 class, you can enter any of the following IPv6 protocol match
criteria:

ahesp

icmp2

ipv6

sctptcp2

udp2

Table Continued
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source-address

destination-address

Defines the source IP address (SA) and destination IP address (DA)
that a packet must contain to match a match/ignore statement in an
IPv4 or IPv6 traffic class. Both the source and destination address
parameters are required entries in a match/ignore statement.

Valid values for source-address and destination-address are
as follows:
• any: Matches IPv4 or IPv6 packets from, or destined to, any SA or

DA.

• host [ SA | DA ]: Matches only packets from a specified IPv4
or IPv6 host address. Use this match criterion when you want to
match IP packets from only one SA/DA.

• SAv4 mask | DAv4 mask: Matches packets received from, or
destined to, a subnet or a group of IP4 addresses defined by the
IPv4 mask. Enter an IPv4 mask in dotted-decimal format for an IPv4
address (for example, 10.28.31.1 0.0.0.255).

NOTE: An IPv6 address and mask are not supported as
SAv6 mask and DAv6 mask match criteria.

SAv4/mask-length | DAv4/mask-length: Matches packets
received from, or destined to, an IPv4 subnet or a group of IPv4
addresses defined by the mask length. Enter the mask length for an
IPv4 SA or DA mask in CIDR format by using the number of significant
bits. (for example, 10.28.31.3/24).

An IPv4 mask-length is applied to an SA or DA in a match/ignore
statement to define which bits in a packet's SA/DA must exactly match
the specified SA/DA and which bits need not match. For example,
10.28.31.3/24 means that the leftmost 24 bits in an IPv4 source or
destination address in a packet header must match the same bit set in
the specified IPv4 address (in this case, 10.28.3.3).

An IPv4 mask-length is applied from right to left, starting from the
rightmost bits. For example, 10.10.10.1/24 and 10.10.10.1 0.0.0.255
both match IPv4 addresses in the range 10.10.10.(1 to 255).

NOTE: Specifying a group of non-contiguous IP source
addresses may require more than one match/ignore
statement.

SAv6/prefix-length | DAv6/prefix-length: Matches packets
received from, or destined to, an IPv6 subnet or a group of IPv6
addresses defined by the prefix length. Enter the prefix length for an
IPv6 SA/DA in CIDR format by using the number of significant bits; for
example: 2001:db8:2620:212::01b4/64.

An IPv6 prefix-length is applied to an SA/DA in a match/ignore
statement to define which bits in a packet's SA/DA must exactly match
the specified SA/DA and which bits need not match. For example,
2001:db8:2620:212::01b4/64 means that the leftmost 64 bits in a 128-

Table Continued
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bit IPv6 source or destination address in a packet header must match
the same bit set in the specified IPv6 address (in this case,
2001:db8:2620:212::01b4).

An IPv6 prefix-length is applied from left to right, starting from the
leftmost bits. For example, 2001:db8::0001: 2620:a03:e102:127/64 and
2001:db8::1: 244:17ff:feb6:d37d/64 both match IPv6 addresses with a
network prefix of 2001:db8:0000:0001.

ip-dscp codepoint (Optional) Matches the six-bit DSCP codepoint DSCP codepoint in IPv4
or IPv6 packets to further define match criteria. Valid values for
codepoint are one of the following:

• Numeric equivalent of a binary DSCP bit set from 0 (low priority) to
63 (high priority)

• ASCII standard name for a binary DSCP bit set

af11 (001010) af42 (100100)
af12 (001100) af43 (100110)
af13 (001110) ef
(101110) af21 (010010) cs1 (001000)=precedence 1
af22 (010100) cs2 (010000)= precedence 2
af23 (010110) cs3 (011000)= precedence 3
af31 (011010) cs4 (100000)= precedence 4
af32 (011100) cs5 (101000)= precedence 5
af33 (011110) cs6 (110000)= precedence 6
af41 (100010) cs7 (111000) = precedence 7
default (000000)

To display a list of valid codepoint entries when you enter ip-dscp in
a match/ignore statement, enter ?.

The DSCP codepoints are the leftmost six bits of the ToS/Traffic Class
byte.

Table Continued
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precedence precedence-
value

(Optional) Matches the three-bit IP precedence value in IPv4 or IPv6
packets to further define match criteria. Valid values for precedence-
value are either the numeric value (0 to 7) or corresponding name of an
IP precedence bit set:

0 routine

1 priority

2 immediate

3 flash

4 flash-override

5 critical

6 internet (for internetwork control)

7 network (for network control)

To display a list of valid precedence-value entries when you enter
precedence in a match/ignore statement, enter ?.

NOTE: When used as a match criteria, the IP precedence
value is applied to all other criteria configured in the
match/ignore statement. You can enter a match/ignore
statement either with or without a precedence-value.

The IP precedence bits are the leftmost three bits of the ToS/Traffic
Class byte. The numeric value (0 to 7) of the IP precedence bits
corresponds to the hexadecimal equivalent of the three binary 0 and 1
bits in the IP precedence field. For example if the IP precedence-bit
binary values are 1 1 1, the numeric value is 7 (1+2+4). Similarly, if
the IP precedence bits are 0 1 0, the numeric value is 2 (0+2+0).

Table Continued
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tos tos-value (Optional) Matches the Delay Throughput Reliability (DTR) bit set in the
IPv4 Type-of-Service or IPv6 Traffic Class byte to further define match
criteria.

Valid values are the numeric value or corresponding name of the DTR
bit set. Some useful values are as follows:

0 — normal

2 — max-reliability

4 — max-throughput

8 — minimize-delay

Default: 0 or normal.

To display a list of valid tos-value entries when you enter tos in a
match/ignore statement, enter ?.

NOTE: When used as a match criteria, the ToS/Traffic
Class byte entry is applied to all other criteria configured
in the match/ignore statement. You can enter a match/
ignore statement either with or without a tos-value.

vlan vlan-id (Optional) Matches the VLAN ID number in the Layer 2 header of
802.1Q VLAN packets to further define match criteria. Valid VLAN IDs
are from 1 to 4094.

The image below, shows a sample ToS/Traffic Class field of 10101000
to show the differences between the IP precedence (101), DSCP
(101010), and ToS/Traffic Class (10101000) bits. The rightmost two
bits are reserved as 00.

1 For IPv4 ICMP, IGMP, TCP, and UDP packets, you can enter additional match criteria.
2 For IPv6 ICMP, TCP, and UDP packets, you can enter additional match criteria; see Defining the ICMP match criteria, 

Defining the IGMP match criteria, and Defining TCP and UDP match criteria

Figure 58: A ToS class field

3. To display a class configuration, enter the following command.

show class [ipv4 | ipv6] [classname]
To edit a class configuration, re-enter the class configuration context (class command) and enter new match/
ignore statements as follows:

Chapter 14 Classifier-based software configuration 361

Anexo 08 ITENS 8 E 9 (0592727)         SEI 0008478-63.2018.6.02.8000 / pg. 7965



• If you do not enter a sequence number, a new statement is inserted at the end of the class configuration.

• To remove a match/ignore statement from a class configuration, enter the no sequence-number
command or the complete form of the no match or no ignore command.

• To resequence the order in which match/ignore statements are listed, include the resequence option in
the class command.

• To replace an existing match/ignore statement, enter the no sequence-number command to delete the
entry and re-enter a complete sequence-number match or sequence-number ignore command.

When exiting the class configuration context, the changes are automatically saved and applied to existing
policy configurations on the switch that use the class if the policies have not been applied to an interface. If a
policy has already been applied to an interface, the editing changes are not accepted and an error message is
displayed.

Class configurations

The following example shows two class configurations:

• AdminTraffic
selects the administrative traffic sent to, and received from, the IPv4 address of an administrator's PC.

• http
selects HTTP traffic sent to TCP ports 80, 443, and 8080, and excludes HTTP traffic sent to, and received
from, TCP port 1214.

switch(config)# class ipv4 AdminTraffic
switch(config)# match ip 15.29.16.1/10 any
switch(config-class)# match ip any 15.29.16.1/10
switch(config-class)# exit
switch(config)# class ipv4 http
switch(config-class)# match tcp any any eq 80
switch(config-class)# match tcp any any eq 443
switch(config-class)# match tcp any any eq 8080
switch(config-class)# ignore tcp any eq 1214 any
switch(config-class)# ignore tcp any any eq 1214
switch(config-class)# exit

Defining the ICMP match criteria
To more precisely define the ICMP packets to match in an IPv4 or IPv6 traffic class, use the optional parameter
settings below. For example, instead of matching or ignoring all ICMP traffic, you can configure a class that
matches only a specific ICMP packet type by entering its numeric value.

Context: Class configuration

Syntax:

no [seq—number] [match | ignore] [icmp] source—address destination—address [icmp—
type—number | icmpv4—type—name | icmpv6—type—name] [ip—dscp codepoint] [precedence 
precedence—value] [tos tos—value] [vlan—id]
If you enter icmp as the IP protocol type in a match/ignore statement, you can optionally specify an ICMP packet
type to more precisely define match criteria for a traffic class. Enter the optional ICMP match criteria immediately
after the destination address (DA) value in the command syntax; for example:
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switch(config-class)# match icmp any any host-unknown 
switch(config-class)# match icmp any any 3 7
icmp-type-number

Configures an ICMP packet type as match criteria in a class configuration by entering its numeric identifier.
Valid values are from 0 to 255.

For information on ICMP packet-type names and numeric identifiers, go to the Internet Assigned Numbers
Authority (IANA) website at www.iana.com, click Protocol Number Assignment Services, and then go to
the selections under Internet Control Message Protocol (ICMP) Parameters.

icmpv4-type-name

Enter any of the following ICMPv4 packet-type names to configure more precise match criteria for ICMP
packets in an IPv4 class configuration.

To display a list of valid icmpv4-type-name entries when entering icmp as the IP protocol type in a match/
ignore statement, enter ?. Some of the valid values are:

• administratively-prohibitednet-tos-unreachable
• alternate-addressnet-unreachable
• conversion-errornetwork-unknown
• dod-host-prohibitedno-room-for-option
• dod-net-prohibitedoption-missing
• echopacket-too-big
• echo-replyparameter-problem
• general-parameter-problemport-unreachable
• host-isolatedprecedence-unreachable
• host-precedence-unreachableprotocol-unreachable
• host-redirectreassembly-timeout
• host-tos-redirectredirect
• host-tos-unreachablerouter-advertisement
• host-unknownrouter-solicitation
• host-unreachablesource-quench
• information-replysource-route-failed
• information-requesttime-exceeded
• mask-replytimestamp-reply
• mask-requesttimestamp-request
• mobile-redirecttraceroute
• net-redirectttl-exceeded
• net-tos-redirectunreachable
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icmpv6-type-name

You can also enter any of the following ICMPv6 packet-type names to configure more precise match criteria
for ICMP packets in an IPv6 class configuration.

To display a list of valid icmpv6-type-name entries when you enter icmp as the IP protocol type in a match/
ignore statement, enter ?. Some of the valid values are as follows:

• cert-path-advertisemobile-advertise
• cert-path-solicitmobile-solicit
• destination-unreachablend-na
• echo-replynd-ns
• echo-requestnode-info
• home-agent-replynode-query
• home-agent-requestpacket-too-big
• inv-nd-naparameter-problem
• inv-nd-nsredirect
• mcast-router-advertiserouter-advertisement
• mcast-router-solicitrouter-renum
• mcast-router-terminate router-solicitation
• mld-done time-exceeded
• mld-query ver2-mld-report
• mld-report

Defining the IGMP match criteria
To more precisely define the IGMP packets to match in an IPv4 traffic class, use the optional parameter settings
described in this section. For example, instead of matching all IGMP traffic, configure a class that matches only a
specific IGMP packet type.

Context: Class configuration

Syntax:

no [seq—number] [match | ignore] igmp source—address destination—address [igmp—
type] [ip—dscp codepoint] [precedence precedence—value] [tos tos—value] [vlan vlan—
id]
If you enter igmp as the IP protocol type in a match/ignore statement, you can optionally specify an IGMP packet
type to more precisely define match criteria for a traffic class. Enter the optional IGMP match criteria immediately
after the destination IP address (DA) value in the command syntax; for example:

 
switch(config-class)# match igmp any any host-query
switch(config-class)# match igmp any any 3 7
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igmp-type

Configures an IGMP packet type as match criteria in a class configuration. Some of the valid values for IGMP
packet-type names are as follows:

dvmrpmtrace-requesttrace
host-querymtrace-replyv2-host-leave
host-reportpimv2-host-report
v3-host-report

To display a list of valid igmp-type entries when you enter igmp as the IP protocol type in a match/ignore
statement, enter ?.

Defining TCP and UDP match criteria
In a class configuration, you can enter match/ignore statements that more precisely define the TCP or UDP traffic
to match in an IPv4 or IPv6 traffic class. For example, enter a port number as a match criterion that specifies one
or more TCP source ports, destination ports, or both.

Context: Class configuration

Syntax:

no [seq—number] [match | ignore] {tcp | udp} source—address [operator tcp—src—port 
| udp—src—port] destination—address [operator tcp—dest—port [established] [tcp—
flag tcp—flag ...] udp—dest—port] [ip—dscp codepoint] [precedence precedence—
value] [tos tos—value] 
 [vlan vlan—id]
If you use TCP or UDP as the IP protocol type in a match/ignore statement, you can optionally configure TCP or
UDP source and destination port numbers or ranges of numbers to more precisely define match criteria for a
traffic class. Enter the optional TCP/UDP match criteria immediately after the source and destination address in
the command syntax; for example:

switch(config-class)# match tcp host 10.20.10.17 eq 23 host 10.20.10.155  established
switch(config-class)# match tcp host 10.10.10.100 host 10.20.10.17  eq telnet
switch(config-class)# ignore udp 10.30.10.1/24 host 10.20.10.17  range 161 162
{operator | {tcp-src-port | udp-src-port}}

To specify a TCP or UDP source port number as a match criteria, enter a comparison operator from the
following list with a TCP/UDP port number or well-known port name immediately after the source-address
value in the command.

Comparison Operators:

• eq tcp/udp-port-number
Equal To matches a packet with the same TCP or UDP source port number as tcp/udp-port-number .

• gt tcp/udp-port-number
Greater Than matches any packet with a TCP or UDP source port number greater than tcp/udp-port-
number.

• lt tcp/udp-port-number
Less Than matches any packet with a TCP or UDP source port number less than tcp/udp-port-
number .
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• neq tcp/udp-port-number
Not Equal matches any packet with a TCP or UDP source port number that is not equal to tcp/udp-
port-number.

• range start-port-number end-port-number
Matches any packet with a TCP or UDP source port number in the rangestart-port-number toend-
port-number.

TCP/UDP well-known source-port names and numbers

Enter a comparison operator with the source TCP or UDP port number used by the applications you want to
match. Valid port numbers are from 0 to 255. You can also enter well-known TCP or UDP port names as an
alternative to the corresponding port number; for example:

• TCP: bgp, dns, ftp, http, imap4, ldap, nntp, pop2, pop3, smtp, ssl, telnet
• UDP: bootpc, bootps, dns, ntp, radius, radius-old, rip, snmp, snmp-trap, tftp

To display a list of valid TCP/UDP source ports, enter ? after you enter an operator.

operator tcp-dest-port established {[tcp-flag tcp-flag ...] | udp-destport}
To specify a TCP or UDP destination port number as a match criteria, enter acomparison operator with a
TCP/UDP port number or well-known port name immediately after the destination-address value in the command.

NOTE: The optional established and tcp-flag values apply only to TCP destination-port
criteria.

TCP/UDP well-known destination-port names and numbers

The same operators, port numbers, and well-known names are supported for TCP/UDP destination-port match
criteria as for TCP/UDP source-port criteria. To display a list of valid TCP/UDP destination ports, enter ? after you
enter an operator.

established

(Optional) Applies only to TCP destination-port match criteria and matches only on the TCP Acknowledge
(ACK) or Reset (RST) flags. The established keyword ignores the synchronizing packet associated with
the establishment of a TCP connection in one direction on a port or VLAN, and matches all other IP traffic in
the opposite direction.

For example, a Telnet connection requires TCP traffic to move both ways between a host and the target
device. If you configure a match statement for inbound Telnet traffic, policy actions are normally applied to
Telnet traffic in both directions because responses to outbound requests are also matched. However, if you
enter the established option, inbound Telnet traffic arriving in response to outbound Telnet requests is
matched, but inbound Telnet traffic trying to establish a connection is not matched.

tcp-flag tcp-flag ...

(Optional) Applies only to TCP bit settings in packets destined to a TCP destination port configured as match
criteria (with the tcp-dest-port parameter) and can be one or more of the following values:
ack

Acknowledge matches TCP packets with the ACK flag.

fin

Finish matches TCP packets with the FIN flag.

366 Aruba 2930F / 2930M Advanced Traffic Management Guide for
ArubaOS-Switch 16.08

Anexo 08 ITENS 8 E 9 (0592727)         SEI 0008478-63.2018.6.02.8000 / pg. 7970



rst

Reset matches TCP packets with the RST bit set.

syn

Synchronized matches TCP packets with the SYN flag.

Net-destination and Net-services for classifiers
Syntax
[no] match|ignore {alias-src <NAME-STR>} {alias-dst <NAME-STR>} 
alias-srvc <NAME-STR>
Description

This command provides options to support net-destination and net-services for classifiers.

Parameters

alias-src

Specifies net-destination to control incoming packets.

alias-dst

Specifies destination IP address alias.

alias-srvc

Specifies service alias

Example net-service tcp-service tcp 100 for classifiers

     netdestination “src-ip”
      host 10.120.0.1
      host 10.91.1.1
      host 10.0.100.12   
   netdestination “destn-ip”    
      host 16.90.51.12
      host 10.93.24.1
   netservice “tcp-service” tcp 100
   class ipv4 “abc”
      match alias-src “any” alias-dst “destn-ip” alias-srvc "tcp-service”

How IPv4 mask bit settings define a match (Example)
The following configuration exists:

• A match statement in a class configuration uses an IPv4 source-address/mask-length of 10.38.31.125/21. The
mask-length of 21 results in an IPv4 mask of 0.0.7.255. In the second octet of the mask, 7 means that the
rightmost three bits are on or 1.

• The second octet of the corresponding source address is 31, which means that the rightmost five bits are on or
1.

A match occurs when the second octet of the SA in a packet being classified has a value in the range of 24
(binary 00011000) to 31 (binary 00001111), as shown in the last row in the following table.
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Table 28: How IPv4 mask defines a match

Location of octet Bit position in the octet

128 64 32 16 8 4 2 1

SA in match statement 0 0 0 1 1 1 1 1

Mask for SA 0 0 0 0 0 1 1 1

Bits in the corresponding octetof
a packet's SA that must exactly
match

0 0 0 1 1 0/1 0/1 0/1

The shaded area indicates the bits in the packet that must exactly match the bits in the source IPv4 address in
the match/ignore statement.

• If a mask bit is 1 (wildcard value), the corresponding bits in a source/destination address in an IPv4 packet
header can be any value.

• If a mask bit is 0, the corresponding bits in a source/destination address must be the same value as in the
IPv4 address in the match/ignore statement.

NOTE: Only one octet in an IPv4 address is used as a match criterion. The mask in a match/
ignore statement may apply a packet filter to all four octets of a source/destination address in IPv4
packet headers.

How IPv6 mask bit settings define a match

For an example in which an IPv6 prefix-length of 126 is used to select four IPv6 addresses in a match statement,
see the following figure. The specified source IPv6 address is: 2001:DB8:0000:0000:244:17FF:FEB6:D37D.
The IPv6 prefix-length (/126) results in the IPv6 mask: FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFC.

Figure 59: Mask for matching four IPv6 devices
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To see the on and off settings in the last block of the resulting IPv6 mask that determine the matching IPv6
addresses, see the preceding figure. In this mask, all bits except the last two are set to 1 (on) and must be the
same in an IPv6 address. The binary equivalent of hexadecimal C is 1100, which allows the last two bits to differ.

Figure 60: How a mask determines four authorized IPv6 manager addresses

To see how the binary equivalent (1100) of the C value in the last block of the resulting IPv6 mask supports four
possible combinations (D37C, D37D, D37E, and D37F) in the last block of a matching IPv6 address, see the
following figure. Therefore, the IPv6 mask that results from a /126 prefix-length matches inbound traffic from four
IPv6-based devices.

Figure 61: How hexadecimal C in an IPv6 mask matches four IPv6 addresses

For more detailed information on how to use CIDR notation to specify masks in match criteria, see the ArubaOS-
Switch Access Security Guide.

Resequencing match/ignore statements
Use the class command with the resequence option to reconfigure the number at which the first match/ignore
statement in the class starts, and reset the interval used to number other match/ignore statements.

Resequencing match/ignore statements is useful when you want to insert a new match/ignore statement between
two numbered entries.

Context: Global configuration
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Syntax:

class resequence [ipv4 | ipv6] name seq-number interval
resequence

Resets the sequence numbers for all match/ignore statements in the class.

name

Specifies the name of the class that contains the match/ignore statements that you want to resequence.

seq-number

Specifies the sequence number of the first match/ignore statement in the class. Default: 10.

interval

Specifies the interval between sequence numbers of match/ignore statements in the class to allow additional
match/ignore statements to be inserted. Default: 10.

To view the current sequence numbering in a particular class, enter the following command:

show class [ipv4 | ipv6] classname

Resequencing a class configuration

The following example shows how to resequence a class configuration so that you can insert new match/ignore
statements between sequentially numbered statements. The resequenced class contains two additional match/
ignore statements and renumbers the criteria with an interval of 10.

Figure 62: Resequencing a class configuration
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Creating a service policy
In the classifier-based configuration model, the service policy you create for one or more traffic classes is always
relative to a software feature, such as QoS, port and VLAN mirroring, or PBR. The software feature must support
class and policy configuration. Each feature supports different actions for managing selected packets.

NOTE: Policy Based Routing (PBR) is available on switches running v2 or higher modules.

For example, QoS policies support QoS-specific actions, such as rate limiting, 802.1p-priority, IP-precedence, and
DSCP-codepoint assignment. Port and VLAN mirroring policies support mirror-destination assignment for
matching packets. PBR policies support specifying the IP next-hop and IP default next-hop, tunnel ID, or null for
matching packets.

Procedure

1. To create a service policy that performs feature-specific actions on selected packets, enter the policy
feature-name command from the global configuration context.

Context: Global configuration

Syntax

policy [qos | mirror | pbr] [policy-name]

no policy [qos | mirror | pbr] [policy-name]

Defines the name of a service policy and enters the policy configuration context, where policy-name is a text
string (64 characters maximum).

A traffic policy consists of one or more actions that are configured for each class of traffic. The configured
actions are executed on packets that match a match statement in a class. No policy action is performed on
packets that match an ignore statement. You can configure multiple classes in a policy.

2. To configure the actions that you want to execute on packets that match the match criteria in a specified class,
enter one or more class action commands from the policy configuration context.

Context: Policy configuration

[seq-number] class [ipv4 | ipv6 classname action action-name] [action action-name ...]

no [seq-number] class [ipv4 | ipv6 classname action action-name] [action action-name ...]

Defines the actions to be applied on a pre-configured IPv4 or IPv6 traffic class when a packet matches the
match criteria in the class.

You can enter multiple class-action statements for the same class. The actions supported for a class command
differ according to the feature-specific policy (for example, QoS or mirroring) configured with the policy
command in Step 1.

seq-number
(Optional) Sequentially orders the class-action statements in a policy configuration. Actions are executed on
matching packets in numerical order.

Default: Class-action statements are numbered in increments of 10, starting at 10.

class ipv4|ipv6 classname
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Defines the preconfigured class on which the actions in a class-action statement are executed, and specifies
whether the class consists of IPv4 or IPv6 traffic. The class name is a text string (64 characters maximum).

NOTE: You can configure multiple class-action statements to include different classes in a policy.
The execution of actions is performed in the order in which the class-actions are numerically
listed.

action action-name [action action-name ...]
The action keyword configures the action specified by the action-name parameter. The action is executed
on any packet that matches the match criteria in the class. The action is not executed on packets that match
ignore criteria. You can configure more than one action for a class. The complete no form of the class
action command or the no seq-number command removes an action from the policy configuration.

Be sure to enter a class and its associated actions in the precise order in which you want packets to be
checked and handled by class action commands.

3. (Optional) To configure a default class, enter the default-class command and specify one or more actions
to be executed on packets that are not matched and not ignored.

Context: Policy configuration

default-class action action-name [action action-name ...]

no default-class action action-name [action action-name ...]
Configures a default class to be used to execute one or more actions on packets that are not matched nor
ignored in any of the class configurations in a policy. The default-class action command supports only
the feature-specific commands supported in the class actioncommand.

The default class manages packets that do not match the match or ignore criteria in all classes in a policy,
and otherwise would have no actions performed on them.

The default class differs from other classes because it contains no match/ignore statements and uses implicit
match ipv4 any any and match ipv6 any any statements to manage all unmatched packets. If you do
not configure a default class, unmatched and ignored packets are transmitted without an action performed on
them.

4. Enter the exit command to exit the policy configuration context.

To display a policy configuration, enter the show policy policy-name feature-name command where
feature-name is a software feature (such as qos, mirror, or pbr) that supports classifier-based configuration.

To edit a policy configuration, re-enter the policy context (policy command) and modify class-action statements.

To resequence the order in which class-action statements are listed, enter the resequence command.

In the following QoS policy configuration, matching HTTP packets are rate limited to 10000 kbps. All unmatched
packets are managed by the default class, which assigns a slightly higher 802.1p priority (4) and a new DSCP
codepoint (5).

switch(config)# class ipv4 http
switch(config-class)# match tcp any any eq 80
switch(config-class)# match tcp any any eq 8080
switch(config-class)# exit
switch(config)# policy qos RateLimitPrioritizeSuspectTraffic
switch(policy-qos)# class ipv4 http action rate-limit kbps 10000
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switch(policy-qos)# default-class action priority 4 action dscp 5
switch(policy-qos)# exit
A policy configuration requires a feature-specific policy command to identify the software feature used to
manage one or more traffic classes:

• To configure a QoS policy, use the policyqos command as described in the "Quality of Service" chapter in
the Advanced Traffic Management Guide.

• To configure a mirroring policy, use the policy mirror command as described in the Management and
Configuration Guide for your switch.

Creating a PBR policy
PBR enables you to manipulate a packet's path based on attributes of the packet. Traffic with the same
destination can be routed over different paths, so that different types of traffic, such as VOIP or traffic with special
security requirements, can be better managed.

NOTE: Policy Based Routing (PBR) is available on switches running v2 or higher modules.

The supported actions for PBR are:

• Setting the next hop for routing the packet ([ipv4 | ipv6] next-hop [ip-addr] ).

• Setting the next hop for routing the packet if there is no explicit route for this destination ([ipv4 | ipv6] ip
default-next-hop [ip-addr] ).

• Setting the outbound tunnel interface for the packet (interface tunnel [tunnel-ID] ). See the IPv6
Configuration Guide for your switch.

• Setting interface null, which specifies that the packets are dropped if no other actions have occurred.

Operating notes for PBR

• Multiple actions can be configured for a class, up to 8 actions per class.

• If you configure an action of interface null, no more actions for that class may be configured.

• Only one of the 8 possible actions can be active at one time.

• The precedence of actions is indicated by the order in which they are added to the policy.

• Actions can only be added to a class, and they are added to the end of the action list for the class.

• To remove actions from a class, the entire class must be removed from the policy.

• When an action becomes inactive, for example, if the configured address becomes unreachable (for next-
hop and default-next-hop) or the interface goes down (for a tunnel), the policy is configured with the next
action for that class, if possible. If that action is not active, the next action is tried, and so on, until an interface
null or the end of the list of configured actions is encountered. If the end of the list is reached, the policy action
for that class behaves as if no PBR policy is applied.

• The maximum combined number of unique IP next-hops and default-next-hops supported is 16.

TCP and UDP traffic routing

The following example shows TCP and UDP traffic routed on different network paths. First, the traffic classes are
created, then the PBR policy is created, and lastly the PBR policy is applied to an interface.
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switch(config)# class ipv4 TCP
switch(config-class)# match tcp 10.0.8.1/24 15.29.16.104/24 eq 80
switch(config-class)# match tcp 10.0.8.1/24 15.29.16.104/24 eq 22
switch(config-class)# match tcp 10.0.8.1/24 15.29.16.104/24 eq 23
switch(config-class)# exit
switch(config)# class ipv4 UDP
switch(config-class)# match udp 10.0.8.1/24 15.29.16.104/24 eq 80
switch(config-class)# match udp 10.0.8.1/24 15.29.16.104/24 eq 22
switch(config-class)# match upd 10.0.8.1/24 15.29.16.104/24 eq 23
switch(config-class)# exit
switch(config)# class ipv6 TCP
switch(config-class)# match tcp 2001::1/64 3001::1/64 eq 80
switch(config-class)# match tcp 2001::1/64 3001::1/64 eq 22
switch(config-class)# match tcp 2001::1/64 3001::1/64 eq 23
switch(config-class)# exit
switch(config)# class ipv6 UDP
switch(config-class)# match udp 2001::1/64 3001::1/64 eq 80
switch(config-class)# match udp 2001::1/64 3001::1/64 eq 22
switch(config-class)# match udp 2001::1/64 3001::1/64 eq 23
switch(config-class)# exit
switch(config)# policy pbr TCP_UDP
switch(policy-pbr)# class ipv4 TCP
switch(policy-pbr-class)# action ip next-hop 20.0.0.1
switch(policy-pbr-class)# action interface null
switch(policy-pbr-class)# exit
switch(policy-pbr)# class ipv4 UDP
switch(policy-pbr-class)# action ip default-next-hop 30.0.0.1
switch(policy-pbr-class)# action interface tunnel 3
switch(policy-pbr-class)# exit
switch(policy-pbr)# class ipv6 TCP
switch(policy-pbr-class)# action ip next-hop 20.0.0.1
switch(policy-pbr-class)# exit
switch(policy-pbr)# class ipv6 UDP
switch(policy-pbr-class)# action ip next-hop 30.0.0.1
switch(policy-pbr-class)# exit
switch(policy-pbr)# exit
switch(config)# vlan 10
switch(vlan-10)# service-policy TCP_UDP in
To enable debug logging for PBR, enter the debug ip pbr command. A message is logged when a PBR policy is
applied, when the action in a class becomes inactive, and when an action in a class becomes active. See the
Management and Configuration Guide for your switch.

NOTE: Policy Based Routing (PBR) is available on switches running v2 or higher modules.

Troubleshooting PBR

Cause

Use the show statistics policy command to display information about which PBR action for an applied
policy is active. Hit counts for each entry in the class and policy with the active action are displayed.

switch(vlan-111)# show statistics policy TCP_UDP vlan 111 in
HitCounts for Policy TCP_UDP
Total
100 class ipv4 TCP action
( 5 ) 10 match tcp 10.0.8.1 0.0.0.255 15.29.16.104 0.0.0.255 eq 80
( 2 ) 20 match tcp 10.0.8.1 0.0.0.255 15.29.16.104 0.0.0.255 eq 22
( 2 ) 30 match tcp 10.0.8.1 0.0.0.255 15.29.16.104 0.0.0.255 eq 23
110 class ipv4 voice action
( 4 ) 10 match tcp 10.0.8.1 0.0.0.255 15.29.16.104 0.0.0.255 eq 80
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To enable debug logging for PBR, enter the debug ip pbr command. A message will be logged when a PBR
policy is applied, when the action in a class becomes inactive, and when an action in a class becomes active. See
the Management and Configuration Guide for your switch.

NOTE: Policy Based Routing (PBR) is available on the 5400 series switch which all have v2 or
higher modules. Any v1 modules will prevent PBR from functioning.

Modifying classes in a policy
You can modify the classes and class-action statements in a policy configuration without removing them from the
policy:

• To modify the match/ignore statements in a class, enter the class-configuration context with the command, and
make the necessary changes by removing or replacing existing statements. To display a class configuration,
enter the following command as shown in Figure 62: Resequencing a class configuration on page 370:

show class [ipv4 | ipv6] classname
When you exit class configuration context, the changes are automatically saved and applied to existing policy
configurations on the switch that use the class if the policies have not been applied to an interface. If a policy
has already been applied to an interface, the editing changes are not accepted and an error message is
displayed.

• To modify the class-action statements in a policy, enter the policy-configuration context with the policy
feature-name policy-name command. To display a policy configuration, enter the following command as
shown in Resequencing a policy configuration on page 376:

show policy feature-name policy-name
Then do one of the following:
◦ You can enter a new class-action statement. If you do not enter a sequence number, the new class-action

statement is inserted at the end of the policy configuration.

◦ To remove a class-action statement from a policy configuration, enter the no sequence-number
command or the complete form of the no class ... action command.

◦ To resequence the order in which class-action statements are listed, enter the resequencecommand.

◦ To replace an existing class-action statement, enter the no sequence-number command to delete the
entry, and re-enter the following complete command:

class [ipv4 | ipv6] classname action action-name or default-class action action-name

When exiting the policy-configuration context, the changes are automatically saved and applied to the policy
configuration if the policy has not been applied to an interface. If the policy has already been applied to an
interface, the editing changes are not accepted and an error message is displayed.

Resequencing classes in a policy
You can use the policy command with the resequence option to reconfigure the number at which the first
class-action statement starts, and reset the interval used to number other class-actions.

Resequencing class-actions is useful when you want to insert a new class-action between two numbered entries.

Context: Global configuration
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Syntax:

policy resequence name seq-number interval
resequence

Resets the sequence numbers for all class-action statements in the policy.

name

Specifies the name of the policy that contains the class-action statements that you want to resequence.

seq-number

Specifies the sequence number of the first class-action-statement in the policy. Default: 10.

interval

Specifies the interval between sequence numbers of class-action statements in the policy to allow additional
statements to be inserted. Default: 10.

NOTE:

When resequencing class-action statements in a policy, the default class-action-statement always
remains as the last class-action statement.

To view the current class-action numbering in a policy, enter the following command:

show policy feature-name policy-name

Resequencing a policy configuration

The following example shows how to resequence a policy configuration after Viewing its contents. The
resequenced policy allows you to add a new class-action statement between entries 100 and 200.

Applying a service policy to an interface
To apply feature-specific service policies to inbound port or VLAN interfaces, use the interface service-
policy in or vlan service-policy in command.

The following service-policy restrictions apply to all software features:
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• A service policy is supported only on inbound traffic.

• Only one feature-specific policy (for example, QoS or mirroring) is supported on a port or VLAN interface.

• PBR is only supported within a vlan [vlan-id] service-policy [policy-name] in command or
within a VLAN context. PBR is not applicable a port‐specific interface.

• If you apply a policy to a port or VLAN interface on which a policy of the same type (for example, QoS) is
already configured, an error message is displayed. The new policy does not overwrite the existing one.

Before you can apply a new policy, you must first remove the existing policy with the no interface
service-policy in or no vlan service-policy in command.

Because only one policy of each type is supported on a port or VLAN interface, ensure that the policy you want to
apply contains all the required classes and actions for your configuration.

NOTE: If ICMP rate limiting is already configured on a port, a service policy cannot be applied to the
port until you disable the ICMP rate limiting configuration.

To apply a service policy to the port, maintain ICMP rate limiting by configuring a QoS policy in which
you add the necessary match statements for ICMP packets to a class configuration and configure a
rate-limit action for the class in the policy configuration.

For information on globally configured ICMP, see the ArubaOS-Switch Management Configuration
Guide for your switch.

To apply a service policy on a port or VLAN interface, enter one of the following commands from the global
configuration context.

Context: Global configuration

Syntax:

interface port-list service-policy policy-name in | out
Configures the specified ports with a policy that is applied to inbound traffic on each interface. Separate individual
port numbers in a series with a comma; for example, a1, b4, d3. Enter a range of ports by using a dash; for
example, a1-a5.

The policy name you enter must be the same as the policy name you configured with the policy command.

Context: Global configuration

Syntax:

vlan vlan-id service-policy policy-name in | out
Configures a policy on the specified VLAN that is applied to inbound traffic on the VLAN interface. Valid VLAN ID
numbers range from 1 to 4094.

The policy name you enter must be the same as the policy name you configured with the policy command.

Applying a QoS policy to a port range and a VLAN interface

The following example shows how to apply a QoS policy to a port range and a VLAN interface:

switch(config)# interface a4 service-policy RateLimitPrioritizeSuspectTraffic in
switch(config)# vlan 10 service-policy RateLimitPrioritizeSuspectTraffic in
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Checking resource usage
Syntax:

show policy resources
After applying service policies to an interface, use the show policy resources command to verify the amount
of additional resources used and the amount of resources that are still available on the switch. Classifier-based
service policies (such as QoS or mirroring) share the same hardware resources with other software features, such
as ACLs, virus throttling, management VLAN, globally configured QoS policies, MAC-based mirroring policies,
and so on.

Use the displayed information to decide whether to re-prioritize current resource usage by reconfiguring or
disabling software features to free the resources reserved for less important features. For a detailed explanation
of the information displayed with the show policy resources command, see the ArubaOS-Switch
Management and Configuration Guide.

Viewing policy resources

The show policy resources command output displays the number of hardware resources (rules, meters, and
application port ranges) used by classifier-based QoS and mirroring policies that are currently applied to
interfaces on the switch and other software features.

Viewing statistics for a policy

Only the active redirects (matches, ignores, etc.) are displayed when executing the show statistics
command.
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Statistical output for a policy with active redirects

switch(vlan-111)# show statistics policy TCP_UDP vlan 111 in
HitCounts for Policy TCP_UDP
Total
100 class ipv4 TCP action
( 0 ) 10 match tcp 10.0.8.1 0.0.0.255 15.29.16.104 0.0.0.255 eq 80
( 0 ) 20 match tcp 10.0.8.1 0.0.0.255 15.29.16.104 0.0.0.255 eq 22
( 0 ) 30 match tcp 10.0.8.1 0.0.0.255 15.29.16.104 0.0.0.255 eq 23
110 class ipv4 voice action
( 0 ) 10 match tcp 10.0.8.1 0.0.0.255 15.29.16.104 0.0.0.255 eq 80

Viewing statistics for a policy
Only the active redirects (matches, ignores, etc.) are displayed when executing the show statistics
command.

Statistical output for a policy with active redirects

switch(vlan-111)# show statistics policy TCP_UDP vlan 111 in

HitCounts for Policy TCP_UDP

  Total

 100 class ipv4 TCP action
( 0 )     10 match tcp 10.0.8.1 0.0.0.255 15.29.16.104 0.0.0.255 eq 80 
( 0 )     20 match tcp 10.0.8.1 0.0.0.255 15.29.16.104 0.0.0.255 eq 22
( 0 )     30 match tcp 10.0.8.1 0.0.0.255 15.29.16.104 0.0.0.255 eq 23

  110 class ipv4 voice action
( 0 )     10 match tcp 10.0.8.1 0.0.0.255 15.29.16.104 0.0.0.255 eq 80

About Classifier-based configuration
Traffic classes and software releases
The Classifier feature introduces:

• A finer granularity than globally configured features for placing network traffic (IPv4 or IPv6) into classes that
can be used in cross-feature software configurations

• Additional policy actions, such as rate limiting and IP precedence marking, to manage selected traffic

• The configuration of service policies for classified traffic with the following software features:
◦ Quality of Service (QoS)

◦ Traffic mirroring

◦ Policy Based Routing (PBR)

• The application of service policies to specific inbound traffic flows on individual port and VLAN interfaces
(rather than only on switch-wide or port-wide traffic).

Using CIDR notation for IPv4/IPv6 addresses
You can use CIDR (Classless Inter-Domain Routing) notation to enter an IPv4 mask-length or an IPv6 prefix-
length with a source and destination address that are used as match criteria in a match/ignore statement. The
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switch interprets the IP address with CIDR notation to compute the range of corresponding IP source or
destination addresses in packet headers that are considered to be a match for the traffic class.

When the switch uses a match/ignore statement to compare an IP address and corresponding mask/prefix length
to the IP source/destination address carried in a packet, the IPv4 mask-bit settings and IPv6 prefix-bit settings
select packets in different ways.

• An IPv4 mask length creates a mask in which:
◦ A mask-bit setting set to 0 (off) requires the corresponding bit in a packet's IPv4 source/destination address

to be the same binary value as the mask-bit in the matching IPv4 source/destination address.

◦ A mask-bit setting set to 1 (on) is used as a wildcard and allows the corresponding bit in a packet's IPv4
source/destination address to be either binary value (0 or 1).

Table 29: How CIDR notation is used with IPv4 SA/DA match criteria

IPv4 Source/
Destination address
used with CIDR
notation in a Match/
Ignore statement

Resulting mask Range of IPv4 addresses selected by the match
criteria

10.38.240.125/15 0.1.255.255 The leftmost 15 bits must match; the remaining bits are
wildcards.

10.38.240.125/20 0.0.15.255 The leftmost 20 bits must match; the remaining bits are
wildcards.

10.38.240.125/21 0.0.7.255 The leftmost 21 bits must match; the remaining bits are
wildcards.

10.38.240.125/24 0.0.0.255 The leftmost 24 bits must match; the remaining bits are
wildcards.

18.38.240.125/32 0.0.0.0 All bits must match.

• An IPv6 prefix-length creates a mask in which:
◦ A mask-bit setting set to 1 (on) requires the corresponding bit in a packet's IPv6 source/destination address

to be the same binary value as the mask-bit in the matching IPv6 source/destination address.

◦ A mask-bit setting set to 0 (off) is used as a wildcard and allows the corresponding bit in a packet's IPv6
source/destination address to be either binary value (0 or 1).
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Table 30: How CIDR notation is used with IPv6 SA/DA match criteria

IPv6 source/destination address
used with CIDR notation in a Match/
Ignore statement

Resulting mask Range of IPv6 addresses selected
by the match criteria

2001:db8:0:7::5/64 FFFF:FFFF:FFFF:FFFF:: The leftmost 64 bits must match; the
remaining bits are wildcards.

2001:db8:0:7::5/72 FFFF:FFFF:FFFF:FFFF:FF00:: The leftmost 72 bits must match; the
remaining bits are wildcards.

2001:db8::244:17ff:feb6:d37d/126 FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:F
FFF:FFFC

The first 126 bits mst match; the C
value in the mask allows four possible
combinations (D37C, D37D, D37E,
and D37F) in the last block of a
matching IPv6 address.

2001:db8:0:7:af:e2:c1:5/128 FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:F
FFF:FFFF

All bits must match.

NOTE: Although IPv4 and IPv6 masks are applied in opposite directions:
◦ An IPv4 mask-length is applied from right to left, starting from the rightmost bits.

◦ An IPv6 prefix-length is applied from left to right, starting from the leftmost bits.

The behavior of IPv4 and IPv6 masks as match criteria and wildcards is the same.

Where to go from here
Classifier-based service policies are designed to work with your existing globally-configured software settings.
While existing software features allow you to globally manage all network traffic on a switch or port, classifier-
based service policies allow you to zoom in on subsets of network traffic to further manage it on a per-port or per-
VLAN basis.

You can use the match criteria described in this chapter across software features to configure classes of traffic for
use in feature-specific service policies.

After you decide on the IPv4 and IPv6 network traffic you want to manage, see the ArubaOS-Switch Management
and Configuration Guide for more information about how to configure and use classifier-based quality-of-service
and mirroring policies.

Traffic class-based configuration model
Traffic class-based software configuration consists of the following general steps:

Procedure

1. Determine the inbound traffic you want to manage and how you want to manage it. For example, you may
want to rate limit certain traffic, prioritize it, mirror it, and so on.

2. Classify the traffic that you want to manage by configuring a class, using match and ignore commands. A
traffic class is configured separately from service policies and can be used in various policies.
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3. Configure a service policy for one or more address classes, including an optional, default class. A policy
consists of configuration commands executed on specified traffic classes for one of the following software
features:

• Quality of Service (policy qos command)

• Port and VLAN mirroring (policy mirror command)

• Policy Based Routing (policy pbr command)

4. Assign the policy to an inbound port or VLAN interface using the interface service-policy in or vlan
service-policy in command.

The following figure shows an overview of traffic class-based software configuration:

Figure 63: Traffic class-based configuration model
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Creating a traffic class
In the traffic class-based configuration model, you use match criteria to create a class of IPv4 or IPv6 traffic and
select the packets you want to manage. In a traffic class configuration, match criteria consist of match and
ignore commands. These commands determine the packets that belong to a class. (Match/ignore criteria are
modelled on the permit/deny criteria used in ACLs.)

The traffic classes you configure can be used later in the service policies you create for different software
features, such as QoS and port mirroring. The match criteria used in match/ignore statements are the same
across software features.

Using match criteria
To identify the packets that belong to a traffic class for further processing by policy actions, use match and
ignore commands in a class configuration:
match commands

Define the values that header fields must contain for a packet to belong to the class and be managed by
policy actions.

ignore commands

Define the values which, if contained in header fields, exclude a packet from the policy actions configured for
the class. An ignored packet is transmitted without having a policy action performed on it.

The switch compares match/ignore statements to the values in packet fields. It compares the specified criteria in
the sequential order in which the statements are entered in the class, until a match is found. Be sure to enter
match/ignore statements in the precise order in which you want their criteria to be used to check packets.

• As soon as a field in a packet header matches the criteria in a match statement, the sequential comparison of
match criteria in the class stops, and the policy actions configured for the class are executed on the packet.

• If a packet matches the criteria in an ignore statement, the sequential comparison of match criteria in the
class stops, and no policy action is performed on the packet.

If a packet does not match the criteria in any match/ignore statement in a traffic class configuration, one of the
following actions is taken:

• The packet is transmitted without a policy action performed on it.

• If a default class is configured in the policy, the actions specified in the default-class command are
performed on packets that do not match the criteria in preceding classes in the policy.

The following match criteria are supported in match/ignore statements for inbound IPv4/IPv6 traffic:

• IP source address (IPv4 and IPv6)

• IP destination address (IPv4 and IPv6)

• Layer 2 802.1Q VLAN ID

• Layer 3 IP protocol

• Layer 3 IP precedence bits

• Layer 3 DSCP bits

• Layer 4 TCP/UDP application port (including TCP flags)

• VLAN ID
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Control Plane Policing
CoPP prioritizes traffic handled by the CPU and also serves to protect the device from Denial-of-Service (DoS)
attacks.

Aruba OS now supports policing the different CPU traffic classes based on a user configurable set of rate limits.
The feature is disabled by default and can be enabled using a set of CoPP CLI commands, which can do either of
the following:

• Apply a default rate-limit profile to all traffic classes via a single command

• Apply a rate limit on a per-traffic class

copp traffic-class
Syntax
copp traffic-class {<traffic-class-type> limit {default | <VALUE>}}

no copp traffic-class {<traffic-class-type> limit {default | <VALUE>}}

Description

Enables control plane policing for the specified traffic class. The no form of this command disables control plane
policing.

Command context
config

Parameters
<traffic-class-type>

Specifies the traffic class type.
all

Specifies control plane policing for all traffic classes.

bgp
Specifies control plane policing for BGP control packets.

broadcast
Specifies control plane policing for broadcast packets.

exception-notification
Specifies control plane policing for MAC security, IP security flow and host.

icmp-redirect
Specifies control plane policing for ICMP redirect packets.

ip-gateway-control
Specifies control plane policing for VRRP traffic.

layer2-control-others
Specifies control plane policing for LLDP, LACP, and 802.1x.
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loop-protect
Specifies control plane policing for loop-protect control packets.

mac-notification
Specifies control plane policing for MAC learn and move notifications.

multicast-route-control
Specifies control plane policing for IGMP, MLD, and PIM control packets.

multicast-sw-forward
Specifies control plane policing for IGMP data driven and multicast routing unknown flows.

mvrp
Specifies control plane policing for MVRP control packets.

ospf
Specifies control plane policing for OSPF control packets.

pvst
Specifies control plane policing for PVST packets.

rip
Specifies control plane policing for RIP control packets.

sampling
Specifies control plane policing for SFLOW.

smart-links
Specifies control plane policing for smart link control packets.

station-arp
Specifies control plane for the traffic class that applies to all ARP and ND packets reaching the switch
CPU.

station-icmp
Specifies control plane policing for the traffic class that applies to all ICMP and ICMPv6 packets reaching
the switch CPU.

station-ip
Specifies control plane policing for the traffic-class that applies to all ip and ipv6 (for example, telnet, snmp,
http, ftp and other services enabled on the switch) traffic reaching the switch CPU.

udld-control
Specifies control plane policing for UDLD and DLDP control packets.

unclassified
Specifies control plane policing for various other protocol packets copied to the switch.

unicast-sw-forward
Specifies control plane policing for unknown IP destination packets to be routed.

limit {default | <VALUE>}
Specifies the rate limit value in packets per second. See Traffic class limits.
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Example

Enable control plane policing for icmp traffic:

switch(config)# copp traffic-class station-icmp limit default

Example

Limit mac-learns or move notifications copied to the CPU to 128 packets per second on each slot (slave cards or
interface modules):

switch(config)# copp traffic-class mac-notificaiton limit 128

copp user-def
Syntax

copp user-def <copp-id> {ipv4 | ipv6}{any <protocol> <dest-port> | <dest-ipaddress> [<protocol> <dest-port>]}
     {limit <limit-val> | none | drop}
     [tcp | udp]}

no copp user-def <copp-id> {ipv4 | ipv6}{any <protocol> <dest-port> | <dest-ipaddress> [<protocol> <dest-port>]}
     {limit <limit-val> | none | drop}
     [tcp | udp]}

Description

Enables control plane policing for a user-defined traffic class. Matches on a particular ip address and layer 4 port
for CoPP.

The no form of this command disables control plane policing.

Command context
config

Parameters
user-def <copp-id>

Specifies up to 8 user defined copp configurations.

{ipv4|ipv6}
Specifies control plane policing for IPv4 or IPv6.

any <protocol> <dest-port>
Specify the port number between 0-65535.

<dest-ipaddress>
Specifies the IP address of User Defined Control Plane Policing.

<protocol>
Specifies control plane policing for transport layer protocol (TCP, UDP), the destination port for the given TCP
or UDP protocol .

limit <limit-val>
Specifies the rate limit value in packets per second.

none
Allows all traffic matching the user-defined traffic class with no limit.
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drop
Blocks user-defined traffic from reaching the switch CPU.

tcp
Telnet protocol for user-defined control plane policing.

udp
Protocol for user-defined control plane policing.

Example

Enable control plane policing only for SNMP traffic reaching the switch at up to 80 packets per second on each
slot:

switch(config)# copp user-def ipv4 any udp 161 limit 80

Example

Block all Telnet traffic from reaching the switch:

switch(config)# copp user-def 1 ipv4 any tcp 23 drop
switch(config)# show copp user-def config

CoPP-ID  L3    Protocol  Port   Threshold
-------  --    --------  ----   ---------
1        IPv4  udp       161    drop
2        IPv4  udp        69    none

Traffic class limits
Table 31: Traffic class limits

Traffic class Default limit Range

station-arp 512 8 to 1024

station-icmp 128 8 to 1024

station-ip 512 8 to 1024

ip-gateway-control 128 8 to 512

ospf 512 8 to 1024

bgp 512 8 to 1024

rip 512 8 to 1024

multicast-route-control 256 8 to 1024

loop-ctrl-mstp 256 8 to 512

loop-ctrl-pvst 256 8 to 512

Table Continued
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loop-ctrl-loop-protect 256 8 to 512

loop-ctrl-smart-links 256 8 to 512

layer2-control-others 512 8 to 1024

udld-control 256 8 to 256

sampling 256 8 to 512

icmp-redirect 64 8 to 128

unicast-sw-forward 512 8 to 1024

multicast-sw-forward 512 8 to 1024

mac-notification 512 8 to 1024

exception-notification 256 8 to 512

broadcast 512 8 to 512

unclassified 64 8 to 512

show copp
Syntax
show copp {config | status | user-def}

Description

Show CoPP configuration information.

Command context
config

Parameters
config

Show CoPP configuration details for all traffic classes.
status

Show CoPP status information for all traffic classes.
user-def

Show the user-defined CoPP configuration.

Example
slot(config)# show copp config
 Traffic-Class                  CoPP Status    Rate-Limit  
 ------------------------------ -------------- ------------
 station-arp                    Disabled       0
 station-icmp                   Enabled        128
 station-ip                     Disabled       0
 ip-gateway-control             Disabled       0
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 ospf                           Disabled       0
 bgp                            Disabled       0
 rip                            Disabled       0
 multicast-route-control        Disabled       0
 loop-ctrl-mstp                 Disabled       0
 loop-ctrl-pvst                 Disabled       0
 loop-ctrl-loop-protect         Disabled       0
 loop-ctrl-smart-links          Disabled       0
 layer2-control-others          Disabled       0
 udld-control                   Disabled       0
 sampling                       Disabled       0
 icmp-redirect                  Disabled       0
 unicast-sw-forward             Disabled       0
 multicast-sw-forward           Disabled       0
 mac-notification               Enabled        128
 exception-notification         Disabled       0
 broadcast                      Disabled       0
 unclassified                   Disabled       0

Example
slot(config)# show copp status
 Traffic-Class                  CoPP Status Threshold Ex Rx Violate Pkts       
 ------------------------------ ----------- ------------ ----------------------
 station-arp                    Disabled    No
 station-icmp                   Enabled     No
 station-ip                     Disabled    No
 ip-gateway-control             Disabled    No
 ospf                           Disabled    No
 bgp                            Disabled    No
 rip                            Disabled    No
 multicast-route-control        Disabled    No
 loop-ctrl-mstp                 Disabled    No
 loop-ctrl-pvst                 Disabled    No
 loop-ctrl-loop-protect         Disabled    No
 loop-ctrl-smart-links          Disabled    No
 layer2-control-others          Disabled    No
 udld-control                   Disabled    No
 sampling                       Disabled    No
 icmp-redirect                  Disabled    No
 unicast-sw-forward             Disabled    No
 multicast-sw-forward           Disabled    No
 mac-notification               Enabled     No
 exception-notification         Disabled    No
 broadcast                      Disabled    No
 unclassified                   Disabled    No

Example
slot(config)# show copp user-def  config
 CoPP-ID L3   Protocol Port   Threshold
 ------- ---- -------- ------ --------------
 1       ipv4 udp      161    80
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Example
slot(config)# show copp user-def  status
 CoPP-ID L3   Protocol Port   Threshold Ex   Dropped Pkts
 ------- ---- -------- ------ -------------- ----------------------
 1       ipv4 udp      161    No
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Overview of MAC classes
MAC classes provide a new functionality to the existing Classifier policy feature. MAC classes allow for the
matching on Ethernet header information: source MAC address, destination MAC address, EtherType, CoS, or
VLAN. MAC classes open up the ability to match traffic that the existing IPv4 and IPv6 classes were unable to
match. After the class is configured the class can be added into a policy and be associated with an action (that is,
remark, rate limits, or mirroring). MAC classes can be included in QoS and Mirror policies and be applied to port,
trunk, and VLAN interfaces.

There are some limitations to using MAC classes with the existing IPv4 and IPv6 classes; they cannot both be
used in the same policy. However, it is possible to have a policy that contains MAC classes applied to a port
interface and also have a policy that contains IPv4 and IPv6 classes applied to a VLAN. The user interface to
configure MAC classes works similarly to the way classes are defined for IP-based traffic.

To use a MAC class, this feature requires the class to be configured, the policy to be configured, and the policy to
be applied to an interface. This section describes how to configure each of these items and provides examples
showing the use of this feature.

MAC Class configuration commands

MAC classes creation syntax
Syntax

no class ipv4|ipv6|mac|zoneCLASS_NAME
This command creates a new MAC class with a given name. The name is used when configuring the policy to
associate a class with a given action. Upon configuring a class, the user is placed into the class context to
configure the rules.

ipv4

Create a traffic class for IPv4 packets.

ipv6

Create a traffic class for IPv6 packets.

mac

Create a traffic class for MAC packets.

zone

Enter the zone name.

CLASS_NAME

Enter an ASCII string.

Create a new MAC class

(config)# class mac “mac-class-1”
(config-class)#

Chapter 15
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NOTE: The command class ipv4 NAME is the IPv4 equivalent command.

MAC class resequence
Syntax

class resequence ipv4|ipv6|mac start_increment
Resequencing a class renumbers the class from a specified starting point. Renumbering allows for additional
space to be placed between the class entries while maintaining the proper order of the entries.

ipv4

Classify traffic based on IPv4 information.

ipv6

Classify traffic based on IPv6 information.

mac

Classify traffic based on Ethernet header information.

<1-2147483647>

The starting sequence number.

<1-2147483646>

The increment for each entry.

Resequence a class starting at sequence 10 and incrementing by 5

 (config)# class resequence mac 10 5

MAC configuring class entries
Syntax

no SEQ_NUM match|ignore any|host SRC-MAC|SRC-MAC SRC-MAC-MASK any|host SRC-MAC|SRC-MAC SRC-MAC-MASK any|ETHERTYPE cos COS vlan vlan_id

A class is composed of entries that describe the traffic to be matched and ignored. Later, when the class is added
to a policy, an action can be applied to the matched traffic. Traffic that is ignored excludes the traffic from the rest
of the policy and takes no action. A class can be composed of many entries, which are processed sequentially.

Behavior

match

Create a rule to match specified packets.

ignore

Create a rule to ignore specified packets.

SOURCE MAC

any

Match packets with any source MAC address.

host

Match a specified source MAC address.
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SRC-MAC

Match a specified source MAC address Range.

SRC-MAC-MASK

The source MAC address mask.

DESTINATION MAC

any

Match packets with any source MAC address.

host

Match a specified source MAC address.

SRC-MAC

Match a specified source MAC address Range.

SRC-MAC-MASK

The source MAC address mask.

ETHERTYPE

600-FFFF

Match a specific EtherType.

any

Match any EtherType.

aarp

AppleTalk Address Resolution Protocol.

appletalk

AppleTalk/EtherTalk.

arp

Address Resolution Protocol.

fcoe

Fibre Channel over Ethernet.

fcoe-init

Fibre Channel over Ethernet Initialization.

lldp

Link Layer Discovery Protocol.

ip

Internet Protocol Version 4.

ipv6

Internet Protocol Version 6.

ipx-arpa

IPX Advanced Research Projects Agency.
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ipx-non-arpa

IPX non-ARPA

is-is

Intermediate System to Intermediate System

mpls-unicast

MPLS Unicast

mpls-multicast

MPLS Multicast

q-in-q

IEEE 802.1ad encapsulation

rbridge

RBridge Channel Protocol

trill

IETF TRILL protocol

wake-on-lan

Wake on LAN

OPTIONS

cos

Match packets with a specified 802.1Q Priority Code Point value.

vlan

Match packets for a configured VLAN.

0-7

Match packets with a specified 802.1Q Priority Code Point value.

vlan

Match packets for a configured VLAN.

VLAN-ID

Enter VLAN identifier or name.

Configuring a basic rule to match ARP traffic

(config)# class mac “mac-class-1”
(config-class)# match any any arp

Configuring a basic rule to match range of source MAC addresses

(config)# class mac “mac-class-2”
(config-class)# match AABB.CCDD.0000 0000.0000.FFFF any any
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Configuring a basic rule to match a specific destination MAC addresses

(config)# class mac “mac-class-2”
(config-class)# match any host AABB.CCDD.EEFF any

Creating policy
A policy associates a class with an action. The policy is not active until it is applied to an interface. A policy that
contains no entries has no effect on the traffic. The available actions of a policy differ depending on the type of
policy configured. Mac classes are valid only with QoS and Mirror policies. After creating a policy, the user is
placed in that policy's context in order to add, remove, or modify entries in the policy. A policy can contain many
entries that provide the same or different actions for a class.

Syntax

no policy qos|pbr|mirror|zone POLICY-NAME
mirror

Create or modify a policy that has mirror actions.

pbr

Create or modify a policy that has PBR actions.

qos

Create or modify a policy that has QOS actions.

POLICY-NAME

Enter an ASCII string.

Create a new qos policy

(config)# policy qos “qos-policy-1”
(policy-qos)#

Create a new mirror policy

(config)# policy mirror “mirror-policy-1”
(policy-mirror)#

Mirror policy context
Syntax

no SEQ_NUM class ipv4|ipv6|mac CLASS_NAME action mirror SESSION mirror SESSION
The mirror policy context associates classes with mirror actions. After creating a policy, the user is placed in the
mirror policy context. Traffic that matches the rules inside the class is mirrored using the associated mirror
instance. Traffic that matches an ignore rule is not mirrored. Traffic that does not match any entries has the
default-mac-class action applied. MAC classes cannot be configured in the same policy with IPv4 and IPv6
classes. The default-class is to be used with policies that contain IPv4 and IPv6 classes, whereas the default-
mac-class is to be used with MAC classes.
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class_name

Enter an ASCII string

<1-4>

Specify a mirror session as the action.

Create a new mirror policy that uses a MAC class

(config)# class mac mac-class-1

(config-class)# match any any arp

(config)# policy mirror “mirror-policy-1”

(policy-mirror)# class mac mac-class-1 action mirror 1

NOTE: The mirror action can be matched multiple times for the number of mirror sessions available.
If there is a maximum of four mirror sessions available, you may have four mirror actions associated
with a single class.

Syntax

no default-mac-class action mirror SESSION
The default-mac-class applies an action to the packets that are neither matched nor ignored by any class
associated with the mirror policy. The default MAC class is used in a policy that contains only MAC classes.

Create a Mirror policy with a default MAC class

(config)# policy mirror “mirror-policy-1”
(policy-mirror)# default-mac-class action mirror 1

NOTE: The default-mac-class is to be used only in a policy that contains MAC classes.

Adding a remark to the policy
Syntax

no SEQ_NUM remark REMARK_STR
REMARK_STR

Add a comment to the policy.

The remark command inserts a comment into the policy at the specified sequence number. If no sequence
number is given, the remark is added to the end of the list. Remarks consume the sequence number they are
given and remain in order if the policy is resequenced.

Add a remark to a mirror policy

(config)# policy mirror “mirror-policy-1”
(policy-mirror)# 5 remark “This rule was added to fix problems related to ticket 234223”
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QoS policy context
Syntax

no SEQ_NUM class ipv4|ipv6|mac CLASS_NAME action dscp|ip_precedence| priority |rate_limit
The QoS policy context associates classes with policy actions. One is placed in this context after creating a QoS
policy. Traffic that matches the rules in the class will have the specified QoS action applied. Traffic that matches
an ignore statement in the class does not have an action applied. Traffic that does not match any entries has the
default-mac-class action applied. MAC classes cannot be configured in the same policy with IPv4 and IPv6
classes. The default-class is used with policies that contain IPv4 and IPv6 classes, whereas the default-mac-class
is to be used with MAC classes.

dscp

Specify an IP DSCP.

ip-precedence

Specify the IP precedence.

priority

Specify the priority.

rate-limit

Configure rate limiting for all traffic.

DSCP OPTIONS

<0-63>
af11 Match DSCP AF11 (001010)
af12 Match DSCP AF12 (001100)
af13 Match DSCP AF13 (001110)
af21 Match DSCP AF21 (010010)
af22 Match DSCP AF22 (010100)
af23 Match DSCP AF23 (010110)
af31 Match DSCP AF31 (011010)
af32 Match DSCP AF32 (011100)
af33 Match DSCP AF33 (011110)
af41 Match DSCP AF41 (100010)
af42 Match DSCP AF42 (100100)
af43 Match DSCP AF43 (100110)
cs1 Match DSCP CS1 (001000)
cs2 Match DSCP CS2 (010000)
cs3 Match DSCP CS3 (011000)
cs4 Match DSCP CS4 (100000)
cs5 Match DSCP CS4 (101000)
cs6 Match DSCP CS6 (110000)
cs7 Match DSCP CS7 (111000)
default Match DSCP default (000000)
ef Match DSCP EF (101110)

IP-PRECEDENCE OPTIONS

<0-7>
routine
priority
immediate
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flash
flash-override
critical
internet
network

PRIORITY Options

<0-7> Enter an integer number.

RATE-LIMIT Options

kbps Specify the rate limit in kilobits per second.

Create a QoS policy that rate remarks a packet

(config)# policy qos “qos-policy-1”
(policy-qos)# class mac mac-class-1 action priority 3

Create a QoS policy that rate limits traffic

(config)# policy qos “qos-policy-1”
(policy-qos)# class mac mac-class-1 action rate-limit kbps 1000

NOTE: The dscp and ip-precedence actions set the same set of bits in the IP header.

Default MAC Class
Syntax

no default-mac-class action mirror SESSION
The default-mac-class applies an action to the packets that are neither matched nor ignored by any class
associated with the mirror policy. The default MAC class is used in a policy that contains only MAC classes.

Create a QoS policy with a default MAC class

(config)# policy qos “qos-policy-1”
(policy-qos)# default-mac-class action dscp af11

NOTE: The default-mac-class is to be used only in a policy that contains MAC classes.

Inserting a remark into a policy
Syntax

no SEQ_NUM remark REMARK_STR
REMARK_STR

Add a comment to the policy.
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The remark command inserts a comment into the policy at the specified sequence number. If no sequence
number is given, the remark is added to the end of the list. Remarks consume the sequence number that they are
given and remain in order if the policy is resequenced.

Add a remark to a mirror policy

(config)# policy qos “qos-policy-1”
(policy-qos)# 100 remark “Add user specific rules above this point”

NOTE: A policy does not perform any action until it is applied to an interface. A policy that contains
MAC classes can be applied to a port, trunk, or VLAN. The interface and direction of the application
determine where in the flow of traffic through the switch the traffic will be compared with the policy's
entries.

Applying the Service-policy
Syntax

no service-policy POLICY_NAME in
A policy does not perform any action until it is applied to an interface. A policy that contains MAC classes can be
applied to a port, trunk, or VLAN. The interface and direction of the application determine where in the flow of
traffic through the switch the traffic will be compared with the policy's entries.

in

Apply policy on inbound packets.

policy-name

Enter an ASCII string.

Apply a QoS policy to the inbound direction of a port

(config)# interface a1
(eth-A1)# service-policy qos-policy-1 in

Apply a QoS policy to the inbound direction of a VLAN

(config)# vlan 10
(vlan-10)# service-policy qos-policy-2 in

Apply a QoS policy to the inbound direction of a trunk

(config)# interface trk1
(eth-trk1)# service-policy qos-policy-3 in

Creating class assigning to mirror policy and applying to a port

(config)# class mac mac-class-1
(config-class)# match any any any
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(config)# policy mirror “mirror-policy-1”
(policy-mirror)# class mac mac-class-1 action mirror 1
(config)# interface a1
(eth-a1)# service-policy mirror-policy-1 in

Show MAC class by name
Syntax

show class mac class_name
Displays information about a specific class.

ASCII-STR

Enter an ASCII string.

Show class mac

Switch(config)# show class mac macClass Statements for class mac "macClass"
class mac "macClass" 10 match 1111.2222.3333 ffff.ffff.0000 4444.5555.6666 ffff.ffff.0000 aarp
exit

Show class ports
Syntax
show class ports port_list
Displays the classes that are applied on the specified port.

[ethernet] PORT-LIST

Enter a port number, a list of ports, or all for all ports

Show class ports

Switch(config)# show class ports A1
Classes for port A1
 Name   : test
 Type   : MAC

show class vlan
Syntax
show class vlan vlan-id
Displays the classes that are applied on the specified VLAN.

vlan-id

Enter a VLAN identifier or a VLAN name.

Show class vlan

Switch(config)# show class vlan 2
Classes for vlan 2
 Name   : test
 Type   : MAC

400 Aruba 2930F / 2930M Advanced Traffic Management Guide for
ArubaOS-Switch 16.08

Anexo 08 ITENS 8 E 9 (0592727)         SEI 0008478-63.2018.6.02.8000 / pg. 8004



Show policy
Syntax

show policy policy-name
Shows a specific policy.

POLICY-NAME

Enter an ASCII string.

Show policy by name

switch(config)# show policy qos-policy-1
Statements for policy "qos-policy-1"
policy qos "qos-policy-1"
10 class mac "macClass" action ip-precedence 3 action priority 0
exit
(

show policy ports
Syntax
show policy ports port-list
Shows the applied policies on a specified port.

[ethernet] PORT-LIST

Enter a port number, a list of ports or 'all' for all ports.

Show policy ports

Switch(config)# show policy ports A1
Policies for port A1
Name   : macClass
Type   : QOS

show policy vlan
Syntax

show policy vlan vlan-id
Shows policies that are applied on a specified VLAN.

all

Show policies applied to all VLANs.

VLAN-ID

Show policies applied to the specified VLAN.

Create a new mirror policy

show policy vlan 2
Policies for VLAN 2 
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Name    : macClass
Type      : QOS

show statistics policy port
Syntax
show statistics policy POLICY-NAME-STR port PORT-NUM
Displays hit count statistics for a given policy on a port.

PORT-NUM

Enter a port name.

POLICY-NAME-STR

The policy to show statistics for.

Show statistics for policy by port

Switch(config)# show statistics policy temp port a1
HitCounts for Policy qos-policy-1 since the last 2277 seconds
Total
10 class mac "macClass" action ip-precedence 3 action priority 0
( 69171 ) 10 match 1111.2222.3333 ffff.ffff.0000 4444.5555.6666 ffff.ffff.0000
aarp

Show statistics policy VLAN
Syntax
show statistics policy POLICY-NAME vlan VLAN-ID
Displays hit counts for a specified policy on a VLAN.

VLAN-ID

The VLAN ID or VLAN name.

POLICY-NAME

The policy to show statistics for.

show statistics policy

Switch(config)# show statistics policy temp vlan 1
HitCounts for Policy temp occurring in the last 851 seconds
Total
10 class mac "macClass" action ip-precedence 3 action priority 0
( 0 ) 10 match 1111.2222.3333 ffff.ffff.0000 4444.5555.6666 ffff.ffff.0000
aarp

clear statistics
Syntax

clear statistics policy|aclv6|aclv4|mac
Clears hit counts.

policy

QoS/Mirror/PBR policy.

402 Aruba 2930F / 2930M Advanced Traffic Management Guide for
ArubaOS-Switch 16.08

Anexo 08 ITENS 8 E 9 (0592727)         SEI 0008478-63.2018.6.02.8000 / pg. 8006



aclv6

IPv6 ACL.

aclv4

IPv4 ACL.

mac

MAC ACL.

Clear statistics for a policy on a port

(config)# clear statistics policy policy-name port a1

Clear statistics for a policy on a vlan

(config)# clear statistics policy policy-name vlan 1
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Networking Websites
Hewlett Packard Enterprise Networking Information Library

www.hpe.com/networking/resourcefinder

Hewlett Packard Enterprise Networking Software

www.hpe.com/networking/software

Hewlett Packard Enterprise Networking website

www.hpe.com/info/networking

Hewlett Packard Enterprise My Networking website

www.hpe.com/networking/support

Hewlett Packard Enterprise My Networking Portal

www.hpe.com/networking/mynetworking

Hewlett Packard Enterprise Networking Warranty

www.hpe.com/networking/warranty

General websites
Hewlett Packard Enterprise Information Library

www.hpe.com/info/EIL

For additional websites, see Support and other resources.
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Accessing Hewlett Packard Enterprise Support
• For live assistance, go to the Contact Hewlett Packard Enterprise Worldwide website:

http://www.hpe.com/assistance

• To access documentation and support services, go to the Hewlett Packard Enterprise Support Center website:

http://www.hpe.com/support/hpesc

Information to collect

• Technical support registration number (if applicable)

• Product name, model or version, and serial number

• Operating system name and version

• Firmware version

• Error messages

• Product-specific reports and logs

• Add-on products or components

• Third-party products or components

Accessing updates
• Some software products provide a mechanism for accessing software updates through the product interface.

Review your product documentation to identify the recommended software update method.

• To download product updates:

Hewlett Packard Enterprise Support Center
www.hpe.com/support/hpesc

Hewlett Packard Enterprise Support Center: Software downloads
www.hpe.com/support/downloads

Software Depot
www.hpe.com/support/softwaredepot

• To subscribe to eNewsletters and alerts:

www.hpe.com/support/e-updates

• To view and update your entitlements, and to link your contracts and warranties with your profile, go to the
Hewlett Packard Enterprise Support Center More Information on Access to Support Materials page:

www.hpe.com/support/AccessToSupportMaterials

Chapter 17
Support and other resources
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IMPORTANT: Access to some updates might require product entitlement when accessed through
the Hewlett Packard Enterprise Support Center. You must have an HPE Passport set up with
relevant entitlements.

Customer self repair
Hewlett Packard Enterprise customer self repair (CSR) programs allow you to repair your product. If a CSR part
needs to be replaced, it will be shipped directly to you so that you can install it at your convenience. Some parts
do not qualify for CSR. Your Hewlett Packard Enterprise authorized service provider will determine whether a
repair can be accomplished by CSR.

For more information about CSR, contact your local service provider or go to the CSR website:

http://www.hpe.com/support/selfrepair

Remote support
Remote support is available with supported devices as part of your warranty or contractual support agreement. It
provides intelligent event diagnosis, and automatic, secure submission of hardware event notifications to Hewlett
Packard Enterprise, which will initiate a fast and accurate resolution based on your product's service level.
Hewlett Packard Enterprise strongly recommends that you register your device for remote support.

If your product includes additional remote support details, use search to locate that information.

Remote support and Proactive Care information
HPE Get Connected

www.hpe.com/services/getconnected
HPE Proactive Care services

www.hpe.com/services/proactivecare
HPE Proactive Care service: Supported products list

www.hpe.com/services/proactivecaresupportedproducts
HPE Proactive Care advanced service: Supported products list

www.hpe.com/services/proactivecareadvancedsupportedproducts

Proactive Care customer information
Proactive Care central

www.hpe.com/services/proactivecarecentral
Proactive Care service activation

www.hpe.com/services/proactivecarecentralgetstarted

Warranty information
To view the warranty information for your product, see the links provided below:

HPE ProLiant and IA-32 Servers and Options
www.hpe.com/support/ProLiantServers-Warranties

HPE Enterprise and Cloudline Servers
www.hpe.com/support/EnterpriseServers-Warranties

HPE Storage Products
www.hpe.com/support/Storage-Warranties

HPE Networking Products
www.hpe.com/support/Networking-Warranties
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Regulatory information
To view the regulatory information for your product, view the Safety and Compliance Information for Server,
Storage, Power, Networking, and Rack Products, available at the Hewlett Packard Enterprise Support Center:

www.hpe.com/support/Safety-Compliance-EnterpriseProducts

Additional regulatory information

Hewlett Packard Enterprise is committed to providing our customers with information about the chemical
substances in our products as needed to comply with legal requirements such as REACH (Regulation EC No
1907/2006 of the European Parliament and the Council). A chemical information report for this product can be
found at:

www.hpe.com/info/reach

For Hewlett Packard Enterprise product environmental and safety information and compliance data, including
RoHS and REACH, see:

www.hpe.com/info/ecodata

For Hewlett Packard Enterprise environmental information, including company programs, product recycling, and
energy efficiency, see:

www.hpe.com/info/environment

Documentation feedback
Hewlett Packard Enterprise is committed to providing documentation that meets your needs. To help us improve
the documentation, send any errors, suggestions, or comments to Documentation Feedback
(docsfeedback@hpe.com). When submitting your feedback, include the document title, part number, edition,
and publication date located on the front cover of the document. For online help content, include the product
name, product version, help edition, and publication date located on the legal notices page.
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Aruba ClearPass Universal Profiler Software
Identify everything connected to wired and wireless networks

 

Product overview
 

As every connected device today is a potential attack point, knowing what is on your network is the first step
to securing your data. It's no longer acceptable to estimate the total number of devices on your network and
whether they are IT-managed laptops, unmanaged smartphones or IoT devices. And given that the number
of IoT devices is expected to grow into the billions, knowing what's on the network has become IT's biggest
challenge. 
IoT devices may be deployed by IT, facilities, or even brought in from home by employees, so
understanding what they are and how they're being used is critical. In fact, as hackers figure out how to
exploit vulnerabilities, knowing what should be on a network and what is not allowed is needed for both
internal and external compliance, regardless of the industry.  
The Aruba ClearPass Universal Profiler is designed to automatically give you that granular visibility into all
connected devices, even controllers and switches. A customizable dashboard lets you see categories and
families of devices and individual attributes for everything connected. No agents or initial investment in a
network access control (NAC) or policy management solution is needed. 
And, as security requirements change, it's easy to migrate from pure profiling to a comprehensive policy and
enforcement solution, when needed. This is something that the competition can't offer.

Key Benefits
Automatically find all managed, unmanaged and IoT  devices
Monitor any wired or wireless multi-vendor network
Uses active and passive profiling methods - DHCP, SNMP,  and  more
See what devices come and go from the network
Built-in profi  update feed for new or unknown devices
Low cost entry point lets you scale to any size network
Easily start with profiling and move to policy enforcement, when  needed

Features and Benefits

 

Real-Time Discovery And Fingerprinting
The ClearPass Universal Profiler automatically identifies all devices on your network by leveraging DHCP, SNMP, and other
methods on both wired and wireless, with minimal set-up—even in multi-vendor environments. In addition to an initial
discovery, Universal Profiler identifies any new devices and the attributes that change on existing devices, too.

It's never been easier to gather information about device categories, manufacturers, connection methods,
OS types and version numbers, and IP addresses. You now have the visibility needed for security and
network performance optimization that allows your business to thrive while delivering a secure and reliable
user experience.

 

QuickSpecs Aruba ClearPass Universal Profiler

Overview

DA - 15753   Worldwide QuickSpecs — Version 1 — 2/6/2017 Page  1

Anexo 09 A 16 ITENS 8 E 9 (0592738)         SEI 0008478-63.2018.6.02.8000 / pg. 8012



Granular device discovery, categorization and visibility

Visibility From One Central Location
The ClearPass Universal Profiler also delivers an intuitive web-based interface that is simple to administer,
shows device totals and devices per category, host names, device vendor information, and if the devices
are online or off. Visual graphs make it easy to track what's on the network and allows you to drill down to
see device specific attributes. All from your office or while on the road. 
A filtering option easily lets you find the one device that may require extra attention - maybe it shouldn't be
on the network, or is exhibiting suspect security behavior. Or perhaps you want to find out a little more about
a new IoT device that is connected to a wired port in a remote office. No more hunting for devices across
multiple tools.

Profiling Is Your Security Launch Point
Just as vulnerability scans are critical to identifying security gaps within servers and other resources,
identifying all IP-enabled devices is critical from a security standpoint, and for audit and compliance
requirements. What you do with the profiling information is what makes the difference. Device visibility is
easily applied to adjust policies on existing firewalls, SIEM, UBA, and other solutions.
 
For more comprehensive controls, a simple migration path from Aruba ClearPass Universal Profiler to the
Aruba ClearPass Policy Manager ensures that automated policy enforcement is easily implemented for real-
time access security. Managed, unmanaged and IoT devices are allowed onto a network based on
category, OS version, ownership, or other attributes.

Key Features
Identify all IP-enabled devices: laptops, smartphones, switches, controllers, routers
Easily view per device attributes:

- Type - printer, HVAC sensor, laptop, IV Pump, and more

- Model name

- MAC address

- IP address

- NIC vendor

- Operating system type and version number
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- Associated switch port

- VLAN

Web-based dashboard: Dynamic visibility, reporting and tiered admin access
Simple to read device totals: Categories, family, and specific vendor names
Continuous insight: See all devices connecting and profiled over time
Compilation of device connectivity: View information like IP subnet, wired/wireless
Simple administration: Easily monitor the heath metrics of all profiler nodes
Vendor-agnostic: Built to work in multi-vendor wired and wireless networks
No agents required: Leverages DHCP, SNMP and other methods

 

Ordering Guidance
The ClearPass Universal Profiler will be available via subscription licenses that include support. For
simplicity, there will be a single part number that covers licensing for 100 devices. For example, for
deployments that contain 2,060 devices, the guidance is to order 21 instances of the part number below.
This allows the ClearPass Universal Profiler software to run on a virtual appliance.

System Requirements
The ClearPass Universal Profiler will only be available in a virtual appliance format. VMware ESX is the
supported platform. Based on the number of devices discovered within an environment, there are three
sizing recommendations for a virtual appliance (specifications provided upon request):

Up to 2,000 devices
Up to 20,000 devices
Up to 100,000 devices
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Ordering Information
   

Description Part Number

Aruba ClearPass Universal Profiler 100 Endpoint Licenses 1yr Subscription E-
STU

JY914AAE

Aruba ClearPass Universal Profiler 100 Endpoint Licenses 3yr Subscription E-
STU

JY981AAE

   

   

For more information on Aruba's Universal Profiler, visit
http://www.arubanetworks.com/products/security/network-access-control/clearpass-universal-

profiler/.
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Date Version History Action Description of Change

06-Feb-2016 Version 1 Created Document creation.

     

Sign up for updates

 

 
 

© Copyright 2017 Hewlett Packard Enterprise Development LP. The information

contained herein is subject to change without notice. The only warranties for Hewlett

Packard Enterprise products and services are set forth in the express warranty

statements accompanying such products and services. Nothing herein should be

construed as constituting an additional warranty. Hewlett Packard Enterprise shall not

be liable for technical or editorial errors or omissions contained herein.

To learn more, visit: http://www.hpe.com/networking
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Aruba ClearPass OnGuard Software
Enterprise-class endpoint protection, posture assessments and health checks

 

Product overview
 

ClearPass OnGuard agents perform advanced endpoint posture assessments on leading computer operating systems to
ensure compliance is met before devices connect.

Running on the Aruba ClearPass Policy Manager platform, the advanced network access control (NAC) framework in
ClearPass OnGuard offers exceptional safeguards against vulnerabilities.

The following operating systems and versions are supported:

Microsoft - Support for Windows 7 and above.

- Can be run as a service.

Apple - Support for macOS X 10.10 and above.
Linux - Support for Red Hat Enterprise Linux 5 and above, Ubuntu 14.x LTS and 16.x LTS, Community
Enterprise Operating System (CentOS) 5 and above, Fedora Core 24 and above, and SUSE Linux
12.x.

Supported agents:

  OnGuard
Persistent

Agent

OnGuard
Dissolvable

Agent

Microsoft’s
NAP Agent

Microsoft X X X

Apple X X  

Linux X* X  

 
NOTE: Auto-remediation only supported by persistent agents

* Persistent agent supported on Ubuntu endpoints running 14.x LTS or 16.x LTS

Key Features
Enhanced capabilities for endpoint compliance and control
Supports Microsoft, Apple, and Linux operating systems
Anti-virus, firewall checks and more
Optional auto-remediation and quarantine capabilities
System-wide endpoint messaging, notifications and session control
Centrally view the online status of all devices from the ClearPass Policy Manager platform
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Successful wireless authentication of a Windows 7 device

The ClearPass Advantage
In addition to anti-virus, anti-spyware and personal firewall audits performed by traditional NAC products, OnGuard agents
can perform more granular posture and health checks to ensure a greater level of endpoint compliance and network
authorization.

Persistent and dissolvable agents
The difference between the two is that the persistent agent provides nonstop monitoring and automatic remediation and
control. When running persistent OnGuard agents, ClearPass Policy Manager can centrally send system-wide notifications
and alerts, and allow or deny network access based on real-time changes on the endpoint. The persistent agent also
supports auto and manual remediation.

Alternatively, the web-based dissolvable agent is ideal for personal, non-IT issued devices that connect via a captive portal
and do not allow agents to be permanently installed. A one-time check at login ensures policy compliance.  Devices not
meeting compliance can be redirected to a captive portal for manual remediation.

Automatic remediation
If unhealthy endpoints do not meet compliance requirements, the user receives a message about the endpoint status and
instructions on how to achieve compliance if auto-remediation is not used.

Messages can include reasons for remediation, links to helpful URLs and helpdesk contact information.
ClearPass persistent agents provide the same message and remediation capabilities for 802.1X and
combined environments.
 
IT-managed and BYOD endpoint compliance

OnGuard's persistent and dissolvable agents can be used together in environments where endpoints are
owned by the organization, employees and visitors. This ensures that all devices are assessed and granted
proper privileges before accessing the network.
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Detailed Mac OS X quarantine messages

 

Persistent and dissolvable agents can be used for endpoint health checks

Complete endpoint visibility

To simplify troubleshooting, endpoint control and compliance reporting, ClearPass Policy Manager allows IT
to centrally manage health-check settings and policies. IT also has the ability to view endpoint activity,
including user and device data for each device that connects using OnGuard agents. 
Real-time endpoint compliance

Depending on operating system type OnGuard performs the following level of posture and health checks. 
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  Windows Mac OS
X

Linux

Installed Applications X X  
AntiVirus X X X

Firewall X X  
Disk Encryption X X  
Network Connections X X  
Processes X X  
Patch Management X X  
Peer to Peer X X  
Services X X X
Virtual Machines X X  

Windows Hotfixes X    
USB Devices X X  
File Check X X  

 
*Chart represents ClearPass version 6.7 functionality.
**Disclaimer: Not all checks are supported across operating systems and agent type.
 

Centralized view of endpoints OnGuard activity

Ordering Guidance
ClearPass OnGuard can be ordered via persistent licenses where support is separate or by subscription
licenses that include ArubaCare support.
 
Ordering ClearPass OnGuard involves the following steps:

1. Determine the number of unique computer endpoints that will have posture/health checks performed prior to network
access within your environment.

2. Select the total number of OnGuard licenses.

 
Additional ClearPass OnGuard capacity can be purchased at any time to meet growth demands. ClearPass
OnGuard is licensed on a per endpoint basis.
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Ordering Information
   

Description Part Number

Perpetual Licenses  

Aruba ClearPass OnGuard 100 Endpoint Licenses E-LTU JZ472AAE

Aruba ClearPass OnGuard 500 Endpoint License E-LTU JZ473AAE

Aruba ClearPass OnGuard 1K Endpoint License E-LTU JZ474AAE

Aruba ClearPass OnGuard 2500 Endpoint License E-LTU JZ475AAE

Aruba ClearPass OnGuard 5K Endpoint License E-LTU JZ476AAE

Aruba ClearPass OnGuard 10K Endpoint License E-LTU JZ477AAE

   

Perpetual Licenses Warranty  

90 days** Software

   

Subscription Licenses  

Aruba ClearPass OnGuard 100 Endpoint Licenses 1-Year Subscription E-STU JZ481AAE

Aruba ClearPass OnGuard 500 Endpoint Licenses 1-Year Subscription E-STU JZ482AAE

Aruba ClearPass OnGuard 1K Endpoint Licenses 1-Year Subscription E-STU JZ483AAE

Aruba ClearPass OnGuard 2500 Endpoint Licenses 1-Year Subscription E-STU JZ484AAE

Aruba ClearPass OnGuard 5K Endpoint Licenses 1-Year Subscription E-STU JZ485AAE

Aruba ClearPass OnGuard 10K Endpoint Licenses 1-Year Subscription E-STU JZ486AAE

Aruba ClearPass OnGuard 100 Endpoint Licenses 3-Year Subscription E-STU JZ490AAE

Aruba ClearPass OnGuard 500 Endpoint Licenses 3-Year Subscription E-STU JZ491AAE

Aruba ClearPass OnGuard 1K Endpoint Licenses 3-Year Subscription E-STU JZ492AAE

Aruba ClearPass OnGuard 1500 Endpoint Licenses 3-Year Subscription E-STU JZ493AAE

Aruba ClearPass OnGuard 5K Endpoint Licenses 3-Year Subscription E-STU JZ494AAE

Aruba ClearPass OnGuard 10K Endpoint Licenses 3-Year Subscription E-STU JZ495AAE

   

*Subscription and enterprise licenses can be purchased in 1- or 3--year increments for 100, 500, 1,000,
2,500, 5,000, and 10,000 endpoints

** Extended with support contract  
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Date Version History Action Description of Change

18-Dec-2017 From Version 3 to 4 Changed Minor edit on Configuration section
04-Dec-2017 From Version 2 to 3 Added SKUs added: JZ472AAE,

JZ473AAE, JZ474AAE, JZ475AAE,
JZ476AAE, JZ477AAE, JZ481AAE,
JZ482AAE, JZ483AAE, JZ484AAE,
JZ485AAE, JZ486AAE, JZ490AAE,
JZ491AAE, JZ492AAE, JZ493AAE,
JZ494AAE, JZ495AAE

Changed All document sections updated
16-Oct-2017 From Version 1 to 2 Changed Aruba information updated
01-Nov-2016 Version 1 Created Document creation.

     

Sign up for updates
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Resumo da garantia e suporte do produto da HPE Networking
 
(outubro de 

2018) 
 

A versão mais atual deste documento está disponível em www.hpe.com/networking/warrantysummary 
Detalhes da política de garantia do produto de rede da HPE estão disponíveis em www.hpe.com/networking/warranty 

Informações sobre os serviços para produtos HPE Networking podem ser encontradas em www.hpe.com/networking/services  
 As informações contidas neste documento estão sujeitas a alterações sem aviso prévio. As garantias para produtos e serviços da HPE são as estabelecidas nas 

declarações de garantia expressa que acompanham tais produtos e serviços. Além disso, nossos produtos já vêm com garantias que não podem ser excluídas sob as leis 
do consumidor da Austrália e Nova Zelândia. Sujeitas às informações anteriores, nenhuma informação aqui descrita deve ser interpretada como parte de uma garantia 

adicional. A HPE não se responsabiliza por erros técnicos ou editoriais ou omissões contidos neste documento. 

 
 

 

 

Produtos 
Duração da 

garantia
1
 

Substituição de 
hardware

2
 

Suporte técnico 
em horário 
comercial

3
 

Suporte técnico 24h 
por dia, 7 dias por 

semana
3
 

(Após 1º de dezembro de 2015) 

Versões de 
software/sistem
a operacional

4
 

S
w

it
c
h

e
s

 

Modular      

 129xx, 125xx, 119xx 1 ano 10 dias 1 ano N/A Desde que sejam 
de propriedade4 

 105xx, 75xx 1 ano 10 dias 1 ano 90 dias Desde que sejam 
de propriedade4 

 84xx, 83xx 5 anos 10 dias 90 dias N/A 5 anos4 

 82xxzl, 54xxzl/R, 42xxvl 
Vida útil

5
 Envio no PDU 

Desde que sejam de 
propriedade5 

90 dias 
Desde que sejam 
de propriedade4 

Configuração fixa      

 79xx, 59xx/AF, 583x/AF, 582x/AF, 57xx 1 ano 10 dias 1 ano N/A Desde que sejam 
de propriedade4 

 Switches Altoline 9xxx, 6xxx (adquiridos após 31 de março de 

2016) 
1 ano 10 dias 1 ano N/A N/A 

 Switches Arista (Consulte 

http://www.arista.com/assets/data/pdf/Warranty.pdf para obter 
detalhes) 

1 ano15 10 dias15 1 ano15 N/A N/A 

 580x/AF 
Vida útil

5
 Envio no PDU 

Desde que sejam de 
propriedade5 

N/A 
Desde que sejam 
de propriedade4 

 55xx, 513x, 512x, 38xx, 36xx, 35xx/yl, 31xx, 29xx/al, 281x, 
26xx, 25xx/G 

Vida útil
5
 Envio no PDU 

Desde que sejam de 
propriedade5 

90 dias 
Desde que sejam 
de propriedade4 

Gerenciamento Inteligente       

 195x, 192x, 191x, 18xx, 17xx, 1620 (Adquiridos após 1º de 

outubro de 2017) 
Vida útil

14 
 Envio no PDU 

90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia14 

90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia14 

Desde que sejam 
de propriedade4 

Não gerenciado       

 1420, 1410 (Adquiridos após 1º de outubro de 2017) 

Vida útil
14 

 Envio no PDU 

90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia 14 

90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia 14 

N/A 

 1405 (Adquiridos após 1º de outubro de 2017) 3 anos
14

 Envio no PDU 90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia

 14
 

90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia

14
 

N/A 

L
A

N
 s

e
m

 f
io

 

Pontos de acesso internos      

 Pontos de acesso gerenciados por controlador (APs) Aruba 
Vida útil

10
 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A 90 dias (somente 

para correção de bug) 

 3WN/P, 155/P, pontos de acesso remoto Aruba 108/109 
(RAPs)  Vida útil

10
 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A 

Imagem 
atualizada 

periodicamente
13

 

 Pontos de acesso instantâneo Aruba (IAPs) 
Vida útil

10
 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A 

Imagem 
atualizada 

periodicamente
13

 

 M330, M2xx 
Vida útil

5
 Envio no PDU 

Desde que sejam de 
propriedade5 

90 dias 
Desde que sejam 
de propriedade4 

 Ponto de Acesso OfficeConnect 20 

3 anos
14

 Envio no PDU 

90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia

14
 

90 dias de suporte 
telefônico bate-papo 

todo o período da 
garantia

14
 

Desde que sejam 
de propriedade4 

Controladores      

 Controladores Aruba
 

1 ano 
30 dias 

PDU/Devolução 
à fábrica

11
 

90 dias
12

 N/A N/A 

 Switches de acesso a mobilidade Aruba 
Vida útil

10
 Envio no PDU 90 dias 90 dias 

Desde que sejam 
de propriedade4 

Outros produtos de WLAN       

 Pontos de acesso externos Gerenciados pelo Controlador 
Aruba Série 2xx Vida útil

10
 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A 90 dias (somente 

para correção de bug) 

 Pontos de acesso instantâneo externos Aruba Série 2xx 
(IAPs) Vida útil

10
 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A 

Imagem 
atualizada 

periodicamente
13

 

 Dispositivos AirWave, Dispositivos ClearPass, Dispositivos 
IntroSpect 1 ano 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias

12
 

N/A 
90 dias (somente 

para correção de bug) 

 Roteadores de malha sem fio para ambiente externo 
MST2HP, MST2HAC, MSR2KP, MSR4KP Aruba 1 ano 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias

12
 N/A 90 dias (somente 

para correção de bug) 

 Beacons Aruba 
90 dias 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A 90 dias (somente 

para correção de bug) 

 Sensores de capa 
90 dias 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A 90 dias (somente 

para correção de bug) 

 Fontes de alimentação, antenas e acessórios Aruba 
1 ano 

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A N/A 
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Resumo da garantia e suporte do produto da HPE Networking
 
(outubro de 

2018) 
 

A versão mais atual deste documento está disponível em www.hpe.com/networking/warrantysummary 
Detalhes da política de garantia do produto de rede da HPE estão disponíveis em www.hpe.com/networking/warranty 

Informações sobre os serviços para produtos HPE Networking podem ser encontradas em www.hpe.com/networking/services  
 As informações contidas neste documento estão sujeitas a alterações sem aviso prévio. As garantias para produtos e serviços da HPE são as estabelecidas nas 

declarações de garantia expressa que acompanham tais produtos e serviços. Além disso, nossos produtos já vêm com garantias que não podem ser excluídas sob as leis 
do consumidor da Austrália e Nova Zelândia. Sujeitas às informações anteriores, nenhuma informação aqui descrita deve ser interpretada como parte de uma garantia 

adicional. A HPE não se responsabiliza por erros técnicos ou editoriais ou omissões contidos neste documento. 

 
 

 

 

R
o

te
a
d

o
re

s
 

Roteadores      

 
88xx, HSR68xx 1 ano 10 dias 1 ano 

N/A Desde que sejam de 
propriedade4 

 
HSR66xx, 66xx, MSR50, MSR4xxx, MSR3xxx, MSR30 1 ano 10 dias 1 ano 

90 dias Desde que sejam de 
propriedade4 

 
MSR2xxx, MSR20, MSR1xxx, MSR9xx 1 ano Envio no PDU 1 ano 

90 dias Desde que sejam de 
propriedade4 

 ALU 77xx 
1 ano

9
 

Devolução para 
a fábrica

9
 

1 ano
9
 N/A 

Todas as 
atualizações de 

licença adquiridas9 

 Roteadores VSR  
90 dias 

(Somente mídia) 
N/A 90 dias N/A 

Todas as 
atualizações de 

licença adquiridas8 

G
e

re
n

c
ia

m
e

n
to

 

Gerenciamento de rede      

 Centro de gerenciamento inteligente (detalhes do suporte em 

www.hpe.com/networking/IMCSupport) 
90 dias 

 (Somente mídia) 
N/A 90 dias N/A 90 dias (somente para 

correção de bug) 

 AirWave, ALE, Aruba Central, ClearPass, Meridian, VIA, Visual RF 90 dias 
 (Somente mídia) 

N/A 90 dias N/A 90 dias (somente para 

correção de bug) 

 Controlador HPE VAN SDN e aplicativos HPE SDN 90 dias 
 (Somente mídia) 

N/A 90 dias N/A Todas as 
atualizações de 

licença adquiridas8
 

 Rede em nuvem distribuída HPE  90 dias 
 (Somente mídia) 

N/A N/A N/A Nenhum 

 Dispositivos controladores da Big Switch Networks (Consulte 

www.bigswitch.com/support para detalhes sobre garantia e suporte) 
N/D

16
 N/D

16
 N/D

16
 N/D

16
 N/D

16
 

P
ro

d
u

to
s
 d

e
 r

e
d

e
 a

d
ic

io
n

a
is

 

Transceptores      

 Transceptores Aruba (Números dos produtos transceptores JWxxxx para 
Controladores e Switches MAS) 1 ano  

30 dias 
PDU/Devolução 

à fábrica
11

 
90 dias N/A N/A 

 Transceptores da marca Aruba (exceto os números dos produtos 
transceptores JWxxxx) 
 e 
HPE X244, X242, X142, X132, X131, X129, X122, X121, X119, X112, X111 

Vida útil
5
 Envio no PDU Desde que 

sejam de 
propriedade5 

N/A N/A 

 Transceptores Aruba 100G 1 ano 10 dias 1 ano N/A N/A 

 HPE X2A0, X240, X190, X180, X170, X160, X150, X140, X135, X130, 
X125, X124, X120, X115, X114, X110 

1 ano 30 dias 1 ano N/A N/A 

 

1) Fontes de alimentação, módulos e acessórios removíveis, como antenas, ventiladores, cabos 
de alimentação, etc., podem ter cobertura de garantia diferente do dispositivo de host. 
Consulte a referência rápida de cobertura de garantia do HPE Networking em 
www.hpe.com/networking/warrantyquickref para obter mais detalhes.  

2) O tempo de resposta baseia-se em um esforço comercialmente razoável e está sujeito a um 
tempo de corte de envio diário. Em alguns países e regiões e de acordo com determinadas 
restrições do fornecedor o tempo de resposta pode variar. Entre em contato com a sua 
organização de serviço HPE local para obter a disponibilidade de tempo de resposta em sua 
área. Envio PDU = Envio no próximo dia útil. 

3) O suporte técnico da garantia por telefone ou meio eletrônico é fornecido durante o horário 
comercial da HPE local para todo o período de garantia para os fins de diagnóstico de 
defeitos de hardware ou software. Muitos produtos adquiridos após 1º de dezembro de 2015 
incluem 90 dias de suporte técnico 24 horas por dia, 7 dias por semana, conforme indicado. 
Consulte a declaração de garantia limitada Hewlett-Packard do produto para obter detalhes 
adicionais da cobertura. Serviços de cobertura estendida estão disponíveis. 

4) Inclui todas as versões de software/OS geralmente disponíveis oferecidas para os produtos 
específicos listados, quando e se disponíveis, enquanto o cliente possuir o produto, exceto 
onde observado. Algumas versões do software podem exigir hardware adicional ou novo. 
Clientes que desejem que atualizações, correções e ajustes de recurso específicos sejam 
priorizados em versões futuras, devem adquirir os serviços de suporte apropriados da HPE. 

5) Para os produtos adquiridos após 1º de dezembro de 2014, a garantia se estende somente 
enquanto o usuário final original possuir o produto. Inclui a cobertura de qualquer ventilador e 
fonte de alimentação incorporados por todo o período de garantia. Um comprovante de 
aquisição ou de arrendamento pode ser exigido como condição para que exista direito ao 
serviço de garantia.  

6) Garantia de hardware, suporte técnico e todas as versões de software fornecidas para 
hardware e apenas UM OS de serviço, quando e se disponíveis, enquanto o usuário final 
original possuir o produto. Consulte documentação específica do produto para suporte ao 
aplicativo. 5 anos de garantia na unidade de disco nos módulos de zl de serviços avançados 
HPE Alliance One. 

7) Produtos comprados antes de 1º de agosto de 2013 incluem 1 ano de suporte técnico e 1 
ano (somente correção de bugs).  

8) Inclui todas as atualizações de software oferecidas para a versão licenciada, quando e se 
disponível. Atualizações de software vão requerer a compra de SKU, pacote de serviços de 
suporte ou contrato apropriado. 

9) Todo o suporte técnico, de hardware e de software para produtos de ALU 77xx é fornecido 
diretamente somente pela Alcatel-Lucent e não pela HPE. Para suporte da Alcatel-Lucent, 
selecione o país do qual o cliente está ligando no link a seguir e ele mostrará as informações 
de contato de suporte da ALU apropriadas: https://Services.support.Alcatel-
Lucent.com/product_support/. A garantia de hardware requer o envio de produtos com falha 
para a ALU para o reparo ou reposição. O custo de logística para o envio de produto no local 
do cliente para o local da ALU para reparo ou reposição será coberto pelo cliente. Versões de 
manutenção de software estão incluídas para a principal versão do software adquirida. As 
principais atualizações de versão do software não estão incluídas. Serviços podem ser 
adquiridos na HPE ou na Alcatel-Lucent para expandir sua cobertura de suporte e upgrades 
de software. O suporte será fornecido pela Alcatel Lucent para esses serviços. 

10) Para os produtos adquiridos depois de 1º de dezembro de 2015, o hardware tem garantia 
estendida somente enquanto o usuário final original possuir o produto e está limitada a cinco 
(5) anos a partir da data de término da venda. 

11) Para os primeiros 30 dias a partir do envio, a HPE fornecerá a substituição 
antecipada de envio no mesmo dia para os produtos de hardware cobertos. Depois 
de trinta (30) dias a partir do envio e durante o período de garantia restante, a HPE 
substituirá ou reparará qualquer produto fora de conformidade e o devolverá em 
condição de operação, enviando após o recebimento da HPE do produto fora de 
conformidade por meio do procedimento RMA da HPE, com recebimento pelo 
cliente em até dez (10) dias em uma base comercialmente razoável. 

12) A HPE fornecerá uma resposta por e-mail no próximo dia útil com o propósito de 
diagnosticar defeitos de hardware ou software durante o horário comercial no 
Horário do Pacífico para os primeiros 90 dias após a compra.  

13) A HPE disponibilizará uma imagem de versão de software de OS instantânea 
recente no portal de software. Essa imagem também está disponível para pontos de 
acesso remoto (RAPs) que estejam executando o OS instantâneo. 

14) Esses produtos são cobertos por 90 dias de suporte telefônico 24x7. 
Posteriormente, apenas suporte por bate-papo estará disponível para o período 
restante da garantia. A garantia de vida útil limitada (quando aplicável) é estendida 
somente enquanto o usuário final original possuir o produto e está limitada a 5 
(cinco) anos a partir do final da data de venda.  Esta garantia inclui a cobertura de 
qualquer ventilador embutido e fonte de alimentação por todo o período de garantia. 
Um comprovante de aquisição ou de arrendamento pode ser exigido como condição 
para que exista direito ao serviço de garantia. Consulte 
www.hpe.com/OfficeConnect/support/ para mais informações sobre o novo 
processo de suporte do OfficeConnect.  

15) Todo o suporte técnico de hardware e de software para produtos Arista é fornecido 
diretamente pela Arista e não pela HPE. Consulte a página de suporte ao cliente da 
Arista para informações de contato: https://www.arista.com/en/support/customer-
support. Os custos de transporte, se houver, relacionados à devolução de um 
hardware defeituoso para um centro de reparos Arista será custeado pelo cliente. A 
Arista irá pagar quaisquer custos de transporte relacionados a uma nova entrega de 
um Hardware reparado ou substituído. Serviços podem ser adquiridos na HPE ou 
na Arista para expandir sua cobertura de suporte e upgrades de software. O suporte 
será fornecido pela Arista para esses serviços. Para obter detalhes sobre a garantia 
e suporte da Arista, consulte: http://www.arista.com/assets/data/pdf/Warranty.pdf. 

16) Todo o suporte técnico de hardware e de software para produtos Big Switch 
Networks é fornecido diretamente pela BSN e não pela HPE. Consulte a página de 
atendimento ao cliente da Big Switch Networks para informações de contato: 
www.bigswitch.com/support. Para detalhes sobre opções de garantia e suporte da 
Big Switch Networks, consulte: 
http://bigswitch.com/sites/default/files/bsn_support_and_maintenance_policy.v2.2.20
16.11.14.pdf. 
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Declaration of Conformity  
based on ISO/IEC 17050-1 and EN 17050-1 

 

1 / 2 

 

©DoC #: RSVLC-1418 R2 / en 
Manufacturer's Name: Hewlett Packard Enterprise Company 
Manufacturer's Address: 8000 Foothills Blvd, Roseville, CA 95747, USA 

declare, under its sole responsibility that the product: 

Product Name and/or Model: Please refer to ANNEX I 
Regulatory Model Number: RSVLC-1418 

Product Options: All 

conforms to the following product specifications and regulations: 

Safety Electromagnetic Compatibility 
IEC 60950-1:2005 +A1:2009 +A2:2013  
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 60825-1:2007  
EN 62479:2010  

EN 55022:2010 Class A  
EN 55024:2010  
EN 61000-3-2:2014  
EN 61000-3-3:2013  
FCC CFR 47 Part 15 Class A  

Restriction of the use of certain hazardous substances 
EN 50581:2012 

The product herewith complies with the requirements of Directive 2014/35/EU relating to electrical equipment designed for 
use within certain voltage limits, Directive 2014/30/EU relating to electromagnetic compatibility, Directive 2011/65/EU on the 
restriction of the use of certain hazardous substances in electrical and electronic equipment and carries the CE marking 
accordingly. 

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: 
(1) This device may not cause harmful interference, and (2) this device must accept any interference received, including 
interference that may cause undesired operation. 

Additional Information 

This product is assigned a Regulatory Model Number which stays with the regulatory aspects of the design. The Regulatory 
Model Number is the main product identifier in the regulatory documentation and test reports, this number should not be 
confused with the marketing name or the product numbers. 

This product was tested in a typical HPE environment. 

 

 
Roseville, CA Brent Ford, Manager 
20.09.2016 HPE Networking, CEB Business Organization 

Local contact for regulatory topics only 

EU: Hewlett Packard GmbH, HPE HQ-TRE, 71029 Boeblingen, Germany 
U.S.:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Declaration of Conformity  
based on ISO/IEC 17050-1 and EN 17050-1 

 

2 / 2 

 

Product Name and/or Model 

Aruba 2930F 24G 4SFP+ Swch  (JL253A) 

Aruba 2930F 48G 4SFP+ Swch  (JL254A) 

Aruba 2930F 24G 4SFP Swch  (JL259A) 

Aruba 2930F 48G 4SFP Swch  (JL260A) 

Aruba 2540 24G 4SFP+ Swch  (JL354A) 

Aruba 2540 48G 4SFP+ Swch  (JL355A) 

ANNEX I 

Regulatory Model Number: RSVLC-1418 
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Декларация за Cъответствие  
съг ласно ISO/IEC 17050-1 и EN 17050-1 

 

1 / 2 

 

ДзC #: RSVLC-1418 R2 / bg 

Име на производителя: Hewlett Packard Enterprise Company 
Адрес на производителя: 8000 Foothills Blvd, Roseville, CA 95747, USA 

декларира на собствена отговорност, че продуктът: 

име и/или модел на продукта: Моля, направете справка Приложение I 
нормативен номер на модела: RSVLC-1418 

опции на продукта: целият 

съответства на следните спецификации на продукта и регламенти: 

безопасност Eлектромагнитната Cъвмест

имост 
IEC 60950-1:2005 +A1:2009 +A2:2013  
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 60825-1:2007  
EN 62479:2010  

EN 55022:2010 Class A  
EN 55024:2010  
EN 61000-3-2:2014  
EN 61000-3-3:2013  
FCC CFR 47 Part 15 Class A  

Oграничението за употребата на определени опасни вещ

ества 
EN 50581:2012 

Този продукт отговаря на изискванията на Директива 2014/35/ЕС относно електрически съоръжения, 
предназначени за използване при някои ограничения на напрежението, Директива 2014/30/ЕС относно 
електромагнитната съвместимост, Директива 2011/65/ЕС относно ограничението за употребата на определени 
опасни вещества в електрическото и електронното оборудване и носи съответната маркировка CE. 

Допълнителна информация 

Този продукт има нормативен номер на модела, който съответства на нормативните аспекти на дизайна. 
Нормативният номер на модела е основният идентификатор на продукта в нормативната документация и 
протоколите от тестовете, като този номер не трябва да се бърка с търговското име или номерата на продукта. 

Този продукт е изпитван в типична среда на HPE. 

 

 
Roseville, CA Brent Ford, Управител 
20.09.2016 HPE Networking, CEB Business Organization 

Информация за връзка в съответния регион само по правни въпроси 

ЕС: Hewlett Packard GmbH, HPE HQ-TRE, 71029 Boeblingen, Germany 
САЩ:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Декларация за Cъответствие  
съг ласно ISO/IEC 17050-1 и EN 17050-1 

 

2 / 2 

 

име и/или модел на продукта 

Aruba 2930F 24G 4SFP+ Swch  (JL253A) 

Aruba 2930F 48G 4SFP+ Swch  (JL254A) 

Aruba 2930F 24G 4SFP Swch  (JL259A) 

Aruba 2930F 48G 4SFP Swch  (JL260A) 

Aruba 2540 24G 4SFP+ Swch  (JL354A) 

Aruba 2540 48G 4SFP+ Swch  (JL355A) 

Приложение I 

нормативен номер на модела: RSVLC-1418 
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Prohlášení o Shodě  
na základě ISO/IEC 17050-1 a EN 17050-1 

 

1 / 2 

 

PoS #: RSVLC-1418 R2 / cs 
Název výrobce: Hewlett Packard Enterprise Company 
Adresa výrobce: 8000 Foothills Blvd, Roseville, CA 95747, USA 

prohlašuje na svou odpovědnost, že výrobek: 

Název Produktu a/nebo model: Podívejte se prosím DODATEK I 
Regulační číslo modelu: RSVLC-1418 

Možnosti výrobku: Všichni 

je v souladu s následující specializací výrobků a nařízeními: 

Bezpečnost Elektromagnetické Kompatibility 
IEC 60950-1:2005 +A1:2009 +A2:2013  
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 60825-1:2007  
EN 62479:2010  

EN 55022:2010 Class A  
EN 55024:2010  
EN 61000-3-2:2014  
EN 61000-3-3:2013  
FCC CFR 47 Part 15 Class A  

Omezení používání některých nebezpečných látek 
EN 50581:2012 

Tento výrobek splňuje požadavky Směrnice 2014/35/EU týkajících se elektrických zařízení určených pro používání v určitých 
mezích napětí, Směrnice 2014/30/EU týkajících se elektromagnetické kompatibility, Směrnice 2011/65/EU o omezení 
používání některých nebezpečných látek v elektrických a elektronických zařízeních a je správně CE označený. 

Další informace 

Výrobek má přidělené regulační číslo modelu, které je v souladu s regulačními aspekty designu. Regulační číslo modelu je 
hlavní identifikátor výrobku v regulační dokumentaci a v protokolu o zkoušce a není možné ho zaměňovat s obchodním 
názvem nebo číslem výrobku. 

Tento výrobek byl testovaný v typickém HPE prostředí. 

 

 
Roseville, CA Brent Ford, Manažer 
20.09.2016 HPE Networking, CEB Business Organization 

Místní kontakt výhradně pro regulační záležitosti 
EU: Hewlett Packard GmbH, HPE HQ-TRE, 71029 Boeblingen, Germany 
USA:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Prohlášení o Shodě  
na základě ISO/IEC 17050-1 a EN 17050-1 

 

2 / 2 

 

Název Produktu a/nebo model 

Aruba 2930F 24G 4SFP+ Swch  (JL253A) 

Aruba 2930F 48G 4SFP+ Swch  (JL254A) 

Aruba 2930F 24G 4SFP Swch  (JL259A) 

Aruba 2930F 48G 4SFP Swch  (JL260A) 

Aruba 2540 24G 4SFP+ Swch  (JL354A) 

Aruba 2540 48G 4SFP+ Swch  (JL355A) 

DODATEK I 

Regulační číslo modelu: RSVLC-1418 
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Overensstemmelseserklæring  
baseret på ISO/IEC 17050-1 og EN 17050-1 

 

1 / 2 

 

OE #: RSVLC-1418 R2 / da 
Producents navn: Hewlett Packard Enterprise Company 
Producents adresse: 8000 Foothills Blvd, Roseville, CA 95747, USA 

erklærer under eget ansvar, at produktet: 

Produktnavn og/eller model: Der henvises TILLÆG I 
Lovpligtigt modelnummer: RSVLC-1418 

Produktmuligheder: Alle 

opfylder følgende produktspecifikationer og bestemmelser: 

Sikkerhed Elektromagnetisk Kompatibilitet 
IEC 60950-1:2005 +A1:2009 +A2:2013  
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 60825-1:2007  
EN 62479:2010  

EN 55022:2010 Class A  
EN 55024:2010  
EN 61000-3-2:2014  
EN 61000-3-3:2013  
FCC CFR 47 Part 15 Class A  

Begrænsning af anvendelsen af visse farlige stoffer 
EN 50581:2012 

Produktet overholder hermed kravene i Direktiv 2014/35/EF lovgivning om elektrisk materiel bestemt til anvendelse inden for 
visse spændingsgrænser, Direktiv 2014/30/EF lovgivning om elektromagnetisk kompatibilitet, Direktiv 2011/65/EF om 
begrænsning af anvendelsen af visse farlige stoffer i elektrisk og elektronisk udstyr og bærer CE mærkningen i 
overensstemmelse hermed. 

Yderligere information 

Dette produkt er tildelt et lovpligtigt modelnummer, som forbliver ved de lovgivningsmæssige aspekter af designet. Det 
lovpligtige modelnummer er den primære produktidentifkator i den lovgivningsmæssige dokumentation og testrapporter, 
dette nummer bør ikke forveksles med markedsføringsnavnet eller produktnumrene. 

Dette produkt blev testet I et typisk HPE-miljø. 

 

 
Roseville, CA Brent Ford, Leder 
20.09.2016 HPE Networking, CEB Business Organization 

Lokal kontakt, kun til lovgivningsmæssige spørgsmål 
EU: Hewlett Packard GmbH, HPE HQ-TRE, 71029 Boeblingen, Germany 
U.S.:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
 

  

Anexo 09 A 16 ITENS 8 E 9 (0592738)         SEI 0008478-63.2018.6.02.8000 / pg. 8032

http://www.hpe.com/eu/certificates


 

Overensstemmelseserklæring  
baseret på ISO/IEC 17050-1 og EN 17050-1 

 

2 / 2 

 

Produktnavn og/eller model 

Aruba 2930F 24G 4SFP+ Swch  (JL253A) 

Aruba 2930F 48G 4SFP+ Swch  (JL254A) 

Aruba 2930F 24G 4SFP Swch  (JL259A) 

Aruba 2930F 48G 4SFP Swch  (JL260A) 

Aruba 2540 24G 4SFP+ Swch  (JL354A) 

Aruba 2540 48G 4SFP+ Swch  (JL355A) 

TILLÆG I 

Lovpligtigt modelnummer: RSVLC-1418 
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Konformitätserklärung  
basierend auf ISO/IEC 17050-1 und EN 17050-1 

 

1 / 2 

 

KE #: RSVLC-1418 R2 / de 
Name des Herstellers: Hewlett Packard Enterprise Company 
Adresse des Herstellers: 8000 Foothills Blvd, Roseville, CA 95747, USA 

erklärt in alleiniger Verantwortung, dass das Produkt: 

Produktbezeichnung und/oder Modell: Siehe ANHANG I 
Behördliche Modellnummer: RSVLC-1418 

Produktoptionen: Alle 

den folgenden Produktspezifikationen und Richtlinien entspricht: 

Sicherheit Elektromagnetische Verträglichkeit 
IEC 60950-1:2005 +A1:2009 +A2:2013  
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 60825-1:2007  
EN 62479:2010  

EN 55022:2010 Class A  
EN 55024:2010  
EN 61000-3-2:2014  
EN 61000-3-3:2013  
FCC CFR 47 Part 15 Class A  

Beschränkung der Verwendung bestimmter gefährlicher Stoffe 
EN 50581:2012 

Das Produkt entspricht hiermit den Anforderungen von Richtlinie 2014/35/EU betreffend elektrische Betriebsmittel zur 
Verwendung innerhalb bestimmter Spannungsgrenzen, Richtlinie 2014/30/EU über die elektromagnetische Verträglichkeit, 
Richtlinie 2011/65/EU zur Beschränkung der Verwendung bestimmter gefährlicher Stoffe in Elektro- und Elektronikgeräten 
und trägt dementsprechend die CE Kennzeichnung. 

Zusatzinformation 

Diesem Produkt wird eine behördliche Modellnummer zugeordnet, welche an die behördlichen Aspekte des Designs 
gebunden ist. Die behördliche Modellnummer ist das Hauptproduktkennzeichen in der behördlichen Dokumentation und in 
Prüfberichten; diese Nummer ist nicht mit dem Marketingnamen oder den Produktnummern zu verwechseln. 

Dieses Produkt wurde in einer typischen HPE-Umgebung getestet. 

 

 
Roseville, CA Brent Ford, Leiter 
20.09.2016 HPE Networking, CEB Business Organization 

Lokaler Ansprechpartner ausschließlich für behördliche Themen 

EU: Hewlett Packard GmbH, HPE HQ-TRE, 71029 Boeblingen, Germany 
U.S.:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Konformitätserklärung  
basierend auf ISO/IEC 17050-1 und EN 17050-1 

 

2 / 2 

 

Produktbezeichnung und/oder Modell 

Aruba 2930F 24G 4SFP+ Swch  (JL253A) 

Aruba 2930F 48G 4SFP+ Swch  (JL254A) 

Aruba 2930F 24G 4SFP Swch  (JL259A) 

Aruba 2930F 48G 4SFP Swch  (JL260A) 

Aruba 2540 24G 4SFP+ Swch  (JL354A) 

Aruba 2540 48G 4SFP+ Swch  (JL355A) 

ANHANG I 

Behördliche Modellnummer: RSVLC-1418 
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ΔΗΛΩΣΗ ΣΥΜΜΟΡΦΩΣΗΣ  
σύμφωνα με  τ α πρότ υπα ISO/IEC 17050-1 και  EN 17050-1 

 

1 / 2 

 

Δσ #: RSVLC-1418 R2 / el 

Επωνυμία κατασκευαστή: Hewlett Packard Enterprise Company 
Διεύθυνση κατασκευαστή: 8000 Foothills Blvd, Roseville, CA 95747, USA 

δηλώνει, μεαποκλειστική του ευθύνη, ότι το προϊόν: 

Όνομα ή/και μοντέλο προϊόντος: Παρακαλώ αναφερθείτε ΠΑΡΑΡΤΗΜΑ I 
Αριθμός μοντέλου σύμφωνα με τη 
νομοθεσία: 

RSVLC-1418 

Προαιρετικά χαρακτηριστικάπροϊόντος: όλοι 

Συμμορφώνεται προς τις ακόλουθες προδιαγραφές και κανονισμούς: 

ασφάλεια ηλεκτρομαγνητική συμβατότ

ητα 
IEC 60950-1:2005 +A1:2009 +A2:2013  
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 60825-1:2007  
EN 62479:2010  

EN 55022:2010 Class A  
EN 55024:2010  
EN 61000-3-2:2014  
EN 61000-3-3:2013  
FCC CFR 47 Part 15 Class A  

τον περιορισμό της χρήσης ορισμένων επικίνδυνων ουσιών 
EN 50581:2012 

Το παρόν προϊόν συμμορφώνεται προς τις απαιτήσεις της Οδηγία 2014/35/ΕΕ των αναφερομένων στο ηλεκτρολογικό 
υλικό που προορίζεται να χρησιμοποιηθεί εντός ορισμένων ορίων τάσεως, Οδηγία 2014/30/ΕΕ σχετικά με την 
ηλεκτρομαγνητική συμβατότητα, Οδηγία 2011/65/ΕΕ για τον περιορισμό της χρήσης ορισμένων επικίνδυνων ουσιών 
σε ηλεκτρικό και ηλεκτρονικό εξοπλισμό και φέρει την ανάλογη σήμανση CE. 

Πρόσθετεςπληροφορίες 

Τοπαρόν προϊόν συνοδεύεται από τον αριθμό μοντέλου που προβλέπεται από τη νομοθεσία σχετικά με τον 
σχεδιασμό του. Ο εν λόγω κανονιστικός αριθμός μοντέλου είναι ο κύριος αναγνωριστικός αριθμός του προϊόντος στα 
έγγραφα ρυθμιστικού χαρακτήρα και στις εκθέσεις δοκιμών, και δεν πρέπει να συγχέεται με την εμπορική ονομασία 
ή τους αριθμούς προϊόντος για σκοπούς εμπορικής διάθεσης. 

Το παρόν προϊόν δοκιμάστηκε σε πρότυπο περιβάλλον της Hewlett Packard Enterprise. 

 

 
Roseville, CA Brent Ford, διαχειριστής 
20.09.2016 HPE Networking, CEB Business Organization 

Στοιχεία επικοινωνίας αποκλειστικά για κανονιστικά ζητήματα 

ΕΕ: Hewlett Packard GmbH, HPE HQ-TRE, 71029 Boeblingen, Germany 
ΗΠΑ:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
 

  

Anexo 09 A 16 ITENS 8 E 9 (0592738)         SEI 0008478-63.2018.6.02.8000 / pg. 8036

http://www.hpe.com/eu/certificates


 

ΔΗΛΩΣΗ ΣΥΜΜΟΡΦΩΣΗΣ  
σύμφωνα με  τ α πρότ υπα ISO/IEC 17050-1 και  EN 17050-1 

 

2 / 2 

 

Όνομα ή/και μοντέλο προϊόντος 

Aruba 2930F 24G 4SFP+ Swch  (JL253A) 

Aruba 2930F 48G 4SFP+ Swch  (JL254A) 

Aruba 2930F 24G 4SFP Swch  (JL259A) 

Aruba 2930F 48G 4SFP Swch  (JL260A) 

Aruba 2540 24G 4SFP+ Swch  (JL354A) 

Aruba 2540 48G 4SFP+ Swch  (JL355A) 

ΠΑΡΑΡΤΗΜΑ I 

Αριθμός μοντέλου σύμφωνα με τη νομοθεσία
: RSVLC-1418 
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Declaración de Conformidad  
basada en las normas ISO/IEC 17050-1 y EN 17050-1 

 

1 / 2 

 

DdC #: RSVLC-1418 R2 / es 
Nombre del fabricante: Hewlett Packard Enterprise Company 
Dirección del fabricante: 8000 Foothills Blvd, Roseville, CA 95747, USA 

declara bajo su sola responsabilidad que el producto: 

Nombre del producto y/o modelo: Por favor, consulte ANEXO I 
Número de modelo reglamentario: RSVLC-1418 

Opciones del producto: Totos 

cumple con las siguientes especificaciones y regulaciones de productos: 

Seguridad  Compatibilidad Electromagnética 
IEC 60950-1:2005 +A1:2009 +A2:2013  
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 60825-1:2007  
EN 62479:2010  

EN 55022:2010 Class A  
EN 55024:2010  
EN 61000-3-2:2014  
EN 61000-3-3:2013  
FCC CFR 47 Part 15 Class A  

Restricciones a la utilización de determinadas sustancias peligrosas 
EN 50581:2012 

El producto adjunto cumple con los requisitos de la Directiva 2014/35/UE sobre el material eléctrico destinado a utilizarse con 
determinados límites de tensión, Directiva 2014/30/UE en materia de compatibilidad electromagnética, Directiva 2011/65/UE 
sobre restricciones a la utilización de determinadas sustancias peligrosas en aparatos eléctricos y electrónicos y porta el 
marcado CE correspondiente. 

Información adicional 

Este producto tiene asignado un número de modelo reglamentario en consonancia con los aspectos normativos del diseño. El 
número de modelo reglamentario es el principal identificador del producto en la documentación reglamentaria y en los 
informes de ensayo. No se debería confundir este número con el nombre comercial ni con los números comerciales del 
producto. 

Este producto ha sido testado en un entorno típico de HPE. 

 

 
Roseville, CA Brent Ford, Manager 
20.09.2016 HPE Networking, CEB Business Organization 

Contactos nacionales solo para temas normativos 

UE: Hewlett Packard GmbH, HPE HQ-TRE, 71029 Boeblingen, Germany 
USA.:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Declaración de Conformidad  
basada en las normas ISO/IEC 17050-1 y EN 17050-1 

 

2 / 2 

 

Nombre del producto y/o modelo 

Aruba 2930F 24G 4SFP+ Swch  (JL253A) 

Aruba 2930F 48G 4SFP+ Swch  (JL254A) 

Aruba 2930F 24G 4SFP Swch  (JL259A) 

Aruba 2930F 48G 4SFP Swch  (JL260A) 

Aruba 2540 24G 4SFP+ Swch  (JL354A) 

Aruba 2540 48G 4SFP+ Swch  (JL355A) 

ANEXO I 

Número de modelo reglamentario: RSVLC-1418 

Anexo 09 A 16 ITENS 8 E 9 (0592738)         SEI 0008478-63.2018.6.02.8000 / pg. 8039



 

Vastavusdeklaratsioon  
vastab standarditele ISO/IEC 17050-1 ja EN 17050-1 
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VD #: RSVLC-1418 R2 / et 
Tootja nimetus: Hewlett Packard Enterprise Company 
Tootja aadress: 8000 Foothills Blvd, Roseville, CA 95747, USA 

deklareerib oma ainuvastutusel, et toode: 

Toote nimetus ja/või mudel: Palun vaadake LISA I 
Normatiivse mudeli number: RSVLC-1418 

Toote variandid: Kõik 

vastab järgmistele toote kohta käivatele spetsifikatsioonidele ja regulatiivsetele dokumentidele: 

Ohutus Elektromagnetilise Ühilduvuse 
IEC 60950-1:2005 +A1:2009 +A2:2013  
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 60825-1:2007  
EN 62479:2010  

EN 55022:2010 Class A  
EN 55024:2010  
EN 61000-3-2:2014  
EN 61000-3-3:2013  
FCC CFR 47 Part 15 Class A  

Teatavate ohtlike ainete kasutamise piiramise kohta 
EN 50581:2012 

Käesolev toode vastab Direktiiv 2014/35/EL teatavates pingevahemikes kasutatavaid elektriseadmeid käsitlevate, Direktiiv 
2014/30/EL mis käsitleb elektromagnetilise ühilduvuse, Direktiiv 2011/65/EL teatavate ohtlike ainete kasutamise piiramise 
kohta elektri- ja elektroonikaseadmetes ja on tähistatud vastavalt CE tähisega. 

Lisateave 

Tootele on omistatud normatiivse mudeli number, mis vastab konstruktsiooni normatiivsetele aspektidele. Normatiivse 
mudeli number on normatiivsetes dokumentides ja katsetuste aruannetes toote peamiseks identifikaatoriks, seda numbrit ei 
tohi segamini ajada turundusnumbri või toote numbriga. 

Toodet on katsetatud HPE keskkonnas. 

 

 
Roseville, CA Brent Ford, Juhataja 
20.09.2016 HPE Networking, CEB Business Organization 

Kohalik kontakt üksnes normatiivsetes küsimustes 

EU: Hewlett Packard GmbH, HPE HQ-TRE, 71029 Boeblingen, Germany 
U.S.:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Vastavusdeklaratsioon  
vastab standarditele ISO/IEC 17050-1 ja EN 17050-1 

 

2 / 2 

 

Toote nimetus ja/või mudel 

Aruba 2930F 24G 4SFP+ Swch  (JL253A) 

Aruba 2930F 48G 4SFP+ Swch  (JL254A) 

Aruba 2930F 24G 4SFP Swch  (JL259A) 

Aruba 2930F 48G 4SFP Swch  (JL260A) 

Aruba 2540 24G 4SFP+ Swch  (JL354A) 

Aruba 2540 48G 4SFP+ Swch  (JL355A) 

LISA I 

Normatiivse mudeli number: RSVLC-1418 
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Vaatimustenmukaisuusvakuutus  
standardien ISO/IEC 17050-1 ja EN 17050-1 

 

1 / 2 

 

Vaatimustenmukaisuusvakuutus #: RSVLC-1418 R2 / fi 
Valmistajan nimi: Hewlett Packard Enterprise Company 
Valmistajan osoite: 8000 Foothills Blvd, Roseville, CA 95747, USA 

vakuuttaa yksinomaisella vastuullaan, että tuote: 

Tuotteen nimi ja/tai malli: Opit luvussa LIITE I 
Lainsäädännön edellyttämä mallinumero: RSVLC-1418 

Tuotevaihtoehdot: Kaiken 

noudattavat seuraavia tuotemäärityksiä ja määräyksiä: 

Turvallisuus Sähkömagneettista Yhteensopivuutta 
IEC 60950-1:2005 +A1:2009 +A2:2013  
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 60825-1:2007  
EN 62479:2010  

EN 55022:2010 Class A  
EN 55024:2010  
EN 61000-3-2:2014  
EN 61000-3-3:2013  
FCC CFR 47 Part 15 Class A  

Tiettyjen vaarallisten aineiden käytön rajoittamisesta 
EN 50581:2012 

Tuote noudattaa täten Direktiivi 2014/35/EU sähkölaitteita tietyllä jännitealueella koskevan, Direktiivi 2014/30/EU 
sähkömagneettista yhteensopivuutta koskevan, Direktiivi 2011/65/EU tiettyjen vaarallisten aineiden käytön rajoittamisesta 
sähkö- ja elektroniikkalaitteissa vaatimuksia, ja näin ollen sillä on CE merkintä. 

Lisätietoja 

Tälle tuotteelle on osoitettu lainsäädännön edellyttämä mallinumero, joka pysyy samana mallin lainsäädännöllisten 
näkökulmien mukaisesti. Lainsäädännön edellyttämä mallinumero on tuotteen päätunniste lainsäädännöllisissä asiakirjoissa 
ja testiraporteissa, ja tätä numeroa ei saa sekoittaa markkinointinimeen tai tuotenumeroihin. 

Tämä tuote testattiin tyypillisessä HPE-ympäristössä. 

 

 
Roseville, CA Brent Ford, Johtaja 
20.09.2016 HPE Networking, CEB Business Organization 

Paikallinen yhteyshenkilö vain lainsäädännöllisille aiheille 

EU: Hewlett Packard GmbH, HPE HQ-TRE, 71029 Boeblingen, Germany 
U.S.:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Vaatimustenmukaisuusvakuutus  
standardien ISO/IEC 17050-1 ja EN 17050-1 

 

2 / 2 

 

Tuotteen nimi ja/tai malli 

Aruba 2930F 24G 4SFP+ Swch  (JL253A) 

Aruba 2930F 48G 4SFP+ Swch  (JL254A) 

Aruba 2930F 24G 4SFP Swch  (JL259A) 

Aruba 2930F 48G 4SFP Swch  (JL260A) 

Aruba 2540 24G 4SFP+ Swch  (JL354A) 

Aruba 2540 48G 4SFP+ Swch  (JL355A) 

LIITE I 

Lainsäädännön edellyttämä mallinumero: RSVLC-1418 
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Déclaration de Conformité  
basée sur ISO/IEC 17050-1 et EN 17050-1 

 

1 / 2 

 

DdC #: RSVLC-1418 R2 / fr 
Nom du fabricant: Hewlett Packard Enterprise Company 
Adresse du fabricant: 8000 Foothills Blvd, Roseville, CA 95747, USA 

déclare, sous sa seule responsabilité, que le produit: 

Nom du produit et/ou modèle: Se il vous plaît se référer ANNEXE I 
Numéro de modèle de règlementation: RSVLC-1418 

Options de produit: Tout 

est conforme aux règlementations et spécifications de produit suivantes: 

Sécurité Compatibilité électromagnétique 
IEC 60950-1:2005 +A1:2009 +A2:2013  
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 60825-1:2007  
EN 62479:2010  

EN 55022:2010 Class A  
EN 55024:2010  
EN 61000-3-2:2014  
EN 61000-3-3:2013  
FCC CFR 47 Part 15 Class A  

Limitation de l’utilisation de certaines substances dangereuses 
EN 50581:2012 

Le présent produit satisfait aux exigences de la Directive 2014/35/EU relatives au matériel électrique destiné à être employé 
dans certaines limites de tension, Directive 2014/30/EU concernant la compatibilité électromagnétique, Directive 2011/65/EU 
relative à la limitation de l’utilisation de certaines substances dangereuses dans les équipements électriques et électroniques 
et arbore la marque CE en conséquence. 

Renseignements complémentaires 

Un numéro de modèle de règlementation, qui demeure avec les aspects règlementaires de conception, est attribué à ce 
produit. Le numéro de modèle de règlementation est le principal élément d’identification du produit dans la documentation 
sur la documentation réglementaire et les rapports d’essai, ce numéro ne doit pas être confondu avec le nom commercial ou 
les numéros de produit. 

Ce produit a été testé dans un environnement HPE caractéristique. 

 

 
Roseville, CA Brent Ford, Responsable 
20.09.2016 HPE Networking, CEB Business Organization 

Contact local pour les sujets de réglementation uniquement 

UE: Hewlett Packard GmbH, HPE HQ-TRE, 71029 Boeblingen, Germany 
USA:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Déclaration de Conformité  
basée sur ISO/IEC 17050-1 et EN 17050-1 

 

2 / 2 

 

Nom du produit et/ou modèle 

Aruba 2930F 24G 4SFP+ Swch  (JL253A) 

Aruba 2930F 48G 4SFP+ Swch  (JL254A) 

Aruba 2930F 24G 4SFP Swch  (JL259A) 

Aruba 2930F 48G 4SFP Swch  (JL260A) 

Aruba 2540 24G 4SFP+ Swch  (JL354A) 

Aruba 2540 48G 4SFP+ Swch  (JL355A) 

ANNEXE I 

Numéro de modèle de règlementation: RSVLC-1418 
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Izjava o Sukladnosti  
na temelju norme ISO/IEC 17050-1 i EN 17050-1 
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IoS #: RSVLC-1418 R2 / hr 
Naziv proizvođača: Hewlett Packard Enterprise Company 
Adresa proizvođača: 8000 Foothills Blvd, Roseville, CA 95747, USA 

izjavljujem, pod punom odgovornošću, da je proizvod: 

Naziv i/ili model proizvoda: Molimo pogledajte ANNEX I 
Regulatorna oznaka modela: RSVLC-1418 

Opcije proizvoda: Sav 

u skladu sa sljedećim Specifikacijama proizvoda i propisima: 

Osigurač Elektromagnetsku Kompatibilnost 
IEC 60950-1:2005 +A1:2009 +A2:2013  
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 60825-1:2007  
EN 62479:2010  

EN 55022:2010 Class A  
EN 55024:2010  
EN 61000-3-2:2014  
EN 61000-3-3:2013  
FCC CFR 47 Part 15 Class A  

Ograničenje uporabe određenih opasnih tvari 
EN 50581:2012 

Navedeni proizvod u skladu je sa zahtjevima Direktiva 2014/35/EU u odnosu na električnu opremu namijenjenu za uporabu 
unutar određenih naponskih granica, Direktiva 2014/30/EU u odnosu na elektromagnetsku kompatibilnost, Direktiva 
2011/65/EU o ograničenju uporabe određenih opasnih tvari u električnoj i elektroničkoj opremi i sukladno tome sadrži oznaku 
CE. 

Dodatni podaci 

Ovom proizvodu dodijeljena je Regulatorna oznaka modela, koja je u skladu s regulatornim aspektima konstrukcije proizvoda. 
Regulatorna oznaka modela glavna je identifikacijska oznaka proizvoda u regulatornoj dokumentaciji i izvještajima o 
ispitivanju i tu se oznaku ne smije zabunom zamijeniti za tržišno ime ili brojeve  proizvoda. 

Ovaj proizvod je ispitan u tipičnom HPE okruženju. 

 

 
Roseville, CA Brent Ford, Voditelj 
20.09.2016 HPE Networking, CEB Business Organization 

Lokalni podaci za kontakt isključivo za regulatorna pitanja 

EU: Hewlett Packard GmbH, HPE HQ-TRE, 71029 Boeblingen, Germany 
SAD:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Izjava o Sukladnosti  
na temelju norme ISO/IEC 17050-1 i EN 17050-1 
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Naziv i/ili model proizvoda 

Aruba 2930F 24G 4SFP+ Swch  (JL253A) 

Aruba 2930F 48G 4SFP+ Swch  (JL254A) 

Aruba 2930F 24G 4SFP Swch  (JL259A) 

Aruba 2930F 48G 4SFP Swch  (JL260A) 

Aruba 2540 24G 4SFP+ Swch  (JL354A) 

Aruba 2540 48G 4SFP+ Swch  (JL355A) 

ANNEX I 

Regulatorna oznaka modela: RSVLC-1418 
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Megfelelőségi Nyilatkozat  
az ISO/IEC és 17050-1 EN 17050-1 
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MN #: RSVLC-1418 R2 / hu 
Gyártó neve: Hewlett Packard Enterprise Company 
Gyártó címe: 8000 Foothills Blvd, Roseville, CA 95747, USA 

teljes felelősséggel kijelenti hogy az alábbi termék: 

Termék neve és/vagy modellje: Kérlek hivatkozz MELLÉKLET I 
Hatósági típusszám: RSVLC-1418 

Termékopciók: Minden 

megfelel az alábbi termékspecifikációknak és előírásoknak: 

Biztonság Elektromágneses Összeférhetőségre 
IEC 60950-1:2005 +A1:2009 +A2:2013  
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 60825-1:2007  
EN 62479:2010  

EN 55022:2010 Class A  
EN 55024:2010  
EN 61000-3-2:2014  
EN 61000-3-3:2013  
FCC CFR 47 Part 15 Class A  

Korlátozásáról egyes veszélyes anyagok való alkalmazásának 
EN 50581:2012 

A termék a jelen nyilatkozat szerint megfelel a 2014/35/EU irányelve elektromos berendezésekre a meghatározott 
feszültséghatáron belüli használatra tervezett vonatkozó, 2014/30/EU irányelve az elektromágneses összeférhetőségre 
vonatkozó, 2011/65/EU irányelve egyes veszélyes anyagok elektromos és elektronikus berendezésekben való alkalmazásának 
korlátozásáról irányelv követelményeinek és ennek alapján található rajta a jelölés. 

További információk 

A termékhez meghatározott hatósági típusszám a kivitel szabályozási szempontjaihoz kapcsolódik. A hatósági típusszám 
szerepel a hatósági dokumentumokban és vizsgálati jelentésekben a termék fő azonosítójaként. Nem összetévesztendő a 
piaci névvel vagy a termék azonosítószámaival. 

A terméket tipikus HPE vállalati környezetben vizsgálták. 

 

 
Roseville, CA Brent Ford, Igazgató 
20.09.2016 HPE Networking, CEB Business Organization 

Helyi elérhetőség hatósági témákhoz 

EU: Hewlett Packard GmbH, HPE HQ-TRE, 71029 Boeblingen, Germany 
U.S.:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Megfelelőségi Nyilatkozat  
az ISO/IEC és 17050-1 EN 17050-1 
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Termék neve és/vagy modellje 

Aruba 2930F 24G 4SFP+ Swch  (JL253A) 

Aruba 2930F 48G 4SFP+ Swch  (JL254A) 

Aruba 2930F 24G 4SFP Swch  (JL259A) 

Aruba 2930F 48G 4SFP Swch  (JL260A) 

Aruba 2540 24G 4SFP+ Swch  (JL354A) 

Aruba 2540 48G 4SFP+ Swch  (JL355A) 

MELLÉKLET I 

Hatósági típusszám: RSVLC-1418 
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Dichiarazione di Conformità  
ai sensi della norma ISO/IEC 17050-1 e EN 17050-1 
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DdC #: RSVLC-1418 R2 / it 
Nome del fabbricante: Hewlett Packard Enterprise Company 
Indirizzo del fabbricante: 8000 Foothills Blvd, Roseville, CA 95747, USA 

dichiara, sotto la propria esclusiva responsabilità, che il prodotto: 

Nome del prodotto e/o modello: Per favore, riferisci ALLEGATO I 
Numero di matricola: RSVLC-1418 

Opzioni del prodotto: Tutti 

è conforme alle seguenti Specifiche del prodotto e ai seguenti regolamenti: 

Sicurezza Compatibilità Elettromagnetica 
IEC 60950-1:2005 +A1:2009 +A2:2013  
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 60825-1:2007  
EN 62479:2010  

EN 55022:2010 Class A  
EN 55024:2010  
EN 61000-3-2:2014  
EN 61000-3-3:2013  
FCC CFR 47 Part 15 Class A  

Restrizione dell’uso di determinate sostanze pericolose 
EN 50581:2012 

Il prodotto è conforme ai requisiti della Direttiva 2014/35/UE relative al materiale elettrico destinato ad essere adoperato 
entro taluni limiti di tensione, Direttiva 2014/30/UE relative alla compatibilità elettromagnetica, Direttiva 2011/65/UE sulla 
restrizione dell’uso di determinate sostanze pericolose nelle apparecchiature elettriche ed elettroniche e pertanto reca il 
marchio CE. 

Informazioni aggiuntive 

A questo prodotto viene assegnato un numero di matricola secondo gli aspetti normativi della progettazione. Il numero di 
matricola normativo è il codice principale di identificazione del prodotto nella documentazione prevista dalla normativa e nei 
verbali di prova, questo numero non deve essere confuso con il nome commerciale o con il codice articolo del prodotto. 

Questo prodotto è stato testato in un tipico ambiente HPE. 

 

 
Roseville, CA Brent Ford, Responsabile 
20.09.2016 HPE Networking, CEB Business Organization 

Contatti locali solo per gli aspetti normativi 
UE: Hewlett Packard GmbH, HPE HQ-TRE, 71029 Boeblingen, Germany 
USA:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Dichiarazione di Conformità  
ai sensi della norma ISO/IEC 17050-1 e EN 17050-1 
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Nome del prodotto e/o modello 

Aruba 2930F 24G 4SFP+ Swch  (JL253A) 

Aruba 2930F 48G 4SFP+ Swch  (JL254A) 

Aruba 2930F 24G 4SFP Swch  (JL259A) 

Aruba 2930F 48G 4SFP Swch  (JL260A) 

Aruba 2540 24G 4SFP+ Swch  (JL354A) 

Aruba 2540 48G 4SFP+ Swch  (JL355A) 

ALLEGATO I 

Numero di matricola: RSVLC-1418 
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Atitikties Deklaracija  
pagal ISO/IEC 17050-1 ir EN 17050-1 
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AD #: RSVLC-1418 R2 / lt 
Gamintojo pavadinimas: Hewlett Packard Enterprise Company 
Gamintojo adresas: 8000 Foothills Blvd, Roseville, CA 95747, USA 

Atsakingai pareiškia, kad produktas: 

Produkto pavadinimas ir / ar modelis: Prašome kreiptis PRIEDAS I 
Reglamentinis modelio numeris: RSVLC-1418 

Produkto parinktys: Visiškai 

atitinka tokias produkto specifikacijas ir reglamentus: 

Saugumas Elektromagnetiniu Suderinamumu 
IEC 60950-1:2005 +A1:2009 +A2:2013  
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 60825-1:2007  
EN 62479:2010  

EN 55022:2010 Class A  
EN 55024:2010  
EN 61000-3-2:2014  
EN 61000-3-3:2013  
FCC CFR 47 Part 15 Class A  

apribojimas naudojimo dėl tam tikrų pavojingų medžiagų  
EN 50581:2012 

Produktas atitinka Žemos įtampos direktyvos Direktyva 2014/35/ES susijusių su elektrotechniniais gaminiais, skirtais naudoti 
tam tikrose įtampos ribose, suderinimo, Direktyva 2014/30/ES susijusių su elektromagnetiniu suderinamumu, Direktyva 
2011/65/ES dėl tam tikrų pavojingų medžiagų naudojimo elektros ir elektroninėje įrangoje apribojimo reikalavimus ir turi 
atitinkamą CE ženklinimą. 

Papildoma informacija 

Šiam produktui yra priskirtas Reglamentinis modelio numeris, kuris priklauso nuo projekto reglamentavimo aspektų. 
Reglamentinis numeris yra pagrindinis produkto identifikatorius reglamentavimo dokumentuose ir bandymų ataskaitose, šis 
numeris neturėtų būti painiojamas su rinkodaros pavadinimu ar produkto numeriais. 

Šis produktas buvo išbandytas įprastoje HPE aplinkoje. 

 

 
Roseville, CA Brent Ford, Menedžeris 
20.09.2016 HPE Networking, CEB Business Organization 

Vietiniai kontaktai tik reglamentavimo klausimais 

ES: Hewlett Packard GmbH, HPE HQ-TRE, 71029 Boeblingen, Germany 
JAV:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Atitikties Deklaracija  
pagal ISO/IEC 17050-1 ir EN 17050-1 
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Produkto pavadinimas ir / ar modelis 

Aruba 2930F 24G 4SFP+ Swch  (JL253A) 

Aruba 2930F 48G 4SFP+ Swch  (JL254A) 

Aruba 2930F 24G 4SFP Swch  (JL259A) 

Aruba 2930F 48G 4SFP Swch  (JL260A) 

Aruba 2540 24G 4SFP+ Swch  (JL354A) 

Aruba 2540 48G 4SFP+ Swch  (JL355A) 

PRIEDAS I 

Reglamentinis modelio numeris: RSVLC-1418 
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Atbilstības Deklarācija  
pamatojoties uz ISO/IEC 17050-1 un EN 17050-1 
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AD #: RSVLC-1418 R2 / lv 
Ražotāja nosaukums: Hewlett Packard Enterprise Company 
Ražotāja adrese: 8000 Foothills Blvd, Roseville, CA 95747, USA 

kā vienīgais atbildīgais par produkta kvalitāti paziņo, ka produkts: 

Produkta nosaukums un/vai modelis: Lūdzu, skatiet PIELIKUMS I 
Tehniskais modeļa numurs: RSVLC-1418 

Produkta komplektācija: Viss 

atbilst šādām produkta specifikācijām un noteikumiem: 

Drošība Elektromagnētisko Savietojamību 
IEC 60950-1:2005 +A1:2009 +A2:2013  
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 60825-1:2007  
EN 62479:2010  

EN 55022:2010 Class A  
EN 55024:2010  
EN 61000-3-2:2014  
EN 61000-3-3:2013  
FCC CFR 47 Part 15 Class A  

Izmantošanas ierobežošanu par dažu bīstamu vielu 
EN 50581:2012 

Šis produkts atbilst šādu tiesību aktu prasībām: Direktīva 2014/35/ES saskaņošanu attiecībā uz elektroiekārtām, kas 
paredzētas lietošanai noteiktās sprieguma robežās, Direktīva 2014/30/ES kas attiecas uz elektromagnētisko savietojamību, 
Direktīva 2011/65/ES par dažu bīstamu vielu izmantošanas ierobežošanu elektriskās un elektroniskās iekārtās un tam ir 
atbilstošs CE marķējums. 

Papildinformācija 

Šim produktam ir piešķirts tehniskais modeļa numurs, kas norāda uz produkta dizaina normatīvajiem aspektiem. Tehniskais 
modeļa numurs ir galvenais produkta identifikators normatīvajos dokumentos un testēšanas ziņojumos. Šo numuru nedrīkst 
sajaukt ar produkta tirdzniecības nosaukumu vai numuru. 

Šis produkts tika testēts standarta HPE vidē. 

 

 
Roseville, CA Brent Ford, Menedžeris 
20.09.2016 HPE Networking, CEB Business Organization 

Vietējo pārstāvniecību kontaktinformācija tikai jautājumiem par normatīvajiem produkta aspektiem 

ES: Hewlett Packard GmbH, HPE HQ-TRE, 71029 Boeblingen, Germany 
ASV:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Atbilstības Deklarācija  
pamatojoties uz ISO/IEC 17050-1 un EN 17050-1 
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Produkta nosaukums un/vai modelis 

Aruba 2930F 24G 4SFP+ Swch  (JL253A) 

Aruba 2930F 48G 4SFP+ Swch  (JL254A) 

Aruba 2930F 24G 4SFP Swch  (JL259A) 

Aruba 2930F 48G 4SFP Swch  (JL260A) 

Aruba 2540 24G 4SFP+ Swch  (JL354A) 

Aruba 2540 48G 4SFP+ Swch  (JL355A) 

PIELIKUMS I 

Tehniskais modeļa numurs: RSVLC-1418 
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Dikjarazzjoni ta 'Konformità  
bbażata fuq ISO/IEC 17050-1 u EN 17050-1 
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Dt'K #: RSVLC-1418 R2 / mt 
Isem il-manifattur: Hewlett Packard Enterprise Company 
Indirizz tal-manifattur: 8000 Foothills Blvd, Roseville, CA 95747, USA 

jiddikjaraw, taħt ir-responsabbiltà unika tagħhom li l-prodott: 

Isem il-prodott u/jew mudell: Jekk jogħġbok irreferi ANNESS I 
Numru tal-Mudell Regolatorju: RSVLC-1418 

Għażliet tal-prodott: Kull 

jikkonforma mal-ispeċifikazzjonijiet u r-regolamenti li ġejjin: 

Sigurtà Kompatibilità Elettromanjetika 
IEC 60950-1:2005 +A1:2009 +A2:2013  
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 60825-1:2007  
EN 62479:2010  

EN 55022:2010 Class A  
EN 55024:2010  
EN 61000-3-2:2014  
EN 61000-3-3:2013  
FCC CFR 47 Part 15 Class A  

Restrizzjoni tal-użu ta’ ċerti sustanzi perikolużi 
EN 50581:2012 

Dan il-prodott jikkonforma mar-rekwiżiti tad- Direttiva 2014/35/UE dwar mat-tagħmir elettriku ddisinjat għall-użu fi ħdan 
ċerti limiti tal-voltaġġ, Direttiva 2014/30/UE x'jaqsmu mal-kompatibilità elettromanjetika, Direttiva 2011/65/UE dwar ir-
restrizzjoni tal-użu ta’ ċerti sustanzi perikolużi fit-tagħmir elettriku u elettroniku u jġorr il-marka korrispondenti CE. 

Aktar informazzjoni 

Dan il-prodott għandu Numru tal-Mudell Regolatorju li jinżamm mal-aspetti regolatorji tad-disinn. In-Numru tal-Mudell 
Regolatorju huwa l-identifikatur prinċipali fid-dokumentazzjoni regolatorja u r-rapporti tat-testijiet. Dan in-numru m'għandux 
jiġi konfuż mal-isem kummerċjali jew in-numri tal-prodott. 

Dan il-prodott ġie ttestjat f'ambjent tipiku ta' HPE. 

 

 
Roseville, CA Brent Ford, Maniġer 
20.09.2016 HPE Networking, CEB Business Organization 

Kuntatt lokali għal suġġetti regolatorji biss 

EU: Hewlett Packard GmbH, HPE HQ-TRE, 71029 Boeblingen, Germany 
U.S.:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Dikjarazzjoni ta 'Konformità  
bbażata fuq ISO/IEC 17050-1 u EN 17050-1 

 

2 / 2 

 

Isem il-prodott u/jew mudell 

Aruba 2930F 24G 4SFP+ Swch  (JL253A) 

Aruba 2930F 48G 4SFP+ Swch  (JL254A) 

Aruba 2930F 24G 4SFP Swch  (JL259A) 

Aruba 2930F 48G 4SFP Swch  (JL260A) 

Aruba 2540 24G 4SFP+ Swch  (JL354A) 

Aruba 2540 48G 4SFP+ Swch  (JL355A) 

ANNESS I 

Numru tal-Mudell Regolatorju: RSVLC-1418 
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Conformiteitsverklaring  
op basis van ISO/IEC 17050-1 en EN 17050-1 
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CV #: RSVLC-1418 R2 / nl 
Naam producent: Hewlett Packard Enterprise Company 
Adres producent: 8000 Foothills Blvd, Roseville, CA 95747, USA 

verklaart, onder haar eigen verantwoordelijkheid, dat het product: 

Productnaam en/of model: Raadpleeg BIJLAGE I 
Wettelijk modelnummer: RSVLC-1418 

Productopties: Alle 

voldoet aan de volgende productspecificaties en reguleringen: 

Veiligheid Elektromagnetische Compatibiliteit 
IEC 60950-1:2005 +A1:2009 +A2:2013  
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 60825-1:2007  
EN 62479:2010  

EN 55022:2010 Class A  
EN 55024:2010  
EN 61000-3-2:2014  
EN 61000-3-3:2013  
FCC CFR 47 Part 15 Class A  

Beperking van het gebruik van bepaalde gevaarlijke stoffen 
EN 50581:2012 

Het product voldoet hierbij aan de vereisten van Richtlijn 2014/35/EU inzake elektrisch materiaal bestemd voor gebruik 
binnen bepaalde spanningsgrenzen, Richtlijn 2014/30/EU inzake elektromagnetische compatibiliteit, Richtlijn 2011/65/EU 
betreffende beperking van het gebruik van bepaalde gevaarlijke stoffen in elektrische en elektronische apparatuur en is 
voorzien van het bijbehorende keurmerk. 

Aanvullende informatie 

Aan dit product is een wettelijk modelnummer toegekend dat de wettelijke aspecten van het ontwerp betreft. Het wettelijk 
modelnummer is de belangrijkste identificatie van het product in de wettelijke documentatie en testberichten. Dit nummer 
mag niet worden verwisseld met de marketingnaam of de productnummers. 

Dit product is getested in een specifieke HPE-omgeving. 

 

 
Roseville, CA Brent Ford, Manager 
20.09.2016 HPE Networking, CEB Business Organization 

Lokaal contact, uitsluitend voor wettelijke kwesties 

EU: Hewlett Packard GmbH, HPE HQ-TRE, 71029 Boeblingen, Germany 
U.S.:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Conformiteitsverklaring  
op basis van ISO/IEC 17050-1 en EN 17050-1 

 

2 / 2 

 

Productnaam en/of model 

Aruba 2930F 24G 4SFP+ Swch  (JL253A) 

Aruba 2930F 48G 4SFP+ Swch  (JL254A) 

Aruba 2930F 24G 4SFP Swch  (JL259A) 

Aruba 2930F 48G 4SFP Swch  (JL260A) 

Aruba 2540 24G 4SFP+ Swch  (JL354A) 

Aruba 2540 48G 4SFP+ Swch  (JL355A) 

BIJLAGE I 

Wettelijk modelnummer: RSVLC-1418 

Anexo 09 A 16 ITENS 8 E 9 (0592738)         SEI 0008478-63.2018.6.02.8000 / pg. 8059



 

Deklaracja Zgodności  
oparta na ISO/IEC 17050-1 oraz EN 17050-1 

 

1 / 2 

 

DZ #: RSVLC-1418 R2 / pl 
Nazwa producenta: Hewlett Packard Enterprise Company 
Adres producenta: 8000 Foothills Blvd, Roseville, CA 95747, USA 

deklaruje z pełną odpowiedzialnością, że produkt: 

Nazwa produktu i/lub model: Proszę odnieś się ZAŁĄCZNIK I 
Numer modelu regulacyjnego: RSVLC-1418 

Opcje produktu: Wszyscy 

jest dostosowany do następujących specyfikacji produktu i regulacji: 

Bezpieczeństwo Kompatybilności Elektromagnetycznej 
IEC 60950-1:2005 +A1:2009 +A2:2013  
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 60825-1:2007  
EN 62479:2010  

EN 55022:2010 Class A  
EN 55024:2010  
EN 61000-3-2:2014  
EN 61000-3-3:2013  
FCC CFR 47 Part 15 Class A  

Ograniczenia stosowania niektórych niebezpiecznych substancji 
EN 50581:2012 

Niniejszy produkt jest zgodny z wymaganiami dyrektywy Dyrektywa 2014/35/WE odnoszących się do sprzętu elektrycznego 
przewidzianego do stosowania w określonych granicach napięcia, Dyrektywa 2014/30/WE odnoszących się 
do kompatybilności elektromagnetycznej, Dyrektywa 2011/65/WE w sprawie ograniczenia stosowania niektórych 
niebezpiecznych substancji w sprzęcie elektrycznym i elektronicznym posiada odpowiednie oznaczenie CE. 

Dodatkowe informacje 

Produkt ma przypisany numer modelu regulacyjnego, który wiąże się z aspektami regulacyjnymi jego wzornictwa. Numer 
modelu regulacyjnego jest głównym identyfikatorem produktu w dokumentacji regulacyjnej i raportach z testów, nie wolno 
mylić tego numeru z nazwą marketingową lub numerami produktu. 

Produkt został przetestowany w typowym środowisku Firmy Hewlett Packard Enterprise (HPE). 

 

 
Roseville, CA Brent Ford, Menażer 
20.09.2016 HPE Networking, CEB Business Organization 

Lokalny adres kontaktowy – tylko w sprawach regulacyjnych 

UE: Hewlett Packard GmbH, HPE HQ-TRE, 71029 Boeblingen, Germany 
USA:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Deklaracja Zgodności  
oparta na ISO/IEC 17050-1 oraz EN 17050-1 

 

2 / 2 

 

Nazwa produktu i/lub model 

Aruba 2930F 24G 4SFP+ Swch  (JL253A) 

Aruba 2930F 48G 4SFP+ Swch  (JL254A) 

Aruba 2930F 24G 4SFP Swch  (JL259A) 

Aruba 2930F 48G 4SFP Swch  (JL260A) 

Aruba 2540 24G 4SFP+ Swch  (JL354A) 

Aruba 2540 48G 4SFP+ Swch  (JL355A) 

ZAŁĄCZNIK I 

Numer modelu regulacyjnego: RSVLC-1418 
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Declaração de Conformidade  
com base na ISO/IEC 17050-1 e EN 17050-1 

 

1 / 2 

 

DdC #: RSVLC-1418 R2 / pt 
Nome do fabricante: Hewlett Packard Enterprise Company 
Endereço do fabricante: 8000 Foothills Blvd, Roseville, CA 95747, USA 

declara, sob sua exclusiva responsabilidade, que o produto: 

Nome e/ou Modelo do Produto: Por favor, consulte ANEXO I 
Número de Modelo Regulamentar: RSVLC-1418 

Opções de produto: Todo 

Em conformidade com as seguintes especificações de produto e diretivas: 

Segurança Compatibilidade Electromagnética 
IEC 60950-1:2005 +A1:2009 +A2:2013  
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 60825-1:2007  
EN 62479:2010  

EN 55022:2010 Class A  
EN 55024:2010  
EN 61000-3-2:2014  
EN 61000-3-3:2013  
FCC CFR 47 Part 15 Class A  

Restrição do uso de determinadas substâncias perigosas 
EN 50581:2012 

O produto está em conformidade com os requisitos da Directiva 2014/35/UE no domínio do material eléctrico destinado a ser 
utilizado dentro de certos limites de tensão, Directiva 2014/30/UE respeitantes à compatibilidade electromagnética, Directiva 
2011/65/UE relativa à restrição do uso de determinadas substâncias perigosas em equipamentos eléctricos e electrónicos , 
bem como detém a respetiva marcação CE. 

Informação adicional 

O presente produto detém um Número de Modelo Regulamentar, correspondente aos aspetos regulamentares do design. O 
Número de Modelo regulamentar é o principal identificador do produto presente na documentação regulamentar e nos 
relatórios de teste; este número não deve ser confundido com o nome de marketing ou os números do produto. 

O presente produto foi testado num ambiente tipicamente HPE. 

 

 
Roseville, CA Brent Ford, Manager 
20.09.2016 HPE Networking, CEB Business Organization 

Contato local apenas para assuntos regulamentares 

UE: Hewlett Packard GmbH, HPE HQ-TRE, 71029 Boeblingen, Germany 
EUA:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Declaração de Conformidade  
com base na ISO/IEC 17050-1 e EN 17050-1 

 

2 / 2 

 

Nome e/ou Modelo do Produto 

Aruba 2930F 24G 4SFP+ Swch  (JL253A) 

Aruba 2930F 48G 4SFP+ Swch  (JL254A) 

Aruba 2930F 24G 4SFP Swch  (JL259A) 

Aruba 2930F 48G 4SFP Swch  (JL260A) 

Aruba 2540 24G 4SFP+ Swch  (JL354A) 

Aruba 2540 48G 4SFP+ Swch  (JL355A) 

ANEXO I 

Número de Modelo Regulamentar: RSVLC-1418 
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Declaratie de Conformitate  
conform ISO/IEC 17050-1 si EN 17050-1 

 

1 / 2 

 

DdC #: RSVLC-1418 R2 / ro 
Numele producătorului: Hewlett Packard Enterprise Company 
Adresa producatorului: 8000 Foothills Blvd, Roseville, CA 95747, USA 

declară, pe proprie răspundere că produsul: 

Nume produs și/sau Model: Vă rugăm să consultați ANEXA I 
Cod de reglementare model: RSVLC-1418 

Opțiuni produs: Toate 

este conform următoarelor specificații și reglementări ale produsului: 

Siguranță Compatibilitatea Electromagnetică 
IEC 60950-1:2005 +A1:2009 +A2:2013  
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 60825-1:2007  
EN 62479:2010  

EN 55022:2010 Class A  
EN 55024:2010  
EN 61000-3-2:2014  
EN 61000-3-3:2013  
FCC CFR 47 Part 15 Class A  

Restricțiile de utilizare a anumitor substanțe periculoase în echipamentele 
EN 50581:2012 

Produsul se conformează cerințelor Directiva 2014/35/EU privind echipamentele electrice destinate utilizării în cadrul unor 
anumite limite de tensiune, Directiva 2014/30/EU cu privire la compatibilitatea electromagnetică, Directiva 2011/65/EU 
privind restricțiile de utilizare a anumitor substanțe periculoase în echipamentele electrice și electronice E și poartă în mod 
corespunzător marca . 

Informații adiționale 

Acestui produs îi este atribuit un cod de reglementare al modelului care se referă la aspectele de reglementare ale designului. 
Codul de reglementare al produsului este principalul cod de identificare al produsului în documentele de reglementare și 
rapoartele de testare, acest cod nu trebuie confundat cu denumirea de marketing sau codurile produsului. 

Acest produs a fost testat într-un mediu standard HPE. 

 

 
Roseville, CA Brent Ford, Manager 
20.09.2016 HPE Networking, CEB Business Organization 

Date de contact locale privind numai probleme de reglementare 

EU: Hewlett Packard GmbH, HPE HQ-TRE, 71029 Boeblingen, Germany 
U.S.:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Declaratie de Conformitate  
conform ISO/IEC 17050-1 si EN 17050-1 

 

2 / 2 

 

Nume produs și/sau Model 

Aruba 2930F 24G 4SFP+ Swch  (JL253A) 

Aruba 2930F 48G 4SFP+ Swch  (JL254A) 

Aruba 2930F 24G 4SFP Swch  (JL259A) 

Aruba 2930F 48G 4SFP Swch  (JL260A) 

Aruba 2540 24G 4SFP+ Swch  (JL354A) 

Aruba 2540 48G 4SFP+ Swch  (JL355A) 

ANEXA I 

Cod de reglementare model: RSVLC-1418 

Anexo 09 A 16 ITENS 8 E 9 (0592738)         SEI 0008478-63.2018.6.02.8000 / pg. 8065



 

Vyhlásenie o Zhode  
na základe ISO/IEC 17050-1 a EN 17050-1 

 

1 / 2 

 

VoZ #: RSVLC-1418 R2 / sk 
Názov výrobcu: Hewlett Packard Enterprise Company 
Adresa výrobcu: 8000 Foothills Blvd, Roseville, CA 95747, USA 

na svoju výlučnú zodpovednosť prehlasuje, že výrobok: 

Názov výrobku a/alebo model: Pozrite sa prosím DODATOK I 
Regulačné číslo modelu: RSVLC-1418 

Možnosti výrobku: Celý 

je v súlade s nasledujúcou špecializáciou výrokov a nariadeniami: 

Bezpečnosť Elektromagnetickú Kompatibilitu 
IEC 60950-1:2005 +A1:2009 +A2:2013  
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 60825-1:2007  
EN 62479:2010  

EN 55022:2010 Class A  
EN 55024:2010  
EN 61000-3-2:2014  
EN 61000-3-3:2013  
FCC CFR 47 Part 15 Class A  

Obmedzení používania určitých nebezpečných látok 
EN 50581:2012 

Tento výrobok spĺňa požiadavky Smernica 2014/35/EÚ týkajúcich sa elektrického zariadenia určeného na používanie v rámci 
určitých limitov napätia, Smernica 2014/30/EÚ vzťahujúcich sa na elektromagnetickú kompatibilitu, Smernica 2011/65/EÚ o 
obmedzení používania určitých nebezpečných látok v elektrických a elektronických zariadeniach a je správne CE označený. 

Ďalšie informácie 

Výrobok má pridelené regulačné číslo modelu, ktorý je v súlade s regulačnými aspektami dizajnu. Regulačné číslo modelu je 
hlavný identifikátor výrobku v regulačnej dokumentácii a v protokole o skúške a nemožno ho zamieňať s obchodným názvom 
alebo číslom výrobku. 

Tento výrobok bol testovaný v typickom HPE prostredí. 

 

 
Roseville, CA Brent Ford, Manažér 
20.09.2016 HPE Networking, CEB Business Organization 

Miestny kontakt výhradne pre regulačné záležitosti 
EU: Hewlett Packard GmbH, HPE HQ-TRE, 71029 Boeblingen, Germany 
USA:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Vyhlásenie o Zhode  
na základe ISO/IEC 17050-1 a EN 17050-1 

 

2 / 2 

 

Názov výrobku a/alebo model 

Aruba 2930F 24G 4SFP+ Swch  (JL253A) 

Aruba 2930F 48G 4SFP+ Swch  (JL254A) 

Aruba 2930F 24G 4SFP Swch  (JL259A) 

Aruba 2930F 48G 4SFP Swch  (JL260A) 

Aruba 2540 24G 4SFP+ Swch  (JL354A) 

Aruba 2540 48G 4SFP+ Swch  (JL355A) 

DODATOK I 

Regulačné číslo modelu: RSVLC-1418 
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Izjava o Skladnosti  
na osnovi ISO/IEC 17050-1 ter EN 17050-1 

 

1 / 2 

 

IoS #: RSVLC-1418 R2 / sl 
Ime proizvajalca: Hewlett Packard Enterprise Company 
Naslov proizvajalca: 8000 Foothills Blvd, Roseville, CA 95747, USA 

Izjavlja z vso odgovornostjo, da je izdelek: 

Ime izdelka in/ali model: Za več informacij glej ANEKS I 
Odobritvena številka modela: RSVLC-1418 

Možnosti izdelka: Vse 

ustreza sledečim specifikacijam izdelka ter predpisom: 

Varnost Elektromagnetno Združljivostjo 
IEC 60950-1:2005 +A1:2009 +A2:2013  
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 60825-1:2007  
EN 62479:2010  

EN 55022:2010 Class A  
EN 55024:2010  
EN 61000-3-2:2014  
EN 61000-3-3:2013  
FCC CFR 47 Part 15 Class A  

Omejevanje uporabe nekaterih nevarnih snovi 
EN 50581:2012 

Proizvod je skladen z zahtevami Direktiva 2014/35/EU zvezi z električno opremo, konstruirano za uporabo znotraj določenih 
napetostnih mej, Direktiva 2014/30/EU v zvezi z elektromagnetno združljivostjo, Direktiva 2011/65/EU o omejevanju uporabe 
nekaterih nevarnih snovi v električni in elektronski opremi  in temu primerno nosi oznako CE. 

Dodatne informacije 

Temu izdelku je dodeljena odobritvena številka modela, ki izhaja iz regulativnega stališča oblikovanja. Odobritvena številka 
modela je glavni identifikator izdelka v dokumentaciji predpisov in testnih poročilih, te številke ne gre zamešati z 
marketinškim imenom ali številkami izdelka. 

Ta izdelek je bil testiran v tipičnem HPE okolju. 

 

 
Roseville, CA Brent Ford, Manager 
20.09.2016 HPE Networking, CEB Business Organization 

Lokalni stik – izključno za zadeve glede predpisov 

EU: Hewlett Packard GmbH, HPE HQ-TRE, 71029 Boeblingen, Germany 
U.S.:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Izjava o Skladnosti  
na osnovi ISO/IEC 17050-1 ter EN 17050-1 

 

2 / 2 

 

Ime izdelka in/ali model 

Aruba 2930F 24G 4SFP+ Swch  (JL253A) 

Aruba 2930F 48G 4SFP+ Swch  (JL254A) 

Aruba 2930F 24G 4SFP Swch  (JL259A) 

Aruba 2930F 48G 4SFP Swch  (JL260A) 

Aruba 2540 24G 4SFP+ Swch  (JL354A) 

Aruba 2540 48G 4SFP+ Swch  (JL355A) 

ANEKS I 

Odobritvena številka modela: RSVLC-1418 

Anexo 09 A 16 ITENS 8 E 9 (0592738)         SEI 0008478-63.2018.6.02.8000 / pg. 8069



 

Försäkran om Överensstämmelse  
i enlighet med ISO/IEC 17050-1 och EN 17050-1 

 

1 / 2 

 

FoÖ #: RSVLC-1418 R2 / sv 
Tillverkarens namn: Hewlett Packard Enterprise Company 
Tillverkarens adress: 8000 Foothills Blvd, Roseville, CA 95747, USA 

deklarerar under eget ansvar att produkten: 

Produktnamn och/eller modell: Var god hänvisa BILAGA I 
Föreskriftenligt modellnummer: RSVLC-1418 

Produktalternativ: Alla 

överensstämmer med följande produktspecifikationer och föreskrifter: 

Säkerhet Elektromagnetisk Kompatibilitet 
IEC 60950-1:2005 +A1:2009 +A2:2013  
EN 60950-1:2006 + A11:2009 +A1:2010 +A12:2011 +A2:2013  
EN 60825-1:2007  
EN 62479:2010  

EN 55022:2010 Class A  
EN 55024:2010  
EN 61000-3-2:2014  
EN 61000-3-3:2013  
FCC CFR 47 Part 15 Class A  

Begränsning av användning av vissa farliga ämnen 
EN 50581:2012 

Produkten överensstämmer med kraven i Direktiv 2014/35/EU lagstiftning om elektrisk utrustning avsedd för användning 
inom vissa spänningsgränser, Direktiv 2014/30/EU lagstiftning om elektromagnetisk kompatibilitet, Direktiv 2011/65/EU om 
begränsning av användning av vissa farliga ämnen i elektrisk och elektronisk utrustning och bär CE markeringen i enlighet 
därmed. 

Tilläggsinformation 

Den här produkten har tilldelats ett föreskriftsenligt modellnummer som följer de föreskriftsenliga aspekterna av 
konstruktionen. Det föreskriftsenliga modellnumret är en identifikator för huvudprodukten i föreskriftsenlig dokumentation 
och testrapporter, detta nummer skall inte blandas samman med marknadsföringsnamnet eller produktnumret. 

Den här produkten har testats i en typisk HPE miljö. 

 

 
Roseville, CA Brent Ford, Manager 
20.09.2016 HPE Networking, CEB Business Organization 

Lokal kontakt, endast för föreskiftsenliga ärenden 

EU: Hewlett Packard GmbH, HPE HQ-TRE, 71029 Boeblingen, Germany 
U.S.:  Hewlett Packard Enterprise, 3000 Hanover St., Palo Alto, CA 94304, U.S.A. 844-806-3425 

http://www.hpe.com/eu/certificates 
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Försäkran om Överensstämmelse  
i enlighet med ISO/IEC 17050-1 och EN 17050-1 

 

2 / 2 

 

Produktnamn och/eller modell 

Aruba 2930F 24G 4SFP+ Swch  (JL253A) 

Aruba 2930F 48G 4SFP+ Swch  (JL254A) 

Aruba 2930F 24G 4SFP Swch  (JL259A) 

Aruba 2930F 48G 4SFP Swch  (JL260A) 

Aruba 2540 24G 4SFP+ Swch  (JL354A) 

Aruba 2540 48G 4SFP+ Swch  (JL355A) 

 

BILAGA I 

Föreskriftenligt modellnummer: RSVLC-1418 
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Hewlett Packard Enterprise (HPE) is committed to compliance with all 
applicable laws and regulations, including material restriction 
requirements under the European Union Recast RoHS Directive, 
otherwise known as EU RoHS 2, applicable restrictions under Annex 
XVII of the EU REACH Regulation and China’s Management Methods 
for Restricted Use of Hazardous Substances in Electrical and 
Electronic Products, otherwise known as China RoHS 2.  
 
Hewlett Packard Enterprise believes that legislation, like the EU RoHS 
2 Directive, plays an important role in promoting industry-wide 
transition to restrict substances of concern. In general, the restriction 
of any substance should take into account the following key items:  
 
• Global harmonization of the legislation content and implementation 

requirements 
• Substance risk assessment, including a clear understanding of the 

environmental impacts of alternative substances 
• Clear identification of what substances (vs. broad classes or 

categories) are to be restricted 
• Clear identification of when alternative technologies are proven and 

readily available 
• Appropriate lead time to allow the industry to transition 
• Substances that are not used or found in final products should not 

be included in the restrictions 
• Material application exemptions should be allowed for the use of 

restricted substances in applications where current substitution is 
not technically feasible 

• Inclusion of maximum concentration values setting de minimis 
levels below which the relevant substances may be present 

 

Hewlett Packard Enterprise’s 
Compliance with Restriction of 
Hazardous Substances (RoHS) 
Legislation 
(rev 14.0 Oct 2016) 

 

Hewlett Packard Enterprise 

3000 Hanover Street 

Palo Alto, CA 94304 

www.hpe.com 
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Hewlett Packard Enterprise fully supports the restriction of the four 
substances incorporated into EU RoHS 2 by Commission Delegated 
Directive 2015/863/EU, specifically:  
 
• Diisobutyl Phthalate (DIBP) 
• Bis (2-ethylhexyl) phthalate (DEHP) 
• Butyl benzyl phthalate (BBP) 
• Dibutylphthalate (DBP) 
 
Hewlett Packard Enterprise believes other substances should be 
considered for inclusion in future RoHS legislation. This includes the 
restriction of polyvinyl chloride (PVC) and brominated flame retardants 
(BFRs) from electrical and electronic equipment (EEE). HPE believes 
PVC and BFRs should be the focus for the restriction of chlorine (Cl) 
and bromine (Br) from electrical and electronic equipment, where 
technically feasible. HPE’s reasons for focusing on PVC and BFRs 
are: 
 
• PVC and BFRs cover 99% of the uses for Cl and Br in electronics; 
• Given the high percentage usage, these substances have the 

highest impact; 
• Restriction of these substances where technically feasible would 

substantially accomplish the goal to eliminate Cl and Br from 
electronic products. 

 
By July 2007, all PVC and BFRs were restricted[1] from the external 
case plastics in HPE branded products. When technically feasible, we 
will continue to phase out other uses of brominated flame retardants 
(BFRs), polyvinyl chloride (PVC), and phthalates to meet market 
demands and customer expectations, taking into account product life 
cycles. 
 
Hewlett Packard Enterprise is taking a proactive approach to 
evaluating materials in its products to assess environmental, health or 
safety risks. HPE may restrict substances because of customer or 
legal requirements, or because HPE believes it is appropriate based 
on a precautionary approach. HPE strives to replace legally permitted 
materials when scientific data have established a potential health or 
environmental risk and lower-risk, commercially and technically viable 
alternatives are available. At HPE the evaluation of alternative 
materials is a continuous process.  
 
Our continued internal voluntary goal is to meet the substance 
restrictions of the EU RoHS legislation outside the EU (and EFTA) 
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within 6 months of each of the EU’s various legal compliance dates on 
a worldwide basis for virtually all Hewlett Packard Enterprise branded 
new products in scope of the Directive, except where it is widely 
recognized that there is no technically feasible alternative (as 
indicated by an exemption under the EU RoHS Directive).  
 
In early 2003, a company-wide RoHS team was formed to manage all 
aspects of Hewlett Packard Company’s global response to all the 
RoHS legislations around the world.  Since the separation of Hewlett 
Packard Company and the creation of Hewlett Packard Enterprise, 
HPE has continued this approach. HPE’s initiative to address the 
RoHS legislations is part of the company’s Design for Environment 
program, which includes using materials more efficiently, finding 
alternatives for designated materials, designing for energy efficiency, 
and designing products that can be easily recycled. 
 
Hewlett Packard Enterprise continues to plan for further “RoHS-like” 
legislation in other jurisdictions and will meet any additional 
requirements that arise. HPE complies with the requirements of all the 
RoHS legislations currently in effect (including those specifically listed 
under Compliance Status below). HPE’s Compliance Verification is 
based on our risk analysis of restricted substances entering the 
supply chain and includes technical documentation outlined in the 
European Union’s EN 50581:2012 standard. 
 
More detailed information can be found at 
www.hpe.com/info/environment 
Living Progress Report 

Design for environment 
Compliance Verification 
General Specifications for the Environment 
Eco Declarations 
 

 
Hewlett Packard Enterprise’s Compliance Status to EXISTING 
RoHS Legislation:  

 

European Union  

HPE products in-scope and put on the market in the EU and EFTA 
Member States comply with the requirements of EU RoHS Directive 
(2011/65/EU) including Commission Decisions withdrawing 
exemptions.  
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Serbia 
HPE products[2] comply with Serbia's WEEE and RoHS "Regulations 
on the List of Electrical and Electronic Products, Measures Banning 
and Restricting the Recovery of Electrical and Electronic Equipment 
Containing Hazardous Materials, and the Methods and Procedures for 
Managing Waste from Electrical and Electronic Products", which 
entered into force on January 4, 2011. RoHS restrictions apply to 
equipment placed on the market on or after July 1, 2011. 
 
Turkey 
HPE products[2] comply with Turkey’s “Regulation on the Restriction of 
the use of Certain Hazardous Substance in Electrical and Electronic 
Equipment”, otherwise known as Turkey RoHS which came into effect 
on March 30, 2009. 
 
Ukraine 
HPE products[2] comply with the substance restrictions in Ukraine’s 
“Technical Regulation on restrictions as to the use of some dangerous 
substances in electric and electronic devices”, otherwise known as 
Ukraine RoHS which came into effect on 1 January 2011. 
 
China 
HPE products[2] comply with China’s, “Management Methods for 
Restricted Use of Hazardous Substances in Electrical and Electronic 
Products”, otherwise known as China RoHS 2 which came into effect 
on July 1, 2016. 
 
India  
HPE products[2] comply with the material restrictions of India’s 
legislation “India E-waste (Management) Rules, 2016”, otherwise 
known as India RoHS, which came into effect on October 1, 2016 and 
will replace the E-Waste (Management and Handling) Rules, 2011. 
 
Japan  
Japan’s “The Marking of Presence of the Specific Chemical 
Substances for Electrical and Electronic Equipment” (JIS-C-0950), 
otherwise known as J-MOSS came into effect on July 1, 2006. At 
present, no HPE-brand products are in scope of J-MOSS.  
 

Korea  
In Korea, “The Act for Resource Recycling of Electrical/Electronic 
Products and Automobiles”, otherwise known as Korean RoHS came 
into effect on January 1, 2008. Korea’s RoHS 2 came into effect on 
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January 1, 2013. At present, no HPE-brand products are in scope of 
Korea RoHS 2. 
 
Taiwan (BSMI) RoHS 
HPE products[2] will comply with Taiwan’s CNS 15663 standard, 
otherwise known as BSMI RoHS, which is a Guidance to reduce the 
restricted chemical substances used in electrical and electronic 
products. This standard was released on July 30, 2013 and applies to 
servers placed on the market on or after July 1, 2017 and other 
products placed on the market on or after January 1, 2018. 
 
Vietnam 
HPE products[2] comply with Vietnam’s legislation “Circular 
30/2011/TT-BCT: Temporarily regulating the permitted limits for a 
number of hazardous substances in electric and electronic products”, 
otherwise known as Vietnam RoHS which came into effect on 
December 1, 2012. You can find HPE’s Vietnam RoHS declarations 
at: http://www8.hp.com/us/en/hpe/hp-
information/livingprogress/environmentalprogress/msds-specs-
more.html 
 
California 
California’s, “Electronic Waste Recycling Act of 2003 (Senate Bill 20) 
substance restrictions”, otherwise known as California RoHS came 
into effect on January 1, 2007. At present, no HPE-brand products are 
in scope of California RoHS. 
 
New Jersey 
New Jersey’s “Electronic Waste Recycling Act” (Senate Bill 2144), 
otherwise known as New Jersey RoHS came into effect on 1 January 
2011. At present, no HPE-brand products are in scope of New Jersey 
RoHS. 
 
Worldwide  
HPE has an internal voluntary goal to meet the substance restrictions 
of the EU RoHS legislation outside the EU (and EFTA) within 6 
months of each of the EU’s various legal compliance dates on a 
worldwide basis for virtually all HPE branded new products in scope of 
the Directive, except where it is widely recognized that there is no 
technically feasible alternative (as indicated by an exemption under 
the EU RoHS Directive). 
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Notes:  
[1] See HPE’s General Specification for the Environment Identification 
Numbers: 041210-80 and 070905-88.  
[2] HPE products that are both in scope and put on the market in the given 
jurisdiction. 
 

 

© Copyright 2016 Hewlett Packard Enterprise Development LP  
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HPE Networking Product Warranty & Support Summary (October 2018)

The most current version of this document is available at www.hpe.com/networking/warrantysummary
HPE Networking product warranty policy details are available at www.hpe.com/networking/warranty

Information on services for HPE Networking products can be found at www.hpe.com/networking/services
The information contained herein is subject to change without notice.  Warranties for HPE products and services are set forth in the express warranty statements 

accompanying such products and services.   In addition, our goods come with guarantees that cannot be excluded under Australian and New Zealand consumer laws.  
Subject to the foregoing, nothing herein should be construed as constituting an additional warranty.  HPE shall not be liable for technical or editorial errors or omissions 

contained herein.

 

Products
Warranty 
duration1

Hardware 
replacement2

Business 
Hours 

Technical 
Support3

24x7
Technical 
Support3

(After Dec. 1, 2015)

Software/OS 
Releases4

S
w

it
c

h
e

s

Modular

129xx, 125xx, 119xx 1 year 10 days 1 year N/A As long as owned4

105xx, 75xx 1 year 10 days 1 year 90 days As long as owned4

84xx, 83xx 5 years 10 days 90 days N/A 5 years4

82xxzl, 54xxzl/R, 42xxvl
Lifetime5 NBD Ship

As long as 
owned5 90 days As long as owned4

Fixed-configuration

79xx, 59xx/AF, 583x/AF, 582x/AF, 57xx 1 year 10 days 1 year N/A As long as owned4

Altoline 9xxx, 6xxx Switches (Purchased after March 31, 2016) 1 year 10 days 1 year N/A N/A

Arista switches (See http://www.arista.com/assets/data/pdf/Warranty.pdf for details) 1 year15 10 days15 1 year15 N/A N/A

580x/AF
Lifetime5 NBD Ship

As long as 
owned5 N/A As long as owned4

55xx, 513x, 512x, 38xx, 36xx, 35xx/yl, 31xx, 29xx/al, 281x, 26xx, 25xx/G
Lifetime5 NBD Ship

As long as 
owned5 90 days As long as owned4

Smart Managed 

195x, 192x, 191x, 18xx, 1620 (Purchased after October 1, 2017)

Lifetime14 NBD Ship

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14

As long as owned4

Unmanaged 

1420, 1410 (Purchased after October 1, 2017)

Lifetime14 NBD Ship

90 days 
Phone 

support-Chat 
support entire 

warranty 
period 14

90 days 
Phone 

support-Chat 
support entire 

warranty 
period 14

N/A

1405 (Purchased after October 1, 2017) 3 years14 NBD Ship 90 days 
Phone 

support-Chat 
support entire 

warranty 
period 14

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14

N/A

W
ir

e
le

s
s
 L

A
N

Indoor Access Points

Aruba Controller-Managed Access Points (APs)
Lifetime10

30 day 
NBD/Return-to-

factory11

90 days N/A 90 days (bug fix only)

3WN/P, 155/P, 108/109 Aruba Remote Access points (RAPs) 
Lifetime10

30 day 
NBD/Return-to-

factory11

90 days N/A
Periodic updated 

image13

Aruba Instant Access Points (IAPs)
Lifetime10

30 day 
NBD/Return-to-

factory11

90 days N/A
Periodic updated 

image13

M330, M2xx
Lifetime5 NBD Ship

As long as 
owned5 90 days

As long as owned4

OfficeConnect 20 Access Point

3 years14 NBD Ship

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14

90 days 
Phone 

support-Chat 
support entire 

warranty 
period14

As long as owned4

Controllers

Aruba controllers
1 year

30 day 
NBD/Return-to-

factory11

90 days12 N/A N/A

Aruba Mobility Access Switches Lifetime10 NBD Ship 90 days 90 days As long as owned4

Other WLAN products 

Aruba Controller-Managed 2xx Series Outdoor Access Points
Lifetime10

30 day 
NBD/Return-to-

factory11

90 days N/A 90 days (bug fix only)

Aruba Instant 2xx Series Outdoor Access Points (IAPs)
Lifetime10

30 day 
NBD/Return-to-

factory11

90 days N/A
Periodic updated 

image13

AirWave Appliances, ClearPass Appliances, IntroSpect Appliances
1 year

30 day 
NBD/Return-to-

factory11

90 days12

N/A
90 days (bug fix only)

MST2HP, MST2HAC, MSR2KP, MSR4KP Aruba Outdoor Wireless Mesh 
Routers 1 year

30 day 
NBD/Return-to-

factory11

90 days12 N/A 90 days (bug fix only)

Aruba Beacons
90 days

30 day 
NBD/Return-to-

factory11

90 days N/A 90 days (bug fix only)

Cape Sensors
90 days

30 day 
NBD/Return-to-

factory11

90 days N/A 90 days (bug fix only)

Aruba Power Supplies, Antennae, Accessories
1 year

30 day 
NBD/Return-to-

factory11

90 days N/A N/A
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HPE Networking Product Warranty & Support Summary (October 2018)

The most current version of this document is available at www.hpe.com/networking/warrantysummary
HPE Networking product warranty policy details are available at www.hpe.com/networking/warranty

Information on services for HPE Networking products can be found at www.hpe.com/networking/services
The information contained herein is subject to change without notice.  Warranties for HPE products and services are set forth in the express warranty statements 

accompanying such products and services.   In addition, our goods come with guarantees that cannot be excluded under Australian and New Zealand consumer laws.  
Subject to the foregoing, nothing herein should be construed as constituting an additional warranty.  HPE shall not be liable for technical or editorial errors or omissions 

contained herein.

 

R
o

u
te

rs

Routers

88xx, HSR68xx 1 year 10 days 1 year N/A As long as owned4

HSR66xx, 66xx, MSR50, MSR4xxx, MSR3xxx, MSR30 1 year 10 days 1 year 90 days As long as owned4

MSR2xxx, MSR20, MSR1xxx, MSR9xx 1 year NBD Ship 1 year 90 days As long as owned4

ALU 77xx
1 year9 Return-to-

factory9 1 year9 N/A
All updates for 

purchased license9

VSR routers 90 days
(Media only)

N/A 90 days N/A
All updates for 

purchased license8

M
a

n
a

g
e

m
e
n

t

Network Management

Intelligent Management Center (support details at www.hpe.com/networking/IMCSupport) 90 days
(Media only)

N/A 90 days N/A 90 days (bug fix only)

AirWave, ALE, ArubaCentral, ClearPass, Meridian, VIA, Visual RF 90 days
(Media only)

N/A 90 days N/A 90 days (bug fix only)

HPE VAN SDN controller and HPE SDN applications 90 days
(Media only)

N/A 90 days N/A All updates for 
purchased license8

HPE Distributed Cloud Networking 90 days
(Media only)

N/A N/A N/A None

Big Switch Networks controller appliances (See www.bigswitch.com/support for 

warranty & support details)
N/A16 N/A16 N/A16 N/A16 N/A16

A
d

d
it

io
n

a
l 

N
e
tw

o
rk

in
g

 

P
ro

d
u

c
ts

Transceivers

Aruba Transceivers (Transceiver product numbers JWxxxx for Controllers 
and MAS Switches) 1 year 

30 day 
NBD/Return-to-

factory11

90 days N/A N/A

Aruba branded transceivers (except transceiver product numbers JWxxxx)
and

HPE X244, X242, X142, X132, X131, X129, X122, X121, X119, X112, X111

Lifetime5 NBD Ship As long as 
owned5

N/A N/A

Aruba 100G transceivers 1 year 10 days 1 year N/A N/A

HPE X2A0, X240, X190, X180, X170, X160, X150, X140, X135, X130, 
X125, X124, X120, X115, X114, X110

1 year 30 days 1 year N/A N/A

1) Removable power supplies, modules and accessories such as antennas, fans, power cords, 
etc. may have different warranty coverage than the host device.  See the HPE Networking 
Warranty Coverage Quick Reference at www.hpe.com/networking/warrantyquickref for more 
details. 

2) Response time is based on commercially reasonable effort and subject to a daily shipment 
cutoff time.  In some countries and regions and under certain supplier constraints, response 

time may vary.  Contact your local HPE service organization for response time availability in 
your area.  NBD Ship = Next Business Day shipment.

3) Warranty phone and electronic case technical support is provided during local HPE business 
hours for the entire warranty period for the purposes of diagnosing hardware or software 
defects.  Many products purchased after December 1, 2015 include 90 days of 24x7 technical 
support as noted.  See product’s Hewlett-Packard Limited Warranty Statement for additional 
coverage details.  Extended coverage services are available.

4) Includes all generally available software/OS releases offered for the specific products listed, 
when and if available, for as long as the customer owns the product, except where noted.  
Some software releases may require additional or new hardware.  Customers who desire 
specific feature updates, patches and fixes to be prioritized into future releases should 
purchase the appropriate support services from HPE.

5) For products purchased after December 1, 2014, the warranty extends only for as long as the 
original end user owns the product. Includes coverage of any built-in fans and power supplies 
for the entire warranty period. You may be required to provide proof of purchase or lease as a 
condition of receiving warranty service.  

6) Hardware warranty, technical support and all software releases provided for hardware and the 
ONE Service OS only, when and if available, for as long as the original end user owns the 
product.  See product specific documentation for application support.  5 year warranty on the 
disk drive in the HPE Alliance One Advanced Services zl Modules.

7) Products purchased before August 1, 2013 include 1 year of technical support and 1 year 
(bug fix only). 

8) Includes all software updates offered for the licensed version, when and if available.  Software 
upgrades will require purchase of appropriate SKU, packaged support services or contract.

9) All technical, hardware and software support for ALU 77xx products is provided directly by 
Alcatel-Lucent only and not HPE.  For support from Alcatel-Lucent, select the country from 
which the customer is calling in the following link and it will present the appropriate ALU 
support contact information: https://services.support.alcatel-lucent.com/product_support/.  
Hardware warranty requires shipping failed product to ALU for repair or replacement.  
Logistics cost for shipment of product from customer’s site to ALU site for repair or 
replacement will be covered by the customer.  Software maintenance releases are included 
for the major software release purchased.  Major software release upgrades are NOT 
included.  Services may be purchased from HPE or Alcatel-Lucent to extend your support 
coverage and software upgrades.  Support will be provided by Alcatel Lucent for these 
services.

10) For products purchased after December 1, 2015, the warranty extends only for as long as the 
original end user owns the product and is limited to five (5) years from the end of sale date.

11) For the first 30 days from shipment, HPE will provide same day ship advanced 
replacement for the covered hardware products.  After thirty (30) days from shipment 
through the remaining warranty period, HPE will replace or repair any non-compliant 
Product and return it in operable condition, shipping after HPE’s receipt of the non-
compliant Product via HPE’s RMA procedure, with receipt by customer within ten 
(10) days on a commercially reasonable basis.

12) HPE will provide next business day email response for the purposes of diagnosing 
hardware or software defects during standard Pacific Time Zone business hours for 
the first 90 days after purchase. 

13) HPE will make one recent Instant OS software release image available on the 
software portal.  This image is also available for Remote Access Points (RAPs) 
running Instant OS.

14) These products are covered by 90 days of 24x7 phone support.  Thereafter, only 
chat support would be available for the remaining warranty period.  Limited lifetime 
warranty (where applicable) extends only for as long as the original end user owns 
the product and is limited to five (5) years from the end of sale date. This warranty 
includes coverage of any built-in fans and power supplies for the entire warranty 
period. You may be required to provide proof of purchase or lease as a condition of 
receiving warranty service. See www.hpe.com/OfficeConnect/support/ for more 
information on the new OfficeConnect support process. 

15) All technical, hardware and software support for Arista products is provided directly 
by Arista and not HPE.   Consult the Arista customer support page for contact 
information: https://www.arista.com/en/support/customer-support.  Transportation 
costs, if any, incurred in connection with the return of a defective Hardware to an 
Arista repair center shall be borne by Customer. Arista shall pay any transportation 
costs incurred with the redelivery of a repaired or replaced Hardware. Services may 
be purchased from HPE or Arista to extend your support coverage and software 
upgrades.  Support will be provided by Arista for these services.  For details on 
Arista warranty and support, see: 
http://www.arista.com/assets/data/pdf/Warranty.pdf.

16) All technical, hardware and software support for Big Switch Networks products is 
provided directly by BSN and not HPE.  Consult the Big Switch Networks customer 
support page for contact information: www.bigswitch.com/support.  For details on 
Big Switch Networks warranty and support options, see: 
http://bigswitch.com/sites/default/files/bsn_support_and_maintenance_policy.v2.2.20
16.11.14.pdf.
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Worldwide support numbers for these product 

families:*

 – Aruba products

 – HPE Nimble Storage products

Support matrix

Technical Support Phone Numbers

Country Support type Support phone number Hours of operations

Aland Contract +358 20 320 300 24x7

Warranty and Out of Warranty +358 20 353 232 M–F 8:00–17:00

Albania Contract & Warranty/Out of Warranty +355 42 322 411 24x7

Algeria Contract & Warranty/Out of Warranty +216 23 92 5000 24x7

Andorra Contract +34 902 220 030 24x7

Warranty and Out of Warranty +34 902 010 333 M–F 8:30–17:30

Angola Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Anguilla Contract & Warranty 1-800-225-5288 then 

844 692-8150

24x7

Antigua and Barbuda Contract & Warranty #1 then 844 692-8151 24x7

Argentina Contratos 0 800 444 7867

+52 55 5258 4500

24x7

Garantías 0 800 333 4857

+52 55 1500 3155

M–F 8:00–17:00

Armenia Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Aruba Contract & Warranty +1 844 264 1328 24x7

Australia Contract & Warranty/Out of Warranty 13 11 47

+61 2 8031 8315

24x7

Azerbaijan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

* For all other product types, please call the support number for your country listed in this document.
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Support matrix Page 2

Country Support type Support phone number Hours of operations

Bahamas Contract & Warranty 1-800-872-2881 then 

844 692-8152

24x7

Bahrain Contract & Warranty/Out of Warranty +973 1 619 82 94 24x7

Barbados Contract & Warranty 1-800-225-5288 then 

844 692-8153

24x7

Belarus Contract & Warranty/Out of Warranty 8 8200 073 01 01

+7 495 411 69 07

24x7

Belgium Contract 078 250 144

+32 26 200 055

24x7

Warranty and Out of Warranty 078 600 600

+32 26 200 099

M–F 8:00–17:00

Belize Contract & Warranty 811 then 844 692-8148 24x7

Benin Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Bermuda Contract & Warranty 1-800-225-5288 then 

844 692-8154

24x7

Bolivia Contratos 800 110 348

+52 55 5258 4500

24x7

Garantías 800 110 348

+52 55 1500 3155

M–F 8:00–17:00

Bonaire (Sint Eustatius, Saba) Contract & Warranty 001-800-872-2881 then 

844 752-2839

24x7

Bosnia and Herzegovina Contract & Warranty/Out of Warranty +387 338 219 22 24x7

Botswana Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Bouvet Island Contract & Warranty/Out of Warranty 800 56 044 24x7

Brasil Contract 0800 55 6405

+55 11 3173 8802 

+55 11 4688 5102

24x7

Warranty 0800 710 2029

+55 11 2377 1002 

+55 11 2377 0002

M–F 8:00–17:00
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Support matrix Page 3

Country Support type Support phone number Hours of operations

British Indian Ocean Territory Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

British Virgin Islands Contract & Warranty 1-800-872-2881 then 

844 692-8156

24x7

Bulgaria Contract & Warranty/Out of Warranty 0700-1-47-47 24x7

Burkina Faso Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Burundi Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Cameroon Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Canada Contract

Contrat

1-800-633-3600 24x7

Warranty and Out of Warranty

Produits garantis et hors garantie

1-844-806-3425 24x7 for most products

Cape Verde Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Cayman Islands Contract & Warranty 1-800-225-5288 then 

844 692-8157

24x7

Central African Republic Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Chad Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Chile Contratos 800 362 365

+52 55 5258 4500

24x7

Garantías 800 123 605

+52 55 1500 3155

M–F 8:00–17:00

Collectivity of Saint Martin Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Colombia Contratos 01 800 051 4747

+57 1 6004150

24x7

Garantías 800 051 7127

+52 55 1500 3155

M–F 9:00–18:00

Comoros Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7
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Support matrix Page 4

Country Support type Support phone number Hours of operations

Costa Rica Contratos 800 794 4401

+52 55 5258 4500

24x7

Garantías 800 794 4401

+52 55 1500 3155

M–F 8:00–17:00

Croatia Contract & Warranty/Out of Warranty 0800 303 556 24x7

Curaçao Contract & Warranty 001-800-872-2881 then 

844 264-1326

24x7

Cyprus Contract & Warranty/Out of Warranty 801 11 47 22 73

+30 211 181 3846

24x7

Czech Republic Contract & Warranty/Out of Warranty 239 018 791 24x7

Denmark Contract +45 70 10 80 25 24x7

Warranty and Out of Warranty +45 70 11 77 00 M–F 8:00–17:00

Deutschland Dienstleistungsverträge/Contracts +49 69 380 789 143 24x7

Produkte innerhalb und außerhalb der Herstellergarantie +49 69 380 789 142 Montag–Freitag

8:00–17:00

(außer an bundeseinheitlichen Feiertagen)

Djibouti Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Dominica Contract & Warranty 1-800-225-5288 then 

844 264-1327

24x7

Dominican Republic Contract & Warranty 1-888-225-5288 then 

844 264-1328

+52 55 5258 4500

24x7

Ecuador Contratos 1-800-225-528 then 

844 845-8165

+52 55 5258 4500

24x7

Garantías 1-800-225-528 then 

844 845-8165

+52 55 1500 3155 

M–F 8:00–17:00

Egypt Contract & Warranty/Out of Warranty 0800 000 0814

+20 2 353 131 62

24x7
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El Salvador Contratos 800-1785 then 

844 845-8167

+52 55 5258 4500

24x7

Garantías 800-1785 then 

844 845-8167

+52 55 1500 3155 

M–F 8:00–17:00

Equatorial Guinea Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Eritrea Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

España Contrato de Mantenimiento +34 902 220 030

+34 913496569

24x7

Garantía y fuera de garantía +34 902 010 333

+34 913496559

Lunes a viernes, 8:30 a 17:30 de julio y agosto,  

8:30 a 14:30

Estonia Contract & Warranty/Out of Warranty +372 686 88 71 24x7

Ethiopia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Falkland Islands Contract & Warranty/Out of Warranty +44 845 161 0050 24x7

Faroe Islands Contract +45 70 10 80 25 24x7

Warranty and Out of Warranty +45 70 11 77 00 M–F 8:00–17:00

Finland Contract +358 20 320 300 24x7

Warranty and Out of Warranty +358 20 353 232 M–F 8:00–17:00

France Contrat 0825 00 41 23

+33 173018471

24x7

Ligne payante au tarif local en France

Garantie et Hors Garantie 0826 10 49 49

+33 173018475

Lundi–Vendredi 

8:30–18:00

(à l’exception des jours fériés et jours de fermeture d’HPE)

French Guiana Contract & Warranty 0800 99 00 11 then 

844 264-1329

24x7

French Polynesia Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

French Southern Territories Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Gabon Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7
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Gambia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Georgia Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Ghana Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Gibraltar Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

Greece Contract & Warranty/Out of Warranty 801 11 47 22 73

+30 211 181 3846

24x7

Greenland Contract +45 70 10 80 25 24x7

Warranty and Out of Warranty +45 70 11 77 00 M–F 8:00–17:00

Grenada Contract & Warranty 1-800-225-5288 then 

844 264-1330

24x7

Guadeloupe Contract & Warranty 0-800-99-0011 then 

844 264-1331

24x7

Guatemala Contratos 999-9190 then 

844 845-8169

+52 55 5258 4500

24x7

Garantías 999-9190 then 

844 845-8169

+52 55 1500 3155

M–F 8:00–17:00

Guernsey Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

Guinea Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Guinea-Bissau Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Guyana Contract & Warranty 159 then 844 752-2835 24x7

Haiti Contract & Warranty +1 844 264 1328 24x7
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Honduras Contratos 800-0-123 then 

844 752-2837

+52 55 5258 4500

24x7

Garantías 800-0-123 then 

844 752-2837

+52 55 1500 3155 

M–F 8:00–17:00

Hong Kong Contract +852 2292 3333 24x7

Alpha, ProLiant, and attached HPE Storage Systems

Warranty +852 3071 3873 M–F 8:30–17:30

HPE Networking, UNIX® system, NetServer, and attached 

HPE Storage systems 

Warranty +852 2904 8338 24x7

ProLiant & attached 

HPE Storage Systems 

Value line (need PIN code during AOH)

Hungary Contract 1 778 9670 24x7

Warranty and Out of Warranty 1 778 9669 M–F 9:00–17:00

Iceland Contract +47 800 56 044 24x7

Warranty and Out of Warranty +47 800 62 800 M–F 8:00–17:00

India Warranty 1800 419 8080 (Callers in India)

+91 806 703 7209 (International Callers)

M–F 9:00–18:00

Indonesia Contract & Warranty 0018 0385 20668

+62 21 5799 4050

24x7

Iran Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Iraq Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Ireland Contract 1850 924 590

+ 353 1 4118915

24x7

Warranty and Out of Warranty 1890 946 500

+ 353 1 4118912

M–F 8:00–18:00

(except Bank Holidays)

Isle of Man Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00
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Israel Contract & Warranty/Out of Warranty 1-809-400-300

+972 3-3726489

24x7

Italia Contratti 02 452 790 50 24x7

In garanzia o fuori garanzia 02 385 912 12 Lunedì–Venerdì 8:00–17:00

Ivory Coast Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Jamaica Contract & Warranty 1-800-872-2881 then 

844 264-1332

24x7

日本 Warranty support.hpe.com/hpsc/doc/public/display?docId=emr_

na-c04770344

Jersey Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

Jordan Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Kazakhstan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Kenya Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Kosovo Contract & Warranty/Out of Warranty 0800 300 003/0800 190 038 (Serbia)

035 542 322 411 (Albania)

24x7

Kuwait Contract & Warranty/Out of Warranty 632 9930 24x7

Kyrgyzstan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Latvia Contract & Warranty/Out of Warranty 678 521 84 24x7

Lebanon Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Lesotho Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Liberia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Libya Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Liechtenstein Contract +41 0848 800 724 24x7

Warranty and Out of Warranty +41 0848 80 20 20 M–F 8:00–18:00

Lithuania Contract & Warranty/Out of Warranty +370 521 415 92 24x7
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Luxembourg Contract +352 27 303 111 24x7

Warranty and Out of Warranty +352 27 303 303 M–F 8:00–17:00

Macedonia Contract & Warranty/Out of Warranty 0800 90 472 24x7

Madagascar Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Malawi Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Malaysia Contract & Warranty 1800 88 1811 (Callers in Malaysia)

+60 3 6207 4533 (International Callers)

24x7

Mali Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Malta Contract & Warranty/Out of Warranty +356 27 781 269 24x7

Martinique Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Mauritania Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Mauritius Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Mayotte Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

México Contratos 800 501 9800

+52 55 5258 4500

24x7

Garantías 800 890 6348

+52 55 1500 3155

M–F 8:00–17:00

Moldova Contract & Warranty/Out of Warranty +7 499 272 37 82 24x7

Monaco Contrat +33 1 73 01 84 71 24x7

Ligne payante au tarif local en France

Garantie et Hors Garantie +33 1 73 01 84 75 Lundi–Vendredi 

8:30–18:00

(à l’exception des jours fériés et jours de fermeture d’HPE)

Montenegro Contract & Warranty/Out of Warranty 0800 300 003 24x7

Montserrat Contract & Warranty 1-800-225-5288 then 

844 264-1333

24x7

Morocco Contract & Warranty/Out of Warranty 00 212 5 22 24 87 70

+44 1793 794886

24x7
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Mozambique Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Namibia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Netherlands Contract 0900 115 0000

+31 205 040 666

24x7

Warranty and Out of Warranty 0900 117 0000 M–F 8:00–17:00

New Caledonia Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

New Zealand Contract & Warranty/Out of Warranty 0800 664 747

+61 2 8031 8316

24x7

Nicaragua Contratos 1-800-0164 then 

844 752-2840

+52 55 5258 4500

24x7

Garantías 1-800-0164 then 

844 752-2840

+52 55 1500 3155

M–F 8:00–17:00

Niger Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Nigeria Contract & Warranty/Out of Warranty 01 27 14 777

+44 203 564 4148

24x7

Norway Contract 800 56 044 24x7

Warranty and Out of Warranty 800 62 800 M–F 8:00–17:00

Oman Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Österreich Dienstleistungsverträge/Contracts 08 1000 2000 24x7

Produkte innerhalb und ausserhalb der

Herstellergarantie

08 1000 1000 M–F 8:00–18:00

Palestinian Territory Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Panama Contratos 800-2288 then 

844 845-8163

+52 55 5258 4500

24x7

Garantías 800-2288 then 

844 845-8163

+52 55 1500 3155 

M–F 8:00–17:00
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Paraguay Contratos 008-11-800 then 

844 752-2842

+52 55 5258 4500

24x7

Garantías 008-11-800 then 

844 752-2842

+52 55 1500 3155 

M–F 8:00–17:00

Perú Contratos 0 800 1 9703

+52 55 5258 4500

24x7

Garantías 0800 44 366

+52 55 1500 3155 

M–F 8:00–17:00

Philippines Contract & Warranty 1800 1441 0669

 1800 8908 6404

+63 2395 3565

24x7

Poland Contract & Warranty/Out of Warranty 0 800 702 284

(22) 306 04 84

24x7

Portugal Contract 808 203 203 24x7

Warranty and Out of Warranty 213 164 164 M–F 9:00–18:00

Puerto Rico Contratos 844 752-2843

+52 55 5258 4500

24x7

Garantías 844 752-2843

+52 55 1500 3155 

M–F 8:00–17:00

Qatar Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Republic of Congo Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Réunion Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Romania Contract & Warranty/Out of Warranty +40 317 305 020 24x7

Россия Поддержка 8 800 500 92 55

+7 495 411 69 07

24x7

Rwanda Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Saint Barthélemy Contract 0-800-990-011 then 

844 845-8168

24x7

Warranty and Out of Warranty +212 5 22 24 87 70 24x7
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Saint Helena (Ascension and Tristan da Cunha) Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Saint Kitts and Nevis Contract & Warranty 1-800-225-5288 then 

844 264-1334

24x7

Saint Lucia Contract & Warranty/Out of Warranty 1 844 231 8954 24x7

Saint Pierre and Miquelon Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Saint Vincent and the Grenadines Contract & Warranty 1-800-225-5288 then 

844 845-8160

24x7

San Marino Contract 02 452 790 50 24x7

Warranty and Out of Warranty 02 385 912 12 M–F 8:00–17:00

Sao Tome and Principe Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Saudi Arabia Contract & Warranty/Out of Warranty 800 844 4611 24x7

Schweiz
Suisse

Dienstleistungsvertrag/

Contrat de services

0848 800 724

+41 43 557 9021

24x7

8Rp./Min*

Herstellergarantie/

Produits garantis

0848 80 20 20

+41 44 200 4115

Montag–Freitag

Lundi–Vendredi

8:00–17:00

(außer Feiertage) 

8Rp./Min*

*aus dem schweizerischen Festnetz; abweichende Preise aus 

Mobilfunknetzen sind je nach Anbieter möglich.

Senegal Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Serbia Contract & Warranty/Out of Warranty 0800 300 003

0800 190 038 

24x7

Seychelles Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Sierra Leone Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Singapore Contract & Warranty 1800 272 4333 (Callers in Singapore)

+65 6272 4333 (International Callers)

24x7

Sint Maarten Contract & Warranty 800-99-0011 then 

844 264-1335

24x7
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Slovakia Contract & Warranty/Out of Warranty 02 686 221 79 24x7

Slovenia Contract & Warranty/Out of Warranty 0800 80 745 24x7

Somalia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

South Africa Contract 0860 001 020 24x7

Warranty and Out of Warranty 0860 001 030 M–F 8:00–17:00

(except public Holidays)

South Georgia and the South Sandwich Islands Contract +44 845 161 0050 24x7

Warranty and Out of Warranty +44 845 161 0030 M–F 8:00–18:00

대한민국 Contract & Warranty +82 1577 3270 M–F 09:00–18:00

Server & Storage

Contract & Warranty +82 1588 0142 M–F 09:00–18:00

Networking

South Sudan Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Sudan Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Suriname Contract & Warranty/Out of Warranty 156 then 844 231-8955 24x7

Svalbard and Jan Mayen Contract +47 800 56 044 24x7

Warranty and Out of Warranty +47 800 62 800 M–F 8:00–17:00

Swaziland Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Sweden Contract 0771 30 30 50 24x7

Warranty and Out of Warranty 0771 30 30 00 M–F 8:00–17:00

Syria Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Taiwan Contract & Warranty 0800 211 666

+886 2 2656 7204

M–F 8:30–17:30

Tajikistan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7
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Tanzania Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Thailand Contract 1800 441 4048

+66 2 118 6000

24x7

Warranty 1800 441 4085

+66 2 118 6300

M–F 8:30–17:30

The Democratic Republic of Congo Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Togo Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Trinidad and Tobago Contract & Warranty/Out of Warranty 1-800-872-2881 then 

844 845-8161

24x7

Tunisia Contract & Warranty/Out of Warranty +216 23 92 5000 24x7

Turkey Contract 850 759 0 724

+90 850 759 0 724

24x7

Warranty and Out of Warranty 850 759 0 473

+90 850 759 0 473

08:30–17:30 GMT+3

Turkmenistan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Turks and Caicos Islands Contract & Warranty 1-800-225-5288 then 

844 845-8162

24x7

Uganda Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Ukraine Contract & Warranty/Out of Warranty 0 800 501 526 24x7

United Arab Emirates Contract & Warranty/Out of Warranty 800 0444 1477 24x7

United Kingdom Contract 0845 161 0050 24x7

Warranty and Out of Warranty 0845 161 0030 M–F 8:00–18:00

United States Contract 1-800-633-3600 24x7

Warranty and Out of Warranty 1-844-806-3425 24x7

Uruguay Contratos 0004 110 032 632

+52 55 5258 4500

24x7

Garantías 0004 110 032 632

+52 55 1500 3155 

M–F 8:00–17:00
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US Virgin Islands Contract & Warranty +1 844 845-8164 24x7

Uzbekistan Contract & Warranty/Out of Warranty +7 495 411 69 07 24x7

Vatican City Contract 02 45279050 24x7

Warranty and Out of Warranty 02 38591212 M–F 8:00–17:00

Venezuela Contratos & Garantías +58 212 7102103 24x7

Vietnam Contract & Warranty +84 28 4458 2390 24x7

Wallis and Futuna Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Western Sahara Contract & Warranty/Out of Warranty +212 5 22 24 87 70 24x7

Yemen Contract & Warranty/Out of Warranty +44 203 564 63 97 24x7

Zambia Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7

Zimbabwe Contract & Warranty/Out of Warranty +234 1 27 14 777

+44 203 564 4148

24x7
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The transceivers listed in this document represent the currently available and End of Sale products at the time of
this publication. Not all transceiver products are supported in every switch available from Aruba. Consult the
QuickSpecs for the applicable switch product for a list of supported transceiver products. QuickSpecs can be
found at http://www.hpe.com/networking/resourcefinder

Conventions
This section describes the conventions used in the documentation.

Note on product images
NOTE: Product images in this guide may differ from actual product.

Port numbering in examples
The port numbers in this document are for illustration only and might be unavailable on your device.

Symbols
Table 1: Symbols

Convention Description

An alert that calls attention to important information that if not
understood or followed can result in personal injury.

An alert that calls attention to important information that if not
understood or followed can result in data loss, data corruption, or
damage to hardware or software.

An alert that calls attention to essential information.

NOTE: An alert that contains additional or supplementary information.

An alert that provides helpful information.

Chapter 1
Overview

Chapter 1 Overview 5

Anexo 01 ITEM 12 (0592742)         SEI 0008478-63.2018.6.02.8000 / pg. 8101

http://www.hpe.com/networking/resourcefinder


Types of transceiver modules and network cables
Table 2: Types of transceiver modules and network cables

Transceiver module type Connector head

QSFP28 module (transceiver) QSFP28 optical transceiver module MPO 12-strand or LC 2-strand

QSFP28 DAC (copper cable for
interconnecting devices) 1 - 5m
reaches

N/A

QSFP+ module (transceiver) QSFP+ optical transceiver module MPO 12-strand or LC 2-strand

QSFP+ DAC (copper cable for
interconnecting devices) 1 - 5m
reaches

N/A

SFP+ module (transceiver) SFP+ optical transceiver module LC 2-strand or 1-strand (for BiDi)

SFP+ DAC (copper cable for
interconnecting devices)

N/A

Small form-factor pluggable (SFP)
module (transceiver)

100-Megabit SFP optical
transceiver module

LC 2-strand

Gigabit SFP optical transceiver
module

Gigabit SFP copper transceiver
module

RJ-45

NOTE:

• The available transceiver modules and network cables vary by device models and are subject to
change over time. For the most up-to-date list of transceiver modules and network cables, contact
your Aruba sales representative or technical support engineer.

• For information about the transceiver modules and network cables available for each device
model, see the QuickSpecs for the applicable switch product.

Data rate
Data rate is the number of bits transmitted per second. The unit of measure for data rate is Megabits per second
(Mbps) or Gigabits per second (Gbps). Optical transceiver modules available for products provide the following
levels of data rates:

• 100 Gbps

• 40 Gbps

• 10 Gbps
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• 1000 Mbps (also known as Gigabit)

• 100 Mbps

Transmission distance
The transmission distance of optical transceiver modules is divided into short and long-range types. A distance of
2 km (1.24 miles) and below is considered a short-range type. A distance of 10 km (6.21 miles) is considered a
long-range type. Transmission distances provided by optical transceiver modules are limited by certain loss and
dispersion suffered during the transmission of fiber signals over fibers.

• Loss is the optical energy loss due to the absorption, dispersion, and leakage over the media when light
travels through optical fibers. This loss increases in direct ratio to transmission distance.

• Dispersion occurs mainly because light waves of different wavelengths travel at different rates over the same
medium. This causes different wave components of optical signals to reach the receiving end early or late as
the transmission distance increases causing impulse broadening. Impulse broadening makes the signal values
indistinguishable (data loss). Different wavelengths traveling down the same fiber are called modes, and this
data loss is known as intermodal dispersion.

To meet different transmission distance requirements, choose suitable optical transceiver modules according to
actual networking conditions.

Central wavelength
Central wavelength (wl) represents the wave band used for optical signal transmission. The following central
wavelengths are available for common optical transceiver modules representing three wavebands:

• 850 nm waveband: Used for short-reach transmission.

• 1310 nm waveband: Used for middle-reach and long-haul transmission.

• 1550 nm waveband: Used for middle-reach and long-haul transmission.

Fiber

Fiber types
Fibers are classified as multimode fibers and single-mode fibers.

• Multimode fibers

Multimode fibers (MMFs) have thicker fiber cores and can transport light in multiple modes. However, the
intermodal dispersion is greater and worsens as the transmission distance increases.

Multimode fibers can be classified into multiple grades according to their diameters and modal bandwidth. For
more information, see Table 2. The modal bandwidth of a multimode fiber is determined by the expression of
the maximum modulation frequency pulse that can pass a fiber × the fiber length. The modal bandwidth is a
comprehensive index reflecting the optical characteristics of a multimode fiber.

International Telecommunication Union (ITU) defines multimode fiber types in its G series standards. The
commonly used multimode fiber is defined in the ITU G.651 standard. The G.651-compliant fiber transmits
light at the wavelength range 800 nm to 900 nm or 1200 nm to 1350 nm.

Chapter 1 Overview 7
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Table 3: Multimode fiber grades

Fiber mode Fiber grade Fiber diameter (μm) Modal bandwidth at 850 nm
(MHz*km)

Multimode fiber OM1 62.5/125 200

OM2 50/125 500

OM3 50/125 2000

OM4 50/125 4700

Other factors that influence the transmission distance of multimode fibers include interface type, central
wavelength, and fiber grade. The modal bandwidth values shown above are for the fiber grades listed. There
are multimode fibers that have different modal bandwidth characteristics and do not necessarily match the
OM1 - OM4 grades.

Table 4: Multimode fiber specifications

Interface types Central wavelength
(nm)

Fiber grade Transmission distance

1000BASE-SX 850 OM1 < 275 m (902.23 ft)

OM2 < 550 m (1804.46 ft)

10GBASE-SR 850 OM1 < 33 m (108.27 ft)

OM2 < 82 m (269.03 ft)

OM3 < 300 m (984.25 ft)

OM4 < 400m (1312.34 ft)

10GBASE-LRM 1310 OM1 < 220 m (721.78 ft)

OM2 < 220 m (721.78 ft)

OM3 < 220 m (721.78 ft)

OM4 < 220 m (721.78 ft)

SMF <300m (987.25 ft)

• Single-mode fibers

Single-mode fibers (SMFs) have a small core size, typically 9 μm or 10 μm, and can transmit light in only one
mode. Single-mode fibers suffer little intermodal dispersion and are suitable for long-haul communication.
Single-mode fibers transmit light at the central wavelength of 1310 nm or 1550 nm.

Telecommunication Industries Alliance (TIA)/Electronic Industries Alliance (EIA) defines that single-mode fibers
use yellow outer jackets with the mark "SM".

ITU defines single-mode fiber types in its G series standards. The most commonly used single-mode fibers are
defined in ITU G.652 and G.655 standards. The following table describes features of the G.652 and G.655-
compliant fibers.
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Table 5: Features of G.652- and G.655-compliant fibers

Single-mode fiber
type

Wavelength (nm) Features Applications

G.652-compliant
fiber (standard
single-mode fiber)

1260 to 1360

1530 to 1565

Zero dispersion at 1310 nm Connecting transceiver
modules with a central
wavelength of 1310 nm or
1550 nm.

G.655-compliant
fiber (non-zero
dispersion shifted
fiber)

1530 to 1565 Near-zero dispersion around
1550 nm

For 1550 nm wavelength-
division multiplexing (WDM)
transmissions.

Fiber diameter
Fiber diameter is expressed as core diameter/cladding diameter, in μm. For example, 9/125 μm means that the
fiber core diameter is 9 μm and the fiber cladding diameter is 125 μm.

For the HPE devices, the following fiber diameters are recommended:

• G.652 standard single-mode fiber: 9/125 μm

• G.655 non zero dispersion shifted single-mode fiber: 9/125 μm

• G.651 standard multimode fiber: 50/125 μm or 62.5/125 μm

Connector
CAUTION: Cover the connector with a dust cap when it is not connected to any optical fibers.

Connectors connect transceiver modules to the corresponding transmission media. The transceiver modules
available for Aruba products use the following types of connectors:

• Lucent connector or local connector (LC).

Single LC connectors (also known as Simplex) are typically used for 1G & 10G BiDi (Bidirectional) optics.

Dual LC connectors (Duplex) are typically used in normal optical types.

Chapter 1 Overview 9
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NOTE: 40G BiDi uses only Duplex fiber versus MPO (see below) for 40G SR4 applications.

Figure 1: LC connector (a simplex connector is shown)

• Multifiber Push On (MPO) connector.

Figure 2: MPO connector

The 40G QSFP+ MPO transceiver modules use only female MPO connectors, which have guide holes in the
end face of the MPO connector (the transceiver has guide pins within the MPO receptacle).

MPO connectors are classified as the following types based on the polish type:
◦ Physical contact (PC): End face polished flat.

◦ Angle-polished contact (APC): End face polished with an angle, typically 8°.

MPO connectors are available with 12 fibers or 24 fibers:
12-fiber MPO connector (40G, SR4, eSR4, and 100G SR4 transceivers use 8 of the available 12 fibers. The
four center fibers are unused. )

Figure 3: End face of a 12-fiber connector and channel assignment

MPO transceivers typically use four channels to communicate. These channels are assigned using the outer
eight fibers (the center four are unused).

Transmit channels are one set of four fibers, and the receive channels are on the other set of four fibers.
Because of this, the cables used and fiber cable connections from endpoint to endpoint effectively create a
crossover connection.

Be aware that using two crossover cables in series cancels this effect and no connection will be established.
An odd number of crossovers combined with straight-thru fiber connections will effect a crossover connection.

The channel layout indicates that the left four fibers are Transmit, and must reach the opposite transceiver
Receive channels (and in proper channel order).
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Optical parameters
This guide provides average transmit and receive power ranges for transceiver modules.

Transmit power

Transmit power is the power at which the transmitter of an optical transceiver module transmits optical signals, in
dBm.

Receive power

Receive power is the power at which the receiver of an optical transceiver module receives optical signals, in
dBm.

Use of attenuators

Transceivers are designed to transmit light pulses at a power level that accounts for loss in the fiber optic cabling,
and meets the receiver input thresholds of the link partner optical transceiver.

If you are using a fiber cable with less light loss than expected (for example, in a test environment and you do not
have a 40km spool of SMF available), use attenuators to affect the transmit level to within the receive sensitivity of
the other transceiver -- you will need to condition both fibers (sends in both directions). If not done, you risk
overdriving the Receive end and permanently damaging the transceiver. For example, a 40G ER4 has a highest
transmit level of 4.5dBm, but the Receive Sensitivity can be no higher than -4.5dBm. That means there must be at
least a 9dBm loss on the light level to be within the standards (4.5 - (-4.5) = 9dBm required).

Copper transceiver modules
Copper transceiver modules transmit signals over Category-5 unshielded twisted pair (UTP). UTP transmission
cover shorter distances than fiber transmission and can be used in small-sized networks only.

Copper transceivers are supported in 1G SFP and 10G SFP+ ports where listed in the Support Matrix tables.

Transmission distance
Through UTP cables, signals can be transmitted over a distance of 100 m (328.08 ft.) only. This behavior occurs
because signals attenuate during transmission through the UTP cables.

Attenuation refers to the dissipation of the power of a transmitted signal as it travels over a cable. Attenuation
occurs because signal transmission suffers certain resistance from the cable, which weakens the signals as they
travel over the cable. When signals are transmitted over a long distance, signal strength decreases significantly,
causing the signal-to-noise ratio to drop below the accepted level. This decrease makes it impossible to
distinguish between signals and noise, which results in data loss.

Patch panel and punch down blocks also affect attenuation; that is, they can be a source of issues resulting in
shorter distances or data loss.

10GBASE-T connections require Category 6a as a minimum for proper 10G speeds up to the 100m distance
dictated by the IEEE 802.3ae standard. Anything less (Cat 6, 5e, 5) will compromise the distance that 10G over
copper can achieve.

Shielded Twisted Pair (STP) Cat 6a cable is required for full support when using the 10GBase-T transceiver
(JL563A) supported only on the 8400 and 8320 switch models. Use of STP prevents EMI events from affecting
data traffic carried on the wire - known as Crosstalk or Alien Crosstalk. Large EMI events from electronically noisy
environments may be coupled onto unshielded cabling and cause temporary packet errors. Fixed 10G ports have
designs to counteract these types of bit error conditions, that the 10GBASE-T transceiver cannot counteract
consistently. Using STP Cat6a cables mitigate the errors significantly. All packet loss errors observed in extensive
testing are considered recoverable by the host system with the JL563A transceiver.
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Connector
Registered Jack-45 (RJ-45) twisted-pair connectors are used as connectors for copper transceiver modules.

Figure 4: RJ-45 connector

Table 6: RJ-45 GE connector pin assignment for Gigabit connections

Pin Signal Function

1 MX_0+ Data transmit/receive

2 MX_0- Data transmit/receive

3 MX_1+ Data transmit/receive

4 MX_2+ Data transmit/receive

5 MX_2- Data transmit/receive

6 MX_1- Data transmit/receive

7 MX_3+ Data transmit/receive

8 MX_3- Data transmit/receive

Identification of 4x4 part numbers
A SKU# may be fulfilled by two or more vendor parts providing similar functionality. A 4x4 part number is of the
form nnnn-nnnn and is on the transceiver or DAC label. For example, JL309A can have a 1990-4680 or
1990-4678 4x4 part number. 4x4 part numbers are referenced in the

• specification tables, to identify parts that support DOM (Digital Optical Monitoring) capabilities. (Some older
vendor parts do not support DOM.)

• compatibility tables, where necessary, to identify supported combinations of switch or module with the
identified transceiver, along with the minimum software version required.

In December 2017, Aruba introduced Revision D versions of 100M, 1G, and 10G products. Revision D products
are structured to be specific alternative vendors as sources for the SKU#. Earlier Revision A, B, or C product may
have alternative vendors that Aruba no longer actively ships, but remains as fully supported in specific switches.

Some switch products will specify Revision D transceivers for full support, while other products may support
earlier (older) revision transceivers – and some with specific 4x4 part numbers.
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Always refer to the Datasheet or QuickSpecs for the switch product to see the current list of supported
transceivers. Refer to the compatibility tables within this document to cross-reference the Transceiver/DAC
product against the switch product to identify the minimum software required for transceiver support.

To use CLI commands to display data for an installed transceiver, see the following examples.

8400X# show int 1/10/6 transceiver 
------------------------------------------------------------
Port      Type        Product   Serial          Part        
                      Number    Number          Number      
------------------------------------------------------------
1/10/6    QSFP+SR4    JH231A    XX57nnnnnn      1990-5555  
8400X# show int 1/10/6 dom
-------------------------------------------------------------------------------------------
Port      Type        Channel#  Temperature     Voltage         Tx Bias      Rx Power        Tx Power        
                                (Celsius)       (Volts)         (mA)         (mW/dBm)        (mW/dBm)        
-------------------------------------------------------------------------------------------
1/10/6    QSFP+SR4    1         26.00           3.32            6.72         0.02, -16.99    0.58, -2.37     
                      2         26.00           3.32            6.79         0.02, -16.99    0.59, -2.29     
                      3         26.00           3.32            6.68         0.03, -15.23    0.59, -2.29     
                      4         26.00           3.32            6.82         0.03, -15.23    0.60, -2.22 

Aruba-5406Rzl2# show interfaces transceiver f2 detail
Transceiver in F2
   Interface Index    : 162 
   Type               : QSFP+SR4        
   Model              : JH231A  
   Connector Type     : MPO                             
   Wavelength         : 850nm                           
   Transfer Distance  : 100m (50um OM3), 150m (50um OM4)                
   Diagnostic Support : DOM   
   Serial Number      : XX57nnnnnn      
 Status
   Temperature : 33.332C         
   Voltage     : 3.3208V     

            Tx Bias  Rx Power       Tx Power
  Channel#  (mA)     (mW/dbM)       (mW/dbM)     
  --------- -------- -------------- --------------
  1         6.904    0.5622, -2.501 0.5822, -2.349
  2         6.706    0.5922, -2.275 0.5856, -2.324
  3         6.894    0.6321, -1.992 0.5813, -2.356
  4         6.792    0.5111, -2.915 0.5651, -2.479
  Current Alarms:
    Channel 1 :  
       Tx bias low alarm                      
       Rx power low warning                  
    Channel 2 :  
       Tx bias low alarm                      
       Rx power low warning                  
  Current Errors:
    Channel 1 :  
       Rx Loss of Signal                     
    Channel 2 :  
       Rx Loss of Signal                     
    Channel 3 :  
       Rx Loss of Signal                     
    Channel 4 :  
       Rx Loss of Signal                

Chapter 1 Overview 13

Anexo 01 ITEM 12 (0592742)         SEI 0008478-63.2018.6.02.8000 / pg. 8109



QSFP28 optical transceiver modules that use MPO
connectors
See Chapter 1, "Overview", for information regarding MPO connectors and cable requirements.

Figure 5: QSFP28 optical transceiver module that use MPO connectors

Models and specifications
QSFP28 optical transceiver modules provide a transmission rate of 100 Gbps and use MPO connectors.

Table 7: Specifications for QSFP28 optical transceiver modules that use MPO connectors (1)

Product name
(SKU)

DOM - Digital
Optical
Monitoring
(4x4 part #)

Central wl
(nm)

Fiber
mode

Fiber
diameter
(µm)

Modal
bandwidth
(MHz*km)

Transmission
distance

Aruba 100G
QSFP28 MPO
SR4 100m 12-fiber
MPO MMF
Transceiver
(JL309A)

YES

(1990-4680,
1990-4678)

850 MMF 50/125 2000 (OM3)

4700 (OM4)

70 m (229.66 ft)

100 m (328.08 ft)

NOTE: SR4 is not supported for use over MMF OM1 or OM2 fiber. (The IEEE standard does not
state a specification.) Use MPO Female connectors with the MPO transceivers.

Chapter 2
QSFP28 modules

14 ArubaOS-Switch and ArubaOS-CX Transceiver Guide

Anexo 01 ITEM 12 (0592742)         SEI 0008478-63.2018.6.02.8000 / pg. 8110



Table 8: Specifications for QSFP28 optical transceiver modules that use MPO connectors (2)

Product name (SKU) Connector Optical parameters (dBm)

Transmit power Receive power

Aruba 100G QSFP28 MPO SR4
100m 12-fiber MPO MMF
Transceiver (JL309A)

MPO (PC polished, 12-fiber) -8.4 to +2.4 -10.3 to +2.4

Table 9: Compatibility for the QSFP28 optical transceiver modules that use MPO connectors.

Product name (SKU) Minimum software required Comments

Aruba 8400X 6p 40G/100G QSFP28 Adv
Module (JL366A)

10.00.0005 10.00.0005 provided 100G
product support.

10.00.0006 provides additional
support for 40G on the JL366A.

QSFP28 optical transceiver modules that use LC
connectors
Figure 6: QSFP28 optical transceiver module that use LC connectors

Models and specifications
QSFP28 optical transceiver modules provide a transmission rate of 100 Gbps and use LC connectors.

Table 10: Specifications for QSFP28 optical transceiver modules that use LC connectors (1)

Product name
(SKU)

DOM - Digital
Optical
Monitoring
(4x4 part #)

Central wl
(nm)

Fiber
mode

Fiber
diameter
(µm)

Modal
bandwidth
(MHz*km)

Transmission
distance

Aruba 100G
QSFP28 LC LR4
10km SMF 2-
strand Transceiver
(JL310A)

YES

(1990-4681)

Four lanes:

1294.53 ~
1296.59

1299.02 ~
1301.09

1303.54 ~
1305.63

1308.09 ~
1310.19

SMF 9/125 N/A 10 km (6.21 miles)
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Table 11: Specifications for QSFP28 optical transceiver modules that use LC connectors (2)

Product name (SKU) Connector Optical parameters (dBm)

Transmit power Receive power

Aruba 100G QSFP28 LC LR4 10km SMF 2-
strand Transceiver (JL310A)

LC -4.3 to +4.5 per lane -10.6 to +4.5 per
lane

Table 12: Compatibility for the QSFP28 optical transceiver modules that use LC connectors

Product name (SKU) Minimum software required Comments

Aruba 8400X 6p 40G/100G QSFP28 Adv
Module (JL366A)

10.00.0005 10.00.0005 provides support for
100G products.

10.00.0006 provides additional
support for 40G on the JL366A.

QSFP28 DAC (copper cables)
Figure 7: QSFP28 DAC (copper cable)

Models and specifications
Table 13: Specifications for QSFP28 copper cables

Product name (SKU) Cable length Data rate Description

Aruba 100G QSFP28 to QSFP28 3m Direct
Attach Copper Cable (JL307A)

3 m (9.8 ft) 100 Gbps Used for interconnecting
100-Gigabit QSFP28 ports
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Table 14: Compatibility for the QSFP28 copper cables

Product name (SKU) Minimum software required Comments

Aruba 8400X 6p 40G/100G QSFP28 Adv
Module (JL366A)

All

Chapter 2 QSFP28 modules 17
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QSFP+ optical transceiver modules that use MPO
connectors
See Chapter 1, " Overview", for information regarding MPO connectors and cable requirements.

Figure 8: QSFP+ optical transceiver module that uses MPO connectors

Models, specifications, and compatibility
QSFP+ optical transceiver modules provide a transmission rate of 40 Gbps and use MPO connectors.

NOTE: 40G SR4 and eSR4 are not supported for use over MMF OM1 or OM2 quality fiber. (The
IEEE standard does not state a specification). Use MPO female connectors for use with the MPO
transceivers.

Table 15: Specifications for QSFP+ optical transceiver modules that use MPO connectors (1)

Product name
(SKU)

DOM - Digital
Optical
Monitoring
(4x4 part #)

Central wl
(nm)

Fiber
mode

Fiber
diameter
(µm)

Modal
bandwidth
(MHz*km)

Transmission
distance

HPE X142 40G
QSFP+ MPO SR4
Transceiver
(JH231A)

YES

(1990-4554)

850 MMF 50/125 2000 (OM3)

4700 (OM4)

100 m (328.08 ft)

150 m (492.12 ft)

HPE X142 40G
QSFP+ MPO
eSR4 300M XCVR
(JH233A)

YES

(1990-4555)

850 MMF 50/125 2000 (OM3)

4700 (OM4)

300 m (984.25 ft)

400 m (1312.33 ft)

Chapter 3
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Table 16: Specifications for QSFP+ optical transceiver modules that use MPO connectors (2)

Product name (SKU) Connector Optical parameters (dBm)

Transmit power Receive power

HPE X142 40G QSFP+ MPO
SR4 Transceiver (JH231A)

MPO (PC polished, 12-fiber) –7.6 to 0 –9.5 to +2.4

HPE X142 40G QSFP+ MPO
eSR4 300M XCVR (JH233A)

MPO (PC polished, 12-fiber) –7.6 to 0 –9.9 to +2.4

Table 17: Compatibility for the QSFP+ optical transceiver modules that use MPO connectors

Product name (SKU) Minimum software required Comments

Aruba 3810M/2930M 1QSFP+ 40GbE
Module (JL078A)

All

Aruba 3810M 24G 1-slot Switch 2QSFP
+ 40GbE Module (JL079A)

All

20p PoE+ / 1p 40GbE QSFP+ v3 zl2
Module (J9992A)

KB.15.17

2p 40GbE QSFP+ v3 zl2 Module
(J9996A)

KB.15.17

Aruba 8320 48p SFP/SFP+ & 6p 40G
QSFP+ Switch (JL479A)

10.00.0006

Aruba 8320 32p 40G QSFP+ Switch
(JL579A)

10.00.0012

Aruba 8400X 8p 40G QSFP+ Adv Module
(JL365A)

All

Aruba 8400X 6p 40G/100G QSFP28 Adv
Module (JL366A)

10.00.0006 10.00.0005 supports 100G
products.

10.00.0006 provides additional
support for 40G on the JL366A.

QSFP+ optical transceiver modules that use LC
connectors
Figure 9: QSFP+optical transceiver module that uses LC connectors
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Models, specifications, and compatibility
QSFP+ optical transceiver modules provide a transmission rate of 40 Gbps and use LC connectors.

Table 18: Specifications for QSFP+ transceiver modules that use LC connectors (1)

Product name
(SKU)

DOM - Digital
Optical
Monitoring
(4x4)

Central wl
(nm)

Fiber
mode

Fiber
diameter
(µm)

Modal
bandwidth
(MHz*km)

Transmission
distance

Aruba 40G QSFP+
LC BiDi 150m
MMF Transceiver
(JL308A)

YES

(1990-4679)

Dual
20Gb/s:

• 850

• 900

MMF 50/125 2000 (OM3)

4700 (OM4)

100 m (328.08 ft)

150 m (492.12 ft)

Not supported on
OM1/OM2.

HPE X142 40G
QSFP+ LC LR4
SM Transceiver
(JH232A)

YES

(1990-4556)

Four
lanes:

• 1271

• 1291

• 1311

• 1331

SMF 9/125 N/A 10 km (6.21 miles)

Aruba 40G QSFP+
LC ER4 40km
SMF XCVR
(Q9G82A)

YES

(1990-4734)

Four
lanes:

• 1271

• 1291

• 1311

• 1331

SMF 9/125 N/A 40km (24.86 miles)

Table 19: Specifications for QSFP+ transceiver modules that use LC connectors (2)

Product name (SKU) Optical parameters (dBm)

Transmit power Receive power

Aruba 40G QSFP+ LC BiDi 150m MMF Transceiver
(JL308A)

–4 to +5 –6 to +5

HPE X142 40G QSFP+ LC LR4 SM Transceiver
(JH232A)

–7 to +2.3 per lane –13.7 to +2.3 per lane

Aruba 40G QSFP+ LC ER4 40km SMF XCVR
(Q9G82A)

-2.7 to 4.5 dBm -21.2 to -4.5 dBm

(Use attenuators to match
power levels.)
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Table 20: Compatibility for the QSFP+ optical transceiver modules that use LC connectors

Product name (SKU) Minimum software required Comments

Aruba 3810M/2930M 1QSFP+ 40GbE
Module (JL078A)

For JH232A: all

For JL308A: KB.16.04.0008 or
WC.16.04.0008

Q9G82A not supported.

Aruba 3810M 2QSFP+ 40GbE Module
(JL079A)

For JH232A: all

For JL308A: KB.16.04.0008

Q9G82A not supported.

The JL079A module is not
supported in the 2930M series
nor on the 3810M 16SFP+ 2-slot
switch (JL075A).

20p PoE+ / 1p 40GbE QSFP+ v3 zl2
Module (J9992A)

For JH232A: KB.15.17

For JL308A: KB.16.04.0008

Q9G82A not supported.

2p 40GbE QSFP+ v3 zl2 Module
(J9996A)

For JH232A: KB.15.17

For JL308A: KB.16.04.0008

Q9G82A not supported.

Aruba 8320 48p SFP/SFP+ & 6p 40G
QSFP+ Switch (JL479A)

For JH232A: 10.00.0006

For JL308A: 10.00.0006

For Q9G82A: 10.00.0018

Aruba 8320 32p 40G QSFP+ Switch
(JL579A)

For JH232A: 10.00.0012

For JL308A: 10.00.0012

For Q9G82A: 10.00.0018

Aruba 8400X 8p 40G QSFP+ Adv Module
(JL365A)

For JH232A: all

For JL308A: all

For Q9G82A: 10.00.0018

Aruba 8400X 6p 40G/100G QSFP28 Adv
Module (JL366A)

For JH232A: 10.00.0006

For JL308A: 10.00.0006

For Q9G82A: 10.00.0018

10.00.0005 provides support for
100G products.

10.00.0006 provides additional
support for 40G on the JL366A.
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QSFP+ DAC (copper cables)
Figure 10: QSFP+ DAC copper cables

IMPORTANT: Direct Attach over Copper (DAC) cables have a minimum bend radius of typically 4x
the diameter of the cable (approximately a 1" bend radius). Handle DAC cables carefully to ensure
that you do not crimp or bend the cable beyond a 1" radius. Otherwise, you risk damaging the cable.

Models, specifications, and compatibility
Table 21: Specifications for QSFP+ copper cables

Product name (SKU) Cable length Data rate Description

HPE X242 40G QSFP+ to QSFP+ 1m DAC
Cable (JH234A)

1 m (3.28 ft)

40 Gbps Used for interconnecting
40-Gigabit QSFP+ ports

HPE X242 40G QSFP+ to QSFP+ 3m DAC
Cable (JH235A)

3 m (9.84 ft)

HPE X242 40G QSFP+ to QSFP+ 5m DAC
Cable (JH236A)

5 m (16.40 ft)

Table 22: Compatibility for the QSFP+ copper cables

Product name (SKU) Minimum software required Comments

Aruba 3810M/2930M 1QSFP+ 40GbE
Module (JL078A)

All

Aruba 3810M 2QSFP+ 40GbE Module
(JL079A)

All The JL079A module is not
supported in the 2930M
series nor on the 3810M
16SFP+ 2-slot Switch
(JL075A).

20p PoE+ / 1p 40GbE QSFP+ v3 zl2
Module (J9992A)

KB.15.17

Table Continued
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Product name (SKU) Minimum software required Comments

2p 40GbE QSFP+ v3 zl2 Module
(J9996A)

KB.15.17

Aruba 8320 48p 10G SFP/SFP+ and 6p
40G QSFP+ Switch (JL479A)

All

Aruba 8320 32p 40G QSFP+ Switch
(JL579A)

10.00.0012

Aruba 8400X 8p 40G QSFP+ Adv Module
(JL365A)

All

Aruba 8400X 6p 40G/100G QSFP28 Adv
Module (JL366A)

10.00.0006
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SFP+ optical transceiver modules
In December, 2017, Aruba introduced Revision D versions of 100M, 1G, and 10G transceivers. Revision D
products are structured to be specific alternate vendors as sources for the SKU#. Earlier Revision A, B, or C
product may have alternate vendors that we no longer actively ship, but remain as fully supported in earlier and
current products.

Some switch products will be specifying Revision D transceivers for full support, while other products may support
earlier (older) revision transceivers – and some with specific 4x4 part numbers (see Chapter 1, "Overview", for
information regarding 4x4 part numbers).

Always refer to the Datasheet or QuickSpecs for the Switch product to see the current list of supported
transceivers.

Figure 11: SFP+ optical transceiver modules

NOTE: 

• Although a 10G SFP+ transceiver module is the same physical dimensions of a 1G SFP
transceiver, a 10G transceiver will NOT operate in a 1G SFP port.

• Many, although not all, 10G SFP+ ports have support to use a 1G SFP transceiver (or even a
100Mbps FX SFP transceiver).

See the QuickSpec for the Switch product and verify if the 1G or 100Mbps SFP transceiver is
supported in the 10G SFP+ port.

Models, specifications, and compatibility
SFP+ optical transceiver modules provide a transmission rate of 10.31 Gbps and use LC connectors.

The specifications for Revision D transceiver products are the same as the specified Revision A, B, C SKUs.
Where support for a Revision A, B, or C transceiver existed, Revision D parts are also supported.

Chapter 4
SFP+ modules
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Table 23: Specifications for SFP+ optical transceiver modules (1)

Product Name
(SKU)

DOM - Digital
Optical
Monitoring
(4x4 part #)

Central
we (nm)

Fiber
mode

Fiber
diameter
(µm)

Bandwidth
(MHz*km)

Transmission
distance

HPE X132 10G
SFP+ LC SR
Transceiver
(J9150A)

Aruba 10G SFP+
LC SR 300m MMF
XCVR (J9150D)

Yes

(1990-4391,

1990-4175)

850 MMF 50/125 4700 (OM4)

2000 (OM3)

500 (OM2)

400

400 m (1312.34 ft)

300 m (984.25 ft)

82 m (269.03 ft)

66 m (216.54 ft)

62.5/125 200 (OM1)

160

33 m (108.27 ft)

26 m (85.30 ft)

HPE X132 10G
SFP+ LC LRM
Transceiver
(J9152A)

Aruba 10G SFP+
LC LRM 220m
MMF XCVR
(J9152D)

Yes

(1990-4485)

1310 MMF 50/125 1500

500 (OM2)

400

220 m (721.78 ft)

220 m (721.78 ft)

100 m (328.08 ft)

62.5/125 200 (OM1)

160

220 m (721.78 ft)

220 m (721.78 ft)

SMF 9/125 N/A 300m (987.25 ft)

HPE X132 10G
SFP+ LC LR
Transceiver
(J9151A)

Aruba 10G SFP+
LC LR 10km SMF
XCVR (J9151D)

Yes

(1990-4657,

1990-4694)

1310 SMF 9/125 N/A 10 km (6.21 miles)

HPE X132 10G
SFP+ LC ER
Transceiver
(J9153A)

Aruba 10G SFP+
LC ER 40km SMF
XCVR (J9153D)

Yes

(1990-4365,

1990-4656)

1550 SMF 9/125 N/A 40 km (24.86
miles)

NOTE: A mode conditioning patch cord is required when you use OM1 or OM2 fiber types on a 10G
LRM Transceiver (J9152A/J9152D). Never use mode conditioning patch cords for OM3 or OM4 fiber
types. For more information about mode conditioning patch cords, see related parts in the IEEE
802.3 standard.
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Table 24: Specifications for SFP+ optical transceiver modules (2)

Product name (SKU) Optical parameters (dBm)

Transmit power Receive power

HPE X132 10G SFP+ LC SR Transceiver (J9150A)

Aruba 10G SFP+ LC SR 300m MMF XCVR (J9150D)

–7.3 to –1 –9.9 to +0.5

HPE X132 10G SFP+ LC LRM Transceiver (J9152A)

Aruba 10G SFP+ LC LRM 220m MMF XCVR (J9152D)

–6.5 to +0.5 –6.5 to +1.5

HPE X132 10G SFP+ LC LR Transceiver (J9151A)

Aruba 10G SFP+ LC LR 10km SMF XCVR (J9151D)

–8.2 to +0.5 –14.4 to +0.5

HPE X132 10G SFP+ LC ER Transceiver (J9153A)

Aruba 10G SFP+ LC ER 40km SMF XCVR (J9153D)

–4.7 to +4 –15.8 to –1

Table 25: Compatibility for the SFP+ optical transceiver module

Product name SKU Minimum software required Comments

10G-SR, LR, LRM
(J9150A/J9150D,
J9151A/J9151D,
J9152A/J9152D)

10G-ER (J9153A/
J9153D)

1850 Switch Series JL169A J9150A/J9150D: All

J9151A/J9151D: All

J9152A/J9152D: All

J9153A/J9153D is
not supported on the
1850 Switch Series.

Unlisted models do not
have SFP+ ports.

2530 Switch Series J9853A

J9854A

J9855A

J9856A

All All Unlisted models do not
have SFP+ ports.

2540 Switch Series JL354A

JL355A

JL356A

JL357A

All (J9150A/J9150D
and J9151A/J9151D
only)

J9152A/J9152D
(LRM) is not
supported in any 2540
model

All J9152A/J9152D (LRM)
is not supported in any
2540 model.

2910al Switch Series J9008A All W.15.07.0002 Unlisted models do not
have SFP+ ports.

Table Continued
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Product name SKU Minimum software required Comments

10G-SR, LR, LRM
(J9150A/J9150D,
J9151A/J9151D,
J9152A/J9152D)

10G-ER (J9153A/
J9153D)

2920 Switch Series J9726A

J9727A

J9728A

J9729A

J9836A

All For use in an installed
J9731A Aruba 2920 2-
port 10GbE SFP+
Module.

2930F Switch Series JL253A

JL254A

JL255A

JL256A

JL258A

JL263A

JL264A

JL558A

JL559A

All (J9150A/J9150D
and J9151A/J9151D
only)

J9152A/J9152D
(LRM) is not
supported in any
2930F model

All Unlisted models do not
have SFP+ ports.

J9152A/J9152D (or
any 10G LRM
technology) is not
supported in any
2930F model.

2930M Switch Series JL319A

JL320A

JL321A

JL322A

JL323A

JL324A

All All For use in an installed
JL083A Aruba 3810M/
2930M 4SFP+
MACsec Module.

3500yl Switch Series J8692A

J8693A

J9310A

J9311A

K.14.50 and later K.15.02.0004 and
later

For use in an installed
J9312A 10GbE 2-port
SFP+/2-port CX4 yl
Module.

3800 Switch Series J9575A

J9576A

J9573A

J9574A

J9584A

All All Unlisted models do not
have SFP+ ports.

Table Continued
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Product name SKU Minimum software required Comments

10G-SR, LR, LRM
(J9150A/J9150D,
J9151A/J9151D,
J9152A/J9152D)

10G-ER (J9153A/
J9153D)

3810M Switch Series JL071A

JL072A

JL073A

JL074A

JL076A

All All For use in an installed
JL083A Aruba 3810M/
2930M 4SFP+
MACsec Module

JL075A All All For use in the JL075A
SFP+ ports or in an
installed JL083A
Aruba 3810M/2930M
4SFP+ MACsec
Module

5400zl Switch Series J9309A K.14.39 K.15.02.0004

J9538A

J9548A

J9536A

K.15.02.0004 K.15.02.0004

5400R Switch Series J9538A

J9548A

J9536A

All All

J9990A

J9993A

KB.15.17 KB.15.17

6120 Switch Series 516733-
B21
(6120XG)

All (not supported) 498358-B21
(6120G/XG) has 1GB
SFP and 10G XFP or
CX4 ports and does
not support these SFP
+ transceivers

6200yl Switch Series J8992A K.14.50 K.15.02.0004 J8992A fixed SFP
ports are 1GB and do
not support these SFP
+ transceivers

For use in an installed
J9312A 10GbE 2-port
SFP+/2-port CX4 yl
Module

6600 Switch Series J9264A

J9265A

K.14.03 K.15.02.0004

Table Continued

28 ArubaOS-Switch and ArubaOS-CX Transceiver Guide

Anexo 01 ITEM 12 (0592742)         SEI 0008478-63.2018.6.02.8000 / pg. 8124



Product name SKU Minimum software required Comments

10G-SR, LR, LRM
(J9150A/J9150D,
J9151A/J9151D,
J9152A/J9152D)

10G-ER (J9153A/
J9153D)

J9452A K.14.24 K.15.02.0004

8200zl Switch Series J9309A K.14.39 K.15.02.0004

J9538A

J9548A

J9536A

K.15.02.0004 K.15.02.0004

Aruba 8320 48p 10G
SFP/SFP+ and 6p 40G
QSFP+ Switch

JL479A All (J9150A/J9150D
and J9151A/J9151D
only)

J9152A/J9152D
(LRM) is not
supported in the 8320
switches

All Only the following 4x4
part numbers are
supported:

• J9150A/J9150D:
1990-4391, 1990-4175

• J9151A/J9151D:
1990-4657,
1990-4727, 1990-4694

• J9153A/J9153D:
1990-4365, 1990-4656

J9152A/J9152D (or
any 10G LRM
technology) is not
supported in the 8320
Switches

Aruba 8400X 32p 10G
SFP/SFP+ Msec Module

JL363A All All Only the following 4x4
part numbers are
supported:
• J9150A/J9150D:

1990-4391,
1990-4175

• J9151A/J9151D:
1990-4657,
1990-4727,
1990-4694

• J9152A/J9152D:
1990-4485

• J9153A/J9153D:
1990-4365,
1990-4656

NOTE: A mode conditioning patch cord is required when you use OM1 or OM2 fiber types on a10G
LRM Transceiver. Never use mode conditioning patch cords for OM3 or OM4 fiber types. For more
information about mode conditioning patch cords, see related parts in the IEEE 802.3 standard.
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10G SFP+ copper transceiver modules
Figure 12: 10G SFP+ copper transceiver module

Models, specifications, and compatibility
Table 26: Specifications for SFP+ copper transceiver modules

Product name (SKU) Transmission
distance

Data rate Cable type Connector
type

Aruba 10GBASE-T SFP+ RJ45 30m
Cat6A XCVR (JL563A)

30 m (98.43 ft) 10G STP Cat6A 1 RJ-45

1 See Transmission distance on page 11.

Table 27: Compatibility for SFP+ copper transceiver modules

Product name SKU Minimum software
required (JL563A)

Comments

Aruba 8320 48p 10G SFP/SFP+
and 6p 40G QSFP+ Switch

JL479A 10.01.0011 The JL563A transceiver does
NOT support 1G operation;
only 10G.

Aruba 8400X 32p 10G SFP/SFP+
Msec Module

JL363A 10.00.0018

SFP+ DAC cables
Figure 13: SFP+ DAC cable

IMPORTANT: Direct Attach over Copper (DAC) cables have a minimum bend radius of typically 4x
the diameter of the cable (approximately a 1" bend radius). Handle DAC cables carefully to ensure
that you do not crimp or bend the cable beyond a 1" radius, otherwise, you risk damaging the cable.
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Models, specifications, and compatibility
The specifications for Revision D transceiver products are the same as the specified Revision A, B, and C SKUs.
Where support for a Revision A, B, or C transceiver existed, Revision D parts are also supported.

Table 28: Specifications for SFP+ DAC cables

Product name (SKU) Cable length Data rate Type

HPE X242 10G SFP+ to SFP+ 1m DAC Cable (J9281B)

Aruba 10G SFP+ to SFP+ 1m DAC Cable (J9281D)

1 m (3.28 ft)

10.31 Gbps SFP+ cable
HPE X242 10G SFP+ to SFP+ 3m DAC Cable (J9283B)

Aruba 10G SFP+ to SFP+ 3m DAC Cable (J9283D)

3 m (9.84 ft)

HPE X242 10G SFP+ to SFP+ 7m DAC Cable (J9285B)

Aruba 10G SFP+ to SFP+ 7m DAC Cable (J9285D)

7 m (22.97 ft)

Table 29: Compatibility for the SFP+ copper cables

Product name SKU Minimum software required
(J9281B/J9281D, J9283B/J9283D,
J9285B/J9285D)

Comments

1850 Switch Series JL169A All Unlisted models do not have
SFP+ ports.

2530 Switch Series J9853A

J9854A

J9855A

J9856A

All Unlisted models do not have
SFP+ ports.

2540 Switch Series JL354A

JL355A

JL356A

JL357A

All (J9281B/J9281D and J9283B/
J9283D only. See comments for
exception)

J9285B/J9285D or any type
of 7m DAC are not supported
in any of these series

2910al Switch Series J9145A

J9146A

J9147A

J9148A

W.14.28 For use in the J9008A 2-port
10GbE SFP+ al module.

2920 Switch Series J9726A

J9727A

J9728A

J9729A

J9836A

All The SFP ports on the models
listed do not support these
10G SFP+ cables. For use in
an installed J9731A Aruba
2920 2-port 10GbE SFP+ .

Table Continued
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Product name SKU Minimum software required
(J9281B/J9281D, J9283B/J9283D,
J9285B/J9285D)

Comments

2930F Switch Series JL253A

JL254A

JL255A

JL256A

JL258A

JL263A

JL264A

JL558A

JL559A

All (J9281B/J9281D and J9283B/
J9283D only. See comment for
exception)

Unlisted models do not have
10G SFP+ ports.

J9285B/J9285D or any type
of 7m DAC are not supported
in any of these series.

2930M Switch Series JL319A

JL320A

JL321A

JL322A

JL323A

JL324A

All For use in an installed
JL083A Aruba 3810M/2930M
4SFP+ MACsec Module

J9285B/9285D (7m DAC) is
supported in all 2930M
models.

3500yl Switch Series J8692A

J8693A

J9310A

J9311A

K.14.50 For use in an installed
J9312A 10GbE 2-port SFP
+/2-port CX4 yl Module.

3800 Switch Series J9575A

J9576A

J9573A

J9574A

J9584A

All Unlisted models not do not
have SFP+ ports.

3810M Switch Series JL071A

JL072A

JL073A

JL074A

JL076A

All For use in an installed
JL083A Aruba 3810M/2930M
4SFP+ MACsec Module.

JL075A All For use in the JL075A SFP+
ports or used in an installed
JL083A Aruba 3810M/2930M
4SFP+ MACsec Module.

5400zl Switch Series J9309A K.14.39

Table Continued
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Product name SKU Minimum software required
(J9281B/J9281D, J9283B/J9283D,
J9285B/J9285D)

Comments

J9538A

J9548A

J9536A

K.15.02.0004

5400R Switch Series J9538A

J9548A

J9536A

All

J9990A

J9993A

KB.15.17

6120 Switch Series 516733-B21 All

6200yl Switch Series J8992A K.14.50 J8992A fixed SFP ports are
1GB and do not support
these SFP+ copper
cables.For use in an installed
J9312A 10GbE 2-port SFP
+/2-port CX4 yl Module.

6600 Switch Series J9264A

J9265A

J9452A

K.14.32

8200zl Switch Series J9309A K.14.39

J9538A

J9548A

J9536A

K.15.02.0004

Table Continued
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Product name SKU Minimum software required
(J9281B/J9281D, J9283B/J9283D,
J9285B/J9285D)

Comments

Aruba 8320 48p 10G
SFP/SFP+ and 6p
40G QSFP+ Switch

JL479A All (J9281B/J9281D and J9283B/
J9283D only. See comment for
exception.)

Only the following 4x4 part
numbers are supported:

• J9281B/J9281D: 8121-1151,
8121-1300

• J9283B/J9283D: 8121-1152,
8121-1298

J9285B/J9285D or any type
of 7m DAC are not supported
in the JL479A 8320 model.

Aruba 8400X 32p 10G
SFP/SFP+ Msec
Module

JL363A All Only the following 4x4 part
numbers are supported:
• J9281B/J9281D:

8121-1151, 8121-1300

• J9283B/9283D:
8121-1152, 8121-1298

• J9285B/J9285D:
8121-1154, 8121-1305
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Gigabit SFP optical transceiver modules
In December 2017, Aruba introduced Revision D versions of 100M, 1G, and 10G transceivers. Revision D
products are structured to be specific alternative vendors as sources for the SKU#. Earlier Revision A, B, or C
product may have alternative vendors that we no longer actively ship, but remain as fully supported in earlier and
current products.

Some switch products will be specifying Revision D transceivers for full support, while other products may support
earlier (older) revision transceivers – and some with specific 4x4 part numbers (see Chapter 1, "Overview" for
information regarding 4x4 part numbers).

Always refer to the Datasheet or QuickSpecs for the Switch product to see the current list of supported
transceivers.

Figure 14: Gigabit or 100-Megabit SFP optical transceiver module

NOTE: 

• Although a 10G SFP+ transceiver module has the same physical dimensions of a 1G SFP
transceiver, a 10G transceiver will NOT operate in a 1G SFP port.

• Many, although not all, 10G SFP+ ports have support to use a 1G SFP transceiver (or even a
100Mbps FX SFP transceiver). See the QuickSpec for the Switch product and verify if the 1G or
100Mbps SFP transceiver is supported in the 10G SFP+ port.

Models, specifications, and compatibility
Gigabit SFP optical transceiver modules use LC connectors.

The specifications for Revision D transceiver products are the same as the specified Revision A, B, and C SKUs.
Where support for a Revision A, B, or C transceiver existed, Revision D parts are also supported.

Chapter 5
SFP modules
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Table 30: Specifications for Gigabit SFP optical transceiver modules (1)

Product name
(SKU)

DOM - Digital
Optical
Monitoring
(4x4 part #)

Central wl
(nm)

Fiber
mode

Fiber
diameter
(µm)

Modal
bandwidth
(MHz*km)

Transmission
distance

HPE X121 1G SFP
LC SX Transceiver
(J4858C)

Aruba 1G SFP LC
SX 500m MMF
XCVR (J4858D)

Yes

(1990-4395 &
1990-4415)

850 MMF 50/125 500 (OM2)

400

550 m (1804.46 ft)

500 m (1640.42 ft)

62.5/125 200 (OM1)

160

275 m (902.23 ft)

220 m (721.78 ft)

HPE X121 1G SFP
LC LX Transceiver
(J4859C)

Aruba 1G SFP LC
LX 10km SMF
XCVR (J4859D)

Yes

(1990-4116,
1990-4414, &
1990-4608)

1310 SMF 9/125 N/A 10 km (6.21 miles)

MMF 50/125 500 or 400 550 m (1804.46 ft)

MMF 62.5/125 500 550 m (1804.46 ft)

HPE X121 1G SFP
LC LH Transceiver
(J4860C)

Aruba 1G SFP LC
LH 70km SMF
XCVR (J4860D)

Yes

(1990-4363)

1550 SMF 9/125 N/A 70 km (43.49
miles)

Table 31: Specifications for Gigabit SFP optical transceiver modules (2)

Product name (SKU) Optical parameters (dBm)

Transmit power Receive power

HPE X121 1G SFP LC SX Transceiver (J4858C)

Aruba 1G SFP LC SX 500m MMF XCVR (J4858D)

–9.5 to 0 –17 to –3

HPE X121 1G SFP LC LX Transceiver (J4859C)

Aruba 1G SFP LC LX 10km SMF XCVR (J4859D)

–9.5 to –3 –20 to –3

HPE X121 1G SFP LC LH Transceiver (J4860C)

Aruba 1G SFP LC LH 70km SMF XCVR (J4860D)

0 to +5 –22 to –3
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Table 32: Compatibility for Gigabit SFP optical transceiver modules

Product name SKU Minimum software required
(J4858C/J4858D, J4859C/J4859D,
J4860C/J4860D)

Comments

1400 Switch Series J9078A All

1410 Switch Series J9561A All

1700 Switch Series J9080A VB.01.09

1800 Switch Series J9028A/B PB.02.09

1810 Switch Series J9450A

J9660A

J4858C/J4858D: All

J4859C/J4859D: All

Gig LH (J4850C/
J4860D) is supported
only in the J9450A
model.

J9801A

J9803A

J9834A

J4858C/J4858D: All

J4859C/J4859D: All

Gig LH (J4860C/
J4860D) is not
supported.

1820 Switch Series J9980A

J9981A

J9983A

J9984A

J4858C/J4858D: All

J4859C/J4859D: All

J4860C/J4860D: Not supported

Gig LH (J4860C/
J4860D) is not
supported on the 1820
series.

1850 Switch Series JL169A J4858C/JL4858D: All

J4859C/J4859D: All

J4860C/J4860D: Not supported

Gig LH (J4860C/
J4860D) is not
supported on the 1850
series. Other 1850
models not listed do not
have SFP ports.

1920S JL381A

JL382A

JL384A

JL385A

JL386A

J4858C/J4858D: All

J4859C/J4859D: All

J4860C/J4860D: Not supported

Gig LH (J4860C/
J4860D) is not
supported on the 1920S
series.

Models JL380A and
JL383A do not include
SFP ports.

2510 Switch Series J9019A/B

J9020A

J9279A

J9280A

All

2520 Switch Series J9137A

J9138A

J9298A

J9299A

All

Table Continued
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Product name SKU Minimum software required
(J4858C/J4858D, J4859C/J4859D,
J4860C/J4860D)

Comments

2530 Switch Series J9772A

J9773A

J9774A

J9775A

J9776A

J9777A

J9778A

J9779A

J9780A

J9781A

J9782A

J9783A

J9853A

J9854A

J9855A

J9856A

All

2540 Switch Series JL354A

JL355A

JL356A

JL357A

All

2600 Switch Series J4899A/B/C

J4900A/B/C

J8164A

J8165A

J8762A

H.08.98

2610 Switch Series J9085A

J9086A

J9087A

J9088A

J9089A

All

2615-8-PoE Switch J9565A All

Table Continued
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Product name SKU Minimum software required
(J4858C/J4858D, J4859C/J4859D,
J4860C/J4860D)

Comments

2620 Switch Series J9623A

J9624A

J9625A

J9626A

J9627A

All

2800 Switch Series J4903A

J4904A

i.08.103

2810 Switch Series J9021A

J9022A

All

2900 Switch Series J9049A

J9050A

T.13.45

2910al Switch Series J9145A

J9146A

J9147A

J9148A

All For use in the SFP ports
on the models listed, and
in the J9008A 2-port
10GbE SFP+ al module.

2915-8G-PoE Switch J9562A All

2920 Series Switches J9726A

J9727A

J9728A

J9729A

J9836A

All For use in the SFP ports
on the models listed.
Also for use in the dual-
speed SFP+ ports of the
J9731A 2-Port 10GbE
SFP+ Module.

Table Continued
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Product name SKU Minimum software required
(J4858C/J4858D, J4859C/J4859D,
J4860C/J4860D)

Comments

2930F Series Switches JL253A

JL254A

JL255A

JL256A

JL258A

JL259A

JL260A

JL261A

JL262A

JL263A

JL264A

JL557A

JL558A

JL559A

All

2930M Switch Series JL319A

JL320A

JL321A

JL322A

JL323A

JL324A

All For use in SFP ports on
switch and an installed
JL083A Aruba 3810M/
2930M 4SFP+ MACsec
Module.

3400cl Switch Series J4905A

J4906A

All

3500 Series Switches J9470A

J9471A

J9472A

J9473A

K.14.31

3500yl Switch Series J8692A

J8693A

All For use in the SFP ports
on the models listed, and
in an installed J9312A
10GbE 2-port SFP+/2-
port CX4 yl Model

J9310A

J9311A

K.14.50

Table Continued
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Product name SKU Minimum software required
(J4858C/J4858D, J4859C/J4859D,
J4860C/J4860D)

Comments

3800 Switch Series J9573A

J9574A

J9575A

J9576A

J9584A

All

3810M Switch Series JL071A

JL072A

JL073A

JL074A

JL076A

JL075A

All For use in the JL075A
3810M switch. Also for
use in any 3810M switch
with a JL083A Aruba
3810M/2930M 4SFP+
MACsec Module
installed.

4200gl Switch Series J4893A

J4908A

G.07.103

4200vl Switch Series J8776A

J9033A

All

5300xl Switch Series J4878A/B

J4907A

E.10.36

5400zl Switch Series J8705A

J8706A

All

J9308A K.14.34

J9537A

J9549A

J9535A

J9637A

J9538A

J9548A

J9536A

K.15.02.0004

Table Continued
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Product name SKU Minimum software required
(J4858C/J4858D, J4859C/J4859D,
J4860C/J4860D)

Comments

5400R Switch Series J9537A

J9549A

J9535A

J9637A

J9538A

J9548A

J9536A

All

J9988A

J9989A

J9990A

J9993A

KB.15.17

6108 Switch J4902A H.07.88

6120 Switch Series 498358-B21

516733-B21

SX, LX: all versions

LH: not supported

6200yl-24G-mGBIC Switch J8992A All

6600 Switch Series J9263A

J9264A

K.14.03

J9451A K.14.24

8100fl Switch J8735A All

8200zl Switch Series J8705A

J8706A

All

J9308A K.14.34

J9537A

J9549A

J9535A

J9637A

J9538A

J9548A

J9536A

K.15.02.0004

Table Continued
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Product name SKU Minimum software required
(J4858C/J4858D, J4859C/J4859D,
J4860C/J4860D)

Comments

Aruba 8320 48p 10G
SFP/SFP+ and 6p 40G QSFP
+ Switch

JL479A All Only the following 4x4
part numbers are
supported:

• J4858C/J4858D:
1990-4395, 1990-4415

• J4859C/J4859D:
1990-4116, 1990-4414

• J4860C/J4860D:
1990-4363

Aruba 8400X 32p 10G
SFP/SFP+ Msec Module

JL363A All Only the following 4x4
part numbers are
supported:
• • J4858C/J4858D:

1990-4395,
1990-4415

• • J4859C/J4859D:
1990-4116,
1990-4414

• • J4860C/J4860D:
1990-4363

9300m Switch Series J4885A

J4894A

All

9408sl Switch J8684A All

100-Megabit SFP optical transceiver modules
Figure 15: Gigabit or 100-Megabit SFP optical transceiver module

Models, specifications, and compatibility
100 Megabit SFP optical transceiver modules use LC connectors.

The specifications for Revision D transceiver products are the same as the specified Revision A, B, and C SKUs.
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Table 33: Specifications for 100-Megabit SFP optical transceiver modules (1)

Product name (SKU) DOM - Digital
Optical
Monitoring (4x4
part #)

Central wl
(nm)

Fiber
mode

Fiber diameter
(µm)

Transmission
distance

HPE X111 100M SFP
LC FX Transceiver
(J9054C)

Aruba 100M SFP LC
FX 2km MMF XCVR
(J9054D)

Yes

(1990-4483,
1990-4360)

1310 MMF 50/125

62.5/125

2 km (1.24 miles)

Table 34: Specifications for 100–Megabit SFP optical transceiver modules (2)

Product name (SKU) Optical parameters (dBm)

Transmit power Receive power

HPE X111 100M SFP LC FX Transceiver
(J9054C)

Aruba 100M SFP LC FX 2km MMF XCVR
(J9054D)

–19 to –14 –30 to –14

Table 35: Compatibility for the 100-Megabit SFP optical transceiver module

Product name SKU Minimum software required Comments

1410G Switch Series J9559A

J9560A

J9561A

J9559A, J9560A: Not supported (no
SFP ports)

J9561A: All

For use in the SFP ports of the
J9561A 1410-24G Switch

1810G Series
Switches

J9450A

J9660A

For J9450A, J9660A: All For use in the SFP ports of the
J9450A 1810G-24 Switch and
J9660A V1810-48G Switch. (The
J9449A 1810G-8 Switch does not
have SFP ports.)

1810G v2 Switch
Series

J9801A

J9803A

All For use in the SFP ports of the
J9801A 1810-24 v2 and J9803A
1810-24G v2 Switches

PS1810 Switch J9834A All For use in the SFP ports of the
J9834A PS1810-24G Switch

Table Continued
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Product name SKU Minimum software required Comments

1820 Switch Series J9980A

J9981A

J9983A

J9984A

All The J9054B 100-FX SFP-LC
transceiver is not supported in the
1820G switches

The J9054C part number
1990-4483 is not supported in
these products.

(Only the J9054C/J9054D part
number 1990-4360 is supported.)

2510-24 Switch J9019A/B Q.10.04

2510-48 Switch J9020A All

2510G Switch Series J9279A

J9280A

All

2520 Switch Series J9137A

J9138A

All

2520G Switch Series J9298A

J9299A

J9054B: All

J9054C: J.14.32

2530 Switch Series J9772A

J9773A

J9774A

J9775A

J9776A

J9777A

J9778A

J9779A

J9780A

J9781A

J9782A

J9783A

J9853A

J9854A

J9855A

J9856A

For J9853A, J9854A, J9855A, and
J9856A: Not supported

For all other switches: All

For use in the SFP ports of the
2530 Series Switches. (The
J9853A, J9854A, J9855A, and
J9856A models have 1G/10G
SFP+ ports that do not support
these 100Mbps transceiver
modules.)

Table Continued
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Product name SKU Minimum software required Comments

2540 Switch Series JL354A

JL355A

JL356A

JL357A

All

2610 Switch Series J9085A

J9086A

J9087A

J9088A

J9089A

All

2615-8-PoE Switch J9565A J9054B: All J9054C: A.14.07

2620 Switch Series J9623A

J9624A

J9625A

J9626A

J9627A

All

2800 Switch Series J4903A

J4904A

J9054B/C 1990-3613 and J9054C
1990-4112: i.10.30

J9054C 1990-4483: Not supported

J9054C part number 1990-4483 is
not supported

2810 Switch Series J9021A

J9022A

N.10.07

2900 Switch Series J9049A

J9050A

T.12.01

2910al Switch Series J9145A

J9146A

J9147A

J9148A

All

2915-8G-PoE Switch J9562A J9054B: All

J9054C/J9054D: A.14.07

Table Continued
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Product name SKU Minimum software required Comments

2920 Series
Switches

J9726A

J9727A

J9728A

J9729A

J9836A

All Use in the SFP ports of the 2920
Series Switches.

100-FX is not supported in the
SFP+ ports of the J9731A 2-Port
10GbE SFP+ Module

2930F Switch Series JL253A

JL254A

JL255A

JL256A

JL258A

JL263A

JL264A

JL259A

JL260A

JL261A

JL262A

JL557A

JL558A

JL559A

J9054B: is not supported in the
2930F Series Switches

For J9054C/9054D: All

The 2930F Switch Series models
with 1G/10G SFP+ ports added
support for this J9054C/J9054D
100FX transceiver. The J9054C/
J9054D are supported in models
with 1G SFP ports.

2930M Switch Series JL319A

JL320A

JL321A

JL322A

JL323A

JL324A

J9054B is not supported in the
2930M Series Switches.

For J9054C/J9054D: All

For use in SFP ports on switch
and an installed JL083A Aruba
3810M/2930M 4SFP+ MACsec
Module.

3500 Series
Switches

J9470A

J9471A

J9472A

J9473A

J9054B/C 1990-3613: K.14.31

J9054C 1990-4112 and 1990-4483:
K.15.08.0007

J9054D: K.15.08.0007

Table Continued
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Product name SKU Minimum software required Comments

3500yl Switch Series J8692A

J8693A

J9310A

J9311A

For J8692A, J8693A: K.12.01 (for
J9054B/C 1990-3613); K.15.08.0007
(for J9054C 1990-4112 and
1990-4483, and J9054D 1990-4483
and 1990-4360)

For J9310A, J9311A: K.14.50 (for
J9054B/C 1990-3613); K.15.08.0007
(for J9054C 1990-4112 and
1990-4483, and J9054D)

3800 Switch Series J9573A

J9574A

J9575A

J9576A

J9584A

For J9573A, J9574A, J9575A,
J9576A: Not supported.

For J9584A: All

Not supported for use in the
following 3800 models: J9573A,
J9574A, J9575A, and J9576A.
The SFP+ ports do not support
100M operation.

Supported in the J8584A
3800-24SFP-2SFP+ Switch

3810M Switch Series JL071A

JL072A

JL073A

JL074A

JL076A

All For use in an installed JL083A
Aruba 3810M/2930M 4SFP+
MACsec Module.

JL075A All For use in the JL075A SFP+
ports. Also used in an installed
JL083A Aruba 3810M/2930M
4SFP+ MACsec Module.

4100gl Switch Series J4865A

J4887A

n/a J9054C/J9054D 100FX is not
supported.

4200vl Switch Series J8770A

J8771A

J8772A/B

J8773A

L.10.24 Supported: J9033A Switch vl 20-
Port Gig-T + 4-Port SFP Module

Not supported: J8776A Switch vl
4-Port Mini-GBIC Module

5300xl Switch Series J4819A

J4850A

n/a J9054C/J9054D 100FX is not
supported.

Table Continued
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Product name SKU Minimum software required Comments

5400zl Switch Series J8697A

J8698A

J9642A

J9643A

For J8705A and J8706A modules: K.
12.01 (for J9054B/C 1990-3613); K.
15.08.0007 (for J9054C 1990-4112
and 1990-4483) J9054D: K.
15.08.0007

For the J9308A module: K.14.34 (for
J9054B/C 1990-3613); K.15.08.0007
(for J9054C 1990-4112 and
1990-4483) J9054D: K.15.08.0007

For J9537A, J9549A, J9535A, and
J9637A modules: K.15.02.0004 (for
J9054B/C 1990-3613); K.15.08.0007
(for J9054C 1990-4112 and
1990-4483) J9054D: K.15.08.0007

For use in:

J8705A Switch zl 20-Port
10/100/1000 + 4-Port Mini-GBIC
Module

J8706A Switch zl 24-Port Mini-
GBIC Module

J9308A 20-Port 10/100/1000 PoE
+ and 4-Port SFP zl Module

J9537A 24-Port SFP v2 zl Module

J9549A 20- Port Gig-T / 4-Port
SFP v2 zl Module

J9535A 20-Port Gig-T PoE+ / 4-
Port SFP v2 zl Module

J9637A 12-Port Gig- T PoE+ / 12-
Port SFP v2 zl Module

5400R Switch Series J9821A

J9822A

J9823A

J9824A

J9825A

J9826A

J9868A

For J9535A, J9537A, J9549A, and
J9637A modules: All

For the J9988A, J9989A, J9990A,
and J9993A modules: KB.15.17 and
later

For use in:

J9537A 24-Port SFP v2 zl Module

J9549A 20-Port Gig-T / 4-Port
SFP v2 zl Module

J9535A 20-Port Gig-T PoE+ / 4-
Port SFP v2 zl Module

J9637A 12-Port Gig-T PoE+ / 12-
Port SFP v2 zl Module

J9988A 24p 1GbE SFP v3 zl2
Module

J9989A 12p PoE+ / 12p 1GbE
SFP v3 zl2 Module

J9990A 20p PoE+ / 4p SFP+ v3
zl2 Module

J9993A 8p 1G/10GbE SFP+ v3
zl2 Module

6108 Switch J4902A n/a 100-FX is not supported

6120 Blade Switch
Series

498358-B21

516733-B21

n/a 100-FX is not supported

6200yl-24G-mGBIC
Switch

J8992A K.12.01 (for J9054B/C 1990-3613);
K.15.08.0007 (for J9054C 1990-4112
and 1990-4483) J9054D: K.
15.08.0007

For use in all 24 ports of the
J8992A Switch 6200yl- 24G-
mGBIC

Table Continued
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Product name SKU Minimum software required Comments

6600 Switch Series J9263A

J9264A

J9265A

J9451A

J9452A

For J9263A, J9264A: K.14.03 (for
J9054B/C 1990-3613); K.15.08.0007
(for J9054C 1990-4112 and
1990-4483)

For J9451A: K.14.24 (for J9054B/C
1990-3613); K.15.08.0007 (for
J9054C 1990-4112 and 1990-4483)
J9054D: K.15.08.0007

For use in the SFP ports of the
J9263A 6600-24G Switch, the
J9264A 6600-24G-4XG Switch,
and the J9451A 6600-48G Switch

(The J9265A 6600-24XG Switch
and J9452A 6600- 48G-4XG
Switch do not have SFP ports)

8100fl Switch Series J8727A

J8728A

n/a 100-FX is not supported

8200zl Switch Series J8715A/B

J9475A

J9640A

J9641A

For J8705A and J8706A modules: All
(for J9054B/C 1990-3613); K.
15.08.0007 (for J9054C 1990-4112
and 1990-4483) J9054D: K.
15.08.0007

For the J9308A module: K.14.34 (for
J9054B/C 1990-3613); K.15.08.0007
(for J9054C 1990-4112 and
1990-4483) J9054D: K.15.08.0007

For J9537A, J9549A, J9535A, and
J9637A modules: K.15.02.0004 (for
J9054B/C 1990-3613); K.15.08.0007
(for J9054C 1990-4112 and
1990-4483) J9054D: K.15.08.0007

For use in:

J8705A Switch zl 20-Port
10/100/1000 + 4-Port Mini-GBIC
Module

J8706A Switch zl 24-Port Mini-
GBIC Module

J9308A 20-Port 10/100/1000 PoE
+ and 4-Port SFP zl Module

J9537A 24-Port SFP v2 zl Module

J9549A 20- Port Gig-T / 4-Port
SFP v2 zl Module

J9535A 20-Port Gig-T PoE+ / 4-
Port SFP v2 zl Module

J9637A 12-Port Gig- T PoE+ / 12-
Port SFP v2 zl Module

8320 Series All n/a 100Mbps Transceivers are NOT
supported in the 8320 series.

8400 Series All n/a 100Mbps Transceivers are NOT
supported in the 8400 series.

9300m Switch Series J4138A

J4139A

J4874A

n/a 100-FX is not supported.

9408sl Switch J8680A n/a 100-FX is not supported
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Gigabit BIDI optical transceiver modules
Figure 16: Gigabit BIDI optical transceiver module

Models, specifications, and compatibility
Gigabit BIDI optical transceiver modules provide a transmission rate of 1250 Mbps and use LC connectors.

NOTE:

• BIDI optical transceiver modules use different central wavelengths in transmit and receive
directions to implement bidirectional transmission of fiber signals over the same fiber.

• You must use the HPE X122 1G SFP LC BX 10-D Transceiver (J9142B) and HPE X122 1G SFP
LC BX 10-U Transceiver (J9143B) in pairs: a J9142B (-D = downlink) at one end of the
connection and a J9143B (-U = uplink) at the other.

• The J9142B/J9143B were End of Sale in April 2016 and are no longer available. Contact your
Aruba Sales team for alternative solutions. The information presented here is for compatibility
use.

Table 36: Specifications for Gigabit BIDI optical transceiver modules (1)

Product name
(SKU)

DOM - Digital
Optical
Monitoring (4x4
part #)

Central wavelength (nm) Fiber
mode

Fiber
diameter
(µm)

Transmission
distance

Transmit
end (TX)

Receive
end (RX)

HPE X122 1G SFP
LC BX-D Transceiver
(J9142B)

No 1490 1310 SMF 9/125 10 km (6.21
miles)

HPE X122 1G SFP
LC BX-U Transceiver
(J9143B)

No 1310 1490
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Table 37: Specifications for Gigabit BIDI transceiver modules (2)

Product name (SKU) Optical parameters
(dBm)

Transmit power Receive power

HPE X122 1G SFP LC BX-D Transceiver (J9142B)

HPE X122 1G SFP LC BX-U Transceiver (J9143B)

–9 to –3 –18.7 to –3

Table 38: Compatibility for Gigabit BIDI transceiver modules

Product name SKU Minimum software
required (J9142B,
J9143B)

Comments

1400 Switch Series J9078A All

1410 Switch Series J9561A All

1700 Switch Series J9080A VB.02.00

1800 Switch Series J9028A/B PB.03.00

2510-24 Switch J9019A/B Q.11.16

2510-48 Switch J9020A U.11.10

2510G–24 Switch J9279A Y.11.03

2510G–48 Switch J9280A Y.11.03

2520 Switch Series J9137A

J9138A

J9298A

J9299A

All

Table Continued
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Product name SKU Minimum software
required (J9142B,
J9143B)

Comments

2530 Switch Series J9772A

J9773A

J9774A

J9775A

J9776A

J9777A

J9778A

J9779A

J9780A

J9781A

J9782A

J9783A

J9853A

J9854A

J9855A

J9856A

All

2540 Switch Series JL354A

JL355A

JL356A

JL357A

n/a 1G BX is not officially supported for
use in the 2540 series.

2600 Switch Series J4899A/B/C

4900A/B/C

J8164A

J8165A

J8762A

H.10.72

2610 Switch Series J9085A

J9086A

J9087A

J9088A

J9089A

R.11.22

2615-8-PoE Switch J9565A All

Table Continued
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Product name SKU Minimum software
required (J9142B,
J9143B)

Comments

2620 Switch Series J9623A

J9624A

J9625A

J9626A

J9627A

All

2800 Switch Series J4903A

J4904A

i.10.69

2810 Switch Series J9021A

J9022A

N.11.14

2900 Switch Series J9049A

J9050A

T.13.45

2910al Switch Series J9145A

J9146A

J9147A

J9148A

All

2915-8G-PoE Switch J9562A All

2920 Series Switches J9726A

J9727A

J9728A

J9729A

J9836A

All

Table Continued
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Product name SKU Minimum software
required (J9142B,
J9143B)

Comments

2930F Series Switches JL253A

JL254A

JL255A

JL256A

JL258A

JL259A

JL260A

JL261A

JL262A

JL263A

JL264A

Supported for use by
a future software
version.

As of April 2016, the J9142B and
J9143B 1G BX transceivers have been
End of Sale. Contact your Aruba
representative for alternative solutions.

2930M Switch Series JL319A

JL320A

JL321A

JL322A

JL323A

JL324A

See comments. As of April 2016, the J9142B and
J9143B 1G BX transceivers have been
End of Sale. Contact your Aruba
representative for alternative solutions.

3500 Series Switches J9470A

J9471A

J9472A

J9473A

K.14.31

3500yl Switch Series J8692A

J8693A

K.14.31

J9310A

J9311A

K.14.50

3800 Switch Series J9573A

J9574A

J9575A

J9576A

J9584A

All

Table Continued
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Product name SKU Minimum software
required (J9142B,
J9143B)

Comments

3810M Switch Series JL071A

JL072A

JL073A

JL074A

JL076A

All As of April 2016, the J9142B and
J9143B 1G BX transceivers have been
End of Sale. Contact your Aruba
representative for alternative solutions.

For use in the JL075A 3810M switch
or in any 3810M switch with a JL083A
Aruba 3810M/2930M 4SFP+ MACsec
Module installed.

JL075A All

4200vl Switch Series J8776A

J9033A

L.11.16

5300xl Switch Series J4878A/B

J4907A

E.11.08

5400zl Switch Series J8705A

J8706A

K.13.45

J9308A K.14.34

J9537A

J9549A

J9535A

J9637A

J9538A

J9548A

J9536A

K.15.02.0004

5400R Switch Series J9537A

J9549A

J9535A

J9637A

J9538A

J9548A

J9536A

All As of April 2016, the J9142B and
J9143B 1G BX transceivers have been
End of Sale. Contact your Aruba
representative for alternative solutions.

Table Continued
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Product name SKU Minimum software
required (J9142B,
J9143B)

Comments

J9988A

J9989A

J9990A

J9993A

KB.15.17

6200yl-24G-mGBIC Switch J8992A K.13.45

6600 Switch Series J9263A

J9264A

K.14.03

J9451A K.14.24

8200zl Switch Series J8705A

J8706A

K.13.45

J9308A K.14.34

J9537A

J9549A

J9535A

J9637A

J9538A

J9548A

J9536A

K.15.02.0004

8320 Series JL479A,
JL579A

n/a 1G BX Transceivers are NOT
supported in the 8320 series.

8400 Series All n/a 1G BX Transceivers are NOT
supported in the 8400 series.

Gigabit SFP copper transceiver modules
Figure 17: Gigabit SFP copper transceiver module
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Models, specifications, and compatibility
Table 39: Specifications for SFP copper transceiver modules

Product name (SKU) Transmission
distance

Data rate Cable type Connector
type

HPE X121 1G SFP RJ45 T
Transceiver (J8177C)

Aruba 1G SFP RJ45 T 100m Cat5e
XCVR (J8177D)

100 m (328.08 ft) 1G

100Mbps1

Cat5e
UTP/STP

RJ-45

1 For certain products. See next table.

Table 40: Compatibility for SFP copper transceiver modules

The specifications for Revision D transceiver products are the same as the specified Revision A, B, and C SKUs.

Product name SKU Minimum software
required (J8177C/
J8177D)

Comments

1810 Series Switches J9660A

J9801A

J9803A

J9834A

All

1820 Switch Series J9980A

J9981A

J9983A

J9984A

All

1920S Switch Series JL381A

JL382A

JL384A

JL385A

JL386A

Not supported The JL380A and JL383A
switches do not include SFP
ports.

2510 Switch J9020A All

Table Continued
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Product name SKU Minimum software
required (J8177C/
J8177D)

Comments

2530 Switch Series J9782A

J9781A

J9776A

J9775A

J9779A

J9778A

J9773A

J9772A

J9856A

J9855A

J9854A

J9853A

All

2540 Switch Series JL354A

JL355A

JL356A

JL357A

All

2610 Switch Series J9085A

J9086A

J9087A

J9088A

J9089A

All

2620 Switch Series J9623A

J9624A

J9625A

J9626A

J9627A

All

2920 Series Switches J9731A All

Table Continued
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Product name SKU Minimum software
required (J8177C/
J8177D)

Comments

2930F Series Switches JL253A, JL254A

JL255A

JL256A

JL258A

JL259A

JL260A

JL261A

JL262A

JL263A

JL264A

JL557A

JL558A

JL559A

All J8177C/J8177D support both
100Mbps and 1G operation in
this Switch Series.

2930M Switch Series JL319A

JL320A

JL321A

JL322A

JL323A

JL324A

All J8177C is not supported for
use in the Dual-Personality
ports of the 2930M Series
Switches.

For use in an installed JL083A
Aruba 3810M/2930M 4SFP+
MACsec Module.

J8177C/J8177D support both
100Mbps and 1G operation in
this Switch Series.

3800 Switch Series J9573A

J9574A

J9575A

J9576A

J9584A

All

3810M Switch Series JL071A

JL072A

JL073A

JL074A

JL076A

All For use in the JL075A 3810M
switch. Also used in any
3810M switch with a JL083A
Aruba 3810M/2930M 4SFP+
MACsec Module installed.

J8177C/J8177D support both
100Mbps and 1G operation in
this Switch Series.

Table Continued
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Product name SKU Minimum software
required (J8177C/
J8177D)

Comments

JL075A All

4100gl Switch Series J4893A

J4908A

G.07.69

4200vl Switch Series J8776A

J9033A

All

5300xl Switch Series J4878A/B E.09.22

5400zl Switch Series J8705A

J8706A

All

J9308A K.14.34

J9537A

J9549A

J9535A

J9637A

K.15.02.0004

5400R Switch Series J9537A

J9549A

J9535A

J9637A

All J8177C/J8177D support both
100Mbps and 1G operation in
this Switch Series.

J9988A

J9989A

J9990A

J9993A

KB.15.17 J8177C/J8177D support both
100Mbps and 1G operation in
this Switch Series.

6120 Blade Switch Series 498358-B21

516733-B21

All

6200yl-24G-mGBIC Switch J8992A All

8100fl Switch Series J8735A CY.01.02.0050

8200zl Switch Series J8705A

J8706A

All

J9308A K.14.34

Table Continued
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Product name SKU Minimum software
required (J8177C/
J8177D)

Comments

J9537A

J9549A

J9535A

J9637A

K.15.02.0004

Aruba 8320 48p 10G SFP/SFP+
and 6p 40G QSFP+ Switch

JL479A All 100Mbps operation is NOT
supported in this series.

Only the 1G Copper 4x4
numbers 1990-3816 and
1990-4606 are supported for
use in the 8320 and 8400
Series.

Aruba 8400X 32p 10G SFP/SFP+
Msec Module

JL363A All
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Networking Websites
Hewlett Packard Enterprise Networking Information Library

www.hpe.com/networking/resourcefinder

Hewlett Packard Enterprise Networking Software

www.hpe.com/networking/software

Hewlett Packard Enterprise Networking website

www.hpe.com/info/networking

Hewlett Packard Enterprise My Networking website

www.hpe.com/networking/support

Hewlett Packard Enterprise My Networking Portal

www.hpe.com/networking/mynetworking

Hewlett Packard Enterprise Networking Warranty

www.hpe.com/networking/warranty

General websites
Hewlett Packard Enterprise Information Library

www.hpe.com/info/EIL

For additional websites, see Support and other resources.

Chapter 6
Websites
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Accessing Hewlett Packard Enterprise Support
• For live assistance, go to the Contact Hewlett Packard Enterprise Worldwide website:

http://www.hpe.com/assistance

• To access documentation and support services, go to the Hewlett Packard Enterprise Support Center website:

http://www.hpe.com/support/hpesc

Information to collect

• Technical support registration number (if applicable)

• Product name, model or version, and serial number

• Operating system name and version

• Firmware version

• Error messages

• Product-specific reports and logs

• Add-on products or components

• Third-party products or components

Accessing updates
• Some software products provide a mechanism for accessing software updates through the product interface.

Review your product documentation to identify the recommended software update method.

• To download product updates:

Hewlett Packard Enterprise Support Center
www.hpe.com/support/hpesc

Hewlett Packard Enterprise Support Center: Software downloads
www.hpe.com/support/downloads

Software Depot
www.hpe.com/support/softwaredepot

• To subscribe to eNewsletters and alerts:

www.hpe.com/support/e-updates

• To view and update your entitlements, and to link your contracts and warranties with your profile, go to the
Hewlett Packard Enterprise Support Center More Information on Access to Support Materials page:

www.hpe.com/support/AccessToSupportMaterials

Chapter 7
Support and other resources
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IMPORTANT: Access to some updates might require product entitlement when accessed through
the Hewlett Packard Enterprise Support Center. You must have an HPE Passport set up with
relevant entitlements.

Customer self repair
Hewlett Packard Enterprise customer self repair (CSR) programs allow you to repair your product. If a CSR part
needs to be replaced, it will be shipped directly to you so that you can install it at your convenience. Some parts
do not qualify for CSR. Your Hewlett Packard Enterprise authorized service provider will determine whether a
repair can be accomplished by CSR.

For more information about CSR, contact your local service provider or go to the CSR website:

http://www.hpe.com/support/selfrepair

Remote support
Remote support is available with supported devices as part of your warranty or contractual support agreement. It
provides intelligent event diagnosis, and automatic, secure submission of hardware event notifications to Hewlett
Packard Enterprise, which will initiate a fast and accurate resolution based on your product's service level.
Hewlett Packard Enterprise strongly recommends that you register your device for remote support.

If your product includes additional remote support details, use search to locate that information.

Remote support and Proactive Care information
HPE Get Connected

www.hpe.com/services/getconnected
HPE Proactive Care services

www.hpe.com/services/proactivecare
HPE Proactive Care service: Supported products list

www.hpe.com/services/proactivecaresupportedproducts
HPE Proactive Care advanced service: Supported products list

www.hpe.com/services/proactivecareadvancedsupportedproducts

Proactive Care customer information
Proactive Care central

www.hpe.com/services/proactivecarecentral
Proactive Care service activation

www.hpe.com/services/proactivecarecentralgetstarted

Warranty information
To view the warranty for your product or to view the Safety and Compliance Information for Server, Storage,
Power, Networking, and Rack Products reference document, go to the Enterprise Safety and Compliance website:

www.hpe.com/support/Safety-Compliance-EnterpriseProducts

Additional warranty information
HPE ProLiant and x86 Servers and Options

www.hpe.com/support/ProLiantServers-Warranties
HPE Enterprise Servers

www.hpe.com/support/EnterpriseServers-Warranties
HPE Storage Products

www.hpe.com/support/Storage-Warranties
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HPE Networking Products
www.hpe.com/support/Networking-Warranties

Regulatory information
To view the regulatory information for your product, view the Safety and Compliance Information for Server,
Storage, Power, Networking, and Rack Products, available at the Hewlett Packard Enterprise Support Center:

www.hpe.com/support/Safety-Compliance-EnterpriseProducts

Additional regulatory information

Hewlett Packard Enterprise is committed to providing our customers with information about the chemical
substances in our products as needed to comply with legal requirements such as REACH (Regulation EC No
1907/2006 of the European Parliament and the Council). A chemical information report for this product can be
found at:

www.hpe.com/info/reach

For Hewlett Packard Enterprise product environmental and safety information and compliance data, including
RoHS and REACH, see:

www.hpe.com/info/ecodata

For Hewlett Packard Enterprise environmental information, including company programs, product recycling, and
energy efficiency, see:

www.hpe.com/info/environment

Documentation feedback
Hewlett Packard Enterprise is committed to providing documentation that meets your needs. To help us improve
the documentation, send any errors, suggestions, or comments to Documentation Feedback
(docsfeedback@hpe.com). When submitting your feedback, include the document title, part number, edition,
and publication date located on the front cover of the document. For online help content, include the product
name, product version, help edition, and publication date located on the legal notices page.
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Notices
The information contained herein is subject to change without notice. The only warranties for Hewlett Packard
Enterprise products and services are set forth in the express warranty statements accompanying such products
and services. Nothing herein should be construed as constituting an additional warranty. Hewlett Packard
Enterprise shall not be liable for technical or editorial errors or omissions contained herein.

Confidential computer software. Valid license from Hewlett Packard Enterprise required for possession, use, or
copying. Consistent with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software
Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government under vendor's
standard commercial license.

Links to third-party websites take you outside the Hewlett Packard Enterprise website. Hewlett Packard Enterprise
has no control over and is not responsible for information outside the Hewlett Packard Enterprise website.
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The transceivers listed in this document represent the currently available and End of Sale products at the time of
this publication. Not all transceiver products are supported in every switch available from Aruba. Consult the
QuickSpecs for the applicable switch product for a list of supported transceiver products. QuickSpecs can be
found at http://www.hpe.com/networking/resourcefinder

Conventions
This section describes the conventions used in the documentation.

Note on product images
NOTE: Product images in this guide may differ from actual product.

Port numbering in examples
The port numbers in this document are for illustration only and might be unavailable on your device.

Symbols
Table 1: Symbols

Convention Description

An alert that calls attention to important information that if not
understood or followed can result in personal injury.

An alert that calls attention to important information that if not
understood or followed can result in data loss, data corruption, or
damage to hardware or software.

An alert that calls attention to essential information.

NOTE: An alert that contains additional or supplementary information.

An alert that provides helpful information.

Chapter 1
Overview
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Types of transceiver modules and network cables
Table 2: Types of transceiver modules and network cables

Transceiver module type Connector head

QSFP28 module (transceiver) QSFP28 optical transceiver module MPO 12-strand or LC 2-strand

QSFP28 DAC (copper cable for
interconnecting devices) 1 - 5m
reaches

N/A

QSFP+ module (transceiver) QSFP+ optical transceiver module MPO 12-strand or LC 2-strand

QSFP+ DAC (copper cable for
interconnecting devices) 1 - 5m
reaches

N/A

SFP+ module (transceiver) SFP+ optical transceiver module LC 2-strand or 1-strand (for BiDi)

SFP+ DAC (copper cable for
interconnecting devices)

N/A

Small form-factor pluggable (SFP)
module (transceiver)

100-Megabit SFP optical
transceiver module

LC 2-strand

Gigabit SFP optical transceiver
module

Gigabit SFP copper transceiver
module

RJ-45

NOTE:

• The available transceiver modules and network cables vary by device models and are subject to
change over time. For the most up-to-date list of transceiver modules and network cables, contact
your Aruba sales representative or technical support engineer.

• For information about the transceiver modules and network cables available for each device
model, see the QuickSpecs for the applicable switch product.

Data rate
Data rate is the number of bits transmitted per second. The unit of measure for data rate is Megabits per second
(Mbps) or Gigabits per second (Gbps). Optical transceiver modules available for products provide the following
levels of data rates:

• 100 Gbps

• 40 Gbps

• 10 Gbps
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• 1000 Mbps (also known as Gigabit)

• 100 Mbps

Transmission distance
The transmission distance of optical transceiver modules is divided into short and long-range types. A distance of
2 km (1.24 miles) and below is considered a short-range type. A distance of 10 km (6.21 miles) is considered a
long-range type. Transmission distances provided by optical transceiver modules are limited by certain loss and
dispersion suffered during the transmission of fiber signals over fibers.

• Loss is the optical energy loss due to the absorption, dispersion, and leakage over the media when light
travels through optical fibers. This loss increases in direct ratio to transmission distance.

• Dispersion occurs mainly because light waves of different wavelengths travel at different rates over the same
medium. This causes different wave components of optical signals to reach the receiving end early or late as
the transmission distance increases causing impulse broadening. Impulse broadening makes the signal values
indistinguishable (data loss). Different wavelengths traveling down the same fiber are called modes, and this
data loss is known as intermodal dispersion.

To meet different transmission distance requirements, choose suitable optical transceiver modules according to
actual networking conditions.

Central wavelength
Central wavelength (wl) represents the wave band used for optical signal transmission. The following central
wavelengths are available for common optical transceiver modules representing three wavebands:

• 850 nm waveband: Used for short-reach transmission.

• 1310 nm waveband: Used for middle-reach and long-haul transmission.

• 1550 nm waveband: Used for middle-reach and long-haul transmission.

Fiber

Fiber types
Fibers are classified as multimode fibers and single-mode fibers.

• Multimode fibers

Multimode fibers (MMFs) have thicker fiber cores and can transport light in multiple modes. However, the
intermodal dispersion is greater and worsens as the transmission distance increases.

Multimode fibers can be classified into multiple grades according to their diameters and modal bandwidth. For
more information, see Table 2. The modal bandwidth of a multimode fiber is determined by the expression of
the maximum modulation frequency pulse that can pass a fiber × the fiber length. The modal bandwidth is a
comprehensive index reflecting the optical characteristics of a multimode fiber.

International Telecommunication Union (ITU) defines multimode fiber types in its G series standards. The
commonly used multimode fiber is defined in the ITU G.651 standard. The G.651-compliant fiber transmits
light at the wavelength range 800 nm to 900 nm or 1200 nm to 1350 nm.

Chapter 1 Overview 7
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Table 3: Multimode fiber grades

Fiber mode Fiber grade Fiber diameter (μm) Modal bandwidth at 850 nm
(MHz*km)

Multimode fiber OM1 62.5/125 200

OM2 50/125 500

OM3 50/125 2000

OM4 50/125 4700

Other factors that influence the transmission distance of multimode fibers include interface type, central
wavelength, and fiber grade. The modal bandwidth values shown above are for the fiber grades listed. There
are multimode fibers that have different modal bandwidth characteristics and do not necessarily match the
OM1 - OM4 grades.

Table 4: Multimode fiber specifications

Interface types Central wavelength
(nm)

Fiber grade Transmission distance

1000BASE-SX 850 OM1 < 275 m (902.23 ft)

OM2 < 550 m (1804.46 ft)

10GBASE-SR 850 OM1 < 33 m (108.27 ft)

OM2 < 82 m (269.03 ft)

OM3 < 300 m (984.25 ft)

OM4 < 400m (1312.34 ft)

10GBASE-LRM 1310 OM1 < 220 m (721.78 ft)

OM2 < 220 m (721.78 ft)

OM3 < 220 m (721.78 ft)

OM4 < 220 m (721.78 ft)

SMF <300m (987.25 ft)

• Single-mode fibers

Single-mode fibers (SMFs) have a small core size, typically 9 μm or 10 μm, and can transmit light in only one
mode. Single-mode fibers suffer little intermodal dispersion and are suitable for long-haul communication.
Single-mode fibers transmit light at the central wavelength of 1310 nm or 1550 nm.

Telecommunication Industries Alliance (TIA)/Electronic Industries Alliance (EIA) defines that single-mode fibers
use yellow outer jackets with the mark "SM".

ITU defines single-mode fiber types in its G series standards. The most commonly used single-mode fibers are
defined in ITU G.652 and G.655 standards. The following table describes features of the G.652 and G.655-
compliant fibers.
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Table 5: Features of G.652- and G.655-compliant fibers

Single-mode fiber
type

Wavelength (nm) Features Applications

G.652-compliant
fiber (standard
single-mode fiber)

1260 to 1360

1530 to 1565

Zero dispersion at 1310 nm Connecting transceiver
modules with a central
wavelength of 1310 nm or
1550 nm.

G.655-compliant
fiber (non-zero
dispersion shifted
fiber)

1530 to 1565 Near-zero dispersion around
1550 nm

For 1550 nm wavelength-
division multiplexing (WDM)
transmissions.

Fiber diameter
Fiber diameter is expressed as core diameter/cladding diameter, in μm. For example, 9/125 μm means that the
fiber core diameter is 9 μm and the fiber cladding diameter is 125 μm.

For the HPE devices, the following fiber diameters are recommended:

• G.652 standard single-mode fiber: 9/125 μm

• G.655 non zero dispersion shifted single-mode fiber: 9/125 μm

• G.651 standard multimode fiber: 50/125 μm or 62.5/125 μm

Connector
CAUTION: Cover the connector with a dust cap when it is not connected to any optical fibers.

Connectors connect transceiver modules to the corresponding transmission media. The transceiver modules
available for Aruba products use the following types of connectors:

• Lucent connector or local connector (LC).

Single LC connectors (also known as Simplex) are typically used for 1G & 10G BiDi (Bidirectional) optics.

Dual LC connectors (Duplex) are typically used in normal optical types.

Chapter 1 Overview 9
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NOTE: 40G BiDi uses only Duplex fiber versus MPO (see below) for 40G SR4 applications.

Figure 1: LC connector (a simplex connector is shown)

• Multifiber Push On (MPO) connector.

Figure 2: MPO connector

The 40G QSFP+ MPO transceiver modules use only female MPO connectors, which have guide holes in the
end face of the MPO connector (the transceiver has guide pins within the MPO receptacle).

MPO connectors are classified as the following types based on the polish type:
◦ Physical contact (PC): End face polished flat.

◦ Angle-polished contact (APC): End face polished with an angle, typically 8°.

MPO connectors are available with 12 fibers or 24 fibers:
12-fiber MPO connector (40G, SR4, eSR4, and 100G SR4 transceivers use 8 of the available 12 fibers. The
four center fibers are unused. )

Figure 3: End face of a 12-fiber connector and channel assignment

MPO transceivers typically use four channels to communicate. These channels are assigned using the outer
eight fibers (the center four are unused).

Transmit channels are one set of four fibers, and the receive channels are on the other set of four fibers.
Because of this, the cables used and fiber cable connections from endpoint to endpoint effectively create a
crossover connection.

Be aware that using two crossover cables in series cancels this effect and no connection will be established.
An odd number of crossovers combined with straight-thru fiber connections will effect a crossover connection.

The channel layout indicates that the left four fibers are Transmit, and must reach the opposite transceiver
Receive channels (and in proper channel order).
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Optical parameters
This guide provides average transmit and receive power ranges for transceiver modules.

Transmit power

Transmit power is the power at which the transmitter of an optical transceiver module transmits optical signals, in
dBm.

Receive power

Receive power is the power at which the receiver of an optical transceiver module receives optical signals, in
dBm.

Use of attenuators

Transceivers are designed to transmit light pulses at a power level that accounts for loss in the fiber optic cabling,
and meets the receiver input thresholds of the link partner optical transceiver.

If you are using a fiber cable with less light loss than expected (for example, in a test environment and you do not
have a 40km spool of SMF available), use attenuators to affect the transmit level to within the receive sensitivity of
the other transceiver -- you will need to condition both fibers (sends in both directions). If not done, you risk
overdriving the Receive end and permanently damaging the transceiver. For example, a 40G ER4 has a highest
transmit level of 4.5dBm, but the Receive Sensitivity can be no higher than -4.5dBm. That means there must be at
least a 9dBm loss on the light level to be within the standards (4.5 - (-4.5) = 9dBm required).

Copper transceiver modules
Copper transceiver modules transmit signals over Category-5 unshielded twisted pair (UTP). UTP transmission
cover shorter distances than fiber transmission and can be used in small-sized networks only.

Copper transceivers are supported in 1G SFP and 10G SFP+ ports where listed in the Support Matrix tables.

Transmission distance
Through UTP cables, signals can be transmitted over a distance of 100 m (328.08 ft.) only. This behavior occurs
because signals attenuate during transmission through the UTP cables.

Attenuation refers to the dissipation of the power of a transmitted signal as it travels over a cable. Attenuation
occurs because signal transmission suffers certain resistance from the cable, which weakens the signals as they
travel over the cable. When signals are transmitted over a long distance, signal strength decreases significantly,
causing the signal-to-noise ratio to drop below the accepted level. This decrease makes it impossible to
distinguish between signals and noise, which results in data loss.

Patch panel and punch down blocks also affect attenuation; that is, they can be a source of issues resulting in
shorter distances or data loss.

10GBASE-T connections require Category 6a as a minimum for proper 10G speeds up to the 100m distance
dictated by the IEEE 802.3ae standard. Anything less (Cat 6, 5e, 5) will compromise the distance that 10G over
copper can achieve.

Shielded Twisted Pair (STP) Cat 6a cable is required for full support when using the 10GBase-T transceiver
(JL563A) supported only on the 8400 and 8320 switch models. Use of STP prevents EMI events from affecting
data traffic carried on the wire - known as Crosstalk or Alien Crosstalk. Large EMI events from electronically noisy
environments may be coupled onto unshielded cabling and cause temporary packet errors. Fixed 10G ports have
designs to counteract these types of bit error conditions, that the 10GBASE-T transceiver cannot counteract
consistently. Using STP Cat6a cables mitigate the errors significantly. All packet loss errors observed in extensive
testing are considered recoverable by the host system with the JL563A transceiver.
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Connector
Registered Jack-45 (RJ-45) twisted-pair connectors are used as connectors for copper transceiver modules.

Figure 4: RJ-45 connector

Table 6: RJ-45 GE connector pin assignment for Gigabit connections

Pin Signal Function

1 MX_0+ Data transmit/receive

2 MX_0- Data transmit/receive

3 MX_1+ Data transmit/receive

4 MX_2+ Data transmit/receive

5 MX_2- Data transmit/receive

6 MX_1- Data transmit/receive

7 MX_3+ Data transmit/receive

8 MX_3- Data transmit/receive

Identification of 4x4 part numbers
A SKU# may be fulfilled by two or more vendor parts providing similar functionality. A 4x4 part number is of the
form nnnn-nnnn and is on the transceiver or DAC label. For example, JL309A can have a 1990-4680 or
1990-4678 4x4 part number. 4x4 part numbers are referenced in the

• specification tables, to identify parts that support DOM (Digital Optical Monitoring) capabilities. (Some older
vendor parts do not support DOM.)

• compatibility tables, where necessary, to identify supported combinations of switch or module with the
identified transceiver, along with the minimum software version required.

In December 2017, Aruba introduced Revision D versions of 100M, 1G, and 10G products. Revision D products
are structured to be specific alternative vendors as sources for the SKU#. Earlier Revision A, B, or C product may
have alternative vendors that Aruba no longer actively ships, but remains as fully supported in specific switches.

Some switch products will specify Revision D transceivers for full support, while other products may support
earlier (older) revision transceivers – and some with specific 4x4 part numbers.
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Always refer to the Datasheet or QuickSpecs for the switch product to see the current list of supported
transceivers. Refer to the compatibility tables within this document to cross-reference the Transceiver/DAC
product against the switch product to identify the minimum software required for transceiver support.

To use CLI commands to display data for an installed transceiver, see the following examples.

8400X# show int 1/10/6 transceiver 
------------------------------------------------------------
Port      Type        Product   Serial          Part        
                      Number    Number          Number      
------------------------------------------------------------
1/10/6    QSFP+SR4    JH231A    XX57nnnnnn      1990-5555  
8400X# show int 1/10/6 dom
-------------------------------------------------------------------------------------------
Port      Type        Channel#  Temperature     Voltage         Tx Bias      Rx Power        Tx Power        
                                (Celsius)       (Volts)         (mA)         (mW/dBm)        (mW/dBm)        
-------------------------------------------------------------------------------------------
1/10/6    QSFP+SR4    1         26.00           3.32            6.72         0.02, -16.99    0.58, -2.37     
                      2         26.00           3.32            6.79         0.02, -16.99    0.59, -2.29     
                      3         26.00           3.32            6.68         0.03, -15.23    0.59, -2.29     
                      4         26.00           3.32            6.82         0.03, -15.23    0.60, -2.22 

Aruba-5406Rzl2# show interfaces transceiver f2 detail
Transceiver in F2
   Interface Index    : 162 
   Type               : QSFP+SR4        
   Model              : JH231A  
   Connector Type     : MPO                             
   Wavelength         : 850nm                           
   Transfer Distance  : 100m (50um OM3), 150m (50um OM4)                
   Diagnostic Support : DOM   
   Serial Number      : XX57nnnnnn      
 Status
   Temperature : 33.332C         
   Voltage     : 3.3208V     

            Tx Bias  Rx Power       Tx Power
  Channel#  (mA)     (mW/dbM)       (mW/dbM)     
  --------- -------- -------------- --------------
  1         6.904    0.5622, -2.501 0.5822, -2.349
  2         6.706    0.5922, -2.275 0.5856, -2.324
  3         6.894    0.6321, -1.992 0.5813, -2.356
  4         6.792    0.5111, -2.915 0.5651, -2.479
  Current Alarms:
    Channel 1 :  
       Tx bias low alarm                      
       Rx power low warning                  
    Channel 2 :  
       Tx bias low alarm                      
       Rx power low warning                  
  Current Errors:
    Channel 1 :  
       Rx Loss of Signal                     
    Channel 2 :  
       Rx Loss of Signal                     
    Channel 3 :  
       Rx Loss of Signal                     
    Channel 4 :  
       Rx Loss of Signal                
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QSFP28 optical transceiver modules that use MPO
connectors
See Chapter 1, "Overview", for information regarding MPO connectors and cable requirements.

Figure 5: QSFP28 optical transceiver module that use MPO connectors

Models and specifications
QSFP28 optical transceiver modules provide a transmission rate of 100 Gbps and use MPO connectors.

Table 7: Specifications for QSFP28 optical transceiver modules that use MPO connectors (1)

Product name
(SKU)

DOM - Digital
Optical
Monitoring
(4x4 part #)

Central wl
(nm)

Fiber
mode

Fiber
diameter
(µm)

Modal
bandwidth
(MHz*km)

Transmission
distance

Aruba 100G
QSFP28 MPO
SR4 100m 12-fiber
MPO MMF
Transceiver
(JL309A)

YES

(1990-4680,
1990-4678)

850 MMF 50/125 2000 (OM3)

4700 (OM4)

70 m (229.66 ft)

100 m (328.08 ft)

NOTE: SR4 is not supported for use over MMF OM1 or OM2 fiber. (The IEEE standard does not
state a specification.) Use MPO Female connectors with the MPO transceivers.

Chapter 2
QSFP28 modules
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Table 8: Specifications for QSFP28 optical transceiver modules that use MPO connectors (2)

Product name (SKU) Connector Optical parameters (dBm)

Transmit power Receive power

Aruba 100G QSFP28 MPO SR4
100m 12-fiber MPO MMF
Transceiver (JL309A)

MPO (PC polished, 12-fiber) -8.4 to +2.4 -10.3 to +2.4

Table 9: Compatibility for the QSFP28 optical transceiver modules that use MPO connectors.

Product name (SKU) Minimum software required Comments

Aruba 8400X 6p 40G/100G QSFP28 Adv
Module (JL366A)

10.00.0005 10.00.0005 provided 100G
product support.

10.00.0006 provides additional
support for 40G on the JL366A.

QSFP28 optical transceiver modules that use LC
connectors
Figure 6: QSFP28 optical transceiver module that use LC connectors

Models and specifications
QSFP28 optical transceiver modules provide a transmission rate of 100 Gbps and use LC connectors.

Table 10: Specifications for QSFP28 optical transceiver modules that use LC connectors (1)

Product name
(SKU)

DOM - Digital
Optical
Monitoring
(4x4 part #)

Central wl
(nm)

Fiber
mode

Fiber
diameter
(µm)

Modal
bandwidth
(MHz*km)

Transmission
distance

Aruba 100G
QSFP28 LC LR4
10km SMF 2-
strand Transceiver
(JL310A)

YES

(1990-4681)

Four lanes:

1294.53 ~
1296.59

1299.02 ~
1301.09

1303.54 ~
1305.63

1308.09 ~
1310.19

SMF 9/125 N/A 10 km (6.21 miles)
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Table 11: Specifications for QSFP28 optical transceiver modules that use LC connectors (2)

Product name (SKU) Connector Optical parameters (dBm)

Transmit power Receive power

Aruba 100G QSFP28 LC LR4 10km SMF 2-
strand Transceiver (JL310A)

LC -4.3 to +4.5 per lane -10.6 to +4.5 per
lane

Table 12: Compatibility for the QSFP28 optical transceiver modules that use LC connectors

Product name (SKU) Minimum software required Comments

Aruba 8400X 6p 40G/100G QSFP28 Adv
Module (JL366A)

10.00.0005 10.00.0005 provides support for
100G products.

10.00.0006 provides additional
support for 40G on the JL366A.

QSFP28 DAC (copper cables)
Figure 7: QSFP28 DAC (copper cable)

Models and specifications
Table 13: Specifications for QSFP28 copper cables

Product name (SKU) Cable length Data rate Description

Aruba 100G QSFP28 to QSFP28 3m Direct
Attach Copper Cable (JL307A)

3 m (9.8 ft) 100 Gbps Used for interconnecting
100-Gigabit QSFP28 ports
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Table 14: Compatibility for the QSFP28 copper cables

Product name (SKU) Minimum software required Comments

Aruba 8400X 6p 40G/100G QSFP28 Adv
Module (JL366A)

All

Chapter 2 QSFP28 modules 17
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QSFP+ optical transceiver modules that use MPO
connectors
See Chapter 1, " Overview", for information regarding MPO connectors and cable requirements.

Figure 8: QSFP+ optical transceiver module that uses MPO connectors

Models, specifications, and compatibility
QSFP+ optical transceiver modules provide a transmission rate of 40 Gbps and use MPO connectors.

NOTE: 40G SR4 and eSR4 are not supported for use over MMF OM1 or OM2 quality fiber. (The
IEEE standard does not state a specification). Use MPO female connectors for use with the MPO
transceivers.

Table 15: Specifications for QSFP+ optical transceiver modules that use MPO connectors (1)

Product name
(SKU)

DOM - Digital
Optical
Monitoring
(4x4 part #)

Central wl
(nm)

Fiber
mode

Fiber
diameter
(µm)

Modal
bandwidth
(MHz*km)

Transmission
distance

HPE X142 40G
QSFP+ MPO SR4
Transceiver
(JH231A)

YES

(1990-4554)

850 MMF 50/125 2000 (OM3)

4700 (OM4)

100 m (328.08 ft)

150 m (492.12 ft)

HPE X142 40G
QSFP+ MPO
eSR4 300M XCVR
(JH233A)

YES

(1990-4555)

850 MMF 50/125 2000 (OM3)

4700 (OM4)

300 m (984.25 ft)

400 m (1312.33 ft)

Chapter 3
QSFP+ modules
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Table 16: Specifications for QSFP+ optical transceiver modules that use MPO connectors (2)

Product name (SKU) Connector Optical parameters (dBm)

Transmit power Receive power

HPE X142 40G QSFP+ MPO
SR4 Transceiver (JH231A)

MPO (PC polished, 12-fiber) –7.6 to 0 –9.5 to +2.4

HPE X142 40G QSFP+ MPO
eSR4 300M XCVR (JH233A)

MPO (PC polished, 12-fiber) –7.6 to 0 –9.9 to +2.4

Table 17: Compatibility for the QSFP+ optical transceiver modules that use MPO connectors

Product name (SKU) Minimum software required Comments

Aruba 3810M/2930M 1QSFP+ 40GbE
Module (JL078A)

All

Aruba 3810M 24G 1-slot Switch 2QSFP
+ 40GbE Module (JL079A)

All

20p PoE+ / 1p 40GbE QSFP+ v3 zl2
Module (J9992A)

KB.15.17

2p 40GbE QSFP+ v3 zl2 Module
(J9996A)

KB.15.17

Aruba 8320 48p SFP/SFP+ & 6p 40G
QSFP+ Switch (JL479A)

10.00.0006

Aruba 8320 32p 40G QSFP+ Switch
(JL579A)

10.00.0012

Aruba 8400X 8p 40G QSFP+ Adv Module
(JL365A)

All

Aruba 8400X 6p 40G/100G QSFP28 Adv
Module (JL366A)

10.00.0006 10.00.0005 supports 100G
products.

10.00.0006 provides additional
support for 40G on the JL366A.

QSFP+ optical transceiver modules that use LC
connectors
Figure 9: QSFP+optical transceiver module that uses LC connectors
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Models, specifications, and compatibility
QSFP+ optical transceiver modules provide a transmission rate of 40 Gbps and use LC connectors.

Table 18: Specifications for QSFP+ transceiver modules that use LC connectors (1)

Product name
(SKU)

DOM - Digital
Optical
Monitoring
(4x4)

Central wl
(nm)

Fiber
mode

Fiber
diameter
(µm)

Modal
bandwidth
(MHz*km)

Transmission
distance

Aruba 40G QSFP+
LC BiDi 150m
MMF Transceiver
(JL308A)

YES

(1990-4679)

Dual
20Gb/s:

• 850

• 900

MMF 50/125 2000 (OM3)

4700 (OM4)

100 m (328.08 ft)

150 m (492.12 ft)

Not supported on
OM1/OM2.

HPE X142 40G
QSFP+ LC LR4
SM Transceiver
(JH232A)

YES

(1990-4556)

Four
lanes:

• 1271

• 1291

• 1311

• 1331

SMF 9/125 N/A 10 km (6.21 miles)

Aruba 40G QSFP+
LC ER4 40km
SMF XCVR
(Q9G82A)

YES

(1990-4734)

Four
lanes:

• 1271

• 1291

• 1311

• 1331

SMF 9/125 N/A 40km (24.86 miles)

Table 19: Specifications for QSFP+ transceiver modules that use LC connectors (2)

Product name (SKU) Optical parameters (dBm)

Transmit power Receive power

Aruba 40G QSFP+ LC BiDi 150m MMF Transceiver
(JL308A)

–4 to +5 –6 to +5

HPE X142 40G QSFP+ LC LR4 SM Transceiver
(JH232A)

–7 to +2.3 per lane –13.7 to +2.3 per lane

Aruba 40G QSFP+ LC ER4 40km SMF XCVR
(Q9G82A)

-2.7 to 4.5 dBm -21.2 to -4.5 dBm

(Use attenuators to match
power levels.)
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Table 20: Compatibility for the QSFP+ optical transceiver modules that use LC connectors

Product name (SKU) Minimum software required Comments

Aruba 3810M/2930M 1QSFP+ 40GbE
Module (JL078A)

For JH232A: all

For JL308A: KB.16.04.0008 or
WC.16.04.0008

Q9G82A not supported.

Aruba 3810M 2QSFP+ 40GbE Module
(JL079A)

For JH232A: all

For JL308A: KB.16.04.0008

Q9G82A not supported.

The JL079A module is not
supported in the 2930M series
nor on the 3810M 16SFP+ 2-slot
switch (JL075A).

20p PoE+ / 1p 40GbE QSFP+ v3 zl2
Module (J9992A)

For JH232A: KB.15.17

For JL308A: KB.16.04.0008

Q9G82A not supported.

2p 40GbE QSFP+ v3 zl2 Module
(J9996A)

For JH232A: KB.15.17

For JL308A: KB.16.04.0008

Q9G82A not supported.

Aruba 8320 48p SFP/SFP+ & 6p 40G
QSFP+ Switch (JL479A)

For JH232A: 10.00.0006

For JL308A: 10.00.0006

For Q9G82A: 10.00.0018

Aruba 8320 32p 40G QSFP+ Switch
(JL579A)

For JH232A: 10.00.0012

For JL308A: 10.00.0012

For Q9G82A: 10.00.0018

Aruba 8400X 8p 40G QSFP+ Adv Module
(JL365A)

For JH232A: all

For JL308A: all

For Q9G82A: 10.00.0018

Aruba 8400X 6p 40G/100G QSFP28 Adv
Module (JL366A)

For JH232A: 10.00.0006

For JL308A: 10.00.0006

For Q9G82A: 10.00.0018

10.00.0005 provides support for
100G products.

10.00.0006 provides additional
support for 40G on the JL366A.

Chapter 3 QSFP+ modules 21

Anexo 01 ITEM 13 (0592744)         SEI 0008478-63.2018.6.02.8000 / pg. 8183



QSFP+ DAC (copper cables)
Figure 10: QSFP+ DAC copper cables

IMPORTANT: Direct Attach over Copper (DAC) cables have a minimum bend radius of typically 4x
the diameter of the cable (approximately a 1" bend radius). Handle DAC cables carefully to ensure
that you do not crimp or bend the cable beyond a 1" radius. Otherwise, you risk damaging the cable.

Models, specifications, and compatibility
Table 21: Specifications for QSFP+ copper cables

Product name (SKU) Cable length Data rate Description

HPE X242 40G QSFP+ to QSFP+ 1m DAC
Cable (JH234A)

1 m (3.28 ft)

40 Gbps Used for interconnecting
40-Gigabit QSFP+ ports

HPE X242 40G QSFP+ to QSFP+ 3m DAC
Cable (JH235A)

3 m (9.84 ft)

HPE X242 40G QSFP+ to QSFP+ 5m DAC
Cable (JH236A)

5 m (16.40 ft)

Table 22: Compatibility for the QSFP+ copper cables

Product name (SKU) Minimum software required Comments

Aruba 3810M/2930M 1QSFP+ 40GbE
Module (JL078A)

All

Aruba 3810M 2QSFP+ 40GbE Module
(JL079A)

All The JL079A module is not
supported in the 2930M
series nor on the 3810M
16SFP+ 2-slot Switch
(JL075A).

20p PoE+ / 1p 40GbE QSFP+ v3 zl2
Module (J9992A)

KB.15.17

Table Continued
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Product name (SKU) Minimum software required Comments

2p 40GbE QSFP+ v3 zl2 Module
(J9996A)

KB.15.17

Aruba 8320 48p 10G SFP/SFP+ and 6p
40G QSFP+ Switch (JL479A)

All

Aruba 8320 32p 40G QSFP+ Switch
(JL579A)

10.00.0012

Aruba 8400X 8p 40G QSFP+ Adv Module
(JL365A)

All

Aruba 8400X 6p 40G/100G QSFP28 Adv
Module (JL366A)

10.00.0006
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SFP+ optical transceiver modules
In December, 2017, Aruba introduced Revision D versions of 100M, 1G, and 10G transceivers. Revision D
products are structured to be specific alternate vendors as sources for the SKU#. Earlier Revision A, B, or C
product may have alternate vendors that we no longer actively ship, but remain as fully supported in earlier and
current products.

Some switch products will be specifying Revision D transceivers for full support, while other products may support
earlier (older) revision transceivers – and some with specific 4x4 part numbers (see Chapter 1, "Overview", for
information regarding 4x4 part numbers).

Always refer to the Datasheet or QuickSpecs for the Switch product to see the current list of supported
transceivers.

Figure 11: SFP+ optical transceiver modules

NOTE: 

• Although a 10G SFP+ transceiver module is the same physical dimensions of a 1G SFP
transceiver, a 10G transceiver will NOT operate in a 1G SFP port.

• Many, although not all, 10G SFP+ ports have support to use a 1G SFP transceiver (or even a
100Mbps FX SFP transceiver).

See the QuickSpec for the Switch product and verify if the 1G or 100Mbps SFP transceiver is
supported in the 10G SFP+ port.

Models, specifications, and compatibility
SFP+ optical transceiver modules provide a transmission rate of 10.31 Gbps and use LC connectors.

The specifications for Revision D transceiver products are the same as the specified Revision A, B, C SKUs.
Where support for a Revision A, B, or C transceiver existed, Revision D parts are also supported.

Chapter 4
SFP+ modules
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Table 23: Specifications for SFP+ optical transceiver modules (1)

Product Name
(SKU)

DOM - Digital
Optical
Monitoring
(4x4 part #)

Central
we (nm)

Fiber
mode

Fiber
diameter
(µm)

Bandwidth
(MHz*km)

Transmission
distance

HPE X132 10G
SFP+ LC SR
Transceiver
(J9150A)

Aruba 10G SFP+
LC SR 300m MMF
XCVR (J9150D)

Yes

(1990-4391,

1990-4175)

850 MMF 50/125 4700 (OM4)

2000 (OM3)

500 (OM2)

400

400 m (1312.34 ft)

300 m (984.25 ft)

82 m (269.03 ft)

66 m (216.54 ft)

62.5/125 200 (OM1)

160

33 m (108.27 ft)

26 m (85.30 ft)

HPE X132 10G
SFP+ LC LRM
Transceiver
(J9152A)

Aruba 10G SFP+
LC LRM 220m
MMF XCVR
(J9152D)

Yes

(1990-4485)

1310 MMF 50/125 1500

500 (OM2)

400

220 m (721.78 ft)

220 m (721.78 ft)

100 m (328.08 ft)

62.5/125 200 (OM1)

160

220 m (721.78 ft)

220 m (721.78 ft)

SMF 9/125 N/A 300m (987.25 ft)

HPE X132 10G
SFP+ LC LR
Transceiver
(J9151A)

Aruba 10G SFP+
LC LR 10km SMF
XCVR (J9151D)

Yes

(1990-4657,

1990-4694)

1310 SMF 9/125 N/A 10 km (6.21 miles)

HPE X132 10G
SFP+ LC ER
Transceiver
(J9153A)

Aruba 10G SFP+
LC ER 40km SMF
XCVR (J9153D)

Yes

(1990-4365,

1990-4656)

1550 SMF 9/125 N/A 40 km (24.86
miles)

NOTE: A mode conditioning patch cord is required when you use OM1 or OM2 fiber types on a 10G
LRM Transceiver (J9152A/J9152D). Never use mode conditioning patch cords for OM3 or OM4 fiber
types. For more information about mode conditioning patch cords, see related parts in the IEEE
802.3 standard.
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Table 24: Specifications for SFP+ optical transceiver modules (2)

Product name (SKU) Optical parameters (dBm)

Transmit power Receive power

HPE X132 10G SFP+ LC SR Transceiver (J9150A)

Aruba 10G SFP+ LC SR 300m MMF XCVR (J9150D)

–7.3 to –1 –9.9 to +0.5

HPE X132 10G SFP+ LC LRM Transceiver (J9152A)

Aruba 10G SFP+ LC LRM 220m MMF XCVR (J9152D)

–6.5 to +0.5 –6.5 to +1.5

HPE X132 10G SFP+ LC LR Transceiver (J9151A)

Aruba 10G SFP+ LC LR 10km SMF XCVR (J9151D)

–8.2 to +0.5 –14.4 to +0.5

HPE X132 10G SFP+ LC ER Transceiver (J9153A)

Aruba 10G SFP+ LC ER 40km SMF XCVR (J9153D)

–4.7 to +4 –15.8 to –1

Table 25: Compatibility for the SFP+ optical transceiver module

Product name SKU Minimum software required Comments

10G-SR, LR, LRM
(J9150A/J9150D,
J9151A/J9151D,
J9152A/J9152D)

10G-ER (J9153A/
J9153D)

1850 Switch Series JL169A J9150A/J9150D: All

J9151A/J9151D: All

J9152A/J9152D: All

J9153A/J9153D is
not supported on the
1850 Switch Series.

Unlisted models do not
have SFP+ ports.

2530 Switch Series J9853A

J9854A

J9855A

J9856A

All All Unlisted models do not
have SFP+ ports.

2540 Switch Series JL354A

JL355A

JL356A

JL357A

All (J9150A/J9150D
and J9151A/J9151D
only)

J9152A/J9152D
(LRM) is not
supported in any 2540
model

All J9152A/J9152D (LRM)
is not supported in any
2540 model.

2910al Switch Series J9008A All W.15.07.0002 Unlisted models do not
have SFP+ ports.

Table Continued
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Product name SKU Minimum software required Comments

10G-SR, LR, LRM
(J9150A/J9150D,
J9151A/J9151D,
J9152A/J9152D)

10G-ER (J9153A/
J9153D)

2920 Switch Series J9726A

J9727A

J9728A

J9729A

J9836A

All For use in an installed
J9731A Aruba 2920 2-
port 10GbE SFP+
Module.

2930F Switch Series JL253A

JL254A

JL255A

JL256A

JL258A

JL263A

JL264A

JL558A

JL559A

All (J9150A/J9150D
and J9151A/J9151D
only)

J9152A/J9152D
(LRM) is not
supported in any
2930F model

All Unlisted models do not
have SFP+ ports.

J9152A/J9152D (or
any 10G LRM
technology) is not
supported in any
2930F model.

2930M Switch Series JL319A

JL320A

JL321A

JL322A

JL323A

JL324A

All All For use in an installed
JL083A Aruba 3810M/
2930M 4SFP+
MACsec Module.

3500yl Switch Series J8692A

J8693A

J9310A

J9311A

K.14.50 and later K.15.02.0004 and
later

For use in an installed
J9312A 10GbE 2-port
SFP+/2-port CX4 yl
Module.

3800 Switch Series J9575A

J9576A

J9573A

J9574A

J9584A

All All Unlisted models do not
have SFP+ ports.

Table Continued
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Product name SKU Minimum software required Comments

10G-SR, LR, LRM
(J9150A/J9150D,
J9151A/J9151D,
J9152A/J9152D)

10G-ER (J9153A/
J9153D)

3810M Switch Series JL071A

JL072A

JL073A

JL074A

JL076A

All All For use in an installed
JL083A Aruba 3810M/
2930M 4SFP+
MACsec Module

JL075A All All For use in the JL075A
SFP+ ports or in an
installed JL083A
Aruba 3810M/2930M
4SFP+ MACsec
Module

5400zl Switch Series J9309A K.14.39 K.15.02.0004

J9538A

J9548A

J9536A

K.15.02.0004 K.15.02.0004

5400R Switch Series J9538A

J9548A

J9536A

All All

J9990A

J9993A

KB.15.17 KB.15.17

6120 Switch Series 516733-
B21
(6120XG)

All (not supported) 498358-B21
(6120G/XG) has 1GB
SFP and 10G XFP or
CX4 ports and does
not support these SFP
+ transceivers

6200yl Switch Series J8992A K.14.50 K.15.02.0004 J8992A fixed SFP
ports are 1GB and do
not support these SFP
+ transceivers

For use in an installed
J9312A 10GbE 2-port
SFP+/2-port CX4 yl
Module

6600 Switch Series J9264A

J9265A

K.14.03 K.15.02.0004

Table Continued
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Product name SKU Minimum software required Comments

10G-SR, LR, LRM
(J9150A/J9150D,
J9151A/J9151D,
J9152A/J9152D)

10G-ER (J9153A/
J9153D)

J9452A K.14.24 K.15.02.0004

8200zl Switch Series J9309A K.14.39 K.15.02.0004

J9538A

J9548A

J9536A

K.15.02.0004 K.15.02.0004

Aruba 8320 48p 10G
SFP/SFP+ and 6p 40G
QSFP+ Switch

JL479A All (J9150A/J9150D
and J9151A/J9151D
only)

J9152A/J9152D
(LRM) is not
supported in the 8320
switches

All Only the following 4x4
part numbers are
supported:

• J9150A/J9150D:
1990-4391, 1990-4175

• J9151A/J9151D:
1990-4657,
1990-4727, 1990-4694

• J9153A/J9153D:
1990-4365, 1990-4656

J9152A/J9152D (or
any 10G LRM
technology) is not
supported in the 8320
Switches

Aruba 8400X 32p 10G
SFP/SFP+ Msec Module

JL363A All All Only the following 4x4
part numbers are
supported:
• J9150A/J9150D:

1990-4391,
1990-4175

• J9151A/J9151D:
1990-4657,
1990-4727,
1990-4694

• J9152A/J9152D:
1990-4485

• J9153A/J9153D:
1990-4365,
1990-4656

NOTE: A mode conditioning patch cord is required when you use OM1 or OM2 fiber types on a10G
LRM Transceiver. Never use mode conditioning patch cords for OM3 or OM4 fiber types. For more
information about mode conditioning patch cords, see related parts in the IEEE 802.3 standard.
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10G SFP+ copper transceiver modules
Figure 12: 10G SFP+ copper transceiver module

Models, specifications, and compatibility
Table 26: Specifications for SFP+ copper transceiver modules

Product name (SKU) Transmission
distance

Data rate Cable type Connector
type

Aruba 10GBASE-T SFP+ RJ45 30m
Cat6A XCVR (JL563A)

30 m (98.43 ft) 10G STP Cat6A 1 RJ-45

1 See Transmission distance on page 11.

Table 27: Compatibility for SFP+ copper transceiver modules

Product name SKU Minimum software
required (JL563A)

Comments

Aruba 8320 48p 10G SFP/SFP+
and 6p 40G QSFP+ Switch

JL479A 10.01.0011 The JL563A transceiver does
NOT support 1G operation;
only 10G.

Aruba 8400X 32p 10G SFP/SFP+
Msec Module

JL363A 10.00.0018

SFP+ DAC cables
Figure 13: SFP+ DAC cable

IMPORTANT: Direct Attach over Copper (DAC) cables have a minimum bend radius of typically 4x
the diameter of the cable (approximately a 1" bend radius). Handle DAC cables carefully to ensure
that you do not crimp or bend the cable beyond a 1" radius, otherwise, you risk damaging the cable.
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Models, specifications, and compatibility
The specifications for Revision D transceiver products are the same as the specified Revision A, B, and C SKUs.
Where support for a Revision A, B, or C transceiver existed, Revision D parts are also supported.

Table 28: Specifications for SFP+ DAC cables

Product name (SKU) Cable length Data rate Type

HPE X242 10G SFP+ to SFP+ 1m DAC Cable (J9281B)

Aruba 10G SFP+ to SFP+ 1m DAC Cable (J9281D)

1 m (3.28 ft)

10.31 Gbps SFP+ cable
HPE X242 10G SFP+ to SFP+ 3m DAC Cable (J9283B)

Aruba 10G SFP+ to SFP+ 3m DAC Cable (J9283D)

3 m (9.84 ft)

HPE X242 10G SFP+ to SFP+ 7m DAC Cable (J9285B)

Aruba 10G SFP+ to SFP+ 7m DAC Cable (J9285D)

7 m (22.97 ft)

Table 29: Compatibility for the SFP+ copper cables

Product name SKU Minimum software required
(J9281B/J9281D, J9283B/J9283D,
J9285B/J9285D)

Comments

1850 Switch Series JL169A All Unlisted models do not have
SFP+ ports.

2530 Switch Series J9853A

J9854A

J9855A

J9856A

All Unlisted models do not have
SFP+ ports.

2540 Switch Series JL354A

JL355A

JL356A

JL357A

All (J9281B/J9281D and J9283B/
J9283D only. See comments for
exception)

J9285B/J9285D or any type
of 7m DAC are not supported
in any of these series

2910al Switch Series J9145A

J9146A

J9147A

J9148A

W.14.28 For use in the J9008A 2-port
10GbE SFP+ al module.

2920 Switch Series J9726A

J9727A

J9728A

J9729A

J9836A

All The SFP ports on the models
listed do not support these
10G SFP+ cables. For use in
an installed J9731A Aruba
2920 2-port 10GbE SFP+ .

Table Continued
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Product name SKU Minimum software required
(J9281B/J9281D, J9283B/J9283D,
J9285B/J9285D)

Comments

2930F Switch Series JL253A

JL254A

JL255A

JL256A

JL258A

JL263A

JL264A

JL558A

JL559A

All (J9281B/J9281D and J9283B/
J9283D only. See comment for
exception)

Unlisted models do not have
10G SFP+ ports.

J9285B/J9285D or any type
of 7m DAC are not supported
in any of these series.

2930M Switch Series JL319A

JL320A

JL321A

JL322A

JL323A

JL324A

All For use in an installed
JL083A Aruba 3810M/2930M
4SFP+ MACsec Module

J9285B/9285D (7m DAC) is
supported in all 2930M
models.

3500yl Switch Series J8692A

J8693A

J9310A

J9311A

K.14.50 For use in an installed
J9312A 10GbE 2-port SFP
+/2-port CX4 yl Module.

3800 Switch Series J9575A

J9576A

J9573A

J9574A

J9584A

All Unlisted models not do not
have SFP+ ports.

3810M Switch Series JL071A

JL072A

JL073A

JL074A

JL076A

All For use in an installed
JL083A Aruba 3810M/2930M
4SFP+ MACsec Module.

JL075A All For use in the JL075A SFP+
ports or used in an installed
JL083A Aruba 3810M/2930M
4SFP+ MACsec Module.

5400zl Switch Series J9309A K.14.39

Table Continued
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Product name SKU Minimum software required
(J9281B/J9281D, J9283B/J9283D,
J9285B/J9285D)

Comments

J9538A

J9548A

J9536A

K.15.02.0004

5400R Switch Series J9538A

J9548A

J9536A

All

J9990A

J9993A

KB.15.17

6120 Switch Series 516733-B21 All

6200yl Switch Series J8992A K.14.50 J8992A fixed SFP ports are
1GB and do not support
these SFP+ copper
cables.For use in an installed
J9312A 10GbE 2-port SFP
+/2-port CX4 yl Module.

6600 Switch Series J9264A

J9265A

J9452A

K.14.32

8200zl Switch Series J9309A K.14.39

J9538A

J9548A

J9536A

K.15.02.0004

Table Continued
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Product name SKU Minimum software required
(J9281B/J9281D, J9283B/J9283D,
J9285B/J9285D)

Comments

Aruba 8320 48p 10G
SFP/SFP+ and 6p
40G QSFP+ Switch

JL479A All (J9281B/J9281D and J9283B/
J9283D only. See comment for
exception.)

Only the following 4x4 part
numbers are supported:

• J9281B/J9281D: 8121-1151,
8121-1300

• J9283B/J9283D: 8121-1152,
8121-1298

J9285B/J9285D or any type
of 7m DAC are not supported
in the JL479A 8320 model.

Aruba 8400X 32p 10G
SFP/SFP+ Msec
Module

JL363A All Only the following 4x4 part
numbers are supported:
• J9281B/J9281D:

8121-1151, 8121-1300

• J9283B/9283D:
8121-1152, 8121-1298

• J9285B/J9285D:
8121-1154, 8121-1305
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Gigabit SFP optical transceiver modules
In December 2017, Aruba introduced Revision D versions of 100M, 1G, and 10G transceivers. Revision D
products are structured to be specific alternative vendors as sources for the SKU#. Earlier Revision A, B, or C
product may have alternative vendors that we no longer actively ship, but remain as fully supported in earlier and
current products.

Some switch products will be specifying Revision D transceivers for full support, while other products may support
earlier (older) revision transceivers – and some with specific 4x4 part numbers (see Chapter 1, "Overview" for
information regarding 4x4 part numbers).

Always refer to the Datasheet or QuickSpecs for the Switch product to see the current list of supported
transceivers.

Figure 14: Gigabit or 100-Megabit SFP optical transceiver module

NOTE: 

• Although a 10G SFP+ transceiver module has the same physical dimensions of a 1G SFP
transceiver, a 10G transceiver will NOT operate in a 1G SFP port.

• Many, although not all, 10G SFP+ ports have support to use a 1G SFP transceiver (or even a
100Mbps FX SFP transceiver). See the QuickSpec for the Switch product and verify if the 1G or
100Mbps SFP transceiver is supported in the 10G SFP+ port.

Models, specifications, and compatibility
Gigabit SFP optical transceiver modules use LC connectors.

The specifications for Revision D transceiver products are the same as the specified Revision A, B, and C SKUs.
Where support for a Revision A, B, or C transceiver existed, Revision D parts are also supported.

Chapter 5
SFP modules
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Table 30: Specifications for Gigabit SFP optical transceiver modules (1)

Product name
(SKU)

DOM - Digital
Optical
Monitoring
(4x4 part #)

Central wl
(nm)

Fiber
mode

Fiber
diameter
(µm)

Modal
bandwidth
(MHz*km)

Transmission
distance

HPE X121 1G SFP
LC SX Transceiver
(J4858C)

Aruba 1G SFP LC
SX 500m MMF
XCVR (J4858D)

Yes

(1990-4395 &
1990-4415)

850 MMF 50/125 500 (OM2)

400

550 m (1804.46 ft)

500 m (1640.42 ft)

62.5/125 200 (OM1)

160

275 m (902.23 ft)

220 m (721.78 ft)

HPE X121 1G SFP
LC LX Transceiver
(J4859C)

Aruba 1G SFP LC
LX 10km SMF
XCVR (J4859D)

Yes

(1990-4116,
1990-4414, &
1990-4608)

1310 SMF 9/125 N/A 10 km (6.21 miles)

MMF 50/125 500 or 400 550 m (1804.46 ft)

MMF 62.5/125 500 550 m (1804.46 ft)

HPE X121 1G SFP
LC LH Transceiver
(J4860C)

Aruba 1G SFP LC
LH 70km SMF
XCVR (J4860D)

Yes

(1990-4363)

1550 SMF 9/125 N/A 70 km (43.49
miles)

Table 31: Specifications for Gigabit SFP optical transceiver modules (2)

Product name (SKU) Optical parameters (dBm)

Transmit power Receive power

HPE X121 1G SFP LC SX Transceiver (J4858C)

Aruba 1G SFP LC SX 500m MMF XCVR (J4858D)

–9.5 to 0 –17 to –3

HPE X121 1G SFP LC LX Transceiver (J4859C)

Aruba 1G SFP LC LX 10km SMF XCVR (J4859D)

–9.5 to –3 –20 to –3

HPE X121 1G SFP LC LH Transceiver (J4860C)

Aruba 1G SFP LC LH 70km SMF XCVR (J4860D)

0 to +5 –22 to –3
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Table 32: Compatibility for Gigabit SFP optical transceiver modules

Product name SKU Minimum software required
(J4858C/J4858D, J4859C/J4859D,
J4860C/J4860D)

Comments

1400 Switch Series J9078A All

1410 Switch Series J9561A All

1700 Switch Series J9080A VB.01.09

1800 Switch Series J9028A/B PB.02.09

1810 Switch Series J9450A

J9660A

J4858C/J4858D: All

J4859C/J4859D: All

Gig LH (J4850C/
J4860D) is supported
only in the J9450A
model.

J9801A

J9803A

J9834A

J4858C/J4858D: All

J4859C/J4859D: All

Gig LH (J4860C/
J4860D) is not
supported.

1820 Switch Series J9980A

J9981A

J9983A

J9984A

J4858C/J4858D: All

J4859C/J4859D: All

J4860C/J4860D: Not supported

Gig LH (J4860C/
J4860D) is not
supported on the 1820
series.

1850 Switch Series JL169A J4858C/JL4858D: All

J4859C/J4859D: All

J4860C/J4860D: Not supported

Gig LH (J4860C/
J4860D) is not
supported on the 1850
series. Other 1850
models not listed do not
have SFP ports.

1920S JL381A

JL382A

JL384A

JL385A

JL386A

J4858C/J4858D: All

J4859C/J4859D: All

J4860C/J4860D: Not supported

Gig LH (J4860C/
J4860D) is not
supported on the 1920S
series.

Models JL380A and
JL383A do not include
SFP ports.

2510 Switch Series J9019A/B

J9020A

J9279A

J9280A

All

2520 Switch Series J9137A

J9138A

J9298A

J9299A

All

Table Continued
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Product name SKU Minimum software required
(J4858C/J4858D, J4859C/J4859D,
J4860C/J4860D)

Comments

2530 Switch Series J9772A

J9773A

J9774A

J9775A

J9776A

J9777A

J9778A

J9779A

J9780A

J9781A

J9782A

J9783A

J9853A

J9854A

J9855A

J9856A

All

2540 Switch Series JL354A

JL355A

JL356A

JL357A

All

2600 Switch Series J4899A/B/C

J4900A/B/C

J8164A

J8165A

J8762A

H.08.98

2610 Switch Series J9085A

J9086A

J9087A

J9088A

J9089A

All

2615-8-PoE Switch J9565A All

Table Continued
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Product name SKU Minimum software required
(J4858C/J4858D, J4859C/J4859D,
J4860C/J4860D)

Comments

2620 Switch Series J9623A

J9624A

J9625A

J9626A

J9627A

All

2800 Switch Series J4903A

J4904A

i.08.103

2810 Switch Series J9021A

J9022A

All

2900 Switch Series J9049A

J9050A

T.13.45

2910al Switch Series J9145A

J9146A

J9147A

J9148A

All For use in the SFP ports
on the models listed, and
in the J9008A 2-port
10GbE SFP+ al module.

2915-8G-PoE Switch J9562A All

2920 Series Switches J9726A

J9727A

J9728A

J9729A

J9836A

All For use in the SFP ports
on the models listed.
Also for use in the dual-
speed SFP+ ports of the
J9731A 2-Port 10GbE
SFP+ Module.

Table Continued
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Product name SKU Minimum software required
(J4858C/J4858D, J4859C/J4859D,
J4860C/J4860D)

Comments

2930F Series Switches JL253A

JL254A

JL255A

JL256A

JL258A

JL259A

JL260A

JL261A

JL262A

JL263A

JL264A

JL557A

JL558A

JL559A

All

2930M Switch Series JL319A

JL320A

JL321A

JL322A

JL323A

JL324A

All For use in SFP ports on
switch and an installed
JL083A Aruba 3810M/
2930M 4SFP+ MACsec
Module.

3400cl Switch Series J4905A

J4906A

All

3500 Series Switches J9470A

J9471A

J9472A

J9473A

K.14.31

3500yl Switch Series J8692A

J8693A

All For use in the SFP ports
on the models listed, and
in an installed J9312A
10GbE 2-port SFP+/2-
port CX4 yl Model

J9310A

J9311A

K.14.50

Table Continued
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Product name SKU Minimum software required
(J4858C/J4858D, J4859C/J4859D,
J4860C/J4860D)

Comments

3800 Switch Series J9573A

J9574A

J9575A

J9576A

J9584A

All

3810M Switch Series JL071A

JL072A

JL073A

JL074A

JL076A

JL075A

All For use in the JL075A
3810M switch. Also for
use in any 3810M switch
with a JL083A Aruba
3810M/2930M 4SFP+
MACsec Module
installed.

4200gl Switch Series J4893A

J4908A

G.07.103

4200vl Switch Series J8776A

J9033A

All

5300xl Switch Series J4878A/B

J4907A

E.10.36

5400zl Switch Series J8705A

J8706A

All

J9308A K.14.34

J9537A

J9549A

J9535A

J9637A

J9538A

J9548A

J9536A

K.15.02.0004

Table Continued
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Product name SKU Minimum software required
(J4858C/J4858D, J4859C/J4859D,
J4860C/J4860D)

Comments

5400R Switch Series J9537A

J9549A

J9535A

J9637A

J9538A

J9548A

J9536A

All

J9988A

J9989A

J9990A

J9993A

KB.15.17

6108 Switch J4902A H.07.88

6120 Switch Series 498358-B21

516733-B21

SX, LX: all versions

LH: not supported

6200yl-24G-mGBIC Switch J8992A All

6600 Switch Series J9263A

J9264A

K.14.03

J9451A K.14.24

8100fl Switch J8735A All

8200zl Switch Series J8705A

J8706A

All

J9308A K.14.34

J9537A

J9549A

J9535A

J9637A

J9538A

J9548A

J9536A

K.15.02.0004

Table Continued
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Product name SKU Minimum software required
(J4858C/J4858D, J4859C/J4859D,
J4860C/J4860D)

Comments

Aruba 8320 48p 10G
SFP/SFP+ and 6p 40G QSFP
+ Switch

JL479A All Only the following 4x4
part numbers are
supported:

• J4858C/J4858D:
1990-4395, 1990-4415

• J4859C/J4859D:
1990-4116, 1990-4414

• J4860C/J4860D:
1990-4363

Aruba 8400X 32p 10G
SFP/SFP+ Msec Module

JL363A All Only the following 4x4
part numbers are
supported:
• • J4858C/J4858D:

1990-4395,
1990-4415

• • J4859C/J4859D:
1990-4116,
1990-4414

• • J4860C/J4860D:
1990-4363

9300m Switch Series J4885A

J4894A

All

9408sl Switch J8684A All

100-Megabit SFP optical transceiver modules
Figure 15: Gigabit or 100-Megabit SFP optical transceiver module

Models, specifications, and compatibility
100 Megabit SFP optical transceiver modules use LC connectors.

The specifications for Revision D transceiver products are the same as the specified Revision A, B, and C SKUs.
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Table 33: Specifications for 100-Megabit SFP optical transceiver modules (1)

Product name (SKU) DOM - Digital
Optical
Monitoring (4x4
part #)

Central wl
(nm)

Fiber
mode

Fiber diameter
(µm)

Transmission
distance

HPE X111 100M SFP
LC FX Transceiver
(J9054C)

Aruba 100M SFP LC
FX 2km MMF XCVR
(J9054D)

Yes

(1990-4483,
1990-4360)

1310 MMF 50/125

62.5/125

2 km (1.24 miles)

Table 34: Specifications for 100–Megabit SFP optical transceiver modules (2)

Product name (SKU) Optical parameters (dBm)

Transmit power Receive power

HPE X111 100M SFP LC FX Transceiver
(J9054C)

Aruba 100M SFP LC FX 2km MMF XCVR
(J9054D)

–19 to –14 –30 to –14

Table 35: Compatibility for the 100-Megabit SFP optical transceiver module

Product name SKU Minimum software required Comments

1410G Switch Series J9559A

J9560A

J9561A

J9559A, J9560A: Not supported (no
SFP ports)

J9561A: All

For use in the SFP ports of the
J9561A 1410-24G Switch

1810G Series
Switches

J9450A

J9660A

For J9450A, J9660A: All For use in the SFP ports of the
J9450A 1810G-24 Switch and
J9660A V1810-48G Switch. (The
J9449A 1810G-8 Switch does not
have SFP ports.)

1810G v2 Switch
Series

J9801A

J9803A

All For use in the SFP ports of the
J9801A 1810-24 v2 and J9803A
1810-24G v2 Switches

PS1810 Switch J9834A All For use in the SFP ports of the
J9834A PS1810-24G Switch

Table Continued
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Product name SKU Minimum software required Comments

1820 Switch Series J9980A

J9981A

J9983A

J9984A

All The J9054B 100-FX SFP-LC
transceiver is not supported in the
1820G switches

The J9054C part number
1990-4483 is not supported in
these products.

(Only the J9054C/J9054D part
number 1990-4360 is supported.)

2510-24 Switch J9019A/B Q.10.04

2510-48 Switch J9020A All

2510G Switch Series J9279A

J9280A

All

2520 Switch Series J9137A

J9138A

All

2520G Switch Series J9298A

J9299A

J9054B: All

J9054C: J.14.32

2530 Switch Series J9772A

J9773A

J9774A

J9775A

J9776A

J9777A

J9778A

J9779A

J9780A

J9781A

J9782A

J9783A

J9853A

J9854A

J9855A

J9856A

For J9853A, J9854A, J9855A, and
J9856A: Not supported

For all other switches: All

For use in the SFP ports of the
2530 Series Switches. (The
J9853A, J9854A, J9855A, and
J9856A models have 1G/10G
SFP+ ports that do not support
these 100Mbps transceiver
modules.)

Table Continued
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Product name SKU Minimum software required Comments

2540 Switch Series JL354A

JL355A

JL356A

JL357A

All

2610 Switch Series J9085A

J9086A

J9087A

J9088A

J9089A

All

2615-8-PoE Switch J9565A J9054B: All J9054C: A.14.07

2620 Switch Series J9623A

J9624A

J9625A

J9626A

J9627A

All

2800 Switch Series J4903A

J4904A

J9054B/C 1990-3613 and J9054C
1990-4112: i.10.30

J9054C 1990-4483: Not supported

J9054C part number 1990-4483 is
not supported

2810 Switch Series J9021A

J9022A

N.10.07

2900 Switch Series J9049A

J9050A

T.12.01

2910al Switch Series J9145A

J9146A

J9147A

J9148A

All

2915-8G-PoE Switch J9562A J9054B: All

J9054C/J9054D: A.14.07

Table Continued

46 ArubaOS-Switch and ArubaOS-CX Transceiver Guide

Anexo 01 ITEM 13 (0592744)         SEI 0008478-63.2018.6.02.8000 / pg. 8208



Product name SKU Minimum software required Comments

2920 Series
Switches

J9726A

J9727A

J9728A

J9729A

J9836A

All Use in the SFP ports of the 2920
Series Switches.

100-FX is not supported in the
SFP+ ports of the J9731A 2-Port
10GbE SFP+ Module

2930F Switch Series JL253A

JL254A

JL255A

JL256A

JL258A

JL263A

JL264A

JL259A

JL260A

JL261A

JL262A

JL557A

JL558A

JL559A

J9054B: is not supported in the
2930F Series Switches

For J9054C/9054D: All

The 2930F Switch Series models
with 1G/10G SFP+ ports added
support for this J9054C/J9054D
100FX transceiver. The J9054C/
J9054D are supported in models
with 1G SFP ports.

2930M Switch Series JL319A

JL320A

JL321A

JL322A

JL323A

JL324A

J9054B is not supported in the
2930M Series Switches.

For J9054C/J9054D: All

For use in SFP ports on switch
and an installed JL083A Aruba
3810M/2930M 4SFP+ MACsec
Module.

3500 Series
Switches

J9470A

J9471A

J9472A

J9473A

J9054B/C 1990-3613: K.14.31

J9054C 1990-4112 and 1990-4483:
K.15.08.0007

J9054D: K.15.08.0007

Table Continued
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Product name SKU Minimum software required Comments

3500yl Switch Series J8692A

J8693A

J9310A

J9311A

For J8692A, J8693A: K.12.01 (for
J9054B/C 1990-3613); K.15.08.0007
(for J9054C 1990-4112 and
1990-4483, and J9054D 1990-4483
and 1990-4360)

For J9310A, J9311A: K.14.50 (for
J9054B/C 1990-3613); K.15.08.0007
(for J9054C 1990-4112 and
1990-4483, and J9054D)

3800 Switch Series J9573A

J9574A

J9575A

J9576A

J9584A

For J9573A, J9574A, J9575A,
J9576A: Not supported.

For J9584A: All

Not supported for use in the
following 3800 models: J9573A,
J9574A, J9575A, and J9576A.
The SFP+ ports do not support
100M operation.

Supported in the J8584A
3800-24SFP-2SFP+ Switch

3810M Switch Series JL071A

JL072A

JL073A

JL074A

JL076A

All For use in an installed JL083A
Aruba 3810M/2930M 4SFP+
MACsec Module.

JL075A All For use in the JL075A SFP+
ports. Also used in an installed
JL083A Aruba 3810M/2930M
4SFP+ MACsec Module.

4100gl Switch Series J4865A

J4887A

n/a J9054C/J9054D 100FX is not
supported.

4200vl Switch Series J8770A

J8771A

J8772A/B

J8773A

L.10.24 Supported: J9033A Switch vl 20-
Port Gig-T + 4-Port SFP Module

Not supported: J8776A Switch vl
4-Port Mini-GBIC Module

5300xl Switch Series J4819A

J4850A

n/a J9054C/J9054D 100FX is not
supported.

Table Continued
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Product name SKU Minimum software required Comments

5400zl Switch Series J8697A

J8698A

J9642A

J9643A

For J8705A and J8706A modules: K.
12.01 (for J9054B/C 1990-3613); K.
15.08.0007 (for J9054C 1990-4112
and 1990-4483) J9054D: K.
15.08.0007

For the J9308A module: K.14.34 (for
J9054B/C 1990-3613); K.15.08.0007
(for J9054C 1990-4112 and
1990-4483) J9054D: K.15.08.0007

For J9537A, J9549A, J9535A, and
J9637A modules: K.15.02.0004 (for
J9054B/C 1990-3613); K.15.08.0007
(for J9054C 1990-4112 and
1990-4483) J9054D: K.15.08.0007

For use in:

J8705A Switch zl 20-Port
10/100/1000 + 4-Port Mini-GBIC
Module

J8706A Switch zl 24-Port Mini-
GBIC Module

J9308A 20-Port 10/100/1000 PoE
+ and 4-Port SFP zl Module

J9537A 24-Port SFP v2 zl Module

J9549A 20- Port Gig-T / 4-Port
SFP v2 zl Module

J9535A 20-Port Gig-T PoE+ / 4-
Port SFP v2 zl Module

J9637A 12-Port Gig- T PoE+ / 12-
Port SFP v2 zl Module

5400R Switch Series J9821A

J9822A

J9823A

J9824A

J9825A

J9826A

J9868A

For J9535A, J9537A, J9549A, and
J9637A modules: All

For the J9988A, J9989A, J9990A,
and J9993A modules: KB.15.17 and
later

For use in:

J9537A 24-Port SFP v2 zl Module

J9549A 20-Port Gig-T / 4-Port
SFP v2 zl Module

J9535A 20-Port Gig-T PoE+ / 4-
Port SFP v2 zl Module

J9637A 12-Port Gig-T PoE+ / 12-
Port SFP v2 zl Module

J9988A 24p 1GbE SFP v3 zl2
Module

J9989A 12p PoE+ / 12p 1GbE
SFP v3 zl2 Module

J9990A 20p PoE+ / 4p SFP+ v3
zl2 Module

J9993A 8p 1G/10GbE SFP+ v3
zl2 Module

6108 Switch J4902A n/a 100-FX is not supported

6120 Blade Switch
Series

498358-B21

516733-B21

n/a 100-FX is not supported

6200yl-24G-mGBIC
Switch

J8992A K.12.01 (for J9054B/C 1990-3613);
K.15.08.0007 (for J9054C 1990-4112
and 1990-4483) J9054D: K.
15.08.0007

For use in all 24 ports of the
J8992A Switch 6200yl- 24G-
mGBIC
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Product name SKU Minimum software required Comments

6600 Switch Series J9263A

J9264A

J9265A

J9451A

J9452A

For J9263A, J9264A: K.14.03 (for
J9054B/C 1990-3613); K.15.08.0007
(for J9054C 1990-4112 and
1990-4483)

For J9451A: K.14.24 (for J9054B/C
1990-3613); K.15.08.0007 (for
J9054C 1990-4112 and 1990-4483)
J9054D: K.15.08.0007

For use in the SFP ports of the
J9263A 6600-24G Switch, the
J9264A 6600-24G-4XG Switch,
and the J9451A 6600-48G Switch

(The J9265A 6600-24XG Switch
and J9452A 6600- 48G-4XG
Switch do not have SFP ports)

8100fl Switch Series J8727A

J8728A

n/a 100-FX is not supported

8200zl Switch Series J8715A/B

J9475A

J9640A

J9641A

For J8705A and J8706A modules: All
(for J9054B/C 1990-3613); K.
15.08.0007 (for J9054C 1990-4112
and 1990-4483) J9054D: K.
15.08.0007

For the J9308A module: K.14.34 (for
J9054B/C 1990-3613); K.15.08.0007
(for J9054C 1990-4112 and
1990-4483) J9054D: K.15.08.0007

For J9537A, J9549A, J9535A, and
J9637A modules: K.15.02.0004 (for
J9054B/C 1990-3613); K.15.08.0007
(for J9054C 1990-4112 and
1990-4483) J9054D: K.15.08.0007

For use in:

J8705A Switch zl 20-Port
10/100/1000 + 4-Port Mini-GBIC
Module

J8706A Switch zl 24-Port Mini-
GBIC Module

J9308A 20-Port 10/100/1000 PoE
+ and 4-Port SFP zl Module

J9537A 24-Port SFP v2 zl Module

J9549A 20- Port Gig-T / 4-Port
SFP v2 zl Module

J9535A 20-Port Gig-T PoE+ / 4-
Port SFP v2 zl Module

J9637A 12-Port Gig- T PoE+ / 12-
Port SFP v2 zl Module

8320 Series All n/a 100Mbps Transceivers are NOT
supported in the 8320 series.

8400 Series All n/a 100Mbps Transceivers are NOT
supported in the 8400 series.

9300m Switch Series J4138A

J4139A

J4874A

n/a 100-FX is not supported.

9408sl Switch J8680A n/a 100-FX is not supported
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Gigabit BIDI optical transceiver modules
Figure 16: Gigabit BIDI optical transceiver module

Models, specifications, and compatibility
Gigabit BIDI optical transceiver modules provide a transmission rate of 1250 Mbps and use LC connectors.

NOTE:

• BIDI optical transceiver modules use different central wavelengths in transmit and receive
directions to implement bidirectional transmission of fiber signals over the same fiber.

• You must use the HPE X122 1G SFP LC BX 10-D Transceiver (J9142B) and HPE X122 1G SFP
LC BX 10-U Transceiver (J9143B) in pairs: a J9142B (-D = downlink) at one end of the
connection and a J9143B (-U = uplink) at the other.

• The J9142B/J9143B were End of Sale in April 2016 and are no longer available. Contact your
Aruba Sales team for alternative solutions. The information presented here is for compatibility
use.

Table 36: Specifications for Gigabit BIDI optical transceiver modules (1)

Product name
(SKU)

DOM - Digital
Optical
Monitoring (4x4
part #)

Central wavelength (nm) Fiber
mode

Fiber
diameter
(µm)

Transmission
distance

Transmit
end (TX)

Receive
end (RX)

HPE X122 1G SFP
LC BX-D Transceiver
(J9142B)

No 1490 1310 SMF 9/125 10 km (6.21
miles)

HPE X122 1G SFP
LC BX-U Transceiver
(J9143B)

No 1310 1490
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Table 37: Specifications for Gigabit BIDI transceiver modules (2)

Product name (SKU) Optical parameters
(dBm)

Transmit power Receive power

HPE X122 1G SFP LC BX-D Transceiver (J9142B)

HPE X122 1G SFP LC BX-U Transceiver (J9143B)

–9 to –3 –18.7 to –3

Table 38: Compatibility for Gigabit BIDI transceiver modules

Product name SKU Minimum software
required (J9142B,
J9143B)

Comments

1400 Switch Series J9078A All

1410 Switch Series J9561A All

1700 Switch Series J9080A VB.02.00

1800 Switch Series J9028A/B PB.03.00

2510-24 Switch J9019A/B Q.11.16

2510-48 Switch J9020A U.11.10

2510G–24 Switch J9279A Y.11.03

2510G–48 Switch J9280A Y.11.03

2520 Switch Series J9137A

J9138A

J9298A

J9299A

All

Table Continued
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Product name SKU Minimum software
required (J9142B,
J9143B)

Comments

2530 Switch Series J9772A

J9773A

J9774A

J9775A

J9776A

J9777A

J9778A

J9779A

J9780A

J9781A

J9782A

J9783A

J9853A

J9854A

J9855A

J9856A

All

2540 Switch Series JL354A

JL355A

JL356A

JL357A

n/a 1G BX is not officially supported for
use in the 2540 series.

2600 Switch Series J4899A/B/C

4900A/B/C

J8164A

J8165A

J8762A

H.10.72

2610 Switch Series J9085A

J9086A

J9087A

J9088A

J9089A

R.11.22

2615-8-PoE Switch J9565A All

Table Continued
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Product name SKU Minimum software
required (J9142B,
J9143B)

Comments

2620 Switch Series J9623A

J9624A

J9625A

J9626A

J9627A

All

2800 Switch Series J4903A

J4904A

i.10.69

2810 Switch Series J9021A

J9022A

N.11.14

2900 Switch Series J9049A

J9050A

T.13.45

2910al Switch Series J9145A

J9146A

J9147A

J9148A

All

2915-8G-PoE Switch J9562A All

2920 Series Switches J9726A

J9727A

J9728A

J9729A

J9836A

All

Table Continued
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Product name SKU Minimum software
required (J9142B,
J9143B)

Comments

2930F Series Switches JL253A

JL254A

JL255A

JL256A

JL258A

JL259A

JL260A

JL261A

JL262A

JL263A

JL264A

Supported for use by
a future software
version.

As of April 2016, the J9142B and
J9143B 1G BX transceivers have been
End of Sale. Contact your Aruba
representative for alternative solutions.

2930M Switch Series JL319A

JL320A

JL321A

JL322A

JL323A

JL324A

See comments. As of April 2016, the J9142B and
J9143B 1G BX transceivers have been
End of Sale. Contact your Aruba
representative for alternative solutions.

3500 Series Switches J9470A

J9471A

J9472A

J9473A

K.14.31

3500yl Switch Series J8692A

J8693A

K.14.31

J9310A

J9311A

K.14.50

3800 Switch Series J9573A

J9574A

J9575A

J9576A

J9584A

All

Table Continued
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Product name SKU Minimum software
required (J9142B,
J9143B)

Comments

3810M Switch Series JL071A

JL072A

JL073A

JL074A

JL076A

All As of April 2016, the J9142B and
J9143B 1G BX transceivers have been
End of Sale. Contact your Aruba
representative for alternative solutions.

For use in the JL075A 3810M switch
or in any 3810M switch with a JL083A
Aruba 3810M/2930M 4SFP+ MACsec
Module installed.

JL075A All

4200vl Switch Series J8776A

J9033A

L.11.16

5300xl Switch Series J4878A/B

J4907A

E.11.08

5400zl Switch Series J8705A

J8706A

K.13.45

J9308A K.14.34

J9537A

J9549A

J9535A

J9637A

J9538A

J9548A

J9536A

K.15.02.0004

5400R Switch Series J9537A

J9549A

J9535A

J9637A

J9538A

J9548A

J9536A

All As of April 2016, the J9142B and
J9143B 1G BX transceivers have been
End of Sale. Contact your Aruba
representative for alternative solutions.

Table Continued
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Product name SKU Minimum software
required (J9142B,
J9143B)

Comments

J9988A

J9989A

J9990A

J9993A

KB.15.17

6200yl-24G-mGBIC Switch J8992A K.13.45

6600 Switch Series J9263A

J9264A

K.14.03

J9451A K.14.24

8200zl Switch Series J8705A

J8706A

K.13.45

J9308A K.14.34

J9537A

J9549A

J9535A

J9637A

J9538A

J9548A

J9536A

K.15.02.0004

8320 Series JL479A,
JL579A

n/a 1G BX Transceivers are NOT
supported in the 8320 series.

8400 Series All n/a 1G BX Transceivers are NOT
supported in the 8400 series.

Gigabit SFP copper transceiver modules
Figure 17: Gigabit SFP copper transceiver module
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Models, specifications, and compatibility
Table 39: Specifications for SFP copper transceiver modules

Product name (SKU) Transmission
distance

Data rate Cable type Connector
type

HPE X121 1G SFP RJ45 T
Transceiver (J8177C)

Aruba 1G SFP RJ45 T 100m Cat5e
XCVR (J8177D)

100 m (328.08 ft) 1G

100Mbps1

Cat5e
UTP/STP

RJ-45

1 For certain products. See next table.

Table 40: Compatibility for SFP copper transceiver modules

The specifications for Revision D transceiver products are the same as the specified Revision A, B, and C SKUs.

Product name SKU Minimum software
required (J8177C/
J8177D)

Comments

1810 Series Switches J9660A

J9801A

J9803A

J9834A

All

1820 Switch Series J9980A

J9981A

J9983A

J9984A

All

1920S Switch Series JL381A

JL382A

JL384A

JL385A

JL386A

Not supported The JL380A and JL383A
switches do not include SFP
ports.

2510 Switch J9020A All

Table Continued
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Product name SKU Minimum software
required (J8177C/
J8177D)

Comments

2530 Switch Series J9782A

J9781A

J9776A

J9775A

J9779A

J9778A

J9773A

J9772A

J9856A

J9855A

J9854A

J9853A

All

2540 Switch Series JL354A

JL355A

JL356A

JL357A

All

2610 Switch Series J9085A

J9086A

J9087A

J9088A

J9089A

All

2620 Switch Series J9623A

J9624A

J9625A

J9626A

J9627A

All

2920 Series Switches J9731A All

Table Continued
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Product name SKU Minimum software
required (J8177C/
J8177D)

Comments

2930F Series Switches JL253A, JL254A

JL255A

JL256A

JL258A

JL259A

JL260A

JL261A

JL262A

JL263A

JL264A

JL557A

JL558A

JL559A

All J8177C/J8177D support both
100Mbps and 1G operation in
this Switch Series.

2930M Switch Series JL319A

JL320A

JL321A

JL322A

JL323A

JL324A

All J8177C is not supported for
use in the Dual-Personality
ports of the 2930M Series
Switches.

For use in an installed JL083A
Aruba 3810M/2930M 4SFP+
MACsec Module.

J8177C/J8177D support both
100Mbps and 1G operation in
this Switch Series.

3800 Switch Series J9573A

J9574A

J9575A

J9576A

J9584A

All

3810M Switch Series JL071A

JL072A

JL073A

JL074A

JL076A

All For use in the JL075A 3810M
switch. Also used in any
3810M switch with a JL083A
Aruba 3810M/2930M 4SFP+
MACsec Module installed.

J8177C/J8177D support both
100Mbps and 1G operation in
this Switch Series.

Table Continued
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Product name SKU Minimum software
required (J8177C/
J8177D)

Comments

JL075A All

4100gl Switch Series J4893A

J4908A

G.07.69

4200vl Switch Series J8776A

J9033A

All

5300xl Switch Series J4878A/B E.09.22

5400zl Switch Series J8705A

J8706A

All

J9308A K.14.34

J9537A

J9549A

J9535A

J9637A

K.15.02.0004

5400R Switch Series J9537A

J9549A

J9535A

J9637A

All J8177C/J8177D support both
100Mbps and 1G operation in
this Switch Series.

J9988A

J9989A

J9990A

J9993A

KB.15.17 J8177C/J8177D support both
100Mbps and 1G operation in
this Switch Series.

6120 Blade Switch Series 498358-B21

516733-B21

All

6200yl-24G-mGBIC Switch J8992A All

8100fl Switch Series J8735A CY.01.02.0050

8200zl Switch Series J8705A

J8706A

All

J9308A K.14.34

Table Continued
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Product name SKU Minimum software
required (J8177C/
J8177D)

Comments

J9537A

J9549A

J9535A

J9637A

K.15.02.0004

Aruba 8320 48p 10G SFP/SFP+
and 6p 40G QSFP+ Switch

JL479A All 100Mbps operation is NOT
supported in this series.

Only the 1G Copper 4x4
numbers 1990-3816 and
1990-4606 are supported for
use in the 8320 and 8400
Series.

Aruba 8400X 32p 10G SFP/SFP+
Msec Module

JL363A All
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Networking Websites
Hewlett Packard Enterprise Networking Information Library

www.hpe.com/networking/resourcefinder

Hewlett Packard Enterprise Networking Software

www.hpe.com/networking/software

Hewlett Packard Enterprise Networking website

www.hpe.com/info/networking

Hewlett Packard Enterprise My Networking website

www.hpe.com/networking/support

Hewlett Packard Enterprise My Networking Portal

www.hpe.com/networking/mynetworking

Hewlett Packard Enterprise Networking Warranty

www.hpe.com/networking/warranty

General websites
Hewlett Packard Enterprise Information Library

www.hpe.com/info/EIL

For additional websites, see Support and other resources.

Chapter 6
Websites
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Accessing Hewlett Packard Enterprise Support
• For live assistance, go to the Contact Hewlett Packard Enterprise Worldwide website:

http://www.hpe.com/assistance

• To access documentation and support services, go to the Hewlett Packard Enterprise Support Center website:

http://www.hpe.com/support/hpesc

Information to collect

• Technical support registration number (if applicable)

• Product name, model or version, and serial number

• Operating system name and version

• Firmware version

• Error messages

• Product-specific reports and logs

• Add-on products or components

• Third-party products or components

Accessing updates
• Some software products provide a mechanism for accessing software updates through the product interface.

Review your product documentation to identify the recommended software update method.

• To download product updates:

Hewlett Packard Enterprise Support Center
www.hpe.com/support/hpesc

Hewlett Packard Enterprise Support Center: Software downloads
www.hpe.com/support/downloads

Software Depot
www.hpe.com/support/softwaredepot

• To subscribe to eNewsletters and alerts:

www.hpe.com/support/e-updates

• To view and update your entitlements, and to link your contracts and warranties with your profile, go to the
Hewlett Packard Enterprise Support Center More Information on Access to Support Materials page:

www.hpe.com/support/AccessToSupportMaterials

Chapter 7
Support and other resources
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IMPORTANT: Access to some updates might require product entitlement when accessed through
the Hewlett Packard Enterprise Support Center. You must have an HPE Passport set up with
relevant entitlements.

Customer self repair
Hewlett Packard Enterprise customer self repair (CSR) programs allow you to repair your product. If a CSR part
needs to be replaced, it will be shipped directly to you so that you can install it at your convenience. Some parts
do not qualify for CSR. Your Hewlett Packard Enterprise authorized service provider will determine whether a
repair can be accomplished by CSR.

For more information about CSR, contact your local service provider or go to the CSR website:

http://www.hpe.com/support/selfrepair

Remote support
Remote support is available with supported devices as part of your warranty or contractual support agreement. It
provides intelligent event diagnosis, and automatic, secure submission of hardware event notifications to Hewlett
Packard Enterprise, which will initiate a fast and accurate resolution based on your product's service level.
Hewlett Packard Enterprise strongly recommends that you register your device for remote support.

If your product includes additional remote support details, use search to locate that information.

Remote support and Proactive Care information
HPE Get Connected

www.hpe.com/services/getconnected
HPE Proactive Care services

www.hpe.com/services/proactivecare
HPE Proactive Care service: Supported products list

www.hpe.com/services/proactivecaresupportedproducts
HPE Proactive Care advanced service: Supported products list

www.hpe.com/services/proactivecareadvancedsupportedproducts

Proactive Care customer information
Proactive Care central

www.hpe.com/services/proactivecarecentral
Proactive Care service activation

www.hpe.com/services/proactivecarecentralgetstarted

Warranty information
To view the warranty for your product or to view the Safety and Compliance Information for Server, Storage,
Power, Networking, and Rack Products reference document, go to the Enterprise Safety and Compliance website:

www.hpe.com/support/Safety-Compliance-EnterpriseProducts

Additional warranty information
HPE ProLiant and x86 Servers and Options

www.hpe.com/support/ProLiantServers-Warranties
HPE Enterprise Servers

www.hpe.com/support/EnterpriseServers-Warranties
HPE Storage Products

www.hpe.com/support/Storage-Warranties
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HPE Networking Products
www.hpe.com/support/Networking-Warranties

Regulatory information
To view the regulatory information for your product, view the Safety and Compliance Information for Server,
Storage, Power, Networking, and Rack Products, available at the Hewlett Packard Enterprise Support Center:

www.hpe.com/support/Safety-Compliance-EnterpriseProducts

Additional regulatory information

Hewlett Packard Enterprise is committed to providing our customers with information about the chemical
substances in our products as needed to comply with legal requirements such as REACH (Regulation EC No
1907/2006 of the European Parliament and the Council). A chemical information report for this product can be
found at:

www.hpe.com/info/reach

For Hewlett Packard Enterprise product environmental and safety information and compliance data, including
RoHS and REACH, see:

www.hpe.com/info/ecodata

For Hewlett Packard Enterprise environmental information, including company programs, product recycling, and
energy efficiency, see:

www.hpe.com/info/environment

Documentation feedback
Hewlett Packard Enterprise is committed to providing documentation that meets your needs. To help us improve
the documentation, send any errors, suggestions, or comments to Documentation Feedback
(docsfeedback@hpe.com). When submitting your feedback, include the document title, part number, edition,
and publication date located on the front cover of the document. For online help content, include the product
name, product version, help edition, and publication date located on the legal notices page.
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Notices
The information contained herein is subject to change without notice. The only warranties for Hewlett Packard
Enterprise products and services are set forth in the express warranty statements accompanying such products
and services. Nothing herein should be construed as constituting an additional warranty. Hewlett Packard
Enterprise shall not be liable for technical or editorial errors or omissions contained herein.

Confidential computer software. Valid license from Hewlett Packard Enterprise required for possession, use, or
copying. Consistent with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software
Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government under vendor's
standard commercial license.

Links to third-party websites take you outside the Hewlett Packard Enterprise website. Hewlett Packard Enterprise
has no control over and is not responsible for information outside the Hewlett Packard Enterprise website.
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The transceivers listed in this document represent the currently available and End of Sale products at the time of
this publication. Not all transceiver products are supported in every switch available from Aruba. Consult the
QuickSpecs for the applicable switch product for a list of supported transceiver products. QuickSpecs can be
found at http://www.hpe.com/networking/resourcefinder

Conventions
This section describes the conventions used in the documentation.

Note on product images
NOTE: Product images in this guide may differ from actual product.

Port numbering in examples
The port numbers in this document are for illustration only and might be unavailable on your device.

Symbols
Table 1: Symbols

Convention Description

An alert that calls attention to important information that if not
understood or followed can result in personal injury.

An alert that calls attention to important information that if not
understood or followed can result in data loss, data corruption, or
damage to hardware or software.

An alert that calls attention to essential information.

NOTE: An alert that contains additional or supplementary information.

An alert that provides helpful information.

Chapter 1
Overview
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Types of transceiver modules and network cables
Table 2: Types of transceiver modules and network cables

Transceiver module type Connector head

QSFP28 module (transceiver) QSFP28 optical transceiver module MPO 12-strand or LC 2-strand

QSFP28 DAC (copper cable for
interconnecting devices) 1 - 5m
reaches

N/A

QSFP+ module (transceiver) QSFP+ optical transceiver module MPO 12-strand or LC 2-strand

QSFP+ DAC (copper cable for
interconnecting devices) 1 - 5m
reaches

N/A

SFP+ module (transceiver) SFP+ optical transceiver module LC 2-strand or 1-strand (for BiDi)

SFP+ DAC (copper cable for
interconnecting devices)

N/A

Small form-factor pluggable (SFP)
module (transceiver)

100-Megabit SFP optical
transceiver module

LC 2-strand

Gigabit SFP optical transceiver
module

Gigabit SFP copper transceiver
module

RJ-45

NOTE:

• The available transceiver modules and network cables vary by device models and are subject to
change over time. For the most up-to-date list of transceiver modules and network cables, contact
your Aruba sales representative or technical support engineer.

• For information about the transceiver modules and network cables available for each device
model, see the QuickSpecs for the applicable switch product.

Data rate
Data rate is the number of bits transmitted per second. The unit of measure for data rate is Megabits per second
(Mbps) or Gigabits per second (Gbps). Optical transceiver modules available for products provide the following
levels of data rates:

• 100 Gbps

• 40 Gbps

• 10 Gbps

6 ArubaOS-Switch and ArubaOS-CX Transceiver Guide

Anexo 01 ITEM 14 (0592745)         SEI 0008478-63.2018.6.02.8000 / pg. 8234



• 1000 Mbps (also known as Gigabit)

• 100 Mbps

Transmission distance
The transmission distance of optical transceiver modules is divided into short and long-range types. A distance of
2 km (1.24 miles) and below is considered a short-range type. A distance of 10 km (6.21 miles) is considered a
long-range type. Transmission distances provided by optical transceiver modules are limited by certain loss and
dispersion suffered during the transmission of fiber signals over fibers.

• Loss is the optical energy loss due to the absorption, dispersion, and leakage over the media when light
travels through optical fibers. This loss increases in direct ratio to transmission distance.

• Dispersion occurs mainly because light waves of different wavelengths travel at different rates over the same
medium. This causes different wave components of optical signals to reach the receiving end early or late as
the transmission distance increases causing impulse broadening. Impulse broadening makes the signal values
indistinguishable (data loss). Different wavelengths traveling down the same fiber are called modes, and this
data loss is known as intermodal dispersion.

To meet different transmission distance requirements, choose suitable optical transceiver modules according to
actual networking conditions.

Central wavelength
Central wavelength (wl) represents the wave band used for optical signal transmission. The following central
wavelengths are available for common optical transceiver modules representing three wavebands:

• 850 nm waveband: Used for short-reach transmission.

• 1310 nm waveband: Used for middle-reach and long-haul transmission.

• 1550 nm waveband: Used for middle-reach and long-haul transmission.

Fiber

Fiber types
Fibers are classified as multimode fibers and single-mode fibers.

• Multimode fibers

Multimode fibers (MMFs) have thicker fiber cores and can transport light in multiple modes. However, the
intermodal dispersion is greater and worsens as the transmission distance increases.

Multimode fibers can be classified into multiple grades according to their diameters and modal bandwidth. For
more information, see Table 2. The modal bandwidth of a multimode fiber is determined by the expression of
the maximum modulation frequency pulse that can pass a fiber × the fiber length. The modal bandwidth is a
comprehensive index reflecting the optical characteristics of a multimode fiber.

International Telecommunication Union (ITU) defines multimode fiber types in its G series standards. The
commonly used multimode fiber is defined in the ITU G.651 standard. The G.651-compliant fiber transmits
light at the wavelength range 800 nm to 900 nm or 1200 nm to 1350 nm.

Chapter 1 Overview 7
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Table 3: Multimode fiber grades

Fiber mode Fiber grade Fiber diameter (μm) Modal bandwidth at 850 nm
(MHz*km)

Multimode fiber OM1 62.5/125 200

OM2 50/125 500

OM3 50/125 2000

OM4 50/125 4700

Other factors that influence the transmission distance of multimode fibers include interface type, central
wavelength, and fiber grade. The modal bandwidth values shown above are for the fiber grades listed. There
are multimode fibers that have different modal bandwidth characteristics and do not necessarily match the
OM1 - OM4 grades.

Table 4: Multimode fiber specifications

Interface types Central wavelength
(nm)

Fiber grade Transmission distance

1000BASE-SX 850 OM1 < 275 m (902.23 ft)

OM2 < 550 m (1804.46 ft)

10GBASE-SR 850 OM1 < 33 m (108.27 ft)

OM2 < 82 m (269.03 ft)

OM3 < 300 m (984.25 ft)

OM4 < 400m (1312.34 ft)

10GBASE-LRM 1310 OM1 < 220 m (721.78 ft)

OM2 < 220 m (721.78 ft)

OM3 < 220 m (721.78 ft)

OM4 < 220 m (721.78 ft)

SMF <300m (987.25 ft)

• Single-mode fibers

Single-mode fibers (SMFs) have a small core size, typically 9 μm or 10 μm, and can transmit light in only one
mode. Single-mode fibers suffer little intermodal dispersion and are suitable for long-haul communication.
Single-mode fibers transmit light at the central wavelength of 1310 nm or 1550 nm.

Telecommunication Industries Alliance (TIA)/Electronic Industries Alliance (EIA) defines that single-mode fibers
use yellow outer jackets with the mark "SM".

ITU defines single-mode fiber types in its G series standards. The most commonly used single-mode fibers are
defined in ITU G.652 and G.655 standards. The following table describes features of the G.652 and G.655-
compliant fibers.
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Table 5: Features of G.652- and G.655-compliant fibers

Single-mode fiber
type

Wavelength (nm) Features Applications

G.652-compliant
fiber (standard
single-mode fiber)

1260 to 1360

1530 to 1565

Zero dispersion at 1310 nm Connecting transceiver
modules with a central
wavelength of 1310 nm or
1550 nm.

G.655-compliant
fiber (non-zero
dispersion shifted
fiber)

1530 to 1565 Near-zero dispersion around
1550 nm

For 1550 nm wavelength-
division multiplexing (WDM)
transmissions.

Fiber diameter
Fiber diameter is expressed as core diameter/cladding diameter, in μm. For example, 9/125 μm means that the
fiber core diameter is 9 μm and the fiber cladding diameter is 125 μm.

For the HPE devices, the following fiber diameters are recommended:

• G.652 standard single-mode fiber: 9/125 μm

• G.655 non zero dispersion shifted single-mode fiber: 9/125 μm

• G.651 standard multimode fiber: 50/125 μm or 62.5/125 μm

Connector
CAUTION: Cover the connector with a dust cap when it is not connected to any optical fibers.

Connectors connect transceiver modules to the corresponding transmission media. The transceiver modules
available for Aruba products use the following types of connectors:

• Lucent connector or local connector (LC).

Single LC connectors (also known as Simplex) are typically used for 1G & 10G BiDi (Bidirectional) optics.

Dual LC connectors (Duplex) are typically used in normal optical types.

Chapter 1 Overview 9
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NOTE: 40G BiDi uses only Duplex fiber versus MPO (see below) for 40G SR4 applications.

Figure 1: LC connector (a simplex connector is shown)

• Multifiber Push On (MPO) connector.

Figure 2: MPO connector

The 40G QSFP+ MPO transceiver modules use only female MPO connectors, which have guide holes in the
end face of the MPO connector (the transceiver has guide pins within the MPO receptacle).

MPO connectors are classified as the following types based on the polish type:
◦ Physical contact (PC): End face polished flat.

◦ Angle-polished contact (APC): End face polished with an angle, typically 8°.

MPO connectors are available with 12 fibers or 24 fibers:
12-fiber MPO connector (40G, SR4, eSR4, and 100G SR4 transceivers use 8 of the available 12 fibers. The
four center fibers are unused. )

Figure 3: End face of a 12-fiber connector and channel assignment

MPO transceivers typically use four channels to communicate. These channels are assigned using the outer
eight fibers (the center four are unused).

Transmit channels are one set of four fibers, and the receive channels are on the other set of four fibers.
Because of this, the cables used and fiber cable connections from endpoint to endpoint effectively create a
crossover connection.

Be aware that using two crossover cables in series cancels this effect and no connection will be established.
An odd number of crossovers combined with straight-thru fiber connections will effect a crossover connection.

The channel layout indicates that the left four fibers are Transmit, and must reach the opposite transceiver
Receive channels (and in proper channel order).
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Optical parameters
This guide provides average transmit and receive power ranges for transceiver modules.

Transmit power

Transmit power is the power at which the transmitter of an optical transceiver module transmits optical signals, in
dBm.

Receive power

Receive power is the power at which the receiver of an optical transceiver module receives optical signals, in
dBm.

Use of attenuators

Transceivers are designed to transmit light pulses at a power level that accounts for loss in the fiber optic cabling,
and meets the receiver input thresholds of the link partner optical transceiver.

If you are using a fiber cable with less light loss than expected (for example, in a test environment and you do not
have a 40km spool of SMF available), use attenuators to affect the transmit level to within the receive sensitivity of
the other transceiver -- you will need to condition both fibers (sends in both directions). If not done, you risk
overdriving the Receive end and permanently damaging the transceiver. For example, a 40G ER4 has a highest
transmit level of 4.5dBm, but the Receive Sensitivity can be no higher than -4.5dBm. That means there must be at
least a 9dBm loss on the light level to be within the standards (4.5 - (-4.5) = 9dBm required).

Copper transceiver modules
Copper transceiver modules transmit signals over Category-5 unshielded twisted pair (UTP). UTP transmission
cover shorter distances than fiber transmission and can be used in small-sized networks only.

Copper transceivers are supported in 1G SFP and 10G SFP+ ports where listed in the Support Matrix tables.

Transmission distance
Through UTP cables, signals can be transmitted over a distance of 100 m (328.08 ft.) only. This behavior occurs
because signals attenuate during transmission through the UTP cables.

Attenuation refers to the dissipation of the power of a transmitted signal as it travels over a cable. Attenuation
occurs because signal transmission suffers certain resistance from the cable, which weakens the signals as they
travel over the cable. When signals are transmitted over a long distance, signal strength decreases significantly,
causing the signal-to-noise ratio to drop below the accepted level. This decrease makes it impossible to
distinguish between signals and noise, which results in data loss.

Patch panel and punch down blocks also affect attenuation; that is, they can be a source of issues resulting in
shorter distances or data loss.

10GBASE-T connections require Category 6a as a minimum for proper 10G speeds up to the 100m distance
dictated by the IEEE 802.3ae standard. Anything less (Cat 6, 5e, 5) will compromise the distance that 10G over
copper can achieve.

Shielded Twisted Pair (STP) Cat 6a cable is required for full support when using the 10GBase-T transceiver
(JL563A) supported only on the 8400 and 8320 switch models. Use of STP prevents EMI events from affecting
data traffic carried on the wire - known as Crosstalk or Alien Crosstalk. Large EMI events from electronically noisy
environments may be coupled onto unshielded cabling and cause temporary packet errors. Fixed 10G ports have
designs to counteract these types of bit error conditions, that the 10GBASE-T transceiver cannot counteract
consistently. Using STP Cat6a cables mitigate the errors significantly. All packet loss errors observed in extensive
testing are considered recoverable by the host system with the JL563A transceiver.
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Connector
Registered Jack-45 (RJ-45) twisted-pair connectors are used as connectors for copper transceiver modules.

Figure 4: RJ-45 connector

Table 6: RJ-45 GE connector pin assignment for Gigabit connections

Pin Signal Function

1 MX_0+ Data transmit/receive

2 MX_0- Data transmit/receive

3 MX_1+ Data transmit/receive

4 MX_2+ Data transmit/receive

5 MX_2- Data transmit/receive

6 MX_1- Data transmit/receive

7 MX_3+ Data transmit/receive

8 MX_3- Data transmit/receive

Identification of 4x4 part numbers
A SKU# may be fulfilled by two or more vendor parts providing similar functionality. A 4x4 part number is of the
form nnnn-nnnn and is on the transceiver or DAC label. For example, JL309A can have a 1990-4680 or
1990-4678 4x4 part number. 4x4 part numbers are referenced in the

• specification tables, to identify parts that support DOM (Digital Optical Monitoring) capabilities. (Some older
vendor parts do not support DOM.)

• compatibility tables, where necessary, to identify supported combinations of switch or module with the
identified transceiver, along with the minimum software version required.

In December 2017, Aruba introduced Revision D versions of 100M, 1G, and 10G products. Revision D products
are structured to be specific alternative vendors as sources for the SKU#. Earlier Revision A, B, or C product may
have alternative vendors that Aruba no longer actively ships, but remains as fully supported in specific switches.

Some switch products will specify Revision D transceivers for full support, while other products may support
earlier (older) revision transceivers – and some with specific 4x4 part numbers.
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Always refer to the Datasheet or QuickSpecs for the switch product to see the current list of supported
transceivers. Refer to the compatibility tables within this document to cross-reference the Transceiver/DAC
product against the switch product to identify the minimum software required for transceiver support.

To use CLI commands to display data for an installed transceiver, see the following examples.

8400X# show int 1/10/6 transceiver 
------------------------------------------------------------
Port      Type        Product   Serial          Part        
                      Number    Number          Number      
------------------------------------------------------------
1/10/6    QSFP+SR4    JH231A    XX57nnnnnn      1990-5555  
8400X# show int 1/10/6 dom
-------------------------------------------------------------------------------------------
Port      Type        Channel#  Temperature     Voltage         Tx Bias      Rx Power        Tx Power        
                                (Celsius)       (Volts)         (mA)         (mW/dBm)        (mW/dBm)        
-------------------------------------------------------------------------------------------
1/10/6    QSFP+SR4    1         26.00           3.32            6.72         0.02, -16.99    0.58, -2.37     
                      2         26.00           3.32            6.79         0.02, -16.99    0.59, -2.29     
                      3         26.00           3.32            6.68         0.03, -15.23    0.59, -2.29     
                      4         26.00           3.32            6.82         0.03, -15.23    0.60, -2.22 

Aruba-5406Rzl2# show interfaces transceiver f2 detail
Transceiver in F2
   Interface Index    : 162 
   Type               : QSFP+SR4        
   Model              : JH231A  
   Connector Type     : MPO                             
   Wavelength         : 850nm                           
   Transfer Distance  : 100m (50um OM3), 150m (50um OM4)                
   Diagnostic Support : DOM   
   Serial Number      : XX57nnnnnn      
 Status
   Temperature : 33.332C         
   Voltage     : 3.3208V     

            Tx Bias  Rx Power       Tx Power
  Channel#  (mA)     (mW/dbM)       (mW/dbM)     
  --------- -------- -------------- --------------
  1         6.904    0.5622, -2.501 0.5822, -2.349
  2         6.706    0.5922, -2.275 0.5856, -2.324
  3         6.894    0.6321, -1.992 0.5813, -2.356
  4         6.792    0.5111, -2.915 0.5651, -2.479
  Current Alarms:
    Channel 1 :  
       Tx bias low alarm                      
       Rx power low warning                  
    Channel 2 :  
       Tx bias low alarm                      
       Rx power low warning                  
  Current Errors:
    Channel 1 :  
       Rx Loss of Signal                     
    Channel 2 :  
       Rx Loss of Signal                     
    Channel 3 :  
       Rx Loss of Signal                     
    Channel 4 :  
       Rx Loss of Signal                
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QSFP28 optical transceiver modules that use MPO
connectors
See Chapter 1, "Overview", for information regarding MPO connectors and cable requirements.

Figure 5: QSFP28 optical transceiver module that use MPO connectors

Models and specifications
QSFP28 optical transceiver modules provide a transmission rate of 100 Gbps and use MPO connectors.

Table 7: Specifications for QSFP28 optical transceiver modules that use MPO connectors (1)

Product name
(SKU)

DOM - Digital
Optical
Monitoring
(4x4 part #)

Central wl
(nm)

Fiber
mode

Fiber
diameter
(µm)

Modal
bandwidth
(MHz*km)

Transmission
distance

Aruba 100G
QSFP28 MPO
SR4 100m 12-fiber
MPO MMF
Transceiver
(JL309A)

YES

(1990-4680,
1990-4678)

850 MMF 50/125 2000 (OM3)

4700 (OM4)

70 m (229.66 ft)

100 m (328.08 ft)

NOTE: SR4 is not supported for use over MMF OM1 or OM2 fiber. (The IEEE standard does not
state a specification.) Use MPO Female connectors with the MPO transceivers.

Chapter 2
QSFP28 modules
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Table 8: Specifications for QSFP28 optical transceiver modules that use MPO connectors (2)

Product name (SKU) Connector Optical parameters (dBm)

Transmit power Receive power

Aruba 100G QSFP28 MPO SR4
100m 12-fiber MPO MMF
Transceiver (JL309A)

MPO (PC polished, 12-fiber) -8.4 to +2.4 -10.3 to +2.4

Table 9: Compatibility for the QSFP28 optical transceiver modules that use MPO connectors.

Product name (SKU) Minimum software required Comments

Aruba 8400X 6p 40G/100G QSFP28 Adv
Module (JL366A)

10.00.0005 10.00.0005 provided 100G
product support.

10.00.0006 provides additional
support for 40G on the JL366A.

QSFP28 optical transceiver modules that use LC
connectors
Figure 6: QSFP28 optical transceiver module that use LC connectors

Models and specifications
QSFP28 optical transceiver modules provide a transmission rate of 100 Gbps and use LC connectors.

Table 10: Specifications for QSFP28 optical transceiver modules that use LC connectors (1)

Product name
(SKU)

DOM - Digital
Optical
Monitoring
(4x4 part #)

Central wl
(nm)

Fiber
mode

Fiber
diameter
(µm)

Modal
bandwidth
(MHz*km)

Transmission
distance

Aruba 100G
QSFP28 LC LR4
10km SMF 2-
strand Transceiver
(JL310A)

YES

(1990-4681)

Four lanes:

1294.53 ~
1296.59

1299.02 ~
1301.09

1303.54 ~
1305.63

1308.09 ~
1310.19

SMF 9/125 N/A 10 km (6.21 miles)
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Anexo 01 ITEM 14 (0592745)         SEI 0008478-63.2018.6.02.8000 / pg. 8243



Table 11: Specifications for QSFP28 optical transceiver modules that use LC connectors (2)

Product name (SKU) Connector Optical parameters (dBm)

Transmit power Receive power

Aruba 100G QSFP28 LC LR4 10km SMF 2-
strand Transceiver (JL310A)

LC -4.3 to +4.5 per lane -10.6 to +4.5 per
lane

Table 12: Compatibility for the QSFP28 optical transceiver modules that use LC connectors

Product name (SKU) Minimum software required Comments

Aruba 8400X 6p 40G/100G QSFP28 Adv
Module (JL366A)

10.00.0005 10.00.0005 provides support for
100G products.

10.00.0006 provides additional
support for 40G on the JL366A.

QSFP28 DAC (copper cables)
Figure 7: QSFP28 DAC (copper cable)

Models and specifications
Table 13: Specifications for QSFP28 copper cables

Product name (SKU) Cable length Data rate Description

Aruba 100G QSFP28 to QSFP28 3m Direct
Attach Copper Cable (JL307A)

3 m (9.8 ft) 100 Gbps Used for interconnecting
100-Gigabit QSFP28 ports
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Table 14: Compatibility for the QSFP28 copper cables

Product name (SKU) Minimum software required Comments

Aruba 8400X 6p 40G/100G QSFP28 Adv
Module (JL366A)

All

Chapter 2 QSFP28 modules 17
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QSFP+ optical transceiver modules that use MPO
connectors
See Chapter 1, " Overview", for information regarding MPO connectors and cable requirements.

Figure 8: QSFP+ optical transceiver module that uses MPO connectors

Models, specifications, and compatibility
QSFP+ optical transceiver modules provide a transmission rate of 40 Gbps and use MPO connectors.

NOTE: 40G SR4 and eSR4 are not supported for use over MMF OM1 or OM2 quality fiber. (The
IEEE standard does not state a specification). Use MPO female connectors for use with the MPO
transceivers.

Table 15: Specifications for QSFP+ optical transceiver modules that use MPO connectors (1)

Product name
(SKU)

DOM - Digital
Optical
Monitoring
(4x4 part #)

Central wl
(nm)

Fiber
mode

Fiber
diameter
(µm)

Modal
bandwidth
(MHz*km)

Transmission
distance

HPE X142 40G
QSFP+ MPO SR4
Transceiver
(JH231A)

YES

(1990-4554)

850 MMF 50/125 2000 (OM3)

4700 (OM4)

100 m (328.08 ft)

150 m (492.12 ft)

HPE X142 40G
QSFP+ MPO
eSR4 300M XCVR
(JH233A)

YES

(1990-4555)

850 MMF 50/125 2000 (OM3)

4700 (OM4)

300 m (984.25 ft)

400 m (1312.33 ft)

Chapter 3
QSFP+ modules

18 ArubaOS-Switch and ArubaOS-CX Transceiver Guide

Anexo 01 ITEM 14 (0592745)         SEI 0008478-63.2018.6.02.8000 / pg. 8246



Table 16: Specifications for QSFP+ optical transceiver modules that use MPO connectors (2)

Product name (SKU) Connector Optical parameters (dBm)

Transmit power Receive power

HPE X142 40G QSFP+ MPO
SR4 Transceiver (JH231A)

MPO (PC polished, 12-fiber) –7.6 to 0 –9.5 to +2.4

HPE X142 40G QSFP+ MPO
eSR4 300M XCVR (JH233A)

MPO (PC polished, 12-fiber) –7.6 to 0 –9.9 to +2.4

Table 17: Compatibility for the QSFP+ optical transceiver modules that use MPO connectors

Product name (SKU) Minimum software required Comments

Aruba 3810M/2930M 1QSFP+ 40GbE
Module (JL078A)

All

Aruba 3810M 24G 1-slot Switch 2QSFP
+ 40GbE Module (JL079A)

All

20p PoE+ / 1p 40GbE QSFP+ v3 zl2
Module (J9992A)

KB.15.17

2p 40GbE QSFP+ v3 zl2 Module
(J9996A)

KB.15.17

Aruba 8320 48p SFP/SFP+ & 6p 40G
QSFP+ Switch (JL479A)

10.00.0006

Aruba 8320 32p 40G QSFP+ Switch
(JL579A)

10.00.0012

Aruba 8400X 8p 40G QSFP+ Adv Module
(JL365A)

All

Aruba 8400X 6p 40G/100G QSFP28 Adv
Module (JL366A)

10.00.0006 10.00.0005 supports 100G
products.

10.00.0006 provides additional
support for 40G on the JL366A.

QSFP+ optical transceiver modules that use LC
connectors
Figure 9: QSFP+optical transceiver module that uses LC connectors
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Models, specifications, and compatibility
QSFP+ optical transceiver modules provide a transmission rate of 40 Gbps and use LC connectors.

Table 18: Specifications for QSFP+ transceiver modules that use LC connectors (1)

Product name
(SKU)

DOM - Digital
Optical
Monitoring
(4x4)

Central wl
(nm)

Fiber
mode

Fiber
diameter
(µm)

Modal
bandwidth
(MHz*km)

Transmission
distance

Aruba 40G QSFP+
LC BiDi 150m
MMF Transceiver
(JL308A)

YES

(1990-4679)

Dual
20Gb/s:

• 850

• 900

MMF 50/125 2000 (OM3)

4700 (OM4)

100 m (328.08 ft)

150 m (492.12 ft)

Not supported on
OM1/OM2.

HPE X142 40G
QSFP+ LC LR4
SM Transceiver
(JH232A)

YES

(1990-4556)

Four
lanes:

• 1271

• 1291

• 1311

• 1331

SMF 9/125 N/A 10 km (6.21 miles)

Aruba 40G QSFP+
LC ER4 40km
SMF XCVR
(Q9G82A)

YES

(1990-4734)

Four
lanes:

• 1271

• 1291

• 1311

• 1331

SMF 9/125 N/A 40km (24.86 miles)

Table 19: Specifications for QSFP+ transceiver modules that use LC connectors (2)

Product name (SKU) Optical parameters (dBm)

Transmit power Receive power

Aruba 40G QSFP+ LC BiDi 150m MMF Transceiver
(JL308A)

–4 to +5 –6 to +5

HPE X142 40G QSFP+ LC LR4 SM Transceiver
(JH232A)

–7 to +2.3 per lane –13.7 to +2.3 per lane

Aruba 40G QSFP+ LC ER4 40km SMF XCVR
(Q9G82A)

-2.7 to 4.5 dBm -21.2 to -4.5 dBm

(Use attenuators to match
power levels.)

20 ArubaOS-Switch and ArubaOS-CX Transceiver Guide

Anexo 01 ITEM 14 (0592745)         SEI 0008478-63.2018.6.02.8000 / pg. 8248



Table 20: Compatibility for the QSFP+ optical transceiver modules that use LC connectors

Product name (SKU) Minimum software required Comments

Aruba 3810M/2930M 1QSFP+ 40GbE
Module (JL078A)

For JH232A: all

For JL308A: KB.16.04.0008 or
WC.16.04.0008

Q9G82A not supported.

Aruba 3810M 2QSFP+ 40GbE Module
(JL079A)

For JH232A: all

For JL308A: KB.16.04.0008

Q9G82A not supported.

The JL079A module is not
supported in the 2930M series
nor on the 3810M 16SFP+ 2-slot
switch (JL075A).

20p PoE+ / 1p 40GbE QSFP+ v3 zl2
Module (J9992A)

For JH232A: KB.15.17

For JL308A: KB.16.04.0008

Q9G82A not supported.

2p 40GbE QSFP+ v3 zl2 Module
(J9996A)

For JH232A: KB.15.17

For JL308A: KB.16.04.0008

Q9G82A not supported.

Aruba 8320 48p SFP/SFP+ & 6p 40G
QSFP+ Switch (JL479A)

For JH232A: 10.00.0006

For JL308A: 10.00.0006

For Q9G82A: 10.00.0018

Aruba 8320 32p 40G QSFP+ Switch
(JL579A)

For JH232A: 10.00.0012

For JL308A: 10.00.0012

For Q9G82A: 10.00.0018

Aruba 8400X 8p 40G QSFP+ Adv Module
(JL365A)

For JH232A: all

For JL308A: all

For Q9G82A: 10.00.0018

Aruba 8400X 6p 40G/100G QSFP28 Adv
Module (JL366A)

For JH232A: 10.00.0006

For JL308A: 10.00.0006

For Q9G82A: 10.00.0018

10.00.0005 provides support for
100G products.

10.00.0006 provides additional
support for 40G on the JL366A.
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QSFP+ DAC (copper cables)
Figure 10: QSFP+ DAC copper cables

IMPORTANT: Direct Attach over Copper (DAC) cables have a minimum bend radius of typically 4x
the diameter of the cable (approximately a 1" bend radius). Handle DAC cables carefully to ensure
that you do not crimp or bend the cable beyond a 1" radius. Otherwise, you risk damaging the cable.

Models, specifications, and compatibility
Table 21: Specifications for QSFP+ copper cables

Product name (SKU) Cable length Data rate Description

HPE X242 40G QSFP+ to QSFP+ 1m DAC
Cable (JH234A)

1 m (3.28 ft)

40 Gbps Used for interconnecting
40-Gigabit QSFP+ ports

HPE X242 40G QSFP+ to QSFP+ 3m DAC
Cable (JH235A)

3 m (9.84 ft)

HPE X242 40G QSFP+ to QSFP+ 5m DAC
Cable (JH236A)

5 m (16.40 ft)

Table 22: Compatibility for the QSFP+ copper cables

Product name (SKU) Minimum software required Comments

Aruba 3810M/2930M 1QSFP+ 40GbE
Module (JL078A)

All

Aruba 3810M 2QSFP+ 40GbE Module
(JL079A)

All The JL079A module is not
supported in the 2930M
series nor on the 3810M
16SFP+ 2-slot Switch
(JL075A).

20p PoE+ / 1p 40GbE QSFP+ v3 zl2
Module (J9992A)

KB.15.17

Table Continued
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Product name (SKU) Minimum software required Comments

2p 40GbE QSFP+ v3 zl2 Module
(J9996A)

KB.15.17

Aruba 8320 48p 10G SFP/SFP+ and 6p
40G QSFP+ Switch (JL479A)

All

Aruba 8320 32p 40G QSFP+ Switch
(JL579A)

10.00.0012

Aruba 8400X 8p 40G QSFP+ Adv Module
(JL365A)

All

Aruba 8400X 6p 40G/100G QSFP28 Adv
Module (JL366A)

10.00.0006
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SFP+ optical transceiver modules
In December, 2017, Aruba introduced Revision D versions of 100M, 1G, and 10G transceivers. Revision D
products are structured to be specific alternate vendors as sources for the SKU#. Earlier Revision A, B, or C
product may have alternate vendors that we no longer actively ship, but remain as fully supported in earlier and
current products.

Some switch products will be specifying Revision D transceivers for full support, while other products may support
earlier (older) revision transceivers – and some with specific 4x4 part numbers (see Chapter 1, "Overview", for
information regarding 4x4 part numbers).

Always refer to the Datasheet or QuickSpecs for the Switch product to see the current list of supported
transceivers.

Figure 11: SFP+ optical transceiver modules

NOTE: 

• Although a 10G SFP+ transceiver module is the same physical dimensions of a 1G SFP
transceiver, a 10G transceiver will NOT operate in a 1G SFP port.

• Many, although not all, 10G SFP+ ports have support to use a 1G SFP transceiver (or even a
100Mbps FX SFP transceiver).

See the QuickSpec for the Switch product and verify if the 1G or 100Mbps SFP transceiver is
supported in the 10G SFP+ port.

Models, specifications, and compatibility
SFP+ optical transceiver modules provide a transmission rate of 10.31 Gbps and use LC connectors.

The specifications for Revision D transceiver products are the same as the specified Revision A, B, C SKUs.
Where support for a Revision A, B, or C transceiver existed, Revision D parts are also supported.

Chapter 4
SFP+ modules
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Table 23: Specifications for SFP+ optical transceiver modules (1)

Product Name
(SKU)

DOM - Digital
Optical
Monitoring
(4x4 part #)

Central
we (nm)

Fiber
mode

Fiber
diameter
(µm)

Bandwidth
(MHz*km)

Transmission
distance

HPE X132 10G
SFP+ LC SR
Transceiver
(J9150A)

Aruba 10G SFP+
LC SR 300m MMF
XCVR (J9150D)

Yes

(1990-4391,

1990-4175)

850 MMF 50/125 4700 (OM4)

2000 (OM3)

500 (OM2)

400

400 m (1312.34 ft)

300 m (984.25 ft)

82 m (269.03 ft)

66 m (216.54 ft)

62.5/125 200 (OM1)

160

33 m (108.27 ft)

26 m (85.30 ft)

HPE X132 10G
SFP+ LC LRM
Transceiver
(J9152A)

Aruba 10G SFP+
LC LRM 220m
MMF XCVR
(J9152D)

Yes

(1990-4485)

1310 MMF 50/125 1500

500 (OM2)

400

220 m (721.78 ft)

220 m (721.78 ft)

100 m (328.08 ft)

62.5/125 200 (OM1)

160

220 m (721.78 ft)

220 m (721.78 ft)

SMF 9/125 N/A 300m (987.25 ft)

HPE X132 10G
SFP+ LC LR
Transceiver
(J9151A)

Aruba 10G SFP+
LC LR 10km SMF
XCVR (J9151D)

Yes

(1990-4657,

1990-4694)

1310 SMF 9/125 N/A 10 km (6.21 miles)

HPE X132 10G
SFP+ LC ER
Transceiver
(J9153A)

Aruba 10G SFP+
LC ER 40km SMF
XCVR (J9153D)

Yes

(1990-4365,

1990-4656)

1550 SMF 9/125 N/A 40 km (24.86
miles)

NOTE: A mode conditioning patch cord is required when you use OM1 or OM2 fiber types on a 10G
LRM Transceiver (J9152A/J9152D). Never use mode conditioning patch cords for OM3 or OM4 fiber
types. For more information about mode conditioning patch cords, see related parts in the IEEE
802.3 standard.
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Table 24: Specifications for SFP+ optical transceiver modules (2)

Product name (SKU) Optical parameters (dBm)

Transmit power Receive power

HPE X132 10G SFP+ LC SR Transceiver (J9150A)

Aruba 10G SFP+ LC SR 300m MMF XCVR (J9150D)

–7.3 to –1 –9.9 to +0.5

HPE X132 10G SFP+ LC LRM Transceiver (J9152A)

Aruba 10G SFP+ LC LRM 220m MMF XCVR (J9152D)

–6.5 to +0.5 –6.5 to +1.5

HPE X132 10G SFP+ LC LR Transceiver (J9151A)

Aruba 10G SFP+ LC LR 10km SMF XCVR (J9151D)

–8.2 to +0.5 –14.4 to +0.5

HPE X132 10G SFP+ LC ER Transceiver (J9153A)

Aruba 10G SFP+ LC ER 40km SMF XCVR (J9153D)

–4.7 to +4 –15.8 to –1

Table 25: Compatibility for the SFP+ optical transceiver module

Product name SKU Minimum software required Comments

10G-SR, LR, LRM
(J9150A/J9150D,
J9151A/J9151D,
J9152A/J9152D)

10G-ER (J9153A/
J9153D)

1850 Switch Series JL169A J9150A/J9150D: All

J9151A/J9151D: All

J9152A/J9152D: All

J9153A/J9153D is
not supported on the
1850 Switch Series.

Unlisted models do not
have SFP+ ports.

2530 Switch Series J9853A

J9854A

J9855A

J9856A

All All Unlisted models do not
have SFP+ ports.

2540 Switch Series JL354A

JL355A

JL356A

JL357A

All (J9150A/J9150D
and J9151A/J9151D
only)

J9152A/J9152D
(LRM) is not
supported in any 2540
model

All J9152A/J9152D (LRM)
is not supported in any
2540 model.

2910al Switch Series J9008A All W.15.07.0002 Unlisted models do not
have SFP+ ports.

Table Continued
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Product name SKU Minimum software required Comments

10G-SR, LR, LRM
(J9150A/J9150D,
J9151A/J9151D,
J9152A/J9152D)

10G-ER (J9153A/
J9153D)

2920 Switch Series J9726A

J9727A

J9728A

J9729A

J9836A

All For use in an installed
J9731A Aruba 2920 2-
port 10GbE SFP+
Module.

2930F Switch Series JL253A

JL254A

JL255A

JL256A

JL258A

JL263A

JL264A

JL558A

JL559A

All (J9150A/J9150D
and J9151A/J9151D
only)

J9152A/J9152D
(LRM) is not
supported in any
2930F model

All Unlisted models do not
have SFP+ ports.

J9152A/J9152D (or
any 10G LRM
technology) is not
supported in any
2930F model.

2930M Switch Series JL319A

JL320A

JL321A

JL322A

JL323A

JL324A

All All For use in an installed
JL083A Aruba 3810M/
2930M 4SFP+
MACsec Module.

3500yl Switch Series J8692A

J8693A

J9310A

J9311A

K.14.50 and later K.15.02.0004 and
later

For use in an installed
J9312A 10GbE 2-port
SFP+/2-port CX4 yl
Module.

3800 Switch Series J9575A

J9576A

J9573A

J9574A

J9584A

All All Unlisted models do not
have SFP+ ports.

Table Continued
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Product name SKU Minimum software required Comments

10G-SR, LR, LRM
(J9150A/J9150D,
J9151A/J9151D,
J9152A/J9152D)

10G-ER (J9153A/
J9153D)

3810M Switch Series JL071A

JL072A

JL073A

JL074A

JL076A

All All For use in an installed
JL083A Aruba 3810M/
2930M 4SFP+
MACsec Module

JL075A All All For use in the JL075A
SFP+ ports or in an
installed JL083A
Aruba 3810M/2930M
4SFP+ MACsec
Module

5400zl Switch Series J9309A K.14.39 K.15.02.0004

J9538A

J9548A

J9536A

K.15.02.0004 K.15.02.0004

5400R Switch Series J9538A

J9548A

J9536A

All All

J9990A

J9993A

KB.15.17 KB.15.17

6120 Switch Series 516733-
B21
(6120XG)

All (not supported) 498358-B21
(6120G/XG) has 1GB
SFP and 10G XFP or
CX4 ports and does
not support these SFP
+ transceivers

6200yl Switch Series J8992A K.14.50 K.15.02.0004 J8992A fixed SFP
ports are 1GB and do
not support these SFP
+ transceivers

For use in an installed
J9312A 10GbE 2-port
SFP+/2-port CX4 yl
Module

6600 Switch Series J9264A

J9265A

K.14.03 K.15.02.0004

Table Continued
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Product name SKU Minimum software required Comments

10G-SR, LR, LRM
(J9150A/J9150D,
J9151A/J9151D,
J9152A/J9152D)

10G-ER (J9153A/
J9153D)

J9452A K.14.24 K.15.02.0004

8200zl Switch Series J9309A K.14.39 K.15.02.0004

J9538A

J9548A

J9536A

K.15.02.0004 K.15.02.0004

Aruba 8320 48p 10G
SFP/SFP+ and 6p 40G
QSFP+ Switch

JL479A All (J9150A/J9150D
and J9151A/J9151D
only)

J9152A/J9152D
(LRM) is not
supported in the 8320
switches

All Only the following 4x4
part numbers are
supported:

• J9150A/J9150D:
1990-4391, 1990-4175

• J9151A/J9151D:
1990-4657,
1990-4727, 1990-4694

• J9153A/J9153D:
1990-4365, 1990-4656

J9152A/J9152D (or
any 10G LRM
technology) is not
supported in the 8320
Switches

Aruba 8400X 32p 10G
SFP/SFP+ Msec Module

JL363A All All Only the following 4x4
part numbers are
supported:
• J9150A/J9150D:

1990-4391,
1990-4175

• J9151A/J9151D:
1990-4657,
1990-4727,
1990-4694

• J9152A/J9152D:
1990-4485

• J9153A/J9153D:
1990-4365,
1990-4656

NOTE: A mode conditioning patch cord is required when you use OM1 or OM2 fiber types on a10G
LRM Transceiver. Never use mode conditioning patch cords for OM3 or OM4 fiber types. For more
information about mode conditioning patch cords, see related parts in the IEEE 802.3 standard.
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10G SFP+ copper transceiver modules
Figure 12: 10G SFP+ copper transceiver module

Models, specifications, and compatibility
Table 26: Specifications for SFP+ copper transceiver modules

Product name (SKU) Transmission
distance

Data rate Cable type Connector
type

Aruba 10GBASE-T SFP+ RJ45 30m
Cat6A XCVR (JL563A)

30 m (98.43 ft) 10G STP Cat6A 1 RJ-45

1 See Transmission distance on page 11.

Table 27: Compatibility for SFP+ copper transceiver modules

Product name SKU Minimum software
required (JL563A)

Comments

Aruba 8320 48p 10G SFP/SFP+
and 6p 40G QSFP+ Switch

JL479A 10.01.0011 The JL563A transceiver does
NOT support 1G operation;
only 10G.

Aruba 8400X 32p 10G SFP/SFP+
Msec Module

JL363A 10.00.0018

SFP+ DAC cables
Figure 13: SFP+ DAC cable

IMPORTANT: Direct Attach over Copper (DAC) cables have a minimum bend radius of typically 4x
the diameter of the cable (approximately a 1" bend radius). Handle DAC cables carefully to ensure
that you do not crimp or bend the cable beyond a 1" radius, otherwise, you risk damaging the cable.
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Models, specifications, and compatibility
The specifications for Revision D transceiver products are the same as the specified Revision A, B, and C SKUs.
Where support for a Revision A, B, or C transceiver existed, Revision D parts are also supported.

Table 28: Specifications for SFP+ DAC cables

Product name (SKU) Cable length Data rate Type

HPE X242 10G SFP+ to SFP+ 1m DAC Cable (J9281B)

Aruba 10G SFP+ to SFP+ 1m DAC Cable (J9281D)

1 m (3.28 ft)

10.31 Gbps SFP+ cable
HPE X242 10G SFP+ to SFP+ 3m DAC Cable (J9283B)

Aruba 10G SFP+ to SFP+ 3m DAC Cable (J9283D)

3 m (9.84 ft)

HPE X242 10G SFP+ to SFP+ 7m DAC Cable (J9285B)

Aruba 10G SFP+ to SFP+ 7m DAC Cable (J9285D)

7 m (22.97 ft)

Table 29: Compatibility for the SFP+ copper cables

Product name SKU Minimum software required
(J9281B/J9281D, J9283B/J9283D,
J9285B/J9285D)

Comments

1850 Switch Series JL169A All Unlisted models do not have
SFP+ ports.

2530 Switch Series J9853A

J9854A

J9855A

J9856A

All Unlisted models do not have
SFP+ ports.

2540 Switch Series JL354A

JL355A

JL356A

JL357A

All (J9281B/J9281D and J9283B/
J9283D only. See comments for
exception)

J9285B/J9285D or any type
of 7m DAC are not supported
in any of these series

2910al Switch Series J9145A

J9146A

J9147A

J9148A

W.14.28 For use in the J9008A 2-port
10GbE SFP+ al module.

2920 Switch Series J9726A

J9727A

J9728A

J9729A

J9836A

All The SFP ports on the models
listed do not support these
10G SFP+ cables. For use in
an installed J9731A Aruba
2920 2-port 10GbE SFP+ .

Table Continued
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Product name SKU Minimum software required
(J9281B/J9281D, J9283B/J9283D,
J9285B/J9285D)

Comments

2930F Switch Series JL253A

JL254A

JL255A

JL256A

JL258A

JL263A

JL264A

JL558A

JL559A

All (J9281B/J9281D and J9283B/
J9283D only. See comment for
exception)

Unlisted models do not have
10G SFP+ ports.

J9285B/J9285D or any type
of 7m DAC are not supported
in any of these series.

2930M Switch Series JL319A

JL320A

JL321A

JL322A

JL323A

JL324A

All For use in an installed
JL083A Aruba 3810M/2930M
4SFP+ MACsec Module

J9285B/9285D (7m DAC) is
supported in all 2930M
models.

3500yl Switch Series J8692A

J8693A

J9310A

J9311A

K.14.50 For use in an installed
J9312A 10GbE 2-port SFP
+/2-port CX4 yl Module.

3800 Switch Series J9575A

J9576A

J9573A

J9574A

J9584A

All Unlisted models not do not
have SFP+ ports.

3810M Switch Series JL071A

JL072A

JL073A

JL074A

JL076A

All For use in an installed
JL083A Aruba 3810M/2930M
4SFP+ MACsec Module.

JL075A All For use in the JL075A SFP+
ports or used in an installed
JL083A Aruba 3810M/2930M
4SFP+ MACsec Module.

5400zl Switch Series J9309A K.14.39

Table Continued
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Product name SKU Minimum software required
(J9281B/J9281D, J9283B/J9283D,
J9285B/J9285D)

Comments

J9538A

J9548A

J9536A

K.15.02.0004

5400R Switch Series J9538A

J9548A

J9536A

All

J9990A

J9993A

KB.15.17

6120 Switch Series 516733-B21 All

6200yl Switch Series J8992A K.14.50 J8992A fixed SFP ports are
1GB and do not support
these SFP+ copper
cables.For use in an installed
J9312A 10GbE 2-port SFP
+/2-port CX4 yl Module.

6600 Switch Series J9264A

J9265A

J9452A

K.14.32

8200zl Switch Series J9309A K.14.39

J9538A

J9548A

J9536A

K.15.02.0004

Table Continued
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Product name SKU Minimum software required
(J9281B/J9281D, J9283B/J9283D,
J9285B/J9285D)

Comments

Aruba 8320 48p 10G
SFP/SFP+ and 6p
40G QSFP+ Switch

JL479A All (J9281B/J9281D and J9283B/
J9283D only. See comment for
exception.)

Only the following 4x4 part
numbers are supported:

• J9281B/J9281D: 8121-1151,
8121-1300

• J9283B/J9283D: 8121-1152,
8121-1298

J9285B/J9285D or any type
of 7m DAC are not supported
in the JL479A 8320 model.

Aruba 8400X 32p 10G
SFP/SFP+ Msec
Module

JL363A All Only the following 4x4 part
numbers are supported:
• J9281B/J9281D:

8121-1151, 8121-1300

• J9283B/9283D:
8121-1152, 8121-1298

• J9285B/J9285D:
8121-1154, 8121-1305
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Gigabit SFP optical transceiver modules
In December 2017, Aruba introduced Revision D versions of 100M, 1G, and 10G transceivers. Revision D
products are structured to be specific alternative vendors as sources for the SKU#. Earlier Revision A, B, or C
product may have alternative vendors that we no longer actively ship, but remain as fully supported in earlier and
current products.

Some switch products will be specifying Revision D transceivers for full support, while other products may support
earlier (older) revision transceivers – and some with specific 4x4 part numbers (see Chapter 1, "Overview" for
information regarding 4x4 part numbers).

Always refer to the Datasheet or QuickSpecs for the Switch product to see the current list of supported
transceivers.

Figure 14: Gigabit or 100-Megabit SFP optical transceiver module

NOTE: 

• Although a 10G SFP+ transceiver module has the same physical dimensions of a 1G SFP
transceiver, a 10G transceiver will NOT operate in a 1G SFP port.

• Many, although not all, 10G SFP+ ports have support to use a 1G SFP transceiver (or even a
100Mbps FX SFP transceiver). See the QuickSpec for the Switch product and verify if the 1G or
100Mbps SFP transceiver is supported in the 10G SFP+ port.

Models, specifications, and compatibility
Gigabit SFP optical transceiver modules use LC connectors.

The specifications for Revision D transceiver products are the same as the specified Revision A, B, and C SKUs.
Where support for a Revision A, B, or C transceiver existed, Revision D parts are also supported.

Chapter 5
SFP modules
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Table 30: Specifications for Gigabit SFP optical transceiver modules (1)

Product name
(SKU)

DOM - Digital
Optical
Monitoring
(4x4 part #)

Central wl
(nm)

Fiber
mode

Fiber
diameter
(µm)

Modal
bandwidth
(MHz*km)

Transmission
distance

HPE X121 1G SFP
LC SX Transceiver
(J4858C)

Aruba 1G SFP LC
SX 500m MMF
XCVR (J4858D)

Yes

(1990-4395 &
1990-4415)

850 MMF 50/125 500 (OM2)

400

550 m (1804.46 ft)

500 m (1640.42 ft)

62.5/125 200 (OM1)

160

275 m (902.23 ft)

220 m (721.78 ft)

HPE X121 1G SFP
LC LX Transceiver
(J4859C)

Aruba 1G SFP LC
LX 10km SMF
XCVR (J4859D)

Yes

(1990-4116,
1990-4414, &
1990-4608)

1310 SMF 9/125 N/A 10 km (6.21 miles)

MMF 50/125 500 or 400 550 m (1804.46 ft)

MMF 62.5/125 500 550 m (1804.46 ft)

HPE X121 1G SFP
LC LH Transceiver
(J4860C)

Aruba 1G SFP LC
LH 70km SMF
XCVR (J4860D)

Yes

(1990-4363)

1550 SMF 9/125 N/A 70 km (43.49
miles)

Table 31: Specifications for Gigabit SFP optical transceiver modules (2)

Product name (SKU) Optical parameters (dBm)

Transmit power Receive power

HPE X121 1G SFP LC SX Transceiver (J4858C)

Aruba 1G SFP LC SX 500m MMF XCVR (J4858D)

–9.5 to 0 –17 to –3

HPE X121 1G SFP LC LX Transceiver (J4859C)

Aruba 1G SFP LC LX 10km SMF XCVR (J4859D)

–9.5 to –3 –20 to –3

HPE X121 1G SFP LC LH Transceiver (J4860C)

Aruba 1G SFP LC LH 70km SMF XCVR (J4860D)

0 to +5 –22 to –3
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Table 32: Compatibility for Gigabit SFP optical transceiver modules

Product name SKU Minimum software required
(J4858C/J4858D, J4859C/J4859D,
J4860C/J4860D)

Comments

1400 Switch Series J9078A All

1410 Switch Series J9561A All

1700 Switch Series J9080A VB.01.09

1800 Switch Series J9028A/B PB.02.09

1810 Switch Series J9450A

J9660A

J4858C/J4858D: All

J4859C/J4859D: All

Gig LH (J4850C/
J4860D) is supported
only in the J9450A
model.

J9801A

J9803A

J9834A

J4858C/J4858D: All

J4859C/J4859D: All

Gig LH (J4860C/
J4860D) is not
supported.

1820 Switch Series J9980A

J9981A

J9983A

J9984A

J4858C/J4858D: All

J4859C/J4859D: All

J4860C/J4860D: Not supported

Gig LH (J4860C/
J4860D) is not
supported on the 1820
series.

1850 Switch Series JL169A J4858C/JL4858D: All

J4859C/J4859D: All

J4860C/J4860D: Not supported

Gig LH (J4860C/
J4860D) is not
supported on the 1850
series. Other 1850
models not listed do not
have SFP ports.

1920S JL381A

JL382A

JL384A

JL385A

JL386A

J4858C/J4858D: All

J4859C/J4859D: All

J4860C/J4860D: Not supported

Gig LH (J4860C/
J4860D) is not
supported on the 1920S
series.

Models JL380A and
JL383A do not include
SFP ports.

2510 Switch Series J9019A/B

J9020A

J9279A

J9280A

All

2520 Switch Series J9137A

J9138A

J9298A

J9299A

All

Table Continued
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Product name SKU Minimum software required
(J4858C/J4858D, J4859C/J4859D,
J4860C/J4860D)

Comments

2530 Switch Series J9772A

J9773A

J9774A

J9775A

J9776A

J9777A

J9778A

J9779A

J9780A

J9781A

J9782A

J9783A

J9853A

J9854A

J9855A

J9856A

All

2540 Switch Series JL354A

JL355A

JL356A

JL357A

All

2600 Switch Series J4899A/B/C

J4900A/B/C

J8164A

J8165A

J8762A

H.08.98

2610 Switch Series J9085A

J9086A

J9087A

J9088A

J9089A

All

2615-8-PoE Switch J9565A All

Table Continued
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Product name SKU Minimum software required
(J4858C/J4858D, J4859C/J4859D,
J4860C/J4860D)

Comments

2620 Switch Series J9623A

J9624A

J9625A

J9626A

J9627A

All

2800 Switch Series J4903A

J4904A

i.08.103

2810 Switch Series J9021A

J9022A

All

2900 Switch Series J9049A

J9050A

T.13.45

2910al Switch Series J9145A

J9146A

J9147A

J9148A

All For use in the SFP ports
on the models listed, and
in the J9008A 2-port
10GbE SFP+ al module.

2915-8G-PoE Switch J9562A All

2920 Series Switches J9726A

J9727A

J9728A

J9729A

J9836A

All For use in the SFP ports
on the models listed.
Also for use in the dual-
speed SFP+ ports of the
J9731A 2-Port 10GbE
SFP+ Module.

Table Continued
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Product name SKU Minimum software required
(J4858C/J4858D, J4859C/J4859D,
J4860C/J4860D)

Comments

2930F Series Switches JL253A

JL254A

JL255A

JL256A

JL258A

JL259A

JL260A

JL261A

JL262A

JL263A

JL264A

JL557A

JL558A

JL559A

All

2930M Switch Series JL319A

JL320A

JL321A

JL322A

JL323A

JL324A

All For use in SFP ports on
switch and an installed
JL083A Aruba 3810M/
2930M 4SFP+ MACsec
Module.

3400cl Switch Series J4905A

J4906A

All

3500 Series Switches J9470A

J9471A

J9472A

J9473A

K.14.31

3500yl Switch Series J8692A

J8693A

All For use in the SFP ports
on the models listed, and
in an installed J9312A
10GbE 2-port SFP+/2-
port CX4 yl Model

J9310A

J9311A

K.14.50

Table Continued
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Product name SKU Minimum software required
(J4858C/J4858D, J4859C/J4859D,
J4860C/J4860D)

Comments

3800 Switch Series J9573A

J9574A

J9575A

J9576A

J9584A

All

3810M Switch Series JL071A

JL072A

JL073A

JL074A

JL076A

JL075A

All For use in the JL075A
3810M switch. Also for
use in any 3810M switch
with a JL083A Aruba
3810M/2930M 4SFP+
MACsec Module
installed.

4200gl Switch Series J4893A

J4908A

G.07.103

4200vl Switch Series J8776A

J9033A

All

5300xl Switch Series J4878A/B

J4907A

E.10.36

5400zl Switch Series J8705A

J8706A

All

J9308A K.14.34

J9537A

J9549A

J9535A

J9637A

J9538A

J9548A

J9536A

K.15.02.0004

Table Continued
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Product name SKU Minimum software required
(J4858C/J4858D, J4859C/J4859D,
J4860C/J4860D)

Comments

5400R Switch Series J9537A

J9549A

J9535A

J9637A

J9538A

J9548A

J9536A

All

J9988A

J9989A

J9990A

J9993A

KB.15.17

6108 Switch J4902A H.07.88

6120 Switch Series 498358-B21

516733-B21

SX, LX: all versions

LH: not supported

6200yl-24G-mGBIC Switch J8992A All

6600 Switch Series J9263A

J9264A

K.14.03

J9451A K.14.24

8100fl Switch J8735A All

8200zl Switch Series J8705A

J8706A

All

J9308A K.14.34

J9537A

J9549A

J9535A

J9637A

J9538A

J9548A

J9536A

K.15.02.0004

Table Continued
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Product name SKU Minimum software required
(J4858C/J4858D, J4859C/J4859D,
J4860C/J4860D)

Comments

Aruba 8320 48p 10G
SFP/SFP+ and 6p 40G QSFP
+ Switch

JL479A All Only the following 4x4
part numbers are
supported:

• J4858C/J4858D:
1990-4395, 1990-4415

• J4859C/J4859D:
1990-4116, 1990-4414

• J4860C/J4860D:
1990-4363

Aruba 8400X 32p 10G
SFP/SFP+ Msec Module

JL363A All Only the following 4x4
part numbers are
supported:
• • J4858C/J4858D:

1990-4395,
1990-4415

• • J4859C/J4859D:
1990-4116,
1990-4414

• • J4860C/J4860D:
1990-4363

9300m Switch Series J4885A

J4894A

All

9408sl Switch J8684A All

100-Megabit SFP optical transceiver modules
Figure 15: Gigabit or 100-Megabit SFP optical transceiver module

Models, specifications, and compatibility
100 Megabit SFP optical transceiver modules use LC connectors.

The specifications for Revision D transceiver products are the same as the specified Revision A, B, and C SKUs.
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Table 33: Specifications for 100-Megabit SFP optical transceiver modules (1)

Product name (SKU) DOM - Digital
Optical
Monitoring (4x4
part #)

Central wl
(nm)

Fiber
mode

Fiber diameter
(µm)

Transmission
distance

HPE X111 100M SFP
LC FX Transceiver
(J9054C)

Aruba 100M SFP LC
FX 2km MMF XCVR
(J9054D)

Yes

(1990-4483,
1990-4360)

1310 MMF 50/125

62.5/125

2 km (1.24 miles)

Table 34: Specifications for 100–Megabit SFP optical transceiver modules (2)

Product name (SKU) Optical parameters (dBm)

Transmit power Receive power

HPE X111 100M SFP LC FX Transceiver
(J9054C)

Aruba 100M SFP LC FX 2km MMF XCVR
(J9054D)

–19 to –14 –30 to –14

Table 35: Compatibility for the 100-Megabit SFP optical transceiver module

Product name SKU Minimum software required Comments

1410G Switch Series J9559A

J9560A

J9561A

J9559A, J9560A: Not supported (no
SFP ports)

J9561A: All

For use in the SFP ports of the
J9561A 1410-24G Switch

1810G Series
Switches

J9450A

J9660A

For J9450A, J9660A: All For use in the SFP ports of the
J9450A 1810G-24 Switch and
J9660A V1810-48G Switch. (The
J9449A 1810G-8 Switch does not
have SFP ports.)

1810G v2 Switch
Series

J9801A

J9803A

All For use in the SFP ports of the
J9801A 1810-24 v2 and J9803A
1810-24G v2 Switches

PS1810 Switch J9834A All For use in the SFP ports of the
J9834A PS1810-24G Switch

Table Continued
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Product name SKU Minimum software required Comments

1820 Switch Series J9980A

J9981A

J9983A

J9984A

All The J9054B 100-FX SFP-LC
transceiver is not supported in the
1820G switches

The J9054C part number
1990-4483 is not supported in
these products.

(Only the J9054C/J9054D part
number 1990-4360 is supported.)

2510-24 Switch J9019A/B Q.10.04

2510-48 Switch J9020A All

2510G Switch Series J9279A

J9280A

All

2520 Switch Series J9137A

J9138A

All

2520G Switch Series J9298A

J9299A

J9054B: All

J9054C: J.14.32

2530 Switch Series J9772A

J9773A

J9774A

J9775A

J9776A

J9777A

J9778A

J9779A

J9780A

J9781A

J9782A

J9783A

J9853A

J9854A

J9855A

J9856A

For J9853A, J9854A, J9855A, and
J9856A: Not supported

For all other switches: All

For use in the SFP ports of the
2530 Series Switches. (The
J9853A, J9854A, J9855A, and
J9856A models have 1G/10G
SFP+ ports that do not support
these 100Mbps transceiver
modules.)

Table Continued
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Product name SKU Minimum software required Comments

2540 Switch Series JL354A

JL355A

JL356A

JL357A

All

2610 Switch Series J9085A

J9086A

J9087A

J9088A

J9089A

All

2615-8-PoE Switch J9565A J9054B: All J9054C: A.14.07

2620 Switch Series J9623A

J9624A

J9625A

J9626A

J9627A

All

2800 Switch Series J4903A

J4904A

J9054B/C 1990-3613 and J9054C
1990-4112: i.10.30

J9054C 1990-4483: Not supported

J9054C part number 1990-4483 is
not supported

2810 Switch Series J9021A

J9022A

N.10.07

2900 Switch Series J9049A

J9050A

T.12.01

2910al Switch Series J9145A

J9146A

J9147A

J9148A

All

2915-8G-PoE Switch J9562A J9054B: All

J9054C/J9054D: A.14.07

Table Continued

46 ArubaOS-Switch and ArubaOS-CX Transceiver Guide

Anexo 01 ITEM 14 (0592745)         SEI 0008478-63.2018.6.02.8000 / pg. 8274



Product name SKU Minimum software required Comments

2920 Series
Switches

J9726A

J9727A

J9728A

J9729A

J9836A

All Use in the SFP ports of the 2920
Series Switches.

100-FX is not supported in the
SFP+ ports of the J9731A 2-Port
10GbE SFP+ Module

2930F Switch Series JL253A

JL254A

JL255A

JL256A

JL258A

JL263A

JL264A

JL259A

JL260A

JL261A

JL262A

JL557A

JL558A

JL559A

J9054B: is not supported in the
2930F Series Switches

For J9054C/9054D: All

The 2930F Switch Series models
with 1G/10G SFP+ ports added
support for this J9054C/J9054D
100FX transceiver. The J9054C/
J9054D are supported in models
with 1G SFP ports.

2930M Switch Series JL319A

JL320A

JL321A

JL322A

JL323A

JL324A

J9054B is not supported in the
2930M Series Switches.

For J9054C/J9054D: All

For use in SFP ports on switch
and an installed JL083A Aruba
3810M/2930M 4SFP+ MACsec
Module.

3500 Series
Switches

J9470A

J9471A

J9472A

J9473A

J9054B/C 1990-3613: K.14.31

J9054C 1990-4112 and 1990-4483:
K.15.08.0007

J9054D: K.15.08.0007

Table Continued
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Product name SKU Minimum software required Comments

3500yl Switch Series J8692A

J8693A

J9310A

J9311A

For J8692A, J8693A: K.12.01 (for
J9054B/C 1990-3613); K.15.08.0007
(for J9054C 1990-4112 and
1990-4483, and J9054D 1990-4483
and 1990-4360)

For J9310A, J9311A: K.14.50 (for
J9054B/C 1990-3613); K.15.08.0007
(for J9054C 1990-4112 and
1990-4483, and J9054D)

3800 Switch Series J9573A

J9574A

J9575A

J9576A

J9584A

For J9573A, J9574A, J9575A,
J9576A: Not supported.

For J9584A: All

Not supported for use in the
following 3800 models: J9573A,
J9574A, J9575A, and J9576A.
The SFP+ ports do not support
100M operation.

Supported in the J8584A
3800-24SFP-2SFP+ Switch

3810M Switch Series JL071A

JL072A

JL073A

JL074A

JL076A

All For use in an installed JL083A
Aruba 3810M/2930M 4SFP+
MACsec Module.

JL075A All For use in the JL075A SFP+
ports. Also used in an installed
JL083A Aruba 3810M/2930M
4SFP+ MACsec Module.

4100gl Switch Series J4865A

J4887A

n/a J9054C/J9054D 100FX is not
supported.

4200vl Switch Series J8770A

J8771A

J8772A/B

J8773A

L.10.24 Supported: J9033A Switch vl 20-
Port Gig-T + 4-Port SFP Module

Not supported: J8776A Switch vl
4-Port Mini-GBIC Module

5300xl Switch Series J4819A

J4850A

n/a J9054C/J9054D 100FX is not
supported.

Table Continued
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Product name SKU Minimum software required Comments

5400zl Switch Series J8697A

J8698A

J9642A

J9643A

For J8705A and J8706A modules: K.
12.01 (for J9054B/C 1990-3613); K.
15.08.0007 (for J9054C 1990-4112
and 1990-4483) J9054D: K.
15.08.0007

For the J9308A module: K.14.34 (for
J9054B/C 1990-3613); K.15.08.0007
(for J9054C 1990-4112 and
1990-4483) J9054D: K.15.08.0007

For J9537A, J9549A, J9535A, and
J9637A modules: K.15.02.0004 (for
J9054B/C 1990-3613); K.15.08.0007
(for J9054C 1990-4112 and
1990-4483) J9054D: K.15.08.0007

For use in:

J8705A Switch zl 20-Port
10/100/1000 + 4-Port Mini-GBIC
Module

J8706A Switch zl 24-Port Mini-
GBIC Module

J9308A 20-Port 10/100/1000 PoE
+ and 4-Port SFP zl Module

J9537A 24-Port SFP v2 zl Module

J9549A 20- Port Gig-T / 4-Port
SFP v2 zl Module

J9535A 20-Port Gig-T PoE+ / 4-
Port SFP v2 zl Module

J9637A 12-Port Gig- T PoE+ / 12-
Port SFP v2 zl Module

5400R Switch Series J9821A

J9822A

J9823A

J9824A

J9825A

J9826A

J9868A

For J9535A, J9537A, J9549A, and
J9637A modules: All

For the J9988A, J9989A, J9990A,
and J9993A modules: KB.15.17 and
later

For use in:

J9537A 24-Port SFP v2 zl Module

J9549A 20-Port Gig-T / 4-Port
SFP v2 zl Module

J9535A 20-Port Gig-T PoE+ / 4-
Port SFP v2 zl Module

J9637A 12-Port Gig-T PoE+ / 12-
Port SFP v2 zl Module

J9988A 24p 1GbE SFP v3 zl2
Module

J9989A 12p PoE+ / 12p 1GbE
SFP v3 zl2 Module

J9990A 20p PoE+ / 4p SFP+ v3
zl2 Module

J9993A 8p 1G/10GbE SFP+ v3
zl2 Module

6108 Switch J4902A n/a 100-FX is not supported

6120 Blade Switch
Series

498358-B21

516733-B21

n/a 100-FX is not supported

6200yl-24G-mGBIC
Switch

J8992A K.12.01 (for J9054B/C 1990-3613);
K.15.08.0007 (for J9054C 1990-4112
and 1990-4483) J9054D: K.
15.08.0007

For use in all 24 ports of the
J8992A Switch 6200yl- 24G-
mGBIC
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Product name SKU Minimum software required Comments

6600 Switch Series J9263A

J9264A

J9265A

J9451A

J9452A

For J9263A, J9264A: K.14.03 (for
J9054B/C 1990-3613); K.15.08.0007
(for J9054C 1990-4112 and
1990-4483)

For J9451A: K.14.24 (for J9054B/C
1990-3613); K.15.08.0007 (for
J9054C 1990-4112 and 1990-4483)
J9054D: K.15.08.0007

For use in the SFP ports of the
J9263A 6600-24G Switch, the
J9264A 6600-24G-4XG Switch,
and the J9451A 6600-48G Switch

(The J9265A 6600-24XG Switch
and J9452A 6600- 48G-4XG
Switch do not have SFP ports)

8100fl Switch Series J8727A

J8728A

n/a 100-FX is not supported

8200zl Switch Series J8715A/B

J9475A

J9640A

J9641A

For J8705A and J8706A modules: All
(for J9054B/C 1990-3613); K.
15.08.0007 (for J9054C 1990-4112
and 1990-4483) J9054D: K.
15.08.0007

For the J9308A module: K.14.34 (for
J9054B/C 1990-3613); K.15.08.0007
(for J9054C 1990-4112 and
1990-4483) J9054D: K.15.08.0007

For J9537A, J9549A, J9535A, and
J9637A modules: K.15.02.0004 (for
J9054B/C 1990-3613); K.15.08.0007
(for J9054C 1990-4112 and
1990-4483) J9054D: K.15.08.0007

For use in:

J8705A Switch zl 20-Port
10/100/1000 + 4-Port Mini-GBIC
Module

J8706A Switch zl 24-Port Mini-
GBIC Module

J9308A 20-Port 10/100/1000 PoE
+ and 4-Port SFP zl Module

J9537A 24-Port SFP v2 zl Module

J9549A 20- Port Gig-T / 4-Port
SFP v2 zl Module

J9535A 20-Port Gig-T PoE+ / 4-
Port SFP v2 zl Module

J9637A 12-Port Gig- T PoE+ / 12-
Port SFP v2 zl Module

8320 Series All n/a 100Mbps Transceivers are NOT
supported in the 8320 series.

8400 Series All n/a 100Mbps Transceivers are NOT
supported in the 8400 series.

9300m Switch Series J4138A

J4139A

J4874A

n/a 100-FX is not supported.

9408sl Switch J8680A n/a 100-FX is not supported
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Gigabit BIDI optical transceiver modules
Figure 16: Gigabit BIDI optical transceiver module

Models, specifications, and compatibility
Gigabit BIDI optical transceiver modules provide a transmission rate of 1250 Mbps and use LC connectors.

NOTE:

• BIDI optical transceiver modules use different central wavelengths in transmit and receive
directions to implement bidirectional transmission of fiber signals over the same fiber.

• You must use the HPE X122 1G SFP LC BX 10-D Transceiver (J9142B) and HPE X122 1G SFP
LC BX 10-U Transceiver (J9143B) in pairs: a J9142B (-D = downlink) at one end of the
connection and a J9143B (-U = uplink) at the other.

• The J9142B/J9143B were End of Sale in April 2016 and are no longer available. Contact your
Aruba Sales team for alternative solutions. The information presented here is for compatibility
use.

Table 36: Specifications for Gigabit BIDI optical transceiver modules (1)

Product name
(SKU)

DOM - Digital
Optical
Monitoring (4x4
part #)

Central wavelength (nm) Fiber
mode

Fiber
diameter
(µm)

Transmission
distance

Transmit
end (TX)

Receive
end (RX)

HPE X122 1G SFP
LC BX-D Transceiver
(J9142B)

No 1490 1310 SMF 9/125 10 km (6.21
miles)

HPE X122 1G SFP
LC BX-U Transceiver
(J9143B)

No 1310 1490
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Table 37: Specifications for Gigabit BIDI transceiver modules (2)

Product name (SKU) Optical parameters
(dBm)

Transmit power Receive power

HPE X122 1G SFP LC BX-D Transceiver (J9142B)

HPE X122 1G SFP LC BX-U Transceiver (J9143B)

–9 to –3 –18.7 to –3

Table 38: Compatibility for Gigabit BIDI transceiver modules

Product name SKU Minimum software
required (J9142B,
J9143B)

Comments

1400 Switch Series J9078A All

1410 Switch Series J9561A All

1700 Switch Series J9080A VB.02.00

1800 Switch Series J9028A/B PB.03.00

2510-24 Switch J9019A/B Q.11.16

2510-48 Switch J9020A U.11.10

2510G–24 Switch J9279A Y.11.03

2510G–48 Switch J9280A Y.11.03

2520 Switch Series J9137A

J9138A

J9298A

J9299A

All

Table Continued
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Product name SKU Minimum software
required (J9142B,
J9143B)

Comments

2530 Switch Series J9772A

J9773A

J9774A

J9775A

J9776A

J9777A

J9778A

J9779A

J9780A

J9781A

J9782A

J9783A

J9853A

J9854A

J9855A

J9856A

All

2540 Switch Series JL354A

JL355A

JL356A

JL357A

n/a 1G BX is not officially supported for
use in the 2540 series.

2600 Switch Series J4899A/B/C

4900A/B/C

J8164A

J8165A

J8762A

H.10.72

2610 Switch Series J9085A

J9086A

J9087A

J9088A

J9089A

R.11.22

2615-8-PoE Switch J9565A All

Table Continued
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Product name SKU Minimum software
required (J9142B,
J9143B)

Comments

2620 Switch Series J9623A

J9624A

J9625A

J9626A

J9627A

All

2800 Switch Series J4903A

J4904A

i.10.69

2810 Switch Series J9021A

J9022A

N.11.14

2900 Switch Series J9049A

J9050A

T.13.45

2910al Switch Series J9145A

J9146A

J9147A

J9148A

All

2915-8G-PoE Switch J9562A All

2920 Series Switches J9726A

J9727A

J9728A

J9729A

J9836A

All

Table Continued
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Product name SKU Minimum software
required (J9142B,
J9143B)

Comments

2930F Series Switches JL253A

JL254A

JL255A

JL256A

JL258A

JL259A

JL260A

JL261A

JL262A

JL263A

JL264A

Supported for use by
a future software
version.

As of April 2016, the J9142B and
J9143B 1G BX transceivers have been
End of Sale. Contact your Aruba
representative for alternative solutions.

2930M Switch Series JL319A

JL320A

JL321A

JL322A

JL323A

JL324A

See comments. As of April 2016, the J9142B and
J9143B 1G BX transceivers have been
End of Sale. Contact your Aruba
representative for alternative solutions.

3500 Series Switches J9470A

J9471A

J9472A

J9473A

K.14.31

3500yl Switch Series J8692A

J8693A

K.14.31

J9310A

J9311A

K.14.50

3800 Switch Series J9573A

J9574A

J9575A

J9576A

J9584A

All

Table Continued
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Product name SKU Minimum software
required (J9142B,
J9143B)

Comments

3810M Switch Series JL071A

JL072A

JL073A

JL074A

JL076A

All As of April 2016, the J9142B and
J9143B 1G BX transceivers have been
End of Sale. Contact your Aruba
representative for alternative solutions.

For use in the JL075A 3810M switch
or in any 3810M switch with a JL083A
Aruba 3810M/2930M 4SFP+ MACsec
Module installed.

JL075A All

4200vl Switch Series J8776A

J9033A

L.11.16

5300xl Switch Series J4878A/B

J4907A

E.11.08

5400zl Switch Series J8705A

J8706A

K.13.45

J9308A K.14.34

J9537A

J9549A

J9535A

J9637A

J9538A

J9548A

J9536A

K.15.02.0004

5400R Switch Series J9537A

J9549A

J9535A

J9637A

J9538A

J9548A

J9536A

All As of April 2016, the J9142B and
J9143B 1G BX transceivers have been
End of Sale. Contact your Aruba
representative for alternative solutions.

Table Continued
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Product name SKU Minimum software
required (J9142B,
J9143B)

Comments

J9988A

J9989A

J9990A

J9993A

KB.15.17

6200yl-24G-mGBIC Switch J8992A K.13.45

6600 Switch Series J9263A

J9264A

K.14.03

J9451A K.14.24

8200zl Switch Series J8705A

J8706A

K.13.45

J9308A K.14.34

J9537A

J9549A

J9535A

J9637A

J9538A

J9548A

J9536A

K.15.02.0004

8320 Series JL479A,
JL579A

n/a 1G BX Transceivers are NOT
supported in the 8320 series.

8400 Series All n/a 1G BX Transceivers are NOT
supported in the 8400 series.

Gigabit SFP copper transceiver modules
Figure 17: Gigabit SFP copper transceiver module
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Models, specifications, and compatibility
Table 39: Specifications for SFP copper transceiver modules

Product name (SKU) Transmission
distance

Data rate Cable type Connector
type

HPE X121 1G SFP RJ45 T
Transceiver (J8177C)

Aruba 1G SFP RJ45 T 100m Cat5e
XCVR (J8177D)

100 m (328.08 ft) 1G

100Mbps1

Cat5e
UTP/STP

RJ-45

1 For certain products. See next table.

Table 40: Compatibility for SFP copper transceiver modules

The specifications for Revision D transceiver products are the same as the specified Revision A, B, and C SKUs.

Product name SKU Minimum software
required (J8177C/
J8177D)

Comments

1810 Series Switches J9660A

J9801A

J9803A

J9834A

All

1820 Switch Series J9980A

J9981A

J9983A

J9984A

All

1920S Switch Series JL381A

JL382A

JL384A

JL385A

JL386A

Not supported The JL380A and JL383A
switches do not include SFP
ports.

2510 Switch J9020A All

Table Continued
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Product name SKU Minimum software
required (J8177C/
J8177D)

Comments

2530 Switch Series J9782A

J9781A

J9776A

J9775A

J9779A

J9778A

J9773A

J9772A

J9856A

J9855A

J9854A

J9853A

All

2540 Switch Series JL354A

JL355A

JL356A

JL357A

All

2610 Switch Series J9085A

J9086A

J9087A

J9088A

J9089A

All

2620 Switch Series J9623A

J9624A

J9625A

J9626A

J9627A

All

2920 Series Switches J9731A All

Table Continued
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Product name SKU Minimum software
required (J8177C/
J8177D)

Comments

2930F Series Switches JL253A, JL254A

JL255A

JL256A

JL258A

JL259A

JL260A

JL261A

JL262A

JL263A

JL264A

JL557A

JL558A

JL559A

All J8177C/J8177D support both
100Mbps and 1G operation in
this Switch Series.

2930M Switch Series JL319A

JL320A

JL321A

JL322A

JL323A

JL324A

All J8177C is not supported for
use in the Dual-Personality
ports of the 2930M Series
Switches.

For use in an installed JL083A
Aruba 3810M/2930M 4SFP+
MACsec Module.

J8177C/J8177D support both
100Mbps and 1G operation in
this Switch Series.

3800 Switch Series J9573A

J9574A

J9575A

J9576A

J9584A

All

3810M Switch Series JL071A

JL072A

JL073A

JL074A

JL076A

All For use in the JL075A 3810M
switch. Also used in any
3810M switch with a JL083A
Aruba 3810M/2930M 4SFP+
MACsec Module installed.

J8177C/J8177D support both
100Mbps and 1G operation in
this Switch Series.

Table Continued
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Product name SKU Minimum software
required (J8177C/
J8177D)

Comments

JL075A All

4100gl Switch Series J4893A

J4908A

G.07.69

4200vl Switch Series J8776A

J9033A

All

5300xl Switch Series J4878A/B E.09.22

5400zl Switch Series J8705A

J8706A

All

J9308A K.14.34

J9537A

J9549A

J9535A

J9637A

K.15.02.0004

5400R Switch Series J9537A

J9549A

J9535A

J9637A

All J8177C/J8177D support both
100Mbps and 1G operation in
this Switch Series.

J9988A

J9989A

J9990A

J9993A

KB.15.17 J8177C/J8177D support both
100Mbps and 1G operation in
this Switch Series.

6120 Blade Switch Series 498358-B21

516733-B21

All

6200yl-24G-mGBIC Switch J8992A All

8100fl Switch Series J8735A CY.01.02.0050

8200zl Switch Series J8705A

J8706A

All

J9308A K.14.34

Table Continued
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Product name SKU Minimum software
required (J8177C/
J8177D)

Comments

J9537A

J9549A

J9535A

J9637A

K.15.02.0004

Aruba 8320 48p 10G SFP/SFP+
and 6p 40G QSFP+ Switch

JL479A All 100Mbps operation is NOT
supported in this series.

Only the 1G Copper 4x4
numbers 1990-3816 and
1990-4606 are supported for
use in the 8320 and 8400
Series.

Aruba 8400X 32p 10G SFP/SFP+
Msec Module

JL363A All
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Networking Websites
Hewlett Packard Enterprise Networking Information Library

www.hpe.com/networking/resourcefinder

Hewlett Packard Enterprise Networking Software

www.hpe.com/networking/software

Hewlett Packard Enterprise Networking website

www.hpe.com/info/networking

Hewlett Packard Enterprise My Networking website

www.hpe.com/networking/support

Hewlett Packard Enterprise My Networking Portal

www.hpe.com/networking/mynetworking

Hewlett Packard Enterprise Networking Warranty

www.hpe.com/networking/warranty

General websites
Hewlett Packard Enterprise Information Library

www.hpe.com/info/EIL

For additional websites, see Support and other resources.

Chapter 6
Websites
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Accessing Hewlett Packard Enterprise Support
• For live assistance, go to the Contact Hewlett Packard Enterprise Worldwide website:

http://www.hpe.com/assistance

• To access documentation and support services, go to the Hewlett Packard Enterprise Support Center website:

http://www.hpe.com/support/hpesc

Information to collect

• Technical support registration number (if applicable)

• Product name, model or version, and serial number

• Operating system name and version

• Firmware version

• Error messages

• Product-specific reports and logs

• Add-on products or components

• Third-party products or components

Accessing updates
• Some software products provide a mechanism for accessing software updates through the product interface.

Review your product documentation to identify the recommended software update method.

• To download product updates:

Hewlett Packard Enterprise Support Center
www.hpe.com/support/hpesc

Hewlett Packard Enterprise Support Center: Software downloads
www.hpe.com/support/downloads

Software Depot
www.hpe.com/support/softwaredepot

• To subscribe to eNewsletters and alerts:

www.hpe.com/support/e-updates

• To view and update your entitlements, and to link your contracts and warranties with your profile, go to the
Hewlett Packard Enterprise Support Center More Information on Access to Support Materials page:

www.hpe.com/support/AccessToSupportMaterials

Chapter 7
Support and other resources
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IMPORTANT: Access to some updates might require product entitlement when accessed through
the Hewlett Packard Enterprise Support Center. You must have an HPE Passport set up with
relevant entitlements.

Customer self repair
Hewlett Packard Enterprise customer self repair (CSR) programs allow you to repair your product. If a CSR part
needs to be replaced, it will be shipped directly to you so that you can install it at your convenience. Some parts
do not qualify for CSR. Your Hewlett Packard Enterprise authorized service provider will determine whether a
repair can be accomplished by CSR.

For more information about CSR, contact your local service provider or go to the CSR website:

http://www.hpe.com/support/selfrepair

Remote support
Remote support is available with supported devices as part of your warranty or contractual support agreement. It
provides intelligent event diagnosis, and automatic, secure submission of hardware event notifications to Hewlett
Packard Enterprise, which will initiate a fast and accurate resolution based on your product's service level.
Hewlett Packard Enterprise strongly recommends that you register your device for remote support.

If your product includes additional remote support details, use search to locate that information.

Remote support and Proactive Care information
HPE Get Connected

www.hpe.com/services/getconnected
HPE Proactive Care services

www.hpe.com/services/proactivecare
HPE Proactive Care service: Supported products list

www.hpe.com/services/proactivecaresupportedproducts
HPE Proactive Care advanced service: Supported products list

www.hpe.com/services/proactivecareadvancedsupportedproducts

Proactive Care customer information
Proactive Care central

www.hpe.com/services/proactivecarecentral
Proactive Care service activation

www.hpe.com/services/proactivecarecentralgetstarted

Warranty information
To view the warranty for your product or to view the Safety and Compliance Information for Server, Storage,
Power, Networking, and Rack Products reference document, go to the Enterprise Safety and Compliance website:

www.hpe.com/support/Safety-Compliance-EnterpriseProducts

Additional warranty information
HPE ProLiant and x86 Servers and Options

www.hpe.com/support/ProLiantServers-Warranties
HPE Enterprise Servers

www.hpe.com/support/EnterpriseServers-Warranties
HPE Storage Products

www.hpe.com/support/Storage-Warranties
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HPE Networking Products
www.hpe.com/support/Networking-Warranties

Regulatory information
To view the regulatory information for your product, view the Safety and Compliance Information for Server,
Storage, Power, Networking, and Rack Products, available at the Hewlett Packard Enterprise Support Center:

www.hpe.com/support/Safety-Compliance-EnterpriseProducts

Additional regulatory information

Hewlett Packard Enterprise is committed to providing our customers with information about the chemical
substances in our products as needed to comply with legal requirements such as REACH (Regulation EC No
1907/2006 of the European Parliament and the Council). A chemical information report for this product can be
found at:

www.hpe.com/info/reach

For Hewlett Packard Enterprise product environmental and safety information and compliance data, including
RoHS and REACH, see:

www.hpe.com/info/ecodata

For Hewlett Packard Enterprise environmental information, including company programs, product recycling, and
energy efficiency, see:

www.hpe.com/info/environment

Documentation feedback
Hewlett Packard Enterprise is committed to providing documentation that meets your needs. To help us improve
the documentation, send any errors, suggestions, or comments to Documentation Feedback
(docsfeedback@hpe.com). When submitting your feedback, include the document title, part number, edition,
and publication date located on the front cover of the document. For online help content, include the product
name, product version, help edition, and publication date located on the legal notices page.
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© Copyright 2017, 2018 Hewlett Packard Enterprise Development LP

Notices
The information contained herein is subject to change without notice. The only warranties for Hewlett Packard
Enterprise products and services are set forth in the express warranty statements accompanying such products
and services. Nothing herein should be construed as constituting an additional warranty. Hewlett Packard
Enterprise shall not be liable for technical or editorial errors or omissions contained herein.

Confidential computer software. Valid license from Hewlett Packard Enterprise required for possession, use, or
copying. Consistent with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software
Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government under vendor's
standard commercial license.

Links to third-party websites take you outside the Hewlett Packard Enterprise website. Hewlett Packard Enterprise
has no control over and is not responsible for information outside the Hewlett Packard Enterprise website.
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The transceivers listed in this document represent the currently available and End of Sale products at the time of
this publication. Not all transceiver products are supported in every switch available from Aruba. Consult the
QuickSpecs for the applicable switch product for a list of supported transceiver products. QuickSpecs can be
found at http://www.hpe.com/networking/resourcefinder

Conventions
This section describes the conventions used in the documentation.

Note on product images
NOTE: Product images in this guide may differ from actual product.

Port numbering in examples
The port numbers in this document are for illustration only and might be unavailable on your device.

Symbols
Table 1: Symbols

Convention Description

An alert that calls attention to important information that if not
understood or followed can result in personal injury.

An alert that calls attention to important information that if not
understood or followed can result in data loss, data corruption, or
damage to hardware or software.

An alert that calls attention to essential information.

NOTE: An alert that contains additional or supplementary information.

An alert that provides helpful information.

Chapter 1
Overview
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Types of transceiver modules and network cables
Table 2: Types of transceiver modules and network cables

Transceiver module type Connector head

QSFP28 module (transceiver) QSFP28 optical transceiver module MPO 12-strand or LC 2-strand

QSFP28 DAC (copper cable for
interconnecting devices) 1 - 5m
reaches

N/A

QSFP+ module (transceiver) QSFP+ optical transceiver module MPO 12-strand or LC 2-strand

QSFP+ DAC (copper cable for
interconnecting devices) 1 - 5m
reaches

N/A

SFP+ module (transceiver) SFP+ optical transceiver module LC 2-strand or 1-strand (for BiDi)

SFP+ DAC (copper cable for
interconnecting devices)

N/A

Small form-factor pluggable (SFP)
module (transceiver)

100-Megabit SFP optical
transceiver module

LC 2-strand

Gigabit SFP optical transceiver
module

Gigabit SFP copper transceiver
module

RJ-45

NOTE:

• The available transceiver modules and network cables vary by device models and are subject to
change over time. For the most up-to-date list of transceiver modules and network cables, contact
your Aruba sales representative or technical support engineer.

• For information about the transceiver modules and network cables available for each device
model, see the QuickSpecs for the applicable switch product.

Data rate
Data rate is the number of bits transmitted per second. The unit of measure for data rate is Megabits per second
(Mbps) or Gigabits per second (Gbps). Optical transceiver modules available for products provide the following
levels of data rates:

• 100 Gbps

• 40 Gbps

• 10 Gbps
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• 1000 Mbps (also known as Gigabit)

• 100 Mbps

Transmission distance
The transmission distance of optical transceiver modules is divided into short and long-range types. A distance of
2 km (1.24 miles) and below is considered a short-range type. A distance of 10 km (6.21 miles) is considered a
long-range type. Transmission distances provided by optical transceiver modules are limited by certain loss and
dispersion suffered during the transmission of fiber signals over fibers.

• Loss is the optical energy loss due to the absorption, dispersion, and leakage over the media when light
travels through optical fibers. This loss increases in direct ratio to transmission distance.

• Dispersion occurs mainly because light waves of different wavelengths travel at different rates over the same
medium. This causes different wave components of optical signals to reach the receiving end early or late as
the transmission distance increases causing impulse broadening. Impulse broadening makes the signal values
indistinguishable (data loss). Different wavelengths traveling down the same fiber are called modes, and this
data loss is known as intermodal dispersion.

To meet different transmission distance requirements, choose suitable optical transceiver modules according to
actual networking conditions.

Central wavelength
Central wavelength (wl) represents the wave band used for optical signal transmission. The following central
wavelengths are available for common optical transceiver modules representing three wavebands:

• 850 nm waveband: Used for short-reach transmission.

• 1310 nm waveband: Used for middle-reach and long-haul transmission.

• 1550 nm waveband: Used for middle-reach and long-haul transmission.

Fiber

Fiber types
Fibers are classified as multimode fibers and single-mode fibers.

• Multimode fibers

Multimode fibers (MMFs) have thicker fiber cores and can transport light in multiple modes. However, the
intermodal dispersion is greater and worsens as the transmission distance increases.

Multimode fibers can be classified into multiple grades according to their diameters and modal bandwidth. For
more information, see Table 2. The modal bandwidth of a multimode fiber is determined by the expression of
the maximum modulation frequency pulse that can pass a fiber × the fiber length. The modal bandwidth is a
comprehensive index reflecting the optical characteristics of a multimode fiber.

International Telecommunication Union (ITU) defines multimode fiber types in its G series standards. The
commonly used multimode fiber is defined in the ITU G.651 standard. The G.651-compliant fiber transmits
light at the wavelength range 800 nm to 900 nm or 1200 nm to 1350 nm.

Chapter 1 Overview 7
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Table 3: Multimode fiber grades

Fiber mode Fiber grade Fiber diameter (μm) Modal bandwidth at 850 nm
(MHz*km)

Multimode fiber OM1 62.5/125 200

OM2 50/125 500

OM3 50/125 2000

OM4 50/125 4700

Other factors that influence the transmission distance of multimode fibers include interface type, central
wavelength, and fiber grade. The modal bandwidth values shown above are for the fiber grades listed. There
are multimode fibers that have different modal bandwidth characteristics and do not necessarily match the
OM1 - OM4 grades.

Table 4: Multimode fiber specifications

Interface types Central wavelength
(nm)

Fiber grade Transmission distance

1000BASE-SX 850 OM1 < 275 m (902.23 ft)

OM2 < 550 m (1804.46 ft)

10GBASE-SR 850 OM1 < 33 m (108.27 ft)

OM2 < 82 m (269.03 ft)

OM3 < 300 m (984.25 ft)

OM4 < 400m (1312.34 ft)

10GBASE-LRM 1310 OM1 < 220 m (721.78 ft)

OM2 < 220 m (721.78 ft)

OM3 < 220 m (721.78 ft)

OM4 < 220 m (721.78 ft)

SMF <300m (987.25 ft)

• Single-mode fibers

Single-mode fibers (SMFs) have a small core size, typically 9 μm or 10 μm, and can transmit light in only one
mode. Single-mode fibers suffer little intermodal dispersion and are suitable for long-haul communication.
Single-mode fibers transmit light at the central wavelength of 1310 nm or 1550 nm.

Telecommunication Industries Alliance (TIA)/Electronic Industries Alliance (EIA) defines that single-mode fibers
use yellow outer jackets with the mark "SM".

ITU defines single-mode fiber types in its G series standards. The most commonly used single-mode fibers are
defined in ITU G.652 and G.655 standards. The following table describes features of the G.652 and G.655-
compliant fibers.
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Table 5: Features of G.652- and G.655-compliant fibers

Single-mode fiber
type

Wavelength (nm) Features Applications

G.652-compliant
fiber (standard
single-mode fiber)

1260 to 1360

1530 to 1565

Zero dispersion at 1310 nm Connecting transceiver
modules with a central
wavelength of 1310 nm or
1550 nm.

G.655-compliant
fiber (non-zero
dispersion shifted
fiber)

1530 to 1565 Near-zero dispersion around
1550 nm

For 1550 nm wavelength-
division multiplexing (WDM)
transmissions.

Fiber diameter
Fiber diameter is expressed as core diameter/cladding diameter, in μm. For example, 9/125 μm means that the
fiber core diameter is 9 μm and the fiber cladding diameter is 125 μm.

For the HPE devices, the following fiber diameters are recommended:

• G.652 standard single-mode fiber: 9/125 μm

• G.655 non zero dispersion shifted single-mode fiber: 9/125 μm

• G.651 standard multimode fiber: 50/125 μm or 62.5/125 μm

Connector
CAUTION: Cover the connector with a dust cap when it is not connected to any optical fibers.

Connectors connect transceiver modules to the corresponding transmission media. The transceiver modules
available for Aruba products use the following types of connectors:

• Lucent connector or local connector (LC).

Single LC connectors (also known as Simplex) are typically used for 1G & 10G BiDi (Bidirectional) optics.

Dual LC connectors (Duplex) are typically used in normal optical types.

Chapter 1 Overview 9
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NOTE: 40G BiDi uses only Duplex fiber versus MPO (see below) for 40G SR4 applications.

Figure 1: LC connector (a simplex connector is shown)

• Multifiber Push On (MPO) connector.

Figure 2: MPO connector

The 40G QSFP+ MPO transceiver modules use only female MPO connectors, which have guide holes in the
end face of the MPO connector (the transceiver has guide pins within the MPO receptacle).

MPO connectors are classified as the following types based on the polish type:
◦ Physical contact (PC): End face polished flat.

◦ Angle-polished contact (APC): End face polished with an angle, typically 8°.

MPO connectors are available with 12 fibers or 24 fibers:
12-fiber MPO connector (40G, SR4, eSR4, and 100G SR4 transceivers use 8 of the available 12 fibers. The
four center fibers are unused. )

Figure 3: End face of a 12-fiber connector and channel assignment

MPO transceivers typically use four channels to communicate. These channels are assigned using the outer
eight fibers (the center four are unused).

Transmit channels are one set of four fibers, and the receive channels are on the other set of four fibers.
Because of this, the cables used and fiber cable connections from endpoint to endpoint effectively create a
crossover connection.

Be aware that using two crossover cables in series cancels this effect and no connection will be established.
An odd number of crossovers combined with straight-thru fiber connections will effect a crossover connection.

The channel layout indicates that the left four fibers are Transmit, and must reach the opposite transceiver
Receive channels (and in proper channel order).
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Optical parameters
This guide provides average transmit and receive power ranges for transceiver modules.

Transmit power

Transmit power is the power at which the transmitter of an optical transceiver module transmits optical signals, in
dBm.

Receive power

Receive power is the power at which the receiver of an optical transceiver module receives optical signals, in
dBm.

Use of attenuators

Transceivers are designed to transmit light pulses at a power level that accounts for loss in the fiber optic cabling,
and meets the receiver input thresholds of the link partner optical transceiver.

If you are using a fiber cable with less light loss than expected (for example, in a test environment and you do not
have a 40km spool of SMF available), use attenuators to affect the transmit level to within the receive sensitivity of
the other transceiver -- you will need to condition both fibers (sends in both directions). If not done, you risk
overdriving the Receive end and permanently damaging the transceiver. For example, a 40G ER4 has a highest
transmit level of 4.5dBm, but the Receive Sensitivity can be no higher than -4.5dBm. That means there must be at
least a 9dBm loss on the light level to be within the standards (4.5 - (-4.5) = 9dBm required).

Copper transceiver modules
Copper transceiver modules transmit signals over Category-5 unshielded twisted pair (UTP). UTP transmission
cover shorter distances than fiber transmission and can be used in small-sized networks only.

Copper transceivers are supported in 1G SFP and 10G SFP+ ports where listed in the Support Matrix tables.

Transmission distance
Through UTP cables, signals can be transmitted over a distance of 100 m (328.08 ft.) only. This behavior occurs
because signals attenuate during transmission through the UTP cables.

Attenuation refers to the dissipation of the power of a transmitted signal as it travels over a cable. Attenuation
occurs because signal transmission suffers certain resistance from the cable, which weakens the signals as they
travel over the cable. When signals are transmitted over a long distance, signal strength decreases significantly,
causing the signal-to-noise ratio to drop below the accepted level. This decrease makes it impossible to
distinguish between signals and noise, which results in data loss.

Patch panel and punch down blocks also affect attenuation; that is, they can be a source of issues resulting in
shorter distances or data loss.

10GBASE-T connections require Category 6a as a minimum for proper 10G speeds up to the 100m distance
dictated by the IEEE 802.3ae standard. Anything less (Cat 6, 5e, 5) will compromise the distance that 10G over
copper can achieve.

Shielded Twisted Pair (STP) Cat 6a cable is required for full support when using the 10GBase-T transceiver
(JL563A) supported only on the 8400 and 8320 switch models. Use of STP prevents EMI events from affecting
data traffic carried on the wire - known as Crosstalk or Alien Crosstalk. Large EMI events from electronically noisy
environments may be coupled onto unshielded cabling and cause temporary packet errors. Fixed 10G ports have
designs to counteract these types of bit error conditions, that the 10GBASE-T transceiver cannot counteract
consistently. Using STP Cat6a cables mitigate the errors significantly. All packet loss errors observed in extensive
testing are considered recoverable by the host system with the JL563A transceiver.
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Connector
Registered Jack-45 (RJ-45) twisted-pair connectors are used as connectors for copper transceiver modules.

Figure 4: RJ-45 connector

Table 6: RJ-45 GE connector pin assignment for Gigabit connections

Pin Signal Function

1 MX_0+ Data transmit/receive

2 MX_0- Data transmit/receive

3 MX_1+ Data transmit/receive

4 MX_2+ Data transmit/receive

5 MX_2- Data transmit/receive

6 MX_1- Data transmit/receive

7 MX_3+ Data transmit/receive

8 MX_3- Data transmit/receive

Identification of 4x4 part numbers
A SKU# may be fulfilled by two or more vendor parts providing similar functionality. A 4x4 part number is of the
form nnnn-nnnn and is on the transceiver or DAC label. For example, JL309A can have a 1990-4680 or
1990-4678 4x4 part number. 4x4 part numbers are referenced in the

• specification tables, to identify parts that support DOM (Digital Optical Monitoring) capabilities. (Some older
vendor parts do not support DOM.)

• compatibility tables, where necessary, to identify supported combinations of switch or module with the
identified transceiver, along with the minimum software version required.

In December 2017, Aruba introduced Revision D versions of 100M, 1G, and 10G products. Revision D products
are structured to be specific alternative vendors as sources for the SKU#. Earlier Revision A, B, or C product may
have alternative vendors that Aruba no longer actively ships, but remains as fully supported in specific switches.

Some switch products will specify Revision D transceivers for full support, while other products may support
earlier (older) revision transceivers – and some with specific 4x4 part numbers.
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Always refer to the Datasheet or QuickSpecs for the switch product to see the current list of supported
transceivers. Refer to the compatibility tables within this document to cross-reference the Transceiver/DAC
product against the switch product to identify the minimum software required for transceiver support.

To use CLI commands to display data for an installed transceiver, see the following examples.

8400X# show int 1/10/6 transceiver 
------------------------------------------------------------
Port      Type        Product   Serial          Part        
                      Number    Number          Number      
------------------------------------------------------------
1/10/6    QSFP+SR4    JH231A    XX57nnnnnn      1990-5555  
8400X# show int 1/10/6 dom
-------------------------------------------------------------------------------------------
Port      Type        Channel#  Temperature     Voltage         Tx Bias      Rx Power        Tx Power        
                                (Celsius)       (Volts)         (mA)         (mW/dBm)        (mW/dBm)        
-------------------------------------------------------------------------------------------
1/10/6    QSFP+SR4    1         26.00           3.32            6.72         0.02, -16.99    0.58, -2.37     
                      2         26.00           3.32            6.79         0.02, -16.99    0.59, -2.29     
                      3         26.00           3.32            6.68         0.03, -15.23    0.59, -2.29     
                      4         26.00           3.32            6.82         0.03, -15.23    0.60, -2.22 

Aruba-5406Rzl2# show interfaces transceiver f2 detail
Transceiver in F2
   Interface Index    : 162 
   Type               : QSFP+SR4        
   Model              : JH231A  
   Connector Type     : MPO                             
   Wavelength         : 850nm                           
   Transfer Distance  : 100m (50um OM3), 150m (50um OM4)                
   Diagnostic Support : DOM   
   Serial Number      : XX57nnnnnn      
 Status
   Temperature : 33.332C         
   Voltage     : 3.3208V     

            Tx Bias  Rx Power       Tx Power
  Channel#  (mA)     (mW/dbM)       (mW/dbM)     
  --------- -------- -------------- --------------
  1         6.904    0.5622, -2.501 0.5822, -2.349
  2         6.706    0.5922, -2.275 0.5856, -2.324
  3         6.894    0.6321, -1.992 0.5813, -2.356
  4         6.792    0.5111, -2.915 0.5651, -2.479
  Current Alarms:
    Channel 1 :  
       Tx bias low alarm                      
       Rx power low warning                  
    Channel 2 :  
       Tx bias low alarm                      
       Rx power low warning                  
  Current Errors:
    Channel 1 :  
       Rx Loss of Signal                     
    Channel 2 :  
       Rx Loss of Signal                     
    Channel 3 :  
       Rx Loss of Signal                     
    Channel 4 :  
       Rx Loss of Signal                
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QSFP28 optical transceiver modules that use MPO
connectors
See Chapter 1, "Overview", for information regarding MPO connectors and cable requirements.

Figure 5: QSFP28 optical transceiver module that use MPO connectors

Models and specifications
QSFP28 optical transceiver modules provide a transmission rate of 100 Gbps and use MPO connectors.

Table 7: Specifications for QSFP28 optical transceiver modules that use MPO connectors (1)

Product name
(SKU)

DOM - Digital
Optical
Monitoring
(4x4 part #)

Central wl
(nm)

Fiber
mode

Fiber
diameter
(µm)

Modal
bandwidth
(MHz*km)

Transmission
distance

Aruba 100G
QSFP28 MPO
SR4 100m 12-fiber
MPO MMF
Transceiver
(JL309A)

YES

(1990-4680,
1990-4678)

850 MMF 50/125 2000 (OM3)

4700 (OM4)

70 m (229.66 ft)

100 m (328.08 ft)

NOTE: SR4 is not supported for use over MMF OM1 or OM2 fiber. (The IEEE standard does not
state a specification.) Use MPO Female connectors with the MPO transceivers.

Chapter 2
QSFP28 modules
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Table 8: Specifications for QSFP28 optical transceiver modules that use MPO connectors (2)

Product name (SKU) Connector Optical parameters (dBm)

Transmit power Receive power

Aruba 100G QSFP28 MPO SR4
100m 12-fiber MPO MMF
Transceiver (JL309A)

MPO (PC polished, 12-fiber) -8.4 to +2.4 -10.3 to +2.4

Table 9: Compatibility for the QSFP28 optical transceiver modules that use MPO connectors.

Product name (SKU) Minimum software required Comments

Aruba 8400X 6p 40G/100G QSFP28 Adv
Module (JL366A)

10.00.0005 10.00.0005 provided 100G
product support.

10.00.0006 provides additional
support for 40G on the JL366A.

QSFP28 optical transceiver modules that use LC
connectors
Figure 6: QSFP28 optical transceiver module that use LC connectors

Models and specifications
QSFP28 optical transceiver modules provide a transmission rate of 100 Gbps and use LC connectors.

Table 10: Specifications for QSFP28 optical transceiver modules that use LC connectors (1)

Product name
(SKU)

DOM - Digital
Optical
Monitoring
(4x4 part #)

Central wl
(nm)

Fiber
mode

Fiber
diameter
(µm)

Modal
bandwidth
(MHz*km)

Transmission
distance

Aruba 100G
QSFP28 LC LR4
10km SMF 2-
strand Transceiver
(JL310A)

YES

(1990-4681)

Four lanes:

1294.53 ~
1296.59

1299.02 ~
1301.09

1303.54 ~
1305.63

1308.09 ~
1310.19

SMF 9/125 N/A 10 km (6.21 miles)
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Table 11: Specifications for QSFP28 optical transceiver modules that use LC connectors (2)

Product name (SKU) Connector Optical parameters (dBm)

Transmit power Receive power

Aruba 100G QSFP28 LC LR4 10km SMF 2-
strand Transceiver (JL310A)

LC -4.3 to +4.5 per lane -10.6 to +4.5 per
lane

Table 12: Compatibility for the QSFP28 optical transceiver modules that use LC connectors

Product name (SKU) Minimum software required Comments

Aruba 8400X 6p 40G/100G QSFP28 Adv
Module (JL366A)

10.00.0005 10.00.0005 provides support for
100G products.

10.00.0006 provides additional
support for 40G on the JL366A.

QSFP28 DAC (copper cables)
Figure 7: QSFP28 DAC (copper cable)

Models and specifications
Table 13: Specifications for QSFP28 copper cables

Product name (SKU) Cable length Data rate Description

Aruba 100G QSFP28 to QSFP28 3m Direct
Attach Copper Cable (JL307A)

3 m (9.8 ft) 100 Gbps Used for interconnecting
100-Gigabit QSFP28 ports
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Table 14: Compatibility for the QSFP28 copper cables

Product name (SKU) Minimum software required Comments

Aruba 8400X 6p 40G/100G QSFP28 Adv
Module (JL366A)

All

Chapter 2 QSFP28 modules 17
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QSFP+ optical transceiver modules that use MPO
connectors
See Chapter 1, " Overview", for information regarding MPO connectors and cable requirements.

Figure 8: QSFP+ optical transceiver module that uses MPO connectors

Models, specifications, and compatibility
QSFP+ optical transceiver modules provide a transmission rate of 40 Gbps and use MPO connectors.

NOTE: 40G SR4 and eSR4 are not supported for use over MMF OM1 or OM2 quality fiber. (The
IEEE standard does not state a specification). Use MPO female connectors for use with the MPO
transceivers.

Table 15: Specifications for QSFP+ optical transceiver modules that use MPO connectors (1)

Product name
(SKU)

DOM - Digital
Optical
Monitoring
(4x4 part #)

Central wl
(nm)

Fiber
mode

Fiber
diameter
(µm)

Modal
bandwidth
(MHz*km)

Transmission
distance

HPE X142 40G
QSFP+ MPO SR4
Transceiver
(JH231A)

YES

(1990-4554)

850 MMF 50/125 2000 (OM3)

4700 (OM4)

100 m (328.08 ft)

150 m (492.12 ft)

HPE X142 40G
QSFP+ MPO
eSR4 300M XCVR
(JH233A)

YES

(1990-4555)

850 MMF 50/125 2000 (OM3)

4700 (OM4)

300 m (984.25 ft)

400 m (1312.33 ft)

Chapter 3
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Table 16: Specifications for QSFP+ optical transceiver modules that use MPO connectors (2)

Product name (SKU) Connector Optical parameters (dBm)

Transmit power Receive power

HPE X142 40G QSFP+ MPO
SR4 Transceiver (JH231A)

MPO (PC polished, 12-fiber) –7.6 to 0 –9.5 to +2.4

HPE X142 40G QSFP+ MPO
eSR4 300M XCVR (JH233A)

MPO (PC polished, 12-fiber) –7.6 to 0 –9.9 to +2.4

Table 17: Compatibility for the QSFP+ optical transceiver modules that use MPO connectors

Product name (SKU) Minimum software required Comments

Aruba 3810M/2930M 1QSFP+ 40GbE
Module (JL078A)

All

Aruba 3810M 24G 1-slot Switch 2QSFP
+ 40GbE Module (JL079A)

All

20p PoE+ / 1p 40GbE QSFP+ v3 zl2
Module (J9992A)

KB.15.17

2p 40GbE QSFP+ v3 zl2 Module
(J9996A)

KB.15.17

Aruba 8320 48p SFP/SFP+ & 6p 40G
QSFP+ Switch (JL479A)

10.00.0006

Aruba 8320 32p 40G QSFP+ Switch
(JL579A)

10.00.0012

Aruba 8400X 8p 40G QSFP+ Adv Module
(JL365A)

All

Aruba 8400X 6p 40G/100G QSFP28 Adv
Module (JL366A)

10.00.0006 10.00.0005 supports 100G
products.

10.00.0006 provides additional
support for 40G on the JL366A.

QSFP+ optical transceiver modules that use LC
connectors
Figure 9: QSFP+optical transceiver module that uses LC connectors
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Models, specifications, and compatibility
QSFP+ optical transceiver modules provide a transmission rate of 40 Gbps and use LC connectors.

Table 18: Specifications for QSFP+ transceiver modules that use LC connectors (1)

Product name
(SKU)

DOM - Digital
Optical
Monitoring
(4x4)

Central wl
(nm)

Fiber
mode

Fiber
diameter
(µm)

Modal
bandwidth
(MHz*km)

Transmission
distance

Aruba 40G QSFP+
LC BiDi 150m
MMF Transceiver
(JL308A)

YES

(1990-4679)

Dual
20Gb/s:

• 850

• 900

MMF 50/125 2000 (OM3)

4700 (OM4)

100 m (328.08 ft)

150 m (492.12 ft)

Not supported on
OM1/OM2.

HPE X142 40G
QSFP+ LC LR4
SM Transceiver
(JH232A)

YES

(1990-4556)

Four
lanes:

• 1271

• 1291

• 1311

• 1331

SMF 9/125 N/A 10 km (6.21 miles)

Aruba 40G QSFP+
LC ER4 40km
SMF XCVR
(Q9G82A)

YES

(1990-4734)

Four
lanes:

• 1271

• 1291

• 1311

• 1331

SMF 9/125 N/A 40km (24.86 miles)

Table 19: Specifications for QSFP+ transceiver modules that use LC connectors (2)

Product name (SKU) Optical parameters (dBm)

Transmit power Receive power

Aruba 40G QSFP+ LC BiDi 150m MMF Transceiver
(JL308A)

–4 to +5 –6 to +5

HPE X142 40G QSFP+ LC LR4 SM Transceiver
(JH232A)

–7 to +2.3 per lane –13.7 to +2.3 per lane

Aruba 40G QSFP+ LC ER4 40km SMF XCVR
(Q9G82A)

-2.7 to 4.5 dBm -21.2 to -4.5 dBm

(Use attenuators to match
power levels.)
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Table 20: Compatibility for the QSFP+ optical transceiver modules that use LC connectors

Product name (SKU) Minimum software required Comments

Aruba 3810M/2930M 1QSFP+ 40GbE
Module (JL078A)

For JH232A: all

For JL308A: KB.16.04.0008 or
WC.16.04.0008

Q9G82A not supported.

Aruba 3810M 2QSFP+ 40GbE Module
(JL079A)

For JH232A: all

For JL308A: KB.16.04.0008

Q9G82A not supported.

The JL079A module is not
supported in the 2930M series
nor on the 3810M 16SFP+ 2-slot
switch (JL075A).

20p PoE+ / 1p 40GbE QSFP+ v3 zl2
Module (J9992A)

For JH232A: KB.15.17

For JL308A: KB.16.04.0008

Q9G82A not supported.

2p 40GbE QSFP+ v3 zl2 Module
(J9996A)

For JH232A: KB.15.17

For JL308A: KB.16.04.0008

Q9G82A not supported.

Aruba 8320 48p SFP/SFP+ & 6p 40G
QSFP+ Switch (JL479A)

For JH232A: 10.00.0006

For JL308A: 10.00.0006

For Q9G82A: 10.00.0018

Aruba 8320 32p 40G QSFP+ Switch
(JL579A)

For JH232A: 10.00.0012

For JL308A: 10.00.0012

For Q9G82A: 10.00.0018

Aruba 8400X 8p 40G QSFP+ Adv Module
(JL365A)

For JH232A: all

For JL308A: all

For Q9G82A: 10.00.0018

Aruba 8400X 6p 40G/100G QSFP28 Adv
Module (JL366A)

For JH232A: 10.00.0006

For JL308A: 10.00.0006

For Q9G82A: 10.00.0018

10.00.0005 provides support for
100G products.

10.00.0006 provides additional
support for 40G on the JL366A.
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QSFP+ DAC (copper cables)
Figure 10: QSFP+ DAC copper cables

IMPORTANT: Direct Attach over Copper (DAC) cables have a minimum bend radius of typically 4x
the diameter of the cable (approximately a 1" bend radius). Handle DAC cables carefully to ensure
that you do not crimp or bend the cable beyond a 1" radius. Otherwise, you risk damaging the cable.

Models, specifications, and compatibility
Table 21: Specifications for QSFP+ copper cables

Product name (SKU) Cable length Data rate Description

HPE X242 40G QSFP+ to QSFP+ 1m DAC
Cable (JH234A)

1 m (3.28 ft)

40 Gbps Used for interconnecting
40-Gigabit QSFP+ ports

HPE X242 40G QSFP+ to QSFP+ 3m DAC
Cable (JH235A)

3 m (9.84 ft)

HPE X242 40G QSFP+ to QSFP+ 5m DAC
Cable (JH236A)

5 m (16.40 ft)

Table 22: Compatibility for the QSFP+ copper cables

Product name (SKU) Minimum software required Comments

Aruba 3810M/2930M 1QSFP+ 40GbE
Module (JL078A)

All

Aruba 3810M 2QSFP+ 40GbE Module
(JL079A)

All The JL079A module is not
supported in the 2930M
series nor on the 3810M
16SFP+ 2-slot Switch
(JL075A).

20p PoE+ / 1p 40GbE QSFP+ v3 zl2
Module (J9992A)

KB.15.17

Table Continued
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Product name (SKU) Minimum software required Comments

2p 40GbE QSFP+ v3 zl2 Module
(J9996A)

KB.15.17

Aruba 8320 48p 10G SFP/SFP+ and 6p
40G QSFP+ Switch (JL479A)

All

Aruba 8320 32p 40G QSFP+ Switch
(JL579A)

10.00.0012

Aruba 8400X 8p 40G QSFP+ Adv Module
(JL365A)

All

Aruba 8400X 6p 40G/100G QSFP28 Adv
Module (JL366A)

10.00.0006
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SFP+ optical transceiver modules
In December, 2017, Aruba introduced Revision D versions of 100M, 1G, and 10G transceivers. Revision D
products are structured to be specific alternate vendors as sources for the SKU#. Earlier Revision A, B, or C
product may have alternate vendors that we no longer actively ship, but remain as fully supported in earlier and
current products.

Some switch products will be specifying Revision D transceivers for full support, while other products may support
earlier (older) revision transceivers – and some with specific 4x4 part numbers (see Chapter 1, "Overview", for
information regarding 4x4 part numbers).

Always refer to the Datasheet or QuickSpecs for the Switch product to see the current list of supported
transceivers.

Figure 11: SFP+ optical transceiver modules

NOTE: 

• Although a 10G SFP+ transceiver module is the same physical dimensions of a 1G SFP
transceiver, a 10G transceiver will NOT operate in a 1G SFP port.

• Many, although not all, 10G SFP+ ports have support to use a 1G SFP transceiver (or even a
100Mbps FX SFP transceiver).

See the QuickSpec for the Switch product and verify if the 1G or 100Mbps SFP transceiver is
supported in the 10G SFP+ port.

Models, specifications, and compatibility
SFP+ optical transceiver modules provide a transmission rate of 10.31 Gbps and use LC connectors.

The specifications for Revision D transceiver products are the same as the specified Revision A, B, C SKUs.
Where support for a Revision A, B, or C transceiver existed, Revision D parts are also supported.

Chapter 4
SFP+ modules
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Table 23: Specifications for SFP+ optical transceiver modules (1)

Product Name
(SKU)

DOM - Digital
Optical
Monitoring
(4x4 part #)

Central
we (nm)

Fiber
mode

Fiber
diameter
(µm)

Bandwidth
(MHz*km)

Transmission
distance

HPE X132 10G
SFP+ LC SR
Transceiver
(J9150A)

Aruba 10G SFP+
LC SR 300m MMF
XCVR (J9150D)

Yes

(1990-4391,

1990-4175)

850 MMF 50/125 4700 (OM4)

2000 (OM3)

500 (OM2)

400

400 m (1312.34 ft)

300 m (984.25 ft)

82 m (269.03 ft)

66 m (216.54 ft)

62.5/125 200 (OM1)

160

33 m (108.27 ft)

26 m (85.30 ft)

HPE X132 10G
SFP+ LC LRM
Transceiver
(J9152A)

Aruba 10G SFP+
LC LRM 220m
MMF XCVR
(J9152D)

Yes

(1990-4485)

1310 MMF 50/125 1500

500 (OM2)

400

220 m (721.78 ft)

220 m (721.78 ft)

100 m (328.08 ft)

62.5/125 200 (OM1)

160

220 m (721.78 ft)

220 m (721.78 ft)

SMF 9/125 N/A 300m (987.25 ft)

HPE X132 10G
SFP+ LC LR
Transceiver
(J9151A)

Aruba 10G SFP+
LC LR 10km SMF
XCVR (J9151D)

Yes

(1990-4657,

1990-4694)

1310 SMF 9/125 N/A 10 km (6.21 miles)

HPE X132 10G
SFP+ LC ER
Transceiver
(J9153A)

Aruba 10G SFP+
LC ER 40km SMF
XCVR (J9153D)

Yes

(1990-4365,

1990-4656)

1550 SMF 9/125 N/A 40 km (24.86
miles)

NOTE: A mode conditioning patch cord is required when you use OM1 or OM2 fiber types on a 10G
LRM Transceiver (J9152A/J9152D). Never use mode conditioning patch cords for OM3 or OM4 fiber
types. For more information about mode conditioning patch cords, see related parts in the IEEE
802.3 standard.
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Table 24: Specifications for SFP+ optical transceiver modules (2)

Product name (SKU) Optical parameters (dBm)

Transmit power Receive power

HPE X132 10G SFP+ LC SR Transceiver (J9150A)

Aruba 10G SFP+ LC SR 300m MMF XCVR (J9150D)

–7.3 to –1 –9.9 to +0.5

HPE X132 10G SFP+ LC LRM Transceiver (J9152A)

Aruba 10G SFP+ LC LRM 220m MMF XCVR (J9152D)

–6.5 to +0.5 –6.5 to +1.5

HPE X132 10G SFP+ LC LR Transceiver (J9151A)

Aruba 10G SFP+ LC LR 10km SMF XCVR (J9151D)

–8.2 to +0.5 –14.4 to +0.5

HPE X132 10G SFP+ LC ER Transceiver (J9153A)

Aruba 10G SFP+ LC ER 40km SMF XCVR (J9153D)

–4.7 to +4 –15.8 to –1

Table 25: Compatibility for the SFP+ optical transceiver module

Product name SKU Minimum software required Comments

10G-SR, LR, LRM
(J9150A/J9150D,
J9151A/J9151D,
J9152A/J9152D)

10G-ER (J9153A/
J9153D)

1850 Switch Series JL169A J9150A/J9150D: All

J9151A/J9151D: All

J9152A/J9152D: All

J9153A/J9153D is
not supported on the
1850 Switch Series.

Unlisted models do not
have SFP+ ports.

2530 Switch Series J9853A

J9854A

J9855A

J9856A

All All Unlisted models do not
have SFP+ ports.

2540 Switch Series JL354A

JL355A

JL356A

JL357A

All (J9150A/J9150D
and J9151A/J9151D
only)

J9152A/J9152D
(LRM) is not
supported in any 2540
model

All J9152A/J9152D (LRM)
is not supported in any
2540 model.

2910al Switch Series J9008A All W.15.07.0002 Unlisted models do not
have SFP+ ports.

Table Continued
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Product name SKU Minimum software required Comments

10G-SR, LR, LRM
(J9150A/J9150D,
J9151A/J9151D,
J9152A/J9152D)

10G-ER (J9153A/
J9153D)

2920 Switch Series J9726A

J9727A

J9728A

J9729A

J9836A

All For use in an installed
J9731A Aruba 2920 2-
port 10GbE SFP+
Module.

2930F Switch Series JL253A

JL254A

JL255A

JL256A

JL258A

JL263A

JL264A

JL558A

JL559A

All (J9150A/J9150D
and J9151A/J9151D
only)

J9152A/J9152D
(LRM) is not
supported in any
2930F model

All Unlisted models do not
have SFP+ ports.

J9152A/J9152D (or
any 10G LRM
technology) is not
supported in any
2930F model.

2930M Switch Series JL319A

JL320A

JL321A

JL322A

JL323A

JL324A

All All For use in an installed
JL083A Aruba 3810M/
2930M 4SFP+
MACsec Module.

3500yl Switch Series J8692A

J8693A

J9310A

J9311A

K.14.50 and later K.15.02.0004 and
later

For use in an installed
J9312A 10GbE 2-port
SFP+/2-port CX4 yl
Module.

3800 Switch Series J9575A

J9576A

J9573A

J9574A

J9584A

All All Unlisted models do not
have SFP+ ports.

Table Continued
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Product name SKU Minimum software required Comments

10G-SR, LR, LRM
(J9150A/J9150D,
J9151A/J9151D,
J9152A/J9152D)

10G-ER (J9153A/
J9153D)

3810M Switch Series JL071A

JL072A

JL073A

JL074A

JL076A

All All For use in an installed
JL083A Aruba 3810M/
2930M 4SFP+
MACsec Module

JL075A All All For use in the JL075A
SFP+ ports or in an
installed JL083A
Aruba 3810M/2930M
4SFP+ MACsec
Module

5400zl Switch Series J9309A K.14.39 K.15.02.0004

J9538A

J9548A

J9536A

K.15.02.0004 K.15.02.0004

5400R Switch Series J9538A

J9548A

J9536A

All All

J9990A

J9993A

KB.15.17 KB.15.17

6120 Switch Series 516733-
B21
(6120XG)

All (not supported) 498358-B21
(6120G/XG) has 1GB
SFP and 10G XFP or
CX4 ports and does
not support these SFP
+ transceivers

6200yl Switch Series J8992A K.14.50 K.15.02.0004 J8992A fixed SFP
ports are 1GB and do
not support these SFP
+ transceivers

For use in an installed
J9312A 10GbE 2-port
SFP+/2-port CX4 yl
Module

6600 Switch Series J9264A

J9265A

K.14.03 K.15.02.0004

Table Continued
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Product name SKU Minimum software required Comments

10G-SR, LR, LRM
(J9150A/J9150D,
J9151A/J9151D,
J9152A/J9152D)

10G-ER (J9153A/
J9153D)

J9452A K.14.24 K.15.02.0004

8200zl Switch Series J9309A K.14.39 K.15.02.0004

J9538A

J9548A

J9536A

K.15.02.0004 K.15.02.0004

Aruba 8320 48p 10G
SFP/SFP+ and 6p 40G
QSFP+ Switch

JL479A All (J9150A/J9150D
and J9151A/J9151D
only)

J9152A/J9152D
(LRM) is not
supported in the 8320
switches

All Only the following 4x4
part numbers are
supported:

• J9150A/J9150D:
1990-4391, 1990-4175

• J9151A/J9151D:
1990-4657,
1990-4727, 1990-4694

• J9153A/J9153D:
1990-4365, 1990-4656

J9152A/J9152D (or
any 10G LRM
technology) is not
supported in the 8320
Switches

Aruba 8400X 32p 10G
SFP/SFP+ Msec Module

JL363A All All Only the following 4x4
part numbers are
supported:
• J9150A/J9150D:

1990-4391,
1990-4175

• J9151A/J9151D:
1990-4657,
1990-4727,
1990-4694

• J9152A/J9152D:
1990-4485

• J9153A/J9153D:
1990-4365,
1990-4656

NOTE: A mode conditioning patch cord is required when you use OM1 or OM2 fiber types on a10G
LRM Transceiver. Never use mode conditioning patch cords for OM3 or OM4 fiber types. For more
information about mode conditioning patch cords, see related parts in the IEEE 802.3 standard.
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10G SFP+ copper transceiver modules
Figure 12: 10G SFP+ copper transceiver module

Models, specifications, and compatibility
Table 26: Specifications for SFP+ copper transceiver modules

Product name (SKU) Transmission
distance

Data rate Cable type Connector
type

Aruba 10GBASE-T SFP+ RJ45 30m
Cat6A XCVR (JL563A)

30 m (98.43 ft) 10G STP Cat6A 1 RJ-45

1 See Transmission distance on page 11.

Table 27: Compatibility for SFP+ copper transceiver modules

Product name SKU Minimum software
required (JL563A)

Comments

Aruba 8320 48p 10G SFP/SFP+
and 6p 40G QSFP+ Switch

JL479A 10.01.0011 The JL563A transceiver does
NOT support 1G operation;
only 10G.

Aruba 8400X 32p 10G SFP/SFP+
Msec Module

JL363A 10.00.0018

SFP+ DAC cables
Figure 13: SFP+ DAC cable

IMPORTANT: Direct Attach over Copper (DAC) cables have a minimum bend radius of typically 4x
the diameter of the cable (approximately a 1" bend radius). Handle DAC cables carefully to ensure
that you do not crimp or bend the cable beyond a 1" radius, otherwise, you risk damaging the cable.
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Models, specifications, and compatibility
The specifications for Revision D transceiver products are the same as the specified Revision A, B, and C SKUs.
Where support for a Revision A, B, or C transceiver existed, Revision D parts are also supported.

Table 28: Specifications for SFP+ DAC cables

Product name (SKU) Cable length Data rate Type

HPE X242 10G SFP+ to SFP+ 1m DAC Cable (J9281B)

Aruba 10G SFP+ to SFP+ 1m DAC Cable (J9281D)

1 m (3.28 ft)

10.31 Gbps SFP+ cable
HPE X242 10G SFP+ to SFP+ 3m DAC Cable (J9283B)

Aruba 10G SFP+ to SFP+ 3m DAC Cable (J9283D)

3 m (9.84 ft)

HPE X242 10G SFP+ to SFP+ 7m DAC Cable (J9285B)

Aruba 10G SFP+ to SFP+ 7m DAC Cable (J9285D)

7 m (22.97 ft)

Table 29: Compatibility for the SFP+ copper cables

Product name SKU Minimum software required
(J9281B/J9281D, J9283B/J9283D,
J9285B/J9285D)

Comments

1850 Switch Series JL169A All Unlisted models do not have
SFP+ ports.

2530 Switch Series J9853A

J9854A

J9855A

J9856A

All Unlisted models do not have
SFP+ ports.

2540 Switch Series JL354A

JL355A

JL356A

JL357A

All (J9281B/J9281D and J9283B/
J9283D only. See comments for
exception)

J9285B/J9285D or any type
of 7m DAC are not supported
in any of these series

2910al Switch Series J9145A

J9146A

J9147A

J9148A

W.14.28 For use in the J9008A 2-port
10GbE SFP+ al module.

2920 Switch Series J9726A

J9727A

J9728A

J9729A

J9836A

All The SFP ports on the models
listed do not support these
10G SFP+ cables. For use in
an installed J9731A Aruba
2920 2-port 10GbE SFP+ .

Table Continued
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Product name SKU Minimum software required
(J9281B/J9281D, J9283B/J9283D,
J9285B/J9285D)

Comments

2930F Switch Series JL253A

JL254A

JL255A

JL256A

JL258A

JL263A

JL264A

JL558A

JL559A

All (J9281B/J9281D and J9283B/
J9283D only. See comment for
exception)

Unlisted models do not have
10G SFP+ ports.

J9285B/J9285D or any type
of 7m DAC are not supported
in any of these series.

2930M Switch Series JL319A

JL320A

JL321A

JL322A

JL323A

JL324A

All For use in an installed
JL083A Aruba 3810M/2930M
4SFP+ MACsec Module

J9285B/9285D (7m DAC) is
supported in all 2930M
models.

3500yl Switch Series J8692A

J8693A

J9310A

J9311A

K.14.50 For use in an installed
J9312A 10GbE 2-port SFP
+/2-port CX4 yl Module.

3800 Switch Series J9575A

J9576A

J9573A

J9574A

J9584A

All Unlisted models not do not
have SFP+ ports.

3810M Switch Series JL071A

JL072A

JL073A

JL074A

JL076A

All For use in an installed
JL083A Aruba 3810M/2930M
4SFP+ MACsec Module.

JL075A All For use in the JL075A SFP+
ports or used in an installed
JL083A Aruba 3810M/2930M
4SFP+ MACsec Module.

5400zl Switch Series J9309A K.14.39

Table Continued
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Product name SKU Minimum software required
(J9281B/J9281D, J9283B/J9283D,
J9285B/J9285D)

Comments

J9538A

J9548A

J9536A

K.15.02.0004

5400R Switch Series J9538A

J9548A

J9536A

All

J9990A

J9993A

KB.15.17

6120 Switch Series 516733-B21 All

6200yl Switch Series J8992A K.14.50 J8992A fixed SFP ports are
1GB and do not support
these SFP+ copper
cables.For use in an installed
J9312A 10GbE 2-port SFP
+/2-port CX4 yl Module.

6600 Switch Series J9264A

J9265A

J9452A

K.14.32

8200zl Switch Series J9309A K.14.39

J9538A

J9548A

J9536A

K.15.02.0004

Table Continued
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Product name SKU Minimum software required
(J9281B/J9281D, J9283B/J9283D,
J9285B/J9285D)

Comments

Aruba 8320 48p 10G
SFP/SFP+ and 6p
40G QSFP+ Switch

JL479A All (J9281B/J9281D and J9283B/
J9283D only. See comment for
exception.)

Only the following 4x4 part
numbers are supported:

• J9281B/J9281D: 8121-1151,
8121-1300

• J9283B/J9283D: 8121-1152,
8121-1298

J9285B/J9285D or any type
of 7m DAC are not supported
in the JL479A 8320 model.

Aruba 8400X 32p 10G
SFP/SFP+ Msec
Module

JL363A All Only the following 4x4 part
numbers are supported:
• J9281B/J9281D:

8121-1151, 8121-1300

• J9283B/9283D:
8121-1152, 8121-1298

• J9285B/J9285D:
8121-1154, 8121-1305
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Gigabit SFP optical transceiver modules
In December 2017, Aruba introduced Revision D versions of 100M, 1G, and 10G transceivers. Revision D
products are structured to be specific alternative vendors as sources for the SKU#. Earlier Revision A, B, or C
product may have alternative vendors that we no longer actively ship, but remain as fully supported in earlier and
current products.

Some switch products will be specifying Revision D transceivers for full support, while other products may support
earlier (older) revision transceivers – and some with specific 4x4 part numbers (see Chapter 1, "Overview" for
information regarding 4x4 part numbers).

Always refer to the Datasheet or QuickSpecs for the Switch product to see the current list of supported
transceivers.

Figure 14: Gigabit or 100-Megabit SFP optical transceiver module

NOTE: 

• Although a 10G SFP+ transceiver module has the same physical dimensions of a 1G SFP
transceiver, a 10G transceiver will NOT operate in a 1G SFP port.

• Many, although not all, 10G SFP+ ports have support to use a 1G SFP transceiver (or even a
100Mbps FX SFP transceiver). See the QuickSpec for the Switch product and verify if the 1G or
100Mbps SFP transceiver is supported in the 10G SFP+ port.

Models, specifications, and compatibility
Gigabit SFP optical transceiver modules use LC connectors.

The specifications for Revision D transceiver products are the same as the specified Revision A, B, and C SKUs.
Where support for a Revision A, B, or C transceiver existed, Revision D parts are also supported.

Chapter 5
SFP modules
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Table 30: Specifications for Gigabit SFP optical transceiver modules (1)

Product name
(SKU)

DOM - Digital
Optical
Monitoring
(4x4 part #)

Central wl
(nm)

Fiber
mode

Fiber
diameter
(µm)

Modal
bandwidth
(MHz*km)

Transmission
distance

HPE X121 1G SFP
LC SX Transceiver
(J4858C)

Aruba 1G SFP LC
SX 500m MMF
XCVR (J4858D)

Yes

(1990-4395 &
1990-4415)

850 MMF 50/125 500 (OM2)

400

550 m (1804.46 ft)

500 m (1640.42 ft)

62.5/125 200 (OM1)

160

275 m (902.23 ft)

220 m (721.78 ft)

HPE X121 1G SFP
LC LX Transceiver
(J4859C)

Aruba 1G SFP LC
LX 10km SMF
XCVR (J4859D)

Yes

(1990-4116,
1990-4414, &
1990-4608)

1310 SMF 9/125 N/A 10 km (6.21 miles)

MMF 50/125 500 or 400 550 m (1804.46 ft)

MMF 62.5/125 500 550 m (1804.46 ft)

HPE X121 1G SFP
LC LH Transceiver
(J4860C)

Aruba 1G SFP LC
LH 70km SMF
XCVR (J4860D)

Yes

(1990-4363)

1550 SMF 9/125 N/A 70 km (43.49
miles)

Table 31: Specifications for Gigabit SFP optical transceiver modules (2)

Product name (SKU) Optical parameters (dBm)

Transmit power Receive power

HPE X121 1G SFP LC SX Transceiver (J4858C)

Aruba 1G SFP LC SX 500m MMF XCVR (J4858D)

–9.5 to 0 –17 to –3

HPE X121 1G SFP LC LX Transceiver (J4859C)

Aruba 1G SFP LC LX 10km SMF XCVR (J4859D)

–9.5 to –3 –20 to –3

HPE X121 1G SFP LC LH Transceiver (J4860C)

Aruba 1G SFP LC LH 70km SMF XCVR (J4860D)

0 to +5 –22 to –3
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Table 32: Compatibility for Gigabit SFP optical transceiver modules

Product name SKU Minimum software required
(J4858C/J4858D, J4859C/J4859D,
J4860C/J4860D)

Comments

1400 Switch Series J9078A All

1410 Switch Series J9561A All

1700 Switch Series J9080A VB.01.09

1800 Switch Series J9028A/B PB.02.09

1810 Switch Series J9450A

J9660A

J4858C/J4858D: All

J4859C/J4859D: All

Gig LH (J4850C/
J4860D) is supported
only in the J9450A
model.

J9801A

J9803A

J9834A

J4858C/J4858D: All

J4859C/J4859D: All

Gig LH (J4860C/
J4860D) is not
supported.

1820 Switch Series J9980A

J9981A

J9983A

J9984A

J4858C/J4858D: All

J4859C/J4859D: All

J4860C/J4860D: Not supported

Gig LH (J4860C/
J4860D) is not
supported on the 1820
series.

1850 Switch Series JL169A J4858C/JL4858D: All

J4859C/J4859D: All

J4860C/J4860D: Not supported

Gig LH (J4860C/
J4860D) is not
supported on the 1850
series. Other 1850
models not listed do not
have SFP ports.

1920S JL381A

JL382A

JL384A

JL385A

JL386A

J4858C/J4858D: All

J4859C/J4859D: All

J4860C/J4860D: Not supported

Gig LH (J4860C/
J4860D) is not
supported on the 1920S
series.

Models JL380A and
JL383A do not include
SFP ports.

2510 Switch Series J9019A/B

J9020A

J9279A

J9280A

All

2520 Switch Series J9137A

J9138A

J9298A

J9299A

All

Table Continued
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Product name SKU Minimum software required
(J4858C/J4858D, J4859C/J4859D,
J4860C/J4860D)

Comments

2530 Switch Series J9772A

J9773A

J9774A

J9775A

J9776A

J9777A

J9778A

J9779A

J9780A

J9781A

J9782A

J9783A

J9853A

J9854A

J9855A

J9856A

All

2540 Switch Series JL354A

JL355A

JL356A

JL357A

All

2600 Switch Series J4899A/B/C

J4900A/B/C

J8164A

J8165A

J8762A

H.08.98

2610 Switch Series J9085A

J9086A

J9087A

J9088A

J9089A

All

2615-8-PoE Switch J9565A All

Table Continued

38 ArubaOS-Switch and ArubaOS-CX Transceiver Guide

Anexo 01 ITEM 15 (0592747)         SEI 0008478-63.2018.6.02.8000 / pg. 8332



Product name SKU Minimum software required
(J4858C/J4858D, J4859C/J4859D,
J4860C/J4860D)

Comments

2620 Switch Series J9623A

J9624A

J9625A

J9626A

J9627A

All

2800 Switch Series J4903A

J4904A

i.08.103

2810 Switch Series J9021A

J9022A

All

2900 Switch Series J9049A

J9050A

T.13.45

2910al Switch Series J9145A

J9146A

J9147A

J9148A

All For use in the SFP ports
on the models listed, and
in the J9008A 2-port
10GbE SFP+ al module.

2915-8G-PoE Switch J9562A All

2920 Series Switches J9726A

J9727A

J9728A

J9729A

J9836A

All For use in the SFP ports
on the models listed.
Also for use in the dual-
speed SFP+ ports of the
J9731A 2-Port 10GbE
SFP+ Module.

Table Continued
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Product name SKU Minimum software required
(J4858C/J4858D, J4859C/J4859D,
J4860C/J4860D)

Comments

2930F Series Switches JL253A

JL254A

JL255A

JL256A

JL258A

JL259A

JL260A

JL261A

JL262A

JL263A

JL264A

JL557A

JL558A

JL559A

All

2930M Switch Series JL319A

JL320A

JL321A

JL322A

JL323A

JL324A

All For use in SFP ports on
switch and an installed
JL083A Aruba 3810M/
2930M 4SFP+ MACsec
Module.

3400cl Switch Series J4905A

J4906A

All

3500 Series Switches J9470A

J9471A

J9472A

J9473A

K.14.31

3500yl Switch Series J8692A

J8693A

All For use in the SFP ports
on the models listed, and
in an installed J9312A
10GbE 2-port SFP+/2-
port CX4 yl Model

J9310A

J9311A

K.14.50

Table Continued
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Product name SKU Minimum software required
(J4858C/J4858D, J4859C/J4859D,
J4860C/J4860D)

Comments

3800 Switch Series J9573A

J9574A

J9575A

J9576A

J9584A

All

3810M Switch Series JL071A

JL072A

JL073A

JL074A

JL076A

JL075A

All For use in the JL075A
3810M switch. Also for
use in any 3810M switch
with a JL083A Aruba
3810M/2930M 4SFP+
MACsec Module
installed.

4200gl Switch Series J4893A

J4908A

G.07.103

4200vl Switch Series J8776A

J9033A

All

5300xl Switch Series J4878A/B

J4907A

E.10.36

5400zl Switch Series J8705A

J8706A

All

J9308A K.14.34

J9537A

J9549A

J9535A

J9637A

J9538A

J9548A

J9536A

K.15.02.0004

Table Continued
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Product name SKU Minimum software required
(J4858C/J4858D, J4859C/J4859D,
J4860C/J4860D)

Comments

5400R Switch Series J9537A

J9549A

J9535A

J9637A

J9538A

J9548A

J9536A

All

J9988A

J9989A

J9990A

J9993A

KB.15.17

6108 Switch J4902A H.07.88

6120 Switch Series 498358-B21

516733-B21

SX, LX: all versions

LH: not supported

6200yl-24G-mGBIC Switch J8992A All

6600 Switch Series J9263A

J9264A

K.14.03

J9451A K.14.24

8100fl Switch J8735A All

8200zl Switch Series J8705A

J8706A

All

J9308A K.14.34

J9537A

J9549A

J9535A

J9637A

J9538A

J9548A

J9536A

K.15.02.0004

Table Continued
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Product name SKU Minimum software required
(J4858C/J4858D, J4859C/J4859D,
J4860C/J4860D)

Comments

Aruba 8320 48p 10G
SFP/SFP+ and 6p 40G QSFP
+ Switch

JL479A All Only the following 4x4
part numbers are
supported:

• J4858C/J4858D:
1990-4395, 1990-4415

• J4859C/J4859D:
1990-4116, 1990-4414

• J4860C/J4860D:
1990-4363

Aruba 8400X 32p 10G
SFP/SFP+ Msec Module

JL363A All Only the following 4x4
part numbers are
supported:
• • J4858C/J4858D:

1990-4395,
1990-4415

• • J4859C/J4859D:
1990-4116,
1990-4414

• • J4860C/J4860D:
1990-4363

9300m Switch Series J4885A

J4894A

All

9408sl Switch J8684A All

100-Megabit SFP optical transceiver modules
Figure 15: Gigabit or 100-Megabit SFP optical transceiver module

Models, specifications, and compatibility
100 Megabit SFP optical transceiver modules use LC connectors.

The specifications for Revision D transceiver products are the same as the specified Revision A, B, and C SKUs.
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Table 33: Specifications for 100-Megabit SFP optical transceiver modules (1)

Product name (SKU) DOM - Digital
Optical
Monitoring (4x4
part #)

Central wl
(nm)

Fiber
mode

Fiber diameter
(µm)

Transmission
distance

HPE X111 100M SFP
LC FX Transceiver
(J9054C)

Aruba 100M SFP LC
FX 2km MMF XCVR
(J9054D)

Yes

(1990-4483,
1990-4360)

1310 MMF 50/125

62.5/125

2 km (1.24 miles)

Table 34: Specifications for 100–Megabit SFP optical transceiver modules (2)

Product name (SKU) Optical parameters (dBm)

Transmit power Receive power

HPE X111 100M SFP LC FX Transceiver
(J9054C)

Aruba 100M SFP LC FX 2km MMF XCVR
(J9054D)

–19 to –14 –30 to –14

Table 35: Compatibility for the 100-Megabit SFP optical transceiver module

Product name SKU Minimum software required Comments

1410G Switch Series J9559A

J9560A

J9561A

J9559A, J9560A: Not supported (no
SFP ports)

J9561A: All

For use in the SFP ports of the
J9561A 1410-24G Switch

1810G Series
Switches

J9450A

J9660A

For J9450A, J9660A: All For use in the SFP ports of the
J9450A 1810G-24 Switch and
J9660A V1810-48G Switch. (The
J9449A 1810G-8 Switch does not
have SFP ports.)

1810G v2 Switch
Series

J9801A

J9803A

All For use in the SFP ports of the
J9801A 1810-24 v2 and J9803A
1810-24G v2 Switches

PS1810 Switch J9834A All For use in the SFP ports of the
J9834A PS1810-24G Switch

Table Continued
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Product name SKU Minimum software required Comments

1820 Switch Series J9980A

J9981A

J9983A

J9984A

All The J9054B 100-FX SFP-LC
transceiver is not supported in the
1820G switches

The J9054C part number
1990-4483 is not supported in
these products.

(Only the J9054C/J9054D part
number 1990-4360 is supported.)

2510-24 Switch J9019A/B Q.10.04

2510-48 Switch J9020A All

2510G Switch Series J9279A

J9280A

All

2520 Switch Series J9137A

J9138A

All

2520G Switch Series J9298A

J9299A

J9054B: All

J9054C: J.14.32

2530 Switch Series J9772A

J9773A

J9774A

J9775A

J9776A

J9777A

J9778A

J9779A

J9780A

J9781A

J9782A

J9783A

J9853A

J9854A

J9855A

J9856A

For J9853A, J9854A, J9855A, and
J9856A: Not supported

For all other switches: All

For use in the SFP ports of the
2530 Series Switches. (The
J9853A, J9854A, J9855A, and
J9856A models have 1G/10G
SFP+ ports that do not support
these 100Mbps transceiver
modules.)

Table Continued
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Product name SKU Minimum software required Comments

2540 Switch Series JL354A

JL355A

JL356A

JL357A

All

2610 Switch Series J9085A

J9086A

J9087A

J9088A

J9089A

All

2615-8-PoE Switch J9565A J9054B: All J9054C: A.14.07

2620 Switch Series J9623A

J9624A

J9625A

J9626A

J9627A

All

2800 Switch Series J4903A

J4904A

J9054B/C 1990-3613 and J9054C
1990-4112: i.10.30

J9054C 1990-4483: Not supported

J9054C part number 1990-4483 is
not supported

2810 Switch Series J9021A

J9022A

N.10.07

2900 Switch Series J9049A

J9050A

T.12.01

2910al Switch Series J9145A

J9146A

J9147A

J9148A

All

2915-8G-PoE Switch J9562A J9054B: All

J9054C/J9054D: A.14.07

Table Continued
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Product name SKU Minimum software required Comments

2920 Series
Switches

J9726A

J9727A

J9728A

J9729A

J9836A

All Use in the SFP ports of the 2920
Series Switches.

100-FX is not supported in the
SFP+ ports of the J9731A 2-Port
10GbE SFP+ Module

2930F Switch Series JL253A

JL254A

JL255A

JL256A

JL258A

JL263A

JL264A

JL259A

JL260A

JL261A

JL262A

JL557A

JL558A

JL559A

J9054B: is not supported in the
2930F Series Switches

For J9054C/9054D: All

The 2930F Switch Series models
with 1G/10G SFP+ ports added
support for this J9054C/J9054D
100FX transceiver. The J9054C/
J9054D are supported in models
with 1G SFP ports.

2930M Switch Series JL319A

JL320A

JL321A

JL322A

JL323A

JL324A

J9054B is not supported in the
2930M Series Switches.

For J9054C/J9054D: All

For use in SFP ports on switch
and an installed JL083A Aruba
3810M/2930M 4SFP+ MACsec
Module.

3500 Series
Switches

J9470A

J9471A

J9472A

J9473A

J9054B/C 1990-3613: K.14.31

J9054C 1990-4112 and 1990-4483:
K.15.08.0007

J9054D: K.15.08.0007

Table Continued
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Product name SKU Minimum software required Comments

3500yl Switch Series J8692A

J8693A

J9310A

J9311A

For J8692A, J8693A: K.12.01 (for
J9054B/C 1990-3613); K.15.08.0007
(for J9054C 1990-4112 and
1990-4483, and J9054D 1990-4483
and 1990-4360)

For J9310A, J9311A: K.14.50 (for
J9054B/C 1990-3613); K.15.08.0007
(for J9054C 1990-4112 and
1990-4483, and J9054D)

3800 Switch Series J9573A

J9574A

J9575A

J9576A

J9584A

For J9573A, J9574A, J9575A,
J9576A: Not supported.

For J9584A: All

Not supported for use in the
following 3800 models: J9573A,
J9574A, J9575A, and J9576A.
The SFP+ ports do not support
100M operation.

Supported in the J8584A
3800-24SFP-2SFP+ Switch

3810M Switch Series JL071A

JL072A

JL073A

JL074A

JL076A

All For use in an installed JL083A
Aruba 3810M/2930M 4SFP+
MACsec Module.

JL075A All For use in the JL075A SFP+
ports. Also used in an installed
JL083A Aruba 3810M/2930M
4SFP+ MACsec Module.

4100gl Switch Series J4865A

J4887A

n/a J9054C/J9054D 100FX is not
supported.

4200vl Switch Series J8770A

J8771A

J8772A/B

J8773A

L.10.24 Supported: J9033A Switch vl 20-
Port Gig-T + 4-Port SFP Module

Not supported: J8776A Switch vl
4-Port Mini-GBIC Module

5300xl Switch Series J4819A

J4850A

n/a J9054C/J9054D 100FX is not
supported.

Table Continued
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Product name SKU Minimum software required Comments

5400zl Switch Series J8697A

J8698A

J9642A

J9643A

For J8705A and J8706A modules: K.
12.01 (for J9054B/C 1990-3613); K.
15.08.0007 (for J9054C 1990-4112
and 1990-4483) J9054D: K.
15.08.0007

For the J9308A module: K.14.34 (for
J9054B/C 1990-3613); K.15.08.0007
(for J9054C 1990-4112 and
1990-4483) J9054D: K.15.08.0007

For J9537A, J9549A, J9535A, and
J9637A modules: K.15.02.0004 (for
J9054B/C 1990-3613); K.15.08.0007
(for J9054C 1990-4112 and
1990-4483) J9054D: K.15.08.0007

For use in:

J8705A Switch zl 20-Port
10/100/1000 + 4-Port Mini-GBIC
Module

J8706A Switch zl 24-Port Mini-
GBIC Module

J9308A 20-Port 10/100/1000 PoE
+ and 4-Port SFP zl Module

J9537A 24-Port SFP v2 zl Module

J9549A 20- Port Gig-T / 4-Port
SFP v2 zl Module

J9535A 20-Port Gig-T PoE+ / 4-
Port SFP v2 zl Module

J9637A 12-Port Gig- T PoE+ / 12-
Port SFP v2 zl Module

5400R Switch Series J9821A

J9822A

J9823A

J9824A

J9825A

J9826A

J9868A

For J9535A, J9537A, J9549A, and
J9637A modules: All

For the J9988A, J9989A, J9990A,
and J9993A modules: KB.15.17 and
later

For use in:

J9537A 24-Port SFP v2 zl Module

J9549A 20-Port Gig-T / 4-Port
SFP v2 zl Module

J9535A 20-Port Gig-T PoE+ / 4-
Port SFP v2 zl Module

J9637A 12-Port Gig-T PoE+ / 12-
Port SFP v2 zl Module

J9988A 24p 1GbE SFP v3 zl2
Module

J9989A 12p PoE+ / 12p 1GbE
SFP v3 zl2 Module

J9990A 20p PoE+ / 4p SFP+ v3
zl2 Module

J9993A 8p 1G/10GbE SFP+ v3
zl2 Module

6108 Switch J4902A n/a 100-FX is not supported

6120 Blade Switch
Series

498358-B21

516733-B21

n/a 100-FX is not supported

6200yl-24G-mGBIC
Switch

J8992A K.12.01 (for J9054B/C 1990-3613);
K.15.08.0007 (for J9054C 1990-4112
and 1990-4483) J9054D: K.
15.08.0007

For use in all 24 ports of the
J8992A Switch 6200yl- 24G-
mGBIC
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Product name SKU Minimum software required Comments

6600 Switch Series J9263A

J9264A

J9265A

J9451A

J9452A

For J9263A, J9264A: K.14.03 (for
J9054B/C 1990-3613); K.15.08.0007
(for J9054C 1990-4112 and
1990-4483)

For J9451A: K.14.24 (for J9054B/C
1990-3613); K.15.08.0007 (for
J9054C 1990-4112 and 1990-4483)
J9054D: K.15.08.0007

For use in the SFP ports of the
J9263A 6600-24G Switch, the
J9264A 6600-24G-4XG Switch,
and the J9451A 6600-48G Switch

(The J9265A 6600-24XG Switch
and J9452A 6600- 48G-4XG
Switch do not have SFP ports)

8100fl Switch Series J8727A

J8728A

n/a 100-FX is not supported

8200zl Switch Series J8715A/B

J9475A

J9640A

J9641A

For J8705A and J8706A modules: All
(for J9054B/C 1990-3613); K.
15.08.0007 (for J9054C 1990-4112
and 1990-4483) J9054D: K.
15.08.0007

For the J9308A module: K.14.34 (for
J9054B/C 1990-3613); K.15.08.0007
(for J9054C 1990-4112 and
1990-4483) J9054D: K.15.08.0007

For J9537A, J9549A, J9535A, and
J9637A modules: K.15.02.0004 (for
J9054B/C 1990-3613); K.15.08.0007
(for J9054C 1990-4112 and
1990-4483) J9054D: K.15.08.0007

For use in:

J8705A Switch zl 20-Port
10/100/1000 + 4-Port Mini-GBIC
Module

J8706A Switch zl 24-Port Mini-
GBIC Module

J9308A 20-Port 10/100/1000 PoE
+ and 4-Port SFP zl Module

J9537A 24-Port SFP v2 zl Module

J9549A 20- Port Gig-T / 4-Port
SFP v2 zl Module

J9535A 20-Port Gig-T PoE+ / 4-
Port SFP v2 zl Module

J9637A 12-Port Gig- T PoE+ / 12-
Port SFP v2 zl Module

8320 Series All n/a 100Mbps Transceivers are NOT
supported in the 8320 series.

8400 Series All n/a 100Mbps Transceivers are NOT
supported in the 8400 series.

9300m Switch Series J4138A

J4139A

J4874A

n/a 100-FX is not supported.

9408sl Switch J8680A n/a 100-FX is not supported
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Gigabit BIDI optical transceiver modules
Figure 16: Gigabit BIDI optical transceiver module

Models, specifications, and compatibility
Gigabit BIDI optical transceiver modules provide a transmission rate of 1250 Mbps and use LC connectors.

NOTE:

• BIDI optical transceiver modules use different central wavelengths in transmit and receive
directions to implement bidirectional transmission of fiber signals over the same fiber.

• You must use the HPE X122 1G SFP LC BX 10-D Transceiver (J9142B) and HPE X122 1G SFP
LC BX 10-U Transceiver (J9143B) in pairs: a J9142B (-D = downlink) at one end of the
connection and a J9143B (-U = uplink) at the other.

• The J9142B/J9143B were End of Sale in April 2016 and are no longer available. Contact your
Aruba Sales team for alternative solutions. The information presented here is for compatibility
use.

Table 36: Specifications for Gigabit BIDI optical transceiver modules (1)

Product name
(SKU)

DOM - Digital
Optical
Monitoring (4x4
part #)

Central wavelength (nm) Fiber
mode

Fiber
diameter
(µm)

Transmission
distance

Transmit
end (TX)

Receive
end (RX)

HPE X122 1G SFP
LC BX-D Transceiver
(J9142B)

No 1490 1310 SMF 9/125 10 km (6.21
miles)

HPE X122 1G SFP
LC BX-U Transceiver
(J9143B)

No 1310 1490
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Table 37: Specifications for Gigabit BIDI transceiver modules (2)

Product name (SKU) Optical parameters
(dBm)

Transmit power Receive power

HPE X122 1G SFP LC BX-D Transceiver (J9142B)

HPE X122 1G SFP LC BX-U Transceiver (J9143B)

–9 to –3 –18.7 to –3

Table 38: Compatibility for Gigabit BIDI transceiver modules

Product name SKU Minimum software
required (J9142B,
J9143B)

Comments

1400 Switch Series J9078A All

1410 Switch Series J9561A All

1700 Switch Series J9080A VB.02.00

1800 Switch Series J9028A/B PB.03.00

2510-24 Switch J9019A/B Q.11.16

2510-48 Switch J9020A U.11.10

2510G–24 Switch J9279A Y.11.03

2510G–48 Switch J9280A Y.11.03

2520 Switch Series J9137A

J9138A

J9298A

J9299A

All

Table Continued
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Product name SKU Minimum software
required (J9142B,
J9143B)

Comments

2530 Switch Series J9772A

J9773A

J9774A

J9775A

J9776A

J9777A

J9778A

J9779A

J9780A

J9781A

J9782A

J9783A

J9853A

J9854A

J9855A

J9856A

All

2540 Switch Series JL354A

JL355A

JL356A

JL357A

n/a 1G BX is not officially supported for
use in the 2540 series.

2600 Switch Series J4899A/B/C

4900A/B/C

J8164A

J8165A

J8762A

H.10.72

2610 Switch Series J9085A

J9086A

J9087A

J9088A

J9089A

R.11.22

2615-8-PoE Switch J9565A All

Table Continued
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Product name SKU Minimum software
required (J9142B,
J9143B)

Comments

2620 Switch Series J9623A

J9624A

J9625A

J9626A

J9627A

All

2800 Switch Series J4903A

J4904A

i.10.69

2810 Switch Series J9021A

J9022A

N.11.14

2900 Switch Series J9049A

J9050A

T.13.45

2910al Switch Series J9145A

J9146A

J9147A

J9148A

All

2915-8G-PoE Switch J9562A All

2920 Series Switches J9726A

J9727A

J9728A

J9729A

J9836A

All

Table Continued

54 ArubaOS-Switch and ArubaOS-CX Transceiver Guide

Anexo 01 ITEM 15 (0592747)         SEI 0008478-63.2018.6.02.8000 / pg. 8348



Product name SKU Minimum software
required (J9142B,
J9143B)

Comments

2930F Series Switches JL253A

JL254A

JL255A

JL256A

JL258A

JL259A

JL260A

JL261A

JL262A

JL263A

JL264A

Supported for use by
a future software
version.

As of April 2016, the J9142B and
J9143B 1G BX transceivers have been
End of Sale. Contact your Aruba
representative for alternative solutions.

2930M Switch Series JL319A

JL320A

JL321A

JL322A

JL323A

JL324A

See comments. As of April 2016, the J9142B and
J9143B 1G BX transceivers have been
End of Sale. Contact your Aruba
representative for alternative solutions.

3500 Series Switches J9470A

J9471A

J9472A

J9473A

K.14.31

3500yl Switch Series J8692A

J8693A

K.14.31

J9310A

J9311A

K.14.50

3800 Switch Series J9573A

J9574A

J9575A

J9576A

J9584A

All

Table Continued
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Product name SKU Minimum software
required (J9142B,
J9143B)

Comments

3810M Switch Series JL071A

JL072A

JL073A

JL074A

JL076A

All As of April 2016, the J9142B and
J9143B 1G BX transceivers have been
End of Sale. Contact your Aruba
representative for alternative solutions.

For use in the JL075A 3810M switch
or in any 3810M switch with a JL083A
Aruba 3810M/2930M 4SFP+ MACsec
Module installed.

JL075A All

4200vl Switch Series J8776A

J9033A

L.11.16

5300xl Switch Series J4878A/B

J4907A

E.11.08

5400zl Switch Series J8705A

J8706A

K.13.45

J9308A K.14.34

J9537A

J9549A

J9535A

J9637A

J9538A

J9548A

J9536A

K.15.02.0004

5400R Switch Series J9537A

J9549A

J9535A

J9637A

J9538A

J9548A

J9536A

All As of April 2016, the J9142B and
J9143B 1G BX transceivers have been
End of Sale. Contact your Aruba
representative for alternative solutions.

Table Continued
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Product name SKU Minimum software
required (J9142B,
J9143B)

Comments

J9988A

J9989A

J9990A

J9993A

KB.15.17

6200yl-24G-mGBIC Switch J8992A K.13.45

6600 Switch Series J9263A

J9264A

K.14.03

J9451A K.14.24

8200zl Switch Series J8705A

J8706A

K.13.45

J9308A K.14.34

J9537A

J9549A

J9535A

J9637A

J9538A

J9548A

J9536A

K.15.02.0004

8320 Series JL479A,
JL579A

n/a 1G BX Transceivers are NOT
supported in the 8320 series.

8400 Series All n/a 1G BX Transceivers are NOT
supported in the 8400 series.

Gigabit SFP copper transceiver modules
Figure 17: Gigabit SFP copper transceiver module
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Models, specifications, and compatibility
Table 39: Specifications for SFP copper transceiver modules

Product name (SKU) Transmission
distance

Data rate Cable type Connector
type

HPE X121 1G SFP RJ45 T
Transceiver (J8177C)

Aruba 1G SFP RJ45 T 100m Cat5e
XCVR (J8177D)

100 m (328.08 ft) 1G

100Mbps1

Cat5e
UTP/STP

RJ-45

1 For certain products. See next table.

Table 40: Compatibility for SFP copper transceiver modules

The specifications for Revision D transceiver products are the same as the specified Revision A, B, and C SKUs.

Product name SKU Minimum software
required (J8177C/
J8177D)

Comments

1810 Series Switches J9660A

J9801A

J9803A

J9834A

All

1820 Switch Series J9980A

J9981A

J9983A

J9984A

All

1920S Switch Series JL381A

JL382A

JL384A

JL385A

JL386A

Not supported The JL380A and JL383A
switches do not include SFP
ports.

2510 Switch J9020A All

Table Continued
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Product name SKU Minimum software
required (J8177C/
J8177D)

Comments

2530 Switch Series J9782A

J9781A

J9776A

J9775A

J9779A

J9778A

J9773A

J9772A

J9856A

J9855A

J9854A

J9853A

All

2540 Switch Series JL354A

JL355A

JL356A

JL357A

All

2610 Switch Series J9085A

J9086A

J9087A

J9088A

J9089A

All

2620 Switch Series J9623A

J9624A

J9625A

J9626A

J9627A

All

2920 Series Switches J9731A All

Table Continued
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Product name SKU Minimum software
required (J8177C/
J8177D)

Comments

2930F Series Switches JL253A, JL254A

JL255A

JL256A

JL258A

JL259A

JL260A

JL261A

JL262A

JL263A

JL264A

JL557A

JL558A

JL559A

All J8177C/J8177D support both
100Mbps and 1G operation in
this Switch Series.

2930M Switch Series JL319A

JL320A

JL321A

JL322A

JL323A

JL324A

All J8177C is not supported for
use in the Dual-Personality
ports of the 2930M Series
Switches.

For use in an installed JL083A
Aruba 3810M/2930M 4SFP+
MACsec Module.

J8177C/J8177D support both
100Mbps and 1G operation in
this Switch Series.

3800 Switch Series J9573A

J9574A

J9575A

J9576A

J9584A

All

3810M Switch Series JL071A

JL072A

JL073A

JL074A

JL076A

All For use in the JL075A 3810M
switch. Also used in any
3810M switch with a JL083A
Aruba 3810M/2930M 4SFP+
MACsec Module installed.

J8177C/J8177D support both
100Mbps and 1G operation in
this Switch Series.

Table Continued
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Product name SKU Minimum software
required (J8177C/
J8177D)

Comments

JL075A All

4100gl Switch Series J4893A

J4908A

G.07.69

4200vl Switch Series J8776A

J9033A

All

5300xl Switch Series J4878A/B E.09.22

5400zl Switch Series J8705A

J8706A

All

J9308A K.14.34

J9537A

J9549A

J9535A

J9637A

K.15.02.0004

5400R Switch Series J9537A

J9549A

J9535A

J9637A

All J8177C/J8177D support both
100Mbps and 1G operation in
this Switch Series.

J9988A

J9989A

J9990A

J9993A

KB.15.17 J8177C/J8177D support both
100Mbps and 1G operation in
this Switch Series.

6120 Blade Switch Series 498358-B21

516733-B21

All

6200yl-24G-mGBIC Switch J8992A All

8100fl Switch Series J8735A CY.01.02.0050

8200zl Switch Series J8705A

J8706A

All

J9308A K.14.34

Table Continued
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Product name SKU Minimum software
required (J8177C/
J8177D)

Comments

J9537A

J9549A

J9535A

J9637A

K.15.02.0004

Aruba 8320 48p 10G SFP/SFP+
and 6p 40G QSFP+ Switch

JL479A All 100Mbps operation is NOT
supported in this series.

Only the 1G Copper 4x4
numbers 1990-3816 and
1990-4606 are supported for
use in the 8320 and 8400
Series.

Aruba 8400X 32p 10G SFP/SFP+
Msec Module

JL363A All
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Networking Websites
Hewlett Packard Enterprise Networking Information Library

www.hpe.com/networking/resourcefinder

Hewlett Packard Enterprise Networking Software

www.hpe.com/networking/software

Hewlett Packard Enterprise Networking website

www.hpe.com/info/networking

Hewlett Packard Enterprise My Networking website

www.hpe.com/networking/support

Hewlett Packard Enterprise My Networking Portal

www.hpe.com/networking/mynetworking

Hewlett Packard Enterprise Networking Warranty

www.hpe.com/networking/warranty

General websites
Hewlett Packard Enterprise Information Library

www.hpe.com/info/EIL

For additional websites, see Support and other resources.

Chapter 6
Websites
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Accessing Hewlett Packard Enterprise Support
• For live assistance, go to the Contact Hewlett Packard Enterprise Worldwide website:

http://www.hpe.com/assistance

• To access documentation and support services, go to the Hewlett Packard Enterprise Support Center website:

http://www.hpe.com/support/hpesc

Information to collect

• Technical support registration number (if applicable)

• Product name, model or version, and serial number

• Operating system name and version

• Firmware version

• Error messages

• Product-specific reports and logs

• Add-on products or components

• Third-party products or components

Accessing updates
• Some software products provide a mechanism for accessing software updates through the product interface.

Review your product documentation to identify the recommended software update method.

• To download product updates:

Hewlett Packard Enterprise Support Center
www.hpe.com/support/hpesc

Hewlett Packard Enterprise Support Center: Software downloads
www.hpe.com/support/downloads

Software Depot
www.hpe.com/support/softwaredepot

• To subscribe to eNewsletters and alerts:

www.hpe.com/support/e-updates

• To view and update your entitlements, and to link your contracts and warranties with your profile, go to the
Hewlett Packard Enterprise Support Center More Information on Access to Support Materials page:

www.hpe.com/support/AccessToSupportMaterials

Chapter 7
Support and other resources
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IMPORTANT: Access to some updates might require product entitlement when accessed through
the Hewlett Packard Enterprise Support Center. You must have an HPE Passport set up with
relevant entitlements.

Customer self repair
Hewlett Packard Enterprise customer self repair (CSR) programs allow you to repair your product. If a CSR part
needs to be replaced, it will be shipped directly to you so that you can install it at your convenience. Some parts
do not qualify for CSR. Your Hewlett Packard Enterprise authorized service provider will determine whether a
repair can be accomplished by CSR.

For more information about CSR, contact your local service provider or go to the CSR website:

http://www.hpe.com/support/selfrepair

Remote support
Remote support is available with supported devices as part of your warranty or contractual support agreement. It
provides intelligent event diagnosis, and automatic, secure submission of hardware event notifications to Hewlett
Packard Enterprise, which will initiate a fast and accurate resolution based on your product's service level.
Hewlett Packard Enterprise strongly recommends that you register your device for remote support.

If your product includes additional remote support details, use search to locate that information.

Remote support and Proactive Care information
HPE Get Connected

www.hpe.com/services/getconnected
HPE Proactive Care services

www.hpe.com/services/proactivecare
HPE Proactive Care service: Supported products list

www.hpe.com/services/proactivecaresupportedproducts
HPE Proactive Care advanced service: Supported products list

www.hpe.com/services/proactivecareadvancedsupportedproducts

Proactive Care customer information
Proactive Care central

www.hpe.com/services/proactivecarecentral
Proactive Care service activation

www.hpe.com/services/proactivecarecentralgetstarted

Warranty information
To view the warranty for your product or to view the Safety and Compliance Information for Server, Storage,
Power, Networking, and Rack Products reference document, go to the Enterprise Safety and Compliance website:

www.hpe.com/support/Safety-Compliance-EnterpriseProducts

Additional warranty information
HPE ProLiant and x86 Servers and Options

www.hpe.com/support/ProLiantServers-Warranties
HPE Enterprise Servers

www.hpe.com/support/EnterpriseServers-Warranties
HPE Storage Products

www.hpe.com/support/Storage-Warranties
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HPE Networking Products
www.hpe.com/support/Networking-Warranties

Regulatory information
To view the regulatory information for your product, view the Safety and Compliance Information for Server,
Storage, Power, Networking, and Rack Products, available at the Hewlett Packard Enterprise Support Center:

www.hpe.com/support/Safety-Compliance-EnterpriseProducts

Additional regulatory information

Hewlett Packard Enterprise is committed to providing our customers with information about the chemical
substances in our products as needed to comply with legal requirements such as REACH (Regulation EC No
1907/2006 of the European Parliament and the Council). A chemical information report for this product can be
found at:

www.hpe.com/info/reach

For Hewlett Packard Enterprise product environmental and safety information and compliance data, including
RoHS and REACH, see:

www.hpe.com/info/ecodata

For Hewlett Packard Enterprise environmental information, including company programs, product recycling, and
energy efficiency, see:

www.hpe.com/info/environment

Documentation feedback
Hewlett Packard Enterprise is committed to providing documentation that meets your needs. To help us improve
the documentation, send any errors, suggestions, or comments to Documentation Feedback
(docsfeedback@hpe.com). When submitting your feedback, include the document title, part number, edition,
and publication date located on the front cover of the document. For online help content, include the product
name, product version, help edition, and publication date located on the legal notices page.
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PLUGNET COMÉRCIO E REPRESENTAÇÕES 

LTDA 

          
Insc. Estadual Nº. - 18.1.001.0241444-4  
C.N.P.J. Nº. - 02.213.325/0001-88  
www.plugnetshop.com.br 
plugnet@nlink.com.br 
 

 

MATRIZ – RECIFE / PE 

 

Rua General Abreu e Lima, 222, 
Rosarinho – 52041-060 
Fone/Fax: 81 3426.7006 
plugnet@plugnetshop.com.br 

 

FILIAL – JOÃO PESSOA / PB 

 

Av. Nossa Senhora dos 
Navegantes, 104 / 402 Tambaú 

Fone/Fax: 83 3226.1422 
plugnetpb@plugnetshop.com.br 

 

FILIAL – FORTALEZA / CE 

 

Av. Santos Dumont, 5335 
Sl. 817 Papicu – 60175-047 

Fone/Fax: 85 3044 0115 
plugnetce@plugnetshop.com.br 

 

 

 
 
 

SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE TECNOLOGIA PARA SWITCHS DE REDE 
 
 
Características Gerais 
 
1. Os serviços serão realizados em horário comercial (08:00 às 12:00 e das 14:00 às 18:00) de forma 
presencial ou remota conforme necessidade da CONTRATANTE; 
 
 
Implantação 
 
2. Instalação e configuração de no mínimo 10 (dez) switchs de rede, contemplando: 
3. Configuração básica de acesso a gerencia via rede; 
4. Gerência e monitoramento em MÓDULO DE GERENCIA DE REDE; 
5. Configuração de autenticação de usuários em MÓDULO DE CONTROLE DE ACESSO; 
6. Configuração de no mínimo 10 (dez) VLANs; 
7. Configuração de stacking de 2 (duas) pilhas com no máximo 4 (quatro) switchs; 
8. Configuração de agregação de links em até 10 (dez) switchs com no máximo 4 (quatro) portas por 
dispositivo. 
 
 
Transferência de Tecnologia 
 
9. O treinamento deverá ser no realizado na modalidade workshop com tarefas práticas hands- on, visando 
assim a melhor fixação dos temas abordados com foco direto na explicação da tecnologia dos produtos 
ofertados como também nas rotinas de configuração, gerenciamento, administração e operação dos mesmos, 
devendo ter duração mínima de 24 (vinte e quatro) horas onde serão abordados no mínimo os seguintes tópicos: 
 

a. Configuração inicial e acesso a gerencia; 
b. Configuração de VLANS; 
c. Configuração de autenticação de usuários em MÓDULO DE CONTROLE DE ACESSO; 
d. Configuração de empilhamento de switchs; 
e. Configuração de agregação de links; 
f. Configuração de switchs para MÓDULO DE GERENCIA DE REDE; 
g. Configuração de switchs para MÓDULO DE ANÁLISE DE TRÁFEGO. 
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PLUGNET COMÉRCIO E REPRESENTAÇÕES 

LTDA 

          
Insc. Estadual Nº. - 18.1.001.0241444-4  
C.N.P.J. Nº. - 02.213.325/0001-88  
www.plugnetshop.com.br 
plugnet@nlink.com.br 
 

 

MATRIZ – RECIFE / PE 

 

Rua General Abreu e Lima, 222, 
Rosarinho – 52041-060 
Fone/Fax: 81 3426.7006 
plugnet@plugnetshop.com.br 

 

FILIAL – JOÃO PESSOA / PB 

 

Av. Nossa Senhora dos 
Navegantes, 104 / 402 Tambaú 

Fone/Fax: 83 3226.1422 
plugnetpb@plugnetshop.com.br 

 

FILIAL – FORTALEZA / CE 

 

Av. Santos Dumont, 5335 
Sl. 817 Papicu – 60175-047 

Fone/Fax: 85 3044 0115 
plugnetce@plugnetshop.com.br 

 

 

 
 
SERVIÇOS DE IMPLANTAÇÃO E TRANSFERÊNCIA DE TECNOLOGIA DO MÓDULO DE CONTROLE DE 

ACESSO 
 
Características Gerais 
 
1. Os serviços serão realizados em horário comercial (08:00 às 12:00 e das 14:00 às 18:00) de forma 
presencial ou remota conforme necessidade da CONTRATANTE; 
 
 
Implantação 
 
2. Instalação e configuração de 1 (uma) instância do serviço controle de acesso, contemplando configurações 
básicas para acesso à rede, dimensionamento, configuração de armazenamento; 
3. Configuração de autenticação em Active Directory para usuários corporativos; 
4. Configuração de autenticação de visitantes com portal de autosserviço para criação de usuários; 
5. Configuração de no mínimo 10 (dez) dispositivos de rede para autenticação na solução. 
 
 
Transferência de Tecnologia 
 
6. O treinamento deverá ser no realizado na modalidade workshop com tarefas práticas hands- on, visando 
assim a melhor fixação dos temas abordados com foco direto na explicação da tecnologia da solução como 
também nas rotinas de configuração, gerenciamento, administração e operação da mesma devendo ter duração 
mínima de 24 (vinte e quatro) horas onde será abordado no mínimo os seguintes tópicos: 
 
a. Configuração de Active Directory como base de autenticação; 
b. Configuração de autenticação de usuários corporativos; 
c. Configuração de autenticação de usuários visitantes; 
d. Configuração de portal de autosserviço; 
e. Configuração de autenticação e autorização com RADIUS. 

Anexo 01 ITEM 17 (0592750)         SEI 0008478-63.2018.6.02.8000 / pg. 8362



Course Data Sheet

Course ID 01077931

HPE product
number

H0LL1

Course format,
Typical duration

Select one:
VILT - Virtual Instructor Led, 3 days
ILT - Instructor Led, 3 days
WBT - Web Based, Self Paced, 3 days

Skill level Foundational

Delivery
languages

English

Lab required Yes

Related
certifications

Aruba Certified Switching Associate (ACSA) V1
Aruba Certified Switching Associate (ACSA) V1
- upgrade from HPE ATP - FlexNetwork
Solutions V3
Aruba Certified Switching Associate (ACSA) V1
- upgrade from Cisco, Juniper or Brocade

In preparation
for these exams

Selected items from this course are included in these
exams:

HPE2-Z40: Delta - Applying Aruba Switching
Fundamentals for Mobility
HPE6-A41: Applying Aruba Switching
Fundamentals for Mobility
HPE2-Z39: Fast Track - Applying Aruba
Switching Fundamentals for Mobility

Register for this course. 
Find this course in the Training calendar. Click the "Register" link to get started.

Aruba Switching Fundamentals for Mobility, Rev. 16.41

Course description
This course teaches you the fundamental skills necessary to configure
and manage modern, open standards-based networking solutions. This
course consists of approximately 20% lecture and 80% hands-on lab
exercises to help you learn how to implement and validate small to
medium enterprise network solutions. This 3-day course prepares
network professionals for the Aruba Certified Switching Associate
(ACSA) V1 exam.

In this course, participants learn about ArubaOS switch technologies
including: VLANs, secure access, redundancy technologies such as
MSTP, link aggregation techniques including LACP, and switch
virtualization with Aruba’s Virtual Switching Framework (VSF). You also
learn about IP Routing including static and dynamic IP routing with
OSPF. This course teaches you how to deploy Aruba wireless Access
Points and configure Aruba Instant Access Point (IAP) Clustering
technology. It also teaches you how to configure, manage and monitor
the network with the Aruba AirWave management solution.
 

Ideal candidate for this course
Ideal candidates are IT Professionals who deploy small-to- medium
scale enterprise network solutions based on Aruba products and
technologies.

For a refresh watch these videos:
• HP Networking Fundamentals Video Series - OSI Model, Rev. 13.31
(course ID 00764936)
• HP Networking Fundamentals Video Series - Binary, Rev. 13.31
(course ID 00764942)
• HP Networking Fundamentals Video Series - Data Flows, Rev. 13.31
(course ID 00765397)
• HP Networking Fundamentals Video Series - IP Addressing, Rev. 13.31 (course ID 00766100)
• HP Networking Fundamentals Video Series - IP Subnetting, Rev. 13.31 (course ID 00764933)
• HP Networking Fundamentals Video Series - TCP/UDP, Rev. 13.31 (course ID 00765415)
• HP Networking Fundamentals Video Series - VLANs, Rev. 13.31 (course ID 00764953)
• HP Networking Fundamentals Video Series - Routing, Rev. 13.31 (course ID 00764946)
• HP Networking Fundamentals Video Series - Spanning Tree, Rev. 13.31 (course ID 00764948

 

Topics
Introduction to Aruba, a Hewlett Packard Enterprise Company 

Describe market trends that are causing customers to transform in four key Transformation Areas
Describe how Aruba delivers the digital workplace

Switch CLI (Command Line Interface) Navigation 
Describe out-of-band management
Complete the initial setup on ArubaOS switches
Verify configuration

Protecting Management Access 
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Explanation of in-band management
Protect in-band and out-of-band management access
Configure local authentication
Control the privilege level allowed to managers

Management of Software and Configurations 
Overview of ArubaOS and file structures
Different methods for setting the software from which to boot
Software update
Saving and restoring configurations

VLANS 
Explain use cases for VLANs
Configure port-based VLANs on ArubaOS switches, using appropriate tagging
Implement basic IP routing between directly connected VLANs or links

Spanning Tree Protocol (STP) 
Understand and configure Rapid Spanning Tree Protocol (RSTP)
Understand how Multiple Spanning Tree Protocol (MSTP) provides load sharing and implement MSTP

 

Link Aggregation 
Differentiate between different types of link aggregation and understand the benefits of Link Aggregation Control Protocol (LACP)
Configure and troubleshoot link aggregation on ArubaOS switches

IP Routing 
Configure static routes on ArubaOS switches
Interpret IP routing tables
Configure a basic OSPF solution

Virtual Switching Framework (VSF) 
Understand how VSF works and the advantages that it provides
Configure and verify a simple VSF fabric

Wireless for Small-to-Medium Businesses (SMBs) 
Understand the basics of wireless communications and 802.11 standards
Define a WLAN and differentiate between wireless security options
Configure basic settings on Aruba Instant Access Point (IAP)
Form an Aruba Instant cluster

Aruba AirWave 
Configure AirWave management settings on an IAP cluster
Configure SNMP v2c settings on ArubaOS switches
Discover ArubaOS switches in AirWave and bring switches and IAPs under monitoring and management
Implement zero touch provisioning (ZTP) for Aruba IAPs and ArubaOS switches

Objectives
After you successfully complete this course, expect to be able to:

Explain how Aruba networking solutions meet customers’ requirements
Explain how Aruba AirWave provides unified wireless and wired network management
Describe in-band management and out-of-band management
Complete the initial setup on ArubaOS switches
Control access to switches for both in-band and out-of-band management
Manage software and configuration files on ArubaOS switches
Explain use cases for VLANs and configure port-based VLANs on ArubaOS switches
Understand and configure Rapid Spanning Tree Protocol (RSTP)
Understand and configure Multiple Spanning Tree Protocol (MSTP)
Differentiate between different types of link aggregation and understand the benefits of Link Aggregation Control Protocol (LACP)
Configure and troubleshoot link aggregation on ArubaOS switches
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Configure static routes on ArubaOS switches and interpret IP routing tables
Configure a basic Open Shortest Path First (OSPF) solution
Describe how Virtual Switching Framework (VSF) works and the advantages that it provides
Configure and verify a simple VSF fabric
Describe the basics of wireless communications and 802.11 standards
Define a wireless LAN (WLAN) and differentiate between wireless security options
Configure basic settings on Aruba Instant APs
Configure AirWave management settings on an IAP cluster
Configure SNMP v2c settings on ArubaOS switches
Discover ArubaOS switches in AirWave and bring switches and IAPs under monitoring and management
Implement zero touch provisioning (ZTP) for Aruba IAPs and ArubaOS switches

How to register
View the Certification and Learning Global Training Calendar to register for the training offerings that best meets your needs.
Policies, fees and cancellations

Course fees may vary. Fees are established and collected by the training center that delivers the course. Cancellation fees may apply. Contact your
HPE Authorized Training Partner for their respective policies.

For more information
Contact our program

© Copyright 2019 Hewlett Packard Enterprise. The information contained herein is subject to change without notice. The only warranties for HPE products and services are set forth in the express warranty

statements accompanying such products and services. Nothing herein should be construed as constituting an additional warranty. HPE shall not be liable for technical or editorial errors or omissions contained

herein.

Information is as of September 2017, Revision 3
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Course Data Sheet

Course ID 01124970

Course format,
Typical duration

Select one:
ILT - Instructor Led, 5 days
VILT - Virtual Instructor Led, 5 days

Skill level Intermediate

Delivery languages English

Lab required No

Related certifications Aruba Certified ClearPass Expert (ACCX)
V6.7
Aruba Certified ClearPass Professional
(ACCP) V6.7
Aruba Certified ClearPass Associate
(ACCA) V6.5
Aruba Certified ClearPass Associate
(ACCA) V6.7
Aruba Certified ClearPass Professional
(ACCP) V6.5

In preparation for
these exams

Selected items from this course are included in
these exams:

HPE0-A122P: Aruba Certified ClearPass
Expert Practical Exam
HPE6-A68: Aruba Certified Clearpass
Professional 6.7
HPE6-A07: Aruba Certified ClearPass
Associate 6.5
HPE6-A67: Aruba Certified ClearPass
Associate 6.7
HPE6-A15: Aruba Certified Clearpass
Professional 6.5

Register for this course. 
Register for this course in the Training calendar. Click the "Register" link to get
started.

ClearPass Essentials (CPE) 6.7, Rev. 19.21

Course description
This Instructor Led Training (ILT) course prepares participants with
foundational skills in Network Access Control using the ClearPass
product portfolio. This 5-day classroom session includes both modules
and labs to teach participants about the major features of the
ClearPass portfolio. Participants will learn how to setup ClearPass as a
AAA server, and configure the Policy Manager, Guest, OnGuard and
OnBoard feature sets. In addition, this course covers integration with
external Active Directory servers, Monitoring and Reporting, as well as
deployment best practices.

Ideal candidate for this course
Ideal candidates include network professionals who are looking to
build their foundational knowledge of the ClearPass product portfolio.

Topics
Intro to ClearPass 

BYOD
High Level Overview
Posture and Profiling
Guest and Onboard

ClearPass for AAA 
Policy Service Rules
Authentication Authorization and Roles
Enforcement Policy and Profiles

Authentication and Security Concepts 
Authentication Types
Servers
Radius COA
Active Directory
Certificates

Intro to NAD 
NAD Devices
Adding NAD to ClearPass
Network Device Groups
Network Device Attributes
Aruba Controller as NAD
Aruba Switch
Aruba Instant

Monitoring and Troubleshooting 
Monitoring
Troubleshooting
Logging
Policy Simulation

ClearPass Insight 
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Insight Dashboard
Insight Reports
Insight Alerts
Insight Search
Insight Administration
Insight Replication

Active Directory 
Adding AD as Auth Source
Joining AD domain
Using AD services

External Authentication 
Multiple AD domains
LDAP
Static Host Lists
SQL Database
External Radius Server

Guest 
Guest Account creation
Web Login pages
Guest Service configuration
Self-registration pages
Configuring NADS for Guest
Guest Manager Deep Dive
Web Login Deep Dive
Sponsor Approval
MAC Caching

Onboard 
Intro to Onboard
Basic Onboard Setup
Onboard Deepdive
Single SSID Onboarding
Dual SSID Onboarding

Profiling 
Intro to Profiling
Endpoint Analysis Deep Dive

Posture 
Intro to Posture
Posture Deployment Options
OnGuard Agent Health Collection
OnGuard workflow
802.1x with Posture using Persistent/dissolvable agent
OnGuard web Login
Monitoring and Updates

Operation and Admin Users 
Operations
Admin Users

Clustering and Redundancy 
Clustering
Redundancy
LAB

Licensing 
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ClearPass Licensing
Base License
Applications

Single Sign-On 
Deployment Options
ClearPass Admin Login SSO
Access Network SSO
ASO-Auto-Sign On
Configuration and Demo

ClearPass Exchange 
Intro
Examples
General HTTP Palo Alto Firewall
Configuration

Case Study 
Objectives
Discussion
Advanced Labs Overview

Objectives
After you successfully complete this course, expect to be able to:

Ability to setup ClearPass as a AAA server
Demostrate Configuration Guest, Ongurad, Onboard and Profiling features
Integrate with External AD Server
Understand Monitoring and Reporting
Demostrate Scaling and deployment of best practices

How to register
View the Certification and Learning Global Training Calendar to register for the training offerings that best meets your needs.
Policies, fees and cancellations

Course fees may vary. Fees are established and collected by the training center that delivers the course. Cancellation fees may apply. Contact your
HPE Authorized Training Partner for their respective policies.

For more information
Contact our program

© Copyright 2019 Hewlett Packard Enterprise. The information contained herein is subject to change without notice. The only warranties for HPE products and services are set forth in the express warranty

statements accompanying such products and services. Nothing herein should be construed as constituting an additional warranty. HPE shall not be liable for technical or editorial errors or omissions contained

herein.

Information is as of May 2019, Revision 1
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Copyright Information

©Copyright 2019 Hewlett Packard Enterprise Development LP

Open Source Code

This product includes code licensed under theGNU General Public License, the GNU Lesser General Public
License, and/or certain other open source licenses. A completemachine-readable copy of the source code
corresponding to such code is available upon request. This offer is valid to anyone in receipt of this information
and shall expire three years following the date of the final distribution of this product version by Hewlett-
Packard Enterprise Company. To obtain such source code, send a check ormoney order in the amount of US
$10.00 to:

Hewlett-Packard Enterprise Company
Attn: General Counsel
6280 America Center Drive
San Jose, CA 95002
USA

Please specify the product and version for which you are requesting source code.

Youmay also request a copy of this source code free of charge at: http://hpe.com/software/opensource.
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Contacting Support

Main Site arubanetworks.com

Support Site support.arubanetworks.com

Airheads Social Forums and Knowledge Base community.arubanetworks.com

North American Telephone 1-800-943-4526 (Toll Free)

1-408-754-1200

International Telephone arubanetworks.com/support-services/contact-support/

Software Licensing Site hpe.com/networking/support

End-of-life Information arubanetworks.com/support-services/end-of-life/

Security Incident Response Team (SIRT) Site: arubanetworks.com/support-services/security-bulletins/

Email: aruba-sirt@hpe.com
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Chapter 1
Identifying Hardware Requirements

This document provides general guidelines to followwhen selecting and configuring hardware. The first part of
this chapter describes two AirWave appliances, and the networking environment in which those appliances were
tested and validated. The following sections lists network conditions and AirWave settings that can cause your
server sizing needs to differ from the tested values, and how those settingsmight impact your choice of
hardware.

Please keep inmind that the information presented in this Sizing Guide is intended as a set of guiding principles
and not a guarantee of a level of performance on given hardware. If you have questions about how to provision
AirWave appropriately for your network, and certainly if you intend to monitormore than 3,000 devices, contact
Technical Support.

Tested Hardware Platforms
The information provided in this document is based on internal testing scenarios using the hardware platforms
described in Table 1, below.

These hardware platforms have been tested and verified in the Aruba test networking environment, which is
described in detail in "Testing Environment Parameters" on page 5.

Category Pro
HPE DL360 Gen9

Enterprise
HPE DL360 Gen9

Central Ready
HPE DL360 Gen10

Appliance Scalability

MaximumManaged
Devices

1,500 4,000 4,000

Appliance Specifications

CPU 2.6 GHz Intel Xeon E5-
2640v3

2.6 GHz Intel Xeon E5-
2640v3

3.6 GHz Intel Xeon Gold
6138

Memory 48 GB 96 GB 256 GB

Storage 6 300 GB 12G SAS 15K
2.5 in SC ENT HDD

8 300 GB 12G SAS 15K
2.5 in SC ENT HDD

2 TB SSD HDD
(4 TB in RAID 10)

Physical Cores 8 16 40

Passmark Score 14,057 19,892 25,774

Recommended IOPS 2,132 2,842 69,000 (random read)
28,500 (random write)

Table 1: Tested Hardware Platforms

Testing Environment Parameters
The tested hardware platforms described in "Tested Hardware Platforms" on page 5 support a network with the
following Aruba test values. This testing information is included to give you a clear idea of the type of
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environment that is recommended for these hardware platforms, and to give you an opportunity to note how
your own networking environment may differ from the Aruba testing environment, as any changes from these
conditions can have a significant impact hardware performance and requirements. Formore information on
how these differences can impact your network, see "Conditions that Impact Hardware Sizing" on page 8.

Aruba uses a PassMark (http://www.cpubenchmark.net/) score of AirWave appliance CPUs to compare the
relative processing power between servers. These scores provide for a close comparison, although the score for a
CPU model can vary over time asmore users contribute benchmark values for that CPU.
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To calculate the IOPS delivered by the disk subsystem, Aruba uses the calculator at
http://www.wmarrow.com/strcalc/. The following values for that calculatormost closely approximate the disk
workload characteristics of the AMP.

l RAID Level: RAID 1 and 10

l Stripe size: 1024 KiB

l Number of drives: 8

l Reads%: 20%

l Read cache hit ratio: 95%

l Write cache hit ratio: 65%

l Average I/O size : 8 KiB

Test Values
Scalability is tested based on the following test values. Deviations from these values can impact overall scalability
of your AirWave server.

Category

AP Interface polling period 10

Device-to-device link period 5

CDP neighbor data polling 30

Ratio of switches/routers to access points 25%

Read ARP polling (hours) 4

Read CDP table for device discovery polling (hours) 4

Read bridge forwarding table polling (hours) 4

Interface Up/Down polling period 10

Ratio of APs to controllers 128:1

Ratio of clients to APs 5:1

Ratio of switches/routers to access points 25%

Average port density of switches/routers 36

Read ARP polling period (hours) 8

Read CDP table for device discovery polling period (hours) 8

Read bridge forwarding table polling period (hours) 8

Interface polling period (minutes) 20

Table 2: Wireless Scalability Test Values

AirWave 8.2.9 | Server Sizing Guide Identifying Hardware Requirements | 7
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Category

Average floor plan size (feet) 62,500

Number of access points per floor plan 20

Number of clients per floor plan 100

Number of attenuation grid cells per floor plan 2,500

Number Rogue devices per floor plan 20

AirWave Synchronization timer (minutes) 15

Rogue location timer (minutes) 30

Location calculation timer (min/max/number of samples) 90/360/3

Table 3: VisualRF Scalability Test Values

Conditions that Impact Hardware Sizing
Accurate hardware sizing is almost asmuch of an art as it is a science, as it requires you to balance the needs of
your users and the demands of your existing network infrastructure using a very complex set of interdependent
variables. There is no one-size-fits-all approach to hardware sizing that can accurately predict the needs of any
individual network.

However, as part of a best practicemethodology for hardware sizing, Aruba suggests network administrators
review the following list of network requirements and variables, all of which that have a significant impact on the
load on AirWave, and are all factors to consider when determining hardware requirements.

l Client Mobility: How often are your clients roaming? This is largely a function of your environment, but
more frequent client roaming increases the AirWaveworkload. For example, a typical corporate office has
relatively low client mobility, asmost people stay at their desks for extended periods of time. In contrast, at a
university, thousands of students change classrooms on the hour, producing a flood of association change
data for AirWave to process. Airports have yet another type of client mobility pattern, withmany new, highly
mobile clients. These client mobility factors impact the disk write demands and the storage requirements of
the AirWave server.

l Number Clients Per AP: The number of clients served by AirWave has a direct and significant impact on
hardware sizing requirement. As a guideline, consider that the Aruba testing environment assumes a client-to-
AP ratio of 5:1. If the test networking environment was altered to support twice the clients, the server size
would need to double as well.

l Ratio of New Clients: AirWave requiresmore processing resources to identify new clients than existing
clients. If your AirWave servermanages APs in public places like airports or retail spaces, your network will
likely have a higher ratio of new clients than the testing environment, will need a server with increased
processing power.

l Wired Switch Percentage: Switches demandmore processing resources fromAirWave. The 4,000 device
rating for the AW-HW630-ENT appliance assumes a distribution of 20% switches and 80% APs. If your
network has a higher percentage of switches, consider a server with increased CPU processing power.
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l Trap Rate: Traps consumeprocessing resources, and trap rates are associated with client mobility. The AW-
HW630-ENT appliancewas tested against a continuous rate of 100 traps/second. If your environment will
triggermore traps than the test environment, consider a hardware server with a greater CPU and IOPS
capacity.

l AMON: AMON allows AirWave to collect enhanced data fromAruba devices on certain firmware versions. An
AirWave server collecting data using AMON requiresmore CPU andmemory resources than an AirWave
server using SNMP, especially if AirWave is collecting Traffic Analysis and Unified Communication and
Collaboration (UCC) data. Traffic Analysis can produce a lot of data and increase the AirWave’s storage
requirements, but an upper bound can be configured to mitigate that problem.

l SNMP Poll Periods: The AW-HW630-ENT appliance is certified with default polling periods (i.e., 10 minutes
for interface polling, 5 minutes for up/down polling). More aggressive or frequent AirWave polling needs a
server with increased CPU and IOPS capacity to handle the increased workload.

l RAPIDS. The Rogue AP Intrusion Detection System (RAPIDS) is another feature that can have amajor impact
the AirWave server size. Identifying and processing rogue APs consumes CPU and disk resources on the AMP.
If the AirWavemanages an AP that detectsmany APs in other networks (for example, if your AP is in an open
plaza or an atrium in a shoppingmall) then that AP will likely identify a large amount of rogue APs, requiring
increased server capacity.

l VisualRF. The numbers of floor plans and campusesmanaged andmonitored by AirWave directly impacts
the amount of memory used by the VisualRF feature. The AirWave servermay needmorememory resources
to manage a complex network using VisualRF.

l Data Retention Periods. Long retention periods increase the bulk of data the AirWave has to manage. If
your network requires longer data retention periods than the default retention settings, consider a server
with a larger disk capacity than the tested devices.

l Reports. The type, frequency and scope of reports can have an large impact on the AirWave. The AirWave
RAID controllers are configured for write-back, so they behave like an solid-state drive for writes. Reads, on
the other hand, takemuchmore processing resources. Report generation require that a lot of data is read
from the disk, which slows the disk subsystem. Internal testing is focused on the steady-state of the AirWave,
and does not explicitly factor in report generation and processes like nightly maintenance. Internal testing
ensures the steady-state never uses 100% of the server's resources so there is extra processing available
when needed. If you will be generating reports frequently, consider a server with a greater IOPS and disk
capacity.

l Instant APs. The Supported Devices values in Table 1 do not apply to Instant APs unless the following
criteria aremet.

n Device counts are adjusted for virtual controllers

An Instant AP acting as a virtual controller ismanaged as two devices; one virtual controller, and one AP.
(This is in contrast to Instant APs associated to the Instant virtual controller and standard APs, which are
counted as a single device). If your network includes a large number of standalone Instant APs acting as
virtual controllers, be aware that thismay impact the device count. The Supported Devices values in
Table 1 assume that these devices are standard APs. If your network includesmany Instant virtual
controllers, your hardware requirementsmust take into consideration increased device count.

n WAN Link is High Quality

The quality of theWAN link has a large impact on Instant networks. PoorWAN link quality increases the
amount of time it takes for an Instant AP to download new firmware, causing downloads to take longer.
This increases HTTP socket utilization, reducing the ability of other Instant APs to initiate their firmware
downloads. Configuration updates are pushed fromAirWave to Instant APs one device at a time, so if an

AirWave 8.2.9 | Server Sizing Guide Identifying Hardware Requirements | 9
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Instant AP on poor quality WAN link is slow to update, that AP acts as a bottleneck, slowing down the
configuration push to other devices.

n Rogue Polling and VisualRF are disabled

A single Instant AP cannot accurately detect rogue APs or determine VisualRF location information, as
these features typically require triangulation between three ormore APs to accurately detect the locations
of other devices on the networks. Best practices are to disable rogue polling and VisualRF in networks with
just a single Instant AP per location, to reservememory and CPU utilization resources for other processes.

Choosing Your RAID Controller
RAID 10 is the only supported RAID configuration for AirWave.

SoftwareRAID and SATA drives areNOT SUPPORTED for any configuration of AirWave.

RAID Configuration Information
For RAID 10:

l Use a dedicated Hardware RAID controller with caching and battery backup or a non volatile (NV) cache.

l Configure the RAID controller forWrite-Back caching with battery backup (unless NVcache is selected, in
which case ForceWrite-Back without Battery backup is recommended).

l Enable individual drive caching.

l Ensure that all disks are assigned and configured to a single volume.

ImproperRAID configuration can result in drastically reduced server performance. If you have any questions
regardinghardware compatibility or selection, contact Technical Support.

Choosing Your Hard Drives
Mixed-use SSD drives are some of the highest performance drives available today and are required for AirWave
to perform properly at scales above 1,500 devices.

Toensure hardware capability, purchase server hardware that is certified to be compatible with Red Hat
EnterpriseLinux 6.2.
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Chapter 2
Configuring Your Hardware

This section explains sizing information for CPUs, Disk partitions, and file systems, and it includes the following
sections:

l "CPU Configuration " on page 11

l "Disk Partitioning" on page 11

l "FilesystemConfiguration" on page 11

CPU Configuration
Ensure that PowerManagement is configured forMaximum Performance. By default, most vendors
configure BIOS to an eco-friendly setting. Ensure that Memory OperatingMode is configured toOptimizer
Mode, if available.

Disk Partitioning
AirWave automatically partitions the disk subsystemupon installation. You can override these values. Table 4
below lists the default partitioning and provides guidance formore advanced scenarios.

Default
Partitions

Size

boot 100 MB

swap 4 GB

/ Remainder of disk space

Table 4: Default Partitions

Filesystem Configuration
For AirWave, theNoop File I/O scheduler provides the best randomwrite performance. If you are running
AirWave 7.2 or later, AirWave should automatically manage this setting for you.

To check the currently assigned scheduler (if sda is not your device name, please replacewith the correct device
name):

# cat /sys/block/sda/queue/scheduler
noop anticipatory deadline [cfq] (Sample Output)

To configureNoop as your preferred scheduler:
# echo noop > /sys/block/sda/queue/scheduler

And confirm that your change has been applied:
# cat /sys/block/sda/queue/scheduler
[noop] anticipatory deadline cfq (Expected Output)
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Chapter 3
Virtualization

Virtualization
AirWave can run in a virtualized environment running VMware ESX(i) 5.5 and later. To ensure scalability, use a
dedicated processor andmemory. Youmust also ensure that the disk subsystem canmaintain the I/O
operations per second (IOPS) throughput described in "Tested Hardware Platforms" on page 5.

Most virtualized environments use a shared disk subsystem assuming that each application will have bursts of
I/Owithout a sustained high I/O throughput. AirWave requires a continuous sustained high data I/O rate. If you
don't have the recommended IOPS listed in Table 5, youmight see performance issues.

Arubarecommends using RAID 10 in the underlying virtual machine infrastructure.

Managed
Devices

CPU Cores Memory Storage Passmark
Score

Recommended
IOPS

750 Dual Intel Xeon CPU E5-2640
v3 @ 2.60GHz or higher

8 48 GB 500 GB 9,942 2,132

1,500 Dual Intel Xeon CPU E5-2640
v3 @ 2.60GHz or higher

10 56 GB 800 GB 14,057 2,558

2,500 Dual Intel Xeon CPU E5-2640
v3 @ 2.60GHz or higher

16 96 GB 1 TB 19,892 2,842

4,000 Dual Intel Xeon CPU E5-2640
v3 @ 2.60GHz or higher

20 120 GB 1.2 TB 25,116 3,410

Table 5: VMware Minimum Requirements
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Appendix A
Sizing a Master Console and Failover Server

Master Console
Refer to Table 6 forMaster Console server requirements.

Environment
Size

CPU
Class

Clock
Speed
(GHz)

CPUs Total
Cores

Memory Disk Subsystem

Small
(2-3 servers)

Intel Xeon
E5-2640

2.5 1 6 48GB 6 x 146 GB 15k RAID 10
(438 GB usable disk
space)

Large
(More than 3
servers)

Dual Intel
Xeon E5-
2640

2.5 2 12 80GB 8 x 146 GB 15k RAID 10
(584 GB usable disk
space)

Table 6: Master Console Specifications

Failover Server
The Failover server should be at least as powerful as themost powerful AirWave server that it monitors to ensure
smooth operation in a failover situation.
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Aruba AirWave Management Platform 
  
On-premises IT operations management for multi-vendor campus networks 
 
Aruba AirWave is a scalable, full featured management solution for multi-vendor wired and wireless networks. Organizations gain the 
visibility, control and troubleshooting tools required to fully manage today’s distributed enterprise environments. 
 
AirWave integrates configuration and deployment and real-time visibility and control for comprehensive management and 
troubleshooting. This provides a flexible platform for maintaining the reliability and performance of Aruba access points, controllers, 
switches, and selected multi-vendor devices. 
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Features and Benefits 
Streamlined Configuration And Deployment 
AirWave utilizes configuration groups, assigned templates, and step by step workflows to simplify device configuration. Entire config 
files can be imported, compared, assigned and archived. Modifying and using smaller segments of configuration files across groups 
of devices is also supported. 
 
These capabilities allow IT to quickly add, modify and deploy devices across distributed locations, while saving time and minimizing 
mistakes. Aruba’s Zero-Touch Provisioning (ZTP) can be used to automatically push configuration files to devices to further simplify 
the deployment process. Integrated auditing is also provided for security and change management.. 

 

Real-Time Visibility And Control 
AirWave provides detailed health and analytics dashboards to monitor critical applications and services, including: 
• Network Health – used to view client usage, monitoring and configuration compliance, alert summaries and other selected 

statistics. 
• Traffic Analysis – helps to monitor application usage and policy enforcement across the entire network. Tracks web categories, 

client destinations and relative trust levels. Details are displayed by network, roles, device type and users. 
• UCC Analytics – a consolidated view of how VoIP applications are performing displays MOS scores, and potential RF performance 

and capacity issues. 
 
For detailed device visibility, simply click a chart or graph to drill-down from any network level view, or locate and select a device for 
a configuration summary and details on connected clients, neighbors, alerts and related events. 
When looking at switch information, additional visibility into key values of individual and stacked switches is provided. This includes 
port status, PoE consumption, VLAN assignment, device and neighbor connections, power status and trends, alerts and events and 
which troubleshooting actions can be performed. 

 

Comprehensive Management And Troubleshooting 
Role-Based Access, Discovery and Topology 
AirWave utilizes a role-based model for administrative access. Multiple combinations of access and management rights can be 
assigned as needed. AirWave allows IT to protect the environment and provides the ability to tailor administrative access based on 
assigned scope and responsibilities. 
 
AirWave also discovers and maps devices across the entire environment, including those with distributed locations. The resulting 
topology map shows upstream relationships between APs, controllers and switches in order to assess the impact on related devices 
and clients, and to isolate root cause of issues.. 

 

Stage-based Connectivity Health 
A reliable connection is the foundation of a successful user experience. AirWave monitors the connectivity of clients, to proactively 
help identity and resolve issues. Data points include client association, as well as network authentication and DHCP metrics. 

 

VisualRF for Wi-Fi Visibility & Management  
Real-time views of actual floorplan maps make it easy to see RF coverage issues, location of all access points, and possible interference 
points. The result is a comprehensive view of how the network is performing, and potential trouble spots. 
Selectable overlays show client health, traffic thresholds, UCC performance and channel utilization to quickly diagnose client, building, 
floor or location specific issues. 
 
VisualRF also provides the ability to capture and playback physical movement of devices and clients within locations to isolate and 
troubleshoot those challenging intermittent mobility issues.. 
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RAPIDS for Intrusion Detection 
AirWave utilizes Aruba’s Rogue AP Intrusion Detection Service (RAPIDS), to identify and resolve issues caused by rogue access 
points, and clients. 
 
Wired and wireless data is correlated to identify relevant threats, while reducing false positives to strengthen network security. 
RAPIDS includes: 
• Summary Data – percentage of device classification and acknowledgments, and device counts by type. 
• Lists & Events – concise summaries of devices by type and events by severity, category and scope. 
• Rules Engine - easily define and edit wireless, wired, and controller properties to detect rogues, classifications and threat levels. 

 
Firmware Upgrade and Compliance 
An advanced image upgrade and compliance module, makes it easy to update firmware by device type or version group, split 
download images, and schedule updates during off hours to minimize the impact during peak operations. 

 
Flexible Platform And Deployment Options 
Aruba AirWave is available on either pre-configured hardware appliances or deployed in virtual machines (VMs).  
 
AirWave hardware appliances are designed and tested to meet the demanding requirements of distributed networks. The AirWave 
Pro appliance is optimized to support up to 1,500 managed devices, and the AirWave Enterprise and Central Ready appliances 
support up to 4,000 managed devices.  
 
The AirWave Central Ready appliance is also designed for investment protection. Providing the enhanced performance, storage, and 
interface requirements to support either AirWave or the planned Aruba Central on-premises deployment option. 
 
AirWave virtual deployments are supported on VWware and Microsoft Hyper-V host hyper visors. 

 
Government-Grade Certifications 
AirWave is highly secure, and has achieved the Federal Information Processing Standard (FIPS) Publication 140-2 validation, a 
government level computer security standard for cryptographic modules (Certificate #2577). See detailed   security documentation 
for more information. 
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Build To Order:  
BTO is a standalone unit with no integration. BTO products ship standalone are not part of a CTO or Rack-Shippable solution. 
Rule # Description SKU 
1,2 Aruba Central Ready AirWave 8 Appliance R1Q04A 
1,2 Aruba AirWave DL360 Professional Edition Hardware Appliance JX918A 
 NOTE: Aruba AirWave DL360 Professional Edition Hardware Appliance  
1,2 Aruba AirWave DL360 Enterprise Edition Hardware Appliance JX919A 
 NOTE: Aruba AirWave DL360 Enterprise Edition Hardware Appliance  
Configuration Rules:  
Rule # Description  
1 Bring in (Min 1 // Max 1) Localized power cord based on the Aruba Localization Menu  
2 If JW124A is the selected localized power cord, do not add Localized Power Cord  
 NOTE: OCA Only Model Selection Form - 

HPE Offering > Aruba > Network Management - AirWave: 
Aruba AirWave 

 

 Power Options   
 Std (Min 0 // max 99) User Selection (min 0 // max 99)  
Rule # Description SKU 
1,2 Aruba ClearPass-Airwave DL360 500W Spare Power Supply JX922A 
 NOTE: Aruba ClearPass-AirWave DL360 500W Spare Power Supply  
1,3 Aruba DL360 Gen10 500W Spare PSU R1T38A 
Configuration Rules:  
Rule # Description  
1 Bring in (Min 1 // Max 1) Localized power cord based on the Aruba Localization Menu  
2 This PSU is supported on:JX918A, JX919A  
3 This PSU is supported on:R1Q04A  
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Licenses 
 AirWave License   
 Std (Min 0 // max 99) User Selection (min 0 // max 99)  
Rule # Description SKU 
 Aruba LIC-AW Aruba Airwave with RAPIDS and VisualRF 1 Device License E-LTU JW546AAE 
 NOTE: LIC-AW  
 Aruba AW-MASTER AirWave Master Console License E-LTU JW567AAE 
 NOTE: AW-MASTER  
 Failover License  
 Std (Min 0 // max 99) User Selection (min 0 // max 99)  
 Aruba AW-100-FR AirWave 100 Device Failover License E-LTU JW560AAE 
 NOTE: AW-100-FR  
 Aruba AW-1000-FR 1000 AirWave Device Failover License E-LTU JW563AAE 
 NOTE: AW-1000-FR  
 Aruba AW-200-FR AirWave 200 Device Failover License E-LTU JW561AAE 
 NOTE: AW-200-FR  
 Aruba AW-25-FR AirWave 25 Device Failover License E-LTU JW558AAE 
 NOTE: AW-25-FR  
 Aruba AW-2500-FR 2500 AirWave Device Failover License E-LTU JW564AAE 
 NOTE: AW-2500-FR  
 Aruba AW-50-FR AirWave 50 Device Failover License E-LTU JW559AAE 
 NOTE: AW-50-FR  
 Aruba AW-500-FR AirWave 500 Device Failover License E-LTU JW562AAE 
 NOTE: AW-500-FR  
 Aruba AW-EXF1-2500 AirWave 2500 Volume Failover Expansion License E-LTU JW566AAE 
 NOTE: AW-EXF1-2500  
 Aruba AW-EXF1-50 AirWave 50 Device Failover Expansion License E-LTU JW565AAE 
 NOTE: AW-EXF1-50  
 K12 Network Management License  
 Std (Min 0 // max 99) User Selection (min 0 // max 99)  
 Aruba AW-K12-1 AirWave K-12 Bundle 1 Device License E-LTU JW605AAE 
 NOTE: AW-K12-1  
 Aruba SUB1-AW-K12 1-year AirWave 1 Device 1-yr Subscription E-STU JW467AAE 
 NOTE: SUB1-AW-K12  
 Aruba SUB1-AW-K12 1-year AirWave 1 Device 3-yr Subscription E-STU JW468AAE 
 NOTE: SUB3-AW-K12  
 Aruba SUB1-AW-K12 1-year AirWave 1 Device 5-yr Subscription E-STU JW469AAE 
 NOTE: SUB5-AW-K12  
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Ordering Information  
Rule # Description SKU 
 Aruba LIC-AW Aruba Airwave with RAPIDS and VisualRF 1 Device License E-LTU JW546AAE 
 Aruba AW-25-FR AirWave 25 Device Failover License E-LTU JW558AAE 
 Aruba AW-50-FR AirWave 50 Device Failover License E-LTU JW559AAE 
 Aruba AW-100-FR AirWave 100 Device Failover License E-LTU JW560AAE 
 Aruba AW-200-FR AirWave 200 Device Failover License E-LTU JW561AAE 
 Aruba AW-500-FR AirWave 500 Device Failover License E-LTU JW562AAE 
 Aruba AW-1000-FR 1000 AirWave Device Failover License E-LTU JW563AAE 
 Aruba AW-2500-FR 2500 AirWave Device Failover License E-LTU JW564AAE 
 Aruba AW-EXF1-50 AirWave 50 Device Failover Expansion License E-LTU JW565AAE 
 Aruba AW-EXF1-2500 AirWave 2500 Volume Failover Expansion License E-LTU JW566AAE 
 Aruba AW-MASTER AirWave Master Console License E-LTU JW567AAE 
 Aruba AirWave DL360 Professional Edition Hardware Appliance JX918A 
 Aruba AirWave DL360 Enterprise Edition Hardware Appliance JX919A 
 Aruba Central Ready AirWave 8 Appliance R1Q04A 
 Aruba AW-HW-GLASS AirWave Hardware Appliance for Centralized Monitoring JZ075A 

 
Hardware specifications  

Pro Appliance (JX918A) 
Appliance Specifications 

 

CPU 8-core 2.6 Ghz HPE DL360 Gen9 E5-2640v3 
Memory 48GB 
Storage 6 300GB 12G SAS 15K 2.5in SC ENT HDD   

Appliance Scalability 
 

Maximum Managed Devices 1,500   

Power 
 

Power 500W FS Plat Hot Plug Power Supply 
Power Supply Optional redundant power supply 
AC Input Voltage 110/220 VAC Auto-Selecting 
AC Input Frequency 50/60 Hz Auto-Selecting   

Physical 
 

Rackmount 1U SFF Easy Install Rail  
1U Cable Management Arm 

Dimensions 1.7 x 17.1 x 27.5 in 
(H x W x D) (4.32 x 43.47 x 69.85 cm) 
Weight 33.3 lb. (15.31 kg) max 
HP SmartDrives 8 + 2 SFF/4 LFF max, HDD/SSD 
Networking 4 x 1GbE embedded + FlexibleLOM slot 
VGA/serial/USB ports Front VGA opt, rear VGA standard, and serial opt.,  

5 USB 3.0 
Industry compliance ASHRAE A3 and A4, lower idle power   

Warranty 
 

Anexo 01 ITENS 21 E 22 (0592758)         SEI 0008478-63.2018.6.02.8000 / pg. 8387



QuickSpecs  Aruba AirWave Management Platform 

Technical Specifications 
 

 
 Page 7 

 

Hardware 1 year parts 
Software 90 days 

 

Enterprise Appliance (JX919A) 
Appliance Specifications 

 

CPU 2 8-core 2.6 Ghz HPE DL360 Gen9 E5-2640v3 
Memory 96GB 
Storage 8 300GB 12G SAS 15K 2.5in SC ENT HDD   

Appliance Scalability 
 

Maximum Managed Devices 4,000   

Power 
 

Power 500W FS Plat Hot Plug Power Supply 
Power Supply Optional redundant power supply 
AC Input Voltage 110/220 VAC Auto-Selecting 
AC Input Frequency 50/60 Hz Auto-Selecting   

Physical 
 

Rackmount 1U SFF Easy Install Rail  
1U Cable Management Arm 

Dimensions 1.7 x 17.1 x 27.5 in 
(H x W x D) (4.32 x 43.47 x 69.85 cm) 
Weight 33.3 lb. (15.31 kg) max 
HP SmartDrives 8 + 2 SFF/4 LFF max, HDD/SSD 
Networking 4 x 1GbE embedded + FlexibleLOM slot 
VGA/serial/USB ports Front VGA opt, rear VGA standard, and serial opt.,  

5 USB 3.0 
Industry compliance ASHRAE A3 and A4, lower idle power   

Warranty 
 

Hardware 1 year parts 
Software 90 days 

 

Aruba Central Ready AirWave 8 Appliance (R1Q04A) 

Appliance Specifications 
 

CPU 2 20-core Intel Xeon-G 6138, 3.6 GHz,  HPE DL360 Gen10 

Memory 256GB 

Storage 2 TB SSD or SAS HDD (4 TB in RAID 10 configuration) 
  

Appliance Scalability 
 

Maximum Managed Devices 4,000 
  

Anexo 01 ITENS 21 E 22 (0592758)         SEI 0008478-63.2018.6.02.8000 / pg. 8388



QuickSpecs  Aruba AirWave Management Platform 

Technical Specifications 
 

 
 Page 8 

 

Power 
 

Power 500W FS Plat Hot Plug Power Supply 

Power Supply Optional redundant power supply 

AC Input Voltage 110/220 VAC Auto-Selecting 

AC Input Frequency 50/60 Hz Auto-Selecting 
  

Physical 
 

Rackmount 1U SFF Easy Install Rail 
 

1U Cable Management Arm 

Dimensions 1.7 x 17.1 x 27.8 in 

(H x W x D) (4.29 x 43.46 x 70.7 cm) 

Weight 35.9 lb. (16.27 kg) max 

HP SmartDrives 4 LFF SAS/SATA/SSD 8 or 10 SFF SAS/SATA/SSD 

Networking 4 x 1GbE embedded + FlexibleLOM slot 

VGA/serial/USB ports Front VGA opt, rear VGA standard, and serial opt., 
 

5 USB 3.0 

Industry compliance ASHRAE A3 and A4, lower idle power 
  

Warranty 
 

Hardware 1 year parts 

Software 90 days 
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Date Version History Action Description of Change 
02-Apr-2019 Version 3 Changed Configuration Information, Standard Features and Technical Specifications 

sections were updated. 
03-Apr-2017 Version 2 Changed SKUs added: JZ075A, JZ076AAE 
01-Nov-2016 Version 1 New New QuickSpecs 
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Introduction to IMC 

IMC overview 
IMC is a comprehensive management platform that was built from the ground up to support the 
Fault, Configuration, Accounting, Performance, Security (FCAPS) model. It provides features and 
functions that are designed for comprehensive management of the network infrastructure. 

IMC was designed to provide the following functions: 

 Supports the ITIL operational center of excellence IT practices model.  

 Uses a single-pane management paradigm to enable end-to-end business management of IT 
services. 

 Provides scalability by supporting distributed and hierarchical system architectures, through 
additional operating system and database support. 

 Uses an SOA model to provide full resource, service, and user management.  

 Enables the integration of traditionally separate management tools using a modular design.  

 Enables enterprises to expand their infrastructure management in scale, and to seamlessly 
accommodate new technologies at the same time. 

 This IMC version supports TLS 1.0, enhancing network communication security. To use TLS 
1.0, enable it on the IMC server. 

IMC platform features 
IMC consists of a base platform and service components that offer additional functionality. The base 
platform provides administrators and operators with the functionality needed to manage IMC and the 
devices managed by IMC. 

The IMC platform provides the following functions: 

 Administrative controls for accessing and managing IMC. This includes granting or restricting 
operator access to IMC features through operator and operator group management. 

 The base platform also includes features for the system-wide management of device data 
collection and information shared by all IMC modules. These features include: 

 The creation and maintenance of device, user, and service groups. 

 Device vendor, series, and device model information. 

 SNMP MIB management and other system-wide settings and functions. For information, 
see "Role-based administrative controls." 

 A broad feature set for network device management, from the ability to manage SNMP, Telnet, 
and SSH configurations on a device, to configuring spanning tree and PoE energy 
management for managed switches and much more. For more information, see "Resource 
management." 

 Management of the configuration and system software files on devices managed by IMC. You 
can perform the following configuration and software operations for individual devices or a 
group of devices: store, backup, baseline, compare, and deploy. For more information, see 
"Configuration and change management." 

 Real time management of events and the translation of events into faults and alarms in IMC. 
For more information, see "Real time fault management." This includes creating, managing, 
and maintaining the following: 

 Alarm lists 

 Syslog filters and definitions 
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 Trap filters and definitions 

 Configurations for notifications of alarms 

 Monitoring, reporting, and alarming on the performance of the network and the devices that 
comprise it. For more information, see "Performance monitoring and management." This 
includes: 

 Managing global and device-specific monitors. 

 Managing global and device-specific thresholds. 

 Creating views and reports for displaying performance information. 

 Access control list (ACL) management. This includes:  

 Creating and maintaining ACL templates, resources, and rule sets. 

 Deploying ACL rule sets to devices managed by IMC. 

 Monitoring and leveraging ACLs that exist on devices for deployment to other network 
devices. 

For more information, see "Global ACL management." 

 Monitoring and managing security attacks and the alarms they generate. For more information, 
see "Security monitoring." 

 Global management of VLANs on all devices that support VLANs, managed by IMC. For more 
information, see "Global VLAN management." 

 Basic Wireless Service Manager (WSM) service module. This includes: 

 WLAN device configuration, topology, performance monitoring. 

 RF coverage and planning. 

 WLAN intrusion detection and defense. 

 Generation of WLAN service reports from the same platform used to manage wired 
networks. 

These are the functional areas of the IMC platform. The IMC framework and suite of services also 
includes service components for extending the scope and reach of IMC ability to manage the 
network infrastructure.  

Role-based administrative controls 
IMC provides administrators with both the tools and the ability to grant access to only those features 
and resources operators need. IMC also provides controls and audit trails to support IT management 
best practices.  

In IMC, management rights and access to all resources managed by IMC are granted or restricted 
through the use of three IMC features: 

 Operator groups 

 Device groups 

 Custom views of the devices 

Through the configuration of the operator account, these three features converge to define the 
specific set of access and management rights and restrictions assigned to each operator.  

First, administrators can define operator group by selecting which IMC features members of the 
group can access. 

 An administrator can use operator groups to grant or restrict access to IMC features including: 

 Resource Management 

 Alarm Management 

 Intelligent Configuration Center 

 Report Management 
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 Performance Management 

 Network Asset Management 

 Security Control Center 

 Virtual Resource Management 

 ACL Management 

 VLAN Management 

 Syslog Management 

 QoS Management 

 Administrators can grant or rescind operator access to these functional areas of IMC, as well as 
to specific features within these areas. 

Next, administrators create device groups, which enable administrators to group devices by device 
type (usually a grouping of similar device types). 

 Once device groups are created, administrators can assign operators to a device group, 
granting them access and rights to manage the devices in that group.  

 Operators cannot view or access devices that are not included in the groups to which they have 
been granted access. 

Lastly, operators can create custom views, which allows administrators to grant or restrict access 
and management rights to a group of devices in a custom view. 

After creating the operator groups, device groups, and custom device views, the administrator 
assigns or restricts rights through the configuration of the operator account.  

In addition to these flexible role-based administrative controls, IMC provides administrators with the 
following administrative controls over IMC features and the devices managed through IMC: 

 Supports secure operator access to IMC through LDAP or RADIUS authentication. 

 Provides administrators with the ability to view the online activity of IMC operators, and the tools 
for logging online operators off and blocking their access temporarily or permanently. 

 Employs the concept of access control to enable administrators to permit or deny operator 
access to IMC, based on individual IP addresses as well as IP address ranges.  

 Supports IT compliance practices by providing audit trails that detail changes IMC operators 
make to devices in the infrastructure. 

Resource management 
IMC provides comprehensive element management for multi-vendor devices such as Hewlett 
Packard Enterprise, H3C, and 3Com, using a single Web portal. 

Managing and monitoring devices 

Operators have access to a feature set for managing and monitoring many aspects of a device from 
the Resource tab. IMC offers these management capabilities for a wide range of devices including:  

 Routers 

 Switches 

 Wireless devices 

 Voice devices 

 Desktops 

 Servers 

From this portal, operators can add, configure, monitor or manage one device at a time or multiple 
devices. In addition, operators can create batch jobs for managing multiple devices. 
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Adding devices 

IMC provides operators with several methods for adding devices. Operators can add devices 
manually, by importing a comma delimited list of devices and their attributes, or by using one of the 
following auto discovery methods: 

 Routing-based 

 ARP-based 

 IPSec VPN-based 

 Network segment-based 

 PPP-based 

Operators can use the IMC batch operation feature for adding devices. 

Viewing devices 

IMC also provides operators with the following views for monitoring and managing devices: 

 Device View—Groups devices by device type. 

 IP View—Groups devices by IP address. 

 Network Topology View—Provides a physical view of devices by generating a topology map 
of the network. Operators can create custom maps down to individual racks in the data center. 
Topology maps, down to data center maps, in IMC are active. The left-click shortcut menu on a 
topology map provides device monitoring information. The right-click shortcut menu on a 
topology map provides operators with device configuration and management features.  

 Custom View—Provides user-defined views to support the needs of their organization. IMC 
incorporates access control features into the custom view enabling administrators to manage 
access to devices through the use of these views. All custom views provide summary 
color-coded views of the current alarm status for devices in each view. 

Device Details page 

The Device Details page provides the following information for operators to ascertain the health and 
status of a device: 

 Summary information—Includes device label and system name, IP address and mask, 
location and contact information, hardware, and product and serial number information.  

 Real time data—Includes performance data, real time service monitoring data, and 
configuration management details. 

On the Device Details page, operators can perform the following tasks: 

 Test connectivity with the device through ping or traceroute operations. 

 Manage the device by accessing the device with Telnet or SSH, or by launching a Web 
Manager or Device Panel view. 

 Modify the device management parameters, including: 

 Login parameters, including SNMP, Telnet, and SSH settings. 

 Polling and pinging settings for periodical data and status collection. 

 View and configure the device, including ACLs, PoE, VLAN interfaces, address binding, port 
security, RMON, spanning tree, and routing protocols. Configurable parameters vary with 
device types. 

Configuration and change management 

Using Configuration Center 

The Configuration Center combines the tasks of network device change and configuration 
management to effectively manage devices and audit changes. 
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Like the IMC Resource Management feature, the Configuration Center has a portal for accessing 
most of IMC change and configuration management features.  

From this portal, operators have access to the configuration management details and history for 
devices managed by IMC.  

Operators can perform the following operations: 

 View the latest startup and running configurations for managed devices. 

 View configuration and software histories. 

 Prepare a device for software upgrades by removing unneeded files. 

 Deploy software to devices. 

The Configuration Center also supports the following operations for configuration file baselines: 

 Modify 

 Restore 

 Compare 

 Deploy 

 Backup 

 Restore 

 Establish a baseline  

From this same page, operators can view configuration and software histories, prepare a device for 
software upgrades by removing unneeded files, and deploy software to devices. 

Using configuration templates 

Configuration templates enable operators to manage configuration on a group of devices in bulk. 
Operators can use a configuration template to perform the following configuration management 
operations on a group of devices: baseline, create, deploy, and store. 

Operators can create templates using a portion or an entire configuration file that has been backed 
up to IMC. 

They can also import a portion or an entire configuration file into a template, and can create 
templates from scratch.  

In IMC, configuration templates are either file based or segment based. 

 File based configuration template—Contains the contents of an entire configuration file. 

 Segment based configuration template—Contains just a portion of a configuration file.  

Once a template has been created, it becomes available in the Deployment Guide for deployment to 
one or more compatible devices. 

Using the Software Library 

IMC also has a Software Library that provides operators with a convenient facility for storing system 
software and other files. Once system software or other files are uploaded to the Software Library 
from other IMC-managed devices, or from the operator's local computer, the operator can establish a 
software baseline for the devices that use the entries, allowing for identification of devices whose 
software differs from the baseline. System software in the Software Library also becomes available 
in the Deployment Guide for deployment to one or more compatible devices. 

Using the Deployment Guide 

The Deployment Guide provides operators with a process for selecting the configuration files or 
system software to be deployed, and the devices to which the files will be deployed.  

As part of this process, IMC validates whether or not a configuration file or system software file can 
be successfully deployed. IMC also checks device resources to ensure that there are sufficient 
resources on every device to support a successful configuration file or software deployment.  
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Using Clean Device Space 

If a configuration file or system software file cannot be successfully deployed because of insufficient 
device resources, operators can use the Clean Device Space feature to make room for new 
deployments. This helps to ensure successful deployments, and minimizes network outages due to 
deployment failures. 

Using the Deployment Task List 

Once a deployment task has been submitted to IMC, operators can view and manage the progress 
or results of a task using the Deployment Task List. 

Using Auto Backup Plan 

The Auto Backup Plan provides operators with the ability to schedule automated backups of device 
configurations. With this feature, operators can back up the startup or running configuration files for 
all managed devices. IMC also provides operators with backup histories, and the ability to quickly 
deploy a backup configuration file when necessary. 

Using Compare with other Device Configurations 

Use the Compare with other Device Configurations feature to view two configuration files 
side-by-side to quickly identify what is different. IMC highlights all differences and notifies an 
operator of a changed device configuration. Operators can choose to view the entire file or to view 
the differences in the file, in addition to viewing each difference. 

Tracking or auditing device configuration changes 

IMC also provides operators with the ability to track or audit changes to device configurations 
through the following auditing features:  

 Configuration Backup Report—Provides a view of the backup history of both the startup and 
running configuration files for devices managed by IMC. 

Operators can also initiate a configuration file restore for one or more devices from this report. 

 Configuration Baseline Report—Provides a view of comparing startup and running 
configuration files against the configured baseline file. 

 IMC identifies any changes, between the files and provides a link for the operator to 
manually compare the contents of the two files. 

 The Deployment Guide can also be launched from this page to restore the baseline 
configuration to the device. 

 Software Update Report—Provides operators with software update histories for all devices 
managed in IMC. The Deployment Guide can be launched from this page to restore selected 
software to the source device. 

 Software Baseline Report—Provides a comparison of the current system software against the 
configured baseline file. If differences between the baseline version and the current system 
software exist, IMC notes these differences. The Deployment Guide can be launched from this 
page to restore the baseline software to the device. 

Using the Compliance Center 

The Compliance Center feature supports organization adherence to compliance policies and 
standards. This feature enables operators to create compliance policies and rules that check the 
configuration of devices.  

First, the operator creates a compliance policy, and creates check rules in the policy or imports 
check rules from other policies. One compliance policy can contain multiple check rules that focus on 
different check items.  

Next, the operator creates a configuration Check Task that combines the check rules with the list of 
devices (only devices under IMC management), and compares the device configuration against the 
content configured in the rules.  
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The check task can be executed immediately or periodically at a regular interval. Once a check task 
is complete, operators can view the task results through Check History. 

Network asset management 
With Network Asset Manager, administrators and operators can track assets, as well as changes to 
assets. This feature provides operators with a list of assets and drilldown capabilities into individual 
device details or device audit details. Operators can also query IMC for specific audit records, and 
manage the device auditing process. 

Real time fault management 
IMC integrated network management system of fault, performance, auditing, security, and 
configuration reduces the effort required to manage complex network infrastructures, allowing 
network managers to have one database of network devices in IMC that drives various tasks of 
network management. This database is integrated with all IMC functions, including fault 
management, thereby eliminating the need to maintain multiple databases for each functional area 
of fault, performance, auditing, security, and configuration. 

The alarm or event management system in IMC also uses the existing device database and couples 
it with sophisticated SNMP trap processing and Syslog parsing algorithms, intelligently generating 
alarms for notifying operators and support organizations when a network failure or an event of 
interest occurs.  

IMC uses rules to define an event of interest, and which events generate alarms. IMC includes 
pre-defined system rules and also provides operators with the ability to create user-defined rules for 
generating events and alarms. 

IMC also includes root symptom analysis and built-in downstream event suppression by mapping out 
the network infrastructure and automatically defining relationships between devices through its 
comprehensive discovery algorithms. 

Using this information, IMC intelligently distinguishes between alarms that are most likely pointing to 
the root cause, and those that are merely a symptom of a problem elsewhere in the infrastructure. 
Operators can specify alarm presentation based on these distinctions.  

IMC also provides operators with the ability to modify IMC mapping of the core, and access devices 
used for root cause or symptom analysis and event suppression. 

As with most other features, IMC provides operators with a single pane for viewing alarms, as well as 
several alarm viewing options. From each of the alarm views, operators can drill down to view the 
detailed information for a particular alarm and take action to correct the problem.  

Operators can also drill down to the Device Details page for accessing the monitoring information 
and configuration features for the device reporting issues. 

IMC also offers operators the ability to notify members of the support organization through mail and 
SMS or text notifications. In addition, operators can forward alarms generated in IMC to other IMC 
instances, or to other management systems including the Help Desk system and the manager of 
managers system. 

Performance monitoring and management 
True to the FCAPS model, IMC also provides the ability to monitor the performance of devices 
managed by IMC.  

The Performance Management features provide the ability to customize the collection, alarming, 
and presentation of performance data. When conditions are met for system-defined, user-defined, 
global, or individual monitoring thresholds, performance monitors can be leveraged to: 

 Collect performance information 
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 Generate historical reports 

 Generate alarms 

IMC enables the real-time and historical performance management for managed devices, and 
provides over two hundred global system-defined monitors for measuring the availability, 
accessibility, and performance of network devices, such as routers and switches.  

It also supports the performance monitoring of technologies including: 

 IPSec VPNs 

 WLAN 

 QoS 

 RMON 

Compile MIBs into IMC to create custom global monitors, which can then be applied to the monitor 
sets for one or more devices. Sixteen of the over two hundred system defined monitors are 
configured with polling intervals, threshold settings, and alarm level settings. This enables 
immediate, proactive performance monitoring of devices managed in IMC. Four primary 
performance monitors will automatically be added to new devices. By default, the following indexes 
are monitored on devices: 

 Availability 

 Response time 

 CPU usage 

 Memory usage 

IMC provides flexibility for customizing global monitors including threshold settings.  

 Global monitors can be added to the monitor sets for individual devices, enabling the 
performance monitoring for every device to be tailored.  

 Threshold settings can also be customized for individual device monitors. 

Once performance monitors have been created, performance views can be added that include one 
or more monitors.  

 Performance view shortcuts can be added to the left navigation system, enabling one-click 
access to performance data for mission-critical devices.  

 Performance data and the configuration of performance monitoring can be accessed from 
multiple places, including the Device Details page. 

IMC provides the real time monitor feature, which allows performance indexes of key network 
devices to be monitored, to efficiently detect and solve problems.  

Global ACL management 

ACL Manager overview 

ACL Manager provides operators with a comprehensive feature set for managing ACLs for devices 
managed by IMC, including the following tasks: 

 Viewing and configuring existing ACLs on a device managed by IMC. 

 Importing ACLs from devices into ACL Manager as a template or as an ACL resource. 

Once ACL templates and resources are created, they can be deployed to devices managed by IMC. 
Use the ACL Deployment wizard to deploy ACLs and ACL uses to these devices.  

With ACL Manager's deployment task management features, operators can monitor and manage the 
deployment of ACLs and ACL resources.  

ACL Manager supports four types of ACLs:  

 Basic 
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 Advanced 

 Link 

 User-Defined 

With these ACL types, operators can create rules based on: 

1. Source IP address or address range, and mask. 

2. Layer 3 and Layer 4 information including IP source and destination addresses, and Layer 4 
protocol information. 

3. Layer 2 information including MAC source and destination addresses. 

4. User defined hexadecimal patterns and masks. 

ACL templates in ACL Manager serve as a container for the configuration options of the rule sets 
required to create an ACL. Once an ACL template has been created, it can be imported as an ACL 
resource.  

 An ACL resource in ACL Manager is an ACL that contains one or more rule sets. 

 ACL resources, once created, can be deployed to devices managed by IMC that support ACLs. 

Using ACL Assistant 

The ACL Assistant facilitates ACL template creation by modularizing some of the configuration 
components of an ACL rule, including services, network addresses, and time ranges.  

 With services, operators can define one or more TCP or UDP ports as a named service.  

 With net address groups, operators can specify an IP address or range of IP addresses, and 
their subnet mask.  

 With time ranges, operators specify fixed or recurring date and time ranges.  

Once created, the services, net address groups, and time range groups are available for use when 
configuring rules for templates. 

Using ACL Resource List 

The ACL Resource List provides a single portal for viewing and managing all of the ACLs that can 
be deployed to network devices. Use this portal to view, add, rename, and delete ACLs. 

Using Rule Set List 

Navigate to the Rule Set List to manage every aspect of a rule set for a given ACL. 

 View information for every rule in a set. 

 Take action on all of the existing rules in the list, including: 

 Add 

 Modify 

 Copy 

 Deploy 

 Delete 

From the Rule Set List, operators can also import the contents of a template into a new rule set for 
an existing ACL. 

ACL Manager provides the following key features for managing the effect an ACL can have on 
network performance: 

 Redefine or manually sort the order of appearance of rules in a rule set. This can be crucial to 
the effectiveness of the ACL when the rule set's match order is based on the order of rule 
appearance.  

 Use the Optimize feature for evaluating the effect of rules on network performance, and for 
making and implementing recommendations for reducing the effect of ACLs on network 
performance. 
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ACL Manager simplifies and streamlines the process for managing ACLs on devices. It has a single 
portal for viewing and managing the ACL configurations on all devices that support ACLs.  

ACL Manager also provides operators with a single portal for managing ACL configurations for a 
selected device. From this portal, operators can view, synchronize, and refresh the ACL 
configuration data for the device, as well as modify the ACL configuration polling interval.  

Options are also provided for managing ACL device configurations, including adding and deleting 
ACL definitions, exporting ACL text files, and applying ACLs as packet filters or VLAN filters to one or 
more interfaces on the device. 

Using ACL Deployment wizard 

ACL Manager facilitates the deployment of ACLs and rule sets using the ACL Deployment wizard. 
This wizard provides a step-by-step process for successfully deploying ACLs, ACL uses for packet 
filtering and VLAN filtering, and the removal of ACLs and ACL uses.  

During the deployment task configuration process, IMC evaluates the selected devices and ACLs to 
determine whether or not the task can be executed successfully. It identifies when devices do not 
match the configuration selections, displays warning messages, and provides evaluation results to 
guide the successful deployment of ACL resources.  

The ACL Deployment wizard provides a way to view and manage all deployment tasks through the 
ACL Deployment Task List. 

Security monitoring 
The IMC Security Control Center (SCC) offers a proactive and integrated security monitoring and 
management system. SCC provides operators with real time threat monitoring, detection, and 
analysis. In addition, it includes the ability to define security control policies, enabling operators to 
take manual or automated actions when a security attack occurs. 

IMC detects and provides actions for threats listed in Table 1. 

Table 1 Threats that IMC can deal with 

Attack type Attacks by protocol 

Malformed packet attacks 

 ARP—ARP Overspeed, Duplicate ARP Address 
 IP—IP Fragment, IP Spoofing, Route Record, Source Route, 

Teardrop 
 ICMP—ICMP Redirect, ICMP Unreachable, Large ICMP, Ping of 

Death, Smurf 
 NetBIOS—WinNuke 
 TCP—Land, TCP Flag 
 UDP—Fraggle, Tracert 

Scanning attacks IP Sweep, IPS Scan, TCP Port Scan, UDP Port Scan 

Flood attacks Frag Flood, ICMP Flood, SYN Flood, UDP Flood 
 

IMC monitors many of these security threats in real time by receiving and processing two data 
sources: Syslog events and SNMP traps sent by devices.  

The Syslog messages that trigger IMC event alarms include:  

 Duplicate Addresses 

 ARP Overspeed 

 DHCP Server Detect 

 IMC attack event 

IMC also processes SNMP traps sent by managed devices. The SNMP traps that SCC currently 
supports for security attack alarms include: 
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 Duplicate Address 

 ARP Overspeed 

 DHCP Server Detect 

 Flow Monitor Abnormal for IMC UAM  

 Flow Monitor Serious for IMC UAM  

 SecCenter 

Once IMC has detected and escalated a security event to an alarm, it is displayed in one of the 
following tabular views for security attack alarms: the Attack Alarm List and the Real Time Attack 
Alarm List. SCC also provides operators with a visual display of attacks through the attack path 
topology map.  

Operators can respond to attack alarms by initiating any of the following actions: 

 Shutting down an interface 

 Sending a mail 

 Sending a message to the online user 

 Kicking the online user off 

 Adding the online user to the blacklist 

SCC also provides integration with the IMC EAD component, which enables SCC to receive security 
events from IPS and other security aware devices in the network. It can turn those events into 
actions, such as isolating or blocking endpoints to protect network assets. 

Through the use of security control policies, operators can proactively manage their response to 
security threats and attacks. Service control policies allow operators to define what actions are taken 
in response to attack alarms.  

A security control policy combines the identification and alarming of a security attack with an action 
that can be taken in response to the security attack. The actions configured for security control 
policies can be executed manually, or they can be configured to run automatically upon detection of 
the security attack. 

Like many IMC modules, SCC also provides operators with summarized reporting of security attacks 
in the last hour. Summary reports include: 

 Top 10 Attack Alarms Report 

 Top 10 Attack Sources Report 

 Top 10 Attack Destinations Report 

 Execution Results Report 

SCC can be integrated with the SMS. Open the SMS management page in SCC to view information 
about security devices managed by the SMS. 

Through the SMS, SCC integrates the monitoring functions for security devices in the entire network.  

Intelligent Policy Center enables you to define actions to be taken in response to custom device 
alarm events and periodic events. IPC provides the following features: 

 Event Configuration 

 Action Configuration 

 Policy Management 

 View Event 

 Report 
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Global VLAN management 
With IMC, VLANs can be managed globally, or on a per device basis. The IMC Global VLAN option 
gives operators the ability to create standardized VLANs across all devices in the infrastructure that 
support VLANs. They can create VLANs, then add, configure, or remove them from all devices that 
support this feature. 

IMC also employs the batch operation concept to VLAN management. Operators can create and 
configure VLANs on one or more devices. This includes configuring access, trunk, or hybrid ports 
using the batch feature for VLAN management. 

For individual device VLAN management, operators can select devices for configuring VLANs. From 
the same interface, they can also configure virtual interfaces, access ports, trunk ports, or hybrid 
ports for each VLAN. 

With the IMC VLAN Topo option, operators can launch a network topology view. This view highlights 
devices for the selected VLAN, and grays out devices that are not part of the VLAN. Operators can 
actively monitor and manage devices in the selected VLAN from the topology map. 

Virtual Resource Management 
Virtual Resource Management (VRM) provides the ability to manage virtual network devices such as 
servers, virtual machines, and virtual switches. View virtual network resource configuration in Virtual 
Network View. Plan and manage a virtual network by creating a vSwitch or port group. 

VRM provides a virtual machine migration function. Migrate a virtual machine from a server, with 
limited resources, to a server with enough resources to ensure the efficiency of the virtual machine.  

VRM automatically collects data on the vManager that manages virtual servers. In the Migration 
Recommendation List, select manual or automatic migration. After the migration is complete, view 
the migration report. 

With the topology function, view the virtual network architecture to facilitate planning a virtual 
network. 

Reporting 
IMC offers administrator performance, operator performance, and resource reporting options in the 
Report tab. From this tab, operators can find template driven reports for the following contents: 

 Network assets 

 Configuration and configuration changes 

 Network device and link status 

 Network events 

 Alarms 

 Network device health 

IMC supports the following types of report categories:  

 Real Time Report—Offers operators reports on resource statistics, configuration and change, 
fault or alarm, and performance reporting on network devices, interfaces, users, and services.  

 Custom Report—Provides two types of informational reports: device and link.  

Device detail reports include the following information for managed devices:  

 Device status 

 Label 

 IP address 

 MAC address 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 8414



13 

 Device type 

 Model 

 Vendor 

 Contact 

 SysOID 

 Hardware version 

 Software version 

 Serial number 

 Product number 

Link detail reports include information on devices connected to either end of a link. This 
information includes device name, port, IP address, and port speed. 

IMC provides every operator with the ability to customize the reporting interface to meet individual 
reporting needs.  

Use the Add My Real Time Report and Add My Quick Report links to customize the Report main 
page and include only the most useful reports. 

After adding a report to the Report main page, operators can access the report by clicking the report 
name link and entering report parameters to quickly access desired information. 

Intuitive user interface 
IMC includes many features that enable administrators and operators to effectively manage the 
network infrastructure. 

The tabular navigation system is located at the top of every IMC page to provide one click access to 
most IMC features. These features can include lists that provide operators with access to the 
managed resources.  

Most lists provide active links for drilling down into the details for individual components, such as the 
Device Details page. From these individual device or component pages, operators can access the 
IMC features that enable them to manage, monitor, configure, and audit network resources.  

IMC also provides operators with many paths to the same destination. Operators are provided with 
quick start guides. With the My Favorites feature, operators can create links to the IMC features 
they use most often.  

Once created, My Favorites links become available on every IMC page through the My Shortcut > 
My Favorites link located in the upper left corner of the left navigation system. 

IMC provides the following forms of online help: 

 System-wide help system provides operators with detailed information on IMC features using 
examples and instructions. 

 User interface help provides operators with context-sensitive help that includes instructions and 
guidance specific to a particular page or feature. User interface help also provides a basic and 
advanced search facility available on almost every window in IMC. Using this feature, operators 
can quickly access the device details for any device based on the search criteria they entered. 
Most lists in IMC also provide operators with the ability to search or filter the list based on the 
criteria entered. 

IMC service components 
IMC modular and scalable SOA architecture supports the extension of IMC scope of coverage 
beyond the functionality of the base platform.  
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Additional and optional service modules are available to extend coverage. These additional areas of 
coverage include managing wireless and voice devices, QoS, MPLS VPNs, user access and 
behavior, traffic analysis, and endpoint security. IMC provides these additional areas of management 
from a single, integrated platform and Web portal. 

Wireless Service Manager 
IMC provides network administrators and engineers with a unified management system for both 
wired and wireless networks. With the IMC Wireless Service Manager component, operators can 
use the same platform to manage wireless networks and perform the following functions: 

 WLAN device configuration 

 Topology 

 Performance monitoring 

 RF coverage and planning 

 WLAN intrusion detection and defense 

 WLAN service reports 

IMC provides operators with historical reports for monitoring how wireless network usage, 
performance, and roaming patterns have changed over months or years. 

WSM provides the following functionality: 

 Unified management of wired and wireless devices, including network devices such as ACs, 
APs, Fit APs and mobile terminals. 

 Wireless and wired network scans to identify and locate unauthorized rogue APs on a network, 
including those that are not in range of authorized APs or sensors. Once detected, rogue APs or 
unauthorized users are denied access to the network. 

 Detects wireless attacks and sends alerts about network vulnerabilities to administrators. 

 Provides specialized views and reports for multiple classes of users—from Level ½ helpdesk 
staff to network engineers, security auditors, IT managers, and other user-defined groups. 

 Provides template support for wireless device configuration that facilitates centralized 
configuration and control over wireless devices. 

 UAM's wireless service logical topology mapping provides a visual display of wireless network 
deployment and the current state of devices and links on the network. 

 Provides information about a mobile terminal on the network, including its MAC address, signal 
strength, transmit rate set, RSSI, SSID, channels used, and associated AC and AP. It also 
provides the roaming records of each mobile terminal. 

 Provides topologies that show real-time RF information about the wireless network. 

 Provides rogue device detection that identifies wireless intrusions as well as the intrusion AP. 
WSM also enables you to query information about the intrusion AP, and add the intrusion AP to 
a blacklist. 

 Provides wireless statistics reports that you can query and customize. 

From a single pane, operators can manage the wired and the wireless infrastructure using the IMC 
platform and the Wireless Service Manager. 

User Access Manager 
The UAM component provides IMC users with authentication and authorization services for 
endpoints accessing the network edge.  

As a component of the IMC management platform, UAM centrally manages access for wired, 
wireless, and remote users. It supports access policies across devices such as Ethernet switches, 
routers, broadband access servers, and VPN access gateways. 
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UAM, together with the base IMC platform and other IMC modules, provides network operators with 
integrated management of users, resources, and services. 

UAM provides the following functionality: 

 RADIUS server that supports centralized AAA management of endpoints that connect and use 
network services. 

 Policy management that provides access control with tiered privilege levels. IMC UAM enables 
multiple 802.1X authentication methods such as PAP, CHAP, EAP, and MS-CHAPv2, and 
leverages existing user directories as a RADIUS proxy directly to LDAP-compliant user stores, 
such as the Microsoft Active Directory, Novelle Directory, OpenLDAP, or as a local user store. 

 Creation of realms within UAM to authenticate user names and passwords against distributed 
UAM databases. This provides authentication redundancy, which increases security and 
enables the authentication of roaming users. IMC UAM provides flexible authorization policies 
to dictate access by defining access policies for individual users, devices, and groups. 
Additionally, policies provide the ability to control access by location and time of day. 

 Reporting capabilities through its centralized, Web-based management console, which enables 
network administrators to quickly scan the activity and status of all devices currently or 
historically connected to the network. Reports can be used for real-time analysis, historical 
analysis, compliance auditing, and troubleshooting. 

 A comprehensive directory of all network attached devices and endpoints—including printers, 
IP telephony equipment, uninterruptible power supplies, HVAC systems, PXE boot hosts, and 
badge readers—to provide additional control and authentication for "non-networking" devices. 

 A single, central database of devices, users, and available services—important for networks 
that include more than one remote communications server and access device. 

 Topology view of access services that provides immediate visualization of the access 
infrastructure and online users. This provides a tool for monitoring and managing access 
systems and users. 

User Access Manager is integrated with other IMC services and features, providing operators with 
one pane for managing critical network resources. 

Endpoint Admission Defense 
The Endpoint Admission Defense (EAD) component supports operators in reducing network 
vulnerabilities by integrating security policy management and endpoint posture assessment for 
identifying and evaluating, alerting, and isolating risks at the network edge. Network Access Control 
(NAC) solutions have typically involved the integration of several functions that were usually 
deployed, configured, managed, and audited as independent systems. The HPE IMC management 
platform provides all of these functions in a single platform, eliminating the complexity of managing 
multiple systems.  

With EAD, IMC integrates security threat evaluation, identification, location, security event 
awareness, and the execution of protective measures into a centrally managed and monitored 
platform. IMC reduces implementation costs and complexity while increasing overall network 
security.  

EAD provides the following functionality: 

 Reduces the risk of malicious code or actions by detecting endpoint patches, viruses, ARP 
attacks, abnormal traffic, the installation and execution of sensitive software, as well as the 
status of system services. 

 Works in conjunction with the user access manager to define and apply appropriate security 
posture policies to every user or device on the network. With EAD, administrators can build 
policies for operating systems and operating system patches, registry settings, applications, 
processes, and services into their EAD policies. 

 The EAD security policy component allows administrators to control endpoint admission based 
on identity and the posture of the endpoint. Network operators can regulate network access 
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based on identity and posture to prevent unauthorized access to network assets and resources. 
If an endpoint is not compliant with required software packages and updates, network assets 
can be protected by blocking or isolating the endpoint's access, or by non-intrusive actions such 
as notification and monitoring of the endpoint. 

 Works in conjunction with the iNode desktop client to gather endpoint posture information to 
determine if an endpoint is compliant with established security policies.  

 With the iNode desktop client, key data theft protection features can be enabled, such as 
controlling access to USB and CD drives, to protect sensitive data. 

 To ensure continued security, EAD provides continual monitoring of endpoint traffic, installed 
software, running processes and registry changes. 

 IMC leverages the existing instrumentation of network devices supporting NetStream and 
sFlow data to provide greater visibility and control over network usage.  

Interaction with the integrated UAM component enables traffic flows to be linked with users, rather 
than IP addresses alone, for comprehensive auditing of network usage. EAD also provides operators 
with an EAD Service report that allows administrators and operators to view and analyze statistics 
related to security services. 

EAD provides operators with a single console for identifying, evaluating, locating, monitoring, 
reporting, and protecting the network from the many threats that can be introduced at the network 
edge. 

User Behavior Auditor 
The User Behavior Auditor (UBA) component is a log auditing tool that enables operators to view 
user and network access information. It is designed to process large, complex log files, and to 
present the information in a simplified tabular format. It also audits NAT, Web, and FTP site visits.  

UBA provides the following functionality: 

 Processing support for log files from NAT, NetStream, Flow, and the DIG probe. With UBA log 
analysis, operators have visibility into user behavior that supports problem identification and 
resolution, as well as network resource planning. 

 General behavior audits, NAT audits, Web visiting audits, FTP audits, and mail audits. 

 User-defined auditing templates. 

The combination of UAM and UBA offers operators tools for managing user access and 
authentication to critical network resources, as well as visibility into the behavior of users on the 
network. 

QoS Manager 
The QoSM is the core component of IMC QoS solution. QoSM provides operators with a common 
set of QoS device and configuration management features to manage QoS for different device types. 
The IMC QoSM implementation of QoS management enables operators to focus on the most critical 
aspects of QoS management service planning.  

The QoS Manager provides the following functions: 

 Auto discovery for discovering the real time QoS configurations for devices in the network.  

 Traffic classification is the basis for providing differentiated services. QoSM enables operators 
to organize traffic into different classes based on the configured match criteria, such as source 
or destination address, IP protocol type, port number, and more.  

 For effectively managing traffic control and network resources, QoSM enables operators to 
configure CAR, GTS, priority marking, queue scheduling, and congestion avoidance. 
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 Enables operators to perform traffic control through the use of QoS policies. QoS policies in 
IMC allow operators to associate a class with traffic behavior. QoSM supports multiple 
class-to-traffic behavior associations in a policy. 

 Utilizes a deployment manager, similar to the Configuration Center in the IMC platform, for 
applying QoS policies to targeted devices. Operators can define different deployment schemes 
based on the network design, enabling operators to manage and maintain QoS services 
throughout the network. The QoSM deployment manager enables operators to manage the 
application and removal of QoS policies for devices that support QoS. With the QoSM auditing 
feature, operators can check the consistency between the current configurations on the devices 
and the policy applications in the scheme. 

 Leverages ACL information on devices to provide operators with a method for creating and 
managed ACLs. 

 List of QoS-capable devices that enable operators to quickly and effectively manage their QoS 
implementations. 

Network Traffic Analyzer 
The Network Traffic Analyzer (NTA) provides operators with real time traffic analysis. It is a graphical 
network monitoring tool that leverages industry standard sources of network traffic data to generate 
real-time displays of TopN users and applications.  

NetFlow-capable routers and switches provide NTA with the data that feeds NTA reports. NTA 
analysis and reports monitor how network bandwidth and resources are being used. The analysis 
and reports also provide information that shows which hosts and users are consuming network 
resources.  

NTA also supports operators in identifying network bottlenecks and in taking corrective measures. 
The information provided by NTA supports mission critical network management activities such as 
network planning, monitoring, optimization, and troubleshooting. 

NTA provides the following features and benefits: 

 Uses embedded instrumentation available in switches and routers including sFlow, NetFlow, 
and NetStream. This lowers the cost of network monitoring by eliminating the need for 
expensive probes. 

 Supports both the strategic and tactical aspects of network management. NTA delivers detailed 
information on network bandwidth usage pattern, enabling operators and engineers to make 
well-informed policy and planning decisions. NTA also provides detailed information on specific 
applications, users, and ports, enabling operators to quickly determine the source of spikes and 
bursts to proactively monitor, control, and manage network usage. 

 Provides network managers with network-wide surveillance of complex multilayer switched and 
routed environments. This helps to ensure the rapid identification and resolution of threats to 
the network. This information allows administrators to identify suspicious behavior, respond to 
security threats, ensure quality of service, and enforce security policies. 

MPLS VPN Manager 
The MPLS VPN Manager (MVM) component provides operators with VPN monitoring and 
management features for MPLS networks. 

MVM provides the following features: 

 Allows operators to auto discover, map MPLS VPN topologies, monitor, audit, measure 
performance, and manage VPN deployment for MPLS networks. 

 Support for heterogeneous networks that include MPLS VPN devices from Cisco, H3C, and 
Huawei.  
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 Includes a MVM TE sub-component that provides monitoring of TE devices, addition and 
publishing of tunnels, and protection of service quality.  

 MVM TE enables operators to monitor the entire MPLS VPN network, distribute suitable 
network resource, and ensure service quality. 

Service Health Manager 
Service Health Manager provides the following functions: 

 Visual service quality management. 

 Integration of the alarm, performance, NTA, and NQA data.  

 Use of the KQI and SLA to monitor and measure the service health, and visually manage the 
service health. 

 Visual display of SLA statistics and rating results in diagrams and tables, so that you can 
understand the overall service level and promptly find out potential problems. 

 Use of network inspection to examine status and basic configurations on a large number of 
devices. 

 Use of path analysis to detect the path change from a source to a destination. 

IPsec VPN Manager 
IPsec VPN Manager (IVM) provides unified management of IPsec VPN configurations. It is designed 
for managing network domains, IPsec device configurations, and security proposal templates.  

IVM provides the network domain management function for IPsec VPN, GRE over IPsec, and DVPN, 
allowing operators to add IPsec devices to the same network domain for unified configuration 
management. It allows operators to perform batch deployment operations, tear down IPsec tunnels, 
and view topologies, facilitating network maintenance work. In addition, IVM cooperates with BIMS 
to manage Spoke devices that are located behind NAT and use dynamic IP addresses. 

Service Operation Manager 
The Service Operation Manager (SOM) component is a solution for the operation and maintenance 
of enterprise IT networks. It focuses on the key service switching and operation part of the ITIL 
lifecycle, and support for flows related to IT network operation and maintenance.  

With the flow management capability, SOM makes all IT operation and maintenance activities—for 
example, configuration changes and troubleshooting—controllable, measurable, and auditable. 
SOM provides Service Desk as the unified management portal for IT network services. 

Based on the automated operation and maintenance capability provided by a unified CMDB, custom 
flow framework, and self-service framework, SOM manages the following: 

 Assets 

 Configurations 

 Changes 

 Requests/events/faults 

 Troubles 

 Knowledge base in ITIL service operation and maintenance 
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Application Manager 
The Application Manager (APM), based on the IMC platform, monitors heterogeneous network 
applications. While providing continuous monitoring of network applications, it collects monitoring 
data, and generates reports for operators to address application bottlenecks and ensure the service 
reliability, availability and continuity. 

TACACS+ Authentication Manager 
The TACACS+ Authentication Manager (TAM), based on the IMC platform, performs centralized 
authentication, authorization, and auditing for device users. Authentication, authorization, and 
auditing for device users are implemented through the TACACS+ protocol. TAM supports devices of 
different models from multiple vendors, and provides flexible configurations and easy operations.  

VAN Connection Manager 
The Virtual Application Network (VAN) Connection Manager, based on the IMC platform, migrates 
the physical network configuration to the new network when migrating VMs, thus guaranteeing 
normal communication between the physical network and the virtual network. In this document, VAN 
Connection Manager is referred to as VCM. 

VCM determines the new physical network that a VM accesses by tracing the start, stop, and 
migration process of the VM, and migrates the physical network configuration before the VM is 
migrated to the new physical network, so that both the physical network configuration and the VM are 
migrated. 

Branch Intelligent Management System 
Branch Intelligent Management System (BIMS) contains the BIMS platform and the Auto 
Configuration Server (ACS). BIMS uses the TR-069 protocols to remotely and centrally manage a 
large number of customer premise equipment (CPE) devices in a WAN. It solves problems in 
managing dynamic IP addresses and devices behind NAT, saves network maintenance costs, 
improves the network management efficiency, and satisfies various CPE management requirements 
in the service provider network. 

BIMS provides the following: 

 Resource management 

 Service management 

 Configuration management 

 Alarm management 

 Report management 

 System management for CPE 

Remote Site Manager 
The Remote Site Manager (RSM), based on the IMC platform, manages the branch networks of 
enterprises. RSM uses the server/agent model. The IMC platform is deployed in the headquarters to 
manage the agents. The RSM component is deployed on each branch network as an agent to 
manage the branch network. In this way, RSM penetrates the firewalls and NAT devices on the 
branch networks, and performs unified management for the branch networks in different Internets or 
WANs. In the IMC platform, the network administrator can view the operating status of the agent for 
each branch network, view information about the multi-agent device groups, and can perform the 
following operations for devices in branch networks: 
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 Configuration management 

 ACL deployment, 

 Asset management 

 Reporting 

Additionally, RSM provides an independent administrator console. The network administrator can 
directly access the agent of each branch network, and manage the internal network of the branch. 

Resource Automation Manager 
The Resource Automation Manager (RAM) is used to customize network services for users and 
automatically deploy network services. 

Basic network functions include MSTP, VLAN, OSPF, RIP, VRRP, ACL, and QoS. 

VAN SDN Manager 
Virtual Application Network (VAN), which is developed by Hewlett Packard Enterprise, is a network 
solution for virtualization and automation of a Software Defined Network (SDN). VAN SDN Manager 
(SDNM) is used to manage OpenFlow-based SDN. SDNM allows you to manage an OpenFlow 
network through RESTful APIs. Combined with the device management, reports, and homepage 
widgets functions in the IMC platform, SDNM also allows you to perform visual management and 
monitoring on an OpenFlow network. 

VAN Fabric Manager 
The Virtual Application Network (VAN) Fabric Manager (VFM) component is data center 
management software based on the IMC platform. VAN uses virtualization, automation, and 
software-defined networking (SDN) technologies. A fabric is a network composed of FCoE switches, 
servers, and storage devices. 

VFM is positioned to offer an integrated solution for managing both the LANs and SANs in data 
centers by working with HPE devices. VFM depends on VRM to obtain virtual machine (VM) 
migration information. 

VFM provides the following functions: 

 At a Glance 

 VAN Fabric Topology 

 DC Management 

 SAN Configuration 

 LAN Configuration 

 Statistics 

Unified Communications Health Manager 
Unified Communications Health Manager (UCHM) provides a solution for monitoring the health 
status of networks deployed with Microsoft Lync Server. It allows operators to manage network 
resources including the Lync Servers, PSTN gateways, and Lync client endpoints.  

UCHM supports the auto discovery function. It uses a Topology Builder configuration file to search 
the network and add all found Lync servers and PSTN gateways to UCHM. This feature eliminates 
the need for manual device import, and prevents import errors. 
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Intelligent Analysis Reporter 
Intelligent Analysis Reporter (iAR) extends the reporting capabilities within IMC to include 
customized reporting. iAR includes a report designer, which can save designs into report templates. 
Report formats include charts. Reports can be automatically generated at specified intervals and 
distributed to key stakeholders. 

Business Service Performance 
Business Service Performance (BSP) allows you to monitor the servers, applications, and network 
devices for a service and to evaluate the service on the aspects of availability, health, and workload. 

As shown in Figure 1, BSP integrates IT services and infrastructure to monitor services in real time, 
and displays the running status of services in a common dashboard. BSP helps the operator to 
identify and troubleshoot service outages. 

Figure 1 BSP model 

 
 

How IMC works 
Network managers have been challenged by the number of systems that require managing and 
monitoring the network infrastructure. Separate, specialized systems were, and continue to be used 
for managing network faults, configuration, performance, auditing, assets, security, and 
performance. Network managers were required to maintain separate databases of devices and 
device information. Integration and interoperability between these systems were often, and continue 
to be complex and expensive. This often resulted in monolithic systems with large feature sets. 
Features did not always align with the services or needs of IT organizations or Network Operations 
Centers with multiple consoles. All of which were reporting different, uncorrelated information about 
the health and performance of the network infrastructure. 

SOA model 
The Service-Oriented Architecture (SOA) model for application development has changed what is 
possible for the management of the network infrastructure.  

SOA is an adaptable set of design principles oriented around business services that inform how an 
application is developed and integrates with other applications. An application developed with an 
SOA architecture provides its users with a set of loosely integrated services with well defined 
interfaces. It also has a method for users of those services to become aware of, communicate with, 
and use the services made available by the SOA application. 

In SOA, a service is a unit of work that is bounded, well defined, and well understood: 
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 Each service is independent, with a set of defined interfaces that other applications can call 
upon. They can be executed in a standard way without requiring any knowledge of how the 
service is performed. 

 A service can be a business process or a step in a business process.  

 Services can be combined, used, and reused to create applications that meet business needs.  

SOA also defines how services, or service providers and service consumers, communicate:  

 Service providers publish the services they offer, and the requirements to participate in those 
services.  

 A service provider is a module or service in the application that provides a service, function, or 
unit of work.  

 A service consumer is a service that makes use of the service offered by a service module and 
can be another service in the application.  

The format of service requests and responses are well defined for both service providers and service 
consumers: 

 Service requests and responses are published on the shared message or communication bus. 

 Service providers and consumers both subscribe to messages sent on the bus. 

From a software development perspective, SOA applications benefit by the separation of the 
business logic from the layers that manage and communicate with computers and other resources. 
such as Web and database interfaces. Web interfaces in SOA applications are provided for the most 
part by common libraries defined at the basic and service presentation layer. With the Web 
interfaces, developers can rely on existing and established libraries for quickly delivering a 
consistent, coherent user interface. In addition, developers can leverage existing modules or 
protocols at the data abstraction layer for communicating with databases and devices from which 
they read data or to which they write data. 

IMC is a suite of loosely integrated services based on a SOA framework that delivers unified 
resource management for devices in the network infrastructure based on the FCAPS model. IMC 
service modules encompass the FCAPS model for delivering fault, configuration, accounting, 
performance, and security management in a single framework.  

IMC provides service modules that extend to the following value-added service areas: 

 MPLS VPN management 

 Wireless service management 

 Traffic analysis 

 Guest access management 

 Authentication and authorization 

 EPON provisioning 

IMC also provides the following business service solutions:  

 SLA management 

 Desktop asset management 

 Network access control solutions 

 User behavior monitoring and management 

IMC framework layers 
Three layers in IMC conform to the three layers of the SOA framework. The first layer is the Data 
Abstraction and Data Access Layer, allowing for the separation of the business logic from database 
communications: 

 The Data Abstraction layer provides access data for resources managed by IMC, as well as 
access to databases that store information about the managed resources.  
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 IMC leverages industry standard technologies such as JDBC and JNDI for handling IMC 
database communications.  

 IMC uses JDBC as the interface to the database, which enables it to communicate with virtually 
any database that also supports JDBC.  

 IMC also relies on industry standard protocols including SNMP, Syslog, Telnet, and SSH for 
communicating with, and collecting information on, devices managed by IMC. 

The IMC platform also has a Service Presentation Layer and Basic Presentation Layer that 
separates the business logic from the processes that present IMC services and data to the IMC 
administrators and operators: 

 IMC leverages common and external SPL to deliver a unified user interface for the base IMC 
platform, and IMC modules based on XML and Web Services.  

 IMC uses a unified Web SDK to access Java libraries to publish and subscribe on the message 
bus for the presentation of information in a Web format. 

 IMC also leverages report platforms and topology platforms at the presentation layer to deliver 
IMC topology mapping and reporting services.  

The heart of IMC is the Service Logic Layer and Common Service Units of its SOA framework, also 
known as the middleware:  

 The standard and external Service Logic Libraries at the Service Logic Layer contain the 
business logic internal to IMC that drives the data analytics and processing analytics for all 
services delivered by IMC. 

 The Common Service Units in IMC include Resource, Fault, Security, Performance, 
Configuration, Log, and Data Analyzer. They are the processes external to the business logic 
that manage access and communication between the business logic at the Service Logical 
Layer and the processes at the Presentation and Data Abstraction and Access Layers.  

 The Common Service Units are what make the contained business logic available to all other 
processes in IMC as it handles publishing and subscription within IMC for all services. Figure 2 
shows a graphical representation of the IMC framework and components. 
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Figure 2 IMC platform framework 

 
 

The scenario is an example of initiating an auto discovery, navigating to the Device Details page for 
a newly discovered device, and shutting down an interface. Assume the Home page as the starting 
point for this exercise. This is a high level overview of the process and does not contain specific, 
packet for packet, request/response pairs.  

To initiate an auto discovery, view the device list, and then shut down an interface: 

1. From the IMC home page, click the Resource tab located at the top of the Home page. 

The following workflow applies: 

a. The common SPL publishes the request for the Resource page to the communication bus.  

b. The Resource CSU picks up the request, and invokes the DAL for the data that is used to 
render the dynamic data (device status) that is displayed on the Resource home page.  

c. The DAL publishes a call to the database for current information on the status of devices in 
IMC, and the database picks up the request.  

d. The results of the database query for current information are stored in the Data Cache. 

e. The Resource CSU picks up the results of the database query, and publishes the Home 
page response with the dynamic data to the communication bus.  

f. The common SPL picks up the Home page response and renders it on the operator's local 
computer. 

2. Click the Auto Discovery link to begin the process of automatically discovering and adding 
devices to IMC. 

The following workflow applies: 

a. The common SPL publishes the request for auto discovery on the communication bus, 
which is picked up by the Service Logic Layer. 

b. The Service Logic Layer identifies and forwards the request to the appropriate CSU, in this 
case the Resource CSU. 
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c. The Resource CSU publishes the Auto Discovery response on the communication bus, 
which the common SPL picks up.  

d. The common SPL renders the auto discovery configuration page on the operator's 
computer. 

3. Enter configuration parameters for the auto discovery, and then click Auto Discovery to begin 
the discovery process.  

The following workflow applies: 

a. The common SPL publishes the configuration information entered for the auto discovery on 
the communication bus, which is picked up by the Resource CSU. 

b. The Resource CSU initiates the discovery CSU, and pushes data through the JDBC 
interface into tables in the IMC database using the communication bus. 

c. The Resource CSU publishes the data to the communication bus, which is picked up by the 
common SPL for real time Web updates on the operator's local computer. 

d. The Resource CSU manages these parallel processes of discovery, of pushing and 
processing data to the database, and of updating the operator's Web interface with a 
current status. 

4. Navigate to the Device View, and then click All Devices to view a list of all devices. 

The following workflow applies: 

a. The navigation prompts the common SPL to publish a request for the All Devices page, 
which is picked up and responded to by the Resource CSU.  

b. The Resource CSU publishes a request for data, since IMC views all have dynamic data, 
which is picked up by the Data Abstraction Layer. 

c. The Data Abstraction Layer responds to the request by publishing a response with current 
information from the Data Cache or by initiating a query to the database, if necessary, to 
render current real time status information on the All Devices page.  

d. The Resource CSU publishes the response, which the common SPL picks up and displays 
on the operator's local computer. 

5. Navigate to the Device Details page for the device by clicking the link in the Device Label field 
from the All Devices list.  

The following workflow applies: 

a. The navigation prompts the common SPL to publish the request for the data specific to the 
selected device for the Device Details page, which is picked up by the SLL. 

b. The SLL identifies which of the several CSUs should be invoked by the request, and 
forwards the request to the appropriate CSU, in this case the Resource CSU. 

c. The Resource CSU again publishes a request for data, which is picked up by the Data 
Abstraction Layer.  

d. The Data Abstraction Layer responds to the request by initiating a query to the database to 
render the Device Details information for the requested device.  

e. The Data Abstraction Layer publishes the response, which is picked up by the Resource 
CSU and published on the communication bus, which the Service Logical Layer picks up 
and displays on the operator's local computer. 

6. On the Device Details page, click Interface List to drill down into the list of interfaces for the 
selected device, and then click the interface to shut it down.  

The following workflow applies: 

a. The navigation prompts the common SPL to publish the request for the Interface List and 
the Interface Details page for the specific interface.  

b. The SLL picks up both requests.  

c. The SLL identifies which of the several CSUs should be invoked by the request, and 
forwards the request to the appropriate CSU, in this case the Resource CSU.  
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d. The Resource CSU publishes the request for data, which is picked up by the Data 
Abstraction Layer.  

e. The Data Abstraction Layer responds to the request by initiating a query to the database to 
render the information on the Interface List page.  

f. The Data Abstraction Layer publishes a response, which is picked up by the Resource CSU 
and published on the communication bus, which the common SPL picks up and displays on 
the operator's local computer. 

7. Select DOWN from the Action menu located on the right of the Interface Details page.  

The following workflow applies: 

a. The navigation prompts the common SPL to publish the request for the interface DOWN 
function, which is picked up by the SLL.  

b. The SLL identifies which of the several CSUs should be invoked by the request, and 
forwards the request to the appropriate CSU, in this case the Configuration CSU. 

c. The Configuration CSU publishes the request on the communication bus, which is picked 
up by the Data Abstraction Layer.  

d. The Data Abstraction Layer determines which of the 2500+ device abstractions is required 
to fulfill this DOWN request. (A device abstraction in IMC includes a combination of 
information about the device including vendor, device type, model, command set, and 
execution method.)  

e. Once the Data Abstraction Layer has identified the abstraction to use, it then publishes a 
request on the communication bus for the method of communication. 

f. The IMC database picks up the request and publishes the communication method (SNMP, 
Telnet, or SSH) configured for the device. 

g. The Data Abstraction Layer picks up the response and begins communicating with the 
device itself using the communication method specified by the database.  

h. Using the command set and execution method specified in the abstraction, the Data 
Abstraction Layer issues the interface DOWN request to the device.  

i. The Data Abstraction Layer then publishes the status for the DOWN request to the 
communication bus, which is picked up by the Configuration CSU. 

j. The Configuration CSU publishes the status to the communication bus, which is picked up 
by the common SPL and rendered on the operator's local computer. 

SOA framework 
The SOA single, integrated framework provides organizations with a foundation for network 
management based on the FCAPS model, which is both scalable and extensible. Network 
infrastructures can grow in size, in demand for performance, in diversity of device types, and in 
demand for new functionality, and IMC grows with them. First, networks grow in size. With the IMC 
SOA framework, organizations can deploy multiple IMC systems to new areas of growth. All IMC 
instances can communicate with each other, and share information through hierarchical or 
parent/child relationships with each other. 

Networks can also grow in their demand for higher performance from IMC as the demand for network 
services and network management services grows. Given IMC distributed processing at the CSU, or 
middleware layer, and a communication bus that all IMC instances and service modules publish and 
subscribe to, operators can meet this demand by deploying separate instances of one or more 
CSUs. For example, organizations that have high demand for fault management may consider 
deploying the Fault CSU on a dedicated system. And large organizations that use IMC to manage 
device configurations and change may consider deploying the Configuration CSU on a dedicated 
system for higher performance.  

IMC can also grow in diversity of device types that can be managed. IMC abstracts information about 
device vendors, device types, command sets, and execution methods, and stores this at the Data 
Abstraction Layer that is shared by all CSU modules. This means that IMC can easily and 
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seamlessly add new devices as they emerge, and continue to add abstractions for existing devices 
with each new release of IMC. 

Given the IMC SOA framework, Hewlett Packard Enterprise continues to develop new CSU modules 
at the middleware layer that are aligned with IT functional needs as those needs change and grow. 
Extending IMC to meet new functional needs is as simple as developing a new CSU that participates 
in the publish/subscribe communication bus, shared Data Access Layer, and IMC database 
resources. 
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Planning considerations for a successful 
implementation 

Executing a successful deployment of IMC requires gathering information about what infrastructure 
stakeholders need, as well as what information they have about the network infrastructure, devices 
that comprise it, and services that run on it.  

Understanding the stakeholders' needs and requirements helps to determine how IMC must be 
configured to meet those needs. Stakeholders and IT staff also have valuable information about the 
network, its idiosyncrasies and performance, that supports the successful configuration of IMC. In 
addition to interviewing stakeholders to understand their requirements, you need to investigate 
various areas of the network infrastructure. You need to know your network in order to ensure a 
successful implementation of IMC. Once you have interviewed your stakeholders and investigated 
the many and varied layers of a network infrastructure, you are ready to begin translating 
requirements into actionable configuration tasks to create a successful deployment of IMC.  

Knowing your organization's network resource 
management requirements 

Collaborating with stakeholders to identify their needs and to determine if and how their needs are 
met by IMC is critical to the successful deployment of IMC. Identifying and interviewing stakeholders 
to understand their requirements for IMC, and gathering from them the needed information to 
effectively configure IMC is a great place to begin planning the IMC deployment.  

Identifying network infrastructure stakeholders 
To ensure a successful IMC deployment, identify the organization users and their needs. The most 
likely stakeholders of IMC are those who manage, engineer, and support the network infrastructure. 
This includes network managers, engineers, administrators, and the NOC staff. The network 
engineering and operations teams benefit significantly by the services IMC offers, and they are the 
greatest source of information and experience for guiding a successful deployment of IMC. 

Network security teams also have a need or interest in gaining visibility into the network 
infrastructure, and teams that engineer and support data center environments also benefit from IMC. 
Teams that develop and support databases and applications also have some interest or need for 
visibility into the network infrastructure. Systems management, the staff responsible for managing 
system software upgrades and patches, have an interest in the visibility that IMC provides. 

Teams that support the tracking and resolution of failures and problems, including Help Desks, have 
an interest in IMC. For organizations that have formal or informal processes for monitoring, 
managing, and reporting on service quality and compliance with service level agreements, are also 
IMC stakeholders. Organizations that deal with governance, risk and compliance issues and 
initiatives, and those who deal with auditing IT controls are also stakeholders for IMC. Managers, 
engineers and teams charged with meeting the performance requirements of the network, and those 
who plan for the future capacity demands for IT services are also key stakeholders of IMC. 

Each group of stakeholders has a unique perspective, and store of knowledge and experience of the 
network infrastructure, that help guide a successful IMC deployment.  

The most obvious example is the network engineering team who can provide network diagrams, and 
device model and series information, for network devices. 

 They should also participate in decisions regarding which traps or Syslog events from network 
devices should be escalated to alarms, and which traps should be filtered. 
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 They should also provide input into alarm thresholds and frequency of alerting. 

For organizations that do in-house application development, QA teams can be a resource for 
information about application environments, as well as what services, systems, and devices should 
be monitored, and what are the device and application dependencies. Also, they can help guide 
alarm threshold definitions. 

Identifying stakeholder needs 
The requirements for most stakeholders can be reduced to two basic needs: visibility and access. 
Visibility is the ability to see into the network infrastructure—to see into the devices, resources, links, 
and systems that constitute it—and the ability to see how well the network is performing and meeting 
the organization's needs. Delivering visibility to stakeholders is accomplished by collecting data from 
network resources, analyzing it, and presenting it in various formats. In addition, some, if not all, 
stakeholders need access to IMC to configure or manage devices, and to obtain data.  

Common data requirements 
Use the following questions as a starting point for developing your own process and set of questions 
for gathering requirements from those people in your organization who use or benefit from IMC. 

1. What Data is needed? 

a. What are the devices, resources, or systems that constitute the services that the 
stakeholders are responsible for? 

The list of devices, resources, or systems that a stakeholder offers, provides the following 
information: 

 The list of resources to monitor. 

 The vendor, series, and model information you need to research to determine what 
metrics or data is available, and what data you can collect from every device. 

b. What are the key metrics or performance indicators, that the stakeholders use to measure 
the effectiveness of the services they are responsible for delivering? 

The list of key metrics or performance indicators that a stakeholder offers, provides several 
key pieces of information: 

 How the stakeholder measures success. 

 What the stakeholder needs in terms of data to measure success. 

 If the information that the stakeholder needs can or cannot be met by the data collected 
by IMC from the devices, services, or systems that constitute the service the stakeholder 
delivers. 

c. What are the quantifiable targets or goals that the stakeholders have set for delivering on 
their service commitments? 

The list of goals that a stakeholder defines enables you to align with the stakeholder's needs, 
and use IMC to meet the organization's needs and goals. In addition, this information helps 
define threshold settings for alarms and monitoring requirements. 

d. What baseline data do the stakeholders have for measuring their targets and goals against? 

Having baseline data enables you to measure the effect that IMC has had on supporting the 
realization of the organization's goals and aligning IT with business objectives. 

2. For What Timeframe? 

a. Is the data for alarming purposes? Is the data needed in near real time? If so, what are the 
service level commitments for performance, outage duration, or service availability? How 
long can the organization wait before being notified of a problem or outage? 

These questions identify some of the monitoring requirements for fault or event 
management. Fault management identifies current failures or problems that need 
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immediate attention. The collection and processing of data, and event notification for fault 
monitoring, need to align with the service level commitments that stakeholders make. For 
example, a service level commitment of 99.999% network reachability translates into about 
five minutes of network outage per year. The polling interval used for monitoring reachability 
must be significantly less than five minutes in order to support the achievement of this 
service level commitment. 

b. Is historical reporting required? If so, in what areas is historical reporting needed? On 
resource performance? On faults or events in the network? On device configurations and 
changes to configurations? On network assets and changes to network assets? On security 
events? On access to IMC and changes to IMC? 

These questions identify in what areas historical reporting is needed. Historical reporting 
can encompass everything from network and performance management, to asset, 
configuration, change, incident, problem, and service level management. In fact, most 
groups require some form of historical reporting, and the key is to provide stakeholders with 
reports targeted to meet their needs. 

c. What level of data granularity is needed? How much summarization is needed? For how 
long does data need to be retained? 

The first question can be translated into how frequently data must be polled from the 
devices, a key requirement, as it defines how you configure polling in IMC. How many data 
samples does the stakeholder need to reliably measure their key performance indicators? 
Once you have this information, you can evaluate the load that polling places on the: 

 Resources being monitored. 

 Network resource and bandwidth consumption that monitoring introduces. 

 The processing and storage load that places on IMC. Ultimately, this involves finding a 
balance between stakeholder needs and network and IMC resource consumption. 

Data retention and summarization requirements vary for different stakeholders. The on-call 
network operations team usually requires data retention with less summarization, typically 
one day to one week of data retention. Less summarization, or more granularity, is needed 
for network operations teams as they are most closely focused on pinpointing when, how, 
and why problems occurred. The data retention and summarization requirements of 
performance analysts, whose time horizon may be up to one month or more, fall in a 
mid-range. Capacity planner time horizons are much longer, and may span five years, and 
with much greater data summarization. 

Data retention is another matter for asset, problem, incident, change, and configuration 
management, as both detail and summary reports are required. In such cases, data export 
options may be considered.  

3. In What Format? 

a. If the data is needed for alarming purposes, what method is used? Mail or SMS text 
notifications? Console display of events and alarms? Integration with other management 
systems? Integration with Help Desk ticketing systems? 

The format and method for the delivery of data varies considerably for stakeholders. 
Operations teams needing data as quickly as possible rely on methods such as mail or SMS 
text messaging, console presentation, or integration with other management systems for 
the quick delivery of data. Oftentimes, operations teams and NOCs use one or more of 
these methods and formats for data. 

b. If the data is needed for historical reporting, what kinds of reports are needed? Tabular, 
graphical?  

Historical reporting requirements typically focus more on how the data is presented. 
Understanding how your stakeholders want the data presented (bar charts, pie charts, 
scatter graphs, and tables) helps you meet their needs. 

c. Is export to raw data files required? 

Many times stakeholders want raw data as they have their own systems for analyzing and 
presenting the data in ways most useful for them. Additionally, stakeholders may have data 
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retention or polling requirements that extend beyond the scope or ability of IMC. 
Understanding the data requirements of your stakeholders enables you to know whether or 
not exporting data from IMC is the best option available for your stakeholders. 

Stakeholder access and configuration requirements 

In addition to the data that provides stakeholders with visibility into network resources and services, 
stakeholders also need access to IMC. Access might be needed for: 

 Viewing purposes only. 

 Configuring and managing devices, users, and services in IMC. 

 Configuration and management of IMC. 

Understanding what devices, users and resources IMC manages, and the levels of access needed, 
helps to configure IMC to support stakeholder needs. 

Knowing your network infrastructure 
To deploy IMC successfully, you need to have a clear understanding of the network infrastructure 
that IMC monitors and manages.  

Knowing your network topology 
While IMC does auto discoveries, it relies on the accurate identification of seed IP addresses to 
begin the discovery process. Identifying those IP addresses that best serve as seed IP addresses to 
discover the whole of your network ensures a successful IMC deployment. IMC can auto discover 
logical relationships in the network infrastructure, and this influences how IMC identifies root and 
symptom alarms in its event deduplication and root cause analysis algorithms. If needed, you can 
make adjustments to the devices IMC defines as the core and access devices that determine how 
root and symptom alarms are identified.  

The network documentation you need includes topology maps, IP addressing schemes, and 
information identifying areas of your network that require special attention. The topology maps you 
need should ideally include both physical and logical diagrams of the network. A logical map helps 
you understand the relationships between devices and verify the accuracy of the topology maps 
generated by IMC. Physical diagrams, including data center maps and details of individual wiring 
racks, support you in creating accurate data center topology maps in IMC. 

Next, you need current and accurate documentation on the IP address schemes used. IP address 
documentation should also include any areas in your infrastructure that have overlapping address 
spaces. In addition, this documentation should include any locations or devices on the network that 
use non-routable IP addresses. The network documentation should also identify areas or zones in 
your network that have special access requirements. For example, many companies prefer to 
separate internal corporate user traffic from external customer traffic, and use layers of firewalls to 
separate these zones. In addition, many corporations create zones within zones to create secure 
application environments for the Web, application, and database tiers. Tiers and zones may have 
specific access requirements. Understanding the management system requirements is necessary to 
configure IMC to manage devices in those tiers and zones. 

Knowing your device vendors, series, and models 
IMC uses device vendor, series, and model information in the Configuration Center to determine 
whether or not configuration and software files can be successfully deployed to devices in the 
network. Knowing what you have, and configuring this information when IMC cannot auto discover, 
supports you in managing the complex task of device configuration and software and patch 
management: 

 Make a list of all of the vendors that provide the devices and resources that are the building 
blocks of your network. 
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 Gather the device series and model information for every unique device type in your 
environment.  

 Take the output of an asset inventory for your network and combine it with the device vendor, 
model, and series information you have gathered so that you have clear and comprehensive 
details for all devices in your network. 

 Comparing asset inventories to the IMC database of devices provides a gap analysis of what 
you have versus what IMC knows about your network. 

Identifying device vendor, series, and model information enables you to more easily identify and 
research vendor specific enterprise MIBs that contain objects, including traps, for customized and 
optimized monitoring of devices:  

 Once you have identified the MIB objects for which you want to poll, you can create 
user-defined global index monitors that can be applied to all devices of the same vendor series 
and model type.  

 Once you have identified the traps you want to process, you can create user-defined trap 
definitions and apply them to all devices of the same type. 

Having concise, usable, and consistently applied device naming standards simplifies IMC 
administration.  

IMC uses the MIB-2 object sysName, the administratively assigned name for a managed device, as 
the Device Label or name in IMC, unless an IMC administrator or operator configures a custom 
Device Label. 

Knowing access requirements and standards of your 
organization 

Consider the following aspects of access in the planning stages of an IMC deployment:  

 Organization access requirements and restrictions for IMC to manage devices. 

 Requirements for providing operators with access to IMC. 

IMC uses several methods to manage devices: 

 IMC uses SNMP (v1, v2c, or v3) to poll devices for management and monitoring data, and to 
receive SNMP traps from devices for proactive notification of events on managed devices.  

 IMC uses ping or ICMP requests for status polling and reachability statistics for managed 
devices. IMC also uses Telnet or SSH to manage devices. 

You need to understand your organization's policy on the use of SNMP, ICMP, Telnet, and SSH in the 
various zones and application tiers of your network, in order to use IMC to manage devices in them. 
IMC uses TCP and UDP ports to communicate with other IMC servers and modules. Understanding 
your organization's policy on permitting this traffic facilitates a successful implementation. 

You need to work with the teams that manage access control lists and firewall rules to ensure the 
following:  

 SNMP, ICMP, Telnet, and SSH traffic are permitted for all networks, zones, and application tiers 
that have resources you want to manage. 

 TCP and UDP ports that IMC uses to communicate with other servers and modules are also 
permitted. 

Alternatively, your organization may have a management VLAN or subnet dedicated to management 
systems for which this traffic is permitted for devices in the VLAN or subnet. If your organization has 
such a VLAN or subnet, be sure to locate the IMC servers in this VLAN or subnet. 

To manage devices using SNMP: 

 Enable SNMP on every managed device, using the version of SNMP your organization 
mandates. 
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 Configure the device to forward SNMP traps to IMC if you have designated IMC as the device to 
process and display SNMP traps. 

 Configure IMC with the SNMP configuration that allows it to poll SNMP devices, as well as to 
receive SNMP traps from managed devices. 

 Use the SNMP templates feature to configure IMC for all devices that are monitored and 
managed using SNMP. 

You can configure IMC to receive traps from devices when the devices are auto-discovered or added 
to IMC. 

To manage devices with Telnet and SSH: 

 Configure every device to enable Telnet and/or SSH sessions. See the vendor documentation 
for instructions. 

 Configure IMC with the Telnet or SSH settings to allow IMC to establish a session with a 
managed device.  

 Use Telnet and SSH templates to simplify the process of adding device specific Telnet and SSH 
configuration information to IMC. 

Some features in IMC require a Telnet or SSH application on the operator's local computer.  

IMC can use the native Telnet and SSH clients that most operating systems provide.  

Check with your organization's requirements regarding the use of Telnet or SSH for secure access to 
managed devices. 

Identifying security policies and restrictions for monitoring 
To successfully deploy IMC, you must identify the various zones and application tiers in your 
network, and what the access policies are for each of them: 

 Is ICMP, SNMP, Telnet, and SSH traffic permitted to and from each of the zones that contain 
one or more devices you want to manage, and the VLANs or subnets that IMC resides on? 

 What is required to permit ICMP, SNMP, Telnet, and SSH traffic to the zones and tiers? 

Configure the version of SNMP that is mandated by your organization on each device to be managed 
using SNMP. The SNMP configuration on the device must match the SNMP configuration for the 
device in IMC.  

Identify your organization's requirements for the use of Telnet or SSH for managed devices, and 
configure each device and IMC accordingly. 

Identifying your organization's password requirements for SNMP community strings, Telnet, and 
SSH passwords, as well as IMC operator accounts, enables you to configure IMC to meet those 
requirements. 

Identifying the integration requirements and 
opportunities 

IMC may not be the only management system in your infrastructure. Consider the following 
questions to determine how to accomplish integration:  

 Is IMC the destination for events and alarms generated by IMC as well as by other management 
systems? 

 Is IMC the repository and console for SNMP traps and Syslog events?  

 Does your organization have a manager of IMC systems or other systems that processes 
events from many management systems? 

 Does your organization have a help desk to which events and alarms should be forwarded? 
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Translating requirements into actions 
The first step in a successful deployment is gathering requirements. The next step is translating 
requirements into actions, which varies by organization. 

The following lists provide some ideas for configuring IMC: 

Compiling information 

1. Compile a list of vendors that include vendor contact information. 

2. Compile a list of vendor series information for all unique device series. 

3. Compile a list of vendor model information for all unique device models. 

4. Identify which metrics collected by IMC can be translated into key metrics or performance 
indicators to meet stakeholder requirements.  

 Do any of the metrics require enterprise MIBs that need to be compiled into IMC? 

 Do new user-defined global monitors need to be created? 

5. Obtain MIBs to compile into IMC to support additional fault and performance monitoring. 

6. Compile MIBs into IMC. 

7. Compile a list of devices that include the following information for each device: 

 Vendor 

 Series Name 

 Model Name 

 SNMP Settings 

 Telnet Parameters 

 SSH Parameters 

 Default or Custom status polling requirements 

 Default or Custom configuration polling requirements 

 Default or Custom performance monitoring requirements 

 List of services running on the device that require monitoring 

 Management IP Address 

 Identify people that require access for viewing or managing the device 

 Identify recipients of mail or text notifications for alarms for this device 

 Identify device groups to which this device should belong 

 Identify custom views to which this device should belong 

Network infrastructure  

1. Work with your organization's network, security, and change control teams to implement 
network management VLANs, and to permit traffic between IMC and all devices managed by 
IMC for all zones and tiers in the application environments. 

2. Make or request changes to device naming conventions to simplify and standardize naming 
between IMC and the physical devices. 

Event and performance management 

1. Verify that IMC system-defined trap and Syslog definitions capture all events, and escalate 
events to alarms for devices, as defined by the gathered requirements. 

2. Verify that IMC system defined trap and Syslog filters eliminate unwanted events as needed. 

3. Configure user-defined trap and Syslog definitions, and configure to escalate to alarms as 
needed to meet requirements. 

4. Configure user-defined trap and Syslog filters to eliminate unwanted events. 
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5. Create user-defined global monitors to meet stakeholder requirements for monitoring 
performance and reporting. 

6. Customize as needed the default set of monitor indexes before adding devices to IMC, so that 
once devices are added, the default set of monitors are applied. 

7. Define performance monitoring thresholds as needed, for global monitors that map to key 
metrics for devices or that notify operators of degraded conditions. 

8. Configure status and configuration polling intervals for devices to map to key metrics and 
service level commitments. 

9. Configure mail, SMS, and alarm forwarding to other management systems based on 
requirements. 

10. Identify custom reporting requirements for faults, performance, configuration, change, and 
security. 

11. Configure Data Export based on data export and retention requirements. 

Groups and views 

1. Define operator groups based on stakeholder requirements for access to IMC features and 
devices, users, and services managed by IMC. 

2. Create device, user, and service groups based on stakeholder requirements for device access 
and management requirements. 

3. Create custom views based on stakeholder requirements for access to devices. 

4. Add vendor, device series, device category, and device model information. 

Device access 

1. Create an SNMP template for every unique SNMP configuration. 

2. Create a Telnet template for every unique Telnet configuration. 

3. Create an SSH template for every unique SSH configuration. 

4. Create an SOAP/HTTP template for Virtual Resource Management to manage virtual network 
devices. 

5. Create a WMI template for Virtual Resource Management to manage virtual network devices. 

6. Create a PowerShell template for Virtual Resource Management to manage virtual network 
devices. 

System configuration 

Configure the transfer mode option for Configuration Center for transferring software and 
configuration files. 

Adding devices 

1. Compile a list of seed IP addresses that allows you to streamline the discovery process. 

2. Develop a strategy for adding devices to the network using one or more of IMC auto discovery 
methods. 

3. Auto discover devices using one or more methods as needed, and include in the configuration 
the ability to automatically register IMC to receive SNMP traps from all supported devices 
configured to send SNMP traps to IMC. 

4. Add devices manually that cannot or were not auto discovered, and include in the configuration 
the ability to automatically register IMC to receive SNMP traps from all supported devices 
configured to send SNMP traps to IMC. 

5. Add devices to device groups and custom views based on gathered information. 

6. Add device vendor, series, category, and model information to devices manually added or to 
devices for which this information could not be discovered automatically. 

7. Use physical maps to create data center maps for dynamic data center mapping. 

8. Use the IP address scheme documentation to document the allocation of IP addresses in IMC. 

9. Map IP addresses to Mac addresses and MAC addresses to interfaces as needed. 
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10. Configure Asset Manager to collect asset information based on stakeholder requirements. 

11. Configure configuration backups and configuration checks as dictated by requirements. 

12. Configure performance views to meet historical reporting requirements for chart type and 
metrics. 

13. Configure My Real Time Reports as needed to meet reporting requirements. 

14. Apply configuration and software baselines to all devices. 

15. Disable status polling for devices that cannot be pinged. 

Access to IMC 

1. Create operator accounts based on requirements gathered for operator access to devices and 
IMC services and features. 

2. Configure a password strategy in IMC that aligns IMC passwords with organizational policies on 
passwords. 

3. Configure IMC to use an existing LDAP system for password authentication if your organization 
uses LDAP. 

4. Restrict operator access to IMC as needed by configuring login control templates. 
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Exploring the IMC interface 
IMC provides unified visibility for all IMC features, services and components through a single Web 
portal. This Web portal offers a common launch point for all installed IMC and add-on modules.  

 IMC administrators use this Web portal for configuring all IMC settings and functions. 

 Network infrastructure engineers, administrators, and managers can use the Web portal for 
performing tasks. Tasks range from viewing and managing network user activity, to configuring 
and viewing the current status and performance of devices. 

Standard IMC supports access to IMC resources from mobile clients. It allows you to: 

 View faulty device and interface information 

 Query specific device information 

 View alarm information 

 Perform device reachability tests (ping) 

 View custom views and device views 

 Log in to IMC through the browser on a mobile client (IMC supports Android and iPhone 
clients.) 

The following information covers the IMC Web interface, IMC context sensitive online help, and how 
to customize the IMC interface to meet individual administrator needs.  

The online help system provides help for each window, as well as system-wide help. 

Logging in to IMC 
To log in to IMC: 

1. Enter the URL for the IMC server in the browser, including the port number for IMC. 

 http://servername:portnumber/imc 

 https://servername:portnumber/imc 

Where server name is the name of the IMC server, and port number is the TCP port assigned to 
IMC during installation. 

Alternatively, the IP address of the server can be used instead of the server name. 

2. Enter the user ID assigned to you in the Operator field. 

3. Enter your password in the Password field. 

4. Click Log In or press Enter. 

Exploring the IMC home page 
The IMC home page displays information in a hierarchical way. It comprises two layers, space and 
widget. If you log in to IMC for the first time, you can see the default space, which comprises widgets 
displaying the alarm, resource, and performance summary information of the IMC, as shown in 
Figure 3. 

IMC modules also offer a variety of widgets in order to meet your viewing and monitoring needs.  

You can customize a space and add system-defined alarm, resource, performance, and other 
modules' widgets to your space. In addition, you can customize RSS widgets, which provide you with 
the ability to subscribe to RSS feeds. 
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Figure 3 IMC home page 

 
 

No data is available for any widgets displayed in the default space when you log in to the IMC home 
page for the first time. After devices are added to IMC, the system immediately generates statistics 
and displays them in the default space. 

Basic operations on the IMC home page 

The IMC home page provides the Settings icon  that helps you view and customize the home 
page. Click the icon to view accesses to respective functions, as shown in Figure 4. 

Figure 4 Space tabs and the Settings icon 
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Maximizing the home page 

1. Click the Settings icon . 

2. Select Maximize from the shortcut menu to hide the tabular navigation system at the top and 
maximize the home page.  

3. Select Restore from the shortcut menu to display the tabular navigation system at the top. 

Adding a space 

1. Click Expand icon  on the space tab. A new space tab named New Space 

 is displayed.  

2. Enter the name for the new space, and then click any blank part of the page to complete naming 
the space. 

Renaming a space 

 Click the Expand icon  next to the space name on the space tab, and then select Rename 
from the list 

 Double-click the space, type a new name for the space, and then click any blank part of the 
page to complete renaming the space. 

Switching between spaces 

To switch between spaces, click the relevant space tabs. 

Saving a space 

1. Click the Settings icon . 

2. Select Save from the shortcut menu. 

If no modification is made for the current space, the Save icon  is unavailable. You do not 
need to save the space. 

Deleting a space 

1. Click  next to the space name on the space tab. 

2. Select Delete from the list. 

3. Confirm your operation. 

You cannot delete the default space Welcome. 

Adding new widgets to a space 

1. Click the Settings icon . 

2. Select Edit from the shortcut menu to launch the dialog box for adding widgets. By default, the 
dialog box provides 39 types of resource, alarm, and performance statistics widgets defined by 
the system. 

If no widget is contained in the space,  is displayed in the middle of the space. You 
can launch the dialog box for adding widgets by clicking the icon. 

3. Locate a widget by using one of the following methods: 

 Query a widget 

In the upper right corner of the dialog box, enter the keyword of a widget name, and then 
click Query. All widgets matching the query criteria are displayed in the dialog box. Query 
supports fuzzy matching and is case-sensitive.  

 Sort widgets 

 In the upper left corner of the dialog box, select the All, Resource, Alarm and 
Performance tab to display all widgets, resource-related widgets, alarm-related 
widgets, and performance-related widgets.  
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 In the bottom right corner of the page, click Previous or Next to display widgets on the 
previous or next pages. 

Use either method to display the desired widgets in the dialog box. 

4. Click  for a widget to add it to the space.  

Then  changes to Succeeded, indicating the widget was successfully added.  

You can add up to 10 widgets to a space.  

5. Click OK to complete the operations and return to the space.  

Changing the widget layout of a space 

1. Click the Settings icon . 

2. Select Edit from the shortcut menu to launch the widget dialog box. 

3. Change the layout by using one of the following methods: 

 Quick Layout 

At the top middle of the widget dialog box, select a layout: 

  means two widgets are displayed per row. The left widget occupies 2/3 and the right 
occupies 1/3 of the row.  

  means two widgets are displayed per row. The left widget occupies 1/3 and the right 
occupies 2/3 of the row.  

  means two widgets are displayed per row, each occupying 1/2 of the row.  

  means three widgets are displayed per row, each occupying 1/3 of the row. 

  means one widget is displayed per row. 

  means two widgets are displayed per row. The left widget occupies 1/4 and the right 
occupies 3/4 of the row. 

  means two widgets are displayed per row. The left widget occupies 3/4 and the right 
occupies 1/4 of the row. 

  means three widgets are displayed per row. The middle widget occupies 1/2 and 
each of the other two occupies 1/4 of the row. 

 Layout 

 Click the Layout tab. 

 Select a layout for each row in the same way that you select a layout using the quick 
layout method. 

 Select a row height from the list next to each row. By default, the value of the row height 
for each row is 400. 

 Click . 

4. Click OK to complete the operations and return to the space. 

Expanding/Collapsing all widgets of a space 

 To expand all widgets in the current space, click the Settings icon , and then select Expand 
All from the shortcut menu. 

 To collapse all widgets in the current space, click the Settings icon , and then select 
Collapse All from the shortcut menu. 

Expanding/Collapsing a widget of the space 

 To expand a widget, click the Restore icon  in the upper left corner of a widget. 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 8442



41 

 To collapse a widget, click the Minimize icon  in the upper left corner of a widget. 

Dragging and dropping a widget 

1. Point to the name bar of a widget. 

2. When the cursor becomes a black cross , drag and drop the name 
bar to place the widget to the desired position. 

Refreshing a widget manually 

To refresh a widget, click the Refresh icon  in the upper right corner of the widget. 

Setting the refresh interval 

1. Click the Set icon  in the upper right corner of the widget to launch the Setting dialog box. If 
other parameters are required for the widget, two options, Setting and Refresh Interval, are 
provided.  

2. Click Refresh interval to enter the refresh interval setting window.  

3. If no other parameters are required for the widget, the Setting dialog box opens. Available 
options include No Refresh, 1, 5, 10, and 30, in minutes.  

4. Select a refresh interval, and then click OK. 

Opening a widget in a new window 

To open a widget in a new browser window, click the New Window icon  in the upper right corner 
of the widget. 

This feature is available only for some widgets. 

Deleting a widget from the space 

To delete a widget, click the Delete icon  in the upper right corner, and then confirm your 
operation. 

Maximizing/Restoring a widget 

To maximize a widget, click the Maximize icon  in the upper left corner of the widget. 

To restore a maximized widget, click the Restore icon  in the upper left corner of the widget. 

This feature is available only for some widgets. 

Setting a widget title 

1. Click the Modify icon  in the upper right corner of a widget. 

2. Edit the title settings: 

 Select or clear the check box next to the widget name to display or hide the widget name. 

 Enter a widget name when the widget name is displayed. 

3. Click OK. 

Setting the widget background 

1. Click the Color icon  in the upper right corner of a widget. 

2. Select a color from the color list. 

3. Click OK. 

Displaying more widget content 

To display more content in the right area of a widget, click the Right icon  in the upper right corner 
of the widget. 

To display more content in the left area of a widget, click the Left icon  in the upper right corner of 
the widget. 
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You can also move the scrollbar to the right or left of a widget to display more content of the widget. 

This feature is available only for some widgets. 

Alarm, performance, and resource widgets 
By default, IMC provides 45 types of resource, alarm, and performance statistics widgets defined by 
the system. 

Alarm TopN 

By default, the Alarm TopN widget, as shown in Figure 5, displays the topN devices generating the 
most alarms. The y-axis indicates the device, and the x-axis indicates the alarm quantity. The 
content includes the device information (Device Label (IP) by default), alarm type, and the quantities 
of alarms.  

Figure 5 Alarm TopN 

 
 

The color of the alarm for each device reflects in real time. Color-coding of the severity or alarm level 
conforms to industry standards, and is displayed in Table 2. 

Table 2 Color-coding of the severity or alarm level 

Color  Severity or alarm level  

 Critical 

 Major 

 Minor 

 Warning 
 

Click the Set icon  in the upper right corner of the widget, and then select Setting to launch the 
Setting dialog box. 

 Alarm Level—Specifies the alarm level for alarms to be displayed. The available options 
include Critical, Major and Higher, Minor and Higher, Warning and Higher. 

 Unrecovered Alarm Statistics—Specifies the number of devices to be displayed for the 
Alarm view. The available options include 5 and 10. 
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Alarm TopN 

The Alarm TopN widget, as shown in Figure 6, displays the top five devices generating the most 
alarms in a ring chart. Each ring displays a device label and the total number of alarms that the 
device has generated. 

Figure 6 Alarm Top5 

 
 

The color of the alarm for each device reflects in real time. Color-coding of the severity or alarm level 
conforms to industry standards, and is displayed in Table 3. 

Table 3 Color-coding of the severity or alarm level 

Color  Severity or alarm level  

 Critical 

 Major 

 Minor 

 Warning 

 Info 
 

 Click the Set icon  in the upper right corner of the widget, and then select Setting to launch 
the Setting dialog box. Alarm Level—Specifies the alarm level for alarms to be displayed. The 
available options include Critical, Major and Higher, Minor and Higher, and Warning and 
Higher.  

 Unrecovered Alarm Statistics—Specifies the number of devices to be displayed for the 
Alarm view. The available options include 5 and 10. 

Lower-Level System Real-Time Alarm 

The Lower-Level System Real-Time Alarm widget displays the real-time alarms for a lower-level 
NMS, as shown in Figure 7. 
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Figure 7 Lower-Level System Real-Time Alarm 

 
 

Click the Recover or Acknowledge link for an alarm to recover or acknowledge the alarm. 

Click the Set icon  in the upper right corner of the widget, and then select Lower-Level System to 
launch the Setting dialog box. Select the IP address of a lower-level NMS from the Select 
Lower-Level System list. The Lower-Level System Real-Time Alarm widget displays all real-time 
alarms for the lower-level NMS. 

Upper and Lower-Level System Real-Time Alarm 

The Upper and Lower-Level System Real-Time Alarm widget displays the real-time alarms for all 
upper and lower-level NMS, as shown in Figure 8. 

Figure 8 Upper and Lower-Level System Real-Time Alarm 

 
 

Click the Recover icon  or Acknowledge icon  for an alarm to recover or acknowledge the 
alarm. 
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Real-Time Alarms 

The Real-Time Alarms widget displays the real-time alarms for IMC, as shown in Figure 9. 

Figure 9  Real-Time Alarms 

 
 

Click the Recover icon  or Acknowledge icon  for an alarm to recover or acknowledge the 
alarm. 

Click the Set icon  in the upper right corner of the widget, and then select Alarm Level to launch 
the Setting dialog box.  

 Alarm Level—Select an alarm level for alarms to be displayed from the Alarm Level list. The 
available options include Critical, Major and Higher, Major, Minor and Higher, Minor, 
Warning and Higher, and Warning. 

 Number—Select the number of alarms to be displayed. The available options include 10, 20, 
30, 40, and 50. 

 Alarm Time—Select the Durations or Generated time. 

 Add Device—Click Add Device to select the devices for which the alarms are to be displayed. 

Click the  icon to delete selected devices from the device list.  

Lower-Level System Alarm Statistics 

The Lower-Level System Alarm Statistics widget, as shown in Figure 10, displays alarms for a 
lower-level NMS. The y-axis indicates the alarm category, and the x-axis indicates the alarm quantity. 
The content includes the alarm categories, quantities of alarms, and alarm levels.  
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Figure 10 Lower-Level System Alarm Statistics 

 
 

Click the Set icon  in the upper right corner of the widget, and then select Lower-Level System to 
launch the Setting dialog box. Select the IP address of a lower-level NMS from the Select 
Lower-Level System list. The Lower-Level System Alarm Statistics widget displays all alarms for 
the lower-level NMS. 

Upper and Lower-Level System Alarm Statistics 

The Upper and Lower-Level System Alarm Statistics widget, as shown in Figure 11, displays 
alarms for all upper and lower-level NMS. The y-axis indicates the alarm category, and the x-axis 
indicates the alarm quantity. The content includes the alarm categories, quantities of alarms, and 
alarm levels.  

Figure 11 Upper and Lower-Level System Alarm Statistics 

 
 

Unrecovered Alarm Statistics 

The Unrecovered Alarm Statistics widget, as shown in Figure 12, displays the total number of 
unrecovered alarms in a card chart, and displays the total alarm number for each alarm level in a 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 8448



47 

card chart and bar chart. Each card or bar displays an alarm level and the total alarm number for the 
alarm level. 

Figure 12  Unrecovered Alarm Statistics 

 
 

Performance Instance Profile 

The Performance Instance Profile widget, as shown in Figure 13, allows the creation of one or 
more monitor instances in an interested index as a performance instance profile. It can be displayed 
on the home page so that users can view the performance data of monitored instances at any time. 
Multiple Performance Instance Profile widgets can be customized, but the total number of 
customized Performance Instance Profile widgets cannot exceed 10. 

Figure 13 Performance Instance Profile 
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After you customize the performance instance profiles for the first time, you can click Performance 
Instance Profile to add a performance instance profile. For more information, see "Adding an 
instance profile." 

To select a performance instance profile that has been created, click the Set icon  in the upper 
right corner of the widget, and then select Setting to launch the Setting dialog box. 

 Name—Specifies the name of a performance instance profile. All existing performance 
instance profiles are displayed in the list. 

 Time Range—Specifies the time range for statistics collection. 

 Type—Specifies how the Performance Instance Profile is displayed, including Trend Line 
and Data Grid. A trend line displays the performance data trend for each monitor instance within 
the past period. A data grid displays the performance data statistics for each monitor instance 
within the past period, including the maximum, minimum, and average value of performance 
data. 

Performance View Profile 

The Performance View Profile widget, as shown in Figure 14, allows you to create monitor 
instances in one or more interested indexes as a performance view profile. It can be displayed on the 
home page so that users can view the performance data of the performance view at any time. 
Multiple Performance View Profile widgets can be customized, but the total number of customized 
Performance View Profile widgets cannot exceed five. 

Figure 14 Performance View Profile 

 
 

To select a performance view that has been created, click the Set icon  in the upper right corner of 
the widget, and then select Setting to launch the Setting dialog box. 

 Performance View Name—Specifies the name of a performance view. All existing 
performance views are displayed in the list. For more information about creating a performance 
view, see "Creating a Data Grid/Trend Line performance view" and "Creating an At a Glance 
performance view." 

 Level—Specifies the level for which performance data of monitored instances is to be 
displayed. The available options include All Instance, Exceeds the level-1 threshold, and 
Exceeds the level-2 threshold.  

CPU Utilization (%)—TopN 

By default, the CPU Utilization TopN table, as shown in Figure 15, displays the topN high-utilization 
CPUs within the last hour. The content includes the time range, device/slot to which the CPU 
belongs, and the CPU utilization.  
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Figure 15 CPU utilization 

 
 

Click the Set icon  in the upper right corner of the widget, and then select Setting to launch the 
Setting dialog box. 

 Time Range—Specifies the time range for statistics collection. The available options include 
Last Hour, Today, Yesterday, This Week, Last Week, This Month, Last Month, This Year, 
and Last Year.  

 Top—Specifies the number of monitoring instances for the widget. The available options 
include 5, 10, 20, and 30. 

CPU Utilization (%)—Top5 

By default, the CPU Utilization Top5 widget, as shown in Figure 16, displays the top five instances 
with the highest CPU utilization for the last hour in a line chart. When you point to a time on a curve, 
a tip appears and displays the instance name, collection time, and collection data of the specified 
time. Press and drag the mouse to select a time range on the x-axis to view the line chart for that time 
range. 
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Figure 16 CPU Utilization Top 5 

 
 

Click the Set icon  in the upper right corner of the widget, and then select Setting to launch the 
Setting dialog box. 

 Custom View—Specifies the custom view in which you want to view the top 5 devices by CPU 
utilization. By default, you can select All Devices or My Network View. If you have added 
views on the Resource > Custom View page, these custom views are displayed on the list. 

 Time Range—Specifies the time range for statistics collection. The available options include 
Last Hour, Today, Yesterday, This Week, Last Week, This Month, Last Month, This Year, 
and Last Year.  

 Display Mode—Specifies the display mode of the widget. Options are Line and Ring. To 

quickly change the display mode, click the Line Mode icon  or the Ring Mode icon  in 
the upper right corner of the widget. When the display mode is set to Ring, the widget displays 
the top five instances in a ring chart. Each ring displays a device label and the CPU utilization of 
the respective instance. Click a ring to view details of the respective instance. 

 Show Legend—Specifies whether to display legends on the line chart. 

Interface Flux TopN 

The Interface Flux TopN widget, as shown in Figure 17, displays the top N monitored interfaces 
with the most traffic. Parameters on the widget include the interface index, realtime traffic rate, 
maximum traffic rate, and average traffic rate of the interfaces. Before configuring this widget, you 
must add receiving/sending rate monitors for the device interfaces in Performance Management.  
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Figure 17 Interface Flux TopN 

 
 

Click the Set icon  in the upper right corner of the widget, and then select Setting to launch the 
Setting dialog box. 

 Included View—Selects the custom views for which you want to collect interface traffic 
statistics. Traffic statistics will be collected for interfaces of devices in the selected views.  

 Excluded View—Selects the custom views for which you do not want to collect interface traffic 
statistics. Traffic statistics will not be collected for interfaces of devices in the selected views. 

 Direction—Selects the direction of traffic for which statistics are collected. The available 
options include IN, OUT, and Both, which represent incoming traffic, outgoing traffic, and both 
incoming and outgoing traffic, respectively.  

 Time Range—Specifies the time range for statistics collection. The available options include 
Last Hour, Today, Yesterday, This Week, Last Week, This Month, Last Month, This Year, 
and Last Year.  

 Top—Specifies the number of monitoring instances for the widget. The available options 
include 5, 10, 20, and 30. 

 Granularity—Specifies the granularity of interface traffic statistics collected. The available 
options include Original Value, 1 Hour Average, and 1 Day Average, which represent the 
minimum granularity of original statistics (collected every 5 seconds), hourly average, and daily 
average, respectively.  

Port Group TopN 

The Port Group TopN widget, as shown in Figure 18, displays topN interfaces with the highest 
performance monitoring data and their device names in the specified port group. Click the View icon 

 next to the widget to view the interface list of the port group. 
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Figure 18 Port Group TopN 

 
 

Click the Set icon  in the upper right corner of the widget, and then select Setting to launch the 
Setting dialog box. 

 Port Group—Select a port group from the list. Options include all existing port groups in IMC. 

 Monitor Index—Select a performance index from the list. Options include Interface Receiving 
Rate (bps), Interface Transmitting Rate (bps), Interface In-Bandwidth Usage, Interface 
Out-Bandwidth Usage, Interface Receiving Broadcasting Rate (packet/s), Interface 
Transmitting Broadcasting Rate (packet/s), Proportion of Receiving Packets Discarded 
on Interface, and Proportion of Transmitting Packets Discarded on Interface. 

 Top—Specifies the number of monitoring instances for the widget. Available options include 5, 
10, 20, 30, and Custom. If Custom is selected, enter a value in the Custom TopN field. 

Memory Utilization (%)—TopN 

By default, the Memory Utilization TopN table, as shown in Figure 19, displays the topN memories 
with the highest utilization within the last hour. The content includes the time range, device/slot to 
which the memory belongs, and memory utilization.  
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Figure 19 Memory Utilization 

 
 

Click the Set icon  in the upper right corner of the widget, and then select Setting to launch the 
Setting dialog box. 

 Time Range—Specifies the time range for statistics collection. The available options include 
Last Hour, Today, Yesterday, This Week, Last Week, This Month, Last Month, This Year, 
and Last Year.  

 Top—Specifies the number of monitoring instances for the widget. The available options 
include 5, 10, 20, and 30. 

Memory Utilization (%)—Top5 

By default, the Memory Utilization Top5 widget, as shown in Figure 20, displays the top five 
instances with the highest memory utilization for the last hour in a ring chart. Each ring displays a 
device label and the memory utilization of the respective instance. Click a ring to view details of the 
respective instance. 
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Figure 20 Memory Utilization Top 5 

 
 

Click the Set icon  in the upper right corner of the widget, and then select Setting to launch the 
Setting dialog box. 

 Custom View—Specifies the custom view for which you want to view the top 5 devices by 
memory utilization. By default, you can select All Devices or My Network View. If you have 
added views on the Resource > Custom View page, these custom views are displayed on the 
list. 

 Time Range—Specifies the time range for statistics collection. The available options include 
Last Hour, Today, Yesterday, This Week, Last Week, This Month, Last Month, This Year, 
and Last Year.  

 The Display Mode—Specifies the display mode of the widget. Options are Line and Ring. To 

quickly change the display mode, click the Line Mode icon  or the Ring Mode icon  in 
the upper right corner of the widget. When the display mode is set to Line, the widget displays 
the top five instances in a line chart. When you point to a time on a curve, a tip appears and 
displays the instance name, collection time, and collection data of the specified time. Press and 
drag the mouse to select a time range on the x-axis to view the line chart for the that range. 

 Show Legend—Specifies whether to display legends on the line chart. 

Device Response Time (ms)—TopN 

By default, the Device Response Time TopN table, as shown in Figure 21, displays the top N 
devices with the longest response time within the last hour. The content includes the time range, 
device name and IP address, and the response time.  
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Figure 21 Device Response Time 

 
 

Click the Set icon  in the upper right corner of the widget, and then select Setting to launch the 
Setting dialog box. 

 Time Range—Specifies the time range for statistics collection. The available options include 
Last Hour, Today, Yesterday, This Week, Last Week, This Month, Last Month, This Year, 
and Last Year.  

 Top—Specifies the number of monitoring instances for the widget. The available options 
include 5, 10, 20, and 30. 

Device Response Time (ms)—Top5 

By default, the Device Response Time Top5 widget, as shown in Figure 22, displays the top five 
devices with the longest response time for the last hour in a card chart. Each card displays a device 
label and the response time of the respective instance. Click a device label to view details of the 
respective instance.  
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Figure 22 Device Response Time Top 5 

 
 

Click the Set icon  in the upper right corner of the widget, and then select Setting to launch the 
Setting dialog box. 

 Time Range—Specifies the time range for statistics collection. The available options include 
Last Hour, Today, Yesterday, This Week, Last Week, This Month, Last Month, This Year, 
and Last Year.  

 The Display Mode—Specifies the display mode of the widget. Options are Line and Card. To 

quickly change the display mode, click the Line Mode icon  or the Card Mode icon  in 
the upper right corner of the widget. When the display mode is set to Line, the widget displays 
the top five instances in a line chart. When you point to a time on a curve, a tip appears and 
displays the instance name, collection time, and collection data of the specified time. Press and 
drag the mouse to select a time range on the x-axis to view the line chart for that time range. 

 Show Legend—Specifies whether to display legends on the line chart. 

Device Unreachability (%)—TopN 

By default, the Device Unreachability TopN table, as shown in Figure 23, displays the top N 
devices with the highest unreachability rate within the last hour. The content includes the time range, 
device name and IP address, and the unreachability rate. 
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Figure 23 Device Unreachability TopN 

 
 

Click the Set icon  in the upper right corner of the widget, and then select Setting to launch the 
Setting dialog box. 

 Time Range—Specifies the time range for statistics collection. The available options include 
Last Hour, Today, Yesterday, This Week, Last Week, This Month, Last Month, This Year, 
and Last Year.  

 Top—Specifies the number of monitoring instances for the widget. The available options 
include 5, 10, 20, and 30.  

Device Unreachability (%)—Top5 

By default, the Device Unreachability Top5 widget, as shown in Figure 24, displays the top five 
devices with the highest unreachability rate for the last hour in a ring chart. Each ring displays a 
device label and the unreachability rate of the respective instance. Click a ring to view details of the 
respective instance. 
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Figure 24 Device Unreachability Top5 

 
 

Click the Set icon  in the upper right corner of the widget, and then select Setting to launch the 
Setting dialog box. 

 Time Range—Specifies the time range for statistics collection. The available options include 
Last Hour, Today, Yesterday, This Week, Last Week, This Month, Last Month, This Year, 
and Last Year.  

 The Display Mode—Specifies the display mode of the widget. Options are Line and Ring. To 

quickly change the display mode, click the Line Mode icon  or the Ring Mode icon  in 
the upper right corner of the widget. When the display mode is set to Line, the widget displays 
the top five instances in a line chart. When you point to a time on a curve, a tip appears and 
displays the instance name, collection time, and collection data of the specified time. Press and 
drag the mouse to select a time range on the x-axis to view the line chart for that time range. 

 Show Legend—Specifies whether to display legends on the line chart. 

Bandwidth Utilization (In) (%)—TopN 

By default, the Bandwidth Utilization(In) TopN table, as shown in Figure 25, displays the top N 
devices with the highest inbound traffic bandwidth utilization within the last hour. The content 
includes the time range, device name and IP address, and the Interface In-Bandwidth Usage. 
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Figure 25 Bandwidth Utilization (In) TopN 

 
 

Click the Set icon  in the upper right corner of the widget, and then select Setting to launch the 
Setting dialog box. 

 Time Range—Specifies the time range for statistics collection. The available options include 
Last Hour, Today, Yesterday, This Week, Last Week, This Month, Last Month, This Year, 
and Last Year.  

 Top—Specifies the number of monitoring instances for the widget. The available options 
include 5, 10, 20, and 30. 

Bandwidth Utilization (In) (%)—Top5 

By default, the Bandwidth Utilization(In) Top5 widget, as shown in Figure 26, displays the top five 
devices with the highest inbound traffic bandwidth utilization for the last hour in a line chart. When 
you point to a time on a curve, a tip appears and displays the instance name, collection time, and 
collection data of the specified time. Press and drag the mouse to select a time range on the x-axis to 
view the line chart for that time range. 
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Figure 26 Bandwidth Utilization (In) Top5 

 
 

Click the Set icon  in the upper right corner of the widget, and then select Setting to launch the 
Setting dialog box. 

 Time Range—Specifies the time range for statistics collection. The available options include 
Last Hour, Today, Yesterday, This Week, Last Week, This Month, Last Month, This Year, 
and Last Year. 

 The Display Mode—Specifies the display mode of the widget. Options are Line and Ring. To 

quickly change the display mode, click the Line Mode icon  or the Ring Mode icon  in 
the upper right corner of the widget. When the display mode is set to Ring, the widget displays 
the top five instances in a ring chart. Each ring displays a device label and the inbound traffic 
bandwidth utilization of the respective instance. Click a ring to view details of the respective 
instance. 

 Show Legend—Specifies whether to display legends on the line chart. 

Bandwidth Utilization (Out) (%)—TopN 

By default, the Bandwidth Utilization(Out) TopN table, as shown in Figure 27, displays the top N 
devices with the highest outbound traffic bandwidth utilization within the last hour. The content 
includes the time range, device name and IP address, and the Interface Out-Bandwidth Usage. 
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Figure 27 Bandwidth Utilization (Out) TopN 

 
 

Click the Set icon  in the upper right corner of the widget, and then select Setting to launch the 
Setting dialog box. 

 Time Range—Specifies the time range for statistics collection. The available options include 
Last Hour, Today, Yesterday, This Week, Last Week, This Month, Last Month, This Year, 
and Last Year.  

 Top—Specifies the number of monitoring instances for the widget. The available options 
include 5, 10, 20, and 30. 

Bandwidth Utilization (Out) (%)—Top5 

By default, the Bandwidth Utilization(Out) Top5 widget, as shown in Figure 26, displays the top 
five devices with the highest outbound traffic bandwidth utilization for the last hour in a line chart. 
When you point to a time on a curve, a tip appears and displays the instance name, collection time, 
and collection data of the specified time. Press and drag the mouse to select a time range on the 
x-axis to view the line chart for that time range. 
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Figure 28 Bandwidth Utilization (Out) Top5 

 
 

Click the Set icon  in the upper right corner of the widget, and then select Setting to launch the 
Setting dialog box. 

 Time Range—Specifies the time range for statistics collection. The available options include 
Last Hour, Today, Yesterday, This Week, Last Week, This Month, Last Month, This Year, 
and Last Year. 

 The Display Mode—Specifies the display mode of the widget. Options are Line and Ring. To 

quickly change the display mode, click the Line Mode icon  or the Ring Mode icon  in 
the upper right corner of the widget. When the display mode is set to Ring, the widget displays 
the top five instances in a ring chart. Each ring displays a device label and the outbound traffic 
bandwidth utilization of the respective instance. Click a ring to view details of the respective 
instance. 

 Show Legend—Specifies whether to display legends on the line chart. 

Customize TopN 

By default, the Customize TopN widget, as shown in Figure 29, displays the Interface Receiving 
Rate TopN view, which displays the top N interfaces by receiving rate within the last hour. The 
content includes the time range, device information (Device Label (IP) by default), Instance, and 
Data. 
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Figure 29 Customize TopN 

 
 

Click the Set icon  in the upper right corner of the widget, and then select Setting to launch the 
Setting dialog box. 

 Summary—Specifies the summary for the index group whose indexes you want to monitor. 
The available options include All Index and System. 

 Index Group—Specifies the index group whose indexes you want to monitor. When System is 
selected for Summary, the available options include All Index, Interface Statistics, CPU 
Usage, Other Interface Statistics, Memory Usage, Device Defect, and Device Traffic. 

 Monitor Index—Specifies the performance indexes you want to monitor. The available options 
include Interface Receiving Rate (bits/s), CPU Usage (%), Interface Inbound Packet Loss 
Rate (%), Memory Usage (%), Interface Transmitting Rate (bits/s), Interface Sending 
Error Proportion (%), Response Time of Device (ms), Interface Receiving Error 
Proportion (%), Device Unreachability Proportion (%), Interface Inbound Bandwidth 
Usage (%), Interface Outbound Packet Loss Rate (%), Interface Outbound Bandwidth 
Usage (%), IP Datagram Receiving Rate (datagrams/s), Interface Broadcasts Receiving 
Rate (packets/s), IP Datagram Forwarding Rate (datagrams/s), Discarded Proportion of 
Input Datagrams (%), Discarded Proportion of Output IP Datagrams (%), and Interface 
Broadcasts Transmitting Rate (packets/s). 

 Time Range—Specifies the time range for statistics collection. The available options include 
Last Hour, Today, Yesterday, This Week, Last Week, This Month, Last Month, This Year, 
and Last Year.  

 Top—Specifies the number of monitoring instances for the widget. The available options 
include 5, 10, 20, and 30. 

Customize Top5 

By default, the Customize Top5 widget, as shown in Figure 30, displays the top five device 
interfaces with the highest interface receiving rates for the last hour in a ring chart. Each ring displays 
a device label and the interface receiving rate of the respective device interface. Click a ring to view 
details of the respective instance. Before using this widget, you must add the performance 
monitoring index on the Performance Management > Monitoring Settings page.  
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Figure 30 Customize Top5 

 
 

Click the Set icon  in the upper right corner of the widget, and then select Setting to launch the 
Setting dialog box. 

 Summary—Specifies the summary for the index group whose indexes you want to monitor. 
The available options include All Index and System. 

 Index Group—Specifies the index group whose indexes you want to monitor. When System is 
selected for Summary, the available options include All Index, Interface Statistics, CPU 
Usage, Other Interface Statistics, Memory Usage, Device Defect, and Device Traffic. 

 Monitor Index—Specifies the performance indexes you want to monitor. The available options 
include Interface Receiving Rate (bits/s), CPU Usage (%), Interface Inbound Packet Loss 
Rate (%), Memory Usage (%), Interface Transmitting Rate (bits/s), Interface Sending 
Error Proportion (%), Response Time of Device (ms), Interface Receiving Error 
Proportion (%), Device Unreachability Proportion (%), Interface Inbound Bandwidth 
Usage (%), Interface Outbound Packet Loss Rate (%), Interface Outbound Bandwidth 
Usage (%), IP Datagram Receiving Rate (datagrams/s), Interface Broadcasts Receiving 
Rate (packets/s), IP Datagram Forwarding Rate (datagrams/s), Discarded Proportion of 
Input Datagrams (%), Discarded Proportion of Output IP Datagrams (%), and Interface 
Broadcasts Transmitting Rate (packets/s). 

 Time Range—Specifies the time range for statistics collection. The available options include 
Last Hour, Today, Yesterday, This Week, Last Week, This Month, Last Month, This Year, 
and Last Year.  

 The Display Mode—Specifies the display mode of the widget. Options are Line and Ring. To 

quickly change the display mode, click the Line Mode icon  or the Ring Mode icon  in 
the upper right corner of the widget. When the display mode is set to Line, the widget displays 
the top five instances in a line chart. When you point to a time on a curve, a tip appears and 
displays the instance name, collection time, and collection data of the specified time. Press and 
drag the mouse to select a time range on the x-axis to view the line chart for that time range. 

 Show Legend—Specifies whether to display legends on the line chart. 

Performance Top5 

By default, the Perf Top5 widget, as shown in Figure 31, displays the top five devices with the 
highest unreachability rates and the top five device interfaces with the highest interface receiving 
rates for the last hour in a ring chart. In Device Unreachability (%) – Top5, each ring displays a 
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device label and the unreachability rate of the device. In Customize Top5-Interface Receiving 
Rate (bps), each ring displays a device label and the interface receiving rate of the respective device 
interface. You can modify the performance index for the lower Customize Top5 area. Click a ring to 
view details of the respective instance.  

Figure 31 Perf Top5 

 
 

Click the Set icon  in the upper right corner of the widget, and then select Setting to launch the 
Setting dialog box. 

 Monitor Index—Specifies the performance indexes you want to monitor. The available options 
include Interface Receiving Rate (bits/s), CPU Usage (%), Interface Inbound Packet Loss 
Rate (%), Memory Usage (%), Interface Transmitting Rate (bits/s), Interface Sending 
Error Proportion (%), Response Time of Device (ms), Interface Receiving Error 
Proportion (%), Device Unreachability Proportion (%), Interface Inbound Bandwidth 
Usage (%), Interface Outbound Packet Loss Rate (%), Interface Outbound Bandwidth 
Usage (%), IP Datagram Receiving Rate (datagrams/s), Interface Broadcasts Receiving 
Rate (packets/s), IP Datagram Forwarding Rate (datagrams/s), Discarded Proportion of 
Input Datagrams (%), Discarded Proportion of Output IP Datagrams (%), and Interface 
Broadcasts Transmitting Rate (packets/s). 

 Time Range—Specifies the time range for statistics collection. The available options include 
Latest, Last Hour, Today, Yesterday, This Week, Last Week, This Month, Last Month, 
This Year, and Last Year.  

Device Response Time (ms)—Top5 

By default, the Device Response Time Top5 widget, as shown in Figure 32, displays the top five 
devices with the longest response time for the last hour in bars. Each bar displays a device label and 
the response time of the respective instance. Click a device label to view details of the respective 
instance. 
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Figure 32 Device Response Time (ms)—Top5 

 
 

Click the Set icon  in the upper right corner of the widget, and then select Setting to launch the 
Setting dialog box. 

 Time Range—Specifies the time range for statistics collection. The available options include 
Latest, Last Hour, Today, Yesterday, This Week, Last Week, This Month, Last Month, This 
Year, and Last Year.  

Network 

The Network widget, as shown in Figure 33, displays the number of devices in different IP segments 
and custom views in the IMC.  
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Figure 33 Network 

  
 

The color of the icon for each IP segment or custom view reflects in real time the most severe alarm 
or severity level of any device within the IP segment or custom view. Color-coding of the severity or 
alarm level conforms to industry standards, and is displayed in Table 4. 

Table 4 Color-coding of the severity or alarm level 

Color  Alarm severity 

 Critical 

 Major 

 Minor 

 Warning 

 Normal 

 Informational 

 Unmanaged 
 

These IP views provide drilldown to lists of all devices within the IP segments. To access these 
views, click the link of the IP segment. 

These custom views provide drilldown to lists of all devices with their respective groups. To access 
these views, click the name of the custom view. 

Click the Set icon  in the upper right corner of the widget, and then select the Setting option to 
launch the Setting dialog box. 

 Columns—Specifies the quantities of IP segments and custom views to be displayed per row 
for the widget. The available options include 2, 4, 6, 8, and 10.  

 Network—Specifies the content to be displayed for the widget. Select Both to display both IP 
view and custom view, select IP View to display only IP view, and select Custom View to 
display only custom view.  

By default, the Network widget is displayed on the Welcome space of the IMC home page. 

For more information about the IP view and custom view, see "Resource management." 
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Device State Overview 

The Device State Overview widget, as shown in Figure 34, contains the following charts: 

 Card chart—Displays device states in cards. Each card represents a device type and displays 
the total number of devices of that device type. Click the Details link on each card to view the 
device list of the respective device type. The color of each card represents the overall state of 
devices of the device type, and the overall state is determined by the highest severity level of 
devices of the device type. 

 Ring chart—Displays device states in a ring with color-coded legends. The ring displays the 
total number of devices. Each slice of the ring represents the percentage of a device state. You 
can click a slice to view all devices in the respective device state. Each color-coded legend 
represents a device state and displays the total number of devices in the device state. 

Figure 34 Device State Overview 

 
 

Click the Set icon  in the upper right corner of the widget, and then select the Setting option to 
launch the Setting dialog box. 

 Custom View—Specifies the custom views for which you want to view the device state 
overview. By default, you can select All Devices or My Network View. If you have added views 
on the Resource > Custom View page, these custom views are displayed on the list.  

Hierarchical Device State Overview 

The Hierarchical Device State Overview widget, as shown in Figure 35, shows the device status of 
the current device and all its lower-level NMS devices by default and contains the following charts: 

 Card chart—Displays device states in cards. Each card represents a device type and displays 
the total number of devices of that device type. Click the Details link on each card to view the 
device list of the respective device type. The color of each card represents the overall state of 
devices of the device type, and the overall state is determined by the highest severity level of 
devices of the device type. 

 Ring chart—Displays device states in a ring with color-coded legends. The ring displays the 
total number of devices. Each slice of the ring represents the percentage of a device state. You 
can click a slice to view all devices in the respective device state. Each color-coded legend 
represents a device state and displays the total number of devices in the device state. 
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Figure 35 Hierarchical Device State Overview 

 
 

Click the Set icon  in the upper right corner of the widget, and then select the Setting option to 
launch the Setting dialog box. From the Hierarchical NMS list, select All Lower-level System 
(including the current System) to display the status of all lower-level NMS devices (including the 
current device) or select a lower-level NMS device to display its status.  

Device View 

As shown in Figure 36, the Device View widget displays the quantities of various devices in the 
current system (the y-axis indicates the device type, and the x-axis indicates the device quantity). 
Click a bar to access the device list of the respective device type to view device details. 

Figure 36 Device View 

 
 

The color of the bar for each device type reflects in real time the most severe alarm or severity level 
of any device within the device type. Color-coding of the severity or alarm level conforms to industry 
standards, and is displayed in Table 5. 
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Table 5 Color-coding of the severity or alarm level 

Color  Alarm severity  

 Critical  

 Major  

 Minor  

 Warning  

 Normal  

 Informational  

 Unmanaged  
 

Device View 

As shown in Figure 37, the Device View widget displays the quantities of various devices in the 
current system (the x-axis indicates the device type, and the y-axis indicates the device quantity). 
Click a bar to access the device list of the respective device type to view device details. 

Figure 37 Device View 

 
 

The color of the bar for each device type reflects in real time the most severe alarm or severity level 
of any device within the type. Color-coding of the severity or alarm level conforms to industry 
standards, and is displayed in Table 6. 

Table 6 Color-coding of the severity or alarm level 

Color  Alarm severity  

 Critical  

 Major  

 Minor  

 Warning  
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 Normal  

 Informational  

 Unmanaged  
 

Custom View Top5 

As shown in Figure 38, the Custom View Top5 widget contains the following charts: 

 Bar chart—Displays the top five custom views containing the highest-quantities of devices in 
the current system (the x-axis indicates the custom view name, and the y-axis indicates the 
device quantity). 

 Pie chart—Displays the percentage of devices within the top five custom views by their alarm 
status.  

Figure 38 Custom View Top5 

 
 

The color of the bar or pie reflects in real time the severity or alarm level of any device within the 
custom view. Color-coding of the severity or alarm level conforms to industry standards and is 
displayed in Table 7. 

Table 7 Color-coding of the severity or alarm level 

Color  Alarm severity  

 Critical  

 Major  

 Minor  

 Warning  

 Normal  

 Informational  

 Unmanaged  
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Important Devices 

The Important Devices widget, as shown in Figure 39, displays the basic information and 
performance data of each important device in an unreachability dashboard, a CPU Usage line chart, 
a Memory Usage ring chart, a device label and status card, an Alarm card chart, and a Response 
Time line chart. Click a device label to access the details page of the device. To switch between 
important devices, click dots at the bottom of the widget.  

Figure 39 Important Devices  

 
 

Click the Set icon  in the upper right corner of the widget, and then select Choose Devices. On 
the Setting dialog box that opens, configure the list of devices to be displayed in the widget, and then 
click OK. 

 To add devices to the device list, click Add Devices, select devices on the page that opens, and 
then click OK. 

 To delete a device from the device list, click the Delete icon  for the device, and then click 
OK in the dialog box that opens. 

Important Ports 

The Important Ports widget, as shown in Figure 40, displays the basic information and performance 
data of each important port in an interface receive/transmit rate line chart, an interface description 
and status card, and a Bandwidth Usage line chart. Click an interface description to access the 
details page of an interface. To switch between interfaces, click dots at the bottom of the widget. 
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Figure 40 Important Ports 

 
 

Click the Set icon  in the upper right corner of the widget, and then select Choose Ports. On the 
Setting dialog box that opens, configure the list of interfaces to be displayed in the widget, and then 
click OK. 

 To add interfaces to the interface list, click Add, select interfaces on the page that opens, and 
then click OK. 

 To delete an interface from the interface list, click the Delete icon  for the interface, and click 
OK in the dialog box that opens. 

IP Topology 

The IP Topology widget, as shown in Figure 41, displays the IP view. 
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Figure 41 IP Topology 

  
 

Click the Set icon  in the upper right corner of the widget, and then select Setting to launch the 
Setting dialog box. 

 Subnet—Specifies the subnet for which the topology is to be displayed. The available options 
include the existing subnets of the system. 

 Zoom (%)—Sets the zoom percentage of a view. Drag  to change the zoom percentage, or 
enter a zoom percentage in the text box to the right. The value range is from 15 to 600. The 
default value is 100. Then in the confirmation dialog box, click OK to save your configuration. 
Upon entering the home page again, the view is displayed in the modified zoom percentage. 
Changing the zoom percentage does not affect the IP views in the Network Topology. 

You can use the tools described in Table 8 to view the IP view. 

Table 8 Toolbar description 

Icon  Function  

 Displays the network in its original proportion.  

 Zoom in on the topology view.  

 Zoom out on the topology view.  

 Fit the contents of the topology view into the window.  

 Enables you to magnify the contents on the topology view. 

 Displays a bird's eye view in the upper left corner of the widget. 

 

Enables you to grab and move one or multiple objects in the topology view within the confines 

of the pane. Click the icon to switch to the Pointer Tool , which allows you to move the 
entire topology view within the confines of the pane. 

 Allows you to save topology view settings. 
 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 8476



75 

For more information about custom view, see "Resource management." 

Custom Topology 

The Custom Topology widget, as shown in Figure 42, displays all custom views.  

Figure 42 Custom Topology 

 
 

Click the Set icon  in the upper right corner of the widget, and then select Setting to launch the 
Setting dialog box. 

 View—Specifies the custom view for which the topology is to be displayed. The available 
options include the existing custom view of the system. 

 Zoom (%)—Sets the zoom percentage of a view. Drag  to change the zoom percentage, or 
enter a zoom percentage in the text box to the right. The value range is from 15 to 600. The 
default value is 100. Then in the confirmation dialog box, click OK to save your configuration. 
Upon entering the home page again, the view is displayed in the modified zoom percentage. 
Changing the zoom percentage does not affect the IP views in the Network Topology. 

You can use the tools described in Table 9 to view the custom view: 

Table 9 Toolbar description 

Icon  Function  

 Displays the network in its original proportion.  

 Zoom in on the topology view.  

 Zoom out on the topology view.  

 Fit the contents of the topology view into the window.  

 Enables you to magnify the contents on the topology view. 

 Displays a bird's eye view in the upper left corner of the widget. 
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Icon  Function  

 

Enables you to grab and move one or multiple objects in the topology view within the confines 

of the pane. Click the icon to switch to the Pointer Tool , which allows you to move the 
entire topology view within the confines of the pane. 

 Allows you to save topology view settings. 
 

For more information about custom view, see "Resource management." 

Port Group 

The Port Group widget, as shown in Figure 43, displays the port group list. Click a port group name 
to view detailed port information.  

Figure 43 Port Group 

 
 

Click the Set icon  in the upper right corner of the widget, and then select the Setting to launch 
the Setting dialog box. Select a number from the Columns list for the quantities of IP segments and 
custom views to be displayed per row for the widget. The available options include 2, 4, 6, 8, and 10.  

For more information about port groups, see "Resource management." 

Port Group - TopN 

The Port Group TopN widget, as shown in Figure 44, contains the following charts: 

 Bar chart—Displays the quantities of various devices in the current system (the x-axis 
indicates the state of port, and the y-axis indicates the port quantity). 

 Pie chart—Displays the percentage of ports by their status. 
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Figure 44 Port Group TopN 

 
 

For more information about port groups, see "Resource management." 

Device List (by Custom View) 

The Device List (by Custom View) widget, as shown in Figure 45, allows you to display the device 
list in custom view on the home page. Multiple Device List (by Custom View) widgets can be 
customized, but the total number of customized widgets cannot exceed 10. The default custom view 
name of a Device List (by Custom View) widget on the home page is My Network View. 

Figure 45 Device List (by Custom View) 

 
 

Click the Set icon  in the upper right corner of the widget, and then select Setting to launch the 
Setting dialog box. 

 View—Specify a custom view. All custom views created in IMC are displayed in the list.  
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 Sort Column—Specify the column by which the list is sorted. Available options are Status, 
Device Label, Model, IP Address, and Device Category. The widget sorts the device list by 
the specified column name. 

 Sort Model—Select a sort mode. Available options are Ascending and Descending. The 
widget sorts the device list by the specified sort mode. 

 Max Items—Select 25, 50, 100, or 200 from the list to configure how many items you want to 
view. 

Interface List (by Port Group) 

The Interface List (by Port Group) widget, as shown in Figure 46, allows you to display the 
interface list in a created interface view on the home page.  

Multiple Interface List (by Port Group) widgets can be customized, but the total number of 
customized widgets cannot exceed 10. 

Figure 46 Interface List (by Port Group) 

 
 

Click the Set icon  in the upper right corner of the widget, and then select Setting to launch the 
Setting dialog box. 

 View—Specifies an interface view. All interface views created in IMC are displayed in the list. 

The column items in the interface list depend on the customized column items in the interface 
view. For more information about custom column items, see "Viewing device interfaces with 
port groups." 

 Sort Column—Select a column name from the Sort Column list. The widget sorts the interface 
list by the specified column name. 

 Sort Mode—Select a sort mode from the Sort Mode list. The widget sorts the interface list by 
the specified sort mode. 

 Max Items—Click 25, 50, 100, or 200 from the right side of the main pane to configure how 
many items you want to view. 

Quick Service Process 

The Quick Service Process widget, as shown in Figure 47, allows you to display common service 
functions as applications on the home page. 
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Figure 47 Quick Service Process 

 
 

Click the Set icon  in the upper right corner of the widget. 

 Select Quick Service Process—Select Select Quick Service Process to launch the Setting 
dialog box. From the list, select a quick service process. By default, the list contains the 
Common Configuration option. To add quick service processes, access the System > 
System Configuration > Quick Service Process page. The newly added quick service 
processes are displayed on the list.  

 Modify Quick Service Process—Select Modify Quick Service Process to launch the 
Setting dialog box. The application list displays all applications that the widget contains. 

 To add applications to the widget, click Add Application, locate the target applications, and 
then click Add Application for each application. 

 To delete an application from the widget, click the Delete icon  for the application. 

 To modify the rank of an application in the widget, click the Up icon  or Down icon  for 
the application. 

Network Devices 

The Network Devices widget, as shown in Figure 48, allows you to display the total number of 
network devices in the system and the number of devices with the alarm level as Critical, Major, and 
Minor separately on the home page. 

This widget vividly shows the differences among the numbers of devices in each alarm level in rings. 
The red ring displays the critical devices, the orange ring displays the major devices, and the yellow 
ring displays the minor devices.  

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 8481



80 

Figure 48 Network Devices (front) 

 
 

Click  to reverse the card, as shown in Figure 49, which displays the total number of devices of 
each type in the system. Take Switch[1/6] as an example. The red color means the top alarm level of 
the switches is Critical, 1 indicates the number of switches with the alarm level as Critical is 1, and 
6 indicates the total number of switches in the system is 6.  

Figure 49 Network Devices (back) 

 
 

Physical Network Asset Statistics 

The Physical Network Asset Statistics widget, as shown in Figure 50, displays the number of 
devices managed in the network asset manager and the number of their parts (for example, power 
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supplies, fans, and backplanes) in a bar graph. Click a bar to enter the network asset list of the specified 

type and view network asset details.  

Figure 50 Physical Network Asset Statistics 

 
 

Customizing spaces and system-defined widgets 
In addition to the default Welcome space defined by the system, you can customize a space and 
add widgets to that space as needed.  

To customize a space and add widgets: 

1. Log in to IMC, and then click the Settings icon  in the upper right corner of the home page. 

A tab bar appears on the top of the space. A shortcut menu appears in the upper right corner of 
the home page. 

2. Click  on the space tab. 

A new space tab named New Space  appears.  

3. Enter the name for the new space, and then click any blank part of the page to complete naming 
the space. 

4. Launch the dialog box for adding widgets by selecting Edit  from the shortcut menu in the 
upper right corner. 

By default, the dialog box provides system-defined alarm, resource, and performance widgets 
located under the Widgets tab. 

5. Select the layout for widgets by using one of the following methods:. 

 Quick Layout 

At the top middle of the widget dialog box, select a layout: 
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  means two widgets are displayed per row. The left widget occupies 2/3 and the right 
occupies 1/3 of the row.  

  means two widgets are displayed per row. The left widget occupies 1/3 and the right 
occupies 2/3 of the row.  

  means two widgets are displayed per row, each occupying 1/2 of the row.  

  means three widgets are displayed per row, each occupying 1/3 of the row. 

  means one widget is displayed per row. 

  means two widgets are displayed per row. The left widget occupies 1/4 and the right 
occupies 3/4 of the row. 

  means two widgets are displayed per row. The left widget occupies 3/4 and the right 
occupies 1/4 of the row. 

  means three widgets are displayed per row. The middle widget occupies 1/2 and 
each of the other two occupies 1/4 of the row. 

 Layout 

 Click the Layout tab. 

 Select a layout for each row in the same way that you select a layout using the quick 
layout method. 

 Select a row height from the list next to each row. By default, the value of the row height 
for each row is 400. 

 Click . 

Locate a system-defined widget by using one of the following methods: 

 Query a widget. 

 Select the Widget tab in the dialog box. 

 In the upper right corner of the dialog box, enter the keyword of a widget name, and then 
click Query. All widgets matching the query criteria are displayed in the dialog box. 
Query supports fuzzy matching and is case-sensitive. 

 Sort widgets. 

 Select the Widget tab in the dialog box.  

 In the upper left corner of the dialog box, select the All, Alarm, Performance, and 
Resource sub-tabs to display all widgets, alarm-related widgets, performance-related 
widgets, and resource-related widgets.  

 In the bottom right corner of the page, click Previous or Next to display widgets on the 
previous or next pages. 

Use either method to display the desired widgets in the dialog box. 

6. Click  of a widget to add it to the space. Then  changes to Succeeded, 
indicating the widget was successfully added. You can add up to 10 widgets to a space. 

7. Click OK to complete the operations and return to the space. 

8. Click the Set icon  in the upper right corner of a widget to configure the widget. 

Different widgets require different parameters to be configured. For more information about 
configuring widgets, see "Alarm, performance, and resource widgets." 

9. Click OK to confirm your changes. 

10. Click the Save icon  in the shortcut menu in the upper right corner to save your 
configurations. 
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Customizing RSS widgets 
RSS widgets offer the ability to subscribe to RSS feeds.  

To customize RSS widgets: 

1. Log in to the IMC, and then click the Settings icon  in the upper right corner of the home 
page. 

A tab bar appears on the top of the space. A shortcut menu appears in the upper right corner of 
the home page. 

2. Click the tab to which you want to add the RSS widget. 

3. Select Edit  from the shortcut menu in the upper right corner. 

The dialog box for adding widgets opens. 

4. Click the RSS tab in the dialog box to customize the RSS widget. 

5. Enter the following RSS information: 

 RSS Site—Enter the URL of the RSS feed you want to subscribe. 

 RSS Title—Enter the name of the RSS widget. 

6. Click the Check icon  to test the validity of the RSS feed URL. 

7. Click the Add icon  to add another RSS widget. 

Device status through status bar 
A summary of all alarms, as shown in Figure 51, is displayed on the IMC status bar located at the 
bottom of the Home page. Click the icons for each severity or alarm level to drill down into the alarms 
for each level. 

Figure 51 Status bar 
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Alarm sound settings 
IMC provides operators with the ability to customize the use of sound files for notifying them when 
new alarms are received or when existing alarms have not been cleared or recovered. Operators can 
use IMC system sound files or they can upload custom sound files. These sound files are then 
applied to severity or alarm levels. 

To enable system-defined sound files for alarm levels: 

1. Click the Sound icon  located in the lower left corner of the IMC home page. 

The Alarm Sound Setting page opens. 

2. In the Scope Area, select the type of alarm sound setting. Options are System and Custom. 
Operators can customize alarm sound settings and IMC plays different sound files for different 
operators. 

3. In the Sound Occasion Setting area, select when you want alarm sound files to play, and set 
the sound interval. By default, the sound interval is 5 seconds. You can adjust the sound 
interval according to the length of the sound file to ensure the played sounds do not overlap. 

 To play sound files only when new alarms are received, select When receiving new 
alarms. 

 To play sound files when unrecovered alarms exist in IMC, select When unrecovered 
alarms exist. 

 To play sound files when unrecovered alarms exist in unacknowledged state, select When 
unrecovered alarms are not acknowledged. 

4. In the Voice File Setting area, configure sound files for IMC to play for one or more alarm 
levels. 

To select the alarm levels for which you want to play sound files, select the checkbox to the left 
of the alarm level. 

You can use the system sound files that are configured by default, or you can select which 
sound you want to use for each alarm level. To select a sound file you want to apply to an alarm 
level:  

a. Click Select associated with the alarm level. 

The Select Voice File page opens. 

b. Select the sound file you want to apply. 

c. Click Select to apply your sound file selection. 

5. Click Set to apply your changes. 

To restore the default sound settings, click Default. To close the Alarm Sound Setting page, 
click Close. 

IMC supports the ability to add custom sound files to alarm sound notifications. 

To enable custom sound files for alarm levels: 

1. Click the Sound icon  located in the lower left corner of the IMC home page. 

The Alarm Sound Setting page opens. 

2. In the Scope Area, select the type of alarm sound setting. Options are System and Custom. 
Operators can customize alarm sound settings and IMC plays different sound files for different 
operators. 

3. In the Sound Occasion Setting area, select when you want alarm sound files to play, and set 
the sound interval. By default, the sound interval is 5 seconds. You can adjust the sound 
interval according to the length of the sound file to ensure the played sounds do not overlap. 

 To play sound files only when new alarms have been received, select When receiving new 
alarms. 
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 To play sound files when unrecovered alarms exist in IMC, select When unrecovered 
alarms exist. 

 To play sound files when unrecovered alarms exist in unacknowledged state, select When 
unrecovered alarms are not acknowledged. 

4. Click the Voice File Manager link located in the upper right corner of the Alarm Sound Setting 
dialog box. 

The Upload Voice File page opens. 

5. Click Browse to browse your local directories for the sound file. 

6. Click Upload to upload the selected sound file.  

7. Verify that the Upload Voice File page indicates that the file was successfully uploaded. 

8. Click Back to return to the Alarm Sound Setting dialog box. 

9. Select the alarm levels to which you want to apply the custom sound file. 

10. Click Select associated with the alarm level to which you want to apply the custom sound file. 

The Select Voice File page opens. 

11. Select the custom sound file you uploaded. 

12. Click Select to apply your sound file selection and return to the Alarm Sound Setting dialog 
box. 

13. Click Set to apply your changes. 

14. Click Default to restore the default sound settings. 

15. Click Close to close the Alarm Sound Setting dialog box. 

Sound files must be in PCM format (WAV), and the bit rate must be less than or equal to 352 
kbps. The filename must include the .wav extension. 

To disable sound files for alarm levels: 

1. Click the Sound icon  located in the lower left corner of the IMC home page. 

The Alarm Sound Setting dialog box opens. 

2. To remove sound settings, clear the alarm level for which you want to disable sounds.  

3. Click Set to apply your changes. 

4. Click Close to close the Alarm Sound Setting window 

5. Restart the browser for the sound setting changes to take effect. 

Navigating IMC functions 
IMC provides you the following ways to navigate functions: 

 After you log in to IMC, point to a tab on top of the page, and a list appears, as shown in Figure 
52. Select the desired function to enter the relevant page.  

 After you log in to IMC, click a tab on top of the page. After the page is refreshed, select the 
desired function from the left navigation tree to enter the relevant page, as shown in Figure 53.  
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Figure 52 Tabular navigation 

 
 

Figure 53 Tabular navigation system and navigation tree 

 
 

The tabular navigation system includes the six functional areas of IMC: Resource (or performance) 
management, User management, Service management, Alarm (or fault) management, Report, 
and IMC System wide settings and configuration. All IMC features and functions can be found under 
these tabs. 

The navigation tree located on the left of every IMC page contains context sensitive options that 
change as you navigate using the tabular navigation system. For example, if you click Resource 
from the tabular navigation system, the navigation tree on the left displays various features and 
functions under resource management, including View Management, Resource Management, 
Terminal Access, Network Assets, Virtual Resource Management, and Performance Management. 

Expanding and collapsing the left navigation tree 

On any page except the home page: 

 Click the Collapse Left icon  in the lower right corner of the page to hide the left navigation 
tree.  
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 Click the Expand Left icon  in the lower right corner of the page to display the left navigation 
tree. 

Expanding and collapsing the tabular navigation system and the left navigation tree 

On any page except the home page: 

 Click the Collapse Top and Left icon  in the lower right corner of the page to hide the 
tabular navigation system and the left navigation tree.  

 Click the Expand Top and Left icon  in the lower right corner of the page to display the 
tabular navigation system and the left navigation tree. 

Resource tab 

The Resource tab on the tabular navigation system displays the Resource Management page, as 
shown in Figure 54. 

Figure 54 Resource management page 

 
 

The main Resource page contains real time status views including:  

 Custom View Snapshot—Real time status view for custom views. 

 Snapshot of Lower-Level NMS View—Real time status view for lower-level NMS views. 

 View Snapshot—Real time status view by device type. 

 Faulty Device List—Real time status view of all devices reporting errors. 

In addition, the lower portion of the Resource page provides tabs for viewing real time 
performance statistics for a subset of devices for the last hour. 

The navigation tree on the left includes the ability to navigate to various real time status views of the 
network infrastructure including: 

 Network Topology—Provides a real time status view of the network infrastructure based on 
topology. 

 Port Group—Displays user-defined port group information. 

 Lower-Level NMS View—Displays the lower-level NMS servers managed by the current NMS. 

 Custom View—Provides a real time status view of devices prioritized into custom views by the 
administrator or operator. 
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 IP View—Provides a real time status view of the network infrastructure organized by IP 
address. 

 Device View—Provides a real time status view of the network infrastructure organized by 
device type. 

You can also manage and perform configuration tasks using the navigation tree including: 

 Resource Management—Manages resources within IMC including adding devices, device 
auto discovery, batch operations, and device/topology import and export. 

 Terminal Access—Manages IP addresses including address allocation, binding, IP address 
location, discovery and device access. 

 Network Assets—Implements network asset functions including asset audits and reporting. 

 Virtual Resource Management—Manages the virtual network including servers, virtual 
switches, and virtual machines. 

 Performance Management—Configures real time reports on device performance, including 
configuration of real time performance status reporting on the main Resource page. 

Topology maps 

Topology maps available under the Resource tab have special navigation features.  

 Left mouse click 

Click a selected node or link on the topology map to display information about the selected node 
or link, as shown in Figure 55. To select a node or link, click the node or link. 

Figure 55 Left mouse click on topology 

 
 

 Right mouse click 

Right-click a selected node or link on the topology map to display a list of information and 
configuration options that can be applied to the selected node or link, as shown in Figure 56. 
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Figure 56 Right mouse click in topology 

 
 

 
 

Right-click the blank area to display a menu for map configuration. 

Resource tab: Device details 

The Device Details page under the Resource tab also has special features. To access the Device 
Details page, click any active link in IMC that contains the device name/IP address. 
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The following information provides a high level overview of the Device Details page. For more 
information about this page, see "Accessing the device details page." 

The right pane of the Device Details page, as shown in Figure 57, contains information and 
configuration options that apply to the selected device. The navigation tree on the left offers 
configuration options for global settings. 

Figure 57 Right pane 

 
 

 NOTE: 

The figure above contains only a partial view of the navigation pane. 
 

For more information about using features and functions under the Resource tab, see "Resource 
management." 

User tab 

Users are resources on the network that both use and impact network infrastructure resources. To 
view and manage network user and their activity, click the User tab, as shown in Figure 58. The 
views available under the User tab depend on the installation of user management modules (for 
example, Guest Access Manager and User Access Manager). 

Figure 58 User tab 

 
 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 8492



91 

The navigation tree on the left includes configuration options for: 

 User Management—Provides the ability to add, delete, modify platform users and change their 
group assignments, search for users, add supplemental information to user profiles, import 
users, and delete users in individual or batch mode.  

 Access User—Allows you to manage the access account associated with the platform user. 

 Guest—Allows you to manage the guest accounts provided by IMC UAM. 

 Guest Access Manager—Allows you to manage the guest accounts provided by the IMC 
platform. 

Guest Management is similar to Guest Access Manager. They are independent of each other.  

 Guest Access Management requires only the installation of the IMC platform.  

 Guest Management requires the installation of both the IMC platform and IMC UAM. 

Service tab 

Management of network infrastructure services can be accessed by clicking the Service tab, as 
shown in Figure 59, in the tabular navigation system. 

Figure 59 Service tab 

 
 

The Service page serves as a portal for access to all of the service modules that together constitute 
the IMC system. 

 Security Control Center 

 Configuration Center 

 ACL Management 

 VLAN Management 

For more information about using the services listed above, see the sections of this manual that 
correspond with those modules.  

The Service page also serves as a portal for add-on modules that support managing and 
maintaining additional functions of network infrastructure management including: 

 User Access Manager 

 EAD Security Policy Manager 

 Desktop Asset Manager 
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 Wireless Service Manager 

 MPLS TE Manager 

 MPLS VPN Manager 

 L2VPN Manager 

 Traffic Analysis and Audit 

Icons for the aforementioned service modules are displayed under the Service tab after successful 
installation of each module. 

For more information about these modules and their use, see the user guides for the corresponding 
service module. 

Alarm tab 

The real time event or fault management features of IMC can be accessed by clicking the Alarm tab, 
as shown in Figure 60, of the tabular navigation system. 

Figure 60 Alarm tab 

 
 

The Alarm tab is an IMC portal into the reporting of faults on the network infrastructure. IMC lists real 
time alarms or faults, sorted by most recent in the main portion of the Alarm page. 

From this page, you can drill down into individual alarm details by clicking the Description field of an 
individual alarm. 

You can also quickly access the device in alarm mode by clicking the Alarm Source of an individual 
alarm. This navigates the operator to Device Details for the device in alarm mode. 

The navigation tree has the following configuration and viewing options: 

 Real-Time Alarms—View, delete, and recover the recent 50 unrecovered alarms with the 
exception of information alarms. 

 Root Alarms—View, delete, and recover the most recent important alarms with the exception 
of information alarms. 

 All Alarms—View all alarms. 

 Faulty Devices—View devices grouped by device type that are currently reporting a fault or 
error. 

 Alarm Statistics—View statistical analysis of alarm distribution in real time. 

 TopN—View devices grouped by severity of alarm. 

The navigation tree also has the following configuration and viewing options: 

 Alarm Settings—Configure alarm settings to include mail and SMS notification, alarm 
forwarding to IMC as well as to other management systems, and downstream alarm 
suppression. 

 Trap Management—Browse, filter traps, and add and modify trap definitions within IMC.  

 Syslog Management—Browse, filter, and configure Syslog events. 

For more information about using features and functions under the Alarm tab, see "Event and alarm 
management." 
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Report tab 

Real time and historical reports in IMC can be accessed by clicking the Report tab, as shown in 
Figure 61, of the tabular navigation system. 

Figure 61 Report tab 

 
 

From the Report tab, you can access real time and historical reports. The main pane in the Report 
tab provides a listing of all configured Real Time reports.  

 From this pane, you can add quick reports, schedule reports, and delete reports.  

 From the navigation tree, you can customize reports, add report templates, and schedule 
reports.  

For more information about using features and functions under the Report tab, see "Reporting in 
IMC." 

System tab 

System-wide configuration options and system level functions can be accessed by clicking the 
System tab, as shown in Figure 62, of the tabular navigation system located in the upper portion of 
the IMC interface.  

Figure 62 System tab 

 
 

You can configure system wide resources and settings, including: 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 8495



94 

 Resource Management—Configures IMC to manage devices globally by configuring 
templates for SNMP, Telnet, SSH, SOAP/HTTP, PowerShell, and WMI access. Manage devices 
through vendor, series, model and category definitions, and MIB management. 

 Operator Management—Manages access to IMC through operator accounts and groups, and 
manage IMC access through login controls and password strategies. 

 Group Management—Manages IMC device groups, user groups and service groups. 

 Hierarchical NMS—Manages the flow of data and alarms through IMC hierarchical alarm 
settings. 

 System Configuration—Configures IMC system parameters, log details, data export, alarm 
and performance monitoring, SMS configuration, and mail server settings. 

The navigation tree for the System tab provides a shortcut to all system functions provided in the 
System tab. 

For more information about using features and functions under the System tab, see "Configuring 
IMC for use." 

Quick start 
You can see a Quick Start link in the left navigation tree of some IMC components. Quick Start 
briefly describes the functions of the modules and their relations within a component, and offers 
name links to the configuration pages. 

Floating menus of the navigation tree 
The IMC navigation tree provides floating menus, as shown in Figure 63. 

Figure 63 Floating menus of the navigation tree 

 
 

Point to the Expand icon  to quickly locate and expand a functional link. Point to a link marked with 
the icon and the floating menu of the link appears. Click a link on the floating menu to navigate to the 
corresponding functional page. 
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Navigating IMC using breadcrumb trails 
A breadcrumb trail, as shown in Figure 64, is a secondary navigation method that supports 
accessing features and functions of the IMC system. 

They are also an effective visual aid that displays the operator's location within the context of IMC 
Web interface. They are a great resource of contextual information for knowing where the operator is 
and moving more quickly to where the operator wants to be. 

Figure 64 Breadcrumb trail 

 
 

The breadcrumb trail shown above indicates that the administrator or operator is in the switch view 
under the View Management option on the Resource tab. The administrator or operator can quickly 
navigate back to the All Devices page by clicking the All Devices link in the breadcrumb trail. 

The first value of the breadcrumb trail is most often one of the functional areas of IMC that are 
denoted by the tabs in the tabular navigation system. Thus the starting points for any navigation in 
IMC are these tabs and their breadcrumb counterparts:  

 Resource > 

 User > 

 Service > 

 Report > 

 System > 

The breadcrumb under the Alarm tab does not begin with Alarm >. It displays only the name of the 
function.  

The breadcrumb for operator group management, found under the System tab, is System > 
Operator Group. 

All features and functions within IMC can be found under one of these tabs. The breadcrumb 
navigation convention used in IMC and described here, is used throughout the IMC manuals to 
describe the navigation path for IMC features and functions. 
 

 NOTE: 

The IMC online help system also uses breadcrumb trails to support effective and quick navigation. 
 

Online help system 
IMC offers two levels of online help, system-wide help and context-sensitive help.  
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System-wide help 
System-wide help can be accessed by clicking the arrow in the upper right corner and selecting 
Help, as shown in Figure 65.  

Figure 65 Help link 

 
 

Clicking this link displays the main help page, as shown in Figure 66, with help organized by 
functional groups within IMC. 

Figure 66 Help 

 
 

The main pain of the system-wide help includes useful resources for managing and using IMC. 
These resources include an overview of the IMC platform, a quick start guide, managing resources 
within IMC, and more. 
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On the navigation tree located on the left of the Help page, help is organized by functional groups 
within IMC. 

Searching IMC system online help 

Operators can query the online help system using the Search field located at the upper left corner of 
the main help page by entering search criteria in the field provided. Results of the search query are 
displayed in the left pane of the IMC interface. When a phrase is enclosed by quotations marks, the 
exact phrase is searched. For example, if you enter Add Device, all results that contain Add or 
Devices are displayed. However, if you enter Add Device, only results that contain the exact 
phrase, Add Device, are displayed. 

Context-sensitive help 
To access context-sensitive help, click the Help link located in the upper right corner of the main 
pane of the IMC functional pages, as shown in Figure 67. The help system displays online help 
relevant to the current page. 

The context-sensitive help link is located below the system-wide help link. 

Figure 67 Context-sensitive help 

 

Global search 
Global search includes basic query and advanced query. Basic query helps you search devices and 
users. It also helps you search the data, help, and navigation information that matches the search 
criteria. Advanced query helps you query devices, interfaces, and users. 

Performing a basic device search 
1. Navigate to the basic query.  

The basic query field  can be found in the upper right corner of most 
IMC pages. 

2. Select the  Query Devices option from the list by clicking the Search icon  next to the 
search field. 

IMC supports fuzzy matching for most search and filtering features. 

3. Enter a full or partial device name or IP address in the field provided. 

4. Click the Go icon . 

All devices matching the specified criteria are displayed on the Device List 
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5. Click Export Excel or Export CSV on the right of device list to launch the Download Exported 
Data window, and then click the Download Exported Data link to export the query result in the 
format of Excel or CSV.  

Performing a basic user search 
1. Navigate to the basic query. 

The basic query field  can be found in the upper right corner of most 
IMC pages.  

2. Select the Query Users option from the list by clicking the Search icon  next to the 
search field. 

IMC supports fuzzy matching for most search and filtering features. 

3. Enter a full or partial user name in the field provided. 

4. Click the Go icon . 

Performing a general search 
1. Navigate to the general search. 

The general search field  can be found in the upper right corner of 
most IMC pages. 

2. Select the General Search option from the list by clicking the Search icon  located next 
to the search field. 

3. Enter what you want to search for in the general search field.  

This function only supports exact match. For example, if you enter performance, all the data, 
help, and navigation information that exactly matches performance is displayed. If you enter 
perf, only the data, help, and navigation information that exactly matches perf is displayed, and 
the data, help, and navigation information that does not exactly match perf, for example, 
information that contains performance, will not be displayed. 

Also, you can perform a search by using the following operators: 

 OR—The default operator. When you include the OR operator (or a space) between two 
terms, the items that contain either of the two terms are searched. For example, when you 
enter device OR interface, the items that contain either device or interface are searched.  

 AND—When you include the AND operator between two terms, the items that contain both 
terms are searched. For example, when you enter device AND interface, the items that 
contain both device and interface are searched.  

 NOT—When you include the NOT operator between two terms, the items that contain the 
term before NOT, and do not contain the term after NOT, are searched. For example, when 
you enter device NOT interface, the items that contain device but do not contain interface 
are searched. When the NOT operator is used before only one term, no results will be 
searched. 

 Plus sign (+)—When you enter +XX, the items to be searched must contain the term after 
+. For example, when you enter +device, the items that contain device are searched.  

 Minus sign (-)—When you enter -XX, the items to be searched cannot contain the term 
after -. For example, when you enter -device interface, the items that do not contain device 
are searched. 

 Question mark (?)—The single-character wildcard indicates any single character in the 
search. For example, when you enter devi?e, the items that contain device, devide, and so 
on are searched. 
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 Asterisk sign (*)—The multiple-character wildcard indicates 0 or more characters. For 
example, when you enter devi*, the items that contain the word devi or any word prefixed 
with devi are searched. When you enter *vice, the items that contain the word vice or any 
word suffixed with vice are searched. When you enter *vic*, the items that contain any word 
with vic are searched. 

4. Click the Go icon . 

The Extension dialog box opens. All the data, help, and navigation information that matches 
the search criteria is displayed in the dialog box.  

5. Click the Data, Help, or Navigation link to display the specified type of search results.  

The search results include the following types: 

 All—All the data, help, and navigation information that matches the search criteria.  

 Data—Devices that match the search criteria. You can search devices by Device Label, 
System Name, Device Status, Contact, IP Address, Location, or Device Category. 
Click the link for a device in the search result to enter the Device Details page. 

 Help—Help that matches the search criteria. Click the link displayed in the search result to 
open the matching help page. 

 Navigation—Function navigation entry that matches the search criteria. Click the link 
displayed in the search result to enter the matching function page. 

Performing an advanced search for a device 
1. Navigate to the Advanced Query page. 

2. Click the Advanced icon  located in the upper right corner of the IMC page 

3. Select Query Devices to perform a device search. 

4. Enter the following information in the Advanced Query page: 

 Device Label—IMC supports fuzzy matching for this field. You can enter a partial or 
complete name for the devices you want to locate in the Device Label field. 

 Device IP—Enter the IP address of the device for which you want to search in the Device IP 
field. Select Fuzzy from the list next to the Device IP if you want to enter a partial IP 
address. Select Exact from this list to search for an exact match for the entered IP address. 

 MAC—Enter the MAC address of the device for which you want to search in the MAC field. 
IMC supports fuzzy matching for this field. You can enter a partial or complete MAC address 
for the devices you want to locate. 

 Bridge MAC—Enter the MAC address for the Bridge device that you want to query for in the 
Bridge Mac field. 

 Device Category—Select the device category from the Device Category list. 

 Device Status—Select the device status from the Device Status list. 

 Device Series—Select the device series from the Device Series list. 

 Contact—Enter the contact name information for which you want to search. IMC supports 
fuzzy matching for this field, allowing you to enter a partial or complete string for the contact 
in the Contact field. 

 Location—Enter the location information for which you want to search. IMC supports fuzzy 
matching for this field, allowing you to enter a partial or complete string for the location in the 
Location field. 

 Device Reachability—Select device reachability status from the Device Reachability list. 

 Maintenance Tag—Select whether to match devices that have maintenance tags from the 
Maintenance Tag list. 

 Custom View—Select a custom view from the Custom View list. IMC searches devices 
matching the query criteria only from the specified custom view. 
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 Faulty Device—Select whether to match devices that have alarms from the Faulty Device 
list. 

 Append Info—Select an option from the Append Info list, and then enter a value in the 
field next to it. The list supports fuzzy matching. Enter a partial or complete string to locate 
an option. This parameter appears only when you have configured device additional 
information. For more information about configuring device additional information, see 
"Device additional information." 

5. Click Query. 

All devices matching the specified criteria are displayed on the Device List.  

6. Click Export Excel or Export CSV on the right of Device List to launch the Download 
Exported Data window, and then click the Download Exported Data link to export the query 
result in the format of Excel or CSV. 

Performing an advanced search for an interface 
1. Navigate to the Advanced Query page. 

2. Click the Advanced icon  located in the upper right corner of the IMC page. 

3. Select Query Interfaces to perform search for interfaces. 

4. Enter the following information in the Advanced Query page: 

 Interface Alias—IMC supports fuzzy matching for this field. You can enter a partial or 
complete name for the interface alias you want to locate in the Interface Alias field. 

 Interface Type—Select the interface type you want to search from the Interface Type list. 

 Speed—Select the interfaces speed from the Speed list. 

 Interface IP—Enter the IP address of the interface for which you want to search in the 
Interface IP field. Select Fuzzy from the list next to the Interface IP if you want to enter a 
partial IP address. Select Exact from the list to search for an exact match for the entered IP 
address. 

 MAC Address—Enter the MAC address of the interface for which you want to search in the 
MAC Address field. IMC supports fuzzy matching for this field, allowing you to enter a 
partial or complete MAC address. 

 Device Label—Enter a partial or complete name of the device to which the interface 
belongs in the Device Label field. IMC supports fuzzy matching for this field, allowing you to 
enter a partial or complete string for the device name. 

 Device IP—Enter the IP address of the device to which the interface belongs in the Device 
IP field. Select Fuzzy from the list next to the Device IP if you want to enter a partial IP 
address. Select Exact from the list if you want IMC to search for an exact match for the 
entered IP address. 

 Management Status—Select the management status of the interfaces for which you want 
to search from the Management Status list. 

 Operational Status—Select the operational status of the interfaces for which you want to 
search from the Operational Status list. 

 Interface Up/Down Alarm Filter—Select the interface up/down alarm filter used by the 
interfaces for which you want to search from the Interface Up/Down Alarm Filter list. 

 Interface Link Type—Select the link type of the interfaces for which you want to search 
from the Interface Link Type list. 

5. Click Query. 

All interfaces that match the query criteria are displayed on the Interface List. For more 
information, see "Accessing the interface list and interface details page." 

To set an interface up/down alarm filter for interfaces: 

a. Select interfaces for which you want to set the interface up/down alarm filter. 
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b. Click Up/Down Alarm Filter on top of the page. The Resource > Batch Operation > 
Interface Up/Down Alarm Filter page opens. Set the interface up/down alarm filter. For 
more information, see "Using batch mode to modify interface up/down alarm filter." 

To view detailed information about an interface, click the Operation icon  of the interface, 
and then select the Interface Detail icon  from the menu. For more information, see 
"Interface details page." 

To modify the VLAN setting of an interface, click the Operation icon  of the interface, and 
then select the Modify VLAN icon  from the menu. For more information, see "Interface 
details right navigation tree." 

To modify properties or perform a loopback test for an interface, click the Operation icon  of 
the interface, and then select the Port Properties icon  from the menu. For more 
information, see "Interface details right navigation tree." 

To save the query criteria as a filter, click Save as Filter, which you can view in the Filter List.  

The filter can be used by port groups to filter interfaces. For more information about filters, see 
"Managing filters to filter interfaces." 

Performing an advanced search for a user 
To perform an advanced user search: 

1. Navigate to the Advanced Query page. 

2. Click the Advanced icon  located in the upper right corner of the IMC page. 

3. Select Query Users to perform a user search. 

4. Enter the following information in the Advanced Query page:  

 User Name—Enter the user's name in the User Name field. IMC supports fuzzy matching 
for this field. You can enter a partial or complete string for the user you want to locate. 

 Identity Number—Enter the Identity number for the user for which you want to search in 
the Identity Number field. IMC supports fuzzy matching for this field. You can enter a partial 
or complete string for the identify number for the user you want to locate. 

 Contact Address—Enter the contact address information for the user in the Contact 
Address field. IMC supports fuzzy matching for this field. You can enter a partial or 
complete string for the contact address for the user you want to locate. 

 Telephone—Enter the telephone number of the user in the Telephone Number field. IMC 
supports fuzzy matching for this field. You can enter a partial or complete telephone number 
for the user you want to locate. 

 Email—Enter the mail address of the user in the Email field. IMC supports fuzzy matching 
for this field. You can enter a partial or complete mail address for the user you want to 
locate. 

 User Group—Click the User Group icon  to select the group to which the user belongs.  

5. Click the Expand All icon  to expand all groups. 

6. Select the group in which you want to search. 

7. Click OK. 

8. Click Query. 

Personalizing the IMC Web interface 
IMC allows you to customize the IMC Web page theme and add often-used functions to My 
Favorites. 
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My Favorites 
You can customize the IMC Web page by storing favorites for quick access to often-used functions 
within IMC.  

Accessing a favorite 

1. Point to the My Favorites icon  located to the right of the search box on the menu bar. 

A list of predefined and user defined favorites appears. 

2. Point to the My Favorites folder option.  

The list of configured favorites is displayed in a popup list to the right.  

3. Click the favorite you want to access. 

Adding a favorite 

1. Click the Add to My Favorites icon  located in the upper right corner of the main pane of 
most IMC pages. 

2. Enter the new name of the favorite link in the Name field. 

3. Click OK to confirm adding the link to My Favorites. 

4. Refresh or reload the page in your Web browser to access the newly created favorite. 

Modifying a favorite 

1. Navigate to System > My Favorites: 

a. Click the System tab from the top tabular navigation system.  

b. From the navigation tree, select System Configuration > My Favorites. 

The Manage My Favorites list is displayed on the main page. 

2. Click the Expand icon  next to the folders and links displayed in the Manage My Favorites 
list to expand the view to display all of the links under the selected folder. 

3. Click the Modify icon  associated with the link you want to modify. 

4. Enter the new name of the favorite link in the Name field. 

5. Select the folder to which you want to move the link from the Folder list. 

6. Click OK. 

7. Click Refresh to refresh the Manage My Favorites list. 

Sorting favorites 

1. Navigate to System > My Favorites: 

a. Click the System tab from the top tabular navigation system.  

b. From the navigation tree, select System Configuration > My Favorites. 

The Manage My Favorites list is displayed on the main page. 

2. Do one of the following: 

 Click the up arrow key icon  associated with the link you want to move up one position. 

 Click the up arrow key icon  associated with the link you want to move to the top in the 
folder. 

 Click the down arrow key icon  associated with the link you want to move down one 
position. 

 Click the down arrow key icon  associated with the link you want to move to the bottom in 
the folder. 
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Deleting a favorite 

 CAUTION: 

If you delete a folder, all of its contents are also deleted. Once a folder has been deleted, it cannot 
be recovered. 
 

1. Navigate to System > My Favorites: 

a. Click the System tab from the top tabular navigation system.  

b. From the navigation tree, select System Configuration > My Favorites. 

The Manage My Favorites list is displayed on the main page. 

2. Click the Expand icon  next to the folders and links displayed in Manage My Favorites list to 
expand the view to display all links under the selected folder. 

3. Click the Delete icon  in the Manage My Favorites list associated with the link you want to 
delete. 

4. Click OK to confirm the deletion of the selected link. 

5. Click Refresh to refresh the Manage My Favorites list. 

Theme 
You can select an IMC Web page theme, which is Classic by default.  

To set the IMC Web page theme: 

1. Point to the My Favorites icon  located to the right of the search box on the menu bar. 

A list of predefined and user-defined favorites appears. 

2. Point to the Theme option. 

3. On the menu that appears, select Sky Blue, Classic, Midnight, Gun Metal, or Ocean. 

The selected theme will be applied to the IMC Web page. 

Customizing logo and product information 
You can customize logos, product names, and copyright information on IMC Web pages by replacing 
or modifying specific files instead of recompiling or reinstalling IMC. The following information 
describes areas that can be customized on IMC Web pages and the custom methods. 

For customization to take effect, restart IMC in the monitoring agent. 

An IMC upgrade overwrites the customization contents. Back up the customization contents before 
an IMC upgrade, and customize logo and product information again after the IMC upgrade 
completes. 

Customizing the IMC login page 

Figure 68 displays areas that can be customized on the IMC login page. Table 10 lists custom 
methods. 
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Figure 68 Areas that can be customized on the IMC login page 

  
 

Table 10 Custom methods for the IMC login page 

Area Custom method Remarks 

1 
Replace the following file in the IMC installation path: 

\client\web\apps\imc\resources\primefaces-imc-theme 
name\images\login_bg.jpg 

For example, to customize the 
login page of the sky blue 
theme, replace files in the 
primefaces-imc-new-webui\i
mages directory. 

Make sure the new picture has 
the same resolution as the 
original picture. 

2 
Replace the following file in the IMC installation path: 

\client\web\apps\imc\resources\primefaces-imc-theme 
name\images\login_logo_hp.png 

3 
Replace the following file in the IMC installation path: 

\client\web\apps\imc\resources\primefaces-imc-theme 
name\images\login_logo_imc_hp.png 
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Area Custom method Remarks 

4 

Modify the following contents in the 
\client\web\apps\imc\login.xhtml file in the IMC installation 
path by using the common HTML tag or JSF tag: 

<div class="imc_ui_log_tips imc_ui_log_tips_txt"> 

<h:outputText 
value="#{platmsgs['home.imc.login.brower']}" 
escape="false"/> 

<h:outputText 
value="#{platmsgs['home.imc.login.brower.IE']}
" /> 

<h:outputText 
value="#{platmsgs['home.imc.login.brower.comma
']}" escape="false"/> 

<p:commandLink id="downloadFirefox" 
styleClass="imc_ui_log_link"value="#{platm
sgs['home.imc.login.brower.Firefox']}"acti
on="#{platOperatorBean.onDownloadFirefox}" 
immediate="true"ajax="false" > 

</p:commandLink> 

<h:outputText 
value="#{platmsgs['home.imc.login.brower.comma
']}" escape="false"/> 

<h:outputText 
value="#{platmsgs['home.imc.login.brower.and']
}" escape="false"/> 

<h:outputText 
value="#{platmsgs['home.imc.login.brower.Chrom
e']}" /> 

<h:outputText 
value="#{platmsgs['home.imc.login.brower.fullp
oint']}" escape="false"/> 

<h:outputText 
value="#{platmsgs['home.imc.login.brower.resol
ution']}" /> 

<h:outputText 
value="#{platmsgs['home.imc.login.brower.fullp
oint']}" escape="false"/> 

</div> 

For the Firefox download link to 
successfully provide the 
installation file of the modified 
Firefox version, replace the 
following file in the IMC 
installation path: 

\client\web\apps\imc\noAuth\
firefox\Firefox_en_US.exe.  

Make sure the new file has the 
same name as the original file. 

 

Customizing the IMC home page 

Figure 69 displays areas that can be customized on the IMC home page. Table 11 lists custom 
methods. 
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Figure 69 Areas that can be customized on the IMC home page 

 
 

Table 11 Custom methods for the IMC home page 

Area Custom method Remarks 

1 
1. In the \client\web\apps\imc\WEB-INF\classes\ directory of 

the IMC installation path, create a Logo.txt file in the ANSI 
encoding format (the default is ANSI). 

2. In the Logo.txt file, add the following content: 
login.title=New Product Name 

3. Rename the Logo.txt file as Logo.properties. 

If the classes folder does not 
exist, add the folder. 

Names on the About and 
Online Help pages will also 
be modified. 

2 

3 

Modify the following contents of footer.xhtml and 
footerForDnd.xhtml files in the \client\web\apps\imc\ directory in 
the IMC installation path by using the common HTML tag or JSF 
tag: 

<h:panelGroup style="white-space:nowrap;" > 

<h:outputText escape="false" 
value="#{platmsgs['info.copyright']}" /> 

<h:outputText escape="false" 
value="#{platLogoBean.copyrightYear}" /> 

<h:outputText escape="false" 
value="#{platLogoBean.company}" /> 

</h:panelGroup> 

As a best practice, keep 
values in the footer.xhtml 
file consistent with values in 
the footerForDnd.xhtml file. 

 

Customizing About and Online Help pages 

Figure 70 and Figure 71 display areas that can be customized on the About page and Online Help 
page, respectively. Table 12 lists custom methods. 
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Figure 70 Areas that can be customized on the About page 

 
 

Figure 71 Areas that can be customized on the Online Help page 
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Table 12 Custom methods for the About and Online Help pages 

Area Custom method Remarks 

1 

1. In the \client\web\apps\imc\WEB-INF\classes\ directory of 
the IMC installation path, create a Logo.txt file in the ANSI 
encoding format (the default is ANSI). 

2. In the Logo.txt file, add the following content: 
login.title=New Product Name 

3. Rename the Logo.txt file as Logo.properties. 

If the classes folder does not 
exist, add the folder. 

Names on the IMC home 
page and the Online Help 
page will also be modified. 

2 

Modify the following contents in the 
\client\web\apps\imc\aboutContent.xhtml file in the IMC 
installation path by using the common HTML tag or JSF tag: 

<td valign="bottom" width="90%" style="font-size: 
9pt;"> 

<h:outputText escape="false" 
value="#{platmsgs['info.copyright']} 
#{platLogoBean.copyrightYear} 
#{platLogoBean.company}"/> 

</td> 

N/A 

3 

1. In the \client\web\apps\imc\WEB-INF\classes\ directory of 
the IMC installation path, create a Logo.txt file in the ANSI 
encoding format (the default is ANSI). 

2. In the Logo.txt file, add the following content: 
login.title=New Product Name 

3. Rename the Logo.txt file as Logo.properties. 

If the classes folder does not 
exist, add the folder. 

Names on the IMC home 
page and the Online Help 
page will also be modified. 

4 

Modify the following contents in the 
\client\web\apps\imc\help\helpframe\support.xhtml file in the 
IMC installation path by using the common HTML tag or JSF tag: 

<td valign="bottom" width="90%" style="font-size: 
9pt;"> 

<h:outputText escape="false" 
value="#{platmsgs['info.copyright']} 
#{platLogoBean.copyrightYear} 
#{platLogoBean.company}"/> 

</td> 

<td height="20px"> 

<div align="center" class="copyright"> 

<h:outputText escape="false" 
value="#{platmsgs['info.copyright']}" /> 

<h:outputText escape="false" 
value="#{platLogoBean.copyrightYear}" /> 

<h:outputText escape="false" 
value="#{platLogoBean.company}" /> 

<h:outputLink 
value="#{platLogoBean.loginHomepage}" 
target="_blank"> 

<h:outputText style="FONT-FAMILY: Arial" 
value="#{platLogoBean.loginHomepage}" /> 

</h:outputLink> 

</div> 

</td> 

N/A 
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Dashboard 
IMC displays multiple types of data in separate views. For example, it displays network structures in 
the network topology and displays device performance data in performance views. 

Large projects and conferences usually require an integrated view to show multiple types of network 
data together, including devices, views, alarms, and performance data. 

To meet this requirement, you can use the dashboard feature of IMC. This feature allows operators 
to customize targeted devices, views, alarms, performance data, and other data in different areas 
known as "widgets" for a big-screen display. 
 

 NOTE: 

To obtain the best display effect, install your screen and tune its settings before you use the 
dashboard feature. 
 

The following describes important terms and concepts for the dashboard: 

 Panel—Represents the configuration area in which an operator creates a view and customizes 
widgets for the view. The panel displays one view at a time. For more information, see 
"Accessing the view configuration window." 

 View—Contains one or more widgets and displays widgets' data on a big screen. This term is 
different from IP, device, and other views in IMC. Views in the dashboard are configured with 
widgets as needed. 

 Widget—Displays information about devices, alarms, performance, custom views, or 
environment or power devices such as air conditioners, thermometers, hygrometers, and 
UPSs. For example, the IP Topology widget displays the specified IP topology. 

To use the dashboard, an operator must first add views and customize widgets for each view on the 
panel, select one view, and then complete the display settings. The panel is actually a scaled-down 
screen that shows the layout of each view to be displayed. Move the mouse wheel to switch between 
views.  

An operator, who can be an administrator, a maintainer, or a viewer, can configure up to 10 views but 
cannot manage views created by other operators. 

The widgets that an operator can customize vary with the operating privileges in the IMC platform. 
For example, operators who cannot display or configure custom views, are not allowed to configure 
custom view widgets. 

The following information describes how to configure views and customize widgets for a view, and 
describes widgets in details. 

Configuring a view 
IMC offers a link on its home page to launch a separate window for view configuration. 

Accessing the view configuration window 

1. Point to the My Favorites icon  located to the right of the search box on the menu bar. 

A list of predefined and user-defined favorites is displayed. 

2. Point to the Dashboard folder option. 

The popup list is displayed. 

3. Click the Configuration icon  in the popup list. 

The view configuration window opens. 
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Figure 72 View configuration window 

 
 

The window contains the following parts: 

 Widget area—The widget area is located at the top of the window, and displays all widgets 
loaded for view configuration. By default, the area contains 21 widgets loaded from the IMC 
platform. When other service components are deployed, more widgets are displayed in the 
area. 

 Panel—The top of the panel displays the scroll units. The other area uses a grid layout 
consisting of cells. 

 You can drag and drop widgets down to the scroll units. The selected widgets' data will be 
displayed in the scroll area on a big screen. 

 Cells in the first row and first column display the row number and the column number of the 
current view, respectively. 

 The panel is fixed in size, and the cell size changes along with the grid settings of the view.  

 A wider and higher view contains more cells and they look smaller on the panel. 

 To properly display the view in a big screen, make sure the row and column numbers of 
each view do not exceed the maximum resolution of the big screen.  

 You can drag and drop widgets down to the panel, and then adjust their positions in the 
view. 

 Command area—The command area is located on the right of the window. It displays the view 
name and comprises two subareas:  

 Grid Properties—By default, only the Grid Properties subarea is displayed. The Grid 
Properties subarea allows you to set the name, title, title size, and title color of the view, 
adjust the view pixels, configure the scroll region, filter the widgets by component, enable 
switching views, set the switching interval, move backward or forward between views, add 
or delete the view, save views, refresh views, and sort views. 

 Cell Properties—When you select a widget in the panel, the Cell Properties subarea is 
displayed, on which you can set the position, size, and title font size of the widget. 

Basic operations in the view configuration window 

On the view configuration window, you can perform basic operations on the panel, views, and 
widgets. 

Renaming a view 

In the Grid Properties area, enter a new name in the View Name field. By default, the View Name 
field uses New View. 

Setting a view title 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 8512



111 

To display a single-line title at the top of a view, perform the following tasks in the Grid Properties 
area: 

1. Enter a title in the Title field. 

2. Enter a number in the Title Size field. 

3. Click the textbox next to the Title Color field and configure the title color. 

Setting panel properties 

In the Grid Properties subarea, you can set the pixels for the panel grid. Set the screen pixels in the 
Screen Width(PT) and Screen Height(PT) fields. The fields are automatically populated with the 
resolution values of the current server. After you set the grid properties, click the panel. The row and 
column numbers of the panel change along with the grid properties. The number of cells that the 
panel contains also changes.  

To display the view completely on the big screen, make sure the grid properties do not exceed the 
maximum resolution that your big screen supports.  

Configuring a scroll area 

You can configure a scroll area to scroll widgets at the specified time interval at the top of the display 
window of a view. 

To configure a scroll area: 

1. Set the widget display size in the Scroll Region Height and Scroll Unit Column fields. 

2. Set the scroll interval for widgets in minutes in the Scroll Interval field. 

3. Set the number of cells at the top of the panel in the Scroll Number field. 

You can drag widgets to be displayed in the scroll area to the cells at the top of the panel. 

Filtering widgets 

From the System Widgets list, you can select All, Platform, Alarm, or Performance to filter the 
widgets displayed on widget bar on the top. For example, if you select Alarm, the widget bar on the 
top displays only alarm-related widgets Alarm Panel and Alarm Statistics. 

Switching views 

Select Switch Views and set the view switching interval in the Switching Interval (Second) field. 
By default, the Switch Views option is selected and the switching interval is 30 seconds.  

Navigating the views 

 Click the Previous View icon  to move backward to the previous view. If the view is 
the first view, the icon is unavailable. 

 Click the Next View icon  to move forward to the next view. If the view is the last view, 
the icon is unavailable. 

Adding a view 

1. Click the New View icon . 

The Add View window opens. 

2. Enter the view name. The default name is New View. The name is a string of 1 to 32 
characters, and it can be the same as that of an existing view. 

3. Click OK. 

Deleting a view 

1. Click the Delete View icon . 

2. Click Yes in the dialog box that opens. 

Saving modifications to all views 
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Click the Save Configuration icon  to save all modifications to all views. If a view contains 
overlapping widgets, IMC displays a conflict message. Please adjust the widget positions, and then 

click the Save Configuration icon  again. 

Refreshing all views 
 

 CAUTION: 

Save any modifications to the views before you refresh them. Otherwise, all modifications are lost. 
 

Click the Refresh icon  to refresh all views. 

Sorting views 

1. Click the View Order icon . 

2. Select a single view, and then click Sticky to place the view at the top or click Lowest to place 
the view at the bottom. 

3. Select one or more views and click Up or Down to move the selected views up or down one 
position. 

4. Click Save. 

Setting widget properties 

Select a widget, and then set the following parameters in the command area: 

 Row Index—Start row number of the widget. Enter a number in the Row Index field, or modify 

the value by clicking  or . 

 Column Index—Start column number of the widget. Enter a number in the Column Index field, 

or modify the value by clicking  or . 

 Row Spans—Total rows of the widget. Enter a number in the Row Spans field, or modify the 

value by clicking  or . 

 Column Spans—Total columns of the widget. Enter a number in the Column Spans field, or 

modify the value by clicking  or . 

 Title Font Size—Title font size of the widget displayed in the dashboard. By default, the title 

font size is 12. Enter a number in the Title Font Size field, or modify the value by clicking  

or . 

On the panel, the cells covered by a widget depend on the properties of the widget. If the rows or 
columns counted from the start row or column number of the widget are less than the row or column 
spans, the widget covers a single cell only, and has only part of its data displayed on the big screen.  

As a best practice, use the pointer to adjust the widget positions and sizes. 

Adding a view 

An operator, who can be an administrator, a maintainer, or a viewer, can configure up to 10 views and 
cannot manage views created by other operators.  

To add a view: 

1. Navigate to the view configuration window: 

a. Point to the My Favorites icon  located to the right of the search box on the menu bar. 

A list of predefined and user-defined favorites is displayed. 

b. Point to the Dashboard folder option. 

The popup list is displayed. 

c. Click the Configuration icon  in the popup list. 
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The view configuration window opens. 

2. Click the New View icon  in the command area.  

The Add View window opens.  

If the current operator has already added 10 views, IMC displays a message, prohibiting the 
operator from adding more views. 

3. Enter the name of the view in the View Name field. The name need not be unique. 

4. Click OK.  

The view you have added is displayed on the view configuration window. 

Deleting a view 

1. Navigate to the view configuration window: 

a. Point to the icon  located to the right of the search box on the menu bar. 

A list of predefined and user defined favorites is displayed. 

b. Point to the Dashboard folder option. 

The popup list is displayed. 

c. Click the Configuration icon  in the popup list. 

The view configuration window opens. 

2. Switch to the view you want to delete, and then click the Delete View icon  in the 
command area. 

3. Click OK in the dialog box that opens.  

Customizing a single widget for a view 

To customize a single widget for a view, you can set the position and size of the widget, and then 
save the view. This example describes how to customize an alarm widget for a view.  

An operator can customize widgets to which the operator has privileges. For example, if the operator 
cannot display or configure the custom views in resource management, the widget area does not 
display the Custom View List and Custom View Status Pie Chart widgets for the operator.  

To customize a widget for a view: 

1. Navigate to the view configuration window: 

2. Point to the icon  located to the right of the search box on the menu bar. 

A list of predefined and user-defined favorites is displayed. 

a. Point to the Dashboard folder option. 

The popup list is displayed. 

b. Click  Configuration in the popup list. 

The view configuration window opens. 

3. Drag the Alarm Panel widget and drop it to the panel. By default, the widget covers five rows 
and eight columns.  

If the rows or columns counted from the start row or column number of the widget are less than 
five or eight, the widgets will overlap and the display of the view will be affected. Adjust the 
position to properly display the widget. 

4. Set the position, size, and title font size of the widget in the command area on the right in the 
view configuration window. 

 Row Index—The start row number of the widget. Enter a number in the Row Index field or 

modify the value by clicking  or . 

 Column Index—The start column number of the widget. Enter a number in the Column 

Index field, or modify the value by clicking  or . 
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 Row Spans—Total rows of the widget. Enter a number in the Row Spans field, or modify 

the value by clicking  or . 

 Column Spans—Total columns of the widget. Enter a number in the Column Spans field, 

or modify the value by clicking  or . 

 Title Font Size—Title font size of the widget displayed in the dashboard. By default, the title 
font size is 12. Enter a number in the Title Font Size field, or modify the value by clicking 

 or . 

5. Configure the widget through the right-click shortcut menu. 

Right-click a selected widget on the panel to display a list of management options that can be 
applied to the selected widget, including widget deletion and optional parameter settings.  

 If a widget does not contain configurable parameters, the shortcut menu contains only the 
Delete Widget option. 

 This document does not describe the flash related options on the lower section of the 
shortcut menu. 

Delete Widget 

This option enables you to delete a widget from the current view. 

To delete a widget: 

a. Right-click the widget. 

b. Select Delete Widget from the shortcut menu. 

c. Click OK in the dialog box that opens. 

Parameter Settings 

This option enables you to set parameters for a widget. Whether the right-click shortcut menu 
contains this option varies with the widget. 

To set parameter settings: 

a. Right-click the widget. 

b. Select Parameter Settings from the shortcut menu, and then set parameters in the dialog 
box that opens. For more information about setting parameters for the alarm panel widget, 
see "Alarm panel widget." 

Preview 

This option enables you to preview a widget. 

To preview a widget: 

a. Right-click the widget. 

b. Select Preview from the shortcut menu. The dashboard opens. 

6. Click the Save Configuration icon . 

Configuring widgets to be displayed in a scroll area 

You can configure a scroll area and configure widgets to be displayed in the scroll area. The scroll 
area scrolls widgets at the specified time interval at the top of the display window of a view. 

To configure widgets to be displayed in a scroll area: 

1. Navigate to the view configuration window: 

a. Point to the My Favorites icon  located to the right of the search box on the menu bar. 

A list of predefined and user-defined favorites is displayed. 

b. Point to the Dashboard folder option. 

The popup list is displayed. 

c. Click  Configuration in the popup list. 

The view configuration window opens. 
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Figure 73 Configuring a scroll area 

 
 

2. In the Grid Properties subarea, perform the following tasks: 

a. In the Scroll Region Height field, set the height of each widget to be displayed in the scroll 
area. 

The widget height equals to the set number multiplied by the height of the panel cell. 

b. In the Scroll Number field, set the number of cells at the top of the panel. 

As a best practice, set a number that is no less than the number of widgets to be displayed. 

c. In the Scroll Unit Column field, set the width of each widget to be displayed in the scroll 
area. 

The widget width equals to the set number multiplied by the width of the panel cell. 

d. In the Scroll Interval field, set the scroll interval of widgets in minutes. 

3. Drag widgets to be displayed in the scroll area to cells at the top of the panel. 

4. Configure the widget through the right-click shortcut menu. 

Right-click a selected widget on the scroll unit to display a list of management options that can 
be applied to the selected widget, including widget deletion and optional parameter settings.  

 If a widget does not contain configurable parameters, the right-click shortcut menu contains 
only the Delete Widget option. 

 This document does not describe the flash related options on the lower section of the 
right-click shortcut menu. 

Delete widget 

This option enables you to delete the widget from the current view. 

To delete a widget: 

a. Right-click the widget. 

b. Select Delete Widget from the shortcut menu. 

c. Click OK in the dialog box that opens. 

Parameter settings 

This option enables you to set parameters for the widget. Whether the right-click shortcut menu 
contains this option varies with the widget. 

To set parameter settings: 

d. Right-click the widget. 

e. Select Parameter Settings from the shortcut menu, and then set parameters in the dialog 
box that opens. For more information about setting parameters for a widget, see 
"Configuring widgets." 

5. Click the Save Configuration icon . 
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Displaying a view 

On the view display window, only the display style can be modified, and the view and the widgets it 
contains cannot be modified. The view display window does not provide a link to the view 
configuration window. To enter the view configuration window, you must use the My Shortcut menu. 
After that, the view display window is automatically switched into the view configuration window.  

To display a view: 

1. Navigate to the view display window. 

a. Point to the icon  located to the right of the search box on the menu bar. 

A list of predefined and user-defined favorites is displayed. 

b. Point to the Dashboard folder option.  

The popup list is displayed. 

c. Click the view you want to display. 

The view is displayed in the popup window. 

2. Right-click the popup window. 

The Change Theme window opens. The window lists 10 themes predefined by the system, and 
Blue is used by default. To switch to another theme, click a theme name. 

Configuring widgets 
By default, the IMC platform contains 21 widgets.  

 To load the performance management widgets, make sure the Performance Management 
component has been deployed.  

 To load the alarm management widget, make sure the Alarm Management component has 
been deployed.  

An operator can only customize widgets to which the operator has privileges. For example, if the 
operator cannot display or configure the custom views in resource management, the operator cannot 
view the custom views, the Custom View List, or the Custom View Status Pie Chart widget. 

The dashboard automatically loads widgets from all deployed service components and displays 
them in the widget area of the view configuration window. In addition, dashboard allows operators to 
load widgets as needed. For more information about widget management, see "Alarm, performance, 
and resource widgets." 

The following information describe the 21 widgets offered by the IMC platform. 

Alarm panel widget 

Figure 74 Alarm panel widget icon 

 
 

The Alarm Panel widget is loaded only after the alarm management component is deployed. It 
displays the latest alarm statistics and trends on the network, and allows operators to set the display 
mode and alarm class. Operators can display per-level alarm trend, per-class TopN alarms, 
Real-Time alarms, per-class statistics, or per-class statistics trend, and select the class of alarms 
they want to view, such as device alarms and performance alarms.  

The Alarm Panel widget refreshes every 300 seconds. As shown in Figure 75, the left part of the 
window displays a column of numbers organized by alarm severity, and the right part displays a bar 
chart (the x-axis indicates the alarm category and the y-axis indicates the alarm quantity), the total 
devices and new devices, and the most recent unrecovered alarms.  
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Figure 75 Alarm panel widget contents 

 
 

To configure the Alarm Panel widget: 

1. Navigate to the view configuration window: 

a. Point to the My Favorites icon  located to the right of the search box on the menu bar. 

A list of predefined and user-defined favorites is displayed. 

b. Point to the Dashboard folder option. 

The popup list is displayed. 

c. Click the Configuration icon  in the popup list. 

The view configuration window opens. 

2. Drag the Alarm Panel widget from the widget area to the panel. 

3. Right-click the Alarm Panel widget, and then select Configure Parameters from the shortcut 
menu.  

The Parameter Configuration window opens. 

4. Select a display mode from the list. Options include: 

 Per-class statistics—Displays the number of alarms by severity level for every alarm 
class. 

 Per-level alarm trend—Displays an alarm diagram showing the alarm trends by severity 
level. If you select this option, set the widget's Row Spans to be greater than its Column 
Spans. 

 Per-class statistics trend—Displays an alarm diagram showing the alarm trends by 
severity level for every alarm class. 

 Real-Time alarms—Displays the real-time alarms messages. If you select this option, you 
can set the alarm level and blinking alarm levels and specify whether to fold lines as 
needed.  

 Per-class TopN alarms—Displays the alarms by severity level for each alarm class, and 
displays the top five devices that contain the most unrecovered alarms. 

5. Select an alarm class from the list. Options include: 

 All alarms 

 Device alarms 

 Performance alarms 

 Security alarms 
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 Configuration alarms 

 Application alarms 

 Select an alarm source range from the Custom View list. Options are All Devices and 
names of existing custom views. 

6. If you select Real-Time alarms, set the following parameters as needed: 

 Alarm Level—Select the levels of alarms to be displayed on the alarm panel. Options are 
All Levels, Critical, Major and Higher, Major, Minor and Higher, Minor, Warning and 
Higher, and Warning.  

 Blinking Alarm Levels—Specify the levels of blinking alarms. You can select Critical, 
Major, Minor, and Warning as needed.  

 Folding Line—Specify whether to display the alarm information in one line or fold the line.  

7. Click OK. 

8. Click the Save Configuration icon . 

Electric clock 

Figure 76 Electric clock widget icon 

 
 

The Electric Clock widget displays the current date and time in the dashboard, as shown in Figure 
77. The electric clock font color is blue by default and can be customized.  

Figure 77 Electric clock widget contents 

 
 

To configure the Electric Clock widget: 

1. Navigate to the view configuration window: 

a. Point to the icon  located to the right of the search box on the menu bar. 

A list of predefined and user-defined favorites is displayed. 

b. Point to the Dashboard folder option. 

The popup list is displayed. 

c. Click the Configuration icon  in the popup list. 

The view configuration window opens. 

2. Drag the Electric Clock widget from the widget area to the panel. 

3. Right-click the Electric Clock widget, and then select Configure Parameters from the shortcut 
menu.  

The Parameter Configuration window opens. 

4. Initially, the Default Color option is selected, and the color is blue. To customize the font color, 
clear the Default Color option and click the  icon. 

5. Click OK. 

6. Click the Save Configuration icon . 
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Important device monitor widget 

Figure 78 Important device monitor widget icon 

 
 

The Important Device Monitor widget displays the basic information and performance data of the 
specific device in an unreachability dashboard, a CPU Usage line chart, a Memory Usage ring 
chart, a device label and status card, an Alarm card chart, and a Response Time line chart. You can 
click a device label to access the details page of the device.  

Figure 79 Import device monitor widget contents 

 
 

To configure the Important Device Monitor widget: 

1. Navigate to the view configuration window: 

a. Point to the icon  located to the right of the search box on the menu bar. 

A list of predefined and user-defined favorites is displayed. 

b. Point to the Dashboard folder option. 

The popup list is displayed. 

c. Click the Configuration icon  in the popup list. 

The view configuration window opens. 

2. Drag the Important Device Monitor widget from the widget area to the panel. 

3. Right-click the Important Device Monitor widget, and then select Configure Parameters from 
the shortcut menu.  

The Parameter Configuration window opens. 

4. Enter the display name of the widget. 

5. Click Add Device. On the window that opens, select one or more important devices. You can 

select up to 20 devices. Then, click OK. To delete an important device, click the  icon for the 
device.  

6. Click OK. 

7. Click the Save Configuration icon . 
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Lower-level NMS performance view widget 

Figure 80 Lower-level NMS performance view widget icon 

 
 

The Lower-Level NMS Performance View widget displays performance view data in the 
dashboard. As shown in Figure 81, the Lower-Level Performance View widget displays the 
monitoring data of an index in the specified performance view in a line chart. 

Figure 81 Lower-level NMS performance view widget contents 

 
 

To configure the Lower-Level NMS Performance View widget: 

1. Navigate to the view configuration window: 

a. Point to the icon  located to the right of the search box on the menu bar. 

A list of predefined and user-defined favorites is displayed. 

b. Point to the Dashboard folder option. 

The popup list is displayed. 

c. Click the Configuration icon  in the popup list. 

The view configuration window opens. 

2. Drag the Lower-Level NMS Performance View widget from the widget area to the panel. 

3. Right-click the Lower-Level NMS Performance View widget, and then select Configure 
Parameters from the shortcut menu.  

The Text Label window opens. 

4. Select a lower-level NMS. 

5. Select a performance view to be displayed. 

Only existing performance views of trend line and data grid types are available. 

6. Select an index to be displayed. 

7. Click OK. 

8. Click the Save Configuration icon . 
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Performance view widget 

Figure 82 Performance view widget icon 

 
 

The Performance View widget displays performance view data in the dashboard. As shown in 
Figure 83, the Performance View widget displays the monitoring data of an index in the specified 
performance view in a line chart. 

Figure 83 Performance view widget contents 

 
 

To configure the Performance View widget: 

1. Navigate to the view configuration window: 

a. Point to the icon  located to the right of the search box on the menu bar. 

A list of predefined and user-defined favorites is displayed. 

b. Point to the Dashboard folder option. 

The popup list is displayed. 

c. Click the Configuration icon  in the popup list. 

The view configuration window opens. 

2. Drag the Performance View widget from the widget area to the panel. 

3. Right-click the Performance View widget, and then select Configure Parameters from the 
shortcut menu.  

The Parameter Configuration window opens. 

4. Select a performance view to be displayed. 

Only existing performance views of trend line and data grid types are available. 

5. Select an index to be displayed. 

6. Click OK. 

7. Click the Save Configuration icon . 
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Single device monitor widget 

Figure 84 Single device monitor widget icon 

 
 

The Single Device Monitor widget displays real-time data collected from the specified device. As 
shown in Figure 85, the Single Device Monitor widget displays the CPU usage and memory usage 
of the specified device in a dashboard and a line chart, and displays alarm numbers of the device by 
alarm level in dashboards. Click the title in the upper left corner to enter the page showing the device 
details. Click a legend name to display or hide the data for the corresponding index in the trend chart.  

Figure 85 Single device monitor widget contents 

 
 

To configure the Single Device Monitor widget: 

1. Navigate to the view configuration window: 

a. Point to the icon  located to the right of the search box on the menu bar. 

A list of predefined and user-defined favorites is displayed. 

b. Point to the Dashboard folder option. 

The popup list is displayed. 

c. Click the Configuration icon  in the popup list. 

The view configuration window opens. 

2. Drag the Single Device Monitor widget from the widget area to the panel. 

3. Right-click the Single Device Monitor widget, and then select Configure Parameters from the 
shortcut menu.  

The Parameter Configuration window opens. 

4. Click Select Device next to the Device Label field, select a device on the window that opens, 
and then click OK. 

The Device Label field is populated with the device label of the device. 

5. Use the automatically populated device label as the display name or enter the display name of 
the widget. 

6. Click OK. 
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7. Click the Save Configuration icon . 

Single interface monitor widget 

Figure 86 Single interface monitor widget icon 

 
 

The Single Interface Monitor widget displays real-time data collected from the specified interface. 
As shown in Figure 87, the Single Interface Monitor widget displays the receive rate, transmit rate, 
and traffic of the specified interface in dashboards and a line chart, and displays alarm numbers of 
the interface by alarm level in a line chart. Click the title in the upper left corner to enter the page 
showing the interface details. Click a legend name to display or hide the data for the corresponding 
index in the trend chart. 

Figure 87 Single interface monitor widget contents 

 
 

To configure the Single Interface Monitor widget: 

1. Navigate to the view configuration window: 

a. Point to the icon  located to the right of the search box on the menu bar. 

A list of predefined and user-defined favorites is displayed. 

b. Point to the Dashboard folder option. 

The popup list is displayed. 

c. Click the Configuration icon  in the popup list. 

The view configuration window opens. 

2. Drag the Single Interface Monitor widget from the widget area to the panel. 

3. Right-click the Single Interface Monitor widget, and then select Configure Parameters from 
the shortcut menu.  

The Parameter Configuration window opens. 

4. Click Select Device next to the Interface Description field, select an interface on the window 
that opens, and then click OK. 

The Device Label and Interface Description fields are populated with the device label of the 
device to which the interface belongs and the description of the interface, respectively. 
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5. Use the automatically populated device label as the display name or enter the display name of 
the widget. 

6. Click OK. 

7. Click the Save Configuration icon . 

Video play widget 

Figure 88 Video play widget icon 

 
 

The Video Play widget allows operators to play videos. The widget automatically loads the video 
files stored in the \client\web\apps\imc\bigscreen\videos directory of the IMC installation path. 
Only OGG and MP4 videos are supported.  

To configure the Video Play widget: 

1. Navigate to the view configuration window: 

a. Point to the My Favorites icon  located to the right of the search box on the menu bar. 

A list of predefined and user-defined favorites is displayed. 

b. Point to the Dashboard folder option. 

The popup list is displayed. 

c. Click the Configuration icon  in the popup list. 

The view configuration window opens. 

2. Drag the Video Play widget from the widget area to the panel. 

3. Right-click the Video Play widget, and then select Configure Parameters from the shortcut 
menu. 

The Configure Video Files window opens. 

4. Select the video files you want to play from the list. 

5. To play the selected videos in a continuous loop, select Repeat. Otherwise, the widget plays 
the videos in sequence and stops when the last video has played. 

6. To display the playback control area such as Pause and Stop icons, select Display Play 
Control Buttons. By default, the playback control area is not displayed when a video is 
playing. 

7. Click OK. 

8. Click the Save Configuration icon . 

Text label widget 

Figure 89 Text Label widget icon 

 
 

The Text Label widget allows operators to add text labels to the dashboard. 

To configure the Text Label widget: 

1. Navigate to the view configuration window: 

a. Point to the My Favorites icon  located to the right of the search box on the menu bar. 

A list of predefined and user-defined favorites is displayed. 

b. Point to the Dashboard folder option. 
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The popup list is displayed. 

c. Click the Configuration icon  in the popup list. 

The view configuration window opens. 

2. Drag the Text Label widget from the widget area to the panel. 

3. Right-click the Text Label widget, and then select Configure Parameters from the shortcut 
menu. 

The Text Label window opens. 

4. In the Label Content field, enter the content to be displayed. 

5. In the Font Size field, specify the font size of the text label. 

6. Click the Font Color icon  next to the Font Color field, and select a font color for the text 
label on the window that opens. 

7. Click OK. 

8. Click the Save Configuration icon . 

CPU utilization(%) – top5 widget 

Figure 90 CPU utilization(%) – top5 widget icon 

 
 

The CPU Utilization Top5 widget displays the top five instances with the highest CPU utilization for 
the last hour in a line chart. When you point to a time on a curve, a tip appears and displays the 
instance name, collection time, and collection data of the specified time. You can press and drag the 
pointer to select a time range on the x-axis to view the line chart for that time range. 

Figure 91 CPU utilization(%) – top5 widget contents 

 
 

To configure the CPU Utilization Top5 widget: 

1. Navigate to the view configuration window: 

a. Point to the My Favorites icon  located to the right of the search box on the menu bar. 

A list of predefined and user-defined favorites is displayed. 

b. Point to the Dashboard folder option. 

The popup list is displayed. 
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c. Click the Configuration icon  in the popup list. 

The view configuration window opens. 

2. Drag the CPU Utilization Top5 widget from the widget area to the panel. 

3. Click the Save Configuration icon . 

Custom view – top5 widget 

Figure 92 Custom view – top5 widget icon 

 
 

As shown in Figure 93, the Custom View Top5 widget contains the following charts: 

 Bar chart—Displays the top five custom views containing the highest-quantities of devices in 
the current system (the x-axis indicates the custom view name, and the y-axis indicates the 
device quantity). 

 Pie chart—Displays the total number of devices within the top five custom views by their alarm 
status.. 

Figure 93 Custom view – top5 widget contents 

 
 

To configure the Custom View Top5 widget: 

1. Navigate to the view configuration window: 

a. Point to the My Favorites icon  located to the right of the search box on the menu bar. 

A list of predefined and user-defined favorites is displayed. 

b. Point to the Dashboard folder option. 

The popup list is displayed. 

c. Click the Configuration icon  in the popup list. 

The view configuration window opens. 

2. Drag the Custom View Top5 widget from the widget area to the panel. 

3. Click the Save Configuration icon . 
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Alarm statistics widget 

Figure 94 Alarm statistics widget icon 

 
 

The Alarm Statistics widget displays the total alarm number for each alarm level in a card chart and 
a bar chart. Each card displays an alarm level and the total alarm number for the alarm level. 

Figure 95 Alarm statistics widget contents 

 
 

To configure the Alarm Statistics widget: 

1. Navigate to the view configuration window: 

a. Point to the My Favorites icon  located to the right of the search box on the menu bar. 

A list of predefined and user-defined favorites is displayed. 

b. Point to the Dashboard folder option. 

The popup list is displayed. 

c. Click the Configuration icon  in the popup list. 

The view configuration window opens. 

2. Drag the Alarm Statistics widget from the widget area to the panel. 

3. Click the Save Configuration icon . 

IP topology widget 

Figure 96 IP topology widget icon 

 
 

The IP Topology widget displays the specified IP topology. 
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Figure 97 IP Topology widget contents 

 
 

To configure the IP Topology widget: 

1. Navigate to the view configuration window: 

a. Point to the My Favorites icon  located to the right of the search box on the menu bar. 

A list of predefined and user-defined favorites is displayed. 

b. Point to the Dashboard folder option. 

The popup list is displayed. 

c. Click the Configuration icon in the popup list. 

The view configuration window opens. 

2. Drag the IP Topology widget from the widget area to the panel. 

3. Right-click the IP Topology widget, and then select Configure Parameters from the shortcut 
menu. 

The Configure Topology window opens. 

4. Select Background Transparent to configure the widget background color as transparent. 

If this options is not selected, the widget uses the background color of the selected topology. 

5. Select or clear Show Toolbar. By default, this option is cleared. 

6. Set the refresh interval for the IP topology. 

7. Select an IP topology from the IP Topology/Subnet list. 

8. Click OK. 

9. Click the Save Configuration icon . 

Device response time(ms) top5 widget 

Figure 98 Device response time(ms) – top5 widget icon 

 
 

The Device Response Time Top5 widget displays the top five devices with the longest response 
time for the last hour in a card chart. Each card displays a device label and the response time of the 
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respective monitor instance. Click the Line link to switch to the trend chart, which displays the 
response time trend and values for top five devices with the longest response time for the last hour.  

Figure 99 Device response time(ms) – top5 widget contents – card chart 

 
 

Figure 100 Device response time(ms) – top5 widget contents – trend chart 

 
 

To configure the Device Response Time Top5 widget: 

1. Navigate to the view configuration window: 

a. Point to the My Favorites icon  located to the right of the search box on the menu bar. 

A list of predefined and user-defined favorites is displayed. 

b. Point to the Dashboard folder option. 

The popup list is displayed. 

c. Click the Configuration icon  in the popup list. 

The view configuration window opens. 

2. Drag the Device Response Time Top5 widget from the widget area to the panel. 

3. Click the Save Configuration icon . 
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Custom topology widget 

Figure 101 Custom topology widget icon 

 
 

The Custom Topology widget displays the specified custom topology. 

Figure 102 Custom Topology widget contents 

 
 

To configure the Custom Topology widget: 

1. Navigate to the view configuration window: 

a. Point to the My Favorites icon  located to the right of the search box on the menu bar. 

A list of predefined and user-defined favorites is displayed. 

b. Point to the Dashboard folder option. 

The popup list is displayed. 

c. Click the Configuration icon  in the popup list. 

The view configuration window opens. 

2. Drag the Custom Topology widget from the widget area to the panel. 

3. Right-click the Custom Topology widget, and then select Configure Parameters from the 
shortcut menu. 

The Configure Topology window opens. 

4. Select Background Transparent to set the widget background color to be transparent. 

If this options is not selected, the widget uses the background color of the selected topology. 

5. Select or clear Show Toolbar. By default, this option is cleared. 

6. Set the refresh interval for the custom topology. 

7. Select a custom topology from the Custom Topology list. 

8. Click OK. 
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9. Click the Save Configuration icon . 

Converged topology widget 

Figure 103 Converged topology widget icon 

 
 

The Converged Topology widget displays the specified converged topology. 

Figure 104 Converged topology widget contents 

 
 

To configure the Converged Topology widget: 

1. Navigate to the view configuration window: 

a. Point to the My Favorites icon  located to the right of the search box on the menu bar. 

A list of predefined and user-defined favorites is displayed. 

b. Point to the Dashboard folder option. 

The popup list is displayed. 

c. Click the Configuration icon  in the popup list. 

The view configuration window opens. 

2. Drag the Converged Topology widget from the widget area to the panel. 

3. Right-click the Converged Topology widget, and then select Configure Parameters from the 
shortcut menu. 

The Configure Topology window opens. 

4. Select Background Transparent to set the widget background color to be transparent. 

If this options is not selected, the widget uses the background color of the selected topology. 

5. Select or clear Show Toolbar. By default, this option is cleared. 

6. Set the refresh interval for the converged topology. 

7. Select a converged topology from the Converged Topology list. 
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8. Click OK. 

9. Click the Save Configuration icon . 

Memory utilization(%)– top5 widget 

Figure 105 Memory utilization(%)– top5 widget icon 

 
 

The Memory Utilization Top5 widget displays the top five instances with the highest memory 
utilization for the last hour in a ring chart. Each ring displays a device label and the memory utilization 
of the respective monitor instance. Click the Line link to switch to the trend chart, which displays the 
memory utilization trend and values for top five instances with the highest memory utilization for the 
last hour. 

Figure 106 Memory utilization(%)– top5 widget contents – ring chart 

 
 

Figure 107 Memory utilization(%)– top5 widget contents – trend chart 
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To configure the Memory Utilization Top5 widget: 

1. Navigate to the view configuration window: 

a. Point to the My Favorites icon  located to the right of the search box on the menu bar. 

A list of predefined and user-defined favorites is displayed. 

b. Point to the Dashboard folder option. 

The popup list is displayed. 

c. Click the Configuration icon  in the popup list. 

The view configuration window opens. 

2. Drag the Memory Utilization Top5 widget from the widget area to the panel. 

3. Click the Save Configuration icon . 

Device state overview widget 

Figure 108 Device state overview widget icon 

 
 

The Device State Overview widget, as shown in Figure 109, contains the following charts: 

 Card chart—Displays device states in cards. Each card represents a device type and displays 
the total number of devices of the device type. You can click the Details link on each card to 
view the device list of the respective device type. The color of each card represents the overall 
state of devices of the device type. The overall state is determined by the highest severity level 
of devices of the device type. 

 Ring chart—Displays device states in a ring with color-coded legends. The ring displays the 
total number of devices. Each slice of the ring represents the percentage of a device state. Click 
a slice to view all devices in the respective device state. Each color-coded legend represents a 
device state and displays the total number of devices in the device state. 

Figure 109 Device state overview widget contents 

 
 

To configure the Device State Overview widget: 

1. Navigate to the view configuration window: 

a. Point to the My Favorites icon  located to the right of the search box on the menu bar. 
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A list of predefined and user-defined favorites is displayed. 

b. Point to the Dashboard folder option. 

The popup list is displayed. 

c. Click the Configuration icon  in the popup list. 

The view configuration window opens. 

2. Drag the Device State Overview widget from the widget area to the panel. 

3. Right-click the Device State Overview widget, and then select Configure Parameters from 
the shortcut menu. 

The Select Important Device window opens. 

4. Select a view from the Custom View list. Then, this widget displays the state overview for all 
devices in the view. By default, you can select All Devices or My Network View from the list. If 
you have added views on the Resource > Custom View page, these custom views are 
displayed on the list.  

5. Select Yes or No from the Display Device Type With Device Count 0 list.  

6. Click OK. 

7. Click the Save Configuration icon . 

User defined widget 

Figure 110 User defined widget icon 

 
 

The User Defined widget displays contents of the specified URL. 

To configure the User Defined widget: 

1. Navigate to the view configuration window: 

a. Point to the My Favorites icon  located to the right of the search box on the menu bar. 

A list of predefined and user-defined favorites is displayed. 

b. Point to the Dashboard folder option. 

The popup list is displayed. 

c. Click the Configuration icon  in the popup list. 

The view configuration window opens. 

2. Drag the User Defined widget from the widget area to the panel. 

3. Right-click the User Defined widget, and then select Configure Parameters from the shortcut 
menu. 

The User Defined window opens. 

4. In the Name field, enter the widget name. 

5. In the URL field, enter the URL to be accessed. 

6. Click OK. 

7. Click the Save Configuration icon . 
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Device view widget 

Figure 111 Device view widget icon 

 
 

The Device View widget displays the quantities of various devices in the current system (the x-axis 
indicates the device type, and the y-axis indicates the device quantity). Click a bar to access the 
device list of the respective device type to view device details. 

Figure 112 Device view widget contents 

 
 

To configure the Device View widget: 

1. Navigate to the view configuration window: 

a. Point to the My Favorites icon  located to the right of the search box on the menu bar. 

A list of predefined and user-defined favorites is displayed. 

b. Point to the Dashboard folder option. 

The popup list is displayed. 

c. Click the Configuration icon  in the popup list. 

The view configuration window opens. 

2. Drag the Device View widget from the widget area to the panel. 

3. Click the Save Configuration icon . 

Device unreachability(%) – top5 widget 

Figure 113 Device unreachability(%) – top5 widget icon 

 
 

The Device Unreachability Top5 widget displays the top five devices with the highest 
unreachability rate for the last hour in a ring chart. Each ring displays a device label and the 
unreachability rate of the respective monitor instance. Click the Line link to switch to the trend chart, 
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which displays the device unreachability rate trend and values for top five devices with the highest 
unreachability rate for the last hour. 

Figure 114 Device unreachability(%) – top5 widget contents  

 
 

To configure the Device Unreachability Top5 widget: 

1. Navigate to the view configuration window: 

a. Point to the My Favorites icon  located to the right of the search box on the menu bar. 

A list of predefined and user-defined favorites is displayed. 

b. Point to the Dashboard folder option. 

The popup list is displayed. 

c. Click the Configuration icon  in the popup list. 

The view configuration window opens. 

2. Drag the Device Unreachability Top5 widget from the widget area to the panel. 

3. Click the Save Configuration icon . 

Wizard Center 
IMC provides a Wizard Center to configure common functions and third-party devices. You can enter 
the pages for configuring common functions through Quick Start, and enter the pages for 
configuring third-party devices through Third-Party Support. 

Quick Start 
To enter the pages for configuring different functions through Quick Start: 

1. Point to the icon  located to the right of the search box on the menu bar. 

A list of predefined and user-defined favorites is displayed. 

2. Point to the Wizard Center folder option.  

3. Click Quick Start in the popup list to the right.  

The Quick Start window, containing five pages, is displayed. You can click a page number to 
enter the target page. The following functions are available on the pages:  

Device access settings 
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 SNMP settings 

 Telnet settings 

 SSH settings 

Default performance monitor indexes 

 Configure default performance monitor indexes 

 Configure performance monitor option 

Add device 

 Auto discover device 

 Manually add device 

View and topology 

 Add user-defined view and topology 

 Arrange topology elements and recover links 

 Add interface view 

Configuration backup 

 Add auto backup plan 

 Modify backup policy option 

Custom home page 

 Add new space and select interested widgets 

4. To enter the next page, click . 

5. To return to the previous page, click . 

6. To enter the page for configuring a function, click the function name link. 

7. To switch to the Support third-party device window, point to the  link, and then select 
Support third-party device. 

Support third-party device 
To enter the third-party device configuration page: 

1. Point to the icon  located to the right of the search box on the menu bar. 

A list of predefined and user-defined favorites is displayed. 

2. Point to the Wizard Center folder option.  

3. Click Support third-party device in the popup list to the right.  

The Support third-party device window, containing five pages, is displayed. You can click the 
page number to enter the target page. The following functions are available on the pages: 

 Register third-party device information 

 Add device vendor 

 Add device series 

 Add device model 

 Advanced alarm settings 

 Add trap events 

 Import user-defined trap events from a MIB file 

 Escalate trap event to alarm 

 Advanced performance settings 

 Add performance index 
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 Display performance indexes in topology 

 Configuration management 

 Add telnet script 

 Compliance policy check 

 Add compliance policy 

 Add check task 

 Customize device panel 

 Import third-part panels from device panel project files 

4. To enter the next page, click . 

5. To return to the previous page, click . 

6. To enter the page for configuring a function, click the function name link. 

7. To switch to the Quick Start window, point to the  link, and then select Quick Start. 

Task Management 
Task Management helps you easily view the status and execution results of tasks, and restore and 
suspend tasks. With the message delivery function, you can obtain task execution results and query 
message history.  

Task Management supports ACL, iCC, General Config, Compliance, and VLAN. 

Accessing Task Management 
After you create the tasks for the components supported by Task Management, the tasks are 
displayed on the Task Management page. You can view the current status and execution result of 
each task, and restore or suspend specific tasks. 

Task Management displays only the following tasks: 

 All periodical tasks. 

 Tasks that start in 24 hours and have been executed. 

 Tasks that start after 24 hours and have not been executed. 

To access task management: 

1. Point to the My Favorites icon  located to the right of the search box on the menu bar. 

A list of predefined and user defined favorites is displayed. 

2. Point to the Task Management folder option. 

The popup list is displayed. 

3. Click the Task Management icon  in the popup list. 

The task management window opens. 

The window displays two properties by default. 

4. Click the Expand icon  in the upper right corner to expand the window and display more 
properties. 

5. Click the Next icon  at the top of the window to display the next component. 

6. Click the component name at the top of the window to enter the component task list. 

 Task Name—Displays the task name and creation time. Before a task name: 
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 —The task is executed successfully.  

 —The task failed to be executed.  

 —The task is waiting to be executed or is being executed. 

 Status—Refers to the current task status, which can be: 

 Finished—Task has been executed.  

 Waiting for Execution—Task is waiting to be executed.  

 Suspend—Task is suspended. 

 Execution Time—Displays the previous execution time. 

 Next Execution—Displays the next execution time. 

 Operation—Provides operations related to the task. 

7. If a task is waiting to be executed,  is displayed in the Operation column. Click  to 
suspend the task. 

8. If a task is suspended,  is displayed in the Operation column. Click  to restore the task. 

9. If a task has been executed, nothing is displayed in the Operation column. 

10. If the task list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Task List. 

 Click  to page forward to the end of the Task List. 

 Click  to page backward in the Task List. 

 Click  to page backward to the front of the Task List. 

11. Enter part of a task name or a complete task name, and click Query to display matching tasks 
of the component on the task list. 

12. Select a refresh interval, No Refresh, 1, 5, or 10, from the Refresh Interval (minutes) list. IMC 
then refreshes task status of all components at the specified interval. 

Message history 
After you enable the message delivery function, Task Management sends task execution result 
messages to the administrator, and logs the event. View the message history through the Message 
History function.  

To access message history: 

1. Point to the icon My favorites icon  located to the right of the search box on the menu bar. 

A list of predefined and user defined favorites are displayed. 

2. Point to the Task Management folder option. 

The popup list is displayed. 

3. Click the Message History icon  in the popup list. 

The History Messages window opens. 

 Time—Displays the task execution time. 

 Message Type—Displays the task type, which can be iCC, ACL, VLAN, Generic Config, 
or Compliance. 

 Message—Indicate the summary information of the message.  

If the message history list spans multiple pages, use the following aids to navigate the list: 
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 Click  to page forward in the message history list  

 Click to page forward to the end of the message history list . 

 Click  to page backward in the message history list  

 Click  to page backward to the front of the message history list . 

4. Select a message type from the Message Type list, and click Query. 

All matching entries are displayed. 

Message options 

1. Point to the My favorites icon  located to the right of the search box on the menu bar. 

A list of predefined and user defined favorites are displayed. 

2. Point to the Task Management folder option. 

The popup list is displayed. 

3. Click the Message Options icon  in the popup list to the right. 

The Push Settings window opens. 

4. Select Enable or Disable from the Enable Push list. 

 If you select Enable, Task Management sends task execution result messages to the 
administrator. 

 If you select Manual Close from the Message Display list, you must manually close the 
message delivery window upon receiving a message.  

 If you select Auto Close in 10 Seconds, the message delivery window automatically 
closes in 10 seconds. This option takes effect when you enable the message delivery 
function. 

5. Click OK. 

Switching between perspectives 
IMC reorganizes the common functions of services in the default IMC perspective and displays them 
in new perspectives. 

To switching between perspectives: 

1. Access the IMC home page. 

2. In the upper right corner of the page, click the Expand icon  next to Default Perspective, 
and then select a perspective from the shortcut menu. 

The IMC platform provides the following perspectives: 

 Default Perspective—Unless otherwise stated, this guide uses the default perspective. 

 Quick Service Process—The quick service process view reorganizes the common 
functions of the specific services and displays them in service flows. For more information 
about the quick service process view, see "Quick Service Process View."  

 Desktop View—The desktop view displays IMC services and functions as applications on 
Web desktops. For more information about the desktop view, see "Web desktop 
management." 

 

 NOTE: 

To access the perspectives of IMC components, first deploy the respective IMC components. 
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The perspective pages of all IMC components have the same page layout. Each page includes 
a navigation tree, a main pane, and a quick operation panel. The quick operation panel includes 
the following areas and icons: 

 Alarm status bar area— Allows you to view alarm statistics by alarm level and total alarms. 
Click the icon for an alarm level to view alarms of the alarm level. You can also click the 

Sound icon  to set alarms sounds. For more information about setting alarm sounds, 
see "Alarm sound settings." 

 Global search area—Global search includes basic query and advanced query. It allows 
you to query devices, interfaces, users, data, help, and navigation information that match 
the query criteria. For more information about the global search, see "Global search." 

 Switch Perspective icon —Allows you to switch to another perspective. Click the icon 
and select a perspective from the menu that appears. 

 Admin icon —Displays the current operator. Click the icon  next to the icon and the 
shortcut menu displays the following options: 

 About icon —Allows you to view version and license information about various IMC 
components. 

 Help icon —Allows you to open the online help. For more information about the 
online help, see "Online help system." 

 Logout icon —Allows you to log out of the perspective. 
 

Quick Service Process View 
The quick service process view reorganizes the common functions of the default IMC perspective 
and displays them in a new view, as shown in Figure 115. Unless otherwise stated, this guide uses 
the default perspective. 

To view the quick service process view: 

1. Access the IMC home page. 

2. In the upper right corner of the page, click the Expand icon  next to Default Perspective, 
and then select Quick Service Process from the shortcut menu. 

The quick service process page opens. The page includes a quick operation panel, a 
navigation tree area, and a main pane. 

The quick operation panel includes the product name, logo, and the following icons: 

 Admin icon —Displays the current operator. Point to the icon to view the login 
information about the operator. 

 Help icon —Allows you to open the online help. For more information about the online 
help, see "Online help system." 

 About icon —Allows you to view version and license information about various IMC 
components. 

 Logout icon —Allows you to log out of the quick service process view. 

The navigation tree area includes the following: 

 Select Template Category—Allows you to select a service template from the Select 
Template Category list. 

 Navigation Tree—Displays the structure and contents of the current service template. The 
root node menu represents the service template category. Each level-2 node menu 
represents a service that the template provides. Each level-3 node menu represents a 
function that a service might use. 
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The main pane includes all services of the current service template, and the service processes 
or functions involved in the configuration procedures of each service. To access the 
configuration page of a service, click Start for a service. The service configuration page guides 
you through functions involved in the configure procedures of a service. The usage method of 
each function is the same as the usage method of the function in the default perspective. To 

switch between function pages, click the Previous icon  or the Next icon  in the 
upper right corner of the page. To close the service configuration page, click the Close icon  
in the upper left corner of the page. 

Figure 115 Quick service process view 

 
 

Web desktop management 
This function displays IMC services and functions as applications on Web desktops. It allows you to 
add applications and customize the Web desktops to meet different requirements of service 
management or solutions. 

Entering the Web desktop 
You can enter the desktop edition of IMC either by logging in to the Web desktop directly or by 
switching to the desktop edition of IMC after you log in to the classic edition of IMC. 

Logging in to the Web desktop 

1. Enter the URL for the IMC server in your browser, including the port number for IMC.  

 http://servername:portnumber/imc 

 https://servername:portnumber/imc 

Where server name is the name of the IMC server and port number is the TCP port assigned 
to IMC during installation. 

Alternatively, the IP address of the server can be used instead of the server name. 

2. Enter the user ID assigned to you in the Operator field.  

3. Enter your password in the Password field. 

4. Select the Desktop login mode. 
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5. Click Login or press Enter. 

Switching from the classic edition of IMC to the desktop edition of IMC 

1. Log in to the classic edition of IMC. 

2. Click Desktop in the upper right corner of the page. 

3. To switch to the classic edition of IMC, do one of the following: 

 Click the Start icon  on the left of the Web desktop, and then select Classic from the 
menu that appears. 

 Right-click the blank area of Web desktop, and then select Classic from the menu that 
appears. 

Viewing the Web desktop 

Web desktop layout 

As shown in Figure 116, the Web desktop includes the following parts: 

 Application area—Supports multiple desktops. You can add applications to different desktops 
as needed. You can arrange applications in random order. 

 Global application launcher—Click the Start icon  to view information about the Web 
desktop and personalizing the Web desktop. The global application launcher is located next to 

the Start icon . You can add application icons to, or delete application icons from, the global 
application launcher. The global application launcher does not move when you switch between 
desktops. 

Figure 116 Web desktop 

 
 

Switching between desktops 

1. Access the Web desktop.  

2. Do one of the following: 

 Hold the mouse and move the cursor to left or right on the current desktop to switch to 
another desktop.  

 Click  on the top toolbar to switch to another desktop. 
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 indicates that the current desktop is used. When the last desktop is filled with applications 
icons, you are prompted to add a new desktop if you continue to add applications. Click OK to 
add a new desktop. 

Web desktop menus 

Start menu 

1. Access the Web desktop.  

2. Click the Start icon  on the left of the Web desktop, and then select one of the following 
options: 

 Login Name—Allows you to view information about the user that uses the current 
username. 

 Classic—Allows you to switch to the classic edition of IMC. 

 Personalization—Allows you to set the Web desktop background and theme. 

 Help—Allows you to open the online help. 

 About—Allows you to view version and license information about various IMC components. 

 Logout—Allows you to log out of the Web desktop. 

Right-click context menu 

1. Access the Web desktop. 

2. Right-click the blank area of Web desktop, and then select one of the following options: 

 Classic—Allows you to switch to the classic edition of IMC. 

 Personalization—Allows you to set the Web desktop background and theme. 

 Help—Allows you to open the online help. 

 Auto Arrange Icon—Allows you to drag applications freely on the desktop. This option is 
available only after you select the Cancel Arrange Icon option. 

 Cancel Arrange Icon—Allows you to drag an application over another to make them switch 
places. This option is available only after you select the Auto Arrange Icon option. 

Global application launcher 

1. Access the Web desktop.  

2. To add an application to the Global application launcher, drag the application to the gray area 
above the Start icon . 

3. To remove an application from the Global application launcher, drag the application to the 
desktop. 

If an application has existed on the desktop, you cannot drag the application to the desktop. 

4. To delete an application from the Global application launcher, right-click the application, and 
then select Delete from the shortcut menu. 

Viewing user login data on the Web desktop 
1. Access the Web desktop.  

2. Click the Start icon  on the left of the Web desktop, and then select the current login user 
from the menu that appears. 

The User Login Information page opens and displays the following information for the current 
login user: 

 Operator—User name used by the operator to log in. 

 Login Time—Time when the operator logged in. 

 IP Address—IP address of the host used by the operator to log in. 

 Browser—Browser used by the operator to log in. 
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 Browser Version—Version of the browser used by the operator to log in. 

Personalizing the Web desktop 

Personalizing the Web desktop background 

1. Access the Web desktop.  

2. Click the Start icon  on the left of the Web desktop, and then select Personalization from 
the shortcut menu. 

3. In the Background tab, select a background picture, and then click Set background. 

Personalizing the Web desktop theme 

1. Access the Web desktop.  

2. Click the Start icon  on the left of the Web desktop, and then select Personalization from 
the shortcut menu. 

3. In the Theme tab, select a theme, and then click Set theme. 

Managing applications 
IMC Web desktop displays IMC services and functions as applications on the Web desktop. After 
adding applications to a desktop, the applications can be used directly. 

The IMC Web desktop integrates the following application categories: 

 Resource—Integrates the resource management function for devices, topologies, views, port 
groups, and so on. For more information, see "Resource management." 

 Performance—Integrates the performance management function for indexes, performance 
views, service monitoring, monitoring settings, and so on. For more information, see 
"Performance management." 

 User—Integrates the user management function, including adding uses, viewing user 
information, managing users, and so on. For more information, see "User and guest access 
management." 

 Configuration Center—Integrates the device configuration management function, including 
backing up and deploying startup and running configuration files, deploying and restoring 
software, and so on. For more information, see "Configuration and change management." 

 Compliance Center—Integrates the compliance policy management function, including 
configuring compliance check tasks, and so on. For more information, see "Using compliance 
check." 

 Alarm—Integrates the alarm and trap management function, including viewing alarms and 
traps, analyzing alarms, and configuring alarm and trap settings. For more information, see 
"Event and alarm management." 

 System—Integrates the system management function, including configuring parameter 
templates, managing device information, and so on. For more information, see "Configuring 
IMC for use." 

 GAM—Integrates the guest access management function, including managing guest access 
users, and guest access operators. For more information, see "User and guest access 
management." 

 SCC—Integrates the security control management function, including managing security 
policies, monitoring real-time threats, configuring alarm settings, and so on. For more 
information, see "Security control center." 

 Syslog—Integrates the Syslog management function, including viewing Syslogs, configuring 
filtering policies and rules, updating alarm rules, and so on. For more information, see 
"Managing Syslog." 
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Adding an application to the Web Desktop 

1. Access the Web desktop. 

2. Click the Add Application icon . 

The Add Application window opens.  

3. Do one of the following: 

 Select a category from the Group Name list.  

All applications that belong to the category are displayed in the Add Application window. 

 Enter a complete or partial name in the application name field, and then click Query.  

All matched applications are displayed in the Add Application window. Point to an 
application to view its description. 

If the application list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the application list. 

 Click  to page forward to the end of the application list. 

 Click  to page backward in the application list. 

 Click  to page backward to the front of the application list. 

4. Click Add Application for the application you want to add to the Web desktop. 

The same application can be added to different desktops. Existing is displayed for an 
application that already exists on the current desktop and cannot be added to the current 
desktop. 

Registering an application 

When you add applications to the Web desktop, you can select predefined applications or 
applications that are registered by yourself. 

To register an application: 

1. Access the Web desktop. 

2. Click the Add Application icon . 

The Add Application window opens.  

3. Click Register App. 

The window for registering an application opens. 

4. Configure the following parameters: 

 Application Name—Enter an application name. 

 url—Enter a URL through which the application can be accessed by double-clicking the 
application. 

 Description—Enter an application description. This field is optional. 

 Icon—Select an application icon. The icon to be uploaded must be in the PNG format, and 
the recommended icon size is 48 × 48 pixels. 

 Share to All Users—Select this option to allow other operations to view the application. By 
default, this option is cleared, which indicates all other operators have no access to the 
application. 

5. Click OK. 

The new application is displayed on the Add Application window and belongs to the Custom 
group. To delete the application from the Add Application window, click Delete for the 
application. 
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Opening an application 

1. Access the Web desktop.  

2. Double-click an application icon, or right-click the application icon and select Open. 

You can have multiple applications open without one affecting the other. 

3. To minimize a window, click Minimize icon . Click the window name at the lower left of the 
desktop to restore the window. 

4. To maximize a window, click Maximize icon . Click the Restore icon  to restore the 
window. 

5. To close a window, click the Close icon . 

Moving an application between desktops 

Make sure the target desktop does not have the application you want to move. 

1. Access the Web desktop. 

2. Do one of the following: 

 Select an application and drag the application to  at the top of the desktop to switch 
between desktops, and then release the application. 

 Select an application and drag the application to left or right on the Web desktop to switch 
between desktops, and then release the application. 

Modifying an application name 

1. Access the Web desktop.  

2. Right-click an application icon and select Modify App Name from the shortcut menu. 

The Modify App Name window opens. 

3. Enter a new application name. 

4. Click OK. 

Deleting an application from a desktop 

Deleting an application from a desktop does not delete the application from other desktops and the 
system. 

1. Access the Web desktop.  

2. Right-click an application icon and select Delete. 

Logging out of the Web desktop 

1. Click the Start icon  on the left of the Web desktop, and then select Logout from the menu 
that appears. 

2. Click OK when prompted to confirm logout. 
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Configuring IMC for use 
Effective implementation and maintenance of IMC depends on pre-discovery planning and 
configuration. The following information describes the functional areas of IMC that are most 
effectively used when configured and implemented prior to populating IMC with users, devices, and 
resources. In addition, the information includes basic IMC system-wide configuration and 
maintenance functions. 

Securing IMC and access to managed resources 
IMC offers you powerful control over network resources including network devices, network users, 
and services. Securing IMC is at the top of the list of priorities for configuring IMC for use. The 
following information describes the security options available in IMC that secure its use, the access 
and control over resources it offers you, and the data IMC uses to manage resources.  

 Operator groups—Operator groups enable you to assign or remove IMC management 
privileges by group. You can also create custom groups to further extend administrative control 
over access to IMC and the network resources managed by it. For configuring operator groups, 
see "Managing operator groups." 

 Operator roles—Assign various levels of rights to individual operator accounts, with the ability 
to restrict access by views and groups. For configuring operator accounts, see "Managing IMC 
operators." 

 Login control templates—Permit or deny operator access to IMC by IP address. For 
configuring login control templates, see "Securing IMC through operator login control 
templates." 

 Integration with authentication services—IMC supports secure access to IMC through 
integration with RADIUS and LDAP for operator authentication to IMC. For more information, 
see "Securing IMC access through authentication services." 

 Password strategy—IMC enables you to define system-wide password requirements for all 
operators that have access to IMC. For configuring password strategies, see "Establishing IMC 
password strategies." 

 Online operators—View current IMC access and activity through the Online Operators 
feature. Through this feature, you can log operators off, as well as block access to IMC in real 
time. For more information about this feature, see "Managing online IMC operator access." 

 SNMP configuration—For secure communications between IMC and managed devices, IMC 
supports SNMPv1, v2c, and various forms of v3. In addition, IMC also supports global SNMP 
community string management for all managed devices once devices are configured to be 
managed by IMC. For configuring SNMP through templates, see "SNMP templates." 

 Telnet and SSH device access—IMC also supports remote device access through Telnet and 
SSH, with the ability to use templates to configure Telnet and SSH settings. For configuring 
Telnet and SSH templates, see "Device access templates." 

Resource management: managing network 
resources with global settings 

IMC incorporates many services and features that enable you to easily and effectively manage 
global network resources.  

Resource Management covers the configuration of templates and device vendor, series and model 
definitions that support you in easily managing access to network devices.  
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In addition, Resource Management also includes the configuration of filters, which are used by port 
groups to filter interfaces. 

Device access templates 
Device access templates enable you to save SNMP, Telnet, SSH, NETCONF, SOAP/HTTP, 
PowerShell, and WMI configuration settings that IMC uses to access network devices. You can apply 
these templates when adding devices to IMC, performing auto discovery to populate IMC with newly 
discovered devices, or to configure device parameters by individual device or batch mode. 

SNMP templates 

IMC uses SNMP to query and manage remote network devices. The SNMP template feature allows 
you to save SNMP configuration settings in IMC, which can then be applied when adding new 
devices to IMC. SNMP templates store IMC SNMP configurations for devices to support IMC 
communication with the device. SNMP Templates do not configure the SNMP settings on the device 
itself. 

This feature is particularly useful for organizations that use a variety of SNMP configurations, such 
as different SNMP configurations based on device type, geographical location, or organizational 
support models. 

Viewing the SNMP template list 

1. Navigate to System > Access Parameter Template. 

a. Click the System tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Access Parameter Template under Resource Management on the left navigation 
tree. 

The Access Parameter Template window opens. 

2. Click the SNMP tab. 

IMC displays all SNMP templates in the SNMP Template List. 

SNMP template list contents 

 Name—Contains the SNMP template name. 

 Parameter type—Identifies which version of SNMP for which this template is configured. 

 Timeout (seconds)—Contains the SNMP timeout value for the associated template. The 
Timeout counter determines how long IMC waits for an SNMP reply from the managed 
device before declaring that the request has timed out. 

 Retries—Contains the SNMP retries value for the associated template. The retries 
parameter defines how many times the management system (IMC) sends SNMP retries in 
an attempt to communicate with the managed device before reporting a failure. 

 Modify—Contains an icon for navigating to the Modify SNMP Template page for the 
associated template. 

 Delete—Contains an icon for deleting the associated template. 

Adding an SNMPv1 or v2c template 

1. Access the SNMP template list page. 

2. Click Add. 

3. Enter a unique name for the SNMP template name in the Name field. 

You cannot modify the name of a template once the template has been created. To modify the 
name, you must first delete the template and then recreate it with the new name. 

4. Select the version of SNMP that is configured for use on the managed devices from the 
Parameter Type list.  

5. Select SNMPv1 or SNMPv2c. 
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6. Enter the Read-Only community string that is configured on the managed devices in the 
Read-Only Community String field.  

The default is public. 

7. Enter the Read-Write community string configured on the managed devices in the Read-Write 
Community String field.  

The default is private. 

SNMP configuration settings for each managed device must match the SNMP settings 
configured on it. For information about configuring SNMP settings on the managed devices, see 
the vendor documentation. 

8. Enter the SNMP timeout value (1–60 seconds) in the Timeout field.  

This parameter determines how long IMC waits for an SNMP reply from the managed device 
before declaring that the request has timed out. 

9. Enter the number of SNMP retries (1–20) in the Retries field. 

The retries parameter defines how many times the management system (IMC) sends SNMP 
retries in an attempt to communicate with the managed device before reporting a failure. The 
default is 3. 

10. Click OK. 

Adding an SNMPv3 template 

1. Access the SNMP template list page. 

2. Click Add. 

3. Enter a unique name for the SNMP template name in the Name field. 

4. Select the SNMPv3 type that matches the version of SNMP configured on the devices to be 
managed by this template from the Parameter Type list, as shown in Table 13. 

Table 13 SNMP parameters 

Parameter type option Description 

SNMPv1 SNMP version 1 

SNMPv2c SNMP version v2c 

SNMPv3 No-Priv No_Auth SNMPv3 with no authentication and no encryption 

SNMPv3 No-Priv Auth-Md5 SNMPv3 with no encryption and with MD5 authentication 

SNMPv3 No-Priv Auth-Sha SNMPv3 with no encryption and with SHA authentication 

SNMPv3 Priv-Des Auth-Md5 SNMPv3 with DES encryption and MD5 authentication 

SNMPv3 Priv-Des Auth-Sha SNMPv3 with DES encryption and SHA authentication 

SNMPv3 Priv-Aes128 Auth-Md5 SNMPv3 with AES 128 bit encryption and MD5 authentication 

SNMPv3 Priv-Aes128 Auth-Sha SNMPv3 with AES 128 bit encryption and SHA authentication 

SNMPv3 Priv-Aes192 Auth-Md5 SNMPv3 with AES 192 bit encryption and MD5 authentication 

SNMPv3 Priv-Aes192 Auth-Sha SNMPv3 with AES 192 bit encryption and SHA authentication 

SNMPv3 Priv-Aes256 Auth-Md5 SNMPv3 with AES 256 bit encryption and MD5 authentication 

SNMPv3 Priv-Aes256 Auth-Sha SNMPv3 with AES 256 bit encryption and SHA authentication 
 

5. Enter the username that is configured on the managed devices in the Username field. 

6. If prompted, enter the authentication password that is configured on the managed devices in 
the Authentication Password field. 

7. If prompted, enter the encryption password that is configured on the managed devices in the 
Encryption Password field. 
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8. Enter the SNMP timeout value in the Timeout field.  

Valid range is 1–60 seconds. The timeout parameter defines how long the system waits for the 
device to respond to an SNMP request before reporting that the request has timed out. 

9. Enter the SNMP retries value in the Retries field.  

Valid range is 1–20. The retries parameter defines how many times the management system 
(IMC) sends SNMP retries in an attempt to communicate with the managed device before 
reporting a failure. The default is 3. 

10. Click OK. 

The SNMP templates you have created now are displayed as configuration options when adding 
devices to IMC by auto discovery, by batch mode, or by adding devices individually. For more 
information, see "Adding devices in IMC." 

Modifying an SNMP template 

1. Access the SNMP template list page. 

2. Click the Modify icon  for the SNMP template you want to modify. 

3. Modify any of the configuration information displayed in the Modify SNMP Template page.  

For more information about template parameters, see "Adding an SNMPv1 or v2c template" or 
"Adding an SNMPv3 template." 

4. Click OK. 

Deleting an SNMP template 

1. Access the SNMP template list page. 

2. Click the Delete icon  for the SNMP template you want to delete. 

3. Click OK to confirm deletion of the selected SNMP template. 

Telnet templates 

IMC uses Telnet to provide you with remote access to managed devices. IMC also uses Telnet for 
certain network resource management functions. 

The Telnet template feature allows you to save Telnet configuration settings in IMC, which can then 
be applied when adding new devices to IMC, performing an auto discovery, or configuring devices in 
individual or batch mode. Telnet templates store IMC Telnet configurations for devices to support 
IMC communication with the device. Telnet templates do not configure the Telnet settings on the 
device itself. 

Viewing the Telnet template list 

1. Navigate to System > Access Parameter Template. 

a. Click the System tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Access Parameter Template under Resource Management on the left navigation 
tree. 

The Access Parameter Template window opens. 

2. Click the Telnet tab. 

IMC displays all Telnet templates in the Telnet Template List. 

Telnet template list contents 

 Name—Contains the Telnet template name. 

 Authentication Mode—Identifies the authentication for which this template is configured. 

 Timeout (seconds)—Contains the Telnet timeout value for the associated template. The 
Timeout counter defines how long the system waits for the device to respond in seconds. 

 Modify—Contains an icon for navigating to the Modify Telnet Template page for the 
associated template. 
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 Delete—Contains an icon for deleting the associated template. 

Adding a Telnet template 

1. Access the Telnet template list page. 

2. Click Add. 

3. Enter a unique name for the Telnet template in the Name field. 

You cannot modify the name of a template once the template has been created. To modify the 
name, you must first delete the template and then recreate it with a new name. 

4. Select the mode to match the telnet authentication mode configured on the managed devices 
from the Authentication Mode list.  

Options include:  

 Password 

 Username + Password 

 Super Password 

 Password + Super Password 

 Username + Password + Super Password 

 No Username + No Password 

 Username + No Password 

5. If prompted, enter the username that is configured on managed devices in the Username field. 

6. If prompted, enter the password that is configured on the managed devices in the Password 
field. 

7. If prompted, enter the super password that is configured on the managed devices in the Super 
Password field. 

8. Enter the Telnet timeout value in the Timeout field.  

Valid range is 1–60 seconds. The timeout parameter defines how long the system waits for the 
device to respond in seconds. 

9. Click OK. 

The Telnet configuration settings in IMC must match the Telnet settings configured on the managed 
devices. For information about configuring Telnet settings on the managed devices, see the vendor's 
documentation. The Telnet templates also are displayed as configuration options when adding 
devices to IMC by auto discovery, by batch mode or by adding devices individually. For more 
information, see "Adding devices in IMC." 

Modifying a Telnet template 

1. Access the Telnet template list page. 

2. Click the Modify icon  for the Telnet template you want to modify. 

3. Modify the authentication mode setting to match the Telnet authentication mode configured on 
the managed devices.  

Options include:  

 Password 

 Username + Password 

 Super Password 

 Password + Super Password 

 Username + Password + Super Password 

 No Username + No Password 

 Username + No Password 

4. Modify the username to match the username configured on managed devices, if prompted. 

5. Modify the password to match the password configured on the managed devices, if prompted. 
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6. Enter the super password to match the super password configured on the managed devices, if 
prompted. 

7. Modify the Telnet Timeout value.  

Valid range is 1–60 seconds. The timeout parameter defines how long the system waits for the 
device to respond in seconds. 

8. Click OK. 

Deleting a Telnet template 

1. Access the Telnet template list page. 

2. Click the Delete icon  for the Telnet template you want to delete. 

3. Click OK to confirm deletion of the selected Telnet template. 

SSH templates 

IMC uses SSH to enable secure remote access to managed devices. IMC also uses SSH for certain 
network resource management functions. 

The SSH template feature allows you to save SSH configuration settings in IMC, which can then be 
applied when adding new devices to IMC, performing an auto discovery, or configuring devices in 
individual or batch mode. SSH templates store IMC SSH configurations for devices to support IMC 
communication with the device. SSH templates do not configure the SSH settings on the device 
itself. 

Viewing the SSH template list 

1. Navigate to System > Access Parameter Template. 

a. Click the System tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Access Parameter Template under Resource Management on the left navigation 
tree. 

The Access Parameter Template window opens. 

2. Click the SSH tab. 

IMC displays all SSH templates in the SSH Template List. 

SSH template list contents 

 Name—Contains the SSH template name. 

 Authentication Mode—Identifies the form of authentication for which this template is 
configured. 

 User Name—Contains the user name. 

 Timeout (seconds)—Contains the SSH timeout value for the associated template. The 
Timeout counter defines how long the system waits for the device to respond in seconds. 

 Retries—Contains the SSH retries value for the associated template. The retries parameter 
defines how many times the management system (IMC) sends retries in an attempt to 
communicate with the managed device before reporting a failure. 

 Modify—Contains an icon for navigating to the Modify SSH Template page for the 
associated template. 

 Delete—Contains an icon for deleting the associated template. 

Adding an SSH template 

1. Access the SSH template list page. 

2. Click Add. 

3. Enter a unique name for the SSH template name in the Name field. 

You cannot modify the name of a template once the template has been created. To modify the 
name, you must first delete the template and then recreate it with a new name. 
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4. Select the mode that matches the SSH configuration mode configured on the managed devices 
from the Authentication Mode list.  

Authentication mode options include:  

 Password 

 Private Key 

 Password + Private Key 

 Password+Super Password 

 Private Key+Super Password 

 Password+Private Key+Super Password 

5. Enter the username that is configured on managed devices in the User Name field. 

6. Enter the password that is configured on the managed devices in the Password field. 

If prompted, enter the path and filename of the private key file that contains the key that enables 
login in the Private Key File field.  

If prompted, enter the private key password for the private key file in the Private Key 
Password field.  

If prompted, enter the super password that is configured on the managed devices in the Super 
Password field. 

7. Enter the TCP port for SSH configured on managed devices in the Port field.  

The default TCP port is 22. 

8. Enter the SSH timeout value in the Timeout field.  

Valid range is 1–120 seconds. The timeout parameter defines how long the system waits for the 
device to respond in seconds before declaring that the response has timed out. The default 
setting is 10 seconds. 

9. Enter the number of SSH retries in the Retries field.  

Valid range is 1–5. The retries parameter defines how many times the management system 
(IMC) sends SSH retries in an attempt to communicate with the managed device before 
reporting a failure. The default setting is 3. 

10. Click OK. 

The SSH templates you have added now are displayed as options when configuring devices 
individually or in batch mode. 

The SSH configuration settings in IMC must match the SSH settings configured on the managed 
devices. For information about configuring SSH settings on the managed devices, see the vendor's 
documentation. The SSH templates also are displayed as configuration options when adding 
devices to IMC by auto discovery, by batch mode or by adding devices individually. For more 
information, see "Adding devices in IMC." 

Modifying an SSH template 

1. Access the SSH template list page. 

2. Click the Modify icon  for the SSH template you want to modify. 

3. Select the authentication mode to match the SSH configuration on the managed devices from 
the Authentication Mode list.  

Authentication mode options include Password, Password + Private Key, and Private Key. 

4. Modify the username to match the username that is configured on managed devices in the 
User Name field. 

5. Modify the password to match the password that is configured on the managed devices in the 
Password field. 

If prompted, modify the path and filename of the private key file that contains the key that 
enables login in the Private Key File field.  
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If prompted, modify the private key password for the private key file as needed in the Private 
Key Password field.  

If prompted, enter the super password that is configured on the managed devices in the Super 
Password field. 

6. Modify the TCP port for SSH to match what is configured on managed devices in the Port field. 
The default TCP port is 22. 

7. Modify the SSH timeout value as needed in the Timeout field.  

Valid range is 1–120 seconds. The timeout parameter defines how long the system waits for the 
device to respond in seconds before declaring that the response has timed out. The default 
setting is 10 seconds. 

8. Modify the number of SSH retries as needed in the Retries field.  

Valid range is 1–5. The retries parameter defines how many times the management system 
(IMC) resends SSH retries in an attempt to communicate with the managed device before 
reporting a failure. The default setting is 3. 

9. Click OK. 

Deleting an SSH template 

1. Access the SSH template list page. 

2. Click the Delete icon  in the SSH Template List associated with the SSH template you 
want to delete. 

3. Click OK to confirm deletion of the selected SSH template. 

NETCONF template 

IMC can use the NETCONF protocol to access, configure, and manage network devices such as 
firewall devices and load balancers. 

The NETCONF Template function enables you to manage NETCONF parameters in the form of 
parameter templates. To deploy the NETCONF parameters in a NETCONF template to different 
devices, you only need to select the desired NETCONF template from the predefined templates for 
these devices. 

Viewing the NETCONF template list 

1. Navigate to System > Access Parameter Template. 

a. Click the System tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Access Parameter Template under Resource Management on the left navigation 
tree. 

The Access Parameter Template window opens. 

2. Click the Netconf tab. 

IMC displays all NETCONF templates in the NETCONF Template List. 

NETCONF template list contents 

 Template Name—Contains the NETCONF template name. 

 Vendor—Contains the vendor of the device that corresponds to the template. 

 Modify—Contains an icon for navigating to the Modify NETCONF Template page for the 
associated template. 

 Delete—Contains an icon for deleting the associated template. 

Adding a NETCONF template 

1. Access the NETCONF template list page. 

2. Click Add. 

The Add NETCONF Template page opens. 
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3. Enter a unique NETCONF template name in the Template Name field. 

You cannot modify the template name, vendor or description for a template once the template 
has been created. To modify them, you must first delete the template and then recreate it with 
the new parameters. 

4. Select a device vendor that corresponds to the template from the Vendor list. 

5. Enter a description for the template in the Description field. 

6. Select a protocol to be used by NETCONF, and then click Edit for the protocol. 

7. Specify the following parameters in the dialog box that opens: 

 Port Number—Enter the port number used by the protocol on the device. 

 Root Path—Enter the root path for the protocol on the device. By default, the 
/soap/netconf/ root path is used. 

 User Name—Enter the user name, which must be the same as is configured on the device. 

 Password—Enter the password, which must be the same as is configured on the device. 

8. Click OK. 

If you want to configure other protocols, repeat step 6 to step 8. 

9. Click OK on the Add NETCONF Template page. 

Modifying a NETCONF template 

1. Access the NETCONF template list page. 

2. Click the Modify icon  for the NETCONF template you want to modify. 

3. Modify template parameters as required. 

The Template Name, Vendor, and Description cannot be modified. For more information 
about the other parameters, see "Adding a NETCONF template." 

4. Click OK. 

Deleting a NETCONF template 

1. Access the NETCONF template list page. 

2. Click the Delete icon  in the NETCONF Template List for the NETCONF template you 
want to delete. 

3. Click OK to confirm deletion of the selected NETCONF template. 

SOAP/HTTP templates 

With Virtual Resource Management deployed, the SOAP/HTTP Template is displayed in the 
System tab. IMC uses SOAP to enable secure remote access to manage VMware virtual network 
devices, including vManager and ESX server. IMC uses HTTP to manage the connection 
parameters for Citrix virtual network devices, such as XenServer. 

The SOAP/HTTP template feature allows you to save SOAP/HTTP configuration settings in IMC, 
which can then be applied when adding new virtual network devices to IMC, performing an auto 
discovery, or configuring devices in individual or batch mode. SOAP/HTTP templates store the IMC 
SOAP/HTTP configurations for devices to support IMC communication with the device. SOAP/HTTP 
templates do not configure the SOAP/HTTP settings on the device itself. 

Viewing the SOAP/HTTP template list 

1. Navigate to System > SOAP/HTTP Template: 

a. Click the System tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Access Parameter Template under Resource Management on the left navigation 
tree. 

The Access Parameter Template window opens. 

2. Click the SOAP tab. 
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IMC displays all SOAP/HTTP templates in the SOAP/HTTP Template List. 

SOAP/HTTP template list 

 Template Name—Contains the SOAP/HTTP template name. 

 Access Type—Contains the access type for the template. The access type includes SOAP 
and HTTP. 

 Access URL—Contains the access URL for the configured SOAP/HTTP template. 

 User Name—Contains the user name. 

 Modify—Contains an icon for navigating to the Modify SOAP/HTTP Template page for the 
associated template. 

 Delete—Contains an icon for deleting the associated template. 

You can sort the SOAP/HTTP Template List by each field except Modify and Delete. Click the 
column label to sort the list by the selected field. The column label is a toggle switch that allows 
you to toggle between the various sort options specific to each field. 

Adding an SOAP/HTTP template 

1. Access the SOAP/HTTP template list page. 

2. Click Add. 

3. Enter a unique name for the SOAP/HTTP template name in the Template Name field. 

You cannot modify the name of a template once the template has been created. To modify the 
name, you must first delete the template and then recreate it with the new name. 

4. From the list next to Access Type, select one of the following options: 

 SOAP—For VMware virtual network devices. 

 HTTP—For Citrix virtual network devices. 

5. Select the protocol to match the SOAP/HTTP configuration on the managed devices from the 
Protocol list.  

Protocol options include http and https. 

6. Enter the port number that is configured on managed devices in the Port field.  

The default port number is 80 for http, or 443 for https. 

7. Enter the root path that is configured on managed devices in the Root Path field.  

The default setting is sdk. 

8. Enter the username that is configured on managed devices in the Username field. 

9. Enter the password that is configured on the managed devices in the Password field. 

10. If you want to test whether the configured SOAP/HTTP Template can connect to a 
vManager/physical server, click the Test connection to vManager/physical server 
checkbox, and the Select button is displayed.  

11. Click Select to select a vManager/physical server. For more information about selecting 
devices, see "Adding devices by view" and "Adding devices by advanced query." 

12. Confirm that the devices now are displayed in the Devices List field, and then click OK. 

The SOAP/HTTP configuration settings in IMC must match the SOAP/HTTP settings configured on 
the managed devices. For more information about configuring SOAP/HTTP settings on the managed 
devices, see the vendor's documentation. 

If you select the Test connection to vManager/physical server option and add the devices, click 
OK. IMC then accesses the specified device by using the defined SOAP/HTTP parameters. If the 
access succeeds, the SOAP/HTTP template is added to IMC. Otherwise, the SOAP/HTTP template 
is not added to IMC.  

The added SOAP/HTTP templates are displayed as configuration options when you configure 
devices. 

Adding devices by view 
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1. From the Select Devices dialog box, click the By View tab. 

2. Expand the view from which you want to select devices by clicking the arrow to the left of the 
three view options, IP View, Device View, Device Group, or Custom View. 

3. Click the view from which you want to select devices on the left navigation tree. The devices 
from the group you click are displayed in the Devices Found field next to the navigation tree. 
You can select devices from more than one group by clicking more than one group. 

4. Highlight the devices you want to select from the Devices Found list, and then click the Add 
selected icon  to add them to the selected devices list. 

5. To remove one or more devices, select them and click the Remove selected icon . 

6. Confirm that the devices you have found have been added by reviewing the Selected Devices 
list. 

7. Click OK.  

Adding devices by advanced query 

You can also add devices using the Advanced query option to search IMC using various criteria, and 
then use the results of the search to add devices.  

To add devices by advanced query: 

1. Click Select next to the Selected Devices field. 

2. From the Select Devices dialog box, click the Advanced tab. 

3. Enter values in one or more of the search parameters listed here: 

 Device IP—Enter the IP address for which you want to query. Select Exact Query if you 
want IMC to search for the exact IP address you have entered. Leave the Exact Query box 
unchecked if you want IMC to match only a certain portion of the IP address. 

 Device IP List—Configure multiple device IP addresses to be searched. Click the  link. 
The Device IP List Configuration window opens. Enter one or multiple device IP 
addresses in the Input Device IP field (if you enter multiple IP addresses, enter one IP 
address on each line), and then click Add to add the entered IP addresses to the Device IP 
List field below. Repeat the steps above to add all device IP addresses to be searched. To 
delete an IP address in the Device IP List field, select the IP address, and then click Delete. 
Click OK to complete the operation. Make sure that the device IP addresses to be searched 

have been added to the Device IP List field. To clear the Device IP List field, click the  
link. 

 Device Label—Enter the device name for the devices you want to add. IMC supports fuzzy 
matching for device labels. You can enter the entire device label for the device you want to 
locate, or you can enter just a portion of it. IMC displays all matches that contain the portion 
you enter. 

 Device Status—Select device status from the Device Status list. 

 Device Category—Select a device category from the Device Category list. 

 Device Series—Select a device series from the Device Series list. 

 Contact—Enter the contact name information by which you want to search. IMC supports 
fuzzy matching for this field. You can enter a partial string for the contact or the complete 
string for the contact. 

 Location—Enter the location information by which you want to search. IMC supports fuzzy 
matching for this field. You can enter a partial string for location or the complete string for 
location. 

 Device Reachability—Select device reachability status from the Device Reachability list. 

4. Click Query to begin your search. 

The results of your search are displayed in the Devices Found field. 

5. Highlight the devices you want to select and click Add selected  to add them to the selected 
devices list. 
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6. To remove one or more devices, select them and click Remove selected . 

7. Confirm that the devices you have found have been added by reviewing the Selected Devices 
list. 

8. Click OK. Confirm that the devices now are displayed at the left of Select. 

9. Click OK. 

Modifying an SOAP/HTTP template 

1. Access the SOAP/HTTP template list page. 

2. Click the Modify icon  for the SOAP/HTTP template you want to modify. 

3. Modify template parameters as required. 

The Template Name cannot be modified. For more information about the other parameters, 
see "Adding an SOAP/HTTP template." 

4. Click OK. 

Deleting an SOAP/HTTP template 

1. Access the SOAP/HTTP template list page. 

2. Click the Delete icon  for the SOAP/HTTP template you want to delete. 

3. Click OK to confirm deletion of the selected SOAP/HTTP template. 

PowerShell templates 

With Virtual Resource Management deployed, the PowerShell Template is displayed in the 
System tab. IMC uses PowerShell to enable secure remote access to managed Microsoft Virtual 
Machine Manager server. 

The PowerShell template feature allows you to save PowerShell configuration settings in IMC, which 
can then be applied when adding new virtual network devices to IMC, performing an auto discovery, 
or configuring devices in individual or batch mode. PowerShell templates store IMC PowerShell 
configurations for devices to support IMC communication with the device. PowerShell templates do 
not configure the PowerShell settings on the device itself. 

Viewing the PowerShell template list 

1. Navigate to System > PowerShell Template: 

a. Click the System tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Access Parameter Template under Resource Management on the left navigation 
tree. 

The Access Parameter Template window opens. 

2. Click the PowerShell tab. 

IMC displays all PowerShell templates in the PowerShell Template List. 

PowerShell template list contents 

 Template Name—Contains the PowerShell template name. 

 User Name—Contains the user name. 

 Port—PowerShell monitor port.  

 Modify—Contains an icon for navigating to the Modify PowerShell Template page for the 
associated template. 

 Delete—Contains an icon for deleting the associated template. 

If the PowerShell template list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the PowerShell Template List. 
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 Click  to page forward to the end of the PowerShell Template List. 

 Click  to page backward in the PowerShell Template List. 

 Click  to page backward to the front of the PowerShell Template List. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

You can sort the PowerShell Template List by the Template Name, User Name, and Port 
fields. Click the column label to sort the list by the selected field. The column label is a toggle 
switch that allows you to toggle between the various sort options specific to each field. 

Adding a PowerShell template 

1. Access the PowerShell template list page. 

2. Click Add. 

3. Enter a unique name for the PowerShell template name in the Template Name field. 

The PowerShell configuration settings in IMC must match the PowerShell settings configured 
on the managed devices. For information about configuring PowerShell settings on the 
managed devices, see your vendor's documentation. 

4. Enter the username that is configured on managed devices in the Username field. 

5. Enter the password that is configured on the managed devices in the Password field. 

6. Enter the port number that is configured on managed devices in the Port field. 

7. If you want to test whether the configured PowerShell Template can connect to a 
vManager/physical server, click the Test connection to vManager/physical server 
checkbox. The Select button is displayed. 

8. Click Select to select a vManager/physical server.  

9. Add devices by using either the View or Advanced query option. See "Adding devices by view" 
and "Adding devices by advanced query." 

The PowerShell configuration settings in IMC must match the PowerShell settings configured on the 
managed devices. For information about configuring PowerShell settings on the managed devices, 
see the vendor's documentation. 

If you select the Test connection to vManager/physical server option and add the devices, click 
OK. IMC then accesses the specified device by using the defined PowerShell parameters. If the 
access succeeds, the PowerShell Template is added to IMC, Otherwise, the PowerShell Template is 
not added to IMC. 

The added PowerShell templates are displayed as configuration options when configuring devices. 

Modifying a PowerShell template 

1. Access the PowerShell template list page. 

2. Click the Modify icon  for the PowerShell template you want to modify. 

3. Modify the username to match the username that is configured on managed devices in the 
Username field. 

4. Modify the password to match the password that is configured on the managed devices in the 
Password field. 

5. Enter port number that is configured on managed devices in the Port field. 

6. Click OK. 

7. If you select the Test connection to vManager/physical server option and add the devices, 
click OK.  
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IMC then accesses the specified device by using the defined PowerShell parameters. If the access 
succeeds, the PowerShell Template is added to IMC. Otherwise, the PowerShell Template is not 
added to IMC. 

Deleting a PowerShell template 

1. Access the PowerShell template list page. 

2. Click the Delete icon  for the PowerShell template you want to delete. 

3. Click OK to confirm deletion of the selected PowerShell template. 

WMI templates 

WMI refers to the Windows Management Instrumentation (WMI), and is a type of Windows 
management technology. With Virtual Resource Management deployed, the WMI Template is 
displayed in the System tab. IMC uses WMI to enable secure remote access to managed Hyper-V 
physical servers. 

The WMI template feature allows you to save WMI configuration settings in IMC, which can then be 
applied when you perform the following tasks: 

 Adding new virtual network devices to IMC. 

 Performing an auto discovery. 

 Configuring devices in individual or batch mode. 

WMI templates store IMC WMI configurations for devices to support communication with the device. 
WMI templates do not configure the WMI settings on the device itself. 

Viewing the WMI template list 

1. Navigate to System > Access Parameter Template.: 

a. Click the System tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Access Parameter Template under Resource Management on the left navigation 
tree. 

The Access Parameter Template window opens. 

2. Click the WMI tab. 

IMC displays all WMI templates in the main pane of the WMI Template List. 

WMI template list 

 Template Name—Contains the WMI template name. 

 User Name—Contains the user name. 

 Impersonation Level—Can be Default, Anonymous, Identify, Impersonate, and 
Delegate. 

 Authentication Level—Can be Default, None, Connect, Call, Packet, Packetlntegrity, 
and PacketPrivacy. 

 Modify—Contains an icon for navigating to the Modify WMI Template page for the 
associated template. 

 Delete—Contains an icon for deleting the associated template. 

If the WMI template list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the WMI Template List. 

 Click  to page forward to the end of the WMI Template List. 

 Click  to page backward in the WMI Template List. 
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 Click  to page backward to the front of the WMI Template List. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

You can sort the WMI Template List by the Template Name, User Name, Impersonation 
Level, and Authentication Level fields. Click the column label to sort the list by the selected 
field. The column label is a toggle switch that allows you to toggle between the various sort 
options specific to each field. 

Adding a WMI template 

1. Access the WMI template list page. 

2. Click Add. 

3. Enter a unique name for the WMI template name in the Template Name field. 
 

 NOTE: 

You cannot modify the name of a template once the template has been created. To modify the 
name, you must first delete the template and then recreate it with a new name. 
 

4. Enter the username that is configured on managed devices in the Username field. 

5. Enter the password that is configured on the managed devices in the Password field. 

6. Select an impersonation level from the Impersonation Level list. 

7. Select an authentication level from the Authentication Level list. 

8. If you want to test whether the configured WMI parameters can connect to a vManager/physical 
server, click the Test connection to vManager/physical server checkbox.  

The Select button is displayed. 

9. Click Select to select vManager/physical server.  

10. Add devices by using either the View or Advanced query option. See "Adding devices by 
view" and "Adding devices by advanced query." 

The WMI configuration settings in IMC must match the WMI settings configured on the managed 
devices. For information about configuring WMI settings on the managed devices, see the vendor's 
documentation. 

If you select Test connection to vManager/physical server option, IMC accesses the specified 
device by using the configured WMI parameters. If the access succeeds, the WMI Template is added 
to IMC. Otherwise, the WMI Template is not added to IMC. 

The added WMI templates are displayed as configuration options when configuring devices. 

Modifying a WMI template 

1. Access the WMI template list page. 

2. Click the Modify icon  for the WMI template you want to modify. 

3. Modify the username to match the username configured on managed devices in the Username 
field. 

4. Modify the password to match the password that is configured on the managed devices in the 
Password field. 

5. Select an impersonation level from the Impersonation Level list.  

6. Select an authentication level from the Authentication Level list. 

7. Click the Test connection to vManager/physical server checkbox, if you want to test whether 
the configured WMI template can connect to a vManager/physical server.  

The Select button is displayed. 

8. Click Select to select a vManager/physical server.  

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 8564



163 

9. Add devices by using either the View or Advanced query option. See "Adding devices by view" 
and "Adding devices by advanced query." 

If you select the Test connection to vManager/physical server option, IMC uses the configured 
WMI parameters to access the specified device. If the access succeeds, the WMI template is 
updated. Otherwise, the WMI template is not updated. 

Deleting a WMI template 

1. Access the WMI template list page. 

2. Click the Delete icon  for the WMI template you want to delete. 

3. Click OK to confirm deletion of the selected WMI template. 

Configuring vendor and device information 
Vendor and device specific information is used by IMC for Resource, Change, and Configuration 
management functions. It is integral to optimal IMC functioning. Vendor and device specific details 
are also displayed in device details views. 

IMC auto-populates vendor and device information when the information is available. For some third 
party devices this information may not be available. If device information is not available, IMC cannot 
categorize these devices into the router, switch, server, wireless or voice groups to which they should 
belong. In such cases, IMC categorizes these devices as end stations. You can correct this by 
manually adding device vendor, series and model information. 

Viewing and configuring device vendor information 

You can store vendor information for devices in the network infrastructure. The following information 
explains the Device Vendor List, which displays all entries in IMC for device vendors, and how to 
add, modify, and delete device vendor information.  

Viewing the device vendor list 

1. Navigate to System > Device Definition. 

a. Click the System tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Device Definition under Resource Management on the left navigation tree. 

The Device Definition window opens. 

2. Click the Device Vendor tab. 

IMC displays all device vendor information in the Device Vendor List. 

Device vendor list contents 

 Vendor Name—Contains the vendor's name. 

 Vendor Type—Identifies whether the vendor list entry is system or user-defined. 

 Phone Number—Contains the vendor's phone number. 

 Vendor Contact—Contains the vendor's contact name. 

 Description—Contains a description of the vendor. 

 Modify—Contains an icon for navigating to the Modify Device Vendor page for the 
associated vendor entry. 

 Delete—Contains an icon for deleting the associated device vendor entry. 

You can sort the Device Vendor List by the Vendor Name and Vendor Type fields. Click the 
column label to sort the list by the selected field. The column label is a toggle switch that allows 
you to toggle between the various sort options specific to each field. 

If the device vendor list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Device Vendor List. 
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 Click  to page forward to the end of the Device Vendor List. 

 Click  to page backward in the Device Vendor List. 

 Click  to page backward to the front of the Device Vendor List. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

Adding a device vendor 

1. Access the device vendor list page. 

2. Click Add. 

3. Enter the vendor's name in the Vendor Name field. 

4. Enter the phone number for the vendor in the Phone Number field. 

5. Enter a brief description for the vendor in the Description field. 

6. Enter the name of the contact person for the vendor in the Vendor Contact field. 

7. Select a vendor icon from the list next to Vendor Icon. 

If the list does not provide the vendor icon you want, you can upload a local vendor icon. For 
more information about uploading a vendor icon, see "Uploading a vendor icon." 

8. Click OK. 

Modifying a device vendor 

1. Access the device vendor list page. 

2. Click the Modify icon  for the vendor name you want to modify. 

3. Modify the vendor's name as needed in the Vendor Name field. 

4. Modify the phone number for the vendor as needed in the Phone Number field. 

5. Modify the description for the vendor as needed in the Description field. 

6. Modify the name of the contact person for the vendor as needed in the Vendor Contact field. 

7. Modify the vendor icon as needed in the Vendor Icon field. 

8. Click OK. 

You can modify all device vendor settings for manually added vendors, but cannot modify the 
Vendor Name and Icon settings for system-defined vendors. 

Deleting a device vendor 

1. Access the device vendor list page. 

2. Click the Delete icon  for the vendor name you want to delete. 

3. Click OK to confirm deletion of the selected device vendor. 

Uploading a vendor icon 

1. Access the device vendor list page. 

2. Click Upload Vendor Icon. 

3. Click Browse next to the Source File field, and select a local .gif file to be uploaded in the 
dialog box that opens.  

4. Click Open.  

The file path is displayed in the Source File field. 

5. Enter the icon name in the Target File Name field.  

As a best practice, enter the vendor name represented by the vendor icon.  

6. Click Upload to upload the vendor icon. 
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After the vendor icon is successfully uploaded, the vendor icon is displayed in the list next to 
Vendor Icon when you add or modify a vendor.  

Configuring device series 

Managing device series information is an essential element of IMC management and one that you 
should maintain for optimal use of IMC functions. 

 Device series information is a required field when creating a new device model. 

 Device model information is used in IMC to categorize devices.  

 Device categorization is used in many IMC functions including discovery, alarming and 
reporting.  

Viewing the device series list 

1. Navigate to System > Device Definition. 

a. Click the System tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Device Definition under Resource Management on the left navigation tree. 

The Device Definition window opens. 

2. Click the Device Series tab. 

IMC displays all device series information in the Device Series List. 

Device series list contents 

 Series Name—Contains the device series name. 

 Vendor—Contains the vendor's name. 

 Series Type—Identifies whether the device series list entry is system or user-defined. 

 Description—Contains a description of the device series. 

 Modify—Contains an icon for navigating to the Modify Device Series page for the 
associated device series entry. 

 Delete—Contains an icon for deleting the associated device series entry. 

You can sort the Device Series List by the Series Name, Vendor, and Series Type fields. 
Click the column label to sort the list by the selected field. The column label is a toggle switch 
that allows you to toggle between the various sort options specific to each field. 

If the device series list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Device Series List. 

 Click  to page forward to the end of the Device Series List. 

 Click  to page backward in the Device Series List. 

 Click  to page backward to the front of the Device Series List. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

Adding a device series 

1. Access the device series list page. 

2. Click Add. 

3. Enter the name of the series in the Series Name field. 

4. Select the vendor for this device series from the Vendor list. 

If the vendor does not exist, you can add it. To add vendors, see "Adding a device vendor." 

5. Enter a description of the device series the Description field. 
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6. Click OK. 

Modifying a device series 

1. Access the device series list page. 

2. Click the Modify icon  for the device series you want to modify. 

3. Modify the name for the series in the Series Name field as needed. 

4. Select the vendor for this device series from the Vendor list. 

If the vendor does not exist, you can add it. To add vendors, see "Adding a device vendor." 

5. Modify the description of the device series in the Description field. 

6. Click OK. 

Deleting a device series 

1. Access the device series list page. 

2. Click the Delete icon  for the device series you want to delete. 

3. Click OK to confirm deletion of the selected device series. 

Configuring device models 

IMC uses device model information to categorize devices. These categories are used throughout 
IMC to discover, manage and report on network resources. You can manage IMC categories by 
adding device model information for devices in the network infrastructure. 

This section explores the Device Model List that displays all devices models in IMC before 
examining how to add, modify, and delete device models. 

Viewing the device model list 

1. Navigate to System > Device Definition. 

a. Click the System tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Device Definition under Resource Management on the left navigation tree. 

The Device Definition window opens. 

2. Click the Device Model tab. 

IMC displays all device model information in the Device Model List. 

Device model list contents 

 Model Name—Contains the device model name. 

 sysOID—Contains the sysOID or system Object ID for the device model. 

 Series—Identifies the Device Series family to which the device model belongs. 

 Category—Identifies IMC classification for the device model. 

 Display Picture—Contains a picture that indicates the category to which the device model 
belongs. 

 Type—Identifies whether the associated device model is system or user-defined. 

 Modify—Contains an icon for navigating to the Modify Device Model page for the 
associated device model entry. 

 Delete—Contains an icon for deleting the associated device model entry. 

You can sort the Device Model List by the Model Name, sysOID, Series, Category, and 
Type fields. Click the column label to sort the list by the selected field. The column label is a 
toggle switch that allows you to toggle between the various sort options specific to each field. 

If the device model list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Device Model List. 
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 Click  to page forward to the end of the Device Model List. 

 Click  to page backward in the Device Model List. 

 Click  to page backward to the front of the Device Model List. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

Adding a device model 

1. Access the device model list page. 

2. Click Add. 

3. Enter the system object ID in the sysOID field, or use the Query Device feature in IMC to auto 
populate the sysOID field. 

There are two ways to query in the Query Device feature – By View or through Advanced 
query. 

To auto populate the sysOID field using the Query By View feature, see "Adding devices by 
view." You can also auto populate the sysOID field by using the Advanced query option. For 
more information, see "Adding devices by advanced query." 

To use the Query Device option, the device must already exist. To add devices, see "Adding 
devices in IMC." 

4. Select the vendor name from the Vendor list. 

If the vendor does not exist, you can add it. To add vendors, see "Adding a device vendor." 

5. Select the device series from the Series list. 

If the device series does not exist, you can add it. To add a device series, see "Adding a device 
series." 

6. Select the device category from the Category list. 

7. Enter a brief description for this device model in the Description field. 

8. Click OK. 

Modifying a device model 

1. Access the device model list page. 

2. Click the Modify icon  for the device model you want to modify. 

3. Modify the vendor's name for the device model in the Model Name field. 

4. Modify the system object ID in the sysOID field or use the Query Device feature in IMC to auto 
populate the sysOID field. 

There are two ways to query in the Query Device feature – By View or through Advanced 
query.  

To auto populate the sysOID field using the Query By View feature, see "Adding devices by 
view." You can also auto populate the sysOID field by using the Advanced query option, for 
more information, see "Adding devices by advanced query." 

5. To change the vendor name, select the vendor name from the Vendor list. 

If the vendor does not exist, you can add it. To add vendors, see "Adding a device vendor." 

6. To change the device series, select the device series from the Series list. 

If the device series does not exist, you can add it. To add a device series, see "Adding a device 
series."  

7. To change the device category, select the device category from the Category list. 

8. Modify the description for this device model in the Description field. 

9. Click OK. 
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Deleting a device model 

1. Access the device model list page. 

2. Click the Delete icon  for the device model you want to delete. 

3. Click OK to confirm deletion of the selected device model. 

Configuring device categories 

IMC divides devices into 14 categories, including Desktops, Switches, Printers, and Routers. You 
can define other categories as needed. 

Viewing the device category list 

1. Navigate to System > Device Definition. 

a. Click the System tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Device Definition under Resource Management on the left navigation tree. 

The Device Definition window opens. 

2. Click the Device category tab. 

IMC displays device category information in the Device Category List. 

Device category list contents 

 Category Name—Contains the device category name. 

 Type—Identifies whether the associated device category is system or user-defined. 

 Display Default—Identifies whether the device category is displayed by default under 
Device View in the navigation tree. 

 Display Picture—Contains the picture of the associated device category. 

 Modify—Contains an icon for navigating to the Modify Device Category page for the 
associated device series entry. 

 Delete—Contains an icon for deleting the associated device series entry. 

You can sort the Device Category List by the Category Name, Type, and Display Default 
fields. Click the column label to sort the list by the selected field. The column label is a toggle 
switch that allows you to toggle between the various sort options specific to each field. 

If the device category list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Device Category List. 

 Click  to page forward to the end of the Device Category List. 

 Click  to page backward in the Device Category List. 

 Click  to page backward to the front of the Device Category List. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

Adding a device category 

1. Access the device category list page. 

2. Click Add. 

3. Enter the category's name for the device model in the Category Name field. 

4. Select an icon from Display Picture list. 

5. Click OK. 

Modifying a device category 
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1. Access the device category list page. 

2. Click the Modify icon  for the device category you want to modify. 

3. Modify the category's name for the device category in the Category Name field. 

4. Select an icon from the Display Picture list. 

5. Click OK. 

Deleting a device category 

1. Access the device category list page. 

2. Click the Delete icon  for the device category you want to delete. 

3. Click OK to confirm deletion of the selected device category. 

Managing filters to filter interfaces 
A filter is used by port groups to filter interfaces. 

Viewing the filter list 

1. Navigate to System > Filter. 

a. Click the System tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click the Filter icon  under Resource Management on the left navigation tree. 

IMC displays information about all filters in the Filter List in the main pane of the System > 
Filter window. 

Filter List contents 

 Name—Contains the name of the associated filter. 

 Object—Contains the object to be filtered, which is Interface. 

 Type—Contains the type of the associated filter. Options include System-Defined and 
User-Defined. 

 Created by—Contains the name of the operator who created the associated filter. 

 Created at—Contains the time when the associated filter was created. 

 Description—Contains a description for the associated filter. 

 Delete—Contains an icon for deleting the associated filter. 

You can sort the Filter List by the Name, Object, Type, Created by, and Created at fields. 
Click the column label to sort the list by the selected field. The column label is a toggle switch 
that allows you to toggle between the various sort options specific to each field.  

The name you assign to a filter is used to identify the filter. Assigning a descriptive and 
meaningful name to a filter aids you in navigating quickly and easily to filter the interface list. 

If the filter list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Filter List. 

 Click  to page forward to the end of the Filter List. 

 Click  to page backward in the Filter List. 

 Click  to page backward to the front of the Filter List. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 
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Adding a filter 

IMC does not offer the function of directly adding filters to the Filter List. Instead, you can save 
interface query criteria as a filter when using the Advanced Query option.  

To add a filter: 

1. Navigate to the Advanced Query page. 

2. Click Advanced located in the upper right corner of the IMC page. 

3. Select Query Interfaces to perform search for interfaces. 

4. Enter the following information in the Advanced Query page: 

 Interface Alias—IMC supports fuzzy matching for this field. You can enter a partial or 
complete name for the interface alias you want to locate in the Interface Alias field. 

 Interface Type—Select the interface type you want to search from the Interface Type list. 

 Speed—Select the interface's speed from the Speed list. 

 Interface IP—Enter the IP address of the interface for which you want to search in the 
Interface IP field. Select Fuzzy from the list next to the Interface IP if you want to enter a 
partial IP address. Select Exact from this list if you want IMC to search for an exact match 
for the entered IP address. 

 MAC Address—Enter the MAC address of the interface for which you want to search in the 
MAC Address field. IMC supports fuzzy matching for this field. You can enter a partial or 
complete MAC address for the interfaces you want to locate. 

 Device Label—Enter the name of the device to which the interface belongs in the Device 
Label field. IMC supports fuzzy matching for this field. You can enter a partial or complete 
string for the device name. 

 Device IP—Enter the IP address of the device to which the interface belongs in the Device 
IP field. Select Fuzzy from the list next to the Device IP if you want to enter a partial IP 
address. Select Exact from this list if you want IMC to search for an exact match for the 
entered IP address. 

 Management Status—Select the management status of the interfaces for which you want 
to search from the Management Status list. 

 Operational Status—Select the operational status of the interfaces for which you want to 
search from the Operational Status list. 

 Interface Up/Down Alarm Filter—Select the interface up/down alarm filter used by the 
interfaces for which you want to search from the Interface Up/Down Alarm Filter list. 

 Interface Link Type—Select the link type of the interfaces for which you want to search 
from the Interface Link Type list. 

5. Click Save as Filter to save a filter.  

The Save as Filter dialog box opens. 

6. Enter the filter name in Name field. 

7. Enter the description for the associated filter in the Description field. 

8. Click OK. 

Deleting a filter 

1. Navigate to System > Filter: 

a. Click the System tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click the Filter icon  under Resource Management on the left navigation tree. 

IMC displays information about all filters in the Filter List in the main pane of the System > 
Filter window. 

2. Click the Delete icon  in the Filter List associated with the filter you want to delete. 
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3. Click OK to confirm deletion of the selected filter. 

Operator management: managing secure access 
to IMC 

Operator Management offers you powerful control over resources in the network infrastructure. 
Sound network infrastructure security policy and practice should include securing IMC through 
effective use of the IMC security features and functions found in Operator Management under the 
System tab.  

Configure access and management rights to network resources granted to, or rescinded from, IMC 
operators through the use of three features:  

 Operator Groups 

 Device Groups 

 Device Views 

It is through the configuration of the operator account itself that these three features converge to 
define the specific set of access and management rights and restrictions for each operator.  

Operator groups allow you to grant or restrict access and rights to IMC features and functions. You 
can create custom operator groups, and grant or restrict operator access to the following IMC 
functions: 

 Resource Manager 

 Alarm Management 

 Intelligent Configuration Center 

 Report Management 

 Performance Management 

 Network Asset Management 

 Security Control Center 

 Guest Access Management 

 ACL Management 

 VLAN Management 

 Syslog Management 

 NE Management 

 VRM Management 

Once groups are created, you can add operators to an operator group to grant or restrict their access 
to these IMC features. 

Custom views allow you to grant or restrict access to devices by creating custom views. Custom 
views serve two purposes:  

 To grant or restrict access and management rights to a set of devices. 

 To provide operators with a logical view of devices for quick and efficient access to managed 
devices. 

You create custom views that group devices logically. These views become available through the 
Resource tab to operators when they have been granted rights to them. You then grant or restrict 
operator access to one or more custom views when configuring individual operator accounts. 

Device groups give you a layer of refinement for granting or restricting operator access and rights to 
devices managed by IMC. While Device Views allow you to group devices logically, device groups 
enable you to group devices by device type or any other logical grouping. You can create custom 
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groups and add one or more devices to a group. Once device groups are created, you can assign 
operators to a device group, thus granting them access and rights to manage the devices in that 
group. Operators have access only to those devices that are included in the device groups to which 
they have been granted rights. In other words, operators do not have access to, and cannot even 
view, devices that are not included in the groups to which they have been granted rights. Device 
Groups serve to grant access to devices only, and are not visible as device groups in IMC features 
and functions. 

You are then ready to assign or restrict access and management rights to network resources through 
the configuration of operator accounts, once you have done the following:  

 Created operator groups, custom views, and device groups. 

 Populated device views and groups with devices. 

In operator accounts, you assign each operator membership in an operator group and access and 
management rights to device views and groups. Adding an operator to the Administrator Group 
grants that operator rights to all devices, all device groups, and all views, without exception. Thus, to 
use views and device groups to manage rights and restrictions to IMC, you must add operators to 
either the maintainer or the viewer group. 

The sum of operator privileges and restrictions configured in add or modify operator account pages 
ultimately determines what devices become visible to each operator in IMC through custom views or 
IMC system defined views.  

The rights and restrictions in operator accounts also determine which performance reports, alarms, 
other IMC management and reporting views, and features operators see as operators can only view 
information and features for devices over which they have rights. 

In addition to access and rights management features discussed above, IMC offers other features to 
secure access to IMC and the resources managed by it. You have three options for operator 
authentication to IMC:  

 Local IMC password management. 

 RADIUS authentication. 

 LDAP authentication. 

You can configure authentication services through RADIUS or LDAP using the Authentication 
Server feature found under Operator Management. 

You can control login access to IMC through IP address access control lists in the Login Control 
Template function under Operator Management. 

You can also set password strategies that apply to all operators in the Password Strategy function 
under Operator Management. 

Finally, you apply these configurations individually when creating operator accounts. 

Managing operator groups 
In IMC, you can create custom defined operator groups that assign or restrict IMC service and 
component level privileges to members of the operator groups. Once created, custom groups are 
then displayed as configuration options when adding operators to IMC.  

You can create custom operator groups, and grant or restrict operator access to the following IMC 
features: 

 Resource Management 

 Alarm Management 

 Intelligent Configuration Center 

 Report Management 

 Performance Management 
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 Network Asset Management 

 Security Control Center 

 Guest Access Management 

 ACL Management 

 VLAN Management 

 Syslog Management 

Once groups are created, you can add operators to an operator group to grant or restrict their access 
to these IMC features. 

In IMC, administrators are granted the access to all data by default, and the maintainers and viewers 
can view only the data to which they have access. Through the data access right configuration, you 
can view all data to which the administrators have access, and you can view the data access rights of 
maintainers and viewers. 

Securing IMC begins with defining and implementing operator groups, which map the roles and 
responsibilities of individuals and groups within the organization to the services and components 
within IMC.  

Once you have identified the various groups within your support organization, and their roles and 
responsibilities, and how they map to IMC services and components, you are ready to begin creating 
operator groups. 

Viewing the operator group list 

1. Navigate to System > Operator Group: 

a. Click the System tab from the top tabular navigation system. 

b. Click Operator Management on the left navigation tree. 

c. Click Operator Group under Operator Management on the left navigation tree. 

IMC displays all operator groups in the Operator Group List displayed in the main pane of the 
System > Operator Group window. 

Operator group list 

 Group Name—Contains the operator group name. 

 Privilege—Contains privilege level for the associated group. There are three privilege 
levels in IMC:  

 ADMIN 

 Maintainer 

 Viewer 

 Description—Contains a description for the associated operator group. 

 Copy—Contains an icon for navigating to the Add Operator Group page for the 
associated device series entry. 

 Modify—Contains an icon for navigating to the Modify Operator Group page for the 
associated device series entry. 

 Delete—Contains an icon for deleting the associated device series entry. 

 You can sort the Operator Group List by the Group Name, Privilege, and Description. 
Click the column label to sort the list by the selected field. The column label is a toggle 
switch that allows you to toggle between the various sort options specific to each field.  

If the operator group list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Operator Group List. 

 Click  to page forward to the end of the Operator Group List. 
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 Click  to page backward in the Operator Group List. 

 Click  to page backward to the front of the Operator Group List. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

Adding an operator group 

1. Navigate to System > Operator Group: 

a. Click the System tab from the top tabular navigation system. 

b. Click Operator Management on the left navigation tree. 

c. Click Operator Group under Operator Management on the left navigation tree. 

IMC displays all operator groups in the Operator Group List displayed in the main pane of the 
System > Operator Group window. 

2. Click Add. 

3. Enter a unique name for the group you want to create in the Group Name field. 

4. Select a privilege level from the Privilege list.  

Options are ADMIN, Maintainer, and Viewer. The Operation Privileges list varies by the 
selected privilege level. The following operation privileges are displayed only when ADMIN is 
selected: Operator Management, Group Management, and System Settings. Maintainers 
have less permissions than administrators. Viewers have the least permissions among all 
operators. 

Do not confuse the admin operator with other operators who have the ADMIN privileges. The 
admin operator is a built-in super account that has all management permissions. Other 
operators with the ADMIN privileges have restricted permissions to the configuration of each 
other. For example, to delete performance views created by an operator with the ADMIN 
privilege, you must use the account of the admin operator or the creator. 

5. Enter a description for the operator group in the Description field. 

6. Click the Expand ALL icon  to view all Operator Privileges.  

This step grants or restricts access to IMC features for the Operator Group. 

7. Deselect any privileges you want to revoke for this operator group by clicking the checked box 
 to remove the check mark. 

8. Click OK to create the Operator Group. 

You cannot modify the name of an operator group once it has been created. 

Configuring the data access rights 

IMC supports configuring data access rights for all operator groups except the administrator group. 
The administrator group has the access right to all data by default. Through the data access right 
configuration, you can view all the data to which the administrators have access. The data access 
right of the administrator group is not configurable. 

To set the data access rights: 

1. Navigate to System > Operator Group: 

a. Click the System tab from the top tabular navigation system. 

b. Click Operator Management on the left navigation tree. 

c. Click Operator Group under Operator Management on the left navigation tree. 

IMC displays all operator groups in the Operator Group List displayed in the main pane of the 
System > Operator Group window. 

2. Click the Data Privilege Configure icon  for Group Name.  
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If the group is an administrator group, the page displays all data modules that the administrator 
can view. If the group is of another type, the page displays data modules that can be configured.  

3. Two methods are available for configuring the data access rights to data modules. The 
following information takes setting the data access rights to Real-Time Monitoring, and setting 
the access rights to report templates, as examples.  

Configuring the access rights to Real-Time Monitoring 

1. On the Data Privilege Configure page, click the Real-Time Monitoring link.  

The page updates to display all monitors in Real-Time Monitoring. The Monitor Name column 
displays the names of monitors. 

2. Do one of the following: 

 Click the box next to a monitor to allow the operators in the operator group to access the 
monitor. 

 Clear the box next to a monitor to prevent the operators in the operator group from 
accessing the monitor. 

 Click the box next to Monitor Name to allow operators in the operator group to access all 
monitors. 

3. From the Access Right list for a monitor name, select the access right of the operator group: 

 Select Read Only to allow operators in an operator group to only view the current monitor 
and change the background color of the monitor graphs. 

 Select Read/Write to allow operators to modify the current monitor and customize the four 
configuration items. 

4. Click OK. 

Set access rights of report template 

1. On the Data Privilege Configure page, click Set access rights of report template. 

The page updates to display all report templates.  

Report Template List 

 Template Name—Contains the name of the system-defined or user-defined template. 

 Type—Contains the type of report that is generated by the associated template. 

 Definition Type—Identifies the source of the template. Template sources include Custom 
or Pre-defined reports. 

2. Do one of the following: 

 Click the box next to a template to allow operators in the operator group to use the template. 

 Clear the box next to a template to prevent the operators in the operator group from using 
the template. 

 Click the box next to Template Name to allow operators in the operator group to use all 
templates. 

3. Click OK. 

Copying an operator group 

1. Navigate to System > Operator Group: 

a. Click the System tab from the top tabular navigation system. 

b. Click Operator Management on the left navigation tree. 

c. Click Operator Group under Operator Management on the left navigation tree. 

IMC displays all operator groups in the Operator Group List displayed in the main pane of the 
System > Operator Group window. 

2. Click the Copy icon  in the Operator Group List associated with the operator group you 
want to copy. 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 8577



176 

3. Modify the group name as needed in the Group Name field. 

4. Select a privilege level from the Privilege list. 

Options are ADMIN, Maintainer, and Viewer. The Operation Privileges list vary by the 
selected privilege level. The following operation privileges are available only when ADMIN is 
selected: Operator Management, Group Management, and System Settings. Maintainers 
have less permissions than administrators. Viewers have the least permissions among all 
operators. 

Modify the description as needed in the Description field. 

5. Click the Expand All icon  to view all Operator Privileges. 

6. Do one of the following: 

 Deselect any privileges you want to revoke for this operator group by clicking the checked 

box  to remove the check mark. 

 To add privileges, select the associated privilege check box . 

7. Click OK to create a copy of the operator group. 

Modifying an operator group 

1. Navigate to System > Operator Group: 

a. Click the System tab from the top tabular navigation system. 

b. Click Operator Management on the left navigation tree. 

c. Click  Operator Group under Operator Management on the left navigation tree. 

IMC displays all operator groups in the Operator Group List displayed in the main pane of the 
System > Operator Group window. 

2. Click the Modify icon  in the Operator Group List associated with the operator group you 
want to modify. 

3. Modify the group name as needed in the Group Name field. 

4. Select a privilege level from the Privilege list. 

Options are ADMIN, Maintainer, and Viewer. The Operation Privileges list vary by the 
selected privilege level. The following operation privileges are available only when ADMIN is 
selected: Operator Management, Group Management, and System Settings. Maintainers 
have less permissions than administrators. Viewers have the least permissions among all 
operators. 

5. Modify the description as needed in the Description field. 

6. Click the Expand All icon to view all Operator Privileges. 

7. Do either of the following: 

 Deselect any privileges you want to revoke for this operator group by clicking the checked 

box  to remove the check mark. 

 To add privileges, select the associated privilege check box . 

8. Click OK. 
 

 NOTE: 

An operator group cannot be modified while members of the group are online. All members of a 
group must be logged off before changes to the Operator Group can be completed. Administrators 
or operators with ADMIN privileges can log users off using the Online Operators feature in IMC. For 
more information, see "Managing online IMC operator access." 
 

Deleting an operator group 

1. Navigate to System > Operator Group: 
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a. Click the System tab from the top tabular navigation system. 

b. Click Operator Management on the left navigation tree. 

c. Click Operator Group under Operator Management on the left navigation tree. 

IMC displays all operator groups in the Operator Group List displayed in the main pane of the 
System > Operator Group window. 

2. Click the Delete icon  in the Operator Group List associated with the operator group you 
want to delete. 

3. Click OK to confirm deletion of the selected operator group. 
 

 NOTE: 

An operator group cannot be deleted while members of the group are online. All members of a 
group must be logged off before any changes to the Operator Group can be completed. For more 
information about logging operators off, see "Managing online IMC operator access." 
 

Securing IMC access through authentication services 
To further secure access to IMC and to support unified username and password management, IMC 
supports the use of login authentication services for RADIUS, LDAP, and TACACS. 

Configuring IMC to use RADIUS authentication services 

Only administrators or operators who are members of a group with the ADMIN privilege level can 
configure RADIUS authentication services.  

To configure RADIUS authentication: 

1. Navigate to System > Authentication Server: 

a. Click the System tab from the top tabular navigation system. 

b. Click Operator Management on the left navigation tree. 

c. Click Authentication Server under Operator Management on the left navigation tree. 

The Authentication Server configuration page opens. 

2. In the RADIUS Server area, configure the following parameters: 

 Authentication Type—Select the RADIUS authentication type, PAP or CHAP, from the list 
under RADIUS Server. This choice must match the authentication type configured on the 
RADIUS server. 

 Primary Server—Enter the IP address or host name of the primary RADIUS server. 

 Secondary Server—Enter the IP address or host name of the secondary RADIUS server. 

 Authentication Port—Enter the port number used by the RADIUS server for authentication 
in the field. The default port number is 1812. 

 Shared Secret—Enter the shared secret for authentication packets. What is configured 
here must match what is configured on the RADIUS server.  

 Advanced Settings—Click Advanced Settings, and then configure whether to enable the 
Synchronize Radius Operator feature in the dialog box that opens. 

 To enable the Synchronize Radius Operator feature, select Synchronize Radius 
Operator. Enter the Vendor ID and Vendor type of the RADIUS server, set the data type 
and data value of the match contents, select an operator group from the Operator 
Group list, and then click Add Match Rule to add match rules. If the operator does not 
exist but passes the Radius authentication and the rules are matched, the system saves 
the operator information to the operator group. 

 To disable the Synchronize Radius Operator feature, clear Synchronize Radius 
Operator. 
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3. Click OK. 

Configuring IMC to use LDAP authentication services 

Only administrators or operators who are members of a group with the ADMIN privilege level can 
configure LDAP authentication services.  

To configure LDAP authentication: 

1. Navigate to System > Authentication Server: 

a. Click the System tab from the top tabular navigation system. 

b. Click Operator Management on the left navigation tree. 

c. Click Authentication Server under Operator Management on the left navigation tree. 

The Authentication Server configuration page opens. 

2. In the LDAP Server area, configure the following parameters: 

 LDAP Version—Select the LDAP version, 2 or 3 from the list. The option selected here 
must match the configuration of the LDAP server. 

 Server Type—Select LDAP server type from the list. IMC supports Generic LDAP 
Services as well as Microsoft Active Directory. 

 Server Address—Enter the IP address or host name of the LDAP server in the field 
provided. 

 Server Port—Enter the port number used by the LDAP server for authentication in this field. 
The default port number is 389. 

 Base DN—Enter the Base DN value to be used for communication with the LDAP server. 
The Base DN must match what is configured on the LDAP authentication server. 

 Admin DN—Enter the Admin DN value to be used for communication with the LDAP server. 
The Administrator DN must match what is configured on the LDAP authentication server. 

 Admin Password—Enter the Admin password to be used for communication with the 
LDAP server. The admin password must match what is configured on the LDAP 
authentication server. 

 Username Attribute—Enter the username attribute to be used for obtaining user 
information from the LDAP server. The username attribute must match what is configured 
on the LDAP authentication server. 

 Advanced Settings—Click Advanced Settings, and then configure whether to enable the 
Synchronize LDAP Operator feature in the dialog box that opens. 

 To enable the Synchronize LDAP Operator feature, select Synchronize LDAP 
Operator. Enter an OU in the OU field, select an operator group from the Operator 
Group list, and then click Add Match Rule to add match rules. If the operator does not 
exist but passes the LDAP authentication and the rules are matched, the system saves 
the operator information to the operator group. 

 OU: Part of the LDAP user entry that identifies the operator group of the user on 
the LDAP server. 

 Operator Group: Operator group on the system that matches the OU. 

 Operation: Allows you to define access rights to user groups, devices groups, and 
custom views for a synchronized operator. Synchronized operators and manually 
added operators use the same method for defining access rights. A synchronized 
operator will be deleted when the synchronization rule is deleted. 

 To disable the Synchronize LDAP Operator feature, clear Synchronize LDAP 
Operator. 

 Require Security Connection (SSL)—Specifies whether to use an SSL security 
connection for connecting to the LDAP server. 
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 Authentication File Configure—This field is available only when you select Require 
Security Connection (SSL). Click Authentication File Configure, click Browse in the 
dialog box that opens to select a certificate, and then click Upload. 

A certificate is an authentication file for securely connecting to the LDAP server. Without a 
certificate, a security connection cannot be established to the LDAP server. 

3. Click OK. 

Configuring IMC to use TACACS authentication services 

Only administrators or operators who are members of a group with the ADMIN privilege can 
configure TACACS authentication services. 

To configure TACACS authentication: 

1. Navigate to System > Authentication Server: 

a. Click the System tab from the top tabular navigation system. 

b. Click Operator Management on the left navigation tree. 

c. Click Authentication Server under Operator Management on the left navigation tree. 

The Authentication Server configuration page opens. 

2. In the TACACS Server area, configure the following parameters: 

 Authentication Type—Select a TACACS authentication type. Options are ASCII, PAP, and 
CHAP. 

 TACACS Server—Enter the IP address or host name of the TACACS server. 

 Authentication Port—Enter the authentication port number of the TACACS server. The 
default is 49. 

 Shared Secret—Enter the shared key for identity authentication. It must be the same as the 
shared key configured on the TACACS server. 

3. Click OK. 

Packets are encrypted by default during TACACS authentication. 

Securing IMC through operator login control templates 
IMC extends the concept of access control to the desktop by enabling you to permit or deny operator 
access to IMC based on individual IP addresses as well as IP address ranges. These login control 
templates can then be applied to operator accounts to permit or deny IMC access to IMC based on 
the individual operator's IP address. 

Viewing the login control template list  

1. Navigate to System > Login Control Template: 

2. Click the System tab from the top tabular navigation system. 

3. Click Operator Management on the left navigation tree. 

4. Click Login Control Template under Operator Management on the left navigation tree. 

The Login Control Template page opens. 

Login control template list 

 Login Control Name—Contains the name assigned to the login control template. 

 Start IP—Contains the IP address that defines the first IP address in the range of IP addresses 
controlled by this template. 

 End IP—Contains the IP address that defines the last IP address in the range of IP addresses 
controlled by this template. 

 Action—Identifies what action is taken by the login control template. The two options for login 
control templates are Permit and Deny. 
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 Description—Contains a description for the associated login control template. 

 Modify—Contains an icon for navigating to the Modify page for the associated login control 
template. 

 Delete—Contains an icon for navigating to the Delete page for the associated login control 
template. 

Adding a login control template 

Only you or operators who are members of a group with the ADMIN privilege level can manage Login 
Control Templates.  

To add a login control template: 

1. Navigate to System > Login Control Template: 

a. Click the System tab from the top tabular navigation system. 

b. Click Operator Management on the left navigation tree. 

c. Click Login Control Template under Operator Management on the left navigation tree. 

The Login Control Template page opens. 

2. Click Add. 

3. Enter the following information in the Login Control Template window: 

a. Enter the name of the login control template in the Login Control Name field. 

b. Enter the first IP address in the address range you want to permit or deny access to in the 
Start IP field. If you are entering a single IP address, enter the same address in the Start IP 
and the End IP address fields. 

c. Enter the last IP address in the address range you want to permit or deny access to in the 
End IP field. If you are entering a single IP address, enter the same address in the Start IP 
and the End IP address fields. 

d. Select the action you want to implement for this IP address or IP address range from the 
Action list. Options include Permit, which enables IMC access from any IP address in the 
specified range, and Deny, which prohibits IMC access from any IP address in the specified 
range. 

e. Enter a description for this login control template in the Description field provided. 

4. Click OK. 

Modifying a login control template 

Changes to login control lists take effect the next time the operators affected by the template log in.  

To modify a login control template: 

1. Navigate to System > Login Control Template: 

a. Click the System tab from the top tabular navigation system. 

b. Click Operator Management on the left navigation tree. 

c. Click Login Control Template under Operator Management on the left navigation tree. 

The Login Control Template page opens. 

2. Click the Modify  icon in the Login Control Template List associated with the login control 
template you want to modify. 

Login Control Template names cannot be changed once the template has been created. 

3. Modify the first IP address in the address range as needed in the Start IP field.  

If you are entering a single IP address, enter the same address in the Start IP and the End IP 
address fields. 

4. Modify the last IP address in the address range as needed in the End IP field.  

If you are entering a single IP address, enter the same address in the Start IP and the End IP 
address fields. 
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5. Select the action you want to implement for this IP address or IP address range from the Action 
list.  

Options include Permit, which enables IMC access from any IP address in the specified range, 
and Deny, which prohibits IMC access from any IP address in the specified range. 

6. Modify the description for this login control template in the Description field provided. 

7. Click OK. 

Deleting a login control template 

1. Navigate to System > Login Control Template: 

a. Click the System tab from the top tabular navigation system. 

b. Click Operator Management on the left navigation tree. 

c. Click Login Control Template under Operator Management on the left navigation tree. 

The Login Control Template page opens. 

2. Click the Delete icon  in the Login Control Template list associated with the login control 
template you want to delete. 

Click OK to confirm deletion of the selected template. 
 

 NOTE: 

Deleting a login control template does not affect operators who are already logged in. 
 

Establishing IMC password strategies 
IMC provides you with the ability to globally define password policies for IMC passwords when local 
or IMC passwords are used to authenticate operators to IMC. 

With IMC password strategy feature, you can apply minimum length, password complexity and 
expiration to all passwords globally. Once applied, password strategies apply to all newly created 
operators of IMC, effective immediately. 

Password expiration policies do not apply to the IMC Administrator account that is created at 
installation. Administrator passwords never expire. 

Configuring a password strategy 

1. Navigate to System > Password Strategy: 

2. Click the System tab from the top tabular navigation system. 

3. Click Operator Management on the left navigation tree. 

4. Click Password Strategy under Operator Management on the left navigation tree. 

The Configure Password Strategy page opens. 

5. Enter the following information in the Configure Password Strategy page. 

a. Select the desired password minimum length from the Min. Length list.  

Options include passwords that have a length of 6, 8, 10, or 14 characters as well as 
passwords that cannot have zero length or Cannot Be Zero. The default setting is Cannot 
Be Zero. 

b. Select the desired password complexity strategy from the Complexity list.  

Options include: 

 No Requirement 

 Must Contain Letters and Numbers 

 Must Contain Special Characters (see Table 14) 

 Must Contain Letters, Numbers, and Special Characters 
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The default setting is No Requirement. 

c. Select the length of time for which passwords are valid in the Validity Period list.  

Options are Permanent, 30 days, 60 days, 90 days, and 12 Months. The default setting is 
Permanent. 

6. Click OK. 

Changes to password strategies do not affect operators who have established accounts prior to 
the implementation of or changes to IMC password strategies. Changes take effect immediately 
for all newly created operators. 

Table 14 Special characters 

Character Name Character Name 

~ Tilde ' Apostrophe 

! Exclamation mark @ At sign 

# Pound sign $ Dollar sign 

% Percent sign ^ Caret 

& Ampersand * Asterisk 

( ) Parenthesis = Equal sign 

+ Plus sign | Vertical bars 

- Hyphen _ Underscore 

[ ] Square brackets { } Braces 

: Colon ; Semicolon 

\ Backslash " Double quotation 

, Comma / Forward slash 

. Dot < > Angle brackets 

? Question mark   
 

Managing IMC operators 
The individual operator account is where all of the features you have used to grant or restrict access 
to operator accounts converge. These features include the creation of operator groups, custom 
views, and device groups. Once these are created, you can grant or restrict access and 
management rights to network resources using them when they configure individual operator 
accounts. 

With operator accounts, you assign to each operator membership in an operator group and access 
and management rights to device views and groups.  

 Adding an operator to the administrator group grants that operator rights to all devices, all 
device groups and all views, without exception. 

 To use views and device groups to manage rights and restrictions to IMC, you must add 
operators to either the maintainer or the viewer group. 

The sum of operator privileges and restrictions configured in add or modify operator account pages 
determines what devices become visible to each operator in IMC through custom device views or 
IMC system defined views.  

Operators only view information and features for devices over which they have rights. The rights and 
restrictions in operator accounts determine which performance reports, alarms, and other IMC 
management and reporting views and features operators can view. 
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You are ready to begin creating individual operator accounts, once you: 

 Have created the operator groups that grant or restrict access to IMC features that match the 
IMC access requirements of your support organization. 

 Know which operators need rights to manage which network resources, users and services. 

 Have created the device groups and Level 1 custom views as needed. 

For more information about adding devices and views, see "Resource management." 

Viewing the operator list 

1. Navigate to System > Operator: 

a. Click the System tab from the top tabular navigation system. 

b. Click Operator Management on the left navigation tree. 

c. Click Operator under Operator Management on the left navigation tree. 

The Operator page is displayed and a list of all operators is displayed on this page. 

 Login Name—Contains the IMC user ID or name of the operator. 

 Full Name—Contains the first and last name for the associated operator. 

 Authentication Type—Contains the method of authentication configured for the 
associated operator. Possible values for this field include Password, RADIUS, or 
LDAP. When the value is set to Password, you can use both the login name and the full 
name to login. 

 Operator Group—Identifies to which IMC operator group the associated operator 
belongs. 

 Description—Contains a description for the associated operator. 

 Modify—Contains an icon for navigating to the Modify page for the associated 
operator. A user that uses a non admin account cannot modify an admin account and 
the Modify link for the admin account is not available for this user. 

 Delete—Contains an icon for navigating to the Delete page for the associated operator. 

You can sort the Operator List by the Login Name, Full Name, Authentication Type, 
Operator Group, and Description fields. Click the column label to sort the list by the 
selected field. The column label is a toggle switch that allows you to toggle between the 
various sort options specific to each field. 

If the operator list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Operator List. 

 Click  to page forward to the end of the Operator List. 

 Click  to page backward in the Operator List. 

 Click  to page backward to the front of the Operator List. 

 Click 8, 15, 50, 100, or 200 at the bottom of the list to configure how many items per 
page to display. 

Querying operators 

1. Access the Operator page. 

2. To perform a basic query, enter a login name in the field in the upper right corner of the page. 

3. To perform an advanced query, do the following: 

a. Click the Advanced icon . 

b. Specify one or more of the following search criteria: 
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 Login Name—Enter a partial or complete login name. 

 Full Name—Enter a partial or complete full name. 

 Operator Group—Select the group name of the operators by which you want to filter 
the operator list from the Operator Group list. 

 Description—Enter a partial or complete description. 

c. Click Query. 

The operator list displays operators that match the specified criteria. 

Click Reset to restore the full operator list. 

Adding an administrator group operator 

1. Navigate to System > Operator: 

a. Click the System tab from the top tabular navigation system. 

b. Click Operator Management on the left navigation tree. 

c. Click Operator under Operator Management on the left navigation tree. 

The Operator page is displayed and a list of all operators is displayed on this page. 

2. Click Add. 

3. Enter a valid login name in the Login Name field.  
 

 NOTE: 

Login name can include alphanumeric characters, underscores (_), and hyphens (-). As a best 
practice, do not use any spaces in a login name, because this can cause problems with LDAP and 
RADIUS authentication. 
 

4. Enter the operator's first and last name in the Full Name field. 

5. Select the password authentication type from the Authentication Type list.  

Options are: IMC local Password, RADIUS, and LDAP. 

You must configure the IMC Authentication Service module for LDAP and RADIUS before 
operators can authenticate using either one of these forms of authentication. 

6. If you are using IMC local password feature, enter the operator's password in the Password 
field. 

7. If you are using IMC local password feature, re-enter the operator's password in the Confirm 
Password field. 

The Idle Timeout (Minutes) option allows you to configure how long IMC sessions remain 
open and active while not in use. 

8. Select Same as System Settings if you want to apply system wide settings to this operator 
account. 

9. Select Configure Individually.  

The page updates to include a field next to the Idle Timeout list.  

10. Enter the idle timeout in minutes in this field. 

11. Select the Administrator Group from the Operator Group list.  

12. Select from the pre-defined IMC operator groups or configure your own.  

To create and configure your own operator group, see "Adding an operator group." 
 

 NOTE: 

When assigning an operator to the Administrator Group only, you are assigning that operator all 
IMC privileges to all services within IMC and to all devices groups and views. This does not apply 
when creating operators that belong to the Maintainer or Viewer group as rights to views and 
groups can be assigned in the individual operator account. 
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13. Enter a brief description for this operator in the Description field. 

14. Select the Default Access Control Strategy you want to apply to this operator by clicking the 

appropriate radio button . 

15. If you want to apply a login control template or rule to this operator, click Add. 

16. If you have already created a login control template, click the radio button  to the left of 
Select from Existing Templates. 

17. Select the login control template you wish to apply to this operator by clicking the radio button 

 to the left of the Login Control Name you want to select. 

18. Click OK.  

19. If you have not already created a login control template, click the radio button  to the left of 
Manually Add to add an access control rule.  

For more information about creating a login control template, see "Securing IMC through 
operator login control templates." 

20. Enter the following information in the Add Access Control Rule dialog box: 

 Start IP—Enter the first IP address in address range you want to permit or deny access to in 
the field. If you are entering a single IP address, enter the same address in the Start IP and 
the End IP address fields. 

 End IP—Enter the last IP address in address range you want to permit or deny access to in 
the field. If you are entering a single IP address, enter the same address in the Start IP and 
the End IP address fields. 

 Action—Select the action you want to implement for this IP address or IP address range, 
Permit or Deny from the list. 

 Description—Enter a description for this login control template in the field provided. 

21. Click OK to complete the Login Control List configuration. 

If you enter more than one login control into the Login Control List for an operator, the Web 
page updates to include a Change Priority field. This field allows you to define the order or 
priority for execution of login control list entries.  

Entries at the top of the list are treated with a higher priority than those below it.  

22. To move a login control entry up or down in priority, do one of the following: 

 To move a login control entry up in priority, click the up arrow  associated with that 
entry. 

 To move it down, click the down arrow  associated with that entry. 

23. Click OK to accept the operator configuration. 
 

 NOTE: 

You cannot change the login name once you create the operator account. 
 

Modifying an administrator group operator 

1. Navigate to System > Operator: 

a. Click the System tab from the top tabular navigation system. 

b. Click Operator Management on the left navigation tree. 

c. Click Operator under Operator Management on the left navigation tree. 

The Operator page is displayed and a list of all operators is displayed on this page. 

2. Click the Modify icon  in the Operator list associated with the operator you want to modify. 

You cannot change the login name once you create the operator account.  
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3. Modify the operator's first and last name in the Full Name field. 

4. Modify your selection for password authentication type from the Authentication Type list as 
needed.  

Options are IMC local Password, RADIUS, or LDAP. 

You must configure the IMC Authentication Service module for LDAP and RADIUS before 
operators can authenticate using either one of these forms of authentication. 

5. If you are using IMC local password feature, modify the operator's password in the Password 
field as needed. 

6. If you are using IMC local password feature, re-enter the operator's password in the Confirm 
Password field. 

7. Modify the Idle Timeout (Minutes) option as needed. 

8. Select Same as System Settings if you want to apply system wide settings to this operator 
account. 

9. Select Configure Individually.  

The page updates to include a field next to the Idle Timeout list. Enter the idle timeout in 
minutes in this field. 

10. Modify the description for this operator in the Description field as needed. 

11. Select the Default Access Control Strategy you want to apply to this operator by clicking the 
appropriate radio button. 

12. If you want to apply a login control template or rule to this operator, click Add. 

13. If you have already created a login control template, click the radio button  to the left of 
Select from Existing Templates. 

14. Select the login control template you wish to apply to this operator by clicking the radio button 

 to the left of the Login Control Name you want to select. 

15. Click OK.  

16. If you have not already created a login control template, click the radio button  to the left of 
Manually Add to add an access control rule.  

For more information about creating a login control template, see "Securing IMC through 
operator login control templates." 

17. Enter the following information in the Add Access Control Rule page: 

 Start IP—Enter the first IP address in address range you want to permit or deny access to in 
the field. If you are entering a single IP address, enter the same address in the Start IP and 
the End IP address fields. 

 End IP—Enter the last IP address in address range you want to permit or deny access to in 
the field. If you are entering a single IP address, enter the same address in the Start IP and 
the End IP address fields. 

 Action—Select the action you want to implement for this IP address or IP address range, 
Permit or Deny from the list. 

 Description—Enter a description for this login control template in the field provided. 

18. Click OK to complete the Login Control List configuration. 

If you enter more than one login control into the Login Control List for an operator, the Web 
page updates to include a Change Priority field. This field allows you to define the order or 
priority for execution of login control list entries. Entries at the top of the list are treated with a 
higher priority than those below it.  

19. To change the priority of a login control entry, do one of the following: 

 To move a login control entry up in priority, click the up arrow  associated with that 
entry.  
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 To move it down, click the down arrow  associated with that entry. 

20. Click OK to accept your changes to the operator configuration. 

Adding an IMC maintainer or viewer group operator 

You can limit access to network resources managed by operators within IMC by assigning maintainer 
and viewer roles to operators. Some of the features that you can limit access to with these roles are 
custom views, location views and AP groups. 

To limit operator access to custom and location views, the views must be created prior to the creation 
of the operator account.  

Alternatively, you can create the operator accounts first and then return to complete the operator 
configuration after devices have been discovered, custom and location views created, and devices 
added to these views. 

To add a maintainer or viewer group operator: 

1. Navigate to System > Operator: 

a. Click the System tab from the top tabular navigation system. 

b. Click Operator Management on the left navigation tree. 

c. Click Operator under Operator Management on the left navigation tree. 

The Operator page is displayed and a list of all operators is displayed on this page. 

2. Click Add.  

The Add Operator page opens. 

3. Enter a valid login name in the Login Name field.  

Login name can include alphanumeric characters, underscores (_), and hyphens (-). 

4. Enter the operator's first and last name in the Full Name field. 

5. Select the password authentication type from the Authentication Type list.  

Options are IMC local Password, RADIUS, or LDAP. You must configure the IMC 
Authentication Server module for LDAP and RADIUS before operators can authenticate 
using these methods of authentication. 

6. If you have elected to use IMC local password feature by selecting Password from the 
Authentication Type list, enter the operator's password in the Password field. 

7. If you have elected to use IMC local password feature by selecting Password from the 
Authentication Type, re-enter the operator's password in the Confirm Password field. 

The Idle Timeout option allows you to configure for how long IMC sessions remain open and 
active while not in use. 

8. Select Same as System Settings if you want to apply system wide settings to this operator 
account. 

9. Select Configure Individually if you want to configure the Idle Timeout for this operator. Enter 
the idle timeout in minutes for this operator in the field next to the Idle Timeout list. 

10. Select the Maintainer or Viewer Group from the Operator Group list.  

The Operator Group list displays all currently configured operator groups.  

11. Select from the pre-defined IMC operator groups or configure your own. 

To create and configure your own operator group, see "Managing operator groups" or to 
configure this operator as a member of the Administrator Group, see "Adding an administrator 
group operator." 

A Maintainer has access to all operations except those reserved exclusively for administrators. 
Maintainers also have access to maintainer specific resources and certain system level 
information and resources. 

A Viewer also has access to specific resources but has read-only access to system level 
information and resources. 
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12. Enter a brief description for this operator in the Description field. 

13. You can configure the device groups and user groups to which operators have access. If you 
want the operator to have the ability to manage all device and user groups, click the Manage 

All Groups radio button  and skip to step 18. 

14. If you want the operator to manage only a selected subset of device and user groups, click the 

Define Manageable Groups radio button .  

The page updates to display the list of Managed Device Groups and Managed User Groups. 

15. Click the checkboxes  next to the Managed Device Groups for which you want to grant the 
operator access and control. 

16. Click the Expand icon  to view Managed User Groups. 

17. Click the checkboxes  next to the Managed User Groups for which this operator has 
management access and control. 

 To select all subgroups of a user group, click the Operation icon  for the user group and 
select Select All Child Nodes from the shortcut menu. 

 To de-select all subgroups of a user group, click the Operation icon  for the user group 
and select Unselect All Child Nodes from the shortcut menu. 

18. If you want the operator to have the ability to manage all custom views, click the Manage All 

Custom Views radio button  and skip to step 21. 

19. If you want the operator to manage only a selected subset of Custom Views, click the Define 

Manageable Custom Views radio button .  

The page updates to display the list of Manageable Custom Views. 

20. Click the checkboxes next to the Manageable Custom Views to which you want to grant this 
operator access and control. 

21. Select the Default Access Control Strategy you want to apply to this operator by clicking the 

appropriate radio button : Permit to permit access to IMC or Deny to deny access to IMC. 

22. Click Add if you want to use a Login Control Template to manage the operator's access to 
IMC. 

23. If you have already created a login control template, perform the following steps: 

a. Click the radio button  to the left of Select from Existing Templates. 

b. Select the login control template you want to apply to this operator by clicking the radio 
button  to the left of Login Control Name. 

c. Click OK. Skip now to Step 26. 

24. If you have not already created a login control template, click the radio button  Manually Add 
to manually create an access control rule. 

25. Enter the following information in the Add Access Control Rule page: 

a. Enter the first IP address in address range you want to permit or deny access to in the Start 
IP field. If you are entering a single IP address, enter the same address in the Start IP and 
the End IP address fields. 

b. Enter the last IP address in address range you want to permit or deny access to in the End 
IP field. If you are entering a single IP address, enter the same address in the Start IP and 
the End IP address fields. 

c. Select the action you want to implement for this IP address or IP address range, Permit or 
Deny from the Action list. 

d. Enter a description for this login control template in the Description field provided. 

e. Click OK to complete the access control rule configuration. 

26. Click the checkbox  next to Only NE Management could be used in the Network Element 
User section if you want to restrict operator access to network element management only. 
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27. If you want the operator to have the ability to manage all manageable Fit AP groups, click the 
Manage all Fit AP groups radio button  and skip to Step 29. 

28. If you want to select which fit AP groups the operator has access to and control over, perform 
the following steps: 

a. Click the Specify manageable Fit AP groups radio button . 

b. Click the checkboxes  to the left of Manageable Fit AP Groups for which this operator 
has management access and control. 

29. If you want the operator to have the ability to manage all Level 1 location views and the devices 
in these views, click the Manage all Level 1 Location Views radio button . 

30. If you want to select which Level 1 location views and the devices in them that the operator has 
access to and control over, perform the following steps: 

a. Click the Specify manageable Level 1 Location Views radio button . 

b. Click the checkboxes  to the left of Manageable Level 1 Location Views for which this 
operator has management access and control. 

31. Click OK to accept the operator configuration. 
 

 NOTE: 

You cannot change the login name once you create the operator account. 
 

Modifying a maintainer or viewer group operator 

1. Navigate to System > Operator: 

a. Click the System tab from the top tabular navigation system. 

b. Click Operator Management on the left navigation tree. 

c. Click Operator under Operator Management on the left navigation tree. 

The Operator page displays and a list of all operators displays on this page. 

2. Click the Modify icon  in the Operator list associated with the operator you want to modify. 

You cannot modify the name of an operator once you have created it. 

3. Modify the operator's first and last name in the Full Name field as needed. 

4. Modify the password authentication type by selecting the new setting from the Authentication 
Type list.  

Options are IMC local Password, RADIUS, or LDAP. You must configure the IMC 
Authentication Service module for LDAP and RADIUS before operators can authenticate 
using these methods of authentication. 

5. If you have elected to use IMC local password feature by selecting Password from the 
Authentication Type list, modify the operator's password in the Password field. 

6. If you have elected to use IMC local password feature by selecting Password from the 
Authentication Type, re-enter the operator's new password in the Confirm Password field. 

7. Modify the Idle Timeout setting as needed. 

8. Select Same as System Settings if you want to apply system wide settings to this operator 
account. 

9. Select Configure Individually if you want to configure the Idle Timeout for this operator.  

10. Enter the idle timeout in minutes for this operator in the field next to the Idle Timeout list. 

11. Modify the operator group as needed, selecting either Maintainer Group or Viewer Group.  

The Operator Group list displays all currently configured operator groups.  

12. Select from the pre-defined IMC operator groups or configure your own.  

To create and configure your own operator group, see "Managing operator groups." To 
configure this operator as a member of the Administrator Group, see "Adding an administrator 
group operator." 
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A Maintainer has access to all operations except those reserved exclusively for administrators. 
Maintainers also have access to maintainer specific resources and certain system level 
information and resources. 

A Viewer also has access to specific resources but has read-only access to system level 
information and resources. 

13. Modify the description for this operator as needed in the Description field. 

14. Modify which device groups and user groups operators have access to in the Managed 
Groups section.  

15. If you want the operator to have the ability to manage all device and user groups, click the 
Manage All Groups radio button  and skip to Step 18. 

16. If you want the operator to manage only a selected subset of device and user groups, click the 
Define Manageable Groups radio button .  

The page updates to display the list of Managed Device Groups and Managed User Groups. 

17. Do one or more of the following: 

 Click the checkboxes  next to the Managed Device Groups for which you want to grant 
operator access and control. 

 Click the checked boxes  next to the Managed Device Groups for which you want to 
revoke operator access and control. 

 Click the Expand icon  to view Managed User Groups. 

 Click the checkboxes next to the Managed User Groups for which the operator has 
management access and control. 

 Click the checked boxes  next to the Managed User Groups for which you want to revoke 
operator access and control. 

 To select all subgroups of a user group, click the Operation icon  for the user group and 
select Select All Child Nodes from the shortcut menu. 

 To de-select all subgroups of a user group, click the Operation icon  for the user group 
and select Unselect All Child Nodes from the shortcut menu. 

18. If you want the operator to have the ability to manage all Level 1 custom views, click the 
Manage All Custom Views radio button  and skip to Step 21. 

19. If you want the operator to manage only a selected subset of Level 1 Custom Views, click the 
Define Manageable Custom Views radio button .  

The page updates to display the list of Manageable Custom Views. 

20. Click the checkboxes next to the Manageable Custom Views to which you want to grant this 
operator access and control. 

21. Modify the Default Access Control Strategy setting as needed by clicking the appropriate 
radio button , Permit to permit access to IMC or Deny to deny access to IMC. 

22. Click Add if you want to use a Login Control Template to manage the operator's access to 
IMC. 

23. If you have already created a login control template, perform the following steps: 

a. Click the radio button  to the left of Select from Existing Templates. 

b. Select the login control template you want to apply to this operator by clicking the radio 
button  to the left of Login Control Name. 

c. Click OK. Skip now to Step 26. 

24. If you have not already created a login control template, click the radio button  to Manually 
Add manually create an access control rule. 

25. Enter the following information in the Add Access Control Rule page: 

a. Enter the first IP address in address range you want to permit or deny access to in the Start 
IP field. If you are entering a single IP address, enter the same address in the Start IP and 
the End IP address fields. 
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b. Enter the last IP address in address range you want to permit or deny access to in the End 
IP field. If you are entering a single IP address, enter the same address in the Start IP and 
the End IP address fields. 

c. Select the action you want to implement for this IP address or IP address range, Permit or 
Deny from the Action list. 

d. Enter a description for this login control template in the Description field provided. 

e. Click OK to complete the access control rule configuration. 

26. Click the checkbox  to the left of Only NE Management could be used in the Network 
Element User section if you want to restrict operator access to network element management 
only. 

27. If you want the operator to have the ability to manage all manageable Fit AP groups, click the 
Manage all Fit AP groups radio button . 

28. If you want to select which fit AP groups the operator has access to and control over, click the 
Specify manageable Fit AP groups radio button . 

29. Click the checkboxes  to the left of Manageable all Fit AP groups for which this operator 
has management access and control. 

30. Click the checked boxes  next to the Manageable Fit AP Groups for which you want to 
revoke operator access and control. 

31. If you want the operator to have the ability to manage all Level 1 location views and the devices 
in these views, click the Manage all Level 1 Location Views radio button  and skip to step 
34. 

32. If you want to select which Level 1 location views and the devices in them the operator has 
access to and control over, click the Specify manageable Level 1 Location Views radio 
button . 

33. Do one of the following: 

 Click the checkboxes  to the left of Manageable Level 1 Location Views for which this 
operator has management access and control. 

 Click the checked boxes  next to the Manageable Level 1 Location Views for which you 
want to revoke operator access and control. 

34. Click OK to accept the operator configuration. 

Deleting an IMC operator 

1. Navigate to System > Operator: 

a. Click the System tab from the top tabular navigation system. 

b. Click Operator Management on the left navigation tree. 

c. Click Operator under Operator Management on the left navigation tree. 

The Operator page is displayed with a list of all operators.  

2. Click the Delete icon  in the Operator list associated with the operator you want to delete. 

3. Click OK to confirm deletion of the operator. 
 

 NOTE: 

You cannot delete operators that are currently online, nor can you ever delete the administrator 
account. 
 

Sharing custom information between operators 

Use this function to share custom information of an operator with another operator, including home 
page widgets and favorites. Make sure operators have permissions to view shared custom 
information. 

To share custom information between operators: 
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1. Navigate to System > Operator: 

a. Click the System tab from the top tabular navigation system. 

b. Click Operator Management on the left navigation tree. 

c. Click Operator under Operator Management on the left navigation tree. 

The Operator page opens and displays all operators in a list. 

2. Click Copy Info. 

The Copy Info page opens. 

3. Select an operator from the Source Operator list. 

4. Select an operator from the Destination Operator list. 

5. Select one or more custom information entries in the Type area. 

6. Click OK. 

Modifying IMC passwords 
Individual IMC operators manage their own passwords once the operator account has been 
established. 

To change your password: 

1. Navigate to System > Modify Password: 

a. Click the System tab from the top tabular navigation system. 

b. Click Operator Management on the left navigation tree. 

c. Click  Modify Password under Operator Management on the left navigation tree. 

The Modify Password page opens. 

2. Enter the old password for the account that you are currently logged in as in the Old Password 
field. 

3. Enter the new password for the account that you are currently logged in as in the New 
Password field. 

4. Re-enter the new password for the account you are currently logged in as in the Confirm New 
Password field. 

5. Click OK. 

Managing online IMC operator access 
IMC offers you the ability to view which IMC operators are online, to log online operators off and also 
to block operator access for specific IP addresses when necessary. 

Viewing online operators 

To view which operators are currently online: 

1. Navigate to System > Online Operators: 

a. Click the System tab from the top tabular navigation system. 

b. Click Operator Management on the left navigation tree. 

2. Click Online Operators under Operator Management on the left navigation tree. 

The Online Operators page displays with the list of online operators. 

Online operator list 

 Login Name—Contains the IMC user ID or name of the operator. 

 Session ID—Contains the session ID number for the associated online operator. 

 Login Time—Contains the date and time stamp for the beginning of the operator's session. 
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 Login IP—Contains the IP address of the associated operator. 
 

 NOTE: 

Only administrators or operators who are members of a group with the ADMIN privilege level can 
manage online operators. 
 

Logging off online operators 

1. Navigate to System > Online Operators: 

a. Click the System tab from the top tabular navigation system. 

b. Click Operator Management on the left navigation tree. 

c. Click Online Operators under Operator Management on the left navigation tree. 

The Online Operators page is displayed with the list of online operators. 

2. Click the checkbox  next to the operator's login name that you want to log off. 

3. Click Log Off. 
 

 NOTE: 

Only administrators or operators who are members of a group with the ADMIN privilege level can 
log online operators off. Logging an operator off takes effect immediately. 
 

Blocking online operators 

Denying online operator access by blocking IP addresses creates a login control template for the 
operator that is blocked. This login control template becomes part of the operator's permanent 
configuration and once blocked, the operator no longer has access to IMC unless the login control 
template is removed from the operator account. 

To deny current and future operator access to IMC by blocking an IP address or address range for an 
operator: 

1. Navigate to System > Online Operators. 

a. Click the System tab from the top tabular navigation system. 

b. Click Operator Management on the left navigation tree. 

c. Click Online Operators under Operator Management on the left navigation tree. 

The Online Operators page is displayed with the list of online operators. 

2. Click the checkbox  next to the operator's login name that you want to block. 

3. Click Block IP. 
 

 NOTE: 

Only administrators or operators who are members of a group with the ADMIN privilege level can 
block IP addresses. 
 

Removing blocking from an operator account 

1. Navigate to System > Operator: 

a. Click the System tab from the top tabular navigation system. 

b. Click Operator Management on the left navigation tree. 

c. Click  Operator under Operator Management on the left navigation tree. 

The Operator page displays with a list of all operators. 

2. Click the Modify icon  in the Operator list associated with the operator for which you want 
to remove IP address blocking. 
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3. Locate the Login Control List section of the operator configuration. 

4. Locate the login control entry with the starting and ending IP address that you want to unblock. 

5. Click the Delete icon  next to the login control list entry that you want to delete. 

6. Click OK to complete the changes to the operator configuration. 

Group Management: managing resources using 
groups in IMC 

Group Management enables you to more simply and effectively organize and secure access and 
management rights over network resources managed by IMC. It also enables you to grant or restrict 
access to and management of network resources more easily by assigning operators rights by 
device, user, or service groups. 

A device can belong to one or more device groups. Note also that more than one operator can 
manage one or more groups. 

Device groups 
Device groups allow you to organize network devices by logical groups that you define. Groups can 
consist of devices of the same type, in the same location, or devices to be managed by the same 
operator or team within the organization. 

Device groups are one of the three features that IMC offers you for granting or restricting access to 
network resources managed by IMC. Create custom device groups and then add devices to the 
groups. Then assign operators rights to the device groups. This gives operators access and rights to 
manage only the devices in the groups to which they have been granted management access. 

Viewing device groups 

To view the list of all device groups in IMC: 

1. Navigate to System > Device Group: 

a. Click the System tab from the top tabular navigation system. 

b. Click Group Management on the left navigation tree. 

c. Click Device Group under Group Management on the left navigation tree. 

IMC displays all device groups in the Device Group List displayed in the main pane of the 
System > Device Group window. 

Device group 

 Group Name—Contains name for this device group. The Group name is an active link that 
navigates you to the Device Group Details page. The Device Group Details page 
contains information about the selected group including which operators have been granted 
privileges to the selected group. It also includes a list of all devices that are part of the 
selected group. 

 Description—Contains a description of this device group. 

 Device List—Contains a link for the list of devices in the selected group. 

 Modify—Contains a link for modifying the selected device group. 

 Delete—Contains an icon for deleting the selected group.  

If the Device Group List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Device Group List. 

 Click  to page forward to the end of the Device Group List. 
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 Click  to page backward in the Device Group List. 

 Click  to page backward to the front of the Device Group List. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

To view all devices in IMC, click the All Devices link  located in the far right corner of the 
Device Group List window. 

To view all devices in IMC that are not in a device group, click the Ungrouped Devices link 
. 

Querying the device groups 

Operators can search filter device groups by the label or IP address of the member devices 
contained in the groups. 

To query device groups: 

1. Navigate to System > Device Group: 

a. Click the System tab from the top tabular navigation system. 

b. Click Group Management on the left navigation tree. 

c. Click Device Group under Group Management on the left navigation tree. 

2. Enter the following parameters in the Query Device Group area: 

 Device Label—Enter the device label. IMC supports fuzzy matching for this field. For 
example, if you enter HPE, all device groups that contain a device with HPE in the label are 
queried. 

 Device IP—Enter the device label. IMC supports fuzzy matching for this field. For example, 
if you enter 172.0, all device groups that contain a device with 172.0 in the IP address are 
queried. 

3. Click Query. 

All device groups that match the query criteria are displayed on the Device Group List. From 
the list, you can view the member groups contained in each device group, add devices to a 
device group, or remove devices from a device group. 

4. Click Reset when you have finished your query to restore the full Device Group List. 

Viewing the device list 

Device lists provide operators with a list of all devices in a device group. 

To view the device list for a particular device group: 

1. Navigate to System > Device Group: 

a. Click the System tab from the top tabular navigation system. 

b. Click Group Management on the left navigation tree. 

c. Click Device Group under Group Management on the left navigation tree. 

2. Click the Device List icon  for the Device Group for which you want to view devices. 

The page updates to display the Device List for the associated device group. 

Device list 

 Status—Contains the current alarm status of the device. 

 Device Label—Contains the IMC name for this device. By default, the device name is the 
sysName or the configured name on the device. 

 Device Category—Contains the device category as categorized by IMC. 

 Device Model—Contains the device model. 
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 IP Address—Contains the IP address of the device. 

If the Device List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Device List. 

 Click  to page forward to the end of the Device List. 

 Click  to page backward in the Device List. 

 Click  page backward to the front of the Device List. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

Adding a device group 

1. Navigate to System > Device Group: 

a. Click the System tab from the top tabular navigation system. 

b. Click Group Management on the left navigation tree. 

c. Click Device Group under Group Management on the left navigation tree. 

IMC displays all device groups in the Device Group List displayed in the main pane of the 
System > Device Group window. 

2. Click Add. 

3. Enter the name for this device group in the Group Name field. 

4. Select an option from the Automatically Add New Devices list.  

The options include None, All, and From Network Segment. 

If you select None, newly added devices are not automatically added to the device group. If you 
select All, newly added devices are automatically added to the device group. If you select From 
Network Segment, newly added devices whose IP address fall into the specified address 
range are automatically added to the device group.  

If you select From Network Segment, go to step 5. If you select None or All, go to step 8. 

5. Enter the first IP address of the IP address range in the Start IP field. 

6. Enter the last IP address of the IP address range in the End IP field. 

7. Click Add to add the IP address range to the Network Segment list. 

8. Select an IP address range on the Network Segment list, and click Delete to delete the IP 
address range.  

9. Enter a description for this device group in the Description field. 

10.  To grant rights to this device group, click the checkbox  next to the operator's login name in 
the Operator list. 

11. Click OK. 
 

 NOTE: 

Only administrators or operators who are members of a group with the ADMIN privilege level can 
configure a device group. 
 

Modifying a device group 

1. Navigate to System > Device Group: 

a. Click the System tab from the top tabular navigation system. 

b. Click Group Management on the left navigation tree. 

c. Click Device Group under Group Management on the left navigation tree. 
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IMC displays all device groups in the Device Group List displayed in the main pane of the 
System > Device Group window. 

2. Click the Modify icon  in the Device Group List associated with the device group you want 
to modify. 

The Modify Device Group page opens. You cannot modify the name of a device group once 
you create it. 

3. Modify the description for this device group in the Description field. 

4. Do one of the following:  

 To grant rights to this device group, select the checkbox next to the operator's login name in 
the Operator list. 

 To revoke rights, clear the checked box next to the operator's name in the Operator list. 

5. Click OK. 

Deleting a device group 

1. Navigate to System > Device Group: 

a. Click the System tab from the top tabular navigation system. 

b. Click Group Management on the left navigation tree. 

c. Click Device Group under Group Management on the left navigation tree. 

IMC displays all device groups in the Device Group List displayed in the main pane of the 
System > Device Group window. 

2. Click the Delete icon  in the Device Group list associated with the device group you want 
to delete. 

3. Click OK to confirm deletion of the selected device group. 

Once you have created device groups, the next step is to add devices to them. 

Adding devices to a device group 

1. Navigate to System > Device Group: 

a. Click the System tab from the top tabular navigation system. 

b. Click Group Management on the left navigation tree. 

c. Click Device Group under Group Management on the left navigation tree. 

IMC displays all device groups in the Device Group List displayed in the main pane of the 
System > Device Group window. 

2. Click the Device List icon  displayed in the Device List column associated with the device 
group to which you want to add devices. 

The Device List page opens. 

3. Click Add. 

4. Select the devices you want to add to the device group.  

You can add devices by using either the View or Advanced query option.  

Removing a device from a device group 

1. Navigate to System > Device Group: 

a. Click the System tab from the top tabular navigation system. 

b. Click Group Management on the left navigation tree. 

c. Click Device Group under Group Management on the left navigation tree. 

IMC displays all device groups in the Device Group List displayed in the main pane of the 
System > Device Group window. 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 8599



198 

2. Click the Device List  icon for the device group you want to remove devices from. The 
Device List page opens. 

3. Click the Delete icon  associated with the device you want to remove from the group. 

4. Click OK to confirm deletion of the selected device. 

Removing multiple devices from a device group 

1. Navigate to System > Device Group: 

a. Click the System tab from the top tabular navigation system. 

b. Click Group Management on the left navigation tree. 

c. Click Device Group under Group Management on the left navigation tree. 

IMC displays all device groups in the Device Group List displayed in the main pane of the 
System > Device Group window. 

2. Click the Device List  icon for the device group you want to remove devices from.  

The Device List page opens. 

3. Click the checkbox to the left of the device names in the Device List for the devices you want to 
remove. 

4. Click Remove. 

5. Click OK to confirm deletion of the selected devices. 

Viewing the ungrouped devices list 

Devices that have not been added to a group are displayed in the Ungrouped Devices list. From 
this list, operators can add devices to groups, manage or unmanage devices, or delete them from 
IMC. 

To view the ungrouped devices list: 

1. Navigate to System > Device Group > Ungrouped Devices: 

a. Click the System tab from the top tabular navigation system. 

b. Click Group Management on the left navigation tree. 

c. Click Device Group under Group Management on the left navigation tree. 

The Device Group List is displayed. This list displays all device groups. 

2. Click the Ungrouped Devices link  located in the far right corner of the Device Group List. 

The Ungrouped Devices List is displayed. This list displays all devices that have not been 
added to a group. 

Ungrouped devices list 

 Status—Contains the current alarm status of the device. 

 Device Label—Contains the IMC name for this device. By default, the device name is the 
sysName or the configured name on the device. 

 Device Category—Contains the device category as categorized by IMC. 

 Device Model—Contains the device model. 

 IP Address—Contains the IP address of the device. 

If the ungrouped devices list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Ungrouped Devices List. 

 Click  to page forward to the end of the Ungrouped Devices List. 

 Click  to page backward in the Ungrouped Devices List. 
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 Click  to page backward to the front of the Ungrouped Devices List. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

Adding ungrouped devices to groups 

1. Navigate to System > Device Group > Ungrouped Devices: 

a. Click the System tab from the top tabular navigation system. 

b. Click Group Management on the left navigation tree. 

c. Click Device Group under Group Management on the left navigation tree. 

d. The Device Group List is displayed.  

This list displays all device groups. 

2. Click the Ungrouped Devices link  located in the far right corner of the Device Group List. 

The Ungrouped Devices List is displayed. This list displays all devices that have not been 
added to a group. 

3. Select the devices you want to add to a device group. 

The Join Group page displays along with all device groups in the Target Device Groups 
section of the Join Group page. 

4. Select the groups to which you want to add the devices. 

5. Click OK. 

The page updates with the results of the join group task. 

User groups 
Network infrastructure users are considered resources on the network in much the same way as 
devices and services are. Users require effective management to ensure to which they have access 
the network infrastructure resources they need when they need them.  

Network administrators need to ensure the integrity and security of the network infrastructure by 
ensuring that only valid users have access to network devices and services. 

Users groups within IMC simplify the administrator's task by allowing the administrator to group 
users in ways that meet the administrator's and the organization's needs. 

 Administrators can group users by access requirements, location, logical organization 
grouping, or more. 

 Administrators can create nested groups with multiple subgroups in much the same way that 
directory and file structures are organized. Nested groups automatically inherit the permissions 
of the parent group.  

 A user can belong to only one group. 

The best approach for managing user groups in IMC is to plan for and create user groups prior to 
adding users to IMC. 

Viewing the user group list 

1. Navigate to System > User Group: 

a. Click the System tab from the top tabular navigation system. 

b. Click Group Management on the left navigation tree. 

c. Click User Group under Group Management on the left navigation tree. 

IMC displays the top-level user groups in the User Group List displayed in the main pane of 
the System > User Group window. 

User group list 
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 Group Name—Contains the name of the user group. 

 Description—Contains a description for the associated user group. 

 User List—Contains an icon for accessing the User List for the associated user group. 

 Subgroups—Contains an icon for accessing the subgroups under this group. 

 Modify—Contains a link for modifying the selected user group. 

 Delete—Contains an icon for deleting the selected user group.  

If the user group list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the User Group List. 

 Click  to page forward to the end of the User Group List. 

 Click  to page backward in the User Group List. 

 Click  to page backward to the front of the User Group List. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

Adding a user group 

1. Navigate to System > User Group: 

a. Click the System tab from the top tabular navigation system. 

b. Click Group Management on the left navigation tree. 

c. Click User Group under Group Management on the left navigation tree. 

IMC displays the top-level user groups in the User Group List displayed in the main pane 
of the System > User Group window. 

2. Click Add. 

3. Enter the name for this user group in the Group Name field. 

4. Enter a description for this user group in the Description field. 

5. Select the operators to be granted rights to this user group from the Operators list. 

6. Click OK. 

Only administrators or operators who are members of a group with the ADMIN privilege level 
can add, modify, or delete a user group. 

Adding a user subgroup 

You can create nested subgroups under groups in much the same way that directory and file 
structures are organized. A user can belong to only one group. 

To add a subgroup to a user group: 

1. Navigate to System > User Group. 

a. Click the System tab from the top tabular navigation system. 

b. Click Group Management on the left navigation tree. 

c. Click User Group under Group Management on the left navigation tree. 

IMC displays the top-level user groups in the User Group List displayed in the main pane of 
the System > User Group window. 

2. From the User Group List, click the Subgroups icon  associated with the parent user 
group.  

3. Drill down into the various levels of subgroups until you reach the group to which you want to 
add a subgroup. 

4. Click Add. 
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5. Enter the name for this user group in the Group Name field. 

6. Enter a description for this user group in the Description field. 

7. Select the operators to be granted rights to this user group from the Operators list. 

You cannot revoke rights for operators that have been granted access to subfolders by rights 
they have inherited from the parent folder. 

Only administrators or operators who are members of a group with the ADMIN privilege level 
can add, modify, or delete user groups and subgroups. 

8. Click OK. 

Modifying a user group 

1. Navigate to System > User Group: 

a. Click the System tab from the top tabular navigation system. 

b. Click Group Management on the left navigation tree. 

c. Click User Group under Group Management on the left navigation tree. 

IMC displays the top-level user groups in the User Group List displayed in the main pane of 
the System > User Group window. 

2. Click the Modify icon  in the User Group List associated with the user group you want to 
modify. 

You cannot modify the name of a user group once the group has been created 

3. Modify the description for this user group in the Description field as needed. 

4. Select the operators to be granted rights to this user group from the Operators list. 

5. To revoke operator rights, clear the operator's login name from the Operators list. 

6. Click OK. 

Modifying a user subgroup 

1. Navigate to System > User Group: 

a. Click the System tab from the top tabular navigation system. 

b. Click Group Management on the left navigation tree. 

c. Click User Group under Group Management on the left navigation tree. 

IMC displays the top-level user groups in the User Group List displayed in the main pane of 
the System > User Group window. 

2. From the User Group List, click the Subgroups icon  associated with the parent user 
group.  

3. Drill down into the various levels of subgroups until you reach the subgroup that contains the 
subgroup you want to modify. 

4. Click the Modify icon  in the User Group List associated with the subgroup you want to 
modify. 

5. You cannot modify the name of a user group once the group has been created. 

6. Modify the description for this user group in the Description field as needed. 

7. Select the operators to be granted rights to this user group from the Operators list. 

8. To revoke operator rights, clear the operator's name from the Operators list. 

9. Click OK. 

Deleting a user group 

1. Navigate to System > User Group: 

a. Click the System tab from the top tabular navigation system. 

b. Click Group Management on the left navigation tree. 
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c. Click User Group under Group Management on the left navigation tree. 

IMC displays the top-level user groups in the User Group List displayed in the main pane of 
the System > User Group window. 

2. Click the Delete icon  in the User Group List associated with the user group you want to 
delete. 

3. Click OK to confirm deletion of the user group. 

Deleting a user subgroup 

1. Navigate to System > User Group: 

a. Click the System tab from the top tabular navigation system. 

b. Click Group Management on the left navigation tree. 

c. Click User Group under Group Management on the left navigation tree. 

IMC displays the top-level user groups in the User Group List displayed in the main pane of 
the System > User Group window. 

2. From the User Group List, click the Subgroups icon  associated with the parent user 
group.  

3. Drill down into the various levels of subgroups until you reach the group that contains the 
subgroup you want to delete. 

4. Click the Delete icon  in the User Group List associated with the user subgroup you want 
to delete. 

5. Click OK to confirm deletion of the user subgroup. 

Managing hierarchical NMS 

Lower-level NMS view 
When the IMC server is configured as a parent server, the lower-level network view displays the 
information about the lower-level NMS servers of the current IMC server as the upper-level NMS 
server. For more information about the lower-level NMS view, see "Managing the lower-level NMS 
view." 

IMC hierarchical alarm configuration 
You can aggregate alarms by forwarding alarms to other instances of IMC. For more information 
about configuring IMC to forward alarms in a hierarchical configuration of IMC, see "Managing 
hierarchical alarm settings." 

Configuring IMC for alarm notifications 
One of IMC powerful features is real time alarm or event management and notification. The following 
information covers the system settings that require review or configuration in order to meet your 
alarm notification and management needs. 

Mail server settings 
IMC can send mail notifications when problems arise in the network infrastructure, including when 
problems arise in IMC. Before support teams can receive mail notifications of such events from IMC, 
you must first to configure the mail server settings. 
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Configuring the default mail server settings 

You must configure the default SMTP mail server settings for mails sent by IMC to be forwarded. 

To configure the default SMTP mail server settings: 

1. Navigate to System > Mail Server Settings: 

a. Click the System tab from the top tabular navigation system. 

b. Click Mail Server Settings located in the lower right corner of the System Configuration 
section of the System page. 

The page updates to display the Mail Server Settings page. 

2. Select Default Mail Server. 

3. In the Server Address field, enter the IP address or hostname of the SMTP server to which 
IMC mail is forwarded. 

4. In the Server Port field, enter the port number of the SMTP server. 

The default value is 465 when Requires Security Connection (SSL) is selected and is 25 
when Requires Security Connection (SSL) is not selected. 

5. Click the checkbox  to the left of Requires Security Connection (SSL) if the SMTP server 
requires SSL authentication. 

6. Click the checkbox  to the left of Requires Authentication if the SMTP server requires 
authentication. 

7. If you have selected Requires Authentication, then enter the information for username and 
password. If you have not selected Requires Authentication, then skip these fields. 

a. Enter the username of the sender's mailbox in the Username field. 

b. Enter the sender's password in the Password field. 

c. Enter the mail address of the sender in the Sender's Mail Address field. 

d. Click Test Mailbox to confirm that the configuration you have entered works properly. 

8. Click OK. 

The authentication selection you make in IMC for SMTP mail server settings must match the 
configuration of the receiving SMTP server. 

Configuring the third-party mail server 

To configure a third-party mail server: 

1. Navigate to System > Mail Server Settings: 

a. Click the System tab from the top tabular navigation system. 

b. Click Mail Server Settings located in the lower right corner of the System Configuration 
section of the System page. 

The page updates to display the Mail Server Settings page. 

2. Select Third-Party Mail Server. 

3. Click OK. 

4. Implement the logic for mail sending by using the method defined in 
com.h3c.imc.res.mail.func.ThirdMailServerMgr. 

5. Open the commonThirdpartyAppContext.xml file in a text editor. The file is located in the 
/client/conf directory of the system installation path. In the file, add the class configuration 
information for implementing the com.h3c.imc.res.mail.func.ThirdMailServerMgr interface. 

6. Generate a JAR package of the implementing class, and store the package in the 
/client/repository/commonthirdparty/jars directory of the system installation path. 

7. Restart the system server. 
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After you have configured the mail server settings, configure mail notification rules by navigating to 
Alarm > Alarm Settings > Alarm Notification. For more information about configuring alarm 
message notifications through mails, see "Managing mail alarm notifications." 

SMSC settings 
IMC supports SMSC (Short Message Service Center) messaging for proactively alerting network 
administrators and support teams when problems in the network infrastructure arise. 

IMC can send SMS messages through the GSM modem, SMS center, third-party SMS sender, or 
Convert Mail into SMS sending method. IMC also supports configuring multiple SMSC templates. 
After SMSC templates are successfully configured, you can reference the SMSC templates in IMC 
when you perform SMSC settings for other components. 

GSM modem 

To send SMS messages through a GSM modem, the IMC server must be connected to the GSM 
modem. IMC displays the GSM modem configuration for IMC modules or components. You can 
modify the configuration as needed. 

To view the GSM modem list: 

1. Navigate to System > SMSC Settings. 

a. Click the System tab from the top tabular navigation system. 

b. Click the SMSC Settings icon  located in the System Configuration section of the 
System page. 

The SMSC Settings page opens. 

2. Select GSM Modem for Sending Method. 

The page displays the GSM modem list. 

GSM modem list 

 SMSC Name—Name of the IMC component or module that uses the SMSC. 

 Connect Using—Virtual port that connects the GSM modem to the SMSC server. 

 Baudrate (bps)—Communication rate between the GSM modem and the SMSC server. 

 Country Code—Code of a country or a region. 

 SMSC Number—SMSC number for the card issuer of the SIM card in the GSM modem. 

 Modify—Click the Modify icon  to modify an SMSC. 

 Delete—Click the Delete icon  to delete an SMSC. 

To modify an SMSC: 

1. Click the Modify icon  for the SMSC you want to modify. 

The Modify SMSC page opens. 

2. Modify the following parameters: 

 SMSC Name—Cannot be changed. 

 Connect Using—Select a communication port for the SMSC. 

 Baudrate—Select a communication rate for the SMSC. 

 Country Code—Enter a country or region code. 

 SMSC Number—Enter the SMSC number for the SIM card issuer of the GSM modem. 

To test the GSM modem setting changes: 

a. Click Test. 

b. In the Test GSM Modem Setting area, enter a cell phone number to receive the test SMS 
message in the Cell Phone Number field. 
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c. Click Test and view the test result in the upper right corner of the page. 

To hide the Test GSM Modem Setting area, click Cancel. 

3. Click OK. 

SMS sender 

When you use this sending method for the first time, obtain the serial number and password, and 
register with the SMS sender. 

To register with the SMS sender: 

1. Navigate to System > SMSC Settings. 

a. Click the System tab from the top tabular navigation system. 

b. Click the SMSC Settings icon  located in the System Configuration section of the 
System page. 

The SMSC Settings page opens. 

2. Select SMS Sender for Sending Method. 

The page displays the Internet connection information for IMC. Make sure the Internet 
connection information is configured correctly. 

To refresh the Internet connection information, click Refresh in the upper right corner of the 
Internet Connection Info area. 

To configure the Internet connection information, click Internet Connection Configuration in 
the upper right corner of the Internet Connection Info. 

3. Click Register Serial Number. 

The Register Serial Number page opens. 

4. Enter the serial number and password, and then click OK. 

Other SMS Sender 

The Other SMS Sender option is a third-party SMS sender. A third-party SMS sender can use the 
following access methods: custom access and general configuration access. 

General configuration access is applicable only to third-party SMS senders. It uses HTTP for access. 
The system sends simple HTTP requests that meet interface requirements to complete docking. 

General configuration access requires the following API development process: 

1. Select GET or POST for Sending Method. 

2. Select UTF-8 or GBK from Encoding Format. 

3. In Address, enter the URL. For a GET operation, use the format shown in this example: 
http://www.example.com:8080/path/serverServlet?mobile={smsNumber}&smsContent={smsC
ontent}. For a POST operation, use the format shown in this example: 
http://www.example.com:8080. 

4. For a POST operation, configure Attribute. 

5. Enter the test number in Test Number. 

6. Click Test to verify the configuration. 

7. Click OK. 

Custom access requires the following API development process: 

1. Implement the SMS sending method defined in com.h3c.imc.res.smsc.func.ThirdMsgMgr. 

2. Open commonThirdpartyAppContext.xml in a text editor. The file is located at the 
/client/conf directory in the IMC installation path. In the file, add the class configuration for 
implementing the com.h3c.imc.res.smsc.func.ThirdMsgMgr interface. 

3. Generate a .jar package of the implementing class, save the package to the 
/client/repository/thirdparty/jars directory of the IMC installation path, and then restart IMC. 
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Converting mails into SMS messages 

When the Convert Mail into SMS sending method is used, IMC sends mails without subjects to the 
recipient mail addresses that are in the format of mobile phone number@mail address suffix. The 
recipient mail addresses then convert the mail content into SMS messages and send the messages 
to the mobile phone numbers included in the recipient mail addresses. Make sure the recipient mail 
addresses support converting mails into SMS messages and sending the messages out. 

To convert mails into SMS messages: 

1. Navigate to System > SMSC Settings. 

a. Click the System tab from the top tabular navigation system. 

b. Click the SMSC Settings icon  located in the System Configuration section of the 
System page. 

The SMSC Settings page opens. 

2. Select Convert Mail into SMS for Sending Method. 

3. In the Receiver Mail Address Suffix field, enter a recipient mail address suffix. 

4. Click OK. 

Viewing SMS message sending records 

You can view records of SMS messages that are sent by using the SMS Sender, Other SMS Sender, 
and Convert Mail into SMS sending methods. 

To view SMS message sending records: 

1. Navigate to System > SMSC Settings. 

a. Click the System tab from the top tabular navigation system. 

b. Click the SMSC Settings icon  located in the System Configuration section of the 
System page. 

The SMSC Settings page opens. 

2. Click Sending Records. 

The Sending Records page opens. 

Sending Records list contents 

 Time—Time when the SMS message was sent. 

 Function Module—Component or module that sends the SMS message. 

 Cell Phone Number—Cell phone number of the SMS message recipient. 

 SMS Message Content—Content of the SMS message. This column is unavailable for 
operators who have no rights to access the SMS message content. 

 Result—Sending result of the SMS message. 

 Delete—To delete the SMS message record, click the Delete icon for the record. 

To delete SMS message sending records in batches, select sending records and click Delete. 

To quickly locate SMS message sending records, click Query. You can query SMS message 
sending records by various criteria, including the function module, start time, end time, cell 
phone number, SMS message content, and result. 

Integrating IMC alarms into other management systems 
IMC offers the ability to integrate alarms generated by IMC into other management systems. This is 
done by creating alarm rules for the events or conditions that you would like to forward to other 
management systems. 

It is better to create alarm forwarding rules after IMC has been configured with views, groups, and 
after devices have been added to IMC. 
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For more information about creating rules for forwarding alarms from IMC to other management 
systems, see "Managing alarm forwarding: Integrating with other management systems." 

MIB management 
Adding MIBs to IMC supports custom alarming and performance monitoring. To support this and 
other SNMP administrative tasks, IMC includes an integrated SNMP MIB browser. 

Adding a compiled MIB to IMC 
For MIBs to be usable by IMC, they must first be compiled. IMC provides hundreds of standard and 
custom or enterprise MIBs pre-compiled and pre-loaded into IMC.  

To add a compiled MIB to IMC: 

1. Navigate to System: 

a. Click the System tab from the top tabular navigation system. 

b. Click the MIB Management icon  in the Resource Management section of the System 
page. 

The dialog box for the SNMP MIB browser opens. 

2. Click the Load MIB Files icon  located in the navigation bar at the top of the MIB browser 
window. 

This displays the Load MIB Files dialog box. 

3. From the Compiled MIB File list, click the arrow  to expand the list of MIBs that are 
compiled but not currently loaded into IMC from the Unloaded MIB Group navigation tree 
located in the bottom half of the Load MIB Files dialog box. 

This displays the compiled unloaded MIB groups. 

4. Click the arrow  of the Unloaded MIB Group that contains the compiled MIB you want to 
add. 

5. Highlight the MIBs from the Unloaded MIB Group in the Compiled MIB File list that you want 
to load. 

6. Do one of the following: 

 Click the  button to load them. 

 Click the  button to load all of the displayed MIBs. 

The total number of files in the MIB tree cannot exceed 40. 

7. Click Close. 

Compiling a MIB in IMC 
1. Navigate to System: 

a. Click the System tab from the top tabular navigation system. 

b. Click the MIB Management icon  in the Resource Management section of the System 
page. 

The dialog box for the SNMP MIB browser opens. 
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2. Click the Load MIB Files icon  located in the navigation bar at the top of the MIB browser 
window. 

This displays the Load MIB Files dialog box. 

3. Click the Compile MIB Files icon . 

4. Click Browser to select the MIB you want to compile. 

5. Locate the MIB file or the compressed MIB file you want to compile and click Open from the File 
Upload dialog box. 

IMC can automatically compile all MIB files from the compressed file. 

6. Select the directory you want to store the compiled MIB in from the list of directories displayed in 
the Compile MIB Files dialog box. 

7. Click Compile. 

8. Review the results of the compiling process in the Compile Results dialog box. 

9. Specifically, check the Total # of MIB files compiled and the In all # compilations succeeded 
entries. 

If the compilation was not successful, fix the problems in the MIB file indicated by the Compile 
Results output and repeat the steps listed above until the MIB compiles successfully. 

Once you have successfully compiled the MIB you can load it into IMC following the steps provided 
in the previous section, "Adding a compiled MIB to IMC." If the MIB does not compile, please contact 
the MIB vendor for technical support. To expedite the issue, document the error message returned 
by the compile process. 

Removing a compiled MIB from IMC 
To remove a compiled MIB from IMC: 

1. Navigate to System: 

a. Click the System tab from the top tabular navigation system. 

b. Click the MIB Management icon  in the Resource Management section of the System 
page. 

The dialog box for the SNMP MIB browser opens. 

2. Click the Load MIB Files icon  located in the navigation bar at the top of the MIB browser 
window. 

This displays the Load MIB Files dialog box. 

3. From the Compiled MIB file list, click the arrow  to expand the list of MIBs that are currently 
loaded into IMC from the Loaded MIB Group navigation tree. 

This displays the compiled loaded MIB groups. 

4. Click the arrow  of the Loaded MIB Group that contains the compiled MIB you want to 
unload. 

5. Highlight the MIBs from the Loaded MIB Group in the Loaded MIB file list that you want to 
unload.  

 Click the  button to load the file you have highlighted. 

 Click the  button to unload all of the displayed MIBs. 
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6. Click Close. 
 

 NOTE: 

If you unload all MIBs, you need to manually reload them. The MIBs loaded by default at installation 
are located in the Default folder of the Compile MIB Files dialog box. 
 

Configuration center options 

Device capability set options 
The capability set displays support for TFTP, FTP, SFTP, and SCP transfer modes to complete the 
following operations on devices of different access methods in the configuration center: 

 Configuration backup 

 Configuration restoration 

 Software backup 

 Software upgrade 

To view the device capability set list: 

1. Navigate to Service > Options: 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Options under Configuration Center on the left navigation tree. 

The Options page opens. 

2. Click the Device Capability Set tab. 

Device Capability Set list contents 

 Device Name—Label of the device. 

 Device Model—Model of the device. 

 Operation Type—Type of the operation. 

 Access Method—Method that is used to access the device. 

 Support for TFTP—Whether the device supports the TFTP transfer mode. 

 Support for FTP—Whether the device supports the FTP transfer mode. 

 Support for SFTP—Whether the device supports the SFTP transfer mode. 

 Support for SCP—Whether the device supports the SCP transfer mode. 

If the Device Capability Set list spans multiple pages, use the following aids to navigate the 
list: 

 Click  to page forward in the Device Capability Set list. 

 Click  to page forward to the end of the Device Capability Set list. 

 Click  to page backward in the Device Capability Set list. 

 Click  to page backward to the front of the Device Capability Set list. 

 Select 8, 15, 50, 100, or 200 at the bottom of the list to configure how many items per page 
you want to display. 

3. To query device capability sets, specify the following query criteria: 

 Device Name—Enter a device label. This field supports fuzzy matching. 
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 Device Model—Enter a device model. This field supports fuzzy matching. 

 Operation Type—Select an operation type from the list. 

 Access Method—Select an access method from the list. 

4. Click Query to submit your filter criteria. 

The results of your filter or search query are displayed in the list below. 

Click Reset when you want to restore the full list. 

File transfer mode options 
Operators can configure the default transfer mode used in IMC configuration and change 
management tasks. Operators can select FTP, TFTP, SFTP, SCP, or SFTP Server as the default 
transfer method for all devices managed by IMC. Operators can also configure individual devices for 
a specific transfer mode using the Options features in the Configuration Center. 

To access and configure the transfer mode options for configuration and change management 
features in IMC: 

1. Navigate to Service > Options: 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Options under Configuration Center on the left navigation tree. 

d. On the Options page, click the File Transfer Mode tab. 

2. Select the transfer mode you want to configure as the default in the Default Transfer Mode 
section of the File Transfer Mode tab.  

Options include: 

 TFTP—By default, the TFTP mode is used. 

 FTP—This option does not limit the maximum file size limit. 

To use FTP, you must install a third-party FTP software on the IMC server that has been 
deployed with iCC, and must set server\tmp under the IMC installation directory as the root 
directory of the FTP service. 

In addition, you must enable the FTP service on the managed device and configure the user 
name and password for logging in to the FTP server. 

The user name and password configured in IMC must match what is configured on the FTP 
server for the managed device.  

 Set the FTP server to be accessed with its IP address and the loopback address 127.0.0.1. 

 SFTP—This option can be used for operators who prefer to use a secure transmission 
method. To transfer files using SFTP, you must enable the SFTP server on the managed 
device and configure the SSH parameters for the device in IMC. 

The login mode for a device using SFTP must be SSH, and the SSH parameters configured 
in IMC must be the same as those configured on the device. 

 SCP—This option can be used to transfer the configuration file from the device to the IMC 
server by using a secure transmission method. To transfer files using SCP, you must 
configure the login mode of the device as SSH in IMC, and configure the same SSH 
parameters in IMC and on the device. 

 SFTP Server—Select this option when the device does not support the SFTP server. To 
use SFTP Server, you must install a third-party SFTP server software on the IMC server, 
and you must set server\tmp under the IMC installation directory as the root directory of the 
SFTP server service.  

To ensure successful file transfer that goes through a NAT device, set the server_nat_ip value 
to the IP address of the NAT device in the qvdm.conf file in the \server\conf\ directory of the 
IMC installation path. 
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3. If you select FTP as the default transfer mode, you must enable the FTP transfer mode.  

To enable the FTP transfer mode: 

a. Select Enable FTP Transfer Mode. 

b. In the FTP User Name field, enter the user name for the FTP account configured on the 
managed devices that uses the Default Transfer Mode setting. 

c. In the FTP Password field, enter the password for the FTP account configured on the 
managed devices that uses the Default Transfer Mode setting. 

All devices that use the default transfer mode settings must have the same user name and 
passwords as configured in step 2 and step 3. 

4. If you select SFTP Server as the default transfer mode, you must enable the SFTP Server 
transfer mode. 

To enable the SFTP Server transfer mode: 

a. Select Enable SFTP Server Transfer Mode. 

b. In the SFTP User Name field, enter the user name for the SFTP account configured on the 
managed devices that uses the Default Transfer Mode setting. 

c. In the SFTP Password field, enter the password for the SFTP account configured on the 
managed devices that uses the Default Transfer Mode setting. 

5. IMC provides you with the ability to configure exceptions to the Default Transfer Mode 
configuration. Using the Single Device Transfer Mode option, you can configure one or more 
devices to use a different transfer mode configuration than the default. To use this feature, 
follow the steps below. Otherwise, click OK to complete your configuration of the Default 
Transfer Mode option for all devices in IMC. 

To set or cancel the single device transfer mode option for one or more devices:  

1. Click Select Device to configure the selected devices with specific transfer mode 
configurations. You can add devices by using either the View or Advanced query option.  

2. Click the checkbox  to the left of each device. 

3. Click Set Transfer Mode. 

The Set Transfer Mode dialog box opens. 

4. Select the transfer mode you want to use for each of the selected devices from the Transfer 
Mode list. 

5. Set the server IP address.  

6. Click OK. 

7. Select one or more devices, and click Delete to delete the single device transfer mode set for 
these devices. All devices that are not configured using the single device transfer mode adopt 
the default transfer mode. 

Backup policy options 
Operators can configure the backup policy options for individual devices managed by IMC. Options 
include Alarm Generation Mode, Max. Backup Configuration Files, Max. Backup 
Configuration History Days, and Email Configuration. 

Setting the alarm generation mode 

This option enables IMC to generate alarms or disables IMC from generating any alarm for individual 
devices when their configurations to be backed up are different from the baseline configurations or 
last configuration backups. 

To access and configure the Alarm Generation Mode option for individual devices in IMC: 

1. Navigate to Service > Options: 

a. Click the Service tab from the top tabular navigation system. 
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b. Click Configuration Center on the left navigation tree. 

c. Click Options under Configuration Center on the left navigation tree. 

The Options page opens.  

2. Click the Backup Policy tab. 

3. In the Set Type area, select Alarm Generation Mode. 

4. Do one of the following: 

If you do not want to configure one or more devices, skip to step 5. 

If you want to configure one or more devices to use the Generate alarms if the configuration 
to be backed up is different from the baseline policy, follow the steps below. 

a. If you select All devices except the selected ones will generate alarms in the Generate 
alarms if the configuration to be backed up is different from the baseline section, IMC 
generates alarms for all devices that are not listed when their configurations to be backed 
up are different from the baseline configurations. 

b. If you select Only the selected devices will generate alarms in the Generate alarms if 
the configuration to be backed up is different from the baseline section, IMC 
generates alarms for all listed devices when their configurations to be backed up are 
different from the baseline configurations. 

c. Click Select Device to select devices for the backup policy. 

5. Add devices by using either the View or Advanced query option.  

For more information, see "Adding devices by view" and "Adding devices by advanced query." 

To cancel the backup policy option for one or more devices:  

1. Click the Delete icon  next to each device. 

2. Click OK to accept your default and device specific backup policy options. 

Setting the max backup configuration files 

This option specifies the maximum number of backed up configuration files that IMC retains. For 
example, if you specify 5, IMC retains five running configuration files and five startup configuration 
files. The settings take effect at the next backup of the device. 

To access and configure the Max Backup Configuration Files option in IMC: 

1. Navigate to Service > Options: 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Options under Configuration Center on the left navigation tree. 

The Options page opens. 

2. Click the Backup Policy tab. 

3. In the Set Type area, select Max. Backup Configuration Files. 

4. Enter a value in the field next to Max. Backup Configuration Files. 

The value can be 0, or an integer ranging from 5 to 100. The value 0 indicates that the number 
of backed up configuration files is not limited. 

5. Click OK. 

Setting the max backup configuration history days 

This option specifies the maximum number of days that IMC retains backed up configuration files 
before deleting them. 

To access and configure the Max. Backup Configuration History Days option in IMC: 

1. Navigate to Service > Options. 

a. Click the Service tab from the top tabular navigation system. 
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b. Click Configuration Center on the left navigation tree. 

c. Click Options under Configuration Center on the left navigation tree. 

The Options page opens. 

2. Click the Backup Policy tab. 

3. Select Max. Backup Configuration History Days. 

4. Enter a value in the field next to Max. Backup Configuration History Days. 

The default value is 180. The value is in the range of 1 to 1825 (5 years). When the system 
manages small amount of devices, you can set a large value. 

5. Click OK. 

Configuring mail notification parameters 

When the mail notification feature is enabled, IMC automatically sends the backup result to the 
specified mail address after the auto backup plan is executed. 

To configure mail notification parameters: 

1. Navigate to Service > Options: 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Options under Configuration Center on the left navigation tree. 

The Options page opens. 

2. Click the Backup Policy tab. 
 

3. Select Mail Configuration. 

4. Configure the following parameters: 

 Send Auto Back Up Plan Report—Select this option to enable the mail notification 
feature. 

 Receiver Email Address—Enter the mail address of the operator that receives the auto 
backup plan report. 

5. Click OK. 

VPN Instance 
To back up a device enabled with VPN, configure a VPN Instance first: 

1. Navigate to Service > Options: 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Options under Configuration Center on the left navigation tree. 

The Options page opens. 

2. Click the VPN Instance tab. 

3. Select a device for which you want to configure a VPN Instance. 

4. Click Select Device. The Select Devices dialog box opens.  

5. Specify a VPN Instance name for the device. 

 Enter a VPN Instance name in the VPN Instance Name field of the target device. 

The VPN Instance name must be a string of 1 to 31 characters and cannot contain 
characters such as back slash (\), forward slash (/), colon (:), asterisk (*), question mark (?), 
quotation marks ("), left angle bracket (<), right angle bracket (>), and vertical bar (|). The 
VPN Instance name configured in IMC must be the same as that configured on the device. 
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 Or, select a device for which you want to configure the same VPN Instance and click Batch 
Configure. The VPN Instance dialog box opens. Enter the VPN Instance name in the VPN 
Instance Name field. 

6. Click OK. 

7. To delete a device, click Delete. 

8. Click OK. 

An example 
1. Enable SFTP and configure SSH parameters on the device. 

The configuration commands vary depending on the device model. For the configuration 
commands, see the user manual of the devices. The following uses an HPE ProCurve as an 
example: 
config  

password 

crypto key generate ssh rsa 

ip ssh 

ip ssh filetransfer 

aaa authentication ssh login local 

aaa authentication ssh enable local 

 

2. Add the device to a VPN Instance and specify the VPN Instance name. For more information, 
see "VPN Instance." 

3. Specify the file transfer mode of the device as SFTP.  

For more information, see "Adding a compiled MIB to IMC." 

4. Configure the login mode of the device as SSH in IMC and change the SSH parameters to the 
same as those on the device. For more information, see "Managing one device through device 
details." 

IMC system settings and maintenance functions 
To maintain the health and functioning of IMC, you may consider the following tasks:  

 Configuring system settings. 

 Exporting data to maintain the health and performance of IMC. 

 Understanding how operation log files work. 

 Customizing the IMC interface to meet your needs. 

System settings 
You can configure basic system settings to adjust basic IMC functioning and security.  

Modifying system settings 

1. Navigate to System > System Settings: 

a. Click the System tab from the top tabular navigation system. 

b. Click  System Settings located in the System Configuration section of the System 
page. 

The page is updated to display the System Settings page. 

2. Modify the configuration information displayed on the System Settings page. 
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Basic system settings 

To modify basic system settings: 

1. Enter the value in minutes in the Operator Idle Timeout field. This parameter allows the 
administrator to configure the default system-wide setting for how long IMC waits before 
logging out an operator account that is no longer active. The range is 1–9999999 minutes. The 
default setting is 30 minutes. 

2. Click OK. 

3. Select Allow or Prohibit from the Concurrent Logins with Same Operator Account list to 
globally permit or deny operators to have multiple, concurrent active sessions. The default is 
Allow. 

4. Click OK. 

5. To allow multiple users to log in by using the same operator account, enter the allowed 
maximum number in the Max. Concurrent Logins with Same Operator Account field. The 
range is 2 to 100. The default setting is 10. 

6. Click OK. 

7. Select an option from the Device Info Display list to configure how device information is 
displayed: by IP address, device label, or both. Options include Device Label (IP), Device 
Label Only, and IP Only. 

8. Click OK. 

9. Select Interface Description or Interface Alias from the Interface Info Display list to 
configure how interface information is displayed: by interface description or interface alias. 

10. Click OK. 

11. Enter the number of days in the Lifetime of Deleted Users field to retain deleted users before 
permanently removing them from IMC. The range is of 1 to 360 days. The default setting is 60 
days. 

12. Click OK. 

13. Select Plain Text or Ciphertext from the Display Access Passwords list to display or hide 
passwords (for example, Telnet/SSH password), SNMP community strings, or SOAP 
parameters. 

14. Click OK. 

15. Enter the number of days in the Task History Lifetime field to retain deleted task histories 
before permanently removing them from IMC. The range is of 1 to 730 days. The default setting 
is 180 days. 

16. Click OK. 

17. Enter the lock duration in minutes in the Lock Duration for Three Continuous Login Failures 
(1-1440 Minutes) field to lock a user who fails to log in from the same IP address after three 
continuous login attempts. The range is of 1 to 1440. The default setting is 1. 

18. Click OK. 

Ping configuration 

To configure ping: 

1. Enter the value in the Retry field to configure the maximum IGMP packets that IMC sends to the 
managed device for a ping test. The value range is of 1 to 20. The default value is 3. 

2. Enter the value in the Timeout field. This parameter allows you to configure how long, in 
seconds, IMC waits to receive a ping response from the ping request from the managed device 
before issuing a timeout. After the final failed ping request, IMC sets the device in an alarm 
state. The default value is 2. 

3. Click OK. 

Default device connection configuration 
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1. Enter the default Telnet port number in the Telnet Default Connection Port(1-65535) field. 
The range is 1 to 65535. The default setting is 23. 

2. Enter the default SNMP port number in the SNMP Default Connection Port(1-65535) field. 
The range is 1 to 65535. The default setting is 161. 

3. Click OK. 

NNMi configuration 

To configure NNMi: 

1. Configure the following NNMi parameters: 

 Server IP Address—This parameter allows you to configure the server IP address of NNMi 
for communications with IMC. 

 Server Port—This parameter allows you to configure which port NNMi uses for 
communications with IMC. 

 User Name—This parameter allows you to configure the username of NNMi for 
communications with IMC. 

 Password—This parameter allows you to configure the password of NNMi for 
communications with IMC. 

 Start a scheduled task to import devices from NNMi—This parameter allows you to 
select whether to start a scheduled task to import devices from NNMi.  

If a task is scheduled to import devices from NNMi, IMC obtains and imports device information 
from the NNMi server at the specified time.  

To schedule the task, open the file client\conf\platAppContext.xml in the installation path, 
search the platNNMiDeviceImportTrigger field, change the cronExpression attribute of the 
field, and restart IMC. 

The attribute supports the following parameters: second, minute, hour, date of a month, month 
of a year, and day of a week. An asterisk (*) means "all." A question mark (?) means "not set." 
By default, the task is executed at 01:10 every day, which corresponds to the cronExpression 
value 0 10 1 * * ?. 

2. Click OK. 

Device registration configuration 

To configure device registration: 

1. Enter the mail address of the Hewlett Packard Enterprise my.procurve.com website in the 
Email field, so that you can register the device with Hewlett Packard Enterprise by mail and get 
technical support from Hewlett Packard Enterprise. 

2. Click OK. 

Internet connection configuration 

To configure an Internet connection: 

1. Select Direct Connect, HTTP Proxy, or SOCKS Proxy from the Connection Type list to 
determine how IMC connects to the Internet. The default is Direct Connect. 

Use Direct Connect if IMC connection to the Internet is direct rather than through an Internet 
proxy server. 

If you are using a proxy server, whether it is an HTTP or SOCKS proxy, to provide access to the 
Internet, you must enter the proxy server IP address and port number. If the proxy server 
requires authentication, you must enter the user name and password. 

2. Click OK. 

Interface Up/Down alarm 

To configure interface Up/Down alarm: 

1. Configure the following interface up/down alarm filter parameters: 
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 Alarms for PC-connect links—This parameter allows you to select whether to filter 
interface Up/Down alarms for the interfaces that connect to PCs. 

 Alarms for server-connected links—This parameter allows you to select whether to filter 
interface Up/Down alarms for the interfaces that connect to servers or are located on 
servers. 

 Alarms for disconnected links—This parameter allows you to select whether to filter 
interface Up/Down alarms for the interfaces that have no physical connections. 

2. Click OK. 

Device label configuration 

To configure device label configuration: 

1. Configure the following device label parameters: 

 Device Label Type—This parameter allows you to select DNS Name or Sysname as the 
default label for the device.  

 Update Existing Device Labels—This parameter allows you to select whether to update 
all device labels by using the setting. 

 Update Device Label When Sysname Changes—This parameter allows you to select 
whether to update device labels when the devices' sysNames change. This parameter is 
available when you select Sysname for the device label use. 

2. Click OK. 

Device Location configuration 

To configure device location configuration: 

1. Configure the following device location parameters: 

 Update device location information in iMC when location information of devices 
changes—This parameter allows you to select whether to update device location in IMC 
when location information of devices changes. 

 Deploy device location information changes in iMC to devices—This parameter allows 
you to select whether to deploy device location information to devices when device location 
information in IMC changes. 

2. Click OK. 

Interface Alias configuration 

To configure interface alias configuration: 

1. Configure the following device location parameters: 

 iMC Update interface alias changes from devices to iMC—This parameter allows you to 
select whether to update interface alias in IMC when interface alias changes. 

 Deploy interface alias changes from iMC to devices—This parameter allows you to 
select whether to deploy interface alias to devices when interface alias in IMC changes. 

2. Click OK. 

DNS server settings 

To configure DNS server setting: 

1. Enter DNS addresses separated with semicolons (;) in the DNS Server List field. 

2. Click OK. 

Layer 2 topology configuration 

Configure the following Layer 2 topology parameters: 

 Enable STP Link Calculation—This parameter allows you to select whether to use STP 
neighbor information to calculate the physical topology of the network. As a best practice, do 
not enable this feature when STP transparent transmission exists in the network. The default 
setting is Yes. 
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 Enable MAC Intersection Check Among Neighbor Interfaces—This parameter allows you 
to select whether to enable MAC intersection check among neighbor interfaces when 
calculating links by using LLDP, NDP, or CDP neighbor information. Disable this feature when 
loops exist in the network where only LLDP, NDP, or CDP rather than STP can be used. The 
default setting is Yes. 

 Enable Inter-Routing Interface Link Calculation—This parameter allows you to select 
whether to calculate physical links between routing interfaces by using LLDP, NDP, or CDP 
neighbor information. The default setting is No. 

 Enable Realtime Location Extension—This parameter allows you to select whether to 
support third-party devices in real-time location. The default setting is No, which indicates that 
the real-time location function supports only H3C devices. Support for third-party devices in 
real-time location requires high Layer 2 network performance. 

 Enable DismanPing—This parameter allows you to enable or disable the DismanPing feature 
in IMC Network Topology. Enabling DismanPing can improve topology correctness. Not all 
devices support the DismanPing feature. For more information about DismanPing feature, see 
the device configuration manual. 

 Enable Forged Ping Packets—This parameter allows you to enable or disable the Forged 
Ping Packets feature. If the Forged Ping Packets feature is enabled, IMC periodically sends 
forged ping packets to devices that do not support the DismanPing feature or do not have 
DismanPing enabled. Then, the forged ping packets trigger the devices to send ARP broadcast 
packets, which can prevent some devices and links from failing to be detected due to MAC 
address aging. 

Forwarding IMC operation logs in syslogs 

To forward IMC operation logs in syslogs: 

1. Select Yes or No from the Enable Forwarding of IMC Operation Logs in Syslogs list to 
enable or disable forwarding of IMC operation logs in Syslog messages. The default setting is 
No. 

2. Enter the IP address in the Syslog Server IP field. IMC sends Syslogs to this server. 

3. Enter the port number in the Syslog Server Port field. The Syslog server uses this port to 
receive Syslogs. The default setting is 514. 

4. Click OK. 

Configuring browsers to save login usernames and passwords 

To configure browsers to save login usernames and passwords: 

1. Select Yes or No from the Configure browsers to save login usernames and passwords 
list to enable or disable login username and password saving in browsers. The default setting is 
Yes. 

Typically, a browser prompts you to save the password when you log in to IMC. Select No if you 
do not want to save the username and password. If you select Yes and the configuration for 
Configure browsers to save login usernames and passwords is No, the browser still saves 
the username and password. In this case, for the Configure browsers to save login 
usernames and passwords configuration (No) to take effect, manually clear the password 
saved in the browser. 

2. Click OK. 

Configuring SMS alarm statistics 

To configure SMS alarm statistics: 

1. Select Yes or No from the Enable Alarm Statistics SMS list to enable or disable the alarm 
statistics SMS. 

2. In the SMS Transmission Interval (minutes) field, enter a time interval value. 

The time interval value specifies the interval at which IMC sends a notification SMS. 

3. Select an alarm level from the Level Triggering System Failures list. 
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When the number of the unrecovered alarms of the specified alarm level and above is not zero, 
the SMS indicating system failures is sent. Otherwise, the SMS indicating system normality is 
sent. If you do not specify this field, the SMS indicating system failures is sent by default. 

4. Configure the telephone number that receives SMSs: 

a. In the Telephone Number field, enter a telephone number. 

b. Click Add. 

c. Repeat step a and step b to add more telephone numbers. 

To delete a telephone number, select the telephone number and click Delete. 

5. In the SMS for Correct System Operations field, enter the SMS content that is sent when the 
system operates correctly. 

The default content is System is operating correctly. 

6. In the SMS for System Failures field, enter the SMS content that is sent when system failures 
occur.  

When the SMS content includes the numbers of alarms, use the following characters to 
represent the number of alarms of different levels: ${critical} for critical alarms, ${major} for 
major alarms, ${minor} for minor alarms, ${warn} for warning alarms, and ${info} for 
informational alarms. The default content is Alarms: ${critical} critical alarms, ${major} 
major alarms, ${minor} minor alarms, ${warn} warning alarms, and ${info} informational 
alarms. 

Configuring the alarm SMS message title 

To configure the alarm SMS message title: 

1. In the Alarm SMS Message Title field, enter the beginning of the SMS message, for example, 
[Alarm]. This field can contain up to 127 characters.  

2. Click OK.  

Configuring the alarm SMS message content 

To configure the alarm SMS message content: 

1. From the Alarm SMS Message Content list, select Alarm Name or Details. When alarms are 
sent through SMS messages, the SMS message contents are the alarm names or details.  

2. Click OK.  

Configuring maintained object trap-to-alarm upgrade 

To configure maintained object trap-to-alarm upgrade: 

1. From the Enable Maintained Object Trap-to-Alarm Upgrade list, select Yes or No to specify 
whether to upgrade traps to alarms for devices or links with maintenance tags.  

2. Click OK.  

Configuring maintained object alarm forwarding 

To configure maintained object alarm forwarding: 

1. From the Enable Maintained Object Alarm Forwarding list, select Yes or No to specify 
whether to forward alarms generated on devices or links with maintenance tags.  

2. Click OK. 

Configuring the alarm mail forwarding feature 

To configure alarm mail forwarding: 

1. Select Yes or No from the Enable Alarm Acknowledgement Mail list to enable or disable 
alarm acknowledgement in mails. 

After this feature is enabled, each alarm notification mail will contain an alarm 
acknowledgement link. You can click the link to acknowledge the respective alarm. 

2. Click OK. 
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Configuring the auto forwarding recovered alarm feature 

To configure auto forwarding recovered alarm: 

1. Select Yes or No from the Auto Forwarding Recovered Alarm list to enable or disable auto 
forwarding recovered alarm. 

2. Click OK. 

Configuring the repeated alarm count feature 

To configure the repeated alarm count feature: 

1. Select Yes or No from the Enable Repeated Alarm Count list to enable or disable repeated 
alarm count. 

When repeated alarm count is enabled, the system counts repeated alarms and sends only one 
copy of the repeated alarms. You can view the number of alarm repetitions in the Repeat 
Count column of the alarm list. 

2. Click OK. 

Configuring license expiration mail notification settings 

For license expiration mail notification settings to take effect, make sure the mail server is correctly 
configured. 

To configure license expiration mail notification settings: 

1. Select Yes or No from the Enable Mail Notification list to enable or disable the license 
expiration mail notification. 

2. In the Mail Recipient field, enter a mail recipient that receives notification mails and click Add. 

The added recipient address is displayed in the area next to the Mail Recipient field. To add 
more recipient addresses, repeat this step. 

3. In the Notify Me before field, specify how many days before license expiration that the system 
begins to send notification mails. The value range is 1 to 90. 

4. Click OK. 

Writing operation logs into the IMC foreground log file 

To write operation logs into the IMC foreground log file: 

1. Select Yes or No from the Write operation logs into the imc foreground log file list to 
enable or disable writing operation logs into the /client/log/imcforeground.log file of the 
IMC installation path. 

2. Click OK. 

Scheduled offline device deletion 

To schedule offline device deletion configuration: 

1. Select Yes or No from the Enable Scheduled Offline Device Deletion list to enable or disable 
the scheduled offline device deletion. 

2. If you select Yes, set Offline Device Management Policy to Delete or Unmanage. 

3. In the Offline Device Hold Time field, enter a duration. 

If a device goes offline for a period that exceeds the specified duration, the device will be 
deleted or unmanaged depends on the specified offline device management policy. 

4. Click OK. 

Configuring routing information obtaining period 

To configure the routing information obtaining period: 

1. In the Period field, enter an integer in the range of 1 to 24. The default is 12.  

2. Click OK. 

AirWave System Config  
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IMC provides the entry to AirWave.  

To enter the AirWave system: 

1. Select Yes or No from the Enable list to enable or disable the AirWave system. 

2. If you select Yes, configure the parameters required for logging in to the AirWave system, 
including Protocol, IP, Port, Username, and Password. 

3. Click OK. 

4. Click the Service tab. 

5. Select AirWave HomePage > AirWave WLAN Mgmt from the shortcut menu to log in to the 
AirWave system. 

6. Click AirWave AP List > AirWave WLAN Mgmt from the shortcut menu to view the AP list in 
the AirWave system. 

Configuring the ClearPass server 

To configure the ClearPass server: 

1. Select whether to enable the ClearPass server. By default, the ClearPass server is disabled.  

2. When the ClearPass server is enabled, configure the ClearPass server parameters, including 
the IP address, username, password, client ID, grant type, and client secret. 

3. Click OK. 

Configuring the local system server CPU, memory, and disk alarm thresholds 

To configure the local system server CPU, memory, and disk alarm thresholds: 

1. In the CPU field, enter the CPU threshold in the range of 1 to 99. The default is 66.  

2. In the Memory field, enter the memory threshold in the range of 1 to 99. The default is 90. 

3. In the Disk field, enter the disk threshold in the range of 1 to 99. The default is 90. 

4. Click OK. 

Data export 
IMC stores event information in log files. Events turn to alarms, when there is a match in the content 
of a log to a system or user defined alarm rule. IMC enables you to manage the size of its database 
by writing alarms in the database to export logs and then storing exported data for a specified period 
of time. 

Once events are exported, they are removed from the event logs and from IMC processing. This 
feature enables you to manage the size and the performance of IMC database while also storing 
valuable data for post-export analysis, if needed. 

In addition to using Data Export to manage the size and performance of the IMC database, data from 
the Data Export process can be used as an input to other non-IMC data analysis processes. For 
example, you can import data exported by the Data Export process into a spreadsheet. 

The base platform of IMC offers you the ability to export data from the following IMC services or log 
files: 

 SCC – Attack Alarm 

 SMC – Event 

 Operation Log 

 Alarm Export 

 Trap Export 

 Alarm Forwarding 

 Guest Access Log 

 History Access Log 
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 Syslog 

 Device Updown Alarms 

 Interface Updown Alarms 

Syslog data can be exported either to HTML or CSV formats. 

To export IMC event logs:  

1. Navigate to System > Data Export Settings: 

a. Click the System tab from the top tabular navigation system. 

b. Click  Data Export located in the System Configuration section of the System page. 

The page is updated to display the Data Export Settings page. 

2. To select the IMC log file source, click the appropriate tab located at the top of the Data Export 
Settings window. 

3. Configure the following Data Export parameters as needed. 

Export triggers 

To limit the export of the selected log file to a specific number of entries: 

1. Click the checkbox  to the left of By Quantity.  

2. Enter the number of entries you want to export in the Threshold field. 

3. To export all events with the exception of the last x number of entries, enter the number of 
entries you want to exclude from export in the Export but the last field. 

4. Click the checkbox  to the left of By Time if you want to limit the export of the selected log 
file to a specific number of days. 

5. Enter the number of days you want to export in the Threshold field. 

6. To export all events with the exception of the last x number of days, enter the number of days 
you want to exclude from export in the Export but those in last field. 

If you select the By Quantity and By Time check boxes (which is the default configuration), 
IMC automatically uses the export criteria that contain more entries to export the data. 

 

 CAUTION: 

Modify the system time with caution. Modifying IMC system time may trigger a data export that 
removes events from IMC and may impair normal alarming of events. 
 

Export settings 

To export settings: 

1. Select the export file format you want to export from the Target File Type list. 

2. Enter the length of time you would like to save this file for in the Save File for field. 

3. If you want IMC to execute a command upon successful completion of the export, enter the 
command in the Execute Command After Export field.  

The command to be executed must be a batch file that does not invoke any GUI commands. 

The path and file name for the exported file can be found in the Target File Path field.  

4. Click the Change Export Directory link in the upper right corner. 

A popup dialog box opens. 

5. Enter the new file path in the Export Data to field.  

Make sure that the new file path already exists on the IMC master server. 

6. Click OK. 

The new file path is displayed in the Target File Path field. 

7. To view information on the last successful export, see the Last Export field. 
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8. To execute a data export immediately, click Export Immediately located to the far right of the 
Data Export Settings window. 

Data export considerations 

Data exports take effect only after the support IMC components have been installed and deployed. 
For example, the alarm export function takes effect only after the basic network management 
components are installed and deployed. 

Alarm exporting removes the recovered and acknowledged alarms from IMC. It does not remove 
unacknowledged or unrecovered alarms.  

Events can be exported only when its corresponding alarms have been exported. 

An example of the process for exporting By Quantity: 

 When the Threshold parameter is configured for 8000 entries and the Export but the last is 
configured for 500 entries, when the number of entries reaches 8000, all but the most current 
500 entries events are exported. 

An example of the process for exporting By Time:  

 When the Threshold parameter is configured for 60 days and the Export but those in last is 
configured for 30, when the number of days reaches 60 days, events for all but the last 30 days 
are exported. 

Data exports by default occur at 02:00:00 every morning. Make sure that the system server has 
adequate resources at 02:00:00 to process exports. To modify the export time, contact Hewlett 
Packard Enterprise Support. 

 To begin data exporting immediately, click Export Immediately. 

A command executed after the data export runs in the background service mode. Thus, you 
cannot open any window with this command, which automatically exits once it has finished. 

Log files 
IMC writes valuable system level and operator level information to log files. One such file is the 
operation log, which contains information about IMC operator activity.  

Viewing the operation logs 

To view operation logs: 

1. Navigate to System > Operation Log: 

a. Click the System tab from the top tabular navigation system. 

b. Click Operation Log located in the System Configuration section of the System page. 

The Operation Log list is displayed in the main pane. 

 Operator—Contains the name of the operator executing the operation documented in 
the log entry. 

 IP Address—Contains the IP address of the operator executing the operation 
documented in the log entry. 

 Module Name—Contains the name of the IMC module that generated the log entry. 

 Operation Time—Contains the date and time stamp for the log entry. 

 Operation—Contains a description of the operation, action, results, or text for the log 
entry. 

 Result—Contains the result of the operation documented in the log entry. Click the 
results link to view details for a single operation log entry. 

If the operation log list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Operation Log. 
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 Click  to page forward to the end of the Operation Log. 

 Click  to page backward in the Operation Log. 

 Click  to page backward to the front of the Operation Log. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

Querying operation logs 

To filter the operation log list: 

1. Navigate to System > Operation Log: 

a. Click the System tab from the top tabular navigation system. 

b. Click Operation Log located in the System Configuration section of the System page. 

The Operation Log list is displayed in the main pane. 

2. Click Query in the upper right corner of Operation Log list, and a search criteria dialog box 
opens. 

3. Enter the following parameters in the dialog box: 

 Operator—The name of the operator executing the operation documented in the log entry. 

 Started at—A start date and time by which you want to filter the operation log list in the text 
box. You can enter the date and time manually or you can enter it by clicking the field. A 
popup calendar is displayed. Select the start date from the calendar. Adjust the hour value 
as needed in the Started at field. 

 Ended at—An end date and time by which you want to filter the operation log list in the text 
box. You can enter the date and time manually or you can enter it by clicking field. A popup 
calendar is displayed. Select the end date from the calendar. Adjust the hour value as 
needed in the Ended at field. 

 IP Address—The IP address of the operator executing the operation documented in the log 
entry. 

 Module Name—The name of the IMC module that generated the log entry. 

 Result—The result of the operation documented in the log entry. 

 Syslogs—Select whether to display system logs. System logs are not displayed by default. 

 Web Service Logs—Select whether to display Web service logs. Web service logs are not 
displayed by default. 

 Operation—Enter the description of the operation, action, results, or text for the log entry.  

4. Click Query to submit your filter criteria. 

The results are displayed in the main pane. 

Adding chart templates 

Real-time statistics charts can be generated according to the operation logs.  

To add a chart template: 

1. Navigate to System > Operation Log: 

a. Click the System tab from the top tabular navigation system. 

b. Click Operation Log located in the System Configuration section of the System page. 

The Operation Log list is displayed in the main pane. 

2. Click Generate Chart in the upper part of the operation log list. Select Add Chart Template 
from the menu that appears.  

The Add Chart Template page opens.  

3. Configure the Basic Information area: 
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 Name—Enter the chart name.  

 Description—Enter the chart description.  

 Column Number—Select the number of charts displayed per column from the list. Options 
include 1 and 2. 

Chart List 

 Type—Type of the chart.  

 Title—Title of the chart.  

 Description—Description of the chart.  

 Parameters setting—Click the Parameters setting icon  to modify the parameters of 
the chart. 

 Delete—Click the Delete icon  to delete the chart.  

4. Click Add Chart.  

A dialog box opens.  

5. Select a chart type by clicking Select below Count Statistics Bar Chart or Count Statistics 
Pie Chart. 

A dialog box opens.  

6. Select a column name from the Select Column list to use the data of the column for generating 
charts.  

Options include all column names except Operation and Operation time of the Operation 
Log list. 

7. Enter the chart title in the Title field. 

8. Enter the chart description in the Description field. 

9. Click OK. 

The newly added chart is displayed on the Chart List. 

10. Click OK to complete adding the chart template.  

After a chart template is added, click Generate Chart in the upper part of the operation log list, and 
select the added chart template from the menu that appears to view the generated chart.  

Managing chart templates 

To manage an existing chart template: 

1. Navigate to System > Operation Log: 

a. Click the System tab from the top tabular navigation system. 

b. Click Operation Log located in the System Configuration section of the System page. 

The Operation Log list is displayed in the main pane. 

2. Click Generate Chart in the upper part of the Operation Log list, and select Manage Chart 
Template from the menu that appears. 

The Chart Template list displays all chart templates of the Operation Log module. 

3. Click Add to add a chart template. For more information about adding a chart template, see 
"Adding chart templates." 

Chart Template list 

 Name—Chart template name.  

 Description—Chart template description. 

 Modify—Click the Modify icon  for a chart template to modify the chart template. The 
procedure of modifying a chart template is similar to the procedure of adding a chart 
template. For more information, see "Adding chart templates." 

 Delete—Click the Delete icon  to delete the chart template.  
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Log configuration 
The system stores information about background processes in process running logs and iMF logs to 
help you identify and locate problems. You can also download process logs from the log 
configuration page. 

To access the log configuration page: 

1. Click the System tab. 

2. From the navigation tree, select System Configuration > Log Configuration. 

The Log Configuration page opens. 

Log configuration list contents 

 Process Name—Name of the background process.  

 Log Level—Severity level of logs. You can modify the log level. Options are DEBUG, INFO, 
WARN, ERROR, and FATAL. 

 Download Logs (Today)—Provides a download link that allows you to download today's 
running logs for the process and the IMC version information file. 

 iMF Logs—Provides a download link that allows you to download the iMF logs of the 
process and the IMC version information file. 

Server information 
The IMC Server Information function allows you to view the running status of the IMC server, 
including the IMC processes, CPU information, memory information, disk information, and database 
information. If IMC is deployed in distributed mode or deployed with a remote database, you can also 
view the running status of the master and subordinate servers or the remote database. 

Viewing IMC processes 

1. Navigate to System > IMC Server Info: 

a. Click the System tab from the top tabular navigation system. 

b. Click IMC Server Info located in the System Configuration section of the System page. 

The IMC Server Info page opens. By default, the Process tab is displayed. 

Process List 

 Process—Name of the IMC foreground or background service. 

 Description—Description for the process. 

 Status—Current status of the process: Started, Stopped, Starting, or Stopping. 

 Location—Location of the process. If IMC is deployed in centralized mode, this field 
displays Master server. If IMC is deployed in distributed mode, this field displays 
Master server and the IP addresses of the subordinate servers. 

 CPU(%)—CPU usage of the process. 

 MEM(KB)—Amount of the memory used by the process. 

 Start Time—Start time of the process. 

 Type—Type of the process: Core Process or Manageable Process. 

 Startup Mode—Startup mode of the process: Auto or Manual. 

Viewing CPU information 

1. Navigate to System > IMC Server Info: 

a. Click the System tab from the top tabular navigation system. 

b. Click IMC Server Info located in the System Configuration section of the System page. 

The IMC Server Info page opens. 
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2. Click the CPU Info tab. 

The tab displays the real-time CPU usage in a trend chart, as shown in Figure 117. 

Figure 117 CPU usage 

 
 

Viewing memory information 

1. Navigate to System > IMC Server Info: 

a. Click the System tab from the top tabular navigation system. 

b. Click IMC Server Info located in the System Configuration section of the System page. 

The IMC Server Info page opens. 

2. Click the Memory Info tab. 

The tab displays the real-time memory usage in a trend chart, as shown in Figure 118. 

Figure 118 Memory usage 

 
 

Viewing disk information 

1. Navigate to System > IMC Server Info: 

a. Click the System tab from the top tabular navigation system. 

b. Click IMC Server Info located in the System Configuration section of the System page. 

The IMC Server Info page opens. 

2. Click the Disk Info tab. 

The tab displays the following information: 

 Server—If IMC is deployed in centralized mode, this field displays Master and the disks on 
the server. If IMC is deployed in distributed mode, this field displays Master, the IP 
addresses of the subordinate servers, and the disks on each server. 

 Total Space(KB)—Total space of the disk. 

 Used Space(KB)—Used space of the disk. 

 Free Space(KB)—Free space of the disk. 

 Disk Usage—Usage of the disk. 

Viewing database information 

1. Navigate to System > IMC Server Info: 

a. Click the System tab from the top tabular navigation system. 

b. Click IMC Server Info located in the System Configuration section of the System page. 

The IMC Server Info page opens. 
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2. Click the Database Info tab. 

The tab displays the space usage for each database on the master server or each subordinate 
server in a stacked bar chart, as shown in Figure 119. 

Figure 119 Database info 

 
 

My Favorites 
IMC offers you the ability to customize IMC by storing frequently used IMC pages as favorites. For 
more information about this feature, see "Personalizing the IMC Web interface." 

Configuring network asset audit options 
IMC enables you to add devices to network asset management when devices are added to IMC. In 
addition, IMC enables you to configure how frequently automatic asset audit synchronization occurs.  

To configure the network asset audit settings: 

1. Navigate to Resource > Network Assets: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Network Assets on the left navigation tree. 

c. Click Options under Network Assets on the left navigation tree.  

The Options page opens. 

2. If you want to add all devices to the Network Asset Manager for asset auditing when you add 
devices to IMC, select Yes for Add devices to Network Assets when adding them to the 
iMC platform. 

3. Click OK to accept the configuration change. 

4. To configure number of days between the automatic synchronization or polling for audit details:  

a. Enter the number in days in the Auto Synchronization Interval field. The default is 1. 

b. Click OK to accept the configuration change. 

Work time settings 
IMC allows you to set the work time and view the performance data collected in specific work time. 
The work time settings contain the following: workdays, special workdays, and holidays.  

 Workdays are the days for work in a week, generally from Monday to Friday. You can further set 
the work hours for the workdays. You can divide workdays into short periods and configure a 
workday setting for each period. 

 Special workdays are the non-workdays that are specified as workdays.  

 Holidays are workdays that are specified as holidays. For example, May 1st. 

As a best practice, configure the work time settings in the following order: holidays, special 
workdays, and workdays. Configure the holidays based on the national and international holiday 
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conventions, and then configure the special workdays and workdays according to your 
organization's regulations and plans.  

Viewing the holiday configuration page 

To view the holidays:  

1. Navigate to System > Work Time Settings: 

a. Click the System tab from the top tabular navigation system. 

b. Click System Configuration on the left navigation tree. 

c. Click Work Time Settings under System Configuration on the left navigation tree.  

The Work Time Settings page opens. 

2. Click the Holiday tab.  

 Date—Contains the date of the holiday, in the format of YYYY-MM-DD.  

 Time Range—Contains the time ranges of the holiday. The free time ranges are displayed 
in green, and the working time ranges are displayed in gray.  

 Description—Contains a description of the holiday.  

 Modify—Contains a link for entering the page for modifying the holiday.  

 Delete—Contains a link for deleting the holiday.  

3. Click Refresh to update the Holiday page.  

Configuring a holiday 

You can define a specific date as a holiday, for example, May 1st.  

To configure a holiday:  

1. Navigate to System > Work Time Settings: 

a. Click the System tab from the top tabular navigation system. 

b. Click System Configuration on the left navigation tree. 

c. Click Work Time Settings under System Configuration on the left navigation tree.  

The Work Time Settings page opens. 

2. Click the Holiday tab.  

3. Click Add to enter the Add Holiday page. 

4. Enter the date of the holiday in the Date field, or click the field to select the date. The valid date 
format is YYYY-MM-DD. 

5. Enter a description of the holiday in the Description field. 

6. Select a holiday type. Options include Full-day and Partial.  

 Select Full-Day to set the whole day as a holiday, and then skip to step 10.  

 Select Partial to set part of the day as a holiday.  

7. Click Add in the Time Range List to launch the Add Time Range window. 

a. Select the start time from the Start Time list.  

b. Select the end time from the End Time list.  

8. Click OK to return to the Add Holiday page. 

9. Click the Delete icon  for a time range to delete the time range.  

Repeat steps 7 through 8 to add more time ranges.  

10. Click OK. 

Modifying a holiday 

1. Navigate to System > Work Time Settings: 

a. Click the System tab from the top tabular navigation system. 
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b. Click System Configuration on the left navigation tree. 

c. Click Work Time Settings under System Configuration on the left navigation tree.  

The Work Time Settings page opens. 

2. Click the Holiday tab.  

3. Click the Modify icon  for the holiday you want to modify.  

The Modify Holiday page opens.  

4. Enter the date of the holiday in the Date field, or click the field to select a date. The valid date 
format is YYYY-MM-DD.  

5. Enter a new description of the holiday in the Description field. 

6. Modify the holiday type. Options include Full-day and Partial.  

 Select Full-Day to set the whole day as a holiday, and then skip to step 10.  

 Select Partial to set part of the day as a holiday.  

7. Click Add in the Time Range List to launch the Time Range window. 

a. Select the start time from the Start Time list.  

b. Select the end time from the End Time list.  

8. Click OK to return to the Modify Holiday page. 

9. Click the Delete icon  of a time range to delete the time range.  

Repeat steps 7 through 8 to add more time ranges.  

10. Click OK. 

Deleting a holiday 

1. Navigate to System > Work Time Settings: 

a. Click the System tab from the top tabular navigation system. 

b. Click System Configuration on the left navigation tree. 

c. Click Work Time Settings under System Configuration on the left navigation tree.  

The Work Time Settings page opens. 

2. Click the Delete icon  for the holiday you want to delete. A confirmation dialog box opens. 

3. Click OK.  

Viewing the special workday configuration page 

To view the special workday configuration page: 

1. Navigate to System > Work Time Settings. 

a. Click the System tab from the top tabular navigation system. 

b. Click System Configuration on the left navigation tree. 

c. Click Work Time Settings under System Configuration on the left navigation tree.  

The Work Time Settings page opens. 

2. Click the Special Workday tab.  

The special workday configuration page opens.  

 Date—Contains the date of the special workday, in the format of YYYY-MM-DD.  

 Time Range—Contains the time ranges of the special workday. The work time ranges are 
displayed in green, and the free time ranges are displayed in gray.  

 Description—Contains a description of the special workday.  

 Modify—Contains a link for entering the page for modifying the special workday.  

 Delete—Contains a link for deleting the special workday.  

3. Click Refresh to update the Special Workday page.  
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Configuring special workdays 

You can define a non-workday as a special workday for a work shift.  

To configure a special workday: 

1. Navigate to System > Work Time Settings: 

a. Click the System tab from the top tabular navigation system. 

b. Click System Configuration on the left navigation tree. 

c. Click Work Time Settings under System Configuration on the left navigation tree.  

The Work Time Settings page opens. 

2. Click the Special Workday tab.  

3. Click Add to enter the Add Special Holiday page. 

4. Enter the date of the holiday in the Date field, or click the field to select a date. The valid date 
format is YYYY-MM-DD.  

5. Enter a description of the special workday in the Description field. 

6. Configure the work time ranges of the special workday: 

a. Click Add in the Time Range List to launch the Add Time Range window. 

b. Select the start time from the Start Time list.  

c. Select the end time from the End Time list.  

d. Click OK. 

Repeat steps a through d to add more working time ranges.  

Click the Delete icon  of a time range to delete the time range.  

7. Click OK. 

Modifying a special workday 

1. Navigate to System > Work Time Settings: 

a. Click the System tab from the top tabular navigation system. 

b. Click System Configuration on the left navigation tree. 

c. Click Work Time Settings under System Configuration on the left navigation tree.  

The Work Time Settings page opens. 

2. Click the Special Workday tab.  

3. Click the Modify icon  for the special workday you want to modify.  

The Modify Special Workday page opens.  

4. Enter the date of the holiday in the Date field, or click the field to select a date. The valid date 
format is YYYY-MM-DD.  

5. Enter a description of the special workday in the Description field. 

6. Configure the working time ranges for the special workday. 

a. Click Add in the Time Range List to launch the Add Time Range window. 

b. Select the start time from the Start Time list.  

c. Select the end time from the End Time list.  

d. Click OK. 

Repeat steps a through d to add more time ranges.  

Click the Delete icon  for a time range to delete the time range.  

7. Click OK. 
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Deleting a special workday 

1. Navigate to System > Work Time Settings: 

a. Click the System tab from the top tabular navigation system. 

b. Click System Configuration on the left navigation tree. 

c. Click Work Time Settings under System Configuration on the left navigation tree.  

The Work Time Settings page opens. 

2. Click the Special Workday tab. 

3. Click the Delete icon  for a special workday to delete the special workday.  

Viewing the workday configuration page 

1. Navigate to System > Work Time Settings: 

a. Click the System tab from the top tabular navigation system. 

b. Click Work Time Settings under System Configuration on the left navigation tree.  

The Work Time Settings page opens. 

2. Click the Workday tab. 

The workday configuration page opens. The workdays are scheduled into short work periods.  

 Name—Contains the name of the work period.  

 Start Date—Contains the start date of the work period.  

 End Date—Contains the end date of the work period.  

 Details—Contains the working time ranges of the workdays in the work period. Working 
time ranges are displayed in green. Free time ranges are displayed in gray.  

 Description—Contains a description of the workday.  

 Modify—Contains a link for entering the page for modifying the work period.  

 Delete—Contains a link for deleting the work period.  

3. Click Refresh to update the Workday page.  

Adding a work period 

Operators can add a work period and set the workdays and working time ranges for the work period. 

To add a work period: 

1. Navigate to System > Work Time Settings: 

a. Click the System tab from the top tabular navigation system. 

b. Click Work Time Settings under System Configuration on the left navigation tree.  

The Work Time Settings page opens. 

2. Click the Workday tab.  

3. Click Add to enter the Add Workday page. 

4. Enter the name of the work period in the Name field. 

5. Enter the date of the holiday in the Start Date field, or click the field to select a date. The valid 
date format is YYYY-MM-DD.  

6. Enter the date of the holiday in the End Date filed, or click the field to select a date. The valid 
date format is YYYY-MM-DD.  

7. Enter a description of the work period in the Description field. 

8. In the Work Time Settings area, configure the working time ranges of the workdays on a 
weekly basis. 

a. Click Add to launch the Add Time Range window.  

b. Select the days in a week that you want to set as workdays. Options include Monday 
through Sunday. 
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c. Select the start time of the working time range in each workday from the Start Time list.  

d. Select the end time of the working time range in each workday from the End Time list.  

e. Click OK.  

Repeat Steps a through e to add more working time ranges. Any two working time ranges 
cannot overlap with each other.  

f. Click the Delete icon  of a time range to delete the time range.  

9. Select workdays from special workdays as needed. 

 Enable—Allows operators to select workdays from existing special workdays. 

 Disable—Prohibits operators from selecting workdays from existing special workdays. 

If you select Enable, all existing special workdays are displayed in the special workday list.  

10. Select the desired special workdays from the list. 

11. Select workdays from holidays as needed. 

 Enable—Allows operators to select workdays from existing holidays. 

 Disable—Prohibits operators from selecting workdays from existing holidays. 

If you select Enable, all existing holidays are displayed in the holiday list.  

12. Select the desired holidays from the list.  

13. Click OK.  

Modifying a work period 

1. Navigate to System > Work Time Settings: 

a. Click the System tab from the top tabular navigation system. 

b. Click System Configuration on the left navigation tree. 

c. Click Work Time Settings under System Configuration on the left navigation tree.  

The Work Time Settings page opens. 

2. Click the Workday tab.  

3. Click the Modify icon  for the work period you want to modify.  

The Modify Workday page opens.  

4. Enter the name of the work period in the Name field. 

5. Enter a start date of the valid time range of the work period in the Start Date field, or click the 
field to select a start date. The valid date format is YYYY-MM-DD. 

6. Enter an end date of valid time range of the work period in the End Date field, or click the field to 
select an end date. The valid date format is YYYY-MM-DD.  

7. Enter a description of the work period in the Description field. 

8. In the Work Time Settings area, configure the working time ranges of the workdays on a 
weekly basis. 

a. Click Add to launch the Add Time Range window. 

b. Select the days in a week that you want to set as workdays. Options include Monday 
through Sunday. 

c. Select the start time of the working time range in each workday from the Start Time list.  

d. Select the end time of the working time range in each workday from the End Time list. 

e. Click OK.  

Repeat steps a through e to add more working time ranges. Any two working time ranges 
cannot overlap with each other.  

f. Click the Delete icon  of a time range to delete the time range.  

9. Select workdays from special workdays as needed. 
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 Enable—Allows operators to select workdays from existing special workdays. 

 Disable—Prohibits operators from selecting workdays from existing special workdays. 

If you select Enable, all existing special workdays are displayed in the special workday list.  

10. Select the desired special workdays from the list. 

11. Select workdays from holidays as needed. 

 Enable—Allows operators to select workdays from existing holidays 

 Disable—Prohibits operators from selecting workdays from existing holidays. 

If you select Enable, all existing holidays are displayed in the holiday list. 

12. Select the desired holidays from the list.  

13. Click OK.  

Deleting a work period 

1. Navigate to System > Work Time Settings: 

a. Click the System tab from the top tabular navigation system. 

b. Click System Configuration on the left navigation tree. 

c. Click Work Time Settings under System Configuration on the left navigation tree.  

The Work Time Settings page opens. 

2. Click the Workday tab. 

3. Click the Delete icon  of the work period you want to delete. A confirmation dialog box 
opens.  

4. Click OK. 

HTTPS access settings 
IMC allows you to configure HTTPS access. You can choose to enable only HTTPS access, and 
configure certificates. The system supports server-side authentication and mutual authentication. 
You can configure SSL authentication as required. 

A system reboot is required for the settings to take effect. 

To configure HTTPS access: 

1. Navigate to System > HTTPS Access Settings: 

a. Click the System tab from the top tabular navigation system. 

b. Click HTTPS Access Settings located in the System Configuration section of the 
System page. 

The HTTPS Access Settings page opens. 

2. Select enable or disable from the Enable only HTTPS access list. 

3. Select an access type for HTTPS Access Type, which can be Server-side Authentication or 
Mutual Authentication. 

4. For server-side authentication, upload the server-side certificate file and set the corresponding 
password. 

5. For mutual authentication, upload the server-side certificate file and client root certificate, and 
set passwords for the server-side certificate and client root certificate separately. 

6. Click OK, or click Restore Initial Value to reconfigure the settings. 
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LiveUpdate 
LiveUpdate allows you to view and download the latest software versions of HPE devices that are 
managed by IMC from the Hewlett Packard Enterprise website. Also, you can download the latest 
version of IMC installation software. 

 Device software update—Downloads the latest startup configuration and current 
configuration files for HPE devices that are managed in IMC. The downloaded configuration 
files are saved in iCC's device software library. Operators can update or replace software 
configuration using iCC's software deployment function. 

 IMC software update—Downloads the latest version of IMC installation software. For 
information about installing the IMC, see the HPE IMC deployment guides. 

Device software update 

To download the latest software versions for HPE devices: 

1. Navigate to LiveUpdate: 

a. Click the System tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click LiveUpdate under Resource Management on the left navigation tree. 

The LiveUpdate window opens. 

2. Select Device Software Update from the Type list. 

3. Click Next. 

The Check Internet Connection window opens. 

4. Check your network settings in the Internet Connection Info area or modify the settings for 
LiveUpdate: 

a. Click  Internet Connection Configuration next to the Internet Connection Info area. 

b. On the System Settings page, configure the network settings in the Internet Connection 
Configuration area.  

c. Click OK. 

5. To refresh the network settings, click the Refresh icon . 

6. Click Get Update List. 

LiveUpdate automatically obtains and lists latest software versions for all HPE devices 
managed in IMC. The software version list includes the device model, product code, software 

version, software release date, and the Details icon  that links to the release notes. 

7. Select the software versions you want to download and click Download. 

The Certificate of Export Eligibility and End User Agreement window opens. 

8. Click I AGREE. 

The Downloading file window opens, showing the download progress and results. All files are 
downloaded to the iCC Software Library.  

9. To deploy software, click Continue, click Device Software Update in the Update Operation 
window, and select target software versions in the Deploy Software window.  

10. To exit LiveUpdate, click Close. 

IMC software update 

To download the latest version of IMC software: 

1. Navigate to LiveUpdate: 

a. Click the System tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 
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c. Click LiveUpdate under Resource Management on the left navigation tree.  

The LiveUpdate window opens. 

2. Select IMC Software Update from the Type list. 

3. Click Next. 

The Check Internet Connection window opens. 

4. Check your network settings in the Internet Connection Info area or modify the settings for 
LiveUpdate: 

a. Click  Internet Connection Configuration next to the Internet Connection Info area. 

b. On the System Settings page, configure the network settings in the Internet Connection 
Configuration area. For more information, see "Modifying system settings." 

c. Click OK. 

5. To refresh the network settings, click the Refresh icon . 

6. Click Get Update List. 

On the Component Selection page, select the IMC software that you want to download. 

7. Click Next. 

LiveUpdate obtains and lists latest versions for the select IMC software. The version list 

includes the product code, component version, release date, and the Details icon  that link 
to the release notes. The manageable node limit of an IMC component is related with the 
product code. 

8. :Select the IMC software versions you want to download. 

Make sure the first six digits of the select product code are the same as your product number. 
Obtain your product number on the License Information page, which is accessed by clicking 
Activate on the IMC login page. 

9. Click Download. 

The Certificate of Export Eligibility and End User Agreement window opens. 

10. Click I AGREE. 

The Download List window opens, showing all select IMC software versions. 

11. Click the Download icon  for each IMC software version and select a path to save the file. 

12. To exit LiveUpdate, click Close. 

Device additional information 
Customize additional information as a supplement to the predefined basic information for devices. 
Customized additional information will be displayed on pages such as the device details page and 
the auto-deployment plan page. 

In addition, IMC also automatically adds customized additional information with the default values to 
all existing devices. Operators can modify the additional information for devices one by one on the 
Device Details page, or they can add or update additional information for devices in batches. For 
more information, see "Importing device additional information." 

Viewing the device additional information list 
1. Navigate to System > Device Additional Information: 

a. Click the System tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 
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c. Click Device Additional Information under Resource Management on the left navigation 
tree. 

IMC displays all device additional information fields in the Device Additional Information List 
of the Device Additional Information page. 

Device Additional Information List 

 Field Name—Contains the name of the additional information field.  

 Field Type—Contains the type of the additional information field. Field types include Integer, 
Number up to 5 decimal digits, Alphanumeric characters and {-_.@} only, Any 
Characters, and Custom options. 

 Field Property—Contains the property of the additional information field. Options are: 

 Cannot Be Null—The additional information field is required. 

 Can Be Null—The additional information field is optional. 

 Display Order—Contains the links for adjusting the display order of the additional information 
field.  

The display order of the additional information fields in the additional information list determines 
the order of appearance of the additional information fields on the Device Details page.  

Click the  icon for an additional information field to move it one position down. Click the  
icon for an additional information field to move it one position up. For the additional information 
field on the top of the list, the move up icon is unavailable . For the additional information field 

at the bottom of the list, the move down icon is unavailable . 

 Modify—Contains a link to enter the page for modifying the additional information field. For 
more information, see "Modifying a device additional information field." 

 Delete—Contains a link for deleting the additional information field. 

Adding a device additional information field 
1. Navigate to System > Device Additional Information: 

a. Click the System tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Device Additional Information under Resource Management on the left navigation 
tree. 

The device additional information list displays all device additional information fields in the 
main pane of the Device Additional Information page. 

2. Click Add to launch the Add Additional Information page. 

3. Enter the field name of the additional information in the Field Name field. 

4. Select a field property from the Field Property list. Options are: 

 Cannot Be Null—The additional information field is required. 

 Can Be Null—The additional information field is optional. 

5. Select a field type from the Field Type list: 

 Integer 

 Up to five decimal digits 

 Alphanumeric characters and {-_.@} only 

 Any Characters 

 Custom options 

6. Enter a default value for the additional information in the Default field. 

7. If you set the Field Type to Integer or Up to five decimal digits, perform the following: 
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a. Enter the maximum value allowed for the additional information field in the Max. Allowable 
Value field.  

b. Enter the minimum value allowed for the additional information field in the Min. Allowable 
Value field.  

8. If you set the Field Type to Alphanumeric characters and {-_.@} only, or Any Characters, 
enter the maximum length allowed for the additional information field in the Max. Length field. 

9. If you set the Field Type to Custom options, you must configure option list contents. 

To configure the option list contents: 

a. To add an option to the Added Options list, enter the option in the Option field, and then 
click Add. Repeat the above operations to add more options. The added options list must 
contain at least one item.  

b. To replace an existing option in the Added Options list with a new one, select the option, 
enter the new option in the Options field, and then click Modify. 

c. To delete a current option from the Added Options list, select the option and click Delete. 

d. To adjust the position of an option in the Added Options list, select the option, click Up to 
move the option one position up, or click Down to move the option one position down. 

e. To set an existing option as the default setting for the additional information field, select the 
option from the Added Options list, and then click Default. 

10. Click OK. 

The newly added additional information field is displayed in the Device Additional Information 
List. 

Modifying a device additional information field 
1. Navigate to System > Device Additional Information: 

a. Click the System tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Device Additional Information under Resource Management on the left navigation 
tree. 

The Device Additional Information List displays all device additional information fields in 
the main pane of the Device Additional Information page. 

2. Click the Modify  icon for the additional information you want to modify. The Modify 
Additional Information page opens.  

3. Enter a new name for the additional information field in the Field Name field. 

4. Select a field property from the Field Property list. Options are: 

 Cannot Be Null—The additional information field is required. 

 Can Be Null—The additional information field is optional. 

5. Select a field type from the Field Type list: 

 Integer 

 Up to five decimal digits 

 Alphanumeric characters and {-_.@} only 

 Any Characters 

 Custom options 

6. Enter a default value for the additional information in the Default field.  

7. If you set the Field Type to Integer or Up to five decimal digits, perform the following: 

a. Enter the maximum value allowed for the additional information field in the Max. Allowable 
Value field. 
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b. Enter the minimum value allowed for the additional information field in the Min. Allowable 
Value field. 

8. If you set the Field Type to Alphanumeric characters and {-_.@} only, or Any Characters, 
enter the maximum length allowed for the additional information field in the Max. Length field. 

9. If you set the Field Type to Custom options, you must configure option list contents.  

To configure the option list contents: 

a. To add an option to the Added Options list, enter the option in the Option field, and then 
click Add. Repeat the above operations to add more options. The added options list must 
contain at least one item. 

b. To replace an existing option in the Added Options list with a new one, select the option, 
enter the new option in the Options field, and then click Modify.  

c. To delete a current option from the Added Options list, select the option and click Delete.  

d. To adjust the position of an option in the Added Options list, select the option, click Up to 
move the option one position up, or click Down to move the option one position down.  

e. To set an existing option as the default setting for the additional information field, select the 
option from the Added Options list, and then click Default. 

10. Click OK. 

Deleting a device additional information field 
1. Navigate to System > Device Additional Information: 

a. Click the System tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Device Additional Information under Resource Management on the left navigation 
tree. 

The Device Additional Information List displays all device additional information fields in 
the main pane of the Device Additional Information page. 

2. Click the Delete icon  for the additional information field you want to delete. A confirmation 
dialog box opens. 

3. Click OK. 

Once an additional information field is deleted, IMC automatically deletes the additional information 
from all existing devices. 

Configuring data collection 
When a network problem or an IMC failure occurs, you can use the data collection function to collect 
information for troubleshooting. The data that can be collected includes: 

 Device debugging information 

 Device configuration file 

 Crash logs and crash data 

 Neighbor list 

 Device asset information 

 Access terminal information 

 Execution results of commands 

 IMC resource database and logs 

You can collect different types of data specific to the network problems. For example:  

 IMC resource database and log information is for troubleshooting IMC failures 
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 Device debugging and configuration information is for troubleshooting problems that occur on 
the devices managed by IMC 

 Neighbor list and access terminal information is for troubleshooting network topology problems 

To configure data collection: 

1. Navigate to System > Data Collection: 

a. Click the System tab from the top tabular navigation system. 

b. Click System Configuration on the left navigation tree. 

c. Click the Data Collection icon  under System Configuration on the left navigation 
tree. 

The Data Collection page opens.  

The page consists of two parts, Basic Information and Data Collection Settings. In the 
Basic Information section, you can configure contact information for the enterprise or 
company that uses IMC, and briefly describe the problem that occurred. In the Data 
Collection Settings section, you can configure the data delivery options and the types of 
data to be collected, select devices, and set additional information. If you are not accessing 
the Data Collection page for the first time, the page displays any previously configured 
settings for the last data collection. 

2. Configure the Basic Information area. 

 Company Name—Enter the name of the company. 

 Company Address—Enter the address of the company.  

 Telephone—Enter the telephone number of the company. 

 Email Address—Enter the mail address of the company. Make sure you have configured a 
mail server in IMC to forward mails. For more information about configuring a mail server, 
see "Mail server settings." 

 Administrator—Enter the administrator name of the company.  

 Version—The field is automatically populated by the version of IMC and not editable. 

 Bug Ticket No.—Enter the unique number of the bug ticket that contains the problem 
information. 

 Problem Description—Enter a brief description of the problem that occurred. A proper 
description can help technical staff to quickly locate and solve the problem.  

3. Configure the data processing method in Delivery Options of the Data Collection Settings 
area. 

 Compression File Name—Specify a compression file name. IMC compresses all collected 
data files into a zip file, adds a timestamp to the file name, and saves the file to the 
/tmp/datacollection directory of the IMC installation path. 

 Deliver by—Select a collected data transfer mode from the list. Options include Email, 
FTP, SFTP and Save to Server. 

 Email—Select Email to send the collected data to a specified mail address. If you select 
this mode, configure the following parameters: 

 Email Address—Enter the mail address to which collected data is sent. 

 Email Subject—Enter the subject of the mail.  

 FTP—Select FTP to upload the collected data to a specified directory of the FTP server. If 
you select this mode, also configure the following parameters: 

 Anonymous Login—Select this option if you want to enable anonymous logins to the 
FTP server. Otherwise, clear this option. The Username and Password fields are 
displayed only when this option is disabled.  

 FTP Server—Enter the IP address of the FTP server.  

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 8642



241 

 FTP Directory—Enter the directory where the FTP server saves the collected data. If 
you do not configure this parameter, the primary directory of the specified login user is 
used, or the default directory for anonymous logins is used. 

 Username—Enter the FTP login username.  

 Password—Enter the FTP login password. For successful data transfer, make sure the 
username and password are the same as those configured on the FTP server. 

 SFTP—Select SFTP to upload the collected data to a specified directory of a SFTP server. 
If you select this mode, also configure the following parameters: 

 SFTP Server—Enter the IP address of the SFTP server. 

 SFTP Directory—Enter the directory where the SFTP server saves the collected data. If 
you do not configure this parameter, the primary directory of the specified login user is 
used. 

 Username—Enter the SFTP login username.  

 Password—Enter the SFTP login password. For successful data transfer, make sure 
the username and password are the same as those configured on the SFTP server. 

 Save to Server—Select Save to Server to save the collected data to a specified directory 
of the primary IMC server. If you select this mode, also configure the following parameter:  

 Server Folder—Enter the directory on the primary IMC server to save the collected 
data. When the free space of the disk for saving the data is less than 10G, the system 
will prompt that the space is insufficient. In this case, you need to modify the server 
folder or release certain space of the disk.  

4. Configure device data collection in Device Configuration of the Data Collection Settings 
area. 

a. Select the types of data information you want IMC to collect: 

 Debugging Information—Select this option to collect the debugging output after you 
execute the debugging commands on devices.  

 Device Configuration—Select this option to collect the startup configuration files and 
running configuration files saved on devices.  

 Crash Logs and Crash Data—Select this option to collect crash logs, crash data, and 
stack function information generated by devices.  

 Neighbor List—Select this option to collect Layer 2 neighbor information discovered 
through LLDP. The information is used to locate network topology problems.  

 Device Asset Information—Select this option to collect the device asset information, 
such as the asset name, asset type, and asset number.  

 Access Terminal Information—Select this option to collect the MAC/IP 
address-to-interface bindings learned by switches. 

 Execute Command—Select this option to collect the command execution results. Enter 
the commands to be executed in the Enter Command box, a string of 1 to 100 
characters. Different commands are separated by semicolons (;). 

b. Click Select Device to select the devices from which you want to collect data. 

You can select up to 50 devices. For more information about selecting devices, see "Adding 
devices by view" and "Adding devices by advanced query." 

5. Configure the IMC data types to be collected in IMC Option of the Data Collection Settings 
area. 

 Resource Database—Select this option to collect the database file of the IMC resource 
component. 

 Collect IMC Logs—Select this option to collect foreground and background logs of the 
primary and subordinate IMC servers and the remote agent site logs. If you select this 
option, also enter how many days in which IMC logs are collected. The value ranges from 1 
to 90. If you do not set the number of days, IMC logs are not collected. 
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 l2Topo dump information—Select this option to dump Layer 2 topology information to a 
file. The dump file is the memory image file of Layer 2 topology background processes. The 
file stores the execution status of Layer 2 topology operations and can be used to debug 
and view process status. 

6. Select an attachment in Additional Information of the Data Collection Settings area to 
provide additional information, such as a screenshot or a text containing the problem 
description, to aid troubleshooting. IMC sends the attachment together with the collected data. 
The attachment cannot exceed 5 MB in size.  

7. Click OK. 

The operation result page opens, displaying whether or not data collection is successful.  

The Latest Result link is displayed on the Data Collection page after a successful data 
collection. Click the link, and the Collection Result page opens. Select an end time from the 
Collect Time list. The page displays the collection tasks for the collection time and collection 
results for the tasks. 

To suspend the data collection operation, click the Stop icon . The collected data is 
deleted. However, you can click Latest Result to view the collection tasks and the results for 
the tasks on the Collection Result page. 

Processing all alarms 
IMC supports deleting, recovering, and acknowledging all alarms in the system. 

To process all alarms: 

1. Navigate to System > Data Collection: 

a. Click the System tab from the top tabular navigation system. 

b. Click System Configuration on the left navigation tree. 

c. Click Process All Alarms under System Configuration on the left navigation tree. 

The Process All Alarms page opens. 

2. Do one of following: 

 Delete All—Click the radio button next to Delete All and click OK to delete all alarms in 
IMC.  

 Recover All—Click the radio button next to Recover All and click OK to recover all alarms 
in IMC.  

 Acknowledge All—Click the radio button next to Acknowledge All and click OK to 
acknowledge all alarms in IMC.  
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Resource management 
The Resource tab provides you with a portal for the device monitoring and management features of 
IMC. From this portal, you can view and manage network resources including devices and IP 
addresses.  

IMC offers you a variety of options for viewing and managing devices through views that organize by: 

 Device type (Device View) 

 IP address (IP View) 

 Topology (Network Topology) 

 The operator's own organization of devices using Custom Views. 

Each of these views offers the ability to manage multiple devices from the device lists on these 
pages. In addition, each view offers drill down capabilities to the Device Details page, which 
includes a multitude of monitoring and management features for the selected device. On the Device 
Details page, you can synchronize, refresh, manage or unmanage, or delete a device.  

From this view, devices can be accessed remotely through Telnet, SSH, the Device Panel, or Web 
Manager. You can also ping or traceroute to a device on the Device Details page that is accessed 
from all views.  

In addition, you can configure devices. Configuration options include modifying a device label, 
system group attributes, SSH and Telnet settings, polling intervals, ping and Web Manager 
parameters. You can add or cancel performance monitoring for a selected device.  

From IMC, you can also manage devices including resetting or rebooting a device remotely, saving 
device configuration, or system information. You can configure address binding, view hardware, 
OSPF, and IPv6 information and view and configure Power over Ethernet configuration on switches. 
In addition, you can view protocol information for routers and switches, view and modify VLAN, 
RMON, and Spanning tree information on switches and IGMP Snooping configuration on wireless 
devices.  

You can also view and manage interfaces on devices from IMC. Interface management options 
including: 

 Managing and unmanaging interfaces 

 Synchronizing 

 Configuring management status and speed 

 Loopback testing 

 Adding ports to and removing ports from VLANs 

IMC also offers you the ability to manage multiple devices from views and in batch mode. From 
views, you can add, remove, delete, manage, unmanage, synchronize, and refresh devices. You can 
configure SNMP, SSH, and Telnet settings as well as check these settings on multiple devices. You 
can also configure polling intervals, save configurations, reboot devices, backup configurations, and 
deploy software for multiple devices.  

Using batch mode, you can configure SNMP, Telnet, and SSH settings, polling intervals and modify 
login types. You can also check settings in batch mode for SNMP, Telnet, and SSH. You can save 
device configurations, reboot devices, check and configure management status on interfaces, 
implement PoE, configure trap destinations, Spanning Tree on switches and interfaces and 
configure LACP on switches.  

You can also track the usage of and allocate IP addresses in IMC, bind IP addresses to MAC 
address, and bind MAC addresses to interfaces. You can search IMC in real time and historically for 
locations of IP addresses to pinpoint the location of a user/device. You can track network assets, and 
perform and configure asset auditing. 
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Adding devices in IMC 
The most basic network resource management task is to add a device. IMC offers you several 
methods for adding devices in IMC: 

 Add devices manually. 

 Add devices through auto discovery. 

 Add devices by importing the device data directly into IMC. 

When you add a device, either manually, by import, or through auto discovery, IMC by default sets 
their status as managed. Managed devices consume node licenses in IMC and a warning dialog box 

opens. For the current license count, click the About link  in the upper right corner of IMC. 

Adding devices manually to IMC 
You can add devices manually, one at a time. IMC automatically manages a device once a device 
has been added to IMC, whether it has been manually or automatically added.  

Adding a device manually 

1. Navigate to Resources > Add Device: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Add Device under Resource Management on the left navigation tree. 

2. Enter the node name or IP address of the network device you want to add in the Host Name/IP 
address field. This field is required. 

3. Enter the name that is displayed on the IMC platform in the Device Label field. 

4. Enter a valid IP subnet mask for the device to be added in the Mask field. 

5. Select the device group to which you want to add this device from the Device Group list.  

If you do not want to add the device to a device group, leave this option blank.  

All devices that have not been added to a device group are displayed in the Ungrouped 
Devices List. You can add devices to groups from the Ungrouped Devices List after they 
have been added to IMC.  

You must create device groups before you can add devices to them. Once you have created the 
device groups, they are displayed in the Device Group list. 

6. Select the access method for this device from the Login Type list.  

Options include Telnet, SSH, and None. The device to be added must be configured to support 
the access or login type selected here. 

7. If you want IMC to process traps sent by this device for alarming and notification purposes, 
verify that Automatically register to receive SNMP traps from supported devices is selected. 

 

 IMPORTANT: 

 If the Automatically register to receive SNMP traps from supported devices checkbox is 
cleared, IMC does not process, display, or alarm on traps sent by this device.  

 If the Automatically register to receive SNMP traps from supported devices checkbox is 
selected, IMC automatically sets the IP address of the IMC master server as the destination host 
on each newly added device to receive traps generated by the device. 

 

8. Do one of the following: 

 If you select Support Ping Operation, IMC will use ping packets to probe devices. Devices 
that respond to IMC ping packets are added. The devices (for example, firewalls) that filter 
or do not respond to IMC ping packets are not added. 
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 If you clear Support Ping Operation, IMC will use SNMP packets to probe devices and add 
devices (for example, firewalls) that support SNMP. 

9. If you want to add the device even if it does not respond to ping requests, select Add the 
device regardless of the ping result. 

10. If you want IMC to use the Loopback address for the management of the discovered device, 
check the box to the left of Use the loopback address as the management IP. 

11. To view and configure SNMP settings for this device, click the SNMP Settings link . 

12. To configure the SNMP settings for this device, click the Configure link  located at the 
SNMP Settings section. 

The SNMP Parameters dialog box opens.  

You can either enter the SNMP settings in this dialog box or you can select an existing SNMP 
template that contains the SNMP settings for this device. SNMP templates are particularly 
useful when SNMP configurations are standardized. For more information about creating 
SNMP templates, see "SNMP templates." 

Editing SNMP settings manually 

To edit the SNMP parameters, verify that Edit SNMP Parameters is selected. 

 Parameter Type—Select the version of SNMP (v1 or v2c) that is configured on the device to be 
added from the Parameter Type list. You can add devices that are configured with SNMPv3 
using SNMP templates only. You must create an SNMP template with the SNMPv3 parameters 
for this device before adding it. 

 Read-Only Community String—Enter the read-only community string for this device in the 
Read-Only Community String field. This value must match the read only community string 
that is configured on the device to be added. 

 Read-Write Community String—Enter the read-write community string for this device in the 
Read-Write Community String field. This value must match the read-write community string 
that is configured on the device to be added. 

 Timeout—Enter the SNMP timeout value (1–60 seconds) in the Timeout field. This parameter 
determines how long IMC waits for an SNMP reply from the managed device before declaring 
that the request has timed out. The default is 4. 

 Retries—Enter the number of SNMP retries (1–20) in the Retries field. The retries parameter 
defines how many times the management system (IMC) sends SNMP retries in an attempt to 
communicate with the managed device before reporting a failure. The default is 3. 

Using existing SNMP templates 

To configure the SNMP settings for this device using an SNMP template: 

1. Select Select an Existing Template. 

2. Select a template. 

3. Click OK. 

4. Do one of the following: 

 To view and configure Telnet settings for this device, click the Telnet Settings link .  

 To configure the Telnet settings for this device, click the Configure link  located at the 
Telnet Settings section.  

The Telnet Parameters dialog box opens. 

You can either enter the Telnet settings in this dialog box or select an existing Telnet template 
that contains the Telnet settings for this device. Telnet templates are particularly useful when 
Telnet configurations are standardized. For more information about creating Telnet templates, 
see "Telnet templates." 

Editing Telnet parameters manually 

1. Verify that Edit Telnet Parameters is selected. 
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2. Configure the following parameters: 

 Authentication Mode—Select the mode that matches the Telnet authentication mode 
configured on the managed devices from the Authentication Mode list. 

 Username—Enter the username configured on managed devices in the Username field, if 
prompted. 

 Password—Enter the password configured on the managed devices in the Password field, 
if prompted. 

 Super Password—Enter the super password configured on the managed devices for the 
Super Password, if prompted. 

 Timeout—Enter the Telnet timeout value configured on the managed device in the Timeout 
field. The valid range is 1–60 seconds. 

Using an existing Telnet template 

To configure the Telnet settings for this device using Telnet templates: 

1. Select Select an Existing Template. 

2. Select a template. 

3. Click OK. 

4. Do one of the following: 

 To view and configure SSH settings for this device, click the SSH Settings link .  

 To configure the Telnet settings for this device, click the Configure link  located at the 
SSH Settings section.  

The SSH Parameters dialog box opens. 

You can either enter the SSH settings in this dialog box or select an existing SSH template that 
contains the SSH settings for this device. SSH templates are useful when SSH configurations 
are standardized. For more information about creating SSH templates, see "SSH templates." 

Editing SSH settings manually 

1. Select Edit SSH Parameters. 

2. Configure the following parameters: 

 Authentication Mode—Select the mode that matches the SSH authentication mode 
configured on the managed devices from the Authentication Mode list. 

 The authentication mode selected must match the authentication mode configured on the 
device. 

 User Name—Enter the username configured on managed devices in the Username field, if 
prompted. 

 Password—Enter the password configured on the managed devices in the Password field, 
if prompted. 

 Private Key File—Select the local path and filename of the private key file that contains the 
key that enables login, if prompted. 

 Private Key Password—Enter the private key password for the private key file, if 
prompted. 

 Super Password—Enter the super password configured on the managed devices, if 
prompted. 

 Port—Enter the TCP port for SSH configured on managed devices. The default TCP port is 
22. 

 Timeout—Enter the SSH timeout value (1–120 seconds).  

The timeout parameter defines how long the system waits for the device to respond in 
seconds before declaring that the response has timed out. The default setting is 10 
seconds. 

 Retries—Enter the number of SSH retries (1–5).  
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The retries parameter defines how many times the management system (IMC) sends SSH 
retries in an attempt to communicate with the managed device before reporting a failure. 
The default setting is 3. 

Using existing SSH templates 

To configure the SSH settings for this device using SSH templates:  

1. Select Select an Existing Template. 

2. Select an SSH template. 

3. Click OK to accept the SSH configuration. 

4. Click OK to add the device. 

When you add a device, IMC automatically records your settings for the following parameters. When 
you add another device, IMC uses your settings as the default settings.  

The parameters include: 

 Login Type. 

 Automatically register to receive SNMP traps from supported devices. 

 Support Ping Operation. 

 Add the device regardless of the ping result. 

 Use the loopback address as the management IP. 
 

 NOTE: 

IMC automatically manages all devices that you add to IMC. Check your license count before 
adding devices to IMC to verify that you have enough licenses to manage all added devices. 
 

Auto discovering devices 
Auto discovering in IMC allows you to search the network and add all found devices to IMC using two 
methods: basic and advanced. With the basic auto discovery method, you provide a start and end IP 
address that directs the discovery process. In addition, you provide SNMP and Telnet settings that 
support the addition of devices for these protocols. You have the option to run basic and advanced 
discoveries immediately or at a scheduled date and time. You can save simple auto discoveries as 
plans and manage the plans in a plan list, including viewing plan details and auto discovery results 
and modifying or deleting plans. 

With advanced auto discoveries, you can search the network using routing tables. With this option, 
you configure hop counts to determine how far IMC searches the infrastructure for new devices. In 
routing based discoveries, you also provide a Seed IP to direct the starting point for the auto 
discovery. 

Another option for auto discovery of network devices is an ARP-based auto discovery. ARP-based 
auto discoveries search ARP tables to discover new devices. As with routing based discoveries, you 
also configure hop counts to determine how far IMC searches the infrastructure for new devices. In 
ARP-based discoveries, you also provide a Seed IP to direct the starting point for the auto discovery. 

A third option is the IPsec VPN-based auto discovery method. With this option, IMC queries IPsec 
devices for new devices, again using hop counts to limit how far IMC searches the infrastructure. 
Seed IP addresses are also required for this method. 

You can use the network segment-based advanced method for auto discovering new devices. With 
this method, you configure IMC with IP address segments, which IMC then searches for new 
devices. With this method, hop count and Seed IP addresses are not required. 

You can use the PPP-based advanced method for auto discovering new devices. With this method, 
hop count and Seed IP addresses are not required. 
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Adding devices through basic auto discovery 

The device to be added must be configured to support the access or login type selected here. As a 
best practice, configure default monitor indexes before performing an auto discovery. Monitor 
indexes gather the metrics that IMC uses to measure performance of managed devices. Monitor 
indexes are also used to generate alarms when they exceed configured thresholds. By configuring 
the default monitor indexes first, IMC applies them to devices found in the discovery process. For 
more information, see "Configuring network asset audit options."  

To add devices to IMC using the basic auto discovery method: 

1. Navigate to Resource > Auto Discovery: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Auto Discovery under Resource Management on the left navigation tree. 

2. Confirm that you are in Basic mode. 

The main section of the page title should read Auto Discovery (Basic). 

3. If the dialog box does not have this title and your breadcrumb trail is Resource > Auto 

Discovery (Advanced), then click the Go to Basic icon  to navigate to the Auto 

Discovery (Basic) page. Go to Basic can be found in the far right corner of the Auto 
Discovery page. 

4. Enter the first IP address of the IP address range you want to search devices for in the Start IP 
field. 

5. Enter the last IP address of the IP address range you want to search devices for in the End IP 
field. 

6. Click Add to add the IP address range. 

7. Import IP address ranges: 

a. Click Import. The Import Network Segment Address window opens. 

b. Click Browse to browse your local directories for the file. Text files no greater than 5 MB are 
supported. Separate the start and end IP addresses with hyphens "-", for example, 
192.168.1.1-192.168.1.20, 9041::1-9041::10 and enter each IP address range in a separate 
line. 

c. Click OK. The imported IP address segments are displayed in the Network Segment field. 

8. If you want to receive SNMP traps from the discovered devices that support SNMP trap 
generation, verify that Automatically register to receive SNMP traps from supported 
devices is selected. 

 

 IMPORTANT: 

If the Automatically register to receive SNMP traps from supported devices checkbox is 
cleared, IMC does not process, display, or alarm on traps sent by the discovered devices. 
 

9. From the Device Group list, select the device group to which the automatically discovered 
devices will be added. You can also leave this field empty. Before selecting a device group, you 
must first create device groups on the System > Group Management > Device Group page.  

All devices that have not been added to a device group are displayed in the Ungrouped 
Devices List. You can add devices to groups from the Ungrouped Devices List after they 
have been added to IMC. 

10. Enter the SNMP v1 read community string in the SNMP Read Community string field. 

11. Enter the SNMP v1 write community string in the SNMP Write Community string field. 

The SNMP read and write community string configuration you enter here must match the SNMP 
configuration settings on the devices to be discovered and managed. See each vendor's 
manual for information about setting the SNMP configuration parameters for each device type.  
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In the basic auto discovery mode, only SNMP v1 is supported. 

12. Select the Telnet authentication mode that corresponds with the Telnet authentication mode 
configured on the managed devices from the Telnet Authentication Mode list. 

13. Configure the following parameters: 

a. Telnet Username—Enter the username configured on managed devices in the Telnet 
Username field, if prompted. 

b. Telnet Password—Enter the password configured on the managed devices in the Telnet 
Password field, if prompted. 

c. Telnet Super Password—Enter the super password configured on the managed devices 
for the Telnet Super Password, if prompted. 

14. If you want IMC to perform scheduled auto discoveries, select the frequency with which you 
want IMC to perform scheduled auto discoveries from the Schedule list.  

Options include Never, Hour, Day, Week, and Month.  

15. Select Never if you want IMC to perform the auto discovery immediately rather than on a 
scheduled basis.  

IMC runs the auto discovery when you have completed the configuration and clicked Auto 
Discovery. 

16. If you select to schedule an auto discovery for Hour, you only need to enter the discover time. 

17. If you select to schedule an auto discovery for Day, Week, or Month, enter the start date you 
want to begin the scheduled auto discovery in the Start Date field.  

You can also click the Start Date field to select and auto-populate the field.  

18. Select the hour and minute from the lists next to the Discover Time field. 

19. Select the administrator groups that have the privilege to manage the plan. By default, all 
administrator groups are selected. The Administrator Group option cannot be cleared. You 
can clear the Maintainer Group and Viewer Group options as needed.  

20. The Save as Plan button is available if you select Hour, Day, Week, or Month from the 
Schedule list. Click this button to save an auto discovery as a plan and perform the scheduled 
auto discovery: 

a. Click Save as Plan. The Save as Plan window opens. 

b. Enter the name of the plan. 

c. Click OK. 

Then IMC runs the auto discovery at the specified period and adds the discovered devices 
to IMC. You can configure multiple scheduled auto discoveries. To manage the scheduled 
auto discoveries, click Plan List in the right of the auto discovery main pane. For more 
information, see "Plan management." 

21. Click Save Only if you want IMC to save the auto discovery configuration and perform the auto 
discovery according to the schedule you have defined.  

You can review summary results for all discoveries, including scheduled discoveries in the 
Discovery Report that is found under Resource Statistics Report.  

For more information about accessing reports in IMC, see "My report templates." 

22. Click Auto Discovery if you want to begin the auto discovery immediately. 

23. If you clicked Auto Discovery, the Auto Discovery Running window is displayed along with 
details of the auto discovery process. 

While the auto discovery is running, IMC displays a rotating icon . 

24. Click the Stop icon  if you want to cancel the auto discovery process. 

Once IMC has completed the auto discovery, IMC displays a status and summary of the auto 
discovery process at the top of the Auto Discovery Running window.  
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25. To access the LiveUpdate window, click LiveUpdate in the upper right corner of the page. For 
more information, see "LiveUpdate."  

Advanced auto discovery: routing-based, ARP-based (ND), IPsec VPN-based, or PPP-based 

The following information describes the advanced method for auto discovering devices using four of 
the five advanced discovery methods: routing-based, ARP-based, IPsec VPN-based or PPP-based. 
With each of these methods, you configure hop counts to determine how far IMC searches the 
infrastructure for new devices. In these discovery methods, you also provide one or more seed IP 
addresses to direct the starting points for the auto discovery.  

As a best practice, configure default monitor indexes before performing an auto discovery. Monitor 
indexes gather the metrics that IMC uses to measure performance of managed devices. Monitor 
indexes are also used to generate alarms when they exceed configured thresholds. By configuring 
the default monitor indexes first, IMC applies them to devices found in the discovery process. For 
more information, see "Configuring default monitor indexes." 

To configure advanced auto discovery: 

1. Navigate to Resource > Auto Discovery: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Auto Discovery under Resource Management on the left navigation tree. 

2. Confirm that you are in Advanced mode.  

The dialog box title should read Select Auto Discovery Mode and the breadcrumb trail should 
read Resource > Auto Discovery (Advanced).  

If not, then click the Go to Advanced icon  located on the far right of the Auto Discovery 
page. 

3. Select any one of the first three auto discovery options you want to use by selecting the 
discovery mode.  

Options include: 

 Routing-Based—This option searches the routing tables of all reachable routers for 
manageable network devices. 

 ARP(ND)-Based—This option searches the ARP tables or the IPv6 Neighbor Discovery 
protocol for manageable network devices. 

 IPsec VPN-Based—This option searches IPsec VPN devices for manageable network 
devices. 

 Network Segment-Based—This option searches for manageable devices by the specified 
IP address range. 

 PPP-Based—This option searches the Peer-to-Peer Protocol for manageable network 
devices. 

4. Click Next. 

 Hop Count—Select the hop count number from the Hop Count list.  
The Hop Count parameter defines the maximum number of network node hops IMC 
traverses in the discovery process. The valid value can be 1 through 7. 

 

 CAUTION: 

The larger the hop count, the more the discovery process consumes system and network 
resources, including bandwidth, and the longer the discovery process takes. Exercise the hop count 
configuration parameter with caution. 
 

 Login Type—Select the login type. Options include: Telnet, SSH, and None. 
This parameter defines how IMC logs into the discovered device. The discovered devices 
must be configured to support the login type you select. 
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 Use the loopback address as the management IP—Select this option to select the 
Loopback address for the management of the discovered device. 

 Discover Non-SNMP Devices—Select this option if you do not want IMC to manage 
devices that do not support SNMP. The Discover Non-SNMP Devices option is not 
available for IPsec VPN-Based auto discovery.  

 Scan one by one in the Segment—This option configures IMC to discover every 
device in the configured network segment. This option is not displayed if you select the 
IPsec VPN-based or ARP(ND)-based auto discovery option. This is a very time 
consuming method for auto discovery, as IMC pings every IP address in the segment 
serially and adds only the devices that respond to the ping request.  

 To select the auto discovery option described above, select Scan one by one in the 
Segment. 

 Automatically register to receive SNMP traps from supported devices—If you want 
IMC to receive and process traps from discovered devices, verify that Automatically 
register to receive SNMP traps from supported devices is selected. If it is not 
selected, IMC does not process, display, or alarm on traps sent by the discovered 
devices. 

 Seed IP—Enter the IP address of the device to serve as a seed device for auto discovery 
purposes in this field. A seed IP address in an auto discovery serves as a starting point for 
the discovery process.  

As the seed IP address, select the device that enables IMC to discover as many devices to 
be managed as possible. 

Typically, routers and layer three switches are the most logical choice for routing and ARP 
based discoveries. For IPsec VPN-Based discoveries, options for the Seed IP include VPN 
gateways and routers supporting VPN. 

You can add more than one IP address to serve as seed IP devices by clicking Add after 
entering the IP address in the Seed IP field.  

5. To configure the SNMP settings, click the Configure icon  next to SNMP Settings 
(Required). 

The SNMP Parameters dialog box opens. 

You can either enter the SNMP settings in this dialog box or you can select an existing SNMP 
template that contains the SNMP settings for this device. SNMP templates are particularly 
useful when SNMP configurations are standardized. You can specify multiple SNMP templates. 
For more information about creating SNMP templates, see "SNMP templates." 

To edit SNMP settings manually: 

a. Select Edit SNMP Parameters. 

b. Configure the following parameters: 

 Parameter Type—Select the version of SNMP (v1 or v2c) that is configured on the 
device to be added from the Parameter Type list. 

You can only add devices that are configured with SNMPv3 using SNMP templates. You 
must create an SNMP template with the SNMPv3 parameters for this device before 
adding this device.  

 Read-Only Community String—Enter the read-only community string for this device in 
the Read-Only Community String field. This value must match the read only 
community string that is configured on the device to be added. 

 Read-Write Community String—Enter the read-write community string for this device 
in the Read-Write Community String field. This value must match the read-write 
community string that is configured on the device to be added. 

 Timeout—Enter the SNMP timeout value (1–60 seconds) in the Timeout field. This 
parameter determines how long IMC waits for an SNMP reply from the managed device 
before declaring that the request has timed out. The default is 4. 
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 Retries—Enter the number of SNMP retries (1–20) in the Retries field. The retries 
parameter defines how many times the management system (IMC) sends SNMP retries 
in an attempt to communicate with the managed device before reporting a failure. The 
default is 3. 

To configure the SNMP settings for this device using an SNMP template: 

a. Select Select an Existing Template. 

b. Select a template. 

c. Click OK. 

6. To configure the Telnet settings for this device, click the Configure link  located at the 
Telnet Settings section. 

The Telnet Parameters dialog box opens. 

You can either enter the Telnet settings in this dialog box or select an existing Telnet template 
that contains the Telnet settings for this device. Telnet templates are particularly useful when 
Telnet configurations are standardized. For more information about creating Telnet templates, 
see "Telnet templates." 

To edit Telnet settings manually: 

a. Select Edit Telnet Parameters. 

b. Configure the following parameters: 

 Authentication Mode—Select the mode that matches the Telnet authentication mode 
configured on the managed devices from the Authentication Mode list. 

 Username—Enter the username configured on managed devices in the Username 
field, if prompted. 

 Password—Enter the password configured on the managed devices in the Password 
field, if prompted. 

 Super Password—Enter the super password configured on the managed devices for 
the Super Password, if prompted. 

 Timeout—Enter the Telnet timeout value configured on the managed device in the 
Timeout field. Valid range is 1–60 seconds. 

To configure the Telnet settings for this device using Telnet templates:  

c. Select Select an Existing Template.  

d. Select a Telnet template. 

e. Click OK. 

7. To configure the SSH settings for this device, click the Configure icon  next to SSH 
Parameters.  

The SSH Parameters dialog box opens. 

8. Configure the SSH settings by using one of the following methods: 

 Enter the SSH settings in this dialog box. 

 Select an existing SSH template that contains the SSH settings for this device.  

SSH templates are useful when SSH configurations are standardized. For more information 
about creating SSH templates, see "SSH templates." 

To edit SSH settings manually: 

a. Select Edit SSH Parameters. 

b. Configure the following parameters: 

 Authentication Mode—Select the authentication mode that corresponds with the SSH 
configuration mode on the managed devices from the list. 

 User Name—Enter the username that is configured on the managed devices. 
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 Password—Enter the password that is configured on the managed devices, if 
prompted. 

A password is optional if the Private Key File option is selected. 

 Private Key File—Select the local path and filename of the private key file that contains 
the key that enables login, if prompted. 

 Private Key Password—Enter the private key password for the private key file, if 
prompted. 

 Super Password—Enter the super password that is configured on the managed 
devices, if prompted. 

 Port—Enter the TCP port for SSH configured on managed devices. The default TCP 
port is 22. 

 Timeout—Enter the SSH timeout value (1–120 seconds). The timeout parameter 
defines how long the system waits for the device to respond in seconds before declaring 
that the response has timed out. The default setting is 10 seconds. 

 Retries—Enter the number of SSH retries (1–5). The retries parameter defines how 
many times the management system (IMC) sends SSH retries in an attempt to 
communicate with the managed device before reporting a failure. The default setting is 
3. 

To configure the SSH settings for this device using SSH templates: 

a. Select Select an Existing Template. 

b. Select a SSH template to use. 

c. Click OK to accept the SSH configuration. 

9. The filter settings offer you flexibility in determining which subnets and devices model to either 
include in or exclude from the auto discovery process. Do one of the following: 

 Select By Subnets and go to step 10. 

 Select By Device Model and go to step 13. 

10. Enter the IP address subnet range and the subnet mask you want to filter by in the Subnet IP 
field. 

11. Masks can be entered using either CIDR or dotted decimal notation. 

For example, a valid network/subnet mask entry using CIDR notation would be  
192.168.1.0/24 

where /24 represents the number of bits allocated to the network portion of the address and 
implying that the remaining bits are allocated to the host portion. 

Alternatively, a valid network/subnet mask using dotted decimal notation would be 
192.168.1.0/255.255.255.0 

12. Do one of the following:  

 Select Yes if you want IMC to include devices in the subnet list. 

 Select No if you want IMC to exclude devices in the subnet list.  

You can add more than one IP address/subnet range by clicking Add after entering the IP 
address range in the Subnet IP field. Go to step 13. 

13. Click Add.  

The dialog box for selecting device models opens and displays all device models in IMC.  

14. In the Query Device Model area in the upper part of the dialog box, enter query criteria to 
query device models. 

15. Select the device models to be filtered. 

16. Click OK.  

The selected device models are displayed on the Filter Settings list. 

17. Do one of the following: 
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 Select Yes if you want IMC to include the device model. 

 Select No if you want IMC to exclude the device model. 

You can add more than one device model by clicking Add. 

18. If you want IMC to perform scheduled auto discoveries, select the frequency with which you 
want IMC to perform scheduled auto discoveries from the Schedule list.  

Options include Never, Hour, Day, Week, and Month. Select Never if you want IMC to perform 
the auto discovery immediately rather than on a scheduled basis. IMC runs the auto discovery 
when you have completed the configuration and clicked Auto Discovery. 

19. Do one of the following: 

 Schedule an auto discovery for Hour by entering the discover time. 

 Schedule an auto discovery for a specific day, week, or month, by entering the start date to 
begin the scheduled auto discovery in the Start Date field.  

 You can also click the Start Date field to select and auto populate the field.  

 Select the hour and minutes from the lists next to the Discover Time field. 

20. Select the administrator groups that have the privilege to manage the plan. By default, all 
administrator groups are selected. The Administrator Group option cannot be cleared. You 
can clear the Maintainer Group and Viewer Group options as needed. 

21. The Save as Plan button is available if you select Hour, Day, Week, or Month from the 
Schedule list. Click this button to save an auto discovery as a plan and perform the scheduled 
auto discovery: 

a. Click Save as Plan. The Save as Plan window opens. 

b. Enter the name of the plan. 

c. Click OK. 

Then IMC runs the auto discovery at the specified period and adds the discovered devices to 
IMC. 

You can configure multiple scheduled auto discoveries. To manage the scheduled auto 
discoveries, click Plan List in the right of the auto discovery main pane. For more information, 
see "Plan management." 

22. Click Save Only if you want IMC to save the auto discovery configuration and perform the auto 
discovery according to the schedule you have defined. 

23. Click Auto Discovery if you want to begin the auto discovery immediately. 

If you clicked Auto Discovery, the Auto Discovery Running window is displayed along with 
details of the auto discovery process. 

While the auto discovery is running, IMC displays a rotating icon . 

24. Click the Stop icon  if you want to cancel the auto discovery process. 

Once IMC has completed the auto discovery, it displays a status and summary of the auto 
discovery process at the top of the Auto Discovery Running window as well as a list of all 
discovered devices and the results in the Auto Discovery Running list.  

25. To access the LiveUpdate window, click LiveUpdate in the upper right corner of the page. For 
more information, see "LiveUpdate." 

Advanced Auto Discovery: network segment based discovery method 

You can also use the network segment based advanced method for auto discovering new devices. 
With this method, you configure IMC with one or more IP address segments, which IMC then 
searches for new devices. With this method, hop count and Seed IP addresses are not required. As 
a best practice, configure default monitor indexes before performing an auto discovery. Monitor 
indexes gather the metrics that IMC uses to measure performance of managed devices. Monitor 
indexes are also used to generate alarms when they exceed configured thresholds. By configuring 
the default monitor indexes first, IMC applies them to devices found in the discovery process.  
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For more information, see "Configuring default monitor indexes." 

To add devices to IMC using Advanced Auto Discovery method: 

1. Navigate to Resource > Auto Discovery: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Auto Discovery under Resource Management on the left navigation tree. 

2. Confirm that you are in advanced mode.  

The dialog box title should be Select Auto Discovery Mode and the breadcrumb trail should 

be Resource > Auto Discovery (Advanced). If not, then click the Go to Advanced icon  
located to the far right of the Auto Discovery page. 

3. Select the auto discovery mode, Network Segment-Based discovery mode.  

4. Click Next. 

5. Enter the first IP address of the IP address range for which you want to search new devices in 
this auto discovery in the Start IP field. 

6. Enter the last IP address of the IP address range for which you want to search new devices in 
this auto discovery in the End IP field. 

7. Click Add to add the IP address range to the Configured Segment Address list. 

You can add more than one IP Segment to the list by repeating steps 3-4 for each segment you 
want to add. 

Importing network segment addresses 

You can also import the list of network segment addresses. To do so, the import file format must 
conform to the following rules: 

 Import file must be a text file.  

 Import file size must not exceed 5 MB. 

 Start IP address and End IP address must be separated by hyphen (-). 

 Every network segment address must be in a new line. 

The examples below are valid entries for an import file: 

10.9.1.1-10.9.128.1 

9041::1-9041::10 

To import network addresses from an import file: 

1. Click Import next to the Configured Segment Address list. 

2. Click Browse to locate your import file. 

3. Click OK to accept the selected import file. 

4. Confirm that the entries in your import file have been added to the Configured Segment 
Address list. 

 Login Type—This option defines how IMC logs into the discovered device. Options include 
Telnet, SSH, and None. Select login type from the Login Type list. The discovered devices 
must be configured to support the login type you select. 

 Use the loopback address as the management IP—If you want IMC to use the Loopback 
address for the management of the discovered device, select Loopback Address as 
Manager IP. 

 Discover Non-SNMP Devices—IMC can manage devices that do not support SNMP. If 
you want IMC to manage these devices, select Discover Non-SNMP Devices. 

 Scan one by one in the Segment—This option configures IMC to discover every device in 
the configured network segment. This is a very time consuming option for auto discovery as 
IMC pings every IP address in the segment serially and then add the devices that respond 
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to the ping request. If you want this auto discovery option, select Scan one by one in the 
Segment. 

 Automatically register to receive SNMP traps from supported devices—If you want 
IMC to receive and process traps from discovered devices, verify that Automatically 
register to receive SNMP traps from supported devices is selected. 

 

 IMPORTANT: 

If the Automatically register to receive SNMP traps from supported devices checkbox is 
cleared, IMC does not process, display, or alarm on traps sent by the discovered devices. 
 

5. Perform the left operations in the same way Advanced auto discovery is configured: 
routing-based, ARP-based(ND), or IPsec VPN-based, PPP-based. For more information, see 
"Advanced auto discovery: routing-based, ARP-based (ND), IPsec VPN-based, or 
PPP-based." 

Viewing auto discovery results 

1. Navigate to Resource > Auto Discovery: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Auto Discovery under Resource Management on the left navigation tree. 

2. Confirm that you are in Basic mode. 

The main section of the page title should read Auto Discovery (Basic).  

If the dialog box does not have this title and your breadcrumb trail is Resource > Auto 

Discovery (Advanced), then click the Go to Basic icon  to navigate to the Auto 

Discovery (Basic) page. The Go to Basic icon  can be found in the far right corner of the 
Auto Discovery page. 

3. Click the Latest Result icon  on the right of the page to enter the auto discovery result page. 
By default, the result of the last auto discovery is displayed. For more information about the auto 
discovery result page, see "Viewing auto discovery results." 

Setting default monitor indexes 

When automatically discovered devices are added to IMC, IMC monitors the devices according to 
the default monitor indexes. 

To set default monitor indexes: 

1. Navigate to Resource > Auto Discovery: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Auto Discovery under Resource Management on the left navigation tree. 

2. Confirm that you are in Basic mode. 

The main section of the page title should read Auto Discovery (Basic).  

If the dialog box does not have this title and your breadcrumb trail is Resource > Auto 

Discovery (Advanced), then click the Go to Basic icon  to navigate to the Auto 

Discovery (Basic) page. The Go to Basic icon  can be found in the far right corner of the 
Auto Discovery page. 

3. Click the Set Default Monitor Indexes icon  on the right of the page to enter the Default 
Monitoring Indexes page.  
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Plan management 

After you save auto discoveries as plans, you can manage the plans, including viewing plan details, 
modifying or deleting plans, and viewing plan execution results. 

Viewing a plan list 

1. Navigate to Resource > Auto Discovery: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Auto Discovery under Resource Management on the left navigation tree. 

2. Confirm that you are in Basic mode. 

The main section of the page title should read Auto Discovery (Basic).  

If the dialog box does not have this title and your breadcrumb trail is Resource > Auto 

Discovery (Advanced), then click the Go to Basic icon  to navigate to the Auto 

Discovery (Basic) page. The Go to Basic icon  can be found in the far right corner of the 
Auto Discovery page. 

3. Click the Plan List icon  to navigate to the plan list page. 

Plan List 

 Status—Status of the plan, including Waiting and Periodically Discovering. Waiting 
indicates the plan is waiting to be executed. Periodically Discovering indicates the plan is 
being executed. 

 Model—Model of the plan. Options are Basic and Advanced. 

 Name—Name of the plan. 

 Device Group—Device group to which the automatically discovered devices are added. 

 Discovery History—Discovery history of the plan. Click Discovery History to enter the 
Auto Discovery Result page. 

 Modify—Click the Modify icon  associated with the plan you want to modify. 

 Delete—Click the Delete icon  associated with the plan you want to delete. 

4. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items 
per page you want to view. 

5. Click Refresh. 

Viewing plan details 

1. Navigate to Resource > Auto Discovery: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Auto Discovery under Resource Management on the left navigation tree. 

2. Confirm that you are in Basic mode. 

The main section of the page title should read Auto Discovery (Basic).  

If the dialog box does not have this title and your breadcrumb trail is Resource > Auto 

Discovery (Advanced), then click the Go to Basic icon  to navigate to the Auto 

Discovery (Basic) page. The Go to Basic icon  can be found in the far right corner of the 
Auto Discovery page. 

3. Click the name link of a plan to view its details. 

All IP address ranges are displayed in the Network Segment field. 

If you select Automatically register to receive SNMP traps from supported devices, IMC 
automatically receives SNMP traps sent by devices supporting traps. Otherwise, IMC does not 
receive these traps. 
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SNMP & Telnet Settings 

 SNMP Read Community. 

 SNMP Write Community. 

 Telnet Authentication Mode. 

 Telnet Username—Whether this option is available depends on the Telnet Authentication 
Mode. 

 Telnet Password—Whether this option is available depends on the Telnet Authentication 
Mode. 

 Telnet Super Password—Whether this option is available depends on the Telnet 
Authentication Mode. 

Basic Settings 

 Device Group—Device group to which the automatically discovered devices are added. 

Scheduled Discovery Settings 

 Schedule—Frequency with which you want IMC to perform scheduled auto discoveries, 
including Hour, Day, Week, and Month. 

 Start Date—This field is available if you select Day, Week, or Month from the Schedule 
list. The field specifies the validation time and execution period of the plan. 

 Discover Time—Execution time of the plan, in the format of hh:mm. 

4. Click Back to return to the plan list page. 

Viewing plan execution results 

1. Navigate to Resource > Auto Discovery: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Auto Discovery under Resource Management on the left navigation tree. 

2. Confirm that you are in Basic mode. 

The main section of the page title should read Auto Discovery (Basic).  

If the dialog box does not have this title and your breadcrumb trail is Resource > Auto 

Discovery (Advanced), then click the Go to Basic icon  to navigate to the Auto 

Discovery (Basic) page. The Go to Basic icon  can be found in the far right corner of the 
Auto Discovery page. 

3. Click the Plan List icon  to navigate to the plan list page. 

4. Click the Discovery History link corresponding to a plan that has been executed to enter the 
auto discovery result page. 

 Discover Time—View the result according to the execution time of the plan. 

 Operator Name—Name of the operator that performs the auto discovery. All auto 
discoveries are performed by IMC, so the operator name of all tasks is $System. 

 Discovery Type—Type of the plan. This field is displayed as Network Segment-Based for 
all plans. 

 Start Time—Start time of the auto discovery. 

 End Time—End time of the auto discovery. 

 Total—Total number of discovered devices. 

 SNMP Devices—Number of discovered SNMP devices. 

 ICMP Devices—Number of discovered ICMP devices. 

5. View the auto discovery process in the list at the lower part of the page. 

 Time—Time when the devices were discovered. 

 Newly Discovered devices—Names of the discovered devices. 
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 Result—Auto discovery results. 

Modifying a plan 

1. Navigate to Resource > Auto Discovery: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Auto Discovery under Resource Management on the left navigation tree. 

2. Confirm that you are in Basic mode. 

The main section of the page title should read Auto Discovery (Basic).  

If the dialog box does not have this title and your breadcrumb trail is Resource > Auto 

Discovery (Advanced), then click the Go to Basic icon  to navigate to the Auto 

Discovery (Basic) page. The Go to Basic icon  can be found in the far right corner of the 
Auto Discovery page. 

3. Click the Modify icon  associated with the plan you want to modify. For more information, 
see "Plan management." 

Deleting a plan 

1. Navigate to Resource > Auto Discovery: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Auto Discovery under Resource Management on the left navigation tree. 

2. Confirm that you are in Basic mode. 

The main section of the page title should read Auto Discovery (Basic).  

If the dialog box does not have this title and your breadcrumb trail is Resource > Auto 

Discovery (Advanced), then click the Go to Basic icon  to navigate to the Auto 

Discovery (Basic) page. The Go to Basic icon  can be found in the far right corner of the 
Auto Discovery page. 

3. Click the Plan List icon  to navigate to the plan list page. 

4. Click the Delete icon  associated with the plan you want to delete. A confirmation dialog box 
opens. 

5. Click OK. 

Adding devices by importing device information 
IMC supports the import and export of devices and information. Both administrators and maintainers 
can import and export devices. You can quickly and easily import the devices you want IMC to 
manage by using a well-defined file format or from NNMi. 

In addition, you can also export device information into a CSV format for easy import into other 
management or reporting systems. 

The following information describes the import process as a quick and easy way to quickly manage 
only those devices you want to manage with IMC.  

Importing devices into IMC 

To add devices to IMC through importing device information: 

1. Navigate to Resource > Import/Export Device. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Import/Export Device under Resource Management on the left navigation tree. 
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2. On the Import/Export Device page, select Import Device. 

3. In the Input File field, enter the file name you want to use to import devices or click Browse to 
browse for the file on your local computer. 

You must create a valid import file prior to importing devices. The following information 
describes all possible columns that can be used in a valid data import file and the rules for 
constructing a valid import file using these column definitions. 

The field definitions for all possible columns in an import file are listed in Table 15. 

Table 15 Import file column definitions 

Column label Column contents/requirements 

DeviceIp  This field contains the device IP address, which must conform to 
standard dotted decimal IP address formatting. This field is required.  

DeviceName  Device name, a string of up to 64 characters. This field is optional.  

SnmpParaVersion 

NOTE: 

If the SnmpParaVersion field 
is 3, an SNMPv3 template is 
created. 

This field contains the SNMP version. Possible values include: 
 1 = SNMPv1, which is the default. 
 2 = SNMPv2c. 
 3 = SNMPv3. 

This field is optional. 

SnmpParaRead  
This field contains the SNMP read-only community name, a string of 
up to 32 characters. The default is public. This field is optional.  

SnmpParaWrite  
This field contains the SNMP write community name, a string of up to 
32 characters. The default is private. This field is optional.  

SnmpParaContextName  
This field contains the SNMPv3 context name, a string of up to 32 
characters. This field is optional.  

SnmpParaSecurityUser  

This field contains the SNMPv3 user name, a string of up to 32 
characters. Two users with the same name are considered as 
belonging to the same SNMPv3 template. This field is applicable to 
only SNMPv3. This field is optional.  

SnmpParaSecuMode  

This field contains the security mode. This value must match the 
SnmpParaAuthScheme and SnmpParaPrivScheme values. 
 1 = no authentication and no encryption. 
 2 = authentication but no encryption. 
 3 = authentication and encryption. 

This field is optional. 

SnmpParaAuthScheme  

This field contains the Authentication mode.  
 1 = none 
 2 = MD5 
 3 = sha 

This field is optional. 

SnmpParaAuthPassword  This field contains the authentication password, a string of up to 32 
characters. This field is optional.  

SnmpParaPrivScheme  

This field contains the encryption mode.  
 1 = none 
 2 = DES 
 19 = AES128 
 20 = AES192 
 21 = AES256 

This field is optional. 

SnmpParaPrivPassword  This field contains the encryption password, a string of up to 32 
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characters. This field is optional.  

SnmpParaTimeOut  This field contains the timeout value in seconds, which is 4 by default. 
This field is optional.  

SnmpParaRetry  This field contains the number of retries, which is 3 by default. This 
field is optional.  

PingDevType  

This field identifies whether or not the device responds to ping 
requests. The field is 0 by default.  
 1 = the discovered device responds to Ping requests.  
 0 = the discovered device does not respond to Ping requests.  

This field is optional. 

CustomViewName  

This field contains the name of the custom view name to which the 
imported device will be added. If the custom view name that you enter 
exists, IMC automatically adds the device to this custom view. If the 
name doesn't exist, IMC automatically creates the custom view and 
adds the device to it.  

This field is optional. 
 

Import file format requirements 

The requirements for a device import file are: 

 The extension of an import file must be CSV or TXT. 

 The first line or row of an import file must contain the following text only: [DEF] 

 The second line or row of an import file must contain at least one or more of the column 
labels separated by commas. Column labels with null values must also be separated by 
commas. 

 Only the first column label, DeviceIP, is required. All other columns are optional. 

 You must specify ONLY those columns in the second line or row that contain values in the 
device entry rows (line 3 and beyond) of the data import file. If, for example, you do not 
intend to include in your data import file, the public and private community strings for the 
devices you want to import, then do not include these column labels (SNMPParaRead and 
SnmpParaWrite) in the second line of your import file. 

For example, a valid entry for the second line of an import file that includes some but not all 
column labels is provided below. 

DeviceIp, DeviceName, SnmpParaVersion, SnmpParaRead, SnmpParaWrite,,,,,,,, 
SnmpParaTimeOut, PingDevType, CustomViewName. 

 The third line or row of an import file must contain the first entry for a device you want to add 
to IMC with field values (including fields with null values) separated by commas. All 
subsequent rows must follow the same conventions as the third line or row. 

 The third line or row must contain values only for the columns specified in line two of the 
data import file. In other words, if you did not specify a column label in line two, then you 
cannot specify the value in the third and all subsequent rows. 

A valid entry for lines 3 and 4 of an import file for the line 2 example provided above would 
be: 
DeviceIp,DeviceName,SnmpParaVersion,SnmpParaRead,SnmpParaWrite,,,,,,,,SnmpPara

TimeOut,,PingDevType, CustomViewName 

192.168.0.1,router1,1,public,private,,,,,,,,3,,0, 

9041::1-9041::10,switch1,2,public,private,,,,,,,,3,,0, 

These two lines have values for only those columns that were specified in line two. 

Here is a complete, sample import file using the examples provided above that use some 
but not all of the column definitions possible for data import. 
[DEF] 
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DeviceIp,DeviceName,SnmpParaVersion,SnmpParaRead,SnmpParaWrite,,,,,,,,SnmpPara

TimeOut,,PingDevType, CustomViewName 

192.168.0.1,router1,1,public,private,,,,,,,,3,,0, 

9041::1-9041::10,switch1,2,public,private,,,,,,,,3,,0, 

4. Click Import Device to begin the import process. 

The page is updated with the results of the device import.  

If the import file is encrypted, select Import Encrypted File, enter the file password in the 
Decrypt Password field and click Import Device. 

5. Review the results found on the Device Import Results page to verify that all the devices have 
been imported successfully. 

Exporting device information 

To export device information from IMC: 

1. Navigate to Resource > Import/Export Device: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Import/Export Device under Resource Management on the left navigation tree. 

2. On the Import/Export Device page, select Export Device. 

3. Click Export Device to begin the export process. 

To encrypt the export file, select Encrypt security sensitive content and enter the file 
password in the Encrypt Password field. 

4. To view and save the results of your export, click Device Export Result link located below the 
Download File portion of the Resource > Export Result page. 

To view an encrypted export file, click the Import Device tab in the Resource > Import/Export 
Device window, and then decrypt the file. 

Follow the instructions to complete the process of saving the export results. 

Importing devices from NNMi 

To import device information to IMC through NNMi: 

1. Navigate to Resource > Import/Export Device: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Import/Export Device under Resource Management on the left navigation tree. 

2. On the Import/Export Device page, select Import Devices from NNMi. 

3. Enter the parameters of NNMi. 

 Server IP Address—Allows you to configure the server IP address of NNMi for 
communications with IMC. 

 Server Port—Allows you to configure which port NNMi uses for communicates with IMC. 

 User Name—Allows you to configure the username of NNMi for communicates with IMC. 

 Password—Allows you to configure the password of NNMi for communicates with IMC. 

4. Click Import to begin the import process. 

The page is updated with device information imported from NNMi.  

5. Review the results found on the Device Import Results page to verify that the devices have 
been imported successfully. 

IMC supports importing devices from NNMi 9.00 or higher. 

The passwords and private keys of the devices are not imported into IMC. You must configure 
them after the devices are imported. 
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Importing device labels 

Use this function to update device labels of existing devices within the system in batches. 

To import device labels: 

1. Navigate to Resource > Import/Export Device: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Import/Export Device under Resource Management on the left navigation tree. 

2. On the Import/Export Device page, select Import Device Label. 

3. Click Browse next to Select File and select a file in the dialog box that opens. 

The import file must be in CSV or TXT format. 

Each line in the file defines a device with one column specifying the device IP and the other 
column specifying the new device label. IMC updates the device labels of the devices that 
match the device IPs in the import file. An example of a line of device data would be: 
90.16.0.5,SW1 

The field definitions for all columns in an import file are listed in Table 16. 

Table 16 Import file column definitions 

Column label  Column contents/requirements  

Device IP  
Device IP that uniquely defines a device whose label will be updated. 

This field is required. 

New device label  
New device label. 

This field is required. 
 

4. Click Import. 

Importing device locations 

Use this function to update device locations of existing devices within the system in batches. 

To import device locations: 

1. Navigate to Resource > Import/Export Device: 

a.  Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Import/Export Device under Resource Management on the left navigation tree. 

2. On the Import/Export Device page, select Import Device Locations. 

3. Click Browse next to Select File and select a file in the dialog box that opens. 

The import file must be in TXT format. 

Each line in the file defines a device with one column specifying the device IP and the other 
column specifying the new device location. IMC updates the device locations of the devices that 
match the device IPs in the import file. An example of a line of device data is 90.16.0.5,branch1, 
where the comma (,) is a delimiter. 

4. Click Import. 

Exporting device additional information 

Use this function to import device additional information for all devices in batches. This function is 
available only when you have configured device additional information. For more information about 
configuring device additional information, see "Device additional information." 

To export device additional information: 

1. Navigate to Resource > Import/Export Device: 
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a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Import/Export Device under Resource Management on the left navigation tree. 

2. On the Import/Export Device page, select Export Device Additional Information. 

3. Click Export Device Additional Information. 

The Download File page opens. 

4. Click the 
http://192.168.7.148:8080/imc/tmp/download?fileName=DeviceAppendInfo_20160924195451
.csv link to download the device additional information to a CSV file. 

Importing device additional information 

Use this function to add or update the device additional information for devices in batches. This 
function is available only when you have configured device additional information. For more 
information about configuring device additional information, see "Device additional information." 

To import device additional information: 

1. Navigate to Resource > Import/Export Device: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Import/Export Device under Resource Management on the left navigation tree. 

2. On the Import/Export Device page, select Import Device Additional Information. 

3. Click Browse next to Select File and select a file in the dialog box that opens. 

The import file must be in CSV or TXT format. 

Each line in the file defines a device by IP address and includes one or more device additional 
information fields and values. IMC adds or updates the device additional information of the 
devices that match the device IP addresses in the import file. An example of a line of device 
data would be: 
90.16.0.5,Area,1,Loc,a 

The field definitions for all columns in an import file are listed in Table 17. 

Table 17 Import file column definitions 

Column label  Column contents/requirements  

Device IP  
Device IP address that uniquely identifies a device. 

This field is required. 

Device additional 
information field  

Name of a field as an additional information parameter for a device. If the 
field already exists, IMC will update the value for the field. If the field does 
not exist, IMC will add the device additional field and value for the 
matching device. 

This field is optional. 

Device additional 
information value  

Value of an additional information parameter for a device. 

This field is optional. 
 

4. Click Import. 

Viewing devices with Device, IP, and Topology 
views 

IMC offers you a variety of options for viewing network resources and for drilling down into the 
features used to manage them. IMC provides you with a graphical representation of the physical 
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network in the Topology view. Table views of the network are provided in the Device View, IP View 
and Custom View. Each of these three view types offer you a real time snapshot of the status of 
devices in the network infrastructure. Also, all views offer drilldown capabilities to devices within the 
groups and ultimately to the device details for an individual device. The Device Details page 
provides you with access to IMC's network device management features. 

In the Device View, IP View, and Custom View, you can add interested performance indexes to the 
device list and sort them in ascending order. In addition, you can add the Interface List and Device 
List in Port Group and Custom View to the home page of IMC. 

Viewing devices through the Device View 
In the Device View, you can easily locate network resources by device type – Routers, Switches, 
Servers, Security, Storage, Wireless, Voice, Desktops and Others. IMC classifies devices that 
respond to ICMP requests but not SNMP requests as "Desktop" devices. IMC classifies as "Other" 
devices that respond to both ICMP and SNMP but do not conform to any of IMC's device 
classifications. IMC organizes devices into the Device View groupings by using the information 
stored in the Device Category field. 

This view, like all IMC views, offers you a real time snapshot of the status of devices in the network 
infrastructure through color-coded icons that match the highest severity or alarm level for devices in 
the view. Also, all views offer you high-level groupings of devices with drilldown capabilities to 
devices within the groups and ultimately to the device details for an individual device.  

From the Device Details page, you can access IMC management features that enable quick and 
easy access to network resources as well as the ability to manage them. 

You can add performance indexes to the device list in the Device View and sort them in ascending 
order. 

Accessing the Device View 

1. Navigate to Resource > Device View: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click View Management on the left navigation tree. 

c. Click Device View under View Management on the left navigation tree.  

By default, devices in all states are displayed. Click View in the upper part of the list, select 
View Device Status from the menu that appears, and select a state from the upper part of 
the page to display all devices in this state. Device status includes: 

 ALL 

 Critical 

 Major 

 Minor 

 Warning 

 Normal 

 Unknown 

 Unmanaged 

Each state is displayed as a different color.  

Click View in the upper part of the list, and select Include Desktops or Exclude Desktops 
from the menu that appears to display or exclude the desktops on the device list 

At the same time, the device list title changes when the device state changes and displayed 
as Device List – <Status> – <Include/Exclude Desktops> 

2. Point to the  icon on the left navigation tree. Device type icons are displayed in the popup 
menu. By default, the following device types are displayed: 
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 Click  Routers under Devices View on the left navigation tree for a summary view of 
all routers. 

 Click  Switches under Devices View on the left navigation tree for a summary view of 
all switches. 

 Click  Servers under Devices View on the left navigation tree for a summary view of all 
servers. 

 Click  Security under Devices View on the left navigation tree for a summary view of 
all security devices. 

 Click  Desktops under Devices View on the left navigation tree for a summary view of 
all desktop devices. 

 Click Others under Devices View on the left navigation tree for a summary view of all 
devices that were not classified by the categories listed above. 

If a device of any other type exists, the floating menu displays the icon of the corresponding 
device type. To enter the device list page for this type of device, click the icon. 

Each category of device in the Device View is followed by a number that is enclosed with 
square brackets []. This number represents the number of devices in that category. 

The status of a Device View depends on the status of the devices in it. The color of the 
group icon represents the highest severity or alarm setting of all devices in the category. 
The icon of a device view is grayed out if there is no device in the view. 

3. The following list contains all of the fields that are displayed for all device categories.  

 Status—Contains the latest status of the device. Status is determined by the highest 
severity or alarm level for the device, when the device has one or more current alarms that 
have not been cleared or recovered. 

 Device Label—Contains the IMC name for the device, which, by default, is the name 
assigned to it by IMC in its device configuration. If a device is configured with a sysName, 
the sysName is used as the Device Label unless the Device Label is manually configured. 
This field also contains the IP address. The contents of the device label field serve as an 
active link for drilling down into the Device Details page. This offers you convenient access 
to device management features for the selected device. 

You can modify the device label on the Device Details page. This changes IMC's name or 
label for the device in IMC only. It does not change the name of the device on the device 
itself. 

 Model—Contains device model information. If the device is managed for reachability using 
ICMP only and thus no device model information is available, this field contains "ICMP." 

 IP Address—Contains the IP address of the device. 

 Device Category—Contains the device type, such as router, switch, and server. 

 Operation—Contains an icon that displays links to operational tasks for the associated 
device. 

4. Customize the columns displayed in the Device List to add interested data to the Device List. 

a. Click View in the upper part of the list, and select Customize Columns from the menu that 
appears. 

The Customize Columns window opens. 

The columns that can be customized include: 

 Model 

 IP Address 

 Vendor 
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 Device Category 

 Location 

 Contact 

 CPU Usage (%) 

 Memory Usage (%) 

 Device Response Time (ms) 

 Device Unreachability (%) 

 Rx Rate(datagrams/s) 

 Fw Rate(datagrams/s) 

 Rx Discards (%) 

 Tx Discards (%) 

 Rack 

b. Select the columns to be displayed and click OK. The selected columns and the data 
collected within the last five minutes are displayed in the Device List. 

In the Device List, the Status, Device Label, and Operation columns are required. The 
default columns that can be displayed are Model, IP Address, and Device Category. 

5. You can sort the device list by a column by clicking the column label. Click the column label to 
sort the list by the selected field. The column label is a toggle switch that allows you to toggle 
between the various sort options specific to each field. 

If the Device List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Device List. 

 Click  to page forward to the end of the Device List. 

 Click  to page backward in the Device List. 

 Click  to page backward to the front of the Device List. 

6. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items 
per page you want to view. 

IMC enables you to manage multiple devices through the Device View. This includes deleting, 
synchronizing, managing and unmanaging devices. For information about managing multiple 
devices through these views, see "Managing multiple devices using batch operations." 

IMC supports generating real-time charts based on the data of Device View. Click Generate Chart, 
and select Add Chart Template or Manage Chart Template from the menu that appears. For more 
information about the left operations, see "Adding chart templates" and "Managing chart template." 

IMC supports exporting the device list to an Excel file. To generate and download an Excel file, click 
Export Excel, and then click Download Exported Data on the page that opens. 

Viewing devices through the IP view 
The IP View offers you a view of network resources by the IP address ranges found in the discovery 
process or added manually. 

This view, like all IMC views, offers you a real time snapshot of the status of devices in the network 
infrastructure through color-coded icons that match the highest severity or alarm level for devices in 
the view. 

Also, all views offer you high-level groupings of devices with drilldown capabilities to devices within 
the groups and ultimately to the device details for an individual device. From the Device Details 
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page, you can access IMC management features that enable quick and easy access to network 
resources as well as the ability to manage them. 

You can add options or performance indexes to the device list in the IP View and sort the data in 
ascending order. 

Accessing the IP view 

1. Navigate to Resource > View-IP View: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click View Management on the left navigation tree. 

c. Click IP View under View Management on the left navigation tree. 

2. Display all automatically assigned IP address ranges in IMC in a table. 

 Status—Contains the latest status of the group. Status is determined by the highest 
severity or alarm level for a device in the group, when the device has one or more current 
alarms that have not been cleared or recovered. Group icons with the color gray indicate 
that there are no managed devices in the view. 

 Subnet—Contains a link to entering the device list of an IP subnet view. This option 
searches for manageable devices by the specified IP address range. It contains the network 
address and mask of an IP address group and displays the number of devices in this IP 
address group. Click the name link of an IP address range to enter the device list page of 
the subnet. 

 View Topology—Contains a link to entering the IP topology view. Click the View Topology 
link to enter the IP topology view of the subnet. 

3. Hover over IP View on the left navigation tree. IP subnet views assigned by IMC according to IP 
addresses of all devices are displayed in the popup menu. 

4. Click the IP address subnet view icon  for which you want to view devices. The color of the 
subnet icon represents the highest severity or alarm setting of all devices in the IP subnet. The 
device list for the selected IP subnet is displayed. 

Each IP address subnet in the IP View is followed by a number that is enclosed with square 
brackets ([]). This value represents the number of devices in that subnet. 

IMC displays all IP View entries, including subnets and individual devices in the IP View Device 
List displayed in the main page of the IP View window. 

Device List 

 Status—Contains the latest status of the group. Status is determined by the highest 
severity or alarm level for a device in the group, when the device has one or more current 
alarms that have not been cleared or recovered. Group icons with the color gray indicate 
that there are no managed devices in the view. 

 Device Label—Contains the IMC name for the device, which, by default, is the name 
assigned to it by IMC in its device configuration. This field also contains the IP address. The 
device label serves as an active link for drilling down into an IP address subnet Device List 
or into the Device Details page of an individual device. 

 Model—Contains device model information. If the device is managed for reachability using 
ICMP only and thus no device model information is available, this field contains "ICMP." 

 IP Address—Contains the IP address of the device. 

 Device Category—Contains the IMC device category for the associated device. 

 Operation—Contains an icon that displays links to operational tasks for the associated 
device. 

5. Customize the columns displayed in the Device List to add interested data to the Device List. 

6. Click Customize Columns in the upper right corner of the page. The Customize Columns 
window opens. 

The columns that can be customized include: 
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 Model  

 IP Address 

 Vendor 

 Device Category 

 CPU Usage (%) 

 Memory Usage (%) 

 Device Response Time (ms) 

 Device Unreachability (%) 

 Rx Rate (datagrams/s) 

 Fw Rate (datagrams/s) 

 Rx Discards (%) 

 Tx Discards (%) 

7. Select the columns to be displayed and click OK. The selected columns and the data collected 
within the last five minutes are displayed in the Device List. 

In the Device List, the Status, Device Label, and Operation columns are required. The 
default columns that can be displayed are Model, IP Address, and Device Category. 

You can sort the IP View List by every field with the exception of the Operation fields. Click the 
column label to sort the list by the selected field. The column label is a toggle switch that allows 
you to toggle between the various sort options specific to each field. 

The status of an IP View or IP subnet depends on the status of the devices in it. The color of the 
group icon represents the highest severity or alarm setting of all devices in the IP subnet. The 
icon of an IP view or subnet is grayed out if there is no device in the view. 

If the Device List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Device List. 

 Click  to page forward to the end of the Device List. 

 Click  to page backward in the Device List. 

 Click  to page backward to the front of the Device List. 

8. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items 
per page you want to view. 

IMC enables you to manage multiple devices through the IP view. This includes deleting, 
synchronizing, managing and unmanaging devices. For information about managing multiple 
devices through these views, see "Device list management options." 

Viewing devices through the network topology 
Similar to Network Topology (Applet), Network Topology provides a graphical view of the health 
and status of network connectivity and devices, allowing you to quickly and easily locate, monitor, 
modify, and manage network devices directly from this graphical representation of the network. 

You can use a browser to open the topology and you do not need to install a Java plugin that is 
needed for opening the Applet topology. 

Accessing the network topology 

To access the network topology: 

1. Click the Resource tab from the top tabular navigation system. 

2. Click View Management on the left navigation tree. 
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3. Click Network Topology under View Management on the left navigation tree. 

Navigating the network topology interface 

Upon a successful auto discovery, IMC automatically generates topology maps and organizes 
discovered devices into topology views based on the groupings found. The groupings are navigated 
using the topology navigation system located on the left of the Network Topology map. To expand  

the groupings displayed on the left navigation system, click the Expand icon . 

The created topology groupings include: 

 Custom Topology—Contains topology views for the custom views that the operator has 
management rights to and contains the custom views that you have been granted access to as 
well as any custom views that have been created. 

 IP Topology—Contains topology views of devices grouped by IP address. 

 Data Center Topology—Contains user-defined views created by the administrator or operator. 
The Data Center Topology contains any custom data center maps that include floor plans and 
graphical representations of data centers down to individual racks and the devices in them. 

 Converged Topology—Contains topology views that converge multiple topologies into one 
topology. You can customize converged topology views as needed, which helps you monitor 
and manage topologies of multiple services. 

 VRM Topology—Contains a view of the virtual network devices, including physical servers, 
virtual machine and vSwitches on each physical server, and how they are connected. 

The navigation tree on the left allows you to move quickly to the particular view displayed in the 
navigation tree. 

For example, clicking one of the custom views you have created opens a new tab in the main pane 
and displays all of the device icons for the devices in the selected Custom Topology. 

Clicking one of the IP Topology opens a new tab in the main pane and displays all of the devices in 
the selected IP Topology group. 

Topology map toolbar 

The Topology Maps interface includes several menu options that support the use and 
customization of topology maps. These toolbar options are described below. 

  Displays the network in its original proportion. 

  Enables you to zoom in on the topology view. 

  Enables you to zoom out on the topology view. 

  Enables you to fit the contents of the topology view into the window. 

  Enables you to magnify the contents on the topology view. Right-click the magnified area 
to set the shape and the zoom factor for the magnifier on the menu that appears. To exit 
magnify mode, click the icon again. 

  Provides a separate bird's eye view window of the topology map. 

  Enables you to hide the left navigation tree and tabs to display the topology in full screen. 

  Enables you to display the left navigation tree and tabs from the full screen mode. 

  Enables you to grab and move one or multiple objects in the topology view within the 

confines of the pane. Click the icon to switch to the Pointer Tool , which allows you to move 
the entire topology view within the confines of the pane. 
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  Enables you to browse and load a background image into the topology view. The 
background image can be a picture from your local collection, a picture from the server, a .cad 
file, or a GIS map. 

  Enables you remove a background image from the topology view. 

  Allows you to save topology view settings. 

  Enables you to save the current topology view as an image (.png) file. 

  Enables you to save the current topology view as a Visio (.vdx) file. 

  Enables you to organize icons according to a pre-defined structure to the topology view. 
Options for organizing topology views include union length, tree, star, ring or grid. 

  Allows you to back to the upper-level topology. 

  Navigates you to the Resource > Add Device dialog box for adding device to IMC. For 
more information about adding a device in IMC, see "Adding devices manually to IMC." 

  Allows you to add devices to the converged topology view. 

  Allows you to add virtual devices to the converged topology view. 

 Allows you to add wireless devices to the converged topology view. 

  Allows you to add a cloud icon to the topology view. 

  Enables you to add a note on the topology view. 

  Allows you to add a link on the topology view. 

  Allows you to browse, add, and query links on the topology. 

  Offers you the ability to search and retrieve devices in the topology view by IP address or 
by IMC label. In data center view, you can locate a device in the rack topology according to its 
asset number. 

  Enables you to display the empty edge subnet on the IP topology. 

  Enables you to hide the empty edge subnet on the IP topology. 

  Allows you to select an MST instance. 

  Allows you to view the MSTP Region Details. 

  Displays a legend for the topology view. 

  Allows you to draw irregular nodes on the topology background. Click the icon, configure 
the Shape, Label, Label Position, Border, Fill Color, Opacity, Fill, and Auto Save fields, 
and click OK. 

  Allows you to exit the editing mode for drawing irregular nodes on the topology background. 
After you exit the editing mode, right-click an irregular node to modify or delete the irregular 
node on the menu that appears. The right-click menu is available only when you have selected 

Auto Save or clicked the Save icon  for that irregular node. 

  Allows you to display or hide grids. The grids is under the background picture. 

 Displays the Traffic Topology. The Traffic Topology feature applies only to the current 
topology. For more information about the traffic topology, see "Viewing traffic with traffic 
topology." 
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  Displays a list on the right of all VLANs. By default, VLANs are sorted by VLAN ID in 
ascending order. Selecting a VLAN from this list filters the topology view to highlight only those 
devices that are members of the selected VLAN.  

   Allows you to have a data center topology map automatically built. For more information 
about automatically building data center topology maps in IMC, see "Managing data center 
topology maps." 

  Allows you to customize the topology view by defining the tree and grid layout, save, 
display and color options. This option also allows you to set the opacity of the hidden nodes in 
IP View. You can select 2D Icon or 3D Icon from the Icon Type list to display icons in 2D or 3D 
in topologies. 

Left & right mouse clicks: Monitoring and management 

Topology maps have special left and right-click mouse features. The left mouse click supports device 
monitoring options while the right mouse click supports device management options. 

Device and link monitoring through the left mouse click 

To display information about a node or link, left-click the selected node or link on the topology map. 
The information displayed varies based on the node or link type selected.  

To select a node or link, click the node or link using the left mouse button. Some of the information 
displayed provides links that allow you to drill down into IMC features or perform certain actions.  

 Device Label—This field contains the IMC name for the device that is assigned during the 
configuration. If the device has a sysName at the time of configuration, this name becomes the 
Device Label. 

The device label serves as an active link for drilling down into the Device Details page, which 
provides convenient access to device management features. The Device Details page loads in 
the browser instance that originally launched the topology maps, not in the browser instance 
that has the topology maps loaded. 

 IP Address/Mask—Contains the management IP address and mask of the device. 

 Device Status—Contains the latest status of the device. Status is determined by the highest 
severity or alarm level for the device, when a device has more than one current alarm that has 
not been cleared or recovered. Gray device icons indicate the device is unmanaged. 

 SysName—Contains the name that is configured on the device. 

 Vendor—Contains the device vendor's name. 

 Runtime—Contains the total operating time of the device. The value is obtained in last polling 
and accurate to the millisecond. 

 Last Poll—Contains the time when IMC last polled the device. For information about setting the 
device polling period, see "Using batch mode to configure polling intervals." 

 Unrecovered Alarms—Number of unrecovered critical, major, minor, and warning alarms, 
listed separately. Click the link to enter the device alarm details page, where you can process 
device alarms.  

 Performance Monitoring Data—Related performance monitoring data are displayed here 
after you add monitoring indexes on the performance management page and configure the 
data shown in the topology. 

For links, the left mouse click includes the following: 

 Link Name—Contains a name for the link if one is available. Otherwise, a device label displays. 

 Link Type—Contains information about the link type. 

 Left Node—Contains the device label for the device that is located on the left of the link as 
represented in the topology map. 

 Left Interface—Contains the interface name for the device that connects on the left in the 
topology map. Click the link to view the interface details.  
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 Left Interface Alias—Contains the interface alias for the device that connects on the left in the 
topology map. 

 Left Interface VLAN Type—Port link type of the left interface. This field is displayed only when 
VLAN is enabled on the device. The value is displayed only when a port link type is configured 
for the left interface. 

 Left Interface Allowed VLAN—The allowed VLANs on the left interface. This field is displayed 
only when VLAN is enabled on the device. The value is displayed only when the left interface is 
assigned to VLANs. 

 Right Node—Contains the device label for the device that is located on the right of the link as 
represented in the topology map. 

 Right Interface—Contains the interface name for the device that connects on the right in the 
topology map. Click the link to view the interface details. 

 Right Interface Alias—Contains the interface alias for the device that connects on the right in 
the topology map. 

 Right Interface VLAN Type—Port link type of the right interface. This field is displayed only 
when VLAN is enabled on the device. The value is displayed only when a port link type is 
configured for the right interface. 

 Right Interface Allowed VLAN—The allowed VLANs on the right interface. This field is 
displayed only when VLAN is enabled on the device. The value is displayed only when the right 
interface is assigned to VLANs. 

 Link Speed—Contains the speed of the link in bits per second. 

 Performance Monitoring Data—Related performance monitoring data are displayed here 
after you add link monitoring indexes on the performance management page for devices at both 
ends of the link and configure the data shown in the topology.  

Device management through the right mouse click 

Right-click a selected node on the topology map to display a list of management options that can be 
used to manage the selected node or link and a right-click the blank area to display a menu for map 
configuration. 

The right mouse click on a device includes one or more of the following management options, 
depending on the view and device model: 

 Create Subview—Allows you to create logical subviews of devices that are displayed on the 
topology map for all users of the topology map. For more information about creating subviews, 
see "Customizing topology maps." 

 Open Web-Based NMS—Allows you to launch the Web Manager interface for the selected 
device directly from the topology map. Selecting this option opens the Web Manager in a new 
browser window that can be accessed through the tabs located at the top of the main pane. 
From this window, you can manage the selected device. For more information about the Web 
Manager, see "Open Web manager." 

 Open Device Panel—Allows you to launch the Device Panel interface for the selected device 
directly from the topology map. Selecting this option opens the Device Panel in a new pane in 
the topology window that can be accessed through the tabs located at the top of the main pane. 
From this window, you can manage the selected device. For more information about the Device 
Panel, see "Open device panel." 

 Modify Device Icon—Allows you to modify the device icon. It is available only for Custom 
Topology.  

To modify the device icon: 

a. Select Modify Device Icon. 

The Modify Device Icon dialog box opens. 

b. Do one of the following: 

 From the Select Icon list, select an icon for the device. 
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 Click Upload New Icon. 

In the dialog box that opens, click Select to upload a local icon. 

The system automatically renders the icon in 7 colors to indicate the seven alarm 
levels. If you are not satisfied with the effect of any icon, click Modify next to this icon to 
re-upload an icon. 

Click OK. 

 Click OK to confirm the change to the device icon. 

The device icon in the IP Topology changes accordingly. 

 Device Information—Opens the Device Details page for the selected device. The Device 
Details page loads in the browser instance that originally launched the topology maps, not in 
the browser instance that has the topology maps loaded. For more information about the 
Device Details page, see "Managing one device through device details." 

 Neighbor Topology—Enables you to view a portion of the network from the perspective of the 
selected device. When prompted, select the number of hops you want to include. IMC opens a 
new pane in the topology window for this map, which can be accessed through the tabs located 
at the top of the main pane. From this window, you have access to the monitoring features 
available using the left mouse click only. 

 LLDP-MED Topology—Displays the media endpoint devices that the selected device has 
learned through LLDP-MED and the endpoint devices that access the network through the 
media endpoint devices. Media endpoint devices include the following types: MED Generic 
Endpoints, MED Media Endpoints, and MED Communication Device Endpoints. IMC uses 
different icons to represent the three types of media endpoint devices. This option is available 
only when LLDP-MED has been enabled on the device. 

 Spanning Tree—For more information about configuring spanning tree for devices that support 
it, see "Managing MSTP options for routers and switches." 

 Topology Diagnosis—Enables you to view the topology diagnosis methods and results. This 
option is only available on the IP topology. 

 VRRP Information—Enables you to view VRRP information for the selected device. VRRP 
typically adds a group of routers to a VRRP group called a "virtual router" to serve as the default 
gateway. This option is available only when the device has been configured with VRRP. 

Select VRRP Information. The VRRP Information window opens. 

The left of the window displays the VRRP list: 

 ID—ID of the virtual group. 

 IP—IP address of the virtual router. This IP address is the default gateway address of the 
terminal devices. 

 Master IP—IP address of the master router. A VRRP group comprises one master router 
and multiple backup routers. When the master router fails, the backup router with the 
highest priority takes over as the new master router to serve as the default gateway. 

 MAC—MAC address of the virtual router. 

The right side of the window displays detailed VRRP information about each router in the VRRP 
group. 

 Tools-Ping—Enables you to launch a ping request sent from the IMC server to the selected 
device and launched from the topology map. IMC opens a new browser window for the ping 
operation and the results of the ping operation display in the new browser instance. 

 Tools-Telnet—Enables you to launch a telnet session for the selected device directly from the 
topology map that prompts you for the application on the local computer that supports Telnet. 

 Tools-Traceroute—Enables you to launch a traceroute request sent from the IMC server to the 
selected device and launched from the topology map. 

IMC opens a new browser window for the Traceroute operation and the results of the traceroute 
operation display in the new browser instance. 
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 Tools-SSH—Enables you to launch an SSH session for the selected device directly from the 
topology map that prompts you for the application on the local computer that supports SSH. 

 Copy—Enables you to copy a device. 

 Delete—Enables you to delete devices from IMC, removing the selected device from all views 
and all data associated with the device during the next scheduled Data Export, which by default 
is 2:00 am daily. 

 

 CAUTION: 

Once a device is deleted, it cannot be recovered. Use this feature with caution. 
 

 Delete from Subview—Enables you to remove the selected device from its current subview 
and return it to the parent view. Deleting the last device from the subview removes the subview 
from the topology view. This option is displayed only on the device that belongs to a subview. 

 Delete Device from This View—Enables you to remove the selected device from the current 
view if the device is not a member of any subview. 

 Modify Label—Enables you to change IMC name for the selected device from the topology 
map. Changing the Device Label in IMC does not change the device name or sysName on the 
device itself. 

 Set Hold—Enables you to configure the maintenance tag for the selected device. You can add 
maintenance tags for devices that are being maintained. 

 Set Hold-Start Hold—Enables you to add a maintenance tag for the selected device. This 
option is displayed only for devices that do not have maintenance tags. 

 Set Hold-Modify Hold Description—Enables you to modify the maintenance tag 
information. This option is displayed only for devices that have maintenance tags. 

 Set Hold-Stop Hold—Enables you to cancel the maintenance tag for the selected device. 
This option is displayed only for devices that have maintenance tags. 

 Hide—Enables you to hide selected nodes. You can hide nodes only in IP view and the option 
only takes effect in IP view. You can set the opacity of the hidden nodes in IP view by using the 

Advanced Setting option  in the toolbar in the upper part of the topology view. 

 Synchronize—Enables you to update IMC views with current data for the selected device. 

 Unmanage/Manage—Acts as a toggle switch, enabling you to unmanage or manage the 
selected device in IMC. During discovery, IMC adds all discovered devices to the IMC database 
and configures them to be managed. Managed devices contain features that are available for 
monitoring and managing the devices. Each device, managed or unmanaged, requires a node 
license. 

 Lock/Unlock—Enables you to fix the position of a particular device on the topology map, 
rendering it unmovable until the device is unlocked. This feature is also a toggle switch that 
enables you to either lock or unlock the selected device. 

 Open Stack Topology—If the device is a stack device, the Open Stack Topology option 
becomes available on the right-click shortcut menu of the device. This feature launches a Stack 
Topology page displaying the internal structure of the stack with the selected stack device. The 
Stack Topology page can be accessed through tabs located at the top of the main pane of the 
topology page. For more information about the stack topology, see "Managing stack devices 
with the stack topology." 

Link management through the right mouse click 

Right-click a selected link on the topology map to display a list of management options that can be 
applied to the selected link and a right-click the blank area to display a menu for map configuration. 

The right mouse click on the selected link includes one or more of the following management options 
for links: 

 Link Information—Provides you with detailed information on the selected link, including basic 
information as well as information about the interfaces on either side of the link. Information 
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includes link name, status, device information, operational and administrative status of each 
interface, IP address and subnet information and more. On the Left/Right Interface tab, you can 
view MP interfaces and PoE interfaces. 

 Modify Link Name—Enables you to modify a label or name in IMC for the selected link. 

 Modify Link Interface—Enables you to modify the interface on either side of the selected link. 

 Delete Link—Enables you to delete the link. 

 Adding Break Point—Enables you to add a break point on the selected link. Drag the point to 
display the link as a broken line. 

 Set Hold—Enables you to configure the maintenance tag for the selected device. You can add 
maintenance tags for devices that are being maintained. 

 Set Hold-Start Hold—Enables you to add a maintenance tag for the selected device. This 
option is displayed only for devices that do not have maintenance tags. 

 Set Hold-Modify Hold Description—Enables you to modify the maintenance tag 
information. This option is displayed only for devices that have maintenance tags. 

 Set Hold-Stop Hold—Enables you to cancel the maintenance tag for the selected device. 
This option is displayed only for devices that have maintenance tags. 

 Add Monitor—Allows you to enable the performance monitoring feature for the selected link. 
After this feature is enabled, the system performs real-time monitoring on the performance 
indexes specified for the link. 

 Real-Time Monitor—Allows you to view the receive and transmit rates of the interface on 
either end of the selected link.  

 Interface Receiving Rate—Select this option to monitor the receive rate (in bps) of the 
interface on either end of the selected link. The receive rates are displayed in graph form. 

 Interface Transmitting Rate—Select this option to monitor the transmit rate (in bps) of the 
interface on either end of the selected link. The transmit rates are displayed in graph form. 

Customizing topology maps 

You can customize the topology maps. Options for customizing topology maps include creating 
subviews, adding clouds, adding devices, setting default topology views, configuring device and link 
labels and creating views of multiple levels which are not restricted. 

Custom topology management through the right mouse click 

The right-click shortcut menu allows you to re-load custom views, add custom views, and set the 
default topology. The menu contains the following options:  

 Reload—Refreshes the current topology view. 

 Add View—Allows you to add a custom view. 

 Set Default Topology View—Enables you to define which topology view loads when an 
operator selects the Network Topology link located on the left navigation tree of IMC Web 
interface. By default, the Custom View is loaded. 

 Zoom—Enables you to zoom in or out of the topology view or to fit the contents of the topology 
map into the current window. 

To add a custom view: 

1. Right-click a blank area in the Custom Topology, and select Add View from the shortcut 
menu. 

The Add View window opens. 

2. Enter the view name. 

3. Select an upper-level view for the custom view in the Up Level View list. 

4. Specify whether to automatically add the newly added devices to the view. 

The options in the Automatically Add New Devices list include: 

 None—Not automatically adding the newly added devices to the view. 
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 All—Automatically adding every newly added device to the view.  

 From Designated Rule—Adding newly added device to the view based on the designated 
rule. The designated rule includes: 

 Designated Network—Automatically adding newly added devices whose IP addresses 
are on the specified IP network segment to the view. 

 Designated Device Type—Automatically adding newly added devices whose device 
models are among the specified device models to the view. 

 Designated System Name—Automatically adding newly added devices whose system 
names are in the specified system name list to the view. 

 Designated Contact—Automatically adding newly added devices whose contacts are 
in the specified contact list to the view. 

 Designated SysLocation—Automatically adding newly added devices whose system 
locations are in the specified system location list to the view. 

5. Click the  check box to the left of Add all devices of the current system to add all devices 
in IMC to the view. Clear the check box to add the specified devices to the view. 

6. Click Add to enter the Select Devices window. You can click Add to manually add one or more 
devices to the current view when the Add all devices of the current system is unselected. 

7. Add devices using either the By View or the Advanced query option.  

See "Adding devices by view" and "Adding devices by advanced query." 

8. Highlight the devices you want to select and do one of the following: 

 To add them to the Selected Devices list, click Add selected . 

 To select all of the devices displayed in the Devices Found list, click Add all . 

 To remove one or more, select them and click Remove selected . 

 To remove all of the selected devices, click Remove all . 

9. Confirm that the devices you have found have been added. 

10. Click OK. 

11. To delete devices from the list, select the devices to be deleted, and click the Delete icon . 

Topology map options 

Right-click the topology background to access menus for using and customizing topology maps. The 
options for customizing topology maps include: 

 Create Subview—Enables you to create logical device views. From the Create Subview 
dialog box, you can add devices to the subview using the View or Advanced query feature. 

 Add Cloud—Enables you to add a cloud icon to the topology view. You can configure a link to 
the IP Topology or Custom Topology for the cloud. The color of the cloud is determined by the 
device with the highest alarm level in IP Topology or Custom Topology. 

 Add Note—Enables you to add a note for a topology view. 

 Add Device—Enables you to launch the Add Device page found under the Resource tab, 
Resource > Add Device. Using the Add Device feature, you can add devices to IMC. The 
Add Device page loads in the browser instance that originally launched the topology maps, not 
in the browser instance that has the topology maps loaded. For more information about using 
the Add Device feature, see "Adding devices manually to IMC." 

 Add Device to This View—Enables you to add one or more devices to this view. 

 Modify View—Enables you to modify this view. This feature also enables you to specify the 
upper-level view of this view. 

 Add Link—Enables you to add a link. 
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 Link Management—For other link management operations, see "Left & right mouse clicks: 
Monitoring and management." 

 Topology Integrity Analysis—Launches a Topology Integrity Analysis window, displaying 
all neighboring devices that are connected to a device on the topology but are not added to 
IMC. The analysis is based on LLDP, NDP, CDP, and STP table entries. The list contains the 
following parameters: 

 Root Device IP—IP address of the root device to which the neighboring device that is not 
added to IMC is connected. 

 Connected Interface Description—Description of the interface through which the root 
device is connected to the neighboring device that is not added to IMC. 

 IP of Device not in IMC—IP address of the neighboring device that is not added to IMC. 

 MAC of Device not in IMC—MAC address of the neighboring device that is not added to 
IMC. 

 SysName of Device not in IMC—System name of the neighboring device that is not added 
to IMC. 

 Description of Device not in IMC—Description of the neighboring device that is not added 
to IMC. 

 Search—Launches a simple dialog box that enables you to search IMC for a device by IP 
address or device label. The results display in the Search Result dialog box in a tabular format. 
To search device over the whole network, select Network-Wide Search. To search devices 
over the current view, leave Network-Wide Search unselected. 

 Paste—Enables you to paste the copied device nodes or links to the specified custom topology. 
This feature applies to only device nodes and links. Before pasting a link to a custom topology, 
you should copy the devices at both ends of the link to the custom topology. This feature is not 
available for IP topologies and Layer 2 topologies. In a custom topology, you can paste the 
copied device nodes or links to a subview.  

 Reload—Refreshes the current topology view. 

 Modify Font—Enables you to modify the font of the current topology. The topology-specific font 
setting takes precedence over the global font setting. 

 Path Topology—Enables you to trace a path between any two devices by entering their IP 
addresses. The results of the path topology view is displayed on a new page in the main pane of 
the topology page. This view can be accessed through the tabs located at the top of the main 
pane. 

 Analyze Route—Enables you to use the tracert function to view the Layer 3 devices that IP 
packets go through from the source device to the destination device. You can use this function 
to check the network connectivity and analyze which network nodes failed. To use the function, 
you must enable the function of sending ICMP timeout messages on the intermediate devices 
and the function of sending ICMP destination unreachable messages on the destination device. 

Configure the following parameters in the dialog box that opens: 

 Device IP—Enter an IP address of a source device. 

 Source Interface IP—Select an interface for the source device. 

 Destination Device IP—Enter an IP address of a destination device. 

 Timeout Period (ms)—Enter a timeout period. The current hop is considered as 
unreachable after the timeout period expires during the route analyzing process. 

 VPN Instance Name—Enter a VPN instance name. 

You can also select two devices and right-click to select Analyze Route from the shortcut 
menu. 

 Set Default Topology View—Enables you to define which topology loads when an operator 
selects the Network Topology link located on the left navigation tree of IMC Web interface. By 
default, the Custom View is loaded. 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 8680



279 

 Enable Ping Topology—Allows you to view devices by reachability state on the topology. 
When this option is selected, a device icon on the topology is either green or red. Green icons 
represent devices that can be pinged from IMC. Red icons represent devices that cannot be 
pinged from IMC and are unreachable 

 Device Label—Allows you to decide which label is used to denote the various devices 
displayed on a topology map. Options include Show IP, Show Label, Show SysName, Show 
Vendor, Show Device Type, Show Device Model, and No Label. 

 Link Label—Allows you to decide which label is used to denote the various links displayed on a 
topology map. Options include Show Name, Show Type, Show Node (Device Name), Show 
Interface, Show Interface Alias, and No Label. 

For Show Interface, which supports showing abbreviated interface names, you can customize 
the abbreviation rules through the configuration file as follows: 

a. Log in to the server that has IMC installed. 

b. Open the file linKInterface.xml in the path IMC installation path\client\conf\topo. 

The file displays: 
<?xml version="1.0" encoding="UTF-8"?> 

<linkAlias name="Link name abbreviation definition"> 

<linkName> 

   <region> 

     <fullname>GigabitEthernet</fullname> 

     <abbreviation>GE</abbreviation> 

   </region> 

<region> 

     <fullname>Ethernet</fullname> 

     <abbreviation>E</abbreviation> 

</region> 

  </linkName> 

 </linkAlias> 

c. Edit the file linKInterface.xml as required 

The file predefines the abbreviations for GigabitEthernet and Ethernet. You can use the 
following lines to modify the file content: 
<region> 

     <fullname>FastEthernet</fullname> 

     <abbreviation>FE</abbreviation> 

</region> 

The lines contain the following items: 

 Fullname—Full name of the interface type. 

 Abbreviation—Abbreviation of the interface type name. 

For example, the preceding lines indicate that the abbreviation for FastEthernet is FE. 

d. Save and close the file linKInterface.xml. 

e. Restart IMC in the Deploy tab of Intelligent Deployment Monitoring Agent, or restart the 
jserver process in the Process tab. 

The changes take effect after IMC or the jserver process is restarted. 

 Hand tool—Enables you to grab and move the topology view within the confines of the pane. 

To exit this mode, click the Pointer Tool icon  in the topology map toolbar. 

 Zoom—Enables you to zoom in or out of the topology view or to fit the contents of the topology 
map into the current window. 
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Managing stack devices with the stack topology 

The stack topology enables you to manage stack devices directly from the topology view, by allowing 
you to view the stack members, link status among stack members, and link status among stack 
members and external devices, and delete invalid stack members.  

To view stack devices from the stack topology: 

1. Click the Resource tab from the top tabular navigation system. 

2. Click View Management on the left navigation tree. 

3. Click Network Topology under View Management on the left navigation tree. 

4. Double-click any custom topology under Custom Topology or IP topology under IP 
Topology. 

A new page for the Custom Topology or IP Topology opens on the main pane. Multiple pages 
in the main pane can be navigated using the tabs located at the top of the main pane. 

5. To access the stack topology, do one of the following:  

 Right-click the stack device icon  and select Open Stack Topology from the shortcut 
menu. 

 Double-click the stack device icon. 

A new page for the stack topology opens on the main pane. 

6. Use the tabs located at the top of the page to navigate between topology maps. 

7. Select the tab located at the top of the page for the stack topology you want to display. 

The stack device icon expands as a rectangle. From this rectangle you can view the internal 
structure of the stack. 

The device marked with the Master device icon  is the master device of the stack, and the 
other devices are all subordinate devices. The links among the stack members show the 
internal structure of the stack. The links among the stack members and external devices show 
how the stack is connected to external devices. 

8. Double-click the rectangle to collapse the stack device to a stack device icon. 

9. Click a rectangle, stack member, or stack link. 

The stack topology displays information about the selected stack device, stack member, or 
stack link. 

For the stack device, the left mouse click includes the following: 

 Device label—Contains the IMC name for the stack device, which, by default, is the name 
assigned to it by IMC in its device configuration. If the stack device is configured with a 
sysName, IMC uses this as the Device Label unless a Device Label has been manually 
configured. The stack device label serves as an active link for drilling down into the Device 
Details page, which offers you convenient access to device management features. 

 IP Address—Contains the management IP address of the stack device. 

 Mask—Contains the mask of the management IP address. 

 Device Status—Contains the latest status of the stack device. Status is determined by the 
highest severity or alarm level for the stack device, when a stack device has more than one 
current alarm that has not been cleared or recovered. 

 Sysname—Contains the name that is configured on the stack device. 

 Vendor—Contains the stack device vendor's name. 

For the stack member and stack link, the left mouse click includes the following: 

 Device label—Contains the device label of the stack member. 

 Stack Member ID—Contains the stack member ID. 

 Stack Member Role—Contains the role of the stack member, which can be Master or 
Slave. 
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 Link Name—Contains the name for the stack link. 

 Line Type—Contains information about the stack link type. 

 Left Node—Contains the device label for the stack member device that is located on the left 
of the link as represented in the stack topology map. 

 Left Physical Interface—Contains the physical interface name for the device that connects 
on the left in the stack topology map. 

 Left Logical Interface—Contains the logical interface name for the device that connects on 
the left in the stack topology map. 

 Right Node—Contains the device label for the stack member device that is located on the 
right of the link as represented in the stack topology map. 

 Right Physical Interface—Contains the physical interface name for the device that 
connects on the right in the stack topology map. 

 Right Logical Interface—Contains the logical interface name for the device that connects 
on the right in the stack topology map.  

 Link Speed—Contains the speed of the stack link in bits per second. 

To delete invalid stack members from the stack topology: 

1. Click the Resource tab from the top tabular navigation system. 

2. Click View Management on the left navigation tree. 

3. Click Network Topology under View Management on the left navigation tree. 

4. Double-click either Custom Topology or IP Topology under Topology. 

A new page for the Custom Topology or IP Topology opens on the main pane. Multiple pages 
in the main pane can be navigated using the tabs located at the top of the main pane. 

5. To access the stack topology, do one of the following: 

 Right-click the Stack Device icon  and select Open Stack Topology from the shortcut 
menu. 

 Double-click the stack device icon. 

A new page for the stack topology opens on the main pane.  

6. Use the tabs located at the top of the page to navigate between topology maps. 

7. Select the tab located at the top of the page for the stack topology you want to display. 

The stack device icon expands as a rectangle. From this rectangle you can view the internal 

topology of the stack device. A device marked with the icon  is an invalid stack member. 

8. To delete an invalid stack member, right-click the invalid stack member in the stack topology 
map and select Delete Stack Member from the shortcut menu. 

9. Click OK. 

Viewing traffic with traffic topology 

The traffic topology enables you to view the traffic conditions of links of the specified type in the 
custom topology. 

To view the traffic from the traffic topology: 

1. Click the Resource tab from the top tabular navigation system. 

2. Click View Management on the left navigation tree. 

3. Click Network Topology under View Management on the left navigation tree. 

4. Double-click any custom topology under Custom Topology. 

A new page for the Custom Topology opens on the main pane. Multiple pages in the main 
pane can be navigated using the tabs located at the top of the main pane. 

5. Click the  icon. 
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The Traffic Topology dialog box opens and displays the following information: 

 Traffic Topology Index—Allows you to decide which index denotes the traffic of the link on 
a topology map. Options are Interface Receiving and Transmitting Rate (bps), Interface 
Receiving Rate (bps), Interface Inbound Packet Loss Rate (%), Interface Transmitting 
Rate (bps), Interface Inbound Bandwidth Usage (%), Interface Outbound Packet Loss 
Rate (%), Interface Receiving Multicast Rate (packets/s), Interface Transmitting 
Multicast Rate (packets/s), Interface Outbound Bandwidth Usage (%), Interface 
Receiving Error Proportion (%), and Interface Sending Error Proportion (%). 

 Link Type of Traffic Topology—Allows you to decide which type of the link displays the 
traffic on a topology map. Options include All links, Core links, Links to servers, and Link 
to PCs. Core links are links connecting network devices. Links to servers are links 
connecting network devices to servers. Links to PCs are links connecting network devices 
to PCs. 

 Show—Identifies the link traffic load status by color. This option is available when No Index 
is not selected for Traffic Topology Index. The Show feature provides the Traffic Labels 
and Traffic load options.  

 Traffic labels—Displays the values of the indexes selected in Traffic Topology Index over 
links, and displays the values in different background colors according to the level-1 and 
level-2 thresholds set in the global indexes. If the traffic over a link is normal, the 
background color of the index values is the same as the background color of the traffic 
topology.  

 Traffic load—Displays links in different colors according to their traffic load conditions. The 
system has pre-defined traffic ranges for each index in the Traffic Topology Index. After 
you select an index in the Traffic Topology Index, the links are divided into three sections, 
and the middle part displays the status of links. The links in the left part and the links in the 
right part are displayed in different colors according to the ranges of traffic over the left 
interfaces and the right interfaces. 

6. Click OK. 

The topology page refreshes to load the latest traffic information. 

7. Customize the traffic range thresholds and their corresponding colors in the Traffic load 
parameters. 

a. Add a file userDefined.xml in directory \client\conf\perf\trafficTop in the IMC 
installation path. 

b. Configure the traffic range thresholds and their corresponding colors in the file 
userDefined.xml. 

For example, task id=1 corresponds to the index Interface Transmitting Rate. By setting 
the min and max parameters for the region parameter and setting rgb-r, rgb-g, and rgb-b 
values for the color_value parameter, you can set different colors for different threshold 
ranges. 

For more information, see the system-defined configuration file systemDefined.xml. IMC 
preferentially uses the configurations in the file userDefined.xml. At the same time, do not 
modify the configurations in the system-defined configuration file systemDefined.xml. 

The traffic topology feature applies only to the current topology. 

If you enable the traffic topology, the message box located at the bottom of the current topology 
prompts you to start to monitor traffic on topology links. 

Setting the refresh parameters of the traffic topology 

The traffic topology does not support manual refresh. It uses a special automatic refreshing 
mechanism that gradually increases the refresh interval to promptly show traffic changes with 
minimum impact to the network performance. The refresh parameters include a minimum value, an 
increment value, and a maximum value. When the traffic topology is enabled, it uses the minimum 
value for the first automatic refreshing. The next refresh interval increases by the increment value 
until the refresh interval reaches the maximum value. 
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To set the automatic refresh parameters: 

1. Open file systemDefine.xml in notepad at the \client\conf\perf\trafficTopo directory in the 
IMC installation path. 

2. Configure the minimum refresh interval in seconds, in the range of 5 to 300. The default is 30. 
<refreshInervalMin>30</refreshInervalMin> 

3. Configure the increment value in seconds, in the range of 0 to 60. The default is 30. 
<refreshInervalIncr>30</refreshInervalIncr> 

4. Configure the maximum refresh interval in seconds, in the range of 60 to 600. The default is 
300. 
<refreshInervalMax>300</refreshInervalMax> 

5. Save and close the file. 

6. Restart the Web browser. 

Managing the converged topology 

The converged topology enables you to converge topologies of multiple IMC modules and 
components into one topology, which helps you monitor and manage topologies of multiple services. 

To view the converged topology: 

1. Click the Resource tab from the top tabular navigation system. 

2. Click View Management on the left navigation tree. 

3. Click Network Topology under View Management on the left navigation tree. 

4. Double-click Converged Topology under Topology. 

A new page for the Converged Topology opens on the main pane. Multiple pages in the main 
pane can be navigated using the tabs located at the top of the main pane. 

Converged topology management through the right mouse click 

The right-click shortcut menu allows you to re-load converged views, add converged views, and set 
the default topology. The menu contains the following options: 

 Add View—Allows you to add a converged view.  

To add a converged view: 

a. Right-click a blank area in the Converged Topology, and select Add View from the 
shortcut menu.  

b. The Add View window opens.  

c. Enter the view name. 

d. Click OK. 

 Reload—Refreshes the current topology view. 

 Set Default Topology View—Enables you to define which topology view loads when an 
operator selects the Network Topology link located on the left navigation tree of IMC Web 
interface. By default, the Custom View is loaded. 

 Zoom—Enables you to zoom in or out of the topology view or to fit the contents of the topology 
map into the current window. 

 Add Note—Enables you to add a note for a topology view. 

Adding devices to a converged topology view 

1. Access a converged topology view. 

2. To add devices to the converged topology view, perform the following tasks: 

a. In the toolbar, click . 

The dialog box for selecting devices opens. 
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b. Add devices using either By View or Advanced query option. For more information, see 
"Adding devices by view" and "Adding devices by advanced query." 

c. Click OK. 

3. To add virtual devices to the converged topology view, perform the following tasks: 

a. In the toolbar, click . 

The Add Virtual Device To This View dialog box opens and displays all virtual devices in 
IMC in a list. 

b. Select one or more virtual devices. 

c. Click OK. 

4. To add wireless devices to the converged topology view, perform the following tasks: 

a. In the toolbar, click .  

The Add Wireless Device To This View dialog box opens and displays all wireless 
devices in IMC in a list. 

b. Select one or more wireless devices. 

c. Click OK. 

The color of the view icon is the same as that of the device with the worst status.  

Managing data center topology maps 

Data center topology maps enable you to create realistic maps of the data center down to the 
individual racks and racks and the devices that populate them. Upon installation, the Data Center 
Topology map is a blank page that allows you customize the options through the right-click shortcut 
menu. You can create nested maps up to four layers deep (data center, building room, and rack) 
displaying the physical layout of the data centers in the organization. For example, one or more 
buildings can be nested in the top level data center topology map, one or more rooms can be nested 
in a building, one or more racks or racks can be nested in a room, and one or more devices can be 
added to the racks and racks as they actually exist in the data center. You can locate a device in the 
room topology according to its asset number. You can manually configure data center topology maps 
or have them automatically built. 

Manually configuring data center topology maps 

IMC provides a high-level data center topology map, which is a blank page upon which you can 
create a visual representation of your data center. On the data center page, you can add clouds, 
buildings, or rooms. 

You cannot add racks or devices to the data center view. You must first create a building or room. You 
can only add racks to rooms and devices to racks. The following information describes the various 
data center map levels and their menu options. 

Data center topology maps 

There are many options for customizing the top-level map of the data center topology. You can 
create multi-level nested maps representing the physical layout of the data centers in your 
organization, add one or more clouds, or add one or more buildings to the data center map, Adding 
buildings to topology maps are optional. You can add one or more rooms to the data center map. 

To access the data center topology map: 

1. Click the Resource tab from the top tabular navigation system. 

2. Click View Management on the left navigation tree. 

3. Click Network Topology under View Management on the left navigation tree. 

A new browser instance opens and an icon labeled Custom Topology is displayed on the main 
pane of the page. A navigation system displays on the left. 

4. Double-click Data Center Topology under Topology. 

A new page for the Data Center Topology opens on the main pane. Multiple pages in the main 
pane can be navigated using the tabs located at the top of the main pane. 
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You can access data center topology configuration options through the right-click shortcut menu. 
Data center map menu options include: 

 Search—This feature enables you to locate a device in the rack topology.  

a. To locate the device, right-click the Data Center Topology map. 

b. Select Search from the shortcut menu.  

The Search window opens. 

c. Enter the partial or full asset number of the device you want to find. 

d. Click Search. 

The matched devices are displayed on the Search Result window.  

Click a device name to see the location of the device in the chassis topology. 

 Reload—This option refreshes the page after you have made changes to it. Once you have 
added a building or room to the data center map, click Reload to view and access the cloud, 
building, or room containers you have added. 

 Add data centers—This option enables you to add one or more data centers to the data center 
topology map. 

To add a Data Center: 

a. Right-click the data center topology map. 

b. Select Add Data Center from the shortcut menu. 

c. Enter a name for the data center. 

For easy management, configure different names for different data centers. 

d. Select the layer. 

e. Click OK. 

f. Select Reload from the right-click shortcut menu to refresh the data center map. 

 Add room—This option enables you to add one or more rooms to the data center topology 
map. 

To add a room: 

a. Right-click the data center topology map. 

b. Select Add Room from the shortcut menu. 

c. Enter a name for the room. 

For easy management, configure different names for different rooms. 

d. Click OK. 

e. Select Reload from the right-click shortcut menu to refresh the data center map. 

 Add cloud—This option enables you to add one or more clouds to connect to data centers. The 
clouds represent the external networks.  

To add a cloud: 

a. Right-click the data center topology map. 

b. Select Add Cloud from the shortcut menu. 

c. Enter a name for the cloud. 

d. Click OK. 

e. Select Reload from the right-click shortcut menu to refresh the data center map. 

 Set Default Topology View—Enables you to make this the view that is loaded when you click 
network topology view from Resource > View Management > Network Topology. 

 Hand Tool—Enables you to grab and move the topology view within the confines of the pane. 

To exit this mode, click the Hand Pointer Tool Switchover icon  in the toolbar. 
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 Zoom—Enables you to zoom in or out of the topology view or to fit the contents of the topology 
map into the current window. 

 Adjust Background—Enables you to adjust background of the topology. 

Accessing building topology maps 

You can add one or more rooms to a building topology map; you cannot add racks or devices to the 
building map. You must create buildings first, then rooms and add racks to rooms. While rooms are 
required to add racks, buildings are optional. You can add rooms directly to the data center topology 
map. 

To access a building map: 

1. Click the Resource tab from the top tabular navigation system. 

2. Click View Management on the left navigation tree. 

3. Click Network Topology under View Management on the left navigation tree. 

A new browser instance opens and an icon labeled Custom Topology is displayed on the main 
pane of the page. A navigation system displays on the left. 

4. Double-click Data Center Topology under Topology. 

A new page for the Data Center Topology opens on the main pane. Multiple pages in the main 
pane can be navigated using the tabs located at the top of the main pane. 

5. To access a data center, do one of the following: 

 Double-click the icon for the map you want to access. 

 Right-click the data center icon and select Enter Datacenter from the shortcut menu. 

A view of the data center expands in the existing page. Use the tabs at the top of the page to 
navigate between data center map options. 

The data center icon also has right-click shortcut menu for configuring the data center map. Menu 
options for the data center map are: 

 Enter Datacenter—Enables you to open the data center. 

 Modify Name—Enables you to rename the data center. 

 Delete—Enables you to delete the current data center from the data center map. After you 
select Delete, right-click Reload from the data center map to view the updated data center 
map. 

 Automatically Build—Enables you to add devices to the data center by importing a CSV file or 
selecting devices from IMC. 

Accessing room topology maps 

A room represents a small-scale data center. You can add one or more rooms to data centers or 
directly to data center topology maps. Room topology maps serve as containers for the racks that 
house managed devices. You can add one or more racks or racks to room topology maps. 

To access a room topology map: 

1. Click the Resource tab from the top tabular navigation system. 

2. Click View Management on the left navigation tree. 

3. Click Network Topology under View Management on the left navigation tree. 

A new browser instance opens and an icon labeled Custom Topology is displayed on the main 
pane of the page. A navigation system displays on the left. 

4. Double-click Data Center Topology under Topology. 

A new page for the Data Center Topology opens on the main pane. Multiple pages in the main 
pane can be navigated using the tabs located at the top of the main pane. 

To access a room, do one of the following: 

 Double-click the room icon for the map you want to access. 

 Right-click the room icon and select Edit from the shortcut menu. 
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 After accessing a data center, double-click a room icon on the data center map, or right-click 
a room icon and select Edit from the shortcut menu. 

A new window for the room opens. The left area of the page displays the room components and 
the right area displays the configuration area and the preview area of the room.  

You can add objects, such as walls, windows, racks, and devices, to the room in the 
configuration area. For more information, see "Using the 3D room management tool." 

The room topology icon also has right-click shortcut menu for configuring the room map. Menu 
options for the room map are: 

 Edit—Enables you to open the room in edit mode. The edit mode provides more functions than 
the view mode. For more information about editing a room, see "Editing the 3D room." 

 View—Enables you to open the room in view mode. 

 Open Capacity View—Enables you to open the room and view the space usage of the room. 
For more information about viewing the space usage of a room, see "Managing the 3D room 
and network devices." 

 Link View—Enables you to open the room and view the link states of devices in the room. 

 Modify Name—Enables you to rename the room. 

 Delete—Enables you to delete the current room from the data center map. After you select 
Delete, right-click Reload on the data center map to view the updated data center map. 

 Automatically Build—Enables you to add devices to the room by importing CSV file or 
selecting devices from IMC. For more information, see "Managing the 3D room and network 
devices." 

Accessing a rack topology map 

Rack topology maps contain graphical representations of the managed network devices. In rack 
topology maps you can add one or more devices, rack supports, and objects to the selected rack.  

To access a rack map: 

1. Click the Resource tab from the top tabular navigation system. 

2. Click View Management on the left navigation tree. 

3. Click Network Topology under View Management on the left navigation tree. 

A new browser instance opens and an icon labeled Custom Topology is displayed on the main 
pane of the page. A navigation system displays on the left. 

4. Double-click Data Center Topology under Topology. 

A new page for the Data Center Topology opens in the main pane. Multiple pages in the main 
pane can be navigated using the tabs located at the top of the main pane. 

5. Double-click the room icon that contains the rack icon you want to access, or right-click the 
room icon and select Edit from the shortcut menu. 

A new page for the room map opens in the main pane. 

If the room that contains the rack is located in a data center, first access the data center by 
performing one of the following tasks: 

 Double-click the data center icon. 

 Right-click the data center icon and select Enter Datacenter from the shortcut menu. 

6. Click a rack and right-click to select Open Rack Topo from the shortcut menu. 

A new page for the rack map opens in the main pane. 

The rack topology map also has right-click shortcut menu for configuring the map. Menu options for 
the map are: 

 Reload—Refreshes the page after you have made changes to it. Once you have added a 
device to the wiring topology map, click Reload to view your changes. 
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 Add Device to Cabinet—Add a new device to the rack. You can add devices using either the 
By View or the Advanced query method. See "Adding devices by view" and "Adding devices 
by advanced query." 

a. Click OK.  

b. Right-click the rack and select Reload from the shortcut menu to update the map. The 
newly added device is displayed in the rack. 

 Add Supports—Add a new supports to the rack. 

 Add Object—Adds a new object to the rack. 

a. From the Add Object dialog box, enter the dimensions of the object. 

b. Click OK.  

c. Select Reload from the right-click shortcut menu to update the map. 

 Rename—Enables you to rename the rack. 

 Zoom—Enables you to zoom in or out of the topology view or to fit the contents of the topology 
map into the current window. 

Managing devices from the data center topology maps 

The network topology maps also enable you to manage devices directly from the topology view. 
From the topology devices, you can view and perform management functions including viewing 
device information and performing actions such as ping, trace route and initiating Telnet or SSH 
sessions to the selected devices.  

To manage devices from the Data Center Topology map: 

1. Click the Resource tab from the top tabular navigation system. 

2. Click View Management on the left navigation tree. 

3. Click Network Topology under View Management on the left navigation tree. 

4. Double-click Data Center Topology under Topology. 

A new page for the Data Center Topology opens in the main pane. Multiple pages in the main 
pane can be navigated using the tabs located at the top of the main pane. 

5. Access the room that contains the rack you want to access by performing one of the following 
tasks:  

 Double-click the room icon that contains the rack icon you want to access. 

 Right-click the room icon and select Edit from the shortcut menu.  

 After accessing the data center that contains the room you want to access, double-click the 
room icon or right-click the room icon and select Edit from the shortcut menu. 

A new page for the room map opens in the main pane.  

6. Right-click a rack and select Open Rack Topo from the shortcut menu. 

A new page for the rack map opens on the main pane. 

7. Select the device that you want to manage by clicking it. 

8. Right-click the device you have selected. 

The management menu appears. Menu options are: 

 Configuration—Enables you to configure the device specifications for the rack topology 
map. Enter the device dimensions in the Configuration dialog box. You can also select an 
icon in which the device is to be displayed on the rack. IMC defines the default icons of 
devices. You can modify the default icon of a device by modifying the configuration file or 
configuring the default icon for a third-party device. 

The icon configuration file and icons are all saved in <IMC installation 
path>/client/web/apps/imc/topo/racktopo. The name of the configuration file is 
rackPicDef.xml. Do not modify the configuration in the file. 

a. Copy the default icon (for example 2510-24.gif) to be configured to <IMC installation 
path>/client/web/apps/imc/topo/racktopo. 
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b. Change the name of the custRackDefExample.xml file to custRackDef.xml. 

c. Configure the default icon of the device in the custRackDef.xml file by referring to the 
rackPicDef.xml file. The following is the configuration segment for the default icon of each 
device. 
<imageElement> 

  <path>2510-24.gif</path>  

  <oid>1.3.6.1.4.1.11.2.3.7.11.61</oid>  

  <height>1</height>  

  <width>1</width>  

  <includeBolt>1</includeBolt>  

  </imageElement> 

2510-24.gif is the icon name, and 1.3.6.1.4.1.11.2.3.7.11.61 is the OID of the device. You can 
obtain the OID information of the device from the device details page (see "Accessing the 
device details page"). Height and width represent the size of the icon in the rack, and 
includeBolt represents the number of slots to be used. Each of these fields defaults to 1. 

d. Save the modification and exit the file. 

e. Add the device to the rack. If the default icon of the device has been modified, the new 
default icon is displayed. 

IMC loads the rackPicDef.xml file first and then the custRackDef.xml file. If you use the 
two files to configure different icons for the same device, the icon configured by using the 
custRackDef.xml file overwrites that configured by using the rackPicDef.xml file. 

 Delete—Enables you to delete the selected device from the rack. 

 Open Web-Based NMS—Allows you to launch the Web Manager interface for the selected 
device directly from the topology map. Selecting this option opens the Web Manager in a 
new browser instance that can be accessed through the tabs located at the top of the main 
pane. From this window, you can manage more fully the selected device. For more 
information about the Web Manager, see "Open Web manager." 

 Open Device Panel—Allows you to launch the Device Panel interface for the selected 
device directly from the topology map. Selecting this option opens the Device Panel in a 
new pane in the topology window that can be accessed through the tabs located at the top 
of the main pane, allowing you to more fully manage the selected device. For more 
information about the Device Panel, see "Open device panel." 

 Device Information—Opens the Device Details page for the selected device. The Device 
Details page loads in the browser instance that originally launched the topology maps, not 
in the browser instance that has the topology maps loaded. For more information about the 
Device Details page, see "Managing one device through device details." 

 Tools-Ping—Enables you to launch a ping request from the IMC server to the selected 
device from the topology map. IMC opens a new browser instance that can be accessed 
through the tabs located at the top of the main pane. 

 Tools-Telnet—Enables you to launch a telnet session for the selected device directly from 
the topology map. You are prompted for the application on the local computer that supports 
telnet. 

 Tools-Traceroute—Enables you to launch a traceroute request from the IMC server to the 
selected device from the topology map. IMC opens a new browser instance that can be 
accessed through the tabs located at the top of the main pane. 

 Tools-SSH—Enables you to launch an SSH session for the selected device directly from 
the topology map. You are prompted for the application on the local computer that supports 
SSH. 

Viewing the virtual network with VRM topology maps 

You can view the virtual network with VRM topology maps. Options for VRM topology maps include 
displaying or hiding the storage devices, and viewing the physical servers managed by a specific 
vManager. 
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To display/hide the storage devices: 

1. Click the Resource tab from the top tabular navigation system. 

2. Click View Management on the left navigation tree. 

3. Click Network Topology under View Management on the left navigation tree. 

4. Double-click VRM Topology under Topology. 

A new page for the VRM Topology opens on the main pane. Multiple pages in the main pane 
can be navigated using the tabs located at the top of the main pane. 

5. Right-click with nothing selected on the VRM topology to display a menu containing the 
Display/Hide Storage Devices option.  

6. Select this option, to display or hide the storage devices. 

Viewing the physical servers managed by a specific vManager 

You can select a vManager and view the physical servers it manages. When you use this feature, the 
physical servers managed by the vManager you select are highlighted, whereas all physical servers 
managed by other vManager are grayed out. 

To view the physical servers managed by a specific vManager: 

1. Click the Resource tab from the top tabular navigation system. 

2. Click View Management on the left navigation tree. 

3. Click Network Topology under View Management on the left navigation tree. 

4. Double-click VRM Topology under Topology. 

A new page for the VRM Topology opens on the main pane. Multiple pages in the main pane 
can be navigated using the tabs located at the top of the main pane. 

5. Click the vManager Topology icon  and select the vManager you want to view in the popup 
menu.  

The vManagers are sorted by IP address and device label. 

6. Click the vManager Topology icon  and select the Exit option in the popup menu to cancel 
viewing the physical servers. 

Using the 3D room management tool 
The 3D room management tool is provided for visualization of equipment rooms. Use the tool to 
simulate the room environments, manage devices, and inspect the room in the first-person 
perspective. The tool can cooperate with a third-party monitoring system to display the environment 
monitoring parameters, such as temperature, humidity, and UPS power supplies. 

Editing the 3D room 

3D room edit can be 2D view edit or 3D view edit. 

To edit a 3D room: 

1. Add a 3D room and enter 3D room edit view. 

For more information, see "Accessing room topology maps" and "Managing data center 
topology maps." 

The system displays a predefined room plan in 2D view for the first edit of the room. 

2. Draw the room in 2D view. 

3. Add facilities to the room and decorate the room in 3D view. 

Drawing the 3D room 

Drawing the 3D room in 2D view. To open the page for drawing the 3D room, click the Draw tab. For 
the supported operations on the page, see Table 18. 
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Figure 120 Page for drawing a 3D room 

 
 

Table 18 Supported operations on the page for drawing a 3D room 

Area Supported operations 

1 Click the cube icon  to expand or hide area 2 and area 3. 

2 

 Tabs: 
 Click the Draw tab to draw a 3D room in 2D view. 
 Click the Furnish tab to add facilities to the room in 3D view. 
 Click the Decorate tab to decorate the room in 3D view. 

 Toolbar: 

 Click the Save icon  to save changes to the room. 

 Click the Upload icon  to import a template for the 3D room duplication. The 
uploaded template overwrites the current 3D room data. 

 Click the Download icon  to export the current room data to a .json file as a 
template. The file does not include data of network devices added to the racks. 

 Click the Options icon  to set the 3D view performance. 

 Click the Undo icon  to return to the previous step. 

 Click the Redo icon  to restore the step you have canceled. 

 Click the Print icon  to set the print parameters of the 3D room. 

 Click the Capture icon  to locally save the current 3D room as an image. 

 Click the Full icon  or press F11 to display the current page in full screen. 

 Click the Refresh icon  or press F5 to refresh the current page. 

3 Select elements for drawing the 3D room. 

4 

Adjust the location and the display scale of the 3D room plan. 
 To move the room plan, use direction keys or drag the mouse. 
 To zoom in or zoom out the room plan with the fixed center position of the room, use the 

sliding bar. 
 To zoom in or zoom out the room plan with the pointer as the center, roll the mouse wheel. 
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Area Supported operations 

5 View the display scale. 

6 

 Click the tab of a floor to view its plan. All floor tabs are displayed in this area. The tab of the 
current floor is highlighted. 

 Point to a floor tab, and click the Change settings icon  to modify the floor name and 
height. 

 Point to a floor tab, and click the Remove this floor icon  to delete the floor. 
 Click Add to select elements to be copied, and then click Create to create a new floor. 

 

Adding rooms and walls 

The following types of walls are available for the room: walls, bulkheads, and room separators. Walls 
are thicker than bulkheads by default. Use the room separators to separate the room. Room 
separators are visible only in 2D view. 

The system provides several room models in RoomModels. You can draw a wall based on a room 
model.  

To draw a wall: 

1. Click the Draw tab. 

2. Select Rooms & Walls from the menu to expand the wall list. 

3. Select a type of wall, and then point to the room. 

Green lines are displayed and indicate that the pointer is aligned with an element in the room. 

4. Click a place to start drawing the wall. 

A cross icon  is displayed at the start point. To cancel the drawing, click this icon. 

5. Point to the end point and click again to finish drawing the wall. 

The tick icons  and  are displayed when you point to the end point of the wall. To continue 
to draw another wall, drag the mouse. To finish drawing all walls, double-click the end point. 

The following operations are supported on a wall, as shown in Figure 121: 

 To change the location of the wall, point to the wall, and then drag the green line that appears, 
as shown in area 1. 

 To change the angle between two walls, point to their joint point, and then drag the green circle 
that appears, as shown in area 2. 

 To divide the wall into two walls, double-click the wall. The position you click becomes the joint 
point of the two walls. To change the angle between them, drag the joint point. 

 To set parameters for the wall, click the wall, and then set the wall parameters (such as 
thickness and height) in the dialog box that opens, as shown in area 3. 

 To display the measurement of the wall, turn on the Display measures switch in the dialog 
box. This example displays a measurement of 10m in area 4. 

 To adjust the distance between the measurement and the wall, enter a value in the Measure 
distance field or adjust the sliding bar of this parameter. The distance is represented by the 
green line in area 4. 

 To delete the wall, click the wall, and then click Remove in the dialog box that opens, as shown 
in area 3. 

 When multiple walls form an enclosed area, a room label appears in the center of the area, as 
shown in area 5. The room label includes the room name (Room by default) and the available 
space in square meters. To modify the room name and room settings, click the room label. 
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Figure 121 Drawing a wall 

 
 

Adding a door 

The following types of doors are available for the room: openings, single doors, bifold doors, sliding 
doors, and garage doors. 

To add a door: 

1. Click the Draw tab. 

2. Select Doors from the menu to expand the door list. 

3. Select a type of door from the list, and then point to the wall where you want to add the door. 

The door preview is displayed on the wall. 

4. Click the position where you want to add the door. 

The following operations are supported on a door, as shown in Figure 122: 

 To change the location of the door, point to the door, and then drag the green line that appears, 
as shown in area 1 

The system displays the measurement of the door and the wall when you drag the green line. 

 To change the door width, point to the door, and then drag one end of the green line that 
appears. 

 To copy the door, double-click the door, and then click a wall to paste the door. 

 To set parameters for the door, click the door, and then set the door parameters in the dialog 
box that opens, as shown in area 2. 
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 To delete the door, click the door, and then click Remove in the dialog box that opens, as shown 
in area 2. 

Figure 122 Drawing a door 

 
 

Adding a window 

The following types of windows are available for the room: 

 Common windows—Includes openings, fixed windows, single-casement windows, 
double-casement windows, and sliding windows.  

 Bay windows—Includes fixed bay windows, single-casement bay windows, double-casement 
bay windows, and sliding bay windows. The system-defined elevation for bay windows is 0 
centimeters. 

To add a window: 

1. Click the Draw tab. 

2. Select Windows or Bay Windows from the menu to expand the window list.  

3. Select a type of window, and then point to the wall where you want to add the window. 

The window preview is displayed on the wall. 

4. Click the position where you want to add the window. 

The following operations are supported on a window, as shown in Figure 123: 

 To change the location of the window, point to the window, and then drag the green line that 
appears, as shown in area 1. 
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The system displays the measurement of the window and the wall when you drag the green 
line. 

 To change the window width, point to the window, and then drag one end of the green line that 
appears. 

 To copy the window, double-click the window, and then click a wall to paste the window. 

 To set parameters for the window, click the window, and then set the window parameters in the 
dialog box that opens, as shown in area 2. 

 To delete the window, click the window, and then click Remove in the dialog box that opens, as 
shown in area 2. 

Figure 123 Drawing a window 

 
 

Adding stairs 

The following types of stairs are available for rooms: winder stairs, landing stairs, hanging stairs, and 
spiral stairs. By default, the platform winder is disabled for winder stairs and enabled for landing 
stairs. For hanging stairs, risers and guardrails are disabled by default, and the default bottom rail 
height is 0 centimeters. 

To draw a flight of winding stairs, landing stairs, or hanging stairs: 

1. Click the Draw tab. 

2. Select Stairway from the menu to expand the stairs list. 

3. Select a type of stairs from the list. 

4. Click a place to start drawing the stairs. 

The direction of the arrow indicates the direction of the stairs. 
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5. Point to the end point and click again to finish drawing the stairs. 

The tick icons  and  are displayed when you point to the end point of the stairs. To 
continue to draw another flight of the stairs, drag the mouse. To finish drawing all stairs, 
double-click the end point. 

When you draw a flight of stairs, the system displays the total run for the stairs. 

The following operations are supported on the winding stairs, landing stairs, or hanging stairs, as 
shown in Figure 124: 

 To change the location of a flight of stairs, point to the stairs, and then drag the green line that 
appears, as shown in area 1. 

 To change the end point of a flight of stairs, point to the end point, and then drag the green circle 
that appears, as shown in area 2. Move the joint point of multiple flights of stairs in the same 
way the end point of one flight of stairs is moved. 

 To delete stairs, click the stairs, and then click Remove in the dialog box that opens. 

 To set parameters for stairs, click the stairs, and then set parameters in the dialog box that 
opens, as shown in area 4. For components and terminology in stairs, see Table 19. 

Table 19 Components and terminology in stairs 

Components and terminology Description 

Height Total rise of the stairs. 

Tread See the stairs in area 5 and area 6 in Figure 124. 

Stair offset 
Stair nosing. 

See the length marked in area a in Figure 124. 

Riser See area 7 in Figure 124. 

Guardrail 
See area 8 in Figure 124. The bottom rail height is a negative 
number if the guardrail is under the tread, and is a positive 
number if the guardrail is above the tread. 
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Figure 124 Drawing stairs 

 
 

To draw a flight of spiral stairs: 

1. Click the Draw tab. 

2. Select Stairway from the menu to expand the stairs list. 

3. Select Spiral from the list, and then point to the room. 

The preview of the stairs is displayed in the room. 

4. Click the position where you want to add the stairs. 

By default, the vertical semidiameter and horizontal semidiameter represent the start point and 
the end point of the stairs, respectively. 

The following operations are supported on spiral stairs, as shown in Figure 125: 

 To move the spiral stairs, point to the stairs, and then drag the stairs, as shown in area 1.  

 To change the end point of the stairs, point to the end point of the stairs, and then drag the green 
circle than appears. Change the start point of the stairs in the same way the end point is 
changed. 

 To set parameters for the stairs, click the stairs, and then set parameters in the dialog box that 
opens, as shown in area 2.  

 To delete the stairs, click the stairs, and then click Remove in the dialog box, as shown in area 
2. 
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Figure 125 Drawing stairs 

 
 

Adding a hopper 

To add a hopper: 

1. Click the Draw tab. 

2. Select Hoppers from the menu, and then point to the position where you want to add a hopper. 

The hopper preview is displayed in the room. 

3. Click again to finish drawing the hopper. 

The following operations are supported on a hopper, as shown in Figure 126: 

 To change the location of the hopper, point to the hopper, and then drag the hopper when the 
hopper color turns green, as shown in area 2. 

 To move a boundary line of the hopper, point to the boundary line, and then drag the green line 
that appears, as shown in area 3. 

 To move the vertex of the hopper, point to the vertex, and then drag the green circle that 
appears, as shown in area 4. 

 To divide a boundary line into two lines, you must first add a separator point on the boundary 
line by double-clicking the line. Then, point to the separator point and drag the green circle that 
appears. 

 To add handrails to the hopper, click the hopper, and then enable the handrail use in the dialog 
box that opens, as shown in area 5. 

 To delete the hopper, click the hopper, and then click Remove in the dialog box, as shown in 
area 5. 
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Figure 126 Drawing a hopper 

 
 

Adding facilities 

Add facilities to the equipment room in 3D view. To open the page for adding facilities, click the 
Furnish tab. For the supported operations on the page, see Table 20. 

Figure 127 Page for adding facilities 
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Table 20 Supported operations on the page for adding facilities 

Area Supported operations 

1 Click the cube icon  to expand or hide area 2 and area 3. 

2 

 Tabs: 
 Click the Draw tab to draw a 3D room in 2D view. 
 Click the Furnish tab to add facilities to the room in 3D view. 
 Click the Decorate tab to decorate the room in 3D view. 

 Toolbar: 

 Click the Save icon  to save changes to the room. 

 Click the Upload icon  to import a template for the 3D room duplication. The 
uploaded template overwrites the current 3D room data. 

 Click the Download icon  to export the current room data to a .json file as a template. 
The file does not include data of network devices added to the racks. 

 Click the Options icon  to set the 3D view performance. 

 Click the Undo icon  to return to the previous step. Operations of adding and deleting 
elements cannot be restored. 

 Click the Redo icon  to restore the step you have canceled. Operations of adding 
and deleting elements cannot be restored. 

 Click the Transparency icon  or Opacity icon  to set the transparency of the 
walls in the 3D room. 

 Click the Print icon  to set the print parameters of the 3D room. 

 Click the Lock icon  to unlock an element. 

 Click the Unlock icon  to lock an element. Locked elements cannot be moved. 

 Click the Alarm icon  to view real-time alarm information for all devices in the 3D 
room. 

 Click the Capture icon  to locally save the current 3D room as an image. 

 Click the Full icon  or press F11 to display the current page in full screen. 

 Click the Query icon  to query devices in the 3D room. 

 Click the Refresh icon or press F5  to refresh the current page. 

3 
Select elements to add to the 3D room. 

For more information about the elements, see "Managing elements in 3D view." 

4 

Adjust the perspective and position to view the 3D room. The following modes for viewing the 
room are available: 
 Third-person perspective mode—View the room from the third-person perspective with a 

fixed center position. This mode is available when a person icon  is displayed in the 
center of the direction keys. To move around the fixed position, use the direction keys or 
drag the mouse. To adjust the display scale, use the sliding bar or roll the mouse wheel. 

 First-person perspective mode—View the room from the first-person perspective. This 

mode is available when a camera icon  is displayed in the center of the direction keys. To 
move around, use the direction keys. To adjust the angle of view, use the sliding bar or roll 
the mouse wheel. In this mode, the center position changes accordingly as you move 
around the room. 

To switch between the two modes, click the person icon  or the camera  icon. 
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Area Supported operations 

5 Click the Filter icon  to select elements you want to view. To close the filter dialog box, click 
the icon again. 

6 

 Click the tab of a floor to view its room settings. All floor tabs are displayed in this area. The 
tab of the current floor is highlighted. 

 Point to a floor tab, and click the Change settings icon  to modify the floor name and 
height. 

 Point to a floor tab, and click the Remove this floor icon  to delete the floor. 
 Click Add to select elements and then click Create to create a new floor. 

 

The page also supports the following operations: 

 Switch Center Person—Shows or hides the person in the center position. 

 Switch Smoke Detector—Shows or hides smoke detectors. 

 Switch Temperature & Humidity Sensors—Shows or hides temperature and humidity 
sensors. 

 Inspect—Inspects the 3D room and saves the inspection process as a video. 

To perform one of these operations, right-click a blank area on the page and then select an operation 
from the list that is displayed. 

Managing elements in 3D view 

You can add the following categories of elements to a 3D room, and then set their dimensions and 
locations: 

 Racks. 

 Environment and power facilities. 

 Safety protection facilities. 

 Living facilities. 

 Others (objects and areas). 

To add an element to the room: 

1. Click the Furnish tab. 

2. Click the category to which the element belongs from the left menu. 

3. Point to the picture of the element, and click the picture to add the element. 

The element is displayed in the center of the room. 

To add more copies of the element, click the picture of the element multiple times. 

To avoid ambiguity, assign unique names to different element copies. If you do not rename them, 
different copies will use the same name as the copied element. 

To modify the name of an element: 

1. Right-click the element, and then select Modify Name from the shortcut menu. 

2. Enter a new name in the dialog box that opens. 

3. Click OK. 

To modify the height (in RUs) of a rack element: 

1. Right-click the element, and then select Modify Rack U Num from the shortcut menu. 

2. Enter a new value in the dialog box that opens. 

3. Click OK. 

To delete an element, right-click the element, and then select Delete from the shortcut menu. 
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Adjust the dimensions and locations of elements in the 3D room to match the facilities in the 
equipment room. To adjust an element, select the element and perform the following operations: 

 To rotate the element horizontally, drag the double arrow icon  at the bottom of the 
element. 

 To adjust the elevation, slide the bar on the sliding icon . 

 For some elements, the direction icons , , and  are displayed when you select the 
element.  

 To adjust the height of the element, drag the direction icon . 

 To adjust the side-to-side width of the element, drag the direction icons  and . 

 To adjust the front-to-back width of the element, rotate the element first, and then drag the 

direction icons  and  in front of and behind the element, respectively. 

 To adjust the element accurately, use the product information dialog box. To open the dialog 

box, select the element, and click the information icon  above the element. 

The product information dialog box has the Dimensions tab and the Position & Rotation tab. 
Parameters on the Dimensions tab vary by element. 

 To modify dimensions of the element, enter values in the width, height, and depth fields on 
the Dimensions tab, and then click a blank area to save the values. 

 To modify the advanced parameters for a Living Facilities element, click the show 
advanced params link on the Dimensions tab, enter parameter values, and then click a 
blank area to save the values. 

Different Living Facilities elements have different advanced parameters.  

 To copy the element, set the location of the new element relative to the copied element, and 
then click Duplicate on the Dimensions tab. To add more copies, click Duplicate multiple 
times. 

By default, new elements are added one by one to the left of the copied element with a step 
distance of 30 centimeters. To add elements to the right, turn off the Left switch. To change 
the step distance, turn on the Set interval switch and enter a value in the Distance field. If 
you turn off the Set interval switch, new elements are adjacent to each other without gaps. 

 To rotate the element, use the sliding bars for X-axis, Y-axis, and Z-axis in the rotation area 
on the Position & Rotation tab. To identify the X-axis, Y-axis, and Z-axis for an element, 
see the example shown in Figure 128.  

 To view the location of the element, click the Position & Rotation tab and view values of 
the X-axis, Y-axis, and Z-axis in the positioning area. To change the location of the 
element, enter values for X-axis, Y-axis, and Z-axis in the positioning area, and then click a 
blank area to save the values. 

 To delete the element, click Remove on the product information dialog box. 
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Figure 128 Element in selected state 

 
 

To manage the 3D room efficiently, group multiple elements together. When you change the location 
of a member element, other elements in the group are also moved the same distance as the element 
moves. 

When you modify a member element on the product information dialog box, the group is canceled. 
When an element is assigned to another group, the original group of the element is canceled. 

To assign elements to a group: 

1. Press Ctrl and select elements.  

2. Click the group information icon . 

3. On the group information dialog box that opens, turn on the Group switch. 

To align the grouped elements, use the Horizontal switch and enter a value in the Distance field. 

To select a group, click any member element in the group. To select an element in the group, you 
must double-click the element. 

Configuring the data source for environment and power facilities 

Configure data sources for environment and power facilities so IMC can get the monitoring data and 
display them in the 3D room. 

To configure the data source for an environment or power facility: 

1. Right-click the facility in 3D view, and then select Configure Data from the shortcut menu. 

2. On the Configure Data dialog box, configure the following parameters: 

 Protocol—Select a protocol that IMC uses for communication. Options are http and https. 

 Host—Enter the host name or the IP address of the host that provides the data. 

 Port—Enter the port number for communication. The default port number is 80 for HTTP 
and 443 for HTTPS. 

 HTTP Method—Select an HTTP or HTTPS access method. Options are GET and PUT. 

 User Name—Enter the user name to log in to the host. 
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 Password—Enter the password to log in to the host. 

 URI—Enter the interface URI or use the URI that is automatically filled by the system based 
on the template to be selected. 

 Vendor—Select a vendor that provides the data. 

 Template—Select a template or use the template that the system automatically selects for 
the element. 

 Request Header—Enter the header of the request message. The default message format 
is .json. 

3. Click OK. 

Decorating the 3D room 

Decorate the 3D room in 3D view. To open the page for decorating the 3D room, click the Decorate 
tab. 

The supported operations on the Decorate tab are the same as the Furnish tab except that: 

 Area 3 on the Decorate tab provides colors and materials to decorate the 3D room. 

 Area 3 on the Furnish tab provides elements that can be added to the 3D room. 

For more information about other areas, see Table 20. 

Figure 129 Decoration colors and materials 

 
 

Area 3 has the following menus: 

 Outside—Provides colors for the sky and the ground outside the room. 

 Latest Colors—Displays the most recently used colors and materials. 

 Customer Material—Provides pictures that are uploaded by the user for the room decoration.  

To upload a picture, click the add icon  from this menu, upload the picture, and then refresh 
the page. 

 Other colors and materials—Includes lists of system-defined colors and materials for 
decorating facilities inside the room. 

The following facilities cannot be decorated: 

 Racks. 

 Environment and power facilities, such as power distribution cabinets, and air conditioners. 
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 Safety protection facilities. 

To change the color of the ground outside the room, click Outside from the left menu, and then select 
a color from the Ground list. Change the sky color in the same way the ground color is changed. 

To select a material to decorate an element: 

1. On the left menu, click the category to which the material belongs, and then select the material 
from the list. 

2. Point to the 3D room. 

The pointer turns into a pen icon . 

3. Click the element. 

Use a color or a user-defined picture to decorate an element in the same way the material is used for 
decoration. 

Managing the 3D room and network devices 

To manage network devices in the 3D room, add them to IMC and then to the 3D room. 

Adding network devices to the 3D room 

Use one of the following methods to add network devices to the 3D room: 

 Method 1: 

a. On the data center topology, right-click an equipment room or data center node, and then 
select Automatically Build from the shortcut menu. 

The Automatically Build a Data Center Topology page opens. The device list on the 
page is empty. 

b. Use one of the following methods to add devices to the list: 

 Click Choose, select a .csv file, and then click Import. 

Each line of the .csv file contains information about a device to be added to the device 
list. For successful file export, make sure the devices in the file have been added to IMC 
and are not added to other racks. 

 Click Select Devices, select devices to be added in the dialog box that opens, and then 
click OK. 

The devices that have been added to the 3D room are not displayed in the dialog box. 

The added devices are displayed in the list. 

c. Specify the location for the device by using one of the following methods: 

 Select the device location from the Data Center, Layer, Room, Rack, and Start(U) 
lists. 

Racks that use default names are not displayed in the Rack list. 

 Select the device, click the Modify link below the device list, and then enter the device 
location in the dialog box that opens. 

You must specify the room and the rack for a device. 

Skip this step if you have exported devices from a .csv file and the locations of the imported 
devices do not need to be changed. 

To delete a selected device, select the device, and then click Delete. 

d. Click OK. 

 Method 2: 

a. On the data center topology, right-click an equipment room or data center node, and then 
select Edit from the shortcut menu. 

b. Click the Furnish tab or the Decorate tab. 

c. Right-click a rack, and then select Open Rack Topology from the shortcut menu. 

d. Right-click the rack topology that is displayed.  
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The following operations are available: 

 Reload—Reload the rack topology. 

 Add Device To Cabinet—Add devices in IMC to the rack. 

 Add Supports—Add trays to the rack. 

 Add Objects—Add devices that are not added to IMC to the rack. 

 Rename—Rename the rack. 

 Zoom—Zoom in or zoom out the rack topology. 

e. Select Add Device To Cabinet, select devices in the dialog box that opens, and then click 
OK. 

The selected devices are displayed on the rack. 

f. Drag the device panel to adjust the device location. 

g. Click the Save icon  above the rack topology. 

After adding network devices to the rack, double-click the rack in the 3D room, and the newly added 
devices are displayed on the rack. 

To view the device details, click the device panel. The device panel provides operations to manage 
the device, such as configuring the device specifications, opening Web-based NMS, and viewing 
device details. For more information, see "Managing devices from the data center topology maps." 

The color of the device panel changes according to the device status. If devices in a rack do not 
operate correctly, a warning mark is displayed above the rack with the same color as the device that 
has the highest severity level. 

Displaying the 3D room capacity view 

The 3D room capacity view supports space query and displays the capacity topology and statistics. 
To enter the capacity view, right-click the 3D room, and then select Open Capacity View from the 
shortcut menu. 

Figure 130 Capacity view 

 
 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 8708



307 

Table 21 Supported operations on the capacity view page 

Area Supported operations 

1 

 To hide the space search area, click the arrow icon . To display the area, click the icon 
again. 

 To select a rack in the 3D room, click the rack node or a subnode of the rack in the tree 
structure at the bottom of the area. 
When you select a rack in the 3D room, the rack node in the tree is also selected. The tree 
structure displays the available space of all racks in the room in the following hierarchies: 
floor, rack, and available space. 

 To query free space with a specific height, enter the height in the Available (U) field, select a 
floor from the Position list, and then click OK. 
Space information that meets the query criteria is displayed on the capacity topology and 
locations are displayed in the tree structure. By default, all free space information in the first 
floor is displayed. 

2 

 Click the Transparency icon  or Opacity icon  to set the transparency of the walls in 
the 3D room. 

 Click the Print icon  to set the print parameters of the 3D room. 

 Click the Capture icon  to locally save the current 3D room as an image. 

 Click the Full icon  or press F11 to display the current page in full screen. 

 Click the Refresh icon or press F5  to refresh the current page. 

3 

View the space statistics of the current floor by moving the pointer on the toolbar. 

The space statistics tab divides the rack space on the floor into 100 blocks. Black blocks represent 
used space, and green blocks represent free space. The tab also displays the total space, used 
space, free space, and the utilization rate of the 3D room. 

The Legend area of the tab displays the colors to represent different value ranges of the utilization 
rate. For example, the green color indicates that the utilization rate is less than 25%. In the 
capacity topology, green cuboids are used to represent racks that have a utilization rate lower than 
25%. 

4 

Adjust the perspective and position to view the 3D room. 

The following modes for viewing the room are available: 
 Third-person perspective mode—View the room from the third-person perspective with a 

fixed center position. This mode is available when a person icon  is displayed in the center 
of the direction keys. To move around the fixed position, use the direction keys or drag the 
mouse. To adjust the display scale, use the sliding bar or roll the mouse wheel. 

 First-person perspective mode—View the room from the first-person perspective. This 

mode is available when a camera icon  is displayed in the center of the direction keys. To 
move around, use the direction keys. To adjust the angle of view, use the sliding bar or roll the 
mouse wheel. In this mode, the center position changes accordingly as you move around the 
room. 

To switch between the two modes, click the person icon  or the camera  icon. 

5 Click the tab of a floor to view its capacity view. All floor tabs are displayed in this area. The tab of 
the current floor is highlighted. 

 

Viewing devices with custom views 
Custom views offer you the ability to create their own views based on groups of devices they define. 
Like all IMC views, custom views offer you a real time snapshot of the status of devices in the 
network infrastructure through color-coded icons that match the highest severity or alarm level for 
devices in the view.  
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Like device view and IP view, custom views enable you to grant and revoke management rights for 
devices in custom views. First, you create custom views and add devices to them. Then, you grant 
access to the custom groups in the individual operator accounts.  

When considering how to organize devices into custom groups and subviews, consider first the 
rights and privileges you want to grant or restrict. Also, consider how the logical grouping of devices 
can support an effective rights management policy. For more information about the relationship of 
custom views and operator rights, see "Operator management: managing secure access to IMC." 

You can organize one or more views according to the IMC security needs and viewing requirements 
of your organization. Custom views can be organized by geography, location, buildings, or 
organizational groupings, just to name a few. Devices can belong to more than one custom view.  

As with all IMC views, custom views offer drilldown capabilities to the device details for an individual 
device. From the Device Details page, you can access management features that offer you quick 
and easy access to network resources as well as the ability to manage them. 

Accessing custom views 

1. Navigate to Resource > Custom View: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click View Management on the left navigation tree. 

c. Click Custom View on the left navigation tree. The list of custom views is displayed in the 
Custom View List. If a custom view contains subviews, click the Expand icon  next to the 
view name to display the subviews. 

2. Click the view name you want to access. The Device List/Topology for that view is displayed. 

Device List 

 Status—Contains the latest status of the device. Device icons that are gray are not 
managed. 

 Device Label—Contains the name of a device in the view. The contents of this field serve 
as an active link for drilling down into the Device Details page, which offers you convenient 
access to device management features. 

 Subview—Displays the subview to which the device belongs in the custom topology. If the 
device does not belong to any subview, this field displays a hyphen (-). For more information 
about subviews, see "Left & right mouse clicks: Monitoring and management." 

 Device Category—Contains the IMC device category for the associated device. 

 Model—Contains device model information. If the device is managed for reachability using 
ICMP only no device model information is available and the field contains "ICMP." 

 IP Address—Contains the IP address of the device. 

 Operation—Contains an icon  that displays links to operational tasks for the 
associated device. 

3. Customize the columns displayed in the Device List to add interested data to the Device List. 

4. Click Customize Columns in the upper right corner of the page. The Customize Columns 
window opens. 

The columns that can be customized include: 

 Model  

 IP Address 

 Vendor  

 Device Category 

 CPU Usage (%) 

 Memory Usage (%) 

 Device Response Time (ms) 

 Device Unreachability (%) 
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 Rx Rate (datagrams/s) 

 Fw Rate(datagrams/s) 

 Rx Discards(%) 

 Tx Discards(%) 

5. Select the columns to be displayed and click OK. The selected columns and the data collected 
within the last five minutes are displayed in the Device List. 

In the Device List, the Status, Device Label, Subview, and Operation columns are required. 
The default columns that can be displayed are Model, IP Address, and Device Category. 

For a performance index column, a trend chart pops up if you click the data in the target 

performance index column in the Device List. To pin the trend chart, click the  icon in the 

upper right corner of the trend chart. When the icon changes to , the trend chart is pinned. 

You can sort the Device List by the Status, Device Label, Subview, Device Category, 
Model, or IP Address field by clicking the column label to sort the list by the selected field. The 
column label is a toggle switch that allows you to toggle between the various sort options 
specific to each field. 

If the Device List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Device List. 

 Click  to page forward to the end of the Device List. 

 Click  to page backward in the Device List. 

 Click  to page backward to the front of the Device List. 

6. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items 
per page you want to view. 

Operators can only view the custom views and devices to which they have been granted 
management access. 

The color of a device icon represents the severity or alarm level for the most severe alarm condition 
for that device. 

IMC enables you to manage multiple devices through the custom view, including deleting, 
synchronizing, managing and unmanaging devices. For information about managing multiple 
devices through these views, see "Device list management options." 

Topology 

A topology map of the custom view is located on the Topology option, from which you can view the 
network diagram and perform certain operations on the topology map of the custom view. For more 
information about operating the topology map, see "Viewing devices through the network topology."  
 

 NOTE: 

This topology is embedded into the webpage and does not support double-clicks on clouds. For 
information about viewing a cloud topology, see "Customizing topology maps." 
 

Managing custom views 

Custom views offer administrators the ability to create views based on groups of devices you define. 
Unlike other IMC device views, custom views enable you to grant and revoke management rights to 
operators based on custom views. First, you must create the custom views, add devices to them, 
and then grant access to the custom groups in the individual operator accounts. 

It is important to also consider the rights and privileges you want to grant or restrict to you and how 
the logical grouping of devices can support an effect rights management policy. For more information 
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about the relationship of custom views and operator rights, see "Operator management: managing 
secure access to IMC." 

You can create one or more custom views based on the IMC security needs and viewing 
requirements of their organization.  

Creating custom views 

1. Navigate to Resource > Custom View: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Custom View on the left navigation tree. The list of custom views is displayed in the 
Custom View List.  

2. Click Add.  

3. Enter the name for the custom view you want to add in the View Name field. 

4. Click the Selecting a view icon  link next to the Upper-Level View field.  

The window for selecting a view opens.  

5. Select an upper-level view for the new view, and click OK.  

The selected view is displayed at the right of the Upper-Level View field. You can create 
unlimited levels sub-custom views for a custom view. 

6. Select an option from the Automatically Add New Devices list.  

 None—You must manually add devices to the view. 

 All—If you select this option, any device added to IMC is automatically added to the view. 

 From Designated Rule—Adding newly added device to the view based on the designated 
rule. The designated rule includes: 

 Designated Network—Automatically adding newly added devices whose IP addresses 
are on the specified IP network segment to the view. 

 Enter the start IP address in the Start IP field. 

 Enter the end IP address in the End IP field. 

 Click Add to add the network segment to the Network Segment field. Or, click 
Delete to delete one or more IP address segments. 

 Designated Device Type—Automatically adding newly added devices whose device 
models are among the specified device models to the view. 

 Click Add. 

 Select device models in the dialog box that opens. 

 Click OK. 

The selected device models are displayed in the device model list. To remove a device 

model from the list, click the Remove icon  for the device model. 

 Designated System Name—Automatically adding newly added devices whose system 
names are in the specified system name list to the view. 

 Enter a system name in the System Name field. 

 Click Add to add the system name to the System Name List field. 

 To delete one or more system names, click Delete. 

 Designated Contact—Automatically adding newly added devices whose contacts are 
in the specified contact list to the view. 

 Enter a contact in the Contact field. 

 Click Add to add the contact to the Contact List field. 

 To delete one or more contacts, click Delete. 
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 Designated SysLocation—Automatically adding newly added devices whose system 
locations are in the specified system location list to the view. 

 Enter a location in the Location field. 

 Click Add to add the system location to the SysLocation List field. 

 To delete one or more locations, click Delete. 

7. In the Device List, select whether to Add all devices of the current system.  

8. If this option is selected, the Device List is hidden, all devices managed by IMC are added to 
the view, and you directly go to Step 10. 

9. If the Add all devices of the current system option is not selected in Step 5, you can click 
Add in the Device List to select devices you want to add to the view. 

10. Add devices using either By View or Advanced query option.  

See "Adding devices by view" and "Adding devices by advanced query." 

11. Click OK to create the custom view. 

Importing custom views 

Use this function to quickly create custom views and add devices in specified IP segments to the 
custom views.  

To import custom views: 

1. Navigate to Resource > Custom View: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Custom View on the left navigation tree. The list of custom views is displayed in the 
Custom View List. 

2. Click Import. 

The Import custom view dialog box opens. 

3. In the Input File field, click Browse. Select an import file that is saved locally in the dialog box 
that opens. 

The import file must be a text file and the file size cannot be larger than 5 MB. 

Each custom view takes one row and the import file uses the following column contents: View 
Name, IP Segment1, Segment2,,,,,,,IP SegmentN. 

The field definitions for all columns in an import file are listed in Table 22. The table describes all 
columns that can be used in a valid data import file and the rules for constructing a valid import 
file using these column definitions. 

Table 22 Import file column definitions 

Column label  Column contents/requirements  

View Name  
This column contains the custom view name. 

This field is required. 

IP Segment  

This column contains one or more IP segments. The start and end IP addresses 
for each IP segment are separated by a hyphen (-). All IP segments are 
separated by commas. 

This field is optional. 
 

4. Click Import. 

The page is updated with the results of the custom view import. 

5. View the result of the custom view import and check whether or not all devices in the specified 
segments have been added to the custom view. 

Modifying custom views 

1. Navigate to Resource > Custom View: 
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a. Click the Resource tab from the top tabular navigation system. 

b. Click Custom View on the left navigation tree. The list of custom views is displayed in the 
Custom View List. If a custom view contains subviews, click the Expand icon  next to the 
view name to display the subviews. 

2. Click the Modify icon  associated with the custom view you want to modify. 

3. Modify the name for the custom view in the View Name field. 

4. Click the Selecting a view icon  link next to the Upper-Level View field.  

The window for selecting a view opens.  

5. Select an upper-level view for the new view, and click OK.  

The selected view is displayed at the right of the Upper-Level View field.  

6. Reselect an option from the Automatically Add New Devices list.  

 From Designated Rule—Adding newly added device to the view based on the designated 
rule. The designated rule includes: 

 Designated Network—Automatically adding newly added devices whose IP addresses 
are on the specified IP network segment to the view. 

 Enter the start IP address in the Start IP field. 

 Enter the end IP address in the End IP field. 

 Click Add to add the network segment to the Network Segment field. Or, click 
Delete to delete one or more IP address segments. 

 Designated Device Type—Automatically adding newly added devices whose device 
models are among the specified device models to the view. 

 Click Add. 

 Select device models in the dialog box that opens. 

 Click OK. 

The selected device models are displayed in the device model list. To remove a device 

model from the list, click the Remove icon  for the device model. 

 Designated System Name—Automatically adding newly added devices whose system 
names are in the specified system name list to the view. 

 Enter a system name in the System Name field. 

 Click Add to add the system name to the System Name List field. 

 To delete one or more system names, click Delete. 

 Designated Contact—Automatically adding newly added devices whose contacts are 
in the specified contact list to the view. 

 Enter a contact in the Contact field. 

 Click Add to add the contact to the Contact List field. 

 To delete one or more contacts, click Delete. 

 Designated SysLocation—Automatically adding newly added devices whose system 
locations are in the specified system location list to the view. 

 Enter a location in the Location field. 

 Click Add to add the system location to the SysLocation List field. 

 To delete one or more locations, click Delete. 

7. In the Device List, select whether to Add all devices of the current system.  

If this option is selected, the Device List is hidden, all devices managed by IMC are added to 
the view, and you directly go to Step 10. 
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8. If the Add all devices of the current system option is not selected in Step 5, you can click 
Add in the Device List to select devices you want to add to the view. 

9. Add devices using either By View or Advanced query option. 

 See "Adding devices by view" and "Adding devices by advanced query." 

10. Click OK to modify the custom view. 

Deleting custom views 

1. Navigate to Resource > Custom View: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Custom View on the left navigation tree. The list of custom views is displayed in the 
Custom View List. If a custom view contains subviews, click the Expand icon  next to the 
view name to display the subviews. 

2. Click the Delete icon  associated with the custom view you want to delete. 

3. Click OK to confirm deletion of the custom view. 
 

 NOTE: 

All the devices in the view are removed from the deleted views but are not deleted from IMC. 
 

Adding devices to custom views 

Once you have created the custom views, you are ready to add devices.  

To add devices to custom views: 

1. Navigate to the Device List for a custom view: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Custom View on the left navigation tree.  

This displays the Custom View List in the main pane of the Custom View page. If a 
custom view contains subviews, click the Expand icon  next to the view name to display 
the subviews. 

2. Click the View Name link for the custom view to which you want to add devices. 

3. Click Add. 

4. Add devices using either By View or Advanced query option. 

 See "Adding devices by view" and "Adding devices by advanced query." 

Removing devices from custom views 

To remove devices from custom views: 

1. Navigate to the Device List for a custom view. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Custom View on the left navigation tree.  

This displays the Custom View List in the main pane of the Custom View page. If a 
custom view contains subviews, click the Expand icon  next to the view name to display 
the subviews. 

2. To remove devices from a view, click the View Name link for the custom view from which you 
want to delete devices.  

3. Remove one or more devices from the Device List by selecting devices you want to remove 
from the custom view, and then click Remove. 

Now that you have created custom views and have added devices to them, the next step is to grant 
or restrict access to these views and the devices in them by configuring each operator account. 

Operator accounts that are included in the Administrator Group have administrator privileges to all 
custom views. These privileges cannot be revoked. To effectively use custom views to restrict 
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access and management rights to devices in them, you must also configure the operators to have 
membership in an operator group that does not have ADMIN privileges. For more information about 
configuring operator groups and individual operator accounts, see "Operator management: 
managing secure access to IMC." 

Viewing device interfaces with port groups 
IMC offers you a variety of options for viewing network resources and for drilling down into the 
features used to manage them. IMC provides you with the ability to manage port groups. To facilitate 
viewing interface status, administrators can group several concerned interfaces or important 
interfaces (such as the device interfaces that connect to a mail server, or core layer device 
interfaces) together as a port group. 

The Port Group also offers drilldown capabilities to the device and interface details page. The 
Device Details page provides you with access to IMC's network device management features. The 
Interface Details page provides you with access to IMC's interface management features. 

Managing port groups 
The Port Group feature provides you with the ability to query, add, modify, and delete port groups 
and to grant and revoke management rights to operators. You can create one or more port groups 
based on the administrators' jobs and port functions. In addition, port groups offer you the ability to 
drill down to port groups' details. 

Querying port group list 

IMC enables you to filter port groups by a partial or complete port group name, by interface status, or 
by interface alias and then displays only those port groups that match the search or filter criteria. 

To filter the Port Group list: 

1. Navigate to Resource > Port Group List: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click View Management on the left navigation tree. 

c. Click Port Group under View Management on the left navigation tree.  

The Port Group List is displayed on the main pane of the Port Group List page. 

Port group list contents 

 Group Name—Contains the port group name. 

 Created by—Contains the name of the operator who created the associated port group. 

 Total Number—Contains the number of the interfaces in the associated port group. 

 Interface Status—Contains the latest status statistic of the interfaces in the associated port 
group. The interface statuses include:  

 Down 

 Up 

 Unknown 

 Disabled 

 Unmanaged 

Each interface status is attached with the number of interfaces in the port group that are in 
that status. 

 Description—Contains the description for the associated port group. 

 Modify—Contains the Modify  icons that link to modify the port group. For more 
information about deleting port groups, see "Modifying a port group." 
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 Delete—Contains the Delete  icons that link to delete the port group. For more 
information about deleting port groups, see "Deleting a port group." 

2. To perform a basic query, enter a port group name in the upper right corner of the Port Group 

List, and click the Search icon . 

3. To perform an advanced query: 

a. Click the Advanced icon  located in the upper right corner of the Port Group List. 

A search criteria dialog box opens. 

b. Enter the following search criteria: 

 Group Name—Enter the port group name for which you want to search. Select Fuzzy 
from the list next to the Group Name if you want to enter a partial IP address. Select 
Exact from this list if you want IMC to search for an exact match for the port group name 
you have entered. 

 Created by—Enter the name of the operator who created the port group for which you 
want to search. IMC supports fuzzy matching for this field, allowing you to enter a partial 
or complete string for the operator name. 

 Interface Status—Select the status of the interfaces in the port group for which you 
want to search from the Interface Status list.  

 Interface Description—Enter the description of the port group for which you want to 
search in the Interface Description field. IMC supports fuzzy matching for this field, 
allowing you to enter a partial or complete string for the interface description. 

 Interface Alias—Enter the interface alias that is contained in the port group for which 
you want to search in the Interface Alias field. IMC supports fuzzy matching for this 
field, allowing you to enter a partial or complete name for the interface alias. 

c. Click Query. 

The results display in the main pane of the Port Group List page. 

Viewing the interface list of a port group 

1. Navigate to Resource > Port Group List: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click View Management on the left navigation tree. 

c. Click Port Group under View Management on the left navigation tree.  

The Port Group List is displayed on the main pane of the Port Group List page. 

2. Click the Group Name link. 

The interface list of the port group is displayed. 

Interface list of the port group 

 Interface Status—Contains the latest status statistic of the interfaces in the associated port 
group. The interface statuses include:  

  Down 

  Up 

  Unknown 

  Disabled 

  Unmanaged 

 Interface Description—Contains the interface name, which serves as a link for navigating 
to the Interface Details page. For more information about the Interface Details page, see 
"Interface details page." 

 Interface Index—Contains a unique index of the associated interface. 
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 Interface Type—Contains the type of the associated interface. 

 Device Label—Contains the name of the device where the interface is located, serving as a 
link for navigating to the Device Details page. For more information about the Device 
Details page, see "Managing one device through device details." 

 Interface IP—Contains the IP address of the associated interface. 

 Mac Address—Contains the MAC address of the associated interface. 

 Speed (bps)—Contains the speed of the associated interface, in bits per second. 

 Duplex Mode—Contains the duplex mode of the associated interface: Half, Auto, or Full. 

 Rx (bps)—Contains the average receive rate of the day on the associated interface, in bits 
per second. 

 Tx (bps)—Contains the average transmit rate of the day on the associated interface, in bits 
per second. 

 Rx Util (%)—Contains the average receive bandwidth usage of the day on the associated 
interface, in percent. 

 Tx Util (%)—Contains the average transmit bandwidth usage of the day on the associated 
interface, in percent. 

 Rx Dis (%)—Contains the average inbound packet loss rate of the day on the associated 
interface, in percent. 

 Tx Dis (%)—Contains the average outbound packet loss rate of the day on the associated 
interface, in percent. 

 Rx Err (%)—Contains the average inbound packet error rate of the day on the associated 
interface, in percent. 

 Tx Err (%)—Contains the average outbound packet error rate of the day on the associated 
interface, in percent. 

You can sort the interface list by the Interface Status, Interface, Interface Type, Device 
Label, Interface IP, Mac Address, Speed (bps), and Duplex Mode fields by clicking the 
column label to sort the list by the selected field. The column label is a toggle switch that allows 
you to toggle between the various sort options specific to each field. 

IMC supports generating real-time charts based on the data of Port Group. Click Generate 
Chart, and select Add Chart Template or Manage Chart Template from the menu that 
appears. For more information about the left operations, see "Adding chart templates" and 
"Managing chart templates." 

Adding a port group 

1. Navigate to Resource > Port Group List: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click View Management on the left navigation tree. 

c. Click Port Group under View Management on the left navigation tree.  

The Port Group List is displayed on the main pane of the Port Group List page. 

2. Click Add to add a port group.  

The Add Port Group page opens. 

3. Enter the port group name in the Group Name field. 

4. Select the operator groups that can access the port group.  

5. Enter a description for this port group in the Description field. 

6. Select either of the following options from the Automatically Add New Interfaces list: 

 None—You must manually add interfaces to the view. 

 Based on Specified Rule—The system automatically adds newly added interfaces to the 
view based on the designated rule. If you select this option, enter the match rule for 
interface aliases in the Interface Alias Rule field. 
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7. Click Add to select interfaces you want to add to the port group.  

The Select Interfaces dialog box opens. 

8. Add interfaces using either the View or Advanced query option. 

Adding interfaces uses the same process as adding devices. See "Adding devices by view" and 
"Adding devices by advanced query."  

When you select a custom view in the By View tab and then click the Advanced tab, IMC 
automatically populates the View Name field with the name of the custom view. This helps you 
quickly locate a custom view and query target interfaces in the custom view. 

9. Click OK to create a port group. 

Modifying a port group 

1. Navigate to Resource > Port Group List: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click View Management on the left navigation tree. 

c. Click Port Group under View Management on the left navigation tree.  

The Port Group List is displayed on the main pane of the Port Group List page. 

2. Click the Modify icon  for the port group you want to modify.  

The Modify Port Group page opens. 

3. Modify the port group name in the Group Name field. 

4. Do one of the following: 

 To change access to this port group, select the operator groups to which you want to grant 
access. 

 To remove operator groups, click the checked boxes  to the left of the operator groups 
for which you want to revoke access. 

5. Modify the description for this port group in the Description field. 

6. Click Add to select the device interfaces to a port group.  

The Select Interfaces dialog box opens. 

7. Add interfaces using either the View or Advanced query option. Adding interfaces uses the 
same process as adding devices.  

See "Adding devices by view" and "Adding devices by advanced query." 

8. Do one of the following: 

 To delete the selected interfaces from a port group, click the Delete icon  in the delete 
field of the Select Interfaces list. 

 To delete all interfaces from a port group, click Remove All in the upper of the Select 
Interfaces list.  

9. Click OK to accept you change to this port group. 

Deleting a port group 

1. Navigate to Resource > Port Group List: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click View Management on the left navigation tree. 

c. Click Port Group under View Management on the left navigation tree.  

The Port Group List is displayed on the main pane of the Port Group List page. 

2. Click the Delete icon  for the port group you want to delete. 

3. Click OK to confirm the deletion of the port group. 

Deleting a port group does not remove the interfaces of this port group from IMC. 
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Managing the rack view 
The rack view displays location and capacity information for all racks in the IMC data center 
topology. 

Viewing the rack view 
1. Click the Resource tab. 

2. From the navigation tree, select View Management > Rack View. 

The All Rack page opens. 

Rack List contents 

 Rack Name—Name of the rack. 

 Room Name—Name of the room where the rack is located. 

 Data Center—Name of the data center to which the rack belongs. 

 Floor—Floor where the rack is located. 

 Available U Nums—Total number of rack units that are still available. 

 Max Continuous Available U Nums—Maximum number of continuous available rack 
units in the rack. 

As a best practice, reconfigure the rack name and height of a rack after you add it to the 3D room. 

Querying rack views 
1. Access the All Rack page. 

2. Enter search criteria: 

 Rack Name—Name of the rack. 

 Room Name—Name of the room where the rack is located. 

IMC supports fuzzy matching for these fields. 

3. Click Query. 

The page displays all results that match the specified criteria. 

Managing the lower-level NMS view 
IMC supports parent/child NMS, and the lower-level network view displays the information about the 
lower-level NMS servers with current IMC as the upper-level NMS server. You can add, modify, or 
delete the lower-level NMSs of the current IMC through the lower-level NMS view. You can also log in 
to the lower-level NMS to see information about the topology and customize view. 

Viewing the lower-level NMS view 
To view a lower-level NMS view: 

1. Navigate to Resource > Lower-Level NMS View. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Hierarchical NMS on the left navigation tree. 

c. Click Lower-Level NMS View under Hierarchical NMS on the left navigation tree.  

The Lower-Level NMS View displays information about all the lower-level NMS servers.  

Lower-Level NMS View list 
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 IP Address—IP address of the lower-level NMS server. Click the IP Address link. The 
Device Details page opens. 

 Status—Status of the lower-level NMS server. It is determined by the highest alarm level of 
the server. 

 Login Port—Login port of the lower-level NMS server. 

 Login Name—Login name of the lower-level NMS server. 

2. Click Refresh at the top of the page to refresh the current page. 

Adding a lower-level NMS 
IMC uses the ICMP IPv4 protocol to monitor and manage the lower-level NMS servers. Make sure 
the target NMS server has been added to IMC before performing this operation. 

To add a lower-level NMS: 

1. Navigate to Resource > Lower-Level NMS View: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Hierarchical NMS on the left navigation tree. 

c. Click Lower-Level NMS View under Hierarchical NMS on the left navigation tree.  

The Lower-Level NMS View displays information about all the lower-level NMS servers.  

2. Click Add.  

The Add Lower-Level NMS page opens. 

3. Click Select Devices next to IP Address.  

A dialog box opens. 

4. Select the target lower-level server from the box.  

The available device categories includes Server, Virtual Device and Desktop. 

You can add devices by using either the By View or Advanced query option. See "Adding 
devices by view" and "Adding devices by advanced query." 

5. Click OK. 

The IP address of the selected lower-level NMS server is displayed in the input filed next to IP 
Address. 

6. Select HTTP or HTTPS for Login Type. 

7. Enter the login port number in the field next to Login Port. 

8. Select Specified Operator or Current Operator as Login Operator. 

 Specified Operator—Use the specified login name and password to log in to lower-level 
NMS. Go to Step 9. 

 Current Operator—Use the current IMC login name and password to log in to lower-level 
NMS. Go to Step 11. 

9. Enter the login name in the field next to Login Name. 

10. Enter the password in the field next to Password. Enter the password again in the field next to 
Confirm Password. 

11. Click OK to add a lower-level NMS. 

Modifying a lower-level NMS 
1. Navigate to Resource > Lower-Level NMS View: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Hierarchical NMS on the left navigation tree. 

c. Click Lower-Level NMS View under Hierarchical NMS on the left navigation tree.  
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The Lower-Level NMS View displays information about all the lower-level NMS servers.  

2. Click the Modify icon  for the target lower-level NMS server. 

The Modify Lower-Level NMS page opens. 

3. Modify the configuration parameters as required.  

The IP Address cannot be modified. For the other parameters, see "Adding a lower-level 
NMS." 

4. Click OK to accept your change to this lower-level NMS. 

Deleting a lower-level NMS 
1. Navigate to Resource > Lower-Level NMS View: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Hierarchical NMS on the left navigation tree. 

c. Click Lower-Level NMS View under Hierarchical NMS on the left navigation tree.  

The Lower-Level NMS View displays information about all the lower-level NMS servers.  

2. Click the Delete icon  for the target lower-level NMS server. 

A confirmation box opens. 

3. Click OK to confirm the deletion of the lower-level NMS. 

Accessing a lower-level NMS 
1. Navigate to Resource > Lower-Level NMS View: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Hierarchical NMS on the left navigation tree. 

c. Click Lower-Level NMS View under Hierarchical NMS on the left navigation tree.  

The Lower-Level NMS View displays information about all the lower-level NMS servers.  

2. Do one of the following: 

 Click Log In icon . The lower-level NMS home page opens. 

 Click Network Topology icon . The lower-level NMS topology is displayed. 

 Click Custom View icon . The lower-level NMS custom view page opens. 

Managing one device through device details 
IMC offers you a rich set of monitoring and management features for network devices. You have the 
option to manage one device at a time or multiple devices. IMC's feature set for managing one 
device includes the ability to synchronize and refresh views, manage, unmanage, and delete devices 
from IMC, launch Telnet, SSH, Device Panel and Web Manager sessions for the selected device, 
perform ping and Traceroute tests.  

You can also configure the selected device on the Device Details page. Options include configuring 
the device label, system group attributes, IMC's SNMP, SSH, and Telnet settings for the selected 
device, modifying status and configuration polling intervals, ping parameters, and ACL settings.  

In addition, you can both monitor and manage switches for PoE, RMON, VLAN and Spanning Tree 
configurations. You can configure and view performance information for a selected device as well as 
launch configuration management functions including backing up device configurations. You can 
also view protocol management information for OSPF, IGMP, and IPv6.  

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 8722



321 

All of these options are available through the Device Details page of a selected device.  

Accessing the device details page 
There are many ways to access the Device Details page, the most common of which is through the 
Device List. The Device List is displayed in each of the following views – Device View, IP View, 
and the Custom View. The Device Label column in the Device List contains a link that navigates 
you to the Device Details page for the selected device. For information about accessing the Device 
List displayed in these views, see "Viewing devices with Device, IP, and Topology views" and 
"Viewing devices with custom views." 

In addition, you can right-click a selected device in the Network Topology to access the Device 
Details page. For information about viewing Device Details from the Network Topology view, see 
"Viewing devices through the network topology." 

Navigation instructions for accessing the Device Details page from the Device View for all devices 
are provided below. 

1. Navigate to Resource > Device View: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click View Management on the left navigation tree. 

c. Click Device View under View Management on the left navigation tree. 

The Device List – All displays all devices in IMC. 

2. Locate the device for which you want to view the details.  

3. Click the link in the Device Label column in the Device List for the device. 

The Device Details page opens. 

The Device Details page has features and resources that provide you with quick and easy 
access to important device information as well as links to device configuration options.  

Device details section contents & configuration options 

The Device Details section of the Device Details page presents basic device information as well as 
several options for device configuration. 

 Device Label—Contains the IMC name for the device. By default, IMC uses the system name 
or sysName of the device if it has been configured. 

To modify the device label, click the Modify icon  next to the Device Label field, enter a 
new device label, and then click OK. 

Modifying the device label changes IMC name or label for the device in IMC only. It does not 
change the name of the device on the device itself. 

 Device Status—Contains the latest status for the device. Status is determined by the highest 
severity or alarm level for the device, when a device has more than one current alarm that has 
not been cleared or recovered. Device icons with the color gray denote that the device is 
unmanaged. 

 IP Address/Mask—Contains the IP address and the subnet mask of the device. 

To modify the IP address or the mask, click the Modify icon  next to the IP Address or 
Mask field, enter the new IP address or mask, and then click OK. 

 sysOID—Contains the system Object ID for this device. 

 Device Model—Contains information on the model of the device. 

 Device Category—Contains IMC's category of the device. 

To modify the device category, click the Modify icon  next to the Device Category field, 
reselect a device category, and then click OK. 

 System Name—Contains the name of the device as configured on the device. 
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To modify the system name, click the Modify icon  next to the System Name field, enter the 
new system name, and then click OK. 

 Contact—Contains contact information for this device. 

To modify the contact information, click the Modify icon  next to the Contact field, enter the 
new contact information, and then click OK. 

 Location—Contains the location of the device. 

To modify the location information, click the Modify icon  next to the Location field, enter 
the new location, and then click OK. 

 Runtime—Contains the SysUpTime or system up time for this device. 

 Last Poll—Contains the date and time stamp for IMC's last status poll for the associated 
device. 

 Login Type—Contains the access method for the device.  

To modify the login type, click the Modify icon  next to the Login Type field, select the new 
login type or access method from the Login Type list, and then click OK. The device must also 
be configured to support the login type. 

a. Click OK. 

 Interfaces—This field contains the number of interfaces and a link that displays a list of all 
interfaces on the device. This list includes interface status as well as a link to view and take 
action on specific interfaces. For more interface information, see "Interface details page." This 
list contains all of the fields displayed, including those fields for which IMC is unable to gather 
information. In these cases, the field is blank or contains the value "unknown." 

 Device Bridge MAC—Contains the bridge MAC address of the device.  

 System Description—Contains the system description as defined by the vendor. 

 Maintenance Tag—Contains the description of the maintenance tag task for the device. If the 
device does not have a maintenance tag, this field displays No Maintenance Tag. To modify 
the maintenance tag: 

a. Click the Modify link  next to the Maintenance Tag field. 

b. Select Yes or No from the Enable Maintenance Tag list. 

If the Yes option is selected, enter a new maintenance tag description in the Description 
field. 

c. Click OK. 

Service monitoring 

On the Device Details page, you can configure IMC to perform TCP and UDP port checks to 
validate that a service on the selected device is listening and responding to queries on that port. This 
form of monitoring validates basic service availability. By default, Telnet, FTP, SMTP, DNS, HTTP, 
and TFTP are configured, but not enabled at installation. In addition to these standard service 
monitors, user defined service monitors can be added. Once configured, you can view real time 
status of services running on a selected device, also on the Device Details page.  

You can configure service monitors from the Device Details page of a selected device. In addition, 
IMC displays the results of this service monitoring in the Service Monitoring tab found in the lower 
portion of the Device Details page. 

Viewing monitored services 

To view real time service monitoring for an individual device, navigate to the Device Details page for 
the selected device: 

1. On the Device Details page, click the Service Monitoring tab located below the Device 
Details section. 
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2. To view all of the monitored services, click the Monitoring Service link located just below the 
Service Monitoring tab. 

IMC displays all service monitoring entries in a table in the Service Monitoring tab. 

Monitoring service list fields and explanations 

 Service Name—Contains the name of the service being monitored.  

 Service Port—Contains the TCP or UDP port number that is being monitored. 

 Service Type—Identifies which IP transmission protocol is being monitored, TCP or UDP. 

 Service Status—Contains the last known status of this service, based on IMC's last poll. 
Status of a service can be running, stopped, or unknown. 

Configuring monitored services 

To configure IMC to perform service monitoring:  

1. On the Device Details page, click the Service Monitoring tab located below the Device 
Details section. 

2. Click the Customize link  next to Monitoring Information. 

3. Select the Service Name for which you want to enable service monitoring.  

4. Do one of the following: 

 If you have selected a system defined service (Telnet, FTP, SMTP, DNS, HTTP, or TFTP), 
skip to step 6. 

 If you want to monitor a service that is not one of the system-defined services displayed in 
the Service Name field, select CustomService_1-5. 

 If you are monitoring a custom or user defined service, first delete the CustomService_# 
value in the field associated with the checkbox you checked in step 3.  

5. Enter the service name for the service you want to monitor. 

6. Enter the TCP or UDP port number for the service that is being used by the monitored service 
on the selected device in the Service Port field. 

7. Select the transmission protocol that is being used by this service on the managed device from 
the Service Type list. 

8. Click OK. 

It may take a few minutes for IMC to execute the service monitoring poll and update the Monitor 
Information field with the status of this service. Use your browser's refresh or reload option to 
refresh the Service Monitoring table. The Service Port number and Service Type or transmission 
protocol must match what is configured on and being used by the service being monitored on the 
managed device. 

VDC information 

For Cisco Nexus series switches, you can view the VDC information on the Device Details page. 
The VDC information displays VDCs that are created in the device in a list. 

To view the VDC information for a device, click the VDC Information tab located below the Device 
Details area. The VDC information list contains the following fields: 

 VDC Name—Name of the VDC. 

 Role—Current role of the VDC. 

 Status—Running status of the VDC. Options are active and inactive. 

Alarms 

On the Device Details page, you can view the most recent 10 alarms that have not been cleared or 
recovered, along with a graph that summarizes alarms that have not been cleared or recovered. The 
alarms list also provides you with drilldown capabilities to alarm details.  
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Scroll down to the section of the Device Details page titled Recent 10 unrecovered alarms to view 
the most recent unrecovered alarms. 

IMC displays the 10 most recent, unrecovered alarms in a table that contains the fields listed below. 

 Level—Contains the current severity or alarm level status for the associated alarm. 

 Description—Contains a description of the event or condition that is being alarmed on. The 
Description field contains a hyperlink for drilling down into the Alarm Details for the selected 
alarm. For more information about the Alarm Details page and actions that you can take from 
this page, see "Taking actions ." 

 Alarm At—Contains the date and time stamp for the associated alarm. 

For a view of all alarms for the selected device, click More located in the right corner of the table.  

The All Alarms table is displayed, filtered by the selected device's IP address. For more information 
about the All Alarms page, see "Browsing all alarms." 

Alarm summary graph 

The Device Details page also includes a graph that summarizes all alarms except the Info alarms 
for the selected device. This graph contains active links on the graph itself for drilling down into 
alarms by severity or alarm level. 

Performance monitor 

On the Device Details page, you can access the Performance Monitor. This feature provides you 
with a quick snapshot of the monitoring indexes for the selected device from which you can view the 
most current performance statistics as well as generate historical reports for the same indexes.  

Scroll down to the section of the Device Details page titled Performance Monitor to view the most 
recent performance metrics.  

IMC displays performance metrics in a table that contains the fields listed below. 

 Monitor Index—Contains the performance metric for which the device is being monitored. 

 Monitored Value—Contains the most recent polled value for the performance metric. 

 Operation—This field contains the Start/Stop Monitor option. 

To view historical data for the performance monitors listed in the Performance Monitor table: 

1. On the Device Details page, click Performance at a Glance in the Performance Monitor 
area. 

IMC displays reports for the last hour for all monitoring indexes listed in the Performance 
Monitor table. You can modify the statistical time range. 

2. Use the scroll bar to view all displayed reports. 

To modify display indexes for the performance monitors in the Performance Monitor list: 

1. On the Device Details page, click Modify Display Index in the Performance Monitor area. 

The display index dialog box opens and displays all monitoring indexes that are in the 
Performance Monitor list.  

The Performance Monitor list only displays the monitoring data of the added indexes instead 
of all indexes. 

2. Modify display indexes by performing the following tasks: 

 To add display indexes, click Add, select display indexes and set the time range in the 
dialog box that opens, and then click OK. The Performance Monitor list supports a 
maximum of 20 display indexes for a device. 

Adding display indexes displays the data of the selected display indexes in the 
Performance Monitor list instead of adding monitoring instances for performance data 
collection. For the Performance Monitor list to display the data of a display index, make 
sure the respective monitoring instance of the display index has existed. 
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 To delete a display index, click the Delete icon  for the display index. If you want to delete 
all display indexes, click Delete All. 

 To modify the time range for a display index, click the Modify icon  for the display index, 
set a time range in the dialog box that opens, and then click OK.  

3. Click Close. 

Device additional information 

This tab displays customized additional information for the device, including parameter names and 
values. This tab is displayed only when you have configured device addition information. For more 
information about configuring device additional information, see "Device additional information." 

To modify parameter values, click Customize. 

Rack And Room information 

This tab displays the position information of the device, including the data center name, room name, 
and rack name. This tab is displayed only when you have added the device to a rack. Click the link in 
the Rack Name column to enter a specific room, and locate the rack containing the device. 

For more information about adding network devices to a rack, see "Managing the 3D room and 
network devices." 

Right navigation tree 

The Device Details page contains many options for configuring one device. The navigation tree 
located on the right side of the Device Details page contains configuration options for the selected 
device. Except the action section, all other sections of the right navigation tree are collapsed by 
default. Click a section of the right navigation tree to expand the section. The sections of the right 
navigation tree include Action, Configure, Performance Monitor, Configuration Center, VLAN 
Management, Device Management, RMON Management, and Protocol Management.  

The right navigation tree is context sensitive and configuration options on this tree vary as the device 
type changes.  

Actions – For all devices 

On the right of the Device Details page for a device, an Action menu is available for you to manage 
and configure that device, including managing or unmanaging the device, synchronizing the device 
data, and deleting the device from IMC. 

In addition, you can establish a remote session with the selected device using Telnet or SSH on the 
Device Details page, launch the Web Manager or Device Panel for remote management of the 
selected device, and execute Ping and Traceroute tests from the IMC server to the selected device. 

Synchronize 

Synchronize allows you to update IMC views with current data for the selected device. Information 
in the device details section of the page as well as changes to Telnet or SNMP parameters are 
updated.  

To synchronize the selected device: 

1. On the selected device's Device Details page, click the Synchronize link in the Action section 
of the right navigation tree. For information about navigating to a device's Device Details page, 
see "Viewing devices with Device, IP, and Topology views." 

The top of the Device Details page updates to reflect the initiation of the synchronization 
process.  

2. Refresh this page using the Refresh option on the right navigation tree to view any updates to 
device data.  

To synchronize multiple devices, see "Managing multiple devices from the device list." 

Refresh 
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Refresh allows you to reload the current Device Details page and capture any updates to the device 
details or other dynamic data found on this page. This feature is particularly useful when you use the 
Synchronize option to query the selected device for updated information.  

To refresh the selected device: 

1. On the selected device's Device Details page, click the Refresh link in the Action section of 
the right navigation tree. For information about navigating to a device's Device Details page, 
see "Viewing devices with Device, IP, and Topology views." 

2. To refresh multiple devices, see "Managing multiple devices from the device list." 

Manage/Unmanage 

The process of discovering devices in IMC is separate and distinct from the process of managing 
them. During discovery, IMC adds all discovered devices to the IMC database. You should determine 
which devices should be actively managed. Managing devices means that IMC features for 
monitoring and managing the device are available for the managed device. Both managed and 
unmanaged devices consume node licenses.  

From the Action menu, you can manage or unmanage the selected device. The 
Manage/Unmanage link is a toggle switch between these two states. If the right navigation tree 
menu option displays the Manage option, this means that the device is currently unmanaged. 
Conversely, if the right navigation tree menu option displays the Unmanage option, this means that 
the device is currently managed.  

To manage or unmanage the selected device: 

1. On the selected device's Device Details page, click the Manage or Unmanage link in the 
Action section of the right navigation tree to unmanage a device. 

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views." 

The top of the Device Details page updates to reflect the completion status of the Manage or 
Unmanage task.  

2. Refresh this page using the Refresh option on the right navigation tree to view any updates to 
device data.  

To manage or unmanage multiple devices, see "Managing multiple devices from the device list." 

Delete 
 

 CAUTION: 

Once a device has been deleted, it cannot be restored. Proceed with caution.  
 

You can permanently delete the selected device from IMC along with all its associated data. When 
you delete a device, all its associated data is removed from IMC immediately.  

To delete a device: 

1. On the selected device's Device Details page, click the Delete link in the Action section. For 
information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views." 

2. Click OK. 

To delete multiple devices, see "Managing multiple devices from the device list." 

Telnet 

You can launch a Telnet session to the selected device to configure or manage the device.  

To telnet to the selected device: 

1. On the selected device's Device Details page, click the Telnet link in the Action section of the 
right navigation tree.  
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For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views." 

2. Follow system instructions to establish a Telnet session with the selected device. 
 

 NOTE: 

To use this feature, you must have an operating system or application that supports Telnet on the 
computer you use to access IMC. 
 

Open Web manager 

You can open a Web Manager session to manage the selected device on the Device Details page, 
providing quick Web access to managed devices.  

To use Web Manager to access and manage the selected device: 

1. On the selected device's Device Details page, click the Open Web Manager link in the Action 
section of the right navigation tree.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views." 

The Web Manager interface opens. 

2. Enter your Web Manager user name and password. 

3. Click OK. 

Web Service must be supported and enabled on the device for this feature to function properly. 

Ping 

You can ping the selected device to test its reachability with the IMC server.  

To ping the selected device: 

1. On the selected device's Device Details page, click the Ping link in the Action section of the 
right navigation tree. For information about navigating to a device's Device Details page, see 
"Viewing devices with Device, IP, and Topology views." 

The Ping dialog box opens. 

2. Select the Ping packet size in bytes from the Buffer Size list. 

3. Enter the number of Ping packets you want IMC to send to the selected device in the Number 
field. The value range is 1 to 1000. 

4. Click OK to accept your changes and begin the Ping test. 

5. View the results of your Ping test in the Ping dialog box. 

To export the ping result, click Export Result. The name of the exported result file uses the 
following format: Ping[Device Label(Device IP)]. When the length of the device label exceeds 
32 characters, only the first 32 characters are used in the file name. 

6. Click OK to close the Ping test dialog box. 

Traceroute 

You can perform a Traceroute to the selected device to test its reachability or troubleshoot the 
reachability issue.  

To perform a Traceroute to the selected device: 

1. On the selected device's Device Details page, click the Traceroute link in the Action section 
of the right navigation tree. For information about navigating to a device's Device Details page, 
see "Viewing devices with Device, IP, and Topology views." 

The Traceroute dialog box opens. 

2. View the results of your Traceroute in the Traceroute dialog box. 

3. Click OK to close the Traceroute dialog box. 

View topology 
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You can view the position of the device in a topology and the network structure. 

To view the topology of a device: 

1. On the selected device's Device Details page, click the View Topology link in the Action 
section of the right navigation tree. For information about navigating to a device's Device 
Details page, see "Viewing devices with Device, IP, and Topology views." 

The Select Topology dialog box opens. 

2. Select a topology from the Topology List. 

3. Click OK. 

MIB management 

The MIB Management option offers the ability to view, edit, and manage the MIB file of the device. 

To launch MIB Management for the selected device on the Device Details page: 

1. On the selected device's Device Details page, click the MIB Management link in the Action 
section of the right navigation tree. For information about navigating to a device's Device 
Details page, see "Viewing devices with Device, IP, and Topology views." 

2. Load the MIB file and view MIB information. 

For more information about MIB Management, see "MIB management." 

Telnet/SSH proxy 

With the Telnet/SSH proxy feature, you can use a browser to remotely access and manage devices 
through SSH or Telnet on any client without installing a Telnet/SSH tool. This feature uses the IMC 
server as a proxy, uses a browser on a client to access devices, sends configuration commands, and 
displays output through Telnet/SSH. 

To use the Telnet/SSH proxy to access and manage a device: 

1. Click the Telnet/SSH link in the Action section of the selected device's Device Details page.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views." 

The Telnet/SSH Proxy window opens. 

2. Do one of the following: 

 Click Connection  in the upper part of the window to connect to the selected device. 
The client displays connection status information.  

 Click Disconnection  to disconnect from the device.  

 Click Set protocol parameters  to set the connection protocol parameters. 

If you use the Telnet protocol, you can modify the Telnet listening port, which is 23 by default. If 
you use the SSH protocol, you can modify the login information, including User Name, 
Password, and Port. The Telnet/SSH proxy automatically selects Telnet or SSH for login 
according to the login method configured on the device. By default, Telnet is used.  

Click Clear  to clear all output displayed on the client.  

When you use the SSH protocol for connecting to a device, the username+password 
authentication is supported, and the key file authentication is not supported.  

3. Enter commands in the field on the lower part of the Telnet/SSH Proxy window to interact with 
the device. 

4. After you enter the commands, click Send  next to the field or press Enter to send the 
commands to the device.  

Open device panel 
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The Device Panel provides you with a graphical view of HPE, 3Com, and H3C devices with the 
ability to monitor and manage the device from the graphical view.  

To access the graphical device panel for the selected device: 

1. Click the Open Device Panel link in the Action section of the selected device's Device Details 
page.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views." 

The Device Panel for the selected device is displayed on a new browser window, providing you 
with a real-time graphical rendering of the selected device. From the Device Panel, you can 
configure the selected device as well as view configuration and other information. 

Device panel navigation aids 

 Hovering the mouse over the blank area of the device panel displays a tip. The tip displays the 
device label and the IP address. 

 Pointing to a component of the device displays component information. 

 A left click a port to select the port. Hovering the mouse over a port displays a tip. The tip 
displays the port information, including the port description, port alias, and IP address. If no 
information is configured for the port, the tip displays N/A. 

 A right-click the chassis to display the Chassis Menu for viewing device information or 
configuration options. Information on the Chassis Menu can be found in the following 
information titled Device Panel Chassis Menu. By default, the 2D panel is displayed. The 2D 
panel supports the Switch Front/Rear Panel Alignment menu. You can switch to the 3D 
panel. 

 A right-click a port from the device panel to display the Port Menu for viewing port information 
or configuration options. Information on the Port Menu can be found in the following 
information titled Device Panel Port Menu. 

Device panel chassis menu 

The Device Panel Chassis menu can be accessed by right-clicking the chassis itself from the Device 
Panel. The following information provides an overview of the information and configuration options 
of the Chassis Menu. 

 Device Information—From this menu option, you can: 

 View some or all of information in the following areas depending on the device type 
selected.  

 Configure the selected device.  

 Perform Port Mode Switch, Port Aggregation, Reset Device, Save Device Configuration, 
Mpu Switch, Port Mirror, Address Binding, Environment Monitor, RMON, Config Interface 
802.1X Status and RADIUS Server Configuration. 

 Protocol Management—From this menu option, you can view information in the following 
areas (the areas vary with the device model): 

 OSPF—OSPF Attribute, Area Information, Stub Area Information, LSDB Information, Extended 
LSDB Information, OSPF Interface, Interface ToS Metric, Peer Information, Virtual Link 
Interface and Virtual Link Peer. 

 MSTP—Global MSTP, MSTI, and Port MSTP. 

 IGMP Snooping—IGMP Snooping Status, Aging Time of Router Port (second), Maximum 
Response Time of Query (second), and Aging Time of multicast Port (second). 

 Real-time Performance Monitor—From this menu option, you can view performance 
information and configure the selected device in the Device Realtime Monitor area. 

Device panel port menu 

The Device Panel Port Menu can be accessed by right-clicking a port from the Device Panel, 
providing an overview of the information and configuration options of the Port Menu. 
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 Port Management—From this menu option, you can view information and configure Port 
Information, Loopback Test, and Add Port to VLAN. 

 Realtime Performance Monitor—From this menu option, you can view performance 
information and configure the selected device in the Port Realtime Monitor area. 

SSH 

You can launch an SSH session to the selected device from the Device Details page, providing 
quick and centralized access to managed devices.  

To establish an SSH session to the selected device: 

1. Click the SSH link in the Action section of the selected device's Device Details page. 

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views." 

2. Follow the Tools Configuration dialog box instructions on downloading and installing an SSH 
application used to establish an SSH session with the selected device, or browse your local 
machine for an application that supports SSH. 

3. Follow the applications instructions for configuring and establishing an SSH sessions to the 
selected device. To use this feature, you must have an operating system or application that 
supports SSH on the computer you use to access IMC. 

Actions - For switches 

IMC offers the IP/MAC Learning Query service under the Action section of the right navigation tree 
of the Device Details page which provides you with quick query the IP/MAC Learned information. 

IP/MAC Learning Query 

To configure device IP/MAC settings: 

1. Click the IP/MAC Learning Query link in the Action section of the selected device's Device 
Details page.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views." 

2. Enter the Learned IP address in the Learned IP Address field. 

3. Enter the Learned MAC address in the Learned MAC Address field. 

4. Click Query. 

The results of your query display in the IP/MAC Learning List. 

IP/MAC learning list 

 Switch IP—Contains the IP address of the selected switch which serves as a link for drilling 
down to the associated device's Device Details page. 

 Interface Description—Contains the interface description of the associated interface on 
the selected switch which serves as a link for drilling down to the associated interface's 
Interface Details page. 

 VLAN ID—Contains the VLAN ID to which the associated interface belongs. 

 Learned IP Address—Contains the learned IP address associated with the interface listed 
in the Interface Description field. 

 Learned MAC Address—Contains the learned MAC address associated with interface 
listed in the Interface Description field. 

If the IP/MAC Learning List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the IP/MAC Learning List. 

 Click  to page forward to the end of the IP/MAC Learning List. 

 Click  to page backward in the IP/MAC Learning List. 
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 Click  to page backward to the front of the IP/MAC Learning List. 

5. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

6. For IP/MAC Learning lists that have more than one page, click 1, 2, 3, 4, 5, 6, 7, 8, 9, 10… from 
the bottom right side of the main pane to jump to a particular page of the IP MAC Learning list. 

You can sort the IP/MAC Learning List by most fields by clicking the column label to sort the 
list by the selected field. The column label is a toggle switch that allows you to toggle between 
the various sort options specific to each field. 

7. Click Reset when you have finished your query to clear the IP/MAC Learning List. 

Configure - For all devices 

Using the Configure features found in the Device Details right navigation tree, you can modify a 
device label and system group attributes including system name, location, and contact, modify 
SNMP, Telnet, and SSH settings and modify status and configuration polling intervals as well as ping 
and Web Manager parameters. 

Modify device label 

The Device Label is the IMC name for the selected device. By default, IMC takes the system name 
or sysName of a device if the system name has been configured on it. You can change the name of 
the device in IMC for the device without changing the name on the device itself. 

To modify the device label of the selected device from the Device Details page: 

1. Click the Modify Device Label link  in the Configure section of the right navigation tree on 
the selected device's Device Details page.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views." 

The Modify Device Label dialog box opens. 

2. Delete the existing device label name from the Device Label field and enter the new device 
name. 

3. Click OK. 

Modify system group attributes 

You can change other attributes of a device including its system name or sysName, its contact 
information, and the device's location. This option is not available for desktop devices. 

To modify the system group attributes of the selected device from the Device Details page: 

1. Click the Modify System Group Attributes link  in the Configure section of the right 
navigation tree on the selected device's Device Details page. For information about navigating 
to a device's Device Details page, see "Viewing devices with Device, IP, and Topology views." 

The Modify System Group Attributes dialog box opens. 

2. Delete the existing system name in the System Name field and enter the new system name. 

3. Delete the existing contact information in the Contact field and enter the new contact 
information. 

4. Delete the existing location information in the Location field and enter the new location 
information. 

5. Click OK. 

In addition to numbers, letters, and spaces, the characters in Table 23 are valid entries for the 
System Name, Contact, and Location fields. 
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Table 23 Valid Characters for Naming 

Character Name Character Name 

~ Tilde ' Apostrophe or single quotation 

! Exclamation mark @ At sign 

# Pound sign $ Dollar sign 

% Percent sign ^ Caret 

& Ampersand * Asterisk 

() Parenthesis = Equal sign 

+ Plus sign | Vertical bars 

- Hyphen _ Underscore 

[] Square brackets {} Braces 

: Colon ; Semicolon 

\ Backslash " Double quotation 

, Comma / Forward slash 

. Dot <> Angle brackets 

? Question mark   
 

Modify SNMP settings 

You can modify IMC's SNMP settings for the selected device. Modifying the SNMP settings changes 
the device's SNMP settings but does not change the SNMP settings on the managed device. 

To modify IMC's SNMP settings for the selected device from the Device Details page: 

1. Click the Modify SNMP Settings link in the Configure section of the right navigation tree on 
the selected device's Device Details page. 

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views." 

The Modify SNMP Parameters dialog box opens. 

2. Do one of the following: 

 To edit IMC's configuration of the device's SNMP parameters, verify that Edit SNMP 
Parameters is selected. 

 To edit IMC's configuration using templates, skip down to "Using existing SNMP template." 

3. Select the version of SNMP (v1 or v2c) that is configured on the device to be added from the 
Parameter Type list: 

 Enter the read-only community string in the Read-Only Community String field. 

 Enter the read-write community string in the Read-Write Community String field. 

4. Enter the SNMP timeout value (1–60 seconds) in the Timeout field.  

This parameter determines how long IMC waits for an SNMP reply from the managed device 
before declaring that the request has timed out. The default is 4. 

5. Enter the number of SNMP retries (1–20) in the Retries field.  

The retries parameter defines how many times the management system (IMC) sends SNMP 
retries in an attempt to communicate with the managed device before reporting a failure. The 
default is 3. 

6. Click Test to check whether the current SNMP parameters are consistent with the SNMP 
configuration on the device. 

7. Click OK. 
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Using existing SNMP templates 

To use existing SNMP templates: 

1. To apply the SNMP settings of an existing SNMP template to this device, perform the following 
steps: 

 Select Select an Existing Template. 

 Select an SNMP template. 

2. Click OK. For more information about creating SNMP templates, see "SNMP templates." 

Modify Telnet settings 

To modify Telnet settings for the selected device from the Device Details page: 

1. Click the Modify Telnet Settings link in the Configure section of the right navigation tree on 
the selected device's Device Details page.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views." 

The Modify Telnet Parameters dialog box opens.  

2. Do one of the following:  

 To edit IMC configuration using templates, skip down to "Using an existing Telnet template." 

 To edit the Telnet parameters manually, verify that Edit Telnet Parameters is selected. 

3. Select the Telnet authentication mode from the Authentication Mode list. 

4. Enter the username in the Username field, if prompted. 

5. Enter the password in the Password field, if prompted. 

6. Enter the super password in the Super Password field, if prompted. 

7. Enter the Telnet timeout value (1–60 seconds) in the Timeout field.  

8. Click Test to check whether the current Telnet parameters are consistent with the Telnet 
configuration on the device. 

9. Click OK. 

Using existing Telnet templates 

To configure the Telnet settings for this device using an existing Telnet template: 

1. Select Select an Existing Template. 

2. Select a Telnet template. 

3. Click OK. For more information about creating Telnet templates, see "Telnet templates." 

Modify NETCONF settings 

To modify NETCONF settings for the selected device: 

1. On the selected device's Device Details page, click the Modify NETCONF Settings link in the 
Configure section of the right navigation tree.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views." 

The Modify NETCONF Parameters dialog box opens.  

2. Do one of the following:  

 To add a new NETCONF access setting, click the Add Protocol icon  and go to step 3. 

 To modify an existing NETCONF access setting, click Modify for the NETCONF access 
setting and go to step 4. 

 To delete an existing NETCONF access setting, click Delete for the NETCONF access 
setting. 

3. Select the protocol to be used by NETCONF. 

4. Specify the following parameters in the dialog box that opens: 
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 Port Number—Enter the port number used by the protocol on the device. 

 Root Path—Enter the root path for the protocol on the device. The default is 
/soap/netconf. 

 User Name—Enter the username, which must be the same as that configured on the 
device. 

 Password—Enter the password, which must be the same as that configured on the device. 

5. Click OK. 

Modify SSH settings 

To modify SSH settings for the selected device from the Device Details page: 

1. On the selected device's Device Details page, click the Modify SSH Settings link in the 
Configure section of the right navigation tree.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views." 

The Modify SSH Parameters dialog box opens.  

2. Do one of the following:  

 To edit IMC's configuration using templates, skip down to "Using existing SSH templates." 

 To edit the SSH parameters, verify that Edit SSH Parameters is selected. 

3. Select the authentication mode from the Authentication Mode list. 

The authentication mode selected must match what is configured on the device. 

4. Enter username in the User Name field. 

5. Enter the password in the Password field, if prompted. 

6. Enter the path and filename of the private key file that contains the key that enables login, if 
prompted. 

7. Enter the private key password for the private key file, if prompted. 

8. Enter the TCP port for SSH in the Port field. The default TCP port is 22. 

9. Enter the SSH timeout value (1–120 seconds).  

The timeout parameter defines how long the system waits for the device to respond in seconds 
before declaring that the response has timed out. The default setting is 10 seconds. 

10. Enter the number of SSH retries (1–5).  

The retries parameter defines how many times the management system (IMC) sends SSH 
retries in an attempt to communicate with the managed device before reporting a failure. The 
default setting is 3. 

11. Click Test to check whether the current SSH parameters are consistent with the SSH 
configuration on the device. 

12. Click OK to accept the SSH configuration. 

Using existing SSH templates 

To configure the SSH settings for this device using SSH templates: 

1. Select Select SSH Parameters. 

2. Select a SSH template. 

3. Click OK to accept the SSH configuration. For more information about creating SSH templates, 
see "SSH templates." 

Modify SOAP/HTTP settings 

When IMC add-on Virtual Resource Manager (VRM) module is installed and in use, you can modify 
the SOAP/HTTP settings IMC uses to remotely access the selected device. 

To modify SOAP/HTTP settings for the selected device from the Device Details page: 
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1. On the selected device's Device Details page, click the Modify SOAP/HTTP Settings link in 
the Configure section of the right navigation tree. 

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views." 

The Modify SOAP/HTTP Parameters dialog box opens.  

2. Do one of the following:  

 To edit IMC configuration using templates, skip down to "Using existing SOAP/HTTP 
templates." 

 To edit the SOAP/HTTP parameters, verify that Edit SOAP/HTTP Parameters is selected. 

3. Select the access URL protocol from the Protocol list. 

4. Enter the port number in the Port field. 

5. Enter access URL root path in the Root Path field. 

6. Enter the user name in the Username field. 

7. Enter the password in the Password field. 

8. Select the Test connection to vManager/physical server, if you want to do the testing. 

9. Click OK to accept the SOAP/HTTP configuration. 

Using existing SOAP/HTTP templates 

To configure the SOAP/HTTP settings for this device using SOAP/HTTP templates: 

1. Select Select SOAP/HTTP Parameters. 

2. Select the SOAP/HTTP template you want to use. 

3. Click OK to accept the SOAP/HTTP configuration. For more information about creating 
SOAP/HTTP templates, see "SOAP/HTTP templates." 

Modify poll interval 

You can modify the polling interval settings for status and configuration polling for the selected 
device. Modifying the status or configuration polling interval influences how quickly IMC detects 
problems with status or configuration—setting long polling intervals delays detection and setting 
short polling intervals increases the resource demand on IMC.  

To modify polling interval settings for the selected device from the Device Details page: 

1. On the selected device's Device Details page, click the Modify Poll Interval link in the 
Configure section of the right navigation tree.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views." 

The modify Poll Interval dialog box opens. 

2. Enter the configuration polling interval in minutes in the Configuration Poll Interval field.  

This interval determines how long IMC must wait before polling managed devices for 
configuration changes. 

The range is 5 to 1500 minutes and the default is 120 minutes. Like most management 
systems, IMC uses ping to query devices for their status or reachability. 

3. Enter the status-polling interval in minutes in the Status Poll Interval field.  

This interval determines how long IMC waits before sending ping requests to the managed 
device to determine its reachability status. 

The range is 30 to 600 seconds and the default is 60 seconds. 

4. Click OK to accept the polling interval configuration. 

Modify ping parameters 

To modify ping parameters for the selected device from the Device Details page: 
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1. Click the Modify Ping Parameters link in the Configure section of the right navigation tree on 
the selected device's Device Details page.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views." 

The Modify Ping Parameters dialog box opens. 

2. Select Support Ping Operation. 

 If you select Support Ping Operation, IMC will use ping packets to detect the reachability 
of devices. 

 If you clear Support Ping Operation, IMC will use SNMP packets to detect the reachability 
of devices. 

3. Click OK. 

Modify Web manager parameters 

To modify the communication parameters for Web Manager: 

1. Click the Modify Web Manager Parameters link in the Configure section of the right 
navigation tree on the selected device's Device Details page.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views." 

The Modify Web Manager Parameters dialog box opens. 

2. Select the protocol that is used by Web Manager from the Protocol list. 

3. Enter the port number for Web Manager in the Port field. 

4. Click OK. 

If you do not make a selection from the Protocol list and the selection for Protocol is blank, 
IMC uses the global setting found under the System tab and the port value assigned is ignored. 

Configure – For specific device types 

IMC offers quick access to the ACL Management service module from the Device Details page. 
The ACL Configuration link, which can be found under Configure on the right navigation tree for 
routers, redirects you to the ACL Management service module found under the Service tab. For 
more information about the ACL management features of IMC, see "Access control list 
management." 

Performance monitoring 

In the Performance Monitor section of the right navigation tree of the Device Details page, you can 
quickly access performance reports for the selected device. In addition, you can refresh monitor 
instances as well as delete performance data and cancel configured monitor instances.  

By default, IMC provides the following two monitors for all devices as measured by ping requests and 
responses for devices that support ping monitoring:  

 Average Unreachability 

 Average Response Time 

By default, four monitors are created for managed network devices, such as routers, switches, and 
wireless devices, which support these metrics. These four monitors are:  

 Average CPU Utilization 

 Average Memory Utilization 

 Average Unreachability 

 Average Response Time 

For devices that do not support the default monitors, the Add Monitor link is available if no 
performance monitor instances have been configured for the selected device. 

Add Monitor 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 8738



337 

The Add Monitor link is displayed under Performance Monitor on the right navigation tree only if 
there are no performance monitors already configured for the selected device. The Add Monitor link 
is a shortcut to the Performance Management > Monitoring Settings-Add Monitor menu option 
located on the left navigation tree under the Resource tab. For more information about adding 
monitors, see "Performance management." 

Cancel Monitor 
 

 CAUTION: 

Clicking Cancel Monitors removes all monitoring instances for the selected device without 
warning; use this feature with caution. 
 

Once monitors have been created for the selected device, the Cancel Monitor option is displayed 
on the right navigation tree. From this menu option, you can remove or cancel all monitoring 
instances for the selected device.  

To cancel all monitor instances: 

1. On the selected device's Device Details page, click the Cancel Monitor link in the 
Performance Monitor section of the right navigation tree. For information about navigating to a 
device's Device Details page, see "Viewing devices with Device, IP, and Topology views." 

All monitors are removed and the Results page opens.  

2. See the Result field of the Results table for details on the results of the monitoring operation. In 
addition, all links under the Performance Monitor section of the right navigation tree are 
replaced with the Add Monitor link. 

Performance at a glance 

To view the most current and historical data for the performance monitor instances configured for this 
device: 

1. On the selected device's Device Details page, click the Performance at a Glance link in the 
Performance Monitor section of the right navigation tree.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views." 

IMC displays reports for the current day for all monitors instances for the selected device. Use 
the scroll bar on the right to view all reports. 

Refresh monitor instance 

To refresh the data for the performance monitor instances configured for this device: 

1. On the selected device's Device Details page, click the Refresh Monitor Instance link in the 
Performance Monitor section of the right navigation tree.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views." 

2. Click OK to perform you operation. 

Delete performance data 

To delete performance data for the monitor instances for this device without deleting the monitoring 
instances: 

1. On the selected device's Device Details page, click the Delete Performance Data link in the 
Performance Monitor section of the right navigation tree.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views." 

2. Click OK to confirm deletion of the performance data. 

Device real-time monitor 

To add a realtime monitor for this device:  
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1. On the selected device's Device Details page, click the Device Real-Time Monitoring link in 
the Performance Monitor section of the right navigation tree.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views." 

2. Click Add to select one or more monitor indexes. 

The system automatically selects CPU Usage, Memory Usage, Response Time of Device, 
and Device Unreachability Proportion as the default monitor indexes and the current device 
as the monitor object for each index. 

3. In the Select Instances area, select instances to be monitored. By default, the system monitors 
all instances for CPU Usage, Memory Usage, Response Time of Device, and Device 
Unreachability Proportion.  

4. Click OK. 

5. The monitor graph is automatically populated with the basic information, including the graph 
title, Y-axis name, and Y-axis unit. You can modify the basic information as needed.  

6. Click OK. The realtime monitor is successfully added. The realtime monitor can be 
automatically saved on the Device Details page. If you close and then open the realtime 
performance monitoring window, you can still see the previously added monitor graph. You do 
not need to add the monitor graph again.  

Configuration center 

IMC provides you with the ability to launch configuration management tasks for the selected device 
directly on the Device Details page. On the Device Details page, you can, with one click, back up 
the configuration of the selected device and configure the automated backup attributes for the 
selected device. 

Backup configuration files 

To back up device configuration: 

1. On the selected device's Device Details page, click the Backup Configuration File link in the 
Configuration Center section of the right navigation tree. 

2. View the results of the backup task in the Configuration File Backup Result page that display 
upon completion of the backup request. 

Set auto backup attribute 

The Set Auto Backup Attribute link is a shortcut to the Auto Backup Plan feature of the 
Configuration Center service module. For more information about adding monitors, see "Storing 
device configuration backups in cipher text." 

By default, iCC stores device configuration backups in plain text to the \server\data\cfgbak 

(/server/data/cfgbak for Linux) directory of the IMC installation path. The configuration backups 
can be viewed by any system user who has the privileges to the directory. To enhance security for 
the backups, you can configure IMC to store them in cipher text. 

To configure IMC to store device configuration backups in ciphertext on Windows: 

1. Open the qvdm.conf file with WordPad in the \IMC\server\conf directory of the IMC installation 
path. 

2. Find the following parameter: 
#flag indicate if the configuration file is encrypt stored, 1: encrypt; 0, plain text 
#EncryptConfigFileFlag = 0 

3. Set the value of the EncryptConfigFileFlag parameter to 1: 
#EncryptConfigFileFlag = 1 

4. Save and close the file. 

5. Restart the IMC service. 

To configure IMC to store device configuration backups in ciphertext on Linux: 
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1. Open the qvdm.conf file with the vi editor in the /IMC/server/conf directory of the IMC 
installation path and press i to enter insert mode. 

2. Find the following parameter: 
#flag indicate if the configuration file is encrypt stored, 1: encrypt; 0, plain text 
#EncryptConfigFileFlag = 0 

3. Set the value of the EncryptConfigFileFlag parameter to 1: 
#EncryptConfigFileFlag = 1 

4. Press Esc and then enter the wq command to save and close the file. 

5. Restart the IMC service. 

With the configuration, IMC starts to store device configuration backups in ciphertext. 

The configuration does not encrypt existing configuration backups. 

If IMC is deployed in distributed mode, modify the qvdm.conf file only on servers that are deployed 
with the iCC component. 

Device default startup configuration 

You can specify the default startup software, primary configuration file, and secondary configuration 
file for a device. 

To configure device default startup: 

1. On the selected device's Device Details page, click the Device Default Startup 
Configuration link in the Configuration Center section of the right navigation tree.  

The Device Default Startup Configuration window opens. 

2. Set the default startup software. Select Image.  

Valid options include Primary and Secondary.  

3. Do one of the following: 

 To configure the device to start with the primary startup software, select Primary. 

 To configure the device to start with the secondary startup software, select Secondary. 

The Startup Configuration File list shows all configurations files on the device: 

 File Name—Contains the name of the configuration file. 

 Active—Identifies the configuration file that is currently in use with an icon . 

 Primary—Identifies the primary configuration file with an icon . If the file is not the 

primary configuration file of the device, this field contains a Configure link. You can 
click the link to configure the file as the primary configuration file. The process takes some 
time. 

 Secondary—Identifies the secondary configuration file with an icon . If the file is not the 

secondary configuration file of the device, this field contains a Configure link. You can 
click the link to configure the file as the secondary configuration file. The process takes 
some time. 

 Copy—Contains an icon  that copies the configuration file. After you rename the copied 
configuration file, it is displayed in the Startup Configuration File list. 

 Delete—Contains an icon  for deleting the configuration file. 

4. Click Close. 

Device management 

The options displayed in this section of the right navigation tree vary based upon the selected device 
being viewed in the Device Details page.  
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Basic options under Device Management include the ability to reset a device and save device 
configuration. 

From the Device Management menu option, you can also view the following system information: 

 IP Address Table 

 Address Translation Table 

 IP Routing Table 

 TCP Connection Table 

You can also view the following address binding information: 

 MAC-Port Binding Management 

 Global MAC Address Learning Configuration 

 Port MAC Address Learning Management 

You can also view device hardware information including module, port, power, and fan information. 
IPv6 information is also available from the Device Management menu. This option enables you to 
view the following information:  

 IPv6 Address Translation Table 

 IPv6 Interface Table 

 IPv6 Address Table 

 IPv6 Routing Table 

 IPv6 Address Prefix Table 

 IPv6 UDP Table 

 IPv6 TCP Table 

Finally, port aggregation information is also available from the Device Management menu. From 
this menu, you can configure or remove port aggregation for the selected device. 

Resetting a device 

You can reset routers, switches, and wireless devices by using the Reset Device option located in 
the Device Management section of the right navigation tree of the Device Details page.  

To reset the selected device: 

1. On the selected device's Device Details page, click the Reset Device link in the Device 
Management section of the right navigation tree.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views" and "Viewing devices with custom views." 

The Reset Device dialog box opens. 

2. Do one of the following:  

 Clear Save device's current configuration if you want reboot the device without saving its 
current configuration.  

 Leave the checkbox selected if you want to save the device's current configuration. 

3. Click Reset. 

4. Verify that the device reset was successful by checking the Reset Device dialog box for reset 
results. 

5. Click Close to close the Reset Device dialog box. 

Saving configuration 

You can save the configuration of routers, switches, and wireless devices by using the Save 
Configuration option located in the Device Management section of the right navigation tree of the 
Device Details page. This function is equivalent to executing the Save command on devices. 

To save the configuration of the selected device: 
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1. On the selected device's Device Details page, click the Save Configuration link in the Device 
Management section of the right navigation tree.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views" and "Viewing devices with custom views." 

2. Click OK to confirm your request to save the configuration for the selected device. 

Environment monitor 

To view or modify the environment information for the selected card, or reset the card: 

1. On the selected device's Device Details page, click the Environment Monitor link in the 
Device Management section of the right navigation tree.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views" and "Viewing devices with custom views." 

The Environment Monitor page opens. 

Environment monitor list 

 Frame No.—Contains the frame number. 

 Slot No.—Contains the slot number that specifies the slot where the board resides. 

 Type—Contains the type of the board. 

 Status—Indicates the state is normal, upper indicates that the temperature exceeds the 
upper threshold, and lower indicates the temperature is under the lower threshold. 

 Value(cent.)—Contains the temperature of the board. 

 Upper Limit(cent.)—Contains the upper threshold for the board temperature. 

 Lower Limit(cent.)—Contains the lower threshold for the board temperature. 

 Modify—Contains the link for modifying the environment parameters, including upper limit, 
lower limit and critical limit. 

 Reset—Contains a link to reset the card and the Save device's current configuration option. 

 Click  to page forward in the Environment list. 

 Click  to page forward to the end of the Environment list. 

 Click  to page backward in the Environment list. 

 Click  to page backward to the front of the Environment list. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

Switch MPU 

To switch the active/standby MPUs for the selected device and view MPU information: 

1. Click the Switch MPU link in the Device Management section of the right navigation tree on 
the selected device's Device Details page.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views" and "Viewing devices with custom views." 

The MPU Switch page opens, including the Last MPU Switch Date, Last MPU Switch Time, 
and MPU Switch Times options. 

2. Click Switch to switch the active/standby MPUs. 

System information 

To view the system information for the selected device: 

1. On the selected device's Device Details page, click the System Information link in the Device 
Management section of the right navigation tree.  
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For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views" and "Viewing devices with custom views." 

The IP Address Table page opens. Four tables of system information are displayed: IP 
Address Table, Address Translation Table, IP Routing Table, and TCP Connection Table.  

2. To access any one of these tables, click the tabs located at the top of the page. 

3. Click Close to close the page. 

HPE Power Management 

Use this function to manage external power supplies that are used to power HPE devices. Only HPE 
640 external power supplies support this function. HPE 640 external power supplies are used to 
power HPE devices over Ethernet through twisted cables. 

To view HPE power management details: 

1. On the selected device's Device Details page, click the HPE Power Management link in the 
Device Management section of the right navigation tree. 

For more information about navigating to a device's Device Details page, see "Viewing devices 
with Device, IP, and Topology views" and "Viewing devices with custom views." 

The HPE Power Management page displays the following information: 

 Reset to Factory Default Settings—Reset the external power supply to the factory default 
settings. 

 Enable Power—Enable or disable the external power supply. 

 Enable Power Auto-recovery—By default, an HPE switch uses the external power supply, 
and uses its own power supply when the external power supply is unavailable. If the power 
auto-recovery is enabled, the HPE switch automatically switches to the external power 
supply when the external power supply becomes available again. If the power 
auto-recovery is disabled. the HPE switch will still use its own power supply. 

 Reset to Factory Default Settings Status: 

 1—Idle. 

 2—The request is being processed. 

 3—The request is processed successfully. 

 4—The request fails. 

 PowerZone Distribution—An external power supply has 1 to 4 zones. Each zone has 1 to 
4 slots—A, B, C, and D. For example, "1A, 1B" indicates that the slot A and slot B in the 
zone 1 are being used. 

 Power Zone Mode(Force/Balance Mode)—Force mode, When power shortage occurs, 
lower-priority switches that belong to a zone are suspended from being powered. Balance 
mode, When power shortage occurs, power is allocated to switches that belong to a zone 
and no switch will be suspended from being powered. 

 Number of Supported Switches—Number of switches that can be powered by the current 
zone. This value range is 1 to 4 because each zone has 4 slots at most. 

 Serial NO.—Serial number of the power supply. 

 Model—Model of the power supply. 

 Type—Type of the power supply. 

 Voltage(V)—Voltage of the power supply. 

 Wattage(W)—Wattage of the power supply. 

 Connection State—Connection state of the power supply. 

 Modify—Click the Modify icon  for an external power supply to modify its configuration 
parameters. 

To modify HPE 640 external power supply configuration parameters: 
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1. On the selected device's Device Details page, click the HPE Power Management link in the 
Device Management section of the right navigation tree. 

2. Click the Modify icon  for the HPE 640 external power supply. 

The page for modifying the HPE 640 external power supply opens. 

3. Modify the following parameters as needed: 

 Reset to Factory Default Settings—Whether to reset the external power supply to factory 
default settings. 

 Enable Power—Enable or disable the external power supply. 

 Enable Power Auto-recovery—Enable or disable the external power supply 
auto-recovery. 

 Power Zone Distribution—Modify the external power supply zone distribution. 

 Power Zone Mode(Force/Balance Mode)—Modify the external power supply zone mode 
to Force Mode or Balance Mode. 

 Number of Supported Switches—Modify the number of switches that can be powered by 
the current zone. 

 Connection State—Connection state of the power supply. You cannot modify this field. 

4. Click OK. 

Mirror group 

You can add, edit, and delete mirror groups for devices. 

Displaying mirror group information 

1. On the selected device's Device Details page, click the Mirror Group link in the Device 
Management section of the right navigation tree.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views" and "Viewing devices with custom views." 

The Mirror Group (MG) page opens. 

Mirror Group (MG) list 

 MG ID—Contains the MG ID. 

 MG Type—Contains the MG type. 

 MG Status—Contains the MG status. 

 MG Mirror—Contains a link to edit the MG mirror. 

 MG Monitor—Contains a link to edit the MG monitor. 

 MG Reflector—Contains a link to edit the MG reflector. 

 MG VLAN ID—Contains a link to edit the MG VLAN ID. 

If the Mirror Group (MG) List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Mirror Group (MG) List. 

 Click  to page forward to the end of the Mirror Group (MG) List. 

 Click  to page backward in the Mirror Group (MG) List. 

 Click  to page backward to the front of the Mirror Group (MG) List. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

Adding a mirror group 
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1. On the selected device's Device Details page, click the Mirror Group link in the Device 
Management section of the right navigation tree.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views" and "Viewing devices with custom views." 

The Mirror Group (MG) page opens. 

2. Click Add to add a mirror group. 

3. Enter the MG ID in the MG ID field. 

4. Select the MG type from the MG Type list. 

5. Click OK to add the mirror group. 

Editing a mirror group 

After you add a mirror group, you need to configure the MG mirrors, MG reflectors, or MG VLAN IDs 
for the mirror group. 

Configuring MG mirrors 

1. On the selected device's Device Details page, click the Mirror Group link in the Device 
Management section of the right navigation tree.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views" and "Viewing devices with custom views." 

The Mirror Group (MG) page opens. 

2. Click the MG Mirror icon  you want to configure. 

MG mirror list 

 MG ID—Contains the MG ID. 

 MG Mirror—Contains the MG mirror. 

 MG Mirror Direction—Contains the MG mirror direction. 

If the MG Mirror List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the MG Mirror List. 

 Click  to page forward to the end of the MG Mirror List. 

 Click  to page backward in the MG Mirror List. 

 Click  to page backward to the front of the MG Mirror List. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

4. Click Add to add an MG mirror. 

5. Select the MG ID in the MG ID list. 

6. Select the MG mirror in the MG Mirror list. 

7. Select the MG mirror direction in the MG Direction list.  

8. Do one of the following: 

 Click OK to add the MG mirror.  

 Select one or more MG mirrors you want to delete and click Delete. 

9. Click Return to return to the Mirror Group (MG) page. 

Configuring MG monitors 

1. On the selected device's Device Details page, click the Mirror Group link in the Device 
Management section of the right navigation tree.  
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For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views" and "Viewing devices with custom views." 

The Mirror Group (MG) page opens. 

2. Click the MG Monitor icon  you want to configure. 

The MG Monitor page opens. 

MG Monitor List contents 

 MG ID—Contains the MG ID. 

 MG Monitor—Contains the MG monitor. 

If the MG Monitor list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the MG Monitor List. 

 Click  to page forward to the end of the MG Monitor List. 

 Click  to page backward in the MG Monitor List. 

 Click  to page backward to the front of the MG Monitor List. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

4. Click Add to add an MG monitor. 

5. Select the MG ID in the MG ID list. 

6. Select the MG monitor in the MG Monitor list. 

7. Do one of the following: 

 Click OK to add the MG monitor.  

 Select one or more MG monitors you want to delete and click Delete. 

8. Click Return to return to the Mirror Group (MG) page. 

Configuring MG reflectors 

You can configure this option only when the remoteSource option is selected as the MG type.  

To configure the MG reflector: 

1. On the selected device's Device Details page, click the Mirror Group link in the Device 
Management section of the right navigation tree.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views" and "Viewing devices with custom views." 

The Mirror Group (MG) page opens. 

2. Click the MG Reflector icon  you want to configure. 

The MG Reflector page opens. 

MG Reflector List fields and explanations 

 MG ID—Contains the MG ID. 

 MG Reflector—Contains the MG reflector. 

If the MG Monitor list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the MG Reflector List. 

 Click  to page forward to the end of the MG Reflector List. 

 Click  to page backward in the MG Reflector List. 
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 Click  to page backward to the front of the MG Reflector List. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items 
per page you want to view. 

4. Click Add to add an MG reflector. 

5. Select the MG ID in the MG ID list. 

6. Select the MG reflector in the MG Reflector list. 

7. Do one of the following: 

 Click OK to add the MG reflector. 

 Select one or more MG reflectors you want to delete and click Delete. 

8. Click Return to return to the Mirror Group (MG) page. 

Setting the MG VLAN ID 

You can configure this option only when the remoteSource or remoteDestination option is selected 
as the MG type. 

To set the MG VLAN ID: 

1. On the selected device's Device Details page, click the Mirror Group link in the Device 
Management section of the right navigation tree.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views" and "Viewing devices with custom views." 

The Mirror Group (MG) page opens. 

2. Click the MG VLAN ID icon  you want to set. 

The MG VLAN ID page opens. 

MG VLAN ID list 

 MG ID—Contains the MG ID. 

 MG VLAN ID—Contains the MG VLAN ID. 

If the MG VLAN ID list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the MG VLAN ID list. 

 Click  to page forward to the end of the MG VLAN ID list. 

 Click  to page backward in the MG VLAN ID list. 

 Click  to page backward to the front of the MG VLAN ID list. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

4. Click Add to add an MG VLAN ID. 

5. Select the MG ID in the MG ID list. 

6. Select the MG VLAN ID in the MG VLAN ID list. 

7. Do one of the following: 

 Click OK to add the MG VLAN ID. 

 Select one or more MG VLAN IDs you want to delete and click Delete. 

8. Click Return to return to the Mirror Group (MG) page. 

Deleting mirror groups 

1. On the selected device's Device Details page, click the Mirror Group link in the Device 
Management section of the right navigation tree.  

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 8748



347 

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views" and "Viewing devices with custom views." 

The Mirror Group (MG) page opens. 

2. Select the MG ID you want to delete. 

3. Click Delete. 

4. Click OK to confirm deletion of the selected items. 

Address binding 

You can both view and configure port to MAC address binding for devices by using the Address 
Binding option located in the Device Management section of the right navigation tree of the Device 
Details page.  

To view and configure MAC address binding for the selected device: 

1. On the selected device's Device Details page, click the Address Binding link in the Device 
Management section of the right navigation tree. For information about navigating to a device's 
Device Details page, see "Viewing devices with Device, IP, and Topology views" and "Viewing 
devices with custom views." 

The MAC-Port Binding Management page opens. Three types of MAC address information 
tables and configuration options are displayed:  

 MAC-Port Binding Management 

 Global MAC Address Learning Configuration 

 Port MAC Address Learning Management 

2. To access any one of these configuration windows, click the tabs located at the top of the page.  

The title bar of the window changes to reflect the tab's title and IMC displays all MAC-Port 
Binding Management entries in the list displayed under the MAC-Port Binding Management 
tab. 

MAC-Port Binding Management Table 

 VLAN ID—Contains the VLAN ID to which the associated MAC address belongs. 

 MAC Address—Contains the MAC address. 

 Port—Contains the interface description. 

 MAC Address Entry Type—Contains information on how the address was acquired. 

 Modify—Contains a link for modifying the associated MAC address.  

To bind a MAC address-port : 

1. On the selected device's Device Details page, click the Address Binding link in the Device 
Management section of the right navigation tree.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views" and "Viewing devices with custom views." 

The MAC-Port Binding Management page opens. 

2. Click Add from the MAC-Port Binding Management table. 

3. Select the VLAN to which this port belongs from the VLAN ID list. 

4. Enter the MAC address you want to bind to this port in the MAC Address field. 

The format IMC accepts for MAC addresses is ####-####-#### where # is the hexadecimal 
value of the MAC address. 

5. Select the port you want to bind to the MAC address to in the Port field. 

6. Select the type of MAC address from the MAC Address Entry Type field.  

7. Click OK to accept your configuration. 

8. Click Close. 

To modify a MAC address-port binding configuration: 
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1. On the selected device's Device Details page, click the Address Binding link in the Device 
Management section of the right navigation tree.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views" and "Viewing devices with custom views." 

The MAC-Port Binding Management page opens. 

2. Click the Modify icon  associated with the MAC-Port binding configuration you want to 
modify. 

3. Select the type of MAC address from the MAC Address Entry Type field.  

4. Click OK to accept your configuration. 

5. Click Close. 

To delete a MAC-port binding: 

1. On the selected device's Device Details page, click the Address Binding link in the Device 
Management section of the right navigation tree.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views" and "Viewing devices with custom views." 

The MAC-Port Binding Management page opens. 

2. From the MAC-Port Binding Management table, select the MAC-Port binding configuration 
you want to delete. 

3. Click Delete. 

4. Click OK to confirm deletion of the selected items. 

To configure the global MAC address learning configuration: 

1. On the selected device's Device Details page, click the Address Binding link in the Device 
Management section of the right navigation tree.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views" and "Viewing devices with custom views." 

The MAC-Port Binding Management page opens. 

2. Click the Global MAC Address Learning Configuration tab. 

3. Enter the MAC address aging time in seconds in the MAC Address Aging Time field.  

Valid range is 10–1000000. The value -1 entered in this field indicates no limit to MAC address 
aging. 

4. Click OK. 

To modify a port MAC address learning management: 

1. On the selected device's Device Details page, click the Address Binding link in the Device 
Management section of the right navigation tree.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views" and "Viewing devices with custom views." 

The MAC-Port Binding Management page opens. 

2. Click the Port MAC Address Learning Management tab. 

3. Click the Modify icon  associated with interface you want to modify. 

4. Enter the maximum learnable MAC address in the Max Learnable MAC Addresses field.  

Valid range is 1–1048576. The value –1 entered in this field denotes no limit. 

5. Click OK to accept your configuration. 

Hardware information 

From the Hardware Information link under Device Management, you can view information about 
selected routers, switches, and wireless devices. The information provided in this view may vary by 
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device type but most network device types provide Device Information, Module Information, Port 
Information, Power Information, and Fan Information.  

To view hardware information for the selected device on the Device Details page: 

1. On the selected device's Device Details page, click the Hardware Information link in the 
Device Management section of the right navigation tree.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views" and "Viewing devices with custom views." 

The Hardware Information page opens. 

2. Use the Device Information, Module Information, Port Information, Power Information, 
and Fan Information tabs located at the top of the Device Information page to navigate to the 
information page you wish you view. 

3. Click Close when you have finished viewing the hardware information for the selected device. 

IPv6 information 

From the IPv6 Information link under Device Management, you can view IPv6 information for 
selected routers, switches, and wireless devices. The information provided in this view includes IPv6 
Address Translation Table, IPv6 Interface Table, IPv6 Address Table, IPv6 Routing Table, IPv6 
Address Prefix Table, IPv6 UDP Table, and IPv6 TCP Table. 

To view IPv6 information for the selected device on the Device Details page: 

1. On the selected device's Device Details page, click the IPv6 Information link in the Device 
Management section of the right navigation tree.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views" and "Viewing devices with custom views." 

The IPv6 Information page opens. 

2. Use the IPv6 Address Translation Table, IPv6 Interface Table, IPv6 Address Table, IPv6 
Routing Table, IPv6 Address Prefix Table, IPv6 UDP Table, and IPv6 TCP Table tabs 
located at the top of the IPv6 Information page to navigate to the information page you wish 
you view. 

3. Click Close when you have finished viewing the IPv6 information for the selected device. 

MDC management 

When the Multitenant Devices Context (MDC) feature is enabled on a device, you can use MDC 
management to manage MDCs. 

By default, there is a default MDC with the name Admin and the ID 1. 

To view and manage MDCs: 

1. On the selected device's Device Details page, click the MDC Management link  in the 
Device Management section of the right navigation tree.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views" and "Viewing devices with custom views." 

The MDC Management page opens. 

2. MDC Management includes the following parts: 

 MDC Management—Displays MDCs on a device. You can add MDCs, delete existing 
MDCs, and start or stop non-default MDCs.  

 Group Management—Displays interface groups on a device. Physical interfaces in 
interface groups can be assigned to MDCs.  

 Disk Management—Assigns disk space to MDCs on a device. 

 Memory Management—Assigns memory to MDCs on a device.  

 CPU Management—Assigns CPU weights for MDCs on a device. 

Viewing MDC management details 
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1. On the selected device's Device Details page, click the MDC Management link  in the 
Device Management section of the right navigation tree. 

The MDC Management page opens. 

2. Click the MDC Management tab. 

MDC Management List contents 

 MDC ID—ID of the MDC. The default MDC always uses the ID 1. 

 MDC Name—Name of the MDC. The default MDC always uses the name Admin. 

 Start/Stop—Whether or not the MDC is started: Start or Stop. The default MDC is always 
started. 

 Status—Current state of the MDC: Active, Inactive, Starting, or Stopping. 

 Switch Start/Stop—Click the Switch icon  to switch between Start and Stop. You 
cannot switch from Start to Stop for the default MDC. 

Adding an MDC 

1. Access the MDC Management page. 

2. Click the MDC Management tab. 

3. Click Add. 

4. Enter the name of the MDC. 

5. Click OK. 

Switching between Start and Stop for an MDC 

1. Access the MDC Management page. 

2. Click the MDC Management tab. 

3. Click the Switch icon  to switch between Start and Stop. 

You cannot switch from Start to Stop for the default MDC. 

4. Click OK on the confirmation dialog box that opens. 

Deleting MDCs 

1. Access the MDC Management page. 

2. Click the MDC Management tab. 

3. Select MDCs that you want to delete. 

4. Click Delete. 

Viewing MDC group management details 

1. Access the MDC Management page. 

2. Click the Group Management tab. 

Group Management List 

 Group ID—ID of the MDC group. 

 Port Description—Description of the ports included in the group. The default MDC can use 
any port on the device. 

 MDC Name—Name of the MDC to which the port group belongs. The default MDC always 
uses the name Admin. 

 Modify—Click the Modify icon  to modify the MDC to which the port group belongs. 

Modifying an MDC group 

1. Access the MDC Management page. 

2. Click the Group Management tab. 

3. Click the Modify icon  for the port group you want to modify. 
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The Modify Group page opens. 

4. Select a new MDC from the MDC Name list. 

5. Click OK. 

Viewing MDC disk management details 

1. Access the MDC Management page. 

2. Click the Disk Management tab. 

Disk Management List 

 Slot—Description of the card. 

 Chassis No.—Number of the chassis to which the card belongs. 

 Slot No.—Number of the slot to which the card belongs. 

 MDC Name—Name of the MDC that is authorized to use the card. The default MDC always 
uses the name Admin. 

 Disk Name—Name of the disk in the card. 

 Quota (%)—Maximum percentage of the disk space that MDC can use. 

 Quota (KB)—Maximum amount of the disk space that MDC can use. The value equals the 
total disk size multiplied by Quota (%). 

 Reserved (KB)—Minimum amount of the disk space that must be reserved for the MDC. 

 Used (KB)—Amount of the disk space that is used by the MDC. 

 Available (KB)—Amount of the disk space that is available for the MDC. If the amount of 
the free space is smaller than Quota (KB) minus Used (KB), the amount of the available 
disk space for the MDC is that of the free disk space. If the amount of the free space is larger 
than Quota (KB) minus Used (KB), the amount of the available disk space for the MDC 
equals Quota (KB) minus Used (KB). 

 Modify—Click the Modify icon  to modify the maximum disk space percentage for an 
MDC. 

Modifying the maximum disk space percentage for an MDC 

1. Access the MDC Management page. 

2. Click the Disk Management tab. 

3. Click the Modify icon  for the MDC for which you want to modify the maximum disk space 
percentage. 

The Modify Quota page opens. 

4. Enter a new disk space percentage in the Quota (%) field. 

5. Click OK. 

Viewing MDC memory management detail 

1. Access the MDC Management page. 

2. Click the Memory Management tab. 

Memory Management List 

 Slot—Description of the card. 

 Chassis No.—Number of the chassis to which the card belongs. 

 Slot No.—Number of the slot to which the card belongs. 

 MDC Name—Name of the MDC that is authorized to use the card. The default MDC always 
uses the name Admin. 

 Disk Name—Name of the disk in the card. 

 Quota (%)—Maximum percentage of the memory that MDC can use. 
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 Quota (KB)—Maximum amount of the memory that MDC can use. The value equals the 
total memory size multiplied by Quota (%). 

 Reserved (KB)—Minimum amount of the memory that must be reserved for the MDC. 

 Used (KB)—Amount of the memory that is used by the MDC. 

 Available (KB)—Amount of the memory that is available for the MDC. If the amount of the 
free memory is smaller than Quota (KB) minus Used (KB), the amount of the available 
memory for the MDC is that of the free memory. If the amount of the memory is larger than 
Quota (KB) minus Used (KB), the amount of the available memory for the MDC equals 
Quota (KB) minus Used (KB). 

 Modify—Click the Modify icon  to modify the maximum memory percentage for an 
MDC. 

Modifying the maximum memory percentage for an MDC 

1. Access the MDC Management page. 

2. Click the Memory Management tab. 

3. Click the Modify icon  for the MDC for which you want to modify the maximum memory 
percentage. 

The Modify Quota page opens. 

4. Enter a new memory percentage in the Quota (%) field. 

5. Click OK. 

Viewing MDC CPU management details 

1. Access the MDC Management page. 

2. Click the CPU Management tab. 

CPU Management List contents 

 Slot—Description of the card. 

 Chassis No—Number of the chassis to which the card belongs. 

 Slot No—Number of the slot to which the card belongs. 

 MDC Name—Name of the MDC that is authorized to use the card. The default MDC always 
uses the name Admin. 

 CPU Weight—Weight for the CPU resources that the MDC can use in the card. The system 
allocates CPU resources based on the CPU weights of all MDCs that share the same CPU. 
The default MDC has a CPU weight of 10 in any card. 

 CPU Usage—Percentage of the CPU resources that are used by the MDC in the card. 

 Modify—Click the Modify icon  to modify the CPU weight for an MDC. 

Modifying the CPU weight for an MDC 

1. Access the MDC Management page. 

2. Click the CPU Management tab. 

3. Click the Modify icon  for the MDC for which you want to modify the CPU weight. 

The Modify Weight page opens. 

4. Enter a new CPU weight in the CPU Weight field. 

5. Click OK. 

Port mode switch 

This feature enables you to switch the port mode. The options include Bridge Mode and Route 
mode. 

To switch the port mode: 
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1. On the selected device's Device Details page, click the Port Mode Switch link in the Device 
Management section of the right navigation tree.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views" and "Viewing devices with custom views." 

The Port Mode Switch page opens. 

Port mode switch list 

 Port Description—Contains the port description. 

 Port Mode—Contains the port mode. 

 Is Support—Contains support for switching the port mode. 

 Switch—Contains a link to switch the port mode. 

If the Port Mode Switch List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Port Mode Switch List.  

 Click  to page forward to the end of the Port Mode Switch List. 

 Click  to page backward in the Port Mode Switch List. 

 Click  to page backward to the front of the Port Mode Switch List. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

3. Click the Switch link  for the port whose port mode you want to switch in the Port Mode 
Switch list.  

4. Confirm your operation to switch the port mode. 

Port aggregation 

You can add, modify, and delete port aggregation information for devices. 

To view port aggregation information: 

1. On the selected device's Device Details page, click the Port Aggregation link in the Device 
Management section of the right navigation tree.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views" and "Viewing devices with custom views." 

The Port Aggregation Management page opens. 

Port aggregation list 

 Aggregation ID—Contains the aggregation ID. 

 Aggregation Type—Contains the aggregation type. 

 Aggregation Mode—Contains the aggregation mode. 

 Edit—Contains a link to edit port aggregation information. 

If the Port Aggregation Management List spans multiple pages, use the following aids to 
navigate the list: 

 Click  to page forward in the Port Aggregation Management List. 

 Click  to page forward to the end of the Port Aggregation Management List. 

 Click  to page backward in the Port Aggregation Management List. 

 Click  to page backward to the front of the Port Aggregation Management List. 
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2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

To add a port aggregation entry: 

1. On the selected device's Device Details page, click the Port Aggregation link in the Device 
Management section of the right navigation tree.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views" and "Viewing devices with custom views." 

The Port Aggregation Management page opens. 

2. Click Add to add a port aggregation entry. 

3. Select an aggregation type from the Aggregation Type list. 

4. Enter the aggregation ID in the Aggregation ID field. 

5. Select an aggregation mode from the Aggregation Mode list. 

6. Click OK to add the port aggregation entry. 

To modify port aggregation information: 

1. On the selected device's Device Details page, click the Port Aggregation link in the Device 
Management section of the right navigation tree.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views" and "Viewing devices with custom views." 

The Port Aggregation Management page opens. 

2. Click the Edit link on the Port Aggregation Management list. 

The Port List page opens. 

Port list 

 Aggregation ID—Contains the aggregation ID in the Aggregation ID field. 

 Port Index—Contains the port index in the Port Index field. 

 Port Description—Contains the port description in the Port Description field. 

If the Port List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Port List. 

 Click  to page forward to the end of the Port List. 

 Click  to page backward in the Port List. 

 Click  to page backward to the front of the Port List. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

4. Click Add Port above the Port List.  

5. Select one or more ports in the Please Select Port dialog box. 

6. Do one of the following: 

 Click OK to add the ports.  

 Select one or more ports you want to delete and click Delete. 

7. Click Return to return to the Port Aggregation Management page. 

To delete port aggregation information: 

1. On the selected device's Device Details page, click the Port Aggregation link in the Device 
Management section of the right navigation tree.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views" and "Viewing devices with custom views." 
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The Port Aggregation Management page opens. 

2. Select the aggregation ID you want to delete. 

3. Click Delete. 

4. Click OK to confirm deletion of the selected items. 

PoE management for switches 

IMC offers you a portal for configuring Power over Ethernet for switches.  

From the PoE Energy Management link under Device Management, you can view and configure 
the PoE settings for the selected switch. The information provided in this view includes PoE Power 
Units information and PoE Port Power Consumption information and configuration options.  

To view and configure PoE management settings for the selected device on the Device Details 
page: 

1. On the selected device's Device Details page, click the PoE Energy Management link in the 
Device Management section of the right navigation tree.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views" and "Viewing devices with custom views." 

The PoE Energy Management page opens. 

2. Use the PoE Power Units and PoE Port Power Consumption tabs located at the top of the 
PoE Energy Management page to navigate to the information page you wish you view: 

 Use the PoE Power Units tab to view PoE power units for the selected switch. 

 Use the PoE Port Power Consumption tab to configure PoE port power allocations on a 
per port basis. 

Modifying PoE port power consumption 

1. Click the Modify icon  associated with the port you want to modify. 

2. To enable PoE port power consumption on the selected port, select Enable from the Status list. 

3. Select the priority of the selected port for power allocation from the Port Priority list. 

4. Enter the maximum amount of power, in milliwatts (mW), to be allocated to the selected port 
from the Max Power field.  

The valid range is 0–100000. 

5. Click OK to accept your changes. 

For more information about PoE configurations for the selected switch, see the vendor's switch 
documentation. 

RADIUS server configuration 

To configure the RADIUS server for access devices: 

1. On the selected device's Device Details page, click the RADIUS Server Configuration link in 
the Device Management section of the right navigation tree.  

2. For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views" and "Viewing devices with custom views." 

The RADIUS Server Configuration page opens. The configuration page contains RADIUS 
Authentication Server Configuration, RADIUS Accounting Server Configuration, and 
802.1X Configuration. 

3. RADIUS Authentication Server Configuration: 

a. Enter the scheme name in the Scheme Name field. 

b. Enter the primary server IP address in the Primary Server IP field. 

c. Enter the primary server UDP port number in the Primary Server UDP Port field. By 
default, the UDP port number is 1812. 

d. Enter the second server IP address in the Secondary Server IP field. 
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e. Enter the second server UDP port number in the Second Server UDP Port(1-65535) field. 

f. Enter the shared secret in the Shared Secret field. 

g. Select the service type from the Service Type list. 

h. Select the username format from the Username Format list. 

i. Enter the domain name in the Domain Name field. 

4. RADIUS Accounting Server Configuration: 

a. Enter the primary server IP address in the Primary Server IP field. 

b. Enter the primary server UDP port number in the Primary Server UDP Port(1-65535) field. 
By default, the primary server UDP port number is 1813. 

c. Enter the secondary server IP address in the Secondary Server IP field. 

d. Enter the secondary server UDP port number in the Secondary Server UDP Port(1-65535) 
field. By default, the secondary server UDP port number is 1813. 

5. 802.1X Configuration: 

a. Select the global 802.1X status from the Global 802.1X Status list. 

b. Select the authentication mode from the Authentication Mode list. 

6. Click OK to complete the configuration. 

802.1X interface configuration 

This function allows you to enable or disable 802.1X on interfaces, and remove interfaces for which 
you do not need to change the 802.1X status from the interface list. 

To configure 802.1X interface: 

1. On the selected device's Device Details page, click the Interface 802.1X Configuration link in 
the Device Management section of the right navigation tree.  

For information about navigating to a device's Device Details page, see "Viewing devices with 
Device, IP, and Topology views" and "Viewing devices with custom views." 

The Interface 802.1X configuration page opens. 

Configure interface 802.1X status list 

 Device IP—Contains the device IP address of the interface. 

 Interface Description—Contains the interface description. 

 802.1X Status—Contains the current 802.1X status of the interface. 

 Switch 802.1X Status—Contains the link to change the 802.1X status. 

 Delete—Contains the link to delete the interface that you do not need to change the 802.1X 
status. 

If the Configure Interface 802.1X Status list spans multiple pages, use the following aids to 
navigate the list: 

 Click  to page forward in the Configure Interface 802.1X Status list. 

 Click  to page forward to the end of the Configure Interface 802.1X Status list. 

 Click  to page backward in the Configure Interface 802.1X Status list. 

 Click  to page backward to the front of the Configure Interface 802.1X Status list. 

2. Click Enable 802.1X or Disable 802.1X to enable or disable 802.1X from all interfaces in the 
list. 

Virtual connect 

VC is a network interconnected technology to replace traditional switch connections and 
management. VC reduces network costs in various aspects. For example, it reduces cabling cost 
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and complexity, and allows pre-provision of network assignments. VC also simplifies blade server 
connectivity to production LANs, SANs and converged networks. The VC technology uses an 
abstraction layer between servers and their external networks to virtualize I/O connections, and 
displays network interface (NIC) and host bus adapter (HBA) addresses on LANs and SANs, instead 
of the default physical interface addresses.  

IMC offers virtual connect management, allowing you to configure Ethernet network, FC, FCoE, and 
iSCSI connections and server downlink port mappings. 

To configure virtual connect: 

1. On the selected device's Device Details page, click the Virtual Connect link in the Device 
Management section of the right navigation tree.  

The Virtual Connect window opens. 

2. Click a tab on top of the window to enter the corresponding configuration page. The tabs include 
Ethernet Network Connections, FC SAN Connections, FCoE Connections, iSCSI 
Connections, and Server Port Mappings. 

3. Click Add.  

On the window that opens, you can configure the following parameters: 

 Ethernet Network Connections 

 Profile Name 

 Network 

 PXE 

 Address Type 

 Ethernet MAC 

 iSCSI MAC 

 Speed Type 

 Speed 

 FC SAN Connections 

 Profile Name 

 Fabric 

 Speed 

 Address Type 

 Port WWN 

 Node WWN 

 FCoE Connections 

 Profile Name 

 Fabric 

 Speed 

 Custom Speed 

 WWN Type 

 Port WWN 

 Node WWN 

 MAC Address Type 

 Ethernet MAC 

 iSCSI Connections 

 Profile Name 

 Network 
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 Address Type 

 iSCSI MAC 

 Speed Type 

 Speed 

 Server Port Mappings 

 Profile Name 

 Port Name 

 Network 

 Uplink Set Name 

 VLAN ID 

 Untagged 

4. Click OK. 

5. Do one of the following: 

 To remove an entry, select the entry, and then click Delete. 

 To refresh the page, click Refresh. 

RMON 

IMC supports the ability to configure RMON for network devices that support RMON. From the right 
navigation tree of the Device Details page, you can configure the following RMON groups:  

 Statistics 

 History 

 Alarm 

 Event 

 Extension Alarm 

 Log 

Managing the RMON statistics group 

The RMON Statistics Group provides real-time statistics on LAN traffic.  

Viewing RMON statistics group details 

To view RMON Statistics Group details for the selected device on the Device Details page: 

1. On the selected device's Device Details page, click the RMON link in the Device Management 
section of the right navigation tree. 

2. Click the Statistics Group tab located at the top of the RMON Stat Group page. 

IMC displays all RMON Stat Group entries in the Stat Group list displayed in the main pane of 
the RMON Stat Group page. 

Stat group list 

 Index—Contains unique index values for the associated Statistics Group instance. If a MIB 
object contains more than one entry, indexes are used to uniquely identify each entry. 

 Port—Contains port name/description for the associated interface. 

 Received Bytes—Contains the number of received bytes for the associated interface for 
the most recent polling cycle. 

 Received Packets—Contains the number of received packets for the associated interface 
for the most recent polling cycle. 

 Owner—Contains the name of the owner of the RMON statistics collection that is 
configured when you add the interface to Statistics group collection. 

 Status—Indicates whether or not the Stat Group collection is active for this interface. 
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 Monitor Status—Indicates the status of monitor for this interface. 

 At a Glance—Shows the RMON statistics in the RMON diagram. You can select a time 
range to query the RMON statistics within the specified time range.  

If the RMON Stat Group List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Stat Group List. 

 Click  to page forward to the end of the Stat Group List. 

 Click  to page backward in the Stat Group List. 

 Click  to page backward to the front of the Stat Group List. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

Operators can only view devices to which they have been granted management access. 

Adding RMON statistics group entries 

To add interfaces to the RMON Statistics Group to enable data collection for the selected 
interfaces: 

1. On the selected device's Device Details page, click the RMON link in the Device Management 
section of the right navigation tree.  

2. Click the Statistics Group tab located at the top of the RMON Stat Group page. 

IMC displays all RMON statistics group entries in the Stat Group List displayed in the main 
pane of the RMON Stat Group page. 

3. Click Add. 

4. Select the port or interface for which you want to collect RMON statistics from the Port list. 

5. Enter the name of the person who owns this RMON Statistics Group collection in the Owner 
field. 

6. Click OK.  

Deleting RMON statistics group entries 

To delete interfaces from RMON statistics group collection for the selected device: 

1. On the selected device's Device Details page, click the RMON link in the Device Management 
section of the right navigation tree.  

2. Click the Statistics Group tab located at the top of the RMON Stat Group page.  

IMC displays all RMON stat group entries in the Stat Group List displayed in the main pane of 
the RMON Stat Group page. 

3. Select the ports or interfaces you want to remove from RMON Statistics Group collection. 

4. Click Delete. 

5. Click OK to confirm deletion of the selected interfaces. 

Managing the RMON history group 

The RMON History group defines the sampling configuration for one or more monitored interfaces. 
From the RMON History Group configuration window, you can configure the sampling rate for 
selected interfaces. 

Viewing RMON history group details 

To view RMON History Group details for the selected device: 

1. On the selected device's Device Details page, click the RMON link in the Device Management 
section of the right navigation tree.  

2. Click the History Group tab located at the top of the RMON Stat Group page.  
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IMC displays all RMON History Group entries in the History Group List displayed in the main 
pane of the RMON History Group page. 

History group list fields and explanations 

 Index—Contains unique index values for the associated history collection instance. If a MIB 
object contains more than one entry, indexes are used to uniquely identify each entry.  

 Port—Contains port name/description for the associated interface. 

 Configured Max Samples—Contains the maximum number of samples that are collected 
and retained for viewing for the given metrics. 

 Actual Max Samples—When the Configured Max Samples is less than the max samples 
supported by the device, the Actual Max Samples are the same as the Configured Max 
Samples. When the Configured Max Samples is greater than the max samples supported 
by the device, the Actual Max Samples is the max number supported by the device. 

 Sampling Interval (second)—Contains the amount, in seconds, of time between polls. 

 Owner—Contains the name of the owner of the RMON statistics collection that is 
configured when you add the interface to History Group collection. 

 Status—Indicates whether or not the history collection is active for this interface. 

If the RMON History Group List spans multiple pages, use the following aids to navigate the 
list: 

 Click  to page forward in the History Group list. 

 Click  to page forward to the end of the History Group list. 

 Click  to page backward in the History Group list. 

 Click  to page backward to the front of the History Group list. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

Operators can only view devices to which they have been granted management access. 

Adding RMON history group entries 

To add interfaces to the RMON History Group to enable data collection for the selected interfaces: 

1. On the selected device's Device Details page, click the RMON link in the Device 
Management section of the right navigation tree. 

2. Click the History Group tab located at the top of the RMON Stat Group page. 

IMC displays all RMON history group entries in the History Group List displayed in the main 
pane of the RMON History Group page. 

3. Click Add. 

4. Select the port or interface you want to collect RMON statistics for from the Port list. 

5. Enter the maximum number of samples IMC retains for this interface in the Configured Max 
Samples field. Valid range is 1–65535. 

6. Enter the sampling interval in the Sampling Interval (second) field. Valid range is 1–3600. 

7. Enter the name of the person who owns this RMON History Group collection in the Owner 
field. 

8. Click OK. 

Deleting RMON history group entries 

To delete one or more entries from the RMON History Group for the selected device: 

1. On the selected device's Device Details page, click the RMON History Group link in the 
Device Management section of the right navigation tree. 
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2. Click the History Group tab located at the top of the RMON Stat Group page. 

IMC displays all RMON history group entries in the History Group list displayed in the main 
pane of the RMON History Group page. 

3. Select the ports or interfaces you want to remove from RMON History Group collection. 

4. Click Delete. 

5. Click OK to confirm deletion of the selected interfaces. 

Managing the RMON alarm group 

The RMON Alarm Group defines when SNMP traps are sent based on collection samples that 
exceed defined thresholds. From the RMON Alarm Group configuration window, you can configure 
sampling types and rates as well as rising and falling thresholds for selected interfaces.  

Once a condition is met to generate an SNMP trap, the device forwards the trap to the trap 
destination configured in the SNMP settings on it. For information about configuring the SNMP trap 
destination, see the device vendor's documentation. 

Viewing RMON alarm group details 

To view RMON Alarm Group details for the selected device: 

1. On the selected device's Device Details page, click the RMON link in the Device Management 
section of the right navigation tree. 

2. Click the Alarm Group tab located at the top of the RMON Stat Group page. 

IMC displays all RMON alarm group entries in the Alarm Group list displayed in the main pane 
of the RMON Alarm Group page. 

Alarm group list  

 Index—Contains unique index values for the associated alarm. If a MIB object contains 
more than one entry, indexes are used to uniquely identify each entry.  

 Item—Contains the metric that is measured by this alarm instance. 

 Port—Contains a port name/description for the associated interface. 

 Sampling Type—Identifies whether or not the value of the sample to be measured should 
be evaluated in an absolute sense or in a comparative sense. Absolute sampling measures 
the current sampling value accumulated since the system started up. Comparative 
sampling, also referred to as delta sampling, measures the value by subtracting the last 
absolute sampling value from the current absolute sampling value. The sampling interval is 
also a factor in comparative or delta sampling. Generally, delta or comparative sampling is 
selected. 

 Interval (second)—Contains the amount, in seconds, of time between polls. 

 Current Sampling Value—Contains the value for the most recent sample. 

 Startup Type—Contains the type of threshold being used by the alarm instance. Three 
alarm startup types are available: allowing rising and falling alarms, allowing rising alarms 
and allowing falling alarms. 

 Rising Threshold—Contains the rising threshold value. A rising threshold defines the value 
that the sampled value must exceed in order to generate an alarm. 

 Falling Threshold—Contains the falling threshold value. A falling threshold defines the 
value that the sampled value must fall below in order to generate an alarm. 

 Rising Event Index—Contains the index for a rising event. 

 Falling Event Index—Contains the index for a falling event. 

 Owner—Contains the name of the owner of the RMON statistics collection that is 
configured when you add the interface to Alarm Group collection. 

 Status—Indicates whether or not the alarm instance is active. 

If the RMON Alarm Group list spans multiple pages, use the following aids to navigate the list: 
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 Click  to page forward in the Alarm Group list. 

 Click  to page forward to the end of the Alarm Group list. 

 Click  to page backward in the Alarm Group list. 

 Click  to page backward to the front of the Alarm Group list. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

Operators can only view devices to which they have been granted management access. 

Adding RMON alarm group entries 

To add an alarm instance to the RMON Alarm Group for the selected interfaces on a device: 

1. On the selected device's Device Details page, click the RMON Alarm link in the Device 
Management section of the right navigation tree.  

2. Click the Alarm Group tab located at the top of the RMON Stat Group page.  

IMC displays all RMON alarm group entries in the Alarm Group list displayed in the main pane 
of the RMON Alarm Group page. 

3. Click Add. 

4. Select the metric you want to alarm for from the Item list. 

5. Select the port or interface you want to collect RMON statistics for from the Port list. 

To enable alarming on an interface, you must have configured statistics collection for it. For 
information about configuring an interface for RMON Statistics Group collection, see "RMON." 

6. Select the sampling type you want to use from the Sampling Type list. 

There are two sampling type options: Absolute Value and Comparative Value. Absolute 
sampling measures the current sampling value accumulated since the system started up. 
Comparative sampling also referred to as delta sampling, measures the value by subtracting 
the last absolute sampling value from the current absolute sampling value. The sampling 
interval is also a factor in relative or delta sampling. Typically, delta or comparative sampling is 
selected. 

7. Enter the sampling interval in the Interval (second) field. Valid range is 5-65535. 

8. Do one of the following: 

 Select Yes from the Create Default Event list if you want to create a default event to 
generate an alarm. 

 Select No from the Create Default Event list if you do not want to create a default event to 
generate an alarm. 

9. Enter the rising threshold value in the Rising Threshold field. 

A rising threshold defines the value that the sampled value must exceed in order to generate an 
alarm.  

10. Enter the falling threshold value in the Falling Threshold field. 

A falling threshold defines the value that the sampled value must fall below in order to generate 
an alarm. 

11. Select the rising event index from the Rising Event Index list. 

12. Select the falling event index from the Falling Event Index list. 

You must select No from the Create Default Event list to configure the Rising and Falling 
Event Index settings. 

13. Enter the name of the person who owns this RMON Alarm Group collection in the Owner field. 

14. Click OK.  
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Deleting RMON alarm group entries  

To delete alarm instances from the RMON Alarm Group for the selected device: 

1. On the selected device's Device Details page, click the RMON link in the Device 
Management section of the right navigation tree.  

2. Click the Alarm Group tab located at the top of the RMON Stat Group page.  

IMC displays all RMON alarm group entries in the Alarm Group list displayed in the main pane 
of the RMON Alarm Group page. 

3. Select the alarm instance you want to remove from RMON Alarm Group collection.  

4. Click Delete. 

5. Click OK to confirm deletion of the instances. 

Viewing invalid RMON alarm details 

IMC displays all alarms that returned a null value in the Invalid RMON Alarm table.  

To view RMON invalid alarm details for the selected device: 

1. On the selected device's Device Details page, click the RMON link in the Device Management 
section of the right navigation tree.  

2. Click the Alarm Group tab located at the top of the RMON Alarm Group page.  

3. Click Invalid Item located at the top of the Alarm Group table. 

IMC displays all RMON invalid alarm entries in the Invalid RMON Alarm list on the RMON 
Alarm Group page. 

Alarm group list 

 Index—Contains unique index values for the associated alarm.  

 Item—Contains the metric that is measured by this alarm instance. 

 Port—Contains the port name/description for the associated interface. 

 Sampling Type—Identifies whether or not the value of the sample to be measured should 
be evaluated in an absolute sense or in a comparative sense. Absolute sampling measures 
the current sampling value accumulated since the system started up. Comparative 
sampling, also referred to as delta sampling, measures the value by subtracting the last 
absolute sampling value from the current absolute sampling value. The sampling interval is 
also a factor in comparative or delta sampling. Generally, delta or comparative sampling is 
selected. 

 Interval (second)—Contains the amount, in seconds, of time between polls. 

 Current Sampling Value—Contains the value for the most recent sample. 

 Startup Type—Contains the type of threshold being used by the alarm instance. Three 
alarm startup types are available: allowing rising and falling alarms, allowing rising alarms 
and allowing falling alarms. 

 Rising Threshold—Contains the rising threshold value. A rising threshold defines the value 
that the sampled value must exceed in order to generate an alarm.  

 Falling Threshold—Contains the falling threshold value. A falling threshold defines the 
value that the sampled value must fall below in order to generate an alarm.  

 Rising Event Index—Contains the index for a rising event. 

 Falling Event Index—Contains the index for a falling event. 

 Owner—Contains the name of the owner of the RMON statistics collection that is 
configured when you add the interface to Alarm Group collection. 

 Status—Indicates whether or not the alarm instance is active. 

 Reason for Null—Contains the cause for the null value for the associated alarm group 
entry. 

If the Invalid RMON Alarm list spans multiple pages, use the following aids to navigate the list: 
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 Click  to page forward in the Invalid RMON Alarm list. 

 Click  to page forward to the end of the Invalid RMON Alarm list. 

 Click  to page backward in the Invalid RMON Alarm list. 

 Click  to page backward to the front of the Invalid RMON Alarm list. 

4. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

Operators can only view devices to which they have been granted management access. 

Managing the RMON event group 

The RMON Event Group provides you with the ability to define the events that generate event log 
entries and send SNMP traps to a management workstation. Events can originate from a crossed 
threshold on any RMON variable. 

Viewing RMON event group details 

To view RMON Event Group details for the selected device: 

1. On the selected device's Device Details page, click the RMON link in the Device Management 
section of the right navigation tree.  

2. Click the Event Group tab located at the top of the RMON Stat Group page.  

IMC displays all RMON event group entries in the Event Group list displayed in the main pane 
of the RMON Event Group page. 

RMON event group list 

 Event Index—Contains a unique index for the associated event instance. 

 Description—Contains a description for the event. 

 Type—Identifies the action that is taken by the RMON agent when an event has occurred: 
Log to an event log, send an SNMP trap or both. 

 Trap Community—Contains the community string of the trap destination device. This value 
is included in the trap that is sent to the management station receiving the trap. This value 
must match the Trap community string setting on the management station. 

 Last Trigger Time—Contains the date and time stamp for the last occurrence of an event. 

 Owner—Contains the name of the owner of the RMON statistics collection that is 
configured when you add the interface to Event Group collection. 

 Status—Indicates whether or not the event instance is active. 

If the RMON Event Group list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the RMON Event Group list. 

 Click  to page forward to the end of the RMON Event Group list. 

 Click  to page backward in the RMON Event Group list. 

 Click  to page backward to the front of the RMON Event Group list. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

Operators can only view devices to which they have been granted management access. 

Adding RMON event group entries 

To add event instances for the RMON Event Group for the selected device: 
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1. On the selected device's Device Details page, click the RMON link in the Device Management 
section of the right navigation tree.  

2. Click the Event Group tab located at the top of the RMON Stat Group page.  

IMC displays all RMON event group entries in the RMON Event Group list displayed in the 
main pane of the RMON Event Group page. 

3. Click Add. 

4. Enter a description for this event in the Description field. 

5. Select the action to be taken for this event from the Type list.  

Options include sending a None, Log, SNMP Trap, and Both. 

6. Enter the community string for the management station that receives the traps in the Trap 
Community field. 

The value entered in the Trap Community field must match what is configured on the 
management station that receives the traps. 

7. Enter the name of the person who owns this RMON Event Group collection in the Owner field. 

8. Click OK. 

Deleting RMON event group entries 

To delete event instances from RMON Event Group collection for the selected device: 

1. On the selected device's Device Details page, click the RMON link in the Device 
Management section of the right navigation tree.  

2. Click the Event Group tab located at the top of the RMON Stat Group page.  

IMC displays all RMON Event Group entries in the Event Group list displayed in the main 
pane of the RMON Event Group page. 

3. Select the alarm instance you want to remove from RMON Event Group collection. 

4. Click Delete. 

5. Click OK to confirm deletion of the selected events. 

Viewing the invalid event list details 

IMC provides you with a list of invalid RMON events and the cause for the invalidation.  

To view RMON Invalid Event List details for the selected device: 

1. On the selected device's Device Details page, click the RMON link in the Device Management 
section of the right navigation tree. 

2. Click the Event Group tab located at the top of the RMON Stat Group page. 

3. Click Invalid Item located at the top of the Event Group list. 

IMC displays all RMON invalid event entries in the Invalid Event Item list on the RMON Event 
Group page. 

Invalid event list  

 Event Index—Contains a unique index for the associated event instance.  

 Description—Contains a description for the event. 

 Type—Identifies the action that is taken by the RMON agent when an event has occurred: 
Log to an event log, send an SNMP trap or both. 

 Trap Community—Contains the community string of the trap destination device. This value 
is included in the trap that is sent to the management station receiving the trap. This value 
must match the Trap community string setting on the management station.  

 Last Trigger Time—Contains the date and time stamp for the last occurrence of an event. 

 Owner—Contains the name of the owner of the RMON statistics collection that is 
configured when you add the interface to Event Group collection. 

 Status—Indicates whether or not the event instance is active. 
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 Reason for Null—Indicates the cause for the invalidation of the entry in the Invalid Event 
List. 

If the Invalid Event Item list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Invalid Event Item list. 

 Click  to page forward to the end of the Invalid Event Item list. 

 Click  to page backward in the Invalid Event Item list. 

 Click  to page backward to the front of the Invalid Event Item list. 

4. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

Operators can only view devices to which they have been granted management access. 

Managing the RMON extension alarm group 

The RMON Extension Alarm Group is an extension to the RMON Alarm Group developed by 
HPE, designed to support alarm configuration for a single object as well as for the object expression. 
This group also supports interface configuration and configurations for any valid index instance 
value. With the extension alarm group management, you can add or delete an RMON extension 
alarm group, refresh the data for the current group's view and view invalid RMON extension alarm 
groups. 

Viewing RMON extension alarm group details  

To view RMON Extension Alarm Group details for the selected device: 

1. On the selected device's Device Details page, click the RMON link in the Device Management 
section of the right navigation tree.  

2. Click the Extension Alarm Group tab located at the top of the RMON Stat Group page.  

IMC displays all RMON extension alarm group entries in the Extension Alarm Group list in the 
main pane of the RMON Extension Alarm Group page. 

Extension alarm group list  

 Index—Contains unique index values for the associated alarm. If a MIB object contains 
more than one entry, indexes are used to uniquely identify each entry.  

 Item—Contains the metric that is measured by this alarm instance. 

 Sampling Object Expression—Several formulas composed of OIDs and arithmetic 
expressions are provided in the Extension Alarm Group. Alarms are generated based on 
the results of the operation. 

 Port—Contains port name/description for the associated interface. 

 Alarm Sampling Type—Identifies how the value of the sample to be measured. There are 
three sampling types: absolute, delta, and speed sampling. Absolute sampling measures 
the current sampling value accumulated since the system started up. Delta sampling, also 
referred to as comparative or relative sampling, measures the value by subtracting the last 
absolute sampling value from the current absolute sampling value. Speed sampling refers 
to the delta sampling value per unit of time, that is, the delta sampling value divided by the 
sampling interval. 

 Interval (second)—Contains the amount, in seconds, of time between polls. 

 Alarm Value—Contains the value for the most recent sample. 

 Alarm Startup Type—Contains the type of threshold being used by the alarm instance. 
Three alarm startup types are available: allowing rising and falling alarms, allowing rising 
alarms and allowing falling alarms. 

 Rising Threshold—Contains the rising threshold value. A rising threshold defines the value 
that the sampled value must exceed in order to generate an alarm.  

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 8768



367 

 Falling Threshold—Contains the falling threshold value. A falling threshold defines the 
value that the sampled value must fall below in order to generate an alarm.  

 Rising Event Index—Contains the index for a rising event. 

 Falling Event Index—Contains the index for a falling event. 

 Stat. Type—Contains two statistics period types in the Extension Alarm Group: Permanent 
and Periodic.  

 Selecting a Permanent Stat. Type creates a permanent group with a sampling interval 
that is based on the configured interval. 

 Selecting a Periodic Stat. Type creates a temporary statistical collection group. If 
Periodic is selected, the Stat. Period must be specified (> Interval). The collection 
group disappears after the Stat. Period has expired. 

 Stat. Period—Contains the number of samples IMC must collect for a Periodic Stat. 
Group for the group expires. 

 Owner—Contains the name of the owner of the RMON statistics collection that is 
configured when you add the interface to Extension Alarm Group collection. 

 Status—Indicates whether or not the alarm instance is active. 

If the RMON Extension Alarm Group list spans multiple pages, use the following aids to 
navigate the list: 

 Click  to page forward in the Extension Alarm Group list. 

 Click  to page forward to the end of the Extension Alarm Group list. 

 Click  to page backward in the Extension Alarm Group list. 

 Click  to page backward to the front of the Extension Alarm Group list. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

Operators can only view devices to which they have been granted management access. 

Adding RMON extension alarm group entries 

To add an alarm instance for the RMON Extension Alarm Group for the selected interfaces on a 
device: 

1. On the selected device's Device Details page, click the RMON link in the Device Management 
section of the right navigation tree.  

2. Click the Extension Alarm Group tab located at the top of the RMON Stat Group page. 

IMC displays all RMON extension alarm group entries in the Extension Alarm Group list 
displayed in the main pane of the RMON Extension Alarm Group page. 

3. Click Add. 

4. Select the metric you want to alarm for from the Item list. 

5. Select the port or interface you want to collect RMON statistics for from the Port list. 

6. Select the sampling type you want to use from the Alarm Sampling Type list. 

There are three sampling types: absolute, delta, and speed sampling. Absolute sampling 
measures the current sampling value accumulated since the system started up. Delta sampling, 
also referred to as comparative or relative sampling, measures the value by subtracting the last 
absolute sampling value from the current absolute sampling value. Speed sampling refers to 
the delta sampling value per unit of time, that is, the delta sampling value divided by the 
sampling interval. 

7. Enter the sampling interval in the Interval (second) field.  

The valid range is 10-65535. 
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8. Do one of the following: 

 Select Yes from the Create Default Event list if you want to create a default event. 

 Select No from the Create Default Event list if you do not want to create a default event. 

9. Enter the rising threshold value in the Rising Threshold field.  

A rising threshold defines the value that the sampled value must exceed in order to generate an 
alarm.  

10. Enter the falling threshold value in the Falling Threshold field. 

A falling threshold defines the value that the sampled value must fall below in order to generate 
an alarm. 

11. Select the rising event index from the Rising Event Index list. 

12. Select the falling event index from the Falling Event Index list. 

You must select No from the Create Default Event list to configure the Rising and Falling 
Event Index settings. 

When a value greater than 0 is entered as the Rising Event Index value and 0 is entered as the 
Falling Event Index value, the Alarm Startup Type is a rising alarm. When 0 is entered as the 
Rising Event Index and a value greater than 0 is entered as the Falling Event Index, the 
Alarm Startup Type is a falling alarm. 

13. Select the Stat. Type from the Stat. Type list. There are two statistics period types in the 
Extension Alarm Group: Permanent and Periodic.  

14. Do one of the following: 

 Select Permanent if you want to create a permanent group with a sampling interval that is 
based on the configured interval. 

 Select Periodic if you want to create a temporary statistical collection group. 

The collection group disappears after the Stat. Period interval has expired. 

15. If you selected Periodic in the Stat. Type field, enter the Stat. Period value in the Stat. Period 
field. 

The valid range is 0-2147483647. 

16. Enter the name of the person who owns this RMON Extension Alarm Group collection in the 
Owner field. 

17. Click OK. 

Deleting RMON extension alarm group entries 

To delete alarm instances from the RMON Extension Alarm Group for the selected device: 

1. On the selected device's Device Details page, click the RMON link in the Device Management 
section of the right navigation tree. 

2. Click the Extension Alarm Group tab located at the top of the RMON Stat Group page.  

IMC displays all RMON extension alarm group entries in the Extension Alarm Group list in the 
main pane of the RMON Extension Alarm Group page. 

3. Select the alarm instance you want to remove from RMON Extension Alarm Group collection. 

4. Click Delete. 

5. Click OK to confirm deletion of the selected interfaces. 

Managing the RMON log 

The RMON Log enables you to view log entries that are triggered by events configured in the RMON 
MIB in the Alarm Group and the Extension Alarm Group. 

Viewing RMON log details 

To view the RMON Log details for the selected device: 

1. On the selected device's Device Details page, click the RMON link in the Device Management 
section of the right navigation tree.  
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2. Click the Log tab located at the top of the RMON Stat page. 

IMC displays all RMON log entries in the Log list in the main pane of the RMON Log page. 

Log list fields and explanations 

 Event Index—Contains a unique index value for the event associated with the log entry. 

 Log Index—Contains a unique index value for the log entry. 

 Log Time—Contains a date and time stamp for the log entry. 

 Log Description—Contains information about the event. 

If the RMON Log Group list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Log list. 

 Click  to page forward to the end of the Log list. 

 Click  to page backward in the Log list. 

 Click  to page backward to the front of the Log list. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

You can only view devices and their components to which you have been granted management 
access. 

Protocol Management 

IMC provides you with visibility into various protocol information and configuration settings. The 
menu varies with the protocols supported by the device. 

RIP browsing for routers 

From the RIP link under Protocol Management, you can view RIP information for the selected 
router. The information provided in this view includes RIP Interface Configuration, RIP Interface 
Statistics and RIP Peer Information.  

To access RIP browsing from the Device Details page: 

1. On the selected device's Device Details page, click the RIP link in the Protocol Management 
section of the right navigation tree. 

2. Use the RIP Interface Configuration, RIP Interface Statistics and RIP Peer Information 
tabs located at the top of the RIP page to navigate to the information page you wish you view. 

BGP browsing for routers 

From the BGP link under Protocol Management, you can view BGP information for the selected 
router. The information provided in this view includes BGP Attribute, Basic Information, Statistic 
Information, Time Attribute, BGP4 Path Information.  

To access BGP browsing from the Device Details page: 

1. On the selected device's Device Details page, click the BGP link in the Protocol Management 
section of the right navigation tree. 

2. Use the BGP Attribute, Basic Information, Statistic Information, Time Attribute, BGP4 
Path Information tabs located at the top of the BGP page to navigate to the information page 
you wish you view. 

OSPF browsing for routers 

From the OSPF link under Protocol Management, you can view OSPF information for the selected 
router. The information provided in this view includes OSPF Attribute, Area Information, Stub 
Area Information, LSDB Information, Extended LSDB Information, OSPF Interface, Interface 
TOS Metric, Peer Information, Virtual Link Interface and Virtual Link Peer information.  
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To access OSPF browsing from the Device Details page: 

1. On the selected device's Device Details page, click the OSPF link in the Protocol 
Management section of the right navigation tree. 

2. Use the OSPF Attribute, Area Information, Stub Area Information, LSDB Information, 
Extended LSDB Information, OSPF Interface, Interface TOS Metric, Peer Information, 
Virtual Link Interface and Virtual Link Peer tabs located at the top of the OSPF page to 
navigate to the desired information page. 

Managing MSTP options for routers and switches 

IMC provides you with the ability to configure Multiple Spanning Tree Protocol (MSTP) options for 
both routers and switches. From the MSTP link under Protocol Management, you can configure the 
MSTP options for the selected router or switch. 

Configuring global MSTP settings 

To configure Global MSTP settings for a network device: 

1. On the selected device's Device Details page, click the MSTP link in the Protocol 
Management section of the right navigation tree. 

2. Click the Global MSTP tab located at the top of the page to navigate to the Global MSTP page. 

3. To enable MSTP on the selected switch or router, select Enable from the MSTP Status list. 

4. Select the Spanning Tree Protocol version you want to apply to this device from the MSTP 
Type list. Options include STP, RSTP, and MSTP. 

STP BPDUs and RSTP BPDUs can be recognized and used for spanning tree calculation on 
MSTP-enabled switches. 

5. Enter the Spanning Tree diameter in the Diameter field. A valid range for diameter is 2-7. 

This option configures the network diameter of a switched network. The network diameter 
parameter indicates the size of a network. The bigger the network diameter is, the larger the 
network size is.  

6. Enter the maximum number of hops in the Max Hops field. 

The value of maximum hops limits the size of the MST region. The maximum hop count 
configured on the region root also acts as the maximum hop count of the MST region. The 
larger the maximum hop count of an MST region is, the larger the scale of the MST region is. 
The scale of an MST region can be limited only when the maximum hop count is configured for 
the root switch of the MST region. Other switches in the MST region adopt the configuration on 
the region root, even if the switch configuration is different. 

7. If you want to enable BPDU protection, select Enable from the BPDU Protection list. 

For access layer devices, the access port is usually connected to the user terminal (such as 
PC) or the file server. In this case, the access port is configured as an edge port to implement 
fast migration. When these ports receive BPDUs, the system automatically configures these 
ports as non-edge ports and re-calculates the spanning tree, causing network topology 
instability. Under normal conditions, these ports should not receive STP BPDUs. If someone 
forges BPDUs maliciously to attack the switch, network topology instability occurs. You can 
prevent these types of attacks by utilizing the BPDU guard function. This configuration item can 
be Enable or Disable. By default, BPDU guard is disabled on a switch. 

8. If needed, modify the name for the STP admin region in the Admin Region Name field. 

By default, the MST region name is the first MAC address of the MST region switch.  

9. If needed, modify the admin revision level in the Admin Revision Level field.  

The valid range is 0-65535. All VLANs in the MST region belong to spanning tree instance 0, 
and the revision level of the MST region is 0. 

10. Click Config to accept any changes you have made to the Global MSTP settings. 

a. Click Apply to apply the existing global MSTP settings. 

b. Click Default VLAN to reset the VLANs to their default settings, which configures all VLANs 
to spanning tree instance 0. 
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c. Click Default Region to reset the region parameters to their default settings. This restores 
the MST region name to its default. 

d. When you configure the parameters related to the MST region, especially the 
VLAN-to-instance mapping table, network topology instability can result. To reduce such 
instability caused by configuration changes, MSTP does not immediately trigger the 
re-calculation of the spanning tree upon processing the region-related configurations. The 
region-related configurations take effect only when MSTP is enabled. 

e. Click Close when you have finished configuring the Global MSTP settings. 

For more information about configuring Spanning Tree, see your switch vendor's 
documentation. 

Modifying MSTI settings 

To modify the configuration of Multiple Spanning Tree Instance (MSTI) settings: 

1. On the selected device's Device Details page, click the MSTP link in the Protocol 
Management section of the right navigation tree. 

2. Click the MSTI tab located at the top of the page to navigate to the MSTI page. 

3. Locate the MSTI instance you want to modify from the list provided. 

4. Click the Modify icon  associated with the instance you want to modify. 

5. Select the bridge priority for this instance from the Priority list. 

The priority of a bridge determines whether or not the bridge can be elected as the root of the 
spanning tree. You can force a specific switch to act as the root bridge by setting a low value for 
the bridge priority for the switch. An MSTP-enabled switch may have different bridge priorities in 
different spanning tree instances. The bridge priority of a switch is 32768 by default. 

6. Select the root type for this instance from the Root Type list. 

Configuring the network bridge root type assigns priority to the switch for the purposes of 
determining the root bridge. The root type can be Normal, Secondary, or Primary. Normal 
sets the priority to 32768, Primary sets the priority to 0, and Secondary sets the priority to 
4096. A bridge with a lower priority value is more likely to be elected as the root bridge. By 
default, the role of a bridge is Normal. 

When the Root Type is set to Primary or Secondary, the bridge Priority cannot be set. 

7. Enter the Admin VLAN ID for this instance in the Admin VLAN ID field. You can enter more 
than one VLAN ID. Separate each VLAN ID with a comma (,). You can also enter VLAN IDs by 
range, using a dash (-) between the beginning and ending of the VLAN ID range. 

Admin VLAN ID is used to tie an MSTI to a specific VLAN. The configured VLAN-to-instance 
mapping does not take effect until MSTP is enabled. 

8. Click OK to accept your changes.  

9. Click Close to close the MSTI window. 

For more information about configuring the Spanning Tree feature, see your switch vendor's 
documentation. 

Modifying port MSTP settings 

To modify port configuration of the Multiple Spanning Tree Protocol (MSTP) settings: 

1. On the selected device's Device Details page, click the MSTP link in the Protocol 
Management section of the right navigation tree. 

2. Click the Port MSTP tab located at the top of the page to navigate to the Port MSTP page. 

3. Locate the port you want to modify the MSTP settings for from the list provided. 

4. Click the Modify icon  associated with the instance you want to modify. 

5. Select the port priority for the selected port from the Priority list. 

The priority of a port is an important factor in determining whether the port can be elected as the 
root port of a device during the spanning tree calculation process. If all other conditions are 
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equal, the port with the highest priority is elected as the root port. On an MSTP-enabled device, 
a port can have different priorities in different MSTIs, and the same port can play different roles 
in different MSTIs, so that data of different VLANs can be propagated along different physical 
paths, thus implementing per-VLAN load balancing. When the priority of a port is changed, 
MSTP re-computes the role of the port and initiates a state transition. Generally, a configured 
lower priority value indicates a higher priority of the port. If all the ports of a switch have the 
same port priority value, the port priorities are determined by the port indexes. You can set port 
priority values based on the actual networking requirements. The default port priority is 128. 

6. Enter the path cost to the root bridge in the Path Cost to Root Bridge field. 

The Path Cost to Root Bridge parameter is related to the rate of port-connected links. On a 
switch supporting MSTP, the port may have varying path costs in different spanning tree 
instances so that traffic from different VLANs can be forwarded along different physical links to 
implement per-VLAN load sharing. By default, MSTP calculates the path cost of each port. 

7. To enable CIST Edge Port, select Enable from the CIST Edge Port field. 

The CIST Edge Port option is only applicable when the MSTI is a CIST. Edge port indicates 
that the port is neither directly connected to any switch nor indirectly connected to any switch 
through the port-connected network. When the operator specifies one port as the edge port and 
when the port migrates from the congestion state to the forwarding state, fast migration can be 
implemented without any delay. The user can only configure the port connecting the terminal as 
the edge port. If BPDUs from other ports are received on the edge port, the port becomes a 
non-edge port again. This parameter is valid for all spanning tree instances. In other words, 
when the port is configured as an edge port or non-edge port, the port is configured as an edge 
port or non-edge port on the CIST and all MSTIs. When the port receives BPDUs, the port 
actually operates as a non-edge port even it if is configured as the edge port by the operator. By 
default, all Ethernet ports of a switch are non-edge ports. 

8. Select the CIST Port Point-to-Point configuration from the CIST Port Point-to-Point list. 

Point-to-Point link generally refers to the link between switches. The two ports in a point-to-point 
link can be quickly migrated to the forwarding state by transmitting synchronous packets, thus 
reducing forwarding delay. If this option is configured for automatic mode, MSTP can 
automatically detect whether the current Ethernet port is connected to a point-to-point link. For 
an aggregation port, only the link type of the aggregation group can be configured as 
point-to-point. If a port operates in the auto-negotiation mode and the negotiated operation 
mode is the full duplex mode, the link type of the port can be configured as point-to-point. The 
configuration is valid for the CIST and all MSTIs. If the actual physical link of a port is not a 
point-to-point link and you forcibly configure the link as a point-to-point link, temporary loops 
may occur. By default, this parameter is auto. 

9. Enter the value for transmission limit for this port in the Trans Limit field.  

The Trans Limit option is related to the physical state and the network structure of the port. 
You can configure the maximum transmitting rate as needed. The larger the Trans Limit 
setting, the more packets are sent per unit time, consequently consuming more network 
bandwidth and resources. As a best practice, use the default setting. By default, the maximum 
transmission rate for all Ethernet ports on a switch is 10. 

10. To disable a port's participation in spanning tree calculations, select Disable from the Port 
MSTP Status field to reduce CPU utilization on the switch.  

11. To enable root bridge protection, select Enable from the Root Protection list. 

The root switch and backup switch of the spanning tree should be located in the same region, 
especially the root switch and backup switch of the CIST. Generally, the root switch and backup 
switch of the CIST is placed in the core region of high bandwidth upon network design. 
Sometimes, due to device configuration errors or malicious attacks by users, the current valid 
root switch may receive configuration messages with a higher priority. When this occurs, the 
current root switch loses its status as the root switch. This causes an invalid change of the 
network topology structure. Such invalid changes may cause traffic, which should be 
transmitted over the high-speed link, to be transmitted over the low-speed link, resulting in 
network congestion. You can avoid this problem by enabling the root guard function. For a port 
configured with the root guard function, it can only be the designated port. Once this port 
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receives BPDUs with a higher priority, it is selected as a non-designated port and enters the 
discarding state and no longer forwards packets. When the priority of the received BPDUs is 
lower than that of the local BPDUs, the port automatically migrates from the listening state, 
through the intermediate state, to the normal forwarding state. The root guard function is 
disabled by default. 

12. Click OK. 

For more information about configuring Spanning Tree, see your switch vendor's 
documentation. 

Forcing port migration to MSTP mode 

From the Port MSTP window, you can force a switch port to operate in MSTP mode. Ports on an 
MSTP-enabled switch can operate in STP-compatible mode or MSTP mode. In a switched network, 
if a port on the device running MSTP connects to a device running STP, this port automatically 
migrates to the STP-compatible mode. If the device running STP is removed, this cannot migrate 
automatically to the MSTP mode, but remains working in the STP-compatible mode.  

To force a port to migrate to MSTP mode: 

1. On the selected device's Device Details page, click the MSTP link in the Protocol 
Management section of the right navigation tree. 

2. Click the Port MSTP tab located at the top of the page to navigate to the Port MSTP page. 

3. Locate the port you want to modify the MSTP settings for from the list provided.  

4. Click the Configure icon  in the Mcheck field associated with the instance you want to 
modify. 

5. Click OK to confirm this configuration change. 

Clearing MSTP statistics entries 

To clear the MSTP statistics entries: 

1. On the selected device's Device Details page, click the MSTP link in the Protocol 
Management section of the right navigation tree.  

2. Click the Port MSTP tab located at the top of the page to navigate to the Port MSTP page. 

3. Locate the port you want to clear statistics for from the list provided. 

4. Click the Configure icon  in the Clear Statistics field associated with the instance for which 
you want to clear statistics. 

5. Click OK to confirm clearing the statistics for the selected port. 

Restoring default settings for path cost 

From the Port MSTP window, you can also restore the default settings for path cost of each port. 

1. On the selected device's Device Details page, click the MSTP link in the Protocol 
Management section of the right navigation tree. 

2. Click the Port MSTP tab located at the top of the page to navigate to the Port MSTP page. 

3. Locate the port you want to modify the MSTP settings for from the list provided. 

4. Click the Configure icon  in the Default Port Cost field associated with the instance to which 
you want to restore default settings . 

5. Click OK to confirm this configuration change. 

IGMP snooping 

IMC provides you with the ability to configure IGMP Snooping options for devices.  

To configure IGMP Snooping settings: 

1. On the selected device's Device Details page, click the IGMP Snooping configuration link in 
the Protocol Management section of the right navigation tree. 

The IGMP Snooping Configuration page opens. 
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2. To enable IGMP Snooping on the selected wireless device, select Enable from the IGMP 
Snooping Status list. 

3. Enter the aging time of the router port in seconds in the Aging Time of Router Port field. 

The routing port should be deleted from all port members of the MAC multicast group if IGMP 
general queries are not received within the aging time of routing port. By default, the aging time 
of a routing port is 105 seconds. 

4. Enter the maximum response time for queries in the Maximum Response Time of Query 
field. 

If no IGMP reports are received within the query response time, the port is removed from the 
multicast member ports. By default, the maximum response time to IGMP queries is 10 
seconds. 

5. Enter the aging time for the multicast port in the Aging Time of multicast Port field. 

If no multicast report is received on a port within the aging time of the port, group-specific 
queries are sent to the port. By default, the aging time of a multicast port is 260 seconds. 

6. Click OK to confirm the IGMP settings. 

IGMP snooping and GMRP are mutually exclusive. You cannot enable IGMP snooping while 
GMRP is enabled. 

VLAN management 

IMC provides you with the ability to configure VLAN on managed devices. The VLAN Management 
menu options are the shortcuts to the VLAN Management > VLAN Devices menu options located 
on the left navigation tree under the Service tab. For more information about configuring VLAN for a 
specific device, see "VLAN device management." 

Accessing the interface list and interface details page 
From the Device Details page, you can navigate to the Interface Details page. On the Interface 
Details page, you can view interface information including status and speed as well as perform 
interface related actions.  

There are many ways to access the Interface List. The most straightforward way to access the 
Interface Details page is through the individual device's Device Details page.  

To access the Interface List and Interface Details page: 

1. Navigate to Resource > Device Name > Interface List. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click View Management on the left navigation tree. 

c. Click Device View under View Management on the left navigation tree. 

The Device List – All is displayed, listing all devices in IMC. 

2. Locate the device you want to view interface details for and click the link in the Device Label 
column in the Device List for the device for which you want to view interface details. 

The Device Details page opens. 

3. Click the Interface List link in the Interfaces field of the Device Details section for the selected 
device. 

The Interface List is displayed, with all interfaces for the selected device shown in the main 
pane of the page. 

Interface list 

 Interface Status—Contains an active icon indicating the current up/down status for the 
associated interface. 

 Interface Description—Contains a description of the associated interface. The entry in the 
description field serves as a link to the Interface Details page. 
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 Interface Alias—Contains the name of the interface that has been configured on the 
device. For information about configuring interface alias, see the vendor's documentation. 

 Last Change—Contains the time when the interface status was last changed (for example, 
plugging/unplugging the network cable). 

 Media Type—Contains the media type for the associated interface. 

 Interface IP—Contains the IP address for the associated interface. 

 Up/Down Alarm Filter—Contains the interface up/down alarm filter setting of the 
associated interface: Filter, No Filter, or System Settings (see "System settings"). For 
more information about setting an interface up/down alarm filter, see "Using batch mode to 
modify interface up/down alarm filter." 

 Interface Link Type—Contains the link type of the associated interface. This parameter 
identifies the type of the peer device to which the interface connects. If the interface is not 
connected to any peer device, this field displays Idle Interface. 

If the Interface Group list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Interface List. 

 Click  to page forward to the end of the Interface List. 

 Click  to page backward in the Interface List. 

 Click  to page backward to the front of the Interface List. 

4. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

Operators can only view devices to which they have been granted management access. 

5. To access the Interface Details page, click the link in the Interface Description field for the 
interface for which you want to view details. 

The Interface Details page opens. 

Interface details page 

The Interface Details page provides you with quick and easy access to important interface 
information as well as links to interface configuration options.  

The Interface Details section provides the following information on the selected interface. 

Interface details page 

 Interface Index—Contains the unique index value for the associated interface. 

 Interface Type—Identifies the type of interface as defined by its physical/link protocol.  

 Interface Description—Provides a description for the interface. 

 Management Status—Contains an active icon denoting the current management status for the 
interface. 

 Operational Status—Contains an active icon denoting the current operational status for the 
associated interface. 

 Media Type—Contains the media type for the associated interface. 

 Speed (bps)—Contains the speed, in bits per second of the associated interface. 

 User-Defined Speed (bps)—Contains the user-defined speed, in bits per second of the 
interface. 

 Interface Alias—Contains the name of the interface that has been configured on the device. 
For information about configuring interface alias, see the vendor's documentation. 

 MAC Address—Contains the MAC address for the associated interface. 

 MTU—Contains the maximum size of IP packets processed by this interface. 
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 Last Change—Contains the time when the interface status was last changed (for example, 
plug/unplug the network cable). 

 Interface Up/Down Alarm Filter—Identifies whether or not there are system defined or user 
defined filters in place for filtering out Interface up and down traps for the selected interface. 

 Duplex Mode—Contains the duplex mode of the associated interface: Half, Auto, or Full. 

 IP Address/Mask—Contains the IP address and subnet mask for the interface. 

Performance monitor 

On the Interface Details page, you can access the Performance Monitor. This feature provides 
you with a quick snapshot of the performance metrics for the selected interface from which you can 
view the most current performance statistics.  

Scroll down to the section of the Interface Details page titled Performance Monitor to view the 
most recent performance metrics.  

IMC displays performance metrics in a table that contains the fields listed below. 

 Monitor Index—Contains the performance metric for which the interface is being monitored. 

 Monitored Value—Contains the most recent polled value for the performance metric. 

 Operation—This field contains the Start/Stop Monitor option. 

To modify display indexes for the performance monitors in the Performance Monitor list: 

1. From the Interface Details page, click Modify Display Index in the Performance Monitor 
area. 

The display index dialog box opens and displays all monitoring indexes that are in the 
Performance Monitor list.  

The Performance Monitor list only displays the monitoring data of the added indexes instead 
of all indexes. 

2. Modify display indexes by performing the following tasks: 

 To add display indexes, click Add, select display indexes and set the time range in the 
dialog box that opens, and then click OK. The Performance Monitor list supports a 
maximum of 20 display indexes for an interface. 

Adding display indexes displays the data of the selected display indexes in the 
Performance Monitor list instead of adding monitoring instances for performance data 
collection. For the Performance Monitor list to display the data of a display index, make 
sure the respective monitoring instance of the display index has existed. 

 To delete a display index, click the Delete icon  for the display index. If you want to delete 
all display indexes, click Delete All. 

 To modify the time range for a display index, click the Modify icon  for the display index, 
set a time range in the dialog box that opens, and then click OK.  

3. Click Close. 

Interface details right navigation tree 

The Interface Details page provides quick and easy access to configuration and management tasks 
for the selected interface. 

Actions 

The Action menu options enable you to apply management and configuration options to the 
selected interface from the convenience of the navigation tree located on the right of the Interface 
Details section. 

Synchronize 

With the Synchronize option, you can update IMC's data on the selected interface. When an 
operator uses the Synchronize option, IMC queries the selected device for information about the 
selected interface and then updates the Interface Details page with any updated information.  
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To synchronize the selected interface from the Interface Details page, select Synchronize from the 
Action menu. The top of the Interface Details page updates to reflect the initiation of the 
synchronization process. Refresh this page using the Refresh option on the right navigation tree to 
view any updates to device data.  

Refresh 

With the Refresh option, you can reload the current Interface Details page and capture any 
updates to the interface details or other dynamic data found on this page. This feature is particularly 
useful when you use the Synchronize option to query the selected interface for updated information.  

To refresh the selected device, select Refresh from the Action menu. 

Unmanage 

You can select to unmanage an interface. This feature is particularly useful for those interfaces that 
are either not in use or not significant enough to warrant monitoring them.  

To unmanage the selected interface from the Interface Details page, select Unmanage from the 
Action menu. 

The top of the Interface Details page updates to reflect the completion status of the unmanage task. 
Refresh this page using the Refresh option on the right navigation tree to view any updates to 
interface data. 

The Manage/Unmanage option is a toggle switch between these two states: 

 Manage means that the interface is currently unmanaged.  

 Unmanage means that the interface is currently managed. 

UP 

To change the management status of the selected interface to UP, select UP from the Action menu. 
The top of the Interface Details page updates to reflect the completion status of the task. 

DOWN 

To change the management status of the selected interface to DOWN, select DOWN from the 
Action menu. 

The top of the Interface Details page updates to reflect the completion status of the task. 

User-Defined Speed 

To change the user-defined speed setting for the selected interface: 

1. On the selected interface's Interface Details page, select User-Defined Speed from the 
Action menu. 

2. Enter the speed you want to assign to this interface in the User-Defined Speed field.  

3. Select the unit of speed measurement from the list located next to the User-Defined Speed 
field. 

4. Click OK. 

If you leave the User-defined Speed field blank, the value of N/A is applied. 

The top of the Interface Details page updates to reflect the completion status of the task. In 
addition, the User-Defined Speed field updates to include the configuration change. 

Up/Down Alarm Filter 

To change the status of the up/down alarm filter of the selected interface: 

1. On the selected interface's Interface Details page, select Up/Down Alarm Filter from the 
Action menu. 

The Interface Up/Down Alarm Filter page opens. 

2. Select the status of up/down alarm filter you want to perform from the Interface Up/Down 
Alarm Filter list.  

For more information about System Settings, see "System settings." 
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3. Click OK. 

View Topology 

The topology location feature allows administrators to quickly locate an interface in the topology. 

To  locate an interface in a topology: 

1. On the selected interface's Interface Details page, click the View Topology link in the Action 
section of the right navigation tree.  

The Select Topology page opens. 

2. Select the topology that you want to view from the topology list.  

3. Click OK to open the selected topology. The link that uses the interface is selected. If no link 
uses the interface, the device where the interface resides is selected.  

IP/MAC Learning Query 

For information about IP/MAC learning query, see "Actions - For switches." 

Interface management 

The Interface Management menu options enable you to apply management and configuration 
options to the selected interface from the navigation tree located on the right of the Interface Details 
section. The menu options available for Interface Management vary by device and interface type. 

Loopback testing 

To test the loopback interface for the selected device: 

1. On the selected interface's Interface Details page, select Loopback Testing from the 
Interface Management menu. 

The Loopback Test page opens. 

2. Click the Port Loopback Test tab. 

3. Select the type of loopback test you want to perform from the Test Type list: 

 An internal test tests the reachability of the Loopback interface from an interface on the 
device itself. 

 An external test tests the reachability of the loopback interface from the IMC server. 

4. Click OK. 

The Loopback Test page updates with the results of the loopback test. 

Interface IP management 

To configure the IP address for the selected interface: 

1. On the selected interface's Interface Details page, select Interface IP from the Interface 
Management menu. 

2. Click Add. 

3. Enter the IP address in the IP Address field. 

4. Enter the mask in the Mask field. 

5. Select the type of the IP address in the Type field. 

6. Click OK. 

Modify VLAN 

To modify the VLAN configurations for the selected interface: 

1. On the selected interface's Interface Details page, select Modify VLAN from the Interface 
Management menu. 

The Modify VLAN page opens. 

2. From the Port Type list, select the link type of the port. Options include Access, Trunk, and 
Hybrid.  
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3. Enter the PVID of the current interface in the PVID field. 

The range is 1 to 4094. 

4. Enter VLAN IDs in the Allowed VLAN field to allow packets with the specified VLAN tags to 
pass through the current interface. 

Use a hyphen (-) to specify a VLAN ID range, such as 1-10. Separate VLAN IDs and/or VLAN 
ID ranges by commas (,), such as 1-10, 12, 14-20. This option is available only when Trunk is 
selected from the Port Type list. 

5. Enter VLAN IDs in the Tagged VLAN field. The current interface directly forwards packets that 
carry the specified VLAN tags without processing the tags. 

Use a hyphen (-) to specify a VLAN ID range, such as 1-10. Separate VLAN IDs and/or VLAN 
ID ranges by commas (,), such as 1-10, 12, 14-20. This option is available only when Hybrid is 
selected from the Port Type list. 

6. Enter VLAN IDs in the Untagged VLAN field. The current interface forwards packets that carry 
the specified VLAN tags after removing the tags. 

Use a hyphen (-) to specify a VLAN ID range, such as 1-10. Separate VLAN IDs and/or VLAN 
ID ranges by commas (,), such as 1-10, 12, 14-20. This option is available only when Hybrid is 
selected from the Port Type list. 

7. Click OK. 

Port properties 

On the Interface Details page, you can view information for the selected interface. You can also 
configure the selected interface on the Port Properties page. Menu options for Port Properties 
vary by device as well as by interface.  

To view port information and to configure an Ethernet or Gigabit Ethernet port: 

1. On the selected interface's Interface Details page, select Port Properties from the Interface 
Management menu. 

2. On the Port Properties page that opens, do the following: 

a. Enter a name for the interface in the Port Alias field. The value is a string of 1 to 64 
characters. 

b. Select the administrative status for this port from the Administrative Status list. 

c. Select the port priority from the Port Priority list. 

d. Select the speed of the port from the Configured Rate list. 

e. Select the broadcast suppression type from the Broadcast Suppression Type list. 

f. Enter the broadcast suppression value in the Broadcast Suppression field. 

g. Select the duplex mode for this interface from the Configured Duplex Mode list. 

h. Enable or disable flow control from the Flow Control Status list. To enable flow control, 
select True. To disable flow control, select False. 

i. Select the link type from the Link Type list. Options include Trunk, Access, Hybrid, and 
Fabric. 

j. Select the MDI mode from the MDI Mode list. Options include Normal, Across, and Auto. 

3. Click OK to accept your changes. 

When configuring a VLAN interface, you only need to configure Port Alias and Administrative 
Status. 

Only Comware devices support all parameters in this configuration procedure. For other devices, the 
supported parameters vary with the device model. For more information about the configuration 
parameters available on the Port Properties page, see your switch vendor's documentation.  

Performance Monitor 

To monitor the performance indexes for the interface in real time: 
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1. On the selected interface's Interface Details page, select Performance Monitor from the 
Interface Management menu. 

2. Click Add to select one or more monitor indexes.  

The system automatically selects Interface Receiving Rate, Interface Transmitting Rate, 
Interface Inbound Bandwidth Usage, and Interface Outbound Bandwidth Usage as the 
default monitor indexes and the current interface as the monitor object for each index. 

3. Select the instances you want to monitor. 

4. Click OK to add the interface real-time monitor. 

Interface Alarms 

To view all alarms on the selected interface, select View Interface Alarms from the Interface 
Alarms menu. The All Alarm page opens. The interface alarm query criteria are automatically 
displayed in the query criteria area, and all alarms on the interface are displayed on the interface. 

Managing multiple devices using batch operations 
Batch Operations allow you to streamline repetitive administrative tasks by applying a single 
configuration to one or more devices. Configuring devices using batch operations reduces the 
amount of time and effort involved in managing network resources.  

IMC provides batch mode support for administrative tasks including configuring SNMP, Telnet, and 
SSH settings, configuring status and configuration of polling intervals, and changing login types. 
Using batch mode, you can also check Telnet and SSH settings and perform network device 
configuration tasks including saving device configuration, rebooting devices, applying energy saving 
policies, configuring trap destinations, configuring STP and LACP, and deploying VLANs to devices 
and interfaces. 

Using batch mode to configure SNMP settings 
You can use the IMC batch mode feature to update IMC's SNMP configuration for one or more 
devices within IMC but it does not modify the SNMP settings on the device itself.  

To add or modify IMC's SNMP settings for one or more devices in batch mode: 

1. Navigate to Resource > Batch Operation > SNMP Settings. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click the Batch Operation link under Resource Management on the left navigation tree. 

d. Click the SNMP Settings link from the NMS Parameter Configuration section of the 
Resource > Batch Operation page. 

2. Click Add to select the devices to which you want to apply the SNMP settings in the SNMP 
Settings window. 

You can add devices by using either the View or Advanced query option. See "Adding devices 
by view" and "Adding devices by advanced query."  

3. To configure the SNMP settings for selected devices, click the Configuration icon . 

The SNMP Parameters dialog box opens. 

You can either enter the SNMP settings in this dialog box or you can select an existing SNMP 
template that contains the SNMP settings for this device. SNMP templates are particularly 
useful when SNMP configurations are standardized. For more information about creating 
SNMP templates, see "SNMP templates." 

Editing SNMP settings manually 

1. To edit the SNMP parameters, verify that Edit SNMP Parameters is selected. 
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2. Select the version of SNMP (v1 or v2c) that is configured on the device to be added from the 
Parameter Type list. 

You can only add devices that are configured with SNMPv3 using SNMP templates. You must 
create an SNMP template with the SNMPv3 parameters for this device before adding this 
device. For more information about creating SNMP templates, see "SNMP templates." 

3. Enter the read-only community string in the Read-Only Community String field. 

4. Enter the read-write community string in the Read-Write Community String field. 

5. Enter the SNMP timeout value (1–60 seconds) in the Timeout field.  

This parameter determines how long IMC waits for an SNMP reply from the managed device 
before declaring that the request has timed out. The default is 4. 

6. Enter the number of SNMP retries (1–20) in the Retries field. 

The retries parameter defines how many times the management system (IMC) sends SNMP 
retries in an attempt to communicate with the managed device before reporting a failure. The 
default is 3. 

Using existing SNMP templates 

1. To configure the SNMP settings for this device using an SNMP template, select Select an 
Existing Template. 

2. Select an SNMP template. 

3. Click OK. 

4. Click OK to apply the SNMP configuration settings to the selected devices. 

The Batch Operation Result page displays once IMC has completed the batch operation.  

5. Review the Operation Result field to verify that the requested changes have been made for all 
devices. 

Using batch mode to configure Telnet settings 
You can use the IMC batch mode feature to update IMC's Telnet configuration for one or more 
devices.  

To add or modify IMC Telnet settings for one or more devices in batch mode: 

1. Navigate to Resource > Batch Operation > Telnet Settings. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click the Batch Operation link under Resource Management on the left navigation tree. 

2. Click the Telnet Settings link from the NMS Parameter Configuration section of the 
Resource > Batch Operation page. 

3. Click Add to select the devices to which you want to apply the Telnet settings in the Telnet 
Settings window. 

You can add devices by using either the View or Advanced query option. See "Adding devices 
by view" and "Adding devices by advanced query."  

4. To configure the Telnet settings for selected devices, click the Configuration icon .  

The Telnet Parameters dialog box opens. 

5. You can either enter the Telnet settings in this dialog box or you can select an existing Telnet 
template that contains the Telnet settings for this device.  

Telnet templates are particularly useful when Telnet configurations are standardized. For more 
information about creating Telnet templates, see "SNMP templates." 

Editing Telnet settings manually 

1. To edit the Telnet parameters manually, verify that Edit Telnet Parameters is selected. 
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2. Select the Telnet authentication mode from the Authentication Mode list: 

a. Username—Enter the Telnet username in the Username field, if prompted. 

b. Password—Enter the Telnet password in the Password field, if prompted. 

c. Super Password—Enter the Telnet super password in the Super Password field, if 
prompted. 

d. Timeout—Enter the Telnet timeout value configured on the managed device in the 
Timeout field. Valid range is 1–60 seconds. 

Using existing Telnet templates 

1. To configure the Telnet settings for this device using Telnet templates, select Select an 
Existing Template. 

2. Select a Telnet template. 

3. Click OK. 

4. Click OK to apply the Telnet configuration settings to the selected devices. 

The Batch Operation Result page displays once IMC has completed the batch operation. 

5. Review the Operation Result field to verify that the requested changes have been made for all 
devices. 

6. If you want to check the Telnet settings for the devices configured in this batch mode operation, 
click Check. 

The Check Telnet Settings pane opens.  

7. Click OK to check the Telnet settings for all devices in the displayed list. 

8. Review the Operation Result field in the Check Telnet Settings List to verify whether or not 
the Telnet settings you applied were successful. 

Using batch mode to configure NETCONF parameters 
You can use the IMC batch mode feature to update IMC's NETCONF configuration for one or more 
devices. 

To add or modify IMC's NETCONF settings for one or more devices in batch mode: 

1. Navigate to Resource > Batch Operation > Netconf Settings. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click the Batch Operation link under Resource Management on the left navigation tree. 

2. Click the Netconf Settings link from the NMS Parameter Configuration section of the 
Resource > Batch Operation page. 

3. Click Add to select the devices to which you want to apply the NETCONF settings in the 
Netconf Settings window. 

You can add devices by using either the View or Advanced query option. See "Adding devices 
by view" and "Adding devices by advanced query."  

4. To configure the NETCONF settings for selected devices, click the Configuration icon  .  

The Netconf Parameters dialog box opens. 

5. Click Modify to modify NETCONF parameters. The Protocol field cannot be modified. 

6. Click the Add Protocol icon , and configure the Protocol, Port Number, Root Path, User 
Name, and Password fields. Two protocol options are available: SOAP/HTTPS and 
SOAP/HTTPS. 

7. To delete NETCONF settings, click Delete. To use the NETCONF settings, click OK. 

The Batch Operation Result page displayed once IMC has completed the batch operation. 
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8. Review the Operation Result field to verify that the requested changes have been made for all 
devices. 

Using batch mode to configure SSH settings 
You can use the IMC batch mode feature to update IMC SSH configuration for one or more devices.  

Adding or modifying IMC SSH settings for one or more devices in batch mode 

1. Navigate to Resource > Batch Operation > SSH Settings. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click the Batch Operation link under Resource Management on the left navigation tree. 

2. Click SSH Settings link from the NMS Parameter Configuration section of the Resource > 
Batch Operation page. 

3. Click Add to select the devices to which you want to apply the SSH settings in the SSH 
Settings window.  

You can add devices by using either the View or Advanced query option. See "Adding devices 
by view" and "Adding devices by advanced query." 

4. To configure the SSH settings for selected devices, click the Configuration icon .  

The SSH Parameters dialog box opens.  

You can either enter the SSH settings in this dialog box or you can select an existing SSH 
template that contains the SSH settings for this device. SSH templates are particularly useful 
when SSH configurations are standardized. For more information about creating SSH 
templates, see "SNMP templates." 

Editing SSH settings manually 

1. Verify that Edit SSH Parameters is selected. 

2. Select the authentication mode from the Authentication Mode list. 

The authentication mode selected must match the configuration on the managed devices. 

3. Enter data in the following fields, as required: 

a. User Name—Enter username in the User Name field. 

b. Password—Enter the password in the Password field. 

c. Private Key File—Enter the path and filename of the private key file that contains the key 
that enables login, if prompted. 

d. Private Key Password—Enter the private key password for the private key file, if 
prompted. 

e. Super Password—Enter the super password in the Super Password field. 

f. Port—Enter the TCP port for SSH in the Port field. The default TCP port is 22. 

g. Timeout—Enter the SSH timeout value (1–120 seconds). The timeout parameter defines 
how long the system waits for the device to respond in seconds before declaring that the 
response has timed out. The default setting is 10 seconds. 

h. Retries—Enter the number of SSH retries (1–5). The retries parameter defines how many 
times the management system (IMC) sends SSH retries in an attempt to communicate with 
the managed device before reporting a failure. The default setting is 3. 

Using existing SSH templates 

To configure SSH settings for this device by using existing SSH templates: 

1. Select Select an Existing Template.  

2. Select a SSH template. 
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3. Click OK to accept the SSH configuration. 

4. Click OK to apply the SSH configuration settings to the selected devices. 

The Batch Operation Result page displays once IMC has completed the batch operation.  

5. Review the Operation Result field to verify that the requested changes have been made for all 
devices. 

6. If you want to check the SSH settings for the devices configured in this batch mode operation, 
click Check.  

The Check SSH Settings window opens.  

7. Click OK to check the SSH settings for all devices in the displayed list. 

8. Review the Operation Result field in the Check SSH Settings List to verify whether or not the 
SSH settings you applied were successful. 

Using batch mode to configure polling intervals 
To add or modify the polling interval for device configuration polls and device status to one or more 
devices in batch mode: 

1. Navigate to Resource > Batch Operation > Poll Interval Settings: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click the Batch Operation link under Resource Management on the left navigation tree. 

2. Click the Poll Interval link from the NMS Parameter Configuration section of the Resource > 
Batch Operation page. 

3. Click Add to select the devices to which you want to apply the polling configuration settings in 
the Poll Interval Settings window.  

You can add devices by using either the View or Advanced query option. See "Adding devices 
by view" and "Adding devices by advanced query." 

The Configuration Poll Interval is the parameter that determines how long IMC waits before 
polling managed devices for any configuration changes. 

4. Enter the configuration polling interval in minutes in the Configuration Poll Interval field.  

The Configuration Poll Interval is the parameter that determines how long IMC waits before 
polling managed devices for any configuration changes. The range is 5–1500 minutes and the 
default is 120 minutes. 

5. Enter the status polling interval in minutes in the Status Poll Interval field.  

The Status Poll Interval is the parameter that determines how long IMC waits before sending 
ping requests to managed devices to determine their reachability status. The range is 30–600 
seconds and the default is 60 seconds. 

6. Click OK to apply the configuration settings to the selected devices.  

The Batch Operation Result page display once IMC has completed the batch operation.  

7. Review the Operation Result field to verify that the requested changes have been made for all 
devices. 

Using batch mode to modify login types 
To add or modify the login type for network devices using batch mode: 

1. Navigate to Resource > Batch Operation > Login Type Settings: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click the Batch Operation link under Resource Management on the left navigation tree. 
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2. Click the Login Type Settings link from the NMS Parameter Configuration section of the 
Resource > Batch Operation page. 

3. Click Add to select the devices to which you want to apply the polling configuration settings in 
the Login Type Settings pane.  

You can add devices by using either the View or Advanced query option. See "Adding devices 
by view" and "Adding devices by advanced query." 

4. Select the access type you want to use next to Login Type. 

5. Click OK to apply the configuration settings to the selected devices.  

After IMC completes the batch operation, the Batch Operation Result page opens. 

6. Review the Operation Result field to verify that the requested changes have been made for all 
devices. 

Using batch mode to modify ping settings 
To add or modify the Ping settings for network devices using batch mode: 

1. Navigate to Resource > Batch Operation > Ping Settings: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click the Batch Operation link under Resource Management on the left navigation tree. 

2. Click the Ping Settings link from the NMS Parameter Configuration section of the Resource 
> Batch Operation page. 

3. Click Add to select the devices to which you want to apply the polling configuration settings in 
the Ping Settings pane.  

You can add devices by using either the View or Advanced query option.  

4. Select Support Ping Operation. 

 If you select Support Ping Operation, IMC will use ping packets to detect the reachability 
of devices. 

 If you clear Support Ping Operation, IMC will use SNMP packets to detect the reachability 
of devices. 

5. Click OK to apply the configuration settings to the selected devices. 

The Batch Operation Result page displays once IMC has completed the batch operation.  

6. Review the Operation Result field to verify that the requested changes have been made for all 
devices. 

Using batch mode to modify interface up/down alarm filter 
To modify the interface Up/Down alarm filter for network devices using batch mode: 

1. Navigate to Resource > Batch Operation > Interface Up/Down Alarm Filter: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click the Batch Operation link under Resource Management on the left navigation tree. 

2. Click the Interface Up/Down Alarm Filter link from the NMS Parameter Configuration 
section of the Resource > Batch Operation page. 

3. Click Add to select the interfaces to which you want to apply the interface alarm filter settings in 
the Interface Alarm Filter pane.  

You can add interfaces using either the View or Advanced query option. Add interfaces by 
using the same process as adding devices. See "Adding devices by view" and "Adding devices 
by advanced query." 
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When you select a custom view in the By View tab and then click the Advanced tab , IMC 
automatically populates the View Name field with the name of the custom view. This helps you 
quickly locate a custom view and query target interfaces in the custom view. 

4. Set the filter to permit or deny the Up/Down alarm of the interface settings from the Interface 
Up/Down Alarm Filter list. 

5. Click OK to apply the configuration settings to the selected devices. 

The Batch Operation Result page displayed once IMC has completed the batch operation.  

6. Review the Operation Result field to verify that the requested changes have been made for all 
devices. 

Using the batch mode to configure device types 
To configure device types using batch mode: 

1. Navigate to Resource > Batch Operation > Configure Device Type: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click the Batch Operation link under Resource Management on the left navigation tree. 

2. Click the Configure Device Type link from the NMS Parameter Configuration section of the 
Resource > Batch Operation page. 

3. Click Add and select network devices. You can add devices by using either the View or 
Advanced query option. See "Adding devices by view" and "Adding devices by advanced 
query." 

4. Select a device type from the Device Category list. Options include Routers, Switches, 
Servers, Security, Storage, Wireless, Voice, Surveillance, Video, Virtual Devices, and 
Module, 

5. Click OK. 

The Batch Operation Result page displayed once IMC has completed the batch operation. 

6. Review the Operation Result field to verify that the requested changes have been made for all 
devices. 

Checking device access settings in batch mode 
Using IMC batch mode operation feature, you can configure plans to check SNMP, Telnet, and SSH 
settings and determine quickly whether SNMP, Telnet, or SSH is enabled and functioning on 
managed devices from the plan execution and check results in the plan list. 

Using batch mode to create a plan to check access settings 

To create a plan to verify the access settings for network devices using batch mode: 

1. Navigate to Resource > Batch Operation > Check Access Settings: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click the Batch Operation link under Resource Management on the left navigation tree. 

2. Click the Check Access Settings link from the Check Configuration section of the Resource 
> Batch Operation page.  

The Check Access Settings window opens. 

3. Click Add to select the devices for which you want to check the SNMP, Telnet, or SSH settings.  

You can add devices using either the View or Advanced query option. See "Adding devices by 
view" and "Adding devices by advanced query." 

4. Select the access parameters to be checked SNMP, Telnet, or SSH. 
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5. Run the check access settings plan now or schedule it to run once at a later date by selecting 
from the following: 

 To run the batch mode check access setting plan now, select Immediately from the 
Schedule Information list. 

 To schedule the plan to run in the future, select Once. 

If you selected Once: 

a. Enter a date and time in the field next to the Schedule Information.  

b. Enter the date and time manually or enter it by clicking the field.  

A popup calendar is displayed.  

c. Select the date from the calendar. To enter it manually, the valid date format is 
YYYY-MM-DD hh:mm:ss where YYYY refers to the four-digit year, MM refers two-digit 
month, DD refers to the two-digit day, hh refers to the two-digit hour, mm refers to the 
two-digit minute, and ss refers to the two-digit second values. 

6. Click OK.  

The check plan is displayed in the Plan List.  

Viewing the plan list 

To view the plans for checking the access settings in the plan list: 

1. Navigate to Resource > Batch Operation > Check Access Settings > Plan List: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click the Batch Operation link under Resource Management on the left navigation tree. 

2. Click the Edit Plan link after the Check Access Settings from the Check Configuration 
section of the Resource > Batch Operation page. The Plan List window opens. 

Plan list 

 Status—Identifies the current plan status, which can be Waiting, Finished, Running, or 
Expired. Waiting means the plan is waiting to be executed. Finished means the plan is 
already executed. Running means the plan is being executed. Expired means the plan is 
expired and cannot be executed. A plan is expired if the IMC service is not started within the 
execution time configured for the plan. Click Suspend to suspend a plan in Waiting or 
Running status. Click Resume to resume a suspended plan. 

 Result—Identifies the execution result of the associated plan, which can be Success, 
Failure, or Unknown. Success means the plan was successfully executed. Failure means 
the plan execution failed. Unknown means the plan is being executed. 

 Name—Contains the name of the associated plan, in the format of Check Access Setting 
execution-time. Click the name to view the check result details of the plan. 

 Start Time—Contains the start date and time of the associated plan. 

 End Time—Contains the end date and time of the associated plan. 

 Created by—Contains the name of the operator who created the associated plan. 

 Details—Contains an icon  for viewing the check result details page for the associated 
plan. 

 Copy—Contains an icon  for copying the parameters of the associated plan. You can 
modify these parameters and set a plan name to add a new plan.  

 Modify—Contains an icon  for modifying parameters of the associated plan. The plan 
name cannot be modified.  

 Delete—Contains an icon  for deleting the associated plan. You cannot delete plans in 
the running state. You can click Add on the Plan List page to add more plans. 
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3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

You can sort the Plan List by the Status, Result, Name, Start Time, End Time, and Created 
by fields by clicking the column label to sort the list by the selected field. The column label is a 
toggle switch that allows you to toggle between the various sort options specific to each field. 

Viewing device check results 

To view the check results of a device: 

1. Navigate to Resource > Batch Operation > Check Access Settings > Plan List: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click the Batch Operation link under Resource Management on the left navigation tree. 

2. Click the Edit Plan link after the Check Access Settings from the Check Configuration 
section of the Resource > Batch Operation page.  

The Plan List window opens. 

3. Click the name of a plan to enter the check result page.  

The Schedule Information field shows how the plan was or is to be executed: 

 Immediately—The plan was executed immediately after it was created. 

 Once—The plan was or is to be executed at a scheduled time.  

The Check Items area shows the parameters that the plan checks. The plan checks 
selected parameters only. 

The Device List area shows the check result on each device: 

 Device Label—Contains the label and IP address of the associated device. 

 Check Result—Identifies the result of checking the access settings on the associated 
device. Success means the access settings were successfully checked. Failure means the 
device cannot be connected. Partially Success means part of the access settings was 
successfully checked. Unknown means there is no check result, because the access 
settings are not checked or being checked. For ICMP devices or other devices that do not 
support Telnet, SNMP, or SSH parameters, this field displays check not supported.  

Viewing the check results of a plan 

To view the check results of a plan: 

1. Navigate to Resource > Batch Operation > Check Access Settings > Plan List. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click the Batch Operation link under Resource Management on the left navigation tree. 

2. Click the Edit Plan link after the Check Access Settings from the Check Configuration 
section of the Resource > Batch Operation page.  

The Plan List window opens. 

3. Click the Check result icon  in the Details field associated with the plan whose check 
results you want to view.  

The check results of the plan are displayed.  

The Schedule Information field shows how the plan was or is to be executed: 

 Immediately—The plan was executed immediately after it was created. 

 Once—The plan was or is to be executed at a scheduled time. 

The Check Items area shows the parameters that the plan checks. The plan checks 
selected parameters only.  

The Result area shows the execution time of the plan, device information, and the check 
result on each device. 
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 Execution Time—Contains the time when the plan was or is to be executed. 

 Device Label—Contains the label and IP address of the associated device. 

 SNMP, Telnet, and SSH—Contains the check result of the SNMP, Telnet, and SSH 
parameters on the associated device. Consistent means the parameters configured in IMC 
are consistent with the access settings of the device. Inconsistent means the parameters 
configured in IMC are not consistent with the access settings of the device. If the check 

result is Inconsistent, the system displays a Modify icon  for you to modify access 
parameters. 

Modifying device configurations in batch mode 
IMC also simplifies administrative tasks for saving device configurations, rebooting devices, 
configuring device interfaces, applying energy saving policies, configuring trap destinations, 
Spanning Tree Protocol and Spanning Tree Protocol interfaces, LACP, Device Configuration Wizard, 
and Interface Configuration.  

Using batch mode to save device configurations 

Using batch mode, you can save device configurations for one or more devices. You can also 
schedule IMC to run the save configuration batch mode operation once.  

To save device configurations using batch mode: 

1. Navigate to Resource > Batch Operation > Save Configuration: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click the Batch Operation link under Resource Management on the left navigation tree. 

2. Click the Save Configuration link from the Device Configuration section of the Resource > 
Batch Operation page. 

3. Click Add to select the devices to which this batch mode operation is applied.  

You can add devices using either the View or Advanced query option. See "Adding devices by 
view" and "Adding devices by advanced query." 

4. Run the batch mode save configuration task now or schedule it to run in the future: 

 To run the batch mode save configuration task now, select Immediately from the Schedule 
Information list. 

 To schedule the task to run once in the future, select Once. 

If you selected Once: 

 Enter a date and time in the field next to the Schedule Information.  

 Enter the date and time manually or enter it by clicking the field.  

 A popup calendar is displayed.  

 Select the date from the calendar. To enter it manually, the valid date format is 
YYYY-MM-DD hh:mm:ss where YYYY refers to the four-digit year, MM refers two-digit 
month, DD refers to the two-digit day, hh refers to the two-digit hour, mm refers to the 
two-digit minute, and ss refers to the two-digit second values. 

 To schedule the plan to run periodically, select Daily and enter a time in the field next to 
Daily in the format of hh:mm:ss. 

5. Click OK.  

The Plan List displays along with the status of the batch mode operation task in the Status 
field. 

6. Click Refresh to update the Plan List and the Status field.  

When the task is complete, the Status field updates to Finished.  
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7. Click the Details icon  associated with the task to view detailed results of the batch mode 
task. 

If you opted to run the batch mode operation at a later date, you can review the results of this batch 
operation task by clicking Edit Plan next to Save Configuration. For other operations on the plan 
configuration page, see "Viewing the plan list." 

Using batch mode to reboot devices 

Using batch mode, you can reboot one or more devices. You can also schedule IMC to run the reboot 
device batch operation once.  

To reboot devices using batch mode: 

1. Navigate to Resource > Batch Operation > Reboot Device: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click the Batch Operation link under Resource Management on the left navigation tree. 

2. Click the Reboot Device link from the Device Configuration section of the Resource > Batch 
Operation page. 

3. Click Add to select the devices to which this batch mode operation is applied.  

You can add devices using either the View or Advanced query option. See "Adding devices by 
view" and "Adding devices by advanced query." 

4. Run the batch mode device reboot task now or schedule it to run once at a later date by 
selecting from the following: 

 To run the batch mode check access setting plan now, select Immediately from the 
Schedule Information list. 

 To schedule the plan to run in the future, select Once. 

If you selected Once: 

a. Enter a date and time in the field next to the Schedule Information.  

b. Enter the date and time manually or enter it by clicking the field.  

A popup calendar is displayed.  

c. Select the date from the calendar. To enter it manually, the valid date format is 
YYYY-MM-DD hh:mm:ss where YYYY refers to the four-digit year, MM refers two-digit 
month, DD refers to the two-digit day, hh refers to the two-digit hour, mm refers to the 
two-digit minute, and ss refers to the two-digit second values. 

5. Click OK.  

The Plan List displays along with the status of the batch mode operation task in the Status 
field. 

6. Click Refresh to update the Plan List and the Status field.  

When the task is complete, the Status field updates to Finished.  

7. Click the Details icon  associated with the task to view detailed results of the batch mode 
task.  

If you opted to run the batch mode operation at a later date, you can review the results of this batch 
operation task by clicking Edit Plan next to Reboot Device. For other operations on the plan 
configuration page, see "Viewing the plan list." 

Using batch mode to configure management status on interfaces 

Using batch mode, you can configure the management status of one or more interfaces for one or 
more devices. You can also schedule IMC to run the batch operation once.  

To configure the management status of one or more interfaces using batch mode: 

1. Navigate to Resource > Batch Operation > Configure Interfaces: 
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a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click the Batch Operation link under Resource Management on the left navigation tree. 

2. Click the Configure Interface link from the Device Configuration section of the Resource > 
Batch Operation page. 

3. Click Add to select the interfaces to which this batch mode operation is applied.  

You can add interfaces using either the View or Advanced query option. Add interfaces by 
using the same process as adding devices. See "Adding devices by view" and "Adding devices 
by advanced query." 

When you select a custom view in the By View tab and then click the Advanced tab , IMC 
automatically populates the View Name field with the name of the custom view. This helps you 
quickly locate a custom view and query target interfaces in the custom view. 

4. Select the management status for the selected interfaces from the Management Status list. 

5. Run the batch mode interface management status configuration task now or schedule it to run 
in the future: 

 To run the batch mode task now, select Immediately from the Schedule Information list. 

 To schedule the task to run once in the future, select Once. 

If you selected Once: 

 Enter a date and time in the field next to the Schedule Information.  

 Enter the date and time manually or enter it by clicking the field.  

 A popup calendar is displayed.  

 Select the date from the calendar. To enter it manually, the valid date format is 
YYYY-MM-DD hh:mm:ss where YYYY refers to the four-digit year, MM refers two-digit 
month, DD refers to the two-digit day, hh refers to the two-digit hour, mm refers to the 
two-digit minute, and ss refers to the two-digit second values. 

 To schedule the task to run at a time every day, selected Daily and enter the time in format 
hh:mm:ss in the field next to the Schedule Information. 

6. Click OK.  

The Plan List displays along with the status of the batch mode operation task in the Status 
field. 

7. Click Refresh to update the Plan List and the Status field.  

When the task is complete, the Status field updates to Finished.  

8. Click the Details icon  associated with the task to view detailed results of the batch mode 
task.  

9. Click the Modify icon  to modify the batch mode task, including reselecting interfaces, 
managing the interface status, and re-configuring the scheduling time. 

If you opted to run the batch mode operation at a later date, you can review the results of this 
batch operation task by clicking Edit Plan next to Configure Interfaces. For other operations 
on the plan configuration page, see "Viewing the plan list." 

Using batch mode to implement energy saving policies 

Using batch mode, you can configure Power over Ethernet (PoE) settings on one or more interfaces 
for one or more devices. You can also schedule IMC to run the batch operation once.  

To configure PoE settings using batch mode: 

1. Navigate to Resource > Batch Operation > Energy Saving Policy. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click the Batch Operation link under Resource Management on the left navigation tree. 
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2. Click the Energy Saving Policy link from the Device Configuration section of the Resource > 
Batch Operation page. 

3. Click Add to select the interfaces to which this batch mode operation is applied.  

You can add interfaces using either the View or Advanced query option. Add interfaces by 
using the same process as adding devices. See "Adding devices by view" and "Adding devices 
by advanced query." 

When you select a custom view in the By View tab and then click the Advanced tab , IMC 
automatically populates the View Name field with the name of the custom view. This helps you 
quickly locate a custom view and query target interfaces in the custom view. 

4. Enter the PSE power setting in the PSE Power field.  

The range is 1-806 Watts. 
 

 NOTE: 

The status of PSE must be enabled and the maximum PSE power must be greater than or equal to 
the sum of the maximum power of all critical PoE interfaces on the PSE to guarantee power to the 
PoE interfaces. 
 

5. Enter the power for the PoE interfaces in the Power of the PoE Interface field.  

The range is 1-17000mW. 

6. Select the priority for this PoE setting from the Priority list. 

7. Run the batch mode energy saving policy implementation task now or schedule it to run once at 
a later date: 

 To run the batch mode task now, select Immediately from the Schedule Information list. 

 To schedule the task to run once in the future, select Once. 

If you selected Once: 

a. Enter a date and time in the field next to the Schedule Information.  

b. Enter the date and time manually or enter it by clicking the field.  

A popup calendar is displayed.  

c. Select the date from the calendar. To enter it manually, the valid date format is 
YYYY-MM-DD hh:mm:ss where YYYY refers to the four-digit year, MM refers two-digit 
month, DD refers to the two-digit day, hh refers to the two-digit hour, mm refers to the 
two-digit minute, and ss refers to the two-digit second values. 

8. Click OK.  

The Plan List displays along with the status of the batch mode operation task in the Status 
field. 

9. Click Refresh to update the Plan List and the Status field.  

When the task is complete, the Status field updates to Finished.  

10. Click the Details icon  associated with the task to view detailed results of the batch mode 
task.  

If you opted to run the batch mode operation at a later date, you can review the results of this 
batch operation task by clicking Edit Plan next to Configure PoE. For other operations on the 
plan configuration page, see "Viewing the plan list." 

Using batch mode to configure trap destinations 

Using batch mode, you can configure the trap destination for one or more devices. You can also 
schedule IMC to run the trap destination batch operation once.  

To configure the trap destination using batch mode: 

1. Navigate to Resource > Batch Operation > Configure Trap Destination. 

a. Click the Resource tab from the top tabular navigation system. 
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b. Click Resource Management on the left navigation tree. 

c. Click the Batch Operation link under Resource Management on the left navigation tree. 

2. Click the Configure Trap Destination link from the Device Configuration section of the 
Resource > Batch Operation page. 

3. Click Add to select the devices to which this batch mode operation is applied.  

You can add devices using either the View or Advanced query option. See "Adding devices by 
view" and "Adding devices by advanced query." 

4. Enter the IP address or hostname of the device that serves as the trap destination in the Host 
field. 

5. Enter the UDP port configured on the trap destination for receiving SNMP traps in the UDP Port 
field.  

The default UDP port for SNMP traps is 162.  

6. Do one of the following:  

 If you are using SNMP v1 or v2c, enter the trap community string configured on the trap 
destination in the Authentication Parameters field.  

 If you are using SNMPv3, enter the username that is configured on the trap destination in 
the Authentication Parameters field. 

7. Select the version of SNMP that is configured on the trap destination from the SNMP Version 
list. 

8. If you selected SNMPv3, select the security model from the Security Model list. 

9. Select Clear Trap Destination if you want to configure the same host as the recipient for clear 
traps. 

10. Run the batch mode trap destination configuration task now or schedule it to run once at a later 
date: 

 To run the batch mode task now, select Immediately from the Schedule Information list. 

 To schedule the task to run in the future, select Once. 

If you selected Once: 

a. Enter a date and time in the field next to the Schedule Information.  

b. Enter the date and time manually or enter it by clicking the field.  

A popup calendar is displayed.  

c. Select the date from the calendar. To enter it manually, the valid date format is 
YYYY-MM-DD hh:mm:ss where YYYY refers to the four-digit year, MM refers two-digit 
month, DD refers to the two-digit day, hh refers to the two-digit hour, mm refers to the 
two-digit minute, and ss refers to the two-digit second values. 

11. Click OK.  

The Plan List displays along with the status of the batch mode operation task in the Status 
field. 

12. Click Refresh to update the Plan List and the Status field.  

When the task is complete, the Status field updates to Finished.  

13. Click the Details icon  associated with the task to view detailed results of the batch mode 
task.  

If you opted to run the batch mode operation at a later date, you can review the results of this 
batch operation task by clicking Edit Plan next to Configure Trap Destination. For other 
operations on the plan configuration page, see "Viewing the plan list." 

Using batch mode to configure spanning tree protocol on switches 

Using batch mode, you can apply Spanning Tree Protocol (STP) configurations to one or more 
devices. You can also schedule IMC to run the spanning tree batch operation once.  

To configure STP on switches using batch mode: 
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1. Navigate to Resource > Batch Operation > Configure Spanning Tree. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click the Batch Operation link under Resource Management on the left navigation tree. 

2. Click the Configure STP link from the Device Configuration section of the Resource > Batch 
Operation page. 

3. Click Add to select the devices to which this batch mode operation is applied.  

You can add devices using either the View or Advanced query option. See "Adding devices by 
view" and "Adding devices by advanced query." 

4. To enable spanning tree mode, select Enabled from the Spanning Tree Mode list in the 
Configure Spanning Tree window.  

Selecting Enabled activates the remaining spanning tree configuration options listed below. 

5. To configure bridge priority for the selected devices, select Bridge Priority. 

6. Select the bridge priority number from the Bridge Priority list.  

The list lists all valid bridge priority numbers. 

7. To configure the Hello Time for packets sent between switches in a spanning tree to determine 
when the root switch has failed for the selected devices, select Hello Time field.  

The range is 1–10 seconds and the default is 2 seconds. 

8. To configure the maximum age of a Hello packet, enter the max age value in the Max Age field.  

The range is 6–40 seconds and the default is 20 seconds. 

9. To configure the Forward Delay settings for Hello packets, enter the value in seconds in the 
Forward Delay field.  

The range is 4–30 seconds and the default is 15 seconds. 

10. Run the batch mode STP configuration task now or schedule it to run once at a later date: 

 To run the batch mode task now, select Immediately from the Schedule Information list. 

 To schedule the task to run once in the future, select Once. 

If you selected Once: 

a. Enter a date and time in the field next to the Schedule Information.  

b. Enter the date and time manually or enter it by clicking the field.  

A popup calendar is displayed.  

c. Select the date from the calendar. To enter it manually, the valid date format is 
YYYY-MM-DD hh:mm:ss where YYYY refers to the four-digit year, MM refers two-digit 
month, DD refers to the two-digit day, hh refers to the two-digit hour, mm refers to the 
two-digit minute, and ss refers to the two-digit second values. 

11. Click OK.  

The Plan List displays along with the status of the batch mode operation task in the Status 
field. 

12. Click Refresh to update the Plan List and the Status field.  

When the task is complete, the Status field updates to Finished.  

13. Click the Details icon  associated with the task to view detailed results of the batch mode 
task.  

If you opted to run the batch mode operation at a later date, you can review the results of this 
batch operation task by clicking Edit Plan next to Configure STP. For other operations on the 
plan configuration page, see "Viewing the plan list." 

Using batch mode to configure spanning tree protocol on interfaces 

Using batch mode, you can apply STP configurations to one or more interfaces. You can also 
schedule IMC to run the STP batch operation once.  
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To configure the STP on interfaces using batch mode: 

1. Navigate to Resource > Batch Operation > Configure Interface-Level STP. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click the Batch Operation link under Resource Management on the left navigation tree. 

2. Click the Configure STP Interface link from the Device Configuration section of the 
Resource > Batch Operation page. 

3. Click Add to select the interfaces to which this batch mode operation is applied.  

You can add interfaces using either the View or Advanced query option. Add interfaces by 
using the same process as adding devices. See "Adding devices by view" and "Adding devices 
by advanced query."  

When you select a custom view in the By View tab and then click the Advanced tab , IMC 
automatically populates the View Name field with the name of the custom view. This helps you 
quickly locate a custom view and query target interfaces in the custom view. 

4. To configure the port path cost for the selected interfaces, first verify that the Port Path Cost 
field is selected.  

5. Enter the port path cost in the Port Path Cost field.  

The Port Path Cost field must contain an integer that is greater than or equal to zero. 

6. To enable Spanning Tree Fast Start, first verify that the Spanning Tree Fast Start field is 
selected.  

7. Select Enabled from the Spanning Tree Fast Start list. 

8. Run the batch mode STP configuration task now or schedule it to run once at a later date: 

 To run the batch mode task now, select Immediately from the Schedule Information list. 

 To schedule the task to run once in the future, select Once. 

If you selected Once: 

a. Enter a date and time in the field next to the Schedule Information.  

b. Enter the date and time manually or enter it by clicking the field.  

A popup calendar is displayed.  

c. Select the date from the calendar. To enter it manually, the valid date format is 
YYYY-MM-DD hh:mm:ss where YYYY refers to the four-digit year, MM refers two-digit 
month, DD refers to the two-digit day, hh refers to the two-digit hour, mm refers to the 
two-digit minute, and ss refers to the two-digit second values. 

9. Click OK.  

The Plan List displays along with the status of the batch mode operation task in the Status 
field. 

10. Click Refresh to update the Plan List and the Status field.  

When the task is complete, the Status field updates to Finished.  

11. Click the Details icon  associated with the task to view detailed results of the batch mode 
task.  

If you opted to run the batch mode operation at a later date, you can review the results of this 
batch operation task by clicking Edit Plan next to Configure STP Interface. For other 
operations on the plan configuration page, see "Viewing the plan list." 

Using batch mode to configure LACP 

Using batch mode, you can apply Link Aggregation Control Protocol (LACP) configurations to one or 
more interfaces. You can also schedule IMC to run the LACP batch operation once.  

To configure the LACP on interfaces using batch mode: 

1. Navigate to Resource > Batch Operation > Configure LACP. 
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a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click the Batch Operation link under Resource Management on the left navigation tree. 

2. Click the Configure LACP link from the Device Configuration section of the Resource > 
Batch Operation page. 

3. Click Add to select the interfaces to which this batch mode operation is applied.  

You can add interfaces using either the View or Advanced query option. Add interfaces by 
using the same process as adding devices. See "Adding devices by view" and "Adding devices 
by advanced query." 

When you select a custom view in the By View tab and then click the Advanced tab , IMC 
automatically populates the View Name field with the name of the custom view. This helps you 
quickly locate a custom view and query target interfaces in the custom view. 

4. To enable LACP on the selected devices, select Enabled from the LACP State list. 

5. Run the batch mode LACP configuration task now or schedule it to run once at a later date by 
selecting from the following: 

 To run the batch mode task now, select Immediately from the Schedule Information list. 

 To schedule the task to run once in the future, select Once. 

If you selected Once: 

a. Enter a date and time in the field next to the Schedule Information.  

b. Enter the date and time manually or enter it by clicking the field.  

A popup calendar is displayed.  

c. Select the date from the calendar. To enter it manually, the valid date format is 
YYYY-MM-DD hh:mm:ss where YYYY refers to the four-digit year, MM refers two-digit 
month, DD refers to the two-digit day, hh refers to the two-digit hour, mm refers to the 
two-digit minute, and ss refers to the two-digit second values. 

6. Click OK.  

The Plan List displays along with the status of the batch mode operation task in the Status 
field. 

7. Click Refresh to update the Plan List and the Status field.  

When the task is complete, the Status field updates to Finished.  

8. Click the Details icon  associated with the task to view detailed results of the batch mode 
task.  

If you opted to run the batch mode operation at a later date, you can review the results of this 
batch operation task by clicking Edit Plan next to Configure LACP. For other operations on the 
plan configuration page, see "Viewing the plan list." 

Using batch mode to configure devices 

By creating a batch device configuration plan, you can configure multiple devices in batch. You can 
configure a batch device configuration plan according to the requirements of each component. In a 
practical service that involves multiple component operations, you can create a batch device 
configuration plan to apply the integrated operations.  

The IMC platform supports the following types of operations: VLAN, Device Access, and Virtual 
Connect.  

To configure device using batch mode: 

1. Navigate to the Deployment window: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click the Batch Operation link under Resource Management on the left navigation tree. 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 8798



397 

2. Click the Device Configuration Guide link from the Batch Operation page. 

The Deployment window opens. 

3. Select operations and devices.  

The selected operations are to be performed on all the selected devices.  

4. Click Add under the Operation List.  

The Select Operations window opens. 

5. Click  to expand all operations. Click  to collapse all operations.  

At the same time, you can click  to the left of an operation type to expand all operations of this 
type, and click  to collapse all operations of this type.  

6. Do one of the following:  

 Select the parameters. 

 Select all operations of a certain type.  

7. Click OK. 

8. Confirm that the operations you have selected now are displayed in the Operation List. 

9. Click the Delete icon  in the Delete field to delete the association operation. 

10. Click one of the icons in the Sort field to reorder the operations in the operation list: 

 Use  to move the operation up one position. 

 Use  to move the operation to the top of the parameter list. 

 Use  to move the operation down one position. 

 Use  to move the operation to the bottom of the list. 

Operations are executed in the order that they are sorted. 

11. Click Add under the Device List to select the devices to which these batch mode operation are 
applied.  

You can add devices using either the View or Advanced query option. See "Adding devices by 
view" and "Adding devices by advanced query." 

12. Click Next. 

13. To configure parameters for the operations, do one of the following: 

VLAN 

Add VLAN 

 VLAN ID—Enter the VLAN ID. 

 VLAN Name—Enter a name for the VLAN. 

Delete VLAN 

 VLAN ID—Select a VLAN from the VLAN ID list. The selected VLAN is deleted from all 
selected devices, and the VLAN must already exist in the IMC. 

When you configure multiple devices at a time, the available VLAN IDs are the intersection 
of the VLANs on all devices. 

Modify VLAN Name 

 VLAN ID—Select a VLAN from the VLAN ID list. 

 VLAN Name—Enter a new name for the VLAN. 

Add VLAN Interface 

 VLAN ID—Select a VLAN from the VLAN ID list. 

 IP Address Type—Select a type for the virtual interface from the IP Address Type list. 
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 DHCP Enabled—Specify whether to enable DHCP. With DHCP enabled, the virtual 
interface obtains an IP address from the DHCP server. 

 IP Address—Enter an IP address for the virtual interface. This property is required if you do 
not enable DHCP.  

 Mask—Enter a mask for the IP address in dotted decimal notation, such as 255.255.255.0. 
This property is required if DHCP is not enabled. 

Delete VLAN Interface 

 VLAN ID—Enter the VLAN ID you want to delete. IMC deletes the specified VLAN interface, 
but does not delete the VLAN. 

 IP Address Type—Select a type for the virtual interface from the IP Address Type list. 

 DHCP Enabled—Select whether to enable DHCP. With DHCP enabled, the virtual interface 
obtains an IP address from the DHCP server. 

 IP Address—Enter an IP address for the virtual interface. This property is required if DHCP 
is not enabled. 

 Mask—Enter a mask for the IP address in dotted decimal notation, such as 255.255.255.0. 
This property is required if DHCP is not enabled. 

When you configure multiple devices at a time, the available VLAN IDs are the intersection of 
the VLANs on all devices. 

Device Access 

Set Telnet User 

 User Name—Enter a Telnet username. 

 Password Mode—Select a password mode for the Telnet user. 

 Password—Enter a Telnet user password. 

 User Level—Enter a Telnet user level. 

 Service Type—Select a service type for Telnet users. 

Set SSH Global Parameters 

 Compatible with SSHv1—Select whether to be compatible with SSHv1.  

 Authentication Retry—Enter a number of retries for the authentication process. 

 Rekey Interval (1-24 hours)—Enter an interval at which the SSH server's password is 
reset. 

 Authentication Timeout (1-120 seconds)—Enter a timeout value for the authentication 
process. If no response is received before the timeout expires, the authentication process is 
considered a failure. 

 SFTP Server Idle Timeout (1-120 minutes)—Enter an idle time value for the SFTP server. 
With this parameter configured, the SFTP server disconnects from the client with which the 
server does not exchange any packet within the idle time. 

 SFTP Server Enable—Select whether to enable the SFTP server. 

 SSH Server Enable—Select whether to enable the SSH server. 

Set SSH User 

 User Name—Enter an SSH username. 

 Service Type—Select a service type. Options include ALL, Stelnet, and SFTP. 

 Authentication Mode—Select an authentication mode. Options include ALL, Password, 
PublicKey, and PublicKey Password. 

 Public Key—Enter a public key if you selected PublicKey or PublicKey Password as the 
authentication mode. 

 Working Directory—Enter the default working directory if you selected SFTP as the 
service type. 

Config SNMP (v1 or v2c) Param (H3C) 
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 SNMP Type—Select an SNMP version, which can be v1 or v2c. 

 Read-only Community String—Enter the read-only community string, which must be the 
same as what is configured on the device. 

 Read-Write Community String—Enter the read-write community string, which must be the 
same as what is configured on the device. 

Config SNMP (v3) Param (H3C) 

 Group Name—Enter an SNMPv3 group name. 

 Read-View Type—Select an option from the Read-View Type list. Options include 
Included and Excluded. The Included option enables the associated SNMP user to read 
only the nodes that are included in the MIB subtree specified by the MIB SubTree Name 
parameter. The Excluded option enables the associated SNMP user to read only the nodes 
that are excluded from the MIB subtree specified by the MIB SubTree Name parameter. 

 Read-View Name—Enter a name of the read view. 

 MIB SubTree Name—Enter a name of the MIB subtree for the read view. 

 Write-View Type—Select an option from the Write-View Type list. Options include 
Included and Excluded. The Included option enables the associated SNMP user to write 
all nodes that is contained in the MIB subtree specified by the MIB SubTree Name 
parameter. The Excluded option enables the associated SNMP user to write all nodes that 
is excluded from the MIB subtree specified by the MIB SubTree Name parameter. 

 Write-View Name—Enter a name of the write view. 

 MIB SubTree Name—Enter a name of the MIB subtree for the write view. 

 Authentication-Privacy Mode—Select an authentication mode from the 
Authentication-Privacy Mode list. 

 Username—Enter an SNMP username. 

 Authentication Password—Enter an authentication password. 

 Encryption Password—Enter an encryption password. 

Virtual Connect 

Only HPE VC devices support Virtual Connect operations. 

Add Ethernet Network Connection 

 Profile Name—Select the server profile file created on the HPE VC device. This option is 
required. 

 Network—Select the network to which the HPE VC device is assigned. 

 PXE—This parameter allows you to select whether to enable PXE. Options include Use 
BIOS, Enable, and Disable. The default is Use BIOS. 

 Address Type—Select the MAC address type of the NIC or port. Options include 
Factory-Default and User-Defined. If you do not configure this option, the device 
automatically assigns an address string to the NIC or port from a specified address pool. If 
Factory-Default is selected, the device uses the factory-default MAC address. If 
User-Defined is selected, assign a MAC address to the NIC or port by configuring the 
Ethernet MAC or iSCSI MAC parameter. 

 Ethernet MAC—Enter an Ethernet MAC address. If you select User-Defined in Address 
Type, this option is required. 

 iSCSI MAC—Enter a hexadecimal iSCSI MAC address in the format of 
FF-FF-FF-FF-FF-FF. If you select User-Defined in Address Type, this option is required. 

 Speed Type—Select the speed type of the port. Options include Preferred, Auto, and 
Custom. 

 Speed—Set the speed of the port, which must be an integer ranging from 100 to 10000 in 
MBps. This option is required when Custom is selected in Speed Type. 

Delete Ethernet Network Connection 
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 Profile Name—Select the server profile file created on the HPE VC device. IMC deletes 
all Ethernet connections in this file. 

Add FC SAN Connection 

 Profile Name—Select the server profile file created on the HPE VC device. This option is 
required. 

 Fabric—Enter the fabric name created on the HPE VC device. 

 Speed—Select the speed of the port. Options include Auto, 1G, 2G, 4G, 8G, and Disabled. 
The default is Auto. 

 Address Type—Select the WWN address type of the port or node. Options include 
Factory-Default and User-Defined. If you do not configure this option, the device 
automatically assigns a WWN address to the port or node from a specified address pool. If 
Factory-Default is selected, the device uses the factory-default WWN address. If 
User-Defined is selected, assign a WWN address to the port or node by configuring the 
Port WWN or Node WWN parameter. 

 Port WWN—Enter a hexadecimal WWN address for the port, in the format of 
FF-FF-FF-FF-FF-FF-FF-FF. 

 Node WWN—Enter a hexadecimal WWN address for the node, in the format of 
FF-FF-FF-FF-FF-FF-FF-FF. 

Delete FC SAN Connection 

 Profile Name—Select the server profile file created on the HPE VC device. IMC deletes 
all FC connections in this file. 

Add FCoE Connection 

 Profile Name—Select the server profile file created on the HPE VC device. This option is 
required. 

 Fabric—Enter the fabric name created on the HPE VC device. 

 Speed—Select the speed of the port. Options include Auto, 1G, 2G, 4G, 8G, Custom, and 
Disabled. The default is Auto. 

 Custom Speed—Set the speed of the port, which must be an integer ranging from 100 to 
10000 in MBps. This option is available only when Custom is selected in Speed. 

 WWN Type—Select the WWN address type of the port and node. Options include 
Factory-Default and User-Defined. If you do not configure this option, the device 
automatically assigns a WWN address to the port or node from a specified address pool. If 
Factory-Default is selected, the device uses the factory-default WWN address. If 
User-Defined is selected, assign a WWN address to the port or node by configuring the 
Port WWN or Node WWN parameter. 

 Port WWN—Enter a hexadecimal WWN address for the port, in the format of 
FF-FF-FF-FF-FF-FF-FF-FF. 

 Node WWN—Enter a hexadecimal WWN address for the node, in the format of 
FF-FF-FF-FF-FF-FF-FF-FF. 

 MAC Address Type—Select the MAC address type of the NIC or port. Options include 
Factory-Default and User-Defined. If you do not configure this option, the device 
automatically assigns an address string to the NIC or port from a specified address pool. If 
Factory-Default is selected, the device uses the factory-default MAC address. If 
User-Defined is selected, assign a MAC address to the NIC or port by configuring the 
Ethernet MAC parameter. 

 Ethernet MAC—Enter an Ethernet MAC address. If you select User-Defined in Address 
Type, this option is required. 

Delete FCoE Connection 

 Profile Name—Select the server profile file created on the HPE VC device. IMC deletes all 
FCoE connections in this file. 

Add iSCSI Connection 
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 Profile Name—Select the server profile file created on the HPE VC device. This option is 
required. 

 Network—Select the network to which the HPE VC device is assigned. 

 Address Type—Select the MAC address type of the NIC or port. Options include 
Factory-Default and User-Defined. If you do not configure this option, the device 
automatically assigns an address string to the NIC or port from a specified address pool. If 
Factory-Default is selected, the device uses the factory-default MAC address. If 
User-Defined is selected, assign a MAC address to the NIC or port by configuring the 
iSCSI MAC parameter. 

 iSCSI MAC—Enter a hexadecimal iSCSI MAC address in the format of 
FF-FF-FF-FF-FF-FF. If you select User-Defined in Address Type, this option is required. 

 Speed Type—Select the speed type of the port. Options include Preferred, Auto, and 
Custom.  

 Speed—Set the speed of the port, which must be an integer ranging from 100 to 10000 in 
MBps. This option is required when Custom is selected in Speed Type. 

Delete iSCSI Connection 

 Profile Name—Select the server profile file created on the HPE VC device. IMC deletes 
all iSCSI connections in this file. 

Add Server Downlink Port Mapping 

 Profile Name—Select the server profile file created on the HPE VC device. This option is 
required. 

 Port Number—Select the port to map. 

 Network—Select the network to which the HPE VC device is assigned. 

 Uplink Set Name—Select the uplink set created on the HPE VC device. 

 VLAN ID—Enter the ID of the VLAN to which the port belongs, in the range of 1 to 4094. 

 Untagged—This parameter allows you to configure the network whether to process 
packets without VLAN tags. Options include No and Yes and the default is No. 

Delete Server Downlink Port Mapping 

 Profile Name—Select the server profile file created on the HPE VC device. 

 Port Number—Select the port to map. 

 Network—Select the network to which the HPE VC device is assigned. 

 Do one of the following: 

 Click the Copy link next to an operation to copy the operation to create an operation that 
uses the default parameters.  

 Click the Delete link next to an operation to delete the operation.  

You can apply up to 30 operations (including operations of the same name) at a time. If you 
apply more than 30 operations, the copying operation fails, and you cannot enter the next 
configuration procedure. 

14. Click Next to enter the Set Task Attributes page. 

15. Enter a name for this task in the Task Name field. 

16. Select the type of deployment schedule you want to apply to this task from the Schedule Type 
list.  

17. Do one of the following: 

 If you want IMC to execute this task one time, select Once and go to step 19.  

 If you want this configuration deployment task to be executed on a scheduled basis, select 
Cycle and go to step 20. 

18. If you select Once in the Schedule Type field, do the following: 
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a. Select the time you want IMC to execute this task from the Schedule Time list. Options 
include Scheduled and Immediately. With the Immediately option selected, IMC 
immediately executes this task after the task is designated. With the Scheduled option 
selected, IMC executes this task in the specified time. 

b. Do one of the following: 

 If you selected Immediately, go to step 21. 

 If you selected Scheduled, click the field to populate the date and time for the execution 
of this task. A popup calendar is displayed, select the date from the calendar. 

c. Go to step 21. 

19. If you selected Cycle from the Schedule Type list, do the following: 

a. Select the frequency with which you want IMC to execute this task from the Operation 
Frequency list. 

b. If you selected Every Week from the Operation Frequency list, select the date of the week 
you want IMC to execute this task from the list next to the Operation Frequency list and go 
to Step d. 

c. If you selected Every Month from the Operation Frequency list, select the day of the 
month you want IMC to execute this task from the list next to the Operation Frequency list 
and go to Step e. 

d. Enter the time you want IMC to execute this task in the field to the far right of the Operation 
Frequency list. Enter the time in HH:MM:SS format where HH denotes a two digit hour 
value, MM denotes a two digit minute value and SS denotes a two digit second value. 

e. Enter the beginning date and time you want IMC to execute this task in the Start Time field. 
Click the field to populate the date and time for the execution of this task. A popup calendar 
is displayed. Select the start date from the calendar. 

f. Enter the ending date and time you want IMC to execute this task in the End Time field. 
Click the field to populate the date and time for the execution of this task. A popup calendar 
is displayed. Select the end date from the calendar. 

20. Define how you want IMC to handle errors that arise in the deployment process, by selecting 
one of the following:  

 If you want IMC to continue the deployment for the device if an error arises during 
deployment, select Continue deployment on the current device from the Error Handling 
list.  

 If you want IMC to abandon the deployment for the device if an error arises during 
deployment, select Stop deployment on the current device from the Error Handling list. 

21. Click OK. 

Using batch mode to configure interfaces 

By creating a batch interface configuration plan, you can configure multiple interfaces in batch. You 
can configure a batch interface configuration plan according to the requirements of each component. 
In a practical service that involves multiple component operations, you can create a batch interface 
configuration plan to apply the integrated operations.  

To configure interface using batch mode: 

1. Navigate to the Deployment window: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click the Batch Operation link under Resource Management on the left navigation tree. 

2. Click the Interface Configuration Guide link from the Batch Operation page. 

The Deployment window opens. 

3. To expand the batch operations in Device Configuration section to access the Interface 
Configuration Wizard option. 
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4. Click the Expand icon  to the left of Device Configuration. 

5. Click Add under the Operation List.  

The Select Operations window opens. 

6. Click  to expand all operations. Click  to collapse all operations.  

7. Click  to the left of an operation type to expand all operations of this type, and click  to 
collapse all operations of this type.  

After you deploy the components that the batch operations support, the batch operations are 
displayed on the following operation list, which takes the VLAN component for example. 

8. Select the parameters.  

9. Select a type to select all operations of this type.  

The operation include Add Ports to VLAN, Delete ports from VLAN, Modify Access Port 
PVID, Add Hybrid Port, Delete Hybrid Port, Modify Hybrid Port, Add Trunk Port, Delete 
Trunk Port, Modify Trunk Port, Bring Up/Shut Down Interface, Enable/Disable 802.1X, 
and Enable/Disable MAC Binding. If you have installed other service components, the 
corresponding operations are displayed.  

10. Click OK.  

11. Confirm that the operations you have selected now are displayed in the Operation List. 

12. To reorder the parameters in the operation list using the icons located in the Sort field:  

 Use  to move the parameter up one position. 

 Use  to move the parameter to the top of the parameter list. 

 Use  to move the parameter down one position. 

 Use  to move the parameter to the bottom of the list. 

13. Click the Delete icon  in the Delete field to delete the association operation. 

14. Click Add under the Interface List to select the interfaces to which to apply this batch mode 
operation.  

You can add interfaces using either the View or Advanced query option. Add interfaces by 
using the same process as adding devices. See "Adding devices by view" and "Adding devices 
by advanced query." 

When you select a custom view in the By View tab and then click the Advanced tab , IMC 
automatically populates the View Name field with the name of the custom view. This helps you 
quickly locate a custom view and query target interfaces in the custom view. 

15. Click Next.  

The Configure Parameters page opens. 

16. Configure the following parameters: 

Add ports to VLAN 

 VLAN ID—Select a VLAN ID in the list. The VLANs in the VLANs are the intersection of all 
VLANs on the devices.  

Delete port from VLAN 

 VLAN ID—Select the VLAN ID you want to delete from the interfaces in the list. 

Modify Access Port PVID 

 Destination PVID—Select a VLAN in the list as the PVID of the port.  

Add Hybrid Port 

 PVID—Enter the PVID for the ports. 

 Tagged VLAN—Enter the tagged VLAN IDs. 

 Enable Untagged VLAN—Specify whether to enable the untagged VLAN feature.  
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 Untagged VLAN—Enter the untagged VLAN IDs if you have enabled the untagged VLAN 
feature.  

 Enable Forbidden VLAN—Specify whether to enable the forbidden VLAN feature. If you 
enable the feature, you can prevent the hybrid port from being assigned to the specified 
VLAN.  

 Forbidden VLAN—Enter the forbidden VLAN IDs.  

Modify Hybrid Port 

 PVID—Enter the port VLAN ID (PVID). 

 Tagged VLAN—Enter the tagged VLAN IDs. 

 Enable Untagged VLAN—Specify whether to enable the untagged VLAN feature.  

 Untagged VLAN—Enter the untagged VLAN IDs if you have enabled the untagged VLAN 
feature.  

 Enable Forbidden VLAN—Specify whether to enable the forbidden VLAN feature. If you 
enable the feature, you can prevent the hybrid port from being assigned to the specified 
VLANs.  

 Forbidden VLAN—Enter the forbidden VLAN IDs. 

Add Trunk Port 

 PVID—Enter the PVID of the trunk port.  

 Allowed VLAN—Enter the VLAN IDs allowed on the trunk port.  

Modify Trunk Port 

 PVID—Enter the PVID of the trunk port.  

 Allowed VLAN—Enter the VLAN IDs allowed on the trunk port.  

When you configure multiple devices at a time, the VLAN IDs available for selection are the 
intersection of the VLANs of all devices. 

Bring Up/Shut Down Interface 

 Operation—Select a Bring Up or Bring Down from the list. 

Enable/Disable 802.1X 

 Operation—Select Enable or disable from the list. 

Enable/Disable MAC Binding 

 Operation—Select Enable or disable from the list.  

17. Click the Set icon  for an operation and select Copy from the shortcut menu to copy the 

operation to create a new operation, which uses the default parameters. Click the Set icon 
for an operation and select Delete from the shortcut menu to delete the operation. 

You can apply up to 30 operations (including operations of the same name) at a time. If you 
apply more than 30 operations, the copying operation fails, and you cannot enter the next 
configuration procedure 

18. Click Next to enter the Set Task Attributes page. 

19. Enter a name for this task in the Task Name field. 

20. Select the type of deployment schedule you want to apply to this task from the Schedule Type 
list: 

 Select Once if you want IMC to execute this task one time.  

 Select Cycle if you want this configuration deployment task to be executed on a scheduled 
basis. 

21. If you select Once in the Schedule Type field, complete the following steps.  

Select the time you want IMC to execute this task from the Schedule Time list. Options include 
Scheduled and Immediately. 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 8806



405 

a. If you selected Scheduled, click the field to populate the date and time for the execution of 
this task. 

A popup calendar is displayed. 

b. Select the date from the calendar. 

22. If you selected Cycle from the Schedule Type list, complete the following steps. 

a. Select the frequency with which you want IMC to execute this task from the Operation 
Frequency list. 

b. If you selected Every Week from the Operation Frequency list, select the date of the week 
you want IMC to execute this task from the list next to the Operation Frequency list. 

c. If you selected Every Month from the Operation Frequency list, select the day of the 
month you want IMC to execute this task from the list next to the Operation Frequency list. 

d. Enter the time you want IMC to execute this task in the field to the far right of the Operation 
Frequency list.  

e. Enter the time in HH:MM:SS format where HH denotes a two digit hour value, MM denotes 
a two digit minute value and SS denotes a two digit second value. 

f. Enter the beginning date and time you want IMC to execute this task in the Start Time field.  

g. Click the field to populate the date and time for the execution of this task.  

A popup calendar is displayed.  

h. Select the start date from the calendar. 

i. Enter the ending date and time you want IMC to execute this task in the End Time field.  

j. Click the field to populate the date and time for the execution of this task. A popup calendar 
is displayed.  

k. Select the end date from the calendar. 

23. Do one of the following to define how you want IMC to handle errors that arise in the 
deployment process:  

 If you want IMC to continue the deployment for the device if an error arises during 
deployment, select Continue deployment on the current device from the Error Handling 
list.  

 If you want IMC to abandon the deployment for the device if an error arises during 
deployment, select Stop deployment on the current device from the Error Handling list. 

24. Click OK. 

Managing device routes 
IMC allows you to view the routing tables of managed devices and display routes that meet certain 
conditions.  

To view routes of devices; 

1. Navigate to Resources > Add Device: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Device Routes under Resource Management on the left navigation tree. 

The Device Routes page lists all device routes. Each route has a mask, device label, interface 
description, destination address, next hop address, route type, and routing protocol. 

2. If there are a large number of routes, you can use the query section at the top right corner of the 
page to display only the routes you want to view. You can filter routes by device IP, destination 
IP, or next hop address. 

3. If the Device Routes List spans multiple pages, use the following aids to navigate the list: 
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 Click  to page forward in the Device Routes List. 

 Click  to page forward to the end of the Device Routes List. 

 Click  to page backward in the Device Routes List. 

 Click  to page backward to the front of the Device Routes List. 

4. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

Managing device and interface maintenance tag 
tasks 

You can tag devices or interfaces that need maintenance by adding the devices or interfaces to 
maintenance tag tasks. Alarms generated for devices or interfaces that have maintenance tags will 
include maintenance tag information, and will not be displayed as real-time alarms. 

View the maintenance tag task list 
1. Click the Resource tab. 

2. From the navigation tree, select Resource > Resource Management > Maintenance Task. 

The Maintenance Tag Task page opens. The page includes the device maintenance tag task 
and interface maintenance tag task lists and the device maintenance tag task list is displayed 
by default. Both the device maintenance tag task and interface maintenance tag task lists have 
Status, Result, Name, Schedule Type, Start Time, End Time, and Created by columns. To 
view details of a maintenance tag task, click the maintenance tag task name. The details page 
includes basic maintenance tag task information and the devices or interfaces on which the task 
is executed. 

Adding a maintenance tag task 
1. Access the Maintenance Tag Task page. 

The page displays the device maintenance tag task list by default. To display the interface 
maintenance tag task list, click the Interface Maintenance Tag Task tab. 

2. Click Add. 

The page for adding a device or interface maintenance tag task opens. 

3. Enter the maintenance tag task name. 

4. Select a schedule type from the Schedule Type list: 

 To execute the maintenance tag task only once: 

 Select Once. 

 Configure the Execution Time field. 

You can enter a date in the format of YYYY-MM-DD hh:mm:ss, or click the textbox next 
to the Execution Time field and then select the time on the calendar that is displayed. 

 To execute the maintenance tag task at the specified interval: 

 Select Cycle. 

 Configure Start Time, End Time, and Execution Time fields. 
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You can enter a date in the format of YYYY-MM-DD hh:mm:ss, or click textboxes next to 
Start Time, End Time and Execution Time fields and then select time on the 
calendars. 

 Configure the Execution Interval field. 

5. Enter the maintenance tag description in the Description field. 

6. Add devices or interfaces to the maintenance tag task: 

a. Click Add. 

b. On the page that opens, select devices or interfaces. 

You can add devices by using either the View or Advanced query option. For more 
information, see "Adding devices by view" and "Adding devices by advanced query." 

To remove all selected devices or interfaces from the device or interface list, click Remove All. 
To remove a single selected device or interface from the device or interface list, click the Delete 

icon  for the device or interface. 

7. Click OK. 

Modifying a maintenance tag task 
1. Access the Maintenance Tag Task page. 

The page displays the device maintenance tag task list by default. To display the interface 
maintenance tag task list, click the Interface Maintenance Tag Task tab. 

2. Click the Modify icon  for a maintenance tag task. 

The page for modifying a device or interface maintenance tag task opens. 

3. Modify maintenance tag task parameters as needed. 

The maintenance tag task name cannot be modified. For more information about modifying the 
other parameters, see "Adding a maintenance tag task." 

4. Click OK. 

Stopping a maintenance tag task 
1. Access the Maintenance Tag Task page. 

The page displays the device maintenance tag task list by default. To display the interface 
maintenance tag task list, click the Interface Maintenance Tag Task tab. 

2. Click the Stop icon  for a maintenance tag task.  

After the maintenance tag task is stopped, the following rules apply:  

 Devices or interfaces for which the task has been completed keep unchanged.  

 The task continues to be executed for device or interfaces for which the task is being 
executed.  

 The task will not be executed for devices or interfaces for which the task has not started. 

Copying a maintenance tag task 
1. Access the Maintenance Tag Task page. 

The page displays the device maintenance tag task list by default. To display the interface 
maintenance tag task list, click the Interface Maintenance Tag Task tab. 

2. Click the Copy icon  for a maintenance tag task to copy the task.  

3. The parameters (including the basic information and device list) of the maintenance tag task are 
automatically copied. Modify the maintenance tag task name, modify the other parameters as 
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needed, and click OK. For more information about modifying the other parameters, see "Adding 
a maintenance tag task." 

The process of copying a maintenance tag task equals clicking the Add button and then 
entering maintenance tag task parameters, and does not affect the existing data. Therefore, no 
operation log is recorded for the copying operation. 

Deleting a maintenance tag task 
1. Access the Maintenance Tag Task page. 

The page displays the device maintenance tag task list by default. To display the interface 
maintenance tag task list, click the Interface Maintenance Tag Task tab. 

2. Click the Delete icon  for a maintenance tag task. 

The confirmation dialog box opens. 

3. Click OK. 

If you delete an executing maintenance tag task, the maintenance tags of the devices in the task are 
automatically removed. 

Viewing the maintenance records 
1. Click the Resource tab.  

2. From the navigation tree, select Resource Management > Maintenance Records.  

By default, the Device Maintenance Records tab is displayed. You can switch to the Interface 
Maintenance Records or Link Maintenance Records tab as needed.  

3. View the device, interface, or link maintenance record list. Click Query to query records based 
on criteria.  

 Device Maintenance Records—Records history maintenance tag adding information of 
managed devices. Records are generated when a maintenance tag is added to a device 
through the maintenance tag adding function in a maintenance tag task, on the device 
details page, or on the topology. 

 IP Address—IP address of the device with a maintenance tag. 

 Device Category—Category of the device with a maintenance tag. 

 Description—Description of adding a maintenance tag to the device. 

 Start Time—Start time of adding a maintenance tag to the device. 

 End Time—End time of adding a maintenance tag to the device. If this field is empty, a 
maintenance tag is being added to the device. 

 Interface Maintenance Records—Records the history maintenance tag adding 
information of managed device interfaces. The interface maintenance records contain 
information about adding maintenance tags to device interfaces through maintenance tag 
tasks and through the maintenance tag adding function on the interface details page. When 
a maintenance tag is added to an interface that acts as the left or right interface of a link, a 
maintenance tag is also added to the link, and the link maintenance information is recorded. 

 Interface Description—Description of the interface with a maintenance tag. 

 Device IP—IP address of the device where the interface resides. 

 Interface Alias—Name that the user specifies for the interface. By default, the interface 
alias is the same as the interface description. 

 Maintenance Description—Description of adding a maintenance tag to the interface. 

 Start Time—Start time of adding a maintenance tag to the interface. 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 8810



409 

 End Time—End time of adding a maintenance tag to the interface. If this field is empty, 
a maintenance tag is being added to the interface. 

 Link Maintenance Records—Records the history maintenance tag adding information of 
links in the topology. When a maintenance tag is added to an interface that acts as the left or 
right interface of a link, a maintenance tag is also added to the link, and the link 
maintenance information is recorded. 

 Link Name—Name of the link. If you do not specify a name for a link, the link is named 
in the format of Left interface device IP-right interface device IP. 

 Left Interface Device Label—Label of the device where the left interface resides. 

 Left Interface Description—Description of the left interface of the link. If this field is 
empty, it means that the left interface is not selected when the link is added. 

 Right Interface Device Label—Label of the device where the right interface resides. 

 Right Interface Description—Description of the right interface of the link. If this field is 
empty, it means that the right interface is not selected when the link is added. 

 Maintenance Description—Description of adding a maintenance tag to the link. 

 Start Time—Start time of adding a maintenance tag to the link. 

 End Time—End time of adding a maintenance tag to the link. If this field is empty, a 
maintenance tag is being added to the link. 

Managing multiple devices from the device list 
From the Device List page, IMC offers you the ability to manage and unmanage, synchronize, 
refresh and deploy batch operations for one or more devices. In addition, the Device List offers quick 
access to batch operations for SNMP, Telnet, SSH, Poll configurations, rebooting, saving and 
backing up configurations and deploying software.  

All of these options can be performed from the Device List. Device lists can be accessed from the 
Device View, the IP View, and Custom Views simply by clicking the device, IP, or custom group. 

Navigating to the device list 
The features that enable you to manage multiple devices are available from the Device List. The 
Device List can be accessed from the Device View, the IP View, and the Custom View.  

Navigating to the device list from the device view 

1. Navigate to Resource > View Management > View-<Device Type>: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click View Management on the left navigation tree. 

c. Point to Device View under View Management on the left navigation tree.  

A floating menu of categorized device views is displayed. 

2. Click the category of device view you want to access. 

The Device List for the device category you selected is displayed. 

3. Click Device View from the navigation system for the Device List for all devices.  

Navigating to the device list from the IP view 

1. Navigate to Resource > IP View > Subnet-<Subnet IP Address>: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click View Management on the left navigation tree. 

c. Point to IP View under View Management on the left navigation tree. 
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A floating menu of all IP views is displayed. 

d. Click the IP subnet view you want to access. 

The Device List for the IP subnet you selected is displayed.  

IMC displays all devices in the IP View in the Device List displayed in the main pane of the 
IP View window. 

Navigating to the device list from a custom view 

1. Navigate to Resource > Custom View > <View Name>: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click View Management on the left navigation tree. 

c. Point to Custom View under View Management on the left navigation tree. 

A floating menu of all custom views is displayed. 

2. Click the custom view you want to access.  

The Device List for the custom view you selected is displayed. IMC displays all devices in the 
Custom View in the Device List displayed in the main pane of the Custom View. 

Device list management options 
From the Device List, you can add, remove, delete, manage, and unmanage devices as well as 
synchronize and refresh data for device details. In addition, you can select one or more devices from 
the Device List and then launch batch operations for configuring SNMP, Telnet, and SSH settings as 
well as checking Telnet and SSH settings.  

You can also launch batch operations for one or more devices from the Device List for configuring 
status and configuration polling intervals, rebooting devices, saving device configurations, deploying 
software, and backing up configurations. 

Add 

This feature, available only for Custom View Device Lists, allows you to add devices that already 
exist in IMC to the current Custom View.  

To add a device to the current custom view: 

1. Navigate to the Custom View to which you want to add devices. 

For information about navigating to a Device List from a custom view, see "Navigating to the 
device list from a custom view." 

2. Click Add from the selected custom view's Device List. 

3. Add devices by using either the View or the Advanced query option.  

For more information, see "Adding devices by view" and "Adding devices by advanced query." 

4. Click OK. 

5. Confirm that the devices now are displayed in the custom view Device List. 

Remove 

This feature, available only from Custom View Device Lists, allows you to remove devices from the 
current Custom View. The Remove feature is only available for Custom Views and only from the 
Device List level of a Custom View.  

To remove a device from the current custom view: 

1. Navigate to the Custom View that you want to remove devices from. 

For information about navigating to a Device List from a custom view, see "Navigating to the 
device list from a custom view." 

2. Select the devices you want to remove from the selected custom view's Device List.  
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For information about navigating to a Device List, see "Navigating to the device list from a 
custom view." 

3. Click Remove to remove the devices from the selected custom view's Device List. 

4. Click OK to confirm the removal of the selected devices from the custom view. 

Delete 

 CAUTION: 

You cannot recover a device or associated data once you have deleted it. Use this feature with 
caution. 
 

Delete the selected devices from IMC. IMC purges all data associated with the deleted devices 
immediately. The Delete feature is only available for Device Views and IP Views.  

To delete devices from the current view: 

1. Navigate to a Device List that contains the devices that you want to delete.  

For information about navigating to a Device List, see "Navigating to the device list." 

2. Select the devices you want to delete from a Device View or IP View Device List. 

3. Click Delete to manage the selected devices. 

4. Review the results of the operation in the Device List page. 

Manage 

Managing a device enables all relevant IMC management, monitoring, and reporting features to be 
applied to the selected devices. Managing a device therefore consumes IMC node licenses.  

To manage devices from the current view: 

1. Navigate to a Device List that contains the devices that you want to manage.  

For information about navigating to a Device List, see "Navigating to the device list." 

2. Select the devices you want to manage from the selected view's Device List.  

3. Click Manage to manage the selected devices. 

4. Review the results of the operation in the Device List page. 
 

 NOTE: 

For a current license count, click the About icon  in the upper right corner of IMC. 
 

Unmanage 

Unmanaging a device disables all relevant IMC management, monitoring, and reporting features 
from the selected devices. Unmanaged devices also need IMC node licenses.  

To unmanage devices from the current view: 

1. Navigate to a Device List that contains the devices that you want to unmanage.  

For information about navigating to a Device List, see "Navigating to the device list." 

2. Select the devices you want to unmanage from the selected view's Device List.  

3. Click Unmanage to unmanage the selected devices. 

4. Review the results of the operation in the Device List page.  

Unmanaging devices does not remove them from views nor does it delete the devices from 
IMC.  

To remove devices from custom views, see "Remove." 

To delete devices from IMC, see "Delete." 
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Synchronize 

With the Synchronize option, you can update IMC views with current data for the selected devices. 
When an operator uses the Synchronize option, IMC queries the selected device and then updates 
the current page with any updated information.  

To synchronize devices from the current view: 

1. Navigate to a Device List that contains the devices that you want to synchronize.  

For information about navigating to a Device List, see "Navigating to the device list." 

2. Select the devices you want to synchronize from the selected view's Device List. 

3. Click Synchronize to synchronize the selected devices. 

4. Review the results of the operation in the Device List page. 

5. Click Refresh to update the current page with current information from the Synchronize 
process. 

Refresh 

With the Refresh option, you can reload the current Device List page and capture any updates to 
device details or other dynamic data found on this page. This feature is particularly useful when you 
use the Synchronize option to query the selected device for updated information.  

To refresh devices from the current view: 

1. Navigate to a Device List that contains the devices that you want to refresh.  

For information about navigating to a Device List, see "Navigating to the device list." 

2. Select the devices you want to refresh from the selected view's Device List. 

3. Click Refresh to refresh the selected devices.  

The refreshed page opens. 

SNMP settings 

From the Device List, you can easily and quickly access IMC's batch operations feature for 
configuring SNMP settings for one or more devices.  

To access IMC's Batch Operation for SNMP settings for devices from the Device List: 

1. Navigate to a Device List that contains the devices for which you want to configure SNMP 
settings.  

For information about navigating to a Device List, see "Navigating to the device list." 

2. Select the devices you want to manage the SNMP settings for from the selected view's Device 
List. 

3. Click More. 

4. Select Parameter Settings > SNMP Settings from the list.  

The Resource > Batch Operation > SNMP Settings page opens. 

5. Configure and apply the SNMP settings for batch mode operation.  

For information about using batch operations in to configure multiple devices, see "Using batch 
mode to configure SNMP settings." 

Telnet settings 

From the Device List, you can easily and quickly access IMC's batch operations feature for 
configuring Telnet settings for one or more devices.  

To access IMC's Batch Operation for Telnet settings for devices from the Device List: 

1. Navigate to a Device List that contains the devices for which you want to configure Telnet 
settings.  

For information about navigating to a Device List, see "Navigating to the device list." 
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2. Select the devices you want to manage the Telnet settings for from the selected view's Device 
List. 

3. Click More. 

4. Select Parameter Settings > Telnet Settings from the list.  

The Resource > Batch Operation > Telnet Settings page opens. 

5. Configure and apply the Telnet settings for batch mode operation.  

For information about using batch operations to configure Telnet settings on multiple devices, 
see "Using batch mode to configure Telnet settings." 

SSH settings 

You can also easily and quickly access IMC's batch operations for configuring SSH settings directly 
from the Device List.  

To configure IMC's SSH settings for devices from the Device List using batch operations: 

1. Navigate to a Device List that contains the devices for which you want to configure SSH 
settings.  

For information about navigating to a Device List, see "Navigating to the device list." 

2. Select the devices you want to manage the SSH settings for from the selected view's Device 
List. 

3. Click More. 

4. Select Parameter Settings > SSH Settings from the list.  

The Resource > Batch Operation > SSH Settings page opens. 

5. Configure and apply the SSH Settings for batch mode operation.  

For information about using Batch Operations to configure SSH settings on multiple devices, 
see "Using batch mode to configure SSH settings." 

Poll interval settings 

You can also modify configuration and status poll settings on managed devices using IMC batch 
operations feature accessed from the Device List.  

To configure IMC's configuration and status poll settings for devices from the Device List using 
batch operations: 

1. Navigate to a Device List that contains the devices for which you want to configure 
configuration and status polling settings.  

For information about navigating to a Device List, see "Navigating to the device list." 

2. Select the devices you want to manage the poll configurations for from the selected view's 
Device List. 

3. Click More. 

4. Select Parameter Settings > Poll Interval Settings from the list.  

The Resource > Batch Operation > Poll Interval Settings page opens. 

5. Configure and apply the Poll Interval Settings for batch mode operation.  

For information about using Batch Operations to configure polling intervals on multiple 
devices, see "Using batch mode to configure polling intervals." 

Check access settings 

You can also check SNMP settings, Telnet settings and SSH settings on managed devices by using 
IMC's batch operations feature accessed from the Device List.  

To check IMC's access settings for devices from the Device List using batch operations: 

1. Navigate to a Device List that contains the devices for which you want to check access 
settings.  

For information about navigating to a Device List, see "Navigating to the device list." 
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2. Select the devices you want to manage the access settings for from the selected view's Device 
List. 

3. Click More. 

4. Select Check Access Settings from the list.  

The Resource > Batch Operation > Check Access Settings page opens. 

5. Configure and apply the Check Access Settings for batch mode operation.  

For information about using Batch Operations to configure SSH settings on multiple devices, 
see "Using batch mode to configure SSH settings." 

Reboot device 

You can also reboot one or more devices using IMC's batch operations feature accessed from the 
Device List.  

To reboot one or more devices from the Device List using batch operations: 

1. Navigate to a Device List that contains the devices that you want to reboot.  

For information about navigating to a Device List, see "Navigating to the device list." 

2. Select the devices you want to reboot from the selected view's Device List. 

3. Click More. 

4. Select Reboot Device from the list.  

The Resource > Batch Operation > Reboot Device page opens. 

5. Configure and apply the Reboot Device settings for batch mode operation.  

For information about using Batch Operations to reboot multiple devices, see "Using batch 
mode to reboot devices." 

Save configuration 

You can also save the configurations of one or more managed devices using IMC's batch operations 
feature accessed from the Device List. This function is equivalent to executing the Save command 
on devices. 

To save the configuration for one or more devices from the Device List using batch operations: 

1. Navigate to a Device List that contains the devices that you want to save the configuration of.  

For information about navigating to a Device List, see "Navigating to the device list." 

2. Select the devices you want to save the configuration for from the selected view's Device List. 

3. Click More. 

4. Select Save Configuration from the list.  

The Resource > Batch Operation > Save Configurations page opens. 

5. Configure and apply the Save Configuration settings for batch mode operation.  

For information about using Batch Operations to save the configuration of multiple devices, 
see "Using batch mode to save device configurations." 

Add to Device Group 

You can add devices to different device groups to aid management. 

To add one or more devices to a device group: 

1. Navigate to a Device List that contains the devices that you want to monitor. 

For information about navigating to a Device List, see "Navigating to the device list." 

2. Select the devices you want to add to a device group from the selected view's Device List. 

3. Click More. 

4. Select Add to Device Group from the list. 

The System > Device Group > Join Group page opens. 
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5. Select a device group in the Target Device Groups area. 

6. Click OK. 

The selected devices are added to the selected device group. 

Add monitor 

You can also monitor one or more devices from the Device List.  

To monitor one or more devices from the Device List: 

1. Navigate to a Device List that contains the devices that you want to monitor.  

For information about navigating to a Device List, see "Navigating to the device list." 

2. Select the devices you want monitor from the selected view's Device List. 

3. Click More. 

4. Select Device Monitor > Add Monitor from the list.  

The Resource > Batch Operation > Add Monitor dialog box opens. 

5. Configure and apply the Add Monitor settings for batch mode operation.  

For information about using Add Monitor to monitor multiple devices, see "Adding a monitor." 

Cancel monitor 

You can also cancel monitor to one or more devices from the Device List.  

To cancel monitor to one or more devices from the Device List: 

1. Navigate to a Device List that contains the devices for which you want to cancel monitor.  

For information about navigating to a Device List, see "Navigating to the device list." 

2. Select the devices you want cancel monitor from the selected view's Device List. 

3. Click More. 

4. Select Device Monitor > Cancel Monitor from the list.  

The Cancel Monitor dialog box opens. 

5. Click OK to cancel monitoring the selected devices. 

For information about using Batch Operations to cancel monitor to multiple devices, see 
"Deleting a monitor." 

Deploy software 

You can also deploy software to one or more devices using IMC's configuration center features 
directly from the Device List.  

To deploy software to one or more devices from the Device List: 

1. Navigate to a Device List that contains the devices to which you want to deploy software.  

For information about navigating to a Device List, see "Navigating to the device list." 

2. Select the devices you want to deploy software to from the selected view's Device List. 

3. Click More. 

4. Select Deploy Software from the list.  

The Resource > Batch Operation > Deploy Software page opens. 

5. Configure and apply the Deploy Software settings for batch mode operation.  

For information about deploying software in IMC using IMC's configuration center, see 
"Deploying configurations and software by using IMC deployment guide." 

Backup configuration 

You can also back up device configurations for one or more devices using IMC's configuration center 
features directly from the Device List.  

To back up device configurations for one or more devices from the Device List: 
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1. Navigate to a Device List that contains the devices for which you want to back up the 
configuration.  

For information about navigating to a Device List, see "Navigating to the device list." 

2. Select the devices you want to back up the configuration of from the selected view's Device 
List. 

3. Click More. 

4. Select Backup Configuration from the list.  

IMC initiates the backup request upon selection of this menu option. IMC also updates the page 
with the Configuration File Backup Results. 

For information about backing up device configurations in IMC using IMC configuration center, 
see "Managing automatic backup plans." 

Data Collection 

You can enter the data collection settings page to collect data of selected devices and store collected 
data to a specified location. 

To configure data collection for one or more devices: 

1. Navigate to a Device List that contains the devices for which you want to collect data. 

For information about navigating to a Device List, see "Navigating to the device list." 

2. Select the devices you want to collect data from the selected view's Device List. 

3. Click More. 

4. Select Data Collection. 

The System > Data Collection page opens. 

5. Set the data collection parameters.  

For more information, see "Configuring data collection." 

LiveUpdate 

You can access the LiveUpdate window quickly by using this function. 

To quickly access the LiveUpdate window: 

1. Navigate to a Device List that contains the devices for which you want to perform LiveUpdate. 

For information about navigating to a Device List, see "Navigating to the device list." 

2. Click More. 

3. Select LiveUpdate. 

The LiveUpdate - Type Selection dialog box opens. For more information, see "LiveUpdate." 

Device configuration guide 

You can configure VLANs or other settings on devices in batch using the device configuration guide 
feature directly from the Device List.  

To configure for one or more devices from the Device List: 

1. Navigate to a Device List that contains the devices for which you want to use the device 
configuration guide.  

For information about navigating to a Device List, see "Navigating to the device list." 

2. Select the devices for which you want to back up the configuration in the selected view's Device 
List. 

3. Click More. 

4. Select Device Configuration Guide from the list.  

The Device Configuration Guide window opens. Select an operation and set the operation 
parameters and task attributes. Then IMC deploys the configurations to the target devices 
according to the task. 
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For more information about the device configuration guide feature, see "Using batch mode to 
configure devices." 

Exporting a device list 

The custom view and device view pages provide the function of exporting the device list. You can 
select one or more devices as needed, and export their information into a device list and save the list 
locally.  

To export a device list: 

1. Enter the custom view or device view page. View the device list.  

For information about navigating to a Device List, see "Navigating to the device list." 

2. Select one or more devices on the device list and click Export Excel.  

3. On the window that opens, click Download Exported Data to export information of selected 
devices into an Excel file and save the file locally. If you do not select any devices, information 
of all devices on the device list is exported.  

Exporting the device additional information 

The device view page provides the function of exporting the additional information of one or more 
devices. When the device additional information list is empty, the Export Device Additional 
Information button is hidden. To add device additional information, click System Management in 
the upper right corner and select Device Additional Information to add device additional 
information. Then, the Export Device Additional Information button appears after you refresh the 
device view page. If you have not customized the device additional information on the device details 
page, the exported device additional information contains the default values on the System 
Management > Device Additional Information page.  

For more information about configuring device additional information, see "Device additional 
information." 

To export the device additional information: 

1. Enter the device view page. View the device list.  

For information about navigating to a Device List, see "Navigating to the device list from the 
device view" 

2. Select one or multiple devices on the device list, and click Export Device Additional 
Information to export the additional information of selected devices to a file and save the file 
locally. 

Terminal access 
IMC lets you manage IP address resources in IMC. You can track, locate, allocate, and bind desktop 
IP addresses to network access resources. While the primary focus of IP address management in 
IMC is the desktop servers, printers and other devices can also be tracked using the IMC Terminal 
Access features.  

The purpose of allocating and binding IP addresses in IMC is to enable IMC to track its intended use, 
such as when an operator binds a terminal to some interfaces or an interface to some terminal and to 
alarm when its use has changed. Allocating and binding IP addresses to network access devices is 
done in IMC only, not on the device itself.  

To support effective IP address management, IMC lets you add IP addresses to the IMC database 
and centrally manage their allocation and binding. You can manually add IP addresses or they can 
be added automatically using the IMC auto scan feature. In addition, you can define IP segments 
based on departments or work areas.  

IMC lets you manage the allocation of IP addresses for reporting and alarming purposes. When an 
operator assigns an IP address to a device in IMC, it tracks that assignment and reports on any 
changes to the assignment. This feature provides visibility into which IP addresses have been 
assigned, and when unauthorized uses of IP addresses occur.  
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IMC also supports the ability to bind terminal resources for security purposes. You can bind an IP 
address to a MAC address. In addition, you can bind a terminal to some interfaces. Binding IP 
addresses enables IMC to track IP and MAC address usage to a specific resource and to proactively 
notify you when that resource is not used in the way it was intended.  

You can bind IP addresses to MAC addresses manually or they can use the auto-scanning feature. 
With this feature, IMC identifies IP address and MAC address combination pairs, in which you then 
can selectively apply binding.  

With terminal access binding and switch access binding, you can link the MAC address of an end 
device to an interface on an access device. This enables IMC to identify when a device has been 
moved or when a new device is accessing the network through an interface not assigned to it.  

IMC also lets you locate IP or MAC addresses in the network infrastructure. This feature is useful for 
pinpointing to which access device a particular user is located when some information about the user 
is known. This is useful both for troubleshooting network issues and tracking down security problems 
in the network infrastructure. 

Allocating IP addresses 
IMC lets you manage the allocation of IP addresses for reporting and alarming purposes. You can 
add an IP segment and perform an auto scan for or assign IP addresses to the IP segment. You can 
create child IP segments under an IP segment, and can build an IP segment structure of at most five 
levels. You can perform a global auto scan, and then IMC automatically adds the IP addresses to 
existing IP segments. If the IP addresses do not belong to any existing IP segment, IMC adds them 
to the system default IP segment.  

In addition, you can batch import IP addresses to IMC from a file, such as the IP address file of a 
DHCP server. The following information provides you with information on the IMC IP address 
allocation features. 

Viewing the IP segment list 

IMC provides you with the ability to view existing IP address allocations.  

To view IMC existing IP address allocations: 

1. Navigate to Resource > IP Address Allocation: 

2. Click the Resource tab from the top tabular navigation system. 

3. Click Terminal Access on the left navigation tree. 

4. Click IP Address Allocation under Terminal Access on the left navigation tree.  

The IP Segment List is displayed. 

IP Segment List 

 IP Segment—Contains the IP segments that have been created. The IP segment serves as 
an active link to display allocated IP list of the IP segment. 

 Owner—Contains the owner's name of the IP segment. 

 Description—Contains a description of the IP segment. 

 Percent of Allocated IPs—Contains the percentage that the allocated IP addresses takes 
in the whole IP segment. 

 Operation—Contains links including Add Child IP Segment, Modify, Restore, Details, 
Auto Scanning, and Idle IP Detection. 

To customize columns for the IP segment list, click Customize Columns in the list and select 
the column names you want to display in the dialog box that opens. You can customize the 
following column names: 

 IP Count—Number of IP addresses the IP segment contains. 

 Assigned IP Count—Number of assigned IP addresses in the IP segment. 

 Unassigned IP Count—Number of unassigned IP addresses in the IP segment. 
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 Online IP Count Today—Number of today's online IP addresses in the IP segment. 

 Online Assigned IP Count Today—Number of today's online assigned IP addresses in the 
IP segment. 

 Online Unassigned IP Count Today—Number of today's online unassigned IP addresses 
in the IP segment. 

Allocated IP List 

 IP Address—Contains the IP address that has been allocated. 

 Owner—Contains the name of the device that has been granted the IP address listed in the 
IP address field. 

 Description/Host Name—Contains a description of the IP address allocation. If you do not 
specify this field, the field displays the device label. 

 Status—Contains the latest status of the device. Status is determined by the highest 
severity or alarm level for the device, when a device has more than one current alarm that 
has not been cleared or recovered. 

 Device Type—Contains the type of the device. 

 Details—Contains a link to viewing the IP Address Allocation details page for the 
associated IP address. 

 Modify—Contains a link for modifying the owner and description on the associated IP 
address. 

 Restore—Contains a link for restore the allocated IP address. 

If the IP list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the IP Address Allocation List. 

 Click  to page forward to the end of the IP Address Allocation List. 

 Click  to page backward in the IP Address Allocation List. 

 Click  to page backward to the front of the IP Address Allocation List. 

5. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

Querying IP segments 

You can filter IP segments by start/end IP, owner, or IP address.  

To query IP segments in IMC: 

1. Navigate to Resource > IP Address Allocation: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click IP Address Allocation under Terminal Access on the left navigation tree.  

The IP Segment List is displayed. 

2. Click Query in the upper right corner of the IP Segment List.  

A search criteria dialog box opens. 

3. Enter the following parameters in the dialog box: 

 Start IP—First IP address of the IP segment range you want to search. It only supports 
exact match. For example, if you enter 192.168.1.1, the IP segment with 192.168.1.1 as the 
start IP is displayed. 

 End IP—Last IP address of the IP segment range you want to search, which must be 
greater than the first IP address. It only supports exact match. For example, if you enter 
192.168.1.100, the IP segment with 192.168.1.100 as the end IP is displayed. 
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If you enter both the Start IP and the End IP, IMC searches for exact matches for IP 
segments that range from the start IP address to the end IP address you have entered. It 
only supports exact match. For example, if IMC contains IP segments 192.168.1.2 through 
192.168.1.10, entering 192.168.1.2 and 192.168.1.9 as the start IP and the end IP 
respectively does not match any IP segments in IMC. 

 Owner—Owner of the IP segment. IMC supports fuzzy matching for this field. 

 IP Address—IP address in dotted decimal notation. IMC searches for an exact match for 
the IP segment to which the IP address you have entered belongs. 

 Display network segments of unassigned IP addresses—Query network segments of 
unassigned IP addresses. This option must be used together with IP Address. When you 
enter an unassigned IP address in the IP Address field: 

 If you select this option and the IP segment of this IP address exists in the IMC, it 
displays the IP segment of the IP address in the list. 

 If you have not selected this option, the IP segments of the IP address cannot be 
queried. 

4. Click Query.  

All IP segments matching the specified criteria are displayed on the IP Segment List. 

5. Click Reset when you have finished your query to restore the full IP Segment List. 

Adding an IP segment 

You can manually add an IP segment in IMC in advance according to the actual IP segment plan.  

To manually add an IP segment in IMC: 

1. Navigate to Resource > IP Address Allocation: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click IP Address Allocation under Terminal Access on the left navigation tree.  

The IP Segment List is displayed. 

2. Click Add IP Segment. 

3. Select a format in which you want to specify the IP segment from the IP Segment Input 
Format list. Options include Subnet IP and Start IP and End IP. 

4. Enter the IP segment in either of the following formats: 

 If you have selected Subnet IP, enter an IP segment in the IP address/mask format such as 
192.168.1.1/24 and 192.168.1.1/255.255.255.0. 

 If you have selected Start IP and End IP, enter the first IP address to be allocated in the 
Start IP field and the last IP address to be allocated in the End IP field. The last IP address 
must be greater than the first IP address. 

5. Enter the owner of the IP segment in the Owner field. 

6. Select one or more operator groups in Operator Group field.  

Operators in different operator groups can have different rights to the IP segment. Using IP 
address allocation auto scanning feature discovers IP addresses and the devices associated 
with them. IMC auto populates the device name, type and description fields when the 
information is available, thus ensuring consistency in naming conventions across management 
modules in IMC. As a best practice, use the auto scanning feature whenever possible. 

7. Enter a brief description for this IP segment in the Description field. 

8. Click OK. 

Modifying an IP segment 

1. Navigate to Resource > IP Address Allocation: 

a. Click the Resource tab from the top tabular navigation system. 
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b. Click Terminal Access on the left navigation tree. 

c. Click IP Address Allocation under Terminal Access on the left navigation tree.  

The IP Segment List is displayed. 

2. Click the Modify icon  associated with the IP address allocation you want to modify. 

3. Select a format in which you want to specify the IP segment from the IP Segment Input 
Format list. Options include Subnet IP and Start IP and End IP. 

4. Enter the IP segment in either of the following formats: 

 If you have selected Subnet IP, enter an IP segment in the IP address/mask format such as 
192.168.1.1/24 and 192.168.1.1/255.255.255.0. 

 If you have selected Start IP and End IP, enter the first IP address to be allocated in the 
Start IP field and the last IP address to be allocated in the End IP field. The last IP address 
must be greater than the first IP address. 

5. Modify the owner of the IP segment that is granted in the IP segment in the Owner field as 
needed. 

6. Re-select the operator group in the Operator Group field for performing this IP segment. You 
cannot perform this operation in a child IP segment. 

7. Modify the description for this IP segment in the Description field. 

8. Click OK. 

Deleting an IP segment 

1. Navigate to Resource > IP Address Allocation: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click IP Address Allocation under Terminal Access on the left navigation tree.  

The IP Segment List is displayed. 

2. Click the Delete icon  associated with the IP segment you want to delete. 

3. Click OK to confirm the deletion of the IP segment. 

4. Review the results of the operation on the IP Address Allocation page. 

Querying allocated IP addresses 

1. Navigate to Resource > IP Address Allocation: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click IP Address Allocation under Terminal Access on the left navigation tree. 

The IP Segment List is displayed. 

2. Click the IP segment in the IP Address field of the IP Segment List that you want to allocate an 
IP address from. 

The Allocated IP List for the selected IP segment is displayed in the dialog box that opens. 

3. Click Query. 

The IP Address Allocation Query dialog box opens. 

4. Specify the following query criteria as needed: 

 IP Address—Enter an IP address. Select Fuzzy from the list located at the right of the IP 
Address field if you want to enter a partial IP address. Select Exact from this list if you want 
IMC to search for an exact match for the entered IP address. 

 Owner—Enter an owner of an IP address. This field supports fuzzy matching. 

 Description—Enter a description of an IP address. This field supports fuzzy matching. 

5. Click Query. 
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All matched IP addresses are displayed in the Allocated IP List. 

6. To restore the full Allocated IP List, click Reset. 

Manually allocating IP addresses 

You can manually assign IP addresses in the IP segment to devices.  

To allocate an IP address to a device manually: 

1. Navigate to Resource > IP Address Allocation: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click IP Address Allocation under Terminal Access on the left navigation tree.  

The IP Segment List is displayed. 

2. Click the IP segment in the IP Address field of the IP Segment List that you want to allocate 
an IP address from. 

The Allocated IP List for the selected IP segment is displayed in the dialog box that opens. 

3. Click Allocate. 

4. Select an allocation type from the IP Address Allocation Type list.  

The options include Allocate One IP and Allocate IPs in Batch: 

 If you selected Allocate One IP in step 4, enter the IP address. 

 If you selected Allocate IPs in Batch in step 4, enter the start IP address. 

 If you selected Allocate IPs in Batch in step 4, enter the end IP address. 

5. Enter the owner in the Owner field. 

6. Enter the description in the Description field. 

7. Click OK. 

Allocating IP addresses using the auto scanning feature 

You can use the auto scanning feature to identify all IP addresses in use and then add them to the IP 
address management system. This feature allows you to easily and proactively manage IP address 
resources.  

To add IP addresses using IMC's auto scanning feature: 

1. Navigate to Resource > IP Address Allocation: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click IP Address Allocation under Terminal Access on the left navigation tree.  

The IP Segment List is displayed. 

2. Click Auto Scanning. 

3. Enter the first usable IP address in the range of IP addresses you want to identify in the Start IP 
field. 

4. Enter the last usable IP address in the range of IP addresses you want to identify in the End IP 
field. 

5. Click Add to add the IP segment to the Configured Segments list. 

6. Repeat steps 3-5 until you have added all of the IP segments for which you want to scan the 
network. 

7. Click OK to begin the IP address auto scanning process.  

All IP addresses discovered by auto scanning are unallocated. You can manually allocate them 
to terminals. 

8. Select to the left for each IP address you want to allocate to the associated device. 
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9. Select the first empty checkbox in the upper left corner of the list to select all IP addresses in the 
list for the current page. 

10. Click Allocate. 

11. Review the results of your allocation in the IP Address Allocation Result list.  

After auto scanning, the IP addresses are automatically added to existing IP segments. If the IP 
addresses do not belong to any existing IP segment, they are automatically added to the 
system default IP segment. 

Allocating IP addresses using the import IP address feature 

You can use the import IP address feature to batch import IP addresses from an IP address file or a 
DHCP server. This feature lets you quickly import IP addresses to Terminal Access in batches.  

To add IP addresses using IMC's import IP address feature: 

1. Navigate to Resource > IP Address Allocation: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click IP Address Allocation under Terminal Access on the left navigation tree.  

The IP Segment List is displayed. 

2. Click Import IP Address. 

3. Click Browse to select the imported file. 

4. Enter the separator that the imported file uses in the Column Separator File field. Options 
include Space, TAB, comma (,), semi-colon (;), pound sign (#), and dollar sign ($).  

5. Select Yes or No in the Import First Row field. 

6. Click OK. 

7. Select the column that contains the device IP addresses. 

8. Select the column that contains the owners of the IP addresses, or select Do not select from 
the file and then enter an owner in the text box to assign the owner to all IP addresses to be 
imported.  

9. Enter the description in the Description field. 

10. Click OK. 

11. Review the results of IP address import in the IP Import Results page. 

Importing IP address segments 

IMC allows you to import IP address segments in batches from a standard .xml file. 

To import IP address segments to IMC: 

1. Navigate to Resource > IP Address Allocation: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click IP Address Allocation under Terminal Access on the left navigation tree.  

The IP Segment List is displayed. 

2. Click Import IP Segment. 

The Import IP Segment page opens. 

3. Browse to the local .xml file that contains the IP address segments you want to import to IMC. 

The following is a sample text: 
- <list> 

- <ipSegment startIp="10.153.147.1" endIp="10.153.147.20" owner="aaa" 

description="1-20"> 
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<ipSegment startIp="10.153.147.1" endIp="10.153.147.10" owner="aaa" 

description="1-10" />  

 <ipSegment startIp="10.153.147.11" endIp="10.153.147.20" owner="aaa" 

description="11-20" />  

 </ipSegment> 

- <ipSegment startIp="10.153.148.1" endIp="10.153.148.20" owner="aaa" 

description="1-20"> 

 <ipSegment startIp="10.153.148.1" endIp="10.153.148.10" owner="aaa" 

description="1-10" /> 

</ipSegment> 

 </list> 

The file can contain a list of IP address segments marked with ipSegment tags. Make sure IP 
address segment contains at least the startIp and endIp attributes. 

The content in each pair of ipSegment tags can contain at most five lines, in which the first line 
represents the first-level IP address segment, the second line represents the second-level IP 
address segment, and so forth. Make sure IP address segments have correct start and end IP 
addresses and are organized in a proper hierarchy. IMC does not import any invalid IP address 
segment and its lower level address segments. 

In addition, you can define other attributes to provide more information about IP address 
segments, such as the owner and description attributes the sample text. 

4. Click OK. 

IMC starts to import the IP address segments from the file, and displays the Import Result List. 

Import Result List contents 

 Start IP—Start IP address of the IP address segment. 

 End IP—End IP address of the IP address segment. 

 Operation Result—Import result of the IP address segment. 

IMC automatically filters out existing IP address segments and does not display them on the 
Import Result List. 

5. Click Back to return to the IP Address Allocation page. 

Exporting IP addresses 

IMC supports exporting IP addresses to .csv files. 

To export IP addresses: 

1. Navigate to Resource > IP Address Allocation: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click IP Address Allocation under Terminal Access on the left navigation tree. 

The IP Segment List is displayed. 

2. Click Export and select Export IP Addresses from the menu that appears. 

The Download IP Address Export File page opens. 

3. To save the exported file to your local computer, click the IP Address Export Result link. 

4. Follow your browser's instructions for saving the file to your local computer. 

Exporting IP segments 

IMC supports exporting IP segments to .xml files. 

To export IP segments: 

1. Navigate to Resource > IP Address Allocation: 

a. Click the Resource tab from the top tabular navigation system. 
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b. Click Terminal Access on the left navigation tree. 

c. Click IP Address Allocation under Terminal Access on the left navigation tree. 

The IP Segment List is displayed. 

2. Click Export and select Export IP Segments from the menu that appears. 

The Download IP Segment Export File page opens. 

3. To save the exported file to your local computer, click the IP Segment Export Result link. 

4. Follow your browser's instructions for saving the file to your local computer. 

Deleting allocated IP addresses 

1. Navigate to Resource > IP Address Allocation: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click IP Address Allocation under Terminal Access on the left navigation tree.  

The IP Segment List is displayed. 

2. Click the IP segment that includes the IP addresses you want to delete. 

The Allocated IP List is displayed. 

3. Select the IP addresses you want to delete. 

4. Select the first empty checkbox in the upper corner of the list to select all IP addresses in the list 
for the current page. 

5. Click Delete. 

6. Click OK to confirm the deletion of the selected IP addresses. 

To delete a single IP address, from the Allocated IP List, click the Delete icon  associated 
with the IP address you want to delete. 

Viewing the IP recycle bin 

The IP recycle bin displays all deleted IP addresses. You can restore the IP addresses to the pool of 
available addresses or delete the IP address completely. 

To view the IP recycle bin: 

1. Navigate to Resource > IP Address Allocation: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click IP Address Allocation under Terminal Access on the left navigation tree. 

The IP Segment List is displayed. 

2. Click IP Recycle Bin. 

The IP Recycle Bin page opens and displays the following information: 

 Click  to page forward in the IP Address List. 

 Click  to page forward to the end of the IP Address List. 

 Click  to page backward in the IP Address List. 

 Click  to page backward to the front of the IP Address List. 

3. Select one or more IP addresses. 

4. Do one of the following: 

 To restore the selected IP addresses, click Restore. 

 To completely delete the selected IP addresses, click Delete. 
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Click OK on the confirmation dialog box that opens. 

Detecting idle IP addresses 

Perform this task to regularly check the usage of assigned IP addresses, so that you can analyze 
and re-utilize those addressed that have not accessed the network. Make sure the Idle IP Detection 
Processing Policy has been enabled before you use this function. For more information, see "Idle IP 
Detection Processing Policy." 

To detect idle IP addresses: 

1. Navigate to Resource > IP Address Allocation: 

2. Click the Resource tab from the top tabular navigation system. 

3. Click Terminal Access on the left navigation tree. 

4. Click IP Address Allocation under Terminal Access on the left navigation tree. 

The IP Segment List is displayed. 

5. Do one of following: 

 Click the Idle IP Detection icon  for an IP segment, and go to step 11. 

 Click Idle IP Detection.  

The Idle IP Detection Condition Settings page opens. 

6. Set the minimum idle days in the Minimum Idle Days field. 

7. Enter the start IP address for the target IP segment in the Start IP Address field. 

8. Enter the end IP address for the target IP segment in the End IP Address field, which must be 
greater than the first IP address. 

If you are not setting the Start IP Address and End IP Address, IMC detects all the assigned 
IP addresses. 

9. Click Add to add the IP segment.  

You can delete the unneeded IP segment by clicking Delete after selecting. 

10. Click OK.  

The Idle IP Detection Results page displays idle IP addresses and idle days that match the 
criteria. 

11. The Idle IP Detection Results page displays idle IP addresses.  

To detect idle IP addresses again, click Cancel and modify the idle detection conditions on the 
Idle IP Detection Condition Settings page. 

12. Select the IP addresses you want to release, and then click Restore. 

Unauthorized access 
The Unauthorized Access provides you with the ability to view the terminals that did not comply 
with the access policies, the unauthorized access logs, and how they were handled by IMC. 

Viewing unauthorized access lists 

The Unauthorized Access List shows you the terminals that did not comply with the access 
policies.  

To view the Unauthorized Access List: 

1. Click the Resource tab from the top tabular navigation system. 

2. Click Terminal Access on the left navigation tree. 

3. Click Unauthorized Access under Terminal Access on the left navigation tree.  

The Unauthorized Access List is displayed in the main portion of the Unauthorized Access 
page. 

Unauthorized access list 
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 Terminal MAC—Contains the MAC address of the unauthorized access terminal. 

 Terminal Name—Contains the name of the unauthorized access terminal. If a DNS server 

is configured in IMC system settings, IMC resolves the domain name of the terminal by 
using the DNS server. For more information about configuring DNS server, see "System 
settings." If the IMC cannot retrieve the terminal domain name from the DNS server and the 
IMC is configured with a DHCP server, the IMC retrieves the terminal domain name from the 
DHCP server. For more information about configuring the DHCP server, see the HPE IMC 
deployment guides, for example, HPE IMC Distributed Deployment Guide with Local 
Database. 

 Terminal IP—Contains the IP address of the unauthorized access terminal. 

 Device Label—Contains the IMC name for the device, which, by default, is the name 
assigned to it in its device configuration.  

 Device IP—Contains the IP address of the access device. 

 Interface Description—Contains the description of the interface connected to the terminal. 

 Status—Contains the process status. 

 Unauthorized Access Log—Contains a link for navigating to the Unauthorized Access 
Log List page of the current terminal. 

If the Unauthorized Access List spans multiple pages, use the following aids to navigate the 
list: 

 Click  to page forward in the Unauthorized Access List. 

 Click  to page forward to the end of the Unauthorized Access List. 

 Click  to page backward in the Unauthorized Access List. 

 Click  to page backward to the front of the Unauthorized Access List. 

4. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

5. For the Unauthorized Access List that have more than one page, click 1, 2, 3, 4, 5, 6, 7, 8, 
9,10… from the upper middle or bottom right side of the main pane to jump to a particular page 
of the list.  

You can sort the Unauthorized Access List by most fields. Click the column label to sort the 
list by the selected field. The column label is a toggle switch that lets you toggle between the 
various sort options specific to each field. 

Querying the unauthorized access list 

IMC provides the ability to query the Unauthorized Access List.  

To query the Unauthorized Access List: 

1. Click the Resource tab from the top tabular navigation system. 

2. Click Terminal Access on the left navigation tree. 

3. Click Unauthorized Access under Terminal Access on the left navigation tree.  

The Unauthorized Access List is displayed in the main portion of the Unauthorized Access 
page. 

4. Point to Query in the upper right corner of Unauthorized Access List, and a search criteria 
dialog box opens. 

5. Enter one or more of the following search criteria in the dialog box: 

 Terminal MAC—Enter the MAC address in the Terminal MAC field. 

 Terminal IP—Enter the IP address in the Terminal IP field. 

 Terminal Name—Enter the terminal name in the Terminal Name field. 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 8829



428 

 Device Label—Enter the device label in the Device Label field. 

 Device IP—Enter the IP address of the access device in the Device IP field. 

 Interface Description—Enter the description of the interface connected to the terminal in 
the Interface Description field. 

 Status—Select the process status from the Status list. 

6. Click Query. 

7. Click Reset when you have finished your search to restore the full Unauthorized Access List. 

Viewing the unauthorized access log list 

1. Click the Resource tab from the top tabular navigation system. 

2. Click Terminal Access on the left navigation tree. 

3. Click the Unauthorized Access icon under Terminal Access on the left navigation tree.  

The Unauthorized Access List is displayed in the main portion of the Unauthorized Access 
page. 

4. Click All Unauthorized Access Logs.  

The Unauthorized Access Log List is displayed in the main portion of the Unauthorized 
Access Log List page. 

Unauthorized access log list 

 Action Status—Contains the status of the action taken for the unauthorized access. 

 Terminal MAC—Contains the MAC address of the unauthorized access terminal. 

 Terminal Name—Contains the name of the unauthorized access terminal. If a DNS server 
is configured in IMC system settings, IMC resolves the domain name of the terminal by 
using the DNS server. For more information about configuring DNS server, see "System 
settings." 

 Terminal IP—Contains the IP address of the unauthorized access terminal. 

 Device Label—Contains the IMC name for the device, which, by default, is the name 
assigned to it in its device configuration.  

 Device IP—Contains the IP address of the access device. 

 Interface—Contains the description of the interface connected to the terminal. 

 Conflict Type—Contains the conflict type. 

 Found Time—Contains the time when the unauthorized access was detected. 

 Details—Contains a link for navigating to the Unauthorized Access Log List Details 
page. 

If the Unauthorized Access Log List spans multiple pages, use the following aids to navigate 
the list: 

 Click  to page forward in the Unauthorized Access Log List. 

 Click  to page forward to the end of the Unauthorized Access Log List. 

 Click  to page backward in the Unauthorized Access Log List. 

 Click  to page backward to the front of the Unauthorized Access Log List. 

5. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

6. For the Unauthorized Access Log List that has more than one page, click 1, 2, 3, 4, 5, 6, 7, 8, 
9,10… from the upper middle or bottom right side of the main pane to jump to a particular page 
of the list.  
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You can sort the Unauthorized Access Log List by most fields. Click the column label to sort 
the list by the selected field. The column label is a toggle switch that lets you toggle between the 
various sort options specific to each field. 

Unauthorized access log query 

IMC provides you with the ability to query unauthorized access logs.  

To query the Unauthorized Access Log List: 

1. Navigate to Resource > Unauthorized Access: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click Unauthorized Access under Terminal Access on the left navigation tree.  

2. Click the All Unauthorized Access Logs. 

The Unauthorized Access Log List is displayed in the main portion of the Unauthorized 
Access Log List page. 

3. Click Query in the upper right corner of the Unauthorized Access Log List.  

A search criteria dialog box opens. 

4. Enter one or more of the following search criteria in the dialog box: 

 Terminal MAC—Enter the MAC address in the Terminal MAC field. 

 Terminal IP—Enter the IP address in the Terminal IP field. 

 Terminal Name—Enter the terminal name in the Terminal Name field. 

 Conflict Type—Select the type of the conflict occurred from the Conflict Type list. Options 
include Terminal Access Binding Conflict, Switch Access Binding Conflict, 
Terminal/Switch Binding Conflict, and Undefined Access Binding Conflict. 

 Device Label—Enter the device label in the Device Label field. 

 Device IP—Enter the IP address of the access device in the Device IP field. 

 Interface—Enter the interface of the device to which the terminal connects in the Interface 
field. 

 Action Status—Select the action status from the Action Status list. 

 Found Start Time—Enter the start date and time for the query. Click the textbox next to the 
Found Start Time field to enter the start time using the calendar function. 

 Found End Time—Enter the end date and time for the query. Click the textbox next to the 
Found End Time field to enter the start time using the calendar function. 

5. Click Query. 

6. Click Reset when you have finished your search to restore the full Unauthorized Access Log 
List. 

Terminal access binding 

To configure terminal access binding for the devices in the Unauthorized Access List: 

1. Navigate to Resource > Unauthorized Access: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click Unauthorized Access under Terminal Access on the left navigation tree.  

The Unauthorized Access List is displayed in the main portion of the Unauthorized 
Access page. 

2. Select the terminal MAC address you want to configure terminal access binding to the 
associated terminal. 

3. Click Terminal Access Binding.  

The Select Terminal Access Binding Type dialog box opens. 
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4. Select Yes or No from the Trusted list:  

 If Yes is selected, the terminal is allowed to access the network through any port.  

 If No is selected, the terminal is only allowed to access the network through the binding 
ports. 

5. Click OK. 

Switch access binding 

To configure switch access binding for the terminals in the Unauthorized Access List: 

1. Navigate to Resource > Unauthorized Access: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click Unauthorized Access under Terminal Access on the left navigation tree.  

The Unauthorized Access List is displayed in the main portion of the Unauthorized 
Access page. 

2. Select the terminal MAC address you want to configure terminal access binding to the 
associated terminal. 

3. Click Switch Access Binding.  

The Select Switch Access Binding Type dialog box opens. 

4. Select Yes or No from the Trusted list:  

 If Yes is selected, the port allows any terminal to access the network through this port.  

 If No is selected, the port only allows the binding terminals to access the network through 
this port. 

5. Click OK to confirm your operation. 

Delete unauthorized access entries 

To delete one or more unauthorized access entries: 

1. Navigate to Resource > Unauthorized Access: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click Unauthorized Access under Terminal Access on the left navigation tree.  

The Unauthorized Access List is displayed in the main portion of the Unauthorized 
Access page. 

2. Select each unauthorized access entry you want to delete. 

3. Click Delete. 

4. Click OK to confirm your operation. 

Cancel action 

In the unauthorized access processing policy, you can cancel the action of shutting down a port. The 
canceling action is effective when the action is in the waiting state.  

To cancel an action: 

1. Navigate to Resource > Unauthorized Access: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click Unauthorized Access under Terminal Access on the left navigation tree.  

The Unauthorized Access List is displayed in the main portion of the Unauthorized 
Access page. 

2. Click All Unauthorized Access Logs. 
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The Unauthorized Access Log List is displayed in the main portion of the Unauthorized 
Access Log List page. 

3. Select each action status you want to cancel to the associated unauthorized access log entries. 

4. Click Cancel Action. 

5. Click OK to confirm your operation. 

Refreshing the unauthorized access list 

1. Navigate to Resource > Unauthorized Access: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click Unauthorized Access under Terminal Access on the left navigation tree.  

The Unauthorized Access List is displayed in the main portion of the Unauthorized 
Access page. 

2. Click Refresh to reload the Web page and review any updated information. 

Refreshing the unauthorized access log list 

1. Navigate to Resource > Unauthorized Access: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click Unauthorized Access under Terminal Access on the left navigation tree.  

The Unauthorized Access List is displayed in the main portion of the Unauthorized 
Access page. 

2. Click the All Unauthorized Access Logs.  

The Unauthorized Access Log List is displayed in the main portion of the Unauthorized 
Access Log List page. 

3. Click Refresh to reload the Web page and review any updated information. 

History access log 
With the History Access Log function, you can view history access logs of terminals in the network. 
IMC obtains the MAC addresses and terminal names on the device by polling the device. IMC 
displays the information in the format of history access logs, facilitating IP address management. 

Viewing history access log list 

1. Navigate to Resource > History Access Log: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click History Access Log under Terminal Access on the left navigation tree.  

The History Access Log List is displayed in the main portion of the History Access Log 
page. 

History access log list 

 Terminal MAC—contains the MAC address of the terminal. 

 Terminal Name—contains the name of the terminal. If a DNS server is configured in 
IMC system settings, IMC resolves the domain name of the terminal by using the DNS 
server. For more information about configuring DNS server, see "System settings." If the 
IMC cannot retrieve the terminal domain name from the DNS server and the IMC is 
configured with a DHCP server, the IMC retrieves the terminal domain name from the 
DHCP server. For how to configure the DHCP server, see the HPE IMC deployment 
guides.  
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 Terminal IP—Contains the IP address of the terminal. 

 Device Label—Contains the IMC name for the device, which, by default, is the name 
assigned to it in its device configuration. 

 Device IP—Contains the IP address of the device. 

 Interface—Contains the interface of the terminal. 

 VLAN—Contains the VLAN to which the terminal belongs. 

 Login Time—Contains the time when the terminal logged in. 

 Logout Time—Contains the time when the terminal logged out. 

If the History Access Log List spans multiple pages, use the following aids to navigate the 
list: 

 Click  to page forward in the History Access Log List. 

 Click  to page forward to the end of the History Access Log List. 

 Click  to page backward in the History Access Log List. 

 Click  to page backward to the front of the History Access Log List. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

3. For History Access Log lists that have more than one page, click 1, 2, 3, 4, 5, 6, 7, 8, 9,10 … 
from the upper middle or bottom right side of the main pane to jump to a particular page of the 
list.  

Periodically retrieve data 

To retrieve the data on the History Access Log page: 

1. Navigate to Resource > History Access Log: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click History Access Log under Terminal Access on the left navigation tree.  

The History Access Log List is displayed in the main portion of the History Access Log 
page. 

2. Select Periodically Retrieve Data. 

Real-time location 

To access information for a terminal by IP or MAC address: 

1. Navigate to Resource > History Access Log: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click History Access Log under Terminal Access on the left navigation tree.  

The History Access Log List is displayed in the main portion of the History Access Log 
page. 

2. Click the Real-Time Location link located in the far right corner of the History Access List. 

Retrieve now 

To immediately retrieve the History Access Log List: 

1. Navigate to Resource > History Access Log: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 
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c. Click History Access Log under Terminal Access on the left navigation tree.  

The History Access Log List is displayed in the main portion of the History Access Log 
page. 

2. Click the Retrieve Now link located in the far right corner of the History Access List.  

3. Click the Back link to return to the History Access List, which displays the latest data. 

History access log query 

IMC provides you with the ability to query specified access logs.  

To query history access logs: 

1. Navigate to Resource > History Access Log: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click History Access Log under Terminal Access on the left navigation tree.  

The History Access Log List is displayed in the main portion of the History Access Log 
page. 

2. Click Query in the upper right corner of History Access Log List, and a search criteria dialog 
box opens. 

3. Enter one or more of the following search criteria in the dialog box: 

 Terminal MAC—Enter the MAC address in the Terminal MAC field. 

 Terminal IP—Enter the IP address in the Terminal IP field. 

 Terminal Name—Enter the terminal name in the Terminal Name field. 

 Device Label—Enter the device label in the Device Label field. 

 Device IP—Enter the IP address of the access device in the Device IP field. 

 Interface—Enter the interface that connects the terminal to the device in the Interface field. 

 VLAN—Enter the ID of the VLAN to which the terminal belongs in the VLAN field. 

 Logon Start Time—Enter a date and time to query logon start time. Click the field next to 
Logon Start Time to enter the start time using the calendar function. 

 Logon End Time—Enter a date and time to query logon end time. Click the field next to 
Logon End Time to enter the end time using the calendar function. 

 Logoff Start Time—Enter a date and time to query logoff start time. Click the field next to 
Logon Start Time to enter the start time using the calendar function. 

 Logoff End Time—Enter a date and time to query logoff end time. Click the field next to 
Logon End Time to enter the end time using the calendar function. 

4. Click Query. 

5. Click Reset when you have finished your search to restore the full History Access Log list. 

Deleting history access logs 

To delete one or more history access logs: 

1. Navigate to Resource > History Access Log: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click History Access Log under Terminal Access on the left navigation tree.  

2. Select each action status you want to delete to the associated history access log entries. 

3. Click Delete. 

4. Click OK. 

Refreshing the history access log page 

To refresh the History Access Log page: 
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1. Navigate to Resource > History Access Log. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click History Access Log under Terminal Access on the left navigation tree.  

2. Click Refresh to reload the Web page and review any updated information. 

Real-time location 
IMC lets you locate IP or MAC addresses in the network infrastructure. This feature is useful for 
pinpointing to which access device a particular user is located when some information about the user 
is known. IMC distinguishes end user devices or desktops from network infrastructure devices and 
therefore only returns search results that are end stations or desktop devices.  

A Real-Time Location query initiates a poll of the network to discover in real time in which access 
device an IP or MAC address is connected.  

Upon entering search criteria, IMC returns the IP address, MAC address, access device, Device IP 
address, interface, and VLAN information. This supports troubleshooting network problems and 
security issues.  

IP address location query 

To locate an IP address using a real-time location query: 

1. Navigate to Resource > Real-Time Location. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click Real-Time Location under Terminal Access on the left navigation tree.  

The Real-Time Location page opens. 

2. Select IP Address from the Location Type field.  

Select MAC Address if you have the MAC address of the terminal you want to locate. 

3. Enter the IP or MAC address that you want to locate. 

4. Click OK.  

The results of your query display in the Real-Time Location Result list. 

Real-time location result 

 Location Address—Contains the IP address that has been located. 

 Device IP—Contains the IP address of the access device that provides network 
connectivity for the IP or MAC address that has been located. 

 Interface—Contains the description of the interface to which the located IP/MAC address is 
or was connected. 

 View Access Device Topology—Contains a link for accessing the network topology. In the 
topology, you can check the position of the device that connects to the terminal with this 
address. 

5. Click Reset when you have finished your search to restore the full Real-Time Location Result 
list. 

MAC address location query 

To locate a MAC address using a real-time location query: 

1. Navigate to Resource > Real-Time Location. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click Real-Time Location under Terminal Access on the left navigation tree.  
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The Real-Time Location page opens. 

2. Select MAC Address from the Location Type field.  

Select IP Address if you have the IP address of the terminal you want to locate. 

3. Enter the IP or MAC address that you want to locate. 

4. Click OK.  

The results of your query display in the Real-Time Location Result list. 

Real-time location result 

 Location Address—Contains the MAC address that has been located.  

 Device IP—Contains the IP address of the access device that provides network 
connectivity for the IP or MAC address that has been located. 

 Interface—Contains the description of the interface to which the located IP/MAC address is 
or was connected. 

 View Access Device Topology—Contains a link for accessing the network topology. In the 
topology, you can check the position of the device that connects to the terminal with this 
address. 

5. Click Reset when you have finished your search to restore the full Real-Time Location Result 
list. 

Access configuration 
You can bind an IP address to a MAC address for security purposes. In addition, you can bind a MAC 
address to an interface. When an IP address is bound to a MAC address or when a MAC address is 
bound to an interface, the binding takes place in IMC only. The address is not bound on the device, 
but rather the address is bound in IMC. Binding has the result of enabling IMC to track IP and MAC 
address usage to a specific resource and proactively notify you when that resource is not be used in 
the way it was allocated or intended. 

Terminal access binding 

You can define rules to restrict terminal access to the network. In IMC, you can bind all interfaces, 
which means a terminal can access the network from any location. In addition, you can bind one or 
more interfaces to allow a terminal to access the network from specified locations.  

After specifying binding policies, you can configure an Unauthorized Access Processing Policy to 
take actions such as sending alarms or shutting down ports against terminals that violate the policy. 
For more information about unauthorized access processing policies, see "Unauthorized access." 

Viewing the terminal access binding list 

To view the Terminal Access Binding list: 

1. Navigate to Resource > Access Configuration. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click Access Configuration under Terminal Access on the left navigation tree. 

2. Click the Terminal Access Binding link on the Access Configuration page.  

The Terminal Access Binding List is displayed. 

 Terminal MAC—Contains the MAC address for the terminal associated with the IP 
address.  

 Terminal Name—Contains the name of the terminal. 

 Terminal IP—Contains the IP address of the terminal that is connected to the terminal 
access device. 

 Trusted—Contains information about whether or not the terminal is trusted on all interfaces. 
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 Device Label—Contains the label of the device to which the terminal connects. In addition, 
it provides a link for entering the Device Details page. 

 Device IP—Contains the IP address that has been allocated to the device. The IP address 
serves as an active link for drilling down to the Device Details page. 

 Interface—Contains the interface to which the associated MAC address is bound. 

 Details—Contains a link for viewing the MAC/Interface Binding details page for the 
associated MAC/Interface binding entry. 

 Modify—Contains a link for modifying the Terminal Access Binding entry. 

If the Terminal Access Binding List spans multiple pages, use the following aids to navigate 
the list: 

 Click  to page forward in the Terminal Access Binding List.  

 Click  to page forward to the end of the Terminal Access Binding List. 

 Click  to page backward in the Terminal Access Binding List. 

 Click  to page backward to the front of the Terminal Access Binding List. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

4. For lists that have more than one page, click 1, 2, 3, 4, 5, 6, 7, 8, 9,10 … from the upper middle 
or bottom right side of the main pane to jump to a particular page of the list.  

You can sort the Terminal Access Binding List by most fields. Click the column label to sort 
the list by the selected field. The column label is a toggle switch that lets you toggle between the 
various sort options specific to each field. 

Searching for terminal access bindings 

To search IMC for an existing terminal access binding: 

1. Navigate to Resource > Access Configuration. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click Access Configuration under Terminal Access on the left navigation tree. 

2. Click Terminal Access Binding on the Access Configuration page.  

The Terminal Access Binding List is displayed in the Terminal Access Binding page. 

3. Click Query in the upper right corner of Terminal Access Binding List, and a search criteria 
dialog box opens. 

4. Enter one or more of the following search criteria: 

 Terminal MAC—Enter the MAC address for the terminal associated in the Terminal MAC 
field. 

 Terminal IP—Enter the IP address that you want to locate a binding for in the Terminal IP 
field. 

 Terminal Name—Enter the name for the terminal you want to locate a binding in the 
Terminal Name field.  

 Trusted—Select whether to trust the terminal from the Trusted list. 

 Device Label—Enter the device label for which you want to search. 

 Device IP—Enter the IP address of the access device in the Device IP field. 

 Interface—Enter the interface to which the associated MAC address is bound. 

5. Click Query. 

6. Click Reset when you finish your search to restore the full Terminal Access Binding list. 

Manually binding a terminal to interfaces 
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To bind a terminal to one or more interfaces in IMC: 

1. Navigate to Resource > Access Configuration. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click Access Configuration under Terminal Access on the left navigation tree. 

2. Click Terminal Access Binding on the Access Configuration page.  

The Terminal Access Binding List is displayed in the Terminal Access Binding page. 

3. Click Add Binding. 

4. Enter the MAC address for the binding you want to create in the Terminal MAC field. Valid 
MAC address format includes ##:##:##:##:##:##. 

For example, 00:24:82:1e:3b:81 is a valid entry.  

5. Enter the Terminal Name in the Terminal Name field. 

6. Enter the maintainer in the Maintainer field. 

7. Select whether to bind all interfaces in the Trusted list.  

8. Enter the device label in the Device Label field. 

9. Enter the device IP in the Device IP field. 

10. Click Select next to the Interface field. 

11. Add interfaces using either the View or Advanced query option.  

Add interfaces by using the same process as adding devices. See "Adding devices by view" 
and "Adding devices by advanced query." 

When you select a custom view in the By View tab and then click the Advanced tab , IMC 
automatically populates the View Name field with the name of the custom view. This helps you 
quickly locate a custom view and query target interfaces in the custom view. 

Manually unbinding a terminal from one or more interfaces 

To manually unbind a Terminal from one or more interfaces: 

1. Navigate to Resource > Access Configuration. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click Access Configuration under Terminal Access on the left navigation tree. 

2. Click Terminal Access Binding on the Access Configuration page.  

The Terminal Access Binding List is displayed in the Terminal Access Binding page. 

3. Click Unbind. 

4. Click OK to confirm the unbinding request. 

Binding multiple terminal to interfaces using the Auto Scanning feature 

You can use the auto scanning feature to also bind a terminal to the current interface associated with 
them. You can easily and proactively secure network resources using this feature.  

To add Terminal Access binding in IMC (not on the device) using IMC's auto scanning feature: 

1. Navigate to Resource > Access Configuration. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click Access Configuration under Terminal Access on the left navigation tree. 

2. Click the Terminal Access Binding icon on the Access Configuration page.  

The Terminal Access Binding List is displayed in the Terminal Access Binding page. 

3. Click Auto Scanning. 
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4. Click Add Device to add devices to the Device List. 

5. Add devices using the By View and by Advanced query option.  

See "Adding devices by view" and "Adding devices by advanced query." 

Refreshing the terminal access binding list 

To refresh the Terminal Access Binding List: 

1. Navigate to Resource > Access Configuration. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click Access Configuration under Terminal Access on the left navigation tree. 

2. Click Terminal Access Binding on the Access Configuration page.  

The Terminal Access Binding List is displayed on the Terminal Access Binding page. 

3. Click Refresh to reload the Web page and review any updated information. 

Switch access binding 

Using the Switch Access Binding feature, you can bind an interface on the switch to the MAC 
address of one or more terminals to control terminal access to the network. 

Viewing the switch access binding list 

To view the Switch Access Binding List: 

1. Navigate to Resource > Access Configuration. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click Access Configuration under Terminal Access on the left navigation tree. 

2. Click Switch Access Binding on the Access Configuration page. 

The Switch Access Binding List is displayed. 

Switch access binding list 

 Interface Description—Contains the interface to which the associated MAC address is 
bound. The interface description serves as an active link for drilling down to the Interface 
Details page. 

 Device Label—Contains the device label of the access device. The device label serves as 
an active link for drilling down to the Device Details page. 

 Device IP—Contains the IP address of access device. The IP address serves as an active 
link for drilling down to the Device Details page. 

 Trusted—Contains information about whether or not the terminal is trusted on all interfaces. 

 Terminal MAC—Contains the MAC address for the terminal associated with the interface. 

 Terminal IP—Contains the IP address of the terminal that is connected to the terminal 
access device. 

 Terminal Name—Contains the name of the terminal. 

 Details—Contains a link to viewing the Switch Access Binding Details page for the 
associated switch access binding entry. 

 Modify—Contains a link for modifying the switch access binding entry. 

If the Switch Access Binding List spans multiple pages, use the following aids to navigate the 
list: 

 Click  to page forward in the Switch Access Binding List. 

 Click  to page forward to the end of the Switch Access Binding List. 
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 Click  to page backward in the Switch Access Binding List. 

 Click  to page backward to the front of the Switch Access Binding List. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

4. For lists that have more than one page, click 1, 2, 3, 4, 5, 6, 7, 8, 9,10 … from the upper middle 
or bottom right side of the main pane to jump to a particular page of the list.  

You can sort the Switch Access Binding List by most fields. Click the column label to sort the 
list by the selected field. The column label is a toggle switch that lets you toggle between the 
various sort options specific to each field. 

Searching for switch access bindings 

To search IMC for an existing terminal access binding: 

1. Navigate to Resource > Access Configuration. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click Access Configuration under Terminal Access on the left navigation tree. 

2. Click Switch Access Binding on the Access Configuration page. 

The Switch Access Binding List is displayed. 

3. Click Query in the upper right corner of Switch Access Binding List.  

The search criteria dialog box opens. 

4. Enter one or more of the following search criteria: 

 Interface Description—Enter the interface description to which the associated MAC 
address is bound. 

 Device Label—Enter the label of the device where the interface resides. 

 Device IP—Enter the IP address of the device where the interface resides. 

 Trusted—Select whether to trust the terminal from the Trusted list. 

 Terminal MAC—Enter the MAC address of the terminal. 

 Terminal IP—Enter an IP address of the terminal. 

 Terminal Name—Enter the terminal name.  

5. Click Query. 

6. Click Reset when you finish your search to restore the full Switch Access Binding list. 

Manually binding interfaces to one or more terminals 

You can bind interfaces to one or more terminals. In addition, you can define trusted interfaces. The 
trusted interfaces allow any terminals to access the network through them.  

To bind an interface to one or more terminals in IMC: 

1. Navigate to Resource > Access Configuration. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click Access Configuration under Terminal Access on the left navigation tree. 

2. Click Switch Access Binding on the Access Configuration page. 

The Switch Access Binding List is displayed. 

3. Click Add Binding. 

4. Click Select to select the interface to be bound. 

5. Add devices by using either the View or Advanced query option. 
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For more information, see "Adding devices by view" and "Adding devices by advanced query." 

Manually unbinding one or more terminals from interfaces 

To manually unbind one or more Terminals from an interface: 

1. Navigate to Resource > Access Configuration. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click Access Configuration under Terminal Access on the left navigation tree. 

2. Click Switch Access Binding on the Access Configuration page. 

The Switch Access Binding List is displayed. 

3. Select the terminal access binding entries you want to unbind. 

4. Click Unbind. 

5. Click OK to confirm the unbinding request. 

Switch access binding by using the auto-scanning feature 

You can use the auto scanning feature to also bind interfaces to the current terminal associated with 
them. You can easily and proactively secure network resources using this feature.  

To add Switch Access binding in IMC (not on the device) using IMC's auto scanning feature: 

1. Navigate to Resource > Access Configuration. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click Access Configuration under Terminal Access on the left navigation tree. 

2. Click Switch Access Binding on the Access Configuration page. 

The Switch Access Binding List is displayed. 

3. Click Auto Scanning. 

4. Click Add Device to add devices to the Device List. 

You can add devices using the By View and by Advanced query option.  

See "Adding devices by view" and "Adding devices by advanced query." 

Refreshing switch access binding list 

To refresh Switch Access Binding List: 

1. Navigate to Resource > Access Configuration. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click Access Configuration under Terminal Access on the left navigation tree. 

2. Click Switch Access Binding on the Access Configuration page. 

The Switch Access Binding List is displayed. 

3. Click Refresh to reload the Web page and review any updated information. 

IP to MAC address binding 

Using the IP/MAC Address Binding feature, you can bind an IP address to a MAC address within 
IMC (not on the device). When IMC detects an invalid IP address and MAC address pairing, it 
generates an alarm notifying you of this event. The benefits of this feature are as follows:  

 IP addresses cannot be changed without notification of changes. 

 Supports the centralized management of IP address resources. 

 Helps defend against security threats. 
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You can bind IP addresses to MAC addresses manually or they can use the auto-scanning feature. 
With the auto-scanning feature, IMC identifies IP address and MAC address combination pairs, to 
which you can then selectively apply binding. IMC version 5.1 supports 5,000 IP address to MAC 
address bindings. The following information provides details on IP to MAC address binding. 

Viewing the IP/MAC binding list 

To view the IP/MAC binding list: 

1. Navigate to Resource > Access Configuration. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click Access Configuration under Terminal Access on the left navigation tree. 

2. Click IP/MAC Binding in the Access Configuration page. 

The IP/MAC Binding List is displayed in the IP/MAC Binding page. 

IP/MAC Binding List 

 IP Address—Contains the IP address that has been allocated. 

 MAC Address—Contains the MAC address for the device associated with the IP address. 

 Owner—Contains the name of the IP address owner. 

 Details—Contains a link to viewing the IP/MAC binding details page for the associated 
IP/MAC binding entry. 

 Unbind—Contains a link for unbinding the IP address allocation from the MAC address. 

If the IP/MAC Binding List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the IP/MAC Binding List. 

 Click  to page forward to the end of the IP/MAC Binding List. 

 Click  to page backward in the IP/MAC Binding List. 

 Click  to page backward to the front of the IP/MAC Binding List. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

4. For lists that have more than one page, click 1, 2, 3, 4, 5, 6, 7, 8, 9,10 … from the upper middle 
or bottom right side of the main pane to jump to a particular page of the list.  

You can sort the IP/MAC Binding List by most fields. Click the column label to sort the list by 
the selected field. The column label is a toggle switch that lets you toggle between the various 
sort options specific to each field. 

Searching for IP/MAC bindings 

IMC provides you with the ability to search for existing IP address to MAC address bindings.  

To search IMC for an existing IP/MAC binding: 

1. Navigate to Resource > Access Configuration. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click Access Configuration under Terminal Access on the left navigation tree. 

2. Click IP/MAC Binding on the Access Configuration page. 

The IP/MAC Binding List is displayed in the IP/MAC Binding page. 

3. Click Query in the upper right corner of IP/MAC Binding List, and a search criteria dialog box 
opens. 

4. Enter one or more of the following search criteria in the dialog box: 
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 IP Address—Enter the IP address that you want to locate a binding for in the IP Address 
field. 

 MAC Address—Enter the MAC address for the device associated in the MAC Address 
field. 

 Owner—Enter the owner of the IP address. 

5. Click Query. 

6. Click Reset when you have finished your search to restore the full IP/MAC Binding list. 

Manually binding an IP address to a MAC address 

To bind an IP address to a MAC address in IMC: 

1. Navigate to Resource > Access Configuration. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click Access Configuration under Terminal Access on the left navigation tree. 

2. Click IP/MAC Binding on the Access Configuration page. 

The IP/MAC Binding List is displayed in the IP/MAC Binding page. 

3. Click Add. 

4. To select the IP address to bind, click Select next to the IP address field. In the Select an IP 
Address dialog box, enter one or more of the following search criteria in the fields provided: 

 IP Address—Enter a partial or complete IP address for the IP address you want to bind in 
the IP Address field. 

 Owner—Enter the owner for the IP address in the Owner field. 

5. Click Query to begin your search. 

6. Select the search result entry that you want to bind. 

7. Click OK to accept your selection and return to the IP/MAC binding page.  

Only an IP address that has been allocated using the IP Address Allocation feature can be 
bound to a MAC address. If the IP address you want to bind is not displayed in the query results, 
check the IP Address Allocation list to verify that the IP address you want to bind has already 
been allocated. For more information about allocating IP addresses, see "Allocating IP 
addresses." 

8. Enter the MAC address for the binding you want to create in the MAC Address field. A valid 
MAC address format is ##:##:##:##:##:##. 

For example, 00:24:82:1e:3b:81 is a valid entry.  

Using the IP/MAC auto scanning feature discovers IP addresses and the current MAC 
addresses associated with them. IMC auto populates the IP Address, MAC Address, Device 
Name and Device Type fields when the information is available, thus ensuring consistency in 
naming conventions across management modules in IMC. As a best practice, use the auto 
scanning feature whenever possible. 

9. Enter the owner of the binding in the Owner field. 

10. Click OK. 

Manually unbinding an IP address from a MAC address 

To manually unbind an IP address from a MAC address in IMC: 

1. Navigate to Resource > Access Configuration. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click Access Configuration under Terminal Access on the left navigation tree. 

2. Click IP/MAC Binding in the Access Configuration page. 

The IP/MAC Binding List is displayed in the IP/MAC Binding page. 
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3. Click the Unbind icon  associated with the IP/MAC address binding you want to unbind. 

4. Click OK to confirm the unbinding request. 

Binding multiple IP/MAC addresses using the auto scanning feature 

You can use the auto scanning feature to also bind IP addresses to the current MAC addresses 
associated with them.  

To add IP/MAC binding in IMC (not on the device) using auto scanning: 

1. Navigate to Resource > Access Configuration. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click Access Configuration under Terminal Access on the left navigation tree. 

2. Click IP/MAC Binding in the Access Configuration page. 

The IP/MAC Binding List is displayed in the IP/MAC Binding page. 

3. Click Auto Scanning. 

4. Enter the first usable IP address in the range of IP addresses you want to identify in the Start IP 
Address field. 

5. Enter the last usable IP address in the range of IP addresses you want to identify in the End IP 
Address field. 

6. Click Add to add the IP Segment to the Configured Segments list. 

7. Repeat steps 3-9 until you have added all of the IP segments for which you want to scan the 
network. 

8. Click OK, IMC scans the network and return all IP addresses and the MAC addresses 
associated with them. 

9. Select each IP address you want to bind.  

Selecting the first empty checkbox in the upper corner of the list selects all entries in the list for 
the current page. 

10. Click Bind to bind the IP addresses to their associated MAC addresses. 

11. Review the results of your allocation in the Binding Result List. 

Unbinding multiple IP/MAC address bindings 

You can unbind multiple IP addresses from the MAC addresses.  

To unbind multiple IP/MAC address bindings in IMC: 

1. Navigate to Resource > Access Configuration. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click Access Configuration under Terminal Access on the left navigation tree. 

2. Click IP/MAC Binding in the Access Configuration page. 

The IP/MAC Binding List is displayed in the IP/MAC Binding page. 

3. Select each IP/MAC binding you want to unbind.  

Selecting the first empty checkbox in the upper left corner of the list selects all IP addresses in 
the list for the current page. 

4. Click Unbind. 

5. Click OK to confirm the unbinding of the selected IP addresses. 

6. Review the results of your allocation in the Unbinding Result List page. 
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Unauthorized access process policy 

After completing Terminal Access Binding, Switch Access Binding, and IP/MAC Binding, you can use 
an Unauthorized Access Processing Policy to configure rules for taking actions against terminals 
that violate the rules. For example, sending alarms or shutting down ports can help the administrator 
control unauthorized terminal access. 

To configure an Unauthorized Access Processing Policy: 

1. Navigate to Resource > Access Configuration. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Terminal Access on the left navigation tree. 

c. Click Access Configuration under Terminal Access on the left navigation tree. 

2. Click Unauthorized Access Processing Policy in the Access Configuration page.  

The Unauthorized Access Processing Policy page opens. 

Configuring the conflict processing policy 

1. Select Yes or No in the Send Alarm list. 

2. Select an interface shutdown policy in the Interface Shutdown list. If you select Do not shut 
down, you go to the next section. 

3. Configure the duration before the interface is shut down in the Shut Down the Interface in 
(5-1800 seconds) field, if prompted. 

4. Select the operation to be performed after the interface is shut down in the After the Interface 
is Down for a Period list, if prompted. 

5. Configure the duration before the interface is brought up in the Bring up the Interface in 
(5-1800 seconds) field, if prompted. 

Configuring an undefined access processing policy 

1. Select Illegal in the Undefined Access list. If you select Legal, you go to the next section. 

2. Select Yes or No, in the Send Alarm list. 

3. Select an interface shutdown policy in the Interface Shutdown list. 

4. Configure the duration before the interface is shut down in the Shut Down the Interface in 
(5-1800 seconds) field, if prompted. 

5. Select the operation to be performed after the interface is shut down in the After the Interface 
is Down for a Period list, if prompted. 

6. Configure the duration before the interface is brought up in the Bring up the Interface in 
(5-1800 seconds) field, if prompted. 

7. Adopt the default IP/MAC Mismatch Processing Policy, which is Send Alarm. 

8. Click OK.  

IP/MAC Mismatch Processing Policy 

This policy is enabled and cannot be disabled. IMC generates an alarm when detecting that the IP 
and MAC address of a managed device are not bound in IMC. For information about configuring an 
IP/MAC address binding, see "IP to MAC address binding." 

IP Address Monitor Processing Policy 

When a device is added, IMC checks whether the ARP table of the device contains unallocated IP 
addresses in IP Allocation Management. If it is, IMC further determines their legitimacy according to 
the IP Address Monitor Processing Policy. IP addresses are considered legitimate if they pass one or 
both of the check items in the policy. IP addresses are considered illegitimate if they fail both check 
items in the policy. 

To configure the IP Address Monitor Processing Policy: 

1. Select Yes or No from the Send Alarm list. 
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This parameter specifies whether IMC sends an alarm when an illegitimate IP address is found 
in the ARP table of a newly added device. 

2. Select Legal or Illegal from the Existing Device IP in IMC list. If Legal is selected, an IP 
address in the ARP table is legitimate if it belongs to a device that is added to IMC. If Illegal is 
selected, an IP address in the ARP table is illegitimate if it belongs to a device that is added to 
IMC. 

3. Select Legal or Illegal from the Unallocated IP in the IP Segments list. If Legal is selected, 
an IP address in the ARP table is legitimate if it is an unallocated IP address in IP Allocation 
Management. If Illegal is selected, an IP address in the ARP table is illegitimate if it is an 
unallocated IP address in IP Allocation Management. 

Idle IP Detection Processing Policy 

Perform this task to enable the idle IP detection function so that IMC can detect the idle IP 
addresses. For more information, see "Detecting idle IP addresses." 

To configure the Idle IP Detection Processing Policy: 

1. From the list next to Enable Idle IP Detection, select Yes or No. 

2. From the Save History Data list, select Yes or No. 

 Yes—History data of the detection will be retained and will be used as the baseline for the IP 
idle detection of the next time. 

 No—History data of the detection will not be retained and a new IP idle detection will be 
performed next time. 

3. Set the idle IP detection period. After your setting, IMC will ping every assigned addresses 
according to the detection period. By 24 o'clock on the day, IMC will regard the IP address that 
cannot be pinged as idle one and increase its idle days by 1. If the IP addresses can be pinged 
at least one time, its idle days will change to 0. 

4. Click OK. 

OneView management 
The HPE OneView automation hub (OneView) manages data center infrastructure systems. 
OneView provides task-oriented, system-level management, including change management, 
configuration consistency, and software update functions. With the discovery, deployment, and 
updating features, OneView simplifies data maintenance work and quickly responds to environment 
changes. 

In cooperation with HPE OneView, the IMC OneView management module executes different 
actions in response to infrastructure change messages received from OneView. This process 
enables networks to automatically adapt to infrastructure changes. For example, when OneView 
deploys configuration files to a blade server and completes the VC module configuration, OneView 
proactively learns the VC module interface that connects to the upstream switch. OneView then 
informs other management tools of the learned interface information. After IMC receives the 
message, it deploys the specified VLAN configuration to the switch. This ensures the virtual 
networks created or managed by OneView to communicate correctly with other networks. 

Configuring access parameters 
Configure access parameters for the OneView management module to listen to and receive 
messages that OneView sends to other management tools. 

To configure access parameters: 

1. Click the Resource tab. 

2. From the navigation tree, select OneView Management > Access Parameter. 

The Access Parameter page opens. 
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3. Configure the following access parameters: 

 Server IP—Enter the IP address of OneView. 

 Protocol—Select https or http from the Protocol list. 

 Port—Enter the port number used to access OneView. 

 User Name—Enter the user name used to access OneView. 

 User Password—Enter the password used to access OneView. 

4. Click OK. 

After IMC successfully connects to OneView, IMC obtains OneView information and displays 
the information at the bottom of the page. The OneView information includes the version 
number and serial number. Empty OneView information indicates that OneView information 
cannot not be obtained. OneView information is refreshed every hour. 

Viewing messages 
OneView informs other management tools of infrastructure changes. IMC displays the received 
messages in a list. 

To view messages: 

1. Click the Resource tab. 

2. From the navigation tree, select OneView Management > Messages. 

The Messages List page opens and displays all messages in the message list. To view the 
most recent message list, click Refresh. 

Messages List contents 

 Server IP—IP address of OneView. 

 Resource—Name of the entity that changed in OneView. 

 Category—Category of the entity that changed in OneView. 

 Change Type—Type of the change on the entity in OneView. 

 Category Type—Change on the entity in OneView. 

 Date—Date when the entity changed in OneView. 

Viewing the action history 
IMC executes actions based on the contents of received messages. Only the VLAN configuration 
deployment action is supported in the current IMC version. 

To view the action history: 

1. Click the Resource tab. 

2. From the navigation tree, select OneView Management > Action History. 

The Action History List page opens and displays all action history entries in the action history 
list. To view the most recent action history list, click Refresh. 

Messages List contents 

 Server IP—IP address of OneView. 

 Resource—Name of the entity that changes in OneView. 

 Category—Category of the entity that changed in OneView. 

 Change Type—Type of the change on the entity in OneView. 

 Category Type—Change on the entity in OneView. 

 Operate Date—Date when the OneView management module executed the action. 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 8848



447 

 Result—Result of the action executed by the OneView management module. Click the link 
in the Result column for an action to view result details for the action. The details include 
the execution steps of the action, and the execution time, operation content, and execution 
result of each step. 

Network Asset Manager 
The Network Asset Manager lets you track and modify assets and make changes to these assets. 
Using this feature, you can view asset lists and drill down into individual device details or device audit 
details, query IMC for specific audit records and manage the auditing process.  

The asset OID feature lets you manage the device OID information and identify the asset type by its 
OID, and facilitates the device management and statistics. At the same time, the physical asset 
attributes of the asset OID feature let you identify the physical assets and non-physical assets.  

Viewing network assets 
You can view device specific details including component level details. From the Network Asset 
List, you can view asset details that include device specific and module specific information. From 
this view you can also access the Device Details page for the selected device and audit histories. 

Network asset list 

1. Navigate to Resource > Network Assets. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Network Assets on the left navigation tree. 

c. Click Network Assets under Network Assets on the left navigation tree.  

The Network Asset List is displayed in the main portion of the Network Assets page. 

Network asset list 

 Asset Name—Contains the asset name. The contents of this field serve as an active 
link for navigating to the Network Asset Details page. At the device level, the asset 
name is derived from the device label in IMC. Device labels are derived from sysName if 
it is configured and if the operator has not manually configured it. Asset names for 
component level assets are defined in the MIB for the device. 

 Asset Description—Contains a description for the asset. If the asset is a device, this 
field contains the device label. If it is a component, it contains the system description or 
sysDescr provided by the vendor if this information is available. 

 Class—Contains the asset classification for the asset type. Asset classes are defined 
by values defined in the Entity MIB. 

 Device Label—Contains the IMC name for the device, which, by default, is the name 
assigned to it in its device configuration. This field also contains the IP address. The 
device label serves as an active link for drilling down into the Device Details page, 
which offers you convenient access to device management features. 

 Device Type—Contains IMC's categorization of the device. If the asset is a component, 
it inherits the device type from the parent device. 

 Service Time—Contains the date and time stamp marking the start date of the asset's 
time in service. 

 Physical Asset—Contains the physical attributes of the asset. Yes indicates that the 
asset is a physical asset, and No indicates that the asset is a non-physical asset.  

 Modify—Contains a link for modifying the network asset entry. 

If the Network Asset List spans multiple pages, use the following aids to navigate the list: 
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 Click  to page forward in the Network Asset List. 

 Click  to page forward to the end of the Network Asset List. 

 Click  to page backward in the Network Asset List. 

 Click  to page backward to the front of the Network Asset List. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

3. For Network Asset lists that have more than one page, click 1, 2, 3, 4, 5, 6, 7, 8, 9,10 … from the 
upper middle or bottom right side of the main pane to jump to a particular page of the list.  

You can sort the Network Asset List by the Asset Name, Asset Description, Class, Device 
Label, Service Time, and Physical Asset fields. Click the column label to sort the list by the 
selected field. The column label is a toggle switch that lets you toggle between the various sort 
options specific to each field. 

Operators can view asset information only for the devices to which they have been granted 
management access. 

Viewing device level network asset details 

Device level asset information includes device specific asset details on the manufacturer, build, 
software, and hardware versions, IMC information on the specific device and operator remarks. It 
also includes sub module information, access to the interface list and an audit history for the 
individual device.  

Device level network asset information is displayed in the Network Asset Details page. This page 
has several sections: The Basic Information section, a Sub Module List of components, and an 
Audit History and a quick link to the Interfaces List for the selected device. 

Accessing the network assets details page 

To access network asset details: 

1. Navigate to Resource > Network Assets. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Network Assets on the left navigation tree. 

c. Click Network Assets under Network Assets on the left navigation tree.  

The Network Asset List is displayed in the main portion of the Network Assets page. 

2. Click the link in the Asset Name field for the device for which you want to view asset details.  

The Network Asset Details page is displayed for the selected. 

Viewing network asset details 

The Network Asset Details page contains network assets, Device Information, and Net Asset 
Information. Network asset information includes all asset information such as device chassis 
and modules.  

Click Hide Non Physical Asset to display only physical assets and hide all non-physical 
assets. Click Show Non Physical Asset to display all assets. Device Information contains two 
links, Device Label and Interface List for entering the Device Details page and Interface List 
page. Net asset information for network devices includes IMC specific device information and 
information gathered from the asset by IMC.  

Information about the device and its components that is gathered from it includes Asset Name, 
Asset Class, Asset Description, Manufacturer, Model, Serial Number, FRU, Asset Number, 
Asset OID, Physical Asset, Alias, Manufacture Date, Building Version, Hardware Version, 
Firmware Version/Boot ROM, Software Version, Card Serial Number, BOM Code, CLEI Code, 
Location, Department, Maintainer Contact Info, and Remarks. IMC displays this information if it 
can be polled from the asset.  
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Some of the fields in the Network Asset Details page include: 

 Device Label—Contains the IMC name for the device, which by default is the name 
assigned to it in its device configuration. This field also contains the IP address. The device 
label serves as an active link for drilling down into the Device Details page, which offers 
you convenient access to device management features. 

 Asset Name—Contains the asset name. At the device level, the asset name is derived from 
the device label in IMC. IMC populates the device label value with the sysName if it has 
been configured on the device and if the operator has not manually changed the device 
label in IMC. 

 Asset Class—Contains the asset classification for the asset type. 

 Asset Description—Contains a description for the asset. If the asset is a device, this field 
contains the device label. If it is a component, it contains the system description or sysDescr 
provided by the vendor if this information is available. 

 Service Time—Contains the date and time stamp marking the start date of the asset's time 
in service. 

 Maintenance Expiration Date—Expiration date of the asset's maintenance contract. 

 Remaining Maintenance—Time remaining before expiration of the asset's maintenance 
contract. This value equals Maintenance Expiration Date minus the current time. 

 Last Poll Time—Contains the date and time stamp for the asset audit that captured the 
current information. 

Operators can view asset information only for the devices to which they have been granted 
management access. 

Viewing audit history 

The Audit History section of the Network Asset Details page provides you with a list of all 
asset audits performed on the selected device. 

1. To access the Audit History list, click the Audit History link in the upper right corner of 
Network Asset Details page. 

Asset audit list 

 Audit Time—Contains a date and time stamp for the entry in the Audit History list. 

 Device Label—Contains the IMC name for the devices, which by default, is the name 
assigned to it in its device configuration. This field also contains the IP address. The device 
label serves as an active link for drilling down into the Device Details page, which offers 
you convenient access to device management features. 

 Asset Class—Contains the asset classification for the device. 

 Asset Name—Contains the asset name. At the device level, the asset name is derived from 
the device label in IMC. IMC populates the device label value with the sysName if it has 
been configured on the device and if the operator has not manually changed the device 
label in IMC. 

 Audit Options—Contains type of audit action performed. Possible audit actions include: 
add asset, modify firmware version, modify alias, delete asset, modify software version, 
modify asset ID, modify asset name, modify serial number, modify build information, modify 
hardware version, and modify model name. 

 Before Change—Contains a description of the asset prior to the change. 

 After Change—Contains a description of the asset after the change. 

If the Audit History list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Audit History List. 

 Click  to page forward to the end of the Audit History List. 

 Click  to page backward in the Audit History List. 
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 Click  to page backward to the front of the Audit History List. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

3. For Audit History lists that have more than one page, click 1, 2, 3, 4, 5, 6, 7, 8, 9,10 … from the 
upper middle or bottom right side of the main pane to jump to a particular page of the list.  

Viewing interface list 

The Interface section of the Network Asset Details page provides you with a list of interfaces 
on the selected device.  

To access the Interface List, click the Interface List link below the Device Information 
section of the Network Asset Details page. 

Network asset query 

You can query the Network Asset List for audit records for specific devices. You have two options 
for querying: a basic query and an advanced query. The following information provides information 
on each of these query methods. 

Basic query 

To perform a basic query: 

1. Navigate to Resource > Network Assets. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Network Assets on the left navigation tree. 

c. Click Network Assets under Network Assets on the left navigation tree.  

The Network Asset List is displayed in the main portion of the Network Assets page. 

The Network Asset Query section of the Network Assets page is located at the top of the 
main pane. 

The Basic Query section is displayed (by default) above the Network Asset list. The link to 
the far right is a toggle between Basic Query and Advanced Query. If the link is 
Advanced Query, then you are in the Basic Query mode. 

2. Enter one or more search criteria in the fields provided. 

 Asset Name—Enter the name of the asset in the Asset Name field. 

 Device Label—Enter the IMC name for the device in the Device Label field. 

 Device IP—Enter the IP address of the device you want to locate audit records for in the 
Device IP field. You can use the asterisk (*) as a wildcard for one or more digits in the IP 
address. 

 Class—Select the asset class from the Class list. 

3. Click Query. The results of the query are displayed in the Network Asset List portion of the 
page. 

Advanced query 

To perform an advanced query: 

1. Navigate to Resource > Network Assets. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Network Assets on the left navigation tree. 

c. Click Network Assets under Network Assets on the left navigation tree.  

The Network Asset List is displayed in the main portion of the Network Assets page. 

The Network Asset Query section of the Network Assets page is located at the top of the 
main pane. 
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The Basic Query section is displayed (by default) above the Network Asset list. The link to 
the far right is a toggle between Basic Query and Advanced Query. If the link is 
Advanced Query, then you are in the Basic Query mode. 

2. Click Advanced Query to navigate to the Advanced Query page. 

3. Enter one or more search criteria in the fields provided. 

 Asset Name—Enter the name of the asset in the Asset Name field. 

 Asset Description—Enter a portion of or the entire description in the Asset Description 
field. 

 Class—Select the asset class from the Class list. 

 Asset Number—Enter the number of the asset in the Asset Number field. 

 Serial Number—Enter the serial number of the asset in the Serial Number field. 

 Service Start Time—Enter a date and time when the asset you want to find was entered 
into service or entered into the Network Asset Manager. Click the textbox next to the 
Service Start Time field to enter the start time using the calendar function. 

 Service End Time—Enter a date and time the asset you want to find was removed from 
service or removed from the Network Asset Manager. Click the textbox next to the 
Service End Time field to enter the end time using the calendar function 

 FRU—Specify whether the asset is hot swappable.  

 Physical Asset—Select the asset's physical attributes from the Physical Asset list. 

 Asset OID—Enter the OID of the asset that you want to query. 

 Device Label—Enter the IMC name or device label in the Device Label field. 

 Device IP—Enter the IP address of the device you want to locate audit records for in the 
Device IP field. You can use the asterisk (*) as a wildcard for one or more digits in the IP 
address. 

 Device Type—Select IMC's categorization of the asset type you want to locate from the 
Device Type list. 

 Device Status—Select the status from the Device Status list for the assets you want to 
locate. 

4. Click Query. The results of the query are displayed in the Network Asset List portion of the 
page. 

5. Click Reset when you have finished and restored the Network Asset List to a complete 
display of all assets. 

Asset OID 
In the network asset manager, the assets fall into physical assets and non-physical assets. The IMC 
uses the OIDs to identify the asset types. You can add, modify, delete, and query the asset OIDs. 
Among the IMC reports, the device asset-related reports display only physical assets (by default).  

Asset OID list 

To view the asset OID list: 

1. Navigate to Resource > Asset OID. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Network Assets on the left navigation tree. 

c. Click Asset OID under Network Assets on the left navigation tree.  

The Asset OID List page is displayed in the main portion of the Asset OID page. 

Asset OID list 

 OID—Contains the OID. 
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 Name—Contains the name of the OID and specifies the asset type of the OID, for example, 
switch or port. 

 Type—Contains the OID generation type, which can be Predefined or User-defined.  

 Physical Asset—Contains the asset property. Yes indicates that the asset is a physical 
asset, and No indicates that the asset is a non-physical asset.  

 Description—Contains some description about the OID. 

 Modify—Contains a link for modifying the asset OID entry. You can modify only the 
user-defined OIDs.  

 Delete—Contains a link to delete the asset OID from the IMC. You can delete only the 
user-defined OIDs.  

If the Asset OID List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Network Asset List. 

 Click  to page forward to the end of the Network Asset List. 

 Click  to page backward in the Network Asset List. 

 Click  to page backward to the front of the Network Asset List. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

3. For Network Asset lists that have more than one page, click 1, 2, 3, 4, 5, 6, 7, 8, 9,10 … from 
the upper middle or bottom right side of the main pane to jump to a particular page of the list.  

You can sort the Asset OID List by the OID, Name, Type, Physical Asset, and Description 
fields. Click the column label to sort the list by the selected field. The column label is a toggle 
switch lets you toggle between the various sort options specific to each field. 

Asset OID query 

You can query the OIDs by setting the query conditions. The following information describes how to 
query OIDs.  

To query an asset OID: 

1. Navigate to Resource > Asset OID. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Network Assets on the left navigation tree. 

c. Click Asset OID under Network Assets on the left navigation tree.  

The Asset OID List page is displayed in the main portion of the Asset OID page. 

2. Enter one or more search criteria in the fields provided. 

 OID—Enter the partial or complete OID. 

 Name—Enter the partial or complete name of the OID. 

 Type—Select the OID generation type, which can be Predefined or User-defined. 

 Physical Asset—Select the asset property. Select Yes to query physical assets, and select 
No to query non-physical assets. 

3. Click Query. The results of the query are displayed in the Network Asset List portion of the 
page. 

4. Click Reset when you have finished and restored the Network Asset List to a complete display 
of all assets. 

Adding an asset OID 

To manually add an asset OID to the IMC: 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 8854



453 

1. Navigate to Resource > Asset OID. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Network Assets on the left navigation tree. 

c. Click Asset OID under Network Assets on the left navigation tree.  

The Asset OID List page is displayed in the main portion of the Asset OID page. 

2. Click Add. 

The Add Asset OID page opens. 

3. Enter the following information. 

 OID—Enter the OID, which is defined by the vendor. The OID must start and end with a digit 
and contain no wildcard, for example, 1.3.6.1.4.1.2011.10.3.1. 

 Name—Enter the name of the OID. This field specifies the asset type of the OID, for 
example, switch or port.  

 Physical Asset—Select the asset property. Select Yes if the OID is a physical asset, and 
select No when the OID is a non-physical asset. 

 Description—Enter any description of the OID.  

4. Click OK. 

5. Confirm that the OID you added is displayed in the Asset OID List. 

Modifying an asset OID 

To modify an asset OID to the IMC: 

1. Navigate to Resource > Asset OID. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Network Assets on the left navigation tree. 

c. Click Asset OID under Network Assets on the left navigation tree.  

The Asset OID List page is displayed in the main portion of the Asset OID page. 

2. Click the Modify link  located in the upper right corner of the Asset OID List page. 

The Modify Asset OID page opens. 

3. You can modify Name, Physical Asset, and Description. You can modify any of the following 
options as needed.  

 Name—Enter the new name in the Name field. 

 Physical Asset—Select the asset property. Select Yes if the OID is a physical asset, and 
select No if the asset is a non-physical asset. 

 Description—Enter any description of the OID.  

4. Click OK. 

Deleting an asset OID 

To delete an asset OID from the IMC: 

1. Navigate to Resource > Asset OID. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Network Assets on the left navigation tree. 

c. Click Asset OID under Network Assets on the left navigation tree. The Asset OID List is 
displayed in the main portion of the Asset OID page. 

2. Click the Delete link  located in the upper right corner of the Asset OID page. 

3. Click OK. Confirm that the OID is deleted from the IMC.  
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Managing asset information in Network Asset Manager 
You can manually add, modifying, remove, audit assets, and modify property. 

Manually adding a network asset 

To manually add a network device to the Network Asset Manager: 

1. Navigate to Resource > Network Assets. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Network Assets on the left navigation tree. 

c. Click the Network Assets icon under Network Assets on the left navigation tree. The 
Network Asset List is displayed in the main portion of the Network Assets page. 

2. Click Add. 

The Add Devices to the Network Asset Manager page opens. 

3. Click Add. 

You can add devices by using either the View or Advanced query option.  

Modifying a network asset 

To modify a network asset: 

1. Navigate to Resource > Network Assets. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Network Assets on the left navigation tree. 

c. Click the Network Assets icon under Network Assets on the left navigation tree. The 
Network Asset List is displayed in the main portion of the Network Assets page. 

2. Click the link in the Asset Name field for the device you want to modify.  

The Network Asset Details page is displayed for the selected device. 

3. Click the Modify link  located in the upper right corner of the Network Asset Details page. 

4. Do one of the following: 

 Modify the service time by entering a new service time in the Service Time field. A valid 
service time entry is YYYY-MM-DD HH:MM:SS. 

 Click the calendar function next to the Service Time field to select the date and time. 

5. Enter any comments in the Remarks field. 

6. Click OK to accept your changes. 

Modifying property 

To modify a network asset property: 

1. Navigate to Resource > Network Assets. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Network Assets on the left navigation tree. 

c. Click the Network Assets icon under Network Assets on the left navigation tree. The 
Network Asset List is displayed in the main portion of the Network Assets page. 

2. Select the asset name to select asset you want to modify.  

3. Click Modify Property. 

The Modify Property page opens. 

4. The Network Asset List contains information of selected assets.  

 Asset Name—Contains the asset name. The contents of this field serve as an active link for 
navigating to the Network Asset Details page. At the device level, the asset name is derived 
from the device label in IMC. Device labels are derived from sysName if it is configured and 
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if the operator has not manually configured it. Asset names for component level assets are 
defined in the MIB for the device. 

 Asset Description—Contains a description for the asset. If the asset is a device, this field 
contains the device label. If it is a component, it contains the system description or sysDescr 
provided by the vendor if this information is available. 

 Class—Contains the asset classification for the asset type. Asset classes are defined by 
values defined in the Entity MIB. 

 Device Label—Contains the IMC name for the device, which, by default, is the name 
assigned to it in its device configuration. This field also contains the IP address. The device 
label serves as an active link for drilling down into the Device Details page, which offers 
you convenient access to device management features. 

 Device Type—Contains IMC's categorization of the device. If the asset is a component, it 
inherits the device type from the parent device. 

 Service Time—Contains the date and time stamp marking the start date of the asset's time 
in service. 

 Physical Asset—Displays the physical property of the asset. Yes is displayed for a 

physical asset, and No is displayed for a non-physical asset.  

 Remove—Contain a link to delete the asset you want. 

5. Click the Delete icon  to delete the assets whose physical properties you do not want to 
modify. Click Delete All to delete all assets.  

6. Select the property from the Physical Asset list, which contains three options: Computed by 
system, Yes, and No. If you select the Computed by system, IMC determines whether an 
asset is physical in the following workflow: 

 If an asset is pluggable but is not an IRF member device, it is recognized as a physical 
asset. 

 If the OID of an asset is not suffixed with .0, the asset uses the physical property specified in 
the Asset OID entry. 

 If the OID of an asset is suffixed with .0 and the name does not contain the term "virtual" 
(case-insensitive), the asset is recognized as a physical asset. 

 If all these conditions are not satisfied, the asset is recognized as a non-physical asset. 

7. If you select the Yes, the asset is recognized as a physical asset by force.  

8. If you select the No, the asset is recognized as a non-physical asset by force.  

9. If you have selected Yes or No for a device, when the physical properties of the device change, 
the physical properties of the device are not changed in the IMC after the IMC synchronizes the 
device.  

10. Click OK. 

11. Check whether the Physical Asset properties of the assets modified are synchronized in the 
Network Asset List.  

Auditing a network asset 

To perform an audit for a selected device: 

1. Navigate to Resource > Network Assets. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Network Assets on the left navigation tree. 

c. Click Network Assets under Network Assets on the left navigation tree. The Network 
Asset List is displayed in the main portion of the Network Assets page. 

2. Click the link in the Asset Name field for the device you want to modify.  

The Network Asset Details page is displayed for the selected device. 

3. Click the Audit link located in the upper right corner of the Network Asset Details page. 
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IMC immediately initiates an audit for the selected device. 

4. Click Refresh to reload the Web page and view an updated Network Asset Details page for 
the selected device. 

Refreshing a network asset details view 

To refresh a Network Asset Details page: 

1. Navigate to Resource > Network Assets. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Network Assets on the left navigation tree. 

c. Click Network Assets under Network Assets on the left navigation tree. The Network 
Asset List is displayed in the main portion of the Network Assets page. 

2. Click the link in the Asset Name field for the device for which you want to view asset details. 
The Network Asset Details page is displayed for the selected device. 

3. Click the Refresh link located in the upper right corner of the Network Asset Details page to 
reload the Web page and review any updated information for the selected device. 

Removing a network asset 

To remove a Network Asset Details page: 

1. Navigate to Resource > Network Assets. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Network Assets on the left navigation tree. 

c. Click Network Assets under Network Assets on the left navigation tree. The Network 
Asset List is displayed in the main portion of the Network Assets page. 

2. Click the link in the Asset Name field for the device for which you want to view asset details. 
The Network Asset Details page is displayed for the selected device. 

3. Click Remove located in the upper right corner of the Network Asset Details page. 

4. Click OK to confirm the removal of the selected device from the Network Asset Manager. 

Review the results of the removal operation from the Network Assets page. 

Network asset auditing 
With Network Asset Auditing, you can view change information for the managed network assets. 
Asset changes can include adding, modifying, and removing assets, modifying asset names and 
modifying hardware versions. From this page, you can also query the Asset Audit database using the 
Asset Audit list basic and advanced query features.  

Viewing the asset audit list 

The Asset Audit List provides you with a view of asset audit entries.  

To view the Asset Audit list: 

1. Navigate to Resource > Asset Audit. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click the Asset Audit on the left navigation tree. 

The Network Asset List is displayed in the main portion of the Asset Audit page. 

Asset Audit List 

 Audit Time—Contains the date and time stamp for the asset's audit. 

 Device Label—Contains the IMC name for the device, which, by default, is the name 
assigned to it in its device configuration. This field also contains the IP address. The device 
label serves as an active link for drilling down into the Device Details page, which offers 
you convenient access to device management features. 
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 Asset Class—Contains the asset classification for the asset type. 

 Asset Name—Contains the asset name. The contents of this field serve as an active link for 
navigating to the Network Asset Details page. For more information about the Network 
Asset Details page, see "Viewing device level network asset details." 

At the device level, the asset name is derived from the device label in IMC. Device labels 
are derived from sysName if it is configured and if the operator has not manually configured 
it. 

 Audit Option—Contains information on the type of change that was discovered in the audit 
process. Audit options include: 

 Add Asset 

 Delete Asset 

 Modify Asset Name 

 Modify Hardware Version 

 Modify Firmware Version 

 Modify Software Version 

 Modify Serial Number 

 Modify Model Name 

 Modify Alias 

 Modify Asset ID 

 Modify Building Information 

 Before Change—Contains a description of the asset prior to the change. 

 After Change—Contains a description of the asset after the change. 

If the Asset Audit List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Asset Audit List. 

 Click  to page forward to the end of the Asset Audit List. 

 Click  to page backward in the Asset Audit List. 

 Click  to page backward to the front of the Asset Audit List. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

3. For lists that have more than one page, click 1, 2, 3, 4, 5, 6, 7, 8, 9, 10… from the bottom right 
side of the main pane to jump to a particular page of the list. 

Operators can view asset information only for the devices to which they have been granted 
management access. 

Asset audit query 

You can query the Asset Audit List for audit records for specific devices. You have two options for 
querying: a basic query and an advanced query. The following information provides information on 
each of these query methods. 

Basic query 

To perform a basic query: 

1. Navigate to Resource > Asset Audit. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Network Assets on the left navigation tree. 
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c. Click the Asset Audit icon under Network Assets on the left navigation tree. The Asset 
Audit List is displayed in the main portion of the Network Assets page. 

The Asset Audit Query section of the Network Assets page is located at the top of the main 
pane. 

The Basic Query dialog box is displayed (by default) above the Network Asset list. The 
link to the far right is a toggle between Basic Query and Advanced Query. If the link is 
Advanced Query, then you are in the Basic Query mode. 

2. Enter one or more search criteria in the fields provided. 

 Device IP—Enter the IP address of the device you want to locate audit records for in the 
Device IP field. You can use the asterisk (*) as a wildcard for one or more digits in the IP 
address. 

 Device Label—Enter the IMC name for the device in the Device Label field. 

 Asset Name—Enter the name of the asset in the Asset Name field. 

3. Click Query. The result of the query is displayed in the Asset Audit List portion of the page. 

Advanced query 

To perform an advanced query: 

1. Navigate to Resource > Asset Audit. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Network Assets on the left navigation tree. 

c. Click Asset Audit under Network Assets on the left navigation tree. The Asset Audit List 
is displayed in the main portion of the Network Assets page. 

The Asset Audit Query section of the Network Assets page is located at the top of the main 
pane. 

The Basic Query dialog box is displayed (by default) above the Network Asset list. The 
link to the far right is a toggle between Basic Query and Advanced Query. If the link 
displays Advanced Query, then you are in Basic Query mode. 

2. Enter one or more search criteria in the fields provided. 

 Device IP—Enter the IP address of the device you want to locate audit records for in the 
Device IP field. You can use the asterisk (*) as a wildcard for one or more digits in the IP 
address. 

 Device Label—Enter the IMC name for the device in the Device Label field. 

 Asset Name—Enter the name of the asset in the Asset Name field. 

 Asset Class—Select the asset class you want to locate audit records for from the Asset 
Class list. Options include All Classes and Subassembly. If you select All Classes, IMC 
locates audit records for all asset classes. If you select Subassembly, the page updates to 
include a list of audit records for subassembly asset classes only. By default, all 
subassembly options are selected. To remove options from the search, deselect the 

subassembly classes you do not want to search for by clicking the check marked box  to 
the left of each subassembly type. 

 Audit Options—This option lets you search for all or specific types of audit records. To 
locate all audit records, verify that All is selected. To locate specific audit records, select 
Selected. By default, all audit record types are selected. To remove options from the 
search, deselect the type of audit records you do not want to search for by clicking the check 
marked box to the left of each audit record type. 

 Audit Start Time—Enter a date and time for the audit start time for the assets you want to 
locate. Click the textbox next to the Audit Start Time field to enter the start time using the 
calendar function. 

 Audit End Time—Enter a date and time for the audit end time for the assets you want to 
locate. Click the textbox next to the Audit End Time field to enter the end time using the 
calendar function. 
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3. Click Query. The result of the query is displayed in the Network Asset List portion of the 
page. 

4. Click Reset when you have finished restoring the Network Asset List to a complete display of 
all asset audit records. 

Network asset global configuration options 
You can add devices to network asset management when devices are added to IMC. In addition, 
IMC lets you configure how frequently automatic asset audit synchronization occurs. For more 
information about this option, see "Configuring network asset audit options." 

Virtual Resource Management 
With VRM, you can manage virtual network devices such as physical servers, vManager (a server 
that manages virtual servers), virtual machines, and virtual switches. You can view virtual network 
resource configuration in Virtual Network View. By creating a vSwitch or port group, you can plan and 
manage your network. VRM can manage four types of vManagers, Microsoft Virtual Machine 
Manager, VMware vCenter Server, KVM, XenServer, and CAS. 

In addition, VRM provides the virtual machine migration function. A virtual machine can migrate from 
a physical server with limited resources to a physical server with enough resources to ensure the 
efficiency of the virtual machine. VRM automatically collects data on the vManager. In the Migration 
Recommendation List, you can select manual or automatic migration. After the migration is 
complete, you can view the migration report. 

The vManager users must be granted proper privileges to exchange data between VRM and the 
vManager, add, modify, and delete vSwitches and port groups, and perform virtual machine 
migration. 

To read data from VMware vCenter Server, the user must have at least the read-only privilege. To 
add, modify, or delete a vSwitch or port group, the user must be an administrator or have the network 
configuration privilege on vCenter Server. To perform application or virtual machine migration, the 
user must be an administrator or have the following privileges on vCenter Server: 

 Resource > Querying VMotion 

 Resource > Migration 

 Resource > Migration recommendation 

 Resource > Assigning virtual machines to resource pools 

 Resource > Redirect 

Only the root user can read data from an ESX server or perform other operations by directly 
accessing the ESX server through VRM. 

The domain users can perform all operations on Microsoft Virtual Machine Manager after they join 
the local Users group of the VRM server. To enable VRM to read data from or perform other 
operations on a Hyper-V server, make sure that the related user belongs to the Administrators group 
on the Hyper-V server. 

With the Topology function, you can see the virtual network architecture, facilitating planning a virtual 
network. 

Importing virtual resources 
To import virtual resources: 

1. Click the Resource tab from the top tabular navigation system. 

2. Select Virtual Resource Management > Import Virtual Resources on the left navigation 
tree. 
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The Import Virtual Resources page is displayed. 

3. Click Download Template to download the template for resource import. 

4. Follow the instructions to fill out the virtual resource information on the General Configuration, 
Hyper-V Direct, Hyper-V SCVMM, and KVM sheet tabs of the template. These types of virtual 
resources can be configured on the General Configuration tab: ESX/ESXi/vCenter, 
XenServer, PowerCenter, and CAS. 

5. Click Select File to select the template file. 

6. Click Upload File to upload the file. IMC will read the resource information in the file and display 
the information in the list below. 

7. To import all the listed virtual resources, click Import All.  

The import result will be displayed in the Status column. If the import failed, the reason will be 
displayed in the Error Message column. 

8. To clear the virtual resource list, click Clear All. 

Viewing virtual network 
Virtual Network View displays all resources and their relationship in a virtual network in a list. The list 
can expand and collapse, and includes three levels. In the list, the first-level nodes are physical 
servers (for example, VMware ESX server or Microsoft Hyper-V server), the second-level nodes are 
virtual switches created on the servers, and the third-level nodes are virtual machines connected to 
the virtual switches. You can click a resource name to view detailed resource information and 
perform operations on different resources. 

Virtual network view 

To view the virtual network: 

1. Click the Resource tab from the top tabular navigation system. 

2. Click Virtual Resource Management on the left navigation tree. 

3. Click Virtual Network View under Virtual Resource Management on the left navigation tree. 
The Virtual Network View is displayed in the main portion of the Virtual Resource 
Management page. 

Virtual network view 

 Expand/Collapse icon—Contains the expand/collapse icon to expand or collapse the 

associated resources (physical server). Click the Expand icon  to expand the associated 
physical server to view the virtual switches and virtual machines performed on the server. Click 

the Collapse icon  to collapse the physical server. 

 Resource Name—Contains the server IP address and device label. The server name serves 
as a link for navigating to the Server Details page. For more information about server details, 
see "Viewing server level details." 

 Status—Contains the alarming status of the server. Click the status icon to view the detailed 
alarm information of the server, including the alarm level, alarm source, type, description, alarm 
generation time, and alarm duration. 

 Operation—Contains the Topology icon . Clicking the topology icon navigates you to the 
VRM Topology. 

 Vendor—Contains the vendor of the server. 

 Model—Contains the model of the server. 

 Data Center—Contains the name of the data center where the server resides. 

 vManager—Contains information about the vManager for managing the server. 

 Memory—Contains the memory size of the server. 

 CPU—Contains the CPU information of the server. 
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 Support Migration—Contains information about whether or not the server supports migration. 

Viewing the resource list for a server 

The resource list includes the server, virtual switch, and virtual machine. 

To view the resource list for a server: 

1. Navigate to Resource > Virtual Resource Management > Virtual Network View. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Virtual Resource Management on the left navigation tree. 

c. Click Virtual Network View under Virtual Resource Management on the left navigation 
tree. The Virtual Network View is displayed in the main portion of the Virtual Resource 
Management page. 

2. Click the Expand icon  next to the server for which you want to view the resource list.  

The resource list of the server is displayed. 

To customize the columns displayed on the resource list, click Customize Columns in the 
upper right corner, select the desired columns, and then click OK. Available columns include 
CPU Usage (%), Memory Usage (%), Memory Active (KB), Memory Shared Common (KB), 
Memory Granted (KB), Memory Balloon (KB), Disk Read Rate (KBps), Disk Write Rate 
(KBps), Disk I/O Rate (KBps), Network Receive Rate (KBps), Network Transmit Rate 
(KBps), and Network Receive/Transmit Rate (KBps). 

By default, the resource list displays the following columns: 

 Resource Name—Contains the name of the virtual network device. The contents of this 
field serve as an active link for navigating to the details page. 

 Status—Contains the status of the virtual network device. For a physical server, this field 
displays the alarming status; for a virtual machine, this field displays Running, Stopped, 
and Suspend; for a virtual switch, this field displays no data. 

 Type—Contains the virtual network device type. 

 IP Address—Contains the IP Address of the virtual network device. 

 CPU Usage (%)—Contains the CPU usage ratio of the virtual network device.  

 Memory Usage (%)—Contains the memory usage ratio of the virtual network device.  

 Operation—Contains five operations, including Topology  , Join IMC , Manual 

Migration  (the Manual Migration icon is displayed only when the device joins IMC), 

Migration Recommendations  , Migration Reports , and VM Operation . 

Viewing server level details 

The Server Details page provides virtual network resources such as virtual machines and vSwitch, 
and allocation of the resources. The tree graph on the left displays the relationship between items 
under the server. The tabs on the right display the following information: 

 Server information 

 virtual machine configuration 

 vSwitch configuration 

 Port Group configuration 

 Network Card configuration 

 Storage Device configuration 

Four common buttons are provided in the upper right corner. They let you perform the following 
actions: 

 Add vSwitch 

 Add port group 
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 Synchronize 

 Quickly refresh operations 

Accessing the server details page 

To access physical server details: 

1. Navigate to Resource > Virtual Network View. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Virtual Resource Management on the left navigation tree. 

c. Click Virtual Network View under Virtual Resource Management on the left navigation 
tree. The Virtual Network View is displayed in the main portion of the Virtual Resource 
Management page. 

2. Click the link in the Resource Name field for the server for which you want to view details. The 
Server Details page is displayed for the selected server. 

Server 

Server details contains the server information that the IMC server obtains, including Server Name, IP 
Address, Vendor, CPU, Memory, whether migration is supported, Datacenter, and vManager. 

Some of the fields in the Server tab include: 

 Server Name—Contains the name of the server. You can modify the server name as needed. 

 Status—Contains the alarming status of the server. 

 IP Address—Contains the IP address of the server. 

 Label—Contains the label of the server. The value can be modified in the device details 
information. 

 Vendor—Contains the vendor of the server. 

 Model—Contains the model of the server. 

 CPU—Contains the CPU information of the server. 

 Memory—Contains the memory size of the server. 

 Support Migration—Contains information about whether the server supports migration. 

 Datacenter—Contains the name of the data center where the server resides. 

 vManager—Contains information about vManager for managing the server. 

 Startup Time—Contains the startup time of the server. 

 NTP Server—Contains the NTP server address. If no NTP server is specified, this field displays 
Unconfigured. 

 CPU Overcommit Ratio—CPU overcommit ratio. You can modify the setting as need. 

 Actual CPU Overcommit Ratio—Actual CPU overcommit ratio. 

 Memory Overcommit Ratio—Memory overcommit ratio. You can modify the setting as need. 

 Actual Memory Overcommit Ratio—Actual memory overcommit ratio. 

 Disk Overcommit Ratio—Disk overcommit ratio. You can modify the setting as need. 

 Actual Disk Overcommit Ratio—Actual disk overcommit ratio. 

Performance 

The Performance tab of the Server Details page displays the CPU usage and memory usage in the 
specified range of time for the current physical server by trend charts. 

The Performance tab of the Server Details page displays no data if the current physical server is 
not supported or monitored. 

Virtual machine 
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The virtual machines of the Server Details page provide a list of all virtual machines for the selected 
server.  

To access the Virtual Machine list, click the Virtual Machine tab in the Detail of Server page: 

 Virtual Machine Name—Contains the name for the Virtual Machine. You can click the name 
link to enter the details page of the virtual machine. On this page, you can view the hardware 
configuration, status, virtual network information, and the storage device information of the 
virtual machine. 

 Virtual Machine IP—Contains the IP Address of the Virtual Machine. 

 Status—Contains the status of the Virtual Machine, including Running, Stopped, and 
Suspended. 

 Migration Report—Contains a link for view virtual machine migration report. 

 Manual Migration—Contains a link for triggering manual migration. 

 VM Profile—Contains a link for modifying Profile. 

 Operation—Click the Operation icon  and select an option from the menu that appears to 
perform an operation for the associated virtual machine. 

vSwitch 

The vSwitch tab of the Server Details page provides a list of all vSwitch performed on the selected 
servers. 

To access the vSwitch list, click the vSwitch tab in the Server Details page: 

 Name—Contains the name of the vSwitch. 

 Number of Ports—Contains the port number of the vSwitch. 

 Modify—Contains a link for modifying the associated vSwitch. 

 Adv Properties—Contains a link for modifying the advanced properties of the vSwitch. 

 Delete—Contains a link for deleting the associated vSwitch. 

Port group 

The Port Group tab of the Server Details page provides a list of all port groups performed on the 
selected servers. The operations in the Port Group tab apply to only the VMware physical servers. 

To access the Port Group list, click the Port Group tab in the Server Details page. 

 Name—Contains the name of the port group. 

 Type—Contains the type of the port group. 

 VLAN ID—Contains the VLAN ID of the port group. 

 vSwitch—Contains the vSwitch to which the port group belongs. 

 IP Address—Contains the IP Address of the port group. 

 Mask—Contains the mask of the IP Address. 

 VLAN and Port—Hover over Detail for the port group, and a tip appears that displays the 
following information: VLAN to which the port group belongs, number of ports included in the 
port group, and binding type for ports. 

 Modify—Contains a link for modifying the associated port group. 

 Adv Properties—Contains a link for modifying the advanced properties of a port group. 

 Remove—Contains a link for removing the associated port group. 

Network card 

The Network Card tab of the Server Details page provides a list of all network cards on the selected 
servers. 

To access the Network Card list, click the Network Card tab in the Server Details page. 
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 Network Card Name—Contains the name of the network card. 

 vSwitch—Contains the vSwitch where the network card resides. 

 Type—Contains the type of the network card. 

 IP Address—Contains the IP Address of the network card. 

 Mask—Contains the mask of the IP Address. 

 Status—Contains the status of the network card. 

Storage 

The Storage tab of the Server Details page provides a list of all storage devices for the selected 
servers. 

To access the Storage list, click the Storage tab in the Server Details page. 

 Name—Contains the name of the storage device. 

 Type—Contains the type of the storage device. 

 Capacity (GB)—Contains the capacity of the storage device, in GB. 

 Free Space (GB)—Contains the free space of the storage device, in GB. 

Viewing the virtual network topology 

To view the virtual network topology: 

1. Navigate to Resource > Virtual Resource Management. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Virtual Resource Management on the left navigation tree. 

c. Click Virtual Network Topology under Virtual Resource Management on the left 
navigation tree. 

d. Or, click Virtual Network View under Virtual Resource Management on the left 
navigation tree. The Virtual Network View is displayed in the main portion of the Virtual 
Resource Management page. Select a server or VM in the Virtual Network View list. 

Click the Virtual Network Topology icon  in the Operation column. 

The VRM Topology is displayed in the Network Topology page. 

2. You can check the connection status of the virtual network. Double-click a server icon or 
double-click the blank area of the expanded sub-view to automatically expand or collapse the 
view to display or hide virtual switches and virtual machines on the server. 

For detailed topology operations, see "Viewing devices through the network topology." 

Server query 

You can query the servers for viewing detailed server, virtual machine, or virtual network information. 
The following information provides information on the query. 

To perform server query: 

1. Navigate to Resource > Virtual Resource Management > Virtual Network View. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Virtual Resource Management on the left navigation tree. 

c. Click Virtual Network View under Virtual Resource Management on the left navigation 
tree. The Virtual Network View is displayed in the main portion of the Virtual Resource 
Management page. 

2. Click Query in the upper right corner of Virtual Network View, and a search criteria dialog box 
opens. 

3. Enter one or more search criteria in the fields provided. IMC supports fuzzy matching for all 
fields. 

 Server Name—Enter the name of the server in the Server Name field. 
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 IP Address—Enter the IP address of the server in the Device IP field. 

 Virtual Machine Name—Enter a partial or complete name of the virtual machine that runs 
on the server in the Virtual Machine Name field. 

 Virtual Machine IP—Enter a partial or complete IP address of the virtual machine that runs 
on the server in the Virtual Machine IP field. 

4. Click Query. The results of the query are displayed in the Virtual Network View portion of the 
page. 

5. Click Reset when you have finished your search to restore the full Virtual Network View list. 

Refreshing virtual network view 

To refresh the Virtual Network View page: 

1. Navigate to Resource > Virtual Network View. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click the Virtual Resource Management on the left navigation tree. 

c. Click Virtual Network View under Virtual Resource Management on the left navigation 
tree. The Virtual Network View is displayed in the main portion of the Virtual Resource 
Management page. 

2. Click Refresh located in the upper left corner of the Virtual Network View page to reload the 
Web page and review any updated information. 

Configuring servers in Virtual Resource Management 

Adding vSwitch 

To add a vSwitch to a server: 

1. Navigate to Resource > Virtual Network View. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Virtual Resource Management on the left navigation tree. 

c. Click Virtual Network View under Virtual Resource Management on the left navigation 
tree. The Virtual Network View is displayed in the main portion of the Virtual Resource 
Management page. 

2. Click the Resource Name or the IP Address link of the server for which you want to add 
vSwitch. The Server Details page opens. 

3. Click the Add vSwitch link located in the upper right corner of the Server Details page. 

The Add vSwitch page opens. 

4. Enter the name of the vSwitch. 

5. Use the scrolling bar to select Number of the Ports, which ranges from 1 to 1016. 

6. Select one or more Physical Network Cards. 

7. Highlight the network cards you want to select and click Select. 

8. To select all of the physical network cards displayed in the Physical Network Card list, click 
Select All. 

9. Do one of the following: 

 To remove one or more, select them and click Remove. 

 To remove all of the selected devices, click Remove all. 

10. Confirm that the physical network cards you have found have been added. 

11. Click OK. 

Adding port group 

To add a port group to a server: 
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1. Navigate to Resource > Virtual Network View. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Virtual Resource Management on the left navigation tree. 

c. Click Virtual Network View under Virtual Resource Management on the left navigation 
tree. The Virtual Network View is displayed in the main portion of the Virtual Resource 
Management page. 

2. Click the Resource Name or the IP Address link of the server for which you want to add port 
group. The Server Details page opens. 

3. Click the Add Port Group link located in the upper right corner of the Server Details page. 

The Add Port Group page opens. 

4. Select a type of port group from the Type list. 

5. Enter the name of the port group in the Name field. 

6. Enter the VLAN ID in the VLAN ID field. 

7. Select a vSwitch from the vSwitch list. 

8. Enter the IP Address of the network card that binds to the vSwitch.  

If you select VMkernel in Step 4, this option is required. 

9. Enter the Mask of the IP address in the Mask field.  

If you select VMkernel in Step 4, this option is required. 

10. Click OK. 

Refreshing a server details page 

To refresh the Server Details page: 

1. Navigate to Resource > Virtual Network View. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Virtual Resource Management on the left navigation tree. 

c. Click Virtual Network View under Virtual Resource Management on the left navigation 
tree. The Virtual Network View is displayed in the main portion of the Virtual Resource 
Management page. 

2. Click the Resource Name or the IP Address of the server you want to view information. The 
Server Details page opens. 

3. Click the Refresh link located in the upper right corner of the Server Details page to reload the 
Web page and review any updated information. 

Configuring virtual machines in Virtual Resource 
Management 

Joining a virtual machine in IMC 

Use one of the following methods to add virtual machines. 

Method 1 

1. Navigate to Resource > Virtual Network View. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Virtual Resource Management on the left navigation tree. 

c. Click Virtual Network View under Virtual Resource Management on the left navigation 
tree.  

The Virtual Network View is displayed in the main portion of the Virtual Resource 
Management page. 
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2. In Virtual Network View, add a virtual machine to IMC. Click the Join IMC icon  in the 
Operation column.  

The Add Device page opens. 

3. Enter related parameters. Click OK. For more information, see "Adding devices manually to 
IMC." 

Method 2 

1. Navigate to Resource > Virtual Network View. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Virtual Resource Management on the left navigation tree. 

c. Click Virtual Network View under Virtual Resource Management on the left navigation 
tree.  

The Virtual Network View is displayed in the main portion of the Virtual Resource 
Management page. 

2. Click Unmanaged Host. 

The Unmanaged Host page opens and displays virtual machines that are discovered by 
vManagers but are not added to VRM. 

3. Click the Join IMC icon  for a virtual machine in the Operation column.  

The Add Device page opens. 

4. Enter virtual machine parameters and click OK. 

For more information about adding virtual machines, see "Adding devices manually to IMC." 

Method 3 

1. Navigate to Resource > Virtual Network View. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Virtual Resource Management on the left navigation tree. 

c. Click Virtual Network View under Virtual Resource Management on the left navigation 
tree.  

The Virtual Network View is displayed in the main portion of the Virtual Resource 
Management page. 

2. Click Unmanaged Host. 

The Unmanaged Host page opens and displays virtual machines that are discovered by 
vManagers but are not added to VRM. 

3. Select one or more virtual machines. 

4. Click Add. 

The system displays the operation result when the operation is complete. 

Operating a virtual machine 

VRM allows you to perform operations on virtual machines. 

This function supports the following types of virtual machines: ESX, Hyper-V, and XenServer. 

For ESX and Hype-V, physical servers must be managed by a vManager of the same vendor. The 
ESX and Hyper-V servers must be managed by vCenter and by SCVMM, respectively. For 
XenServer, the primary server must be added to VRM prior to the secondary server. 

Make sure the physical servers and the vManagers that manage virtual machines have been added 
to IMC and have access parameters correctly configured. 

Viewing the virtual machine list 

1. Click the Resource tab.  

2. From the navigation tree, select Virtual Resource Management > Virtual Network View.  
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3. Do one of following to display the virtual machine list: 

 Click the Expand icon  next to the server for which you want to view the virtual machine 
list. 

 Click the resource name or IP address of a physical server, and click the Virtual Machine 
tab on the Server Details page that opens. 

Starting a virtual machine 

1. Access the virtual machine list. 

2. Click the VM Operation icon  for a virtual machine in Stopped or Suspended status, and 
select Start from the menu that appears. 

The operation result appears in the upper right corner of the page. 

Stopping a virtual machine 

1. Access the virtual machine list. 

2. Click the VM Operation icon  for a virtual machine in Running or Suspended status, and 
select Stop from the menu that appears. 

The operation result is displayed in the upper right corner of the page. 

Suspending a virtual machine 

1. Access the virtual machine list. 

2. Click the VM Operation icon  for a virtual machine in Running status, and select Suspend 
from the menu that appears. 

The operation result is displayed in the upper right corner of the page. 

Resetting a virtual machine 

1. Access the virtual machine list. 

2. Click the VM Operation icon  for a virtual machine in Running status, and select Reset 
from the menu that appears. 

The operation result is displayed in the upper right corner of the page. 

Shutting down a client 

This function requires that Virtual Tools software runs on the virtual machine. 

1. Access the virtual machine list. 

2. Click the VM Operation icon  for a virtual machine in Running status, and select Shut 
Down Client from the menu that appears. 

The operation result is displayed in the upper right corner of the page. 

Rebooting a client 

This function requires that Virtual Tools software runs on the virtual machine. 

1. Access the virtual machine list. 

2. Click the VM Operation icon  for a virtual machine in Running status, and select Reboot 
Client from the menu that appears. 

The operation result is displayed in the upper right corner of the page. 

Modifying the configuration for a virtual machine 

1. Access the virtual machine list. 

2. Click the VM Operation icon  for a virtual machine in Stopped status, and select Modify 
Configuration from the menu that appears. 

3. Modify virtual machine configurations as needed on the window that opens: 

a. Click the Modify icon  next to the CPU field. Modify the CPU Quantity and Cores per 
CPU fields in the dialog box that opens, and click OK. 
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b. Click the Modify icon  next to the Memory field. Modify the memory size in the dialog box 
that opens and click OK. 

4. Configure the virtual disks for the virtual machine: 

 Click the Add Disk icon  and configure the virtual disk size in the dialog box that opens. 
Click OK. 

 Click the Modify icon  for a disk and modify the virtual disk size in the dialog box that 
opens. Click OK. 

 Click the Delete icon  for a disk and click OK. 

Deleting a virtual machine from the list 

Perform this task to delete a virtual machine from the virtual machine list of a vCenter server that 
manages the virtual machine. 

Deleting a virtual machine from the virtual machine list of a vCenter server does not delete the virtual 
machine that is stored in the vCenter server. You can recover the virtual machine for a specific 
vCenter server. 

To delete a virtual machine from the list: 

1. Access the virtual machine list. 

2. Click the VM Operation icon  for a virtual machine in Stopped status, and select Delete 
from List from the menu that appears. 

Deleting a virtual machine from a disk 

Perform this task to delete a virtual machine from the disk of the storage device that stores the virtual 
machine. 

Deleting a virtual machine from a disk deletes the virtual machine both from the virtual machine list of 
a vCenter server and the vCenter server. 

To delete a virtual machine from a disk: 

1. Access the virtual machine list. 

2. Click the VM Operation icon  for a virtual machine in Stopped status, and select Delete 
from Disk from the menu that appears. 

Cloning a Virtual machine template from a virtual machine 

This function does not support Hyper-V. 

To clone a Virtual machine template from a virtual machine: 

1. Access the virtual machine list. 

2. Click the VM Operation icon  for a virtual machine, and select Clone as Template from the 
menu that appears. 

The Add Template page opens. 

3. Configure the following parameters: 

 Enter a template name in the Template Name field. 

 Select a data center to which the virtual machine belongs from the Data Center list. 

 Select a cluster to which the virtual machine belongs from the Cluster list. 

 Select an IP address of a physical server in which the virtual machine is located from the 
Host list. 

 Select a storage device for storing the template file from the storage list. 

The storage list displays all storage devices in the physical server and displays the following 
information: 

 Storage—Name of the storage device. 

 Capacity—Capacity of the storage device. 

 Free Space—Free space of the storage device. 
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4. Click Finish. 

The Operation History page opens and displays the operation result. For more information 
about operation histories, see "Managing virtual machine operation histories." 

Converting a virtual machine to a template 

After the conversion, the virtual machine is deleted. 

To convert a virtual machine to a template: 

1. Access the virtual machine list. 

2. Click the VM Operation icon  for a virtual machine, and select Convert to Template from 
the menu that appears. 

The confirmation dialog box opens. 

3. Click OK. 

You can view the template that is successfully converted from the virtual machine on the VM 
template page. For more information about VM templates, see "Managing virtual machine 
templates." 

Cloning a new virtual machine from a virtual machine 

Perform this task to clone a new virtual machine from an existing virtual machine and configure 
parameters for the new virtual machine. 

The operation procedures for configuring parameters for the new virtual machine vary with the virtual 
machine types. This example uses the ESX type. 

To clone a new virtual machine from a virtual machine: 

1. Access the virtual machine list. 

2. Click the VM Operation icon  for a virtual machine, and select Clone as VM from the menu 
that appears. 

The Add VM window opens. 

3. Configure the following parameters: 

a. Enter a new VM name in the VM Name field. 

b. Select a data center to which the new virtual machine belongs from the Data Center list. 

c. Select a cluster to which the new virtual machine belongs from the Cluster list. 

d. Select an IP address of the host in which the new virtual machine is located from the Host 
list. 

e. Select a storage device for storing the new template file from the Storage list. 

The storage list displays all storage devices in the physical server and displays the following 
information: 

 Storage—Name of the storage device. 

 Capacity—Capacity of the storage device. 

 Free Space—Free space of the storage device. 

f. To configure the hardware for the new virtual machine, select Edit Hardware. By default, 
the hardware configuration of the original virtual machine is used. 

g. To configure the network properties for the new virtual machine, select Config Network. By 
default, the network properties of the original virtual machine are used. 

You can configure the network properties for the new virtual machine only when VMware 
Tools(for ESX) or Virtual Guest Services(for Hyper-V) is installed on the original virtual 
machine. XenServer does not support the network properties configuration. 

4. Click Next. 

5. If you have selected Edit Hardware, configure virtual hardware parameters on the Virtual 
Hardware page: 
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a. Enter a memory size for the new virtual machine in the Memory Size field. 

b. Select a number of CPUs for the new virtual machine from the CPU Quantity list. 

c. Select a number of cores per CPU for the new virtual machine from the Cores per CPU list. 

d. Configure the virtual disks for the new virtual machine. By default, the virtual disk list 
displays the disks that are used by the original virtual machine and the new virtual machine 
uses the disks. 

 Click the Add Disk icon  and configure the virtual disk size in the dialog box that 
opens. Click OK. 

 Click the Modify icon  for a disk and modify the virtual disk size in the dialog box that 
opens. Click OK. 

 Click the Delete icon  for a disk and click OK. 

6. Click Next. 

7. If you have selected Config Network, configure network properties on the Network 
Properties page. By default, the network adapter list displays the adapters that are used by the 
original virtual machine and the new virtual machine uses the adapters. The network adapter 
list displays the following information: 

 vNic—Name of the network adaptor. 

 MAC—MAC address of the network adapter. 

 IP—IP address of the network adapter. You can use a static IP address or obtain an IP 
address automatically through DHCP. 

To modify the network properties for a new virtual machine: 

a. Click the Configure icon  for a network adapter. 

The Config Network dialog box opens. 

b. Configure the IP address of the network adapter. Do one of following: 

 Select Obtain an IP address automatically through DHCP. 

 Select Use the following IP address and enter the IP address, subnet, and default 
gateway. 

c. Configure the DNS server of the network adapter. Do one of following: 

 Select Obtain a DNS server automatically through DHCP. 

 Select Use the following DNS server and enter the DNS server IP address. 

d. Click OK. 

8. Click Next. 

The summary page opens and displays the following configurations for the new virtual machine: 

 VM To Clone—Name of the virtual machine from which the new virtual machine is cloned. 

 VM Name—Name of the new virtual machine. 

 vManager—Name and IP address of the vManager that manages the host. 

 Host—IP address of the host in which the new virtual machine is located. 

 Data Storage—Storage device that stores the new virtual machine file. 

 Virtual Hardware—Hardware information about the new virtual machine. 

 Network Properties—Network properties of the new virtual machine. 

9. Click Finish. 

The operation history page opens and displays the operation result. For more information about 
the operation history, see "Managing virtual machine operation histories." 

Manually migrating a virtual machine 

You can migrate a virtual machine only when you add it into IMC. To manually migrate a virtual 
machine: 
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1. Navigate to Resource > Virtual Network View. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Virtual Resource Management on the left navigation tree. 

c. Click Virtual Network View under Virtual Resource Management on the left navigation 
tree.  

The Virtual Network View is displayed in the main portion of the Virtual Resource 
Management page. 

2. Click  Manual Migration in the Operation column of the virtual machine that you want to 
manually migrate in Virtual Network View.  

The Manual Migration page opens. 

3. Click the Select Resource Pool link corresponding to Target Server.  

The Resource Pool page opens. 

4. Select a resource pool from the Resource Pool list. 

5. Click OK. 

6. Click OK. 

Configuring auto migration 

1. Navigate to Resource > Migration Recommendations. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Virtual Resource Management on the left navigation tree. 

c. Click Migration Recommendations under Virtual Resource Management on the left 
navigation tree.  

The Recommendation List is displayed in the main portion of the Virtual Resource 
Management page. 

2. Click Mode: Auto link in the upper right corner of the Recommendation List. 

The Migration Settings page opens. 

3. Select the type of virtual machine migration from the Mode list. 

4. Use the scrolling bar to select the trigger time in the Execute after (minute) field. 

5. Click OK. 

Modifying a VM profile 

1. Navigate to Resource > VM Profile. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Virtual Resource Management on the left navigation tree. 

c. Click VM Profile under Virtual Resource Management on the left navigation tree.  

The VM Profile List is displayed in the main portion of the Virtual Resource Management 
page. 

VM profile list 

 Virtual Machine—Contains the name of the virtual network device. The contents of this 
field serve as an active link for navigating to the Network Asset Details page. At the 
device level, the asset name is derived from the device label in IMC. Device labels are 
derived from sysName if it is configured and if the operator has not manually configured 
it. Asset names for component level assets are defined in the MIB for the device. 

 IP Address—Contains the IP Address of the virtual network device. 

 Source Server—Contains a link of Source Server. You can click this link to enter the 
Detail of Server page. 

 Migration Report—Contains a link for the associated Migration Report. 

 Modify—Contains a link for modifying the associated VM Profile. 
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If the Audit History list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the VM Profile List. 

 Click  to page forward to the end of the VM Profile List. 

 Click  to page backward in the VM Profile List. 

 Click  to page backward to the front of the VM Profile List. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

3. For VM Profile lists that have more than one page, click 1, 2, 3, 4, 5, 6, 7, 8, 9,10… from the 
bottom right side of the main pane to jump to a particular page of the list. 

You can sort the VM Profile List by the Virtual Machine and IP Address fields. Click the 
column label to sort the list by and the selected field. The column label is a toggle switch that 
lets you toggle between the various sort options specific to each field. 

4. Click the Modify link  of the virtual machine for which you want to modify profile. The 
Modify Profile page opens. 

5. Enter the commands for configuring the switch connected to the virtual machine in the Profile 
field. 

6. Click OK. 

Viewing virtual machine recommendations 

To view the Recommendations of a Virtual Machine: 

1. Navigate to Resource > Migration Recommendations. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Virtual Resource Management on the left navigation tree. 

c. Click Migration Recommendations under Virtual Resource Management on the left 
navigation tree. The Recommendation List is displayed in the main portion of the Virtual 
Resource Management page. 

Recommendation list 

 vManager—Contains the vManager name and IP address. The contents of this field 
serve as an active link for navigating to the device details page. 

 Reason—Contains the reason for virtual machine migration. 

 Created—Contains the time when recommendations were created. If you select 
automatic migration, the system calculates the automatic migration trigger time by using 
this time as the start time. 

 Status—Contains the status of the recommendations. 

 Rating—Contains the rating of the recommendations. 

 Manually Execute—Contains a link for triggering manual migration. 

 Source Virtual Machine—Contains the name of the source virtual machine. The 
contents of this field serve as an active link for navigating to the source virtual machine 
details page. 

 Source Server—Contains the name of the source server. The contents of this field 
serve as an active link for navigating to the Detail of Server page. 

 Target Server—Contains the name of the destination server. The contents of this field 
serve as an active link for navigating to the Detail of Server page. 

 Migration Status—Contains the migration status. 
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If the Recommendation List spans multiple pages, use the following aids to navigate the 
list: 

 Click  to page forward in the Recommendation List. 

 Click  to page forward to the end of the Recommendation List. 

 Click  to page backward in the Recommendation List. 

 Click  to page backward to the front of the Recommendation List. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

3. For Recommendation lists that have more than one page, click 1, 2, 3, 4, 5, 6, 7, 8, 9,10… 
from the bottom right side of the main pane to jump to a particular page of the list. 

You can sort the Recommendation List by the Reason, Created, Status, Rating, Source 
Virtual Machine, and Migration Status fields. Click the column label to sort the list by the 
selected field. The column label is a toggle switch that lets you toggle between the various sort 
options specific to each field. 

Querying migration recommendations 

1. Navigate to Resource > Migration Recommendations. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Virtual Resource Management on the left navigation tree. 

c. Click Migration Recommendations under Virtual Resource Management on the left 
navigation tree.  

d. The Recommendation List is displayed in the main portion of the Virtual Resource 
Management page. 

2. Click Query in the upper right corner of the Recommendation List, and a search criteria dialog 
box opens. 

3. Enter one or more search criteria in the fields provided. 

 Virtual Machine Name—Enter the virtual machine name. Select Fuzzy from the list next to 
the field to perform fuzzy match for the virtual machine name. Select Exact from the list next 
to the field to perform exact match for the virtual machine name. 

 Source Server—Enter the source server name for virtual machine migration. 

 Target Server—Enter the target server name for virtual machine migration. 

 Rating—Select the virtual machine migration rating from Rating list. 

 Status—Select the virtual machine migration status from the Status list. 

 Reason—Enter the reason for the migration. 

 Migration Status—Select the migration status of the virtual machine from the Migration 
Status list. 

 Created from—Enter a date and time for the created time for the recommendations you 
want to locate. Click the textbox next to the Created from field to enter the start time using 
the calendar function. 

 To—Enter a date and time for the end time for the recommendations you want to locate. 
Click the field to the right to enter the end time using the calendar function. 

4. Click Query. The results of the query are displayed in the Recommendation List portion of the 
page. 

Viewing migration reports of the virtual machine 

1. Navigate to Resource > Migration Reports. 

a. Click the Resource tab from the top tabular navigation system. 
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b. Click Virtual Resource Management on the left navigation tree. 

c. Click Migration Reports under Virtual Resource Management on the left navigation tree.  

The Migration Report List is displayed in the main portion of the Virtual Resource 
Management page. 

 Virtual Machine—Contains the name of the virtual device. The contents of this field serve 
as an active link for navigating to the Virtual Machine details page.  

 Source Server—Contains the name of the source server of the virtual machine. 

 Target Server—Contains the name of the target server of the virtual machine. The contents 
of this field serve as an active link for navigating to the Detail of Server page.  

 Status—Contains the status of virtual machine migration. 

 Type—Contains the type of virtual machine migration, including manual and auto. 

 Start Date—Contains the start date for virtual machine migration. 

 End Date—Contains the end date for virtual machine migration. 

 View Report—Contains a link for viewing the associated migration report. 

If the Migration Report List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Migration Report List.  

 Click  to page forward to the end of the Migration Report List. 

 Click  to page backward in the Migration Report List. 

 Click  to page backward to the front of the Migration Report List. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

3. For Migration Report lists that have more than one page, click 1, 2, 3, 4, 5, 6, 7, 8, 9,10 … from 
the bottom right side of the main pane to jump to a particular page of the list. 

You can sort the Migration Report List by the Virtual Machine, Source Server, Status, 
Type, Start Date, End Date, and View Report fields. Click the column label to sort the list by 
the selected field. The column label is a toggle switch that lets you toggle between the various 
sort options specific to each field. 

4. Click the View Report link corresponding to the VM that you want to migrate. The Migration 
Report appears. 

5. In Virtual Machine Information, you can view information such as Virtual Machine Name, IP 
Address, Source Server, Source Server IP, Target Server, and Target Server IP. 

You can view the migration steps in the Step of Migration Report list. 

6. Click  in the upper right corner of the page to close the page. 

Querying migration reports 

1. Navigate to Resource > Migration Reports. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Virtual Resource Management on the left navigation tree. 

c. Click Migration Reports under Virtual Resource Management on the left navigation tree. 
The Migration Report List is displayed in the main portion of the Virtual Resource 
Management page. 

2. Click Query in the upper right corner of the Migration Report List, and a search criteria dialog 
box opens. 

3. Enter one or more search criteria in the fields provided. 

 Virtual Machine—Enter the virtual machine name. 

 Source Server—Enter the source server name for virtual machine migration. 

 Target Server—Enter the target server name for virtual machine migration. 
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 Status—Select the virtual machine migration status from the Status list. 

 Type—Select the virtual machine migration type from the Type list. 

 Start Date (From)—Select a time for the start date time range. Enter a date and time for the 
query start time for the migration reports you want to locate. Click the textbox next to the 
Start Date (From) field to enter the date and time using the calendar function. 

 Start Date (To)—Select a time for the start date time range. Enter a date and time for the 
query start time for the migration reports you want to locate. Click the textbox next to the 
Start Date (To) field to enter the date and time using the calendar function. 

 End Date (From)—Select a time for the end date time range. Enter a date and time for the 
query end time for the migration reports you want to locate. Click the textbox next to the End 
Date (From) field to enter the date and time using the calendar function. 

 End Date (To)—Select a time for the end date time range. Enter a date and time for the 
query end time for the migrations you want to locate. Click the textbox next to the End Date 
(To) field to enter the date and time using the calendar function. 

4. Click Query. The result of the query is displayed in the Migration Report List portion of the 
page. 

Modifying the advanced properties of a vSwitch or port group 

To modify the advanced properties of a vSwitch or port group: 

1. Navigate to Resource > Virtual Network View. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Virtual Resource Management on the left navigation tree. 

c. Click Virtual Network View under Virtual Resource Management on the left navigation 
tree.  

The Virtual Network View is displayed in the main portion of the Virtual Resource 
Management page. 

2. Click the link in the Resource Name field for the server for which you want to view details.  

The Server Details page is displayed for the selected server. 

3. Click the vSwitch or Port Group tab at the right part of the Server Details page. 

4. On the vSwitch or Port Group tab, click the  icon in the Properties area of the vSwitch or 
port group that you want to modify to open the Properties window. 

The Properties page provides the following types of parameters: Security, Traffic Shaping, 
and NIC Teaming. 

Security 

 Promiscuous Mode—Specify whether to enable the promiscuous mode, which provides 
the Reject and Accept options. Selecting the Reject option configures the VM adapter to 
operate in non-promiscuous mode. A VM adapter operating in non-promiscuous mode does 
not affect the received frames. Selecting Accept configures the guest adapter to operate in 
promiscuous mode. In this mode, the guest adapter can detect all frames passed on the 
vSwitch that are allowed under the VLAN policy for the port group in which the adapter is 
connected. 

 MAC Address Changes—Specify whether to accept the MAC address changes. This 
feature provides the Reject and Accept options. When you select Reject, if the VM 
changes the MAC address of the adapter to anything other than what is in the .VMX 
configuration file, all inbound frames are dropped. If the VM changes the MAC address back 
to match the MAC address in the .VMX configuration file, inbound frames are passed again. 
When you select Accept, if the VM changes the MAC address of the adapter to anything 
other than what is in the .VMX configuration file, frames to the new MAC address are 
received. 

 Forget Transmits—Specify whether to filter the outbound frames. This feature provides the 
Reject and Accept options. If you select Reject, the outbound frames with a source MAC 
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address that is different from the one currently set on the adapter is dropped. If you select 
Accept, no filtering is performed and all outbound frames are passed.  

Traffic shaping 

 Status—Specify whether to adjust the outbound traffic on vSwitches. This feature provides 
the Disable and Enable options. If you select Enable, you must configure the following 
parameters. 

 Average Bandwidth(Kbit/s)—Average bandwidth (in Kbps) of a port. 

 Burst Size(KByte)—The maximum number of bytes (in KB) allowed in a burst. If this 
parameter is set, a port can gain a burst bonus when it does not use all its allocated 
bandwidth. Whenever the port needs more bandwidth than specified by Average 
Bandwidth, it can be allowed to temporarily transmit data at a higher speed if a burst bonus 
is available. This parameter tops the number of bytes that may be accumulated in the burst 
bonus and thus transferred at a higher speed. 

 Peak Bandwidth(Kbit/s)—Set the peak bandwidth (in Kbps) of a port. The peak bandwidth 
specifies the maximum number of bits per second to allow across a port when it is sending a 
burst of traffic. This tops the bandwidth used by a port whenever it is using its burst bonus. 
This parameter can never be smaller than the average bandwidth. 

NIC teaming 

 Load Balancing—The load balancing policy determines how outgoing traffic is distributed 
among the network adapters assigned to a vSwitch. Incoming traffic is controlled by the load 
balancing policy on the physical switch. This feature provides the following options. 

 Route based on the originating port ID—Select an uplink based on the virtual port where 
the traffic entered the vSwitch. 

 Route based on IP hash—Select an uplink based on a hash of the source and destination 
IP addresses of each packet. For non-IP packets, whatever is at those offsets is used to 
compute the hash. 

 Route based on source MAC hash—Select an uplink based on a hash of the source MAC 
address of each packet. 

 Use explicit failover order—Always use the highest order uplink from the list of active 
adapters that passes failover detection criteria. 

 Network Failover Detection—Set the failover detection method, which can be Link Status 
only or Beacon Probing. 

 Link State only—Relies solely on the link status that the network adapter provides. This 
option detects failures, such as cable pulls and physical switch power failures, but not 
configuration errors, such as a physical switch port being blocked by spanning tree or 
misconfigured to the wrong VLAN or cable pulls on the other side of a physical switch. 

 Beacon Probing—Sends out and listens for beacon probes on all NICs in the team and 
uses this information, in addition to link status, to determine link failure. This option detects 
many of the failures mentioned above that are not detected by link status alone. 

 Notify Switches—Specify that a notification is sent over the network to update the lookup 
tables on the physical switches whenever a virtual NIC is connected to the vSwitch or 
whenever that virtual NIC's traffic is routed over a different physical NIC in the team 
because of a failover event. If you select Yes, whenever a virtual NIC is connected to the 
vSwitch or whenever that virtual NIC's traffic is routed over a different physical NIC in the 
team because of a failover event, a notification is sent over the network to update the lookup 
tables on the physical switches. In most cases, this is desirable for the lowest latency of 
failover occurrences and migrations with VMotion. Do not use this option when the virtual 
machines using the port group are using Microsoft Network Load Balancing (NLB) in unicast 
mode. No such issues exist with NLB running in multicast mode. 

 Failback—Specify how a physical adapter is returned to active duty after recovering from a 
failure. If failback is set to Yes, the adapter is returned to active duty immediately on 
recovering, displacing the standby adapter that took over its slot, if any. If failback is set to 
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No, a failed adapter is left inactive even after recovery until another active adapter fails, 
requiring its replacement. 

5. Use the Failover Order option to specify how to distribute the work load for adapters. To use 
some adapters but reserve others for emergencies, you can place them into the following 
groups. 

 Active Adapters—Specifies the active adapters. The vSwitch can continue to use the 
adapter when the network adapter connectivity is available and active. 

 Standby Adapters—Specifies the standby adapters. Use this adapter if one of the active 
adapter's connectivity is unavailable. 

 Unused Adapters—Specifies the unused adapters. Do not use this adapter. 

The Active Adapters, Standby Adapters, and Unused Adapters are in descending priority 
order.  

6. Click the  link of an adapter to increase the priority of the adapter in the current group. If the 
adapter is of the highest priority in the current group, clicking the  link adds it to a 
higher-priority group.  

7. Click the  link of an adapter to decrease the priority of the adapter in the current group. If the 
adapter is of the lowest priority in the current group, clicking the  link adds the adapter to a 
lower-priority group.  

8. Click OK. 

9. To modify the advanced properties of a Port Group, select the properties to active the 
properties. 

Managing virtual machine templates 

A VM template includes basic configuration of a virtual machine. You can use an existing VM 
template to fast deploy a new virtual machine. 

Viewing the virtual machine template list 

1. Click the Resource tab. 

2. From the navigation tree, select Virtual Resource Management > VM Template. 

The VM Template page displays all VM templates. 

VM Template List contents 

 Template Name—Name of the VM template. 

 vManager/Pool—Name of the vManager that manages the host in which the VM is located 
or name of the resource pool in which the VM is located. 

 CPU—Number of CPUs of the VM. 

 Memory—Memory size of the VM. 

 Disk—Disk information about the VM. 

 OS—Operating system of the VM. 

 Operation—Click an icon to perform an operation on the VM template. 

If the VM Template List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the VM Template List. 

 Click  to page forward to the end of the VM Template List. 

 Click  to page backward in the VM Template List. 

 Click  to page backward to the front of the VM Template List. 

3. To view the most recent VM template list, click Refresh. 

Deploying a virtual machine 
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The operation procedures for configuring parameters for a virtual machine vary with the virtual 
machine types. This example uses the ESX type. 

To deploy a virtual machine: 

1. Access the VM template list. 

2. Click the Deploy VM icon  for a VM template. 

The Add VM window opens. 

For more information about deploying a VM, see "Cloning a Virtual machine template from a 
virtual machine" 

Cloning a new virtual machine template from a virtual machine template 

1. Access the VM template list. 

2. Click the Clone icon  for a VM template. 

The Add Template window opens. 

For more information about cloning a new VM template from a virtual machine template, see 
"Cloning a Virtual machine template from a virtual machine." 

Deleting a virtual machine template from the list 

Perform this task to delete a template from the template list of a vCenter server that manages the 
template or from the disk of the storage device that stores the template. 

Deleting a template from the template list of a vCenter server does not delete the template that is 
stored in the vCenter server. VRM allows you to recover the template for a specific vCenter server. 
Deleting a template from the disk deletes the template both from the template list and the vCenter 
server. 

To delete a virtual machine template from the list: 

1. Access the VM template list. 

2. Click the Delete Template icon  for a VM template. 

The Delete Template dialog box opens. 

3. Select Disk or List from the Delete From list. 

4. Click OK. 

Managing virtual machine operation histories 

Viewing the virtual machine operation history list 

1. Click the Resource tab. 

2. From the navigation tree, select Virtual Resource Management > Operation History. 

The Operation History page displays all VM operation histories. 

VM Operation History List contents 

 VManager—Name of the vManager that manages the host to which the VM belongs. 

 Device Name—Name of the VM. 

 Task Name—Name of the task. 

 Task Progress—Task progress for the VM. 

 Start Time—Time when the task started. 

 End Time—Time when the task ended. 

 Task Result—Task result for the VM: Succeeded or Failed. 

 Failure Reason —Failure reason for the task. 

 Operation—Click the Delete icon  to delete the operation history. 

3. To view the most recent VM template list, click Refresh. 

4. To return to the previous page, click Back. 
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Deleting virtual machine operation histories 

1. Access the operation history list. 

2. To delete one operation history: 

a. Click the Delete icon  for an operation history. 

b. Click OK on the confirmation dialog box that opens. 

3. To delete one or more operation histories: 

a. Select one or more operation histories. 

b. Click Delete at the top of the operation history list. 

c. Click OK on the confirmation dialog box that opens. 
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Extending and customizing functions to 
support third-party devices 

The IMC network management platform supports extending device management and configuration 
functions through dynamic language scripts. You can either extend an existing function to support 
third-party devices by compiling interactive scripts and XML files, or customize a function by 
compiling interactive scripts, XML files, and UI configuration files.  

In either way, you can define vendor, drive, service, and action scripts through XML files, define 
device interaction through standard TCL\Expect scripts, and parse or process returned information 
through standard Perl scripts. Before customizing a function, you must compile UI configuration files 
so that IMC can automatically add the operation entrance and display pages as required.  

The function extension feature makes investment in IMC rewarding in a long term, and provides 
powerful regular expression processing capability by using the Expect and Perl language scripts. 
 

 NOTE: 

Promptly synchronize third-party device information to IMC if the device has extended or custom 
functions, so IMC can use these functions for device management. For information about device 
synchronization, see "Synchronize." 
 

Extending an existing function to support 
third-party devices 

You can extend IMC components to support third-party device management by customizing scripts. 
For example, by default, the IMC Configuration Center component supports configuration file 
management and software upgrade for devices of HPE, Cisco, and many other vendors.  

You can enable the component to support configuration file backup and deployment and software 
upgrade for other third-party devices by customizing the script. By default, IMC VLAN Manager 
supports VLAN management for devices of HPE, Cisco, and many other vendors. You can also 
enable the component to support VLAN management for other third-party devices by customizing 
the script.  

Follow these steps to customize a third-party device process: 

 Create a vendor folder. 

 Create a drive index file and a drive folder. 

 Create a drive definition file. 

 Create various service and action definition files. 

 Create TCL and Perl scripts. 

The content under the directory IMC\server\conf\adapters\ICC can be used as a reference. The 
following example illustrates how to extend Configuration Center to support Cisco devices.  

Creating a vendor folder 
Query the vendor name in IMC and then create the vendor folder. 

To query the vendor name: 

1. Navigate to System > Resource Management > Device Vendor.  

2. Click the System tab from the top tabular navigation system. 
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3. Click Resource Management on the left navigation tree. 

4. Click Device Vendor under Resource Management on the left navigation. 

Enter the Device Vendor List page.  

5. Enter the third-party device vendor name in the field on the left of Vendor Name. 

6. Click Query to display all matching vendor names on the Device Vendor List. Locate the 
target vendor name.  

If the target vendor does not exist, you can customize the vendor, series, and model. For more 
information, see "Configuring vendor and device information." 

7. Create a folder under the directory <IMC installation 
directory>\IMC\server\conf\adapters\ICC.  

8. Specify the target vendor name as the folder name.  

Creating a drive index file and a drive folder 
A vendor can provide devices of multiple series or models. These devices can use the same or 
different drive files for communication between each other. To manage the mappings between 
devices and drive files, create a drive index file and then create a drive folder for each drive.  

To create a drive index file and a drive folder: 

1. Open the third-party device vendor folder. 

2. Create a drive index file named adapter-index.xml.  

3. Create a drive folder (with customized name) for target devices. The drive corresponds to the 
devices with similar command lines for configuration back and deployment and software 
upgrade, for example, Cisco CatNative series.  

4. Query the target third-party device model.  

a. Click the System tab from the top tabular navigation system. 

b. Click Resource Management on the left navigation tree. 

c. Click Device Model under Resource Management on the left navigation tree. 

d. Access the Device Model List page.  

e. Enter the query criteria, and click Query to display all matching device models on the 
Device Model List. 

5. Get the sysOID of the target third-party device.  

6. Open the adapter-index.xml file, and create a drive folder for the device with the specified 
sysOID. You must create a drive folder for each drive, and use the drive name as the folder 
name. The format of the adapter-index.xml file: 
<?xml version="1.0" encoding="UTF-8"?> 

<!--sysOID adapt adapter--> 

<adapters>                                              <!—note 1>  

<default>CiscoIOSGeneric</default>                      <!-note 2> 

    <adapter name="CiscoIOSGeneric">                    <!—note 3> 

  <description>Cisco routers,800,1700  IOS version 12.x</description>        

                                                                                                         

<!—note 4> 

        <sysOID>1.3.6.1.4.1.9.1.17</sysOID>             <!—note 5> 

        <sysOID>1.3.6.1.4.1.9.1.208</sysOID>            <!—note 5> 

        <sysOID>1.3.6.1.4.1.9.1.185</sysOID>     

    </adapter> 

    <adapter name="CiscoIOS12K">                         <!—note 6> 
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        <description>Cisco routers, 12000 series (GSR), IOS version 

12.x</description> 

        <sysOID>1.3.6.1.4.1.9.1.45</sysOID> 

        <sysOID>1.3.6.1.4.1.9.1.46</sysOID> 

    </adapter> 

</adapters> 

 

Note 1—Label of drives in fixed format.  

Note 2—Default drive is used when the sysOID of the device does not match any of the 
following drives. 

Note 3—Drive name must be the same as the name of the drive folder.  

Note 4—Description.  

Note 5—sysOIDs supported by the drive.  

Note 6—Name of another drive supported by the vendor. 

Creating drive definition file 
Each drive folder contains various TCL/Expect files, service and action XML definition files, and Perl 
files of the drive.  

To create a drive definition file: 

1. Open the drive folder. 

2. Create a driver definition file adapter.xml. 

The format of the adapter.xml file: 
<adapter name="CiscoIOSGeneric">                                    <!—note 1>   

 <description>Cisco routers, 800, 1700 series, IOS version 12.x</description>     

                  <!-note 2>                                    

 <version>1.0.0</version> 

 <services>                                                         <!-note 3> 

     <uses-adapter vendor="H3C" adapter="H3CCommon"/>               <!-note 4> 

                   <service name="CLICommon">                <!-note 5>  

   <item type="common">Cisco_Common_CLI.xml</item>      <!-note 6>   

  </service> 

  <service name="CleanupParser">                              <!—note 7>  

   <item type="parser_definition">Cisco_Cleanup_Parser.xml</item>      

                  <!—note 8>   

   <item type="perl_script">Cisco_Cleanup_Parser_Script.pl</item>         

<!—note 9>      

</service> 

  <service name="ConfigBackup">                               <!—note 10> 

   <item 

type="builder_definition">Cisco_Config_Backup_Builder.xml</item>  

<!—note 11>    

   <item type="tcl_script">Cisco_Config_Backup_Builder_Script.xml</item>    

<!—note 12>    

  </service> 

  <service name="ConfigDeploy">                               <!—note 13> 

   <item 

type="builder_definition">Cisco_Config_Deploy_Builder.xml</item> 
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<!—note 11>   

   <item type="tcl_script">Cisco_Config_Deploy_Builder_Script.xml</item>   

<!—note 12>    

  </service> 

  <service name="ImageDeploy">                                 <!—note 14>  

   <item type="builder_definition">Cisco_Image_Deploy_Builder.xml</item> 

                                                                                           

                 <!—note 11>       

   <item type="tcl_script">Cisco_Image_Deploy_Builder_Script.xml</item>   

                  <!—note 12>     

  </service> 

 </services> 

</adapter> 

 

Note 1—Drive name must be the same as the name of the drive folder. 

Note 2—Description. 

Note 3—Label of services in fixed format. 

Note 4—If the local drive has the same services and command lines as another drive, you can 
specify that drive. You must define services different from the drive in use. The system 
automatically searches for a service in the definition file. If the search fails, the system uses the 
specified drive. 

Note 5—Common service name, which cannot be changed.  

Note 6—The type must be common.  

Note 7—Parse service name, which cannot be changed. 

Note 8—Parse definition file, whose type must be parser_definition. 

Note 9—Parse script file, whose type must be parser_script. 

Note 10—Configuration backup service name, which cannot be changed. 

Note 11—Action definition file, whose type must be builder_definition. 

Note 12—Action implementation file, whose type must be tcl_script. 

Note 13—Configuration deployment service name, which cannot be changed. 

Note 14—Software deployment service name, which cannot be changed. 

3. Open the adapter.xml file, and define services that the drive supports, including common 
service, parse service, configuration backup, configuration deployment, and software upgrade.  

The services other than the common services are determined by the extended component 
functions. The services above apply to Configuration Center and are different from those for 
VLAN component function extension. The services other than the common services are 
optional. 

 Common service (CLICommon) defines the device login process and common functions 
(for example, save, reboot, or delete a file). 

 Parse service (CleanupParser) provides a series of Perl script functions for parsing returned 
information acquired from the device.  

 Each of the configuration backup (ConfigBackup), configuration deployment 
(ConfigDeploy), and software deployment (ImageDeploy) services comprises an action 

definition file (builder_definition) and an action script file (tcl_script). The action 
definition file defines the actions of the service and the processing procedure of each action. 
The action script file specifies the execution environment and execution script for each 
action.  
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Defining the common service (CLICommon) 
The common service file name is xxxxxx_Common_CLI.xml (xxxxxx indicates the drive name). The 
common service file defines the device login process and common functions for device operations 
(for example, save/reboot/delete a file).  

The format of the common service file: 
<?xml version="1.0"?> 

<common>                                                   <!—note 1>     

     

    <mode name="initialize" method="CLI">                  <!—note 2>  

        <require-mode>connect</require-mode>               <!—note 3> 

        <enter>                                           <!—note 4> 

            initialize.tcl                                 <!—note 5> 

        </enter>                                         <!—note 6> 

    </mode>                                   

    <mode name="exec" method="CLI">                         <!—note 7> 

        <error>Failed to get to exec mode. </error>         <!—note 8> 

        <require-mode>initialize</require-mode>             <!—note 9> 

        <enter>                                                               

                <!—note 10> 

            enter_exec.tcl                                              

        </enter> 

        <exit>                                                                  

                <!—note 11>  

            exit_exec.tcl 

        </exit> 

    </mode> 

    <mode name="enable" method="cli"> 

        <error>Failed to get to enable mode. </error> 

        <require-mode>exec</require-mode> 

        <enter> 

            enter_enable.tcl 

        </enter> 

        <exit> 

            exit_enable.tcl 

        </exit> 

    </mode> 

 <function name="delete_file" method="CLI">              <!—note 12>  

     <error>An error occurred while trying to delete a file from the device.</error>   

        <enter>                                                                

                <!—note 13>  

   delete_file.tcl 

        </enter>                                                               

                <!—note 14>  

    </function> 

    <function name="save" method="CLI"> 

        <error>An error occurred while trying to save the configuration.</error> 

        <enter> 
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            save.tcl 

        </enter> 

    </function> 

</common> 

 

Note 1—Common label in fixed format. 

Note 2—Specifies the mode name and method (CLI). The common service must have the initialize 
mode. The label name is mode.  

Note 3—Specifies the required mode for the mode. connect indicates the connection mode. 

Note 4—enter label, which defines the execution script to enter the mode. 

Note 5—Script file, which must be available in the drive folder.  

Note 6—The initialize mode has only the enter label, and does not have the exit label. 

Note 7—Defines the mode name and method. 

Note 8—Error description. 

Note 9—Specifies the required mode for the mode.  

Note 10—enter label, which defines the execution script to enter the mode. 

Note 11—exit label, which defines the execution script to exit the mode.  

Note 12—Specifies the function and method. The method is CLI and label is function. 

Note 13—enter label and script of the function, which must be available in the drive folder. 

Note 14—The function has only the enter label, and does not have the exit label.  

For example, you must implement device configuration backup in enable mode, and locate the TCL 

files used to log in to the enable mode based on the require-mode, including initialize.tcl, 

enter_exec.tcl, and enter_enable.tcl. Execute these files in sequence for login and execute the 

exit_enable.tcl and exit_exec.tcl files for logout.  

Defining services and actions for a component 
Define services in the adapter.xml file. The following illustrates how to define services for 
Configuration Center. For instructions on defining services for other components, see relevant 
configuration files of the components.  

The services you can define in the adapter.xml file include configuration backup (ConfigBackup), 
configuration deployment (ConfigDeploy), and software deployment (ImageDeploy). Each service 

consists of an action definition file xxxxxx_Builder.xml and an action script file 

xxxxxx_Builder_Script.xml (xxxxxx indicates the action name). You can define multiple actions in 
the action definition file—each action corresponds to an action on the Configuration Center 
interface. The action script file provides a specific execution script for every action in the action 
definition file.  

Configuration Center supports the following services and actions (the action name cannot be 
modified): 

 Configuration backup (ConfigBackup) 

 backup_running_config 

 backup_startup_config 

 Configuration deployment (ConfigDeploy) 

 deploy_running_config 

 deploy_startup_config 
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 save_config 

 reload_device 

 Software deployment (ImageDeploy) 

 deploy_image 

 delete_image 

 set_device_boot 

 get_image_version 

 get_image_position 

 get_image_size 

 get_partion_info 

You must note the following guidelines when you define services for Configuration Center: 

 If you have defined the ConfigBackup service in the adapter.xml file, you must define 
backup_running_config, backup_startup_config, or both. These actions are executed during 
device configuration backup.  

 If you have defined the ConfigDeploy service in the adapter.xml file, you must define 
deploy_running_config, deploy_startup_config, or both. You must define save_config and 
reload_device.  

 When you deploy configurations, the deploy_running_config or deploy_startup_config action, 
based on your configuration, is executed. If no action is defined, the system prompts that 
deploy_running_config or deploy_startup_config is not supported. During deployment, both the 
deployment and save actions are executed. To specify the restart action, select Restart device 
after deployment on the Deploy Strategy page.  

 If you have defined the ImageDeploy service in the adapter.xml file, you must define 
deploy_image, set_device_boot, and delete_image. The actions get_image_position, 
get_image_version, get_image_size, and get_partion_info are optional. 

 When you deploy device software, deploy_image is executed. To execute set_device_boot and 
delete_image, make the settings as shown on the following page.  

 Set the Current Running Software as Backup Startup Software and Delete Current 
Backup Startup Software are not supported. These actions are not executed even if you have 
selected them.  

 The actions get_image_version and get_partion_info are used during software deployment. 
The get_partion_info action retrieves partition name and the available space. If these actions 
are not defined, the system asks you to enter the storage location, and perform software 
deployment without checking the available space (the default space is sufficient).  

 After deployment, the get_image_size action is executed to check the software size and 
deployment result. If this action is not defined, the checking is not performed.  

Defining specific services 

Defining the software deployment service 

1. xxxxxx_Image_Deploy_Builder.xml file format: 
<?xml version="1.0"?> 

<definition>                                              <!—note 1> 

 <action name="deploy_image">               <!—note 2> 

  <step>                                           <!—note 3> 

       <command name="deploy_image" description="download image through TFTP"/>   

<!—note 4> 

  </step>  
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 </action> 

 <action name="set_device_boot">          <!—note 5> 

     <step>                                               <!—note 6> 

      <command name="get_board_number" description="Get board number which current 

image is located through CLI">                               <!—note 7>  

          <result name="board_number">         <!—note 8> 

        <parser parserName="CleanupParser" parserRet="board_number" 

parserScript="cleanupBoardNumber"/>                    <!—note 9> 

       </result> 

      </command>       

  </step> 

        <step> 

            <properties>                                        

                 <!—note 10> 

       <property name="board" refer="board_number"/> <!—note 11> 

      </properties> 

            <command name="set_device_boot" description="set OS boot order through CLI"/>    

        </step> 

    </action> 

 <action name="delete_image">            <!—note 12> 

  <step> 

   <command name="delete_image" description="delete specified image"/> 

  </step> 

 </action> 

</definition> 

 

Note 1—Action definition label in fixed format.  

Note 2—Action name. All the following software deployment steps are performed based on this 
name. 

Note 3—Step. Each action can have multiple steps, which are executed in turn. 

Note 4—Commands required for this step. Define all commands in the 
xxxxxx_Builder_Script.xml file. Each step can consist of multiple commands, which are 
executed until one of the commands is executed successfully. For example, if you set to 
download configuration files through TFTP and display configuration files at the CLI, and the 
first command is successfully executed, the second command is not executed. 

Note 5—Action name, which is used to define the set_device_boot action. 

Note 6—Get the board number.  

Note 7—Command called to get the board name, which is defined in the 
xxxxxx_Builder_Script.xml file. 

Note 8—Define the result variable board_number, which provides the result after the following 
parser commands are executed. 

Note 9—Call the parser function. parserName specifies the parser service name, parserScript 
specifies the parser function, and parserRet specifies the parser result variable name. You do 
not need to specify the parameters for the parser function. The system uses all the returned 
parameters of the command above by default.  

Note 10—Properties label. All properties under this label are used as the variables in the TCL 
script of the following command. To be specific, the TCL script for set_device_boot can use the 
$board variable, and the variable is defined by the properties label. 

Note 11—Define the board variable. You can reference the board_number value obtained in the 
previous step, or specify a value. For example, property name="board" value="slot1".  
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Note 12—Delete the software.  

2. xxxxxx_Image_Deploy_Builder_Script.xml file format:  
<?xml version="1.0"?> 

<scripts>                                                    <!—note 1> 

 <command name="deploy_image" method="CLI">          <!—note 2>  

  <error>Failed to retrieve image in CLI.  Command syntax may be incorrect, or prompts 

may not be what was expected.</error>                               <!—note 3> 

  <require-mode>exec</require-mode>             <!—note 4> 

  <script> 

            deploy_image.tcl                                                 

                   <!—note 5> 

  </script> 

 </command> 

 <command name="set_device_boot" method="CLI">        <!—note 6> 

  <error>Failed to set boot order in CLI. Command syntax may be incorrect, or prompts 

may not be what was expected</error> 

  <require-mode>exec</require-mode>                   <!—note 4> 

  <script> 

            set_device_boot.tcl                                           

                   <!—note 5> 

  </script> 

 </command> 

 <command name="delete_image" method="CLI">           <!—note 6> 

  <require-mode>enable</require-mode>                  <!—note 4> 

  <script> 

            delete_image.tcl                                        <!—note 5> 

  </script> 

 </command> 

</scripts> 

<?xml version="1.0"?> 

 

Note 1—Scripts label in fixed format.  

Note 2—Command name and method. The method can be TFTP or CLI.  

Note 3—Error description.  

Note 4—Required mode.  

Note 5—TCL script.  

Note 6—set_device_boot action. 

Defining the parser service (CleanupParser) 

CleanupParser consists of parser definition file xxxxxx_Cleanup_Parser.xml and parser script file 

xxxxxx_Cleanup_Parser_Script.pl. xxxxxx refers to the drive name.  

To define the parser service (CleanupParser): 

1. xxxxxx_Cleanup_Parser.xml file format:  
<?xml version="1.0"?> 

<parser>                                                <!—note 1> 

 <perlfile>Cisco_Cleanup_Parser_Script.pl</perlfile>               <!—note 2> 

 

 <script name="cleanupConfiguration">                                  <!—note 3> 
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  <callfunction name="cleanupConfiguration">                   <!—note 4> 

   <parameterspec name="0" type="data_string"/>        <!—note 5> 

   <result type="single">configuration</result>             <!—note 6> 

  </callfunction> 

 </script> 

 <script name="cleanupTFTPConfiguration"> 

  <callfunction name="cleanupTFTPConfiguration"> 

   <parameterspec name="0" type="data_string"/> 

   <result type="single">cleanedConfig</result> 

  </callfunction> 

 </script> 

</parser> 

 

Note 1—Parser label in fixed format. 

Note 2—File to which the parser script file belongs. The label name is perlfile, which cannot 
be modified.  

Note 3—Script name, which is used for calling.  

Note 4—Called Perl function name. Perl functions are defined in the Perl file specified by the 
perlfile label.  

Note 5—Enter the parameter name and type. Only the string type, data_string, is supported. 

Note 6—Result variable. The parsing result assigns value to the variable, which is used by the 
caller. Array is not supported, so the type is single.  

2. The parser script file xxxxxx_Cleanup_Parser_Script.pl consists of multiple Perl functions.  
sub cleanupConfiguration 

{ 

 my($config) = @_; 

 my(@array) = (); 

 

 $start = index($config, "!"); 

 if ($start == -1) 

 { 

  $start = 0; 

 } 

       … … 

 ## 

 # ACNS remove CLI prompts 

 $config =~ s/\n\S+#\n/\n/g; 

 

 $cleanConfig = $config; 

 

 return $cleanConfig; 

} 

 

sub cleanupTFTPConfiguration 

{ 

 my($config) = @_; 

 

 $start = index($config, "!"); 
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 if ($start == -1) 

 { 

  $start = 0; 

 } 

 

 return substr($config, $start); 

} 

 

Defining the TCL script and Perl script 
The TCL script consists of Expect commands. You do not need to compile the Telnet connection 
device code because the connection is performed by the Configuration Center background. You 
only need to compile returned value judgment and login interaction scripts, for example, 
enter_exec.tcl.  

Some variables in the TCL script do not need to be defined. They are provided from the 
Configuration Center background. 

To define the TCL script and Perl script: 

 Common variables 

 ERROR_MESSAGE [OUT] (If the script has an error, you must assign a value to the variable. 
Configuration Center then judges the execution result based on the variable.)  

 Username [IN] (Telnet user name) 

 Password [IN] 

 enable_password [IN] 

 Configuration backup variables 

 TFTPFile [IN] (local file name) 

 TFTPServer [IN] 

 Configuration deployment variables 

 TFTPFile [IN](local file name) 

 TFTPServer [IN] 

 Testvalue [OUT] (This variable is used for running configuration deployment. Assign a value, 
true or false, to it, indicating whether the deployment is completed.) 

 Deleting software variables 

 TFTPFile [IN] (device software name) 

 TFTPServer [IN] (TFTP server) 

 transfer_protocol [IN] (protocol) 

 slot [IN] (software location) 

 Software upgrade variables 

 TFTPFile [IN] (local file name) 

 DestTFTPFile [IN] (destination file name) 

 TFTPServer [IN] 

 transfer_protocol [IN] (protocol) 

 slot [IN] (software storage location) 

 Variables for setting startup software  

 transfer_protocol [IN] (protocol) 
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 slot [IN] (software storage location) 

 TFTPFile [IN] (device software name) 

 Variables for obtaining partition information 

 partion_name [OUT] (partition name) 

 free_size [OUT] (free space) 

 Variable for obtaining software version 

 image_version [OUT] (software version) 

 Variable for obtaining software location 

 image_position [OUT] (software location) 

 Variable for obtaining software size 

 TFTPFile [IN] (software version, obtained by executing the get_image_version command) 

 Slot [IN] (software location, obtained by executing the get_image_position command) 

 image_size [OUT] (software size) 

Use standard Perl script language to compile the Perl script.  
 

 IMPORTANT: 

After you customize the script, restart IMC to validate new functions.  
 

Extending a customized function 
IMC supports customizing new functions and can automatically generate entrance pages for the new 
functions based on the definitions in the Device Configuration Guide or Interface Configuration 
Guide. To enter the Device Configuration Guide or Interface Configuration Guide, use one of 
the following ways:  

 Select Resource > Batch Operation, and select Device Configuration Guide and Interface 
Configuration Guide from Device Configuration, or 

 Select Resource > Device View. On the device list page, click More and select Device 
Configuration Guide, or  

 In topology view, right-click a device and select Device Configuration Wizard, or 

 On the device interface list page, click More and select Interface Configuration Guide, or 

 Select Resource > Port Group List. On the interface list page, select Interface Configuration 
Guide. 

To extend the customized function, you must compile the background customized function script in 

the <IMC installation directory>\server\conf\adapters\custom. At the same time, create the 
following files as follows: 

<IMC installation directory>\client\web\apps\imc\gencfg\register\custom directory. 

 Operation definition file—<component name>_operations.xml 

This file is issued to define operations supported by the component. See the following 
description for the file format.  

 Device capability set definition file—<component name>_devCapabilities.xml 

This file is used to define the device capability set supported by the operations of the 
component. See the following description for the file format. 

 English resource file—<component name>.properties 

This file is used to define English resource information used in the component 
name_properties file.  
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 IMPORTANT: 

After you compile the files and restart IMC, the files are automatically loaded.  
 

The content in the IMC\server\conf\adapters\GenericConfig directory can be used as a reference 
for the background custom script.  

The content in the IMC\client\web\apps\imc\gencfg\register\gencfg directory can be used as a 
reference for the UI definition script. 

Defining background custom script 
Enter the IMC\server\conf\adapters\custom directory (if it is not available, create the directory), 
and following these steps to compile the background custom script. For more information about the 
steps, see "Extending an existing function to support third-party devices."  

To define background custom script: 

1. Create a vendor folder. 

2. Create a drive index file and a drive folder. 

3. Create drive definition file. 

4. Create various services and actions definition file. 

5. Create the TCL script and Perl script. 

Registering service operation and compiling operation definition file 

The operation definition file is in the XML format. The file name must be <component 

name>_operations.xml. The file defines operations supported by the component. The following is an 
example:  
#Global resource 

str.gencfg.yes=Yes 

str.gencfg.no=No 

 

#Create Telnet User 

str.create.telnet.user=Create Telnet User 

str.telnet.user.name=User Name 

str.telnet.user.name.info=Only number,'_' and English character are allowed, start with 

English character, no longer than 32 characters. 

str.telnet.user.password.mode=Password Mode 

str.telnet.user.password=Password 

str.telnet.user.password.info=No longer than 32 characters. 

str.telnet.user.level=User Level 

str.telnet.user.service.type=Service Type 

 

The following describes properties supported by the elements in the file.  

Operations 

The Operations element is the root node of the operation definition file in Table 24.  
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Table 24 Properties supported by the Operations element 

Property 
name 

Description Required Remarks 

devCapability 
Device capability 
set supported by 
the component 

N 

 The capability set must be defined in the 
<component name>_devCapabilities.xml file or 
be ALL (which means supports all devices).  

 It is ALL by default.  

 devCapability="" means not support any device. 
 The values of devCapability can be the capability 

sets defined in the <component 
name>_devCapabilities.xml file, separated by 
colons (:).  

 

Example: 
<Operations devCapability="baseDC,dc1"> 

          <!—-operation definition--> 

</Operations> 

 

Variable 

The Variable element is used to define a variable. The consequent operation definitions can 
reference the variable in the format ${}.  

The user-defined variable takes precedence over the system-defined variable.  

For more information about replaceable variables, see Table 25.  

Table 25 Properties supported by the Variable element 

Property 
name  

Description  Required  Remarks  

Name Variable name  Y  The value can contain only letters, digits, 
underlines (_), and dots (.).  

Value Variable value  Y  N/A  
 

Example: 
<Variable name="RestServerIP" value="10.153.88.70" /> 

Operation 

Operations can contain multiple operation definitions, each of which defines a service operation in 
Table 26.  

Table 26 Properties supported by the Operation element 

Property 
name  

Description  Required  Remarks  

Id Operation ID  Y  A character string consisting of letters or digits 
and unique in a file.  

Label Operation display 
name  Y  A resource string starting with %.  

categoryID Category ID of the 
operation  Y  

The operation category is defined in the 
categoryDef.xml file. See the later sections 
for more information.  
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Property 
name  

Description  Required  Remarks  

actionId Primary action ID  Y  
Action executed for the operation. The value 
must have been defined in the operation. Other 
actions can be called secondary actions.  

actionType Primary action type  Y  Enumerated value: 1(REST) or 2(ASN1).  

operLevel Operation level  N  

Indicates whether the operation is port level or 
device level. It is an enumerated value: 
1(DEVICE) or 2(PORT). The default value is 
1—device level.  

devCapability Device capability set  N  

Indicates the device capability set supported by 
the operation. The capability set must be 
defined in the <component 
name>_devCapabilities.xml file. The 
default is the device capability set defined by 
the Operations element (rather than ALL). 

 

The operations with the same name in different registration files are considered one operation. The 
following information for the operations must be consistent: 

 Operation ID (id) 

 Category ID of the operation (categoryId) 

 Operation display name (label) 

 Operation level (operLevel) 

 For parameters of the actions (primary and secondary actions) of the operation, the values, 
numbers, sequence (compiling sequence), and property values (unique for each property) must 
be the same.  

For the operations with the same name in different registration files, the following items are typically 
different.  

 Capability set (devCapability) (If the capabilities are the same, the defined operations are 
meaningless.) 

 Primary action name (actionName). 

 Primary action type (actionType). 

 Action (primary and secondary) properties, excluding the parameter information.  
 

 NOTE: 

If the operations with the same name do not satisfy the requirement of information consistency, the 
system discards the loaded operations and logs the event.  
 

Example: 

<Operation id="addXXXX" category="%str.category1" label="%str.addXXXX" 
actionName="addXXXXAction" actionType="1" operLevel="1" devCapability="dc1"> 

...<!—-action and parameter definition--> 

</Operations> 

RestAction and Asn1Action 

The operation definitions include operation parameter definition and action definition. Although an 
operation requires one action, the operation parameter initialization typically requires additional 
actions, so you can define multiple actions. Only the action corresponding to actionName is 
executed for the operation. The system dynamically generates input interface only for this action.  
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Common configurations support two types of actions: REST action and ASN1 action. The REST 
action is executed in the REST mode. The ASN1 action is executed in the ASN1 and background 
communication modes, listed in Table 27 and Table 28. 

Table 27 Properties supported by the RestAction element 

Property 
name  

Description  Required  Remarks  

Id ActionID  Y  A character string consisting of letters or digits 
and unique in an operation.  

protocol Protocol  Y  HTTP or HTTPS  

ip IP address  Y  
Supports replaceable variable, for example, 
${ IMC_SERVER_IP }.  

port Port number  Y  
Supports replaceable variable, for example, 
${ IMC_HTTP_PORT } or 
${ IMC_HTTPS_PORT }.  

uri URI used by the REST 
operation  Y  For example, /IMCrs/vlan?devId=33. 

userName Authentication 
username  Y  

Supports replaceable variable, for example, 
${ IMC_USER_NAME }. 

userPassword Authentication 
password  Y  

Supports replaceable variable, for example, 
${ IMC_USER_PWD }. 

method Method used by the 
REST operation  Y  Enumerated value: 1(GET), 2(POST), 3(PUT), 

or 4(DELETE).  

bufferSize Buffer size  N  The default is 8192 bytes.  

Timeout Timeout time (in 
milliseconds)  N  The default is 5000 milliseconds.  

class  
Entity class used by the 
REST operation  N  

 
 If the REST method is POST or PUT, this 

parameter is typically required. When the 
parameter is provided, the instantiation of 
an entity object is done, and an XML file is 
generated and sent to the REST server. At 

this time, the entityProperty and 

dataType properties must be specified for 

each Parameter element.  

   

 
 If the REST method is GET or DELETE, 

this parameter is typically not required. 
When the parameter is not provided, the 
system sends the parameter value 
entered by the user as the URL parameter 
to the REST server. At this time, the 

system ignores the entityProperty and 

dataType properties of the Parameter 

elements. 
 

Example 1: usestatic URL values 
<RestAction id="getXXXXAction" protocol="http" ip="10.153.88.70" port="8080" 

uri="/IMCrs/XXXX" userName="${IMC_USER_NAME}"  userPassword="${IMC_USER_PWD}" 

method="1"> 

    <Parameter name="devId" value="${DEVICE_ID}"/> 

</RestAction> 
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Example 2: use replaceable URL variables 
<RestAction id="getXXXXAction" protocol="http" ip="${RestServerIP}" 

port="${RestServerPort}" uri="/imcrs/XXXX" userName="${IMC_USER_NAME}"  

userPassword="${IMC_USER_PWD}" method="1"> 

    <Parameter name="devId" value="${DEVICE_ID}"/> 

</RestAction> 

 

Example 3: send REST request by using the entity class 
<RestAction id="addXXXXAction" protocol="http" ip="${RestServerIP}" 

port="${RestServerPort}" uri="/imcrs/XXXX" userName="${IMC_USER_NAME}"  

userPassword="${IMC_USER_PWD}" method="2" class="com.h3c.imc.XXXEntity"> 

        <Parameter name="devId" value="${DEVICE_ID}" entityProperty="id" 

dataType="java.math.BigInteger"/> 

</RestAction> 

 

Example 4: send REST request by using the URL parameter 
<RestAction id="getXXXXAction" protocol="http" ip="${RestServerIP}" 

port="${RestServerPort}" uri="/imcrs/XXXX" userName="${IMC_USER_NAME}"  

userPassword="${IMC_USER_PWD}" method="1"> 

        <Parameter name="devId" value="${DEVICE_ID}"/> 

</RestAction> 

 

Table 28 Properties supported by the Asn1Action element 

Property 
name  

Description  Required  Remarks  

Id Action ID  Y  
A character string consisting of letters or digits, 
unique in an operation, and consistent with the 
actionName in the background script.  

serviceName Service name  Y  
It must be consistent with the serviceName 
field in the background script. 

actionName Action name  Y  
It must be consistent with the actionName field 
in the background script. 

operType Operation type  Y  Enumerated value: 1 (deploy configuration) or 2 
(get configuration)  

operMode Operation mode  N  Enumerated value: 0 (any), 1 (SNMP), or 2 
(CLI). The default is 0.  

transProtocol Transmission protocol  N  Enumerated value: 0 (any), 1 (TFTP), 2 (FTP), 
or 3 (SFTP). The default is 0.  

execMode Execution mode  N  Enumerated value: 1 (synchronous) or 2 
(asynchronous). The default is 1.  

Timeout Timeout time (in 
seconds)  N  The default is 300 seconds.  

 

Example 5: 
<Asn1Action id="getXXXXAction" serviceName="getXXXX" actionName="getXXXX" operType="2" 

timeout="300"> 

   <Parameter name="devId" value="$(DEVICE_ID)"/> 
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 <Parameter name="vlanId" value="1"/> 

</Asn1Action> 

 

Parameter 

The Parameter element, as shown in Table 29, is used to define parameters for operations. Each 
parameter can define its own view, and whether to perform initialization, and if yes, how to perform 
initialization. For the view and initialization description, see the following information.  

The common configuration framework generates the dynamic interface for only the primary action 
(identified by the actionName property of the Operation element). The sequence of parameters on 
the interface is consistent with that defined in the registration file.  

Table 29 Properties supported by the Parameter element 

Property name  Description  Required  Remarks  

Name Parameter name  Y  A character string consisting of letters or 
digits. Unique in an action.  

Value Parameter value  N  
Supports replaceable variable. The system 
does not generate dynamic interface for the 
parameter whose variable is replaced.  

Label Parameter display 
name  N  A resource string starting with %. If it is null, 

the name value is displayed.  

Required Required or not  N  The value can be true or false. The default is 
true (required).  

entityProperty Entity class property 
of the parameter  N  

Required when the class property of 
RestAction is not null. The system calls the 
setter of the property to assign a value to it.  

dataType Entity property data 
type of the parameter  N  

Required when the class property of 
RestAction is not null. The following data 
types are supported (package name is 
contained in the type name): 

Basic data type: 
 boolean 
 byte 
 double 
 float 
 int 
 long 
 short 
 char 
 Boolean type: 
 java.lang.Boolean 

String type: 
 java.lang.String 

Number type: 
 java.lang.Byte 
 java.lang.Double 
 java.lang.Float 
 java.lang.Integer 
 java.lang.Long 
 java.lang.Short 
 java.math.BigInteger 
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Property name  Description  Required  Remarks  

validateRegEx Validation with 
regular expression  N  

Regular expression used for validation. If it is 
null, no validation is performed.  

defaultValue Default value  N  It is null by default.  

Info Prompt information  N  

Tooltip help information behind the input box. 
It is a resource string starting with %. Prompt 
information display is supported by only text 
boxes, combo boxes, and calendar control.  

 

Example 1: a parameter, which has its view defined as SelectManyCheckbox, and has static 
initialization performed.  
    <Parameter name="param8" label="%str.param8"> 

       <View type="SelectManyCheckbox" layout="1"> 

        <SelectItem value="1" displayValue="Monday"/> 

            <SelectItem value="2" displayValue="%str.tuesday"/> 

     <SelectItem value="3" displayValue="Wednesday"/> 

     <SelectItem value="4" displayValue="Thursday"/> 

     <SelectItem value="5" displayValue="Friday"/> 

<SelectItem value="6" displayValue="Saturday"/> 

<SelectItem value="7" displayValue="Sunday"/> 

 </View>  

</Parameter> 

 

Example 2: if no view is defined, the text box InputText is used by default 
<Parameter name="param6" label="%str.param6"/> 

Example 3: If the parameter value uses replaceable variable, the system does not generate a 
dynamic view for the parameter. The system dynamically assigns a value to the replaced variable 
when executing the action of the operation. For more information about variable replacement 
supported by the common configuration framework, see "Replaceable variable list."  
<Parameter name="devId" value="${DEVICE_ID}"/> 

Example 4: parameter format when sending REST request by using the entity class:  
<Parameter name="devId" value="${DEVICE_ID}" entityProperty="id" 

dataType="java.math.BigInteger"/> 

To access services provided by the third-party system through the REST interface, use one of the 
following methods: 

 Send the parameter value entered by the user as the URI parameter to the third-party system.  

 Send REST request by using the entity class. You must compress the third-party entity class as 

a jar package and place it in the following directory: $IMC_HOME/client/web/repository. 

Parameter view control 

The common configuration framework supports the following views: text box (InputText), check box 

(Checkbox), check box group (SelectManyCheckbox), calendar control (PopupCalendar), list 

(SelectOneMenu), and combo box (CompositeInputText).  

 Text box (InputText) 

The text box, as shown in Figure 131, is used to control text input shown in Table 30.  

Figure 131 Text box view 
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Table 30 Properties of the text box element 

Property 
name  

Description  Required  Remarks  

editable Whether editing 
is allowed  N  Enumerated value: true (allowed) or false (not 

allowed). The default is true.  
 

Example 1: 
<View type="InputText"/> 

Example 2: if no view is defined, the text box InputText is used by default.  
<Parameter name="param6" label="%str.param6"/> 

 Check box 

The check box indicates the enabled or disabled state of a parameter.  

If the check box, as shown in Figure 132, is selected, the parameter value is true—if not, the 
parameter value is false.  

Figure 132 Check box view 

 
 

Example: 
<View type="Checkbox"/> 

 Check box group (SelectManyCheckbox) 

A check box group, as shown in Figure 133, provides you multiple check boxes for selection. 

Figure 133 Check box group view 

 
 

Table 31 Properties of the checkboxes 

Property 
name  

Description  Required  Remarks  

layout Layout  N  Enumerated value: 1 (horizontal) or 2 (vertical). The 
default is 1.  

 

Example: 
    <View type="SelectManyCheckbox" layout="2"> 

   <SelectItem value="1" displayValue="Fragmentation"/> 

 <SelectItem value="2" displayValue="Logging"/> 

 <SelectItem value="3" displayValue="All Source Hosts"/> 

</View> 

 

If you select multiple check boxes, as shown on the page above, the parameter takes the string of 
the values (separated by ",") of the selected items, for example 2, 3. 

 Calendar control (PopupCalendar) 

The calendar control, as shown in Figure 134, has the following functions, listed in Table 32: 

 Allows you to enter date or time in the date input box. 
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 Provides date format prompt information.  

 Allows you to change information in the input box by selecting the date and time on the calendar 
that appears when you click the icon behind the input box.  

 Provides help information when you click the question mark in the upper left corner of the 
calendar.  

 Allows you to flexibly set the view style of the calendar through the style list file.  

 Automatically changes the language setting based on the specified system environment.  

Figure 134 Calendar control view 

 
 

Table 32 Properties supported by the calendar control 

Property 
name  

Description  Required  Remarks  

dateformat Time display format  N  The default format is: YYYY-MM-DD HH:MM  

showtime Whether to display 
time  N  The value can be true or false. The default is true.  

 

Example: 
<View type="PopupCalendar" dateformat="yyyy-MM-dd HH:mm" showtime="true"/> 

The list, as shown in Figure 135, provides options from which you select one.  
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Figure 135 List view 

 
 

Example 1: static initialization 
    <View type="SelectOneMenu"> 

     <SelectItem value="1" displayValue="Alert"/> 

     <SelectItem value="2" displayValue="%str.alarm.info"/> 

     <SelectItem value="3" displayValue="Critical"/> 

     <SelectItem value="4" displayValue="Information"/>  

</View> 

 

Example 2: dynamic initialization 
    <View type="SelectOneMenu"> 

 <Init refAction="getXXXXAction" destValueProperty="XXXXId" 

destDisplayProperty="XXXXName" type="1"/> 

 </View> 

 
 

 NOTE: 

This control supports only initialization. 
 

 Combo box, as shown in Figure 136, (CompositeInputText) 

Figure 136 Enter text information in the combo box. Combo box view 

 
 

Example 1: static initialization 
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<View type="CompositeInputText"> 

 <SelectItem value=" tester1@gmail.com"/> 

 <SelectItem value=" tester2@gmail.com"/> 

 <SelectItem value=" tester3@gmail.com"/> 

</View>  

 

Example 2: dynamic initialization 
<View type="CompositeInputText"> 

<Init refAction="getXXXXAction" destValueProperty="XXXXId" 

destDisplayProperty="XXXXName" type="1"/> 

</View>  

 
 

 NOTE: 

 This control supports only initialization. 

 Do not enter colons (:) in the parameter.  

 If you enter multiple values, as shown on the page above, the parameter takes the string of the 
values (separated by ",") of the entered items, for example, tester1@gmail.com, 
tester2@gmail.com, tester3@gmail.com. 

 The displayValue property and value property of the SelectItem of the control are consistent, 
so only the value property is used.  

 

Control initialization 

The list (SelectOneMenu) and combo box (CompositeInputText) support initialization. Initialization 
includes static initialization, dynamic initialization, and mixed initialization. Static initialization uses 
static values for initialization, and uses the SelectItem element. Dynamic initialization dynamically 
obtains data from the device for initialization, and uses the Init element. Mixed initialization allows for 
both static and dynamic initialization, and takes the result from the union of the static and dynamic 
initialization results. See Table 33. 

 SelectItem 

The service component can use SelectItem to perform static initialization for the list (SelectOneMenu) 

and combo box (CompositeInputText) controls.  

Table 33 Properties supported by SelectItem 

Property 
name  

Description  Required  Remarks  

value Item value  Y  The parameter takes the property value.  

displayValue Item display value  N  This property is used for display. If it is not 
available, the value property is displayed.  

 

Example 1: list static initialization 
    <View type="SelectOneMenu"> 

     <SelectItem value="1" displayValue="Alert"/> 

     <SelectItem value="2" displayValue="%str.alarm.info"/> 

     <SelectItem value="3" displayValue="Critical"/> 

     <SelectItem value="4" displayValue="Information"/>  

</View> 

 

Example 2: combo box static initialization 
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<View type="CompositeInputText"> 

 <SelectItem value=" tester1@gmail.com"/> 

 <SelectItem value=" tester2@gmail.com"/> 

 <SelectItem value=" tester3@gmail.com"/> 

</View>  

 
 

 NOTE: 

If the displayValue property and value property of the SelectItem of the combo box control are 
consistent, the value property is used. 
 

 Init 

The Init element can dynamically get data from the device to perform initialization for the list 
(SelectOneMenu) and combo box (CompositeInputText) controls. The following is the working 
process: 

 Enter parameters required by the refAction. 

The control initialization action is executed after the dynamic page is generated. You do not 
need to enter parameters for such actions. Control initialization action parameters can only be 
dynamic information, such as the selected port or device.  

The common configuration framework provides a group of replaceable variables related to the 
IMC system, device, and interface for the components. When you enter the parameters 
required by the refAction, if replaceable variables (with the format ${ DEVICE_ID } that starts 
with ${ and ends with -}) are found in the registration file, the system automatically replaces it 
with the parameter related to IMC system, device, or interface. For example, the system 
replaces ${DEVICE_ID} with the device ID. For more information about replaceable variables 
supported by the common configuration framework, see the following information.  

 The system executes the refAction action.  

 Parse the execution result of the action.  

When parsing the execution result of the action, the common configuration framework takes the 
destValueProperty value as the value property value of SelectItem, the destDisplayProperty 
value as the display property value of SelectItem.  

If you have selected multiple devices or ports, the system executes the refAction action on all 
selected devices or ports to generate multiple result values. The policy to process these result 
values is defined by the type property. Type 1 means to take the intersection of multiple result 
values. Type 2 means to take the union of multiple result values. See Table 34. 

 Initialize the control based on the result. 

Table 34 Properties support by Init 

Property name  Description  Required  Remarks  

refAction Action for initialization  Y  The action must have been defined in 
the operation.  

destValueProperty Name of the SelectItem 
Value property  Y  

For RestAction, the system gets an 
XML file. This property specifies the 
XML property of "value." If the XML file 
consists of multiple elements, and 
each element has the property defined 
by destValueProperty, the property of 
the first element is taken. For 
Asn1Action, the system receives an 
ASN1 response message. This 
property specifies the property name 
of the SelectItem "value."  
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Property name  Description  Required  Remarks  

destDisplayProperty Name of the SelectItem 
displayValue property  Y  

For RestAction, the system gets an 
XML file. This property specifies the 
XML property of "displayValue." If the 
XML file consists of multiple elements, 
and each element has the property 
defined by destDisplayProperty, the 
property of the first element is taken. 

For Asn1Action, the system receives 
an ASN1 response message. This 
property specifies the property name 
of "displayValue."  

Type Processing method  N  
Enumerated value: 1 (takes 
intersection of result sets) or 2 (takes 
union of result sets). The default is 1.  

 

Example 1: list dynamic initialization 
    <View type="SelectOneMenu"> 

        <Init refAction="getVlanAction" destValueProperty="XXXXId" 

destDisplayProperty="XXXXName" type="1"/> 

    </View>  

 

Example 2: combo box dynamic initialization 
    <View type=" CompositeInputText"> 

        <Init refAction="getVlanAction" destValueProperty="XXXXId" 

destDisplayProperty="XXXXName" type="1"/> 

</View>  

 

If the initialization action is of the REST type, destValueProperty and destDisplayProperty require 
the XPath expression, as shown in example 3.  

The displayValue property and value property of the combo box control are consistent, so the system 

uses the destValueProperty value for initialization.  

Example 3: To use the device VLAN information to initialize the list by using the vlanName value as 

the displayValue value and the vlanId value as the value of the component, compile the following 
information: 
<View type="SelectOneMenu"> 

        <Init refAction="getVlanAction" destValueProperty="//vlan/@vlanId" 

destDisplayProperty="//vlan/@vlanName" type="1"/> 

    </View>  

 

Following is the response message body for querying device VLANs. 
<list> 

        <vlan vlanStatus="1" vlanName="VLAN 0001" vlanId="1" />   

 <vlan vlanStatus="1" vlanName="VLAN 0002" vlanId="2" />   

  <vlan vlanStatus="1" vlanName="VLAN 0003" vlanId="3" />   

  <vlan vlanStatus="1" vlanName="VLAN 0004" vlanId="4" />   

  <vlan vlanStatus="1" vlanName="VLAN 0005" vlanId="5" />   

</list> 

 

 Mixed initialization 
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Mixed initialization allows for both static and dynamic initialization, and takes the result from the 
union of the static and dynamic initialization results. 

Example 1: list mixed initialization 
<View type="SelectOneMenu"> 

     <SelectItem value=" " displayValue=" "/> 

        <Init refAction="getVlanAction" destValueProperty="XXXXId" 

destDisplayProperty="XXXXName" type="1"/> 

    </View>  

 

Example 2: combo box mixed initialization 
    <View type=" CompositeInputText"> 

     <SelectItem value=" " displayValue=" "/> 

        <Init refAction="getVlanAction" destValueProperty="XXXXId" 

destDisplayProperty="XXXXName" type="1"/> 

    </View>  

 

Compiling device capability set definition file 

The device capability set definition file is an XML file, whose name must be component 

name_devCapabilities.xml. This file defines the device capability set supported by the operations of 
the component. The following is an example: 
<?xml version="1.0" encoding="UTF-8"?> 

<DevCapabilities> 

  <Capability name="gencfgDC"> 

    <SysOID>1.3.6.1.4.1.25506</SysOID> 

    <SysOID>1.3.6.1.4.1.2011</SysOID> 

  </Capability> 

</DevCapabilities> 

 

The properties supported by the elements in the file are described as follows: 

 DevCapabilities element 

The DevCapabilities element is the root node the operation definition file, and does not support 
any property.  

 Capability element, as shown in Table 35. 

Table 35 Properties supported by the Capability element 

Property 
name  

Description  Required  Remarks  

name Name  Y  ALL is reserved, meaning all devices. The name must be 
unique in a file.  

 

SysOID element 

The content of the sysOID element is the device sysOID. sysOID can be a complete sysOID meaning 

a specific device model, or part of a sysOID meaning a device series.  

Example: specify the capability set to support all 3Com devices and a specific Cisco device.  
<Capability name="baseDC"> 

  <!--s̹upport all 3Com devices-->  

  <SysOID>1.3.6.1.4.1.43</SysOID> 

  <!--support a specific Cisco device-->  
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  <SysOID>1.3.6.1.4.1.9.1.501</SysOID>  

</Capability> 

 

Replaceable variable list 

Replaceable variables are used to replace the specified property values in the registration file. For 
example, to replace the value property value of the Parameter element or uri property value of the 

RestAction element. The replaceable variable is in the format of ${VARIABLE _NAME}, and must start 

with ${ and end with }.  

The replaceable variables include three categories: user-defined replaceable variables, system-level 
replaceable variables, and parameter-level replaceable variables. In certain cases, you must enter 
some properties or names multiple times. To address this issue, the system allows for user-defined 
replaceable variables in registration files, pre-defines some commonly used replaceable variables 

for you as shown in the table below and lets you reference a parameter in the {parameter name} 
format that is called a parameter-level replaceable variable. For the property of an action, only the 
parameters of the action are allowed to be used.  

The system replaces the user-defined replaceable variables when loading the registration file, 
replaces system-level replaceable variables when executing actions, and then replaces the 
parameter-level replaceable variables. In the following example, ${vlanId} is a parameter-level 
replaceable variable.  
<RestAction id="addPort2VlanAction" protocol="http" ip="${IMC_SERVER_IP}" 

      port="${IMC_HTTP_PORT}" uri="/imcrs/vlan/${vlanId}" userName="${IMC_USER_NAME}" 

      userPassword="${IMC_USER_PWD}" method="2"> 

      <Parameter name="devId" value="${DEVICE_ID}" /> 

      <Parameter name="vlanId" label="%str.vlanId" required="true" 

validateRegEx="[2-9]|[1-3]?[0-9]{2,3}|[4][0][0-8][0-9]|[4][0][9][0-4]" 

        info="%str.vlan.id.info" /> 

      <Parameter name="ifIndex" value="${IF_INDEX}" /> 

</RestAction> 

 

When dynamically generating a page, the system does not generate the view for parameters using 
replaceable variables in the value property. The system dynamically assigns a value to the 
parameter based on the replaceable variable when executing actions for the operation and you do 
not need to enter a value. Replaceable variables can also be used in the control initialization 
process.  

The control initialization action is executed after the dynamic page is generated. Such actions do not 
require manual input of parameters. The control initialization action parameters can only be the 
dynamic information, such as the selected port or device. At this time, the service component 
requires using replaceable variables. When the system performs control initialization, it replaces the 
replaceable variables with the corresponding device or port information, as shown in Table 36.  

Table 36 System-level replaceable variable supported by the common configuration 
framework 

Category  Parameter name  
Parameter 
description  

Remarks  

System-level 
variables  

IMC_SERVER_IP IMC primary 
server IP address  N/A  

IMC_HTTP_PORT IMC HTTP port 
number  N/A  

IMC_HTTPS_PORT IMC HTTPS port 
number  N/A  
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Category  Parameter name  
Parameter 
description  

Remarks  

IMC_USER_NAME Current IMC user 
name  N/A  

IMC_USER_PWD Current IMC user 
password  N/A  

Device-level 
variables  

DEVICE_ID Device ID  

Same as the returned value of 
getDeviceID () for SymbolInfo. 

You can get other device properties by 
using this property.  

SYMBOL_ID Symbol ID  
Same as the returned value of 
getSymbolID () for SymbolInfo. 

DEVICE_IP Device IP 
address  

Same as the returned value of 
getIpAddress () for SymbolInfo. 

DEVICE_SYSOID Device sysOID  
Same as the returned value of 
getSysOID () for SymbolInfo. 

Interface-level 
variables  

IF_INDEX Interface index  

Same as the returned value of 
getId().getIfIndex () for 
IfInfo. 

You can get other interface properties 
by using this property. 

IF_DESC Interface 
description  

Same as the returned value of 
getDesc () for IfInfo. 

IF_TYPE Interface type  
Same as the returned value of 
getType () for IfInfo. 

IF_IP Interface IP 
address  

Same as the returned value of 
getIfIp () for IfInfo. 
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Configuration and change management 
The Configuration Center service module provides change management features for managing the 
configuration of and changes to network resources. 

The Configuration Center option of the Configuration Center service module serves as a portal 
for managing the configuration of one or more devices. Through this portal, you can view, backup, 
baseline, compare, check, and deploy startup and running configuration files. In addition, you can 
view and restore configuration file histories to selected devices.  

From the Configuration Center option, you can also view, export, deploy, and restore system 
software and view software update histories for the selected devices. And, you can manage device 
space usage by removing unwanted files to make space for new software deployments. 

Configuration templates 
By using the Configuration Templates feature, you can create templates based on entire startup or 
running configuration files. Or, you can modularize the management of configurations by creating 
templates based on portions of configuration files called segments. You can import the contents of a 
template from the backup of a configuration file, thus simplifying the process of template creation. 

You can also create configuration templates from scratch or they can import the contents of 
configuration templates In addition, you can organize templates into nested folders for easy access 
to templates. Once created, deploy them to selected devices by using the Deployment Guide. 

Software library 
With the Configuration Center's Software Library, you have several methods for building a 
software library. You can backup system or other software to IMC. Or, you can import the software 
from a file stored on your local computer. Once a file is imported, IMC determines to which devices 
the associated software can be deployed. In addition, you have the ability to designate software 
library entries as baselines. Lastly, you can export software from IMC. Once software has been 
imported into IMC, it then becomes available for deployment by using the Deployment Guide. 

With the Deployment Guide, you have a step-by-step wizard for deploying configuration templates 
and software from the Software Library. In addition, the Deployment Guide provides you with a 
facility for restoring device configurations and software. When deploying configuration files, IMC 
evaluates the configuration template against every device selected for deployment to ensure that the 
template can be deployed. IMC identifies when devices do not match the configuration template. 

With software deployments, IMC performs two checks. The first check evaluates whether or not the 
system software matches the devices current system software and identifies whether or not the 
software should be deployed to the device. IMC also performs a second check to verify that there is 
enough device space to deploy the selected software by using the deployment strategy that you 
have configured. You can run deployments immediately or schedule them for a later date. For 
configuration deployments, you can configure recurring or periodic deployments. 

While the Deployment Guide serves as an input queue for submitting deployment tasks to IMC, the 
Deployment Task feature of the Configuration Center serves the output queue. From the 
Deployment Task link, you can view, run, suspend, resume, or delete deployment tasks that have 
been submitted to IMC.  

In addition, you can view the execution results for every job and view the step-by-step details of the 
configuration or software deployment. Additionally, you can view the changes that were made during 
the deployment. 
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Configuration compare 
With the Configuration Compare option, you can select and view configuration files side-by-side. 
You can select a current startup or running configuration file and compare it against another file from 
the same device or another device. In addition, you can compare device startup or running 
configuration files that have been backed up to IMC. IMC presents both files side-by-side with the 
option to view the entirety of the files or the differences only. You can also step through the files and 
highlight every difference by using Next Diff. 

Configuration audit and reports 
With the Configuration Audit option, you can audit the configuration and software versions for 
network resources. 

From the Configuration Backup Report, you can view, export, and restore the backup files for both 
startup and running configuration files for all devices managed in IMC. 

With the Configuration Baseline Report feature, you can view the results of IMC evaluation of the 
last backup configuration file against the configured baseline file to determine if any changes have 
been made. In addition, you can launch the configuration compare option from the Configuration 
Baseline Report to compare the last backup configuration file against the configured baseline file. 

Software update 
With the Software Update feature, you can view a history of all software updates performed in IMC 
with the ability to launch a software restoration from the Software Update Report. With the 
Software Baseline Report, you can view both current and baseline software file information. In 
addition, IMC performs a baseline comparison to verify whether or not the baseline software running 
on a device is identical to the current version. 

Auto backup plan 
By using the Auto Backup Plan, you can schedule automated backups of configuration files for one 
or more devices. By using IMC Backup History Report you have visibility into the backup results for 
all backup tasks, including backups initiated manually and backups initiated through an auto backup 
plan. 

Compliance check 
The Compliance Check feature lets you check the configurations of devices. First, create a 
compliance policy and add rules in the policy. Then, create a check task, associate the compliance 
policy and devices to be checked with the check task, and schedule the check task to complete 
compliance check.  

You can also specify display commands to be issued on the selected devices. IMC checks the 
compliancy of the display command output by using the policy rules. 

Using the Configuration Center 
The Configuration Center link within the Configuration Center service module provides you with a 
portal for managing the configurations of one or more devices. Through the Configuration Center 
portal, you can view the latest running and startup configuration files for managed devices in IMC. 
From this list, you can initiate a manual backup of the startup and running configurations of the 
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selected devices, define a configuration baseline, set schedules for backups of configuration files 
and deploy configuration files to the selected devices. 

You can also view histories of startup and running configuration backup files for the selected device 
and modify, restore, compare, establish a baseline or save configuration files. 

With the configuration baseline facility, you can define a startup and running configuration version as 
a baseline and with auditing features, identify when a device does not conform to its configuration 
baseline. 

From the same portal, you can manage the software for managed devices. This includes viewing the 
software update history for the selected device. In addition, you can deploy software from IMC 
software library to selected devices from the Configuration Center portal. With the software 
baseline facility, you can define a software version as a baseline and with auditing features, identify 
when a device does not conform to its software baseline. 

The Configuration Center portal also provides a convenient facility for comparing the contents of 
configuration files. You can compare backup startup or running configuration files with the current 
startup or running configuration files. IMC also provides a line-by-line comparison of the two files with 
changes highlighted. In addition, IMC provides a summary of identical, changes, and unique lines. 

From IMC, you can remove system software, configuration files and other file types from devices by 
using the Clean Device Space option. IMC displays the contents of a device's memory and with a 
few clicks can remove any unwanted files. 

Accessing the Configuration Center 
To access the Configuration Center: 

1. Navigate to Service > Configuration Center. 

2. Click the Service tab from the top tabular navigation system. 

3. Do one of the following: 

 Click Configuration Center in the Resource and Configuration Management section of 
the Service page. 

 Click Configuration Center located on the left navigation tree. 

All devices that can be managed by the Configuration Center are displayed in the list in the 
bottom half of the Configuration Center page. 

Configuration center device list 

 Device Name—Contains the IMC name for the device, which, by default, is the name 
assigned to it by IMC in its device configuration. If a device is configured with a sysName, 
the sysName is used as the Device Label unless the Device Label is manually configured. 
This field also contains the IP address. The contents of the device label field serve as an 
active link for drilling down into the Device Details page. 

 Device Model—Contains the device model information for the associated device. This 
information is the same as the Device Model information found on the Device Details 
page. IMC can automatically identify H3C, 3Com, HPE, Huawei, and Cisco devices. Device 
model information for all other devices can be configured by using the Device Model 
feature found under the System tab. 

 Current Version—Contains the operating system version that is currently running on the 
associated device. 

 Latest Available Version—Contains the most current version stored in IMC's software 
library. A "–" in this field indicates that a newer version of the software exists, but has not 
been added to the software library. 

 Last Backup Time—Contains a date and time stamp for the most recent backup of the 
associated device's running and startup configuration files. 

 Operation—Contains an icon that displays links to operational tasks for the associated file, 
segment, or folder. 
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From the Operation  popup menu, you can view the latest startup and running 
configuration, navigate to the configuration management page for the associated device, clean 
device space on the associated device, set a software baseline, or compare the device 
configuration with another device. 

You can sort the Configuration Center device list by every field except the Operation field. 
Click the column label to sort the list by the selected field. The column label is a toggle switch 
that lets you toggle between the various sort options specific to each field. 

If the Configuration Center device list spans multiple pages, use the following aids to navigate 
the list: 

 Click  to page forward in the Configuration Center device list. 

 Click  to page forward to the end of the Configuration Center device list. 

 Click  to page backward in the Configuration Center device list. 

 Click  to page backward to the front of the Configuration Center device list. 

4. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

Querying for devices in the Configuration Center 
You can search for a particular device and its associated configuration information from the 
Configuration Center. You can search either by a partial or complete device name. IMC then 
displays only those devices that match the search criteria. Alternatively, you can filter the list by 
Custom View. 

To filter the Configuration Center device list: 

1. Navigate to Service > Configuration Center. 

2. Click the Service tab from the top tabular navigation system.  

3. Do one of the following: 

 Click Configuration Center in the Resource and Configuration Management section of 
the Service page. 

 Click Configuration Center located on the left navigation tree. 

4. Enter a device name in the field in the upper right corner of the Configuration Center page, 

and click the Search icon , or click the Advanced icon  located in the upper right corner 
of the page. 

The search criteria dialog box opens. 

5. Enter one or more of the following search criteria in the Query Condition section of the page: 

 Device Name—Enter a partial or complete device label or name in the Device Name field. 

 Custom View—Select the custom view by which you want to search or filter the list. You 
can also select the blank option, which searches all custom views. 

 Device Model—Enter a partial or complete device model in the Device Model field. 

 Current Version—Enter a partial or complete device current version in the Current 
Version field. 

6. Click Query to submit your filter criteria. 

The results of your filter or search query display in the Configuration Center device list below. 

7. Click Reset when you want to restore the full Configuration Center device list. 
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Device configuration options in the Configuration Center 
The Operation link  associated with an individual device in the Configuration Center device list 
provides you with access to a variety of configuration management tasks. 

Viewing the latest startup configuration 

To view the latest startup configuration for a device in the Configuration Center device list: 

1. Navigate to Service > Configuration Center > Current Startup Configuration File. 

2. Click the Service tab from the top tabular navigation system.  

3. Do one of the following: 

 Click Configuration Center in the Resource and Configuration Management section of 
the Service page. 

 Click Configuration Center located on the left navigation tree. 

All devices that can be managed by IMC Configuration Center are displayed in the list in the 
bottom half of the Configuration Center page. 

4. Click the Operation icon  in the Operation field of the device in which you want to view the 
startup configuration. 

5. Select Latest Startup Configuration from the popup menu. 

The most recent startup configuration file is displayed in the Configuration File Details page. 

Stackable devices 

For stackable devices, you must select the directory or location of the configuration file as follows: 

1. Click the arrow keys next to the Source Device list, and select the unit you want to view. 

2. To compare the startup file with the most recent backup version of the startup configuration file, 
click the Compare with Startup Configuration file of Latest Backup link located to the far 
right of the Configuration File Details page. 

The Compare Configuration File dialog box opens. 

The two startup configuration files are displayed in side-by-side windows with file details at the 
top of the dialog box. 

IMC provides a summary of all identical, changed, and unique lines at the bottom of the dialog 
box. 

3. Do one of the following: 

 To view the entire contents of both configuration files, select Show All. 

 To view only the differences between the two files, select Show Difference Only. 

4. Do one of the following: 

 Click Next Diff to view, line-by-line, the configuration differences between the two files. 

 Click Previous Diff to view the previous line that contains differences. 

5. Click Close when you have finished viewing the configuration file comparison. 

Viewing the latest running configuration 

To view the latest running configuration for a device in the Configuration Center device list: 

1. Navigate to Service > Configuration Center > Current Running Configuration File. 

2. Click the Service tab from the top tabular navigation system. 

3. Do one of the following: 

 Click Configuration Center in the Resource and Configuration Management section of 
the Service page. 

 Click Configuration Center located on the left navigation tree. 
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All devices that can be managed by IMC's Configuration Center are displayed in the list in the 
bottom half of the Configuration Center page.  

4. Click the Operation icon  in the Operation field of the device for which you want to view the 
running configuration for. 

5. Select Latest Running Configuration from the popup menu. 

The most recent running configuration file is displayed in the Configuration File Details page. 

Stackable devices 

For stackable devices, you must select the directory or location of the configuration file as follows: 

1. Click the arrow keys next to the Source Device list, and select the unit you want to view. 

2. To compare the running configuration file with the most recent backup version of the running 
configuration file, click the Compare with Running Configuration file of Latest Backup link 
located to the far right of the Configuration File Details page. 

The Compare Configuration File dialog box opens. 

The two running configuration files are displayed in side-by-side windows with file details at the 
top of the dialog box. 

IMC provides a summary of all identical, changed, and unique lines at the bottom of the dialog 
box. 

3. Do one of the following: 

 To view the entire contents of both configuration files, select Show All. 

 To view only the differences between the two files, select Show Difference Only. 

4. Do one of the following: 

 Click Next Diff to view, line-by-line, the configuration differences between the two files. 

 Click Previous Diff to view the previous line that contains differences. 

5. Click Close when you have finished viewing the configuration file comparison. 

Configuration management page details 

The Configuration Management option that can be found on the Operation popup menu provides 
you with many features for managing change and configuration for the selected device. At the top of 
this page, you can view configuration management summary details for the selected device. By 
using the features found in this section, you can initiate a manual backup of the startup and running 
configurations of the selected device, configure a software baseline, set scheduled backups and 
deploy operating system software to the selected device. 

From the Configuration Backup History tab on the Configuration Management page, you can 
view a history of startup and running configuration backup files for the selected device. In addition, 
you can modify, restore, compare, establish a baseline and save configuration files. 

Lastly, you can view the software update history for the selected device and deploy software from the 
Software Update History tab. 

Viewing configuration management summary 

To view a summary of configuration management information for the selected device: 

1. Navigate to Service > <Device Name> > Configuration Management. 

2. Click the Service tab from the top tabular navigation system. 

3. Do one of the following: 

 Click Configuration Center in the Resource and Configuration Management section of 
the Service page. 

 Click Configuration Center located on the left navigation tree. 

All devices that can be managed by the Configuration Center are displayed in the list in the 
bottom half of the Configuration Center page. 
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4. Click the Operation icon  in the Operation field of the device for which you want to view 
configuration information. 

5. Select Configuration Management from the popup menu. 

The Configuration Management page is displayed and includes the following information: 

 Device Name—Contains a link to the Device Details page for the associated device. 

 Device Model—Contains device series and model information. 

 Last Backup at—Contains a date and time stamp for the last backup of the configuration 
file. The [Backup] link next to this field initiates a manual backup of both the startup and 
running configuration files. 

 Auto Backup Period—Contains information on the backup schedule for device 
configuration files. The [Set Attribute] link next to this field navigates you to the Add Auto 
Backup Plan page for scheduling regular configuration file backups. For more information 
about configuring an automatic backup plan, see "Managing automatic backup plans." 

 Current Software Version—Contains the current version of the operating system. The 
operating system name also serves as a link to the software library entry for the operating 
system, if it exists in the software library. 

 Latest Available Version—Contains the latest version of the system software in the library 
for the associated device. The field is blank if there is no system software version that is 
newer than what is on the device and in the library. The [Deploy] link next to this field 
navigates you to the Deployment Guide configuration page for deploying software to select 
devices. For more information of deploying software, see "Deploying configurations and 
software by using IMC deployment guide." 

 Baseline Software Version—Contains the baseline version of the operating system. To 
configure baseline software not to act as baseline software, click Remove next to the 
baseline software. A hyphen (-) in this field indicates that there is no configured baseline 
software version for the associated device. The [Configure] link next to this field enables 
you to select operating system versions from the software list to establish a baseline on the 
selected device. For more information about establishing a software version baseline, see 
"Establishing a software baseline." 

Viewing configuration backup history 

From the Configuration Backup History tab on the Configuration Management page, you can 
view a history of startup and running configuration backup files for the selected device. In addition, 
you can modify, restore, compare, establish a baseline or save configuration files. 

To navigate to the Configuration Backup History list: 

1. Click the Service tab from the top tabular navigation system.  

2. Do one of the following: 

 Click Configuration Center in the Resource and Configuration Management section of 
the Service page. 

 Click Configuration Center located on the left navigation tree. 

All devices that can be managed by the Configuration Center are displayed in the list in the 
bottom half of the Configuration Center page. 

3. Click the Operation icon  in the Operation field of the device you in which you want to view 
the backup history. 

4. Select Configuration Management from the popup menu. 

The Configuration Management page for the selected device opens. 

5. Click the Configuration Backup History tab. 

The Configuration Backup History list is displayed. 

Configuration backup history list 

 Version—Identifies the type of backup that was performed, a standard or common backup 
or a baseline backup. 
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 File Name—Contains the name of the backup file. 

 Type—identifies what kind of configuration file was backed up, a startup or a running 
configuration file. 

 Backup Time—Contains the date and time stamp for the associated backup of the 
configuration file. 

 Modify—Contains a Modify link  for modifying the associated configuration file. 

 Restore—Contains a Restore link  for restoring the associated configuration file. 

 Compare—Contains a Compare link  for comparing the associated configuration file. 
IMC provides five options for comparing, including: 

 Compare with Baseline Configuration—Compares the selected backup history 
configuration file with the established baseline configuration file. 

 Compare with Current Startup Configuration—Compares the selected backup 
history configuration file with the device's current startup configuration file. 

 Compare with Current Running Configuration—Compares the selected backup 
history configuration file with the device's running startup configuration file. 

 Compare with Current Startup and Running Configurations—Compares the 
selected backup history configuration file with the device's startup and running startup 
configuration file. 

 Compare with Other Configuration—Compares the selected backup history 
configuration file with another startup, running, or backup history file for the same or 
another device. 

 Make Baseline—Contains a Make Baseline link  for establishing a baseline by using 
the associated file. The field is empty if the Version column displays Baseline. 

 Save As—Contains a Save As link  for saving the associated file. 

If the Configuration Backup History list spans multiple pages, use the following aids to 
navigate the list. 

 Click  to page forward in the Configuration Backup History list.  

 Click  to page forward to the end of the Configuration Backup History list. 

 Click  to page backward in the Configuration Backup History list. 

 Click  to page backward to the front of the Configuration Backup History list. 

6. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items 
per page you want to view. 

7. For Configuration Backup History list that have more than one page, click 1, 2, 3, 4, 5, 6, 7, 8, 
9, 10 … from the bottom right side of the main pane to jump to a particular page of the trap list. 

You can sort the Configuration Backup History list by the Version, File Name, Type, and 
Backup Time fields. Click the column label to sort the list by the selected field. The column 
label is a toggle switch that lets you toggle between the various sort options specific to each 
field. 

8. To filter the Configuration Backup History list, select the option you want to filter by from the 
Configuration File Version list located on the far right of the Configuration Backup History 
section. 

Modifying a backup configuration file 

IMC offers you the ability to make changes to configuration files. These changes include adding or 
modifying a description and changing the source devices. 

To modify a backup configuration file: 

1. Navigate to Service > <Device Name> > Configuration Management. 
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a. Click the Service tab from the top tabular navigation system. 

b. Do one of the following: 

 Click Configuration Center in the Resource and Configuration Management section 
of the Service page. 

 Click Configuration Center located on the left navigation tree. 

All devices that can be managed by the Configuration Center are displayed in the list in the 
bottom half of the Configuration Center page.  

2. Click the Operation icon  in the Operation field of the device for which you want to view the 
backup history. 

3. Select Configuration Management from the popup menu. 

The Configuration Management page for the selected device opens. 

4. Click the Configuration Backup History tab. 

The Configuration Backup History list is displayed. 

5. Click the Modify icon  in the Modify field of the backup configuration file you want to modify. 

6. If prompted, select the device unit from the Source Device list. 

7. Enter a description for this configuration backup file in the Description field. 

8. To save the source device and description changes you made, click Modify Description. 

9. To save your changes to a new file, click Save As. 

The Save File As dialog box opens. 

10. Enter the name for the configuration file in the File Name field. The characters listed in Table 37 
are invalid and cannot be used. 

Table 37 Invalid characters 

Character Name Character Name 

0-9 Numbers ' Apostrophe or single quotation 

_ Underscore * Asterisk 

| Vertical bars : Colon 

\ Backslash " Double quotation 

/ Forward slash < > Angle brackets 

? Question mark   
 

11. Click OK. 

Restoring a configuration file 

The Restore  option on the Configuration Management page provides you with a link to the 
Deployment Guide for restoring a configuration file. For information about restoring software in 
IMC, see "Deploying configurations and software by using IMC deployment guide" and "Restoring a 
device configuration." 

Comparing configuration files 

The Configuration Management page under the Operation link for a selected device contains a 
link for comparing the contents of configuration files. You can compare backup, startup, or running 
configuration files with the current startup or running configuration files. IMC also provides a 
line-by-line comparison of the two files with changes highlighted. In addition, IMC provides a 
summary of identical, changed, and unique lines. 

To compare the contents of a backup configuration file with another file: 

1. Navigate to Service > <Device Name> > Configuration Management. 
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a. Click the Service tab from the top tabular navigation system. 

b. Do one of the following: 

 Click Configuration Center in the Resource and Configuration Management section 
of the Service page. 

 Click Configuration Center located on the left navigation tree. 

All devices that can be managed by the Configuration Center are displayed in the list in the 
bottom half of the Configuration Center page. 

2. Click the Operation icon  in the Operation field of the device to view the startup 
configuration. 

3. Select Configuration Management from the popup menu. 

The Configuration Management page for the selected device opens. 

4. Click the Configuration Backup History tab. 

The Configuration Backup History list is displayed. 

5. Click the Compare icon  in the Compare field of the backup configuration file you want to 
compare. 

The Select Target File dialog box listing file comparison options opens. 

6. Select the file you want to compare:  

 Select Compare with Baseline Configuration if you want to compare the selected file with 
the configuration file that has been designated as the Baseline Configuration for this device. 

 Select Compare with Current Startup Configuration if you want to compare the selected 
file with the current startup configuration of the selected device. 

 Select Compare with Current Running Configuration if you want to compare the 
selected file with the current running configuration of the selected device. 

 Select Compare with Current Startup and Running Configurations if you want to 
compare the selected backup history configuration file with the device's startup and running 
startup configuration file. 

 Select Compare with Other Configuration if you want to compare the selected file with 
another configuration file from the same or another device. 

7. Click OK. 

8. If you have selected one of the first four options in step 6, go to step 10. If you have selected the 
last option in step 6, go to step 9. 

9. Configure the two files you want to compare on the Compare with Other Configuration page. 

To configure the options for the first or left file: 

a. If you are comparing configuration files for a stackable unit, the Stack Unit list is displayed. 

Select the unit you want to use as a source for a configuration file from the Stack Unit list. 

b. Select the type of configuration file you want to use for comparison from the File Type list.  

c. If you select Backup History as your file type, select the particular configuration file you 
want to compare from the Configuration File list. 

To configure the options for the second or right configuration file: 

a. Enter the device name or click Select Device to add a device by View or by the Advanced 
query method. 

For more information, see "Adding devices by view" and "Adding devices by advanced 
query." 

b. Confirm that the device now is displayed in the Right Device field of the General 
Configuration Compare page. 

c. Select the type of configuration file you want to use for comparison from the File Type list. 

d. Click OK. 
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The Compare Configuration File dialog box is displayed with configuration files in 
side-by-side windows and file details at the top of the dialog box. 

At the bottom of the page is a summary of all identical, changed, and unique lines. 

e. Select Show All to view the entire contents of both configuration files. Or, select Show 
Difference Only to view only the differences between the two files. 

10. Click Next Diff to view, line-by-line, the configuration differences between the two files. 

11. Click Previous Diff to view the previous line that contains differences. 

12. Click Close when you have finished viewing the configuration file differences. 

Establishing a configuration file baseline 

You can define a baseline from the Configuration Management page under the Operation link for 
a selected device. Establishing a baseline in IMC marks the selected file as the standard or basic 
configuration file for the selected device. Every device can have one configuration file defined as its 
baseline and it serves as a foundation upon which the device's configuration is evaluated and 
audited. 

In addition, once a baseline has been established, you can revert to the established baseline 
configuration file if any problems arise with the device's configuration. 

To establish a configuration file as a baseline configuration for the selected device: 

1. Navigate to Service > <Device Name> > Configuration Management. 

a. Click the Service tab from the top tabular navigation system. 

b. Do one of the following: 

 Click Configuration Center under the Resource and Configuration Management 
section of the Service page. 

 Click Configuration Center on the left navigation tree. 

All devices that can be managed by the Configuration Center are displayed in the list in 
the bottom half of the Configuration Center page. 

2. Click the Operation icon  in the Operation field of the device for which you want to view the 
startup configuration. 

3. Select Configuration Management from the popup menu. 

The Configuration Management page for the selected device opens. 

4. Click the Configuration Backup History tab. 

The Configuration Backup History List is displayed. 

5. Click the Make Baseline icon  in the Make Baseline field of the backup configuration file 
you want to set as the baseline configuration. The Make Baseline field is empty if the for the 
configuration file is already the baseline configuration. 

The Configuration Management page is updated to display the results of the baseline 
operation. 

6. Review the results to ensure successful completion. 

Creating a configuration template by using Save As for configuration files 

You can save a configuration file as a configuration template from the Configuration Management 
page. The Save As icon in the Configuration Backup History list serves as a link that navigates 
you to the Configuration Templates page for creating a configuration template. For more 
information about creating configuration templates in IMC, see "Creating a configuration template." 

Viewing software update history 

The Software Update History tab of the Configuration Management page provides you with 
visibility into the history for system and other software updates for the selected device. 

To view the software update history for the selected device: 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 8921



520 

1. Navigate to Service > <Device Name> > Configuration Management. 

a. Click the Service tab from the top tabular navigation system. 

b. Do one of the following: 

 Click Configuration Center in the Resource and Configuration Management section 
of the Service page. 

 Click Configuration Center located on the left navigation tree. 

All devices that can be managed by IMC Configuration Center is displayed in the list in the 
bottom half of the Configuration Center page.  

2. Click the Operation icon  in the Operation field of the device for which you want to view the 
startup configuration. 

3. Select Configuration Management from the popup menu. 

The Configuration Management page for the selected device opens. 

4. Click the Software Update History tab. 

The Software Update History list is displayed. 

Software update history list 

 Update Result—Contains the result of the software update task. 

 Start Time—Contains a date and time stamp for the start time of the associated software 
update task. 

 Finished Time—Contains a date and time stamp for the completion time of the associated 
software update task. 

 Update Type—Identifies what type of software update task was performed. Possible values 
include Update and Rollback. 

 Old Version—Contains the software file name of the old version of software, and whether 
the task was an update or a rollback. 

 New Version—Contains the software file name of the new version of software. 

 Update Path—Identifies to which directory on the selected device the software was written. 

 Restore—Contains a Restore link to the Deployment Guide for restoring the system 
software file. For information about restoring software in IMC, see "Deploying configurations 
and software by using IMC deployment guide" and "Restoring device software." 

If the Software Update History list spans multiple pages, use the following aids to navigate the 
list. 

 Click  to page forward in the Software Update History list. 

 Click  to page forward to the end of the Software Update History list. 

 Click  to page backward in the Software Update History list. 

 Click  to page backward to the front of the Software Update History list. 

5. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

6. For Software Update History list that have more than one page, click 1, 2, 3, 4, 5, 6, 7, 8, 9, 10 
… from the bottom right side of the main pane to jump to a particular page of the trap list. 

You can sort the Software Update History list by the Update Result, Start Time, Finished 
Time, Update Type, Old Version, New Version and Update Path fields. Click the column 
label to sort the list by the selected field. The column label is a toggle switch that lets you toggle 
between the various sort options specific to each field. 
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Cleaning device space 

From the configuration management page, you can also remove system software, configuration files 
and other file types from the selected device by using the Clean Device Space option. IMC displays 
the contents of a device's memory and with a few clicks you can remove unneeded files. 

To remove files from the memory of a network device: 

1. Navigate to Service > <Device Name> > Configuration Management. 

a. Click the Service tab from the top tabular navigation system. 

b. Do one of the following: 

 Click Configuration Center under the Resource and Configuration Management 
section of the Service page. 

 Click Configuration Center on the left navigation tree. 

All devices that can be managed by the Configuration Center are displayed in the list in 
the bottom half of the Configuration Center page. 

2. Click the Operation icon  in the Operation field of the device for which you want to view the 
startup configuration. 

3. Select Clean Device Space from the popup menu. 

The Device File List dialog box for the selected device opens. This dialog box contains the 
Device File List for the selected device. 

Total space and available space on the device is displayed at the top of the Device File List 
table. 

Device file list 

 File Name—Contains the name of the file. 

 File Location—Contains the location of the file on the device. 

 File Size (Byte)—Contains the size of the file in bytes. 

 File Type—identifies the type of file–system or operating system software, configuration 
file, or other. 

 File State—identifies whether or not the associated file is valid (usable) or invalid. 

 Image File Type—If an image exists, the type of image is displayed in this field. 

 Running Image File—identifies whether or not the associated file is also the current or 
running image for the device. 

 Startup Configuration—identifies whether or not the associated file is the startup 
configuration file for the device. 

If the Device File List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Device File List. 

 Click  to page forward to the end of the Device File List. 

 Click  to page backward in the Device File List. 

 Click  to page backward to the front of the Device File List. 

4. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items 
per page you want to view. 

5. For Device File List that have more than one page, click 1, 2, 3, 4, 5, 6, 7, 8, 9, 10 … at the 
bottom right side of the main pane to jump to a particular page of the Device File List. 

6. To delete one or more files from the device, click the checkbox  to the left of each file you 
want to remove. 

7. Click Delete File. 
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8. Click OK to confirm deletion of the selected files. 

9. Click Refresh to refresh the Device File List and to confirm removal of the selected files. 

Establishing a software baseline 

By using the Set Baseline Software option available from the Operation popup menu, you can 
define the baseline or standard software configuration for the selected device. Once a software 
baseline has been established, you can easily revert to the established baseline if any problems 
arise with the device. 

To set a software baseline for the selected device: 

1. Navigate to Service > <Device Name> > Configuration Management. 

a. Click the Service tab from the top tabular navigation system. 

b. Do one of the following: 

 Click Configuration Center under the Resource and Configuration Management 
section of the Service page. 

 Click Configuration Center on the left navigation tree. 

All devices that can be managed by the Configuration Center are displayed in the list in 
the bottom half of the Configuration Center page.  

2. Click the Operation icon  in the Operation field of the device for which you want to view the 
startup configuration. 

3. Select Set Baseline Software from the popup menu. 

The Set Baseline Software dialog box opens. 

4. Select the file you want to set as the software baseline. 

5. Click OK. 

The results of the set baseline software task are displayed at the top of the Configuration 
Center page. 

6. Review the results to ensure that the task was completed successfully. 

Comparing device configurations 

You can compare the contents of configuration files. You can compare backup startup or running 
configuration files with the current startup or running configuration files. IMC also provides a 
line-by-line comparison of the two files with changes highlighted. 

In addition, IMC provides a summary of identical, changes, and unique lines. The Compare with 
Other Device Configuration option available from the Operations popup offers you a quick link to 
the Configuration Compare page. For more information about this feature, see "Comparing device 
configurations." 

Deploying software from the Configuration Center 

You can launch the Deployment Guide from the Configuration Center for deploying software to 
selected devices. The Deploy Software button on the Configuration Management page serves as 
a link that navigates you to the Deployment Guide for deploying software to the selected devices. 

To use this feature, first click the checkbox  to the left of the devices to which you want to deploy 
software. Click Deploy Software to begin the deployment process for the selected devices. For 
more information about deploying software by using the Deployment Guide, see "Deploying 
configurations and software by using IMC deployment guide." 

Deploying configurations from the Configuration Center 

You can launch the Deployment Guide from the Configuration Center for deploying configurations 
to selected devices. The Deploy Configuration button on the Configuration Management page 
serves as a link that navigates you to the Deployment Guide for deploying configurations to the 
selected devices. 
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To use this feature, select the devices in which you want to deploy software. Click Deploy 
Configuration to begin the deployment process for the selected devices. For more information 
about deploying software by using the Deployment Guide, see "Deploying configurations and 
software by using IMC deployment guide." 

Backing up configurations from the Configuration Center 

You can back up the configuration files for one or more devices. The Configuration Center provides 
you with quick access to the backup configuration feature for one-time backups of selected devices. 
For scheduled backups, see "Managing automatic backup plans" and "Configuring automatic device 
backups." 

The iCC component supports TFTP, FTP, and SFTP for file transfer. The default transfer mode is 

TFTP. The configuration backups are stored in the \server\data\cfgbak (/server/data/cfgbak 

for Linux) directory of the IMC installation path. To transfer a 32MB or larger configuration file, make 
sure you use FTP. For more information about the transfer modes, see "File transfer mode options." 

The iCC component also provides the backup file encryption feature. To enable or disable the 
feature, configure the EncryptConfigFileFlag parameter in the qvdm.conf file in the \server\conf\ 
directory of the IMC installation path. The value of 1 enables the feature. The value of 0 disables the 
feature. By default, this parameter does not take effect. 

To manually backup one or more devices from the Configuration Center: 

1. Navigate to Service > Configuration Center. 

a. Click the Service tab from the top tabular navigation system. 

b. Do one of the following: 

 Click Configuration Center under the Resource and Configuration Management 
section of the Service page. 

 Click Configuration Center on the left navigation tree. 

All devices that can be managed by the Configuration Center are displayed in the list in 
the bottom half of the Configuration Center page. 

2. Click the checkboxes  to the left of the devices for which you want to back up the 
configuration file. 

3. Click Backup Configuration. 

The page is updated to display the Configuration File Backup Result table. This results table 
displays the result for each configuration file that was backed up. The Configuration File Backup 
Result table provides descriptive information for the devices that were backed up including Device 
Name, Device Model, File Type, startup or running configuration file and the Time of the backup. 
Also included in this table are the results of each configuration file backup. The Result field contains 
information on whether or not the backup of configuration files for each device succeeded or failed. 

Additionally, the icon in the Detail field associated with every configuration file navigates to a new 
dialog box that provides information on where backup succeeded or failed in each step of the backup 
process. Review the results for each entry in this table and in the Result and Details fields in 
particular to ensure that all configuration files were backed up successfully or to identify where 
problems occurred that prevented a successful backup. 

The Backup History Report option in the Configuration Center provides you with visibility into the 
results of both manual and automatic backup tasks. For more information about using the Backup 
History Report option, see "Viewing backup history reports and restarting a failed backup." 

Restoring a configuration from the Configuration Center 

The Restore button on the Configuration Management page provides a link to the Deployment 
Guide for restoring configurations or software by using IMC Deployment Guide. For information 
about restoring software or configurations in IMC, see "Deploying configurations and software by 
using IMC deployment guide." 
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Deploying a file from the Configuration Center 

You can launch the Deployment Guide from the Configuration Center for deploying files to 
selected devices. The Deploy File button on the Configuration Management page serves as a link 
that navigates you to the Deployment Guide for deploying files to the selected devices. 

To use this feature, first click the checkbox  to the left of the devices to which you want to deploy 
software. Then, click Deploy Configuration to begin the deployment process for the selected 
devices. For more information about deploying software by using the Deployment Guide, see 
"Deploying configurations and software by using IMC deployment guide." 

Batch baselining device configuration 
To batch baseline device configuration: 

1. Navigate to Service > Configuration Center. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Configuration Center under Configuration Center on the left navigation tree.  

2. Click Baseline Device Configuration. 

3. In the Select Baseline Policy area, set the earliest backup time, latest backup time, matching 
policy, and configuration file type.  

 Matching Policy—Options are Latest Backup Configuration and Earliest Backup 
Configuration. For example, if you select Latest Backup Configuration, the latest backup 
configuration between the earliest backup time and latest backup time is configured as the 
baseline.  

 Configuration File Type—Options are All, Running Configuration, and Startup 
Configuration.  

4. Click Select Device. The page for selecting devices opens.  

5. Select the devices for which you want to baseline the configuration, and click Add Device.  

6. Close the page for selecting devices, and click OK to start baselining device configuration. After 
certain period of time, click Refresh to see the baselining result.  

Managing device configurations with templates 
IMC uses configuration templates for standardizing the configuration of network device. 
Configuration templates allows you to create and save device configurations and determine device 
series or models to which to apply the configuration templates. When you deploy the configuration 
template, IMC filters out all devices to which the configuration template cannot be deployed. This 
simplifies the deployment of configuration templates and reduces errors that can arise from applying 
a configuration template to the wrong device. 

You can create three types of configuration templates, File, Segment, and CLI Script templates. 
With a file template type, you can create and store an entire startup or running configuration template 
and apply it in its entirety to one or more devices. With file templates, the old configuration file is 
replaced by the contents of the file template. With a segment template type, you create just a portion 
of a startup or running configuration. IMC applies just the segment to the existing startup or running 
configuration file. 

IMC provides folders for managing the organization of configuration templates. This lets you quickly 
access configuration templates. As with most other features and modules, IMC provides a search 
method for quickly locating configuration templates. 

Accessing configuration templates 

To access configuration templates and template folders: 

1. Navigate to Service > Configuration Templates. 
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a. Click the Service tab from the top tabular navigation system.  

b. Click Configuration Center on the left navigation tree. 

c. Click Configuration Templates under Configuration Center on the left navigation tree. 

All root configuration template folders and configuration templates stored at the template folder 
root level is displayed in the Configuration Templates list.  

Configuration template list 

 Template Name—Contains the name of the template or the template folder. Templates have a 
template icon to the left of the template name. Folders have a folder icon to the left of the folder 
name. 

 Type—Identifies whether or not the associated entry is a template file, segment, or folder. 

 Create Time—Identifies by date and time stamp when the configuration file, segment, or folder 
was created. 

 Description—Contains the description for the file, segment or folder that was configured by the 
operator when it was created. 

 Delete—Contains a link  for deleting the associated configuration template or folder. 

 Operation—Contains an icon that displays links to operational tasks for the associated file, 
segment, or folder. Options include Rename, Modify, Copy, Export and Deploy. For more 
information about using each of these operations, see the following information on renaming, 
modifying, copying, exporting, or deploying templates. 

You can sort the Configuration Templates list by the Template Name, Create Time, and 
Description fields. Click the column label to sort the list by the selected field. The column label is a 
toggle switch that lets you toggle between the various sort options specific to each field. 

If the Configuration Templates list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Configuration Templates list. 

 Click  to page forward to the end of the Configuration Templates list. 

 Click  to page backward in the Configuration Templates list. 

 Click  to page backward to the front of the Configuration Templates list. 

 Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

Querying configuration templates 

You can search for a particular configuration template file or folder and filter the current list. You can 
filter either by a partial or complete template file or folder name or by template type. IMC displays 
only those configuration template files and folders that match the search or filter criteria. 

To filter the Configuration Templates list: 

1. Navigate to Service > Configuration Templates. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Configuration Center on the left navigation tree. 

c. Click Configuration Templates under Configuration Center on the left navigation tree. 

All root configuration template folders and configuration templates stored at the template folder 
root level are displayed in the Configuration Templates list. The Query Criteria section of the 
templates page displays above the Configuration Templates list. 

2. Enter a device name in the field in the upper right corner of the Configuration Templates list, 

and click the search icon , or click the Advanced icon  located in the upper right corner 
of the page. 
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The search criteria dialog box opens. 

3. Enter one or more of the following search criteria in the Query Criteria dialog box: 

 Folder—Select which folder you want to search in or filter on from the Folder list. 

 Template Name—Enter some portion or all of the configuration template name by which 
you want to filter the configuration template list. 

 Template Type—Select the type of template by which you want to filter the configuration 
template list from the Template Type list. 

4. Click Query to submit your filter criteria. 

The results of your filter or search query is displayed in the Configuration Templates list 
below. 

5. Click Reset when you want to restore the full Configuration Templates list. 

Organizing configuration templates 

IMC offers you the ability to create as many configuration templates as needed to manage the 
ongoing task of network device configuration management. With the ability to create whole 
configuration files and sections of a configuration file called segments, you can easily create 
hundreds of configuration files. 

You can create folders to organize configuration templates. Template configuration folders work 
exactly the same way as folder or directories in file systems, meaning you can create folders at the 
root level and nested within folders. You can also add templates at the root level and in subfolders. 
Ideas for template organization include grouping templates by device type, location, device function, 
just to name a few. 

Template configuration subfolders are accessed by selecting the parent folder in the same way that 
subdirectories are accessed by double-clicking the parent directory.  

Creating a template folder 

1. Navigate to Service > Configuration Templates. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Configuration Center on the left navigation tree. 

c. Click Configuration Templates under Configuration Center on the left navigation tree. 

All root configuration template folders and configuration templates stored at the template folder 
root level are displayed in the Configuration Templates list.  

2. Navigate to the folder in which you want to add a folder. 

3. Click Add Folder located to the upper of the Configuration Templates list. 

The Add Folder dialog box opens. 

Operators must have administrative level access to create configuration template folders. 

4. Enter a name for the folder in the Name field.  

Configuration template names cannot begin or end with a period (.). Spaces in the configuration 
template name are also not permitted. In addition, the characters in Table 38 are not permitted 
in a configuration template file name. 

Table 38 Invalid characters 

Character Name Character Name 

* Asterisk ' Apostrophe or single quotation 

| Vertical bars : Colon 

\ Backslash " Double quotation 

/ Forward slash < > Angle brackets 

? Question mark   
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5. Enter a description for the folder in the Description field.  

6. Click OK. 

Modifying a configuration template folder 

To modify an existing configuration template folder: 

1. Navigate to Service > Configuration Templates. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Configuration Center on the left navigation tree. 

c. Click Configuration Templates under Configuration Center on the left navigation tree. 

All root configuration template folders and configuration templates stored at the template folder 
root level are displayed in the Configuration Templates list.  

2. Navigate to the parent folder that contains the folder you want to modify. 

3. From the Configuration Templates list, click the Operation icon  associated with the 
configuration template folder you want to modify. Select Modify from the popup window. 

4. Modify the description of the folder in Description field as needed. 

5. Click OK to accept your changes. 

Deleting a configuration template folder  

1. Navigate to Service > Configuration Templates. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Configuration Templates under Configuration Center on the left navigation tree. 

All root configuration template folders and configuration templates stored at the template folder 
root level are displayed in the Configuration Templates list. 

2. Navigate to the parent folder that contains the folder you want to delete. 

3. From the Configuration Templates list, click the Delete icon  associated with the 
configuration template folder you want to delete. 

4. Click OK to confirm deletion of the configuration template folder. 

Creating a configuration template 
IMC provides you with these types of templates: File, Segment, CLI Script, and TCL Script. 

File configuration templates include the entire contents of a startup or running configuration. File 
configuration templates are applied in their entirety and the operator determines which file (the 
existing startup or running configuration file) is replaced when a template is deployed.  

Segment configuration templates contain only a portion of a configuration file. When they are 
deployed, the configuration segment is added to the existing startup or running configuration. 
Segment configuration templates let you modularize the process of template creation and 
configuration file management.  

A CLI script template contains a set of commands. When a CLI script template is deployed, IMC 
automatically logs in to the device through Telnet or SSH and executes the commands contained in 
the template step by step. 

IMC also provides three methods for creating device configuration templates. The recommended 
method for creating a template involves importing the contents of a template from a configuration file 
backed up by IMC. By using this method, you can leverage existing configurations and modify them 
as needed to create a template. 

You can also create a configuration template from scratch by using the Manual Add option. By using 
this method, you begin with a blank file and build the configuration manually. 
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The third method for creating a configuration template is to import the contents from a file on the 
operator's local computer.  

Adding a configuration template by using a backup file 

Creating a configuration template by using a backup file is the quickest and easiest way to build 
templates. By using this method, you can leverage an existing configuration file and make the 
modifications that are needed before saving it as a template. This method is effective for both file and 
segment configuration template types and is the recommended method for building configuration 
templates quickly and easily. 

To create a configuration template from a backup configuration file created by IMC: 

1. Navigate to Service > Configuration Templates. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Configuration Center on the left navigation tree. 

c. Click Configuration Templates under Configuration Center on the left navigation tree. 

All root configuration template folders and configuration templates stored at the template folder 
root level are displayed in the Configuration Templates list.  

2. Navigate to the folder to which you want to add a configuration template. 

3. Click Add. 

4. Select Import From Backup File from the popup menu. 

A list of all backup configuration files in IMC is displayed. 

5. In the query field in the upper right corner of the page, enter the IP address of the device you 

want to query, and click the Search icon . 

All matching backup configuration files are displayed in the list. 

6. Click the Advanced icon  located in the upper right corner of the page. 

The search criteria dialog box opens. 

7. Enter one or more of the following query criteria: 

 Device IP—Enter the IP address of the device. 

 Device Label—Enter the label of the device. 

 File Name—Enter the name of the backup configuration file. 

 File Type—Select a type for the backup configuration file. Options are: All, Startup 
Configuration, and Running Configuration. 

8. Select the configuration file you want to use. 

To use this feature, the configuration file must already exist in IMC. For more information about 
using IMC to back up the device configuration files, see "Managing automatic backup plans." 

9. Click Next. 

The Add Configuration Template page opens. 

10. Enter a name for the template in the Template Name field. 

Configuration template names cannot begin or end with a period (.). Spaces in the configuration 
template name are also not permitted. In addition, the characters in Table 39 are not permitted 
in a configuration template file name. 

Table 39 Invalid characters 

Character Name Character Name 

* Asterisk ' Apostrophe or single quotation 

| Vertical bars : Colon 

\ Backslash " Double quotation 
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Character Name Character Name 

/ Forward slash < > Angle brackets 

? Question mark   
 

11. Select the type of template you want to create from the Template Type list. Template type 
options include File, Segment, and TCL Script.  

A file template type creates an entire configuration file that is then applied to the devices 
selected for deployment. A segment template type creates only a portion of a configuration 
field, which is then applied to the selected devices. For example, if your organization uses 
SNMP community strings that vary by location, you can create a configuration file by using a 
segment template type for just the SNMP community string configuration for each location and 
then deploy that configuration template to devices by location. 

12. Select the configuration template folder you want to save this template to from the Folder list. 

13. Select the device type you want to create this configuration template for by clicking Select 
Model next to the Applicable Devices field. 

The Device Model dialog box opens. 

The Device Model dialog box contains two sections. The Series List section contains a list of 
all vendor specific device series in IMC. The top section under Device Model provides two 
options for filtering the Series List.  

14. Do one of the following: 

 To display the device series for a specific vendor, select the vendor from the Vendor Name 
list in the top section of the Device Model dialog box. 

 To display a specific device series, enter a full or partial device series name in the Series 
field. 

15. Click Query to apply your filter to the Series List. 

16. Click the device series name to which you want to adapt this configuration template. An 
expanded list of all device types under the device series name you selected is displayed. 

17. Select the devices to which you want to adapt this configuration template. 

18. Click OK. 

19. Enter a description for the configuration template in the Description field. 

Adding a description that uniquely identifies the function of the configuration template is a 
valuable aid that supports the correct deployment of configuration templates. Consider using 
the devices to which the template is applied and what the template contains, if using a segment 
template type. For segment configuration templates, consider naming the template by the type 
of function or commands contained within the template. 

20. Modify the text in the Content field as needed. 

21. If you are creating a segment template, delete all of the content that you do not want to apply to 
devices when this configuration template is deployed to devices in the infrastructure. 

Variables are supported in configuration templates. If you use variables in a configuration 
template, you are prompted for the variable values when you deploy the configuration template. 

Variables include value variables and configuration template variables.  

A value variable is in the format of ${value variable name}, for example, ${ip address}, where ip 
address is used as the value variable name. When you deploy the configuration template, ${ip 
address} will be replaced by the IP address that you set.  

A configuration template variable is in the format of §{configuration template variable name}, for 
example, §{configTemplate}, where configTemplate is used as the configuration template 
variable name. When you deploy the configuration template, §{configTemplate} will be replaced 
by the contents of the configuration template that you select. 
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Any blank spaces before or after variable names are omitted. For example, IMC converts ${ 
paramName } to ${paramName}. A variable name cannot include spaces ( ), dollars signs ($) or 
curly braces ({}). 

22. Click OK. 

Adding a configuration template by using file import 

You can also import the contents of a configuration file from your local computer for use in creating a 
configuration template as follows: 

1. Navigate to Service > Configuration Templates. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Configuration Templates under Configuration Center on the left navigation tree. 

All root configuration template folders and configuration templates stored at the template folder 
root level are displayed in the Configuration Templates list. 

2. Navigate to the folder in which you want to add a configuration template. 

3. Click Add. 

4. Select Import From File from the popup menu. 

The Import Configuration Template page opens.  

5. Enter the file, including the full path you want to use for this configuration template in the Select 
file field.  

6. Optionally, you can browse for the file by clicking Upload File. 

7. Click Browse to locate the file on your local computer.  

8. Click OK once you have selected the file and the filename including its full path is displayed in 
the Select File field. 

9. Enter a name for the template in the Target Name field. 

Configuration template names cannot begin or end with a period (.). Spaces in the configuration 
template name are also not permitted. In addition, the characters in Table 40 are not permitted 
in a configuration template file name. 

Table 40 Invalid characters 

Character Name Character Name 

* Asterisk ' Apostrophe or single quotation 

| Vertical bars : Colon 

\ Backslash " Double quotation 

/ Forward slash < > Angle brackets 

? Question mark   
 

10. Select the type of template you want to create from the Template Type list. Template type 
options include File, Segment, and TCL Script.  

A file template type creates an entire configuration file that is then applied to the device by using 
the deployment option. A segment template type creates only a portion of a configuration field, 
which is then applied to the device.  

For example, if your organization uses SNMP community strings that vary by location, you can 
create a configuration file by using a segment template type for just the SNMP community string 
configuration for each location. Then deploy that configuration template to devices by location. 

11. Select the configuration template folder you want to save this template to from the Folder list. 

12. Select the device you want to adapt this configuration template to by clicking Select Model next 
to the Applicable Devices field. 
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The Device Model dialog box opens. 

The Device Model dialog box contains two sections. The Series List section contains a list of 
all vendor specific devices series in IMC. The top section under Device Model gives you two 
options for filtering the Series List.  

13. Do one of the following: 

 To display devices series for a specific vendor, select the vendor from the Vendor Name list 
in the top section of the Device Model dialog box. 

 To display a specific device series, enter a full or partial device series name in the Series 
field. 

14. Click Query to apply your filter to the Series List. 

15. Click the device series name to which you want to adapt this configuration template.  

An expanded list of all device types under the device series name you selected is displayed. 

16. Select the devices to which you want to adapt this configuration template. 

17. Click OK. 

18. Enter a description for the configuration template in the Description field. 

Adding a description that uniquely identifies the function of the configuration template is a 
valuable aid that supports the correct deployment of configuration templates. Consider using 
the devices to which the template is applied and what the template contains, if using a segment 
template type. For segment configuration templates, consider naming the template by the type 
of function or commands contained within the template. 

19. Click OK. 

Manually adding a configuration template 

To manually create a configuration template:  

1. Navigate to Service > Configuration Templates. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Configuration Center on the left navigation tree. 

c. Click Configuration Templates under Configuration Center on the left navigation tree. 

All root configuration template folders and configuration templates stored at the template folder 
root level display in the Configuration Templates list.  

2. Navigate to the folder to which you want to add a configuration template. 

3. Click Add. 

4. Select Manual Add from the popup menu. 

5. Enter a name for the template in the Template Name field. 

Configuration template names cannot begin or end with a period (.). Spaces in the configuration 
template name are also not permitted. In addition, the characters in Table 41 are not permitted 
in a configuration template file name. 

Table 41 Invalid characters 

Character Name Character Name 

* Asterisk ' Apostrophe or single quotation 

| Vertical bars : Colon 

\ Backslash " Double quotation 

/ Forward slash < > Angle brackets 

? Question mark   
 

6. Select the type of template you want to create from the Template Type list. Template type 
options include File, Segment, CLI Script, and TCL Script.  
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A file template type creates an entire configuration file that is then applied to the device by using 
the deployment option.  

A segment template type creates only a portion of a configuration field, which is then applied to 
the device. For example, if your organization uses SNMP community strings that vary by 
location, you can create a configuration file by using a segment template type for just the SNMP 
community string configuration for each location and then deploy that configuration template to 
devices by location. 

A CLI script template type creates a CLI configuration file, which is then applied to the device 
through telnet.  

7. Select the configuration template folder you want to save this template to from the Folder list. 

8. Select the device type you want to create this configuration template for by clicking Select 
Model next to the Applicable Devices field. 

The Device Model dialog box opens. 

The Device Model dialog box contains two sections. The Series List section contains a list of all 
vendor specific device series in IMC. The top section under Device Model provides two options 
for filtering the Series List.  

9. Do one of the following: 

To display the device series for a specific vendor, select the vendor from the Vendor Name list 
in the top section of the Device Model dialog box. 

To display a specific device series, enter a full or partial device series name in the Series field. 

10. Click Query to apply your filter to the Series List. 

11. Click the device series name to which you want to adapt this configuration template.  

An expanded list of all device types under the device series name you selected is displayed. 

12. Click the checkbox  to the left of the devices to which you want to adapt this configuration 
template. 

13. Click OK. 

14. Enter a description for the configuration template in the Description field. 

Adding a description that uniquely identifies the function of the configuration template is a 
valuable aid that supports the correct deployment of configuration templates. Consider using 
the devices to which the template is applied and what the template contains, if using a segment 
template type. For segment configuration templates, consider naming the template by the type 
of function or commands contained within the template. 

15. Enter the contents of your configuration template in the Content field. 

Variables are supported in configuration templates. If you use variables in a configuration 
template, you are prompted for the variable values when you deploy the configuration template. 

Variables include value variables and configuration template variables.  

A value variable is in the format of ${value variable name}, for example, ${ip address}, where ip 
address is used as the value variable name. When you deploy the configuration template, ${ip 
address} will be replaced by the IP address that you set.  

A configuration template variable is in the format of §{configuration template variable name}, for 
example, §{configTemplate}, where configTemplate is used as the configuration template 
variable name. When you deploy the configuration template, §{configTemplate} will be replaced 
by the contents of the configuration template that you select. 

Any blank spaces before or after variable names are omitted. For example, IMC converts ${ 
paramName } to ${paramName}. A variable name cannot include spaces ( ), dollars signs ($) or 
curly braces ({}). 

16. If you select the CLI Script option from the Template Type list, you can add configuration 
template commands in the Content field by using a table. 

 Command—Enter the command to be configured. 

 Response Prompt—Response of the command lines. 
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 Prompt Condition—Select the response type,  Error Prompt or  Successful 
Prompt. 

 Action—Click Add to enter another command, and click Delete to delete the corresponding 
command. 

17. Click Change to Advanced Mode link to switch to the advanced mode, and enter the 
configuration template commands in the Content field. 

Any blank spaces before or after variable names are omitted. For example, IMC converts ${ 
paramName } to ${paramName}. A variable name cannot include spaces ( ), dollars signs ($) or 
curly braces ({}). 

18. Click OK. 

If you click Add on the Configuration Templates page, and select Add CLI Script from the 
popup menu, you can also enter the Add Configuration Template page with the default 
Template Type as CLI Script. 

Modifying a configuration template 
You can modify most of a configuration template's parameters. Other configuration options such as 
renaming a template or moving it to another location are available through other Operation menu 
options. 

To modify most of the parameters of a configuration template: 

1. Navigate to Service > Configuration Templates. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Configuration Templates under Configuration Center on the left navigation tree. 

All root configuration template folders and configuration templates stored at the template folder 
root level are displayed in the Configuration Templates list. 

2. Navigate to the folder that contains the configuration template you want to modify. 

3. Click the Operation icon  in the Operation field of the configuration template you want to 
modify. 

4. Select the Modify icon  from the popup menu. 

The Modify Configuration Template page opens. 

You cannot modify the name of a configuration template from the Modify Configuration 
Template page. To rename it, you must select the Rename option from the Operation popup 
menu. For more information about renaming a configuration template, see "Renaming a 
configuration template." 

5. To modify the template type, select the type from the Template Type list. Template type 
options include File, Segment, CLI Script, and TCL Script. 

A file template type creates an entire configuration file that is then applied to the device by using 
the deployment option. 

A segment template type creates only a portion of a configuration field, which is then applied to 
the device. For example, if your organization uses SNMP community strings that vary by 
location, you can create a configuration file by using a segment template type for just the SNMP 
community string configuration for each location and then deploy that configuration template to 
devices by location. 

A CLI script template type creates a CLI configuration file, which is then applied to the device 
through telnet. 

You also cannot modify the folder in which a configuration template is saved once you have 
created it. To move a configuration file to a new folder, you can copy the configuration template 
and specify the new folder location from the Copy Configuration Template page. For more 
information about copying a configuration template, see "Copying a configuration template." 
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6. You can remove devices in the Applicable Devices field by selecting the device you want to 
delete and clicking Delete Model. 

7. Select the device type you want to create this configuration template for by clicking Select 
Model next to the Applicable Devices field. The Device Model dialog box opens. 

The Device Model dialog box contains two sections. The Series List section contains a list of 
all vendor specific devices series in IMC. The top section under Device Model gives you two 
options for filtering the Series List.  

8. Do one of the following: 

 To display the devices series for a specific vendor, select the vendor from the Vendor Name 
list in the top section of the Device Model dialog box. 

 To display a specific device series, enter a full or partial device series name in the Series 
field. 

9. Click Query to apply your filter to the Series List. 

10. Click the device series name to which you want to adapt this configuration template. An 
expanded list of all device types under the device series name you selected is displayed. 

11. Select the devices to which you want to adapt this configuration template. 

12. Click OK. 

13. Modify the description for the configuration template in the Description field as needed. 

14. Modify the contents of the configuration template in the Content field as needed. 

Variables are supported in configuration templates. If you use variables in a configuration 
template, you are prompted for the variable values when you deploy the configuration template. 

The variable format is ${variable name}. For example ${ip address} is a valid variable where ip 
address is used as the variable name. When you deploy the configuration template, ${ip 
address} is replaced by the IP address you define. 

15. If you select the CLI Script option from the Template Type list, you can modify configuration 
template commands in the Content field by using a table. 

 Command—Enter the command to be configured 

 Response Prompt—Response of the command lines 

 Prompt Condition—Select the response type,  Error Prompt or  Successful 
Prompt. 

 Action—Click Add to enter another command, and click Delete to delete the corresponding 
command. 

16. Click Change to Advanced Mode link to switch to the advanced mode, and modify the 
configuration template commands in the Content field. 

Any blank spaces before or after variable names are omitted. For example, IMC converts ${ 
paramName } to ${paramName}. A variable name cannot include spaces ( ), dollars signs ($) or 
curly braces ({}). 

17. Click OK. 

Renaming a configuration template 
To rename a configuration template: 

1. Navigate to Service > Configuration Templates. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Configuration Templates under Configuration Center on the left navigation tree. 

All root configuration template folders and configuration templates stored at the template folder 
root level are displayed in the Configuration Templates list. 

2. Navigate to the folder that contains the configuration template you want to rename. 
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3. Click the Operation icon  in the Operation field of the configuration template you want to 
rename. 

4. Select  Rename from the popup menu. 

The Rename dialog box opens. 

5. Enter the new name for the configuration template in the New Name field. 

Configuration template names cannot begin or end with a period (.). Spaces in the configuration 
template name are also not permitted. In addition, the characters in Table 42 are not permitted 
in a configuration template file name. 

Table 42 Invalid characters 

Character Name Character Name 

* Asterisk ' Apostrophe or single quotation 

| Vertical bars : Colon 

\ Backslash " Double quotation 

/ Forward slash < > Angle brackets 

? Question mark   
 

6. Click OK. 

Copying a configuration template 
Copying a configuration template allows you to re-use and modify an existing configuration template. 
In addition, the copy option also lets you move an existing configuration template to a new location. 

To copy a configuration template: 

1. Navigate to Service > Configuration Templates. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Configuration Templates under Configuration Center on the left navigation tree. 

All root configuration template folders and configuration templates stored at the template folder 
root level are displayed in the Configuration Templates list. 

2. Navigate to the folder that contains the configuration template you want to copy. 

3. Click the Operation icon  in the Operation field of the configuration template you want to 
copy. 

4. Select Copy  from the popup menu 

The Copy Configuration Template page opens. 

5. Modify the name for the template in the Template Name field. 

You cannot modify the name of a configuration template from the Modify Configuration 
Template page. To rename it, you must select the Rename option from the Operation popup 
menu. For more information about renaming a configuration template, see "Renaming a 
configuration template." 

6. Select the type of template you want to create from the Template Type list. Template type 
options include File, Segment, CLI Script, and TCL Script. 

A file template type creates an entire configuration file that is then applied to the device by using 
the deployment option. 

A segment template type creates only a portion of a configuration field, which is then applied to 
the device. For example, if your organization uses SNMP community strings that vary by 
location, you can create a configuration file by using a segment template type for just the SNMP 
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community string configuration for each location and then deploy that configuration template to 
devices by location. 

A CLI script template type creates a CLI configuration file, which is then applied to the device 
through telnet. 

7. To copy, delete, or add devices to a configuration template, do one of the following: 

Select the folder you want to copy the configuration template to from the Folder list. 

Select the devices you want to remove in the Applicable Devices field and click Delete Model. 

Click Select Model next to the Applicable Devices field to add devices. 

The Device Model dialog box opens, containing two sections: 

The Series List section contains a list of all vendor specific device series in IMC. 

The top section under Device Model gives you two options for filtering the Series List. 

8. Do one of the following: 

 To display the devices series for a specific vendor, select the vendor from the Vendor Name 
list in the top section of the Device Model dialog box. 

 To display a specific device series, enter a full or partial device series name in the Series 
field. 

9. Click Query to apply your filter to the Series List. 

10. Click the device series name to which you want to adapt this configuration template. 

An expanded list of all device types under the device series name you selected is displayed. 

11. Click the checkbox  to the left of the devices to which you want to adapt this configuration 
template. 

12. Click OK. 

13. Modify the description for the configuration template in the Description field as needed. 

14. Modify the contents of the configuration template in the Content field. 

Variables are supported in configuration templates. If you use variables in a configuration 
template, you are prompted for the variable values when you deploy the configuration template. 

The variable format is ${variable name}. For example ${ip address} is a valid variable where ip 
address is used as the variable name. When you deploy the configuration template, ${ip 
address} is replaced by the IP address you define. 

15. If you select the CLI Script option from the Template Type list, you can modify configuration 
template commands in the Content field by using a table. 

 Command—Enter the command to be configured 

 Response Prompt—Response of the command lines. 

 Prompt Condition—Select the response type, Error Prompt  or Successful Prompt 

. 

 Action—Click Add to enter another command, and click Delete to delete the corresponding 
command. 

16. Click Change to Advanced Mode link to switch to the advanced mode, and modify the 
configuration template commands in the Content field. 

Any blank spaces before or after a variable name is omitted. For example, IMC converts ${ 
paramName } to ${paramName}. A variable name cannot include spaces ( ), dollars signs ($) or 
curly braces ({}). 

17. Click OK. 
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Exporting a configuration template 
Exporting a configuration template lets you make the contents of an IMC configuration template 
available for other devices not managed by IMC. IMC exports templates into plain text, which can 
then be imported as configuration files to other devices. 

To export the contents of a configuration template: 

1. Navigate to Service > Configuration Templates. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Configuration Templates under Configuration Center on the left navigation tree. 

All root configuration template folders and configuration templates stored at the template folder 
root level are displayed in the Configuration Templates list. 

2. Navigate to the folder that contains the configuration template you want to export. 

3. Click the Operation icon  in the Operation field of the configuration template you want to 
export. 

4. Select Export from the popup menu. 

The Download Exported Device Configuration page opens 

5. To save the exported file to your local computer, click the Download Exported Device 
Configuration link. 

6. Follow your browser's instructions for saving the file to your local computer. 

Deploying a configuration template 
You can launch the Deployment Guide from the Configuration Templates list for deploying the 
select configuration template. For information about deploying configurations in IMC, see "Deploying 
configurations and software by using IMC deployment guide." 

Deleting a configuration template 
1. Navigate to Service > Configuration Templates. 

a. Click the Service tab from the top tabular navigation system. 

b. Click the Configuration Center on the left navigation tree. 

c. Click the Configuration Templates under Configuration Center on the left navigation 
tree. 

All root configuration template folders and configuration templates stored at the template folder 
root level are displayed in the Configuration Templates list. 

2. Navigate to the folder that contains the configuration template you want to delete. 

3. Click the Delete icon  in the Delete field of the configuration template you want to delete. 

4. Click OK to confirm deletion of the selected configuration template. 

Managing the software library 
You can store various system files in IMC for quick and reliable deployment. By using the Software 
Library feature, you can upload and annotate software, Boot ROM files, Web files, OAP software or 
other file types to IMC. If the filename extension of the imported file complies with standard filename 
extension conventions (such as .bin, .web, .app, and .zip), IMC automatically resolves which 
software files can be downloaded to which devices in the infrastructure. This ensures a successful 
software deployment to selected devices. 
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IMC provides two ways to import software. The first method is to upload the software or other file 
from your local computer. The second method is to import software from a device in the network 
infrastructure. Using the second method, you can import the software from every device model in the 
network infrastructure to build a comprehensive software library. Using this method in combination 
with the baseline feature provides critical software that is immediately available for restoration in the 
event of a failure. 

Viewing the software library 
To view the software you have imported into IMC software library: 

1. Navigate to Service > Software Library. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Software Library under Configuration Center on the left navigation tree.  

All files in the software library are displayed in the Software Library list. 

Software library list 

 Software Name—Contains the name of the software file that has been imported. This field 
contains a link for navigating to the details for the associated software library entry or 
imported file. 

 Software Type—Contains the type of software that the operator assigned to this file when 
the file was imported. Software type options include Agent Software, Boot ROM, Web File, 
OAP Software, and Other. 

 Software Size—Contains the size in bytes of the associated file. 

 Applicable Devices—Contains every device series and Object ID auto discovered by IMC 
to which the associated software or other file can be deployed. 

 Released Date—Contains the date stamp of the releasing of the software file. 

 Import Time—Contains the date and time stamp for the successful import of the associated 
file. 

 Operation—Click the Operation icon  for a software file and select one of the following 
options from the shortcut menu: 

 Rename—Renames the associated import file. 

 Modify—Modifies the associated import file entry. 

 Export—Exports the associated import file. 

 Make Baseline—Creates a baseline for the associated import file. 

 Remove Baseline—Removes a baseline for the associated import file. 

If the Software Library list spans multiple pages, use the following aids to navigate the list. 

 Click  to page forward in the Software Library list. 

 Click  to page forward to the end of the Software Library list. 

 Click  to page backward in the Software Library list. 

 Click  to page backward to the front of the Software Library list. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

3. For Software Library list that have more than one page, click 1, 2, 3, 4, 5, 6, 7, 8, 9, 10 … from 
the bottom right side of the main pane to jump to a particular page of the trap list. 
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You can sort the Software Library by the Software Name, Software Type, Software Size, 
and Import Time fields. Click the column label to sort the list by the selected field. The column 
label is a toggle switch that lets you toggle between the various sort options specific to each 
field. 

Viewing the details of a software library entry 
To view the details for an individual software library entry: 

1. Navigate to Service > Software Library > Software Details-<Software Name>. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Software Library under Configuration Center on the left navigation tree. 

All files in the software library are displayed in the Software Library list. 

2. Click the link in the Software Name field for the import file for which you want to view details. 

The Software Details page opens. 

Software details 

 Software Name—Contains the name of the software file that has been imported. 

 Software Size—Contains the size in bytes of the associated file. 

 Software Type—Contains the type of software that the operator assigned to this file when 
the file was imported. Software type options include Agent Software, Boot ROM, Web 
File, OAP Software, and Other. 

 Software Version—Contains the version of the associated import file or software, if 
available. 

 Released Data—Contains the date stamp of the releasing of the software file. 

 Import Time—Contains the date and time stamp for the successful import of the associated 
file. 

 Applicable Devices—Contains every device series auto discovered by IMC to which the 
associated import file can be deployed. 

 Description—Contains the description provided by the operator when the file was 
imported. 

3. Click Modify in the upper right of the page to enter the Modify Software Information page. For 
more information, see "Modifying a software library entry." 

Searching for a software library entry 
You can search for a particular file in the software library by a partial or complete file name. IMC 
displays only those files that match the search criteria. 

To search the Software Library list: 

1. Navigate to Service > Software Library. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Software Library under Configuration Center on the left navigation tree.  

All files in the software library are displayed in the Software Library list.  

2. Enter either a portion or the entire software file name you want to locate in the Software Name 
field in the upper right corner of the Software Library list. 

3. Click  to submit your filter criteria. 

The results of your filter or search query is displayed in the Software Library list below. 
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Importing software into the software library from a file 
IMC provides two methods for importing software into the Software Library. Software can be 
uploaded to IMC from a file on your local computer. Or, software can be downloaded from devices in 
the network infrastructure. 

To import software into your software library from a file on your local computer: 

1. Navigate to Service > Software Library. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Software Library under Configuration Center on the left navigation tree. 

All files in the software library are displayed in the Software Library list. 

2. Click Add. 

3. Select Import Software from the popup menu. 

4. Select Import from File to import software from your local computer. 

5. Select the type of software to import from the Software Type list. 

6. Click the Calendar icon  next to Released Data to enter the release time. 

7. You can browse the file system of your local computer for the file you want to import. To browse, 
click Browse next to the Select File field. Follow the instructions provided by your browser for 
locating the file. 

IMC auto populates the Target File field with the file name. You can override this by deleting 
the contents of the Target File field and entering your own file name. 

Software file names cannot begin or end with a period (.). Spaces in the configuration template 
name are also not permitted. In addition, the characters in Table 43 are not permitted in a 
software file name. 

Table 43 Invalid characters 

Character Name Character Name 

* Asterisk ' Apostrophe or single quotation 

| Vertical bars : Colon 

\ Backslash " Double quotation 

/ Forward slash < > Angle brackets 

? Question mark   
 

8. Enter a description for this software file in the Description field. 

9. Click OK to import the file. 

Importing software into the software library from a device 
1. Navigate to Service > Software Library. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Software Library under Configuration Center on the left navigation tree. 

All files in the software library are displayed in the Software Library list. 

2. Click Add. 

3. Select Import Software from the popup menu. 

4. Select Import from Device to import software from your local computer. 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 8942



541 

5. Select the type of software to import from the Software Type list. 

6. Select the devices you want to import the software file from by clicking Select Device. 

7. Add devices either By View or by Advanced query.  

You can add devices by using either the View or Advanced query option. 

For more information, see "Adding devices by view" and "Adding devices by advanced query." 

All devices you select are displayed in the device list. 

Device List 

 Device Name—Label and IP address of the device. 

 Software Name—Name of the startup software used by the device. 

 Device Model—Model of the device. 

 Check Result—Check result that indicates whether the device supports importing software 
through IMC. If the check result is Check failed, IMC does not import software to the device. 

 Delete—Click the Delete icon  to delete the device. 

8. Click OK. IMC starts to import software. 

9. View import information on the import result page. 

a. View import information on the Result list. 

b. Click the Details icon  to view detailed import information. If a failure occurs, the detailed 
information includes the failure reason and the repair suggestions. 

Downloading software from the Web to the software library 
1. Navigate to Service > Software Library. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Software Library under Configuration Center on the left navigation tree. 

All files in the software library are displayed in the Software Library list. 

2. Click Add. 

3. Select Download From Web from the popup menu. 

The LiveUpdate - Type Selection dialog box opens. For more information, see "LiveUpdate." 

Adding OAP software into the software library 
You can add OAP software into the Software Library: 

To add OAP software into your software library from a file on your local computer: 

1. Navigate to Service > Software Library. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Configuration Center on the left navigation tree. 

c. Click Software Library under Configuration Center on the left navigation tree. 

All files in the software library are displayed in the Software Library list. 

2. Click Add. 

3. Select Add OAP Software from the popup menu. 

The Add OAP Software page opens. 

4. Enter a software name for this software file in the Software Name field. 

The Software Name field lets you set the name of the software file that has been added. 
Software file names cannot begin or end with a period (.). Spaces in the configuration template 
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name are also not permitted. In addition, the characters in Table 44 are not permitted in a 
software file name. 

Table 44 Invalid characters 

Character Name Character Name 

* Asterisk ' Apostrophe or single quotation 

| Vertical bars : Colon 

\ Backslash " Double quotation 

/ Forward slash < > Angle brackets 

? Question mark   
 

5. Select the type of software you want to import from the Software Type list. OAP Software is 
selected by default. 

6. Enter a description for this software file in the Description field. 

7. Enter the IP address of the FTP server where the OAP software is located in the FTP Server 
field. Server name is not supported here. 

8. Enter the file path of the OAP software on the FTP server in the Software Path field. 

9. Enter the username for logging in to the FTP server in the FTP User field. 

10. Enter the password for logging in to the FTP server in the FTP Password field. 

11. Click OK to add the OAP software. 

Renaming a software library entry 
To rename an entry in your software library: 

1. Navigate to Service > Software Library. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Software Library under Configuration Center on the left navigation tree. 

All files in the software library are displayed in the Software Library list. 

2. Click the Operation icon  for the software file you want to rename, and select Rename 
from the shortcut menu.  

The Rename Software dialog box opens. 

3. Delete the existing name and enter the new name in the New Name field. 

Software file names cannot begin or end with a period (.). Spaces in the configuration template 
name are also not permitted. In addition, the characters in Table 45 are not permitted in a 
software file name. 

Table 45 Invalid characters 

Character Name Character Name 

* Asterisk ' Apostrophe or single quotation 

| Vertical bars : Colon 

\ Backslash " Double quotation 

/ Forward slash < > Angle brackets 

? Question mark   
 

4. Click OK. 
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Modifying a software library entry 
To modify an existing entry in your software library: 

1. Navigate to Service > Software Library > Modify Software Information-<Software Name>. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Software Library under Configuration Center on the left navigation tree. 

All files in the software library are displayed in the Software Library list. 

2. Click the Operation icon  for the software file you want to modify, and select Modify 
from the shortcut menu. 

The Software Details page opens. 

3. To delete device series or models from the Applicable Devices field, click the device series 
you want to delete.  

4. Click Delete Model. 

5. To add new device series or models to the Applicable Devices list, click Select Model. 

The Device Model dialog box opens. 

The Device Model dialog box contains two sections. The Series List section contains a list of 
all vendor specific devices series in IMC. The top section under Device Model gives you two 
options for filtering the Series List. 

6. Do one of the following: 

 To display a device series for a specific vendor, select the vendor from the Vendor Name list 
in the top section of the Device Model dialog box. 

 To display a specific device series, enter a full or partial device series name in the Series 
field. 

7. Click Query to apply the filter to the Series List. 

8. Click the device series name you want to add to the Applicable Devices list. An expanded list 
of all device types under the device series name you selected is displayed 

9. Select the devices you want to add. 

10. Modify the description in the Description field as needed. 

11. Click OK. 

Exporting a software library entry 
1. Navigate to Service > Software Library > Export Software-<Software Name>. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Configuration Center on the left navigation tree. 

c. Click Software Library  under Configuration Center on the left navigation tree. 

All files in the software library are displayed in the Software Library list. 

2. Click the Operation icon  for the software file you want to export, and select  Export 
from the shortcut menu. 

The Download Exported Software page opens. 

3. To save the exported file to your local computer, click the Download Exported Software link. 

4. Follow your browser's instructions for opening or saving the file to your local computer. 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 8945



544 

Deleting a software library entry 
To delete one or more entries from your software library: 

1. Navigate to Service > Software Library. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Configuration Center on the left navigation tree. 

c. Click Software Library under Configuration Center on the left navigation tree. 

All files in the software library are displayed in the Software Library list. 

2. Select the software library entry you want to delete. 

3. Click Delete. 

4. Click OK to confirm the deletion of the selected software library entry. 

Establishing baselines by using a software library entry 
You can define an entry in the software library as the baseline for one or more devices or device 
models. 

To establish a software file as a baseline for one or more devices: 

1. Navigate to Service > Software Library. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Software Library under Configuration Center on the left navigation tree. 

All files in the software library are displayed in the Software Library list. 

2. Click the Operation icon  for the software file you want to establish as a baseline, and 

select Make Baseline from the shortcut menu.  

3. Do one of the following: 

 If you want to define a software file as the baseline for one or more devices, select Single 
Device. The Select the baseline software and device page opens.  

 If you want to define a software file as the baseline for one or more device models, select 
Device Model. The Select the baseline software and device model page opens.  

The Device Software field is populated by the software file name you selected in step 2. 

4. Do one of the following: 

 If you want to select another software file, click Select next to the Device Software field. 

 If you want to use the current software file, go to Step 8. 

5. After clicking Select, the Select Software dialog box opens. 

6. Select the software file you want to establish as a baseline. 

7. Click OK. 

8. Do one of the following: 

 If you have selected Single Device in Step 3, go to Step 9. 

 If you have selected Device Model in Step 3, go to Step 10. 

9. Select the devices on which you want to establish a baseline by using the software file you have 
selected: 

a. Click Select Device. 

The Select Device dialog box opens. 

b. Add devices by using either the View or Advanced query option.  
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For more information, see "Adding devices by view" and "Adding devices by advanced 
query." 

All selected devices are displayed in the Select Device area. The list displays the following 
information: 

 Device Name—Label of the device. 

 Device Model—Model of the device. 

 Device Model Check—Check result of whether or not the software file matches the 

device model. The Identical indicates that the software file matches the device 
model and you can perform a baseline on the device. 

 Existing Baseline Software—Existing baseline software on the device. To remove 
baseline from baseline software, click Remove from Baseline next to the baseline 
software. 

 Delete—Click the Delete icon  for a device to delete the device from the list. 

c. Go to step 11. 

10. Select the device models on which you want to establish a baseline by using the software file 
you have selected: 

a. Click Select Model.  

The Device Model dialog box opens. 

b. Select one or more device series names and click OK. 

All selected devices are displayed in the Select Device area. The list displays the following 
information: 

 Device Model—Model of the device. 

 Device Model Check—Check result of whether or not the software file matches the 

device model. The Identical  value indicates that the software file matches the 

device model and you can perform a baseline on the device. The Disaccord  value 
indicates that the software file does not match the device model and you cannot perform 
a baseline on the device. 

 Existing Baseline Software—Existing baseline software on the device model. To 
remove baseline from baseline software, click Remove from Baseline next to the 
baseline software. 

 Delete—Click the Delete icon  for a device model to delete the device model from the 
list. 

11. Click Next. 

The Baseline Result page opens. 

Removing baseline from baseline software 
You can remove baseline from baseline software for devices or devices models. 

To remove baseline from baseline software: 

1. Navigate to Service > Software Library. 

a. Click the Service tab from the top tabular navigation system. 

b. Click the Configuration Center on the left navigation tree. 

c. Click Software Library under Configuration Center on the left navigation tree. 

All files in the software library are displayed in the Software Library list. 

2. Click the Operation icon  for the baseline software from which you want to remove 

baseline and select Remove Baseline from the menu that appears.  
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The Remove Device Software Baseline in Batches page opens. 

3. Do one of the following: 

 To select another software file, click Select next to the Device Software field and go to step 
4. 

 To use the current software file, go to step 6. 

4. Select the baseline software from which you want to remove baseline on the Select Software 
dialog box that opens. 

5. Click OK. 

6. Do one of the following: 

 To remove baseline from one or more devices, select Single Device. All devices that have 
baseline established with the software file are displayed in the Select Device with 
Baseline area. 

 To remove baseline from one or more device models, select Device Model. All device 
models that have baseline established with the software file are displayed in the Select 
Device Model with Baseline area. 

7. Select one or more devices or device models. 

8. Click Remove Baseline. 

The operation result is displayed at the upper right of the page. 

Comparing device configurations 
You can compare the contents of configuration files, including current startup configuration files, 
current running configuration files, and backup configuration files by using the Configuration 
Compare function of iCC. 

Configuration Compare applies in the following scenarios: 

 Compare different configuration files on a device to view the configuration changes of that 
device. 

 Compare the configuration files on multiple devices that play the same role on the network, for 
example on multiple access devices, to view how they differ in configuration. 

Configuration Compare provides the following modes: 

 Simple Mode—Allows you to compare different configuration files on a single device or 
different configuration files on two devices. 

 Advanced Mode—Allows you to select multiple devices and their respective configuration files 
and compare these configuration files with a specified baseline configuration file. This mode is 
suitable for comparing configuration files on multiple devices of the same model.  

You can configure content filtering in both simple mode and advanced mode to ignore certain 
commands in comparison. The content filtering setting takes effect globally. The filtered commands 
you specified in simple mode is also valid in advanced mode and for all operators that have 
permissions to General Configuration Compare. 

IMC also provides a line-by-line comparison of the two files with the differences highlighted. In 
addition, IMC provides a summary of identical, changed, and unique lines. You can enter the page 
for comparing device configurations as explained in the following information. 

Configuration comparison in Configuration Center 
To enter the General Configuration Compare page from Configuration Center: 

1. Navigate to Service > Configuration Center. 

a. Click the Service tab from the top tabular navigation system.  
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b. Click Configuration Center on the left navigation tree. 

c. Click Configuration Center in Configuration Center on the left navigation tree. 

All devices that can be managed by the Configuration Center are displayed in the list in the 
bottom half of the Configuration Center page.  

2. Click the Operation icon  in the Operation field of the device with which you want to 
compare a file. 

3. Select Compare with Other Device Configuration  from the popup menu. 

The General Configuration Compare page opens. This page lets you configure the two files 
you want to compare. The first file is displayed on the left side of the results page and the 
second file is displayed on the right.  

Simple Mode 

Use the simple mode to view configuration differences on a single device or two devices. 

1. Click the Simple Mode tab. 

2. Configure the first or left configuration file:  

 Left Device—Display the label and IP address of the device. The left device cannot be 
changed. 

 Stack Unit—If prompted, select the unit you want to use as a source for a configuration file 
from the Stack Unit list. 

 File Type—Select the type of configuration file you want to use for comparison from the File 
Type list.  

 Configuration File—If you selected Backup History as your file type, select a backup 
configuration file you want to compare from the Configuration File list. 

3. Configure the second or right configuration file: 

Select the second configuration file to display on the right by configuring the following: 

 Right Device—Display the name of the device that you want to compare on the right of the 
page. Click Select Device. The Select Device dialog box opens. 

Add devices either By View or by Advanced query by using either the View or Advanced 
query option. See "Adding devices by view" and "Adding devices by advanced query." The 
right device can be the same as the left device to typically have its current startup or running 
configuration file compared with a backup startup or backup running configuration file. 

 Stack Unit—If prompted, select the unit you want to use as a source for a configuration file 
from the Stack Unit list. 

 File Type—Select the type of the configuration file you want to use for comparison from the 
File Type list. 

 Configuration File—If Backup History is selected as the file type, select a backup 
configuration file you want to compare from the Configuration File list. 

4. Filter out commands that you do not want to compare: 

a. Click the Filtered content link in the upper right of the page. The Filtered content window 
opens. 

b. Enter keywords or complete command lines you want to filter out in the Filtered content 
field. The contents are case sensitive. For example, if you enter interface, the commands in 
either configuration file containing interface are not compared. If you enter a, the 
commands in either configuration file containing character a are not compared. 

c. Click Add to add one more line of contents to be filtered out. 

d. Click Delete to delete the contents on that line. 

e. Click OK to save the filtered contents and return to the General Configuration Compare 
page. 

5. Click OK.  
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The comparison starts. After the comparison is complete, a window opens and displays the 
comparison results. For more information, see "Results window." 

Advanced Mode 

Use the advanced mode to view configuration differences on multiple devices. 

View configuration differences on multiple devices: 

1. Click the Advanced Mode tab on the General Configuration Compare page to enter the 
advanced mode. 

2. Click Add. The Select Device window opens. 

3. Click Select Device. The window where you can select devices opens. 

You can add devices either By View or by Advanced query by using either the View or 
Advanced query option. For more information, see "Adding devices by view" and "Adding 
devices by advanced query." 

4. The label and IP address of the selected device are displayed in the Device Name field. 

5. Select a configuration file of the device you want to compare from the File Type list. Options 
include Current Startup Configuration, Current Running Configuration, and Backup 
History. 

6. If you select Backup History from the File Type list, also select a backup configuration file you 
want to compare from the Configuration File list. 

7. Click OK. The selected device and configuration file are displayed in the device list. 

Repeat the previous steps to select more devices and their configuration files to compare. 

Device List 

 Device Name—Label and IP address of the device. 

 File Type—The type of configuration files to be compared, including Current Startup 
Configuration, Current Running Configuration, and Backup History. 

 Stack Unit—If the selected device is a stack device, this field displays the stack unit. 

 File Name—If the selected file is the current startup configuration file or current running 
configuration file, this field is blank. If the selected file is a backup configuration file, this field 
displays the name of the backup configuration file. 

 Baseline Configuration File—This field identifies whether the configuration file of the 
device is the baseline configuration file. You can specify only one baseline configuration file. 
If the current configuration file is the baseline, the field is blank. Otherwise, the field displays 

a Baseline icon . Click the Baseline icon  to configure the current configuration as 

the new baseline configuration file. Then the Baseline icon  is displayed in the Baseline 
Configuration File field of the previous baseline configuration file. 

 Compare—This field is blank if the current file is the baseline configuration file. Otherwise, 

this field displays the View Change icon . 

8. Filter out commands that you do not want to compare. The filtered contents you configured in 
simple mode also takes effect for comparison in advanced mode. 

a. Click the Filtered content link in the upper right of the page. The Filtered content window 
opens. 

b. Enter keywords or complete command lines you want to filter out in the Filtered content 
field. The contents are case sensitive. For example, if you enter interface, the commands in 
either configuration file containing interface are not compared. If you enter a, the 
commands in either configuration file containing character a are not compared. 

c. Click Add to add one more line of contents to be filtered out. 

d. Click Delete to delete the contents on that line. 

e. Click OK to save the filtered contents and return to the General Configuration Compare 
page. 
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9. Click the View Change icon  to compare the current configuration file with the baseline 
configuration file. After comparison, the comparison results are displayed. For more 
information, see "Results window." 

Results window 

The compare results window comprises two parts. The left side of the window displays the command 
lines of the left device, and the right side of the window displays the command lines of the right 
device. Commands are compared line by line. 

To view results: 

1. Select Show All to view all commands, including the same lines, changed lines, and unique 
lines of the two configuration files. Select Show Different Only to view the changed lines and 
unique lines. 

Commands in black are the same lines or were filtered out in comparison. Commands in red are 
changed lines, which are different in the two configuration files. Commands in blue are unique 
lines that exist only in the left or right configuration file. 

Click Previous Diff to move the cursor to the previous changed line or unique line. Click 
Previous Diff to move the cursor to the next changed line or unique line. 

2. Click Close to exit the compare results window. 

Configuration comparison in General Configuration Compare 
To enter the General Configuration Compare page from Configuration Compare: 

1. Navigate to Service > General Configuration Compare. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Configuration Center on the left navigation tree. 

c. Click Configuration Compare under Configuration Center on the left navigation tree. 

The General Configuration Compare page opens. This page lets you configure the two files 
you want to compare. The first file is displayed on the left side of the results page and the 
second file is displayed on the right. 

2. Select devices: 

a. Click Select Device. 

The Select Device dialog box opens. 

b. Add devices either by View or by Advanced query. 

For more information, see "Adding devices by view" and "Adding devices by advanced 
query." 

You can select at most two devices. If you select one device, the left device and the right device 
are the same. If you select two devices, one of them is the left device and the other is the right 
device. 

For how to compare configuration files, see "Configuration comparison in Configuration Center." 

Deploying configurations and software by using 
IMC deployment guide 

IMC Deployment Guide is a step-by-step guide for successfully deploying device configurations 
and software. The Deployment Guide provides a facility for deploying device configurations by 
using the configuration templates you have created. When deploying configuration files, IMC 
evaluates the configuration template against every device selected for deployment to ensure that the 
template can be deployed successfully. IMC identifies when devices do not match the configuration 
template. By using the Deployment Guide you can also restore device configurations. 
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You can also deploy system software and other files uploaded to the software library. With the 
Deployment Guide, you can deploy software from the Software Library to one or more devices. 
With software deployments, IMC performs two checks. The first check evaluates whether or not the 
system software matches the devices current system software and identifies whether or not the 
software should be deployed to the devices. With the second check, IMC verifies that there is 
enough device space to deploy the selected software by using the deployment strategy that you 
have configured. By using the Deployment Guide you can also restore system software should the 
need arise. 

IMC also lets you run configuration or software deployments immediately or to schedule them for a 
later date. For configuration deployments, you can configure recurring or periodic deployments. 

Deploying a device configuration 
The Deployment Guide lets you deploy the device configurations they have created by using 
configuration templates. IMC validates the viability of deploying configurations to every device 
selected for deployment and identifies when a configuration cannot be deployed to a device. In 
addition, you can run deployments immediately or schedule deployments for a later date. 

To deploy device configuration to a selected device: 

1. Navigate to Service > Deployment Guide. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Deployment Guide under Configuration Center on the left navigation tree. 

2. Click Deploy Device Configuration from the Select a Deployment Task section of the 
Deployment Guide page. 

3. Select the configuration template folder that contains the configuration file you want to deploy 
from the Folder list of the Select Configuration Template section of the Select Device page. 

4. Select the configuration template you want to deploy from the Template Name list. Click Merge 
to merge multiple configuration segments or CLI scripts into one template. When a template 
with critical commands (for example, shutdown) is selected, the system automatically 
recognizes the critical commands and displays a notice on the page.  

5. Select the devices you want to update by using the selected configuration file by clicking Select 
Device. 

6. Add devices By View or by Advanced query. 

For more information, see "Adding devices by view" and "Adding devices by advanced query." 

Confirm that the devices now are displayed on the Select Device for Update section of the 
Select Device for Update page. 

7. Review the contents of the Check Result field for every device you have selected. Make sure 
the configuration template matches the device type and the configuration file can be applied to 
all selected devices.  

A Check Passed value in the Check Result field indicates that the configuration template 
can be applied to the selected device.  

A  and error message value in the Check Result field indicates that the selected device did 
not pass IMC configuration file check and the configuration file cannot be applied to the device.  

Remove devices by clicking the Delete icon  associated with the device that did not pass the 
configuration check. 

The statistical result of the device compliance check is displayed at the upper left of the list, 
including the number of the compliant devices, the number of noncompliant devices, and the 
number of the unknown devices. 
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 NOTE: 

If you change the configuration file after you have selected the devices, review the Check Result 
field again to verify that the configuration template can be applied to the selected devices. 
 

8. Select the configuration file type you want to deploy to the selected devices from the File Type 
to be Deployed list under the Deploy Strategy section. Options include Startup 
Configuration and Running Configuration. 

 

 NOTE: 

If you select a configuration file, you can deploy it as a startup configuration or a running 
configuration. If you select a configuration segment, you can deploy it only as a running 
configuration. 
 

9. If you select Running Configuration in the File Type to be Deployed field, the following 
options are displayed. Select options you want to apply to this deployment task. 

 View the change before and after deployment—With this option, IMC displays the 
configuration changes contained in the template you have selected before and after the 
changes have been applied. 

 Deployment Stopped. The configuration running on the device is not consistent with 
the latest running configuration backed up by IMC—With this option, IMC stops 
deploying a configuration file if the device's current running configuration does not match 
the most current running configuration file IMC has for the device. 

 Before deployment, back up the device's running configuration to IMC—With this 
option, IMC makes a backup copy of the running configuration of all devices configured to 
receive the configuration template. This option provides the operator with a copy of the most 
current running configuration for backing out of the configuration template deployment if 
problems occur. 

 Before deployment, save the device's running configuration as a startup 
configuration—With this option, IMC makes a backup copy of the running configuration of 
all devices and save it as the startup configuration to the device. This option also provides 
the operator with a current startup configuration for backing out of the configuration 
template deployment if problems occur. 

 After deployment, back up the device's running configuration to IMC—This option 
instructs IMC to copy the new running configuration to IMC. 

 After deployment, save the device's running configuration as a startup 
configuration—This option instructs IMC to save the device's running configuration as the 
new startup configuration to IMC after deployment is complete. 

10. If you select Startup Configuration in the File Type to be Deployed field, the following 
options are displayed. Select options you want to apply to this deployment task. 

 Backup the current startup configuration file of the device—This option instructs IMC 
to save the current startup configuration to IMC. 

 Restart device after deployment—This option instructs IMC to reboot the selected 
devices after the configuration template is deployed. 

11. In the Access Right area, you can specify the access privilege to this deployment task for 
operator groups. When an operator group is selected, operators in the group can view and 
manage this task. Only administrators and the operator that creates the task can modify the 
attributes of the task.  

12. Click Next. 

The page updates to display the next stage in deploying a configuration file, Set Task 
Attribute. 

13. Enter a name for this task in the Task Name field. 

14. Select the type of deployment schedule you want to apply to this task from the Schedule Type 
list. Options include Once and Cycle. Select Once if you want IMC to execute this task one 
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time. Select Cycle if you want this configuration deployment task to be executed on a 
scheduled basis. 

15. If you select Once in the Schedule Type field, select the time you want IMC to execute this task 
from the Schedule Time list: Immediately or Scheduled. If you select Scheduled, click the 
field to populate the date and time for the execution of this task. 

16. If you select Cycle from the Schedule Type list, complete the following steps: 

a. Select the frequency with which you want IMC to execute this task from the Operation 
Frequency list: Every Day, Every Week or Every Month. 

b. Select the day of the week or date of the month you want IMC to execute this task from the 
list next to the Operation Frequency list. 

c. Enter the time you want IMC to execute this task in the field to the far right of the Operation 
Frequency list. Enter the time in HH:MM:SS format where HH denotes a two digit hour 
value, MM denotes a two digit minute value and SS denotes a two digit second value. 

d. Enter the beginning date and time you want IMC to execute this task in the Start Time field 
or click the Calendar icon  to populate the date and time for the execution of this task. 

e. Enter the ending date and time you want IMC to execute this task in the End Time field or 
click the Calendar icon  to populate the date and time for the execution of this task. 

17. Select how you want IMC to execute the deployment of configuration files to every device in the 
deployment task from the Schedule Sequence list: Concurrent and Sequential. If you select 
Concurrent, IMC executes the deployment to multiple devices simultaneously. If you select 
Sequential, IMC deploys the configuration file to one device at a time.  

18. If you select Sequential from the Schedule Sequence list, you can define the order IMC uses 
to deploy the selected configuration file or segment.  

To define the deployment order for devices: 

a. Click Sort next to the Schedule Sequence list. The Sort window opens. 

b. Select the devices you want to move. 

c. Sort the devices. 

 Click Up to move the devices up in the list. 

 Click Down to move the devices down in the list. 

 Click Top to move the devices to the top of the list. 

 Click Bottom to move the devices to the bottom of the list. 

 Click OK when you have finished sorting the devices in the list. 

19. If you select Sequential from the Schedule Sequence list, you can define how you want IMC 
to handle errors that arise in the deployment process.  

 If you want IMC to abandon the deployment for all devices if an error arises during 
deployment, select Stop Deployments on All Devices from the Error Handling list.  

 If you want IMC to abandon deployment for the device IMC is currently deploying the 
configuration file or segment to, select Stop Deployment on the Current Device from the 
Error Handling list. 

20. Enter a description for this deployment task in the Task Description field. 

21. Click Next. 

The page updates to display the Abstract page, the final step in deploying a configuration file. 
This page provides a summary of the configuration options you selected for this deployment 
task. Review the information on this page carefully to ensure that the configured deployment 
meets your needs. 

22. To view the contents of the configuration file you have selected for deployment, click View icon 

 in the Configuration Content field of the Deploy Device section of this page. 
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The configuration file or segment template is displayed in the View Configuration Content 
dialog box. Review the content to ensure this is the configuration file or segment you want to 
deploy.  

Click Close when you have finished reviewing the configuration template contents. 

23. Click Finish to accept your changes and submit the deployment task to IMC. 

The page is updated to display the Deployment Task page. The Deployment Task List 
displayed on this page contains the deployment task you submitted.  

Review the Status-Operation Result field for a status update on the deployment task you 
submitted. The contents of the Status-Operation Result field serve as a link to the View 
Execution Result page that provides deployment details for every device. 

The View Execution Result page contains details about the deployment task for every device. 
For deployment tasks that failed or were partially successful, click the Status-Operation 
Result link to view the View Execution Result details that include causes for deployment 
failures. 

24. Click Refresh to refresh the page with a new status update.  

For more information about the Deployment Task page and list, see "Managing deployment tasks." 

Deploying software 
You can deploy system software to devices by using the Deployment Guide's step-by-step software 
deployment wizard. This wizard includes several checkpoints to ensure the successful deployment 
of software to selected devices. 

To deploy software by using IMC Deployment Guide, the software to be deployed must first exist in 
the software library. For more information about uploading files to IMC software library, see 
"Managing the software library." 

To deploy system software: 

1. Navigate to Service > Deployment Guide. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Deployment Guide under Configuration Center on the left navigation tree. 

2. Click Deploy Software from the Select a Deployment Task section of the Deployment Guide 
page. 

3. To select the software you want to deploy, click Select next to the Software field in the Select 
Deployed Software section of the page. 

The Choose Software dialog box opens. 

4. Select the software filename you want to deploy. 

5. Click OK. 

The software file must exist in IMC software library before you can deploy it. To upload files to 
the software library, see "Managing the software library." 

The Applicable Devices field of the Software List displays all device models that are 
supported by the associated file. Review the Applicable Devices information before selecting 
the devices in which you plan to deploy the selected software. 

6. To select the Boot ROM you want to deploy, click Select next to the Boot ROM field. 

The Choose Boot ROM dialog box opens. 

7. Select the Boot ROM version you want to deploy to the left of the Boot ROM file name you want 
to deploy. 

8. Click OK. 

9. To select the devices to which the software or Boot ROM file is deployed, click Select Device 
located in the Devices for Deployment section of the page. 
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The Select Devices dialog box opens. 

10. Add devices either By View or by using the Advanced query option.  

For more information, see "Adding devices by view" and "Adding devices by advanced query." 

Confirm that the devices are displayed in the Devices for Deployment area. 

11. Define the directory to save the software file in the Save Directory on Device field for every 
device selected for software deployment. 

Select the directory location from the list in the Save Directory on Device field, or click Modify 
next to the list, enter the name of the directory you want to save the file to in the Save Directory 
on Device field in the popup Modify Save Directory on Device window, and click OK. 

12. Review software version check results in the Check Result field of the Check Device Space 
list for every device you have selected to ensure a successful software deployment. 

 If IMC was able to evaluate the software and determine that it is a valid match for the 
selected device, the contents of the Check Result field contain the message:  

Software: Check succeeded. 

 If the select software is lower than the current version running on the selected device, the 
contents of the Check Result field contain the message:  

Software: The version is lower than the current version running on device. 

 If IMC was unable to evaluate the software and determine a valid match between the 
selected device and the software, the contents of the Check Result field contain the 
message: Software: The version could not be evaluated.  

 If the software version does not match the selected device type, the contents of the Check 
Result field contain the message:  

Software: The version does not match the device type. 

 If the select software is already running on the selected device, but the feature version is 
inconsistent, the contents of the Check Result field contain the message:  

Software: The version is currently running on device, but feature version is 
inconsistent. 

 If the select software is already running on the selected device, but the patch version is 
inconsistent, the contents of the Check Result field contain the message: 

Software: The version is currently running on device, but patch version is 
inconsistent. 

 If the select software is already running on the selected device, the contents of the Check 
Result field contain the message:  

Software: The version is currently running on the device. 
 

 CAUTION: 

If the software being deployed has the same name as a file that already exists on the device, the file 
being deployed overwrites the file on the device. 
 

 

 NOTE: 

 Software updates apply to full releases and patch releases. 

 Software can be still deployed to devices that failed the version check. 

 Software cannot be deployed to devices that are not supported by this feature or on devices that 
failed communication. 

 

13. Configure the following settings as needed in the Deploy Strategy section: 

 Use Only ISSU to Upgrade Software—As a best practice, click the option for devices 
running the Comware V7 software, so that you can upgrade software for the devices by 
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using InService Software Upgrade (ISSU). For other devices, if you click the option, the 
deployment will fail. 

 Preferentially Use ISSU to Upgrade Software—Select this option if you want to 
preferentially use ISSU to upgrade software for the devices. If the upgrade fails, the default 
way of upgrading will be used. 

 Set the Current Running Software as Backup Startup Software—Select this option if 
you want to back up the current system software as startup software on the selected 
devices. 

 Delete Current Running Software—Select this option if you do not want to retain the 
current running software on the selected devices. The current running software is deleted 
when the deployment task starts. To select this option, you must first deselect the first 
option, Set the Current Running Software as Backup Startup Software. 

 

 CAUTION: 

Use the Delete Current Running Software option with caution. With this option selected, IMC 
deletes the current running software of devices even if the deployment task fails. If the deployment 
task fails, the devices may not restart. 
 

 Delete Current Backup Startup Software—Select this option if you want to delete the 
current startup software backup from the selected devices. The startup software backup is 
deleted when the deployment task begins. 

 Restart Device after Deployment—Select this option if you want to reboot the selected 
devices after the software has been deployed. 

 Check Device Space—Select this option if you want to check whether the disk has enough 
free space for the Save Directory. IMC does not deploy software on devices that do not 
have enough disk space. As a best practice, select this option. This option does not take 
effect on HPE devices. 

14. Click Next. 

15. If the Check Device Space option is selected, review the results in the Check Result field for 
each selected device in the list to verify that there is sufficient device space on every device. 

 If the contents of the Check Result field contain the result Sufficient device space, you 
can deploy the selected software to the device without modifying your deployment strategy 
selections or the device. 

 If the contents of the Check Result field contain the result  Insufficient device space, 
you need to remove files from the device to reclaim space by using the Clean Device Space 
feature. To access this feature, click the Clean Device Space link located in the Check 
Result field. For more information about using the Clean Device Space option, see 
"Cleaning device space." 

16. Click Next. 

The page updates to display the next stage in deploying software, Set Task Attribute. 

17. Enter a name for this task in the Task Name field. 

18. Select the time you want IMC to execute this task from the Schedule Time list. Options include 
Immediately and Scheduled. 

19. If you select Scheduled, click the Calendar icon  next to the Schedule Time field to 
populate the date and time for the execution of this task. A popup calendar is displayed. Select 
the date from the calendar. Alternatively, you can enter the date and time manually. Valid date 
and time format for this entry is YYYY-MM-DD hh:mm:ss where YYYY denotes the four digit 
year, MM denotes the two digit month, DD denotes the two digit day and hh denotes the two 
digit hour, mm denotes the two digit minute and ss denotes the two digit second value. 

20. Select how you want IMC to execute the deployment of software to every device in the 
deployment task from the Schedule Sequence list:  

 Concurrent—IMC executes the deployment to multiple devices simultaneously. 
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 Sequential—IMC deploys the configuration file to one device at a time. 

21. If you select Sequential from the Schedule Sequence list, you can define the order IMC uses 
to deploy the select software.  

To define the deployment order for devices: 

a. Click Sort next to the Schedule Sequence list. The Sort window opens. 

b. Select the devices you want to move. 

c. Sort the devices. 

 Click Up to move the devices up in the list. 

 Click Down to move the devices down in the list. 

 Click Top to move the devices to the top of the list. 

 Click Bottom to move the devices to the bottom of the list. 

d. Click OK when you have finished sorting the devices in the list. 

22. If you select Sequential from the Schedule Sequence list, you can define how you want IMC 
to handle errors that arise in the deployment process.  

 If you want IMC to abandon the deployment for all devices if an error arises during 
deployment, select Stop Deployments on All Devices from the Error Handling list.  

 If you want IMC to abandon deployment for the device IMC is currently deploying the 
configuration file or segment to, select Stop Deployment on the Current Device from the 
Error Handling list. 

23. Enter a description for this deployment task in the Task Description field. 

24. Click Next. 

The page updates to display the Abstract page, the final step in deploying a system software 
file. This page provides a summary of the configuration options you select for this deployment 
task. Review the information on this page carefully to ensure that the configured deployment 
meets your needs. 

25. Click Finish to accept your changes and submit the deployment task to IMC. 

The page is updated to display the Deployment Task page. The Deployment Task List 
displayed on this page contain the deployment task you submitted.  

Review the Status-Operation Result field for a status update on the deployment task you 
submitted. The contents of the Status-Operation Result field serve as a link to the View 
Execution Result page that provides deployment details for every device. 

The View Execution Result page contains details about the deployment task for every device. 
For deployment tasks that failed or were partially successful, click the Status-Operation 
Result link to view the View Execution Result details that include causes for deployment 
failures. 

26. Click Refresh to refresh the page with a new status update.  

For more information about the Deployment Task page and list, see "Managing deployment tasks."  

Deploying a file 
You can deploy other file types to select devices. As with deployments for system software, the 
Deployment Guide provides a step-by-step wizard for configuring the deployment of the select file. 
This wizard also includes several checkpoints to ensure the successful deployment of the select file. 

To deploy files by using IMC's Deployment Guide, the file to be deployed must already exist in the 
software library. For more information about uploading files to IMC's software library, see "Managing 
the software library." 

To deploy a file: 

1. Navigate to Service > Deployment Guide. 
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a. Click the Service tab from the top tabular navigation system.  

b. Click Configuration Center on the left navigation tree. 

c. Click Deployment Guide under Configuration Center on the left navigation tree. 

2. Click Deploy File (Other Files) from the Select a Deployment Task section of the 
Deployment Guide page. 

3. To select the file you want to deploy, click Select next to the Device Software field in the 
Select the file and device section of the page. 

The Select Software dialog box opens. 

4. Select the software file you want to deploy to the left of the software filename you want to 
deploy. 

5. Click OK. 

The software file must exist in the software library before you can deploy it. To upload files to 
IMC's software library, see "Managing the software library." 

6. To select the devices to which the file is deployed, click Select Device located in the Device 
List section of the page. 

The Select Devices dialog box opens. 

7. Add devices either By View or by using the Advanced query option.  

For more information, see "Adding devices by view" and "Adding devices by advanced query." 

Confirm that the devices now are displayed in the Device List.  

8. Define the directory to save the software file in the Save Directory on Device field for every 
device select for software deployment. 

Select the directory location from the list in the Save Directory on Device field, or click Modify 
next to the list, enter the name of the directory you want to save the file to in the Save Directory 
on Device field, in the popup Modify Save Directory on Device window, and click OK. 

9. Click Next. 

The page updates to display the Check Device Space page. IMC evaluates the device space 
requirements of the select software against the available device space on each of the selected 
devices and display the results in the Check Result field of the Check Device Space page. 
Review the Check Result field for each select device in the list to verify that there is sufficient 
device space for every device. 

 If the contents of the Check Result field contain the result Sufficient device space, you 
can deploy the select software to the device without modifying your deployment strategy 
selections or the device. 

 If the contents of the Check Result field contain the result  Insufficient device space, 
you need to remove files from the device to reclaim space by using the Clean Device 
Space feature. To access this feature, click the Clean Device Space link located in the 
Check Result field. For more information about using the Clean Device Space option, see 
"Cleaning device space." 

10. Click Next. 

The page updates to display the next stage in deploying a configuration file, Set Task 
Attribute. 

11. Enter a name for this task in the Task Name field. 

12. Select the time you want IMC to execute this task from the Schedule Time list. Options include 
Immediately and Scheduled. 

13. If you select Scheduled, click the Calendar icon  next to the Schedule Time field to 
populate the date and time for the execution of this task. A popup calendar is displayed. Select 
the date from the calendar. Alternatively, you can enter the date and time manually. Valid date 
and time format for this entry is YYYY-MM-DD hh:mm:ss where YYYY denotes the four digit 
year, MM denotes the two digit month, DD denotes the two digit day and hh denotes the two 
digit hour, mm denotes the two digit minute and ss denotes the two digit second value. 
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14. Select how you want IMC to execute the deployment of files to every device in the deployment 
task from the Schedule Sequence list: Concurrent and Sequential. If you select Concurrent, 
IMC executes the deployment to multiple devices simultaneously. If you select Sequential, IMC 
deploys the file to one device at a time.  

15. If you select Sequential from the Schedule Sequence list, you can define the order IMC uses 
to deploy the select file.  

To define the deployment order for devices: 

a. Click Sort next to the Schedule Sequence list. The Sort window opens. 

b. Select the devices you want to move. 

c. Sort the devices. 

 Click Up to move the devices up in the list. 

 Click Down to move the devices down in the list. 

 Click Top to move the devices to the top of the list. 

 Click Bottom to move the devices to the bottom of the list. 

d. Click OK when you have finished sorting the devices in the list. 

16. If you select Sequential from the Schedule Sequence list, you can define how you want IMC 
to handle errors that arise in the deployment process.  

 If you want IMC to abandon the deployment for all devices if an error arises during 
deployment, select Stop Deployments on All Devices from the Error Handling list.  

 If you want IMC to abandon deployment for the device IMC is currently deploying the 
configuration file or segment to, select Stop Deployment on the Current Device from the 
Error Handling list. 

17. Enter a description for this deployment task in the Task Description field. 

18. Click Next. 

The page updates to display the Abstract page, the final step in deploying a file. This page 
provides a summary of the configuration options you select for this deployment task. Review 
the information on this page carefully to ensure that the configured deployment meets your 
needs. 

19. Click Finish to accept your changes and submit the deployment task to IMC. 

The page is updated to display the Deployment Task page. The Deployment Task List 
displayed on this page contain the deployment task you submitted.  

Review the Status-Operation Result field for a status update on the deployment task you 
submitted. The contents of the Status-Operation Result field serve as a link to the View 
Execution Result page that provides deployment details for every device. 

The View Execution Result page contains details about the deployment task for every device. 
For deployment tasks that failed or were partially successful, click the Status-Operation 
Result link to view the View Execution Result details that include causes for deployment 
failures. 

20. Click Refresh to refresh the page with a new status update.  

For more information about the Deployment Task page and list, see "Managing deployment tasks." 

Restoring a device configuration 
IMC Deployment Guide also provides a step-by-step wizard for restoring a device's configuration. 

To restore configuration files: 

1. Navigate to Service > Deployment Guide. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Configuration Center on the left navigation tree. 
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c. Click Deployment Guide under Configuration Center on the left navigation tree. 

2. Click Restore Device Configuration from the Select a Deployment Task section of the 
Deployment Guide page. 

3. To select the devices you want to restore a configuration file to, click Select Device. 

The Select Devices dialog box opens. 

4. Add devices either By View or by using the Advanced query option. 

For more information, see "Adding devices by view" and "Adding devices by advanced query." 

Confirm that the devices now are displayed in the Select Devices for Update list. 

5. Review configuration check results in the Check Result field. IMC evaluates that a startup 
configuration file exists and that it can be deployed to the target device. 

 If the contents of the Check Result field contain the result Check Passed, you can 
restore the select configuration file to the device. 

 If the contents of the Check Result field contain the result Check Failed, contact 
Technical Support. 

6. Select which configuration file you want to restore from the Restore To list displayed in the 
Restore To field of the Select Device for Update list. 

7. To select the type of configuration file you want to restore, select it from the File Type to be 
Deployed list. 

8. Configure the following settings as needed in the Deploy Strategy section: 

 Backup the current startup configuration file of the device—Select this option if you 
want to back up the startup configuration of the file before restoring the startup configuration 
file. 

 Restart device after deployment—Select this option if you want to reboot the selected 
devices after the select configuration file has been restored. 

9. In the Access Right area, you can specify the access privilege to this deployment task for 
operator groups. When an operator group is selected, operators in the group can view and 
manage this task. Only administrators and the operator that creates the task can modify the 
attributes of the task. 

10. Click Next. 

The page updates to display the next stage in deploying a configuration file, Set Task 
Attribute. 

11. Enter a name for this task in the Task Name field. 

12. Select the type of restoration schedule you want to apply to this task from the Schedule Type 
list. Options include Once and Cycle. Select Once if you want IMC to execute this task one 
time. Select Cycle if you want this configuration restoration task to be executed on a scheduled 
basis. 

13. If you select Once in the Schedule Type field, select the time you want IMC to execute this task 
from the Schedule Time list: Immediately or Scheduled. If you select Scheduled, click the 
Calendar icon  to populate the date and time for the execution of this task. 

14. If you select Cycle from the Schedule Type list, complete the following steps: 

a. Select the frequency with which you want IMC to execute this task from the Operation 
Frequency list: Every Week or Every Month. 

b. Select the day of the week or date of the month you want IMC to execute this task from the 
list next to the Operation Frequency list. 

c. Enter the time you want IMC to execute this task in the field to the far right of the Operation 
Frequency list. Enter the time in HH:MM:SS format where HH denotes a two digit hour 
value, MM denotes a two digit minute value and SS denotes a two digit second value. 

d. Enter the beginning date and time you want IMC to execute this task in the Start Time field 
or click the Calendar icon  to populate the date and time for the execution of this task. 
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e. Enter the ending date and time you want IMC to execute this task in the End Time field or 
click the Calendar icon  to populate the date and time for the execution of this task. 

15. Select how you want IMC to execute the restoration of configuration files to every device in the 
restoration task from the Schedule Sequence list: Concurrent and Sequential. If you select 
Concurrent, IMC executes the restoration to multiple devices simultaneously. If you select 
Sequential, IMC restores the configuration file to one device at a time.  

16. If you select Sequential from the Schedule Sequence list, you can define the order IMC uses 
to restore the select configuration file or segment.  

To define the deployment order for devices: 

a. Click Sort next to the Schedule Sequence list. The Sort window opens. 

b. Select the devices you want to move. 

c. Sort the devices. 

 Click Up to move the devices up in the list. 

 Click Down to move the devices down in the list. 

 Click Top to move the devices to the top of the list. 

 Click Bottom to move the devices to the bottom of the list. 

d. Click OK when you have finished sorting the devices in the list. 

17. If you select Sequential from the Schedule Sequence list, you can define how you want IMC 
to handle errors that arise in the restoration process.  

 If you want IMC to abandon restoration for all devices if an error arises during restoration, 
select Stop Deployments on All Devices from the Error Handling list.  

 If you want IMC abandon restoration for the device to which IMC is currently restoring the 
configuration file or segment, select Stop Deployment on the Current Device from the 
Error Handling list. 

18. Enter a description for this deployment task in the Task Description field. 

19. Click Next. 

The page updates to display the next stage in restoring a configuration file, Abstract. This page 
provides a summary of the configuration options you select for this restoration task. Review the 
information on this page carefully to ensure that the configuration meets your needs. 

To view the contents of the configuration file you have selected for restoration, click the View 

icon  in the Configuration Content field of the Deploy Device section of this page. 

The configuration file or segment template is displayed in the Configuration Content dialog 
box. Review the content to ensure that this is the configuration file or segment template you 
want to restore. Click Close when you have finished reviewing the configuration template 
contents. 

20. Click Finish to accept your changes and submit the deployment task to IMC. 

The page is updated to display the Deployment Task page. The Deployment Task List 
displayed on this page contain the deployment task you submitted.  

Review the Status-Operation Result field for a status update on the task you submitted. The 
contents of the Status-Operation Result field serve as a link to the View Execution Result 
page that provides restoration details for every device. 

The View Execution Result page contains details about the deployment task for every device. 
For tasks that failed or were partially successful, click the Status-Operation Result link to view 
the View Execution Result details that include causes for deployment failures. 

21. Click Refresh to refresh the page with a new status update.  

For more information about the Deployment Task page and list, see "Managing deployment tasks." 
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Restoring device software 
IMC's Deployment Guide provides a step-by-step wizard for restoring device system software. 

To restore system software: 

1. Navigate to Service > Deployment Guide. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Deployment Guide under Configuration Center on the left navigation tree. 

2. Click Restore Device Software from the Select a Deployment Task section of the 
Deployment Guide page. 

The Select the Device for Update and the Software Version page of the deployment wizard 
opens. 

3. To select the devices to which software is deployed, click Select Device located in the Devices 
for Deployment section of the page. 

The Select Devices dialog box opens. 

4. Add devices either By View or by using the Advanced query option.  

Confirm that the devices now are displayed in the Devices for Deployment list. 

5. Select the software version you want to update from the list in the Update Version field for 
every device you have selected. 

6. Define the directory to save the software file in the Save Directory on Device field for every 
device selected for software deployment. 

Select the directory location from the list in the Save Directory on Device field, or click Modify 
next to the list, enter the name of the directory you want to save the file to in the Save Directory 
on Device field in the popup Modify Save Directory on Device window, and click OK. 

7. Review software version check results in the Check Result field of the Check Device Space 
list for every device you have selected to ensure a successful software deployment. 

 If IMC was unable to evaluate the software and determine a valid match between the 
selected device and the software, the contents of the Check Result field contain the 
message:  

Software: The version could not be evaluated.  
 

 NOTE: 

Software can be still deployed on devices that failed the version check. Software cannot be 
deployed to devices that are not supported by this IMC feature or on devices that failed 
communication. 
 

 If IMC was able to evaluate the software and determine that it is a valid match for the 
selected device, the contents of the Check Result field contain the message:  

Software: Check succeeded. 

 If the software version does not match the device type and therefore cannot be deployed to 
the device, the contents of the Check Result field contain the message:  

Software: The version does not match the device type. 

 If the select software is already running on the selected device, the contents of the Check 
Result field contain the message:  

Software: The version is currently running on the device. 
 

 CAUTION: 

If the software being deployed has the same name as a file that already exists on the device, the file 
being deployed overwrites the file on the device. 
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 If the select software is lower than the current version running on the selected device, the 
contents of the Check Result field contain the message:  

Software: The version is lower than the current version running on device. 

8. Configure the following settings as needed in the Deploy Strategy section: 

 Set the Current Running Software as Backup Startup Software—Select this option if 
you want to back up the current system software as startup software on the selected 
devices. 

 Delete Current Running Software—Select this option if you do not want to retain the 
current running software on the selected devices. The current running software is deleted 
when the deployment task starts. To select this option, you must first deselect the first 
option, Set the Current Running Software as Backup Startup Software. 

 

 CAUTION: 

Use the Delete Current Running Software option with caution. With this option select, IMC deletes 
the current running software of devices even if the deployment task fails. If the deployment task 
fails, the devices may not restart. 
 

 Delete Current Backup Startup Software—Select this option if you want to delete the 
current startup software backup from the selected devices. The startup software backup is 
deleted when the deployment task begins. 

 Restart Device after Deployment—Select this option if you want to reboot the selected 
devices after the software has been deployed. 

9. Click Next. 

IMC evaluates the device space requirements of the select software against the available 
device space on each of the selected devices. Review software version check results in the 
Check Result field for each select device in the list to verify that there is sufficient device space 
for every device.  

 If the contents of the Check Result field contain the result Sufficient device space, you 
can deploy the select software to the device without modifying your deployment strategy 
selections or the device. 

 If the contents of the Check Result field contain the result  Insufficient device space, 
you need to remove files from the device to reclaim space by using the Clean Device 
Space feature. To access this feature, click the Clean Device Space link located in the 
Check Result field. For more information about using the Clean Device Space option, see 
"Cleaning device space." 

10. Click Next. 

The page updates to display the next stage in deploying a configuration file, Set Task 
Attribute. 

11. Enter a name for this task in the Task Name field. 

12. Select the time you want IMC to execute this task from the Schedule Time list. Options include 
Immediately and Scheduled. 

13. If you select Scheduled, click the Calendar icon  next to the Schedule Time field to 
populate the date and time for the execution of this task. A popup calendar is displayed. Select 
the date from the calendar. Alternatively, you can enter the date and time manually. Valid date 
and time format for this entry is YYYY-MM-DD hh:mm:ss where YYYY denotes the four digit 
year, MM denotes the two digit month, DD denotes the two digit day and hh denotes the two 
digit hour, mm denotes the two digit minute and ss denotes the two digit second value. 

14. Select how you want IMC to execute the deployment of software to every device in the 
deployment task from the Schedule Sequence list: Concurrent and Sequential. If you select 
Concurrent, IMC executes the deployment to multiple devices simultaneously. If you select 
Sequential, IMC deploys the configuration file to one device at a time.  
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15. If you select Sequential from the Schedule Sequence list, you can define the order IMC uses 
to deploy the select file.  

To define the deployment order for devices: 

a. Click Sort next to the Schedule Sequence list. The Sort window opens. 

b. Select the devices you want to move. 

c. Sort the devices. 

 Click Up to move the devices up in the list. 

 Click Down to move the devices down in the list. 

 Click Top to move the devices to the top of the list. 

 Click Bottom to move the devices to the bottom of the list. 

d. Click OK when you have finished sorting the devices in the list. 

16. If you select Sequential from the Schedule Sequence list, you can define how you want IMC 
to handle errors that arise in the deployment process.  

 If you want IMC to abandon the deployment for all devices if an error arises during 
deployment, select Stop Deployments on All Devices from the Error Handling list.  

 If you want IMC to abandon deployment for the device IMC is currently deploying the 
configuration file or segment to, select Stop Deployment on the Current Device from the 
Error Handling list. 

17. Enter a description for this deployment task in the Task Description field. 

18. Click Next. 

The page updates to display the Abstract page, the final step in deploying a system software 
file. This page provides a summary of the configuration options you select for this deployment 
task. Review the information on this page carefully to ensure that the configured deployment 
meets your needs. 

19. Click Finish to accept your changes and submit the software deployment task to IMC. 

The page is updated to display the Deployment Task page. The Deployment Task List 
displayed on this page contain the deployment task you submitted.  

Review the Status-Operation Result field for a status update on the deployment task you 
submitted. The contents of the Status-Operation Result field serve as a link to the View 
Execution Result page that provides deployment details for every device. 

The View Execution Result page contains details about the deployment task for every device. 
For deployment tasks that failed or were partially successful, click the Status-Operation 
Result link to view the View Execution Result details that include causes for deployment 
failures. 

20. Click Refresh to refresh the page with a new status update.  

For more information about the Deployment Task page and list, see "Managing deployment tasks." 

Deploying OAP software 
You can deploy the OAP software to devices by using a step-by-step software deployment wizard of 
the Deployment Guide. This wizard includes several checkpoints to ensure the successful 
deployment of software to selected devices. 

To deploy OAP software by using IMC Deployment Guide, the OAP software to be deployed must 
first exist in IMC software library. For more information about uploading files to IMC software library, 
see "Managing the software library." 

To deploy OAP software to selected devices: 

1. Navigate to Service > Deployment Guide. 

a. Click the Service tab from the top tabular navigation system. 
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b. Click Configuration Center on the left navigation tree. 

c. Click Deployment Guide under Configuration Center on the left navigation tree. 

2. Click Deploy OAP Software from the Select a Deployment Task section of the Deployment 
Guide page. 

3. To select the software you want to deploy, click Select next to the OAP Software field in the 
Select Deployed Software section of the page. The Choose Software dialog box opens.  

4. Select the software file you want to deploy to the left of the software filename you want to 
deploy. 

5. Click OK. 

The OAP software file must exist in IMC's software library before you can deploy it. To upload 
files to IMC's software library, see "Managing the software library." 

The Applicable Devices field of the Software List displays all device models that are 
supported by the associated file. Review the Applicable Devices information before selecting 
the devices to which you plan to deploy the selected software. 

6. To select the devices to which the OAP software is deployed, click Select Device located in the 
Devices for Deployment section of the page. The Select Devices dialog box opens. 

7. Add devices either By View or by using the Advanced query option.  

For more information, see "Adding devices by view" and "Adding devices by advanced query." 

Confirm that the devices now are displayed in the Devices for Deployment list. 

8. Review software version check results in the Check Result field for every device you have 
selected to ensure a successful software deployment. 

 If IMC was able to evaluate the software and determine that it is a valid match for the 

selected device, the contents of the Check Result field contain the message Check 
succeeded. 

 If the selected software is lower than the current version running on the selected device, the 
contents of the Check Result field contain the message The version is lower than the 
current version running on device. 

 If IMC was unable to evaluate the software and determine a valid match between the 
selected device and the software, the contents of the Check Result field contain the 
message The version could not be evaluated.  

 If the software version does not match the selected device type, the contents of the Check 
Result field contain the message The version does not match the device type. 

 If the selected software is already running on the selected device, the contents of the Check 
Result field contain the message The version is currently running on the device. 

 CAUTION: 

If the OAP software being deployed has the same name as a file that already exists on the device, 
the file being deployed overwrites the file on the device. 
 

 NOTE: 

 OAP Software updates apply only to full releases. IMC does not deploy OAP software for patch 
releases. 

 OAP software that failed the version check can still be deployed to devices. 

 OAP software cannot be deployed to devices that are not supported by this feature or failed in 
communication. 

 

9. Click Next. 

The page updates to display the next stage in deploying software, Set Task Attribute. 

10. Enter a name for this task in the Task Name field. 
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11. Select the time you want IMC to execute this task from the Schedule Time list. Options include 
Immediately and Scheduled. 

12. If you select Scheduled, click the Calendar icon  next to the Schedule Time field to 
populate the date and time for the execution of this task. A popup calendar is displayed. Select 
the date from the calendar. Alternatively, you can enter the date and time manually. Valid date 
and time format for this entry is YYYY-MM-DD HH:MM:SS where YYYY denotes the four digit 
year, the first MM denotes the two digit month, DD denotes the two digit day and HH denotes 
the two digit hour, the second MM denotes the two digit minute, and SS denotes the two digit 
second value. 

13. Select how you want IMC to execute the deployment of software to every device in the 
deployment task from the Schedule Sequence list: Concurrent and Sequential. If you select 
Concurrent, IMC executes the deployment to multiple devices simultaneously. If you select 
Sequential, IMC deploys the configuration file to one device at a time.  

14. If you select Sequential from the Schedule Sequence list, you can define the order IMC uses 
to deploy the selected software.  

To define the deployment order for devices: 

a. Click Sort next to the Schedule Sequence list. The Sort window opens. 

b. Select the devices you want to move. 

c. Sort the devices. 

 Click Up to move the devices up in the list. 

 Click Down to move the devices down in the list. 

 Click Top to move the devices to the top of the list. 

 Click Bottom to move the devices to the bottom of the list. 

d. Click OK when you have finished sorting the devices in the list. 

15. If you select Sequential from the Schedule Sequence list, you can define how you want IMC 
to handle errors that arise in the deployment process.  

 If you want IMC to abandon the deployment for all devices if an error arises during 
deployment, select Stop Deployments on All Devices from the Error Handling list.  

 If you want IMC to abandon deployment for the device IMC is currently deploying the 
software to, select Stop Deployment on the Current Device from the Error Handling list. 

16. Enter a description for this deployment task in the Task Description field. 

17. Click Next. 

The page updates to display the Abstract page, the final step in deploying an OAP software 
file. This page provides a summary of the configuration options you select for this deployment 
task. Review the information on this page carefully to ensure that the deployment task 
configuration meets your needs. 

18. Click Finish to accept your changes and submit the software deployment task to IMC. 

The page is updated to display the Deployment Task page. The Deployment Task List 
displayed on this page contains the deployment task you just submitted.  

Review the Status--Operation Result field for a status update on the deployment task you 
submitted. The contents of the Status--Operation Result field serve as a link to the View 
Execution Result page, which provides per device details. 

The View Execution Result page contains details about the deployment task for every device. 
For deployment tasks that failed or were partially successful, click the Status-Operation 
Result link to view the View Execution Result details that include causes for deployment 
failures. 

19. Click Refresh to refresh the page with a new status update.  

For more information about the Deployment Task page and list, see "Managing deployment tasks." 
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Managing deployment tasks 
The Deployment Task management feature provides visibility into the status of configuration and 
software deployment tasks in IMC. Through the Deployment Task portal, you can view the current 
status of configuration and software deployments submitted by using the Deployment Guide. From 
the Deployment Task portal, you can drill down into the step-by-step details for every device in a 
deployment task and identify which devices failed a deployment and why.  

From the same portal, you can suspend and resume configuration and software deployments and 
re-run failed or partially successful deployment tasks. From the same Deployment Task page, you 
can also modify a failed or partially successful deployment task and re-run it.  

Lastly, you can copy a deployment task, make changes to it and resubmit it to the deployment task 
list.  

Accessing the deployment task list 
1. Navigate to Service > Deployment Task. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Deployment Task under Configuration Center on the left navigation tree.  

The Deployment Task page opens. All deployment tasks are displayed in the list in the bottom 
half of the Deployment Task page.  

Deployment task list 

 Status--Operation Result—Contains the results of the deployment task. The contents of 
this field serve as a link to the View Execution Result page for the associated deployment 
task. For more information about the View Execution Result page, see the section 
describing the Execution Result Page in this manual. 

 Task Name—Contains the name of the deployment task. The contents of this field serve as 
a link to the View Task Detail Information page. The View Task Detail Information page 
provides details about the deployment task, including the basic task information, 
deployment strategy, and devices configured in the deployment task. 

You can configure the task name when using the Deployment Guide to deploy a 
configuration or software file. Otherwise, IMC provides a default task name that includes a 
date and time stamp for uniquely identifying deployment tasks. 

 Task Sub Type—Identifies what type of deployment task was executed. Options include: 

 Deploy Device Configuration 

 Deploy Software 

 Deploy File 

 Restore Device Configuration from NMS 

 Restore Device Configuration from Device 

 Restore Software 

 Schedule Type—Identifies whether or not the deployment task is a recurring or cyclical 
task or a task that was run once. 

 Creator—Identifies the creator of the deployment task. 

 Last Begin Time—Contains the date and time stamp of the start time of the associated 
deployment task's execution. 

 Next Begin Time—Contains the date and time stamp of the start time of the associated 
deployment task's next cycle of execution. This field is blank if the Schedule Type is Once. 
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 Modify—IMC lets you modify the attributes of a deployment task for those tasks that have 

the status "For Executing". This field contains a Modify icon  for navigating to the page 
for modifying the associated task. 

 Copy—Contains a Copy icon  for navigating to the page for copying the associated 
task. 

You can sort the Deployment Task List by the Status—Operation Result, Task Name, Task 
Sub Type, Schedule Type, Creator, Last Begin Time, and Next Begin Time fields. Click the 
column label to sort the list by the selected field. The column label is a toggle switch that lets 
you toggle between the various sort options specific to each field.  

If the Deployment Task List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Deployment Task List. 

 Click  to page forward to the end of the Deployment Task List. 

 Click  to page backward in the Deployment Task List. 

 Click  to page backward to the front of the Deployment Task List. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

Searching for a deployment task 
IMC provides the ability to search for a particular deployment task from the Deployment Task page.  

To search the Deployment Task List:  

1. Navigate to Service > Deployment Task. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Deployment Task under Configuration Center on the left navigation tree.  

The Deployment Task page opens. The query conditions for searching the Deployment Task 
List are displayed in the upper portion of the page. 

2. Enter a task name in the field in the upper right corner of the Deployment Task page, and click 

the Search icon , or click the Advanced icon  located in the upper right corner of the 
page. 

The search criteria dialog box opens. 

3. Enter one or more of the following search criteria in the Query Condition section of the page:  

 Task Name—Enter the name of the deployment task to be searched. 

 Creator—Enter the creator of the deployment task to be searched. 

 Task Type—Select the task type from the Task Type list. 

 Task Sub Type—Select the task sub type from the Task Sub Type list. 

 Task Status—Select the task status from the Task Status list. 

 Operation Result—Select the operation result for which you want to search from the 
Operation Result list. 

4. Click Query to submit your filter criteria. 

The results of your filter or search query are displayed in the Deployment Task List below. 

5. Click Reset when you want to restore the full Deployment Task List. 
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Viewing execution result page 
IMC displays the deployment task results for every device configured in the task in the Execution 
Result page. This page provides the cause of deployment failures and information for each step in 
the deployment process for every device. 

To view the results for a deployment task: 

1. Navigate to Service > Deployment Task. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Deployment Task under Configuration Center on the left navigation tree. 

The Deployment Task page opens. All deployment tasks are displayed in the list in the bottom 
half of the Deployment Task page.  

2. Click the Status--Operation Result link for the deployment task for which you want to view 
results. 

The View Execution Result page opens. All deployment tasks are displayed in the list in the 
bottom half of the Deployment Task page.  

Execution Results 

 Device Name—Contains the name of the device to which a deployment was executed. 

 Start Time on Device—Contains the start time of the deployment task. 

 End Time on Device—Contains the end time of the deployment task. 

 Execution Status—Identifies whether or not the deployment task has been completed. 

 Operation Result—Identifies whether or not the deployment to the associated device was 
successful. 

 Details—Contains a link for viewing the details for every step in the deployment process for 
the associated device. The Details page provides information on failures in the deployment 
process. 

 View Change—Contains a link for comparing the changes that were made to the 
associated device. On the Select Device for Update page that is used to deploy device 
configurations, if you select Running Configuration in the File Type to be Deployed field, 

the following options are displayed. Click the checkbox  to the left of the View the 
change before and after deployment option. After the deployment task is complete, you 
see View Change in the View Execution Result page. 

Modifying a deployment task 
By using the Modify option of the Deployment Task page, you can change the parameters of a 
failed or partially successful deployment task and resubmit it to the deployment task queue for 
processing. For a task whose sub type is Deploy Device Configuration, Deploy Device Software, 
Restore Device Configuration, or Restore Device Software, you can re-select the device, 
configuration template, and software to be deployed. 

To modify a deployment task: 

1. Navigate to Service > Deployment Task. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Deployment Task under Configuration Center on the left navigation tree.  

The Deployment Task page opens. The query conditions for searching the Deployment Task 
List are displayed in the upper portion of the page. 

2. Click the Modify icon  of the deployment task you want to modify. 
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3. Perform the following operations according to the task sub type: 

 If the Task Sub Type is Deploy Device Configuration, the Deploy Configuration page 
opens. For information about the operations on the page, see "Deploying a device 
configuration." In these steps, do not modify the Task Name in step 15. 

 If the Task Sub Type is Deploy Device Software, the Deploy Software page opens. For 
more information about the operations on the page, see "Deploying software." In these 
steps, do not modify the Task Name in step 20. 

 If the Task Sub Type is Restore Device Configuration, the Restore Device 
Configuration page opens. For information about operations on the page, see "Restoring a 
device configuration." In these steps, do not modify the Task Name in step 13. 

 If the Task Sub Type is Restore Device Software from NMS or Restore Device Software 
from Device, the Deploy Software page opens. For information about operations on the 
page, see "Restoring device software." In these steps, do not modify the Task Name in step 
14. 

 If the Task Sub Type is any other value, go to step 7. 

4. Select the type of deployment schedule you want to apply to this task from the Schedule Type 
list. Options include Once and Cycle. Select Once if you want IMC to execute this task one 
time. Select Cycle if you want this configuration deployment task to be executed on a 
scheduled basis. 

5. If you select Once in the Schedule Type field, complete the following steps: 

a. Select the time you want IMC to execute this task from the Schedule Time list. Options 
include Immediately and Scheduled. If you select Immediately, go to step 13. 

b. If you select Scheduled, click the Calendar icon  to populate the date and time for the 
execution of this task. A popup calendar is displayed. Select the date from the calendar. Go 
to step 13. 

6. If you select Cycle from the Schedule Type list, complete the following steps: 

a. Select the frequency with which you want IMC to execute this task from the Operation 
Frequency list. 

b. If you select Every Week from the Operation Frequency list, select the day of the week 
you want IMC to execute this task from the list next to the Operation Frequency list. 

c. If you select Every Month from the Operation Frequency list, select the date of the month 
you want IMC to execute this task from the list next to the Operation Frequency list. 

7. Enter the time you want IMC to execute this task in the field to the far right of the Operation 
Frequency list. Enter the time in HH:MM:SS format where HH denotes a two digit hour value, 
MM denotes a two digit minute value and SS denotes a two digit second value. 

8. Enter the beginning date and time you want IMC to execute this task in the Start Time field. 
Click the Calendar icon  to populate the date and time for the execution of this task. A popup 
calendar is displayed. Select the start date from the calendar. 

9. Enter the ending date and time you want IMC to execute this task in the End Time field. Click 
the Calendar icon  to populate the date and time for the execution of this task. A popup 
calendar is displayed. Select the end date from the calendar. 

10. Select how you want IMC to execute the deployment of configuration files to every device in the 
deployment task from the Schedule Sequence list. Two options are available: Concurrent 
and Sequential. If you select Concurrent, IMC executes the deployment to multiple devices 
simultaneously. If you select Sequential, IMC deploys the configuration file to one device at a 
time.  

11. If you select Sequential from the Schedule Sequence list, you can also define the order in 
which IMC uses to deploy the selected configuration file or segment as follows.  

12. Click Sort next to the Schedule Sequence list. The Sort dialog box opens. 

13. Click the checkbox  to the left of the devices you want to move. 

14. Do one of the following: 
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 Click Up to move the devices up in the list. 

 Click Down to move the devices down in the list. 

15. Do one of the following: 

 Click Top to move the devices to the top of the list.  

 Click Bottom to move the device to the bottom of the list. 

16. Click OK when you have finished sorting the devices in the list. 

17. If you select Sequential from the Schedule Sequence list, you can also define how you want 
IMC to handle errors that arise in the deployment process. If you want IMC to abandon the 
deployment for all devices if an error arises during deployment, select Stop Deployments on 
All Devices from the Error Handling list. If you want IMC to abandon deployment for the 
device IMC is currently deploying the configuration file or segment to, select Stop Deployment 
on the Current Device from the Error Handling list. 

18. Modify the description for this deployment task in the Task Description field. 

19. Click OK to accept your changes to the deployment task. The page is updated to display the 
Deployment Task page. The Deployment Task List displayed on this page contains the 
modified deployment task you just submitted.  

Review the Status--Operation Result field for a status update on the deployment task you 
submitted. The contents of the Status--Operation Result field serve as a link to the View 
Execution Result page, which provides per device details.  

The View Execution Result page contains details about the deployment task for every device. 
For deployment tasks that failed or were partially successful, click the Status--Operation 
Result link to view the View Execution Result details that include causes for deployment 
failures. 

20. Click Refresh to refresh the page with a new status update.  

Copying a deployment task 
The copy option lets you leverage the existing configuration of a deployment task and make any 
changes to it through the Deployment Guide before resubmitting it to the Deployment Task List. 
For more information about using the Deployment Guide to configure deployment tasks, see 
"Deploying configurations and software by using IMC deployment guide." 

Running a deployment task 
You can re-run deployment tasks that failed or have been suspended.  

To re-run a failed or suspended deployment task:  

1. Navigate to Service > Deployment Task. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Deployment Task under Configuration Center on the left navigation tree.  

The Deployment Task page opens. The query conditions for searching the Deployment Task 
List are displayed in the upper portion of the page. 

2. Click the checkbox  to the left of the deployment task you want to run. 

3. Click Run.  

The Deployment Task page is updated to reflect the results of the deployment task.  

4. Click Refresh to refresh the page with a new status update. 

5. Review the Status--Operation Result field for a status update on the deployment task you 
submitted. The contents of the Status--Operation Result field serve as a link to the View 
Execution Result page.  
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The View Execution Result page contains details about the deployment task for every device. 
For deployment tasks that failed or were partially successful, click Status-Operation Result to 
view the View Execution Result details that include causes for deployment failures. 

Suspending a deployment task 
IMC provides you with the ability to suspend a deployment task that is in progress. 

To suspend a deployment task that is in progress: 

1. Navigate to Service > Deployment Task. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Deployment Task under Configuration Center on the left navigation tree. 

The Deployment Task page opens. The query conditions for searching the Deployment Task 
List are displayed in the upper portion of the page. 

2. Click the checkbox  to the left of the deployment task you want to suspend. Deployment 
tasks that are in progress contain the Waiting for Executing--Unfinished in the 
Status--Operation Result field. 

3. Click Suspend. 

The Status--Operation Result field is updated to include the status Suspended--Unfinished. 

4. To complete the task, use the resume feature.  

Resuming a deployment task 
IMC provides you with the ability to resume a suspended deployment task. 

To resume a suspended deployment task: 

1. Navigate to Service > Deployment Task. 

a. Click Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Deployment Task under Configuration Center on the left navigation tree. 

The Deployment Task page opens. The query conditions for searching the Deployment Task 
List are displayed in the upper portion of the page. 

2. Select the deployment task you want to resume. Deployment tasks that have been suspended 
contain Suspended > Unfinished in the Status > Operation Result field of the associated 
deployment task. 

3. Click Resume. 

The Status > Operation Result field is updated to include the status Waiting for Executing > 
Unfinished. 

4. Click Refresh to refresh the page with a new status update. 

5. Review the Status > Operation Result field for a status update on the deployment task you 
submitted. The contents of the Status > Operation Result field serve as a link to the View 
Execution Result page. 

The View Execution Result page contains details about the deployment task for every device. 
For deployment tasks that failed or were partially successful, click the Status > Operation 
Result link to view the View Execution Results details that include causes for deployment 
failures. 
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Deleting a deployment task 
You can also delete a task from the Deployment Task List.  

To delete a deployment task from the Deployment Task List: 

1. Navigate to Service > Deployment Task: 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Deployment Task under Configuration Center on the left navigation tree.  

The Deployment Task page opens. The query conditions for searching the Deployment Task 
List are displayed in the upper portion of the page. 

2. Select the deployment tasks you want to delete.  

3. Click Delete. 

4. Click OK to confirm deletion of the selected deployment tasks. The Deployment Task page is 
updated to reflect the status of the deletion request. Review the results to ensure the successful 
removal of deployment tasks. 

Managing automatic deployment plans 
IMC provides a facility for automatic executions of software upgrade, startup configuration 
deployment, CLI script execution, and configuration backup for devices with zero or simple 
configurations. With the Auto Deployment Plan feature, you can quickly configure devices in a batch 
to operate properly without manual intervention.  

An auto deployment plan is a set of automatic deployment operations that the network administrator 
defines for devices according to the network plan. IMC displays automatic deployment plans in a 
nested table. The external table shows information about each automatic deployment plan, including 
the plan name, creator, creation time, and the execution status of each device in the plan. The 
internal table shows information about automatic deployment devices, including the MAC address, 
current IP address, target IP address, mask, and operating status. As for automatic deployment 
plans,  

IMC provides the functions of adding, deleting, modifying, and viewing automatic deployment plans. 
As for automatic deployment devices, IMC provides the functions of adding, deleting, modifying, 
viewing, and importing automatic deployment devices, triggering deployment, and viewing automatic 
deployment execution results. 

An initial configuration file in IMC is deployed on a zero-configuration device through DHCP after the 
device is powered on. The initial configuration file must contain basic SNMP and Telnet parameters. 
After the zero-configuration device executes the initial configuration file, IMC automatically adds the 
device through auto discovery and apply a pre-configured automatic deployment plan to it. 

Automatic deployment plans can be triggered for the following devices:  

 Zero-configuration devices that are powered on and automatically added to IMC. Before 
powering on a zero-configuration device, the network administrator must configure on the 
DHCP server the address pool, gateway, DNS server, domain name, TFTP server for IMC, 
initial configuration file name, and timeout period. 

 Simple-configuration devices that were not managed by IMC and are now added to IMC 
manually or through auto discovery. 

 Simple-configuration devices that have been added to IMC. 
 

 NOTE: 

Only operators with administrative level privileges can manage automatic deployment plans. 
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With the Auto Deployment Plan feature, you can schedule configuration files and software to be 
automatically deployed on one or more devices.  

Accessing the automatic deployment plan page 

IMC provides a list of all automatic deployment plans in the Auto Deployment Plan page, in which 
you can add, view, modify, or delete automatic deployment tasks. 

To access the page of automatic deployment plans: 

1. Navigate to Service > Auto Deployment Plan. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Configuration Center on the left navigation tree. 

c. Click Auto Deployment Plan under Configuration Center on the left navigation tree. 

All existing automatic or scheduled deployment plans are displayed in the Auto Deployment 
Plan page. 

Auto Deployment Plan 

 Created by—Identifies the person who created the deployment plan. 

 Created at—Displays when the deployment plan was created. 

 Being Executed—Displays the number of devices on which the deployment plan is being 
executed. 

 Not Executed—Displays the number of devices on which the deployment plan has not 
been executed. 

 Successfully Deployed—Displays the number of devices on which the deployment plan 
has been successfully executed. 

 Failures—Displays the number of devices on which the deployment plan failed to be 
executed. 

 Operation—Contains the following icons for managing the deployment plan: 

 This icon  adds devices for the deployment plan. 

 This icon  imports devices for the deployment plan. 

 This icon  views the execution result of the deployment plan. 

 This icon  modifies basic information for the deployment plan. 

 This icon  deletes the deployment plan. 

2. Select the Undeployed Devices Only box above the list to display only the devices on which 
the deployment plan has not been deployed. 

3. Click the icon  with the deployment plan you want to expand.  

When the Undeployed Devices Only box is not selected, all existing devices in the 
deployment plan are displayed. When the Undeployed Devices Only box is selected, only the 
devices on which the deployment plan has not been deployed are displayed. 

Automatic deployment device list 

 MAC Address—Displays the MAC address of the device. 

 Current IP Address—Displays the current IP address of the device. 

 Target IP Address/Mask—Displays the IP address and mask of the device after the 
deployment plan is successfully executed on it. 

 Running Status—Contains the execution result of the deployment plan on the device. 

 Operation—Contains the following icons for managing the deployment device: 

 — Allows you to modify the deployment information for the device. 

 —Allows you to view detailed information about the deployment plan on the device. 
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 —Allows you to view the execution result of the deployment plan on the device. 

 — Allows you to manually trigger a deployment plan on the device. 

 —Allows you to delete the device. 

Adding an automatic deployment plan 

1. Navigate to Service > Auto Deployment Plan. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Configuration Center on the left navigation tree. 

c. Click Auto Deployment Plan under Configuration Center on the left navigation tree. 

All existing automatic or scheduled deployment plans are displayed in the Auto Deployment 
Plan page. 

2. Click Add. 

The Auto Deployment Plan dialog box opens. 

3. Enter a unique name for this deployment plan in the Name field.  

Valid name length is 1–32 characters. 

4. Enter a brief description for this deployment plan in the Description field.  

Valid description length is 0–128 characters. 

5. Click OK to accept your deployment plan configuration. 

Review the results of the add operation in the Auto Deployment Plan page. 

Modifying an automatic deployment plan 

1. Navigate to Service > Auto Deployment Plan. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Configuration Center on the left navigation tree. 

c. Click Auto Deployment Plan under Configuration Center on the left navigation tree. 

All existing automatic deployment plans is displayed in the Auto Deployment Plan page. 

2. Click the Modify icon  in the Operation field associated with the deployment plan you want 
to modify.  

The Auto Deployment Plan dialog box opens. 

You cannot modify the name of a deployment plan once you have created it. You must delete 
the existing deployment plan and create a new deployment plan with the new name. 

3. Modify the description for this deployment plan in the Description field.  

Valid description length is 0–128 characters. 

4. Click OK to accept your deployment plan configuration changes. 

5. Review the results of the modify operation in the Auto Deployment Plan page. 

Deleting an automatic deployment plan 

1. Navigate to Service > Auto Deployment Plan. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Configuration Center on the left navigation tree. 

c. Click Auto Deployment Plan under Configuration Center on the left navigation tree. 

All existing automatic deployment plans is displayed in the Auto Deployment Plan page. 

2. Click the Delete icon  in the Operation field associated with the deployment plan you want 
to delete.  
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You cannot delete an automatic deployment plan containing devices on which automatic 
deployment is being executed 

3. Click OK to confirm deletion of the deployment plan. 

4. Review the results of the delete operation in the Auto Deployment Plan page. 

Viewing detailed information about an automatic deployment device 

To view detailed information about an automatic deployment device in the existing automatic 
deployment plan: 

1. Navigate to Service > Auto Deployment Plan. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Configuration Center on the left navigation tree. 

c. Click Auto Deployment Plan under Configuration Center on the left navigation tree. 

All existing automatic deployment plans are displayed in the Auto Deployment Plan page. 

2. Click the Expand icon  with the deployment plan you want to expand.  

All existing devices in the deployment plan are displayed. 

3. Click the Details icon  in the Operation field associated with the device you want to view. 

The Auto Deployment Device dialog box is displayed, and shows detailed information about 
the automatic deployment device, including the configuration file to deploy, software to deploy, 
CLI script, device basic information, device information, and access parameters. 

Adding an automatic deployment device 

You can configure the following parameters on the device to which an automatic deployment device 
is deployed: configuration file to deploy, software to deploy, CLI script, device information, and 
access parameters.  

After you add a device to an automatic deployment plan, the iCC component configures the device in 
the following workflow:  

 Determines whether the device has been added to IMC and adds the device to IMC if not 
already included.  

 Deploys the following items in the deployment plan to the device in turn: software (optional), 
configuration file, and CLI script (optional), and backs up the device configuration (optional). 

To add a device to an automatic deployment plan: 

1. Navigate to Service > Auto Deployment Plan. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Configuration Center on the left navigation tree. 

c. Click Auto Deployment Plan under Configuration Center on the left navigation tree. 

All existing automatic deployment plans are displayed in the Auto Deployment Plan page. 

2. Click the Add device icon  in the Operation field associated with the deployment plan for 
which you want to add a device.  

The Add Auto Deployment Device page opens. 

3. Select the configuration file folder that contains the configuration file you want to deploy from 
the Folder list of the Configuration File to Deploy section. 

4. Select the configuration file name you want to deploy from the File Name list of the 
Configuration File to Deploy section. 

You must add or import configuration files in the Configuration Templates list before selecting 
the configuration file name. Once you have added or imported the configuration files, they are 
displayed in the File Name list. 

5. Do one of the following: 
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 If you want IMC to back up the configurations of this device, select Yes in the Back Up 
Configuration File field of the Configuration File to Deploy section. 

 Select No if you do not. 

6. Do one of the following: 

 If the configuration file content includes variables, enter the parameters of the configuration 
file in the Please input parameter field of the Configuration File to Deploy section 

 If not, go to step 7. 

7. Do one of the following: 

 If you want to deploy software to this device, click the checkbox  to the left of Software to 
Deploy of the Software to Deploy section, and then go to step 8. 

 If you do not, go to step 10. 

8. Select the software name you want to deploy from the Software Name list of the Software to 
Deploy section. 

9. Configure the following settings as needed in the Software Deployment Policy section: 

 Set the Current Running Software as Backup Startup Software—Select this option if 
you want to back up the current system software as startup software on this device.  

 Delete Current Running Software—Select this option if you do not want to retain the 
current running software on this device. The current running software is deleted when the 
deployment plan begins. To select this option, you must first deselect the first option, Set 
the Current Running Software as Backup Startup Software. 

 

 CAUTION: 

If you select the Delete Current Running Software option, IMC deletes the current running 
software of the device even if the deployment plan fails. If the deployment plan fails, the device 
might not restart. Exercise this option with caution. 
 

 Delete Current Backup Startup Software—Select this option if you want to delete the 
current startup software backup from this device. The startup software backup is deleted 
when the deployment plan begins. 

10. Do one of the following: 

 If you want to deploy the CLI script to this device, select CLI Script in the CLI Script 
section, and then go to step 11. 

 If you do not, go to step 14. 

11. Select the CLI script file folder that contains the CLI script file you want to deploy from the 
Folder list of the CLI Script section. 

12. Select the CLI script file name you want to deploy from the File Name list of the CLI Script 
section. 

You must add CLI script files in the Configuration Templates list before selecting the CLI 
script file name. Once you have added the CLI script files, they are displayed in the File Name 
list. 

13. Do one of the following: 

 If the CLI script file content includes variables, enter the parameters of the CLI script file in 
the Please input parameter field of the CLI Script section. 

 If not, go to step 14. 

14. Enter the MAC address for this device in the Match Criteria: MAC Address field of the Device 
Basic Information section. 

15. Enter the current IP address for this device in the Match Criteria: Current IP Address field of 
the Device Basic Information section. 
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You should enter at least one of the match criteria. To match a zero-configuration device, enter 
the MAC address. To match a device that has been added to IMC, enter its MAC address, 
current IP address, or both. 

16. Enter the target IP address for this device in the Target IP Address field of the Device Basic 
Information section. 

17. If you want to assign a stack member ID to a zero-configuration device, select Stack Member 
ID, and enter the stack member ID. 

 

 CAUTION: 

You can assign stack member IDs only to the zero-configuration devices. Otherwise, automatic 
deployment can fail. 
 

18. Do one of the following: 

 If you want to configure device information, click the checkbox  to the left of Configure 
Device Information of the Configure Device Information section, and then go to step 19. 

 If you do not, go to step 25. 

19. Enter a device label for this device in the Device Label field of the Configure Device 
Information section. 

 Device Label—Enter the name for the device you want to add. 

20. Select the device group to which you want to add this device from the Device Group list of the 
Configure Device Information section. 

You must create device groups before you can add devices to them. Once you have created the 
device groups, they are displayed in the Device Group list. 

21. Select the login type for this device from the Login Type list of the Configure Device 
Information section. 

 Login Type—Select the type that IMC uses to log in to the device from the Login Type list. 
Options include Telnet, SSH, and None. 

This parameter does not take effect on a device that has been added to IMC. 

22. If you want IMC to process traps sent by this device for alarming and notification purposes, 
verify that the checkbox to the left of Automatically register to receive SNMP traps from 
supported devices is checked . 

 

 IMPORTANT: 

If the Automatically register to receive SNMP traps from supported devices checkbox is not 
checked, IMC does not process, display, or alarm on traps sent by this device. 
 

23. If this device to be added responds to ping requests for monitoring reachability, verify that the 
checkbox  to the left of Support Ping Operation is checked. If this device does not respond 
to ping requests, verify that the checkbox is unchecked . 

24. To configure the device additional information, select the checkbox  next to Set Appended 
Information for Device and set the device additional information value. 

This option is available only when you have configured the device additional information. For 
more information about configuring device additional information, see "Device additional 
information." 

25. Do one of the following: 

 If the configuration file or CLI script to be deployed contains SNMP, Telnet, and SSH 
parameter modifications, modify the access parameters to keep them consistent with those 
in the configuration file or CLI script, so that IMC can access the device, and then go to step 
26. 

 If not, go to step 32. 

26. Do one of the following: 
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 If you want to configure the SNMP parameters for this device, click the checkbox  to the 
left of SNMP Settings of the Access Parameters section, and then go to step 27. 

 If you do not, go directly to step 28. 

27. To configure the SNMP settings for this device, click the Configure link  located at the 
SNMP Settings of the Access Parameters section. 

The SNMP Parameters dialog box opens. 

You can either enter the SNMP settings in this dialog box or select an existing SNMP template 
that contains the SNMP settings for this device. SNMP templates are particularly useful when 
SNMP configurations are standardized. For more information about creating SNMP templates, 
see "SNMP templates." 

Editing SNMP settings manually 

a. Verify that Edit SNMP Parameters is selected. 

b. Select the version of SNMP (v1 or v2c) that is configured on the device to be added from the 
Parameter Type list. 

c. You can only add devices that are configured with SNMPv3 using SNMP templates. You 
must create an SNMP template with the SNMPv3 parameters for this device before adding 
this device. For more information about creating SNMP templates, see "SNMP templates." 

d. Enter the read-only community string in the Read-Only Community String field. 

e. Enter the read-write community string in the Read-Write Community String field. 

f. Enter the SNMP timeout value (1–60 seconds) in the Timeout field. This parameter 
determines how long IMC waits for an SNMP reply from the managed device before 
declaring that the request has timed out. The default is 4. 

g. Enter the number of SNMP retries (1–20) in the Retries field. The retries parameter defines 
how many times the management system (IMC) sends SNMP retries in an attempt to 
communicate with the managed device before reporting a failure. The default is 3. 

Using existing SNMP templates 

a. Select Select an Existing Template. 

b. Select the SNMP template you want to use. 

c. Click OK to apply the SNMP parameters for this device. 

28. Do one of the following: 

 If you want to configure the telnet parameters for this device, click the checkbox  to the 
left of Telnet Settings of the Access Parameters section, and then go to step 29. 

 If you do not, go directly to step 30. 

29. To configure the Telnet settings for this device, click the Configure link  located at the 
Telnet Settings of the Access Parameters section. 

The Telnet Parameters dialog box opens. 

You can either enter the Telnet settings in this dialog box or select an existing Telnet template 
that contains the Telnet settings for this device. Telnet templates are particularly useful when 
Telnet configurations are standardized. For more information about creating Telnet templates, 
see "Telnet templates." 

Editing Telnet settings manually 

a. To edit the telnet parameters manually, verify that Edit Telnet Parameters is selected. 

b. Select the Telnet authentication mode from the Authentication Mode list. 

 Username—Enter the Telnet username in the Username field, if prompted. 

 Password—Enter the Telnet password in the Password field, if prompted. 

 Super Password—Enter the Telnet super password in the Super Password field, if 
prompted. 
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 Timeout—Enter the Telnet timeout value configured on the managed device in the 
Timeout field. Valid range is 1–60 seconds. 

Using existing Telnet templates 

a. To configure the Telnet settings for this device using Telnet templates, select Select an 
Existing Template. 

b. Select the Telnet template you want to use. 

c. Click OK to apply the Telnet configuration settings to this device. 

30. Do one of the following: 

 If you want to configure the SSH parameters for this device, click the checkbox  to the left 
of SSH Settings of the Access Parameters section. 

 If you do not, go directly to step 32. 

31. To configure the SSH settings for this device, click the Configure link  located at the SSH 
Settings of the Access Parameters section. 

The SSH Parameters dialog box opens. 

You can either enter the SSH settings in this dialog box or select an existing SSH template that 
contains the SSH settings for this device. SSH templates are useful when SSH configurations 
are standardized. For more information about creating SSH templates, see "SSH templates." 

Editing SSH settings manually 

To edit the SSH parameters, verify that Edit SSH Parameters is selected. 

 Authentication Mode—Select the authentication mode from the Authentication Mode 
list. The authentication mode selected must match the configuration on the managed 
devices. 

 User Name—Enter username in the User Name field. 

 Password—Enter the password in the Password field, if prompted. 

 Private Key File—Enter the path and filename of the private key file that contains the key 
that enables login, if prompted. 

 Private Key Password—Enter the private key password for the private key file, if 
prompted. 

 Port—Enter the TCP port for SSH in the Port field. The default TCP port is 22. 

 Timeout—Enter the SSH timeout value (1–120 seconds). The timeout parameter defines 
how long the system waits for the device to respond in seconds before declaring that the 
response has timed out. The default setting is 10 seconds. 

 Retries—Enter the number of SSH retries (1–5). The retries parameter defines how many 
times the management system (IMC) sends SSH retries in an attempt to communicate with 
the managed device before reporting a failure. The default setting is 3. 

Using existing SSH templates 

a. Select Select an Existing Template. 

b. Select the SSH template you want to use. 

c. Click OK to apply the SSH configuration settings to this device. 

32. Click OK to apply this device configuration. 

Review the results of the add operation in the Auto Deployment Plan page. 

Modifying an automatic deployment device 

1. Navigate to Service > Auto Deployment Plan. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Auto Deployment Plan under Configuration Center on the left navigation tree. 

All existing automatic deployment plans are displayed in the Auto Deployment Plan page.  
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2. Click the icon  with the deployment plan you want to expand.  

All existing devices in the deployment plan are displayed. 

3. Click the Modify icon  in the Operation field associated with the deployment device you 
want to modify. 

The Modify Auto Deployment Device page opens. 

4. Do one of the following: 

 If you want to modify the Configuration File to Deploy information, click the Modify link to 
the left of the Configuration File to Deploy section, and then go to step 9. 

 If you do not, go to "Modifying the software to deploy information." 

5. Select the configuration file folder that contains the configuration file you want to deploy from 
the Folder list of the Configuration File to Deploy section. 

6. Select the configuration file name you want to deploy from the File Name list of the 
Configuration File to Deploy section. 

7. Do one of the following: 

 If you want IMC to back up the configurations of this device, select Yes of the Back Up 
Configuration File field of the Configuration File to Deploy section. 

 Select No if you do not. 

8. If the configuration file content includes variables, enter the parameters of the configuration file 
in the Please input parameter field of the Configuration File to Deploy section. 

9. If not, go to "Modifying the software to deploy information." 

Modifying the software to deploy information 

To modify the Software to Deploy information: 

1. Do one of the following: 

 If you clicked the checkbox  to the left of Software to Deploy when this device was 
added, go to step 2. 

 If you want to deploy software to this device, click the checkbox  to the left of Software to 
Deploy, and then go to step 2. 

 If you do not want to deploy software to this device, click the checkbox  to the left of 
Software to Deploy, and then go to step 4. 

2. Select the software name you want to deploy from the Software Name list of the Software to 
Deploy section. 

3. Configure the following settings as needed in the Software Deployment Policy section: 

 Set the Current Running Software as Backup Startup Software—Select this option if 
you want to back up the current system software as startup software on this device.  

 Delete Current Running Software—Select this option if you do not want to retain the 
current running software on this device. The current running software is deleted when the 
deployment plan begins. To select this option, you must first deselect the first option, Set 
the Current Running Software as Backup Startup Software. 

 

 NOTE: 

If you select the Delete Current Running Software option, IMC deletes the current running 
software of the device even if the deployment plan fails. If the deployment plan fails, the device 
might not restart. Exercise this option with caution. 
 

 Delete Current Backup Startup Software—Select this option if you want to delete the 
current startup software backup from this device. The startup software backup is deleted 
when the deployment plan begins. 

4. Do one of the following: 
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 If you want to modify the CLI Script information, click the Modify link to the left of the CLI 
Script section, and then go to step 5. 

 If you do not, go to step 9. 

5. To modify the CLI Script information: 

 If you clicked the checkbox  to the left of CLI Script when this device was added, go to 
step 6. 

 If you want to deploy the CLI script to this device, click the checkbox  to the left of CLI 
Script, and then go to step 6. 

 If you do not want to deploy the CLI script to this device, click the checkbox  to the left of 
CLI Script, and then go to step 9. 

6. Select the CLI script file folder that contains the CLI script file you want to deploy from the 
Folder list of the CLI Script section. 

7. Select the CLI script file name you want to deploy from the File Name list of the CLI Script 
section. 

8. If the CLI script file content includes variables, enter the parameters of the CLI script file in the 
Please input parameter field of the CLI Script section. 

9. Do one of the following: 

 If you want to modify the Device Basic Information, go to step 10. 

 If not, go to step 14. 

10. Modify the MAC address for this device as needed in the Match Criteria: MAC address field of 
the Device Basic Information section. 

11. Modify the current IP address for this device as needed in the Match Criteria: Current IP 
address field of the Device Basic Information section. 

You should enter at least one of the match criteria. To match a zero-configuration device, enter 
the MAC address. To match a device that has been added to IMC, enter its MAC address, 
current IP address, or both 

12. Modify the target IP address for this device as needed in the Target IP Address field of the 
Device Basic Information section. 

13. If you want to modify the stack member ID for this device, enter the new stack member ID in the 
Stack Member ID field. 

 

 NOTE: 

You can assign stack member IDs only to the zero-configuration devices. Otherwise, auto 
deployment can fail. 
 

14. If you want to modify the Configure Device Information, see "Modifying the configure device 
information." 

Modifying the configure device information 

1. Do one of the following: 

 If you clicked the checkbox  to the left of Configure Device Information when this 
device was added, go to step 2. 

 If you want to configure this device information, click the checkbox  to the left of 
Configure Device Information, and then go to step 2. 

 If you do not want to configure this device information, click the checkbox  to the left of 
Configure Device Information, and then go to step 8. 

2. Modify the device label for this device in the Device Label field of the Configure Device 
Information section. 

3. Select the device group to which you want to modify this device from the Device Group list of 
the Configure Device Information section. 
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You must create device groups before you can modify devices in them. Once you have created 
the device groups, they are displayed in the Device Group list. 

4. Select the login type for this device from the Login Type list of the Configure Device 
Information section. 

This parameter does not take effect on a device that has been added to IMC. 

5. If you want IMC to process traps sent by this device for alarming and notification purposes, 
verify that the checkbox to the left of Automatically register to receive SNMP traps from 
supported devices is checked . 

 

 NOTE: 

If the Automatically register to receive SNMP traps from supported devices checkbox is not 
checked, IMC cannot process, display, or alarm on traps sent by this device. 
 

6. If this device to be modified responds to ping requests for monitoring reachability, verify that the 
checkbox  to the left of Support Ping Operation is checked.  

If this device does not respond to ping requests, verify that the checkbox is unchecked . 

7. To configure the device additional information, select the checkbox  next to Set Appended 
Information for Device and set the device additional information value. 

This option is available only when you have configured the device additional information. For 
more information about configuring device additional information, see "Device additional 
information." 

8. Do one of the following: 

 If you want to modify the Access Parameters, for information about the operations, see 
"Adding an automatic deployment device." The method of modifying the access parameters 
is the same as that described in "Adding an automatic deployment device." 

 If you do not, go to step 9. 

9. Click OK to complete the operation of modifying the automatic deployment device. 

Review the results of the modification operation in the Auto Deployment Plan page. 

Importing devices into an automatic deployment plan 

IMC provides you with the ability to batch import device information from a file to an automatic 
deployment plan. 

The file must be in CSV format. The first line in the file is the column headings, and all the other lines 
are the corresponding values. The following information describes these columns, as shown in Table 
46. 

Table 46 Columns in a CSV file 

Column heading  Description  Required  

TargetIp  
IP address of the device after the selected 
configuration file is deployed on the device.  Yes  

ConfigFile  
Name of the configuration file to be deployed on 
the device.  Yes  

ConfigPara  

Parameters in the configuration file to be 
deployed.  

The parameters are in the format of Parameter 
name1: Parameter value1; Parameter name2: 
Parameter value2; ...For example, ACLNumber: 
3005. 

No  

CurrentDeviceIp Current IP address of the device. Yes if the file does not contain 
the MACAddress column. 
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Column heading  Description  Required  

MACAddress MAC address of the device. 
Yes if the file does not contain 
the CurrentDeviceIp column. 

UnitId 
Stack member ID, ranging from 1 to 9. A value of 
–1 indicates that the stack feature is disabled on 
the device. 

No 

changDeviceInfo  

Indicates whether or not the device information is 
different from that in the existing configuration file 
on the device. The value can be:  
 0 for no 
 1 for yes 

No  

DeviceName  Device label.  No  

DeviceGroup  Device group.  No  

DeploySoft  Software to be deployed on the device.  No  

CLIScript  Name of the CLI script to be deployed on the 
device.  No  

CLIPara  

Parameters in the CLI script file to be deployed.  

The parameters are in the format of Parameter 
name1: Parameter value1; Parameter name2: 
Parameter value2; ...For example, ACLNumber: 
3005. 

No  

changSnmpPara  

Indicates whether or not the device's SNMP 
parameters are different from those in the existing 
configuration file on the device. The value can be: 
 0 for no 
 1 for yes 

No  

SnmpParaVersion  

SNMP version. The value can be:  
 1 for SNMPv1 
 2 for SNMPv2c 
 3 for SNMPv3 

No  

SnmpParaRead  Read-only community name, which is public by 
default and contains 32 characters at most.  No  

SnmpParaWrite  Read and write community name, which is private 
by default and contains 32 characters at most.  No  

SnmpParaSecurityUs
er  

Username, which applies to only SNMPv3 and 
contains 32 characters at most.  

A username corresponds to an SNMPv3 template 
name. 

No  

SnmpParaContextNa
me  

SNMPv3 context name, which contains 32 
characters at most.  No  

SnmpParaSecuMode  

Security mode. The value can be: 
 1 for no authentication and no encryption 
 2 for authentication and no encryption 
 3 for authentication and encryption 

The SnmpParaAuthScheme and 
SnmpParaPrivScheme columns must have the 
same value as this column. 

No  
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Column heading  Description  Required  

SnmpParaAuthSche
me  

Authentication mode. The value can be:  
 1 for none 
 2 for MD5 
 3 for SHA 

No  

SnmpParaAuthPass
word  

Authentication password, which contains 32 
characters at most.  No  

SnmpParaPrivSchem
e  

Encryption mode. The value can be:  
 1 for none 
 2 for DES 
 19 for AES128 
 21 for AES256 

No  

SnmpParaPrivPassw
ord  

Encryption password, which contains 32 
characters at most.  No  

SnmpParaTimeOut  Operation timeout period (in seconds), which is 4 
by default.  No  

SnmpParaRetry  Maximum number of SNMP retries allowed, which 
is 3 by default.  No  

PingDevType  

Indicates whether or not the ping operation is 
supported. The value can be:  
 1 for yes 
 0 for no 

No  

changTelnet  

Indicates whether or not the device's Telnet 
parameters are different from those in the existing 
configuration file on the device. The value can be:  
 0 for no 
 1 for yes 

No  

TelnetStyle  

Telnet type. The value can be:  
 0 for password 
 1 for username+password 
 2 for super password 
 3 for password+super password 
 4 for username+password+super password 
 5 for no username+no password 
 6 for username+no password 

No  

TelnetUseName  Telnet username.  No  

TelnetPassword  Telnet password.  No  

TelnetSuperWord  Telnet super password.  No  

TelnetTimeout  Telnet timeout period, ranging from 1 to 60 
seconds.  No  

changeSsh  

Indicates whether or not the device's SSH 
parameters are different from those in the existing 
configuration file on the device. The value can be:  
 0 for no 
 1 for yes 

No  

SshParaAuthType  
SSH authentication mode.  

The value can be 0 (for password authentication). 
Other authentication modes are not supported.  

No  
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Column heading  Description  Required  

SshParaPort  SSH port number.  No  

SshParaUserName  SSH username.  No  

SshParaPassword  SSH password.  No  

SshParaRetries  Maximum number of SSH retries allowed, ranging 
from 1 to 5.  No  

SshParaTimeOut  SSH timeout period, ranging from 1–120 
seconds.  No  

LoginType  

Login type. The value can be:  
 0 for none 
 1 for Telnet 
 2 for SSH 

No  

sendTrap  

Indicates whether or not the device sends traps to 
IMC. The value can be:  
 0 for no 
 1 for yes 

No  

delBackupSoftFlag  

Indicates whether or not the backup software is 
deleted. The value can be:  
 0 for no 
 1 for yes 

No  

delCurrSoftFlag  

Indicates whether or not the current software is 
deleted. The value can be:  
 0 for no 
 1 for yes 

No  

mainToBackupFlag  

Specifies whether or not the current software is 
backed up. The value can be:  
 0 for no 
 1 for yes 

No  

 

To import devices into an automatic deployment plan from a file on your local computer: 

1. Navigate to Service > Auto Deployment Plan. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Configuration Center on the left navigation tree. 

c. Click Auto Deployment Plan under Configuration Center on the left navigation tree. 

All existing automatic deployment plans are displayed in the Auto Deployment Plan page.  

2. Click the Import icon  in the Operation field associated with the deployment plan to which 
you want to import devices. 

The Import Auto Deployment Devices dialog box opens. 

3. Enter the file you want to import, including the full path in the Select Source File field. 

4. Alternatively, you can browse the file system of your local computer for the file you want to 
import. To browse, click Browse next to the Select Source File field. Follow the instructions 
provided by your browser for locating the file. 

5. Click Start Import to import the file. 

6. After the file is imported, click Close. 

7. Review the results of the import operation in the Auto Deployment Plan page. 
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Deleting a device from an automatic deployment plan 

To delete a device from an automatic deployment plan: 

1. Navigate to Service > Auto Deployment Plan. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Configuration Center on the left navigation tree. 

c. Click Auto Deployment Plan under Configuration Center on the left navigation tree. 

All existing automatic deployment plans are displayed in the Auto Deployment Plan page.  

2. Click the icon  with the deployment plan you want to expand.  

All existing devices in the deployment plan are displayed. 

3. Click the icon  in the Operation field associated with the deployment device you want to 
delete.  

You cannot delete an automatic deployment device on which automatic deployment is being 
executed. 

4. Click OK to confirm deletion of the deployment device. 

5. Review the results of the delete operation in the Auto Deployment Plan page. 

Triggering automatic deployment on devices 

You can trigger automatic deployment on devices that have not been deployed or failed to be 
deployed in the automatic deployment plan. This operation applies only to the simple-configuration 
devices that have been added to IMC. 

To trigger automatic deployment on devices: 

1. Navigate to Service > Auto Deployment Plan. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Configuration Center on the left navigation tree. 

c. Click Auto Deployment Plan under Configuration Center on the left navigation tree. 

All existing automatic deployment plans are displayed in the Auto Deployment Plan page.  

2. Click the icon  with the deployment plan you want to expand.  

All existing devices in the deployment plan are displayed. 

3. Click the icon  in the Operation field associated with the device on which you want to trigger 
automatic deployment.  

The system displays that the deployment process is successfully triggered 

Viewing automatic deployment execution results 

To view the execution result of an automatic deployment plan or device: 

1. Navigate to Service > Auto Deployment Plan. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Configuration Center on the left navigation tree. 

c. Click Auto Deployment Plan under Configuration Center on the left navigation tree. 

All existing automatic deployment plans are displayed in the Auto Deployment Plan page.  

2. Do one of the following, to view the result of an automatic deployment plan or device, 
respectively: 

 If you want to view the execution result of an automatic deployment plan, go to step 3. 

 If you want to view the execution result of an automatic deployment device, go to step 6. 

3. Click the icon  with the deployment plan for which you want to view the execution result in 
the Auto Deployment Plan page. 
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The Auto Deployment Execution Result dialog box is displayed, showing the automatic 
deployment execution result of the plan. 

4. Click the icon  with the device information you want to view. 

5. Click the icon  with the deployment plan you want to expand in the Auto Deployment Plan 
page.  

All existing devices in the deployment plan are displayed. 

6. Click the icon  in the Operation field associated with the deployment device for which you 
want to view the execution result.  

The Auto Deployment Execution Result dialog box is displayed, showing the automatic 
deployment execution result of the device. 

Managing the initial configuration file 
You can manage the pre-defined and user-defined initial configuration files. An initial configuration 
file in IMC is deployed on a zero-configuration device through DHCP after the device is powered on. 
The initial configuration file must contain basic SNMP and Telnet parameters. After the 
zero-configuration device executes the initial configuration file, IMC automatically adds the device 
through auto discovery and applies a pre-configured automatic deployment plan to it. 

Configuring the DHCP server 

IMC provides you with the automatic initial configuration function for zero-configuration devices. 
When a zero-configuration device or a simple-configuration device is connected to IMC and started 
up, the DHCP server assigns an IP address to the device and sends the TFTP server address and 
initial configuration file name to the device. The device then downloads the initial configuration file 
from the TFTP server to complete automatic configuration. 

Configure the address pool, network management system, DNS server, domain name, TFTP server 
address, initial configuration file name, and lease duration on the DHCP server. 

The following guidelines apply to configuration file management: 

 If the DHCP server and the device are not on the same network segment, configure a DHCP 
relay agent on the gateway that connects to the device. 

 If the DHCP server does not support configuring the TFTP server address, configure the DNS 
server address and domain name on the DHCP server. The TFTP server must have an IMC 
iCC component installed. 

 The initial configuration file configured on the DHCP server must be created in IMC and applies 
to the zero-configuration device to be deployed. 

Accessing the initial configuration file 

To access the page of initial configuration files: 

1. Navigate to Service > Auto Deployment Plan > Initial Configuration File Management.  

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Auto Deployment Plan under Configuration Center on the left navigation tree. 

2. Click Initial Configuration File Management located in the upper right corner of the Auto 
Deployment Plan page. 

All existing initial configuration files are displayed in the Initial Configuration File 
Management page. 

 File Name—Contains the name of the initial configuration file. 

 File Type—Identifies the type of the initial configuration file. Options include Pre-Defined 
and Self-Defined. 
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 Creation Time—Contains a date and time stamp for the creation of the initial configuration 
file. 

 Description—Contains a description for the initial configuration file. 

 Modify—Contains a link  for modifying the initial configuration file. 

 Copy—Contains a link  for copying the initial configuration file. 

 Delete—Contains a link  for deleting the initial configuration file. 

You can sort the Initial Configuration File List by the File Name Creation Time, and 
Description field. Click the column label to sort the list by the selected field. The column label is 
a toggle switch that lets you toggle between the various sort options specific to each field. 

If the Deployment Task List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Initial Configuration File Management list. 

 Click  to page forward to the end of the Initial Configuration File Management list. 

 Click  to page backward in the Initial Configuration File Management list. 

 Click  to page backward to the front of the Initial Configuration File Management list. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

Adding an initial configuration file 

1. Navigate to Service > Auto Deployment Plan > Initial Configuration File Management.  

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Auto Deployment Plan under Configuration Center on the left navigation tree. 

d. Click Initial Configuration File Management located in the upper right corner of the Auto 
Deployment Plan page. 

All existing initial configuration files are displayed in the Initial Configuration File 
Management page. 

2. Click Add. 

The Add Initial Configuration File page opens. 

3. Enter a unique name for this initial configuration file in the File Name field under the 
Configuration File section.  

Valid name length is 1–32 characters. 

4. Enter a brief description for this initial configuration file in the Description field under the 
Configuration File section.  

Valid description length is 0–128 characters. 

5. Do one of the following: 

 If you want to add this initial configuration file content in the File Content field, go to step 6. 

 If you want to add this initial configuration file content through an existing template, go to 
step 7. 

6. Enter the content for this initial configuration file in the File Content field under the 
Configuration File section, and then go to step 10. 

7. Click the Select Template link next to the File Content field under the Configuration File 
section. 

The Select Template dialog box opens 
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8. Select a template in the left of the Template Name field, and click . 

The selected template content is displayed in the Template Content field. 

9. Click OK to accept your template selected. 

When you add an initial configuration file content through an existing template, IMC 
automatically replaces the ${snmpv1_community_read}, ${snmpv1_community_write}, 
${telnet_user_name}, and ${telnet_password} variables in the template with the default 
settings in the Access Parameters section. 

10. Click OK to accept your configuration. 

11. Review the results of the add operation in the Initial Configuration File Management page. 

Modifying an initial configuration file 

1. Navigate to Service > Auto Deployment Plan > Initial Configuration File Management.  

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Auto Deployment Plan under Configuration Center on the left navigation tree. 

d. Click Initial Configuration File Management located in the upper right corner of the Auto 
Deployment Plan page. 

All existing initial configuration files are displayed in the Initial Configuration File 
Management page. 

2. Click the Modify icon  in the Modify field associated with the initial configuration file you 
want to modify. 

The Modify Initial Configuration File page opens. The pre-defined initial configuration file 
cannot be modified. You can modify the name of an initial configuration file once you have 
created it. You must delete the existing initial configuration file and create a new initial 
configuration file with the new name. 

3. Modify the brief description for this initial configuration file as needed in the Description field 
under the Configuration File section.  

Valid description length is 0–128 characters. 

4. Do one of the following: 

 If you want to modify this initial configuration file content in the File Content field, go to step 
5, or 

 If you want to modify this initial configuration file content through an existing template, go to 
step 6. 

5. Modify the content for this initial configuration file as needed in the File Content field under the 
Configuration File section, and then go to step 9. 

6. Click the Select Template link next to the File Content field under the Configuration File 
section. 

The Select Template dialog box opens. 

7. Select a template in the left of the Template Name field, and click . 

The selected template content is displayed in the Template Content field. 

8. Click OK to accept your template selected. 

9. Click OK to accept your configuration. 

10. Review the results of the modify operation in the Initial Configuration File Management page. 

Copying an initial configuration file 

Copying an initial configuration file allows you to re-use and modify an existing initial configuration 
file.  

To copy an existing initial configuration file: 
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1. Navigate to Service > Auto Deployment Plan > Initial Configuration File Management.  

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Auto Deployment Plan under Configuration Center on the left navigation tree. 

2. Click Initial Configuration File Management located in the upper right corner of the Auto 
Deployment Plan page. 

All existing initial configuration files are displayed in the Initial Configuration File 
Management page. 

3. Click the Copy icon  in the Copy field associated with the initial configuration file you want 
to copy. 

The Copy Initial Configuration File page opens. 

4. Rename the initial configuration file with a unique name in the File Name field. 

5. Modify the brief description for this initial configuration file as needed in the Description field 
under the Configuration File section.  

Valid description length is 0–128 characters. 

6. Do one of the following: 

 If you want to modify this initial configuration file content in the File Content field, go to step 
7. 

 If you want to modify this initial configuration file content through an existing template, go to 
step 8. 

7. Modify the content for this initial configuration file as needed in the File Content field under the 
Configuration File section, and then go to step 11. 

8. Click the Select Template link next to the File Content field under the Configuration File 
section. 

The Select Template dialog box opens. 

9. Select a template in the left of the Template Name field, and click . 

The selected template content is displayed in the Template Content field. 

10. Click OK to accept your template selected. 

11. Click OK to accept your configuration. 

12. Review the results of the copy operation in the Initial Configuration File Management page. 

Deleting an initial configuration file 

1. Navigate to Service > Auto Deployment Plan > Initial Configuration File Management.  

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Auto Deployment Plan under Configuration Center on the left navigation tree. 

d. Click Initial Configuration File Management located in the upper right corner of the Auto 
Deployment Plan page. 

All existing initial configuration files are displayed in the Initial Configuration File 
Management page. 

2. Do one of the following: 

 Select the initial configuration files you want to delete, and click Delete. 

 Click the icon  in the Delete field associated with the initial configuration files you want to 
delete. The pre-defined initial configuration file cannot be deleted. 

3. Click OK to confirm deletion of the initial configuration files. 

4. Review the results of the delete operation in the Initial Configuration File Management page. 
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Viewing detailed information of an initial configuration file 

1. Navigate to Service > Auto Deployment Plan > Initial Configuration File Management.  

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Auto Deployment Plan under Configuration Center on the left navigation tree. 

d. Click Initial Configuration File Management located in the upper right corner of the Auto 
Deployment Plan page. 

All existing initial configuration files are displayed in the Initial Configuration File 
Management page. 

2. Click the file name link in the File Name field with the initial configuration file you want to view. 

The View Initial Configuration File page is displayed, showing detailed information about the 
initial configuration file, including the file name, description, and file content. 

Managing automatic backup plans 
You can back up the configurations of network devices. With the Auto Backup Plan, you can 
schedule automated backups of configuration files for one or more devices. Backups can be 
scheduled to run every day, every week, or every month at a specified time. In addition, you can 
select one or more devices for automated backup. Or, with a single click of the mouse, you can 
configure a network-wide device configuration backup. 

By using the Backup History Report you gain visibility into the backup results for all backup tasks, 
including backups initiated manually and backups initiated through an auto backup plan.  

Once a backup task has been initiated, whether manual or scheduled, you can view the results in the 
Backup History Report. 

Storing device configuration backups in cipher text 
By default, iCC stores device configuration backups in plain text to the \server\data\cfgbak 
(/server/data/cfgbak for Linux) directory of the IMC installation path. The configuration backups can 
be viewed by any system user who has the privileges to the directory. To enhance security for the 
backups, you can configure IMC to store them in cipher text. 

To configure IMC to store device configuration backups in cipher text on Windows: 

1. Open the qvdm.conf file with WordPad in the \IMC\server\conf directory of the IMC installation 
path. 

2. Find the following parameter: 
#flag indicate if the configuration file is encrypt stored, 1: encrypt; 0, plain text 
#EncryptConfigFileFlag = 0 

3. Set the value of the EncryptConfigFileFlag parameter to 1: 
#EncryptConfigFileFlag = 1 

4. Save and close the file. 

5. Restart the IMC service. 

To configure IMC to store device configuration backups in cipher text on Linux: 

1. Open the qvdm.conf file with the vi editor in the /IMC/server/conf directory of the IMC 
installation path and press i to enter insert mode. 

2. Find the following parameter: 
#flag indicate if the configuration file is encrypt stored, 1: encrypt; 0, plain text 
#EncryptConfigFileFlag = 0 

3. Set the value of the EncryptConfigFileFlag parameter to 1: 
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#EncryptConfigFileFlag = 1 

4. Press Esc and then enter the wq command to save and close the file. 

5. Restart the IMC service. 

With the configuration, IMC starts to store device configuration backups in cipher text. 

The configuration does not encrypt existing configuration backups. 

If IMC is deployed in distributed mode, modify the qvdm.conf file only on the servers that are 
deployed with the iCC component. 

Configuring automatic device backups 
IMC provides the ability to schedule daily, weekly, or monthly backups of one or more devices. 

Accessing the automatic backup plan list 

IMC provides you with a list of all auto backup plans in the Auto Backup Plan List. This list provides 
you with the ability to add, view, modify, or delete scheduled backup tasks. 

To access the list of automatic or scheduled backup plans: 

1. Navigate to Service > Auto Backup Plan. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Auto Backup Plan under Configuration Center on the left navigation tree. 

All existing automatic or scheduled backup plans are displayed in the Auto Backup Plan 
List.  

Auto backup plan list  

 Name—Contains the operator defined name for this scheduled backup plan. 

 Description—Contains the description for this backup plan provided by the creator. 

 Configuration Type—Identifies whether or not the backup plan is a network wide 
backup plan or an auto backup plan that includes a list of one or more network devices 
for backup. 

 Backup History—Contains a link for accessing a filtered view of the Backup History 
Report for the selected backup plan. 

 Status—Identifies whether or not the associated backup plan is enabled or disabled. 

 Modify—Contains an Modify icon  for navigating to the page for modifying the 
associated backup plan. 

You can sort the Auto Backup Plan List by the Name, Description, and Configuration 
Type fields. Click the column label to sort the list by the selected field. The column label is a 
toggle switch that allows you to toggle between the various sort options specific to each 
field. 

If the Auto Backup Plan List spans multiple pages, use the following aids to navigate the 
list: 

 Click  to page forward in the Auto Backup Plan List. 

 Click  to page forward to the end of the Auto Backup Plan List. 

 Click  to page backward in the Auto Backup Plan List. 

 Click  to page backward to the front of the Auto Backup Plan List. 
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2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

Adding an automatic backup plan 

To add a scheduled backup plan that runs automatically: 

1. Navigate to Service > Auto Backup Plan. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Auto Backup Plan under Configuration Center on the left navigation tree. 

All existing automatic or scheduled backup plans are displayed in the Auto Backup Plan 
List.  

2. Click Add. 

The Set Auto Backup Attribute page opens. 

3. Enter a unique name for this backup plan in the Name field.  

Valid name length is 1-32 characters. 

4. Select the frequency with which you want this backup to run from the Operation Frequency 
list.  

Options include Every Day, Every Week, and Every Month. 

5. Enter the time of day that you want the backup to run in the field next to the Operation 
Frequency list.  

Valid time entry is HH:MM:SS where HH denotes the two digit hour value, MM denotes the two 
digit minute value and SS denotes the two digit second value.  

6. Enter a brief description for this backup plan in the Description field.  

Valid description length is 0-128 characters. 

7. Set whether to send the report of the auto back plan to the designated mail recipient. Options 
are: 

 Not send report of auto backup plan—Do not send any report. This is the default setting. 

 Send report of auto backup plan only when backup fails—Send the report only when 

backup of one or more devices fails.  

 Send report of auto backup plan—Send the report each time the auto backup plan is 

executed, regardless of the device backup result.  

8. Specify the address of the mail recipient in the Receiver's Mail Address field. This field is 
displayed only when Send report of auto backup plan only when backup fails or Send 
report of auto backup plan is selected. 

9. If you want to include all devices in IMC in this backup plan, select Backup network-wide 
devices. Click Select Device to add the devices that do not need backup to the Filtered 
Device List. 

Only one backup plan can be configured as a network-wide backup plan. 

10. If you did not select the Backup network-wide devices option, click Select Device to select 
the devices for which you want configuration files to be backed up by using this backup plan.  

11. Add devices either By View or by Advanced query. For more information, see "Adding devices 
by view" and "Adding devices by advanced query." 

12. If you did not select the Backup network-wide devices option, you can also select the Select 
View option to select views for whose devices you want to back up configuration files by using 
this backup plan. 

Click Select View next to the Selected Views area to select one or more view names that you 
want to back up on the window that opens and click OK. 

All selected views are displayed in the Selected Views area. 
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13. Click OK. The automatic backup plan is created successfully. The unmanaged devices are 
automatically filtered out.  

Modifying an existing automatic backup plan 

1. Navigate to Service > Auto Backup Plan. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Auto Backup Plan under Configuration Center on the left navigation tree. 

All existing automatic or scheduled backup plans are displayed in the Auto Backup Plan 
List.  

2. Click the icon  in the modify field associated with the backup plan you want to modify.  

The Set Auto Backup Attribute page opens. 

3. Modify the frequency with which you want this backup to run by selecting the new frequency 
from the Operation Frequency list.  

Options include Every Day, Every Week, and Every Month. 

4. Modify the time of day that you want the backup to run in the field next to the Operation 
Frequency list.  

A valid time entry is HH:MM:SS where HH denotes the two digit hour value, MM denotes the 
two digit minute value and SS denotes the two digit second value.  

5. Modify the description for this backup plan in the Description field.  

Valid description length is 0-128 characters. 

6. Set whether to send the report of the auto back plan to the designated mail recipient. Options 
are: 

 Not send report of auto backup plan—Do not send any report. This is the default setting. 

 Send report of auto backup plan only when backup fails—Send the report only when 

backup of one or more devices fails.  

 Send report of auto backup plan—Send the report each time the auto backup plan is 

executed, regardless of the device backup result.  

7. Specify the address of the mail recipient in the Receiver's Mail Address field. This field is 
displayed only when Send report of auto backup plan only when backup fails or Send 
report of auto backup plan is selected. 

8. Do one of the following to either include or remove devices from the backup plan: 

 If you want to include all devices in IMC in this backup plan, click the checkbox  to the left 
of Backup network-wide devices. Go to step 10. 

 To remove this selection, click the checked box . Go to step 11. 

9. Do one of the following to either modify your plan or remove all devices from the Filtered 
Device List: 

 To modify selected devices, click Select Device to add the devices to be filtered to the 

Filtered Device List, or click the Delete icon  to delete the devices that do not need 
filtering from the Filtered Device List. 

 To delete all devices from the Filtered Device List, click Delete All. 

10. Do one of the following to either modify your plan or remove all devices from the Device List: 

 To modify your selection of devices for this backup plan, click Select Device to select the 
devices for which you want their configuration files to be backed up by using this backup 
plan or to remove devices on this list. 

 To remove all devices from the Device List for this backup configuration, click Delete All. 

11. Add or remove devices either By View or by Advanced query.  
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For more information, see "Adding devices by view" and "Adding devices by advanced query." 

12. If you did not select the Backup network-wide devices option, you can also select the Select 
View option to select views for whose devices you want to back up configuration files by using 
this backup plan. 

Click Select View next to the Selected Views area to select one or more view names that you 
want to back up on the window that opens and click OK. 

All selected views are displayed in the Selected Views area. 

13. Click OK. 

Deleting an existing automatic backup plan 

To delete an existing automatic backup plan: 

1. Navigate to Service > Auto Backup Plan. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Auto Backup Plan under Configuration Center on the left navigation tree. 

All existing automatic or scheduled backup plans are displayed in the Auto Backup Plan 
List.  

2. Select the backup plans you want to delete. 

3. Click Delete. 

4. Click OK to confirm deletion of the selected backup plans. 

5. Review the results of the deletion operation in the Auto Backup Plan page. 

Disabling an existing automatic backup plan 

1. Navigate to Service > Auto Backup Plan. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Auto Backup Plan under Configuration Center on the left navigation tree. 

All existing automatic or scheduled backup plans are displayed in the Auto Backup Plan 
List.  

The Status field contains the current status of the associated backup task. 

 Enabled indicates that the associated backup task is enabled. 

 Disabled indicates that the associated backup task is disabled. 

2. Click Enabled in the Status field for the associated backup plan you want to disable. 

3. Review the results of the operation in the Auto Backup Plan page to ensure that the backup 
plan now contains Disabled in the Status field of the Auto Backup Plan List. 

Enabling an existing automatic backup plan 

1. Navigate to Service > Auto Backup Plan. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Auto Backup Plan under Configuration Center on the left navigation tree. 

All existing automatic or scheduled backup plans are displayed in the Auto Backup Plan 
List.  

The Status field contains the current status of the associated backup task. 

 Enabled indicates that the associated backup task is enabled. 

 Disabled indicates that the associated backup task is disabled. 

2. To enable a check task, click the Disabled icon  in the Status field. 
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The Backup History Report option in the Configuration Center provides you with visibility 
into the results of both manual and automatic backup tasks. For more information about using 
the Backup History Report option, see "Managing automatic backup plans" and "Viewing 
backup history ." 

Viewing backup history 

By using the Backup History option in the Auto Backup Plan List, you can quickly access a filtered 
Backup History Report for the selected backup plan.  

To view a filtered list:  

1. Navigate to Service > Auto Backup Plan. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Auto Backup Plan under Configuration Center on the left navigation tree. 

All existing automatic or scheduled backup plans are displayed in the Auto Backup Plan 
List.  

2. Click the icon  in the Backup History field for the associated backup plan you want to 
disable. 

The current page is updated to display the Backup History Report filtered for the selected 
backup plan. For more information about using the Backup History Report, see "Viewing 
backup history reports and restarting a failed backup." 

Configuring manual device backups 
By using the Configuration Center, you can perform manual backups of the configuration files for 
one or more devices.  

To manually backup one or more devices from the Configuration Center: 

1. Navigate to Service > <Device Name> > Configuration Management. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Configuration Center located under Configuration Center on the left navigation 
tree. 

All devices that can be managed by the Configuration Center are displayed in the list in 
the bottom half of the Configuration Center page. 

2. Select the devices for which you want to back up the configuration files. 

3. Click Backup Configuration. 

The page is updated to display the Configuration File Backup Result table. This results table 
displays the result for each configuration file that was backed up.  

4. Review the results for each entry in this table to ensure that all configuration files were backed 
up successfully. 

Viewing backup history reports and restarting a failed backup 
IMC provides a history of configuration file backup tasks for all backup tasks, including those initiated 
manually and scheduled backups. The Backup History Report list provides you with a view to the 
results of manual and automated backups. 

Accessing the backup history report 

To access the Backup History Report: 

1. Navigate to Service > Backup History Report. 
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a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Backup History Report under Configuration Center on the left navigation tree. 

The Backup History Report page opens. A history of backups for all automatic and 
manual backups is displayed in the Backup History List. 

Backup history list 

 Name—Contains a name for the entry. If the backup type is automated or scheduled, this 
field contains the name of the automatic backup plan. If the backup type for the entry is 
manual, it contains a date and time stamp for the execution of the manual backup. 

The contents of this field serve as a link to the Detailed Information page for the entry.  

 Description—Contains the description configured for the backup plan if the entry is the 
result of an automated backup plan. This field is blank if the backup type is a manual 
backup. 

 Configuration Type—Identifies whether or not the backup was a Network Wide Backup 
Plan, an Auto Backup Plan, or a Manual Backup. 

 Execution Time—Contains a date and time stamp for the completion of the backup task. 

 Execution Result—Identifies whether the backup Succeeded, Failed, or Partially 
Succeeded. 

 Operation—Contains the following icons:  

 This icon  initiates a backup of the configuration files for devices that failed on the 
first attempt. 

 This icon  is a link to the Deployment Guide for deploying the associated backup 
configuration files. For more information about deploying configuration files, see 
"Deploying configurations and software by using IMC deployment guide." 

 The icon  sets the backup configuration to the baseline. 

The Backup History List can be sorted by many fields. Click the column label to sort the list by 
the selected field. The column label is a toggle switch that lets you toggle between the various 
sort options specific to each field. 

If the Backup History List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Backup History List. 

 Click  to page forward to the end of the Backup History List. 

 Click  to page backward in the Backup History List. 

 Click  to page backward to the front of the Backup History List. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items 
per page you want to view. 

Querying the backup history report 

To query the Backup History Report: 

1. Navigate to Service > Backup History Report. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Backup History Report under Configuration Center on the left navigation tree. 

The Backup History Report page opens. A history of backups for all automatic and 
manual backups is displayed in the Backup History List. To search for a manual backup, 
enter the date stamp to filter by using the YYYY-MM-DD format. 
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2. Enter a report name in the field in the upper right corner of the Backup History Report page, 

and click the Search icon , or click the Advanced icon  located in the upper right corner 
of the page. 

The search criteria dialog box opens. 

3. Enter one or more of the following search criteria in the Query Criteria dialog box: 

 Name—Enter a complete or partial name of the backup plan name for which you want to 
search in the Name field. 

 Type—You can filter the Backup History List by selecting the type of backup you want to 
filter for from the Type list. 

 Start Time—Enter the start time of the backup task in the Start Time field. You can also use 

the calendar function by clicking the Calendar icon  next to the Start Time field. A popup 
calendar is displayed. Select the start date from the calendar. 

 End Time—Enter the ending time of the backup task in the End Time field. You can also 

use the calendar function by clicking the Calendar icon  next to the End Time field. A 
popup calendar is displayed. Select the end date from the calendar. 

4. Click Query to submit your filter criteria. 

The results of your filter or search query display in the Backup History List as explained in the 
next section. 

5. Click Reset when you want to restore the full Backup History List. 

Backup history detailed information 

The Backup History Report page provides drill down capabilities to the details of an individual 
backup task. From the Backup History Detailed Information page, you can view backup details 
and navigate to the Device Details page for each device in the Device Backup List.  

In addition, you can view the configuration file details, view the backup results for every device in the 
Device List, view the details for each backup task, and save the backup file as a configuration 
template. 

To view backup history detailed information: 

1. Navigate to Service > Backup History Report. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Backup History Report under Configuration Center on the left navigation tree. 

The Backup History Report page opens. A history of backups for all automatic and 
manual backups is displayed in the Backup History List.  

2. Click the link in the name field for the backup in which you want to view detailed information. 

The Detailed Information page opens. The Detailed Information page consists of two 
sections: the Basic Information section and the Device Backup List. 

A list of all devices backed up is displayed in the Device Backup List.  

Device backup list 

 Device Name—Contains the device label for the associated device.  

 Configuration File Name—Contains the name of the backup file for the device's 
configuration. The contents of this field serve as a link to view the details for the associated 
configuration file. 

 Configuration Type—Identifies whether the configuration file that was backed up was a 
startup or running configuration file. 

 Version—Identifies the version of the backup configuration file. Options are Baseline, 
Common, and Draft.  

 Result—Identifies whether the backup Succeeded, or Failed. If failed, click the Failed link to 
view the cause for the backup failure.  
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 Detail—Contains an icon  that displays the step-by-step detail for the configuration task.  

 Save As—Contains an icon  that opens the Add Configuration Template page for 
converting the backup configuration file into a configuration template. For more information 
about creating configuration templates, see "Managing device configurations with 
templates." 

3. On the Device Backup List, select one or multiple items, and click Export Configuration File 
to export the configuration files generated in the backup and save them locally.  

4. On the Device Backup List, select one or multiple items, and click Export History Report to 
export the backup history reports and save them locally.  

Alternatively, you can query devices on the top right corner of the page, select devices as 
needed on the queried device list, and select More > Configuration Management > Export 
Latest Backup Configuration to export the latest backup history reports and save them 
locally.  

5. On the Device Backup List, select one or multiple items, click Upload Configuration File, set 
the related parameters (including transfer protocol, host address, port number, and so on) 
correctly, and upload the configuration files generated in the backup to remote devices for 
saving. The transfer protocol can be SFTP. 

The exported or uploaded configuration file naming method is defined on the Options > 
Backup Policy page. The file naming method is Device Name_IP Address_Backup 
Time_startup/running.cfg, where the IP address and backup time are optional. 

You can sort the Device Backup List by the Device Name, Configuration File Name, 
Configuration Type, and Result fields. Click the column label to sort the list by the selected 
field. The column label is a toggle switch that lets you toggle between the various sort options 
specific to each field. 

If the Device Backup List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Device Backup List. 

 Click  to page forward to the end of the Device Backup List. 

 Click  to page backward in the Device Backup List. 

 Click  to page backward to the front of the Device Backup List. 

6. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

Re-executing a failed or partially successful backup 

1. Navigate to Service > Backup History Report. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree 

c. Click Backup History Report under Configuration Center on the left navigation tree. 

The Backup History Report page opens. A history of backups for all automatic and 
manual backups is displayed in the Backup History List.  

2. Click the icon  in the Operation field for the failed or partially successful backup you want to 
re-execute. 

The Configuration File Backup Result page is displayed and the result for each device entry 
is updated with the results of the backup.  

3. Verify that all devices in the results page have been backed up successfully. 
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Auditing configurations 
The Configuration Audit feature provides features for managing the task of auditing the 
configuration and software of network devices. The Configuration Backup Report provides you 
with a history of configuration file backups for all devices that are configured for backup. From this 
report, you can view the backup history of both the startup and running configuration file. IMC also 
provides you with a search/filter option for viewing by device name or file type or both. From the 
Config Backup page, you can also initiate a configuration file restore for one or more devices. 

By using the Configuration Baseline Report feature, you can view IMC's comparisons of the 
startup and running configuration files against the configured baseline files. If changes to the 
baseline exist, IMC acknowledges these changes and provides a link for the operator to manually 
compare the contents of the two files. From the Config Baseline page, you can launch the 
Deployment Guide to restore the baseline configuration to the device. 

The Software Update Report provides you with software update histories for devices managed in 
IMC. With this software auditing feature, you can view the software update histories for all devices 
managed by IMC. From this page, you can also launch the Deployment Guide to restore selected 
software to the source device.  

With the Software Baseline Report, you can compare the current system software against the 
configured baseline file. If differences exist between the baseline and the current system software, 
IMC acknowledges these differences. From the Software Baseline page, you can launch the 
Deployment Guide to restore the baseline software to the device. 

Using the configuration backup report 
The Configuration Backup Report provides access to the backup history and files for all devices 
that IMC is configured to back up. 

Accessing the configuration backup report 

1. Navigate to Service > Configuration Audit > Config Backup. 

2. Click the Service tab from the top tabular navigation system.  

3. Click Configuration Center on the left navigation tree. 

4. Click Config Backup under Configuration Audit on the left navigation tree. 

5. To expand the section, click the Expand icon  to the left of Configuration Audit. 

The Config Backup page opens. 

Config Backup Report 

 Device Name—Contains the device label or name. 

 Device Model—Contains the model information for the associated device. 

 Latest Backup Time—Contains the date and time stamp for the last backup of the 
configuration file type identified in the File Type field for the associated device. 

 File Name—Contains the name of the backup file. 

 File Type—Contains the type of configuration file that was backed up, startup or running 
configuration file. 

You can sort the Config Backup report by every field. Click the column label to sort the list by 
the selected field. The column label is a toggle switch that lets you toggle between the various 
sort options specific to each field. 

If the Configuration Backup Report spans multiple pages, use the following aids to navigate the 
list: 

 Click  to page forward in the Config Backup report. 
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 Click  to page forward to the end of the Config Backup report. 

 Click  to page backward in the Config Backup report. 

 Click  to page backward to the front of the Config Backup report. 

6. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

Querying the configuration backup report 

IMC provides the ability to search for a particular configuration backup report entry. 

To search the Config Backup report: 

1. Navigate to Service > Configuration Audit > Configuration Backup. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Config Backup under Configuration Audit on the left navigation tree.  

To expand the section, click the Expand icon  to the left of Configuration Audit. 

The Config Backup page opens. 

2. Enter one or more of the following search criteria in the Device Query section of the page: 

 Device Name—To locate the configuration backup files for a particular device, enter a 
partial or complete device label or name in the Device Name field. 

 File Type—To filter the Configuration Backup Report for a particular configuration file type, 
select the type from the File Type list. 

3. Click Query to submit your filter criteria. 

The results of your filter or search query is displayed in the Config Backup list. 

4. Click Reset when you want to restore the full Config Backup report. 

Restoring a configuration file from the configuration backup report page 

The Restore button on the Config Backup page provides a link to the Deployment Guide wizard 
for restoring configuration files. For more information about using the Deployment Guide for 
updating or restoring device configurations, see "Restoring a device configuration." 

Exporting a configuration file from the configuration backup report page 

You can export the contents of a configuration file to a file on the operator's local computer.  

To export a configuration file to your local computer:  

1. Navigate to Service > Configuration Audit > Config Backup. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Configuration Center on the left navigation tree. 

c. Click Config Backup under Configuration Audit on the left navigation tree. Expand the 
section by clicking the Expand icon  to the left of Configuration Audit. 

The Config Backup page opens. 

2. Select the combination of device name and configuration file type you want to export. 

3. Click Export. 

The Download Exported Device Configuration page opens. 

4. Click the Download Exported Device Configuration link to download the file to your local 
computer. 

5. Follow your browser's instructions for saving the file to your computer. 
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Using the configuration baseline report 
The Configuration Baseline Report provides the ability to view IMC's comparison of a device's 
most current startup and running configuration files against its configured baseline configuration 
files.  

With this feature, IMC identifies when the last backed up configuration file does not match the 
configured baseline. IMC provides the ability to restore select files from the Config Baseline page 
for those devices where running or startup configuration files do not match their baseline. 

Viewing the configuration baseline report 

1. Navigate to Service > Configuration Audit > Config Baseline. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Configuration Center on the left navigation tree 

c. Click Config Baseline under Configuration Audit on the left navigation tree. Expand the 
section by clicking the Expand icon  to the left of Configuration Audit. 

The Config Baseline page opens. 

Config baseline report 

 Device Name—Contains the device label or name. 

 Device Model—Contains the model information for the associated device. 

 Last Backup Configuration—Contains the filename of the last backed up 
configuration file for the file type identified in the File Type field. 

 Baseline Configuration—Contains the name of the baseline configuration file. 

 File Type—Contains the type of configuration file that was last backed up, startup or 
running configuration file. 

 Audit Result—Contains the result of IMC's comparison of the last backed up file and its 
configured baseline. 

The value Identical indicates that the last backed up configuration file matches the 
configured baseline configuration file. 

The value Changed indicates that the last backed configuration file does not match the 
configured baseline configuration file. The Compare link in this field launches the 
Configuration Compare feature for comparing the last backed up configuration file against 
the configured baseline configuration file.  

The value Unknown indicates that IMC could not make a comparison between the last 
backed up configuration file and the configured baseline configuration file. You can sort the 
Config Baseline report by all fields except Audit Result. Click the column label to sort the 
list by the selected field. The column label is a toggle switch that lets you toggle between the 
various sort options specific to each field. 

If the Config Baseline report spans multiple pages, use the following aids to navigate the 
list: 

 Click  to page forward in the Configuration Baseline report. 

 Click  to page forward to the end of the Configuration Baseline report. 

 Click  to page backward in the Configuration Baseline report. 

 Click  to page backward to the front of the Configuration Baseline report. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 
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3. Select one or multiple items and click Export to export the selected device configuration 
baseline audit results to a file and save the file locally.  

If you do not select any item before clicking Export, all device configuration baseline audit 
results are exported.  

Querying the configuration baseline report 

IMC provides the ability to search for a particular Configuration Baseline Report entry. 

To search the Config Baseline report: 

1. Navigate to Service > Configuration Audit > Config Baseline. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Config Baseline under Configuration Audit on the left navigation tree. Expand the 
section by clicking the Expand icon  to the left of Configuration Audit. 

The Config Baseline page opens. 

2. Enter a device name in the field in the upper right corner of the Config Baseline page, and click 

the Search icon , or click the Advanced icon  located in the upper right corner of the 
page. 

The search criteria dialog box opens. 

3. Enter one or more of the following search criteria in the Device Query section of the page: 

 Device Name—To locate the configuration backup files for a particular device, enter a 
partial or complete device label or name in the Device Name field. 

 Audit Result—To filter the Configuration Baseline Report for a particular audit result, 
select the result from the Audit Result list. 

 File Type—To filter the Configuration Baseline Report for a particular configuration file 
type, select the type from the File Type list. 

4. Click Query to submit your filter criteria. 

The results of your filter or search query is displayed in the Config Baseline list. 

5. Click Reset when you want to restore the full Config Baseline report. 

Comparing files in the configuration baseline report 

If Changed is displayed for the Audit Result field, you can click the Compare link to view the 
baseline configuration changes for the device. To compare the last backed up configuration file 
against the configured baseline file for the selected device.  

To compare files in the configuration baseline report: 

1. Navigate to Service > Configuration Audit > Config Baseline. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Configuration Center on the left navigation tree. 

c. Click Config Baseline under Configuration Audit on the left navigation tree. Expand the 
section by clicking the Expand icon  to the left of Configuration Audit. 

The Config Baseline page opens. 

2. Click the Compare link in the Audit Result field for the device for which you want to compare 
files. 

The Compare Configuration File dialog box opens. 

The two startup configuration files are displayed in side-by-side windows with file details at the 
top of the dialog box. 

IMC provides a summary of all identical, changed, and unique lines at the bottom of the dialog 
box. 

3. Do one of the following: 
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 To view the entire contents of both configuration files, select Show All. 

 To view only the differences between the two files, select Show Difference Only. 

4. Do one of the following: 

 Click Next Diff to view, line-by-line, the configuration differences between the two files.  

 Click Previous Diff to view the previous line that contains differences. 

5. Click Close when you have finished viewing the configuration file comparison. 

Restoring a configuration file from the configuration baseline report page 

The Restore button on the Config Baseline page provides a link to the Deployment Guide wizard 
for restoring configuration files. For more information about using the Deployment Guide for 
updating or restoring device configurations, see "Restoring a device configuration." 

Using the software update report 
The Software Update Report provides software update histories for devices managed in IMC. With 
this system software auditing feature, you can view the software update histories for devices 
managed by IMC. From this page, you can also launch the Deployment Guide to restore select 
software to the source device.  

Viewing the software update report 

1. Navigate to Service > Configuration Audit > Software Update. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Configuration Center on the left navigation tree. 

c. Click Software Update under Configuration Audit on the left navigation tree. Expand the 
section by clicking the Expand icon  to the left of Configuration Audit. 

The Software Update page opens. 

Software update report  

 Device Name—Contains the device label or name. 

 Device Type—Contains the model information for the associated device. 

 Latest Update Time—Contains the date and time stamp for the last software update for the 
associated device. 

 Before Software Name—Contains the file name of the system software that was replaced 
with the system software specified in the After Software Name field. 

 After Software Name—Contains the file name of the system software that was used to 
update the system software specified in the Before Software Name field. 

You can sort the Software Update report by all fields. Click the column label to sort the list by 
the selected field. The column label is a toggle switch that lets you toggle between the various 
sort options specific to each field. 

If the Software Update report spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Software Update report. 

 Click  to page forward to the end of the Software Update report. 

 Click  to page backward in the Software Update report. 

 Click  to page backward to the front of the Software Update report. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 
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Querying the software update report 

You can search for a particular Software Update Report entry. 

To search the Software Update report:  

1. Navigate to Service > Configuration Audit > Software Update. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Configuration Center on the left navigation tree. 

c. Click Software Update under Configuration Audit on the left navigation tree. Expand the 
section by clicking the Expand icon  to the left of Configuration Audit. 

The Software Update page opens. 

2. Enter the following search criterion in the upper right of the page: 

Device Name—To locate the configuration backup files for a particular device, enter a partial or 
complete device label or name in the Device Name field. 

3. Click  to submit your filter criterion. 

The results of your filter or search query are displayed in the Software Update list below. 

Restoring a software file from the software update report page 

The Restore button on the Software Update page provides quick link to the Deployment Guide 
wizard for updating or restoring system software. For more information about using the Deployment 
Guide for updating or restoring system software, see "Restoring device software." 

Using the software baseline report 
The Software Baseline Report provides you the ability to compare a device's most current system 
software against its configured baseline system software file. IMC identifies when the current 
software file does not match the configured baseline software. 

IMC also provides the ability to restore selected files from the Software Baseline page for those 
devices where current software does not match the baseline. 

Viewing the software baseline report 

1. Navigate to Service > Configuration Audit > Software Baseline. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Configuration Center on the left navigation tree. 

c. Click Software Baseline under Configuration Audit on the left navigation tree. Expand 
the section by clicking the Expand icon  to the left of Configuration Audit. 

The Software Baseline page opens. 

Software baseline report 

 Device Name—Contains the device label or name. 

 Device Type—Contains the model information for the associated device. 

 Current Software—Contains the filename of the software currently running on the 
associated device. 

 Baseline Software—Contains the name of the software file that is configured as the 
baseline software for the associated device. 

 Audit Result—Contains the result of IMC's comparison of the current software file and it's 
configured baseline. 

The value Identical indicates that the current software file matches the configured 
baseline software file. 

The value Changed indicates that the current software file does not match the configured 
baseline file. 
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The value  Unknown indicates that IMC could not make a comparison between the 
current software file and the configured baseline software file. 

You can sort the Software Baseline report by all fields. Click the column label to sort the list 
by the selected field. The column label is a toggle switch that lets you toggle between the 
various sort options specific to each field. 

If the Software Baseline report spans multiple pages, use the following aids to navigate the 
list. 

 Click  to page forward in the Software Baseline report. 

 Click  to page forward to the end of the Software Baseline report. 

 Click  to page backward in the Software Baseline report. 

 Click  to page backward to the front of the Software Baseline report. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

Querying the software baseline report 

You can search for a particular software baseline report entry.  

To search the Software Baseline report:  

1. Navigate to Service > Configuration Audit > Software Baseline. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Configuration Center on the left navigation tree. 

c. Click Software Baseline under Configuration Audit on the left navigation tree. Expand 
the section by clicking the Expand icon  to the left of Configuration Audit. 

The Software Baseline page opens. 

2. Enter a device name in the field in the upper right corner of the Software Baseline page, and 

click the search icon , or click the Advanced icon  located in the upper right corner of 
the page. 

The search criteria dialog box opens. 

3. Enter one or more of the following search criteria in the Device Query section of the page: 

 Device Name—To locate the configuration backup files for a particular device, enter a 
partial or complete device label or name in the Device Name field. 

 Audit Result—To filter the Software Baseline report for a particular audit result, select the 
result from the Audit Result list. 

 Custom View—To filter the Software Baseline report for devices in a custom view, select 
the custom view from the Custom View list. You can also select the blank option, which 
searches all custom views.  

4. Click Query to submit your filter criteria. 

The results of your filter or search query are displayed in the Software Baseline list below. 

5. Click Reset when you want to restore the full Software Baseline report. 

Restoring a software file from the software baseline report page 

The Restore button on the Software Update page provides a link to the Deployment Guide wizard 
for updating or restoring system software. For more information about using the Deployment Guide 
for updating or restoring system software, see "Restoring device software." 
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Using compliance check 
Compliance check verifies whether configurations on devices are compliant with compliance policies 
and shows the check results in various forms. In addition, compliance check can fix noncompliant 
configurations to make sure the network operates in a secure, stable environment.  

Compliance check comprises the following elements: 

 Rule—Contains the violation severity level, check target, device vendor, device series, and the 
content to be checked for a compliance policy. Rules must be associated with a compliance 
policy. To create a rule, first create a compliance policy.  

 Compliance policy—Comprises one or more rules to check specific objects. Compliance 
policies reduce operators' workload and improve the work efficiency. Multiple compliance 
policies can share the same rules. 

 Check task—Contains one or more compliance policies that are associated with devices. You 
can configure a check task to be executed once or periodically. 

IMC shows the check results in policy view for analysis from the compliance policy's perspective, in 
device view for analysis from the device's perspective, and in the execution report for analysis from a 
comprehensive perspective.  

Compliance check can also check whether the output of specific display commands is compliant with 
the associated compliance policy. You need to add the display commands in the rules of the 
compliance policy. 

The iCC component uses configuration backups for compliance check. To perform compliance 
check, first back up the latest startup configuration or the latest running configuration for the target 
device. For more information about backing up device configuration files, see "Configuration and 
change management." To check the compliancy of the display command output, IMC logs into the 
target device by using the specified login method and then executes the display command. 

Compliance policy 
IMC performs compliance check according to compliance policies.  

A compliance policy comprises a set of rules and each rule defines the violation severity level, check 
type, check target, vendor and product series under check, recovery commands, and the content to 
be checked. The following information describes how to configure and maintain compliance policies 
and their rules.  

Viewing the compliance policy list 

1. Navigate to Service > Compliance Policy. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Compliance Center on the left navigation tree. 

c. Click Compliance Policy under Compliance Center on the left navigation tree. 

The Policy List is displayed. 

Policy list 

 Name—Contains the name of the compliance policy. The contents of this field serve as a 
link for navigating to the Compliance Policy Details page for the associated policy. 

 Description—Contains a description for the compliance policy. 

 Status—Shows the status of the compliance policy.  means the policy is disabled and 

you can click it to enable the policy.  means the policy is enabled and you can click it to 
disable the policy. Only enabled compliance policies can be associated with check tasks. 

 Type—Identifies whether the associated compliance policy is System Defined or User 
Defined. 
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 Modify—Contains a link  for modifying the associated compliance policy. 

 Delete—Contains a link  for deleting the associated compliance policy. 

System defined policies cannot be modified or deleted. Only user defined policies can be 
modified and deleted. 

You can sort the Policy List by the Name, Description, Status, and Type fields by clicking the 
column label to sort the list by the selected field. The column label is a toggle switch that allows 
you to toggle between the various sort options specific to each field. 

If the Policy List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Policy List. 

 Click  to page forward to the end of the Policy List. 

 Click  to page backward in the Policy List. 

 Click  to page backward to the front of the Policy List. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

3. Click Start Check to enter the Add Check Task page. 

Viewing detailed information about a compliance policy 

1. Navigate to Service > Compliance Policy. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Compliance Center on the left navigation tree. 

c. Click Compliance Policy under Compliance Center on the left navigation tree. 

The Policy List is displayed. 

2. Click the name link of a compliance policy to enter the Compliance Policy Details page. 

Basic information 

 Name—Contains the name of the compliance policy. 

 Type—Contains the type of the compliance policy, System Defined or User Defined. 

 Description—Contains the description for the compliance policy. 

Rule list 

 Name—Contains the name of the rule. Click this link to view detailed information about the rule.  

 Type—Contains the type of the rule, System Defined or User Defined. 

 Severity Level—Contains the violation severity level of the rule.  

 Type—Contains the object to be checked. Options include: 

 Device 

 Interface 

 Link 

 Aggregate Link 

 Configuration Segment 

 Jython Script 

 Test—Click this link to enter the test page where you can perform a test to verify the function 
and validity of this rule. Only the rules whose Check Type is Device, Interface, or 
Configuration Segment can be tested. 

Performing a test 
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To perform a test: 

1. Click the link  to enter the Rule Test page.  

2. Enter the test content in the text box under Test Content or click the Import link to import a 
configuration file from the configuration template database. 

3. Click Test.  

After the test is complete, the test results show whether the test content or configuration file 
matches the rule. You can judge whether the rule achieves your purpose according to the test 
results.  

4. To clear the test content and result, click Reset.  

Viewing detailed information about a rule 

1. Navigate to Service > Compliance Policy. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Compliance Center on the left navigation tree. 

c. Click Compliance Policy under Compliance Center on the left navigation tree. 

The Policy List is displayed. 

2. Click the name link of a compliance policy to enter the Compliance Policy Details page. 

3. Click the name link of a rule to enter the Rule Details page. 

Basic information  

 Name—Contains the name of the rule.  

 Type—Contains the type of the rule, System Defined or User-Defined. 

 Severity Level—Contains the violation severity level of the rule. Options include 
Informational, Warning, Minor, Major, and Critical. 

 Check Target—Contains the check target of the rule. Options include Latest backup 
running configuration, Latest backup startup configuration, and Display command output. 

 Command—Contains the display command. After IMC assigns this task, the target device 
executes this display command and checks whether the command output matches the rule. 
The Command field is available only when the Check Target is Display command output.  

 Vendor—Contains the device vendor to be checked. 

 Device Series—Contains the device series to be checked. 

 Check Type—Contains the check type. Options include: 

 Device 

 Interface 

 Link 

 Aggregate Link 

 Configuration Segment 

 Jython Script 

 Start Identifier—Contains the start identifier of the content to be checked when the check 
type is Interface, Link, Aggregate Link, or Configuration Segment. 

 End Identifier—Contains the end identifier of the content to be checked when the check 
type is Interface, Link, Aggregate Link, or Configuration Segment.  

 Description—Contains the description for the rule. 

 Rule Type—This field is displayed only when the rule type is Advanced. 

 Operation—Contains the operation mode of the rule, Check or Check and Get. The 
Check operation only checks the configuration file content. The Check and Get operation 
checks the configuration file content and gets relevant parameters according to the rule. 
When the check type is Link or Aggregate Link, the Check and Get operation gets 
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relevant parameters according to the rule and compares the parameters to predefined 
values according to the comparison mode to check whether the device configuration 
matches the compliance policy. For other check types, the Check and Get operation only 
gets relevant parameters and displays them in the Configuration Retrieval Report.  

The following describes the configuration items for basic and advanced rules respectively. 

Basic  

 Rule Type—Contains the rule type. 

 Match Mode: 

 Loose Match—In this mode, a match occurs when the content in the configuration file 
or display command output contains the content in the rule. 

 Negative Loose Match—In this mode, a match occurs when the content in the 
configuration file or display command output does not contain the content in the rule.  

 Strict Match—In this mode, a match occurs only if the content in the configuration file or 
display command output is displayed in the same order as specified in the rule. 

 Negative Strict Match—In this mode, a match occurs only if the content in the 
configuration file or display command output is not displayed in the same order as 
specified in the rule.  

 Match Patterns—IMC compares the match patterns to the configuration content on the 
device, and determines whether the device violates the rule according to the match mode. 

Advanced  

When the rule contains only one match pattern, the following are displayed.  

 Rule Type—Contains the type of the rule. 

 Operation—Contains the operation mode of rule, Check or Check and Get. 

 Match Patterns—Contains the content of the rule or regular expression.  

When the rule contains multiple match patterns, the following are displayed. 

 Rule Relation—AND or OR, displayed only when the rule type is Advanced. If the rule 
relation is AND, the two adjacent patterns must both comply with the policy. If the rule 
relation is OR, only one of the two adjacent patterns must comply with the policy. 

 Rule Content Configuration—Included or Excluded, displayed only when the check type 
is Device, Interface, or Configuration Segment. 

 Included—A match occurs if the device configuration contains the match patterns of the 
rule. 

 Excluded—A match occurs if the device configuration does not contain the match 
patterns of the rule. 

 Match Criteria—Displayed when the check type is Link or Aggregate Link. 

 Contain all—A match occurs when both ends of a link have the match patterns of the 
rule in their configuration files.  

 Contain none of them—A match occurs when both ends of a link do not have the 
match patterns of the rule in their configuration files. 

 Contain one of them—A match occurs when at least one end of a link has the match 
patterns of the rule in its configuration file. 

 Contain all but one—A match occurs when at least one end of a link does not have the 
match patterns of the rule in its configuration file. 

 Match Patterns—IMC compares the match patterns against the configuration content on 
the device. 

 Comparison Type—IMC compares the values of the two interfaces according to the 
comparison type. Options include All equal to, All not equal to, One of them equal to, 
One of them not equal to, and All Identical. Configure the comparison type when the 
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check type is Link or Aggregate Link, or when the check type is Advanced and the 
operation mode is Check and Get. 

 Value for Comparison—IMC compares this value to the value obtained from the device. 
Use this item together with Comparison Type. 

When the check type is Jython Script, the name information for the Jython script is displayed 
in the text box next to Script Directory Information in the Jython Script area. 

4. Click Back to return to the Compliance Policy List page. 

Querying a compliance policy 

1. Navigate to Service > Compliance Policy. 

2. Click the Service tab from the top tabular navigation system.  

3. Click Compliance Center on the left navigation tree. 

4. Click Compliance Policy under Compliance Center on the left navigation tree. 

The Policy List is displayed. 

5. Enter a partial or complete name of a compliance policy in the Name field in the upper right 
corner of the Policy List page. 

6. Click . 

All matching compliancy policies are displayed in the Policy List. 

Creating a compliance policy 

1. Navigate to Service > Compliance Policy. 

2. Click the Service tab from the top tabular navigation system.  

3. Click Compliance Center on the left navigation tree. 

4. Click Compliance Policy under Compliance Center on the left navigation tree. 

The Policy List is displayed. 

5. Click Add. 

6. Enter a name of the compliance policy, a string of 1 to 32 characters. 

7. Enter a description for the compliance policy, a string of 0 to 128 characters.  

You can add a new rule or import a rule from another compliance policy into the compliance 
policy. 

Adding a rule  

1. Click Add Rule under Rule List. 

2. Enter the name of the rule, a string of 1 to 32 characters.  

3. Select Severity Level to select the violation severity level for the rule. 

Options include: 

 Informational 

 Warning 

 Minor 

 Major 

 Critical 

4. Select the check type. Options include:  

 Device 

 Interface 

 Link 

 Aggregate Link 

 Configuration Segment 
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 Jython Script 

5. Do one of the following: 

 If you select Interface or Configuration Segment, go to step 6.  

 If you select Link or Aggregate Link, go to step 10.  

 If you select Device, go to step 13.  

 If you select Jython Script, go to step 17. 

6. Set the start and end identifiers. 

7. In the Start Identifier text box, enter the start identifier of the interface to be checked, for 
example, enter interface *. 

8. In the End Identifier text box, enter the end identifier of the interface configuration, for 
example, enter # or !. 

The rule checks the configuration segment according to the start and end identifiers. 

9. Go to step 13. 

10. Set the start and end identifiers. 

11. In the Start Identifier text box, enter the start identifier of the link configuration. 

12. In the End Identifier text box, enter the end identifier of the link configuration. 

For example, enter # or !. 

The rule checks the configuration segment according to the start and end identifiers. 

13. Select the check target from the Check Target list.  

Options include:  

 Latest backup running configuration 

 Latest backup startup configuration 

 Display command output 

14. Do one of the following: 

 If you select Latest backup running configuration or Latest backup startup 
configuration, go to step 17. 

 If you select Display command output, go to step 15. 

15. Enter a display command in the text box next to Command, or select a display command as 
follows. 

a. Click Select next to the text box.  

b. In the window that displays, enter a partial or complete display command in the text box next 
to Name of Display Command, all qualified display commands are displayed in the 
Command List.  

c. Select the desired display commands.  

The selected commands are displayed in the text box next to Command. 

The variables such as the dollar sign ($) are not supported. For example, a display 
command cannot contain ${ip address}. 

16. Select a vendor from the Vendor list for the rule.  

The rule only checks the devices of the selected vendor.  

17. Select the device series to be checked. 

18. Click Select next to Device Series.  

19. In the Select Device Series window that opens, enter the partial or complete name of the 
device series, and click Query.  

All the qualified device series are displayed in the Device Series List. 

If the device series spans multiple pages, use the following aids to navigate the list: 
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 Click  to page forward in the Device Series List. 

 Click  to page forward to the end of the Device Series List. 

 Click  to page backward in the Device Series List. 

 Click  to page backward to the front of the Device Series List. 

20. Select the target device series, and click OK.  

The selected device series are displayed in the area next to Device Series. 

21. To delete a device series, select it and click Delete. 

22. Enter a description for the rule in the text box next to Description, a string of 1 to 128 
characters. 

23. If the check type selected in step 4 is Jython Script, go to step 24. 

24. Click Browse next to Jython Script, and select a local Jython script. 

If you select Device, Interface, or Configuration Segment in step 4, the Recover option is 
displayed. 

25. Select Recover. 

 If you select Yes, enter the command for entering the configuration mode in the Command 
for entering configuration mode field and the fix command in the Recovery Commands 
field. IMC uses this fix command to fix configuration files incompliant with the rule. 

 If you select No, IMC does not modify the settings.  

26. Select the rule type from the Rule Type list, Basic or Advanced.  

If you select Advanced, go to step 29. 

27. Select the match mode you want to use from the Match Mode list. Options include: 

 Loose Match—In this mode, a match occurs when the content in the configuration file or 
display command output contains the content in the rule. 

 Negative Loose Match—In this mode, a match occurs when the content in the 
configuration file or display command output does not contain the content in the rule.  

 Strict Match—In this mode, a match occurs only if the content in the configuration file or 
display command output is displayed in the same order as specified in the rule. 

 Negative Strict Match—In this mode, a match occurs only if the content in the 
configuration file or display command output is not displayed in the same order as specified 
in the rule.  

28. Enter the string you want IMC to search for in the Match Patterns field. 

29. Select the operation mode from the Operation field, Check or Check and Get.  

The Check operation only checks the configuration file for selected devices. The Check and 
Get operation checks and retrieves the configuration settings for the selected devices. The 
check results are displayed in the Configuration Retrieval Report. For more information 
about the Configuration Retrieval Report, see "Viewing configuration retrieval report." 

30. If you select Check and Get, go to step 40. If the check type selected is Link or Aggregate 
Link, go to step 32. 

31. Select the match mode from the Match Mode list. This option is available when the check type 
is Device, Interface, or Configuration Segment. Two options provided for the advanced rule 
type are described below: 

 Included—A match occurs if the device configuration contains the match patterns of the 
rule. 

 Excluded—A match occurs if the device configuration does not contain the match patterns 
of the rule. 
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32. Select the match criteria from the Match Criteria list. This option is available when the check 
type is Link or Aggregate Link. Four options provided for the advanced rule type are described 
below: 

 Contain all—A match occurs when both ends of a link have the match patterns of the rule in 
their configuration files.  

 Contain none of them—A match occurs when both ends of a link do not have the match 
patterns of the rule in their configuration files. 

 Contain one of them—A match occurs when at least one end of a link has the match 
patterns of the rule in its configuration file. 

 Contain all but one—A match occurs when at least one end of a link does not have the 
match patterns of the rule in its configuration file. 

33. Enter the pattern or regular expression in the Match Patterns field. 

34. Click Add to add it to the rule. 

35. To add a new pattern, select the logical operator from the Rule Relation list:  

Options include AND and OR. 

 If you select AND, the two adjacent patterns must both comply with the policy. 

 If you select OR, only one of the two adjacent patterns must comply with the policy. 

IMC checks contents against the match patterns in sequence. You can have more than two 
patterns for one rule and use more than one logical operator in a given rule. 

36. Select the match mode from the Match Mode list. If the check type is Link or Aggregate Link, 
select the match criteria from the Match Criteria list. 

37. Enter the pattern or regular expression. 

38. Click Add to add the pattern to the rule. 

39. Repeat steps 31–38 to add more patterns to the rule in the Match Patterns field. 

40. Enter a match pattern or regular expression for the rule in the text box next to Match Patterns. 
If the check type selected is not Link or Aggregate Link, go to step 50. 

41. Select a comparison type from the Comparison Type list. Options include the following: 

 All equal to—IMC uses the match pattern entered in step 40 to retrieve the target value 
from both devices on a link, and compares the retrieved value to the value entered in step 
42. If they match for both devices, both devices are matched. Otherwise, both devices are 
violated.  

 All not equal to—IMC uses the match pattern entered in step 40 to retrieve the target value 
from both devices on a link, and compares the retrieved value to the value entered in step 
42. If no match is found for both devices, both devices are matched—otherwise, both 
devices are violated. 

 One of them equal to—IMC uses the match pattern entered in step 40 to retrieve the target 
value from both devices on a link, and compares the retrieved value to the value entered in 
step 42. If they match for both devices, both devices are matched—otherwise, both devices 
are violated. 

 One of them not equal to—IMC uses the match pattern entered in step 40 to retrieve the 
target value from both devices on a link, and compares the retrieved value to the value 
entered in step 42. If no match is found for both devices, both devices are 
matched—otherwise, both devices are violated. 

 All Identical—IMC uses the match pattern entered in step 40 to retrieve the target value 
from both devices on a link, and compares the values of the two devices. If they match, both 
devices are matched—otherwise, both devices are violated. 

42. Enter a value in the Value for Comparison text box when the comparison type selected in step 
41 is not All Identical.  

IMC compares the value with the value retrieved from devices.  

43. Click Add next to Value for Comparison to add the match condition combination to the rule. 
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44. To add a new Value for Comparison, select a logical operator from the Rule Relation list.  

Options include AND and OR. 

 If you select AND, the two adjacent values must both comply with the policy. 

 If you select OR, only one of the two adjacent values must comply with the policy. 

45. Select a comparison type from the Comparison Type list as described in step 41. 

46. Enter a value in the Value for Comparison text box if the comparison type selected in step 45 
is not All Identical. IMC compares the entered value to the value retrieved from the devices.  

47. Click Add next to Value for Comparison to add the match condition combination to the rule. 

48. Repeat steps 40–47 to add more match conditions of the Check and Get type to the rule. 

49. If the check type is Link or Aggregate Link, repeat steps 29–48 to add more different types of 
match conditions to the rule. 

50. Click OK. 

51. The newly created rule is displayed in the Rule List. 

Importing a rule  

To import a rule from another compliance policy: 

1. Click Import Rule under Rule List.  

The Select Rules window pops up. All compliance policies are displayed in the Policy List.  

2. Click the name link of a compliance policy to show all rules. 

3. Select a rule, or select all rules by selecting the compliance policy name.  

4. Click OK. 

The selected rules are displayed in the Rule List. 

5. Click the link  of a rule to modify the rule. 

6. Click the link  of a rule to test the rule. 

7. Enter the test content in the text box under Test Content, or click Import to import the test 
results from a configuration template.  

8. Click Test.  

After the test is complete, IMC shows whether the test content or configuration file matches the 
rule. The test function is available only for rules whose check type is Device, Interface, or 
Configuration Segment. You can judge whether the rule achieves your purpose according to 
the test results. 

9. To delete a rule, click the link  of that rule. 

10. Click OK. 

11. Verify that the added compliance policy is in the Policy List. 

Set the rule relation formula 

When the rule list contains more than one rule, you can set the rule relation formula.  

To set the rule relation formula: 

1. When you click OK on the Add Compliance Policy page after setting basic information and 
associated rules, the Set Rule Relation Formula page opens if the rule list contain two or more 
rules.  

2. Enter the rule relation formula. 

 A rule relation formula supports the following fields: rule name, "&&", "||", "(", and ")". 

 The rule relation formula must contain all rule names. Each rule name can appear only 
once. 

 "&&" indicates the AND relationship, and "||" indicates the OR relationship. Priority order: 
"()" > "&&" > "||". 
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 Example: (Rule 1||Rule 2)&&(Rule 3||Rule 4). 

3. Click OK to add the compliancy policy.  

Modifying a compliance policy 

1. Navigate to Service > Compliance Policy. 

2. Click the Service tab from the top tabular navigation system.  

3. Click Compliance Center on the left navigation tree. 

4. Click Compliance Policy under Compliance Center on the left navigation tree. 

The Policy List is displayed. 

5. Click the link  for the policy to enter the Modify Compliance Policy page. System Defined 
configuration check rules cannot be modified. Only User Defined configuration check rules can 
be modified. 

6. Delete the existing description, and enter a new description (0 to 128 characters) for the policy. 

7. Add rules as required. When there are two or more rules, you can set the rule relation formula. 
For information about how to add a rule or set the rule relation formula, see "Creating a 
compliance policy." 

8. To modify a rule, click the link  for the rule to enter the modification page.  

9. Select the severity level.  

Options include:  

 Informational 

 Warning 

 Minor 

  Major 

 Critical 

10. Select a check type from the Check Type list.  

Options include: 

 Device 

 Interface 

 Link 

 Aggregate Link 

 Configuration Segment 

 Jython Script 

These types are described respectively in the following steps.  

11. Do one of the following: 

 If you selected Interface or Configuration Segment, go to step 12. 

 If you selected Link or Aggregate Link, go to step 16. 

 If you selected Device, go to step 19. 

 If you selected Jython Script, go to step 23. 

12. Set the start identifier and end identifier.  

13. In the Start Identifier field, enter the start identifier, such as interface *. 

14. In the End Identifier field, enter the end identifier, such as # or !. 

The rule checks the configuration segment according to the start and end identifiers. 

15. Go to step 19. 

16. Set the start identifier and end identifier for link configuration check.  

17. In the Start Identifier field, enter the start identifier of the link configuration. 
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18. In the End Identifier field, enter the end identifier, such as # or !. 

The rule checks the configuration segment according to the start and end identifiers. 

19. Select the check target from the Check Target list.  

Options include Latest backup running configuration, Latest backup startup 
configuration, and Display command output. 

20. If you selected Latest backup running configuration or Latest backup startup 
configuration, go to step 29. 

21. Enter a display command in the field or select a display command from the command 
fragment. 

22. Click Select to bring up the Select window.  

23. In the Name of Display Command field, enter the command or part of the command.  

All commands matching your input is displayed in Command List. 

24. Select a command and click OK.  

The selected command is displayed in the command field. The variables such as $ are not 
supported. For example, a display command cannot contain ${ip address}. 

25. Select a vendor from the Vendor list. 

26. Select a device series. 

27. Click Select next to the device series area.  

The Select Device Series dialog box opens. 

28. Enter the device series name or part of the name in the Device Series Name field, and click 
Query. All matching device series are displayed in the Device Series List.  

If the query result list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Device Series List. 

 Click  to page forward to the end of the Device Series List. 

 Click  to page backward in the Device Series List. 

 Click  to page backward to the front of the Device Series List. 

Click a page number to display the entries on the page. 

To select a device series, select the device series and click OK. The selected device series is 
displayed in the area next to the Device Series. 

To delete a device series, select a device series and click Delete. 

29. Enter a new description (1 to 128 characters) for the rule in the Description field. 

30. Click Browse next to the Jython script area to locate the Jython script. 7 

If you selected Device, Interface, or Configuration Segment, the Recover option is 
displayed. 

31. Select Yes or No next to the Recover option:  

 If you select Yes, enter the command for entering the configuration mode in the Command 
for entering configuration mode field and the fix command in the Recovery Commands 
field. IMC uses this command to fix configuration files incompliant with the rule. 

 If you select No, IMC does nothing. 

32. Select a rule type for the rule. 

33. Select a rule type for the rule from the Rule Type list.  

Options include Basic and Advanced. 

34. Select the match mode you want to use from the Match Mode list. Four options are provided for 
a basic configuration check file and each option as follows: 
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 Loose Match—With this option, IMC matches on the presence of any words provided in the 
rule. If the configuration file or the display command results includes the rule content, IMC 
considers the device compliant with the policy. 

 Negative Loose Match—With this option, IMC matches on the presence of any words 
provided in the rule. If the configuration file or the display command result does not include 
the rule content, IMC considers the device compliant with the policy.  

 Strict Match—With this option, IMC considers the content in the rule a match with the 
content in the configuration file or display command result only if they are displayed in the 
same order as specified in the rule. 

 Negative Strict Match—With this option, IMC considers the content in the rule a match 
with the content in the configuration file or display command result only if they are not 
displayed in the same order as specified in the rule.  

35. Enter the pattern or regular expression in the Match Patterns field. 

36. Select the type of rule check operation you want to perform with this rule from the Operation 
field: a configuration Check or a configuration Check and Get.  

 A configuration Check checks the configuration for all selected devices. 

 A configuration Check and Get checks and retrieves the configuration settings for the 
selected devices. Check and Get results are displayed in the Configuration Retrieval 
Report. For more information about the Configuration Retrieval Report, see "Viewing 
configuration retrieval report." 

37. Select the pattern matching method you want to use from the Match Mode list. Two options are 
provided for an advanced configuration check file and each option is described below: 

 Included—If the configuration includes the rule content defined in the Match Pattern, the 
configuration is considered compliant with the policy. 

 Excluded—If the configuration does not include the rule content defined in the Match 
Pattern, the configuration is considered compliant with the policy. 

38. Select the pattern matching method you want to use from the Match Criteria list. Four options 
provided for an advanced configuration check file and each option is described below: 

 Contain all—When the configuration files of the devices at the two ends of the link both 
include the rule content defined in the Match Patterns, the configurations are considered 
compliant with the policy.  

 Contain none of them—When neither of the configuration files of the devices at the two 
ends of the link includes the rule content defined in the Match Patterns, the configurations 
are considered compliant with the policy. 

 Contain one of them—When at least one of the configuration files of the devices at the two 
ends of the link includes the rule content defined in the Match Patterns, the configurations 
are considered compliant with the policy. 

 Contain all but one—When at least one of the configuration files of the devices at the two 
ends of the link do not include the rule content defined in the Match Patterns, the 
configurations are considered compliant with the policy. 

39. Enter the pattern or regular expression you want IMC to search for in the Match Patterns field. 

40. Click Add next to the Match Patterns field to add the match condition combination to the rule. 

41. To add a new match condition, select the logical operator you want IMC to use to evaluate 
patterns and pattern matching from the Rule Relation list:  

Options include AND and OR. 

 If you select AND, the two adjacent values must both comply with the policy. 

 If you select OR, only one of the two adjacent values must comply with the policy. 

You can have more than two Match Pattern regular expression values for one rule and more 
than one logical operator in use in a given rule. 

42. Select the pattern matching method you want to use from the Match Mode list as you did for the 
first match pattern in step 39. 
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43. If the check type is Link or Aggregate Link, select the pattern matching method you want to 
use from the Match Criteria list as you did for the first match pattern in step 40. 

44. Enter the pattern or regular expression you want IMC to search for in the Match Patterns field. 

45. Click Add next to the Match Patterns field to add the conditions to the rule. 

46. Repeat steps 39–47 for as many check type match patterns you want to add to the rule. 

47. Enter the pattern or regular expression in the Match Patterns field. If what you selected in step 
7 is not Link or Aggregate Link, go to step 40. 

48. Select the value comparison type from the Comparison Type list. Five options are provided: 

 All equal to—IMC retrieves values from the devices' configuration files based on the rule 
content entered in step 49, and compares them with the value you enter in step 51. If the 
values match, the configuration files are compliant with the policy.  

 All not equal to—IMC retrieves values from the devices' configuration files based on the 
rule content entered in step 49, and compares them with the value you enter in step 51. If 
none of the extracted values match the entered value, the configuration files are compliant 
with the policy. 

 One of them equal to—IMC retrieves values from the devices' configuration files based on 
the match pattern entered in step 49, and compares them with the value you entered in step 
51. If at least one of the extracted values matches the entered value, the configuration files 
are compliant with the policy. 

 One of them not equal to—IMC retrieves values from the devices' configuration files 
based on the match pattern entered in step 49, and compares them with the value you 
entered in step 51. If at least one of the extracted values does not match the entered value, 
the configuration files are compliant with the policy. 

 All Identical—IMC retrieves values from the devices' configuration files based on the 
match pattern entered in step 49, and compares them. If the extracted values of the devices 
match, the configuration files are compliant with the policy. 

49. If the comparison type you selected is not All Identical, enter a value in the Value for 
Comparison field. IMC compares this value with the values retrieved from the devices.  

50. Click Add next to the Value for Comparison field to add the match condition combination to 
the rule. If you selected the comparison type All Identical in step 50, add the match pattern 
entered in step 49 to the rule. 

51. To add a new Value for Comparison, select the logical operator you want IMC to use to 
evaluate patterns and pattern matching from the Rule Relation list. Options include AND and 
OR. 

If you select the logical operator AND, both patterns defined in the Match Patterns field on 
either side of the AND must be found in the configuration file for IMC to take the actions defined 
in the rule. If you select the logical operator OR, only one of the patterns defined in the Match 
Patterns field on either side of the OR must be found in the configuration file for IMC to take the 
actions defined in the rule.  

52. Select a comparison type from the Comparison Type list. 

53. If the comparison type you selected is not All Identical, enter a value in the Value for 
Comparison field. 

IMC compares this value with the value retrieved from the device. 

54. Click Add next to the Value for Comparison field to add the match condition combination to 
the rule.  

55. Repeat the steps to add more Check and Get type match conditions to the rule.  

56. If the check type is Link or Aggregate Link, repeat the necessary steps to add more match 
conditions to the rule and click OK. 

57. Click the link  of a rule to enter the rule test window. 

58. Enter the test content in the text box under Test Content, or import a configuration file from the 
configuration template database, and click Test.  
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After the test is complete, the test results show whether the content or configuration file 
matches the rule. You can judge whether the rule achieves your purpose according to the test 
results. To clear the test content and result, click Reset. 

59. To delete the rule, click the link  of the rule and click OK. 

Copying a compliance policy 

The extended compliance policies of the component cannot be copied. 

To copy a compliance policy: 

1. Navigate to Service > Compliance Policy. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Compliance Center on the left navigation tree. 

c. Click Compliance Policy under Compliance Center on the left navigation tree. 

The Policy List is displayed. 

2. Click the Copy icon  for the target compliance policy. 

The Copy Compliance Policy page opens. 

3. Enter a name in the Name field. 

The compliance policy name must be unique. 

4. Modify other parameters of the compliance policy. 

For more information, see "Creating a compliance policy." 

5. Click OK. 

Deleting a compliance policy 

1. Navigate to Service > Compliance Policy. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Compliance Center on the left navigation tree. 

c. Click Compliance Policy under Compliance Center on the left navigation tree. 

The Policy List is displayed. 

2. Click the link  of the policy to be deleted. A dialog box opens. 

3. Click OK. 

System Defined compliance policy cannot be deleted. Only User Defined compliance policy 
can be deleted. 

Enabling a single compliance policy 

1. Navigate to Service > Compliance Policy. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Compliance Center on the left navigation tree. 

c. Click Compliance Policy under Compliance Center on the left navigation tree. 

The Policy List is displayed. 

2. Click the Disabled link  of the compliancy policy to be enabled. 

Enabling all compliance policies 

1. Navigate to Service > Compliance Policy. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Compliance Center on the left navigation tree. 

c. Click Compliance Policy under Compliance Center on the left navigation tree. 

The Policy List is displayed. 
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2. Click Enable All. 

Disabling a single compliance policy 

1. Navigate to Service > Compliance Policy. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Compliance Center on the left navigation tree. 

c. Click Compliance Policy under Compliance Center on the left navigation tree. 

The Policy List is displayed. 

2. Click the Enabled link  of the compliancy policy to be disabled. 

Disabling all compliance policies 

1. Navigate to Service > Compliance Policy. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Compliance Center on the left navigation tree. 

c. Click Compliance Policy under Compliance Center on the left navigation tree. 

The Policy List is displayed. 

2. Click Disable All. 

Rule examples 
IMC predefines rules in a compliance policy. The following describes rules with the check type:  

 Device 

 Interface 

 Link 

 Aggregate Link 

 Configuration Segment 

A Device rule checks the configuration file or display command outputs on the device. For example, 
if a rule checks the Latest backup running configuration file, it checks all the contents of the 
Latest backup running configuration file. (HPA)Syslog enabled is used as an example. 

An Interface rule checks the configuration segments about interface in the configuration file or the 
configuration segments about interface in a display command output on the device. The start 
position and end position of the configuration segment are determined by Start Identifier and End 
Identifier in the rule. (Cisco) No delay an interface-CatOS is used as an example. 

A Link rule checks the configuration segments about interface in the configuration file or the 
configuration segments about interface in a display command output on the devices on the two ends 
of a link. The start position and end position of the configuration segment are determined by Start 
Identifier and End Identifier in the rule. A Link rule checks devices by link rather than by device. 
(HPA) Duplex status is used as an example. 

An Aggregate Link rule checks the configuration segments about interface in the configuration file 
or the configuration segments about interface in a display command output on the devices on the two 
ends of an Aggregate Link. The start position and end position of the configuration segment are 
determined by Start Identifier and End Identifier in the rule. An Aggregate Link rule checks 
devices by link rather than by device. (HPA) Speed status is used as an example. 

A Configuration Segment rule checks any configuration segment in the configuration file on the 
device. The start position and end position of the configuration segment are determined by Start 
Identifier and End Identifier in the rule. (HPA) Remote login is used as an example. 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 9023



622 

Viewing device rules 

The (HPA)Syslog enabled rule belongs to the Syslog compliance policy. It checks whether the 
device is enabled with the Syslog function. If the device is not enabled with the Syslog function, a 
fixing command is executed to enable the function. 

To check device compliance: 

1. Navigate to Service > Compliance Policy. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Compliance Center on the left navigation tree. 

c. Click Compliance Policy under Compliance Center on the left navigation tree. 

The Policy List is displayed. 

2. Enter Syslog in the Name field, and click Query. 

3. Click the name link of Syslog in the Policy List to enter the Compliance Policy Details page.  

For more information about the Compliance Policy Details page, see "Viewing detailed 
information about a compliance policy." 

4. Click the name link of (HPA)Syslog enabled in the Rule List to enter the Rule Details page.  

a. Checks whether the device is a Hewlett Packard device. If not, the rule does not check the 
device. If yes, the rule goes to the next step. 

b. Checks whether the device series belongs to Device Series. If not, the rule does not check 
the device. If yes, the rule goes to the next step. 

c. Checks whether the Latest backup running configuration file contains the undo 
info-center enable string. If not, the device is enabled with the Syslog function and 
conforms to the Compliance Policy. If yes, the device violates the Compliance Policy, 
and the rule goes to the next step. 

d. Executes the info-center enable command to enable the Syslog function on the device and 
ends the check. 

e. Repeats the previous steps to check all the devices in the check task. 

Viewing interface rules 

The (Cisco)No delay on interfaces-CatOS rule checks whether an interface delay is configured for 
an interface on the device. If yes, a fixing command is used to remove the interface delay 
configuration. 

To check interface delay configuration:  

1. Navigate to Service > Compliance Policy. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Compliance Center on the left navigation tree. 

c. Click Compliance Policy under Compliance Center on the left navigation tree. 

The Policy List is displayed. 

2. Enter Interface in the Name field, and click Query. 

3. Click the name link of Interface delay in the Policy List to enter the Compliance Policy 
Details page.  

For more information about the Compliance Policy Details page, see "Viewing detailed 
information about a compliance policy." 

4. Click the name link of (Cisco)No delay on interfaces-CatOS in the Rule List to enter the Rule 
Details page.  

a. Checks whether the device is a Cisco device. If not, the device is not checked. If yes, goes 
to the next step. 

b. Checks whether the device series belongs to Device Series. If not, the rule does not check 
the device. If yes, the rule goes to the next step. 
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c. Reads the Latest backup running configuration file on the device to check the 
configuration segment starting with interface and ending with !. If the configuration 
segment does not contain delay, the device conforms to the compliance policy. If the 
configuration segment contains delay, the rule goes to the next step. 

d. Executes the no delay command to remove the interface delay configuration and ends the 
check. 

e. Repeats the previous steps to check all the devices in the check task. 

Viewing link rules 

The (HPA) Duplex status rule checks whether the duplex modes on the devices on the two ends of 
a link are the same. If not, the check result is displayed to notify the administrator. 

To check duplex modes of devices: 

1. Navigate to Service > Compliance Policy. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Compliance Center on the left navigation tree. 

c. Click Compliance Policy under Compliance Center on the left navigation tree. 

The Policy List is displayed. 

2. Enter Link status in the Name field, and click Query. 

3. Click the name link of Link status in the Policy List to enter the Compliance Policy Details 
page.  

For more information about the Compliance Policy Details page, see "Viewing detailed 
information about a compliance policy." 

4. Click the name link of (HPA)Duplex status in the Rule List to enter the Rule Details page.  

a. Checks whether the device is a Hewlett Packard device. If not, the device is not checked. If 
yes, the rule goes to the next step. 

b. Checks whether the device series belongs to Device Series. If not, the rule does not check 
the device. If yes, the rule goes to the next step. 

c. Performs link calculation. If a device is not directly connected to any other device, the device 
is not checked. If only one device exists or no devices are directly connected, the rule ends 
the compliance check on all devices. Otherwise, the rule calculates links, reads description 
for interfaces connecting the two devices, and uses interface + interface description as a 
start identifier. Then the rule goes to the next step. 

d. Reads the Latest backup running configuration files on the devices on the two ends of a 
link, and checks whether the configuration segment starting with interface + interface 
description and ending with # contains duplex. If the configuration segment does not 
contain duplex, the two devices use the auto negotiated duplex mode and conform to the 
compliance policy. Otherwise, the rule goes to the next step. 

e. Checks whether the configuration segments contain duplex auto. If at least one 
configuration segment contains duplex auto, at least one device adopts the auto 
negotiated duplex mode, and the two devices conform to the compliance policy. Otherwise, 
the rule goes to the next step. 

f. Reads the values of duplex according to the regular expression duplex ?<value> from the 
configuration segments on the two devices and compares the values. If the values are the 
same, the duplex modes for the two devices are the same, and the two devices conform to 
the compliance policy. Otherwise, the two devices violate the compliance policy. The check 
result is displayed to notify the administrator. 

g. Ends the check on the two devices and repeats the previous steps to check devices on 
other links. 

Viewing aggregate link rules 

The (HPA) Speed status rule checks whether the flow control configurations on the devices on the 
two ends of a link are the same. If not, the check result is displayed to notify the administrator. 
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To check device flow control configuration: 

1. Navigate to Service > Compliance Policy. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Compliance Center on the left navigation tree. 

c. Click Compliance Policy under Compliance Center on the left navigation tree. 

The Policy List is displayed. 

2. Enter Aggregate Link status in the Name field, and click Query. 

3. Click the name link of Aggregate Link status in the Policy List to enter the Compliance 
Policy Details page.  

For more information about the Compliance Policy Details page, see "Viewing detailed 
information about a compliance policy." 

4. Click the name link of (HPA) Speed status in the Rule List to enter the Rule Details page.  

a. Checks whether the device is a Hewlett Packard device. If not, the device is not checked. If 
yes, the rule goes to the next step. 

b. Checks whether the device series belongs to Device Series. If not, the rule does not check 
the device. If yes, the rule goes to the next step. 

c. Performs link calculation. If a device is not directly connected to any other device, the device 
is not checked. If only one device exists or no devices are directly connected, the rule ends 
the compliance check on all devices. Otherwise, the rule calculates links, reads description 
for interfaces connecting the two devices, and uses interface + interface description as a 
start identifier. Then the rule goes to the next step. 

d. Reads the Latest backup running configuration files on the devices on the two ends of a 
link, and checks whether the configuration segment starting with interface + interface 
description and ending with # contains speed. If the configuration segment does not 
contain speed, the two devices do not restrict interface traffic and conform to the 
compliance policy. Otherwise, the rule goes to the next step. 

e. Reads the values of duplex according to the regular expression speed ?<value> from the 
configuration segments on the two devices and compares the values. If the values are the 
same, the two devices conform to the compliance policy. Otherwise, the rule goes to the 
next step. 

f. Checks whether the configuration segments contain speed auto. If at least one 
configuration segment contains speed auto, the two devices conform to the compliance 
policy. Otherwise, the two devices violate the compliance policy. The check result is 
displayed to notify the administrator. 

g. Ends the check on the two devices and repeats the previous steps to check devices on 
other links. 

Viewing configuration segment rules 

The (HPA)Remote login rule checks whether the remote login mode is SSH. 

To check remote login mode: 

1. Navigate to Service > Compliance Policy. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Compliance Center on the left navigation tree. 

c. Click Compliance Policy under Compliance Center on the left navigation tree. 

The Policy List is displayed. 

2. Enter Security in the Name field, and click Query. 

3. Click the name link of Security in the Policy List to enter the Compliance Policy Details 
page.  

For more information about the Compliance Policy Details page, see "Viewing detailed 
information about a compliance policy." 
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4. Click the name link of (HPA)Remote login in the Rule List to enter the Rule Details page.  

a. Checks whether the device is a Hewlett Packard device. If not, the device is not checked. If 
yes, goes to the next step. 

b. Checks whether the device series belongs to Device Series. If not, the rule does not check 
the device. If yes, the rule goes to the next step. 

c. Reads (user-interface){1}|#{1} in the latest backup running configuration file, and uses the 
read parameter as the end identifier. If no parameter is read, ends the check on the device. 
Otherwise, the rule goes to the next step. 

d. Checks the configuration segment starting with user-interface vty and ending with 1, 2, or 
3, for example. If the configuration segment contains protocol inbound ssh, the device 
conforms to the compliance policy, and the rule ends the check on the device. If the 
configuration segment does not contain protocol inbound ssh, the device violates the 
compliance policy. The check result is displayed to notify the administrator that the device 
violates the compliance policy. 

e. Repeats the previous steps to check all the devices in the check task. 

Using check tasks 
A check task is used to check the policy compliancy of a device based on the association between a 
compliance policy with the device and parameters such as the check severity level and execution 
period.  

The following information provides details about check tasks. 

Viewing the check task list 

1. Navigate to Service > Check Task. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Compliance Center on the left navigation tree. 

c. Click Check Task under Compliance Center on the left navigation tree. 

The Task List is displayed. 

Task list 

 Status—Contains status of the check task, which can be Finished, Enabled, Disabled, or 
Running. If a task is finished, Finished is displayed. A task in Enabled state is executed 
automatically at an interval, and a task in Disabled state is not. Only periodic check tasks 
can be in Enabled or Disabled state. A task being executed is in Running state. 

 Task Name—Contains name of the check task. Clicking a check task name link, you enter 
the check task details page. 

 Execute Task—Contains type of the check task, which can be Periodically or 
Immediately. A Periodically task is executed periodically as scheduled. An Immediately 
task is executed immediately, but only once. 

 Creation Time—Contains time when the check task was created. 

 Operation—Indicates whether the task is enabled ( Disabled) or disabled ( Enabled) 
when the task is periodic, and lets you disable or enable the task by clicking the status link. 
For a task in Running or Finished state, nothing is displayed in this field.  

 Check Results—Highest violation level of the device. Violation levels are set when you 
create a rule. When you point to a violation level name, a popup window displays, showing 
the counts of each violation level. You can click the level name link to enter the Task 
Execution Results page. 

 Fix—Click the link  to enter the page for fixing violations. For more information about 
violation fixing, see "Fixing violating devices." 
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 Modify—Contains a link  for modifying the associated check task. This link is displayed 
when the value of the Execute Task field is Periodically. 

 Copy—Click the Copy icon  to copy the associated check task. The policy information 
and device information of the current task can be copied. Based on the copied information, 
you can create a new check task.  

 History—Contains a link for checking the execution results and history of the check task. 

When you click the link , a menu appears, providing the following options:  

 Task Check Results (Compliance Policy) 

 Task Check Results (Device) 

 Export Task Check Results 

 Task History 

If the device is compliant with the policy, only the Task History option is displayed on the 
menu. The Export Task Check Results option allows you to export the compliance check 
task results as reports to the local device The Task Check Results (Compliance Policy) 
option shows you the check results in policy view for analysis from the compliance policy's 
perspective. The Task Check Results (Device) option shows you the check results in 
device view for analysis from the device's perspective. For more information about the 
check result reports, see "Using the task execution results, task execution report, and 
configuration retrieval report." 

If the Task List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Task List. 

 Click  to page forward to the end of the Task List. 

 Click  to page backward in the Task List. 

 Click  to page backward to the front of the Task List. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

You can sort the Task List by the Status, Task Name, Execute Task, and Creation Time 
fields. Click the column label to sort the list by the selected field. The column label is a toggle 
switch that lets you toggle between the various sort options specific to each field. 

Viewing check task details 

1. Navigate to Service > Check Task. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Compliance Center on the left navigation tree. 

c. Click Check Task under Compliance Center on the left navigation tree. 

The Task List is displayed. 

2. Click the Task Name link of the target check task to enter the Task Details page. 

The Task Details page includes three parts: Task Attribute, Compliance Policy 
Information, and Device Information. The following describes these parts in detail. 

Task attribute  

 Task Name—Contains the name of the check task.  

 Severity—Controls which rules to execute. Only rules with a severity level equal to or higher 
than the value of this argument are executed. 

 Execute Task—Contains the execution type of the check task, which can be Periodically or 
Immediately. 
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 Start Time—Start time of the check task. This argument is displayed only when the value of the 
Execute Task field is Periodically.  

 Description—Contains a description of the check task. 

 Receiver's Mail Address—Contains the address of the mail recipient to which the check task 
result report is sent. This field is not displayed if the Not send check task result report option 
is selected on the check task configuration page.  

Compliance policy information  

 Name—Contains the name of the compliance policy added to the check task. Click the 
compliance policy name link to enter the compliance policy details page. For more information 
about compliance policy details, see "Viewing detailed information about a compliance policy." 

 Description—Contains a description of the compliance policy. 

Device information  

 Status—Contains the alarm status of the device. If there are multiple alarms for the device, the 
status of the highest level is displayed. 

 Device Name—Contains the name of the device. Click the name link to enter the device details 
page. For more information about device details, see "Accessing the device details page." 

 IP Address—Contains the IP address of the device.  

 Device Model—Contains the model of the device.  

 Device Source—Contains the source of the device.  

Query check tasks 

1. Navigate to Service > Check Task. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Compliance Center on the left navigation tree. 

c. Click Check Task under Compliance Center on the left navigation tree. 

The Task List is displayed. 

2. Enter a partial or complete task name in the field in the upper right corner of the Task List. 

3. Click . 

The task list display all check tasks that match the query criterion. 

Adding a check task 

1. Navigate to Service > Check Task. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Compliance Center on the left navigation tree. 

c. Click Check Task under Compliance Center on the left navigation tree. 

The Task List is displayed. 

2. Click Add to enter the Add Check Task page. 

3. Enter a name in the Task Name field.  

The name can be a string of 1 to 32 characters. 

4. Select a level from the Severity list.  

Options include All, Above Informational, Above Warning, Above Minor, and Above Major.  

This argument controls which rules to execute. Only rules with a severity level equal to or higher 
than the value of this argument are executed. 

5. Configuration check tasks can be run immediately or they can be scheduled to run on a periodic 
basis: 

 To run the task immediately, select Immediately from the Execute Task list.  
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 To create a task that runs periodically, select Periodically from the Execute Task list. 

If you selected Periodically, the Task Attribute page of the Add Check Task wizard updates 
with fields to schedule the task. 

6. Select the frequency with which you want to run this check task by selecting it from the Start 
Time list: 

 If you select Every Week, select the day of the week from the list next to the Start Time 
list. 

 If you select Every Month, select the date of the month from the list next to the Start Time 
list. 

7. Enter the time of day that you want the check task to begin by entering it in the field next to the 
Start Time list.  

The valid format for time entry is HH:MM:SS where HH denotes the two digit hour, MM denotes 
the two digit minute, and SS denotes the two digit second. 

8. Enter a brief description for this task in the Description field.  

A valid length for the description is 0-128 characters. 

9. Set whether to send the check task result report to the designated mail recipient. Options are: 

 Not send check task result report—Do not send any report. This is the default setting. 

 Send check task result report upon failure—Send the report only when one or more 

devices failed to pass the compliance check.  

 Send check task result report—Send the report each time the check task is executed, 

regardless of the task result.  

10. Specify the address of the mail recipient in the Receiver's Mail Address field. This field is 
required only when Send check task result report upon failure or Send check task result 
report is selected. 

11. In the Compliance Policy List area, click Add. Select the compliance policies to be executed 
and click OK.  

12. Click the link for a compliance policy to enter the policy's details page. 

13. To cancel the association of a compliance policy with the task, click the Delete icon , or you 
can select the target compliance policy and click Delete. To delete all the compliance policies, 
check the box next to Name, and click Delete. 

Click OK in the confirmation dialog box. 

14. To select devices, you can do so from all devices, select device models and then exclude the 
devices that you do not want to check, or directly select custom views: 

a. Select Select Device under Select Devices or Device Models and then click Select 
Device. The Select Devices dialog box opens. 

b. Add devices by View or by the Advanced query method.  

For more information, see "Adding devices by view" and "Adding devices by advanced 
query." 

c. Click Select Device Model under Select Devices or Device Models and then click Select 
Device. The Device Model dialog box opens. 

Select one or more series names, and click OK. 

d. Click Select View under Select Devices or Device Models and then click the Select View 
button. On the window that opens, select custom views in the system to select devices in 
these views.  

15. Click OK. 

Modifying a check task 

Only the tasks for which Periodically is selected from the Execute Task list can be modified. 

To modify a check task: 
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1. Navigate to Service > Check Task. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Compliance Center on the left navigation tree. 

c. Click Check Task under Compliance Center on the left navigation tree. 

The Task List is displayed. 

2. Click the Modify icon  for a task. 

The Modify Check Task page opens. Only the Start Time, Description, and Select Devices 
or Device Models fields can be modified. 

3. Select the frequency with which you want to run this check task by selecting it from the Start 
Time list: 

 If you select Every Week, select the day of the week from the list next to the Start Time list. 

 If you select Every Month, select the day of the month from the list next to the Start Time 
list. 

4. Enter the time of day that you want the check task to begin by entering it in the field next to the 
Start Time list.  

The valid format for time entry is hh:mm:ss where hh denotes the two digit hour, mm denotes 
the two digit minute, and ss denotes the two digit second. 

5. Enter a brief description for this task in the Description field. 

A valid length for the description is 0–128 characters. 

6. Set whether to send the check task result report to the designated mail recipient. Options are: 

 Not send check task result report—Do not send any report. This is the default setting. 

 Send check task result report upon failure—Send the report only when one or more 

devices failed to pass the compliance check. Specify the address of the mail recipient in the 
Receiver's Mail Address field. 

 Send check task result report—Send the report each time the check task is executed, 

regardless of the task result. Specify the address of the mail recipient in the Receiver's Mail 
Address field. 

7. Specify the address of the mail recipient in the Receiver's Mail Address field. This field is 
required only when Send check task result report upon failure or Send check task result 
report is selected. 

8. To select devices, you can do so from all devices, select device models and then exclude the 
devices that you do not want to check, or directly select custom views: 

a. Select Select Device under Select Devices or Device Models and then click Select 
Device. The Select Devices dialog box opens. 

b. Add devices by View or by the Advanced query method.  

For more information, see "Adding devices by view" and "Adding devices by advanced 
query." 

c. Click Select Device Model under Select Devices or Device Models and then click Select 
Device. The Device Model dialog box opens. 

Select one or more series names, and click OK. 

d. Click Select View under Select Devices or Device Models and then click the Select View 
button. On the window that opens, select custom views in the system to select devices in 
these views. 

9. Click OK. 

Copying a check task 

1. Navigate to Service > Check Task. 

a. Click the Service tab from the top tabular navigation system. 
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b. Click Compliance Center on the left navigation tree. 

c. Click Check Task under Compliance Center on the left navigation tree. 

The Task List is displayed. 

2. Click the Copy icon  for a task. 

The page for copying the check task opens. 
 

 NOTE: 

 If the compliance policy in the source check task has been deleted from IMC, the compliance 
policy is not copied to the new check task. 

 If the compliance policy in the source check task has not been enabled in IMC, the compliance 
policy is not copied to the new check task. 

 If the devices in the source check task have been deleted from IMC, the devices are not copied 
to the new check task. 

 

3. Enter a name in the Task Name field. 

The check task name must be unique. 

4. Modify other parameters of the check task. 

5. Click OK. 

Deleting a check task 

1. Navigate to Service > Check Task. 

a. Click the Service tab from the top tabular navigation system. 

b. Click the Compliance Center on the left navigation tree. 

c. Click Check Task under Compliance Center on the left navigation tree. 

The Task List is displayed. 

2. Select the target check task, or select the checkbox to the left of Status to select all check 
tasks. 

3. Click Delete to delete the selected check tasks. 

Fixing violating devices 
IMC provides the function of fixing the violating devices. The operator can enter a fix command, and 
set the execution time of the fix task.  

When the time is reached, IMC deploys the fix task to the device and executes the fix command on 
the device. This increases the fix task efficiency and reduces the operator workload. 

To fix violating devices: 

1. Navigate to Service > Check Task. 

2. Click the Service tab from the top tabular navigation system.  

3. Click Compliance Center on the left navigation tree. 

4. Click Check Task under Compliance Center on the left navigation tree. 

The Task List is displayed. 

5. Click the corresponding link  of the target check task to enter the rule violation preview page. 

The link  is displayed only when the check task is completed and violating devices are 
detected. 

Stack devices do not support the fix task. 
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The rule violation preview is displayed in a tree structure of Device > Compliance Policy > 
Rule.  

6. Do one of the following: 

 To collapse a compliance policy, click the link  to the left of the device name. 

 To expand a compliance policy, click the link  to the left the compliance policy.  

 To collapse rules, click the link  to the left of the compliance policy.  

 To expand rules, click the link . 

 Name—Contains names of devices, compliance policies, and rules. 

 Description—Contains detailed information about the violations of the device and number 
of violations for each violation severity level for a device or compliance policy. You can know 
which check contents are not compliant with the rules and the match criteria for the rules. 

7. Do one of the following: 

 To enter the rule information page, click a rule name link. 

 To enter the check task detailed information page, click the Check Content link. 

8. Do one of the following: 

 To select the violation contents of a rule, select the checkbox  to the left of the rule name. 

 To select the violation contents of a compliance policy, select the checkbox  to the left of 
the compliance policy. 

 To select all the violation contents of a device, select the checkbox  to the left of the 
device name. 

 To select the violation contents of all devices on the current page, select the checkbox  to 
the left of the Name field. 

 To select the violation contents for all devices, select the checkbox  next to Fix All 
Devices in the upper right of the page. 

9. Select 8, 15, or 50 from the right side of the main pane to configure how many items per page 
you want to view. 

10. Click Fix to enter the Fixing Commands page. 

11. Use the default Running Configuration for the Type to be Deployed field, and select the 
deployment strategy for the fixing commands: 

 View the change before and after deployment—With this option, IMC displays the 

configuration changes contained in the template you have selected before and after the 
changes have been applied. 

 Deployment Stopped. The configuration running on the device is not consistent with 

the latest running configuration backed up by IMC—With this option, IMC stops 

deploying a configuration file if the device's current running configuration does not match 
the most current running configuration file IMC has for the device. 

 Before deployment, back up the device's running configuration to IMC—With this 

option, IMC makes a backup copy of the running configuration of all devices configured to 
receive the configuration template. This option provides the operator with a copy of the most 
current running configuration for backing out of the configuration template deployment if 
problems occur. 

 Before deployment, save the device's running configuration as a startup 

configuration—With this option, IMC makes a backup copy of the running configuration of 

all devices and saves it as the startup configuration to the device. This option also provides 
the operator with a current startup configuration for backing out of the configuration 
template deployment if problems occur. 

 After deployment, back up the device's running configuration to IMC—This option 

instructs IMC to copy the new running configuration to IMC. 
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 After deployment, save the device's running configuration as a startup configuration

—This option instructs IMC to save the device's running configuration as the new startup 

configuration to IMC after deployment is complete. 

12. Enter the command for fixing the device in the text box under the device name. The variables 
such as $ are not supported. For example, a fixing command cannot contain ${ip address}. 

13. Select the checkbox  next to the target device to cancel fixing the device. 

14. Click Next to enter the Set Task Attributes page. 

15. Enter a name for this task in the Task Name field. 

16. Select the time you want IMC to execute this task from the Schedule Time list.  

Options include Immediately and Scheduled. If you selected Immediately, go to step 26. 

17. If you selected Scheduled, click the Calendar icon  to populate the date and time for the 
execution of this task. A popup calendar is displayed. Select the date from the calendar. Enter 
the start time in the box next to the Time field on the lower part of the calendar window, in the 
format of HH:MM. 

Valid date and time format for this field is YYYY-MM-DD hh:mm:ss where YYYY denotes the 
four digit year, MM denotes the two digit month, DD denotes the two digit day and hh denotes 
the two digit hour, mm denotes the two digit minute and ss denotes the two digit second value.  

18. Select the sequence to execute the fixing task from the Schedule Sequence list. 

Two options are available: Concurrent and Sequential. If you select Concurrent, IMC can fix 
multiple devices simultaneously. If you select Sequential, IMC can only fix one device at a time. 

If you select Sequential from the Schedule Sequence list, you need to set the sequence to fix 
the devices, and IMC fixes the devices based on the sequence you set. 

19. Click Sort next to the Schedule Sequence list. The Sort dialog box opens. 

20. Click the checkbox  to the left of the devices you want to move. 

21. Do one of the following: 

 Click Up to move the devices up in the list. 

 Click Down to move the devices down in the list. 

22. Do one of the following: 

 Click Top to move the devices to the top of the list. 

 Click Bottom to move the devices to the bottom of the list. 

23. Click OK when you have finished sorting the devices in the list. 

24. If you select Sequential from the Schedule Sequence list, you can define how you want IMC 
to handle errors that arise in the deployment process. 

25. If errors occur in the fixing process and you want to stop the fixing task on all devices, select 
Stop Deployments on All Devices from the Error Handling list. 

26. If errors occur in the fixing process and you want to skip the fixing task on the current device and 
continue with other devices, select Stop Deployment on the Current Device from the Error 
Handling list. 

27. Enter the task description in the box next to Task Description. 

28. Click Finish. 

29. Go to the Service > Deployment Task page. The new fixing tasks are displayed in the 
deployment task list. For more information about task deployment, see "Accessing the 
deployment task list." 

Using check task history 
The check task execution results and violations are displayed in a report. Task check results 
(compliance policy), task check results (device), task execution report, and rule extract report are 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 9034



633 

available. At the same time, the device violating results are sent to the network administrator in the 
form of alarms. 

Viewing check task history 

1. Navigate to Service > Task History. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Compliance Center on the left navigation tree. 

c. Click Task History under Compliance Center on the left navigation tree. 

The Task History List is displayed. 

Task history list 

 Task Name—Contains name of the check task. You can enter the check task details page 
by clicking the task name link. 

 Description—Contains description for the check task. 

 Start Time—Contains the time when the check task starts to run. 

 End Time—Contains the time when the check task stops running. 

 Execution Result—Contains execution result of the check task. You can click an execution 
result link to enter the View Execution Result page. The page displays all the devices 
concerned, start and end time, and execution result of the check task. 

 Operation 

 Compliance Policy Check Results 

To enter the Compliance Policy Check Results page, click . On the page, you can 
filter the compliancy policy check information based on the policy check result.  

 Device Violating Results 

To enter the Device Violating Results page, click . On the page, the violating 
interfaces are listed, and the interface check information can be exported.  

 Configuration Check Report 

To enter the Configuration Check Report page, click . 

 Configuration Retrieval Report 

To enter the Configuration Retrieval Report page, click . 

If the Task History List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Task History List. 

 Click  to page forward to the end of the Task History List. 

 Click  to page backward in the Task History List. 

 Click  to page backward to the front of the Task History List. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

You can sort the Policy List by the Task Name, Description, Start Time, End Time, and 
Execution Result fields. Click the column label to sort the list by the selected field. The column 
label is a toggle switch that lets you toggle between the various sort options specific to each 
field. 

Querying check task history 

1. Navigate to Service > Task History. 
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a. Click the Service tab from the top tabular navigation system. 

b. Click Compliance Center on the left navigation tree. 

c. Click Task History under Compliance Center on the left navigation tree. 

The Task History List is displayed. 

2. Enter a task name in the field in the upper right corner of the Task History List, and click the 

Search icon , or click the Advanced icon  located in the upper right corner of the page. 

The search criteria dialog box opens. 

3. Enter one or more of the following search criteria in the Query section of the page: 

 Task Name—To locate a check task name, enter a partial or complete name for the task in 
the Check Task Name field. 

 Time Range—To view tasks for a specific time range, enter the start of your time range in 
the From field. Valid date and time format for this field is YYYY-MM-DD hh:mm:ss where 
YYYY denotes the four digit year, MM denotes the two digit month, DD denotes the two digit 
day and hh denotes the two digit hour, mm denotes the two digit minute and ss denotes the 
two digit second value. 

4. To auto populate the from field, click the Calendar icon  next to the from field. A popup 
calendar is displayed. Select the start date from the calendar. Enter the start time in the box 
next to the Time field on the lower part of the calendar window, in the format of hh:mm. 

5. Enter the end time for the range in the to field. To auto populate the to field, click the Calendar 
icon  next to the to field. A popup calendar is displayed. Select the end date from the 
calendar. Enter the start time in the box next to the Time field on the lower part of the calendar 
window, in the format of hh:mm. 

6. Valid date and time format for this field is YYYY-MM-DD hh:m:ss where YYYY denotes the four 
digit year, MM denotes the two digit month, DD denotes the two digit day and hh denotes the 
two digit hour, mm denotes the two digit minute and ss denotes the two digit second value. 

7. Click Query to submit your filter criteria. 

The results of your filter or search query display in the Task History List. 

8. Click Reset when you want to restore the full Task History. 

Deleting check task history 

1. Navigate to Service > Task History. 

a. Click the Service tab from the top tabular navigation system. 

b. Click Compliance Center on the left navigation tree. 

c. Click Task History under Compliance Center on the left navigation tree. 

The Task History List is displayed. 

2. Click the checkbox  to the left of the target check task, or click the checkbox  to the left of 
Task Name to select the history for all check tasks. 

3. Click Delete. A confirmation dialog box opens. Click OK. 

Using the task execution results, task execution report, and 
configuration retrieval report 

The Task Execution Results are displayed in a report. The report shows the check task execution 
results and the device violating results. At the same time, the device violating results are sent to the 
network administrator in the form of alarms.  

 Compliance Policy Check Results—Lets you view the execution result of a check task in a 
policy compliance report, which shows the check result of the rules in each policy contained in 
the check task. 
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 Device Violating Results—Lets you view the execution result of a check task in a device 
violation report, which shows the check result of the task on each device and information about 
the unchecked devices. 

 Configuration Check Report—Lets you view the execution report of a check task. The report 
shows the policy compliance and the check result of each rule. 

 Configuration Retrieval Report—Lets you view the report received after execution of a check 
task. The report shows the result of each rule on all devices associated with the check policy. 

The following reports are described in detail: 

 Task Execution Results 

 Compliance Policy Check Results 

 Device Violating Results 

 Configuration Check Report 

 Configuration Retrieval Report 

Viewing task execution results 

1. Navigate to Service > Check Task. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Compliance Center on the left navigation tree. 

c. Click Check Task under Compliance Center on the left navigation tree. 

The Task List is displayed. 

2. Click the violation level link in the Check Results column to enter the Task Execution Results 
page. 

The check task information is displayed in the upper left part of the report. 

 Task Name—Contains the name of the check task. 

 Creator—Contains the operator that created the check task. 

 Violating Devices—Contains the number of violating devices. 

 Vulnerability Sum—Contains the number of violations. 

 Task Description—Contains a description for the check task. 

The information is displayed in the upper right part of the report. 

The lower part of the report contains four areas:  

 Device Check Information 

 Compliance Policy Check Information 

 Severity Level 

 Level Description 

Device Check Information 

Number of violations for each device and for each violation severity level is displayed in a form. 

3. Click the device name link to enter the Device Violating Results page. 

 Task Name—Contains the name of the check task. 

 Check Time—Contains the time when the device violated the compliance policy. 

 Task Description—Contains a description for the check task. 

The Device Check Information area displays the detailed information about compliance 
policy violation by device. 

 Device Name—Contains the name of the device. 

 Description—Contains the detailed information about the violations of the device and 
number of violations for each violation severity level. You can click a rule name link to enter 
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the Rule Content window and click the checked content link to enter the Check Content 
window. 

4. Do one of the following: 

 To collapse the compliance policy, click  to the left of the device name. 

 To expand the compliance policy, click . 

If the Device Check Information List spans multiple pages, use the following aids to navigate 
the list: 

 Click  to page forward in the Device Check Information List. 

 Click  to page forward to the end of the Device Check Information List. 

 Click  to page backward in the Device Check Information List. 

 Click  to page backward to the front of the Device Check Information List. 

5. Select 8, 15, or 50 from the right side of the main pane to configure how many items per page 
you want to view. 

6. Click  the upper left corner to return to the Task Execution Results page. 

Compliance policy check information  

 Policy Name—Contains the name of the compliance policy. To enter the compliance policy 
check result page, click the target compliance policy. 

 Total Devices—Contains the number of devices that violate the compliance policy. 

 Violating Devices—Contains the name of each device that violates the compliance policy. 
To enter the Device Violating Results page, click the target device. 

7. Click the target compliance policy to enter the Compliance Policy Check Results page. 

The check task information is displayed in the upper left part of the report. 

 Task Name—Contains the name of the check task. 

 Check Time—Contains the time when the device violated the compliance policy. 

 Task Description—Contains the description on the check task. 

The Compliance Policy Check Information area displays the detailed information about 
compliance policy violation by compliance policy: 

 Compliance Policy Name—Contains the name of the compliance policy. 

 Rules—Contains the number of rules contained in the compliance policy. 

 Check Result—Contains the violation status of the device associated with the compliance 

policy.  means the device does not violate the compliance policy.  means the 
device violated the compliance policy. 

 Violations—Contains the total number of violations for all devices. 

 Violating Devices—Contains the number of violating devices. 

 Severity level—For a compliance policy, this field displays the highest violation severity 
level among the rules. For a rule, this field displays the violation severity level for the rule. 

8. Do one of the following: 

 To collapse the rules, click  to the left of the compliance policy. 

 To expand the rules, click . 

9. Do one of the following: 

 To collapse the devices, click  to the left of the rule name. 

 To expand the devices, click . 
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If the Compliance Policy Check Information List spans multiple pages, use the following 
aids to navigate the list: 

 Click  to page forward in the Compliance Policy Check Information List. 

 Click  to page forward to the end of the Compliance Policy Check Information List. 

 Click  to page backward in the Compliance Policy Check Information List. 

 Click  to page backward to the front of the Compliance Policy Check Information 
List. 

10. Select 8, 15, or 50 from the right side of the main pane to configure how many items per page 
you want to view. 

11. Click  in the upper left corner to return to the Task Execution Results page. 

The Severity level area displays the number of violating devices for each severity level and the 
names of the violating devices. 

The Level description area describes the impact of violations for each severity level to the 
network. 

Viewing compliance policy check results 

1. Navigate to Service > Task History. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Compliance Center on the left navigation tree. 

c. Click Task History under Compliance Center on the left navigation tree. 

The Task History List is displayed. 

2. Click  in the Operation column of the target check task to enter the Compliance Policy 
Check Results page. 

The check task information is displayed in the upper left part of the report. 

 Task Name—Contains the name of the check task. 

 Creator—Contains the username of the operator that created the check task. 

 Violating Devices—Contains the number of violating devices. 

 Vulnerability Sum—Contains the number of violations. 

 Task Description—Contains a description for the check task. 

The number of violations for each severity level is displayed in a form in the upper right part of 
the report. 

The Compliance Policy Check Information area displays the violation information by 
compliance policy: 

 Compliance Policy Name—Contains the name of the compliance policy. 

 Rules—Contains the number of rules contained in the compliance policy. 

 Check Result—Contains the violation status of the device associated with the compliance 

policy.  means the device does not violate the compliance policy.  means the 
device violated the compliance policy. 

 Violations—Contains the total number of violations for all devices. 

 Violating Devices—Contains the number of violating devices. 

 Severity Level—For a compliance policy, this field displays the highest violation severity 
level among the rules. For a rule, this field displays the violation severity level for the rule. 

3. Do one of the following: 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 9039



638 

 To collapse the rules, click  to the left of the compliance policy. 

 To expand the rules, click . 

4. Do one of the following: 

 To collapse the devices, click  to the left of the rule name. 

To expand the devices, click . 

If the Compliance Policy Check Information List spans multiple pages, use the following 
aids to navigate the list: 

 Click  to page forward in the Compliance Policy Check Information List. 

 Click  to page forward to the end of the Compliance Policy Check Information List. 

 Click  to page backward in the Compliance Policy Check Information List. 

 Click  to page backward to the front of the Compliance Policy Check Information 
List. 

5. Click 8, 15, or 50 from the right side of the main pane to configure how many items per page you 
want to view. 

Viewing device violating results 

1. Navigate to Service > Task History. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Compliance Center on the left navigation tree. 

c. Click Task History under Compliance Center on the left navigation tree. 

The Task History List is displayed. 

2. Click  in the Operation column of the target check task to enter the Device Violating 
Results page. 

The check task information is displayed in the upper left part of the report, including: 

 Task Name—Name of the check task. 

 Creator—Username of the operator that created the check task. 

 Violating Devices—Number of violating devices. 

 Vulnerability Sum—Number of the violations for all devices associated with the 
compliance policy. 

 Task Description—Description for the check task. 

Number of violations for each severity level is displayed in a form in the upper right part of 
the report. 

The Device Check Information area displays the detailed violation information by device: 

 Device Name—Name of the device. 

 Description—For a device, this field displays the number of violations for each violation 
severity level. For a compliance policy, this field displays the name of the rule that the device 
violates and the violation content. To view the detailed rule information, click the rule name 
link. To view the configuration file on the device, click the Checked Content link. 

3. Do one of the following: 

 To collapse the compliance policies, click  to the left of the device name. 

 To expand the compliance policies, click . 

The Check Failure Devices area displays the check failure devices and check task execution 
results. 

The Skipped Devices area displays information about the skipped devices and the reasons. 
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If the Device Check Information List spans multiple pages, use the following aids to navigate 
the list: 

 Click  to page forward in the Device Check Information List. 

 Click  to page forward to the end of the Device Check Information List. 

 Click  to page backward in the Device Check Information List. 

 Click  to page backward to the front of the Device Check Information List. 

4. Click 8, 15, or 50 from the right side of the main pane to configure how many items per page you 
want to view. 

Viewing configuration check report 

1. Navigate to Service > Task History. 

2. Click the Service tab from the top tabular navigation system.  

3. Click Compliance Center on the left navigation tree. 

4. Click Task History under Compliance Center on the left navigation tree. 

The Task History List is displayed. 

5. Click  in the Operation column of the target check task to enter the Configuration Check 
Report page. 

The number of violations is displayed in a form on the upper part of the report. 

 Device Name—Contains the name of the device. 

 Match State—Whether the device matches the rules. If not, Breach is displayed. If yes, 
Match is displayed. 

 Breach Count—Contains the number of the violations for each violation level. 

 Match Count—Contains the number of rules that the device matches. 

 Check Time—Time when IMC applied the check task to the device. 

 Details—Contains the link for displaying detailed violation information for the device. You 
can click the Details link to enter the detailed information page. The Details link is displayed 
only when the device violates a compliance policy. 

To perform a query, enter a text in the text box next to the Search icon  located on the 
toolbar at the top of the report, and then click the Search icon . The page that contains the 
text opens. 

6. Click the Details link of the target device to enter the details page of the device. 

Number of violations and number of matches for each violation severity level, and total number 
of violations and matches are displayed in a form on the upper part of the page. 

The rule information and violation status of the device are displayed on the lower part of the 
page. 

 Rule Name—Contains the name of the rule. 

 Description—Contains a description on the rule. 

 Match State—Whether the device matches the rules. If not, Breach is displayed. If yes, 
Match is displayed. 

 Rule Level—Contains the violation severity level of the rule. 

You can export the execution result report to a local file or print the report to a .pdf file. 

To export the report: 

1. Click the Export icon  located on the toolbar at the top of the report. 
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2. Select the desired export file format from the File Format list.  

Options include:  

 PDF 

 XLS 

 CSV 

 DOCX 

 RTF 

 XLSX 

 PPTX 

3. Select the desired page range from Page Range. 

4. Click Export. 

To print the report to a .pdf file: 

1. Click the Print icon  located on the toolbar at the top of the report. 

2. Select the desired page range from Page Range. 

3. Click Export. 

Viewing configuration retrieval report 

1. Navigate to Service > Task History. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Compliance Center on the left navigation tree. 

c. Click Task History under Compliance Center on the left navigation tree. 

The Task History List is displayed. 

2. Click  in the Operation column of the target check task to enter the Rule Extract Report 
page. 

 Rule Name—Contains the name of the rule. 

 Rule Description—Contains a description for the rule. 

 Extract Device Count—Contains the number of devices from which values are extracted. 

To perform a query, enter a text in the text box next to the Search icon  located on the 
toolbar at the top of the report, and then click the Search icon . The page that contains the 
text opens. 

You can export the execution result report to a local file or print the report to a .pdf file. 

To export the report: 

1. Click the Export icon  located on the toolbar at the top of the report. 

2. Select the desired export file format from the File Format list.  

Options include:  

 PDF 

 XLS 

 CSV 

 DOCX 

 RTF 

 XLSX 

 PPTX 

3. Select the desired page range from Page Range. 

4. Click Export. 
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To print the report to a .pdf file: 

1. Click the Print icon  located on the toolbar at the top of the report. 

2. Select the desired page range from Page Range. 

3. Click Export. 

Using the display command to perform a configuration check 
IMC provides a feature that lets you check the results of a device's display command results against 
defined rules. You can create a display command configuration that contains the specific display 
command for which you want to test. You then create a rule and a compliance policy to compare 
against the output of the display command. By using the Check Task feature, you create a check 
task that tests the output of the display command against the rule to identify any violations in the 
display commands output. 

Accessing the configuration check display command list 

1. Navigate to Service > Display Command. 

a. Click the Service tab from the top tabular navigation system.  

b. Click Compliance Center on the left navigation tree. 

c. Click Display Command under Compliance Center on the left navigation tree.  

The Display Command List is displayed. 

Display command list 

 Name—Contains the name of the display command. The contents of this field serve as a 
link for navigating to the Detail page for the associated display command. 

The Detail page provides you with basic display command information including name, 
description, and display command content.  

 Description—Contains a description for the display command.  

 Creation Time—Contains a date and time stamp for the creation of the associated display 
command. 

 Modify—Contains a Modify icon  for modifying the associated configuration check rule. 

 Copy—Contains a Copy icon  for copying the associated configuration check rule. 

 Delete—Contains a Delete icon  for deleting the associated configuration check rule. 

You can sort the Display Command List by the Name, Description, and Creation Time 
fields. Click the column label to sort the list by the selected field. The column label is a toggle 
switch that lets you toggle between the various sort options specific to each field. 

If the Display Command List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Display Command List. 

 Click  to page forward to the end of the Display Command List. 

 Click  to page backward in the Display Command List. 

 Click  to page backward to the front of the Display Command List. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

Adding a configuration check display command 

1. Navigate to Service > Display Command. 
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a. Click the Service tab from the top tabular navigation system.  

b. Click the Compliance Center on the left navigation tree. 

c. Click Display Command under Compliance Center on the left navigation tree.  

The Display Command List is displayed. 

2. Click Add. 

3. Enter a name for the display command in the Name field.  

Display Command names cannot begin or end with a period (.). Spaces in the configuration 
template name are also not permitted. In addition, the characters in Table 47 are not permitted 
in a display command file name. 

Table 47 Invalid characters 

Character Name Character Name 

* Asterisk ' Apostrophe or single quotation 

| Vertical bars : Colon 

\ Backslash " Double quotation 

/ Forward slash < > Angle brackets 

? Question mark   
 

4. Enter a description for the display command in the Description field. 

5. Enter the display command in the Content field.  

For example, the following command displays the SNMP read community string on a 3Com 
switch. 
display snmp-agent community read 

6. Click OK to create the display command.  

After you create a display command list, you can select a display command from the created 
display command list when you select Display command output from the Check Target list. 

Modifying configuration display commands 

1. Navigate to Service > Display Command. 

a. Click the Service tab from the top tabular navigation system.  

b. Click the Compliance Center on the left navigation tree. 

c. Click Display Command under Compliance Center on the left navigation tree.  

The Display Command List is displayed. 

2. Click the Modify icon  in the Modify field of the display command you want to modify. 

You cannot modify the name of a display command once you have created it.  

To rename it, you must delete the existing display command and re-create it. 

3. Modify the description for the display command in the Description field.  

4. Modify the display command in the Content field as needed. 

5. Click OK to accept your modifications to the display command. 

Deleting configuration display commands 

1. Navigate to Service > Display Command.  

a. Click the Service tab from the top tabular navigation system.  

b. Click the Compliance Center on the left navigation tree. 

c. Click Display Command under Compliance Center on the left navigation tree.  

The Display Command List is displayed. 
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2. Click the Delete icon  in the Delete field of the display command you want to delete. 

3. Click OK to confirm the deletion of the display command. 
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Event and alarm management 
IMC includes in its feature set the ability to manage events or faults and their resolutions in real time. 
This chapter explains traps and Syslog entries as sources of events in IMC that become alarms. It 
also covers browsing and filtering traps and Syslog events and the processes for defining which 
traps IMC processes.  

This chapter also explains views that IMC offers for browsing the alarms generated by IMC. This 
includes how to query for alarms, and the processes for sending alarms into mail and SMS text 
notifications and alarm forwarding to help desk and other management systems. 

Event and alarm overview 
In IMC, an event is an incident of interest in the network infrastructure. An event could indicate a 
failure or fault on a network device. An event could also indicate a resolution of fault in the network. 
Or an event can be informational. An alarm is an event that has been escalated in IMC for viewing by 
an IMC operator, network administrator, or support team using one of the IMC alarm browser views.  

IMC can receive SNMP traps and Syslog entries as real time alarm sources. You can configure all 
devices in the network infrastructure to send traps to IMC when issues arise and when issues are 
resolved. In addition, you can configure all devices to forward specified Syslog messages to IMC for 
notification of faults or their resolutions. 

IMC can be a source of traps for events. IMC generates traps that are displayed in IMC when events 
arise for managed devices such as when performance thresholds are exceeded, when IP address 
conflicts arise, or when configuration management tasks do not complete. In addition, the IMC 
system is also a managed device and traps can also be generated by IMC when a condition arises 
within IMC such as high CPU utilization, disk space issues, or IMC process issues on the IMC server.  

In addition, IMC has a built in engine for polling configured devices for performance metrics. System- 
and user-defined thresholds translate a polling result into an event, whether the event is a fault or its 
resolution.  

IMC itself is a source of events. IMC generates events for IMC.  

Each of these three sources of events (traps, Syslog events, and performance polling) in the network 
infrastructure serves as inputs for alarms in IMC. System- and user-defined rules determine which of 
the events generated by these three sources become an alarm.  

Alarms take the form of entries into alarm browser views in IMC. They also can be escalated into 
alarm notifications through mail, SMS text messaging, or alarm forwarding to help desk and other 
management systems.  

Once an event becomes an alarm, it is written to the alarm database. There are two ways to remove 
an alarm from IMC's views and further notifications.  

The first and preferred option for removing an alarm from the view and further notifications is to clear 
or recover the event. Clearing an event removes the event from Real-Time Alarms and Root 
Alarms views though recovered alarms can still be viewed in the All Alarms view. Alarms that have 
been recovered are removed from the database according to the Data Export configuration. When 
an event is recovered, IMC includes the date and timestamp so that the duration of the event is 
recorded. This information can be valuable for measuring the duration of a fault or event. Clearing or 
recovering an event is the preferred method for removing an alarm from alarm views. Clearing or 
recovering an alarm does not mean that the actual fault or error condition has been resolved.  

When an alarm is cleared or recovered, IMC removes the alarm instance from the Real-Time 
Alarms and Root Alarms views. The alarm is visible in the All Alarms view until it is removed from 
the alarm database during the next Data Export, which is 2:00 a.m. daily by default.  

The clearing or recovering of an event can occur manually, as when an operator selects the Recover 
action for an alarm. In addition, an alarm can be cleared automatically. Automatic clearing is done 
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when an event is received by IMC and there is a rule, either system or user defined, that 
distinguishes this event as the resolution for a specified alarm. In fact, many MIBs include resolution 
traps along with traps that indicate failures.  

The second option is to delete an alarm. As a best practice, do not use this option because deleting 
an alarm removes it from the alarm database and along with it the ability to report on it. Alarms are a 
valuable data source for performance management of the network infrastructure. You can schedule 
regular exports of the alarm database to retain alarm histories. Operators should consider carefully 
policies for retaining and for deleting alarms. For more information about the data export capabilities, 
see "Data export." 

Clearing or recovering alarms is an important function of IMC and incident management in IT 
organizations. Alarms can be cleared from the alarm Actions navigation tree located on the right of 
the Alarm Details page. This can be accessed from all of the alarm browse views that IMC offers. 
For more information about clearing alarms, see "Performing actions on the alarm in the alarm 
details page." 

Managing traps 
An SNMP trap is a message that is generated by an SNMP network device and sent to a 
management system for processing. A trap can indicate an error condition and its resolution. 
Additionally, a trap can also be informational. Traps are a proactive source of real time information on 
the health and status of the network infrastructure. Traps are effective for monitoring failures in real 
time because SNMP traps are messages sent by managed devices to management systems such 
as IMC.  

IMC can receive traps from all SNMP managed devices for you to review, filter, and generate alarms 
and notifications based on the traps received. IMC will discard a trap if its OID exceeds 128 
characters, the trap will be discarded. 

Trap management is most effective when all devices in the network infrastructure are configured to 
forward traps to IMC and IMC is configured to manage all of the devices that are configured to 
forward traps to it. Traps that IMC receives from unmanaged devices are (by default) filtered out.  

Therefore, to effectively use IMC as a trap destination and a source for managing and displaying trap 
information, you must first configure all devices to forward traps to IMC. See each vendor's support 
documentation for information about how to configure their devices to forward traps to a 
management system. You must also add all devices (trap sources) to IMC and configure IMC to 
receive traps from them using the IMC auto discovery feature.  

For more information about adding and managing devices in IMC and specifically auto discovery, 
see "Resource management." For information about the filtering out traps from unmanaged devices, 
see "Modifying trap filter configuration of devices not in IMC."  

IMC simplifies the process of configuring SNMP settings in IMC when adding devices to IMC through 
the use of SNMP templates. SNMP templates let you save one or more SNMP configurations, which 
can then be applied to devices during discovery or when adding devices manually. For more 
information about using SNMP templates, see "SNMP templates." 

Browsing traps 
You can view traps. IMC trap views include the trap source, a description of the trap and the date and 
time the trap was received. 

To browse traps: 

1. Navigate to Browse Trap. 

2. Click the Alarm tab from the top tabular navigation system.  

3. Click Trap Management on the left navigation tree.  

4. Click Browse Trap under Trap Management on the left navigation tree.  

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 9047



646 

IMC displays all trap entries in the Trap List displayed in the main pane of the Browse Trap 
window. Trap list fields are as follows: 

 Device Name—Contains the name of the device from which the trap was sent. 

 Device IP—Contains the IP address of the device from which the trap was sent. 

5. Click an individual entry in the Device Name or Device IP column to navigate to the Device 
Details page for the device that generated the trap.  

For more information about the Device Details page, see "Managing one device through 
device details." 

 Description—Provides the description that is contained within the trap itself. 

6. Click an individual entry in the Description column to navigate to the Trap Details page that 
provides a view of all known trap details.  

For more information about the Trap Details page, see "Viewing the trap details page." 

 Trap at—Contains the date and time stamp that the trap was either sent or received. 

You can sort the Trap List by the Device Name, Device IP, Description and the Trap at 
fields. Click the column label to sort the list by the select field. The column label is a toggle 
switch that lets you toggle between the various sort options specific to each field. 

7. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

 Click  to page forward in the Trap List. 

 Click  to page forward to the end of the Trap List. 

 Click  to page backward in the Trap List. 

 Click  to page backward to the front of the Trap List. 

8. For trap lists that have more than one page, click 1, 2, 3, 4, 5, 6, 7, 8, 9, 10 … from the bottom 
right side or on the top center of the main pane to jump to a particular page of the trap list.  

You can configure devices to forward traps to IMC. IMC then receives and display all traps 
forwarded to it. IMC recognizes them and displays related information on the traps and the trap 
source only if the source of the trap is known and managed by IMC.  

For unknown traps, the trap object identifier (OID) is displayed in the Description column to 
help locate the source of the trap.  

Only the OID and the parameter value are displayed for unknown traps. 

Viewing the trap details page 
The Trap Details page lets you view the details contained within individual traps. In addition, all traps 
for a particular device can be viewed from the Trap Details page. 

Viewing trap details 

1. Click the Alarm tab from the top tabular navigation system. 

2. Click Trap Management on the left navigation tree. 

3. Click Browse Trap on the left navigation tree. 

4. Click Description under Trap List for the specific trap details you want to view. 

Trap detail fields are as follows: 

 Name—Contains the event name as defined in the source MIB. 

 OID—Contains the object ID for the trap. 

 Trap At—Contains the date and time stamp. 
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 Trap Source—Contains the name or IP address of the device that sent the trap. Clicking 
Trap Source in this column navigates you to the Device Details page for the device that 
generated the trap. For more information about the Device Details page, see "Accessing 
the device details page."  

You can view all known traps sent by the selected device by clicking the More Traps… link 
next to the Trap Source entry. This navigates you to the Browse Trap list that is filtered by 
the selected device's name and IP address. 

 Description—Contains the description for this event as defined in the source MIB. 

 Trap Cause—Contains the cause for this event as defined in the source MIB. 

 Remediation Suggestion—Contains the suggested remediation for this event as defined 
in the source MIB. 

 Trap Parameter—Contains the parameters and parameter values for this particular trap. 

Managing traps by using the right navigation tree 

You can use these options for managing traps in the right navigation tree: 

 Filter the trap—You can add trap filter rules for the selected trap by clicking Filter the Trap 
located on the right Action navigation tree in the Trap Details page. This navigates you to the 
Add Filtering Rule page. For instructions on creating a trap filtering rule, see "Filtering traps 
with user-defined trap filter rules." 

 Modify severity—You can modify the severity of the selected trap to an alarm by clicking 
Modify Severity on the right Action navigation tree in the Trap Details page. This navigates 
you to the Trap Definition > Trap Severity Setting page. For instructions on modifying a trap 
to an alarm, see "Modifying trap definition severity settings." 

 Escalate to alarms—You can also escalate the selected trap to an alarm by clicking Escalate 
to alarms located on the right Action navigation tree in the Trap Details page. This navigates 
you to the Trap to Alarm > Add Alarm Generation Settings page. For instructions on 
escalating a trap to an alarm, see "Generating alarms from traps." 

 Previous—You can view the previous Trap Details page by clicking Previous on the right 
Action navigation tree in the Trap Details page. 

 Next—You can view the next Trap Details page by clicking Next on the right Action navigation 
tree in the Trap Details page. 

 Back—You can return to the Browse Trap page by clicking Back on the right Action 
navigation tree in the Trap Details page. 

Querying traps 
1. Navigate to Browse Trap. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Trap Management on the left navigation tree. 

c. Click Browse Trap under Trap Management on the left navigation tree.  

2. Enter a device IP in the field in the upper right corner of the Browse Trap page, and click the 

search icon , or click the Advanced icon  located in the upper right corner of the page. 

The search criteria dialog box opens. 

3. To query by device IP address, enter the IP address you want to view traps from in the Device 
IP field. 

4. Click Add, the device IP address is added to Selected Devices field.  

5. Click Select next to the Selected Devices field. The Select Devices dialog box opens. 

Add devices By View. For more information, see "Adding devices by view." 

6. To query by description, enter the description that you want to view traps from in the Description 
field. 
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7. Click Select next to the Selected Views field. The Select Views dialog box opens. 

Click the Expand icon  to the left of the Custom View on the window that opens. Select one 
or more subviews and click OK. 

8. To query all traps by time, click , and select the time range you want to query by. 

9. Click Query. 

Click Reset to if you want to reset the query values. 

Filtering traps with existing IMC Trap filter rules 
Effective trap management requires careful consideration of which traps are useful to the 
organization and the consequent configuration of the network devices that send traps and the 
management station that receives them. More often than not though, some of these steps are 
skipped as network administrators and network management administrators rarely have time for this. 
Frequently, network devices are often configured either to send more traps than are useful or 
necessary or to send none at all.  

You can more effectively manage the reception of traps for reporting incidents and their resolution in 
the network infrastructure through trap filtering. Trap filtering lets you distinguish between traps 
received by devices in the infrastructure that are useful from those that are not, before traps are 
translated into alarms for viewing and notification.  

You can create user defined trap filter rules and modify them in IMC.  

Viewing IMC trap filter rules 

1. Click the Alarm tab from the top tabular navigation system. 

2. Click Trap Management on the left navigation tree. 

3. Click the Filtering Trap under Trap Management on the left navigation tree. IMC is configured 
with the following trap filter rules: 

 Duplicate Trap Filter—This filter rule reduces the possibility of event storms in IMC by 
filtering out duplicate traps from reporting and displaying when thresholds are met.  

 Intermittent Trap Filter—This filter rule reduces the possibility of event storms by detecting 
when there is an intermittent problem in the network and setting thresholds when 
intermittent issues occur to eliminate the redundant alarming that occurs when intermittent 
issues arise.  

 Unknown Trap Filter—Devices in the network infrastructure are often configured to send 
traps to management systems even when the management system is not configured to 
manage the source of the trap. Thus, these traps might be unknown and indecipherable to 
IMC. This filter rule lets you remove unknown traps from IMC views and reports.  

 Trap Filter of Devices not in IMC—Devices in the network infrastructure are often 
configured to send traps to management systems even when the management system is 
not configured to manage these devices and receive traps from them. This filter rule lets you 
remove these traps from IMC views and reports. Only administrators or operators who are 
members of a group with the ADMIN privilege level can add or modify trap filters. 

Modifying the duplicate trap filter rule 

This filter reduces the possibility of event storms in IMC by filtering out duplicate traps from reporting 
and display once thresholds are met.  

To modify the Duplicate Trap Filter rule: 

1. Navigate to Filtering Trap. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Trap Management on the left navigation tree. 

c. Click Filtering Trap under Trap Management on the left navigation tree.  
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2. Click the Modify icon  next to the Duplicate Trap Filter. 

3. Select Escalate to alarms if you want an alarm to be generated and displayed in IMC when the 
number of traps received for each duplicate trap type exceeds the value configured in the 
Threshold field.  

If you check this box, you need to define the threshold setting. Threshold determines how many 
duplicate traps are received before IMC generates an alarm. The default is 100. 

4. Uncheck the Escalate to alarms box if you do not want to receive any alarms in IMC when 
devices in the network infrastructure are sending duplicate alerts for the same error condition. 

5. Select Filter Repeated Traps if you want IMC to use both the Length of Trap Queue and the 
length of time window defined below it in the Length of Time Window field for escalating 
duplicate traps to alarms. 

6. If you only want to use the Escalate to alarms threshold for escalating duplicate traps to 
alarms, verify that Filter Repeated Traps is not selected. One of the two parameters listed in 
steps 3 and 4 must be checked to configure the remaining parameters of this trap filter rule. 
Operators can remove specific traps from this trap filter rule to ensure that all traps for the 
selected trap type are always reported. To remove specific trap types from being included in 
this rule and de-duplicated: 

7. Click Select next to the Unfiltered Duplicate Traps field. 

8. In the Select Trap dialog box, locate the MIB that contains the trap you want to exclude from 
this de-duplication rule. 

9. To expand your view of the MIB, click the Right-Arrow icon  next to the MIB. 

10. Use the query function located at the top of the Select Trap dialog box to locate a particular 
trap. As with most IMC search features, fuzzy matching is supported so partial and complete 
search criteria is acceptable. 

11. Enter one or more of the following search criteria: 

 Trap Name—Enter a partial or complete object name for the trap you want to locate in the 
Trap Name field. 

 Trap OID—Enter a partial or complete Object ID for the trap in the Trap OID field. 

 Enterprise Name—Enter a partial or complete name for the Enterprise MIB you want to 
locate in the Enterprise Name field. 

 Enterprise OID—Enter a partial or complete Enterprise ID for the MIB you want to locate in 
the Enterprise OID field 

12. Click Query to submit your search criteria. 

The result of your query is displayed in the dialog box. 

13. Click Reset to clear your query criteria and to restore the full list of MIBs and traps. 

14. Select the MIB object that you want to add to the filtering rule. 

15. Clear the check box to remove a MIB object from the filtering rule. 

16. Click OK. 

It can take a while for the Select Trap dialog box to close. When it does, it updates the 
Unfiltered Duplicate Traps field with the configured trap.  

You can select multiple traps to exclude from this de-duplication rule. Each trap is listed in the 
Unfiltered Duplicate Traps field. 

 Length of Time Window—Defines the length of time in minutes in which traps would be 
considered duplicate. Enter the time in minutes. The default is 10 minutes. 

 Length of Trap Queue—Defines the maximum number of traps that are kept by IMC. Traps 
in the trap queue are matched against incoming traps to determine if there is a duplicate 
trap match. A long trap queue length ensures that the filter catches more traps and a shorter 
trap queue length reduces the number of traps filtered by this filter. The default is 5000 trap 
entries. The minimum is 100 and the maximum is 10000. 
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17. Select Use Sliding Time Window if you want a sliding window time counter applied to the 
length of time window for this filter rule. 

18. If you want to apply a fixed time window, do not select Use Sliding Time Window. 

19. Click OK. 

Modifying the intermittent trap filter rule 

This filter reduces the possibility of event storms by detecting when there is an intermittent problem 
in the network and setting thresholds for reporting when intermittent issues occur and eliminating the 
redundant alarming that occurs when intermittent issues arise. 

To modify the Intermittent Trap Filter: 

1. Navigate to Filtering Trap. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Trap Management on the left navigation tree. 

c. Click Filtering Trap under Trap Management on the left navigation tree.  

2. Click the Modify icon  in the Modify field associated with the Intermittent Trap Filter rule. 

3. If you want an alarm to be sent to and displayed in IMC if the number of traps received for each 
intermittent trap type exceeds the value configured in the Threshold field, select Escalate to 
alarms. 

If you check this box, you need to define the threshold setting. The threshold determines how 
many traps are received before IMC generates an alarm. The default is 3.  

4. Uncheck the Escalate to alarms box if you do not want to receive any alarms notifying you that 
devices in the network infrastructure are sending intermittent alerts for the same error condition.  

The Escalate to alarms box must be checked to configure the parameters of this trap filter rule.  

You can add specific traps to this trap filter rule so that all traps for the selected trap type are 
included in this intermittent trap filter. 

5. Select Filter Intermittent Trap to filter intermittent traps. 

If both the Filter Intermittent Trap and the Escalate to alarms options are selected, an alarm 
is still generated if the number of filtered traps exceeds the threshold configured for the 
Escalate to alarms option. 

6. To add specific trap types to this rule, perform the following tasks: 

a. Click Select next to the field below the Threshold field. 

b. In the Select Trap dialog box, locate the MIB that contains the trap you want to exclude 
from this de-duplication rule. 

You can quickly locate traps by specifying query criteria in the query area. The query criteria 
includes the trap name, trap OID, enterprise name, and enterprise ID. 

c. Click the expand icon  next to a MIB to expand your view of the MIB. 

d. Select the MIB object that you want to add to the filtering rule. 

e. Click OK. 

It can take a while for the Select Trap dialog box to close. When it does, it updates the field 
with the configured trap. 

7. Select multiple traps to exclude from this de-duplication rule. Each trap is listed in the field. 

 Length of Time Window—Defines the length of time during which traps would be 
considered intermittent. Enter the time in seconds. The default is 1 second. 

 Length of Trap Queue—Defines the maximum number of traps that are kept. Traps in the 
trap queue are matched against incoming traps to determine if there is a duplicate trap 
match. A long trap queue length ensures that the filter catches more traps and a shorter trap 
queue length reduces the number of traps filtered by this filter. The default is 5000 trap 
entries. The minimum is 100 and the maximum is 5000. 
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8. Select Use Sliding Time Window if you want a sliding window time counter applied to the 
Length of Time window for this filter rule. 

9. Leave the box unchecked if you want to apply a fixed time window. 

10. Click OK. 

Modifying trap filter configuration of devices not in IMC 

Devices in the network infrastructure are often configured to send traps to management systems 
even when the management system is not configured to receive them. Thus, these traps are 
unknown and indecipherable to IMC. This filter allows you to remove unknown traps from IMC views 
and reports. 

To modify the Unknown Trap Filter: 

1. Navigate to Filtering Trap. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Trap Management on the left navigation tree. 

c. Click Filtering Trap under Trap Management on the left navigation tree. 

2. Click the Modify icon  next to the Unknown Trap Filter. 

3. Select Escalate to alarms if you want an alarm to be sent to and displayed in IMC if the number 
of traps received for unknown traps exceeds the value configured in the Threshold field.  

You need to define the threshold setting. Threshold determines how many traps are received 
before IMC generates an alarm. The default is 1000. 

4. Uncheck the Escalate to alarms box if you do not want to receive any alarms in IMC notifying 
you that devices in the network infrastructure are sending traps that are unknown to IMC.  

The Escalate to alarms box must be checked to have the ability to configure the parameters of 
this trap filter rule. 

5. Select Filter Traps from devices not in IMC if you want IMC to discard all traps for which the 
trap type is unknown to IMC. 

6. Uncheck the Filter Traps from devices not in IMC box if you want IMC to receive and report 
unknown traps. 

7. Click OK. 

Filtering traps with user-defined trap filter rules 
Effective use and management of traps for reporting faults in the network infrastructure requires trap 
filtering. User defined trap filtering lets you define your own trap filters to determine for your 
environments the traps that are useful from those that are not. 

Adding a user-defined trap filter rule 

1. Navigate to Filtering Trap. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Trap Management on the left navigation tree. 

c. Click Filtering Trap under Trap Management on the left navigation tree. 

2. Click Add on the Filtering Trap page. 

3. Enter a unique name for this filtering rule in the Filtering Rule Name field. 

4. Select the filter mode for this rule from the Filter Mode list: 

 By Trap Group—Select this option if you want to filter by the trap groups defined by IMC.  

There are two types of common trap groups in IMC. The first is the interface UP/DOWN 
Trap Group. This group provides filtering for interface UP and DOWN traps. Interface UP 
and DOWN traps are generated by two sources. The first UP/DOWN trap source is IMC 
through its device polling. The second source of UP/DOWN traps are the managed devices. 
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For a managed device to send UP/DOWN traps, it must be configured to send them and it 
must be configured to forward them to IMC. In addition, IMC must be configured to receive 
them, which is done when a device is added to IMC.  

You must specify which interfaces on every device for which you want to filter UP/DOWN 
traps. If you do not specify the device interfaces, IMC filters out UP/DOWN traps for all 
interfaces on all devices.  

The second type of common trap group is the iMC Trap Group. This option provides 
filtering for traps sent by IMC modules, including Sysmonitor and MPLS VPN monitor. 
Selecting this option filters out all traps generated by these IMC modules. 

 By Trap—Select this option if you want to define the trap that is used in this trap filtering 
rule. If you select the By Trap option, go to step 10. 

5. Select the trap group that you want to filter on from the Common Trap Group list if you 
selected By Trap Group from the Filter Mode list. 

 Select iMC Trap Group if you want to filter traps for IMC Sysmonitor and MPLS VPN 
Monitor. Then go to step 22. 

 Select UP/DOWN Trap Group if you want to filter for interface UP/DOWN traps. 

 Select the name of an existing trap group, and then go to step 22. For more information 
about adding a trap group, see "Adding a trap group." 

6. If you select UP/DOWN Trap Group, you must also select the devices, and select their 
interfaces to which this trap filter rule applies or select an existing port group. For more 
information about adding a port group, see "Adding a port group.". 

 

 IMPORTANT: 

If you select the UP/DOWN Trap Group in the Common Trap Group list without selecting the 
interfaces, the trap filtering rule is applied to all interfaces on all devices. 
 

7. To select interfaces by advanced query, go directly to step 8. To select an existing port group, 
go directly to step 9. To select interfaces by view, click Select next to the Interfaces to Filter 
field, then complete the following substeps: 

a. From the Select Interfaces dialog box, click the By View tab. 

b. Expand the view you want to select interfaces from by clicking the arrow icon to the left of 
the four view options, IP View, Device View, Custom View, or Port Group. 

c. Click the view from which you want to select interfaces on the left navigation tree. The 
devices from the group you click is displayed in the Device List tab next to the navigation 
tree. Highlighting a device from the Device List tab populates the Interface List tab with 
the highlighted device's interfaces.  

d. Highlight the interfaces you want to select from the Interface List tab and do one of the 
following:  

 Click the Add selected icon  to add them to the Selected Interface list, or 

 To select all of the interfaces displayed in the Interface List tab, click the Add all icon 

. 

 To remove one or more interfaces, select them and click the Remove selected icon 
. 

 To remove all of the select interfaces, click the Remove all icon . 

e. Confirm that the interfaces you have found have been added by reviewing the Select 
Interfaces list. 

f. Click OK. Confirm that the interfaces now are displayed in the Interfaces to Filter field.  

8. To select interfaces using the Advanced query option, complete the following substeps: 

a. Click Select next to the Interfaces to Filter field. 
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b. From the Select Interfaces dialog box, click the Advanced tab. 

c. Enter values in one or more of the search parameters as follows: 

 Query By Filter—Select the filter you want to filter interfaces by. A filter is a set of query 
criteria. Operators do not need to enter other query criteria if a filter is selected. 

 Device IP—Enter the IP address for which you want to query. Select Exact Query if you 
want IMC to search for the full IP address you have entered. Leave the Exact Query 
box unchecked if you want IMC to match only a certain portion of the IP address. 

 Device IP List—Configure multiple device IP addresses to be searched. Click the 

Device IP icon . Then, the Device IP List Configuration window opens. Enter one or 
multiple device IP addresses in the Input Device IP field (if you enter multiple IP 
addresses, enter one IP address on each line), and then click Add to add the entered IP 
addresses to the Device IP List field below. Repeat the steps above to add all device IP 
addresses to be searched. To delete an IP address in the Device IP List field, select the 
IP address and then click Delete. Click OK to complete the operation. Make sure that 
the device IP addresses to be searched have been added to the Device IP List field. To 

clear the Device IP List field, click the Delete icon . 

 Device Label—Enter the name for the devices you want to add. IMC supports fuzzy 
matching for device labels. You can enter the entire device label for the device you want 
to locate, or you can enter just a portion of it. IMC displays all matches that contain the 
portion you enter. 

 Interface Alias—Enter the alias for the interface you want to filter on. 

 Interface Type—Select an interface type from the Interface Type list. 

 Interface IP—Enter the IP address of the interface in which you want to filter. Select 
Exact Query if you want IMC to search for the exact IP address you have entered. 

 Status—Select the current status of the interfaces you want to filter by. 

d. Click Query to begin your search. 

The results of your search are displayed in the Interface List. 

e. Highlight the interfaces you want to select and do one of the following:  

 Click the Add select icon  to add them to the select Interface list. 

 To select all of the interfaces displayed in the Interface List tab, click the Add all icon 

. 

 To remove one or more interfaces, select them and click the Remove select icon . 

 To remove all of the select interfaces, click the Remove all icon . 

f. Confirm that the interfaces you have found have been added. 

g. Click OK. Confirm that the interfaces now are displayed in the Interfaces to Filter field. 

9. To select an existing port group, complete the following substeps: 

a. Click Select Port Group next to the Port Group field. 

b. Select a view name.  

c. Click OK. Confirm that the port group is displayed.  

d. If you select By Trap in the Filter Mode list, you need to select the trap to be filtered for in 
this rule as follows. 

10. Click Select next to the Alarm Trap Name field. 

11. Do one of the following: 

 In the Select Trap dialog box, locate the MIB that contains the trap in which you want to 
filter. 

 To expand your view of the MIB, click the Right Arrow icon  next to the MIB that contains 
the trap that you want to add. 
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 You can also use the query function located at the top of the Select Trap dialog box to 
locate the trap you want to add. Fuzzy matching is supported so partial and complete 
search criteria is acceptable. Enter one or more of the following search criteria: 

 Trap Name—Enter a partial or complete object name for the trap you want to locate in 
the Trap Name field. 

 Trap OID—Enter a partial or complete object ID for the trap in the Trap OID field. 

 Enterprise Name—Enter a partial or complete name for the Enterprise MIB you want to 
locate in the Enterprise Name field. 

 Enterprise OID—Enter a partial or complete Enterprise ID for the MIB you want to 
locate in the Enterprise OID field. 

12. Click Query to submit your search criteria.  

The results of your query display in the dialog box.  

13. Click Reset to clear your query criteria and to restore the full list of MIBs and traps. 

14. Select the trap that you want to add. 

15. Click OK.  

It might take a while for the Select Trap dialog box to close. When it does, it updates the Alarm 
Trap Name field with the configured trap. 

16. If you select By Trap in the Filter Mode list, you also need to select the devices to which this 
trap filter rule is to be applied. 

 

 IMPORTANT: 

If you select By Trap as your Filter Mode without selecting the devices, then the trap filtering 
defined in the rule applies to all devices. 
 

17. Click Select next to the Devices to Filter field. The Select Devices dialog box opens. 

Add devices either By View or by using the Advanced query option. 

See "Adding devices by view" and "Adding devices by advanced query." 

18. If the selected trap has parameters, click Parameter Settings and set alarm parameters for 
each device on the Set Alarm Parameters window that opens, and click OK. For more 
information about setting alarm parameters, see "Adding trap definitions." 

19. Click Select View next to the Custom View field, and click the Expand icon  to the left of the 
Custom View on the window that opens. Select one more subviews and click OK. 

20. If the selected trap has parameters, click Parameter Settings and set alarm parameters for 
each view on the Set Alarm Parameters window that opens, and click OK. For more 
information about setting alarm parameters, see "Adding trap definitions." 

21. Select the period of time for which this trap filter rule applies from the Validity Period 
Configuration list. 

22. Select Weekly if you want to define the days of the week and the hourly range. 

23. Select the day of the week to which you want to apply this trap filter rule. Clear the check box to 
remove the rule for that day. 

24. Select By Time Range if you want to set a specific date and time range for this trap filter rule. 

25. If you select By Time Range, enter: 

 Start Date—You can auto-populate this field by clicking the field located to the right. A 
popup calendar is displayed. Select the start date from the calendar. 

 End Date—You can auto populate this field by clicking the field located to the right. Select 
the end date from the calendar. 

26. Enter the Start Time for every day to which you have applied this trap filter rule. 

27. Enter the End Time for every day to which you have applied this trap filter rule. 

28. Click OK. 
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Modifying a user-defined trap filter rule 

1. Navigate to Filtering Trap. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Trap Management on the left navigation tree. 

c. Click Filtering Trap under Trap Management on the left navigation tree.  

2. Click the Modify icon in the Filtering Trap main page associated with the trap filtering rule 
you want to modify.  

Rule name entries in the Filtering Trap table that are displayed in blue denote user defined 
filtering rules.  

You cannot modify the name of a trap filtering rule once you have created it. 

3. Modify the filter mode for this rule from the Filter Mode list. 

 By Common Trap Group—Select this option if you want to filter by the trap groups defined 
by IMC.  

There are two types of common trap groups in IMC. The first is the interface UP/DOWN 
Trap Group. This group provides filtering for interface UP and DOWN traps. Interface UP 
and DOWN traps are generated by two sources. The first UP/DOWN trap source is IMC 
through its device polling. The second source of UP/DOWN traps are the managed devices. 
For a managed device to send UP/DOWN traps, it must be configured to send them and it 
must be configured to forward them to IMC. In addition, IMC must be configured to receive 
them, which is done when a device is added to IMC.  

You must specify which interfaces on every device for which you want to filter UP/DOWN 
traps. If you do not specify the device interfaces, IMC filters out UP/DOWN traps for all 
interfaces on all devices.  

The second type of common trap group is the IMC Trap Group. This option provides 
filtering for traps sent by IMC modules, including Sysmonitor and MPLS VPN monitor. 
Selecting this option filters out all traps generated by these IMC modules. 

 By Trap—Select this option if you want to define the trap that is used in this trap filtering 
rule. If you select the By Trap option, go to step 9. 

4. Modify the trap group that you want to filter on from the Common Trap Group list if you select 
By Common Trap Group from the Filter Mode list. 

 Select IMC Trap Group if you want to filter traps for IMC Sysmonitor and MPLS VPN 
Monitor. 

 Select UP/DOWN Trap Group if you want to filter traps for interface up/down traps. 

5. If you select UP/DOWN Trap Group, you must also select the devices, and select their 
interfaces to which this trap filter rule applies or select an existing port group. For more 
information about adding a port group, see "Adding a port group." 

6. To select interfaces by advanced query, go directly to step 7. To select an existing port group, 
go directly to step 8. To select interfaces by view, click Select next to the Interfaces to Filter 
field, then complete the following substeps: 

a. From the Select Interfaces dialog box, click the By View tab. 

b. Expand the view you want to select interfaces from by clicking the arrow icon to the left of 
the four view options, IP View, Device View, Custom View, or Port Group. 

c. Click the view from which you want to select interfaces on the left navigation tree. The 
devices from the group you click is displayed in the Device List tab next to the navigation 
tree. Highlighting a device from the Device List tab populates the Interface List tab with 
the highlighted device's interfaces.  

d. Highlight the interfaces you want to select from the Interface List tab and do one of the 
following:  

 Click the Add select icon  to add them to the select Interface list. 
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 To select all of the interfaces displayed in the Interface List tab, click the Add all icon 

. 

 To remove one or more interfaces, select them and click the Remove select icon . 

 To remove all of the select interfaces, click the Remove all icon . 

e. Confirm that the interfaces you have found have been added by reviewing the select 
Interfaces list. 

f. Click OK. Confirm that the interfaces now are displayed in the Interfaces to Filter field.  

7. To select interfaces using the Advanced query option, complete the following sub-steps: 

a. Click Select next to the Interfaces to Filter field. 

b. From the Select Interfaces dialog box, click the Advanced tab. 

c. Enter values in one or more of the search parameters as follows: 

 Query By Filter—Select the filter by which you want to filter interfaces. A filter is a set of 
query criteria. Operators do not need to enter other query criteria if a filter is selected. 

 Device IP—Enter the IP address for which you want to query. Select Exact Query if you 
want IMC to search for the full IP address you have entered. Leave the Exact Query 
box unchecked if you want IMC to match only a certain portion of the IP address. 

 Device IP List—Configure multiple device IP addresses to be searched. Click the 

Device IP icon . Then, the Device IP List Configuration window opens. Enter one or 
multiple device IP addresses in the Input Device IP field (if you enter multiple IP 
addresses, enter one IP address on each line), and then click Add to add the entered IP 
addresses to the Device IP List field below. Repeat the steps above to add all device IP 
addresses to be searched. To delete an IP address in the Device IP List field, select the 
IP address and then click Delete. Click OK to complete the operation. Make sure that 
the device IP addresses to be searched have been added to the Device IP List field. To 

clear the Device IP List field, click the Delete icon . 

 Device Label—Enter the name for the devices you want to add. IMC supports fuzzy 
matching for device labels. You can enter the entire device label for the device you want 
to locate, or you can enter just a portion of it. IMC displays all matches that contain the 
portion you enter. 

 Interface Alias—Enter the alias for the interface you want to filter on. 

 Interface Type—Select an interface type from the Interface Type list. 

 Interface IP—Enter the IP address of the interface in which you want to filter. Select 
Exact Query if you want IMC to search for the exact IP address you have entered. 

 Status—Select the current status of the interfaces you want to filter by. 

d. Click Query to begin your search. 

The results of your search are displayed in the Interface List. 

e. Highlight the interfaces you want to select and do one of the following:  

 Click the Add selected icon  to add them to the Selected Interfaces list. 

 To select all of the interfaces displayed in the Interface List tab, click the Add all icon 

. 

 To remove one or more interfaces, select them and click the Remove select icon . 

 To remove all of the selected interfaces, click the Remove all icon . 

f. Confirm that the interfaces you have found have been added. 

g. Click OK. Confirm that the interfaces now are displayed in the Interfaces to Filter field. 

8. To select an existing port group, complete the following substeps: 

a. Click Select Port Group next to the Port Group field. 
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b. Select a view name.  

c. Click OK. Confirm that the port group is displayed.  

9. If you select By Trap in the Filter Mode list, you need to select the trap to be filtered for in this 
rule as follows. 

10. Click Select next to the Alarm Trap Name field. 

11. Do one of the following: 

12. In the Select Trap dialog box, locate the MIB that contains the trap in which you want to filter. 

 To expand your view of the MIB, click the Right Arrow icon  next to the MIB that contains 
the trap that you want to add, or 

 Click the Expand all icon  located in the upper right corner of the Select Trap dialog box 
to expand your view to display all traps.  

You can also use the query function located at the top of the Select Trap dialog box to 
locate the trap you want to add. Fuzzy matching is supported so partial and complete 
search criteria is acceptable. Enter one or more of the following search criteria: 

 Trap Name—Enter a partial or complete object name for the trap you want to locate in 
the Trap Name field. 

 Trap OID—Enter a partial or complete Object ID for the trap in the Trap OID field. 

 Enterprise Name—Enter a partial or complete name for the Enterprise MIB you want to 
locate in the Enterprise Name field. 

 Enterprise OID—Enter a partial or complete Enterprise ID for the MIB you want to 
locate in the Enterprise OID field. 

13. Click Query to submit your search criteria.  

The results of your query display in the dialog box.  

14. Click Reset to clear your query criteria and to restore the full list of MIBs and traps. 

15. Select the trap you want to add. 

16. Click OK.  

It might take a while for the Select Trap dialog box to close. When it does, it updates the Alarm 
Trap Name field with the configured trap. 

17. If you select By Trap in the Filter Mode list, you also need to select the devices to which this 
trap filter rule is to be applied. 

 

 CAUTION: 

If you select By Trap as your Filter Mode without selecting the devices, then the trap filtering 
defined in the rule applies to all devices. 
 

18. Click Select next to the Devices to Filter field. The Select Devices dialog box opens. 

19. Add devices either By View or by using the Advanced query option.  

See "Adding devices by view" and "Adding devices by advanced query." 

20. If the selected trap has parameters, click Parameter Settings and set alarm parameters for 
each device on the Set Alarm Parameters window that opens, and click OK. For more 
information about setting alarm parameters, see "Adding trap definitions." 

21. Click Select View next to the Custom View field, and click the Expand icon  to the left of the 
Custom View on the window that opens. Select one more subviews and click OK. 

22. If the selected trap has parameters, click Parameter Settings and set alarm parameters for 
each view on the Set Alarm Parameters window that opens, and click OK. For more 
information about setting alarm parameters, see "Adding trap definitions." 

23. Select the period of time for which this trap filter rule applies from the Validity Period 
Configuration list. 

24. Select Weekly if you want to define the days of the week and the hourly range. 
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25. Select the day of the week to which you want to apply this trap filter rule. Clear the check box to 
remove the rule for that day. 

26. Select By Time Range if you want to set a specific date and time range for this trap filter rule. 

27. If you select By Time Range, enter: 

 Start Date—You can auto-populate this field by clicking the field located to the right. A 
popup calendar is displayed. Select the start date from the calendar. 

 End Date—You can auto populate this field by clicking the field located to the right. Select 
the end date from the calendar. 

28. Enter the Start Time for every day to which you have applied this trap filter rule. 

29. Enter the End Time for every day to which you have applied this trap filter rule. 

30. Click OK. 

Deleting a user-defined trap filter rule 

1. Navigate to Filtering Trap. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Trap Management on the left navigation tree. 

c. Click Filtering Trap under Trap Management on the left navigation tree.  

2. Click the Delete icon  in the Filtering Trap list associated with the user-defined trap 
forwarding rule you want to delete. 

3. Click OK to confirm deletion of the user-defined trap-forwarding rule. 

You can only delete user-defined trap forwarding rules. You cannot delete IMC-generated trap 
forwarding rules. 

Generating alarms from traps 
IMC relies on system- and user-defined rules to determine which traps generate alarms. IMC 
includes many system-defined rules that upon installation generate alarms based on traps received 
by IMC. You can also create user-defined rules that generate alarms based on traps received by 
IMC.  

You can create rules from scratch or you can copy an existing system defined rule and modify it to 
meet your needs. You also have the ability to enable and disable system- and user-defined rules and 
upgrade traps to alarms system wide. You can escalate traps to alarms based on traps that match 
alarm rules or have traps that do not match alarm rules. After you upgrade a trap to an alarm, the 
severity level does not change. 

Viewing trap to alarm rules 

1. Navigate to Trap to Alarm. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Trap Management on the left navigation tree. 

c. Click Trap to Alarm under Trap Management on the left navigation tree.  

IMC displays all trap to alarm entries in the Trap to Alarm list displayed in the main pane of the 
Trap to Alarm window. The following list describes each of the columns in this window. 

 Rule Name—Contains the trap to alarm rule name. Clicking the link in this field navigates 
you to the Alarm Generation Setting Details page that displays the details of this alarm 
setting. 

 Rule Description—Provides a general description of the rule. System generated rules 
contains the value "default rule" in this field while you can provide descriptions for user 
defined rules that lets you identify the purpose of rules you have created. 

 Type—Identifies the creator of the rule: system-defined or operator (user)-defined. 

 Status—Provides a current status of the rule and the ability to enable or disable a rule. 
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 Modify—Provides you with a link for modifying the associated rule. 

 Copy—Provides you with a link for copying an existing rule to serve as a foundation for a 
user defined or operator defined rule.  

You can sort the Trap to Alarm List by the Rule Name, Rule Description, Type, and Status 
fields. Click the column label to sort the list by the selected field. The column label is a toggle 
switch that lets you toggle between the various sort options specific to each field. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

 Click  to page forward in the Trap to Alarm list. 

 Click  to page forward to the end of the Trap to Alarm list. 

 Click  to page backward in the Trap to Alarm list. 

 Click  to page backward to the front of the Trap to Alarm list. 

3. For Trap to Alarm lists that have more than one page, click 1, 2, 3, 4, 5, or 6 from the bottom 
right side of the main pane to jump to a particular page of the trap list. 

Creating a user-defined trap to alarm rule 

1. Navigate to Trap to Alarm. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Trap Management on the left navigation tree. 

c. Click Trap to Alarm under Trap Management on the left navigation tree.  

IMC displays all trap to alarm entries in the Trap to Alarm list displayed in the main pane of 
the Trap to Alarm window. The following list describes each of the columns in this window. 

2. Click Add. 

3. Enter a unique name in the Rule Name field. 

4. Enter a description in the Rule Description field. 

5. Select Keywords if you want to add a keyword to this trap to alarm rule.  

Keywords can be any word found in the Selected Keywords field of a trap. 

6. Select the logical operator you want to use for this rule from the Logical Combination list. If 
you select AND, an alarm is generated when all keywords in the Selected Keywords field are 
matched. If you select OR, an alarm is generated when any keyword in the Selected 
Keywords field is matched. Only one logical operator can be used in a rule. This parameter is 
meaningful only if you add more than one keyword. 

7. Select the keyword condition from the Keyword list. Select Yes if you want the trap to contain 
the keyword. Select No if you want to alarm on traps that do not contain the keyword. 

8. Enter the keyword you want to match on in the Keyword field next to the Keyword list.  

The total number of characters of all the keywords cannot exceed 256. 

9. Click Add to add the keyword condition and keyword to the Selected Keywords for the trap to 
generate an alarm.  

If you want to remove any keyword condition and keyword, highlight the keyword condition and 
keyword and click Delete located to right of the Selected Keywords field. You can have more 
than one keyword and each keyword can use yes or no. However, you can only have one 
AND/OR logical operator in a rule. 

10. Select Trap Source if you want to define devices for which this Trap to Alarm rule generates 
alarms. You can also define devices by view. 
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 CAUTION: 

If you do not specify a trap source, the Trap to Alarm rule applies to all devices. 
 

11. Select Yes or No from the If Match list as follows:  

 Select Yes if you want the trap source to match one of the IP addresses specified in the 
Selected Devices fields. 

 Select No if you do not want the trap source to match one of the IP addresses specified in 
the Selected Devices fields.  

You can select multiple IP addresses as the trap source but you can only have one IF Match 
condition for trap source in a rule. 

12. Enter the IP address of the device you want to include or exclude in the Device IP field. 

13. Click Add. 

14. Add multiple devices by first selecting Yes or No in the IF Match field and then entering the IP 
address for every device you want to include in this Trap to Alarm rule. 

15. Add devices by selecting devices by views that have already been discovered or managed in 
IMC. 

16. Click Select next to the Selected Devices field. The Select Devices dialog box opens. 

17. Add devices either By View or using the Advanced query option.  

See "Adding devices by view" and "Adding devices by advanced query." 

18. To specify a trap source by custom view, click the Expand icon  next to Selected Custom 
View. Click Select View next to the Custom View field, and click the Expand icon  to the left 
of Custom View on the window that opens. Select one more subviews and click OK. 

19. Select Trap Type if you want to define for which traps this Trap to Alarm rule generates 
alarms. 

20. Select Yes or No from the If Match list. Select Yes if you want the alarms to be generated for 
the trap type selected. Select No if you do not want alarms to be generated for the trap type 
selected.  

You can select multiple traps as the trap type but you can only have one IF Match condition for 
trap type in a rule. 

21. Select the trap(s) you want to add to this Trap to Alarm rule by clicking Select next to the Trap 
Name field. 

22. In the Select Trap dialog box, locate the MIB that contains the traps you want to add. 

23. To expand your view of the MIB, click the Right Arrow icon  next to the MIB that contains the 
trap for which you want to filter. Click the Expand all icon  located in the upper right corner of 
the Select Trap dialog box to display all traps. 

24. You can also use the query function located at the top of the Select Trap dialog box to locate 
the trap you want to add. Enter one or more of the following search criteria: 

 Trap Name—Enter a partial or complete object name for the trap you want to locate in the 
Trap Name field. 

 Trap OID—Enter a partial or complete Object ID for the trap in the Trap OID field 

 Enterprise Name—Enter a partial or complete name for the Enterprise MIB you want to 
locate in the Enterprise Name field. 

 Enterprise OID—Enter a partial or complete Enterprise ID for the MIB you want to locate in 
the Enterprise OID field. 

25. Click Query to submit your search criteria. The results of your query are displayed in the dialog 
box. Click Reset to clear your query criteria and to restore the full list of MIBs and traps. 

26. After you have located the trap or traps you want to add, select the trap or traps that you want to 
add.  

27. Click OK. 
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It may take a while for the Select Trap dialog box to close. When it does, it updates the Trap 
Name field with the configured traps. 

28. You can select multiple traps. Each trap is listed in the Trap Name field. 

29. If you want to remove any trap(s) from the Trap Name field, simply highlight the trap(s) and 
click Delete next to the Trap Name field. 

30. Modify the trap parameter settings by clicking the Parameter Settings next to the Trap Name 
field. Add any values to the variables displayed in the Set Alarm Parameters dialog box.  

31. Click OK. These parameters vary based on the trap you have selected in the Trap Name field. 

32. Click the Delete icon  if you want to remove the parameter from the parameter settings 
configuration. By deleting a parameter, you are removing it from IMC's evaluation of the trap for 
alarm purposes. 

33. Select Time Range if you want to define when this Trap to Alarm rule generates alarms. 

34. Select the period of time to which this Trap to Alarm rule applies from the Validity Period 
Configuration list. 

35. Select Weekly if you want to define the days of the week and the hourly range. 

36. Select the day of the week to which you want to apply this Trap to Alarm rule, or uncheck the 
box to remove the rule for that day. 

37. Select By Time Range if you want to set a specific date and time range for this Trap to Alarm 
rule. 

38. If you select By Time Range, enter: 

 Start Date—You can auto-populate this field by clicking the field. A popup calendar is 
displayed. Select the start date from the calendar. 

 End Date—You can auto-populate this field by clicking the field. A popup calendar is 
displayed. Select the end date from the calendar. 

39. Enter the Start Time for every day to which you have applied this Trap to Alarm rule. 

40. Enter the End Time for every day to which you have applied this Trap to Alarm rule. 

41. Click OK. 

Modifying the trap to alarm upgrade strategy 

You can create user-defined rules that upgrade received traps to alarms either when the trap 
matches the rule or when a trap does not match the alarm rule conditions. To use this feature, you 
must first create the Trap to Alarm rule and then apply the upgrade strategy to the alarm rule. For 
more information about creating a user defined trap to alarm rule, see "Creating a user-defined trap 
to alarm rule." 

To modify the Trap to Alarm strategy: 

1. Navigate to Trap to Alarm. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Trap Management on the left navigation tree. 

c. Click Trap to Alarm under Trap Management on the left navigation tree. IMC displays all 
trap to alarm entries in the Trap to Alarm list displayed in the main pane of the Trap to 
Alarm window. 

The current upgrade strategy is displayed above the Trap to Alarm list. 

2. Click Modify next to the Upgrade Strategy field. 

The upgrade strategy list is displayed. 

3. Select the Trap to Alarm upgrade strategy you want to use from the Upgrade Strategy list. 

4. Select Upgrade Traps matching the rules to alarm if you want IMC to escalate a trap to an 
alarm if the trap's contents match the conditions defined in the Trap to Alarm rule list. 

5. Select Upgrade Traps not matching the rules to alarm if you want IMC to escalate a trap to 
an alarm if the trap's contents do not match the conditions defined in the Trap to Alarm rule list. 
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6. Click OK to accept the upgrade strategy for the alarms you have selected. 

Modifying the trap-to-alarm rule scenario 

Trap-to-alarm rule scenarios allow you to apply different trap-to-alarm rules to different scenarios. 
Only trap-to-alarm rules for the current scenario take effect. 

1. Navigate to Trap to Alarm. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Trap Management on the left navigation tree. 

c. Click Trap to Alarm under Trap Management on the left navigation tree. IMC displays all 
trap-to-alarm entries in the Trap to Alarm list displayed in the main pane of the Trap to 
Alarm window. 

The current upgrade strategy is displayed above the Trap to Alarm list. 

2. Click the Modify link next to the Trap-to-Alarm Rule Scenario field. 

The trap-to-alarm rule scenario list is displayed. 

3. Select the trap-to-alarm rule scenario you want to use from the Trap-to-Alarm Rule Scenario 
list. 

Configure the scenario list and traps for scenarios in the file named faultUpgradeScene.xml in 
the \client\conf directory of the IMC installation path. 

4. Click OK. 

Modifying and copying trap to alarm rules 

The Copy feature for Trap to Alarm rules lets you create a new rule by making a copy of an existing 
system or user-defined rule and make whatever modifications are necessary to the copy.  

With this feature, you can make changes to a system-defined rule, as IMC does not allow 
modifications to system-defined rules. The Copy feature also provides you with the additional benefit 
of changing the name of a Trap to Alarm rule, which the Modify feature does not.  

The process for copying a Trap to Alarm rule is similar to the process for modifying a rule. To modify 
and copy trap to alarm rules: 

1. Navigate to Trap to Alarm. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Trap Management on the left navigation tree. 

c. Click Trap to Alarm under Trap Management on the left navigation tree.  

2. Do one of the following: 

 Click the Copy icon  associated with the rule you want to copy. 

 Click the Modify icon  associated with the user-defined rule you want to modify. 

3. If you are copying a rule, you can rename the rule by entering the new name in the Rule Name 
field. Rule names must be unique.  

You cannot modify the name of a rule after it has been created. To modify a rule name, you 
must create a new copy of the rule.. 

4. Enter a description in the Rule Description field. 

5. Select Keywords if you want to add or modify a keyword in this Trap to Alarm rule. 

6. Change the logical operator for this rule as needed in the Logical Combination field.  

This parameter is meaningful only if you add more than one keyword. 

7. Do one of the following: 

 If you select the logical operator AND with multiple keywords, all keywords must be found in 
the description field of the trap for the trap to generate an alarm. 

 If you select the logical operator OR, only one of the words must exist in the description field 
of the trap for an alarm to be generated. Only one logical operator can be used in a rule. 
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8. Add the keyword condition from the Keyword list. 

9. Do one of the following:  

 Select Yes if you want the trap to contain the keyword. 

 Select No if you want to alarm on traps that do not contain the keyword. 

10. Add the keywords you want to match on in the Keyword field next to the Keyword list.  

The total number of characters of all the keywords cannot exceed 256. 

11. Delete keywords as necessary by clicking Delete next to the Selected Keywords field. 

12. To modify the added keyword conditions, delete undesirable keyword conditions and then add 
new ones. 

13. Select Trap Source if you want to modify devices for which this Trap to Alarm rule generates 
alarms. You can also define devices by view. 

14. Select Yes or No from the Trap Source If Match list:  

 Select Yes if you want the trap source to match one of the IP addresses specified in the 
Selected Devices fields. 

 Select No if you do not want the trap source to match one of the IP addresses specified in 
the Selected Devices fields. 

15. Modify or remove the IP address of the devices you want to include or exclude in this trap to 
alarm field in the Device IP field by highlighting the IP addresses you want to remove and click 
Delete next to the Trap Source field. 

16. To add devices, see the step on adding devices in the previous section of this manual. 

To specify a trap source by custom view, click the Expand icon  next to Selected Custom 
View. Click Select View next to the Custom View field, and click the Expand icon  to the left 
of Custom View on the window that opens. Select one more subviews and click OK. 

17. Select Trap Type if you want to define the traps for which this Trap to Alarm rule generates 
alarms. 

18. Select Yes or No from the Trap Type If Match list: 

 Select Yes if you want the alarms to be generated for the trap type selected. 

 Select No if you do not want alarms to be generated for the trap type selected. 

You can select multiple traps as the trap type, but you can only have one IF Match condition for 
trap type in a rule. 

19. Select the traps for which you want to add this trap to alarm rule by clicking Select next to the 
Trap Name field. 

20. In the Select Trap dialog box, locate the MIB that contains the trap that you want. 

21. Do one of the following: 

 To expand your view of the MIB, click the Right Arrow icon  next to the MIB that contains 
the trap that you want to add. 

 You can also use the query function located at the top of the Select Trap dialog box to 
locate the trap you want to add. 

22. Enter one or more of the following search criteria: 

 Trap Name—Enter a partial or complete object name for the trap you want to locate in the 
Trap Name field. 

 Trap OID—Enter a partial or complete Object ID for the trap in the Trap OID field. 

 Enterprise Name—Enter a partial or complete name for the Enterprise MIB you want to 
locate in the Enterprise Name field. 

 Enterprise OID—Enter a partial or complete Enterprise ID for the MIB you want to locate in 
the Enterprise OID field. 

23. Click Query to submit your search criteria. 

The results of your query display in the dialog box. 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 9065



664 

24. Click Reset to clear your query criteria and to restore the full list of MIBs and traps. 

25. Select the trap that you want to include in this rule. 

26. Click OK.  

It can take a while for the Select Trap dialog box to close. When it does, it updates the Trap 
Name field with the modified traps. 

27. To delete any of the existing traps, highlight the traps you want to delete and click Delete next to 
the Trap Name field. 

28. Modify the trap parameter settings by clicking Parameter Settings next to the Trap Name field. 

29. Add any values to the variables displayed in the Set Alarm Parameters dialog box.  

30. Click OK.  

These parameters vary based on the trap you have select in the Trap Name field. 

31. Click the Delete icon  if you want to remove the parameter from the parameter settings 
configuration. By deleting a parameter, you are removing it from IMC's evaluation of the trap for 
alarm purposes. 

32. Select Time Range if you want to define when this trap to alarm rule generates alarms. 

33. Select the period of time to which this trap to alarm rule applies from the Validity Period 
Configuration list. 

34. Select Weekly if you want to define the days of the week and the hourly range. 

35. Do one of the following: 

 Select the day of the week during which you want to apply this trap to the alarm rule. 

 Uncheck the box to remove the rule for that day. 

36. Select By Time Range if you want to set a specific date and time range for this trap to alarm 
rule. 

37. If you select By Time Range, enter: 

 Start Date—You can auto-populate this field by clicking the field located to the right. A 
popup calendar is displayed. Select the start date from the calendar. 

 End Date—You can auto-populate this field by clicking the field located to the right. A popup 
calendar is displayed. Select the end date from the calendar. 

38. Enter the Start Time for every day in which you have applied this trap to alarm rule. 

39. Enter the Start Time and End Time for every day in which you have applied this trap to alarm 
rule. 

40. Click OK. 

Enabling/disabling trap-to-alarm rules 

To enable or disable Trap to Alarm rules: 

1. Navigate to Trap to Alarm. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Trap Management on the left navigation tree. 

c. Click Trap to Alarm under Trap Management on the left navigation tree. 

2. Do one of the following: 

 To enable a Trap to Alarm rule, click  Disable in the Status field for the target rule. 

 To disable a Trap to Alarm rule, click  Enable in the Status field for the target rule. 

Managing trap definition settings 
You can define which of the received traps IMC can process and is considered known traps. Trap 
definitions determine which of all traps received are known to IMC. 
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Viewing trap definitions 

To view all trap definitions in IMC: 

1. Navigate to Trap Definition. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Trap Management in the navigation tree on the left. 

c. Click Trap Definition under Trap Management on the left navigation tree. 

IMC displays all trap definitions in the Trap Definition list displayed in the main pane of the 
Trap Definition screen. 

 Trap Name—Contains the name of the trap. The trap name serves as a link to navigate to 
the Trap Definition Details page. 

The Trap Definition Details page provides detailed information for traps including trap 
name, trap OID, enterprise name, enterprise ID, trap level, description, and trap cause. 

 Trap OID—Contains the Object ID of the trap. 

 Enterprise Name (Enterprise ID)—Contains the name of the Enterprise and its Object ID. 

 Severity—Contains the severity setting for the trap. The severity setting is equivalent to the 
alarm level in IMC. 

 Type—Contains the source of the trap, whether it is System Defined or User Defined. 

 Add Device Severity—Click the Add Device Severity icon  to add a device severity 
level. For more information, see "Managing the device severity list." 

 Description—Click the Description icon  for a trap to view device severity information 
of the trap. The Trap Definition list summarizes device severity information of multiple 
devices as one record when the severity information has the same parameters, severity 
level, and setting for whether to be applicable to new devices. 

 Modify—Contains a Modify icon  that links to the Modify Trap Definition page for 
modifying the associated trap. 

 Delete—Contains the Delete icon  for deleting the associated trap.  

You can sort the Trap Definition list by the Trap Name, Trap OID, Severity, or Type fields. Click 
the column label to sort the list by the select field. The column label is a toggle switch that lets 
you toggle between the various sort options specific to each field. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view: 

 Click  to page forward in the Trap List. 

 Click  to page forward to the end of the Trap List. 

 Click  to page backward in the Trap List. 

 Click  to page backward to the front of the Trap List. 

3. For Trap Definition Lists that have more than one page, click 1, 2, 3, 4, 5, 6, 7, 8, 9, or 10 from 
the bottom right side or top center of the main pane. 

4. To jump to a particular page of the trap list, click the page number. 

Querying traps 

Operators can also query IMC for specific details in a trap. 

To query IMC for a trap: 

1. Navigate to Trap Definition. 

a. Click the Alarm Tab from the top tabular navigation system. 
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b. Click Trap Management on the left navigation tree. 

c. Click Trap Definition under Trap Management on the left navigation tree. 

2. Enter a trap name in the field in the upper right corner of the Trap Definition page, and click the 

Search icon , or click the Advanced icon  located in the upper right corner of the page. 

The search criteria dialog box opens. 

3. Enter one or more of the following search criteria in the Trap Query section of the Trap 
Definition window, using partial or complete entries. You can use a partial entry, as IMC 
supports fuzzy matching. 

 Trap Name—Enter a partial or complete name for the trap. For example, to query for a trap 
definition with the name, alarmFeBlock, enter alarmFeBlock in the Trap Name field. 

 Enterprise Name—Enter partial or complete name for the vendor whose MIB contains the 
trap for which you want to query. For example, to query for all 3Com traps, enter 3Com in 
the Enterprise Name field. 

 Trap OID—Enter partial or complete Object ID for the trap in which you want to query. For 
example, the object ID for alarmFeBlock is 1.3.6.1.4.1.43.1.12.3.6.155. Enter 
1.3.6.1.4.1.43.1.12.3.6.155 in the Trap OID field to retrieve traps with this Object ID. 

 Enterprise ID—Enter partial or complete Enterprise ID for the vendor whose MIB contains 
the trap in which you want to query. For example, the Enterprise ID for 3Com is 
1.3.6.1.4.1.43.1.12.3. Enter 1.3.6.1.4.1.43.1.12.3 to retrieve all traps by 3Com from the trap 
definition list. 

Adding trap definitions 

You can customize IMC by adding user defined trap definitions that process, interpret and display 
traps received by IMC. In addition, you can modify existing, system-defined traps.  

IMC provides the ability to deduplicate multiple instances of the same trap for the same device or the 
same component on the same device for the same event. IMC provides a system defined trap filter, 
called the Duplicate Trap Filter. To deduplicate traps in IMC, the trap Object ID, the source device, 
and the Key Parameter fields must be identical. The trap Object ID is defined in the MIB definition file 
and the source of the trap is defined by its IP address. With user defined trap definitions, the operator 
defines which object in a MIB file is used to deduplicate traps.  

The same rules apply when you want to associate a clear or restore trap with the trap that reports an 
error or fault. To create a trap definition that automatically allows a restore trap to clear or recover an 
alarm in IMC that was generated by a trap, you first create the trap definition that reported the error. 
Then, you create another trap that is configured as a Restore Trap and includes in the Restore Trap 
configuration the traps that are cleared or recovered by the restore trap.  

The trap reporting the error and the trap reporting the recovery must contain the same Object ID that 
is configured as the Key Parameter in the Set Parameter configuration.  

For example, in the system defined trap definition for reporting a link down is Link Down. The Link 
Down trap OID is 1.3.6.1.6.3.1.1.5.2.0 and it has the Interface Index OID 1.3.6.1.2.1.2.2.1.1 
configured as the Key Parameter. The system defined trap definition for automatically clearing or 
recovering the Link Down trap event is the Link Up trap. The Link UP trap OID is 1.3.6.1.6.3.1.1.5.3.0 
and it also has the Interface Index OID 1.3.6.1.2.1.2.2.1.1 configured as the Key Parameter.  

In its Restore Trap settings, it has the Link Down trap configured with the OID as 
1.3.6.1.6.3.1.1.5.2.0. In essence, the trap definition for clearing the trap contains the key parameters 
and the trap definition that identifies the error condition.  

Once you have added trap definitions to the trap definition list, then received traps are displayed in 
the Trap List of under Browse Trap feature. The Trap List displays all traps received by IMC. For 
more information about viewing received traps, see "Browsing alarms."  

You can also generate alarms based on traps received in the Trap to Alarm feature. For more 
information about this feature, see "Generating alarms from traps."  

To add a trap definition: 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 9068



667 

1. Navigate to Trap Definition. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Trap Management on the left navigation tree. 

c. Click Trap Definition under Trap Management on the left navigation tree. The Trap 
Definition page opens. 

2. Click Add. The Add Trap page opens. 

3. Enter the Object ID for this trap in the Trap OID field. This value must correspond with the 
Object ID of the received trap that is processed by this definition.  

The Object ID for any trap can be found in the system or vendor's MIB.  

A trap OID is composed of three parts: the enterprise ID, the generic ID, and the specific ID. The 
number following the last dot "." is the specific ID. The number following the second to the last 
dot "." is the generic ID, and all remaining numbers constitute the enterprise ID.  

For example, if the trap OID is:  

1.3.6.1.4.1.2011.2.23.11.2.6.2001 

 the specific ID is 2001 

 the generic ID is 6 

 the enterprise ID is 1.3.6.1.4.1.2011.2.23.11.2. 

Following is a list of the basic rules for processing Trap Object IDs: 

 If the Object ID is a standard OID, the system does not process it.  

 If the enterprise ID exists in the system, the enterprise name you enter must be the same as 
that defined in the system. 

 If the number following the next to the last dot "." is "0", it is replaced with a "6" so that it can 
be used as the generic ID. 

 If the number following the next to the last dot is "6", IMC leaves this value unchanged as 
the generic ID. 

 If the number following the next to the last dot is neither "0" nor "6", the system adds ".6" 
after the number and use it as the generic ID.  

For example following the rules outlined above,  

1.3.6.1.4.1.2011.2.23.11.2.0.2001 is converted to 1.3.6.1.4.1.2011.2.23.11.2.6.2001. 

1.3.6.1.4.1.2011.2.23.11.2.2001 is converted to 1.3.6.1.4.1.2011.2.23.11.2.6.2001.  

1.3.6.1.4.1.2011.2.23.11.2.6.2001 remains unchanged. 

4. Enter a unique name for this trap in the Trap Name field. Maximum length is 64 characters. 

5. Enter the enterprise name for this trap in the Enterprise Name field.  

If the enterprise ID already exists in IMC, the enterprise name you enter must match the 
Enterprise Name defined in IMC. 

6. Select the Trap Level (corresponding with Severity Level and Alarm Level) from the Trap 
Level list. Trap levels include: 

 Critical 

 Major 

 Minor 

 Warning 

 Info 

7. Enter a description for this trap in the Description field.  

The Description field is used to describe the condition that triggered the trap. A brief and clear 
description of the condition is important for support teams in addressing and communicating 
faults in the network infrastructure. You can also use the description of the condition that is 
described in the trap itself. 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 9069



668 

You can use predefined macros in the Description field. The system replaces the macros with 
actual values after receiving traps. 

The code below provides an example of macro usage in the Trap Description field: 
the CPU usage ($4) of device $3 ($2) exceeds the threshold ($5).  

Supported macros are listed in Table 48. 

Table 48 Predefined Macros 

Macro  Value  

$n  This macro displays the value of a trap variable in the format of a character string, in the 
range 1 to 99  

$+n  Displays the name of a trap variable in the format of a character string, in the range 1 to 
99  

$O  Trap name  

$o  Trap OID  

$R  Trap source name  

$a  Trap source IP address  

$s  Trap severity level  

$x  Date when the trap was generated  

$X  Time when the trap was generated  

$@  Time when the numerical trap was generated  

$E  Trap Enterprise ID  

$S  Trap Specific ID  

$G  Trap Generic ID  

$#  Number of trap variables  

$P  Interface description  
 

8. Enter the cause for the condition for which this trap was sent in the Trap Cause field.  

Maximum length of this field is 1024 characters. 

9. Enter the remediation suggestion for the resolution to the condition indicated by this trap in the 
Remediation Suggestion field.  

Maximum field length is 512 characters. 

10. Set the maintenance experience for the trap. When receiving this type of traps, the system uses 
the maintenance experience. The value can have a maximum of 128 characters.  

11. Select Set Parameter to define the parameters for this trap definition. 

12. Click Add under the Set Parameter check box. 

13. Enter a name for the parameter in the Parameter Name field.  

Maximum length is 64 characters. 

14. Enter the parameter's Object ID in the Parameter OID field. 

15. Select the type of parameter from the Parameter Type list.  

Parameter types for SNMP traps include: 

 UInteger32 

 Integer32 

 Counter32 

 Gauge32 
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 TimeTicks 

 IPAddress 

 OID 

 OctetString 

 Counter64 

 Opaque 

 Others 

The trap parameter Object ID and parameter type can be found in the vendor's MIB definition 
file. 

16. Set the key parameter setting by selecting Yes from the Key Parameter list if this is a key 
parameter. Select No if it is not.  

The Key Parameter field is used by IMC to pair or match traps sent by the same device or 
component of a device. For example, devices can generate Link Down and Link Up traps for 
every interface. You want IMC to process the Link Down trap and generate alarms for every 
interface that reports this condition.  

You may also want IMC to process the Link Up traps that the device sends so that IMC can 
automatically clear or recover the Link Down alarm condition for the correct interface as soon as 
it receives the Link UP trap. To do so, you must use the same Object ID for the key parameter in 
the Link Down definition as you use for the trap definition that identifies the Link Up trap. For the 
system-defined Link Down/Link Up trap definitions, the Interface Index Object ID is used as the 
Key Parameter. 

17. Specify whether the trap is an interface index. 

If you select Yes, the trap will be configured as an interface index, and the trap will affect the link 
status in the topology. If you select No, the trap is not configured as an interface index. 

18. Click OK. 

19. If the trap you are configuring is to clear or recover an event, select Restore Trap to establish 
this trap definition as a clear/recover or restore trap definition.  

When configuring a restore trap definition, you must include the traps that are cleared, 
recovered, or restored by this trap definition. 

20. Click Select Trap under the Restore Trap check box. 

21. In the Select Trap dialog box, locate the MIB that contains the trap definition that is 
cleared/recovered or restored by this trap definition. 

22. Do one of the following: 

 To expand your view of the MIB, click the Right Arrow icon  next to the MIB that contains 
the trap that you want to add. 

 Click the Expand all icon  located in the upper right corner of the Select Trap dialog box 
to display all traps. 

23. Use the query function located at the top of the Select Trap dialog box to locate the trap you 
want to add. 

24. Enter one or more of the following search criteria: 

 Trap Name—Enter a partial or complete object name for the trap you want to locate in the 
Trap Name field. 

 Trap OID—Enter a partial or complete Object ID for the trap in the Trap OID field. 

 Enterprise Name—Enter a partial or complete name for the Enterprise MIB you want to 
locate in the Enterprise Name field. 

 Enterprise OID—Enter a partial or complete Enterprise ID for the MIB you want to locate in 
the Enterprise OID field 

25. Click Query to submit your search criteria.  

The results of your query are displayed in the dialog box. 
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26. Click Reset to clear your query criteria and to restore the full list of MIBs and traps. 

27. Select the trap to be cleared/recovered or restored by this trap definition. 

28. Click OK. 

It can take a while for the Select Trap dialog box to close. When it does, it updates the Restore 
Trap table with the configured restore trap settings.  

The Object ID of the key parameters in the trap to be restored must be the same as that of the 
key parameters of the trap definition that identifies the fault or error.  

The number of the key parameters in the trap to be restored must be the same as that of the key 
parameters of the trap definition that identifies the error or fault.  

For restore trap definitions, IMC evaluates the Restore Trap configuration to validate that it has 
the same Key Parameter configured as the traps listed in the restore trap configuration that 
identifies the faults. If the Key Parameter configured for all traps is identical, the Check Result 
field contains the value  Pass. If the Key Parameter is not identical for all traps in the 
Restore Trap Configuration, the Check Result field contains the value  Not Pass. 

29. Click OK. 

The values for many of the settings in a trap definition can be found in the trap itself. You can 
view the trap by browsing the MIB using the SNMP MIB browser, known in IMC as MIB 
Management or by viewing the vendor's MIB file. 

Once you have completed the trap definition configuration, IMC is ready to begin receiving traps from 
managed devices that are configured to send these traps to IMC. See vendor information for each 
device's SNMP configuration to ensure that these traps are configured and that the devices are 
configured to send traps to IMC. 

Modifying user-defined trap definitions 

You can modify system-defined and user-defined traps. Operators can change the Trap Name, 
Enterprise Name, Trap Level, Description, Trap Cause, Remediation Suggestion and 
Maintenance Experience fields of a trap definition. The Trap Object ID field cannot be modified. 
This feature lets you modify traps to meet your organizational needs as they change.  

The Browse Trap feature provides a view into real time network conditions. You can customize the 
information that is displayed with traps to provide network operational staff with meaningful and 
actionable information. 

To modify user defined trap definitions: 

1. Navigate to Trap Definition. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Trap Management on the left navigation tree. 

c. Click Trap Definition under Trap Management on the left navigation tree. 

2. Click the Modify icon  in the Trap Definition list associated with the trap definition you want 
to modify. 

The Trap OID of an existing trap definition cannot be modified. 

3. Modify the name for this trap in the Trap Name field. Maximum name length is 64 characters. 

4. Modify the enterprise name for this trap in the Enterprise Name field.  

If the enterprise ID already exists in IMC, the enterprise name you enter must match the 
Enterprise Name defined in IMC. 

5. Modify the Trap Level from the Trap Level list. 

Trap levels include Critical, Major, Minor, Warning, and Info.  

The Trap Level parameter might or might not correspond with Severity Level and Alarm 
Level parameters. 

6. Modify the description for this trap in the Description field.  
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The Description field is used to describe the condition that triggered the trap. A brief and clear 
description of the condition is important for support teams in addressing and communicating 
faults in the network infrastructure. You can also use the description of the condition that is 
described in the trap itself. 

You can use predefined macros in the Description field. The system replaces the macros with 
actual values after receiving traps. 

The code below provides an example of macro usage in the Trap Description field: 
the CPU usage ($4) of device $3 ($2) exceeds the threshold ($5).  

Supported macros are listed in Table 49. 

Table 49 Predefined Macros 

Macro  Value  

$n  
This macro displays the value of a trap variable in the format of a character string, in 
the range 1 to 99  

$+n  
Displays the name of a trap variable in the format of a character string, in the range 
1 to 99  

$O  Trap name  

$o  Trap OID  

$R  Trap source name  

$a  Trap source IP address  

$s  Trap severity level  

$x  Date when the trap was generated  

$X  Time when the trap was generated  

$@  Time when the numerical trap was generated  

$E  Trap Enterprise ID  

$S  Trap Specific ID  

$G  Trap Generic ID  

$#  Number of trap variables  
 

7. Modify the cause for the condition for which this trap was sent in the Trap Cause field. 
Maximum length of this field is 1024 characters. 

8. Modify the remediation suggestion for the resolution to the condition indicated by this trap in the 
Remediation Suggestion field.  

Maximum field length is 512 characters. 

9. Set or modify the maintenance experience for the trap in the Maintenance Experience field.. 
The value can have a maximum of 128 characters. 

10. If you want to set parameters for this trap definition, select Set Parameters to define the 
parameters for this trap definition. 

11. Click Add under the Set Parameter check box. 

12. Modify the name for the parameter in the Parameter Name field.  

Maximum length is 64 characters. 

13. Modify the parameter OID in the Parameter OID field. 

14. Select the type of parameter from the Parameter Type list.  

Parameter types for SNMP traps include: 

 UInteger32 
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 Integer32 

 Counter32 

 Gauge32 

 TimeTicks 

 IPAddress 

 OID 

 OctetString 

 Counter64 

 Opaque 

 Others 

15. Set the key parameter setting by selecting Yes from the Key Parameter list if this is a key 
parameter. Select No if it is not.  

The Key Parameter field is used by IMC to pair or match traps sent by the same device or 
component of a device. For example, devices can generate Link Down and Link Up traps for 
every interface. You want IMC to process the Link Down trap and generate alarms for every 
interface that reports this condition.  

You may also want IMC to process the Link Up traps that the device sends so that IMC can 
automatically clear or recover the Link Down alarm condition for the correct interface as soon as 
it receives the Link UP trap. To do so, you must use the same Object ID for the key parameter in 
the Link Down definition as you use for the trap definition that identifies the Link Up trap. For the 
system-defined Link Down/Link Up trap definitions, the Interface Index Object ID is used as the 
Key Parameter. 

16. Specify whether the trap is an interface index. 

If you select Yes, the trap will be configured as an interface index, and the trap will affect the link 
status in the topology. If you select No, the trap is not configured as an interface index. 

17. Click OK. 

18. Select the parameters you want to move.  

19. Click Delete to delete the parameters. 

You can reorder the parameters in the Trap rule using the icons located in the Compositor field 
as follows: 

 Use  to move the parameter to the top of the parameter list. 

 Use  to move the parameter up one position. 

 Use  to move the parameter down one position. 

 Use  to move the parameter to the bottom of the parameter list. 

20. Click OK. 

21. If the trap you are configuring is to clear or recover an event, select Restore Trap to establish 
this trap definition as a clear/recover or restore trap definition. When configuring a restore trap 
definition, you must include the traps that are cleared, recovered, or restored by this trap 
definition. 

22. Click Select Trap under the Restore Trap check box. 

23. In the Select Trap dialog box, locate the MIB that contains the trap definition that is 
cleared/recovered or restored by this trap definition. 

24. Do one of the following: 

 To expand your view of the MIB, click the Right Arrow icon  next to the MIB that contains 
the trap that you want to add. 

 Click the Expand all icon  located in the upper right corner of the Select Trap dialog box 
to display all traps. 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 9074



673 

25. You can also use the query function located at the top of the Select Trap dialog box to locate 
the trap you want to add. Enter one or more of the following search criteria: 

 Trap Name—Enter a partial or complete object name for the trap you want to locate in the 
Trap Name field. 

 Trap OID—Enter a partial or complete Object ID for the trap in the Trap OID field. 

 Enterprise Name—Enter a partial or complete name for the Enterprise MIB you want to 
locate in the Enterprise Name field. 

 Enterprise OID—Enter a partial or complete Enterprise ID for the MIB you want to locate in 
the Enterprise OID field. 

26. Click Query to submit your search criteria.  

The results of your query are displayed in the dialog box. 

27. Click Reset to clear your query criteria and to restore the full list of MIBs and traps. 

28. Select the trap that is cleared/recovered or restored by this trap definition. 

29. Click OK.  

It can take a while for the Select Trap dialog box to close. When it does, it updates the Restore 
Trap table with the configured restore trap settings. 

30. Select the traps you want to delete.  

31. Click Delete Trap to delete the traps. 

Restore trap conditions 

The Object ID of the key parameters in the trap to be restored must be the same as that of the key 
parameters of the trap definition that identifies the fault or error. 

The number of the key parameters in the trap to be restored must be the same as that of the key 
parameters of the trap definition that identifies the error or fault. 

For restore trap definitions, IMC evaluates the Restore Trap configuration to validate that it has the 
same Key Parameter configured as the traps listed in the restore trap configuration that identifies the 
faults. If the Key Parameters configured for all traps are identical, the Check Result field contains 
the value Pass. If the Key Parameter is not identical for all traps in the Restore Trap Configuration, 

the Check Result field contains the value Not Pass. Click OK. 

Modifying trap definition severity settings 

You can change the severity settings of trap definitions for many trap definitions at once.  

To modify trap definition severity settings: 

1. Navigate to Trap Definition. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Trap Management on the left navigation tree. 

c. Click Trap Definition under Trap Management on the left navigation tree. 

2. Select Trap Name for all trap definitions for which you want to change the Severity setting 
(also referred to as the Alarm Level or Trap Level). 

3. Click Modify Severity.  

The Trap Severity Setting page opens. 

4. Select the Setting Style to which to apply these changes in the Trap Severity Setting page. 

 All Setting—Select this option if you want to apply the same severity or alarm level setting 
to all selected trap definitions. 

If you select this option, select the severity or alarm level setting you want to apply from the 
All Setting list. 

 Individual Setting—Select this option if you want to apply severity or alarm level settings 
individually to every selected trap definition.  
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If you select this option, the Selected Traps list becomes active and you can select the 
Goal Trap Severity setting for every trap definition listed in the Selected Traps table. 

5. Select the Goal Trap Severity setting for every trap definition for which you want to modify the 
severity setting. 

Select the Default Severity option if you want to apply the default severity to all trap definitions 
listed in the Selected Traps table. 

6. Click OK. 

Importing trap definitions from MIBs 

You can also import trap definitions from system or vendor MIBs. Depending on the way that the 
system obtains trap files, the following two methods are available for importing traps.  

If you can copy MIB files to the IMC server, follow these steps to import trap definitions: 

1. Copy the MIBs that contain trap definitions to: 
IMC_installation_directory/client/TrapMIB 

Most MIBs have dependencies on other MIBs, most especially MIB2 or SNMP-v2-MIB and 
IF-MIB. These MIBs are compiled into IMC by default and should not be removed. There may 
also be other MIB dependencies that require you to compile them into IMC before you can 
compile the MIBs that contain the trap definitions you want to add. MIB definition files list their 
dependencies at the beginning of the MIB. 

2. Navigate to Trap Definition. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Trap Management on the left navigation tree. 

c. Click Trap Definition under Trap Management on the left navigation tree. 

3. Click Import trap definition from MIB file in the Trap Definition list. 

4. Click Compile. 

5. Select the MIB file that contains the traps you want to import from the list of MIBs located below 
Compile.  

A dialog box opens listing all of the traps in the select MIB. 

6. Select Trap Name you want to import. 

7. Click Import.  

The maximum number of MIBs that can be imported is 1000. 

If you can copy MIB files to the host where the browser in-use resides, follow these steps to import 
trap definitions: 

1. Navigate to Trap Definition. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Trap Management on the left navigation tree. 

c. Click Trap Definition under Trap Management on the left navigation tree. 

2. Click Import trap definition from MIB file in the Trap Definition list. 

3. Click MIB Upload in the Trap Definition list. 

4. Select Yes or No for the Using the System MIB library field. 

If Yes is selected, the uploaded MIB file will be compiled together with some system MIBs. If No 
is selected, the MIB file to upload must contain its dependent MIBs. 

5. Select the MIB file you want to upload and click Upload. 

Make sure the MIB file is in the MIB or ZIP format and the file name contains only characters, 
digits, and underscores. 

The system automatically compiles the file and lists MIB module names. The compiled MIB 
module list displays only MIB modules that contain unimported trap definitions. If the compiled 
MIB module list is faulty, click Compile to compile the MIB file again. 
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6. Click a MIB module name. 

7. In the trap definition list, select one or more trap definitions that you want to import and click 
Import. 

Trap definitions that already exist in the system cannot be selected for import. 

8. Click Return to trap definition to return to the trap definition page. 
 

 NOTE: 

Only one operator is allowed to compile the MIB file at a time. 
 

Managing the device severity list 

The device severity list shows the severity levels of a device corresponding to the trap in different 
parameter configurations. 

To manage the device severity list: 

1. Navigate to Trap Definition. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Trap Management on the left navigation tree. 

c. Click Trap Definition under Trap Management on the left navigation tree. 

2. Click the Add Device Severity icon  for a trap to enter the device severity page of the trap. 

The page displays the severity level of the device in the trap. 

Device Severity List 

 Severity—Severity level of the trap. 

 Device Name—Name of the device. 

 Paras—Trap parameters. 

 Use for New Device—Specify whether to apply the device severity level to new devices. 

 Modify—Click the Modify icon  to modify the device severity. 

 Delete—Click the Delete icon  to delete the device severity. 

Adding a device severity 

1. Click Add. 

2. Set the Basic Information area: 

Trap OID and Trap Name are the trap information corresponding to the Device Information, 
and they cannot be modified. 

a. Select an alarm level from the Alarm Level list. 

b. Click Select in the Select area. 

The Select Devices dialog box opens. 

c. Add devices by View or by the Advanced query option.  

See "Adding devices by view" and "Adding devices by advanced query." 

The selected devices are displayed in the Select area. To delete devices from the area, 
select the devices to be deleted and click Delete. 

d. Select Enable or Disable from the Use for New Device list. 

3. Set Trap Parameter. Enter the trap parameter value in the Parameter Value field 
corresponding to a Parameter Name. 

4. Click OK. 

Modifying a device severity 

1. Click the Modify icon . 
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The Modify Device Severity page opens. 

2. Modify a device severity in the same way a device severity is added. 

3. Click OK. 

Deleting a device severity 

1. Use one of the following methods to delete device severities: 

 Click the Delete icon  for a device to delete the device severity. 

You can use this method to delete a single device severity. 

 Click the box next to a severity, and click Delete in the upper part of the page. 

You can use this method to delete multiple device severities. 

2. Click OK. 

Trap group management 
Use trap group management to add traps to a group, which allows you to add filter rules for multiple 
traps on a group basis. 

Viewing trap groups 

1. Navigate to Trap Definition. 

2. Click the Alarm tab. 

3. From the navigation tree, select Trap Management > Groups. 

The Trap Groups page opens. 

Trap group list contents 

 Group Name—Contains the name of the trap group. The trap name provides a link to the 
trap group details page, which provides detailed information about the trap group including 
the group name, description, and traps. 

 Group Description—Contains the description of the trap group. 

 Modify—Contains a Modify icon  for modifying the trap group. 

 Delete—Contains a Delete icon  for deleting the trap group.  

Adding a trap group 

1. Access the Trap Groups page. 

2. Click Add. 

3. Configure trap group parameters: 

a. Enter a unique group name in the Group Name field. 

b. Enter a description in the Description field. 

This field can be empty. 

c. Click Select next to the Alarm Trap Name field, select traps in the dialog box that opens, 
and then click OK. The selected traps are displayed in the Alarm Trap Name field. 

To delete traps from the group, select the traps, and then click Delete next to the Alarm 
Trap Name field. 

4. Click OK. 

Modifying a trap group 

1. Access the Trap Groups page. 

2. Click the Modify icon  for a trap group in the trap group list. 
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3. Configure trap group parameters except the group name. For more information about 
configuring trap group parameters, see "Adding a trap group." 

Deleting a trap group 

Trap groups used by trap filter rules cannot be deleted. 

To delete a trap group: 

1. Access the Trap Groups page. 

2. Click the Delete icon  for a trap group in the trap group list. 

A confirmation dialog box opens. 

3. Click OK. 

Managing Syslog 
Syslog is a standard for forwarding log messages over IP to devices configured to receive them. 
Entries in Syslog files are effective for monitoring failures in real time because devices write error 
conditions to Syslog files and most network infrastructure devices can be configured to forward 
Syslog entries to management systems such as IMC. 

You can receive Syslog entries from managed devices and to review, filter, and generate alarms and 
notifications based on the Syslog entries received. 

Syslog management is most effective when all devices in the network infrastructure are configured to 
forward Syslog messages to IMC and IMC is configured to manage all of the devices that are 
configured to forward Syslog messages to it. Syslog entries that IMC receives from unmanaged 
devices (by default) are filtered out.  

You can configure filtering policies and rules to filter out undesired Syslog messages. For more 
information about configuring the filtering policy, see "Filtering Syslog entries." 

To effectively use IMC as a Syslog server and a source for managing and displaying Syslog event 
information, you must first configure all devices to forward Syslog entries to IMC. See each vendor's 
support documentation for information about how to configure their devices to forward Syslog entries 
to a management system. Then, you must also add all devices (Syslog sources) to IMC. For more 
information about adding and managing devices in IMC, see "Resource management." For 
information about the filtering out traps from unmanaged devices, see "Filtering traps with existing 
IMC Trap filter rules" and "Modifying trap filter configuration of devices not in IMC." 

Syslog overview 
You have full visibility into all Syslog events received by IMC. With IMC, you can view all Syslog 
events from a single window. 

From the Browse Syslog view, you can drill down to the Device Details view for the devices that 
generated the Syslog entry. The Device Details page provides access to monitor and manage the 
devices that generated the Syslog entry. 

From the Device Syslog Detailed Information page, operators can view specific details about the 
Syslog entry. 

From the Browse Syslog view, you can query the IMC logs for any Syslog entry using powerful 
search capabilities. You can also save those searches for future use and viewing.  

Browsing Syslog entries 
IMC provides a view that displays all Syslog events received by IMC. Through the Browse Syslog 
view, you can view all Syslog events received by IMC. 
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Browsing Syslog entries 

1. Navigate to Browse Syslog. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Syslog Management on the left navigation tree. 

c. Click Browse Syslog under Syslog Management on the left navigation tree. 

IMC displays all Syslog entries in the Syslog List displayed in the main pane of the Browse 
Syslog window. 

Syslog list  

 Level—Contains the severity level for this Syslog entry as defined by the source of the 
event. 

 Syslog Source—Contains the device name for the source of this Syslog entry. This field 
contains an active link that navigates to the Device Details page for the source device of 
this Syslog entry. 

 Device IP—Contains the IP address for the source of this Syslog entry. 

 Description—Contains a description of the condition on the source side that triggered this 
Syslog entry. This field contains an active link to the Device Syslog Detailed Information 
page. 

 Repeat Times—Contains the number of duplicate Syslog events for the same condition. 

 Receive Time—Contains the date and time stamp for this Syslog event. 

You can sort the Syslog List by any field. Click the column label to sort the list by the selected 
field. The column label is a toggle switch that lets you toggle between the various sort options 
specific to each field: 

 Click  to page forward in the Syslog List.  

 Click  to page forward to the end of the Syslog List. 

 Click  to page backward in the Syslog List. 

 Click  to page backward to the front of the Syslog List. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

3. For lists that have more than one page, click 1, 2, 3, 4, 5, 6, 7, 8, 9, 10 … at the bottom right side 
of the main pane to jump to a particular page of the list. 

Export Syslog entries 

You can export the first 2000 entries in the Syslog list.  

To export Syslog entries: 

1. Click Export as Excel to the far right in the Syslog List. 

2. Follow the instructions in the Syslog Data Download dialog boxes to complete the export of 
data to Excel. 

Querying Syslog entries in IMC 
IMC provides search capabilities for Syslog entries that can be accessed through the Browse 
Syslog page under the Alarm tab. There are two Syslog query methods in IMC, the Basic Query 
and the Advanced Query.  

To query for Syslog entries: 

1. Navigate to Browse Syslog. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Syslog Management on the left navigation tree. 
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c. Click Browse Syslog under Syslog Management on the left navigation tree. 

2. Do one of the following: 

 Enter a device IP in the field in the upper right corner of the Browse Syslog page, and click 

the search icon . 

 Click the Advanced icon  located in the upper right corner of the page. 

Specify one or more of the following query criteria: 

 Device IP—Enter an IP address for the device you want to view Syslog entries for, and 
click Add. The Selected Devices field is updated to display the IP addresses you have 
added. 

 Selected Devices—Click Select, and select the devices you want to include in your 
query by using the By View or the Advanced options in the Select Devices window.  

 Selected Views—Click Select, and click the Expand icon  to the left of the Custom 
View on the window that opens. Select one more subviews and click OK. 

 Level—Lets you to query for a specific Syslog severity level. Select this option from the 
Level list. 

 Receive Time—Lets you query for a recent time range. You can select all time or a 
recent time range, or customize a time range. If you customize the receive time, the end 
time must be later than the start time. 

 Description—This field allows you to enter one or more strings to match against the 
contents of a Syslog entry. When you enter multiple strings, you can select AND, NO, or 
OR from the Logical Combination list to specify the logical relationship between these 
strings. The Logical Combination setting applies only to the Description field. 

3. Click Query. Click Reset to if you want to reset the query values. 

Viewing Syslog details 
The basic component of all Syslog browsing in IMC is the individual Syslog entry. Operators can view 
individual Syslog entries by clicking an individual entry in the Browse Syslog page.  

The Device Syslog Detailed Information page provides information on a specific Syslog entry. 

Viewing device Syslog detailed information 

To view the details for an individual Syslog entry: 

1. Navigate to Browse Syslog. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Syslog Management on the left navigation tree. 

c. Click Browse Syslog under Syslog Management on the left navigation tree. 

2. Click the link in the Description field in the Syslog List for the individual Syslog entry for which 
you want to view details. 

IMC displays all entries in the Device Syslog Detailed Information view displayed in the main 
pane of the Browse Syslog > Detailed Information window. 

Device Syslog detailed information 

 System Name—Contains the device name for the source of this Syslog entry. 

 Device IP—Contains the IP address for the source of this Syslog entry. 

 Receive Time—Contains the date and time stamp for this Syslog event. 

 Module Name—Contains the name of the module from the source that generated this Syslog 
entry. 

 Level—Contains the severity level for this Syslog entry as defined by the source of the event. 
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 Repeat Time—Contains the number of duplicate Syslog events for the same condition. 

 Description—Contains a description of the condition on the source side that triggered this 
Syslog entry. 

 Original Log Text—Contains the display template content defined in the parsing template. 

Filtering Syslog entries 
You can filter Syslog entries by using filtering policies or filtering rules. IMC supports two filtering 
policies. One policy enables you to receive or drop Syslog entries from unmanaged devices, and the 
other enables you to receive or drop Syslog entries matching the specified rules. The latter one can 
filter Syslog entries only by cooperating with filtering rules. 

Viewing Syslog filtering rules 

To view Syslog filtering rules: 

1. Navigate to Filtering Rule. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Syslog Management on the left navigation tree. 

c. Click Filtering Rule under Syslog Management on the left navigation tree. 

Filtering Rule List contents 

 Rule Name—Contains the name of the Syslog filtering rule. 

 Rule Description—Provides a brief description of the filtering performed by the rule. 

 Status—Provides the current status of the functioning of the associated rule, Enabled or 

Disabled. To disable the filtering rule, click the  Enabled link. To enable the filtering rule, 

click the  Disabled link. 

 Modify—Click the link  to enter the page for modifying the associated rule. 

 Delete—Click the link  to delete the associated rule. 

 Copy—Click the link  to copy the associated rule. 

If the Filtering Rule List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Filtering Rule List.  

 Click  to page forward to the end of the Filtering Rule List. 

 Click  to page backward in the Filtering Rule List. 

 Click  to page backward to the front of the Filtering Rule List. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items 
per page you want to view. 

3. For lists that have more than one page, click 1, 2, 3, 4, 5, 6, 7, 8, 9, or 10 … from the lower right 
side of the main pane to skip to a particular page of the list. 

Viewing Syslog filtering rule details 

1. Navigate to Filtering Rule. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Syslog Management on the left navigation tree. 

c. Click Filtering Rule under Syslog Management on the left navigation tree. 

2. Click the name link of a filtering rule to enter the Filtering Rule Details page. 

 Rule Name—Contains the name of the Syslog filtering rule. 
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 Status—Provides the current status of the filtering rule, including Disabled and Enabled. 
Disabled indicates that the filtering rule is disabled, and Enabled indicates that the filtering 
rule is enabled. 

 Rule Description—Provides a detailed description of the filtering rule. 

 Target Devices—Contains the target devices to be filtered by the filtering rule. The filtering 
rule filters only the Syslog entries from the target devices. 

 Matching Order—Contains the matching order, Ignore Keyword Order or Keep Keyword 
Order. This parameter is used to determine whether Syslogs match the filtering rule.  

 Keywords—Contains the keywords. This parameter is used to determine whether Syslogs 
match the filtering rule. 

3. Click Back to return to the filtering rule page. 

Setting Syslog filtering policies 

IMC supports two Syslog filtering policies. One policy enables you to receive or drop Syslog entries 
from unmanaged devices, and the other enables you to receive or drop Syslog entries matching the 
specified filtering rules. 

To set Syslog filtering policies: 

1. Navigate to Filtering Rule. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Syslog Management on the left navigation tree. 

c. Click Filtering Rule under Syslog Management on the left navigation tree. 

2. Click the Modify in the Filtering Policies area. 

A dialog box opens. 

3. Select a device filtering policy. Options are Receive syslogs from Devices in IMC and 
Receive syslogs from Devices in and not IMC. 

4. Select a filtering rule filtering policy. Options are: Receive matching syslogs and Receive 
unmatching syslogs. 

5. Click OK. 

Adding a Syslog filtering rule 

1. Navigate to Filtering Rule. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Syslog Management on the left navigation tree. 

c. Click Filtering Rule under Syslog Management on the left navigation tree. 

2. Click Add to enter the Add Rule page. 

3. Enter a name for the filtering rule in the Rule Name field. 

The rule name must be unique and a valid length for the rule name is 1-256 characters. 

4. Set the status of the filtering rule. 

The status of the filtering rule can be modified. 

 Disabled—Disables the filtering rule. After the filtering rule is added, it does not take effect. 

 Enabled—Enables the filtering rule. After the filtering rule is added, it immediately takes 
effect. 

5. Enter a brief description for the filtering rule in the Rule Description field. 

6. Select target devices for the filtering rule by using one of the following methods: 

 Enter the IP addresses of a device in the Device IP field, and then click Add to add the IP 
address to the Target Devices field. 

 Click Select to select one or more devices from the Select Devices popup window. 

For more information, see "Adding devices by view" and "Adding devices by advanced query." 
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To delete a device from the Target Devices field, select the device from the Target Devices 
field and then click Delete. 

To add multiple devices, repeat the operation by using one of the above methods. 

7. Select a matching rule from the Matching Order list. 

 Keep Keyword Order—Keeps the keyword order. For example, set three keywords in the 
order of A, B, and C for the filtering rule. To match the filtering rule, the Syslog entries must 
have the three keywords and the three keywords must be in the order of A, B, and C. 

 Ignore Keyword Order—Ignores the keyword order. For example, set three keywords in 
the order of A, B, and C for the filtering rule. To match the filtering rule, the Syslog entries 
only need to have the three keywords regardless of the order of the keywords. 

8. Enter keywords for the filtering rule. 

a. Enter keywords in the field under Keywords. 

b. Click Add in the Action list to add multiple keywords. 

If you entered multiple keywords, Delete is displayed next to Add. To delete a keyword, click 
Delete associated with the keyword. 

9. Click OK. 

Modifying a Syslog filtering rule 

1. Navigate to Filtering Rule. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Syslog Management on the left navigation tree. 

c. Click Filtering Rule under Syslog Management on the left navigation tree. 

2. Click the Modify icon  for the filtering rule to be modified. 

The Modify Rule page opens. 

Do not modify the name of the filtering rule. 

3. Set the status of the filtering rule. 

The status of the filtering rule can be modified. 

 Disabled—Disables the filtering rule. After the filtering rule is added, it does not take effect. 

 Enabled—Enables the filtering rule. After the filtering rule is added, it immediately takes 
effect. 

4. Enter a brief description for the filtering rule in the Rule Description field. 

5. Select target devices for the filtering rule by using one of the following methods: 

 Enter the IP addresses of a device in the Device IP field, and then click Add to add the IP 
address to the Target Devices field. 

 Click Select to select one or more devices from the Select Devices popup window. 

For more information, see "Adding devices by view" and "Adding devices by advanced query." 

To delete a device from the Target Devices field, select the device from the Target Devices 
field and then click Delete. 

To add multiple devices, repeat the operation by using one of the above methods. 

6. Select a matching rule from the Matching Order list. 

 Keep Keyword Order—Keeps the keyword order. For example, set three keywords in the 
order of A, B, and C for the filtering rule. To match the filtering rule, the Syslog entries must 
have the three keywords and the three keywords must be in the order of A, B, and C. 

 Ignore Keyword Order—Ignores the keyword order. For example, set three keywords in 
the order of A, B, and C for the filtering rule. To match the filtering rule, the Syslog entries 
only need to have the three keywords regardless of the order of the keywords. 

7. Enter keywords for the filtering rule. 

a. Enter keywords in the field under Keywords. 
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b. Click Add in the Action list to add multiple keywords. 

If you entered multiple keywords, Delete is displayed next to Add. To delete a keyword, click 
Delete associated with the keyword. 

8. Click OK. 

Copying filtering rules 

This function enables you to copy filtering rules. After you modify a filtering rule, you can save the 
modified filtering rule by using a new rule name. 

To copy filtering rules: 

1. Navigate to Filtering Rule. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Syslog Management on the left navigation tree. 

c. Click Filtering Rule under Syslog Management on the left navigation tree. 

2. Click the Copy icon  for the filtering rule to be copied. 

The Copy Rule page opens. 

3. Enter a new name for the filtering rule in the Rule Name field. 

The new name must be unique and a valid length for the new name is 1-256 characters. 

4. Set the status of the filtering rule. 

The status of the filtering rule can be modified. 

 Disabled—Disables the filtering rule. After the filtering rule is added, it does not take effect. 

 Enabled—Enables the filtering rule. After the filtering rule is added, it immediately takes 
effect. 

5. Enter a brief description for the filtering rule in the Rule Description field. 

6. Select target devices for the filtering rule by using one of the following methods: 

 Enter the IP addresses of a device in the Device IP field, and then click Add to add the IP 
address to the Target Devices field. 

 Click Select to select one or more devices from the Select Devices popup window. 

For more information, see "Adding devices by view" and "Adding devices by advanced query." 

To delete a device from the Target Devices field, select the device from the Target Devices 
field and then click Delete. 

To add multiple devices, repeat the operation by using one of the above methods. 

7. Select a matching rule from the Matching Order list. 

 Keep Keyword Order—Keeps the keyword order. For example, set three keywords in the 
order of A, B, and C for the filtering rule. To match the filtering rule, the Syslog entries must 
have the three keywords and the three keywords must be in the order of A, B, and C. 

 Ignore Keyword Order—Ignores the keyword order. For example, set three keywords in 
the order of A, B, and C for the filtering rule. To match the filtering rule, the Syslog entries 
only need to have the three keywords regardless of the order of the keywords. 

8. Enter keywords for the filtering rule. 

a. Enter keywords in the field under Keywords. 

b. Click Add in the Action list to add multiple keywords. 

If you entered multiple keywords, Delete is displayed next to Add. To delete a keyword, click 
Delete associated with the keyword. 

9. Click OK. 

Enabling and disabling filtering rules 

To enable or disable filtering rules: 
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1. Navigate to Filtering Rule. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Syslog Management on the left navigation tree. 

c. Click Filtering Rule under Syslog Management on the left navigation tree. 

2. If a filtering rule is enabled, the status of the filtering rule is Enabled. To disable the filtering 

rule, click the Enabled link. 

3. If a filtering rule is disabled, the status of the filtering rule is Disabled. To enable the filtering 

rule, click the Disabled link. 

Deleting filtering rules 

1. Navigate to Filtering Rule. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Syslog Management on the left navigation tree. 

c. Click Filtering Rule under Syslog Management on the left navigation tree. 

2. Delete filtering rules: 

Select one or multiple filtering rules to be deleted, and then click Delete. 

3. Click the link  associated with the target filtering rules. 

Configuring alarms for Syslog messages 
IMC relies on system- and user-defined rules to determine which of the Syslog events received by 
IMC generates alarms and the resolution of alarms. IMC includes many system defined rules that 
generate and resolve alarms based on Syslog events received by IMC. You can also create user 
defined rules that generate or resolve alarms based on Syslog events received by IMC. 

IMC separates the identification of content in Syslog entries from the configuration of alarm 
generation and resolution rules.  

Syslog templates allow you to define the content that must exist in a Syslog entry to be escalated to 
an alarm or its resolution. Once created, the Syslog templates can then be applied to one or more 
alarm generation and resolution rules. 

You can create both Syslog templates and Syslog alarm rules from scratch or they can be copied 
from existing system defined templates and rules and modified to meet your needs. 

Using Syslog templates 

Syslog templates are used by Syslog to Alarm rules to match Syslog template content against 
Syslog entries, which are used by the Syslog to Alarm rules to determine whether or not an alarm is 
generated. User defined Syslog templates must be created before the Syslog to Alarm rules that 
depend on them can be created. 

You can view system defined Syslog templates. You can also create user defined Syslog templates 
or they can be copied from existing system defined templates. 

Browsing Syslog templates 

1. Navigate to Syslog Template. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Syslog Management on the left navigation tree. 

c. Click Syslog Template under Syslog Management on the left navigation tree. 

Syslog Template page provides you with a list of all Syslog templates that are used in 
Syslog to alarm rules that generate alarms. 
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IMC displays all Syslog template entries in the Syslog Template List displayed in the main 
pane of the Syslog Template window. 

Syslog template list 

 Template Name—Contains the Syslog template name. Clicking the link in this field 
navigates you to the Syslog Template Details page that displays the details of this rule. 

 Template Content—Provides you with information on the contents of the Syslog template, 
including parameters and content to be matched. 

 Type—Identifies whether or not the associated Syslog template is system-defined or 
user-defined. 

 Modify—Provides you with a link for modifying the associated template. Only user-defined 

templates can be modified and only user-defined templates have the Modify icon  in 
this field. 

 Delete—Provides you with a link for deleting the associated template. Only user-defined 

templates can be deleted and only user-defined templates have the Delete icon  in this 
field. 

 Copy—Provides you with a link for copying an existing template to serve as a foundation for 
a user defined or operator defined template. 

You can sort the Syslog Template List by the Template Name, Template Content, and Type 
fields. Click the column label to sort the list by the selected field. The column label is a toggle 
switch that lets you toggle between the various sort options specific to each field. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view: 

 Click  to page forward in the Syslog Template List.  

 Click  to page forward to the end of the Syslog Template List. 

 Click  to page backward in the Syslog Template List. 

 Click  to page backward to the front of the Syslog Template List. 

3. For Syslog Template List with more than one page, click 1, 2, or 3 from the bottom right side of 
the main pane to jump to a particular page of the Syslog Template list. 

Creating a user-defined Syslog template 

To create a user defined Syslog template: 

1. Navigate to Syslog Template. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Syslog Management on the left navigation tree. 

c. Click Syslog Template under Syslog Management on the left navigation tree. 

Syslog Template page provides you with a list of all Syslog templates that are used in 
Syslog to alarm rules that generate alarms. 

2. Click Add. 

3. Enter a unique name for this Syslog template in the Name field.  

Valid length is 1-32 characters. 

4. Enter the contents of the Syslog event that you want this template to search Syslog entries for in 
the Template Content field. 

Valid length is 1-512 characters. 

Guidelines for the template content field  

IMC supports the use of variables or parameters for matching dynamic content in Syslog 
entries, though, the use of variables or parameters in Syslog Templates is not required. 
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The template content to be matched can include an asterisk (*) as a wildcard. An asterisk 
represents one or more characters. You cannot use asterisks to represent all of the content. 

You cannot use the dollar sign ($) as content to be matched. 

You can use variables or parameters to represent the content to be matched. Variables or 
parameters take the format of  
$(parameter-name) 

For example,  

Duplicate address $(Duplicate IP) on $(Source VLAN). 

A parameter cannot include any of the following: 

dollar sign ($), left parenthesis ((), right parenthesis ()), asterisk (*), left brace ({), right brace (}), 
left angle brackets (<), or right angle bracket (>). 

Carriage returns and line feed characters are not allowed in a variable or parameter. 

Content to be matched cannot include identical parameters. 

At least one visible character must be placed between two parameters. This character cannot 
be an asterisk (*). 

Spaces preceding or following a parameter are ignored. For example, the following two 
parameters are considered identical: 

$(parameter-name) and $( parameter-name). 

5. Select whether to enable Description Display Template. 

Use the description display template feature to customize the template content. To enable the 
feature, select Enabled, and then enter display template content in the textbox that is displayed. 
The text input rules for the description display template are the same as rules for the template 
content. The parameters in the description display template must be same as parameters in the 
template content. 

6. Enter a description for this template in the Description field.  

Valid length is 0-64 characters. 

7. Click OK. 

Modifying a user-defined Syslog template 

1. Navigate to Syslog Template. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Syslog Management on the left navigation tree. 

c. Click Syslog Template under Syslog Management on the left navigation tree. 

Syslog Template page provides you with a list of all Syslog templates that are used in 
Syslog to alarm rules that generate alarms. 

2. Click the Modify icon  associated with the Syslog template you want to modify. 

You cannot modify the name of a Syslog template once it has been created. 

3. Modify the contents of the Syslog event that you want this template to search Syslog entries for 
in the Template Content field. 

Guidelines for the template content field  

IMC supports the use of variables or parameters for matching dynamic content in Syslog 
entries, though, the use of variables or parameters in Syslog Templates is not required. 

The template content to be matched can include an asterisk (*) as a wildcard. An asterisk 
represents one or more characters. You cannot use asterisks to represent all of the content. 

You cannot use the dollar sign ($) as content to be matched. 

You can use variables or parameters to represent the content to be matched. Variables or 
parameters take the format of  
$(parameter-name) 
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For example,  

Duplicate address $(Duplicate IP) on $(Source VLAN). 

A parameter cannot include any of the following: 

dollar sign ($), left parenthesis ((), right parenthesis ()), asterisk (*), left brace ({), right brace (}), 
left angle brackets (<), or right angle bracket (>). 

Carriage returns and line feed characters are not allowed in a variable or parameter. 

Content to be matched cannot include identical parameters. 

At least one visible character must be placed between two parameters. This character cannot 
be an asterisk (*). 

Spaces preceding or following a parameter are ignored. For example, the following two 
parameters are considered identical: 

$(parameter-name) and $( parameter-name). 

4. Select whether to enable Description Display Template. 

Use the description display template feature to customize the template content. To enable the 
feature, select Yes, and then enter display template content in the textbox that is displayed. The 
text input rules for the description display template are the same as rules for the template 
content. The parameters in the description display template must be same as parameters in the 
template content. 

5. Modify the description for this template in the Description field. 

6. Click OK. 

Copying a Syslog template 

The Copy feature for Syslog templates lets you create a new rule by making a copy of an existing 
system or user defined template and making whatever modifications are necessary to the copy. This 
feature lets you make changes to a system-defined template, as IMC does not allow modifications to 
system-defined templates. 

To copy a system or user defined Syslog template: 

1. Navigate to Syslog Template. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Syslog Management on the left navigation tree. 

c. Click Syslog Template under Syslog Management on the left navigation tree. 

Syslog Template page provides you with a list of all Syslog templates that are used in 
Syslog to alarm rules that generate alarms. 

2. Click the Copy icon  associated with the system or user defined Syslog template you want 
to copy. 

3. Delete the existing name and enter a new name for the rule in the Name field of the Copy 
Syslog Template page. 

4. Modify any of the Syslog Template settings as needed.  

For more information about modifying a Syslog template, see "Modifying a user-defined Syslog 
template." 

5. Click OK. 

Deleting a user-defined Syslog template 

1. Navigate to Syslog Template. 

2. Click the Alarm tab from the top tabular navigation system. 

3. Click Syslog Management on the left navigation tree. 

4. Click Syslog Template under Syslog Management on the left navigation tree. 

Syslog Template page provides you with a list of all Syslog templates that are used in Syslog 
to alarm rules that generate alarms. 
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5. Click the Delete icon  associated with the Syslog template you want to delete. 

6. Click OK to confirm deletion of the Syslog template. 

Using Syslog to alarm rules 
IMC uses system- and user-defined rules to determine which of the Syslog events received by IMC 
should be considered alarms. IMC includes system defined rules that, upon installation, generate 
alarms based on Syslog entries received by IMC. 

You can also create rules that generate alarms based on Syslog events received by IMC. You can 
create these from scratch or you can copy an existing system defined rule and modify it to meet your 
needs. You also have the ability to enable and disable system- and user-defined rules. The following 
information explores the use of Syslog to alarm rules. 

Browsing Syslog to alarm rules 

1. Navigate to Syslog to Alarm. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Syslog Management on the left navigation tree. 

c. Click Syslog to Alarm under Syslog Management on the left navigation tree. 

IMC displays all Syslog to Alarm rule entries in the Syslog to Alarm Rule list displayed in 
the main pane of the Syslog to Alarm window. 

Syslog to alarm rule list 

 Name—Contains the Syslog-to-alarm rule name. Clicking the link in this field navigates 
you to the Rule Detailed Information page that displays the details of this rule. 

 Type—Provides you with the creator of the rule system defined or operator (user) 
defined. 

 State—Provides you with a current status of the rule and the ability to enable or disable 
a rule. 

 Modify—Provides you with a  link for modifying the associated rule. 

 Delete—Provides you with a  link for deleting the associated rule. 

 Copy—Provides you with a link  for copying an existing rule to serve as a foundation 
for a user defined or operator defined rule. 

You can sort the Syslog to Alarm rule list by the Name, Type, and State fields. Click the 
column label to sort the list by the selected field. The column label is a toggle switch lets you 
toggle between the various sort options specific to each field. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view: 

 Click  to page forward in the Syslog to Alarm Rule List.  

 Click  to page forward to the end of the Syslog to Alarm Rule List. 

 Click  to page backward in the Syslog to Alarm Rule List. 

 Click  to page backward to the front of the Syslog to Alarm Rule List. 

3. For Syslog to Alarm Rule Lists that have more than one page, click 1, 2, 3 at the bottom right 
side of the main pane to jump to a particular page of the Syslog Alarm to Rule list. 

Creating a user-defined Syslog to alarm rule 

To create a user defined Syslog to alarm rule: 

1. Navigate to Syslog to Alarm. 

a. Click the Alarm tab from the top tabular navigation system. 
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b. Click Syslog Management on the left navigation tree. 

c. Click Syslog to Alarm under Syslog Management on the left navigation tree. 

IMC displays all Syslog to Alarm rule entries in the Syslog to Alarm Rule list displayed in 
the main pane of the Syslog to Alarm window. 

2. Click Add. The Add Rule page opens. 

3. Enter a unique name in the Name field. Valid length is 1-32 characters. 

4. Do one of the following: 

 Select Disabled if you want this rule to be in a disabled state upon completion of rule 
creation. 

 Select Enabled if you want this rule to be in an enabled state upon completion of the rule. 

5. Enter a description for this Syslog to Alarm rule in the Description field.  

Valid length is 0-128 characters. 

The following steps outline the configuration parameters for the alarm generation aspects of 
this rule. 

6. Select the type of Syslog event to be processed by this rule from the Syslog Type list. 

7. Select the Syslog levels of the events that is processed by this rule by selecting the checkboxes 
to the left of the Syslog Level for each Syslog level you want to include in this rule definition. 

The Syslog level defined here refers to the level set within the Syslog event, not the severity or 
alarm level used by IMC to escalate alarms. The value you define here must match the Syslog 
level setting in the Syslog event for it to be processed by this rule. 

IMC lets you summarize duplicate Syslog entries that match the rule's conditions. The method 
used for summarizing Syslog entries is set in the Statistic field. The two methods are: Network 
and Single Device. 

8. Do one of the following to select the method for summarizing Syslog entries: 

 Select Network if you want IMC to summarize matching Syslog entries for the entire 
network.  

 Select Single Device if you want IMC to summarize matching Syslog entries by device. 

IMC lets you configure how many times similar or duplicate Syslog entries are received before 
IMC escalates the entries to an alarm. This is determined by two variables: the Repeat Interval 
and the Repeat Times. 

Repeat Interval defines the window of time in seconds that IMC considers Syslog entries 
duplicate.  

9. Enter the window of time in seconds in the Repeat Interval field.  

Valid range is 1–3600 seconds. 

10. To select how many duplicate Syslog entries must be received before generating an alarm, 
enter the number of duplicate Syslog entries in the Repeat Times field.  

Valid range is 1–10,000. 

11. Select the alarm level that IMC applies to all Syslog entries that match this rule from the Alarm 
Level list. 

12. In the Alarm Description field, enter the string that matches some or all of the contents in the 
Syslog entry that must be matched for this rule to generate an alarm in IMC.  

Valid length is 0–128. 

The default value in the description field is %Syslog%. This value requires IMC to match the 
entire contents of the Syslog event. You can refine your matching and what is escalated to an 
alarm by selecting a subset of the entire contents of the Syslog event. To do so, the string you 
define in the Alarm Description field must be a subset of what is defined in the Syslog 
template specified in the alarm generation rule. 

13. Select the Syslog template to apply to this rule by clicking Select next to the Syslog Template 
field. 
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14. Select the Syslog template you want to use from the list of existing Syslog templates displayed 
in the Select dialog box.  

15. Select the Syslog template you want to apply to this rule. 

16. Verify that the Syslog template you selected is displayed in the Syslog Template field. 

If the Syslog template contains parameters, the Add Rule page updates to include a Param 
Setting section that lets you configure parameter settings for the template to match parameter 
values in the Syslog entry. IMC includes the following configuration options that determine how 
IMC counts Syslog entries: 

 Count Type—determines how IMC treats similar Syslog events with different parameter 
values. 

17. Select Summing Count if you want IMC to consider similar Syslog entries as one alarm without 
distinguishing between different parameter values.  

Alarms are generated when the number of matched Syslog entries, regardless of parameter 
values, equals the number of Syslog entries configured in the Repeated Times field within the 
time configured in Repeat Interval window. 

18. Select Classifying Count if you want IMC to consider similar Syslog entries with different 
parameter values as separate alarms.  

The Syslog entries with parameter values matching those configured in the Param Value fields 
is counted. When the number of Syslog entries with matched Param Values equals the number 
configured in the Repeated Times field within the time configured in the Repeat Interval 
window is escalated to an alarm. 

 Count Parameter—Click the checkbox to the left of the parameter name under Count 
Parameter if you want IMC to match the value you define in the Param Value field to the 
right with the contents of each Syslog entry. 

 Param Name—Contains the parameter name that IMC uses to match against the contents 
of Syslog entries. 

 Parameter Type—Specify whether the color of links in topologies changes when alarms 
are generated by Syslog events for the links. Select Noninterface Parameter, Interface 
Index, or Interface Description from the list. If you select Noninterface Parameter, the 
link color in topologies does not change when alarms are generated by Syslog events for 
the links. If you select Interface Index or Interface Description, the color of links in 
topologies changes when alarms are generated by Syslog events for the links. 

 Param Value—Enter the value of the parameter that IMC uses to match against the 
contents of Syslog entries in the Param Value field. 

 

 NOTE: 

If you enter 'N/A' in the Param Value field, or you uncheck the checkbox for Count Parameter, IMC 
evaluates Syslog entries by Count Type without evaluating the parameter values in the Syslog 
entries 
 

Configuring Alarm recovery  

The following steps outline the configuration parameters for the alarm recovery or resolution 
configuration options for this rule. 

To configure alarm recovery: 

1. If you want to associate a Syslog resolution event with the Syslog event identified in this rule, 
select Alarm Recovery Rule. 

2. Select the type of Syslog event that IMC uses to resolve the condition identified by this Syslog 
to alarm rule from the Syslog Type list. 

3. Select the Syslog Levels of the events that is processed by this alarm recovery rule by clicking 
the checkboxes to the left of the Syslog Level. 

4. Enter a description for this alarm recovery rule in the Description field. 
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The valid length is 0-128 characters. 

5. Select the Syslog template to apply to this alarm recovery rule by clicking Select next to the 
Syslog Template field in the Alarm Recovery Rule section of the Add Rule page. 

6. Select the Syslog template you want to use from the list of existing Syslog templates displayed 
in the Select dialog box. Select the Syslog template you want to apply to this alarm recovery 
rule. 

7. If the Syslog template contains variables or parameters, the Add Rule page updates to include 
a Recovery Alarm key Parameters field that lets you select one or more parameters. To add 
parameters to the alarm recovery or resolution rule: 

8. Do one of the following: 

 Click the right arrow key  to add one parameter. 

 Click  to add all parameters. 

 Click the left arrow key  to remove one parameter. 

 Click  to remove all parameters. 

If your Syslog to Alarm rule requires a user-defined Syslog template, you must create that 
template before creating the Syslog to Alarm rule. 

9. Click OK. 

Modifying a user-defined Syslog to alarm rule 

1. Navigate to Syslog to Alarm. 

2. Click the Alarm tab from the top tabular navigation system. 

3. Click Syslog Management on the left navigation tree. 

4. Click Syslog to Alarm under Syslog Management on the left navigation tree. 

IMC displays all Syslog to Alarm rule entries in the Syslog to Alarm Rule list displayed in the 
main pane of the Syslog to Alarm window. 

5. Click the Modify icon  associated with the Syslog to alarm rule you want to modify. 

You can only modify user defined Syslog to alarm rules. In addition, you cannot modify the 
name of a Syslog to alarm rule once the rule has been created. 

6. Do one of the following: 

 Select Disabled if you want to disable this rule. 

 Select Enabled to enable this rule. 

7. Enter a description for this Syslog to Alarm rule in the Description field.  

Valid length is 0-128 characters. 

The following steps outline the configuration parameters for the alarm generation aspects of 
this rule. 

8. Select the type of Syslog event to be processed by this rule from the Syslog Type list. 

9. Select the syslog levels of the events that are processed by this rule by clicking the checkboxes 
to the left of the Syslog Level. 

10. Do one of the following to select the method for summarizing Syslog entries: 

 Select Network if you want IMC to summarize matching Syslog entries for the entire 
network.  

 Select Single Device if you want IMC to summarize matching Syslog entries by device. 

Repeat Interval defines the window of time in seconds that Syslog entries can be considered 
duplicate. 

11. Change the window of time value by entering a new value in seconds in the Repeat Interval 
field.  
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12. To modify how many duplicate Syslog entries must be received before generating an alarm, 
enter the new number of duplicate Syslog entries in the Repeat Times field.  

13. Select the alarm level that IMC applies to all Syslog entries that match this rule from the Alarm 
Level list. 

14. In the Alarm Description field, enter a new string that matches some or all of the content in the 
Syslog event description field that must be matched for this rule to generate an alarm in IMC. 

15. Do one of the following: 

 Select Yes in the Forward to SCC field. 

 If you do not want to forward Syslog events to SCC, select No in the Forward to SCC field. 

16. Modify the Syslog template to be used with this rule clicking Select next to the Syslog 
Template field. 

17. Select the Syslog template you want to use from the list of existing Syslog templates displayed 
in the Select dialog box.  

18. Select the Syslog template you want to apply to this rule. 

If the Syslog template contains parameters, the Add Rule page updates to include a Param 
Setting section that lets you configure parameter settings for the template to match parameter 
values in the Syslog entry. IMC includes the following configuration options that determine how 
IMC counts Syslog entries: 

 Count Type—determines how IMC treats similar Syslog events with different parameter 
values. 

19. Select Summing Count if you want IMC to consider similar Syslog entries as one alarm without 
distinguishing between different parameter values.  

Alarms are generated when the number of matched Syslog entries, regardless of parameter 
values, equals the number of Syslog entries configured in the Repeated Times field within the 
time configured in Repeat Interval window. 

20. Select Classifying Count if you want IMC to consider similar Syslog entries with different 
parameter values as separate alarms.  

The Syslog entries with parameter values matching those configured in the Param Value fields 
is counted. When the number of Syslog entries with matched Param Values equals the number 
configured in the Repeated Times field within the time configured in the Repeat Interval 
window is escalated to an alarm. 

 Count Parameter—Click the checkbox to the left of the parameter name under Count 
Parameter if you want IMC to match the value you define in the Param Value field to the 
right with the contents of each Syslog entry. 

 Param Name—Contains the parameter name that IMC uses to match against the contents 
of Syslog entries. 

 Param Value—Enter the value of the parameter that IMC uses to match against the 
contents of Syslog entries in the Param Value field. 

 

 NOTE: 

If you enter 'N/A' in the Param Value field, or you uncheck the checkbox for Count Parameter, IMC 
evaluates Syslog entries by Count Type without evaluating the parameter values in the Syslog 
entries 
 

The following steps outline the configuration parameters for the alarm recovery or resolution 
configuration for this rule. 

To configure alarm recovery or resolution:  

1. If you want to modify the Syslog resolution event to the Syslog event identified in this rule, click 
the checkbox  to the left of Alarm Recovery Rule. 

2. Select the type of Syslog event that IMC uses to resolve the condition identified by this Syslog 
to alarm rule from the Syslog Type list. 
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3. Select the Syslog Levels of the events that is processed by this alarm recovery rule by clicking 
the checkboxes to the left of the Syslog Level. 

4. Select the Syslog template to apply to this alarm recovery rule by clicking Select next to the 
Syslog Template field in the Alarm Recovery Rule section of the Add Rule page. 

5. Select the Syslog template you want to use from the list of existing Syslog templates displayed 
in the Select dialog box. Click the radio button  to the left of the Syslog template you want to 
apply to this alarm recovery rule. 

If the Syslog template contains variables or parameters, the Add Rule page updates to include 
a Recovery Alarm key Parameters field that lets you select one or more parameters. 

6. To add parameters to the alarm recovery or resolution rule, do one of the following: 

 Click the right arrow key  to add one parameter. 

 Click  to add all parameters. 

 Click the left arrow key  to remove one parameter. 

 Click  to remove all parameters. 

7. Click OK. 

Copying a Syslog to alarm rule 

1. Navigate to Syslog to Alarm. 

2. Click the Alarm tab from the top tabular navigation system. 

3. Click Syslog Management on the left navigation tree. 

4. Click Syslog to Alarm under Syslog Management on the left navigation tree. 

5. Click the Copy icon  associated with the system or user defined Syslog to alarm rule you 
want to copy. 

6. Delete the existing name and enter a new name for the rule in the Name field of the Copy Rule 
page. 

7. Modify any of the Syslog to Alarm rule settings as needed. 

For more information about modifying a Syslog to alarm rule, see "Modifying a user-defined 
Syslog to alarm rule." 

8. Click OK. 

Enabling and disabling Syslog to alarm rules 

1. Navigate to Syslog to Alarm. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Syslog Management on the left navigation tree. 

c. Click Syslog to Alarm under Syslog Management on the left navigation tree. 

2. Do one of the following: 

 To enable a Syslog to Alarm rule, click the disabled status icon  Disable in the State 
field for the rule. 

 To disable a Syslog to Alarm rule, click the enabled status icon  Enable in the State field 
for the rule. 

Deleting a user-defined Syslog to alarm rule 

1. Navigate to Syslog to Alarm. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Syslog Management on the left navigation tree. 
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c. Click Syslog to Alarm under Syslog Management on the left navigation tree. 

2. Click the Delete icon  associated with the Syslog to alarm rule you want to delete. 

3. Click OK to confirm deletion of the selected rule. 

Browsing alarms 
IMC provides full visibility into all alarms generated by IMC. IMC provides you with alarm views for 
Real-Time Alarms and Root Alarms and an All Alarms view.  

The Real Time Alarms list provides you with a view of the last 50 unrecovered alarms in real time.  

The Root Alarms list displays all unrecovered, root alarms although operators can modify the 
configuration of this list to included non-root alarms.  

The All Alarms list provides you with a view of all alarms, root and symptom, recovered or cleared 
and unrecovered. From the All Alarms view, you can also query the alarm database through search 
capabilities and save those searches for future use.  

All views of alarms offer drill-down capabilities to the device details for the devices that generated the 
event. The Device Details page provides access for monitoring and managing reporting errors for 
the selected device. From the Device Details page, you can also view the ten most recent alarms for 
the selected device.  

All views of alarms also offer drill-down capabilities to the Alarm Details page, where you can view 
specific details about the alarm and take actions to recover, acknowledge, delete, annotate or report 
on alarms.  

IMC also provides views of all faults or errors on the network through the Alarm Statistics charts 
and TopN views with the ability to create user defined Alarm Statistics charts. 

When you enable the alarm distribution function in the configuration file 
iMC\client\conf\faultDistribute.properties and configure related parameters for a third-party 
distribution system, the Distribute menu is added to the All Alarms, Real-time Alarms, and Alarm 
Details pages. You can use this menu to distribute alarms to the third-party workflow system at the 
specified address. 

Alarm details 
The basic component of all alarm browsing in IMC is the individual alarm itself. You can view 
individual alarms through the Alarm Details page but you can only access this page through the 
three alarm browsing portals available in IMC: Real-Time Alarms, Root Alarms and All Alarms 
browsing. Before covering these alarm views, we provide an overview of the Alarm Details page.  

The Alarm Details page provides you with information on a specific alarm and active links to related 
alarms and the Device Details page for details on the source device of the alarm. From this page, 
you can also perform actions on an alarm and access the Alarm Relations Report page.  

Each of the three alarm views, Real-Time Alarms, Root Alarms, and All Alarms has different 
navigation paths to the Alarm Details page. The instructions below provide the steps for navigating 
to the Alarm Details page from and information on alarm actions and alarm reporting. 

Viewing alarm details 

1. Navigate to Alarm Browse. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Browse on the left navigation tree. 

To view alarm details from the real-time alarms page: 

1. Click Real-Time Alarms under Alarm Browse on the left navigation tree. 
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2. Click the link in the Description field in the Real-Time Unrecovered Alarms list for the alarm 
for which you want to view details. 

To view alarm details from the root alarms page: 

1. Click Root Alarms under Alarm Browse on the left navigation tree. 

2. Click the link in the Information field in the Root Alarms list for the alarm for which you want to 
view details. 

To view alarm details from the all alarms page: 

1. Click All Alarms under Alarm Browse on the left navigation tree. 

2. Click the link in the Description field in the Alarm List for the alarm for which you want to view 
details. 

Taking actions on alarms 

The Alarm Details page offers you the ability to take action on each alarm.  

To execute actions from the Alarm Details page: 

1. Navigate to the Alarm Details page using the navigation steps provided in the previous section 
for the alarms page you want to use. 

2. Locate the Action navigation tree located on the right of the Alarm Details page. 

3. Click Recover to recover or clear the alarm. Recovering an alarm has the effect of clearing it in 
IMC. 

When an alarm has been recovered, the select alarm instance is considered resolved and 
removed from notification functions, though recovered alarms can still be viewed from the All 
Alarms view. Recovered alarms are removed from the alarms database according to the 
configuration for Data Export. For more information about the Data Export feature, see "Data 
export."  

There might be a time lag between the recovering or clearing of an alarm and its removal from 
IMC Alarm browsing views. Click Refresh to update the Alarm Browsing view. 

4. Click Acknowledge to acknowledge the alarm. 

5. Click Delete to delete the alarm. 

6. Click Filter the Alarm to add a filtering rule for alarms. You can filter out alarms that you want to 
ignore by defining filter rules. For more information, see "Filtering traps with user-defined trap 
filter rules." 

7. Click Modify Severity on the right Action navigation tree in the Alarm Details page to modify 
the severity of the trap to an alarm. This navigates you to the Trap Definition > Trap Severity 
Setting page. For instructions on modifying a trap to an alarm, see "Modifying trap definition 
severity settings." 

8. Click Edit Maintenance Experience to enter your maintenance notes in the Maintenance 
Experience field in the Edit Maintenance Experience dialog box. 

9. Click the Performance Data to view history performance data of the monitor instance on which 
the alarm was generated. This field is available only for performance alarms. 

10. Click Alarm Relation Report to view the report for this alarm. 

11. Click Previous to view the previous Trap Details page. 

12. Click Next to view the next Trap Details page. 

Viewing the alarm relation report 

With the Alarm Relation Report, you can view and print to PDF a formatted report that includes the 
details for an individual alarm. In addition, you can export the data in the Alarm Relation Report to 
a .pdf, .xls, .csv, .docx, .rtf, .xlsx, or .pptx file. 

To view the Alarm Relation Report, click Alarm Relation Report located on the Action navigation 
tree on the right of the Alarm Details page. The Alarm Relation Report is displayed in the 
Intelligent Analysis Report Viewer page. 
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To print the report to a .pdf file: 

1. Access the Alarm Relation Report. 

2. Click the Print icon  located on the toolbar at the top of the Alarm Relation Report. 

3. Select the desired Page Range. 

4. Click Export. 

To export the report: 

1. Access the Alarm Relation Report. 

2. Click the Export icon  located on the toolbar at the top of the Alarm Relation Report. 

3. Select the desired export file format from the File Format list. 

Options include: 

 PDF 

 XLS 

 CSV 

 DOCX 

 RTF 

 XLSX 

 PPTX 

4. Select the desired Page Range. 

5. Click Export. 

Modifying performance threshold 

Use this function to modify the threshold for the performance instance that generates the alarm. This 
function is applicable only to performance alarms. 

1. Click the Performance Threshold link in the Advanced Performance section of the right 
navigation tree on the alarm's Alarm Details page. 

The Modify Index dialog box opens. 

By default, the Global Index Settings option is selected and all other parameters are 
unavailable, indicating the threshold settings are the same as those configured for the index in 
Global Index Settings. 

2. Deselect the Global Index Settings option and set the first and second thresholds. For more 
information, see "Modifying a global monitor in the global index settings." 

Querying alarms in IMC 
IMC provides search capabilities that are accessed through one or more of the alarm browsing views 
accessed under the Alarm tab. 

To query for alarms: 

1. Navigate to All Alarms. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Browse on the left navigation tree. 

c. Click All Alarms under Alarm Browse on the left navigation tree. 

2. Enter an alarm source or a description in the field in the upper right corner of the All Alarms 

page, and click the search icon , or click the Advanced icon  located in the upper right 
corner of the page. 

The search criteria dialog box opens. 

3. Specify the following query criteria: 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 9098



697 

 Device IP—Enter the IP address of the device you want to view alarms for in the Device IP 
field and click Add. The Selected Devices field is updated to display the IP addresses you 
have added. This field supports fuzzy matching. 

 Selected Devices—Select the devices you want to include in your query by clicking Select 
located next to the Selected Devices field. On the Select Devices dialog box that opens, 
select devices by using the By View or Advanced option. 

 Selected Views—Select the custom view you want to include in your query criteria from the 
Custom View list. This limits your query to alarms generated for one or more devices in the 
custom view as well as any subviews under the selected custom view. 

 Alarm Level—This option allows you to query for a specific alarm or severity level. Select 
one or more levels to the left of the alarm level for which you want to search. 

 Type—This option allows you to select the alarm source type: Trap or IMC. Select this 
option from the Type list. To search alarms whose source are SNMP traps, select Trap. To 
search alarms whose source is Syslog events, select Syslog. To search or filter the list for 
alarms that were generated by IMC itself, select IMC. 

 Alarm Category—This option allows you to refine your alarm search by selecting from a list 
of alarm categories defined by IMC. 

 Alarm At—This option allows you to define the starting and ending date and time for your 
search. 

 Recovery Status—This option allows you to select the alarm status to query for: 
Recovered or Unrecovered. Select this option from the Recovery Status list. 

 Acknowledgement Status—This option allows you to select alarms that have or have not 
been acknowledged by an operator. Select this option from the Acknowledgement Status 
list. 

 Description—This field allows you to enter a string to match against the contents of an 
alarm's description field. Separate multiple query strings with commas (,) and set the logical 
combination to AND, OR, or No. The default logical combination is OR. 

 Interface Index—This field allows you to enter an integer to match against the interface 
index of an alarm. 

4. Click Query to begin your search. View the results of your query after the query has completed. 

5. Click Reset to reset both the query values and the search results. Re-enter your search criteria. 

6. Click Save As to save your query as a Query View.  

After you have saved a query view, you can access it by clicking the Expand icon  next to All 
Alarms on the left navigation tree. 

Browsing real-time alarms 
The Real Time Alarms List provides you with a view of the last 50 unrecovered alarms in real time. 
In addition, you can view the particular details of an individual alarm, take action on the select alarm 
including recover, acknowledge, delete or annotate an alarm and print or export the individual alarm 
details. 

Browsing real-time alarms 

1. Navigate to Real-Time Alarms. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Browse on the left navigation tree. 

c. Click Real-Time Alarms under Alarm Browse on the left navigation tree. 

IMC displays fifty real-time unrecovered alarms in the Real-Time Unrecovered Alarms list 
displayed in the main pane of the Real-Time Alarms window. For each alarm, the following 
information is provided: 
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 Level—Contains the alarm or severity level of the alarm. For more information about alarm 
or severity levels, see "Exploring the IMC interface." 

 Alarm Source—Contains the name and or IP address of the device to which this alarm 
refers.  

Device names and device IP addresses that are grayed out indicate either that the alarm is 
generated by the IMC server or that the device is unmanaged.  

This field contains an active link to navigate you to the Device Details page for the source 
of this alarm. Click this link to navigate to source device details page of this alarm. 

 Type—Contains the source type of this alarm. The contents of this field identify whether the 
alarm was generated by a trap, by IMC, or by a Syslog entry. 

 Description—Contains a description of the condition that triggered this alarm.  

This field contains an active link to navigate you to the Alarm Details page for this alarm. 
The Alarm Details page provides more detailed information for each alarm. For more 
information about the Alarm Details page, see "Alarm details." 

This field also contains the Crystal Reports Alarm Relation Report icon , which you can 
click to display the report. For more information about this report, see "Viewing the alarm 
relation report." 

 Alarm At—Contains the date and time stamp for IMC's receipt of this alarm. 

 Report—Contains an active link to navigate you to the report page for this alarm. The report 
page provides the root analysis of the alarm and all devices that are related to the alarm. 

2. In the upper right corner of the Real-Time Unrecovered Alarms view, select Real-Time 
Alarms or Root Alarms from the Show list. 

3. Modify the refresh rate for this page by clicking the Refresh Interval list located in the upper 
right corner of the Real-Time Unrecovered Alarms view. 

You can only view alarms for devices over which you have management access and control. In 
addition, you can recover, acknowledge or delete alarms for only those devices to which you have 
write access. 

Viewing filtered real-time alarms 

1. Navigate to Real-Time Alarms. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Browse on the left navigation tree. 

c. Click Real-Time Alarms under Alarm Browse on the left navigation tree. 

2. Configure the filter criteria in the upper right corner of the page: 

a. Enter a partial or complete IP address in the Search Device IP field. 

b. Click the Expand icon  next to the search Device IP field and configure the 
Acknowledgement Status, Alarm Level, and Type parameters. 

The real-time alarm page displays real-time alarms that match the specified filter criteria when 
the page is refreshed next time. 

To save the specified filter criteria, click the Add to My Favorites icon  to add the current 
page to my favorites. When you access the real-time alarm page from my favorites, the page 
displays the real-time alarms that match the saved specified filter criteria. 

Viewing alarm details on the real-time alarms page 

1. Navigate to Real-Time Alarms. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Browse on the left navigation tree. 

c. Click Real-Time Alarms under Alarm Browse on the left navigation tree. 

2. Locate and click the link in the Description field in the Real-Time Unrecovered Alarms list for 
the alarm details you want to view. 
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Performing actions on the alarm in the alarm details page 

1. Locate the Action navigation tree located on the right of the Alarm Details page. 

2. Click Recover to recover the alarm.  

Recovering an alarm has the effect of clearing it in IMC. When an alarm has been recovered, 
the selected alarm instance is removed from IMC browsing and notification functions.  

3. Click Acknowledge to acknowledge the alarm. 

4. Click Delete to delete the alarm. 

5. Click Edit Maintenance Experience to annotate the alarm with maintenance notes. 

6. Enter your maintenance notes in the Maintenance Experience field in the Edit Maintenance 
Experience dialog box. 

7. Click Alarm Relation Report to view the report for this alarm. 

Viewing the alarm relation report 

1. Locate the Action navigation tree located on the right of the Alarm Details page. 

2. Click Alarm Relation Report to view the report for this alarm.  

You can view and print to PDF a formatted report that includes the details of individual alarms. In 
addition, you can export the data in Alarm Relation Reports to a .pdf, .xls, .csv, .docx, .rtf, .xlsx, 
or .pptx file. 

To print the report to a .pdf file: 

1. Access the Alarm Relation Report page. 

2. Click the Print icon  located on the toolbar at the top of the Alarm Relation Report. 

3. Select the desired Page Range. 

4. Click Export. 

To export the report: 

1. Access the Alarm Relation Report page. 

2. Click the Export icon  located at the toolbar at the top of the Alarm Relation Report. 

3. Select the desired export file format from the File Format list. 

Options include: 

 PDF 

 XLS 

 CSV 

 DOCX 

 RTF 

 XLSX 

 PPTX 

4. Select the desired Page Range. 

5. Click Export 

Recovering alarms from the real-time alarms page 

Recovering an alarm has the effect of clearing it from the real-time view. When an alarm has been 
recovered, the selected alarm instance is considered resolved and removed from notification 
functions, though recovered alarms can still be viewed from the All Alarms view.  

Recovered alarms are removed from the alarms database according to the configuration for Data 
Export. For more information about the Data Export feature, see "Data export."  

To recover one or more alarms from the Real-Time Alarms page: 

1. Navigate to Real-Time Alarms. 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 9101



700 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Browse on the left navigation tree. 

c. Click Real-Time Alarms under Alarm Browse on the left navigation tree. 

2. Select the real time alarms you want to recover. 

3. Click Recover located in the upper left corner of the Real-Time Alarms window or click 
Recover located in the lower right corner of the alarm list. 

Deleting alarms from the real-time alarms list 

Deleting alarms is one way of removing alarms from the alarms database. As a best practice, do not 
use this method because deleting an alarm removes the event from the alarm database and along 
with it the ability to report on it. Alarm histories are a valuable data source for performance 
management of the network infrastructure and this should be considered before deleting alarms.  

Rather than deleting, you can recover an alarm. Recovering an alarm clears it from IMC alarm views 
while retaining it in the alarm database for a period of time. You can configure the data export 
function to export the Alarm database in order to keep a history of alarms. For more information 
about data exporting, see "Data export." 

To delete an alarm: 

1. Navigate to Real-Time Alarms. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Browse on the left navigation tree. 

c. Click Real-Time Alarms under Alarm Browse on the left navigation tree. 

2. Select the real time alarms you want to delete. 

3. Click Delete located in the upper left corner of the Real-Time Alarms window or click Delete 
located in the lower right corner of the alarm list. 

4. Click OK when prompted to confirm deletion. 

Browsing all alarms 
The All Alarms List provides a view of all alarms, root and symptom, recovered or cleared and 
unrecovered. From the All Alarms view, you can also query the alarm database through search 
capabilities and save those searches for future use.  

In addition, you can view the particular details of an individual alarm, take action on the selected 
alarm including recover, acknowledge, delete or annotate an alarm and print or export the individual 
alarm details. 

IMC supports deleting, recovering, and acknowledging all alarms. For more information, see 
"Processing all alarms." 

Browsing all alarms 

1. Click the Alarm tab from the top tabular navigation system. 

2. Click Alarm Browse on the left navigation tree. 

3. Click All Alarms under Alarm Browse on the left navigation tree.  

IMC displays all alarm entries in the Alarm List displayed in the main pane of the All Alarms 
window, including this information: 

 Level—Contains the alarm or severity level of the alarm. For more information about alarm 
or severity levels, see "Exploring the IMC interface." 

 Alarm Source—Contains the name and or IP address of the device to which this alarm 
refers.  

Device names and device IP addresses that are grayed out indicate that the alarm is 
generated by the IMC server or an unmanaged device.  
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This field contains an active link to navigate you to the Device Details page for the source 
of this alarm. 

 Type—Contains the source type of this alarm. The contents of this field identify whether the 
alarm was generated by a trap, by IMC, or by a Syslog entry. 

 Description—Contains a description of the condition that triggered this alarm.  

This field contains an active link to navigate you to the Alarm Details page for this alarm. 
The Alarm Details page provides more detailed information for each alarm. For more 
information about the Alarm Details page, see "Alarm details." 

This field also contains the Crystal Reports Alarm Relation Report icon , which you can 
click to display the report. For more information about this report, see "Viewing the alarm 
relation report." 

 Recovery—Contains information on whether the alarm is recovered or unrecovered. 

 Ack Status—Contains information on whether or not the alarm has been acknowledged or 
not. If the alarm has been acknowledged, it contains the name of the operator who 
acknowledged the alarm. 

 Alarm At—Contains the date and time stamp for IMC's receipt of this alarm condition. 

 Recovered At—Contains the date and time stamp for the recovery or clearing of this event. 

 Persisted For—Contains the duration of the error condition. Persisted time is measured as 
the amount of time that transpired since the receipt of the event that triggered an alarm and 
the resolution of the event.  

 Report—Contains an active link to navigate you to the report page for this alarm. The report 
page provides the root analysis of the alarm and all devices that are related to the alarm. 

 Have Presentation Alarms or Not—Indicates whether the current alarm is the root alarm 
of other alarms. If the current alarm affects other alarms, the current alarm is considered as 
having presentation alarms. The current alarm can also be a presentation alarm of another 
alarm. 

 Operation—If the current alarm has child alarms,  the Operation column displays the 
Show Root Alarm link.  For more information, see "Viewing the alarm relationship". If not, 
the Operation column displays nothing. 

4. In the upper right corner of the All Alarms view, select All Alarms or Root Alarms from the 
Show list. 

You can sort the All Alarms list by the Type, Level, Alarm Source, Description, Recovery, 
Ack Status, Alarm at, and Recovered at fields. Click the column label to sort the list by the 
selected field. The column label is a toggle switch that lets you toggle between the various sort 
options specific to each field. 

 Click  to page forward in the All Alarms list. 

 Click  to page forward to the end of the All Alarms list. 

 Click  to page backward in the All Alarms list. 

 Click  to page backward to the front of the All Alarms list. 

 Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items 
per page you want to view. 

 For lists that have more than one page, click 1, 2, 3, 4, 5, 6, 7, 8, 9, or 10 from the upper 
middle of the main pane to jump to a particular page of the list.  

You can only view alarms for devices over which you have management access and control. In 
addition, you can recover, acknowledge or delete alarms for only those devices to which you 
have write access. 
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Viewing the alarm relationship 

Perform this task to view alarms affected by a root alarm, including child alarms and sibling alarms. 
You can also view the relationship between the alarm source and devices and interfaces connected 
to the alarm source in a root alarm relationship graph. 

1. Log in to IMC. 

2. Click the Alarm tab from the top tabular navigation system. 

3. Click Alarm Browse on the left navigation tree. 

4. Click All Alarms under Alarm Browse on the left navigation tree.  

The All Alarms page opens and displays all alarms in a list. 

5. Click the Operation icon  for an alarm that has presentation alarms, and then select Show 
Root Alarm from the shortcut menu. 

The Root Alarm page opens. 

6. Click the Root Alarms tab to view the current root alarm and the related alarms that are 
displayed in a hierarchical structure. 

7. Click the Relationship Graph to view the nodes and links that correspond to the current root 
alarm and the related alarms. 

Performing actions in the all alarms page 

1. Select the alarms you want to take action on from the alarm list. 

2. To recover the selected alarms, click Recover. 

There might be a time lag between the recovering or clearing of an alarm and its removal from 
IMC Alarm browsing views. 

3. To acknowledge the selected alarms, click Acknowledge. 

4. To delete the selected alarms, click Delete. 

Querying alarms in the all alarms page 

The All Alarms page lets you search the IMC Alarms database. For more information about 
querying alarms in IMC, see "Browsing all alarms." 

Viewing alarm details from the all alarms page 

1. Navigate to All Alarms. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Browse on the left navigation tree. 

c. Click All Alarms under Alarm Browse on the left navigation tree. 

2. Locate and click the link in the Description field in the All Alarms list for the alarm for which 
you want to view details. 

Performing actions on the alarm in the alarm details page 

1. Locate the Action navigation tree located on the right of the Alarm Details page. 

2. Click the Recover link to recover the alarm.  

Recovering an alarm has the effect of clearing it from the view. When an alarm has been 
recovered, the selected alarm instance is considered resolved and removed from notification 
functions, though recovered alarms can still be viewed from the All Alarms view. Recovered 
alarms are removed from the alarms database according to the configuration for Data Export. 
For more information, see "Data export."  

There might be a time lag between the recovering or clearing of an alarm and its removal from 
IMC Alarm browsing views. 

3. Click the Acknowledge link to acknowledge the alarm. 

4. Click the Delete link to delete the alarm. 
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5. Click the Edit Maintenance Experience and then enter your maintenance notes in the 
Maintenance Experience field in the Edit Maintenance Experience dialog box. 

6. Click the Alarm Relation Report link to view the report for this alarm. 

7. Click the Back link to return to the previous page. 

Viewing the alarm relation report 

1. Locate the Action navigation tree located on the right of the Alarm Details page. 

2. Click the Alarm Relation Report link to view the report for this alarm.  

The Alarm Relation Report is displayed in the Intelligent Analysis Report Viewer window. 

With the Alarm Relation Report, you can view and print to PDF a formatted report that includes the 
details of individual alarms. In addition, you can export the data in Alarm Relation Reports to 
a .pdf, .xls, .csv, .docx, .rtf, .xlsx, or .pptx file. 

To print the repot to a .pdf file: 

1. Access the Alarm Relation Report. 

2. Click the Print icon  located on the toolbar on the top of the Alarm Relation Report. 

3. Select the desired Page Range. 

4. Click Export. 

To export report data: 

1. Access the Alarm Relation Report. 

2. Click the Export icon  located on the toolbar on the top of the Alarm Relation Report. 

3. Select the desired export file format from the File Format list. 

Options include: 

 PDF 

 XLS 

 CSV 

 DOCX 

 RTF 

 XLSX 

 PPTX 

4. Select the desired Page Range. 

5. Click Export. 

Customizing the all alarms list columns 

Operators can customize the All Alarms list to meet their individual alarm view needs. 

To customize the All Alarms list: 

1. Navigate to All Alarms. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Browse on the left navigation tree. 

c. Click All Alarms under Alarm Browse on the left navigation tree. 

2. In the upper part of the Alarm List, click More. From the menu that appears, select Custom 
the table columns. The Custom the table columns dialog box opens. 

3. Clear check boxes to the left of the column name to remove specific columns from the All 
Alarms list. 

4. Reorder the appearance of one or more columns in the list by using the Compositor icons next 
to each column name: 

 Use  to move the column to the leftmost position. 
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 Use  to move the column one position to the left. 

 Use  to move the column one position to the right. 

 Use  to move the column to the rightmost position. 

5. Click OK to save your changes. 

6. Click Default to restore the All Alarms list to its default appearance. 

Recovering alarms from the all alarms page 

Operators can recover one or more alarms from the All Alarms list. Recovering an alarm has the 
effect of clearing it from the view. When an alarm has been recovered, the selected alarm instance is 
considered resolved and removed from notification functions, though recovered alarms can still be 
viewed from the All Alarms view.  

Recovered alarms are removed from the alarms database according to configuration for Data 
Export. For more information about IMC's Data Export feature, see "Data export."  

To recover one or more alarms from the All Alarms page: 

1. Navigate to All Alarms. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Browse on the left navigation tree. 

c. Click All Alarms under Alarm Browse on the left navigation tree. 

2. Select the alarms you want to recover. 

3. In the upper part of the Alarm List, click More, and select Recover reported alarms from the 
menu that appears. 

Deleting alarms from the root alarms list 

Deleting is one option for removing alarms from the IMC alarms database. As a best practice, do not 
use this option because deleting an alarm removes the event from IMC alarm database and along 
with it the ability to report on it.  

Alarm histories are a very valuable data source for performance management of the network 
infrastructure and this should be considered before deleting alarms. Rather than deleting, you can 
recover an alarm. Recovering an alarm clears it from IMC alarm views while retaining it in the alarm 
database for a period of time. You can configure the IMC data export function to export the Alarm 
database in order to keep a history of alarms. For more information about data exporting, see "Data 
export." 

Deleting alarms from the all alarms page 

To delete an alarm from the All Alarms list: 

1. Navigate to All Alarms. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Browse on the left navigation tree. 

c. Click All Alarms under Alarm Browse on the left navigation tree. 

2. Select the alarms you want to delete. 

3. Click Delete located in the upper left corner of the All Alarms page. 

4. Click OK to confirm deletion of the select alarms. 

Exporting alarms from the all alarms page to Excel 

IMC provides you with the ability to export alarms to Excel for further analysis. When the number of 
alarm entries is no more than 5000, IMC exports these alarm entries to a CSV file. When the number 
of alarm entries is more than 5000, IMC exports these alarm entries to CSV files in batches of 5000, 
and automatically compresses all CSV files to a ZIP file for you to download. 

To export all alarms from the All Alarms list to Excel: 

1. Navigate to All Alarms. 
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a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Browse on the left navigation tree. 

c. Click All Alarms under Alarm Browse on the left navigation tree. 

2. In the upper part of the Alarm List, click More, and select Export as CSV from the menu that 
appears. 

3. Follow the instructions in the Download Exported Data dialog boxes to complete the export of 
data to Excel. 

Viewing faulty devices 
The Faulty Devices view offers you a graphical view of devices in the network infrastructure that are 
reporting errors. From this view, you can navigate to the device details page for quick access to 
devices that are reporting errors. 

To view the Faulty Devices view: 

1. Navigate to Faulty Devices. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Browse on the left navigation tree. 

c. Click Faulty Devices on the left navigation tree.  

2. To view updates to the Faulty Device list, click Refresh located in the upper left corner of the 
page. IMC rechecks the alarms database and updates the Faulty Device list.  

Graphical icons and device names and IP addresses are displayed in the Faulty Devices list 
for those devices that are reporting errors.  

3. To view alarms for these devices, click the icon or device name to drill down to the Device 
Details page.  

For more information about navigating the Device Details page, see "Accessing the device 
details page."  

 

 NOTE: 

 Operators can only view devices to which they have been granted management access.  

 The color of a device icon in the Faulty Devices list represents the alarm or severity level for the 
most severe alarm condition for that device.  

 If a device's most severe alarm condition is "Info," the device is not displayed in the Faulty 
Device list as these alarms are ignored. 

 

Viewing alarm statistics 
The Alarm Statistics view provides a summary of unrecovered alarm statistics. The statistical 
summaries offered in this view include alarms by application, configuration, security, performance, 
device, and a graph for all unrecovered alarms.  

In addition, the Alarm Statistics view offers drilldown capabilities from the summary reports to the 
All Alarms list and the powerful search capabilities of the All Alarms page. 

Viewing alarm statistics charts 

1. Navigate to Alarm Statistics. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Browse on the left navigation tree. 

c. Click Alarm Statistics under Alarm Browse on the left navigation tree.  

The Alarm Statistics page opens.  
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The Alarm Statistics page summarizes alarms by category with active links embedded in 
the summary charts. 

2. To view the individual alarms that underlie the summary charts, click the summary chart. 

3. To view more details about the statistical breakdown by alarm category, click the active chart 
titles located at the top of each summary chart. 

4. Click Refresh to refresh the Alarm Statistics charts. 

Creating user-defined alarm statistics charts 

To add your own statistical charts to the Alarm Statistics page: 

1. Navigate to Alarm Statistics. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Browse on the left navigation tree. 

c. Click Alarm Statistics under Alarm Browse on the left navigation tree.  

The Alarm Statistics page opens.  

2. Click Add at the top of the page. 

3. Enter a name for this chart in the Statistics Name field. 

4. Click Select under Select Alarm Category to select the alarm categories for which you want to 
create a summary Alarm Statistics chart. 

5. Select Main Category names to add that category to your chart. 

6. Click OK. 

7. Select the devices you want to include in this Alarm Statistics chart. 

8. Select All Devices if you want this chart to summarize alarms for all devices in IMC. 

9. Click Select if you want to specify which devices or groups of devices to summarize alarms for 
in this chart. 

10. Select the devices you want to add by using the add By View or by Advanced query functions 
in the Select Devices dialog box.  

For more information, see "Adding devices by view" and "Adding devices by advanced query." 

11. Click OK when you have completed your selection of devices.  

The user defined Alarm Statistics chart you have created is displayed on the Alarm Statistics 
page. 

12. To modify the user defined Alarm Statistics chart you have created, click the Modify icon  
located in the upper right corner of the chart. 

13. Modify any parameters as needed. 

14. Click OK. 

15. To delete a user defined Alarm Statistics chart you have created, click the Delete icon  
located in the upper right corner of the chart. 

16. Click OK to confirm deletion of the user defined chart you have created. 

Viewing TopN devices 
The TopN view offers you a view of devices in the network infrastructure that are reporting the 
highest number of errors by the alarm or severity level. From this view, you can quickly navigate to 
the device details page for those devices that are reporting the most errors. Operators can also 
configure how many devices to include in the TopN view.  

To access the TopN view:  

1. Navigate to TopN. 

a. Click the Alarm tab from the top tabular navigation system. 
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b. Click Alarm Browse on the left navigation tree. 

c. Click TopN under Alarm Browse on the left navigation tree. 

2. To adjust the number of devices included in the TopN view, select the number from the TopN 
list located in the upper right corner of the TopN page. 

3. Click Refresh to refresh the contents of the TopN page. 

Device names and IP addresses are displayed in the subsections of the TopN list for those 
devices that are reporting the highest number of errors for each severity or alarm level. To view 
alarms for these devices, click the device name to display the Device Details page. For more 
information about navigating the Device Details page, see "Accessing the device details 
page." 

Configuring alarm notifications 
IMC supports the ability to send notifications for alarms and can be configured to: 

 Send notifications by mail or text messaging to designated recipients. 

 Forward alarms to other management systems such as help desk systems for proactive 
escalation of alarms generated by IMC. 

 Forward alarms to other IMC instances in a distributed architecture for centralized alarm 
viewing and notification.  

 Manage the number of alarms generated, directly affecting how IMC escalates root alarms 
through its configuration of relationship to network devices. 

Managing mail alarm notifications 
IMC provides extensive control and flexibility over the management of alarms it generates. You can: 

 Set alarms to trigger mail and SMS text message notifications to recipients defined by the 
administrator.  

 Forward alarms to other management systems.  

 Configure times of the day and days of the week that notifications are sent or forwarded to other 
management systems. 

 Configure which alarm types generate notifications or forwarding to other management 
systems. 

 Configure which devices trigger mail, SMS messaging, or alarm forwarding to other 
management systems when an alarm condition occurs. 

 Configure which severity or alarm levels trigger mail, SMS messaging notification or alarm 
forwarding to another management system. 

All of these alarm configuration options can be combined into one or more alarm notification 
rules, providing the ability to customize IMC to meet organizational alarm notification needs. 

Configuring the mail content format 

1. Navigate to Alarm Notification. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Settings on the left navigation tree. 

c. Click Alarm Notification under Alarm Settings on the left navigation tree. 

2. Click Configure Mail Content Format in the upper right corner of the Alarm Notification 
page. 

The Configure Mail Content Format window is displayed. 

3. Configure the mail parameters in the Mail Format area. You can also configure those 
parameters on the System > System Settings page.  
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a. Select Yes or No from the Enable Alarm Acknowledgement Mails list to enable or disable 
alarm acknowledgement through mails. After this feature is enabled, each alarm notification 
mail will contain an alarm acknowledgement link. You can click the link to acknowledge the 
alarm. 

b. Select Yes or No from the Enable Public IP list to enable or disable access to IMC from the 
public network.  

c. Enter the public IP address of IMC. This field is required only when Yes is selected for 
Enable Public IP. 

d. Enter the sender name of the alarm notification mail in the Mail Sender field. The default is 
NMS_FaultDM. The sender name is a string of 6 to 16 characters and can contain letters, 
digits, underscores (_), and spaces, but consecutive underscores are not allowed. The 
sender name must start with a letter and cannot end with an underscore. 

4. Customize the mail title and mail content as needed. The default mail title and mail content 
settings will be used if you do not configure these settings.  

To customize the mail content, use parameters in the format of $(parameter name). For 
example: "system alarm $(FaultName) at $(FaultTime) from $(FaultSour)". The dollar sign ($) is 
not allowed in mail contents except in parameters.  

Available alarm parameters and their descriptions are: 

 $(NMSSour)—NMS source. 

 $(FaultSour)—Alarm source. 

 $(FaultLocation)—Location of the alarm source. 

 $(FaultContant)—Person to contact for the alarm. 

 $(FaultName)—Alarm name. 

 $(FaultLevel)—Severity level of the alarm. 

 $(FaultTime)—Time when the alarm was generated. 

 $(FaultDesc)—Description of the alarm. 

 $(FaultDuration)—Duration the alarm has lasted for. 

 $(FaultParas)—Alarm parameters. 

 $(FaultDevIp)—IP address of the device for which the alarm was generated. 

 $(FaultDevName)—Name of the device for which the alarm was generated. 

 $(FaultHoldInfo)—Maintenance information of the device. 

 $(FaultIsRecover)—Whether the alarm has been recovered. 

5. Click OK. 

Adding a mail alarm notification rule 

1. Navigate to Alarm Notification. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Settings on the left navigation tree. 

c. Click Alarm Notification under Alarm Settings on the left navigation tree. 

2. Click Add in the Mail Notification area. 

3. Enter a name for this mail alarm notification rule in the Rule Name field.  

After you create a rule, you cannot modify its name. 

4. Select whether to enable stage forward. By default, this feature is disabled, and the system 
sends notification mails to all destination mail addresses after alarms are generated. When this 
feature is enabled, the system sends notification mails to the specified mail addresses based on 
the specified tolerance time for alarm acknowledgement. 

5. If you enable stage forward, perform the following tasks: 

a. Enter a notification stage name in the Notification Stage Name field. 
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b. Configure the destination mail addresses of the recipients by using one of the following 
methods: 

 To add destination mail addresses manually, enter one or more destination mail 
addresses in the Destination Mail Address field, and click Add next to the Destination 
Mail Address field. Use semicolons (;) to separate multiple destination mail addresses. 

 To add destination mail addresses based on platform users, click Select User next to 
the Destination Mail Address field, select one or multiple platform users, and click OK. 

c. Enter a tolerance time (in minutes) for alarm acknowledgement in the Tolerance Time for 
Alarm Ack field.  

d. Click Add to complete the notification configuration for the current stage. 

You can add multiple notification stages. 

6. If you do not enable stage forward, configure the destination mail addresses of the recipients by 
using one of the following methods: 

 To add destination mail addresses manually, enter one or more destination mail addresses 
in the Destination Mail Address field, and then click Add next to the Destination Mail 
Address field. Use semicolons (;) to separate multiple destination mail addresses. 

 To add destination mail addresses based on platform users, click Select User next to the 
Destination Mail Address field, select one or multiple platform users, and click OK. 

7. Select the alarm levels you want to apply to this mail notification rule next to the Concerned 
Alarm Levels field. 

This field determines which severity or alarm levels trigger notifications. By default, all alarm 
levels except the Info alarm level are selected. 

8. Select All Resources or Selected Devices from the Concerned Resources list. When the 
IMC platform has the APM component installed, you can select Application Group from the 
list.  

 All Resources—With this option, all resources in IMC trigger a mail notification if the alarm 
condition meets the rule's Alarm Level setting.  

For example, if you set the alarm level to critical and major, then all devices in the network 
infrastructure that have a condition that is configured in IMC as a critical or major alarm 
generate a mail notification to all recipients configured in this rule. 

 Selected Devices—With this option, only the selected devices trigger a mail notification if 
the alarm condition meets the rule's Alarm Level setting. You can select devices by Device 
IP address, by Custom Views, by Network Segment, by Concerned Port Groups or by a 
combination of the four. 

 Application Group—This option is displayed only when the APM component is installed. 
With this option selected, a mail notification is triggered only when applications in the 
selected application group meet the alarm forwarding conditions.  

Selecting devices by IP address  

a. Enter the IP address for the device you want to send mail notifications for in the Device IP 
field. 

b. Click Add. 

c. Add multiple devices by clicking Add after entering the IP address in the Device IP field for 
each device you want to add. 

Selecting devices by custom view 

a. Expand the Selected Custom View section of the Add Mail Notification dialog box by 
clicking the Expand icon  located at the far right of Selected Custom View. 

b. Select the custom view from the list. 

c. Click Add. 

d. Add multiple device groups by custom views by clicking Add after selecting one custom 
view from the Custom View list. 
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Selecting devices by network segment 

a. Expand the Selected Network Segment section of the Add Mail Notification dialog box 
by clicking the Expand icon  located at the far right of Selected Network Segment. 

b. Enter the IP address range for the range of devices that you want to send mail notifications 
for, by entering the first IP address in the range in the Start IP field and the last IP address in 
the End IP field. 

c. Click Add. 

d. Add multiple network segment groups by clicking Add after entering the IP address range in 
the Start IP and End IP fields. 

You can add devices by using either the View or Advanced query option. For example, you 
can enter the IP address of one device, an IP address range, and groups defined by custom 
view. The alarm notification rule sends mail notifications for all devices or groups of devices 
configured in the rule.  

For more information, see "Adding devices by view" and "Adding devices by advanced 
query." 

Selecting devices by Concerned Port Groups 

a. Expand the Concerned Port Groups section of the Add Mail Notification dialog box by 
clicking the Expand icon  located at the far right of Concerned Port Groups. 

b. Click Select Port Group and select a view name. 

c. Click OK. 

9. Select All Alarms or Selected Alarms from the Concerned Alarms list.  

This option allows you to configure which error conditions trigger mail notifications. 

 All Alarms—With this option, all alarms configured in IMC trigger a mail notification to be 
sent if the alarm condition is triggered. 

 Selected Alarms—With this option, only the alarms you selected in alarm notification 
trigger a mail notification if the alarm condition is triggered. Further, if you select Selected 
Alarms, you can select which alarm conditions generate mail notifications. 

10. To configure for which conditions to send notifications: 

a. Click Select next to the Concerned Alarms field. The Select Trap dialog box opens. 

b. In the Select Alarm dialog box, locate the Enterprise MIB that contains an object or 
condition that you want to alarm on. 

c. To expand your view of the MIB, click the Expand icon  next to the MIB that contains an 
object or condition that you want to alarm on. 

d. Use the query function located at the top of the Select Alarm dialog box to locate the object 
on which you want an alarm. 

11. Enter one or more of the following search criteria: 

 Trap Name—Enter a partial or complete object name for the trap you want to locate in the 
Trap Name field. 

 Trap OID—Enter a partial or complete Object ID for the trap in the Trap OID field. 

 Severity—Select a severity level for the trap. 

 Enterprise Name—Enter a partial or complete name for the Enterprise MIB you want to 
locate in the Enterprise Name field. 

 Enterprise OID—Enter a partial or complete Enterprise ID for the MIB you want to locate in 
the Enterprise OID field. 

12. Do one of the following:  

 Click Query to submit your search criteria. 

 Click Reset to clear your query criteria and to restore the full list of MIBs and traps The 
results of your query display in the dialog box. 

The results of your query display in the dialog box. 
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13. Enable or disable the Automatically select recovered alarms function. Options are: 

 Open—Enables the Automatically select recovered alarms function. When the selected 
traps have recovered alarms defined, IMC automatically selects the recovered alarms for 
the selected traps. 

 Close—Disables the Automatically select recovered alarms function. When the selected 
traps have recovered alarms defined, IMC does not automatically select the recovered 
alarms for the selected traps. 

14. Select a MIB object on which you want an alarm. 

15. Click OK.  

It may take a while for the Select Trap dialog box to close. When the box closes, it updates the 
Concerned Alarms field with the configured object or alarm condition.  

You can select multiple objects or conditions to alarm on. Each alarm condition is listed in the 
Concerned Alarms field below the list. 

16. Click Parameter Setting next to the Concerned Alarm field.  

The Set Alarm Parameter dialog box opens with all alarms and parameters listed. 

17. Click the trap name to expand the alarm parameters. 

18. Enter the value in the field right of the parameters name: 

 To set multiple values for a parameter, click the Add icon  to add a value. 

 To delete a value, click the Delete icon  for that value. 

 To restore a parameter that you have removed, enter the Set Alarm Parameter page again. 

19. Click OK.  

IMC determines whether to forward the received alarms according to the configured 
parameters. 

20. To delete one or more alarm conditions, highlight the condition(s) and click Delete.  

Not all alarms have parameters.  

When you select multiple MIB objects or alarm conditions, the alarm conditions are evaluated 
and performed as an OR operation. With OR operations, only one of the conditions that you 
select must be true for the alarm notification rule to generate a mail notification. 

21. Confirm that the MIB objects or conditions you selected have populated the Concerned 
Alarms field in the Add Mail Notification page.  

If IMC does not have the vendor's MIBs you want to send as mail notifications, you can add 
them and then add a mail notification rule. For adding a MIB to IMC, see "MIB management." 

22. Enter the hourly range in the Time Ranges field for each day of the week, using an 
hh:mm-hh:mm format.  

To exclude a day of the week, delete any values, including 00:00, from the hourly range for that 
day. 

23. Click OK.  

You must configure IMC to forward mail notifications to the SMTP server in your environment 
for recipients to receive mail alarm notifications. For information about configuring IMC to 
forward mails to your SMTP server, see "Mail server settings." 

Modifying a mail alarm notification rule 

1. Navigate to Alarm Notification. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Settings on the left navigation tree. 

c. Click Alarm Notification under Alarm Settings on the left navigation tree. 

2. Click the Modify icon  for a mail notification rule. 
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3. Configure mail notification rule parameters except the mail notification rule name. For more 
information, see "Configuring the mail content format 

4. Navigate to Alarm Notification. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Settings on the left navigation tree. 

c. Click Alarm Notification under Alarm Settings on the left navigation tree. 

5. Click Configure Mail Content Format in the upper right corner of the Alarm Notification 
page. 

The Configure Mail Content Format window is displayed. 

6. Configure the mail parameters in the Mail Format area. You can also configure those 
parameters on the System > System Settings page.  

a. Select Yes or No from the Enable Alarm Acknowledgement Mails list to enable or disable 
alarm acknowledgement through mails. After this feature is enabled, each alarm notification 
mail will contain an alarm acknowledgement link. You can click the link to acknowledge the 
alarm. 

b. Select Yes or No from the Enable Public IP list to enable or disable access to IMC from the 
public network.  

c. Enter the public IP address of IMC. This field is required only when Yes is selected for 
Enable Public IP. 

d. Enter the sender name of the alarm notification mail in the Mail Sender field. The default is 
NMS_FaultDM. The sender name is a string of 6 to 16 characters and can contain letters, 
digits, underscores (_), and spaces, but consecutive underscores are not allowed. The 
sender name must start with a letter and cannot end with an underscore. 

7. Customize the mail title and mail content as needed. The default mail title and mail content 
settings will be used if you do not configure these settings.  

To customize the mail content, use parameters in the format of $(parameter name). For 
example: "system alarm $(FaultName) at $(FaultTime) from $(FaultSour)". The dollar sign ($) is 
not allowed in mail contents except in parameters.  

Available alarm parameters and their descriptions are: 

 $(NMSSour)—NMS source. 

 $(FaultSour)—Alarm source. 

 $(FaultLocation)—Location of the alarm source. 

 $(FaultContant)—Person to contact for the alarm. 

 $(FaultName)—Alarm name. 

 $(FaultLevel)—Severity level of the alarm. 

 $(FaultTime)—Time when the alarm was generated. 

 $(FaultDesc)—Description of the alarm. 

 $(FaultDuration)—Duration the alarm has lasted for. 

 $(FaultParas)—Alarm parameters. 

 $(FaultDevIp)—IP address of the device for which the alarm was generated. 

 $(FaultDevName)—Name of the device for which the alarm was generated. 

 $(FaultHoldInfo)—Maintenance information of the device. 

 $(FaultIsRecover)—Whether the alarm has been recovered. 

8. Click OK. 

9. Adding a mail alarm notification rule." 

Copying a mail alarm notification rule 

1. Navigate to Alarm Notification: 
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a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Settings on the left navigation tree. 

c. Click Alarm Notification under Alarm Settings on the left navigation tree. 

2. Click the Copy icon  in the Mail Notification list associated with the alarm rule you want to 
copy. 

3. Rename the rule by giving it a unique name. 

4. Make any necessary modifications to the rule in the Copy Mail Notification page. For more 
information about modifying a mail notification, see "Modifying a mail alarm notification rule." 

5. Click OK. 

Enabling or disabling a mail alarm notification rule 

1. Navigate to Alarm Notification. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Settings on the left navigation tree. 

c. Click Alarm Notification under Alarm Settings on the left navigation tree. 

2. Do one of the following: 

 To enable, click  Disable in the Mail Notification Status field associated with the mail 
rule you want to enable. 

 To disable, click  Enable in the Mail Notification Status field associated with the mail 
rule you want to disable. 

Batch enabling or disabling mail alarm notification rules 

1. Navigate to Alarm Notification. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Settings on the left navigation tree. 

c. Click Alarm Notification under Alarm Settings on the left navigation tree. 

2. In the Mail Notification area, do one of the following: 

 To enable, select rules in Disabled status, click Status, and select Batch Enabled.  

 To disable, select rules in Enabled status, click Status, and select Batch Disabled. 

Deleting a mail alarm notification rule 

1. Navigate to Alarm Notification. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Settings on the left navigation tree. 

c. Click Alarm Notification under Alarm Settings on the left navigation tree. 

2. Click the Delete icon  in the Mail Notification list associated with the alarm rule you want to 
delete. 

3. Click OK to confirm deletion of the rule. 

Managing SMS alarm notifications 
You can configure alarm notifications, which are implemented by notification rules, to be sent by 
SMS (text messaging) to devices configured to receive them.  

You can configure one or more rules that define who receives SMS notifications for faults or errors 
and their resolution in the network infrastructure that are specified by the IMC administrator. In 
addition, you can configure which device(s) or groups of devices, which error condition, which alarm 
or severity levels generate SMS notifications. 
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Adding an SMS messaging alarm notification rule 

1. Navigate to Alarm Notification: 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Settings on the left navigation tree. 

c. Click Alarm Notification under Alarm Settings on the left navigation tree. 

2. Click Add in the Message Notification area. 

3. Enter a name for this SMS message notification rule in the Rule Name field. 

After you create a rule, you cannot modify its name. 

4. Select whether to enable stage forward. By default, this feature is disabled, and the system 
sends notification messages to all telephone numbers after alarms are generated. When this 
feature is enabled, the system sends notification messages to the specified telephone numbers 
based on the specified tolerance time for alarm acknowledgement.  

5. If you enable stage forward, perform the following tasks:  

a. Enter a notification stage name in the Notification Stage Name field. 

b. Configure the telephone numbers of the SMS notification recipients by using one of the 
following methods: 

 To add telephone numbers manually, enter a telephone number, including the country 
code and area code, if needed, in the Telephone Number field, and then click Add next 
to the Telephone Number field. Repeat this step to add more telephone numbers. The 
telephone numbers can contain only digits, parentheses (()), plus signs (+), hyphens (-), 
and spaces ( ). 

 To add telephone numbers based on platform users, click Select User next to the 
Telephone Number field, select one or multiple platform users, and click OK. 

c. Enter a tolerance time (in minutes) for alarm acknowledgement in the Tolerance Time for 
Alarm Ack field. 

d. Click Add to complete notification configuration for the current stage.  

You can add multiple notification stages. 

6. If you do not enable stage forward, configure the telephone numbers of the SMS notification 
recipients by using one of the following methods: 

 To add telephone numbers manually, enter a telephone number, including the country code 
and area code, if needed, in the Telephone Number field, and then click Add next to the 
Telephone Number field. Repeat this steps to add more telephone numbers. The 
telephone numbers can contain only digits, parentheses (()), plus signs (+), hyphens (-), and 
spaces ( ). 

 To add telephone numbers based on platform users, click Select User next to the 
Telephone Number field, select one or multiple platform users, and click OK. 

7. Select the alarm levels you want to apply to this SMS message notification rule next to 
Concerned Alarm Levels. 

This field determines which severity or alarm levels trigger notifications. By default, all alarm 
levels except the Info alarm level are selected. 

8. Select All Resources or Selected Devices from the Concerned Resources list. When the 
IMC platform has the APM component installed, you can select Application Group from the 
list. 

 All Resources—If you select this option after initially configuring this option with Selected 
Devices, then IMC overrides the existing configuration by configuring the alarm rule to send 
to all devices. 

 Selected Devices—With this option, only the selected devices trigger an SMS Message 
notification if the alarm condition meets the rule's Alarm Level setting. 
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 Application Group—This option is displayed only when the APM component is installed. 
With this option selected, an SMS message notification is triggered only when applications 
in the selected application group meet the alarm forwarding conditions. 

You can select devices by Device IP address, by Custom Views, by Network Segment, by 
Concerned Port Groups or by a combination of the four.  

9. Select devices by using either the View or Advanced query option.  

For example, you can enter the IP address of one device, an IP address Range, and groups 
defined by custom view. The alarm notification rule forwards alarms for all devices or groups of 
devices configured in the rule.  

For more information, see "Adding devices by view" and "Adding devices by advanced query." 

10. Select All Alarms or Selected Alarms from the Concerned Alarms list, allowing you to 
configure which error conditions trigger SMS message notifications. 

 All Alarms—With this option, all alarms configured in IMC trigger an SMS Message 
notification to be sent if the alarm condition is triggered. 

 Selected Alarms—With this option, only the alarms you select in alarm notification trigger 
an SMS Message notification if the alarm condition is triggered. Further, if you select 
Selected Alarms, you can select which alarm conditions generate SMS Message 
notifications. 

11. To configure for which conditions to send notifications: 

a. Click Select next to the Concerned Alarms field. The Select Trap dialog box opens. 

b. In the Select Alarm dialog box, locate the Enterprise MIB that contains an object or 
condition on which you want an alarm. 

c. To expand your view of the MIB, click the Expand icon  next to the MIB that contains an 
object or condition that on which you want an alarm.  

d. Click the Expand all icon  located in the upper right corner of the Select Alarm dialog 
box to expand your view to display all MIBs, or 

Use the query function located at the top of the Select Alarm dialog box to locate the object 
on which you want an alarm. 

12. Enter one or more of the following search criteria: 

 Trap Name—Enter a partial or complete object name for the trap you want to locate in the 
Trap Name field. 

 Trap OID—Enter a partial or complete Object ID for the trap in the Trap OID field. 

 Severity—Select a severity for the trap. 

 Enterprise Name—Enter a partial or complete name for the Enterprise MIB you want to 
locate in the Enterprise Name field. 

 Enterprise OID—Enter a partial or complete Enterprise ID for the MIB you want to locate in 
the Enterprise OID field. 

13. Click Query to submit your search criteria. The results of your query display in the dialog box.  

Optional: Click Reset to clear your query criteria and to restore the full list of MIBs and traps. 

14. Enable or disable the Automatically select recovered alarms function. Options are: 

 Open—Enable the Automatically select recovered alarms function. When the selected 
traps have recovered alarms defined, IMC automatically selects the recovered alarms for 
the selected traps. 

 Close—Disable the Automatically select recovered alarms function. When the selected 
traps have recovered alarms defined, IMC does not automatically select the recovered 
alarms for the selected traps. 

15. Select a MIB object on which you want an alarm. 

16. Click OK.  

It may take a while for the Select Trap dialog box to close. When the box closes, it updates the 
Concerned Alarms field with the configured object or alarm condition.  
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Select multiple objects or conditions to set alarms on. Each alarm condition is listed in the 
Concerned Alarms field below the list. 

17. Click Parameter Setting next to the Concerned Alarm field, the Set Alarm Parameter dialog 
box opens with all alarms and parameters listed. 

18. Click the trap name to expand the alarm parameters. 

19. Enter the value in the field right of the parameters name: 

 To set multiple values for a parameter, click the Add icon  to add a value. 

 To delete a value, click the Delete icon  for the value. 

 To restore a parameter that you have removed, enter the Set Alarm Parameter page again. 

20. Click OK.  

IMC determines whether to forward the received alarms according to the configured 
parameters. 

21. To delete one or more alarm conditions, highlight the condition(s) and click Delete.  

Not all alarms have parameters.  

When you select multiple MIB objects or alarm conditions, the alarm conditions are evaluated 
and performed as an OR operation. With OR operations, only one of the conditions that you 
select must be true for the alarm notification rule to generate a mail notification. 

22. Confirm that the MIB objects or conditions you select have populated the Concerned Alarms 
field in the Add Mail Notification page.  

If IMC does not have the vendor's MIBs you want to send mail notifications, you can add them 
and then add a mail notification rule. For adding a MIB to IMC, see "MIB management." 

23. Enter the hourly range in the Time Ranges field for each day of the week, using an 
hh:mm-hh:mm format. 

To exclude a day of the week, delete any values, including 00:00, from the hourly range for that 
day. 

24. Click OK.  

You must configure IMC to forward mail notifications to the SMTP server in your environment 
for recipients to receive mail alarm notifications. For information about configuring IMC to 
forward mails to your SMTP server, see "Mail server settings." 

You must configure the SMSC settings in IMC to forward messaging notifications. For 
information about configuring SMSC settings, see "SMSC settings." 

Modifying an SMS alarm notification rule 

1. Navigate to Alarm Notification. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Settings on the left navigation tree. 

c. Click Alarm Notification under Alarm Settings on the left navigation tree. 

2. Click the Modify icon  for an SMS notification rule. 

3. Configure SMS notification rule parameters except the SMS notification rule name. For more 
information, see "Adding an SMS messaging alarm notification rule." 

Copying an SMS alarm notification 

1. Navigate to Alarm Notification: 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Settings on the left navigation tree. 

c. Click Alarm Notification under Alarm Settings on the left navigation tree. 

2. Click the Copy icon  in the Message Notification list associated with the alarm rule you 
want to copy. 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 9118



717 

3. Rename the rule by giving it a unique name. 

4. Make any necessary modifications to the rule in the Copy Message Notification page. For 
more information about modifying an SMS Notification, see "Modifying an SMS alarm 
notification rule." 

5. Click OK. 

Enabling or disabling an SMS alarm notification rule 

1. Navigate to Alarm Notification: 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Settings on the left navigation tree. 

c. Click Alarm Notification under Alarm Settings on the left navigation tree. 

2. Do one of the following: 

 To enable, click  Disable in the Message Notification Status field associated with the 
message rule you want to enable. 

 To disable, click  Enable in the Message Notification Status field associated with the 
message rule you want to disable. 

Batch enabling or disabling message notification rules 

1. Navigate to Alarm Notification. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Settings on the left navigation tree. 

c. Click Alarm Notification under Alarm Settings on the left navigation tree. 

2. In the Message Notification area, do one of the following: 

 Select rules in Disabled status, click Status, and select Batch Enabled.  

 Select rules in Enabled status, click Status, and select Batch Disabled. 

Deleting an SMS alarm notification rule 

1. Navigate to Alarm Notification: 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Settings on the left navigation tree. 

c. Click Alarm Notification under Alarm Settings on the left navigation tree. 

2. Click the Delete icon  in the SMS Notification list associated with the alarm rule you want to 
delete. 

3. Click OK to confirm deletion of the rule. 

Exporting all SMS alarm notification rules 

1. Navigate to Alarm Notification: 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Settings on the left navigation tree. 

c. Click Alarm Notification under Alarm Settings on the left navigation tree. 

2. Click Export in the Message Notification area. 

3. Click Download Exported Data. 

The exported file has the following fields: 

 Rule Name. 

 Telephone Number. 

 Concerned Devices. 

 Selected Custom View. 
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 Selected Network Segment. 

 Concerned Alarms/Parameter Information. 

Managing alarm forwarding: Integrating with other 
management systems 

You can configure IMC to forward alarm notifications to other management systems including help 
desk ticketing systems by establishing notification rules that contain the configuration parameters 
necessary to forward alarms.  

You can configure one or more rules that define which faults or errors in the network infrastructure 
are forwarded to other management systems. Alarm forwarding rules can also be included to forward 
alarms by device or groups of devices as well as by day and time of day. 

Adding an alarm forwarding rule 

1. Navigate to Alarm Notification. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Settings on the left navigation tree. 

c. Click Alarm Notification under Alarm Settings on the left navigation tree. 

2. Click Add in the Alarm Forwarding area. 

3. Enter a name for this alarm forwarding rule in the Rule Name field.  

After you create a rule, you cannot modify its name. 

4. Enter the IP address of the destination management system for this rule in the Destination IP 
Address field. 

5. Enter the destination port number for the management system for this rule in the Port field. 

6. Select the alarm level you want to apply to this forwarding rule next to Concerned Alarm 
Levels.  

This configuration parameter determines which severity or alarm levels trigger alarm 
forwarding.  

For new alarm forwarding rules, all alarm levels are checked with the exception of Info alarms.  

To remove an alarm level setting, uncheck the box next to each of the severity or alarm levels 
you want to exclude from this alarm rule. 

7. Select All Resources or Selected Devices from the Concerned Resources list. When the 
IMC platform has the APM component installed, you can select Application Group from the 
list. 

 All Resources—With this option, all resources in IMC trigger alarm forwarding if the alarm 
condition meets the rule's Concerned Alarm Level setting. 

For example, if you set the alarm level to critical and major, then all devices in the network 
infrastructure that have a condition that is configured in IMC as critical and major generate 
alarm forwarding to all recipients configured in this rule. 

 Selected Devices—With this option, only the selected devices trigger a mail notification if 
the alarm condition meets the rule's Concerned Alarm Level setting. 

 Application Group—This option is displayed only when the APM component is installed. 
With this option selected, alarm forwarding is triggered only when applications in the 
selected application group meet the alarm forwarding conditions. 

You can select devices by Device IP address, by Custom Views, by Network Segment, 
by Concerned Port Groups or by a combination of the four.  

You can select devices by using either the View or Advanced query option. See "Adding 
devices by view" and "Adding devices by advanced query." 
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You can add devices using one or more of the Selected Devices options. For example, you 
can enter the IP address of one device and an IP address range, and groups defined by 
custom view. The alarm notification rule forwards alarms for all devices or groups 
configured in the rule. 

8. Select which error conditions trigger alarm forwarding from the Concerned Alarms list. 
Operators can select all conditions or only a specified subset of conditions that trigger alarm 
forwarding. 

 All Alarms—With this option, all alarms configured in IMC generate alarm forwarding if the 
alarm condition is triggered. 

 Selected Alarms—With this option, only the alarms you select in alarm notification 
generate alarm forwarding if the alarm condition is triggered. Further, you can select which 
alarms trigger alarm forwarding. 

9. To configure for which conditions to send notifications: 

a. Click Select next to the Concerned Alarms field. The Select Alarm dialog box opens. 

b. In the Select Alarm dialog box, locate the Enterprise MIB that contains an object or 
condition on which you want an alarm. 

c. To expand your view of the MIB, click the Right-Arrow icon  next to the MIB that contains 
an object or condition on which you want an alarm.  

d. Click the Expand all icon  located in the upper right corner of the Select Alarm dialog 
box to expand your view to display all MIBs, or 

Use the query function located at the top of the Select Alarm dialog box to locate the object 
on which you want an alarm. 

10. Enter one or more of the following search criteria: 

 Trap Name—Enter a partial or complete object name for the trap you want to locate in the 
Trap Name field. 

 Trap OID—Enter a partial or complete Object ID for the trap in the Trap OID field. 

 Enterprise Name—Enter a partial or complete name for the Enterprise MIB you want to 
locate in the Enterprise Name field. 

 Enterprise OID—Enter a partial or complete Enterprise ID for the MIB you want to locate in 
the Enterprise OID field. 

11. Click Query to submit your search criteria. The results of your query display in the dialog box.  

Optional: Click Reset to clear your query criteria and to restore the full list of MIBs and traps. 

12. Select a MIB object on which you want an alarm. 

13. Click OK.  

It might take a while for the Select Alarm dialog box to close. When the box closes, it updates 
the Concerned Alarms field with the configured object or alarm condition.  

You can select multiple objects or conditions to set alarms on. Each alarm condition is listed in 
the Concerned Alarms field below the list. 

14. Click Parameter Setting next to the Concerned Alarm field, the Set Alarm Parameter dialog 
box opens with all alarms and parameters listed. 

15. Click the trap name to expand the alarm parameters. 

16. Enter the value in the field right of the parameters name: 

 To set multiple values for a parameter, click the Add Line icon  to add a line. 

 To remove a line, click the Delete icon . 

 To restore a parameter that you have removed, enter the Set Alarm Parameter page again. 

17. Click OK.  

IMC determines whether to forward the received alarms according to the configured 
parameters. 

18. To delete one or more alarm conditions, highlight the conditions and click Delete.  
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Not all alarms have parameters.  

When you select multiple MIB objects or alarm conditions, the alarm conditions are evaluated 
and performed as an OR operation. With OR operations, only one of the conditions that you 
select must be true for the alarm notification rule to generate a mail notification. 

19. Confirm that the MIB objects or conditions you selected have populated the Concerned 
Alarms field in the Add Mail Notification page.  

For adding a MIB to IMC, see "MIB management." 

20. Enter the hourly range in the Time Ranges field for each day of the week, using an 
hh:mm-hh:mm format.  

To exclude a day of the week, delete any values, including 00:00, from the hourly range for that 
day. 

21. Click OK.  

You can integrate IMC into multiple systems by creating one forwarding rule for each system. 

Modifying an alarm forwarding rule 

1. Navigate to Alarm Notification: 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Settings on the left navigation tree. 

c. Click Alarm Notification under Alarm Settings on the left navigation tree. 

2. Click the Modify icon  in the Alarm Notification main pane associated with the alarm 
forwarding rule you want to modify. 

You cannot modify the name of an alarm rule after you have created it. 

3. Modify the IP address of the destination management system for this rule as needed in the 
Destination IP Address field. 

4. Modify the destination port number for the management system for this rule as needed in the 
Port field. 

5. Do one of the following: 

 Select the alarm level you want to apply to this alarm forwarding rule next to Concerned 
Alarm Levels.  

 To remove an alarm level setting, uncheck the box next to each of the severity or alarm 
levels you want to exclude for this alarm rule. 

6. Select All Resources or Selected Devices from the Concerned Resources list. When the 
IMC platform has the APM component installed, you can select Application Group from the 
list. 

 All Resources—If you select this option after initially configuring this option with Selected 
Devices, then IMC overrides the existing configuration by configuring the alarm rule to send 
to all resources. 

For example, if you set the alarm level to critical and major, then all devices in the network 
infrastructure that have a condition that is configured in IMC as critical and major generate 
alarm forwarding to all recipients configured in this rule. 

 Selected Devices—With this option, only the selected devices trigger alarm forwarding if 
the alarm condition meets the rule's Concerned Alarm Level setting. 

 Application Group—This option is displayed only when the APM component is installed. 
With this option selected, alarm forwarding is triggered only when applications in the 
selected application group meet the alarm forwarding conditions. 

You can modify your selection devices by Device IP address, by Custom Views, by 
Network Segment, or by a combination of the three. For more information, see "Selecting 
devices by IP address", "Selecting devices by custom view", or "Selecting devices by 
network segment." 
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You can also select devices by using Select next to the Device IP field. This enables you to 
use IMC's display and search capabilities to select the device(s) from established groups 
and views either By View or by query using the Advanced feature. 

For more information, see "Adding devices by view" and "Adding devices by advanced 
query." 

7. Modify which error conditions trigger alarm forwarding from the Concerned Alarms list. 
Operators can select all conditions or only a specified subset of conditions that trigger alarm 
forwarding. 

 All Alarms—With this option, all alarms configured in IMC trigger alarm forwarding if the 
alarm condition is triggered. 

 Selected Alarms—With this option, only the alarms you select in alarm notification trigger 

alarm forwarding if the alarm condition is triggered. If you select Selected Alarms, you can 
select which alarm conditions trigger alarm forwarding.  

8. Click Select to configure which conditions to alarm on. 

9. In the Select Alarm dialog box, locate the Enterprise MIB that contains an object or condition 
that you want to alarm on. 

10. To expand your view of the MIB, click the Right-Arrow icon  next to the MIB that contains an 
object or condition on which you want an alarm. 

11. Do one of the following: 

 Click the Expand all icon  located in the upper right corner of the Select Alarm dialog 
box to expand your view to display all MIBs, or 

 Use the query function located at the top of the Select Alarm dialog box to locate the object 
on which you want an alarm by entering one or more of the following search criteria: 

 Trap Name—Enter a partial or complete object name for the trap you want to locate in 
the Trap Name field. 

 Trap OID—Enter a partial or complete Object ID for the trap in the Trap OID field. 

 Enterprise Name—Enter a partial or complete name for the Enterprise MIB you want to 
locate in the Enterprise Name field. 

 Enterprise OID—Enter a partial or complete Enterprise ID for the MIB you want to 
locate in the Enterprise OID field. 

 Click Query to submit your search criteria.  

The results of your query are displayed in the dialog box. 

 Click Reset to clear your query criteria and to restore the full list of MIBs and traps. 

12. Select a MIB object that you want to add to this alarm rule. 

13. Click OK.  

It may take a while for the Select Alarm dialog box to close. When the box closes, it updates 
the Concerned Alarms field with the configured object or alarm condition.  

14. You can select multiple objects or conditions to alarm on. Each alarm condition is listed in the 
Concerned Alarms field below the list. 

15. Click Parameter Setting next to the Concerned Alarm field.  

The Set Alarm Parameter dialog box opens with all alarms and parameters listed. 

16. Click the trap name to expand the alarm parameters. 

17. Enter the value in the field next to the parameter name: 

 To set multiple values for a parameter, click the Add Line icon  to add a line. 

 To remove a line, click the Delete icon . 

18. To restore a parameter that you have removed, enter the Set Alarm Parameter page again. 

19. Click OK. 

20. To delete one or more alarm conditions, highlight the conditions and click Delete.  
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Not all alarms have parameters.  

When you select multiple MIB objects or alarm conditions, the alarm conditions are evaluated 
and performed as an OR operation. With OR operations, only one of the conditions that you 
select must be true for the alarm notification rule to generate a mail notification. 

21. Confirm that the MIB objects or conditions you selected have populated the Concerned 
Alarms field in the Modify Alarm Forwarding page.  

22. Modify the hourly range in the Time Ranges field for each day of the week, using an 
hh:mm-hh:mm format.  

23. To exclude a day of the week, delete any values, including 00:00, from the hourly range for that 
day. 

24. Click OK. 

Copying an alarm forwarding rule 

1. Navigate to Alarm Notification. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Settings on the left navigation tree. 

c. Click Alarm Notification under Alarm Settings on the left navigation tree. 

2. Click the Copy icon  in the Alarm Forwarding list associated with the alarm rule you want 
to copy. 

3. Rename the rule by giving it a unique name. 

4. Make any necessary modifications to the rule in the Copy Alarm Forwarding page. For more 
information about modifying an alarm forwarding rule, see "Modifying an alarm forwarding rule." 

5. Click OK. 

Enabling or disabling an alarm forwarding rule 

1. Navigate to Alarm Notification. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Settings on the left navigation tree. 

c. Click Alarm Notification under Alarm Settings on the left navigation tree. 

2. Do one of the following: 

 To enable and alarm forwarding rule, click  Disable in the Alarm Forwarding Status 
field for the target rule. 

 To disable an alarm forwarding rule, click  Enable in the Alarm Forwarding Status field 
for the target rule. 

Batch enabling or disabling alarm forwarding rules 

1. Navigate to Alarm Notification. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Settings on the left navigation tree. 

c. Click Alarm Notification under Alarm Settings on the left navigation tree. 

2. In the Alarm Forwarding area, do one of the following: 

 Select rules in Disabled status, click Status, and select Batch Enabled.  

 Select rules in Enabled status, click Status, and select Batch Disabled. 

Deleting an alarm forwarding rule 

1. Navigate to Alarm Notification. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Settings on the left navigation tree. 
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c. Click Alarm Notification under Alarm Settings on the left navigation tree. 

2. Click the Delete icon  in the Alarm Forwarding list associated with the alarm rule you want 
to delete. 

3. Click OK to confirm deletion of the rule. 

Managing hierarchical alarm settings 
One architecture option that IMC offers is a hierarchical configuration where IMC servers are 
configured in parent/child relationships. Part of this configuration includes configuring child IMC 
instances to forward alarms of importance to parent IMC instances. 

In hierarchical IMC, recovering a trap also recovers the related trap in the upper-level/lower-level 
IMC. 

Configuring IMC for hierarchical alarm configuration 

To configure IMC hierarchical alarm settings: 

1. Navigate to Alarm > Hierarchical IMC Alarming: 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Settings on the left navigation tree. 

c. Click Hierarchical IMC Alarming under Alarm Settings on the left navigation tree. 

2. Click the checkbox next to Enable Alarming field to enable alarming. 

3. Enter the IP address of the IMC instance to which alarms are forwarded in the Upper-Level IP 
field. 

It is better to add a lower-level IMC to an upper-level IMC configuration than to add an 
upper-level IMC to a lower-level IMC. 

 

 IMPORTANT: 

The Upper-Level IP address cannot be the IP address of the current IMC or any of its 
lower-level IMC systems. 

 

4. Enter the TCP port number for the IMC service running on the IMC instance to which alarms are 
forwarded in the Upper-Level RxPort field. 

5. Configure whether the lower-level IP address is a public IP address. 

Select Yes if the communication between upper-level and lower IMC systems goes through 
NAT devices. 

6. Enter the IP address of the IMC instance to which alarms are forwarded in the Lower-Level IP 
field. 

7. Select All Devices or Selected Devices from the Interested Devices list. 

 All Devices—With this option, alarms for all devices are forwarded to the Upper Level IMC 
instance. 

 Selected Devices—With this option, alarms for only the selected devices are forwarded to 
the upper-level IMC instance. If you select Selected Devices, you can select devices to 
which you forward alarms. You can specify which devices by specific device IP address, or 
devices grouped by views. 

 Device IP—Enter the IP address for the device to which you want to forward alarms. 

 You can add multiple devices by clicking Add after entering the IP address in the Device 
IP field for every device you want to add. 

 You can also add devices by using views or IMC Advanced query option. To do so, click 
Select. 

The Select Devices dialog box opens. 
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8. Add devices by using either the View or Advanced query option.  

See "Adding devices by view" and "Adding devices by advanced query." 

9. Select the configuration setting for this rule from the Interested Alarms list to select all 
conditions that trigger alarms or only a specified subset of conditions that trigger alarms. 

 All Alarms—With this option, all alarms configured in IMC triggers a mail notification to be 
sent if the alarm condition is triggered. 

 Selected Alarms—With this option, only the alarms you select in alarm notification triggers 
a mail notification if the alarm condition is triggered.  

If you select Selected Alarms, you can select which alarms generate mail alarm notifications. 
You can specify which conditions triggers mail alarm notifications. 

a. Click Select to configure which conditions to alarm on. 

b. In the Select Alarm dialog box, locate the MIB that contains an object or condition that you 
want to alarm on. 

c. To expand your view of the MIB, click the arrow key  next to the MIB that contains an 
object or condition that you want to alarm on. 

d. Select a MIB object that you want to add to this alarm rule. 

e. Click the checked box to remove a MIB object from the alarm rule. 

f. Scroll down to the bottom of the MIB list and click OK. 

It might take a while for the Select Alarm dialog box to close. When it does, it updates the 
Concerned Alarms field with the configured object or alarm condition. 

Select multiple objects or conditions for which to forward alarms. Each alarm condition is 
listed in the Interested Alarms field below the list. 

 

 IMPORTANT: 

When you select multiple MIB objects or alarm conditions, the alarm conditions are evaluated and 
performed as an AND operation. In other words, all of the conditions that you selected must be true 
for the alarm notification rule to generate a mail notification. 
 

Confirm that the MIB objects or conditions you have either added or removed have 
populated the Interested Alarms field in the Hierarchical IMC Alarming page. 

10. Select concerned alarm levels. Available alarm levels include: Critical, Major, Minor, Warning, 
and Info. 

11. Click OK. 

Only administrators or operators who are members of a group with the ADMIN privilege level 
can configure hierarchical alarm settings. 

Configuring access device and core device alarms 
An event storm occurs when many alarms are generated for what can be attributed to a single failure 
or error in the network. While event storms can be an unfortunate consequence of a managed 
network infrastructure, they are not unusual because many managed devices, users, or services can 
be affected by a failure or error on one device and managed devices report errors when they are 
configured to do so.  

Most event management systems, IMC included, have capabilities for managing event storms. 
However, management systems can still generate event storms if the event management system is 
unaware or unable to accurately determine its place in the network relative to all managed devices.  

IMC manages event storms automatically by accurately determining its place in the network and 
combining knowledge of its position with sophisticated rules based on years of research around the 
behavior of networks, failures, and event suppression techniques. The net result is a dramatic 
reduction in alarming and event storms. As part of this process, IMC distinguishes between and 
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labels root alarms as those alarms that indicate the root cause of a failure from symptom alarms, 
those events that suggest or point to a problem elsewhere.  

You can modify how IMC understands its place in the network infrastructure by adding to the 
knowledge of what is considered an access device and what is considered a core device. Also, you 
can configure IMC to automatically calculate the access devices. 
 

 CAUTION: 

These changes can affect how IMC responds to failures and manages alarm suppression. Use this 
feature with caution and keep in mind the recipients of alarm notifications when making these 
changes. 
 

Adding an access device 

1. Navigate to Access and Core Devices: 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Settings on the left navigation tree. 

c. Click Access and Core Device under Alarm Settings on the left navigation tree. 

2. Click Add under Access Device in the Access and Core Device window. 

3. Add devices by using either the View or Advanced query option.  

For more information, see "Adding devices by view" and "Adding devices by advanced query." 

4. Highlight the device you want to add, and click Add select to add it to the Selected Devices 
list. 

5. Confirm that the device has been added. 

6. Click OK. Confirm that the device has been added to the Access Device portion of the Access 
and Core Device window. 

Deleting an access device 

1. Navigate to Access and Core Devices. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Settings on the left navigation tree. 

c. Click Access and Core Device under Alarm Settings on the left navigation tree. 

2. Click the Delete icon  next to the access device you want to delete from the Access and 
Core Device window. 

Resuming the system calculation 

After the system calculation is resumed, IMC will automatically calculate the access devices. If you 
want to manually specify the access devices, you can delete the access devices, and then manually 
add devices. 

To resume system calculation: 

1. Navigate to Access and Core Devices: 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Settings on the left navigation tree. 

c. Click Access and Core Device under Alarm Settings on the left navigation tree. 

2. Click Resume System Calculation in the Access Devices area to make IMC automatically 
calculate the access devices. 

Adding a core device 

1. Navigate to Access and Core Devices. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Settings on the left navigation tree. 
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c. Click Access and Core Device under Alarm Settings on the left navigation tree. 

2. Click Add under Core Device in the Access and Core Device window. 

3. Add devices by using either the View or Advanced query option. 

For more information, see "Adding devices by view" and "Adding devices by advanced query." 

4. Highlight the devices you want to select and click the Add selected icon  to add them to the 
Selected Devices list. 

 To select all of the devices displayed in the Devices Found list, click the Add all icon . 

 To remove one or more devices, select them and click the Remove selected icon . 

 To remove all of the selected devices, click the Remove all icon . 

5. Confirm that the device has been added. 

6. Click OK.  

7. Confirm that the device has been added to the Core Device portion of the Access and Core 
Device window. 

Deleting a core device 

1. Navigate to Access and Core Devices. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Settings on the left navigation tree. 

c. Click Access and Core Device under Alarm Settings on the left navigation tree. 

2. Click the Delete icon  next to the core device you want to delete from the Access Device 
and Core Device window. 

Managing alarm levels 
IMC supports redefining alarm levels for alarms of devices based on alarm duration or alarm 
repetitions. You can select devices and alarm types, add configuration item parameters, set the 
alarm duration or the number of alarm repetitions, and specify the alarm level for matching alarms. 
When IMC receives alarms that match the rule, IMC upgrades the alarm levels of the alarms as 
defined by the rule. 

Adding an alarm level configuration rule 

1. Navigate to Alarm Level Configuration:  

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Settings on the left navigation tree. 

c. Click Alarm Level Configuration under Alarm Settings on the left navigation tree.  

2. Click Add. 

3. Enter a rule name in the Rule Name field. 

After you create a rule, you cannot modify its name. 

4. Select All Devices or Selected Devices from the Concerned Devices list. 

 All Devices—This rule applies to all devices. 

 Selected Devices—This rule applies only to selected devices. 

You can select devices by Device IP, by Custom Views, by Network Segment, or by a 
combination of the three. For more information, see "Selecting devices by IP address", 
"Selecting devices by custom view", or "Selecting devices by network segment." 

5. Select All Alarms or Selected Alarms from the Concerned Alarms list.  

This option allows you to specify the alarms to which this rule applies. 

 All Alarms—This rule applies to all types of alarms. 
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 Selected Alarms—This rule applies only to selected types of alarms.  

6. If you selected Selected Alarms in the previous step, perform the following operations: 

a. Click Select next to the Concerned Alarms field. The Select Trap dialog box opens. 

b. In the Select Trap dialog box, locate the Enterprise MIB that contains an object or condition 
that you want to alarm on. 

c. To expand your view of the MIB, click the Expand icon  next to the MIB that contains an 
object or condition that you want to alarm on. 

d. Use the query function located at the top of the Select Alarm dialog box to locate the object 
on which you want an alarm. 

7. Enter one or more of the following search criteria: 

 Trap Name—Enter a partial or complete object name for the trap you want to locate in the 
Trap Name field. 

 Trap OID—Enter a partial or complete Object ID for the trap in the Trap OID field. 

 Severity—Select a severity level for the trap. 

 Enterprise Name—Enter a partial or complete name for the Enterprise MIB you want to 
locate in the Enterprise Name field. 

 Enterprise ID—Enter a partial or complete Enterprise ID for the MIB you want to locate in 
the Enterprise ID field. 

8. Do one of the following:  

 Click Query to submit your search criteria. 

 Click Reset to clear your query criteria and to restore the full list of MIBs and traps. 

The results of your query are displayed in the dialog box. 

9. Enable or disable the Automatically select recovered alarms function. Options are: 

 Open—Enables the Automatically select recovered alarms function. When the selected 
traps have recovered alarms defined, IMC automatically selects the recovered alarms for 
the selected traps. 

 Close—Disables the Automatically select recovered alarms function. When the selected 
traps have recovered alarms defined, IMC does not automatically select the recovered 
alarms for the selected traps. 

10. Select a MIB object on which you want an alarm. 

11. Click OK.  

It may take a while for the Select Trap dialog box to close. When the box closes, it updates the 
Concerned Alarms field with the configured object or alarm condition.  

You can select multiple objects or conditions to alarm on. Each alarm condition is listed in the 
Concerned Alarms field below the list. 

12. Click Parameter Settings next to the Concerned Alarm field.  

The Set Alarm Parameters dialog box opens with all alarms and parameters listed. 

13. Click the trap name to expand the alarm parameters. 

14. Enter the value in the field to the right of the parameters name: 

 To set multiple values for a parameter, click the Add icon  to add a value. 

 To delete a value, click the Delete icon  for that value. 

 To restore a parameter that you have removed, enter the Set Alarm Parameter page again. 

15. Click OK.  

IMC determines whether to upgrade the received alarms according to the configured 
parameters. 

16. To delete one or more alarm conditions, highlight the conditions and click Delete.  

Not all alarms have parameters.  
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When you select multiple MIB objects or alarm conditions, the alarm conditions are evaluated 
and performed as an OR operation. With OR operations, only one of the conditions that you 
select must be true for the alarm level configuration rule to configure alarm levels. 

17. Confirm that the MIB objects or conditions you selected have populated the Concerned 
Alarms field in the Alarm Level Configuration page.  

18. Select Alarm Duration or Alarm Repetitions from the Configuration Item list. 

 Alarm Duration—Duration of the alarm, from the time when IMC receives the alarm to the 
time when the alarm is canceled. 

 Alarm Repetitions—Number of times that IMC receives the same alarm (identified by key 
parameters) from the same device. 

19. Enter the alarm duration or number of alarm repetitions in the Configuration Item Value field. 
The alarm duration is measured in minutes by default. The number of alarm repetitions starts 
from 2 and can have 1 to 8 digits. 

20. Select an alarm severity level. Alarm severity levels include critical, major, minor, and warning 
in descending order of severity. 

21. Click Add to add the configuration item.  

You can add multiple configuration items. If multiple alarm levels are matched, the highest level 
takes effect. 

To delete a configuration item, click the Delete link for the item.  

22. Click OK. 

Modifying an alarm level configuration rule 

1. Navigate to Alarm Level Configuration:  

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Settings on the left navigation tree. 

c. Click Alarm Level Configuration under Alarm Settings on the left navigation tree. 

2. Click the  icon for the rule that you want to modify. 

After you create a rule, you cannot modify its name. For more information, see "Adding an 
alarm level configuration rule." 

Enabling or disabling an alarm level configuration rule 

1. Navigate to Alarm Level Configuration:  

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Settings on the left navigation tree. 

c. Click Alarm Level Configuration under Alarm Settings on the left navigation tree. 

2. Click the Yes link for an alarm level configuration rule to disable the rule, or click the No link to 
enable the rule. 

Deleting an alarm level configuration rule 

1. Navigate to Alarm Level Configuration:  

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Alarm Settings on the left navigation tree. 

c. Click Alarm Level Configuration under Alarm Settings on the left navigation tree. 

2. Click the icon for the rule that you want to delete. 

3. Click OK to confirm deletion of the rule. 
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Performance management 
IMC provides real time and historical performance management for managed devices. The 
Performance Management features provide you with the ability to customize the collection, 
alarming and presentation of performance data. In addition, you can leverage system or user defined 
global or individual monitors to collect performance information, generate historical reports on the 
performance of devices or generate alarms when performance monitors meet threshold conditions. 

Upon installation, you have access to several groups of more than two hundred globally defined 
monitors that define the monitoring options for configuring monitoring for individual devices.  

Within these global monitors, sixteen come configured with polling intervals, threshold settings, and 
alarm settings configured to enable immediate, proactive performance monitoring of devices 
managed in IMC.  

Of the sixteen global monitors, four are immediately added to the performance monitoring of devices 
whenever devices are added to IMC, providing a standard set of monitors for immediate 
performance monitoring and reporting. These four monitors include Device Un-reachability 
Proportion, Device Response Time, CPU Usage, and Memory Usage. 

IMC also provides the ability to customize the list of global monitors that define performance 
monitoring. You can add custom monitors to the set of global index settings monitors, modify or 
remove the threshold settings for global monitors that already have these settings defined, add 
threshold settings for global monitors that have no pre-defined thresholds set, or add, remove, or 
modify the set of default global monitors that are applied when a device is added to IMC.  

In addition to global monitoring options, you can also customize the list and configuration of monitors 
that are applied to individual devices or groups of devices or add monitors to, or remove monitors 
from the list, for one or more devices. Naturally, you can also add, modify, or remove the threshold 
settings for performance monitors that determine when a performance monitor generates an alarm.  

You can create views for viewing the historical data collected by the performance view. You can also 
organize views by folders and create shortcuts for easy access to performance views from the left 
navigation tree. Lastly, you can customize which performance views are available from the Network 
Topology.  

Managing performance with global index settings 
IMC provides you with over two hundred globally defined monitors organized into eight monitor 
groups. The first of these is a system monitoring group that includes monitoring for general system 
performance such as reachability, CPU, memory, and device response time.  

In addition, the Performance Management feature provides device specific performance monitoring 
for IPsec VPNs, WLANs, IVS, QoS, and RMON. All of these monitors can be found under Global 
Index Settings.  

There are 16 global monitors already configured with polling intervals, threshold settings and alarm 
level settings, enabling you to immediately and proactively monitor the performance of devices 
managed in IMC.  

Out of the box, you have a standard set of monitors for performance monitoring and reporting along 
with over 200 monitors that can be configured with threshold settings and applied to specific devices 
for more comprehensive and technology specific performance monitoring, allowing you to create 
custom global monitors to expand the set of global performance monitors.  

Once you have configured global monitors, these monitor settings can be applied to individual 
devices using the Monitoring Settings feature within the Performance Management service.  
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Accessing global index settings 
All global monitors are listed in the Global Index Settings list in IMC.  

To access the Global Index Settings list: 

1. Navigate to Resource > Global Index Settings. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Global Index Settings under Performance Management on the left navigation tree. 

The Global Index Settings window opens, with monitors grouped by type. 

To view the individual monitors, click  next to the group name.  

The window displays the following: 

 Index Name—Contains the name for the monitor index. 

 Threshold 1—Contains the value of the first threshold for the associated monitor index. 

 Alarm Level—Contains the severity or alarm level for alarms that are generated when 
the condition of the first threshold is met. 

 Repeat Time—Contains the number of sequential data samples that must be collected 
and meet the first threshold value to trigger an alarm in IMC. 

 Threshold 2—Contains the value for the second threshold for the associated monitor 
index. 

 Alarm Level—Contains the severity or alarm level for alarms that are generated when 
the condition of the second threshold is met. 

 Repeat Time—Contains the number of sequential data samples that must be collected 
and meet the second threshold value to trigger an alarm in IMC. 

 Interval (Sec.)—Contains the sampling interval in seconds for the associated monitor. 

2. If the Global Index Settings list spans multiple pages, use the following aids to navigate the 
list: 

 Click  to page forward in the Global Index Settings list. 

 Click  to page forward to the end of the Global Index Settings list. 

 Click  to page backward in the Global Index Settings list. 

 Click  to page backward to the front of the Global Index Settings list. 

 Click  at the bottom of the Global Index Settings list to refresh the list.  

3. Enter a page number in the text box next to the navigational icons to quickly go to that page. 

Searching global index settings 
1. Navigate to Resource > Global Index Settings: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Global Index Settings under Performance Management on the left navigation tree. 

The Global Index Settings window displays with monitors grouped by type. To view the 

individual monitors, click  next to the group name.  

2. Click the Query icon  located on the toolbar at the top of the Global Index Settings list. 

3. Enter one or more of the search criteria listed below: 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 9132



731 

 Index Name—Enter a partial or complete index name in the Index Name field. 

 Index Group Name—To filter the list by group name, enter the name of the group in the 
Index Group Name field. 

4. Click Query. The result of your search is displayed in the Global Index Settings list.  

Managing global index settings 
You can add a custom index by using the Add Custom Index option or by copying from an existing 
custom index, modify or delete a custom index, modify the threshold and alarming features of a 
global performance monitor, or modify the list of default monitors that are applied to all devices when 
added to IMC. 

Modifying a global monitor in the global index settings 

You can modify system defined threshold settings for global monitors. Changing threshold settings 
for global index changes the threshold settings for all existing monitors as well as all monitors that 
are created after the threshold setting change was made. 

To modify the performance thresholds for a global index: 

1. Navigate to Resource > Global Index Settings: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Global Index Settings under Performance Management on the left navigation tree. 

The Global Index Settings window displays with monitors grouped by type.  

2. To view the individual monitors, click the Expand icon  next to the group name. 

3. Click the  icon in the Operation column for the global index that you want to modify.  

The Modify Index dialog box opens. 

4. In the Threshold Level field, select a threshold level. Options are Disable, Threshold 1, 
Threshold 2, Threshold 3, Threshold 4, and Threshold 5.  

5. In the Match Mode field, select a match mode. Options include greater than or equal to , 

less than or equal to , Between, and Outside. The option Between or Outside allows you 
to define a range of values that trigger an alarm. 

The match mode applies to all thresholds. For example, when both threshold 1 and threshold 2 
are enabled and the match mode is set to greater than or equal to, the match mode applies to 
both threshold 1 and threshold 2.  

6. When threshold 1 is enabled, enter the operand or threshold value in the Value 1 field.  

If you selected Between or Outside in the Match Mode field, enter an operand or a threshold 
value in the Value 1 field, and enter the second operand or threshold value in the Value 2 field. 

7. Select the form of measurement from the Measurement list.  

The options for this field vary based on the type of monitor instance you are modifying. 

8. Enter the number of successive data samples collected that must meet the threshold 
requirements in the Repeat Time field. 

9. Select the severity or alarm level for this monitor from the Alarm Level list. 

10. If you enable multiple threshold levels, repeat steps 6 through 9 to configure parameters for 
each threshold level. The alarm level for threshold 1 must be lower than that for threshold 2, and 
so on.  

11. Enter the amount of time between data collections in the Interval (Sec.) field. 

12. Click OK to accept your threshold settings for the selected monitor. 
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Adding a custom template 

Perform this task to add a custom template for a performance monitoring index. 

To add a custom template:  

1. Navigate to Resource > Global Index Settings: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Global Index Settings under Performance Management on the left navigation tree. 

The Global Index Settings window displays with monitors grouped by type.  

2. To view the individual monitors, click the Expand icon  next to the group name. 

3. Click the  icon in the Operation column for the global index that you want to modify. On the 
menu that opens, select Add Custom Template. 

4. Configure the template name, template description, index type, index definition OID, and 
formula. 

5. Click OK. 

Adding a user-defined monitor to the global index settings list 

In addition to the system-defined global monitors that are available in IMC by default, you can also 
add your own custom monitors to the list of global index settings or monitors.  

To add a custom or user defined global monitor:  

1. Navigate to Resource > Global Index Settings: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Global Index Settings under Performance Management on the left navigation tree. 

The Global Index Settings window displays with monitors grouped by type.  

2. To view the individual monitors, click the Expand icon  next to the group name. 

3. Click Add Custom Index located on the toolbar at the top of the Global Index Settings list. 
The Add Custom Index window opens.  

4. Enter a name for the custom global monitor in the Name field. 

5. To define the unit of measure, do one of the following: 

 To use a predefined unit of measure, select it from the Predefined list.  

 To define a custom unit of measure, select Custom, and then enter the unit of measure in 
the field next to Custom. 

6. In the Type field, enter an instance of the performance monitor as defined in the MIB definition. 
(Multi-level MIB objects are supported.) Use the following format: 
[index1[0|2]:NAME:TYPE:LENGTH].[index2[0|2]:NAME:TYPE:LENGTH]  

 The parameter indexN defines the hierarchy level of a monitor instance. For example, 
[index1[2]:Frame:1:0].[index2[2]:Slot:1:0].[index3[2]:Memory:1:0] indicates the memory on 
the slot of the frame. 

 0 indicates a MIB leaf node and 2 indicates a non-leaf node. 

 The value in the NAME field identifies the name of the instance for the performance monitor. 
This name is used by IMC as the name of the instance for the performance monitor. 

 1 in the TYPE field indicates an integer and 2 indicates a string. 

 The value in the LENGTH field indicates the index length, which is 0 for integer index and 
non-hierarchical index.  

 Use a colon ":" to separate each field in the definition. 
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 Use a dot "." to separate length values for hierarchical indexes. For example, 

[index1[2]:Interface:1:0] and 

[index1[2]:Frame:1:0].[index2[2]:Slot:1:0].[index3[2]: Memory:1:0] are both valid 
entries for the Type field.  

7. Enter the object identifier (OID) of the MIB object you want to use to translate numeric values 
into user friendly values in the Instance Label (Definition OID) field.  

8. Use a colon ":" to separate the OIDs for hierarchical indexes, and enter 0 if no OID is provided.  

IMC displays user friendly values together with the instance names you defined in step 6. For 
example, the ifIndex object of the ifEntry table of the MIB2 ifTable contains numeric values 
for every interface in the table. The ifDescr object of the ifEntry table contains a name or 
description for every interface in the table and is more readable. The Instance Label 
(Definition OID) field allows you to use the values contained in ifDescr to translate the 
ifIndex value into the more usable descriptions for interfaces on the device being monitored.  

9. Do one of the following:  

To use the IMC integrated MIB browser to select the object: 

a. Click Select OID. 

b. Locate the section of the MIB tree that contains the object you want to use for this global 
index. 

To expand your view of the MIB, click the  arrow key to the left of the MIB tree. 

c. Continue to expand using the arrow key until you have located the object you want to use. 

d. Click the MIB object you want to use to select it. 

e. Click OK. 

10. Enter the MIB object to be monitored and the calculation algorithm in the Formula field.  

The results calculated by this algorithm are the performance data of the monitored instance.  

The characters that can be used in this field include + - * / t ' ( ), where "t" must be lowercase, 
indicating the query interval.  

The quotation mark (') must be placed immediately next to the OID, indicating the value of the 
previous poll. This is used to offset the calculation.  

Examples 

 An example of a valid entry in the Formula field would be:  
1.3.6.1.2.1.2.2.1.10 

This formula instructs IMC to use the MIB object, ifInOctets (inbound traffic of the 
interface) as the returned value for this monitor. This formula would return the data collected 
for ifInOctets for one poll cycle. In this example, since ifInOctets is an object in the 
ifEntry table, the Instance Label (Definition OID) for this formula would be ifDescr 
(1.3.6.1.2.1.2.2.1.2), and the Type field could be [index1[2]:Interface:1:0].  

 Another example of a valid entry in the Formula field would be:  
1.3.6.1.2.1.2.2.1.10-1.3.6.1.2.1.2.2.1.10'  

1.3.6.1.2.1.2.2.1.10' indicates the value of ifInOctets in the first poll. 
1.3.6.1.2.1.2.2.1.10 indicates the value of ifInOctets in the second poll. The formula 
1.3.6.1.2.1.2.2.1.10-1.3.6.1.2.1.2.2.1.10' shows the difference of ifInOctets in the 
two polls.  

In this example, since ifInOctets is an object in the ifEntry table, the Instance Label 
(Definition OID) for this formula would be ifDescr (1.3.6.1.2.1.2.2.1.2), and the Type 
field could be [index1[2]:Interface:1:0].  

 A third example of a valid entry in the Formula field would be:  
(3.6.1.2.1.2.2.1.10-1.3.6.1.2.1.2.2.1.10')/t  
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The formula (1.3.6.1.2.1.2.2.1.10-1.3.6.1.2.1.2.2.1.10')/t indicates that the value 
you get by dividing the difference by the polling interval is the inbound traffic rate of the 
interface.  

In this example, since ifInOctets is an object in the ifEntry table, the Instance Label 
(Definition OID) for this formula would be ifDescr (1.3.6.1.2.1.2.2.1.2), and the Type 
field could be [index1[2]:Interface:1:0].  

 As a final example, provided below is a formula for calculating bandwidth utilization for a half 

duplex link. In this example, the Measurement field contains %, the Type field contains 

[index1[2]:Interface:1:0], the Instance Label (Definition OID) field contains 

1.3.6.1.2.1.2.2.1.2, and the Formula field contains  
(((1.3.6.1.2.1.2.2.1.10-1.3.6.1.2.1.2.2.1.10')+(1.3.6.1.2.1.2.2.1.16-1.3.6.1.2
.1.2.2.1.16'))*8*100/(t*1.3.6.1.2.1.2.2.1.5)) 

 Here is the same formula using MIB object names rather than the Object ID.  
(((ifInOctets-ifInOctets')+( ifOutOctets-ifOutOctets'))*8*100/(t*ifSpeed)) 

a. To use the IMC integrated MIB browser that has a graphical interface for selecting each MIB 
object in the formula, click Select OID, and then locate the section of the MIB tree that 
contains the object you want to use for this global index setting.  

b. To expand your view of the MIB, click the  arrow key to the left of the MIB tree, and then 
continue to expand using this arrow key until you have located the object you want to use.  

c. Click the MIB object you want to use to select it. 

d. Click OK. 

The object ID for the object you selected is displayed in the Formula field. 

e. Repeat as necessary for each MIB object you want to use in the formula. 

11. Click Test to validate the proper functioning of your custom global index definition.  

The window updates to display the Test Customized Index window.  

12. Do the following to continue the validation test: 

a. Enter the IP address of the device you want to use to test your formula in the Select Device 
or Enter IP Address field. You can also select the device you want to use by clicking Select 
next to this field. 

b. Select the instance from the Select Instance list.  

c. To have IMC populate a list of interfaces for the selected device, click Resolve next to the 
Select Instance list. The window and the Select Instance list update to include all 
available interfaces.  

d. Click Start to begin the data collection test process for the monitor you have created. The 
results of the data collection are displayed in the Result table. This table presents the 
results of sequential polls for the selected device and interface.  

e. Scroll to the bottom of the Result table, and then click Back when you have completed 
testing the formula for the user-defined monitor you have created. 

13. When you complete the configuration of the custom index setting and the test results are 
successful, click Apply to create the custom global index. Once you create a user-defined 
monitor, you can no longer access the configuration window for modifying it. You can only 
modify its threshold and interval settings or delete it.  

Viewing a user-defined monitor from the global index settings 

1. Navigate to Resource > Global Index Settings: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Global Index Settings under Performance Management on the left navigation tree. 

The Global Index Settings window displays with monitors grouped by type.  

2. To view the individual monitors, click the Expand icon  next to the group name. 
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3. Click the  icon in the Operation column for the custom index you want to view and select 
View from the menu that opens. 

The View Custom Index dialog box that opens displays the custom index details. For more 
information about the parameter description, see "Adding a user-defined monitor to the global 
index settings list." 

Modifying a user-defined monitor from the global index setting 

To modify a user defined global monitor: 

1. Navigate to Resource > Global Index Settings. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Global Index Settings under Performance Management on the left navigation tree. 

The Global Index Settings window displays with monitors grouped by type.  

2. To view the individual monitors, click the Expand icon  next to the group name. 

3. Click the  icon in the Operation column for the custom index you want to modify and select 
Modify from the menu that opens. 

The Modify Custom Index page opens. 

4. Modify custom index parameters as needed.  

For more information about modifying custom index parameters, see "Adding a user-defined 
monitor to the global index settings list." 

Copying a user-defined monitor from the global index settings 

To copy a user defined global monitor: 

1. Navigate to Resource > Global Index Settings: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Global Index Settings under Performance Management on the left navigation tree. 

The Global Index Settings window displays with monitors grouped by type.  

2. To view the individual monitors, click the Expand icon  next to the group name. 

3. Click the  icon in the Operation column for the custom index you want to copy and select 
Copy from the menu that opens. 

The Add Custom Index page opens. 

4. Modify custom index parameters as needed. 

For more information about modifying custom index parameters, see "Adding a user-defined monitor 
to the global index settings list." 

Deleting a user-defined monitor from the global index settings 

You can delete user-defined global index monitors, but you cannot delete system defined global 
monitors.  

To delete a user-defined global index monitor:  

1. Navigate to Resource > Global Index Settings: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Global Index Settings under Performance Management on the left navigation tree. 

The Global Index Settings window displays with monitors grouped by type. 
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2. To view the individual monitors, click  next to the group name, and then navigate to the 
section of the Global Index Setting list that contains user defined monitors. 

3. Click the  icon in the Operation column for the custom index you want to delete and select 
Delete from the menu that opens. 

4. Click Yes to confirm the deletion of the user-defined global index monitor. 

Managing individual device monitoring settings 
IMC enables you to fully customize the monitors used to manage the performance of devices. With 
each device that is added, four monitors are automatically added to the performance management of 
the device. In addition, you can add new, individual monitors for specific devices, based in the list of 
monitors found in Global Index Settings list. You can then use system defined global monitors or 
the custom monitors added to the Global Index Settings list. Monitor threshold settings for 
individual devices can also be customized which overrides the system defined threshold settings of 
global monitors.  

If you add monitors for devices or device instances in a new performance view, IMC automatically 
adds monitors for them in the index settings.  

Accessing the monitor list 
All performance management monitors for all devices are displayed in the monitor list. This list can 
be found under the Monitoring Settings option of Performance Management. 

To access the Monitor List: 

1. Navigate to Resource > Monitoring Settings: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Monitoring Settings under Performance Management on the left navigation tree. 

The Monitor List is displayed, with all devices managed in IMC as the default. 

The monitor list includes the following: 

 Device Name—Contains the name or label for the device that is being monitored. Click the 
name or label to view detailed information about the device. For more information, see 
"Managing one device through device details." Click the Expand icon  next to a device to 
view the monitor indexes for the device. Click the Expand icon  next to an index to view 
the monitor instances for the index.  

 Device Model—Contains device model information. If the device is managed using SNMP, 
this field displays the device model. If the device is managed for reachability using ICMP 
only and thus no device model information is available, this field contains ICMP. 

 Instances—Contains an active link. The link is the number of the monitor instance for the 
device that is being monitored. When the device is managed using SNMP, CPU Usage (%), 
Memory Usage (%), Response Time of Device (ms), and Device Unreachability 
Proportion (%) are monitored by default. When the device is managed for reachability 
using ICMP only, Response Time of Device (ms) and Device Unreachability Proportion 
(%) are monitored by default. The CPU Usage (%) and Memory Usage (%) of some 
devices cannot be monitored if they use proprietary MIBs. 

 Operation—Contains links for managing devices and monitor instances. The links for 
managing devices include Add Monitor, Cancel Monitor, and Alarm Threshold. The link 
for managing monitor indexes includes Cancel. The links for managing monitor instances 
include Cancel, Modify Index, and Modify Instance Name. For more information about 
the functions of these links, see "Managing device monitors." 

 Data—Contains the following icons: 
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  Click the icon to enter the Performance at a Glance window of the device. For 
more information, see "Viewing the At a Glance performance view." 

  Click the icon for a monitor instance to view the report for a time range for the 
monitor instance. 

If the Monitor List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Monitor List. 

 Click  to page forward to the end of the Monitor List. 

 Click  to page backward in the Monitor List. 

 Click  to page backward to the front of the Monitor List. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items 
per page you want to view. 

3. For Monitor list that have more than one page, click 1, 2, 3, 4, 5, 6, 7, 8, 9, 10 … from the 
bottom right side of the main pane to jump to a particular page. You can sort the Monitor List 
by the Device Name, IP Address, and Device Model fields. Click the column label to sort the 
list by the select field. The column label is a toggle switch that allows you to toggle between the 
various sort options specific to each field.  

Switching the monitor list 
The Monitor List, which displays all devices managed in IMC and the numbers of monitored 
instances of each device, can be in device list or instance list mode. 

To switch the Monitor List:  

1. Navigate to Resource > Monitoring Settings: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Monitoring Global Index Settings under Performance Management on the left 
navigation tree. 

The Monitor List is displayed with the Monitor List in the device list mode. 

2. Click the Switch to Instance List link located in the upper right corner of the Monitor List.  

The window refreshes to display all the monitor instances. 

3. Click the Switch to Device List link located in the upper right corner of the Monitor List.  

The window refreshes to display all managed devices. 

Searching for monitors 

Searching for monitors in the device list 

1. Navigate to Resource > Monitoring Settings. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Monitoring Settings under Performance Management on the left navigation tree. 

The Monitor List is displayed in the device list mode. Point to Query in the upper right 
corner of the monitor list.  

2. Enter one or more of the search criteria listed below: 
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 Device Name—Enter a partial or complete device name in the Device Name field for the 
devices you want to locate. 

 IP Address—Enter a partial or complete IP address in the IP Address field for the devices 
you want to locate. 

 View—Select the custom view, device view, or IP view from the View list to filter for devices 
that are members of the selected view. 

 Device Series—Select the device series from the Device Series list to filter for devices that 
are members of the selected series. 

3. Click Query. The result of your search is displayed in the Monitor List.  

4. Click Reset to clear the query criteria you entered in the Query area and query all the devices 
in IMC. 

Searching for monitors in the instance list 

1. Navigate to Resource > Monitoring Settings. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Monitoring Settings under Performance Management on the left navigation tree. 

The Monitor List is displayed. 

2. Click the Switch to Instance List link located in the upper right corner of the Monitor List. 

3. Point to Query in the upper right corner of the monitor list. 

4. Enter one or more of the search criteria listed below: 

 Device Name—Enter a partial or complete device name in the Device Name field for the 
devices you want to locate. 

 IP Address—Enter a partial or complete IP address in the IP Address field for the devices 
you want to locate. 

 View—Select the custom view, device view, or IP view from the View list to filter for devices 
that are members of the selected view. 

 Device Series—Select the device series from the Device Series list to filter for devices that 
are members of the selected series. 

 Item Name—Select the monitor item from the Item Name list to filter for instances that are 
using the selected monitor item. 

 Instance Name—Enter a partial or complete instance name in the Instance Name field for 
one or more instances you want to locate.  

5. Click Query. The result of your search is displayed in the Monitor List.  

6. Click Reset to clear the query criteria you entered in the Query area and query all the 
monitored instances. 

Managing device monitors 
In addition to the default monitor instances that are created for all devices by default, you can add 
monitor instances by choosing from a list of system or globally defined monitor indices. Once a 
monitor instance is created, you can modify the monitor instance to add thresholds for alarming on 
performance issues for selected devices. 

Adding monitor instances 

To add one or more monitored instances for devices:  

1. Navigate to Resource > Monitoring Settings. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 
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c. Click Monitoring Settings under Performance Management on the left navigation tree. 

The device Monitor List is displayed. 

2. To enter the Add Monitor window, do one of the following:  

 Select one or more devices you want to add monitor instances for and click Add Monitor at 
the top of the Monitor List. Also, you can click Add Monitor without selecting any devices. 

 Click Add for the device you want to add monitor instances for in the Operation column in 
the Monitor List. 

The Monitoring Settings-Add Monitor window opens. 

3. Select the method you want to use for adding performance instances: Monitoring Device or 
Monitoring Instance.  

The Monitoring Device option enables you to add all instances of one or more indexes to 
devices. The Monitoring Instance option enables you to add specific instances of one or more 
indexes to devices. 

4. Select monitor indexes: 

a. Click Add in the Select Index area. 

The Select Index window opens. 

b. Select Common Index or All Index. 

c. Click the Expand icon  for an index group to view all indexes contained in that group. 

d. Select indexes to monitor. 

e. Click OK. 

All selected indexes are displayed in the Select Index area of the Monitoring Settings-Add 
Monitor window. 

5. Configure the threshold settings for the selected indexes:  

a. Click the Configure icon  for an index whose threshold settings you want to modify. 

The Modify Index window opens. By default, the Global Index Settings option is selected 
and all other parameters are grayed out, indicating the threshold settings are the same as 
those configured for the index in Global Index Settings. 

b. Deselect the Global Index Settings option and set the first and second thresholds. For 
more information, see "Modifying a global monitor in the global index settings." 

c. Click OK. 

6. Select devices for which you want to add monitor instances in the Select Device area. This 
area is displayed only when the Monitoring Device option is selected. 

The Select Device area already contains the devices you have selected when the Monitoring 
Settings-Add Monitor window is accessed. If you want to add more devices, click Add in the 
Select Device area to add devices by using the By View or Advanced query option in the 
popup window. Remove one or more undesired devices by clicking their respective Delete 

icons . 

For more information about adding devices, see "Adding devices by view" and "Adding devices 
by advanced query." 

7. Set the type of interfaces whose data is to be monitored in the Monitoring Settings area. This 
area is displayed only when the Monitoring Device option is selected. For more information, 
see "Setting monitor option." 

8. Select monitor instances in the Select Instance area. This area is displayed only when the 
Monitoring Instance option is selected. 

The Select Instance area already contains the devices you have selected when the 
Monitoring Settings-Add Monitor window is accessed. If you want to add more devices, click 
Select in the Select Instance area to add devices by using the By View or Advanced query 
option in the popup window. Remove one or more undesired devices by clicking their respective 

Delete icons . 
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For more information about adding devices, see "Adding devices by view" and "Adding devices 
by advanced query." 

To select monitor instances, click the Expand icon  for a device for which you want to add 
monitor instances, and then select the target monitor instances. 

9. Click OK. 

IMC starts to add the selected monitor instances for devices and displays the operation results 
on the Monitoring Settings-Instance List. 

Monitoring Settings-Instance List 

 Device Name—Name of the device for which the monitor instances are added. Click the 
Expand icon to view all monitor instances that were successfully added for the device and 
are being monitored. 

 Result—Number of monitor instances that were successfully added for the device and their 
operation results. The operation result of a monitor instance can be Partially succeeded, 
Succeeded, or Failed. Click Partially succeeded or Failed for a device name to view the 
failure reason. 

If failures exist, modify the network configuration and click Previous to reselect monitor 
instances. 

10. You can save part of or all monitor instances on the Monitoring Settings-Instance List to a 
new or existing performance view. To do that: 

a. Select one or more monitor instances in the list. 

b. Click Save as New View or Save to Existing View. For more information, see "Creating a 
performance view from the monitor settings page" or "Saving monitors to an existing 
performance view from the monitor settings page." 

11. Click Close.  

To modify the name of a monitor instance, click the Modify Instance Name link, and modify the 
monitor instance name in the dialog box that opens. 

12. Click OK. 

Now that you have created monitor instances for the selected devices, you can view reports for the 

selected monitors by clicking the Data icon  in the column of the Monitor List. On the page, click 

the Modify Threshold icon  to modify thresholds in the popup window. For more information, see 
"Modifying threshold settings on a performance view." 

For more information about the Performance Monitor, see "Viewing the At a Glance performance 
view." 

You can also modify thresholds for alarming in IMC by modifying the monitor instances you have 
created.  

Modifying monitor instances 

The Modify Index option provides you with the ability to add, remove, or fine tune threshold settings 
for monitor instances that trigger alarms in IMC. You can modify the threshold settings for one or 
more monitor instances of the same type or different types for one or more devices.  

You can modify the individual monitor instances for any device, whether the monitor instance was 
created by the operator or was created automatically when the device was added to IMC.  

To modify one or more monitor instances: 

1. Navigate to Resource > Monitoring Settings: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Monitoring Settings under Performance Management on the left navigation tree. 

The Monitor List is displayed. 
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2. Enter the Modify Index window using any of the following methods: 

 Select the devices you want to modify, and then click Modify Index at the top of the Monitor 
List to modify all the monitor instances of the selected devices. 

 Click the Modify Index link of a device you want to modify in the Operation column to 
modify all the monitor instances of the device. 

 Click the Modify Index link of an instance you want to modify in the Operation column to 
modify the monitor instance. 

 Click the Switch to Instance List link located in the upper right corner of the Monitor List. 
Click the checkbox  to the left of the instance(s), select the instances you want to modify. 
Click, and then click Modify Index at the top of the Monitor List to modify all the selected 
monitor instances. 

 Click the Switch to Instance List link located in the upper right corner of the Monitor List. 
Click, and then click the Modify Index of the instance you want to modify in the Operation 
column to modify the monitor instance. 

The Modify Index window contains a left navigation tree and a threshold configuration area on 
the right. 

3. From the navigation tree, select a node for which you want to modify the threshold settings. 
Nodes are organized into the following hierarchies: performance index, device, and monitor 
instance name. If you select an index, modifications to the threshold settings apply to all 
existing monitor instances using that index on all devices in IMC. If you select a device, 
modifications to the threshold settings apply to all monitor instances using a specific index on 
that device. If you select a monitor instance, modifications to the threshold settings apply only to 
the monitor instance. 

If you configure different threshold settings for a monitor instance, the device where that 
monitor instance is located, and the index that the monitor instance uses, the most recent 
configuration takes effect. If you configure different threshold settings for an index and a device 
that has the index monitored, the most recent configuration takes effect. 

4. Modify the threshold settings for the selected node.  

By default, the Global Index Settings option is selected and all other parameters are grayed 
out, indicating the threshold settings are the same as those configured for the index in Global 
Index Settings. 

To modify the settings, clear the Global Index Settings box, set one or more threshold levels, 
and click OK. For more information, see "Modifying a global monitor in the global index 
settings." 

5. When you have finished modifying the threshold settings for all target nodes, click Close to 
return to the Monitor Instance List. 

Deleting monitor instances 

You can delete monitor instances for any device, whether the monitor instance was created by the 
operator or was created automatically when the device was added to IMC. Deleting an individual 
monitor instance does not delete the global monitor setting.  

To delete one or more monitor instances:  

1. Navigate to Resource > Monitoring Settings. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Monitoring Settings under Performance Management on the left navigation tree. 

The Monitor List is displayed. 

2. To delete one or more monitor instances, do one of the following: 

 Select the devices, and then click Cancel Monitor at the top of the Monitor List to delete all 
the monitor instances of the selected devices. 
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 Click the Cancel link for a device whose instances you want to delete in the Operation 
column to delete all the monitor instances of the device. 

 Click the Cancel link for an index in the Operation column to delete all monitor instances of 
the index. 

 Click the Cancel link for a monitor instance in the Operation column to delete the monitor 
instance. 

 Click the Switch to Instance List link located in the upper right corner of the Monitor List, 
select the instances you want to delete, and then click Cancel Monitor at the top of the 
Monitor List to delete all the select monitor instances. 

 Click the Switch to Instance List link located in the upper right corner of the Monitor List, 
and then click the Cancel of the instance you want to delete in the Operation column to 
delete the monitor instance. 

3. Click OK to confirm the deletion of the selected monitor instances. 

4. Review the results of this operation in the Result table. 

5. Check the Result field to verify that deleting the select monitor instances succeeded: 

 If the task was successful, the Result field contains the content, Succeeded. 

 If the task failed, the Result field contains the content, Failed. Click the contents of 
this field to drill down For more information about the cause of the failure. 

6. When you are finished reviewing the results of the task, click Back to return to the Monitor List. 

Modifying a monitor instance name 

1. Navigate to Resource > Monitoring Settings. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Monitoring Settings under Performance Management on the left navigation tree. 

The Monitor List is displayed. 

2. Click the Expand icon  for a device name and then click the Expand icon  for a monitor 
index. 

3. Click the Modify Instance Name link for a monitor instance. 

The Modify Instance Name window opens. 

4. Enter a monitor instance name. 

5. Click OK. 

Displaying monitored devices only 

1. Navigate to Resource > Monitoring Settings: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Monitoring Settings under Performance Management on the left navigation tree. 

The Monitor List is displayed. 

2. Select Only Display Monitored Devices located in the upper right corner of the Monitor List. 

The data in the Monitor List refreshes, and only the monitored devices are displayed.  

Saving monitors to a performance view 

A performance view is a collection of one or more charts that display the data collected by IMC for the 
configured monitors. IMC provides you with the ability to quickly and easily add one or more monitors 
to a new performance view or to existing performance views.  
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Modifying the default indexes 

IMC is configured to automatically gather performance data for all managed devices using a 
predefined set of monitors. Operators can customize this list of monitors by adding or removing 
monitors from the list. 

Managing performance views 
Performance views provide you with various methods of displaying monitoring data of the devices 
running on your network. 

IMC supports the following types of performance views:  

 TopN—Displays the TopN monitor instances of the 16 system-defined performance indexes. 
The TopN monitors are ranked by the performance data. Monitor instances can be added from 
the Monitoring Settings page. The performance indexes cannot be changed. 

 Data Grid—Displays the summary information about performance data, including the 
maximum, minimum, and average one. The performance data is about all the monitor instances 
of each performance index. 

 Trend Line—Displays the trend of the performance data of the monitor instances of each 
performance index. The trend is displayed in the form of trend chart. 

 At a Glance—Displays statistics of one or more indexes of the 16 system-defined performance 
indexes. 

 Service Monitor—Displays performance data about the reachability and the response time of 
the monitored services. 

In addition to the system-defined performance view, TopN, IMC allows you to add custom views and 
configure monitor instances for the performance views. 

When displaying a performance view, you can switch between the Data Grid view and Trend Line 
view.  

The following information describes how to create and modify performance views and view their 
performance data. 

Viewing the performance view list 

You can view all system-defined and custom performance views on the performance view list. 

To view the performance view list: 

1. Navigate to Resource > Performance View. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Performance View under Performance Management on the left navigation tree. 

The Performance View page opens with the Performance View List populated. 

Performance View List 

 Name—Name of the performance view. Click the name to view monitor data of the 
performance view in a popup window. 

 Monitoring Instance/State—Total number of monitor instances contained in the 
performance view and the numbers monitor instances in different states. Click the total 
number link to view these monitor instances in an At a Glance performance view. 

Each colored box next to a device indicates the state of monitor instances, and the number 
to the left of the box indicates the number of monitor instances in the associated state. The 
description of the colored boxes is as follows: 

 The green box  indicates that the performance data is normal or might reach the first 
threshold or second threshold, but triggers no alarms. The number of monitor instances 
in this state is next to the box. 
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 The yellow box  indicates that the performance data has triggered the first threshold 
level and triggered alarms. The number of monitor instances in this state is next to the 
box. 

 The pink box  indicates that the performance data has reached the second 
threshold level and triggered alarms. The number of monitor instances in this state is 
next to the box. 

 View Type—Type of the performance view: Trend Line, Data Grid, At a Glance, or Service 
Monitor. The system-defined TopN view does not have a type. 

 Description—Description of the performance view. 

 Creator—Name of the operator who created the performance view. 

 Creation Time—Time when the performance view was created. 

 Operation—Click the Operation icon  for the performance view to configure its settings. 

2. If the Performance View List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Performance View List. 

 Click  to page forward to the end of the Performance View List. 

 Click  to page backward in the Performance View List. 

 Click  to page backward to the front of the Performance View List. 

Or click 1, 2, 3, 4, 5, 6, 7, 8, 9, 10 … at the bottom right side of the main pane to jump to a 
particular page. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

4. You can sort the Performance View List by the Name, View Type, Description, Creator, and 
Creation Time fields. Click the column label to sort the list by the selected field. The column 
label is a toggle switch that allows you to toggle between the various sort options specific to 
each field. 

Viewing performance view details 

1. Navigate to Resource > Performance View: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Performance View under Performance Management on the left navigation tree. 

The Performance View window opens with the Performance View List populated. 

2. Click the Operation icon  for the performance view for which you want to view the detailed 
information and select View from the menu. 

The performance view details page opens, displaying the following information: 

 General Information—Displays basic information about the performance view, such as the 
name of the performance view, operator groups that can manage the performance view, 
and description of the performance view. 

 Applicable to—Displays information about the device and monitor instances contained in 
the performance view, such as the device name, type, IP address, and monitor instance 
name. 

Information is organized in three-hierarchical structure: device, performance index, and 
monitor instance. Click the Expand icon  for a device name to view the performance 
indexes that are contained in the performance view. Click the Expand icon  for a 
performance index name to view monitor instance names that are contained in the 
performance view. The TopN view details page does not have this area. 
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3. Click Back to return to the Performance View page. 

Modifying threshold settings on a performance view 

Every performance index, device, and monitor instance in a performance view has threshold 
settings, which define the conditions to trigger alarms. You can use their default global settings or 
modify the threshold settings by accessing performance views. 

The threshold settings of a performance index, device, and monitor instance are globally effective. 
Once the settings are modified for a performance index, device, and monitor instance in one 
performance view, the new settings apply to all performance views that contain the performance 
index, device, and monitor instance. The threshold settings in Global Index Settings do not change. 

To modify threshold settings of a performance index, device, or monitor instance: 

1. Navigate to Resource > Performance View: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Performance View under Performance Management on the left navigation tree. 

The Performance View window opens with the Performance View List populated. 

2. Click the Operation icon  for the performance view that contains the performance index, 
device, or monitor instance for which you want to view the threshold settings and select Modify 
Threshold from the menu. 

The Modify Index window opens, displaying a left navigation tree and a threshold configuration 
area on the right. 

3. From the navigation tree, select a node for which you want to modify the threshold settings. 

Nodes are organized into the following hierarchies: performance index, device, and monitor 
instance name. If you select an index, modifications to the threshold settings apply to all 
existing monitor instances using that index on all devices in IMC. If you select a device, 
modifications to the threshold settings apply to all monitor instances using a specific index on 
that device. If you select a monitor instance, modifications to the threshold settings apply only to 
the monitor instance. 

If you configure different threshold settings for a monitor instance, the device where that 
monitor instance is located, and the index that the monitor instance uses, the most recent 
configuration takes effect. If you configure different threshold settings for an index and a device 
that has the index monitored, the most recent configuration takes effect. 

4. Modify the threshold settings for the selected node. 

a. Clear the Global Index Settings box. 

b. Set the first and second thresholds. For more information, see "Modifying a global monitor in 
the global index settings." 

c. Click OK. 

5. When you have finished modifying the threshold settings for all target nodes, click Close to 
return to the Performance View page. 

Creating a Data Grid/Trend Line performance view 

A performance view is a collection of one or more charts that display the data collected by IMC for the 
configured monitors. You can add one or more monitors to a new or existing performance view.  

To create a Data Grid/Trend Line performance view:  

1. Navigate to Resource > Performance View. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Performance View under Performance Management on the left navigation tree. 

The Performance View window opens with the Performance View List populated. 

2. Click Add, and then select Data Grid or Trend Line from the Add list. 
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The Add Performance View window opens. 

3. Add monitor instances: 

a. Select a system index group from the Select Index list.  

Indexes that belong to the index group are displayed under the selected index.  

b. To add a monitor index, click the Add link associated with the monitor index. 

The monitor index is displayed in Existing Indexes and Monitored Objects. 

c. To delete all monitor indexes, click Delete under Existing Indexes and Monitored 
Objects. To delete a monitor index, click the Delete link associated with the monitor 
index. 

d. For monitor indexes whose monitored objects are devices, click Device to enter the Select 
Devices window to add monitor instances. For monitor indexes whose monitored objects 
are interfaces, click Interface to add monitor instances.  

For more information, see "Adding devices by view" and "Adding devices by advanced 
query." 

e. To add monitor instances for a monitor index, click the Interface or Device link 
associated with the monitor index.  

f. To display all monitor instances of a monitor index, click the Link icon  associated with the 
monitor index. For a monitor index whose monitored objects are interfaces, you must also 

click the Link icon  associated with the device to display all interfaces of the device. 

g. To delete a monitor instance, click the  Delete link associated with the monitor instance. 
To delete all interface monitor instances of a device, click the  Delete link associated with 
a device to delete the device. 

4. Click Next to enter the Instance List. 

All monitor instances are displayed in the Instance List. 

Instance List 

 Index—Contains the names of the monitor indexes. 

 Device Name—Contains the names of the devices. A device name comprises the device 
label and device IP address. 

 Instance Name—Contains the names of the monitor instances. 

 Monitoring Status—Displays the status of the monitor instances. If a monitor instance is 
monitored, this field displays Monitored. If a monitor instance fails to be monitored, this field 
displays the Failed to add the default indexes link, and you can click this link to display 
the failure reasons. 

5. Select one or more monitor instances whose monitoring status is Monitored. 

6. Click Save. 

The popup window Add Performance View opens. 

7. Select a view type for the performance view.  

Available options include Trend Line and Data Grid. 

8. Enter a name in the View Name field.  

A valid length for the view name is 1 to 32 characters. 

9. Select one or more operator groups that have the right to access the performance view.  

Available options include Maintainer Group and Viewer Group. By default, the Administrator 
Group is select and cannot be deleted. 

10. Enter a description for the performance view in the Description field. 

11. Click OK to confirm that the performance view is successfully added. 

12. Click Close. 
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The newly added performance view is displayed in the Performance View List. 

Creating an At a Glance performance view 

1. Navigate to Resource > Performance View: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Performance View under Performance Management on the left navigation tree. 

The Performance View window opens with the Performance View List populated. 

2. Click Add, and then select At a Glance from the Add list. 

The Add Performance View window opens. You cannot select monitor indexes in this window. 
By default, 16 monitor indexes are available. 

3. Click Device. 

A popup window for selecting devices opens. 

For more information, see "Adding devices by view" and "Adding devices by advanced query." 

4. To display all monitor instances of a monitor index, click the Link icon  associated with the 
monitor index. For a monitor index whose monitored objects are interfaces, you must also click 

the Link icon  associated with the device to display all interfaces of the device. 

5. To delete a monitor instance, click the Delete link associated with the monitor instance. To 
delete all interface monitor instances of a device, click the Delete link associated with a device 
to delete the device. 

6. Click Next to enter the Instance List. 

All monitor instances are displayed in the Instance List, which includes the following: 

 Index—Contains the names of the monitor indexes. 

 Device Name—Contains the names of the devices. A device name comprises the device 
label and device IP address. 

 Instance Name—Contains the names of the monitor instances. 

 Monitoring Status—Displays the status of the monitor instances. If a monitor instance is 
monitored, this field displays Monitored. If a monitor instance fails to be monitored, this field 
displays the Failed to add the default indexes link, and you can click this link to display 
the failure reasons. 

7. Select one or more monitor instances whose monitoring status is Monitored.  

8. Click Save. 

The popup window Add Performance View opens. 

9. Select At a Glance for the view type. 

10. Enter a name in the View Name field. A valid length for the view name is 1 to 32 characters.  

11. Select one or more operator groups that have the right to access the performance view.  

Available options include Maintainer Group and Viewer Group. By default, the Administrator 
Group is selected and cannot be deleted. 

12. Enter a description for the performance view in the Description field. 

13. Click OK to confirm that the performance view is successfully added. 

14. Click Close. 

The newly added performance view is displayed in the Performance View List. 

Creating a performance view from the monitor settings page 

From the Monitoring Settings page, you can select monitor instances and then initiate the creation 
of a new performance view using the select monitor instances.  

You can create only Data Grid or Trend Line views from the Monitoring Settings page. 
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To create a new performance view:  

1. Navigate to Resource > Monitoring Settings: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Monitoring Settings under Performance Management on the left navigation tree. 

The Monitor List is displayed. 

2. Select one or more devices, and then select Save as New View from the Save Performance 
View list to save all the monitor instances of the selected devices to a new performance view. 

The Add Performance View page opens. The selected instances are displayed in the Select 
Instances area. For more information about adding a performance, see "Creating a Data 
Grid/Trend Line performance view." 

Saving monitors to an existing performance view from the monitor settings page 

You can add monitor instances only to the existing Data Grid or Trend Line views from the 
Monitoring Settings page. 

To add monitor instances to an existing performance view:  

1. Navigate to Resource > Monitoring Settings: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Monitoring Settings under Performance Management on the left navigation tree. 

The Monitor List is displayed. 

2. Select one or more devices, and then select Save to Existing View from the Save 
Performance View list to save all the monitor instances of the selected devices to an existing 
performance view. 

The Select View dialog box opens. 

3. Select the performance view to which you want to add the selected monitor instances.  

In a performance view, you can specify up to 50 instances for a monitor index.  

The performance monitoring settings can be saved as a performance view of the trend line or 
data grid type.  

4. Click OK to add the selected monitor instances to the existing performance view.  

Once you have added the monitor instances to the performance views, you can launch the 
views from the Performance View List. For more information about performance views, see 
"Viewing a performance view report."  

Adding a performance view shortcut to the floating menu 

Once a performance view has been created, you can add it to the floating menu for quick access to 
it. By default, the newly added performance view is added to the floating menu in the navigation tree.  

To add performance views to the floating menu:  

1. Navigate to Resource > Performance View: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Performance View under Performance Management on the left navigation tree. 

The Performance View page opens with the Performance View List populated. 

2. Navigate to the folder that contains the performance view you want to add to the floating menu. 

3. Click the Operation icon  in the field associated with the performance view you want to add 
to the left navigation tree, and then select Add to the floating menu to add the performance 
view to the floating menu.  

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 9150



749 

Hover over Performance View on the left navigation tree, and a floating menu appears. Click 
the performance view in the floating menu to enter the Monitoring Data Statistics window. For 
more information, see "Viewing performance views."  

Removing a performance view shortcut from the floating menu 

1. Navigate to Resource > Performance View: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Performance View under Performance Management on the left navigation tree. 

The Performance View page opens with the Performance View List populated. 

2. Navigate to the folder that contains the performance view you want to remove from the floating 
menu. 

3. Click the Operation icon  in the field associated with the performance view you want to 
remove from the floating menu, and then select Remove from floating menu to remove the 
performance view from the floating menu. 

Modifying the upper-level folder of a performance view 

1. Navigate to Resource > Performance View: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Performance View under Performance Management on the left navigation tree. 

The Performance View page opens with the Performance View List populated. 

2. Navigate to the folder that contains the performance view you want to modify from the floating 
menu. 

3. Click the Operation icon  in the field associated with the performance view you want to 
modify.  

4.  Select Modify the upper-level folder from the popup menu.  

The Modify the upper-level folder page opens.  

5. Select a upper-level folder for the performance view from The Upper-level Folder list. 

6. Click OK. 

Modifying a Data Grid/Trend Line performance view 

1. Navigate to Resource > Performance View: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Performance View under Performance Management on the left navigation tree. 

The Performance View page opens with the Performance View List populated. 

2. Navigate to the folder that contains the performance view you want to modify. 

3. Click the Operation icon  in the field associated with the performance view you want to 
modify.  

4. Select Modify from the popup menu.  

The Modify Performance View page opens.  

5. Modify monitor instances: 

a. Select a system index group from the Select Index list. Indexes that belong to the index 
group are displayed under the selected index.  

b. To add a monitor index, click the  Add link associated with the monitor index. 

The monitor index is displayed in Existing Indexes and Monitored Objects. 
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c. To delete all monitor indexes, click Delete under Existing Indexes and Monitored 
Objects. To delete a monitor index, click the  Delete link associated with the monitor 
index. 

d. For monitor indexes whose monitored objects are devices, click Device to enter the Select 
Devices window to add monitor instances. For monitor indexes whose monitored objects 
are interfaces, click Interface to add monitor instances.  

For more information, see "Adding devices by view" and "Adding devices by advanced 
query." 

e. To add monitor instances for a monitor index, click the Interface or Device link 
associated with the monitor index.  

f. To display all monitor instances of a monitor index, click the Link icon  associated with 
the monitor index. For a monitor index whose monitored objects are interfaces, you must 

also click the Link icon  associated with the device to display all interfaces of the device. 

g. To delete a monitor instance, click the  Delete link associated with the monitor instance. 
To delete all interface monitor instances of a device, click the  Delete link associated with 
a device to delete the device. 

6. Click Next to enter the Instance List. 

All monitor instances are displayed in the Instance List with the following information: 

 Index—Contains the names of the monitor indexes. 

 Device Name—Contains the names of the devices. A device name comprises the device 
label and device IP address. 

 Instance Name—Contains the names of the monitor instances. 

 Monitoring Status—Displays the status of the monitor instances. If a monitor instance is 
monitored, this field displays Monitored. If a monitor instance fails to be monitored, this 
field displays the Failed to add the default indexes link, and you can click this link to 
display the failure reasons. 

7. Select one or more monitor instances whose monitoring status is Monitored. 

8. Click Save. 

The popup window Modify Performance View opens. 

9. Select a view type for the performance view.  

Available options include Trend Line and Data Grid. 

10. Enter a name in the View Name field. 

A valid length for the view name is 1 to 32 characters. 

11. Select one or more operator groups that have the right to access the performance view.  

Available options include Administrator Group, Maintainer Group, and Viewer Group. By 
default, the Administrator Group is selected and cannot be deleted.  

12. Enter a description for the performance view in the Description field. 

13. Click OK to confirm that the performance is successfully added. 

14. Click Close. 

The newly modified performance view is displayed in the Performance View List. 

Modifying an At a Glance performance view 

1. Navigate to Resource > Performance View. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Performance View under Performance Management on the left navigation tree. 

The Performance View window opens with the Performance View List populated. 
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2. Navigate to the folder that contains the performance view you want to modify. 

3. Click the Operation icon  for the performance view you want to modify.  

4. Select Modify from the popup menu.  

The Modify Performance View window opens. You cannot select monitor indexes in this 
window. By default, 16 monitor indexes are available. 

5. Modify monitor instances.  

6. Click Device.  

A popup window for selecting devices opens. 

 For more information, see "Adding devices by view" and "Adding devices by advanced query." 

7. To display all monitor instances of a monitor index, click the Link icon  associated with the 
monitor index. For a monitor index whose monitored objects are interfaces, you must also click 

the Link icon  associated with the device to display all interfaces of the device. 

8. To delete a monitor instance, click the  Delete link associated with the monitor instance. To 
delete all interface monitor instances of a device, click the  Delete ink associated with the 
device. 

9. Click Next to enter the Instance List. 

All monitor instances are displayed in the Instance List with the following information: 

 Index—Contains the names of the monitor indexes. 

 Device Name—Contains the names of the devices. A device name comprises the device 
label and device IP address. 

 Instance Name—Contains the names of the monitor instances. 

 Monitoring Status—Displays the status of the monitor instances. If a monitor instance is 
monitored, this field displays Monitored. If a monitor instance fails to be monitored, this field 
displays the Failed to add the default indexes link, and you can click this link to display 
the failure reasons. 

10. Select one or more monitor instances whose monitoring status is Monitored. 

11. Click Save. 

The popup window Modify Performance View opens. 

12. Select At a Glance for the view type. 

13. Enter a name in the View Name field. 

A valid length for the view name is 1 to 32 characters 

14. Select one or more operator groups that have the right to access the performance view.  

Available options include Maintainer Group, and Viewer Group. By default, the 
Administrator Group is selected and cannot be deleted.  

15. Enter a description for the performance view in the Description field. 

16. Click OK to confirm that the performance view is successfully added. 

17. Click Close. 

The newly modified performance view is displayed in the Performance View List. 

Deleting a performance view 

1. Navigate to Resource > Performance View: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Performance View under Performance Management on the left navigation tree. 

The Performance View page opens with the Performance View List populated. 

2. Navigate to the folder that contains the performance view you want to delete. 
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3. Click the Delete icon  for the performance view you want to delete. 

Viewing performance views 
This section describes viewing different types of performance views. 

Viewing TopN performance views 

1. Navigate to Resource > Performance View: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Performance View under Performance Management on the left navigation tree. 

The Performance View page opens with the Performance View List populated. 

2. Click the name link of the TopN performance view to enter the Performance View window. 

By default, this window displays the Top5 monitor instances of the monitor index CPU Usage 
TopN within the last one hour. 

3. Select Last Hour, Today, Yesterday, This Week, Last Week, This Month, Last Month, This 
Year or Last Year on top of the window to view the performance data in a specified time. 

4. To view the monitor instances of a specified monitor index, select the monitor index from the list 
in the upper right of the window. The monitor instances depend on its monitor index in the 
monitor settings. 

5. Click the Set icon  in the upper right of the window.  

The popup window Set opens.  

6. Select the number of monitor instances, or select Custom from the TopN list, and then click 
OK.  

If you select Custom, enter a number in the Custom TopN field. 

7. Click the name link of an instance.  

The popup window Performance Data opens and you can view the trend chart of the 
performance data of the monitor instance.  

8. On top of the window, view the trend chart of the performance data within a specified time by 
the following available options: 

 Last Hour 

 Today 

 Yesterday 

 This Week 

 Last Week 

 This Month 

 Last Month 

 This Year 

 Last Year 

Select Custom on top of the Monitoring Data Statistics window to view the performance data 
within a customized time. 

If you select Custom, click the field next to From to define the begin date, click the field next to 
To to define the end date in the form of YYYY:MM:DD hh:mm, and then click Query to view the 
performance data within a customized time. 

9. Close the Performance Data window to return to the Performance View window. 

10. Click  in the upper right of the window to view the performance data report. For more 
information, see "Viewing a performance view report."  
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Viewing monitor instances in a performance view at a glance 

1. Navigate to Resource > Performance View: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Performance View under Performance Management on the left navigation tree. 

The Performance View page opens with the Performance View List populated. 

2. Navigate to the folder that contains the performance view you want to view. 

3. Click Instance N (N is the number of instances) in the Monitoring Instance/Sate list in the 
Trend Line, Data Grid, or At a Glance performance view.  

The popup window Monitoring Instances at a Glance opens.  

Each colored box next to a device indicates the state of monitor instances, and the number to 
the left of the box indicates the number of monitor instances in the associated state. 

  indicates that the performance data is normal and might reach the first threshold or 

second threshold, but triggers no alarms. The number to the left of  indicates the number 
of monitor instances in this state. 

  indicates that the performance data has triggered the first threshold level and triggered 

alarms. The number to the left of  indicates the number of monitor instances in this 
state.  

  indicates that the performance data has reached the second threshold and triggered 

alarms. The number to the left of  indicates the number of monitor instances in this 
state.  

4. Click the Link icon  to the left of a device name to display all monitor indexes and monitor 
instances.  

All the monitor instances of a monitor index are displayed in the form of bar box next to the 
monitor index. The color of the bar box indicates the alarm status of the monitor instances.  

5. Click the name link of a monitor instance to enter the Performance Data window.  

The Performance Data window displays the trend of performance data within a specified time 
in the form of trend chart and the performance data collected within a specified interval in the 
form of table.  

6. Select a time range for the performance data by using one of the following methods: 

 On top of the Performance Data window, select one of the following options: 

 Last Hour 

 Today 

 Yesterday 

 This Week 

 Last Week 

 This Month 

 Last Month 

 This Year 

 Last Year 

 Select Custom on top of the Performance Data window to view the performance data 
within a customized time. 
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If you select Custom, click the field next to From to define the begin date, click the field next 
to To to define the end date in the form of YYYY:MM:DD hh:mm, and then click Query to 
view the performance data within a customized time. 

7. Close the Performance Data window to return to the Monitoring Instances at a Glance 
window. 

8. Query the performance data: 

 For a Trend Line or Data Grid performance view, click  or  on top of the window to 
enter the Monitoring Data Statistics window. For more information, see "Viewing the 
Trend Line or Data Grid performance view." 

 For an At a Glance performance view, click  to enter the Monitoring Data Statistics 
window. For more information, see "Viewing the At a Glance performance view." 

9. Click the Modify Threshold icon  to modify thresholds in the popup window. For more 
information, see "Modifying threshold settings on a performance view." 

10. Click the Refresh icon  on top of the window to refresh the current window. 

Viewing the Trend Line or Data Grid performance view 

1. Navigate to Resource > Performance View: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Performance View under Performance Management on the left navigation tree. 

The Performance View page opens with the Performance View List populated. 

2. Navigate to the folder that contains the performance view you want to view. 

3. Click the name link of a Trend Line or Data Grid performance view to enter the Monitoring 
Data Statistics window: 

 For the Trend Line performance view, click  in the upper right of the window to view a 
summary of the performance data. 

 For the Data Grid performance view, click the Max.Value(%), Min.Value(%), or 

Average(%) column to sort the device performance data, or click  in the upper right of 
the window to display the performance trend. 

 To enter the Monitoring Instances at a Glance window, click  on top of the page. 

4. Select a monitor index from the list in the upper right of the window to view the summary chart or 
trend chart of the monitor instances in the monitor index. 

5. Select a time range for the performance data by using one of the following methods: 

 Select Last Hour, Today, Yesterday, This Week, Last Week, This Month, Last Month, 
This Year or Last Year on top of the window to view the trend chart of the performance data 
within a specified time. 

 Select Custom on top of the Monitoring Data Statistics window to view the performance 
data within a customized time. 

If you select Custom, click the field next to From to define the begin date, click the field next 
to To to define the end date in the form of YYYY:MM:DD hh:mm, and then click Query to 
view the performance data within a customized time. 

6. You can modify the layout of monitor instances for a performance view displayed in a trend 
chart: 

a. Click the Performance View Layout icon  next to the window.  

The popup window Performance View Layout opens.  

b. Modify the layout of the monitor instances. 

c. Click Save. 
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The new layout of monitor instances is displayed in the Monitoring Data Statistics 
window.  

To view the performance data report, click  next to the window. For more information, 
see "Viewing a performance view report."  

7. Query the performance data: 

 For the Trend Line performance view, click the name link of a monitor instance to view the 
summary of the performance data. 

 For the Data Grid performance view, click the name link of a monitor instance to view the 
summary of the performance data. 

8. Click the Modify Threshold icon  to modify thresholds in the popup window. For more 
information, see "Modifying threshold settings on a performance view." 

9. Click the Refresh icon  on top of the window to refresh the current window. 

Viewing the At a Glance performance view 

1. Navigate to Resource > Performance View: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Performance View under Performance Management on the left navigation tree. 

The Performance View page opens with the Performance View List populated. 

2. Navigate to the folder that contains the performance view you want to view. 

3. Click the name link of an At a Glance performance view to enter the At a Glance window.  

The At a Glance performance view displays the performance data of all the monitor instances 
of the 16 monitor indexes for a device. To enter the Monitoring Instances at a Glance 

window, click the  on top of the window.  

4. Select a device from the list on top of the window, as needed, to view the performance data of 
the device. 

5. Select a time range for the performance data by using one of the following methods: 

 On top of the window, view the trend chart of the performance data within a specified time by 
selecting the following options: 

 Last Hour 

 Today 

 Yesterday 

 This Week 

 Last Week 

 This Month 

 Last Month 

 This Year 

 Last Year 

 Select Custom on top of the Performance Data window to view the performance data 
within a customized time. 

 Select Custom on top of the Monitoring Data Statistics window to view the performance 
data within a customized time. 

If you select Custom, click the field next to From to define the begin date, click the field next to 
To to define the end date in the form of YYYY:MM:DD hh:mm, and then click Query to view the 
performance data within a customized time. 

6. Click the Refresh icon  in each monitor index pane to refresh the performance data of the 
monitor index. 
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7. Click the Refresh icon  on top of the window to refresh the performance data of all the 
monitor indexes on the window. 

8. Click the Modify Threshold icon  to modify thresholds in the popup window. For more 
information, see "Modifying threshold settings on a performance view." 

Viewing a performance view report 

1. Navigate to Resource > Performance View: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Performance View under Performance Management on the left navigation tree. 

The Performance View page opens with the Performance View List populated. 

2. Navigate to the folder that contains the performance view you want to view. 

3. Enter the window associated with the relevant performance view: 

 Click the name link of a Trend Line or Data Grid performance view to enter the Monitoring 
Data Statistics window. 

 Click the name link of the TopN performance view to enter the Performance View window. 

4. Select monitor indexes from the list in the upper right of the window.  

IMC can generate a report based on the select monitor indexes.  

5. Click  in the upper right of the window.  

The popup window Set Query Condition opens.  

6. Select a monitor index from the View Format list. 

7. Select a time range for the performance data by using one of the following methods: 

 Select a time range from the Time Range list.  

The report can collect the data within the specified time range.  

 (For a non-TopN performance view) Select Custom from the Time Range list. 

If you select Custom, you can customize a time range by entering the begin time in Begin 
Time in the format of YYYY:MM:DD hh:mm:ss, or by clicking the field next to Begin Time, 
and then entering the end time in End Time in the format of YYYY:MM:DD hh:mm:ss, or 
clicking the field next to End Time to specify an end time.  

8. Click OK.  

The popup window Intelligent Analysis Report Viewer opens.  

For a Trend Line or Data Grid performance view report, it displays the trend of each monitor 
instance in a specified time range in the form of trend chart on top of its first page. Each monitor 
instance is distinguished by a colored bar. The bar also displays the data statistics of each 
monitor instance collected in a specified interval, including the maximum, minimum, and 
average one.  

For a TopN performance view report, it displays the TopN monitor instance statistics of the 
monitor index in the form of tables.  

9. Click the Detail link associated with a monitor instance to enter the Performance Data Detail 
Report window.  

The Performance Data Detail Report window displays the trend of the performance data in 
the specified time range in the form of trend chart.  

You can switch to different reports by clicking the tabs on top of the window.  

Exporting or printing a report 

To export a report: 

1. Click the Export icon  in the upper left corner of a report.  

The Export page opens.  
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2. From the File Format list, select a file format in which you want to export the report. Options 
include: 

 PDF 

 XLS 

 CSV 

 DOCX 

 RTF 

 XLSX 

 PPTX 

3. Select the range of pages. 

4. To export all pages of the report, select All Pages. To export a specified range of pages, select 
Select Pages, and then enter the begin page in the From field and the end page in the To field. 
Click Export to save the report in the pre-defined path. 

To print a report to a .pdf file: 

1. Click the Print icon  at the top of a report.  

The Print Setup page opens. 

If printing is performed for the first time, you are prompted to install Crystal Printer Control. 
The Print Setup page opens after the installation succeeds.  

2. Set the range of pages to be printed. 

3. Click Print. 

Managing the IMC performance monitor settings 
for topology maps 

IMC provides you with the ability to customize and view performance reporting on topology maps. 
Select devices in a topology map to view the performance data of the devices in a tip. With the Data 
Shown in Topo feature, you can customize the reports that are displayed on the topology maps, and 
add, modify, or remove monitors that are available on the topology map. 

Accessing data shown in topology 
All reports that are displayed on the topology map are listed in the Data Shown in Topo list. From 
this list, you can view, add, modify, or remove performance monitors for display on topology maps.  

To access the Data Shown in Topo list:  

1. Navigate to Resource > Data Shown in Topo: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Data Shown in Topo under Performance Management on the left navigation tree. 

The Data Shown in Topo page opens. 

Data shown in topo list 

 Performance Index—Contains the name of the index or monitor. 

 Applicable To—Identifies which devices on the topology map to which the associated 
monitor can be applied. 

 Time Range—Contains the range of data that is provided on the topology map for the 
associated performance monitor. 

 Modify—Contains a link for modifying the topology map settings for the associated monitor. 
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 Delete—Contains a link for deleting the topology map settings for the associated monitor. 

If the Data Shown in Topo list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Data Shown in Topo list. 

 Click  to page forward to the end of the Data Shown in Topo list. 

 Click  to page backward in the Data Shown in Topo list. 

 Click  to page backward to the front of the Data Shown in Topo list. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

3. For Data Shown in Topo lists that have more than one page, click 1, 2, 3, 4, 5, 6, 7, 8, 9, 10 … 
from the bottom right side of the main pane to jump to a particular page of the trap list.  

You can sort the Data Shown in Topo list by the Performance Index, Applicable To, and 
Time Range fields. Click the column label to sort the list by the selected field. The column label 
is a toggle switch that allows you to toggle between the various sort options specific to each 
field.  

Managing data shown in topology 
IMC provides you with the ability to define which performance monitors are displayed on the 
Network Topology.  

Adding a monitor to the IMC network topology 

To add a monitor to the Data Shown in Topo list for display on the IMC topology maps: 

1. Navigate to Resource > Data Shown in Topo. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Data Shown in Topo under Performance Management on the left navigation tree. 

The Data Shown in Topo page opens, 

2. Click Add.  

The Add/Modify Data Shown in Topo dialog box opens.  

3. Select which device type displays the performance monitor from the Applicable to list.  

The default device and default link options apply the topology settings to all devices and links 
regardless of type.  

4. Select the performance monitor group you want to display on the topology maps from the first 
Performance Index list.  

The option you select here filters the options available to you in the second Performance Index 
list to only those monitors that are available under the monitor you select here.  

5. Select the individual performance monitor item you want to display on the topology maps from 
the second Performance Index list. 

6. Select the time period you want IMC to display performance statistics for from the Time Range 
list. 

7. Click OK to accept your changes. 

Once you have added a performance monitor item to the Data Shown in Topo list, it becomes 
available for viewing on the IMC Network Topology.  

To view the data of the performance monitor item, click the device, hovering over it, and the tip 
containing the performance data appears  

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 9160



759 

Modifying a monitor on the IMC network topology 

To modify a monitor on the Data Shown in Topo list: 

1. Navigate to Resource > Data Shown in Topo: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Data Shown in Topo under Performance Management on the left navigation tree. 

The Data Shown in Topo page opens, 

2. Click the Modify icon  for the performance monitor item you want to modify.  

The Add/Modify Data Shown in Topo dialog box opens.  

You cannot modify the Applicable to and Performance Index fields. 

3. Select the time period you want IMC to display performance statistics for from the Time Range 
list. 

4. Click OK to accept your changes. 

Once you have added a performance monitor item to the Data Shown in Topo list, it becomes 
available for viewing on the IMC Network Topology.  

Deleting a monitor from the IMC network topology 

To delete a monitor from the Data Shown in Topo list: 

1. Navigate to Resource > Data Shown in Topo: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Data Shown in Topo under Performance Management on the left navigation tree. 

The Data Shown in Topo page opens, 

2. Click the Delete icon  for the performance monitor item you want to delete. 

3. Click OK to confirm the deletion of the selected monitor. 

Managing the real-time performance monitor 
IMC provides you with the ability to monitor the real-time performance of key devices.  

To display real-time performance data for easy management, IMC manages the data in three 
hierarchies:  

 Real-Time Monitoring—Provides the whole frame and the main window for displaying 
performance data. You can create monitors in the frame and view the data of each monitor in 
the main window. 

 Monitor—Provides you with the ability to create monitor graphs in the monitor and group the 
real-time performance data. 

 Monitor Graph—Displays performance data in graphs for one or more devices.  

Viewing real-time monitoring page 
1. Click the Resource tab from the top tabular navigation system. 

2. Click Performance Management on the left navigation tree. 

3. Click Real-Time Monitoring under Performance Management on the left navigation tree. 

The Real-Time Monitoring page opens. 

Real-Time Monitoring page 
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 Monitor/Monitor graphs—The main pane in the Real-Time Monitoring window displays the 
history monitor and its monitor graph when you closed the window last time. The monitor graph 
does not display any history data and displays real-time performance data. 

 Toolbar—The toolbar is located on the top of the Real-Time Monitoring window. From the left 
to the right, the toolbar contains three configuration shortcuts. 

For more information about adding a monitor graph, see "Adding a monitor graph."  

 Monitor List—The Monitor List is located in the upper left corner of the Real-Time 
Monitoring window. You can click the Monitor List to add, delete, modify, or switch monitors. 
For more information, see "Managing monitors." 

When you open the Realtime Monitor window that contains no monitor or monitor graph of a 
monitor, the following dialog box opens: 

 If no monitor has been created for the Realtime Monitor window, an Add Monitor dialog 
box opens when you open the Realtime Monitor window. For more information about 
adding a monitor, see "Adding a monitor." 

 If a monitor has no monitor graph created in the Realtime Monitor window, an Add 
Monitor Graph dialog box opens when you open the Realtime Monitor window. For more 
information about adding a monitor graph, see "Adding a monitor graph." 

 Interval (Sec.)—Performance data of the monitor is collected at the interval and displayed in 
the Real-Time Monitoring window. The system automatically adjusts the interval based on the 
number of monitor instances in IMC. 

Managing monitors 
Monitors provide you with the ability to group real-time performance monitor data and view grouped 
data. 

Viewing a monitor 

Open the Real-Time Monitoring window to view the history monitor as it was when you closed the 
window last time. For more information about accessing a monitor, see "Viewing real-time monitoring 
page." 

To switch to another monitor, click Monitor List located in the upper left corner of the Real-Time 
Monitoring window, and then select the name of the desired monitor.  

When you switch to another monitor, the performance monitor data from the previous monitor is 
cleared.  

Adding a monitor 

1. Navigate to Resource > Real-Time Monitoring: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Real-Time Monitoring under Performance Management on the left navigation tree. 

The Real-Time Monitoring page opens. 

2. Click Monitor List next to the toolbar. 

3. Select Add. 

The Add Monitor dialog box opens. 

Enter a name for the monitor in the Monitor Name field. 

4. Set the Access Right. 

5. Select the operator groups you want to add in the Access Right table. 

6. Click the list in the Access Right field associated with the operator group. 

7. Do one of the following: 
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 Select Read Only to allow operators in an operator group only to view the current monitor 
and change the background color of the monitor graphs. 

 Select Read/Write to allow operators to modify the current monitor and customize the four 
configuration items. 

You cannot cancel or modify the authorization of the administrator group and the operation 
group of the current operators for the monitor. 

8. Click OK to create the new monitor. 

Modifying a monitor 

1. Navigate to Resource > Real-Time Monitoring: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Real-Time Monitoring under Performance Management on the left navigation tree. 

The Real-Time Monitoring page opens. 

2. Click Monitor List located in the upper right corner of the Real-Time Monitoring window. 

3. Click Modify.  

The Modify Monitor dialog box opens.  

You cannot change the name of the monitor. 

4. Set the Access Right. 

5. Do one of the following: 

 Select the operator groups you want to add in the Access Right table. 

 Clear the  check box to the left of the operator groups you want to cancel in the Access 
Right table. 

6. Click the list in the Access Right field associated with the operator group. 

7. Do one of the following: 

 Select Read Only to allow operators in an operator group only to view the current monitor 
and change the background color of the monitor graphs. 

 Select Read/Write to allow operators to modify the current monitor and customize the four 
configuration items. 

You cannot cancel or modify the authorization of the administrator group and the operation 
group of the current operators for the monitor. 

8. Click OK to confirm your changes. 

Deleting a monitor 

1. Navigate to Resource > Real-Time Monitoring: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Real-Time Monitoring under Performance Management on the left navigation tree. 

The Real-Time Monitoring page opens. 

2. Click Monitor List located in the upper right corner of the Real-Time Monitoring window. 

3. Click Delete.  

4. Click OK to confirm the deletion. 

Managing monitor graphs 
A monitor graph displays performance monitor data for one or more devices.  
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Viewing monitor graphs 

Open the Real-Time Monitoring window to the history monitor and its monitor graphs when you 
closed the window last time. For more information about accessing monitor graphs, see "Viewing 
real-time monitoring page."  

A monitor graph has the graph name located in the top middle, a toolbar under the graph name, 
performance data table or graph under the toolbar, and monitor instances at the bottom of the 
monitor graph. To modify or delete a monitor graph, click Set in the upper right corner of the monitor 
graph. 

In the bar graph, the X-axis denotes the time, and the Y-axis denotes the performance data. The 
graph displays the performance data for one or more devices at a specified time.  

Under the graph are the items of the monitor instance name. If there are several instances, the 
instances are distinguished by colors. Click a monitor instance name link to hide the line for the 
monitor instance in the monitor graph and gray out the monitor instance name. Click the monitor 
instance name link again to display the line for the monitor instance in the monitor graph. 

Adding a monitor graph 

You can add one or more monitor graphs to a monitor.  

To add a monitor graph:  

1. Navigate to Resource > Real-Time Monitoring: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Real-Time Monitoring under Performance Management on the left navigation tree. 

The Real-Time Monitoring page opens. 

2. Click Add Monitor Graph located in the top toolbar.  

The Add Monitor Graph dialog box opens.  

3. Enter a name for the graph in the Graph Title field. 

4. Enter a name for the monitor item of this graph in the Y-Axis Name field. 

5. Enter a unit for the monitor item of this graph in the Y-Axis Unit field. 

6. Add the monitor instance: 

a. Click  Add Monitor Instance in the Monitor Instance Information area. 

The Add Monitor dialog box opens.  

b. Click Add in the Select Index area. 

The Select Index dialog box opens. 

c. Select Common Index or All Index. 

d. Expand the monitor group you want to select monitor items from by clicking the arrow icon 
 to the left of the monitor group. 

e. Select the monitor items you want to monitor. 

f. Click OK. 

g. Confirm that the indexes now are displayed in the Select Index field. 

h. Click Select in the Select Instances area. 

The Select Devices dialog box opens. 

Add devices by View or by the Advanced query option. 

For more information, see "Adding devices by view" and "Adding devices by advanced 
query." 

i. Expand the monitor instance by clicking the arrow icon  to the left of the device name in 
the Select Instances field. 

j. Confirm that the monitor instances now are displayed in the Select Instances field. 
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k. Click the box next to the monitor instance to be monitored. 

l. Click OK. 

m. Confirm that the monitor instances now are displayed in the Monitor Instance Information 
field. 

7. Click OK to create the new monitor graph. 

There is no performance monitor data in a new monitor graph. 

Modifying a monitor graph 

1. Navigate to Resource > Real-Time Monitoring: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Real-Time Monitoring under Performance Management on the left navigation tree. 

The Real-Time Monitoring page opens. 

2. Click Set located in the upper right corner of the monitor graph you want to modify.  

3. Select Modify from the menu that appears. 

The Modify Monitor Graph dialog box opens. 

Graph Title cannot be modified. 

4. Enter a new name for the monitor item of this graph in the Y-Axis Name field. 

5. Enter a new unit for the monitor item of this graph in the Y-Axis Unit field. 

6. Do one of the following: 

 Click  Add Monitor Instance located in the Monitor Instance Information area to add 
the new monitor instances. 

 In the Monitor Instance Information area, click the Remove icon  for a monitor instance 
to delete the monitor instance. Click Delete All located in the upper part of the Monitor 
Instance Information area to delete all monitor instances. 

Click OK to confirm the deletion. 

7. Click OK to confirm your changes. 

If you change the monitor instances in a monitor graph, the existing performance data in the monitor 
graph is cleared. 

Deleting a monitor graph 

1. Navigate to Resource > Real-Time Monitoring: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Real-Time Monitoring under Performance Management on the left navigation tree. 

The Real-Time Monitoring page opens. 

2. Click Set located in the upper right corner of the monitor graph you want to delete. 

3. Select Delete from the menu that appears. 

4. Click OK to confirm the deletion. 

Managing performance option 
The Performance Option includes Display Option, Monitor Option and Instance Profiles. 
Display Option allows you to set the data unit. Monitor Option allows you to set which ports are to 
be monitored. Instance Profiles allows you to configure instance profiles for the Performance 
Instance Profile widget displayed on the IMC home page.  
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Setting the display option 
1. Navigate to Resource > Performance Option. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Performance Option under Performance Management on the left navigation tree.  

The Performance Option page opens.  

2. Click the Display Option tab on the Performance Option page. 

3. Select the data unit option from the Data unit list.  

The Auto option can automatically adjust the data unit based on the actual length of the data.  

4. Select Yes or No for the Allow breaks in performance trend graphs field. 

 If you select Yes, the curve breaks where there are time points when data collection fails. 

 If you select No, a smooth curve is used to represent the trend. The curve is generated on 
the data that are collected after at least three continuous polling time points. 

5. Configure performance trend line colors: 

a. Click Select Colors. 

The Select Colors dialog box opens. 

b. Select colors. 

 Select one or more colors in the Available area and click the Add icon  to add the 
colors to the Selected area. 

 Click the Add All icon  to add all colors in the Available area to the Selected area. 

 Select one or more colors in the Selected area and click the Remove icon  to 
remove the colors from the Selected area. 

 Click the Remove All icon  to remove all colors from the Selected area. 

c. Modify the rank of colors in the Selected area. 

 Select one or more colors and click the Up icon  to move the colors up one position. 

 Select one or more colors and click the Top icon  to move the colors to the top. 

 Select one or more colors and click the Down icon  to move the colors down one 
position. 

 Select one or more rules and click the Bottom icon  to move the colors to the bottom. 

d. Click Close. 

6. In the Performance trend line width field, enter a value, or set a value by clicking the Increase 
icon  or Decrease icon . The value range is 1 to 5 and the step value is 0.25. 

7. In the Dashboard trend line width field, you can set the trend line width for the performance 
view widget in the dashboard. Enter a value, or set a value by clicking the Increase icon  or 
Decrease icon . The value range is 1 to 5 and the step value is 0.25. 

8. Click Set to confirm your change. 

Setting monitor option 
1. Navigate to Resource > Performance Option. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Performance Option under Performance Management on the left navigation tree.  
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The Performance Option page opens.  

2. Click the Monitor Option tab on the Performance Option page. 

3. Select the types of the interfaces to be monitored. Options include All interfaces, Up 
Interfaces , Monitor Physical Interfaces only, and UP physical interfaces. You can select 
only one option at a time.  

4. Select one or multiple conditions you want the interfaces to meet before they can be monitored. 
Options include Interfaces Connected to SNMP Devices, Interfaces Connected to Servers, 
and Interfaces Connected to PCs. The options follow the logical OR rule. If an interface 
matches one option, the interface is monitored.  

The options configured in step 3 and step 4 follow the logical AND rule. The interfaces must 
match the option selected in step 3 and at least one option selected in step 4 to be monitored.  

For example, if you select Up Interfaces in step 3, and Interfaces Connected to SNMP 
Devices and Interfaces Connected to Servers in step 4, the interfaces that can be monitored 
are interfaces in up state that are connected to SNMP devices or connected to servers.  

5. Click Set to confirm your change. 

Configuring instance profiles 
Instance profiles are displayed in a Performance Instance Profile widget on the IMC home page. You 
can add, modify, and delete instance profiles.  

Viewing the instance profile list 

1. Navigate to Resource > Performance Option. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Performance Option under Performance Management on the left navigation tree.  

The Performance Option page opens.  

2. Click the Homepage Widget tab on the Performance Option page. 

The Instance Profiles page opens with the following: 

 Name—Name of the instance profile. 

 Creator—Creator name of the instance profile. 

 Delete—Link for deleting the instance profile. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view.  

You can sort the instance profile list by the Name field. Click the column label to sort the list by 
the selected field. The column label is a toggle switch that allows you to toggle between the 
various sort options specific to each field.  

4. Click Refresh to update the Instance Profiles page.  

Adding an instance profile 

1. Click the Home tab from the top tabular navigation system. 

2. Click the Settings icon . 

3. Select Edit from the shortcut menu to launch the dialog box for adding widgets. 

4. Click the Performance tab and click  for the Performance Instance Profile widget 
to add the widget to the home page. 

5. Click Performance Instance Profile on the Performance Instance Profile widget. 

The Add Performance Instance Profile page opens. 
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6. In the Name field, enter the performance instance profile name, using a string of 1 to 32 
characters.  

7. Select a monitor item from the Item Name list.  

The selected monitor item is displayed in the Select Instance area.  

8. Click the Link icon  to the left of the selected monitor item to expand all devices.  

9. Click the Link icon  to the left of a device name to display the instance of the device. 

10. Select the desired instances. You can select up to eight instances for an instance profile.  

11. Click OK.  

Modifying a performance instance profile 

1. Click the Home tab from the top tabular navigation system. 

2. Click a performance instance profile name on the Performance Instance Profile widget. 

The Modify Performance Instance Profile page opens. For more information, see "Adding an 
instance profile." 

Deleting instance profiles 

1. Navigate to Resource > Performance Option. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Performance Option under Performance Management on the left navigation tree.  

The Performance Option page opens.  

2. Click the Homepage Widget tab on the Performance Option page. 

3. Do one of the following: 

 Select one or more instance profiles to be deleted, and then click Delete.  

 Click the Delete icon  of the instance profile to be deleted. 

A confirmation dialog box opens.  

4. Click OK to delete the instance profile. 

Configuring common indexes 
After you configure common indexes, you can quickly select the common indexes when you select 
indexes. 

1. Navigate to Resource > Performance Option. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Performance Option under Performance Management on the left navigation tree.  

The Performance Option page opens.  

2. Click the Common Index tab in the Performance Option page. 

The Common Index page opens with all monitor indexes in IMC. 

 To expand all index categories, click Expand All at top of the page. 

 To collapse all index categories, click Collapse All at top of the page. 

 To expand an index category, click the Expand icon  next to the index category. 

3. Select the indexes or indexes categories to configure. 

4. Click OK. 
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Configuring TOPN indexes 
You can configure a maximum of 20 TOPN indexes. The system collects data by the specified TOPN 
indexes and displays the data through performance views and homepage widgets. 

1. Navigate to Resource > Performance Option. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Performance Option under Performance Management on the left navigation tree.  

The Performance Option page opens. 

2. Click the TOPN Index tab in the Performance Option page. 

The TOPN Index page opens with all monitor indexes in IMC. 

 To expand all index categories, click Expand All at top of the page. 

 To collapse all index categories, click Collapse All at top of the page. 

 To expand an index category, click the Expand icon  next to the index category. 

3. Select indexes or indexes categories. 

4. Click OK. 

Configuring display indexes 
In the Display Index tab, you can globally configure the monitor indexes to be displayed in the 
performance monitor part of the device details page for all devices. If you modify the monitor indexes 
for a device, the device uses its specific configuration rather than the global configuration.  

1. Navigate to Resource > Performance Option. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Performance Option under Performance Management on the left navigation tree.  

The Performance Option page opens. 

2. Click the Display Index tab in the Performance Option page. 

3. Click Add to add monitor indexes.  

The Select Index page opens with all monitor indexes in IMC. 

 To expand all index categories, click Expand All at top of the page. 

 To collapse all index categories, click Collapse All at top of the page. 

 To expand an index category, click the Expand icon  next to the index category. 

4. Select indexes or indexes categories. 

5. Click OK. 

6. Click Batch Set to enter the Batch Set Display Indexes page. On the page, you can batch set 
the performance monitoring indexes displayed on the device details page.  

Batch setting display indexes for the selected devices will clear all original display indexes for 
these devices and save the current settings. After batch setting display indexes, you can see 
the effective display indexes on the device details page for the selected devices.  

7. Select monitoring indexes as display indexes and select the devices for which you want to set 
the display indexes.  

8. Click OK. 
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Configuring device memory usage trend alarms 
The device memory usage trend alarms monitor the device memory usage status. This feature can 
find possible memory leaks through calculation and promptly send alarms. With this feature, you can 
analyze whether memory leaks occur on devices and avoid network failures caused by slow memory 
leaks after the devices have been running for a long period of time.  

This feature calculates the memory usage growth rates based on the history data of the memory 
usage monitoring index. The calculation is triggered when the device memory usage exceeds the 
level-2 threshold. To use this feature, you must enable the memory usage monitoring index for the 
devices, and configure the level-2 threshold alarms.  

To discover tiny memory leaks, this feature supports calculating both the daily growth rate and 
weekly growth rate. When the memory usage grows but the daily growth rate in 30 days is too small 
to trigger alarms, the calculation is automatically switched to calculate the weekly memory usage 
growth rate.  

To configure the device memory usage trend alarm: 

1. Navigate to Resource > Performance Option. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Performance Option under Performance Management on the left navigation tree.  

The Performance Option page opens. 

2. Click the Device Memory Usage Trend Alarm tab in the Performance Option page. 

3. Configure the parameters for the device memory usage trend alarm: 

 Enable—Select Yes or No to enable or disable the device memory usage trend alarms.  

 Repetition Times—Specify the repetition times, 3 by default. After the memory usage 
growth rate exceeds the level-2 threshold, alarms are sent if the memory usage 
continuously grows for three days or weeks.  

 Growth Rate—Specify the daily or weekly average growth rate. When the actual average 
growth rate exceeds the configured value, alarms are sent. By default, the growth rate is 
0.001%. 

4. Click Set.  

Configuring dynamic threshold indexes 
This feature calculates the optimal threshold of a performance index by learning the history data of 
the index. Based on the data change type, you can enable the rising alarms and falling alarms. You 
can set the rising/falling base value and rising/falling threshold conditions for the rising/falling alarms. 
When both conditions for a type of alarms are met, alarms are sent. Select a maximum of 16 
dynamic threshold indexes. Otherwise, you cannot save the dynamic threshold index settings. If the 
dynamic threshold index is opened for 5 weeks, it will judge whether the threshold alarm is generated 
according to the actual situation.  

To configure dynamic threshold indexes: 

1. Navigate to Resource > Performance Option. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Performance Option under Performance Management on the left navigation tree.  

The Performance Option page opens. 

2. Click the Dynamic Threshold Index tab in the Performance Option page. 

3. Click Enable Dynamic Threshold Index. 
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4. Click Select Index to select one or multiple dynamic threshold indexes.  

5. Click Save.  

6. Click the  icon for a dynamic threshold index and modify parameters for the dynamic 
threshold index on the page that opens. You can enable rising or falling alarms, set the base 
value, and set the rising/falling threshold.  

 Rising—When the actual value is greater than the threshold and the alarm conditions are 
met, the rising alarms are sent. 

 Falling—When the actual value is smaller than the threshold and the alarm conditions are 
met, the falling alarms are sent. 

 Base Value—The judgement starts only when the actual value or threshold is greater than 
the base value. For example, suppose the base value is 30 and the rising threshold is 20%. 
When the threshold is 10 and the actual value is 15, no alarms are sent because the actual 
value is smaller than the base value. 

 Rising/Falling Threshold—When the actual value is greater than the threshold*(1 + rising 
threshold) or is smaller than the threshold*(1 - falling threshold), alarms are sent. For 
example, suppose the threshold is 50 and the base value is 40. If the rising threshold is 
20%, rising alarms are sent only when the actual value is greater than 50+50*0.2=60. 

Configuring default monitor indexes 
IMC is configured to automatically poll all managed devices for specific system and performance 
metrics. You can customize this list of metrics or indexes by adding or removing indexes from the list. 

To configure the default monitor indexes: 

1. Navigate to Resource > Performance Option: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Performance Option under Performance Management on the left navigation tree.  

The Performance Option page opens. 

2. Click the Default Monitoring Indexes tab in the Performance Option page. 

3. Select a monitor index. 

4. Click Save to save the current configuration as the default monitoring indexes. The saved 
default monitoring indexes do not affect the existing devices, and apply only to the new devices. 
When a new device is added to IMC, IMC uses indexes that the new device supports among the 
default monitoring indexes to monitor the device. 

5. Click Add Indexes to save the configuration and add the default monitor indexes to the devices 
that have been added to IMC. 

6. Click Cancel Indexes to remove the selected indexes from the default monitor indexes and 
remove the selected indexes from the devices that have been added to IMC. 

Configuring service monitoring 
Service monitoring monitors the reachability and response time of network services to determine the 
availability and quality of the services. Services that can be monitored include:  

 DHCP  

 DNS 

 FTP 

 Internet service 

 RADIUS service 
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 SNMP 

You can add, modify, delete, start, or stop a service monitor.  

Viewing the service monitor list 

1. Navigate to Resource > Service Monitor. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Service Monitor under Performance Management on the left navigation tree.  

The Service Monitor List displays the following information about all service monitors: 

Service monitor list 

 Monitor Name—Contains the name of the service monitor.  

 Service Type—Contains the type of the service to be monitored 

 Item Name—Contains the name of the monitoring index.  

 Monitor Status—Contains the status of the service monitor, which can be Start Monitor or 
Stop Monitor. 

 Server IP address—Contains the IP address of the server on which the service is running.  

 Modify—Contains a link for entering the page for modifying the service monitor. 

 Data—Contains the collected data. 

2. Click Refresh to update the Service Monitor List.  

Adding a service monitor 

1. Navigate to Resource > Service Monitor. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Service Monitor under Performance Management on the left navigation tree.  

The Service Monitor List displays all service monitors.  

2. Click Add Monitor.  

The Add Service Monitor window opens.  

Before you add a service monitor, make sure the server on which IMC is running has been 
added to the IMC system.  

3. Enter a unique monitor name in the Monitor Name field, a string of 1 to 32 characters.  

4. Select the service type to be monitored from the Select Service Type list. Options include: 

 DHCP Service Monitor 

 DNS Service Monitor 

 FTP Service Monitor 

 Internet Service Monitor 

 RADIUS Service Monitor 

 SNMP Service Monitor 

5. Select the monitor index. Options include service-name Unreachability Proportion (%) and 
Response Time of service-name (ms).  

The configuration parameters vary with service types.  

6. Enter configuration parameters, as necessary, by service type: 

For a DHCP Service Monitor 

 Enter the IP address of the DHCP server in the Server Address field. 

 Enter the MAC address of the client for which you want to test reachability to the DHCP 
server in the format of xx-xx-xx-xx. 
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 Select the Use Unicast option if you want to send the testing packets in unicast. If you do 
not select this option, the packets are sent in broadcast. 

For a DNS Service Monitor 

 Enter the IP address of the DNS server in the Server Address field.  

 Enter the fully qualified domain name (FQDN) of the DNS server in the FQDN field. 

For an FTP Service Monitor 

 Enter the IP address of the DHCP server in the Address field. 

 Enter the listening port used by the FTP service in the Port field.  

 Enter the FTP login username in the Username field.  

 Enter the login password for the FTP user.  

Leave the Username and Password fields empty if you want to use anonymous logins. 

For an Internet Service Monitor 

 Enter a URL in the Web Address field. The URL can start with http:// or https://. 

 Select the Use HTTP Proxy option if HTTP proxy is enabled for the Web service, and then 
configure the following parameters: 

 HTTP Proxy Address—Enter the IP address of the HTTP proxy server. 

 Port—Enter the listening port of the HTTP proxy server. 

 Username—Enter the username used for logging in to the HTTP proxy server. 

 Password—Enter the password used for logging in to the HTTP proxy server. 

For a RADIUS Service Monitor 

 Enter the IP address of the RADIUS server in the Server Address field. 

 Configure the following server parameters:  

 Shared Key—Enter the shared key used for communication between the RADIUS 
client and RADIUS server.  

 Username—Enter the username used for logging in to the RADIUS server. 

 Password—Enter the password used for logging in to the RADIUS server. 

 Authentication Type—Select an authentication type. Options include PAP and CHAP. 

 Authentication Port—Enter the authentication port of the RADIUS server. 

 Accounting Port—Enter the accounting port of the RADIUS server.  

For an SNMP Service Monitor 

 Enter the IP address of the device to be tested in the IP Address field. 

 Enter the SNMP read-write community string in the SNMP Community String field. The 
value must be the same as that configured on the device. 

 Enter any OID value on the device to be tested in the SNMP OID field. IMC tries to get the 
corresponding value on the device according to the OID value. If the value can be obtained, 
IMC determines that the service can be reached. 

7. Click OK.  

The new service monitor is displayed in the Service Monitor List, in the default Start Monitor 
state.  

Modifying a service monitor 

1. Navigate to Resource > Service Monitor. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Service Monitor under Performance Management on the left navigation tree.  

The Service Monitor List displays all service monitors.  
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2. Click the Modify icon  for the service monitor you want to modify.  

The page for modifying the service monitor opens. For information about modifying the service 
monitor, see "Adding a service monitor."  

Starting service monitors 

1. Navigate to Resource > Service Monitor. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Service Monitor under Performance Management on the left navigation tree.  

The Service Monitor List displays all service monitors.  

2. Select one or more service monitors you want to start. 

3. Click Start Monitor.  

Stopping service monitors 

To stop one or more service monitors: 

1. Navigate to Resource > Service Monitor. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Service Monitor under Performance Management on the left navigation tree.  

The Service Monitor List displays all service monitors.  

2. Select one or more service monitors you want to stop. 

3. Click Stop Monitor.  

Deleting service monitors 

1. Navigate to Resource > Service Monitor. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Service Monitor under Performance Management on the left navigation tree.  

The Service Monitor List displays all service monitors.  

2. Select one or more service monitors you want to delete. 

3. Click Delete.  

A confirmation dialog box opens. 

4. Click OK. 

Configuring periodic monitoring 
The periodic monitoring feature allows you to view the performance data for devices in custom views 
for the specified work time. 

Viewing the periodic monitor list 

1. Navigate to Resource > Service Monitor: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Periodic Monitor under Performance Management on the left navigation tree. 

The periodic monitor list displays all periodic monitors.  

Periodic Monitor List 

 Name—Contains the name of the periodic monitor. 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 9174



773 

 Work Time Setting—Contains the name of the work time setting that is used by the 
periodic monitor. Click the name to view the work time for the periodic monitor. 

 Custom View—Contains the name of the custom view that is used by the periodic monitor. 
Click the name to view the monitored devices by the periodic monitor. 

 Modify—Contains a link for entering the page for modifying the periodic monitor. 

 Delete—Contains a link for deleting the periodic monitor.  

2. Click Refresh to update the Periodic Monitor List.  

Adding a periodic monitor 

1. Navigate to Resource > Service Monitor: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Periodic Monitor under Performance Management on the left navigation tree. 

The periodic monitor list displays all periodic monitors.  

2. Click Add.  

The Add Periodic Monitor page opens.  

Before you add a periodic monitor, make sure the custom view and the work time setting have 
been added to the IMC system.  

3. Enter a periodic monitor name in the Name field. 

The periodic monitor name is a string of 1 to 32 characters. 

4. Select a custom view to be monitored from the Custom View list. 

The custom view list display the existing custom views. Click Add Custom View next to the 
Custom View field to add a new item. 

5. Select the work time from the Work Time Setting list.  

The work time setting list displays the existing work time names. Click Add Work Time Setting 
next to the Work Time Setting field to add a new item. 

6. Click OK.  

The new periodic monitor is displayed in the periodic monitor list.  

Modifying a periodic monitor 

1. Navigate to Resource > Service Monitor: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Periodic Monitor under Performance Management on the left navigation tree. 

The periodic monitor list displays all periodic monitors.  

2. Click the Modify icon  for the periodic monitor you want to modify. 

The page for modifying the periodic monitor opens. For information about modifying the 
periodic monitor, see "Adding a periodic monitor."  

Deleting a periodic monitor 

1. Navigate to Resource > Service Monitor: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Periodic Monitor under Performance Management on the left navigation tree. 

The periodic monitor list displays all periodic monitors.  

2. Click the Delete icon  for the periodic monitor to be deleted. 

A confirmation dialog box opens.  
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3. Click OK to delete the periodic monitor. 

Managing monitoring settings of a group 
This feature allows you to batch set performance monitoring indexes by interface view or custom 
view. Before using this feature, you must add interface views or custom views in the view 
management of resource management. After you configure monitoring settings for an interface view 
or custom view group, the selected performance monitoring indexes will be added to all interfaces or 
devices in the group. When interfaces or devices are newly added to the interface view or custom 
view, the system will automatically add the corresponding performance monitoring indexes to the 
newly added interfaces or devices.  

Viewing monitoring settings of a group 
1. Navigate to Resource > Service Monitor: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Group-Based Monitoring Settings under Performance Management on the left 
navigation tree. 

2. Select Interface View or Custom View to view the monitoring settings of the corresponding 
group.  

Adding monitoring settings to a group 
1. Navigate to Resource > Service Monitor: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Group-Based Monitoring Settings under Performance Management on the left 
navigation tree. 

2. Select Interface View or Custom View. 

3. Click Add. The window for adding monitoring settings to a group opens.  

4. In the View Name field, select a view.  

5. Click Select Index. On the Select Index window that opens, select performance indexes in the 
Common Index or All Index area.  

6. Click OK to return to the page for adding monitoring indexes to a group. The selected 
performance indexes are displayed on the list. To delete a selected performance index, click 

the  icon for the performance index.  

7. After selecting monitoring indexes, click OK. After adding monitoring settings for a group, the 
selected performance monitoring indexes are added to the interfaces or devices in the group.  

Modifying monitoring settings of a group 
1. Navigate to Resource > Service Monitor: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Group-Based Monitoring Settings under Performance Management on the left 
navigation tree. 

2. Select Interface View or Custom View. 
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3. Click the  icon for the group to be modified. On the window that opens, modify the 
performance monitoring indexes for the group.  

4. Click Select Index. On the window that opens, select performance indexes to be monitored in 
the Common Index or All Index area.  

5. Click OK. To delete a selected performance index, click the  icon for the performance index.  

6. After the performance indexes are selected, click OK.  

Deleting monitoring settings of a group 
1. Navigate to Resource > Service Monitor: 

a. Click the Resource tab from the top tabular navigation system. 

b. Click Performance Management on the left navigation tree. 

c. Click Group-Based Monitoring Settings under Performance Management on the left 
navigation tree. 

2. Select Interface View or Custom View. 

3. Click the  icon for a group to delete its monitoring settings. After the monitoring settings of a 
group are deleted, the performance monitoring indexes added to interfaces or devices in the 
corresponding view group will not be deleted.  
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Access control list management 
ACL Management allows you to view and configure existing ACLs on devices managed by IMC and 
to import ACL from the devices into ACL Management as templates or resources. Once you have 
created ACL templates and resources, they can be used to create ACLs for deployment to other 
managed devices. ACL also has a deployment wizard that allows you to quickly deploy ACLs and 
ACL applications (called ACL uses in IMC) to managed devices. An ACL use specifies the network 
services that use an ACL, for example, a packet filter on a port or a routing policy. The deployment 
task management features allows you to monitor and manage deployment and removal of ACLs and 
ACL uses.  

Rules are the core of an ACL. A rule contains conditions that define whether traffic is forwarded or 
filtered by a network device and includes a rule number, the action that is taken in the rule - whether 
traffic is permitted or denied, and a pattern for matching the contents of every packet to determine 
whether or not the packet is forwarded. The pattern to match can be an IP or MAC address or range 
of addresses and their masks and can include a Layer 4 TCP, UDP port number, or it can be a 
hexadecimal string and an offset value that identifies where in the packet to begin the pattern 
matching. Rules may also include identification of the protocol or type of traffic that the action is 
taken for and protocol specific configuration options. Rules can also include time ranges and options 
specific to the protocol identified in the rule or the type of ACL and rule. A rule set is a collection of 
individual rules that are identified by the rule set name. An ACL is a container for one or more rule 
sets. In ACL Management, an ACL includes the name or number that identifies the ACL (ACL 
Identifier), the type of ACL it is, and its name. 

There are four types of ACLs that can be created in IMC and four types of templates: 

 Basic—Allows you to create rules based on source IP addresses. 

 Advanced—Allows you to create rules based on Layer 3 and Layer 4 information including IP 
source and destination addresses, TCP and UDP port information, and protocol specific 
options. 

 Link—Allows you to create rules based Layer 2 information including MAC source and 
destination addresses, source VLAN and VLAN priority information as well as link layer protocol 
type. 

 User-Defined ACLs—Enable you to define a hexadecimal pattern and mask and the offset in 
the packet header where pattern matching begins. When a pattern is matched, the actions 
specified in the rule in the ACL are applied.  

ACL Template in ACL Management is a container for the configuration options required to create an 
ACL and to maintain the template. An ACL template contains configuration information including the 
ACL template name and template description, the type of ACL it is, rules that define what actions are 
taken for each packet examined by the ACL, protocol specific configuration options, and time ranges 
during which the rules of the ACL are in effect. Once you have created an ACL template, you can 
import it into an ACL resource. Once ACL resources are created, they can be deployed to devices 
managed by IMC that support ACLs. 

The ACL Assistant facilitates ACL template rule creation by modularizing some of the aspects of an 
ACL rule–services, network address groups, and time ranges. With Services, you define one or 
more TCP or UDP ports as a named service. With Net Address Groups, you can specify an IP 
address or range of IP addresses and their subnet mask. With Time Ranges, you specify a fixed or 
recurring date and time range. Once these are created using the Assistant, they become available 
for use when configuring rules for templates. 

ACL Management offers you a rich feature set for simplifying the task of managing ACLs and their 
rule sets. Through the ACL Resource list, you have a single portal for viewing and managing all of 
the ACLs that can be deployed to network devices. From this list, you can view, add, rename and 
delete ACLs. 

From the ACL Resource list, you can drill down into the Rule Set List to view every rule set for a 
given ACL. From the Rule Set List page, you can view information for every rule in a set. From this 
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list, you can also take action all of the rules in the list, including adding, modifying, copying, 
deploying, or deleting existing rule sets. From the Rule Set List, you can also import the contents of 
a template into a new rule set of an existing ACL. 

ACL Management also provides features for rule management. You can redefine the order of 
appearance of rules in a rule set, which can be crucial to its effectiveness when the match order is 
based on the order of rule appearance. In addition, ACL Management can optimize rules in a rule 
set by making and implementing recommendations for reducing the effect of ACLs on network 
performance. 

ACL Management also simplifies and streamlines the process of managing ACLs on devices. With 
ACL Management, you have a single portal for viewing and managing the ACL configurations for all 
devices that support ACLs. From the ACL Device List, you can view all devices that support ACLs 
as well as view detailed information the ACL configuration for a single device. 

The ACL Device configuration page provides you with features for managing ACL configurations for 
the selected device. From this page, you can synchronize and refresh the ACL configuration data for 
the device as well as modify the ACL configuration polling interval. From the configuration page you 
can access the ACL Definitions tab to add or delete ACL definitions, export an ACL to a text file, and 
apply an ACL as a packet filter or VLAN packet filter to one or more interfaces on the device. 

ACL Management's ACL Deployment wizard provides you with a step-by-step process for 
successfully deploying ACLs, ACL uses for packet and VLAN filtering, as well as removing ACLs, 
and ACL uses. During the deployment task configuration process for each of these deployment 
types, IMC evaluates the selected devices and ACLs to determine whether or not the task can be 
executed successfully. IMC identifies when devices do not match the configuration selections and 
displays warning messages and evaluation results to guide the successful deployment of ACL 
resources. In addition, ACL Management removes from the deployment configuration devices for 
which the selected action cannot be successfully executed. Lastly, the ACL Deployment wizard 
provides you with a facility for viewing and managing all deployment tasks through the ACL 
Deployment Task List. 

The subnet mask inversion function simplifies the task of configuring IP subnets in ACL rules. You 
can enter an IP address and a subnet mask to identify an IP subnet. ACL Management 
automatically inverts the subnet mask into a wildcard mask when applying the configuration to 
devices. The following configuration for access control list management supposes that the subnet 
mask inversion function is enabled. 

Simplifying ACL rule creation using the assistant 
The ACL Assistant facilitates ACL template rule creation by modularizing various aspects of an ACL 
rule. With the ACL Assistant, you can create services, network address groups, and time ranges 
consisting of one or more entries. Once created, you can then apply the services, network address 
groups, and time ranges to one or more rules of any ACL template in ACL Management. 

With Services, you define one or more ports that constitute a service and assign a name to the list of 
ports. Then, when creating a rule in a template, you assign the service to one or more rules, which 
defines the ports that are permitted or denied based on the parameters configured in the rules. 

With Net Address Groups, you define a list of one or more IP address and subnet mask 
combinations. Then, the address group is assigned to one or more template rules in a template that 
is imported into ACL rule sets. The addresses specified in the net address groups become the 
source or destination addresses specified in the rules of an ACL. 

With Time Ranges, you specify the fixed date and time ranges, or recurring, or cyclic time ranges, 
specified by one or more days of the week that the rule takes effect. Operators can then assign the 
specified time range to one or more rules in a template. 

With Wildcard Mask, or the subnet mask inversion function, you identify an IP subnet by specifying 
an IP address and a subnet mask. ACL Management automatically inverts the subnet mask into a 
wildcard mask when applying the configuration to devices.  
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Managing services using the ACL assistant 
In ACL Management, a service is a mnemonic for the TCP or UDP port configuration of a service, an 
application, or group of services or applications. Once you create a service in ACL Management 
using the ACL Assistant, you can use this service when configuring the port information in a 
template rule. Each service is comprised of a service name and a set of port numbers. For example, 
you can define a service called Telnet and specify port 23 as the port for the Telnet service. Or, you 
can create a service group that specifies one or more ports for one or more services or applications. 
For example, your organization has a network management application called "WatchIT" and the 
application uses ports in the range of 1001 to 1010. You can create a service called "WatchIT" and 
define the ports used by this application in the service. Once you have created the "WatchIT" service, 
you can specify its name in the Variable Port fields of an advanced ACL template rule configuration. 

Viewing the service list 

1. Navigate to Service List. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click Assistant under ACL Management on the left navigation tree. 

d. Click Service List in the Assistant Management portion of the Service List page. 

The Service List is displayed on the main pane of the page. 

Service List 

 Name—Contains the name of the service.  

This field serves as a link for navigating to the View Service page for the associated 
service. For more information about the View Service option, see "Viewing a service". 

 Description—Contains a description for the associated service. 

 Modify—Contains a link  for modifying the associated service. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure the number of items 
per page you want to view. 

You can sort the Service List by the Name and Description fields. Click the column label to 
sort the list by the selected field. The column label is a toggle switch that allows you to toggle 
between the various sort options specific to each field. 

Viewing a service 

1. Navigate to Service List. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click Assistant under ACL Management on the left navigation tree. 

d. Click Service List in the Assistant Management portion of the Service List page. 

The Service List is displayed on the main pane of the page. 

2. Click the service name in the Name field. 

The View Service page opens. 

Service List 

 Name—Contains the name of the service. 

 Description—Contains a description for the associated service. 

 Port List—Contains a list of all UDP or TCP ports specified for this service. 

Adding a service to the service list 

1. Navigate to Service List. 
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a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click Assistant under ACL Management on the left navigation tree. 

d. Click Service List in the Assistant Management portion of the Service List page. 

The Service List is displayed on the main pane of the page. 

2. Click Add. 

The Add Service page opens. 

3. Enter a name for the service in the Name field.  

A valid length is 1-32 characters. A service name cannot begin with a number. 

4. Enter a brief description for the service in the Description field. 

5. Enter a port number in the Port field.  

A valid port entry includes a port number in the rage from 0-65535. 

6. Click Add. 

7. Do one of the following: 

 To enter more than one port, repeat step 5. 

 To remove a port number, select the port and click Delete. 

 To remove all ports in the list, click Delete All. 

8. Click OK to create the service. 

Once you have created a service, you can enter it in the Variable Port field when you have 
select TCP or UDP as the protocol for an Advanced rule when creating an ACL template. For 
more information about using a service when defining a rule in an ACL template, see "Creating 
ACL templates." 

Modifying a service in the service list 

1. Navigate to Service List. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click Assistant under ACL Management on the left navigation tree. 

d. Click Service List in the Assistant Management portion of the Service List page. 

The Service List is displayed on the main pane of the page. 

2. Click the Modify icon  for the service you want to modify. 

The Modify Service page opens. 

You cannot modify the name of a service once the service has been created. 

3. Modify the description for the service as needed in the Description field. 

4. To add a port number to the existing list, enter the new port number in the Port field.  

A valid port entry includes port numbers in the range from 0-65535. 

5. Click Add. 

6. Do one of the following: 

 To enter more than one port, repeat steps 4-5. 

 To remove a port number, select the port and click Delete. 

 To remove all ports in the list, click Delete All. 

7. Click OK to accept your modifications to the service. 

Deleting a service in the service lists 

1. Navigate to Service List. 

a. Click the Service tab from the top tabular navigation system. 
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b. Click ACL Management on the left navigation tree. 

c. Click Assistant under ACL Management on the left navigation tree. 

d. Click Service List in the Assistant Management portion of the Service List page. 

The Service List is displayed on the main pane of the page. 

2. Select the service names for the services you want to delete. 

3. Click Delete. 

4. Click OK to confirm the deletion of the selected services. 

Managing net address groups using the ACL Assistant 
In ACL Management, a Net Address Group is mnemonic for one or more IP address/subnet mask 
combinations. Once you have created a Net Address Group in ACL Management using the ACL 
Assistant, you can specify it when configuring source or destination IP addresses and subnet 
masks in a template rule. 

Each Net Address Group is composed of a group name and a set of IP addresses and their subnet 
masks. For example, you can define a Net Address Group called NetMgmt and specify one or more 
of the IP addresses for your organization's network management subnets or servers and their subnet 
masks in the Net Address Group called NetMgmt. Once you have created the Net Address Group, 
you can specify its name in ACL resource when use an ACL template to create an ACL. 

Viewing the net address group list 

1. Navigate to Net Address Group List: 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click Assistant under ACL Management on the left navigation tree. 

d. Click Net Address Group List in the Assistant Management portion of the Service List 
page. 

The Net Address Group List page opens on the main pane of the page. 

Net address group list 

 Name—Contains the name of the Net Address Group.  

This field serves as a link for navigating to the View Network Address Group page for the 
associated Net Address Group. For more information about the View Network Address 
Group option, see "Viewing a network address group." 

 Description—Contains a description for the associated Net Address Group. 

 Modify—Contains a link  for modifying the associated Net Address Group. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure the number of items 
per page you want to view. 

You can sort the Net Address Group List by the Name and Description fields. Click the 
column label to sort the list by the selected field. The column label is a toggle switch that allows 
you to toggle between the various sort options specific to each field. 

Viewing a network address group 

1. Navigate to Net Address Group List. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click Assistant under ACL Management on the left navigation tree. 

d. Click Net Address Group List in the Assistant Management portion of the Service List 
page. 

The Net Address Group List page opens on the main pane of the page. 
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2. Click the Net Address Group name in the Name field. 

The View Network Address Group page opens. 

Network address group 

 Name—Contains the name of the Net Address Group. 

 Description—Contains a description for the associated Net Address Group. 

 IP Address/Mask List—Contains a list of all of the IP addresses and their subnet masks in the 
Net Address Group. 

Adding a network address group 

1. Navigate to Net Address Group List. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click Assistant under ACL Management on the left navigation tree. 

d. Click Net Address Group List in the Assistant Management portion of the Service List 
page. 

The Net Address Group List page opens on the main pane of the page. 

2. Click Add. 

The Add Network Address Group page opens. 

3. Enter a name for the Net Address Group in the Name field.  

A valid length is 1-32 characters. A Net Address Group name cannot begin with a number. 

4. Enter a brief description for the Network Address Group in the Description field. 

5. Enter an IP address/subnet mask combination in the IP Address/Mask field.  

The subnet mask must be entered using either CIDR or dotted decimal notation. A valid IP 
address/subnet mask using dotted decimal notation would be 192.168.1.0/255.255.255.0 

A valid IP address/subnet mask using CIDR would be 192.168.1.0/24 

6. Click Add. 

7. Do one of the following: 

 To add more than one IP address/subnet mask combinations, repeat step 5-6. 

 To remove an IP address/subnet mask combination, select the Net Address Group and 
click Delete. 

 To remove all IP address/subnet mask combinations in the list, click Delete All. 

8. Click OK to create the Net Address Group. 

Once you have created a Net Address Group, you can enter it in the Variable Address field of 
a rule configuration when creating an ACL template. For more information about using a Net 
Address Group when defining a rule in an ACL template, see "Creating ACL templates." 

Modifying a network address group 

1. Navigate to Net Address Group List. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click Assistant under ACL Management on the left navigation tree. 

d. Click Net Address Group List in the Assistant Management portion of the Service List 
page. 

The Net Address Group List page opens on the main pane of the page. 

2. Click the Modify icon  in the Modify field associated with the Net Address Group you want 
to modify. 

The Modify Network Address Group page opens. 
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You cannot modify the name of a Net Address Group once it has been created. 

3. Modify the description for the Net Address Group in the Description field. 

4. To add a new IP address/subnet mask combination, enter it in the IP Address/Mask field.  

The subnet mask must be entered using either CIDR or dotted decimal notation. A valid IP 
address/subnet mask using dotted decimal notation would be 192.168.1.0/255.255.255.0. 

A valid IP address/subnet mask using CIDR would be 192.168.1.0/24. 

5. Click Add. 

6. Do one of the following: 

 To add more than one IP address/subnet mask combinations, repeat steps 4-5. 

 To remove an IP address/subnet mask combination, select the IP address/subnet mask 
combination and click Delete. 

 To remove all IP address/subnet mask combinations in the list, click Delete All. 

7. Click OK to modify the Net Address Group. 

Once you have created or modified a Net Address Group, you can enter it in the Variable 
Address field of a rule configuration when creating an ACL template. For more information 
about using a Net Address Group when defining a rule in an ACL template, see "Creating ACL 
templates." 

Deleting a network address group 

1. Navigate to Net Address Group List. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click Assistant under ACL Management on the left navigation tree. 

d. Click Net Address Group List in the Assistant Management portion of the Service List 
page. 

The Net Address Group List page opens on the main pane of the page. 

2. Select the network address groups you want to delete. 

3. Click Delete. 

4. Click OK to confirm the deletion of the selected network address groups. 

Managing time ranges using the ACL Assistant 
In ACL Management, a Time Range is a mnemonic for a time range definition that you can apply to 
a rule in an ACL template. Once you have created a time range using the ACL Assistant, you can 
use this named time range when configuring the time range for a rule. 

Each time range is comprised of a name, a description and a starting and ending date and time. For 
example, you can define a time range called "workweek" and specify the days Monday through 
Friday. Once you have created the named time range, you can specify its name in the Time Range 
field of an ACL template rule configuration. 

Viewing the time range list 

1. Navigate to Time Range List. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click Assistant under ACL Management on the left navigation tree. 

d. Click Time Range List in the Assistant Management portion of the Service List page. 

The Time Range List is displayed on the main pane of the page. 

Time Range List 
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 Name—Contains the name of the time range. This field serves as a link for navigating to the 
View Time Range page for the associated time range. For more information about the View 
Time Range option, see "Viewing the time range list." 

 Description—Contains a description for the associated time range. 

 Modify—Contains a link for modifying the associated time range. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

You can sort the Time Range List by the Name and Description fields. Click the column label 
to sort the list by the select field. The column label is a toggle switch that allows you to toggle 
between the various sort options specific to each field. 

Viewing a time range 

1. Navigate to Time Range List. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click Assistant under ACL Management on the left navigation tree. 

d. Click Time Range List in the Assistant Management portion of the Service List page. 

The Time Range List is displayed on the main pane of the page. 

2. Click the Time Range name in the Name field for the time range for which you want to view 
individual details. 

The View Time Range page opens. 

Time Range list 

 Name—Contains the name assigned to this time range. 

 Description—Contains a description for the associated time range. 

 Start Time—Contains the date and time stamp for the time at which the rule configured with 
this time range takes effect. 

 End Time—Contains the date and time stamp for the time at which the rule configured with this 
time range is no longer in effect. 

 Type—Identifies the type of time range. There are two types of time ranges, Fixed and Cyclic. 

 Execution Period—For Cyclic time ranges, identifies the recurring days during which the time 
range is in effect. If the time range is Fixed, this field is empty. 

Adding a time range 

1. Navigate to Time Range List. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click Assistant under ACL Management on the left navigation tree. 

d. Click Time Range List in the Assistant Management portion of the Service List page. 

The Time Range List is displayed on the main pane of the page. 

2. Click Add. 

The Add Time Range page opens. 

3. Enter a name for the Time Range in the Name field.  

A valid length is 1–32 characters. The name must begin with a letter (A-Z, a-z). Spaces and 
question marks are not permitted in a Time Range name. 

4. Enter a brief description for the time range in the Description field. 

5. Click Add to enter the time range. 

The Add Time Range dialog box opens. 
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6. Select the type of time range you want to create by selecting the desired time range type: 

 Fixed—If you want to identify a specific and finite start and end date and time. 

 Cyclic—If you want the time range to recur for select days of the week. 

7. See "Configuring fixed time ranges" to configure fixed time ranges and "Configuring cyclic time 
ranges" to configure cyclic time ranges. 

Configuring fixed time ranges 

1. Do one of the following to populate the start time field: 

a. Enter the start time for the time range in the From field.  

A valid format for date and time is YYYY-MM-DD hh:mm where YYYY refers to the four-digit 
year, MM refers two-digit month, DD refers to the two-digit day, hh refers to the two-digit 
hour, and mm refers to the two-digit minute values. 

b. Click the Calendar icon  located to the right.  

A popup calendar is displayed. 

Select the start date from the calendar.  

Enter the time in the Time fields provided below the calendar. 

2. Do one of the following to populate the end time field: 

Enter the end time for the time range in the To field. 

A valid format for date and time is YYYY-MM-DD hh:mm where YYYY refers to the four-digit 
year, MM refers two-digit month, DD refers to the two-digit day, hh refers to the two-digit hour, 
and mm refers to the two-digit minute values. 

Click the Calendar icon  located to the right.  

A popup calendar is displayed. 

Select the end date from the calendar. 

Enter the time in the Time fields provided below the calendar. 

3. Click OK. 

4. To add more Fixed time ranges, repeat steps 1-3 for each time range you want to add. 

Configuring cyclic time ranges 

1. If you select Cyclic as the time range type, select from the following: 

 All Time—Includes every day of the week. 

 Workday—Includes days of the work week only, which includes Monday, Tuesday, 
Wednesday, Thursday, and Friday. 

 Weekend—Excludes days of the work week and includes the weekend days only, Saturday 
and Sunday. 

 Customizing Time—Allows you to select one or more days of the week, by selecting each 
day. 

2. Enter the start time for the time range in the From field. 

A valid format for time is hh:mm where hh refers to the two-digit hour and mm refers to the 
two-digit minute values. 

3. Enter the end time for the time range in the To field.  

A valid format for time is hh:mm where hh refers to the two-digit hour and mm refers to the 
two-digit minute values. 

4. Click OK. 

5. To add more Cyclic time ranges, repeat steps 1-4 for each time range you want to add. 

Up to twelve time periods are allowed for Fixed time ranges. Thirty-two time periods are 
permitted for Cyclic time ranges. 

6. To remove a time range, do one of the following: 
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To remove a time range, select the time range name and click Delete. 

To delete all time ranges, select the Start Time and click Delete. 

7. Click OK to create the Time Range. 

Once you have created a Time Range, you can enter it in the Time Range field of a rule 
configuration when creating an ACL template. For more information about using a Time Range 
when defining a rule in an ACL template, see "Creating ACL templates." 

Modifying time range 

1. Navigate to Time Range List. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click Assistant under ACL Management on the left navigation tree. 

d. Click Time Range List in the Assistant Management portion of the Service List page. 

The Time Range List is displayed on the main pane of the page. 

2. Click the Modify icon  for the Time Range you want to modify. 

The Modify Time Range page opens. 

You cannot modify the name of a Time Range once it has been created. 

3. Modify the description for the time range as needed in the Description field. 

4. To add a new time range to the existing list, click Add. 

The Add Time Range dialog box opens. 

5. Do one of the following: 

 Select Fixed if you want to identify a specific and finite start and end date and time. 

 Select Cyclic if you want the time range to recur for select days of the week. 

6. See "Configuring fixed time ranges" to configure fixed time ranges and "Configuring cyclic time 
ranges" to configure cyclic time ranges. 

Deleting a time range 

1. Navigate to Time Range List. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click Assistant under ACL Management on the left navigation tree. 

d. Click Time Range List in the Assistant Management portion of the Service List page. 

The Time Range List is displayed on the main pane of the page. 

2. Select the Time Ranges you want to delete. 

3. Click Delete. 

4. Click OK to confirm the deletion of the selected Time Ranges. 

Configuring subnet mask type for ACL management 
In ACL Management, the subnet mask inversion function allows you to identify an IP subnet by 
entering an IP address and a subnet mask. ACL Management automatically inverts the subnet 
mask into a wildcard mask when applying the ACL configuration to devices. You can select subnet 
mask types as needed, including Enable Subnet Mask Inversion and Enable Wildcard Mask. 

To configure subnet mask type for ACL management: 

1. Click the Service tab from the top tabular navigation system. 

2. Click ACL Management on the left navigation tree. 

3. Click Options under ACL Management on the left navigation tree. 
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4. Select Enable Subnet Mask Inversion or Enable Wildcard Mask. By default, the Enable 
Wildcard Mask option is selected. 

 Enable Subnet Mask Inversion—When this option is selected, ACL management inverts 
the wildcards configured on devices into subnet masks for display in IMC. During device 
configuration, ACL management inverts an input subnet mask into a wildcard mask. The 
subnet mask is a 32-bit binary represented in dotted decimal notation, where the 1 bits 
represent do care bits and the 0 bits represent don't care bits. 

 Enable Wildcard Mask—When this option is selected, ACL management displays 
wildcards as configured on the device in IMC. During device configuration, ACL 
management applies the mask specified during ACL configuration as is, without inversion. 
Also called represent do care bits, and the 1 bits represent don't care bits. 

After you change the options, go to the ACL device page to synchronize ACL devices. 

5. Click OK. 

Managing ACL templates in IMC 
ACL Templates in ACL Management are a container for the configuration options required to 
create an ACL or to maintain the template. The ACL template contains configuration and can be 
imported into an ACL resource. Resources are ACLs that contain one or more rule sets and can be 
deployed to devices managed by IMC that support ACLs. 

Rules, which are grouped to form rule sets, are the core of an ACL. A rule contains conditions that 
define whether or not traffic is forwarded by a device. A rule includes a rule number, the action that is 
to be taken in the rule, whether traffic is permitted or denied, and a pattern for matching against the 
contents of every packet to determine whether or not the packet is forwarded. The pattern to match 
can be an IP or MAC address, range of addresses and their masks, or a Layer 4 port number, or a 
hexadecimal string and an offset value that identifies where in the packet to begin the pattern 
matching. Rules may also include identification of the protocol or type of traffic for the action to be 
taken and for protocol specific configuration options. Rules can also include time ranges and options 
specific to the protocol identified in the rule or the type of ACL and rule. 

There are four types of ACLs that can be created in IMC and four types of templates: 

 Basic—Allows you to create rules based on source IP addresses. 

 Advanced—Allows you to create rules based on Layer 3 and Layer 4 information including IP 
source and destination addresses, TCP and UDP port information, and protocol specific 
options. 

 Link—Allows you to create rules based on Layer 2 information including MAC source and 
destination addresses, VLAN priority information as well as link layer protocol type. 

 User-Defined—Allows you to define a hexadecimal pattern and mask and the offset in the 
packet header where pattern matching begins. When a pattern is matched, the actions 
specified in the rule in the ACL template are applied. A valid numeric range for assigning ACL 
Identifiers to user-defined ACLs is 5000-5999. 

Creating templates in ACL management 
To create templates in ACL Management: 

1. Define the Services, Net Address Groups, and Time Ranges using the Assistant in the 
configuration ACL templates. 

2. Create an ACL template using the Services, Net Address Groups, and Time Ranges created 
in the Assistant to configure many of the template's options, including rule sets in the template. 

3. Modify options, copy templates, import into an existing ACL. 

4. Deploy to one or more devices using the ACL Deployment wizard. 
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Viewing ACL templates 
The ACL Management provides you with a single portal for accessing all ACL templates. From the 
Template List, you can view a list of all ACL templates as well as navigate to the View Template 
page for viewing detailed information for each ACL template. From this page, you can navigate to the 
View Rule page for viewing detailed information for every rule in an ACL template. 

Viewing the template list 

1. Navigate to ACL Template. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Template under ACL Management on the left navigation tree. 

The Template List is displayed on the main pane of the page. 

2. To filter the Template List by template type, select the template type you want to filter for from 
the Template Type list located in the upper right corner of the Template List. 

Template list 

 Template Name—Contains the name for the ACL template. The template name serves as a 
link for navigating to the View Template page for the associated template. For more 
information about the viewing the details of a template, see "Viewing ACL templates." 

 Type—Contains the ACL template type for the associated template. There are four types of 
templates in IMC: Basic, Advanced, Link, or User-Defined. 

 Template Description—Contains a description for the associated template. 

 Match Order—Contains the match order type for the associated Rule. The Match Order 
can either be Config or Auto. 

 Modify—Contains a link  for modifying the associated ACL. 

 Copy—Contains a link  for copying the associated ACL. 

 Export—Contains a link  for exporting the associated ACL. 

If the Template List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Template List. 

 Click  to page forward to the end of the Template List. 

 Click  to page backward in the Template List. 

 Click  to page backward to the front of the Template List. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

You can sort the Template List by the Template Name, Type, Template Description and 
Match Order fields. Click the column label to sort the list by the selected field. The column label 
is a toggle switch that allows you to toggle between the various sort options specific to each 
field. 

Viewing an ACL template 

1. Navigate to ACL Template. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Template under ACL Management on the left navigation tree. 
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The Template List is displayed on the main pane of the page. 

2. Click the name in the Template Name field. 

The View Template page opens. The content of the page varies based on the template style. 

Basic info 

 Template Name—Contains the name for the ACL template. 

 Type—Contains the ACL template type for the associated template. There are four types of 
templates in IMC—Basic, Advanced, Link, or User-Defined. 

 Match Order—Contains the match order type for the associated rule. The Match Order can 
either be Config or Auto. 

 Template Description—Contains a description for the associated template. 

Rule maintenance field names and explanations 

 No.—Contains the sequence or rule number for the associated rule in the Rule Set. The value 
in the sequence field serves as a link for navigating to the View Rule page for the associated 
rule. This page displays rule configuration information for the associated rule. For more 
information about viewing rule information, see "Viewing ACL templates." 

 Action—Contains the access control action specified in the associated rule. Actions include 
permit and deny. 

 Time Range—Contains the name assigned to the Time Range specified for the associated 
rule. 

 Source Address—Contains the source address specified in the associated rule for which the 
action is taken. For example, if the action is to permit IP traffic, this field identifies the source IP 
address from which IP traffic is permitted. Source Address is available for basic and advanced 
ACL templates. 

 Protocol—Contains the protocol specified in the associated rule for which the action is taken. 
Protocol is available for advanced ACL templates. 

 Destination Address—Contains the destination address specified in the associated rule for 
which the action is taken. For example, if the action is to permit IP traffic, this field identifies the 
destination IP address to which IP traffic is permitted. Destination Address is available for 
advanced ACL templates. 

 Source Mac Addr—Contains the source MAC address specified in the associated rule for 
which the action is taken. For example, if the action is to permit traffic, this field identifies the 
source MAC address from which traffic is permitted. Source Mac Addr is available for link ACL 
templates. 

 Destination Mac Addr—Contains the destination MAC address specified in the associated 
rule for which the action is taken. For example, if the action is to permit traffic, this field identifies 
the destination MAC address from which traffic is permitted. Destination Mac Addr is available 
for link ACL templates. 

 Matching String—Contains the hexadecimal string to be matched in a packet, the mask, and 
the offset values for a user-defined pattern-matching rule. Matching String is available for 
user-defined ACL templates. 

Creating ACL templates 
ACL templates enable you to create containers for the configuration options of an ACL. ACLs contain 
rules sets and other ACL attributes that define whether or not packets are forwarded or dropped by 
network devices. Once a template is created, you can import templates into existing ACLs for 
simplifying the process of ACL creation and management. Once an ACL has been created in ACL 
Management, it can then be deployed to one or more devices using the ACL Deployment wizard. 
For more information, see "Managing ACL templates in IMC." 
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Creating a basic ACL template 

Basic ACLs enable you to create one or more rules based on source IP addresses and subnet 
masks. A valid numeric range for assigning ACL Identifiers to basic ACLs is 1-99, 1300-1999, or 
2000-2999. 

To create a basic ACL template: 

1. Navigate to ACL Template. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Template under ACL Management on the left navigation tree. 

The Template List is displayed on the main pane of the page. 

2. Click Add. 

3. Enter the name for the template in the Template Name field.  

A valid length for a template name is 1-32 characters. A template name cannot begin with a 
number or a space. 

4. Select a Type field to define the type of ACL template to create. 

Options include Basic, Advanced, Link, and User-Defined. Select Basic from the Type list. 

5. Select the match order you want to apply to this ACL template by selecting the Match Order 
option you want to use. Options include Config and Auto. 

If you select Config, IMC matches rules in the order in which they were configured. This feature 
works only for the devices that support it. If you select Auto, IMC matches rules based on the 
principle of depth priority. 

6. Enter a brief description for this ACL template in the Template Description field. 

7. Select Self-Define Rule ID to enter a rule ID when adding a rule, or clear the option so the 
system automatically assigns a rule ID. 

8. Click Add Rule to add a rule to the ACL template. 

The Add Basic Rule page opens. 

9. Select the action you want to take by selecting the option you want to apply to this rule: 

 Select permit if, upon matching the specified conditions, the packet should be forwarded. 

 Select deny if, upon matching the specified conditions, the packet should be discarded. 

10. Enter a named variable for this ACL template in the Time Range field which allows you to 
create a named variable without requiring you enter the time range in the template. 

The named variable then serves as a placeholder for Time Range you created using the 
Assistant combination when you import the template as a rule set into an existing ACL. 

11. Select the source IP address option you want to use by selecting the desired option in the 
Source Address field of the Basic Info. 

This option specifies where the pattern matching occurs in this template rule. In this case, the 
pattern matching is applied to the source IP address. 

Options include: 

 All—Allows you to permit or deny traffic from all IP addresses. 

 IP Address/Mask—Allows you to enter a specific IP address and its subnet mask for which 
you want to either permit or deny traffic. 

a. Enter an IP address/subnet mask combination in the IP Address/Mask field. 

The subnet must be entered using either CIDR or dotted decimal notation. A valid IP 
address/subnet mask using dotted decimal notation would be  
192.168.1.0/255.255.255.0  

A valid IP address/subnet mask using CIDR would be 
192.168.1.0/24  
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A forward slash "/" must be used to separate the IP address from the subnet mask. 

Variable Address—Allows you to create a named variable without requiring you to enter 
the IP addresses/subnet masks in the template. The named variable then serves as a 
placeholder for the Net Address Group you created using the Assistant combination 
when you import the template as a rule set into an existing ACL. 

b. Enter a name for this variable in the field to the right. 

12. Do one of the following: 

 Select Yes in the Fragment option if you want to apply the rule to each fragment, or 

select No in the Fragment option if you want to apply the rule to first fragments. 

Traditional packet filtering matched only first fragments of IPv4 packets and allowed all 
subsequent non-first fragments to pass through. This resulted in security risks as hackers can 
fabricate non-first fragments to attack networks. 

13. Select Yes in the Logging option if you want to enable logging for this rule. 

This feature enables the logging of packet filtering only when a module (for example, a firewall) 
using the ACL supports logging. 

14. Enter the VPN instance you want to apply to this rule by entering the VPN-instance-name in the 
VPN Instance field. 

A valid entry must be 0-31 characters that cannot contain question marks or blank spaces. This 
field is case sensitive. If no VPN instance is specified in this field, the rule applies only to 
non-VPN packets. 

15. Click OK to create the rule you have just configured. 

16. Do one of the following: 

 To add more rules to the ACL template, repeat steps 7-17. 

 To delete one or more rules from the ACL template, select the sequence number of the rules 
you want to delete and click Delete located above the rule table. Click OK to confirm the 
deletion of the select rules. 

 To modify the rules you have already created, click the Modify icon associated with the 
rule sequence you want to modify. For more information about modifying a rule set, see 
"Managing the rules in a rule set." 

 To copy rules you have already created, click the Copy icon  associated with the rule 
sequence you want to copy. For more information about copying a rule set, see "Copying a 
rule in a template." 

Rules that belong to a rule set that is configured with a Match Order of 'Config' are executed in 
the order in which they are displayed in the rule set. 

If Self-Define Rule ID is not selected, the order in which rules are displayed in a rule set is 
initially defined by the order in which they are created. You can reorder the rules in a rule set 
using the Sort feature. For more information about using Sort to redefine the order of 
appearance of rules in a rule set, see "Using sort to reorder the rules in an ACL rules set." 

17. Click OK to create the ACL template. 

Once you have created an ACL template, you can import the template into one or more ACLs. 
For more information about importing into ACLs, see "Importing rule sets." 

Creating an advanced ACL template 

Advanced ACLs enable you to define rules based on Layer three and Layer four information 
including IP source and destination addresses, protocol and TCP and UDP port information, as well 
as protocol specific features. A valid numeric range for assigning ACL Identifiers to Advanced ACLs 
is 100-199, 2000-2699, or 3000-3999. 

To create an advanced ACL template: 

1. Navigate to ACL Template. 

a. Click the Service tab from the top tabular navigation system. 
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b. Click ACL Management on the left navigation tree. 

c. Click ACL Template under ACL Management on the left navigation tree. 

The Template List is displayed on the main pane of the page. 

2. Click Add. 

3. Enter the name for the template in the Template Name field.  

A valid length for a template name is 1–32 characters. A template name cannot begin with a 
number or a space. 

4. Select the Type field to define the type of ACL template you want to create. 

Options include: 

 Basic 

 Advanced 

 Link 

 User-Defined 

Select Advanced from the Type list. 

If you change the type, the added rules are deleted. 

5. Select the match order you want to apply to this ACL template by selecting the Match Order 
option you want to use. Options include Config and Auto. 

 If you select Config, IMC matches rules in the order in which they were configured. 

 If you select Auto, IMC matches rules based on the principle of depth priority. 

This feature works only for devices that support it. 

6. Enter a brief description for this ACL template in the Template Description field.  

7. Select Self-Define Rule ID to enter a rule ID when adding a rule, or clear the option so the 
system automatically assigns a rule ID. 

8. Click Add Rule to add a rule to the ACL template. 

The Add Advanced Rule page opens. 

9. Select the protocol for which you want to permit or deny traffic from the Protocol list. 

10. Select the action you want to take by selecting the option you want to apply to this rule. 

 Select permit if, upon matching the specified conditions, the packet should be forwarded.  

 Select deny if, upon matching the specified conditions, the packet should be discarded. 

11. Enter a named variable for this ACL template in the Time Range field, allowing you to create a 
named variable without requiring you to enter the time range in the template. 

The named variable then serves as a placeholder for Time Range you created using the 
Assistant combination when you import the template as a rule set into an existing ACL. 

The string entered in the Time Range field must start with a letter and have a length of 1-32 
characters. Blank spaces ( ) and question marks (?) are not permitted. 

12. Select the source IP address option you want to use by selecting the desired option in the 
Source Address field in Basic Info. 

This option specifies where the pattern matching occurs in this template rule. In this case, the 
pattern matching is applied to the source IP address. 

 All—Allows you to permit or deny traffic for all IP addresses. 

 IP Address/Mask—Allows you to enter a specific IP address and its subnet mask for which 
you want to either permit or deny traffic. 

Enter an IP address/subnet mask combination in the field. 

The subnet mask must be entered in dotted decimal notation. A valid IP address/subnet 
mask using dotted decimal notation would be 
192.168.1.0/255.255.255.0  

A forward slash "/" must be used to separate the IP address from the subnet mask. 
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 Variable Address—Enter a name for this variable in the field to the right, allowing you to 
create a named variable without requiring you to enter the IP addresses/subnet masks in 
the template. The named variable then serves as a placeholder for Net Address Group 
you created using the Assistant combination when you import the template as a rule set 
into an existing ACL. 

13. Select the destination IP address option you want to use by selecting the desired option in the 
Destination Address field in Basic Info. 

This option specifies where the pattern matching occurs in this template rule. In this case, the 
pattern matching is applied to the destination IP address. 

 All—Allows you to permit or deny traffic for all IP addresses. 

 IP Address/Mask—Allows you to enter a specific IP address and its subnet mask for which 
you want to either permit or deny traffic. 

Enter an IP address/subnet mask combination in the IP Address/Mask field. 

This option specifies where the pattern matching occurs in this template rule. In this case, 
the pattern matching is applied to the destination IP address. 

The subnet mask must be entered in dotted decimal notation. A valid IP address/subnet 
mask using dotted decimal notation would be 
192.168.1.0/255.255.255.0  

A forward slash "/" must be used to separate the IP address from the subnet mask. 

 Variable Address—Enter a name for this variable in the field to the right, allowing you to 
create a named variable without requiring you to enter the IP addresses/subnet masks in 
the template. The named variable then serves as a placeholder for the Net Address Group 
you created using the Assistant combination when you imported the template as a rule set 
into an existing ACL. 

14. If you select tcp or udp as the protocol you want to apply this ACL rule to in step 8, you must 
also specify the source TCP or UDP port numbers, as follows: 

a. Select the source TCP or UDP port option by selecting the port option you want to apply in 
the Source Port field of the Advanced Settings. 

 Undefined—Allows you to permit or deny traffic for all TCP or UDP port numbers. 

 Specified Port—Allows you to identify a specific TCP or UDP port number or range of 
numbers. 

b. Select Specified Port and select the operator you want to use from the list next to the 
Specified Port option. 

c. Enter the TCP or UDP port number in the Port field. 

 Variable Port—Enter a name for this variable in the field to the right. This option allows 
you to create a named variable without requiring you to enter the port in the template. 
The named variable then serves as a placeholder for the Service you are creating using 
the Assistant combination when you import the template as a rule set into an existing 
ACL. 

15. If you select tcp or udp as the protocol you want to apply this ACL rule to in step 8, you must 
also specify the destination TCP or UDP port numbers, as follows: 

a. Select the destination TCP or UDP port option by selecting the port option you want to apply 
in the Destination Port field of the Advanced Settings of the page. 

 Undefined—This option allows you to permit or deny traffic for all TCP or UDP port 
numbers. 

 Specified Port—This option allows you to identify a specific TCP or UDP port number 
or range of numbers. 

b. Select Specified Port and select the operator you want to use from the list next to the 
Specified Port option. 

c. Enter the TCP or UDP port number in the Port field. 
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 Variable Port—Enter a name for this variable in the field to the right. This option allows 
you to create a named variable without requiring you to enter the port in the template. 
The named variable then serves as a placeholder for the Service you are creating using 
the Assistant combination when you import the template as a rule set into an existing 
ACL. 

16. If you select tcp or udp as the protocol you want to apply this ACL rule to in step 8, you may be 
promoted to select these options: 

 Select Yes in the HP ACK option if you want to apply the rule to match the TCP ACK, 
otherwise select No. 

 Select Yes in the HP FIN option if you want to apply the rule to match the TCP FIN, 
otherwise select No. 

 Select Yes in the HP RST option if you want to apply the rule to match the TCP RST, 
otherwise select No. 

 Select Yes in the HP SYN option if you want to apply the rule to match the TCP SYN, 
otherwise select No. 

The HP ACK, HP FIN, HP RST, and HP SYN settings are valid only for the HPE E series 
devices. 

17. Select the IP priority you want to apply to ACL template from the IP Priority list. 

18. Select the Type of Service for this ACL template from the ToS Value list.  

19. Select the DSCP value you want to apply to this ACL template from the DSCP Value list.  

20. Do one of the following: 

 Select Yes in the Fragment option if you want to apply the rule to each fragment, or 

 Select No in the Fragment option if you want to apply the rule first fragments. 

Traditional packet filtering matched only first fragments of IPv4 packets and allowed all 
subsequent non-first fragments to pass through. This resulted in security risks as hackers can 
fabricate non-first fragments to attack networks. 

21. Select Yes in the Logging option if you want to enable logging for this rule. 

This feature enables the logging of packet filtering only when a module (for example, a firewall) 
using the ACL supports logging. 

22. Enter the VPN instance you want to apply to this rule by entering the VPN-instance-name in the 
VPN Instance field. 

A valid entry must be 0–31 characters that cannot contain question marks or blank spaces. This 
field is case sensitive. If no VPN instance is specified in this field, the rule applies only to 
non-VPN packets. 

23. Click OK to create the rule you have just configured. 

24. Do one of the following to add more rules, delete, modify or copy existing rules: 

 To add more rules to the ACL template, repeat steps 7-21. 

 To delete one or more rules from the ACL template, select the No. of the rules you want to 
delete and click Delete located above the rule table. Click OK to confirm the deletion of the 
select rules. 

 To modify a rule you already created, click the Modify icon  associated with the rule 
sequence you want to modify. For more information about modifying a rule set, see 
"Modifying the rules in an ACL template." 

 To copy rules you have already created, click the Copy icon  associated with the rule 
sequence you want to copy. For more information about copying a rule set, see "Copying a 
rule in a template." 

Rules that belong to a rule set that is configured with a Match Order of 'Config' are executed in 
the order in which they are displayed in the rule set. If Self-Define Rule ID is not selected, the 
order in which rules are displayed in a rule set is initially defined by the order in which they are 
created. You can reorder the rules in a rule set using the Sort feature. For more information 
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about using Sort to redefine the order of appearance of rules in a rule set, see "Using sort to 
reorder the rules in an ACL rules set." 

25. Click OK to create the ACL template. 

Once you have created an ACL template, you are ready to import the template into one or more 
ACLs. For more information about importing into ACLs, see "Importing rule sets." 

Creating a link ACL template 

Link ACLs enable you to define rules based on Layer 2 information including MAC source and 
destination addresses and masks, VLAN priority information, as well as link layer protocol type. A 
valid numeric range for assigning ACL Identifiers to Link ACLs is 4000-4999. 

To create a link ACL template: 

1. Navigate to ACL Template. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Template under ACL Management on the left navigation tree. 

The Template List is displayed on the main pane of the page. 

2. Click Add. 

3. Enter the name for the template in the Template Name field.  

A valid length for a template name is 1–32 characters. A template name cannot begin with a 
number or a space. 

4. Select one of the options in the Type field list to define the type of ACL template you want to 
create.  

If you change the type, the added rules are deleted. 

5. Select the match order you want to apply to this ACL template by selecting the Match Order 
option you want to use. 

 If you select Config, IMC matches rules in the order in which they were configured. This 
feature works only for devices that support it. 

 If you select Auto, IMC matches the rule based on the principle of depth priority. 

6. Enter a brief description for this ACL template in the Template field. 

7. Select Self-Define Rule ID to enter a rule ID when adding a rule, or clear the option so the 
system automatically assigns a rule ID.  

8. Click Add Rule to add a rule to the ACL template. 

The Add Link Rule page opens. 

9. Select the action you want to take by selecting the option you want to apply to this rule. 

 Select permit if, upon matching the specified conditions, the packet should be forwarded.  

 Select deny if, upon matching the specified conditions, the packet should be discarded. 

10. Enter a named variable for this ACL template in the Time Range field, allowing you to create a 
named variable without requiring you to enter the Time Range in the template. 

The named variable then serves as a placeholder for Time Range you created using the 
Assistant combination when you import the template as a rule set into an existing ACL. 

11. Select the source MAC address option you want to use by selecting the desired option in the 
Source MAC Addr field of the Basic Info. 

This option specifies where the pattern matching occurs in this template rule. In this case, the 
pattern matching is applied to the source MAC address. 

 All—Allows you to permit or deny traffic for all MAC addresses. 

 MAC Address/Mask—Allows you to enter a specific MAC address and mask for which you 
want to either permit or deny traffic. 
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A Valid MAC address format for IMC consists of three sets of four hexadecimal characters 
separated by a dash, "-". For example: 
0014-2ad9-05f7  

would be a valid entry for a MAC address in IMC. 

Similarly, the format for a MAC address mask consists of three sets of four hexadecimal 
characters separated by a dash, "-". For example: 
ffff-ffff-ffff  

would be a valid entry for a MAC address mask in IMC. 

The MAC address and its mask must be separated by a forward slash, "/". 

A valid entry for a MAC Address/Mask would be: 
0014-2ad9-057f/ffff-fff-ffff  

 Variable Address—Enter a name for this variable in the field to the right, allowing you to 
create a named variable without requiring you to enter the MAC addresses/masks in the 
template. The named variable then serves as a placeholder for entering a MAC 
address/mask combination when you import the template as a rule set into an existing ACL. 

12. Select the destination MAC address option you want to use by selecting the desired option in 
the Destination MAC Address field of the Basic Info. 

This option specifies where the pattern matching occurs in this template rule. In this case, the 
pattern matching is applied to the source MAC address. 

 All—Allows you to permit or deny traffic for all MAC addresses. 

 MAC Address/Mask—Allows you to identify a specific MAC address and mask for which 
you want to either permit or deny traffic. 

A valid MAC address format for IMC consists of three sets of four hexadecimal characters 
separated by a dash, "-". For example, 
0014-2ad9-05f7  

would be a valid entry for a MAC address in IMC. 

Similarly, the format for a MAC address mask consists of three sets of four hexadecimal 
characters separated by a dash, "-". For example, 
ffff-ffff-ffff  

would be a valid entry for a MAC address mask in IMC. 

The MAC address and its mask must be separated by a forward slash, "/". 

A valid entry for a MAC Address/Mask would be 
0014-2ad9-05f7/ffff-ffff-ffff  

 Variable Address—Enter a name for this variable in the field to the right allowing you to 
create a named variable without requiring you to enter the MAC addresses/masks in the 
template. The named variable then serves as a placeholder for entering a MAC 
address/mask combination when you import the template as a rule set into an existing ACL. 

13. Select the 802.1 priority you want to apply to this ACL rule from the 802.1 Priority list. 

14. Select the Layer 2 encapsulation type you want to apply to this ACL rule from the 
Encapsulation Type list. 

15. Enter the Source VLAN ID by entering it in the Source VLAN ID field. 

This field cannot contain question marks (?) or spaces ( ). 

16. Select the Layer 2 frame type from the Based Frame Type list. 

17. If you select Ethernet Frame or 802.2 Ethernet Frame in the Base Frame Type list, you must 
specify a code in the Code field. 

A valid entry for this field includes any four character hexadecimal value. 

18. If you select Ethernet Frame or 802.2 Ethernet Frame in the Base Frame Type list, you must 
also specify a mask in the Mask field. 

A valid entry for this field includes any four character hexadecimal value. 
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19. Click OK to create the rule you have just configured. 

20. To add more rules, delete, modify, or copy existing rules, do one of the following: 

 To add more rules to the ACL template, repeat steps 7-18. 

 To delete one or more rules from the ACL template, select the No. of the rules you want to 
delete, click Delete located above the rule table and then OK to confirm the deletion of the 
select rules. 

 To modify rules you have already created, click the Modify icon  associated with the rule 
sequence you want to modify. For more information about modifying a rule set, see 
"Managing the rules in a rule set."  

 To copy rules you have already created, click the Copy icon  associated with the rule 
sequence you want to copy. For more information about copying a rule set, see "Copying a 
rule in an ACL rule set." 

Rules that belong to a rule set that is configured with a Match Order of 'Config' are executed in 
the order in which they are displayed in the rule set. If Self-Define Rule ID is not selected, the 
order in which rules are displayed in a rule set is initially defined by the order in which they are 
created. You can reorder the rules in a rule set using the Sort feature. For more information 
about using Sort to redefine the order of appearance of rules in a rule set, see "Using sort to 
reorder the rules in an ACL rules set." 

21. Click OK to create the ACL template. 

Once you have created an ACL template, you are ready to import the template into one or more 
ACLs. For more information about importing into ACLs, see "Importing rule sets." 

Creating a user-defined ACL template 

User-Defined ACLs enable you to define a hexadecimal pattern and mask and the offset in the 
packet header to begin the pattern matching. When a pattern is matched, the conditions of the rule in 
the ACL template are applied. A valid numeric range for assigning ACL Identifiers to user-defined 
ACLs is 5000-5999. 

To create a user-defined ACL template: 

1. Navigate to ACL Template. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Template under ACL Management on the left navigation tree. 

The Template List is displayed on the main pane of the page. 

2. Click Add. 

3. Enter the name for the template in the Template Name field. 

A valid length for a template name is 1–32 characters. A template name cannot begin with a 
number or a space. 

4. Select User-Defined from the Type list to define the type of ACL template you want to create.  

A User-Defined template can only have a Match Order of Config. 

5. Enter a brief description for this ACL template in the Template Description field. 

6. Select Self-Define Rule ID to enter a rule ID when adding a rule, or clear the option so the 
system automatically assigns a rule ID. 

7. Click Add Rule to add a rule to the ACL template. 

The Add User-Defined Rule page opens. 

8. Select the action you want to take by selecting the option you want to apply to this rule: 

 Select permit if, upon matching the specified conditions, the packet should be forwarded.  

 Select deny if, upon matching the specified conditions, the packet should be discarded. 
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9. Enter a named variable for this ACL template in the Time Range field, allowing you to create a 
named variable without requiring you enter the Time Range in the template. 

The named variable then serves as a placeholder for Time Range you created using the 
Assistant combination when you import the template as a rule set into an existing ACL. 

10. Enter up to eight hexadecimal patterns, masks, and offsets for matching the contents of a 
packet and applying the actions specified in the rule when a hexadecimal pattern is matched. 

The following rules and guidelines apply to constructing a valid hexadecimal string, mask, and 
offset value: 

 A rule string must be expressed in hexadecimal only. 

 A mask must be expressed in hexadecimal only. 

 A rule string length must be equal to its mask length. 

 Rule string and mask length must be in multiples of 2. 

 The minimum length of a rule string and mask is 2. 

 The maximum length of a rule string and mask is 160. 

 Offsets must be expressed as a decimal integer. 

 Offset range varies by the mask length. 

 The minimum value for an offset is 0. 

 The maximum value for an offset is 79. 

 The offset must increase progressively. 

a. Enter a hexadecimal pattern to be matched in the Rule String field. 

b. Enter a mask in the Mask field. 

c. Enter the offset in the Excursion field. 

d. Enter up to eight Rule String/Mask/Excursion combinations. 

11. Click OK to create the rule you have just configured. 

12. To add more rules, delete, modify, or copy an existing rule, do one of the following: 

 To add more rules to the ACL template, repeat steps 7-10. 

 To delete one or more rules from the ACL template, select the No. of the rules you want to 
delete, click Delete located above the rule table, and click OK to confirm the deletion of the 
select rules. 

 To modify rules you have already created, click the Modify icon  associated with the rule 
sequence you want to modify. For more information about modifying a rule set, see 
"Managing the rules in a rule set." 

 To copy rules you have already created, click the Copy icon  associated with the rule 
sequence you want to copy. For more information about copying a rule set, see "Copying a 
rule in an ACL rule set." 

Rules that belong to a rule set that is configured with a Match Order of 'Config' are executed in 
the order in which they are displayed in the rule set. If Self-Define Rule ID is not selected, the 
order in which rules are displayed in a rule set is initially defined by the order in which they are 
created. You can reorder the rules in a rule set using the Sort feature. For more information 
about using Sort to redefine the order of appearance of rules in a rule set, see "Using sort to 
reorder the rules in an ACL rules set." 

13. Click OK to create the ACL template. 

Once you have created an ACL template, you are ready to import the template into one or more 
ACLs. For more information about importing into ACLs, see "Importing rule sets." 
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Modifying ACL templates 
Many of the parameters used to configure an ACL template can be changed using the modify option 
for each of the ACL template types. 

Modifying a basic ACL template 

1. Navigate to ACL Template. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Template under ACL Management on the left navigation tree. 

The Template List page opens. 

2. Click the Modify icon  for the template you want to modify. 

The Modify Template page opens. 

You cannot change the Template Name, template Type, or Match Order of an ACL template 
once you have created it. 

3. Modify the description for this ACL template as needed in the Template Description field. 

4. To add a new rule to the existing rule set, click Add Rule to add a rule to the ACL template. 

The Add Basic Rule page opens. 

5. Select the action you want to take by selecting the option you want to apply to this rule: 

 Select permit if, upon matching the specified conditions, the packet should be forwarded.  

 Select deny if, upon matching the specified conditions, the packet should be discarded. 

6. Enter a named variable for this ACL template in the Time Range field, allowing you to create a 
named variable without requiring you to enter the time range in the template. 

The named variable then serves as a placeholder for Time Range you created using the 
Assistant combination when you import the template as a rule set into an existing ACL. 

7. Select the source IP address option you want to use by selecting the desired option in the 
Source Address field in Basic Info. 

This option specifies where the pattern matching occurs in this template rule. In this case, the 
pattern matching is applied to the source IP address. 

 All—Allows you to permit or deny traffic for all IP addresses. 

 IP Address/Mask—Allows you to enter a specific IP address and its subnet mask for which 
you want to either permit or deny traffic. 

Enter an IP address/subnet mask combination in the IP Address/Mask field.  

The subnet mask must be entered in dotted decimal notation. A valid IP address/subnet 
mask using dotted decimal notation would be 
192.168.1.0/255.255.255.0  

A forward slash "/" must be used to separate the IP address from the subnet mask. 

 Variable Address—Allows you to create a named variable without requiring you to enter 
the IP addresses/masks in the template. The named variable then serves as a placeholder 
for Net Address Group you created using the Assistant combination when you import the 
template as a rule set into an existing ACL. 

Enter a name for this variable field to the right. 

8. Do one of the following: 

 Select Yes in the Fragment option if you want to apply the rule to each fragment. 

 Select No in the Fragment option if you want to apply the rule to first fragments. 

Traditional packet filtering matched only first fragments of IPv4 packets and allowed all 
subsequent non-first fragments to pass through. This resulted in security risks as hackers can 
fabricate non-first fragments to attack networks. 
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9. Select Yes in the Logging option if you want to enable logging for this rule. 

This feature enables the logging of packet filtering only when a module (for example, a firewall) 
is using the ACL support logging. 

10. Enter the VPN instance you want to apply to this rule by entering the VPN-instance-name in the 
VPN Instance field. 

A valid entry must be 0-31 characters and cannot contain question marks or blank spaces. This 
field is also case sensitive. If no VPN instance is specified in this field, the rule applies only to 
non-VPN packets. 

11. Click OK to create the rule you have just configured. 

12. Select from the following options to add more rules, delete, modify, or copy existing rules. 

 To add more rules to the ACL template, repeat steps 4-11. 

 To delete one or more rules from the ACL template, select the No. of the rules you want to 
delete, click Delete located above the rule table and then click OK to confirm the deletion of 
the select rules. 

 To modify rules you have already created, click the Modify icon  associated with the rule 
sequence you want to modify. For more information about modifying a rule set, see 
"Managing the rules in a rule set." 

 To copy rules you have already created, click the Copy icon  associated with the rule 
sequence you want to copy. For more information about copying a rule set, see "Copying a 
rule in an ACL rule set." 

Rules that belong to a rule set that is configured with a Match Order of 'Config' are executed in 
the order in which they are displayed in the rule set. The order in which rules are displayed in a 
rule set is initially defined by the order in which they are created. You can reorder the rules in a 
rule set using the Sort feature. For more information about using Sort to redefine the order of 
appearance of rules in a rule set, see "Using sort to reorder the rules in an ACL rules set." 

13. Click OK to accept your modifications to the ACL template. 

Once you finished modifying an ACL template, you can import the template into one or more 
ACLs. For more information about importing into ACLs, see "Importing rule sets." 

Modifying an advanced ACL template 

1. Navigate to ACL Template. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Template under ACL Management on the left navigation tree. 

The Template List page opens. 

2. Click the Modify icon  for the template you want to modify. 

The Modify Template page opens. 

You cannot change the Template Name, template Type, or Match Order of an ACL template 
once you have created it. 

3. Modify the description for this ACL template as needed in the Template Description field. 

4. To add a new rule to the existing rule set, click Add Rule to add a rule to the ACL template. 

The Add Advanced Rule page opens. 

5. Select the protocol for which you want to permit or deny traffic from the Protocol list. 

6. Select the action you want to take by selecting the option you want to apply to this rule. 

 Select permit if, upon matching the specified conditions, the packet should be forwarded.  

 Select deny if, upon matching the specified conditions, the packet should be discarded. 

7. Enter a named variable for this ACL template in the Time Range field, allowing you to create a 
named variable without requiring you enter the time range in the template. The named variable 
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then serves as a placeholder for Time Range you created using the Assistant combination 
when you import the template as a rule set into an existing ACL. 

8. Select the source IP address option you want to use by selecting the desired option in the 
Source Address field in Basic Info. 

This option specifies where the pattern matching occurs in this template rule. In this case, the 
pattern matching is applied to the source IP address. 

 All—Allows you to permit or deny traffic for all IP addresses. 

 IP Address/Mask—Allows you to enter a specific IP address and its subnet mask for which 
you want to either permit or deny traffic. 

Enter an IP address/subnet mask combination in the IP Address/Mask field.  

The subnet mask must be entered in dotted decimal notation. A valid IP address/subnet 
mask using dotted decimal notation would be 
192.168.1.0/255.255.255.0  

A forward slash "/" must be used to separate the IP address from the subnet mask. 

 Variable Address—This option allows you to create a named variable without requiring you 
to enter the IP addresses/masks in the template. The named variable then serves as a 
placeholder for Net Address Group you created using the Assistant combination when 
you import the template as a rule set into an existing ACL. 

Enter a name for this variable in the field to the right. 

9. Select the destination IP address option you want to use by selecting the Destination Address 
field in Basic Info. 

This option specifies where the pattern matching occurs in this template rule. In this case, the 
pattern matching is applied to the source IP address. 

 All—Allows you to permit or deny traffic for all IP addresses. 

 IP Address/Mask—Allows you to enter a specific IP address and its subnet mask for which 
you want to either permit or deny traffic. 

Enter an IP address/subnet mask combination in the IP Address/Mask field.  

The subnet mask must be entered in dotted decimal notation. A valid IP address/subnet 
mask using dotted decimal notation would be 
192.168.1.0/255.255.255.0  

A forward slash "/" must be used to separate the IP address from the subnet mask. 

 Variable Address—Allows you to create a named variable without requiring you to enter 
the IP addresses/masks in the template. The named variable then serves as a placeholder 
for Net Address Group you created using the Assistant combination when you import the 
template as a rule set into an existing ACL. 

Enter a name for this variable in the field to the right. 

10. If you select TCP or UDP as the protocol you want to apply this ACL rule to in step 5, you must 
also specify the source TCP or UDP port numbers: 

a. Select the source TCP or UDP port option by selecting the Source Port field of the 
Advanced Settings: 

 Undefined—Allows you to permit or deny traffic for all TCP or UDP port numbers. 

 Specified Port—Allows you to identify a specific TCP or UDP port number or range of 
numbers. Select Specified Port and select the operator you want to use from the list 
next to the Specified Port option. Enter the TCP or UDP port number in the Port field. 

 Variable Port—Allows you to create a named variable without requiring you to enter the 
ports in the template. The named variable then serves as a placeholder for the Service 
you are creating using the Assistant combination when you import the template as a 
rule set into an existing ACL. 

b. Enter a name for this variable in the field to the right. 
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11. If you select TCP or UDP as the protocol you want to apply this ACL rule to in step 5, you must 
also specify the destination TCP or UDP port numbers: 

a. Select the destination TCP or UDP port option by selecting the port option you want to apply 
in the Destination Port field of the Advanced Settings: 

 Undefined—Allows you to permit or deny traffic for all TCP or UDP port numbers. 

 Specified Port—Allows you to identify a specific TCP or UDP port number or range of 
numbers. Select Specified Port and select the operator you want to use from the list 
next to the Specified Port option. Enter the TCP or UDP port number in the Port field. 

 Variable Port—Allows you to create a named variable without requiring you to enter the 
ports in the template. The named variable then serves as a placeholder for the Service 
you are creating using the Assistant combination when you import the template as a 
rule set into an existing ACL. 

b. Enter a name for this variable in the field to the right. 

12. If you select TCP or UDP as the protocol you want to apply this ACL rule to in step 5, you may 
be promoted to select these options: 

 Select Yes in the HP ACK option if you want to apply the rule to match the TCP ACK, 
otherwise select No. 

 Select Yes in the HP FIN option if you want to apply the rule to match the TCP FIN, 
otherwise select No. 

 Select Yes in the HP RST option if you want to apply the rule to match the TCP RST, 
otherwise select No. 

 Select Yes in the HP SYN option if you want to apply the rule to match the TCP SYN, 
otherwise select No. 

The HP ACK, HP FIN, HP RST, and HP SYN settings are valid only for the HPE E series 
devices. 

13. Select the IP priority you want to apply to ACL template from the IP Priority list.  

14. Select the Type of Service for this ACL template from the ToS Value list. 

15. Select the DSCP value you want to apply to this ACL template from the DSCP Value list.  

16. Do one of the following: 

 Select Yes in the Fragment option if you want to apply the rule to each fragment. 

 Select Yes in the Fragment if you want to apply the rule to first fragments. 

Traditional packet filtering matched only first fragments of IPv4 packets and allowed all 
subsequent non-first fragments to pass through. This resulted in security risks as hackers can 
fabricate non-first fragments to attack networks. 

17. Select Yes in the Logging option if you want to enable logging for this rule. 

This feature enables the logging of packet filtering only when a module (for example, a firewall) 
using the ACL supports logging. 

18. Enter the VPN instance you want to apply to this rule by entering the VPN-instance-name in the 
VPN Instance field. 

A valid entry must be 0-31 characters that cannot contain question marks or blank spaces. This 
field is case sensitive. If no VPN instance is specified in this field, the rule applies only to 
non-VPN packets. 

19. Click OK to create the rule you have just configured. 

20. Select from the following to delete, modify, or copy rules that you have just configured: 

 To delete one or more rules from the ACL template, select the No. of the rules you want to 
delete, click Delete located above the rule table, and then click OK to confirm the deletion of 
the select rules. 
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 To modify rules you have already created, click the Modify icon  associated with the rule 
sequence you want to modify. For more information about modifying a rule set, see 
"Managing the rules in a rule set." 

 To copy rules you have already created, click the Copy icon  associated with the rule 
sequence you want to copy. For more information about copying a rule set, see "Copying a 
rule in an ACL rule set." 

Rules that belong to a rule set that is configured with a Match Order of 'Config' are executed in 
the order in which they are displayed in the rule set. The order in which rules are displayed in a 
rule set is initially defined by the order in which they are created. You can reorder the rules in a 
rule set using the Sort feature. For more information about using Sort to redefine the order of 
appearance of rules in a rule set, see "Using sort to reorder the rules in an ACL rules set." 

21. Click OK to accept your modifications to the ACL template. 

Once you finished modifying an ACL template, you can import the template into one or more 
ACLs. For more information importing into ACLs, see "Importing rule sets." 

Modifying a link ACL template 

1. Navigate to ACL Template. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Template under ACL Management on the left navigation tree. 

The Template List page opens. 

2. Click the Modify icon  for the template you want to modify. 

The Modify Template page opens. 

You cannot change the Template Name, template Type, or Match Order of an ACL template 
once you have created it. 

3. Modify the description for this ACL template as needed in the Template Description field. 

4. To add a new rule to the existing rule set, click Add Rule to add a rule to the ACL template. 

The Add Link Rule page opens. 

5. Select the action you want to take by selecting the option you want to apply to this rule. 

 Select permit if, upon matching the specified conditions, the packet should be forwarded.  

 Select deny if, upon matching the specified conditions, the packet should be discarded. 

6. Enter a named variable for this ACL template in the Time Range field allowing you to create a 
named variable without requiring you to enter the Time Range in the template. 

The named variable then serves as a placeholder for Time Range you created using the 
Assistant combination when you import the template as a rule set into an existing ACL. 

7. Select the source MAC address option you want to use by selecting the desired option in the 
Source MAC Addr field of the Basic Info. 

This option specifies where the pattern matching occurs in this template rule. In this case, the 
pattern matching is applied to the source MAC address. 

 All—Allows you to permit or deny traffic for all MAC addresses. 

 MAC Address/Mask—Allows you to enter a specific MAC address and mask for which you 
want to either permit or deny traffic for. 

A valid MAC address format for IMC consists of three sets of four hexadecimal characters 
separated by a dash, "-". For example, 
0014-2ad9-05f7  

would be a valid entry for a MAC address in IMC. 

Similarly, the format for a MAC address mask consists of three sets of four hexadecimal 
characters separated by a dash, "-". For example, 
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ffff-ffff-ffff  

would be a valid entry for a MAC address mask in IMC. 

The MAC address and its mask must be separated by a forward slash, "/". 

A valid entry for a MAC Address/Mask would be 
0014-2ad9-05f7/ffff-ffff-ffff  

 Variable Address—Allows you to create a named variable without requiring you to enter 
the MAC addresses/masks in the template. The named variable then serves as a 
placeholder for entering a MAC address/mask combination when you import the template 
as a rule set into an existing ACL. 

Enter a name for this variable in the field to the right. 

8. Do the following steps: 

a. Select the destination MAC address option you want to use by selecting the desired option 
in the Destination MAC Address of the page. 

This option specifies where the pattern matching occurs in this template rule. In this case, 
the pattern matching is applied to the source MAC address. 

 All—Allows you to permit or deny traffic for all MAC addresses. 

 MAC Address/Mask—Allows you to identify a specific MAC address and its mask for 
which you want to either permit or deny traffic. 

b. Select the destination MAC address option you want to use by selecting the desired option 
in the Source MAC Addr field of the Basic Info. 

This option specifies where the pattern matching occurs in this template rule. In this case, 
the pattern matching is applied to the source MAC address. 

 All—Allows you to permit or deny traffic to all MAC addresses. 

 MAC Address/Mask—Allows you to enter a specific MAC address and mask to which 
you want to either permit or deny traffic. 

A valid MAC address format for IMC consists of three sets of four hexadecimal 
characters separated by a dash, "-". For example, 
0014-2ad9-05f7  

would be a valid entry for a MAC address in IMC. 

Similarly, the format for a MAC address mask consists of three sets of four hexadecimal 
characters separated by a dash, "-". For example, 
ffff-ffff-ffff  

would be a valid entry for a MAC address mask in IMC. 

The MAC address and its mask must be separated by a forward slash, "/". 

A valid entry for a MAC Address/Mask would be 
0014-2ad9-05f7/ffff-ffff-ffff  

 Variable Address—Allows you to create a named variable without requiring you to 
enter the MAC addresses/masks in the template. The named variable then serves as a 
placeholder for entering a MAC address/mask combination when you import the 
template as a rule set into an existing ACL. 

Enter a name for this variable in the field to the right. 

9. Select the 802.1 priority you want to apply to this ACL rule from the 802.1 Priority list. 

10. Select the Layer 2 encapsulation type you want to apply to this ACL rule from the 
Encapsulation Type list. 

11. Enter the Source VLAN ID by entering it in the Source VLAN ID field. 

This field cannot contain question marks or blank spaces. 

12. Select the Layer 2 frame type from the Based Frame Type list. 
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13. If you select Ethernet Frame or 802.2 Ethernet Frame in the Base Frame Type list, you must 
specify a code in the Code field. 

A valid entry for this includes any four character hexadecimal value. 

14. Click OK to create the rule you have just configured. 

15. Do one of the following to add more rules, delete, modify, or copy an existing rule: 

 To add more rules to the ACL template, repeat steps 4-14. 

 To delete one or more rules from the ACL template, select the No. of the rules you want to 
delete, click Delete located above the rule table and then click OK to confirm the deletion of 
the select rules. 

 To modify rules you have already created, click the Modify icon  associated with the rule 
sequence you want to modify. For more information about modifying a rule set, see 
"Modifying the rules in an ACL template." 

 To copy rules you have already created, click the Copy icon  associated with the rule 
sequence you want to copy. For more information about copying a rule set, see "Copying a 
rule in a template." 

Rules that belong to a rule set that is configured with a Match Order of 'Config' are executed in 
the order in which they are displayed in the rule set. The order in which rules are displayed in a 
rule set is initially defined by the order in which they are created. You can reorder the rules in a 
rule set using the Sort feature. For more information about using Sort to redefine the order of 
appearance of rules in a rule set, see "Using sort to reorder the rules in an ACL rules set." 

16. Click OK to accept your modifications to the ACL template. 

Once you finish modifying an ACL template, you can import the template into one or more 
ACLs. For more information about importing into ACLs, see "Importing rule sets." 

Modifying a user-defined ACL template 

1. Navigate to ACL Template. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Template under ACL Management on the left navigation tree. 

The Template List page opens. 

2. Click the Modify icon  for the template you want to modify. 

The Modify Template page opens. 

You cannot change the Template Name, Type, or Match Order of an ACL template once you 
have created it. 

3. Modify the description for this ACL template as needed in the Template Description field. 

4. To add a new rule to the existing rule set, click Add Rule to add a rule to the ACL template. 

The Add User-Defined Rule page opens. 

5. Select the action you want to take by selecting the option you want to apply to this rule: 

 Select permit if, upon matching the specified conditions, the packet should be forwarded. 

 Select deny if, upon matching the specified conditions, the packet should be discarded. 

6. Enter a named variable for this ACL template in the Time Range field allowing you to create a 
named variable without requiring you to enter the Time Range in the template. 

The named variable then serves as a placeholder for Time Range you created using the 
Assistant combination when you import the template as a rule set into an existing ACL. 

7. Enter up to eight hexadecimal patterns, masks, and offsets for matching the contents of a 
packet and applying the actions specified in the rule when a hexadecimal pattern is matched. 

The following rules and guidelines apply to constructing a valid hexadecimal string, mask, and 
offset value: 
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 A rule string must be expressed in hexadecimal only. 

 A mask must be expressed in hexadecimal only. 

 A rule string length must be equal to its mask length. 

 Rule string and mask length must be in multiples of 2. 

 The minimum length of a rule string and mask is 2. 

 The maximum length of a rule string and mask is 160. 

 Offsets must be expressed as a decimal integer. 

 Offset range varies by the mask length. 

 The minimum value for an offset is 0. 

 The maximum value for an offset is 79. 

 The offset must increase progressively. 

Enter a hexadecimal pattern to be matched in the Rule String field. 

Enter a mask in the Mask field. 

Enter the offset in the Excursion field. 

Enter up to eight Rule String/Mask/Excursion combinations. 

8. Click OK to create the rule you have just configured or to accept the modifications. 

9. Do one of the following to add more rules, delete, modify or copy existing rules: 

 To add more rules to the ACL template, repeat steps 4-8. 

 To delete one or more rules from the ACL template, select the No. of the rules you want to 
delete, click Delete located above the rule table and then OK to confirm the deletion of the 
select rules. 

 To modify rules you have already created, click the Modify icon  associated with the rule 
sequence you want to modify. For more information about modifying a rule set, see 
"Managing the rules in a rule set." 

 To copy rules you have already created, click the Copy icon  associated with the rule 
sequence you want to copy. For more information about copying a rule set, see "Copying a 
rule in an ACL rule set." 

Rules that belong to a rule set that is configured with a Match Order of 'Config' are executed in 
the order in which they are displayed in the rule set. The order in which rules are displayed in a 
rule set is initially defined by the order in which they are created. You can reorder the rules in a 
rule set using the Sort feature. For more information about using Sort to redefine the order of 
appearance of rules in a rule set, see "Using sort to reorder the rules in an ACL rules set." 

10. Click OK to accept your modifications to the ACL template. 

Once you are finished modifying an ACL template, you can import the template into one or more 
ACLs. For more information about importing into ACLs, see "Importing rule sets." 

Copying an ACL template 
ACL Management provides you with the ability to copy an existing ACL template to a new template 
and change some of the configuration parameters to adapt it to meet other needs. While you can 
change many of the configuration options using the copy feature, you cannot change the ACL 
template type or match order of a template using the Copy option. Copying an existing ACL template 
limits you to creating rules for the same template type as was used for the original ACL template that 
was copied. 

To copy an existing ACL template: 

1. Navigate to ACL Template. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 
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c. Click ACL Template under ACL Management on the left navigation tree. 

The Template List page opens. 

2. Click the Copy icon  for the template you want to copy. 

3. Enter a new name for the ACL template in the Template Name field. 

You cannot change the template Type or Match Order of an ACL template when copying an 
existing template to a new template. 

4. Enter a template description in the Template Description field. 

5. You can create, modify, copy, or delete the rules of a copied template based on the existing 
ACL template type. 

For more information about creating rules, see the chapters of this manual on creating or 
modifying ACLs and specifically the steps for creating rules for the ACL template type you have 
copied. The steps for creating rules vary by template type. 

6. Click OK to create a copy of the ACL template. 

Once you finished copying an ACL template, you can import the template into one or more 
ACLs. For more information about importing into ACLs, see "Importing rule sets." 

Exporting an ACL template 
IMC provides you with the ability to export the contents of an ACL template for import into an ACL 
resource. Or rather, you can import the contents of an ACL template into an existing ACL in ACL 

Management. There are two paths for accessing this option. The first is by clicking the Export icon 

 associated with the ACL template you want to import and the second is by clicking Import from 
the Rule Set List of an existing ACL Resource. Both paths lead to the same feature in ACL 
Management, the Import ACL Template to ACL Resource feature. For more information about 
importing the contents of an ACL template into an ACL resource, see "Importing rule sets." 

Deleting ACL templates 
You can manage the ACL template list by deleting templates that are no longer used. 

To delete one or more templates: 

1. Navigate to ACL Template. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Template under ACL Management on the left navigation tree. 

The Template List page opens. 

2. Select the Template Names for the templates you want to delete. 

3. Click Delete. 

4. Click OK to confirm the deletion of the select templates. 

Managing the rules in a template 
Effective template management requires effective rule management. ACL Management provides 
you with the ability to manage the rules within the rule set of a template. This includes adding, 
modifying, copying, deleting, and sorting the rules in a rules set. 

Adding rules to a template 

Once a template has been created, you can add rules to it. You can only add rules of the same type 
as the ACL. 
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To add a basic rule to a basic ACL template: 

1. Navigate to ACL Template. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Template under ACL Management on the left navigation tree. 

The Template List page opens. 

2. Click the Modify icon  for the basic template you want to modify. 

The Modify Template page opens. 

3. Click Add Rule to add a rule to the ACL template. 

The Add Basic Rule page opens. 

4. Select the action you want to take by selecting the option you want to apply to this rule: 

 Select permit if, upon matching the specified conditions, the packet should be forwarded.  

 Select deny if, upon matching the specified conditions, the packet should be discarded. 

5. Enter a named variable for this ACL template in the Time Range field allowing you to create a 
named variable without requiring you to enter the time range in the template. The named 
variable then serves as a placeholder for the Time Range you created using the Assistant 
combination when you import the template as a rule set into an existing ACL. 

6. Select the source IP address option you want to use by selecting the desired option in the 
Source Address field in Basic Info. 

This option specifies where the pattern matching occurs in this template rule. In this case, 
pattern matching is applied to the source IP address. 

 All—Allows you to permit or deny traffic for all IP addresses. 

 IP Address/Mask—Allows you to enter a specific IP address and its subnet mask for which 
you want to either permit or deny traffic. 

Enter an IP address/subnet mask combination in the IP Address/Mask field. 

The subnet mask must be entered in dotted decimal notion. A valid IP address/subnet mask 
using dotted decimal notation would be 
192.168.1.0/255.255.255.0  

A forward slash "/" must be used to separate the IP address from the subnet mask. 

 Variable Address—allows you to create a named variable without requiring you to enter 
the IP addresses/masks in the template. The named variable then serves as a placeholder 
for Net Address Group you created using the Assistant combination when you import the 
template as a rule set into an existing ACL. 

Enter a name for this variable in the field to the right. 

7. Do one of the following: 

 Select Yes in the Fragment option if you want to apply the rule to each fragment. 

 Select No in the Fragment option if you want the rule to apply to first fragments. 

Traditional packet filtering matched only first fragments of IPv4 packets and allowed all 
subsequent non-first fragments to pass through. This resulted in security risks as hackers can 
fabricate non-first fragments to attack networks. 

8. Select Yes in the Logging option if you want to enable logging for this rule. 

This feature enables the logging of packet filtering only when a module (for example, a firewall) 
using the ACL supports logging. 

9. Enter the VPN instance you want to apply to this rule by entering the VPN-instance-name in the 
VPN Instance field. 

A valid entry must be 0-31 characters that cannot contain question marks or blank spaces. Note 
also that this field is case sensitive. If no VPN instance is specified in this field, the rule applies 
only to non-VPN packets. 
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10. Click OK to create the rule you have just configured. 

11. Click OK to add the rule to the ACL template. 

Adding an advanced rule to an advanced template 

1. Navigate to ACL Template. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Template under ACL Management on the left navigation tree. 

The Template List page opens. 

2. Click the Modify icon  for the advanced template you want to modify. 

The Modify Template page opens. 

3. Click Add Rule to add a rule to the ACL template. 

The Add Advanced Rule page opens. 

4. Select the protocol for which you want to permit or deny traffic from the Protocol list. 

5. Select the action you want to take by selecting the option you want to apply to this rule: 

 Select permit if, upon matching the specified conditions, the packet should be forwarded.  

 Select deny if, upon matching the specified conditions, the packet should be discarded. 

6. Enter a named variable for this ACL template in the Time Range field allowing you to create a 
named variable without requiring you enter the time range in the template. 

The named variable then serves as a placeholder for Time Range you created using the 
Assistant combination when you import the template as a rule set into an existing ACL. 

7. Select the source IP address option you want to use by selecting the desired option in the 
Source Address field in Basic Info. 

This option specifies where the pattern matching occurs in this template rule. In this case, 
pattern matching is applied to the source IP address. 

 All—Allows you to permit or deny traffic for all IP addresses. 

 IP Address/Mask—Allows you to enter a specific IP address and its subnet mask for which 
you want to either permit or deny traffic. 

Enter an IP address/subnet mask combination in the IP Address/Mask field. 

The subnet mask must be entered in dotted decimal notation. A valid IP address/subnet 
mask using dotted decimal notation would be 
192.168.1.0/255.255.255.0  

A forward slash "/" must be used to separate the IP address from the subnet mask. 

 Variable Address—allows you to create a named variable without requiring you to enter 
the IP addresses/masks in the template. The named variable then serves as a placeholder 
for Net Address Group you created using the Assistant combination when you import the 
template as a rule set into an existing ACL. 

Enter a name for this variable in the field to the right. 

8. Select the destination IP address option you want to use by selecting the desired option in the 
Destination Address field in Basic Info. 

This option specifies where the pattern matching occurs in this template rule. In this case, the 
pattern matching is applied to the source IP address. 

 All—Allows you to permit or deny traffic for all IP addresses. 

 IP Address/Mask—Allows you to enter a specific IP address and its subnet mask for which 
you want to either permit or deny traffic. 

Enter an IP address/subnet mask combination in the IP Address/Mask field. 

The subnet mask must be entered in dotted decimal notation. A valid IP address/subnet 
mask using dotted decimal notation would be 
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192.168.1.0/255.255.255.0  

A forward slash "/" must be used to separate the IP address from the subnet mask. 

 Variable Address—allows you to create a named variable without requiring you to enter 
the IP addresses/masks in the template. The named variable then serves as a placeholder 
for Net Address Group you created using the Assistant combination when you import the 
template as a rule set into an existing ACL. 

Enter a name for this variable in the field to the right. 

9. If you select TCP or UDP as the protocol you want to apply this ACL rule to in step 8, you must 
also specify the source TCP or UDP port numbers: 

a. Select the source TCP or UDP port option by selecting the port option you want to apply in 
the Source Port field of the Advanced Settings: 

 Undefined—Allows you to permit or deny traffic for all TCP or UDP port numbers. 

 Specified Port—Allows you to identify a specific TCP or UDP port number or range of 
numbers. Select Specified Port and select the operator you want to use from the list 
next to the Specified Port option. Enter the TCP or UDP port number in the Port field. 

 Variable Port—Allows you to create a named variable without requiring you to enter the 
ports in the template. The named variable then serves as a placeholder for the Service 
you are creating using the Assistant combination when you import the template as a 
rule set into an existing ACL. 

b. Enter a name for this variable in the field to the right. 

10. If you select TCP or UDP as the protocol you want to apply this ACL rule to in step 8, you must 
also specify the destination TCP or UDP port numbers: 

a. Select the destination TCP or UDP port option by selecting the port option you want to apply 
in the Destination Port field of the Advanced Settings: 

 Undefined—Allows you to permit or deny traffic for all TCP or UDP port numbers. 

 Specified Port—Allows you to identify a specific TCP or UDP port number or range of 
numbers.  

b. Select Specified Port and select the operator you want to use from the list next to the 
Specified Port option. 

c. Enter the TCP or UDP port number in the Port field. 

 Variable Port—Allows you to create a named variable without requiring you to enter the 
ports in the template. The named variable then serves as a placeholder for the Service 
you are creating using the Assistant combination when you import the template as a 
rule set into an existing ACL. 

d. Enter a name for this variable in the field to the right. 

11. If you select TCP or UDP as the protocol you want to apply this ACL rule to in step 4, you could 
be promoted to select these options: 

 Select Yes in the HP ACK option if you want to apply the rule to match the TCP ACK, 
otherwise select No. 

 Select Yes in the HP FIN option if you want to apply the rule to match the TCP FIN, 
otherwise select No. 

 Select Yes in the HP RST option if you want to apply the rule to match the TCP RST, 
otherwise select No. 

 Select Yes in the HP SYN option if you want to apply the rule to match the TCP SYN, 
otherwise select No. 

The HP ACK, HP FIN, HP RST, and HP SYN settings are valid only for the HPE E series 
devices. 

12. Select the IP priority you want to apply to ACL template from the IP Priority list.  

13. Select the Type of Service for this ACL template from the ToS Value list. 

14. Select the DSCP value you want to apply to this ACL template from the DSCP Value list.  
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15. Do one of the following: 

 Select Yes in the Fragment option if you want to apply the rule to each fragment. 

 Select No in the Fragment option if you want to apply the rule to first fragments. 

Traditional packet filtering matched only first fragments of IPv4 packets and allowed all 
subsequent non-first fragments to pass through. This resulted in security risks as hackers can 
fabricate non-first fragments to attack networks. 

16. Select Yes in the Logging option if you want to enable logging for this rule. 

This feature enables the logging of packet filtering only when a module (for example, a firewall) 
using the ACL supports logging. 

17. Enter the VPN instance you want to apply to this rule by entering the VPN-instance-name in the 
VPN Instance field. 

A valid entry must be 0-31 characters that cannot contain question marks or blank spaces. Note 
also that this field is case sensitive. If no VPN instance is specified in this field, the rule applies 
only to non-VPN packets. 

18. Click OK to create the rule you have just configured. 

19. Click OK to add the rule to the ACL template. 

Adding a link rule to a link ACL template 

1. Navigate to ACL Template. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Template under ACL Management on the left navigation tree. 

The Template List page opens. 

2. Click the Modify icon  for the link template you want to modify. 

The Modify Template page opens. 

3. Click Add Rule to add a rule to the ACL template. 

The Add Link Rule page opens. 

4. Select the action you want to take by selecting the option you want to apply to this rule. 

 Select permit if, upon matching the specified conditions, the packet should be forwarded.  

 Select deny if, upon matching the specified conditions, the packet should be discarded. 

5. Enter a named variable for this ACL template in the Time Range field, allowing you to create a 
named variable without requiring you to enter the Time Range in the template. 

The named variable then serves as a placeholder for Time Range you created using the 
Assistant combination when you import the template as a rule set into an existing ACL. 

6. Select the source MAC address option you want to use by selecting the desired option in the 
Source MAC Addr field of the Basic Info. 

This option specifies where the pattern matching occurs in this template rule. In this case, the 
pattern matching is applied to the source MAC address. 

 All—Allows you to permit or deny traffic for all MAC addresses. 

 MAC Address/Mask—Allows you to enter a specific MAC address and mask for which you 
want to either permit or deny traffic. 

A Valid MAC address format for IMC consists of three sets of four hexadecimal characters 
separated by a dash, "-". For example: 
0014-2ad9-05f7  

would be a valid entry for a MAC address in IMC. 

Similarly, the format for a MAC address mask consists of three sets of four hexadecimal 
characters separated by a dash, "-". For example: 
ffff-ffff-ffff  
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would be a valid entry for a MAC address mask in IMC. 

The MAC address and its mask must be separated by a forward slash, "/". 

A valid entry for a MAC Address/Mask would be: 
0014-2ad9-057f/ffff-fff-ffff  

 Variable Address—Enter a name for this variable in the field to the right, allowing you to 
create a named variable without requiring you to enter the MAC addresses/masks in the 
template. The named variable then serves as a placeholder for entering a MAC 
address/mask combination when you import the template as a rule set into an existing ACL. 

a. Select Variable Address in the Source MAC addr portion of the Basic Info section of the 
page. 

b. Enter a name for this variable in the field to the right. 

7. Select the destination MAC address option you want to use by selecting the desired option in 
the Destination MAC Address field of the Basic Info. 

This option specifies where the pattern matching occurs in this template rule. In this case, the 
pattern matching is applied to the source MAC address. 

 All—Allows you to permit or deny traffic for all MAC addresses. 

 MAC Address/Mask—Allows you to identify a specific MAC address and mask for which 
you want to either permit or deny traffic. 

A valid MAC address format for IMC consists of three sets of four hexadecimal characters 
separated by a dash, "-". For example, 
0014-2ad9-05f7  

would be a valid entry for a MAC address in IMC. 

Similarly, the format for a MAC address mask consists of three sets of four hexadecimal 
characters separated by a dash, "-". For example, 
ffff-ffff-ffff  

would be a valid entry for a MAC address mask in IMC. 

The MAC address and its mask must be separated by a forward slash, "/". 

A valid entry for a MAC Address/Mask would be 
0014-2ad9-05f7/ffff-ffff-ffff  

 Variable Address—Enter a name for this variable in the field to the right allowing you to 
create a named variable without requiring you to enter the MAC addresses/masks in the 
template. The named variable then serves as a placeholder for entering a MAC 
address/mask combination when you import the template as a rule set into an existing ACL. 

Enter a name for this variable in the field to the right. 

8. Select the 802.1 priority you want to apply to this ACL rule from the 802.1 Priority list. 

9. Select the Layer 2 encapsulation type you want to apply to this ACL rule from the 
Encapsulation Type list. 

10. Enter the Source VLAN ID by entering it in the Source VLAN ID field. 

This field cannot contain question marks (?) or spaces ( ). 

11. Select the Layer 2 frame type from the Based Frame Type list. 

12. If you select Ethernet Frame or 802.2 Ethernet Frame in the Base Frame Type list, you must 
specify a code in the Code field. 

A valid entry for this field includes any four character hexadecimal value. 

13. If you select Ethernet Frame or 802.2 Ethernet Frame in the Base Frame Type list, you must 
also specify a mask in the Mask field. 

A valid entry for this field includes any four character hexadecimal value. 

14. Click OK to create the rule you have just configured. 

15. Click OK to add the rule to the ACL template 
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Adding a user-defined rule to a user-defined ACL template 

1. Navigate to ACL Template. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Template under ACL Management on the left navigation tree. 

The Template List page opens. 

2. Click the Modify icon  for the user-defined template you want to modify. 

The Modify Template page opens. 

3. Click Add Rule to add a rule to the ACL template. 

The Add User-Defined Rule page opens. 

4. Select the action you want to take by selecting the option you want to apply to this rule: 

 Select permit if, upon matching the specified conditions, the packet should be forwarded.  

 Select deny if, upon matching the specified conditions, the packet should be discarded. 

5. Enter a named variable for this ACL template in the Time Range field, allowing you to create a 
named variable without requiring you enter the Time Range in the template. 

The named variable then serves as a placeholder for Time Range you created using the 
Assistant combination when you import the template as a rule set into an existing ACL. 

6. Enter up to eight hexadecimal patterns, masks, and offsets for matching the contents of a 
packet and applying the actions specified in the rule when a hexadecimal pattern is matched. 

The following rules and guidelines apply to constructing a valid hexadecimal string, mask, and 
offset value: 

 A rule string must be expressed in hexadecimal only. 

 A mask must be expressed in hexadecimal only. 

 A rule string length must be equal to its mask length. 

 Rule string and mask length must be in multiples of 2. 

 The minimum length of a rule string and mask is 2. 

 The maximum length of a rule string and mask is 160. 

 Offsets must be expressed as a decimal integer. 

 Offset range varies by the mask length. 

 The minimum value for an offset is 0. 

 The maximum value for an offset is 79. 

 The offset must increase progressively. 

Enter a hexadecimal pattern to be matched in the Rule String field. 

Enter a mask in the Mask field. 

Enter the offset in the Excursion field. 

Enter up to eight Rule String/Mask/Excursion combinations. 

7. Click OK to create the rule you have just configured. 

8. Click OK to add the rule to the ACL template 

Modifying the rules in an ACL template 

You can also modify the individual rules of a template.  

To modify the basic rule of a basic ACL template: 

1. Navigate to ACL Template. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 
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c. Click ACL Template under ACL Management on the left navigation tree. 

The Template List page opens. 

2. Click the Modify icon  for the basic template you want to modify. 

The Modify Template page displays, with the Modify Template page in the main pane. 

3. Click the Modify icon  for the basic rule you want to modify. 

4. Select the action you want to take selecting the option you want to apply to this rule: 

 Select permit if, upon matching the specified conditions, the packet should be forwarded.  

 Select deny if, upon matching the specified conditions, the packet should be discarded. 

5. Enter a named variable for this ACL template in the Time Range field allowing you to create a 
named variable without requiring you to enter the time range in the template. 

The named variable then serves as a placeholder for the Time Range you created using the 
Assistant combination when you import the template as a rule set into an existing ACL. 

6. Select the source IP address option you want to use by selecting the desired option in the 
Source Address field in Basic Info. 

This option specifies where the pattern matching occurs in this template rule. In this case, 
pattern matching is applied to the source IP address. 

 All—Allows you to permit or deny traffic for all IP addresses. 

 IP Address/Mask—Allows you to enter a specific IP address and its subnet mask for which 
you want to either permit or deny traffic. 

Enter an IP address/subnet mask combination in the IP Address/Mask field. 

The subnet mask must be entered in dotted decimal notion. A valid IP address/subnet mask 
using dotted decimal notation would be 
192.168.1.0/255.255.255.0  

A forward slash "/" must be used to separate the IP address from the subnet mask. 

 Variable Address—allows you to create a named variable without requiring you to enter 
the IP addresses/masks in the template. The named variable then serves as a placeholder 
for Net Address Group you created using the Assistant combination when you import the 
template as a rule set into an existing ACL. 

Enter a name for this variable in the field to the right. 

7. Do one of the following: 

 Select Yes in the Fragment option if you want to apply the rule to each fragment. 

 Select No in the Fragment option if you want to apply the rule to first fragments. 

Traditional packet filtering matched only first fragments of IPv4 packets and allowed all 
subsequent non-first fragments to pass through. This resulted in security risks as hackers can 
fabricate non-first fragments to attack networks. 

8. Select Yes in the Logging option if you want to enable logging for this rule.  

This feature enables the logging of packet filtering only when a module (for example, a firewall) 
using the ACL supports logging. 

9. Enter the VPN instance you want to apply to this rule by entering the VPN-instance-name in the 
VPN Instance field. 

A valid entry must be 0–31 characters that cannot contain question marks or blank spaces. This 
field is case sensitive. If no VPN instance is specified in this field, the rule applies only to 
non-VPN packets. 

10. Click OK to accept the modifications to the rule. 

11. Click OK to accept the modifications to the template. 

Modifying advanced rules in advanced ACL templates 

To modify the advanced rule of an advanced ACL template: 
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1. Navigate to ACL Template. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Template under ACL Management on the left navigation tree. 

The Template List page opens. 

2. Click the Modify icon  for the advanced template you want to modify. 

The Modify Template page opens. 

3. Click the Modify icon  for the rule you want to modify. 

4. Select the protocol for which you want to permit or deny traffic from the Protocol list by 
selecting the option you want to apply to this rule: 

 Select permit if, upon matching the specified conditions, the packet should be forwarded.  

 Select deny if, upon matching the specified conditions, the packet should be discarded. 

5. Enter a named variable for this ACL template in the Time Range field allowing you to create a 
named variable without requiring you enter the time range in the template. 

The named variable then serves as a placeholder for the Time Range you created using the 
Assistant combination when you import the template as a rule set into an existing ACL. 

6. Select the source IP address option you want to use by selecting the desired option in the 
Source Address field in Basic Info. 

This option specifies where the pattern matching occurs in this template rule. In this case, 
pattern matching is applied to the source IP address. 

 All—Allows you to permit or deny traffic for all IP addresses. 

 IP Address/Mask—Allows you to enter a specific IP address and its subnet mask for which 
you want to either permit or deny traffic. 

Enter an IP address/subnet mask combination in the IP Address/Mask field. 

The subnet mask must be entered in dotted decimal notation. A valid IP address/subnet 
mask using dotted decimal notation would be 
192.168.1.0/255.255.255.0  

A forward slash "/" must be used to separate the IP address from the subnet mask. 

 Variable Address—allows you to create a named variable without requiring you to enter 
the IP addresses/masks in the template. The named variable then serves as a placeholder 
for Net Address Group you created using the Assistant combination when you import the 
template as a rule set into an existing ACL. 

Enter a name for this variable in the field to the right. 

7. Select the destination IP address option you want to use by selecting the desired option in the 
Destination Address field in Basic Info. 

This option specifies where the pattern matching occurs in this template rule. In this case, the 
pattern matching is applied to the source IP address. 

 All—Allows you to permit or deny traffic for all IP addresses. 

 IP Address/Mask—Allows you to enter a specific IP address and its subnet mask for which 
you want to either permit or deny traffic. 

Enter an IP address/subnet mask combination in the IP Address/Mask field. 

The subnet mask must be entered in dotted decimal notation. A valid IP address/subnet 
mask using dotted decimal notation would be 
192.168.1.0/255.255.255.0  

A forward slash "/" must be used to separate the IP address from the subnet mask. 

 Variable Address—Allows you to create a named variable without requiring you to enter 
the IP addresses/masks in the template. The named variable then serves as a placeholder 
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for Net Address Group you created using the Assistant combination when you import the 
template as a rule set into an existing ACL. 

Enter a name for this variable in the field to the right. 

8. If you select TCP or UDP as the protocol you want to apply this ACL rule to in step 4, you must 
also specify the source TCP or UDP port numbers: 

a. Select the source TCP or UDP port option by selecting the port option you want to apply in 
the Source Port field of the Advanced Settings: 

 Undefined—Allows you to permit or deny traffic for all TCP or UDP port numbers. 

 Specified Port—Allows you to identify a specific TCP or UDP port number or range of 
numbers. Select Specified Port and select the operator you want to use from the list 
next to the Specified Port option. Enter the TCP or UDP port number in the Port field. 

 Variable Port—Allows you to create a named variable without requiring you to enter the 
ports in the template. The named variable then serves as a placeholder for the Service 
you are creating using the Assistant combination when you import the template as a 
rule set into an existing ACL. 

b. Enter a name for this variable in the field to the right. 

9. If you select TCP or UDP as the protocol you want to apply this ACL rule to in step 4–, you must 
also specify the destination TCP or UDP port numbers: 

a. Select the destination TCP or UDP port option by selecting the port option you want to apply 
in the Destination Port field of the Advanced Settings: 

 Undefined—Allows you to permit or deny traffic for all TCP or UDP port numbers. 

 Specified Port—Allows you to identify a specific TCP or UDP port number or range of 
numbers.  

b. Select Specified Port and select the operator you want to use from the list next to the 
Specified Port option. 

c. Enter the TCP or UDP port number in the Port field. 

 Variable Port—Allows you to create a named variable without requiring you to enter the 
ports in the template. The named variable then serves as a placeholder for the Service 
you are creating using the Assistant combination when you import the template as a 
rule set into an existing ACL. 

d. Enter a name for this variable in the field to the right. 

10. If you select TCP or UDP as the protocol you want to apply this ACL rule to in step 4, you could 
be promoted to select these options: 

 Select Yes in the HP ACK option if you want to apply the rule to match the TCP ACK, 
otherwise select No. 

 Select Yes in the HP FIN option if you want to apply the rule to match the TCP FIN, 
otherwise select No. 

 Select Yes in the HP RST option if you want to apply the rule to match the TCP RST, 
otherwise select No. 

 Select Yes in the HP SYN option if you want to apply the rule to match the TCP SYN, 
otherwise select No. 

The HP ACK, HP FIN, HP RST, and HP SYN settings are valid only for the HPE E series 
devices. 

11. Select the IP priority you want to apply to ACL template from the IP Priority list.  

12. Select the Type of Service for this ACL template from the ToS Value list. 

13. Select the DSCP value you want to apply to this ACL template from the DSCP Value list.  

14. Do one of the following: 

 Select Yes in the Fragment option if you want to apply the rule to each fragment. 

 Select No in the Fragment option if you want to apply the rule to first fragments. 
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Traditional packet filtering matched only first fragments of IPv4 packets and allowed all 
subsequent non-first fragments to pass through. This resulted in security risks as hackers can 
fabricate non-first fragments to attack networks. 

15. Select Yes in the Logging option if you want to enable logging for this rule. 

This feature enables the logging of packet filtering only when a module (for example, a firewall) 
using the ACL supports logging. 

16. Enter the VPN instance you want to apply to this rule by entering the VPN-instance-name in the 
VPN Instance field. 

A valid entry must be 0-31 characters that cannot contain question marks or blank spaces. Note 
also that this field is case sensitive. If no VPN instance is specified in this field, the rule applies 
only to non-VPN packets. 

17. Click OK to accept the modifications to the rule. 

18. Click OK to accept the modifications to the template. 

Modifying the link rule of a link ACL template 

1. Navigate to ACL Template. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Template under ACL Management on the left navigation tree. 

The Template List page opens. 

2. Click the Modify icon  for the link template you want to modify. 

The Modify Template page opens. 

3. Click the Modify icon  for the rule you want to modify. 

4. Select the action you want to take by selecting the option you want to apply to this rule. 

 Select permit if, upon matching the specified conditions, the packet should be forwarded.  

 Select deny if, upon matching the specified conditions, the packet should be discarded. 

5. Enter a named variable for this ACL template in the Time Range field, allowing you to create a 
named variable without requiring you enter the Time Range in the template. 

The named variable then serves as a placeholder for Time Range you created using the 
Assistant combination when you import the template as a rule set into an existing ACL. 

6. Select the source MAC address option you want to use by selecting the desired option in the 
Source MAC Addr field of the Basic Info. 

This option specifies where the pattern matching occurs in this template rule. In this case, the 
pattern matching is applied to the source MAC address. 

 All—Allows you to permit or deny traffic for all MAC addresses. 

 MAC Address/Mask—Allows you to enter a specific MAC address and mask for which you 
want to either permit or deny traffic. 

A Valid MAC address format for IMC consists of three sets of four hexadecimal characters 
separated by a dash, "-". For example: 
0014-2ad9-05f7  

would be a valid entry for a MAC address in IMC. 

Similarly, the format for a MAC address mask consists of three sets of four hexadecimal 
characters separated by a dash, "-". For example: 
ffff-ffff-ffff  

would be a valid entry for a MAC address mask in IMC. 

The MAC address and its mask must be separated by a forward slash, "/". 

A valid entry for a MAC Address/Mask would be: 
0014-2ad9-057f/ffff-fff-ffff  
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 Variable Address—Enter a name for this variable in the field to the right, allowing you to 
create a named variable without requiring you to enter the MAC addresses/masks in the 
template. The named variable then serves as a placeholder for entering a MAC 
address/mask combination when you import the template as a rule set into an existing ACL. 

a. Select Variable Address in the Source MAC addr portion of the Basic Info section of the 
page. 

b. Enter a name for this variable in the field to the right. 

7. Select the destination MAC address option you want to use by selecting the desired option in 
the Destination MAC Address field of the Basic Info. 

This option specifies where the pattern matching occurs in this template rule. In this case, the 
pattern matching is applied to the source MAC address. 

 All—Allows you to permit or deny traffic for all MAC addresses. 

 MAC Address/Mask—Allows you to identify a specific MAC address and mask for which 
you want to either permit or deny traffic. 

A valid MAC address format for IMC consists of three sets of four hexadecimal characters 
separated by a dash, "-". For example, 
0014-2ad9-05f7  

would be a valid entry for a MAC address in IMC. 

Similarly, the format for a MAC address mask consists of three sets of four hexadecimal 
characters separated by a dash, "-". For example, 
ffff-ffff-ffff  

would be a valid entry for a MAC address mask in IMC. 

The MAC address and its mask must be separated by a forward slash, "/". 

A valid entry for a MAC Address/Mask would be 
0014-2ad9-05f7/ffff-ffff-ffff  

 Variable Address—Enter a name for this variable in the field to the right allowing you to 
create a named variable without requiring you to enter the MAC addresses/masks in the 
template. The named variable then serves as a placeholder for entering a MAC 
address/mask combination when you import the template as a rule set into an existing ACL. 

Enter a name for this variable in the field to the right. 

8. Select the 802.1 priority you want to apply to this ACL rule from the 802.1 Priority list. 

9. Select the Layer 2 encapsulation type you want to apply to this ACL rule from the 
Encapsulation Type list. 

10. Enter the Source VLAN ID by entering it in the Source VLAN ID field. 

This field cannot contain question marks (?) or spaces ( ). 

11. Select the Layer 2 frame type from the Based Frame Type list. 

12. If you select Ethernet Frame or 802.2 Ethernet Frame in the Base Frame Type list, you must 
specify a code in the Code field. 

A valid entry for this field includes any four character hexadecimal value. 

13. Click OK to accept the modifications to the rule. 

14. Click OK to accept the modifications to the template. 

Modifying user-defined rules in a user-defined ACL template 

1. Navigate to ACL Template. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Template under ACL Management on the left navigation tree. 

The Template List page opens. 
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2. Click the Modify icon  for the user-defined template you want to modify. 

The Modify Template page displays with the Rule List for the selected ACL template in the 
main pane 

3. Click the Modify icon  for the rule you want to modify. 

4. Select the action you want to take by selecting the option you want to apply to this rule: 

 Select permit if, upon matching the specified conditions, the packet should be forwarded.  

 Select deny if, upon matching the specified conditions, the packet should be discarded. 

5. Enter a named variable for this ACL template in the Time Range field, allowing you to create a 
named variable without requiring you to enter the Time Range in the template. 

The named variable then serves as a placeholder for the Time Range you created using the 
Assistant combination when you import the template as a rule set into an existing ACL. 

6. Enter up to eight hexadecimal patterns, masks, and offsets for matching the contents of a 
packet and applying the actions specified in the rule when a hexadecimal pattern is matched. 

The following rules and guidelines apply to constructing a valid hexadecimal string, mask, and 
offset value: 

 A rule string must be expressed in hexadecimal only. 

 A mask must be expressed in hexadecimal only. 

 A rule string length must be equal to its mask length. 

 Rule string and mask length must be in multiples of 2. 

 The minimum length of a rule string and mask is 2. 

 The maximum length of a rule string and mask is 160. 

 Offsets must be expressed as a decimal integer. 

 Offset range varies by the mask length. 

 The minimum value for an offset is 0. 

 The maximum value for an offset is 79. 

 The offset must increase progressively. 

a. Enter a hexadecimal pattern to be matched in the Rule String field. 

b. Enter a mask in the Mask field. 

c. Enter the offset in the Excursion field. 

d. Enter up to eight Rule String/Mask/Excursion combinations. 

7. Click OK to accept the modifications to the Rule String/Mask/Excursion combinations. 

8. Click OK to accept the modifications to the template. 

Copying a rule in a template 

You can copy an existing rule in a template to a new rule in the same template and make 
modifications to the new copy. 

To copy an existing rule in a template and make modifications to it: 

1. Navigate to ACL Template. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Template under ACL Management on the left navigation tree. 

The Template List page opens. 

2. Click the Modify icon  for the template you want to modify. 

The Modify Template page displays with the list of rules for the associated template in the 
Rule Maintenance of the page. 
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3. Click the Copy icon  for the rule you want to copy. 

You can make any modifications to the copy of a rule that you can to the rule itself, including 
creating new rules. 

The steps for creating and modifying rules in a template vary by the template type to which the 
rule belongs. For more information about modifying rules in a template, see "Managing the 
rules in a rule set."  

4. Click OK when you have finished modifying the copy to create the new copy. 

Deleting rules from a template 

To delete one or more rules from a template: 

1. Navigate to ACL Template. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Template under ACL Management on the left navigation tree. 

The Template List page opens. 

2. Click the Modify icon  for the template you want to delete rules from. 

The Modify Template page displays with the list of rules for the associated template in the 
Rule Maintenance of the page. 

3. Select the sequence numbers for the rules you want to delete. 

4. Click Delete. 

5. Click OK to confirm the deletion of the select rules. 

6. Click OK to complete the modifications to the template. 

Managing ACL resources in IMC 
Resources are comprised of the configured ACLs and their rules sets that are deployed to devices in 
the network. ACL Management offers you a rich feature set for simplifying the task of resource 
management. Through the Resource List, you have a single portal for viewing and managing all of 
the ACLs that can be deployed to network devices. From the ACL Resource list, you can view all 
four types of ACLs, add new ACLs, rename existing ACLs and delete ACLs that are no longer 
needed. You can also drill down into the Rule Set List to view all rules for each ACL, take actions on 
all rules in the list and import the contents of a template into a new rule set. 

The Rule Set List also contains a wizard you can use to modify existing rules of a set, including 
modifying, copying, or deleting existing rules. You can also redefine the order of appearance of rules 
in a set which can be critical to the effectiveness of a rule set when the match order is based on the 
order of the rule appearance. 

Managing ACLs 
ACL Management provides you with a single portal for viewing and accessing all ACLs.  

Viewing the ACL resource list 

To view the list of ACL resources in IMC: 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Resource under ACL Management on the left navigation tree. 

The ACL Resource list page opens. 
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ACL resource list 

 ACL Identifier—Contains the identifier for the ACL. The ACL Identifier serves as a link 
for navigating to the Rule Set List page for the associated ACL. 

 ACL Resource Name—Contains a descriptive name for the associated ACL. 

 ACL Type—Identifies the ACL type. An ACL can be a Basic, Advanced, Link, or 
User-Defined ACL in IMC. 

 Modify—Contains a link  for modifying the ACL Resource Name with the 
associated ACL. 

If the ACL Resource list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the ACL Resource list. 

 Click  to page forward to the end of the ACL Resource list. 

 Click  to page backward in the ACL Resource list. 

 Click  to page backward to the front of the ACL Resource list. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

You can sort the ACL Resource list by the ACL Identifier, ACL Resource Name, and ACL 
Type fields. Click the column label to sort the list by the selected field. The column label is a 
toggle switch that allows you to toggle between the various sort options specific to each field. 

Adding an ACL 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Resource under ACL Management on the left navigation tree. 

The ACL Resource list page opens. 

2. Click Add. 

The Add ACL Resource page opens. 

3. Select the type of ACL you want to create by selecting the desired ACL Identity Type. The 
option for identifying the ACL is by Number or by Name. 

4. Select the type of ACL you want to create by selecting it from the ACL Type list.  

Operators have four ACL types to select from: 

 Basic—Enables you to create rules based on source IP addresses. 

 Advanced—Enables you to define rules based on Layer 3 and Layer 4 information 
including IP source and destination addresses, TCP and UDP port information, as well as 
protocol specific features. 

 Link—Enables you to define rules based on Layer 2 information including source MAC and 
destination MAC addresses, VLAN priority information as well as data link layer protocol 
type. 

 User-Defined—Enables you to define a hexadecimal pattern and mask and the offset in the 
packet header to begin the pattern matching. When a pattern is matched, the conditions of 
the rule in the ACL template are applied. 

5. Enter a valid ACL identifier for the ACL type you have select in the ACL Identifier field. Valid 
entries for each ACL type is provided below: 

 Basic—Any number in the range of 1-99, 1300-1399, or 2000-2999. 

 Advanced—Any number in the range of 100-199, 2000-2699, or 3000-3999. 
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 Link—Any number in the range of 700-799, 1100-1199, 4000-4999. 

 User Defined—Any number in the range of 5000-5999. 

6. Enter a valid name for the ACL in the ACL Resource Name field.  

A valid length for an ACL name is 1–32 characters. An ACL name cannot begin with a space. 

7. Click OK to create the ACL. 

Renaming an ACL 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Resource under ACL Management on the left navigation tree. 

The ACL Resource list page opens. 

2. Click the Rename icon  in the field associated with the ACL you want to rename. 

The Rename ACL Resource dialog box opens. 

3. Delete the current value in the ACL Resource Name field and enter the new name for the ACL. 

4. Click OK to apply the new name to the ACL resource. 

Deleting ACLs 

To delete one or more ACLs from the ACL Management: 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Resource under ACL Management on the left navigation tree. 

The ACL Resource list page opens. 

2. Select the ACL Identifiers you want to delete. 

3. Click Delete. 

4. Click OK to confirm the deletion of the select ACLs. 

Managing rule sets 
ACL Management provides you with a rich feature set for managing ACLs and the rule sets that 
constitute them. From the ACL Resource list, you can drill down into the Rule Set List to view every 
rule set for a given ACL. From the Rule Set List page, you can view rule set information including 
basic rule set information, time ranges applied to rules in the list. In addition, you can view 
information for every rule in the list. 

From the Rule Set List, you can also take action on all of the rules in the list including adding new 
rule sets, modifying, copying, deploying, and deleting existing rule sets, as well as importing the 
contents of a template into a new rule set of an existing ACL. 

You can also navigate to the Modify Rule Set wizard for modifying the existing rules of a rule set. 
Using this wizard, you can modify, copy, or delete an existing rule, or redefine the order of 
appearance of rules in a set. In addition, you can initiate the evaluation of any rule set for optimizing 
its effect on network performance and have ACL Management make and implement 
recommendations for the improvement of rule sets. 

Viewing rule set information 

Rule sets are the core of an ACL, providing you with a single view of rule sets through the Rule Set 
List. From this list, you can view detailed information for every rule set in an ACL. Operators can also 
view detailed information for every rule in a rule set, including rule and time range information. 

To view the Rule Set List for an ACL resource in IMC: 
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1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Resource under ACL Management on the left navigation tree. 

The ACL Resource list page opens. 

2. Click the ACL Identifier for the ACL for which you want to view the Rules Set List. 

The Rule Set List is displayed on the main pane of the ACL Resource > <ACL Resource 
Name (ACL Identifier)> page. 

Rule set list field names and explanations 

 Rule Set Name—Contains the name of the Rule Set. The Rule Set Name serves as a link 
for navigating to the Rule Set Info page for the associated Rule Set. This page displays Rule 
Set configuration information for the associated Rule Set. For more information about 
viewing rule set information, see "Viewing rule set information." 

 Description—Contains a description for the associated Rule Set. 

 Deploy—Contains a link  for deploying the associated Rule Set. 

 Copy—Contains a link  for copying the associated Rule Set. 

 Modify—Contains a link  for modifying the associated Rule Set. 

If the Rule Set List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Rule Set List. 

 Click  to page forward to the end of the Rule Set List. 

 Click  to page backward in the Rule Set List. 

 Click  to page backward to the front of the Rule Set List. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

You can sort the Rule Set List by the Rule Set Name and the Description fields. Click the 
column label to sort the list by the select field. The column label is a toggle switch that allows 
you to toggle between the various sort options specific to each field. 

Viewing the information for a Rule Set for an ACL 

To view the information for a Rule Set for an ACL: 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Resource under ACL Management on the left navigation tree. 

The ACL Resource list page opens. 

2. Click the ACL Identifier for the ACL for which you want to view the Rules Set List. 

The Rule Set List is displayed on the main pane of the ACL Resource > <ACL Resource 
Name (ACL Identifier)> page. 

3. Click the name in the Rule Set Name field for the Rule Set for which you want to view 
configuration information. 

The Rule Set Info page opens on the main pane of the ACL Resource > <ACL Resource 
Name (ACL Identifier)> > <Rule Set Name> page. This page includes three fields, Basic 
Info, Rule Info, and Time Range Info. The field for the Rule Info field varies based on ACL 
type. 
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Basic info 

 ACL Identifier—Contains the identifier for the ACL. 

 ACL Resource Name—Contains a descriptive name for the associated ACL. 

 ACL Type—Identifies the ACL type. An ACL can be a Basic, Advanced, Link, or 
User-Defined ACL in IMC. 

 ACL Description—Contains a description for the associated ACL. 

 Rule Set Name—Contains the name of the Rule Set. 

 Match Order—Contains the match order type for the associated rule. The Match Order 
can either be Config or Auto.  

 Rule Set Description—Contains a description for the associated Rule Set. 

Rule info for basic ACL  

 No.—Contains the sequence or rule number for the associated rule in the Rule Set. The 
value in the sequence field serves as a link for navigating to the Rule Info page for the 
associated rule. This page displays rule configuration information for the associated rule. 
For more information about viewing rule information, see "Viewing rule set information." 

 Action—Contains the access control action specified in the associated rule. Actions include 
permit and deny. 

 Source Address—Contains the source address specified in the associated rule for which 
the action is taken. For example, if the action is to permit IP traffic, this field identifies the 
source IP address from which IP traffic is permitted. 

Rule info for Advanced ACL 

 No.—Contains the sequence or rule number for the associated rule in the Rule Set. The 
value in the sequence field serves as a link for navigating to the Rule Info page for the 
associated rule. This page displays rule configuration information for the associated rule. 
For more information about viewing rule information, see "Viewing ACL templates." 

 Action—Contains the access control action specified in the associated rule. Actions include 
permit and deny. 

 Protocol—Contains the protocol specified in the associated rule for which the action are 
taken. 

 Source Address—Contains the source address specified in the associated rule for which 
the action is taken. For example, if the action is to permit IP traffic, this field identifies the 
source IP address from which IP traffic is permitted. 

 Destination Address—contains the destination address specified in the associated rule for 
which the action is taken. For example, if the action is to permit IP traffic, this field identifies 
the destination IP address to which IP traffic is permitted. 

Rule info for link ACL 

 No.—Contains the sequence or rule number for the associated rule in the Rule Set. The 
value in the sequence field serves as a link for navigating to the Rule Info page for the 
associated rule. This page displays rule configuration information for the associated rule. 
For more information about viewing rule information, see "Viewing ACL templates." 

 Action—Contains the access control action specified in the associated rule. Actions include 
permit and deny. 

 Source MAC Addr—Contains the source MAC address specified in the associated rule for 
which the action is taken. 

 Destination MAC Addr—Contains the destination MAC address specified in the 
associated rule for which the action is taken. 

Rule info for user-defined ACL 

 No.—This field contains the sequence or rule number for the associated rule in the Rule 
Set. The value in the No. field serves as a link for navigating to the Rule Info page for the 
associated rule. This page displays rule configuration information for the associated rule. 
For more information about viewing rule information, see "Viewing ACL templates." 
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 Action—Contains the access control action specified in the associated rule. Actions include 
permit and deny. 

 Matching String—Contains the hexadecimal string to be matched in a packet, the mask, 
and the offset values for a user-defined pattern-matching rule. 

Time range info 

 No.—Contains the sequence or rule number for the time range specified for the associated 
the Rule Set. 

 Name—Contains the name assigned to the Time Range specified for the associated rule 
set. The value in the Name field serves as a link for navigating to the View Time Range 
page for the associated rule. This page displays time range configuration information for the 
associated rule. 

Viewing the rule information for a rule for an ACL resource 

To view the rule information for a rule for an ACL resource: 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Resource under ACL Management on the left navigation tree. 

The ACL Resource list page opens. 

2. Click the ACL Identifier for the ACL for which you want to view the Rule Set List. 

The Rule Set List is displayed on the main pane of the ACL Resource > <ACL Resource 
Name (ACL Identifier)> page. 

3. Click the name in the Rule Set field for the Rule Set for which you want to view configuration 
information. 

The Rule Set Info is displayed on the main pane of the ACL Resource > <ACL Resource 
Name (ACL Identifier)> > <Rule Set Name> page. 

4. Click the rule No. in the Rule Info of the Rule Set Info page for which you want to view rule 
information. 

The ACL Rule Information page varies based on ACL type. 

Rule Info page for Basic ACL 

The Rule Info page opens on the main pane of the ACL Resource > <ACL Resource Name 
(ACL Identifier)> > <Rule Set Name> > View Basic Rule page. 

The Basic Info field names and explanations include: 

 Action—Contains the access control action specified in the associated rule. Actions include 
permit and deny. 

 Time Range—Contains the time range specified for this rule. 

 Source Address—Contains the source address specified in the associated rule for which 
the action is taken. For example, if the action is to permit IP traffic, this field identifies the 
source IP address from which IP traffic is permitted. 

The Other Settings field names and explanations include: 

 Fragment—Identifies whether or not the rule is configured to apply to all fragments (Yes) or 
to apply to first fragments (No). 

 Logging—Identifies whether or not logging is enabled. 

 VPN Instance—Identifies the VPN instance name for the VPN instance to which this rule is 
applied. The VPN-instance-name argument takes a case sensitive string of 0-31 
characters. If no VPN is specified, the rule applies only to non-VPN packets. 

Rule info page for advanced ACL 

The Rule Info page opens on the main pane of the ACL Resource > <ACL Resource Name 
(ACL Identifier)> > <Rule Set Name> > View Advanced Rule page. 
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The Basic Info field names and explanations include: 

 Protocol—Contains the protocol specified in the associated rule for which the action to be 
taken. If the Protocol is TCP or UDP, the Advanced Settings field displays below the Basic 
Info field. 

 Action—Contains the access control action specified in the associated rule. Actions include 
permit and deny. 

 Time Range—Contains the time range specified for this rule. 

 Source Address—Contains the source address specified in the associated rule for which 
the action is to be taken. For example, if the action is to permit IP traffic, this field identifies 
the source IP address from which IP traffic is permitted. 

 Destination Address—Contains the destination address specified in the associated rule 
for which the action is to be taken. For example, if the action is to permit IP traffic, this field 
identifies the destination IP address to which IP traffic is permitted. 

The Advanced Settings field names and explanations include: 

 Source Port—Contains the source port specified in the associated rule for which the action 
is to be taken. 

 Destination Port—Contains the destination port specified in the associated rule for which 
the action is to be taken. 

The Other Settings field names and explanations include: 

 IP Priority—Contains the IP priority setting for this rule. 

 ToS Value—Contains the type of service setting for this rule. 

 DSCP Value—Contains the differentiated control services protocol value for this rule. 

 Fragment—Identifies whether or not the rule is configured to apply to all fragments (Yes) or 
to apply to first fragments (No). 

 Logging—Identifies whether or not logging is enabled. 

 VPN Instance—Identifies the VPN instance name for the VPN instance to which this rule is 
applied. The VPN-instance-name argument takes a case sensitive string of 0-31 
characters. If no VPN is specified, the rule applies only to non-VPN packets. 

Rule info page for link ACL 

The Rule Info page opens on the main pane of the ACL Resource > <ACL Resource Name (ACL 
Identifier)> > <Rule Set Name> > View Link Rule page. 

The Basic Info field names and explanations include: 

 Protocol—Contains the protocol specified in the associated rule for which the action is taken. If 
the Protocol is TCP or UDP, the Advanced Settings field is displayed below the Basic Info 
field. 

 Action—Contains the access control action specified in the associated rule. Actions include 
permit and deny. 

 Time Range—Contains the time range specified for this rule. 

 Source MAC Addr—Contains the source MAC address specified in the associated rule for 
which the action is taken. 

 Destination MAC Addr—Contains the destination MAC address specified in the 
associated rule for which the action is taken. 

The Other Settings field names and explanations include: 

 802.1 Priority—Contains the priority you want to apply to this ACL rule. 

 Encapsulation Type—Contains the Layer 2 encapsulation type you want to apply to this 
ACL rule. 

 Source VLAN ID—Contains the source VLAN ID. 

 Base Frame Type—Contains the Layer 2 frame type.  
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 Code—If you select Ethernet Frame or 802.2 Ethernet Frame in the Base Frame Type 
field, you must specify a code in the Code field. 

A valid entry for this field includes any four character hexadecimal value. 

 Mask—If you select Ethernet Frame or 802.2 Ethernet Frame in the Base Frame Type 
field, you must also specify a mask in the Mask field. 

A valid entry for this field includes any four character hexadecimal value. 

Rule Info page for user-defined ACL 

 The Rule Info page opens on the main pane of the ACL Resource > <ACL Resource Name 
(ACL Identifier)> > <Rule Set Name> > View User-Defined Rule page. 

The Basic Info field names and explanations include: 

 Action—Contains the access control action specified in the associated rule. Actions include 
permit and deny. 

 Time Range—Contains the time range specified for this rule. 

 Rule String—Contains up to eight hexadecimal patterns, masks, and offsets for matching the 
contents of a packet and applying the actions specified in the rule when a hexadecimal pattern 
is matched. 

Viewing the time range information for a rule for an ACL resource 

To view the time range information for a rule for an ACL resource: 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click the ACL Management on the left navigation tree. 

c. Click ACL Resource under ACL Management on the left navigation tree. 

The ACL Resource list is displayed on the main pane of the ACL Resource page. 

2. Click the ACL Identifier for the ACL for which you want to view the Rules Set List. 

The Rule Set List is displayed on the main pane of the ACL Resource > <ACL Resource 
Name (ACL Identifier)> page. 

3. Click the name in the Rule Set field for the Rule Set for which you want to view configuration 
information. 

The Rule Set Info is displayed on the main pane of the ACL Resource > <ACL Resource 
Name (ACL Identifier)> > <Rule Set Name> page. 

4. Click the rule Name field in the Time Range Info area of the Rule Set Info page for the rule for 
which you want to view time range information. 

The View Time Range page opens on the main pane of the ACL Resource > <ACL Resource 
Name (ACL Identifier)> > <Rule Set Name> > View Time Range page. 

Time range list 

 Start Time—Contains the start of the time range in hours and minutes that the associated 
rule is to be in effect. 

 End Time—Contains the end of the time range in hours and minutes that the associated 
rule is to be in effect. 

 Type—Identifies what type of time range is to be in effect.  

 Execution Period—Identifies the days of the week that the associated time range is to be 
in effect. 

Adding rule sets 

Rule sets are the core of an ACL because they contain the conditions that define how traffic is 
handled by network devices. An ACL can contain one or more rule sets and each rule set can contain 
one or more rules that determine whether or not traffic is to be forwarded. 
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An ACL is defined by its type and an ACL can contain rule sets of the same type only. There are four 
types of ACLs:  

 Basic 

 Advanced 

 Link 

 User-Defined 

Adding a basic rule set 

Basic ACLs enable you to create one or more rules based on source IP addresses or address ranges 
and their subnet masks. A valid numeric range for assigning ACL Identifiers to basic ACLs is 1-99, 
1300-1999, or 2000-2999. When adding a rule set to an ACL, the ACL type automatically defines the 
rule set you can create. 

To add a basic rule set to an ACL resource: 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Resource under ACL Management on the left navigation tree. 

The ACL Resource list page opens. 

2. Click the ACL Identifier for the basic ACL for which you want to create a new rule set. See the 
ACL Type field in the ACL Resource list for identifying ACLs for which the type is Basic. 

The Rule Set List for the select ACL is displayed on the main pane of the ACL Resource > 
<ACL Resource Name (ACL Identifier)> page. 

3. Click Add. 

The Basic Info step of the Add Rule Set page opens. 

Several fields are already configured and cannot be changed. These include the ACL 
Identifier, the ACL Type, and the ACL Resource Name. These parameters cannot be 
changed because they are inherited by the ACL to which this rule set belongs. 

You can create rule sets of the same type as the type of ACL to which the rule set belongs. 

4. Enter a name for the rule set in the Rule Set Name field.  

A valid length for a rule set name is 1–32 characters. 

5. Select the match order you want to apply to this rule set by selecting the Match Order option 
you want to use. 

Options include Config and Auto. If you select Config, IMC matches rules in the order in which 
they were configured, but only works for devices that support it. If you select Auto, IMC 
matches rules based on the principle of depth priority. 

6. Enter a brief description for this ACL in the ACL Description field.  

A valid length for this field is 0–127 characters. 

7. Enter a brief description for this rule set in the Rule Set Description field.  

A valid length for this field is 0–127 characters. 

8. If you want to apply a time range to the rule set, select Configure ACL Rules with Time 
Range. 

9. Click Next. 

10. Do one of the following: 

 If you checked the box to Configure ACL Rules with Time Range, click Add under 
Configure Time Range to add a time range to this rule set. 

 If you do not want to add a time range, skip to step 14. 

11. Enter a name for the time range in the Name field of the Add Time Range page. 
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Time Range names must begin with a letter (A-Z) and consist of 1-32 characters. Blank spaces 
( ) and question marks (?) are not permitted. Uppercase letters may be converted to lowercase 
letters by some devices after deployment. 

12. Click Add to enter a time range. 

The Add Time Range dialog box opens. 

13. Select the type of time range you want to create by selecting the desired time range type: 

 Fixed if you want to identify a specific and finite start and end date and time.  

 Cyclic if you want the time range to recur for select days of the week. 

See "Configuring fixed time ranges" to configure fixed time ranges and "Configuring cyclic 
time ranges" to configure cyclic time ranges. 

14. Click Add on the Configure Rule page to configure a new rule. 

The Add Rule page opens. 

15. Select the action you want to take by selecting the option you want to apply to this rule: 

 Select permit if, upon matching the specified conditions, the packet should be forwarded.  

 Select deny if, upon matching the specified conditions, the packet should be discarded. 

16. Select the time range you want to apply to this rule from the Time Range list you created in the 
step 10. 

17. Select the source IP address option you want to use by selecting the desired option in the 
Source Address field of the Add Rule page. 

This option specifies where the pattern matching occurs in this rule. In this case, the pattern 
matching applies to the source IP address. 

 All—Allows you to permit or deny traffic for all IP addresses. 

 IP Address/Mask—Allows you to enter a specific IP address and its subnet mask for which 
you want to either permit or deny traffic. 

Enter an IP address/subnet mask combination in the IP Address/Mask field. The subnet 
mask must be entered in dotted decimal notation. A valid IP address/subnet mask using 
dotted decimal notation would be 
192.168.1.0/255.255.255.0  

A forward slash "/" must be used to separate the IP address from the subnet mask. 

18. Do one of the following: 

 Select Yes in the Fragment option if you want to apply the rule to each fragment.  

 Select No in the Fragment option if you want to apply the rule to first fragments. 

Traditional packet filtering matched only first fragments of IPv4 packets and allowed all 
subsequent non-first fragments to pass through. This resulted in security risks as hackers can 
fabricate non-first fragments to attack networks. 

19. Select Yes in the Logging option if you want to enable logging for this rule. 

This feature enables the logging of packet filtering only when a module (for example, a firewall) 
is using the ACL supports logging. 

20. Enter the VPN instance you want to apply to this rule by entering the VPN-instance-name in the 
VPN Instance field. 

A valid entry must be 0–31 characters that cannot contain question marks or blank spaces. This 
field is case sensitive. If no VPN instance is specified in this field, the rule applies only to 
non-VPN packets. 

21. Enter the VPN. 

22. Click OK to create the rule you have just configured. 

23. To add more rules, modify, copy, sort, optimize or delete existing rules, select one of the 
following: 

 To add more rules to the ACL, repeat steps 14-21. 
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 To modify rules you have already created, click the Modify icon associated with the rule 
sequence you want to modify. For more information about modifying a rule set, see 
"Managing the rules in a rule set." 

 To copy rules you have already created, click the Copy icon associated with the rule 
sequence you want to copy. For more information about copying a rule set, see "Copying a 
rule in an ACL rule set." 

 Rules that belong to a rule set that is configured with a Match Order of 'Config' are 
executed in the order in which they are displayed in the rule set. The order in which rules are 
displayed in a rule set is initially defined by the order in which they are created. You can 
reorder the rules in a rule set using the Sort feature. For more information about using Sort 
to redefine the order of appearance of rules in a rule set, see "Using sort to reorder the rules 
in an ACL rules set." 

 ACLs can have a profound effect on the performance of networks. ACL Management 
automatically evaluates the effectiveness of rules and their effect on overall network 
performance as you add rules to a rule set. You can also manually perform an analysis of a 
rule set and optimize its effect on network performance using the Optimize feature. For 
more information about using this feature, see "Optimizing the rules in a rule set." 

 To delete one or more rules from a rule set, see "Deleting rules from an ACL rule set." 

24. Click Finish when you have finished creating rules for this rule set. 

Once you have created an ACL you are ready to deploy the ACL to devices using the ACL 
Management's ACL Deployment wizard. For more information about deploying ACLs, see 
"Deploying ACLs using IMC ACL deployment wizard." 

Adding an advanced rule set 

Advanced ACLs enable you to define rules based on Layer three and Layer four information 
including IP source and destination addresses, TCP and UDP port information, as well as protocol 
specific features. A valid numeric range for assigning ACL Identifiers to advanced ACLs is 100-199, 
2000-2699, or 3000-3999. 

To add an advanced rule set to an existing ACL resource: 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Resource under ACL Management on the left navigation tree. 

The ACL Resource list page opens. 

2. Click the ACL Identifier for the advanced ACL for which you want to create a new rule set. See 
the ACL Type field in the ACL Resource list for identifying ACLs for which the type is 
Advanced. 

The Rule Set List for the selected ACL is displayed on the main pane of the ACL Resource > 
<ACL Resource Name (ACL Identifier)> page. 

3. Click Add. 

The Basic Info step of the Add Rule Set page opens. 

Several fields are already configured and cannot be changed. These include the ACL 
Identifier, the ACL Type, and the ACL Resource Name. These cannot be changed because 
they are inherited by the ACL to which this rule set belongs. 

You can create rule sets of the same type as the type of ACL to which the rule set belongs. 

4. Enter a name for the rule set in the Rule Set Name field.  

A valid length for a rule set name is 1–32 characters. 

5. Select the match order you want to apply to this rule set by selecting the Match Order option 
you want to use. Options include: 
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 Config—IMC matches rules in the order in which they were configured. This feature works 
only for devices that support it. 

 Auto—IMC matches rules based on the principle of depth priority. 

6. Enter a brief description for this ACL in the ACL Description field. 

A valid length for this field is 0–127 characters. 

7. Enter a brief description for this rule set in the Rule Set Description field. 

A valid length for this field is 0–127 characters. 

8. Do one of the following: 

 If you select Configure ACL Rules with Time Range, click Add under Configure Time 
Range to add a time range to this rule set. 

 If you do not want to add a time range, skip to Step 12. 

9. Enter a name for the time range in the Name field of the Add Time Range page. 

Time Range names must begin with a letter (A-Z) and consist of 1-32 characters. Blank spaces 
( ) and question marks (?) are not permitted. Uppercase letters may be converted to lowercase 
letters by some devices after deployment. 

10. Click Add to enter a time range. 

The Add Time Range dialog box opens. 

11. Select the type of time range you want to create by selecting the desired time range type: 

 Fixed if you want to identify a specific and finite start and end date and time. 

 Cyclic if you want the time range to recur for select days of the week. 

12. Click Add on the Configure Rule page to configure a new rule. 

13. See "Configuring fixed time ranges" to configure fixed time ranges and "Configuring cyclic time 
ranges" to configure cyclic time ranges. 

14. Select the protocol for which you want to permit or deny traffic from the Protocol list. 

15. Select the action you want to take by selecting the option you want to apply to this rule: 

 Select permit if, upon matching the specified conditions, the packet should be forwarded. 

 Select deny if, upon matching the specified conditions, the packet should be discarded. 

16. Select the time range you want to apply to this rule from the Time Range list you created in the 
step 10. 

17. Select the source IP address option you want to use by selecting the desired option in the 
Source Address of the Configure Rule - Add Rule page. 

This option specifies where the pattern matching occurs in this rule. In this case, the pattern 
matching is applied to the source IP address. 

 All—Allows you to permit or deny traffic for all IP addresses. 

 IP Address/Mask—Allows you to enter a specific IP address and its subnet mask for which 
you want to either permit or deny traffic. 

Enter an IP address/subnet mask combination in the IP Address/Mask field. The subnet 
mask must be entered in dotted decimal notation. A valid IP address/subnet mask using 
dotted decimal notation would be 
192.168.1.0/255.255.255.0  

A forward slash "/" must be used to separate the IP address from the subnet mask. 

18. Select the destination IP address option you want to use by selecting the desired option in the 
Destination Address portion of the Configure Rule - Add Rule page. 

This option specifies where the pattern matching occurs in this rule. In this case, the pattern 
matching is applied to the destination IP address. 

 All—Allows you to permit or deny traffic for all IP addresses. 

 IP Address/Mask—Allows you to enter a specific IP address and its subnet mask for which 
you want to either permit or deny traffic. 
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Enter an IP address/subnet mask combination in the IP Address/Mask field. The subnet 
mask must be entered in dotted decimal notation. A valid IP address/subnet mask using 
dotted decimal notation would be: 
192.168.1.0/255.255.255.0  

A forward slash "/" must be used to separate the IP address from the subnet mask. 

19. If you selected TCP or UDP as the protocol to which this ACL rule applies, you must also 
specify the source TCP or UDP port numbers: 

a. Select the source TCP or UDP port by selecting the port option you want to apply in the 
Source Port portion of the Configure Rule - Add Rule page: 

 Undefined—Allows you to permit or deny traffic for all TCP or UDP port numbers. 

 Specified Port—Allows you to identify a specific TCP or UDP port number or range of 
numbers.  

b. Select Specified Port and select the operator you want to use from the list next to the 
Specified Port option. 

c. Enter the TCP or UDP port number in the Port field. 

20. If you selected TCP or UDP as the protocol to which this ACL rule applies, you must also 
specify the destination TCP or UDP port numbers: 

a. Select the destination TCP or UDP port by selecting the port option you want to apply in the 
Destination Port portion of the Configure Rule - Add Rule page: 

 Undefined—Allows you to permit or deny traffic for all TCP or UDP port numbers. 

 Specified Port—Allows you to identify a specific TCP or UDP port number or range of 
numbers.  

b. Select Specified Port and select the operator you want to use from the list next to the 
Specified Port option. 

c. Enter the TCP or UDP port number in the Port field. 

21. If you selected TCP or UDP as the protocol you want to apply this ACL rule to in step 14, you 
could be prompted to select these options: 

 Select Yes in the HP ACK option if you want to apply the rule to match the TCP ACK, 
otherwise select No. 

 Select Yes in the HP FIN option if you want to apply the rule to match the TCP FIN, 
otherwise select No. 

 Select Yes in the HP RST option if you want to apply the rule to match the TCP RST, 
otherwise select No. 

 Select Yes in the HP SYN option if you want to apply the rule to match the TCP SYN, 
otherwise select No. 

The HP ACK, HP FIN, HP RST, or HP SYN settings are valid only for the HPE E series 
devices. 

22. Select the IP priority you want to apply to ACL from the IP Priority list.  

23. Select the Type of Service for this ACL from the TOS Value list.  

24. Select the DSCP value you want to apply to this ACL from the DSCP Value list.  

25. Do one of the following: 

Select Yes in the Fragment option if you want to apply the rule to each fragment. 

Select No in the Fragment option if you want to apply the rule to first fragments. 

Traditional packet filtering matched only first fragments of IPv4 packets and allowed all 
subsequent non-first fragments to pass through. This resulted in security risks as hackers can 
fabricate non-first fragments to attack networks. 

26. Select Yes in the Logging option if you want to enable logging for this rule. 

This feature enables the logging of packet filtering only when a module (for example, a firewall) 
using the ACL supports logging. 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 9233



832 

27. Enter the VPN instance you want to apply to this rule by entering the VPN-instance-name in the 
VPN Instance field. 

A valid entry must be 0–31 characters that cannot contain question marks or blank spaces. This 
field is case sensitive. If no VPN instance is specified in this field, the rule applies to non-VPN 
packets only. 

28. Click OK to create the rule you have just configured. 

29. To add more rules, modify, copy, sort, optimize or delete existing rules, select one of the 
following: 

 To add more rules to the ACL, repeat steps 12-28. 

 To modify rules you have already created, click the Modify icon  associated with the rule 
sequence you want to modify. For more information about modifying a rule set, see "Adding 
or modifying rules in a rule set." 

 To copy rules you have already created, click the Copy icon  associated with the rule 
sequence you want to copy. For more information about copying a rule set, see "Copying a 
rule in an ACL rule set." 

Rules that belong to a rule set that is configured with a Match Order of Config are executed 
in the order in which they are displayed in the rule set. The order in which rules are 
displayed in a rule set is initially defined by the order in which they are created. You can 
reorder the rules in a rule set using the Sort feature. For more information about using Sort 
to redefine the order of appearance of rules in a rule set, see "Using sort to reorder the rules 
in an ACL rules set." 

ACLs can have a profound effect on the performance of networks. ACL Management 
automatically evaluates the effectiveness of rules and their effect on overall network 
performance as you add rules to a rule set. However, you can also manually perform an 
analysis of a rule set and optimize its effect on network performance using the Optimize 
feature. For more information about using this feature, see "Optimizing the rules in a rule 
set." 

 To delete one or more rules from a rule set, see "Deleting rules from an ACL rule set." 

30. Click Finish when you have finished creating rules for this rule set. 

Once you have created an ACL you are ready to deploy the ACL to devices using the ACL 
Management's ACL Deployment wizard. For more information about deploying ACLs, see 
"Deploying ACLs using IMC ACL deployment wizard." 

Adding a link rule set 

Link ACLs enable you to define rules based on Layer 2 information including MAC source and 
destination addresses, VLAN priority information as well as link layer protocol type. 

When you add a rule set to an existing ACL, the ACL type automatically defines the rule set you 
create. 

To add a link rule set to an existing ACL resource: 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Resource under ACL Management on the left navigation tree. 

The ACL Resource list page opens. 

2. Click the ACL Identifier for the link ACL for which you want to create a new rule set. See the 
ACL Type field in the ACL Resource list for identifying ACLs for which the type is Link. 

The Rule Set List is displayed on the main pane of the ACL Resource > <ACL Resource 
Name (ACL Identifier)> page. 

3. Click Add. 

The Basic Info step of the Add Rule Set page opens. 
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Several fields are already configured and cannot be changed. These include the ACL 
Identifier, ACL Type, and ACL Resource Name. These cannot be changed because they are 
inherited by the ACL to which this rule set belongs. 

You can create rule sets of the same type as the type of ACL to which the rule set belongs. 

4. Enter a name for the rule set in the Rule Set Name field.  

A valid length for a rule set name is 1–32 characters. 

5. Select the match order you want to apply to this rule set by selecting the Match Order option 
you want to use. 

Options include Config and Auto: 

 If you select Config, IMC matches rules in the order in which they were configured. 
However, this feature works only for devices that support it. 

 If you select Auto, IMC matches rules based on the principle of depth priority. 

6. Enter a brief description for this ACL in the ACL Description field.  

A valid length for this field is 0–127 characters. 

7. Enter a brief description for this rule set in the Rule Set Description field.  

A valid length for this field is 0–127 characters. 

8. If you want to apply a time range to the rule set, select Configure ACL Rules with Time 
Range. 

9. Click Next. 

10. If you checked the box to Configure ACL Rules with Time Range, click Add under Configure 
Time Range to add a time range to this rule set. If you do not want to add a time range, skip to 
step 14. 

11. Enter a name for the time range in the Name field of the Add Time Range page. 

Time Range names must begin with a letter (A-Z) and consist of 1-32 characters. Blank spaces 
( ) and question marks (?) are not permitted. Uppercase letters may be converted to lowercase 
letters by some devices after deployment. 

12. Click Add to enter a time range. 

The Add Time Range dialog box opens. 

13. Select the type of time range you want to create by selecting the desired time range type: 

 Fixed if you want to identify a specific and finite start and end date and time.  

 Cyclic if you want the time range to recur for select days of the week.  

14. Click Add on the Configure Rule page to configure a new rule. 

See "Configuring fixed time ranges" to configure fixed time ranges and "Configuring cyclic time 
ranges" to configure cyclic time ranges. 

The Configure Rule–Add Rule page opens. 

15. Select the action you want to take by selecting the option you want to apply to this rule: 

 Select permit if, upon matching the specified conditions, the packet should be forwarded.  

 Select deny if, upon matching the specified conditions, the packet should be discarded. 

16. Select the time range you want to apply to this rule from the Time Range list you created in the 
step 10. 

17. Select the source MAC address option you want to use by selecting the desired option in the 
Source MAC Addr section of the Configure Rule–Add Rule page. 

This option specifies where the pattern matching occurs in this rule. In this case, the pattern 
matching is applied to the source MAC address. 

 All—Allows you to permit or deny traffic for all MAC addresses. 

 MAC Address/Mask—Allows you to enter a specific MAC address and mask for which you 
want to either permit or deny traffic. 
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A valid MAC address format for IMC consists of three sets of four hexadecimal characters 
separated by a dash, "-". For example, 
0014-2ad9-05f7  

would be a valid entry for a MAC address in IMC. 

Similarly, the format for a MAC address mask consists of three sets of four hexadecimal 
characters separated by a dash, "-". For example, 
ffff-ffff-ffff  

would be a valid entry for a MAC address mask in IMC. 

The MAC address and its mask must be separated by a forward slash, "/". 

A valid entry for a MAC Address/Mask would be 
0014-2ad9-05f7/ffff-ffff-ffff  

18. Select the destination MAC address option you want to use by selecting the desired option in 
the Destination MAC Address of the Configure Rule — Add Rule page. 

This option specifies where the pattern matching occurs in this rule. In this case, the pattern 
matching is applied to the destination MAC address. Options include: 

 All—Allows you to permit or deny traffic for all MAC addresses. 

 MAC Address/Mask—Allows you to identify a specific MAC address and its mask for which 
you want to either permit or deny traffic. 

A valid MAC address format for IMC consists of three sets of four hexadecimal characters 
separated by a dash, "-". For example, 
0014-2ad9-05f7  

would be a valid entry for a MAC address in IMC. 

Similarly, the format for a MAC address mask consists of three sets of four hexadecimal 
characters separated by a dash, "-". For example, 
ffff-ffff-ffff  

would be a valid entry for a MAC address mask in IMC. 

The MAC address and its mask must be separated by a forward slash, "/". 

A valid entry for a MAC Address/Mask would be 
0014-2ad9-05f7/ffff-ffff-ffff  

19. Select the 802.1 priority you want to apply to this ACL rule from the 802.1 Priority list. 

20. Select the Layer 2 encapsulation type you want to apply to this ACL rule from the 
Encapsulation Type list. 

Options include Undefined, Ethernet II, SNAP, IEEE 802.2/802.3, and IEEE 802.3. 

21. Enter the source VLAN ID by entering it in the Source VLAN ID field.  

This field cannot contain question marks or blank spaces. 

22. Select the Layer 2 frame type from the Based Frame Type list. 

Options include Undefined, Ethernet Frame, and 802.2 Ethernet Frame. 

23. If you select Ethernet Frame or 802.2 Ethernet Frame in the Base Frame Type list, you must 
specify a code in the Code field. 

A valid entry for this field includes any four character hexadecimal value. 

24. If you select Ethernet Frame or 802.2 Ethernet Frame in the Base Frame Type list, you must 
also specify a mask in the Mask field. 

A valid entry for this field includes any four character hexadecimal value. 

25. Click OK to create the rule you have just configured. 

26. To add more rules, modify, copy, sort, optimize or delete existing rules, select one of the 
following: 

 To add more rules to the ACL, repeat steps 14-25. 
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 To modify rules you have already created, click the Modify icon  associated with the rule 
sequence you want to modify. For more information about modifying a rule set, see "Adding 
or modifying rules in a rule set." 

 To copy rules you have already created, click the Copy icon  associated with the rule 
sequence you want to copy. For more information about copying a rule set, see "Copying a 
rule in an ACL rule set."  

Rules that belong to a rule set that is configured with a Match Order of 'Config' are 
executed in the order in which they are displayed in the rule set. The order in which rules are 
displayed in a rule set is initially defined by the order in which they are created. You can 
reorder the rules in a rule set using the Sort feature. For more information about using Sort 
to redefine the order of appearance of rules in a rule set, see "Using sort to reorder the rules 
in an ACL rules set."  

ACLs can have a profound effect on the performance of networks. ACL Management 
automatically evaluates the effectiveness of rules and their effect on overall network 
performance as you add rules to a rule set. However, you can also manually perform an 
analysis of a rule set and optimize its effect on network performance using the Optimize 
feature. For more information about using this feature, see "Optimizing the rules in a rule 
set." 

 To delete one or more rules from a rule set, see "Deleting rules from an ACL rule set." 

27. Click Finish when you have finished creating rules for this rule set. 

Once you have created an ACL you are ready to deploy the ACL to devices using the ACL 
Management's ACL Deployment wizard. For more information about deploying ACLs, see 
"Deploying ACLs using IMC ACL deployment wizard." 

Adding a user-defined rule set 

User-Defined ACLs enable you to define a hexadecimal pattern and mask and the offset in the 
packet header that identifies where to begin the pattern matching. When a pattern is matched, the 
conditions of the rule in the ACL are applied. A valid numeric range for assigning ACL Identifiers to 
user-defined ACLs is 5000-5999. 

To add a user-defined rule set to an existing ACL resource: 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Resource under ACL Management on the left navigation tree. 

The ACL Resource list page opens. 

2. Click the ACL Identifier for the user-defined ACL for which you want to create a new rule set. 
See the ACL Type field in the ACL Resource list for identifying ACLs for which the type is 
'User-Defined'. 

The Rule Set List is displayed on the main pane of the ACL Resource > <ACL Resource 
Name (ACL Identifier)> page. 

3. Click Add. 

The Basic Info step of the Add Rule Set page opens. 

Several fields are already configured and cannot be changed. These include the ACL 
Identifier, the ACL Type, and the ACL Resource Name. These cannot be changed because 
they are inherited by the ACL to which this rule set belongs. 

You can create rule sets of the same type as the type of ACL to which the rule set belongs. 

4. Enter a name for the rule set in the Rule Set Name field.  

A valid length for a rule set name is 1–32 characters. 

5. Select the match order you want to apply to this rule set by selecting the Match Order option 
you want to use. 
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Options include Config and Auto: 

 If you select Config, IMC matches rules in the order in which they were configured and only 
works for devices that support it. 

 If you select Auto, IMC matches rules based on the principle of depth priority. 

6. Enter a brief description for this ACL in the ACL Description field.  

A valid length for this field is 0–127 characters. 

7. Enter a brief description for this rule set in the Rule Set Description field.  

A valid length for this field is 0–127 characters. 

8. If you want to apply a time range to the rule set, select Configure ACL Rules with Time 
Range. 

9. Click Next. 

10. If you checked the box to Configure ACL Rules with Time Range, click Add under Configure 
Time Range to add a time range to this rule set. If you do not want to add a time range, skip to 
step 14. 

11. Enter a name for the time range in the Name field of the Add Time Range page. 

Time Range names must begin with a letter (A-Z) and consist of 1-32 characters. Blank spaces 
( ) and question marks (?) are not permitted. Uppercase letters may be converted to lowercase 
letters by some devices after deployment. 

12. Click Add to enter a time range. 

The Add Time Range dialog box opens. 

13. Select the type of time range you want to create by selecting the desired time range type: 

 Fixed if you want to identify a specific and finite start and end date and time.  

 Cyclic if you want the time range to recur for selected days of the week.  

14. Click Add on the Configure Rule page to configure a new rule. 

The Configure Rule–Add Rule page opens. 

See "Configuring fixed time ranges" to configure fixed time ranges and "Configuring cyclic time 
ranges" to configure cyclic time ranges. 

15. Select the action you want to take by selecting the option to apply to this rule. 

 Select permit if, upon matching the specified conditions, the packet should be forwarded.  

 Select deny if, upon matching the specified conditions, the packet should be discarded. 

16. Select the time range you want to apply to this rule from the Time Range list you created in the 
step 10. 

17. Enter up to eight hexadecimal patterns, masks, and offsets for matching the contents of a 
packet and applying the actions specified in the rule when a hexadecimal pattern is matched. 

The following rules and guidelines apply to constructing a valid hexadecimal string, mask, and 
offset value. 

 A rule string must be expressed in hexadecimal only. 

 A mask must be expressed in hexadecimal only. 

 A rule string length must be equal to its mask length. 

 Rule string and mask length must be in multiples of 2. 

 The minimum length of a rule string and mask is 2. 

 The maximum length of a rule string and mask is 160. 

 Offsets must be expressed as a decimal integer. 

 Offset range varies by the mask length. 

 The minimum value for an offset is 0. 

 The maximum value for an offset is 79. 
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 The offset must increase progressively. 

Enter a hexadecimal pattern to be matched in the Rule String field. 

Enter a mask in the Mask field. 

Enter the offset in the Excursion field. 

Enter up to eight Rule String/Mask/Excursion combinations. 

18. Click OK to create the rule you have just configured. 

19. To add more rules, modify, copy, sort, optimize or delete existing rules, select one of the 
following: 

 To add more rules to the ACL, repeat steps 14-18. 

 To modify rules you have already created, click the Modify icon  associated with the rule 
sequence you want to modify. For more information about modifying a rule set, see "Adding 
or modifying rules in a rule set."  

 To copy rules you have already created, click the Copy icon  associated with the rule 
sequence you want to copy. For more information about copying a rule set, see "Copying a 
rule in an ACL rule set."  

Rules that belong to a rule set that is configured with a Match Order of 'Config' are 
executed in the order in which they are displayed in the rule set. The order in which rules are 
displayed in a rule set is initially defined by the order in which they are created. You can 
reorder the rules in a rule set using the Sort feature. For more information about using Sort 
to redefine the order of appearance of rules in a rule set, see "Using sort to reorder the rules 
in an ACL rules set."  

ACLs can have a profound effect on the performance of networks. ACL Management 
automatically evaluates the effectiveness of rules and their effect on overall network 
performance as you add rules to a rule set. However, you can also manually perform an 
analysis of a rule set and optimize its effect on network performance using the Optimize 
feature. For more information about using this feature, see "Optimizing the rules in a rule 
set."  

 To delete one or more rules from a rule set, see "Deleting rules from an ACL rule set." 

20. Click Finish when you have finished creating rules for this rule set. 

Once you have created an ACL you are ready to deploy the ACL to devices using the ACL 
Management's ACL Deployment wizard. For more information about deploying ACLs, see 
"Deploying ACLs using IMC ACL deployment wizard." 

Modifying ACL rule sets 

Many of the parameters used to create a rule set can be changed using the modify option for all of 
the ACL rule types. 

Modifying a basic rule set 

To modify the basic rule set of an existing ACL resource: 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Resource under ACL Management on the left navigation tree. 

The ACL Resource list page opens. 

2. Click the ACL Identifier for the basic ACL for which you want to modify a rule. See the ACL 
Type field in the ACL Resource list for identifying ACLs for which the type is Basic. 

The Rule Set List for the select ACL is displayed on the main pane of the ACL Resource > 
<ACL Resource Name (ACL Identifier)> page. 

3. Click the Modify icon  in the field associated with the rule set you want to modify. 
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The Basic Info step of the Modify Rule Set page opens. 

Several fields cannot be changed. These include ACL Identifier, ACL Type, ACL Resource 
Name, Rule Set Name, and Match Order. 

4. Modify the description for this ACL as needed in the ACL Description field. 

A valid length for this field is 0–127 characters. 

5. Modify the description for this rule set as needed in the Rule Set Description field.  

A valid length for this field is 0–127 characters. 

6. Click Next. The Configure Time Range step of the Modify Rule Set page opens. 

7. If you do not want to modify or add a time range, click Next and skip to step 8. 

 To modify an existing time range, click the Modify icon  in the Modify field of the time 
range table, the Modify Time Range page is displayed. Modification options include adding 
new time ranges or deleting existing time ranges. 

 To modify the time range name, enter a new name for the time range in the Name field of the 
Modify Time Range page. Time Range names must begin with a letter (A-Z) and consist of 
1-32 characters. Blank spaces ( ) and question marks (?) are not permitted. Uppercase 
letters may be converted to lowercase letters by some devices after deployment. 

 To configure a new time range item, click Add under the Time Range Items and follow the 
instructions below. 

The Add Time Range dialog box opens. 

8. Select the type of time range you want to create by selecting the desired time range type: 

 Fixed if you want to identify a specific and finite start and end date and time.  

 Cyclic if you want the time range to recur for select days of the week. 

See "Configuring fixed time ranges" to configure fixed time ranges and "Configuring cyclic 
time ranges" to configure cyclic time ranges. 

9. Do one of the following: 

 To add a new rule click Add on the Configure Rule page to configure a new rule 

The Add Rule page opens. 

 To modify an existing rule, click the Modify icon  in the Modify field associated with the 
rule you want to modify. 

10. Select the action you want to take by selecting the option you want to apply to this rule: 

 Select permit if, upon matching the specified conditions, the packet should be forwarded.  

 Select deny if, upon matching the specified conditions, the packet should be discarded. 

11. Select the time range you want to apply to this rule from the Time Range list you created in the 
step 7. 

12. Select the source IP address option you want to use by selecting the desired option in the 
Source Address field of the Add Rule page. 

This option specifies where the pattern matching occurs in this rule. In this case, the pattern 
matching applies to the source IP address. 

 All—Allows you to permit or deny traffic for all IP addresses. 

 IP Address/Mask—Allows you to enter a specific IP address and its subnet mask for which 
you want to either permit or deny traffic. 

Enter an IP address/subnet mask combination in the IP Address/Mask field. The subnet 
mask must be entered in dotted decimal notation. A valid IP address/subnet mask using 
dotted decimal notation would be 
192.168.1.0/255.255.255.0  

A forward slash "/" must be used to separate the IP address from the subnet mask. 

13. Do one of the following: 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 9240



839 

 Select Yes in the Fragment option if you want to apply the rule to each fragment.  

 Select No in the Fragment option if you want to apply the rule to first fragments. 

Traditional packet filtering matched only first fragments of IPv4 packets and allowed all 
subsequent non-first fragments to pass through. This resulted in security risks as hackers can 
fabricate non-first fragments to attack networks. 

14. Select Yes in the Logging option if you want to enable logging for this rule. 

This feature enables the logging of packet filtering only when a module (for example, a firewall) 
is using the ACL supports logging. 

15. Enter the VPN instance you want to apply to this rule by entering the VPN-instance-name in the 
VPN Instance field. 

A valid entry must be 0–31 characters that cannot contain question marks or blank spaces. This 
field is case sensitive. If no VPN instance is specified in this field, the rule applies only to 
non-VPN packets. 

16. Click OK to create the rule you have just configured or to accept the modifications to the 
existing rule. 

17. To add more rules, modify, copy, sort, optimize or delete existing rules, select one of the 
following: 

 To add more rules to the ACL, repeat steps 9-16. 

 To copy rules you have already created, click the Copy icon  associated with the rule 
sequence you want to copy. For more information about copying a rule set, see "Copying a 
rule in an ACL rule set."  

 Rules that belong to a rule set that is configured with a Match Order of 'Config' are 
executed in the order in which they are displayed in the rule set. The order in which rules are 
displayed in a rule set is initially defined by the order in which they are created. You can 
reorder the rules in a rule set using the Sort feature. For more information about using Sort 
to redefine the order of appearance of rules in a rule set, see "Using sort to reorder the rules 
in an ACL rules set." 

 ACLs can have a profound effect on the performance of networks. ACL Management 
automatically evaluates the effectiveness of rules and their effect on overall network 
performance as you add rules to a rule set. You can also manually perform an analysis of a 
rule set and optimize its effect on network performance using the Optimize feature. For 
more information about using this feature, see "Optimizing the rules in a rule set." 

 To delete one or more rules from a rule set, see "Deleting rules from an ACL rule set." 

18. Click Finish when you have finished modifying this rule set. 

Modifying an advanced rule set 

To modify the advanced rule set of an existing ACL: 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Resource under ACL Management on the left navigation tree. 

The ACL Resource list page opens. 

2. Click the ACL Identifier for the advanced ACL for which you want to modify a rule. See the 
ACL Type field in the ACL Resource list for identifying ACLs for which the type is Advanced. 

The Rule Set List for the select ACL is displayed on the main pane of the ACL Resource > 
<ACL Resource Name (ACL Identifier)> page. 

3. Click the Modify icon  in the field associated with the rule set you want to modify. 

The Basic Info step of the Modify Rule Set page opens. 

Several fields cannot be changed. These include the ACL Identifier, the ACL Type, the ACL 
Resource Name, the Rule Set Name, and the Match Order. 
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4. Modify the description for this ACL as needed in the ACL Description field.  

A valid length for this field is 0 – 127 characters. 

5. Modify the description for this rule set as needed in the Rule Set Description field. 

A valid length for this field is 0–127 characters. 

6. Click Next.  

The Configure Time Range step of the Modify Rule Set page opens. 

7. Do one of the following: 

 If you do not want to modify or add a time range, click Next and skip to step 9. 

 If you want to modify an existing time range, click the Modify icon  in the Modify field of 
the time range table, the Modify Time Range page opens.  

Modification options include adding new time ranges or deleting existing time ranges. 

a. To modify the time range name, enter a new name for the time range in the Name field of 
the Modify Time Range page and skip to step 9. 

Time Range names must begin with a letter (A-Z) and consist of 1-32 characters. Blank 
spaces ( ) and question marks (?) are not permitted. Uppercase letters may be converted to 
lowercase letters by some devices after deployment. 

b. To configure a new time range item, click Add under the Time Range Items section. 

The Add Time Range dialog box opens. 

c. Select the type of time range you want to create by selecting the desired time range type: 

 Select Fixed if you want to identify a specific and finite start and end date and time. 

 Select Cyclic if you want the time range to recur for selected days of the week.  

8. To add a new rule, click Add on the Configure Rule page to configure a new rule. 

The Add Rule page opens. 

9. To modify an existing rule, click the Modify icon  in the Modify field associated with the rule 
you want to modify. 

10. Select the action you want to take by selecting the option you want to apply to this rule: 

 Select permit if, upon matching the specified conditions, the packet should be forwarded. 

 Select deny if, upon matching the specified conditions, the packet should be discarded. 

11. Select the time range you want to apply to this rule from the Time Range list you created in the 
step 7. 

12. Select the protocol for which you want to permit or deny traffic from the Protocol list. 

13. Select the source IP address option you want to use by selecting the desired option in the 
Source Address of the Configure Rule - Modify Rule page. 

This option specifies where the pattern matching occurs in this rule. In this case, the pattern 
matching is applied to the source IP address. 

 All—Allows you to permit or deny traffic for all IP addresses. 

 IP Address/Mask—Allows you to enter a specific IP address and its subnet mask for which 
you want to either permit or deny traffic. 

14. Enter an IP address/subnet mask combination in the IP Address/Mask field. The subnet mask 
must be entered in dotted decimal notation. A valid IP address/subnet mask using dotted 
decimal notation would be 
192.168.1.0/255.255.255.0  

A forward slash "/" must be used to separate the IP address from the subnet mask. 

15. Select the destination IP address option you want to use by selecting the desired option in the 
Destination Address portion of the Configure Rule - Modify Rule page. 

This option specifies where the pattern matching occurs in this rule. In this case, the pattern 
matching is applied to the destination IP address. 
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 All—Allows you to permit or deny traffic for all IP addresses. 

 IP Address/Mask—Allows you to enter a specific IP address and its subnet mask for which 
you want to either permit or deny traffic. 

Enter an IP address/subnet mask combination in the IP Address/Mask field. The subnet 
mask must be entered in dotted decimal notation. A valid IP address/subnet mask using 
dotted decimal notation would be: 
192.168.1.0/255.255.255.0  

A forward slash "/" must be used to separate the IP address from the subnet mask. 

16. If you select TCP or UDP as the protocol to apply this ACL rule to in step 12, you must also 
specify the source TCP or UDP port numbers: 

a. Select the source TCP or UDP port by selecting the port option you want to apply in the 
Source Port portion of the Configure Rule - Modify Rule page: 

 Undefined—Allows you to permit or deny traffic for all TCP or UDP port numbers. 

 Specified Port—Allows you to identify a specific TCP or UDP port number or range of 
numbers.  

b. Select Specified Port and select the operator you want to use from the list next to the 
Specified Port option. 

c. Enter the TCP or UDP port number in the Port field. 

17. If you select TCP or UDP as the protocol to apply this ACL rule to, you must also specify the 
destination TCP or UDP port numbers: 

a. Select the source TCP or UDP port by selecting the port option you want to apply in the 
Destination Port portion of the Configure Rule - Modify Rule page: 

 Undefined—Allows you to permit or deny traffic for all TCP or UDP port numbers. 

 Specified Port—Allows you to identify a specific TCP or UDP port number or range of 
numbers.  

b. Select Specified Port and select the operator you want to use from the list next to the 
Specified Port option. 

c. Enter the TCP or UDP port number in the Port field. 

18. If you select TCP or UDP as the protocol you want to apply this ACL rule to in step 12, you could 
be prompted to select these options: 

 Select Yes in the HP ACK option if you want to apply the rule to match the TCP ACK, 
otherwise select No. 

 Select Yes in the HP FIN option if you want to apply the rule to match the TCP FIN, 
otherwise select No. 

 Select Yes in the HP RST option if you want to apply the rule to match the TCP RST, 
otherwise select No. 

 Select Yes in the HP SYN option if you want to apply the rule to match the TCP SYN, 
otherwise select No. 

The HP ACK, HP FIN, HP RST, or HP SYN settings are valid only for the HPE E series 
devices. 

19. Select the IP priority you want to apply to ACL from the IP Priority list.  

20. Select the Type of Service for this ACL from the TOS Value list.  

21. Select the DSCP value you want to apply to this ACL from the DSCP Value list.  

22. Do one of the following: 

 Select Yes in the Fragment option if you want to apply the rule to each fragment. 

 Select No in the Fragment option if you want to apply the rule to first fragments. 

Traditional packet filtering matched only first fragments of IPv4 packets and allowed all 
subsequent non-first fragments to pass through. This resulted in security risks as hackers can 
fabricate non-first fragments to attack networks. 
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23. Select Yes in the Logging option if you want to enable logging for this rule. 

This feature enables the logging of packet filtering only when a module (for example, a firewall) 
using the ACL supports logging. 

24. Enter the VPN instance you want to apply to this rule by entering the VPN-instance-name in the 
VPN Instance field. 

A valid entry must be 0–31 characters that cannot contain question marks or blank spaces. This 
field is case sensitive. If no VPN instance is specified in this field, the rule applies to non-VPN 
packets only. 

25. Click OK to create the rule you have just configured or to accept the modifications to the 
existing rule. 

26. Select from the following to add more rules, copy, sort, optimize, or delete existing rules: 

 To add more rules to the ACL, repeat steps 8-25. 

 To copy rules you have already created, click the Copy icon  associated with the rule 
sequence you want to copy. For more information about copying a rule set, see "Copying a 
rule in an ACL rule set." 

 Rules that belong to a rule set that is configured with a Match Order of Config are executed 
in the order in which they are displayed in the rule set. The order in which rules are 
displayed in a rule set is initially defined by the order in which they are created. You can 
reorder the rules in a rule set using the Sort feature. For more information about using Sort 
to redefine the order of appearance of rules in a rule set, see "Using sort to reorder the rules 
in an ACL rules set." 

 ACLs can have a profound effect on the performance of networks. ACL Management 
automatically evaluates the effectiveness of rules and their effect on overall network 
performance as you add rules to a rule set. However, you can also manually perform an 
analysis of a rule set and optimize its effect on network performance using the Optimize 
feature. For more information about using this feature, see "Optimizing the rules in a rule 
set." 

 To delete one or more rules from a rule set, see "Deleting rules from an ACL rule set." 

27. Click Finish when you have finished modifying this rule set. 

Modifying a link rule set 

To modify the link rule set of an existing ACL: 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Resource under ACL Management on the left navigation tree. 

The ACL Resource list page opens. 

2. Click the ACL Identifier for the link ACL for which you want to create a new rule set. See the 
ACL Type field in the ACL Resource list for identifying ACLs for which the type is Link. 

The Rule Set List is displayed on the main pane of the ACL Resource > <ACL Resource 
Name (ACL Identifier)> page. 

3. Click the Modify icon  for the rule set you want to modify. 

Several fields cannot be changed. These include ACL Identifier, ACL Type, ACL Resource 
Name, Rule Set Name, and Match Order. 

4. Modify the description for this ACL as needed in the ACL Description field.  

A valid length for this field is 0–127 characters. 

5. Modify the description for this rule set as needed in the Rule Set Description field.  

A valid length for this field is 0–127 characters. 

6. Click Next.  
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The Configure Time Range step of the Modify Rule Set page opens. 

7. Do one of the following: 

 If you do not want to modify or add a time range, click Next and skip to step 8. 

 If you want to modify an existing time range, click the Modify icon  in the Modify field of 
the time range table, the Modify Time Range page opens. 

Modification options include adding new time ranges or deleting existing time ranges. 

8. Enter a name for the time range in the Name field of the Modify Time Range page. 

Time Range names must begin with a letter (A-Z) and consist of 1-32 characters. Blank spaces 
( ) and question marks (?) are not permitted. Uppercase letters may be converted to lowercase 
letters by some devices after deployment. 

To configure a new time range item, click Add under the Time Range Items and the Add Time 
Range dialog box opens. 

Select the type of time range you want to create by selecting the desired time range type.  

 Select Fixed if you want to identify a specific and finite start and end date and time.  

 Select Cyclic if you want the time range to recur for select days of the week.  

9. To add a new rule click Add on the Configure Rule page to configure a new rule. 

The Add Rule page opens. 

10. To modify an existing rule, click the Modify icon  in the Modify field associated with the rule 
you want to modify. 

11. Select the action you want to take by selecting the option you want to apply to this rule: 

 Select permit if, upon matching the specified conditions, the packet should be forwarded.  

 Select deny if, upon matching the specified conditions, the packet should be discarded. 

12. Select the time range you want to apply to this rule from the Time Range list you created in the 
step 7. 

13. Select the source MAC address option you want to use by selecting the desired option in the 
Source MAC Addr of the Configure Rule–Modify Rule page. 

This option specifies where the pattern matching occurs in this rule. In this case, the pattern 
matching is applied to the source MAC address. 

 All—Allows you to permit or deny traffic for all MAC addresses. 

 MAC Address/Mask—Allows you to enter a specific MAC address and mask for which you 
want to either permit or deny traffic. 

A valid MAC address format for IMC consists of three sets of four hexadecimal characters 
separated by a dash, "-". For example, 
0014-2ad9-05f7  

would be a valid entry for a MAC address in IMC. 

Similarly, the format for a MAC address mask consists of three sets of four hexadecimal 
characters separated by a dash, "-". For example, 
ffff-ffff-ffff  

would be a valid entry for a MAC address mask in IMC. 

The MAC address and its mask must be separated by a forward slash, "/". 

A valid entry for a MAC Address/Mask would be 
0014-2ad9-05f7/ffff-ffff-ffff  

14. Select the destination MAC address option by selecting the desired option in the Destination 
MAC Address of the Configure Rule — Modify Rule page. 

This option specifies where the pattern matching occurs in this rule. In this case, the pattern 
matching are applied to the destination MAC address. Options include: 

 All—Allows you to permit or deny traffic for all MAC addresses. 
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 MAC Address/Mask—Allows you to identify a specific MAC address and its mask for which 
you want to either permit or deny traffic. 

A valid MAC address format for IMC consists of three sets of four hexadecimal characters 
separated by a dash, "-". For example, 
0014-2ad9-05f7  

would be a valid entry for a MAC address in IMC. 

Similarly, the format for a MAC address mask consists of three sets of four hexadecimal 
characters separated by a dash, "-". For example, 
ffff-ffff-ffff  

would be a valid entry for a MAC address mask in IMC. 

The MAC address and its mask must be separated by a forward slash, "/". 

A valid entry for a MAC Address/Mask would be 
0014-2ad9-05f7/ffff-ffff-ffff  

15. Select the 802.1 priority you want to apply to this ACL rule from the 802.1 Priority list. 

16. Select the Layer 2 encapsulation type you want to apply to this ACL rule from the 
Encapsulation Type list. 

Options include Undefined, Ethernet II, SNAP, IEEE 802.2/802.3, and IEEE 802.3. 

17. Enter the source VLAN ID by entering it in the Source VLAN ID field.  

This field cannot contain question marks or blank spaces. 

18. Select the Layer 2 frame type from the Based Frame Type list. 

19. If you select Ethernet Frame or 802.2 Ethernet Frame in the Base Frame Type list, you must 
specify a code in the Code field. 

A valid entry for this field includes any four character hexadecimal value. 

20. If you select Ethernet Frame or 802.2 Ethernet Frame in the Base Frame Type list, you must 
also specify a mask in the Mask field. 

A valid entry for this field includes any four character hexadecimal value. 

21. Click OK to create the rule you have just configured or to accept the modifications to the 
existing rule. 

22. To add more rules, copy, sort, optimize, or delete existing rules, select one of the following: 

 To add more rules to the ACL, repeat steps 8-19. 

 To copy rules you have already created, click the Copy icon  associated with the rule 
sequence you want to copy. For more information about copying a rule set, see "Copying a 
rule in an ACL rule set."  

 Rules that belong to a rule set that is configured with a Match Order of 'Config' are 
executed in the order in which they are displayed in the rule set. The order in which rules are 
displayed in a rule set is initially defined by the order in which they are created. You can 
reorder the rules in a rule set using the Sort feature. For more information about using Sort 
to redefine the order of appearance of rules in a rule set, see "Using sort to reorder the rules 
in an ACL rules set."  

 ACLs can have a profound effect on the performance of networks. ACL Management 
automatically evaluates the effectiveness of rules and their effect on overall network 
performance as you add rules to a rule set. However, you can also manually perform an 
analysis of a rule set and optimize its effect on network performance using the Optimize 
feature. For more information about using this feature, see "Optimizing the rules in a rule 
set." 

 To delete one or more rules from a rule set, see "Deleting rules from an ACL rule set." 

23. Click Finish when you have finished modifying rules for this rule set. 

Modifying a user-defined rule set 

To modify the user-defined rule set of an existing ACL: 
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1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Resource under ACL Management on the left navigation tree. 

The ACL Resource list page opens. 

2. Click the ACL Identifier for the user-defined ACL for which you want to modify a rule. See the 
ACL Type field in the ACL Resource list for identifying ACLs for which the type is 
User-Defined. 

The Rule Set List is displayed on the main pane of the ACL Resource > <ACL Resource 
Name (ACL Identifier)> page. 

3. Click the Modify icon  in the Modify field associated with the rule set you want to modify. 

The Basic Info step of the Modify Rule Set page opens. 

Several fields cannot be changed. These include ACL Identifier, ACL Type, ACL Resource 
Name, Rule Set Name, and Match Order. 

4. Modify the description for this ACL as needed in the ACL Description field.  

A valid length for this field is 0–127 characters. 

5. Modify the description for this rule set as needed in the Rule Set Description field.  

A valid length for this field is 0–127 characters. 

6. Click Next.  

The Configure Time Range step of the Modify Rule Set page opens. 

7. Do one of the following: 

 If you do not want to modify or add a time range, click Next and skip to step 8. 

 If you want to modify an existing time range, click the Modify icon  in the Modify field of 
the time range table, the Modify Time Range page opens. 

 Modification options include adding new time ranges or deleting existing time ranges. 

Enter a new name for the time range in the Name field of the Modify Time Range page to 
modify the time range name. 

Time Range names must begin with a letter (A-Z) and consist of 1-32 characters. Blank 
spaces ( ) and question marks (?) are not permitted. Uppercase letters may be converted to 
lowercase letters by some devices after deployment. 

 To configure a new time range item, click Add under the Time Range Items and the Add 
Time Range dialog box opens. Select the type of time range you want to create by selecting 
the desired time range type: 

 Select Fixed if you want to identify a specific and finite start and end date and time.  

 Select Cyclic if you want the time range to recur for select days of the week. 

8. To add a new rule click Add on the Configure Rule page to configure a new rule. 

The Add Rule page opens. 

9. To modify an existing rule, click the Modify icon  in the Modify field associated with the rule 
you want to modify. 

10. Select the action you want to take by selecting the option you want to apply to this rule. 

 Select permit if, upon matching the specified conditions, the packet should be forwarded.  

 Select deny if, upon matching the specified conditions, the packet should be discarded. 

11. Select the time range you want to apply to this rule from the Time Range list you created in the 
step 7. 

12. Modify the existing Rule String/Mask/Excursion combinations or enter new combinations. 
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You can enter up to eight hexadecimal patterns, masks, and offsets for matching the contents 
of a packet and applying the actions specified in the rule when a hexadecimal pattern is 
matched. The following rules and guidelines apply to constructing a valid hexadecimal string, 
mask, and offset value. 

 A rule string must be expressed in hexadecimal only. 

 A mask must be expressed in hexadecimal only. 

 A rule string length must be equal to its mask length. 

 Rule string and mask length must be in multiples of 2. 

 The minimum length of a rule string and mask is 2. 

 The maximum length of a rule string and mask is 160. 

 Offsets must be expressed as a decimal integer. 

 Offset range varies by the mask length. 

 The minimum value for an offset is 0. 

 The maximum value for an offset is 79. 

 The offset must increase progressively. 

a. Modify or enter a hexadecimal pattern to be matched in the Rule String field. 

b. Modify or enter a mask in the Mask field. 

c. Modify or enter the offset in the Excursion field. 

d. Modify or enter up to eight Rule String/Mask/Excursion combinations. 

13. Click OK to create the rule you have just configured or to accept the modifications to the 
existing rule. 

14. To add more rules, copy, sort, optimize or delete existing rules, select one of the following: 

 To add more rules to the ACL, repeat steps 11-18. 

 To copy rules you have already created, click the Copy icon  associated with the rule 
sequence you want to copy. For more information about copying a rule set, see "Copying a 
rule in an ACL rule set."  

 Rules that belong to a rule set that is configured with a Match Order of 'Config' are 
executed in the order in which they are displayed in the rule set. The order in which rules are 
displayed in a rule set is initially defined by the order in which they are created. You can 
reorder the rules in a rule set using the Sort feature. For more information about using Sort 
to redefine the order of appearance of rules in a rule set, see "Using sort to reorder the rules 
in an ACL rules set."  

 ACLs can have a profound effect on the performance of networks. ACL Management 
automatically evaluates the effectiveness of rules and their effect on overall network 
performance as you add rules to a rule set. However, you can also manually perform an 
analysis of a rule set and optimize its effect on network performance using the Optimize 
feature. For more information about using this feature, see "Optimizing the rules in a rule 
set."  

 To delete one or more rules from a rule set, see "Deleting rules from an ACL rule set." 

15. Click Finish when you have finished modifying this rule set. 

Copying rule sets 

To simplify the process of creating new rule sets, you can make a copy of an existing rule set and 
copy it to the same ACL and make modifications to create a new rule set. 

To copy a rule set: 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 
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c. Click ACL Resource under ACL Management on the left navigation tree. 

The ACL Resource list page opens. 

2. Click the ACL Identifier of the ACL for which you want to create a copy of a rule set. 

The Rule Set List for the select ACL is displayed on the main pane of the ACL Resource > 
<ACL Resource Name (ACL Identifier)> page. 

3. Click the Copy icon  in the Copy field associated with the rule set you want to copy. 

You can make any modifications to the copy of a rule set that you can to the rule set itself, 
including creating new rules. Note that the steps for creating and modifying rule sets vary by the 
ACL type to which the rule set belongs. For more information about modifying rules, see 
"Modifying ACL rule sets" and specifically to the information that addresses how to modify the 
type of rule set you want to copy.  

4. Click Finish when you have completed your modifications to the rule set copy. 

Deploying rule sets 

The Deploy link  in the Rule Set List is a shortcut to the ACL Deployment wizard. For more 
information about deploying an ACL, see "Deploying ACLs using IMC ACL deployment wizard." 

Importing rule sets 

You can import the contents of an ACL template to an existing ACL, which accelerates and 
standardizes the process for creating rule sets. You can only import a template of the same type as 
the ACL.  

Importing a basic ACL template into a basic ACL 

To import the contents of a basic template into a basic ACL: 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Resource under ACL Management on the left navigation tree. 

The ACL Resource list page opens. 

2. Click the ACL Identifier for the Basic ACL for which you want to import the contents of a basic 
template. 

The Rule Set List for the select ACL is displayed on the main pane of the ACL Resource > 
<ACL Resource Name (ACL Identifier)> page. 

3. Click Import. 

The Import ACL Template to ACL Resource page opens. 

4. Select the ACL template you want to import from the ACL Template list.  

Only templates of the same type as the ACL you are importing into display in the ACL 
Template list. 

The page updates to display the time ranges and network address groups configured in the 
ACL template, if any, as shown in the title bar examples below. 

September(Type—Time Range) 

NetMgmt_Servers(Type—Network) 

5. Select from one of the methods for configuring the time range contents of an ACL: 

To configure the imported rules without limitations to the dates and times that the rule lists are in 
effect, select All. 

To configure a time range using a pre-configured time range from the Assistant, click Select, 
and the Select Time Ranges dialog box opens: 

a. Select the time ranges you want to add. For more information about viewing the details of a 
time range in the Assistant, see "Viewing the time range list." 
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b. Click OK to accept your selection. 

To customize a time range configuration for this import, click Add and the Add Time Range 
dialog box opens. 

c. Select the type of time range you want to create by selecting the desired time range type: 

 Select Fixed if you want to identify a specific and finite start and end date and time.  

 Select Cyclic if you want the time range to recur for select days of the week.  

See "Configuring fixed time ranges" to configure fixed time ranges and "Configuring cyclic 
time ranges" to configure cyclic time ranges. 

6. Select from the following options to import the source IP addresses and subnet mask 
combination contents of an ACL template: 

To configure the rule sets to apply to all devices, select All. This configuration does not apply to 
any rules for which the source IP address and subnet mask have been configured in the rule. 

7. Click Select to configure an IP address/subnet mask combination using a pre-configured 
network address group from the Assistant and the Select Networks dialog box opens: 

a. Select the network address groups you want to add. For more information about viewing the 
details of an individual network address group, see "Viewing a network address group." 

b. Click OK to accept your selection. 

To customize a network segment configuration for this import, enter the IP address and 
subnet mask in the field next to Input Network(IP/Mask) field. 

The subnet mast must be entered in dotted decimal notation. A valid IP address/subnet 
mask using dotted decimal notation would be 
192.168.1.0/255.255.255.0  

c. Click Add. Repeat this step to add more IP address/subnet mask combinations. 

8. Click OK when you have completed the configuration of time ranges and network addresses as 
the source IP addresses of a basic ACL. 

The Basic Info step of the Add Rule Set page opens. 

Several fields cannot be changed. These include the ACL Identifier, the ACL Type, and the 
ACL Resource Name. 

9. Enter a name for the rule set in the Rule Set Name field.  

A valid length for a rule set name is 1–32 characters. 

10. Select the match order you want to apply to this rule set by selecting the Match Order option 
you want to use: 

If you select Config, IMC matches rules in the order in which they were configured and works 
only for the devices that support it. 

If you select Auto, IMC matches rules based on the principle of depth priority. 

11. Enter a brief description for this ACL in the ACL Description field.  

A valid length for this field is 0–127 characters. 

12. Enter a brief description for this rule set in the Rule Set Description field.  

A valid length for this field is 0–127 characters. 

13. Do one of the following: 

To add new time ranges you have already configured to the rule set, leave Configure ACL 
Rules with Time Range selected.  

To proceed with the import using the time ranges already configured in the previous steps, clear 
the check box to the left of Configure ACL Rules with Time Range. 

14. Click Next. 

15. Do one of the following: 

 If you checked the box to Configure ACL Rules with Time Range, click Add under 
Configure Time Range to add a time range to this rule set. 
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 If you do not want to add a time range, skip to step 15. 

16. Enter a name for the time range in the Name field of the Add Time Range page.  

Time Range names must begin with a letter (A-Z) and consist of 1-32 characters. Blank spaces 
( ) and question marks (?) are not permitted. Uppercase letters may be converted to lowercase 
letters by some devices after deployment. 

17. Click Add to enter a time range. 

The Add Time Range dialog box opens. 

18. Select the type of time range you want to create by selecting the desired time range type: 

 Fixed if you want to identify a specific and finite start and end date and time.  

 Cyclic if you want the time range to recur for select days of the week.  

19. Select from one of the following to import rules: 

 To add all rules from the template to the new ACL, skip to the next step. 

 To delete one or more of the template rules: 

a. Select the sequence number for each of the rules you want to delete. 

b. Click Delete. When prompted, click OK to confirm the deletion of the selected rules. 

c. Skip to the next step. 

 To add new rules: 

a. Click Add on the Configure Rule page and the Add Rule page opens. 

b. Select the action you want to take by selecting the option you want to apply to this rule: 

 Select permit if, upon matching the specified conditions, the packet should be 
forwarded. 

 Select deny if, upon matching the specified conditions, the packet should be discarded. 

c. Select the time range you want to apply to this rule from the Time Range list. 

Select the source IP address option you want to use by selecting the desired option: 

This option specifies where the pattern matching occurs in this rule. In this case, the pattern 
matching is applied to the source IP address. 

 All—Allows you to permit or deny traffic for all IP addresses. 

 IP Address/Mask—Allows you to enter a specific IP address and its subnet mask for 
which you want to either permit or deny traffic. 

d. Enter an IP address/subnet mask combination in the IP Address/Mask field. 

The subnet mask must be entered in dotted decimal notation. A valid IP address/subnet 
mask using dotted decimal notation would be 
192.168.1.0/255.255.255.0  

A forward slash "/" must be used to separate the IP address from the subnet mask. 

20. Do one of the following: 

 Select Yes in the Fragment option if you want to apply the rule to each fragment. 

 Select No in the Fragment option if you want to apply the rule to first fragments. 

Traditional packet filtering matched only first fragments of IPv4 packets and allowed all 
subsequent non-first fragments to pass through. This resulted in security risks as hackers 
can fabricate non-first fragments to attack networks. 

 Select Yes in the Logging option if you want to enable logging for this rule.  

This feature enables the logging of packet filtering only when a module (for example, a 
firewall) using the ACL supports logging. 

 Enter the VPN instance you want to apply to this rule by entering the VPN-instance-name in 
the VPN Instance field. Note that a valid entry must be 0-31 characters that cannot contain 
question marks or blank spaces. Note also that this field is case sensitive. If no VPN 
instance is specified in this field, the rule applies only to non-VPN packets. 
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 Click OK to create the rule you have just configured. 

21. Do one of the following: 

 To add more rules to the ACL, repeat this step. 

 To modify rules you have already created, click the Modify icon  associated with the rule 
sequence you want to modify. For more information about modifying a rule set, see 
"Managing the rules in a rule set."  

 To copy rules you have already created, click the Copy icon  associated with the rule 
sequence you want to copy. For more information about copying a rule set, see "Copying a 
rule in an ACL rule set."  

 Rules that belong to a rule set that is configured with a Match Order of 'Config' are 
executed in the order in which they are displayed in the rule set. The order in which rules are 
displayed in a rule set is initially defined by the order in which they are created. You can 
reorder the rules in a rule set using the Sort feature. For more information about using Sort 
to redefine the order of appearance of rules in a rule set, see "Using sort to reorder the rules 
in an ACL rules set."  

 ACLs can have a profound effect on the performance of networks. ACL Management 
automatically evaluates the effectiveness of rules and their effect on overall network 
performance as you add rules to a rule set. However, you can also manually perform an 
analysis of a rule set and optimize its effect on network performance using the Optimize 
feature. For more information about using this feature, see "Optimizing the rules in a rule 
set."  

 To delete one or more rules from a rule set, see "Deleting rules from an ACL rule set." 

22. Click Finish to accept your configuration for the import process and to create the new rule set. 

Importing an advanced ACL template into an advanced ACL 

To import the contents of an advanced template into an advanced ACL: 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click the ACL Management on the left navigation tree. 

c. Click ACL Resource under ACL Management on the left navigation tree. 

The ACL Resource list is displayed on the main pane of the ACL Resource page. 

2. Click the ACL Identifier for the Advanced ACL for which you want to import the contents of an 
Advanced template. 

The Rule Set List for the select ACL is displayed on the main pane of the ACL Resource > 
<ACL Resource Name (ACL Identifier)> page. 

3. Click Import. 

The Import ACL Template to ACL Resource page opens. 

4. Select the ACL template you want to import from the ACL Template list.  

Only import templates of the same type as the ACL you are importing into display in the ACL 
Template list. 

The page updates to display the time ranges, network access groups, and ports configured in 
the ACL template, if any, as shown in the title bar examples below. 

<WorkDays> (Type—Time Range) 

<NetMgmt_Servers> (Type—Network) 

<NetMgmt_Protocols> (Type—Port) 

5. Select from one of the methods for configuring the time range contents of an ACL: 

 To configure the imported rules without limitations to the dates and times that the rule lists 
are in effect, select All. 
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 To configure a time range using a pre-configured time range from the Assistant, click 
Select, and the Select Time Ranges dialog box opens: 

a. Select the time ranges you want to add. For more information about viewing the details of a 
time range in the Assistant, see "Viewing the time range list." 

b. Click OK to accept your selection. 

To customize a time range configuration for this import, click Add and the Add Time Range 
dialog box opens. 

c. Select the type of time range you want to create by selecting the desired time range type: 

 Select Fixed if you want to identify a specific and finite start and end date and time.  

 Select Cyclic if you want the time range to recur for select days of the week.  

6. Select from the three options for importing the source IP addresses and subnet masks 
combination contents of an ACL template: 

 To configure the rule sets to apply to all devices, select All. 

This configuration applies to any rules for which the source IP address and subnet mask 
have been configured in the rule. 

 To use pre-configured network address groups, click Select to configure an IP 
address/subnet mask combination using a pre-configured network address group from the 
Assistant. 

The Select Networks dialog box opens. 

a. Select the network address groups you want to add. For more information about viewing the 
details of an individual network address group, see "Viewing a network address group." 

b. Click OK to accept your selection. 

 To customize a time range configuration for this import, enter the IP address and subnet 
mask in the field next to Input Network (IP/Mask) field. 

The subnet mask must be entered in dotted decimal notation. A valid IP address/subnet 
mask using dotted decimal notation would be 
192.168.1.0/255.255.255.0  

A forward slash "/" must be used to separate the IP address from the subnet mask. 

a. Click Add. Repeat this step to add more IP address/subnet mask combinations. 

b. Select from the options for importing the port configuration contents of an ACL template— 

To configure the rule set to apply to all ports, select All.  

To use pre-configured services, click Select to configure a port using a pre-configured 
service. 

The Select Services dialog box opens.  

This configuration does not apply to any rules for which the ports have been specified. 

c. Select the services you want to add. For more information about viewing the details of an 
individual service, see "Viewing a service." 

d. Click OK to accept your selection. 

 To customize a port configuration for this import, enter the port in the field next to Input Port 
field.  

A valid port entry must in the range of 1-65535. 

Click Add. Repeat this step to add more port numbers. 

7. Click OK when you have completed the configuration of time ranges, network addresses, and 
protocols for advanced ACL. 

The Basic Info step of the Add Rule Set page opens. 

Several fields cannot be changed. These include the ACL Identifier, the ACL Type, and the 
ACL Resource Name. 

8. Enter a name for the rule set in the Rule Set Name field.  
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A valid length for a rule set name is 1–32 characters. 

9. Select the match order you want to apply to this rule set by selecting the Match Order option 
you want to use: 

 If you select Config, IMC matches rules in the order in which they were configured and 
works only for the devices that support it. 

 If you select Auto, IMC matches rules based on the principle of depth priority. 

10. Enter a brief description for this ACL in the ACL Description field.  

A valid length for this field is 0–127 characters. 

11. Enter a brief description for this rule set in the Rule Set Description field.  

A valid length for this field is 0–127 characters. 

12. Do one of the following: 

To add new time ranges you have already configured to the rule set, leave Configure ACL 
Rules with Time Range selected. 

To proceed with the import using the time ranges already configured in the previous steps, clear 
the check box to the left of Configure ACL Rules with Time Range. 

13. Click Next. 

14. Do one of the following: 

 If you checked the box to Configure ACL Rules with Time Range, click Add under 
Configure Time Range to add a time range to this rule set. 

 If you do not want to add a time range, skip to Step 16. 

15. Enter a name for the time range in the Name field of the Add Time Range page.  

Time Range names must begin with a letter (A-Z) and consist of 1-32 characters. Blank spaces 
( ) and question marks (?) are not permitted. Uppercase letters may be converted to lowercase 
letters by some devices after deployment. 

a. Click Add to enter a time range. 

The Add Time Range dialog box opens. 

b. Select the type of time range you want to create by selecting the desired time range type: 

 Fixed if you want to identify a specific and finite start and end date and time.  

 Cyclic if you want the time range to recur for select days of the week.  

16. Select from one of the following to import rules: 

To add all rules from the template to the new ACL, skip to the next step. 

To delete one or more of the template rules: 

a. Select the sequence number for each of the rules you want to delete. 

b. Click Delete. When prompted, click OK to confirm the deletion of the selected rules. 

c. Skip to the next step. 

To add new rules: 

a. Click Add on the Configure Rule page and the Add Rule page opens. 

b. Select the protocol for which you want to permit or deny traffic from the Protocol list. 

c. Select the action to take by selecting the option you want to apply to this rule: 

Select permit if, upon matching the specified conditions, the packet should be forwarded. 

Select deny if, upon matching the specified conditions, the packet should be discarded. 

17. Select the time range you want to apply to this rule from the Time Range list. 

18. Select the source IP address option you want to use by selecting the desired option in the 
Source Address field of the Add Rule page. 

This option specifies where the pattern matching occurs in this rule. In this case, the pattern 
matching is applied to the source IP address. 
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 All—Allows you to permit or deny traffic for all IP addresses. 

 IP Address/Mask—Allows you to enter a specific IP address and its subnet mask for which 
you want to either permit or deny traffic. 

Enter an IP address/subnet mask combination in the IP Address/Mask field.  

The subnet mask must be entered in dotted decimal notation. A valid IP address/subnet 
mask using dotted decimal notation would be 
192.168.1.0/255.255.255.0  

A forward slash "/" must be used to separate the IP address from the subnet mask. 

19. Select the destination IP address option you want to use by selecting the desired option in the 
Destination Address field of the Add Rule page. 

 All—Allows you to permit or deny traffic for all IP addresses. 

 IP Address/Mask—Allows you to enter a specific IP address and its subnet mask for which 
you want to either permit or deny traffic. 

Enter an IP address/subnet mask combination in the IP Address/Mask field.  

The subnet mask must be entered in dotted decimal notation. A valid IP address/subnet 
mask using dotted decimal notation would be 
192.168.1.0/255.255.255.0  

A forward slash "/" must be used to separate the IP address from the subnet mask. 

20. If you select TCP or UDP as the protocol you want to apply this ACL rule to, you must also 
specify the source TCP or UDP port numbers. 

21. Select the source TCP or UDP port by selecting the port option you want to apply in the Source 
Port field of the Add Rule page. Options include: 

 Undefined—Allows you to permit or deny traffic for all TCP or UDP port numbers. 

 Specified Port—Allows you to identify a specific TCP or UDP port number or range of 
numbers.  

a. Select Specified Port and select the operator you want to use from the list next to the 
Specified Port option.  

b. Enter the TCP or UDP port number in the Port field. 

22. If you select TCP or UDP as the protocol you want to apply this ACL rule to, you must also 
specify the destination TCP or UDP port numbers: 

 Select the destination TCP or UDP port by selecting the port option you want to apply in the 
Destination Port field of the Add Rule page. Options include: 

 Undefined—Allows you to permit or deny traffic for all TCP or UDP port numbers. 

 Specified Port—Allows you to identify a specific TCP or UDP port number or range of 
numbers. Select Specified Port and select the operator you want to use from the list 
next to the Specified Port option.  

Enter the TCP or UDP port number in the Port field. 

23. If you select TCP or UDP as the protocol you want to apply this ACL rule, you could be 
promoted to select these options: 

 Select Yes in the HP ACK option if you want to apply the rule to match the TCP ACK, 
otherwise select No. 

 Select Yes in the HP FIN option if you want to apply the rule to match the TCP FIN, 
otherwise select No. 

 Select Yes in the HP RST option if you want to apply the rule to match the TCP RST, 
otherwise select No. 

 Select Yes in the HP SYN option if you want to apply the rule to match the TCP SYN, 
otherwise select No. 

The HP ACK, HP FIN, HP RST, or HP SYN settings are valid only for the HPE E series 
devices. 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 9255



854 

24. Select the IP priority you want to apply to ACL from the IP Priority list.  

25. Select the Type of Service for this ACL from the TOS Value list. 

26. Select the DSCP value you want to apply to this ACL from the DSCP Value list.  

27. Do one of the following: 

 Select Yes in the Fragment option if you want to apply the rule to each fragment. 

 Select No in the Fragment option if you want to apply the rule to first fragments. 

Traditional packet filtering matched only first fragments of IPv4 packets and allowed all 
subsequent non-first fragments to pass through. This resulted in security risks as hackers can 
fabricate non-first fragments to attack networks. 

28. Select Yes in the Logging option if you want to enable logging for this rule. 

This feature enables the logging of packet filtering only when a module (for example, a firewall) 
using the ACL supports logging. 

29. Enter the VPN instance you want to apply to this rule by entering the VPN-instance-name in the 
VPN Instance field. 

30. A valid entry must be 0-31 characters that cannot contain question marks or blank spaces. Note 
also that this field is case sensitive. If no VPN instance is specified in this field, the rule applies 
only to non-VPN packets. 

31. Click OK to create the rule you have just configured. 

32. Do one of the following: 

 To add more rules to the ACL, repeat this step. 

 To modify rules you have already created, click the Modify icon  associated with the rule 
sequence you want to modify. For more information about modifying a rule set, see "Adding 
or modifying rules in a rule set." 

 To copy rules you have already created, click the Copy icon  associated with the rule 
sequence you want to copy. For more information about copying a rule set, see "Copying a 
rule in an ACL rule set."  

Rules that belong to a rule set that is configured with a Match Order of 'Config' are 
executed in the order in which they are displayed in the rule set. The order in which rules are 
displayed in a rule set is initially defined by the order in which they are created. You can 
reorder the rules in a rule set using the Sort feature. For more information about using Sort 
to redefine the order of appearance of rules in a rule set, see "Using sort to reorder the rules 
in an ACL rules set."  

ACLs can have a profound effect on the performance of networks. ACL Management 
automatically evaluates the effectiveness of rules and their effect on overall network 
performance as you add rules to a rule set. However, you can also manually perform an 
analysis of a rule set and optimize its effect on network performance using the Optimize 
feature. For more information about using this feature, see "Optimizing the rules in a rule 
set." 

 To delete one or more rules from a rule set, see "Deleting rules from an ACL rule set." 

33. Click Finish to accept your configuration for the import process and to create the new rule set. 

Importing a link ACL template into a link ACL 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Resource under ACL Management on the left navigation tree. 

The ACL Resource list page opens. 

2. Click the ACL Identifier for the Link ACL for which you want to import the contents of a link 
template. 
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The Rule Set List for the selected ACL is displayed on the main pane of the ACL Resource > 
<ACL Resource Name (ACL Identifier)> page. 

3. Click Import.  

The Import ACL Template to ACL Resource page opens. 

4. Select the ACL template you want to import from the ACL Template list.  

The page updates to display the Basic Info step of the Add Rule Set page. 

A valid entry must be 0-31 characters that cannot contain question marks or blank spaces. This 
field is case sensitive. If no VPN instance is specified in this field, the rule applies only to 
non-VPN packets. 

Several fields cannot be changed. These include the ACL Identifier, the ACL Type, and the 
ACL Resource Name. 

5. Enter a name for the rule set in the Rule Set Name field.  

A valid length for a rule set name is 1–32 characters. 

6. Select the match order you want to apply to this rule set by selecting the Match Order option 
you want to use: 

 If you select Config, IMC matches rules in the order in which they were configured and only 
works for devices that support it.  

 If you select Auto, IMC matches rules based on the principle of depth priority. 

7. Enter a brief description for this ACL in the ACL Description field.  

A valid length for this field is 0 - 127 characters. 

8. Enter a brief description for this rule set in the Rule Set Description field.  

A valid length for this field is 0 - 127 characters. 

9. Do one of the following: 

To add new time ranges you have already configured to the rule set, leave Configure ACL 
Rules with Time Range selected. 

To proceed with the import using the time ranges already configured in the previous steps, 
uncheck the box to the left of Configure ACL Rules with Time Range . 

10. Click Next. 

11. Do one of the following: 

If you checked the box to Configure ACL Rules with Time Range, click Add under Configure 
Time Range to add a time range to this rule set.  

If you do not want to add a time range, skip to step 12. 

12. Enter a name for the time range in the Name field of the Add Time Range page. 

Time Range names must begin with a letter (A-Z) and consist of 1-32 characters. Blank spaces 
( ) and question marks (?) are not permitted. Uppercase letters may be converted to lowercase 
letters by some devices after deployment. 

13. Click Add to enter a time range. 

The Add Time Range dialog box opens. 

14. Select the type of time range you want to create by selecting the desired time range type: 

 Fixed if you want to identify a specific and finite start and end date and time. 

 Cyclic if you want the time range to recur for selected days of the week.  

15. Select from the following options to import rules: 

To add all of the rules from the template to the new ACL, skip to the next step. 

To delete one or more of the template rules, select the sequence number for each of the rules 
you want to delete, and: 

a. Click Delete.  

b. When prompted, click OK to confirm the deletion of the selected rules.  
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c. Skip to the next step. 

To add new rules, click Add on the Configure Rule page. 

The Add Rule page opens. 

16. Select the action you want to take by selecting the option you want to apply to this rule. 

 Select permit if, upon matching the specified conditions, the packet should be forwarded. 

 Select deny if, upon matching the specified conditions, the packet should be discarded. 

 Select the time range you want to apply to this rule from the Time Range list. 

 Select the source MAC address option you want to use by selecting the desired option in the 
Source MAC Addr section of the Configure Rule–Add Rule page. 

This option specifies where the pattern matching occurs in this rule. In this case, the pattern 
matching is applied to the source MAC address. 

 All—Allows you to permit or deny traffic for all MAC addresses. 

 MAC Address/Mask—Allows you to enter a specific MAC address and mask for which you 
want to either permit or deny traffic. 

A valid MAC address format for IMC consists of three sets of four hexadecimal characters 
separated by a dash, "-". For example, 
0014-2ad9-05f7  

would be a valid entry for a MAC address in IMC. 

Similarly, the format for a MAC address mask consists of three sets of four hexadecimal 
characters separated by a dash, "-". For example, 
ffff-ffff-ffff  

would be a valid entry for a MAC address mask in IMC. 

The MAC address and its mask must be separated by a forward slash, "/". 

A valid entry for a MAC Address/Mask would be 
0014-2ad9-05f7/ffff-ffff-ffff  

17. Select the destination MAC address option by selecting the desired option in the Destination 
MAC Address section of the Configure Rule–Add Rule page.  

This option specifies where the pattern matching occurs in this rule. In this case, the pattern 
matching is applied to the source MAC address. 

 All—Allows you to permit or deny traffic for all MAC addresses. 

 MAC Address/Mask—Allows you to identify a specific MAC address and its mask for which 
you want to either permit or deny traffic. 

A valid MAC address format for IMC consists of three sets of four hexadecimal characters 
separated by a dash, "-". For example, 
0014-2ad9-05f7  

would be a valid entry for a MAC address in IMC. 

Similarly, the format for a MAC address mask consists of three sets of four hexadecimal 
characters separated by a dash, "-". For example, 
ffff-ffff-ffff  

would be a valid entry for a MAC address mask in IMC. 

The MAC address and its mask must be separated by a forward slash, "/". 

A valid entry for a MAC Address/Mask would be 
0014-2ad9-05f7/ffff-ffff-ffff  

18. Select the 802.1 priority you want to apply to this ACL rule from the 802.1 Priority list.  

19. Select the Layer 2 encapsulation type you want to apply to this ACL rule from the 
Encapsulation Type list.  

20. Enter the Source VLAN ID by entering it in the Source VLAN ID field. 
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This field cannot contain question marks or blank spaces. 

21. Select the Layer 2 frame type from the Based Frame Type list. 

22. If you select Ethernet Frame or 802.2 Ethernet Frame in the Base Frame Type list, you must 
specify a code in the Code field. 

A valid entry for this field includes any four character hexadecimal value. 

23. If you select Ethernet Frame or 802.2 Ethernet Frame in the Base Frame Type list, you must 
also specify a mask in the Mask field. 

A valid entry for this field includes any four character hexadecimal value. 

24. Click OK to create the rule you have just configured. 

25. Do one of the following: 

 To add more rules to the ACL, repeat this step. 

 To modify rules you have already created, click the Modify icon  associated with the rule 
sequence you want to modify. For more information about modifying a rule set, see "Adding 
or modifying rules in a rule set." 

 To copy rules you have already created, click the Copy icon  associated with the rule 
sequence you want to copy. For more information about copying a rule set, see "Copying a 
rule in an ACL rule set."  

 Rules that belong to a rule set that is configured with a Match Order of 'Config' are 
executed in the order in which they are displayed in the rule set. The order in which rules are 
displayed in a rule set is initially defined by the order in which they are created. You can 
reorder the rules in a rule set using the Sort feature. For more information about using Sort 
to redefine the order of appearance of rules in a rule set, see "Using sort to reorder the rules 
in an ACL rules set."  

 ACLs can have a profound effect on the performance of networks. ACL Management 
automatically evaluates the effectiveness of rules and their effect on overall network 
performance as you add rules to a rule set. However, you can also manually perform an 
analysis of a rule set and optimize its effect on network performance using the Optimize 
feature. For more information about using this feature, see "Optimizing the rules in a rule 
set."  

 To delete one or more rules from a rule set, see "Deleting rules from an ACL rule set." 

26. Click Finish to accept your configuration for the import process and to create the new rule set. 

Importing a user-defined ACL template into a user-defined ACL 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Resource under ACL Management on the left navigation tree. 

The ACL Resource list page opens. 

2. Click the ACL Identifier for the User-Defined ACL for which you want to import the contents of 
a User-Defined template. 

The Rule Set List for the selected ACL is displayed on the main pane of the ACL Resource > 
<ACL Resource Name (ACL Identifier)> page. 

3. Click Import. 

The Import ACL Template to ACL Resource page opens. 

4. Select the ACL template you want to import from the ACL Template list.  

The page updates to display the Basic Info step of the Add Rule Set page. 

Only import templates of the same type as the ACL you are importing into display on the ACL 
Template list. 
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Several fields cannot be changed. These include the ACL Identifier, the ACL Type, and the 
ACL Resource Name. 

5. Enter a name for the rule set in the Rule Set Name field.  

A valid length for a rule set name is 1–32 characters. 

You cannot configure or modify the Match Order configuration of a User-Defined Rule. 

6. Enter a brief description for this ACL in the ACL Description field.  

A valid length for this field is 0–127 characters. 

7. Enter a brief description for this rule set in the Rule Set Description field.  

A valid length for this field is 0–127 characters. 

8. Do one of the following: 

 To add new time ranges you have already configured to the rule set, leave Configure ACL 
Rules with Time Range selected. 

 To proceed with the import using the time ranges already configured in the previous steps, 

uncheck the box to the left of Configure ACL Rules with Time Range . 

9. Click Next. 

10. Do one of the following: 

 If you checked the box to Configure ACL Rules with Time Range, click Add under 
Configure Time Range to add a time range to this rule set.  

 If you do not want to add a time range, skip to step 11. 

a. Enter a name for the time range in the Name field of the Add Time Range page. 

Time Range names must begin with a letter (A-Z) and consist of 1-32 characters. Blank 
spaces ( ) and question marks (?) are not permitted. Uppercase letters may be converted to 
lowercase letters by some devices after deployment. 

b. Click Add to enter a time range. 

The Add Time Range dialog box opens. 

c. Select the type of time range you want to create by selecting the desired time range type: 

 Fixed if you want to identify a specific and finite start and end date and time.  

 Cyclic if you want the time range to recur for selected days of the week.  

11. Select from the following options to import rules: 

To add all of the rules from the template to the new ACL, skip to the next step. 

To delete one or more of the template rules, select the sequence number for each of the rules 
you want to delete. 

a. Click Delete.  

b. When prompted, click OK to confirm the deletion of the selected rules. 

c. Skip to the next step. 

To add new rules, click Add on the Configure Rule page to configure a new rule. The Add 
Rule page opens. 

12. Select the action you want to take by selecting the option you want to apply to this rule: 

 Select permit if, upon matching the specified conditions, the packet should be forwarded. 

 Select deny if, upon matching the specified conditions, the packet should be discarded. 

13. Select the time range you want to apply to this rule from the Time Range list. 

You can enter up to eight hexadecimal patterns, masks, and offsets for matching the contents 
of a packet and applying the actions specified in the rule when a hexadecimal pattern is 
matched. The following rules and guidelines apply to constructing a valid hexadecimal string, 
mask, and offset value. 

 A rule string must be expressed in hexadecimal only. 

 A mask must be expressed in hexadecimal only. 
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 A rule string length must be equal to its mask length. 

 Rule string and mask length must be in multiples of 2. 

 The minimum length of a rule string and mask is 2. 

 The maximum length of a rule string and mask is 160. 

 Offsets must be expressed as a decimal integer. 

 Offset range varies by the mask length. 

 The minimum value for an offset is 0. 

 The maximum value for an offset is 79. 

 The offset must increase progressively. 

a. Enter a hexadecimal pattern to be matched in the Rule String field. 

b. Enter a mask in the Mask field. 

c. Enter the offset in the Excursion field. 

d. Enter up to eight Rule String/Mask/Excursion combinations. 

14. Click OK to create the rule you have just configured. 

15. Select one of the following: 

 To add more rules to the ACL, repeat this step. 

 To modify rules you have already created, click the Modify icon  associated with the rule 
sequence you want to modify. For more information about modifying a rule set, see "Adding 
or modifying rules in a rule set."  

 To copy rules you have already created, click the Copy icon  associated with the rule 
sequence you want to copy. For more information about copying a rule set, see "Copying a 
rule in an ACL rule set."  

 Rules that belong to a rule set that is configured with a Match Order of 'Config' are 
executed in the order in which they are displayed in the rule set. The order in which rules are 
displayed in a rule set is initially defined by the order in which they are created. You can 
reorder the rules in a rule set using the Sort feature. For more information about using Sort 
to redefine the order of appearance of rules in a rule set, see "Using sort to reorder the rules 
in an ACL rules set."  

 Access control lists can have a profound effect on the performance of networks. ACL 
Management automatically evaluates the effectiveness of rules and their effect on overall 
network performance as you add rules to a rule set. However, you can also manually 
perform an analysis of a rule set and optimize its effect on network performance using the 
Optimize feature. For more information about using this feature, see "Optimizing the rules 
in a rule set."  

 To delete one or more rules from a rule set, see "Deleting rules from an ACL rule set." 

16. Click Finish to accept your configuration for the import process and to create the new rule set. 

Deleting rule sets 

To delete one or more rule sets from an ACL: 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Resource under ACL Management on the left navigation tree. 

The ACL Resource list page opens. 

2. Click the ACL Identifier of the ACL for which you want to create a copy of a rule set. 

The Rule Set List for the selected ACL is displayed on the main pane of the ACL Resource > 
<ACL Resource Name (ACL Identifier)> page. 

3. Select the rule sets you want to delete from the ACL. 
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4. Click Delete. 

5. Click OK to confirm the deletion of the selected rule sets. 

Managing the rules in a rule set 
ACL Management provides you with the ability to manage the rules within the rule set, including 
adding, modifying, copying, deleting, sorting, and optimizing rules. 

Adding or modifying rules in a rule set 

Once an ACL has been created, you can add rules to it or modify the existing rules. The process for 
doing both is essentially the same, however the process for modifying rules of different types is 
different and you can only add rules of the same type as the ACL. 

Adding or modifying a basic rule in a basic ACL rule set 

To add or modify a basic rule in a basic rule set: 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Resource under ACL Management on the left navigation tree. 

The ACL Resource list page opens. 

2. Click the ACL Identifier of the ACL for which you want to add or modify a rule. 

The Rule Set List for the selected ACL is displayed on the main pane of the ACL Resource > 
<ACL Resource Name (ACL Identifier)> page. 

3. Click the Modify icon  for the rule set to which you want to add a rule. 

The Basic Info step of the Modify Rule Set page opens. 

4. Click Next to advance to the next step in the Modify Rule Set page. 

The Configure Time Range step of the Modify Rule Set page opens. 

5. Click Next to advance to the next step in the Modify Rule Set page. 

The Configure Rule page opens. 

6. Select Self-Define Rule ID to enter a rule ID when adding a rule, or clear the option so the 
system automatically assigns a rule ID.  

7. Click Add on the Configure Rule page to configure a new rule. 

The Add Rule page opens. 

8. To modify a rule, click the Modify icon  associated with the rule you want to modify. 

The Modify Rule page opens. 

9. Select the action you want to take by selecting the option you want to apply to this rule: 

 Select permit if, upon matching the specified conditions, the packet should be forwarded. 

 Select deny if, upon matching the specified conditions, the packet should be discarded. 

10. Select the time range you want to apply to this rule from the Time Range list. 

11. Select the source IP address option you want to use in the Source Address section.  

This option specifies where the pattern matching occurs in this rule. In this case, the pattern 
matching is applied to the source IP address. 

 All—Allows you to permit or deny traffic for all IP addresses. 

 IP Address/Mask—Allows you to enter a specific IP address and its subnet mask for which 
you want to either permit or deny traffic. 

Enter an IP address/subnet mask combination in the IP Address/Mask field.  
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The subnet mask must be entered in dotted decimal notation. A valid IP address/subnet 
mask using dotted decimal notation would be 
192.168.1.0/255.255.255.0  

A forward slash "/" must be used to separate the IP address from the subnet mask. 

12. Do one of the following: 

 Select Yes in the Fragment option if you want to apply the rule to each fragment. 

 Select No in the Fragment option if you want to apply the rule to first fragments. 

Traditional packet filtering matched only first fragments of IPv4 packets and allowed all 
subsequent non-first fragments to pass through. This resulted in security risks as hackers can 
fabricate non-first fragments to attack networks. 

13. Select Yes in the Logging option if you want to enable logging for this rule.  

This feature enables the logging of packet filtering only when a module (for example, a firewall) 
using the ACL supports logging. 

14. Enter the VPN instance you want to apply to this rule by entering the VPN-instance-name in the 
VPN Instance field. 

A valid entry must be 0-31 characters that cannot contain question marks or blank spaces. This 
field is case sensitive. If no VPN instance is specified in this field, the rule applies only to 
non-VPN packets. 

15. Click OK to create or modify the rule you have just configured. 

Adding or modifying an advanced rule in an advanced rule set 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Resource under ACL Management on the left navigation tree. 

The ACL Resource list page opens. 

2. Click the ACL Identifier of the Advanced ACL for which you want to add or modify an advanced 
rule. 

The Rule Set List for the select ACL is displayed on the main pane of the ACL Resource > 
<ACL Resource Name (ACL Identifier)> page. 

3. Click the Modify icon  for the rule set to which you want to add a rule. 

The Basic Info step of the Modify Rule Set page opens. 

4. Click Next to advance to the next step in the Modify Rule Set page. 

The Configure Time Range step of the Modify Rule Set page opens. 

5. Click Next to advance to the next step in the Modify Rule Set page. 

The Configure Rule page opens. 

6. Select Self-Define Rule ID to enter a rule ID when adding a rule, or clear the option so the 
system automatically assigns a rule ID. 

7. Click Add on the Configure Rule page to configure a new rule. 

The Add Rule page opens. 

8. To modify a rule, click the Modify icon  associated with the rule you want to modify. 

The Modify Rule page opens. 

9. Select the protocol for which you want to permit or deny traffic from the Protocol list. 

10. Select the action you want to take by select the option you want to apply to this rule: 

 Select permit if, upon matching the specified conditions, the packet should be forwarded.  

 Select deny if, upon matching the specified conditions, the packet should be discarded. 

11. Select the time range you want to apply to this rule from the Time Range list. 
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12. Select the source IP address option you want to use by selecting the desired option in the 
Source Address.  

This option specifies where the pattern matching occurs in this template rule. In this case, the 
pattern matching is applied to the source IP address. 

 All—Allows you to permit or deny traffic for all IP addresses. 

 IP Address/Mask—Allows you to enter a specific IP address and its subnet mask for which 
you want to either permit or deny traffic. 

Enter an IP address/subnet mask combination in the field.  

The subnet mask must be entered in dotted decimal notation. A valid IP address/subnet 
mask using dotted decimal notation would be 
192.168.1.0/255.255.255.0  

A forward slash "/" must be used to separate the IP address from the subnet mask. 

13. Select the destination IP address option by selecting the desired option in the Destination 
Address field. 

This option specifies where the pattern matching occurs in this template rule. In this case, the 
pattern matching is applied to the destination IP address. 

 All—Allows you to permit or deny traffic for all IP addresses. 

 IP Address/Mask—Allows you to enter a specific IP address and its subnet mask for which 
you want to either permit or deny traffic. 

Enter an IP address/subnet mask combination in the IP Address/Mask field. 

The subnet mask must be entered in dotted decimal notation. A valid network/subnet mask 
using dotted decimal notation would be 
192.168.1.0/255.255.255.0  

A forward slash "/" must be used to separate the IP address from the subnet mask. 

14. If you select TCP or UDP as the protocol you want to apply this ACL rule to in step 7, you must 
also specify the source TCP or UDP port numbers: 

a. To select the source TCP or UDP port, select the port option you want to apply in the 
Source Port section: 

 Undefined—Allows you to permit or deny traffic for all TCP or UDP port numbers. 

 Specified Port—Allows you to identify a specific TCP or UDP port number or range of 
numbers.  

b. Select Specified Port and select the operator you want to use from the list next to the 
Specified Port option.  

c. Enter the TCP or UDP port number in the Port field. 

15. If you select TCP or UDP as the protocol you want to apply this ACL rule to in step 7, you must 
also specify the destination TCP or UDP port numbers selecting the port option you want to 
apply in the Destination Port section.  

 Undefined—Allows you to permit or deny traffic for all TCP or UDP port numbers. 

 Specified Port—Allows you to identify a specific TCP or UDP port number or range of 
numbers.  

a. Select Specified Port and select the operator you want to use from the list next to the 
Specified Port option. 

b. Enter the TCP or UDP port number in the Port field. 

16. If you select TCP or UDP as the protocol you want to apply this ACL rule to in step 7, you could 
be promoted to select these options: 

 Select Yes in the HP ACK option if you want to apply the rule to match the TCP ACK, 
otherwise select No. 

 Select Yes in the HP FIN option if you want to apply the rule to match the TCP FIN, 
otherwise select No. 
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 Select Yes in the HP RST option if you want to apply the rule to match the TCP RST, 
otherwise select No. 

 Select Yes in the HP SYN option if you want to apply the rule to match the TCP SYN, 
otherwise select No. 

The HP ACK, HP FIN, HP RST, and HP SYN settings are valid only for the HPE E series 
devices. 

17. Select the IP priority you want to apply to ACL template from the IP Priority list.  

18. Select the Type of Service for this ACL template from the ToS Value list. 

19. Select the DSCP value you want to apply to this ACL template from the DSCP Value list.  

20. Do one of the following: 

 Select Yes in the Fragment option if you want to apply the rule to each fragment.  

 Select No in the Fragment option if you want to apply the rule to first fragments. 

Traditional packet filtering matched only first fragments of IPv4 packets and allowed all 
subsequent non-first fragments to pass through. This resulted in security risks as hackers can 
fabricate non-first fragments to attack networks. 

21. Select Yes in the Logging option if you want to enable logging for this rule. 

This feature enables the logging of packet filtering only when a module (for example, a firewall) 
using the ACL supports logging. 

22. Enter the VPN instance you want to apply to this rule by entering the VPN-instance-name in the 
VPN Instance field. 

A valid entry must be 0-31 characters that cannot contain question marks or blank spaces. This 
field is case sensitive. If no VPN instance is specified in this field, the rule applies only to 
non-VPN packets. 

23. Click OK to create or modify the rule you have just configured. 

Adding or modifying a link rule in a link rule set 

To add or modify a link rule in a link rule set: 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Resource under ACL Management on the left navigation tree. 

The ACL Resource list page opens. 

2. Click the ACL Identifier of the ACL for which you want to add or modify a rule. 

The Rule Set List for the selected ACL is displayed on the main pane of the ACL Resource > 
<ACL Resource Name (ACL Identifier)> page. 

3. Click the Modify icon  for the rule set to which you want to add a rule. 

The Basic Info step of the Modify Rule Set page opens. 

4. Click Next to advance to the next step in the Modify Rule Set page. 

The Configure Time Range step of the Modify Rule Set page opens. 

5. Click Next to advance to the next step in the Click Next to advance to the next step in the 
Modify Rule Set page. 

The Configure Rule page opens. 

6. Select Self-Define Rule ID to enter a rule ID when adding a rule, or clear the option so the 
system automatically assigns a rule ID.  

7. Click Add on the Configure Rule page to configure a new rule. 

The Add Rule page opens. 

8. To modify a rule, click the Modify icon  associated with the rule you want to modify. 
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9. Select the action by selecting the desired option to apply to this rule: 

 Select permit if, upon matching the specified conditions, the packet should be forwarded.  

 Select deny if, upon matching the specified conditions, the packet should be discarded. 

10. Select the time range you want to apply to this rule from the Time Range list. 

11. Select the source MAC address option you want to use by selecting the desired option in the 
Source MAC Addr field. 

This option specifies where the pattern matching occurs in this template rule. In this case, the 
pattern matching is applied to the source MAC address. 

 All—Allows you to permit or deny traffic for all MAC addresses. 

 MAC Address/Mask—Allows you to enter a specific MAC address and mask for which you 
want to either permit or deny traffic. 

A valid MAC address format for IMC consists of three sets of four hexadecimal characters 
separated by a dash, "-". For example: 
0014-2ad9-05f7  

would be a valid entry for a MAC address in IMC. 

Similarly, the format for a MAC address mask consists of three sets of four hexadecimal 
characters separated by a dash, "-". For example: 
ffff-ffff-ffff  

would be a valid entry for a MAC address mask in IMC. 

The MAC address and its mask must be separated by a forward slash, "/". 

A valid entry for a MAC Address/Mask would be 
0014-2ad9-05f7/ffff-ffff-ffff  

12. Select the destination MAC address option by selecting the desired option in the Destination 
Address. 

This option specifies where the pattern matching occurs in this template rule. In this case, the 
pattern matching is applied to the destination MAC address. 

 All—Allows you to permit or deny traffic for all MAC addresses. 

 MAC Address/Mask—Allows you to identify a specific MAC address and its mask for which 
you want to either permit or deny traffic. 

A valid MAC address format for IMC consists of three sets of four hexadecimal characters 
separated by a dash, "-". For example: 
0014-2ad9-05f7  

would be a valid entry for a MAC address in IMC. 

Similarly, the format for a MAC address mask consists of three sets of four hexadecimal 
characters separated by a dash, "-". For example: 
ffff-ffff-ffff  

would be a valid entry for a MAC address mask in IMC. 

The MAC address and its mask must be separated by a forward slash, "/". 

A valid entry for a MAC Address/Mask would be 
0014-2ad9-05f7/ffff-ffff-ffff  

13. Select the 802.1 priority you want to apply to this ACL rule from the 802.1 Priority list.  

14. Select the Layer 2 encapsulation type you want to apply to this ACL rule from the 
Encapsulation Type list.  

15. Enter the Source VLAN ID by entering it in the Source VLAN ID field.  

This field cannot contain question marks or blank spaces. 

16. Select the Layer 2 frame type from the Based Frame Type list. 

17. If you select Ethernet Frame or 802.2 Ethernet Frame in the Base Frame Type list, you must 
specify a code in the Code field.  
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A valid entry for this field includes any four character hexadecimal value. 

18. If you select Ethernet Frame or 802.2 Ethernet Frame in the Base Frame Type list, you must 
also specify a mask in the Mask field.  

A valid entry for this field includes any four character hexadecimal value. 

19. Click OK to create the rule you have just configured. 

Adding or modifying a user-defined rule in a user-defined rule set 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Resource under ACL Management on the left navigation tree. 

The ACL Resource list page opens. 

2. Click the ACL Identifier of the User-Defined ACL for which you want to add or modify a 
user-defined rule. 

The Rule Set List for the selected ACL is displayed on the main pane of the ACL Resource > 
<ACL Resource Name (ACL Identifier)> page. 

3. Click the Modify icon  for the rule set to which you want to add a rule. 

The Basic Info step of the Modify Rule Set page opens. 

4. Click Next to advance to the next step in the Modify Rule Set page. 

The Configure Time Range step of the Modify Rule Set page opens. 

5. Click Next to advance to the next step in the Modify Rule Set page. 

The Configure Rule page opens. 

6. Select Self-Define Rule ID to enter a rule ID when adding a rule, or clear the option so the 
system automatically assigns a rule ID.  

7. Click Add on the Configure Rule page to configure a new rule. 

The Add Rule page opens. 

8. To modify a rule, click the Modify icon  associated with the rule you want to modify. 

The Modify Rule page opens. 

9. Select the action you want to take by selecting the option you want to apply to this rule: 

 Select permit if, upon matching the specified conditions, the packet should be forwarded.  

 Select deny if, upon matching the specified conditions, the packet should be discarded. 

10. Select the time range you want to apply to this rule from the Time Range list. 

11. Enter up to eight hexadecimal patterns, masks, and offsets for matching the contents of a 
packet and applying the actions specified in the rule when a hexadecimal pattern is matched. 
The following rules and guidelines apply to constructing a valid hexadecimal string, mask, and 
offset value. 

 A rule string must be expressed in hexadecimal only. 

 A mask must be expressed in hexadecimal only. 

 A rule string length must be equal to its mask length. 

 Rule string and mask length must be in multiples of 2. 

 The minimum length of a rule string and mask is 2. 

 The maximum length of a rule string and mask is 160. 

 Offsets must be expressed as a decimal integer. 

 Offset range varies by the mask length. 

 The minimum value for an offset is 0. 

 The maximum value for an offset is 79. 
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 The offset must increase progressively. 

a. Enter a hexadecimal pattern to be matched in the Rule String field. 

b. Enter a mask in the Mask field. 

c. Enter the offset in the Excursion field. 

d. Enter up to eight Rule String/Mask/Excursion combinations. 

12. Click OK to create the rule you have just configured. 

Copying a rule in an ACL rule set 

You can copy an existing rule, in a rule set, to a new rule in the same rule set and make modifications 
to the new copy. 

To copy an existing rule and make modifications to it: 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Resource under ACL Management on the left navigation tree. 

The ACL Resource list page opens. 

2. Click the ACL Identifier of the ACL for which you want to copy a rule. 

The Rule Set List for the selected ACL is displayed on the main pane of the ACL Resource > 
<ACL Resource Name (ACL Identifier)> page. 

3. Click the Modify icon  for the rule set you want to modify. 

The Basic Info step of the Modify Rule Set page opens. 

4. Click Next to advance to the next step in the Modify Rule Set page. 

The Configure Time Range step of the Modify Rule Set page opens. 

5. Click Next to advance to the next step in the Modify Rule Set page. 

The Configure Rule step of the Modify Rule Set page opens with the rules for the associated 
rule set displayed. 

6. Click the Copy icon  for the rule you want to copy. 

7. You can make any modifications to the copy of a rule that you can to the rule itself, including 
creating new rules.  

The steps for creating and modifying rules in a rule set vary by the ACL type to which the rule 
set belongs. For more information about modifying rules, see "Modifying ACL rule sets" and 
specifically to the information that addresses how to modify the type of rule set you want to 
copy. For example, if you have copied a rule from an advanced ACL, see "Modifying an 
advanced rule set." 

8. Click OK when you have finished modifying the copy to create the new copy. 

Deleting rules from an ACL rule set 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Resource under ACL Management on the left navigation tree. 

The ACL Resource list page opens. 

2. Click the ACL Identifier of the ACL from which you want to delete one or more rules. 

The Rule Set List for the selected ACL displayed in the main pane of the ACL Resource > 
<ACL Resource Name (ACL Identifier)> page. 

3. Click the Modify icon  for the rule set from which you want to delete rules. 
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The Basic Info step of the Modify Rule Set page opens. 

4. Click Next to advance to the next step in the Modify Rule Set page. 

The Configure Time Range step of the Modify Rule Set page opens. 

5. Click Next to advance to the next step in the Modify Rule Set page. 

The Configure Rule step of the Modify Rule Set page displays with the associated rule set 
listed. 

6. Select the sequence numbers for the rules you want to delete. 

7. Click Delete. 

8. Click OK to confirm the deletion of the selected rules. 

Using sort to reorder the rules in an ACL rules set 

The order in which rules are displayed in a rule set can influence the effectiveness of an ACL rule set 
and its effect on network performance. This is true for rules that belong to a rule set that is configured 
with a Match Order of Config because rules are executed in the order in which they are displayed in 
the rule set. If Self-Define Rule ID is not selected, the order in which rules are displayed in a rule set 
is initially defined by the order in which they are created but you can reorder the rules in a rule set 
using the Sort feature.  

To use the sort feature to reorder the rules in a rule set: 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Resource under ACL Management on the left navigation tree. 

The ACL Resource list page opens. 

2. Click the ACL Identifier of the ACL for which you want to sort a rule set. 

The Rule Set List for the selected ACL is displayed on the main pane of the ACL Resource > 
<ACL Resource Name (ACL Identifier)> page. 

3. Click the Modify icon  for the rule set where you want to sort rules. 

The Basic Info step of the Modify Rule Set page opens. 

4. Click Next to advance to the next step in the Modify Rule Set page. 

The Configure Time Range step of the Modify Rule Set page opens. 

5. Click Next to advance to the next step in the Modify Rule Set page. 

The Configure Rule step of the Modify Rule Set page displays with the associated rule set 
listed. 

6. Click Sort. 

The Rule Sort dialog box opens. 

7. Select the rules you want to move. 

Use one of the following methods: 

 Click one of the four navigation buttons located at the top of the Rule Sort dialog box: 

 Click Top to move the selected rules to the top of the list. 

 Click Up to move the selected rules up one position in the list. 

 Click Down to move the selected rules down one position in the list. 

 Click Bottom to move the selected rules to the bottom of the list. 

 Select a rule ID from the Move to list and click Move to move the rule to the specified 
position. 

8. Click OK when you have finished sorting the rule set. 

9. Click Finish to complete your modifications to the selected rule set. 
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Optimizing the rules in a rule set 

ACLs can have a profound effect on the performance of networks. ACL Management automatically 
evaluates the effectiveness of rules and their effect on overall network performance as you add rules 
to a rule set, but you can also initiate an analysis of a rule set and optimize its effect on network 
performance using the Optimize feature. 

There are essentially two causes for performance degradation related to ACLs. First, every packet 
that arrives at an interface is matched against all the ACL rules until a match is found. The more rules 
there are, the longer it takes to process every packet. Second, all rules are matched in a certain 
order and more rules lead to more time processing the matching requirements of every rule and 
leads to more time processing every packet. 

ACL Management's rule optimization algorithms improve both causes for performance degradation 
for ACLs that use Config as the Match Order because the sorting rules remove unnecessary rules 
and determine the applicable rules to reduce the effect of ACLs and to improve the overall 
performance of the device. In addition, ACL Management provides suggestions for efficient ACL 
implementation and simplified configurations based on the configured rules and the relations 
between them. 

ACL Management optimizes the rules in the following ways: 

 Removing coverable rules—If the coverage of a rule includes the coverage of another rule, 
the former overwrites the latter. The default rule is Permit All. 

 Removing duplicate rules—If several rules perform the same function, the rule set is reduced 
to one rule that performs the same function.  

 Merging rules with mask-identified address segments—If several rules have the same 
parameter values (including the address mask) with the exception of the IP or MAC address 
range, these rules are merged using appropriate mask settings.  

 Merging rules with duplicate port assignments—If several rules have the same parameter 
values with the exception of the port, the rules are merged using appropriate port range 
settings.  

 Removing redundant rules—If the coverage of a rule is included in the coverage of a 
preceding rule, the former rule is removed.  

 Reordering the rule set—ACL Management reorders rule sets by placing the most commonly 
matched rules first. 

In addition to optimizing rule sets, ACL Management also notifies you of rules that may jeopardize 
device to IMC connections. 

To optimize a rule set: 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Resource under ACL Management on the left navigation tree. 

The ACL Resource list page opens. 

2. Click the ACL Identifier of the ACL for which you want to optimize a rule set. 

ACL Management can optimize rule sets for ACLs that use Config as the Match order. Rule 
sets that use the Match order Auto cannot be optimized. 

In addition, rule sets that use Services to define the port assignments for a rule cannot be 
optimized. 

The Rule Set List for the selected ACL is displayed on the main pane of the ACL Resource > 
<ACL Resource Name (ACL Identifier)> page. 

3. Click the Modify icon  for the rule set you want to optimize. 

The Basic Info step of the Modify Rule Set page opens. 

4. Click Next to advance to the next step in the Modify Rule Set page. 
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The Configure Time Range step of the Modify Rule Set page opens. 

5. Click Next to advance to the next step in the Modify Rule Set page. 

The Configure Rule step of the Modify Rule Set page displays with the rules for the 
associated rule set listed. 

6. Click Optimize located at the top of the Configure Rule page. 

The Optimize dialog box opens. 

7. Select the device for which you want to optimize this rule set from the list located in upper left 
corner of the Optimize dialog box. 

ACL Management displays a summary of all of the rules in a rule set in the Before Optimize 
column of the Optimize dialog box. The contents of this column changes based upon the 
device command line format selected in the Select a device list located in the upper left corner 
of the Optimize dialog box. The recommended changes to the rule set display in the After 
Optimize column of the Optimize dialog box, and the optimize advices display in the Optimize 
Advice box. 

8. Select the device command line format you intend to apply this ACL rule set to from the Select 
a device list in the upper right corner. The columns update to reflect any changes required by 
the device command line format change. 

9. Review the recommendations in the After Optimize column. 

10. Click OK if you want to apply the changes recommended in the After Optimize column.  

If you select this option, the dialog box closes and the rule list in the Configure Rule step of the 
Modify Rule Set page updates to reflect the rule changes that resulted from the Optimize 
process. 

11. Click Cancel if you do not want to apply the changes recommended in the After Optimize 
column.  

The rules in the rule set remain unchanged. 

12. Click Finish to complete your modifications to the selected rule set. 

Managing device ACL configurations 
ACL Management simplifies and streamlines the process of managing ACLs on devices by providing 
a single portal for viewing and managing the configurations for all devices that support ACLs. From 
the ACL Device List, you can view all devices that support ACLs and navigate quickly to the device 
configuration page to view detailed information of the configuration for a single device. 

From the configuration page you can synchronize and refresh the ACL configuration data for the 
device as well as configure the ACL configuration polling interval. 

The lower half of the page provides the following tabs: 

 ACL Definitions—Add ACL definitions to the device or delete ACL definitions, export ACL to a 
text file, view details page for a single ACL or a single rule, save the selected device as an ACL 
resource or template, apply the ACL as a packet filter to one or more interfaces on the device, 
and view applied ACL uses that already exist on the device. 

 ACL Uses—View the ACL uses currently deployed on the device as well as add and remove 
ACL uses. 

 Time Ranges—View and delete time ranges that have been applied to ACLs. 

 Config History—View the ACL configuration history for the selected device as well as view the 
configuration details for every entry in the configuration history. In addition, a configuration 
history entry and baseline entry can be modified. 

 Flow Template Definitions—View, add, modify, and remove flow templates for devices.  

 Flow Template Applications—View, add, and remove flow templates that have been applied.  
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ACL device list management 
ACL Management provides you with a single portal for viewing and managing the ACL configurations 
for all devices that support ACLs. 

Viewing the ACL device list 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices list page opens. 

ACL devices list 

 Status—Contains the latest status of the device. Status is determined by the highest 
severity or alarm level for the device, when the device has one or more current alarms that 
have not been cleared or recovered. 

 Device Name—Contains the IMC name for the device, which, by default, is the name 
assigned to it by IMC in its device configuration. The contents of the device label field serve 
as an active link for navigating to the Device Details page for the associated device. 

 IP Address—Contains the IP address of the associated device. 

 Device Model—Contains the model information for the associated device. 

 Poll Interval—Contains the ACL configuration polling interval for the selected device.  

 Last Synchronize Time—Contains the date and time stamp for the last time the IMC 
database was polled for the latest device configuration, including ACL definitions, ACL 
uses, and time ranges. 

 Last Poll Result—Contains information whether or not the last poll of the device was 
successful or not. Note that this field contains information for the cause of poll failures. 

 ACL Configuration—Contains an icon  for navigating to the ACL Device configuration 
page for the associated device. This page provides detailed information on the ACL 
configuration for associated devices, as well as features for managing the ACL 
configuration of the device. 

You can sort the ACL Devices list, by every field, with the exception of the ACL Config 
field. Click the column label to sort the list by the selected field. The column label is a toggle 
switch that allows you to toggle between the various sort options specific to each field. 

If the ACL Devices list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the ACL Devices list. 

 Click  to page forward to the end of the ACL Devices list. 

 Click  to page backward in the ACL Devices list. 

 Click  to page backward to the front of the ACL Devices list. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

You can configure the ACL Devices list to display all devices managed in IMC, or only those 
devices that can support ACLs. To view only the devices in IMC that support ACLs, select Only 
Show the devices that support ACL option located in the upper right corner of the ACL 
Devices list. IMC determines which devices support ACLs by the methods of communication 
that IMC uses to configure ACLs on devices. If the device for which you want to manage ACLs 
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are not displayed in this list, check the SNMP, Telnet, and SSH settings to ensure that IMC can 
communicate with the device. 

Querying ACL devices list 

To search the ACL devices list for a specific device: 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices list page opens. 

2. Enter one or more of the following search criteria in the Query Condition section at the top of 
the page: 

 Device Name—Enter a partial or complete device name in the Device Name field. 

 Device IP—Enter a partial or complete device IP in the Device IP field. 

3. Click the Search icon  to submit your filter criteria. 

The results of your filter or search query display in the ACL Devices list. 

Synchronizing ACL devices 

ACL Management provides you with a facility for polling the IMC database for the most current 
information device configuration, including ACL definitions, ACL uses, and time ranges for devices in 
the ACL Devices list. 

To synchronize the ACL Devices list with the latest status and ACL configuration information in the 
IMC database: 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices list page opens. 

2. Select the devices for which you want to synchronize data. 

3. Click Synchronize located at the top of the ACL Devices list. 

The page displays a message indicating that device configuration is being synchronized. 

4. Click Refresh to refresh the page with current data. 

Customizing ACL configuration polling for devices 

ACL Management provides you with the ability to customize the polling interval for ACL configuration 
information for every device. 

To configure the ACL configuration polling interval for one or more devices: 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices list page opens. 

2. Select the Status and Device Name fields for the devices for which you want to customize ACL 
configuration polling. 

3. Click Poll Setting located at the top of the ACL Devices list. 

The Poll Setting dialog box opens. 

4. Select the poll option you want to implement for the selected devices: 
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 Select Poll Interval if you want to poll the selected devices and you want to customize the 
polling interval. 

Enter the poll interval value in the Poll Interval field.  

A valid polling interval range is 2–168 hours. 

 Select Disable Polling if you do not want to poll the selected devices for their ACL 
configuration information. 

5. Click OK to accept your ACL configuration polling configuration changes. 

The results of your configuration change is displayed in the ACL Devices list banner. 

ACL device configurations 
The ACL Device configuration page provides you with many features for managing ACL 
configurations for the selected device. At the top of this page, IMC provides you with access to 
summary details for the selected device.  

In the lower half of this page, there are many options for managing ACL device configurations using 
the tabs provided: 

 ACL Definitions—Add ACL definitions to the device or delete ACL definitions from it. In 
addition, you can export ACLs to a text file. By navigating to the View ACL details page for a 
single ACL, you can view ACL rule details for a single rule, as well as save the select ACL as an 
ACL resource or template in ACL Management, apply the ACL as a packet filter or VLAN packet 
filter to one or more interfaces on the device, and view applied ACL uses that already exist on 
the device. 

 ACL Uses—View the ACL uses for packet filtering and VLAN packet filtering currently deployed 
on the device as well as add and remove these ACL uses. 

 Time Ranges—View and delete time ranges that have been applied to ACLs. 

 Config History—View the ACL configuration history for the selected device as well as view the 
configuration details for every entry in the configuration history. In addition, you can modify the 
description of a configuration history entry and baseline an entry. 

 Flow Template Definitions—View, add, modify, and remove flow templates for devices.  

 Flow Template Applications—View, add, and remove flow templates that have been applied.  

You can view and manage the details for a single device's ACL configuration from a single portal. 
From the ACL Device configuration page, you can view basic device information, synchronize and 
refresh ACL data. This page also provides you with access to the tabs for managing ACLs and ACL 
uses, ACL time ranges and ACL configuration histories, flow template definitions, and flow template 
applications. From these tabs, you can add, delete, or export device ACLs, add and delete ACL 
packet filtering, delete time ranges, view and manage ACL configuration history for a single device, 
view, add, modify, and remove device flow templates, and view, add, and remove flow template 
applications. 

Viewing the ACL device configuration page 

To view the ACL Device Configuration page for managing the ACL configuration for a single device: 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system.  

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices list page opens. 

2. Click the icon  in the ACL Configuration field for the device for which you want to view and 
manage the ACL configuration. 

The ACL Device configuration page opens. 
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The upper portion of this page provides basic device information including: 

 Name—Contains the device label for the selected device. 

 Status—Contains the latest status of the device. Status is determined by the highest 
severity or alarm level for the device, when the device has one or more current alarms that 
have not been cleared or recovered. 

 IP Address—Contains the IP address for the selected device. 

 Mask—Contains the IP address subnet mask for the selected device. 

 Poll Interval—Contains the ACL configuration polling interval for the selected device as 
well as a Modify link for changing the ACL configuration polling interval. 

3. To modify the polling interval for the selected device, click the Modify link. 

The Poll Settings dialog box opens.  

4. Select the poll option you want to implement for the selected devices: 

 Select Poll Interval if you want to poll the selected devices and you want to customize the 
polling interval and enter the poll interval value in the Poll Interval field. 

Valid polling interval range is 2-168 hours. 

 Select Disable Polling if you do not want to poll the selected devices for their ACL 
configuration information. 

5. Click OK to accept modifications to the polling interval. 

 Last Poll Time—Contains the date and time stamp for the last ACL configuration poll. 

The lower portion of the ACL Device configuration page contains several tabs that provide 
you with a feature set for managing various aspects of a device's ACL configuration. These 
tabs include: 

 ACL Definitions—Add ACL definitions to the device or delete ACL definitions from it. For 
additional information, see "Managing device ACL definitions." 

 ACL Uses—View the ACL uses currently deployed on the device as well as add and 
remove ACL uses. 

 Time Ranges—View and delete time ranges that have been applied to ACLs. 

 Config History—View the ACL configuration history for the selected device, view the 
configuration details for every entry in the configuration history, and modify the description 
of a configuration history and baseline an entry. 

Managing device ACL definitions 

From the ACL Definitions tab of the ACL Device configuration page, you can add ACL definitions to 
the device, or delete ACL definitions from it, and export an ACL to a text file. By navigating to the 
View ACL details page for a single ACL on the device, you can view ACL rule details for a single rule, 
save the selected ACL as an ACL resource or template in ACL Management, apply the ACL as a 
packet filter or VLAN packet filter to one or more interfaces on the device, and view applied ACL uses 
that already exist on the device. 

Viewing the ACL definition list 

To view the list of ACLs that do not currently exist on the selected device: 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system.  

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices list page opens. 

2. Click the icon  in the ACL Configuration field for the device for which you want to view and 
manage the ACL configuration. 

The ACL Device configuration page opens. 
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3. Click the ACL Definitions tab. 

ACL information for ACLs on the selected device is displayed in a list below the ACL Definition 
tab.  

The contents of this list are described below. 

ACL definitions list 

 ACL Identifier—Contains the identifier for the ACL.  

The contents of this field serve as a link for navigating to the View ACL page for the 
associated ACL.  

 ACL Type—Contains the ACL type for the associated ACL. There are five types of ACL in 
IMC: 

 Interface 

 Basic 

 Advanced 

 Link 

 User-Defined 

 Match Order—Contains the match order type for the associated ACL. The Match Order 
can either be Config or Auto. 

 ACL Description—Contains a description for the associated ACL. 

 Operation—Contains two icons that serve as links—the Add Use icon  for adding 
packet filtering and VLAN packet filtering for one or more interfaces on the selected device 

and an Applied ACLs icon  for navigating to a view of all applied ACL uses for the 
associated ACL. 

You can sort the ACL Definitions list by the ACL Identifier, ACL Type, Match Order, and 
ACL Description fields by clicking the column label to sort the list by the selected field. The 
column label is a toggle switch that allows you to toggle between the various sort options 
specific to each field. 

You can filter the ACL Definitions list by ACL Type by selecting the ACL type you want to 
filter for from the ACL Type list located in the upper right corner of the ACL list. Options 
include All, Interface, Basic, Advanced, Link, and User-Defined. The default is All. 

Adding an ACL to the selected device 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system.  

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices list page opens. 

2. Click the icon  in the ACL Configuration field for the device for which you want to view and 
manage the ACL configuration. 

The ACL Device configuration page opens. 

3. Click the ACL Definitions tab. 

ACL information for ACLs on the selected device is displayed in a list below the ACL Definition 
tab. 

4. Click Add. 

5. The Add button navigates you to the Deploy ACLs wizard of ACL Management's ACL 
Deployment feature for managing the deployment of ACLs to devices. For more information 
about this feature, see "Deploying ACLs to devices." 

Deleting ACLs 
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To delete one or more ACLs from the selected device: 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system.  

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices list page opens. 

2. Click the icon  in the ACL Configuration field for the device for which you want to view and 
manage the ACL configuration. 

The ACL Device configuration page opens. 

3. Click the ACL Definitions tab. 

The ACL Definitions tab contents display along with a list of ACLs that currently exist on the 
device. 

4. Select the ACL Identifier for the ACLs you want to delete. 

5. Click Delete. 

6. When prompted, click OK to confirm the deletion of the selected ACLs. 

The Add Task page displays with the default task name displayed in the Task Name field. 

7. To enter a task name for this deployment task, delete the contents of this field and enter a new 
task name.  

A valid length for a task name is 1-32 characters. Note that the task name cannot begin with a 
number (0-9). 

8. Enter a brief description for this deployment task in the Description field. 

9. Select how you want IMC to execute the task to every device from the Deployment Order 
section of the Add Task page by selecting each option: 

 Select Concurrent if you want ACL Management to execute the task to multiple devices 
simultaneously. 

 Select Sequential if you want ACL Management to execute the task to one device at a time. 

10. Select the strategy you want ACL Management to use should a problem arise in the execution 
of the task from the Error Handling list: 

 Select Abort the task if you want to stop the deployment to pending devices, but not affect 
devices to which deployments are in progress or to which deployments have successfully 
completed once an error in deployment arises. 

 Select Abort the task and clear data deployed on the error device if you want to stop the 
deployment and clear all deployments on the device experiencing a problem once an error 
in deployment arises. 

 Select Skip the error device and continue if you want to stop all deployments on the 
device experiencing a problem once an error in deployment arises. 

 Select Clear data deployed on the error device and continue if you want to clear all 
deployments on the device experiencing a problem once an error in deployment arises. 

11. Do one of the following regarding the device's running configuration: 

 To save the device's running configuration as the startup configuration, prior to execution, 
select Yes in the Save to Startup File field.  

 Select No if you do not want to save the current configuration. 

12. You can select when you want ACL Management to execute the task to the selected device 
from one of the following: 

 To execute the task immediately, select Immediately. 

 To schedule a time for ACL Management to execute the task, select At Scheduled Time. 
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a. Click the Calendar function  next to the At Scheduled Time field to populate the date 
and time for the execution of this task.  

A popup calendar is displayed.  

b. Select the date from the calendar.  

Alternatively, you can enter the date and time manually. Valid date and time format for this 
entry is YYYY-MM-DD hh:mm where YYYY denotes the four digit year, MM denotes the two 
digit month, DD denotes the two digit day and hh denotes the two digit hour, mm denotes 
the two digit minute. 

13. To preview the commands of the task, click the Preview Commands icon  in the field of the 
Deploy Details list. 

The Preview Commands dialog box displays and the commands of the task to be executed 
are listed.  

a. Review the contents to verify that these are the commands you want to execute. 

b. Click OK when you have finished previewing the commands. 

14. Click OK to accept the deployment and task configuration and to submit this request to the 
deployment task queue. 

If the task is scheduled to run immediately, the Task Result dialog box opens, providing a real 
time status of the deployment task. 

 Click Close on the Task Result dialog box when the task has finished executing. 

 Review the results of the task in the Result field of the Task List.  

 Click Refresh located at the top of the Task List to reload the page with the most current 
information for all tasks in the list. 

 Review the results of your deployment task in the Result field of the deployment Task List.  

The contents of this field serve as a link to the Task Result page that contains more 
detailed information of the results and causes for a failed deployment. From this page, you 
can also review the commands executed by the deployment task. 

Exporting an ACL 

To export the contents of an ACL on the selected device to a text file on your local computer: 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system.  

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices page opens and the deployment ACL Devices list is displayed on this 
page. 

2. Click the icon  in the ACL Configuration field for the device for which you want to view and 
manage the ACL configuration. 

The ACL Device configuration page opens. 

3. Click the ACL Definitions tab. 

ACL information for ACLs on the selected device is displayed in a list below the ACL Definition 
tab.  

4. Select the ACL Identifier for the ACLs you want to export. 

5. Click Export. 

6. Follow your Web browser's instruction for opening or saving the contents of the ACL to a file on 
your local computer. 

Adding use 

The Add Use option provides a shortcut for deploying packet filtering or VLAN packet filtering to one 
or more interfaces on the selected device. 
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To add use: 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system.  

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices list page opens. 

2. Click the icon  in the ACL Configuration field for the device for which you want to view and 
manage the ACL configuration. 

The ACL Device configuration page opens. 

3. Click the ACL Definitions tab. 

ACL information for ACLs on the selected device is displayed in a list below the ACL Definition 
tab.  

4. Click the Add Use icon in the Operation field to navigate to the Add Use feature found 
under the ACL Uses tab.  

For more information about using this feature to add packet filtering or VLAN packet filtering to 
one or more interfaces for the selected device, see "Adding an ACL use." 

Viewing applied ACLs 

To view a list of packet filtering and VLAN packet filtering uses for the selected device: 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system.  

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices list page opens. 

2. Click the icon  in the ACL Configuration field for the device for which you want to view and 
manage the ACL configuration. 

The ACL Device configuration page opens. 

3. Click the ACL Definitions tab. 

ACL information for ACLs on the selected device is displayed in a list below the ACL Definition 
tab. 

4. Click the Applied ACLs icon  in the Operation field associated with the ACL for which you 
want to use to packet filtering or VLAN packet filtering. 

The Apply ACLs page opens. 

5. Click Back when you have finished viewing the application of ACL uses to the selected device. 

The view ACL page 

The View ACL page provides you with visibility into more detailed information for the selected ACL 
on the selected device. In addition, you can save the selected ACL as an ACL resource or ACL 
template in ACL Management, apply the selected ACL, or configure ACL uses for packet filtering and 
VLAN packet filtering to selected interfaces on the selected device.  

To view the View ACL page: 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system. 

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices list page opens. 
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2. Click the icon  in the ACL Configuration field for the device for which you want to view and 
manage the ACL configuration. 

The ACL Device configuration page opens. 

3. Click the ACL Definitions tab. 

ACL information for ACLs on the selected device is displayed in a list below the ACL Definition 
tab. 

4. Click the link in the ACL Identifier field for the ACL you want to view. 

The View ACL page opens. 

 The upper portion of this page provides basic ACL information including the ACL Identifier, 
Description, ACL Type, and Match Order configuration for the selected ACL. 

 The lower portion of the ACL View page contains a rule Information list that provides 
detailed information about the rules in the ACL based on the ACL type. 

The sequence number in this list serves as a link for navigating to a dialog box for viewing 
rule information specific to the rule type. 

ACL Management provides rule match count statistics in the Match Count field for the 
associated rule. 

Saving a device ACL as an ACL rule set 

Operators can save a device's ACL as a rule set in an existing ACL. Once the ACL on the device has 
been saved as a rule set, it becomes available for deployment to other network devices.  

To save an ACL on a device as an ACL rule set in ACL Management: 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system.  

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices list page opens. 

2. Click the icon  in the ACL Configuration field for the device for which you want to view and 
manage the ACL configuration. 

3. Click the ACL Definitions tab. 

ACL information for ACLs on the selected device is displayed in a list below the ACL Definition 
tab. 

4. Click the link in the ACL Identifier field for the ACL you want to save as an ACL resource in 
ACL Management. 

The View ACL page opens. 

5. Click Save as Resource. 

The Basic Info step of the Add Rule Set wizard is displayed. 

6. Select the ACL in ACL Management to which you want to add the device's ACL as a rule set 
from the Add to ACL Resource list. 

When you save an ACL on a device as an ACL resource in ACL Management, you are saving 
it as a rule set in an existing ACL. Therefore, you must first create the ACL in ACL 
Management before you can save a device's ACL to it as a rule set. For more information 
about creating an ACL in ACL Management, see "Adding an ACL use." 

7. Enter a name for the rule set in the Rule Set Name field.  

A valid length for a rule set name is 1–32 characters. 

8. Select the match order you want to apply to this ACL template by selecting the Match Order 
option you want to use: 

 If you select Config, IMC matches rules in the order in which they were configured but only 
for devices that support it. 
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 If you select Auto, IMC matches rules based on the principle of depth priority.  

9. Enter a brief description for this ACL in the ACL Description field.  

A valid length for this field is 0 - 127 characters. 

10. Enter a brief description for this rule set in the Rule Set Description field.  

A valid length for this field is 0 - 127 characters. 

11. If you want to apply a time range to the rule set, select Configure ACL Rules with Time 
Range. 

12. Click Next.  

The Configure Time Range step of the Add Rule Set wizard is displayed. 

13. Do one of the following: 

If you checked the box to Configure ACL Rules with Time Range, click Add under Configure 
Time Range to add a time range to this rule set. 

Skip to step 14. 

a. Enter a name for the time range in the Name field of the Add Time Range page.  

Time Range names must begin with a letter (A-Z) and consist of 1-32 characters. Blank 
spaces ( ) and question marks (?) are not permitted. Uppercase letters may be converted to 
lowercase letters by some devices after deployment. 

You must enter at least one time range. You can enter up to twelve fixed time ranges and 
thirty-two cyclic time ranges. 

b. Click Add to enter a time range. 

The Add Time Range dialog box opens. 

c. Select the type of time range you want to create by selecting the desired time range type: 

 Select Fixed if you want to identify a specific start and end date and time.  

 Select Cyclic if you want the time range to recur for select days of the week.  

14. Click Finish to save the ACL rules from the selected device to the new rule set. 

15. Select from one of the following to modify, copy, sort, optimize, or delete existing rules: 

 To modify rules, click the Modify icon  associated with the rule sequence you want to 
modify. For more information about modifying a rule set, see "Modifying ACL rule sets." 

 To copy rules you have already created, click the Copy icon  associated with the rule 
sequence you want to copy. For more information about copying a rule set, see "Copying a 
rule in an ACL rule set." 

 Rules that belong to a rule set that is configured with a Match Order of 'Config' are 
executed in the order in which they are displayed in the rule set. The order in which rules are 
displayed in a rule set is initially defined by the order in which they are created. You can 
redefine the order in which the rules in a rule set are executed by using the Sort feature. For 
more information about using Sort to redefine the order of appearance of rules in a rule set, 
see "Using sort to reorder the rules in an ACL rules set." 

 ACLs can have a profound effect on the performance of networks. ACL Management 
automatically evaluates the effectiveness of rules and their effect on overall network 
performance as you add rules to a rule set. However, you can also manually perform an 
analysis of a rule set and optimize its effect on network performance using the Optimize 
feature. For more information about using this feature, see "Optimizing the rules in a rule 
set." 

 To delete one or more rules from a rule set, see "Deleting rules from an ACL rule set." 

Saving a device ACL as a template 

Operators can save a device's ACL as a template, making it available for importing an ACL resource 
for deployment to other network devices. 

To save a device ACL as a template: 
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1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system.  

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices page opens and the deployment ACL Devices list is displayed on this 
page. 

2. Click the icon  in the ACL Configuration field for the device for which you want to view and 
manage the ACL configuration. 

The ACL Device configuration page opens. 

3. Click the ACL Definitions tab. 

ACL information for ACLs on the selected device is displayed in a list below the ACL Definition 
tab. 

4. Click the link in the ACL Identifier field for the ACL you want to save as an ACL resource in 
ACL Management. 

The View ACL page opens. 

5. Click Save as Template. 

The Save as new template dialog box opens. 

6. Enter the name for the template in the Save as new template field. 

A valid length for a template name is 1–32 characters. Template names cannot begin with a 
number or a space. 

7. Click OK to create the new template using the name provided. 

8. Once you have created the template you can view information for it, modify it, copy it, delete it, 
or export it. For more information about managing templates in ACL Management, see 
"Managing ACL templates in IMC." 

Applying an ACL 

On the View ACL page, you can add packet filtering or VLAN packet filtering to one or more 
interfaces on the selected device using the rules defined in the ACL for which you are viewing 
information. To add these ACL uses, the target device must support them. For more information 
about applying the ACL uses of packet filtering and VLAN packet filtering to the selected device, see 
"Adding an ACL use." 

Viewing applied ACLs 

On the View ACL page, you can view the configured packet filtering or VLAN packet filtering for the 
selected device and ACL for which you are viewing information. For more information about applying 
the ACL uses of packet filtering and VLAN packet filtering to the selected device, see "Viewing 
applied ACLs." 

Modifying an ACL 

On the View ACL page, you can modify the ACL for which you are viewing information. 

To modify an ACL: 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system.  

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices list page opens. 

2. Click the icon  in the ACL Configuration field for the device for which you want to view and 
manage the ACL configuration. 

The ACL Device configuration page opens. 
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3. Click the ACL Definitions tab. 

ACL information for ACLs on the selected device is displayed in a list below the ACL Definition 
tab. 

4. Click the link in the ACL Identifier field for the ACL you want to modify. 

The View ACL page opens. 

5. Click Modify ACL. 

The Modify ACL page opens. 

6. In the Basic Info area, enter an ACL description in the Description field. 

The ACL Identifier, ACL Type, and Match Order fields cannot be modified. 

7. In the Rule Maintenance area, perform the following tasks: 

 Click Add Rule to add rules for the ACL. To add rules by copying an existing rule, click the 

Copy icon  for the rule. For more information about configuring rules, see "Managing the 
rules in a template." 

 Click the Modify icon  for a rule to modify the rule. 

 Select one or more rules and click Delete to delete the rules. 

 Click Sort and modify the rank of rules on the window that opens.  

 Select one or more rules and click Top to move the rules to the top of the rule list. 

 Select one or more rules and click Up to move the rules up one position. 

 Select one or more rules and click Down to move the rules down one position. 

 Select one or more rules and click Bottom to move the rules to the bottom of the rule list. 

8. If you want to save the ACL as a template, perform the following tasks: 

a. Click Save as Template. 

The Save as new template dialog box opens. 

b. Enter a template name in the Save as new template field. 

c. Click OK. 

9. Click OK. 

Managing device ACL uses for packet filtering and VLAN packet filtering 

From the ACL Uses tab of the ACL Device configuration page, you can view the ACL uses for 
packet filtering and VLAN packet filtering currently deployed on the device or add and remove these 
ACL uses. 

Viewing the ACL use list 

To view the list of ACL Uses for packet filtering and VLAN packet filtering for the select ACL on the 
selected device: 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system.  

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices list page opens. 

2. Click the icon  in the ACL Configuration field for the device for which you want to view and 
manage the ACL configuration. 

The ACL Device configuration page opens. 

3. Click the ACL Uses tab. 

ACL use information for packet filtering and VLAN packet filtering is displayed in a list below the 
ACL Uses tab. The contents of this list are described below. 
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ACL uses list 

 Use Type—Identifies what type of ACL Use is being used, Packet Filtering or VLAN 
Packet Filtering. 

 View—Identifies the view of the ACL that was used. 

 ACL Name—Identifies the ACL that contains the filtering command in use. 

 Command—Displays the command used to apply the filtering. 

You can filter the ACL Uses list by Use Type by selecting the use type you want to filter for from 
the Use Type list located in the upper right corner of the ACL Uses list. Options include All, 
Packet Filter and VLAN Packet Filter. The default is All. 

Adding an ACL use 

To add an ACL use for packet filtering and VLAN packet filtering to one or more interfaces on the 
selected device: 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system.  

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices list page opens. 

2. Click the icon  in the ACL Configuration field for the device for which you want to view and 
manage the ACL configuration. 

The ACL Device configuration page opens. 

3. Click the ACL Uses tab. 

4. Click Add. 

The Select Use Type step of the Add Use deployment wizard is displayed. 

5. Select the use type you want to deploy from the list provided. 

The options displayed are defined by the supported options on the selected device. 

6. Click Next. 

The Select Object step of the Add Use deployment wizard is displayed. 

7. Select the direction that you want the filter to be applied from the Filter Direction list.  

8. Select the interfaces or VLAN interfaces to which you want to apply the filtering. 

9. Select the interfaces that you want to apply the filter to from the Interface List column on the 
left: 

 To select an interface, click the interface to highlight it and then click the right arrow key  
to select it. 

 To select all interfaces, click the double right arrow key  

 To deselect an interface, click the interface in the Selected Interfaces column to select it 

and then click the left arrow key  to deselect it. 

 To deselect all interfaces, click the double left arrow key  

10. Select the VLAN that you want to apply the filter to from the VLAN List column on the left: 

 To select a VLAN, click the VLAN to highlight it and click the right arrow key  to select it. 

 To select all interfaces, click the double right arrow key . 

 To deselect a VLAN, click the VLAN in the Selected VLANs column to highlight it and click 

the left arrow key  

 To deselect all VLANs, click the double left arrow key  

11. Repeat this step for every device you have selected for ACL use deployment. 
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12. Click Next when you have finalized your selection of interfaces for all devices to which you 
applied filtering. 

The Select ACL step of the Add Use deployment wizard is displayed. 

13. Select the ACL you want to deploy for this use from the list provided. 

The Summary step of the Add Use wizard is displayed. 

14. Review the information provided in the Summary page to ensure that you have configured the 
wizard according to your needs. 

15. Click Finish when you have finished reviewing the configuration details and are ready to submit 
the task to the ACL deployment task queue. 

The Add Task page opens. 

16. To enter a task name for this deployment task, delete the contents of this field and enter a new 
task name. 

A valid length for a task name is 1–32 characters. The task name cannot begin with a number 
(0-9). 

17. Enter a brief description for this deployment task in the Description field. 

18. Select how you want IMC to execute the task to every device from the Deployment Order 
section of the Add Task page by selecting each option. 

 Select Concurrent if you want ACL Management to execute the task to multiple devices 
simultaneously. 

 Select Sequential if you want ACL Management to execute the task to one device at a 
time. 

19. Select the strategy you want ACL Management to use should a problem arise in the execution 
of the task from the Error Handling list: 

 Select Abort the task if you want to stop the deployment to pending devices, but not affect 
devices to which deployments are in progress, or to which deployments have successfully 
completed once an error in deployment arises. 

 Select Abort the task and clear data deployed on the error device if you want to stop the 
deployment and clear all deployments on the device experiencing a problem once an error 
in deployment arises. 

 Select Skip the error device and continue if you want to stop all deployments on the 
device experiencing a problem once an error in deployment arises. 

 Clear data deployed on the error device and continue if you want to clear all 
deployments on the device experiencing a problem once an error in deployment arises. 

20. To select to save or not save the device's running configuration as the startup configuration 
prior to execution: 

 Select Yes in the Save to Startup File field. 

 Select No if you do not want to save the current configuration. 

21. You can select when you want ACL Management to execute the task to the selected device by 
selecting one of the following: 

 To execute the task immediately, select Immediately. 

 To schedule a time for ACL Management to execute the task, selecting At Scheduled 
Time. 

If you select At Scheduled Time: 

a. Click the Calendar function  next to the At Scheduled Time field to populate the date 
and time for the execution of this task. 

A popup calendar is displayed. 

b. Select the date from the calendar. 

Alternatively, you can enter the date and time manually. Valid date and time format for this 
entry is YYYY-MM-DD hh:mm where YYYY denotes the four digit year, MM denotes the two 
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digit month, DD denotes the two digit day and hh denotes the two digit hour, and mm 
denotes the two digit minute. 

22. To preview the commands of the task, click the Preview Commands icon  in the field of the 
Deploy Details list. 

The Preview Commands dialog box displays and the commands of the task to be executed is 
displayed. 

23. Review the contents to verify that these are the commands you want to execute. 

24. Click OK when you have finished previewing the commands. 

25. Click OK to accept the deployment and task configuration and to submit this request to the 
deployment task queue. 

If the task is scheduled to run immediately, the Task Result dialog box opens, providing you 
with a real time status of the deployment task. 

26. Click Close on the Task Result dialog box when the task has finished executing. 

27. Click Refresh located at the top of the Task List to reload the page with the most current 
information for all tasks in the list and review the results of the task in the Result field. 

28. Review the results of your deployment task in the Result field of the deployment Task List.  

The contents of this field serve as a link to the Task Result page that contains more detailed 
information of the results and causes for a failed deployment. From this page, you can also 
review the commands executed by the deployment task. 

Deleting an ACL use 

To delete an ACL packet filtering or VLAN packet filtering use from one or more interfaces on the 
selected device: 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system.  

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices list page opens. 

2. Click the icon  in the ACL Configuration field for the device for which you want to view and 
manage the ACL configuration. 

The ACL Device configuration page opens. 

3. Click the ACL Uses tab. 

4. Select the Use Types for the ACL uses you want to delete. 

5. Click Delete. 

6. When prompted, click OK to confirm the deletion of the selected ACL uses. 

The Add Task page opens. 

7. To enter a task name for this deployment task, delete the contents of this field and enter a new 
task name. 

A valid length for a task name is 1–32 characters. The task name cannot begin with a number 
(0-9). 

8. Enter a brief description for this deployment task in the Description field. 

9. Select how you want IMC to execute the task to every device from the Deployment Order 
section of the Add Task page by selecting each option: 

 Select Concurrent if you want ACL Management to execute the task to multiple devices 
simultaneously. 

 Select Sequential if you want ACL Management to execute the task to one device at a 
time. 
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10. Select the strategy you want ACL Management to use should a problem arise in the execution 
of the task from the Error Handling list: 

 Select Abort the task if you want to stop the deployment to pending devices, but not affect 
devices to which deployments are in progress or to which deployments have successfully 
completed once an error in deployment arises. 

 Select Abort the task and clear data deployed on the error device if you want to stop the 
deployment and clear all deployments on the device experiencing a problem once an error 
in deployment arises. 

 Select Skip the error device and continue if you want to stop all deployments on the 
device experiencing a problem once an error in deployment arises. 

 Select Clear data deployed on the error device and continue if you want to clear all 
deployments on the device experiencing a problem once an error in deployment arises. 

11. To select to save or not save the device's running configuration as the startup configuration 
prior to execution: 

 Select Yes in the Save to Startup File field. 

 Select No if you do not want to save the current configuration. 

12. You can select when you want ACL Management to execute the task to the selected device: 

 To execute the task immediately, select Immediately. 

 To schedule a time for ACL Management to execute the task, select At Scheduled Time. 

If you select At Scheduled Time: 

a. Click the Calendar function  next to the At Scheduled Time field to populate the date 
and time for the execution of this task. 

A popup calendar is displayed. 

b. Select the date from the calendar. 

Alternatively, you can enter the date and time manually. Valid date and time format for this 
entry is YYYY-MM-DD hh:mm where YYYY denotes the four digit year, MM denotes the two 
digit month, DD denotes the two digit day and hh denotes the two digit hour, and mm 
denotes the two digit minute. 

13. To preview the commands of the task, click the Preview Commands icon  in the Preview 
Commands field of the Deploy Details list. 

The Preview Commands dialog box opens and the commands of the task to be executed are 
shown. 

14. Review the contents to verify that these are the commands you want to execute. 

15. Click OK when you have finished previewing the commands. 

16. Click OK to accept the deployment and task configuration and to submit this request to the 
deployment task queue. 

If the task is scheduled to run immediately, the Task Result dialog box opens. This dialog box 
provides a real time status of the deployment task. 

17. Click Close on the Task Result dialog box when the task has finished executing. 

18. Click Refresh located at the top of the Task List to reload the page with the most current 
information for all tasks in the list and the results of the task in the Result field. 

19. Review the results of your deployment task in the Result field of the deployment Task List. 

The contents of this field serve as a link to the Task Result page that contains more detailed 
information about the results and causes for a failed deployment. From this page, you can also 
review the commands executed by the deployment task. 

Managing device ACL time ranges 

You can view and delete time ranges that have been applied to ACLs on the selected device from the 
Time Ranges tab of the ACL Device configuration page.  

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 9287



886 

Viewing the time range list 

To view the list of time ranges in use by the selected device: 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system.  

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices page opens and the deployment ACL Devices list is displayed on this 
page. 

2. Click the icon  in the ACL Configuration field for the device for which you want to view and 
manage the ACL configuration. 

The ACL Device configuration page opens. 

3. Click the Time Ranges tab. 

ACL time ranges display in a list below the Time Ranges tab. 

Time range list 

 Name—This field identifies the name of each time range in use by the selected device. The 
contents of this field serve as a link for navigating to the View Time Range page. The View 
Time Range page provides you with more detailed information for the select time range 
including the start and end dates and times for the time range if the time range type is Fixed. 
If the time range is Cyclical, the Execution Period field contains the days of the week to 
which that the time range applies. 

4. Click 8, 15, 50, 100, or 200 from the right side of the Time Range list to configure how many 
items per page you want to view. 

Deleting time ranges 

To delete one or more time ranges from the selected device: 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system.  

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices page opens and the deployment ACL Devices list is displayed on this 
page. 

2. Click the icon  in the ACL Configuration field for the device for which you want to view and 
manage the ACL configuration. 

The ACL Device configuration page opens. 

3. Click the Time Ranges tab. 

ACL time ranges is displayed in a list below the Time Ranges tab. 

4. Select the time range Names for every time range you want to delete. 

5. Click Delete. 

6. When prompted, click OK to confirm the deletion of the select time ranges. 

The Add Task page displays with the default task name in the Task Name field. 

7. To enter a task name for this deployment task, delete the contents of this field and enter a new 
task name. 

A valid length for a task name is 1-32 characters. Note that the task name cannot begin with a 
number (0-9). 

8. Enter a brief description for this deployment task in the Description field. 

9. Select how you want IMC to execute the task to every device from the Deployment Order 
section of the Add Task page by selecting each option: 
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 Select Concurrent if you want ACL Management to execute the task to multiple devices 
simultaneously. 

 Select Sequential if you want ACL Management to execute the task to one device at a 
time. 

10. Select the strategy you want ACL Management to use should a problem arise in the execution 
of the task from the Error Handling list. Options include: 

 Select Abort the task if you want to stop the deployment to pending devices, but not affect 
devices to which deployments are in progress or to which deployments have successfully 
completed once an error in deployment arises. 

 Select Abort the task and clear data deployed on the error device if you want to stop the 
deployment and clear all deployments on the device experiencing a problem once an error 
in deployment arises. 

 Select Skip the error device and continue if you want to stop all deployments on the 
device experiencing a problem once an error in deployment arises. 

 Select Clear data deployed on the error device and continue if you want to clear all 
deployments on the device experiencing a problem once an error in deployment arises. 

11. To save the device's running configuration as the startup configuration prior to execution: 

 Select Yes in the Save to Startup File field. 

 Select No if you do not want to save the current configuration. 

12. Select when you want ACL Management to execute the task to the selected device: 

 To execute the task immediately, select Immediately. 

 To schedule a time for ACL Management to execute the task, select At Scheduled Time. 

If you select At Scheduled Time: 

a. Click the Calendar function  next to the At Scheduled Time field to populate the date 
and time for the execution of this task. 

A popup calendar is displayed. 

b. Select the date from the calendar. 

c. Alternatively, you can enter the date and time manually. 

Valid date and time format for this entry is YYYY-MM-DD hh:mm where YYYY denotes the 
four digit year, MM denotes the two digit month, DD denotes the two digit day and hh 
denotes the two digit hour, and mm denotes the two digit minute. 

13. To preview the commands of the task, click the Preview Commands icon  in the field of the 
Deploy Details list. 

The Preview Commands dialog box opens and displays the commands of the task to be 
executed. 

14. Review the contents to verify that these are the commands you want to execute. 

15. Click OK when you have finished previewing the commands. 

16. Click OK to accept the deployment and task configuration and to submit this request to the 
deployment task queue. 

If the task is scheduled to run immediately, the Task Result dialog box opens, providing you 
with a real time status of the deployment task. 

17. Click Close on the Task Result dialog box when the task has finished executing. 

18. Click Refresh located at the top of the Task List to reload the page with the most current 
information for all tasks in the list to review the results of the task in the Result field. 

19. Review the results of your deployment task in the Result field of the deployment Task List.  

The contents of this field serve as a link to the Task Result page that contains more detailed 
information about the results and causes for a failed deployment. From this page, you can also 
review the commands executed by the deployment task. 
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Managing device configuration history 

From the Config History tab of the ACL Device configuration page, you can view the ACL 
configuration history for the selected device and the configuration details for every entry in the ACL 
configuration history. You can also modify a configuration history entry and a baseline entry. 

Viewing the ACL configuration history 

To view the ACL configuration history for the selected device: 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system.  

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices list page opens. 

2. Click the icon  in the ACL Configuration field for the device for which you want to view and 
manage the ACL configuration. 

The ACL Device configuration page opens. 

3. Click the Config History tab. 

The ACL configuration history is displayed in a list below the Config History tab. 

ACL configuration history list 

 Version—Contains the type of ACL configuration history list entry, a common ACL 
configuration history entry, or a baseline entry. 

 Update Date—Contains the date and time when this entry was executed. The contents of 
this field serve as a link for navigating to the View Config History page for viewing details 
for the individual entry. For more information about this feature, see "Viewing an ACL 
configuration history entry." 

 Description—Contains a description for the ACL configuration entry. 

 Baseline—Contains an icon  for setting the associated ACL configuration history event 
as a baseline configuration. 

 Modify—Contains an icon  for modifying the description of the associated ACL 
configuration history entry. 

If the list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the ACL Configuration History list. 

 Click  to page forward to the end of the ACL Configuration History list. 

 Click  to page backward in the ACL Configuration History list. 

 Click  to page backward to the front of the ACL Configuration History list. 

4. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

You can sort the ACL Configuration History list by the Version, Update Date, and 
Description fields by clicking the column label to sort the list by the selected field. The column 
label is a toggle switch that allows you to toggle between the various sort options specific to 
each field. 

Viewing an ACL configuration history entry 

To view the details for an entry in the ACL configuration history list for the selected device: 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system.  
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b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices page opens and the deployment ACL Devices list is displayed on this 
page. 

2. Click the icon  in the ACL Configuration field for the device for which you want to view and 
manage the ACL configuration. 

The ACL Device configuration page opens. 

3. Click the Config History tab. 

The ACL configuration history is displayed in a list below the Config History tab. 

4. Click the link in the Update Date field of the Config History list associated with the entry you 
want to view. 

The View Config History page opens. The upper portion of the page contains basic 
information on the configuration history entry and details on the ACL configuration file that was 
changed on the associated device. 

Modifying a configuration history entry 

To modify an entry in the ACL configuration history list for the selected device: 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system.  

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices list page opens. 

2. Click the icon  in the ACL Configuration field for the device for which you want to view and 
manage the ACL configuration. 

The ACL Device configuration page opens. 

3. Click the Config History tab. 

The ACL configuration history is displayed in a list below the Config History tab. 

4. Click the Modify icon  in the Modify field associated with the ACL configuration history 
event you want to modify. 

The Modify Config History dialog box opens. 

5. Enter a new description for the entry in the Description field provided. 

6. Click OK to accept your modifications to the ACL configuration history entry. 

Deleting configuration history entries 

To delete one or more entries from the ACL configuration history list for the selected device: 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system.  

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices list page opens. 

2. Click the icon  in the ACL Configuration field for the device for which you want to view and 
manage the ACL configuration. 

The ACL Device configuration page opens. 

3. Click the Config History tab. 

The ACL configuration history is displayed in a list below the Config History tab. 

4. Select the Version and Update Date fields of the entries you want to delete. 
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5. Click Delete. 

6. When prompted, click OK to confirm the deletion of the selected ACL configuration history 
entries. 

Baselining a configuration history entry 

Defining an ACL configuration history entry as a baseline enables you to mark a particular device 
configuration performed at a certain point in time. 

To establish an ACL configuration baseline for the selected device: 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system.  

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices list page opens. 

2. Click the icon  in the ACL Configuration field for the device for which you want to view and 
manage the ACL configuration. 

The ACL Device configuration page opens. 

3. Click the Config History tab. 

The ACL configuration history is displayed in a list below the Config History tab. 

4. Click the Baseline icon  in the field for the configuration history entry for which you want to 
establish as a baseline. 

5. Confirm that the entry has been configured as the baseline entry by reviewing the contents of 
the Version field for the entry you designated as the baseline entry.  

Only one entry can serve as a baseline entry. 

Managing device flow templates 

From the Flow Template Definitions tab of the ACL Device configuration page, you can view, add, 
modify, and remove device flow templates.  

Viewing the flow template 

To view the flow templates for the selected device: 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system.  

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices list page opens. 

2. Click the icon  in the ACL Configuration field for the device for which you want to view and 
manage the ACL configuration. 

The ACL Device configuration page opens. 

3. Click the Flow Template Definitions tab. 

The flow templates that already exist on the device display in a list below the Flow Template 
Definitions tab.  

Flow template definitions 

 Name—Contains the name assigned to this flow template. 

 Type—Identifies the type of flow template. The type can only be Basic. 

 Status—Contains the current status of the flow template. Status values include Used and 
Unused. 
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 NOTE: 

Flow templates in use cannot be deleted. 
 

 Modify—Contains an icon  for modifying this flow template. 

 Details—Contains an icon  for viewing this flow template. 

 Delete—Contains an icon  for deleting this flow template. 

You can sort the Flow Template Definitions list by the Name, Type and Status fields by 
clicking the column label to sort the list by the selected field. The column label is a toggle 
switch that allows you to toggle between the various sort options specific to each field. 

Viewing flow template details 

To view the details for an entry in the flow template list for the selected device: 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system.  

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices list page opens. 

2. Click the icon  in the ACL Configuration field for the device for which you want to view and 
manage the ACL configuration. 

The ACL Device configuration page opens. 

3. Click the Flow Template Definitions tab. 

The flow templates that already exist on the device display in a list below the Flow Template 
Definitions tab. 

4. Click the Details icon  in the field of the Flow Template Definitions list associated with the 
entry you want to view. 

The View Template Definition page opens. 

View template 

 Name—Contains the name assigned to this flow template. 

 Type—Identifies the type of flow template. The type can only be Basic. 

 Parameter Name—Contains the parameters defined for the flow template. 

5. Click Back when you have finished viewing the flow template to the selected device. 

Adding flow template definition 

To add a flow template to the selected device: 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system.  

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices list page opens. 

2. Click the icon  in the ACL Configuration field for the device for which you want to view and 
manage the ACL configuration. 

The ACL Device configuration page opens. 

3. Click the Flow Template Definitions tab. 

The flow templates that already exist on the device display in a list below the Flow Template 
Definitions tab. 

4. Click Add. 
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The Add Flow Template Definitions page opens. 

5. Enter a name in Template Name field.  

A valid length for a task name is 1-32 characters. The template name cannot begin with a 
number (0-9) or contain any spaces or question marks. 

The template type, Basic, is selected by default.  

6. Select the parameters that you want to add to the flow template in Set Parameters: 

 Address Type—Allows you set the address type. 

 Precedence Type—Allows you to set the type of precedence. 

 Protocol Type—Allows you to set the protocol type. 

7. Click OK. 

Modifying flow template definitions 

To modify a flow template to the selected device: 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system.  

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices list page opens. 

2. Click the icon  in the ACL Configuration field for the device for which you want to view and 
manage the ACL configuration. 

The ACL Device configuration page opens. 

3. Click the Flow Template Definitions tab. 

The flow templates that already exist on the device display in a list below the Flow Template 
Definitions tab. 

4. Click the Modify icon  in the Set Parameters, select the parameter that you want to add to 
the flow template or uncheck the boxes to the left of the parameters that you want to remove 
from the template: 

 Address Type—Allows you set the address type. 

 Precedence Type—Allows you to set the type of precedence.  

 Protocol Type—Allows you to set the protocol type.  

5. Click OK. 

Deleting flow template definition 

To delete a flow template to the selected device: 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system.  

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices list page opens. 

2. Click the icon  in the ACL Configuration field for the device for which you want to view and 
manage the ACL configuration. 

The ACL Device configuration page opens. 

3. Click the Flow Template Definitions tab. 

The flow templates that already exist on the device display in a list below the Flow Template 
Definitions tab. 
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4. Click the icon  in the Modify field of the Flow Template Definitions list associated with the 
entry you want to modify. 

The Modify Flow Template Definition page opens. 

5. In Set Parameters section, select the parameter that you want to add to the flow template or 
uncheck the boxes to the left of the parameters that you want to remove from the template: 

 Address Type—Allows you set the address type. 

 Precedence Type—Allows you to set the type of precedence.  

 Protocol Type—Allows you to set the protocol type.  

6. Click OK. 

Deleting flow template definition 

To delete a flow template to the selected device: 

1. Navigate to ACL Devices: 

a. Click the Service tab from the top tabular navigation system.  

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices list page opens. 

2. Click the icon in the ACL Configuration field for the device for which you want to view and 
manage the ACL configuration. 

The ACL Device configuration page opens. 

3. Click the Flow Template Definitions tab. 

The flow templates that already exist on the device display in a list below the Flow Template 
Definitions tab. 

4. Select the flow template Names for every flow template you want to delete. 

5. Click Delete. 

6. When prompted, click OK to confirm the deletion of the selected flow templates. 

Managing device flow template applications 

From the Flow Template Applications tab of the ACL Device configuration page, you can view, add, 
and delete flow template applications.  

Viewing flow template application 

To view the flow template applications for the selected device: 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system.  

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices list page opens. 

2. Click the icon  in the ACL Configuration field for the device for which you want to view and 
manage the ACL configuration. 

The ACL Device configuration page opens. 

3. Click the Flow Template Applications tab. 

The flow templates that have been applied to the device display in a list below the Flow 
Template Applications tab.  

Flow template 

 Interface Description—Identifies the interface for the selected device. 

 Template Name—Contains the name assigned to this flow template. 
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 Template Type—Identifies the type of flow template. The type can only be Basic. 

 Delete—Contains an icon  for deleting this flow template application from interface. 

You can sort the Flow Template Applications list by the Interface , Template Name and 
Template Type fields by clicking the column label to sort the list by the select field. The 
column label is a toggle switch that allows you to toggle between the various sort options 
specific to each field. 

Adding flow template application 

To add a flow template application to the selected device: 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system.  

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices list page opens. 

2. Click the icon  in the ACL Configuration field for the device for which you want to view and 
manage the ACL configuration. 

The ACL Device configuration page opens. 

3. Click the Flow Template Applications tab. 

The flow templates that have been applied to the device display in a list below the Flow 
Template Applications tab. 

4. Click Add. 

The Add Flow Template Application page opens. 

5. Select a flow template from the Flow Template list. 

For more information about adding a flow template, see "Managing device flow templates." 

6. Select interfaces from Interface List. 

7. Click OK.  

The page updates to Add Flow Template Application list.  

Add flow template application 

 Device Name—Identifies the device name and IP address. 

 Interface Desc—Identifies the interface to which the flow template is applied. 

 Flow Template Name—Identifies the name of the flow template that is applied to the 
interface. 

 Operate Result—Contains the application result for the interface. If the application is 

successfully added, the icon  is displayed. If the system fails to add the application, the 

icon  is displayed. 

Clicking the icon brings up a message box listing the possible reasons for the failure. 

Deleting flow template application 

To delete a flow template application from the selected device: 

1. Navigate to ACL Devices. 

a. Click the Service tab from the top tabular navigation system.  

b. Click ACL Management on the left navigation tree. 

c. Click ACL Devices under ACL Management on the left navigation tree. 

The ACL Devices list page opens. 

2. Click the icon  in the ACL Configuration field for the device for which you want to view and 
manage the ACL configuration. 
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The ACL Device configuration page opens. 

3. Click the Flow Template Applications tab. 

The flow templates that have been applied to the device display in a list below the Flow 
Template Applications tab. 

4. Select the Interface Description field for every flow template application you want to delete. 

5. Click Delete. 

6. When prompted, click OK to confirm the deletion of the flow template application. 

Deploying ACLs using IMC ACL deployment 
wizard 

ACL Management's ACL Deployment wizard provides you with a step-by-step guide for 
successfully deploying ACLs by providing you with a facility for viewing all deployment tasks through 
the ACL Deployment Task List. In addition, there are step-by-step guides for deploying ACLs and 
ACL uses, for removing ACLs, ACL time ranges, and ACL uses. During the deployment task 
configuration process for each of these deployment types, IMC evaluates the selected devices and 
ACLs to determine whether or not the task can be executed successfully, identifies when devices do 
not match the configuration selections, and displays warning messages and evaluation results to 
guide the successful deployment of ACL resources. In addition, ACL Management removes devices 
from the deployment configuration for which the select action cannot be successfully executed. 

The ACL Deployment wizard also gives you the choice to run deployment tasks immediately or to 
schedule them for a later date, to execute tasks to one or more devices sequentially or in concurrent, 
and how to handle errors when they arise. 

Managing the deployment task list 
ACL Management displays all deployment tasks, including tasks that have already been executed 
and those waiting for execution, in the deployment Task List. This list provides you with a single 
portal for managing ACL deployment tasks, including navigating to views that display task details 
and task results, links to modifying a task and the ability to start and stop deployment tasks. 

Viewing the deployment task list 

To view all deployment tasks in the Task List: 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click the ACL Management on the left navigation tree. 

c. Click ACL Deployment under ACL Management on the left navigation tree. 

The ACL Deployment page opens and the deployment Task List is in the lower half of this 
page. 

Deployment task 

 Status—Contains the current status of the deployment task. Possible values include: 

 Waiting for Execution 

 Executing 

 Finished 

 Paused 

 Stopping 

 Task Name—Contains the name of the deployment task. 
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The contents of this field serve as a link to the View Task page which provides details 
for the associated deployment task including basic task information, the deployment 
strategy and the devices configured in the deployment task. For more information, see 
"Viewing deployment task detailed information." 

You can configure the task name when using the ACL Deployment wizard to deploy an 
ACL. 

Otherwise, IMC provides a default task name that includes a date and time stamp for 
uniquely identifying deployment tasks. 

 Creation Time—Identified the date and time stamp for the creation of the associated 
ACL deployment task. 

 Creator—Contains the user ID of the operator who submitted the task to the 
deployment Task List. 

 Task Type—Identifies whether or not the deployment task was configured to run 
immediately or was scheduled for a specific or fixed date and time. 

 Expected Time—Contains the date and time stamp of the start time of the associated 
deployment task's execution. 

 End Time—Contains the date and time stamp of the end time of the associated 
deployment task's completion. This field contains a "-" if the associated task has not 
been executed. 

 Result—Contains a summary of the result of the deployment task. The contents of this 
field serve as a link for navigating to the Task Result page. This report provides you with 
a summary of the task result, cause for failure if the execution of the deployment task 
failed, and the command that was executed. 

 Modify—Contains an icon  for modifying the configuration parameters of the ACL 
deployment task. For more information about modifying an ACL deployment task, see 
"Modifying an ACL deployment task." 

You can sort the deployment Task List by clicking the column labels: 

 Status 

 Task Name 

 Creation Time 

 Creator 

 Task Type 

 Expected Time 

 End Time 

 Result 

The column label is a toggle switch that allows you to toggle between the various sort 
options specific to each field. 

If the deployment Task List spans multiple pages, use the following aids to navigate the list. 

 Click  to page forward in the deployment Task List. 

 Click  to page forward to the end of the deployment Task List. 

 Click  to page backward in the deployment Task List. 

 Click  to page backward to the front of the deployment Task List. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 
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3. To filter the deployment Task List by task status, select the task status you want to filter for 
from the Task Status list located in the upper right corner of the Task List. 

Viewing deployment task detailed information 

To view the details of a deployment task: 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click the ACL Management on the left navigation tree. 

c. Click ACL Deployment under ACL Management on the left navigation tree. 

The ACL Deployment page opens and the deployment Task List is in the lower half of this 
page. 

2. Click the link in the Task Name field associated with the ACL deployment task for which you 
want to view details. 

The View Task page opens. 

The basic information of detailed information 

 Task Name—Contains the name of the deployment task. Operators can configure the task 
name when using the ACL Deployment wizard to deploy an ACL. Otherwise, IMC provides 
a default task name that includes a date and time stamp for uniquely identifying deployment 
tasks. 

 Description—Contains the description that the creator of this ACL deployment task added. 

 Deployment Order—Contains the deployment order select by the creator of this task. 

 Error Handling—Contains the manner in which ACL Management handles errors in the 
deployment of the select ACL and rule set based on the creator's configuration for error 
handling. 

 Save to Startup File—Identifies whether or not ACL Management saves the running 
config to the startup config on the device after the deployment has been completed. 

 Execute—Contains the date and time stamp for the execution of this task. 

The deploy details of detailed information 

 Device—Contains the device label for the devices to which the ACL rule set was deployed. 
This field is a link to the ACL Devices device information page. For more information, see 
"Managing device ACL definitions." 

 Category—Identifies the type of ACL deployment task. 

 Name—Contains the name of the ACL that was configured for deployment. 

 Operation—Contains the type of operation configured for execution within the category 
specified. 

 Preview Commands—Contains an icon  for navigating to the dialog box that displays 
the commands to be executed. If the task has completed, this field is not displayed. 

Modifying an ACL deployment task 

You can modify any task in the Task List that has not completed or that has paused. 

To modify a deployment task: 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click the ACL Management on the left navigation tree. 

c. Click ACL Deployment under ACL Management on the left navigation tree. 

The ACL Deployment page opens and the deployment Task List is in the lower half of this 
page. 

2. Click the Modify icon  for the deployment task you want to modify. 
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The Modify Task page opens with the default task name displayed in the Task Name field. 

3. To enter a task name for this deployment task, delete the contents of this field and enter a new 
task name.  

A valid length for a task name is 1–32 characters. The task name cannot begin with a number 
(0-9). 

4. Enter a brief description for this deployment task in the Description field. 

5. Select how you want IMC to execute the deployment of ACLs to every device in the deployment 
task from the Deployment Order of the Modify Task page by selecting the appropriate option: 

 Select Concurrent if you want ACL Management to deploy the ACL to multiple devices 
simultaneously. 

 Select Sequential if you want ACL Management to deploy the ACL to one device at a time. 

6. Select the strategy you want ACL Management to use should a problem arise in the 
deployment of ACLs to devices from the Error Handling list. Options include: 

 Select Abort the task if you want to stop the deployment to pending devices, but not affect 
devices to which deployments are in progress or to which deployments have successfully 
completed once an error in deployment arises. 

 Select Abort the task and clear data deployed on the error device if you want to stop the 
deployment and clear all deployments on the device experiencing a problem once an error 
in deployment arises. 

 Select Skip the error device and continue if you want to stop all deployments on the 
device experiencing a problem once an error in deployment arises. 

 Select Clear data deployed on the error device and continue if you want to clear all 
deployments on the device experiencing a problem once an error in deployment arises. 

7. You can select to save the device's running configuration as the startup configuration prior to 
execution: 

 Select Yes in the Save to Startup File field. 

 Select No if you do not want to save the current configuration. 

8. Select when you want ACL Management to deploy the select ACL and rule list to the selected 
devices: 

 To deploy the ACL and rule set immediately, select Immediately. 

 To schedule a time for ACL Management to deploy the ACL and rule set, select At 
Scheduled Time. 

 If you select At Scheduled Time: 

a. Click the Calendar function  next to the At Scheduled Time field to populate the date 
and time for the execution of this task.  

A popup calendar is displayed. 

b. Select the date from the calendar.  

c. Alternatively, you can enter the date and time manually.  

Valid date and time format for this entry is YYYY-MM-DD hh:mm where YYYY denotes the 
four digit year, MM denotes the two digit month, DD denotes the two digit day and hh 
denotes the two digit hour, and mm denotes the two digit minute. 

9. To preview the commands of the ACL rule set that deploys, click the Preview Commands icon 

 in the field of the Deploy Details list. 

The Preview Commands dialog box opens and displays the contents of the rule list configured 
for deployment to the selected device. 

10. Review the contents to verify that these are the rules you want to deploy for every device. 

11. Click OK when you have finished reviewing the rules. 
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12. Click OK to accept the deployment and task modification and to submit this request to the 
deployment task queue. 

Starting an ACL deployment task 

To re-start a deployment task that has been paused: 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click the ACL Management on the left navigation tree. 

c. Click ACL Deployment under ACL Management on the left navigation tree. 

The ACL Deployment page opens and the deployment Task List is in the lower half of this 
page. 

2. Select the Status and Task Name fields for the deployment tasks you want to start. Note that 
you can only start deployment tasks that have been paused. 

3. Click Start located at the top of the Task List. 

The Status for the deployment task indicates that the task is now in a waiting status. 

Stopping an ACL deployment task 

To stop a deployment task: 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click the ACL Management on the left navigation tree. 

c. Click ACL Deployment under ACL Management on the left navigation tree. 

The ACL Deployment page opens and the deployment Task List is in the lower half of this 
page. 

2. Select the Status and Task Name fields for the deployment task you want to stop. 

3. Click Stop located at the top of the Task List. 

The Status for the deployment task indicates that the task has been paused. 

Managing deployments using the ACL deployment wizard 
The ACL Deployment wizard provides you with a step-by-step guide for successfully deploying and 
removing ACLs and ACL uses. During the deployment task configuration process, IMC evaluates the 
selected devices and ACLs to determine whether or not the task can be executed successfully, 
identifies when devices do not match the configuration selections, displays warning messages and 
evaluation results to guide the successful deployment of ACL resources, and removes devices from 
the deployment configuration for which the select action cannot be successfully executed. 

You can choose to run deployment tasks immediately or to schedule them for a later date and you 
can also choose to execute tasks to one or more devices sequentially or concurrently. Operators can 
also choose how ACL Management handles errors when they arise. 

Deploying ACLs to devices 

You can use ACL Management's ACL Deployment wizard to deploy an ACL rule set to one or more 
devices. 

To deploy an ACL to one or more devices: 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click the ACL Management on the left navigation tree. 

c. Click ACL Deployment under ACL Management on the left navigation tree. 

The ACL Deployment page opens. 
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2. Click the Deploy ACLs icon located under the Deploy Wizard of the ACL Deployment page. 

The Settings step of the Deploy ACLs wizard is displayed. 

3. To select the devices you want to deploy ACLs to, click Select located under Select Devices. 

The Select Devices dialog box opens. 

You can add devices by using either the View or Advanced query option. For more information, 
see "Adding devices by view" and "Adding devices by advanced query." 

You can add devices by using either the View or Advanced query option. 

4. To select the ACL you want to add, click Select located under Select ACL Resource. 

The Select ACL Resource dialog box opens with all ACLs displayed in the list. 

5. Select a rule set from the Select Rule Set to Deploy list associated with the ACL that contains 
the rule set you want to deploy. 

6. Click OK to accept your ACL and rule set choice.  

7. Confirm that the rule set from the ACL you selected now is displayed in the Select ACL 
Resource list. 

8. To delete the ACL and rule set you have selected, click the Delete icon  for the rule set want 
to delete. Repeat the instructions in this step to re-select a rule list from an ACL. 

9. Click Next. 

The Summary step of the Deploy ACLs wizard is displayed with the ACLs to Deploy list that 
contains all devices to which the selected ACL and rule set are deployed. 

10. Review the entire contents of the ACLs to Deploy list to verify that the deployment is 
configured as intended. 

11. In particular, select from the Deploy Strategy field, the deploy strategy you want to employ for 
every device you have selected for ACL deployment.  

Deployment strategies include: 

 Select Not Deploy if you have decided after reviewing the deployment information that you 
do not want to deploy the selected rule list to the associated device. 

 Select Add if you want to deploy the selected ACL and rule list to the device. If an ACL with 
the same name already exists on the device, the existing ACL is deleted and replaced with 
the ACL and rule list to be deployed. 

 Select Append if you want to append the contents of the selected ACL and rule list to an 
ACL with the same name that already exists on the device. This option is only selectable if 
there is already an existing ACL with the same name or identifier. 

 

 CAUTION: 

If an ACL with the same name exists, the match order of the ACL for the Add or Append operation 
must match that of the existing ACL. 
 

If a device does not support ACLs, the device will not be displayed in the list. 

12. Click Deploy to accept your ACL deployment configuration. 

The Add Task page opens. 

The default task name is displayed in the Task Name field.  

13. To enter a task name for this deployment task, delete the contents of this field and enter a new 
task name. 

A valid length for a task name is 1–32 characters. The task name cannot begin with a number 
(0-9). 

14. Enter a brief description for this deployment task in the Description field. 

15. Select how you want IMC to execute the task to every device from the Deployment Order of 
the Add Task page by selecting the appropriate option: 
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 Select Concurrent if you want ACL Management to execute the task to multiple devices 
simultaneously. 

 Select Sequential if you want ACL Management to execute the task to one device at a 
time. 

16. Select the strategy you want ACL Management to use should a problem arise in the execution 
of the task from the Error Handling list. Options include: 

 Select Abort the task if you want to stop the deployment to pending devices, but not affect 
devices to which deployments are in progress or to which deployments have successfully 
completed once an error in deployment arises. 

 Select Abort the task and clear data deployed on the error device if you want to stop the 
deployment and clear all deployments on the device experiencing a problem once an error 
in deployment arises. 

 Select Skip the error device and continue if you want to stop all deployments on the 
device experiencing a problem once an error in deployment arises. 

 Select Clear data deployed on the error device and continue if you want to clear all 
deployments on the device experiencing a problem once an error in deployment arises. 

17. Select to save the device's running configuration as the startup configuration prior to execution: 

 Select Yes in the Save to Startup File field.  

 Select No if you do not want to save the current configuration. 

18. Select when you want ACL Management to execute the task to the selected devices: 

 To execute the task immediately, select Immediately. 

 To schedule a time for ACL Management to execute the task, select At Scheduled Time. 

 If you select At Scheduled Time: 

a. Click the calendar function  next to the At Scheduled Time field to populate the date 
and time for the execution of this task.  

A popup calendar is displayed. 

b. Select the date from the calendar.  

c. Alternatively, you can enter the date and time manually. 

Valid date and time format for this entry is YYYY-MM-DD hh:mm where YYYY denotes the 
four digit year, MM denotes the two digit month, DD denotes the two digit day and hh 
denotes the two digit hour, and mm denotes the two digit minute. 

19. To preview the commands of the task, click the Preview Commands icon  in the field of the 
Deploy Details list. 

The Preview Commands dialog box opens and displays the commands of the task to be 
executed. 

20. Review the contents to verify that these are the commands you want to execute. 

21. Click OK when you have finished previewing the commands. 

22. Click OK to accept the deployment and task configuration and to submit this request to the 
deployment task queue. 

If the task is scheduled to run immediately, the Task Result dialog box opens. This dialog box 
provides you with a real time status of the deployment task. 

23. Click Close on the Task Result dialog box when the task has finished executing. 

24. To review the results of the task in the Result field of the Task List, click Refresh located at the 
top of the Task List to reload the page with the most current information for all tasks in the list. 

25. Review the results of your deployment task in the Result field of the deployment Task List.  

The contents of this field serve as a link to the Task Result page that contains more detailed 
information of the results and causes for a failed deployment. From this page, you can also 
review the commands executed by the deployment task. 
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Removing ACLs from devices 

You can use the ACL Deployment wizard to remove ACLs from selected devices. 

To remove an ACL from one or more devices: 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click the ACL Management on the left navigation tree. 

c. Click ACL Deployment under ACL Management on the left navigation tree. 

The ACL Deployment page opens. 

2. Click Delete ACLs on Devices under the Deploy Wizard section of the ACL Deployment 
page. 

The Select Devices step of the Delete ACLs on Devices wizard is displayed. 

3. To select the devices you want to remove ACLs from, click Select Devices located under the 
Select Devices step page. 

The Select Devices dialog box opens. 

4. Add devices by using either the View or Advanced query option.  

For more information, see "Adding devices by view" and "Adding devices by advanced query." 

5. Click Next. 

The Select ACL step of the Delete ACLs on Devices wizard is displayed. 

6. Select the ACL identity type for the ACL you want to delete. 

For more information about using ACL Management to view the ACLs on a device and ACL 
details, see "Managing device ACL definitions." 

7. Enter the ACL identifier you want to delete in the ACL Identifier field. 

8. Click Next. 

The Summary step of the Delete ACLs on Devices wizard is displayed. 

9. Review the contents of this page to verify the configuration of the Delete ACLs task: 

 If the ACL Exists on Device field contains the value No, then the Delete ACL deployment 
task cannot proceed because the ACL specified in the previous step cannot be found on the 
selected device. 

 If the ACL Exists on Device field contains the value Yes, then the Delete ACL deployment 
task can proceed because the ACL specified in the previous step was found on the selected 
device. 

 If the ACL Being Used field contains the value Yes, then the Delete ACL deployment task 
cannot proceed because the ACL specified in the previous step is in use. 

 If the ACL Being Used field contains the value No, then the Delete ACL deployment task 
can proceed because the ACL specified in the previous step is not in use. 

10. Click Finish when you have finished reviewing the configuration details and are ready to submit 
the task to the ACL deployment task queue. 

The Delete ACLs on Device Result page opens with the results of ACL Management's 
evaluation of the deployment task. If the delete ACL deployment task can be completed 
successfully, the Success field contains the value Yes. 

11. Click Deploy if the Success field contains the value Yes to proceed to the next step in the 
deployment process. 

The Add Task page opens with the default task name in the Task Name field. 

12. To enter a task name for this deployment task, delete the contents of this field and enter a new 
task name. 

A valid length for a task name is 1–32 characters. The task name cannot begin with a number 
(0-9). 
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13. Enter a brief description for this deployment task in the Description field. 

14. Select how you want IMC to execute the task to every device from the Deployment Order of 
the Add Task page by selecting the appropriate option: 

Select Concurrent if you want ACL Management to execute the task to multiple devices 
simultaneously. 

Select Sequential if you want ACL Management to execute the task to one device at a time. 

15. Select the strategy you want ACL Management to use should a problem arise in the execution 
of the task from the Error Handling list. Options include: 

 Select Abort the task if you want to stop the deployment to pending devices, but not affect 
devices to which deployments are in progress or to which deployments have successfully 
completed once an error in deployment arises. 

 Select Abort the task and clear data deployed on the error device if you want to stop the 
deployment and clear all deployments on the device experiencing a problem once an error 
in deployment arises. 

 Select Skip the error device and continue if you want to stop all deployments on the 
device experiencing a problem once an error in deployment arises. 

 Select Clear data deployed on the error device and continue if you want to clear all 
deployments on the device experiencing a problem once an error in deployment arises. 

16. Save the device's running configuration as the startup configuration prior to execution: 

 Select Yes in the Save to Startup File field.  

 Select No if you do not want to save the current configuration. 

17. Select when you want ACL Management to execute the task to the selected devices: 

 To execute the task immediately, select Immediately. 

 To schedule a time for ACL Management to execute the task, select At Scheduled Time. 

If you select At Scheduled Time: 

a. Click the Calendar function  next to the At Scheduled Time field to populate the date 
and time for the execution of this task. 

A popup calendar is displayed. 

b. Select the date from the calendar. 

c. Alternatively, you can enter the date and time manually. 

Valid date and time format for this entry is YYYY-MM-DD hh:mm where YYYY denotes the 
four digit year, MM denotes the two digit month, DD denotes the two digit day and hh 
denotes the two digit hour, and mm denotes the two digit minute. 

18. To preview the commands of the task, click the Preview Commands icon  in the field of the 
Deploy Details list. 

The Preview Commands dialog box opens and the commands of the task to be executed are 
shown. 

19. Review the contents to verify that these are the commands you want to execute. 

20. Click OK when you have finished previewing the commands. 

21. Click OK to accept the deployment and task configuration and to submit this request to the 
deployment task queue. 

If the task is scheduled to run immediately, the Task Result dialog box opens with the real time 
status of the deployment task. 

22. Click Close on the Task Result dialog box when the task has finished executing. 

23. To review the results of the task in the Result field of the Task List, click Refresh located at the 
top of the Task List to reload the page with the most current information for all tasks in the list. 

24. Review the results of your deployment task in the Result field of the deployment Task List.  
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The contents of this field serve as a link to the Task Result page that contains more detailed 
information the result and causes for a failed deployment. From this page, you can also review 
the commands executed by the deployment task. 

Deleting time ranges on devices 

You can use the ACL Deployment wizard to remove ACL time range configurations from select 
devices. 

To remove a time range from an ACL one or more devices: 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click the ACL Management on the left navigation tree. 

c. Click ACL Deployment under ACL Management on the left navigation tree. 

The ACL Deployment page opens. 

2. Click Delete Time Ranges on Devices under the Deploy Wizard of the ACL Deployment 
page. 

The Config step of the Delete Time Ranges on Devices wizard is displayed. 

3. Enter the name of the time range you want to remove in the Input time ranges to be deleted 
field. 

4. To identify the time ranges that are configured on a device, go to the ACL Devices feature of 
the ACL Management.  

For more information about using ACL Management to view the ACLs on a device and ACL 
details, see "Managing device ACL definitions." 

5. To select the devices you want to remove time ranges from, click Select Devices in the Select 
Devices section of the Config step page. 

The Select Devices dialog box opens. 

6. Add devices by using either the View or Advanced query option.  

For more information, see "Adding devices by view" and "Adding devices by advanced query." 

7. Click Next. 

The Summary step of the Delete Time Ranges on Devices wizard is displayed. 

8. Review the contents of this page to verify the configuration of the delete time range task: 

 If the Time Range Exists on Device field contains the value No, then the deployment task 
cannot proceed because the time range specified in the previous step cannot be found on 
the selected device. 

 If the Time Range Exists on Device field contains the value Yes, then the deployment task 
can proceed because the time ranges specified in the previous step was found on the 
selected device. 

9. Click Finish when you have finished reviewing the configuration details and are ready to submit 
the task to the ACL deployment task queue. 

The Delete Time Ranges on Devices Result page display with the results of ACL 
Management's evaluation of the deployment task. If the delete the time range deployment task 
can be completed successfully, the Success field contains the value Yes. 

10. Click Deploy if the Success field contains the value Yes to proceed to the next step in the 
deployment process. 

The Add Task page opens. 

The default task name is displayed in the Task Name field.  

11. To enter a task name for this deployment task, delete the contents of this field and enter a new 
task name.  

A valid length for a task name is 1–32 characters. The task name cannot begin with a number 
(0-9). 
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12. Enter a brief description for this deployment task in the Description field. 

13. Select how you want IMC to execute the task to every device from the Deployment Order of 
the Add Task page by selecting the applicable option: 

 Select Concurrent if you want ACL Management to execute the task to multiple devices 
simultaneously. 

 Select Sequential if you want ACL Management to execute the task to one device at a 
time. 

14. Select the strategy you want ACL Management to use should a problem arise in the execution 
of the task from the Error Handling list. Options include: 

 Select Abort the task if you want to stop the deployment to pending devices, but not affect 
devices to which deployments are in progress or to which deployments have successfully 
completed once an error in deployment arises. 

 Select Abort the task and clear data deployed on the error device if you want to stop the 
deployment and clear all deployments on the device experiencing a problem once an error 
in deployment arises. 

 Select Skip the error device and continue if you want to stop all deployments on the 
device experiencing a problem once an error in deployment arises. 

 Select Clear data deployed on the error device and continue if you want to clear all 
deployments on the device experiencing a problem once an error in deployment arises. 

15. Save the device's running configuration as the startup configuration prior to execution: 

 Select Yes in the Save to Startup File field.  

 Select No if you do not want to save the current configuration. 

16. You can select when you want ACL Management to execute the task to the selected devices: 

 To execute the task immediately, select Immediately. 

 To schedule a time for ACL Management to execute the task, select At Scheduled Time. 

If you select At Scheduled Time: 

a. Click the Calendar function  next to the At Scheduled Time field to populate the date 
and time for the execution of this task.  

A popup calendar is displayed.  

b. Select the date from the calendar.  

c. Alternatively, you can enter the date and time manually.  

Valid date and time format for this entry is YYYY-MM-DD hh:mm where YYYY denotes the 
four digit year, MM denotes the two digit month, DD denotes the two digit day and hh 
denotes the two digit hour, and mm denotes the two digit minute. 

17. To preview the commands of the task, click the Preview Commands icon  in the field of the 
Deploy Details list. 

The Preview Commands dialog box opens and displays the commands of the task to be 
executed.  

18. Review the contents to verify that these are the commands you want to execute. 

19. Click OK when you have finished previewing the commands. 

20. Click OK to accept the deployment and task configuration and to submit this request to the 
deployment task queue. 

If the task is scheduled to run immediately, the Task Result dialog box opens, providing you 
with a real time status of the deployment task. 

21. Click Close on the Task Result dialog box when the task has finished executing. 

22. To review the results of the task in the Result field of the Task List, click Refresh located at the 
top of the Task List to reload the page with the most current information for all tasks in the list. 

23. Review the results of your deployment task in the Result field of the deployment Task List.  
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The contents of this field serve as a link to the Task Result page that contains more detailed 
information the result and causes for a failed deployment.  

From this page, you can also review the commands executed by the deployment task. 

Deploying ACL uses using the deploy ACL uses feature 

You can also use the ACL Deployment wizard to deploy specific ACL uses to select devices. Uses 
that can be deployed using the Deployment wizard include packet filtering and VLAN packet filtering. 

To deploy an ACL use to one or more interfaces on select devices: 

1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click the ACL Management on the left navigation tree. 

c. Click ACL Deployment under ACL Management on the left navigation tree. 

The ACL Deployment page opens. 

2. Click Deploy ACL Uses under the Deploy Wizard of the ACL Deployment page. 

The Select Use Type step of the Deploy ACL Uses wizard is displayed. 

3. Select the use type you want to deploy from the list provided.  

4. Click Next. 

5. Click Select Device to select the device to which you want to deploy the select use type. 

The Select Devices dialog box opens. 

6. Add devices by using either the View or Advanced query option.  

For more information, see "Adding devices by view" and "Adding devices by advanced query." 

7. Click Next. 

The Select Object step of the Deploy ACL Uses wizard is displayed. 

8. Select the direction that you want the filter to be applied from the Filter Direction list. 

9. Select the interfaces that you want to apply the filtering to from the Interface List column on the 
left, or VLAN interfaces you want to apply the filtering to, by choosing from the following: 

 To select an interface, click the interface to highlight it, and then click the right arrow key  
to select it.  

 To select all interfaces, click the double right arrow key  

 To deselect an interface, click the interface in the Selected Interfaces column to select it 

and then click the left arrow key  to deselect it. 

 To deselect all interfaces, click the double left arrow key  and then select the VLAN that 
you want to apply the filter to from the VLAN List column on the left. 

 To select a VLAN, click the VLAN to highlight it and click the right arrow key  to select it.  

 To select all interfaces, click the double right arrow key . 

 To deselect a VLAN, click the VLAN in the select VLANs column to highlight it and click the 

left arrow key  to deselect it. 

 To deselect all VLANs, click the double left arrow key . 

10. Repeat this step for every device you have selected for ACL use deployment. 

You can use the same interface for other devices by checking the box to the left of the Same 
choice for other devices.  

11. Click Next when you have finalized your selection of interfaces for all devices to which you 
apply filtering. 

ACL Management displays a warning if one or more of the selected devices do not support the 
ACL use type selected.  
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12. Select the ACL type you want apply from the ACL Type list. 

13. Select the type of ACL identifier that to be used for filtering by selecting the type in the ACL 
Identity Type section. 

14. To view a list of all ACLs in IMC, navigate to the ACL Resource link located on the left 
navigation tree under ACL Management. 

15. Enter the name or number of the ACL you want to use for filtering in the ACL Identifier field. 

16. To view a list of all ACLs in IMC, navigate to the ACL Resource link located on the left 
navigation tree under.  

17. Click Next. 

The Summary step of the Deploy ACL Uses wizard is displayed. 

18. Review the information provided in the Summary page to ensure that you have configured the 
wizard according to your needs and that the ACL can be deployed to all interfaces on all 
devices you have selected. 

Specifically, review the contents of the ACL Exists field for every entry in the table as the value 
in this field helps identify whether or not the packet filter can be applied to the associated 
interface. 

 If the ACL Exists field contains the value No, then the Deploy ACL Uses deployment task 
cannot proceed because the ACL specified in the previous step cannot be found on the 
selected device. 

 If the ACL Exists field contains the value Yes, then the Deploy ACL Uses deployment task 
can proceed because the ACL specified in the previous step was found on the selected 
device. 

19. Click Finish when you have finished reviewing the configuration details and are ready to submit 
the task to the ACL deployment task queue. 

Packet filters are not deployed if the selected ACL rule number ranges do not match the ACL 
type for the selected devices. Packet direction is device dependent. If the device does not 
support the selected direction of the packet filter, the ACL is not deployed to the device. 

The Deploy ACL Uses Result page opens. 

ACL Management evaluates whether or not the selected Deploy ACL Uses can be 
successfully deployed to all of the selected interfaces for all selected devices. The results of this 
evaluation can be found in the Result field in the list displayed in the Deploy ACL Uses Result 
page. 

20. Click Deploy to proceed to the next step. 

ACL Management lists only those devices and their interfaces to which the ACL Use can be 
deployed successfully. 

The Add Task page opens. 

The default task name is displayed in the Task Name field.  

21. To enter a task name for this deployment task, delete the contents of this field and enter a new 
task name.  

A valid length for a task name is 1–32 characters. The task name cannot begin with a number 
(0-9). 

22. Enter a brief description for this deployment task in the Description field. 

23. Select how you want IMC to execute the task to every device from the Deployment Order 
section of the Add Task page by selecting the applicable option: 

 Select Concurrent if you want ACL Management to execute the task to multiple devices 
simultaneously. 

 Select Sequential if you want ACL Management to execute the task to one device at a 
time. 

24. Select the strategy you want ACL Management to use should a problem arise in the execution 
of the task from the Error Handling list. Options include: 
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 Select Abort the task if you want to stop the deployment to pending devices, but not affect 
devices to which deployments are in progress or to which deployments have successfully 
completed once an error in deployment arises. 

 Select Abort the task and clear data deployed on the error device if you want to stop the 
deployment and clear all deployments on the device experiencing a problem once an error 
in deployment arises. 

 Select Skip the error device and continue if you want to stop all deployments on the 
device experiencing a problem once an error in deployment arises. 

 Select Clear data deployed on the error device and continue if you want to clear all 
deployments on the device experiencing a problem once an error in deployment arises. 

25. Save the device's running configuration as the startup configuration prior to execution: 

 Select Yes in the Save to Startup File field.  

 Select No if you do not want to save the current configuration. 

26. Select when you want ACL Management to execute the task to the selected devices: 

 To execute the task immediately, select Immediately. 

 To schedule a time for ACL Management to execute the task, select At Scheduled Time. 

If you select At Scheduled Time 

a. Click the Calendar function  next to the At Scheduled Time field to populate the date 
and time for the execution of this task.  

A popup calendar is displayed. 

b. Select the date from the calendar.  

c. Alternatively, you can enter the date and time manually.  

Valid date and time format for this entry is YYYY-MM-DD hh:mm where YYYY denotes the 
four digit year, MM denotes the two digit month, DD denotes the two digit day and hh 
denotes the two digit hour, and mm denotes the two digit minute. 

27. To preview the commands of the task, click the Preview Commands icon  in the field of the 
Deploy Details list. 

The Preview Commands dialog box opens and displays the commands of the task to be 
executed. 

28. Review the contents to verify that these are the commands you want to execute. 

29. Click OK when you have finished previewing the commands. 

30. Click OK to accept the deployment and task configuration and to submit this request to the 
deployment task queue. 

If the task is scheduled to run immediately, the Task Result dialog box opens. This dialog box 
provides you with a real time status of the deployment task. 

31. Click Close on the Task Result dialog box when the task has finished executing. 

32. To review the results of the task in the Result field of the Task List, click Refresh located at the 
top of the Task List to reload the page with the most current information for all tasks in the list. 

33. Review the results of your deployment task in the Result field of the deployment Task List.  

The contents of this field serve as a link to the Task Result page that contains more detailed 
information about the results and causes for a failed deployment. From this page, you can also 
review the commands executed by the deployment task. 

Removing ACL uses from devices 

You can also use the ACL Deployment wizard to remove specific ACL uses previously deployed to 
devices. Uses that can be removed using the Deployment wizard include packet filtering and VLAN 
packet filtering.  

To remove an ACL use from one or more interfaces on select devices: 
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1. Navigate to ACL Resource. 

a. Click the Service tab from the top tabular navigation system. 

b. Click the ACL Management on the left navigation tree. 

c. Click ACL Deployment under ACL Management on the left navigation tree. 

The ACL Deployment page opens. 

2. Click Delete ACL Uses on Devices under the Deploy Wizard section of the ACL Deployment 
page. 

The Select Use Type step of the Delete ACL Uses on Devices wizard is displayed. 

3. Select the use type you want to remove from the list provided.  

4. Click Next. 

5. Click the Select Device to the devices you want to remove the selected use type from. 

The Select Devices dialog box opens. 

6. Add devices by using either the View or Advanced query option.  

7. Click Next. 

The Select Object step of the Delete ACL Uses on Devices wizard is displayed. 

8. Select the direction that the filter was previously applied from the Filter Direction list. Select 
the interfaces or VLAN interfaces you want to apply the filtering to by choosing from the 
following: 

 Select the interfaces that you want to remove the filtering for from the Interface List column 
on the left. 

a. To select an interface, click the interface to highlight it. 

b. Click the right arrow key  to select it.  

c. To select all interfaces, click the double right arrow key . 

d. To deselect an interface, click the interface in the Selected Interfaces column to select it. 

e. Click the left arrow key  to deselect it. 

f. To deselect all interfaces, click the double left arrow key . 

 Select the VLAN that you want to apply the filter to from the VLAN List column on the left. 

a. To select a VLAN, click the VLAN to highlight it. 

b. Click the right arrow key  to select it.  

c. To select all interfaces, click the double right arrow key . 

d. To deselect a VLAN, click the VLAN in the Selected VLANs column to highlight it. 

e. Click the left arrow key  to deselect it. 

f. To deselect all VLANs, click the double left arrow key . 

9. Repeat this step for every device you have selected for ACL use removal. 

10. Click Next when you have finalized your selection of interfaces for all devices to which you are 
removing filtering. 

11. Select the ACL type you want remove from the ACL Type list.  

12. Select the type of ACL identifier to remove by selecting the type in the ACL Identity Type. 

To view a list of all ACLs in IMC, navigate to the ACL Resource link located on the left 
navigation tree under.  

13. Enter the name or number of the ACL you want remove in the ACL Identifier field.  

To view a list of all ACLs in IMC, navigate to the ACL Resource link located on the left 
navigation tree under ACL Management.  

14. Click Next. 
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The Summary step of the Delete ACL Uses on Devices wizard is displayed. 

15. Review the information provided in the Summary page to ensure that you have configured the 
wizard according to your needs and that the ACL can be removed from all interfaces on all 
devices you have selected. 

Specifically, review the contents of the ACL exists field for every entry in the table as the value 
in this field helps you identify whether or not the packet filter can be removed from the 
associated interface. 

16. Do one of the following: 

 If the ACL Use Exists field contains the value No, then the ACL Uses on Devices 
deployment task cannot proceed because the ACL specified in the previous step is not 
being used on the selected device. 

 If the ACL Use Exists field contains the value Yes, then the Delete ACL Uses deployment 
task can proceed because the ACL specified in the previous step is in use on the selected 
device. 

17. Click Finish when you have finished reviewing the contents of the Summary page and are 
ready to proceed to the next step. 

The Delete ACL Uses on Devices Result page opens. 

ACL Management evaluates whether or not the selected Deploy ACL Use can be successfully 
deployed to all of the selected interfaces for all selected devices. The results of this evaluation 
can be found in the Result field in the list displayed in the Delete ACL Uses on Devices 
Result page. 

18. Click OK to proceed to the next step. 

The Add Task page opens. 

The default task name is displayed in the Task Name field.  

19. To enter a task name for this deployment task, delete the contents of this field and enter a new 
task name.  

A valid length for a task name is 1–32 characters. The task name cannot begin with a number 
(0-9). 

20. Enter a brief description for this deployment task in the Description field. 

21. Select how you want IMC to execute the task to every device from the Deployment Order 
section of the Add Task page by selecting the applicable option: 

 Select Concurrent if you want ACL Management to execute the task to multiple devices 
simultaneously.  

 Select Sequential if you want ACL Management to execute the task to one device at a 
time. 

22. Select the strategy you want ACL Management to use should a problem arise in the execution 
of the task from the Error Handling list. Options include: 

 Select Abort the task if you want to stop the deployment to pending devices, but not affect 
devices to which deployments are in progress or to which deployments have successfully 
completed once an error in deployment arises. 

 Select Abort the task and clear data deployed on the error device if you want to stop the 
deployment and clear all deployments on the device experiencing a problem once an error 
in deployment arises. 

 Select Skip the error device and continue if you want to stop all deployments on the 
device experiencing a problem once an error in deployment arises. 

 Select Clear data deployed on the error device and continue if you want to clear all 
deployments on the device experiencing a problem once an error in deployment arises. 

23. Save the device's running configuration as the startup configuration prior to execution: 

 Select Yes in the Save to Startup File field. 

 Select No if you do not want to save the current configuration. 
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24. Select when you want ACL Management to execute the task to the selected devices: 

 To execute the task immediately, select Immediately. 

 To schedule a time for ACL Management to execute the task, select At Scheduled Time. 

If you select At Scheduled Time: 

a. Click the Calendar function  next to the At Scheduled Time field to populate the date 
and time for the execution of this task.  

A popup calendar is displayed.  

b. Select the date from the calendar. 

c. Alternatively, you can enter the date and time manually.  

Valid date and time format for this entry is YYYY-MM-DD hh:mm where YYYY denotes the 
four digit year, MM denotes the two digit month, DD denotes the two digit day and hh 
denotes the two digit hour, and mm denotes the two digit minute. 

25. To preview the commands of the task, click the Preview Commands icon  in the field of the 
Deploy Details list. 

The Preview Commands dialog box opens and displays the commands of the task to be 
executed. 

26. Review the contents to verify that these are the commands you want to execute. 

27. Click OK when you have finished previewing the commands. 

28. Click OK to accept the deployment and task configuration and to submit this request to the 
deployment task queue. 

If the task is scheduled to run immediately, the Task Result dialog box opens. This dialog box 
provides you with a real time status of the deployment task. 

29. Click Close on the Task Result dialog box when the task has finished executing. 

30. To review the results of the task in the Result field of the Task List, click Refresh located at the 
top of the Task List to reload the page with the most current information for all tasks in the list. 

31. Review the results of your deployment task in the Result field of the deployment Task List.  

The contents of this field serve as a link to the Task Result page that contains more detailed 
information about the results and causes for a failed deployment. From this page, you can also 
review the commands executed by the deployment task. 
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Security control center 
The Security Control Center provides you with proactive security monitoring and management, 
including real time threat monitoring, detection, and analysis and the ability to define security policies 
enabling operators to take manual or automated actions when a security attack occurs. You can 
manage security attacks from a choice of two displays, where you can also access attack reports, 
including their source, destinations, and the results of actions taken to address the attacks. 

IMC can detect and take proactive action on many types of security attacks, including: 

 IP Spoofing 

 WinNuke 

 SYN Flood 

 ICMP Flood 

 UDP Flood 

 IP Sweep 

 TCP Port Scan 

 UDP Port Scan 

 IPS Worm 

 IPS Scan 

 Tracert 

 Large ICMP 

 Smurf 

 ICMP Redirect 

 ICMP Unreachable 

 Fraggle 

 Source Route 

 Route Record 

 Land 

 Teardrop 

 TCP Flag 

 Ping of Death 

 Frag Flood 

 IP Fragment 

 Scan 

 DHCP Server Detect 

 Duplicate ARP Address 

IMC monitors many of these security threats in real time by receiving and processing Syslog events 
and SNMP traps sent by devices. Syslog messages are analyzed by IMC Syslog CSU module, 
which are then processed and displayed by both IMC Fault module and SCC. The Syslog messages 
that IMC alarms on include: 

 Duplicate Addresses 

 ARP Overspeed 

 DHCP Server Detect 

 IMC attack event 
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IMC also processes SNMP traps sent by managed devices when the devices support these trap 
types and are configured to send traps to IMC and when IMC is configured to receive traps from the 
device. The SNMP traps that SCC currently supports include Duplicate Address/ARP 
Overspeed/DHCP Server Detect (1.3.6.1.4.1.2011.10.4.2.8.2.6.22), IMC Alarm 
(1.3.6.1.4.1.2011.10.4.2.8.2.6.9) for SYSLOG component, and SecCenter 
(1.3.6.1.4.1.25506.2.77.6.0 and 1.3.6.1.4.1.8763.6.0). In addition to the tabular view on security 
attack alarms, SCC also provides you with a visual display of attacks through the attack path 
topology map. 

Once IMC has received a Syslog message or SNMP trap and generated an alarm for it, SCC 
displays the alarm in the Attack Alarm List. Alternatively, you can use the Realtime Attack Alarm 
List for viewing the most recent attack alarms, allowing you to respond to attack alarms by initiating 
actions. Actions that can be taken vary by attack type but in general there are six supported actions:  

 Shut down the access port 

 Alert the administrator by mail 

 Isolate the online user to a restricted network 

 Send a warning message to the online user 

 Kick the online user offline 

 Add the online user to the blacklist 

Through the use of security control policies, you can proactively manage their response to security 
threats and attacks. Security control policies allow you to define what actions are to be taken in 
response to attack alarms. A security control policy combines the identification and alarming of a 
security attack with an action that can be taken in response to the security attack. The actions 
configured for security control policies can be executed manually or they can be configured to run 
automatically upon detection of the security attack. 

SCC enables you to filter alarms with matching policies. Then actions defined in a security control 
policy can be taken only for the matching alarms. SCC predefines alarm matching policies and also 
supports user-defined alarm matching policies. 

Lastly, SCC provides operators with summarized reporting of security attacks in the last hour. 
Summary reports include: 

 Top 10 Attack Alarms Report 

 Top 10 Attack Sources Report 

 Top 10 Attack Destinations Report 

 Execution Results Report 

Managing security attack alarms 
SCC provides you with two views for alarms, the Attack Alarm List and the Realtime Attack Alarm 
List. The Attack Alarm List provides operators with visibility into all attack alarms, allowing you to 
view all alarms and drill down into the details for the attack alarm. From the Attack Alarm List, you 
can also perform basic and advanced queries to filter the Attack Alarm List for those attack alarms 
that meet their search criteria and initiate actions including shutting down interfaces and notifying the 
appropriate staff of a security event. From this list, operators can also view the results of the actions 
they have executed against a security attack with a topology map of the attack path. For actions that 
support it, operators can also restore an action.  

The Realtime Attack Alarm List provides operators with a view of the Attack Alarm List filtered for 
the most recent attack alarms. The Realtime Attack Alarm List offers operators the same 
functionality as the Attack Alarm List for browsing attack alarms and attack alarm details, taking 
actions, viewing the results of an action, restoring an action, and viewing the topology of an attack 
path. 
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Attack alarm list overview 
You can view all security threats detected by IMC from the Attack Alarm List, providing visibility into 
the type of attack, its source, destination, and date and time stamp. From the Attack Alarm List, you 
can navigate to the Alarm Details page to view more information for the associated attack alarm and 
use a topology view of the attack using the Attack Path option. You can also execute an action for 
attack alarms from the Attack Alarm List. 

Browsing the attack alarm list 

To browse all attack alarms: 

1. Navigate to Alarm > Browse Attack Alarm. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Security Control Center on the left navigation tree. 

c. Click Browse Attack Alarm under Security Control Center on the left navigation tree. 

The Attack Alarm List page opens. 

Attack alarm list 

 Name—Contains the type of attack that was detected by IMC. The contents of this field 
serve as a link to the Attack Alarm Details page. The Attack Alarm Details page provides 
more detailed information on the attack. For more information about this feature, see 
"Viewing attack alarm details." 

 Source—Contains the IP address of the device that initiated the attack, if known. 

 Destination—Contains the destination IP address of the attack, or rather the device that 
the attack was intended for, if known. 

 Time—Contains a date and time stamp for IMC detection of the attack. 

 Correlated Policy—Contains the security control policy in IMC that is associated with the 
attack identified in this attack alarm. If there is no security policy associated with the attack 
alarm, this field contains the value "Undefined." 

 Result—Contains a status or summary of the result of any action IMC has taken to address 
the attack. 

2. Click Manual execution required in the Result field to navigate to the Attack Alarm Details 
page.  

 Manual execution required—Indicates that no action, either automatic or manual, was 
taken for the associated event. From this page you can execute any actions that are 
associated with this attack alarm type. 

 Success—Indicates that the automatic or manual action that was taken for this type of 
attack was successful. 

 Failure—Indicates that the automatic or manual action that was taken for this type of attack 
failed. Click Failure in the Result field to navigate to the Attack Alarm Details page. From 
this page you can get the detailed failure reason. 

 Executing policy—Indicates that the automatic or manual action that was specified for this 
type of attack is currently being executed. The contents of the Result field do not serve as a 
navigation link to the Attack Alarm Details page when an action is being executed. 

 No matching policy—Indicates that the alarm does not match any security control policy. 
Click No matching policy in the Result field to navigate to the Attack Alarm Details page. 
From this page you can select one or more actions, if available, that are associated with this 
attack alarm type. 

 Waiting for policy execution—Indicates that the selected action for the associated 
security attack alarm is in the queue for processing by IMC. The contents of the Result field 
do not serve as a navigation link to the Attack Alarm Details page when an action is 
waiting for policy execution. 
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 Acknowledgement—Indicates that the configured action could not be completed 
successfully because the conditions necessary to complete the action were not met. For 
example, the configured action was to shut down an interface. If the interface is 
unreachable and cannot be shut down, the Result field contains the value, 
Acknowledgement required. The value, Acknowledgement required in the Result field 
serves as a link for navigating to page for re-executing the action manually. 

The contents of the Result field serve as a link to one of several pages, depending on the 
result of the action taken for the associated event. If the result is Failure, the link navigates 
you to the Security Control Policy Result Report. For more information, see "Viewing the 
execution result report." 

If the result is No matching policy, the link navigates you to the Execute Action page. For 
more information about executing an action, see "Executing a manual action for an attack 
alarm." 

 Attack Path—This field contains a link  to a topology map that displays the attack path. If 
the Attack Alarm List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Attack Alarm List. 

 Click  to page forward to the end of the Attack Alarm List. 

 Click  to page backward in the Attack Alarm List. 

 Click  to page backward to the front of the Attack Alarm List. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

 

 NOTE: 

You can sort the Attack Alarm List by the Name, Source, Destination, Time, and Correlated 
Policy fields, by clicking the column label to sort the list by the selected field. The column label is a 
toggle switch that allows you to toggle between the various sort options specific to each field. 
 

Viewing attack alarm details 

You can view more detailed information for every attack alarm in the Attack Alarm Details page. 

To view the details of an attack alarm: 

1. Navigate to Alarm > Browse Attack Alarm. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Security Control Center on the left navigation tree. 

c. Click Browse Attack Alarm under Security Control Center on the left navigation tree. 

The Attack Alarm List page opens. 

2. Click the link in the Name field of the attack alarm for which you want to view details. 

The Attack Alarm Details page opens. 

Attack alarm details 

 Event Name—Contains the name or type of the attack. 

 Description—Contains detailed information about the event. For attack alarms generated 
by Syslog events, this field contains the actual Syslog entry. For attack alarms generated by 
Traps, this field contains trap details. 

 Generated at—Contains a date and timestamp for IMC detection of the security attack. 

 Access Device IP of the Attack Source—Contains the IP address of the access device 
that the attack source connects to, if known. 
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 Access Device Port of the Attack Source—Contains the interface description of the 
access device that the attack source connects to, if known. 

 Source MAC—If displayed, contains the MAC address of the attack source that originated 
the attack. 

 Source IP—If displayed, contains the IP address of the attack source that originated the 
attack 

 Destination IP—If displayed, contains the IP address of the attack destination, if known 

For example, as shown in Figure 137, if an attack arises from IP address 192.168.1.1 to IP 
address 192.168.2.1, the Source IP field is 192.168.1.1, the Destination IP field is 
192.168.2.1, the Access Device IP of the Attack Source field is 10.8.1.1, and the Access 
Device Port of the Attack Source field is GE 0/0/1. 

Figure 137 Schematic diagram for the attack source and attack destination 

 
 

 Event Description—If displayed, contains additional information about the attack event. 
Devices must be configured to include event descriptions in order for this field to be 
populated. 

 Attack Initiator—Contains the user ID or name of the user who initiated the attack. 

Querying the attack alarm list 

SCC provides you with two methods for searching the Attack Alarm List, a basic query method and 
an advanced query method.  

Attack alarm basic query 

To query for attack alarms using the Basic Query method: 

1. Navigate to Alarm > Browse Attack Alarm. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Security Control Center on the left navigation tree. 

c. Click Browse Attack Alarm under Security Control Center on the left navigation tree. 

The Attack Alarm List page opens. 

The Basic Query feature, by default, is displayed above the Attack Alarm List, if the link to 
the far right is Advanced Query, then you are in the Basic Query mode. 

2. Enter one or more of the following search criteria: 

 Name—Allows you to query for attack alarms by name or attack type.  

Enter a partial or complete attack alarm name or type in the Name field. 

 Result—Allows you to search by the result of an action taken by IMC to address the attack. 

Select the result you want to query for from the Result list, or select All if you do not want to 
limit your search by result. The default option for the result field is All. 

 Time—Allows you to query for attack alarms using a specific time range.  

Select the time range for which you want to search from the Time list. The default option is 
All. 

 Attack Destination—Allows you to specify a device IP address in the infrastructure for 
which the attacks were intended.  

Enter the full IP address of the device for which you want to view all attack alarms in the 
Attack Destination field. 

3. Click Query to begin you search. 
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4. View the results of your query in the Attack Alarm List. 

5. Click Reset to reset both the query values and the search results and to restore the full Attack 
Alarm List. 

Attack alarm advanced query 

To query for alarms using the Advanced Query method: 

1. Navigate to Alarm > Browse Attack Alarm. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Security Control Center on the left navigation tree. 

c. Click Browse Attack Alarm under Security Control Center on the left navigation tree. 

The Attack Alarm List page opens. 

2. Click the Advanced Query link located in the right of the Attack Alarm List.  

If this link says Basic Query, then you are in the Advanced Query mode. 

3. Enter one or more of the following search criteria: 

Name—Allows you to query for attack alarms by name or attack type. 

Enter a partial or complete attack alarm name or type in the Name field. 

Correlated Policy—Allows you to query for attack alarms that have a security control policy 
associated with the attack alarm type. 

Select the correlated security control policy from the Correlated Policy list. 

Result—Allows you to search by the result of an action taken by IMC to address the attack. 

Select the result you want to query for from the Result list, or select All if you do not want to limit 
your search by result. 

Attack Time: Start—Allows you to query for attack alarms using a specific start time. 

a. Auto-populate this field by clicking the field located to the right.  

A popup calendar is displayed. 

b. Select the start date from the calendar. 

c. Enter the time in the Time fields provided below the calendar. 

Attack Time: End—Allows you to query for attack alarms using a specific end time. 

a. Auto-populate this field by clicking the field located to the right.  

A popup calendar is displayed. 

b. Select the end date from the calendar. 

c. Enter the time in the Time fields provided below the calendar. 

Attack Source Start—Allows you to specify a range of IP addresses for the source of the 
attacks. Enter a full IP address as the starting IP address of the range for which you want to 
search. 

Attack Source End—Allows you to specify a range of IP addresses for the source of the 
attacks. Enter a full IP address as the ending IP address of the range for which you want to 
search. 

Attack Destination Start—Allows you to specify a range of IP addresses for the destination of 
the attacks. Enter a full IP address the starting IP address of the range for which you want to 
search. 

Attack Destination End—Allows you to specify a range of IP addresses for the destination of 
the attacks. Enter a full IP address as the ending IP address of the range for which you want to 
search 

4. Click Query to begin you search. 

5. View the results of your query in the Attack Alarm List. 

6. Click Reset to reset both the query values and the search results and to restore the full Attack 
Alarm List. 
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Refreshing the attack alarm list 

You can refresh the Attack Alarm List. Refreshing the Attack Alarm List initiates a query to IMC 
database and refreshes the Attack Alarm List with any changes to the Attack Alarm List since the 
page was last loaded. 

To refresh the Attack Alarm List: 

1. Navigate to Alarm > Browse Attack Alarm. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Security Control Center on the left navigation tree. 

c. Click Browse Attack Alarm under Security Control Center on the left navigation tree. 

The Attack Alarm List page opens. 

2. Click Refresh. 

Deleting attack alarms from the attack alarm list 

You can delete one or more attack alarms from the Attack Alarm List. Once an alarm is deleted, it is 
removed immediately from the IMC database and it cannot be recovered. Use this feature with 
caution. 

To delete one or more attack alarms: 

1. Navigate to Alarm > Browse Attack Alarm. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Security Control Center on the left navigation tree. 

c. Click Browse Attack Alarm under Security Control Center on the left navigation tree. 

The Attack Alarm List page opens. 

2. Select the attack alarms you want to delete. 

3. Click Delete. 

4. Click OK to confirm the deletion of the selected attack alarms. 

Real-time attack alarm overview 
You can view the most recent security threats detected by IMC from the Realtime Attack Alarm 
List. This list filters the Attack Alarm List for the most recent alarms only. From this list, you can 
navigate to the Alarm Details page. You can also navigate to a topology view of the attack using the 
Attack Path link. You can also execute an action from the Results link available in the Realtime 
Attack Alarm List. 

Browsing the real-time attack alarm list 

To browse real-time attack alarms: 

1. Navigate to Alarm > Realtime Attack Alarm. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Security Control Center on the left navigation tree. 

c. Click Realtime Attack Alarm under Security Control Center on the left navigation tree. 

The Realtime Attack Alarm List page opens. 

Realtime attack alarm list 

 Name—Contains the type of attack that was detected by IMC. The contents of this field 
serve as a link to the Attack Alarm Details page. The Attack Alarm Details page provides 
more detailed information on the attack. For more information about this feature, see 
"Viewing attack alarm details." 

 Source—Contains the IP address of the device that initiated the attack, if known. 
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 Destination—Contains the destination IP address of the attack, or rather the device that 
the attack was intended for, if known. 

 Time—Contains a date and time stamp for IMC detection of the attack. 

 Correlated Policy—Contains the security control policy in IMC that is associated with the 
attack identified in this attack alarm. If there is no security policy associated with the attack 
alarm, this field contains the value Undefined. 

 Result—Contains a status or summary of the result of any action IMC has taken to address 
the attack. 

 Manual execution required—indicates that no action, either automatic or manual, was 
taken for the associated event. 

2. Click Manual execution required in the Result field to navigate to the Attack Alarm Details 
page.  

 Success—indicates that the automatic or manual action that was taken for this type of 
attack was successful. 

 Failure—indicates that the automatic or manual action that was taken for this type of attack 
failed.  

3. Click Failure in the Result field to navigate to the Attack Alarm Details page. From this page 
you can get the detailed failure reason. 

 Executing policy—Indicates that the automatic or manual action that was specified for this 
type of attack is currently being executed. The contents of the Result field do not serve as a 
navigation link to the Attack Alarm Details page when an action is being executed. 

 No matching policy—Indicates that the alarm does not match any security control policy. 
Click No matching policy in the Result field to navigate to the Attack Alarm Details page. 
From this page you can select one or more actions, if available, that are associated with this 
attack alarm type. 

 Waiting for policy execution—Indicates that the selected action for the associated 
security attack alarm is in the queue for processing by IMC. The contents of the Result field 
do not serve as a navigation link to the Attack Alarm Details page when an action is 
waiting for policy execution. 

 Acknowledgement required indicates that the configured action could not be completed 
successfully because the conditions necessary to complete the action were not met. For 
example, the configured action was to shut down an interface. If the interface is 
unreachable and cannot be shut down, the Result field contains the value, 
Acknowledgement required. The value, Acknowledgement required in the Result field 
serves as a link for navigating to page for re-executing the action manually. 

 The contents of the Result field serve as a link to one of several pages, depending on the 
result of the action taken for the associated event. If the result is Failure, the link navigates 
you to the Security Control Policy Result Report. For more information, see "Viewing the 
execution result report." 

 If the result is No matching policy, the link navigates you to the Execute Action page. For 
more information about executing an action, see "Executing a manual action for an attack 
alarm." 

 Attack Path—This field contains a link  to a topology map that displays the attack path.  

4. Select the number of recent attack alarms you want IMC to display from the Display list located 
in the far right of the Realtime Attack Alarm List.  

This option filters the list for the most recent 25, 50, 75, 100, or 125 attack alarms. 

Refreshing the real-time attack alarm list 

You can refresh the Realtime Attack Alarm List. Refreshing the Realtime Attack Alarm List 
initiates a query to IMC database and refreshes the Realtime Attack Alarm List with any changes 
to the Realtime Attack Alarm List since the page was last loaded 

To refresh the Realtime Attack Alarm List: 
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1. Navigate to Alarm > Realtime Attack Alarm. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click the Security Control Center on the left navigation tree. 

c. Click Realtime Attack Alarm under Security Control Center on the left navigation tree. 

The Realtime Attack Alarm List page opens. 

2. Click Refresh. 

Deleting attack alarms from the real-time attack alarm 

You can delete one or more attack alarms from the Realtime Attack Alarm List. Once an alarm is 
deleted, it is removed immediately from the IMC database and it cannot be recovered. Exercise this 
feature with caution. 

To delete one or more attack alarms from the Realtime Attack Alarm List: 

1. Navigate to Alarm > Realtime Attack Alarm. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Security Control Center on the left navigation tree. 

c. Click Realtime Attack Alarm under Security Control Center on the left navigation tree. 

The Realtime Attack Alarm List page opens. 

2. Select the attack alarms you want to delete. 

3. Click Delete. 

4. Click OK to confirm the deletion of the selected attack alarms. 

Viewing attacks through topology maps 
SCC displays attack alarms in the topology map, providing you with a choice of two visual displays of 
the locations and network devices, the Attack Topology and the Attack Path, where attacks have 
occurred and where security threats exist. The Attack Topology view provides you with a single 
topology map displaying the logical connections for all current attacks. Rendered on the Attack 
Topology map is the source and destination access devices and the originating device and its 
destination, if known. The Attack Path view provides you with a subset of what is shown on the 
Attack Topology view because it displays the physical connections between the source and 
destination for a single attack only. 

Viewing all attacks using the attack topology map 

To view all current attacks for the entire managed network: 

1. Navigate to Alarm > Browse Attack Alarm. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Security Control Center on the left navigation tree. 

c. Click Browse Attack Alarm under Security Control Center on the left navigation tree. 

The Attack Alarm List page opens. 

2. Click the Attack Topology icon  located in the upper right corner of the Attack Alarm List. 

A new browser window opens and the Attack Topology map is displayed on the active 
window. 

3. To facilitate use and customization of the topology, the, Attack Topology map provides the 
following functions:  

 Toolbar options 

 

The Refresh icon  enables operators to reload the Attack Topology map once it has 
changed. 
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All other icons provides the same functions as they do of IMC Network Topology module. 
For more information about these icons, see "Topology map toolbar" 

 Device monitoring through the left mouse click 

Click the selected device on the Attack Topology map to display information about the 
selected device. The information displayed by a left mouse click varies based on the device 
selected. 

For more information about the left mouse click for devices, see "Left & right mouse clicks: 
Monitoring and management." 

 Link monitoring through the left mouse click 

The term "link" here refers to a virtual path from the attack source to the attack destination, 
rather than a physical link. 

For links, the left mouse click includes the following: 

 Alarm Name—Contains the type of the attack alarm for the link. 

 Alarm Time—Contains the time when the attack alarm was generated. 

 Source—Contains the IP address of the attack source. 

 Destination—Contains the IP address of the attack destination. 

 Map configuring through the right mouse click 

Right-click shortcut menu options for the map are listed below: 

 Set Filter Condition—Opens the page for setting the filter conditions. After setting the 
filter conditions, click OK to view the matched attacks. 

 Reload—Refreshes the page. Once the attack topology map has changed, click 
Reload to view the changes. 

 Hand Tool—Enables operators to grab and move the topology view within the confines 

of the pane. To exit this mode, click  in the toolbar. 

 Zoom—Enables operators to zoom in or out of the topology view or to fit the contents of 
the topology map into the current window. 

 Device configuring through the right mouse click 

Click the selected device on the attack topology map to display a list of management 
options that can be used to manage the selected device. 

For more information about the right mouse click for devices, see "Left & right mouse clicks: 
Monitoring and management." 

 Link configuring through the right mouse click 

The term "link" here refers to a virtual patch from the attack source to the attack destination, 
rather than a physical link.  

For links, the right mouse click includes only the Attack Path option. This option opens the 
virtual link topology, which displays the physical links and devices in the virtual link. 

Viewing a single attack using the attack path map 

You can view the topology for a single attack using the Attack Path option that is available on both 
the Attack Alarm List and the Realtime Attack Alarm list. 

To view the attack topology for a single attack from the Attack Alarm List: 

1. Navigate to Alarm > Browse Attack Alarm. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Security Control Center on the left navigation tree. 

c. Click Browse Attack Alarm under Security Control Center on the left navigation tree. 

The Attack Alarm List page opens. 
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2. Click the Attack Path icon  in field for the attack alarm for which you want to view the attack 
path. 

A new browser window opens and the Attack Path map is displayed on the active window. 

At the right of the page, the detailed attack path information is displayed, including: 

 Alarm Name—Contains the type of the attack alarm for the link. 

 Alarm Time—Contains the time when the attack alarm was generated. 

 Source—Contains the IP address of the attack source. 

 Destination—Contains the IP address of the attack destination. 

 Access Device IP of the Attack Source—Contains the IP address of the access device 
that the attack source connects to, if known. 

 Access Device Port of the Attack Source—Contains the interface description of the 
access device that the attack source connects to, if known. 

 Access Device IP of the Attack Destination—Contains the IP address of the access 
device that the attack destination connects to, if known. 

 Access Device Port of the Attack Destination—Contains the interface description of the 
access device that the attack destination connects to, if known. 

3. To facilitate use and customization of the topology, the Attack Path map provides the following 
functions:  

 Toolbar options 

 

The Reload icon  enables operators to reload the Attack Path map once it has changed. 

All other icons provides the same functions as they do of IMC Network Topology module. 
For more information about these icons, see "Topology map toolbar." 

 Device monitoring through the left mouse click 

Click the selected device on the Attack Path map to display information about the selected 
device. The information displayed by a left mouse click varies based on the device selected. 

For more information about the left mouse click for devices, see "Left & right mouse clicks: 
Monitoring and management." 

 Device configuring through the right mouse click 

Click to select a device on the attack path map to display a list of management options that 
can be used to manage the selected device. 

For more information about the right mouse click for devices, see "Left & right mouse clicks: 
Monitoring and management." 

 Link configuring through the right mouse click 

Click to select a link on the topology map to display a list of management options that can be 
applied to the selected link. 

The right mouse click on the selected link includes one or more of the following 
management options for links: 

 Link Information—Provides operators with detailed information on the selected link, 
including basic information as well as information about the interfaces on either side of 
the link. Information includes link name, status, device information, the operational and 
administrative status of each interface, IP address and subnet information and more. 

 Modify Link Name—Allows operators to apply a label or name in IMC for the selected 
link. 

 View MAC—Provides two options, Interface 1 and Interface 2, which represent the 
interfaces at both ends of the link. Select Interface 1 or Interface 2, a new browser 
window opens and the MAC addresses learned on the selected interface is displayed in 
the active window. 
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Executing an action for an attack alarm 
You can take action on attack alarms displayed in the Attack Alarm List or the Realtime Attack 
Alarm List. The actions that can be taken vary by the type of security attack identified but in general 
SCC supports six actions: 

 Shutting down the access port. 

 Alerting the administrator by mail.  

 Isolating the online user to a restricted network. 

 Sending a warning message to the online user. 

 Kicking the online user offline. 

 Adding the online user to the blacklist. 

The Execute Action page for initiating an action for a security alarm can be accessed from the link in 
the Result field of the Attack Alarm List and the Realtime Attack Alarm List when the Result field 
contains one of the following values, Manual execution required, No matching policy, and 
Acknowledgement required. 

Executing a manual action for an attack alarm 

You can execute a manual action for an attack alarm from both the Attack Alarm List and the 
Realtime Attack Alarm list. 

To execute a manual action from the Attack Alarm List: 

1. Navigate to Alarm > Browse Attack Alarm. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Security Control Center on the left navigation tree. 

c. Click Browse Attack Alarm under Security Control Center on the left navigation tree. 

The Attack Alarm List page opens. 

2. Click the link in the Result field of the attack alarm for which you want to view details. 

The Execute Action page opens. 

The value in the Result field must contain one of the following values in order to execute an 
action manually: Manual execution required, No matching policy, and Acknowledgement 
required. 

3. Click Select Action located at the top of the Action and Order section of the Execute Action 
page. 

The Select Action dialog box opens. 

4. To view the full list of possible actions for this security attack type, do one of the following:  

 Click the Expand arrow  next to Action List. 

 Click the Expand all link  located in the upper right corner of the Select Action dialog 
box. 

5. Select the actions you want to execute. 

The actions that are available vary by attack alarm type. 

6. Click OK. 

7. To add another action, repeat step 4 and step 5. 

Some actions may have parameters that must be configured before IMC can execute them. If 

they do, the Configure icon  is displayed in the Configure Parameters field of the 
associated action in the Action and Order list. 

8. Click the Configure icon  to configure the parameters for the associated action. 

You are prompted to configure any parameters that have not been configured before you can 
execute the action you have configured. 
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9. For the Email action, enter the following configuration parameters in the Parameter 
configurations for mail sender dialog box: 

 Destination Mail Address—Enter the fully qualified mail address of the recipient of this 
mail alert in the Destination Mail Address field. 

 Mail Subject—Enter a brief subject for this mail in the Mail Subject field. 

 Mail Content—Enter the content of the mail in the Mail Content field. 

10. Click OK. 

11. For the Warn action, enter the following configuration parameters in the Send Message dialog 
box. 

12. Enter the message that will be displayed on the online user's browser in the Send Message 
field. 

The message length is limited 60 characters. 

13. Click OK to send the message to the online user. 

For the Warn option to become visible as an action, the User Access Manager module must be 
installed and the attack alarm must contain the source IP or source MAC address. 

If you have entered more than one action in the Action and Order list, you can specify the 
order in which IMC executes them. Otherwise, IMC performs the actions in the order in which 
they were created. 

14. To re-order actions, do one of the following: 

 Click the up arrow key  to move an action up in order of execution. 

 Click the down arrow key  to move an action down in order of execution. 

15. Click the Delete icon  to delete an action from the Action and Order list. 

16. When you have completed the configuration of all actions and you are ready to have IMC 
execute the actions, click Execute. 

17. Click Back to return to the Attack Alarm List and to view the results of the actions you have 
executed. 

The results display in the Result field. The Result field contents also serve as a link to the 
Execution Result Report that displays more detailed information about the actions taken. For 
more information about the Execution Result Report, see "Viewing the execution result 
report." 

Viewing the execution result report 

You can view the Execution Result Report from either the Attack Alarm List or the Realtime 
Attack Alarm list. 

To view the results of an action from the Attack Alarm List: 

1. Navigate to Alarm > Browse Attack Alarm. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Security Control Center on the left navigation tree. 

c. Click Browse Attack Alarm under Security Control Center on the left navigation tree. 

The Attack Alarm List page opens. 

2. Click the link in the Result field of the attack alarm for which you want to view details. 

The Result Report page opens. 

IMC displays the results of every action configured for the attack alarm in the Execution Result 
List displayed in the lower portion of the Security Control Policy Result Report. 

Execution result list 

 Action Name—Contains the name of the action that was executed. 

 Action Description—Contains a description for the action that was taken. 
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 Result—Contains the result of the action. 

 Result Description—Contains more detailed information about the outcome of the result, 
including a possible cause if known. 

 Restored—Contains information about whether or not the action can be undone or 
restored. The contents of this field serve as a link for restoring conditions prior to the 
execution of an action. For example, if the action taken was to shut down an interface, 
restoring the action brings the interface up. 

 Result—Contains a result for the restore action. This field is empty if no restore action was 
taken. 

 Result Description—Contains more detailed information about the outcome of the restore 
result, including a possible cause if known. This field is empty if no restore action was taken. 

3. Click Refresh located at the top of the Execution Result List to query IMC for any updates to 
the Execution Result List. 

4. Click Back to return to the Attack Alarm List. 

Configuring alarm matching policies 
Operators can define alarm matching policies to filter alarms and enable the actions defined in a 
security control policy to be taken only for the matching alarms. SCC filters alarms by alarm OID and 
further by alarm variable matching rule. 

SCC maintains a set of variables to which different actions are to be taken. These variables are 
known as action variables. Different types of alarms can have multiple variables mapped to the same 
action variable. Operators can configure mappings between alarm variables and action variables in 
each alarm matching policy, so SCC can correctly identify alarm variables and take correct actions 
on them. 

In an alarm matching policy, operators can configure mappings between alarm variables and action 
variables. With the mappings, SCC can identify alarms variables and then take correct actions to the 
alarms. 

Operators can add, modify, and delete user-defined alarm matching policies, but cannot modify or 
delete pre-defined alarm matching policies. 

Viewing the Alarm Matching Policy list 
To view the alarm matching policy list: 

1. Navigate to Alarm > Alarm Matching Policy. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Security Control Center on the left navigation tree. 

c. Click Alarm Matching Policy under Security Control Center on the left navigation tree. 

The Alarm Matching Policy List is displayed in the main pane of the Security Control 
Policy page. 

Alarm Matching Policy list 

 Policy Name—Contains the name of the alarm matching policy. Click the name to view 
detailed information about the alarm matching policy. 

 Policy Description—Contains the description of the alarm matching policy. 

 Modify—Contains an icon for navigating to the Modify Alarm Matching Policy page 
for the associated policy. 

 Delete—Contains an icon for the deleting the associated policy. 

If the alarm matching policy list spans multiple pages, use the following aids to navigate the 
list: 
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 Click  to page forward in the Alarm Matching Policy List. 

 Click  to page forward to the end of the Alarm Matching Policy List. 

 Click  to page backward in the Alarm Matching Policy List. 

 Click  to page backward to the front of the Alarm Matching Policy List. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items per 
page you want to view. 

You can sort the Alarm Matching Policy List by the Policy Name and Policy Description 
fields. Click the column label to sort the list by the selected field. The column label is a toggle 
switch that allows you to toggle between the various sort options specific to each field. 

Viewing detailed information about an alarm matching policy 
To view detailed information about an alarm matching policy: 

1. Navigate to Alarm > Alarm Matching Policy. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Security Control Center on the left navigation tree. 

c. Click Alarm Matching Policy under Security Control Center on the left navigation tree. 

The Alarm Matching Policy List is displayed in the main pane of the Security Control 
Policy page. 

2. Click the name link of an alarm matching policy to enter the Alarm Matching Policy Details 
page. 

Basic information 

 Policy Name—Contains the name of the alarm matching policy. 

 Policy Description—Contains the description of the alarm matching policy. 

 Alarm Name—Contains the name and OID of the alarm to be matched by the policy. 

Alarm Variable Matching Rules 

 Alarm Variable Name—Contains the name of the alarm variable to be matched. 

 Regular Expression—Contains the regular expression specified for the matching rule. 

Action/Alarm Variable Mappings 

 Locate Attack Source—Configure SCC to locate the path of the attack source. 

 Locate Attack Destination—Configure SCC to locate the path of the attack destination. 

 Action Variable Name—Contains the name of the action variable. 

 Alarm Variable Name—Contains the name of the variable defined in the alarm. 

3. Click Back to return to the Alarm Matching Policy List. 

Adding an alarm matching policy 
To add an alarm matching policy: 

1. Navigate to Alarm > Alarm Matching Policy. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Security Control Center on the left navigation tree. 

c. Click Alarm Matching Policy under Security Control Center on the left navigation tree. 
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The Alarm Matching Policy List is displayed in the main pane of the Security Control 
Policy page. 

2. Click Add. 

The Add Alarm Matching Policy page opens. 

3. Enter a name for the alarm matching policy in the Policy Name field. The name can contain 1 to 
32 characters. 

4. Enter a description for the alarm matching policy in the Policy Description field. 

5. Select an alarm for the alarm matching policy: 

a. Click Select Alarm next to the Alarm Name field. 

The Select Alarm window opens. 

b. Click  to expand alarms. 

c. Or filter alarms by the following criteria: 

 Trap Name—Enter a partial or complete name for the trap. For example, to query for a 
trap definition with the name, alarmFeBlock, enter alarmFeBlock in the Trap Name field. 

 Enterprise Name—Enter partial or complete name for the vendor whose MIB contains 
the trap for which you want to query. For example, to query for all 3Com traps, enter 
3Com in the Enterprise Name field. 

 Trap OID—Enter partial or complete Object ID for the trap in which you want to query. 
For example, the object ID for alarmFeBlock is 1.3.6.1.4.1.43.1.12.3.6.155. Enter 
1.3.6.1.4.1.43.1.12.3.6.155 in the Trap OID field to retrieve traps with this Object ID. 

 Enterprise ID—Enter partial or complete Enterprise ID for the vendor whose MIB 
contains the trap in which you want to query. For example, the Enterprise ID for 3Com is 
1.3.6.1.4.1.43.1.12.3. Enter 1.3.6.1.4.1.43.1.12.3 to retrieve all traps by 3Com from the 
trap definition list. 

d. Click Query. 

The results of the query are displayed in the alarm list portion of the page. 

e. Click Reset when you have finished your search to restore the full alarm list. 

f. Select an alarm. 

g. Click OK. 

The name and OID of the selected alarm are displayed in the Alarm Name field. 

6. Define alarm variable matching rules for filtering alarms that have the same OID or alarms that 
do not contain alarm variables: 

a. Click Add Rule in the Alarm Variable Matching Rule List. 

The Add Rule window opens. 

b. Select an alarm variable from the Alarm Variable Name list. 

c. Enter a regular expression in the Regular Expression field. 

d. Click OK. 

The new alarm variable matching rule is displayed in the Alarm Variable Matching Rule 
List. 

e. Repeat the previous steps to add more rules. 

f. To delete one or more rules, click the Delete icon  for the associated rules. 

7. Configure the attack location options in the Action/Alarm Variable Mappings area: 

 Locate Attack Source—Select this option to enable SCC to locate the attack source for the 
alarm. 

 Locate Attack Destination—Select this option to enable SCC to locate the attack 
destination for the alarm. 
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If the attack location options are configured, SCC displays the attack path for the alarm on the 
attack topology. 

8. Configure mappings between alarm variables and action variables in the Action/Alarm 
Variable Mapping List: 

a. Click Add Mapping. 

The Add Mapping window opens. 

b. Select an action variable from the Action Variable Name list. SCC preloads all action 
variables it can identify in the list. 

c. Select an alarm variable from the Alarm Variable Name list. If the alarm does not contain 
variables, the list is empty. 

d. Click OK. 

The new mapping is displayed in the Action/Alarm Variable Mapping List. 

e. Repeat the previous steps to add more rules. 

f. To delete one or more mappings, click the Delete icon  for the associated mappings. 

9. Click OK. 

The new alarm matching policy is displayed in the Alarm Matching Policy List. 

Modifying a user-defined alarm matching policy 
To modify a user-defined alarm matching policy: 

1. Navigate to Alarm > Alarm Matching Policy. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Security Control Center on the left navigation tree. 

c. Click Alarm Matching Policy under Security Control Center on the left navigation tree. 

The Alarm Matching Policy List is displayed in the main pane of the Security Control 
Policy page. 

2. Click the Modify icon  for the alarm matching policy you want to modify. 

The Modify Alarm Matching Policy page opens. 

You cannot modify the policy name. 

3. Enter a new description for the alarm matching policy in the Policy Description field. 

4. Re-select an alarm for the alarm matching policy: 

a. Click Select Alarm next to the Alarm Name field. 

The Select Alarm window opens. 

b. Filter alarms by the following criteria: 

 Trap Name—Enter a partial or complete name for the trap. For example, to query for a 
trap definition with the name, alarmFeBlock, enter alarmFeBlock in the Trap Name field. 

 Enterprise Name—Enter partial or complete name for the vendor whose MIB contains 
the trap for which you want to query. For example, to query for all 3Com traps, enter 
3Com in the Enterprise Name field. 

 Trap OID—Enter partial or complete Object ID for the trap in which you want to query. 
For example, the object ID for alarmFeBlock is 1.3.6.1.4.1.43.1.12.3.6.155. Enter 
1.3.6.1.4.1.43.1.12.3.6.155 in the Trap OID field to retrieve traps with this Object ID. 

 Enterprise ID—Enter partial or complete Enterprise ID for the vendor whose MIB 
contains the trap in which you want to query. For example, the Enterprise ID for 3Com is 
1.3.6.1.4.1.43.1.12.3. Enter 1.3.6.1.4.1.43.1.12.3 to retrieve all traps by 3Com from the 
trap definition list. 

c. Click Query. 
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The results of the query are displayed in the alarm list portion of the page. 

d. Click Reset when you have finished your search to restore the full alarm list. 

e. Select an alarm. 

f. Click OK. 

The name and OID of the selected alarm are displayed in the Alarm Name field. 

5. Modify the alarm variable matching rules for the alarm matching policy: 

a. Click Add Rule in the Alarm Variable Matching Rule List. 

The Add Rule window opens. 

b. Select an alarm variable from the Alarm Variable Name list. 

c. Enter a regular expression in the Regular Expression field. 

d. Click OK. 

The new alarm variable matching rule is displayed in the Alarm Variable Matching Rule 
List. 

e. Repeat the previous steps to add more rules. 

f. To delete one or more rules, click the Delete icon  for the associated rules. 

6. Configure the attack location options in the Action/Alarm Variable Mappings area: 

 Locate Attack Source—Select this option to enable SCC to locate the attack source for the 
alarm. 

 Locate Attack Destination—Select this option to enable SCC to locate the attack 
destination for the alarm. 

If the attack location options are configured, SCC displays the attack path for the alarm on the 
attack topology. 

7. Modify the mappings between alarm variables and action variables in the Action/Alarm 
Variable Mapping List: 

a. Click Add Mapping. 

The Add Mapping window opens. 

b. Select an action variable from the Action Variable Name list. SCC preloads all action 
variables it can identify in the list. 

c. Select an alarm variable from the Alarm Variable Name list. If the alarm does not contain 
variables, the list is empty. 

d. Click OK. 

The new mapping is displayed in the Action/Alarm Variable Mapping List. 

e. Repeat the previous steps to add more rules. 

f. To delete one or more mappings, click the Delete icon  for the associated mappings. 

8. Click OK. 

Deleting a user-defined alarm matching policy 
To delete a user-defined alarm matching policy: 

1. Navigate to Alarm > Alarm Matching Policy. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Security Control Center on the left navigation tree. 

c. Click Alarm Matching Policy under Security Control Center on the left navigation tree. 

The Alarm Matching Policy List is displayed in the main pane of the Security Control 
Policy page. 
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2. Click the Delete icon  for the user-defined alarm matching policy you want to delete. 

3. Click OK to confirm deletion of the selected policy. 

Managing security control policies 
You can proactively manage the response to security threats and attacks using security control 
policies. A security control policy combines the following information:  

 Identification and alarming of a security attack. 

 An action that can be taken in response to the security attack. 

 Identification of the portion of the network to be protected by the security control policy.  

The actions configured for security control policies can be executed manually or they can be 
configured to run automatically upon detection of the security attack. 

Viewing the security control policy list 
The Security Control Policy List provides you with a list of all configured security control policies in 
IMC. From this list, you can view the policy names, descriptions, and execution types for each policy. 
From this list, you can also modify and delete security control policies.  

To view the Security Control Policy List: 

1. Navigate to Alarm > Security Control Policy. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Security Control Center on the left navigation tree. 

c. Click Security Control Policy under Security Control Center on the left navigation tree. 

The Security Control Policy List page opens. 

Security control policy list 

 Policy Name—Contains the name of the security control policy. This field contains a link to the 
Security Control Policy Details page that contains more detailed information on the associated 
security control policy. 

 Policy Description—Contains a description for the association security control policy. 

 Execution Type—Contains the type of action for the associated security control policy. 
Possible values include Manual for actions that can be executed manually and Auto for actions 
that can be executed automatically. 

 History—Contains an icon  for viewing the Attack Alarm List of the security control policy. 

 Modify—Contains an icon  for modifying the associated security control policy. 

 Delete—Contains an icon  for deleting the associated security control policy. 
 

 NOTE: 

You can sort the Security Control Policy List by the Policy Name, Policy Description, and 
Execution Type fields by clicking the column label to sort the list by the selected field. The column 
label is a toggle switch that allows you to toggle between the various sort options specific to each 
field. 
 

Adding a security control policy 
To add a security control policy: 
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1. Navigate to Alarm > Security Control Policy. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Security Control Center on the left navigation tree. 

c. Click Security Control Policy under Security Control Center on the left navigation tree. 

The Security Control Policy List page opens. 

2. Click Add. 

The Add Security Control Policy page opens. 

3. Enter the name for this policy in the Policy Name field.  

The maximum length for a policy name is 32 characters. 

4. Enter a brief description for this policy in the Policy Description field. 

5. Select the type of execution you want to apply to this policy from the Execution Type list: 

 Select Auto if you want IMC to apply this policy automatically when a matching security 
attack is detected. 

 Select Manual if you want to apply this policy manually when a matching security attack is 
detected. 

6. Click Select Event next to the Event to Process field to select the type of security attack for 
which you want to define this policy control event. 

The Select Attack Alarm dialog box opens. 

7. Click the radio button  to the left of the attack alarm type for which you want to create this 
security control policy. 

8. Click OK. 

The security event you selected for processing is displayed in the Event to Process field. 

9. Click Next to enter the Network Segment to Protect page to set the network range to which 
the policy applies. 

10. If you want to apply this security control policy to the entire network, select It takes effect on 
the whole network. If you select this option, skip to step 12. 

11. If you want to specify the IP address range to apply this security control policy to, do the 
following: 

a. Enter the first IP address for the IP address range in the Start IP field. 

b. Enter the last IP address for the IP address range in the End IP field. 

c. Click Add to add the IP address range to the Configured Segments list. 

To add more IP address ranges, repeat step 11 for each IP address range you want to add 

12. Click Next to enter the Protection Periods page to set the time periods in which the policy is 
effective. 

13. If you want this security control policy to be always effective, select The policy is always 
effective. If you select this option, skip to step 15. 

14. If you want to specify the time periods in which the security control policy is effective, do the 
following: 

a. Clear the It takes effect all periods box. All time periods are displayed in the Period List. 

b. Select one or more time periods. 

15. Click Next to enter the Protect Alarm Sources page to configure whether to protect the 
devices that generate alarms 

16. If you want the security control policy to protect the devices that generate alarms, click It takes 
effect on all alarm sources. If you select this option, skip to step 18. 

The It takes effect on all alarm sources option is grayed out for alarms that do not contain 
alarm source variables. 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 9333



932 

17. If you want to specify the alarm sources to be protected by the security control policy, do the 
following: 

a. Clear the It takes effect all periods box. The page displays Device List, Custom View 
List, and Device Group List. 

b. Click Select Device in the Device List area and then select the devices you want to protect 
in the popup window. For more information about selecting devices, see "Adding devices by 
view" and "Adding devices by advanced query." 

c. Click Select Custom View in the Custom View List area.  

The Select Custom View window opens. 

d. Select the check box to the left of Custom View to select all custom views. Clear the check 
box to the left of Custom View to clear all custom views. Click Expand All  to expand all 
custom views. Click Collapse All  to collapse all custom views. Click  to the left of a 
custom view to expand all subviews of this view, and click  to collapse all subviews of this 
view. 

e. Select one or more custom views and click OK. 

The selected custom views are displayed in the Custom View List. The security control 
policy protects all alarm source devices on the selected custom views. 

f. Select one or more device groups in the Device Group List. The security control policy 
protects all devices that belong to the selected device groups. 

18. Click Next to enter the Action Target page to set the target devices on which the action is 
taken. 

19. If you want the policy to take actions only to the devices that generate alarms, click On Alarm 
Sources. If you select this option, skip to step 21. 

20. If you want the policy to take actions to specific devices, do the following: 

a. Click On Special Objects. 

b. Click Select Device in the Device List area and then select devices in the popup window. 
For more information about selecting devices, see "Adding devices by view" and "Adding 
devices by advanced query." 

c. Click Select Custom View in the Custom View List area.  

The Select Custom View window opens. 

d. Select the check box to the left of Custom View to select all custom views. Clear the check 
box to the left of Custom View to clear all custom views. Click Expand All  to expand all 
custom views. Click Collapse All  to collapse all custom views. Click  to the left of a 
custom view to expand all subviews of this view, and click  to collapse all subviews of this 
view. 

e. Select one or more custom views and click OK. 

The selected custom views are displayed in the Custom View List. The security control 
policy takes actions to all devices on the selected custom views. 

f. Select one or more device groups in the Device Group List. The security control policy 
takes actions to all devices that belong to the selected groups. 

21. Click Next to enter the Action Settings page to set the action strategy and the actions that the 
policy can take. 

22. Select one of the following options as the strategy for SCC to use when executing actions 
defined in the security check policy: 

 Execute actions in sequence if all action variables are valid, or execute none of the 
actions if any action variable is invalid—If all action variables read by SCC are correct, 
SCC executes actions in sequence. If one or more variables are incorrect, SCC does not 
execute any action. 

 Execute actions in sequence and skip actions with invalid variables—SCC executes 
actions in sequence and skips incorrect variables. 
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 Stop executing actions if one action is successfully executed—SCC executes actions 
in sequences and stops executing actions immediately after it successfully executes one 
action. 

23. Click Select Action next to the Action List. 

The Select Action dialog box opens. 

24. Click the checkboxes  to the left of the actions you want to execute.  

Actions that are available vary by attack alarm type. 

25. Click the checkbox  next to the Action List to select all Actions. 

The IMC platform supports the following actions: 

 Shut down port—Shut down the access port. 

 Email—Alert the administrator by mail. 

 Execute Command on Server—Execute a system command on the IMC server. 

 Execute the Jython Script—Execute the specified Jython script file. 

 Display Notification Message—Display a notification message in the browser. 

 Configuration Backup—Back up the configuration file. 

 Deploy Configuration File—Deploy the specified configuration file. 

 Compliance Center—Execute the check task of the specified compliance policy. 

For organizations that have deployed IMC User Access Manager module, the following actions 
are also supported: 

 Isolate—Isolate the online user to a restricted network. 

 Warn—Send a warning message to the online user. 

 Kick off—Kick the online user off. 

 Blacklist—Add the online user to the blacklist. 

For these four options to become visible as actions, the User Access Manager module must be 
installed and the attack alarm must contain the source IP or source MAC address. 

Actions that IMC makes visible in the Select Action dialog box vary based on the type of 
attack, as not all actions are available for all attack types. 

26. Click OK. 

27. To add another action, repeat steps 23 through 26. 

28. Some actions may have parameters that must be configured before IMC can execute them. If 

they do, the Configure icon  is displayed in the Configure Parameters field of the 
associated action in the Action list. 

29. Click the Configure icon  to configure the parameters for the associated action. You are 
prompted to configure any parameters that have not been configured before you can create the 
security control policy. 

a. For the Email action, enter the following configuration parameters in the Parameter 
configurations for mail sender dialog box. 

 Destination Mail Address—Enter the fully qualified mail address of the recipient of this 
mail alert in the Destination Mail Address field. 

 Mail Subject—Enter a brief subject for this mail in the Mail Subject field. 

 Mail Content—Enter the content of the mail in the Mail Content field. 

b. Click OK. 

c. For the Warn action, enter the following configuration parameters in the Send Message 
dialog box. 

d. Enter the message that will be displayed on the online user's browser the Send Message 
field. Message length is limited to 60 characters. 
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e. Click OK to send the message to the online user. 

30. If you have entered more than one action in the Action list, you can specify the order in which 
IMC executes them. 

 Click the Up Arrow Key icon  to move an action up in order of execution, or 

 Click the Down Arrow Key icon  to move an action down in order of execution, or 

 Click the Delete icon  to delete one or more actions from the Action list. 

31. Click OK to create the security control policy. 

Modifying a security control policy 
To modify a security control policy: 

1. Navigate to Alarm > Security Control Policy. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Security Control Center on the left navigation tree. 

c. Click Security Control Policy under Security Control Center on the left navigation tree. 

The Security Control Policy List page opens. 

2. Click the Modify icon  associated with the security control policy you want to modify. 

The Modify Security Control Policy page opens. 

3. You cannot modify the Policy Name field. 

4. Modify the description for this policy in the Policy Description field. 

5. Change the type of execution you want to apply to this policy by making a new selection from 
the Execution Type list: 

 Select Manual if you want to apply this policy manually when a matching event arises, or 

 Select Auto if you want IMC to apply this policy automatically when a matching event 
arises. 

6. Click Select Event next to the Event to Process field to select the type of security attack for 
which you want to define this policy control event. 

 

 NOTE: 

Changing the event or attack alarm type deletes all actions previously configured. 
 

The Select Attack Alarm dialog box opens and displays all attack alarms. 

7. Select the attack alarm type you want to create this security control policy for, and click OK. The 
results of your selection are displayed in the Event to Process field. 

8. Click Next to enter the Network Segment to Protect page to set the network range to which 
the policy applies. 

9. If you want to apply this security control policy to the entire network, click the checkbox  to 
the left of It takes effect on the whole network. If you select this option, skip to step 11. 

10. If you want to specify the IP address range to apply this security control policy to, do the 
following: 

a. Enter the last IP address for the IP address range you want to apply this security control 
policy to in the End IP field. 

b. Click Add to add the IP address range to the Configured Segments list. 

c. To add more IP address ranges, repeat step 10 for each IP address range you want to add 

d. To delete an IP address range, click the IP address range you want to delete, and then click 
Delete next to the Configured Segments field. 
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11. Click Next to enter the Protection Periods page to set the time periods in which the policy is 
effective. 

12. If you want this security control policy to be always effective, click the checkbox  to the left of 
The policy is always effective. If you select this option, skip to step 14. 

13. If you want to specify the time periods in which the security control policy is effective, do the 
following: 

a. Clear the The policy is always effective box. All time periods are displayed in the Period 
List. 

b. Select one or more time periods. 

14. Click Next to enter the Protect Alarm Sources page to configure whether to protect the 
devices that generate alarms 

15. If you want the security control policy to protect the devices that generate alarms, click It takes 
effect on all alarm sources. If you select this option, skip to step 17. 

The It takes effect on all alarm sources option is grayed out for alarms that do not contain 
alarm source variables. 

16. If you want to specify the alarm sources to be protected by the security control policy, do the 
following: 

a. Clear the It takes effect all periods box. The page displays Device List, Custom View 
List, and Device Group List. 

b. Click Select Device in the Device List area and then select the devices you want to protect 
in the popup window. 

For more information about selecting devices, see "Adding devices by view" and "Adding 
devices by advanced query." 

c. Click Select Custom View in the Custom View List area.  

The Select Custom View window opens. 

d. Click Select All to select all custom views. Click Select None to clear none of the custom 
views. Click Expand All  to expand all custom views. Click Collapse All  to collapse all 
custom views. Click  to the left of a custom view to expand all subviews of this view, and 
click  to collapse all subviews of this view. 

e. Select one or more custom views and click OK. 

The selected custom views are displayed in the Custom View List. The security control 
policy protects all alarm source devices on the selected custom views. 

f. Select one or more device groups in the Device Group List. The security control policy 
protects all devices that belong to the selected device groups. 

17. Click Next to enter the Action Target page to set the target devices on which the action is 
taken. 

18. If you want the policy to take actions only to the devices that generate alarms, click On Alarm 
Sources. If you select this option, skip to step 20. 

19. If you want the policy to take actions to specific devices, do the following: 

a. Click On Special Objects. 

b. Click Select Device in the Device List area and then select devices in the popup window. 

For more information about selecting devices, see "Adding devices by view" and "Adding 
devices by advanced query." 

c. Click Select Custom View in the Custom View List area.  

The Select Custom View window opens. 

d. Click Select All to select all custom views. Click Select None to clear none of the custom 
views. Click Expand All  to expand all custom views. Click Collapse All  to collapse all 
custom views. Click  to the left of a custom view to expand all subviews of this view, and 
click  to collapse all subviews of this view. 
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e. Select one or more custom views and click OK. 

The selected custom views are displayed in the Custom View List. The security control 
policy takes actions to all devices on the selected custom views. 

f. Select one or more device groups in the Device Group List. The security control policy 
takes actions to all devices that belong to the selected groups. 

20. Click Next to enter the Action Settings page to set the action strategy and the actions that the 
policy can take. 

21. Select one of the following options as the strategy for SCC to use when executing actions 
defined in the security check policy: 

 Execute actions in sequence if all action variables are valid, or execute none of the 
actions if any action variable is invalid—If all action variables read by SCC are correct, 
SCC executes actions in sequence. If one or more variables are incorrect, SCC does not 
execute any action. 

 Execute actions in sequence and skip actions with invalid variables—SCC executes 
actions in sequence and skips incorrect variables. 

 Stop executing actions if one action is successfully executed—SCC executes actions 
in sequences and stops executing actions immediately after it successfully executes one 
action. 

22. Click Select Action next to the Action List. 

23. If you selected a new attack alarm or event type to process, re-enter all actions for this policy. 
Click Select Action next to the Action List. 

The Select Action dialog box opens. 

24. Click the checkboxes  to the left of the actions you want to execute.  

Actions that are available vary by attack alarm type. 

25. Click the checkbox  next to the Action List to select all Actions. 

26. Click OK. 

27. To add another action, repeat steps 22 through 26. 

Some actions may have parameters that must be configured before IMC can execute them. If 

they do, the Configure icon  is displayed in the Configure Parameters field of the 
associated action in the Action and Order list. 

28. Click the Configure icon  to configure the parameters for the associated action. You are 
prompted to configure any parameters that have not been configured before you can create the 
security control policy. 

29. For the Email action, enter the following configuration parameters in the Parameter 
configurations for mail sender dialog box. 

 Destination Mail Address—Enter the fully qualified mail address of the recipient of this 
mail alert in the Destination Mail Address field. 

 Mail Subject—Enter a brief subject for this mail in the Mail Subject field. 

 Mail Content—Enter the content of the mail in the Mail Content field. 

a. Click OK. 

b. For the Warn action, enter the following configuration parameters in the Send Message 
dialog box. 

c. Enter the message that will be displayed on the online user's browser the Send Message 
field. Message length is limited to 60 characters. 

d. Click OK to send the message to the online user. 

30. If you have entered more than one action in the Action list, you can specify the order in which 
IMC executes them. 

 Click the Up Arrow Key icon  to move an action up in order of execution. 
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 Click the Down Arrow Key icon  to move an action down in order of execution. 

 Click the Delete icon  to delete one or more actions from the Action list. 

31. Click OK to create the security control policy. 

Deleting a security control policy 
To delete a security control policy: 

1. Navigate to Alarm > Security Control Policy. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Security Control Center on the left navigation tree. 

c. Click Security Control Policy under Security Control Center on the left navigation tree. 

The Security Control Policy List page opens. 

2. Click the Delete icon  associated with the security control policy you want to delete 

3. Click OK to confirm the deletion of the selected security control policy. 

Executing a security control policy 
SCC provides two options for executing a security control policy; automatic and manual. When the 
Auto option is selected in the configuration of a security control policy, IMC automatically executes 
the action when the matching security alarm is generated. For more information about configuring a 
security control policy to run automatically, see "Adding a security control policy." 

When the Manual option is selected in the configuration of a security control policy, IMC does not 
automatically execute the action when the matching security alarm is generated. Rather, the 
operator must navigate to the Execution Result Report and manually initiate the execution of the 
action when a matching event is detected and an alarm is generated in SCC. For more information 
about executing an action manually, see "Executing an action for an attack alarm." 

Viewing the security control policy execution history 
To view the security control policy execution history: 

1. Navigate to Alarm > Security Control Policy. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click Security Control Center on the left navigation tree. 

c. Click Security Control Policy under Security Control Center on the left navigation tree. 

The Security Control Policy List page opens. 

2. Click the History icon  for the security control policy to be viewed. 

The Browse Attack Alarm page opens, which displays the Attack Alarm List of the security 
control policy. For more information about the attack alarm list, see "Browsing the attack alarm 
list." 

Viewing SCC reports 
SCC provides you with a quick snapshot of security events from four perspectives for the last hour. 
Each of these four reports is described below. 

1. Navigate to Alarm > Report. 

a. Click the Alarm tab from the top tabular navigation system. 
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b. Click Security Control Center on the left navigation tree. 

The four perspectives are displayed in the main pane of the Report page. 

Top 10 attack alarms report 
The Top 10 Attack Alarms report provides you with a brief bar graph of the number of attacks 
summarized by attack type, as shown in Figure 138. 

Figure 138 Top 10 attack alarms 

 
 

 To hide this graph, click the Collapse icon  located in the upper right corner of the graph 

 To view a hidden graph, click the Expand icon  located in the upper right corner of the 
graph. 

Top 10 attack sources report 
The Top 10 Attack Sources report provides you with a pie chart displaying the distribution of attacks 
by the attack source IP address, as shown in Figure 139. 

Figure 139 Top 10 attack sources 

 
 

 To hide this graph, click the Collapse icon  located in the upper right corner of the graph. 

 To view a hidden graph, click the Expand icon  located in the upper right corner of the 
graph. 

Top 10 attack destinations report 
The Top 10 Attack Destinations report provides you with a pie chart displaying the distribution of 
attacks by the attack destination IP address, as shown in Figure 140. 
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Figure 140 Top 10 attack destinations 

 
 

 To hide this graph, click the Collapse icon  located in the upper right corner of the graph. 

 To view a hidden graph, click the Expand icon  located in the upper right corner of the graph 

The execution results report 
The Execution Result of Security Control Policy report provides you with a pie chart displaying the 
distribution of execution results, as shown in Figure 141. 

Figure 141 Execution result of security control policy 

 
 

 To hide this graph, click the Collapse icon  located in the upper right corner of the graph. 

 To view a hidden graph, click the Expand icon  located in the upper right corner of the 
graph. 

Integrating SCC with SMS 
The Security Management System (SMS) software is designed for network security monitoring and 
management, enabling operators to obtain the status information and alarms from the security 
devices on the network and manage the entire network security status in real time. 

For unified management, you can integrate SCC with SMS and enter the SMS management page in 
SCC to monitor the network-wide security devices. 

Integrating SCC with SMS 
SCC supports SMS 3.1.0.7607 and later versions. 
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SMS plug-in installation 

1. Install the SMS plug-in. 

2. Launch the CLI of the server installed with SCC, and go to the IMC installation 
directory\IMC\client\bin\ directory. 

3. Execute installsms.bat. For Linux operating systems, execute ./installsms.sh. 

4. Enter the IP address of the SMS plug-in in the https://smsip format. 

5. Enter the username and password for the SMS administrator. 

Figure 142 shows an example of the SMS screen when the plug-in is successful installed. 

Figure 142 SMS plug-in installation example 

 
 

6. Restart jserver. 

7. Open the Intelligent Deployment Monitoring Agent, and click the Process tab. 

8. Right-click the jserver process and select Stop Process from the shortcut menu. 

9. When the jserver process stops, right-click the process, and select Start Process from the 
shortcut menu. 

The SMS management page in SCC 

1. Navigate to Alarm > SMS Management. 

a. Click the Alarm tab from the top tabular navigation system. 

b. Click the Security Control Center on the left navigation tree. 

c. Click the SMS Management link located under Security Control Center on the left 
navigation tree. 

The SMS Management page opens. 

SMS list 

 Device Label—Contains the IMC name and the IP address for the SMS. The contents of the 
device label field serve as an active link for drilling down into the Device Details page. 

 IP Address—Contains the IP address of SMS. 

 Operation—Contains an active link. Click the link to display five actions:  

 Launch SMS Client 

 Display All Attack Alarms 

 Modify Login information 

 Display All Managed TP IPSs 

 Display Report 

You can click any link to open the SMS management page, and view or edit information. 

SMS and managed devices in the topology 

1. Navigate to My Network View topology. 

a. Click the Resource tab from the top tabular navigation system. 

b. Click View Management on the left navigation tree. 

c. Click Network Topology under View Management on the left navigation tree. 

The topology window opens. 
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2. Click the Expand icon  to the left of Custom Topology on the left navigation tree. 

3. Click My Network View.  

The My Network View topology is displayed. 

4. Click the icon  in the toolbar at the top of the topology.  

At the right of the topology page, an SMS area is displayed, containing SMS entries and their IP 
addresses. 

5. Click an SMS in the SMS area.  

Then in the topology map, the SMS and the IPS devices managed by the SMS lightup, and 
other devices are grayed out. 

6. Right-click the SMS and select any of the following items from the shortcut menu: 

 Open SMS Client—Opens the SMS management page. 

 Browse Events—Views alarms collected by SMS. 

 Browse Reports—Views reports in the SMS. 

7. Right-click an IPS device and select any of the following items from the shortcut menu: 

 Open IPS Device—Opens the IPS device and view its details. 

 Browser IPS Events—Views alarms generated on the IPS device. 

Intelligent policy center 
The intelligent policy center (IPC) extends SCC to process the following events in addition to attack 
alarms: 

 Device alarms, which are generated based on device state change traps received from 
managed trap sending devices (also called alarm source devices). 

 Periodic events, which are scheduled in IPC to take specified actions periodically. For example, 
you can define a periodic event to change passwords for wireless devices at a regular interval. 

Both SCC and IPC can process device alarms and attack alarms. However, only IPC can process 
periodic events. 

When processing alarms, IPC typically does not locate or take action on alarm-relevant devices as 
does SCC. Instead, IPC takes action only on the alarm source device unless you have configured 
IPC to shut down interfaces on the devices attached to the alarm source device. 

To process alarms effectively and efficiently, use the following guidelines when you choose the alarm 
processing module: 

 Use IPC to resolve device alarms. Locating relevant devices takes time and does not help in 
resolving device alarms, which are typically irrelevant to other devices than the trap sending 
device.  

 Use SCC to resolve attack alarms. SCC can locate the attack initiator and target and identify the 
IP address and port of the device that provides access service to the attack initiator. Then, SCC 
can remove the security issue by performing actions on the alarm source device and its 
attached devices, including re-enabling interfaces and restarting devices.  

IPC includes the following parts: 

 Event Configuration—Allows you to define device alarm events and periodic events. 

 Action Configuration—Allows you to view available actions. 

 Policy Management—Allows you to manage policies. A policy specifies the actions to take in 
response to an event. 

 View Event—Displays events that occurred and policy execution results. 

 Report—Allows you to view the event report and policy execution report for the last hour. 
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To use IPC to process an alarm or periodic event: 

1. In the event configuration, add a device alarm event or periodic event configuration entry.  

2. In the policy configuration, add a policy, associate the specified event configuration entry with 
actions to be executed, and configure action parameters. 

Each time an event occurs and matches an event configuration entry, the system performs the 
following operations: 

 Records the event on the View Event page. 

 Executes the actions specified in the policy associated with the event configuration entry and 
records the policy execution result for the event. Alternatively, you can manually execute the 
actions. 

Managing event configuration entries 
Event Configuration allows you to customize device alarm events and periodic events to be 
managed: 

 A device alarm event configuration entry specifies an alarm name and a set of alarm variable 
matching rules. If a received alarm has the specified alarm name and matches the rules in the 
event configuration entry, the system records the device alarm event. 

 A periodic event configuration entry defines a scheduled task. After the configuration entry is 
associated with a policy, the system automatically executes the actions specified in the policy at 
the time specified in the task. The system records each execution as an event. 

Accessing the event configuration list 

1. Click the Service tab. 

2. From the navigation tree, select Intelligent Policy Center > Event Configuration. 

The list includes all event configuration entries. 

Event configuration list contents 

 Name—Name of the event configuration entry. Click the name to view the detailed 
information of the event configuration entry. 

 Description—Description of the event configuration entry. 

 Type—Type of the event configuration entry: Periodic Event or Device Alarm. 

 Modify—Click the Modify icon  to modify the event configuration entry. For more 
information, see "Modifying an event configuration entry." 

 Delete—Click the Delete icon  to delete the event configuration entry. For more 
information, see "Deleting event configuration entries." 

Adding a device alarm event configuration entry 

1. On the event configuration list page, click Add. 

2. In the Basic Information area, select the Device Alarm type. 

3. Configure the following parameters: 

 Name—Enter a name for the event configuration entry. 

 Description—Enter a description for the event configuration entry. 

 Alarm Name—Click Select Alarms. In the Select Alarm dialog box, filter alarms by Trap 
Name, Trap OID, Enterprise Name, or Enterprise ID, and then select the desired alarm 
name. 

4. Define alarm variable matching rules: 

a. In the Alarm Variable Matching Rule area, click Add Rule. 

The Add Rule dialog box opens. 

b. Select an alarm variable from the Alarm Variable Name list. 
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c. Enter a regular expression in the Regular Expression field. 

d. Click OK. 

The new alarm variable matching rule is displayed in the Alarm Variable Matching Rule 
list. 

e. Repeat the previous steps to add more rules. 

f. To delete a rule, click the Delete icon  for the rule. 

An alarm must match the alarm name and all the configured alarm variable matching rules in 
the event configuration entry to match the device alarm event. 

5. Click OK. 

The new device alarm event configuration entry is displayed in the event configuration list. 

Adding a periodic event configuration entry 

1. On the event configuration list page, click Add. 

2. In the Basic Information area, select the Periodic Event type. 

3. Configure the following parameters: 

 Name—Enter a name for the event configuration entry. 

 Description—Enter a description for the event configuration entry. 

 Event Name—Enter a name for the periodic event. If you do not specify a name, the name 
of the event configuration entry is used. 

4. In the Task Schedule Information area, configure the following parameters: 

 Schedule Type—Select a schedule type from the list. Options are One Time and Periodic. 

 If you select One Time, specify the time to execute the event. 

 If you select Periodic, specify the execution interval, execution time, and effective time 
range of the event.  

5. Click OK. 

The new periodic event configuration entry is displayed in the Event Configuration list. 

Modifying an event configuration entry 

1. On the event configuration list page, click the Modify icon  for the event configuration entry 
you want to modify. 

2. Modify the event configuration parameters. 

For the parameter descriptions, see "Adding a device alarm event configuration" or "Adding a 
periodic ." 

3. Click OK. 

Deleting event configuration entries 

You can delete event configuration entries individually or in batches.  

When you delete event configuration entries, the followings guidelines apply: 

 Deleting an event configuration entry does not delete the matching events already recorded by 
the system. (The system records and displays the matching events on the View Event page.) 

 Event configuration entries that are assigned to policies cannot be deleted. To delete the event 
configuration entries, delete the policies first. 

Deleting an event configuration entry 

1. On the event configuration list page, click the Delete icon  for the event configuration you 
want to delete. 

2. In the confirmation dialog box, click OK. 

Deleting event configuration entries in batches 
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3. On the event configuration list page, select one or more event configuration entries you want to 
delete. 

4. Click Delete. 

5. In the confirmation dialog box, click OK. 

Managing actions 
As shown in Figure 143, Action Management lists the actions that can be associated with an event 
configuration entry in a policy. Click the name of an action to view the parameter list and other 
information about the action. 

Figure 143 Action Management page 

 

Accessing the Action Management page 

1. Click the Service tab. 

2. From the navigation tree, select Intelligent Policy Center > Action Configuration. 

The Action Management page opens, listing all available actions. 

Action list contents 

 Name—Name of the action. Click the name to view the action details.  

 Description—Description of the action. 

Viewing detailed information about an action 

On the Action Management page, click the name of the action whose detailed information you want 
to view. 

The Action Details page includes the following areas: 

 Basic Information—This area displays the name and description of the action, and the 
Execution actions when parameters are matched option at the bottom. If the option is 
selected, you must configure the alarm parameter-to-action parameter mappings when using 
the action in a policy. 

 Parameter List—This area displays the parameter list of the action. 

Managing policies 
A policy defines the actions to be taken in response to an event. 
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You can specify actions for an event in a policy. If a specified action supports recovery actions, the 
system automatically execute the recovery actions to restore the network to the previous state. 

Accessing the policy list page 

1. Click the Service tab. 

2. From the navigation tree, select Intelligent Policy Center > Policy Management. 

The policy list displays all policies in the system. 

Policy list contents 

 Policy Name—Name of the policy. Click the name to view the policy details.  

 Policy Description—Description of the policy. 

 Execution Type—Execution type of the policy: Auto or Manual. 

 History—Click the History icon  to view the policy execution history. For more 
information, see "Viewing the policy history." 

 Modify—Click the Modify icon  to modify the policy. 

 Delete—Click the Delete icon  to delete the policy. 

Adding a policy 

1. On the policy list page, click Add. 

The Basic Information page opens. 

2. Configure the following parameters: 

 Policy Name—Enter a name for the policy. 

 Policy Description—Enter a description for the policy. 

 Execution Type—Select a policy execution type from the list. Options are Auto and 
Manual. 

 Auto—The system automatically executes the actions in the policy when it receives a 
matching event. 

 Manual—Administrators must go to the View Event page to manually execute the 
actions in the policy for a matching event. For more information, see "Executing the 
policy for an event with an execution result of Manual execution required." 

 Event to Process—Click Select Event. In the Select Event dialog box, select an event 
and click OK. Available options include all periodic and device alarm event configuration 
entries that are not used by other policies. 

3. Specify the network segments to which the policy applies. 

Skip this step if a periodic event is selected for Event to Process. 

 To apply the policy to the whole network, select the It takes effect on the whole network 
option. 

 To apply the policy only to the specified network segments, clear the It takes effect on the 
whole network option, and configure and add the network segments. To delete an added 
network segment, select the segment in the Configured Segment(s) list and then click 
Delete. 

4. Specify the effective time range for the policy. 

 To make the policy always effective, select The policy is always effective. 

 To make the policy effective during only the specified time ranges, clear the The policy is 
always effective option, and select time ranges in list below the option. 

The effective time range of the policy is the intersection of all selected time ranges. For 
example, if you select two time ranges for a policy, one is 8:00 to 18:00 on Sunday, another 
is 8:00 to 10:00 on Sunday, the effective time range of the policy is 8:00 to 10:00 on Sunday. 

The policy does not take effect if the selected times ranges do not have an intersection. 
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To configure the available time range, go to System > System Configuration > Work 
Time Settings. 

5. Click Next. 

The Action Configuration page opens. 

On this page, the following action configuration options are available: 

 Execute by Default—Allows you to configure the default actions. The default actions are 
executed for a matching event of the policy in either of the following cases: 

 No condition branches are configured in the policy. 

 The event does not match any condition branch in the policy. 

 Execute Under Condition—Allows you to configure condition branches and the actions to 
execute in each condition branch. 

A condition branch is a set of event filtering conditions in AND or OR relations. When an 
event matches a condition branch, the system executes the actions configured for the 
branch. 

6. Configure default actions for events. 

Skip this step if you do not want to execute any actions for events that match none of the 
condition branches. 

a. Select Execute by Default. 

b. In the Action Strategy area, select one of the following strategies: 

 Execute actions in sequence if all action variables are valid, or execute none of 
the actions if any action variable is invalid. 

 Execute actions in sequence and skip actions with invalid variables. 

 Stop executing actions if one action is successfully executed. 

c. On the action list, click Select Action. The Select Action dialog box displays all the actions 
supported by the event configuration entry in the policy. Select one or more actions and 
click OK. 

The selected actions are displayed on the Action List.  

d. Configure the following parameters for each action: 

 Configure Action Parameters—Click the Configure Action Parameters icon  to 
configure the action parameters. 

 Alarm Parameter—Click the Alarm Parameter icon  and configure the action 
parameter-to-alarm parameter mappings if the action needs to obtain parameter values 
from the event. 

 Target—Click the Target icon . In the Action Target Configuration dialog box, 
specify the action targets by selecting existing devices, custom views, or devices groups 
in IMC, or by specifying the alarm parameters in the event. 

 Sort—Adjust the position of the action on the action list by clicking the Move up icon  

or Move down icon . Actions are executed in the order they are displayed on the 
action list.  

 Delete—Click the Delete icon  to delete the action. 

7. To configure a condition branch and associate actions with the branch: 

a. Click Add Condition Branch. 

The Add Condition Branch dialog box opens. 

b. Add a condition: 

 Select a parameter from the Condition Parameters list. Options are all event 
parameters that have not been used in the condition branch. 
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 Select a condition type. Options are Character String and Value. 

 Enter the condition content in the Condition Content field. 

 From the Match Mode list, select the match mode between the condition parameter and 
condition content. Options are Included and Excluded. 

 If the condition list already contains a condition, specify the relationship (AND or OR) 
between the new condition and the existing condition. 

 Click Add. 

The new condition is displayed in the condition list. 

c. Repeat step b to add more conditions. 

d. To delete a condition from the condition list, click the Delete icon  for the condition. 

e. Click OK. 

The condition branch named Condition Branch N is displayed on the Action 
Configuration page, with the conditions listed under Action Execution Condition. 

f. In the Action Strategy area, select one of the following strategies: 

 Execute actions in sequence if all action variables are valid, or execute none of 
the actions if any action variable is invalid. 

 Execute actions in sequence and skip actions with invalid variables. 

 Stop executing actions if one action is successfully executed. 

g. Configure the actions for events that match the condition branch. 

On the action list, click Select Action. In the Select Action dialog box, select one or more 
actions and click OK. 

The selected actions are displayed on the Action List.  

Configure the following parameters for each action: 

 Configure Action Parameters—Click the Configure Action Parameters icon  to 
configure the action parameters. 

 Alarm Parameter—Click the Alarm Parameter icon  and configure the action 
parameter-to-alarm parameter mappings if the action needs to obtain parameter values 
from the event. 

 Target—Click the Target icon . In the Action Target Configuration window, specify 
the action targets by selecting existing devices, custom views, or devices groups in IMC, 
or by selecting the alarm parameters in the event. 

 Sort—Adjust the position of the action on the action list by clicking the Move up icon  

or Move down icon . Actions are executed in the order they are displayed on the 
action list. 

 Delete—Click the Delete icon  to delete the action. 

h. Repeat step a through g to add more condition branches. 

A policy supports a maximum of five condition branches named Condition Branch 1 
through Condition Branch 5.  

The system compares an event against the condition branches sequentially from Condition 
Branch 1 to Condition Branch 5 until a match is found (the rest condition branches are 
ignored). Then, it executes the actions associated with the matching condition branch for 
the event. 

8. Click OK. 

Modifying a policy 

1. On the policy list page, click the Modify icon  for the policy you want to modify. 
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The Modify Policy page opens. 

2. Modify the policy settings and click OK. 

For the operation procedures, see "Adding a policy." 

Deleting a policy 

After you delete a policy from the policy list, you can no longer access the policy details page from 
the View Event page. All action information, except for the action execution result and description, is 
also removed from the policy execution result. 

To delete a policy: 

1. On the policy list page, click the Delete icon  for the policy you want to delete. 

2. In the confirmation dialog box, click OK. 

Viewing the policy history 

The policy history records the events that match the event configuration entry associated with the 
policy, and the policy execution results for these events. 

To view the history of a policy: 

1. On the policy list page, click the History icon  for a policy. 

The View Event page displays all matching events of the policy. 

2. Perform any of following tasks: 

 To delete one or more events, select the events, click Delete, and then click OK in the 
conformation dialog box. 

 To view the policy execution result of an event, click the link in the Result column of the 
event. 

 To execute the policy for an event that has an execution result of Manual execution 
required, click the Manual execution required result link for the event. On the Execution 
Result Report page, click Execute. 

For more information about the tasks you can perform on events from the View Event page, 
see "Viewing events." 

Viewing events 
Each time an event occurs and matches an event configuration entry, the system records the event 
on the View Event page. If the event configuration entry is associated with a policy, the policy 
execution result for the event is also recorded. 

The policy execution result of an event is a link to the Execute Result Report page, which allows 
you to manually process the event. For more information, see "Manually processing events." 

Accessing the View Event page 

1. Click the Service tab. 

2. From the navigation tree, select Intelligent Policy Center > View Event. 

The View Event page displays all events in the event list. 

Event list contents 

 Name—Name of the event. Click the name to view the event details.  

 Description—Description of the event. 

 Time—Time when the event was received. 

 Correlated Policy—Policy associated with the event. If the event is not associated with any 
policy, Undefined is displayed. 

 Result—Policy execution result. The value in this field acts as a link to the Execution 
Result Report page. 
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Policy execution results are: 

 Success—The policy is successfully executed for the event. 

 Failure—Failed to execute the policy for the event. 

 Manual execution required—The policy has an execution type of Manual and must be 
manually executed for the event. 

 No matching policy—No matching policy is found for the event. 

 Executing policy—The policy is being executed. 

 Waiting for policy execution—The policy is waiting to be executed. 

 Acknowledgement required—Acknowledgement is required to execute the policy. 

Querying events 

You can query events on the event list through basic query or advanced query. 

Performing a basic query 

1. In the Query Events area, specify one or more of the following query criteria: 

 Name—Enter a partial or complete event name. 

 Time—Select a time range during which the event was received. Options are: 

 All 

 Events in Last 1 Hour 

 Events in Last 6 Hours 

 Events in Last 12 Hours. 

 Events in Last 24 Hours 

 Result—Select an execution result from the list. 

Empty fields are ignored. 

2. Click Query. 

The event list displays all matching event records. 

3. To reset the query criteria and display all events, click Reset. 

Performing an advanced query 

1. In the Query Events area, click Advanced Query in the upper right corner.  

2. Specify one or more of the following query criteria: 

 Name—Enter a partial or complete event name. 

 Description—Enter a partial or complete description of the event. 

 Correlated Policy—Select the policy associated with the event. 

 Result—Select a policy execution result from the list. 

 Start Time/End Time—Specify the time range during which the event was received. 

Empty fields are ignored. 

3. Click Query. 

The event list displays all matching event records. 

4. To reset the query criteria and display all events, click Reset. 

Deleting events 

Deleting an event record does not delete the event configuration entry or the policy associated with 
the event configuration entry. 

To delete events: 

1. On the event list, select the events you want to delete. 

2. Click Delete. 
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3. In the confirmation dialog box, click OK. 

Manually processing events 

The execution result of an event is a link to the Execution Result Report page.  

From the Execution Result Report page, you can perform the following tasks:  

 Configure and execute actions for an event with a policy execution result of No matching 
policy. 

 Execute the policy for an event with a policy execution result of Manual execution required.  

 Re-execute the policy for an event with a policy execution result of Failure. 

Configuring and executing actions for an event with an execution result of No matching 
policy 

1. On the event list, click the No matching policy result link for an event. 

The Execution Result Report page opens. 

2. In the Action Strategy area, select one of the following strategies: 

 Execute actions in sequence if all action variables are valid, or execute none of the 
actions if any action variable is invalid. 

 Execute actions in sequence and skip actions with invalid variables. 

 Stop executing actions if one action is successfully executed. 

3. In the Action and Order area, configure the actions to be executed: 

a. Click Select Action. 

b. In the Select Action dialog box, select one or more actions and click OK. 

The selected actions are displayed on the action list.  

c. Configure the following parameters for each action: 

 Configure Action Parameters—Click the Configure Action Parameters icon  to 
configure the action parameters. 

 Alarm Parameter—If the action needs to obtain parameter values from the event, click 

the Alarm Parameter icon  and configure the action parameter-to-alarm parameter 
mappings. 

 Target—Click the Target icon . In the Action Target Configuration dialog box, 
specify the action targets by selecting existing devices, custom views, or devices groups 
in IMC, or by selecting the alarm parameters in the event.  

 Sort—Actions are executed in the order they are displayed on the action list. Adjust the 

position of the action on the action list by clicking the Move up icon  or Move down 

icon . 

 Delete—Click the Delete icon  to delete the action. 

4. Click Execute. 

The system executes the actions for the event. 

5. To view the execution result, go back to the View Event page. 

Executing the policy for an event with an execution result of Manual execution required 

1. On the event list, click the Manual execution required result link for an event. 

The Execution Result Report page opens. 

2. Click Execute. 

The system executes the policy for the event. 

3. To view the execution result, go back to the View Event page. 

Re-executing the policy for an event with a policy execution result of Failure 
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1. On the event list, click the Failure result link for an event. 

The Execution Result Report page opens. 

2. Click Redo. 

The system re-executes the policy for the event. 

3. To view the execution result, go back to the View Event page. 

Viewing reports 
The system summarizes the event statistics and policy execution statistics by result for the last hour 
in the following reports: 

 Last Hour Events 

 Policy Execution Result in Last Hour 

To access the report page: 

1. Click the Service tab. 

2. From the navigation tree, select Intelligent Policy Center > Report. 

The Report of Policy Control Center page opens. 

Last Hour Events report 

As shown in Figure 144, the Last Hour Events report displays the last hour event statistics in a bar 
chart: 

The X axis shows the event name, and the Y axis shows the number of occurrences. 

Point to a bar to view the event information, including the event name and number of times the event 
has occurred. 

Figure 144 Last Hour Events report 

 
 

Policy Execution Result in Last Hour 

As shown in Figure 145, the Policy Execution Result in Last Hour report displays the policy 
execution statistics by result for the last hour in a pie chart. 

Each slice on the chart represents a type of policy execution result, including: 

 Success 

 Failure 

 No matching policy 

 Others 
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Figure 145 Policy Execution Result in Last Hour report 
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VLAN management 
With IMC, you have a convenient facility for managing VLANs globally or on a per device basis. With 
IMC Global VLAN option, you can simplify the process of creating standardized VLANs across 
devices in the infrastructure. Using the Global VLAN option, you can create VLANs and select from 
the list of all managed devices, which devices to add the VLAN to or remove the VLAN from. 

With IMC Batch Deploy option, you can create and configure VLANs on one or more devices, 
including configuring access, trunk, or hybrid ports. 

For individual device VLAN management, you can select the device for which to configure VLANs. 
From the VLAN configuration page, you can configure a VLAN for the selected device as well as 
configure virtual interfaces, access ports, trunk ports, or hybrid ports for each VLAN. 

In addition, you can view histories of VLAN management operations using IMC VLAN Deployment 
Task option. 

Finally, with IMC VLAN Topo option, you can launch a network topology view that highlights devices 
for the selected VLAN and grays out devices that are not part of the VLAN. You can actively monitor 
and manage devices in the selected VLAN from the topology map. 

Global VLAN management 
IMC Global VLAN management feature makes it simple and easy to create standardized VLANs for 
one, some, or all devices in the network infrastructure. With the Global VLAN option, you can add a 
VLAN to all switches in the network simply by defining the VLAN ID, the VLAN name, and by 
selecting the devices to which you add the VLAN. In addition, you can easily add, modify or delete 
VLANs on selected devices. 

Viewing the global VLAN list 
The Global VLAN List provides you with a list of all VLANs configured on devices managed by IMC 
for which IMC  recognizes. 

To view the VLANs in the network infrastructure: 

1. Navigate to VLAN Management > Global VLAN. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click Global VLAN under VLAN Management on the left navigation tree. 

The global VLAN List is displayed. 

2. Do one of the following: 

 When the VLAN ID and VLAN Name Identification Mode box is not selected, a VLAN ID 
uniquely identifies a global VLAN, so the global VLAN list for a VLAN ID displays only one 
VLAN. As a best practice, use this mode for Layer 2 network management.  

 When the VLAN ID and VLAN Name Identification Mode is selected, the global VLAN list 
displays multiple VLANs with the same VLAN ID but different VLAN names. As a best 
practice, use this for Layer 3 network management.  

VLAN list 

 VLAN ID—Contains the ID for the associated VLAN. 

 VLAN Name—Contains the name for the associated VLAN. 

 Include VLAN Interfaces—Identifies whether or not the associated VLAN has a virtual 
interface configured for it. 
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 Member Operation—Contains a link to the VLAN Device List for the associated VLAN. 

The VLAN ID and Member Operation fields for VLAN 1 or VLAN 001 are grayed out 
because this VLAN serves as a management VLAN for most switch manufacturers. The 
VLAN Device List, which is accessed through the Member Operation link, is gray and 
unavailable because all devices are by default, a member of VLAN 1 or 001. 

 Modify VLAN Name—Contains a link for modifying the name of the associated VLAN. 

If the VLAN List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the VLAN List. 

 Click  to page forward to the end of the VLAN List. 

 Click  to page backward in the VLAN List. 

 Click  to page backward to the front of the VLAN List. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items 
per page you want to view. 

4. Click Refresh to reload this Web page. 

5. You can sort the VLAN List by VLAN ID, VLAN Name, and Include VLAN Interfaces fields by 
clicking the column label to sort the list by the selected field. The column label is a toggle switch 
that allows you to toggle between the various sort options specific to each field. 

Querying Global VLAN 
Using the global or Overall VLAN Query option, you can quickly identify which devices have a 
specific VLAN configured on it.  

To query by VLAN ID or VLAN name: 

1. Navigate to VLAN Management > Global VLAN. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click Global VLAN under VLAN Management on the left navigation tree. 

The global VLAN List is displayed. 

2. Enter one of the following search criteria in the field in the upper right corner of the VLAN list: 

 VLAN ID—Enter a partial or complete VLAN ID for the VLAN you wish to locate in the field. 

 VLAN Name—Enter a partial or complete name for the VLAN you wish to locate in the field. 

3. Click . 

The result of your query is displayed in the VLAN list. 

Creating a global VLAN 
With the Global VLAN feature in IMC, you can create a VLAN and add it to one or more devices. 

To create a global VLAN: 

1. Navigate to VLAN Management > Global VLAN. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click Global VLAN under VLAN Management on the left navigation tree. 

The global VLAN List is displayed. 
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2. Click Add. 

3. Enter the ID for this VLAN in the VLAN ID field. A valid range for a VLAN ID is 2 – 4094. 

4. Enter the name for this VLAN in the VLAN Name field. 

Question marks (?) and non-ASCII characters are not permitted in VLAN names. Maximum 
length is 32 characters. 

5. Click Add to select the devices to which you add to the VLAN. 

6. Add devices by using either the View or Advanced query option.  

7. Click OK. 

8. Review the results of the VLAN creating task by reviewing the Adding global VLAN Summary 
Report that display upon completion of the task. 

Once you have created the VLAN and added devices to it as you have completed in the 
previous steps, you must then add ports from the selected devices to the VLAN. For more 
information about adding ports to VLAN, see "VLAN device management." 

Deleting a global VLAN 
With the Global VLAN feature in IMC, you can also remove one or more VLANs from one, some, or 
all devices on the VLAN’s device list with just a few clicks. 

To delete a VLAN from all devices in the VLAN’s device list: 

1. Navigate to VLAN Management > Global VLAN. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click Global VLAN under VLAN Management on the left navigation tree. 

The global VLAN List is displayed. 

2. Select the VLANs that you want to remove. 

3. Click Delete. 

4. Click OK to confirm deletion of the selected VLANs. 

Adding devices to a global VLAN 
Once you have created a global VLAN, you can then use the Global VLAN option to add it to one or 
more devices. 

To add a VLAN to one or more devices: 

1. Navigate to VLAN Management > Global VLAN. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click Global VLAN under VLAN Management on the left navigation tree. 

The global VLAN List is displayed. 

2. Click the Member Operation link associated with the VLAN to which you want to add devices . 

3. Click Add. 

4. Add devices by using either the View or Advanced query option.  

5. Click OK to add the selected devices to the VLAN. 

Once you have added the VLAN to devices, you can then add individual ports to the VLAN on 
each device. For more information about adding individual ports to a VLAN on a particular 
device, see "VLAN device management." 
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Deleting a VLAN from devices 
You can also easily remove a VLAN from one or more devices using the Global VLAN feature. 

To delete a VLAN from one or more devices: 

1. Navigate to VLAN Management > Global VLAN. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click Global VLAN under VLAN Management on the left navigation tree. 

The global VLAN List is displayed. 

2. Click the Member Operation link associated with the global VLAN you want to remove from 
devices. 

3. Select the devices you want to remove the VLAN from. 

4. Click Delete. 

5. Click OK to confirm deletion of the VLAN from the selected devices. 

VLAN device management 
IMC offers you a convenient facility for managing VLANs on the selected device, allowing you to 
select the device for which to configure VLANs. From the VLAN configuration page, you can 
configure a VLAN for the selected device as well as configure virtual interfaces, access ports, trunk 
ports, or hybrid ports for each VLAN. 

Viewing the VLAN device list 
The VLAN Device List displays all devices for which IMC can manage VLANs. Devices that are 
VLAN capable but are not displayed in this list are devices that use a proprietary VLAN protocol. IMC 
supports the 802.1q standard for VLANs. 

To view devices that IMC can manage VLANs for: 

1. Navigate to VLAN Management > VLAN Devices. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click VLAN Devices under VLAN Management on the left navigation tree. 

The VLAN Device List is displayed. 

VLAN device list 

 Device Status—Contains the latest status of the device. Status is determined by the 
highest severity or alarm level for the device, when a device has more than one current 
alarm that has not been cleared or recovered. Device icons with the color gray denote that 
the device is unmanaged. 

 Device Name—Contains the IMC name for the device, which, by default, is the name 
assigned to it in its device configuration. If the device is configured with a sysName, IMC 
uses this as the Device Name unless a Device Name has been manually configured, and 
contains the IP address of the device. 

 Device Type—Contains the device series information for the associated device. 

 VLAN—Displays all VLAN IDs added to the device. 

 VLAN Configuration—Contains a link to configure VLANs for the associated device. 

If the VLAN Device List spans multiple pages, use the following aids to navigate the list: 
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 Click  to page forward in the VLAN Device List. 

 Click  to page forward to the end of the VLAN Device List. 

 Click  to page backward in the VLAN Device List. 

 Click  to page backward to the front of the VLAN Device List. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items 
per page you want to view. 

3. Select a device and click Synchronize. 

IMC queries the device for the most current VLAN configuration for the selected devices. 

4. Click Refresh to reload the Web page. 

You can sort the VLAN Device List by all fields with the exception of the VLAN Configuration 
and VLAN field by clicking the column label to sort the list by the selected field. The column 
label is a toggle switch that allows you to toggle between the various sort options specific to 
each field. 

Querying a device 
To query a device: 

1. Navigate to VLAN Management > VLAN Devices. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click VLAN Devices under VLAN Management on the left navigation tree. 

The VLAN Device List is displayed. 

2. In the upper right corner of the VLAN Device list, enter a partial or complete device name for 
the device you wish to locate in the Device Name field. 

3. Click the Search icon . 

The result of your query is displayed  in the VLAN Device List. If you want to restore the VLAN 

Device List, delete the query criteria that you entered, and click the Search icon . 

Managing VLAN device details 
The VLAN Device page enables you to view and configure many facets of a VLAN on the selected 
device. There are five tabs on the VLAN Devices page. Each tab provides you with VLAN viewing 
and configuration options. 

 Device VLAN 

 Virtual Interface 

 Access Port 

 Trunk Port 

 Hybrid Port 

To access the VLAN details for a particular device:  

1. Navigate to VLAN Management > VLAN Devices. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click VLAN Devices under VLAN Management on the left navigation tree. 
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The VLAN Device List is displayed. 

2. To view or configure VLAN details for an individual device, click the VLAN Configuration link 
associated with the device you want to view or configure. 

Information for the selected device is displayed in the upper portion of the page. This 
information includes: 

 Device Type 

 Device IP 

 Device Status 

 IP Mask 

There are also five tabs for managing various aspects of VLANs for the selected device:  

 Device VLAN 

 Virtual Interface 

 Trunk Port 

 Access Port 

 Hybrid Port 

The VLAN Devices tab enables you to view, add, and delete VLANs for the selected device.  

Viewing VLANs 

To view the VLANs for a specific device: 

1. Navigate to VLAN Management > VLAN Devices > Device Name. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click VLAN Devices under VLAN Management on the left navigation tree. 

The VLAN Device List is displayed. 

2. Click the VLAN Configuration link associated with the device for which you want to view 
VLANs. 

3. Click the Device VLAN tab. 

Details for the VLANs display in the VLAN list for the selected device. 

 VLAN ID—Contains the VLAN ID. 

 VLAN Name—Contains the name of the VLAN. 

 Allowed Port List—Contains a link to the list of ports assigned to the associated VLAN. 

 Modify VLAN Name—Contains a link for modifying the name of the associated VLAN. 

 Virtual Interface List—Contains a link for modifying the virtual interface of the associated 
VLAN. 

If the Device VLAN List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Device VLAN List. 

 Click  to page forward to the end of the Device VLAN List. 

 Click  to page backward in the Device VLAN List. 

 Click  to page backward to the front of the Device VLAN List. 

4. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items 
per page you want to view. 

5. For device VLAN lists that have more than one page, click 1, 2, 3, 4, 5, 6, 7, 8, 9, 10… at the 
bottom right side of the main pane to jump to a particular page of the list. 
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You can sort the Device VLAN List by the VLAN ID and VLAN Name fields by clicking the 
column label to sort the list by the selected field. The column label is a toggle switch that allows 
you to toggle between the various sort options specific to each field. 

Creating a VLAN 

To create a VLAN on a specific device: 

1. Navigate to VLAN Management > VLAN Devices > Device Name. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click VLAN Devices under VLAN Management on the left navigation tree. 

The VLAN Device List is displayed. 

2. To access the VLAN configuration page, click the VLAN Configuration link associated with 
the device to which you want to add a VLAN. 

3. Click the Device VLAN tab. 

4. Click Add. 

5. Enter the ID for this VLAN in the VLAN ID field.  

A valid range is 2 – 4094. VLAN 1 has special significance and is not a valid VLAN ID option. 

6. Enter the name for this VLAN in the VLAN Name field.  

7. Enter the name for this VLAN in the VLAN Name field.  
Enter 1 to 32 characters, which can include digits, letters, hyphens (-), underscores (_), plus 
sings (+), and spaces. Support for spaces in VLAN names varies by vendor. 

8. Click OK. 

9. Verify that the VLAN you have just configured now is displayed in the VLAN List. 

Modifying a VLAN 

To modify an existing VLAN: 

1. Navigate to VLAN Management > VLAN Devices > Device Name. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click VLAN Devices under VLAN Management on the left navigation tree. 

The VLAN Device List is displayed. 

2. Click the VLAN Configuration link associated with the device on which you want to modify 
an existing VLAN. 

3. Click the Device VLAN tab. 

4. Click the Modify VLAN Name field associated with the VLAN you want to modify. 

5. Delete the contents of the VLAN name field. Enter the new VLAN name. 

6. Click OK. 

7. Verify that the VLAN name you have just modified now is displayed in the VLAN List. 

Deleting a VLAN 

To delete a VLAN: 

1. Navigate to VLAN Management > VLAN Devices > Device Name. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click VLAN Devices under VLAN Management on the left navigation tree. 

The VLAN Device List is displayed. 

2. Click the VLAN Configuration link associated with the device on which you want to modify 
an existing VLAN. 
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3. Click the Device VLAN tab. 

4. Select the VLANs you want to delete.  
 

 NOTE: 

VLAN 1 has special significance and cannot be deleted. 
 

5. Click Delete. 

6. Click OK to confirm deletion of the selected VLANs. 

7. Verify that the VLANs you selected been removed from the Device VLAN list. 

Using the virtual interface tab 
You can assign one virtual interface to a VLAN using the features found under the Virtual Interface 
tab of the VLAN Devices page. The Virtual Interface tab option is available only for devices that 
support virtual interfaces. 

Viewing a virtual interface 

To view the virtual interfaces for a specific switch: 

1. Navigate to VLAN Management > VLAN Devices > Device Name. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click VLAN Devices under VLAN Management on the left navigation tree. 

The VLAN Device List is displayed. 

2. Click the VLAN Configuration link associated with the device for which you want to view 
virtual interfaces. 

3. Click the Virtual Interface tab. 

Details for all virtual interfaces for the selected device display in the Virtual Interface List. 

Virtual interface 

 VLAN ID—Contains ID of the VLAN. 

 IP Address Type—Contains the IP address Type of the virtual interface, including Primary 
IP and Sub IP. You can add multiples Sub IP addresses for one Primary IP address. The 
Sub IP option is only available for the device that supports Sub IP addresses. 

 IP Address—Contains the IP address of the virtual interface. 

 Mask—Contains the IP subnet mask for the virtual interface. 

If the Device VLAN List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Virtual Interface List. 

 Click  to page forward to the end of the Virtual Interface List. 

 Click  to page backward in the Virtual Interface List. 

 Click  to page backward to the front of the Virtual Interface List. 

4. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items 
per page you want to view. 

5. For lists that have more than one page, click 1, 2, 3, 4, 5, 6, 7, 8, 9, 10… at the bottom right side 
of the main pane to jump to a particular page of the list. 
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You can sort the Virtual Interface List by all fields, by clicking the column label to sort the list 
by the selected field. The column label is a toggle switch that allows you to toggle between the 
various sort options specific to each field. 

Adding a virtual interface 

To add a virtual interface to a specific switch: 

1. Navigate to VLAN Management > VLAN Devices > Device Name. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click VLAN Devices under VLAN Management on the left navigation tree. 

The VLAN Device List is displayed. 

2. Click the VLAN Configuration link associated with the device to which you want to add a 
virtual interface. 

3. Click the Virtual Interface tab. 

4. Click Add. 

5. Select the VLAN ID that this interface belongs to from the VLAN ID list. 

The VLAN must exist before a virtual interface can be added to it. For more information about 
creating a VLAN, see "Creating a VLAN." 

6. Select the IP address type from the IP Address Type list.  

The Sub IP option is only available for the device that supports sub IP addresses. 

7. Enter the IP address for the virtual interface in the IP Address field. 

8. Enter the IP subnet mask for the virtual interface in the Mask field. 

Masks can be entered using either CIDR or dotted decimal notation. 

For example, a valid subnet mask entry using CIDR notation would be 
24  

where 24 represents the number of bits allocated to the network portion of the address and 
implying that the remaining bits are allocated to the host portion. 

Alternatively, a valid subnet mask using dotted decimal notation would be 
255.255.255.0  

9. Click OK. 

Deleting a virtual interface 

To delete one or more virtual interfaces from a specific switch: 

1. Navigate to VLAN Management > VLAN Devices > Device Name. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click VLAN Devices under VLAN Management on the left navigation tree. 

The VLAN Device List is displayed. 

2. Click the VLAN Configuration link associated with the device to which you want to add a 
virtual interface. 

3. Click the Virtual Interface tab. 

4. Select the virtual interfaces you want to delete. 

5. Click Delete. 

6. Click OK to confirm deletion of the selected virtual interfaces. 
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Using the Access Port tab 
You can also move access ports between existing VLANs using the features found under the 
Access Port tab on the VLAN Devices page. 

Viewing access ports 

To view the access ports assigned to a VLAN for a specific switch: 

1. Navigate to VLAN Management > VLAN Devices. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click VLAN Devices under VLAN Management on the left navigation tree. 

The VLAN Device List is displayed. 

2. Click the VLAN Configuration link associated with the device for which you want to view 
virtual interfaces. 

3. Click the Access Port tab. 

Details for all ports for the selected device display in the Access Port List. 

Access port list 

 Port Status—Contains the current status for the associated port. 

 Port Name—Contains the port name. 

 PVID—Contains the port VLAN ID of the VLAN. 

If the Access Port List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Access Port List. 

 Click  to page forward to the end of the Access Port List. 

 Click  to page backward in the Access Port List. 

 Click  to page backward to the front of the Access Port List. 

4. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items 
per page you want to view. 

5. For Access Port Lists that have more than one page, click 1, 2, 3, 4, 5, 6, 7, 8, 9, 10… at the 
bottom right side of the main pane to jump to a particular page of the list. 

You can sort the Access Port List by all fields by clicking the column label to sort the list by the 
selected field. The column label is a toggle switch that allows you to toggle between the various 
sort options specific to each field. 

Modifying PVID 

To modify one or more port's PVID: 

1. Navigate to VLAN Management > VLAN Devices > Device Name. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click VLAN Devices under VLAN Management on the left navigation tree. 

The VLAN Device List is displayed. 

2. Click the VLAN Configuration link associated with the device for which you want to view 
access ports. 

3. Click the Access Port tab. 

Details for all ports for the selected device display in the Access Port List. 
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4. Select the ports you want to modify. 

5. Click Modify PVID. The Modify PVID dialog box opens. 

6. Select the VLAN ID from the PVID list. Only VLANs that exist in IMC and have been added to 
the device can be displayed in the list. 

7. Click OK. 

8. Review the results of the change by clicking the Allowed Port List for the associated VLAN 
under the Device VLAN tab. 

Using the Trunk Port tab 
You can also view and configure trunk ports for a VLAN using the features available under the Trunk 
Port tab of the VLAN Devices page. 

Viewing trunk ports 

To view the trunk ports assigned to a VLAN: 

1. Navigate to VLAN Management > VLAN Devices > Device Name. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click VLAN Devices under VLAN Management on the left navigation tree. 

The VLAN Device List is displayed. 

2. Click the  VLAN Configuration link associated with the device for which you want to view 
virtual interfaces. 

3. Click the Trunk Port tab. 

Details for all ports for the selected device display in the Trunk Port List. 

Trunk port list 

 Port Status—Contains the current status for the associated port. 

 Port Name—Contains the port name. 

 PVID—Contains the default VLAN ID of this trunk port. 

 Allowed VLAN—Contains the list of VLANs permitted for this trunk port. 

 Modify—Contains a link  for modifying the associated trunk port. 

If the Trunk Port List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Trunk Port List. 

 Click  to page forward to the end of the Trunk Port List. 

 Click  to page backward in the Trunk Port List. 

 Click  to page backward to the front of the Trunk Port List. 

4. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items 
per page you want to view. 

5. For Port Trunk Lists that have more than one page, click 1, 2, 3, 4, 5, 6, 7, 8, 9, 10… at the 
bottom right side of the main pane to jump to a particular page of the list. 

You can sort the Port Trunk List by the Port Status, Port Name, PVID, and Allowed VLAN 
fields by clicking the column label to sort the list by the selected field. The column label is a 
toggle switch that allows you to toggle between the various sort options specific to each field. 
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Adding a trunk port 

To add a trunk port to a VLAN: 

1. Navigate to VLAN Management > VLAN Devices > Device Name. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click VLAN Devices under VLAN Management on the left navigation tree. 

The VLAN Device List is displayed. 

2. Click the VLAN Configuration link associated with the device for which you want to view 
trunk ports. 

3. Click the Trunk Port tab. 

Details for all ports for the selected device display in the Trunk Port List. 

4. Click Add. 

5. Select the port to be used for the trunk port from the Port Name list. 

6. Enter the port VLAN ID for the trunk port in the PVID field. 

7. Enter the permitted VLAN IDs for the trunk port in the Allowed VLAN field. 

8. Click OK. 

9. View the results of this task in the Trunk Port List. 

Modifying a trunk port 

To modify an existing trunk port: 

1. Navigate to VLAN Management > VLAN Devices > Device Name. 

a. Click the Service tab from the top tabular navigation system. 

b. Click the VLAN Management on the left navigation tree. 

c. Click VLAN Devices under VLAN Management on the left navigation tree. 

The VLAN Device List is displayed. 

2. Click the  VLAN Configuration link associated with the device for which you want to view 
trunk ports. 

3. Click the Trunk Port tab. 

Details for all ports for the selected device display in the Trunk Port List. 

4. Click the Modify icon  associated with the trunk port you want to modify. 

5. Select the port to be used for the trunk port from the Port Name list. 

6. Modify the port VLAN ID for the trunk port in the PVID field. 

7. Modify the permitted VLAN IDs for the trunk port in the Allowed VLAN field. 

8. Click OK. 

9. View the results of this task in the Trunk Port list. 

Deleting a trunk port 

To delete an existing trunk port: 

1. Navigate to VLAN Management > VLAN Devices. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click VLAN Devices under VLAN Management on the left navigation tree. 

The VLAN Device List is displayed. 

2. Click the  VLAN Configuration link associated with the device for which you want to view 
trunk ports. 
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3. Click the Trunk Port tab. 

Details for all ports for the selected device display in the Trunk Port List. 

4. Select the trunk ports that you want to delete. 

5. Click Delete. 

6. Click OK to confirm the deletion of the selected trunk ports. 

Using the Hybrid Port tab 
You can also view and configure hybrid ports for a VLAN using the features available under the 
Hybrid Port tab of the VLAN Devices page.  

Viewing hybrid ports 

To view the hybrid ports assigned to a VLAN: 

1. Navigate to VLAN Management > VLAN Devices. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click VLAN Devices under VLAN Management on the left navigation tree. 

The VLAN Device List is displayed. 

2. Click the  VLAN Configuration link associated with the device for which you want to view 
hybrid ports. 

3. Click the Hybrid Port tab. 

Details for all ports for the selected device display in the Hybrid Port List. 

Hybrid port list 

 Port Status—Contains the current status for the associated port. 

 Port Name—Contains the port name. 

 PVID—Contains the port VLAN ID of the VLAN. 

 Tagged VLAN—Contains the list of tagged VLANs for this port. 

 Untagged VLAN—Contains the list of untagged VLANs for this port. 

 Modify—Contains a link  for modifying the associated hybrid port. 

If the Hybrid Port List spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Hybrid Port List. 

 Click  to page forward to the end of the Hybrid Port List. 

 Click  to page backward in the Hybrid Port List. 

 Click  to page backward to the front of the Hybrid Port List. 

4. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items 
per page you want to view. 

5. For Hybrid Port Lists that have more than one page, click 1, 2, 3, 4, 5, 6, 7, 8, 9, 10… at the 
bottom right side of the main pane to jump to a particular page of the list. 

You can sort the Hybrid Port List by the Port Status, Port Name, PVID, Tagged VLAN, and 
Untagged VLAN fields by clicking the column label to sort the list by the selected field. The 
column label is a toggle switch that allows you to toggle between the various sort options 
specific to each field. 
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Adding a hybrid port 

To add a hybrid port to a VLAN: 

1. Navigate to VLAN Management > VLAN Devices. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click VLAN Devices under VLAN Management on the left navigation tree. 

The VLAN Device List is displayed. 

2. Click the VLAN Configuration link associated with the device for which you want to view 
hybrid ports. 

3. Click the Hybrid Port tab. 

Details for all ports for the selected device display in the Hybrid Port List. 

4. Click Add. 

5. Select the port to be used for the hybrid port from the Port Name list. 

6. Enter the port VLAN ID for the hybrid port in the PVID field. 

7. Enter the all of the VLAN IDs to be tagged in the Tagged VLAN field. 

A valid VLAN ID is 1 – 4096. 

8. Enter the all of the VLAN IDs to be untagged in the Untagged VLAN field. 

A valid VLAN ID is 1 – 4096. 

9. Click OK. 

10. View the results of this task in the Hybrid Port list. 

Modifying a hybrid port 

To modify an existing hybrid port: 

1. Navigate to VLAN Management > VLAN Devices. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click VLAN Devices under VLAN Management on the left navigation tree. 

The VLAN Device List is displayed. 

2. Click the VLAN Configuration icon  associated with the device for which you want to view 
hybrid ports. 

3. Click the Hybrid Port tab. 

Details for all ports for the selected device display in the Hybrid Port List. 

4. Click the Modify icon  associated with the hybrid port you want to modify. 

5. Select the port to be used for the hybrid port from the Port Name list. 

6. Modify the port VLAN ID for the hybrid port in the PVID field. 

7. Modify the VLAN IDs to be tagged in the Tagged VLAN field. 

8. Modify the VLAN IDs to be untagged in the Untagged VLAN field.  

9. Click OK. 

10. View the results of this task in the Hybrid Port list. 

Deleting a hybrid port 

To delete one or more hybrid ports: 

1. Navigate to VLAN Management > VLAN Devices. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 
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c. Click VLAN Devices under VLAN Management on the left navigation tree. 

The VLAN Device List is displayed. 

2. Click the VLAN Configuration icon  associated with the device for which you want to view 
hybrid ports. 

3. Click the Hybrid Port tab. 

Details for all ports for the selected device display in the Hybrid Port List. 

4. Select the hybrid ports that you want to delete. 

5. Click Delete. 

6. Click OK to confirm the deletion of the selected hybrid ports. 

VLAN deployment task 
You can search deployment task by date, to view the results of VLAN deployment task and to view 
details for individual VLAN deployment task.  

Viewing deployment task 
To view all deployment task entries for VLANs: 

1. Navigate to VLAN Management > VLAN Deployment Task. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click VLAN Deployment Task under VLAN Management on the left navigation tree. 

The VLAN Deployment Task page opens. 

VLAN report 

 Operation—Contains a summary of the VLAN management task being reported. 

 Result—Contains the result of the operation. 

 Time—Contains a date and timestamp for the task. 

 Details—Contains a link for viewing details for the associated operation or task. 

2. To view the details for a VLAN report entry, click the Details icon  associated with the report 
entry you want to view.  

This report provides you with the name of the device, the IP address, the configuration task, and 
the results of the configuration task. 

 Click  to page forward in the VLAN Deployment Task. 

 Click  to page forward to the end of the VLAN Deployment Task. 

 Click  to page backward in the VLAN Deployment Task. 

 Click  to page backward to the front of the VLAN Deployment Task. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items 
per page you want to view. 

4. For VLAN Deployment Task that have more than one page, click 1, 2, 3, 4, 5, 6, 7, 8, 9, 10… 
at the bottom right side of the main pane to jump to a particular page of the list. 

You can sort the VLAN Deployment Task list by the Operation, Result, and Time fields by 
clicking the column label to sort the list by the selected field. The column label is a toggle switch 
that allows you to toggle between the various sort options specific to each field. 
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Searching the VLAN deployment task 
To search the VLAN report: 

1. Navigate to VLAN Management > VLAN Deployment Task. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click VLAN Deployment Task under VLAN Management on the left navigation tree. 

The VLAN Deployment Task page opens. 

2. Enter a task name in the field in the upper right corner of the VLAN Deployment Task page, 

and click the Search icon , or click the Advanced icon  located in the upper right corner 
of the page. 

The search criteria dialog box opens. 

3. Enter the start date for your search in the Started at field.  

To use the calendar to auto populate this field: 

a. Click the field next to the Started at field. 

b. Select the start date from the displayed calendar.  

If you do not specify the hour, minutes, and seconds for your search, IMC auto populates 
this value using the current time, possibly limiting your search results. 

c. Enter the end date for your search in the Ended at field. 

To auto populate this field, see steps 3a – 3c, above. 

4. Select the result of the operation from the Result list. 

5. Click Query to begin your search. 

6. Click Reset when you have completed your search to return to the full VLAN report. 

Deleting VLAN deployment task entries 
To delete one or more VLAN report entries: 

1. Navigate to VLAN Management > VLAN Deployment Task. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click VLAN Deployment Task under VLAN Management on the left navigation tree. 

The VLAN Deployment Task page opens. 

2. Select the entry or entries you want to delete. 

3. Click Delete. 

4. Click OK to confirm the deletion of the selected VLAN report entries. 

5. Click Add Task, select Deploy Access Ports, Deploy Trunk Ports, Deploy Hybrid Ports, 
Deploy VLANs to enter the batch deployment window for each port. 

For more information, see "Deploying VLANs using batch mode." 

VLAN topology maps 
IMC provides you with a graphical view of devices in a VLAN. The VLAN Topo option launches IMC 
Custom View, which includes a VLAN view. When you select an individual VLAN, the My Network 
View map updates to gray out all devices that are not part of the selected VLAN. All devices in the 
VLAN view for the selected VLAN remain active. 
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Viewing VLAN topology maps 
To view VLAN topo maps: 

1. Navigate to VLAN Management > My Network View. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click VLAN Topology under VLAN Management on the left navigation tree. 

A window opens and displays all the custom topologies and IP topologies in the list. 

Custom Topology and IP Topology list 

 Status—Contains the latest status of the group. Status is determined by the highest 
severity or alarm level for a device in the group, when the device has one or more 
current alarms that have not been cleared or recovered. Group icons with the color gray 
indicate that there are no managed devices in the view. 

 Topology Name—Name of the topology. For Custom Topology, this column is 
displayed as My Network View or the name of a custom view. For IP Topology, this 
column is displayed as IP View or the name of an IP subnet. 

 Topology Type—Type of the topology. Options are IP Topology and Custom 
Topology. 

2. Click the topology you want to view in the list. 

3. Click OK. 

The VLAN Topology page opens. A VLAN View table displays next to VLAN topology that lists 
all VLANs, including the VLAN name and VLAN ID. 

4. Do one of the following: 

 When the VLAN ID and VLAN Name Identification Mode option is not selected, a VLAN 
ID uniquely identifies a global VLAN, so the global VLAN list for a VLAN ID displays only one 
VLAN. 

 When the VLAN ID and VLAN Name Identification Mode box is selected, the global 
VLAN list displays multiple VLANs with the same VLAN ID but different VLAN names. 

5. To view the devices for a specific VLAN, click the VLAN entry in the VLAN View table. 

Devices that are not part of the VLAN are grayed out. Devices that are part of the VLAN display 
color values associated with their most current alarm status. 

6. To add a device to a VLAN through VLAN Topo: 

a. Click the VLAN entry in the VLAN View table. 

b. Select Add to current VLAN from the right-click menu.  

The Add to current VLAN dialog box opens. 

c. If you select the Add VLAN to all Trunk and Hybrid ports, and click OK to add the VLAN 
to all the trunk and hybrid ports of the device. The VLAN added to the hybrid port must be 
tagged by default. Otherwise, you can only add the VLAN to all the access ports of the 
device. 

d. Click OK. 

Confirm the device display color values associated with their most current alarm status. 

7. To delete the device from a VLAN: 

a. Click the VLAN entry in the VLAN View table. 

b. Select Remove from the current VLAN from the right-click menu of the device. 

The device is deleted from the VLAN and becomes unavailable. 

8. To add link interfaces to a VLAN: 
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a. Right-click the link between two devices, and select Add to Current VLAN from the 
shortcut menu.  

b. On the window that opens, enter a VLAN ID to assign the two interfaces of the link to the 
VLAN.  

c. Select Apply the VLAN configuration to the device to deploy the VLAN configuration to 
the devices at two ends of the link. If you do not select this option, you must manually select 
devices and add the VLAN. 

9. To remove link interfaces from a VLAN: 

a. Right-click the link between two devices, and select Remove from Current VLAN from the 
shortcut menu.  

b. On the window that opens, enter a VLAN ID to remove the two interfaces of the link from the 
VLAN.  

c. Select Remove the VLAN from the device (This operation might affect ongoing 
services) to remove the VLAN from the devices at two ends of the link. If you do not select 
this option, you must manually select devices and delete the VLAN. 

10. To deploy a VLAN to devices: 

a. Enter the default view or click a VLAN entry in the VLAN View table. 

b. Select two devices and right-click to select Deploy VLAN to Devices from the shortcut 
menu. 

c. Enter a VLAN ID and a VLAN name in the dialog box that opens. 

If you entered the VLAN view of a VLAN in step a, the VLAN ID and VLAN Name fields are 
auto-populated. 

d. In the device list, select the devices that you want to deploy the VLAN. 

The device list displays all devices in the links between the two devices that you selected. 

e. Click Next. 

For more information about deploying a VLAN to devices, see "Using batch deployment for 
VLAN creation." 

For more information about viewing the deployment result, see "VLAN deployment task." 

11. To deploy a VLAN to links: 

a. Enter the default view or click a VLAN entry in the VLAN View table. 

b. Select two devices and right-click to select Deploy VLAN to Links from the shortcut menu. 

c. Enter a VLAN ID in the dialog box that opens. 

If you have entered the VLAN view of a VLAN in step a, the VLAN ID field is auto-populated 
with the VLAN ID of the VLAN. 

d. Click OK to deploy the VLAN to all ports in the links between the two devices that you 
selected. The deployment result is displayed at the bottom of the page. 

12. To delete a VLAN from links: 

a. Enter the default view or click a VLAN entry in the VLAN View table. 

b. Select two devices and right-click to select Remove VLAN from Links from the shortcut 
menu. 

c. Enter a VLAN ID in the dialog box that opens. 

If you have entered the VLAN view of a VLAN in step a, the VLAN ID field is auto-populated 
with the VLAN ID of the VLAN. 

d. Click OK to remove the VLAN from all ports in the links between the two devices that you 
selected.  

The operation result is displayed at the bottom of the page. 

13. To search for a particular VLAN in the VLAN View table, enter the VLAN ID in the Query field 
and click Query or press Enter to execute the search. 
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IMC supports fuzzy matching for this field, allowing you to enter a complete or partial VLAN ID. 
IMC displays all VLAN IDs that match the search criteria. 

14. VLAN device monitoring and management features are available on IMC topology maps are 
accessed through left and right mouse clicks.  

For more information about the monitoring and management features of topology maps, see 
"Viewing devices through the network topology." 

Deploying VLANs using batch mode 
Using the Batch Deploy option, you can configure access ports, trunk ports, hybrid ports, or create 
VLANs for one or more devices. 

Using batch deployment for VLAN creation 
You can configure a VLAN on one or more devices using the Batch Deploy option for VLANs. 

To use batch deployment to create a VLAN: 

1. Navigate to VLAN Management > Batch Deploy. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click Batch Deploy under VLAN Management on the left navigation tree. 

The Batch Deploy page opens. 

2. Click the VLAN option. 

The window for batch deploying new VLANs opens. 

3. Enter the VLAN ID for the VLAN you want to add access ports to in the VLAN ID field. 

4. Enter the name for the VLAN in the VLAN Name field. 

Question marks (?) and non-ASCII characters are not permitted in VLAN names. 

5. Click Add to select the devices to which you want to add the VLAN you specified in step 2. 

To delete selected devices, select the Device Status for the devices and click Delete. 

To deploy the VLAN to ports of a device, click the link in the Port Operation for the device in the 
device list and select the ports. To configure the VLAN virtual interface for a device, click Set 
Virtual Interface for a device in the device list. If the VLAN virtual interface you configure 
already exists, the new virtual interface will take effect. 

6. Click OK. 

7. Review the results of your batch deploy configuration task in the Deploying VLAN Summary 
Report that display upon completion. 

Using batch deployment for access ports 
Using batch deployment for access ports, you can configure one or more access ports for an existing 
VLAN. 

To use batch deployment to configure access ports for an existing VLAN: 

1. Navigate to VLAN Management > Batch Deploy. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click Batch Deploy under VLAN Management on the left navigation tree. 

The Batch Deploy page opens. 

2. Click the Access ports option.  
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The window for batch deploying access ports opens. 

3. Enter the port VLAN ID for the VLAN you want to add access ports to in the PVID field. 

The PVID you enter in this field must already exist on all of the access devices that you want to 
add access ports from. To add the PVID to one or more access devices, use the VLAN Batch 
Deploy option. For more information about the VLAN Batch Deploy option, see "Using batch 
deployment for VLAN creation." 

4. Click Add to select the interfaces from which you want to add access ports to the PVID you 
specified in step 2. 

5. Add interfaces by View or by the Advanced query method.  

6. Click OK. 

7. Review the results of your batch deploy configuration task in the Deploying Access Ports 
Summary Report that displays upon completion. 

Using batch deployment for trunk ports 
Using batch deployment for trunk ports, you can configure one or more trunk ports for an existing 
VLAN. 

To use batch deployment to configure trunk ports for an existing VLAN: 

1. Navigate to VLAN Management > Batch Deploy. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click Batch Deploy under VLAN Management on the left navigation tree. 

The Batch Deploy page opens. 

2. Click the Trunk ports option.  

The window for batch deploying trunk ports opens. 

3. Enter the port VLAN ID in the PVID field. 

The PVID you enter in this field must already exist on all trunk devices from which you want to 
add trunk ports. 

4. Enter the existing allowed VLAN ID in the Allowed VLAN field. 

5. Click Add to select the interfaces from which you want to add trunk ports to the PVID you 
specified in step 2. 

6. Add interfaces by View or by the Advanced query method.  

7. Click OK. 

8. Review the results of your batch deploy configuration task in the Deploying Trunk Ports 
Summary Report that displays upon completion. 

Using batch deployment for hybrid ports 
Using batch deployment for hybrid ports, you can configure one or more hybrid ports for an existing 
VLAN. 

To use batch deployment to configure hybrid ports for an existing VLAN: 

1. Navigate to VLAN Management > Batch Deploy. 

a. Click the Service tab from the top tabular navigation system. 

b. Click VLAN Management on the left navigation tree. 

c. Click Batch Deploy under VLAN Management on the left navigation tree. 

The Batch Deploy page opens. 

2. Click the Hybrid ports option.  
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The window for batch deploying hybrid ports opens. 

3. Enter the port VLAN ID for the VLAN you want to add hybrid ports to in the PVID field. 

4. Enter the VLAN ID for the tagged VLAN in the Tagged VLAN field. 

If you do not enter any value, all tagged VLAN IDs on the selected interfaces are cleared. 

5. Enter the VLAN ID for the untagged VLAN in the Untagged VLAN field. 

If you do not enter any value, all untagged VLAN IDs on the selected interfaces are cleared. 

The PVID as well as the Tagged, Untagged VLANs you enter in these fields must already exist 
on all of the devices from which you want to add hybrid ports. 

6. Click Add to select the interfaces from which you want to add hybrid ports to the PVID you 
specified in step 2. 

7. Add interfaces by View or by the Advanced query method. 

8. Click OK. 

9. Review the results of your batch deploy configuration task in the Deploying Hybrid Ports 
Summary Report that displays upon completion.
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VXLAN management 
Virtual eXtensible LAN (VXLAN) is a MAC-in-UDP technology that provides Layer 2 connectivity 
between distant network sites across an IP network. 

The IMC VXLAN module provides the following features: 

 Device management on a device type basis. For VXLAN tunnel endpoints (VTEP), you can also 
manage local and remote MAC addresses. 

 VXLAN, virtual switch instance (VSI), VXLAN tunnel, and attachment circuit (AC) management. 
An Ethernet service instance or Layer 3 interface is called an AC. 

Device management 
Use device management to manage physical devices in VXLAN networks. The devices include 
VTEPs, common devices responsible only for packet forwarding, and servers on which VMs are 
created.  

Managing network devices 

Viewing the network device list 

1. Click the Service tab. 

2. From the navigation tree, select VXLAN Management > Devices. 

The Network Devices page opens. The page includes the Network Devices and Servers tabs, 
of which the Network Devices tab is displayed by default. 

Network device list contents 

 Status—Contains the status of the device. The status is determined by the highest severity 
or alarm level for the device if it has one or more current alarms that have not been cleared 
or recovered. 

 Device Name—Contains the name for the device in IMC. Click the link to view device 
details and configure the device. For more information, see "Viewing network device 
details." 

 IP Address—Contains the management IP address of the device. The system adds the 
device to IMC based on the IP address. 

 Model—Contains the device type. Device types include VTEP and Common Device. 

 Last Sync—Most recent time when IMC synchronized the device information. 

 Sync Status—Result of the most recent device synchronization. 

 Operation—Contains an icon that displays links to operational tasks for the VTEP device. 

You can sort the device list by clicking a column label. The column label is a toggle switch that 
allows you to toggle between the various sort options specific to each field. 

If the network devices list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the list. 

 Click  to page forward to the end of the list. 

 Click  to page backward in the list. 

 Click  to page backward to the front of the list. 
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 Click 8, 15, 50, 100, or 200 at the bottom of the list to configure the number of items per 
page to display. 

Querying network devices 

You can query network devices by device name, IP address, status, and device type. 

To query network devices: 

1. Access the Network Devices page. 

2. To perform a basic query, enter a device name in the field in the upper right corner of the page, 

and then click the Search icon . 

3. To perform an advanced query, do the following: 

a. Click the Advanced icon  in the upper right corner of the page. 

b. Specify one or more of the following query criteria: 

 Device Name—Enter a partial or complete device name in the Device Name field. 

 IP Address—Enter a partial or complete IP address in the IP Address field. 

 Status—Select the status of devices by which you want to query or filter the list. You can 
also select All, which queries all devices. 

 Device Type—Select the type of devices by which you want to search or filter the list. 
Options include VTEP, Common Device, and All. 

c. Click Query. 

The network device list displays network devices that match the specified query criteria. 

Click Reset to restore the full network device list. 

Importing network devices 

Perform this task to import network devices from the IMC platform to the VXLAN module. For more 
information about adding devices to the IMC platform, see "Adding devices in IMC." 

The VXLAN module identifies an imported network device as a VTEP or common device. The 
system can obtain VXLAN configuration from VTEPs, and then deploy the VXLAN configuration. For 
the VXLAN module to correctly identify network devices as VTEPs, make sure the NETCONF 
parameters configured in IMC are consistent with the NETCONF parameters on the network 
devices. For more information about configuring NETCONF parameters, see "Managing one device 
through device details." 

To import network devices to the VXLAN module: 

1. Access the Network Devices page. 

2. Click Import. 

The Import page opens. 

3. Click Select Device, select devices to import, and then click OK. 

The Import page displays the selected devices. For more information about selecting devices, 
see "Adding devices by view" and "Adding devices by advanced query." 

4. Click OK. 

The import execution result page opens after some time. 

Configure global settings for network devices 

Perform this task to configure global VXLAN settings for VTEPs. To correctly deploy global settings 
to network devices, make sure the NETCONF parameters configured in IMC are consistent with the 
NETCONF parameters on the network devices. 

To configure global settings for network devices: 

1. Access the Network Devices page. 

2. Access the Device Global Settings page by using one of the following methods: 
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 To configure global settings for multiple network devices, select one or more VTEPs in the 
network device list, and then click Global Settings. 

 To configure global settings for a single device, click the Operation icon  for the device, 
and then select Global Settings from the shortcut menu. 

3. To keep records on changes to the local MAC addresses, select Yes for the Enabling 
Local-MAC change logging field. 

4. To enable remote MAC address learning, select Yes for the Enabling Remote-MAC address 
learning field. 

5. Click OK. 

Batch deploying VXLANs 

Perform this operation to create a VXLAN on multiple devices.  

To batch deploy VXLANs: 

1. Click the Service tab. 

2. From the navigation tree, select VXLAN Management > Devices. The Network Devices page 
opens. 

3. Select one or more devices, and click Add VXLAN. The Add VXLAN and VSI page opens.  

4. In the Configure VXLAN and VSI area, perform the following: 

a. Enter a VSI name in the VSI Name field. 

The VSI name must be unique on the selected device. 

b. Enter a VXLAN ID in the VXLAN ID field. 

The VXLAN ID must be an integer in the range of 0 to 16777215. 

c. Enter a description in the VXLAN Description field. 

d. Select Enabled or Disabled from the ARP Flood Suppression list. 

e. Select a flood message type to be suppressed from the VSI Flood Suppression list. 

f. Select EVPN or Tunnel from the VSI Mode list. 

g. If you selected Tunnel from the VSI Mode list, select one or more VXLAN tunnels to assign 
the VXLAN from the Tunnel Interface. 

Options are names of existing VXLAN tunnels on the Tunnels page. You can assign one 
VXLAN to multiple VXLAN tunnels. 

5. In the Configure MACs for Selective Flood area, enter a MAC address whose sent 
messages can be flooded, and then click Add to add the MAC address to the MACs for 
Selective Flood list. 

Repeat this step to add more MAC addresses to the list.  

To delete a MAC address from the list, select the MAC address, and then click Delete. 

6. Click Add. 

Viewing network device details 

1. Access the Network Devices page. 

2. Click a network device name. 

The details page for the network device opens. 

For a VTEP, you can also view and configure the global settings, VXLANs, tunnels, remote MAC 
addresses, and VSI interfaces for that VTEP on the Device Details page. 

To configure the global settings, click the Global Settings tab. For more information, see "Configure 
global settings for network ." 

To configure the VXLANs, click the VXLAN tab. For more information, see "Adding a VXLAN." 

To configure the tunnels, click the Tunnel tab. For more information, see "Adding a VXLAN tunnel." 
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To configure the remote MAC addresses: 

1. Click the VM MAC tab. 

2. Click Add. 

3. The Add Remote MAC page opens. 

4. Enter a MAC address in the Remote MAC Address field. 

5. Select a tunnel interface for the remote MAC address. 

6. Select a VSI (VXLAN) to which the remote MAC address belongs from the VSI Name field. 

7. Click Add. 

To configure VSI interfaces: 

1. Click the VSI Interface tab. 

2. Click Add. 

3. The Add VSI Interface page opens. 

4. Select a VXLAN IP gateway type from the Gateway Type list. 

Options are Centralized and Distributed. 

5. Enter a VSI interface ID in the Interface ID field. 

6. Select a VSI to use the VSI interface as the VXLAN IP gateway from the VSI Name list. 

7. Enter an IP address for the VSI interface in the IP Address field. 

8. Enter an IP address mask for the VSI interface in the Mask field. 

9. To enable local proxy ARP, select yes or no from the Enable Local Interface list. 

The Enable Local Interface field is displayed only when Distributed is selected from the 
Gateway Type field. 

10. In the VSI Subnet area, enter a subnet IP address and a subnet mask in the Subnet IP 
Address and Subnet Mask fields, and then click Add to add a subnet. 

The new subnet is displayed in a list. Repeat this step to add more subnets to the list. To delete 
subnets from the list, select the subnets and click Delete. 

The VSI Subnet area is displayed only when Distributed is selected from the Gateway Type 
field. 

11. Enter a MAC address in the Remote MAC Address field. 

12. Select a tunnel interface for the remote MAC address. 

13. Select a VSI (VXLAN) to which the remote MAC address belongs from the VSI Name field. 

14. Click Add.  

To configure a VPN: 

1. Click the VPN tab. 

2. Click Add. The VPN Instance page opens. 

a. Enter a VPN name in the VPN Name field. 

The VPN name must be unique on the device. 

b. Enter a route distinguisher in the RD field. 

The route distinguisher must be unique on the device. 

c. Enter a description in the VXLAN Description field. 

d. Select an address family in the Address Family field. 

e. Enter an address family route import in the Address Family RT Import field. 

f. Enter an address family route export in the Address Family RT Export field. 

g. Click the Add button to the right of the Address Family list to add address family 
configuration. You can add multiple address families.  

3. Click Add. 
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To configure a BGP instance: 

1. Click the BGP Instance tab. 

2. Click Add. The Add BGP Instance page opens. 

3. Enter an AS ID in the AS ID field. 

4. Click Add. 

To configure BGP peers: 

1. Click the BGP Peer tab. 

2. Click Add. The Add BGP Peer page opens. 

a. Select an AS ID in the AS ID field. 

b. Enter a peer IP address in the Peer IP Address field. 

c. Click Select Interface to select the BGP connection source interface. 

d. Select whether to enable client reflector. 

3. Click OK. 

To configure BGP peer groups: 

1. Click the BGP Peer Group tab. 

2. Click Add. The Add BGP Peer Group page opens. 

a. Select an AS ID in the AS ID field. 

b. Enter a peer group name in the Peer Group Name field. 

c. Enter a peer IP address in the Peer IP Address field. Click the Add button to the right to 
add the peer IP address to the list. You can add multiple IP addresses.  

d. Click Select Interface to select the BGP connection source interface. 

e. Select whether to enable client reflector. 

3. Click OK. 

To bind a BGP instance to a VPN instance: 

1. Click the BGP-VPN tab. 

2. Click Add. The BGP-VPN Instance page opens. 

a. Select a BGP instance name in the BGP Instance Name field. 

b. Select a VPN instance in the VPN Instance field. 

3. Click OK. 

Deleting network devices 

Deleting network devices from the VXLAN module does not delete the network devices from the IMC 
platform. 

1. Access the Network Devices page. 

2. Select one or more network devices. 

3. Click Delete. 

A confirmation dialog box opens. 

4. Click OK. 

Managing servers 

Viewing the server list 

1. Click the Service tab. 

2. From the navigation tree, select VXLAN Management > Devices. 

The Network Devices page opens. 
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3. Click the Servers tab. 

The Servers page opens. 

Server list contents 

 Status—Contains the status of the server. The status is determined by the highest severity 
or alarm level for the server if it has one or more current alarms that have not been cleared 
or recovered. 

 Device Name—Contains the name of the server. 

 IP Address—Contains the management IP address of the server. The system adds the 
server to IMC based on the IP address. 

4. You can sort the server list by a column by clicking the column label. Click the column label to 
sort the list by the selected field. The column label is a toggle switch that allows you to toggle 
between the various sort options specific to each field. 

If the server list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the list. 

 Click  to page forward to the end of the list. 

 Click  to page backward in the list. 

 Click  to page backward to the front of the list. 

 Click 8, 15, 50, 100, or 200 at the bottom of the list to configure the number of items per 
page to display. 

Querying servers 

1. Access the Servers page. 

2. To perform a basic query, enter a server name in the field in the upper right corner of the page, 

and then click the Search icon . 

3. To perform an advanced query, do the following: 

a. Click the Advanced icon  in the upper right corner of the page. 

b.  Specify one or more of the following query criteria: 

 Device Name—Enter a partial or complete device name in the Device Name field. 

 IP Address—Enter a partial or complete IP address in the IP Address field. 

 Status—Select the status of devices for which you want to query or filter the list. You 
can also select All, which queries all devices. 

c. Click Query. 

The server list displays servers that match the specified query criteria. 

Click Reset to restore the full server list. 

Importing servers 

Perform this task to import servers from the IMC platform to the VXLAN module. For more 
information about adding devices to the IMC platform, see "Adding devices in IMC." 

To import servers to the VXLAN module: 

1. Access the Servers page. 

2. Click Import. 

The Import page opens. 

3. Click Select Device, select devices to import, and then click OK. 
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The Import page displays the selected devices. For more information about selecting devices, 
see "Adding devices by view" and "Adding devices by advanced query." 

4. Click OK. 

Deleting servers 

Deleting servers from the VXLAN module does not delete the servers from the IMC platform. 

To delete servers from the VXLAN module: 

1. Access the Servers page. 

2. Select one or more servers. 

3. Click Delete. 

A confirmation dialog box opens. 

4. Click OK. 

Managing VXLANs 
Use the VXLAN management function to manage existing VXLANs that are configured on network 
devices and to add new VXLANs and VSIs. 

Viewing the VXLAN dashboard 
1. Click the Service tab. 

2. From the navigation tree, select VXLAN Management > DashBoard. 

The VXLAN dashboard contains the following widgets: 

 Top 5 Loaded VXLAN Tunnels—Displays the Top 5 VXLAN tunnels with the highest load.. 

 VXLAN Topology (VXLAN)—Displays the VXLAN topology. 

 VXLAN Traffic Statistics—Displays VXLAN traffic statistics for VXLANs. You can click 
Select VXLAN to select VXLANs for which to display traffic statistics. 

 Global Network Topology—Displays the topology structure of the whole network. 

Viewing the VXLAN list 
1. Click the Service tab. 

2. From the navigation tree, select VXLAN Management > VXLANs. 

VXLAN list contents 

 VXLAN ID—Uniquely identifies a VLAN network. 

 Device Label—Device label of the device to which the VLAN belongs. 

 VSI Name—Name of the VSI that provides Layer 2 switching services for the VXLAN. Each 
VSI provides switching services for only one VXLAN. 

 VXLAN Description—Description of the VXLAN. 

 Tunnel Interface—Tunnel Interface that is associated with the VXLAN. 

 ARP Flood Suppression—Whether ARP flood suppression is enabled. 

 Monitor Status—Whether the VXLAN is monitored. 

 Operation—Contains an icon that displays links to operational tasks for the VXLAN. 

You can sort the VXLAN list by a column by clicking the VXLAN ID or VSI Name label. Click the 
column label to sort the list by the selected field. The column label is a toggle switch that allows 
you to toggle between the various sort options specific to each field. 

If the network devices list spans multiple pages, use the following aids to navigate the list: 
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 Click  to page forward in the list. 

 Click  to page forward to the end of the list. 

 Click  to page backward in the list. 

 Click  to page backward to the front of the list. 

 Click 8, 15, 50, 100, or 200 at the bottom of the list to configure the number of items per 
page to display. 

Querying VXLANs 
1. Access the VXLANs page. 

2. To perform a basic query, enter a VXLAN name in the field in the upper right corner of the page, 

and then click the Search icon . 

3. To perform an advanced query, do the following: 

a. Click the Advanced icon  in the upper right corner of the page. 

b. Specify one or more of the following query criteria: 

 VXLAN ID—Enter a partial or complete VXLAN ID in the VXLAN ID field. 

 VSI Name—Enter a partial or complete VSI name in the VSI Name field. 

c. Click Query. 

The VXLAN list displays VXLANs that match the specified query criteria. 

Click Reset to restore the full VXLAN list. 

Adding a VXLAN 
Perform this task to add a VXLAN on a VTEP device. Configure the VSI, VXLAN tunnel, service 
instance, and match criterion in the VXLAN configuration. 

When a local VTEP receives a frame, it processes the frame as follows: 

1. Identifies the VSI to which the frame belongs based on the match criterion specified in the 
service instance. 

2. Assigns the frame to a VXLAN by mapping the VSI to the VXLAN. 

3. Sends the frame to the remote VTEP through the specified tunnel interface. 

To add a VXLAN: 

1. Access the VXLANs page. 

2. Click Add. 

The Add VXLAN and VSI page opens. 

3. In the Configure VXLAN and VSI area, perform the following: 

a. Click Select Device next to the Device Label field and select a device on which the VXLAN 
is to be added.  

For more information about selecting devices, see "Adding devices by view" and "Adding 
devices by advanced query." 

b. Enter a VSI name in the VSI Name field. 

The VSI name must be unique on the selected device. 

c. Enter a VXLAN ID in the VXLAN ID field. 
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The VXLAN ID must be an integer in the range of 0 to 16777215. 

d. Enter a description in the VXLAN Description field. 

e. Select Enabled or Disabled from the ARP Flood Suppression list. 

f. Select a flood message type to be suppressed from the VSI Flood Suppression list. 

g. Select EVPN or Tunnel from the VSI Mode list. 

h. If you selected Tunnel from the VSI Mode list, select one or more VXLAN tunnels to assign 
the VXLAN from the Tunnel Interface. 

Options are names of existing VXLAN tunnels on the Tunnels page. You can assign one 
VXLAN to multiple VXLAN tunnels. 

4. In the Configure MACs for Selective Flood area, enter a MAC address whose sent 
messages can be flooded, and then click Add to add the MAC address to the MACs for 
Selective Flood list. 

Repeat this step to add more MAC addresses to the list.  

To delete a MAC address from the list, select the MAC address, and then click Delete. 

5. Click Add. 

Modifying a VXLAN 
1. Access the VXLANs page. 

2. Click the Operation icon  for a VXLAN, and then select the Modify icon  from the 
shortcut menu. 

The page for modifying the VXLAN opens. 

3. Configure VXLAN parameters except the device label, VSI name, and VXLAN ID. For more 
information about configuring VXLAN parameters, see "Adding a VXLAN." 

Deleting VXLANs 
Deleting VXLANs also deletes VSIs and service instances that are associated with the VXLANs. 

To delete a single VXLAN: 

1. Access the VXLANs page. 

2. Click the Operation icon  for a VXLAN, and then select the Delete icon  from the 
shortcut menu. 

A confirmation dialog box opens. 

3. Click OK. 

To delete VXLANs in batches: 

1. Access the VXLANs page. 

2. Select one or more VXLANs in the VXLAN list and click Delete. 

A confirmation dialog box opens. 

3. Click OK. 

Configure ACs 
1. Access the VXLANs page. 

2. Click the Operation icon  for a VXLAN, and then select Configure AC from the shortcut 
menu. 

The AC list displays service instances associated with the VXLAN. 
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3. To associate a new service instance with the VXLAN, do the following: 

a. Click Add. 

The Add Service Instance page opens. 

b. Click Select Interface next to the Port field and select an interface. 

The service instance matches frames received from the specified interface based on the 
match criterion contained in the service instance. 

c. Enter a service instance ID in the Service ID field. 

d. Select a match criterion from the Frame Match Criterion list. 

The matching rules vary by match criterion. For example, if you select VLAN, you must 
configure VLAN IDs. 

e. Click OK. 

4. To delete a service instance associated with the VXLAN, do the following: 

a. Click the Operation icon  for a service instance, and then select the Delete icon  
from the shortcut menu. 

A confirmation dialog box opens. 

b. Click OK. 

Managing VXLAN tunnels 
Use the VXLAN tunnel management function to manage VXLAN tunnels that are configured on 
network devices and to add new VXLAN tunnels. 

Viewing the VXLAN tunnel list 
1. Click the Service tab. 

2. From the navigation tree, select VXLAN Tunnel Management > Tunnels. 

VXLAN tunnel list contents 

 Tunnel Interface—Tunnel interface of the VXLAN tunnel. 

 Local Device—Device label of the local VTEP of the VXLAN tunnel. 

 Source IP address—Source IP address of the VXLAN tunnel. 

 Destination IP Address—Destination IP address of the VXLAN tunnel. 

 Completeness—Current completion status of the VXLAN tunnel. Options are Complete 
and Incomplete. 

 VXLANs—VXLANs that are associated with the VXLAN tunnel. 

 Operation—Contains an icon that displays links to operational tasks for the VXLAN tunnel. 

You can sort the VXLAN tunnel list by a column by clicking the column label. Click the column 
label to sort the list by the selected field. The column label is a toggle switch that allows you to 
toggle between the various sort options specific to each field. 

If the network devices list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the list. 

 Click  to page forward to the end of the list. 

 Click  to page backward in the list. 

 Click  to page backward to the front of the list. 
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 Click 8, 15, 50, 100, or 200 at the bottom of the list to configure the number of items per 
page to display. 

Querying VXLAN tunnels 
1. Access the Tunnels page. 

2. To perform a basic query, enter a VXLAN tunnel name in the field in the upper right corner of the 

page, and then click the Search icon . 

3. To perform an advanced query, do the following: 

a. Click the Advanced icon  in the upper right corner of the page. 

b.  Specify one or more of the following query criteria: 

 Local Device—Enter a partial or complete name of the local VTEP in the Local Device 
field. 

 Completeness—Select the status of tunnels for which you want to search or filter the 
list. Options include Complete, Incomplete, and All. 

c. Click Query. 

The VXLAN tunnel list displays VXLAN tunnels that match the specified query criteria. 

Click Reset to restore the full VXLAN tunnel list. 

Adding a VXLAN tunnel 
1. Access the Tunnels page. 

2. Click Add. 

The Add Tunnel page opens. 

3. Do the following: 

a. Enter a tunnel interface for the VXLAN tunnel in the Tunnel Interface field. 

b. Click Select Device next to the Device Label field and select a device on which the VXLAN 
tunnel is to be added. 

For more information about selecting devices, see "Adding devices by view" and "Adding 
devices by advanced query." 

c. Enter a source IP address for the VXLAN tunnel in the Source IP Address field. 

d. Enter a destination IP address for the VXLAN tunnel in the Destination IP Address field. 

As a best practice, do not configure multiple VXLAN tunnels to use the same source and 
destination IP addresses. 

4. Click Add. 

Modifying a VXLAN tunnel 
1. Access the Tunnels page. 

2. Click the Operation icon  for a VXLAN tunnel, and then select the Modify icon  from the 
shortcut menu. 

3. Configure VXLAN tunnel parameters except the tunnel interface and device label. For more 
information about configuring VXLAN tunnel parameters, see "Adding a VXLAN tunnel." 

Deleting VXLAN tunnels 
Deleting a VXLAN also removes it from the associated VXLAN tunnels. 
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To delete a single VXLAN tunnel: 

1. Access the Tunnels page. 

2. Click the Operation icon  for a VXLAN tunnel, and then select the Delete icon  from the 
shortcut menu. 

A confirmation dialog box opens. 

3. Click OK. 

To delete VXLAN tunnels in batches: 

1. Access the Tunnels page. 

2. Select one or more VXLAN tunnels in the VXLAN tunnel list and click Delete. 

A confirmation dialog box opens. 

3. Click OK. 
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User and guest access management 
As intelligent network management software that supports the FCAPS model, IMC manages not only 
the devices that join IMC, but also users who access the enterprise network through those devices. 
IMC provides user authentication function to prevent unauthorized network access. Moreover, IMC 
can control users to access only necessary network resources. To manage users through IMC, first 
add user information to IMC. The first part of this chapter describes how to add user information to 
IMC. 

In addition to the internal users, an enterprise or organization usually has temporary, external users. 
These users are called "guests." Compared with the internal users, guest users access the network 
for a short time, and are assigned restricted network access privileges. To meet these requirements, 
IMC provides the guest management functions, which allow network administrators to control guest 
permissions and their network behaviors. The second part of this chapter describes how to manage 
guest users. 

This chapter comprises the following two parts: 

 User management—Describes how to manage users who require long-term access to the 
enterprise network, generally including the company employees and administrators of the 
enterprise network. 

 Guest Access Management (GAM)—Describes how to manage guest users who require 
short-term and temporary access to the enterprise network. 

Managing users 
The user management module is used to manage users that are connected to the enterprise network 
and access the network resources. When no user function module or component is deployed, the 
User tab is not displayed in the top navigation bar. The User tab is displayed only when at least one 
of the following components is deployed: 

 User Self-service Management 

 Guest Access Management (GAM) 

 User Access Manager (UAM) 

For how to deploy the components, see the HPE IMC deployment guides. 

The operator can manually add users (a small number of users) or imports users in batches (a large 
number of users) to the user management module. The operator can then modify the basic user 
information and maintain user information, or cancel users from the user management module.  

The operator can open self-service accounts for users, allowing users to log in to the SOM 
self-service platform to perform authorized operations. After UAM is deployed, the operator can 
apply for access accounts for users to access network resources.  

By default, IMC defines certain properties to identify the personal information and contact method of 
users, facilitating user management and maintenance. Operators can also customize additional 
properties for users.  

IMC operators can modify additional information of users and cancel users in batches to improve 
management efficiency.  

The user management module provides group-based management that manages operation rights of 
self-service accounts on the SOM platform. 
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Adding users 
Operators can manually add users one by one or import users in batches to the user management 
module. 

Adding users manually 
To manually add a user: 

1. Navigate to Users > Add User. 

a. Click the User tab from the top tabular navigation system. 

b. Click User Management on the left navigation tree. 

c. Click Add User under User Management on the left navigation tree. 

2. Configure the basic information about the user. 

 User Name—Enter the user name. A user name can be used by multiple users. 

 Identity Number—Enter any identity number of the user. An identity number can be used 
by multiple users. IMC uniquely identifies a user by using user name and identity number. 
Two users cannot have the same user name and identity number at the same time. 

 Contact Address—Enter the contact address of the user. 

 Telephone—Enter the phone number of the user. 

 Email—Enter the mail address of the user. 

 User Group—Select a user group for the user. A user group specifies the users that an IMC 
operator can manage. For more information, see "User groups." The default user group is 
Ungrouped, including all users not belonging to any user group. 

To select a user group, click Select User Group .  

The Select User Group window opens. 

 Select a group and click OK. 

3. Enter additional information parameters. 

If additional information is configured, relevant parameters are displayed. 

4. Select whether or not to open an account for the user. 

The self-service account is used for the SOM self-service platform. 

If the Open Account setting is not required, clear the Open Account box, and skip to step 7. 

If the Open Account setting is required, perform the following: 

 Account Name—Enter the self-service account name. The account name does not need to 
be the same as the user name, but must be unique. 

 Password—Enter the self-service account password. 

 Confirm Password—Enter the password again for confirmation. 

5. Specify account groups. 

Self-service accounts are assigned to various account groups with different rights. The right of 
self-service accounts within an account group might be different. The user right depends on the 
right of the self-service account and its account groups. For more information about account 
groups, see "Managing account groups." 

To select account groups: 

a. Click Add to launch the Select Account Group window. 

By default, no account group is displayed in the account group list. 

b. Enter the account group query criteria, group name or description, and click Query. All 
matching entries are displayed in the account group list. 
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If you click Query without entering a query criterion, all account groups are displayed. 

c. Click Clear Results to clear the query criteria, and no account group is displayed. 

d. Select an account group, or click the box next to the Group Name field to select all account 
groups, and then click OK. 

All selected account groups are displayed in the Account Groups area. 

e. Click the Remove icon  of an account group to delete the account group. 

6. Configure permissions for the self-service account. 

The self-service account permissions are used for the SOM self-service platform. 

When only User Selfservice Management component is deployed, no permission is displayed. 

When the Guest Access Management or SOM component is deployed, relevant permissions 
are displayed. Operators can select the permissions for the self-service account. 

7. Click OK. The Add User Result page opens. 

8. Perform one of the following: 

 Click Back To User List to return to the user list page. 

 Click Have A Look At User Detail to view detailed information about the newly added user. 

 Click Continue To Add User to return to step 3, and then repeat steps 3 through 7 to add 
more users. 

Importing users in batches 
To improve efficiency, operators can import users in batches from a file that contains user 
information. The import file must contain at least the following user attributes: user name, identity 
number, open account name, and account password, and these attributes must be imported from the 
file to IMC. IMC supports importing only text files. 

To import users in batches: 

1. Navigate to Users > Import Users. 

a. Click the User tab from the top tabular navigation system. 

b. Click User Management on the left navigation tree. 

c. Click Import Users under User Management on the left navigation tree. 

The Import Users page opens. 

2. Click Browse to locate the import file. 

The file must be in TXT format, and must contain the same number of columns in each row. 

3. Select a column separator. 

Options include Space, TAB, comma (,), colon (:), pound sign (#), and dollar sign ($). The 
selected separator must be the same as that is used in the import file. Otherwise, the system 
prompts an error message. 

4. Click Next to enter the page for configuring user information. 

5. Configure the basic user information: 

 User Name—Select the corresponding column from the list that contains the user names. 
This parameter must be imported from the text file.  

 Identity Number—Select the corresponding column from the list that contains user identity 
numbers. This parameter must be imported from the text file.  

 Contact Address—Select the corresponding column from the list that contains the user 
contact addresses. Or select Do not select from the file and then enter a contact address. 
The contract address you entered applies to all imported users.  
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 Telephone Number—Select the corresponding column from the list that contains user 
telephone numbers. Or select Do not select from the file and then enter a telephone 
number. The telephone number you entered applies to all imported users.  

 Email—Select the corresponding column from the list that contains user mail addresses. Or 
select Do not select from the file and then enter a mail address. The mail address you 
entered applies to all imported users. 

 User Group—Select a user group from the list to which you want to assign the imported 
users. A user group specifies the users that an IMC operator can manage. For more 
information, see "User groups." The default user group is Ungrouped. All users not 
belonging to any user group are added to Ungrouped. This parameter cannot be imported 
from the import file. 

6. If additional information is configured, relevant parameters are displayed. Select the 
corresponding column from the list that contains user additional information. Or select Do not 
select from the file and enter the setting manually. The setting you entered applies to all 
imported users. 

7. Select whether or not to open an account for imported users. 

The self-service account is used for the SOM self-service platform. 

If the Open Account setting is not required, clear the Open Account box, and skip to step 10. 
If the Open Account setting is required, perform the following: 

 Account Name—Select the corresponding column from the list that contains the 
self-service account names. This parameter must be imported from the text file. 

 Password—Select the corresponding column from the list that contains the self-service 
account passwords. This parameter must be imported from the text file. 

8. Specify account groups. 

Self-service accounts are assigned to various account groups with different rights. If you specify 
an account group, all imported users are assigned to the group. 

To select an account group: 

a. Click Add to launch the Select Account Group window. 

By default, no account group is displayed on the account group list. 

b. Enter the account group query criteria, group name or description, and click Query. All 
matching entries are displayed in the account group list. 

If you click Query without entering a query criterion, all account groups are displayed. 

Click Clear Results to clear the query criteria, and no account group is displayed. 

c. Select an account group, or click the box next to the Group Name field to select all account 
groups, and then click OK. 

All selected account groups are displayed in the Account Groups area. 

d. Click the Remove icon  of an account group to delete the account group. 

9. Configure permissions for the self-service account.  

The self-service account permissions are used for the SOM self-service platform.  

When only User Selfservice Management component is deployed, no permission is 
displayed. When the Guest Access Management or SOM component is deployed, relevant 
permissions are displayed. Operators can select the permissions for the self-service account. 
The permissions configuration applies to all imported users. 

10. Click Preview to launch the Preview Import Result window. 

Check whether the import result is as expected. 

11. Click Close to the return to the Import Users page. 

12. Click OK to start importing users to IMC. 

After the import is complete, the operation result page opens, showing the total number of 
imported rows, number of successfully imported users, and number users failed to be imported. 
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13. Click Back to return to the Import Users page. 

User additional information 
By default, the user management module defines some basic properties for users, such as user 
name and identity number. Operators can also customize additional information for users as needed. 
When the additional information is configured, IMC requires the operator to provide the specified 
additional information for a user when the user is added, and displays the information on the Basic 
User Information page. 

In addition, IMC also automatically adds the new additional information entry with the default value to 
all existing users. Operators can modify the additional information for users one by one on the Basic 
User Information page, or in batches by using the batch modify additional information option 
provided on the Batch User Operations page. For more information, see "Modifying additional 
information of multiple users in batches." 

Viewing the additional information list 
To view the additional information list: 

1. Navigate to Users > Additional Information. 

a. Click the User tab from the top tabular navigation system. 

b. Click User Management on the left navigation tree. 

c. Click Additional Information under User Management on the left navigation tree. 

IMC displays all additional information fields in the Additional Information List displayed 
in the main pane of the Additional Information page. 

Additional Information List 

 Field Name—Contains the name of the additional information field. 

 Field Type—Contains the type of the additional information field. Field types include Integer, 
Number up to 5 decimal digits, Alphanumeric characters and {-_.@} only, Any 
Characters, and Value selected from the option list. 

 Field Property—Contains the property of the additional information field, Cannot Be Null or 
Can Be Null. 

 Cannot Be Null indicates the additional information field is required. 

 Can Be Null indicates the additional information field is optional. 

 Display Order—Contains the links for adjusting the display order of the additional information 
field. The display order of the additional information fields in the additional information list 
determines the order of appearance of the additional information fields on the Add User page 
and on the Basic User Information page. 

Click the  icon for an additional information field to move it one position down. Click the  
icon for an additional information field to move it one position up. For the additional information 

field on the top of the list, the move up icon is grayed out . For the additional information field 

at the bottom of the list, the move down icon is grayed out . 

 Modify—Contains a link to enter the page for modifying the additional information field. For 
more information, see "Modifying an additional information field." 

 Delete—Contains a link for deleting the additional information field. 

Adding an additional information field 
To add an additional information field:  
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1. Navigate to Users > Additional Information. 

a. Click the User tab from the top tabular navigation system. 

b. Click User Management on the left navigation tree. 

c. Click Additional Information under User Management on the left navigation tree. 

IMC displays all additional information fields in the Additional Information List displayed 
in the main pane of the Additional Information page. 

2. Click Add to launch the Add Additional Information page. 

3. Enter the field name of the additional information in the Field Name field. 

4. Select a field property from the Field Property list, Cannot be Null or Can be Null. 

 Cannot Be Null—indicates the additional information field is required. 

 Can Be Null—indicates the additional information field is optional. 

5. Select a field type from the Field Type list. 

IMC supports five field types: 

 Integer 

 Number up to 5 decimal digits 

 Alphanumeric characters and {-_.@} only 

 Any Characters 

 Value selected from the option list 

6. Enter a default value for the additional information in the Default field. 

7. If you set the Field Type to Integer or Number up to 5 decimal digits, perform the following: 

Enter the maximum value allowed for the additional information field in the Max. Allowable 
Value field. 

Enter the minimum value allowed for the additional information field in the Min. Allowable 
Value field. 

8. If you set the Field Type to Alphanumeric characters and {-_.@} only, or Any Characters, 
enter the maximum length allowed for the additional information field in the Max. Length field. 

9. If you set the Field Type to Value selected from the option list, you must configure the option 
list contents. 

To configure the option list contents: 

a. To add an option to the Current Options list, enter the option in the Input Options field, 
and then click Add. Repeat the above operations to add more options. The current options 
list must contain at least one item. 

b. To replace an existing option in the Current Options list with a new one, select the option, 
enter the new option in the Input Options field, and then click Modify. 

c. To delete a current option from the Current Options list, select the option and then click 
Delete. 

d. To adjust the position of an option in the Current Options list, select the option, click Up to 
move the option one position up, or click Down to move the option one position down. 

e. To set an existing option as the default setting for the additional information field, select the 
option from the Current Options list, and then click Default. 

10. Select whether or not to use this additional information field for user preregistration. 

Click the box next to Used for Preregistration if you want IMC to use this additional 
information field for user preregistration. Otherwise, clear the box. 

11. Click OK. 

The newly added additional information field will be displayed in the Additional Information 
List. 
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Modifying an additional information field 
To modify an additional information field: 

1. Navigate to Users > Additional Information. 

a. Click the User tab from the top tabular navigation system. 

b. Click User Management on the left navigation tree. 

c. Click Additional Information under User Management on the left navigation tree. 

IMC displays all additional information fields in the Additional Information List displayed 
in the main pane of the Additional Information page. 

2. Click the Modify icon  for the additional information you want to modify. The Modify 
Additional Information page opens. 

3. Enter a new name for the additional information field in the Field Name field. 

4. Select a field property from the Field Property list, Cannot be Null or Can be Null. 

 Cannot Be Null—The additional information field is required. 

 Can Be Null—The additional information field is optional. 

5. Select a field type from the Field Type list. 

IMC supports five field types: 

 Integer 

 Number up to 5 decimal digits 

 Alphanumeric characters and {-_.@} only 

 Any Characters 

 Value selected from the option list 

6. Enter a new default value for the additional information field in the Default field. 

7. If you set the Field Type to Integer or Number up to 5 decimal digits, perform the following: 

Enter the maximum value allowed for the additional information field in the Max. Allowable 
Value field. 

Enter the minimum value allowed for the additional information field in the Min. Allowable 
Value field. 

8. If you set the Field Type to Alphanumeric characters and {-_.@} only, or Any Characters, 
enter the maximum length allowed for the additional information field in the Max. Length field. 

9. If you set the Field Type to Value selected from the option list, you must configure option list 
contents. 

To configure the option list contents: 

a. To add an option to the Current Options list, enter the option in the Input Options field, 
and then click Add. Repeat the above step to add more options. The Current Options list 
must contain at least one option. 

b. To replace an existing option in the Current Options list with a new one, select the option, 
enter the new option in the Input Options field, and then click Modify. 

c. To delete a current option from the Current Options list, select the option and then click 
Delete. 

d. To adjust the position of an option in the Current Options list, select the option, click Up to 
move the option one position up, or click Down to move the option one position down. 

e. To set an existing option as the default setting for the additional information field, select the 
option from the Current Options list, and then click Default. 

10. Select whether or not to use this additional information field at user preregistration. 

Click the box next to Used for Preregistration if you want IMC to use this additional 
information field for user preregistration. Otherwise, clear the box. 
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11. Click OK. 

Deleting an additional information field 
To delete an additional information field: 

1. Navigate to Users > Additional Information. 

a. Click the User tab from the top tabular navigation system. 

b. Click User Management on the left navigation tree. 

c. Click Additional Information under User Management on the left navigation tree. 

IMC displays all additional information fields in the Additional Information List displayed 
in the main pane of the Additional Information page. 

2. Click the Delete icon  for the additional information field you want to delete. A confirmation 
dialog box opens. 

3. Click OK to delete the additional information field. 

Once an additional information field is deleted, IMC automatically deletes the additional 
information from all existing users. 

Managing users 
After a user is added to the user management module, operators can modify the user information, 
delete the user, or move the user to another user group. 

Operators can modify basic and additional information about a user to maintain the latest user 
information. 

Operators can also delete a user from the user management module. Once a user is deleted, all 
service accounts applied by the user are also cancelled. Before you delete a user, make sure the 
service accounts of the user are no longer needed.  

There are two methods for deleting a user: 

 Navigate to the Basic User Information page, and then click Delete User in the Action menu 
on the page to delete the selected user. Or, 

 Navigate to the All Users page, select one or more users and then delete them by using the 
Delete User option. 

The user management module provides group-based management of users. Operators can move a 
user from one user group to another. There are two methods for regrouping a user: 

 Navigate to the Basic User Information page, and then use the Move User option provided in 
the Action menu on the page to move the selected user to a target user group. Or, 

 Navigate to the User List of a selected user group, and then use the Move User option 
provided in the user list area to move the selected users to a target user group. 

Viewing the user list 
To view the user list: 

1. Navigate to Users > All Users. 

a. Click the User tab from the top tabular navigation system. 

b. Click User Management on the left navigation tree. 

c. Click All Users under User Management on the left navigation tree. 

IMC displays all users in the User List displayed in the main pane of the All Users page. 

User list  
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 User Name—Contains the user name. Click a user name link to enter the Basic User 
Information page. 

 Identity Number—Contains the identity number of the user. IMC uses user name + 
identity number to uniquely identify a user. 

 Open Account—Displays whether or not the user has a self-service account, Yes or 
No. 

 Account Name—Contains the self-service account name. If the user has no 
self-service account, this field is empty. 

 Contact Address—Contains the contact address of the user. This field is empty if no 
contact address is provided. 

 Telephone—Contains the telephone number of the user. This field is empty if no 
telephone number is provided. 

 Email—Contains the mail address of the user. This field is empty if no mail address is 
provided. 

 User Group—Contains the name of the group to which the user belongs. Click the 
group name link to view its details. For users not belonging to any group, this field 
displays Ungrouped. 

2. Click All Users in the upper right corner of the page to display all users in the User List. Or,  

Click Ungrouped Users to display only the users not belonging to any group. At this time, the 
Move User option is displayed in the User List area. This option is not displayed if you select 
All Users. 

3. Click 8, 15, 50, 100, 200, or 1000 from the right side of the main pane to configure how many 
items per page you want to view. 

4. You can sort the User List by any of the above fields provided. Click the column label to sort the 
list by the selected field. The column label is a toggle switch that lets you toggle between the 
various sort options specific to each field. 

Viewing the user list of a user group 
To view the user list of a user group: 

1. Navigate to Users > All Users. 

a. Click the User tab from the top tabular navigation system. 

b. Click User Management on the left navigation tree. 

c. Hover over All Users under User Management on the left navigation tree. 

A floating menu appears, displaying all existing user groups and Ungrouped. 

2. Click the name link of a user group. 

All users belonging to the user group are displayed in the User List. 

User List  

 User Name—Contains the user name. Click a user name link to enter the Basic user 
information page. 

 Identity Number—Contains the identity number of the user. IMC uses user name + identity 
number to uniquely identify a user. 

 Open Account—Displays whether or not the user has a self-service account, Yes or No. 

 Account Name—Contains the self-service account name. If the user has no self-service 
account, this field is empty. 

 Contact Address—Contains the contact address of the user. This field is empty if no 
contact address is provided. 

 Telephone—Contains the telephone number of the user. This field is empty if no telephone 
number is provided. 
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 Email—Contains the mail address of the user. This field is empty if no mail address is 
provided. 

 User Group—Contains the name of the user group to which the user belongs. Click the 
group name link to view its details. For users not belonging to any group, this field displays 
Ungrouped. 

3. Click the All Users icon in the upper right corner of the page to display all users in the User 
List.  

Click the Ungrouped Users icon to display only the users not belonging to any group. At this 
time, the Move User option is displayed in the User List area. 

4. Click 8, 15, 50, 100, 200, or 1000 from the right side of the main pane to configure how many 
items per page you want to view. 

5. You can sort the User List by any of the above fields. Click the column label to sort the list by 
the selected field. The column label is a toggle switch that lets you toggle between the various 
sort options specific to each field. 

Viewing basic user information 
To view the basic information about a user:  

1. Navigate to Users > All Users. 

a. Click the User tab from the top tabular navigation system. 

b. Click User Management on the left navigation tree. 

c. Hover over All Users under User Management on the left navigation tree. 

IMC displays all users in the User List displayed in the main pane of the All Users page. 

2. Click the name link of a user to enter the Basic User Information page. 

3. The Basic Information area displays the user basic information, including: 

 User Name—Contains the user name. A user name can be used by multiple users. 

 Identity Number—Contains the identity number of the user. IMC uses user name + identity 
number to uniquely identify a user. 

 Contact Address—Contains the contact address of the user. 

 Telephone—Contains the telephone number of the user. 

 Email—Contains the mail address of the user. 

 User Group—Contains the user group to which the user belongs. For users not belonging 
to any user group, this field displays Ungrouped. 

4. The Additional Information area displays the user additional information: 

If the additional information is provided when the user is added, this field displays the 
configured value. If not, this field displays the default value. 

5. The Account Information area displays the account information of the user, including: 

 Open Account—Displays whether or not the user has opened a self-service account, Yes 
or No. 

 Account Name—Contains the self-service account name. This field is available only when 
the Open Account field displays Yes. 

6. The Account Groups area displays the account group information of the user. One 
self-service account can be assigned to multiple account groups. 

This area is displayed only for users who have opened self-service accounts. 

7. The Account Permissions area displays the permissions of self-service account, which is the 
collection of the permissions granted to the user account itself and those granted to its account 
groups. 
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Managing a user from the basic user information page 

Operators can manage a user from the convenience of the Action menu located in the upper right 
corner of the Basic User Information page. The Action menu provides the following management 
options: 

Refresh 

 With the Refresh option, operators can reload the current basic user information page and 
capture any updates to the user information. 

 To refresh the current basic user information page, click the Refresh icon in the Action menu. 

Delete User 

 Click Delete in the Action menu. A confirmation box opens. Click OK to delete the user. 

 After you delete a user from the user management module, all the service accounts applied by 
the user are also cancelled. Make sure the service accounts of the user are no longer needed 
before you perform this operation. 

Move User 

With the Move User option, you can move a user from the one user group to another.  

To move a user to another user group: 

1. Click Move User in the Action menu. The Move User page opens. 

2. The Users to be Moved area displays information about the selected user. 

 User Name—Contains the user name. IMC uniquely identifies a user by using user name + 
identity number. A user name can be used by multiple users, but two users cannot have the 
same user name and identity number at the same time. 

 User Group—Contains the current user group to which the user belongs. 

 Created At—Contains the date and time when the user was added to the user 
management module. 

 Telephone—Contains the telephone number of the user. 

3. Select a target group to which you want to move the user. 

Click Select User Group icon  The Select User Group window opens. Select a group and 
then click OK. The selected user group is displayed in the Group Name field. 

4. Click OK. 

Modify Basic Information 

Click the Modify Basic Information link in the Action menu to enter the page for modifying the 
basic user information. For more information, see "Modifying basic user information." 

Querying users 
Operators can locate users quickly through basic query or advanced query. Basic query allows you 
to search users by user name and identity number. Advanced query allows you to search users 
according to the user basic information, additional information, and account information.  

Performing a basic query 

To perform a basic query for users: 

1. Navigate to Users > All Users. 

a. Click the User tab from the top tabular navigation system. 

b. Click User Management on the left navigation tree. 

c. Click All Users under User Management on the left navigation tree. 
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If Advanced Query is displayed in the upper right corner of the page, you are already in 
basic query mode. Otherwise, click Basic Query in the upper right corner of the page to use 
basic query. 

2. Enter the user name in the User Name field. IMC supports fuzzy matching for this field. 

3. Enter the identity number of the user in the Identity Number field. IMC supports fuzzy matching 
for this field. 

4. Click Query. The User List displays all users matching the query criteria. 

5. To clear the query criteria, click Reset. The User List displays all users. 

Performing an advanced query 

To perform an advanced query: 

1. Navigate to Users > All Users. 

a. Click the User tab from the top tabular navigation system. 

b. Click User Management on the left navigation tree. 

c. Click All Users under User Management on the left navigation tree. 

If Basic Query is displayed in the upper right corner of the page, you are already in 
advanced query mode. Otherwise, click Advanced Query in the upper right corner of the 
page to use advanced query. 

2. Enter or select one or more query criteria in the fields provided: 

Basic Information 

 User Name—Enter the user name in the User Name field. 

 Identity Number—Enter the identity number of the user in the Identity Number field. 

 Contact Address—Enter the contact address of the user in the Contact Address field. 

 Telephone—Enter the telephone number of the user in the Telephone field. 

 Email Address—Enter the mail address of the user. 

 User Group—Select a user group for query. After you select a user group, IMC queries 
users in the selected user group only. 

To select a user group, click Select User Group . The Select User Group window 

opens. Select a user group and click OK. Click the Clear icon  to clear your selection. 

Additional Information 

If additional information is configured, relevant parameters are displayed. Enter a value in the 
associated field to search the users by. 

Account Information 

 Open Account—Select Yes or No from the Open Account list. Select Yes to search for 
users that have self-service accounts. Select No to search for users that do not have 
self-service accounts. 

 Account Name—Enter the self-service account name in the Account Name field. 

3. Click Query. The User List displays all users matching the query criteria. 

4. To clear the query criteria, click Reset. The User List displays all users. 

Modifying basic user information 
Operators can modify the user information, such as telephone number and identity number, as 
needed to maintain the user information.  

Additionally, after an operator adds a new additional information entry, IMC automatically adds the 
new entry with the default value to all existing users. The default value does not apply to all users, so 
operators can then use the Modify Basic User Information option to modify the additional 
information for the users. 
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To modify the user information:  

1. Navigate to Users > All Users. 

a. Click the User tab from the top tabular navigation system. 

b. Click User Management on the left navigation tree. 

c. Click All Users under User Management on the left navigation tree. 

2. Click the name link of a user to enter the Basic User Information page. 

3. Click Modify Basic Information in the Action menu in the upper right corner of page. 

The Modify Basic User Information page opens. 

4. Modify basic user information. 

 User Name—Enter a new user name. A user name can be used by multiple users. 

 Identity Number—Enter any identity number of the user. An identity number can be used 
by multiple users. IMC identifies a user by using user name + identity number. Two users 
cannot have the same user name and identity number at the same time. 

 Contact Address—Enter the contact address of the user. 

 Telephone—Enter the telephone number of the user. 

 Email Address—Enter the mail address of the user.  

 User Group—You cannot modify the user group parameter. 

5. If additional information is configured, relevant parameters are displayed. 

If the additional information is configured after the user is added to the user management 
module, the field displays the default value. Operators can modify the additional information 
according to pre-defined rules. 

6. Modify the account information of the user. 

Operators can modify password of the account, but cannot modify the account name. 

The self-service account is used for the SOM self-service platform. 

 Account Name—The self-service account name cannot be modified. 

 Password—Enter a new self-service account password. 

 Confirm Password—Enter the password again for confirmation.  

7. Modify account groups. 

Self-service accounts are assigned to various account groups with different rights. The 
self-service accounts of an account group might be different. The user right depends both on 
the right of the self-service account and its account groups. For more information about account 
groups, see "Modifying an account group." 

To select an account group: 

a. Click Add to launch the Select Account Group window. 

By default, no account group is displayed on the account group list. 

b. Enter the account group query criteria, group name or description, and click Query. All 
matching entries are displayed in the account group list. 

If you click Query without entering a query criterion, all account groups are displayed. 

c. Click Clear Results to clear the query criteria, and no account group is displayed. 

d. Select an account group, or click the box next to the Group Name field to select all account 
groups, and then click OK. 

All selected account groups are displayed in the Account Groups area. 

e. Click the Remove icon  of an account group to delete the account group. 

8. Configure permissions for the self-service account. 

The self-service account permissions are used for the SOM self-service platform. 
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 When only the User Selfservice Management component is deployed, no permission is 
displayed. 

 When the Guess Access Management or SOM component is deployed, relevant 
permissions are displayed. Operators can select the permissions for the self-service 
account. 

One user can join multiple account groups. 

9. Modify permissions for the self-service account.  

The self-service account permissions are used for the SOM self-service platform. 

 When only the User Selfservice Management component is deployed, no permission is 
displayed. 

 When the Guest Access Management or SOM component is deployed, relevant 
permissions are displayed. Operators can select the permissions for the self-service 
account.  

10. Click OK. 

Moving users between user groups 
Operators can move a user from one user group to another. This operation can be performed only on 
the user list page of a specific user group (including Ungrouped), or on the Basic User Information 
page of a specific user (see "Modifying basic user information" for more information). 

This section describes how to move users to another user group on the user list page of a specific 
user group. 

To move users from one group to another: 

1. Navigate to Users > All Users. 

a. Click the User tab from the top tabular navigation system. 

b. Click User Management on the left navigation tree. 

c. Hover over All Users under User Management on the left navigation tree. 

A floating menu appears, displaying all user groups and Ungrouped. 

2. Click the name link of a group. 

The User List is displayed in the main pane, displaying all users belonging to the selected 
group. 

3. Select one or more users, or click the box next to the User Name field to select all users. 

4. Click Move User. The Move User page opens. 

5. The Users to be Moved area displays information about the selected user, including:  

 User Name—Contains the user name. IMC uniquely identifies a user by using user name + 
identity number. A user name can be used by multiple users, but two users cannot have the 
same user name and identity number at the same time. 

 User Group—Contains the current user group name to which the user belongs. 

 Created At—Contains the date and time when the user was added to the user 
management module.  

 Telephone—Contains the telephone number of the user. 

6. Select a target group to which you want to move the user. 

Click the Select User Group icon . The Select User Group window opens. Select a group 
and click OK. The selected user group is displayed in the Group Name field. 

7. Click OK. 
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Deleting users 
Operators can delete a user from the user management module. Once a user is deleted, all service 
accounts applied by the user are also cancelled. Before you delete a user, make sure the service 
accounts of the user are no longer needed. There are two ways for deleting a user: 

 Navigate to the Basic User Information page, and then click Delete User provided in the 
Action menu on the page to delete the selected user.  

 Or, navigate to the All Users page, select one or more users and then delete them by using the 
Delete User option. 

To delete users: 

1. Navigate to Users > All Users. 

a. Click the User tab from the top tabular navigation system. 

b. Click User Management on the left navigation tree. 

c. Click All Users under User Management on the left navigation tree. 

2. Select one or more users to be deleted, or click the box next to the User Name field to select all 
users. 

3. Click Delete User. A confirmation box opens. 

4. Click OK to delete the selected users. 

Batch user operations 
Batch user operations include batch modify additional information, batch delete users, and batch 
modify users.  

After an operator adds a new additional information field, IMC automatically adds the new additional 
information with the default value to all existing users. With the Batch Modify Additional 
Information option, operators can modify the additional information for multiple users at the same 
time. Alternatively, operators can modify the additional information for users individually on the Basic 
user information page.  

The Batch Delete Users option enables operators to delete the unneeded users in bulk to improve 
management efficiency.  

The Batch Modify Users option enables operators to modify user information in bulk by importing 
CSV files. 

The following information describes the batch modify additional information option, the batch delete 
users option, and the batch modify users option separately. 

Modifying additional information of multiple users in batches 
IMC operators can modify additional information of multiple users in bulk to improve management 
efficiency. 

To modify additional information of multiple users in batches: 

1. Navigate to Users > All Users. 

a. Click the User tab from the top tabular navigation system. 

b. Click User Management on the left navigation tree. 

c. Click Batch User Operations under User Management on the left navigation tree. 

2. Select Batch Modify Additional Information, and then click Next. The page for querying 
users opens. 

3. Enter or select one or multiple of the following query criteria: 
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Basic information 

 User Name—Enter the user name. 

 Identity Number—Enter the identity number of the user. 

 Contact Address—Enter the contact address of the user. 

 Telephone—Enter the telephone number of the user. 

 Email—Enter the mail address of the user. 

 User Group—Select a user group for query. IMC queries users only in the selected user 
group. 

To select a user group, click Select User Group . The Select User Group window 

opens. Select a user group and click OK. Click the Clear icon  to clear your selection. 

Additional Information 

If additional information is configured, relevant parameters are displayed. Enter a value in 
the associated field to match the users for which you want to search. 

Account Information 

 Open Account—Select Yes or No from the Open Account list. Select Yes to search 
for users that have self-service accounts. Select No to search for users that do not 
have self-service accounts. 

 Account Name—Enter the self-service account name in the Account Name field. 

4. Click Query. The User List displays all users matching the query criteria. 

5. To clear the query criteria, click Reset. The User List displays all users. 

6. Select the users whose additional information you want to modify. 

Select a user, or click the box  next to the User Name field to select all users. 

7. Click Next. 

IMC displays all additional information entries on the Batch Modify Additional Info page. 

8. Clear the box  for the additional information field that you do not want to modify. 

9. For an additional information entry whose Field Type is Integer, Number up to 5 decimal 
digits, Alphanumeric characters and {-_.@} only, or Any Characters, enter a new value for 
the additional information field. 

10. For an additional information entry whose Field Type is Value selected from the option list, 
select a new option from the list for the additional information field. 

11. Click OK. 

IMC modifies the additional information for users according to your configuration and displays 
the operation results, including: 

 User Name—Contains the name of the user. 

 Result—Contains the operation result. 

12. Click OK to return to the Batch User Operation page. 

Deleting users in batches 
To delete users in batches: 

1. Navigate to Users > All Users. 

a. Click the User tab from the top tabular navigation system. 

b. Click User Management on the left navigation tree. 

c. Click Batch User Operations under User Management on the left navigation tree. 

The Batch User Operation page opens. 
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2. Click the radio button  to the left of Batch Delete Users, and then click Next. The page for 
querying users opens. 

3. Enter or select one or multiple of the following query criteria: 

Basic information 

 User Name—Enter the user name. 

 Identity Number—Enter the identity number of the user. 

 Contact Address—Enter the contact address of the user.  

 Telephone—Enter the telephone number of the user. 

 Email—Enter the mail address of the user. 

 User Group—Select a user group. IMC queries users only in the selected user group. 

To select a user group, click the Select User Group icon  The Select User Group 
window opens. 

Select a user group and click OK. Click the Clear icon  to clear your selection. 

Additional Information 

If additional information is configured, relevant parameters are displayed. Enter a value in the 
associated field to match the users for which you want to search. 

Account Information 

 Open Account—Select Yes or No from the Open Account list. Select Yes to search for 
users that have self-service accounts. Select No to search for users that do not have 
self-service accounts. 

 Account Name—Enter the self-service account name in the Account Name field. 

4. Click Query. The User List displays all users matching the query criteria. 

5. To clear the query criteria, click Reset. The User List displays all users. 

6. Select a user, or click the box next to the User Name field to select all users. 

7. Click OK. A confirmation dialog box opens. 

8. Click OK to delete the selected users. 

Once a user is deleted, IMC automatically deletes all the service accounts applied by the user. 

Batch modifying users 
1. Navigate to Users > All Users. 

a. Click the User tab from the top tabular navigation system. 

b. Click User Management on the left navigation tree. 

c. Click Batch User Operations under User Management on the left navigation tree. 

The Batch User Operation page opens. 

2. Select Batch Modify Users, and then click Next. 

The Import File page opens. 

3. In the File Name field, click Browse. Select an import file that is saved locally in the dialog box 
that opens. 

The import file must be in CSV format and the file size cannot be larger than 1MB. 

The first line in the file is the column headings of user properties, and all the other lines are the 
corresponding values. If a column has no value, the user property of the column will not be 
modified. An example of a line of user data would be: 
oldName,oldId,address,phone,email,groupName,additionalInfo,additionalInfo 

Mary,1001,,1234567,mary@hp.com,info,age:24,sex:female 
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The field definitions for all columns in an import file are listed in Table 50. The table describes all 
columns that can be used in a valid data import file and the rules for constructing a valid import 
file using these column definitions. 

Table 50 Import file column definitions 

Column label  Column contents/requirements  

oldName  
Old user name. The combination of this field and the old ID uniquely identifies a user to 
be modified. 

This field is required. 

oldId  
Old identity number. The combination of this field and the old name uniquely identifies a 
user to be modified. 

This field is required. 

newName  
Modified user name. 

This field is optional. 

newId  
Modified identity number. 

This field is optional. 

address  
Modified contact address. 

This field is optional. 

phone  
Modified telephone number. 

This field is optional. 

email  
Modified mail. 

This field is optional. 

groudName  
Modified group name. The group name must already exist in IMC. 

This field is optional. 

additionalInfo  

Modified additional information. You can specify one or more additional information 
columns. The additional information use the following format: additional information 
name:additional information value. The additional information name must be a name 
that has been defined in the user additional information. For more information, see 
"User additional information." 

This field is optional. 
 

4. Click OK. 

The user information modification result page opens. 

5. View the user information modification results and check whether or not all user information is 
modified. 

Managing account groups 
The user management module provides group-based management that manages operation rights of 
self-service accounts on the SOM platform. With the SOM component deployed, the operator can 
open self-service accounts for users, allowing users to log in to the SOM self-service platform to 
perform authorized operations.  

You can assign SOM self-service platform permissions to an account group. After joining the account 
group, a user can enjoy the permissions set for the account group. A user can join multiple account 
groups.  

IMC supports hierarchical management of account groups. You can create unlimited levels of 
sub-account groups for an account group. If a user joins an account group, the user can enjoy the 
permissions granted to the account group and those to all its parent groups.  
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You can configure the permissions for the self service account of a user when the user is added. 
After the user joins an account group, the user can also enjoy the permissions set for the account 
group. If the account group has parent groups, the user also enjoys the permissions set for the 
parent groups. 

Viewing the account group list 
To view the account group list: 

1. Navigate to Users > Account Group. 

a. Click the User tab from the top tabular navigation system. 

b. Click User Management on the left navigation tree. 

c. Click Account Group under User Management on the left navigation tree. 

IMC displays all account groups in the Account Group List. 

Account group list 

 Group Name—Contains the name of the account group. 

 Description—Contains the description of the account group. 

 Modify—Contains a link for entering the page for modifying the account group. 

 Delete—Contains a link for deleting the account group. Click the Delete icon  to 
delete the account group. After an account group is deleted, users in this group can no 
longer access the operations configured for this group. 

2. Click 8, 15, 50, 100, 200, or 1000 from the right side of the main pane to configure how many 
items per page you want to view. 

3. You can sort the Account Group List by the Group Name and Description fields. Click the 
column label to sort the list by the selected field. The column label is a toggle switch that lets 
you toggle between the various sort options specific to each field. 

Viewing account group details 
To view detailed information about an account group:  

1. Navigate to Users > Account Group. 

a. Click the User tab from the top tabular navigation system. 

b. Click User Management on the left navigation tree. 

c. Click Account Group under User Management on the left navigation tree. 

The Account Group List displays all account groups. 

2. Click the name link of an account group to enter the Account Group Details page. 

3. The Account Group Details area displays the account group information, including: 

 Group Name—Contains the name of the account group. 

 Description—Contains the description of the account group. 

4. The Contained Account Groups area displays all the sub-account groups contained in the 
account group. 

Click the Expand icon  for the account group to expand its sub-account groups. Click the 
Expand icon  for a sub-account group to expand its lower-level account groups. Continue to 
do so until you have expanded all the sub-account groups. 

5. The Group Accounts area displays all users contained in the selected account group and the 
sub-account groups. 

 User Name—Contains the user name.  

 Identity Number—Contains the identity number of the user. 
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 Open Account—Displays whether or not the user has a self-service account, Yes or No. 
The account group is used to assign permissions to the users' self-service accounts, so 
users in the group must have a self-service account opened, and this field always has a 
value Yes. 

 Account Name—Contains the self-service account name. 

6. The Group Permissions displays all the permissions assigned to the account group.  

7. Click Back to return to the Account Group page. 

Querying account groups 
1. Navigate to Users > Account Group. 

a. Click the User tab from the top tabular navigation system. 

b. Click User Management on the left navigation tree. 

c. Click Account Group under User Management on the left navigation tree. 

The Account Group page opens. 

2. Enter the account group name in the Croup Name field. IMC supports fuzzy matching for this 
field. 

3. Enter a description for the account group in the Description field. IMC supports fuzzy matching 
for this field. 

4. Click Query. The Account Group List displays all account groups matching the query criteria. 

5. To clear the query criteria, click Reset. The Account Group List displays all account groups. 

Adding an account group 
1. Navigate to Users > Account Group. 

a. Click the User tab from the top tabular navigation system. 

b. Click User Management on the left navigation tree. 

c. Click Account Group under User Management on the left navigation tree. 

The Account Group page opens. 

2. Click Add to enter the Add Account Group page. 

3. Enter a unique account group name in the Group Name field. 

4. Enter a description for the account group in the Description field. 

5. Add users to the account group. 

a. Click Add in the Group Accounts area to launch the Select User window. 

b. Search for users through basic query or advanced query. 

Basic query 

If Advanced Query is displayed in the upper right corner of the page, you are in basic query 
mode. Otherwise, click Basic Query in the upper right corner of the page to use basic 
query. 

 User Name—Enter the user name in the User Name field. 

 Identity Number—Enter the identity number of the user in the Identity Number field.  

Advanced query  

If Basic Query is displayed in the upper right corner of the page, you are in advanced query 
mode. Otherwise, click Advanced Query in the upper right corner of the page to use 
advanced query. 

 User Name—Enter the user name. A user name can be used by multiple users.  
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 Identity Number—Enter any identity number of the user. An identity number can be 
used by multiple users. IMC uniquely identifies a user by using user name + identity 
number. Two users cannot have the same user name and identity number at the same 
time. 

 Contact Address—Enter the contact address of the user.  

 Telephone—Enter the telephone number of the user.  

 Email—Enter the mail address of the user.  

 User Group—Select a user group. IMC queries users only in the selected user group. 

To select a user group, click Select User Group . The Select User Group window 
opens. Select a user group and click OK. 

 Open Account—Contains a value Yes, which cannot be modified. Only users that have 
opened self-service accounts can be added to the account group. 

 Account Name—Enter the self-service account name. 

c. Click Query. The User List displays all users matching the query criteria. 

d. To clear the query criteria, click Reset. The User List displays all users. 

e. Select a user, or click the box next to the User Name field to select all users.  

f. Click OK. All selected users are displayed in the Group Users area. 

g. Click the Remove icon  of a user to delete the user. 

6. Add sub-account groups to the account group: 

a. Click Add in the Sub-Account Groups area to launch the Select Account Group window. 

b. Enter the account group query criteria, group name or description. 

c. Click Query. 

The Account Group List displays all account groups matching the query criteria. If you 
click Query without entering any query criterion, all account groups are displayed. 

d. Click Clear Results to clear the query criteria, and no account group is displayed. 

e. Select an account group, or click the box next to the Group Name field to select account 
groups. 

f. Click OK. The selected account groups are displayed in the Sub-Account Groups area. 

7. Configure permissions for the account group in the Group Permissions area. 

When the SOM component is deployed, relevant permissions are displayed. Operators can 
select the permissions for the account group. 

8. Click OK. 

The newly added account group is displayed in the Account Group List. 

Modifying an account group 
1. Navigate to Users > Account Group. 

a. Click the User tab from the top tabular navigation system. 

b. Click User Management on the left navigation tree. 

c. Click Account Group under User Management on the left navigation tree. 

The Account Group page opens. 

2. Click the Modify icon  for the account group you want to modify.  

The Modify Account Group page opens. 

3. You cannot modify the account group name. 

4. Enter a new description for the account group in the Description field. 
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5. Add users to the account group. 

a. Click Add in the Group Accounts area to launch the Select User window. 

b. Search for users through basic query or advanced query. 

Basic query 

If Advanced Query is displayed in the upper right corner of the page, you are in basic query 
mode. Otherwise, click Basic Query in the upper right corner of the page to use basic 
query. 

 User Name—Enter the user name in the User Name field. 

 Identity Number—Enter the identity number of the user in the Identity Number field.  

Advanced query  

If Basic Query is displayed in the upper right corner of the page, you are in advanced query 
mode. Otherwise, click Advanced Query in the upper right corner of the page to use 
advanced query. 

 User Name—Enter the user name. A user name can be used by multiple users.  

 Identity Number—Enter any identity number of the user. An identity number can be 
used by multiple users. IMC uniquely identifies a user by using user name + identity 
number. Two users cannot have the same user name and identity number at the same 
time. 

 Contact Address—Enter the contact address of the user.  

 Telephone—Enter the telephone number of the user.  

 Email—Enter the mail address of the user.  

 User Group—Select a user group. IMC queries users only in the selected user group. 

To select a user group, click the Select User Group icon . The Select User Group 
window opens. Select a user group and click OK. 

 Open Account—Contains a value Yes, which cannot be modified. Only users that have 
opened self-service accounts can be added to the account group. 

 Account Name—Enter the self-service account name. 

c. Click Query. The User List displays all users matching the query criteria. 

d. To clear the query criteria, click Reset. The User List displays all users. 

e. Select a user, or click the box next to the User Name field to select all users.  

f. Click OK. All selected users are displayed in the Group Users area. 

g. Click the Remove icon  of a user to delete the user. 

6. Add sub-account groups to the account group: 

a. Click Add in the Sub-Account Groups area to launch the Select Account Group window. 

b. Enter the account group query criteria, group name or description. 

c. Click Query. 

The Account Group List displays all account groups matching the query criteria. If you 
click Query without entering any query criterion, all account groups are displayed. 

d. Click Clear Results to clear the query criteria, and no account group is displayed. 

e. Select an account group, or click the box next to the Group Name field to select account 
groups. 

f. Click OK. The selected account groups are displayed in the Sub-Account Groups area. 

7. Configure permissions for the account group in the Group Permissions area. 

When the SOM component is deployed, relevant permissions are displayed. Operators can 
select the permissions for the account group. 

8. Click OK. 
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Deleting account groups 
1. Navigate to Users > Account Group. 

a. Click the User tab from the top tabular navigation system. 

b. Click User Management on the left navigation tree. 

c. Click Account Group under User Management on the left navigation tree. 

IMC displays all account groups in the Account Group List in the main pane of the 
Account Group page. 

2. Select one or more account groups you want to delete, or click the box next to the Group Name 
field to select all account groups. 

3. Click Delete in the Account Group List area. A confirmation dialog box opens. 

4. Click OK to delete the selected account groups. 

Managing guest access 
An enterprise or organization usually has temporary, external users. These users access the 
network for a short time, and are assigned restricted network access privileges. These users are 
called "guests." The key factors of guest management are guaranteeing that the guests can quickly 
access the network and guaranteeing the network access security.  

Based on the characteristics of guests, IMC provides the Guest Access Manager (GAM) component. 
The GAM provides two parts: guest access management module and guest access self-service 
system. After an IMC operator logs in to IMC, the operator can use the guest access management 
module to manage guest access operators and guest access user groups. After a guest access 
operator logs in to the guest access self-service system, the guest access operator can create and 
manage guest accounts.  

GAM is deployed in the following position of a network, as shown in Figure 146. 

Figure 146 Position of GAM in a network 

 
 

To implement GAM, follow these steps: 

1. An IMC operator (network administrator) creates a guest access user group based on the guest 
characteristics, and specifies the access devices and the corresponding device user groups in 
the guest access user group. 

A guest can access the network through only the access devices specified in the guest access 
user group to which the guest belongs. When an access device receives a network access 
request from the guest, the access device adds the guest to the user group specified for the 
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access device. After the guest passes the authentication, the guest can access network 
resources. 

Because the authentication requires the access device to support user groups, the software 
version of the access device must be Comware Platform Software Version 
COMWAREV500R002B56 or higher. 

2. The IMC operator creates guest access operators, and specifies the guest access user groups 
that each guest access operator can manage. 

3. A guest access operator logs in to the guest access self-service system and creates guest 
users. 

4. The guest access operator prints the guest user information in the guest access self-service 
system and gives it to the guest users. 

5. A guest user uses the guest account to access the network. 

GAM involves the following user roles: 

 IMC operator—An IMC operator is an administrator of the enterprise or organization network. 
The network administrator manages the operation of the whole network, and guarantees the 
network security. 

 User—Internal user of an enterprise or organization, for example, an employee of an 
enterprise. Users use the network resources. For more information about users, see "User and 
guest access management." 

 Guest access operator—Manager of the guest users. A guest access operator is another role 
of a user. When a user is specified as a guest access operator, the user can log in to the guest 
access self-service system to manage the guest users. For example, a gatekeeper can be 
specified as a guest access operator. 

 Guest user—An external user who needs to temporarily access the network of an enterprise or 
organization. 

To manage the guest users, follow these steps in GAM: 

Create guest access user groups. 

 Create guest access operators. 

 Create guest accounts. 

Creating guest access user groups and creating guest access operators are performed in the guest 
access management module. Creating guest accounts is performed in the guest access self-service 
system. 

The guest user access group function assigns guest accounts in the same format to guest users of 
the same type, so that you can identify the guest user information according to the guest account. 
After a user is configured as a guest access operator, the guest access operator can log in to the 
guest access self-service system and manage the guest accounts.  

GAM also provides the log auditing function. GAM logs the operations that a guest access operator 
performs in the guest access self-service system, including logging in to/logging out of the guest 
access self-service system, creating/deleting guest accounts, and modifying passwords. A network 
administrator can use the log auditing function to audit the non-conforming operations of the guest 
access operator, and take the corresponding measures to secure the network.  

When a guest uses an existing guest account to access the network, the guest must first pass the 
authentication of the access device. Therefore, you must configure an authentication method on the 
access device. Portal authentication and 802.1X authentication are available. You must perform the 
following configurations on the access device: 

 Enable port security.  

 Configure an authentication method.  

 Create a local user group.  

 Enable port security on the access interface.  
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 Specify the default ISP domain. 

For how to configure these functions on the access device, see the user guides for the access 
device. 

The following information describes GAM configurations: 

 Guest access user group 

 Guest access operator 

 Guest access logs 

 Guest access system parameters 

 Guest access self-service system 

 Open guest accounts 

 Manage guest accounts 

 Online operator 

 Modify the password 

Managing guest access user group 
An IMC operator can organize the guests into different guest access user groups according to the 
types of guests. Guests in the same group have the same account type, password type and length, 
account expiry period, and access devices.  

An account name is composed of a prefix, serial number, and suffix. The guest accounts in the same 
group have the same prefix and suffix, and are different only in serial numbers. When you create 
guest users in batch, IMC creates accounts according to the account creating rules of the guest 
access user group.  

A guest account has an expiry period. After the period expires, the guest account is invalidated 
automatically.  

In a guest access user group, you must also specify the access devices and device user groups for 
guest users. A guest user can access the network through only the specified access device, and the 
privileges of the guest user are restricted by the access device user group.  

You cannot modify a guest access user group. To do that, delete the group and add a new one.  

This section describes the following functions: 

 Viewing guest access user group list. 

 Adding guest access user group. 

 Viewing guest access user group details. 

 Deleting guest access user group. 

Viewing the guest access user group list 

1. Navigate to Users > Guest Access User Group. 

a. Click the User tab from the top tabular navigation system. 

b. Click Guest Access Manager on the left navigation tree. 

c. Click Guest Access User Group under Guest Access Manager on the left navigation 
tree. 

2. IMC displays all guest access user groups in the List of Guest Access User Groups 
displayed in the main pane of the Guest Access User Group window. 

List of Guest Access User Groups 

 Group Name—Name of the guest access user group.  

 Description—Description of the guest access user group. 
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 Delete—Contains an icon for deleting the associated guest access user group. Click the 

Delete icon  for a guest access user group, and a confirmation dialog box opens. Click 
OK to confirm deletion of the associated guest access user group. 

3. Click Refresh to update the List of Guest Access User Groups. 

4. Click the Group Name or Description column label to sort the List of Guest Access User 
Groups by the selected field. The column label is a toggle switch that lets you toggle between 
the various sort options specific to each field. 

Adding a guest access user group 

1. Navigate to Users > Guest Access User Group. 

a. Click the User tab from the top tabular navigation system. 

b. Click Guest Access Manager on the left navigation tree. 

c. Click Guest Access User Group under Guest Access Manager on the left navigation 
tree. 

2. Click Add. 

3. Configure basic information, including the group name and description, for the guest access 
user group. 

a. Enter the name of the guest access user group in the Group Name field. 

b. Enter the description of the guest access user group in the Description field. 

4. Configure the rule of a batch creating guest accounts. When you batch create guest accounts in 
the guest access self-service system, IMC creates accounts according to the rule of the user 
group. 

a. Select an account type from the Account Type list. Options include: 

 Prefix + Serial Number + Suffix 

 Prefix + Serial Number 

 Serial Number + Suffix 

The prefix and suffix are used to identify guest access users belonging to a guest access 
user group.  

b. Enter a prefix in the Account Prefix field as needed. An account prefix can contain letters 
and digits, and is a string of 1 to 10 characters.  

c. Enter a serial number length in the Serial Number Length field. The serial number length 
must be an integer. It ranges from 3 to 9 and defaults to 5. The serial number length 
determines the number of guest users that you can create in the guest access user group. 
For example, when the serial number length is 4, the available serial numbers are 0001 to 
9999, in other words, you can create up to 9999 guest users.  

d. Enter a suffix in the Account Suffix field as needed. An account suffix can contain letters 
and digits, and is a string of 1 to 10 characters.  

e. In the Account Display Suffix field, enter the account display suffix for the account. The 
account display suffix is displayed after the account. For example, the guest user account is 
BJ0001VIP (where BJ is the prefix, 0001 is the serial number, and VIP is the suffix) and the 
account display suffix is 2F. Then, the full name of the guest access account is 
BJ0001VIP2F. The account display suffix is displayed only when the guest account is 
printed, and is not used when a guest logs in.  

f. From the Password Type list, select a password type for the guest accounts. Options 
include Numbers and Letters, Numbers, and Letters. The password type specifies the 
elements of account passwords. Number and Letters specifies that the password must 
contain numbers and letters. Numbers specifies that the password can contain only 
numbers. Letters indicates that the password can contain only letters.  

g. In the Password Length field, enter the password length for the guest accounts. The 
password length is an integer ranging from 1 to 9. 
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When IMC automatically creates accounts, IMC creates account passwords according to 
the password type and password length you set. 

h. In the Expiry Time field, enter the expiry period (in hours) for the guest accounts. The 
expiry period ranges from 1 to 100000 hours. When the expiry period eclipses after an 
account is created, the account is automatically invalidated and de-registered. 

i. From the Expiry Time Modify list, you can specify whether the expiry period can be 
modified when guest accounts are created. Allowed indicates that you are allowed to 
modify the expiry time when creating guest accounts. Not Allowed indicates that you 
cannot. 

Whether to allow modifying the expiry time depends on the characteristics of guests. For 
guests who have obvious network access time, you can select Not Allowed. 

5. Specify the access devices and device user groups for the guest access user group. 

Users in the guest access user group can access the network through only the specified access 
devices, and their privileges are restricted by the specified device user group. The software 
version of the access device must be Comware Platform Software Version 
COMWAREV500R002B56 or higher.  

Viewing the guest access user group details 

1. Navigate to Users > Guest Access User Group. 

a. Click the User tab from the top tabular navigation system. 

b. Click Guest Access Manager on the left navigation tree. 

c. Click Guest Access User Group under Guest Access Manager on the left navigation 
tree. 

2. Click the group name link of a guest access user group to enter the Details of Guest Access 
User Group page. 

3. Enter the basic information. 

Basic info 

 Group Name—Name of the guest access user group. 

 Description—Description of the guest access user group. 

4. When you batch create guest accounts in the guest access self-service system, IMC creates 
accounts according to the rule of batch creating guest accounts. 

Rule of Batch-Creating Accounts 

 Account Type—Indicates the type of guest access accounts. The account type can be:  

 Prefix + Serial Number + Suffix 

 Prefix + Serial Number 

 Serial Number + Suffix 

 Account Prefix—Prefix of the guest access accounts. This field is displayed when the 
account type is Prefix + Serial Number + Suffix or Prefix + Serial Number.  

 Account Suffix—Suffix of the guest access accounts. This field is displayed when the 
account type is Prefix + Serial Number + Suffix or Serial Number + Suffix. 

 Account Display Suffix—Display suffix for the guest access accounts. When no account 
display suffix is configured, this field is null. For example, the guest user account is 
BJ0001VIP (where BJ is the prefix, 0001 is the serial number, and VIP is the suffix) and the 
account display suffix is 2F. 

Then, the full name of the guest access account is BJ0001VIP2F. The account display 
suffix is displayed only when the guest account is printed, and is not used when a guest logs 
in. 

 Account Range—Range for the guest access accounts. According to the account type, 
suffix, serial number, suffix, and account display suffix configurations, IMC automatically 
calculates the range for the guest access accounts. Suppose the account type is Prefix + 
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Serial Number + Suffix, the prefix is BJ, the serial number length is 5, the suffix is VIP, and 
the account display suffix is 2F, the guest account range is BJ00001VIP-BJ99999VIP. 

 Password Type—Type of the guest account passwords. The password type can be 
Numbers and Letters, Numbers, or Letters. The password type specifies the elements of 
account passwords. 

Number and Letters specifies that the password must contain numbers and letters. 
Numbers specifies that the password can contain only numbers. Letters indicates that the 
password can contain only letters. 

 Password Length—Length of an account password. This field is an integer and ranges 
from 1 to 9. For example, 5 indicates that the password length is 5. 

 Expiry Time—Expiry period of a guest account (in hours). The expiry period ranges from 1 
to 100000. For example, suppose you set the expiry period to 72 hours for guest accounts. 
When 72 hours eclipses after a guest account is created, the guest account is automatically 
invalidated and deregistered from IMC. 

 Expiry Time Modify—Indicates whether the expiry period can be modified when guest 
accounts are created. Allowed indicates that you are allowed to modify the expiry time 
when creating guest accounts. Not Allowed indicates that you cannot. 

5. Device User Group 

Guest users can access the network through only the access devices in the device user group 
list. The privilege level of guest users is determined by the privilege level assigned to the device 
user group. 

 Device IP—IP address of a device. 

 Device Name—Name of a device. The name is made up of the device label and device IP. 

 Device User Group—User group of the device. When the users in the guest access user 
group access the network through the device, the device assigns the access users to the 
user group to controlling the privilege of these access users. 

6. Click Back to return to the List of Guest Access User Groups. 

Deleting a guest access user group 

You cannot delete a guest access user group where guest accounts have been created. To do that, 
first delete all guest accounts created in the guest access user group, and then delete the guest 
access user group. 

To delete a guest access user group: 

1. Navigate to Users > Guest Access User Group. 

a. Click the User tab from the top tabular navigation system. 

b. Click Guest Access Manager on the left navigation tree. 

c. Click Guest Access User Group under Guest Access Manager on the left navigation 
tree. 

2. Click the Delete icon  for the guest access user group you want to delete. A confirmation 
dialog box opens. 

3. Click OK to confirm deletion of the guest access user group. 

Managing guest access operators 
The guest users are managed by guest access operators. An IMC operator can configure users 
added to user management module as guest access operators. In this way, an IMC operator does 
not need to create, manage, and maintain the guest users by himself. Instead, an IMC operator just 
needs to configure some users as the guest access operators. Then, these guest access operators 
can manage the guest users.  
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When configuring a user as a guest access operator, you must configure another account and 
password for the guest access operator. This account is only used for logging in to the guest access 
self-service system.  

When creating a guest access operator, you must specify the guest access user groups that the 
guest access operator can manage, and configure a login control list. After you specify guest user 
access groups for a guest access operator, the guest access operator can create guest accounts for 
the specified groups. A login control list controls the position or area where the operator can log in to 
the guest access self-service system. 

This section describes the following functions: 

 Viewing the guest access operator list. 

 Querying guest access operators. 

 Viewing guest access operator details. 

 Adding a guest access operator. 

 Modifying a guest access operator. 

 Auditing logs of a guest access operator. 

 Deleting a guest access operator. 

Viewing the guest access operator list 

1. Navigate to Users > Guest Access Operator. 

a. Click the User tab from the top tabular navigation system. 

b. Click Guest Access Manager on the left navigation tree. 

c. Click Guest Access Operator under Guest Access Manager on the left navigation tree. 

2. IMC displays all guest access operators in the Guest Access Operator List displayed in the 
main pane of the Guest Access Operator page. 

 Login Name—Name that the guest access operator uses to log in to the guest access 
self-service system. Click the login name link to enter the view guest access operator info 
page. For more information, see "Viewing the guest access user group details." 

 User Name—Username of the guest access operator. A guest access operator is originated 
from a user in the user management module. This field displays the name of the user in the 
user management module. Click the username link to enter the page displaying basic user 
information. For more information about the page, see "Viewing basic user information." 

 Description—Description of the guest access operator. 

 View Log—Contains the link for entering the operation logs of the guest access operator. 
The following operations are logged: the guest access operator logs in to or logs out of the 
guest access self-service system, adds guest users, and deletes guest users. With the log 
auditing function, you can view all the operations performed by the guest access operator, 
and the time and result of each operation. 

 Modify—Contains a link for entering the page for modifying the guest access operator. 

 Delete—Contains a link for deleting the guest access operator. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items 
per page you want to view. 

4. Click the Login Name or User Name column label to sort the Guest Access Operator List by 
the selected field. The column label is a toggle switch that lets you toggle between the various 
sort options specific to each field. 

Querying guest access operators 

1. Navigate to Users > Guest Access Operator. 

a. Click the User tab from the top tabular navigation system. 

b. Click Guest Access Manager on the left navigation tree. 

c. Click Guest Access Operator under Guest Access Manager on the left navigation tree. 
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The Guest Access Operator page opens. 

2. Enter a login name in the upper right corner of the Guest Access Operator List, and click the 

Search icon . 

3. Click the Advanced icon  located in the upper right corner of the Guest Access Operator 
List. 

Specify one or more of the following query criteria: 

 Login Name—Enter a login name in the Login Name field. This field supports fuzzy 
matching. 

 User Name—Enter a username in the User Name field. This field supports fuzzy matching. 

 Description—Enter a description in the Description field. This field supports fuzzy 
matching. 

4. Click Query to submit your query criteria. The results of your query display on the page. 

5. Click Reset to clear your query criteria and to restore the full list of guest access operators. 

Viewing the guest access operator details 

1. Navigate to Users > Guest Access Operator. 

a. Click the User tab from the top tabular navigation system. 

b. Click Guest Access Manager on the left navigation tree. 

c. Click Guest Access Operator under Guest Access Manager on the left navigation tree. 

The Guest Access Operator page opens. 

2. Click the Login Name link of a guest access operator to enter the View Guess Access 
Operator Info page. 

Basic information 

 User Name—Username of the guest access operator. 

 Login Name—Name that the guest access operator uses to log in to the guest access 
self-service system. 

 Password—Password for the login name. 

 Description—Description of the guest access operator. 

 An administrator—Indicates whether the guest access operator is the administrator of the 
guest access self-service system. The administrator here refers to the administrator of 
GAM. If Yes is selected, the operator can view the guest accounts created by all guest 
access operators in the guest access self-service system, and view the online operators in 
the guest access self-service system. If No is selected, the operator can view only the guest 
accounts created by himself, and cannot view the online operators in the guest access 
self-service system. 

3. The Guest Access User Groups to be Managed area displays the guest access user group 
that the guest access operator can manage. 

List of Guest Access User Groups 

 Group Name—Name of the guest access user group. 

 Description—Description of the guest access user group. 

 Number of Devices—Number of access devices set for the guest access user group. The 
guest users in the guest access user group can access the network through only the 
specified access devices, and the privilege of these guest users is restricted by the device 
user group. 

4. The Login Control List area displays the default access control rule and the login control list of 
the operator. Through the default access control rule and the login control list, the position or 
area where the guest access operator can access the network can be controlled. 

Default Access Control Rule—Indicates whether a guest access operator is allowed to 
access the network by default. If Permit is selected, the guest access operator can access the 
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network when the guest access operator accesses the network through an area or terminal out 
of the login control list. If Deny is selected, the guest access operator cannot access the 
network when the guest access operator accesses the network through an area or terminal out 
of the login control list. 

Login Control List 

 Start IP—Start IP address of the control list. 

 End IP—End IP address of the control list. 

 Action—Indicates whether a guest access operator is permitted to access the network 
when the guest access operator accesses the network through a terminal whose IP address 
is in the specified IP address range. Permit means allowing access to the network. Deny 
means denying access to the network. 

 Description—Description of the login control list. 

5. Click Back to return to the Guest Access Operator page. 

Adding a guest access operator 

IMC operators can configure the users in the user management module as guest access operators. 
The login name of a guest access operator can be different from the username in the user 
management module. After you specify a user as a guest access operator, the guest access 
operator can log in to the guest access self-service system to manage guest users.  

To add a guest access operator: 

1. Navigate to Users > Guest Access Operator. 

a. Click the User tab from the top tabular navigation system. 

b. Click Guest Access Manager on the left navigation tree. 

c. Click Guest Access Operator under Guest Access Manager on the left navigation tree. 

The Guest Access Operator page opens. 

2. Click Add to enter the Add Guest Access Operator page. 

3. Select users in the user management module. 

You can select users in one of the following methods: 

 Select existing users in the user management module. 

 Add users. The newly added users are automatically added to the user management 
module. 

This document uses the first method. 

a. Click Select User next to the User Name field. The page for selecting users opens. 

b. Query users. 

You can query users by using basic query or advanced query. If Advanced Query is 
displayed in the upper right corner of the page, you are using basic query. If Basic Query is 
displayed in the upper right corner of the page, you are using advanced query. 

After entering the query criteria, click Query to view the matched users on the user list. 
When all the query criteria are empty, click Query to display all users on the user list. Click 
Clear Results to clear all the query criteria and clear the displayed user list. 

c. Select users. 

Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items 
per page you want to view. Click the radio button next to a username to select the user. 

d. Click OK. The username of the selected user is displayed in the username input box. 

4. Enter a name for the guest access operator in the Login Name field. The name can contain 
letters, numbers, hyphens (-), underlines (_), and spaces. The guest access operator uses the 
name to log in to the guest access self-service system. 

5. Enter the password of the guest access operator in the Password input box. 

6. Enter the same login password again in the Confirm Password input box. 
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7. Enter the description of the guest access operator in the Description input box. 

8. Specify whether the guest access operator is the administrator of the guest access self-service 
system. 

 If you select Yes, the newly added guest access operator is the administrator of the guest 
access self-service system, and can view the guest accounts created by all guest access 
operators and view the online operators. 

 If you select No, the newly added guest access operator is not the administrator of the guest 
access self-service system. Such an operator can view only the guest accounts created by 
himself and cannot view the online operators in the guest access self-service system. 

9. Select guest access user groups that the newly added guest access operator can manage. All 
existing guest access user groups in GAM are displayed in the List of Guest Access User 
Groups. 

Click the checkbox next to a group name to select the group. Alternatively, you can click Add 
Guest Access User Group to enter the page for adding a guest access user group. For more 
information, see "Managing guest access user group." 

Click Refresh to update the List of Guest Access User Groups. 

10. Set the default access control rule. 

Default Access Control Rule—Specifies whether a guest access operator is allowed to 
access the network by default. If you select Permit, the guest access operator can access the 
network when the guest access operator accesses the work through an area or terminal out of 
the login control list. If you select Deny, the guest access operator cannot access the network 
when the guest access operator accesses the network through an area or terminal out of the 
login control list. 

11. Set the login control list. Through the login control list, the position or terminal where the guest 
access operator can access the network can be controlled. In the login control list, the login 
control template takes precedence over the default access control rule. In other words, the 
default access control rule is used to determine whether to permit a guest access operator to 
access the network only when the guest access operator uses an IP address out of the login 
control list to access the network. 

Adding an access control rule 

a. Click Add under the Login Control List. The page for adding an access control rule opens. 

b. You can manually add an access control rule or select one from an existing template. 

Manually adding an access control rule 

a. Select Manually Add. 

b. Enter the start IP address of the access control rule in the Start IP input box. 

c. Enter the end IP address of the access control rule in the End IP input box. 

d. Select an action from the Action list. Options include Permit and Deny. If you select 
Permit, the guest access operator can access the network when the guest access operator 
uses an IP address in the access control rule to access the network. If you select Deny, the 
guest access operator cannot access the network when the guest access operator uses an 
IP address in the access control rule to accesses the network. 

e. Enter the description of the access control rule in the Description input box. 

Selecting an access control rule from an existing template 

a. Select Select from Existing Templates. 

b. Click the checkbox next to a template name to select the template. 

c. Alternatively, you can click the Add Template link to enter the page for adding a login 
control template. For how to add a login control template, see "User groups." 

d. Click OK. The added or selected login control templates are displayed on the login control 
list. 

e. Click the Delete icon  for an access control rule to delete the access control rule. 
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f. If there are multiple access control rules, you can arrange them. When a guest access 
operator accesses network, the operator is matched against the access control rules in the 
login control list in order. When the operator fails to match an access control rule, the 
operator continues to match the next one. 

g. Click the Move Down icon  for an access control rule to move the access control rule 

downwards. Click the Move Up icon for an access control rule to move the access control 
rule upwards. For the access control rule on the top of the list, the move up icon is grayed 

. For the access control rule on the bottom of the list, the move down icon is grayed  

12. Click OK to display the newly added guest access operator on the Guest Access Operator 
List. 

Modifying a guest access operator 

1. Navigate to Users > Guest Access Operator. 

a. Click the User tab from the top tabular navigation system. 

b. Click Guest Access Manager on the left navigation tree. 

c. Click Guest Access Operator under Guest Access Manager on the left navigation tree. 

The Guest Access Operator page opens. 

2. Click the Modify icon  for the guest access operator you want to modify. The page for 
modifying the guest access operator opens. 

3. You cannot modify the username and login name of the guest access operator. 

4. Enter a new password for the guest access operator in the Password input box. 

5. Enter the same login password again in the Confirm Password input box. 

6. Enter the description of the guest access operator in the Description input box. 

7. Specify whether the guest access operator is the administrator of the guest access self-service 
system. 

 If you select Yes, the guest access operator is the administrator of the guest access 
self-service system, and can view the guest accounts created by all guest access operators 
and view the online operators. 

 If you select No, the newly added guest access operator is not the administrator of the guest 
access self-service system. Such an operator can view only the guest accounts created by 
himself and cannot view the online operators in the guest access self-service system. 

8. Select guest access user groups that the guest access operator can manage. All existing guest 
access user groups in GAM are displayed in the List of Guest Access User Groups. 

Click the checkbox next to a group name to select the group. Alternatively, you can click Add 
Guest Access User Group to enter the page for adding a guest access user group. For how to 
add a guest access user group, see "Adding a guest access user group." 

Click Refresh to update the List of Guest Access User Groups. 

9. Set the default access control rule. 

Default Access Control Rule—Specifies whether a guest access operator is allowed to 
access the network by default. If you select Permit, the guest access operator can access the 
network when the guest access operator accesses the work through an area or terminal out of 
the login control list. If you select Deny, the guest access operator cannot access the network 
when the guest access operator accesses the network through an area or terminal out of the 
login control list. 

10. Set the login control list. Through the login control list, the position or terminal where the guest 
access operator can access the network can be controlled. In the login control list, the access 
control rule takes precedence over the default access control rule. In other words, the default 
access control rule is used to determine whether to permit a guest access operator to access 
the network only when the guest access operator uses an IP address which is not in the login 
control list to access the network. 
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Adding an access control rule 

a. Click Add under the Login Control List. The page for adding an access control rule opens. 

b. You can manually add an access control rule or select one from an existing template. 

Manually adding an access control rule 

a. Select Manually Add. 

b. Enter the start IP address of the access control rule in the Start IP input box. 

c. Enter the end IP address of the access control rule in the End IP input box. 

d. Select an action from the Action list. Options include Permit and Deny. If you select 
Permit, the guest access operator can access the network when the guest access operator 
uses an IP address in the access control rule to access the network. If you select Deny, the 
guest access operator cannot access the network when the guest access operator uses an 
IP address in the access control rule to accesses the network. 

e. Enter the description of the access control rule in the Description input box. 

Selecting an access control rule from an existing template 

a. Select Select from Existing Templates. 

b. Click the checkbox next to a template name to select the template. 

c. Alternatively, you can click Add Template to enter the page for adding a login control 
template. For how to add a login control template, see "User groups." 

d. Click OK. The added or selected login control templates are displayed on the login control 
list. 

e. Click the Delete icon  for an access control rule to delete the access control rule. 

f. If there are multiple access control rules, you can arrange them. When a guest access 
operator accesses the network, the operator is matched against the access control rules in 
the login control list in order. When the operator fails to match an access control rule, the 
operator continues to match to the next one. 

g. Click the Move Down icon  for an access control rule to move the access control rule 

downwards. Click the Move Up icon  for an access control rule to move the access 
control rule upwards. For the access control rule on the top of the list, the move up icon is 

grayed For the access control rule on the bottom of the list, the move down icon is 

grayed  

11. Click OK to confirm the modification and return to the Guest Access Operator List page. 

12. Click Cancel to cancel the modification and return to the Guest Access Operator List page. 

Auditing logs of a guest access operator 

All operations of guest access operators are logged. An IMC operator can use the log auditing 
function to determine whether the operations of the guest access operators are normal and thus the 
network remains secure. To audit logs of a guest access operator: 

1. Navigate to Users > Guest Access Operator. 

a. Click the User tab from the top tabular navigation system. 

b. Click Guest Access Manager on the left navigation tree. 

c. Click Guest Access Operator under Guest Access Manager on the left navigation tree. 

The Guest Access Operator page opens. 

2. Click the View Log icon  in the View Log column for the guest access operator you want to 
audit. The page displaying the guest access logs opens. For more information, see "Using 
guest access logs." 

Deleting a guest access operator 

You cannot delete an online guest access operator. 
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To delete a guest access operator: 

1. Navigate to Users > Guest Access Operator. 

a. Click the User tab from the top tabular navigation system. 

b. Click Guest Access Manager on the left navigation tree. 

c. Click Guest Access Operator under Guest Access Manager on the left navigation tree. 

The Guest Access Operator page opens. 

2. Click the Delete icon  for the guest access operator you want to delete. A confirmation dialog 
box opens. 

3. Click OK to delete the guest access operator. 

Using guest access logs 
The guest access logs record all operations performed by guest access operators and the result of 
each operation. The operations include logging in to and logging out of the guest access self-service 
system, adding guest accounts, and deleting guest accounts. An IMC operator can use the guest 
access log auditing function to determine whether the operations of the guest access operators are 
normal and thus the network remains secure.  

This section describes the following functions: 

 Viewing the guest access log list. 

 Querying guest access logs. 

 Viewing the guest access log details. 

Viewing the guest access log list 

To view the guest access log list: 

1. Navigate to Users > Guest Access Log. 

a. Click the User tab from the top tabular navigation system. 

b. Click Guest Access Manager on the left navigation tree. 

c. Click Guest Access Log under Guest Access Manager on the left navigation tree. 

2. IMC displays all guest access logs in the List of Guest Access Logs displayed in the main 
pane of the Guest Access Log window. 

List of Guest Access Logs 

 Guest Access Operator—Guest access operator who performs the operation. 

 IP Address—IP address of the terminal that the guest access operator uses to access the 
network.  

 Operation Time—Time when the guest access operator performs the operation. 

 Description—Description of the operation. The description helps the IMC operator to know 
the operation details. 

 Result—Result of the operation that the guest access operator performs. The operation 
result can be Success, Partial Success, or Failure. 

 Details—Contains a link for entering the page showing the log details. Click the  link to 
enter the page displaying log details. For more information, see "Viewing the guest access 
log details." 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items 
per page you want to view. 

4. If the List of Guest Access Logs spans multiple pages, use the following aids to navigate the 
list: 

 Click  to page forward in the List of Guest Access Logs. 
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 Click  to page backward in the List of Guest Access Logs. 

 Click  to page forward to the end of the List of Guest Access Logs. 

 Click  to page backward to the front of the List of Guest Access Logs. 

5. Click the Guest Access Operator, IP Address, Operation Time, Description, or Result 
column label to sort the List of Guest Access Logs by the selected field. 

Querying guest access logs 

An IMC operator can search the guest access logs by setting the query criteria. Query includes basic 
query and advanced query. Basic query helps you search guest access logs by guest access 
operators. Advanced query helps you search guest access logs by guest access operators, IP 
addresses, results, start time, end time, and descriptions. Basic query and advanced query are 
introduced in the following information. 

An IMC operator can search the guest access logs more accurately by using advanced query. The 
query criteria for advanced query include guest access operator, IP address, result, start time, end 
time, and description. 

To query guest access logs: 

1. Navigate to Users > Guest Access Log. 

a. Click the User tab from the top tabular navigation system. 

b. Click Guest Access Manager on the left navigation tree. 

c. Click Guest Access Log under Guest Access Manager on the left navigation tree. 

2. Enter a guest access log name in the field in the upper right corner of the Guest Access Log 

page, and click the Search icon , or click the Advanced icon  located in the upper right 
corner of the page. 

The search criteria dialog box opens. 

3. Enter a partial or complete name for the guest access operator in the Guest Access Operator 
field. This field supports fuzzy matching. For example, when you enter Ella, all guest access 
operators whose names contain Ella are searched. This field is case-insensitive. 

4. Enter the IP address of the terminal that the guest access operator uses to access the network 
in the IP Address field. This field supports fuzzy matching. For example, when you enter 
192.168, all the logs whose guest access operator login addresses contain 192.168 are 
searched. 

5. From the Result list, select Success, Partial Success, or Failure to filter the guest access 
logs by the operation result. 

6. Enter the start time in the format of YYYY-MM-DD hh:mm in the Start Time input box to filter 
the guest access logs by the start time. You can manually enter a start time or select a start time 
on the calendar. Click the field. The calendar is displayed. On the calendar, select the start 
date, and enter the hh:mm in the Time input box on the bottom. After selecting the start time, 
you can adjust the start time in the Start Time input box. 

7. Enter the end time in the format of YYYY-MM-DD hh:mm in the End Time input box to filter the 
guest access logs by the end time. You can manually enter an end time or select an end time on 
the calendar. Click the field. The calendar is displayed. On the calendar, select the end date, 
and enter the hh:mm in the Time input box on the bottom. After selecting the end time, you can 
adjust the end time in the End Time input box. 

8. Enter the description of the access logs to be queried in the Description input box to filter the 
access logs by the description. This field supports fuzzy matching. For example, when you 
enter Add guest account, all the logs whose descriptions contain Add guest account are 
displayed. 

9. Click Query to submit your query criteria. The results of your query are displayed on the page. 
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10. Click Reset to clear your query criteria and to restore the full list of guest access logs. 

Viewing the guest access log details 

1. Navigate to Users > Guest Access Log. 

a. Click the User tab from the top tabular navigation system. 

b. Click Guest Access Manager on the left navigation tree. 

c. Click Guest Access Log under Guest Access Manager on the left navigation tree. 

2. Click the Details  icon in the Details column for the guest access log you want to view. The 
page displaying the guest access log details opens. 

Log details 

 Guest Access Operator—Name of the guest access operator who performs the operation. 

 IP Address—IP address of the terminal that the guest access operator uses to access the 
network when the guest access operator is performing the operation. 

 Result—Result of the operation. The operation result can be Success, Partial Success, or 
Failure. 

 Operation Time—Time when the guest access operator performs the operation. 

 Description—Description of the operation. The description helps the IMC operator to know 
the operation details. 

3. Click Back to return to the List of Guest Access Logs. 

Configuring Guest Access system parameters 

In the guest access system parameters, you can set the idle timeout period for the operator. After the 
guest access operator logs in to the guest access self-service system, if the operator performs no 
operation within the idle timeout period, the operator is automatically logged out. 

To configure Guest Access System Parameters: 

1. Navigate to Users > Guest Access System Parameters. 

a. Click the User tab from the top tabular navigation system. 

b. Click Guest Access Manager on the left navigation tree. 

c. Click Guest Access System Parameters under Guest Access Manager on the left 
navigation tree. 

2. In the Operator Idle Timeout field, enter the maximum idle period. The parameter is an integer 
ranging from 1 to 1800. 

3. Click OK to make the configuration take effect. 

Using the guest access self-service system 
After you specify a user as a guest access operator, the guest access operator can use the account 
to log in to the guest access self-service system. Then, the guest access operator can manage guest 
accounts (including adding and deleting guest accounts) and modify his password.  

After the guest access operator creates guest accounts, the operator can print the guest accounts 
one by one or in a batch and give the guest accounts to guests. Then, the guests can use the guest 
accounts to access the network.  

If a guest does not need to access the network before the guest account expires, the guest access 
operator can delete the guest account from the guest access self-service system.  

This section describes the following functions: 

 Logging in to the guest access self-service system. 

 Opening guest accounts. 

 Managing guest accounts. 
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 Viewing online operators. 

 Modifying the password. 

Logging in to the guest access self-service system 

You can log in to the guest access self-service system only after deploying the GAM. For how to 
deploy a component, see the HPE IMC deployment guides. 

Log in to the guest access self-service system in one of the following ways: 

 Enter http://192.168.4.40:8080/gam in the address bar of the browser to enter the page for 
logging in to the guest access self-service system. Enter the account name and password of the 
guest access operator, and click Login to enter the home page of the guest access self-service 
system. 

192.168.4.40 is the IP address of the master IMC server, and 8080 is the HTTP protocol port 
(8080 by default) set when IMC is deployed for the first time. 

 Enter http://192.168.4.40:8080/imc in the address bar of the browser to enter the page for 

logging in to IMC. Point to the  icon in the upper right corner of the page. A floating menu 
appears. Select IMC Guest Access Self-Service System from the floating menu to enter the 
page for logging in to the guest access self-service system. Enter the account name and 
password of the guest access operator, and click Login to enter the home page of the guest 
access self-service system. 

192.168.4.40 is the IP address of the master IMC server, and 8080 is the HTTP protocol port 
(8080 by default) set when IMC is deployed for the first time. 

After you log in, the page in Figure 147 opens. 

Figure 147 Home page of the guest access self-service system 

 
 

The navigation tree on the left provides the following items: 

 Open Account 

 Account Management 

 Online Operator 

 Modify Password 
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The Online Operator item is displayed only when the operator is a GAM administrator. 

In the main pane of the page, there are shortcut links for entering the functional pages. The top 
tabular navigation system provides the Service tab. Click the Service tab to enter the home page of 
the guest access self-service system. 

Opening guest accounts 

You can open guest accounts one by one or in batch. Opening accounts in a batch means to create 
one or multiple accounts according to the rule of batch-creating accounts in the guest access user 
group. The account names and passwords are automatically generated. The account names for the 
accounts in the same guest access user group are in the same format. Opening accounts one by one 
means that the guest access operator manually sets the account name and password. In this way, 
the created account name is not necessarily in the same format as those automatically created in the 
selected guest user group. The following information describes the two methods. 

Opening accounts in batches 

1. Navigate to Services > Open Account. 

Click Open Account in the main pane of the home page to enter the page for opening guest 
accounts. 

Alternatively: 

a. Click Service List in the navigation tree on the left to expand the service list. 

b. Click Open Account under Service List to enter the page for opening guest accounts. 

2. Select Open Accounts In Batch from the Account Opening Type list. 

3. Select a guest access user group from the User Group list for the guest accounts to be 
opened. The list displays only the guest user groups that the guest access operator can 
manage. 

4. The Available Amount input box displays the number of remaining accounts that can be 
opened in the guest access user group. The number of accounts that can be created in a guest 
access user group is determined by the serial number length for guest accounts. For example, 
if the serial number length is 5, you can create up to 99999 guest accounts. 

5. Enter the number of guest accounts to be opened this time in the Amount of Accounts input 
box. Up to 100 accounts can be created each time. 

6. Enter the expiration time in the format of YYYY-MM-DD hh:mm in the Expiration Time input 
box. The guest accounts are automatically invalidated when the expiration occurs. An 
invalidated guest account cannot access the network. You can manually enter an expiration 
time or select an expiration time on the calendar. Click the field. The calendar is displayed. On 
the calendar, select the expiration date, and enter the hh:mm in the Time input box on the 
bottom. After selecting the expiration time, you can adjust the expiration time in the Expiration 
Time input box. 

This option is available only when you select Allowed for Expiry Time Modify for the selected 
guest access user group. For more information about the guest access user groups, see 
"Managing guest access user group." 

7. Select the check box to the left of an authentication method to select the authentication method 
for authenticating the guest accounts' access to the network. Available authentication methods 
include Portal and 802.1X. Before selecting an authentication method here, first determine the 
authentication method configured on the access device. If the authentication method selected 
here is different from that on the access device, the guest accounts cannot pass the 
authentication and access the network. If you select both authentication methods, the 
authentication method configured on the access device is used. 

8. Click OK. Then, IMC begins to create accounts in batch and displays the result of opening 
accounts. 

9. If guest accounts are being created, the upper part of the page displays "Opening account, 
please wait." After the accounts are created, the page displays all the guest accounts created. 

 Serial Number—Serial number of the guest account.  
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 User Group—Name of the guest access user group to which the guest account belongs.  

 Account Name—Name of the guest account.  

 Password—Password of the guest account.  

 Expiration Time—Expiration time of the guest account.  

 Result—Result of opening the guest account. 

 Print—Contains the link for printing the guest account. If the opening account result is not 

Opening account succeeded, this link is not displayed. Click the Print link . Then, the 
Guest Account Print window opens. The fields to be printed include the guest access user 

group name, account name, password, and expiration time. Click the Print link  in the 
upper right corner of the window. The window for setting the printer opens. After setting the 

printer, click Print to print the guest account. To close the window, click . 

10. To print all guest accounts opened this time: 

a. Click the Print All link. Then, the Guest Account Print window opens. 

b. The fields to be printed include the guest access user group name, account name, 
password, and expiration time of each guest account. 

c. Click the Print link  in the upper right corner of the window. The window for setting the 
printer opens. After setting the printer, click Print to print the guest account.  

d. Click the Delete link  to close the Guest Account Print window. 

11. Click Return to Open Account in the upper right corner of the guest account opening result 
page to return to the page for opening guest accounts. 

Opening one account 

1. Navigate to Services > Open Account. 

Click Open Account in the main pane of the homepage to enter the page for opening guest 
accounts. 

Alternatively: 

a. Click Service List in the navigation tree on the left to expand the service list. 

b. Click Open Account under Service List to enter the page for opening guest accounts. 

2. Select Open one Account from the Account Opening Type list. 

3. Select a guest access user group from the User Group list for the guest accounts to be 
opened. The list displays only the guest user groups that the guest access operator can 
manage. 

4. Enter the name of the guest account in the Account Name input box. The account name 
cannot be a, al, all, or admin. Otherwise, the guest account will fail to be opened. 

5. Enter the password of the guest account in the Password input box. The password length is not 
necessarily the same as that set in the selected guest access user group. 

6. Enter the expiration time in the format of YYYY-MM-DD hh:mm in the Expiration Time input 
box. The guest accounts are automatically invalidated when the expiration occurs. An 
invalidated guest account cannot access the network. You can manually enter an expiration 

time or select an expiration time on the calendar. Click the Calendar link . The calendar is 
displayed. On the calendar, select the expiration date, and enter the hh:mm in the Time input 
box on the bottom. After selecting the expiration time, you can adjust the expiration time in the 
Expiration Time input box. 

This option is available only when you select Allowed for Expiry Time Modify for the selected 
guest access user group. For more information about the guest access user groups, see 
"Managing guest access user group." 

7. Select the check box to the left of an authentication method to select the authentication method 
for authenticating the guest accounts' access to the network. Available authentication methods 
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include Portal and 802.1X. Before selecting an authentication method here, first determine the 
authentication method configured on the access device. If the authentication method selected 
here is different from that on the access device, the guest accounts cannot pass the 
authentication and access the network. If you select both authentication methods, the 
authentication method configured on the access device is used. 

8. Click OK. Then, IMC begins to create the account and displays the result of opening the 
account. 

9. If the guest account is being created, the upper part of the page displays "Creating account, 
please wait." After the account is created, the page displays the guest account created. 

 Serial Number—Serial number of the guest account.  

 User Group—Name of the guest access user group to which the guest account belongs.  

 Account Name—Name of the guest account.  

 Password—Password of the guest account.  

 Expiration Time—Expiration time of the guest account.  

 Result—Result of opening the guest account.  

 Print—Contains the link for printing the guest account. If the opening account result is not 
Opening account succeeded, this link is not displayed. 

Click the Print link . Then, the Guest Account Print window opens. The fields to be 
printed include the guest access user group name, account name, password, and expiration 

time. Click the Print link . The window for setting the printer opens. After setting the 
printer, click Print to print the guest account. To close the window, click . 

10. Click Return to Open Account in the upper right corner of the guest account opening result 
page to return to the page for opening guest accounts. 

Managing guest accounts 

A guest access operator can log in to the guest access self-service system to manage the opened 
guest accounts. If the guest access operator is a GAM administrator, the operator can manage the 
guest accounts created by all guest access operators. If the guest access operator is not a GAM 
administrator, the operator can manage only the guest accounts created by himself.  

The guest account management function allows a guest access operator to view the guest accounts 
created, print guest accounts, and delete guest accounts. The following information describes the 
details of guest account management. 

Viewing the guest account list 

1. Navigate to Services > Guest Accounts List. 

Click Account Management in the main pane of the home page to enter the page for 
managing guest accounts. 

Alternatively: 

a. Click Service List in the navigation tree on the left to expand the service list. 

b. Click Account Management under Service List to enter the guest account list page. 

2. If the guest access operator is a GAM administrator, the guest accounts created by all guest 
access operators are displayed in the guest account list. If the guest access operator is not a 
GAM administrator, only the guest accounts created by himself are displayed on the guest 
account list. 

Guest accounts list 

 Account Name—Name of the guest account. 

 User Group—Name of the guest access user group to which the guest account belongs. 

 Creator—Guest access operator who creates the account. This field is displayed only when 
the operator is a GAM administrator. 

 Password—Password of the guest account.  

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 9428



1027 

 Expiration Time—Expiration time of the guest account. 

 Print—Contains a link for printing the guest account.  

Click the Print link . Then, the Guest Account Print window opens. The fields to be 
printed include the guest access user group name, account name, password, and expiration 

time. Click the Print link  in the upper right corner of the window. The window for setting 
the printer opens. After setting the printer, click Print to print the guest account. To close the 
window, click . 

 Delete—Contains a link for deleting the guest account. Click the Delete icon  for the 
guest account you want to modify. A confirmation dialog box opens. Click OK to confirm the 
deletion of the guest account. A deleted guest account cannot be used to access the 
network. 

3. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items 
per page you want to view. 

4. If the guest accounts list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Guest Accounts List. 

 Click  to page forward to the end of the Guest Accounts List. 

 Click  to page backward in the Guest Accounts List. 

 Click  to page backward to the front of the Guest Accounts List. 

5. Click the Account Name, User Group, Creator, Password, or Expiration Time column label 
to sort the Guest Accounts List by the selected field. The column label is a toggle switch that 
lets you toggle between the various sort options specific to each field. 

Querying guest accounts 

1. Navigate to Services > Guest Accounts List. 

Click Account Management in the main pane of the home page to enter the page for 
managing guest accounts. 

Alternatively: 

a. Click Service List in the navigation tree on the left to expand the service list. 

b. Click Account Management under Service List to enter the guest account list page. 

2. Enter the name of the guest account in the Account Name input box as the query criterion. 
This field supports fuzzy matching. For example, when you enter BJ, all the guest accounts that 
contain BJ are searched. 

3. Enter the name of a guest access user group in the User Group input box as the query 
criterion. This field supports fuzzy matching. For example, when you enter group, all the guest 
accounts belonging to guest user groups whose names contain group are searched. 

4. Enter the name of a guest access operator in the Creator input box as the query criterion. This 
field supports fuzzy matching. For example, when you enter a, all the guest accounts created by 
guest access operators whose names contain a are searched. This field is displayed only when 
the operator is a GAM administrator. 

5. Click Query to submit your query criteria. The results of your query are displayed on the page. 

6. Click Reset to clear your query criteria and to restore the full list of guest accounts. 

Viewing the guest account details 

1. Navigate to Services > Guest Accounts List. 

Click Account Management in the main pane of the home page to enter the page for 
managing guest accounts. 

Alternatively: 
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a. Click Service List in the navigation tree on the left to expand the service list. 

b. Click Account Management under Service List to enter the guest account list page. 

2. Click the name of the guest account you want to view, and the page showing the details of the 
guest account opens. 

Guest account details 

 User Group—Name of the guest access user group to which the guest account belongs to.  

 Account Name—Name of the guest account.  

 Password—Password of the guest account.  

 Expiration Time—Expiration time of the guest account.  

 Creator—Name of the guest access operator who creates the account. This field is 
displayed only when the operator is a GAM administrator.  

 Access Authentication Mode—Authentication methods of the guest account. Portal and 
802.1X authentication methods are supported. 

3. Click Back to return to the guest account list page. 

Viewing online operators 

A guest access operator can view the online operators of the guest access self-service system only 
when he is a GAM administrator.  

To view online operators: 

1. Navigate to Services > Online Operator.  

Click Online Operator in the main pane of the home page to enter the page showing the online 
operators. 

Alternatively: 

a. Click Service List in the navigation tree on the left to expand the service list. 

b. Click Online Operator under Service List to enter the page displaying online operators. 

2. IMC displays all online operators in the Online Operators, including the following: 

 Username—Login name of the guest access operator.  

 Session ID—ID of the session between the guest access operator and the guest access 
self-service system.  

 Login Time—Time when the guest access operator logs in this time.  

 Login IP—IP address that the guest access operator uses to log in to the guest access 
self-service system. 

3. Click Refresh to refresh the Online operators. 

Modifying the guest operator password 

A guest access operator can modify only his own password. 

To modify the password: 

1. Navigate to Services > Modify Password.  

Click Modify Password in the main pane of the homepage to enter the page for modifying the 
password. 

Alternatively: 

a. Click Service List in the navigation tree on the left to expand the service list. 

b. Click Modify Password under Service List to enter the page for modifying the password. 

2. Enter the current password of the guest access operator in the Old Password input box. 

3. Enter a new password in the New Password input box. 

4. Enter the new password again in the Confirm New Password input box. 
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5. Click OK to modify the password. When the guest access operator logs in to the guest access 
self-service system the next time, the new password must be used. 
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Reporting in IMC 
From the Report tab, you can quickly and easily access IMC template driven reports on network 
assets, configuration and configuration changes, network device and link status and events, alarms, 
and network device health. In addition, you can access reports on network user and service activity 
and device and link details.  

There are two types of report categories: Real Time and Custom. The Real Time category offers 
resource statistics, configuration and change, fault or alarm and performance reporting on network 
devices and interfaces, users and services. You can schedule Real Time reports with format options 
including PDF, CSV, or Microsoft Excel. Scheduled reports are stored on the IMC server for later 
viewing and downloading. 

Custom reports are informational only. There are two types of custom reports–device and link. 
Device detail reports include information on device label, status, IP address, MAC address, device 
type, model, vendor, location, contact, SysOID, hardware version, software version, serial number 
and product number for managed devices. Custom reports based on link details include information 
on devices connected to either end of a link. This information includes device name, port, IP 
address, and port speed. 

All reporting under the Report tab is template driven with reports being generated from the system or 
from user-defined templates. For Real Time reports, IMC provides many system-defined templates 
that you can use to create their custom report views as well as to schedule reports. 

Templates are also used for custom reports. You can create your own templates for custom reports 
through the use of step-by-step configuration and include the reports based on the created 
templates in your report views.  

The Report main page, accessed through the Report tab is a blank page that can be customized to 
meet individual reporting needs. Using the Add My Real Time Report and the Add My Custom 
Report links, you can customize the Report main page to include those reports that are most useful 
to you. Once a report is added to the Report main page, you can access them by clicking the report 
name link and entering report parameters, including date and time, to access the information they 
need quickly. You must first create the reports using the report templates for Real Time reports or 
create the templates for Quick reports before you can add them to your customized My Reports 
page. 

In addition to Web views of reports, you can also schedule Real Time reports that are written to 
Adobe Acrobat, Microsoft Excel, or Comma Separated Value formats. Scheduled reports can also 
be sent through mail in Adobe Acrobat, Microsoft Excel, or Comma Separated Value formats. 

Finally, you can incorporate data from other IMC sources for inclusion in Real Time reporting and you 
can also add your own name or company name and logo to all Real Time reports. 

My report templates 
The base version of IMC provides a number of pre-defined report templates that allow you to obtain 
a wide range of information about the health and performance of network resources from network 
discoveries and topology reports to capacity and optimization reports. Base installation reports also 
include information on alarms as well as network performance. The list of pre-defined report 
templates expands as IMC modules are added to the base installation of IMC. These report 
templates are available to you on the Report Template List page. 

Resource statistics report templates 
Reports found under the Resource Statistics Reports section of My Reports allow you to obtain 
information about devices managed by IMC including device summaries, port utilization and 
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capacity, device connectivity, device changes, and device type. Specifically, the Resource 
Statistics Reports section of the Report Template List includes the following pre-defined reports: 

 Capacity Report—Provides a list of total and available ports for each device managed by IMC. 

The ports available shows the ports that have been down consecutively for seven days. 

 Changes Report—Identifies device changes that have occurred since the last discovery. The 
report reports on the old settings as well as the current or changed settings. 

 Device Asset Report—Filters and displays device asset information (including stack 
information and slot information) by device view. 

 Device Asset Report(Concise)—Filters and displays device asset information (including 
stack information) by device view. 

 Device Category Statistic Report—Provides a distribution of devices by IMC category or 
type. For more information about device categories, see "Configuring device categories." 

 Device History Report—Provides a history of configuration changes to devices including 
device label changes and configuration changes to interface status. 

 Device Summary Report—Provides a statistical summary of devices managed by IMC. It 
reports on the distribution of devices by device category, by status, and by vendor. It also 
provides you with a distribution of device alarm status by IP segment. 

 Discovery Report—Provides a list of problems that IMC encountered while performing a 
network discovery. 

 Inventory Report—Lists all devices discovered by IMC by MAC address and by the IP address 
of the access device that the MAC address is associated with. 

 Misconfigurations and Optimizations Report—Identifies devices that are configured with 
the default SNMP read and write community strings. 

 Topology Report—Provides a list of all devices managed by IMC and to the devices they 
connect. For both devices, IMC provides the device name, IP address, device type, port 
information, and the status of this link. 

 Unused Interface Report—Provides a list of unused interfaces on a device managed by IMC. 

 User Tracking Report—Describes MAC information on the switch devices managed by IMC. 

 Device Model Statistics Report—Provides the device quantity for each device model. 

 Device Status Report——Describes the status of each selected device.  

Alarm analysis reports 
Reports found under the Alarm Analysis Reports section of My Reports allow you to obtain 
information about failures on devices, interfaces, and links managed by IMC including availability 
statistics, outage durations, distribution statistics on outage durations, and causes when the cause is 
available. Statistics can be collected for all Alarm Analysis Reports. Specifically, the Alarm 
Analysis Reports section of the Report Template List includes the following pre-defined reports: 

 Device Connectivity Detail Report—Provides details for devices that reported availability 
problems. This report includes statistics on the duration of downtime, distribution of the length 
of the outage in minutes, and the cause for the outage when available. 

 Device Connectivity Summary Report—Provides availability statistics for devices managed 
by IMC. This report also includes statistics on outage duration and a distribution of outage 
durations for each device. 

 Interface Connectivity Detail Report—Provides details for interfaces that reported availability 
problems. This report includes statistics on the duration of downtime, distribution of the length 
of the outage in minutes, and the cause for the outage when available. 

 Interface Connectivity Summary Report—Provides availability statistics for the interfaces of 
devices managed by IMC. This report also includes statistics on outage duration and a 
distribution of outage durations for each interface. 
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 Link Connectivity Detail Report—Provides details for links that reported availability 
problems. This report includes statistics on the duration of downtime, distribution of the length 
of the outage in minutes, and the cause for the outage when available. 

 Link Connectivity Summary Report—Provides availability statistics for the links managed by 
IMC. This report also includes statistics on outage duration and a distribution of outage 
durations for each link. 

Performance analysis summary reports 
 Custom View Data Summary Report—Provides you with a template for the historical 

reporting of a single performance metric for devices in the select Custom View. On the Set 
Parameter page, set the start and end time, select an index name, click Select to select one or 
more devices, and then click OK to generate a report. 

 Performance View Summary Report—Provides you with a template for the historical 
reporting for devices by performance metric. You must select the performance metric or monitor 
index to be reported on, the date and time range as well as the devices to be included in the 
report by selecting on the Performance View that contains the devices. The contents of the 
Detail field provide you with a link to viewing more detailed information for the associated entry. 

 Performance View All Summary Report—Provides you with a template for the historical 
reporting for all monitor indexes. You must select the date and time range as well as the devices 
to be included in the report by selecting on the Performance View that contains the devices. 
The contents of the Detail field provide you with a link to viewing more detailed information for 
the associated entry. 

For operators who have already customized their My Real Time Reports page, some of these 
reports may no longer be visible. 

To reset your My Real Time Reports page, click Reset My Reports located in the far right 
corner of the My Real Time Reports page. For more information about this feature, see 
"Customizing my real time report page" 

Intelligent Configuration Report 
Intelligent Configuration Report allows you to view the statistical results of auto deployment plan 
execution and auto backup plan execution by devices. Intelligent Configuration Report includes the 
following pre-defined report templates: 

 Auto Deployment Plan Execution Failure Report—Displays information for all devices that 
fail to execute auto deployment plans. If an auto deployment plan is deleted from IMC, the 
report does not collect information for the devices that fail to execute the auto deployment plan. 

 Auto Deployment Plan Execution Result Report—Displays the statistical results of auto 
deployment plan execution in IMC. To view the report, select an auto deployment plan. 

 Auto Deployment Plan Undeployed Device Report—Displays information for devices that 
do not execute auto deployment plans. To view the report, set the minimum number of days that 
devices exist in auto deployment plans. 

 Backup Failed Device Summary Report—Displays information for all devices that fail to 
execute auto backup plans. To view the report, select a backup plan and specify a time range 
during which the auto backup plan is executed. 

Virtual Resource Report 
The Virtual Machine Information Report provides information of virtual machines managed by 
IMC. The information provided includes the name, IP address, CPU, memory, operating system, 
virtual tools, status, resource pool, physical server, data center, vManager, vSphere HA protection, 
DNS name, and startup time.  
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Accessing report template list 
1. Navigate to Report > Report Template List <IMC Instance>: 

a. Click the Report tab from the top tabular navigation system. 

b. Click Reports on the left navigation tree. 

c. Click Report Template List under My Reports on the left navigation tree. 

The report template list page opens. 

Report Template List contents 

 Template Name—Contains the name of the system-defined or user-defined template. 

 Type—Contains the type of report that is generated by the associated template. The IMC 
platform offers five types of report templates. As additional service modules are added, 
report templates for those service modules are added. The base platform report templates 
include: 

 Overall Report—All of the unknown types of user-defined reports.  

 Performance Analysis Report—Provides measurements for almost 300 different 
performance metrics. 

 Resource Statistics Report—Provides distribution statistics of network devices, 
network device change reports, device history, device misconfiguration and optimization 
reports, as well as basic device information reports. 

 Alarm Analysis Report—Provides fault or alarm statistics including device, interface, 
and node connectivity issues. 

 Intelligent Configuration Report—Available when you have installed the iCC module. 
You can customize the intelligent configuration reports and add them to this type.  

 Definition Type—Identifies the source of the template. Template sources include Custom 
and Pre-defined reports. 

 Details—Provides an active link to view additional details for the associated template. 

 Modify—Contains an active link  for modifying the associated template. 

 Delete—Contains an active link  if permitted, for deleting the associated template. 
System or pre-defined templates cannot be deleted. 

You can sort the Report Template list by clicking the Template Name, Type, or Definition 
Type field. The column label is a toggle switch that allows you to toggle between the various 
sort options specific to each field. 

If the report template list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the report template list. 

 Click  to page forward to the end of the report template list. 

 Click  to page backward in the report template list. 

 Click  to page backward to the front of the report template list. 

 Click 8, 15, 50, 100, or 200 at the bottom of the list to configure how many items per page to 
display. 

Querying report templates 

1. Access the report template list page. 

2. In the Query Template area, specify the following query criteria: 

 Template Name—Enter a partial or complete template name. 
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 Type—Select a template type from the Type list. 

Empty fields are ignored. 

3. Click Query. 

The report template list displays all templates that match the specified criteria. To restore the 
query criteria to defaults, click Reset. 

Adding a report template 

You can use predefined report templates, or customize report templates, or custom report templates. 
A custom report template defines display fields in a table. For more information about custom 
templates, see "Custom report templates." Customize report templates by using one of the following 
methods: 

 Directly design report templates in IMC based on data sets provided by IMC modules or 
components. For more information about this method, see "Custom report templates." 

 Import report templates generated by the IMC report designer to IMC. The following information 
describes this method. 

Before adding a report template, make sure report template files have been generated by using the 
IMC report designer. You must specify the data source in a report template file. You can download 
and view the data source file of the current IMC data source by clicking Download Data Source File 
on the report template list page. For more information about generating report template files, see 
related documents about the IMC report designer. 

To add a report template: 

1. Access the Add Report Template page by using either of the following methods: 

 Click the Report tab. From the navigation tree, select Reports > Add Report Template. 

 Click the Report tab. From the navigation tree, select Reports > My Reports > Report 
Template List. On the page that opens, click Add. 

2. Click Upload next to the Template File field and select a report template file on the page that 
opens. 

3. Select a report date source from the Report Data Source list. 

By default, the Report Data Source list uses the current IMC data source. If you want to select 
a data source of lower-level IMC or a data source with the same database type as the current 
IMC data source, first add data sources on the Report Data Source page. For more 
information about adding report data sources, see "Managing report data sources." 

4. Enter a template name in the Template Name field. 

5. Select a template type from the Type list 

6. Select one or more operator groups to allow the operator in the operator groups to access the 
report template. 

By default, the predefined administrator group has access rights to all report templates. 

7. Click OK. 

Modifying a report template 

1. Access the report template list page. 

2. Click the Modify icon  for a report template. 

3. Configure the template name, type, and access rights of operator groups. 

4. Click OK. 

Deleting a report template 

Predefined report templates cannot be deleted. 

1. Access the report template list page. 

2. Click the Delete icon  for a report template. 
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A confirmation dialog box opens. 

3. Click OK. 

Setting access rights for report templates in batches 

Perform this task to configure report templates accessible to an operator group in batches. 

1. Access the report template list page. 

2. Click Access Rights. 

The Set Access rights of Report Template page opens. 

3. Select an operator group from the Operator Group list. 

4. In the report template list, select report templates to allow the specified operator group to 
access the report templates. 

5. Click OK. 

To set access rights of other operator groups, repeat previous steps. 

Custom report templates 
Use the custom report template management function to customize report templates based on data 
sets provided by IMC modules or components. 

Adding a custom report template 

1. Access the Add Custom Report Template page by using either of the following methods: 

 Click the Report tab. From the navigation tree, select Custom Report > Add Custom 
Template. 

 Click the Report tab. From the navigation tree, select Custom Report > Report Template 
List. On the page that opens, click Add. 

2. In the Template Name field, enter a unique name for the custom template. 

3. In the Description field, enter a description for the custom template. 

4. Select the operator groups you want to grant access to the custom report template. 

5. Click Next. 

6. Select a report date set type from the Data Set Type list. 

The options vary by deployment of IMC modules or components. 

7. Select a data set from the Data Set list. 

8. Click Next. 

9. Design the report list for the custom report template: 

a. On the navigation tree, click the Expand icon  next to Data Fields. 

b. Drag data fields to icons that are displayed in the list in the main pane.  

Drag a data field to the icon in the left side or right side of a column to add the data field to 
the left side or right side of the column. 

To modify the rank of a column, click the Left icon  or Right icon  next to the column. 

To modify a column name, click the column name and enter a new name. 

To delete a column from the list, drag the column name from the list to the Data Fields area. 

10. Design the analysis chart for the custom report template: 

a. On the navigation tree, click the Expand icon  next to Analysis Charts. 

b. Drag a chart to the chart area in the main pane. 

The available charts vary by the selected data set. 

To delete the chart from the chart area in the main pane, drag the chart from the chart area to 
the Analysis Charts area. 
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11. If you want to filter report statistics data, do the following: 

a. On the navigation tree, click the Expand icon  next to Filters. 

b. Click the Add icon. 

The Add Filter dialog box opens. 

c. Configure the Filter Field, Filter Type, and Filter Value fields. 

Options for the Filter Field include all data fields that have been dragged to the list and can 
serve as filter conditions. Whether a data field can serve as a filter condition depends on the 
data set that contains the data field. 

d. Click OK. 

You can add multiple filters. To delete a filter, click the Delete icon  for the filter. 

12. Click Finish. 

The Custom Report Template List page opens and displays the new custom report template 
in the list. 

Viewing the custom report template list 

1. Click the Report tab. 

2. From the navigation tree, select Custom Report > Report Template List.  

The system displays all custom report templates in the custom report template list. 

Custom Report Template List contents 

 Template Name—Name of the custom report template. 

 Type—Type of the custom report template. The type depends on the selected data set. 

 Template Content—Type of the display content of the custom report template. The content 
depends on the selected data set. 

 Details—Contains a Details icon  that allows you to view details for a template. 

 Modify—Contains a Modify icon  that allows you to modify a template. 

 Delete—Contains a Delete icon  that allows you to delete a template. 

You can sort the custom report template list by clicking the Template Name, Type, or 
Template Content field. The column label is a toggle switch that allows you to toggle between 
the various sort options specific to each field. 

If the custom report template list spans multiple pages, use the following aids to navigate the 
list: 

 Click the Next Page icon  to page forward in the custom report template list. 

 Click the Last Page icon  to page forward to the end of the custom report template list. 

 Click the Previous Page icon  to page backward in the custom report template list. 

 Click the First Page icon  to page backward to the front of the custom report template 
list. 

 Click 8, 15, 50, 100, or 200 at the bottom of the list to configure the number of items per 
page to display. 

You can query templates by template name or template type. 

 To query templates by template name, enter a template name in the Template Name field, 
and then click Query. 

 To query templates by template type, select a template type from the Type list, and then 
click Query. 
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Modifying a custom report template 

1. Access the custom report template list. 

2. Click the Modify icon  for a custom report template. 

3. Configure custom report template parameters. 

The data set and the data set type cannot be modified. For more information about modifying a 
custom report template, see "Adding a custom report template." 

4. Click Finish. 

Deleting a custom report template 

1. Access the custom report template list. 

2. Click the Delete icon  for a custom report template. 

A confirm dialog box opens. 

3. Click OK. 

Adding custom reports to My Reports 

After you add custom reports to the My Reports page, you can quickly access the custom report 
through the My Reports page. Custom reports are generated based on custom report templates. 

1. Click the Report tab. 

The My Reports page opens. 

2. Click the Add My Custom Report link in the upper part of the page. 

The page for selecting custom report templates opens. 

3. Select one or more custom report templates. 

You can query templates by template name or template type. 

 To query templates by template name, enter a template name in the Template Name field, 
and then click Query. 

 To query templates by template type, select a template type from the Type list, and then 
click Query. 

You can sort the custom report template list by clicking the Template Name, Type, or 
Template Content field. The column label is a toggle switch that allows you to toggle between 
the various sort options specific to each field. 

If the custom report template list spans multiple pages, use the following aids to navigate the 
list: 

 Click the Next Page icon  to page forward in the custom report template list. 

 Click the Last Page icon  to page forward to the end of the custom report template list. 

 Click the Previous Page icon  to page backward in the custom report template list. 

 Click the First Page icon  to page backward to the front of the custom report template 
list. 

 Click 8, 15, 50, 100, or 200 at the bottom of the list to configure the number of items per 
page to display. 

4. Click OK. 

The My Reports page displays all custom reports that are generated based on the selected 
custom report templates in the My Custom Reports area. 
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Customizing my real time report page 
Every IMC operator has a report view that they can customize to meet their individual reporting 
needs and to provide them with quick access to the reports they use most frequently. You can 
include any report that is available under the Report tab in your custom view. This custom view is the 
main report page that is accessed by clicking the Report tab. You can add both Real Time and 
custom reports to this main Report view. This view gives you quick and easy access to the reports 
most relevant for them. 

For managing Real Time reports in your Report main page, see "Adding a real time report." 

For managing custom reports in your Report main page, see "Adding a custom report." 

Resetting my report 

 CAUTION: 

Resetting My Report deletes all existing reports and adds all reports available under the Report 
tab. 
 

Upon account creation, the Report main page is blank for all operators. You can elect to have IMC 
populate your Report main page with all Real Time and Custom reports. 

To reset my report: 

1. Click the Report tab from the top tabular navigation system. 

2. Click Reset My Reports located in the upper right corner of the Report main page. 

If you have the IMC platform installed, the page updates to display pre-defined reports 
described in the My Real Time Reports section of this manual. 

If you have additional modules installed, reports for these modules are also displayed on this 
page. 

For more information about managing and customizing the My Real Time Reports page, see 
"Modifying a real time report" and "Deleting a real time report." 

3. Click OK. 

Using real time reports 
You can configure your Report main page to include any of the Real Time reports IMC offers for 
quick and easy access to the report. In addition, you can schedule Real Time reports with format 
options including PDF, CSV, or XLS. Scheduled reports are stored on the IMC server for later 
viewing and downloading. 

Real Time reports are template driven and IMC comes with templates already created for reporting 
on resource statistics, alarms, reporting on 300 performance metrics as well as reports on 
configuration and change management. In addition, IMC allows you to define new templates as 
needed.  

Using these templates, you can run reports directly from templates or you can customize their 
Report main page with those reports you need most. And, you can schedule any Real Time report 
for historical review and analysis. 

Using real time report templates 
Templates drive report creation for Real Time reports, the heart of IMC reporting. IMC provides 
templates for resource statistics, alarm analysis, performance analysis and change and 
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configuration reporting. IMC also supports the creation of user-defined templates for Real Time 
reports in IMC v5.0. 

Running a report using a real time report template 

To run an ad hoc report through a Real Time report template: 

1. Navigate to Report > Report Template List <IMC Instance>: 

a. Click the Report tab from the top tabular navigation system. 

b. Click Reports on the left navigation tree. 

c. Click Report Template List under Reports on the left navigation tree. 

The report template list page opens. 

2. Click the active link in the Template Name field for the report you want to run. 

For some reports, you may be prompted to enter a starting time and an ending time for the 
report as well as other report configuration parameters. 

a. Enter all required parameters. 

b. Click OK. 

The report is displayed on an Intelligent Analysis Report Viewer window. 

Printing a real time report to PDF 

1. Click the Print icon  located on the toolbar on the top of the report. 

2. Select the desired pages from Page Range. 

3. Click Export. 

Exporting a real time report 

1. Click the Export icon  located on the toolbar on the top of the report. 

2. Select the desired export file format from the File Format list. 

3. Select the desired pages from Page Range. 

4. Click Export. 

Modifying a real time report template 

To modify a Real Time report template: 

1. Navigate to Report > Report Template List <IMC Instance>: 

a. Click the Report tab from the top tabular navigation system. 

b. Click Reports on the left navigation tree. 

c. Click Report Template List under Reports on the left navigation tree. 

2. Click the Modify icon  associated with the report template you want to modify. 

3. Modify the name for the template in the Template Name field.  

4. Verify that the name is unique. 

5. Modify the type of report by selecting a new template type in the Type field. 

6. To add or remove group names, do one of the following: 

 Select the group names you want to add. 

 Select the group names you want to remove. 

7. Click OK. 

You cannot modify a Real Time template's Location or Report Data Source. 

Adding a real time report template 

You can create user-defined templates for Real Time reports (usually of the Overall Report type) by 
importing iAR report templates. 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 9441



1040 

To add a Real Time report template: 

1. Navigate to Report > Add Report Template. 

a. Click the Report tab from the top tabular navigation system. 

b. Click Reports on the left navigation tree. 

c. Click Add Report Template under Reports on the left navigation tree. 

2. Click Upload. 

The Upload Template window opens. 

3. Click Browse next to the Template File field to select a template file. 

This step is required and you can only select an RPT file with the file name consisting of letters, 
digits, and underscores (_). 

4. Click Browse next to the Parameter File field to select a parameter file. 

This step is optional and you can only select an XML file with the file name consisting of letters, 
digits, and underscores (_). 

5. Click OK. 

6. Select the data source from the Report Data Source list. 

7. If you have not defined multiple data sources, select Local (127.0.0.1). 

For more information about data source, see "Managing report data sources" 

8. Enter the name for the template in the Template Name field. 

9. Verify that the name is unique. 

10. Select the type of report by selecting a template type in the Type field.  

11. If you are not sure about the template type, select the Overall Report type. 

12. Select the groups to have access to this report by selecting the group names you want to add. 

13. Click OK. 

The Adding Real Time report template function is available without the need of a license in 
IMC trial versions. To use this function in an IMC retail version, you must purchase a license. 

Managing real time reports 
Real Time reports are those reports that offer resource statistics, configuration and change, fault or 
alarm and performance reporting on network devices and interfaces, users and services. You can 
schedule Real Time reports with PDF, CSV, or Microsoft Excel report formatting as options. 
Scheduled reports are stored on the IMC server for retrieval access.  

You can incorporate data from other IMC sources for inclusion in Real Time reporting and also add 
your own name or company name and logo to all Real Time reports. 

Real Time reports are template driven as reports are generated from pre-defined system templates. 
IMC provides many system-defined templates that you use to create your custom report views as 
well as to schedule reporting. User-defined templates are available for Real Time reports in IMC 
v5.0. Operators can use user-defined templates to create their custom report views as well as to 
schedule reporting. 

Adding a real time report 

Adding a report simply makes the report template available on the operator's Report page for quick 
access. Once it is added to the Report main page, operators can run the report, entering the 
required parameters, if any, before viewing the report's contents. 

To add a Real Time report: 

1. Click the Report tab from the top tabular navigation system. 

2. Click Add My Real Time Report located below and next to the tabular navigation system. 

3. Locate the template you want to use for this Real Time report. 
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 Click  to page forward in the Template list. 

 Click  to page forward to the end of the Template list. 

 Click  to page backward in the Template list. 

 Click  to page backward to the front of the Template list. 

4. Click 8, 15, 50, 100, or 200 from the right side of the main page to configure how many items 
per page you want to view. 

5. Select from one of the following: 

 To more quickly access the template you want to create a Real Time report for, sort the 
template list by clicking Template Name or Type. The column labels are a switch for 
toggling between the various sort of options available for each column. 

 To search by template name, enter the name of the template in the Template Name field of 
the Query Template section and click Query to begin your search. 

 To search by template type, select the template type you want to create a report for from the 
Type list and click Query to begin your search. 

 If you do not know what report you want to select, consider the type of information you want 
to examine. There are five types of reports (which can be found in the Type field) that the 
IMC platform offers. They include: 

 Overall Report—All of the unknown types of user-defined reports. 

 Performance Analysis Report—Provide measurements for almost 300 different 
performance metrics. 

 Resource Statistics Report—Provide distribution statistics of network devices, 
network device change reports, device history, device misconfiguration and optimization 
reports as well as basic device information reports. 

 Alarm Analysis Report—Provide you with a fault or alarm statistics including device, 
interface, and node connectivity issues. 

 Intelligent Configuration Report—Available when you install the iCC module. You can 
customize the intelligent configuration reports and add them to this type. 

6. Select the template names for which you want to create Real Time reports. 

7. Click OK. 

The templates you selected are displayed categorized by Report Template type under My 
Real Time Reports in the main pane of the Report page. 

Viewing a real time report 

1. Click the Report tab from the top tabular navigation system. 

2. Click the report name you want to view under the My Real Time Reports [Edit Mode] section 
heading. 

3. Verify that this link displays [Edit Mode] as this confirms that you are in view mode. 

The My Real Time Reports [Edit Mode] section heading is displayed only after you have 
added Real Time reports. 

In addition, the [Edit Mode/View Mode] link is a toggle switch between editing and viewing 
Real Time reports. 

Use the [Edit Mode/View Mode] link to toggle between viewing and editing Real Time reports. 

4. Set any parameters, if any, that you are prompted to set in the Set Parameters dialog box. 

5. Click OK to view the selected report. 

The report is displayed on an Intelligent Analysis Report Viewer window. 
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Printing a real time report 

1. Click the Report tab from the top tabular navigation system. 

2. Click the report name you want to view under the My Real Time Reports [Edit Mode]  
section heading. 

3. Verify that this link displays [Edit Mode] as this confirms that you are in view mode. 

4. Set any parameters, if any, that you are prompted to set in the Set Parameters dialog box. 

5. Click OK to view the select report. 

The report is displayed on an Intelligent Analysis Report Viewer window. 

Printing a real time report to PDF 

1. Click the Print icon  located on the toolbar on the top of the report. 

2. Select the desired page range from Page Range. 

3. Click Export. 

Exporting a real time report 

1. Click the Export icon  located on the toolbar on the top of the report. 

2. Select the desired export file format from the File Format list. 

3. Click Export. 

Modifying a real time report 

Only the report name and description of a Real Time report can be modified. 

To modify a Real Time report: 

1. Click the Report tab from the top tabular navigation system. 

2. Click [Edit Mode] next to My Real Time Reports [Edit Mode]. Verify that this link displays 
[View Mode] as this confirms that you are in edit mode. 

3. Click the Edit icon  next to the report you want to modify. 

4. To modify the display name, delete the existing value in the Display Name field and enter the 
new report name. 

5. To modify the report description, delete the existing description in the Description field and 
enter a new description. 

6. Click OK to accept changes. 

Deleting a real time report 

1. Click the Report tab from the top tabular navigation system. 

2. Click [Edit Mode] next to My Real Time Reports [Edit Mode]. Verify that this link displays 
[View Mode] as this confirms that you are in edit mode. 

3. Click the Delete icon  next to the report you want to delete. 

4. Click OK to confirm deletion. 

Managing report data sources 
IMC enables you to configure other instances of IMC as a data source for reporting, allowing you to 
centralize your reporting. 

Viewing current report data sources 

1. Navigate to Report > Reporting Data Source. 

a. Click the Report tab from the top tabular navigation system. 

b. Click Reports on the left navigation tree. 
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c. Click Report Data Source under Report on the left navigation tree. 

IMC displays all report data sources entries in the Report Data Source pane displayed in 
the main pane of the Report > Report Data Source window. 

Report data 

 Data Source Name—Contains the name of the data source as defined in IMC. The 
name given for the data source in IMC might be different from the actual hostname of 
the device that serves as the data source. 

 Data Source IP—Contains the IP address of the data source host. 

 Description—Produces a description for the data source host. 

 Modify—Contains a link  for modifying the associated Data Source. 

 Delete—Contains a link  if permitted, for deleting the associated Data Source. 
Pre-defined data sources cannot be deleted. 

You can sort the Report Data Source list by the Data Source Name, Data, or Source IP 
fields by clicking the column label to sort the list by the select field. The column label is a 
toggle switch that allows you to toggle between the various sort options specific to each 
field. 

If your Report Data Source list spans multiple pages, use the following aids to navigate the 
list: 

 Click  to page forward in the Report Data Source list. 

 Click  to page forward to the end of the Report Data Source list. 

 Click  to page backward in the Report Data Source list. 

 Click  to page backward to the front of the Report Data Source list. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main page to configure how many entries 
per page to display. 

3. Do one of the following: 

 To search by data source name, enter the name of the data source in the Data Source 
Name field of the Query section and click Query to begin your search. 

 To search by data source IP address, enter the IP address of the data source in the Data 
Source IP field of the Query section and click Query to begin your search. 

Adding a report data source 

1. Navigate to Report > Reporting Data Source. 

a. Click the Report tab from the top tabular navigation system. 

b. Click Reports on the left navigation tree. 

c. Click Report Data Source under Reports on the left navigation tree. 

2. Click Add. 

3. Enter the IP address of the IMC server to serve as the data source in the Data Source IP field. 

4. If the IMC database has been installed on a standalone server, enter the IP address of the 
database server. 

5. Enter the name of the data source as defined in IMC in the Data Source Name field. 

6. Enter a description for this data source in Description field. 

7. Click OK. 

Data Source DB Name is report_db, and cannot be modified. 
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Modifying a report data source 

1. Navigate to Report > Reporting Data Source. 

a. Click the Report tab from the top tabular navigation system. 

b. Click Reports on the left navigation tree. 

c. Click Report Data Source under Reports on the left navigation tree. 

2. Click the Modify icon associated with the data source you want to modify. 

3. Modify the IP address of the IMC server to serve as the data source in the Data Source IP field. 

4. Modify the host name of the IMC server in the Data Source Name field. 

5. Modify the description for this data source in the Description field. 

6. Click OK. 

Data Source DB Name is report_db, and cannot be modified. 

Deleting a report data source 

1. Navigate to Report > Reporting Data Source. 

a. Click the Report tab from the top tabular navigation system. 

b. Click Reports on the left navigation tree. 

c. Click Report Data Source under Reports on the left navigation tree. 

2. Click the Delete icon  associated with the data source you want to delete. 

3. Click OK to confirm deletion of the data source. 

Report options 
You can add your company name and logo to IMC reports. 

To add a company name and logo: 

1. Navigate to Report > Options. 

a. Click the Report tab from the top tabular navigation system. 

b. Click Reports on the left navigation tree. 

c. Click Options under Reports on the left navigation tree. 

2. Enter the name you want displayed on all IMC reports in the Vendor Name field. 

3. Click OK to accept the Vendor Name. 

4. Click Upload. 

The Upload window opens. 

5. Click Browse, select the image to be used as the vendor logo, and then click OK to upload the 
image to the IMC server. 

A JPG file with the max file size of 100K, max dimensions of 128 pixels by 128 pixels, and a file 
name consisting of letters, digits, and underscores (_) is allowed and the image overwrites the 
old file to become effective, depending on the RPT file. 

Scheduling real time reports 
You can schedule any Real Time report to run daily, weekly, monthly, quarterly, semi-annually, or 
annually and define the start dates of data collection for generating scheduled reports and the end 
dates and times for the corresponding scheduled report tasks. In addition, you can configure the 
report formats with options for PDF, CSV, or XLS and include mail recipients for all scheduled 
reports. 
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When reports are scheduled, IMC generates the reports in the specified report format, mails them to 
specified recipients and stores the reports for future access. 

IMC retains all scheduled reports indefinitely. You need to manage the retention of all historical 
reports manually. 

You can also access reports generated by IMC scheduling, or modify, delete, suspend and resume 
scheduled reports. 

Viewing all scheduled reports 
1. Navigate to Report > All Scheduled Reports. 

a. Click the Report tab from the top tabular navigation system. 

b. Click Scheduled Reports on the left navigation tree. 

c. Click All Scheduled Reports under Scheduled Reports on the left navigation tree. 

IMC displays all scheduled report entries in the Scheduled Report list displayed in the 
main pane of the Report > All Scheduled Reports window. 

Scheduled report  

 Scheduled Report Name—Contains the name of the scheduled report. 

The Scheduled Report Name field contains an active link to the detailed information on 
the scheduled report, including last and next execution time. 

 Template Name—Contains template source for the scheduled report. 

 Type—Identifies the type of the report. 

 Status—Provides information on the status of the associated report. 

 History Report—Provides a link to access previously generated reports for the 
associated report. 

 Operation—Provides you with the ability to suspend or resume scheduled report 
generation for the associated report. 

 Modify—Provides you with a link  to modify the associated report. 

 Delete—Contains a link  for deleting the associated report. 

You can sort the Report Template list by the Scheduled Report Name, Template Name, 
Type or Status fields by clicking the column label to sort the list by the select field. The 
column label is a toggle switch that allows you to toggle between the various sort options 
specific to each field. 

If Scheduled Report list spans multiple pages, use the following aids to navigate the list: 

 Click  to page forward in the Scheduled Report list. 

 Click  to page forward to the end of the Scheduled Report list. 

 Click  to page backward in the Scheduled Report list. 

 Click  to page backward to the front of the Scheduled Report list. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items 
per page you want to view. 

Filtering the scheduled report list 

You can filter the Scheduled Report list in these ways: 

 Daily 
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 Weekly 

 Monthly 

 Quarterly 

 Half Yearly 

 Yearly 

1. You can also use the Query Report option located above the Scheduled Report list or filter 
the Scheduled Report list by the template used in the scheduled report. This filters the list for 
only those reports that use the selected template. Do one of the following: 

 Enter the name of the template in the Template Name field of the Query Report section.  

 Search by scheduled report name by entering it in the Scheduled Report Name field of the 
Query Report section. 

2. Click Query to begin your search. 

Adding a scheduled report 
1. Navigate to Report > All Scheduled Reports. 

a. Click the Report tab from the top tabular navigation system. 

b. Click Scheduled Reports on the left navigation tree. 

c. Click All Scheduled Reports under Scheduled Reports on the left navigation tree. 

2. Click Add. 

3. Click Select to select the template for which you want to schedule a Real Time report. 

4. Select the Template Name for which you want to schedule a report. 

 Click  to page forward in the Scheduled Report list. 

 Click  to page forward to the end of the Scheduled Report list. 

 Click  to page backward in the Scheduled Report list. 

 Click  to page backward to the front of the Scheduled Report list. 

5. Click 8, 15, 50, 100, or 200 to configure how many items per page you want to view. 

6. To search for the template: 

 Enter the template name in the Template Name field of the Query Template portion of the 
dialog box. 

 Search by template type by selecting the type of template you want to select from the Type 
list. 

7. Click OK once you have made your template selection. 

You cannot modify the Template Name and the Scheduled Report Name once you have 
created it. 

8. Enter the name for the scheduled report in the Scheduled Report Name field. 

It is useful to include the frequency as well as the report type in the Scheduled Report Name. 

9. Select the data collection period for the scheduled report by selecting the schedule frequency 
you want to apply to this report in the Schedule Type section. 

Options include: 

 Daily 

 Weekly 
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 Monthly 

 Quarterly 

 Half Yearly 

 Yearly 

10. Select the start date for the scheduled report by clicking the Report Start date field in the 
Schedule Type section.  

11. Select the date from the displayed calendar. 

Once you have added a scheduled report, a scheduled report task is added in IMC. IMC checks 
all scheduled report tasks at 4:00 a.m. every day, and generates scheduled reports for tasks 
whose data collection periods are met. 

For example, if you added at 9:00 a.m. on 2010-12-15 a monthly report with the start date of 
data collection on 2010-10-10, IMC would generate at 4:00 a.m. on 2010-12-16 scheduled 
reports with data collection periods from 2010-10-10 00:00 to 2010-11-10 00:00 and from 
2010-11-10 00:00 to 2010-12-10 00:00. 

12. If you want to configure an end date and time for a scheduled report task, select End by in the 
Schedule Time Settings section. 

The Add Scheduled Report window updates to include an End by field. 

13. Select the end date and time for the scheduled report task by clicking the End by field.  

14. Select the date and enter the time from the displayed calendar. 

Once you have defined the end date and time for a scheduled report task, no new scheduled 
report is generated for the task after the end date and time. 

15. Select the report file format for the scheduled report by selecting it from the Report File Format 
list in the Delivery Options section. Options include PDF, CSV, MS Excel, MS Excel 
(Data-Only), XLSX, RTF, and DOCX. 

16. If you want to configure mail recipients for the scheduled report, perform the following tasks: 

a. Select Send by Email. 

b. Enter a mail address, and then click Add to add the mail address to the mail recipient list. 

Repeat this step to add more mail recipients. 

To remove a mail recipient from the list, select the mail recipient and click Remove. 

To test the connectivity between a mail recipient and the IMC server, select the mail recipient 
and click Test. 

IMC sends a mail to the mail recipients (if specified) when generating a scheduled report. 

For IMC to send scheduled reports to mail recipients, the SMTP mail server settings for IMC 
must be configured. For more information about configuring IMC's mail server settings, see 
"Configuring the default mail server settings." 

17. If the report template has parameter settings, click Next to enter the Set Parameter page. 
Otherwise, skip this step and proceed with step 18.  

On the Set Parameter page, perform the following tasks: 

a. Configure the Begin Time and End Time fields to set the start and end time for the specific 
time range in a data collection period.  

The end time must be greater than the start time. The Begin Time and End Time fields 
might not be displayed for some scheduled report templates. 

b. Configure parameters required by the selected scheduled report template. 

18. Click OK. 

Custom reports cannot be scheduled. Only Real Time reports can be scheduled. 
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Modifying a scheduled report 
1. Navigate to Report > All Scheduled Reports. 

a. Click the Report tab from the top tabular navigation system. 

b. Click Scheduled Reports on the left navigation tree. 

c. Click All Scheduled Reports under Scheduled Reports on the left navigation tree. 

2. Click the Modify icon  associated with the scheduled report you want to modify. 

You cannot modify the Template Name and the Scheduled Report Name once you have 
created it. 

3. Change the data collection period for the scheduled report by selecting the schedule frequency 
you want to apply to this report in Schedule Type section. 

Options include Daily, Weekly, Monthly, Quarterly, Half Yearly, and Yearly. 

4. Modify the start date for the scheduled report by clicking the field in the Schedule Type section.  

5. Select the new date from the displayed calendar. 

IMC checks all scheduled report tasks at 4:00 a.m. every day, and generates scheduled reports 
for tasks whose data collection periods are met. 

For example, if you modified at 9:00 a.m. on 2010-12-16 an existing monthly scheduled report 
with the start time of data collection on 2010-10-05, IMC would generate at 4:00 a.m. on 
2010-12-17 scheduled reports with data collection periods from 2010-10-05 00:00 to 
2010-11-05 00:00 and from 2010-11-05 00:00 to 2010-12-05 00:00. 

6. If you want to add an end date and time for a scheduled report task, select End by in the 
Schedule Time Settings section. 

The Modify Scheduled Report window updates to include an End by field. 

7. Select the end date and time for a new or an existing scheduled report task by clicking the End 
by field. 

8. Select the date and enter the time from the displayed calendar. 

Once you have defined the end date and time for a scheduled report task, no new scheduled 
report is generated for the task after the end date and time. 

9. Change the report file format for the scheduled report by selecting it from the Report File 
Format list in the Delivery Options section.  

Options include: 

 PDF 

 CSV 

 MS Excel 

 MS Excel (Data-Only) 

 XLSX 

 RTF 

 DOCX 

10. If you want to add a mail recipient for the scheduled report, select Send by Email. The Modify 
Scheduled Report window updates to include a field next to Send by Email to enter the mail 
address for the mail recipient. 

11. Enter the mail address of the recipient in this field. 

12. To remove a mail recipient, simply delete the entry in the mail recipient field. 

IMC sends a mail to the mail recipient (if specified) when generating a scheduled report. 

If you modify the mail recipient, IMC sends a mail to the new mail address. 

13. If the report template has parameter settings, click Next to enter the Set Parameter page. 
Otherwise, skip this step and proceed with step 14.  

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 9450



1049 

On the Set Parameter page, perform the following tasks: 

a. Configure the Begin Time and End Time fields to set the start and end time for the specific 
time range in a data collection period.  

The end time must be greater than the start time. The Begin Time and End Time fields 
might not be displayed for some scheduled report templates. 

b. Configure parameters required by the selected scheduled report template. 

14. Click OK. 

Accessing scheduled report histories 
IMC stores the histories of scheduled reports. To access scheduled report histories: 

1. Navigate to Report > All Scheduled Reports. 

a. Click the Report tab from the top tabular navigation system. 

b. Click Scheduled Reports on the left navigation tree. 

c. Click All Scheduled Reports under Scheduled Reports on the left navigation tree. 

2. Click the History Report icon  associated with the scheduled report for which you want to 
access histories. 

 Click  to page forward in the History Report list. 

 Click  to page forward to the end of the History Report list. 

 Click  to page backward in the History Report list. 

 Click  to page backward to the front of the History Report list. 

3. Click 8, 15, 50, 100, or 200 to configure how many items per page you want to view. 

4. Click View located to the far right, that is associated with the History Report you want to view. 

5. Follow the online instructions to download and open the history report. 

The file naming conventions for historical reports are YYYYMMDD.ext where YYYY is the 
four-digit value for year, MM is the two-digit value for month, DD is the two-digit value for day, 
and ext is the three-character value for the file format type. 

Deleting scheduled report histories 
1. Navigate to Report > All Scheduled Reports. 

a. Click the Report tab from the top tabular navigation system. 

b. Click Scheduled Reports on the left navigation tree. 

c. Click All Scheduled Reports under Scheduled Reports on the left navigation tree. 

2. Click the History Report icon  associated with the scheduled report for which you want to 
access histories. 

 Click  to page forward in the History Report list. 

 Click  to page forward to the end of the History Report list. 

 Click  to page backward in the History Report list. 

 Click  to page backward to the front of the History Report list. 
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3. Click 8, 15, 50, 100, or 200 to configure how many items per page you want to view. 

4. Select File Name of the reports you want to delete. 

5. Click Delete. 

6. Click OK to confirm deletion of the history reports you want to delete. 

Suspending and resuming scheduled reports 
1. Navigate to Report > All Scheduled Reports. 

a. Click the Report tab from the top tabular navigation system. 

b. Click Scheduled Reports on the left navigation tree. 

c. Click All Scheduled Reports under Scheduled Reports on the left navigation tree. 

2. If the scheduled report is suspended, click the Resume icon  in the Operation field to 
resume the execution of the scheduled report. This Operation field updates to include the 

Suspend icon . 

3. If the scheduled report is active, click the Suspend icon  in the Operation field to suspend 
the execution of the scheduled report. The Operation field updates to include the Resume icon 

. 

Deleting scheduled reports 
1. Navigate to Report > All Scheduled Reports. 

a. Click the Report tab from the top tabular navigation system. 

b. Click Scheduled Reports on the left navigation tree. 

c. Click All Scheduled Reports under Scheduled Reports on the left navigation tree. 

2. Click the Delete icon  associated with the scheduled report you want to delete. 

3. Click OK to confirm deletion of the scheduled report. 

Custom reports 
Custom reports allows you to generate reports based on created templates that contain details about 
devices and links. Reports based on devices details allow you to generate reports that include 
information on device status, label, IP address, MAC address, device type, model, vendor, location, 
contact, sysOID, serialNumber, hardwareVersion, softwareVersion, and productNumber for 
managed devices. 

Custom reports based on link details include information on devices connected to either end of a link. 
This information includes device name, port, IP address, and port speed. 

To generate custom reports for device or link details, you must first create templates based on one of 
these two report types, device or link. Once custom templates have been created, the templates 
become available in the Add My Custom Report dialog box. This enables you to add custom 
reports to their Report main page for quick and efficient access to device and link detailed reports. 

Custom report templates 
Before a custom report can be added to each operator's Report main page, custom report templates 
must be created. Once created, the custom templates become available as the foundation reports 
added to an operator's main Report page through the Add My Custom Report link. 
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Accessing the custom report template list 

1. Navigate to Report > Custom Report Template List: 

a. Click the Report tab from the top tabular navigation system. 

b. Click Custom Reports on the left navigation tree. 

c. Click Report Template List under Custom Reports on the left navigation tree. 

IMC displays all custom report templates in the Custom Report Template list. 

Custom report template 

 Template Name—Contains the name of the user-defined template. 

 Type—Contains the type of report that is generated by the associated template. 

There is just one type of report that the Custom Reports offers: a report based on resource 
information, the Resource Statistics Report. 

 Template Content—Indicates on which type the template is based: Device Details or 
Link Details. 

 Details—Contains a link to more detailed information on the template. 

 Modify—Contains a link  for modifying the associated template. 

 Delete—Contains a link  , if permitted, for deleting the associated template. 

You can sort the Report Template list by the Template Name, Type, or Template 
Content field by clicking the column label to sort the list by the select field. The column label 
is a toggle switch that allows you to toggle between the various sort options specific to each 
field. 

If the Custom Report Template list spans multiple pages, use the following aids to 
navigate the list: 

 Click  to page forward in the Custom Report Template list. 

 Click  to page forward to the end of the Custom Report Template list. 

 Click  to page backward in the Custom Report Template list. 

 Click  to page backward to the front of the Custom Report Template list. 

2. Click 8, 15, 50, 100, or 200 from the right side of the main pane to configure how many items 
per page you want to view. 

3. Do one of the following: 

 To search by template name, enter the name of the template in the Template Name field of 
the Query Template section and click Query to begin your search. 

 To search by template type, select the template type you want to create a report for from the 
Type list and click Query to begin your search. 

Running a report through the custom report template 

1. Navigate to Report > Custom Report Template List: 

a. Click the Report tab from the top tabular navigation system. 

b. Click Custom Reports on the left navigation tree. 

c. Click Report Template List under Custom Reports on the left navigation tree. 

The Custom Report Template list is displayed. 

2. Click the active link in the Template Name field for the custom report you want to run. 

The report is displayed in an Intelligent Analysis Report Viewer window. 
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Exporting a custom report 

1. Click the icon for the file type you want to export located on the toolbar in the upper left corner of 
the report. 

2. Select the type of file you want to export. 

 Click  for Adobe Acrobat Reader. 

 Click  for Microsoft Excel. 

 Click  for Comma Separated Values. 

 Click  for HTML. 

3. Follow the download or export instructions for each file format. 

4. Click OK. 

Adding a custom report template 

1. Navigate to Report > Report Template List: 

a. Click the Report tab from the top tabular navigation system. 

b. Click Custom Reports on the left navigation tree. 

c. Click Report Template List under Custom Reports on the left navigation tree. 

2. Click Add. 

3. Select the template metadata type you want to create by selecting the metadata Name in the 
Quick Report Metadata List. 

 Device Details—Information available from this metadata type includes device label, 
status, IP address, MAC address, device type, model, vendor, location, contact and sysOID, 
serialNumber, hardwareVersion, softwareVersion, and productNumber. 

 Link Details—Information available from this metadata type includes device name, port, IP 
address, and port speed for each side of a link. 

4. Click Next. 

5. Select the columns you want to add to the report template by selecting the column names you 
want to add. 

6. Change column order of appearance as needed: 

 To move a column down, click the down arrow key  associated with the column until you 
have moved it to the desired position. 

 To move a column up, click the up arrow key  associated with the column until you have 
moved it to the desired position. 

7. Click Next. 

8. Enter a unique name for this custom template in the Template Name field. 

You cannot change the name of a template once you have created it. 

9. Enter a brief description for this custom template in the Description field. 

10. To grant access to this report template, select the operator groups to which you want to grant 
access. 

11. Click Finish. 

Now that you have created a custom report template, you can add the report to their Report main 
page for quick access. 

Modifying a custom report template 

1. Navigate to Report > Report Template list. 

a. Click the Report tab from the top tabular navigation system. 
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b. Click Custom Reports on the left navigation tree. 

c. Click Report Template list under Custom Reports on the left navigation tree. 

2. Click the Modify icon associated with the report template you want to modify. 

3. Do one of the following: 

 To remove columns from the template, clear the check boxes for the column names. 

 To add columns from the template, select the column names. 

 To move a column down, click the down arrow key  associated with the column until you 
have moved it to the desired position. 

 To move a column up, click the up arrow key  associated with the column until you have 
moved it to the desired position. 

4. Click Next. 

5. Modify the description as needed in the Description field. 

6. Do one of the following: 

 To change access to this report template, select the operator groups to which you want to 
grant access. 

 To remove operator groups, click the checked boxes  to the left of the operator groups for 
which you want to revoke access. 

7. Click Finish. 

Deleting a custom report template 

1. Navigate to Report > Report Template List: 

a. Click the Report tab from the top tabular navigation system. 

b. Click Custom Reports on the left navigation tree. 

c. Click Report Template List under Custom Reports on the left navigation tree. 

2. Click the Delete icon  associated with the report template you want to delete. 

3. Click OK to confirm deletion of the selected template. 

Managing custom reports 
Once custom report templates have been created, they become available for adding to each 
operator's custom My Reports view. You add custom reports to this view through user-defined 
templates. For more information about creating Custom Report Template, see "Custom report 
templates." 

Adding a report makes the report template available on the operator’s Report page for quick access. 
Once it is added to the Report main page, you can run the report, entering the required parameters, 
if any, before viewing the report's contents. 

Adding a custom report 

1. Click the Report tab from the top tabular navigation system. 

2. Click Add Custom Report located below and next to the tabular navigation system. 

3. Locate the template you want to use for this custom report. 

4. If the Custom Report Template list spans multiple pages, use the following aids to navigate 
the list: 

 Click  to page forward in the Template list. 

 Click  to page forward to the end of the Template list. 
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 Click  to page backward in the Template list. 

 Click  to page backward to the front of the Template list. 

5. To more quickly access the template you want to create a custom report for, do one of the 
following: 

 Sort the template list by clicking Template Name, Type, or Template Content, or 

 Search by template name by entering the name of the template in the Template Name field 
of the Query Template section and clicking Query to begin your search, or 

 Click Reset to reset the search. 

6. Select the template names for which you want to create custom reports. 

7. Click OK. 

The templates you select now are displayed categorized by Report Template type under My 
Custom Reports in the main pane of the Report page. 

Viewing a custom report 

1. Click the Report tab from the top tabular navigation system. 

2. Click the report name you want to view under the My Custom Reports [Edit Mode] section 
heading. 

3. Verify that this link displays [Edit Mode] as this confirms that you are in View Mode. 

The My Custom Reports [Edit Mode] section heading is displayed only after you have 
added custom reports. 

In addition, the [Edit Mode/View Mode] link is a toggle switch between editing and viewing 
custom reports. 

Use the [Edit Mode/View Mode] link to toggle between viewing and editing custom reports. 

4. Click OK to view the select report. 

The report is displayed on an Intelligent Analysis Report Viewer window. 

Exporting a custom report 

1. Click the Report tab from the top tabular navigation system. 

2. Click the report name you want to view under the My Custom Reports [Edit Mode] section 
heading. 

3. Verify that this link displays [Edit Mode] as this confirms that you are in view mode. 

4. Click OK to view the selected report. 

The report is displayed on an Intelligent Analysis Report Viewer window. 

5. To export a custom report, click the icon for the file type you want to export located on the 
toolbar in the upper left corner of the report: 

 Click  for Adobe Acrobat Reader. 

 Click  for Microsoft Excel. 

 Click  for Comma Separated Values. 

 Click  for HTML. 

6. Follow the download or export instructions for each file format. 

7. Click OK. 

Modifying a custom report 

Only the report name and description of a custom report can be modified.  
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To modify these fields: 

1. Click the Report tab from the top tabular navigation system. 

2. Click [Edit Mode] next to My Custom Reports [Edit Mode]. 

3. Verify that this link displays [View Mode] as this confirms that you are in edit mode. 

4. Click the Edit icon  next to the report you want to modify: 

 To modify the display name, delete the existing value in the Display Name field and enter 
the new report name. 

 To modify the report description, delete the existing description in the Description field and 
enter a new description. 

5. Click OK to accept your changes. 

Deleting a custom report 

1. Click the Report tab from the top tabular navigation system. 

2. Click [Edit Mode] next to My Custom Reports [Edit Mode]. 

3. Verify that this link displays [View Mode] as this confirms that you are in edit mode. 

4. Click the Delete icon  next to the report you want to delete. 

5. Click OK to confirm deletion.  
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rule set rule management, 848 
rule set rule modification, 848 
rule set rule optimization, 856 
rule set rule order sorting, 855 
service list service addition (ACL assistant), 766 
service list service modification (ACL assistant), 767 
service list service deletion (ACL assistant), 767 
service list viewing (ACL assistant), 766 
service management (ACL assistant), 766 
service viewing (ACL assistant), 766 
template configuration, 774 
template copying, 793 
template creation, 774, 776 
template deletion, 794 
template exporting, 794 
template list viewing, 775 
template modification, 786 
template rule addition, 794 
template rule copying, 806 
template rule deletion, 807 
template rule management, 794 
template rule modification, 800 
template viewing, 775 
time range addition (ACL assistant), 771 
time range deletion (ACL assistant), 773 
time range list viewing (ACL assistant), 770 
time range modification (ACL assistant), 773 
time range viewing (ACL assistant), 771 
time ranges management (ACL assistant), 770 

use deployment, 894 
use removal from device, 896 
user-defined ACL template creation, 784 
user-defined ACL template modification, 792 
user-defined ACL template rule addition, 800 
user-defined ACL template rule modification, 805 
view ACL page, 865 

action 
Actions—For all devices, 313 
Actions—For switches, 318 
alarm action taking, 683 
attack alarm action execution, 911 
attack alarm action execution (manual), 911 
OneView management action history viewing, 434 

action management 
detailed information viewing, 932 
event configuration, 932 
event viewing, 936 
Last Hour Events report, 939 
page access, 932 
policy addition, 933 
policy deletion, 936 
Policy Execution Result in Last Hour report, 939 
policy history viewing, 936 
policy list page access, 933 
policy management, 932 
policy modification, 935 
report viewing, 939 

adding 
account group, 993 
ACL, 808 
ACL advanced template rules, 796 
ACL rule set, 814 
ACL rule set rule, 848 
ACL template rules, 794 
administrator group operator, 184 
alarm access device, 712 
alarm core device, 713 
alarm forwarding rule, 705 
alarm level configuration rule, 713 
alarm matching policy, 914 
Asset OID, 440 
automatic backup plan, 581 
automatic deployment device, 563 
automatic deployment plan, 562 
compiled MIB to IMC, 207 
compliance policy check task, 615 
configuration check display command, 629 
configuration template manually, 519 
configuration template using backup file, 516 
configuration template using file import, 518 
custom report, 1041 
custom report template, 1040 
custom report templates, 1023 
custom report to My Reports, 1025 
device additional information field, 237 
device group, 196, 402 
device group devices, 197 
device group ungrouped devices, 199 
device list (custom view), 398 
device monitor, 403 
device monitor instance, 726 
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devices in IMC, 244 
devices in IMC (manual), 244 
event configuration entry (device alarm), 930 
event configuration entry (periodic), 931 
filter, 170 
global index settings custom template, 720 
global index settings user-defined monitor, 720 
global VLAN devices, 943 
group monitored settings, 762 
guest access operator, 1004 
guest access user group, 999 
home page space, 39 
home page space widgets, 39 
IMC maintainer, 187 
IMC network topology monitor, 746 
initial configuration file, 576 
IP segment (terminal access), 408 
link ACL template rule, 798 
login control template, 180 
lower-level NMS, 307 
mail alarm notification rule, 696 
maintenance tag task, 394 
net address group (ACL assistant), 769 
network asset manually, 442 
OAP software into library, 529 
operation log chart templates, 224 
operator group, 174 
performance option instance profile, 753 
performance option periodic monitor, 761 
performance option service monitor, 758 
performance view shortcut, 736 
policy, 933 
port group, 304, 453 
real time report template, 1027 
real time reports, 1028 
real-time monitor graph, 750 
real-time monitors, 748 
report data sources, 1031 
report template, 1022 
scheduled report, 1034 
security control policy, 918 
service list service (ACL assistant), 766 
SMS alarm notification rule, 701 
SSH settings (batch mode), 371 
Syslog filtering rule, 669 
time range (ACL assistant), 771 
trap definitions, 654 
trap groups, 664 
user additional information field, 978 
user group, 200 
user subgroup, 200 
user-defined ACL template rule, 800 
user-defined trap filter rule, 639 
users (manual), 975 
view config window view, 112 
viewer group operator, 187 
virtual machine in IMC, 454 
VLAN hybrid port, 954 
VLAN trunk port, 952 
VLAN virtual interface, 949 
vSwitch, 453 
VXLAN tunnel, 972 

VXLANs, 969 
Web desktop application, 146 
Web interface favorite, 102 
workday work period, 232 

address 
access configuration address binding, 423 
network segment address importing, 247 

Advanced Mode configuration comparison, 536 
alarm 

action taking, 683 
alarm analysis reports, 1019 
attack alarm detail viewing, 903 
attack alarm list alarm deletion, 906 
attack alarm list browsing, 902 
attack alarm list querying, 904, 906 
backup policy alarm generation mode setting, 211 
browsing, 682 
data collection all alarms processing, 242 
detail viewing, 682 
Device Details page alarms, 311 
hierarchical NMS alarm configuration, 202 
hierarchical NMS alarm notification configuration, 202 
IMC alarm querying, 684 
Lower-Level System Alarm Statistics, 45 
Lower-Level System Real-Time Alarm, 43 
management, 632 
performance option device memory usage trend alarms 

configuration, 756 
performance threshold modification, 684 
Real-Time Alarm, 45 
real-time alarm action performance (Alarm Details page), 

687 
real-time alarm browsing, 685 
real-time alarm deletion from list (Real-Time Alarms 

page), 688 
real-time alarm detail viewing (Real-Time Alarms page), 

686 
real-time alarm recovery (Real-Time Alarms page), 687 
real-time alarm relation report viewing (Alarm Details 

page), 687 
real-time alarm viewing (filtered), 686 
real-time attack alarm list alarm browsing, 906 
real-time attack alarm list alarm deletion, 908 
real-time attack alarm list refreshing, 907 
relation report viewing, 683 
security attack alarm management, 901 
SMSC settings configuration, 204 
sound settings enable, 84 
Syslog message alarms configuration, 672 
Syslog to alarm rule browsing, 676 
Syslog to alarm rule copying, 681 
Syslog to alarm rule disabling, 681 
Syslog to alarm rule enabling, 681 
trap alarms generation, 646 
trap-to-alarm rule copying, 650 
trap-to-alarm rule disabling, 652 
trap-to-alarm rule enabling, 652 
trap-to-alarm rule modification, 650 
trap-to-alarm rule scenario modification, 650 
trap-to-alarm rule viewing, 646 
trap-to-alarm upgrade strategy modification, 649 
Unrecovered Alarm Statistics, 46 
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up/down alarm filter settings modification (batch mode), 
373 

Upper+Lower-Level System Alarm Statistics, 46 
Upper+Lower-Level System Real-Time Alarm, 44 
user-defined Syslog to alarm rule creation, 676 
user-defined Syslog to alarm rule deletion, 681 
user-defined Syslog to alarm rule modification, 679 
user-defined trap-to-alarm rule creation, 647 
view config alarm panel widget configuration, 116 
view config alarm statistics widget configuration, 127 

Alarm Details page 
alarm relation report viewing, 691 
real-time alarm action performance, 687 
real-time relation report viewing, 687 

alarm forwarding 
management, 705 
rule addition, 705 
rule copying, 709 
rule deletion, 710 
rule disabling, 709 
rule disabling (batch), 709 
rule enabling, 709 
rule enabling (batch), 709 
rule modification, 707 

alarm level 
configuration rule addition, 713 
configuration rule deletion, 716 
configuration rule disabling, 715 
configuration rule enabling, 715 
configuration rule modification, 715 
management, 713 

alarm matching policy 
addition, 914 
configuration, 913 
deletion (user-defined), 917 
detailed information viewing, 914 
list viewing, 913 
modification (user-defined), 916 

alarm notification 
configuration, 695 
mail alarm notification management, 695 
SMS alarm notification management, 701 

Alarm Page accessing, 92 
Alarm Statistics 

chart viewing, 693 
user-defined chart creation, 694 
viewing, 693 

Alarm Top5 widget, 43 
Alarm TopN widget, 42 
All Alarms List browsing, 688 
All Alarms page 

action performance, 690, 692 
action performance (All Alarms page), 690, 692 
alarm deletion, 692 
alarm deletion (All Alarms page), 692 
alarm deletion (Root Alarms List), 692 
alarm detail viewing, 690 
alarm exporting (All Alarms page > Microsoft Excel), 692 
alarm querying, 690 
alarm relation report viewing (Alarm Details page), 691 
all alarms list columns customization, 691 
detail viewing (All Alarms page), 690 

querying (All Alarms page), 690 
relationship viewing, 690 

allocating 
allocated IP address querying (terminal access), 409 
IP address manually (terminal access), 410 
IP address using auto scanning (terminal access), 410 
IP address using import IP address (terminal access), 411 
IP addresses (terminal access), 406 

application 
SOA application development model, 21 
Web desktop application, 146 
Web desktop application deletion, 147 
Web desktop application moving, 147 
Web desktop application name modification, 147 
Web desktop application opening, 147 
Web desktop application registration, 146 
Web desktop management, 145 

applying 
ACL, 868 

asset 
device-level network asset detail viewing, 436 
network asset audit options configuration, 228 
network asset list viewing, 435 
network asset querying, 438 
network asset viewing, 435 

Asset Audit List 
querying, 445 
viewing, 444 

asset management 
manual network asset addition, 442 
network asset auditing, 443 
network asset detail view refreshing, 444 
Network Asset Manager, 442 
network asset modification, 442 
network asset property modification, 442 
network asset removal, 444 

Asset OID 
addition, 440 
deletion, 441 
list viewing, 439 
modification, 441 
querying, 440 
using, 439 

At a Glance performance view 
creation, 735 
modification, 738 
viewing, 743 

attack alarm 
action execution, 911 
action execution (manual), 911 
detail viewing, 903 
IPC events, 929 
list alarm deletion, 906 
list browsing, 902 
list querying, 904, 906 
security attack alarm management, 901 
Top 10 attack alarm report, 926 
Top 10 attack destinations report, 926 
Top 10 attack sources report, 926 

attack path map 
attack viewing (single attack), 909 

attack topology map 
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attack viewing, 908 
attack viewing (all attacks), 908 

auditing 
asset audit options configuration, 228 
configuration audits+reports, 498 
configurations, 588 
guest access operator log, 1007 
network asset, 443 

authenticating 
LDAP authentication services configuration, 178 
RADIUS authentication services configuration, 177 
TACACS authentication services configuration, 179 

auto 
Configuration Center auto backup plan, 498 
IP address using auto scanning (terminal access), 410 
virtual machine auto migration configuration, 460 

auto discovering 
devices, 247 

auto discovery 
network segment based method, 247 
plan management, 247 
results viewing, 247 

Automatic Backup Plan 
automatic device backup configuration, 580 
automatic device backup plan addition, 581 
automatic device backup plan deletion, 583 
automatic device backup plan disabling, 583 
automatic device backup plan enabling, 583 
automatic device backup plan list accessing, 580 
automatic device backup plan modification, 582 
backup history viewing, 584 
device configuration backup storage in cipher text, 579 
management, 579 

Automatic Deployment Plan 
automatic backup plan management, 579 
device configuration backup storage in cipher text, 579 
DHCP server configuration, 575 
initial configuration file accessing, 575 
initial configuration file addition, 576 
initial configuration file copying, 577 
initial configuration file deletion, 578 
initial configuration file detailed information viewing, 579 
initial configuration file management, 575 
initial configuration file modification, 577 

Automatic Deployment Plan page 
accessing, 561 
automatic deployment execution results viewing, 574 
device addition, 563 
device detailed information viewing, 563 
device modification, 567 
management, 560 
plan addition, 562 
plan deletion, 562 
plan modification, 562 

background 
Web desktop personalization, 145 

backing up 
backup configuration backup file modification, 504 
backup history failed or partially successful backup, 587 
backup history report accessing, 584 
backup history report detailed information viewing, 586 
backup history report querying, 585 

backup history report viewing, 584 
configuration backup history viewing, 503 
configuration backup report accessing, 588 
configuration backup report file exporting, 589 
configuration backup report file restoration, 589 
configuration backup report querying, 589 
configuration from Configuration Center, 511 
device configuration, 403 
failed backup restarting, 584 

backup policy 
alarm generation mode setting, 211 
mail notification parameter configuration, 213 
max configuration files history days setting, 212 
max configuration files setting, 212 
option configuration, 211 
VPN instance configuration, 213 

Bandwidth Utilization (In) (%)—Top5 widget, 59 
Bandwidth Utilization (In) (%)—TopN widget, 58 
Bandwidth Utilization (Out) (%)—Top5 widget, 61 
Bandwidth Utilization (Out) (%)—TopN widget, 60 
baseline 

baseline removal from baseline software, 533 
batch baselining device configuration, 512 
configuration baseline report file comparison, 591 
configuration baseline report file restoration, 592 
configuration baseline report querying, 591 
configuration baseline report use, 590 
configuration baseline report viewing, 590 
configuration file baseline establishment, 507 
establishment by software library entry, 532 
software baseline establishment, 510 
software baseline report querying, 594 
software baseline report restoration, 594 
software baseline report use, 593 
software baseline report viewing, 593 

Basic User Information page 
user management, 984 

batch 
alarm forwarding rule disabling, 709 
alarm forwarding rule enabling, 709 
mail alarm notification rule disabling, 700 
mail alarm notification rule enabling, 700 
SMS alarm notification rule disabling, 704 
SMS alarm notification rule enabling, 704 
user additional information modification, 988 
user deletion, 989 
user importing (batch mode), 976 
user modification, 990 
user operations, 988 
VLAN access port configuration, 959 
VLAN batch deployment, 959 
VLAN creation by batch deployment, 959 
VLAN hybrid port configuration, 960 
VLAN trunk port configuration, 960 
VXLAN deployment, 964 

batch operations 
baselining device configuration, 512 
device check results viewing, 376 
device configuration, 384 
device configuration guide, 404 
device configuration modification, 377 
device configuration saving, 377, 402 
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device list check access settings, 401 
device list poll interval settings access, 401 
device list SNMP settings access, 400 
device list SSH settings access, 401 
device list Telnet settings access, 400 
device management, 368 
device monitor cancellation, 403 
device plan check results viewing, 376 
device reboot, 402 
device rebooting, 378 
device settings access, 374 
device settings plan creation, 374 
device settings plan list viewing, 375 
device software deployment, 403 
device type configuration, 374 
energy-saving policies implementation, 379 
interface configuration, 390 
LACP configuration, 383 
login type modification, 372 
NETCONF parameter configuration, 370 
ping settings modification, 373 
polling interval configuration, 372 
SNMP configuration (existing template), 369 
SNMP settings configuration, 368 
spanning tree protocol configuration on interface, 382 
spanning tree protocol configuration on switch, 381 
SSH configuration (existing template), 371 
SSH settings configuration, 371 
SSH settings editing (manual), 371 
SSH settings modification, 371 
Telnet configuration, 369 
Telnet configuration (existing template), 370 
Telnet settings editing (manual), 369 
trap destination configuration, 380 
up/down alarm filter settings modification, 373 

binding 
IP-to-MAC address binding, 428 
switch access binding, 426 
terminal access binding, 423 
Unauthorized Access switch access, 418 
Unauthorized Access terminal access, 417 

blocking IMC online operator, 193 
breadcrumb trails (navigation), 95 
browsing 

alarms, 682 
all alarms, 688 
real-time alarms, 685 
real-time attack alarm list alarm, 906 
attack alarm list, 902 
Syslog entries, 665 
Syslog templates, 672 
Syslog to alarm rules, 676 
traps, 633 

calculating 
system calculation resumption, 712 

canceling 
device monitor, 403 
Unauthorized Access action, 418 

changing 
home page space widget layout, 40 

chart 
alarm statistics chart viewing, 693 

user-defined alarm statistics chart creation, 694 
checking 

device access settings (batch mode), 374 
cipher text, 579 
cleaning 

device space, 509 
CleanupParser 

third-party device parser service (CleanupParser) 
definition, 477 

clock 
view config electric clock widget configuration, 118 

collapsing 
all home page space widgets, 40 
home page space widget, 40 

collecting 
data collection configuration, 239 

common service 
third-party device common service (CLICommon), 473 

compare 
configuration compare, 498 

comparing 
configuration baseline report files, 591 
configuration files, 505 
configuration in Configuration Center, 534 
configuration in Configuration Center (Advanced Mode), 

536 
configuration in Configuration Center (Simple Mode), 535 
device configurations, 510, 534 

compiling 
device capability set definition file, 494 
MIB in IMC, 207 
operation definition file, 481 

compliance 
Configuration Center compliance check, 498 

Compliance Check 
check task history deletion, 622 
check task history querying, 621 
check task history use, 620 
check task history viewing, 621 
compliance policy check results viewing, 625 
configuration check display command addition, 629 
configuration check display command deletion, 630 
configuration check display command list, 629 
configuration check display command modification, 630 
configuration check report viewing, 627 
configuration check using display command, 629 
configuration retrieval report viewing, 628 
device violating results viewing, 626 
policy check task deletion, 618 
task execution results use, 623 
task execution results, task execution report, 

configuration retrieval report use, 622 
use, 595 

CompliancePolicy 
aggregate link rule viewing, 611 
check task addition, 615 
check task copying, 617 
check task details, 614 
check task list, 613 
check task modification, 616 
check task querying, 615 
check tasks, 613 
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configuration segment rule viewing, 612 
copying, 608 
creation, 599 
deletion, 608 
detailed information viewing, 596 
device rule viewing, 610 
disabling (all), 609 
disabling (single), 609 
enabling (all), 608 
enabling (single), 608 
interface rule viewing, 610 
link rule viewing, 611 
list viewing, 595 
modification, 604 
querying, 599 
rule detailed information viewing, 597 
rules, 609 
violating device fix, 618 

component 
third-party device component action definition, 474 
third-party device component service definition, 474 
third-party device specific services definition, 475 

Configuration Audit feature, 588 
Configuration Backup Report 

accessing, 588 
file exporting, 589 
file restoration, 589 
querying, 589 
use, 588 

Configuration Baseline Report 
file comparison, 591 
file restoration, 592 
querying, 591 
use, 590 
viewing, 590 

Configuration Center 
accessing, 499 
audits+reports, 498 
auto backup plan, 498 
backup configuration file modification, 504 
backup policy option configuration, 211 
baseline establishment by software library entry, 532 
baseline removal from baseline software, 533 
batch baselining device configuration, 512 
compliance check, 498 
configuration backup, 511 
configuration backup history viewing, 503 
configuration compare, 498 
configuration comparison, 534 
configuration comparison (Advanced Mode), 536 
configuration comparison (Simple Mode), 535 
configuration comparison in General Configuration 

Compare, 537 
configuration comparison results window viewing, 537 
configuration deployment, 510 
configuration file baseline establishment, 507 
configuration file comparison, 505 
configuration file restoration, 505 
Configuration Management page details viewing, 502 
Configuration Management page summary viewing, 502 
configuration management tasks, 326 
configuration restoration, 511 

configuration template creation using Save As, 507 
configuration templates, 497 
configuration+change management, 497 
deployment using IMC Deployment Guide, 537 
device capability set options, 209 
device configuration comparison, 510, 534 
device configuration options, 501 
device querying, 500 
device space cleaning, 509 
file deployment, 512 
file transfer mode options, 210 
latest running configuration viewing, 501 
latest startup configuration viewing, 501 
manual device backups, 584 
OAP software addition to library, 529 
software baseline establishment, 510 
software deployment, 510 
software import into library from device, 528 
software import into library from file, 528 
software import into library from Web download, 529 
software library, 497 
software library entry deleting, 532 
software library entry details viewing, 527 
software library entry exporting, 531 
software library entry modification, 531 
software library entry renaming, 530 
software library entry searching, 527 
software library management, 525 
software library viewing, 526 
software update, 498 
software update history viewing, 507 
using, 498 
VPN instance configuration, 213 

Configuration Management page 
details viewing, 502 
summary viewing, 502 

configuration template 
accessing, 512 
addition manually, 519 
addition using backup file, 516 
addition using file import, 518 
copying, 523 
creation, 515 
deletion, 525 
deployment, 525 
device configuration management, 512 
exporting, 525 
modification, 521 
organization, 514 
querying, 513 
renaming, 522 

Configure—For all devices, 319, 324 
configuring 

ACL devices, 860 
ACL management subnet mask type, 773 
ACL templates, 774 
alarm matching policy configuration, 913 
alarm notification, 695 
automatic device backups, 580 
backup policy options, 211 
Configuration Center device configuration options, 501 
cyclic time range (ACL assistant), 772 
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data collection, 239, 404 
data export, 221 
device alarms, 711 
device categories, 168 
device configuration guide (batch mode), 404 
device groups, 194 
device model, 166 
device series, 165 
device types (batch mode), 374 
device vendor information, 163 
devices (batch mode), 384 
DHCP server, 575 
file transfer mode options, 210 
fixed time range (ACL assistant), 772 
guest access system parameters, 1010 
hierarchical NMS alarm notifications, 202 
hierarchical NMS alarms, 202 
hierarchical NMS default mail server settings, 203 
hierarchical NMS mail server settings, 202 
hierarchical NMS third-party mail server settings, 203 
holiday, 229 
HTTPS access settings, 234 
IMC for hierarchical alarms, 710 
IMC password strategy, 181 
IMC server information, 226 
IMC system settings, 214 
interfaces (batch mode), 390 
LACP (batch mode), 383 
LDAP authentication services, 178 
LiveUpdate, 235 
log files, 223 
logs, 226 
mail notification parameters, 213 
manual device backups, 584 
NETCONF parameters (batch mode), 370 
NETCONF template, 155 
network asset audit options, 228 
OneView management access parameters, 433 
operator group data access rights, 174 
operator group RTM access rights, 175 
performance option common indexes, 754 
performance option default monitor indexes, 757 
performance option device memory usage trend alarms, 

756 
performance option display indexes, 755 
performance option dynamic threshold indexes, 756 
performance option instance profiles, 753 
performance option periodic monitoring, 760 
performance option service monitoring, 757 
performance option TOPN indexes, 755 
polling intervals (batch mode), 372 
PowerShell template, 159 
RADIUS authentication services, 177 
servers in VRM, 453 
SMSC GSM modem, 204 
SMSC other SMS sender, 205 
SMSC settings, 204 
SMSC SMS sender, 205 
SNMP (existing template), 369 
SNMP settings (batch mode), 368 
SNMP templates, 149 
SOAP/HTTP template, 156 

spanning tree protocol on interface (batch mode), 382 
spanning tree protocol on switch (batch mode), 381 
special workdays, 231 
SSH (existing template), 371 
SSH settings (batch mode), 371 
SSH template, 153 
Syslog message alarms, 672 
TACACS authentication services, 179 
Telnet (batch mode), 369 
Telnet (existing template), 370 
Telnet template, 151 
user groups, 199 
view, 109 
view config device state overview widget, 133 
view config Device Unreachability Top5 widget, 135 
view config device view widget, 135 
view config Memory Utilization Top5 widget, 132 
view config user-defined widget, 134 
view config window alarm panel widget, 116 
view config window alarm statistics widget, 127 
view config window converged topology widget, 131 
view config window CPU Utilization Top5 widget, 125 
view config window custom topology widget, 130 
view config window Custom View Top5 widget, 126 
view config window Device Response Time Top5 widget, 

128 
view config window electric clock widget, 118 
view config window important device monitor widget, 

119 
view config window IP topology widget, 127 
view config window lower-level NMS performance view 

widget, 120 
view config window single device monitor widget, 122 
view config window single interface monitor widget, 123 
view config window text label widget, 124 
view config window video play widget, 124 
view config window widget display, 114 
view config window widgets, 116 
view config window performance view widget, 121 
virtual machine auto migration, 460 
virtual machine in VRM, 454 
VLAN access ports (batch mode), 959 
VLAN hybrid ports (batch mode), 960 
VLAN trunk ports (batch mode), 960 
VPN instance, 213 
VXLAN ACs, 970 
VXLAN network device global settings, 963 
Wizard Center quick start functions, 136 
Wizard Center third-party device support, 137 
WMI template, 161 
work time settings, 228 

context-sensitive help, 97 
Converged Topology management, 271 
converting 

SMSC mail to SMS message, 206 
copying 

ACL rule set, 834 
ACL rule set rule, 854 
ACL template, 793 
ACL template rules, 806 
alarm forwarding rule, 709 
compliance policy, 608 
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compliance policy check task, 617 
configuration template, 523 
deployment task, 558 
global index settings user-defined monitor, 723 
initial configuration file, 577 
mail alarm notification rule, 700 
maintenance tag task, 395 
operator group, 175 
SMS alarm notification rule, 704 
Syslog filtering rule, 671 
Syslog templates, 675 
Syslog to alarm rules, 681 
trap-to-alarm rule, 650 

core alarms 
configuration, 711 
device addition, 713 
device deletion, 713 

CPU 
IMC server CPU information viewing, 226 
view config CPU Utilization Top5 widget configuration, 125 

CPU Utilization (%)—Top5 widget, 49 
CPU Utilization (%)—TopN widget, 48 
creating 

ACL advanced template, 778 
ACL basic template, 777 
ACL template, 776 
ACL templates, 774 
At a Glance performance view, 735 
compliance policy, 599 
configuration template using Save As, 507 
configuration templates, 515 
Data Grid/Trend Line performance view, 733 
device access settings plan (batch mode), 374 
global VLAN, 942 
link ACL template, 782 
performance view (monitor settings page), 735 
third-party device drive definition file, 471 
third-party device drive folder, 470 
third-party device drive index file, 470 
third-party device vendor folder, 469 
user-defined ACL template, 784 
user-defined alarm statistics charts, 694 
user-defined Syslog templates, 673 
user-defined Syslog to alarm rules, 676 
user-defined trap-to-alarm rule, 647 
VLAN, 947 
VLANs (batch mode), 959 

custom report 
addition, 1041 
addition to My Reports, 1025 
deletion, 1043 
exporting, 1040, 1042 
generation, 1038 
list access, 1039 
management, 1041 
modification, 1042 
template, 1023 
template addition, 1023, 1040 
template deletion, 1025, 1041 
template list viewing, 1024 
template modification, 1025, 1040 
template-run report, 1039 

templates, 1038 
viewing, 1042 

Custom Topology widget, 75 
Custom View 

accessing, 296 
management, 297 

Custom View Top5 widget, 71 
Customize Top5 widget, 63 
Customize TopN widget, 62 
customizing 

ACL configuration polling, 859 
all alarms list columns, 691 
background custom script definition, 481 
function extension, 480 
IMC home page, 105 
IMC login page, 103 
My Real Time Report page, 1026 
RSS widgets, 83 
spaces, 81 
system-defined widgets, 81 
the IMC About page, 106 
the IMC Online Help page, 106 
topology maps, 264 
view config Custom View Top5 widget configuration, 126 
view config window view widget, 113 

cyclic 
ACL cyclic time range configuration (ACL assistant), 772 

Dashboard 
feature, 109 
view configuration, 109 
VXLAN dashboard viewing, 968 
widget configuration, 116 

data 
current report data source viewing, 1030 
operator group data access rights configuration, 174 
report data source addition, 1031 
report data source deletion, 1032 
report data source management, 1030 
report data source modification, 1032 
Web desktop user login data viewing, 144 

Data Center Topology 
map device management, 276 
map management, 272 

data collection 
all alarms processing, 242 
configuration, 239, 404 

data export 
configuration, 221 
settings exporting, 222 
trigger export limitation, 222 

Data Grid/Trend Line performance view 
creation, 733 
modification, 737 

Data Shown in Topo 
accessing, 745 
IMC network topology monitor addition, 746 
IMC network topology monitor deletion, 747 
IMC network topology monitor modification, 747 
management, 746 
topology map performance monitor settings, 745 

database 
IMC server database information viewing, 227 
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default 
auto discovery monitor index setting, 247 
monitor list default index modification, 731 

defining 
ACL device definition management, 861 
background custom script, 481 
third-party device common service (CLICommon), 473 
third-party device component actions, 474 
third-party device component services, 474 
third-party device parser service (CleanupParser), 477 
third-party device Perl script, 479 
third-party device software deployment services, 475 
third-party device specific services, 475 
third-party device TCL script, 479 

definition 
device capability set definition file compilation, 494 
operation definition file compilation, 481 
third-party device vendor drive definition file creation, 

471 
trap definition addition, 654 
trap definition import from MIB, 662 
trap definition severity settings modification, 661 
trap definition viewing, 653 
user-defined trap definition modification, 658 

deleting 
account group, 996 
ACL, 809 
ACL device time range, 892 
ACL rule set, 847 
ACL rule set rule, 854 
ACL template, 794 
ACL template rules, 807 
alarm (All Alarms page), 692 
alarm (Root Alarms List), 692 
alarm access device, 712 
alarm core device, 713 
alarm forwarding rule, 710 
alarm level configuration rule, 716 
alarm matching policy (user-defined), 917 
allocated IP address (terminal access), 413 
Asset OID, 441 
attack alarm list alarms, 906 
automatic backup plan, 583 
automatic deployment plan, 562 
check task history, 622 
compliance policy, 608 
compliance policy check task, 618 
configuration check display command, 630 
configuration template, 525 
custom report, 1043 
custom report template, 1025, 1041 
deployment task, 560 
device additional information field, 239 
device from automatic deployment plan, 574 
device group, 197 
device list (device view, IP view), 399 
device monitor instance, 729 
event configuration entry, 931 
events, 937 
filter, 170 
global index settings user-defined monitor, 723 
global VLAN, 943 

global VLAN device VLAN, 944 
group monitored settings, 763 
guest access operator, 1007 
guest access user group, 1001 
History Access Log, 421 
holiday, 230 
home page space, 39 
home page space widget, 41 
IMC network topology monitor, 747 
IMC operator, 191 
initial configuration file, 578 
IP segment (terminal access), 409 
login control template, 181 
lower-level NMS, 308 
mail alarm notification rule, 700 
maintenance tag task, 396 
net address group (ACL assistant), 770 
operator group, 176 
performance option instance profile, 754 
performance option periodic monitor, 761 
performance option service monitor, 760 
performance view, 739 
policy, 936 
port group, 305 
PowerShell template, 161 
real time reports, 1030 
real-time alarms from list (Real-Time Alarms page), 688 
real-time attack alarm alarms, 908 
real-time monitor graph, 751 
real-time monitors, 749 
report data sources, 1032 
report template, 1022 
scheduled report histories, 1037 
scheduled reports, 1038 
security control policy, 925 
service list service (ACL assistant), 767 
SMS alarm notification rule, 704 
software library entry, 532 
special workdays, 232 
Syslog filtering rule, 672 
time range (ACL assistant), 773 
trap groups, 665 
Unauthorized Access entries, 418 
user additional information field, 981 
user group, 201 
user subgroup, 202 
user-defined Syslog templates, 675 
user-defined Syslog to alarm rules, 681 
user-defined trap filter rule, 646 
users, 988 
users (batch mode), 989 
view config window view, 113 
VLAN, 947 
VLAN deployment task entries, 956 
VLAN hybrid port, 954 
VLAN trunk port, 952 
VLAN virtual interface, 949 
VXLAN network devices, 966 
VXLAN servers, 968 
VXLAN tunnel, 972 
VXLANs, 970 
Web desktop application, 147 
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Web interface favorite, 103 
workday work period, 234 

deploying 
ACL deployment task list management, 883 
ACL deployment wizard management, 887 
ACL rule set, 835 
ACL to device, 887 
ACL uses, 894 
configuration from Configuration Center, 510 
configuration template, 525 
device configuration using Deployment Guide, 538 
device software, 403 
file from Configuration Center, 512 
file using Deployment Guide, 544 
OAP software using Deployment Guide, 551 
software from Configuration Center, 510 
software using Deployment Guide, 541 
third-party device software deployment services 

definition, 475 
using IMC Deployment Guide, 537 
VLANs (batch mode), 959 
VXLANs (batch mode), 964 

Deployment Guide 
automatic backup plan management, 579 
automatic deployment device addition, 563 
automatic deployment device detailed information 

viewing, 563 
automatic deployment device modification, 567 
automatic deployment execution results viewing, 574 
automatic deployment plan addition, 562 
automatic deployment plan deletion, 562 
automatic deployment plan modification, 562 
automatic deployment plan page accessing, 561 
automatic deployment plans management, 560 
automatic deployment triggering on device, 574 
automatic device backup configuration, 580 
automatic device backup plan addition, 581 
automatic device backup plan deletion, 583 
automatic device backup plan disabling, 583 
automatic device backup plan enabling, 583 
automatic device backup plan list accessing, 580 
automatic device backup plan modification, 582 
backup history viewing, 584 
configuration+software deployment, 537 
configure device information modification, 569 
deployment task copying, 558 
deployment task deletion, 560 
deployment task execution result page viewing, 556 
deployment task list accessing, 554 
deployment task management, 554 
deployment task modification, 556 
deployment task resumption, 559 
deployment task running, 558 
deployment task searching, 555 
deployment task suspension, 559 
device configuration backup storage in cipher text, 579 
device configuration deployment, 538 
device configuration restoration, 546 
device deletion from automatic deployment plan, 574 
device import into automatic deployment plan, 570 
device software restoration, 549 
DHCP server configuration, 575 

file deployment, 544 
initial configuration file accessing, 575 
initial configuration file addition, 576 
initial configuration file copying, 577 
initial configuration file deletion, 578 
initial configuration file detailed information viewing, 579 
initial configuration file management, 575 
initial configuration file modification, 577 
OAP software deployment, 551 
software deployment, 541 
software to deploy information modification, 568 

deployment task 
copying, 558 
deletion, 560 
execution result page viewing, 556 
list accessing, 554 
management, 554 
modification, 556 
resumption, 559 
running, 558 
searching, 555 
suspension, 559 
VLAN, 955 
VLAN deployment task entry deletion, 956 
VLAN deployment task searching, 956 
VLAN deployment task viewing, 955 

destination 
trap destination configuration (batch mode), 380 

detecting 
idle IP addresses (terminal access), 414 

device 
access templates, 149 
ACL configuration polling customization, 859 
ACL deployment to device, 887 
ACL device as rule set, 866 
ACL device as template, 867 
ACL device configuration, 860 
ACL device configuration history management, 876 
ACL device configuration management, 857 
ACL device configuration viewing, 860 
ACL device definition management, 861 
ACL device flow template application management, 881 
ACL device flow template management, 878 
ACL device list management, 858 
ACL device list querying, 859 
ACL device list viewing, 858 
ACL device synchronization, 859 
ACL device time range deletion, 892 
ACL removal from device, 890 
additional information export, 251 
additional information import, 252 
advanced device search, 99 
auto discovering, 247 
auto discovering (ARP-based ND), 247 
auto discovering (basic), 247 
auto discovering (IPsec VPN-based), 247 
auto discovering (network segment based), 247 
auto discovering (PPP-based), 247 
auto discovering (routing-based), 247 
automatic deployment device addition, 563 
automatic deployment device detailed information 

viewing, 563 
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automatic deployment device modification, 567 
automatic deployment triggering, 574 
basic device search, 97 
batch baselining device configuration, 512 
batch operations device management, 368 
capability set option, 209 
category configuration, 168 
configuration (batch mode), 384 
configuration backup, 403 
Configuration Center device configuration options, 501 
Configuration Center device querying, 500 
configuration comparison, 510, 534 
configuration comparison in Configuration Center, 534 
configuration comparison in Configuration Center 

(Advanced Mode), 536 
configuration comparison in Configuration Center (Simple 

Mode), 535 
configuration deployment using Deployment Guide, 538 
configuration management with templates, 512 
configuration modification (batch mode), 377 
configuration restoration using Deployment Guide, 546 
configuration saving (batch mode), 402 
configure device information modification, 569 
custom view access, 296 
custom view management, 297 
data center topology map device management, 276 
deletion from automatic deployment plan, 574 
device check results viewing (batch mode), 376 
device configuration saving (batch mode), 377 
device plan check results viewing (batch mode), 376 
device rebooting (batch mode), 378 
device settings access (batch mode), 374 
device settings plan creation (batch mode), 374 
device settings plan list viewing (batch mode), 375 
device type configuration (batch mode), 374 
device violating results viewing, 626 
device+interface maintenance tag tasks, 394 
faulty devices viewing, 693 
group addition, 402 
IMC addition, 244 
IMC addition (manual), 244 
import from NNMi, 250 
import into automatic deployment plan, 570 
import into IMC, 247 
information export, 250 
label import, 250 
location import, 251 
management tasks, 327 
model configuration, 166 
monitor addition, 403 
monitor cancellation, 403 
monitor list searching in device list, 725 
monitor management, 726 
monitored device only display, 730 
reboot (batch mode), 402 
rebooting (batch mode), 378 
route management, 393 
seriesconfiguration, 165 
software deployment, 403 
software restoration using Deployment Guide, 549 
space cleaning, 509 
Syslog management, 665 

TopN device viewing, 694 
trap definition device severity list management, 663 
vendor information configuration, 163 
view config Device Response Time Top5 widget 

configuration, 128 
view config device state overview widget configuration, 

133 
view config Device Unreachability Top5 widget 

configuration, 135 
view config device view widget configuration, 135 
violating device fix, 618 
VLAN access port PVID modification, 950 
VLAN access port tab, 950 
VLAN access port viewing, 950 
VLAN creation, 947 
VLAN deletion, 947 
VLAN device detail management, 945 
VLAN device list viewing, 944 
VLAN device management, 944 
VLAN device querying, 945 
VLAN hybrid port addition, 954 
VLAN hybrid port deletion, 954 
VLAN hybrid port modification, 954 
VLAN hybrid port tab, 953 
VLAN hybrid port viewing, 953 
VLAN modification, 947 
VLAN trunk port addition, 952 
VLAN trunk port deletion, 952 
VLAN trunk port modification, 952 
VLAN trunk port tab, 951 
VLAN trunk port viewing, 951 
VLAN viewing, 946 
VLAN virtual interface addition, 949 
VLAN virtual interface deletion, 949 
VLAN virtual interface tab, 948 
VLAN virtual interface viewing, 948 
VXLAN deployment (batch mode), 964 
VXLAN network device global settings configuration, 963 
VXLAN network device importing, 963 
VXLAN network device querying, 963 

device alarms 
access device addition, 712 
access device deletion, 712 
configuration, 711 
core device addition, 713 
core device deletion, 713 
event configuration entry addition, 930 
IPC events, 929 

Device Details page 
accessing, 89, 309 
Actions—For all devices, 313 
Actions—For switches, 318 
additional information, 236 
alarms viewing, 311 
Configuration Center, 326 
configuration options, 309 
Configure—For all devices, 319, 324 
Device Additional Information, 313 
device management, 308 
Device Management, 327 
Interface Details page accessing, 363 
interface list+details page access, 362 
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Performance Monitor reports, 324 
Performance Monitor viewing, 312 
Port Group device interface viewing, 302 
Protocol Management, 357 
Rack and Room Information, 313 
right navigation tree, 313 
RMON network device management, 346 
section contents, 309 
service monitoring, 310 
VDC information, 311 

device group 
addition, 196 
configuration, 194 
deletion, 197 
device addition, 197 
device removal, 197 
device removal (multiple), 198 
modification, 196 
querying, 195 
ungrouped devices addition, 199 
ungrouped devices list viewing, 198 
viewing, 194 

device list 
addition (custom view), 398 
additional information exporting, 405 
check access settings (batch mode), 401 
data collection configuration, 404 
deletion (device view, IP view), 399 
device configuration guide (batch mode), 404 
exporting, 405 
LiveUpdate access, 404 
management, 399 
management options, 398 
navigation, 397 
navigation (custom view), 398 
navigation (device view), 397 
navigation (IP view), 397 
poll interval settings access (batch mode), 401 
refreshing, 400 
removal (custom view), 398 
SNMP settings access (batch mode), 400 
SSH settings access (batch mode), 401 
synchronization, 400 
Telnet settings access (batch mode), 400 
unmanagement, 399 

Device List (by Custom View) widget, 77 
Device Response Time (ms)—Top5 widget, 55, 65 
Device Response Time (ms)—TopN widget, 54 
Device State Overview widget, 68 
Device Status Bar widget, 83 
Device Unreachability (%)—Top5 widget, 57 
Device Unreachability (%)—TopN widget, 56 
Device View 

accessing, 253 
device viewing, 253 
widget, 69 

DHCP 
server configuration, 575 

disabling 
alarm forwarding rule, 709 
alarm forwarding rule (batch), 709 
alarm level configuration rule, 715 

automatic backup plan, 583 
compliance policy (all), 609 
compliance policy (single), 609 
mail alarm notification rule, 700 
mail alarm notification rule (batch), 700 
SMS alarm notification rule, 704 
SMS alarm notification rule (batch), 704 
Syslog filtering rule, 671 
Syslog to alarm rules, 681 
trap-to-alarm rule, 652 

disk 
IMC server disk information viewing, 227 

displaying 
configuration check using display command, 629 
home page space widget content, 41 
monitored devices only, 730 
performance option display index configuration, 755 
performance option display option setting, 752 
view config window view, 116 

dragging 
home page space widget, 41 

drawing 
3D room editing, 278 

dropping 
home page space widget, 41 

duplicate 
trap filter rule modification, 636 

editing 
3D room, 278 
SNMP settings (manual), 245, 368 
SSH settings (manual), 246, 371 
Telnet parameters (manual), 245 
Telnet settings (manual), 369 

enabling 
alarm forwarding rule, 709 
alarm forwarding rule (batch), 709 
alarm level configuration rule, 715 
alarm sound settings, 84 
automatic backup plan, 583 
compliance policy (all), 608 
compliance policy (single), 608 
mail alarm notification rule, 700 
mail alarm notification rule (batch), 700 
SMS alarm notification rule, 704 
SMS alarm notification rule (batch), 704 
Syslog filtering rule, 671 
Syslog to alarm rules, 681 
trap-to-alarm rule, 652 

entering 
Web desktop, 142 

establishing 
baseline using software library entry, 532 
configuration file baseline, 507 
software baseline, 510 

event configuration 
action management, 932 
Action Management page access, 932 
device alarm entry addition, 930 
entry addition (periodic), 931 
entry deletion, 931 
entry management, 930 
entry modification, 931 
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event deletion, 937 
event processing (manual), 938 
event querying, 937 
event viewing, 936 
Last Hour Events report, 939 
list access, 930 
Policy Execution Result in Last Hour report, 939 
report viewing, 939 
View Event page access, 936 

event management, 632 
Excel 

alarm exporting (All Alarms page > Microsoft Excel), 692 
device list exporting, 405 

executing 
attack alarm action, 911 
attack alarm action (manual), 911 
backup history failed or partially successful backup, 587 
security control policy, 925 

Execution Result Report viewing, 912 
expanding 

all home page space widgets, 40 
home page space widget, 40 

exploring 
IMC home page, 37 

exporting 
ACL template, 794 
alarm (All Alarms page > Microsoft Excel), 692 
configuration backup report file, 589 
configuration template, 525 
custom report, 1040, 1042 
data export configuration, 221 
data export trigger export limitation, 222 
data settings, 222 
device additional information, 251, 405 
device information, 250 
device list, 405 
IP address (terminal access), 412 
IP segments (terminal access), 412 
performance view report, 744 
SMS alarm notification rules (all), 704 
software library entry, 531 

extending 
customized functions, 480 
functions for third-party device support, 469 

Faulty Devices 
viewing, 693 

favorite 
Web interface favorite access, 102 
Web interface favorite addition, 102 
Web interface favorite deletion, 103 
Web interface favorite modification, 102 
Web interface favorite sorting, 102 

field 
device additional information field addition, 237 
device additional information field deletion, 239 
device additional information field modification, 238 
user additional information field addition, 978 
user additional information field deletion, 981 
user additional information field modification, 980 

file 
deployment using Deployment Guide, 544 

file transfer mode 

option configuration, 210 
filtering 

duplicate trap filter rule modification, 636 
filter addition, 170 
filter deletion, 170 
filter list viewing, 169 
filter management, 169 
IMC trap filter rule viewing, 636 
intermittent trap filter rule modification, 638 
real-time alarm viewing (filtered), 686 
scheduled report list, 1033 
Syslog entries, 668 
Syslog filtering policy setting, 669 
Syslog filtering rule addition, 669 
Syslog filtering rule copying, 671 
Syslog filtering rule deletion, 672 
Syslog filtering rule detail viewing, 668 
Syslog filtering rule disabling, 671 
Syslog filtering rule enabling, 671 
Syslog filtering rule modification, 670 
Syslog filtering rule viewing, 668 
trap (existing IMC filter rules), 636 
trap filter configuration modification (device not in IMC), 

639 
trap filtering (existing IMC filter rules), 636 
up/down alarm filter settings modification (batch mode), 

373 
user-defined trap filter rules, 639 

fixed 
ACL fixed time range configuration (ACL assistant), 772 

fixing 
violating device, 618 

floating menus (navigation tree), 94 
folder 

third-party device vendor drive folder creation, 470 
forwarding 

alarm forwarding management, 705 
alarm forwarding rule addition, 705 
alarm forwarding rule copying, 709 
alarm forwarding rule deletion, 710 
alarm forwarding rule disabling, 709 
alarm forwarding rule disabling (batch), 709 
alarm forwarding rule enabling, 709 
alarm forwarding rule enabling (batch), 709 
alarm forwarding rule modification, 707 

framework 
IMC framework layers, 22 
SOA framework, 26 

General Configuration Compare page, 537 
generating 

alarm generation mode setting, 211 
custom report, 1038 
trap alarms, 646 

global index settings 
accessing, 718 
custom template addition, 720 
individual device monitoring settings management, 724 
management, 719 
monitor modification, 719 
performance management, 717 
searching, 718 
user-defined monitor addition, 720 
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user-defined monitor copying, 723 
user-defined monitor deletion, 723 
user-defined monitor modification, 723 
user-defined monitor viewing, 722 

global VLAN 
creation, 942 
deletion, 943 
device addition, 943 
device VLAN deletion, 944 
list view, 941 
querying, 942 

graph 
real-time monitor graph addition, 750 
real-time monitor graph deletion, 751 
real-time monitor graph modification, 751 
real-time monitor graph viewing, 750 

group 
account group management, 991 
administrator group operator addition, 184 
administrator group operator modification, 185 
guest access user group addition, 999 
guest access user group deleting, 1001 
guest access user group detail viewing, 1000 
guest access user group list viewing, 998 
port group addition, 304 
port group deletion, 305 
port group modification, 305 
trap group addition, 664 
trap group deletion, 665 
trap group modification, 664 
trap group viewing, 664 
viewer group operator addition, 187 
viewer group operator modification, 189 

group management 
device addition, 197 
device group addition, 196 
device group configuration, 194 
device group deletion, 197 
device group modification, 196 
device group querying, 195 
device group viewing, 194 
device list viewing, 195 
device removal, 197 
device removal (multiple), 198 
subgroup addition, 200 
subgroup deletion, 202 
subgroup modification, 201 
ungrouped devices addition, 199 
ungrouped devices list viewing, 198 
user group addition, 200 
user group configuration, 199 
user group deletion, 201 
user group list viewing, 199 
user group modification, 201 

group monitored settings 
addition, 762 
deleting, 763 
management, 762 
modification, 762 
viewing, 762 

GSM 
modem configuration, 204 

guest access 
account management, 1014 
account opening, 1012 
log detail viewing, 1010 
log list viewing, 1008 
log querying, 1009 
log use, 1008 
management, 974, 996 
online operator viewing, 1016 
operator addition, 1004 
operator deletion, 1007 
operator detail viewing, 1003 
operator list viewing, 1002 
operator log auditing, 1007 
operator management, 1001 
operator modification, 1006 
operator password modification, 1016 
operator querying, 1002 
self-service system login, 1011 
self-service system use, 1010 
system parameter configuration, 1010 
user group addition, 999 
user group deletion, 1001 
user group detail viewing, 1000 
user group list viewing, 998 
user group management, 998 

help 
context-sensitive help, 97 
online help system, 95 
system-wide help, 96 

hierarchical alarm settings 
IMC configuration, 710 
management, 710 

Hierarchical Device State Overview widget, 68 
hierarchical NMS 

alarm configuration, 202 
alarm notification configuration, 202 
default mail server settings configuration, 203 
mail server settings, 202 
management, 202 
third-party mail server settings configuration, 203 

history 
ACL device configuration history management, 876 
action management policy history viewing, 936 
backup history failed or partially successful backup, 587 
backup history report accessing, 584 
backup history report detailed information viewing, 586 
backup history report querying, 585 
backup history viewing, 584 
backup max configuration files history days setting, 212 
check task history deletion, 622 
check task history querying, 621 
check task history use, 620 
check task history viewing, 621 
configuration backup history viewing, 503 
message history access, 139 
OneView management action history viewing, 434 
scheduled report history access, 1037 
scheduled report history deletion, 1037 
security control policy execution history viewing, 925 
software update history, 507 
virtual machine operation history management, 467 
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History Access Log 
data retrieval (periodic), 420 
data retrieval (retrieve now), 420 
deletion, 421 
list viewing, 419 
page refreshing, 421 
querying, 421 
real-time location, 420 
terminal access, 419 

holiday 
configuration, 229 
configuration page viewing, 229 
deletion, 230 
modification, 229 

HTTP 
SOAP/HTTP template configuration, 156 

HTTPS 
access settings configuration, 234 

hybrid port 
VLAN hybrid port addition, 954 
VLAN hybrid port configuration (batch mode), 960 
VLAN hybrid port deletion, 954 
VLAN hybrid port modification, 954 
VLAN hybrid port tab, 953 
VLAN hybrid port viewing, 953 

IMC 
About page customization, 106 
alarm querying, 684 
compiled MIB removal from IMC, 208 
compiled MIB to IMC addition, 207 
configuration for hierarchical alarms, 710 
Deployment Guide configuration+software deployment, 

537 
device addition, 244 
device addition (manual), 244 
device import, 247 
function navigation, 85 
group resource management, 194 
home page customization, 105 
home page exploration, 37 
how it works, 21 
LiveUpdate IMC software updating, 235 
logging in, 37 
login page customization, 103 
maintainer addition, 187 
maintainer modification, 189 
MIB compilation in IMC, 207 
Online Help page customization, 106 
online operator access management, 192 
online operator blocking, 193 
online operator logoff, 193 
online operator unblocking, 193 
online operator viewing, 192 
operator management, 182 
password modification, 192 
reporting, 1018 
server CPU information viewing, 226 
server database information viewing, 227 
server disk information viewing, 227 
server information configuration, 226 
server memory information viewing, 227 
server process viewing, 226 

Syslog entry querying, 666 
system settings configuration, 214 
system settings modification, 214 
virtual machine addition, 454 
Web desktop IMC edition switching, 143 

implementing 
energy-saving policies (batch mode), 379 

Important Devices widget, 72 
Important Ports widget, 72 
importing 

ACL rule set, 835 
device additional information, 252 
device into automatic deployment plan, 570 
device labels, 250 
device locations, 251 
devices from NNMi, 250 
devices into IMC, 247 
IP address segment (terminal access), 411 
network segment addresses, 247 
software into library from device, 528 
software into library from file, 528 
software into library from Web download, 529 
trap definition from MIB, 662 
users (batch mode), 976 
VRM virtual resources, 447 
VXLAN network devices, 963 
VXLAN servers, 967 

index 
auto discovery default monitor index setting, 247 
monitor list default index modification, 731 
performance management global index settings, 717 
performance option common index configuration, 754 
performance option default monitor index configuration, 

757 
performance option display index configuration, 755 
performance option dynamic threshold index 

configuration, 756 
performance option TOPN index configuration, 755 
third-party device vendor drive index file creation, 470 

information 
ACL deployment task detailed information viewing, 885 
action management detailed information viewing, 932 
alarm matching policy detailed information viewing, 914 
compliance policy detailed information viewing, 596 
configure device information modification, 569 
Device Additional Information, 313 
device additional information export, 251 
device additional information field addition, 237 
device additional information field deletion, 239 
device additional information field modification, 238 
device additional information import, 252 
device additional information list viewing, 236 
device information export, 250 
device list additional information exporting, 405 
Network Asset Manager asset information management, 

442 
operator custom information sharing, 191 
Rack and Room Information, 313 
software to deploy information modification, 568 
Syslog device detailed information viewing, 667 
user additional information field addition, 978 
user additional information field deletion, 981 
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user additional information field modification, 980 
user additional information list viewing, 978 
user additional information modification (batch mode), 

988 
user basic information modification, 985 
user basic information viewing, 983 

infrastructure 
network infrastructure, 31 

initial configuration file 
accessing, 575 
addition, 576 
copying, 577 
deletion, 578 
detailed information viewing, 579 
DHCP server configuration, 575 
management, 575 
modification, 577 

inserting 
report options, 1032 

installing 
SMS plug-in, 928 

instance 
monitor instance viewing in performance view, 741 
monitor list device instance addition, 726 
monitor list device instance deletion, 729 
monitor list device instance modification, 728 
monitor list device instance name modification, 730 
monitor list searching in instance list, 726 
Performance Instance Profile, 47 
performance option instance profile adding, 753 
performance option instance profile configuration, 753 
performance option instance profile deletion, 754 
performance option instance profile list viewing, 753 
performance option instance profile modification, 754 

integrating 
SCC and SMS, 927 

Intelligent Configuration Report, 1020 
Intelligent Policy Center (IPC) 

periodic events, 929 
interface 

advanced interface search, 100 
configuration (batch mode), 390 
filter addition, 170 
filter deletion, 170 
filter list viewing, 169 
filter management, 169 

Interface Details page 
accessing, 363 
interface list+details page access, 362 
Performance Monitor, 364 
right navigation tree, 364 

Interface Flux TopN widget, 50 
Interface List (by Port Group) widget, 78 
intermittent 

trap filter rule modification, 638 
IP address 

allocated IP address deletion (terminal access), 413 
allocated IP address querying (terminal access), 409 
allocation (terminal access), 406 
allocation using auto scanning (terminal access), 410 
allocation using import IP address (terminal access), 411 
exporting (terminal access), 412 

idle IP address detection (terminal access), 414 
IP recycle bin viewing (terminal access), 413 
IP/MAC address binding, 428 
manual allocation (terminal access), 410 
real-time location IP address location querying, 422 
resource management (terminal access), 405 
segment addition (terminal access), 408 
segment deletion (terminal access), 409 
segment importing (terminal access), 411 
segment list viewing (terminal access), 406 
segment modification (terminal access), 408 
segment querying (terminal access), 407 
segments exporting (terminal access), 412 

IP topology 
IP Topology widget, 73 
view config IP topology widget configuration, 127 

IP View 
accessing, 256 
device viewing, 255 

labeling 
device label import, 250 
view config text label widget configuration, 124 

LACP 
configuration (batch mode), 383 

layer 
IMC framework layers, 22 

LDAP 
authentication services configuration, 178 

library 
Configuration Center software library, 497 

limiting 
data export triggers, 222 

link 
ACL template creation, 782 
ACL template modification, 790 
link ACL template rule addition, 798 
link ACL template rule modification, 804 

Link Aggregation Control Protocol. Use LACP 
list 

account group list viewing, 992 
ACL deployment task list management, 883 
ACL deployment task list viewing, 883 
ACL device list querying, 859 
ACL device list viewing, 858 
ACL net address group list viewing (ACL assistant), 768 
ACL resource list viewing, 807 
ACL service list viewing (ACL assistant), 766 
ACL template list viewing, 775 
ACL time range list viewing (ACL assistant), 770 
action management policy list page access, 933 
All Alarms List browsing, 688 
all alarms list columns customization, 691 
Asset Audit List querying, 445 
Asset Audit List viewing, 444 
Asset OID list viewing, 439 
attack alarm list alarm deletion, 906 
attack alarm list browsing, 902 
attack alarm list querying, 904, 906 
automatic device backup plan list accessing, 580 
compliance policy check task details, 614 
compliance policy check task list, 613 
compliance policy list viewing, 595 
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configuration check display command addition, 629 
configuration check display command deletion, 630 
configuration check display command list, 629 
configuration check display command modification, 630 
custom report list access, 1039 
custom report template list viewing, 1024 
deployment task list accessing, 554 
device additional information list viewing, 236 
device configuration saving (batch mode), 402 
device group addition, 402 
Device List (by Custom View), 77 
device list addition (custom view), 398 
device list check access settings (batch mode), 401 
device list deletion (device view, IP view), 399 
device list management, 399 
device list management options, 398 
device list navigation, 397 
device list navigation (custom view), 398 
device list navigation (device view), 397 
device list navigation (IP view), 397 
device list poll interval settings (batch mode), 401 
device list refreshing, 400 
device list removal (custom view), 398 
device list SNMP settings (batch mode), 400 
device list SSH settings (batch mode), 401 
device list synchronization, 400 
device list Telnet settings (batch mode), 400 
device list unmanagement, 399 
device list viewing, 195 
device monitor addition, 403 
device settings plan list viewing (batch mode), 375 
event configuration list access, 930 
filter list viewing, 169 
guest access log list viewing, 1008 
guest access operator list viewing, 1002 
guest access user group list viewing, 998 
Interface List (by Port Group), 78 
IP segment list viewing (terminal access), 406 
login control template list viewing, 179 
maintenance tag task list viewing, 394 
monitor list accessing, 724 
monitor list searching in device list, 725 
monitor list searching in instance list, 726 
monitor list switching, 725 
network asset list viewing, 435 
operator list viewing, 183 
performance option instance profile list viewing, 753 
performance view list viewing, 731 
port group interface list viewing, 303 
port group list querying, 302 
real-time attack alarm list alarm browsing, 906 
real-time attack alarm list refreshing, 907 
replaceable variable list, 495 
report template list access, 1021 
security control policy list viewing, 918 
switch access binding list refreshing, 428 
trap definition device severity list management, 663 
Unauthorized Access list refreshing, 419 
Unauthorized Access log list refreshing, 419 
user group list viewing, 199, 982 
user list viewing, 981 
VLAN device list viewing, 944 

VRM virtual network server resource list, 449 
VXLAN list viewing, 968 
VXLAN network device deletion, 966 
VXLAN network device details viewing, 964 
VXLAN network device list viewing, 962 
VXLAN server list viewing, 966 
VXLAN tunnel list viewing, 971 

LiveUpdate 
accessing, 404 
configuration, 235 
device software updating, 235 
IMC software updating, 235 

locating 
device location import, 251 
History Access Log terminal (real-time), 420 

Log Configuration page, 226 
log file 

configuration, 223 
data export configuration, 221 
data export settings exporting, 222 
data export trigger export limitation, 222 
operation log chart template addition, 224 
operation log chart template management, 225 
operation log querying, 224 
operation log viewing, 223 

logging 
guest access log detail viewing, 1010 
guest access log list viewing, 1008 
guest access log querying, 1009 
guest access log use, 1008 
guest access operator log auditing, 1007 

logging in 
guest access self-service system, 1011 
IMC, 37 
Web desktop, 142 

logging off 
IMC online operators, 193 
Web desktop, 147 

 
login type modification (batch mode), 372 

login control 
operator login control templates, 179 
template addition, 180 
template deletion, 181 
template list viewing, 179 
template modification, 180 

lower-level NMS 
accessing, 308 
addition, 307 
deletion, 308 
modification, 307 
view, 306 
view management, 306 

Lower-Level System Alarm Statistics widget, 45 
Lower-Level System Real-Time Alarm widget, 43 
MAC address 

IP/MAC address binding, 428 
real-time location IP address location querying, 422 

mail alarm notification 
management, 695 
rule addition, 696 
rule copying, 700 
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rule deletion, 700 
rule disabling, 700 
rule disabling (batch), 700 
rule enabling, 700 
rule enabling (batch), 700 
rule modification, 699 

mail notification parameter configuration, 213 
mail server 

hierarchical NMS default mail server settings 
configuration, 203 

hierarchical NMS mail server settings, 202 
hierarchical NMS third-party mail server settings 

configuration, 203 
maintaining 

device+interface maintenance tag tasks, 394 
managing 

3D room network devices, 293 
account groups, 991 
ACL, 764 
ACL deployment task list, 883 
ACL deployment wizard, 887 
ACL device configuration, 857 
ACL device configuration history, 876 
ACL device definitions, 861 
ACL device flow template applications, 881 
ACL device flow templates, 878 
ACL device list, 858 
ACL device time ranges, 873 
ACL device use (packet filtering), 869 
ACL device use (VLAN packet filtering), 869 
ACL rule set rules, 848 
ACL rule sets, 809 
ACL template rules, 794 
ACLs, 807 
actions, 932 
alarm forwarding, 705 
alarm levels, 713 
auto discovery plan, 247 
automatic backup plans, 579 
automatic deployment plans, 560 
converged topology, 271 
custom report, 1041 
custom views, 297 
data center topology map devices, 276 
data center topology maps, 272 
data shown in topology, 746 
deployment tasks, 554 
device configuration with templates, 512 
device list, 399 
device monitors, 726 
device routes, 393 
device through device details, 308 
device+interface maintenance tag tasks, 394 
event configuration entries, 930 
events and alarms, 632 
global index settings, 719 
global VLANs, 941 
group monitored settings, 762 
guest access, 974, 996 
guest access operators, 1001 
guest access user group, 998 
guest accounts, 1014 

hierarchical alarm settings, 710 
hierarchical NMS, 202 
IMC group resources, 194 
IMC online operator access, 192 
IMC operators, 182 
individual device monitoring settings, 724 
initial configuration file, 575 
interface filter, 169 
lower-level NMS views, 306 
mail alarm notifications, 695 
MIBs, 207 
net address groups (ACL assistant), 768 
operation log chart templates, 225 
operator groups, 172 
performance option, 751 
performance view, 731 
performance with global index settings, 717 
policies, 932 
port groups, 302 
real time reports, 1028 
real-time monitor graphs, 749 
real-time monitors, 748 
real-time performance monitor, 747 
report data sources, 1030 
security attack alarms, 901 
security control policies, 918 
services (ACL assistant), 766 
SMS alarm notifications, 701 
software library, 525 
stack topology devices, 268 
Syslog, 665 
time ranges (ACL assistant), 770 
topology map performance monitor settings, 745 
trap definition device severity list, 663 
trap definition settings, 652 
trap groups, 664 
traps, 633 
traps (right navigation tree), 635 
user from basic information page, 984 
users, 974, 981 
virtual machine operation histories, 467 
virtual machine templates, 466 
VLAN device, 944 
VLAN device details, 945 
VLANs, 941 
VXLAN, 962 
VXLAN devices, 962 
VXLAN network devices, 962 
VXLAN servers, 966 
VXLAN tunnels, 971 
VXLANs, 968 
Web desktop application, 145 

mapping 
attack path map viewing (single attack), 909 
attack topology map viewing, 908 
attack topology map viewing (all attacks), 908 
data center topology map device management, 276 
data center topology map management, 272 
topology map customization, 264 
topology map options, 265 
topology map toolbar, 258 
VLAN topology map viewing, 957 
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VLAN topology maps, 956 
VRM topology map physical server viewing, 278 
VRM topology map virtual network viewing, 277 

masking 
ACL management subnet mask type configuration, 773 

maximizing 
home page, 39 
home page space widget, 41 

memory 
IMC server memory information viewing, 227 
performance option device memory usage trend alarms 

configuration, 756 
view config Memory Utilization Top5 widget 

configuration, 132 
Memory Utilization (%)—Top5 widget, 53 
Memory Utilization (%)—TopN widget, 52 
menu 

navigation tree floating menus, 94 
Web desktop menu access, 144 

message 
OneView management message viewing, 434 
Syslog message alarms configuration, 672 

MIB 
compiled MIB addition to IMC, 207 
compiled MIB removal from IMC, 208 
IMC compilation, 207 
management, 207 
trap definition import from MIB, 662 

Microsoft Excel 
alarm exporting (All Alarms page > Microsoft Excel), 692 
device list exporting, 405 

migrating 
virtual machine auto migration configuration, 460 
virtual machine manually, 459 
virtual machine migration manually, 459 
virtual machine migration recommendation querying, 462 
virtual machine migration report querying, 463 
virtual machine migration report viewing, 462 

model 
device categories configuration, 168 
device model configuration, 166 
SOA application development, 21 

modem 
SMSC GSM modem configuration, 204 
SMSC settings configuration, 204 

modifying 
account group, 994 
ACL, 868 
ACL deployment task, 885 
ACL rule set, 825 
ACL rule set rule, 848 
ACL service list service modification (ACL assistant), 767 
ACL template, 786 
ACL template rule, 800 
administrator group operator, 185 
advanced ACL template, 787 
advanced ACL template rule, 801 
alarm forwarding rule, 707 
alarm level configuration rule, 715 
alarm matching policy (user-defined), 916 
alarm performance threshold, 684 
Asset OID, 441 

At a Glance performance view, 738 
automatic backup plan, 582 
automatic deployment device, 567 
automatic deployment plan, 562 
backup configuration file, 504 
basic ACL template, 786 
compliance policy, 604 
compliance policy check task, 616 
configuration check display command, 630 
configuration template modification, 521 
configure device information, 569 
custom report, 1042 
custom report template, 1025, 1040 
Data Grid/Trend Line performance view, 737 
deployment task, 556 
device additional information field, 238 
device configuration (batch mode), 377 
device group, 196 
device monitor instance, 728 
device monitor instance name, 730 
duplicate trap filter rules, 636 
event configuration entry, 931 
global index settings monitor, 719 
global index settings user-defined monitor, 723 
group monitored settings, 762 
guest access operator, 1006 
guest operator password, 1016 
holiday, 229 
IMC maintainer, 189 
IMC network topology monitor, 747 
IMC passwords, 192 
IMC system settings, 214 
initial configuration file, 577 
intermittent trap filter rules, 638 
IP segment (terminal access), 408 
link ACL template, 790 
link ACL template rule, 804 
login control template, 180 
login types (batch mode), 372 
lower-level NMS, 307 
mail alarm notification rule, 699 
maintenance tag task, 395 
monitor list default index, 731 
net address group (ACL assistant), 769 
network asset, 442 
network asset property, 442 
operator group, 176 
performance option instance profile, 754 
performance option periodic monitor, 761 
performance option service monitor, 759 
performance view threshold settings, 733 
performance view upper-level folder, 737 
ping settings (batch mode), 373 
policy, 935 
port group, 305 
Port Group advanced properties, 464 
real time report template, 1027 
real time reports, 1030 
real-time monitor graph, 751 
real-time monitors, 749 
report data sources, 1032 
report template, 1022 
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scheduled report, 1036 
security control policy, 922 
SMS alarm notification rule, 703 
software library entry, 531 
software to deploy information, 568 
special workdays, 231 
SSH settings (batch mode), 371 
Syslog filtering rule, 670 
task management Web desktop application name, 147 
time range (ACL assistant), 773 
trap definition severity settings, 661 
trap filter configuration (device not in IMC), 639 
trap groups, 664 
trap-to-alarm rule, 650 
trap-to-alarm rule scenario, 650 
trap-to-alarm upgrade strategy, 649 
up/down alarm filter settings (batch mode), 373 
user additional information (batch mode), 988 
user additional information field, 980 
user basic information, 985 
user group, 201 
user subgroup, 201 
user-defined ACL template, 792 
user-defined ACL template rule, 805 
user-defined Syslog templates, 674 
user-defined Syslog to alarm rules, 679 
user-defined trap definitions, 658 
user-defined trap filter rule, 643 
users (batch mode), 990 
viewer group operator, 189 
virtual machine profile, 460 
virtual machine recommendation viewing, 461 
VLAN, 947 
VLAN access port PVID, 950 
VLAN hybrid port, 954 
VLAN trunk port, 952 
vSwitch advanced properties, 464 
VXLAN tunnel, 972 
VXLANs, 970 
Web interface favorite, 102 
workday work period, 233 

monitor list 
accessing, 724 
default index modification, 731 
device instance addition, 726 
device instance deletion, 729 
device instance modification, 728 
device instance name modification, 730 
device monitor management, 726 
individual device monitoring settings management, 724 
monitor saving to performance view, 730 
monitored device only display, 730 
searching, 725 
searching in device list, 725 
searching in instance list, 726 
switching, 725 

monitoring 
auto discovery default monitor index setting, 247 
Device Details page service, 310 
Performance Monitor viewing, 312 
performance option index configuration, 757 
performance option monitor option setting, 752 

security policies and restrictions, 33 
view config important device monitor widget 

configuration, 119 
view config single device monitor widget configuration, 

122 
view config single interface monitor widget configuration, 

123 
mouse click 

topology map feature, 260 
moving 

user group users, 987 
Web desktop application, 147 

My Favorites, 102, 228 
My Report templates, 1018 
naming 

ACL renaming, 809 
configuration template renaming, 522 
monitor list device instance name modification, 730 
software library entry renaming, 530 
Web desktop application name modification, 147 

navigating 
breadcrumb trails, 95 
device list, 397 
device list (custom view), 398 
device list (device view), 397 
device list (IP view), 397 
floating menus, 94 
IMC functions, 85 
networktopology interface, 258 
right navigation tree, 313 
SMS management page, 928 

net address group 
ACL net address group addition (ACL assistant), 769 
ACL net address group deletion (ACL assistant), 770 
ACL net address group list viewing (ACL assistant), 768 
ACL net address group modification (ACL assistant), 769 
ACL net address group viewing (ACL assistant), 768 
ACL net address groups management (ACL assistant), 768 

NETCONF 
parameter configuration (batch mode), 370 
template configuration, 155 

network 
3D room network device management, 293 
access requirements, 32 
asset audit options configuration, 228 
how IMC works, 21 
infrastructure, 31 
Network Devices widget, 79 
network topology access, 257 
network topologyinterface navigation, 258 
Network widget, 66 
Physical Network Asset Statistics widget, 80 
protocols and standards, 32 
resource management (global settings), 148 
SCC and SMS integration, 927 
segment address importing, 247 
SMS plug-in installation, 928 
topology, 31 
virtual network viewing, 448 
VRM topology map virtual network viewing, 277 
VXLAN network device global settings configuration, 963 
VXLAN network device importing, 963 
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VXLAN network device querying, 963 
Network Asset Auditing 

Asset Audit List querying, 445 
Asset Audit List viewing, 444 
using, 444 

Network Asset Manager 
asset detail view refreshing, 444 
asset information management, 442 
asset modification, 442 
asset property auditing, 443 
asset property modification, 442 
asset removal, 444 
device-level network asset detail viewing, 436 
manual asset addition, 442 
network asset list viewing, 435 
network asset querying, 438 
network asset viewing, 435 
using, 435 

Network Assets 
Asset OID addition, 440 
Asset OID deletion, 441 
Asset OID list viewing, 439 
Asset OID modification, 441 
Asset OID querying, 440 
Asset OID use, 439 

Network Topology 
access, 257 
device viewing, 257 
interface navigation, 258 

NMS 
hierarchical NMS alarm configuration, 202 
hierarchical NMS alarm notification configuration, 202 
hierarchical NMS mail server settings, 202 
hierarchical NMS management, 202 
lower-level NMS access, 308 
lower-level NMS addition, 307 
lower-level NMS deletion, 308 
lower-level NMS modification, 307 
lower-level NMS view, 306 
lower-level NMS view management, 306 
view config lower-level NMS performance view widget 

configuration, 120 
NNMi 

device import, 250 
notifying 

alarm notification configuration, 695 
hierarchical NMS alarm notification configuration, 202 
mail alarm notification management, 695 
SMS alarm notification management, 701 
SMSC settings configuration, 204 

OAP 
software deployment using Deployment Guide, 551 

OneView management 
access parameter configuration, 433 
action history viewing, 434 
message viewing, 434 
using, 433 

Online Help page 
context-sensitive help, 97 
customization, 106 
help system, 95 
IMC online operator access management, 192 

system-wide help, 96 
Open Stack Topology device management, 268 
opening 

guest accounts, 1012 
home page space widget in new window, 41 
Web desktop application, 147 

operating 
virtual machine, 455 

Operation Log 
chart template addition, 224 
chart template management, 225 
file, 223 
querying, 224 
viewing, 223 

operator 
administrator group operator addition, 184 
administrator group operator modification, 185 
guest access operator addition, 1004 
guest access operator deletion, 1007 
guest access operator detail viewing, 1003 
guest access operator list viewing, 1002 
guest access operator log auditing, 1007 
guest access operator management, 1001 
guest access operator modification, 1006 
guest access operator querying, 1002 
list viewing, 183 

operator group 
addition, 174 
copying, 175 
data access rights configuration, 174 
deletion, 176 
list viewing, 173 
management, 172 
modification, 176 
report template access rights setting, 175 
RTM access rights configuration, 175 

operator management 
administrator group operator addition, 184 
administrator group operator modification, 185 
device group configuration, 194 
group data access rights configuration, 174 
group resource management, 194 
IMC maintainer addition, 187 
IMC maintainer modification, 189 
IMC online operator access management, 192 
IMC online operator blocking, 193 
IMC online operator logoff, 193 
IMC online operator unblocking, 193 
IMC online operator viewing, 192 
IMC operator deletion, 191 
IMC operator management, 182 
IMC password modification, 192 
IMC password strategy establishment, 181 
IMC secure access, 171 
operator custom information sharing, 191 
operator group addition, 174 
operator group copying, 175 
operator group deletion, 176 
operator group list viewing, 173 
operator group management, 172 
operator group modification, 176 
operator group report template access rights setting, 175 
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operator group RTM access rights configuration, 175 
operator list viewing, 183 
operator login control templates, 179 
operator querying, 183 
user group configuration, 199 
viewer group operator addition, 187 
viewer group operator modification, 189 

optimizing 
ACL rule set rules, 856 

option 
device list management options, 398 
performance option common index configuration, 754 
performance option default monitor index configuration, 

757 
performance option device memory usage trend alarms 

configuration, 756 
performance option display index configuration, 755 
performance option display option setting, 752 
performance option dynamic threshold index 

configuration, 756 
performance option instance profile adding, 753 
performance option instance profile configuration, 753 
performance option instance profile deletion, 754 
performance option instance profile list viewing, 753 
performance option instance profile modification, 754 
performance option management, 751 
performance option monitor option setting, 752 
performance option TOPN index configuration, 755 
report option insertion, 1032 

organizing 
configuration templates, 514 

packet filtering 
ACL device use management, 869 
ACL device use management (VLAN packet filtering), 869 

page 
ACL view ACL page, 865 
device details page accessing, 309 

parameter 
guest access system parameter configuration, 1010 
NETCONF parameter configuration (batch mode), 370 
OneView management access parameter configuration, 

433 
Telnet parameter editing (manual), 245 
traffic topology refresh parameter setting, 270 

parser 
third-party device parser service (CleanupParser) 

definition, 477 
password 

guest operator password modification, 1016 
IMC password modification, 192 
IMC password strategy configuration, 181 
IMC password strategy establishment, 181 

Performance Analysis Summary Reports, 1020 
Performance Instance Profile widget, 47 
performance management 

At a Glance performance view modification, 738 
At a Glance performance view viewing, 743 
At a Glance view creation, 735 
Data Grid/Trend Line performance view modification, 737 
Data Grid/Trend Line view creation, 733 
data shown in topo accessing, 745 
Data Shown in Topo feature, 745 

data shown in topo management, 746 
device monitor instance addition, 726 
device monitor instance deletion, 729 
device monitor instance modification, 728 
device monitor instance name modification, 730 
device monitor list management, 726 
global index setting accessing, 718 
global index setting management, 719 
global index setting monitor modification, 719 
global index setting searching, 718 
global index setting user-defined monitor addition, 720 
global index setting user-defined monitor copying, 723 
global index setting user-defined monitor modification, 

723 
global index setting user-defined monitor viewing, 722 
global index settings, 717 
global index settings custom template addition, 720 
group monitored setting addition, 762 
group monitored setting deletion, 763 
group monitored setting modification, 762 
group monitored setting viewing, 762 
group monitored settings management, 762 
IMC network topology monitor addition, 746 
IMC network topology monitor deletion, 747 
IMC network topology monitor modification, 747 
individual device monitoring settings management, 724 
monitor instance viewing in performance view, 741 
monitor list accessing, 724 
monitor list default index modification, 731 
monitor list searching, 725 
monitor list searching in device list, 725 
monitor list searching in instance list, 726 
monitor list switching, 725 
monitor saving to performance view, 730 
monitor saving to performance view (monitor settings 

page), 736 
monitored device only display, 730 
performance option common index configuration, 754 
performance option default monitor index configuration, 

757 
performance option device memory usage trend alarms 

configuration, 756 
performance option display index configuration, 755 
performance option display option setting, 752 
performance option dynamic threshold index 

configuration, 756 
performance option instance profile adding, 753 
performance option instance profile configuration, 753 
performance option instance profile deletion, 754 
performance option instance profile list viewing, 753 
performance option instance profile modification, 754 
performance option management, 751 
performance option monitor option setting, 752 
performance option periodic monitor addition, 761 
performance option periodic monitor deletion, 761 
performance option periodic monitor list viewing, 760 
performance option periodic monitor modification, 761 
performance option periodic monitoring configuration, 

760 
performance option service monitor addition, 758 
performance option service monitor deletion, 760 
performance option service monitor list viewing, 758 
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performance option service monitor modification, 759 
performance option service monitor starting, 760 
performance option service monitor stopping, 760 
performance option service monitoring configuration, 757 
performance option TOPN index configuration, 755 
performance view report exporting, 744 
performance view report printing, 744 
performance view report viewing, 744 
real-time monitor addition, 748 
real-time monitor deletion, 749 
real-time monitor graph addition, 750 
real-time monitor graph deletion, 751 
real-time monitor graph management, 749 
real-time monitor graph modification, 751 
real-time monitor graph viewing, 750 
real-time monitor management, 748 
real-time monitor modification, 749 
real-time monitor page viewing, 747 
real-time monitor viewing, 748 
real-time performance monitor management, 747 
TopN performance view viewing, 740 
Trend Line or Data Grid performance view viewing, 742 
view creation (monitor settings page), 735 
view deletion, 739 
view details viewing, 732 
view list viewing, 731 
view management, 731 
view shortcut addition, 736 
view shortcut removal, 737 
view threshold setting modification, 733 
view upper-level folder modification, 737 
view viewing, 740 

Performance Monitor 
metrics and statistics, 364 
report access, 324 

performance option 
common index configuration, 754 
default monitor index configuration, 757 
device memory usage trend alarms configuration, 756 
display index configuration, 755 
display option setting, 752 
dynamic threshold index configuration, 756 
instance profile adding, 753 
instance profile configuration, 753 
instance profile deletion, 754 
instance profile list viewing, 753 
instance profile modification, 754 
management, 751 
monitor option setting, 752 
TOPN index configuration, 755 

Performance Top5 widget, 64 
Performance View Profile widget, 48 
performance views 

At a Glance performance view modification, 738 
At a Glance performance view viewing, 743 
At a Glance view creation, 735 
creation (monitor settings page), 735 
Data Grid/Trend Line performance view modification, 737 
Data Grid/Trend Line view creation, 733 
deletion, 739 
detail viewing, 732 
list viewing, 731 

management, 731 
monitor instance viewing, 741 
monitor saving (monitor settings page), 736 
report exporting, 744 
report printing, 744 
report viewing, 744 
threshold setting modification, 733 
TopN viewing, 740 
Trend Line or Data Grid performance view viewing, 742 
view shortcut addition, 736 
view shortcut removal, 737 
view upper-level folder modification, 737 
viewing, 740 

performing 
advanced device search, 99 
advanced interface search, 100 
advanced user search, 101 
alarm actions (All Alarms page), 690, 692 
basic device search, 97 
basic user search, 98 
general search, 98 
real-time alarm actions (Alarm Details page), 687 

periodic 
event configuration entry addition, 931 

Perl 
third-party device Perl script definition, 479 

personalizing 
Web desktop personalization, 145 

Physical Network Asset Statistics 
widget, 80 

ping 
settings modification (batch mode), 373 

plan 
auto discovery 

plan management, 247 
device plan check results viewing (batch mode), 376 
device settings plan creation (batch mode), 374 
device settings plan list viewing (batch mode), 375 

plug-in 
SMS plug-in installation, 928 

policy 
alarm matching policy addition, 914 
alarm matching policy configuration, 913 
alarm matching policy deletion (user-defined), 917 
alarm matching policy detailed information viewing, 914 
alarm matching policy list viewing, 913 
alarm matching policy modification (user-defined), 916 
backup policy option configuration, 211 
compliance policy aggregate link rule viewing, 611 
compliance policy check results viewing, 625 
compliance policy check tasks, 613 
compliance policy configuration segment rule viewing, 

612 
compliance policy copying, 608 
compliance policy creation, 599 
compliance policy deletion, 608 
compliance policy detailed information viewing, 596 
compliance policy device rule viewing, 610 
compliance policy disabling (all), 609 
compliance policy disabling (single), 609 
compliance policy enabling (all), 608 
compliance policy enabling (single), 608 
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compliance policy interface rule viewing, 610 
compliance policy link rule viewing, 611 
compliance policy list viewing, 595 
compliance policy modification, 604 
compliance policy querying, 599 
compliance policy rule detailed information viewing, 597 
compliance policy rules, 609 
energy-saving policies implementation (batch mode), 379 
security, 33 
security control policy addition, 918 
security control policy deletion, 925 
security control policy execution, 925 
security control policy execution history viewing, 925 
security control policy list viewing, 918 
security control policy management, 918 
security control policy modification, 922 
Syslog filtering policy setting, 669 
Unauthorized Access Processing Policy configuration, 432 

polling 
ACL configuration polling customization, 859 
device list poll interval settings access (batch mode), 401 
polling interval configuration (batch mode), 372 

port 
group addition (VRM), 453 
Important Ports widget, 72 
Interface List (by Port Group), 78 
Port Group widget, 76 
Port Group—TopN widget, 76 
VLAN access port configuration (batch mode), 959 
VLAN access port PVID modification, 950 
VLAN access port tab, 950 
VLAN access port viewing, 950 
VLAN hybrid port addition, 954 
VLAN hybrid port configuration (batch mode), 960 
VLAN hybrid port deletion, 954 
VLAN hybrid port modification, 954 
VLAN hybrid port tab, 953 
VLAN hybrid port viewing, 953 
VLAN trunk port addition, 952 
VLAN trunk port configuration (batch mode), 960 
VLAN trunk port deletion, 952 
VLAN trunk port modification, 952 
VLAN trunk port tab, 951 
VLAN trunk port viewing, 951 

Port Group 
addition, 304 
advanced property modification, 464 
deletion, 305 
device interface viewing, 302 
interface list viewing, 303 
list querying, 302 
management, 302 
modification, 305 

Port Group—TopN widget, 51 
Port Group widget, 76 
Port Group—TopN widget, 76 
PowerShell 

template configuration, 159 
template deletion, 161 

protocol management 
protocol configuration+information, 357 

printing 

performance view report, 744 
real time reports, 1030 

processing 
data collection all alarms, 242 
events manually, 938 

profile 
Performance Instance Profile, 47 
Performance View Profile, 48 
virtual machine profile modification, 460 

PVID 
VLAN access port PVID modification, 950 

querying 
account group, 993 
ACL device list, 859 
alarms (All Alarms page), 690 
Asset Audit List, 445 
Asset OID, 440 
attack alarm list, 904, 906 
backup history reports, 585 
check task history, 621 
compliance policy, 599 
configuration backup report, 589 
configuration baseline report, 591 
Configuration Center devices, 500 
configuration templates, 513 
device groups, 195 
events, 937 
global VLAN, 942 
guest access logs, 1009 
guest access operators, 1002 
History Access Log, 421 
IMC alarm, 684 
IP allocated IP address (terminal access), 409 
IP segments (terminal access), 407 
network asset, 438 
operation logs, 224 
operator, 183 
port group list, 302 
rack view, 306 
real-time location IP address location, 422 
real-time location MAC address location, 422 
report template, 1021 
software baseline report, 594 
software update report, 593 
Syslog entries in IMC, 666 
traps, 635, 653 
Unauthorized Access list, 415 
Unauthorized Access log, 417 
users, 984 
users (advanced), 985 
users (basic), 984 
virtual machine migration recommendations, 462 
virtual machine migration reports, 463 
VLAN device, 945 
VRM virtual network server, 452 
VXLAN network devices, 963 
VXLAN servers, 967 
VXLAN tunnels, 972 
VXLANs, 969 

Quick Service Process View, 141 
Quick Service Process widget, 78 
Quick Start 
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accessing, 94 
function configuration, 136 

Rack View 
list viewing, 306 
querying, 306 

RADIUS 
authentication services configuration, 177 

Real-Time Alarm widget, 45 
Real-Time Alarms 

action performance (Alarm Details page), 687 
alarm deletion from list (Real-Time Alarms page), 688 
alarm recovery (Real-Time Alarms page), 687 
browsing, 685 
detail viewing (Real-Time Alarms page), 686 
relation report viewing (Alarm Details page), 687 
viewing (filtered), 686 

Real-Time Alarms page 
real-time alarm deletion from list, 688 
real-time alarm recovery, 687 
real-time alarm viewing, 686 

real-time attack alarm 
alarm deletion, 908 
list alarm browsing, 906 
list refreshing, 907 

real-time location 
IP address location querying, 422 
MAC address location querying, 422 
terminal access, 422 

Real-Time Monitoring (RTM) 
operator group RTM access rights configuration, 175 

real-time performance monitor 
management, 747 
monitor addition, 748 
monitor deletion, 749 
monitor graph addition, 750 
monitor graph deletion, 751 
monitor graph management, 749 
monitor graph modification, 751 
monitor graph viewing, 750 
monitor management, 748 
monitor modification, 749 
monitor viewing, 748 
page viewing, 747 

real-time report 
addition, 1028 
all scheduled report viewing, 1033 
deletion, 1030 
management, 1028 
modification, 1030 
My Real Time Report page customization, 1026 
My Real Time Report resetting, 1026 
printing, 1030 
scheduled report deletion, 1038 
scheduled report history access, 1037 
scheduled report history deletion, 1037 
scheduled report list filtering, 1033 
scheduled report modification, 1036 
scheduled report suspension/resumption, 1038 
scheduling, 1032 
template report addition, 1027 
template report modification, 1027 
template report running, 1027 

use, 1026 
viewing, 1029 

Real-Time report 
scheduled report addition, 1034 

rebooting 
device (batch mode), 402 
devices (batch mode), 378 

record 
maintenance records viewing, 396 

recovering 
real-time alarms (Real-Time Alarms page), 687 

recycling 
IP recycle bin viewing (terminal access), 413 

re-executing 
backup history failed or partially successful backup, 587 

refreshing 
device list, 400 
History Access Log page, 421 
home page space widget manually, 41 
network asset details view, 444 
real-time attack alarm list, 907 
Server Details page, 454 
switch access binding list, 428 
traffic topology refresh parameter setting, 270 
Unauthorized Access list, 419 
Unauthorized Access log list, 419 
VRM virtual network view, 453 

registering 
service operation, 481 
Web desktop application, 146 

relation 
alarm relation report viewing, 683 

relationship 
alarm relationship viewing, 690 

removing 
ACL from device, 890 
ACL uses from device, 896 
baseline from baseline software, 533 
compiled MIB from IMC, 208 
device group devices, 197 
device group devices (multiple), 198 
device list (custom view), 398 
network asset, 444 
performance view shortcut, 737 

renaming 
ACL, 809 
configuration template, 522 
home page space, 39 
software library entry, 530 

replaceable variable list, 495 
report 

alarm analysis reports, 1019 
alarm relation report viewing, 683 
all scheduled report viewing, 1033 
backup history report accessing, 584 
backup history report detailed information viewing, 586 
backup history report querying, 585 
current report data source viewing, 1030 
custom report addition, 1041 
custom report addition to My Reports, 1025 
custom report deletion, 1043 
custom report exporting, 1040, 1042 
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custom report management, 1041 
custom report modification, 1042 
custom report template, 1039 
custom report template addition, 1023, 1040 
custom report template deletion, 1025, 1041 
custom report template list viewing, 1024 
custom report template modification, 1025, 1040 
custom report viewing, 1042 
execution results report, 927 
Intelligent Configuration Report, 1020 
Last Hour Events, 939 
My Real Time Report page customization, 1026 
My Real Time Report resetting, 1026 
performance analysis summary reports, 1020 
performance view report exporting, 744 
performance view report printing, 744 
performance view report viewing, 744 
Policy Execution Result in Last Hour, 939 
real time report addition, 1028 
real time report deletion, 1030 
real time report management, 1028 
real time report modification, 1030 
real time report printing, 1030 
real time report scheduling, 1032 
real time report template addition, 1027 
real time report template modification, 1027 
real time report template running, 1027 
real time report use, 1026 
real time report viewing, 1029 
report data source addition, 1031 
report data source deletion, 1032 
report data source management, 1030 
report data source modification, 1032 
report option insertion, 1032 
resource statistics report templates, 1018 
SCC report viewing, 925 
scheduled report addition, 1034 
scheduled report deletion, 1038 
scheduled report history access, 1037 
scheduled report history deletion, 1037 
scheduled report list filtering, 1033 
scheduled report modification, 1036 
scheduled report suspension/resumption, 1038 
template access right setting (batch mode), 1023 
template addition, 1022 
template deletion, 1022 
template list access, 1021 
template modification, 1022 
template querying, 1021 
Top 10 attack alarm report, 926 
Top 10 attack destinations report, 926 
Top 10 attack sources report, 926 
Virtual Machine Information Report, 1020 

Report Page access, 93 
Report tab, 1018 
reporting 

configuration audits+reports, 498 
resetting 

My Real Time Reports, 1026 
resource management 

device access templates, 149 
device routes, 393 

device+interface maintenance tag tasks, 394 
IMC device addition, 244 
maintenance records viewing, 396 
maintenance tag task addition, 394 
maintenance tag task copying, 395 
maintenance tag task deletion, 396 
maintenance tag task list viewing, 394 
maintenance tag task modification, 395 
maintenance tag task stopping, 395 
network resource management (global settings), 148 

Resource Management page, 87 
alarm tab, 92 
device details, 89 
quick start link, 94 
report tab, 93 
service tab, 91 
system tab, 93 
topology maps, 88 
user tab, 90 

Resource Management tab, 243 
restarting failed backup, 584 
restoring 

configuration backup report file, 589 
configuration baseline report files, 592 
configuration file, 505 
configuration from Configuration Center, 511 
device configuration using Deployment Guide, 546 
device software using Deployment Guide, 549 
home page space widget, 41 
software baseline report, 594 
software update report, 593 

restrictions 
security monitoring, 33 

result 
auto discovery results viewing, 247 
device check results viewing (batch mode), 376 
device plan check results viewing (batch mode), 376 
execution result report viewing, 912 
execution results report, 927 

resuming 
deployment task, 559 
scheduled reports, 1038 
system calculation, 712 

retrieving 
Configuration Retrieval Report, 628 
History Access Log data (periodic), 420 
History Access Log data (retrieve now), 420 

RMON 
network device management, 346 

Root Alarms List 
alarm deletion, 692 

routing 
device route management, 393 

RSS widget customization, 83 
rule 

ACL advanced template rule addition, 796 
ACL template rule addition, 794 
ACL template rule copying, 806 
ACL template rule deletion, 807 
ACL template rule management, 794 
ACL template rule modification, 800 
advanced ACL template rule modification, 801 
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alarm forwarding rule addition, 705 
alarm forwarding rule copying, 709 
alarm forwarding rule deletion, 710 
alarm forwarding rule disabling, 709 
alarm forwarding rule disabling (batch), 709 
alarm forwarding rule enabling, 709 
alarm forwarding rule enabling (batch), 709 
alarm forwarding rule modification, 707 
alarm level configuration rule addition, 713 
alarm level configuration rule deletion, 716 
alarm level configuration rule disabling, 715 
alarm level configuration rule enabling, 715 
alarm level configuration rule modification, 715 
compliance policy, 609 
compliance policy aggregate link rule viewing, 611 
compliance policy configuration segment rule viewing, 

612 
compliance policy device rule viewing, 610 
compliance policy interface rule viewing, 610 
compliance policy link rule viewing, 611 
compliance policy rule detailed information viewing, 597 
duplication trap filter rule modification, 636 
IMC trap filter rule viewing, 636 
intermittent trap filter rule modification, 638 
link ACL template rule addition, 798 
link ACL template rule modification, 804 
mail alarm notification rule addition, 696 
mail alarm notification rule copying, 700 
mail alarm notification rule deletion, 700 
mail alarm notification rule disabling, 700 
mail alarm notification rule disabling (batch), 700 
mail alarm notification rule enabling, 700 
mail alarm notification rule enabling (batch), 700 
mail alarm notification rule modification, 699 
SMS alarm notification rule addition, 701 
SMS alarm notification rule copying, 704 
SMS alarm notification rule deletion, 704 
SMS alarm notification rule disabling, 704 
SMS alarm notification rule disabling (batch), 704 
SMS alarm notification rule enabling, 704 
SMS alarm notification rule enabling (batch), 704 
SMS alarm notification rule modification, 703 
SMS alarm notification rules exporting (all), 704 
Syslog filtering rule addition, 669 
Syslog filtering rule copying, 671 
Syslog filtering rule deletion, 672 
Syslog filtering rule detail viewing, 668 
Syslog filtering rule disabling, 671 
Syslog filtering rule enabling, 671 
Syslog filtering rule modification, 670 
Syslog filtering rule viewing, 668 
Syslog to alarm rule browsing, 676 
Syslog to alarm rule copying, 681 
Syslog to alarm rule disabling, 681 
Syslog to alarm rule enabling, 681 
trap filtering (existing IMC filter rules), 636 
trap-to-alarm rule viewing, 646 
user-defined ACL template rule addition, 800 
user-defined ACL template rule modification, 805 
user-defined Syslog to alarm rule creation, 676 
user-defined Syslog to alarm rule deletion, 681 
user-defined Syslog to alarm rule modification, 679 

user-defined trap filter rule addition, 639 
user-defined trap filter rule deletion, 646 
user-defined trap filter rule modification, 643 
user-defined trap filter rules, 639 
user-defined trap-to-alarm rule creating, 647 

rule set 
ACL device as rule set saving, 866 
ACL device as template saving, 867 
addition, 814 
copying, 834 
deletion, 847 
deployment, 835 
importing, 835 
information viewing, 809 
management, 809 
modification, 825 
rule addition, 848 
rule copying, 854 
rule deletion, 854 
rule management, 848 
rule modification, 848 
rule optimization, 856 
rule order sorting, 855 

running 
custom report template, 1039 
deployment task, 558 
real time report template, 1027 

running configuration 
Configuration Center latest running configuration, 501 

saving 
ACL device as rule set, 866 
ACL device as template, 867 
device configuration (batch mode), 377, 402 
home page space, 39 
monitor to performance view, 730 
monitor to performance view (monitor settings page), 736 

scenario 
trap-to-alarm rule scenario modification, 650 

scheduling 
all scheduled report viewing, 1033 
real time reports, 1032 
scheduled report addition, 1034 
scheduled report deletion, 1038 
scheduled report history access, 1037 
scheduled report history deletion, 1037 
scheduled report list filtering, 1033 
scheduled report modification, 1036 
scheduled report suspension/resumption, 1038 

script 
background custom script definition, 481 
third-party device Perl script definition, 479 
third-party device TCL script definition, 479 

searching 
advanced device search, 99 
advanced interface search, 100 
advanced user search, 101 
basic device search, 97 
basic user search, 98 
deployment task, 555 
general search, 98 
global index settings, 718 
monitor, 725 
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monitor in device list, 725 
monitor in instance list, 726 
software library entry, 527 
VLAN deployment task, 956 

security 
policies and restrictions, 33 

Security Control Center (SCC) 
action management, 932 
alarm matching policy configuration, 913 
attack alarm action execution, 911 
attack monitoring+management, 900 
attack topology map viewing, 908 
event configuration entry management, 930 
event viewing, 936 
execution results report, 927 
intelligent policy center (IPC), 929 
Last Hour Events report, 939 
Policy Execution Result in Last Hour, 939 
policy management, 932 
report viewing, 925, 939 
security attack alarm management, 901 
security control policy management, 918 
SMS integration, 927 
SMS managed devices in topology, 928 
SMS management page navigation, 928 
SMS plug-in installation, 928 
Top 10 alarm attack report, 926 
Top 10 attack destinations report, 926 
Top 10 attack sources report, 926 

security control policy 
addition, 918 
deletion, 925 
execution, 925 
execution history viewing, 925 
execution results report, 927 
list viewing, 918 
management, 918 
modification, 922 

segment 
network segment address importing, 247 

self-service 
guest access self-service system, 1010 
guest access self-service system login, 1011 

series 
device series configuration, 165 

server 
IMC server CPU information viewing, 226 
IMC server database information viewing, 227 
IMC server disk information viewing, 227 
IMC server information configuration, 226 
IMC server memory information viewing, 227 
IMC server process viewing, 226 
port group addition, 453 
VRM configuration, 453 
VRM virtual network server querying, 452 
vSwitch addition, 453 
VXLAN server deletion, 968 
VXLAN server importing, 967 
VXLAN server list viewing, 966 
VXLAN server management, 966 
VXLAN server querying, 967 

Server Details page 

refreshing, 454 
VRM virtual network server details page, 450 
VRM virtual network server-level details, 449 

service 
ACL service list service addition (ACL assistant), 766 
ACL service list service deletion (ACL assistant), 767 
ACL service list service modification (ACL assistant), 767 
ACL service list viewing (ACL assistant), 766 
ACL service management (ACL assistant), 766 
ACL service viewing (ACL assistant), 766 
Device Details page monitoring, 310 
Quick Service Process, 78 
service operation registration, 481 

service monitor 
addition, 758 
configuration, 757 
deletion, 760 
list viewing, 758 
modification, 759 
periodic monitor addition, 761 
periodic monitor deletion, 761 
periodic monitor list viewing, 760 
periodic monitor modification, 761 
periodic monitoring configuration, 760 
starting, 760 
stopping, 760 

Service Page access, 91 
service-oriented architecture (SOA) 

application development model, 21 
framework, 26 
IMC framework layers, 22 

setting 
auto discovery default monitor indexes, 247 
backup policy alarm generation mode, 211 
home page space widget background, 41 
home page space widget refresh interval, 41 
home page space widget title, 41 
max backup configuration files, 212 
max backup configuration history days, 212 
operator group report template access rights, 175 
performance option display option, 752 
performance option monitor option, 752 
report template access rights (batch mode), 1023 
Syslog filtering policies, 669 
traffic topology refresh parameters, 270 
Web interface theme, 103 

severity 
trap definition device severity list management, 663 
trap definition severity settings modification, 661 

sharing 
custom information between operators, 191 

Short Message Service Center. Use SMSC 
Simple Mode configuration comparison, 535 
SMS 

mail to SMS message conversion, 206 
managed devices in topology, 928 
management page navigation, 928 
message sending records viewing, 206 
other sender configuration, 205 
plug-in installation, 928 
SCC integration, 927 
sender configuration, 205 
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SMS alarm notification 
management, 701 
rule addition, 701 
rule copying, 704 
rule deletion, 704 
rule disabling, 704 
rule disabling (batch), 704 
rule enabling, 704 
rule enabling (batch), 704 
rule modification, 703 
rules exporting (all), 704 

SMSC 
GSM modem configuration, 204 
mail to SMS message conversion, 206 
other SMS sender configuration, 205 
settings configuration, 204 
SMS message sending records viewing, 206 
SMS sender configuration, 205 

SNMP 
compiled MIB removal from IMC, 208 
compiled MIB to IMC addition, 207 
configuration (existing template), 369 
device list SNMP settings access (batch mode), 400 
duplicate trap filter rule modification, 636 
editing (manual), 368 
existing template use, 245 
IMC trap filter rule viewing, 636 
intermittent trap filter rule modification, 638 
manual settings editing, 245 
MIB compilation in IMC, 207 
MIB management, 207 
settings configuration (batch mode), 368 
template configuration, 149 
trap browsing, 633 
trap detail viewing, 634 
Trap Details page viewing, 634 
trap filter configuration (device not in IMC), 639 
trap filtering (existing IMC filter rules), 636 
trap management, 633 
trap management (right navigation tree), 635 
trap querying, 635 
user-defined trap filter rule addition, 639 
user-defined trap filter rule deletion, 646 
user-defined trap filter rule modification, 643 
user-defined trap filter rules, 639 

SOAP 
SOAP/HTTP template configuration, 156 

software 
baseline establishment, 510 
Configuration Center deployment, 510 
deployment using Deployment Guide, 541 
device software deployment, 403 
LiveUpdate configuration, 235 
LiveUpdate device software updating, 235 
LiveUpdate IMC software updating, 235 
OAP software deployment using Deployment Guide, 551 
software to deploy information modification, 568 
update history viewing, 507 

Software Baseline Report 
querying, 594 
restoration, 594 
use, 593 

viewing, 593 
software library 

baseline establishment by entry, 532 
baseline removal from baseline software, 533 
entry deleting, 532 
entry details viewing, 527 
entry exporting, 531 
entry modification, 531 
entry renaming, 530 
entry searching, 527 
import into library from device, 528 
import into library from file, 528 
import into library from Web download, 529 
management, 525 
OAP software addition, 529 
viewing, 526 

Software Update Report 
querying, 593 
restoration, 593 
use, 592 
viewing, 592 

sorting 
ACL rule set rule order, 855 
Web interface favorite, 102 

sound 
alarm sound settings enable, 84 

space 
customization, 81 
home page space widget background setting, 41 
home page space widget collapse, 40 
home page space widget content display, 41 
home page space widget deletion, 41 
home page space widget dragging, 41 
home page space widget dropping, 41 
home page space widget expansion, 40 
home page space widget manual refresh, 41 
home page space widget open in new window, 41 
home page space widget refresh interval setting, 41 
home page space widget restoration, 41 
home page space widget title setting, 41 

Spanning Tree Protocol (STP) 
configuration on interface (batch mode), 382 
configuration on switch (batch mode), 381 

special workday 
configuration, 231 
configuration page viewing, 230 
deletion, 232 
modification, 231 

SSH 
configuration (existing template), 371 
device list SSH settings access (batch mode), 401 
manual settings editing, 246 
settings addition (batch mode), 371 
settings configuration (batch mode), 371 
settings editing (manual), 371 
settings modification (batch mode), 371 
template configuration, 153 
template use, 247 

starting 
ACL deployment task, 887 
performance option service monitor, 760 

startup configuration 
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Configuration Center latest startup configuration, 501 
statistics 

alarm statistics chart viewing, 693 
alarm statistics viewing, 693 
Lower-Level System Alarm Statistics, 45 
Physical Network Asset Statistics widget, 80 
resource statistics report templates, 1018 
Unrecovered Alarm Statistics, 46 
Upper+Lower-Level System Alarm Statistics, 46 
user-defined alarm statistics chart creation, 694 
view config alarm statistics widget configuration, 127 

stopping 
ACL deployment task, 887 
maintenance tag task, 395 
performance option service monitor, 760 

storing 
device configuration backups in cipher text, 579 

strategy 
IMC password strategy configuration, 181 
trap-to-alarm upgrade strategy modification, 649 

subnetting 
ACL management subnet mask type configuration, 773 

suspending 
deployment task, 559 
scheduled reports, 1038 

switch access 
binding, 426 
binding list refreshing, 428 
Unauthorized Access switch access binding, 418 

switching 
between home page spaces, 39 
monitor list, 725 
task management perspectives, 140 
Web desktop IMC edition switching, 143 
Web desktops, 143 

synchronizing 
ACL devices, 859 
device list, 400 

Syslog 
alarm rule use, 676 
detail viewing, 667 
device detailed information viewing, 667 
entry browsing, 665 
entry filtering, 668 
entry querying in IMC, 666 
filtering policy setting, 669 
filtering rule addition, 669 
filtering rule copying, 671 
filtering rule deletion, 672 
filtering rule detail viewing, 668 
filtering rule disabling, 671 
filtering rule enabling, 671 
filtering rule modification, 670 
filtering rule viewing, 668 
management, 665 
message alarm configuration, 672 
Syslog to alarm rule browsing, 676 
Syslog to alarm rule copying, 681 
Syslog to alarm rule disabling, 681 
Syslog to alarm rule enabling, 681 
template browsing, 672 
template copying, 675 

template use, 672 
user-defined Syslog to alarm rule creation, 676 
user-defined Syslog to alarm rule deletion, 681 
user-defined Syslog to alarm rule modification, 679 
user-defined template creation, 673 
user-defined template deletion, 675 
user-defined template modification, 674 

system administration 
account group management, 991 
guest access log detail viewing, 1010 
guest access log list viewing, 1008 
guest access log querying, 1009 
guest access log use, 1008 
guest access management, 996 
guest access operator addition, 1004 
guest access operator deletion, 1007 
guest access operator detail viewing, 1003 
guest access operator list viewing, 1002 
guest access operator log auditing, 1007 
guest access operator management, 1001 
guest access operator modification, 1006 
guest access operator querying, 1002 
guest access self-service system, 1010 
guest access self-service system login, 1011 
guest access system parameter configuration, 1010 
guest access user group addition, 999 
guest access user group deletion, 1001 
guest access user group detail viewing, 1000 
guest access user group list viewing, 998 
guest access user group management, 998 
guest account management, 1014 
guest account opening, 1012 
guest online operator viewing, 1016 
guest operator password modification, 1016 
IMC system settings configuration, 214 
IMC system settings modification, 214 
system calculation resumption, 712 
user basic information managing, 984 
user basic information modification, 985 
user basic information viewing, 983 
user deletion, 988 
user group list viewing, 982 
user group user movement, 987 
user list viewing, 981 
user management, 981 
user querying, 984 
user querying (advanced), 985 
user querying (basic), 984 

System tab, 93 
system-wide help, 96 
TACACS 

authentication services configuration, 179 
tag 

device+interface maintenance tag tasks, 394 
maintenance tag task addition, 394 
maintenance tag task copying, 395 
maintenance tag task deletion, 396 
maintenance tag task list viewing, 394 
maintenance tag task modification, 395 
maintenance tag task stopping, 395 

taking alarm action, 683 
task 
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ACL deployment task detailed information viewing, 885 
ACL deployment task list management, 883 
ACL deployment task list viewing, 883 
ACL deployment task modification, 885 
ACL deployment task starting, 887 
ACL deployment task stopping, 887 
check task history deletion, 622 
check task history querying, 621 
check task history use, 620 
check task history viewing, 621 
compliance policy check results viewing, 625 
compliance policy check task addition, 615 
compliance policy check task copying, 617 
compliance policy check task deletion, 618 
compliance policy check task details, 614 
compliance policy check task list, 613 
compliance policy check task modification, 616 
compliance policy check task querying, 615 
compliance policy check tasks, 613 
configuration check report viewing, 627 
configuration retrieval report viewing, 628 
deployment task copying, 558 
deployment task deletion, 560 
deployment task list accessing, 554 
deployment task management, 554 
deployment task modification, 556 
deployment task resumption, 559 
deployment task running, 558 
deployment task searching, 555 
deployment task suspension, 559 
device violating results viewing, 626 
device+interface maintenance tag tasks, 394 
maintenance tag task addition, 394 
maintenance tag task copying, 395 
maintenance tag task deletion, 396 
maintenance tag task list viewing, 394 
maintenance tag task modification, 395 
maintenance tag task stopping, 395 
task execution results use, 623 
task execution results, task execution report, 

configuration retrieval report use, 622 
VLAN deployment task, 955 
VLAN deployment task entry deletion, 956 
VLAN deployment task searching, 956 
VLAN deployment task viewing, 955 

Task Management 
accessing, 138 
message history access, 139 
message options, 140 
perspective switching, 140 
quick service process view, 141 
Web desktop entry, 142 
Web desktop IMC edition switching, 143 
Web desktop login, 142 
Web desktop menu access, 144 
Web desktop switching, 143 
Web desktop viewing, 143 

TCL 
third-party device TCL script definition, 479 

Telnet 
configuration (batch mode), 369 
configuration (existing template), 370 

device list Telnet settings access (batch mode), 400 
parameter editing (manual), 245 
settings editing (manual), 369 
template configuration, 151 
template use, 246 

template 
ACL advanced template creation, 778 
ACL advanced template rule addition, 796 
ACL basic template creation, 777 
ACL device as template saving, 867 
ACL device flow template application management, 881 
ACL device flow template management, 878 
ACL template configuration, 774 
ACL template copying, 793 
ACL template creation, 774, 776 
ACL template deletion, 794 
ACL template exporting, 794 
ACL template list viewing, 775 
ACL template modification, 786 
ACL template rule addition, 794 
ACL template rule copying, 806 
ACL template rule deletion, 807 
ACL template rule management, 794 
ACL template rule modification, 800 
ACL template viewing, 775 
advanced ACL template modification, 787 
advanced ACL template rule modification, 801 
basic ACL template modification, 786 
configuration template accessing, 512 
configuration template addition manually, 519 
configuration template addition using backup file, 516 
configuration template addition using file import, 518 
configuration template copying, 523 
configuration template creation, 515 
configuration template creation using Save As, 507 
configuration template deletion, 525 
configuration template deployment, 525 
configuration template exporting, 525 
configuration template modification, 521 
configuration template organization, 514 
configuration template querying, 513 
configuration template renaming, 522 
configuration templates, 497 
custom report, 1023, 1038 
custom report addition to My Reports, 1025 
custom report exporting, 1040 
custom report list access, 1039 
custom report template, 1039 
custom report template addition, 1023, 1040 
custom report template deletion, 1025, 1041 
custom report template list viewing, 1024 
custom report template modification, 1025, 1040 
device access templates, 149 
device configuration management with templates, 512 
global index settings custom template addition, 720 
link ACL template creation, 782 
link ACL template modification, 790 
link ACL template rule addition, 798 
link ACL template rule modification, 804 
login control template addition, 180 
login control template deletion, 181 
login control template list viewing, 179 

Anexo 02 ITENS 21 E 22 (0592760)         SEI 0008478-63.2018.6.02.8000 / pg. 9489



1088 

login control template modification, 180 
My Report templates, 1018 
NETCONF template configuration, 155 
operation log chart template addition, 224 
operation log chart template management, 225 
operator group report template access rights setting, 175 
operator login control templates, 179 
PowerShell template configuration, 159 
PowerShell template deletion, 161 
report template access right setting (batch mode), 1023 
report template addition, 1022 
report template deletion, 1022 
report template list access, 1021 
report template modification, 1022 
report template querying, 1021 
resource statistics report templates, 1018 
SMSC settings configuration, 204 
SNMP configuration (existing template), 369 
SNMP existing template use, 245 
SNMP template configuration, 149 
SOAP/HTTP template configuration, 156 
SSH configuration (existing template), 371 
SSH template configuration, 153 
SSH template use, 247 
Syslog template browsing, 672 
Syslog template copying, 675 
Syslog template use, 672 
Telnet configuration (existing template), 370 
Telnet template configuration, 151 
Telnet template use, 246 
user-defined ACL template creation, 784 
user-defined ACL template modification, 792 
user-defined ACL template rule addition, 800 
user-defined ACL template rule modification, 805 
user-defined Syslog template creation, 673 
user-defined Syslog template deletion, 675 
user-defined Syslog template modification, 674 
virtual machine template management, 466 
WMI template configuration, 161 

terminal access 
allocated IP address deletion, 413 
allocated IP address querying, 409 
binding, 423 
History Access Log, 419 
History Access Log data retrieval (periodic), 420 
History Access Log data retrieval (retrieve now), 420 
History Access Log deletion, 421 
History Access Log list viewing, 419 
History Access Log page refreshing, 421 
History Access Log querying, 421 
idle IP address detection, 414 
IP address allocation, 406 
IP address allocation (manual), 410 
IP address allocation using auto scanning (manual), 410 
IP address allocation using import IP address, 411 
IP address exporting, 412 
IP address resource management, 405 
IP address segment importing, 411 
IP recycle bin viewing, 413 
IP segment addition, 408 
IP segment deletion, 409 
IP segment exporting, 412 

IP segment list viewing, 406 
IP segment modification, 408 
IP segment querying, 407 
IP/MAC address binding, 428 
real-time location, 422 
real-time location IP address location querying, 422 
real-time location MAC address location querying, 422 
Unauthorized Access, 414 
Unauthorized Access cancel action, 418 
Unauthorized Access entry deletion, 418 
Unauthorized Access list querying, 415 
Unauthorized Access list refreshing, 419 
Unauthorized Access list viewing, 414 
Unauthorized Access log list refreshing, 419 
Unauthorized Access log list viewing, 416 
Unauthorized Access log querying, 417 
Unauthorized Access Processing Policy configuration, 432 
Unauthorized Access switch access binding, 418 
Unauthorized Access terminal access binding, 417 

theme 
Web desktop personalization, 145 

third-party device 
background custom script definition, 481 
common service (CLICommon) definition, 473 
component action definition, 474 
component service definition, 474 
customized function extension, 480 
device capability set definition file compilation, 494 
drive definition file creation, 471 
drive folder creation, 470 
drive index file creation, 470 
operation definition file compilation, 481 
parser service (CleanupParser) definition, 477 
replaceable variable list, 495 
script customization, 469 
service operation registration, 481 
software deployment services definition, 475 
specific services definition, 475 
TCL script definition, 479 
vendor folder creation, 469 

threshold 
alarm performance threshold modification, 684 
performance option dynamic threshold index 

configuration, 756 
performance view threshold setting modification, 733 

time 
ACL cyclic time range configuration (ACL assistant), 772 
ACL device time range management, 873 
ACL fixed time range configuration (ACL assistant), 772 
ACL time range addition (ACL assistant), 771 
ACL time range deletion (ACL assistant), 773 
ACL time range list viewing (ACL assistant), 770 
ACL time range modification (ACL assistant), 773 
ACL time range viewing (ACL assistant), 771 
ACL time ranges management (ACL assistant), 770 
holiday configuration, 229 
holiday configuration page viewing, 229 
holiday deletion, 230 
holiday modification, 229 
special workday configuration, 231 
special workday configuration page viewing, 230 
special workday deletion, 232 
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special workday modification, 231 
work time settings configuration, 228 
workday configuration page viewing, 232 
workday work period addition, 232 
workday work period deletion, 234 
workday work period modification, 233 

toolbar 
topology map toolbar, 258 

Top 10 
attack alarm report, 926 
attack destinations report, 926 
attack sources report, 926 

TopN 
Alarm Top5 widget, 43 
Alarm TopN widget, 42 
Bandwidth Utilization (In) (%)—Top5, 59 
Bandwidth Utilization (In) (%)—TopN, 58 
Bandwidth Utilization (Out) (%)—Top5, 61 
Bandwidth Utilization (Out) (%)—TopN, 60 
CPU Utilization (%)—Top5, 49 
CPU Utilization (%)—TopN, 48 
Custom View Top5, 71 
Customize Top5, 63 
Customize TopN, 62 
Device Response Time (ms)—Top5, 55, 65 
Device Response Time (ms)—TopN, 54 
Device Unreachability (%)—Top5, 57 
Device Unreachability (%)—TopN, 56 
device viewing, 694 
Interface Flux TopN, 50 
Memory Utilization (%)—Top5, 53 
Memory Utilization (%)—TopN, 52 
Performance Top5, 64 
performance view viewing, 740 
Port Group TopN, 51 
Port Group—TopN widget, 76 

TOPN index configuration, 755 
topology 

3D room editing, 278 
3D room network device management, 293 
attack path map viewing (single attack), 909 
attack topology map viewing, 908 
attack topology map viewing (all attacks), 908 
converged topology management, 271 
Custom Topology widget, 75 
custom view access, 296 
custom view management, 297 
data center topology map device management, 276 
data center topology map management, 272 
data shown in topo accessing, 745 
data shown in topo management, 746 
IMC network topology monitor addition, 746 
IMC network topology monitor deletion, 747 
IMC network topology monitor modification, 747 
IP Topology widget, 73 
network topology, 31 
network topology interface navigation, 258 
resource management page topology maps, 88 
SMS managed devices in topology, 928 
stack topology device management, 268 
traffic topology refresh parameter setting, 270 
traffic topology traffic, 269 

view config converged topology widget configuration, 131 
view config custom topology widget configuration, 130 
view config IP topology widget configuration, 127 
VLAN topology map viewing, 957 
VLAN topology maps, 956 
VRM topology map physical server viewing, 278 
VRM topology map virtual network viewing, 277 
VRM virtual network topology viewing, 452 

Topology Map 
customization, 264 
, 260 
options, 265 
toolbar, 258 

Traffic Topology 
refresh parameter setting, 270 
traffic viewing, 269 

trap 
browsing, 633 
destination configuration (batch mode), 380 
detail viewing, 634 
duplicate trap filter rule modification, 636 
filter configuration (device not in IMC), 639 
filtering (existing IMC filter rules), 636 
IMC trap filter rule viewing, 636 
intermittent trap filter rule modification, 638 
management, 633 
management (right navigation tree), 635 
querying, 635 
Trap Details page viewing, 634 
user-defined trap filter rule addition, 639 
user-defined trap filter rule deletion, 646 
user-defined trap filter rule modification, 643 
user-defined trap filter rules, 639 

trap alarms 
generation, 646 
trap-to-alarm rule copying, 650 
trap-to-alarm rule disabling, 652 
trap-to-alarm rule enabling, 652 
trap-to-alarm rule modification, 650 
trap-to-alarm rule scenario modification, 650 
trap-to-alarm rule viewing, 646 
trap-to-alarm upgrade strategy modification, 649 
user-defined trap-to-alarm rule creation, 647 

trap definition 
addition, 654 
device severity list management, 663 
MIB importing, 662 
settings management, 652 
severity settings modification, 661 
trap querying, 653 
user-defined trap definition modification, 658 
viewing, 653 

trap group 
addition, 664 
deletion, 665 
managing, 664 
modification, 664 
viewing, 664 

Trend Line/Data Grid performance view, 742 
triggering 

automatic deployment on devices, 574 
data export trigger export limitation, 222 
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trunk port 
VLAN trunk port addition, 952 
VLAN trunk port configuration (batch mode), 960 
VLAN trunk port deletion, 952 
VLAN trunk port modification, 952 
VLAN trunk port tab, 951 
VLAN trunk port viewing, 951 

tunneling 
VXLAN tunnel addition, 972 
VXLAN tunnel deletion, 972 
VXLAN tunnel list viewing, 971 
VXLAN tunnel modification, 972 
VXLAN tunnel querying, 972 

Unauthorized Access 
cancel action, 418 
entry deletion, 418 
list querying, 415 
list refreshing, 419 
list viewing, 414 
log list refreshing, 419 
log list viewing, 416 
log querying, 417 
Processing Policy configuration, 432 
switch access binding, 418 
terminal access, 414 
terminal access binding, 417 

unblocking IMC online operator, 193 
unmanaging device list, 399 
Unrecovered Alarm Statistics widget, 46 
up/down alarm filter settings modification (batch mode), 

373 
updating 

Configuration Center software update, 498 
LiveUpdate device software, 235 
LiveUpdate IMC software, 235 
software update report querying, 593 
software update report restoration, 593 
software update report use, 592 
software update report viewing, 592 

upgrade 
trap-to-alarm upgrade strategy modification, 649 

Upper+Lower-Level System Alarm Statistics widget, 46 
Upper+Lower-Level System Real-Time Alarm widget, 44 
user 

account group addition, 993 
account group deletion, 996 
account group details viewing, 992 
account group list viewing, 992 
account group modification, 994 
account group querying, 993 
additional information modification (batch mode), 988 
advanced user search, 101 
alarm matching policy deletion (user-defined), 917 
alarm matching policy modification (user-defined), 916 
basic information modification, 985 
basic information page management, 984 
basic user search, 98 
batch user operations, 988 
deletion, 988 
deletion (batch mode), 989 
global index settings user-defined monitor addition, 720 
global index settings user-defined monitor copying, 723 

global index settings user-defined monitor deletion, 723 
global index settings user-defined monitor modification, 

723 
global index settings user-defined monitor viewing, 722 
guest access user group management, 998 
list viewing, 981 
management, 974, 981 
modification (batch mode), 990 
querying, 984 
querying (advanced), 985 
querying (basic), 984 
user-defined ACL template creation, 784 
user-defined ACL template modification, 792 
user-defined ACL template rule addition, 800 
user-defined ACL template rule modification, 805 
user-defined alarm statistics chart creation, 694 
user-defined Syslog template creation, 673 
user-defined Syslog template deletion, 675 
user-defined Syslog template modification, 674 
user-defined Syslog to alarm rule creation, 676 
user-defined Syslog to alarm rule deletion, 681 
user-defined Syslog to alarm rule modification, 679 
user-defined trap definition modification, 658 
user-defined trap filter rule addition, 639 
user-defined trap filter rule deletion, 646 
user-defined trap filter rule modification, 643 
user-defined trap filter rules, 639 
user-defined trap-to-alarm rule creating, 647 
view config user-defined widget configuration, 134 
Web desktop user login data viewing, 144 

user group 
addition, 200 
basic information viewing, 983 
configuration, 199 
deletion, 201 
list viewing, 199 
modification, 201 
subgroup addition, 200 
subgroup deletion, 202 
subgroup modification, 201 
user list viewing, 982 
user movement, 987 

user management 
group-based, 974 
importing (batch mode), 976 
user addition (manual), 975 
user additional information, 978 
user additional information field addition, 978 
user additional information field deletion, 981 
user additional information field modification, 980 
user additional information list viewing, 978 

User Tab access, 90 
using 

Asset OID, 439 
compliance check, 595 
configuration backup report, 588 
configuration baseline report, 590 
Configuration Center, 498 
display command for configuration check, 629 
guest access logs, 1008 
guest access self-service system, 1010 
Network Asset Auditing, 444 
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Network Asset Manager, 435 
OneView management, 433 
real time reports, 1026 
SNMP templates, 245 
software baseline report, 593 
software update report, 592 
SSH template, 247 
Syslog alarm rules, 676 
Syslog templates, 672 
task execution results, 623 
task execution results, task execution report, 

configuration retrieval report, 622 
Telnet template, 246 
VLAN access port tab, 950 
VLAN hybrid port tab, 953 
VLAN trunk port tab, 951 
VLAN virtual interface tab, 948 
VRM, 447 

variable 
replaceable variable list, 495 

VDC 
Device Details page VDC information, 311 

vendor 
third-party device common service (CLICommon) 

definition, 473 
third-party device component action definition, 474 
third-party device component service definition, 474 
third-party device specific services definition, 475 
third-party device vendor drive definition file creation, 

471 
third-party device vendor drive folder creation, 470 
third-party device vendor drive index file creation, 470 
third-party device vendor folder creation, 469 

video play widget configuration, 124 
view configuration 

alarm panel widget configuration, 116 
alarm statistics widget configuration, 127 
converged topology widget configuration, 131 
CPU Utilization Top5 widget configuration, 125 
custom topology widget configuration, 130 
Custom View Top5 widget configuration, 126 
Device Response Time Top5 widget configuration, 128 
device state overview widget configuration, 133 
Device Unreachability Top5 widget configuration, 135 
device view widget configuration, 135 
electric clock widget configuration, 118 
important device monitor widget configuration, 119 
IP topology widget configuration, 127 
lower-level NMS performance view widget configuration, 

120 
Memory Utilization Top5 widget configuration, 132 
performance view widget configuration, 121 
single device monitor widget configuration, 122 
single interface monitor widget configuration, 123 
text label widget configuration, 124 
user-defined widget configuration, 134 
video play widget configuration, 124 
view addition, 112 
view deletion, 113 
view display, 116 
view widget customization, 113 
view widget display in scroll area, 114 

widget configuration, 116 
window access, 109 

View Event page access, 936 
viewing 

account group details, 992 
account group list, 992 
ACL deployment task detailed information, 885 
ACL deployment task list, 883 
ACL device configuration, 860 
ACL device list, 858 
ACL resource list, 807 
ACL rule set information, 809 
ACL template, 775 
ACL template list, 775 
ACL templates, 775 
action detailed information, 932 
alarm details, 682 
alarm details (All Alarms page), 690 
alarm matching policy detailed information, 914 
alarm matching policy list, 913 
alarm relation report, 683 
alarm relation report (Alarm Details page), 691 
alarm relationship, 690 
alarm statistics, 693 
alarm statistics charts, 693 
all scheduled reports, 1033 
applied ACL, 868 
Asset Audit List, 444 
Asset OID list, 439 
At a Glance performance view, 743 
attack alarm details, 903 
attack path map (single attack), 909 
attack topology map (all attacks), 908 
attack topology maps, 908 
auto discovery results, 247 
automatic deployment device detailed information, 563 
automatic deployment execution results, 574 
backup history, 584 
backup history detailed information, 586 
backup history reports, 584 
check task history, 621 
compliance policy aggregate link rule, 611 
compliance policy check results, 625 
compliance policy check task details, 614 
compliance policy check task list, 613 
compliance policy check task querying, 615 
compliance policy configuration segment rule, 612 
compliance policy detailed information, 596 
compliance policy device rule, 610 
compliance policy interface rule, 610 
compliance policy link rule, 611 
compliance policy list, 595 
compliance policy rule detailed information, 597 
configuration backup history, 503 
configuration baseline report, 590 
Configuration Center latest running configuration, 501 
Configuration Center latest startup configuration, 501 
configuration check report, 627 
configuration comparison in General Configuration 

Compare, 537 
configuration comparison results window, 537 
Configuration Management page details, 502 
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Configuration Management page summary, 502 
configuration retrieval report, 628 
current report data sources, 1030 
custom report, 1042 
custom report template list, 1024 
device access settings plan list (batch mode), 375 
device additional information list, 236 
device check results (batch mode), 376 
Device Details page alarms, 311 
Device Details page VDC information, 311 
device group ungrouped devices list, 198 
device groups, 194 
device list, 195 
device plan check results (batch mode), 376 
device violating results, 626 
device-level network asset details, 436 
devices through Device View, 253 
devices through IP View, 255 
devices through network topology, 257 
events, 936 
execution result page, 556 
execution result report, 912 
faulty devices, 693 
filter list, 169 
global index settings user-defined monitor, 722 
global VLAN list, 941 
group monitored settings, 762 
guest access log details, 1010 
guest access log list, 1008 
guest access operator details, 1003 
guest access operator list, 1002 
guest access user group details, 1000 
guest access user group list, 998 
guest online operators, 1016 
History Access Log list, 419 
holiday configuration page, 229 
IMC online operators, 192 
IMC server CPU information, 226 
IMC server database information, 227 
IMC server disk information, 227 
IMC server memory information, 227 
IMC server processes, 226 
IMC trap filter rules, 636 
initial configuration file detailed information, 579 
IP recycle bin (terminal access), 413 
IP segment list (terminal access), 406 
login control template list, 179 
lower-level NMS view, 306 
maintenance records, 396 
maintenance tag task list, 394 
monitor instance in performance view, 741 
net address group (ACL assistant), 768 
net address group list (ACL assistant), 768 
network asset list, 435 
network assets, 435 
OneView management action history, 434 
OneView management messages, 434 
operation logs, 223 
operator group list, 173 
operator list, 183 
Performance Monitor, 312 
performance option instance profile list, 753 

performance option periodic monitor list, 760 
performance option service monitor list, 758 
performance view, 740 
performance view details, 732 
performance view list, 731 
performance view report, 744 
policy history, 936 
Port Group device interface, 302 
port group interface list, 303 
quick service process view, 141 
rack view, 306 
real time reports, 1029 
real-time alarm details (Real-Time Alarms page), 686 
real-time alarm relation report (Alarm Details page), 687 
real-time alarms (filtered), 686 
real-time monitor graphs, 750 
real-time monitoring page, 747 
real-time monitors, 748 
reports, 939 
SCC reports, 925 
security control policy execution history, 925 
security control policy list, 918 
service (ACL assistant), 766 
service list (ACL assistant), 766 
SMS managed devices in topology, 928 
SMSC SMS message sending records, 206 
software baseline report, 593 
software library, 526 
software library entry details, 527 
software update history, 507 
software update report, 592 
special workday configuration page, 230 
Syslog details, 667 
Syslog device detailed information, 667 
Syslog filtering rule details, 668 
Syslog filtering rules, 668 
time range (ACL assistant), 771 
time range list (ACL assistant), 770 
TopN devices, 694 
TopN performance view, 740 
traffic topology traffic, 269 
trap definitions, 653 
trap details, 634 
Trap Details page, 634 
trap groups, 664 
trap-to-alarm rules, 646 
Trend Line or Data Grid performance view, 742 
Unauthorized Access list, 414 
Unauthorized Access log list, 416 
user additional information list, 978 
user basic information, 983 
user group list, 199, 982 
user list, 981 
virtual machine migration reports, 462 
VLAN access port, 950 
VLAN deployment task, 955 
VLAN device list, 944 
VLAN hybrid ports, 953 
VLAN topology maps, 957 
VLAN trunk ports, 951 
VLAN virtual interface, 948 
VLANs, 946 
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VRM topology map physical servers, 278 
VRM topology map virtual network, 277 
VRM virtual network, 448 
VRM virtual network server resource list, 449 
VRM virtual network server-level details, 449 
VRM virtual network topology, 452 
VXLAN dashboard, 968 
VXLAN list, 968 
VXLAN network device details, 964 
VXLAN network device list, 962 
VXLAN server list, 966 
VXLAN tunnel list, 971 
Web desktop user login data viewing, 144 
Web desktop viewing, 143 
workday configuration page, 232 

virtual 
VLAN virtual interface addition, 949 
VLAN virtual interface deletion, 949 
VLAN virtual interface tab, 948 
VLAN virtual interface viewing, 948 
VRM topology map virtual network viewing, 277 

virtual machine (VM) 
addition in IMC, 454 
auto migration configuration, 460 
configuration, 454 
migration manually, 459 
migration recommendation querying, 462 
migration report querying, 463 
migration report viewing, 462 
operation, 455 
operation history management, 467 
port group advanced property modification, 464 
profile modification, 460 
recommendation viewing, 461 
template management, 466 
vSwitch advanced property modification, 464 

Virtual Machine Information Report, 1020 
virtual network 

server details page accessing, 450 
server querying, 452 
server resource list viewing, 449 
server-level details viewing, 449 
topology viewing, 452 
view refreshing, 453 
viewing, 448 

Virtual Resource Management. Use VRM 
VLAN 

access port configuration (batch mode), 959 
access port PVID modification, 950 
access port tab, 950 
access port viewing, 950 
ACL device use management (packet filtering), 869 
batch deployment, 959 
creation, 947 
creation by batch deployment, 959 
deletion, 947 
deployment task, 955 
deployment task entry deletion, 956 
deployment task searching, 956 
deployment task viewing, 955 
device detail management, 945 
device list viewing, 944 

device management, 944 
device management shortcut, 362 
device querying, 945 
global VLAN creation, 942 
global VLAN deletion, 943 
global VLAN device addition, 943 
global VLAN device deletion, 944 
global VLAN list view, 941 
global VLAN management, 941 
global VLAN querying, 942 
hybrid port addition, 954 
hybrid port configuration (batch mode), 960 
hybrid port deletion, 954 
hybrid port modification, 954 
hybrid port tab, 953 
hybrid port viewing, 953 
management, 941 
modification, 947 
topology map viewing, 957 
topology maps, 956 
trunk port configuration (batch mode), 960 
trunk port deletion, 952 
trunk port modification, 952 
trunk port tab, 951 
trunk port viewing, 951 
trunk port addition, 952 
viewing, 946 
virtual interface addition, 949 
virtual interface deletion, 949 
virtual interface tab, 948 
virtual interface viewing, 948 

vManager (VRM), 278 
VPN instance configuration, 213 
VRM 

port group addition, 453 
resource import, 447 
server configuration, 453 
Server Details page refreshing, 454 
topology map physical server viewing, 278 
topology map virtual network viewing, 277 
using, 447 
virtual machine addition in IMC, 454 
virtual machine auto migration configuration, 460 
virtual machine configuration, 454 
virtual machine migration manually, 459 
virtual machine migration recommendation querying, 462 
virtual machine migration report querying, 463 
virtual machine migration report viewing, 462 
virtual machine operation, 455 
virtual machine operation history management, 467 
virtual machine profile modification, 460 
virtual machine recommendation viewing, 461 
virtual machine template management, 466 
virtual network server details page accessing, 450 
virtual network server querying, 452 
virtual network server resource list viewing, 449 
virtual network server-level details viewing, 449 
virtual network topology viewing, 452 
virtual network view refreshing, 453 
virtual network viewing, 448 
vSwitch addition, 453 

vSwitch 
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addition (VRM), 453 
advanced property modification, 464 

VTEP 
VXLAN addition, 969 

VXLAN 
AC configuration, 970 
addition, 969 
dashboard viewing, 968 
deletion, 970 
deployment (batch mode), 964 
device management, 962 
list viewing, 968 
management, 962, 968 
modification, 970 
network device deletion, 966 
network device details viewing, 964 
network device global settings configuration, 963 
network device importing, 963 
network device list viewing, 962 
network device management, 962 
network device querying, 963 
querying, 969 
server deletion, 968 
server importing, 967 
server list viewing, 966 
server management, 966 
server querying, 967 
tunnel addition, 972 
tunnel deletion, 972 
tunnel list viewing, 971 
tunnel management, 971 
tunnel modification, 972 
tunnel querying, 972 

Web 
software import into library from Web download, 529 

Web desktop 
application addition, 146 
application deletion, 147 
application management, 145 
application moving, 147 
application name modification, 147 
application opening, 147 
application registration, 146 
desktop personalization, 145 
desktop switching, 143 
entry, 142 
IMC edition switching, 143 
login, 142 
logoff, 147 
menu access, 144 
user login data viewing, 144 
viewing, 143 

Web interface 
favorite access, 102 
favorite addition, 102 
favorite deletion, 103 
favorite modification, 102 
favorite sorting, 102 
theme setting, 103 

widget 
Alarm Top5, 43 
Alarm TopN, 42 

all home page space widget collapse, 40 
all home page space widget expansion, 40 
Bandwidth Utilization (In) (%)—Top5, 59 
Bandwidth Utilization (In) (%)—TopN, 58 
Bandwidth Utilization (Out) (%)—Top5, 61 
Bandwidth Utilization (Out) (%)—TopN, 60 
configuration, 116 
CPU Utilization (%)—Top5, 49 
CPU Utilization (%)—TopN, 48 
Custom Topology, 75 
Custom View Top5, 71 
Customize Top5, 63 
Customize TopN, 62 
Device List (by Custom View), 77 
Device Response Time (ms)—Top5, 55, 65 
Device Response Time (ms)—TopN, 54 
Device State Overview, 68 
device status bar, 83 
Device Unreachability (%)—Top5, 57 
Device Unreachability (%)—TopN, 56 
Device View, 69 
Hierarchical Device State Overview, 68 
home page space widget addition, 39 
home page space widget background setting, 41 
home page space widget collapse, 40 
home page space widget content display, 41 
home page space widget deletion, 41 
home page space widget dragging, 41 
home page space widget dropping, 41 
home page space widget expansion, 40 
home page space widget layout change, 40 
home page space widget manual refresh, 41 
home page space widget maximizing, 41 
home page space widget open in new window, 41 
home page space widget refresh interval setting, 41 
home page space widget restoration, 41 
home page space widget title setting, 41 
Important Devices, 72 
Important Ports, 72 
Interface Flux TopN, 50 
Interface List (by Port Group), 78 
IP Topology, 73 
Lower-Level System Alarm Statistics, 45 
Lower-Level System Real-Time Alarm, 43 
Memory Utilization (%)—Top5, 53 
Memory Utilization (%)—TopN, 52 
Network, 66 
Network Devices, 79 
Performance Instance Profile, 47 
Performance Top5, 64 
Performance View Profile, 48 
Physical Network Asset Statistics, 80 
Port Group, 76 
Port Group TopN, 51 
Port Group—TopN, 76 
Quick Service Process, 78 
Real-Time Alarm, 45 
RSS widget customization, 83 
system-defined customization, 81 
Unrecovered Alarm Statistics, 46 
Upper+Lower-Level System Alarm Statistics, 46 
Upper+Lower-Level System Real-Time Alarm, 44 
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view config alarm panel widget configuration, 116 
view config alarm statistics widget configuration, 127 
view config converged topology widget configuration, 131 
view config CPU Utilization Top5 widget configuration, 125 
view config custom topology widget configuration, 130 
view config Custom View Top5 widget configuration, 126 
view config Device Response Time Top5 widget 

configuration, 128 
view config device state overview widget configuration, 

133 
view config Device Unreachability Top5 widget 

configuration, 135 
view config device view widget configuration, 135 
view config electric clock widget configuration, 118 
view config important device monitor widget 

configuration, 119 
view config IP topology widget configuration, 127 
view config lower-level NMS performance view widget 

configuration, 120 
view config Memory Utilization Top5 widget 

configuration, 132 
view config performance view widget configuration, 121 
view config single device monitor widget configuration, 

122 
view config single interface monitor widget configuration, 

123 
view config text label widget configuration, 124 
view config user-defined widget configuration, 134 
view config video play widget configuration, 124 
view config view widget customization, 113 
view config view widget display, 114 

Windows Management Instrumentation (WMI) 
template configuration, 161 

wizard 
ACL deployment to device, 887 
ACL deployment wizard management, 887 
ACL device time range deletion, 892 
ACL removal from device, 890 
ACL use deployment, 894 
ACL use removal from device, 896 

Wizard Center 
quick start function configuration, 136 
third-party device support configuration, 137 

work time 
holiday configuration, 229 
holiday configuration page viewing, 229 
holiday deletion, 230 
holiday modification, 229 
settings configuration, 228 
special workday configuration, 231 
special workday configuration page viewing, 230 
special workday deletion, 232 
special workday modification, 231 
workday configuration page viewing, 232 
workday work period addition, 232 
workday work period deletion, 234 
workday work period modification, 233 

workday 
configuration page viewing, 232 
work period addition, 232 
work period deletion, 234 
work period modification, 233 
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AirWave 8.2.9
Installation Guide

Overview
This document is designed as a reference for installing or upgrading AirWave 8.2.9 with the CentOS 6.9 software.

AirWavedoes not support downgrading to older versions. In unusual circumstances requiring that you return
toan earlier version of AirWave, we recommend you perform a fresh installation of the earlier AirWave version,
andthen restore data from a pre-upgrade backup.

The Support Download Page
The table below describes the different packages/files that youmight see on the Support site when you
download AirWave.

File Type Description

Install ISO Standalone installationmedia, including the CentOS operating system.
This image can fit on a CD/DVD, or it can be mounted as a virtual disk for
installation.

Install OVA (Virtual
appliance)

VMware OVA template for AirWave deployment on the VMware ESXi
infrastructure. Pre-installed with CentOS and optimized for deployments
up to 100 devices. Sized at 4 CPU, 8 GB RAM, 80 GB disk, based on
VMware ESXi 5.5.
NOTE: Use the install ISO if you intend to monitor more than 100 devices,
or have a custom sizing specification.

TAR package file Used for AirWave upgrades. The TAR package delivers updated security
packages and kernel updates.
NOTE: Direct updates are only supported from up to two versions prior. If
you are upgrading from AirWave 8.2.4 or earlier, contact Technical
Support for help with the multi-step upgrade path.

Table 1: Download Page File Types

Pre-Installation Checklist
Use this check list to ensure installation goes smoothly.

Task Completed

Have available the AirWave license key sent to you in an email from Aruba Networks.

Obtain dedicated server(s) meeting Aruba sizing specifications.

Determine the static IP address for each AirWave server.

Table 2: Pre-Installation Checklist
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Task Completed

Provision firewall and enable proper ports.

Determine WLAN infrastructure properties (type, quantity, and location).

Determine WLAN infrastructure access credentials (SNMP, telnet, SSH, etc.).

Determine WLAN security policy specifications.

Set router and switches to monitoring (optional).

Configure upstream NMS applications (optional).

Determine wireless client authentication servers (optional).

Determine AirWave administrative authentication servers like TACACS+, LDAP, or
RADIUS (optional).

If upgrading, ensure that your current version is not more than two versions behind.
For example, when upgrading to AirWave 8.2.9, youmust already be using AirWave
8.2.7 or later. Contact Techical Support for assistance upgrading AirWave software
more than two versions old.

Table 2: Pre-Installation Checklist (Continued)

Minimum Supported Browsers
AirWave supports the following browsers:

l Internet Explorer 11 onWindows

l Firefox 57 onWindows andmacOS

l Chrome 65.0.3299.0 (64-bit) or later onWindows andmacOS

l Safari 11.0.2 or later formacOS

Installation Media and Hardware Requirements
The AirWave installation ISO includes all software, including the CentOS required to complete the installation of
AirWave. AirWave supports any hardware that is Red Hat Enterprise Linux 6.9 certified. By default, all
installations are based on a 64-bit operating system.

AirWave hardware requirements vary by version. As additional features are added to AirWave, increased
hardware resources becomenecessary. For themost recent hardware requirements, refer to the AirWave 8.2.9
Server Sizing Guide.

Installing Linux CentOS (Phase 1)
Perform the following steps to install the Linux CentOS 6.9 operating system. The Linux installation is a
prerequisite to installing AirWave on the network management system.

This procedure erases the hard drive(s) on the server.

1. Insert the AirWave installation DVD into the drive and boot the server.
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2. Type install and press Enter.
To configure the partitionsmanually, type manual and press Enter.

Figure 1: AirWave Installation

3. Allow the installation process to continue. Installing the CentOS software (Phase I) takes 10 to 20 minutes to
complete.

Upon completion, the systemwill prompt you to eject the installation DVD and reboot the system.

4. Remove theDVD from the drive and store it in a safe location.

Installing the AirWave Software (Phase 2)
This workflow provides step-by-step instructions for installing AirWave 8.2.9.

After installing the software, the ampadmin account will replace the root user account. You will no longer have
root admin access to the legacy AMP CLI.

Use only included or Aruba-specified cables, power cords, AC power supplies and batteries. Don't use the power cord
withother electrical equipment than what is specified by Aruba.

Before You Begin
Ensure that you have sufficient disk storage, memory, and hardware or software versions. As additional features
are added to AirWave, increased hardware resources becomenecessary and hardware requirements vary by
version. For themost recent hardware requirements, refer to the AirWave 8.2.9 Server Sizing Guide.

If you purchased an AirWave appliance, power-up the appliance to view theGRUB screen and log in to the AMP
with the user name root and password admin.

Step 1: Configure the Date and Time
Follow these steps to configure the date and timewhen theGRUB screen appears:
Configure the date and time for the AirWave server when the following message appears:
------------------------ Date and Time Configuration ------------------
Current Time: Mon Jun 03 09:20:14 PST 2019
1) Change Date and Time
2) Change Time Zone

0) Finish

AirWave 8.2.9 | Installation Guide 3
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a. Select 1 to set the date and select 2 to set the time zone. Press Enter after each configuration to return to
themessagemenu above.

b. Select 0 to complete the configuration of date and time information, then press Enter.

Step 2: Check Installed Software
If your server has an earlier version of AirWave installed, you'll see amessage that asks you to reinstall AirWave.

This action erases the current database, including all historical information. To ensure that the AMP database is backed
upprior to reinstallation, answer n at the prompt and contact your Value Added Reseller or Aruba support.

Step 3: Install the Software
Wait several minutes for the installer to install AirWave 8.2.9.

Step 4: Verify Software Installation
Wait for the installer to check that the database is up and running the current version.

Step 5: Create the Recovery User
During this step, AirWave configures the AMP CLI while creating the recover user account. At the prompt, enter a
user name for the recovery user. If you don't enter a username, AirWave uses the default recovery user, called
"amprecovery".

You can change the password later from the AMP CLI by selecting 9 to open the Security menu, then 2 to reset
the password. Formore information, refer to the AirWave 8.2.9 User Guide.

Step 6: Create the Admin User
At the prompt, enter a user name and password for the admin CLI user account. If you don't enter a user name,
AirWave uses the default admin user, called "ampadmin".

Save your user name and password somewhere safe because you'll need them to log in to the CLI.

Step 7: Configure the Network
The following example shows how to configure the default eth0 interface. If you want to configure additional
interfaces, repeat this step for each interface.
Enter the IPv4 static IP address, subnet mask, and gateway addresses (the IPv6 and secondary DNS
settings are optional) when the following message appears:
STEP 6: Assigning AMP's address
AirWave must be configured with a static IP.

Here are the ethernet interfaces with hardware present:
1. eth0
2. eth1
3. eth2
4. eth3
q. Quit

Which interface shall we configure?
a. Select 1 and press Enter.

------ Network Interface Configuration for eth0 -----
1) IPv4 Address : xxx.xxx.xxx.xxx
2) IPv4 Netmask : xxx.xxx.xxx.xxx
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3) IPv4 Gateway : xxx.xxx.xxx.xxx
4) IPv6 Address (optional) : xxx.xxx.xxx.xxx
5) IPv6 Gateway (optional) : xxx.xxx.xxx.xxx
6) Primary DNS : xxx.xxx.xxx.xxx
7) Secondary DNS : xxx.xxx.xxx.xxx

9) Commit Changes
0) Exit (discard changes)

b. Select 1 to enter the network information, then press Enter.
c. Select 2 to enter the subnet mask, then press Enter.
d. Select 3 to enter the gateway, then press Enter.
e. Select 6 to enter the primary DNS address, then press Enter.
f. To commit the changes, type 9 and then press Enter. To discard the changes, type 0 and then press

Enter.
g. To restart the network with the configured settings, type y.

Step 8: Generate an SSL Certificate
To generate the SSL certificate for the AirWave server:

n If AirWave does not have a valid host name on the network, typen.
n If AirWave has a valid host name on the network, type y and enter the fully qualified domain name for the

AirWave server (for example,myserver.example.com)

After installing AirWave, you can install a new SSL certificate, or generate a CSR to install a signed certificate
from the AMP CLI.

Step 9: Complete the Installation
Upon completion of all previous steps, the followingmessage appears.

CONGRATULATIONS! AMP is configured properly.
To access the AMP web console, browse to https://<IP Address>
Login with the following credentials:
Username: admin
Password: [User-provided password from above for 'ampadmin' user]

Onceyou log out, the root user will be disabled. Subsequently, youmust use the ampadmin user generated
duringthe software installation to log in to the CLI.

l To view the Phase 1 installation log file, type cat /root/install.log.
l To view the Phase 2 installation log file, type cat /root/amp-install.log.

Installing AirWave in a VMware Environment
The following sections provide information to help you installAirWave on VMware® ESX(i).

l "VMware Requirements" on page 5

l "Creating a VMware Virtual Machine " on page 6

VMware Requirements
AirWave supports VMware ESX(i) 5.5 and later. To be sure that enough resources are allocated to the virtual
machine, consult the AirWave 8.2.6 Server Sizing Guide.
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If your VM host is hosting other instances, ensure that the AirWave instance has the highest priority. A virtual
SCSI disk is recommended over IDE.

Creating a VMware Virtual Machine
The VMware Infrastructure Client provides awizard to create a new virtualmachine. The resulting virtual
machine acts like physical host, in which you install the AirWave software.

The recommended OS is CentOS 6 (64-bit). Refer to the AirWave 8.2.9 Server Sizing Guide formemory and
storage requirements.

To create a virtualmachine:

1. From the VMware Infrastructure Client, select Create a new virtual machine.
2. Select Next, and then select Typical > Virtual Machine Configuration.
3. Name your virtualmachine (for example, AirWave), and then clickNext.
4. Select an available datastorewith sufficient space for the number of APs that your AirWavewill manage,

choosing the right server hardware to comply with the hardware requirements. ClickNext.
5. Select the Linux radio button, and then select theOS. ClickNext.
6. Select the appropriate number or processors, and then specify theminimum virtual RAM.

7. Accept the VMware default virtual network adapter, and clickNext.
8. Allocate a virtual disk large enough to contain the AirWave operating system, application, and data files.

9. Review the virtualmachine settings, and then click Finish when you are done.

Installing AirWave in a Hyper-V Environment
The following sections provide information to help you install AirWave on a virtualmachine running a Hyper-V:

l "Hyper-V Requirements" on page 6

l "Adding theHyper-V Network Adapter" on page 6

Hyper-V Requirements
AirWave supports using Hyper-V Manager on:

l Windows Server 2003 or later.

l Windows Server 2012 R2. Youmight experience boot issues usingWindows Server 2012 Standard (not R2).

Adding the Hyper-V Network Adapter
When you create the virtualmachine in Hyper-V Manager, youmust configure a virtual network adapter in order
to install AirWave. Hyper-V provides two virtual network adapters: a default and a legacy adapter (for generation
1 virtualmachines). If you use the legacy network adapter to establish networking, youmight experience
connectivity issues even though there are no resource constraints on the server.

To add theHyper-V network adapter:

1. Open Hyper-V Manager, then connect to theHyper-V host.

2. Right-click the virtualmachine and select Settings.
3. From the Add Hardwarewindow, select Network Adapter then click Add.
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4. View the adapter properties, and clickOK.
5. ClickOK.

Installing AirWave on a KVM Virtual Machine
The following sections provide information to help you install AirWave on a KVM:

l "KVM Requirements" on page 7

l "Creating a KVM Virtual Machine" on page 7

KVM Requirements
The recommended OS is CentOS 6 (64-bit). Refer to the AirWave 8.2.9 Server Sizing Guide formemory and
storage requirements.

Creating a KVM Virtual Machine
To create a KVM virtualmachine:

1. On the local host, type virt manager to run theNew VMwizard.

2. Type a name for the virtualmachine, select Local install media (ISO image or CDROM), and then click
Forward.

3. Click Browse to find the ISO image. Select Linux and Red Hat Enterprise Linux 6 from the drop-down
menus, then click Forward.

AirWave 8.2.9 | Installation Guide 7
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4. Assignmemory to the KVM and CPUs, then click Forward.
5. Assign disk storage, enable theAllocate entire disk now option, and then click Forward.
6. Before you start the installation, under the Advanced options, select theHost device and enter the fixedMAC

address of the bridge (typically br0) into the text box.

7. Click Finish. The Virtual MachineManager creates the virtualmachine and opens the AirWave console.

Upgrade Paths
Your upgrade procedure depends upon your current version of AirWave.
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l Direct upgrade path: You can upgrade directly to AirWave 8.2.9 from the following software versions:
8.2.7, 8.2.7.1, 8.2.8, 8.2.8.1, and 8.2.8.2.

l Two-step upgrade path: To upgrade to AirWave 8.2.9 fromAirWave 8.2.5, youmust follow these upgrade
paths before you upgrade to AirWave 8.2.9:

n AirWave 8.2.6 to 8.2.8.

n AirWave 8.2.5 to 8.2.7.

If you are upgrading fromAirWave 8.2.4 or earlier, contact Technical Support for help with themulti-step
upgrade path.

Upgrade from AirWave 8.2.7 or Later
Use the AMP CLI to install the AirWave 8.2.9 upgrade package on your system. If your network doesn't allow
AirWave to connect to the Internet, youmust manually download the software and upload the software before
performing this upgrade.

Youcan change the existing amprecovery username by backing up the server, reinstalling the software, and
restoringfrom the backup. For information about setting up the amprecovery account, refer to "Installing the
AirWave Software (Phase 2) " on page 3.

Follow these steps to upgrade fromAirWave 8.2.7 or later:

1. Log in to the AirWave server with the "ampadmin" user name and password. If you subsequently changed the
ampadmin user name and password, enter the current admin name and password.

2. Enter 7 to select Upgrade.
a. At the next prompt, enter 1 to select Upgrade AirWaveManagement Platform.

b. Enter 8.2.9.0.
c. Enter y to enable AirWave to connect to a proxy server. Or, you can enterN to bypass this step and go to

step d on page 9 to download the software. At the next prompt:

(1) Enter the server address and port number (for example, test.proxy.com and port 22).

(2) Enter y to enter the proxy user name and password (for example, testuser and password).

d. Enter 1 or 2 to log in to your customer portal with your support user name and password.

e. Follow the onscreen instructions to download the software.

Upgrading the Kernel OS
After the upgrade completes, youmight see the followingmessage:
Updated kernel packages that fix various security issues are now available for your OS. To
upgrade, select "Upgrade" menu item on the AMPCLI Menu,
and then choose "Upgrade OS Kernel" menu item.
To run the kernel upgrade:

1. Log in to the AMP CLI as the ampadmin.

2. Select 7 to open theUpgrademenu, then select 2 to run the kernel upgrade. A system reboot is required to
complete the kernel upgrade.

Manually Download the Software
You canmanually download the software if your AirWave server can't access the Internet.

1. Go to the Aruba Support Portal or theHPE My Networking Portal to download the upgrade image.

2. Click the upgrade package, then click Save and install the file later.
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3. Define a user that can transfer AirWave images, and then upload the software:

Forsecurity purposes, image file transfer users are automatically removed every night during nightly
maintenanceoperations.

a. From the AMP command-line interface, with the "ampadmin" user name and password. If you
subsequently changed the ampadmin user name and password, enter the current admin name and
password.

b. Enter 8 to open theAdvancedmenu options.

c. Enter 7 to add a file transfer user.
d. Enter a user name for the file transfer user, then click Enter. The username for an AirWave image file

transfer usermust be five characters or longer, and contain only lowercase letters and numbers. To use
the default file transfer username awsftp, click Enterwithout entering a username.

e. Enter a password for the file transfer user, then click Enter.The passwordmust be eight characters or
longer, and can contain uppercase and lowercase letters, numbers, and non-alphanumeric characters.
Spaces are not allowed.

f. Enter b to go back to themain CLI menu.

g. Enter 1 to upload the file from the source location to the AMP server using SCP to transfer the file.

h. At the prompt, enter the location of the source file (for example, user@host:path. User is the name of the
account on the host computer, host is the hostname of the computer on which the source file exists, and
path is the location of the directory that contains the upgrade package.

i. At the prompt, enter the password on the source location.

Configuring and Mapping Port Usage for AirWave
The following table itemizes the communication protocols and ports necessary for AirWave to communicatewith
wireless LAN infrastructure devices, including access points (APs), controllers, routers, switches, and RADIUS
servers. Assign or adjust port usage on the network administration system as required to support these
components.

Port Type Protocol Description Data
Flow
Direction

Device Type

21 TCP FTP Firmware distribution > APs or controllers

22 TCP SSH Configure devices > APs or controllers

22 TCP SSH Configure AirWave from
the CLI

< Laptop or workstation

22 TCP VTUN Support connection
(optional)

> Aruba supports home office

22 TCP SCP Transfer configuration files
or FW

< APs or controllers

23 TCP Telnet Configure devices > APs or controllers

Table 3: AirWave Protocol and Port Chart
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Port Type Protocol Description Data
Flow
Direction

Device Type

23 TCP VTUN Support connection
(Optional)

> Aruba supports home office

25 TCP SMTP Support email (optional) > Aruba supports email server

49 UDP TACACS AirWave Administrative
Authentication

> Cisco TACACS+

53 UDP DNS DNS lookup from AirWave > DNS Server

69 UDP TFTP Transfer configuration files
or FW

< APs or controllers

80 TCP HTTP Configure devices > Legacy APs

80 TCP VTUN Support connection
(optional)

> Aruba supports home office

161 UDP SNMP Get and Set operations > APs or controllers

162 UDP SNMP Traps from devices < APs or controllers

162 UDP SNMP Traps from AirWave > NMS

443 TCP HTTPS Webmanagement < Laptop or workstation

443 TCP HTTPS WLSE polling > WLSE

443 TCP VTUN Support connection
(optional)

> Aruba supports home office

1701 TCP HTTPS AP and rogue discovery > WLSE

1741 TCP HTTP WLSE polling > WLSE

1812 UDP RADIUS
Auth

Authenticate & authorize
AirWave administrative
users on a RADIUS server.

> RADIUS auth server

1813 UDP RADIUS
accounting

Retrieve user names for
authenticatedWLAN clients
from NAS (captive portal,
controller, autonomous
AP). Only used when user
names are not available in
the SNMPMIB of a
controller or autonomous
AP.

< RADIUS accounting client

Table 3: AirWave Protocol and Port Chart (Continued)
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Port Type Protocol Description Data
Flow
Direction

Device Type

2002 TCP HTTPS Retrieve client
authentication info

> ACS

5050 UDP RTLS Real Time Location Feed < Aruba thin APs

8211 UDP PAPI Real Time Feed (AMON) < > WLAN controllers

ICMP Ping Probe > APs or controllers

Table 3: AirWave Protocol and Port Chart (Continued)

Getting Started
To start using AirWave for the first time:

l "Log in to theWebUI" on page 12

l "Change the Language" on page 13

l "Install the License" on page 13

l "Change theDefault User" on page 13

l "Navigate theWebUI" on page 13

l "Work with Default and Filtered Views" on page 15

Log in to the WebUI
AirWave comeswith a default user account with the user name "admin" and password "admin". In order to log in
to theWebUI for the first time, you have to log in as the default user.

To access the AirWaveWebUI:

1. Enter the AirWave IP address (IPv4 or IPv6) or hostname in the address bar of any browser.

2. Enter the default user name and password: admin and <ampadmin password>.
3. Click Log In.

12 AirWave 8.2.9 | Installation Guide
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Change the Language
You can change the language of the buttons, menus, and tabs in AirWave. You'll see the available languages at
the bottomof the Login window. Look for the language that you want and select it.

If you want to change a language again, youmust log out of AirWave and reopen the Login window.

Install the License
The first page to appear after you initially log in is the Home > Overview page. If you havemore than one
license to install, repeat this procedure for each license.

AirWavepages are protected via SSL. Some browsers will display a confirmation dialog for your self-signed
certificate. Signing your certificate will prevent this dialog fromdisplaying.

To install the AirWave license:

1. On the License page, paste the AirWave license key you received into the license field on this page.

2. Cick Save.
3. In the AirWave licensing agreement, click I Accept to agree to the license terms and apply the license key.

Change the Default User
For security reasons, it's a good idea to change the default user name and password. You can do this from
the AMP Setup > Users page. Refer to the procedure Creating AirWaveUser Roles in the AirWave 8.2.9 User
Guide for additional information.

Navigate the WebUI
The AirWaveWebUI contains the following elements on every page:

AirWave 8.2.9 | Installation Guide 13
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l Header statistics

l Search utility

l Navigation sidebar

l Documentation links

Header Statistics
The top header of each AirWaveWebUI page displays icons that provide counts on newly discovered devices,
device status, mismatches, rogues, clients, and both unacknowledged and severe alerts. These icons also provide
direct links for immediate access to key system components.

You can customize your header statistics to display what you want to monitor. For information, see the AirWave
8.2.9 User Guide.

Figure 2: Header Statistics

Search Utility
The Search field at the top of every AirWave page provides a simpleway to find devices, clients, groups, and
rogues. You can search for things like notes, firmware versions, serial numbers, IP addresses (IPv4 or IPv6), MAC
addresses, and users.

To find something using the Search field:

1. Click ,
2. In the Search field, type a keyword or the first few letters and numbers and do one of the following:

n Press Enter. You can change this default searchmethod preference in theHome > User Info page.
n Click the down arrow and select amethod from the list of search options.

n Click to see quick search results, showing connected clients, whichmight already be your default search
method.

Figure 3 shows the the search results for "00:". Results include hypertext links to additional pages, and the Filter
icon over some columns allows for additional filtering of search returns.

Figure 3: Example of Search Results for 00:

Navigation Sidebar
The navigation bar allows you to accessWebUI pages within AirWave. When you click in the AirWaveWebUI and
select a component from the navigation sidebar, AirWavewill display monitoring, management, details, and
dashboard pages to the right.

Some navigationmenus, such as AMP Setup, might be hidden from a user depending on the user’s role.

14 AirWave 8.2.9 | Installation Guide
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Documentation Links

You can access the AirWave 8.2.9 User Guide and other documents by clicking in the upper-right corner of the
WebUI page, or you can select Home > Documentation from the navigation sidebar.

Work with Default and Filtered Views
AirWave provides predefined, default views for lists displayed on theDevices and RAPIDS pages (Figure 4).
These default views cannot bemodified. However, you can adjust howmuch information displays in your view,
then filter the results.

Figure 4: Default View for Devices

In addition to the default view, you can create a new view, or edit and copy a view, and then save the view to
access information you frequently use. Formore information on filtering data from your view, see "Creating
Customized Filtered Views" in the AirWave 8.2.9 User Guide.
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Contacting Support

Main Site arubanetworks.com

Support Site support.arubanetworks.com

Airheads Social Forums and Knowledge Base community.arubanetworks.com

North American Telephone 1-800-943-4526 (Toll Free)

1-408-754-1200

International Telephone arubanetworks.com/support-services/contact-support/

Software Licensing Site hpe.com/networking/support

End-of-life Information arubanetworks.com/support-services/end-of-life/

Security Incident Response Team (SIRT) Site: arubanetworks.com/support-services/security-bulletins/

Email: aruba-sirt@hpe.com
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Copyright Information

© Copyright 2019 Hewlett Packard Enterprise Development LP

Open Source Code

This product includes code licensed under the GNU General Public License, the GNU Lesser General Public
License, and/or certain other open source licenses. A complete machine-readable copy of the source code
corresponding to such code is available upon request. This offer is valid to anyone in receipt of this information
and shall expire three years following the date of the final distribution of this product version by Hewlett-
Packard Enterprise Company. To obtain such source code, send a check or money order in the amount of US
$10.00 to:

Hewlett-Packard Enterprise Company
Attn: General Counsel
6280 America Center Drive
San Jose, CA 95002
USA

Please specify the product and version for which you are requesting source code.

You may also request a copy of this source code free of charge at: http://hpe.com/software/opensource.
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Chapter 1
Introduction

AirWave is a network management platform that provides a single console where you can monitor, analyze, and
configure wired and wireless networks. Whether your network is simple or a large, complex, multi-vendor
installation, AirWave makes it easy to monitor your network with features like AppRF, Clarity, and VisualRF.

AirWave also provisions Aruba switches, provides CPU, memory and interface monitoring, configuration
management, and upgrades switch firmware. AirWave can be used to implement zero-touch provisioning for
Aruba Instant APs (IAP), Aruba switches and branch controllers.

With AirWave, you can configure:

l "Aruba Mobility Controllers" on page 15

l "Instant Access Points" on page 15

l "ArubaOS-S Switches and ArubaOS-CX Switches" on page 16

Aruba Mobility Controllers
AirWave supports global and group-level configuration of Aruba mobility controllers. Several controllers can
work together with APs to provide a hierarchical and redundant mobility controller system.

The mobility controller system provides:

l AP tunnel termination and translational bridging

l GRE tunnel between each AP and a mobility controller

l A virtual connection point to wireless clients

l Frame translation from 802.11 to 802.3 and 802.3 to 802.11, including encryption and decryption of
wireless traffic

l Quality of service (QoS) and traffic prioritization

Working alone or in conjunction with ClearPass, the mobility controller authenticates wireless clients and includes
a stateful firewall that can be configured to filter wireless traffic.

In this document, mobility controllers are also called access devices. For information about controller
configuration, refer to the AirWave 8.2.9 Controller Configuration Guide.

Instant Access Points
Aruba Instant (Instant) is a system of access points in a Layer 2 subnet. The Instant APs (IAPs) are controlled by a
single IAP that serves a dual role as both an IAP and primary Virtual Controller (VC), eliminating the need for
dedicated controller hardware. This system can be deployed through a simplified setup process appropriate for
smaller organizations, or for multiple geographically dispersed locations without an on-site administrator.

With AirWave, IT can centrally configure, monitor, and troubleshoot Aruba Instant WLANs, upload new software
images, track devices, generate reports, and perform other vital management tasks, all from a remote location.

A Virtual Controller or Instant AP can authenticate to the AirWave server using a pre-shared key, or using two-
way certificate-based authentication using an SSL certificate sent from AirWave to the Instant device. Virtual
Controllers push data to AirWave via HTTPS. If your enterprise has a security policy that restricts the use of port
443 for inbound communication, you can change the port AirWave uses to communicate with Instant devices.

For additional information about Instant AP configuration, refer to the Aruba Instant in AirWave 8.2.8.2
Deployment Guide.
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ArubaOS-S Switches and ArubaOS-CX Switches
AirWave supports group-level configuration of ArubaOS-S Switches andArubaOS-CX Switches. These switches
connect APs, wired clients and other endpoints to the network. Working alone or in conjunction with ClearPass,
the ArubaOS-S Switches provide authentication, authorization and accounting.

In this document, ArubaOS-S Switches are also called access switches, and ArubaOS-CX Switches are also called
core and aggregation switches. For informationabout switch configuration, refer to the AirWave 8.2 Switch
Configuration Guide.
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Chapter 2
Configuring AirWave

This section contains procedures to deploy initial AirWave configuration. Additional configurations are available
after you complete the steps described in this section.

Defining General AirWave Server Settings
The initial configuration tasks to set up AirWave include:

l "Configuring the AirWave Server" on page 17

l "Defining Network Settings" on page 33

l "Configuring AirWave User Roles" on page 38

l "Creating AirWave Users" on page 36

l "Configuring the User Login and Authentication" on page 43

l "Enabling AirWave to Manage Your Devices" on page 52

l "Setting Up Device Types" on page 60

Configuring the AirWave Server
The following topics describe how to configure the general settings for the AirWave server. Figure 1 illustrates the
AMP Setup > General page.
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Figure 1: AMP Setup > General Settings

Whenever you save changes to these settings, AirWave applies them globally across the product for all users.

General Settings
Browse to theAMP Setup > General page, locate theGeneral section, and enter the information described in
Table 1:

Setting Default Description

System Name Defines your name for your AirWave server using alphanumeric
characters.

Default Group Access
Points

Sets the device group that this AirWave server uses as the default for
device-level configuration. Select a device group from the drop-down
menu. A group must first be defined on the Groups > List page to
appear in this drop-down menu. For additional information, refer to
"Using Device Groups" on page 72.

Table 1: AMP Setup > General > General Section Fields and Default Values
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Setting Default Description

Device
Configuration
Audit Interval

Daily This setting defines the interval of queries which compares actual
device settings to the Group configuration policies stored in the
AirWave database. If the settings do not match, the AP is flagged as
mismatched and AirWave sends an alert via email, log, or SNMP.
NOTE: Enabling this feature with a frequency of Daily or more
frequently is recommended to ensure that your AP configurations
comply with your established policies. Specifying Never is not
recommended.

Automatically
repair
misconfigured
devices

Disabled If enabled, this setting automatically reconfigures the settings on the
device when the device is in Manage mode and AirWave detects a
variance between actual device settings and the Group configuration
policy in the AirWave database.

Help improve
AirWave by
sending
anonymous usage
data

Disabled If enabled, AirWave will send anonymous data to Aruba, which may be
used to improve the AirWave software.

Nightly
Maintenance
Time (00:00 -
23:59)

04:15 Specifies the local time of day AirWave should perform daily
maintenance. During maintenance, AirWave cleans the database,
performs backups, and completes a few other housekeeping tasks.
Such processes should not be performed during peak hours of
demand.

License APs
Usage Threshold

90 Sets a threshold to display an alert on the controller monitor page
when the license usage has reached this number.

Check for
software updates

Yes Enables AirWave to check automatically for multiple update types.
Check daily for AirWave updates, to include enhancements, device
template files, important security updates, and other important news.
This setting requires a direct Internet connection via AirWave.

Table 1: AMP Setup > General > General Section Fields and Default Values (Continued)

Automatic Authorization Settings
On theAMP Setup > General page, locate theAutomatic Authorization section. These settings allow you to
control the conditions by which devices are automatically authorized into AP groups and folders. AirWave
validates the Folder and Group to ensure that both settings have been set to valid drop down options. Table 2
describes the settings and default values in this section.
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Setting Default Description

Add New
Controllers and
Autonomous
Devices Location

New Device List Globally add new controllers and autonomous devices to:
l The New Device List (located in Devices > New).
l The same folder and group as the discovering device.
l The same group and folder of their closest IP neighbor on the

same subnet.
l Choose a group and folder. If you select this option, enter the

folder/group in the Auto Authorization Group and Auto
Authorization Folder fields that display.

NOTE: This setting can be overridden in Groups > Basic.

Add New Thin APs
Location

New Device List Globally add new thin APs to:
l The New Devices list.
l The same folder and group as the discovering device.
l The same group and folder of their closest IP neighbor on the

same subnet.
l Choose a group and folder. If you select this option, enter the

folder/group in the Auto Authorization Group and Auto
Authorization Folder fields that display.

NOTE: This setting can be overridden in Groups > Basic.

Automatically
Authorized Virtual
Controller Mode

Manage
Read/Write

Specify whether Virtual Controller mode for Instant APs will be in
Manage Read/Write mode or Monitor Only mode.

Table 2: AMP Setup > General > Automatic Authorization Fields and Default Values

Aruba Instant Settings
A Virtual Controller can communicate with the AirWave server over a configurable communication port, and
authenticate to the server using a pre-shared key, and/or two-way certificate-based authentication using an SSL
certificate sent from AirWave to the Instant device.

The AMP Setup > General > Aruba Instant Options page includes the following Configuration settings:

Setting Default Description

Communication
port
(443,1000-65534):

443 By default, an Instant Virtual Controller communicates with AirWave
over port 443. If your enterprise has a security policy that restricts the
use of port 443 for inbound communication, use this field to change the
port the Virtual Controller uses to communicate with AirWave.

Security method
for adding new
Virtual Controllers:

PSK Only AirWave can use the following security methods to authenticate a
Virtual Controller to the AirWave server:

l PSK Only
l PSK and Certificate
l Certificate Only

If you enable certificate-based authentication, you are directed to the
AMP Setup > General > Upload SSL Certificate page, where you are
prompted to upload an certificate file in PEM format that contains both a
private key and certificate.

Table 3: AMP Setup > General > Aruba Instant Options Fields and Default Values
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Setting Default Description

Allow None-TPM
Devices

Yes If certificate-based authentication is enabled for the Virtual Controller,
AirWave allows low assurance, non-TPM device. This setting is
unavailable when PSK authentication is used.

Configuration Only No By default, AirWave will push Instant configuration settings as well as
AirWave settings such as RAPIDS settings and traps from an AirWave
group to a Virtual Controller assigned to that group. Select the Yes
option to push Instant configuration settings only.

Table 3: AMP Setup > General > Aruba Instant Options Fields and Default Values (Continued)

If you select a security method that includes Certificate-based authentication, you must upload the a certificate
from a supported certificate authority to the AirWave server, as the default AirWave certificate will not be
recognized by the Instant AP, and will cause the SSL handshake to fail. Certificate authentication also requires
that theAMP IP address information configured on the Instant AP is a domain name, and not an IP address.

AirWave supports the following trusted certificate authorities:

l Chain 1: Trusted Root CA: C=SE, O=AddTrust AB, OU=AddTrust External TTP Network, CN=AddTrust External
CA Root Intermediate CA: C=GB, ST=Greater Manchester, L=Salford, O=COMODO CA Limited, CN=COMODO
High-Assurance Secure Server CA

l Chain 2: Trusted Root CA: C=US, O=GeoTrust Inc., CN=GeoTrust Global CA Intermediate CA: Subject: C=US,
O=Google Inc, CN=Google Internet Authority G2

l Chain 3: Trusted Root CA: C=US, O=VeriSign, Inc., OU=VeriSign Trust Network, OU=(c) 2006 VeriSign, Inc. -
For authorized use only, CN=VeriSign Class 3 Public Primary Certification Authority - G5 Intermediate CA:
C=US, O=VeriSign, Inc., OU=VeriSign Trust Network, OU=Terms of use at https://www.verisign.com/rpa (c)10,
CN=VeriSign Class 3 Secure Server CA - G3

l Root CA: Trusted Root CA: C=US, O=Equifax, OU=Equifax Secure Certificate Authority

If you enable certificate authentication, you are prompted to upload an SSL certificate. you can view the current
AirWave certificate using theView Certificate link on that page, or click Change to upload a new certificate file
to the AirWave server.

Top Header Settings
The top header of each AirWave WebUI page displays icons that provide counts on newly discovered devices,
device status, mismatches, rogues, clients, and both unacknowledged and severe alerts. These icons also provide
direct links for immediate access to key system components.

Figure 2: Header Statistics Icons

You can configure what is displayed in the top header for all pages, or for individual AirWave users.

To change the header statistic icons:

1. Navigate to AMP Setup > General, then scroll down to Top Header.
2. Choose the statistics.

3. Choose the devices.

4. Click Save.

Aconfirmation message does not appear when you make modifications to the top header statistic icons.

To change statistics that display for an AirWave user:
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1. Navigate to Home > User Info page, then scroll down to Top Header Stats.

2. Choose the statistics.

3. Choose the devices.

4. Click Save. These user settings will override the general settings on the AMP Setup page.

Search Method
On theAMP Setup > General page, locate the Search Method section. Select one of the following drop down
options as the system-wide default search method. This default search type will be used when a user types an
entry in the Search field and then clicks Enter without selecting a specific search type.

l Use System Defaults: The Search Method will be based on the system-wide configuration setting. This
method is configured on theAMP Setup > General page.

l Active clients + historical clients (exact match) + all devices: Commonly referred to as Quick Search, this looks
at all active and historical clients and all devices. This search is not case-sensitive. The results of this search
display in a pop up window rather than on theHome > Search page. This pop up window includes top-level
navigation that allows you to filter the results based on Clients, APs, Controllers, and Switches.

l Active clients + all categories: This looks at all active clients (not historical) and all categories. This search is not
case-sensitive.

l Active clients + all categories (exact match): This looks at all active clients (not historical) and all categories.
This search returns only matches that are exactly as typed (IP, user name, device name, etc). This search is
case-sensitive for all searched fields.

l Active + historical clients + all categories: This looks at all active and historical clients and all categories. This
search is not case-sensitive.

l Active + historical clients + all categories (exact match): This looks at all active and historical clients and all
categories. This search returns only matches that are exactly as typed (IP, user name, device name, etc). This
search is case-sensitive for all searched fields.

Aconfirmation message does not appear after you make modifications to Search Preferences.

Per-user search preferences can be set in theHome > User Info page.

Home Overview Preferences
On theAMP Setup > General page, locate theHome Overview Preferences section. Table 4 describes the
settings and default values in this section.

Setting Default Description

Configure Channel
Busy Threshold

Yes Whether you want to configure the threshold at which a channel is
considered to be busy at the Top Folders By Radio Channel Usage
Overview widget.

Channel Busy
Threshold (%)

n/a The threshold percent at which the radio channel is considered busier
than normal. This field is only available if the Configure Channel Busy
Threshold setting is Yes.

Table 4: AMP Setup > General > Home Overview Preferences Fields and Default Values
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Display Settings
On theAMP Setup > General page, locate theDisplay section and select the options to appear by default in
new device groups.

Changes to this section apply across all of AirWave. These changes affect all users and all new device groups.

Table 5 describes the settings and default values in this section.

Setting Default Description

AP Fully Qualified
Domain Name
Options

No Sets AirWave to use fully qualified domain names for APs instead of the
AP name. For example, ‘testap.yourdomain.com; would be used instead
of ‘testap.’ Select one of the following options:
l Don’t use FQDN - This default value specifies that the fully qualified

domain name will not be used.
l Use AP Name with FQDN - The AP name will prepend the FQDN, for

example “somehostname (my.hostname.com).” Note that if the AP
name is not present, then the FQDN will still appear in parenthesis.

l Use only FQDN - Only the fully qualified domain name will be used.
NOTE: This option is supported only for Cisco IOS, Dell Networking W-
Series, Aruba Networks, and Alcatel-Lucent devices.

Show vendor-
specific device
settings for

All Devices Displays a drop-down menu that determines which Group tabs and
options are viewable by default in new groups, and selects the device
types that use fully qualified domain names. This field has three options,
as follows:
l All devices—When selected, AirWave displays all Group tabs and

setting options.
l Only devices on this AMP—When selected, AirWave hides all

options and tabs that do not apply to the APs and devices currently on
AirWave.

l Selected device type—When selected, a new field appears listing
many device types. This option allows you to specify the device types
for which AirWave displays group settings. You can override this
setting.

Look up device and
wireless user
hostnames

Yes Enables AirWave to look up the DNS for new user hostnames. This setting
can be turned off to troubleshoot performance issues.

DNS Hostname
Lifetime

24 hours Defines the length of time, in hours, for which a DNS server hostname
remains valid on AirWave, after which AirWave refreshes DNS lookup:
l 1 hour
l 2 hours
l 4 hours
l 12 hours
l 24 hours

Device
Troubleshooting
Hint

N/A The message included in this field is displayed along with the Down if a
device’s upstream device is up. This applies to all APs and controllers but
not to routers and switches.

Table 5: AMP Setup > General > Display Fields and Default Values
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Device Configuration Settings
Locate the Device Configuration section and adjust the settings. Table 6 describes the settings and default
values of this section.

Setting Default Description

Guest User
Configuration

Disabled Enables or prevents guest users to/from pushing configurations to
devices. Options are Disabled (default), Enabled for Devices in
Manage(Read/Write), Enabled for all Devices.

Allow WMS Offload
configuration in
monitor-only mode

No When Yes is selected, you can enable the ArubaOS WMS offload
feature on the Groups > Basic page for WLAN switches in Monitor
Only mode. Enabling WMS offload does not cause a controller to
reboot. This option is supported only for Aruba and Dell Networking
W-Series devices.

Allow disconnecting
users while in
monitor-only mode

No Sets whether you can deauthenticate a user for a device in monitor-
only mode. If set to No, the Deauthenticate Client button for in a
Clients > Client Detail page is enabled only for Managed devices.

Use Global Aruba
Configuration

No Enables Aruba configuration profile settings to be globally configured
and then assigned to device groups. If disabled, settings can be
defined entirely within Groups > Controller Configand Groups
> Switch Config instead of globally.
NOTE: Changing this setting may require importing configuration on
your devices. When an existing Aruba configuration setup is to be
converted from global to group, follow these steps:
1. Set all the devices to Monitor Only mode before setting the flag.
2. Each device Group will need to have an import performed from

the Device Configuration page of a controller in the AMP group.
3. All of the thin APs need to have their settings imported after the

device group settings have finished importing.
4. If the devices were set to Monitor Only mode, set them back to

Managed mode.

Table 6: AMP Setup > General > Device Configuration Section Fields and Default Values

AMP Features
Locate theAMP Features section and adjust settings for VisualRF, RAPIDS, and AirWave Glass. Table 7 describes
these settings and default values.

Setting Default Description

Display VisualRF No Enable or disable the VisualRF navigation tab.

Display RAPIDS No Enable or disable the RAPIDS navigation tab.

Table 7: AMP Setup Setup > General > AMP Features Fields and Default Values

Anexo 03 A 05 ITENS 21 E 22 (0592763)         SEI 0008478-63.2018.6.02.8000 / pg. 9537



Setting Default Description

Hide setup pages
from non-admin
users

Yes Restrict access to following pages to users with the AMP Administration
role only:
l VisualRF > Setup
l AMP Setup > NMS
l RAPIDS > Score Override
l RAPIDS > Rules
l RAPIDS > Setup
l System > Triggers

Allow role based
report visibility

Yes Enable or disable role-based reporting in AMP. When disabled, reports
can only be generated with by-subject visibility.

Enable Central
Authentication
Service

Yes Toggles on or off single-sign on (SSO) authentication between AirWave
and AirWave Glass.

Central
Authentication
Hostname

If the Central Authentication Service is enabled and the managed AMP is
attached to AirWave Glass, this field is automatically populated, and you
don't need to configure the hostname.

Table 7: AMP Setup Setup > General > AMP Features Fields and Default Values (Continued)

External Logging Settings
Locate the External Logging section and adjust settings to send audit and system events to an external syslog
server. Table 8 describes these settings and default values. You can also send a test message using the Send
Test Message button after enabling any of the logging options.

For information about creating triggers in order to receive event notifications, see "Creating New Triggers" on
page 298.

Setting Default Description

Include event log
messages

No Select Yes to send event log messages to an external Syslog server.
NOTE: If you enable event logging, other options to configure the Syslog
server and enable logging using Common Event Format (CEF) become
available.

Syslog Server N/A Enter the IP address of the syslog server. Note that this field is hidden if
both "Include event log messages" and "Include audit log messages" are
set to No.

Syslog Port 514 Enter the port of the syslog server. Note that this field is hidden if both
"Include event log messages" and "Include audit log messages" are set to
No.

Event log facility local1 Select the facility for the event log from the drop-down menu. This field is
only available if the "Include event log messages" setting is Yes.

Include audit log
messages

No Select Yes to send audit log messages to an external syslog server.

Table 8: AMP Setup > General > External Logging Section Fields and Default Values
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Setting Default Description

Audit log facility local1 Select the facility for the audit log from the drop-down menu. This field is
only available if the "Include audit log messages" setting is Yes

Send Test Message N/A If messaging is enabled and a server and port are configured, click this
button to send a test message. Upon completion, a message will appear
at the top of this page indicating that the message was sent successfully.

Table 8: AMP Setup > General > External Logging Section Fields and Default Values (Continued)

Historical Data Retention Settings
Locate theHistorical Data Retention section and specify the number of days you want to keep client session
records and rogue discovery events. Table 9 describes the settings and default values of this section. Many
settings can be set to have no expiration date.

Setting Default Description

Inactive Client and
VPN User Data (0-
1500 days, zero
disables)

60 Defines the number of days AirWave stores basic information about
inactive clients and VPN users. A shorter setting of 60 days is
recommended for customers with high user turnover such as hotels. The
longer you store inactive user data, the more hard disk space you require.

Client Association
and VPN Session
History (0-550
days, zero
disables)

14 Defines the number of days AirWave stores client and VPN session
records. The longer you store client session records, the more hard disk
space you require.

Tag History (0-550
days, zero
disables)

14 Sets the number of days AirWave retains location history for Wi-Fi tags.

Rogue AP
Discovery Events
(14-550 days, zero
disables)

14 Defines the number of days AirWave stores Rogue Discovery Events. The
longer you store discovery event records, the more hard disk space you
require.

Reports (0-550
days, zero
disables)

60 Defines the number of days AirWave stores Reports. Large numbers of
reports, over 1000, can cause the Reports > Generated page to be slow to
respond.

Automatically
Acknowledge
Alerts(0-550 days,
zero disables)

14 Defines automatically acknowledged alerts as the number of days AirWave
retains alerts that have been automatically acknowledged. Setting this
value to 0 disables this function, and alerts will never expire or be deleted
from the database.

Acknowledged
Alerts(0-550 days,
zero disables)

60 Defines the number of days AirWave retains information about
acknowledged alerts. Large numbers of Alerts, over 2000, can cause the
System > Alerts page to be slow to respond.

Table 9: AMP Setup > General > Historical Data Retention Fields and Default Values
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Setting Default Description

Radius/ARM/IDS
Events(0-550 days,
zero disables)

14 Defines the number of days AirWave retains information about RADIUS,
ARM, and IDS events. Setting this value to 0 disables this function, and the
information will never expire or be deleted from the database.

Archived Device
Configurations (0-
100, zero disables)

10 Defines the number of configurations that will be retained for archived
devices. Whether rogue information is included depends on the setting of
the Archive device configs even if they only have rogue
classifications setting.

Archive device
configs even if they
only have rogue
classifications

No Sets whether to archive device configurations even if the device only has
rogue classifications.

Guest Users (0-550
days, zero
disables)

30 Sets the number of days that AirWave is to support any guest user. A value
of 0 disables this function, and guest users will never expire or be deleted
from the AirWave database.

Inactive SSIDs (0-
550 days, zero
disables)

425 Sets the number of days AirWave retains historical information after
AirWave last saw a client on a specific SSID. Setting this value to 0 disables
this function, and inactive SSIDs will never expire or be deleted from the
database.

Inactive Interfaces
(0-550 days, zero
disables)

425 Sets the number of days AirWave retains inactive interface information
after the interface has been removed or deleted from the device. Setting
this value to 0 disables this function, and inactive interface information will
never expire or be deleted from the database.

Interface Status
History (0-550
days, zero
disables)

425 Sets the number of days AirWave retains historical information on
interface status. Setting this value to 0 disables this function.

Interfering Devices
(0-550 days, zero
disables)

14 Sets the number of days AirWave retains historical information on
interfering devices. Setting this value to 0 disables this function.

Device Events
(Syslog, Traps)(1-
31 days)

2 Sets the number of days AirWave retains historical information on device
events such as syslog entries and SNMP traps. Setting this value to 0
disables this function. Refer to "Viewing Device Events" on page 295.
NOTE: If your data table has more than 5 million rows, AirWave will
truncate the device event retention data. In this case, the "number of days"
setting becomes "number of hours."

Mesh Link History
(0-550 days)

30 Sets the number of days AirWave retains historical information for mesh
links.

Device Uptime (0-
120 months, zero
disables)

60 Sets the number of months AirWave retains historical information on
device uptime. Setting this value to 0 disables this function.

Table 9: AMP Setup > General > Historical Data Retention Fields and Default Values (Continued)
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Setting Default Description

Client Data
Retention Interval
(1-425 days)

425 Sets the number of days AirWave retains historical information for clients.

UCC Call History
(1-30 days)

30 Sets the number of days that calls remain in AirWave's call history.

UCC Call Details
(1-7 days)

2 Sets the number if days that the AirWave retains details for individual calls.

Config Job
Retention Interval
(1-31 days)

31 Sets the number of days AirWave retains information about configuration
jobs.

Table 9: AMP Setup > General > Historical Data Retention Fields and Default Values (Continued)

Firmware Upgrade/Reboot Options
Locate the Firmware Upgrade/Reboot Options section and adjust settings as required. This section allows
you to configure the default firmware upgrade behavior for AirWaveTable 10

Table 10 describes the firmware upgrade and reboot options.

Setting Default Description

Allow firmware
upgrades in
monitor-only mode

No If Yes is selected, AirWave upgrades the firmware for APs in Monitor
Only mode. When AirWave upgrades the firmware in this mode, the
desired configuration are not be pushed to AirWave. Only the firmware is
applied. The firmware upgrade may result in configuration changes
AirWave does not correct those changes when the AP is in Monitor Only
mode.

Allow Rebooting
Monitor Only
Devices

No If Yes is selected, AirWave can reboot devices in Monitor Only mode.

Enable firmware
distribution via http

No By default, we use HTTPS and require user log in for firmware updates.
NOTE: For IAPs running versions earlier than Instant 3.4.0.0, set this
option to "Yes" in order to get firmware updates using HTTP.

Fast Download No When fast download is enabled, standalone IAPs in the same RF zone are
grouped so that they can download the image from each other. This
assumes that the APs are behind the same firewall so that they can reach
each other, thereby making the firmware download faster.

Sequential Reboot No When sequential reboot is enabled, the APs in the same RF zone will
reboot sequentially. At any given time, only one AP is being rebooted. As a
result, users can use another AP that is visible in RF and have
uninterrupted service.

Table 10: AMP Setup > General > Firmware Upgrade Defaults Fields and Default Values
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Setting Default Description

Maximum
Interleaved Jobs (1-
20)

20 Defines the number of jobs AirWave runs at the same time. A job can
include multiple APs. When jobs are started by multiple users, AirWave will
interleave upgrades so that one user's job does not completely block
another’s.

Maximum
Interleaved Devices
Per Job (1-1000)

20 Defines the number of devices that can be in the process of upgrading at
the same time. Within a single job, AirWave may start the upgrade
process for up to this number of devices at the same time. However, only
one device will be actively downloading a firmware file at any given time.

Failures before
stopping (0-20, zero
disables)

1 Sets the default number of upgrade failures before AirWave pauses the
upgrade process. User intervention is required to resume the upgrade
process. Setting this value to 0 disables this function.

Failure timeout (5-
60 mins)

60 Sets the timeout for an upgrade attempt.

DRT upgrade failure
timeout (2-30 mins)

6 Sets the timeout for a Downloadable Regulatory Table (DRT) upgrade
attempt.

Number of tries in
failure (1-4)

1 Sets the number of retry attempts.

Periodic run failed
upgrade interval

Disabled Set the length of time AirWave retries running a failed upgrade.

Table 10: AMP Setup > General > Firmware Upgrade Defaults Fields and Default Values (Continued)

Additional AMP Services
Locate theAdditional AMP Services section, and adjust settings as required. Table 11 describes the settings
and default values of this section.

Setting Default Description

Enable FTP Server No Enables or disables the FTP server on AirWave. The FTP server is only
used to manage Aruba AirMesh and Cisco Aironet 4800 APs. Best
practice is to disable the FTP server if you do not have any supported
devices in the network.

Table 11: AMP Setup > General > Additional AMP Services Fields and Default Values
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Setting Default Description

Enable RTLS
Collector

No Enables or disables the RTLS Collector, which is used to allow
ArubaOS controllers to send signed and encrypted RTLS (real time
locating system) packets to VisualRF; in other words, AirWave becomes
the acting RTLS server. The RTLS server IP address must be configured on
each controller. This function is used for VisualRF to improve location
accuracy and to locate chirping asset tags. This function is supported only
for Dell Networking W-Series, Alcatel-Lucent, and Aruba Networks
devices.

If Yes is specified, the following additional fields appear. These
configuration settings should match the settings configured on the
controller:
l RTLS Port—Specify the port for the AirWave RTLS server.
l RTLS Username—Enter the user name used by the controller to

decode RTLS messages.
l RTLS Password—Enter the RTLS server password that matches the

controller’s value.
l Confirm RTLS Password—Re-enter the RTLS server password.

Use Embedded
Mail Server

Yes Enables or disables the embedded mail server that is included with
AirWave.

Mail Relay Server Optional If you enable the "Use embedded mail server" option, enter information
for an optional mail relay server. This field supports a Send Test Email
button for testing server functionality. Click this button to enter valid email
addresses.

Process user
roaming traps from
Cisco WLC

Yes Whether AirWave should parse client association and authentication traps
from Cisco WLC controllers to give real time information on users
connected to the wireless network.

Enable AMON data
collection

Yes Allows AirWave to collect enhanced data from Aruba devices on certain
firmware versions. See the Best Practices Guide on the Home >
Documentation page for more details
NOTE: When enabling AMON, auditing should be set to daily and have
been successful at least once to allow AirWave to calculate the proper
BSSIDs per radio. If these BSSIDs do not exist, clients are dropped
because they do not have any corresponding BSSIDs in the AirWave
database. Auditing should be set to daily because the BSSIDs are kept in
cache memory and cleared every 24 hours.

Enable Clarity Data
Collection

Yes Allows AirWave to collect enhanced Clarity Monitoring data from Aruba
devices running ArubaOS 6.4.3 and later versions

Enable Traffic
Analysis Data
Collection

Yes If AMON is enabled for a controller, you can enable AirWave to collect
Traffic Analysis data from the controller by setting this to Yes. When
enabled, the Home > Traffic Anaylsis dashboard is available in the
WebUI.

Traffic Analysis
Storage Allocated
(GiB)

50 If Traffic Analysis Data Collection is enabled, you can specify the amount
of storage to allocate.

Table 11: AMP Setup > General > Additional AMP Services Fields and Default Values (Continued)
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Setting Default Description

Enable UCC Data
Collection

Yes Enables controllers to send UCC data to AirWave. For this feature to work,
AirWave must be a management server on the controller, the AMON port
is set up for UDP port 8211, and the controller profile has UCC monitoring
enabled.

Enable UCC Calls
Stitching
(Heuristics)

Yes Enables caller-to-callee call stitching for non-SDN deployments. You
should turn off this option for NAT and BOC deployments.

Prefer AMON vs
SNMP Polling

Yes Prefer AMON is a configuration setting which causes AirWave to use an
AMON feed to obtain client monitoring information from a controller
rather than polling it via SNMP. When you enable this setting, values such
as AP lists and rogue AP lists are still polled via SNMP, but the bulk of
client monitoring information is delivered via AMON.

NOTE:
l Auditing needs to have been successful at least once to allow AirWave

to calculate the proper BSSIDs per radio.
l When Prefer AMON is enabled, the controller must be configured to

send AMON to AirWave.
l The network path from the controller to the AirWave server must allow

traffic on UDP port 8211.
l The controller routinely sends AMON in large UDP packets, (up to 30K

bytes). Before enabling this setting, ensure the network path from the
controller to AirWave can pass such large packets intact.

l This setting should only be used in a network environment with low
levels of UDP packet loss, as the loss of a single Ethernet frame will
potentially result in the loss of up to 30K bytes worth of data.

Enable Syslog and
SNMP Trap
Collection

Yes This option specifies whether traps used to detect roaming events, auth
failures, AP up/down status, and IDS events will still be collected if they
are sent by managed devices.

Require SSH host
key verification

No This setting reserved for future use.

Validate PAPI key No Security improvements in AirWave 8.2.1 and later releases allow you to
specify a custom PAPI key and require PAPI key validation. If you select the
Yes option, you are prompted to enter a custom PAPI key

Disable TLS 1.0 and
1.1

Yes This option is set to Yes by default. In order for Aruba switches to
automatically check-in to AirWave by ZTP, you must change this option to
No. If you select No, you must restart AMP.

Table 11: AMP Setup > General > Additional AMP Services Fields and Default Values (Continued)

Performance Settings
Locate the Performance section. Performance tuning is unlikely to be necessary for many AirWave
deployments, and likely provides the most improvements for customers with extremely large Pro or Enterprise
installations. Please contact Aruba support if you think you might need to change any of these settings. Table 12
describes the settings and default values of this section.
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Setting Default Description

Monitoring
Processes

Based on
the number
of cores for
your server

Optional setting configures the throughput of monitoring data.
Increasing this setting allows AirWave to process more data per
second, but it can take resources away from other AirWave
processes. Contact Aruba support if you think you might need to
increase this setting for your network. Also note that the value
range varies based on the number of available process cores.

Maximum number
of configuration
processes

5 Increases the number of processes that are pushing configurations
to your devices, as an option. The optimal setting for your network
depends on the resources available, especially RAM. Contact Aruba
support if you think you might need to increase this setting for your
network.

Maximum number
of audit processes

3 Increases the number of processes that audit configurations for
your devices, as an option. The optimal setting for your network
depends on the resources available, especially RAM. Contact Aruba
support if you are considering increasing this setting for your
network.

SNMP Fetcher
Count (2-6)

2 Specify the number of SNMPv2 fetchers.

Verbose Logging
of SNMP
Configuration

No Enables or disables logging detailed records of SNMP configuration
information.

SNMP Rate
Limiting for
Monitored
Devices

No When enabled, AirWave fetches SNMP data more slowly, potentially
reducing device CPU load.

We recommend enabling this global setting if your network contains
a majority of legacy controllers (800, 2400, 5000, or controllers that
use Supervisor Module II). If your network mainly uses newer
(30000 Series, 600 Series, or the M3 module in the 6000 series), we
strongly recommend disabling this setting.

Client Association
Relevance Factor

0 days
(disabled)

Use this setting to hide old client information from clients lists and
client search results. For example, a setting of 3 limits the historical
client data displayed in client lists and search results to client
sessions that have been disconnected within the last three days.
When this value is set to 1, client lists and search results display
only the client history for the previous day.

This time range can be set from 0-550 days, where a value of zero
disables this feature and makes available all historical client data. A
shorter time period improves search performance and allows client
lists to display more rapidly, though it will also display fewer results.

Table 12: AMP Setup> General > Performance Fields and Default Values
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Setting Default Description

RAPIDS
Processing
Priority

Low Defines the processing and system resource priority for RAPIDS in
relation to AirWave as a whole.

When AirWave is processing data at or near its maximum capacity,
reducing the priority of RAPIDS can ensure that processing of other
data (such as client connections and bandwidth usage) is not
adversely impacted.

The default priority is Low. You can also tune your system
performance by changing group poll periods.

If you select Custom for the priority, then also specify the RAPIDS
custom process limit.

RAPIDS custom
process limit (1-
16)

1 when
Custom is
specified for
the RAPIDS
Processing
Priority.

Sets the maximum number of monitoring process assigned to
RAPIDS work. Note that this option is only available if Custom is
specified for the RAPIDS Processing Priority.

Table 12: AMP Setup> General > Performance Fields and Default Values (Continued)

Defining Network Settings
The next steps in setting up AirWave are to configure the network interface, DNS settings, NTP servers, and static
routes.

Figure 3 illustrates the contents of theAMP Setup > Network page when setting up an IPv4 interface.
Optionally, you can configure an IPv6 interface. For information, see "Primary Network Interface Settings" on
page 34.
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Figure 3: Network Page

Specify the network configuration options described in the sections that follow to define the AirWave network
settings. Select Save when you have completed all changes on theAMP Setup > Network page, or select
Revert to return to the last settings. Save restarts any affected services and may temporarily disrupt your
network connection.

Primary Network Interface Settings
Locate the Primary Network Interface section. The information in this sections should match what you
defined during initial network configuration and should not require changes. Table 13 describes the settings and
default values.

Setting Default Description

IPv4 Address None Sets the IPv4 address of the AirWave network interface.
NOTE: This address must be a static IP address.

Hostname None Sets the DNS name assigned to the AirWave server.

Subnet Mask None Sets the subnet mask for the primary network interface.

IPv4 Gateway None Sets the default gateway for the network interface.

IPv6 Enabled No By selecting Yes, you can enter an optional IPv6 address and gateway
address.

IPv6 Address None Sets the IPv6 address of the AirWave network interface.

Table 13: Primary Network Interface Fields and Default Values
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Setting Default Description

IPv6 Gateway None Sets the default gateway for the network interface.

Primary DNS IP None Sets the primary DNS IP address for the network interface.

Secondary DNS IP None Sets the secondary DNS IP address for the network interface.

Table 13: Primary Network Interface Fields and Default Values (Continued)

Secondary Network Interface Settings
Locate the Secondary Network Interface section. The information in this section should match what you
defined during initial network configuration and should not require changes. Table 14 describes the settings and
default values.

Setting Default Description

Enabled No Select Yes to enable a secondary network interface. You will be
prompted to define the IP address and subnet mask.

IP Address None Specify the IP address of the AirWave secondary network.
NOTE: This address must be a static IP address. AirWave supports
IPv4 and IPv6 addresses.

Subnet Mask None Specify the subnet mask for the secondary network interface.

Table 14: Secondary Network Interface Fields and Default Values

Network Time Protocol (NTP) Settings
On theAMP Setup > Network page, locate theNetwork Time Protocol (NTP) section. The Network Time
Protocol is used to synchronize the time between AirWave and your network’s NTP server. NTP servers
synchronize with external reference time sources, such as satellites, radios, or modems.

SpecifyingNTP servers is optional. NTP servers synchronize the time on the AirWave server, not on individual
accesspoints.

To disable NTP services, clear both the Primary and Secondary NTP server fields. Any problem related to
communication between AirWave and the NTP servers creates an entry in the event log. Table 15 describes the
settings and default values in more detail. For more information on ensuring that AirWave servers have the
correct time, please see http://support.ntp.org/bin/view/Servers/NTPPoolServers.

Setting Default Description

Primary ntp1.yourdomain.com Sets the IP address or DNS name for the primary NTP server.

Secondary ntp2.yourdomain.com Sets the IP address or DNS name for the secondary NTP server.

Table 15: AMP Setup > Network > Secondary Network Fields and Default Values

Static Routes
On theAMP Setup > Network page, locate the Static Routes area. This section displays network, subnet
mask, and gateway settings that you have defined elsewhere from a command-line interface.
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Thissection does not enable you to configure new routes or remove existing routes.

What Next?

l Go to additional tabs in the AMP Setup section to continue additional setup configurations. The next section
describes AirWave roles.

l Complete the required configurations in this chapter before proceeding. Aruba support remains available to
you for any phase of AirWave configuration.

Creating AirWave Users
AirWave installs with only one user—the admin, who is authorized to perform the following functions:

l Define additional users with varying levels of privilege, be it manage read/write or monitoring.

l Limit the viewable devices as well as the level of access a user has to the devices.

Each general user that you add must have a user name, a password, and a role. Use unique and meaningful user
names as they are recorded in the log files when you or other users make changes in AirWave.

Username and password are not required if you configure AirWave to use RADIUS, TACACS, or LDAP
authentication. You do not need to add individual users to the AirWave server if you use RADIUS, TACACS, or
LDAP authentication.

The user role defines the user type, access level, and the top folder for that user. User roles are defined on the
AMP Setup > Roles page. Refer to the previous procedure in this chapter for additional information, "Creating
AirWave User Roles" on page 38.

The admin user can provide optional additional information about the user, including the user's real name, email
address, phone number, and so forth.

Perform the following steps to display, add, edit, or delete AirWave users of any privilege level. You must be an
admin user to complete these steps.

1. Go to theAMP Setup > Users page. This page displays all users currently configured in AirWave, as shown in
Figure 4.

Figure 4: AMP Setup > Users Page

2. Select Add to create a new user, select the pencil icon to edit an existing user, or select a user and select
Delete to remove that user from AirWave. When you select Add or the edit icon, theAdd User page appears,
illustrated in Figure 5.

Current users cannot change their own role. TheRole drop-down field is disabled to prevent this.
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Figure 5: AMP Setup > Users > Add/Edit User Page

3. Enter or edit the settings on this page. Table 16 describes these settings.

Setting Default Description

Username None Sets the user name for the user who logs in to AirWave. This user name is
displayed in AirWave log files.

Role None Specifies the user’s Role, which defines the Top viewable folder as well as the
type and access level of the user specified in the previous field.

The admin user defines user roles on the AMP Setup > Roles page, and each
user in the system is assigned to a role.

Password None Sets the password for the user being created or edited. Enter an alphanumeric
string without spaces, and enter the password again in the Confirm Password
field. AirWave strengthens user passwords with SHA512 encryption.
NOTE: Because the default user's password is identical to the Name, you should
change this password. You will be logged out and asked to enter your new
password.

Name None Allows you to define an optional and alphanumeric text field that takes note of the
user's actual name.

Email
Address

None Allows you to specify a specific email address that will propagate throughout
many additional pages in AirWave for that user, including reports, triggers, and
alerts.

Phone None Allows you to enter an optional phone number for the user.

Notes None Enables you to cite any additional notes about the user, including the reason they
were granted access, the user's department, or job title.

Table 16: AMP Setup > Users > Add/Edit User Fields and Default Values
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4. Select Add to create the new user, Save to retain changes to an existing user, or Cancel to cancel out of this
screen. The user information you have configured appears on theAMP Setup > Users page, and the user
propagates to all other AirWave pages and relevant functions.

AirWave enablesuser roles to be created with access to folders within multiple branches of the overall
hierarchy. This feature assists non-administrator users who support a subset of accounts or sites within a single
AirWavedeployment, such as help desk or IT staff.

Configuring AirWave User Roles
TheAMP Setup > Roles page defines the viewable devices, the operations that can be performed on devices,
and general AirWave access. User roles can be created that provide users with access to folders within multiple
branches of the overall hierarchy. This feature assists non-administrative users, such as help desk or IT staff, who
support a subset of accounts or sites within a single AirWave deployment. You can restrict user roles to multiple
folders within the overall hierarchy even if they do not share the same top-level folder. Non-admin users are only
able to see data and users for devices within their assigned subset of folders.

User Roles and VisualRF
VisualRF uses the same user roles as defined for AirWave. Users can see floor plans that contain an AP to which
they have access in AirWave, although only visible APs appear on the floor plan. VisualRF users can also see any
building that contains a visible floor plan and any campus that contains a visible building.

InVisualRF > Setup > Server Settings, theRestrict visibility of empty floor plans to the user that
created them configuration option allows you to restrict the visibility of empty floor plans to the role of the
userwho created them. By default, this setting is set to No.

When a new role is added to AirWave, VisualRF must be restarted for the new user to be enabled.

Creating AirWave User Roles
Roles define the capabilities a user has access to and the privileges and views available for device groups and
devices in AirWave. The available configuration options differ for each role type.

Most users will see two sections on this page: Role and Guest User Preferences. TheGuest User
Preferences section appears only if Guest User Configuration is enabled in AMP Setup > General.

If you want to create a user role, log in to AirWave as admin and follow these steps:

1. Go to theAMP Setup > Roles and click Add.

2. Enter a name for the user role, select options, and click Add. Figure 6 shows a role named Traffic Analysis
being created.
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Figure 6: Adding a Non-Admin Role Named Traffic Analysis

3. Enter additional settings on this page.

Figure 7 shows the newly created Traffic Analysis Admin role in the Role page.

Figure 7: Newly Created Traffic Analysis Admin Role

AMP Administrator Role

The following table describes the available settings and default values for the AMP Administrator role.
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Setting Default Description

Name None Sets the administrator-definable string that names the role. The role
name should indicate the devices and groups that are viewable, as well
as the privileges granted to that role.

Enabled Yes Disables or enables the role. Disabling a role prevents all users of that
role from logging in to AirWave.

Type Device
Manager

Defines the type of role.

AirWave Administrator—Grants full access to AirWave and all the
devices, the capability to create new users, and access to AMP Setup,
VisualRF > Setup, VisualRF > Audit Log, System > Event Log, and
System > Performance pages.

Aruba Controller
Role

Disabled Enables or disables Single Sign-On for the role. If enabled, allows the
user read-only access or direct access to the Aruba controller UIs from
quick links in the WebUI without having to enter credentials for the
controller.

Allow user to
disable timeout

No Whether a user can disable AirWave’s timeout feature.

Custom Message none A custom message can also be included.

Table 17: AMP Setup > Roles > Add/Edit Roles Fields and Default Values for AMP Administrator Role

Setting Default Description

Name None Sets the administrator-definable string that names the role. The role name
should indicate the devices and groups that are viewable, as well as the
privileges granted to that role.

Enabled Yes Disables or enables the role. Disabling a role prevents all users of that role
from logging in to AirWave.

Type Device
Manager

Defines the type of role.

Device Manager—Provides access to a limited number of devices and groups
based on the Top folder and varying levels of control based on the Access
Level.

Table 18: AMP Setup > Roles > Add/Edit Roles Fields and Default Values for Device Manager Role
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Setting Default Description

Access Level Monitor
(Read Only)

Defines the privileges the role has over the viewable device. AirWave supports
three privilege levels, as follows:
l Manage (Read/Write)—Provides the capability to modify, remove, and

view information for devices and groups. Selecting this option causes a new
field, Allow authorization of Devices, to appear on the page, and is
enabled by default.

l Audit (Read Only)—Provides the capability to view devices and groups
and the Device Configuration page, which may contain sensitive
information like AP passwords.

l Monitor (Read Only)—Provides the capability to view devices and groups
and VisualRF.

Top Folder Top Defines the highest viewable folder for the role. The role is able to view all
devices and groups contained by the specified top folder. The top folder and its
subfolders must contain all of the devices in any of the groups it can view.
NOTE: AirWave enables user roles to be created with access to folders within
multiple branches of the overall hierarchy. This feature assists non-
administrator users who support a subset of accounts or sites within a single
AirWave deployment, such as help desk or IT staff.

User roles can be restricted to multiple folders within the overall hierarchy,
even if they do not share the same top-level folder. Non-administrator users
are only able to see data and users for devices within their assigned subset of
folders.

Allow
Authorization
of Devices

Yes NOTE: This option is only available when the AP/Device Access Level is
specified as Manage (Read/Write).

RAPIDS None Sets the RAPIDS privileges. This field specifies the RAPIDS privileges for the
user role and includes these options:
l None— Cannot view the RAPIDS tab or any rogue devices.
l Read Only—The user can view the RAPIDS pages but cannot make any

changes to rogue devices or perform OS scans.
l Read/Write—The user may edit individual rogues, classification, threat

levels and notes, and perform OS scans.
l Administrator—Has the same privileges as the Read/Write user, but can

also set up RAPIDS rules, override scores and is the only user who can
access the RAPIDS > Setup page.

VisualRF Read Only Sets the VisualRF privileges, which are set separately from the Devices:
l Read Only—The user can view the VisualRF pages but cannot make any

changes to floor plans.
l Read/Write—The user may edit individual floor plans, buildings, and

campuses.

UCC Yes Permits access to UCC views and tables. Monitoring and managing privileges
are set at the device level.

Traffic
Analysis

Yes Permits access to Traffic Analysis views and tables. Monitoring and managing
privileges are set at the AP/Device level.

Table 18: AMP Setup > Roles > Add/Edit Roles Fields and Default Values for Device Manager Role
(Continued)
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Setting Default Description

Aruba
Controller
Single Sign-
On Role

Disabled If enabled, the user has read-only or root access to Aruba controller UIs from
quick links without having to enter credentials for the controller.

Display Client
Diagnostics
Screens By
Default

No Sets the role to support helpdesk users with parameters that are specific to
the needs of helpdesk personnel supporting users on a wireless network.

Allow User to
Disable
Timeout

No Whether a user can disable AirWave’s timeout feature.

Allow Reboot
of Devices

No Allows user to reboot devices in AirWave.

Allow
Creation of
Guest Users

Yes If this option is enabled, users with an assigned role of Monitoring or Audit can
be given access to guest user account creation along with the option to allow a
sponsor to change its user name.
NOTE: This option is not available if the AP/Device Access Level is specified
as Manage (Read/Write).

Allow
Accounts
With No
Expiration

Yes Specifies whether to allow accounts that have no expiration set. If this is set to
No, then enter the amount of time that can elapse before the access expires.

Allow
Sponsor to
Change
Sponsorship
User Name

No Specifies whether a sponsor can change the sponsorship user name.

Custom
Message

none A custom message can also be included.

Table 18: AMP Setup > Roles > Add/Edit Roles Fields and Default Values for Device Manager Role
(Continued)

Guest Access Sponsor Role

The following table describes the available settings and default values for the Guest Access Sponsor role.

Setting Default Description

Name None Sets the administrator-definable string that names the role. The role name
should indicate the devices and groups that are viewable, as well as the
privileges granted to that role.

Table 19: AMP Setup > Roles > Add/Edit Roles Fields and Default Values for Guest Access Sponsor Role
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Setting Default Description

Enabled Yes Disables or enables the role. Disabling a role prevents all users of that role
from logging in to AirWave.

Type AP/Device
Manager

Defines the type of role.

Guest Access Sponsor—Limited-functionality role to allow helpdesk or
reception desk staff to grant wireless access to temporary personnel. This role
only has access to the defined top folder.

Top Folder Top Defines the Top viewable folder for the role. The role is able to view all devices
and groups contained by the Top folder. The top folder and its subfolders must
contain all of the devices in any of the groups it can view.
NOTE: AirWave enables user roles to be created with access to folders within
multiple branches of the overall hierarchy. This feature assists non-
administrator users who support a subset of accounts or sites within a single
AirWave deployment, such as help desk or IT staff.
User roles can be restricted to multiple folders within the overall hierarchy,
even if they do not share the same top-level folder. Non-administrator users
are only able to see data and users for devices within their assigned subset of
folders.

Allow user
to disable
timeout

No Whether a user can disable AirWave’s timeout feature.

Allow
accounts
with no
expiration

Yes Specifies whether to allow accounts that have no expiration set. If this is set to
No, then enter the amount of time that can elapse before the access expires.

Allow
sponsor to
change
sponsorship
user name

No Specifies whether a sponsor can change the sponsorship user name.

Custom
Message

none A custom message can also be included.

Table 19: AMP Setup > Roles > Add/Edit Roles Fields and Default Values for Guest Access Sponsor Role
(Continued)

Configuring the User Login and Authentication
AirWave uses session-based authentication with a configurable login message and idle timeout. As an option,
you can set AirWave to use an external user database to simplify password management for AirWave
administrators and users.

This section contains the following procedures to be followed in AMP Setup > Authentication:

l "Configuring the User Login" on page 44

l "Configuring Whitelists" on page 44

l "Setting Up Certificate Authentication" on page 45

l "Setting Up Single Sign-On" on page 45

l "Specifying the Authentication Priority" on page 45
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l "Configuring RADIUS Authentication and Authorization" on page 46

l "Integrating a RADIUS Accounting Server" on page 45

l "Configuring TACACS+ Authentication" on page 48

l "Configuring LDAP Authentication and Authorization" on page 50

Configuring the User Login
Follow these steps to configure the login banner message, idle timeout, and persistent cookies which are session-
based:

To configure user login:

1. Navigate to AMP Setup > Authentication > Login Configuration.

2. To clear information such as user logins, select No for the "Use Persistent Cookies" option.

3. Enter the length of time that passes before AirWave ends an idle user session. 5 minutes is the lowest idle
setting.

Figure 8: Example Settings for the Login Configuration Page

4. In the Click Through Agreement field, type the login banner message that will display before the user logs in to
AirWave, requiring the user to accept the terms of usage before granting full access to the WebUI.

5. Click Save at the bottom of the page.

Configuring Whitelists
By adding subnets to a whitelist, you can limit AirWave access to users on a list of trusted subnets.

Do not delete the current client network from the AirWave whitelist, or you might lose access to the AirWave WebUI.

To configure the whitelist:

1. Navigate to AMP Setup > Authentication.

2. In the Login Configuration section, select Yes for the "Enable AMP Whitelist" option. When you enable this
functionality, AirWave displays the whitelist with the current client network as the first entry.

Figure 9: EnablingWhitelists

3. Enter additional subnets, one subnet per line.

4. Scroll down the page, then click Save.

Anexo 03 A 05 ITENS 21 E 22 (0592763)         SEI 0008478-63.2018.6.02.8000 / pg. 9557



Setting Up Certificate Authentication
On theAMP Setup > Authentication page, administrators can specify whether to require a certificate during
authentication and whether to use two-factor authentication. A PEM-encoded certificate bundle is required for
this feature.

This feature must be enabled per role in AMP Setup > Roles.

Perform the following steps to enable this feature for this AMP.

1. Locate theCertificate Authentication section in AMP Setup > Authentication.

2. In the Enable Certificate Authentication field, select Yes.

3. Specify whether to require a certificate in order to authenticate. If Yes, then you can also specify whether to
use two-factor authentication.

4. Enter the PEM-encoded CA certificate bundle.

5. Select Save if you are finished or follow the next procedure to specify the authentication priority.

Setting Up Single Sign-On
On theAMP Setup > Authentication page, administrators can set up single sign-on (SSO) for users that have
access to AirWave controllers. This allows users to log in to AirWave and use the IP Address or Quick Links
hypertext links across AirWave to access the controller’s WebUI without having to enter credentials again. The
links the user can select to access a controller can be found on theDevices > Monitor page in theDevice Info
section, and on device list pages.

Perform the following steps to enable this feature for this AirWave.

1. Locate the Single Sign-On section in AMP Setup > Authentication.

2. In the Enable Single Sign-On field, select Yes.

3. Select Save if you are finished or follow the next procedure to specify the authentication priority.

Specifying the Authentication Priority
To specify the authentication priority for this AirWave server, locate theAuthentication Priority section in
AMP Setup > Authentication, and select either Local orRemote as the priority.

If Local is selected, then remote will be attempted if a user is not available. If Remote is selected, then the local
database is searched if remote authentication fails. The order of remote authentication is RADIUS first, followed
by TACACS, and finally LDAP.

Select Save if you are finished or follow the next procedure to configure RADIUS, TACACS+, and LDAP
Authentication options.

Integrating a RADIUS Accounting Server

AirWavechecks the local user name and password before checking with the RADIUS server. If the user is found
locally, the local password and role apply. When using RADIUS, it’s not necessary or recommended to define
userson the AirWave server. The only recommended user is the backup admin, in case the RADIUS server goes
down.

Optionally, you can configure RADIUS server accounting on AMP Setup > RADIUS Accounting. This capability
is not required for basic AirWave operation, but can increase the user-friendliness of AirWave administration in
large networks. Figure 10 illustrates the settings of this optional configuration interface.

Perform the following steps and configurations to enable AirWave to receive accounting records from a separate
RADIUS server. Figure 10 illustrates the display of RADIUS accounting clients already configured.
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Figure 10: AMP Setup > RADIUS Accounting Page Illustration

1. To define a the RADIUS authentication server or network, browse to theAMP Setup > RADIUS Accounting
page, select Add, and provide the information in Table 20.

Setting Default Description

IP/Network None Specify the IP address for the authentication server if you only want to accept
packets from one device. To accept packets from an entire network enter the
IP/Netmask of the network (for example, 10.51.0.0/24).

Nickname None Sets a user-defined name for the authentication server.

Shared Secret
(Confirm)

None Sets the Shared Secret that is used to establish communication between
AirWave and the RADIUS authentication server.

Table 20: AMP Setup > Radius Accounting Fields and Default Values for LDAP Authentication

2. Click Add to save your settings.

Configuring RADIUS Authentication and Authorization
For RADIUS capability, you must configure the IP/Hostname of the RADIUS server, the TCP port, and the server
shared secret. Perform these steps to configure RADIUS authentication:

1. Go to theAMP Setup > Authentication page. This page displays current status of RADIUS. Figure 11
illustrates this page.
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Figure 11: AMP Setup > Authentication Page Illustration for RADIUS

2. Select No to disable or Yes to enable RADIUS authentication. If you select Yes, several new fields appear.
Complete the fields described in Table 21.

Field Default Description

Primary Server
Hostname/IP Address

N/A Enter the IP address or the hostname of the primary RADIUS server.

Primary Server Port
(1-65535)

1812 Enter the TCP port for the primary RADIUS server.

Primary Server Secret N/A Specify and confirm the primary shared secret for the primary RADIUS
server.

Confirm Primary
Server Secret

N/A Re-enter the primary server secret.

Secondary Server
Hostname/IP Address

N/A Enter the IP address or the hostname of the secondary RADIUS server.

Secondary Server Port
(1-65535)

1812 Enter the TCP port for the secondary RADIUS server.

Secondary Server
Secret

N/A Enter the shared secret for the secondary RADIUS server.

Confirm Secondary
Server Secret

N/A Re-enter the secondary server secret.

Table 21: AMP Setup > Authentication Fields and Default Values for RADIUS Authentication
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Field Default Description

Authentication Method PAP Select one of the following authentication methods:
l PAP
l PEAP-MSCHAPv2

If you use the PEAP-MSCHAPv2 authentication method with the default
"Read-Only Monitoring and Auditing" user role, note that the name of
this role has been slightly modified in AirWave 8.2.3 to allow support
the PEAP-MSCHAPv2 authentication method: the ampersand (&)
 symbol has been changed to the word and.
l Role Name in 8.2.2.x and earlier releases: Read-Only Monitoring

& Auditing
l Role Name in AirWave 8.2.3: Read-Only Monitoring and Auditing

If you used the Read-Only Monitoring & Auditing user role prior to
upgrading to AirWave 8.2.3 or later releases, you must modify the user
role name on the RADIUS server to ensure that the user role name on
the RADIUS server exactly matches the user role name in AirWave.

Table 21: AMP Setup > Authentication Fields and Default Values for RADIUS Authentication (Continued)

3. Select Save to retain these configurations, and continue with additional steps in the next procedure.

Configuring TACACS+ Authentication
For TACACS+ capability, you must configure the IP/Hostname of the TACACS+ server, the TCP port, and the
server shared secret. This TACACS+ configuration is for AirWave users and does not affect APs or users logging
into APs.

1. Go to theAMP Setup > Authentication page. This page displays current status of TACACS+. Figure 12
illustrates this page when neither TACACS+, LDAP, nor RADIUS authentication is enabled in AirWave.

Figure 12: AMP Setup > Authentication Page Illustration for TACACS+

2. Select No to disable or Yes to enable TACACS+ authentication. If you select Yes, several new fields appear.
Complete the fields described in Table 22.
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Field Default Description

Primary Server Hostname/IP
Address

N/A Enter the IP address or the hostname of the primary TACACS+
server.

Primary Server Port (1-65535) 49 Enter the port for the primary TACACS+ server.

Primary Server Secret N/A Specify and confirm the primary shared secret for the primary
TACACS+ server.

Confirm Primary Server
Secret

N/A Re-enter the primary server secret.

Secondary Server
Hostname/IP Address

N/A Enter the IP address or hostname of the secondary TACACS+
server.

Secondary Server Port (1-
65535)

49 Enter the port for the secondary TACACS+ server.

Secondary Server Secret N/A Enter the shared secret for the secondary TACACS+ server.

Confirm Secondary Server
Secret

N/A Re-enter the secondary server secret.

Table 22: AMP Setup > Authentication Fields and Default Values for TACACS+ Authentication

3. Select Save and continue with additional steps.

Configuring Cisco ACS to Work with AirWave

To configure Cisco ACS to work with AirWave, you must define a new service named AMP that uses HTTPS on the
ACS server.

1. The AMP HTTPS service is added to the TACACS+ (Cisco) interface under the Interface Configuration tab.

2. Select a checkbox for a new service.

3. EnterAMP in the service column and https in the protocol column.

4. Select Save.

5. Edit the existing groups or users in TACACS to use the AMP service and define a role for the group or user.

l The role defined on theGroup Setup page in ACS must match the exact name of the role defined on the
AMP Setup > Roles page.

n The defined role should use the format: role=<name_of_AMP_role>. For example role=DormMonitoring.

As with routers and switches, AirWave does not need to know user names.

6. AirWave also needs to be configured as an AAA client.

l On theNetwork Configuration page, select Add Entry.

l Enter the IP address of AirWave as theAAA Client IP Address.

l The secret should be the same value that was entered on theAMP Setup > TACACS+ page.

7. Select TACACS+ (Cisco IOS) in theAuthenticate Using drop down menu and select submit + restart.

AirWavechecks the local user name and password store before checking with the TACACS+ server. If the user is
found locally, the local password and local role apply. When using TACACS+, it is not necessary or
recommended to define users on the AirWave server. The only recommended user is the backup administrator,
in the event that the TACACS+ server goes down.
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Configuring LDAP Authentication and Authorization
LDAP (Lightweight Directory Access Protocol) provides users with a way of accessing and maintaining distributed
directory information services over a network. When LDAP is enabled, a client can begin a session by
authenticating against an LDAP server which by default is on TCP port 389.

Perform these steps to configure LDAP authentication:

1. Go to theAMP Setup > Authentication page.

2. Select the Yes radio button to enable LDAP authentication and authorization. Once enabled, the available
LDAP configuration options will display. Figure 13 illustrates this page.

Figure 13: AMP Setup > Authentication Page Illustration for LDAP

3. Complete the fields described in Table 23.

Field Default Description

Primary Server
Hostname/IP Address

none Enter the IP address or the hostname of the primary LDAP
server.

Primary Server Port
(1-65535)

389 Enter the port where the LDAP server is listening. The default
port is 389.

Secondary Server
Hostname/IP Address

none Optionally enter the IP address or hostname of the
secondary LDAP server. This server will be contacted in the
event that the primary LDAP server is not reachable.

Secondary Server Port
(1-65535)

389 Enter the port where the LDAP service is listening on the
secondary LDAP server. The default port is 389.

Connection Type clear-text Specify one of the following connection types AirWave and
the LDAP server:
l clear-text results in unencrypted communication.
l ldap-s results in communication over SSL.
l start-tls uses certificates to initiate encrypted

communication.

Table 23: AMP Setup > Authentication Fields and Default Values for LDAP Authentication
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Field Default Description

View Server
Certificate

none If Connection Type is configured as start-tls, then also
specify whether the start-tls connection type uses a
certificate.
l none - The server may provide a certificate, but it will not

be verified. This may mean that you are connected to the
wrong server.

l optional - Verifies only when the servers offers a valid
certificate.

l require - The server must provide a valid certificate.

A valid LDAP Server CA Certificate must be provided in
case of optional or require. Certificates uploaded on the
Device Setup > Certificates page with a type of
Intermediate CA or Trusted CA are listed in the drop down
for LDAP Server CA Certificate.

LDAP Server CA
Certificate

none Specify the LDAP server certificate to use to initiate
encrypted communication. Only certificates that have been
uploaded with a type of Intermediate CA or Trusted CA will
appear in this drop down.
NOTE: This LDAP Server CA Certificate drop down menu
only appears if View Server Certificate is specified as
optional or require.

Bind DN none Specify the Distinguished Name (DN) of the administrator
account, such as
‘cn=admin01,cn=admin,dn=domain,dn=com’. Note that for
the Active directory, the bind DN can also be in the
administrator@domain format (for example,
administrator@acme.com).

Bind Password none Specify the bind DN account password.

Confirm Bind
Password

none Re-enter the bind password.

Base DN none The DN of the node in your directory tree from which to start
searching for records. Generally, this would be the node that
contains all the users who may access AirWave, for example
cn=users,dc=domain,dc=com.

Key Attribute sAMAccountName The LDAP attribute that identifies the user, such as
‘sAMAccountName’ for Active Directory

Role Attribute none The LDAP attribute that contains the AirWave role. Users
who log in to AirWave using this LDAP authentication will be
granted permissions based on this role. Refer to Configuring
AirWave User Roles for more information about AirWave
User Roles.

Filter (objectclass=*) This option limits the object classes in which the key,role
attributes would be searched.

Table 23: AMP Setup > Authentication Fields and Default Values for LDAP Authentication (Continued)
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Field Default Description

Add New LDAP Rule none The LDAP rule parameters are Position, Role Attribute,
Operation, Value, and AirWave role. If you create multiple
LDAP rules, rules are processed in order based on the rule
position value, so the position you assign to the LDAP rule
represents the order in which the LDAP rule is applied to
determine the AirWave role. LDAP rules can only be
configured and applied after LDAP authentication is enabled.
The LDAP rules are similar to the rules used by the controller
to derive the AirWave role.

Table 23: AMP Setup > Authentication Fields and Default Values for LDAP Authentication (Continued)

4. Select Save to retain these configurations, and continue with additional steps in the next procedure.

What Next?

l Go to additional subtabs in AMP Setup to continue additional setup configurations.

l Complete the required configurations in this chapter before proceeding. Aruba support remains available to
you for any phase of AirWave configuration.

Enabling AirWave to Manage Your Devices
Once AirWave is installed and active on the network, the next task is to define the basic settings that allow
AirWave to communicate with and manage your devices. Device-specific firmware files are often required or are
highly desirable. Furthermore, the use of Web Auth bundles is advantageous for deployment of Cisco WLC
wireless LAN controllers when they are present on the network.

This section contains the following procedures:

l "Configuring Communication Settings for Discovered Devices" on page 52

l "Uploading Firmware and Files" on page 54

Configuring Communication Settings for Discovered Devices
You can configure AirWave to communicate with your devices by defining default shared secrets and SNMP
settings.

To define the default credentials and SNMP settings:

1. On theDevice Setup > Communication page, enter the default credentials for each device model on your
network. AirWave assigns default credentials to all discovered devices.

The Edit button edits the default credentials for newly discovered devices. To modify the credentials for
existing devices, use theDevices > Manage page or theModify Devices link on theDevices > List page.

Community strings and shared secrets must have read-write access for AirWave to configure the devices.
Without read-write access, AirWave may be able to monitor the devices but cannot apply any configuration
changes.

2. Enter the SNMP timeout and retries settings. Table 24 lists the settings and default values.

Setting Default Description

SNMP Timeout
(3-60 sec)

3 Sets the time, in seconds, that AirWave waits for a response from a device
after sending an SNMP request.

Table 24: Device Setup > Communication > SNMP Settings Fields and Default Values
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Setting Default Description

SNMP Retries
(1-40)

3 Sets the number of times AirWave tries to poll a device when it does not
receive a response within the SNMP Timeout Period or the Group's Missed
SNMP Poll Threshold setting (1-100). If AirWave does not receive an SNMP
response from the device after the specified number of retries, AirWave
classifies that device as Down.
NOTE: Although the upper limit for this value is 40, some SNMP libraries still
have a hard limit of 20 retries. In these cases, any retry value that is set above
20 will still stop at 20.

Table 24: Device Setup > Communication > SNMP Settings Fields and Default Values (Continued)

3. Click Add and enter the following information :

l Username - User name of the SNMP v3 user as configured on the controller.

l Auth Protocol - MD5 or SHA. The default setting is SHA.

l Auth and Priv Protocol Passphrases - Authentication and privilege protocol passphrases for the user,
as configured on the controller.

l Priv Protocol - DES or AES. The default setting is DES.

TheSNMP Inform receiver will restart when users are changed or added to the controller.

4. Enter or adjust the default value for the Telnet/SSH timeout. Table 25 shows the setting and default value.

Setting Default Description

Telnet/SSH Timeout
(3-120 sec)

10 Sets the timeout period in seconds used when performing Telnet and SSH
commands.

Table 25: Device Setup > Communication > Telnet/SSH Settings Fields and Default Values

5. Locate the HTTP Discovery Settings section and adjust the default value. Table 26 shows the setting and
default value.

Setting Default Description

HTTP Timeout
(3-120 sec)

5 Sets the timeout period in seconds used when running an HTTP discovery scan.

Table 26: Device Setup > Communication > HTTP Discovery Settings Fields and Default Values

6. Locate the ICMP Settings section and adjust the default value as required. Table 27 shows the setting and
default value.
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Setting Default Description

Attempt to
ping devices
that were
unreachable
via SNMP

Yes l When Yes is selected, AirWave attempts to ping the AP device.
l Select No if performance is affected in negative fashion by this function. If a

large number of APs are unreachable by ICMP, likely to occur where there is
in excess of 100 APs, the timeouts start to impede network performance.

NOTE: If ICMP is disabled on the network, select No to avoid the performance
penalty caused by numerous ping requests.

Table 27: Device Setup > Communication > ICMP Settings Fields and Default Values

7. Locate the Symbol 4131 and Cisco Aironet IOS SNMP Initialization area. Select one of the options listed.
Table 28 describes the settings and default values

Setting Default Description

Do Not Modify
SNMP Settings

Yes When selected, specifies that AirWave will not modify any SNMP settings. If
SNMP is not already initialized on the Symbol, Nomadix, and Cisco IOS APs,
AirWave is not able to manage them.

Enable read-
write SNMP

No When selected, and when on networks where the Symbol, Nomadix, and Cisco
IOS APs do not have SNMP initialized, this setting enables SNMP so the
devices can be managed by AirWave.

Table 28: Device Setup > Communication > Symbol 4131 and Cisco Aironet IOS SNMP Initialization Fields
and Default Values

Uploading Firmware and Files
AirWave automates firmware distribution to the devices on your network. Once you have downloaded the
firmware from the vendor, you can upload the firmware to AirWave for distribution to devices from theUpload
Firmware & Files page. After you upload the firmware, AirWave lists them in the Firmware Files table on this
page.

Formore information about specifying firmware versions for devices in a group, see "Specifying the Minimum
FirmwareVersion for Device Groups" on page 119.

Table 29 below itemizes the contents, settings, and default values for theUpload Firmware & Files page.

Setting Default Description

Type Aruba Networks
Controller(any model)

Displays a drop-down list of the primary AP makes and models
that AirWave supports with automated firmware distribution.

Owner Role None Displays the user role that uploaded the firmware file. This is
the role that has access to the file when an upgrade is
attempted.

Description None Displays a user-configurable text description of the firmware
file.

Server Protocol None Displays the file transfer protocol by which the firmware file
was obtained from the server. This can be FTP, TFTP, HTTP,
HTTPS. or SCP.

Table 29: Device Setup > Upload Firmware & Files Fields and Default Values
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Setting Default Description

Use Group File
Server

None If enabled, displays the name of the file server supporting the
group.

Firmware
Filename

None Displays the name of the file that was uploaded to AirWave
and to be transferred to an AP when the file is used in an
upgrade.

Firmware MD5
Checksum

None Displays the MD5 checksum of the file after it was uploaded to
AirWave. The MD5 checksum is used to verify that the file was
uploaded to AirWave without issue. The checksum should
match the checksum of the file before it was uploaded.

Firmware File
Size

None Displays the size of the firmware file in bytes.

Firmware
Version

None Displays the firmware version number. This is a user-
configurable field.

HTML Filename None Supporting HTML, displays the name of the file that was
uploaded to AirWave and to be transferred to an AP when the
file is used in an upgrade.

HTML MD5
Checksum

None Supporting HTML, displays the MD5 checksum of the file after
it was uploaded to AirWave. The MD5 checksum is used to
verify that the file was uploaded to AirWave without issue. The
checksum should match the checksum of the file before it was
uploaded.

HTML File Size None Supporting HTML, displays the size of the file in bytes.

HTML Version None Supporting HTML, displays the version of HTML used for file
transfer.

Desired
Firmware File for
Specified Groups

None The firmware file is set as the desired firmware version on the
Groups > Firmware Files page of the specified groups. You
cannot delete a firmware file that is set as the desired
firmware version for a group.

Table 29: Device Setup > Upload Firmware & Files Fields and Default Values (Continued)

Loading Firmware Files onto AirWave

Perform the following steps to load a device firmware file onto AirWave:

1. Go to theDevice Setup > Upload Firmware & Files page.

2. Select Add by theNew Firmware File option. The Add Firmware File page appears. Figure 14 illustrates this
page.
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Figure 14: Device Setup > Upload Firmware and Files > Add Page

3. Select the Supported Firmware Versions and Features link to view supported firmware versions.

Unsupported and untested firmware may cause device mismatches and other problems. Please contact Aruba
support before installing non-certified firmware.

4. Enter the appropriate information and select Add. The file uploads to AirWave and once complete, this file
appears on theDevice Setup > Upload Firmware & Files page. This file also appears on additional pages
that display firmware files (such as theGroup > Firmware page and on individualDevices > Manage
pages).

5. You can also import a CSV list of groups and their external TFTP firmware servers. Table 30 itemizes the
settings of this page.

Setting Default Description

Type Aruba Networks
controller

Indicates the firmware file is used with the specified type.

With selection of some types, particularly Cisco
controllers, you can specify the boot software version.

Firmware Version None Provides a user-configurable field to specify the firmware
version number. This open appears if Use an external
firmware file server is enabled.

Description None Provides a user-configurable text description of the
firmware file.

Upload firmware
files (and use
built-in firmware)

Enabled Allows you to select a firmware from your local machine
and upload it via TFTP or FTP.

Use an external
firmware file
server

N/A You can also choose to assign the external TFTP server on
a per-group basis. If you select this option, you must enter
the IP address on the Groups > Firmware page.
Complete the Firmware File Server IP Address field.

Server Protocol TFTP Specify whether to use a built-in TFTP server or FTP, HTTP,
or HTTPS to upload a firmware file. TFTP is
recommended. If you select FTP, AirWave uses an
anonymous user for file upload.

Table 30: Supported Firmware Versions and Features Fields and Default Values
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Setting Default Description

Use Group File
Server

Disabled If you opt to use an external firmware file server, this
additional option appears. This setting instructs AirWave
to use the server that is associated with the group instead
of defining a server.

Firmware File
Server IP
Address

None Provides the IP address of the External TFTP Server (like
SolarWinds) used for the firmware upgrade. This option
displays when the user selects the Use an external
firmware file option.

Firmware
Filename

None Enter the name of the firmware file that needs to be
uploaded. Ensure that the firmware file is in the TFTP root
directory. If you are using a non-external server, you
select Choose File to find your local copy of the file.

HTML Filename None Browse to the HTML file that will accompany the firmware
upload. Note that this field is only available for certain
Firmware File Types (for example, Symbol 4121).

Patch Filename None If you selected Symbol WS5100 as the Firmware File Type,
and you are upgrading from version 3.0 to 3.1, then
browse to the path where the patch file is located.

Boot Software
Version

None If you specified a Cisco WLC device as the Firmware File
Type, then also enter the boot software version.

Table 30: Supported Firmware Versions and Features Fields and Default Values (Continued)

Additional fields may appear for multiple device types. AirWave prompts you for additional firmware
information as required. For example, Intel and Symbol distribute their firmware in two separate files: an image
fileand an HTML file. Both files must be uploaded to AirWave for the firmware to be distributed successfully
viaAirWave.

6. Select Add to import the firmware file.

Deleting FirmWare Files

To delete a firmware file that has already been uploaded to AirWave, return to theDevice Setup > Upload
Firmware & Files page, select the checkbox for the firmware file and select Delete.

Afirmware file may not be deleted if it is the desired version for a group. Use theGroup > Firmware page to
investigatethis potential setting and status.

Adding Web Auth Bundles

Web authentication bundles are configuration files that support Cisco WLC wireless LAN controllers. This
procedure requires that you have local or network access to a Web Auth configuration file for Cisco WLC devices.

To add or edit a Web Authentication Bundle:

1. Go to theDevice Setup > Upload Firmware & Files page.

2. Click Add by theNew Web Auth Bundle option. This page displays any existing web authentication bundles
that are currently configured in AirWave.

AirWave 8.2.9 | User Guide Configuring AirWave | 57
Anexo 03 A 05 ITENS 21 E 22 (0592763)         SEI 0008478-63.2018.6.02.8000 / pg. 9570



58 | Configuring AirWave AirWave 8.2.9 | User Guide

3. Select Add to create a new bundle (see Figure 15), or select the pencil icon next to an existing bundle to edit.
You may also delete a bundle by selecting that bundle with the checkbox, and selectingDelete.

Figure 15: Adding aWeb Auth Bundle

4. Enter a descriptive label in the description field. This is the label used to identify and track web authentication
bundles on the page.

5. Enter the path and file name of the web authentication bundle, or select Choose File to locate the file.

6. Select Add to complete the web authentication bundle creation, or Save if replacing a previous Web Auth
configuration file, or Cancel to abort the Web Auth integration.

For additional information about using web authentication bundles with Cisco WLC controllers, refer to the
Wireless LAN controller Web Authentication Configuration Example, Document ID: 69340 on Cisco’s Web site.

Adding a New Captive Portal Logo

If you want to use a company logo for a guest account that uses a captive portal for network authentication, you
upload the logo to AirWave and then set a group of devices to use the captive portal logo.

To upload a company logo image file:

1. Click Add at the bottom of the Upload Firmware & Files page next to New Captive Portal Logo.

Figure 16: Adding a Captive Portal Logo

2. Enter a logo description.

3. Click Choose File to select the image file, then click Open.

4. Click Add. AirWave displays the newly added image file in the Firmware Files table.

Adding a New DRT File

You can use the downloadable regulatory table (DRT) to update country domain options without upgrading the
ArubaOS software version on an AP.

To add a DRT file to AirWave:

1. Click Add at the bottom of the Upload Firmware & Files page next to New DRT File.
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Figure 17: Adding a DRT File

2. Enter a DRT file description.

3. Click Choose File to select the DRT file, then click Open.

4. Click Add. AirWave displays the newly added DRT file in the Firmware Files table.

Adding Certificates
You can manage your certificates by uploading them to the AirWave server. AirWave verifies basic certificate
information before accepting the certificate and pushing it to a device. After you upload a certificate to AirWave,
the certificate file becomes available on additional pages where you can select certificate files.

For example, Figure 18 shows a certificate named IAP CP Cert being added. You can later choose this certificate
for an IAP by navigating to theGroup > Basic page for the device group that contains IAPs.

To add a certificate:

1. Go to theDevice Setup > Certificates, then click Add.

Figure 18: Adding a Captive Portal Certificate

2. Enter a name for the certificate.

3. Click Choose File to find your local copy of the certificate.

4. Enter the passphrase, if any, and renter the passphrase.

5. Select the format that matches the certificate file.

6. Select the certificate type.
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7. Click Add.

Setting Up Device Types
On theAMP Setup > Device Type Setup page, you can define how the device types displayed for users on
your network is calculated from available data. The first matching property is used. These rules cannot be edited
or deleted, but only reordered or enabled.

You can change the priority order of rules by clicking on a row and dragging and dropping it into a new location,
as shown in Figure 19.

Select the checkbox under the Enabled column to turn on device setup rules.

Refer to "Monitoring Wired and Wireless Clients" on page 197 for more information on theDevice Type column
that appears in Clients list tables.

Figure 19: AMP Setup > Device Type Setup Page Illustration

Configuring Cisco WLSE and WLSE Rogue Scanning
The Cisco Wireless LAN Solution Engine (WLSE) includes rogue scanning functions that AirWave supports. This
section contains the following topics and procedures, and several of these sections have additional sub-
procedures:

l "Introduction to Cisco WLSE" on page 61

l "Initial WLSE Configuration" on page 61

l "Configuring IOS APs for WDS Participation" on page 63

l "Configuring ACS for WDS Authentication" on page 63

l "Configuring Cisco WLSE Rogue Scanning" on page 64

You must enter one or more CiscoWorks WLSE hosts to be polled for discovery of Cisco devices and rogue AP
information.
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Introduction to Cisco WLSE
Cisco WLSE functions as an integral part of the Cisco Structured Wireless-Aware Network (SWAN) architecture,
which includes IOS Access Points, a Wireless Domain Service, an Access Control Server, and a WLSE. In order for
AirWave to obtain Rogue AP information from the WLSE, all SWAN components must be properly configured.
Table 31 describes these components.

SWAN
Component

Requirements

WDS (Wireless Domain
Services)

l WDS Name
l Primary and backup IP address for WDS devices (IOS AP or WLSM)
l WDS Credentials APs within WDS Group
NOTE: WDS can be either a WLSM or an IOS AP. WLSM (WDS) can control up to 250
access points. AP (WDS) can control up to 30 access points.

WLSE (Wireless LAN
Solution Engine)

l IP Address
l Login

ACS (Access Control
Server)

l IP Address
l Login

APs l APs within WDS Group

Table 31: Cisco SWAN Architecture Components

Initial WLSE Configuration
Use the following general procedures to configure and deploy a WLSE device in AirWave:

l "Adding an ACS Server for WLSE" on page 61

l "Enabling Rogue Alerts for Cisco WLSE" on page 61

l "Configuring WLSE to Communicate with APs" on page 62

l "Discovering Devices" on page 62

l "Managing Devices" on page 62

l "Inventory Reporting" on page 62

l "Defining Access" on page 62

l "Grouping" on page 63

Adding an ACS Server for WLSE
1. Go to theDevices > Discover > AAA Server page.

2. Select New from the drop-down list.

3. Enter the server name, server port (default 2002), user name, password, and a secret.

4. Select Save.

Enabling Rogue Alerts for Cisco WLSE
1. Go to the Faults > Network Wide Settings > Rogue AP Detection page.

2. Select the Enable.

3. Select Apply.

Additional information about rogue device detection is available in "Configuring Cisco WLSE Rogue Scanning" on
page 64.
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Configuring WLSE to Communicate with APs
1. Go to theDevice Setup > Discover page.

2. Configure SNMP Information.

3. Configure HTTP Information.

4. Configure Telnet/SSH Credentials

5. Configure HTTP ports for IOS access points.

6. Configure WLCCP credentials.

7. Configure AAA information.

Discovering Devices
The following three methods can be used to discover access points within WLSE:

l Using Cisco Discovery Protocol (CDP)

l Importing from a file

l Importing from CiscoWorks

Perform these steps to discover access points.

1. Go to theDevice > Managed Devices > Discovery Wizard page.

2. Import devices from a file.

3. Import devices from Cisco Works.

4. Import using CDP.

Managing Devices
Prior to enabling radio resource management on IOS access points, the access points must be under WLSE
management.

AirWavebecomes the primary management/monitoring vehicle for IOS access points, but for AirWave to gather
Rogueinformation, the WLSE must be an NMS manager to the APs.

Use these pages to make such configurations:

1. Go to Device > Discover > Advanced Options.

2. Select the method to bring APs into management Auto, or specify via filter.

Inventory Reporting
When new devices are managed, the WLSE generates an inventory report detailing the new APs. AirWave
accesses the inventory report via the SOAP API to auto-discover access points. This is an optional step to enable
another form of AP discovery in addition to AirWave, CDP, SNMP scanning, and HTTP scanning discovery for
Cisco IOS access points. Perform these steps for inventory reporting.

1. Go to Devices > Inventory > Run Inventory.

2. Run Inventory executes immediately between WLSE polling cycles.

Defining Access
AirWave requires System Admin access to WLSE. Use these pages to make these configurations.

1. Go to Administration > User Admin.

2. ConfigureRole and User.
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Grouping
It’s much easier to generate reports or faults if APs are grouped in WLSE. Use these pages to make such
configurations.

1. Go to Devices > Group Management.
2. ConfigureRole and User.

Configuring IOS APs for WDS Participation
IOS APs (1100, 1200) can function in three roles within SWAN:

l Primary WDS

l Backup WDS

l WDS Member

AirWave monitors AP WDS role and displays this information on AP Monitoring page.

APsfunctioning as WDS Master or Primary WDS will no longer show up as Down is the radios are enabled.

WDS Participation
Perform these steps to configure WDS participation.

1. Log in to the AP.

2. Go to theWireless Services > AP page.

3. Select Enable participation in SWAN Infrastructure.
4. Select Specified Discovery, and enter the IP address of the Primary WDS device (AP or WLSM).

5. Enter the user name and password for the WLSE server.

Primary or Secondary WDS
Perform these steps to configure primary or secondary functions for WDS.

1. Go to theWireless Services > WDS > General Setup page.

2. If the AP is the Primary or Backup WDS, select Use the AP as Wireless Domain Services.

n Select Priority (set 200 for Primary, 100 for Secondary).

n Configure theWireless Network Manager (configure the IP address of WLSE).

3. If the AP is Member Only, leave all options unchecked.

4. Go to the Security > Server Manager page.

5. Enter the IP address and Shared Secret for the ACS server and select Apply.

6. Go to theWireless Services > WDS > Server Group page.

7. Enter theWDS Group of the AP.

8. Select theACS server in the Priority 1 drop-down menu and select Apply.

Configuring ACS for WDS Authentication
ACS authenticates all components of the WDS and must be configured first. Perform these steps to make this
configuration.

1. Login to the ACS.

2. Go to the System Configuration > ACS Certificate Setup page.
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3. Install a New Certificate by selecting the Install New Certificate button, or skip to the next step if the
certificate was previously installed.

4. Select User Setup in the left frame.

5. Enter the user name that will be used to authenticate into the WDS and select Add/Edit.
6. Enter the password that will be used to authenticate into the WDS and select Submit.
7. Go to theNetwork Configuration > Add AAA Client page.

8. Add the host name and IP address associated with the AP and the key.

9. Enter the password that will be used to authenticate into the WDS and select Submit.

For additional and more general information about ACS, refer to "Configuring ACS Servers" on page 65.

Configuring Cisco WLSE Rogue Scanning
TheAMP Setup > WLSE page allows AirWave to integrate with the Cisco Wireless LAN Solution Engine (WLSE).
AirWave can discover APs and gather rogue scanning data from the Cisco WLSE.

Perform the following steps for optional configuration of AirWave for support of Cisco WLSE rogue scanning.

1. To add a Cisco WLSE server to AirWave , navigate to theAMP Setup > WLSE page and select Add. Complete
the fields in this page. Table 32 describes the settings and default values.

Setting Default Description

Hostname/IP Address None Designates the IP address or DNS Hostname for the WLSE server,
which must already be configured on the Cisco WLSE server.

Protocol HTTP Specify whether to use HTTP or HTTPS when polling the WLSE.

Port 1741 Defines the port AirWave uses to communicate with the WLSE
server.

Username None Defines the user name AirWave uses to communicate with the WLSE
server. The user name and password must be configured the same
way on the WLSE server and on AirWave.

The user needs permission to display faults to discover rogues and
inventory API (XML API) to discover manageable APs. As derived
from a Cisco limitation, only credentials with alphanumeric
characters (that have only letters and numbers, not other symbols)
allow AirWave to pull the necessary XML APIs.

Password None Defines the password AirWave uses to communicate with the WLSE
server. The user name and password must be configured the same
way on the WLSE server and on AirWave.

As derived from a Cisco limitation, only credentials with
alphanumeric characters (that have only letters and numbers, not
other symbols) allow AirWave to pull the necessary XML APIs.

Poll for AP Discovery; Poll
for Rogue Discovery

Yes Sets the method by which AirWave uses WLSE to poll for discovery of
new APs and/or new rogue devices on the network.

Polling Period 10
minutes

Determines how frequently AirWave polls WLSE to gather rogue
scanning data.

Table 32: AMP Setup >WLSE Fields and Default Values
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2. After you have completed all fields, select Save. AirWave is now configured to gather rogue information from
WLSE rogue scans. As a result of this configuration, any rogues found by WLSE appear on theRAPIDS > List
page.

What Next?

l Go to additional tabs in theAMP Setup section to continue additional setup configurations.

l Complete the required configurations in this chapter before proceeding. Aruba support remains available to
you for any phase of AirWave installation.

Configuring ACS Servers
This is an optional configuration. TheAMP Setup > ACS page allows AirWave to poll one or more Cisco ACS
servers for wireless user name information. When you specify an ACS server, AirWave gathers information about
your wireless users. Refer to "Setting Up Device Types" on page 60 if you want to use your ACS server to manage
your AirWave users.

Perform these steps to configure ACS servers:

1. Go to theAMP Setup > ACS page. This page displays current ACS setup, as illustrated in Figure 20.

Figure 20: AMP Setup > ACS Page Illustration

2. Select Add to create a new ACS server, or select a pencil icon to edit an existing server. To delete an ACS server,
select that server and select Delete. When selectingAdd or Edit, theDetails page appears.

3. Complete the settings on AMP Setup > ACS > Add/Edit Details. Table 33 describes these fields:

Field Default Description

IP/Hostname None Sets the DNS name or the IP address of the ACS Server.

Protocol HTTP Launches a drop-down menu specifying the protocol AirWave uses when it polls
the ACS server.

Port 2002 Sets the port through which AirWave communicates with the ACS. AirWave
generally communicates over port 2002.

Username None Sets the user name of the account AirWave uses to poll the ACS server.

Password None Sets the password of the account AirWave uses to poll the ACS server.

Polling Period 10 min Launches a drop-down menu that specifies how frequently AirWave polls the
ACS server for user name information.

Table 33: AMP Setup > ACS > Add/Edit Details Fields and Default Values

4. Select Add to finish creating the new ACS server, or Save to finish editing an existing ACS server.
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5. The ACS server must have logging enabled for passed authentications. Enable the Log to CSV Passed
Authentications report option, as follows:

n Log in to the ACS server, select System Configuration, then in the Select frame, select Logging.

n Under Enable Logging, select CSV Passed Authentications. The default logging options include the
two columns AirWave requires: User-Name and Caller-ID.

What Next?

l Go to additional tabs in the AMP Setup section to continue additional setup configurations.

l Complete the required configurations in this chapter before proceeding. Aruba support remains available to
you for any phase of AirWave installation.

Integrating NMS Servers
You can integrate AirWave with Network Management System (NMS) servers. Doing so enables AirWave to
forward SNMP traps to the NMS.

Add an NMS Server
AirWave communicates with the NMS server using the SNMPv1, SNMPv2c, or SNMPv3 protocol over Port 162.

To integrate an NMS server with AirWave:

1. Go to AMP Setup > NMS, then click Add.

2. Enter the NMS server hostname or IP address.

3. Use the default port, or you can enter a new port number.

4. Select the SNMP version:

n SNMPv1 or SNMPv2c, then enter the community string and confirm the string.

n SNMPv3, then enter the advanced security options (authentication and privacy protocols and
passphrases).

5. Click Add.

Download the MIB Files
The necessary AMP MIB files are available to download from theAMP Setup > NMS page.

AirWaveprovides integration with HP ProCurve Manager (PCM). For help loading the integration files, navigate
toAMP Setup > NMS, then click the HP ProCurve Manager Integration link.

PCI Compliance Monitoring
AirWave provides compliance monitoring tools that can help your organization be prepared for a PCI Data
Security Standard (DSS) audit. With use of AirWave, your organization can monitor firewalls, network devices,
and other services to show PCI compliance. 

Check Compliance
The PCI compliance report displays which requirements AirWave monitors, provides links to device management
pages, and displays any actions required to resolve compliance failures. In addition to displaying pass or fail
status, AirWave provides diagnostic information and recommends actions required to achieve Pass status when
sufficient information is available.

You can find the PCI compliance report for a device by navigating to Devices > List, hovering the pointer over a
device, and clicking Compliance from the shortcut menu. If you created a PCI compliance report from the
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Reports Definition page, AirWave displays the report on theGenerated Reports page when it is available, as
shown in Figure 21. For information, see "Viewing Generated Reports" on page 353.

Figure 21: PCI Compliance Report Example

You can schedule, view, and re-run custom PCI compliance reports. For information about working with reports,
see "Creating, Running, and Sending Reports" on page 318.

Enabling PCI Compliance Monitoring
When you enable PCI compliance monitoring, AirWave displays real-time information and generates PCI
compliance reports that can be used to verify whether a merchant is compliant with a PCI requirement.

For information security standards, refer to the PCI Quick Reference Guide, accessible online from the PCI
Security Council Document Library or see "Supported PCI Requirements" on page 68.

To enable PCI auditing:

1. Navigate to theAMP Setup > PCI Compliance page.

2. Find the PCI requirement that you want to monitor.
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3. Click to open the Default Credential Compliance page. The compliance settings vary depending on the
PCI requirement.

4. Select Save.

5. To view and monitor PCI auditing on the network, use generated or daily reports. See "Creating, Running, and
Sending Reports" on page 318. In addition, you can view the real-time PCI auditing of any given device online.
Perform these steps:

a. Go to theDevices > List page.

b. Select a specific device. TheMonitor page for that device displays. TheDevices page also displays a
Compliance subtab in the menu bar.

c. Select Compliance to view complete PCI compliance auditing for that specific device.

Supported PCI Requirements
AirWave currently supports the PCI 3.0. requirements described in Table 34. When the requirements are
disabled, AirWave does not check for PCI compliance or report on status.

AirWaveusers without RAPIDS visibility will not see the 11.1 PCI requirements in the PCI compliance report.

Requirement Description

1.1 Establishes firewall and router configuration standards. A device fails if there are
mismatches between the desired configuration and the configuration on the device.

1.2.3 Monitors firewall installation between any wireless networks and the cardholder
data environment. A device fails if the firewall is not stateful.

2.1 Changes vendor-supplied default passwords before a device connects to the
cardholder data environment or transmits data in the network. A device fails if the
user name, passwords or SNMP credentials used by AirWave are on the list of
forbidden default credentials. The list includes common vendor default passwords.

2.1.1 Changes vendor-supplied defaults for wireless environments. A device fails if the
passwords, SSIDs, or other security-related settings are on a list of forbidden values
that AirWave establishes and tracks. The list includes common vendor default
passwords. The user can input new values to achieve compliance.

4.1.1 Uses strong encryption in wireless networks before sending payment cardholder
data across open public networks. A device fails if the desired or actual configuration
reflect that WEP is enabled on the network, or if associated users can connect with
WEP.

11.1 Uses RAPIDS to identify unauthorized devices. A device fails when a rogue device is
detected and unacknowledged, or when there are no rogues discovered in the last
three months.

11.4 Uses intrusion-detection or intrusion-prevention systems to monitor traffic. Recent
IDS events are summarized in the PCI compliance report or the IDS report.

Table 34: PCI Requirements
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Deploying WMS Offload
The Wireless LAN Management Server (WMS) feature is an enterprise-level hardware device and server
architecture with managing software for security and network policy.

WMS components include:

l Air monitor. This operating mode provides wireless IDS, rogue detection and containment.

l WMS server. This server manages devices and network activity, such as rogue detection and network policy
enforcement.

l AirWave WebUI. This graphical user interface (GUI) provides access to the WMS offload feature.

Refer to the Aruba and AirWave 8.2.4 Best Practices Guide for additional information, including detailed concepts,
configuration procedures, restrictions, ArubaOS infrastructure, and AirWave version differences in support of
WMS Offload.

WMS Offload Configuration
WMS offload places the burden of the WMS server data and GUI functions on AirWave. WMS master controllers
provide this data so that AirWave can support rigorous network monitoring capabilities.

WMS Offload is supported with ArubaOS Version 2.5.4 or later and AirWave Version 6.0 or later

Follow these steps to configure WMS offload:

1. Configure WLAN switches for optimal AirWave monitoring:

a. Disable debugging.

b. Ensure the AirWave server is a trap receiver host.

c. Ensure proper traps are enabled.

2. Configure AirWave to optimally monitor the AirWave infrastructure:

a. Enable WMS offload on theAMP Setup > General page.

b. Configure SNMP communication.

c. Create a proper policy for monitoring the AirWave infrastructure.

d. Discover the infrastructure.

3. Configure device classification:

a. Set up rogue classification.

b. Set up rogue classification override.

c. Establish user classification override devices.

4. Deploy ArubaOS-specific monitoring features:

a. Enable remote AP and wired network monitoring.

b. View controller license information.

5. Convert existing floor plans to VisualRF to include the following elements:

l ArubaOS

l RF Plan

6. Use RTLS for increasing location accuracy (optional):

a. Enable RTLS service on the AirWave server.

b. Enable RTLS on ArubaOS infrastructure.
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Integrating External Servers
AirWave supports integration with Juniper, Brocade or HPE Intelligent Management Center (IMC) servers. When a
device is monitored by AirWave and an external server, theDevices > Monitor page for that device provides a
link to that external server.

Add a Juniper Network Director
AirWave supports integration with Juniper Network Director (ND) 2.0. Once integrated, theDevices > Monitor
page for that device provides access to a link the Juniper Network Director WebUI.

To integrate Juniper Network Director with AirWave:

1. Log in to AirWave, then navigate to AMP Setup > External server.
2. In the Juniper Network Director section, enter the IP address or hostname of the Juniper Network

Director.

3. Click Save.

Add a Brocade Network Advisor
AirWave can monitor and secure Brocade wired networks, while Brocade Network Advisor monitors Aruba
networks. Once integrated, the Brocade Network Advisor appears in theDevices list on the AirWaveDevices >
List page, and theDevices > Monitor page for that device provides access to the Brocade Network Advisor
home page.

To integrate Brocade Network Advisor with AirWave:

1. Log in to AirWave, then navigate to AMP Setup > External server.
2. In theBrocade Network Advisor section, enter the IP address or hostname of the Brocade Network

Advisor.

3. Click Save.

Add an HPE Intelligent Management Center
When a managed device is monitored by both AirWave and the HPE Intelligent Management Center (IMC)
Enterprise Software Platform, theDevices > Monitor page for that device includes a link to the IMC server.

Figure 22: IMC Link on the Devices > Monitor page

To integrate an IMC server with AirWave:

1. Log in to AirWave, then navigate to AMP Setup > External server.
2. In the Intelligent Management Center section, enter the IP address or hostname of the IMC server.

3. (Optional) Click the IMC Protocol drop down list and select theHTTPS orHTTP protocol. The default setting
isHTTPS.

4. (Optional) Enter a port number in the IMC Port field. The default port number is 8443.

5. Enter the user name for accessing the IMC server, then confirm this password.
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6. Click Save.
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Chapter 3

Using Device Groups

AirWave automates the processes of device configuration and compliance auditing using device groups. AGroup
can include one device to hundreds of devices that share common configuration settings, and you can define
groups based on geography, usage or security policies, function, or another variable. Variables include basic
settings, security settings, and radio settings.

Navigation Basics
When you select a device group from the Groups List page, the navigation sidebar varies, depending on the
default group and type of devices that you added to AirWave. After you create additional device groups, you can
change the default group by navigating to AMP Setup > General and selecting a group from the Default Group
drop-down menu.

Figure 23 shows a navigation sidebar menu that is available when you select a group that contains Cisco WLCs.

Figure 23: Navigation Sidebar

The following WebUI pages support group monitoring and configuration:

l List. This page lists all groups configured in AirWave and provides the foundation for all group-level
configurations. For more information, see "Viewing Device Groups" on page 73

l Monitor. This page displays client and bandwidth usage information, lists devices in a given group, provides
an Alert Summary table for monitoring alerts for the group, and provides a detailed Audit Log for group-
level activity. The default view of theGroups > Monitor page is predefined and cannot be modified.
However, you can create a new view, or edit and copy a view, and save the view to access information you
frequently use. For more information on filtering data from your view, see "Creating Filtered Views" on page
143.

l Basic. This page becomes available when you create a new group on theGroups > List page. For more
information, see "Configuring Basic Settings for Device Groups" on page 84.

l Templates. This page manages templates for any device group. You can use templates to manage the
configuration of third-party devices in a group using a configuration file. Variables configure device-specific
and group-level properties. For more information, see "Using Configuration Templates" on page 226.
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l Security. This page defines general security settings for device groups, to include RADIUS, encryption, and
additional security settings on devices. For more information, see "Configuring Security for Device Groups"
on page 96

l SSID. This page sets SSIDs, VLANs, and related parameters in device groups. Use this submenu is available
when you configure RADIUS servers on theGroups > AAA Servers page. For more information, see
"Configuring SSIDs and VLANs for Device Groups" on page 101.

l AAA Servers. This page configures authentication, authorization, and accounting settings in support of
RADIUS servers for device groups. For more information, see "Configuring AAA Servers for Device Groups" on
page 95.

l Radio. This page defines general 802.11 radio settings for device groups. "Configuring Group Radio Settings"
on page 105

l Controller Config. This page manages ArubaOS Device Groups, AP Overrides, and other profiles specific to
Aruba devices on the network. Use this page as an alternative to theDevice Setup > Aruba
> Configuration page. The appearance of this page varies depending on whether AirWave is configured for
global configuration or group configuration. For more information, see the Aruba Controller Configuration
Guide.

l Switch Config. This page manages ArubaOS Device Groups, AP Overrides, and other profiles specific to Aruba
switches on the network. For more information, see the Aruba Switch Configuration Guide.

l Instant Config. This page manages Aruba Instant devices on the network. For more information, see the
Aruba Instant in AirWave 8.2.8.2 Deployment Guide.

l Cisco WLC Config. This page becomes available when you select a device group that contains Cisco WLC
devices and consolidates controller-level settings from several pages (Group Radio, Security, SSIDs, Cisco WLC
Radio and AAA Server). For more information, see "Configuring Cisco WLC Device Groups" on page 109

l PTMP. This page defines settings specific to Proxim MP devices when present and is only available when a
Proxim MP device is added to this group. For more information, see "Configuring PTMP Settings for Device
Groups" on page 115.

l Proxim Mesh. This page defines mesh AP settings specific to Proxim devices when present. For more
information, see"Configuring Proxim Mesh Radio Settings" on page 116.

l MAC ACL. This page defines MAC-specific settings that apply to Proxim, Symbol, and ProCurve 520 devices
when present. For more information, see "Configuring Group MAC ACLs for Device Groups" on page 118.

l Firmware. This page enables you to manage firmware files for many device types in one location. For more
information, see "Specifying the Minimum Firmware Version for Device Groups" on page 119.

l Compare. This page allows you to compare line item-settings between two device groups. On theGroups >
List page, select theCompare two groups link, select the two groups from the drop-down menus, and then
select Compare. For more information, see "Comparing Device Groups" on page 75.

Viewing Device Groups
You can view device groups by navigating to Groups > List . When you configure AirWave for the first time,
Access Points is the only group in the list.

From the Groups List page, you can:

l Create a group by clicking Add at the top of the page. Alternatively, you could create a group by selecting

group from the list and clicking to clone the group. The copied group will be added to the group list with
"copy of" appended in front of the group name.

l Compare two groups. For more information, see "Comparing Device Groups" on page 75.

l Click or hover your mouse over the icon for quick access to other Groups pages. For information about
the Groups pages, see "Navigation Basics" on page 72.
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For example, you can select Basic from the shortcut menu to change group configurations. Refer to
"Configuring Basic Settings for Device Groups" on page 84 .

l Add groups to a global group. For more information, see "Subscribing other Groups to a Global Group" on
page 79.

l Delete a group. For more information, see "Deleting a Group" on page 80.

Table 35 describes the device group details available on theGroups > List page.

Field Description

Name Uniquely identifies the group by location, vendor, department or any other identifier (such
as ‘Accounting APs,’ ‘Floor 1 APs,’ ‘Cisco devices,’ ‘802.1X APs,’ and so forth).

SSID The SSID assigned to supported device types within the group.

Total Devices Total number of devices contained in the group including APs, controllers, routers, or
switches.

Changes This field is available when a group has unapplied changes.

Is Global Group This field is available if a group is designated as global. A global group may not contain APs,
but it may be used as a template for other groups.
NOTE: This column might indicate Yes if this group has been pushed to AirWave from a
Master Console.

Global Group Specifies which group this Subscriber Group is using as its template.

Down The number of access points within the group that are not reachable via SNMP or are no
longer associated to a controller. Note that thin APs are not directly polled with SNMP, but
are polled through the controller. That controller may report that the thin AP is down or is no
longer on the controller. At this point, AirWave classifies the device as down.

Mismatched The number of devices within the group that are in a mismatched state.

Ignored The number of ignored devices in that group.

Clients The number of mobile users associated with all access points within the group. To avoid
double counting of clients, clients are only listed in the group of the AP with which they are
associated. Note that device groups with only controllers in them report no clients.

Usage A running average of the sum of bytes in and bytes out for the managed radio page.

VPN Sessions Number of active (connected) VPN sessions under this group.

Up/Down
Status Polling
Period

The time between Up/Down SNMP polling periods for each device in the group. Detailed
SNMP polling period information is available on the Groups > Basic configuration page. By
default, most polling intervals do not match the up/down period.

Duplicate Creates a new group with the name Copy of <Group Name> with identical configuration
settings. (Aruba configuration settings will have to be manually added back.)

Table 35: Groups > List Fields and Descriptions
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Comparing Device Groups
You can compare two existing device groups with a detailed line-item comparison. Group comparison allows
several levels of analysis including the following:

l Compare performance, bandwidth consumption, or troubleshooting metrics between two groups.

l Debug one device group against the settings of a similar and better performing device group.

l Use one group as a model by which to fine-tune configurations for additional device groups.

This topic presumes that at least two device groups are at least partly configured in AirWave, each with saved
configurations. Perform the following steps to compare two existing device groups:

1. From theGroups > List page, select theCompare two groups link. Two drop-down menus appear.

2. Select the two groups to compare in the drop-down menus, and select Compare. TheCompare page
appears, displaying some or many configuration categories. Figure 24 illustrates this page.

Figure 24: Comparing TwoDevices Groups on theGroups > List > Compare Page (Partial View)

3. Note the following factors when using theCompare page:

l TheCompare page can be very long or very abbreviated, depending on how many configurations the
device groups share or do not share.

l When a configuration differs between two groups, the setting is flagged in red text for the group on the
right.
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l The default setting of theCompare page is to highlight settings that differ between two groups.

n To display settings that are similar or identical between two device groups, select Show Similar Fields
at the top left of the page. The result may be a high volume of information.

n Select Hide Similar Fields to return to the default display, emphasizing configuration settings that
differ between two groups.

l You can change the configuration for either or both groups by selecting Edit in the corresponding column
heading. The appropriate configuration page appears.

l If you make and save changes to either or both groups, go back to theGroups > List page and select
Compare two groups. Select the same two groups again for updated information.

l Additional topics in this document describe the many fields that can appear on theGroups > List >
Compare page.

Changing Group Configurations
Perform the following steps to make any changes to an existing group's configuration:

1. Browse to theGroups > List configuration page.

2. Select theModify button (the wrench icon) for the group you wish to edit. TheGroups > Basic
configuration page appears.

3. Select the fields to be edited on theBasic configuration page. Other group configuration pages may be
available, depending upon the type of devices included in that group. or go to Radio, Security, VLANs, or
MAC ACL configuration page and edit the fields. Use the Save button to store the changes prior to applying
them.

4. When all changes for the group are complete select the Save and Apply button to make the changes
permanent. Figure 25 illustrates the confirmation message that appears.
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Figure 25: Groups > Basic Configuration Change Confirmation Page Illustration

5. AirWave displays a Configuration Change screen confirming the changes that will be applied to the group's
settings.

6. There are several action possibilities from within this confirmation configuration page.

l Apply Changes Now— Applies the changes immediately to access points within the group. If you wish to
edit multiple groups, you must use the Preview button.

You cannot apply Aruba Networks Config changes to other groups. If the only changes on the configuration
pageare to Aruba devices, the list of groups and the preview button will not appear.

l Scheduling Options — Schedules the changes to be applied to this group in the future. Enter the desired
change date in the Start Date/Time field. You can also specify if this is a one-time schedule or a recurring
schedule. Recurring options areDaily,Weekly,Monthly, and Annually. AirWave takes the time zone
into account for the group if a time zone other than AirWave System Time has been configured on the
Groups > Basic configuration page.

l Cancel — Cancels the application of changes (immediately or scheduled).

To completely nullify the change request, select Revert on one of the group configuration pages after you
haveselected Cancel.

7. Apply changes to multiple groups by selecting the appropriate group or groups and selecting Preview.
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Using Global Groups for Group Configuration
The AirWave group configuration feature allows you to push configurations defined on a global group to the
managed groups subscribed to that global group.

About Global Group Membership
To have Global Group status, a group must contain no devices; accordingly, access points can never be added to
a Global Group. Global groups are visible to users of all roles, so they may not contain devices, which can be
made visible only to certain roles. illustrates theGroups > List page.

Creating a Global Group
The Use Global Group option becomes available when you have at least two groups configured in AirWave. You
can configure AirWave to push a group configuration to a group when you enable this option.

To configure a global group:

1. Navigate to Groups > List.
2. Select a the group from the list.

3. Navigate to Groups > Basic. TheGlobal Groups section of this page contains theUse Global Group
option.

4. Select Yes for theUse Global Group option.

Figure 26: Selecting the UseGlobal GroupOption

5. To associate the group with a global group, select the group from the Global Group drop-down menu.

6. Click Save and Apply.

7. Click Apply Changes Now.

When the Groups list is updated with the global group, you will see Yes in the "Is Global Group" column, and
when you go to the Basic page for the global group, there will be checkboxes next to the basic settings. Figure 27
shows an example for a global group called "test".
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Figure 27: Basic Settings for the Global Group

When AirWave pushes a global group configuration to subscriber groups, all settings are static except for those
with the checkbox selected; you can change the value or setting of the checked field on the corresponding tab
for each managed group. In the case of theGroups > SSIDs configuration page, override options are available
only on theAdd configuration page (go to theGroups > SSIDs configuration page and select Add).

Global templates are also configurable as part of global groups; for more information, see "Using Configuration
Templates" on page 226.

Subscribing other Groups to a Global Group
Once one or more global groups have been configured, other groups may subscribe to a particular Global Group.
To subscribe a (non-global) group to a Global Group:

1. Navigate to Groups > List.
2. Select a the group from theGroups table.

3. Navigate to Groups > Basic.

4. In theGlobal Groups section of this page, click theGlobal Group drop-down list and select a global group.

5. Select Save and Apply to make the changes permanent.

Figure 28: Subscribe to a Global Group

Once the configuration is pushed, the unchecked fields from the Global Group appears on the Subscriber Group
as static values and settings. Only fields that had the override checkbox selected in the Global Group appear as
fields that can be set at the level of the Subscriber Group. Any changes to a static field must be made on the
Global Group.

If you want to change a global group into a regular group and it has subscribers, you need to remove the
subscribers first before you can change the "Is Global Group" option to No on theGroups > Basic page.
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Deleting a Group
Perform the following steps to delete an existing Group from the AirWave database:

1. Browse to theGroups > List configuration page.

2. Ensure that the group you wish to delete is not marked as thedefault group. (See theAMP Setup >
General page.) AirWave does not permit you to delete the current default group.

3. Ensure that there are no devices in the group that you want to delete. AirWave does not permit you to delete
a group that still contains managed devices. You must move all devices to other groups before deleting a
group.

4. Ensure that the group is not a global group that has subscriber groups, and is not a group that was pushed
from a Master Console. AirWave will not delete a group in which either of those cases is true.

5. Select the checkbox, and click theDelete button.

Monitoring Device Groups
You can find the monitoring page by navigating to Groups > Monitor page and selecting a device group from
the list.

Figure 29 shows the main components of the monitoring page for the default device group called Access Points.

Figure 29: GroupMonitoring Page

Here are some of the things you can view on or from theGroups > Monitor page:

l Group statistics. The total number of devices contained in the group includes APs, controllers, routers, or
switches. From the summary counts at the top of the page, you can click links to monitoring pages for devices
and connected clients.

l Graphs. The client and usage graphs show the attached clients and average bandwidth or VPN session usage
for the devices in the group. You can change the sample interval, or show the maximum or average statistics
by clicking the menu options in the graph header.

l Group table. The default view of the devices group includes these columns:
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n Device. This information shows the device MAC address and provides a quick link to the monitoring page
for the device. Hover over the blue link to access shortcuts to other pages, such as Manage, Config,
Monitor, and Compliance.

n Status. This information shows whether devices are up or down in the group.

n Configuration. This information shows whether the device configuration is good, or there is an error or
mismatch. Click the blue link to access the Device Configuration page and review the device configuration.

n Controller. This information shows the name of the controller and provides a quick link to the monitoring
page for the controller.

n Version. This information shows the firmware version running on the controller.

n Folder. This information shows the name of the folder the device belongs to and provides a quick link to
the list of devices for the folder.

n Clients. This information shows the number of clients per device.

n APs. This information shows the number of APs per device, if applicable.

n Usage. This information shows the total speed of all clients at that moment.

n IP Address. This information shows the IP address of the device.

n Type. This information shows the device model.

n Master Controller. If the controller role is master, AirWave displays the device type and provides a quick
link to the monitoring page for the device.

n Switch Role. For switches that support VSF stacking, this information shows whether the switch functions
as commander, standby, member, or has been provisioned to be a member of the stack.

l Alerts. From the alert summary table at the bottom of the page, you can click links to summary pages
forAMP, Intrusion Detection System (IDS), RADIUS accounting, and RADIUS authentication alerts received on
the devices in the group. You can also access the audit log and system event log from this table.

Modifying Multiple Devices
AirWave provides a Modify Devices tool that enables you to make bulk changes to devices, including controllers
that have thin APS. Some of the device actions you can make include deleting multiple devices, migrating devices
to another group or folder, updating credentials, and optimizing channels.

To modify multiple devices:

1. Navigate to one of the following pages that has a Device List:

n Devices > List. You can also click the Up, Down, Mismatched hyperlinks on the List page to open
monitoring pages for the devices with those devices states.

n Groups > Monitor.

2. Click at the top right corner of the device list, then select the devices you want to modify.
3. Select as many changes as you want from the Device Actions drop-down menu.
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Figure 30: Selecting the Device Actions

4. Click Apply All.

Table 36 describes the changes you can apply to multiple devices at the same time.

Action Description

System Actions

Change Device
Group/Folder

Move the selected devices to a new group or folder. If the device is in managed
mode when it is moved to a new group, it will be reconfigured. When you select
this option, you must also click the Group and/or Folder drop down menu and
select the destination group or folder for the devices. Click Move and then select
Apply All to save your changes.

Poll selected devices Click Poll Now to poll selected devices for current user count and bandwidth data.
This action overrides default poll settings for the group. Polling numerous devices
may create a temporary performance load on your AirWave server.

Audit selected devices Fetches the current configuration from the device and compares it to the desired
AirWave configuration. The audit action updates the Configuration Status.
NOTE: If a group has audit disabled for its devices, AirWave does not show the
Audit button in the Modify devices list.

Table 36: Modify Multiple Devices Section Fields and Default Values
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Action Description

Delete selected devices Click Delete to remove the selected devices from AirWave. A new window opens
and asks you to confirm your changes. Select Apply Changes Now. The deletions
will be performed in the background and it may take a minute to remove the
selected devices from the list.

Run report on selected
devices

Takes you to the Reports > Definitions page where you can define or run a
custom report for selected devices. For more details and a procedure, see
"Creating Custom Reports" on page 351.

Update the credentials
used to communicate
with these devices

Update changes the credentials AirWave uses to communicate with the device. It
does not change the credentials on the AP.

Import settings from
selected devices (and
discard current pre-
device desired settings)

Audit updates a number of the AP-specific settings that AirWave initially read off
of the AP including channel, power, antenna settings and SSL certifications.
AirWave recommends using this setting if APs have been updated outside of
AirWave. Most settings on the Devices > Manage configuration page are set to
the values currently read off of the devices.

Management Level When you select this action, you must select either Monitor Only + Firmware
Upgrade or Manage Read/Write to choose new the management level for the
devices.

Replace Hardware Select the down device that will be replaced and view the list of AirWave devices
that match the name or IP address of the selected device. The down devices can
be replaced with any device in the New Devices list or in the current folder or
group.

Planned Downtime Mode When you select this action, you must select either Enable or Disable to change
the downtime mode for the selected devices. When this option is enabled, the
selected devices are put into Planned Maintenance mode. When this mode is
enabled, no AP Down triggers will be deployed on these devices. Users will not be
able to delete folders that contain devices in Planned Maintenance. The devices in
Planned Maintenance will show the Up status, but will not be tracked in historical
graphs and logs as Up.

Add Maintenance
Window

Automate the manual action of putting the selected devices into Manage mode at
once so that changes can be applied, and after the maintenance period is over,
the devices automatically revert to Monitor-Only mode.

Maintenance windows can be set as a one-time or recurring event.

Delete all Maintenance
Windows

Deletes all maintenance windows set for these devices.

Device Actions (Aruba)

Aruba AP Group When you select this option then click Update Aruba AP Group, a new window
opens that allows you to assign the devices to a new AP group.

Aruba Instant Virtual
Controller Variables

Opens the Variable Editor page for selected Aruba Instant APs.

Table 36: Modify Multiple Devices Section Fields and Default Values (Continued)
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Action Description

Import unreferenced
Aruba profiles from
selected devices

Select the devices that include unreferenced profiles, then click this button to
import those profiles from the selected devices.

Reprovision selected
Aruba devices

Configures the controller to send provisioning parameters such as radio, antenna,
and IP address settings to the selected APs. Please note that APs will be rebooted
as part of reprovisioning.

Device Actions

Rename devices Rename all the selected devices in bulk. Note that you can also rename the
devices one at a time using the editable Name fields in each row.

Upgrade firmware for
selected devices

Upgrades firmware for the selected devices. Refer to the firmware upgrade help
under Devices > Manage configuration page for detailed help on Firmware job
options.

Cancel firmware
upgrade for selected
devices

Cancels any firmware upgrades that are scheduled or in progress for the selected
APs.

Reboot selected devices Reboots the selected devices. Use caution when rebooting devices because this
can disrupt wireless users.

Factory reset Resets the selected devices back to factory-default settings.

Desired Radio Status Enables or disables the radios on the selected device. This parameter does not
apply to Cisco IOS APs.

Cisco Thin AP Settings Bulk configuration for per-thin AP settings, previously configured on the Group
LWAPP AP tab, can be performed from Modify Devices on the Devices > List
page. Make changes to LWAPP AP groups, including the option that was under
Modify Devices.

Table 36: Modify Multiple Devices Section Fields and Default Values (Continued)

Configuring Basic Settings for Device Groups
The first default device group set up in AirWave is theAccess Points group, but you can configure additional
device groups. After you define the basic group settings, you can save the changes without pushing these
settings to the devices in the group. You might want to do this in order to push configuration changes at a later
time.

To access the Basic Group Settings page:

l Add a device group from theGroups > List page. TheGroups > Basic page displays and becomes available
from the navigation sidebar.

l Navigate to Groups > List, locate the group and click .
l Navigate to Groups > List, locate the group and select Basic from the shortcut menu. The shortcut menu

varies depending on the group's settings.

Basic Settings
To set up the device group, you need to configure the basic settings described in Table 37.
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Figure 31: Basic Settings

Setting Default Description

Name Defined
when first
adding the
group

Displays or changes the group name. Enter a name that helps to identify the
group. For example, Accounting APs, Cisco devices, and Aruba controllers).

Missed SNMP
Poll Threshold
(1-100)

1 Sets the number of Up/Down SNMP polls that must be missed before
AirWave considers a device to be down.
NOTE: Set the number of SNMP retries and the SNMP timeout of a poll on the
Device Setup > Communication page.

Regulatory
Domain

US-United
States

Sets the regulatory domain in AirWave, limiting the selectable channels for
APs in the group.

Timezone AMP system
time

Allows group configuration changes to be scheduled relative to the time zone
in which the devices are located.

Allow One-to-
One NAT

No Allows AirWave to talk to the devices on a different IP address than the one
configured on the device.
NOTE: If enabled, the LAN IP Address listed on the Devices > Manage
configuration page under the Settings area is different than the IP Address
under the Device Communication area.

Audit
Configuration
on Devices

Yes Auditing and pushing of configuration to devices can be disabled on all the
devices in the group.
NOTE: Once disabled, all the devices in the groups will not be counted
towards mismatched devices.

Table 37: Basic Settings, Default Values, and Descriptions

Global Groups
The global groups option becomes available on the Groups Basic page when you create a new group for the first
time and it is a global group.

Table 38 describes the global group options you can define in order to push configurations to group members.
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Setting Default Description

Is Global Group No If set to Yes, then this group can be selected in the Use Global Group
drop down menu for future group configurations. For more
information, refer to"Using Global Groups for Group Configuration"
on page 78 .

Use Global Group No Click this drop-down list to select a global group to which this (non-
global) group should be associated. For more information, refer to
"Subscribing other Groups to a Global Group" on page 79 .
NOTE: This field becomes available when there are more than one
groups configured in AirWave.

Table 38: Global Groups Fields and Default Values

SNMP Polling Periods
You can override the override default SNMP polling settings with the SNMP polling period options described in
Table 39.

Setting Default Description

Up/Down Status Polling
Period

5 minutes Sets time between Up/Down SNMP polling for each device in the
group.

The Group SNMP Polling Interval overrides the global parameter
configured on the Device Setup > Communication page. An initial
polling interval of 5 minutes is best for most networks.

Override Polling Period
for Other Services

No Enables or disables overriding the base SNMP Polling Period. If you
select Yes, the other settings in the SNMP Polling Periods section are
activated, and you can override default values.

AP Interface Polling
Period

10
minutes

Sets the interval at which AirWave polls for radio monitoring and
bandwidth being used by a device.

Client Data Polling Period 10
minutes

Sets time between SNMP polls for client data for devices in the
group.

Thin AP Discovery Polling
Period

15
minutes

Sets time between SNMP polls for Thin AP Device Discovery.
Controllers are the only devices affected by this polling interval.

Device-to-Device link
Polling Period

5 minutes Sets time between SNMP polls for Device-to-Device link polling.
Mesh APs are the only devices affected by this polling interval.

802.11 Counters Polling
Period

15
minutes

Sets time between SNMP polls for 802.11 Counter information.

Rogue AP and Device
Location Data Polling
Period

30
minutes

Sets time between SNMP polls for Rogue AP and Device Location
Data polling.

CDP Neighbor Data
Polling Period

30
minutes

Sets the frequency in which this group polls the network for Cisco
Discovery Protocol (CDP) neighbors.

Table 39: SNMP Polling Periods Fields and Default Values
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Setting Default Description

Mesh Discovery Polling
Period

15
minutes

Sets time between SNMP polls for Mesh Device Discovery.

Table 39: SNMP Polling Periods Fields and Default Values (Continued)

Routers and Switches
You can configure how often AirWave polls devices in the group with the routers and switches options described
in Table 40. You can also disable these options.

Setting Default Description

Read ARP Table 4 hours Sets the frequency in which devices poll routers and switches for
Address Resolution Protocol (ARP) table information. This setting can
be disabled, or set to poll for ARP information in a range from every
15 seconds to 12 hours.

Read CDP Table for
Device Discovery

4 hours For Cisco devices, sets the frequency in which devices poll routers
and switches for Cisco Discovery Protocol (CDP) information. This
setting can be disabled, or set to poll for CDP neighbor information
in a range from every 15 seconds to 12 hours.

Read Bridge Forwarding
Table

4 hours Sets the frequency in which devices poll the network for bridge
forwarding information. This setting can be disabled, or set to poll
bridge forwarding tables from switches in a range from every 15
seconds to 12 hours.

Interface Up/Down
Polling Period

5 minutes Sets the frequency in which network interfaces are polled for
up/down status. This setting can be disabled, or set to poll from
switches in a range from every 15 seconds to 30 minutes.

Interface Bandwidth
Polling Period

15
minutes

Sets the frequency in which network interfaces are polled for
bandwidth usage. This setting can be disabled, or set to poll from
switches in a range from every 5 minutes to 30 minutes.

Interface Error Counter
Polling Period

30
minutes

Sets the frequency in which network interfaces are polled for
up/down status. This setting can be disabled, or set to poll bridge
forwarding tables from switches in a range from every 5 minutes to
30 minutes.

Poll 802.3 error counters No Sets whether 802.3 error counters should be polled.

Poll Cisco interface error
counters

No Sets whether the interface error counters for Cisco devices should
be polled.

Table 40: Routers and Switches Fields and Default Values

Notes
Use this optional section to record additional information and comments about the group.

Group Display Options
You can configure the group display options as described in Table 41.
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Setting Default Description

Show device
settings for

Only
devices
on this
AMP

Drop-down menu determines which Group tabs and options are to be viewable
by default in new groups. Settings include the following:
l All Devices—AirWave displays all Group tabs and setting options.
l Only devices in this group—AirWave hides all options and tabs that do not

apply to the devices in the group. If you use this setting, then to get the group
list to display the correct SSIDs for the group, you must Save and Apply on
the group.

l Only devices on this AMP— hides all options and tabs that do not apply to
the APs and devices currently on AirWave.

l Use system defaults—Use the default settings on AMP Setup > General
l Selected device types—Allows you to specify the device types for which

AirWave displays Group settings.

Selected
Device Types

N/A This option appears if you chose to display selected device types, allowing you to
select the device types to display group settings. Use Select devices in this
group to display only devices in the group being configured.

Table 41: Group Display Options Fields and Default Values

Automatic Static IP Assignment
Use theAutomatic Static IP Assignment section on theGroups > Basic configuration page to automatically
assign a range of static IP addresses to new devices as they are added into the group.

These options are relevant for a small number of device types and will appear when they are present.

Table 42 describes the automatic static IP address options.

Setting Default Description

Assign Static
IP Addresses
to Devices

No Specify whether to enable AirWave to statically assign IP addresses from a
specified range to all devices in the Group.
NOTE: If this value is set to Yes, then the additional configuration fields
described in this table will become available.

Start IP
Address

none Sets the first address AirWave assigns to the devices in the Group.

Number of
Addresses

none Sets the number of addresses in the pool from which AirWave can assign IP
addresses.

Subnet Mask none Sets the subnet mask to be assigned to the devices in the Group.

Subnet
Gateway

none Sets the gateway to be assigned to the devices in the Group.

Next IP
Address

none Defines the next IP address queued for assignment. This field is disabled for the
initial Access Points group.

Table 42: Automatic Static IP Assignment Fields and Default Values

Spanning Tree Protocol
Use the Spanning Tree Protocol settings on theGroups > Basic page to configure the Spanning Tree Protocol
on Wireless LAN Controller (WLC) devices and Proxim APs.

Table 43 describes the settings and default values in this section.
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Setting Default Description

Spanning Tree
Protocol

No Specify whether to enable STP on Proxim APs. When you set this option to Yes,
additional configuration fields described in this table become available.

Bridge Priority 32768 Sets the priority for the AP. Values range from 0 to 65535. Lower values have
higher priority. The lowest value is the root of the spanning tree. If all devices
are at default the device with the lowest MAC address will become the root.

Bridge
Maximum Age

20 Sets the maximum time, in seconds, that the device stores protocol
information. The supported range is from 6 to 40.

Bridge Hello
Time

2 Sets the time, from 1 to 10 seconds, between Hello message broadcasts.

Bridge
Forward Delay

15 Sets the time, from 4 to 30 seconds, that the port spends in listening and
learning mode if the spanning tree has changed.

Table 43: Spanning Tree Protocol Fields and Default Values

NTP
Use theNTP Settings section of theGroups > Basic page to define an NTP server and configure Network Time
Protocol (NTP) settings.

Table 44 describes the NTP settings and default values.

Setting Default Description

NTP Server
#1,2,3

None Sets the IP address of the NTP servers to be configured on the AP.

UTC Time
Zone

0 Sets the hour offset from UTC time to local time for the AP. Times displayed in
AirWave graphs and logs use the time set on the AirWave server.

Daylight
Saving Time

No Enables or disables the advanced daylight saving time settings in the Proxim
section of the Groups > Basic configuration page.

Table 44: NTP Fields and Default Values

Aruba Switch Configuration
AirWave automates provisioning of several models of HPE OfficeConnect access points, which are mainly used
for Comware switches. Provisioning uses template-based configuration, zero-touch provisioning (ZTP), and
configuration snippets.

There are two methods of switch configuration:

l Full configuration. AirWave pushes a complete set of changes using a template to the group of devices. By
default, the full configuration mode is enabled whenever you create a device group.

l Config job. AirWave pushes a golden configuration to a group that contains factory-default ZTP devices.

You can also push any command supported by the switch CLI to the device group regardless of their device state
(factory or non-factory).

For help with switch configuration, refer to AirWave 8.2.8 Switch Configuration Guide.
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Aruba
To configure settings specific to Aruba locate the Aruba section and adjust these settings as required.

Table 45 describes the settings and default values of this section of theGroups > Basic page.

Setting Default Description

SNMP Version 2c The version of SNMP used by AirWave to communicate to the AP.

Offload WMS
Database

No Configures commands previously documented in the AirWave 8.2.9 Best
Practices Guide. When enabled, this feature allows AirWave to display
historical information for WLAN switches.

Changing the setting to Yes pushes commands via SSH to all WLAN switches
in Monitor Only mode without rebooting the controller. The command can
be pushed to controllers in manage mode (also without rebooting the
controller) if the Allow WMS Offload setting on AMP Setup > General is
changed to Yes.

Aruba GUI
Config

Yes This setting selects whether you'd like to configure your devices using the
Groups > Controller method (either global or group) or using Templates.

Manage local
configuration on
controllers

No Enables or disables the management of local configuration including audit,
push, and import operations.

Ignore Rogues
Discovered by
Remote APs

No Configures whether to turn off RAPIDS rogue classification and rogue
reporting for RAPs in this group.

Delete
Certificates On
Controller

No Specifies whether to delete the current certificates on an
ArubaOScontroller.

Archive
Controller/Switch
Backups

Yes This setting enables AirWave to create config backups manually.
NOTE: After you enable this setting, you can go to the Device
Configuration page and click Create Backup Now. An archived config
backup is available only Aruba controllers and Mobility Access Switches.

Table 45: Aruba Fields and Default Values

Aruba Instant
To specify the Aruba Instant settings to be applied to this group, locate the Aruba Instant settings section of the
Groups > Basic page and adjust these settings as desired.

Table 46 describes the settings and default values.

Setting Default Description

Enable Instant GUI
Config

No Select this option to configure your Instant APs via the IGC feature on the
Groups > Instant Config pages of the AirWave WebUI, rather than via
Instant template configuration.

Table 46: Virtual Controller Certificate Fields and Default Values
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Setting Default Description

Configure AirWave
communication
settings:

No If the Enable Instant GUI Config setting is set to No, you can use this
option to configure the primary (and optionally, secondary) AirWave
server settings on an Instant AP via template configuration.

Disable auto join
mode

No If you enable the Disable auto join mode setting, then Instant APs will not
automatically join a group of Instant APs in AirWave when that device
becomes active on the network.

Ignore DHCP
configuration

No When this feature is enabled, AirWave will not run a DHCP configuration
audit when the device is added to AirWave. For IAP DHCP configuration,
from the IAP UI, go to DHCP Servers.

HTTPS timeout 5 minutes the HTTPS timeout for Instant devices is the period for which AirWave
waits for an Instant heartbeat message.

The Missed SNMP Poll Threshold in the Basic Settings section at the
top of the Groups > Basic page sets the number of Up/Down SNMP polls
that must be missed before AirWave considers a device to be down.

If, for example, a group of Instant APs your group settings has a Missed
SNMP Poll Threshold of 1, then an instant AP is considered to be down if
there is 1 missed heartbeat during this HTTPS timeout period, which could
be anywhere between 1-30 min.

CA Cert None Specify a CA certificate for the Instant virtual controller. The fields in this
drop down will populate when a certificate of type Intermediate CA or
Trusted CA is added in the Device Setup > Certificates page.

Server Cert None Specify a server certificate for the virtual controller. The fields in this drop
down will populate when a certificate of type Server Cert is added in the
Device Setup > Certificates page.

Captive Portal Cert None Specify a Captive portal certificate for the virtual controller. The fields in
this drop down will populate when a certificate of type Captive Portal
Cert is added in the Device Setup > Certificates page.

Captive Portal Logo None You can use AirWave to download a captive portal logo to your Instant
APs. Upload the image (which must be 16 KB or less) on the Device
Setup > Upload page, then click the Captive Portal Logo drop down list
on the Groups > Basic page to select the image to send to the IAPs.

RadSec Server Cert None Specify a RadSec server certificate for the virtual controller. The fields in
this drop down will populate when a certificate of type Server Cert is
added in the Device Setup > Certificates page.

RadSec CA Cert None Specify a RadSec CA certificate for the virtual controller. The fields in this
drop down will populate when a certificate of type Intermediate CA or
Trusted CA is added in the Device Setup > Certificates page.

Table 46: Virtual Controller Certificate Fields and Default Values (Continued)

Cisco IOS/Catalyst
Configure group settings specific to Cisco IOS/Catalyst devices, as described in Table 47.
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Setting Default Description

SNMP Version 2c The version of SNMP used by AirWave to communicate to the AP.

Cisco IOS CLI
Communication

Telnet The protocol AirWave uses to communicate with Cisco IOS devices.
Selecting SSH uses the secure shell for command line page (CLI)
communication and displays an SSH Version option. Selecting Telnet
sends the data in clear text via Telnet.

Cisco IOS Config
File
Communication

TFTP The protocol AirWave uses to communicate with Cisco IOS devices.
Selecting SCP uses the secure copy protocol for file transfers and
displays an SCP Version option. Selecting TFTP will use the insecure
trivial file transfer protocol. The SCP login and password should be
entered in the Telnet user name and password fields.

Table 47: Cisco IOS/Catalyst Fields and Default Values

Cisco WLC
Use the Cisco WLC section of theGroups > Basic page to configure settings specific to a Cisco Wireless
LAN Controllers (WLC).

Table 48 describes the settings and default values in this section.

Setting Default Description

SNMP Version 2c Sets the version of SNMP used by AirWave to communicate to WLC
controllers.

CLI Communication SSH Sets the protocol AirWave uses to communicate with Cisco IOS devices.
Selecting SSH uses the secure shell for command line page (CLI)
communication. Selecting Telnet sends the data in clear text via Telnet.

Table 48: CiscoWLC Fields and Default Values

When configuring Cisco WLC controllers, refer to "Configuring Wireless Parameters for Cisco Controllers" on
page114.

Proxim/ Avaya
To configure Proxim/Avaya specific settings locate the Proxim/Avaya section of theGroups > Basic page and
adjust these settings as required.

Table 49 describes the settings and default values.

Setting Default Description

SNMP
Version

1 Sets the version of SNMP used by AMP to communicate to the AP.

Enable
DNS
Client

No Enables the DNS client on the AP. Enabling the DNS client allows you to set some values on
the AP by hostname instead of IP address. If you select Yes for this setting, additional DNS
fields display.

Table 49: Proxim/Avaya Settings
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Setting Default Description

Primary
DNS
server

Blank Sets the IP address of the Primary DNS server.

Secondary
DNS
server

Blank Sets the IP address of the Secondary DNS server.

Default
DNS
domains

Blank Sets the default DNS domain used by the AP.

HTTP
Server
Port

80 Sets this port as the HTTP server port on all Proxim APs in the group.

Country
Code

United
States

Configures AMP to derive its time settings based on the country of location, as specified in
this field.

Table 49: Proxim/Avaya Settings (Continued)

HP ProCurve
To configure HP ProCurve specific settings, locate theHP ProCurve section of theGroups > Basic page and
adjust these settings as required.

The Table 50 describes the settings and default values.

Setting Default Description

SNMP Version 2c Sets the version of SNMP used by AirWaveto communicate to the AP.

ProCurve
XL/ZWeSM CLI
Communication

Telnet Sets the protocol AirWave uses to communicate with ProCurve XLWeSM devices.
Selecting SSH will use the secure shell for command line (CLI) communication.
Selecting Telnet will send the data in clear text via telnet.

ControllerSNMP
Version

2c Specifies the version of SNMP used by AirWaveto communicate to the controller.

Table 50: HP ProCurve Settings

Symbol
To configure settings for Symbol controllers, locate the Symbol section of theGroups > Basic page and adjust
these settings as required.

Table 51 describes the settings and default values.

Setting Default Description

SNMP Version 2c Specifies the version of SNMP used by AWMS to communicate to the device.

Symbol Client
Inactivity Timeout
(3-600 min)

3 Sets the minutes of inactivity after which a client associated to a Symbol AP will be
considered "inactive." A lower value typically provides a more accurate
representation of current WLAN usage.

NOTE: For other APs, AWMS has more precise methods to determine when inactive
clients are no longer associated to an AP.

Table 51: Symbol Settings
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Setting Default Description

Symbol Controller
CLI
Communication

Telnet The connection type to support the command-line interface (CLI) connection. The
options are Telnet and secure shell (SSH). This is supported for WS5100, RFS4000,
RFS6000 and RFS7000 devices only.

Web Config
Interface

Yes Enables or disables the http/https configuration page for the Symbol 4131 devices.

Table 51: Symbol Settings (Continued)

Juniper/3Com/Enterasys/Nortel/Trapeze
To configure SNMP settings for 3Com, Enterasys, Nortel, or Trapeze devices, locate the
Juniper/3Com/Enterasys/Nortel/Trapeze section of theGroups > Basic page and click the SNMP Version
drop-down list to define the version of SNMP to be supported. The default setting is SNMPv2c.

Universal Devices, Routers and Switches
To configure settings for universal devices on the network, including routers and switches that support both
wired and wireless networks,, locate the Juniper/3Com/Enterasys/Nortel/Trapeze section of theGroups >
Basic page and click the SNMP Version drop-down list to define the version of SNMP to be supported. The
default setting is SNMPv2c.

Automatic Authorization
To control the conditions by which devices are automatically authorized into this group, locate theAutomatic
Authorization settings section of theGroups > Basic page and adjust these settings as required.

Table 52 describes the automatic authorization options for the device group.

Setting Default Description

Add New Controllers
and Autonomous
Devices Location

Use
Global
Setting

Whether to auto authorize new controllers to the New Devices List, the
same Group/Folder as the discovering devices, the same Group/Folder as
the closest IP neighbor, and/or a specified auto-authorization group and
folder. The Current Global Setting set in AMP Setup > General is shown
below this field. Selecting a different option overrides the global setting.

Add New Thin APs
Location

Use
Global
Setting

Whether to auto authorize new thin APs to the New Devices List, the same
Group/Folder as the discovering devices, the same Group/Folder as the
closest IP neighbor, and/or a specified auto-authorization group and
folder. The Current Global Setting set in AMP Setup > General is shown
below. Selecting a different option overrides the global setting for this
group.

Ignore Device's
Configured Folder

No Enable this option to ignore the folder in the provisioning rule for Aruba
switches configured via Activate, DHCP, or the switch comand-line
interface.

Table 52: Automatic Authorization Fields and Default Values

Maintenance Windows
You can use maintenance windows to put multiple devices into Management mode, apply configuration changes
to the devices in the group, and then reset them to Monitor-Only mode after the maintenance period is over. For
more information, see "Adding a Maintenance Window for a Device" on page 220.
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Configuring AAA Servers for Device Groups
Configure RADIUS servers on theGroups > AAA Servers page. Once defined on this page, theGroups >
Security and Groups > SSIDs menus appear in the navigation bar, allowing you to select and configure your
RADIUS servers.

If theGroups > AAA Servers page does not appear in the navigation bar, select the group from theGroups >
Listpage, select theGroups > Basic page, then choose the Show Device Settings for : All Devices option
in theGroup Display Options section of theGroups > Basic page.

1. Go to theGroups > List page and select the group for which to define AAA servers by selecting the group
name. TheMonitor page appears.

2. Select theAAA Servers page. TheAAA Servers page appears, enabling you to add a RADIUS server.

3. To add a RADIUS server or edit an existing server, select Add New RADIUS Server or the corresponding
pencil icon to edit an existing server. Table 53 describes the settings and default values of theAdd/Edit page.

Setting Default Description

Hostname/IP
Address

None Sets the IP Address or DNS name for RADIUS Server.
NOTE: IP Address is required for Proxim/ORiNOCO and Cisco Aironet IOS
APs.

Secret and
Confirm Secret

None Sets the shared secret that is used to establish communication between
AirWave and the RADIUS server.
NOTE: The shared secret entered in AirWave must match the shared secret
on the server.

Authentication No Sets the RADIUS server to perform authentication when this setting is
enabled with Yes.

Authentication
Port (1-65535)

1812 Appears when Authentication is enabled. Sets the port used for
communication between the AP and the RADIUS server.

Accounting No Sets the RADIUS server to perform accounting functions when enabled with
Yes.

Accounting Port (1-
65535)

1813 Appears when Accounting is enabled. Sets the port used for
communication between the AP and the RADIUS server.

Timeout (0-86400) None Sets the time (in seconds) that the access point waits for a response from
the RADIUS server.

Max Retries
(0-20)

None Sets the number of times a RADIUS request is resent to a RADIUS server
before failing.
NOTE: If a RADIUS server is not responding or appears to be responding
slowly, consider increasing the number of retries.

Table 53: Adding a RADIUS Server Fields and Default Values

4. Select Add to complete the creation of the RADIUS server, or select Save if editing an existing RADIUS server.
TheGroups > AAA Servers page displays this new or edited server. You can now reference this server on the
Groups > Security page.

AirWave supports reports for subsequent RADIUS Authentication. These are viewable by selecting Reports >
Generated, scrolling to the bottom of the page, and selecting Latest RADIUS Authentication Issues
Report.
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5. To make additional RADIUS configurations for device groups, use theGroups > Security page and continue
to the next topic.

TACACS+ servers are configurable only for Cisco WLC devices. Refer to "Configuring Cisco WLC Security
Parametersand Functions" on page 114.

Configuring Security for Device Groups
The Groups > Security page allows you to set security policies for APs in a device group.

Thispage appears in the WebUI after you configure RADIUS servers on theGroups > AAA Servers page. Once
RADIUSservers are defined, theGroups> Security and Groups > SSIDs menus appear in the navigation bar,
allowingyou to select and configure your RADIUS servers.

1. Select the device group for which to define security settings from theGroups > List page.

2. Go to Groups > Security. Some controls on this page interact with additional AirWave pages.

Figure 32 illustrates this page for a group of switches.
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Figure 32: Groups > Security Page

Table 54 explains the fields and default values.

Setting Default Description

VLANs Section

Table 54: Groups > Security Page Fields and Default Values
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Setting Default Description

VLAN Tagging and
Multiple SSIDs

Enabled This field enables support for VLANs and multiple SSIDs on the
wireless network. If this setting is enabled, define additional VLANs and
SSIDs on the Groups > SSIDs page. Refer to "Configuring SSIDs and
VLANs for Device Groups" on page 101. If this setting is disabled, then
you can specify the Encryption Mode in the Encryption section that
displays. Refer to "Groups > Security Encryption Mode settings" on
page 99 for information on configuring Encryption.

Management VLAN ID Untagged This setting sets the ID for the management VLAN when VLANs are
enabled in AirWave . This setting is supported only for the following
devices:
l Proxim AP-600, AP-700, AP-2000, AP-4000
l Avaya AP-3, Avaya AP-7, AP-4/5/6, AP-8
l ProCurve520WL

General Section

Create Closed Network No If enabled, the APs in the Group do not broadcast their SSIDs.
NOTE: Creating a closed network will make it more difficult for
intruders to detect your wireless network.

Block All Inter-client
Communication

No If enabled, this setting blocks client devices associated with an AP from
communicating with other client devices on the wireless network.
NOTE: This option may also be identified as PSPF (Publicly Secure
Packet Forwarding), which can be useful for enhanced security on
public wireless networks.

EAP Options Section

WEP Key Rotation
Interval

300 Sets the frequency at which the Wired Equivalent Privacy (WEP) keys
are rotated in the device group being configured. The supported range
is from 0 to 10,000,000 seconds.

RADIUS Authentication Servers Section

RADIUS Authentication
Server #1 - #4

Not
selected

Defines one or more RADIUS Authentication servers to be supported in
this device group. Select up to four RADIUS authentication servers
from the four drop-down menus.

Authentication Profile
Name

AirWave-
Defined
Server #1

For Proxim devices only, this field sets the name of the authentication
profile to be supported in this device group.

Authentication Profile
Index

1 For Proxim devices only, this field sets the name of the authentication
profile index to be supported in this device group.

RADIUS Accounting Servers Section

RADIUS Accounting
Server #1 - #4

Not
selected

Defines one or more RADIUS Accounting servers to be supported in
this device group. Select up to four RADIUS accounting servers from
the four drop-down menus.

Table 54: Groups > Security Page Fields and Default Values (Continued)
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Setting Default Description

Authentication Profile
Name

For Proxim devices only, this field sets the name of the accounting
profile to be supported in this device group.

Authentication Profile
Index

3 For Proxim devices only, this field sets the name of the accounting
profile index to be supported in this device group.

MAC Address Authentication Section

MAC Address
Authentication

No If enabled, only MAC addresses known to the RADIUS server are
permitted to associate to APs in the Group.

MAC Address Format Single
Dash

Allows selection of the format for MAC addresses used in RADIUS
authentication and accounting requests:
l Dash Delimited: xx-xx-xx-xx-xx-xx (default)
l Colon Delimited: xx:xx:xx:xx:xx:xx
l Single-Dash: xxxxxx-xxxxxx
l No Delimiter: xxxxxxxxxxxx

This option is supported only for Proxim AP-600, AP-700, AP-2000, AP-
4000, Avaya AP3/4/5/6/7/8, HPE ProCurve 520WL

Authorization Lifetime 1800 Sets the amount of time a user can be connected before
reauthorization is required. The supported range is from 900 to 43,200
seconds.

Primary RADIUS Server
Reattempt Period

0 Specifies the time (in minutes) that the AP awaits responses from the
primary RADIUS server before communicating with the secondary
RADIUS server, and so forth

Table 54: Groups > Security Page Fields and Default Values (Continued)

The Encryption options display on theGroups > Security page when theVLAN Tagging and Multiple SSIDs
option is set to Disabled. This setting defaults to No Encryption.

Refer to Table 55 for information regarding configuring encryption.

Setting Default Description

Encryption Mode Require
802.1X

Encryption Mode options: Require 802.1X, Optional WEP, Require WEP,
Require 802.1X, Require LEAP, 802.1X + WEP, 802.1X + WEP, LEAP + WEP,
Static CKIP, WPA, WPA/PSK, WPA2, WPA2/PSK, or xSec.

Transmit Key 1 Select the Transmit Key value. This can be a value from 1 through 4. Note
that 802.1X + WEP mode sets this key value to 1.

Key #1 None Enter 40/64-bit Keys in 5 alphanumeric or 10 hexadecimal digits, or enter
104/128-bit Keys in 13 alphanumeric or 26 hexadecimal digits.

Key #2 None

Key #3 None

Key #4 None

Table 55: Groups > Security Encryption Mode settings
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Setting Default Description

Encryption Mode Static CKIP

CKIP Static Key
(hex) and Confirm

None Enter and confirm the Cisco Key Integrity Protocol (CKIP) static key,
specified in hexadecimal digits.

CKIP Key Index 1 Select the CKIP Key Index value. This can be a value from 1 through 4.

CKIP Key
Permutation

No Specify whether to use Key Permutation.

CKIP MMH Mode No Specify whether to use Multi-Module Has (MMH) mode.

Encryption Mode WPA

Unicast Cipher
(Cisco only)

AES Specify the Unicast Cipher. Values include AES, TKIP, and AES/TKIP.

Encryption Mode WPA/PSK

Unicast Cipher
(Cisco only)

AES/TKIP Specify the Unicast Cipher. Values include AES, TKIP, and AES/TKIP.

WPA Preshared
Key
(Alphanumeric)

None Enter an alphanumeric value for the preshared key.

Encryption Mode WPA2

WPA2 WPA
Compatibility
Mode

Yes Specify whether to enable WPA2 WPA Compatibility Mode.

WPA1 Cipher
(Cisco WLC Only)

TKIP Specify the WPA1 Cipher. Values include AES, TKIP, and AES/TKIP.
NOTE: This drop down is only available if WPA2 WPA Compatibility Mode
is Yes.

Unicast Cipher
(Cisco Only)

AES/TKIP Specify the Unicast Cipher. Values include AES, TKIP, and AES/TKIP.

Encryption Mode WPA2/PSK

WPA2 WPA
Compatibility
Mode

Yes Specify whether to enable WPA2 WPA Compatibility Mode.

WPA1 Cipher
(Cisco WLC Only)

TKIP Specify the WPA1 Cipher. Values include AES, TKIP, and AES/TKIP.
NOTE: This drop down is only available if WPA2 WPA Compatibility Mode
is Yes.

Unicast Cipher
(Cisco Only)

AES/TKIP Specify the Unicast Cipher. Values include AES, TKIP, and AES/TKIP.

Table 55: Groups > Security Encryption Mode settings (Continued)
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Setting Default Description

WPA Preshared
Key
(Alphanumeric)

None Enter an alphanumeric value for the preshared key.

Encryption Mode xSec

This indicates to use xSec encryption. No other configuration options are available.

Table 55: Groups > Security Encryption Mode settings (Continued)

3. Select Save to retain these security configurations for the group, select Save and Apply to make the changes
permanent, or select Revert to discard all unapplied changes.

4. Continue with additional security-related procedures in this document for additional RADIUS and SSID
settings for device groups, as required.

Configuring SSIDs and VLANs for Device Groups
Use theGroups > SSIDs configuration page to create and edit SSIDs and VLANs that apply to a device group.
This configuration page does not appear in the AirWave WebUI until after you configure a RADIUS server using
theGroups > AAA Servers page, as described on "Configuring AAA Servers for Device Groups" on page 95.

AirWave reports users by radio and by SSID. Graphs on the AP and controller monitoring pages display
bandwidth in and out based on SSID. AirWave reports can also be run and filtered by SSID. An option on the
AMP Setup > General page can age out inactive SSIDs and their associated graphical data.

WLANsthat are supported from one or more Cisco WLC controllers can be configured on theGroups > Cisco
WLCConfig page.

To create or edit VLANs and to set SSIDs:

1. Go to Groups > List and select the group name for which to define SSIDs/VLANs.

2. Select theGroups > SSIDs configuration page. Table 56 describes the information that appears for SSIDs
and VLANs that are currently configured for the device group.

Field Description

SSID Displays the SSID associated with the VLAN.

VLAN ID Identifies the number of the primary VLAN SSID on which encrypted or unencrypted
packets can pass between the AP and the switch.

Name Displays the name of the VLAN.

Encryption Mode Displays the encryption on the VLAN.

First or Second Radio
Enabled

Enables the VLAN, SSID and Encryption Mode on the radio control.

Table 56: Groups > SSIDs Fields and Descriptions
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Field Description

First or Second Radio
Primary

Specifies which VLAN to be used as the primary VLAN. A primary VLAN is required.
NOTE: If you create an open network (see the Create Closed Network setting
below) in which the APs broadcast an SSID, the primary SSID is broadcast.

Native VLAN Sets this VLAN to be the native VLAN. Native VLANs are untagged and typically used
for management traffic only. AirWave requires a Native VLAN to be set. For AP
types do not require a native VLAN, create a dummy VLAN, disable it on both radio
controls, and ensure that it has the highest VLAN ID.

Table 56: Groups > SSIDs Fields and Descriptions (Continued)

3. Select Add to create a new SSID or VLAN, or select the pencil icon next to an existing SSID/VLAN to edit that
existing SSID or VLAN. TheAdd SSID/VLAN configuration page appears, as explained in Table 57.

4. Locate the SSID/VLAN section on theGroups > SSIDs configuration page and adjust these settings as
required. This section encompasses the basic VLAN configuration. Table 57 describes the settings and default
values. Note that the displayed settings can vary.

Setting Default Description

Specify Interface Name Yes Enables or disables an interface name for the VLAN interface.
Selecting No for this option displays the Enable VLAN Tagging
and VLAN ID options.

Enable VLAN Tagging
(Cisco WLC, Proxim,
Symbol only)

Enables or disables VLAN tagging. Displays if Specify Interface
Name is set to No.

VLAN ID (1-4094) None Indicates the number of the VLAN designated as the Native
VLAN, typically for management purposes. Displays if Specify
Interface Name is set to No and Enable VLAN Tagging is set to
Yes.

Interface management Sets the interface to support the SSID/VLAN combination.

SSID None Sets the Service Set Identifier (SSID), which is a 32-character
user-defined identifier attached to the header of packets sent
over a WLAN. It acts as a password when a mobile device tries to
connect to the network through the AP, and a device is not
permitted to join the network unless it can provide the unique
SSID.

Name None Sets a user-definable name associated with SSID/VLAN
combination.

Maximum Allowed
Associations (0-2007)

255 Indicates the maximum number of mobile users which can
associate with the specified VLAN/SSID.
NOTE: 0 means unlimited for Cisco.

Table 57: SSID/VLAN Section Fields and Default Values
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Setting Default Description

Broadcast SSID (Cisco
WLC, Proxim and
Symbol 4131 only)

No For specific devices as cited, this setting enables the AP to
broadcast the SSID for the specified VLAN/SSID. This setting
works in conjunction with the Create Closed Network setting on
the Groups > Security configuration page. Proxim devices
support a maximum of four SSIDs.
NOTE: This option should be enabled to ensure support of legacy
users.

Partial Closed System
(Proxim only)

No For Proxim only, this setting enables to AP to send its SSID in
every beacon, but it does not respond to any probe requests.

Unique Beacon
(Proxim only)

No For Proxim only, if more than one SSID is enabled, this option
enables them to be sent in separate beacons.

Block All Inter-Client
Communication

Yes This setting blocks communication between client devices based
on SSID.

Table 57: SSID/VLAN Section Fields and Default Values (Continued)

5. Locate the Encryption area on theGroups > SSIDs page and adjust these settings as required. Table 58
describes the available encryption modes. Table 55 in "Configuring Security for Device Groups" on page 96
describes configuration settings for each mode.

Setting Default Description

Encryption Mode No
Encryption

Drop-down menu determines the level of encryption required for devices
to associate to the APs. The drop-down menu options are as follows.
Each option displays additional encryption settings that must be defined.
Complete the associated settings for any encryption type chosen:
l No Encryption
l Optional WEP—Wired Equivalent Privacy, not PCI compliant as of

2010
l Require WEP—Wired Equivalent Privacy, not PCI compliant as of

2010
l Require 802.1X—Based on the WEP algorithm
l Require LEAP—Lightweight Extensible Authentication Protocol
l 802.1X+WEP—Combines the two encryption types shown
l 802.1X+LEAP—Combines the two encryption types shown
l LEAP+WEP—Combines the two encryption types shown
l Static CKIP—Cisco Key Integrity Protocol
l WPA—Wi-Fi Protected Access protocol
l WPA/PSK—Combines WPA with Pre-Shared Key encryption
l WPA2—Wi-Fi Protected Access 2 encryption
l WPA2/PSK—Combines the two encryption methods shown
l xSec—FIPS-compliant encryption including Layer 2 header info

Table 58: Encryption Section Field and Default Values

6. Locate the EAP Options area on theGroups > SSIDs page, and complete the settings. Table 59 describes the
settings and default values.
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Setting Default Description

WEP Key Rotation
Interval (0-10000000
sec)

120 Time (in seconds) between WEP key rotation on the AP.

Table 59: EAP Options Section Field and Default Value

7. Locate theRADIUS Authentication Servers area on theGroups > SSIDs configuration page and define
the settings. Table 60 describes the settings and default values.

Setting Default Description

RADIUS Authentication
Server 1-3

(Cisco WLC, Proxim only)

None Drop-down menu to select RADIUS Authentication servers previously
entered on the Groups > RADIUS configuration page. These RADIUS
servers dictate how wireless clients authenticate onto the network.

Authentication Profile
Name (Proxim Only)

None Sets the Authentication Profile Name for Proxim AP-600, AP-700, AP-
2000, AP-4000.

Authentication Profile
Index (Proxim Only)

None Sets the Authentication Profile Index for Proxim AP-600, AP-700, AP-
2000, AP-4000.

Table 60: RADIUS Authentication Servers Fields and Default Values

8. Select Save when the security settings and configurations in this procedure are complete.

You may need to return to theGroups > Security configuration page to configure or reconfigure RADIUS
servers.

9. Locate theRADIUS Accounting Servers area on theGroups > SSIDs configuration page and define the
settings. Table 61 describes the settings and default values.

Setting Default Description

RADIUS Accounting
Server 1-3 (Cisco WLC,
Proxim Only)

None Pull-down menu selects RADIUS Accounting servers previously entered
on the Groups > RADIUS configuration page. These RADIUS servers
dictate where the AP sends RADIUS Accounting packets for this
SSID/VLAN.

Accounting Profile
Name (Proxim Only)

None Sets the Accounting Profile Name for Proxim AP-600, AP-700, AP-2000,
AP-4000.

Accounting Profile
Index (Proxim Only)

None Sets the Accounting Profile Index for Proxim AP-600, AP-700, AP-2000,
AP-4000.

Table 61: Radius Accounting Servers Fields and Default Values

10.Select Addwhen you have completed all sections. This returns you to theGroups > SSIDs page.

11.Select Save to retain these SSID configurations for the group, select Save and Apply to make the changes
permanent, or select Revert to discard all unapplied changes.
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Configuring Group Radio Settings
You can configure detailed RF-related radio settings for devices on theGroups > Radio page. If you have
existing deployed devices, you might want to use the RF settings on those devices as a guide when configuring
the radio settings for your default group.

Figure 33: Groups > Radio Page

To define RF-related radio settings for a device group:

1. Go to theGroups > List page, then select a group for which to define radio settings. The monitor page for
the group appears.

2. Navigate to Groups > Radio to open the radio page for the group. Figure 33 illustrates this page.

3. Locate theRadio Settings area and adjust these settings as required. Table 62 describes the settings and
default values.
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Setting Default Description

Allow Automatic
Channel Selection
(2.4, 5, and 4.9GHz
Public Safety)

No If enabled, whenever the AP is rebooted it uses its radio to scan the
airspace and select its optimal RF channel based on observed signal
strength from other radios.
NOTE: If you enable this feature, AirWave automatically reboots the APs
in the group when the change is implemented.

802.11b Data Rates
(Mbps)

Required:
l 1.0
l 2.0

Optional:
l 5.5
l 11.0

Displays pull-down menus for various data rates for transmitting data.
NOTE: This setting does not apply to Cisco LWAPP devices.

The three values in each of the pull-down menus are as follows:
l Required—The AP transmits only unicast packets at the specified

data rate; multicast packets are sent at a higher data rate set to
optional. (Corresponds to a setting of yes on Cisco devices.)

l Optional—The AP transmits both unicast and multicast at the
specified data rate. (Corresponds to a setting of basic on Cisco
devices.)

l Not Used—The AP does not transmit data at the specified data rate.
(Corresponds to a setting of no on Cisco devices.)

Frag Threshold
Enabled

No If enabled, this setting enables packets to be sent as several pieces
instead of as one block. In most cases, leave this option disabled.

Threshold Value (256-
2347 bytes)

2337 If Fragmentation Threshold is enabled, this specifies the size (in bytes)
at which packets are fragmented. A lower Fragmentation Threshold
setting might be required if there is a great deal of radio interference.

RTS/CTS Threshold
Enabled

No If enabled, this setting configures the AP to issue a RTS (Request to
Send) before sending a packet. In most cases, leave this option disabled.

RTS/CTS Threshold
Value (0-2347 bytes)

2338 If RTS/CTS is enabled, this specifies the size of the packet (in bytes) at
which the AP sends the RTS before sending the packet.

RTS/CTS Maximum
Retries (1-255)

32 If RTS/CTS is enabled, this specifies the maximum number of times the
AP issues an RTS before stopping the attempt to send the packet
through the radio.

Acceptable values range from 1 to 128.

Maximum Data
Retries (1-255)

32 The maximum number of attempts the AP makes to send a packet
before giving up and dropping the packet. Acceptable values range from
1 to 255.

Beacon Period (19-
5000 msec)

100 Time between beacons (in microseconds).

DTIM Period (1-255) 2 DTIM alerts power-save devices that a packet is waiting for them. This
setting configures DTIM packet frequency as a multiple of the number
of beacon packets. The DTIM Interval indicates how many beacons
equal one cycle.

Ethernet
Encapsulation

RFC1042 This setting selects either the RFC1042 or 802.1h Ethernet
encapsulation standard for use by the group.

Table 62: Groups > Radio > Radio Settings Fields and Default Values
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Setting Default Description

Radio Preamble Long This setting determines whether the APs uses a short or long
preamble. The preamble is generated by the AP and attached to the
packet prior to transmission. The short preamble is 50 percent shorter
than the long preamble and thus may improve wireless network
performance.
NOTE: Because older WLAN hardware may not support the short
preamble, the long preamble is recommended as a default setting in
most environments.

Table 62: Groups > Radio > Radio Settings Fields and Default Values (Continued)

4. Certain wireless access points offer proprietary settings or advanced functionality that differ from prevailing
industry standards. If you use these APs in the device group, you may wish to take advantage of this
proprietary functionality.

To configure these settings, locate the proprietary settings areas on theGroups > Radio page and continue
with the additional steps in this procedure.

Proprietary settings are only applied to devices in the group from the specific vendor and are not configured on
devicesfrom vendors that do not support the functionality.

5. To configure settings specific to the Proxim AP-600, AP-700, AP-2000, AP-4000; Avaya AP-3/4/5/6/7/8, and
ProCurve 520WL, locate the appropriate section of Groups > Radio page and define the required fields.
Table 63 describes the settings and default values.

Setting Default Description

Load Balancing No If enabled, this setting allows client devices associating to an AP with two
radio cards to determine which card to associate with, based on the load
(# of clients) on each card.
NOTE: This feature is only available when two 802.11b wireless cards
are used in an AP-2000.

Interference
Robustness

No If enabled, this option will fragment packets greater than 500 bytes in
size to reduce the impact of radio frequency interference on wireless
data throughput.

Distance Between
APs

Large This setting adjusts the receiver sensitivity. Reducing receiver sensitivity
from its maximum may help reduce the amount of crosstalk between
wireless stations to better support roaming users. Reducing the receiver
sensitivity, user stations will be more likely to connect with the nearest
access point.

802.11g Operational
Mode

802.11b
+802.11g

This setting sets the operational mode of all g radios in the group to
either b only, g only or b + g.

802.11abg
Operational Mode

802.11b
+802.11g

This setting sets the operational mode of all a/b/g radios in the group to
either a only, b only, g only or b + g.

Table 63: Groups > Radio > Device-Specific Fields and Default Values
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Setting Default Description

802.11b Transmit
Rate

Auto
Fallback

This setting specifies the minimum transmit rate required for the AP to
permit a user device to associate.

802.11g Transmit
Rate

Auto
Fallback

This setting specifies the minimum transmit rate required for the AP to
permit a user device to associate.

802.11a Transmit
Rate

Auto
Fallback

This setting specifies the minimum transmit rate required for the AP to
permit a user device to associate.

Rogue Scanning Yes If enabled, any ORiNOCO or Avaya APs in the group (with the appropriate
firmware) will passively scan for rogue access points at the specified
interval. This rogue scan will not break users' association to the network.
NOTE: This feature can affect the data performance of the access point.

Rogue Scanning
Interval (15-1440
min)

15
minutes

If Rogue Scanning is enabled, this setting controls the frequency with
which scans are conducted (in minutes). Frequent scans provide the
greatest security, but AP performance and throughput available to user
devices may be impacted modestly during a rogue scan.

Table 63: Groups > Radio > Device-Specific Fields and Default Values (Continued)

6. To configure settings specific to Proxim 4900M, locate the Proxim 4900M section and define the required
fields. Table 64 describes the settings and default values.

Setting Default Description

4.9GHz Public Safety
Channel Bandwidth

20 This setting specifies the channel bandwidth for the 4.9 GHz radio. It is
only applicable if you are running the 802.11a/4.9GHz radio in 4.9GHz
mode.

802.11a/4.9GHz
Public Safety
Operational Mode

802.11a This setting specifies if the AP will run the 802.11a/4.9GHz radio in
802.11a mode or in 4.9 GHz mode. Please note that 4.9 GHz is a licensed
frequency used for public safety.

Table 64: Groups > Radio > Proxim 4900M Fields and Default Values

7. To configure Symbol-only settings, locate the Symbol section and define the required fields. Table 65
describes the settings and default values.

Setting Default Description

Rogue Scanning Yes If enabled, Symbol access points with 3.9.2 or later firmware in the group
will passively scan for rogue access points at the specified interval. This
rogue scan will not break a user’s association to the network.

Rogue Scanning
Interval (5-480
min)

240 If Rogue Scanning is enabled, this setting controls the frequency with
which scans are conducted (in minutes). Frequent scans provide the
greatest security, but AP performance and throughput available to user
devices may be impacted modestly during a rogue scan.

Table 65: Groups > Radio > Symbol Fields and Default Values
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8. Select Save when radio configurations as described above are complete, select Save and Apply to make the
changes permanent, or select Revert to discard all unapplied changes.

Configuring Cisco WLC Device Groups
TheGroups > Cisco WLC Config page consolidates the settings for Cisco WLC devices from all group pages. The
Groups > SSIDs subtab applies to SSIDs for all device types except for Cisco WLC, which have WLANs configured
on theCisco WLC Config page.

Do not put Symbol 4131 and Proxim APs in the same group as Cisco devices. Aruba recommends setting
devicepreferences to Only devices in this group.

Accessing Cisco WLC Configuration
The Cisco WLC Config navigation submenu becomes available when you create a Cisco WLC device group for the
first time.

To access theCisco WLC Config page:

1. Navigate to Groups > List, then select a Cisco WLC device group.

2. Select Groups > Cisco WLC Config in the navigation sidebar. In the Groups > Cisco WLC Config page that

displays, click to expand the configurable settings.

Figure 34: Groups > CiscoWLC Config Navigation

You can pre-populate the group WLC settings from a controller in the same group by performing an import on
thecontroller’sDevice Configuration page.

Configuring WLANs for Cisco WLC Devices
In Cisco WLC Config, WLANs are based on SSIDs or VLANs that are dedicated to Cisco WLC controllers. Perform
the following steps to define and configure WLANs for Cisco WLC controllers.

1. Go to theGroups > Cisco WLC Config page, and select WLANs in the left navigation pane. This page
displays the SSIDs or VLANs that are available for use with Cisco WLC devices and enables you to define new
SSIDs or VLANs. illustrates this page.

2. To change the ID/position of a WLAN on the controller by dragging and dropping, set the toggle to Yes. Note
that the by setting this flag to Yes, AirWave will display a mismatch if the WLANs in the desired config and
device config differ only on the order.

3. To add or edit SSIDs or VLANs that are dedicated to Cisco WLC devices, either select theAdd button, or select
the pencil icon for an existing SSID/VLAN. A new page appears comprised of four tabs, as follows:

n General—Defines general administrative parameters for the Cisco WLC WLAN.

n Security—Defines encryption and RADIUS servers.

n QoS—Defines quality of service (QoS) parameters for the Cisco WLC WLAN.

n Advanced—Defines advanced settings that are available only with Cisco WLC devices, for example, AAA
override, coverage, DHCP and DTIM period.
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Referto Cisco documentation for additional information about Cisco WLC devices and related features.

Figure 35: AddNew SSID/VLAN > General Tab Illustration
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Figure 36: AddNew SSID/VLAN > Security Tab Illustration

Figure 37: AddNew SSID/VLAN > QoS Tab Illustration
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Figure 38: AddNew SSID/VLAN > Advanced Tab Illustration
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Defining and Configuring LWAPP AP Groups for Cisco Devices
TheGroups > Cisco WLC Config > WLANs > Advanced > AP Groups page allows you to add/edit/delete AP
Groups on the Cisco WLC. LWAPP AP Groups are used to limit the WLANs available on each AP. Cisco thin APs are
assigned to LWAPP AP Groups.

Viewing and Creating Cisco AP Groups
1. Go to theGroups > Cisco WLC Config page, and select WLANs > Advanced > AP Groups in the

navigation pane on the left side. This page displays the configured LWAPP APs. Figure 39 illustrates this page.

Figure 39: Groups > CiscoWLC Config > WLANS > Advanced > AP Groups Page Illustration

2. To add a new LWAPP AP group, select Yes in theAP Groups section. Additional controls appear.

3. Select Add to create a new LWAPP AP group. To edit an existing LWAPP AP group, select the pencil icon next
to that group. Add one or more SSIDs and the interface/VLAN ID mapping on theAdd/Edit page of the
LWAPP AP Group.

4. Select Save and Apply to make these changes permanent, or select Save to retain these changes to be
pushed to controllers at a later time.

Configuring Cisco Controller Settings
TheGroups > Cisco WLC Config > Controller page defines general Cisco WLC settings, Multicast settings,
Cisco mobility groups to be supported on Cisco controllers, Network Time Protocol (NTP), and Spanning Tree
Protocol settings.

Go to theGroups > Cisco WLC Config > Controller page. This navigation is illustrated in Figure 40.
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Figure 40: Groups > CiscoWLC Config > Controller Navigation

Configuring Wireless Parameters for Cisco Controllers
This section illustrates the configuration of Wireless settings in support of Cisco WLC controllers. Select a group
with Cisco WLC devices, then navigate to Groups > Cisco WLC Config, expand theWireless menu, then
expand Advanced,Mesh, 802.11a/n and 802.11 b/g/n menus to display configuration settings for those
categories. The navigation for Wireless settings is illustrated in Figure 41.

Figure 41: Groups > CiscoWLC Config > Wireless Navigation Illustration

Configuring Cisco WLC Security Parameters and Functions
AirWave enables you to configure many security settings that are specific to Cisco WLC controllers. This section
supports four overriding types of configuration, as follows:

l AAA, to cover both RADIUS and TACACS+ server configuration

l Priority Order
l Wireless Protection Policies
l Web Auth

Figure 42 illustrates these components and this navigation:
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Figure 42: Groups > CiscoWLC Config > Security Navigation Illustration

Configuring Management Settings for Cisco WLC Controllers
AirWave allows you to configure of SNMP and Syslog Server settings for Cisco WLC controllers. You can configure
up to four trap receivers on the Cisco WLC including the AMP IP that can be used in Global Groups. To define
SNMP and server settings, go to theGroups > Cisco WLC Config > Management page, illustrated in Figure
43.

Figure 43: Groups > CiscoWLC Config > Management Navigation Illustration

Configuring PTMP Settings for Device Groups
TheGroups > PTMP configuration page configures Point-to-Multipoint (PTMP) for all subscriber and base
stations in the device group. Subscriber stations must be in the same group as all base stations with which they
might connect.

To configure these functions:

1. Go to theGroups > List page and select the group that supports Proxim MP.11. Alternatively, select Add
from theGroups > List page to create a new group.

2. Select theGroups > PTMP from the navigation sidebar. Figure 44 illustrates this page.
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Figure 44: Groups > PTMP Page Illustration

3. Define the settings on this page. Table 66 describes the settings and default values.

Setting Default Description

802.11a Radio Channel 58 Selects the channel used for 802.11a radios by the devices in
this group.

802.11g Radio Channel 10 Selects the channel used for 802.11g radios by the devices in
this group.

Channel Bandwidth 20 Defines the channel bandwidth used by the devices in this
group.

Network Name Wireless
Network

Sets the Network name, with a range of length supported
from two to 32 alphanumeric characters.

Network Secret None Sets a shared password to authenticate clients to the
network.

Table 66: Groups > PTMP Fields and Default Values

4. Select Save and Apply when configurations are complete to make them permanent, or select Save to retain
these settings prior to pushing to controllers later.

Configuring Proxim Mesh Radio Settings
To configure mesh radio settings:

1. Go to theGroups > Proxim Mesh configuration page.

2. Define the settings as required for your network.

3. Do one of the following:

l Select Save when configurations are complete to retain these settings.

l Select Save and Apply to make the changes permanent.

l Select Revert to discard all unapplied changes.

Figure 45 illustrates this page. The tables that follow describe the settings and default values.
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Figure 45: Groups > Proxim Mesh Page

TheGeneral section contains settings for mesh radio, number of mesh links, RSSI smoothing, roaming
threshold and de-auth client.

Setting Default Description

Mesh Radio 4.9/5Ghz Drop-down selects the radio that acts as the backhaul to the network.

Maximum Mesh
Links (1-32)

6 Sets the maximum number of mesh links allowed on an AP. This
number includes the uplink to the portal as well as downlinks to other
mesh APs.

Neighbor RSSI
Smoothing

16 Specifies the number of beacons to wait before switching to a new link.

Roaming Threshold
(0-100)

80 Specifies the difference in cost between two paths that must be
exceeded before the AP roams. To switch to a new path it must have a
cost that is less by at least the roaming threshold. A high threshold
results in fewer mesh roams.

Deauth Client when
Uplink is Down

Yes With Yes selected, clients have authentication removed (are
deauthenticated) if the uplink is lost.

Table 67: General Fields and Default Values

The Security section contains settings for SSID and enabling AES encryption.
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Setting Default Description

SSID None Sets the SSID used by the Mesh Radio to connect to the mesh network.

Enable AES No Enable or disable AES encryption.

Shared Secret None Specify a shared secret if Enable AES is Yes.

Table 68: Security Fields and Default Values

TheMesh Cost Matrix configuration section contains settings for hop factor and maximum hops to portal,
RSSI factor and cut-off, medium occupancy factor and current medium occupancy weight. Adjust these
settings as required for your network. Table 69 describes these settings and default values.

Setting Default Description

Hop Factor (1-
10)

5 Sets the factor associated with each hop when calculating the best path to the
portal AP. Higher factors will have more impact when deciding the best uplink.

Maximum
Hops to Portal
(1-4)

4 Set the maximum number of hops for the AP to reach the Portal AP.

RSSI Factor (0-
10)

5 Sets the factor associated with the RSSI values used when calculating the best
path to the portal AP. Higher factors will have more impact when deciding the
best uplink.

RSSI Cutoff (0-
26)

10 Specifies the minimum RSSI needed to become a mesh neighbor.

Medium
Occupancy
Factor (0-10)

5 Sets the factor associated with Medium Occupancy when calculating the best
path to the portal AP. Higher factors will have more impact when deciding the
best uplink.

Current
Medium
Occupancy
Weight (0-9)

7 Specifies the importance given to the most recently observed Medium
Occupancy against all of the previously viewed medium occupancies. Lower
values place more importance on previously observed Medium Occupancies.

Table 69: Mesh Cost Matrix Fields and Default Values

Configuring Group MAC ACLs for Device Groups
If you use Symbol, Proxim, or ProCurve 520WL wireless access points, you can specify the MAC addresses of
devices that are permitted to associate with APs in the Group. Other devices are not able to associate to APs in
the Group, even if the users of those devices are authorized users on the network.

To enable MAC ACL:

1. Browse to theGroups > MAC ACL configuration page. Figure 46 illustrates this page.
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Figure 46: Groups > MAC ACL Page

2. Select Yes on theUse MAC ACL drop-down menu.

3. Type all authorized MAC addresses, separated by white spaces.

4. Select Save when configurations are complete to retain these settings, or select Save and Apply to make the
changes permanent. Alternatively, select Revert to cancel your changes.

Specifying the Minimum Firmware Version for Device Groups
AirWave automatically upgrades all eligible devices in a device group when you set the minimum firmware
version on theGroups > Firmware page. When you add devices to the device group later, you must upgrade
the firmware on those devices manually.

Figure 47: Groups > Firmware Page

To set the minimum firmware version for a device group:

1. Navigate to Groups > Firmware .
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2. For each device type in the group, specify the minimum acceptable firmware version. If no firmware versions
are listed, go to Device Setup > Upload Firmware & Files to upload the firmware files to AirWave.

3. Select Upgrade to apply firmware preferences to devices in the group. The device types that display will vary
based on the device types that were selected on theGroups > Basic page.

4. Select Save to save the firmware file as the desired version for the group.

5. If you have opted to assign an external TFTP server on a per-group basis on theDevice Setup > Upload
Firmware & Files configuration page, you can enter the IP address in the Firmware Upgrade Options field
on the top of this configuration page.

6. Once you have defined your first group, you can configure that group to be the default group on your
network. When AirWave discovers new devices that need to be assigned to a management group, the default
group appears at the top of all drop-down menus and lists. Newly discovered devices are place automatically
in the default group if AirWave is set to automatically monitor/manage new devices.

7. Browse to theAMP Setup > General page.

8. In theGeneral section, select the desired group from theDefault Group drop down menu to make it the
default.

Formore information about loading firmware on to an AirWave server, see "Uploading Firmware and Files" on
page54.
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Chapter 4
Discovering, Adding, and Auditing Devices

This chapter describes the steps you should perform after you have deployed AirWave on the network. The
following sections describe:

l "How to Set Up Device Discovery" on page 121

l "Adding Devices into AirWave" on page 125

l "Verifying the Device Configuration" on page 129

l "Setting the Management Mode" on page 128

l "Ignoring Discovered Devices" on page 130

l "Troubleshooting a Newly Discovered Down Device" on page 131

How to Set Up Device Discovery
In order for AirWave to discover devices on your network, you must first enable SNMP/HTTP scanning from the
Device Setup > Discover page and then configure SNMP/HTTP scanning.

Thispage is only visible to users with the AirWave Administrator role or roles that haveAllow authorization
of Devices enabled in AMP Setup > Roles.

This process includes:

l "Adding Networks for SNMP/HTTP Scanning" on page 121

l "Adding Credentials for Scanning" on page 122

l "Defining a Scan Set" on page 123

l "Running a Scan Set" on page 123

Adding Networks for SNMP/HTTP Scanning
The first step when enabling SNMP/HTTP scanning for devices is to define the network segments to be scanned.

To add networks for SNMP/HTTP scanning:

1. Go to theDevice Setup > Discover page.

2. Scroll down to theNetworks section, and click Add.

3. Enter a network name.

4. Enter the IP network range to be scanned. Or, enter the first IP address on the network.

5. Enter the network subnet mask. The largest subnet AirWave supports is 255.255.255.0.

6. Click Add.

Figure 48 shows an example of adding a scan network called Accounting Network, where the network IP address
is 10.52.0.0, and the subnet mask is 255.255.255.0.
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Figure 48: Adding a Scan Network

AirWave displays all network segments in theNetwork section of theDevice Setup > Discover page.

Adding Credentials for Scanning
The next step in SNMP/HTTP device discovery is to define the scan credentials that govern scanning of a given
network. New devices inherit scan credentials from the System Credentials that you configure on theDevice
Setup > Communications page.

Perform these steps to define scan credentials for SNMP/HTTP scanning:

1. Locate theCredentials section on theDevice Setup > Discover page. (Scroll down if necessary.) This page
displays scan sets, networks, and credentials that have been configured so far, and allows you to define new
elements for device scanning.

2. To create a new scan credential, select theAdd button to add a new scan credential. Figure 49 illustrates
this page. (Note that you may have to scroll down the page again to view this section.)

Figure 49: Device Setup > Discover > Add/Edit New Scan Credential Section Illustration

3. Enter a name for the credential in theName field (for example,Default). This field supports alphanumeric
characters (both upper and lower case), blank spaces, hyphens, and underscore characters.

4. Choose the type of scan to be completed (SNMPv1, SNMPv2, orHTTP). In most cases, perform scans using
SNMP for device discovery, but consider the following factors in your decision:

l SNMPv1 and SNMP v2 differ between in their supported traps, supported MIBs, and network query
elements used in device scanning.

l HTTP discovers devices using the HyperText Transfer Protocol in communications between servers and
additional network components. HTTP is not as robust in processing network events as is SNMP, but HTTP
may be sufficient, simpler, or preferable in certain scenarios.
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a. If you selected SNMPv1 or SNMPv2, then define and confirm theCommunity String to be used during
scanning. In this section, the community string used can be either read-only or read/write because
AirWave only uses it for discovering devices. To bring devices under management, AirWave uses the
credentials supplied in theDevice Setup > Communication SNMP section. Once the device is
authorized, it will use the non-scanning credentials.

b. If you selected HTTP for the type, then enter a user name and password for the scan credentials.

AirWaveautomatically appends the type of scan (SNMP or HTTP) to the Label.

5. Select Add after you have completed the previous steps. TheDevice Setup > Discover page displays the
new scan credential or credentials just created or edited.

6. Repeat these steps to add as many credentials as you require.

7. Once scan networks and scan credentials are defined, combine them by creating scan sets using the next
procedure: "Defining a Scan Set" on page 123.

Defining a Scan Set
After you have defined at least one network and one scan credential, you can create a scan set that combines the
two for device discovery.

To create a scan set.

1. Locate the Scan Set area at the top of theDevice Setup > Discover page.

2. Select Add New Scan Set to see all scan components configured so far. If you wish to create a new network,
or new scanning credentials, you can select Add in either of these fields to create new components prior to
creating a scan set.

3. Select the network(s) to be scanned and the Credential(s) to be used. AirWave defines a unique scan for each
Network-Credential combination.

4. In theAutomatic Authorization section, select whether to override the global setting in AMP Setup >
General and have New Devices be automatically authorized into the New Device List, the same
Group/Folder as the discovering devices, the same Group/Folder as the closest IP neighbor, and/or a specified
auto-authorization group and folder.

5. Select Add to create the selected scans, which then appear in a list at the top of theDevice Setup >
Discover page.

6. To edit an existing scan, select thepencil icon next to the scan on theDevice Setup > Discover page.

7. When ready, proceed to the next task, "Running a Scan Set" on page 123.

Schedulingan HTTP scan to run daily on your network can help you to discover rogues. Some consumer APs,
likemost D-Link, Linksys, and NetGear models, do not support SNMP and are found only on the wired side
with an HTTP scan. These devices are discovered only if they have a valid IP address. Proper credentials are not
required to discover these APs. Wireless scans discover these rogues without any special changes.

Running a Scan Set
Once a scan has been defined on theDevice Setup > Discover page, AirWave can now scan for devices.

To run a scan set:

1. Browse to theDevice Setup > Discover page and locate the list of all scan sets that have been defined so
far. Figure 50 illustrates this page.
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Figure 50: Device Setup > Discover Executing a Scan Illustration

2. Check the box next to the scan(s) that you would like to execute.

3. Select Scan to execute the selected scans, and the scan immediately begins. The Stop column indicates the
scan is In Progress. Clicking this column heading will stop the scan(s).

4. For future scans, select the Show Scheduling Options link and enter the desired date and time to schedule
a future scan.

5. After several minutes have passed, refresh the browser page and view the results of the scan. When the Start
and Stop columns display date and time information, the scan is available to display the results.

6. Select thepencil icon for the scan to display the results. Table 70 describes the scan results and related
information.

Column Description

Network Displays the network to be scanned.

Credentials Displays the credentials used in the scan.

Total Devices
Found

Displays the total number of APs detected during the scan that AirWave can configure
and monitor. Total includes both APs that are currently being managed by AirWave as
well as newly discovered APs that are not yet being managed.

New Devices
Found

Displays the number of discovered APs that are not yet managed, but are available.

Total Rogues
Found

Displays the total number of APs detected during the scan that AirWave could not
configure or monitor. Total includes both APs that have been discovered in earlier scans
as well as newly discovered APs from the most recent scan.

New Rogues Found Displays the number of rogue APs discovered on the most recent scan.

Start Displays the date and time the most recent scan was started.

Stop Displays the date and time the scan most recently completed.

Scheduled Displays the scheduled date and time for scans that are scheduled to be run.

Table 70: Device Setup > Discover > Discovery Execution Fields

7. Go to theDevices > New page to see a full list of the newly discovered devices that the scan detected.
Figure 51 illustrates this page.

Thispage is only visible to users with the AirWave Administrator role or roles that haveAllow authorization
of Devices enabled in AMP Setup > Roles.
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Figure 51: Devices > New Page Illustration

The Cisco Discovery Protocol (CDP)
CDP uses the polling interval configured for each individual Cisco switch or router on theGroups > List page.
AirWave requires read-only access to a router or switch for all subnets that contain wired or wireless devices. The
polling interval is specified on theGroups > Basic page.

Adding Devices into AirWave
If AirWave doesn't discover devices automatically, there are two methods of adding devices to AirWave. One is
where you manually select your device type and model from the Add page. The other is where you bulk import
devices from a CSV file.

Adding Devices Manually
If AirWave doesn't discover devices automatically, you can manually add devices. When you add a Cisco or Aruba
device, AirWave adds the make and model into its database. When you add a universal device, AirWave gets only
basic monitoring information. If you don't provide SNMP credentials for the device, AirWave will monitor
upstream switches, RADIUS servers, and other devices in the wired network using ICMP monitoring. Once you
have added a universal device, you can view a list of its interfaces by navigating to Devices > Manage.

By selecting thepencil icon next to an interface, you can assign it to be non-monitored or monitored as
Interface 1 or 2. AirWave collects this information and displays it on theDevices > Monitor page in the
Interface section. AirWave supports MIB-II interfaces and polls in/out byte counts for up to two interfaces.
AirWave also monitors sysUptime.

To add a device into AirWave:

1. Log in to the AirWave with the following credentials:

n Username: admin

n Password: admin password.

2. Navigate to Devices > New, then click Add.

3. From theDevice Setup > Add page, select the device from the drop-down menu.
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Figure 52: Selecting the Device

4. Select Add.

5. From the Add page, enter the device communications settings and location settings. The configuration
options on this page vary depending on the device. See Table 71 for information about each setting.

When adding an Aruba device, be sure to add controllers and switches to separate groups.

6. At the bottom of the page, set the device management mode to Monitor Only orManagement
read/write.

If you select Manage read/write, AirWave overwrites existing device settings with theGroups settings. Place
newly discovered devices in Monitor read/only mode to enable auditing of actual settings instead of Group
Policy settings. For more information, see "Setting the Management Mode" on page 128.

7. Select Add to finish adding the device to the network.

Table 71 describes the settings on the Add Page.

Setting Default Description

Name None User-configurable name for the AP (maximum of 20
characters).

IP Address None IP address of the device (required). AirWave supports IPv4 and
IPv6 addresses.

SNMP Port 161 The port AirWave uses to communicate with the AP using
SNMP.

SSH Port 22 For devices that support SSH, specify the SSH port number.

Table 71: Device Communication and Location Fields and Default Values
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Setting Default Description

Community
String
(Confirm)

Taken from Device Setup
> Communication

Community string used to communicate with the AP.
NOTE: The Community String should have RW (Read-Write)
capability. New, out-of-the-box Cisco devices typically have
SNMP disabled and a blank user name and password
combination for HTTP and Telnet. Cisco supports multiple
community strings per AP.

SNMPv3
Username

Taken from Device Setup
> Communication

User name of the SNMP v3 user on the controller. If you are
going to manage configuration for the device, this field
provides a read-write user account (SNMP, HTTP, and Telnet)
within the Cisco Security System for access to existing APs.
AirWave initially uses this user name and password
combination to control the Cisco AP. AirWave creates a user-
specified account with which to manage the AP if the User
Creation Options are set to Create and user specified as
User.

Auth
Password

Taken from Device Setup
> Communication

SNMPv3 authentication password.
NOTE: SNMPv3 supports three security levels: (1) no
authentication and no encryption, (2) authentication and no
encryption, and (3) authentication and encryption. AirWave
currently only supports authentication and encryption.

Privacy
Password
(Confirm)

Taken from Device Setup
> Communication

SNMPv3 privacy password.
NOTE: SNMPv3 supports three security levels: (1) no
authentication and no encryption, (2) authentication and no
encryption, and (3) authentication and encryption. AirWave
currently only supports authentication and encryption.

SNMPv3 Auth
Protocol

Taken from Device Setup
> Communication

Specifies the SNMPv3 auth protocol, either MD5 or SHA-1.

SNMPv3
Privacy
Protocol

Taken from Device Setup
> Communication

Specifies the SNMPv3 Privacy protocol as either DES or AES.
This option is not available for all devices.

Telnet/SSH
Username

Taken from Device Setup
> Communication

Telnet user name for existing Cisco IOS APs. AirWave uses the
Telnet user name/password combination to manage the AP
and to enable SNMP if desired.
NOTE: New, out-of-the-box Cisco IOS-based APs typically have
SNMP disabled with a default telnet user name of Cisco and
default password of Cisco. This value is required for
management of any existing Cisco IOS-based APs.

Telnet/SSH
Password
(Confirm)

Taken from Device Setup
> Communication

Telnet password for existing Cisco IOS APs. AirWave uses the
Telnet user name/password combination to manage the AP
and to enable SNMP if desired.
NOTE: New, out-of-the-box Cisco IOS-based APs typically have
SNMP disabled with a default telnet user name of Cisco and
default password of Cisco. This value is required for
management of any existing Cisco IOS-based APs.

Table 71: Device Communication and Location Fields and Default Values (Continued)
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Setting Default Description

enable
Password
(Confirm)

Taken from Device Setup
> Communication

Password that allows AirWave to enter enable mode on the
device.

Table 71: Device Communication and Location Fields and Default Values (Continued)

Adding Devices from a CSV File
You can use a CSV file to bulk add devices to AirWave. If you specify the vendor name, AirWave automatically
determines the correct type while bringing up the device. If your CSV file includes make and model information,
AirWave will add the information provided in the CSV file as it did before. AirWave will not override what you
have specified in this CSV file in any way.

Usethe example provided on the bottom of the page, or click the blue "Download a sample CSV file" link to
savethe sample as a CSV file and edit the contents with an external application.

To import a CSV file:

1. From theDevice Setup > Add page, click the blue Import Devices via CSV link. TheUpload a list of
devices page displays. See Figure 53.

Figure 53: Adding Devices from CSV File

2. Select a group and folder into which to import the list of devices.

3. Click Choose File to select the CSV file on your computer.

4. Click Upload to add the devices from the list into AirWave.

Setting the Management Mode
After AirWave discovers devices on your network, you need to add the devices to a group and set the
management mode to Monitor Only to avoid overwriting important configuration settings. In this read-only
mode, AirWave monitors the device, updates the firmware, compares the current configuration with the policy,
and displays any discrepancies on theDevices > Device Configuration page. For information about device
groups, refer to "Using Device Groups" on page 72.
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Placingnewly discovered devices in Monitor Only mode is strongly recommended until you can confirm that all
group configuration settings are appropriate for the devices. Change the management mode to Manage
Read/Writewhen you are ready to push configuration changes to the devices in the group.

To put newly discovered devices into a group and set the management mode:

1. Navigate to Devices > New, then click to the newly discovered devices.

2. Select the group and folder to which the device will be added. You can't add devices to a global group.

3. Select Monitor Only + FirmWare Upgrades from the Management Level drop-down menu, then select
Add.

4. From theDevices > List page, select the folder that contains one or more devices to verify that your device
has been properly assigned.

Verifying the Device Configuration
When you have placed a newly discovered device in to a group and set the management mode to Monitor Only,
the next step is to check the device configuration status. Determine whether AirWave will apply changes to the
device if you change the management mode to Manage Read/Write.

AirWave uses SNMP or Telnet to read a device’s configuration. SNMP is used for Cisco controllers. Aruba devices
and wired routers and switches use Telnet/SSH to read device configuration. See "Individual Device Support and
Firmware Upgrades" on page 223 for more details.

To verify the device configuration status:

1. Navigate to theDevices > List, then locate the device in the Device list.

2. Check the configuration status in the Configuration column:

l indicates that the device is in Monitor Only mode. AirWave won't make any device configuration
changes.

l Good indicates that all of the device's current settings match the group policy settings. AirWave won't
make any changes to the device configuration when the management mode changes to Manage
Read/Write.

l Error indicates that there is a problem with the device configuration. Click the blue Error link to access the
Device Configuration page and review the error.

l Mismatch indicates that at least one of the device's current configuration settings doesn't match the
group policy. AirWave will push configuration changes to the device when the management mode changes
to Manage Read/Write.

3. If there is a configuration mismatch, from the Device Configuration page, click the blue Error link toview the
device configuration settings and it with the group configuration. When the device management mode is set
to Manage Read/Write, the settings on the right side of the Compare Configurations page will be pushed to
the device.
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4. Review the list of changes to be applied to the device to determine whether the changes are appropriate. If
not, you need to change the group settings or move the device to another group.

Ignoring Discovered Devices
You might want to ignore a discovered device. If you know that the device will be down temporarily, you can add
it to the ignore list and then remove it from the ignored list when it is online again.

If AirWave discovers an ignored device in a subsequent scan, it doesn't display the device in the list of new
devices on theAP/Devices > New page. However, AirWave lists a deleted device on this page if it discovers it
again.

To ignore a device:

1. Go to theDevices > New page.

2. Select the checkbox beside the device, and then select Ignore Selected Devices from the drop-down menu
(see Figure 54. You can select more than one at a time.

Figure 54: Devices > New Page Illustration

Unignoring a Device
Perform these steps to return an ignored device to a managed status.

1. To view all devices that are ignored, go to theDevices > Ignored page, illustrated in Figure 55.

Figure 55: Devices > Ignored Page Illustration

This page provides the following information for any ignored device:

l Device name or MAC address, when known

l Controller associated with that device

l Device type
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l Device IP address

l LAN MAC address for the LAN on which the device is located

l Date and time of device discovery

2. To change the device parameters for a given device, select its checkbox and adjust group, folder, monitor, and
manage settings as desired.

3. Select Add to add the device to AirWave so that it appears on theDevices > New list.

4. TheUnignore button will either return the device to its regular folder or group or send it to theDevices >
New
page.

Troubleshooting a Newly Discovered Down Device
If the device status on theDevices > List page remainsDown after being discovered and added to a group,
there is usually an error in the SNMP community string used to manage the device.

To troubleshoot a down device:

1. Go to theDevices > List or theDevices > Down page, then click theName of the down device to access
the device monitoring page.

2. Locate the Status field in theDevice Info section. When the device is down, the status includes a description
of the problem.

A device might be down for any of the discovery issues described in Table 72.

Message Meaning

AP is no longer
associated with
controller

This means the AP no longer shows up in any controller's AP list (on the AirWave
server). Either the AP was removed from the controller, or it has roamed to another
controller that AirWave does not have visibility to, or it is offline.

Controller is Down When a controller goes down, AirWave automatically marks all associated thin APs
down. This is because communication to thin APs are via the controller, and
AirWave assumes that if the Controller has gone offline, then all associated APs are
down as well until they are re-associated with another Controller.

Downloading The AP is in the process of downloading firmware or configuration.
NOTE: Applicable to Cisco WLC thin APs and some Symbol APs.

Error fetching existing
configuration

AirWave could not fetch a configuration for the device. Usually this is because
AirWave has incorrect credentials and was not able to log in.

ICMP Ping Failed (after
SNMP Get Failed)

The device is not responding and is likely offline.

SNMP Get Failed SNMP credentials and/or configuration may be incorrect. Verify that SNMP is
enabled and that credentials and access ports are configured correctly on both the
target device and in AirWave.

SNMP Trap AirWave received an SNMP trap from the controller indicating that the AP is no
longer associated to the controller.

Table 72: System Messages for Discovered, Down Devices
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Message Meaning

Telnet Error: command
timed out

Telnet/SSH user name and password specified for that device is incorrect.

Unexpected LAN MAC
Address found at this
device’s IP address

If AirWave detects that the LAN MAC address of a device has changed this error
message will appear. This usually indicates that a physical hardware change has
occurred (while reusing the same IP Address) without using the Replace Hardware
feature in AirWave. This error may also indicate an IP address conflict between two
or more devices.

When an unexpected LAN MAC address is seen in a device's IP address, its Devices
> Manage page displays the message Click Replace Hardware (preferred) or
Reset MAC Address to reset the LAN MAC address if this device has been replaced
with new hardware at the top of the page. Use the Replace Hardware button at the
bottom of that page in order to avoid this message.

Table 72: System Messages for Discovered, Down Devices (Continued)

To view the detailed status of all your down devices at once, navigate to Devices > Down (try theDown top
headerstats link) and look at theDetailed Status column for the list of down devices. This column can be
sorted using the Filter icon ( ).

3. If the SNMP Get Failedmessage appears, select theDevices > Manage tab to go to the management page
for that device.

4. If the credentials are incorrect, return to theDevice Communications area on theDevices > Manage
page. Enter the appropriate credentials, and select Apply.

5. Return to theDevices > List page to see if the device appears with a Status of Up.
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Chapter 5
Using ZTP Orchestrator Beta

With ZTP Orchestrator, you can setup the campus network and then discover and deploy Aruba access devices
from a single page. AirWave will coordinate the work of ClearPass and Mobility Master without the need for you
to log in to each Aruba device and manually configure a secure network and manage the devices.

To access ZTP Orchestrator, go to Device Setup > ZTP Orchestrator.

Figure 56: ZTP Orchestrator Page

Before You Begin
The following information will help you plan and prepare to use ZTP Orchestrator for the first time:

l Groups and folders. Identify the ZTP groupings with the types of access devices that match the needs of
the campus network and AirWave folders where you want to put the access devices for monitoring.

l Credentials required for ClearPass. Gather network information, such as the ClearPass Policy Manager
API client, RADIUS shared secret, and Downloadable User Role (DUR) credentials. The API Client and dynamic
segmentation policies need to be created on ClearPass server beforehand. For instructions, refer to the
ClearPass Guest User Guide and the ClearPass Policy Manager User Guide.

l Path required for Mobility Master node configuration. Determine the path for creating the Mobility
Master node hierarchies.

l Mobility Master and ArubaOS-CX switch configuration. Configure Mobility Master and Aruba OS-CX
Switches before you work with ZTP Orchestrator.

Minimum Requirements
In order to use ZTP Orchestrator, ensure that your access components meet the following minimum
requirements:

l ArubaOS-CX Switches must be running firmware version 10.02.0031 or later.

l ArubaOS-S Switches must be running firmware version 16.08.002 or later.

l Aruba Mobility Master appliances must be running ArubaOS 8.5.0.0 or later.

l ClearPass appliances must be running ClearPass Policy Manager 6.7 or later.

ZTP Orchestrator does not support third party access components. This feature only works with Aruba devices.

Network Setup
Use ZTP Orchestrator to seamlessly integrate all the access components with AirWave.
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To set up your network, go to Device Setup > ZTP Orchestrator and complete the following steps:

l "Step 1: Create Groups for ZTP" on page 134

l "Step 2: Add ClearPass Policy Manager" on page 135

l "Step 3: Add Mobility Master" on page 137

l "Step 4: Add the ArubaOS-CX Switch" on page 138

Step 1: Create Groups for ZTP
Group same device types together to simplify how you navigate ZTP Orchestrator, select devices, and access
information. For smaller campus networks, you might want to create a group of mixed device types. All
discovered devices in a ZTP group will inherit the group settings.

To create a ZTP group:

1. Log in to the AirWave WebUI as the admin user.

2. Go Device Setup > ZTP Orchestrator. The first time you access ZTP Orchestrator, you will find an empty
table on the Network Setup tab (see Figure 56).

3. From theNetwork Setup tab, click Add/Edit Group. The Groups window displays with required fields
outlined in red (see Figure 57).

Figure 57: Groups Window

4. Enter the following information that ZTP Orchestrator will use to communicate with discovered devices:

n Name. The name to be assigned to the ZTP group.

n Community String/Confirm Community String. The SNMP community string used to allow access to
the device. The community string can include upper case letters, lower case letters, numbers, and special
characters. You can't use spaces.

n SSH Username. The Telnet/SSH username used to securely log in to the device.

n SSH Password. The Telnet/SSH password used to authenticate a secure connection to the device.
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Figure 58: Communication Settings

5. Select the type of device that ZTP Orchestrator will add to the group: Mobility Controllers, ArubaOS-S
Switches, or both.

For Mobility Controllers, enter the following information:

n MM node path. ZTP Orchestrator creates this node path for up to three levels after /md (for example,
/md/sjc/sc/floor1). You can't create multiple groups within the same hierarchy.

n User VLAN range. Defines the range of VLANs, from 2 to 4092.

n Management VLAN ID. The management VLAN used to manage your devices. The default is 1.

Figure 59: Mobility Controller Settings

n For ArubaOS-S Switches, enter the following information:

n AP VLAN ID. The ID number assigned to all access points in a VLAN.

n Syslog Server. The IP address of the syslog server.

n NTP. The IP address or hostname of the NTP server.

n Management VLAN ID. The ID number of the management VLAN.

n DNS Name. The DNS domain name.

n DNS IP. The IP address of the DNS server.

Figure 60: ArubaOS-S Switch Settings

6. Click Save.

Step 2: Add ClearPass Policy Manager
In this step, add Clear Pass Policy Manager (CPPM) as a RADIUS server to authenticate devices. CPPM will also
push policies for dynamically-segmented clients to access the devices.
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ZTP Orchestrator works with standalone CPPM servers. ZTP Orchestrator does not support CPPM clusters.

To add CPPM :

1. In theNetwork Setup tab, click Add ClearPass. The ClearPass window displays with required fields outlined
in red.

Figure 61: ClearPass Window

2. Enter the following information:

n IP address. The IP address of the ClearPass server.

n API Client ID. The client ID used to log in to the ClearPass API Client.

n API Client Secret. The client password used to access the ClearPass API Client.

n Community string/Confirm Community String. The SNMP community string used to allow access to
the ClearPass server.

n RADIUS Secret/Confirm RADIUS Secret. The password used by CPPM to connect devices to the
RADIUS server.

n Downloadable User Role (DUR) credentials. The credentials used to access device attributes in DURs.

3. Click the Folder drop-down menu to add the group to an AirWave folder.

4. Click Save.
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Figure 62: Configuring CPPM

Step 3: Add Mobility Master
In this step, add the Mobility Master that maintains and manages the configurations for a Mobility Controller to
AirWave.

You must add each Mobility Master server using ZTP Orchestrator. The Mobility Master servers will be added to
an auto-generated group named "ZTP Orch. Mobility Master".

To add the Mobility Master server:

1. In theNetwork Setup tab, click Add Mobility Master. The Mobility Master window displays with required
fields outlined in red.

Figure 63: Mobility MasterWindow

2. Enter the following information, as shown in Figure 64:

n HTTPS Admin. The user name for admin login.

n HTTPS Password. The password for admin login.

n Community string. The SNMP community string used to authenticate access to the Mobility Master.

n IP Address. Static IP address assigned to the Mobility Master.

3. Click the Folder drop-down menu to add the group to an AirWave folder.
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Figure 64: ConfiguringMobility Master

4. Click Save.

Step 4: Add the ArubaOS-CX Switch
In this step, add the ArubaOS-CX switches, which are the core and aggregation switches in the network, to
AirWave. I

If you add two ArubaOS-CX Switches individually and they are an aggregation pair, AirWave will later show them
asa pair on theDiscover/Deploy tab. The ArubaOS-CX Switches will be added to an auto-generated group
named "ZTP Orch. ArubaOS-CX".

To add the ArubaOS-CX switches:

1. In theNetwork Setup tab, click Add Mobility Master. The ArubaOS-CX window displays with required
fields outlined in red.

Figure 65: ArubaOS-CXWindow

2. Enter the following information:

n Community string. The SNMP community string used to authenticate access to the ArubaOS-CX switch.

n IP address. The IP address assigned to the ArubaOS-CX switch.

3. Click the Folder drop-down menu to add the group to an AirWave folder.
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Figure 66: Adding ArubaOS-CX

4. Click Save.

Deployment
After setting up the network, click theDiscover/Deploy tab at the top of the page to begin on-boarding the
access devices. First, you discover the access devices and then make bulk changes that include assigning the
access devices to groups, folders, and, in the case of access switches, Mobility Controllers.

l "Step 1: Deploying Mobility Controllers" on page 139

l "Step 2: Deploying ArubaOS-S Switches" on page 139

Step 1: Deploying Mobility Controllers
In this step, discover and then deploy Mobility Controllers. You must on-board Mobility Controllers first in order
for you to connect access switches to deployed Mobility Controllers in "Step 2: Deploying ArubaOS-S Switches"
on page 139.

Follow these steps to discover and deploy Mobility Controllers:

1. Select Mobility Controller for theChoose Device Type option.

2. Click Discover. AirWave discovers Mobility Controllers using LLDP and learns which ports on the Mobility
Controllers are connected to the ArubaOS-CX Switch.

3. Click to edit parameters for each Mobility Controller that you will deploy. Ensure that the IP address is
correct and a static IP address. Other parameters include the name, MAC address, netmask, gateway address,
folder, group, and MM node path.

4. If you changed any parameters in theMobility Controller window, click Save. After all the Mobility
Controllers are configured with a static IP address, proceed to the next step.

5. Click the check box at the top left corner of the device list to select all, or manually select the devices, then
click Deploy.

Step 2: Deploying ArubaOS-S Switches
In this step, you discover and deploy ArubaOS-S Switches. When deployed, AirWave sets the management mode
for the access switches to Manage/Read-Write.

To deploy ArubaOS-S Switches:

1. At the top of the page, select ArubaOS-S Switch for theChoose Device Type option.

2. Select the switch from theAggregation Switch drop-down menu.
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Figure 67: Aggregation Switch Selection

3. Click Discover. In this step, AirWave discovers the access switches using LLDP and learns which ports on the
access switches are connected to the ArubaOS-CX Switch.

4. You can click to edit parameters for each access switch that you will deploy, including:
n Name. The name of the ArubaOS-S Switch.

n Mobility Controller. The Mobility Controller that provides the user-based tunneling.

n Folder. The name of the device folder the switch is organized in.

n Group. The name of the ZTP group the switch belongs to for configuration management.

5. If you changed any parameters in theArubaOS-S Switch window, click Save.

6. Click the check box at the top left corner of the device list to select all, or manually select the devices; then do
the following steps:

a. Assign the access switches to a ZTP group by selectingAssign Group and the ZTP group from the drop-
down menus, and then click OK.

Figure 68: Adding Access Switches to a ZTP Group

b. Assign the access switches to a folder by selectingAssign Folder and the folder from the drop-down
menus, and then click OK.

c. Connect the access switches to the Mobility Controller by selecting Connect to MC and the Mobility
Controller from the drop-down menus, and then click OK.

d. Click Deploy, then click OK.

Automated Workflow
Now that you've launched the deployment, AirWave performs the following tasks:

l Push Mobility Controller details to Mobility Master so that Mobility Master can push configurations to the
Mobility Controller using ZTP

l Whitelist the access switch in ClearPass after Mobility Controller configurations synch successfully with
Mobility Master

l Connect factory-default access switch to LAG configured Aruba OS-CX aggregation switch. Aruba OS-CX
switch uses LLDP to gather information about the access switch and sends the details to AirWave
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l Generate the configuration template with LAG and user-based tunneling (UBT) configurations for the access
switch

l Whitelist the access switch in ClearPass after the access switch configuration synchs successfully with AirWave

Deployment Verification
You can view deployment status updates in real-time on theDiscover/Deploy tab by clickingAll (Summary).
The information displayed clears after 24 hours.

Figure 69: Deployment Summary

Groupsdisplayed on theNetwork Setup tab include groups added from theGroups > List page.

Post Deployment
After ZTP Orchestrator on-boards a device, AirWave updates the device count in the header statistics at the top
of the WebUI, as well as theDevice > List page. New devices can be managed and monitored using AirWave
and will be visible in the topology map.

Clients can start connecting to the newly deployed access switches, and all the devices will be dynamically
segmented. You can monitor segmented traffic from theHome > Traffic Analysis page.
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Chapter 6
Monitoring the Network

AirWave provides an easy-to-use interface that lets you monitor your entire access infrastructure. When you click
a device link from the device list, you can view the monitoring page for the device.

The following sections discuss various monitoring options in AirWave:

l "Monitoring Basics" on page 142

l "Monitoring Access Points, Mesh Devices, and Controllers" on page 147

l "Monitoring ArubaOS-CX and Mobility Access Switches" on page 164.

l "Monitoring ArubaOS Switches" on page 170.

l "Monitoring Controller Clusters" on page 193

l "Monitoring Clients" on page 196

l "Troubleshooting Client Issues" on page 206

Monitoring Basics
You can find the monitoring page by navigating to Devices > List and selecting a device from the list. Or, you
can hover the pointer over a device and click Monitor from the shortcut menu, as shown in Figure 70.

Figure 70: Opening theMonitoring Page for a Device

Here are some of the things you can view on or from theDevices > Monitor page:

l Device Information. The information displayed varies depending on the device type. See "Device Information
for Access Points, Mesh Devices, and Controllers" on page 147 or "Device Information" on page 164.

l Graphs. The graphs show historical data and help you identify trends and anomalies. When you hover the
pointer over a graph, a detailed pop up view displays. See "Graphs for Access Points, Mesh Devices, and
Controllers" on page 151 and "Graphs" on page 165.

l Detailed summary tables. Click theNeighbors tab, located above the device information, to access the
summary tables. You can monitor the nearest RF neighbors of an access point and the physical and virtual
interfaces on a switch. For information, see "Monitoring Access Points, Mesh Devices, and Controllers" on
page 147 and "Detailed Summary Tables" on page 165, respectively.

l Alerts. Click theAlerts & Events tab, located above the device information, to access the alert tables about
AirWave, Intrusion Detection System (IDS), RADIUS accounting, and RADIUS authentication issues. For
information about alert summaries, see "About Alerts" on page 308.
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l Events. Click theAlerts & Events tab to access the event tables for device events and recent AMP device
events. These tables also appear on the System > Event Log page. To learn more about these events, see
"Using the Event Log" on page 297.

From theDevices > Monitor page, you can:

l Use Quick Links. Open the WebUI for a controller in a pop up window, or run a command on a device. For
example, use the show stacking members command to verify the switches in a stack or the AP LED Blinking
Enable command to flash the LEDs on an AP.

l Locate a device. Search by typing the IP address, name, version, or other information. Results include
hypertext links to additional pages.

l Poll the device. Override the preset polling interval by clicking in the top right corner of the page.
AirWave refreshes all but rogue data. For information about polling multiple devices, see "Poll selected
devices" on page 82.

l Authenticate rogue devices found on wired networks. Look for unauthenticated devices in theConnected
Devices tables, then acknowledge them by modifying editable fields. Learn how to do this in "Monitoring
ArubaOS-CX and Mobility Access Switches" on page 164.

l Diagnose issues. Go to theClients > Diagnostics page, where you can check for network status, location,
trends, and alerts. Find more information about "Troubleshooting Client Issues" on page 206.

l Monitor a network interface for a wired device. Find more information about "Interfaces" on page 168.

l Go to Topology by clicking in the upper-right corner of the monitoring page to monitor or troubleshoot a
device or switch interface from the topology map. For more information, see "Using Topology" on page 274.

Customizing the Monitoring Page
You can adjust how much information displays in your tables, then filter the results. You can also categorize
information using groups.

First 25 Results
AirWave displays only 25 rows of information. To display a different number of entries per page, click and
select 10, 25, 50, 100, 250, or 500. Longer page lengths require more time for the page to load.

Creating Filtered Views
To create a new filtered view:

1. Navigate to a page that contains a default view list, such asDevices > List orRAPIDS > List.
2. In the Devices List, select New View from the Default View drop-down menu to create a filtered view.

3. In theName field, type the name for the filtered view.

4. If you want to give all users access to the filtered view, select Is Global. Only Administrators can edit global
filtered views.

5. Click to add device groups to the filtered view, or to remove them.
a. Scroll the list of parameters and select aDevice orRadio parameter.

b. If required, enter search parameters such as "=" to refine the filter parameters.

c. To create a filtered view with multiple filter parameters, click Add Filter again and define any additional
filter parameters. For example, to create a view that displays APs with more than zero clients but less than
five clients, you would need to create one filter with the parameters Clients > 0, and a second filter with
the parameters Clients < 5.
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6. Drag and drop data columns from theAvailable Columns list to theCurrent Columns list to select which
columns display in the view. You can reorder the columns in theCurrent Columns list by dragging and
dropping the data column to a different place in the list.

Figure 71: Customizing the View

7. Click OK.

Figure 72: Creating a Filtered View

The Devices List displays the new filtered view.

Figure 73: New Filtered View

Editing Filtered Views

You can edit a custom filtered view at any time, by selecting the view in the view list, then selecting the icon
and modifying filter parameters and column displays.

Icon Description

Click this icon to create a custom filtered view.

Click this icon to edit an existing custom filtered view.

Click this icon to clone a filtered view.

Click this icon to delete a custom filtered view.

Table 73: Filter icons
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Showing Filters, Clearing Filters, Resetting Grouping
To change how AirWave displays data, do any of the following:

l Click the column heading to sort the data. 

l Click at the top of column headings to filter the data.

l Click to add parameters to the table view.

l Click to remove filters and return to the default table view.

l Click if you no longer want to group capabilities in the table view.

Using Device Folders
Using folders, you can group your devices in order to manage device reporting, view statistics, and identify
status. You must use folders if you want to limit the APs and devices AirWave users can see.

Adding Device Folders
To add a device folder:

1. Go to Devices > List, scroll to the end of the Devices List and click Add New Folder at the bottom of the
page.

2. Enter text that describes the folder, such as APs in Sunnyvale if you want to organize the folders by device
location.

3. Select the parent folder, then click Add.

4. Select the parent folder. If the parent folder contains subfolders, you can create a hierarchical structure that
is manageable, for example, by location, building name, or room.

Figure 74 shows how to create the APs in Sunnyvale folder.

Figure 74: Adding a New Folder

Moving Folders
If you want to change the folder hierarchy, AirWave lets you move and rename folders.

To move folders:

1. Select the folder you want to move fromGo to folder at the upper left of theDevices page.

2. Scroll to bottom of the page and click .
3. Select the new parent folder and click Save.
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Expanding Folders
You can change the information displayed on theDevices > List and Clients > Connected pages by selecting a
folder at the top left corner of the page.

For example, if you select the Top folder and then click Down in the navigation bar, AirWave displays the 7 down
devices in the Top folder.

Figure 75: Collapsed View of the DownDevices in the Top Folder

When you select Expand folders to show all devices, AirWave displays an expanded view of all 13 down
devices in the Top folder and its subfolders.

Figure 76: Expanded View of DownDevices in the Top Folder and Subfolders

Changing Default Views
You can change the way AirWave displays default views in theDevices > List and Clients > Connected pages.
To change the default view, click theDefault Expansion orDefault Folder drop-down menus at the top right
corner of the page to change your view, as shown in Figure 77.

Figure 77: Default Expansion and Default Folder Options
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Default View
Options

Description

Default Expansion l Collapsed: AirWave shows details from the current folder. This view doesn't show
details from the subfolders.

l Expanded: AirWave shows details of the current folder and its subfolders.
l Remember Last: AirWave stores your last view and displays it for you again.
NOTE: The default expansion view affects the way AirWave displays the network on the
topology map. For more information about topology maps, see "Using Topology" on page
274.

Default Folder l Last Visited: AirWave displays the last folder you accessed.
l Folder: When you select a folder, AirWave limits the information displayed to devices

or clients in a specific folder.

Table 74: Ways to View Devices and Clients in Folders

Monitoring Access Points, Mesh Devices, and Controllers
TheDevices > Monitor page for APs, mesh devices, and controllers includes a graph for users and bandwidth.
The controller graph lists the APs connected to it, while the APs include a list of users it has connected. When
available, lists of CDP and RF neighbors are also listed.

For information about switch monitoring, see "Monitoring ArubaOS-CX and Mobility Access Switches" on page
164 and "Monitoring ArubaOS Switches" on page 170.

Device Information for Access Points, Mesh Devices, and Controllers
Table 75 describes the fields and information displayed in theDevice Info section for different models and
types of wireless devices.

Table 75: Device Information for Wireless Devices

Field Description

Status Displays the connection status between AirWave and the device:
l Up. Everything is working as it should.
l Down. Either AirWave can reach the device but can't speak with it using SNMP, or

AirWave is unable to reach the device or connect to it using SNMP.
NOTE: Verify that SNMP is enabled on the device. Many APs ship with SNMP
disabled. This usually means AirWave is blocked from connecting to the device or the
device needs to be rebooted or reset.

Configuration l Good means all the settings on the AP agree with the settings AirWave wants
them to have.

l Mismatched means there is a configuration mismatch between what is on the
AP and what AirWave wants to push to the AP. The Mismatched link directs you
to this specific Devices > Device Configuration page where each mismatch is
highlighted.

l Unknown means the device configuration has not yet been fetched (possible
issue with credentials).

l Verifying means that the device is fetching a configuration that will be compared
to the desired settings.

l Error indicates a problem with the device. This configuration is accompanied with
a description of the error.
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Field Description

Firmware Displays the firmware version running on the AP.

Newer AirMesh APs include the new bootloader APBoot. AirWave helps to identify
the new AirMesh APs from the old SKUs by displaying the bootloader information
here.

Licenses (Appears for
Arubacontrollers)

Selecting this link opens a pop-up window that lists the built-in licenses as well as
other installed licenses for this controller. This also shows whether any license has
expired.

Controller (Appears for APs) Displays the controller for the associated AP device as a link. Select the link to display
the Devices > Monitor page for that controller.

Mesh Gateway * Specifies the mesh AP acting as the wired connection to the network.

Mesh Mode* Specifies whether the AP is a portal device or a mesh node. The portal device is
connected to the network over a wired connection. A node is a device downstream of
the portal that uses wireless connections to reach the portal device.

Mesh ID * The name of the mesh device.

Google Earth* Selecting the Google Earth icon opens the mesh network view in Google Earth.

Type Displays the make and model of the device.

Last Contacted Displays the most recent time AirWave has polled the AP for information. The polling
interval can be set on the Groups > Basic page.

Uptime Displays the amount of time since the device has been rebooted. This is the amount
of time the device reports and is not based on any connectivity with AirWave.

LAN MAC Address Displays the MAC address of the Ethernet interface on the device.

Serial Displays the serial number of the device.

Radio Serial Displays the serial number of the radios in the device. This field is not available for all
APs.

Location Displays the SNMP location of the device.

Contact Displays the SNMP contact of the device.

IP Address Displays the IP address that AirWave uses to communicate to the device. AirWave
supports IPv4 or IPv6 addresses. This number is also a link to the AP web interface.
When the link is moused over a pop-up menu will appear allowing you to access the
device using HTTP, HTTPs, telnet or SSH.

For Arubacontrollers, if Single Sign-On is enabled for your role in this AirWave and
you have access to this controller, you will not have to enter the credentials for this
controller again after selecting this link.

Outer IP Public IP address for a RAP device.
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Field Description

Remote LAN IP LAN IP address for a RAP. This address is useful for troubleshooting from the local
network.

Quick Links Open controller UI: A drop-down menu that allows you to jump to the controller’s
WebUI in a new window.

For Arubacontrollers, if Single Sign-On is enabled for your role in AirWave and you
have access to this controller, you will not have to enter the credentials for this
controller again after selecting this link.

Run a command: A drop-down menu with a list of CLI commands you can run
directly from the Devices > Monitor page.

APs For controllers, displays the number of APs managed by this device at the time of the
last polling.

Clients Displays the total number of users associated to the device or its APs regardless of
which radio they are associated to, at the time of the last polling.

Usage Combined bandwidth through the device at time of polling.

Power Supply Displays the PoE type for the Instant AP.

Power Consumption Displays the power usage on the Instant AP.

Notes Displays notes entered for the device.

*These fields are only available for mesh APs. To see an example of mesh monitoring, see "Monitoring Mesh Devices" on page
160.
** These fields are only available for Instant APs.

AirWave allows you to execute show commands on some models of Aruba or HPE switches by clicking theRun
Command drop-down list on theDevices > Monitor page of the AirWave WebUI, and selecting a supported
show command. For a list of devices that support show commands via the AirWave Devices > Monitor page,
refer to the AirWaveSupported Infrastructure Devices document. For complete information about the output of
each command, refer to the documentation for that switch.

Radios
Table 76 describes the information in theRadio table for APs.

Field Description

Index The number of the radio, used to distinguish radios that may be of the same type on a device.

Name The Radio type (802.11a/b/g/n) as a link to the Radio Statistics page for that radio.

MAC address The MAC address of the corresponding radio in the AP.

Clients The number of users associated to the corresponding radio at the time of the last polling.

Table 76: Devices >Monitor > Radio Fields and Descriptions
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Field Description

Usage (Kbps) The amount of bandwidth being pushed through the corresponding radio interface or device at
the time of the last polling.

Channel The channel of the corresponding radio.

Tx Power Some devices report transmit power reduction rather than transmit power; no value is reported
for those devices.

Antenna Type Indicates Internal or External radio. For devices where antenna type is defined per AP, the same
antenna type will be listed for each radio.

Channel Width* The bandwidth of the channel used by 802.11 stations. Legacy devices use 20 MHz channels, and
newer devices that support the 802.11n standard can use 40 MHz channels to increase
throughput.

Mesh Links * The total number of mesh links to the device including uplinks and downlinks.

Role Whether the radio acts as a Mesh Node or Access

Active SSIDs The SSID(s) of the radio.

Table 76: Devices >Monitor > Radio Fields and Descriptions (Continued)

*These fields are only available for mesh APs. To see an example of mesh monitoring, see "Monitoring Mesh Devices" on page 160.

Wired Interfaces
Devices with wired interfaces (other than Aruba Instant APs) will display theWired Interfaces table, which is
described in Table 77:

Field Description

Name Displays the name of the interface.

MAC Address Displays the MAC address of the corresponding interface in the device.

Clients Displays the number of users associated to the corresponding interface at the time of the last
polling.

Type Indicates the type of interface - gigabit Ethernet or fast Ethernet for wired interfaces.

Admin Status The administrator setting that determined whether the port is on or off.

Operational
Status

Displays the current status of the interface. If an interface is Up, then AirWave is able to ping it
and fetch SNMP information. If the AP is listed as Down, then AirWave is either unable to ping the
interface or unable to read the necessary SNMP information from the device.

Duplex Duplex mode of the link, full or half.

Aruba Port Mode Either Active Standby (which provides redundancy so that when an active interface fails, the user
traffic can failover to the standby interface) or one of the forwarding modes (Split, Bridge).

Table 77: Devices >Monitor >Wired Interfaces Fields and Descriptions
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Field Description

Input Capacity The input capacity of the interface.

Output Capacity The output capacity of the interface.

Table 77: Devices >Monitor >Wired Interfaces Fields and Descriptions (Continued)

Graphs for Access Points, Mesh Devices, and Controllers
Figure 78 illustrates the interactive graphs available on this page. Use the drop down button next to the graph
title to select a different graph.

Figure 78: Interactive graphs for an Aruba controller

Table 78 describes the graphs on this page.

Graph Description

Clients Formerly Users. Shows the max and average client count reported by the device radios for a
configurable period of time. User count for controllers are the sum of the user count on the
associated APs. Check boxes below the graph can be used to limit the data displayed.

Usage Formerly Bandwidth. Shows the bandwidth in and out reported by the device for a configurable
period of time. Bandwidth for controllers is the sum of the associated APs. Check boxes below
the graph can be used to limit the data displayed.

Table 78: Devices >Monitor Graphical Data
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Graph Description

CPU Utilization
(controllers, Aruba
AirMesh, or the
Aruba Mobility
Access Switch only)

Reports overall CPU utilization (not on a per-CPU basis) of the device.

Memory Utilization
(controllers, Aruba
AirMesh, or the
Aruba Mobility
Access Switch only

Reports average used and free memory and average max memory for the device.

Table 78: Devices >Monitor Graphical Data (Continued)

Location
If the device is associated to a VisualRF map, this section of the page displays the device on the map. Click the
map to open it in VisualRF.

Connected Clients
Table 79 describes the fields and information displayed for theConnected Clients display.

Field Description

Username Provides the name of the User associated to the AP. AirWave gathers this data in a variety of ways.
It can be taken from RADIUS accounting data or traps.

Device Type The type of device the user is using as determined by the Device Type Rules set up by an
administrator in AMP Setup > Device Type Setup. For more information, refer to "Setting Up
Device Types" on page 60.

Role The role of the connected client such as employee, perforce, or logon (captive portal).

MAC Address Displays the Radio MAC address of the user associated to the AP. Also provides a link that redirects
to the Users > Detail page.

Radio Displays the radio to which the user is associated.

Association
Time

Displays the first time AirWave recorded the MAC address as being associated.

Duration Displays the length of time the MAC address has been associated.

Table 79: Devices >Monitor > Connected Clients Fields and Default Values
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Field Description

Auth Type Displays the type of authentication employed by the user. Supported auth types include:
l EAP—Extensible Authentication Protocol.
l RADIUS accounting—RADIUS accounting servers integrated with AirWave provide the RADIUS

Accounting Auth type
l WPA2—Wi-Fi Protected Access 2 encryption
l No Encryption

AirWave considers all other types as not authenticated.

The information AirWave displays in Auth Type and Cipher columns depends on what information
the server receives from the devices it is monitoring. The client devices may all be similar, but if the
APs to which they are associated are of different models, or if security is set up differently between
them, then different Auth Type or Cipher values may be reported to AirWave.

If all APs are the same model and all are set up the same way, then another reason for differing
Auth Types might be the use of multiple VLANs or SSIDs. One client device might authenticate on
one SSID using one Auth Type and another client device might authenticate on a second SSID
using a different Auth Type.

Cipher Displays the encryption or decryption cipher supporting the user, when this information is available.
The client devices may all be similar, but if the APs to which they are associated are of different
models, or if security is set up differently between them, then different Auth Type or Cipher values
may be reported to AirWave.

Auth Time Shows how long the user has been authenticated, in minutes. A negative number (such as -17 min)
indicates that the user has not authenticated for the duration displayed.

Signal Quality Displays the average signal quality the user experienced.

Usage Displays the average bandwidth consumed by the MAC address.

Goodput The ratio of the total bytes transmitted or received in the network to the total air time required for
transmitting or receiving the bytes. Note that this information is not available for Instant devices
running Instant releases prior to Instant 4.1.0.

Speed The packet and byte counts of data frames successfully transmitted to and received from
associated stations. Note that this information is not available for Instant devices running Instant
releases prior to Instant 4.1.0.

Location Displays the VisualRF box that allows users to view features including heatmap for a device and
location history for a user.

LAN IP
Addresses

Displays the IP assigned to the user MAC. This information is not always available. AirWave

can gather it from the ARP cache of switches discovered by AirWave. This column can
accommodate multiple IP addresses for a client if it has both IPv4 and IPv6.

LAN Hostnames The DNS hostname(s) broadcast by the client. This column can accommodate multiple hostnames
for a client if it has both IPv4 and IPv6.

Table 79: Devices >Monitor > Connected Clients Fields and Default Values (Continued)

AirMesh Links
If you are viewing an Aruba AirMesh device’s monitoring page, theMesh Links table displays information about
each mesh device linked to this device, as shown in Figure 79:
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Figure 79: Mesh Links Table on Devices > Monitor Illustration

RF Neighbors
This table displays information about other devices in the AP's RF neighborhood, including the name of the AP or
device, and the neighboring radio channel(s) and RSSI (in dBm) detected by the AP.

CDP Neighbors
TheDevices > Monitoring page for devices that support Cisco Discovery Protocol (CDP) may display
information for neighbor devices detected using CDP.

Wirelesscontrollers also include interface-specific data for wired interfaces on theDevices > Interfaces page.
Formore information, see "Monitoring ArubaOS-CX and Mobility Access Switches" on page 164

Viewing the Radio Statistics Page
The Radio Statistics page contains statistics for pinpointing network issues for Aruba APs and Cisco WLC thin APs
running firmware 4.2 or later.

Depending on the AP, assigned group profiles, and recent activity on a radio, you can evaluate:

l Recent and historical changes in the network

l Real-time statistics from the AP’s controller

l Actively interfering devices (requires that you set Aruba to Spectrum mode)

l Summary of major issues

To open the Radio Statistics page, navigate to theDevices > Monitoring page, then select the AP from the
Devices List. Or, in the monitoring page for the AP, locate the radio in the Radios table and click the hyperlink to
open the Radio Statistics page, as shown in Figure 80.

Figure 80: Accessing Radio Statistics from an AP Monitoring Page

Running Commands from the Radio Statistics Page
Adaptive Radio Management (ARM) provides automated channel optimization, transmit power adjustment and
channel width tuning for an individual AP or group of APs.

Startingwith ArubaOS 8.0, only standalone controllers support the Adaptive Radio Management (ARM)
feature.

To run a show command:

1. Navigate to theDevices > Monitoring page, then select the controller from the Devices List.

2. In the monitoring page for the controller, locate the radio in the Radios table and click the hyperlink to open
the Radio Statistics page.

AirWave 8.2.9 | User Guide Monitoring the Network | 154
Anexo 03 A 05 ITENS 21 E 22 (0592763)         SEI 0008478-63.2018.6.02.8000 / pg. 9667



155 | Monitoring the Network AirWave 8.2.9 | User Guide

3. Click Run a command and choose a command, as illustrated in Figure 81.

Figure 81: Running a show command

When this command is selected, a new browser window launches with the statistics in plain text. Other ARM- and
AirMatch-tracked metrics are visible in theRadio Statistics page for Aruba APs.

Issues Summary section
The Issues Summary section only displays when noise, client count, non-802.11 interfering devices, channel
utilization, usage, and MAC and PHY errors reach a certain threshold of concern, as described in Table 80 and
illustrated in Figure 82:

Issue Triggering Threshold

High Noise > -80

High Number of Clients > 15

High Channel Utilization > 75%

High Usage > 75% of max

Interfering Devices Detected Detected within the last 5 minutes

High MAC/Phy Errors > 1000 frames/sec

Table 80: Issues Summary labels and thresholds

Figure 82: Issues Summary Section Illustration

These issues highlighted in this section can be examined in detail using the corresponding interactive graphs on
the same page. See the "Radio Statistics Interactive Graphs" on page 156 section of this chapter for details.

802.11 Radio Counters Summary
This table appears for radios with 802.11 counters and summarizes the number of times an expected
acknowledgment frame was not received, the number of duplicate frames, the number of frames containing
Frame Check Sequence (FCS) errors, and the number of frame/packet transmission retries and failures. These
aggregate error counts are broken down by Current, Last Hour, Last Day, and Last Week time frames, as
illustrated in Figure 83.
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Figure 83: 802.11 Radio Counters Summary table

The frame- per-second rate of these and other 802.11 errors over time are tracked and compared in the 802.11
Counters graph on the same page.

Radio Statistics Interactive Graphs
Time-series graphs for the radio show changes recorded at every polling interval over time when polling with
either SNMP or AMON. Clients and Usage data are polled based on the AP's group'sUser Data Polling Period.
Channel, Noise, and Power are based on AP Interface Polling Period.  802.11 Counters data are based on the
APs group’s 802.11 Counters Polling Period.

Radio Noise and Radio Errors graphs are not supported for Autonomous Cisco Aironet APs.

The two graph panes enable simultaneous display of two different information sets, as detailed in the following
table:

Graph Title Description

Clients A line graph that displays the maximum users associated to the corresponding radio at
polling intervals over the time range set in the slider. Select Show All for other metrics
such as average users and max users for various individual devices.

Usage An area graph displaying the average bandwidth in each direction for the radio. Select
Show All for other metrics such as max bandwidth in and out, average and max
mesh/overhead or overhead bandwidth, and average/max Enet0.

Radio Channel An area graph that displays the channel changes (if any) of the radio over time. Frequent,
regular channel changes on an Aruba or Cisco WLC AP radio usually indicate that the
Adaptive Radio Management feature (ARM) in ArubaOS is compensating for high noise
levels from interfering devices.

Radio Noise An area graph that displays signal interference (noise floor) levels in units of dBm. Noise
from interfering devices above your AP’s noise threshold can result in dropped packets.
For ARM-enabled Aruba APs, crossing the noise threshold triggers an automatic channel
change.

Table 81: Radio Statistics Interactive Graphs Descriptions
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Graph Title Description

Radio Power A line graph that displays the average and maximum radio transmit power, between 0
and 30 dBm, over the time range set in the slider. You can adjust the transmit power
manually in the Devices > Manage page for this radio’s AP, or enable ARM on Aruba APs
to dynamically adjust the power toward your acceptable Coverage Index as needed. For
more information, see the Adaptive Radio Management chapter of the ArubaOS User
Guide.

Radio Errors A line graph displaying the frame reception rate, physical layer error rate (resulting from
poor signal reception or broken antennas), and the data link (MAC) layer (corrupt frames,
driver decoding issues) for the radio.

802.11 Counters A line graph that displays statistics such as frame rate, fragment rate, retry rate, duplicate
frame rate, and other metrics tracked by 802.11 counters.

Utilization Displays max and average percentages on this radio for busy, interfering receiving and
transmitting signals. Special configuration on the controller is required to enable this data.
Consult the Aruba and AirWave Best Practices Guide in Home > Documentation for details.
NOTE: (Aruba and Cisco WLC thin APs on supported firmware versions only)

Goodput Displays the max and average goodput values. Goodput is the ratio of the total bytes
transmitted or received in the network to the total air time required for transmitting or
receiving the bytes. The air time includes the retry effort taken for both successful and
dropped frames.

Table 81: Radio Statistics Interactive Graphs Descriptions (Continued)

Figure 84: Radio Statistics Interactive Graphs Illustration – Radio Power and Channel Utilization displayed

Recent ARM Events Log
If a radio references an active and enabled ARM profile and AirWave is enabled as a trap host, ARM-initiated
events are displayed in the ARM Events table with the original and modified values.

You can filter the results and export the table in CSV format. The columns and values are illustrated in Figure 85.
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Figure 85: ARM Events Table

The columns and values are described in Table 82.

Column Description

Time The time of the ARM event.

Trap Type The type of trap that delivered the change information. Current ARM trap types that
display in AirWave are:
l Power Change
l Mode Change
l Channel Change

Values that display in the following columns depend on the Trap Type.

Previous Tx Power Old value for transmit power before the Power Change event took place.

Current Tx Power New transmit power value after the change.

Previous Radio
Mode

Old value for radio mode before the Mode Change event took place.

Current Radio Mode New radio mode value after the change.

Previous Channel Old primary channel value before the Channel Change event took place.

Current Channel New primary channel value after the change.

Previous Secondary
Channel

Old secondary channel value (for 40Mhz channels on 802.11n devices) before the
Channel Change event took place.

Current Secondary
Channel

New secondary channel value after the change.

Change Reason If the noise and interference cause for the change can be determined, they will be
displayed here. Mode change reasons are not yet tracked.

Table 82: ARM Events table Columns and Values

For information about configuring AirWave as a trap host, see the Aruba and AirWave Best Practices Guide in
Home > Documentation.

Detected Interfering Devices Table
For Aruba APs running in Spectrum mode, the same non-802.11 interfering devices identified in the Issues
Summary section are classified in theDetected Interfering Devices table along with the timestamp of its last
detection, the start and end channels of the interference, the signal to noise ratio, and the percentage of time
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the interference takes place (duty cycle), as illustrated in Figure 86. This table can be exported to CSV format, and
the displayed columns can be moved or hidden as needed.

Figure 86: Detected Interfering Devices Table Illustration

Possible device types for theDetected Interfering Devices table include:

l Audio Device Fixed Freq

l Bluetooth

l Cordless Base Freq Hopper

l Cordless Phone Fixed Freq

l Cordless Phone Freq Hopper

l Generic Fixed Freq

l Generic Freq Hopper

l Microwave

l Microwave Inverter

l Unknown

l Video Device Fixed Freq

l Wi-Fi

l XBox Freq Hopper

Active BSSIDs Table
The Active BSSIDs table maps the BSSIDs on a radio with the SSID it broadcasts to the network, as illustrated in
Figure 87. This table appears only for Aruba AP radios.

Figure 87: Active BSSIDs Table Illustration

AirMatch Statistics for Mobility Master
AirMatch enhances ARM by analyzing the past 24 hours of RF network statistics and proactively optimizing the
network for the next day.

You can enable AirMatch on managed devices associated to Mobility Master running ArubaOS 8.0 or later.
AirMatch dashboard will be populated for ARM-enabled AOS 6.x controllers. Configure the AMP server as a trap
host to populate the "Channel Change Reasons" graph and "Channel Changes" in the AirMatch dashboard.
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For more information on AirMatch, refer to the RF Planning and Channel Management chapter in the ArubaOS
User Guide.

Monitoring Mesh Devices
The monitoring page for mesh devices includes basic device information at the top, two tables for Radios and
Wired Interfaces, and Clients, Usage, CPU Utilization, and Memory Utilization graphs. Under these graphs are a
list of associated Clients, Mesh Links, RF Neighbors, and other common event logs and information.

Figure 88: Devices > Monitor page for aMesh Device

These fields are described in detail in "Device Information for Access Points, Mesh Devices, and Controllers" on
page 147.

Setting up Spectrum Analysis
The spectrum analysis software modules available on many Aruba APs can examine the radio frequency (RF)
environment in which the Wi-Fi network is operating, identify interference and classify its sources.

The spectrum analyzer is used in conjunction with Aruba's Adaptive Radio Management (ARM) technology. While
the spectrum analyzer identifies and classifies Wi-Fi and non-Wi-Fi sources of interference, ARM automatically
ensures that APs serving clients will stay clear of interference.

Individual APs or groups of APs can be converted to dedicated spectrum monitors through the dot11a and
dot11g radio profiles of that AP or AP group, or through a special spectrum override profile.

Each 802.11a and 802.11g radio profile references a spectrum profile, which identifies the spectrum band the
radio will monitor and analyze, and defines the default ageout times for each monitored device type. By default,
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an 802.11a radio profile references a spectrum profile named default-a (which configures the radio to monitor
the upper channels of the 5 GHz radio band), and an 802.11g radio profile references a spectrum profile named
default-g (which configures the radio to monitor all channels the 2.4 GHz radio band).

Most interference will occur in the 2.4 GHz radio band.

For more information about Spectrum analysis and ARM technology, including a list of APs that support
spectrum analysis refer to the ArubaOS User Guide.

Spectrum Configurations and Prerequisites
The following prerequisites must be in place to configure an AP to run in Spectrum mode in AirWave:

l The AP must be in Manage Read/Write mode.

l The AP’s associated controller must have an RFprotect license and must be running ArubaOS 6.0 or later.

l Aruba GUI Config must be enabled for that AP’s group in theGroups > Basic page.

There are three main situations in which you would set one or more devices to Spectrum mode in AirWave:

l Aruba AP Groups running permanently with the default Spectrum profile

l Individual APs running temporarily in Spectrum mode while part of an Aruba AP Group set to ap-mode

l Controller-level Spectrum Overrides (an alternative to creating new Aruba AP groups or new radio profiles for
temporary changes)

Setting up a Permanent Spectrum Aruba AP Group
If you have multiple supported Aruba APs in multiple controllers that you want to run in Spectrum mode over
the long run, you create a special Aruba AP group and set up a profile that is set to spectrum-mode and
references the default Spectrum profile. Set up more than one profile if you want to utilize both radio bands in
Spectrum mode.

If you use an 802.11a or 802.11g radio profile to create a group of spectrum monitors, all APs in any AP group
referencing that radio profile will be set to spectrum mode. Therefore, best practices are to create a new 802.11a
or 802.11g radio profile just for spectrum monitors.

If Use Global Aruba Configuration is enabled in AMP Setup > General, create the configuration below, then
go to the controller group's Controller Config page and select the newly created Aruba AP Group.

Perform these steps to set the AP group to use the default Spectrum profile settings:

1. On theGroups > Controller Config page, click theAdd New Aruba Group button.

2. Give the new Group a name (such as Spectrum APs), and select the plus sign next to the 802.11a Radio
Profile field to create a new radio profile.

3. Enter a name under the General Settings section of Profiles > RF > 802.11a/g Radio.

4. In theOther Settings section, change theMode field from ap-mode to spectrum-mode, as illustrated in
Figure 89, and then select Save.
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Figure 89: Spectrummode in Controller Config

The above steps will use the defaults in the referenced Spectrum Profile. In most cases, you should not change
the settings in the default profile. If you must change the defaults, however, navigate to Groups > Controller
Config > Profiles > RF > 802.11a/g Radio > Spectrum page, and create a new Spectrum profile with non-
default settings.

If all of the devices in this Aruba AP Group are managed by the same controller and you want to temporarily
override one or more profile settings in your spectrum-mode APs, you can set up a controller override.

To disable spectrum mode in this group, change the referenced radio profile back to default.

Configuring an Individual AP to run in Spectrum Mode
If you want to temporarily set an individual radio in an AP to run in Spectrum mode without creating or changing
Aruba AP Groups or radio profiles, perform these steps to set up a Spectrum Override on a supported Aruba AP:

1. Navigate to Devices > List, right-click the Spectrum-supported AP in the Devices List, and then select Audit
from the shortcut menu. Or you can navigate to Devices > Config to access the Device Configuration page.

2. After reviewing the device configuration, set the AP to Manage Read/Write mode.

3. Select Yes on the Spectrum Override field for one or both radios, depending on the band and channels you
want it to analyze.

4. Select the band that should run in spectrum. If you selected the 5GHz band in the 802.11an Radio section,
choose the lower, middle, or upper range of channels that you want to be analyzed by this radio.

5. Select Save and Apply and confirm your edit. This overrides the current Mode setting for that AP (ap-mode
or am-mode).

After making this change, you can view theRadio Role field that will appear in theRadios section of the
Devices > Monitor page.

The new role, Spectrum Sensor, is a link to the Spectrum Analysis page for the controller that manages this AP,
as illustrated in Figure 90.
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Figure 90: Spectrum Analysis on Controller Dashboard

To disable Spectrum mode on this individual AP after it has collected data, return to theDevices > Manage
page for this AP and set the Spectrum Override field back to No.

Configuring a Controller to use the Spectrum Profile
You can use AirWave to customize individual fields in the profile instance used by a particular controller without
having to create new Aruba AP groups and new radio profiles. To do this, you can set a controller-level override
for its referenced Spectrum profile on theDevices > Manage page, as illustrated in Figure 91. This will affect all
Spectrum-supported APs managed by this controller.

Figure 91: Override Section of a Supported Controller's Manage Page

Perform these steps to override individual profile settings for an Aruba controller that is part of a spectrum-
mode Aruba AP group:

1. Select a Spectrum-supported Aruba controller that is referencing a Spectrum profile, and go to itsDevices >
Manage page. Set it to Manage Read/Write mode.

2. Under the Aruba Overrides section, click theAdd New Aruba Controller Override button.

3. In the Profile drop-down menu, select the Spectrum Profile type.

4. In the Profile Instance drop-down menu, select the instance of the Spectrum profile used by the controller.
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5. In the Field drop-down menu, select the setting you would like to change (such as an Age-Out setting or a
Spectrum Band), and enter the overriding value below it.

6. Select Add to save your changes.

7. Repeat this process to create additional overrides for this controller.

8. When you have finished, select Save and Apply.

You can also use the above procedure to turn on Spectrum mode for radio profiles on one particular controller,
or use the overrides to point your radio profile to a non-default Spectrum profile for just this controller.

Monitoring ArubaOS-CX and Mobility Access Switches
AirWave displays the detailed information and tools to help you monitor ArubaOS-CX and Mobility Access
Switches.

For information about these features, see the following sections:

l "Device Information" on page 164

l "Graphs" on page 165

l "Detailed Summary Tables" on page 165

For information on the general monitoring data that appears on theDevices > Monitor page for all device
types, see "Monitoring Basics" on page 142.

Device Information
Table 83 describes the device information that you see in the switch monitoring page for the ArubaOS-CX
Switches and Mobility Access Switches.

Field Description

Status Displays the connection status between AirWave and the wired device:
l Up. Everything is working as it should.
l Down. Either AirWave can reach the device but can't speak with it using SNMP, or AirWave is

unable to reach the device or connect to it using SNMP.
NOTE: When the device is down due to an SNMP get failed error, verify that SNMP is enabled
on the device and check the SNMP credentials that AirWave is using on the Devices > Manage
page. An ICMP ping failed error indicates that AirWave can't connect to the device, or the
device needs to be rebooted or reset.

Configuration l Good. All the settings on the device agree with the settings AirWave wants them to have.
l Mismatched. There is a configuration mismatch between what is on the device and what

AirWave wants to push to the device. The Mismatched link directs you to this specific Devices
> Device Configuration page where each mismatch is highlighted.

l Unknown. The device configuration has not yet been fetched, and there might be an issue
with credentials.

l Verifying. The device is fetching a configuration that will be compared to the desired settings.
l Error. Indicates a problem with the device. This configuration is accompanied with a

description of the error.

Firmware The firmware version running on the AP.
NOTE: Newer AirMesh APs include the new bootloader APBoot. AirWave helps to identify the new
AirMesh APs from the old SKUs by displaying the bootloader information here.

Table 83: Device Information for the ArubaOS-CX Switches and Mobility Access Switches
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Field Description

Upstream Device The upstream device (also called the CDP neighbor) that AirWave discovers using CDP, or, for
non-Cisco devices that AirWave supports, using bridge forwarding tables.

Upstream Port The upstream port on the device.

Type The make of the device.

Model The model of the device.

Last Contacted The most recent time AirWave has polled the device (see "Configuring Basic Settings for Device
Groups" on page 84 for information about the poll interval).

Switch Role The role of the device, which might, for example, be primary or secondary.

LAN MAC
Address

The MAC address of the Ethernet interface on the device.

Serial The serial number of the device.

Location The SNMP location of the device.

Contact The person to contact.

IP Address The IP address that AirWave uses to communicate with the device. This link provides access to the
web management interface. Hover your mouse to access the device using HTTP, HTTPs, telnet or
SSH.

Usage The combined bandwidth through the device at time of polling.

Table 83: Device Information for the ArubaOS-CX Switches and Mobility Access Switches (Continued)

Graphs
The following interactive graphs are available:

l Clients. This graph shows the maximum and average client count reported by the device.

l Usage. This graph shows the bandwidth in and out reported by the device.

l CPU utilization. This graph shows the overall CPU utilization (not on a per-CPU basis) of the device.

l Memory utilization. This graph shows the average used, free memory, and average max memory for the
device.

If you click a graph, a full size view opens. Click to choose which graph to display on the monitoring page.

Detailed Summary Tables
AirWave can help you monitor the wired infrastructure, providing detailed summary tables about your wired
network on theDevices > Monitor page. From this page, you can drill down into diagnostics, client details, and
interface monitoring pages from links found in these tables.

Neighbors
AirWave uses the source protocol (SNMP/HTTP or CDP/LLDP) to discover devices on the network and goes a
step further and discovers neighbors directly connected to a wired device.
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You can view information about all neighbors on theNeighbors table of the monitoring page, as shown in
Figure 92.

Figure 92: Neighbors Table

Table 84 describes theNeighbors table fields.

Table 84: Neighbors Table Fields and Descriptions

Field Description

Name Displays the name of the neighbor device. For example, a MAC address, hostname, or make and
model. If an IP address is known for the device, a link provides access to the monitoring page.

Neighbor Port Displays the port ID of the neighbor device.

Local Port Displays the port ID of the local device.

Address Type Displays the type of address of the neighbor device.

Address Displays the network address associated with the neighbor. This link provides access to the web
management interface. Hover your pointer over the to open a management window to the device
using HTTP, HTTPs, telnet or SSH.

Desc Specify a description that provides additional information about the neighbor device
(recommended).

Capabilities Displays the device type: router, switch, or none (information is not available)

Version Displays the software version running on the neighbor device.

CDP Version Indicates the software version running on the neighbor device.

Duplex Indicates the mode of operation of the connection: simplex, duplex, or half-duplex.

Power Drawn
(Watts)

Displays the amount of power used on the interface of the neighbor device.

VTP Mgmt
Domain

Displays the name of the group of VLANs associated with the neighbor device.

Sysname Displays the system name of the neighbor device.

Primary Mgmt
Address Type

Displays the type of address of the primary management interface.

Primary Mgmt
Address

Displays the network address of the primary management interface.
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Field Description

Secondary
Mgmt Address
Type

Displays the type of address of the secondary management interface.

Secondary
Mgmt Address

Displays the network address of the secondary management interface.

Physical
Location

Displays the location of the neighbor device.

Native VLAN Displays the ID number of the VLAN on the neighbor device.

Appliance ID Displays the ID number of the appliance.

VLAN ID Displays the ID number of the management VLAN on the neighboring device.

Last Change Indicates when the device was last seen.

MTU Specifies the largest packet size which can be received on the neighbor device.

Source Displays the protocol used for device discovery: CDP.

Connected Devices
AirWave detects authenticated and rogue devices and reports them in the Connected Devices table (see
Figure 93). AirWave also uses upstream data to calculate possible neighbors and reports these devices in the
Connected Devices table.

Most information will not be available for rogue devices. If you click and add a name, device type, location,
contact, or notes to a rogue device, the device will move to the client table and be considered an
unauthenticated client. The device category will change from device to client.

When AirWave discovers more than one MAC address from one port and none of the MAC addresses have
LLDP/CDP information, AirWave will list only one unknown device without a MAC address.

When AirWave discovers a switch that doesn't have a MAC address, it classifies the device as an unknown
client. You cannot authenticate the client by modifying the device because it doesn't have a MAC address
associated with it.

Figure 93: Connected Devices Table

Table 85: Connected Devices Fields and Descriptions

Field Description

MAC MAC address for the device. This link provides access to the diagnostics page for the client. Find
more information about "Troubleshooting Client Issues" on page 206.
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Field Description

Switch Port Port number associated with the device. This link provides access to the monitoring page for the
interface.

Name Name of the device. You can enter any name.

IP Address If the gateway is managed by AirWave, the IP address is shown here.

Classification Displays the classification of the device after AirWave detects the device:
l Authenticated Client. This link provides access to the Connected Client page.
l Client. This link provides access to the Rogue table, where you can identify the device.

Notes Notes to help you identify the client. You can enter anything.

Type Type of device. You can enter anything.

User Name Name that is used on the device for authentication.

User Role Identifies the role-based operations that can be performed on the device.

VLAN The number of the VLAN.

Stack Role In a stack of switches, the role can be: master.

Bandwidth The bandwidth used by the device. If the device supports bandwidth per MAC address, the
bandwidth shown is the total bandwith used by all attached devices.

Host Name The hostname of the neighbor device, which is retrieved from the DNS lookup.

Authen Type The authentication server type:
l Dot1x
l Captive Portal
l Local MAC Auth
l WPA-PSK

Interfaces
TheDevices > Interfaces page for managed switches and routers displays interface-specific data, graphs, and
detailed summary tables for any connected clients and wired clients. For stacked switches, the master switch
displays information for the interfaces of all the members, including its own.

From the Physical Interfaces and Virtual Interfaces tables, click any interface link to open the Interface
Monitoring page for that interface, as shown in Figure 94
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Figure 94: Opening theMonitoring Interface Page

Figure 95 shows an example of interface information for an Ethernet CSMA/CD interface.

Figure 95: Interface Information

Table 86 describes fields that you see in Interface Information for switches and routers.

Field Description

Operational
Status

Displays the operational state of the interface: Up or Down.

Type Type of interface.

MAC Address Displays the MAC address assigned to the interface.

Usage In Displays the incoming interface load in Kbps.

Admin Status Displays the configuration on the port: Up or Down.

Description Information about the interface.

Forwarding Mode Indicates whether the interface is configured as an access port with one VLAN or a trunk interface
with two or more VLANs.

Table 86: Interface Information Fields and Descriptions
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Field Description

Usage Out Displays the outgoing interface load in Kbps.

Last Contacted The most recent time AirWave has polled the interface.

Name Name of the interface. You can enter any name.

Table 86: Interface Information Fields and Descriptions (Continued)

Monitoring ArubaOS Switches
Available for ArubaOS-Switches, AirWave puts all your switch monitoring information into a single page. There
are horizontal tabs across the top of the page, so you don't have to scroll down to view the data.

You can open the switch monitoring page by navigating to Devices > List and selecting a switch from the list.
Or, from a topology map, hover over the device to access the quick link in the tooltip (see Figure 96).

Figure 96: Accessing aMonitoring Page from Topology

Getting Started
From the monitoring page for a switch or switch stack, you can view color-coded status, navigate using quick
links, and get details from tooltips.

Color-Coded Status
Color-coded thresholds and icons help you visualize status and hardware-related alerts. For information on the
threshold values that each color represents, see "Hardware Tab" on page 184.

For current device status, green text indicates whether the device is up (Figure 97).

Figure 97: Device Information

Gray text indicates that the switch is disabled, or the stack is active (Figure 98).
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Figure 98: Stack Information

Color-coded port status shows you the health of your ports (Figure 99).

Figure 99: Ports and Power over Ethernet (PoE) Status

Navigate Using Quick Links
Blue links let you navigate to group and folder monitoring pages; open a WebUI, CLI session, or the Intelligent
Management Center (see Figure 98). These quick links also let you switch between stack and stack member
monitoring pages .

In Figure 100, clicking the IP address link and selecting HTTPS will open a secure HTTP session with the stack
commander.

Figure 100: Accessing theWebUI from the Stack Information

When looking at a stack, AirWave will display information about each stack member in the Stack Member table at
the bottom of the Summary tab. You can easily go from one switch member to another in the stack by clicking
the blue stack member link to open the monitoring page for the stack member (see Figure 101).

Anexo 03 A 05 ITENS 21 E 22 (0592763)         SEI 0008478-63.2018.6.02.8000 / pg. 9684



Figure 101: Accessing theMonitoring Page for a Stack Member

If you navigate away from the monitoring page for the stack, you will see the stack name link in the upper-left
corner of the WebUI (see Figure 102). Click this link to return to the monitoring page.

Figure 102: Navigate Backwards from theMember to the Stack

Get Details from Tooltips
Find out details about power supplies, environmental information, memory and CPU consumption by pointing
your mouse over the statistics. When looking at the hardware status for the stack, icons and color-coded
thresholds are the same as for stand-alone switches, but AirWave displays the details for stack members (see
Figure 103). For more information about monitoring your hardware, see "Hardware Tab" on page 184.

Figure 103: Hardware Tooltips

Get details about usage and connected clients by pointing your mouse over the graphs. For more information
about monitoring connected clients, see "Connected Tab" on page 180.

Figure 104: ViewingGraph Tooltips

Back to the Top
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Summary Tab
The Summary tab is the central point for monitoring your switches and switch stacks. Track status like device
uptime, trunk and uplink connectivity, available power, number of fans present, environmental information, CPU
and memory usage. For stacks, you can see important information like member status, stack topology, and split
stacking policy.

Back to the Top

Ports Tab
With the Ports tab, AirWave displays the front panel of the switch, letting you visualize port status, hardware
status, and other properties. Select Ports at the top of the Switch Monitoring page to open the Ports tab.
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Figure 105: Ports Tab for a Switch Stack

See Port Counts
You can see from the colored numbers how many ports are up, down, disabled, or how many alerts are red and
require action.

You can also identify SFP ports on a Gigabit switch by their rectangular shape, and stack ports by their number.
For example, if there are Stack Ports 1, 2, 3, and 4, you'll see them labeled as S1, S2, S3, and S4 on the switch
faceplate, as shown in Figure 106.

Figure 106: Example of Stack Ports

Port status isn't available for stack ports.

Open a Port Status Pop-Up
You can point your mouse over the interactive faceplate to view port status, or click the port to view details and
graphs in a pop-up window, as shown in Figure 107. If you manage a large number of devices and you want to
collapse the view, click at the stack or member level.
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Figure 107: Opening the Ports Status Pop-up

Edit a Physical Interface
You can configure the port interface and add optional details using the Edit tool.

1. From the Ports tab, locate the interface in the Port table.

Figure 108: Selecting the Interface

2. Click to open the Edit Interface pop-up window.

3. Type a descriptive label to identify the port interface.

4. Type a port description that could be helpful for anyone tracing the port.

Figure 109: Edit Interface for a Port

5. Click Save.
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Get Interface Details
From the Ports table, you can see:

l Interface identified by the interface number.

l Port speed and duplex (data transfer operation), or mode.

l If available, the name of the interface entered on the Edit Interface pop-up.

l Type of port, such as gigabit Ethernet (gigabitEthernetT) and 10 gigabit Ethernet (tenGbE-T).

l If available, information about the interface entered on the Edit Interface pop-up.

l If available, the interface label.

l MAC Address assigned to the interface.

l Admin Status: up or down.

l Operational status of the interface: up or down.

l How many clients are connected to the device.

l If available, the incoming interface load in Kbps.

l If available, the outgoing interface load in Kbps.

l ID number of the native VLAN on the neighbor device.

l Ports that are part of the specific tagged VLAN.

l Input capacity of the interface in Mbps.

l Output capacity of the interface in Mbps.

l Maximum transaction unit (MTU) which can be received on the neighbor device.

l Port duplex mode, which can be set to auto-negotiate the duplex mode when the device makes a network
connection, or manually set to full or half-duplex mode.

l If the port is part of a trunk.

l If the port is part of a group of trunks.

PoE Tab
If the switch supports PoE, AirWave provides detailed information on the configuration, power usage, and
statistics of a selected port. Select PoE at the top of the monitoring page for the switch or stack to open the PoE
tab.
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Figure 110: PoE Tab

See PoE Statistics
High-level counts tell you the total power available, used, and remaining. When more power is required than
allowed for a device or port, AirWave will display a powered denied count.

Change the Faceplate Using Overlays
You can change the information you see in the faceplate by selecting the PoE status, PoE priority, or Power Class
overlays at the lower right corner of the faceplate.

In Figure 111, Ports B23 and B24 are online and not using power.

Figure 111: Power Status Overlay

In Figure 112, the power priority for all the PoE ports is low. If there is a power demand higher than the power
budget on the switch, Port B1 has priority over Port B24.

Figure 112: Power Priority Overlay

In Figure 113, all the PoE ports are designated as PoE Power Class 0 and must be allocated up to 12.95 W.
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Figure 113: Power Class Overlay

Get Port Details
From the Ports table (Figure 114), you can see :

l PoE configuration, including the PoE power, PLC class/type, power allocation method, current PoE port status,
power priority, pre-standard detection, and the maximum power draw allocated to a PD on a port.

l LLDP information, including whether the switch supports PoE negotiation over LLDP.

l Statistics like PSE reserved power, actual power drawn from the PD, over current count, power denied count,
PSE voltage, PD power draw, MPS absent count, short count, PSE TLV configured, and PSE TLV configured.

Figure 114: Ports Table

View Power Consumption
The Power Consumption graph shows you the maximum power and power in use on the PoE slot, as shown in
Figure 115.

Figure 115: Power Consumption Graph

Back to the Top

VLANs Tab
The VLANs tab shows all the details about the switch, including the configured VLANs and the port mappings for
both tagged and untagged VLANs. Selecting VLANs at the top of the monitoring page for the switch or stack
opens the VLANs tab.
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TheVLANs tab isn't available for members in the stack, and it is only available from the stack view.

Change the VLANs View in the Faceplate
You can change the VLANs view by select a VLAN from the VLANs table. AirWave highlights the tagged or
untagged ports in the faceplate.

In Figure 116, AirWave highlights tagged Ports 15 to 18 when you select VLAN 2.

Figure 116: Highlighting the Tagged Ports in the Faceplate

Get Trunk Details
If VLAN trunking information is available, AirWave displays a list of active trunks on the device or the configured
trunk groups. Active trunks are trunk groups that have ports assigned to them.

Get Virtual Interface Details
From the Virtual Interface table, you can see:

l Interface configuration, including the name, type of interface, MAC address, IP address and an alias, and the
IPv6 global unicast address.

l Status on the port and interface.

l If any, interface labels entered on the Edit Interface pop-up. For more information, see "Edit a Virtual
Interface" on page 179.

Edit a Virtual Interface
You can configure the virtual interface and add optional details using the Edit tool.

1. Navigate to the monitoring page of a switch that has a configured VLAN.

2. Select the VLANs tab, then scroll down the page to locate the interface in the Virtual Interfaces table.

3. Click to open the Edit Interface pop-up window.

Figure 117: Edit Interface

4. Type a descriptive label to identify the port interface.
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5. Type details in the Description field that could be helpful for anyone working with the device.

6. Click Save.

Connected Tab
When AirWave detects client devices connected to the switch and neighbors that are up or down stream, you can
access information about them from the Connected tab.

To view connected devices and neighbors:

1. From the navigation sidebar, go to Devices > List and select a switch from the list.

2. Select Connected at the top of the Switch Monitoring page.

Figure 118: Connected Tab

See Connected Device and Neighbor Counts
AirWave detects authenticated and rogue devices and reports them in the Connected Devices table. AirWave also
uses upstream data to calculate possible neighbors and reports these devices in the Neighbors table (see Figure
118).

Determine Which Device Is Connected to a Port
Mouse-over the port number to view status and connected devices. In Figure 119, you can see from the tooltip
information about the rogue and get the MAC address of the device from the Connected Devices table beneath
the faceplate.
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Figure 119: Viewing Connected Device Details from the Tooltip

View Dynamic Segmentation Information
In the switch plate view, you can see the pieces of the dynamic segmentation, and when you mouse over the
port, how many users are tunneled, user names, user roles, and IP address of the tunneled controller. shows an
example where 2 users are tunneled through Ports 1 and 2 (indicated by the green shaded area which extends
over the port number). Beneath the faceplate in the Connected Devices table, AirWave provides the
authentication type and MAC address links to the device.

Figure 120: Viewing the Connected Device Port

Get Connected Devices Details
Table 87 describes fields that you see in the Connected Devices table.

Table 87: Connected Devices Fields and Descriptions

Field Description

MAC MAC address for the device. This link provides access to the diagnostics page for the client (see
"Troubleshooting Client Issues" on page 206.

Switch Port Port number associated with the device. This link provides access to the monitoring page for the
interface.

Name Name of the device. You can enter any name.

IP Address If the gateway is managed by AirWave, the IP address is shown here.
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Field Description

Classification Displays the classification of the device after AirWave detects the device:
l Authenticated Client. This link provides access to the Connected Client page.
l Client. This link provides access to the Rogue table, where you can identify the device.

Notes Notes to help you identify the client. You can enter anything.

Type Type of device. You can enter anything.

User Name Name that is used on the device for authentication.

User Role Identifies the role-based operations that can be performed on the device.

VLAN The number of the VLAN.

Stack Role In a stack of switches, the role can be: master.

Bandwidth The bandwidth used by the device. If the device supports bandwidth per MAC address, the
bandwidth shown is the total bandwith used by all attached devices.

Host Name The hostname of the neighbor device, which is retrieved from the DNS lookup.

Authen Type The authentication server type:
l Dot1x
l Captive Portal
l Local MAC Auth
l WPA-PSK

Edit a Connected Device
AirWave doesn't gather much information about connected devices. If you edit a connected device, AirWave
reclassifies the devices as an unauthenticated client.

To edit a connected device:

1. Navigate to the monitoring page of a switch that has a connected device.

2. From the Connected tab, locate the device in the Connected Devices table.

3. Click to open the Edit Client pop-up.
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Figure 121: Editing the Connected Device

4. Add a name, device type, location, contact, or notes to the unknown device.

5. Click Save.

Get Neighbor Details
AirWave uses SNMP/HTTP or CDP/LLDP to discover devices on the network and goes a step further, discovering
neighbors directly connected to the switch. You can filter the Neighbors table to display neighbors connected to
the port.

Table 88 describes the Neighbors Table fields and descriptions.

Table 88: Neighbors Table Fields and Descriptions

Field Description

Name Displays the name of the neighbor device. For example, a MAC address, hostname, or make and
model. If an IP address is known for the device, a link provides access to the monitoring page for
the device.

Neighbor Port Displays the port ID of the neighbor device.

Local Port Displays the port ID of the local device device.

Address Type Displays the type of address of the neighbor device.

Address Displays the network address associated with the neighbor. This link provides access to the web
management interface. Hover your pointer over the to open a management window to the device
using HTTP, HTTPs, telnet or SSH.

Desc Specify a description that provides additional information about the neighbor device
(recommended).

Capabilities Displays the device type: router, switch, or none (information is not available)
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Field Description

Version Displays the software version running on the neighbor device.

CDP Version Indicates the software version running on the neighbor device.

Duplex Indicates the mode of operation of the connection: simplex, duplex, or half-duplex.

Power Drawn
(Watts)

Displays the amount of power used on the interface of the neighbor device.

VTP Mgmt
Domain

Displays the name of the group of VLANs associated with the neighbor device.

Sysname Displays the system name of the neighbor device.

Primary Mgmt
Address Type

Displays the type of address of the primary management interface.

Primary Mgmt
Address

Displays the network address of the primary management interface.

Secondary
Mgmt Address
Type

Displays the type of address of the secondary management interface.

Secondary
Mgmt Address

Displays the network address of the secondary management interface.

Physical
Location

Displays the location of the neighbor device.

Native VLAN Displays the ID number of the VLAN on the neighbor device.

Appliance ID Displays the ID number of the appliance.

VLAN ID Displays the ID number of the management VLAN on the neighboring device.

Last Change Indicates when the device was last seen.

MTU Specifies the largest packet size which can be received on the neighbor device.

Source Displays the protocol used for device discovery: CDP.

Hardware Tab
Color-coded thresholds show power status for power supplies, fans, and temperature on the Hardware tab, and
graphs show you overall CPU and memory usage (see Figure 122).

You can't customize hardware thresholds.
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Figure 122: Hardware Tab

Table 89 describes the color-coded thresholds and icons on the Hardware tab.

Status Power Supply Fan Memory CPU Temperature

Good All power supplies are
up.
NOTE: The status is OK
even if there are missing
power supplies.

All fans are up.
NOTE: The status is
OK even if there are
missing fans.

Usage is
< 75%.

Usage is <
75%.

The temperature
is in the range of 0° C
to 55 ° C.

Fair NA NA Usage is
between 75%
to 90%.

Usage is
between 75%
to 90%.

NA

Poor NA At least 1 fan is
down

Usage is
> 90%.

Usage is >
90%.

The temperature
is <0° C or > 55° C.

Info Missing power supplies. Missing or
removed fans.

NA NA Information is
unavailable.

Table 89: Hardware Status and Thresholds

Alerts & Events Tab
The Alerts & Events Tab provides monitoring information for the device (see Figure 123). AirWave can you alert
you to redundant power supply or 802.3bt failures and power consumption or interface outputs reaching
capacity.
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Figure 123: Alerts & Events Tab

Acknowledge an Alert
To acknowledge an alert:

1. Go to Devices > List, then select a switch from the list. For example, the status in Figure 124 shows 2 alerts
on the switch.

Figure 124: Viewing Alerts on the Summary Tab

2. Select theAlerts & Events tab near the top of the page. Information about the alerts are at the top of the
page, as shown in Figure 125.

Figure 125: Alerts Summary on the Alerts & Events Tab

3. Select the alert and click to acknowledge the alert (Figure 126).
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Figure 126: Acknowledging the Alert

4. Check the Alerts Summary table to confirm that AirWave cleared the alert (see Figure 127).

Figure 127: Confirming That the Alert Cleared

Troubleshooting Tab
Schedule commands to run automatically from the CLI, run commands on a device or a stack, and run cable tests
in the Troubleshooting tab.

Run a Command
AirWave put all the useful commands into a drop-down menu on the Troubleshooting tab.

To run a command:

1. Go to Devices > List, then select a switch from the list to monitor.

2. In the Troubleshooting tab, click the Command field and select one or more commands from the drop-down.

Figure 128: Selecting a Command

3. If you want to schedule a set of commands to run automatically at a specific time, select Auto Run and enter
a time interval.

4. Click Run. The output of the show tech statistics command in Figure 129 shows only 1 port transition in Port
A1.
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Figure 129: Viewing the CLI Output

5. Click to export the results to a text file, or click to clear the results.

Test a Cable
You can identify a faulty or miswired cable by running a cable test against one or more ports. The cable test
might stop or delay the network. AirWave will notify you if this happens.

To run a cable test:

1. Go to Devices > List, then select a switch from the list to monitor.

2. In the Troubleshooting tab, click Cable Test.
3. Select the ports from the faceplate. In Figure 130 shows that Ports A2, A3, and A4 will be tested.

Figure 130: Selecting Ports

4. Click Run.

Monitoring 7000 Controllers
AirWave provides WAN monitoring tools to help you monitor your remote branch network.

In order to use this feature, ensure that you have AMON enabled on the mobility controller. After you add the
controller as an Aruba device, you can begin monitoring the managed device. For more information, see
"Additional AMP Services" on page 29 and "Manually Adding Devices " on page 1.
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To open the WAN monitoring page:

1. Navigate to Devices > List and select a controller from the list.

2. Click theAdvanced Monitoring tab at the top of the monitoring page. Clicking the blueGo Back link at the
top left corner of the WAN Monitoring page will return you to the device monitoring page.

Figure 131: Accessing theWAN Monitoring Page

WAN monitoring is described in the following sections:

l "Summary Tab" on page 189

l "WAN Tab" on page 190

l "Tunnel Tab" on page 192

Port status isn't available for stack ports.

Summary Tab
The Summary tab is the central point for monitoring your Aruba 7000 Series Mobility Controllers. In addition to
device information, such as folder and group membership, firmware version, POE status, and modem status, you
can track uplink connectivity.

Figure 132: Device Information for an Aruba 7005Mobility Controller

The following graphs are available on the Summary tab:

l WAN Availability. This graph shows the branch gateway's WAN uplink availability for the selected time range.
Availability is determined by default gateway, monitored IP, and data VPN Concentrator reachability.

l VPN Hub Availability. This graph shows the VPN concentrator's tunnel availability. Availability is determined
by the probe settings configured using the Health Check option.
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l Aggr. WAN Usage. This graph shows the branch gateway's aggregate inbound and outbound traffic usage by
WAN interface. You can select "All Traffic" or "Internet vs VPN".

l Aggr. WAN Compression. This graph shows aggregate WAN compression details across all uplinks. The
average bandwidth savings is displayed as a percentage.

Figure 133:WAN Monitoring Graphs

WAN Tab
If the gateway is provisioned as a branch gateway, the WAN tab displays port status, summary information
about the WAN interfaces, and details further down the page.

See WAN Ports
You can see from the colored numbers how many ports are up, down, disabled, or how many alerts are red and
require action (see Figure 134).

Figure 134: Example of WAN Ports

Open the Port Details Pop-Up
You can point your mouse over the interactive faceplate to view port status, or click the port to view details and
graphs in a pop-up window (see Figure 135). You can also access the Port Details from the WAN Interface
Summary table at the bottom of the page.
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Figure 135: Opening the Port Details Pop-Up

To change the Port Details graphs, from the Port Statistics drop-down list:

l Select "Packets" to view the inbound and outbound packets for unicast, multicast, and broadcast traffic.

l Select "Errors" to view CRC errors, error frames, and collisions.

WAN Interface Summary
The WAN Interface Summary table lists port interfaces and provides the total number of WAN interfaces (see
Figure 136).

Figure 136:WAN Interface Table

The WAN interface summary table displays the following information:

l Port. Displays the port number as a hyperlink to the Port Details pop-up window.

l VLAN. Displays the VLAN ID.

l WAN Status. Displays the WAN port status.

l Speed & Duplex. Displays the uplink speed and duplex type.

l Oper. Status. Displays the operational status.

l MTU. Displays the MTU size on the port.

l Private IP. Displays the private IP address.

l Public IP. Displays the public IP address.

Get WAN Interface Details
You can select a port from the WAN Interface Details drop down to view the WAN interface details (see Figure
137).
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Figure 137: Selecting a Port

The following graphs are available on the WAN tab:

l Availability. Provides a graphical representation of the selected WAN interface's availability based on
reachability. The graph shows the selected WAN port's ability to reach its default gateway, monitored IP, and
VPN Concentrator.

l Throughput. Shows the throughput for the WAN interface in megabits per second.

l Usage. Shows the inbound and outbound traffic usage.

l WAN Compression. Shows the average bandwidth savings from data compression as a percentage.

l Latency. Shows the round-trip time of ping responses in microseconds.

l Jitter. Shows the variation in the delay times of received packets in microseconds.

l Packet Loss. Shows packet loss as a percentage.

l MOS Score. Shows the transport health score, ranging from 1 to 5.

Tunnel Tab
The Tunnel tab displays tunnel counts at the top of the page and details in a table (see Figure 138). For
information about the graphs on the page, see "Tunnel Details" on page 192.

See Tunnel Counts and Details

Figure 138: Tunnels Table

The Tunnels table lists the total number of tunnels and the following details:

l Tunnel. Displays the tunnel number.

l Status. Displays the status of the tunnel.

l WAN IP. Displays the WAN IP address.

l Peer IP. Displays the peer IP address.

l Last Changed Reason. Displays the reason for the last status change of the tunnel.

l Availability. Displays the percentage of time the tunnel was up.

l Uptime. Displays how long the tunnel was up.

Tunnel Details
You can select a tunnel from the drop down at the top left of the Tunnel Details section to view the tunnel
interface details (see Figure 139).
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Figure 139: Selecting a Tunnel

In addition to tunnel information, such as status, IP address, uplink port details, VLAN ID, availability, and
uptime, you can view the following graphs on the Tunnels tab:

l Throughput. Displays the inbound and outbound traffic rates for the tunnel.

l Latency. Displays the latency in microseconds.

l Jitter. Displays the jitter in microseconds.

l Packet Loss. Displays the packet loss as a percentage.

l MOS Score. Displays the transport health score, ranging from 1 to 5.

Monitoring Controller Clusters
After adding controller clusters to AirWave, you can get a quick cluster status on the Controller Clusters
dashboard. You will find a count of the controllers, APs and clients are associated with these clusters at the top
of the page and cluster information, including fault tolerance in the table beneath the counters.

You can access the Controller Clusters dashboard by navigating to Devices> Controller Clusters.

Figure 140: Controller Cluster Dashboard

Table 90 describes the fields in the Cluster table. You can select any column heading to sort the data, or enter a
text into the column search fields to filter the results.

Field Description

Cluster Name Name of the controller cluster.

Controller Count Number of controller in the cluster.

APs Number of APs associated to controller in the cluster.

Clients Number of clients connected to controller in the cluster.

Cluster Status An orange circle indicates that 1 or more cluster controllers is down.

A green circle indicates that all controllers are active

Table 90: Clusters Table
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Field Description

AP Capacity A green circle indicates that the cluster is below 60% AP capacity.

A yellow circle indicates that the cluster is between 60% and 80% AP capacity.

An orange circle indicates that the cluster is at greater than 80% AP capacity.

Client Capacity A green circle indicates that the cluster is below 60% client capacity.

A yellow circle indicates that the cluster is between 60% and 80% client capacity.

An orange circle indicates that the cluster is at greater than 80% client capacity.

Version Displays the ArubaOS version running on all the controllers in the cluster.

Free AP Count Indicates how many APs you can add to a controller before you must add another controller to
the cluster.

Hitless Failover Indicates whether the cluster can handle a hit less failover. The cluster must be L2-connected.

Max Controller
Failover

Indicates how many controllers can survive a failover.

Mobility Manager Displays the host name of the Mobility Master managing the cluster.

Action Let's you delete the cluster the cluster from AirWave.

Table 90: Clusters Table (Continued)

Viewing Details about the Controller Cluster
From the Clusters table, you can click on the cluster name to open theCluster Detail page, which displays
graphs, controller information, and cluster events.

Capacity Graphs
The graphs show:

l AP Capacity. This graph shows the percentage of a cluster's total AP capacity being used and the percentage
of AP capacity being used on each controller in the cluster.

l Client Capacity. This graph shows the percentage of a cluster's total client capacity being used and the
percentage of client capacity being used on each controller in the cluster.

Hover your mouse over any section of these graphs to view detailed statistics for that point in the graph. To
change the time interval displayed in this graphic, click the schedule toolbar at the top right corner of the page.

Controller Statistics
Table 91 describes the fields in the Controllers table. You can click any table heading to sort the table by that
column criteria, or enter a text string into the entry field at the top of any column to filter the table by that value.

Field Description

Name Name of the controller in the cluster.

Table 91: Controllers Table
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Field Description

IP IP address of the controller in the cluster.

Status An orange circle indicates that the controller is down.

A green circle indicates that the controller is active.

AP Capacity A green circle indicates that the controller is below 60% AP capacity.

A yellow circle indicates that the controller is between 60% and 80% AP capacity.

An orange circle indicates that the controller is at more than 80% AP capacity.

Client Capacity A green circle indicates that the controller is below 60% client capacity.

A yellow circle indicates that the controller is between 60% and 80% client capacity.

An orange circle indicates that the controller is at greater than 80% client capacity.

Role Displays the controller's role within the cluster, either Leader, Member, or Isolated Leader.

Type Displays the controller model type.

Version Displays the version of ArubaOS running on the controller.

Table 91: Controllers Table (Continued)

Monitoring Cluster Events
The Events table displays a description and timestamp for each cluster event. In Figure 141, you can see events
when a cluster member is deleted, crosses a capacity threshold, or changes its role within the cluster. For
information about creating a controller cluster trigger, see "Device Triggers " on page 300.

Figure 141: Cluster Events

Where to Find Additional Cluster Information
TheDevices > Monitor page also displays cluster information for controller and APs associated to a cluster.

l TheDevice Info section of the Devices > Monitor page for a cluster controller includes the name of the
cluster to which that controller belongs.

l TheDevice Info section of the Devices > Monitor page for an AP associated to a cluster controller displays
information about its active controller and its standby controller . Figure 142 shows theDevices > Monitor
page for an AP associated to a cluster member.
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Figure 142: Devices > Monitor page for an AP in a Controller Cluster

Monitoring Clients
Clients are the end-user devices that access the network through other devices monitored or managed by
AirWave. You can view summarized information about all the wired and wireless clients in a dashboard on the
Clients > Overview page.

Here are some of the things you can view on the dashboard:

l Graphs. The graphs show usage trends for all clients on your network. By default, these graphs show data
over the last two hours. You can click in the graph to view details in a popup window, or click
in the top right corner, to change the reported time interval.

l Watched Clients. If any clients are on the watched list, then a Watched Clients table displays on the Overview
page, as shown in Figure 143. You can click the client name link to go to theClients > Diagnostics page.
Find more information about "Troubleshooting Client Issues" on page 206.

Figure 143:Watched Clients Table

l Pie charts. The categories include operating system, device type, SSID, and WLAN vendor. You can click on the
chart or the interactive keys to view client details in a popup window, as shown in Figure 144. In the popup
window, hyperlinks enable you to drill down further into diagnostic pages, floor plans, and dashboards for
UCC, Traffic Analysis, and Clarity. For information about using UCC and Traffic Analysis, see "Using the UCC
Dashboard" on page 257 and "Monitoring Application Traffic" on page 256.

Figure 144: Drilling Down to Client Details

AirWave also provides several pages from the Clients menu which allow you to perform the following tasks:
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l "Monitoring Wired and Wireless Clients" on page 197

l "Monitoring Rogue Clients" on page 198

l "Supporting Wireless Guest Users" on page 199

l "Supporting VPN Users" on page 202

l "Monitoring RFID Tags" on page 203

For information about creating AirWave users and AirWave user roles, refer to:

l "Creating AirWave Users" on page 36

l "Creating AirWave User Roles" on page 38

Monitoring Wired and Wireless Clients
TheClients > All page shows all clients that AirWave monitors, including down clients.

TheClients > Connected page contains the following information:

l The Folder field shows the current folder of Connected Clients you are viewing. You can view users under a
particular folder from the Go to folder drop down menu.

l Links under the Folder fields showing the Total Devices,Mismatched, Clients, and Usage (a static,
unlinked statistic) summarize the device information for this folder. Select these links to open detail pages for
each:

n Total Devices redirects to theDevices > List for that folder,

n Mismatched redirects to the list in Devices > Mismatched for that folder.

n Clients refreshes the page but expands to include users in the subfolders.

l Interactive graphs display average and max Clients over time, and Usage in and out for the selected folder
over time.

n Select a time range option from the upper-right corner of the graphs.

n Select the WLANs drop down to view up to six clients, or select Total Clients.

n Click in a graph to view a pop-up of the graph.

l Below the Clients and Usage graphs is the list of connected users.

Thenumber of clients in AirWave can differ from the number of clients that you see on the controller. This is
becauseAirWave and the controller count clients differently. The controller counts connections to the network
asclients, while AirWave counts devices as clients. For example, in the case where a single device connects to
thenetwork multiple times, the controller will count one client for each connection that the device makes to
thenetwork. AirWave will only recognize the device as a single client, though, regardless of the number of
connections.

The columns in the default view of theClients > Connected and Clients > All pages are defined in AirWave
and cannot be modified. However, you can create a new view in each of these pages that returns custom
information based on the filter parameters and data columns you selected when creating that new view. For
more information, see "Creating Filtered Views" on page 143.

The information on this page can also be adjusted in the following ways:

l TheAlert Summary section displays custom configured alerts that were defined in the System > Alerts
page.

l Use the Filter icon ( ) next to certain columns (AP/Device, Role, VLAN, Connection Mode, and others) to
filter the results by one of the values under that column. You can filter the list by substring match under the
Username column.
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TheClients > Connected page includes SSID information for users, and can display wired users using remote
Access Point (RAP) devices in tunnel and split-tunnel mode.

Figure 145: Default View: Connected Clients Table

Field Description

AP/Device Displays the name of the AP to which the MAC address is associated as a link to this AP's
Devices > Monitor page.

Association
Time

The first time AirWave recorded the user for this association.

MAC Address The radio MAC address of the user associated to APs as a link to the Users > Detail page for
this user.

Role Specifies the role that the Aruba controller assigned to the connected user, such as
employee.

Username Displays the name of the user associated to the AP. AirWave gathers this data from device
traps, SNMP polling, or RADIUS accounting. User names appear in italics when a user name
for that MAC address has been stored in the database from a previous association, but
AirWave is not getting a user name for the current association. This may indicate that the
user has not yet been authenticated for this session or AirWave may not be getting a user
name from an external source.

Table 92: Default View: Connected Clients Table Fields and Descriptions

Monitoring Rogue Clients
You can view connected rogue clients in AirWave by navigating to Clients > Rogue Clients, as shown in Figure
146.

From the Rogue Clients page, you can:

l Click the MAC address of a rogue to classify the device on theClient > Client Details page.

l Click the Rogue AP link to review the AP Details, rogue associations, and discovery events on theRAPIDS >
Details page for the AP.
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Figure 146: Clients > Rogue Clients Page

Table 93 describes the fields on this page.

Field Description

MAC Address Displays the MAC address of the rogue client. Click on this to jump to the Clients >
Client Detail page for this rogue.

Username The user name associated with this client.

Rogue AP The name of the Rogue AP. Click on this to jump to the RAPIDS > Detail page for this
AP.

Device Type The type of device, such as iPhone, Windows 7, etc.

SSID The SSID of this client.

BSSID The BSSID of this client.

First Heard The date and time when this rogue client was first noticed.

Last Heard The date and time when this rogue client was last noticed.

Location If a location is available, you can click on this link to open the VisualRF floor plan and
location on which this client resides.

Connection Mode Shows the type of connection, such as 802.11n, 802.11b, etc.

Ch BW Shows the channel bandwidth for this rogue client.

Signal Shows the signal value for this rogue client.

SNR Shows the signal-to-noise ratio.

Channel Shows the channel on which this rogue client is broadcasting.

Table 93: Clients > Rogue Clients Fields

Supporting Wireless Guest Users
AirWave supports guest user provisioning for Aruba Networks, Dell Networking W-Series, Alcatel-Lucent, and
Cisco WLC devices. This allows frontline staff such as receptionists or help desk technicians to grant wireless
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access to WLAN visitors or other temporary personnel.

TheGuest User Preferences section on AMP Setup > Roles, as well as theClients > Guest Users subtab, will
not appear if Guest User Configuration is globally disabled in AMP Setup > General.

Perform the following steps in the pages described to configure these settings.

1. Navigate to theAMP Setup > Roles page and select theRead-Only Monitoring & Auditing role type.
Under the Guest User Preferences section, enableAllow creation of Guest Users.

2. Next, navigate to theAMP Setup > Users page and click Add to create a new user with the role that was just
created. Figure 147 illustrates this page.

Figure 147: AMP Setup > Users Page Illustration

3. The newly created login information should be provided to the person or people who will be responsible for
creating guest access users.

4. The next step in creating a guest access user is to navigate to theUsers > Guest Clients tab. From this tab,
you can add new guest users, you can edit existing users, and you can repair guest user errors.

This page displays a list of guest users and data, to include the expiration date, the SSID (for Cisco WLC) and
other information. Figure 148 illustrates this page, and Table 94 describes the information.
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Figure 148: Clients > Guest Users Page Illustration

Field Description

Repair Guest User
Errors

Sets AirWave to attempt to push the guest user again in an attempt to repair any errors
in the Status column.

Add New Guest
User

Adds a new guest user to a controller via AirWave

Username Randomly generates a user name for privacy protection. This name appears on the
Guest User detail page.

Name Displays the specified guest user name.

Enabled Enables or disables the user status. Set the status of the guest user as active (enabled)
or expired (disabled).

Email Displays the optional email address of the user.

Company Name Displays the optional company name for the user.

Sponsor Name Displays the name of the sponsor for the guest user. This setting is optional.

Expiration Displays the date the guest user's access is to expire.

WLAN Profile Select the SSID that the guest user can access. This setting applies to Cisco WLC only.

Status Reports current status by the controller. If error messages appear in this column, select
the user with the checkbox at left, and select the Repair guest user errors button.

Table 94: Clients > Guest Users Fields
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Guest users associated to the wireless network appear on the same list as other wireless users, but are
identified as guest users in theGuest User column. TheClient Detail page for a guest user also contains a
box with the same guest information that appears for each user on theClients > Guest Users list.

TheEnabled, Sponsor Name, WLAN Profile, and Status columns can be filtered using the funnel icon ( ).

5. To add a new guest user, select Add, and complete the fields illustrated in Figure 149. Table 94 above
describes most fields. The first three fields are required, and the remaining fields are optional.

Figure 149: Clients > Guest Users > Add New Guest User Page Illustration

To make theUsername or Password anonymous and to increase security, complete these fields then select
Generate. The anonymous and secureUsername and Password appear in the respective fields.

6. Select Add to complete the new guest user, or select Cancel to back out of new user creation. TheClients >
Guest Users page appears and displays results, as applicable.

Supporting VPN Users
TheClients > VPN Sessions page shows active VPN Sessions along with device type and HTTP fingerprinting
information.
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Figure 150: Clients > VPN Sessions Page Illustration

When a VPN user name is selected, a Clients > VPN User Detail page displays with current VPN sessions, a
user and bandwidth interactive graph, and a historical VPN sessions list table.

Monitoring RFID Tags
Radio Frequency Identification (RFID) uses radio wave tags to identify and wireless devices with radio waves.
Active tags have a battery and transmit signals autonomously while passive tags have no battery. RFID tags
often support additional and proprietary improvements to network integration, battery life, and other
functions.

Supported RFID tag vendors include: Aeroscout, Ekahau, Innerwireless-PanGo, Vestac, and Newbury.

TheClients > Tags page displays the RFID tags that are heard by thin APs and reported back to a controller that
AirWave monitors. Figure 151 shows an example of the list of tags.

To identify lost or stolen inventory, you can use the Inactive Tag trigger to generate an alert if a tag is not
reported to AirWave after an interval. For information about enabling this trigger, refer to "Client Triggers" on
page305.
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Figure 151: Tags Table

Table 95 describes the Tags table fields.

Field Description

Name User-editable name associated with the tag. Click the pencil icon to edit the name, or add notes to
the tag.

MAC
Address

MAC address of the AP that reported the tag.

Vendor Vendor of the tag. You can display all or filter by vendor.

Battery
Level

Displays battery information—filterable in drop-down menu at the top of the column; is not
displayed for Aeroscout tags.

Chirp
Interval

Displays the tag chirp frequency or interval, filterable from the drop-down menu at the top of the
column. Note that the chirp interval from the RFID tag influences the battery life of active tags as
well as search times. If a tag chirps with very long chirp interval, it may take longer time for the
location engine to accurately measure x and y coordinates.

Last
Seen

Date and time the tag was last reported to AirWave.

Closest
Device

The device that last reported the tag to the controller (linked to the AP monitoring page in
AirWave).

Table 95: Tags Table Information

Managing Mobile Devices with SOTI MobiControl and AirWave

Overview of SOTI MobiControl
SOTI MobiControl, the mobile device management platform for Windows Mobile, Apple, and Android devices,
has been integrated into AirWave to provide direct access to the MobiControl Web Console.

MobiControl runs on your Mobile Device Manager (MDM) server. This server provisions mobile devices to
configure connectivity settings, enforce security policies, restore lost data, and other administrative services.
Information gathered from mobile devices can include policy breaches, data consumption, and existing
configuration settings.

Refer to the following for additional information:

l "Prerequisites for Using MobiControl with AirWave" on page 205

l "Adding a Mobile Device Management Server for MobiControl" on page 205

l "Accessing MobiControl from the Clients > Client Detail Page " on page 206
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Prerequisites for Using MobiControl with AirWave
In order to use the MobiControl integration in AirWave, the following is required:

l An AirWave running version 7.2.3 or later

l An MDM server with SOTI MobiControl Console 8.0x

l A client device that is:

n associated with WLAN infrastructure managed by the AirWave server running 7.2.3 or later

n being actively managed by the SOTI MobiControl server

For more information about setting up MobiControl, please see http://www.soti.net/mc/help/.

In order to use SOTI MobiControl from within AirWave, you must first add your MDM server and designate it as a
MobiControl.

Adding a Mobile Device Management Server for MobiControl
1. To add an MDM server to AirWave, navigate to AMP Setup > MDM Server and click Add. Complete the

fields on this page. Table 96 describes the settings and default values:

Field Description

Hostname/IP
Address

The address or DNS hostname configured for your MobiControl Web Console.

Protocol Whether HTTP or HTTPS is to be used when polling the MDM server. The port on
which to connect to the MDM server is inferred from the protocol: with HTTP, AirWave
will connect to port 80 of the SOTI server; with HTTPS, AirWave will connect to port
443.

URL Context The URL context appended to the server URL to build the URL when connecting with
the SOTI server. For MobiControl v8.0x the default URL Context is MobiControlWeb.
For MobiControl v8.5x the default URL Context is MobiControl.

Enabled Whether this server can be polled by AirWave. Make sure it is set to Yes.

Username/Password The login credentials for accessing the web console of the MobiControl system.

Polling Period The frequency in which AirWave polls the MDM server. The default is 5 minutes.

Table 96: AMP Setup >MDM Server > Add Fields and Descriptions

2. When finished, select Add.

The list page for the MDM server also displays:

l Last Contacted – The last time AirWave was able to contact the MDM server.

l Errors – Issues, if any, encountered during the last contact.

During each polling period, AirWave will obtain a list of all device IDs and their WLAN MAC addresses. The
information about device OS, device OS Detail, Manufacturer, Model, Name are retrieved from MobiControl and
populated to theClients > Client Detail page for supported mobile devices. AView device in SOTI
MobiControl link provides direct access to the MobiControl Web Console for additional details about the device.
MobiControl information overrides data obtained from ArubaOS controllers running 6.0 or later.
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Accessing MobiControl from the Clients > Client Detail Page
In order to access the MobiControl web console for a SOTI-managed mobile device from within AirWave, follow
these steps:

1. Navigate to a page that lists clients. This can include:

l Clients > Connected or Clients > All
l Search results that display user MAC addresses

2. Select the MAC address in theClients list table. TheClients > Client Detail page displays.

3. Under the Classification field, select theView device in SOTI MobiControl link. A new window will display
the MobiControl Web Console for this device.

Troubleshooting Client Issues
AirWave enables you to monitor and diagnose end-user issues from theClients > Client Detail and Clients >
Diagnostics pages. The following sections describe typical tasks you can do.

l "Evaluating User Status" on page 206

l "Diagnosing Status and Connectivity" on page 210

Evaluating User Status
From theClients > Client Detail page, you can review device information for wired and wireless devices,
evaluate signal quality and usage graphs, and respond to alerts.

You can access this page by doing one of the following:

l Search for a user. In the resulting window, click the MAC address link.

l Click the MAC address link in theDevices > Monitor page, theClients > Connected page, or theClients >
All page.

illustrates a partial view of theClient Detail page.
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Here are some additional things you can do from theClients > Client Detail page:

l Location. If VisualRF is enabled, you can view a map of the user location and facility information.

l Watched List. You can add a client as a on a watched list, which enables you to track performance metrics for
selected clients. For example, you might have a user who repeatedly reports connectivity issues when moving
from one room to another. Adding this client to a watched list allows you to track client issues.

l Client Neighbors. You can monitor neighbors that AirWave discovers.

l UCC Calls. You can view call details for a client.

l Clarity. You can view a timeline of all phases of the client connecting to a network.

l Association History. For more information, see "Viewing the Client Association History" on page 209.

l Rogue Association History. For more information, see "Viewing the Rogue Association History" on page 209.

Enabling Mobile Device Access Control
Mobile Device Access Control (MDAC) secures, provisions, and manages network access for Apple® iOS and
other employee-owned mobile devices by enabling device fingerprinting, device registration, and increased
device visibility. For more information on MDAC, refer to http://www.arubanetworks.com/technology/mobile-
device-access-control/.

You can enable them by selecting the check box next to the Device Type, OS , OS Detail , and Manufacturer fields
on theClients > Client Detail page. To see more options, select the Show additional properties link, as
shown in Figure 152
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Figure 152: Showing Additional Properties

Classifying Aruba Devices
If you have deployed Arubacontrollers and have WMS Offload enabled on the network, theClients > Client
Detail page allows you to classify the device in theDevice Information section, and to push this configuration
to the controllers that govern the devices. The classifications are as follows:

l Unclassified—Devices are unclassified by default.

l Valid—If the Protect Valid Stations option is enabled, this setting designates the device as a legitimate
network device. When this Valid setting is pushed, this setting prevents valid stations from connecting to a
non-valid AP.

l Contained—When this status is pushed to the device, Aruba will attempt to keep it contained from the
network.

You can classify the user regardless of whether WMS Offload is enabled. If WMS Offload is enabled, the
classification will get pushed to the controller.

Quick Links for Clients on Aruba Devices
In Clients > Client Detail, the following two drop-down menus appear next to the Save button in theDevice
Info section:
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l Open controller web UI: A drop-down menu that allows you to jump to the controller’s WebUI in a new
window. Thin APs link to Controller > Access Points when not operating in mesh mode, or Controller >
Mesh Nodes otherwise. Controllers show several more pages in this menu (Security Dashboard, for
instance) if the controller is running ArubaOS version 6.1 or greater.

l Run a command: A drop-down menu with a list of CLI commands you can run directly from theDevices >
Monitor page.

Figure 153: OpenControllerWebUI and RunCommandMenus

Using the Deauthenticate Client Feature
Aruba and Cisco WLC running firmware version v4.0.0.0 or later support a Deauthenticate Client. You can enable
this feature in theCurrent Association section of theClients > Client Detail page (see Figure 154).

Figure 154: Deauthenticating the Client

Viewing the Client Association History
Past association details of a client are tracked in theAssociation History table, which is located under the
VisualRF illustration (if available) and theAlert Summary in theClient Detail page.

The columns in this table, shown in Figure 155, are the same as the fields in theCurrent Association section
for this user.

Figure 155: Client Association History Table

Viewing the Rogue Association History
Past association details of a rogue client are tracked in theRogue Association History table, which is located at
the bottom of theClients > Client Detail page.
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Figure 156: Rogue Association History Table

Diagnosing Status and Connectivity
AirWave looks at the client status and network connectivity and then puts them in an interactive dashboard.
Devices in the network can include clients, access points, switches, wireless controllers, and routers.

To view client diagnostics:

l Search for a user. In the resulting window, click the MAC address link.

l From the navigation bar, select Clients and then click the client's MAC address link from the client list.

l From the navigation bar, select Clients and click on the Clients pie chart. In the resulting window, click the
client's MAC address link.

Figure 157: Accesing Client Trend Charts from the Dashboard

All the information displayed on theClients > Diagnostics page depends on which icon you click at the top of
the dashboard. Here are some of the things you can view on theClients > Diagnostics page:

l Trend charts

l Summary details for UCC, Clarity, and Traffic Analysis

l Quality metrics

l Match events

l Device information for a client, AP, or controller

l Current association for a client

l Radio information for a wireless network

l Switch information

l Performance
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Chapter 7
Configuring and Managing Devices

This section contains the following topics describing individual device configuration within device groups:

l "Moving a Device from Monitor Only to Manage Read/Write Mode" on page 211

l "Configuring Device Settings" on page 212

l "Adding a Maintenance Window for a Device" on page 220

l "Creating Dynamic Variables" on page 221

l "Configuring Device Interfaces for Switches" on page 221

l "Individual Device Support and Firmware Upgrades" on page 223

While most device configuration settings can be efficiently managed by AirWave at a Group level, certain settings
must be managed at the individual device level. For example, because devices within a Group are often
contiguous with one another, and have overlapping coverage areas, it makes sense to manage these devices
individually to avoid RF interference.

Any changes made at an individual device level will automatically override Group level settings.

AirWave automatically saves the last 10 device configurations for reference and compliance purposes. Archived
device configurations are linked on theDevices > Device Configuration page and identified by name. By
default, configuration is tracked by the date and time it was created; device configurations are also archived by
date.

It is not possible to push archived configurations to devices, but archived configurations can be compared to the
current configuration, the desired configuration, or to other archived configurations using the drop-down menus
on theDevices > Device Configuration page. This applies to startup or running configuration files.

Compare two configurations to highlight the specific lines that are mismatched. The Device Configuration page
provides links to AirWave pages where any mismatched settings can be configured.

Moving a Device from Monitor Only to Manage Read/Write Mode
You can move the device to Manage Read/Write mode after you have verified any configuration mismatches
on theDevices > Device Configuration page, or you have confirmed that the device configuration status is
Good on theDevices > List page.

You can set multiple devices into Planned Maintenance Mode in theModify Devices link on an AP list page.
Formore information, refer to "Modifying Multiple Devices" on page 81.

To move a device to Manage Read/Write mode:

1. Go to theDevices > List page, then right-click on the device and select Manage to open the Manage page.

2. From the theGeneral area, select Manage Read/Write, as shown in Figure 158.
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Figure 158: Selecting theManagement Mode

3. Scroll down, then select Save and Apply.

4. Click Confirm Edit on the confirmation page to retain these settings and push the configuration to the
device.

5. For device configuration changes that require the device to reboot, use the Schedule function to push the
changes at a time when WLAN users will not be affected.

Usethe Enable Planned Maintenance Mode field in Devices > Manage > General to put this device into
planned maintenance. During the maintenance mode, no AP Down triggers will be deployed on these devices.
Userswill not be able to delete folders that contain devices in Planned Maintenance. The devices in Planned
Maintenancewill show the Up status, but will not be tracked in historical graphs and logs as Up. You can set
multipledevices into Planned Maintenance Mode in theModify Devices link on an AP list page. For more
information, refer to "Modifying Multiple Devices" on page 81.

Configuring Device Settings
The device settings on the Management page vary depending on the device vendor and model. If any changes
are scheduled for a device, you can view them in a Scheduled Changes section at the top of the page and click
the Job link to access to the System > Configuration Change Job Detail page.

Deviceswith dual radios display radio-specific settings in the Slot A and Slot B area. If a device is dual-radio
capablebut only has one device installed, AirWave manages that device as if it were a single slot device.

Devicesrunning Instant 8.5.0.0 or later display the "Sesimagotag Channel" option which configures the
communication channel used in electronic shelf labelling.

To configure device settings:

1. Navigate to Devices > List , then right click the device and select Manage from the shortcut menu to access
the Management page. Figure 159 shows a Management page for an AP.
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Figure 159: Example of aManagement Page for an AP

2. Locate theGeneral section for information about the device’s current status.

Table 97 describes the fields, information, and settings on the Management page.

Field Description

Name Displays the name currently set on the device.

Status Displays the current status of a device. If a device is Up, then AirWave is able to ping it
and fetch SNMP information from the device. If the device is listed Down then
AirWave is either unable to ping the device or unable to read the necessary SNMP
information from the device.

Configuration Displays the current configuration status of the device. To update the status, select
Audit on the Devices > Device Configuration page.

Last Contacted Displays the last time AirWave successfully contacted the device.

Type Displays the device type.

Controller Links to the controller that is monitoring this device.
NOTE: This field is visible for APs.

Firmware Shows the device firmware version.
NOTE: This field is visible for controllers and switches.

Table 97: Devices >Manage > General Fields and Descriptions
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Field Description

Group Links to the Group > Monitoring page for the device.

Template Displays the name of the group template currently configuring the device. This also
displays a link to the Groups > Template page.
NOTE: This field is only visible for APs that are managed by templates.

Folder Displays the name of the folder containing the device. Also displays a link to the
Devices > List page for the folder.

Management Mode Displays the current management mode of the device. No changes are made to the
device when it is in Monitor Only mode. AirWave pushes configurations and makes
changes to a device when it is in Manage Read/Write mode.

Enable Planned
Maintenance Mode

Put this device into planned maintenance. During the maintenance mode, no device
Down triggers will be deployed on these devices. Users will not be able to delete
folders that contain devices in Planned Maintenance. The devices in Planned
Maintenance will show the Up status, but will not be tracked in historical graphs and
logs as Up. You can set multiple devices into Planned Maintenance Mode in the
Modify Devices link on a device list page.

Notes Provides a free-form text field to describe device information.

Table 97: Devices >Manage > General Fields and Descriptions (Continued)

3. Review and provide the following information in the Settings area.

Table 98 describes field settings, default values, and information for the Settings section of this page.

Setting Default Device
Type

Description

Name None All User-configurable name for the device (max. 20
characters)

Domain Name None IOS Field populated upon initial device discovery or upon
refreshing settings. Enable this option from AMP Setup
> Network page to display this field on the Devices >
Manage page, with fully-qualified domain names for IOS
APs. This field is used in conjunction with Domain
variable in IOS templates.

Mesh ID None Mesh Text field for entering the Mesh ID.

Timezone None Instant Drop-down menu for specifying the controller timezone.

Syslog Server None Instant Text field for specifying the a Syslog server for the
controller.

RADIUS Server None Instant Text field for specifying the a RADIUS server for the
controller.

Table 98: Devices >Manage > Settings Fields and Default Values
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Setting Default Device
Type

Description

RF Band Selection All Instant Drop-down menu for specifying the RF Band on the
controller.

Location Read from
the device

All The SNMP location set on the device.

Latitude None All Text field for entering the latitude of the device. The
latitude is used with the Google Earth integration.

Longitude None All Text field for entering the longitude of the device. The
longitude is used with the Google Earth integration.

Altitude (meters) None All Text field for entering the altitude of the device when
known. This setting is used with the Google Earth
integration. Specify altitude in meters.

Group Default
Group

All Drop-down menu that can be used to assign the device
to another Group.

Folder Top All Drop-down menu that can be used to assign the device
to another Group.

Auto Detect
Upstream Device

Yes All Selecting Yes enables automatic detection of upstream
device, which is automatically updated when the device
is polled.

Selecting No displays a drop-down menu of upstream
devices.

Automatically
clear Down Status
Message when
device comes
back up

None All Whether the message entered in the Down Status
Message field should be removed after the device
returns to the Up status.

Down Status
Message

None All Enter a text message that provides information to be
provided if the device goes down.

Organization Read from
Device

Instant The Organization string of the IAP.

Aruba AP Group default All Specifies the Aruba AP Group in which this devices
resides.

Administrative
Status

Enable All Enables or disables administrative mode for the device.

Table 98: Devices >Manage > Settings Fields and Default Values (Continued)
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Setting Default Device
Type

Description

Mode Local All Designates the mode in which the device should
operate. Options include the following:
l Local
l H-REAP
l Monitor
l Rogue Detector
l Sniffer

Table 98: Devices >Manage > Settings Fields and Default Values (Continued)

4. Complete additional settings on theDevices > Manage page, to include H-REAP, certificates, radio settings,
and network settings. Table 99 describes many of the possible fields.

Forcomplete listing and discussion of settings applicable only to Aruba devices, see the ArubaDevice
ConfigurationGuide.

Setting Default Device
Type

Description

Mesh Mode Mesh AP Mesh
Devices

Drop-down menu specifies the mesh role for the AP as
shown:
l Mesh AP —The AP will act like a mesh client. It will use

other APs as its uplink to the network.
l Portal AP —The AP will become a portal AP. It will use

a wired connection as its uplink to the network and
serve it over the radio to other APs.

l Remote Portal AP —The AP will become a remote
portal AP. It will use a wireless connection as its uplink
to the network and serve it over the radio to other APs.

l None —The AP will act like a standard AP. It will not
perform meshing functions.

Mesh Mobility Static Mesh
Devices

Select Static if the AP is static, as in the case of a device
mounted on a light pole or in the ceiling. Select Roaming if
the AP is mobile. Two examples would be an AP mounted
in a police car or utility truck.

Table 99: Additional Settings
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Setting Default Device
Type

Description

Receive Antenna Diversity Cisco Drop-down menu for the receive antenna provides three
options:

Diversity —Device will use the antenna that receives the
best signal. If the device has two fixed (non-removable)
antennas, the Diversity setting should be used for both
receive and transmit antennas.

Right —If your device has removable antennas and you
install a high-gain antenna on the device's right connector
(the connector on the right side when viewing the back
panel of the device), use this setting for receive and
transmit.

Left —If your device has removable antennas and you
install a high-gain antenna on the device's left connector,
use this setting for both receive and transmit.

Transmit
Antenna

Diversity Cisco See description in Receive Antenna above.

Antenna
Diversity

Primary
Only

Symbol 4131 Drop-down menu provides the following options:

Full Diversity—The device receives information on the
antenna with the best signal strength and quality. The
device transmits on the antenna from which it last
received information.

Primary Only—The device transmits and receives on the
primary antenna only. Secondary Only: The device
transmits and receives on the secondary antenna only.

Rx Diversity—The device receives information on the
antenna with the best signal strength and quality. The
device transmits information on the primary antenna only.

Transmit Power
Reduction

0 Proxim Transmit Power Reduction determines the device's
transmit power. The max transmit power is reduced by the
number of decibels specified.

Table 99: Additional Settings (Continued)
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Setting Default Device
Type

Description

Channel 6 All Represents the device’s current RF channel setting. The
number relates to the center frequency output by the
device’s RF synthesizer.

Contiguous devices should be set to different channels to
minimize ‘crosstalk,’ which occurs when the signals from
APs overlap and interfere with each other. This RF
interference negatively influences WLAN performance.

802.11b’s 2.4-GHz range has a total bandwidth of 80-MHz,
separated into 11 center channels. Of these channels, only
3 are non-overlapping (1, 6, and 11). In the United States,
most organizations use only these non-overlapping
channels.

Transmit Power
Level

Highest
power level
supported
by the radio
in the
regulatory
domain
(country)

Cisco,
Symbol,
Proxim AP-
600, AP-700,
AP-2000
(802.11g)

Determines the power level of radio transmission.
Government regulations define the highest allowable
power level for radio devices. This setting must conform to
established standards for the country in which you use the
device. You can increase the coverage radius of the access
point by increasing the Transmit Power Level. However,
while this increases the zone of coverage, it also makes it
more likely that the device will interfere with neighboring
devices.

Supported values are: Cisco (100mW, 50mW, 30mW,
20mW, 5mW, 1mW) Symbol (Full or 50mW, 30mW,
15mW, 5mW, 1mW)

Radio Enabled Yes All The Radio Enabled option allows you to disable the radio's
ability to transmit or receive data while still maintaining
Ethernet connectivity to the network. AirWave will still
monitor the Ethernet page and ensure the device stays
online. Customers typically use this option to temporarily
disable wireless access in particular locations.

This setting can be scheduled at a device level or Group
level.
NOTE: You cannot disable radios unless rogue scanning is
disabled in Groups > Radio.

Use DHCP Yes All If enabled, the device will be assigned a new IP address
using DHCP. If disabled, the device will use a static IP
address. For improved security and manageability, disable
DHCP and using static IP addresses.

Table 99: Additional Settings (Continued)
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Setting Default Device
Type

Description

LAN IP None All The IP Address of the device Ethernet interface. If One-to-
One NAT is enabled, AirWave will communicate with the
device on a different address (the IP Address defined in
the Device Communication section).

If DHCP is enabled, the current assigned address will
appear grayed out and the field cannot be updated in this
area.

Subnet Mask None All Provides the IP subnet mask to identify the sub-network so
the IP address can be recognized on the LAN. If DHCP is
enabled, the current assigned address will appear grayed
out and the field cannot be updated in this area.

Gateway None All The IP address of the default internet gateway. If DHCP is
enabled, the current assigned address will appear grayed
out and the field cannot be updated in this area.

Table 99: Additional Settings (Continued)

5. Locate the Template Options area on theDevices > Manage page.

Thissection only appears for IOS APs, Symbol devices, and Aruba controllers in groups with Aruba GUI Config
disabled.

Table 100 describes field settings, default values, and additional information for this page.

Setting Default Device
Type

Description

WDS Role Client Cisco IOS
Wireless
LAN
Controllers
only

Set the WDS role for this device. Select Master for the WDS
master APs and Client for the WDS Client. Once this is done
you can use the %if wds_role= % to push the client, master, or
backup lines to appropriate WDS APs.

SSL Certificate None Cisco IOS AirWave will read the SSL Certificate off of the device when it
comes UP in AirWave. The information in this field will defines
what will be used in place of %certificate%.

Extra Device
Commands

None Cisco IOS Defines the lines that will replace the %ap_include_1%
variable in the IOS template. This field allows for unique
commands to be run on individual APs. If you have any
settings that are unique per device like a MOTD you can set
them here.

switch_command None Cisco
Catalyst
switches

Defines lines included for each of the members in the stack.
This field appears only on the master's Manage page. The
information in this field will determine what is used in place of
the %switch_command% variable.

Table 100: Devices >Manage > Template Options Fields and Default Values
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6. For Cisco WLC devices, go to the interfaces section of theDevices > Manage page. Select Add new
Interface to add another controller interface, or select thepencil icon to edit an existing controller interface.
Table 101 describes the settings and default values. For detailed descriptions of Cisco WLC devices supported
by AirWave, refer to the Cisco WLC product documentation.

Field Default Description

Name None The name of the interface on the controller.

VLAN ID None The VLAN ID for the interface on the controller.

Port None The port on the controller to access the interface.

IP Address None The IP address of the controller.

Subnet Mask None The subnet mask for the controller.

Gateway None The controller's gateway.

Primary and
Secondary DHCP
Servers

None The DHCP servers for the controller.

Guest LAN Disabled Indicates a guest LAN.

Quarantine VLAN ID Disabled Enabled indicates it is a quarantine VLAN; used only for H-REAP-
associated clients.

Dynamic Device
Management

Enabled When enabled, makes the interface an AP-manager interface. Cisco calls
this feature Dynamic AP Management.

Table 101: Devices >Manage > Interface Fields and Descriptions for CiscoWLC Devices

Adding a Maintenance Window for a Device
When you add a maintenance window for a device, AirWave changes the management mode to Manage
Read/Write and stops polling or monitoring the device.

AirWave will push the last saved configuration to the device, regardless of any pending changes to the group it
belongs to or its device settings. Ensure all device configurations stored in AirWave are saved before you
proceed.

It is recommended you change the management mode to Planned Downtime before you change the
maintenance window to prevent the device from enteringManage Read/Write mode. AirWave continues
monitoring these device while you configure the maintenance window.

You can also use theModify Devices link to add or delete maintenance windows on multiple devices at once.
This feature can also be used from the Master Console to set maintenance windows for multiple AirWave
servers.

To add a maintenance window:

1. Navigate to Devices > List , then right click the device and select Manage from the shortcut menu to access
the Management page.

2. Scroll down the Management page to theMaintenance Windows section.

3. Click Add.
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Figure 160: Adding aMaintenanceWindow for a Device

4. Enter a name for the maintenance window.

5. Select the frequency of the maintenance window.

6. Enter the start time and the duration of the maintenance window.

7. Click Add.

Creating Dynamic Variables
You can configure a template using dynamic variables, that you create on theDevice > Manage page.

If a variable with the same name exists at the template level and at the device level , AirWave gives precedence
to the dynamic variable created at the device level.

To create a dynamic variable:

1. Go to theDevice > List, and select a device.

2. Scroll down the page to Dynamic Variables, then click Add.

Figure 161: Adding Dynamic Variables

3. Enter the variable name and default value. The variable value can include a multiline string. You can't use
spaces, periods, or non-alphanumeric characters.

4. Click Save and Apply.

Configuring Device Interfaces for Switches
New physical and virtual interfaces are discovered using SNMP polling. SNMP/HTTP discovery scanning is the
primary method for discovering devices on your network, including rogue devices. Enable this scanning method
from theDevice Setup > Discover page.
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You can configure interface settings individually or in groups. For individual settings, select the pencil icon next
the interface name in AP/Devices > Interfaces. This takes you to the Interface Monitoring window which
may a slightly different appearance than Figure 162, depending on the device type, and whether you are
configuring a physical or virtual interface.

Figure 162: Editing a Switch Interface

To configure interfaces as a group, select Edit Interfaces above the Physical or Virtual Interfaces table as shown
in Figure 163.

Figure 163: Edit Multiple Interfaces

You will remain on the same page, but will have the option to make changes to the most commonly edited
settings in batch mode, as shown in Figure 164.
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Figure 164: Multiple Interface Editing Page Illustration

AirWave assembles the entire running configuration using templates and your modifications to these pages. For
a more detailed discussion on templates, see "Using Configuration Templates" on page 226.

Individual Device Support and Firmware Upgrades
Perform the following steps to configure device-level communication settings. The available device
communication fields will vary, depending on the device brand and model.

1. Locate theDevice Communication area on theDevices > Manage page.

2. Enter the credentials to be used to manage the device. Figure 165 illustrates this page.

Figure 165: Devices > Manage > Device Communication

3. Enter and confirm the appropriateAuth Password and Privacy Password.

4. Enter the appropriate SSH and Telnet credentials if you are configuring Dell, Aruba Networks, Alcatel-Lucent
or any Cisco device except Cisco WLAN controllers.

5. Select Apply, then Confirm Edit to apply the changes now.
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Some device configuration changes might require a system reboot, in which case you might schedule these
changesto occur when users will not be affected.

Click Update Firmware at the bottom right of the page to upgrade the device's firmware. This button is not
available if your device is in Monitor Only mode. TheUpdate Firmware button only appears if the AirWave
Administrator has enabled Allow firmware upgrades in monitor-only mode on theAMP Setup > General
page, and you are looking at an Devices > Manage page for a controller or autonomous AP that supports
firmware upgrades in AirWave. See the Supported Infrastructure Devices document on theHome >
Documentation page for a list of the AirWave-supported devices that can perform firmware upgrades. In most
cases, you cannot upgrade firmware directly on thin APs.

Figure 166 illustrates the page that opens and Table 102 describes the settings and default values.

Setting Default Description

Desired Version None Specifies the firmware to be used in the upgrade. Firmware can be
added to this drop-down menu on the Device Setup > Upload
Firmware & Files page.

Job Name None Sets a user-defined name for the upgrade job. Use a meaningful and
descriptive name.

Use /safe flag for
Cisco IOS firmware
upgrade command

No Enables or disables the /safe flag when upgrading IOS APs. The /safe
flag must be disabled on older APs for the firmware file to fit in flash
memory.

Email Recipients None Displays a list of email addresses that should receive alert emails if a
firmware upgrade fails.

Sender Address None Displays the From address in the alert email.

Table 102: Update Firmware Fields and Default Values
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Figure 166: Devices > Manage Firmware Upgrades

Initiating a firmware upgrade will change the Firmware Status column for the device to Pending in Devices >
List. You can review the status of all recent firmware upgrade jobs in System > Firmware Upgrade Jobs.
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Chapter 8
Using Configuration Templates

This section provides an overview and several tasks supporting the use of device configuration templates in
AirWave, and contains the following topics:

l "Group Templates" on page 226

l "Viewing, Adding and Editing Templates" on page 228

l "Configuring General Template Files and Variables" on page 231

l "Configuring Templates for Aruba Instant" on page 237

l "Configuring Templates for AirMesh" on page 238

l "Configuring Cisco IOS Templates" on page 238

l "Configuring Cisco Catalyst Switch Templates" on page 240

l "Configuring Symbol Controller / HPE WESM Templates" on page 240

l "Configuring a Global Template" on page 242

Group Templates
Templates are helpful configuration tools that allow AirWave to manage virtually all device settings. A template
uses variables to adjust for minor configuration differences between devices.

Supported Devices
You can create group templates on theGroups > Templates page for the following types of devices:

l 3Com

l Alcatel-Lucent

l Aruba

l Cisco Aironet IOS

l Cisco Catalyst switches

l Dell

l Enterasys

l HPE

l Motorola

l Nortel

l Siemens

l Trapeze

You can also create local templates in a subscriber group—using global groups does not mean that global
templates are mandatory

Usethe graphical Aruba config feature in support of Aruba devices, particularly for ArubaOS 3.3.2.x and later.
Referto the AirWave 8.2.6 Controller Configuration Guide for additional information.

Template Variables
A template uses variables to adjust for minor configuration differences between devices. You can use variables
to configure device-specific properties, such as name, IP address and channel, or group-level properties, such as
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SSID and RADIUS server.

The AirWave template understands these variables:

l %allowed_aps%
l %ams_identity%
l %antenna_receive%
l %antenna_transmit%
l %ap_include_1% through %ap_include_10%
l %ca_cert_checksum%
l %cck_power%
l %certificate%
l %cert_psk%
l %channel%
l %channel_width%
l %chassis_id%
l %clock_timezone%
l %contact%
l %controller_ip%
l %custom_variable_1% through %custom_variable_10%
l %domain%
l %enabled%
l %gateway%
l %guid%
l %hostname%
l %if interface=Dot11Radio0%
l %if interface=Dot11Radio1%
l %if ip=dhcp%
l %if ip=static%
l %if radio_type=a%
l %if radio_type=an%
l %if radio_type=b%
l %if radio_type=bgn%
l %if radio_type=g%
l %if wds_role=backup%
l %if wds_role=client%
l %if wds_role=master%
l %ip_address%
l %ip_address_a%
l %ip_address_b%
l %ip_address_c%
l %manager_ip_address%
l %master_ip%
l %netmask%
l %ofdmpower%
l %organization%
l %password%
l %power%
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l %radius_server_ip%
l %rf_band%
l %server_cert_checkstum%
l %syslocation%
l %syslog_server%
The variable settings correspond to device-specific values on theDevices > Manage configuration page for the
specific AP that is getting configured.

Changesmade on the otherGroup pages (Radio, Security, VLANs, SSIDs, and so forth) are not applied to any
APsthat are configured by templates.

Viewing, Adding and Editing Templates
AirWave displays the Information about the group template, such as the name, type of device, status, fetch date,
and version restriction.

The device type field displays the template that applies to APs or devices of the specified type. If (Any Model) is
selected for a vendor, then the template applies to all models from that vendor that do not have a version-
specific template defined. If there are two templates that might apply to a device, the template with the most
restrictions takes precedence.

Version restriction designates that the template only applies to APs running the version of firmware specified. If
the restriction isNone, then the template applies to all the devices of the specified type in the group. If there are
two templates that might apply to a device the template with the most restrictions takes precedence. If there is a
template that matches a devices firmware it will be used instead of a template that does not have a version
restriction.

When applicable, there is a notes section that lists devices that are active on the network with no template
available for the respective firmware. Select the link from this note to launch theAdd Template configuration
page for that device.

To view, add, and edit templates:

1. Go to theGroups > List page, then select a group.

2. Navigate to Groups > Templates.

3. From the Templates page (see Figure 167) do one of the following:

n Click Add to create a group template.

n Click to edit a group template.

Figure 167: Group Template Page

4. Refer to for help configuring the template and default values.
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5. Click Add to save the new template, or click Save if you made changes to an existing template.

6. To create a new template and add it to the AirWave template inventory, go to theGroups > List page, and
select the group name. TheDetails page appears.

7. Select Templates, and then Add.

8. Complete the configurations illustrated in Figure 168.

Figure 168: Groups > Templates > Add Template Page Illustration

The settings for theAdd a Template page are described in Table 103. Note that the fields can vary based on the
Group.
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Setting Default Description

Use Global
Template

No Uses a global template that has been previously configured on the
Groups > Templates configuration page. Available templates will
appear in the drop-down menu. If Yes is selected you can also
configure global template variables. For Symbol devices you can
select the groups of thin APs to which the template should be applied.
For more information about global templates, see "Configuring a
Global Template" on page 242.

Name None Defines the template display name.

AP Type Cisco IOS (Any
Model)

Determines that the template applies to APs or devices of the
specified type. If Cisco IOS (Any Model) is selected, the template
applies to all IOS APs that do not have a version specific template
specified.

Reboot APs After
Configuration
Changes

No Determines reboot when AirWave applies the template, copied from
the new configuration file to the startup configuration file on the AP. If
No is selected, AirWave uses the AP to merge the startup and
running configurations. If Yes is selected, the configuration is copied
to the startup configuration file and the AP is rebooted.

This field is only visible for some devices.

Restrict to this
version

No Restricts the template to APs of the specified firmware version. If Yes
is selected, the template only applies to APs on the version of
firmware specified in the Template Firmware Version field.

Template firmware
version

None Designates that the template only applies to APs running the version
of firmware specified.

Fetch Template from
Device

None Selects an AP from which to fetch a configuration. The configuration
will be turned into a template with basic AP specific settings like
channel and power turned into variables. The variables are filled with
the data on the Devices > Manage page for each AP.

Template Variables None Add variables to be used in the template for the group. Refer to
"Configuring General Template Files and Variables" on page 231 for
more information.

Group Template
Variables

Add variables to be used for a Group Template.

Thin AP Groups Configure a template for selected Thin AP groups.

AP Template Specify template variables specifically for APs.

Change credentials
the AMP uses to
contact devices after
successful config
push:

No Specify whether to change the credentials that AirWave uses to
contact devices after the configuration has been pushed. If this
option is enabled, then new credential information fields display.

Table 103: Groups > Templates > Add Template Fields and Default Values
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Setting Default Description

Community String None If the template is updating the community strings on the AP, enter the
new community string AirWave should use here. AirWave updates
the credentials it is using to communicate to the device after the
device has been managed.

Telnet/SSH
Username

None If the template is updating the Telnet/SSH user name on the AP,
enter the new user name AirWave should use here. AirWave updates
the credentials it is using to communicate to the device after the
device has been managed.

Telnet/SSH
Password

None If the template is updating the Telnet/SSH password on the AP, enter
the new Telnet/SSH password AirWave should use here. AirWave
updates the credentials it is using to communicate to the device after
the device has been managed.

enable Password None If the template is updating the enable password on the AP, enter the
new enable password AirWave should use here. AirWave updates the
credentials it is using to communicate to the device after the device
has been managed.

SNMPv3 Username None If the template is updating the SNMPv3 user name on the AP, enter
the new SNMP user name here. AirWave updates the credentials it is
using to communicate to the device after the device has been
managed.

Auth Password None If the template is updating the SNMPv3 auth password on the AP,
enter the new SNMP user name password here. AirWave updates the
credentials it is using to communicate to the device after the device
has been managed.

SNMPv3 Auth
Protocol

MD5 Specifies the SNMPv3 auth protocol, either MD5 or SHA-1.

Privacy Password None If the template is updating the Privacy Password on the AP, enter the
new password here. AirWave updates the credentials it is using to
communicate to the device after the device has been managed.

SNMPv3 Privacy
Protocol

DES Specifies the SNMPv3 Privacy protocol as either DES or AES. This
option is not available for all devices.

Table 103: Groups > Templates > Add Template Fields and Default Values (Continued)

Configuring General Template Files and Variables
This section describes the most general aspects of configuring AP device templates and the most common
variables:

l "Configuring General Templates" on page 232

l "Using Template Syntax" on page 233, including the following sections:

n "Using AP-Specific Variables" on page 233

n "Using Directives to Eliminate Reporting of Configuration Mismatches" on page 234

n "Using Conditional Variables in Templates" on page 235

n "Using Substitution Variables in Templates" on page 235
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Configuring General Templates
To prevent configuration changes from being applied to APs until you are sure you have the correct
configuration, work with a small group of access points that are in Monitor Only mode until you are familiar with
the template configuration process.

To configure templates within a group:

1. Select a group to configure, then select an AP from the group to serve as amodel AP for the others in the
group. Your selection should be configured with all the desired settings. If any APs in the group have two
radios, select a model AP that has two radios and that both are configured properly.

2. Go to Groups > Templates, then select Add to add a new template.

3. Select the type of device that will be configured by this template.

4. Select the model AP from the drop-down list, and select Fetch.

5. AirWave automatically attempts to replace some values from the configuration of that AP with variables to
enable AP-specific options to be set on an AP-by-AP basis. Refer to "Using Template Syntax" on page 233.

These variables are always encapsulated between % signs. On the right side of the configuration page is the
Additional Variables section. This section lists all available variables for your template. Variables that are in
use in a template are green, while variables that are not yet in use are black. Verify these substitutions to
ensure that all of the settings that you believe should be managed on an AP-by-AP basis are labeled as
variables in this fashion. If you believe that any AP-level settings are not marked correctly, please contact
Aruba customer support before proceeding.

6. Specify the device types for the template. The templates only apply to devices of the specified type.

n Specify whether AirWave should reboot the devices after a configuration push. If theReboot Devices
after Configuration Changes option is selected, then AirWave instructs the AP to copy the
configuration from AirWave to the startup configuration file of the AP and reboot the AP.

n If theReboot Devices after Configuration Changes option is not selected, then AirWave instructs the
AP to copy the configuration to the startup configuration file and then tell the AP to copy the startup
configuration file to the running configuration file.

n Use the reboot option when there are changes requiring reboot to take effect, for example, removing a
new SSID from a Cisco IOS device. Copying the configuration from startup configuration file to running
configuration file merges the two configurations and can cause undesired configuration lines to remain
active on the AP.

7. Restrict the template to apply only to the specified version of firmware. If the template should only apply to a
specific version of firmware, select Yes and enter the firmware version in the Template Firmware Version
text field.

8. Select Save and Apply to push the configuration to all of the devices in the group. If the devices are in
Monitor-only mode (which is recommended while you are crafting changes to a template or creating a new
one), then AirWave will audit the devices and compare their current configuration to the one defined in the
template.

If you set the reboot flag to No, then some changes could result in configuration mismatches until the AP is
rebooted.

For example, changing the SSID on Cisco IOS APs requires the AP to be rebooted. Two other settings that
require the AP to be rebooted for configuration change are Logging and NTP. A configuration mismatch
results if the AP is not rebooted.

If logging and NTP service are not required according to the Group configuration, but are enabled on the AP,
you would see a configuration file mismatch as follows if the AP is not rebooted:
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IOS Configuration File Template
…
(no logging queue-limit)
…

Device Configuration File on Devices > Device Configuration Page
…

line con 0
line vty 5 15

actual logging 10.51.2.1
actual logging 10.51.2.5
actual logging facility local6
actual logging queue-limit 100
actual logging trap debugging

no service pad
actual ntp clock-period 2861929
actual ntp server 209.172.117.194

radius-server attribute 32 include-in-access-req format %h
…
9. Once the template is correct and all mismatches are verified on theDevices > Device Configuration page,

navigate to Groups > Monitor and click at the right corner of the device list to select the devices to
change the management mode to Manage Read/Write. The AP pulls the new startup configuration file from
AirWave. For more information, see "Setting the Management Mode" on page 128.

You can set the management mode for individual devices from theDevices > Manage configuration page.
Formore information, see "Moving a Device from Monitor Only to Manage Read/Write Mode" on page 211.

Using Template Syntax
Template syntax is comprised of the following components, described in this section:

l "Using AP-Specific Variables" on page 233

l "Using Directives to Eliminate Reporting of Configuration Mismatches" on page 234

l "Using Conditional Variables in Templates" on page 235

l "Using Substitution Variables in Templates" on page 235

Using AP-Specific Variables
When a template is applied to an AP, all variables are replaced with the corresponding settings from theDevices
> Manage configuration page. This enables AP-specific settings (such as Channel) to be managed effectively on
an AP-by-AP basis. The list of used and available variables appears on the template detail configuration page.
Variables are always encapsulated between % signs. The following example illustrates this usage:

hostname %hostname%
…
interface Dot11Radio0
…
power local cck %CCK_POWER%
power local ofdm %OFDM_POWER%
channel %CHANNEL%

…
The hostname line sets the AP hostname to the hostname stored in AirWave.

The power lines set the power local cck and ofdm values to the numerical values that are stored in AirWave.
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Using Directives to Eliminate Reporting of Configuration Mismatches
AirWave is designed to audit AP configurations to ensure that the actual configuration of the access point exactly
matches the Group template. When a configuration mismatch is detected, AirWave generates an automatic alert
and flags the AP as having aMismatched configuration status on the user page.

However, when using the templates configuration function, there will be times when the running-config file and
the startup-config file do not match under normal circumstances. For example, the ntp clock-period setting is
almost never identical in the running-config file and the startup-config file. You can use directives such as
<ignore_and_do_not_push> to customize the template to keep AirWave from reporting mismatches for this
type of variance.

AirWave provides two types of directives that can be used within a template to control how AirWave constructs
the startup-config file to send to each AP and whether it reports variances between the running-config file and
the startup-config file as "configuration mismatches.” Lines enclosed in <push_and_exclude> are included in the
AP startup-config file but AirWave ignores them when verifying configurations. Lines enclosed in <ignore_and_
do_not_push> cause AirWave to ignore those lines during configuration verification.

Ignore_and_do_not_push Command
The ignore and do not push directive should typically be used when a value cannot be configured on the
device, but always appears in the running-config file. Lines enclosed in the ignore and do not push directive will
not be included in the startup-config file that is copied to each AP.

When AirWave is comparing the running-config file to the startup-config file for configuration verification, it will
ignore any lines in the running-config file that start with the text within the directive. Lines belonging to an
ignored and unpushed line, the lines immediately below the line and indented, are ignored as well. In the
example below, if you were to bracket the NTP server, the NTP clock period would behave as if it were bracketed
because it belongs with or is associated with the NTP server line.

Theline <ignore_and_do_not_push>ntp clock-period</ignore_and_do_not_push> will cause lines starting with
"ntp clock-period" to be ignored. However, the line <ignore_and_do_not_push>ntp </ignore_and_do_not_
push> causes all lines starting with "ntp" to be ignored, so it is important to be as specific as possible.

Push_and_exclude Command
Instead of using the full tags you may use the parenthesis shorthand, (substring). The push and exclude directive
is used to push commands to the AP that will not appear in the running-config file. For example, someno
commands that are used to remove SSIDs or remove configuration parameters do not appear in the running-
config file of a device. A command inside the push and exclude directive are included in the startup-config file
pushed to a device, but AirWave excludes them when calculating and reporting configuration mismatches.

Theopening tag may have leading spaces.

Below are some examples of using directives:
…
line con 0
</push_and_exclude>no stopbits</push_and_exclude>
line vty 5 15
!
ntp server 209.172.117.194
<ignore_and_do_not_push>ntp clock-period</ignore_and_do_not_push>
end
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Using Conditional Variables in Templates
Conditional variables allow lines in the template to be applied only to access points where the enclosed
commands will be applicable and not to any other access points within the Group. For example, if a group of APs
consists of dual-radio Cisco 1200 devices (802.11a/b) and single-radio Cisco 1100 (802.11b) devices, it is
necessary to make commands related to the 802.11a device in the 1200 APs conditional. Conditional variables
are listed in the table below.

The syntax for conditional variables is as follows, and syntax components are described in Table 104:
%if variable=value%
…
%endif%

Variable Values Meaning

interface Dot11Radio0 2.4GHz radio module is installed

Dot11Radio1 5GHz external radio module is installed

radio_type a Installed 5GHz radio module is 802.11a

b Installed 2.4GHz radio module is 802.11b only

g Installed 2.4GHz radio module is 802.11g capable

wds_role backup The WDS role of the AP is the value selected in the drop down menu on the
Devices > Manage configuration page for the device.

client

master

IP Static IP address of the device is set statically on the AP Manage configuration
page.

DHCP IP address of the device is set dynamically using DHCP

Table 104: Conditional Variable Syntax Components

Using Substitution Variables in Templates
Substitution variables are used to set AP-specific values on each AP in the group. It is obviously not desirable to
set the IP address, hostname, and channel to the same values on every AP within a Group. The variables in Table
105 are substituted with values specified on each access point’sDevices > Manage configuration page within
the AirWave User page.

Sometimes, the running-config file on the AP does not include the command for one of these variables because
the value is set to the default. For example, when the transmission power is set to maximum (the default), the
linepower local maximum will not appear in the AP running-config file, although it will appear in the startup-
config file. AirWave would typically detect and flag this variance between the running-config file and startup-
config file as a configuration mismatch. To prevent AirWave from reporting a configuration mismatch between
the desired startup-config file and the running-config file on the AP, AirWave suppresses the lines in the desired
configuration when auditing the AP configuration (similar to the way AirWave suppresses lines enclosed in
parentheses, which is explained below). A list of the default values that causes lines to be suppressed when
reporting configuration mismatches is shown in Table 105.
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Variable Meaning Command Suppressed
Default

hostname Name hostname %hostname% -

channel Channel channel %channel% -

ip_address
netmask

IP address
Subnet mask

ip address %ip_address%
%netmask% or ip address
dhcp …

-

gateway Gateway ip default-gateway
%gateway%

-

antenna_ receive Receive antenna antenna receive %antenna_
receive%

diversity

antenna_transmit Transmit antenna antenna transmit %antenna_
transmit%

diversity

cck_power 802.11g radio module CCK
power level

power local cck %cck_power% maximum

ofdm_power 802.11g radio module OFDM
power level

power local ofdm %ofdm_
power%

maximum

power 802.11a and 802.11b radio
module power level

power local %power% maximum

location The location of the SNMP
server.

snmp-server location
%location%

-

contact The SNMP server contact. snmp-server contact
%contact%

-

certificate The SSL Certificate used by
the AP

%certificate% -

ap include The AP include fields allow
for configurable variables.
Any lines placed in the AP
Include field on the Devices
> Manage configuration
page replace this variable.

%ap_include_1% through
%ap_include_10%

-

chassis id serial number of the device %chassis_id% -

domain dns-domain of the device %domain% -

interfaces Interfaces of the device %interfaces% -

Table 105: Substitution Variables in Templates
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Configuring Templates for Aruba Instant
The first Instant network that is added to AirWave automatically includes the default configuration that is used
as a template to provision other Instant networks. Refer to the documentation that accompanies Aruba Instant
for more information.

Besure that the default configuration is validated and has been pre-tested in a non-production environment
priorto applying it to a production network. Any changes that are made to this configuration will follow the
sameprocess each time and will be applied to other Instant networks as described in this document.

AirWave enables you to control Instant configuration settings via theGroups > Templates configuration page.
A sample configuration is provided below.

virtual-controller-country US
virtual-controller-key %guid%
virtual-controller-ip %ip_address_a_b_c%.3
name %hostname%
%if organization%
organization %organization%
%endif%
syslog-server 216.31.249.235
syslog-level debug
terminal-access
clock timezone Pacific-Time -08 00
rf-band 5.0
ams-ip %manager_ip_address%
ams-key %password%
allow-new-aps
%allowed_aps%
snmp-server engine-id undefined
arm
wide-bands 5ghz
min-tx-power 18
max-tx-power 127
band-steering-mode prefer-5ghz
air-time-fairness-mode fair-access
syslog-level warn ap-debug
syslog-level warn network
syslog-level warn security
syslog-level warn system
syslog-level warn user
syslog-level warn user-debug
syslog-level warn wireless
mgmt-user admin 446f8a8ddacdb735dd42a9873a2e80e2
wlan ssid-profile remote-node-guest
index 0
type employee
essid %ssid%
wpa-passphrase a804e1744c137371943bdeed410e720a58eca75717ff714b
opmode wpa2-psk-aes
rf-band all
captive-portal disable
dtim-period 1
inactivity-timeout 1000
broadcast-filter none
enet-vlan guest
wlan external-captive-portal
server localhost
port 80
url "/"
auth-text "%venue%"
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ids classification
ids
wireless-containment none

Configuring Templates for AirMesh
AirMesh devices can be configured using templates in AirWave. AirWave automatically adds a template for the
first AirMesh AP in a group. The configurations are pushed using CLI commands. The sample code below includes
Mesh configuration options.

mesh
mesh-id %mesh_id%
%preferred_link%
neighbor-list-type %neighbor_list_type%
authentication open key-management wpa2
psk ascii 5d4f50485e4f5048ed1da60b85f2784d6bbf16442fdcbfc06aeb4460d98263f5

neighbor-list
%neighbor_list%

service avt
%avt_ingress_interface%
%avt_ingress_ip%
buffer_time 200
mode %avt_mode%

AirWavedisplays a warning if AirMesh APs attempting to either upgrade or push configurations lack the
necessary write permissions.

Configuring Cisco IOS Templates
Cisco IOS access points have hundreds of configurable settings. AirWave enables you to control them via the
Groups > Templates configuration page. This page defines the startup-config file of the devices rather than
using the AirWave normalGroup configuration pages. AirWave no longer supports making changes for these
devices via the browser-based page, but rather uses templates to configure all settings, including settings that
were controlled formerly on the AirWave Group configuration pages. Perform these steps to configure a Cisco
IOS Template for use with one or more groups, and the associated devices.

This section includes the following topics:

l "Applying Startup-config Files" on page 238

l "WDS Settings in Templates" on page 239

l "SCP Required Settings in Templates" on page 239

l "Supporting Multiple Radio Types via a Single IOS Template" on page 239

l "Configuring Single and Dual-Radio APs via a Single IOS Template" on page 240

Applying Startup-config Files
Each of the APs in the Group copies its unique startup-config file from AirWave via TFTP or SCP.

l If theReboot Devices after Configuration Changes option is selected, then AirWave instructs the AP to
copy the configuration from AirWave to the startup-config file of the AP and reboot the AP.

l If theReboot Devices after Configuration Changes option is not selected, then AirWave instructs the AP
to copy the configuration to the startup-config file and then tell the AP to copy the startup config file to the
running-config file. Use the reboot option when possible. Copying the configuration from startup to running
merges the two configurations and can cause undesired configuration lines to remain active on the AP.
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Changesmade on the standard AirWave Group configuration pages, to include Basic, Radio, Security, VLANs,
and so forth, are not applied to any template-based APs.

WDS Settings in Templates
A group template supports Cisco WDS settings. APs functioning in a WDS environment communicate with the
Cisco WLSE via a WDS master. IOS APs can function in Master or Slave mode. Slave APs report their rogue
findings to the WDS Master (AP or WLSM which reports the data back to the WLSE. On theDevices > Manage
configuration page, select the proper role for the AP in the WDS Role drop down menu.

The following example sets an AP as a WDS Slave with the following lines:
%if wds_role=client%
wlccp ap user name wlse password 7 XXXXXXXXXX
%endif%

The following example sets an AP as a WDS Master with the following lines:
%if wds_role=master%
aaa authentication login method_wds group wds
aaa group server radius wds server
10.2.25.162 auth-port 1645 acct-port 1646
wlccp authentication-server infrastructure method_wds
wlccp wds priority 200 interface BVI1
wlccp ap user name wlse password 7 095B421A1C
%endif%

The following example sets an AP as a WDS Master Backup with the following lines:
%if wds_role=backup%
aaa authentication login method_wds group wds
aaa group server radius wds server
10.2.25.162 auth-port 1645 acct-port 1646
wlccp authentication-server infrastructure method_wds
wlccp wds priority 250 interface BVI1
wlccp ap user name wlse password 7 095B421A1C
%endif%

SCP Required Settings in Templates
A few things must be set up before enabling SCP on theGroups > Basic configuration page. The credentials
used by AirWave to login to the AP must have level 15 privileges. Without them, AirWave is not able to
communicate with the AP via SCP. The line "aaa authorization exec default local" must be in the APs
configuration file and the AP must have the SCP server enabled. These three settings correspond to the following
lines in the AP’s configuration file:

user name Cisco privilege 15 password 7 0802455D0A16
aaa authorization exec default local
ip scp server enable

The user name line is a guideline and will vary based on the user name being set, in this case Cisco, and the
password and encoding type, in this case 0802455D0A16 and 7 respectively.

These values can be set on a group wide level using Templates and TFTP. Once these lines are set, SCP can be
enabled on theGroups > Basic configuration page without problems.

Supporting Multiple Radio Types via a Single IOS Template
Some lines in an IOS configuration file should only apply to 802.11g vs. 802.11b. For instance, lines related to
speed rates that mention rates above 11.0Mb/s do not work for 802.11b radios that cannot support these
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speeds. Use the "%IF variable=value% … %ENDIF%" construct to allow a single IOS configuration template to
configure APs with different radio types within the same Group as illustrated below:

interface Dot11Radio0
…
%IF radio_type=g%
speed basic-1.0 basic-2.0 basic-5.5 6.0 9.0 11.0 12.0 18.0 24.0 36.0 48.0 54.0
%ENDIF%
%IF radio_type=b%
speed basic-1.0 2.0 5.5 11.0
%ENDIF%
%IF radio_type=g%
power local cck %CCK_POWER%
power local ofdm %OFDM_POWER%
%ENDIF%
…

Configuring Single and Dual-Radio APs via a Single IOS Template
To configure single and dual-radio APs using the same IOS config template, you can use the interface variable
within the %IF…% construct. The below example illustrates this usage:

%IF interface=Dot11Radio1%
interface Dot11Radio1
bridge-group 1
bridge-group 1 block-unknown-source
bridge-group 1 spanning-disabled
bridge-group 1 subscriber-loop-control
no bridge-group 1 source-learning
no bridge-group 1 unicast-flooding
no ip address
no ip route-cache
rts threshold 2312
speed basic-6.0 basic-9.0 basic-12.0 basic-18.0 basic-24.0 36.0 48.0 54.0
ssid decibel-ios-a
authentication open
guest-mode
station-role root

%ENDIF%

Configuring Cisco Catalyst Switch Templates
Cisco Catalyst Switch templates are configured much like Cisco IOS templates with the addition of the
interfaces and switch_command (for stacked switches) variables. Interfaces can be configured on the Device
Interface pages, as shown in "Configuring Device Interfaces for Switches" on page 221. You can import interface
information as described in this section or by fetching a template from that device, as described in "Configuring
General Templates" on page 232.

Just one template is used for any type of Cisco IOS device, and another is used for any type of Catalyst Switch
regardlessof individual model.

Configuring Symbol Controller / HPE WESM Templates
This section describes the configuration of templates for Symbol controllers and HPE WESM devices.

Symbol Controllers (RFS x000, 5100 and 2000) can be configured in AirWave using templates. AirWave supports
Symbol thin AP firmware upgrades from the controller’s manage page.
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A sample running-configuration file template is provided in this topic for reference. A template can be fetched
from a model device using the Cisco IOS device procedure described in "Configuring Cisco IOS Templates" on
page 238. Cisco IOS template directives such as ignore_and_do_not_push can also be applied to Symbol
templates.

Certain parameters such as hostname and location are turned into variables with the % tags so that device-
specific values can be read from the individual manage pages and inserted into the template. They are listed in
Available Variable boxes on the right-hand side of the template fields.

Certain settings have integrated variables, including alp-license and adoption-preference-id. The radio
preamble has been template-integrated as well. An option on theGroup > Templates page reboots the device
after pushing a configuration to it.

A sample Symbol controller partial template is included below for reference.
!
! configuration of RFS4000 version 4.2.1.0-005R
!
version 1.4
!
!
aaa authentication login default local none
service prompt crash-info
!
network-element-id RFS4000
!
user name admin password 1 5baa61e4c9b93f3f0682250b6cf8331b7ee68fd8
user name admin privilege superuser
user name operator password 1 fe96dd39756ac41b74283a9292652d366d73931f
!
!
access-list 100 permit ip 192.168.0.0/24 any rule-precedence 10
!
spanning-tree mst cisco-interoperability enable
spanning-tree mst configuration
name My Name
!
ip dns-server-forward
wwan auth-type chap
no bridge multiple-spanning-tree enable bridge-forward
country-code us
aap-ipfilter-list no port 3333 plz
aap-ipfilter-list no port 3333 tcp plz
deny tcp src-start-ip 0.0.0.0 src-end-ip 255.255.255.255 dst-start-ip 0.0.0.0 dst-end-ip
255.255.255.255 dst-start-port 3333 dst-end-port 3334 rule 1
%redundancy_config%
logging buffered 4
logging console 4
snmp-server engineid netsnmp 6b8b45674b30f176
snmp-server location %location%
snmp-server contact %contact%
snmp-server sysname %hostname%
snmp-server manager v2
snmp-server manager v3
snmp-server user snmptrap v3 encrypted auth md5 0x1aa491f4ca7c55df0f57801bece9044c
snmp-server user snmpmanager v3 encrypted auth md5 0x1aa491f4ca7c55df0f57801bece9044c
snmp-server user snmpoperator v3 encrypted auth md5 0xb03b1ebfa0e3d02f50e2b1c092ab7c9f

A sample Symbol Smart RF template is provided below for reference:
radio %radio_index% radio-mac %radio_mac%
%if radio_type=11a%
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radio %radio_index% coverage-rate 18
%endif%
%if radio_type=11an%
radio %radio_index% coverage-rate 18

%endif%
%if radio_type=11b%
radio %radio_index% coverage-rate 5p5

%endif%
%if radio_type=11bg%
radio %radio_index% coverage-rate 6

%endif%
%if radio_type=11bgn%
radio %radio_index% coverage-rate 18

%endif%
A sample Symbol thin AP template is provided below for reference and for the formatting of if statements.

radio add %radio_index% %lan_mac% %radio_type% %ap_type%
radio %radio_index% radio-number %radio_number%
radio %radio_index% description %description%
%if radio_type=11a%
radio %radio_index% speed basic6 9 basic12 18 basic24 36 48 54
radio %radio_index% antenna-mode primary
radio %radio_index% self-heal-offset 1
radio %radio_index% beacon-interval 99
radio %radio_index% rts-threshold 2345
radio %radio_index% max-mobile-units 25
radio %radio_index% admission-control voice max-perc 76
radio %radio_index% admission-control voice res-roam-perc 11
radio %radio_index% admission-control voice max-mus 101
radio %radio_index% admission-control voice max-roamed-mus 11
%endif%
%if radio_type=11an%
radio %radio_index% speed basic11a 9 18 36 48 54 mcs 0,1,2,3,4,5,6,7,8,9,10,11,12,13,14,15
%endif%
%if radio_type=11b%
radio %radio_index% speed basic1 basic2 basic5p5 basic11
%endif%
%if radio_type=11bg%
radio %radio_index% speed basic1 basic2 basic5p5 6 9 basic11 12 18 24 36 48 54
radio %radio_index% on-channel-scan
radio %radio_index% adoption-pref-id 7
radio %radio_index% enhanced-beacon-table
radio %radio_index% enhanced-probe-table
%endif%
%if radio_type=11bgn%
radio %radio_index% speed basic11b2 6 9 12 18 24 36 48 54 mcs
0,1,2,3,4,5,6,7,8,9,10,11,12,13,14,15
%endif%
radio %radio_index% channel-power indoor %channel% %transmit_power% %channel_attribute%
%detector%
%adoption_pref_id%
radio %radio_index% enhanced-beacon-table
radio %radio_index% on-channel-scan
%ap_include_4%

Configuring a Global Template
Global templates allow AirWave users to define a single template in a global group that can be used to manage
member devices. They turn settings like group RADIUS servers and encryption keys into variables that can be
configured on a per-group basis.
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If a variable with the same name exists at the template level and at the device level , AirWave gives precedence
to the dynamic variable created at the device level.

To create global templates, or edit global templates:

1. Go to theGroups > List, and select a device group.

2. From the AirWave navigation pane, select Templates.

3. In the Templates page, click Add. Or, click to edit a template.
4. Select a device as a model for the global template

Figure 169: Selecting the Device

5. Click Fetch. The fetched configuration populates the template field.

Figure 170: Fetching the Device Configuration

6. If you want to use a template variable with the configuration template, click Add at the bottom left of the
Template Variables section. You can also populate global template variables by uploading a CSV file (see step
10 on page 244).

7. Enter the variable value and default value. The variable value can include a multiline string. You can't use
spaces, periods, or non-alphanumeric characters. You can change the default value later for the group
template.

Figure 171: Adding a Template Variable

8. Once you have configured your global template, select Add. Or click Save if you made changes to an existing
template. You are redirected to a confirmation configuration page where you can review your changes.

9. Click Apply Changes Now.
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10.After you created the global template, you can use a CSV upload option to configure global template
variables. Go to theGroups > Templates configuration page and select theCSV upload icon for the
template. The CSV file must contain columns forGroup Name and Variable Name. All fields must be
completed.

n Group Name—the name of the subscriber group that you wish to update.

n Variable Name—the name of the group template variable you wish to update.

n Variable Value—the value to set.

For example, for a global template with a variable called "ssid_1", the CSV file might resemble what follows:
Group Name, ssid_1
Subscriber 1, Value 0

11.Once you have defined and saved a global template, it is available for use by any local group that subscribes
to the global group. Go to theGroups > Template configuration page for the local group and select the
pencil icon next to the global template in the list.

12.To make template changes, go to theGroups > Template configuration page for the global group and select
thepencil icon next to the template you wish to edit. Note that you cannot edit the template itself from the
subscriber group'sGroups > Templates tab.

13.If group template variables have been defined, you are able to edit the value for the group on theGroups >
Templates > Add configuration page in theGroup Template Variables box. For Symbol devices, you are
also able to define the template per group of APs.
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Chapter 9
Using the Home Pages

The Home Overview page provides access to live monitoring of network components and other functions.
AirWave includes the following live monitoring features:

l "Monitoring Your Network Health" on page 254

l "Monitoring Application Traffic" on page 256

l "Using the UCC Dashboard" on page 257

l "Viewing RF Performance" on page 261

l "Viewing RF Capacity" on page 262

l "Using the AirMatch Dashboard" on page 263

l "Using Clarity" on page 266

l "Using Topology" on page 274

l "Viewing Network Deviations" on page 264

This chapter also provides the following information:

l "Accessing AirWave Documentation " on page 288

l "Working with Licenses" on page 288

l "Configuring User Information and Customizing the WebUI" on page 290

Customizing the Dashboard
You can customize the dashboard so you see only what you want in your reports with widgets.

To customize the dashboard:

1. Navigate to Home > Overview, then click at the upper-right corner of the page.
2. Drag and drop widgets from theAvailable Widgets list and an open space on the dashboard within

gridlines. The widget label turns orange if you place it over occupied space.

3. Click Save.

Available Widgets
When a widget is enabled, the information that displays can vary based on the user’s permission level. Certain
roles can limit the top folder that a user sees.

Table 106 describes all the widgets.
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Widget Description

Client/Usage Graphs The Client graph is enabled by default and, by default, shows the
maximum number of attached clients over the last two hours. Select the
Show All link to view more specific client information on the graph, such as
the total and average clients for a specific SSID, the maximum VPN
sessions, etc. The available check boxes within this graph are determined
by the SSIDs that AirWave is aware of from polling the device.

The Usage graph is enabled by default and, by default, shows the average
bits-per-second in/out information and average VPN in/out information.
Select the Show All link to view usage information for specific SSIDs. The
available checkboxes within this graph are determined by the SSIDs that
AirWave is aware of from polling the device.

The information in these graphs is color coded to match the selected check
boxes.

Monitoring and Configuration
Pie Charts

The Monitoring Status pie chart shows the percentage of total devices
that are up and the number and percentage of devices that are currently
down. Clicking within this pie chart takes you to the Devices > Down page.

The Configuration Compliance pie chart shows the percentage of
devices that are mismatched, good, unknown, and those with auditing
disabled. It also provides a summary of the total number of devices that
are mismatched. Clicking within this pie chart takes you to the Devices >
Mismatch page.

These pie charts are enabled by default.

Alert Summary The Alert Summary table is enabled by default and provides the number
of AirWave alerts, IDS events, and RADIUS authentication issues over the
last 2 hours, the last 24 hours, and the total since the last AirWave server
reboot.
l Click on AMPAlerts to drill down to more detailed alert information.

This information displays in the current page. You can return to the
Alert Summary graph by selecting the Home Overview link.

l Click on IDS Events to drill to more detailed event information. This link
takes you to the RAPIDS > IDS Events page.

l Click on RADIUS Authentication Issues to drill to more detailed
RADIUS authentication information. This information displays in the
current page. You can return to the Alert Summary graph by selecting
the Home Overview link.

Quick Links The Quick Links section is enabled by default. This section provides the
user with easy navigation to a specific folder, group, report, or common
task.

RAPIDS: Acknowledged The Acknowledged RAPIDS Devices pie chart shows the percentage of
acknowledged and unacknowledged RAPIDS that the user has visibility into.
The RAPIDS information appears from the moment a rogue is discovered
until it is deleted. Ignored rogues, however, are not included in this chart.

This chart also displays on the RAPIDS > Overview page.

Table 106: Available Widgets
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Widget Description

RAPIDS: Classification Pie The RAPIDS: Classification Pie shows the percentage of devices
classified as Valid, Suspected Neighbor, Suspected Valid, Suspected Rogue,
Rogue, and Neighbor that are attached to AirWave. The RAPIDS
information appears from the moment a rogue is discovered until it is
deleted. Ignored rogues, however, are not included in this chart.

This pie chart can also be viewed on the RAPIDS > Overview page.

RAPIDS: Classification
Summary

The RAPIDS: Classification Summary table shows the number of devices
classified as Valid, Suspected Valid, Neighbor, Suspected Neighbor,
Suspected Rogue, Rogue, and Unclassified that are attached to AirWave. In
addition, contained rogue information will appear if Manage rogue AP
containment is set to Yes on the RAPIDS > Setup page.

The RAPIDS information appears from the moment a rogue is discovered
until it is deleted. Note that ignored rogues are not included in this chart.

This table can also be viewed on the RAPIDS > Overview page.

IDS Events The IDS Events table shows the number and type of attacks logged by the
intrusion detection system over the last 2 hours, the last 24 hours, and the
total since the last AirWave server reboot. This is the same table that
displays on the RAPIDS > Overview page.

RAPIDS: OS Pie The RAPIDS: OSPie chart shows the top 9 rogue devices by OS, Others,
Unknown, and Not Scanned. The RAPIDS information appears from the
moment a rogue is discovered until it is deleted. Note that ignored rogues
are not included in this chart.

This pie chart can also be viewed on the RAPIDS > Overview page.

RAPIDS: OS Summary The RAPIDS: OS Summary table shows the top 9 rogue devices by OS,
Others, Unknown, and Not Scanned. The RAPIDS information appears from
the moment a rogue is discovered until it is deleted. Note that ignored
rogues are not included in this chart.

This table can also be viewed on the RAPIDS > Overview page.

Top Folders By AP Usage This chart lists the folders and the number of APs in each folder whose
usage is greater than the cutoff (or usage threshold). The cutoff represents
75% of the maximum usage, where the maximum usage is the AP with the
highest usage regardless of the folder in which it resides. The cutoff value
is displayed within the title, and this value can vary. The chart takes into
account approved APs with radios based on the last 24 hours. In addition,
this chart is updated every hour.

Table 106: Available Widgets (Continued)
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Widget Description

Top Folders By A Radio
Channel Usage

This chart shows the folders and the number of 802.11a radios (5GHz) in
each folder whose channel usage is greater than the cutoff (or usage
threshold) as measured by Mbps. This cutoff is on the on the AMP Setup >
General page using the Configure Channel Busy Threshold option. If
this option is not configured, then the cutoff is 75% of the ‘maximum,’
where the ‘maximum’ refers to the AP that has the highest usage
regardless of the folder in which it resides. The cutoff value is displayed
within the title, and this value can vary. This chart takes into account
approved APs with ‘A’ radios based on the last 24 hours. In addition, this
chart is updated every hour.

Top Folders By BG Radio
Channel Usage

This chart shows the folders and the number of 802.11b/g radios (2.4GHz)
in each folder whose channel usage is greater than the cutoff (or usage
threshold) as measured by Mbps. This cutoff is on the on the AMP Setup >
General page using the Configure Channel Busy Threshold option. If
this option is not configured, then the cutoff is 75% of the ‘maximum,’
where the ‘maximum’ refers to the AP that has the highest usage
regardless of the folder in which it resides. The cutoff value is displayed
within the title, and this value can vary. This chart takes into account
approved APs with ‘BG’ radios based on the last 24 hours. In addition, this
chart is updated every hour.

Top Folders By A Radio Client
Count

This chart shows the folders and the number of 802.11a radios (5GHz) in
each folder whose client count is greater than the cutoff. The cutoff
represents 75% of the ‘maximum,’ where the ‘maximum’ is the radio that
has the highest client count regardless of the folder. The cutoff value is
displayed within the title and can vary. This chart takes into account
approved APs with A radios based on the last 24 hours. In addition, this
chart is updated every hour.

Top Folders By BG Radio
Client Count

This chart shows the folders and the number of 802.11b/g radios (2.4GHz)
in each folder whose client count is greater than the cutoff. The cutoff
represents 75% of the ‘maximum,’ where the ‘maximum’ is the radio that
has the highest client count regardless of the folder. The cutoff value is
displayed within the title and can vary. This chart takes into account
approved APs with BG radios based on the last 24 hours. In addition, this
chart is updated every hour.

Top Clients By Total Traffic The widget looks at currently connected clients as well has client historical
information over the past 24 hours and then displays the top 10 clients with
the must usage. You can click on a MAC address to view more information
about any of the clients that display on this table. This table is updated
every hour.

Clients By AOS Device Type This pie chart shows the percentage of clients that have attached to
AirWave over the last 24 hours based on the AOS device type.

Clients By Device Type This pie chart shows the percentage of clients that have attached to
AirWave over the last 24 hours based on the device type (such as a specific
operating system or smart phone type).

Table 106: Available Widgets (Continued)
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Widget Description

Clients By Device Mfgr This pie chart shows the percentage of clients that have attached to
AirWave over the last 24 hours based on the client manufacturer.

Clients By Device Model This pie chart shows the percentage of clients that have attached to
AirWave over the last 24 hours based on the device model (such as the
smart phone type).

Clients By Mfgr & Model This 